PLC Automation

Automation Builder, programmable logic controllers, control panels

Automation Builder 2.7.0, AC500 V3, AC500-eCo V3, AC500-XC V3, AC500-S, CP600, CP600-eCo, CP600-Pro
## Table of contents

1 Preface................................................................................................................................. 6
  1.1 Documentation guide........................................................................................................ 6
  1.2 Do I use AC500 V2 or AC500 V3?.................................................................................... 6
  1.3 Your tasks - documentation from the user's point of view............................................. 7
  1.4 Regulations........................................................................................................................ 9
  1.5 Older revisions of this document....................................................................................... 10
  1.6 Structure of safety notices............................................................................................... 10

2 Safety instructions.................................................................................................................... 12

3 Getting started with example projects.................................................................................. 16
  3.1 Introduction........................................................................................................................ 16
  3.2 Engineering software Automation Builder......................................................................... 16
    3.2.1 Purpose......................................................................................................................... 16
    3.2.2 Installation of the Automation Builder.......................................................................... 16
    3.2.3 Licensing procedure.................................................................................................... 17
    3.2.4 Setting up of communication parameters in Windows............................................. 19
  3.3 Hardware AC500 V3........................................................................................................ 21
    3.3.1 Configuration for example projects............................................................................. 21
    3.3.2 System assembly, construction and connection.......................................................... 23
  3.4 Example project for central I/O expansion....................................................................... 24
    3.4.1 Purpose......................................................................................................................... 24
    3.4.2 Preconditions................................................................................................................ 24
    3.4.3 Creation, setting up and saving of your AC500 V3 project.......................................... 24
    3.4.4 Configuration of the I/O module.................................................................................. 29
    3.4.5 Programming and compilation...................................................................................... 33
    3.4.6 Setting up the communication gateway....................................................................... 42
    3.4.7 Installation and update of the AC500 V3 firmware..................................................... 48
    3.4.8 Logging in to CPU and downloading the program....................................................... 50
    3.4.9 Testing the program..................................................................................................... 51
    3.4.10 Setting up a visualization............................................................................................ 53
    3.4.11 Creation of a visualization.......................................................................................... 57
    3.4.12 Enabling a web visualization......................................................................................... 65
    3.4.13 Reset the CPU............................................................................................................. 70
  3.5 Example project for remote I/O expansion with PROFINET............................................ 71
    3.5.1 Purpose......................................................................................................................... 71
    3.5.2 Preconditions................................................................................................................ 71
    3.5.3 Set-up PROFINET controller...................................................................................... 72
    3.5.4 Set-up PROFINET device............................................................................................ 74
    3.5.5 Add remote I/O expansion to project.......................................................................... 78
    3.5.6 Test the program........................................................................................................... 82
    3.5.7 Reset the CPU............................................................................................................. 83

4 System overview, planning and operation........................................................................... 85
  4.1 System overview................................................................................................................ 85
    4.1.1 AC500 PLC product family......................................................................................... 85
    4.1.2 AC500/S500 system structure.................................................................................... 86
    4.1.3 AC500-eCo/S500-eCo system structure...................................................................... 87
    4.1.4 AC500/S500: Short description hardware................................................................. 89
    4.1.5 AC500-eCo/S500-eCo: Short description hardware................................................... 93
4.1.6 AC500-S ........................................................................................................................................... 94
4.1.7 CP600 control panels ...................................................................................................................... 95
4.1.8 Automation Builder: Short description engineering software ......................................................... 95
4.2 Application planning .......................................................................................................................... 97
  4.2.1 Safety instructions ......................................................................................................................... 97
  4.2.2 Processor module and I/O selection ............................................................................................... 97
  4.2.3 I/O bus - Communication within the PLC ...................................................................................... 97
  4.2.4 Fieldbus connectivity options ....................................................................................................... 98
  4.2.5 Power supply dimensioning .......................................................................................................... 100
  4.2.6 Libraries, software packages and licensed features ...................................................................... 103
4.3 Mechanical planning and installation ............................................................................................... 104
  4.3.1 Control cabinet assembly (indoor use) .......................................................................................... 104
  4.3.2 Mounting and demounting - general information ........................................................................ 106
  4.3.3 Mounting and demounting the terminal base .............................................................................. 107
  4.3.4 Mounting and demounting the AC500 processor module ............................................................ 109
  4.3.5 Mounting and demounting the communication module ............................................................... 109
  4.3.6 Mounting and demounting the terminal unit .............................................................................. 111
  4.3.7 Mounting and demounting the I/O module .................................................................................. 113
  4.3.8 Mounting and demounting the AC500-eCo processor module ................................................... 114
  4.3.9 Mounting and demounting the SS00-eCo I/O module .................................................................. 123
  4.3.10 Accessories for AC500 (Standard) .............................................................................................. 126
  4.3.11 Accessories for AC500-eCo ........................................................................................................... 127
  4.3.12 Control panels CP600 ................................................................................................................. 130
4.4 Wiring .................................................................................................................................................. 131
  4.4.1 Grounding concept ....................................................................................................................... 131
  4.4.2 EMC-conforming assembly and construction ............................................................................. 132
  4.4.3 Connection and wiring of the PLC platform ................................................................................. 137
  4.4.4 Connection and wiring of the modules ......................................................................................... 145
4.5 Configuration and programming ...................................................................................................... 145
4.6 Commissioning ................................................................................................................................... 146
4.7 Operation .......................................................................................................................................... 147
  4.7.1 Operating modes ........................................................................................................................... 147
  4.7.2 Diagnosis system ........................................................................................................................... 147
  4.7.3 Status LEDs, display and control elements .................................................................................. 148
  4.7.4 PLC firmware/application update ................................................................................................. 148
  4.7.5 Control panel firmware/application update .................................................................................... 148
  4.7.6 Reset Warm .................................................................................................................................. 149
4.8 Troubleshooting ............................................................................................................................... 149
  4.8.1 General ......................................................................................................................................... 149
  4.8.2 Possible malfunctions .................................................................................................................... 149
  4.8.3 Execution of a hotfix ....................................................................................................................... 151
4.9 Maintenance ......................................................................................................................................... 152
  4.9.1 Maintenance intervals .................................................................................................................... 152
  4.9.2 Replace an AC500 module ............................................................................................................ 152
  4.9.3 Replace an I/O module with hot swap ............................................................................................ 153
  4.9.4 Replace a CP600 control panel ..................................................................................................... 157
4.10 Decommissioning ............................................................................................................................. 157
4.11 Recycling .......................................................................................................................................... 158
5 Hardware descriptions .......................................................................................................................... 159
  5.1 Technical data of the system ........................................................................................................... 159
    5.1.1 System data AC500-eCo .............................................................................................................. 159
6 Configuration and programming

6.1 Cyber security

6.1.1 General

6.1.2 Defense in depth

6.1.3 Secure operation

6.1.4 Hardening

6.1.5 Certificates factory default - no encryption

6.1.6 Open Ports and Services

6.2 Engineering software Automation Builder

6.2.1 Introduction

6.2.2 Automation Builder updates

6.2.3 Use of open source components

6.2.4 Managing your licenses

6.2.5 Setting up of communication parameters in Windows

6.2.6 Version information

6.2.7 PLC runtime and demo licensing

6.2.8 Create log files for support

6.2.9 Menues, views, windows

6.2.10 Device repository

6.2.11 Creating and configuring projects

6.2.12 Handling of AC500 projects

6.2.13 Connection of devices

6.2.14 Connection of serial interfaces

6.2.15 Converting an AC500 V2 project to an AC500 V3 project

6.2.16 Automation Builder installation manager

6.3 Configuration in Automation Builder for AC500 V3 products

6.3.1 General settings

6.3.2 PLC devices and components

6.3.3 Windows server

6.3.4 Protocols and special servers

6.3.5 Data transfer and programming

6.3.6 Server installation

6.3.7 Converting an AC500 V2 project to an AC500 V3 project

6.4 Programming with CODESYS

6.4.1 CODESYS Development System

6.4.2 Fieldbus Support
# Table of contents

6.4.3 Runtime systems, OPC UA server................................................................. 2834  
6.4.4 Libraries.................................................................................................... 2852  
6.4.5 CODESYS Visualization........................................................................... 2852  
6.4.6 CODESYS Visualization Support.............................................................. 3773  
6.5 Libraries and solutions.............................................................................. 3773  
6.5.1 Information on libraries........................................................................... 3773  
6.5.2 Reference to CODESYS (V3)................................................................. 3773  
6.5.3 Library Manager functionality............................................................... 3773  
6.5.4 ACS/DCS drives libraries......................................................................... 3778  
6.5.5 Application libraries.............................................................................. 3833  
6.5.6 BACnet-BC............................................................................................ 3833  
6.5.7 CAA library guidelines.......................................................................... 3849  
6.5.8 Data Logger Library................................................................................ 3849  
6.5.9 High Availability Modbus TCP............................................................. 3859  
6.5.10 Motion Control..................................................................................... 3904  
6.5.11 MQTT client library............................................................................. 4048  
6.5.12 PLCopen libraries................................................................................ 4051  
6.5.13 Pumping library V3............................................................................. 4056  
6.5.14 Reference, function blocks................................................................. 4086  
6.6 Engineering interfaces and tools.............................................................. 4191  
6.6.1 Export and import interfaces.................................................................. 4191  
6.6.2 CODESYS Security Agent................................................................... 4201  
6.6.3 CODESYS Static Analysis................................................................... 4208  
6.6.4 Multi download tool.............................................................................. 4306  
6.6.5 Tool Calling Interface (TCI) implementation...................................... 4309  
6.6.6 Drive composer pro integration............................................................ 4311  
6.6.7 Professional Version Control............................................................... 4315  
6.6.8 Subversion............................................................................................ 4356  
6.6.9 Mail service with SMTP/SMTPS............................................................ 4361  
6.6.10 SNMP.................................................................................................. 4362  
6.6.11 Scripting with Python........................................................................... 4362  
6.7 Human machine interface...................................................................... 4397  
6.7.1 Control panels...................................................................................... 4397  
6.7.2 Panel Builder interface......................................................................... 4398  
6.7.3 SCADA Integration............................................................................... 4406  
6.8 System technology................................................................................... 4411  
6.8.1 General............................................................................................... 4411  
6.8.2 System technology of CPU and overall system................................. 4412  
6.8.3 System technology of the AC500 communication modules............... 4565  
6.8.4 System technology of the communication interface modules............ 4568  
6.9 Diagnosis and debugging...................................................................... 4605  
6.9.1 The diagnosis system.......................................................................... 4605  
6.9.2 Online diagnosis in Automation Builder............................................ 4640  
6.9.3 Diagnosis messages............................................................................ 4655  
7 Glossary....................................................................................................... 4710  
8 Index............................................................................................................ 4713
1 Preface

1.1 Documentation guide

Where to find information about:

- PLC system
  - Chapter 4.1 “System overview” on page 85
  - Chapter 3 “Getting started with example projects” on page 16
  - Starter kit: Introduction to PLC programming and visualization, including all needed hardware components
  - Safety user manual for safety PLCs
- Devices
  - Data sheets
  - Installation instructions
  - Chapter 5.2 “Device specifications” on page 175
  - Safety user manual for safety PLCs
  - Control panels
- Software and programming
  - Chapter 6 “Configuration and programming” on page 1339
  - Programming examples available for download
  - Programming examples available in the engineering suite: Open Automation Builder menu “Help ➔ Project examples”
  - Application descriptions for specific features and use cases
  - Release notes for the latest version of the engineering suite Automation Builder

1.2 Do I use AC500 V2 or AC500 V3?

This document describes AC500 V3 products.

We offer different ranges of the processor modules (V2, V3). You can easily find out which ones are used in your system. Either have a look at your used modules or your configuration.

![Fig. 1: Hardware: Processor modules](image)

<table>
<thead>
<tr>
<th>Written type on the module</th>
<th>Example</th>
<th>Range</th>
<th>Relevant manual</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor module type PM + 3 digits</td>
<td>PM595</td>
<td>V2</td>
<td>AC500 V2</td>
</tr>
<tr>
<td>Processor module type PM + 4 digits</td>
<td>PM5670</td>
<td>V3</td>
<td>AC500 V3 (this manual)</td>
</tr>
</tbody>
</table>
### 1.3 Your tasks - documentation from the user’s point of view

All information about AC500, AC500-XC and AC500-eCo is available in this manual.

All information about AC500-S and AC500-S-XC is available online in the safety user manual.

#### As a specialist for PLCs, new to AC500 PLC

<table>
<thead>
<tr>
<th>PLC related videos</th>
<th>youtube.com/user/abbplc</th>
</tr>
</thead>
<tbody>
<tr>
<td>Getting started with example projects</td>
<td>✈ Chapter 3 “Getting started with example projects” on page 16</td>
</tr>
<tr>
<td>PLC system description</td>
<td>✈ Chapter 4.1 “System overview” on page 85</td>
</tr>
<tr>
<td>Hardware descriptions</td>
<td>✈ Chapter 5.2 “Device specifications” on page 175</td>
</tr>
<tr>
<td>System technology: System behavior, interaction between PLC behavior (firmware), configuration, programming and use cases.</td>
<td>✈ Chapter 6.8 “System technology” on page 4411</td>
</tr>
</tbody>
</table>

#### As a specialist for AC500 V2 CPU range, new to AC500 V3 CPU range

<table>
<thead>
<tr>
<th>AC500 V3 CPU specifications</th>
<th>✈ Chapter 5.2 “Device specifications” on page 175</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comparison of product features</td>
<td>✈ Chapter 5.2.1.2.1 “Product overview and comparison” on page 303</td>
</tr>
<tr>
<td></td>
<td>✈ via product catalog</td>
</tr>
<tr>
<td>Convert an AC500 V2 project to an AC500 V3 project</td>
<td>✈ Chapter 6.2.15 “Converting an AC500 V2 project to an AC500 V3 project” on page 1394</td>
</tr>
<tr>
<td>Compatible modules with AC500 CPUs</td>
<td>✈ Chapter 5.2 “Device specifications” on page 175</td>
</tr>
<tr>
<td>Documentation for AC500 V2</td>
<td>AC500 V2</td>
</tr>
</tbody>
</table>

### Written type in brackets

<table>
<thead>
<tr>
<th>Written type in brackets</th>
<th>Example</th>
<th>Range</th>
<th>Relevant manual</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor module type PM + 3 digits</td>
<td>PM595</td>
<td>V2</td>
<td>AC500 V2</td>
</tr>
<tr>
<td>Processor module type PM + 4 digits</td>
<td>PM5670</td>
<td>V3</td>
<td>AC500 V3 (this manual)</td>
</tr>
</tbody>
</table>
### As a mechanical/electrical designer

<table>
<thead>
<tr>
<th>Task</th>
<th>Page/Chapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLC system description</td>
<td>4.1 “System overview” on page 85</td>
</tr>
<tr>
<td>Hardware descriptions</td>
<td>5.2 “Device specifications” on page 175</td>
</tr>
<tr>
<td>Comparison of product features</td>
<td>2.1.2.1 “Product overview and comparison” on page 303, via product catalog (online)</td>
</tr>
</tbody>
</table>

### As a control cabinet manufacturer

<table>
<thead>
<tr>
<th>Task</th>
<th>Page/Chapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assembly of modules</td>
<td>4.3 “Mechanical planning and installation” on page 104</td>
</tr>
<tr>
<td>Connection of modules</td>
<td>5.2 “Device specifications” on page 175</td>
</tr>
<tr>
<td></td>
<td>“Device specifications ➔ Product group ➔ Product type ➔ Electrical connection”</td>
</tr>
<tr>
<td>Installation instructions</td>
<td>All AC500 modules</td>
</tr>
</tbody>
</table>

### As a programming engineer

<table>
<thead>
<tr>
<th>Task</th>
<th>Page/Chapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example projects</td>
<td>3 “Getting started with example projects” on page 16</td>
</tr>
<tr>
<td>Programming examples for download</td>
<td>Programming examples available in engineering suite: Open Automation Builder menu “Help ➔ Project examples”</td>
</tr>
<tr>
<td>Application descriptions for specific features and use cases</td>
<td></td>
</tr>
<tr>
<td>Installation of Automation Builder</td>
<td>3.2.2 “Installation of the Automation Builder” on page 16</td>
</tr>
<tr>
<td>License management for Automation Builder</td>
<td>6.2.4 “Managing your licenses” on page 1350</td>
</tr>
<tr>
<td>Configuration of PLC hardware in Automation Builder</td>
<td>6.3 “Configuration in Automation Builder for AC500 V3 products” on page 1398</td>
</tr>
<tr>
<td>Firmware update</td>
<td>6.3.1.4 “Firmware identification and update” on page 1419</td>
</tr>
<tr>
<td>Programming</td>
<td>6.4 “Programming with CODESYS” on page 1800</td>
</tr>
<tr>
<td>Function block libraries</td>
<td>6.5 “Libraries and solutions” on page 3773</td>
</tr>
<tr>
<td></td>
<td>CODESYS libraries by 3S 6.4.4 “Libraries” on page 2852</td>
</tr>
<tr>
<td>System technology: System behavior, interaction between PLC behavior (firmware), configuration, programming and use cases.</td>
<td>6.8 “System technology” on page 4411</td>
</tr>
<tr>
<td>Visualization and web visualization: Example projects</td>
<td>3.4 “Example project for central I/O expansion” on page 24</td>
</tr>
<tr>
<td>Visualization and web visualization</td>
<td>6.4.5 “CODESYS Visualization” on page 2852</td>
</tr>
</tbody>
</table>
Add, remove or modify software packages in Automation Builder via installation manager

<table>
<thead>
<tr>
<th>Chapter 6.2.16 “Automation Builder installation manager” on page 1395</th>
</tr>
</thead>
</table>

Add-on software packages

<table>
<thead>
<tr>
<th>Chapter 6.6 “Engineering interfaces and tools” on page 4191</th>
</tr>
</thead>
</table>

HMI, e.g., interface to control panels and SCADA systems

<table>
<thead>
<tr>
<th>Chapter 6.7 “Human machine interface” on page 4397</th>
</tr>
</thead>
</table>

### As a commissioning engineer

<table>
<thead>
<tr>
<th>Function block libraries</th>
</tr>
</thead>
<tbody>
<tr>
<td>Libraries by ABB</td>
</tr>
<tr>
<td>Chapter 6.5 “Libraries and solutions” on page 3773</td>
</tr>
<tr>
<td>CODESYS libraries by 3S</td>
</tr>
<tr>
<td>Chapter 6.4.4 “Libraries” on page 2852</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Hardware descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 5.2 “Device specifications” on page 175</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Troubleshooting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 4.8 “Troubleshooting” on page 149</td>
</tr>
<tr>
<td>Chapter 6.9 “Diagnosis and debugging” on page 4605</td>
</tr>
</tbody>
</table>

### As a service engineer

<table>
<thead>
<tr>
<th>Troubleshooting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 4.8 “Troubleshooting” on page 149</td>
</tr>
<tr>
<td>Chapter 6.9 “Diagnosis and debugging” on page 4605</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>List of diagnosis and error messages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 6.9.3 “Diagnosis messages” on page 4655</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Contact ABB support</th>
</tr>
</thead>
<tbody>
<tr>
<td>new.abb.com/plc</td>
</tr>
</tbody>
</table>

### 1.4 Regulations

**Planning and installation of the electrical system**

The planning and installation of the electrical system must be carried out in compliance with the applicable regulations and standards. Hazards due to malfunctions must be prevented by taking appropriate measures.

The suitability of the products for the respective application is proven by declarations of conformity and certificates.

The PLC Automation catalog contains an overview of the available declarations of conformity and certificates.

**Qualified personnel**

Both the AC500 control system and other components in the vicinity are operated with dangerous touch voltages. Touching live components can lead to serious health implications or even death.

To avoid such risks and the occurrence of property damage, persons involved in the installation, commissioning and maintenance must have relevant knowledge about:

- Automation technology
- Handling of hazardous voltages
- Application of relevant standards and regulations, accident prevention regulations and regulations on special environmental conditions (e.g., hazardous areas due to explosive substances, heavy soiling or corrosive influences).
1.5 Older revisions of this document

You can always find all revisions of our documents on our website.

AC500 V3 (online)

1.6 Structure of safety notices

Throughout the documentation we use the following types of safety and information notices. They make you aware of safety considerations or give advice on AC500 products usage.

1 Safety alert symbol indicates the danger.
2 Signal word classifies the danger.
3 Type and source of the risk are mentioned and possible consequences are described.
4 Measures to avoid these consequences (enumerations).

Signal words

DANGER!

DANGER indicates a hazardous situation which, if not avoided, will result in death or serious injury.

Ensure to take measures to prevent the described impending danger.
WARNING!
WARNING indicates a hazardous situation which, if not avoided, could result in death or serious injury.
Ensure to take measures to prevent the described dangerous situation.

CAUTION!
CAUTION indicates a hazardous situation which, if not avoided, could result in minor or moderate injury.
Ensure to take measures to prevent the described dangerous situation.

NOTICE!
NOTICE is used to address practices not related to physical injury but might lead to property damage for example damage of the product.
Ensure to take measures to prevent the described dangerous situation.

NOTE provides additional information on the product, e.g., advices for configuration or best practice scenarios.
2 Safety instructions

Relevant standards and regulations, accident prevention regulations and regulations on special environmental conditions must be observed (e.g., hazardous areas due to explosive substances, heavy soiling or corrosive influences).

The devices must be handled and operated within the specified technical data and system data. The devices contain no serviceable parts and must not be opened. Removable covers must be closed during operation unless otherwise specified. Any liability for the consequences of incorrect use or unauthorized repairs is rejected.

Qualified personnel

Both the AC500 control system and other components in the vicinity are operated with dangerous touch voltages. Touching live components can lead to serious health implications or even death.

To avoid such risks and the occurrence of property damage, persons involved in the installation, commissioning and maintenance must have relevant knowledge about:

- Automation technology
- Handling of hazardous voltages
- Application of relevant standards and regulations, accident prevention regulations and regulations on special environmental conditions (e.g., hazardous areas due to explosive substances, heavy soiling or corrosive influences).

Functional safety

The AC500-S safety user manual must be read and understood before using the safety configuration and programming tools of Automation Builder/PS501 Control Builder Plus. Only qualified personnel are permitted to work with AC500-S safety PLCs.

General information

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variants and requirements associated with any particular installation, ABB cannot assume responsibility or liability for actual use based on the examples and diagrams.

The PLC was developed according to the relevant standards. Any module-specific measures are described in the individual descriptions of the modules.

PLC-specific safety notices

The product family AC500 control system is designed according to the EN 61131-2 and IEC 61131-2 standards. Any data that differs from IEC 61131-2, is due to the higher requirements of Maritime Services. Other differences are described in the technical data description of the devices.

NOTICE!

Avoidance of electrostatic charging

PLC devices and equipment are sensitive to electrostatic discharge, which can cause internal damage and affect normal operation. Observe the following rules when handling the system:

- Touch a grounded object to discharge potential static.
- Wear an approved grounding wrist strap.
- Do not touch connectors or pins on component boards.
- Do not touch circuit components inside the equipment.
- If available, use a static-safe workstation.
- When not in use, store the equipment in appropriate static-safe packaging.
NOTICE!

Use of suitable enclosure
The devices must be mounted in a control cabinet that ensures compliance with the specified environmental conditions.

Cleaning instructions
Do not use cleaning agent for cleaning the device.
Use a damp cloth instead.

Connection plans and a user program must be created so that no dangerous situations can occur during normal operation or failure.
The application must be tested to ensure that no dangerous situations can occur during operation.

Do not operate devices outside of the specified, technical data!
Trouble-free functioning cannot be ensured outside of the specified data.

NOTICE!

PLC damage due to missing grounding
- Make sure to ground the devices.
- The grounding (switch cabinet grounding) is supplied both by the mains connection (or 24 V supply voltage) and via the DIN rail. The DIN rail must be connected to ground before power is supplied to the device. The grounding may be removed only if it is certain that no more power is being supplied to the control system.
- In case of screw mounting, use metal screws for grounding.

CAUTION!

Do not obstruct the ventilation for cooling!
The ventilation slots on the upper and lower sides of the devices must not be covered.

CAUTION!

Run signal and power wiring separately!
Signal and supply lines (power cables) must be laid out so that no malfunctions due to capacitive and inductive interference can occur (EMC).

WARNING!

Warning sign on the module!
This indicates that dangerous voltages may be present or that surfaces may have dangerous temperatures.
WARNING!
Splaying of strands can cause hazards!
Avoid splayed strands when wiring terminals with stranded conductors.
– Ferrules can be used to prevent splaying.

WARNING!
Removal/Insertion under power
Removal or insertion under power is permissible only if all conditions for hot swapping are fulfilled.

CDF Chapter 4.9.3 “Replace an I/O module with hot swap” on page 153

The devices are not designed for removal or insertion under power when the conditions for hot swap do not apply. Because of unforeseeable consequences, it is not allowed to plug in or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you
– connect or disconnect any signal or terminal block
– remove, mount or replace a module.

Disconnecting any powered devices while they are energized in a hazardous location could result in an electric arc, which could create an ignition source resulting in fire or explosion.

Prior to proceeding, make sure that power is been disconnected and that the area has been thoroughly checked to ensure that flammable materials are not present.

The devices must not be opened when in operation. The same applies to the network interfaces.

CAUTION!
Use only ABB approved lithium battery modules!
At the end of the battery’s lifetime, always replace it only with a genuine battery module.

CAUTION!
Risk of explosion!
Do not open, re-charge or disassemble lithium batteries. Attempting to charge lithium batteries will lead to overheating and can cause explosions.

Protect them from heat and fire and store them in a dry place.

Never short-circuit or operate lithium batteries with the polarities reversed. The batteries are likely to overheat and explode. Avoid unintentional short circuiting do not store batteries in metal containers and do not place them on metallic surfaces. Escaping lithium is a health hazard.
**Environment considerations**

Recycle exhausted batteries. Dispose of batteries in an environmentally conscious manner in accordance with regulations issued by the local authorities.
3 Getting started with example projects

3.1 Introduction

This document gives an overview of the steps for the first use of a PLC with AC500 V3 processor module and describes:

- installation of the engineering software © Chapter 3.2 “Engineering software Automation Builder” on page 16
- hardware needed for example projects © Chapter 3.3 “Hardware AC500 V3” on page 21
- setting up a first, simple project for a stand-alone CPU with central I/O expansion, including visualization and web visualization © Chapter 3.4 “Example project for central I/O expansion” on page 24
- commissioning a project for remote I/O expansion with PROFINET © Chapter 3.5 “Example project for remote I/O expansion with PROFINET” on page 71

3.2 Engineering software Automation Builder

3.2.1 Purpose

For configuring and programming of any AC500 CPU you need the engineering software suite Automation Builder. Automation Builder is available for download.

© Further information on page 16

3.2.2 Installation of the Automation Builder

Preconditions You must have administrator rights on your PC to install Automation Builder.

In case of an update installation:

Create a project archive before upgrading Automation Builder. Project archives contain all project data, including data that is not stored with a *.project file, e.g. device description files for third party devices.

© Chapter 6.3.1.8.2 “Creation of an archive ” on page 1408

Installation

1. Go to abb.com/automationbuilder to access the homepage of Automation Builder.
2. In the “Downloads” section, select “Download Automation Builder”.
3. In the “Latest Automation Builder” section, select “Automation Builder x.x. Download” (x.x = latest version). This downloads the installer on your PC.
4. Open the downloaded installer and follow the instructions of the installation manager.
5. Keep the default type of installation to “Premium Edition” if available.
6. Select software packages to be installed:
   Enable the check box “PLC - AC500 V3” to activate installation of all options for AC500 V3.
7. Click “Download and install” and follow the instructions of the setup.

3.2.3 Licensing procedure

When you start Automation Builder software for the first time, you will be asked to choose a license option.

See also:

- Details about the license model, the features of the editions and the latest license information
- Detailed description of the installation and the licensing possibilities of Automation Builder

Activate a trial license

- Automation Builder software must be installed successfully.
- PC is connected to the internet.

   - A licensing wizard starts and guides you through the licensing procedure.
2. Enter user information.
   - In case of future support requests, your registration details enable ABB support team to handle your questions quickly.
3. Select “OK”.

- 2024/01/05
- 3ADR010583, 1, en_US
4. Enable the trial license.

5. Select “Next”.

6. Enable the single PC license and select “Next”.

![Image of Automation Builder](image1.png)

![Image of ABB License Manager](image2.png)
7. Enable online activation and select “Next”.
   ⇒ License activation procedure starts. A successfully ended licensing procedure ends with a success message.
8. Select “OK” to end the wizard.
   ⇒ Automation Builder license is activated and starts.

### 3.2.4 Setting up of communication parameters in Windows

**Setting up of communication parameters**

To set up the communication between the PC and the PLC, e.g., for downloading the compiled program, you have to set up the communication parameters.

- The IP address of your PC must be in the same class as the IP address of the CPU.
- The factory setting of the IP address of the CPU is 192.168.0.10.
- The IP address of your PC should be 192.168.0.X. Avoid X = 10 in order to prevent an IP conflict with the CPU.
- Subnet mask should be 255.255.255.0.

**Changing of the IP address**

1. Open Windows control panel. Click “Network and Internet” ➔ “Network and Sharing Center”.
2. Click “Change adapter settings”.
   ⇒ **If using existing network with several devices, please pay attention on given network rules or contact your system administrator.**
3. Right-click “Local Area Connection (Ethernet)” and select [Properties].
5. Enter your desired IP address and subnet mask.

3.3 Hardware AC500 V3

3.3.1 Configuration for example projects

The example projects require a small PLC configuration with I/O devices, e.g., as available in the training case TA5450-CASE.

Table 1: Modules for example projects to get started with AC500 V3 PLC

<table>
<thead>
<tr>
<th>Product name</th>
<th>Type</th>
<th>First project</th>
</tr>
</thead>
<tbody>
<tr>
<td>PM5630-2ETH</td>
<td>AC500 V3 CPU</td>
<td>x</td>
</tr>
<tr>
<td>TB5620-2ETH</td>
<td>terminal base for CPU</td>
<td>x</td>
</tr>
<tr>
<td>DA501</td>
<td>analog/digital mixed input/output (I/O)</td>
<td>x</td>
</tr>
<tr>
<td>TU516-H</td>
<td>terminal unit for I/O module</td>
<td>x</td>
</tr>
</tbody>
</table>

Second project:

- Chapter 3.4 “Example project for central I/O expansion” on page 24
- Chapter 3.5 “Example project for remote I/O expansion with PROFINET” on page 71
<table>
<thead>
<tr>
<th>Product name</th>
<th>Type</th>
<th>First project</th>
<th>Second project</th>
</tr>
</thead>
<tbody>
<tr>
<td>CM579-PNIO</td>
<td>PROFINET communication module</td>
<td>--</td>
<td>x</td>
</tr>
<tr>
<td>CI502-PNIO</td>
<td>PROFINET communication interface module</td>
<td>--</td>
<td>x</td>
</tr>
<tr>
<td>TU508-ETH</td>
<td>terminal unit for communication interface module</td>
<td>--</td>
<td>x</td>
</tr>
<tr>
<td>TA524</td>
<td>blind cap for terminal base</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

Connections

Fig. 3: Training case TA5450

In the training case, the control panel CP6607 is included. A control panel is not needed for the example projects.

For testing the example project some inputs require to be connected as follows:
3.3.2 System assembly, construction and connection

**NOTICE!**

Avoidance of electrostatic charging

PLC devices and equipment are sensitive to electrostatic discharge, which can cause internal damage and affect normal operation. Observe the following rules when handling the system:

- Touch a grounded object to discharge potential static.
- Wear an approved grounding wrist strap.
- Do not touch connectors or pins on component boards.
- Do not touch circuit components inside the equipment.
- If available, use a static-safe workstation.
- When not in use, store the equipment in appropriate static-safe packaging.

You can mount AC500 PLC either to DIN rail or to a metal plate. Here, we recommend to mount on DIN rail.

1. Snap the terminal base onto DIN rail.
2. Snap the additional terminal units for I/O modules onto DIN rail.
3. Make the sensor/actuator wire connections according to the dedicated electronic module you want to use. Provide external process power supply as required.
4. If required, make the fieldbus connections according to the dedicated master communication module you want to use.
5. Plug the appropriate electronic and I/O modules in the correct locations (processor module, communication modules on terminal base, and eventually also communication interface modules and I/O modules onto dedicated terminal units).

6. Connect a programming cable (Ethernet cable between ETH port of CPU and PC with engineering software).

3.4 Example project for central I/O expansion

3.4.1 Purpose

The following steps show how to set-up an application project and configure the hardware. A simple logic is used as example to introduce in programming and commissioning of the PLC. The workflow for creation of a visualization is explained, as well as how to set-up a web server for visualization.

3.4.2 Preconditions

- Automation Builder is installed and licensed as, at least, basic edition \( \text{Chapter 6.2.4 “Managing your licenses” on page 1350}. \)
- AC500 V3 CPU is assembled and connected to the PC \( \text{Chapter 3.3 “Hardware AC500 V3” on page 21}. \)

3.4.3 Creation, setting up and saving of your AC500 V3 project

3.4.3.1 Creation of a project

1. Launch Automation Builder either out of the desktop icon or out of the Windows menu.

2. Select “New Project” or go to menu “File ➔ New Project”.
3. Select “Projects”.
4. Select “AC500 project”.
5. Fill in project name.
6. Choose a location to save the project to.
7. Select [OK].
8. Select “PLC - AC500 V3”.
9. Select the CPU according to your hardware set-up.
10. Select [Add PLC] to add the CPU to your application.
3.4.3.2 Configuration of your processor module

1. Double-click “PLC_AC500_V3”.
   ⇒ A tab opens in the editor view.
2. Select “CPU Parameters”.
3. Under parameter “Check battery”, choose the value “Off” since there is no battery present inside the CPU module.
4. Keep the default values for all other parameters.

3.4.3.3 Creation of folders in the device tree

To optimize the project readability, you will create different folders to group similar objects. The folder names are exemplary. Because the device tree view follows an alphabetical order, we use number prefixes to determine the order.
1. Right-click “Application”.
2. Select “Add Folder”.
3. Type in "10 POUs". This is a name example. Here, the intention is to see this folder as a last one.

   The folder "10 POUs" is for program organization units (POU). POUs are objects of type program, function or function block that are used to create a user program.
3.4.3.4 Saving the project

Select menu “File ➔ Save Project”.

Alternatively, select the save icon in the tool bar.

Alternatively, press [Ctrl] + [S].

3.4.4 Configuration of the I/O module

3.4.4.1 General

- The types and order of modules in the Automation Builder project must match the real hardware configuration.
- The position of the modules in the device tree can be changed by drag and drop.
3.4.4.2 Adding an I/O bus module

1. Right-click “IO_Bus” in the device tree.
2. Select “Add object”.

Diagram showing the device tree with “IO_Bus” selected and the context menu open with “Add object” highlighted.
3. Select “S500 I/O modules”.
5. Select [Add object] to add the module to the I/O bus.
3.4.4.3 Variable mapping of the DA501

1. Double-click “DA501” in the device tree.
   ⇐ A tab opens in the editor view.

2. Select “DA501 I/O Mapping”
   ⇐ Here, you will map variable names (symbols) for the channels you will need in the program.

The suggested name convention is based on "Hungarian notation". A name prefix is describing variable type; e.g., "x" = variable of type BOOL, "w" = WORD, "i" = INT (integer) etc. This increases the code readability and is helpful for program analysis.

3.4.4.4 Handling the digital input variables

1. Open the list of the digital inputs.

2. Fill in the variable names:

<table>
<thead>
<tr>
<th>Channel</th>
<th>Type</th>
<th>Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital input DI8</td>
<td>BOOL</td>
<td>xDI_08_DA501_I1</td>
</tr>
</tbody>
</table>
3.4.4.5 Handling the digital output variables

1. Open the list of the digital outputs.
2. Fill in the variable names:

<table>
<thead>
<tr>
<th>Channel</th>
<th>Type</th>
<th>Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital output DC16</td>
<td>BOOL</td>
<td>xStartDrilling1</td>
</tr>
</tbody>
</table>

3.4.5 Programming and compilation

3.4.5.1 Task configuration

A task is a time unit in the processing of a user program (IEC application), which defines by parameters the way and the speed the CPU is executing the user program.

For this project you will use only one cycling task.

In the device tree, you see the objects “Task configuration” and “Task”. Both created automatically with the project.

For this project you will use only one cycling task.

> Double-click “Task” in the device tree.

⇒ A tab opens in the editor view.

For this project you will use only one cyclic task. Keep the default settings for the task.

<table>
<thead>
<tr>
<th>Priority</th>
<th>This is how the CPU prioritizes the task, when more than one task is defined. Priority 0 ... 15 = real time tasks, priority 16 = non-real time task.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>In the CPU you can run tasks dependent on the demands of the process.</td>
</tr>
<tr>
<td>Interval</td>
<td>For cyclic tasks you can set the cyclical execution time. It is usually set in milliseconds with IEC time syntax</td>
</tr>
<tr>
<td>Watchdog</td>
<td>To keep track of the time it takes to complete the task.</td>
</tr>
<tr>
<td>Calls</td>
<td>You can call in one or more program POUs in one single task</td>
</tr>
</tbody>
</table>
3.4.5.2 Main program PLC_PRG

In the default task configuration, there is one call of a POU (program organization unit) i.e. "PLC_PRG" (shown in chapter 3.4.5.1 Task configuration on page 33).

In your project the "PLC_PRG" will become a main program containing calls to other programs (POUs) which you will create one by one.

![Diagram of PLC_PRG POU]

The PLC_PRG POU has been defined by default in ST (Structured Text) editor. Keep this setting because of good visibility of the instructions at a glance and good handling for troubleshooting.

To optimize the project readability, you will work with the previously created folder "10 POUs" and add the created subroutines (POUs) to this folder. The subroutines will be created in FBD (Function Block Diagram) editor.

3.4.5.3 Boolean logic "NOT"

3.4.5.3.1 Application example "driller"

Recognizing of a driller by a photo sensor. "TRUE" input signal from sensor indicates that a driller is broken. If driller has been found correct, then start drilling.

![Diagram of driller]

<table>
<thead>
<tr>
<th>Signal from photo sensor</th>
<th>Required signal of motor ON</th>
</tr>
</thead>
<tbody>
<tr>
<td>FALSE</td>
<td>TRUE</td>
</tr>
<tr>
<td>TRUE</td>
<td>FALSE</td>
</tr>
</tbody>
</table>

Table 2: Required behavior
Table 3: Hardware set-up

<table>
<thead>
<tr>
<th>Element</th>
<th>HW channel</th>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch I1</td>
<td>DA501 DI8</td>
<td>xDI_08_DA501_I1</td>
<td>Photo sensor</td>
</tr>
<tr>
<td>LED output DC16</td>
<td>DA501 DC16</td>
<td>xStartDrilling1</td>
<td>Motor on</td>
</tr>
</tbody>
</table>

3.4.5.3.2 Implementation

Creation of a new program POU in the project

1. Right-click “10 POU’s”.
2. Select “Add object”.
3. Select “POU”.
4. Select [Add object].
5. Enter “_01_Assignment_NOT”.
6. Select “Program”.
7. Select “Function Block Diagram (FBD)”.
8. Select [Add].

⇒ POU has been added.
Assigning the hardware DI signals to local variables

1. Double-click POU “_01_Assignment_NOT” in the device tree.

2. Select “Assignment” from the ToolBox.

3. Drag and drop “Assignment” into the “Start here” field in network “1”.

4. Select “???” on the left side of the assignment, then select “… ”

5. Open the “Io Config_Globals_Mapping” mapping list and select “xDI_08_DA501_I1”.

6. Select [OK] to add this variable to the left side of the assignment connector.
7. Select “???” on the right side of the assignment connector and mark the “???”.
8. Create a new local variable by typing in "xDrillerBroken1" which will replace the “???”.
9. Press [Enter].
   “Auto Declare” opens.
   You see the written variable name and the data type BOOL. The scope is "VAR". It means it is a local variable within this POU.
10. Select [OK] to accept the entries.

11. Drag and drop “Network” from the ToolBox to the down-arrow of network 1.

   ⇒ You added a network “2” below network 1.

Adding assignments and a Boolean NOT to the DO signals

1. Add an assingment from the ToolBox.
2. Type in or copy & paste "xDrillerBroken1" to the left side of the instruction line.
3. Select “???” on the right side of the instruction line, then select “...”.

   ⇒ “Input Assistant” opens.
4. In the “IoConfig_Globals_Mapping” variable list, select “xStartDrilling1”.

5. Select [OK] to close the dialog.
6. Right-click the center of assignment PIN.
7. Select “Negation” to add a negation to the assignment.

Calling the POU in the PLC_PRG

1. Double-click “PLC_PRG”.
2. Select the first line in “PLC_PRG” and press [F2].
   ⇒ “Input Assistant” opens.
3. Select “Module Calls”.
4. Open “Application”.
5. Open “10 POUs” and select “_01_Assignment_NOT”.
6. Select [OK] to close the dialog.
3.4.5.3.3 Compilation of the project

Before logging-in to the CPU, you need to compile the complete code without any errors.

Select menu “Build ➔ Generate code”.

The result of the compiling is shown in the “Messages” field at the bottom of the screen.

If you skip the compiling and select “Login”, the Automation Builder will automatically trigger compiling in advance to logging-in.

3.4.5.3.4 Saving the project

Select menu “File ➔ Save Project”.

Alternatively, select the save icon in the tool bar.

Alternatively, press [Ctrl] + [S].

3.4.6 Setting up the communication gateway

Setting up of communication parameters

To set up the communication between the PC and the PLC, e.g., for downloading the compiled program, you have to set up the communication parameters.

The IP address of your PC must be in the same class as the IP address of the CPU.

The factory setting of the IP address of the CPU is 192.168.0.10.
The IP address of your PC should be 192.168.0.X. Avoid X = 10 in order to prevent an IP conflict with the CPU.

Subnet mask should be 255.255.255.0.

**Changing of the IP address**

1. Open Windows control panel. Click “Network and Internet ➔ Network and Sharing Center”.

2. Click “Change adapter settings”.

   > If using existing network with several devices, please pay attention on given network rules or contact your system administrator.

3. Right-click “Local Area Connection (Ethernet)” and select [Properties].

5. Enter your desired IP address and subnet mask.
CPU and PC are connected with an Ethernet cable.

1. In the Automation Builder device tree right-click “PLC_AC500_V3”.
2. Select “Communication Settings”.
3. Keep the default value in the IP address of the CPU or type in the current IP address, if differs.

   The standard (default) IP address of the port ETH1 is: 192.168.0.10

4. Select [OK] to implement the IP address.

**Network scan**

If you need to scan the network for the CPU or if you have multiple CPUs on the same network.

1. Right-click “PLC_AC500_V3” in the device tree.
2. Select “Communication Settings”.

3. Select “...”.  
   “Pick IP Address for PLC_AC500_V3” opens.

   The automatic scan runs.  
   The results will appear in this field.

4. Select the CPU in the field and select [OK] to implement the needed communications gateway.

   Checking the communication settings
   If you need to check the communications settings or if you want to see more information about
   the current selected CPU.

1. Double-click “PLC_AC500_V3” in the device tree.
2. Select “Communication Settings”.
   ⇒ The selected IP address is shown.
3. If the IP address is not visible, enter the IP address manually.
4. To test the connection and/or to see the CPU information press [Enter] or click on the black dot next to the PLC figure.

### 3.4.7 Installation and update of the AC500 V3 firmware

The multi download tool can be used to update multiple PLCs with firmware or an application at the same time.

⇒ Chapter 6.6.4 “Multi download tool” on page 4306

#### Firmware update with activated user management

The PLC user management will remain also after a firmware update or downgrade.

Due to a structural change in the PLC user management in firmware version 3.5 there are some limitations when updating the PLC firmware from a version 3.4 or lower to 3.5 or higher with activated user management.

If you update the PLC firmware from version 3.4 or lower to version 3.6 or higher this must be done in two steps. First an update to 3.5 must be done via Automation Builder. Afterwards the firmware can be updated to any later firmware version – either via Automation Builder or via memory card.

The PLC firmware can be updated via Automation Builder.

This is also necessary for commissioning V3 CPUs.

A very new CPU has no pre-installed firmware. To guarantee the authenticity of delivered AC500 firmware, V3 CPUs are delivered with a boot loader only. You need to download a valid firmware to the CPU. After download, the functionality of the CPU is given.

- An Automation Builder project with an AC500 V3 CPU is open.
- CPU is in "stop" mode or shows uPdAtE (update) on the display.
- After update the CPU shows either donE or StoP on the display
For new modules: IP address is set. (The default IP address is 192.168.0.10)

1. Double-click CPU “PLC_AC500_V3”.
2. Select “Version information”.

3. Select “Update Firmware”.
   - While the update process is running, the RUN and ERR LEDs are toggling, i.e., they are flashing alternating.
4. Wait for the PLC to finish the update.

Firmware updates that include “UpdateFW” changes must be performed in two steps:

First, the “UpdateFW” is updated, and once this is done click the update button again to execute the “SystemFW” update.

Note: Firmware updates via memory card automatically cover both updates in one step.

A completed update is indicated by a message on the display. Either done, or Stop.

NOTICE!
Do not disconnect the power supply during the update process! The PLC could be damaged.

→ Stop indicates a restart has been performed by the CPU. When done is displayed sometimes it is necessary to re-boot the CPU manually, e.g., by powering-off. Manual re-boot might be, e.g., for some older CPU versions or if downgrading to an older firmware version according to application settings.

The CPU display shows Stop after re-boot. The update process is finished.
5. If necessary, refresh the version information by switching to another tab and back.

- Successful firmware update:

![Image of PM5650 PLC](image)

**Behavior of LEDs during firmware update**

<table>
<thead>
<tr>
<th>LED</th>
<th>LED flashes</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>RUN and ERR</td>
<td>Toggling</td>
<td>Update pending</td>
</tr>
<tr>
<td>RUN</td>
<td>Flashing slow</td>
<td>Done successful</td>
</tr>
<tr>
<td>ERR</td>
<td>Flashing slow</td>
<td>Done failed</td>
</tr>
</tbody>
</table>

### 3.4.8 Logging in to CPU and downloading the program

Logging-in to the CPU will load the project into the AC500 V3 CPU. The first log-in will also load the hardware set-up.
1. In the Automation Builder menu select “Online ➔ Login [PLC_AC500_V3]”.  
   ⇒ A pop-up will appear.

2. Select [Yes] to download the application to the AC500V3 CPU.

   ⇒ PLC is in "stop" mode.

3. Start the PLC ➔ Chapter 3.4.9.1 “Starting the program execution” on page 51.

   Generally, if the CPU is in RUN mode, i.e. in program execution mode, a download will always cause the mode change to "stop". In stop mode the CPU is not controlling the system!

   Always, after selecting the "Login" command, read carefully the dialog box text to ensure that you are aware of the CPU's behavior after the command confirmation.

By default, a download generates following actions in the CPU:

- The project is stored in the RAM memory.
- The project is stored in the flash EEPROM, if boot application was created.

### 3.4.9 Testing the program

#### 3.4.9.1 Starting the program execution

- You are logged in the CPU.
- An executable project is loaded to the CPU.
The CPU is in "stop" mode.

- Select menu “Debug ➔ Start [PLC_AC500_V3]”. Alternatively, select the "start" icon in the tool bar. Alternatively, press [F5].

3.4.9.2 Testing the function

- Operate the switch I1 and observe:
  - The LEDs of the relevant DA501 inputs and outputs.
  - The online status of inputs and outputs within the POU.

3.4.9.3 Stopping the program execution

- You are logged in the CPU.
- An executable project is loaded to the CPU.
The CPU is in RUN mode.

Select menu “Debug → Stop [PLC_AC500_V3]”
Alternatively, select the “stop” icon in the tool bar.
Alternatively, press [Shift] + [F8].

3.4.10 Setting up a visualization
3.4.10.1 General
If you are not yet familiar with CODESYS visualization, we recommend you to start with the application example First steps with CODESYS visualization. The example demonstrates the main features of visualization and provides insights into possible use cases.

To use the Edge browser for CODESYS visualization of AC500 PLCs, follow the steps described in the application note Usage in the Edge browser.

3.4.10.2 Adding the VisualizationManager

1. Right-click “Application” in the device tree.
2. Select “Add object”.
3. Select “VisualizationManager”.
4. Select [Add object] to add the VisualizationManager to the project.
   ⇒ Dialog “Add Visualization Manager” opens.

5. Select [Add].

⇒ You added the objects “VisualizationManager” and “VISU-TASK” to the device tree.
3.4.10.3 Settin up the VisualizationManager

1. Double-click VisualizationManager in the device tree.

⇒ A tab opens in the editor view.
2. Select “Settings”.
3. Open the drop-down menu “Selected style”.
4. Select “Default, x.x.x” (exemplary).
5. Open the drop-down menu “Selected language”.
8. Keep the file transfer to enable the visualization on the PLC (mandatory for web server function) ◄ Chapter 3.4.12 “Enabling a web visualization” on page 65.

3.4.10.4 Saving the project

Select menu “File ➔ Save Project”.
Alternatively, select the save icon ![save icon] in the tool bar.
Alternatively, press [Ctrl] + [S].
3.4.11 Creation of a visualization

3.4.11.1 General

If you are not yet familiar with CODESYS visualization, we recommend you to start with the application example First steps with CODESYS visualization. The example demonstrates the main features of visualization and provides insights into possible use cases.

To use the Edge browser for CODESYS visualization of AC500 PLCs, follow the steps described in the application note Usage in the Edge browser.

3.4.11.2 Adding a folder for visualization screens

1. Right-click “Application” in the device tree.
2. Select “Add Folder”.
3. Type in "02 VISUs".
4. Select [OK] to add the folder.
3.4.11.3 Adding a screen for "_01_Assignment_NOT" POU

1. Right-click "02 VISUs".
2. Select "Add object".
3. Select object "Visualization".
4. Select [OK].
5. Type in "PLC_VISU".
6. Select [Add].

⇒ A tab opens in the editor view.

*Fig. 5: PLC_VISU_tab*
The name "PLC_VISU" has been chosen, because it is the default name for a home screen in a web visualization.

If you have more than one visualization object in your project, it will be useful to choose another name, e.g., "_01_Assignment_NOT_v". And to choose "PLC_VISU" as a home screen to access all available visualization screens.

The name of a visualization object can be modified afterwards.

3.4.11.4 Creation and configuration of a visualization

3.4.11.4.1 Changing the background color

1. Double-click “PLC_VISU” in the device tree.
   ⇒ A tab opens in the editor view.

2. Right-click anywhere on the "PLC_VISU" editor page.

3. Select “Background”.

4. Enable the check box “Use Color”.
   ⇒ This enables the drop-down menu.

5. Select a color, e.g., “Lightgray”.

6. Select [OK] to add the color to "PLC_VISU".
### 3.4.11.4.2 Adding a screen title

1. Double-click on “PLC_VISU” in the device tree.

![Adding a screen title](image1)

2. Select “ToolBox”.

3. Select “Common controls”.

4. Drag and drop “Label” to the page.

![Adding a screen title](image2)

5. Type in "Start drilling condition”.

### 3.4.11.4.3 Further lines and labels

1. Double-click on “PLC_VISU” in the device tree.

![Further lines and labels](image3)

2. Select “ToolBox”.

3. Select “Basic”.

4. Drag and drop the line. Then drag the line to the needed length.
5. Follow the same procedure to create the other shapes and labels.

### 3.4.11.4.4 Lamp element for signal indication

1. Double-click on “PLC_VISU” in the device tree.

2. Select “ToolBox”.
3. Select “Lamps/Switches/Bitmaps”.
4. Drag and drop “Lamp” to the screen.
5. Adapt the size, if required.


![Diagram of lamp element for signal indication](image-url)
7. Double-click on “Variable” and select “… ” to select a variable from the list.

8. Under “IoConfig_Globals_Mapping”, select “xStartDrilling1”.

9. Select [OK].

3.4.11.4.5 Compilation of the project

Before logging-in to the CPU, you need to compile the complete code without any errors.
Select menu “Build ➔ Generate code”. The result of the compiling is shown in the “Messages” field at the bottom of the screen.

If you skip the compiling and select “Login”, the Automation Builder will automatically trigger compiling in advance to logging-in.

### 3.4.11.4.6 Saving the project

Select menu “File ➔ Save Project”. Alternatively, select the save icon in the tool bar. Alternatively, press [Ctrl] + [S].

### 3.4.11.5 Loading the project to the CPU

1. Download the project to the CPU as described in Chapter 3.4.8, on page 50.
2. Check the notification window at the end of the download. In case of message "Boot parameters were changed. These changes will be applied after reboot", a reboot of the CPU is required after creation of the boot project.
3.4.11.6 Testing the program

Operate the switches and observe the visualization screen.

3.4.12 Enabling a web visualization

3.4.12.1 Adding a web server object to the device tree

Ethernet ports can be configured for web server protocol. This description deals with ETH1 configuration for the web server.

1. Right-click “ETH1” in the device tree.
2. Select “Add object”.
3. Select “Web Server”.

![Automation Builder interface](image)
4. Select [Add object].
   ⇒ You added and activated a web server on Ethernet port 1 on the AC500 V3 CPU.

### 3.4.12.2 Setting up the web server

1. Double-click “WebVisu” in the device tree.

2. Under “Start Visualization”, select “…”.
   ⇒ A list opens.

3. Select the “PLC_VISU” screen from the list.

4. Keep all further settings with default values.
5. Select the link “Show used visualizations”.

The VisualizationManager editor and there the tab “Visualizations” opens. All screens and dialog elements created in the project are visible.

Here, you can select which screens are enabled or disabled for web visualization.

If you want to select another screen as a start visualization, you must modify the adequate parameter in the webvisu.htm file: `<param name="STARTVISU" value="PLC_VISU">`

3.4.12.3 Compilation of the project

Before logging-in to the CPU, you need to compile the complete code without any errors.
Select menu “Build ➔ Generate code”. The result of the compiling is shown in the “Messages” field at the bottom of the screen.

If you skip the compiling and select “Login”, the Automation Builder will automatically trigger compiling in advance to logging-in.

### 3.4.12.4 Saving the project

Select menu “File ➔ Save Project”. Alternatively, select the save icon in the tool bar.
Alternatively, press \[Ctrl\] + \[S\].

### 3.4.12.5 Loading the project to the CPU

1. Download the project to the CPU as described in Chapter 3.4.8, on page 50.
2. Check the notification window at the end of the download. In case of message "Boot parameters were changed. These changes will be applied after reboot", a reboot of the CPU is required after creation of the boot project.
3.4.12.6 Creation of a boot project
By default, after project download, the boot project is created automatically.

3.4.12.7 Reboot of the CPU
Reboot the CPU by switching OFF and ON the power supply. (The parameter for web server activation is a boot parameter which is loaded during boot of the CPU)

3.4.12.8 Testing the web visualization

- You have downloaded the project and created the boot project.
- The CPU has been rebooted.
- You are logged in.
- CPU is in "stop" mode.

1. Start the project execution, e.g., from the tool bar.
2. Launch an internet browser.
   192.168.0.10 is the IP address of CPU's ETH1 port.
   /webvisu.htm is the default htm file.
   ⇒ Web visualization will be loaded.
   The start screen “PLC_VISU” is displayed in a responsive view.

4. Test the function by operating switch I1.
5. Test the results for responsive view by changing the web browser window size.
3.4.13 Reset the CPU

**Reset values and parameters**  In some cases, it could be required to do a CPU reset, e.g., for resetting of counter values, parameters etc.

![Reset commands in "Online" menu](image_url)

**Fig. 6: Reset commands in “Online” menu**

<table>
<thead>
<tr>
<th>Reset command</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset warm</td>
<td>All variables are reset, except RETAIN PERSISTENT variables.</td>
</tr>
<tr>
<td>Reset cold</td>
<td>Causes initialization of all variables, except PERSISTENT variables. By recommended creation of remanent variables always with both properties: PERSISTENT and RETAIN, this command resets all variables, except PERSISTENT RETAIN variables.</td>
</tr>
<tr>
<td>Reset origin</td>
<td>All variables and the application project are reset.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 4: Behavior of variables of type VAR (local or global) and variables of type PERSISTENT RETAIN</th>
</tr>
</thead>
<tbody>
<tr>
<td>After online command 'Online change'</td>
</tr>
<tr>
<td>After online command 'Download'</td>
</tr>
<tr>
<td>After online command 'Reset warm'</td>
</tr>
<tr>
<td>After online command 'Reset cold'</td>
</tr>
<tr>
<td>After online command 'Reset origin'</td>
</tr>
<tr>
<td>After power supply off</td>
</tr>
</tbody>
</table>

**Complete reset of the CPU**  To do a complete reset of the CPU thereby erasing the application from the RAM and flash EEPROM do the following.
1. Right-click the station object “PLC_AC500_V3” in the device tree.

2. Select “Reset origin device [station name]”.
   ⇒ The application is completely erased from the CPU (complete project from all memory areas).

### 3.5 Example project for remote I/O expansion with PROFINET

#### 3.5.1 Purpose

This example introduces the configuration of the PLC with remote I/O. The use of I/O channels in a program and commissioning of the configuration is shown.

#### 3.5.2 Preconditions

- Automation Builder is installed and licensed as, at least, standard edition © Chapter 6.2.4 “Managing your licenses” on page 1350.
- AC500 V3 CPU is assembled and connected to the PC © Chapter 3.3 “Hardware AC500 V3” on page 21.
- Configuration and programming of this example project will be made in the existing example project for central I/O expansion © Chapter 3.4 “Example project for central I/O expansion” on page 24.
- CM579-PNIO communication module is inserted in terminal base and connected to the PLC © Chapter 3.3 “Hardware AC500 V3” on page 21.
- CI502-PNIO communication interface module is inserted in terminal unit and connected to the PLC © Chapter 3.3 “Hardware AC500 V3” on page 21.
3.5.3 Set-up PROFINET controller

3.5.3.1 Add the CM579-PNIO to the device tree

1. In the Automation Builder device tree under “Extension_Bus”, right-click “Slot_1”.
2. Select “Add object”.
3. Select “CM579-PNIO”.
4. Select [Replace object] to add the CM579-PNIO.

3.5.3.2 Set-up the general behavior

   A tab opens in the editor view.
2. Select “CM579-PNIO Parameters”.

Run on configuration fault
Bus behavior
This parameter will prohibit the PLC from running if the CM579-PNIO has a configuration error.
This parameter sets how the data from the bus flows in/out of the CM579-PNIO.

3. Select “Status”.
   ⇒ This opens the bus controller status and gives a basic status overview.

4. Select “Information”.
   ⇒ This page contains general information about the CM579-PNIO.

5. For the example project, you can keep the default settings.

3.5.3.3 Set-up the PROFINET IO controller

To edit settings for the controller, you must not be logged-in to the PLC.

   ⇒ A tab opens in the editor view.

2. Select “PROFINET IO CONTROLLER”
3. Select “General”.

4. Here, you can set-up the way, IP addresses are distributed out to the industrial bus network. You can even set, what IP-address and DNS name (station name) the PROFINET controller has.

   For the example project, keep the default settings.

### 3.5.4 Set-up PROFINET device

#### 3.5.4.1 Hardware preparation

1. Switch off the power supply of your PLC.

2. Use a screw driver to set the CI502 module address to "02" by positioning of the upper rotary switch to "0" and lower switch to "2". Note, that the numbers have hexadecimal format.

3. Switch on the power supply.

#### 3.5.4.2 Add the CI502-PNIO to the device tree

1. Right-click “PNIO_Controller” in the device tree.

2. Select “Add object”.

3. Select “CI502-PNIO-Device”.

4. Select [Add object] to add the device.

3.5.4.3 Configure the CI502-PNIO device

3.5.4.3.1 Configure the CI502-PNIO PROFINET IO device

1. Double-click “CI502_PNIO_Device”.
   - A tab opens in the editor view.
2. Select “General”.

3. Set station name to e.g. “ci502-pn-0b” according to hardware settings.

The last two values of the node’s “Station Name” in Automation Builder correspond to the position of module’s rotary switches (hexadecimal values): e.g., “ci502-pn-0a” or “ci502-pn-10”.

- Use small letters for the station name and not large ones.

4. Leave the default settings for “IP Parameter”.

5. Adjust the communication time settings to get a Watchdog (ms) 24:
   - “Send clock (ms)”: 4
   - “Reduction ratio”: 2
   - “Phase”: 1

6. Leave the default settings for “VLAN ID”.

7. Leave the default settings for “RT Class”.
If the node has the same device address (the last two digits of the device name) as set by means of the rotary switches on the module, all the node parameters will be loaded automatically upon initialization scan of the CI50x module. This allows, e.g., the module exchange without an engineering tool.

3.5.4.3.2 Create CI502-PNIO I/O mapping to symbols

1. Double-click “CI502_IO”.

2. Select “PNIO Module I/O Mapping”.

3. Fill in the variable names:

<table>
<thead>
<tr>
<th>Element</th>
<th>Hardware channel</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch I5</td>
<td>CI502 DI8</td>
<td>xDI_08_CI502_I5</td>
</tr>
<tr>
<td>LED output DO8</td>
<td>CI502 DO 8</td>
<td>xDO_08_CI502</td>
</tr>
</tbody>
</table>
3.5.5 Add remote I/O expansion to project

3.5.5.1 Add a program POU to the project

1. Right-click “01 - POUs” in the device tree.
2. Select “Add object”.
3. Select “POU”.
4. Select [Add object].

5. Fill in "_30_PNIO_test".
6. Select “Program”.
7. Select “Function Block Diagram”.

---

Getting started with example projects
Example project for remote I/O expansion with PROFINET > Add remote I/O expansion to project
8. Select [Add] to add the POU.

### 3.5.5.2 Create a POU logic

1. Double-click “30_PNIO_test” in the device tree.

2. In the ToolBox, select “Assignment”.

3. Drag and drop “Assignment” into the "Start here" field in network "1".

4. Select “???” on the left side of the assignment, then select “...”.

5. In “IoConfig_Globals_Mapping” list, select “xDI_08_CI502_15”.

6. Select [OK] to add this variable to the left side of the assignment connector.
7. Select “???” on the right side of the assignment, then select “...”.
8. In “IoConfig_Globals_Mapping” list, select “xDO_08_CI502”.
9. Select [OK].

3.5.5.3 Call the POU in PLC_PRG
1. Double-click “PLC_PRG”.
2. Select the next free line in “PLC_PRG” and press [F2].
   ⇒ “Input Assistent” opens.
3. Select “Module Calls”.
4. Open “Application”.
5. Open “10 POUs” and select “_30_PNIO test”.
6. Select [OK] to close the dialog.

3.5.5.4 Compilation of the project
Before logging-in to the CPU, you need to compile the complete code without any errors.
Select menu “Build ➔ Generate code”. The result of the compiling is shown in the “Messages” field at the bottom of the screen.

If you skip the compiling and select “Login”, the Automation Builder will automatically trigger compiling in advance to logging-in.

3.5.5.5 Saving the project

Select menu “File ➔ Save Project”. Alternatively, select the save icon in the tool bar. Alternatively, press [Ctrl] + [S].

3.5.5.6 Loading the project to the CPU

1. Download the project to the CPU as described in Chapter 3.4.8, on page 50.
2. Check the notification window at the end of the download. In case of message "Boot parameters were changed. These changes will be applied after reboot", a reboot of the CPU is required after creation of the boot project.
3.5.6 Test the program

3.5.6.1 Starting the program execution

- You are logged in the CPU.
- An executable project is loaded to the CPU.
- The CPU is in "stop" mode.

Select menu “Debug ➔ Start [PLC_AC500_V3]”. Alternatively, select the "start" icon in the tool bar. Alternatively, press [F5].

3.5.6.2 Test the function

- Operate the switch I5 and observe:
  - The LEDs of the relevant CI502 inputs and outputs.
  - The online status of inputs and outputs within the POU.
3.5.7 Reset the CPU

**Reset values and parameters** In some cases, it could be required to do a CPU reset, e.g., for resetting of counter values, parameters etc.

![Reset commands in "Online" menu](image)

**Fig. 7: Reset commands in "Online" menu**

- **Reset warm**
  All variables are reset, except RETAIN PERSISTENT variables.

- **Reset cold**
  Causes initialization of all variables, except PERSISTENT variables. By recommended creation of remanent variables always with both properties: PERSISTENT and RETAIN, this command resets all variables, except PERSISTENT RETAIN variables.

- **Reset origin**
  All variables and the application project are reset.

**Table 5: Behavior of variables of type VAR (local or global) and variables of type PERSISTENT RETAIN**

<table>
<thead>
<tr>
<th></th>
<th>VAR</th>
<th>VAR PERSISTENT RETAIN</th>
</tr>
</thead>
<tbody>
<tr>
<td>After online command 'Online change'</td>
<td>no change</td>
<td>no change</td>
</tr>
<tr>
<td>After online command 'Download'</td>
<td>initialization</td>
<td>no change</td>
</tr>
<tr>
<td>After online command 'Reset warm'</td>
<td>initialization</td>
<td>no change</td>
</tr>
<tr>
<td>After online command 'Reset cold'</td>
<td>initialization</td>
<td>no change</td>
</tr>
<tr>
<td>After online command 'Reset origin'</td>
<td>initialization</td>
<td>initialization</td>
</tr>
<tr>
<td>After power supply off</td>
<td>initialization</td>
<td>no change</td>
</tr>
</tbody>
</table>

**Complete reset of the CPU**

To do a complete reset of the CPU thereby erasing the application from the RAM and flash EEPROM do the following.
1. Right-click the station object “PLC_AC500_V3” in the device tree.
2. Select “Reset origin device [station name]”.
   ⇒ The application is completely erased from the CPU (complete project from all memory areas).
4 System overview, planning and operation

4.1 System overview

4.1.1 AC500 PLC product family

AC500 programmable logic controllers (PLCs)

The AC500 (Standard), AC500-eCo, AC500-S and AC500-XC scalable PLC ranges provide solutions for small, medium and high-end applications. Our AC500 platform offers different performance levels and is the ideal choice for high availability, extreme environments or safety solutions. Our AC500 PLC platform offers interoperability and compatibility in hardware and software from compact PLCs up to high-end and safety PLCs.

Due to the flexible combinations of AC500 devices and components, AC500 PLCs can be used for controlling a wide variety of applications to fulfill your automation needs.

Features of AC500 PLCs

- Scalable and consistently expandable system
- Different performance classes of processor modules (CPUs) available
- Several fieldbusses available
- Parallel connection to several fieldbusses which can be combined arbitrarily

The AC500 product family consists of the product groups:

- AC500 (Standard): AC500 standard PLCs offer a wide range of performance levels and scalability. The PLCs are highly capable of communication and extension for flexible application.
- AC500-eCo: AC500-eCo PLCs are cost-effective, high-performance compact PLCs that offer total interoperability with the core AC500 range and provide battery-free buffering of remanent data. All I/O modules can be freely connected in a simple, stable and reliable manner.
- AC500-S: AC500-S PLCs are designed for safety applications in factory, process or machine automation.
- AC500-XC: AC500 (Standard) and AC500-S provide devices with -XC extension as a product variant. These variants operate according to their product group and can, in addition, be operated under extreme conditions. AC500-XC PLCs can be used at high altitudes, extended operating temperature and in humid conditions. The devices also provide a high level of resistance to vibration and corrosive gases. The AC500-XC series is consistent with standard devices concerning the overall dimensions, the control function and the software compatibility.

Chapter 5.1.3 “System data AC500-XC” on page 169.
The AC500 product family is characterized by functional modularity. As the complete AC500 product family shares the same hardware platform and programming software tool, the devices of the AC500 product groups can be flexibly combined.

S500 devices represent the I/O modules of the product group AC500 (Standard), whereas S500-eCo devices represent the I/O modules of the product group AC500-eCo. Both S500 and S500-eCo devices can be flexibly combined with devices of the AC500 product family.

4.1.2 AC500/S500 system structure

The AC500 product family provides a variety of modules and pluggable components for expanding the capabilities of the processor module with additional I/Os or other communication protocols. Depending on the features and functions of the processor module (CPU) compatible components can be added to a complete AC500 PLC system.

Centralized I/O extension

- Terminal base for processor module and 0 to 6 communication modules, with serial and Ethernet interfaces
- Communication module for, e.g., PROFIBUS, EtherCAT, and for support of safety solution
- Processor module with integrated communication
- I/O module, up to 10 I/O modules can be connected
- Terminal unit for I/O modules, also for decentralized extension
Decentralized I/O extension

1 Terminal unit for communication interface modules
2 Communication interface module with up to 24 integrated I/Os
3 I/O bus
4 Terminal unit for I/O modules, with screw or spring connection
5 Terminal unit for hot swap of I/O modules to exchange of I/O modules while the system is running
6 S500 I/O modules with up to 32 channels for analog and/or digital signals
7 Compact S500-eCo I/O modules with up to 16 channels for analog and/or digital signals
8 Removable terminal blocks

4.1.3 AC500-eCo/S500-eCo system structure

AC500-eCo/S500-eCo series is compatible with AC500/S500.

The compact AC500-eCo processor module can be used for small applications with the integrated I/O channels.

The functionality of the processor modules can be extended with option boards, e.g., for additional I/O channels.

For larger applications, I/O modules can be connected centralized or decentralized.
1 AC500-eCo processor module with option boards, different memory sizes, inputs and outputs available
2 S500-eCo I/O module, up to 10 I/O modules can be connected, also for decentralized extension
3 Terminal blocks in different variants available

Centralized I/O extension
Processor modules with an I/O bus interface on the right side can be expanded by up to 10 I/O modules to increase the number of the I/O channels.

Decentralized I/O extension
Up to 10 I/O modules can be connected remotely with the onboard Ethernet interface. Usually, a Modbus/TCP communication interface module or a processor module is used for the decentralized I/O extension.

Fig. 8: I/O modules (S500-eCo) directly connected to an AC500-eCo processor module
4.1.4 AC500/S500: Short description hardware

Processor modules

AC500 processor modules contain the CPU with the core component of the PLC. The CPU is connected with the user memory, input and output module, communication port and other units via the system bus and performs tasks by means of system programs preset in the system memory. The CPU adopts the function preset by the application program to command the PLC for operation.

It has the following functions:

- To receive user programs and data entered
- To diagnose work faults of the power supply and PLC circuit as well as syntax errors in programming
- To receive the state or data of the site via the input interface and save it into the shadow register or data register
- To read the user programs in the memory one by one and execute them after interpretation
- To updating the state of the associated flag bits and the contents of the shadow register according to the execution results and providing output control using the output unit.

Processor modules are available in different performance classes. Only one processor module is required for a valid system architecture.

There are different types of processor module available that differ in the features and functions they provide, e.g. performance, LED display etc.

If required, processor modules are also available with an integrated Ethernet communication module (TCP/IP).

Communication modules
AC500 communication modules are required for
- a connection to standard fieldbus systems and
- for integration into existing networks.

AC500 communication modules
- enable communication on different fieldbuses.
- are mounted on the left side of the processor module on the same terminal base.
- are directly powered via the internal communication module bus of the terminal base.
  A separate voltage source is not required.

Terminal bases

The terminal base is needed for mounting and connecting the processor module and the communication modules. The modules are plugged on the terminal base.
I/O modules

The I/O modules are the input/output unit which connects the PLC with the process. The PLC can detect controlled object data via the input interface and the data is taken as the basis for PLC control on the controlled object. In addition, the PLC sends processing results via the output interface to the controlled object to execute the control.

External input equipment and output equipment needs various signal levels whereas the information processed by the processor module in the PLC can only be the standard level. In order to perform this conversion, the I/O interface generally uses optical isolation and filtering to improve the interference immunity of the PLC. In addition, the I/O interface can generally indicate the working state to facilitate maintenance.

The PLC provides multiple I/O interfaces for operation level and drive capability to users for selection such as digital input, digital output, analog input, analog output, etc. I/O interfaces of the PLC interpret the number of input/output signals as the number of PLC I/O points. The number of I/O points is an important basis for PLC selection. If the system has insufficient I/O points, it can be expanded via the I/O extension interface of the PLC.

The I/O modules for digital and/or analog inputs and outputs are available in different versions and allow flexible use thanks to configurable channels.

The modules can be simply plugged onto a terminal unit for a centralized or decentralized I/O extension via communication interface modules.

Terminal units

I/O modules and function modules are plugged on a terminal unit.

Terminal units enable simple prewiring without electronics and are available for 24 V DC and 120/230 V AC, optionally for spring or screw-type terminals.
Communication interface modules are used to build decentralized I/O stations in decentralized systems. They contain the fieldbus interface and a set of onboard I/O channels. Additional I/O modules can be attached to build larger decentralized I/O stations. A communication interface module is mounted on a terminal unit.

Function modules extend the PLC system to perform special task control. These modules often provide independent components such as a CPU, system programs, memory and interfaces connected with the PLC system bus.

Function modules are connected with the PLC via the I/O bus to exchange data and independently work under cooperative management of the PLC.

Memory

In the PLC, the memory is mainly used for saving system programs, user programs and work data. There are two types of memory:

- Volatile memory:
  All saved data will be lost after power failure of the memory but the memory can provide a high access rate and unlimited programming cycles. Common volatile memories mainly include SRAM and DRAM (including common memories such as SDRAM).

- Nonvolatile memory:
  All saved data will not be lost after power failure of the memory, but the memory is subject to a low read-write rate and limited rewrite cycles. Common nonvolatile memories mainly include NORflash, NANDflash, EEPROM, memory card, etc.

AC500 PLCs store all user programs in the nonvolatile memory to protect them from power failure. The programs are exported to the volatile memory during operation of the PLC to ensure high-speed and efficient operation. If user program debugging is finished, the programs can be fixed in the nonvolatile memory when they need no change. The work data is subject to frequent change and access during the PLC operation. It is saved in the volatile memory to meet the requirements for random access.

The work data memory of the PLC has the memory area for input and output relay, auxiliary relay, timer, counter and other logic devices. The state of these devices depends on initial setting and operation of the user programs. Some data maintains its existing state by using built-in supercapacitors or backup batteries in the event of a power failure. The memory area for data saving in the event of a power failure is called the data retention area.

Power supply

The PLC is equipped with a switching power supply for the internal supply. In comparison with an ordinary power supply, the switching power supply has a higher stability and a higher noise immunity.

Some modules include a stabilized power supply for the supply of external sensors.
4.1.5 AC500-eCo/S500-eCo: Short description hardware

Processor modules

AC500-eCo processor modules contain the CPU with the core microprocessor of the PLC. It is integrated with power supply, onboard I/Os and communication interface.

Functions:
- To download user programs
- To run the CPU
- To execute user programs in loops
- To monitor program input and output devices.

Processor modules are available in different performance classes and provide different numbers of onboard I/Os.

Only one processor module is required for a valid system architecture.

Option boards

AC500-eCo processor modules can be extended with option boards. Option boards provide specific functionality. According to the processor module type, up to three option board slots are available for extension. Each option board slot supports most existing types of option board module. The option board modules provide the following functionality for processor module extension:
- Serial interface RS232 (isolated) or RS485 (isolated or not isolated)
- Digital I/O channels extension (digital inputs, digital outputs, or mixed type)
- Analog I/O channels extension (analog inputs, analog outputs) for standard signal voltage or current, but also temperature measurement with RTD/NTC or thermocouple sensors
- RTC real-time clock board for processor module PM5012 (other processor modules include RTC functionality)
- Configuration address switch board for KNX protocol, only for processor modules PM5072 and PM5082
If the number of onboard I/Os provided on the processor module is insufficient for a certain use case, the PLC can be expanded with I/O modules to meet the control requirements.

Memory

In the PLC, the memory is mainly used for saving system programs, user programs and work data. There are two types of memory:

- **Volatile memory:**
  All saved data will be lost after power failure of the memory but the memory can provide a high access rate and unlimited programming cycles. Common volatile memories mainly include SRAM and DRAM (including common memories such as SDRAM).

- **Nonvolatile memory:**
  All saved data will not be lost after power failure of the memory, but the memory is subject to a low read-write rate and limited rewrite cycles. Common nonvolatile memories mainly include NORflash, NANDflash, EEPROM, memory card, etc.

AC500 PLCs store all user programs in the nonvolatile memory to protect them from power failure. The programs are exported to the volatile memory during PLC operation to ensure high-speed and efficient operation. If user program debugging is finished, the programs can be fixed in the nonvolatile memory when they need no change. The work data is subject to frequent change and access during PLC operation. It is saved in the volatile memory to meet the requirements for random access.

The work data memory of the PLC has the memory area for input and output relay, auxiliary relay, timer, counter and other logic devices. The state of these devices depends on initial setting and operation of the user programs. Some data maintains its existing state by using built-in supercapacitors or backup batteries in the event of a power failure. The memory area for data saving in the event of a power failure is called the data retention area.

Power supply

The PLC is equipped with a switching power supply for the internal supply. In comparison with an ordinary power supply, the switching power supply has a higher stability and a higher noise immunity.

Some modules include a stabilized power supply for the supply of external sensors.

4.1.6 AC500-S

The **AC500-S safety user manual** must be read and understood before using the safety configuration and programming tools of Automation Builder/PS501 Control Builder Plus. Only qualified personnel are permitted to work with AC500-S safety PLCs.

The AC500-S safety PLC includes the following safety-relevant hardware components.

- SM560-S/SM560-S-FD-1/SM560-S-FD-4
- DI581-S
4.1.7 CP600 control panels

The CP600-eCo, CP600 and CP600-Pro control panels offer a wide range of features and functionalities for tailor-made visualization. Our CP600 platform offers different performance levels including control panels for economic applications, robust standard operator panels, high end multi-touch human machine interfaces (HMIs).

The easy to use engineering tool PB610 Panel Builder 600, part of Automation Builder, ensures easy scalability on the CP600 platform.

- CP600-eCo: The economical CP600-eCo control panel, with screen sizes from 4.3” to 10.1” widescreen, is aimed for standard functions and high usability for clear interaction with the operation process.
- CP600: The robust CP600 HMI, with screen sizes from 7” to 15” provides up-to-date visualization performance, versatile communication and representative design for machines and systems.
- CP600-Pro: The CP600-Pro HMI, with screen sizes from 5” to 21.5” widescreen, comes with high end visualization performance, multi-touch operation and versatile communication options.

Further information on page 6

4.1.8 Automation Builder: Short description engineering software

Details about the Automation Builder license model, the features of the editions and the latest license information

Configuration and programming of all AC500 control systems (processor modules) is done by using Automation Builder software.

Features:

- Standardized programming according to IEC 61131-3, five programming languages (Structured Text (ST), Function Block Diagram (FBD), Instruction List (IL), Ladder Diagram (LD), Sequential Function Chart (SFC)), Continuous Function Chart (CFC), debugging functions for program test
- Online diagnosis
- Debugging functions for the program test: Single step, single cycle, breakpoint
- Offline simulation - simulate commands without PLC being connected
- Sampling trace - timing diagrams for process variables
- Recipe management and watch lists
- Visualization
- Configuration of the communication interface modules (for PROFINET, PROFIBUS, EtherCAT, CANopen, Ethernet, Modbus)
- Programming - serial or via Ethernet networks
- Comprehensive libraries
- Export and import interfaces for devices, signals, applications, visualization, etc.
- Multi-user support and project compare
- Project scripting

IEC 61131-3 commands can be simulated without a PLC being connected, including the relevant malfunctions. After the program test, the application can be downloaded to the control system.

Timing diagrams for process variables and storage of data in a circular buffer with event trigger.

Values of selected variables are displayed. Pre-defined values can be assigned to variables which can then be downloaded to the control system all at once ("Write recipe"). Actual values from the control system can also be pre-assigned for reading into the Watch and Recipe Manager, and stored in memory there ("Read recipe"). These functions are also helpful, for example, for setting and entering control parameters.

Includes color change, moving elements, bitmaps, text display, allows input of setpoint values and display of process variables read from the PLC, dynamic bar diagrams, alarm and event management, function keys and ActiveX elements.

The Ethernet interface of the processor modules is used to connect to the engineering software for programming, debugging and diagnosis.

Provides access from the programming system to an external project database in which the program source code of one or several automation projects is managed. Optionally, a version control system can be used in order to ensure data consistency of the program code for several different users and projects.
4.2 Application planning

4.2.1 Safety instructions

NOTICE!
Wiring diagrams and user programs must be designed to prevent hazardous situations from occurring during normal operation or in the event of a malfunction.

4.2.2 Processor module and I/O selection

How to select modules for your automation task: In our main catalog we offer a CPU selector and several comparative tables to find the modules for your application.

4.2.3 I/O bus - Communication within the PLC

The synchronized I/O bus is the I/O data bus for the I/O modules connected with the processor modules or communication interface modules. Through this bus, I/O and diagnosis data are transferred.

With its fast data transmission, the I/O bus obtains very low reaction times.

Up to 10 I/O terminal units (for one I/O module each) can be added to one terminal base or to one AC500-eCo processor module. The I/O terminal units and the AC500-eCo I/O modules, have a bus input at the left side and a bus output at the right side. Thus the length of the I/O bus increases with the number of attached I/O modules. Table 119 “Maximum number of I/O devices which can be connected to the I/O bus” on page 389.

1 I/O bus connection

The connection of the I/O bus is performed automatically by telescoping the modules on the DIN rail. The I/O bus provides the following signals:

- Supply voltage of 3.3 V DC for feeding the electronic interface components
- 3 data lines for the synchronized serial data exchange
- several control signals
NOTICE!
Except when using hot swap terminal units, the I/O bus is not designed for pulling and plugging modules during operation. If a module is pulled or plugged on a terminal unit that is not hot swap capable while the bus is running, the following consequences are possible
- reset of the station or of the processor module
- system lockup
- damage of the module

WARNING!
Removal/Insertion under power
Removal or insertion under power is permissible only if all conditions for hot swapping are fulfilled.

☞ Chapter 4.9.3 “Replace an I/O module with hot swap” on page 153

The devices are not designed for removal or insertion under power when the conditions for hot swap do not apply. Because of unforeseeable consequences, it is not allowed to plug in or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you
- connect or disconnect any signal or terminal block
- remove, mount or replace a module.

Disconnecting any powered devices while they are energized in a hazardous location could result in an electric arc, which could create an ignition source resulting in fire or explosion.

Prior to proceeding, make sure that power is been disconnected and that the area has been thoroughly checked to ensure that flammable materials are not present.

The devices must not be opened when in operation. The same applies to the network interfaces.

Profibus (master and slave) and CM589-PNIO are available since version 2.5.0 of the Automation Builder.

4.2.4 Fieldbus connectivity options

The PLC and control panel portfolio offers a wide range of scalable products, communication protocols and connectivity options, from the field level to the management and visualization levels.

An overview of the different connectivity options can be found below.
Fig. 10: Exemplary networking

**IT network/internet**
- FTP(S)  
  - Chapter 6.3.4.5 “FTP server” on page 1721
- HTTP(S)  
  - Chapter 6.5.5 “Application libraries” on page 3833
- MQTT  
  - Chapter 6.3.4.6 “MQTT client protocol” on page 1722
- NTP/SNTP  
  - Chapter 6.3.4.4.1 “Introduction of the NTP/SNTP protocol” on page 1716
- OPC UA  
  - Chapter 6.3.4.11 “OPC UA” on page 1750
- SMTP(S)  
  - Chapter 6.6.10 “SNMP” on page 4362

**Factory/side network**
- BACnet  
  - Chapter 6.3.4.9 “BACnet-BC” on page 1733
- DNP3 (in preparation)
- FTP(S)  
  - Chapter 6.3.4.5 “FTP server” on page 1721
- HTTP(S)  
  - Chapter 6.5.5 “Application libraries” on page 3833
- IEC 60870-5-104  
  - Chapter 6.3.4.1 “IEC60870-5-104 (Telecontrol)” on page 1647
- IEC 61850  
  - Chapter 6.3.4.2 “IEC 61850 Server” on page 1671
- KNX  
  - Chapter 6.3.4.8 “KNX configurator” on page 1730
4.2.5 Power supply dimensioning

4.2.5.1 General

The power consumption of a complete station consists of the sum of all individual consumptions.

The two supply voltages with 24 V DC are distinguished in the AC500 platform:

- Supply of the internal logic via terminals L+ and M on the CPU module, or an the AC500 terminal base for: CPU, communication module(s) and I/O bus.
- Supply of the process-side input/output circuits for analog signals and 24 V DC digital signals via the ZP and UP terminals of the S500 terminal units.

The two supply voltages can be provided by the same power supply unit. The CPU and the I/O modules should, however, be fused separately. Of course also separate power supplies are possible.
4.2.5.2 Calculation of the total current consumption

Example

In the example, the AC500 control system consists of the following devices:

- AC500 CPU with Ethernet interface
- 4 communication modules
- 7 I/O modules (digital and analog)
- As well as the required terminal bases and terminal units

Because of the high total current consumption of the digital I/O modules (from \( UP = 24 \text{ V DC} \)), the supply is divided up into several electric circuits fused separately.

The maximum permitted total current over the supply terminals of the I/O terminal units is 8 A.

The total current can be calculated as follows:

\[
I_{\text{Total}} = I_{L^+} + I_{UP}
\]

with the assumptions

\[
I_{L^+} = I_{\text{CPU}} + I_{I/O \text{ bus}} + I_{C_1} + I_{C_2} + I_{C_3} + I_{C_4} \quad \text{(CPU + communication modules + I/O bus)}
\]

\[
I_{I/O \text{ bus}} = \text{Number of expansion modules} \times \text{Current consumption through the I/O bus per module}
\]

and

\[
I_{UP} = I_{UP1} + I_{LOAD1} + I_{UP2} + I_{LOAD2} + I_{UP3} + I_{LOAD3} + I_{UP4} + I_{LOAD4} + I_{UP5} + I_{LOAD5} + I_{UP6} + I_{LOAD6} + I_{UP7} + I_{LOAD7}
\]
If one assumes that all outputs are switched on and are operated with their maximum permitted load currents (under compliance with the maximum permitted currents at the supply terminals), then the following values are the result for an example shown above:

<table>
<thead>
<tr>
<th>CPU/communication module part</th>
<th>(I_{CPU} ) (*)</th>
<th>(I_{Cx} ) (*)</th>
<th>(I_{IO _bus} ) (*)</th>
<th>(I_{UPx} ) (*)</th>
<th>(I_{LOADx} ) (*)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>0.110 A</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>C1</td>
<td>-</td>
<td>0.050 A</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>C2</td>
<td>-</td>
<td>0.085 A</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>C3</td>
<td>-</td>
<td>0.050 A</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>C4</td>
<td>-</td>
<td>0.050 A</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>I/O module part</th>
<th>(I_{CPU} ) (*)</th>
<th>(I_{Cx} ) (*)</th>
<th>(I_{IO _bus} ) (*)</th>
<th>(I_{UPx} ) (*)</th>
<th>(I_{LOADx} ) (*)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog1</td>
<td>-</td>
<td>-</td>
<td>0.002 A</td>
<td>0.150 A</td>
<td>-</td>
</tr>
<tr>
<td>Analog2</td>
<td>-</td>
<td>-</td>
<td>0.002 A</td>
<td>0.150 A</td>
<td>0.160 A</td>
</tr>
<tr>
<td>Analog3</td>
<td>-</td>
<td>-</td>
<td>0.002 A</td>
<td>0.100 A</td>
<td>0.080 A</td>
</tr>
<tr>
<td>Analog4</td>
<td>-</td>
<td>-</td>
<td>0.002 A</td>
<td>0.100 A</td>
<td>0.080 A</td>
</tr>
<tr>
<td>Digital1</td>
<td>-</td>
<td>-</td>
<td>0.002 A</td>
<td>0.050 A</td>
<td>8.000 A</td>
</tr>
<tr>
<td>Digital2</td>
<td>-</td>
<td>-</td>
<td>0.002 A</td>
<td>0.050 A</td>
<td>8.000 A</td>
</tr>
<tr>
<td>Digital3</td>
<td>-</td>
<td>-</td>
<td>0.002 A</td>
<td>0.050 A</td>
<td>8.000 A</td>
</tr>
<tr>
<td>Σ columns</td>
<td>0.110 A</td>
<td>0.235 A</td>
<td>0.014 A</td>
<td>0.650 A</td>
<td>24.320 A</td>
</tr>
</tbody>
</table>

\[ Σ \, I_{L+} ≈ 0.4 \, A \]

\[ Σ \, I_{UP} ≈ 25 \, A \]

\[ I_{Total} ≈ 25.4 \, A \]

*) All values in this column are exemplary values

### 4.2.5.3 Dimensioning of the fuses

To be able to select the fuses for the station correctly, both the current consumption and the inrush currents (melting integral for the series-connected fuse) must be taken into consideration.

<table>
<thead>
<tr>
<th>Fuse</th>
<th>for</th>
<th>Σ of the melting integrals in A²s</th>
<th>(I_{L+} ) A</th>
<th>(I_{UPx} ) A</th>
<th>Recommended fuse</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Type</td>
</tr>
<tr>
<td>F1</td>
<td>CPU logic</td>
<td>1.000</td>
<td>≈ 0.4</td>
<td>-</td>
<td>Quick</td>
</tr>
<tr>
<td>F2</td>
<td>Module Digital1</td>
<td>0.005</td>
<td>-</td>
<td>8.050</td>
<td>Quick</td>
</tr>
<tr>
<td>F3</td>
<td>Module Digital2</td>
<td>0.008</td>
<td>-</td>
<td>8.050</td>
<td>Quick</td>
</tr>
<tr>
<td>F4</td>
<td>Module Digital3</td>
<td>0.007</td>
<td>-</td>
<td>8.050</td>
<td>Quick</td>
</tr>
<tr>
<td>F5</td>
<td>Modules Analog1 +</td>
<td>0.130</td>
<td>-</td>
<td>0.820</td>
<td>Quick</td>
</tr>
<tr>
<td></td>
<td>Analog2 + Analog3 +</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Analog4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
4.2.6 Libraries, software packages and licensed features

Many applications are included in the Automation Builder. However, there are some that need to be purchased additionally. The applications are briefly introduced here. If applicable, links lead to further information depending on the version.

**HA-Modbus TCP library**
Library package adds High Availability System functionality for redundant hot standby over Ethernet field network via HA-Modbus TCP.

☞ Chapter 6.5.9.1 “HA-Modbus TCP - System technology” on page 3859

**61850 protocol**
Adds engineering tool and library for 61850 Ed.1 MMS server and GOOSE publish and subscribe functionalities.

☞ Chapter 6.3.4.2 “IEC 61850 Server” on page 1671

**KNX protocol**
Engineering and protocol package that seamlessly integrates ETS and Automation Builder.

☞ Chapter 6.3.4.8 “KNX configurator” on page 1730

**BACnet-BC protocol**
BACnet is a standardized data communication protocol for building automation and control networks as defined in the ANSI/ASHRAE standard 135 and ISO 16484-5.

☞ Chapter 6.3.4.9 “BACnet-BC” on page 1733

**Data logger library**
The data logging function block library ("DataLogger" and "DataLoggerEco") contains 5 function blocks for the purpose of advanced time-stamped data logging for different use cases.

☞ Chapter 6.5.8 “Data Logger Library” on page 3849

**Motion control library**
Library package for decentralized, centralized and coordinated motion according to the PLCopen standard.

☞ Chapter 6.5.10.3 “Motion control library” on page 3958

**EtherNet/IP**
EtherNet/IP is used to connect any number of different terminals in a network, using a scanner-adapter relationship.

☞ Chapter 6.4.2.5.1 “Introduction” on page 2816

<table>
<thead>
<tr>
<th>Table 6: AC500 runtime licenses</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>For</strong></td>
</tr>
<tr>
<td>all AC500 CPUs</td>
</tr>
<tr>
<td>all AC500 V3 CPUs and AC500-eCo V3 PM5072 and PM5082</td>
</tr>
<tr>
<td>all AC500 V3 CPUs and AC500-eCo V3 PM5072 and PM5082</td>
</tr>
<tr>
<td>all AC500 V3 CPUs and AC500-eCo V3 PM5072 and PM5082</td>
</tr>
<tr>
<td>For</td>
</tr>
<tr>
<td>----------------------------</td>
</tr>
<tr>
<td>all AC500 V3 CPUs</td>
</tr>
<tr>
<td>AC500-eCo V3 PM5072 and PM 5082</td>
</tr>
<tr>
<td>all AC500 V3 CPUs and AC500-eCo V3 PM5032 and higher</td>
</tr>
<tr>
<td>AC500 V3/AC500-eCo V3 (for PM5032, PM5052, PM5072, PM5082 and PM56xx)</td>
</tr>
<tr>
<td>AC500-eCo V3 (for PM5032, PM5052, PM5072 and PM5082)</td>
</tr>
<tr>
<td>AC500 V3/AC500-eCo V3 (for PM5032, PM5052, PM5072, PM5082 and PM56xx)</td>
</tr>
<tr>
<td>AC500-eCo V3 (for PM5032, PM5052, PM5072 and PM5082)</td>
</tr>
</tbody>
</table>

For using runtime licensed features one license per CPU is required. The license has to be installed on the AC500 V3 CPU either by connecting it to Automation Builder or via memory card that has been prepared by Automation Builder for license activation.

The licenses can be transferred between AC500 V3 CPUs unlimited times.

* Chapter 6.3.2.2.2 “PLC runtime licensing” on page 1446

**Activating a runtime license**

The linked application note provides step-by-step instructions on how to activate the runtime license for the PLC.

**AC500 V3 Activating a runtime license**

Additional libraries and software packages for specific use cases are available to reduce the programming effort and implement quickly your application. In our main catalog we offer an overview of the available libraries and software packages.

* Chapter 6.5 “Libraries and solutions” on page 3773

### 4.3 Mechanical planning and installation

#### 4.3.1 Control cabinet assembly (indoor use)
NOTICE!
PLC damage due to incorrect housing
Due to their construction (degree of protection IP 20 according to EN 60529) and their connection technology, the devices are only suitable for operation in closed control cabinets.

The cabinet must be suitable to protect the equipment from the following:
- unauthorized access,
- dusting and contamination,
- humidity and moisture and
- mechanical damage,

The equipment must be operated within the specified mechanical and environmental conditions.

Maintain spacing from:
- enclosure walls
- wireways
- adjacent equipment

Allow a minimum of 20 mm clearance on all sides. This provides ventilation and galvanic isolation.

It is recommended to mount the modules on an grounded mounting plate, or an grounded DIN rail, independent of the mounting location.

Fig. 11: Exemplary figure: left side AC500, right side AC500-eCO
1 Cable duct
2 Distance from cable duct ≥20 mm
3 Mounting plate, grounded
4 Screw end-stop clamps recommended to avoid movement of the modules on the DIN rail
NOTICE!
Horizontal mounting is highly recommended.
Vertical mounting is possible, then derating must be considered to avoid overheating due to poor air circulation. See Chapter 5.1.2.1 “Environmental conditions” on page 166.

When horizontal mounted, end-stop clamps are recommended to secure the modules in case of shock or vibration.
When vertically mounted, always place an end-stop clamps on the bottom and on the top of the modules to properly secure the modules.

4.3.2 Mounting and demounting - general information

The control system is designed to be mounted to a well-grounded mounting surface such as a metal panel. Additional grounding connections from the mounting tabs or DIN rail (if used), are not required unless the mounting surface cannot be grounded.

During panel or DIN rail mounting of all devices, be sure that all debris (metal chips, wire strands, etc.) is kept from falling into the controller. Debris that falls into the controller could cause damage while the controller is energized.

All devices are grounded through the DIN rail to chassis ground. Use zinc plated yellow-chromate steel DIN rail to assure proper grounding. The use of other DIN rail materials (e.g. aluminium, plastic, etc.) that can corrode, oxidize, or are poor conductors, can result in improper or intermittent grounding.

Consider the safety instructions
In the description, special attention must be paid to designs using galvanic isolation, grounding and EMC measures for the reasons stated. Consider the safety instructions for AC500 product family.
4.3.3 Mounting and demounting the terminal base

Mounting and demounting on DIN rail

1. Mount DIN rail 7.5 mm or 15 mm.
2. Mount the terminal base/function module terminal base:

   - The terminal base is put on the DIN rail above and then snapped-in below.

3. The demounting is carried out in a reversed order.

Mounting with screws

If the terminal base should be mounted with screws, wall mounting accessories TA526 must be inserted at the rear side first. Chapter 5.2.8.2.5 “TA526 - Wall mounting accessory” on page 1324. These plastic parts prevent bending of the terminal base while screwing on. TB560x and TB561x need one TA526, TB562x, TB564x and TB566x need two TA526.
By wall mounting, the terminal base is grounded through the screws. It is necessary that
- the screws have a conductive surface (e.g. steel zinc-plated or brass nickel-plated)
- the mounting plate is grounded
- the screws have a good electrical contact to the mounting plate

**Practical tip**

The following procedure allows you to use the mounted modules as a template for drilling holes in the panel. Due to module mounting hole tolerance, it is important to follow these procedures:

1. On a clean work surface, mount no more than 3 modules (e.g. one terminal base and two terminal units).
2. Using the mounted modules as a template, carefully mark the center of all module-mounting holes on the panel.
3. Return the mounted modules to the clean work surface, including any previously mounted modules.
4. Drill and tap the mounting holes for the screws (M4 or #8 recommended).
5. Place the modules back on the panel and check for proper hole alignment.
6. Attach the modules to the panel using the mounting screws.

If mounting more modules, mount only the last one of this group and put the others aside. This reduces remounting time during drilling and tapping of the next group.

7. Repeat the steps for all remaining modules.
4.3.4 Mounting and demounting the AC500 processor module

1. After mounting the terminal base on the DIN rail, mount the processor module.

2. Press the processor module into the terminal base until it locks in place.

3. The demounting is carried out in a reversed order. Press above and below, then remove the processor module.

4.3.5 Mounting and demounting the communication module

Communication modules are mounted on the left side of the processor module on the same terminal base. The connection is established automatically when mounting the communication module.
NOTICE!
Risk of damaging the PLC modules!
Overvoltages and short circuits might damage the PLC modules.
- Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
- Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

After mounting the terminal base, mount the communication modules.

1. First insert the bottom nose of the communication module into the dedicated holes of the terminal base. Then, rotate the communication module on the dedicated terminal base slot until it is locked in place.

NOTICE!
Risk of malfunctions!
Unused slots for communication modules are not protected against accidental physical contact.
- Unused slots for communication modules must be covered with dummy communication modules to achieve IP20 rating. Chapter 5.2.8.2.4 "TA524 - Dummy communication module" on page 1323.
- I/O bus connectors must not be touched during operation.
2. The demounting is carried out in a reversed order. Press above and below, then rotate the communication module and remove it.

4.3.6 Mounting and demounting the terminal unit

Mounting on DIN rail

1. Mount DIN rail 7.5 mm or 15 mm.
2. Mount the terminal unit.

The terminal unit is snapped into the DIN rail in the same way as the Terminal Base. Once secured to the DIN rail, slide the terminal unit to the left until it fully locks into place creating a solid mechanical and connection.

When attaching the devices, make sure the bus connectors are securely locked together to ensure proper connection. Max. 10 terminal units can be attached.
3. Demounting: A screwdriver is inserted in the indicated place to separate the terminal units.

If the terminal unit should be mounted with screws, wall mounting accessories TA526 must be inserted at the rear side first. Chapter 5.2.8.2.5 “TA526 - Wall mounting accessory” on page 1324. These plastic parts prevent bending of the Terminal Base while screwing on.

Fig. 14: Fastening with screws

By wall mounting, the terminal unit is grounded through the screws. It is necessary that
- the screws have a conductive surface (e.g. steel zinc-plated or brass nickel-plated)
- the mounting plate is grounded
- the screws have a good electrical contact to the mounting plate

Practical tip

The following procedure allows you to use the mounted modules as a template for drilling holes in the panel. Due to module mounting hole tolerance, it is important to follow these procedures:
1. On a clean work surface, mount no more than 3 modules (e.g. one terminal base and two terminal units).
2. Using the mounted modules as a template, carefully mark the center of all module-mounting holes on the panel.
3. Return the mounted modules to the clean work surface, including any previously mounted modules.
4. Drill and tap the mounting holes for the screws (M4 or #8 recommended).
5. Place the modules back on the panel and check for proper hole alignment.
6. Attach the modules to the panel using the mounting screws.

   ![Note]
   If mounting more modules, mount only the last one of this group and put the others aside. This reduces remounting time during drilling and tapping of the next group.

7. Repeat the steps for all remaining modules.

4.3.7 Mounting and demounting the I/O module

After mounting the terminal unit, mount the I/O modules.

1. Press the I/O module into the terminal unit until it locks in place.
2. The demounting is carried out in a reversed order. Press above and below, then remove the module.

4.3.8 Mounting and demounting the AC500-eCo processor module

4.3.8.1 Mounting and demounting the option boards

4.3.8.1.1 Optimized mounting of the option boards

The AC500-eCo processor modules have up to 3 slots for option boards.

Table 7: Option board slots

<table>
<thead>
<tr>
<th>Slot 3</th>
<th>Slot 2</th>
<th>Slot 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Option board" /></td>
<td><img src="image2.png" alt="Option board" /></td>
<td><img src="image3.png" alt="Option board" /></td>
</tr>
</tbody>
</table>

The best thermal circulation is given on slot 3 (bottom slot), followed by slot 2 (middle slot) and then slot 1 (top slot).

The best mounting position of the option board depends on its power dissipation.

Rules for optimized mounting of the option boards

- The higher the power dissipation of the option board, the lower the mounting position should be selected.
- The TAS126-2AO-UI option board has the highest power dissipation and must always be mounted at the lowest option board slot.

The optimized mounting position can be easily determined with the help of this table.
Table 8: Power dissipation of the option boards

<table>
<thead>
<tr>
<th>Power dissipation of the option boards</th>
<th>Digital</th>
<th>Analog</th>
<th>Serial interface</th>
<th>Accessory</th>
</tr>
</thead>
<tbody>
<tr>
<td>very small</td>
<td>TA5105-4DOT(W)</td>
<td>TA5123-2AI-RT(D/W)</td>
<td>TA5141-RS232I(W)</td>
<td>TA5130-KNXPB(W)</td>
</tr>
<tr>
<td>small</td>
<td>TA5110-2DI2DO(T/W)</td>
<td>TA5120-2AI-UI(W)</td>
<td>TA5142-RS485I(W)</td>
<td>TA5131-RTC</td>
</tr>
<tr>
<td>medium</td>
<td>TA5101-4DI(W)</td>
<td>TA5126-2AO-UI(W)</td>
<td>TA5142-RS485(W)</td>
<td></td>
</tr>
<tr>
<td>large</td>
<td></td>
<td></td>
<td>TA5130-KNXPB(W)</td>
<td></td>
</tr>
</tbody>
</table>

If the option boards to be mounted are in the same power dissipation level, then the slots can be freely selected.

4.3.8.1.2 Inserting the option board

Press the option board TA51xx (or TA5300-CVR) into the slot of the processor module PM50x2 until it locks in place.

The option board must click into the slot of the processor module.
4.3.8.1.3 Removing the option board

1. Push the option board on the side to release the lock.
2. At the same time, pull the option board out of the slot.

**CAUTION!**
Risk of injury and damaging the product!
Always plug in the option board slot cover when the option board is not inserted.
If the option board slot cover is lost, please order the replacement TA5300-CVR (1SAP187500R0001).
Never power up the CPU with uncovered option board slot, otherwise it may cause serious injury and/or damage the product.

4.3.8.2 Mounting and demounting of the terminal blocks

**Intended purpose**
Removable terminal blocks are used for power supply and for I/O connectors on AC500-eCo V3 processor modules PM50x2.
For option boards there are different removable terminal blocks in spring version.
For the AC500-eCo V3 Basic CPUs a 3-pin terminal block for power supply and a 13-pin terminal block for I/O connectors are used.

For the AC500-eCo V3 Standard CPUs and Pro CPUs a 3-pin terminal block for power supply, a 13-pin terminal block and a 12-pin terminal block for I/O connectors are used.

For all CPUs there is a screw and a spring variant available.

<table>
<thead>
<tr>
<th>Basic CPU</th>
<th>Standard and Pro CPUs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spring terminal</td>
<td>Screw terminal</td>
</tr>
<tr>
<td>TA5211-TSPF-B</td>
<td>TA5211-TSCL-B</td>
</tr>
<tr>
<td>Spring terminal</td>
<td>Screw terminal</td>
</tr>
<tr>
<td>TA5212-TSPF</td>
<td>TA5212-TSCL</td>
</tr>
</tbody>
</table>

Various removable spring terminal blocks are available for option boards.
The following spare parts are available (depending on the number of pins).

<table>
<thead>
<tr>
<th>Spring terminals</th>
</tr>
</thead>
<tbody>
<tr>
<td>TA5220-SPF5</td>
</tr>
<tr>
<td>TA5220-SPF6</td>
</tr>
<tr>
<td>TA5220-SPF7</td>
</tr>
<tr>
<td>TA5220-SPF8</td>
</tr>
</tbody>
</table>
CAUTION!
Risk of injury and damaging the product!
Improper installation and maintenance may result in injury and can damage the product!
- Installation and maintenance have to be performed according to the technical rules, codes and relevant standards, e.g. EN 60204-1.
- Read product documentation carefully before wiring. Improper wiring or wrong terminal block from other devices can damage the product!
- Only by qualified personnel.

CAUTION!
Risk of injury and damaging the module when using unapproved terminal blocks!
Only use terminal blocks approved by ABB to avoid injury and damage to the module.

Terminal block set for PM50x2
Processor modules PM50x2 CPU are not delivered with terminal blocks.
Screw terminal block set:
- TA5211-TSCL-B (1SAP187400R0001) for PM5012-x-ETH
- TA5212-TSCL (1SAP187400R0004) for PM5032-x-ETH, PM5052-x-ETH, PM5072-T-2ETH(W), PM5082-T-2ETH
Spring terminal block set:
- TA5211-TSPF-B (1SAP187400R0002) for PM5012-x-ETH
- TA5212-TSPF (1SAP187400R0005) for PM5032-x-ETH, PM5052-x-ETH, PM5072-T-2ETH(W), PM5082-T-2ETH
4.3.8.3 Mounting a processor module on a DIN rail

NOTICE!
Risk of function faults!

- The processor module is grounded via DIN rail.
- The DIN rail must be included into the grounding conception of the plant.
- Use only metal screws for grounding.

Mount the processor module at the top of the DIN rail, then snap it in below.
4.3.8.4 Demounting a processor module mounted on a DIN rail

1. Remove I/O modules if connected.

2. While pressing down processor module pull it away from DIN rail.

See hardware description of PM50xx for connection.
4.3.8.5 Mounting a processor module on a metal plate

**NOTICE!**
Risk of function faults!
- Missing electrical contact by isolating screws or washers!
- Use metal screws on the metal plate.
- The metal plate must be included into the grounding concept of the plant.
- Do NOT use insulating washers!

---

**One TA543 wall mounting accessory is needed per processor module.**

1. Snap in the TA543 at the back side of the processor module.

2. Fasten the processor module with two screws (diameter: 4 mm) to the metal plate.
4.3.8.6 Demounting a processor module mounted on a metal plate

1. Remove I/O modules if connected.

2. Remove the 2 screws.
4.3.8.7 Mounting of the cable fixing accessory TA5301-CFA

1. TA5301-CFA cable fixing accessory
2. 2 openings on the PM50x2 processor module

Insert the TA5301-CFA cable fixing accessory into the two openings on the PM50x2 processor module marked white in the figure.

4.3.9 Mounting and demounting the S500-eCo I/O module

S500-eCo I/O modules can be mounted either on a DIN rail or with screws on a metal plate.

### NOTICE!

- Risk of function faults!
- The S500-eCo I/O modules are grounded via the DIN rail.
- The DIN rail must be included into the grounding concept of the plant.
- Use only metal screws.

1. Mount I/O module at the top of the DIN rail, then snap it in below.
2. Attach I/O module by hand to another module. The I/O bus is connected automatically.

Demounting I/O modules mounted on a DIN rail

1. Remove I/O module by hand if connected.
1. Remove the 2 screws.

2. While pressing down I/O module pull it away from DIN rail.
2. Remove the I/O module from the connected module by hand.

4.3.10 Accessories for AC500 (Standard)
4.3.10.1 Inserting and removing a memory card

1. MC5141 memory card
2. MC5102 micro memory card
3. Micro memory card adapter
4. Memory card slot
1. Insert the memory card into the memory card slot of the processor module until locked.

**NOTICE!**

**Disturbed PLC operation**

Do not remove the micro memory card when it is working!

Otherwise the micro memory card and/or files on it might get corrupted and/or normal PLC operation might be disturbed.

- AC500 V3: Remove the micro memory card only when no black square (■) is shown next to MC in the display.
- AC500-eCo V3: Remove the micro memory card only when the MC LED is not blinking.

2. To remove the memory card, push on the memory card until it moves forward. By this, the memory card is unlocked and can be removed.

4.3.10.2 Further accessories

This section only describes accessories that are frequently used for system assembly, connection and construction.

*All additional accessories that can be used to supplement the AC500 system*

4.3.11 Accessories for AC500-eCo

4.3.11.1 Mounting and demounting the option boards

4.3.11.1.1 Optimized mounting of the option boards

The AC500-eCo processor modules have up to 3 slots for option boards.

**Table 9: Option board slots**

The best thermal circulation is given on slot 3 (bottom slot), followed by slot 2 (middle slot) and then slot 1 (top slot).

The best mounting position of the option board depends on its power dissipation.

*Rules for optimized mounting of the option boards*

- The higher the power dissipation of the option board, the lower the mounting position should be selected.
- The TA5126-2AO-UI option board has the highest power dissipation and must always be mounted at the lowest option board slot.

The optimized mounting position can be easily determined with the help of this table.
Table 10: Power dissipation of the option boards

<table>
<thead>
<tr>
<th>Power dissipation of the option boards</th>
<th>Digital</th>
<th>Analog</th>
<th>Serial interface</th>
<th>Accessory</th>
</tr>
</thead>
<tbody>
<tr>
<td>very small</td>
<td></td>
<td></td>
<td>TA5141-RS232I(W)</td>
<td>TA5130-KNXPB(W)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>TA5142-RS485I(W)</td>
<td>TA5131-RTC</td>
</tr>
<tr>
<td></td>
<td>TA5105-4DOT(W)</td>
<td></td>
<td>TA5110-2DI2DO(T/W)</td>
<td></td>
</tr>
<tr>
<td>small</td>
<td>TA5123-2AI-RT(D/W)</td>
<td></td>
<td>TA5120-2AI-UI(W)</td>
<td></td>
</tr>
<tr>
<td>medium</td>
<td>TA5110-2DI2DO(T/W)</td>
<td></td>
<td>TA5120-2AI-UI(W)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>TA5101-4DI(W)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>large</td>
<td></td>
<td></td>
<td>TA5126-2AO-UI(W)</td>
<td></td>
</tr>
</tbody>
</table>

If the option boards to be mounted are in the same power dissipation level, then the slots can be freely selected.

4.3.11.1.2 Inserting the option board

Press the option board TA51xx (or TA5300-CVR) into the slot of the processor module PM50x2 until it locks in place.

The option board must click into the slot of the processor module.
4.3.11.1.3 Removing the option board

1. Push the option board on the side to release the lock.
2. At the same time, pull the option board out of the slot.

CAUTION!
Risk of injury and damaging the product!
Always plug in the option board slot cover when the option board is not inserted.
If the option board slot cover is lost, please order the replacement TA5300-CVR (1SAP187500R0001).
Never power up the CPU with uncovered option board slot, otherwise it may cause serious injury and/or damage the product.

4.3.11.2 Inserting and removing a memory card
AC500-eCo V3

1. Open the micro memory card slot cover by turning it upwards.
2. Carefully insert the micro memory card into the micro memory card slot as far as it will go. Observe orientation of card.
3. Close the micro memory card slot cover by turning it downwards.
AC500-eCo V3

NOTICE!
Disturbed PLC operation
Do not remove the memory card when it is working!
Otherwise the memory card and/or files on it might get corrupted and/or normal PLC operation might be disturbed.
- Remove the memory card only when no black square (■) is shown next to MC in the display.

1 Micro memory card slot cover
2 Micro memory card
3 Micro memory card slot
1. Open the micro memory card slot cover by turning it upwards.
2. Micro memory card can be removed from the micro memory card slot by gripping and pulling with two fingers.
3. Close the micro memory card slot cover by turning it downwards.

4.3.11.3 Further accessories
This section only describes accessories that are frequently used for system assembly, connection and construction.
*All additional accessories that can be used to supplement the AC500 system*

4.3.12 Control panels CP600
Refer to the *installation instructions* delivered with each control panel and to the *operating instructions*.
4.4 Wiring
4.4.1 Grounding concept

NOTICE!
PLC damage due to missing grounding
- Make sure to ground the devices.
- The grounding (switch cabinet grounding) is supplied both by the mains connection (or 24 V supply voltage) and via the DIN rail. The DIN rail must be connected to ground before power is supplied to the device. The grounding may be removed only if it is certain that no more power is being supplied to the control system.
- In case of screw mounting, use metal screws for grounding.

Block diagram:
Digital I/O modules
4.4.2 EMC-conforming assembly and construction

4.4.2.1 General principles

AC500 and AC500-eCo PLC devices are Class II/Class III devices and do not require a Protective Earth (PE) connection.

For proper EMC performance, all metal parts, DIN rails, mounting screws, and cable shield connection terminals are connected to a common ground and provide Functional Earth (FE). This is typically connected to a common reference potential, such as equipotential bonding rails.

Signal Grounds (SGND or GND) are used for signal reference and must not be connected to cable shields, FE or other signals unless otherwise specified in the specific device description.

General considerations

Electric and electronical devices have to work correctly on site. This is also valid when electromagnetic influences affect them in defined and/or expected strength. The devices themselves must not emit electro-magnetic noises.

Advant controller components have a very high noise immunity.
When the wiring and grounding instructions are met, an error-free operation is given. High electro-magnetic noises of nearby mounted applications must be taken in consideration during the planning phase.

An EMC compatible earthing concept will also guarantee an error-free operation here.

In order to prevent operating malfunctions, it is recommended, that the operating personnel discharge themselves prior to touching communication connectors or perform other suitable measures to reduce effects of electrostatic discharges.

There are three important principles to be especially considered:
- Keep all connections as short as possible (in particular the grounding conductors)
- Use large conductor cross sections (in particular for the grounding conductors)
- Create low-impedance, i.e. good and large-sized contacts (in particular for the grounding conductors)

Pay attention to the following:
- Use vibration-resistant connections
- Clean metallic contact areas
- Use solid plug and screw-type connections
- Use earth cable shields with clips on a well-grounded metallic surface
- Do not use aluminium parts
- Do not use sheath wires
- Do not use toothed lock washers under screw connections

Fig. 15: Assembly: wrong

Fig. 16: Assembly: correct

Make a connection between the DIN rails and PE (Protective Earth). For this, use an grounding wire with a minimum conductor cross section of 10 mm². The wire is connected to the DIN rail with an M6 screw.

A large-area contact of the DIN rail with the metallic mounting plate improves the EMC behavior significantly, as the disturbances can be discharged more effective.
4.4.2 Cable routing

- Route cables meeting the standards.
- Sort the cables into cable groups:
  - Power current cables
  - Power supply cables
  - Signal cables
  - Data cables
- Route signal cables and data cables separately from the power cables.
  - Separate cable ducts or cable bundles.
  - The distance should be 20 cm or greater.
- Lay signal and data cables close to earthed surfaces.

4.4.3 Cable shields

- Use only shielded data cables. The shield should be grounded at both ends.
  A cable shield only grounded at one end can only protect from capacitively coupled interference and low-frequency disturbances (50 Hz hum).
- Avoid parasitic currents flowing through the cable shields.
  This can be done by installing current-carrying equipotential bondings.
- Use only cables with braided shields.
  Foil shields are not robust enough, cannot be contacted well and have poor HF properties.
- Use only metallic or [metal]-plated plugs for shielded data cables.
- Use only shielded cables for analog signals.
  For small signals ground the shield only at one end.
- Ground the cable shield directly with a clip when entering the control cabinet.
  Do not cut the shield until the cable reaches the module connected.

![The connection between the PE bar and the shield bar must have a low impedance.]

4.4.4 Control cabinet

- Installation of configurations in shielded cabinet can be required in shipping applications. Follow specific instructions in the applicable type approval certificate.

Available certificates can be found in the internet

1. Open landing page of the product e.g. DO526
2. In the middle of the page, click on [Downloads].
   ⇒ A two-column window opens on the page with all available documents.
3. In the left column of the downloads page click on [Certificate].
   ⇒ All available certificates are listed in the right column.

In the list of certificates, the maritime certificates can be identified by the title. The title consists of the abbreviation of the maritime classification society followed by the words: Type Approval Certificate. E.g. "DNV Type Approval Certificate: ...".
Connections
The connections between the control cabinet, the mounting plates, the PE bar and the shield bar must have a low impedance.

Grounding
Ground the control cabinet doors with short and highly flexible conductors.

Control cabinet lighting
Only use lighting with interference suppression.

For supplying the PC
Use the mains socket which is located inside the control cabinet.

4.4.2.5 Reference potential
- Provide a uniform reference potential in the entire installation and ground all electrical appliances if possible.
- Route your grounding conductors in a star configuration so that no ground loops can occur.

4.4.2.6 Equipotential bonding
The installation of equipotential bondings are necessary if there are present or expected potential differences between parts of your application.

- The impedance of equipotential bonding must be equal or lower than 10% of the shield impedance of the shielded signal cables between the same points.
- The conductor cross section of a equipotential bonding must be 16 mm² to withstand the maximum possible compensating current.
- Equipotential bondings and shielded signal cables should be laid close to each other.
- Equipotential bondings must be connected to PE with low impedance.
Fig. 17: AC500, equipotential bonding

1 Cabinet 1
2 Cabinet 2
3 Power supply for the CPU
4 Fuse for the CPU power
5 Power supply for the I/Os
6 Fuse for the I/O power
7 For fuses for the contacts of the relay outputs
8 0V rail
9 Grounding of the 0V rail
10 Cabinet grounding
11 Equipotential bonding between the cabinets min. 16 mm²
12 Cable shields grounding
13 Fieldbus connection (e.g. Ethernet)
4.4.3 Connection and wiring of the PLC platform

4.4.3.1 Safety instructions

NOTICE!
Attention:
The devices should be installed by experts who are trained in wiring electronic devices. In case of bad wiring, the following problems could occur:
- On the terminal base, the terminals L+ and M are doubled. If the power supply is badly connected, a short circuit could happen and lead to a destruction of the power supply or its fuse. If no suitable fuse exists, the terminal base itself might be destroyed.
- The terminal bases and all electronic modules and terminal units are protected against reverse polarity.
- All necessary measures should be carried out to avoid damages to modules and wiring. Notice the wiring plans and connection examples.

NOTICE!
All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

NOTICE!
Attention:
Due to possible loss of communication, the communication cables should be fixed with cable duct or bracket or clamp during application.

4.4.3.2 AC500

4.4.3.2.1 Power supply for AC500 system

The system is powered by two different power circuits:
- The power supply for the processor module is provided through the terminals L+/M.
- The power supply for the I/O modules is provided through the terminals UP/ZP.

The power supply for the processor module is galvanic isolated from the power supply for the I/O modules.

As soon as the power supply for the processor module is present, the processor module starts. The power supply of the processor module and the I/O modules should be powered on the same time, otherwise the processor module will not switch to run mode after startup.

When during operation the power supply falls below the minimum process and supply voltage for more than 10 ms, the processor module switches to safe mode. A restart of the processor module only occurs by switching the power supply off and on again.

If an I/O module is disconnected during operation from the power supply while the processor module is still powered, the processor module will continue its normal operation on all other powered peripherals (other I/O modules, communication modules and communication interfaces), but freezes the input image. After recovery of the power supply of the affected I/O module it will continue normal operation and inputs and outputs will be updated.

☞ Chapter 5.1.2.1 “Environmental conditions” on page 166

As power supply for the AC500 system, the ABB power supplies series CP can be used
☞ Chapter 5.2.8.3.1 “CP-E - Economic range” on page 1325 ☞ Chapter 5.2.8.3.2 “CP-C.1 - High performance range” on page 1327.
### 4.4.3.2 Power supply for processor modules

The supply voltage of 24 V DC is connected to a removable 5-pin terminal block. L+/M exist twice. It is therefore possible to feed e.g. external sensors (up to 8 A max. with 1.5 mm$^2$ conductor) via these terminals.

### Pin assignment

<table>
<thead>
<tr>
<th>Pin Assignment</th>
<th>Label</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminal block removed</td>
<td>L+</td>
<td>+24 V DC</td>
<td>Positive pin of the power supply voltage</td>
</tr>
<tr>
<td>Terminal block inserted</td>
<td>L+</td>
<td>+24 V DC</td>
<td>Positive pin of the power supply voltage</td>
</tr>
<tr>
<td>Terminal block inserted</td>
<td>M</td>
<td>0 V</td>
<td>Negative pin of the power supply voltage</td>
</tr>
<tr>
<td>Terminal block inserted</td>
<td>M</td>
<td>0 V</td>
<td>Negative pin of the power supply voltage</td>
</tr>
<tr>
<td>Terminal block inserted</td>
<td>FE</td>
<td></td>
<td>Functional earth</td>
</tr>
</tbody>
</table>

### 4.4.3.2.3 Connection of wires at the spring terminals

**Connection**

Fig. 18: Connect the wire to the spring terminal (steps 1 ... 3)
Fig. 19: Connect the wire to the spring terminal (steps 4 ... 7)

1. Side view (open terminal drawn for illustration)
2. The top view shows the openings for wire and screwdriver
3. Insert screwdriver (2.5 x 0.4 to 3.5 x 0.5 mm) at an angle, screwdriver must be at least 15 mm free of insulation at the tip
4. While erecting the screwdriver, insert it until the stop (requires a little strength)
5. Screwdriver inserted - terminal open
6. Strip the wire for 7 mm (and put on wire-end ferrule)
7. Insert wire into the open terminal
8. Done

Disconnection

Fig. 20: Disconnect wire from the spring terminal (steps 1 ... 3)
Fig. 21: Disconnect wire from the spring terminal (steps 4 ... 6)

1. Terminal with wire connected
2. Insert screwdriver (2.5 x 0.4 ... 3.5 x 0.5 mm) at an angle, screwdriver must be at least 15 mm free of insulation at the tip
3. While erecting the screwdriver, insert it until the stop (requires a little strength) - terminal is now open
4. Remove wire from the open terminal
5. Done

4.4.3.2.4 Terminals for CANopen communication modules

Fig. 22: Combicon, 5-pole, female, removable plug with spring terminals

Fig. 23: Combicon, 5-pole, female, removable plug with spring terminals
4.4.3.2.5 Ethernet connection details

Ethernet interface

Ethernet is also used for PROFINET, EtherCAT and Modbus TCP connection.

Pin assignment

<table>
<thead>
<tr>
<th>Interface</th>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RJ45</td>
<td>1</td>
<td>TxD+</td>
<td>Transmit data +</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>TxD-</td>
<td>Transmit data -</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>RxD+</td>
<td>Receive data +</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>NU</td>
<td>Not used</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>NU</td>
<td>Not used</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>RxD-</td>
<td>Receive data -</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>NU</td>
<td>Not used</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>NU</td>
<td>Not used</td>
</tr>
<tr>
<td>Shield</td>
<td></td>
<td>Cable shield</td>
<td>Functional earth</td>
</tr>
</tbody>
</table>

Supported protocols and used Ethernet ports

Communication via Modbus TCP/IP

Communication via Modbus RTU

Wiring

Cable length restrictions

For the maximum possible cable lengths within an Ethernet network, various factors have to be taken into account. Twisted pair cables (TP cables) are used as transmission medium for 10 Mbit/s Ethernet (10Base-T) as well as for 100 Mbit/s (Fast) Ethernet (100Base-TX). For a transmission rate of 10 Mbit/s, cables of at least category 3 (IEA/TIA 568-A-5 Cat3) or class C (according to European standards) are allowed. For fast Ethernet with a transmission rate of 100 Mbit/s, cables of category 5 (Cat5) or class D or higher have to be used. The maximum length of a segment, which is the maximum distance between two network components, is restricted to 100 m due to the electric properties of the cable.
Furthermore, the length restriction for one collision domain has to be observed. A collision domain is the area within a network which can be affected by a possibly occurring collision (i.e., the area the collision can propagate over). This, however, only applies if the components operate in half-duplex mode since the CSMA/CD access method is only used in this mode. If the components operate in full-duplex mode, no collisions can occur. Reliable operation of the collision detection method is important, which means that it has to be able to detect possible collisions even for the smallest possible frame size of 64 bytes (512 bits). But this is only guaranteed if the first bit of the frame arrives at the most distant subscriber within the collision domain before the last bit has left the transmitting station. Furthermore, the collision must be able to propagate to both directions at the same time. Therefore, the maximum distance between two ends must not be longer than the distance corresponding to the half signal propagation time of 512 bits. Thus, the resulting maximum possible length of the collision domain is 2000 m for a transmission rate of 10 Mbit/s and 200 m for 100 Mbit/s. In addition, the bit delay times caused by the passed network components also have to be considered.

Table 11: Specified cable properties of the respective cable types per 100 m:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>10Base-T [10 MHz]</th>
<th>100Base-TX [100 MHz]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attenuation [dB/100m]</td>
<td>10.7</td>
<td>23.2</td>
</tr>
<tr>
<td>NEXT [dB/100m]</td>
<td>23</td>
<td>24</td>
</tr>
<tr>
<td>ACR [dB/100m]</td>
<td>N/A</td>
<td>4</td>
</tr>
<tr>
<td>Return loss [dB/100m]</td>
<td>18</td>
<td>10</td>
</tr>
<tr>
<td>Wave impedance [Ohms]</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td>Category</td>
<td>3 or higher</td>
<td>5</td>
</tr>
<tr>
<td>Class</td>
<td>C or higher</td>
<td>D or higher</td>
</tr>
</tbody>
</table>

**TP cable**

The TP cable has eight wires arranged in four pairs of twisted wires. Different color codes exist for the coding of the wires, the coding according to EIA/TIA 568, version 1, being the one most commonly used. In this code, the individual pairs are coded with blue, orange, green, and brown color. One wire of a pair is unicolored and the corresponding second wire is striped, the respective color alternating with white. For shielded cables, a distinction is made between cables that have one single shield around all pairs of wires and cables that have an additional individual shield for each pair of wires. The following table shows the different color coding systems for TP cables:

Table 12: Color coding of TP cables:

<table>
<thead>
<tr>
<th>Pairs</th>
<th>EIA/TIA 568 Version 1</th>
<th>EIA/TIA 568 Version 2</th>
<th>DIN 47100</th>
<th>IEC 189.2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pair 1</td>
<td>white/ blue</td>
<td>blue</td>
<td>green</td>
<td>red</td>
</tr>
<tr>
<td>Pair 2</td>
<td>white/ orange</td>
<td>orange</td>
<td>black</td>
<td>yellow</td>
</tr>
<tr>
<td>Pair 3</td>
<td>white/ green</td>
<td>green</td>
<td>blue</td>
<td>orange</td>
</tr>
<tr>
<td>Pair 4</td>
<td>white/ brown</td>
<td>brown</td>
<td>brown</td>
<td>slate</td>
</tr>
</tbody>
</table>

Two general variants are distinguished for the pin assignment of the normally used RJ45 connectors: EIA/TIA 568 version A and version B. The wiring according to EIA/TIA 568 version B is the one most commonly used.
Cable types

Crossover cable

**Particular use**

Crossover cables are needed only for a direct Ethernet connection without crossover functionality. In particular for AC500 modules in product life cycle phase "Classic".

Crossover cables are for a direct Ethernet connection of two terminal devices as the simplest variant of a network. From transmission lines of the first station to the reception lines of the second station.

---

**Straight-through cable**

For networks with more than two subscribers, hubs or switches have to be used additionally for distribution. These active devices already have the crossover functionality implemented which allows a direct connection of the terminal devices using straight-through cables.

---

**CAUTION!**

Risk of communication faults!

When using inappropriate cables, malfunctions in communication may occur.

Only use network cables of the categories 5 (Cat 5, Cat 5e, Cat 6 or Cat 7) or higher within PROFINET networks.
4.4.3.3 AC500-eCo

4.4.3.3.1 Power supply

The processor modules PM50x2 can be connected to the 24 V DC supply voltage via a removable 3-pin spring terminal block or a 3-pin screw terminal block.

Table 13: Removable terminal block for the supply voltage 24 V DC

<table>
<thead>
<tr>
<th>3-pin spring terminal block</th>
<th>3-pin screw terminal block</th>
</tr>
</thead>
</table>

The terminal block is available as a set for AC500-eCo V3 processor modules.

<table>
<thead>
<tr>
<th>Basic CPU (PM5012)</th>
<th>Standard CPUs (PM5032, PM5052) and Pro CPUs (PM5072, PM5082)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spring type</td>
<td>Screw type</td>
</tr>
<tr>
<td>TA5211-TSPF-B</td>
<td>TA5211-TSCL-B</td>
</tr>
</tbody>
</table>

Further information on power supply and onboard inputs/outputs of the terminal blocks

Pin assignment

<table>
<thead>
<tr>
<th>Pin Assignment</th>
<th>Pin</th>
<th>Label</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>FE</td>
<td>FE</td>
<td>Functional earth</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>L+</td>
<td>+24 V DC</td>
<td>Positive pin of the power supply voltage</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>M</td>
<td>0 V</td>
<td>Negative pin of the power supply voltage</td>
</tr>
</tbody>
</table>

NOTICE!

Risk of damaging the PLC due to improper voltage levels!

- Never exceed the maximum tolerance values for process and supply voltages.
- Never fall below the minimum tolerance values for process and supply voltages.

Observe the system data and the technical data of the used module. 

Chapter 5.1.1 “System data AC500-eCo” on page 159
4.4.3.3.2 Ethernet

Ethernet interface

Ethernet is also used for Modbus TCP connection.

The Ethernet interface is carried out via a RJ45 jack. The pin assignment of the Ethernet interface:

<table>
<thead>
<tr>
<th>Interface</th>
<th>Pin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Tx+</td>
<td>Transmit Data +</td>
</tr>
<tr>
<td>2</td>
<td>Tx-</td>
<td>Transmit Data -</td>
</tr>
<tr>
<td>3</td>
<td>Rx+</td>
<td>Receive data +</td>
</tr>
<tr>
<td>4</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td>5</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td>6</td>
<td>Rx-</td>
<td>Receive data -</td>
</tr>
<tr>
<td>7</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td>8</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td>Shield</td>
<td></td>
<td>Cable shield</td>
</tr>
</tbody>
</table>

- Supported protocols and used Ethernet ports
- Communication via Modbus TCP/IP
- Communication via Modbus RTU

4.4.3.4 Control panels CP600

Refer to the installation instructions delivered with each control panel and to the operating instructions.

4.4.4 Connection and wiring of the modules

Specific information about the connections of the modules and the wiring is available in the installation instructions.

- Installation instructions of AC500 PLC product family
- Installation instructions of CP600 control panels

4.5 Configuration and programming

Advanced installation of engineering suite

Programming for PLC system

Detailed information is available in the installation and licensing document.

- Chapter 6.3 “Configuration in Automation Builder for AC500 V3 products” on page 1398
Detailed information is available in the installation and licensing document.

4.6 Commissioning

Commissioning the PLC

Preconditions:
- All PLC modules are installed and wired according to the configuration in Automation Builder.
- The PLC is connected to the power supply.
- The application and the necessary licenses are available.

**WARNING!**

Risk of injury or damage to equipment

To avoid endangering persons or equipment, check before commissioning:
- Mechanical and electrical installation
- Electrical safety of the installation
- Safety functions

1. Switch on the power supply.
   - The green PWR LED goes on.
   - Processor modules with display: Wait until the processor module displays “Update”.

2. Install the firmware and the application on the processor module.

   Installing the firmware and the application on a very new processor module is the same process than updating a firmware and an application on a CPU.

   - Chapter 4.7.4 “PLC firmware/application update” on page 148
   - The PLC starts with the new firmware and the new application.

**WARNING!**

Risk of injury or damage to equipment

To avoid endangering persons or equipment, a functional test of the application must be performed before the final commissioning of the system.

Commissioning the control panel

Preconditions:
- The control panel is installed and wired.
- The control panel is connected to the power supply.
- The project file and the necessary licenses are available.

1. Start the control panel.
2. Set the IP address of the control panel.
3. Download the project file to the control panel.
4. Connect the PLC and the control panel with an Ethernet cable.
Step-by-step instructions using the example of the AC500-eCo starter kit with a control panel included

Protect your data, provide your projects with passwords and access restrictions.
☞ Chapter 6.4.1.6 “Protecting and Saving Projects” on page 1819
☞ Chapter 6.3.1.2.1 “User and access rights” on page 1409

The PLC has an integrated diagnosis system to output diagnosis messages, e.g., parameter setting is wrong or battery low. A diagnosis message is indicated by ERR LED = on.
☞ Chapter 4.8 “Troubleshooting” on page 149

4.7 Operation

4.7.1 Operating modes

The common operating mode is called run mode.

Table 14: Run mode

<table>
<thead>
<tr>
<th>LED</th>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR LED = on</td>
<td><img src="image" alt="PWR LED on" /></td>
<td>Power supply is present. PLC is in run mode.</td>
</tr>
<tr>
<td>RUN LED = on</td>
<td><img src="image" alt="RUN LED on" /></td>
<td></td>
</tr>
<tr>
<td>ERR LED = off</td>
<td><img src="image" alt="ERR LED off" /></td>
<td></td>
</tr>
</tbody>
</table>

If the PLC is connected to the power supply, but does not operate, it is in stop mode. In stop mode, the processor module does not control the system.

Table 15: Stop mode

<table>
<thead>
<tr>
<th>LED</th>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR LED = on</td>
<td><img src="image" alt="PWR LED on" /></td>
<td>E.g., after the download of an application, after a firmware update, an error occurred or the PLC was stopped by the user, etc.</td>
</tr>
<tr>
<td>RUN LED = off</td>
<td><img src="image" alt="RUN LED off" /></td>
<td></td>
</tr>
<tr>
<td>ERR LED = off/on</td>
<td><img src="image" alt="ERR LED off/on" /></td>
<td></td>
</tr>
</tbody>
</table>

4.7.2 Diagnosis system

The PLC has an integrated diagnosis system to output diagnosis messages, e.g., parameter setting is wrong or battery low. A diagnosis message is indicated by ERR LED = on.
☞ Chapter 4.8 “Troubleshooting” on page 149
4.7.3 Status LEDs, display and control elements

Depending on the device type, various operating elements provided on the front panel can be used to control the devices of the PLC system and/or to change the operating mode.

Operating elements:

- **Status LEDs:**
  Indicates the availability of devices and components such as communication modules, communication interface modules or function modules. Functionality and diagnosis of the status LEDs depends on the specific module and is described in the device description of the appropriate module. Possible status: on/off/blinking

- **I/O LEDs:**
  Displays the status of the inputs and outputs.

- **Display:**
  Available for some processor modules. It can be used for simple configurations and for reading out diagnosis information.

- **Function keys and switches:**
  Allows to change the current operating modes/status manually. Refer to the Panel Builder manual for a detailed description.

4.7.4 PLC firmware/application update

During runtime it might be necessary to update the firmware of the modules, e.g., for security reasons.

Updating the firmware and the application on a processor module is the same process than installing a firmware and an application on a very new processor module.

The installation can be performed either via a PC (recommended) or via a memory card.

![Fig. 27: The “Version information” tab of a device in the Automation Builder](image)

4.7.5 Control panel firmware/application update

The system components can be updated via Panel Builder software or via USB flash drive. Refer to the Panel Builder manual for a detailed description.
### 4.7.6 Reset Warm

**PLC**

- PLC is in STOP mode.

1. Press and hold (> 5 sec) [RUN].
   - RUN LED = ON.
   - “Reset” is displayed.

2. Press [OK] to reset the PLC.

**Control panel**

The factory restore of a control panel is described in the *Panel Builder manual*.

---

### 4.8 Troubleshooting

#### 4.8.1 General

Diagnosis messages are shown in the engineering suite Automation Builder. The diagnosis information can be accessed in the IEC application and can be forwarded to, e.g., a web server or a control panel. See *Chapter 6.9.1.5 “Diagnosis in IEC application” on page 4615*

Diagnosis messages can also be read out from the display of the PLC. See *Chapter 6.9.3 “Diagnosis messages” on page 4655*

Some diagnosis messages need to be acknowledged by the user (alarms*), others do not require acknowledgment (events*). The diagnosis system stores alarms and events in a diagnosis history.

Diagnosis messages include the severity of an error. Error severity can be used for defining system behavior, e.g., activating the error LED or stop the PLC.

#### 4.8.2 Possible malfunctions

**Possible malfunctions**

<table>
<thead>
<tr>
<th>Fault description</th>
<th>Cause</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>A processor module, a communication interface module or an I/O module can not be plugged on the corresponding terminal base or terminal unit.</td>
<td>Terminal bases and terminal units have a mechanical encoding. The encoding makes it impossible to insert a module to the wrong place to prevent dangerous voltages or destroyed modules.</td>
<td>Check the given design scheme of your control cabinet. Get in touch with the planner of the design scheme. Check the terminal base compatibility and the terminal unit compatibility.</td>
</tr>
<tr>
<td>An AC500-eCo V3 processor module does not start.</td>
<td>Configuration error due to wrong firmware of the option boards.</td>
<td>Update the option boards TA5141-RS232I, TA5142-RS485I and TA5142-RS485 at least to system firmware 3.5.0_HF-7 and boot firmware 3.5.1 or higher. Use Automation Builder 2.5.2 or higher.</td>
</tr>
<tr>
<td>The module does not respond and is not available for online connection.</td>
<td>Module is not connected to the power supply. Or module is not functional any more.</td>
<td>Check power supply. Replace the module or HMI.</td>
</tr>
<tr>
<td>Fault description</td>
<td>Cause</td>
<td>Remedy</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------</td>
<td>--------</td>
</tr>
<tr>
<td>The module does not respond and is not available for online connection.</td>
<td>Module is not connected to the power supply. Or module is not functional any more.</td>
<td>⇢ Chapter 4.9.2 “Replace an AC500 module” on page 152</td>
</tr>
</tbody>
</table>
| I/O module on a hot swap terminal unit does not respond and is not available for online connection. | I/O module is not plugged or damaged. | As soon as the correct and operational I/O module is plugged on the terminal unit, the module is configured and ready to start.  
⇛ Hot swap behavior of I/O modules  
⇛ Hot swap behavior of remote I/O modules |
| After hot swap of a (remote) I/O module, the system and/or I/O module does not start. | Wrong I/O module type plugged. The type must be the same as of the replaced module. | Plug the correct I/O module type. |
| The display of the control panel is black. | Control panel is not connected to the power supply. Or control panel is not functional any more. | Check power supply.  
Replace the control panel. |
| ERR LED of the processor module flashes fast. The display shows “AC500”. | A fatal system error occurred. | Contact ABB technical support |
| ERR LED of the processor module flashes. RUN LED is off. The display shows “FAIL”. | Installation or update of firmware, boot project or application failed. | Restart the device. Perform the installation or update again.  
⇛ Chapter 4.7.4 “PLC firmware/application update” on page 148 |
| ERR LED is on. | PLC with event* or unacknowledged alarm*. | ● Use Automation Builder, IEC application or other external access available in your project, e.g., a control panel, to read out and acknowledge the diagnosis messages.  
In Automation Builder, double-click on a device and select the “Diagnosis” tab to access the diagnosis messages.  
Or:  
● Read out the diagnosis data on the display of the processor module.  
⇛ Chapter 6.9.3 “Diagnosis messages” on page 4655 |
| The display of the processor module shows “Demo” for 5 min at every license check. (For processor modules without display only visible when logged in with Automation Builder.) | PLC runs in demo mode because at least one feature license is missing. The demo license is valid for 10 days PLC in run. After this time, PLC will go to stop mode. | You can buy the missing license or extend the demo license via Automation Builder. The PLC will not switch back to run mode until a new license is activated or the licensed features are removed from the PLC application.  
⇛ Chapter 6.2.4 “Managing your licenses” on page 1350  
⇛ Chapter 6.3.2.2.2 “PLC runtime licensing” on page 1446 |
| Every 10 min, the display of the processor module shows “Grace” for 5 min. | PLC runs in grace mode because at least one feature license which has been available disappeared. If the grace time expires, PLC will go to stop mode. | You need to buy or activate the missing. We recommend to use the Automation Builder for activation. After the PLC is in stop mode, it will not switch back to run mode until a new license is activated or the licensed features are removed from the PLC application.  
⇛ Chapter 6.2.4 “Managing your licenses” on page 1350 |
<table>
<thead>
<tr>
<th>Fault description</th>
<th>Cause</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Every 10 min, the display of the processor module shows “Grace” for 5 min.</td>
<td>PLC runs in grace mode because at least one feature license which has been available disappeared. If the grace time expires, PLC will go to stop mode.</td>
<td>§ Chapter 6.3.2.2 “PLC runtime licensing” on page 1446</td>
</tr>
<tr>
<td>The CPU displays “noConn” (no connection).</td>
<td>No communication between CPU and display is possible due do very high CPU load (e.g., endless loop in user program and not activated task watchdog).</td>
<td>Check the application for loops and operations they need time. For example file handling. Wait for response from other device who will block the execution from other code.</td>
</tr>
</tbody>
</table>

If a problem persists, contact ABB technical support. In order to be able to solve your problem as soon as possible, please provide the affected Automation Builder project or Panel Builder project, the log files and the firmware versions. How to read out log files is described in the application note How to get log information.

### 4.8.3 Execution of a hotfix

Updates (also hotfixes) are displayed at every system start, if available. § Chapter 6.2.2 “Automation Builder updates” on page 1350

Hotfixes can be in different files - *.exe, *.package or Linux (for communication interface modules).

**Hotfix file via memory card**

A hotfix PLC firmware file (*.exe) can be installed via a memory card. § Chapter 6.3.1.4.5.2.3 “Execution of update via memory card” on page 1430

**Communication interface (CI) module firmware**

The firmware of AC500 communication interface modules can be updated with the IP configuration tool.

**Advanced: Manual installation in Automation Builder**

1. Download the current firmware hotfix from the PLC website.
2. Save and unpack the .zip file at any location of your hard disc.
3. Save and close open projects in Automation Builder.
4. In the menu bar of the Automation Builder open the “Package Manager”. “Tools ➔ Package Manager”
   - The “Package Manager” opens.
5. Follow the instructions. § Chapter 6.4.1.21.3.9.4 “Command 'Package Manager’” on page 2655
4.9 Maintenance

4.9.1 Maintenance intervals

<table>
<thead>
<tr>
<th>Interval</th>
<th>Maintenance work</th>
</tr>
</thead>
<tbody>
<tr>
<td>After 3 years of utilisation or as soon as possible after the PLC diagnosis message &quot;low battery warning&quot;</td>
<td>Replace battery of the CPU.</td>
</tr>
<tr>
<td>Regularly or when the faceplate of the control panel is dusty.</td>
<td>Keep the faceplate of the control panel clean.</td>
</tr>
<tr>
<td></td>
<td>Refer to the panel's operating instruction.</td>
</tr>
</tbody>
</table>

4.9.2 Replace an AC500 module

CAUTION!
Risk of injury and damaging the product!
Improper installation and maintenance may result in injury and can damage the product!
- Installation and maintenance have to be performed according to the technical rules, codes and relevant standards, e.g. EN 60204-1.
- Only by qualified personnel.

WARNING!
Removal/Insertion under power
The devices are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you
- connect or disconnect any signal or terminal block
- remove, mount or replace a module.

Disconnecting any powered devices while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The devices must not be opened when in operation. The same applies to the network interfaces.

All modules of the AC500 range are maintenance free. Spare parts are not available and repair is not allowed. If a module is not functional any more, you have to replace the whole module.

If an I/O module is installed on a hot swap terminal unit, it is possible to replace it with the same type during runtime.

☞ Chapter 4.9.3 “Replace an I/O module with hot swap” on page 153

If an I/O module is installed on a terminal unit that does not support hot swap and for all other AC500 modules, proceed as follows.

1. Disconnect the power supply.
2. For processor modules, insert the memory card into the new module.
For communication modules, adjust the position of the rotary switches on the new module.

For terminal units and terminal bases, disconnect the connectors from the old module.

Demount the module to be replaced as described in the installation instructions.

Mount the new module as described in the installation instructions.

For terminal units and terminal bases, connect the connectors.

Reconnect the power supply.

System boots up again.

If necessary, update module firmware. Chapter 4.7.4 “PLC firmware/application update” on page 148.

If a processor module is replaced, you must install the firmware, the application, the licenses, passwords and the certificates on the new processor module.

Chapter 6.3.1.4.2.2 “CPU firmware” on page 1419

Chapter 4.7.4 “PLC firmware/application update” on page 148

Chapter 6.3.2.2.2 “PLC runtime licensing” on page 1446

Chapter 6.6.2.2 “Encrypted Communication with Devices via Controller Certificates” on page 4201

Chapter 6.4.1.6 “Protecting and Saving Projects” on page 1819

Chapter 6.4.1.11 “Downloading an Application to the PLC” on page 1965

If a problem persists, contact ABB technical support.

4.9.3 Replace an I/O module with hot swap

4.9.3.1 Preconditions for using hot swap

Conditions for hot swapping

- Digital outputs are not under load.
- Input/output voltages above safety extra low voltage/protective extra low voltages (SELV/PELV) are switched off.
- Modules are completely plugged on the terminal unit with both snap fit engaged before switching on loads or input/output voltage.

WARNING!
Risk of explosion or fire in hazardous environments during hot swapping!

Hot swap must not be performed in flammable environments to avoid life-threatening injury and property damage resulting from fire or explosion.
WARNING!
Electric shock due to negligent behavior during hot swapping!
To avoid electric shock:
- Make sure the following conditions apply:
  - Digital outputs are not under load.
  - Input/output voltages above safety extra low voltage/protective extra low voltage (SELV/PELV) are switched off.
  - Modules are fully interlocked with the terminal unit with both snap-fits engaged before switching on loads or input/output voltage.
  - Never touch exposed contacts (dangerous voltages).
  - Stay away from electrical contacts to avoid arc discharge.
  - Do not operate a mechanical installation improperly.

NOTICE!
Risk of damage to I/O modules!
Hot swapping is only allowed for I/O modules.
Processor modules and communication interface modules must not be removed or inserted during operation.

H = Hot swap

Hot swap
System requirements for hot swapping of I/O modules:
- Types of terminal units that support hot swapping of I/O modules have the appendix TU5xx-H.
- I/O modules as of index F0.
The following I/O bus masters support hot swapping of attached I/O modules:
- Communication interface modules CI5xx as of index F0.
- Processor modules PM56xx-2ETH with firmware version as of V3.2.0.

Hot swap is not supported by AC500-eCo V3 CPU!
The index of the module is in the right corner of the label.

**NOTICE!**
**Risk of damage to I/O modules!**
Modules with index below F0 can be damaged when inserted or removed from the terminal unit in a powered system.

**NOTICE!**
**Risk of damage to I/O modules!**
Do not perform hot swapping if any I/O module with firmware version lower than 3.0.14 is part of the I/O configuration.

For min. required device index see table below.

<table>
<thead>
<tr>
<th>Device</th>
<th>Min. required device index for I/O module as of FW Version 3.0.14</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC522(-XC)</td>
<td>F0</td>
</tr>
<tr>
<td>AI523 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AI531</td>
<td>D4</td>
</tr>
<tr>
<td>AI531-XC</td>
<td>D2</td>
</tr>
<tr>
<td>AI561</td>
<td>B2</td>
</tr>
<tr>
<td>AI562</td>
<td>B2</td>
</tr>
<tr>
<td>AI563</td>
<td>B3</td>
</tr>
<tr>
<td>AO523 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AO561</td>
<td>B2</td>
</tr>
<tr>
<td>AX521 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AX522 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AX561</td>
<td>B2</td>
</tr>
<tr>
<td>CD522 (-XC)</td>
<td>D1</td>
</tr>
<tr>
<td>DA501 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DA502 (-XC)</td>
<td>F0</td>
</tr>
<tr>
<td>DC522 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DC523 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DC532 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DC562</td>
<td>A2</td>
</tr>
<tr>
<td>DI524 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DI561</td>
<td>B2</td>
</tr>
<tr>
<td>DI562</td>
<td>B2</td>
</tr>
<tr>
<td>DI571</td>
<td>B2</td>
</tr>
<tr>
<td>DI572</td>
<td>A1</td>
</tr>
</tbody>
</table>
### Device Min. required device index for I/O module as of FW Version 3.0.14

<table>
<thead>
<tr>
<th>Device</th>
<th>Min. required device index</th>
</tr>
</thead>
<tbody>
<tr>
<td>DO524 (-XC)</td>
<td>A3</td>
</tr>
<tr>
<td>DO526</td>
<td>A2</td>
</tr>
<tr>
<td>DO526-XC</td>
<td>A0</td>
</tr>
<tr>
<td>DO561</td>
<td>B2</td>
</tr>
<tr>
<td>DO562</td>
<td>A2</td>
</tr>
<tr>
<td>DO571</td>
<td>B3</td>
</tr>
<tr>
<td>DO572</td>
<td>B2</td>
</tr>
<tr>
<td>DO573</td>
<td>A1</td>
</tr>
<tr>
<td>DX522 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DX531</td>
<td>D2</td>
</tr>
<tr>
<td>DX561</td>
<td>B2</td>
</tr>
<tr>
<td>DX571</td>
<td>B3</td>
</tr>
<tr>
<td>FM562</td>
<td>A1</td>
</tr>
</tbody>
</table>

### 4.9.3.2 Compatibility of hot swap

*Hot swap is not supported by AC500-eCo V3 CPU!*

<table>
<thead>
<tr>
<th>Central I/O on V3 CPU</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O module on TU5xx-H connected to I/O bus master</td>
</tr>
<tr>
<td>AC500 V3 CPU types:</td>
</tr>
<tr>
<td>PM56xx-2ETH</td>
</tr>
<tr>
<td>Required version of I/O bus master</td>
</tr>
<tr>
<td>Firmware as of V3.2.0</td>
</tr>
<tr>
<td>Fieldbus master when used as remote I/O with AC500 V3</td>
</tr>
<tr>
<td>-</td>
</tr>
<tr>
<td>When used as remote I/O on third party controller (PLC or DCS)</td>
</tr>
<tr>
<td>-</td>
</tr>
</tbody>
</table>
### 4.9.3.3 Hot swap behavior

<table>
<thead>
<tr>
<th>Hot swap behavior</th>
<th>Central I/O on V3 CPU</th>
</tr>
</thead>
</table>
| Start-up behavior with unplugged or damaged I/O module on hot swap terminal unit TU5xx-H | System and I/O modules attached to the CPU are starting (except unplugged or damaged module when plugged on hot swap terminal unit).  
As soon as the correct and operational I/O module is plugged on the terminal unit, the module is configured and ready to start.  
No specific setting needed. |
| Start-up behavior with wrong I/O module type on any terminal unit | System and I/O modules are not starting                                              |
| Diagnosis of presence of hot swap terminal unit        | Diagnosis using PLC browser command "io-bus desc" in Automation Builder V3.         |
|                                                      | The PLC browser then provides an overview of the modules on the I/O bus including the position of hot swap terminal units in the I/O bus. |
|                                                      | In the application program this can be detected with a function block "IoModuleHotSwapInfo" (Library: AC500_Io/Function Blocks/I/O-Bus). |
|                                                      | One instance of function block is needed per terminal unit on the I/O bus. The function block provides five outputs delivering information about slot number, hot swap capability and plugged/unplugged state of the I/O module |
| Diagnosis while hot swap module is pulled or module (mounted on hot swap terminal unit) has stopped working | If module is pulled then diagnosis Err 9480 "Module removed from Hot Swap Terminal Unit" is generated |
| Diagnosis after plugging the I/O module on the hot swap terminal unit | Diagnosis Err 9480 is automatically acknowledged |

### 4.9.4 Replace a CP600 control panel

Control panels are maintenance free. Spare parts are not available and repair is not permitted. If a control panel becomes inoperable, it must be replaced. An operation manual is included with the new unit.

For instructions on how to transfer the runtime to a new control panel and how to load projects to a new control panel, refer to the Panel Builder manual.

The procedure for changing from a CP600 device to a CP600 device of the 2nd generation is described in the application example Converting a CP600 project. A description of the differences between both device variants can also be found in this application example.

### 4.10 Decommissioning

1. Delete the runtime licenses from the device by returning the licenses.
   ¶ Chapter 6.3.2.2.2.5 “Returning a license” on page 1452
2. Delete certificates available on the CPU.
   ⇤ Chapter 6.6.2.4.1 “View ’Security Screen’ - ’Devices’” on page 4205
3. Delete applications.
   ⇤ Chapter 6.4.1.21.3.7.12 “Command ’Reset Origin’” on page 2635
   ⇤ Chapter 6.4.1.21.3.7.13 “Command ’Reset Origin Device’” on page 2636
4. Delete applications from memory card, if available.
   ⇤ Chapter 6.4.1.15 “Copying files to/from PLC” on page 2027
5. If available, remove memory card and battery from CPU.
6. Delete all user accounts and user data.
   ⇤ “Tab ’User’” on page 2593
7. Demount and dispose the hardware modules.
   ⇤ Demount AC500, AC500-XC and AC500-S
   ⇤ Chapter 4.11 “Recycling” on page 158

If you cannot access the data stored in the CPU, e.g., because the CPU is not functional any more, then physically destroy the device.

This ensures that the credentials that are stored in the device, cannot be misused.

4.11 Recycling

Disposal and recycling information
This symbol on the product (and on its packaging) is in accordance with the European Union’s Waste Electrical and Electronic Equipment (WEEE) Directive.

The symbol indicates that this product must be recycled/disposed of separately from other household waste.

It is the end user’s responsibility to dispose of this product by taking it to a designated WEEE collection facility for the proper collection and recycling of the waste equipment.

The separate collection and recycling of waste equipment will help to conserve natural resources and protect human health and the environment.

For more information about recycling, please contact your local environmental office, an electrical/electronic waste disposal company or the store where you purchased the product.
5 Hardware descriptions

5.1 Technical data of the system

5.1.1 System data AC500-eCo

5.1.1.1 Environmental conditions

### Table 16: Process and supply voltages

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>24 V DC</td>
<td></td>
</tr>
<tr>
<td>Voltage</td>
<td>24 V (-15 %, +20 %)</td>
</tr>
<tr>
<td>Protection against reverse polarity</td>
<td>Yes</td>
</tr>
<tr>
<td>24 V AC</td>
<td></td>
</tr>
<tr>
<td>Voltage</td>
<td>24 V (-15 %, +10 %)</td>
</tr>
<tr>
<td>Frequency</td>
<td>50/60 Hz (-6 %, +4 %)</td>
</tr>
<tr>
<td>100 V AC ... 240 V AC wide-range supply</td>
<td></td>
</tr>
<tr>
<td>Voltage</td>
<td>100 V ... 240 V (-15 %, +10 %)</td>
</tr>
<tr>
<td>Frequency</td>
<td>50/60 Hz (-6 %, +4 %)</td>
</tr>
</tbody>
</table>

Allowed interruptions of power supply, according to EN 61131-2

| DC supply                     | Interruption < 10 ms, time between 2 interruptions > 1 s, PS2 |
| DC supply (only for analog option boards TA512x) | Interruption < 1 ms, time between 2 interruptions > 1 s, PS1 |

---

**NOTICE!**

Risk of damaging the PLC due to improper voltage levels!

- Never exceed the maximum tolerance values for process and supply voltages.
- Never fall below the minimum tolerance values for process and supply voltages.

Observe the system data and the technical data of the used module.

☞ Chapter 5.1.1 “System data AC500-eCo” on page 159

---

**NOTICE!**

Improper voltage level or frequency range which cause damage of AC inputs:

- AC voltage above 264 V
- Frequency below 47 Hz or above 62.4 Hz

---

**NOTICE!**

Improper connection leads cause overtemperature on terminals.

PLC modules may be destroyed by using wrong cable type, wire size and cable temperature classification.

---

CPUs
### Table 17: Temperature ranges for processor modules revision 0

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PM5012-x-ETH</strong></td>
<td><strong>PM5032-x-ETH, PM5052-x-ETH, PM5072-T-2ETH</strong></td>
</tr>
<tr>
<td>Temperature</td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td></td>
</tr>
<tr>
<td>Horizontal mounting</td>
<td>0 °C ... +55 °C</td>
</tr>
<tr>
<td>Vertical mounting (output load reduced to 50 % per group)</td>
<td>0 °C ... +40 °C</td>
</tr>
<tr>
<td>Storage</td>
<td>-40 °C ... +70 °C</td>
</tr>
<tr>
<td>Transport</td>
<td>-40 °C ... +70 °C</td>
</tr>
<tr>
<td>Humidity</td>
<td>Max. 95 %, without condensation</td>
</tr>
<tr>
<td>Air pressure</td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>&gt; 800 hPa / &lt; 2000 m</td>
</tr>
<tr>
<td>Storage</td>
<td>&gt; 660 hPa / &lt; 3500 m</td>
</tr>
</tbody>
</table>

Between 60 °C ... 70 °C: I/O derating to 75 %

Only 75 % of the I/O channels are allowed to be energized simultaneously, e.g., only 6 of 8 output channels.

### Table 18: Temperature ranges for processor modules revision 1

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PM5012-x-ETH</strong></td>
<td><strong>PM5032-x-ETH, PM5052-x-ETH, PM5072-T-2ETH, PM5082-T-2ETH</strong></td>
</tr>
<tr>
<td>Temperature</td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td></td>
</tr>
<tr>
<td>Horizontal mounting</td>
<td>0 °C ... +55 °C</td>
</tr>
<tr>
<td>Vertical mounting (output load reduced to 50 % per group)</td>
<td>0 °C ... +40 °C</td>
</tr>
<tr>
<td>Storage</td>
<td>-40 °C ... +70 °C</td>
</tr>
<tr>
<td>Transport</td>
<td>-40 °C ... +70 °C</td>
</tr>
<tr>
<td>Humidity</td>
<td>Max. 95 %, without condensation</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>-----------</td>
<td>-------</td>
</tr>
<tr>
<td>PM5012-x-ETH</td>
<td>PM5032-x-ETH, PM5052-x-ETH, PM5072-T-2ETH, PM5082-T-2ETH</td>
</tr>
<tr>
<td>PM5072-T-2ETHW</td>
<td></td>
</tr>
<tr>
<td>Air pressure</td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>&gt; 800 hPa / &lt; 2000 m</td>
</tr>
<tr>
<td>Storage</td>
<td>&gt; 660 hPa / &lt; 3500 m</td>
</tr>
</tbody>
</table>

Option boards

Table 19: Standard temperature ranges with processor modules revision 0

<table>
<thead>
<tr>
<th>Option boards</th>
<th>Configuration</th>
<th>Processor modules</th>
<th>Operating temperature ranges</th>
<th>Derating</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital I/O option boards</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TA5101-4DI</td>
<td>Not relevant</td>
<td>PM5012-x-ETH</td>
<td>0 °C ... +55 °C</td>
<td>No derating</td>
</tr>
<tr>
<td>TA5105-4DOT</td>
<td>Not relevant</td>
<td>PM50x2-x-ETH</td>
<td>0 °C ... +60 °C</td>
<td>No derating</td>
</tr>
<tr>
<td>TA5110-2DI2DOT</td>
<td>Not relevant</td>
<td>PM5072-T-2ETH</td>
<td>0 °C ... +60 °C</td>
<td>No derating</td>
</tr>
<tr>
<td>Analog input option boards</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TA5120-2AI-UI</td>
<td>Not relevant</td>
<td>PM5012-x-ETH</td>
<td>0 °C ... +55 °C</td>
<td>No derating</td>
</tr>
<tr>
<td>TA5123-2AI-RTD</td>
<td>Not relevant</td>
<td>PM50x2-x-ETH</td>
<td>0 °C ... +60 °C</td>
<td>No derating</td>
</tr>
<tr>
<td>Analog output option boards</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TA5126-2AO-UI</td>
<td>0 V ... +10 V</td>
<td>PM5012-T-ETH</td>
<td>0 °C ... +55 °C</td>
<td>No derating</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PM50x2-R-ETH</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PM50x2-T-ETH</td>
<td>0 °C ... +60 °C</td>
<td>No derating</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PM5072-T-2ETH</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0 mA ... +20 mA</td>
<td>PM50x2-x-ETH</td>
<td>0 °C ... +45 °C</td>
<td>No derating</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PM5072-T-2ETH</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>+45 °C ... +50 °C</td>
<td>50 %</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Load: 250 Ω ... 500 Ω</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>+50 °C ... +55 °C</td>
<td>100 %</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Load: 500 Ω</td>
<td></td>
</tr>
<tr>
<td>Accessory option boards</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TA5130-KNXPB</td>
<td>Not relevant</td>
<td>PM5072-T-2ETH</td>
<td>0 °C ... 60 °C</td>
<td>No derating</td>
</tr>
<tr>
<td>TA5131-RTC</td>
<td>Not relevant</td>
<td>PM5012-x-ETH</td>
<td>0 °C ... +55 °C</td>
<td>No derating</td>
</tr>
<tr>
<td>Option boards for serial interface</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TA5141-RS232I</td>
<td>Not relevant</td>
<td>PM5012-x-ETH</td>
<td>0 °C ... +55 °C</td>
<td>No derating</td>
</tr>
<tr>
<td>TA5142-RS485I</td>
<td>Not relevant</td>
<td>PM50x2-x-ETH</td>
<td>0 °C ... +60 °C</td>
<td>No derating</td>
</tr>
<tr>
<td>TA5142-RS485</td>
<td></td>
<td>PM5072-T-2ETH</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 20: Standard temperature ranges with processor modules revision 1

<table>
<thead>
<tr>
<th>Option boards</th>
<th>Configuration</th>
<th>Processor modules</th>
<th>Operating temperature ranges</th>
<th>Derating</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Digital I/O option boards</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TA5101-4DI</td>
<td>Not relevant</td>
<td>PM5012-x-ETH</td>
<td>0 °C ... +55 °C</td>
<td>No derating</td>
</tr>
<tr>
<td>TA5105-4DOT</td>
<td></td>
<td>PM50x2-x-ETH</td>
<td>-20 °C ... +60 °C</td>
<td>No derating</td>
</tr>
<tr>
<td>TA5110-2DI2DOT</td>
<td></td>
<td>PM50x2-T-2ETH</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Analog input option boards</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TA5120-2AI-UI</td>
<td>Not relevant</td>
<td>PM5012-x-ETH</td>
<td>0 °C ... +55 °C</td>
<td>No derating</td>
</tr>
<tr>
<td>TA5123-2AI-RTD</td>
<td></td>
<td>PM50x2-x-ETH</td>
<td>-20 °C ... +60 °C</td>
<td>No derating</td>
</tr>
<tr>
<td><strong>Analog output option boards</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TA5126-2AO-UI</td>
<td>0 V ... +10 V</td>
<td>PM5012-T-ETH</td>
<td>0 °C ... +55 °C</td>
<td>No derating</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PM50x2-R-ETH</td>
<td>-20 °C ... +55 °C</td>
<td>No derating</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PM50x2-T-ETH</td>
<td>-20 °C ... +60 °C</td>
<td>No derating</td>
</tr>
<tr>
<td></td>
<td>0 mA ... +20 mA</td>
<td>PM5012-x-ETH</td>
<td>0 °C ... +45 °C</td>
<td>No derating</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PM50x2-x-ETH</td>
<td>-20 °C ... +45 °C</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PM50x2-T-ETH</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PM50x2-T-ETH</td>
<td>+45 °C ... +50 °C</td>
<td>50 % Load: 250 Ω ... 500 Ω</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PM50x2-x-ETH</td>
<td>+50 °C ... +55 °C</td>
<td>100 % Load: 500 Ω</td>
</tr>
<tr>
<td><strong>Accessory option boards</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TA5130-KNXPB</td>
<td>Not relevant</td>
<td>PM50x2-T-2ETH</td>
<td>-20 °C ... 60 °C</td>
<td>No derating</td>
</tr>
<tr>
<td><strong>Option boards for serial interface</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TA5141-RS232I</td>
<td>Not relevant</td>
<td>PM5012-x-ETH</td>
<td>0 °C ... +55 °C</td>
<td>No derating</td>
</tr>
<tr>
<td>TA5142-RS485I</td>
<td></td>
<td>PM50x2-x-ETH</td>
<td>-20 °C ... +60 °C</td>
<td>No derating</td>
</tr>
<tr>
<td>TA5142-RS485</td>
<td></td>
<td>PM50x2-T-2ETH</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Table 21: Wide temperature ranges

<table>
<thead>
<tr>
<th>Option boards</th>
<th>Configuration</th>
<th>Processor modules</th>
<th>Operating temperature ranges</th>
<th>Derating</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Digital I/O option boards</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TA5101-4DIW</td>
<td>Not relevant</td>
<td>PM5072-T-2ETHW</td>
<td>-20 °C ... +60 °C</td>
<td>No derating</td>
</tr>
<tr>
<td>TA5105-4DOTW</td>
<td></td>
<td></td>
<td>+60 °C ... +70 °C</td>
<td>I/O derating to 75 % Only 3 of 4 I/O channels are allowed to be energized simultaneously.</td>
</tr>
<tr>
<td>TA5110-2DI2DOW</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Analog input option boards</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Option boards

<table>
<thead>
<tr>
<th>Option boards</th>
<th>Configuration</th>
<th>Processor modules</th>
<th>Operating temperature ranges</th>
<th>Derating</th>
</tr>
</thead>
<tbody>
<tr>
<td>TA5120-2AI-UIW</td>
<td>Not relevant</td>
<td>PM5072-T-2ETHW</td>
<td>-20 °C ... +60 °C</td>
<td>No derating</td>
</tr>
<tr>
<td>TA5123-2AI-RTW</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Analog output option boards

<table>
<thead>
<tr>
<th>Option boards</th>
<th>Configuration</th>
<th>Processor modules</th>
<th>Operating temperature ranges</th>
<th>Derating</th>
</tr>
</thead>
<tbody>
<tr>
<td>TA5126-2AO-UIW</td>
<td>0 V ... +10 V</td>
<td>PM5072-T-2ETHW</td>
<td>-20 °C ... +60 °C</td>
<td>No derating</td>
</tr>
<tr>
<td></td>
<td>0 mA ... +20 mA</td>
<td>PM5072-T-2ETHW</td>
<td>-20 °C ... +45 °C</td>
<td>No derating</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>+45 °C ... +50 °C</td>
<td>Load: 0 Ω ... 500 Ω</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>+50 °C ... +55 °C</td>
<td>50 % Load: 250 Ω ... 500 Ω</td>
</tr>
</tbody>
</table>

### Accessory option boards

<table>
<thead>
<tr>
<th>Option boards</th>
<th>Configuration</th>
<th>Processor modules</th>
<th>Operating temperature ranges</th>
<th>Derating</th>
</tr>
</thead>
<tbody>
<tr>
<td>TA5130-KNXPBW</td>
<td>Not relevant</td>
<td>PM5072-T-2ETHW</td>
<td>-20 °C ... 70 °C</td>
<td>No derating</td>
</tr>
</tbody>
</table>

### Option boards for serial interface

<table>
<thead>
<tr>
<th>Option boards</th>
<th>Configuration</th>
<th>Processor modules</th>
<th>Operating temperature ranges</th>
<th>Derating</th>
</tr>
</thead>
<tbody>
<tr>
<td>TA5141-RS232IW</td>
<td>Not relevant</td>
<td>PM5072-T-2ETHW</td>
<td>-20 °C ... +70 °C</td>
<td>No derating</td>
</tr>
<tr>
<td>TA5142-RS485IW</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TA5142-RS485W</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 5.1.1.2 Creepage distances and clearances

The creepage distances and clearances meet the requirements of the overvoltage category II, pollution degree 2.

### 5.1.1.3 Power supply units

AC500 and AC500-eCo PLC devices are Class II/Class III devices and do not require a Protective Earth (PE) connection.

For proper EMC performance, all metal parts, DIN rails, mounting screws, and cable shield connection terminals are connected to a common ground and provide Functional Earth (FE). This is typically connected to a common reference potential, such as equipotential bonding rails.

Signal Grounds (SGND or GND) are used for signal reference and must not be connected to cable shields, FE or other signals unless otherwise specified in the specific device description.

For the supply of the modules, power supply units according to SELV or PELV specifications must be used.
Safety Extra Low Voltage (SELV) and Protective Extra Low Voltage (PELV)

To ensure electrical safety of AC500/AC500-eCo extra low voltage circuits, 24 V DC supply, communication interfaces, I/O circuits, and all connected devices must be powered from sources meeting requirements of SELV, PELV, class 2, limited voltage or limited power according to applicable standards.

WARNING!
Improper installation can lead to death by touching hazardous voltages!
To avoid personal injury, safe separation, double or reinforced insulation and separation of the primary and secondary circuit must be observed and implemented during installation.

- Only use power converters for safety extra-low voltages (SELV) with safe galvanic separation of the primary and secondary circuit.
- Safe separation means that the primary circuit of mains transformers must be separated from the secondary circuit by double or reinforced insulation. The protective extra-low voltage (PELV) offers protection against electric shock.

5.1.1.4 Electromagnetic compatibility

Table 22: Electromagnetic compatibility

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device suitable only as Control Equipment for Industrial Applications, including marine applications. IEC 61131-2, zone B</td>
<td></td>
</tr>
<tr>
<td>© Chapter 5.1.1.6 “Approvals and certifications” on page 166</td>
<td></td>
</tr>
<tr>
<td>Radiated emission according to IEC 61000-6-4 CISPR11, class A</td>
<td>Yes</td>
</tr>
<tr>
<td>Conducted emission according to IEC 61000-6-4 CISPR11, class A</td>
<td>Yes</td>
</tr>
<tr>
<td>Electrostatic discharge (ESD) according to IEC 61000-4-2, criterion B</td>
<td>Air discharge: 8 kV Contact discharge: 6 kV</td>
</tr>
<tr>
<td>Fast transient interference voltages (burst) according to IEC 61000-4-4, criterion B</td>
<td>Power supply (DC): 2 kV Digital inputs/outputs (24 V DC): 1 kV Digital inputs/outputs (240 V AC): 2 kV Analog inputs/outputs: 1 kV Communication lines shielded: 1 kV</td>
</tr>
</tbody>
</table>
### Parameter Value

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
</table>
| High energy transient interference voltages (surge) according to IEC 61000-4-5, criterion B | Power supply (DC):  
- Line to ground: 1 kV  
- Line to line: 0.5 kV  
Digital inputs/outputs/relay:  
(24 V DC):  
- Line to ground: 1 kV  
(AC):  
- Line to ground: 2 kV  
- Line to line: 1 kV  
Analog inputs/outputs:  
- Line to ground: 1 kV  
Communication lines:  
- Line to ground: 1 kV |
| Influence of radiated disturbances IEC 61000-4-3, criterion A | Test field strength: 10 V/m |
| Influence of line-conducted interferences IEC 61000-4-6, criterion A | Test voltage: 10 V |
| Power frequency magnetic fields IEC 61000-4-8, criterion A | 30 A/m 50 Hz  
30 A/m 60 Hz |

### 5.1.1.5 Mechanical data

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mounting</td>
<td>Horizontal/vertical</td>
</tr>
<tr>
<td>Wiring method</td>
<td>Spring/screw terminals</td>
</tr>
</tbody>
</table>
| Degree of protection | PLC system: IP 20  
- with all modules or option boards plugged in  
- with all terminals plugged in  
- with all covers closed |
| Housing | Classification V-0 according to UL 94 |
| Vibration resistance (sinusoidal) acc. to IEC 60068-2-6 | All three axes  
2 Hz ... 8.4 Hz, 3.5 mm peak,  
8.4 Hz ... 150 Hz, 1 g |
| Shock test acc. to IEC 60068-2-27 | All three axes  
15 g, 11 ms, half-sinusoidal |
| Mounting of the modules: |  |
| Mounting Rail Top Hat according to IEC 60715 | 35 mm, depth 7.5 mm or 15 mm |
| Mounting with screws | M4 |
| Fastening torque | 1.2 Nm |
5.1.6 Approvals and certifications

The PLC Automation catalog contains an overview of the available approvals and certifications.

5.1.2 System data AC500

5.1.2.1 Environmental conditions

Table 23: Process and supply voltages

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>24 V DC</td>
<td></td>
</tr>
<tr>
<td>Voltage</td>
<td>24 V (-15 %, +20 %)</td>
</tr>
<tr>
<td>Protection against reverse polarity</td>
<td>Yes</td>
</tr>
<tr>
<td>100 V AC...240 V AC wide-range supply</td>
<td></td>
</tr>
<tr>
<td>Voltage</td>
<td>100 V ... 240 V (-15 %, +10 %)</td>
</tr>
<tr>
<td>Frequency</td>
<td>50/60 Hz (-6 %, +4 %)</td>
</tr>
<tr>
<td>Allowed interruptions of power supply, according to EN 61131-2</td>
<td></td>
</tr>
<tr>
<td>DC supply</td>
<td>Interruption &lt; 10 ms, time between 2 interruptions &gt; 1 s, PS2</td>
</tr>
<tr>
<td>AC supply</td>
<td>Interruption &lt; 0.5 periods, time between 2 interruptions &gt; 1 s</td>
</tr>
</tbody>
</table>

**NOTICE!**

Risk of damaging the PLC due to improper voltage levels!

- Never exceed the maximum tolerance values for process and supply voltages.
- Never fall below the minimum tolerance values for process and supply voltages.

Observe the system data Chapter 5.1.2 “System data AC500” on page 166 and the technical data of the module used.

**NOTICE!**

Improper voltage level or frequency range which cause damage of AC inputs:

- AC voltage above 264 V
- Frequency below 47 Hz or above 62.4 Hz

**NOTICE!**

Improper connection leads cause overtemperature on terminals.

PLC modules may be destroyed by using wrong cable type, wire size and cable temperature classification.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>0 °C ... +60 °C: Horizontal mounting of modules.</td>
</tr>
<tr>
<td></td>
<td>0 °C ... +40 °C: Vertical mounting of modules. Output load reduced to 50 % per group.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>Storage</td>
<td>-40 °C ... +70 °C</td>
</tr>
<tr>
<td>Transport</td>
<td>-40 °C ... +70 °C</td>
</tr>
<tr>
<td>Humidity</td>
<td>Max. 95 %, without condensation</td>
</tr>
<tr>
<td>Air pressure</td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>&gt; 800 hPa / &lt; 2000 m</td>
</tr>
<tr>
<td>Storage</td>
<td>&gt; 660 hPa / &lt; 3500 m</td>
</tr>
</tbody>
</table>

### 5.1.2.2 Creepage distances and clearances
The creepage distances and clearances meet the requirements of the overvoltage category II, pollution degree 2.

### 5.1.2.3 Power supply units

AC500 and AC500-eCo PLC devices are Class II/Class III devices and do not require a Protective Earth (PE) connection.

For proper EMC performance, all metal parts, DIN rails, mounting screws, and cable shield connection terminals are connected to a common ground and provide Functional Earth (FE). This is typically connected to a common reference potential, such as equipotential bonding rails.

Signal Grounds (SGND or GND) are used for signal reference and must not be connected to cable shields, FE or other signals unless otherwise specified in the specific device description.

For the supply of the modules, power supply units according to SELV or PELV specifications must be used.

### Safety Extra Low Voltage (SELV) and Protective Extra Low Voltage (PELV)
To ensure electrical safety of AC500/AC500-eCo extra low voltage circuits, 24 V DC supply, communication interfaces, I/O circuits, and all connected devices must be powered from sources meeting requirements of SELV, PELV, class 2, limited voltage or limited power according to applicable standards.

### WARNING!
Improper installation can lead to death by touching hazardous voltages!
To avoid personal injury, safe separation, double or reinforced insulation and separation of the primary and secondary circuit must be observed and implemented during installation.

- Only use power converters for safety extra-low voltages (SELV) with safe galvanic separation of the primary and secondary circuit.
- Safe separation means that the primary circuit of mains transformers must be separated from the secondary circuit by double or reinforced insulation. The protective extra-low voltage (PELV) offers protection against electric shock.
### Electromagnetic compatibility

*Table 24: Electromagnetic compatibility*

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device suitable only as <em>Control Equipment for Industrial Applications</em>, including marine applications. IEC 61131-2, zone B</td>
<td></td>
</tr>
</tbody>
</table>
   - Yes [Chapter 5.1.2.6 “Approvals and certifications” on page 169](#) |
| Radiated emission according to IEC 61000-6-4 CISPR11, class A | Yes |
| Conducted emission according to IEC 61000-6-4 CISPR11, class A | Yes |
| Electrostatic discharge (ESD) according to IEC 61000-4-2, criterion B | Air discharge: 8 kV  
   - Contact discharge: 6 kV |
| Fast transient interference voltages (burst) according to IEC 61000-4-4, criterion B | Power supply (DC): 2 kV  
   - Digital inputs/outputs (24 V DC): 1 kV  
   - Digital inputs/outputs (240 V AC): 2 kV  
   - Analog inputs/outputs: 1 kV  
   - Communication lines shielded: 1 kV |
| High energy transient interference voltages (surge) according to IEC 61000-4-5, criterion B | Power supply (DC):  
   - Line to ground: 1 kV  
   - Line to line: 0,5 kV  
   - Digital inputs/outputs/relay:  
     - (24 V DC):  
       - Line to ground: 1 kV  
       - Line to line: 1 kV  
   - Digital inputs/outputs:  
     - (AC):  
       - Line to ground: 2 kV  
       - Line to line: 1 kV  
   - Analog inputs/outputs:  
     - Line to ground: 1 kV  
   - Communication lines:  
     - Line to ground: 1 kV |
| Influence of radiated disturbances IEC 61000-4-3, criterion A | Test field strength: 10 V/m |
| Influence of line-conducted interferences IEC 61000-4-6, criterion A | Test voltage: 10 V |
| Power frequency magnetic fields IEC 61000-4-8, criterion A | 30 A/m 50 Hz  
   - 30 A/m 60 Hz |
5.1.2.5 Mechanical data

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mounting</td>
<td>Horizontal/Vertical</td>
</tr>
<tr>
<td>Wiring method</td>
<td>Spring/screw terminals</td>
</tr>
<tr>
<td>Degree of protection</td>
<td>PLC system: IP 20</td>
</tr>
<tr>
<td></td>
<td>● with all modules or option boards plugged in</td>
</tr>
<tr>
<td></td>
<td>● with all terminals plugged in</td>
</tr>
<tr>
<td></td>
<td>● with all covers closed</td>
</tr>
<tr>
<td>Housing</td>
<td>Classification V-2 according to UL 94</td>
</tr>
<tr>
<td>Vibration resistance (sinusoidal)</td>
<td>All three axes</td>
</tr>
<tr>
<td>acc. to IEC 60068-2-6</td>
<td>2 Hz ... 8.4 Hz, 3.5 mm peak,</td>
</tr>
<tr>
<td></td>
<td>8.4 Hz ... 150 Hz, 1 g</td>
</tr>
<tr>
<td>Shock test acc. to IEC 60068-2-27</td>
<td>All three axes</td>
</tr>
<tr>
<td></td>
<td>15 g, 11 ms, half-sinusoidal</td>
</tr>
</tbody>
</table>

Mounting of the modules:
- Mounting Rail Top Hat according to IEC 60715 35 mm, depth 7.5 mm or 15 mm
- Mounting with screws M4
- Fastening torque 1.2 Nm

5.1.2.6 Approvals and certifications

The PLC Automation catalog contains an overview of the available approvals and certifications.

5.1.3 System data AC500-XC

5.1.3.1 Environmental conditions

Table 25: Process and supply voltages

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>24 V DC</td>
<td></td>
</tr>
<tr>
<td>Voltage</td>
<td>24 V (-15 %, +20 %)</td>
</tr>
<tr>
<td>Protection against reverse polarity</td>
<td>Yes</td>
</tr>
<tr>
<td>100 V AC...240 V AC wide-range supply</td>
<td></td>
</tr>
<tr>
<td>Voltage</td>
<td>100 V ... 240 V (-15 %, +10 %)</td>
</tr>
<tr>
<td>Frequency</td>
<td>50/60 Hz (-6 %, +4 %)</td>
</tr>
<tr>
<td>Allowed interruptions of power supply, according to EN 61131-2</td>
<td></td>
</tr>
<tr>
<td>DC supply</td>
<td>Interruption &lt; 10 ms, time between 2 interruptions &gt; 1 s, PS2</td>
</tr>
<tr>
<td>AC supply</td>
<td>Interruption &lt; 0.5 periods, time between 2 interruptions &gt; 1 s</td>
</tr>
</tbody>
</table>
**NOTICE!**

Risks of damaging the PLC due to improper voltage levels:
- Never exceed the maximum tolerance values for process and supply voltages.
- Never fall below the minimum tolerance values for process and supply voltages.

Observe the system data Chapter 5.1.2 “System data AC500” on page 166 and the technical data of the module used.

**NOTICE!**

Improper voltage level or frequency range which cause damage of AC inputs:
- AC voltage above 264 V
- Frequency below 47 Hz or above 62.4 Hz

**NOTICE!**

Improper connection leads cause overtemperature on terminals.
PLC modules may be destroyed by using wrong cable type, wire size and cable temperature classification.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>-40 °C ... +70 °C</td>
</tr>
<tr>
<td></td>
<td>-40 °C ... 0 °C: Due to the LCD technology, the display might respond very slowly.</td>
</tr>
<tr>
<td></td>
<td>-40 °C ... +40 °C: Vertical mounting of modules possible, output load limited to 50 % per group</td>
</tr>
<tr>
<td></td>
<td>+60 °C ... +70 °C with the following deratings:</td>
</tr>
<tr>
<td></td>
<td>• System is limited to max. 2 communication modules per terminal base</td>
</tr>
<tr>
<td></td>
<td>• Digital inputs: maximum number of simultaneously switched on input channels limited to 75 % per group (e.g. 8 channels =&gt; 6 channels)</td>
</tr>
<tr>
<td></td>
<td>• Digital outputs: output current maximum value (all channels together) limited to 75 % per group (e.g. 8 A =&gt; 6 A)</td>
</tr>
<tr>
<td></td>
<td>• Analog outputs only if configured as voltage output: maximum total output current per group is limited to 75 % (e.g. 40 mA =&gt; 30 mA)</td>
</tr>
<tr>
<td></td>
<td>• Analog outputs only if configured as current output: maximum number of simultaneously used output channels limited to 75 % per group (e.g. 4 channels =&gt; 3 channels)</td>
</tr>
<tr>
<td>Storage / Transport</td>
<td>-40 °C ... +85 °C</td>
</tr>
<tr>
<td>Humidity</td>
<td>Operating / Storage: 100 % r. H. with condensation</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Air pressure</td>
<td>Operating: Avgs 1000 m .... 5000 m (1080 hPa ... 620 hPa)</td>
</tr>
<tr>
<td></td>
<td>&gt; 2000 m (&lt; 795 hPa):</td>
</tr>
<tr>
<td></td>
<td>• Max. operating temperature must be reduced by 10 K for each 1000 m</td>
</tr>
<tr>
<td></td>
<td>• I/O module relay contacts must be operated with 24 V nominal only</td>
</tr>
<tr>
<td>Immunity to corrosive gases</td>
<td>Yes, according to:</td>
</tr>
<tr>
<td></td>
<td>ISA S71.04.1985 Harsh group A, G3/GX</td>
</tr>
<tr>
<td></td>
<td>IEC60068-2-60</td>
</tr>
<tr>
<td></td>
<td>Method 4 with following concentrations:</td>
</tr>
<tr>
<td></td>
<td>• H2S 100 ± 10ppb</td>
</tr>
<tr>
<td></td>
<td>• NO2 1250 ± 20ppb</td>
</tr>
<tr>
<td></td>
<td>• CL2 100 ± 10ppb</td>
</tr>
<tr>
<td></td>
<td>• SO2 300 ± 20ppb</td>
</tr>
<tr>
<td>Immunity to salt mist</td>
<td>Yes, horizontal mounting only, according to</td>
</tr>
<tr>
<td></td>
<td>IEC 60068-2-52 severity level: 1</td>
</tr>
</tbody>
</table>

**NOTICE!**

**Risk of corrosion!**

Unused connectors and slots may corrode if XC devices are used in salt-mist environments.

Protect unused connectors and slots with TA535 protective caps for XC devices.

☞ Chapter 5.2.8.3.6 “TA535 - Protective caps for XC devices” on page 1332.

**NOTICE!**

**Risk of malfunctions!**

Unused slots for communication modules are not protected against accidental physical contact.

- Unused slots for communication modules must be covered with dummy communication modules to achieve IP20 rating.

☞ Chapter 5.2.8.2.4 “TA524 - Dummy communication module” on page 1323.

- I/O bus connectors must not be touched during operation.

### 5.1.3.2 Creepage distances and clearances

The creepage distances and clearances meet the requirements of the overvoltage category II, pollution degree 2.
5.1.3.3 Power supply units

AC500 and AC500-eCo PLC devices are Class II/Class III devices and do not require a Protective Earth (PE) connection.

For proper EMC performance, all metal parts, DIN rails, mounting screws, and cable shield connection terminals are connected to a common ground and provide Functional Earth (FE). This is typically connected to a common reference potential, such as equipotential bonding rails.

Signal Grounds (SGND or GND) are used for signal reference and must not be connected to cable shields, FE or other signals unless otherwise specified in the specific device description.

---

5.1.3.4 Electromagnetic compatibility

Table 26: Electromagnetic compatibility

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device suitable only as Control Equipment for Industrial Applications, including marine applications. IEC 61131-2, zone B</td>
<td>Yes</td>
</tr>
<tr>
<td>Radiated emission according to IEC 61000-6-4 CISPR11, class A</td>
<td>Yes</td>
</tr>
<tr>
<td>Conducted emission according to IEC 61000-6-4 CISPR11, class A</td>
<td>Yes</td>
</tr>
<tr>
<td>Electrostatic discharge (ESD) according to IEC 61000-4-2, criterion B</td>
<td>Air discharge: 8 kV, Contact discharge: 6 kV</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Fast transient interference voltages (burst) according to</td>
<td>Power supply (DC): 4 kV</td>
</tr>
<tr>
<td>IEC 61000-4-4, criterion B</td>
<td>Digital inputs/outputs (24 V DC): 2 kV</td>
</tr>
<tr>
<td></td>
<td>Digital inputs/outputs (240 V AC): 4 kV</td>
</tr>
<tr>
<td></td>
<td>Analog inputs/outputs: 2 kV</td>
</tr>
<tr>
<td></td>
<td>Communication lines shielded: 2 kV</td>
</tr>
<tr>
<td>High energy transient interference voltages (surge) according to</td>
<td>Power supply (DC):</td>
</tr>
<tr>
<td>IEC 61000-4-5, criterion B</td>
<td>- Line to ground: 1 kV</td>
</tr>
<tr>
<td></td>
<td>- Line to line: 0,5 kV</td>
</tr>
<tr>
<td></td>
<td>Digital inputs/outputs/relay:</td>
</tr>
<tr>
<td></td>
<td>(24 V DC):</td>
</tr>
<tr>
<td></td>
<td>- Line to ground: 1 kV</td>
</tr>
<tr>
<td></td>
<td>(AC):</td>
</tr>
<tr>
<td></td>
<td>- Line to ground: 2 kV</td>
</tr>
<tr>
<td></td>
<td>- Line to line: 1 kV</td>
</tr>
<tr>
<td></td>
<td>Analog inputs/outputs:</td>
</tr>
<tr>
<td></td>
<td>- Line to ground: 1 kV</td>
</tr>
<tr>
<td></td>
<td>Communication lines:</td>
</tr>
<tr>
<td></td>
<td>- Line to ground: 1 kV</td>
</tr>
<tr>
<td>Influence of radiated disturbances</td>
<td>Test field strength: 10 V/m</td>
</tr>
<tr>
<td>IEC 61000-4-3, criterion A</td>
<td>Test voltage: 10 V</td>
</tr>
<tr>
<td>Influence of line-conducted interferences</td>
<td></td>
</tr>
<tr>
<td>IEC 61000-4-6, criterion A</td>
<td></td>
</tr>
<tr>
<td>Power frequency magnetic fields</td>
<td>30 A/m 50 Hz</td>
</tr>
<tr>
<td>IEC 61000-4-8, criterion A</td>
<td>30 A/m 60 Hz</td>
</tr>
</tbody>
</table>

5.1.3.5 Mechanical data

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mounting</td>
<td>Horizontal/vertical (no application in salt mist environment)</td>
</tr>
<tr>
<td>Wiring method</td>
<td>Spring terminals</td>
</tr>
<tr>
<td>Degree of protection</td>
<td>PLC system: IP 20</td>
</tr>
<tr>
<td></td>
<td>• with all modules or option boards plugged in</td>
</tr>
<tr>
<td></td>
<td>• with all terminals plugged in</td>
</tr>
<tr>
<td></td>
<td>• with all covers closed</td>
</tr>
<tr>
<td>Housing</td>
<td>Classification V-2 according to UL 94</td>
</tr>
<tr>
<td>Vibration resistance (sinusoidal)</td>
<td>2 Hz ... 8.4 Hz, 3.5 mm peak, 8.4 Hz ... 500 Hz, 2 g</td>
</tr>
<tr>
<td>acc. to IEC 60068-2-6</td>
<td></td>
</tr>
<tr>
<td>Vibration resistance (broadband</td>
<td>5 Hz ... 500 Hz, 1,9 g rms (operational)</td>
</tr>
<tr>
<td>random) acc. to IEC 60068-2-6</td>
<td>5 Hz ... 500 Hz, 4 g rms (non operational)</td>
</tr>
</tbody>
</table>
### Parameter | Value
---|---
Shock resistance | All three axes  
15 g, 11 ms, half-sinusoidal
Mounting of the modules:
Mounting Rail Top Hat according to IEC 60715 | 35 mm, depth 7.5 mm or 15 mm
Mounting with screws | M4
Fastening torque | 1.2 Nm

#### 5.1.3.6 Approvals and certifications
The PLC Automation catalog contains an overview of the available approvals and certifications.

#### 5.1.4 AC500-S
**Functional safety**
The AC500-S safety user manual must be read and understood before using the safety configuration and programming tools of Automation Builder/PS501 Control Builder Plus. Only qualified personnel are permitted to work with AC500-S safety PLCs.

The AC500-S safety PLC includes the following safety-relevant hardware components.
- SM560-S/SM560-S-FD-1/SM560-S-FD-4
- DI581-S
- DX581-S
- AI581-S
- TU582-S

#### 5.1.5 CP600
The technical data of the CP600 control panels are included in the CP600 data sheets.
5.2 Device specifications
5.2.1 Processor modules
5.2.1.1 AC500-eCo
5.2.1.1.1 PM50x2

Features

Fig. 28: Example: PM5072-T-2ETH

1. Micro memory card slot
2. 5 LEDs to display the states of the processor module (Power, Error, Run, MC, MOD1)
3. RUN button
4. RJ45 female connector for Ethernet1 connection
5. RJ45 female connector for Ethernet2 connection (available for PM50x2-T-2ETH)
6. 3-pin terminal block for power supply 24 V DC
7. 2 holes for screw mounting
8. Option board slot cover for option board slot (the number of available slots varies according to the CPU type)
9. Cable fixing
10. 13-pin terminal block for onboard I/Os
11. 12-pin terminal block for onboard I/Os (not available on PM5012-x-ETH)
12. 12 LEDs to display the states of the signals
13. 10 LEDs to display the states of the signals
14. Cable fixing accessory TA5301-CFA on the top of the housing (optional)

The processor module is shown with pluggable terminal blocks. These terminal blocks must be ordered separately.
The cable fixing accessory on the top of the housing is optional.

Please use TA5301-CFA cable fixing accessory to provide strain relief.

It can also be used for AC500-eCo I/O modules.

The PM50x2 processor modules are supplied with option board slot covers as standard.

There are various TA51xx option boards for the processor modules that can be ordered separately.

Which and how many option boards can be plugged, depends on the respective processor module.

### Table 27: AC500-eCo V3 CPUs with their most important properties

<table>
<thead>
<tr>
<th>Processor modules</th>
<th>Total maximum downloadable application size</th>
<th>Configurable input/output</th>
<th>Digital inputs</th>
<th>Digital outputs</th>
<th>Power supply</th>
<th>Ethernet interfaces</th>
<th>Option board slots</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Basic CPUs</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PM5012-T-ETH</td>
<td>1 MB thereof 256 kB for user program code and data dynamically allocated</td>
<td>-</td>
<td>6</td>
<td>4 (Transistor)</td>
<td>24 V DC</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>PM5012-R-ETH</td>
<td>1 MB thereof 256 kB for user program code and data dynamically allocated</td>
<td>-</td>
<td>6</td>
<td>4 (Relay)</td>
<td>24 V DC</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td><strong>Standard CPUs</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PM5032-T-ETH</td>
<td>5 MB thereof 512 kB for user program code and data dynamically allocated</td>
<td>2 (Transistor)</td>
<td>12</td>
<td>8 (Transistor)</td>
<td>24 V DC</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>PM5032-R-ETH</td>
<td>5 MB thereof 512 kB for user program code and data dynamically allocated</td>
<td>2 (Transistor)</td>
<td>12</td>
<td>6 (Relay)</td>
<td>24 V DC</td>
<td>1</td>
<td>2</td>
</tr>
</tbody>
</table>
### Processor modules

<table>
<thead>
<tr>
<th>Processor modules</th>
<th>Total maximum downloadable application size</th>
<th>Configurable input/output</th>
<th>Digital inputs</th>
<th>Digital outputs</th>
<th>Power supply</th>
<th>Ethernet interfaces</th>
<th>Option board slots</th>
</tr>
</thead>
<tbody>
<tr>
<td>PM5052-T-ETH</td>
<td>7 MB thereof 768 kB for user program code and data dynamically allocated</td>
<td>2 (Transistor)</td>
<td>12</td>
<td>8 (Transistor)</td>
<td>24 V DC</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td>PM5052-R-ETH</td>
<td>7 MB thereof 768 kB for user program code and data dynamically allocated</td>
<td>2 (Transistor)</td>
<td>12</td>
<td>6 (Relay)</td>
<td>24 V DC</td>
<td>1</td>
<td>3</td>
</tr>
</tbody>
</table>

### Pro CPUs

<table>
<thead>
<tr>
<th>Processor modules</th>
<th>Total maximum downloadable application size</th>
<th>Configurable input/output</th>
<th>Digital inputs</th>
<th>Digital outputs</th>
<th>Power supply</th>
<th>Ethernet interfaces</th>
<th>Option board slots</th>
</tr>
</thead>
<tbody>
<tr>
<td>PM5072-T-ETH</td>
<td>9 MB thereof 1 MB for user program code and data dynamically allocated</td>
<td>2 (Transistor)</td>
<td>12</td>
<td>8 (Transistor)</td>
<td>24 V DC</td>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>PM5072-T-2ETHW *)</td>
<td>9 MB thereof 1 MB for user program code and data dynamically allocated</td>
<td>2 (Transistor)</td>
<td>12</td>
<td>8 (Transistor)</td>
<td>24 V DC</td>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>PM5082-T-2ETH</td>
<td>9 MB thereof 1 MB for user program code and data dynamically allocated</td>
<td>2 (Transistor)</td>
<td>12</td>
<td>8 (Transistor)</td>
<td>24 V DC</td>
<td>2</td>
<td>3</td>
</tr>
</tbody>
</table>

*) W = wide temperature range

### Short description

The processor modules PM50x2 series are the central units of AC500-eCo V3 PLC. Their main characteristics are:

- Power supply 24 V DC
- I/O bus (not for PM5012-x-ETH)
- Real-time clock (PM5012-x-ETH needs additional RTC option board)
- Option board slots for extension on the CPU (1 for PM5012-x-ETH, 2 for PM5032-x-ETH, 3 for PM5052-x-ETH and PM50x2-T-2ETH)
- 6 digital inputs (PM5012-x-ETH), 12 digital inputs (PM5032-x-ETH, PM5052-x-ETH, PM50x2-T-2ETH)
- 4 transistor outputs (PM5012-T-ETH), 8 transistor outputs (PM5032-T-ETH, PM5052-T-ETH, PM50x2-T-2ETH)
- 4 relay outputs (PM5012-R-ETH), 6 relay outputs (PM5032-R-ETH, PM5052-R-ETH)
- 2 configurable digital inputs/outputs (not for PM5012-x-ETH)

The various processor module variants differ in the following characteristics:
- Type of the digital outputs (transistor or relays)
- Ethernet interface one or two independent interfaces

All processor module variants include a micro memory card slot.

Details and technical data are provided in the technical data section "Technical data" on page 188.

Assortment

Detailed data

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PM5012</td>
</tr>
<tr>
<td>Total maximum downloadable application size 1)</td>
<td>1 MB</td>
</tr>
<tr>
<td>Thereof user program code / data memory dynamically allocated</td>
<td>256 KB</td>
</tr>
<tr>
<td>Thereof user web server memory for web visualization max.</td>
<td>no web</td>
</tr>
<tr>
<td>Flash memory for user data</td>
<td></td>
</tr>
<tr>
<td>Remaining for all other usage (project save, infra-structure...)</td>
<td>30 MB</td>
</tr>
<tr>
<td>Buffered (FRAM)</td>
<td>8 KB</td>
</tr>
<tr>
<td>VAR_RETAIN persistent</td>
<td>4 KB</td>
</tr>
<tr>
<td>%MB data</td>
<td>4 KB</td>
</tr>
<tr>
<td>Expandable memory</td>
<td>None</td>
</tr>
<tr>
<td>Integrated mass storage memory (FLASH)</td>
<td>None</td>
</tr>
<tr>
<td>Slot for pluggable memory card</td>
<td>x</td>
</tr>
<tr>
<td>Real-time clock (RTC)</td>
<td>Optional with TA5131-RTC</td>
</tr>
<tr>
<td>Min. retention time for RTC at room temperature (if at least powered for 8 hours)</td>
<td>7 days</td>
</tr>
<tr>
<td>Accuracy</td>
<td>±2 s/day</td>
</tr>
<tr>
<td>Programming languages</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Instruction List (IL)</td>
</tr>
<tr>
<td></td>
<td>Function Block Diagram (FBD)</td>
</tr>
<tr>
<td></td>
<td>Ladder Diagram (LD)</td>
</tr>
<tr>
<td></td>
<td>Sequential Function Chart (SFC)</td>
</tr>
<tr>
<td></td>
<td>Structured Text (ST)</td>
</tr>
<tr>
<td></td>
<td>Continuous Function Chart (CFC)</td>
</tr>
<tr>
<td>Processor type</td>
<td>TI ARM Cortex-A9 32-bit-RISC</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>-------</td>
</tr>
<tr>
<td>Processor clock speed</td>
<td>PM5012</td>
</tr>
<tr>
<td></td>
<td>300 MHz</td>
</tr>
<tr>
<td>Calculation time per instructions (minimum)</td>
<td>PM5012</td>
</tr>
<tr>
<td>Binary</td>
<td>20 ns</td>
</tr>
<tr>
<td>Word</td>
<td>50 ns</td>
</tr>
<tr>
<td>Floating point</td>
<td>600 ns</td>
</tr>
<tr>
<td>Lowest cycle time usable (also f. PTO)</td>
<td>-</td>
</tr>
<tr>
<td>Using onboard EtherCAT protocol (licensed) in preparation</td>
<td></td>
</tr>
<tr>
<td>EtherCAT onboard</td>
<td>PM5012</td>
</tr>
<tr>
<td>No. of synchronized axis</td>
<td></td>
</tr>
<tr>
<td>axis per 1 ms CM typically</td>
<td>-</td>
</tr>
<tr>
<td>axis per 2 ms CM typically</td>
<td>-</td>
</tr>
<tr>
<td>axis per 4 ms CM typically</td>
<td>-</td>
</tr>
<tr>
<td>Cyclic min. configurable</td>
<td>10 ms</td>
</tr>
<tr>
<td>Time-controlled</td>
<td>Yes</td>
</tr>
<tr>
<td>Multitasking</td>
<td>Yes</td>
</tr>
<tr>
<td>Interruption</td>
<td>Yes</td>
</tr>
<tr>
<td>LEDs</td>
<td>Power, Error, Run, MC, MOD1, States of I/Os</td>
</tr>
<tr>
<td>RUN/STOP button</td>
<td>Yes</td>
</tr>
<tr>
<td>Protection of the user program by password</td>
<td>On request</td>
</tr>
<tr>
<td>Usable accessories</td>
<td>On request</td>
</tr>
<tr>
<td>Remarks:</td>
<td></td>
</tr>
<tr>
<td>* Depending on application complexity</td>
<td></td>
</tr>
<tr>
<td>1) The values are for information only and cannot be fulfilled altogether. The available resources are limited at the end by the maximal downloadable application size for each CPU.</td>
<td></td>
</tr>
</tbody>
</table>

### Data of I/Os

<table>
<thead>
<tr>
<th>Data of I/Os</th>
<th>PM5012-x-ETH</th>
<th>PM5032-x-ETH</th>
<th>PM5052-x-ETH</th>
<th>PM5072-T-2ETH(W)</th>
<th>PM5082-T-2ETH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Onboard digital inputs</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Channels</td>
<td>6</td>
<td>12</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(incl. 2 counter inputs 5 kHz and 4 interrupts)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Signal voltage</td>
<td>24 V DC type 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Onboard digital outputs</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type of digital outputs</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PM5012-T-ETH: Transistor</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PM5032-T-ETH: Transistor</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PM5052-T-ETH: Transistor</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PM5072-T-2ETH(W): Transistor</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PM5082-T-2ETH: Transistor</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2024/01/05 3ADR010583, 1, en_US 179
<table>
<thead>
<tr>
<th>Data of I/Os</th>
<th>PM5012-x-ETH</th>
<th>PM5032-x-ETH</th>
<th>PM5052-x-ETH</th>
<th>PM5072-T-2ETH(W)</th>
<th>PM5082-T-2ETH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channels for transistor version</td>
<td>4</td>
<td>8</td>
<td>(5 kHz standard and PWM)</td>
<td>(incl. 4 fast outputs for standard or 4 PWM/4 PTO (100 kHz/200 kHz), 4 standard outputs (5 kHz))</td>
<td></td>
</tr>
<tr>
<td>Channels digital input/ output configurable (valid for both PLC version relais or transistor)</td>
<td>-</td>
<td>2</td>
<td></td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>Relay version:</td>
<td></td>
<td></td>
<td></td>
<td>Transistor version:</td>
<td></td>
</tr>
<tr>
<td>The DC channels can be used as 1 PTO/2 PWM (100 kHz) or standard digital inputs/outputs</td>
<td></td>
<td></td>
<td></td>
<td>The DC channels can only be used as standard digital inputs/outputs</td>
<td></td>
</tr>
<tr>
<td>Transistor version:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The DC channels can only be used as standard digital inputs/outputs</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rated voltage transistor</td>
<td>24 V DC</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nominal current per transistor channel</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.5 A resistive</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Channels for relay version</td>
<td>4</td>
<td>6</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Rated voltage relay</td>
<td>100 V AC ... 240 V AC or 24 V DC</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Nominal current per relay channel</td>
<td>2 A resistive</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Analog inputs</td>
<td>Optional</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Analog outputs</td>
<td>Optional</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of option board slots</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Usage of option board</td>
<td>Each slot can be used for all type of existing option boards, same option board for serial interface or digital/analog I/O extension can be used on several slot per CPU. Note: RTC option board is only for PM5012 possible.</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>KNX address switch</td>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Real-time clock (RTC)</td>
<td>TA5131-RTC</td>
<td>No</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Serial interface</td>
<td>TA5141-RS232I, TA5142-RS485/TA5142-RS485I</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Digital in/out channels</td>
<td>TA5101-4DI, TA5105-4DOT, TA5110-2DI2DOT</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Analog in/out channels</td>
<td>TA5120-2AI-UI, TA5123-2AI-RTD, TA5126-2AO-UI</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Data of I/Os</td>
<td>PM5012-x-ETH</td>
<td>PM5032-x-ETH</td>
<td>PM5052-x-ETH</td>
<td>PM5072-T-2ETH(W)</td>
<td>PM5082-T-2ETH</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>--------------</td>
<td>--------------</td>
<td>--------------</td>
<td>------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Max. number of I/O modules on I/O bus</td>
<td>0</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Digital inputs</td>
<td>Onboard I/O only</td>
<td>128 byte</td>
<td>1 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Digital outputs</td>
<td>128 byte</td>
<td>1 KB</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of decentralized inputs and outputs</td>
<td>Depending on the fieldbus used</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Internal interfaces</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Serial COMx</td>
<td>Optional, use a dedicated serial interface option board (up to 1)</td>
<td>Optional, use a dedicated serial interface option board (up to 2)</td>
<td>Optional, use a dedicated serial interface option board (up to 3)</td>
<td>Modbus RTU Master/Slave, ASCII</td>
<td></td>
</tr>
<tr>
<td>Ethernet interface RJ45</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>Ethernet functions</td>
<td>Programming, TCP/IP, UDP/IP, DHCP, PING, network variables, and other listed below</td>
<td></td>
<td></td>
<td></td>
<td>Independent with switch functionality</td>
</tr>
<tr>
<td>Modbus TCP/IP client/server</td>
<td>Yes 8 / 3</td>
<td>Yes 13 / 8</td>
<td>Yes 20 / 10</td>
<td>Yes 30 / 15</td>
<td>Yes 30 / 15</td>
</tr>
<tr>
<td>SNTP client/server</td>
<td>No</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HTTPs and WebVisu number of connections</td>
<td>No</td>
<td>Yes 1</td>
<td>Yes 2</td>
<td>Yes 4</td>
<td>Yes 4</td>
</tr>
<tr>
<td>FTPs number of connections</td>
<td>No</td>
<td>Yes 1</td>
<td>Yes 2</td>
<td>Yes 2</td>
<td>Yes 2</td>
</tr>
<tr>
<td>OPC UA server number of free tags</td>
<td>No</td>
<td>Yes 125</td>
<td>Yes 250</td>
<td>Yes 1000</td>
<td>Yes 3000</td>
</tr>
<tr>
<td>MQTT and JSON library</td>
<td>No</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OPC DA server</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IEC 60870-5-104 telecontrol protocol</td>
<td>No</td>
<td>Yes</td>
<td></td>
<td></td>
<td>Substation only, 5 connections max., only 1 Ethernet supported</td>
</tr>
<tr>
<td>Licensed protocols (runtime protocol per CPU)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Connections and interfaces

#### General

The I/O bus is the I/O data bus for the I/O modules. Through this bus, I/O and diagnosis data are transferred between the processor module and the I/O modules. Up to 10 I/O modules for PM5032-x-ETH (but with a limit of 128 Bytes input/ 128 Bytes output variables) and 10 I/O modules for PM5052-x-ETH and PM50x2-T-2ETH can be added.

#### I/O bus

The I/O bus is not available for PM5012-T-ETH and PM5012-R-ETH. I/O channel extension using option board slot only.

#### Option board slot interface

Depending on the processor module variants, an additional option board can be connected to the option board slot to extend the feature of the processor module.

* Chapter 5.2.1.1.3 “Option boards” on page 218

#### Serial interface

- RS-232 communication interface is available by using option board:
  - TA5141-RS232 (isolated)
    - *Chapter 5.2.1.1.3.9 “TA5141-RS232 - Option board for COMx serial communication” on page 285*

- RS-485 communication interface is available by using option boards:
  - TA5142-RS485 (isolated)
    - *Chapter 5.2.1.1.3.10 “TA5142-RS485 - Option board for COMx serial communication” on page 289*
  - TA5142-RS485 (non isolated)
    - *Chapter 5.2.1.1.3.11 “TA5142-RS485 - Option board for COMx serial communication” on page 296*
The Ethernet interface is carried out via a RJ45 jack.

**Table 28: Pin assignment of the Ethernet interface**

<table>
<thead>
<tr>
<th>Interface</th>
<th>Pin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>8</td>
<td>Tx+ Transmit data +</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>Tx- Transmit data -</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>Rx+ Receive data +</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>NC Not connected</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>NC Not connected</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>Rx- Receive data -</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>NC Not connected</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>NC Not connected</td>
</tr>
<tr>
<td>Shield</td>
<td></td>
<td>Cable shield Functional earth</td>
</tr>
</tbody>
</table>

The processor modules PM50x2 have onboard I/Os which provide several functionalities. According to the CPU type, the number or the functionality of the onboard I/Os can be different. See Chapter 5.2.1.2 “Onboard I/Os in processor module PM50x2” on page 196.

**Modbus RTU connection details**

The Modbus RTU protocol is implemented in the AC500 processor modules. Modbus is a master-slave (client-server) protocol. The client sends a request to the server(s) and receives the response(s).

Available serial interfaces can work as Modbus interfaces simultaneously.

The Modbus client operating mode of an interface is set with the function block COM_MOD_MAST.

**Technical data**

**Table 29: Description of the Modbus protocol**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported standard</td>
<td>Modbus RTU Server, Modbus RTU Client</td>
</tr>
<tr>
<td></td>
<td><a href="#">Chapter 6.3.2.14.2 “Configuring Modbus RTU on serial interface” on page 1588</a></td>
</tr>
<tr>
<td>Number of connection points</td>
<td>1 client</td>
</tr>
<tr>
<td></td>
<td>Max. 1 server with RS-232 interface</td>
</tr>
<tr>
<td></td>
<td>Max. 31 servers with RS-485</td>
</tr>
<tr>
<td>Protocol</td>
<td>Modbus</td>
</tr>
<tr>
<td>Operating mode</td>
<td>Client/server</td>
</tr>
<tr>
<td>Address</td>
<td>Server only</td>
</tr>
<tr>
<td>Data transmission control</td>
<td>CRC16</td>
</tr>
<tr>
<td>Data transmission speed</td>
<td>From 9,600 bits/s to 115,200 bits/s</td>
</tr>
</tbody>
</table>

[Chapter 6.3.2.14.2 “Configuring Modbus RTU on serial interface” on page 1588](#)
### Parameter Value

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encoding</td>
<td>1 start bit 8 data bits 1 or 2 stop bits 1 parity bit</td>
</tr>
<tr>
<td>Max. cable length for RS-485 on serial interface option board used on the CPU</td>
<td>1.200 m at 19.200 baud</td>
</tr>
</tbody>
</table>

### Bus topology

Point-to-point with RS-232 or bus topology with RS-485. Modbus is a master-slave protocol.  
`Chapter 6.8.2.9 “Communication with Modbus RTU” on page 4506`

### Power supply

The processor modules PM50x2 can be connected to the 24 V DC supply voltage via a removable 3-pin spring terminal block or a 3-pin screw terminal block.

**Table 30: Removable terminal block for the supply voltage 24 V DC**

<table>
<thead>
<tr>
<th>3-pin spring terminal block</th>
<th>3-pin screw terminal block</th>
</tr>
</thead>
</table>

The terminal block is available as a set for AC500-eCo V3 processor modules.

**Basic CPU (PM5012)**  
**Standard CPUs (PM5032, PM5052) and Pro CPUs (PM5072, PM5082)**

<table>
<thead>
<tr>
<th>Spring type</th>
<th>Screw type</th>
<th>Spring type</th>
<th>Screw type</th>
</tr>
</thead>
<tbody>
<tr>
<td>TA5211-TSPF-B</td>
<td>TA5211-TSCL-B</td>
<td>TA5212-TSPF</td>
<td>TA5212-TSCL</td>
</tr>
</tbody>
</table>

`Further information on power supply and onboard inputs/outputs of the terminal blocks`
**NOTICE!**
Risk of damaging the PLC due to improper voltage levels!

- Never exceed the maximum tolerance values for process and supply voltages.
- Never fall below the minimum tolerance values for process and supply voltages.

Observe the system data and the technical data of the used module.

☞ Chapter 5.1.1 “System data AC500-eCo” on page 159

---

State LEDs and operating elements

**RUN/STOP button**
The processor modules, PM50xx series, have a RUN/STOP button. By pressing the RUN/STOP button, the processor modules switch between RUN mode and STOP mode. By long-pressing RUN/STOP button during the processor module power on phase, the processor module will be in MOD1.

**State LEDs**
The processor modules PM50xx indicate their states of operation via 5 LEDs located on the upper left side of the processor module.

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = ON</th>
<th>LED = OFF</th>
<th>LED flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR</td>
<td>Power supply</td>
<td>Green</td>
<td>Power supply present</td>
<td>Power supply missing</td>
<td>-</td>
</tr>
<tr>
<td>MC</td>
<td>Micro memory card indication</td>
<td>Yellow</td>
<td>Micro memory card is in the socket</td>
<td>Micro memory card is not in the socket</td>
<td>Micro memory card is in read/write state: any file on card is opened, means activity on card</td>
</tr>
<tr>
<td>ERR</td>
<td>Error indication</td>
<td>Red</td>
<td>An error occurred</td>
<td>No errors or only warnings encountered (E4 errors). The LED behavior for the error classes 2 to 4 is configurable.</td>
<td>Fast flashing (4 Hz) displays together with the RUN LED a currently running firmware-upgrade or writing data to the Flash-EPROM. Slow flashing (1 Hz) alone displays shutdown of Request To Send. Medium flashing (2 Hz) alone displays at start of PLC if reboot after watchdog.</td>
</tr>
<tr>
<td>MOD1</td>
<td>Mode 1 indication</td>
<td>Yellow</td>
<td>Processor module is in mode 1 state</td>
<td>Processor module is not in mode 1 state</td>
<td>-</td>
</tr>
</tbody>
</table>
### User configurable LEDs

The AC500-eCo V3 processor module also provides 2 LEDs below the state LEDs which can be used by user and driven by an application.

The LEDs can be used into a project and controlled using special function blocks which are contained in the PM AC500 library. The POU is PmLedSet located in folder LED control.

### I/O LEDs

The processor module provides up to 10 LEDs (PM5012-x-ETH), 20 LEDs (PM5032-R-ETH, PM5052-R-ETH), or 22 LEDs (PM5032-T-ETH, PM5052-T-ETH, PM5072-T-2ETH(W), PM5082-T-2ETH) to display the states of the inputs and outputs.

<table>
<thead>
<tr>
<th>Processor module</th>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = ON</th>
<th>LED = OFF</th>
</tr>
</thead>
<tbody>
<tr>
<td>PM5012-x-ETH</td>
<td>I0 ... I5</td>
<td>Digital input</td>
<td>Yellow</td>
<td>Input is ON</td>
<td>Input is OFF</td>
</tr>
<tr>
<td></td>
<td>O0 ... O3</td>
<td>Transistor output</td>
<td>Yellow</td>
<td>Output is ON</td>
<td>Output is OFF</td>
</tr>
<tr>
<td>Processor module</td>
<td>LED</td>
<td>State</td>
<td>Color</td>
<td>LED = ON</td>
<td>LED = OFF</td>
</tr>
<tr>
<td>------------------</td>
<td>------</td>
<td>--------------</td>
<td>--------</td>
<td>--------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td></td>
<td>NO0</td>
<td>Relay output</td>
<td>Yellow</td>
<td>Output is ON</td>
<td>Output is OFF</td>
</tr>
<tr>
<td>PM5032-x-ETH</td>
<td>...</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PM5032-x-ETH</td>
<td>NO3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PM5052-x-ETH</td>
<td>I0</td>
<td>Digital input</td>
<td>Yellow</td>
<td>Input is ON</td>
<td>Input is OFF</td>
</tr>
<tr>
<td>PM5052-x-ETH</td>
<td>I11</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>O0</td>
<td>Transistor output</td>
<td>Yellow</td>
<td>Output is ON</td>
<td>Output is OFF</td>
</tr>
<tr>
<td>PM5052-x-ETH</td>
<td>...</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PM5052-x-ETH</td>
<td>O7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>NO0</td>
<td>Relay output</td>
<td>Yellow</td>
<td>Output is ON</td>
<td>Output is OFF</td>
</tr>
<tr>
<td>PM5072-T-2ETH(W)</td>
<td>...</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PM5072-T-2ETH(W)</td>
<td>NO5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PM5082-T-2ETH</td>
<td>I0</td>
<td>Digital input</td>
<td>Yellow</td>
<td>Input is ON</td>
<td>Input is OFF</td>
</tr>
<tr>
<td>PM5082-T-2ETH</td>
<td>I11</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>O0</td>
<td>Transistor output</td>
<td>Yellow</td>
<td>Output is ON</td>
<td>Output is OFF</td>
</tr>
<tr>
<td>PM5082-T-2ETH</td>
<td>...</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PM5082-T-2ETH</td>
<td>O7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>C12,</td>
<td>Digital configurable input/output</td>
<td>Yellow</td>
<td>Input/Output is ON</td>
<td>Input/Output is OFF</td>
</tr>
<tr>
<td></td>
<td>C13</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Ethernet state LEDs

**Table 31: State LEDs at Ethernet connector**

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>OFF</th>
<th>ON</th>
<th>Flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity</td>
<td>Yellow</td>
<td>No activity</td>
<td>---</td>
<td>Activity</td>
</tr>
<tr>
<td>Link</td>
<td>Green</td>
<td>No link</td>
<td>Link</td>
<td>---</td>
</tr>
</tbody>
</table>

### Diagnosis

The AC500 processor module can display various errors according to the error classes. The following error classes are possible. The reaction of the processor module is different for each type of error.

<table>
<thead>
<tr>
<th>Error class</th>
<th>Type</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>E1</td>
<td>Fatal error</td>
<td>A safe function of the operating system is no longer guaranteed.</td>
<td>Checksum error in the system Flash or RAM error</td>
</tr>
<tr>
<td>E2</td>
<td>Severe error</td>
<td>The operating system is functioning without problems, but the error-free processing of the user program is no longer guaranteed.</td>
<td>Checksum error in the user Flash, independent of the task duration</td>
</tr>
<tr>
<td>E3</td>
<td>Light error</td>
<td>It depends on the application if the user program should be stopped by the operating system or not. The user should determine which reaction is necessary.</td>
<td>Flash could not be programmed, I/O module has failed</td>
</tr>
<tr>
<td>E4</td>
<td>Warning</td>
<td>Error in the periphery (e.g. I/O) which may show an impact in the future. The user should determine which reaction is necessary.</td>
<td>Short-circuit at an I/O module, the battery is run down or not inserted</td>
</tr>
</tbody>
</table>

*) The behaviour if the ERR-LED lights up at error classes E3 or E4 is configurable.

Occurred errors can be displayed with the commands diagshow all in the PLC-Browser of Automation Builder software.
The system data of AC500-eCo V3 apply Chapter 5.1.1 “System data AC500-eCo” on page 159

Only additional details are therefore documented below.

## General data

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power supply</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Connection of power supply</td>
<td>Via removable 3-pin terminal</td>
</tr>
<tr>
<td>Current consumption from power supply (max.)</td>
<td></td>
</tr>
<tr>
<td>Transistor version</td>
<td>200 mA 340 mA 400 mA 420 mA 420 mA</td>
</tr>
<tr>
<td>Relay version</td>
<td>200 mA 340 mA 400 mA - -</td>
</tr>
<tr>
<td>Melting integral of a fuse at 24 V DC</td>
<td>0.9 A²s</td>
</tr>
<tr>
<td>Peak inrush current from 24 V DC</td>
<td>65 A</td>
</tr>
<tr>
<td>Max. power dissipation within the processor module</td>
<td></td>
</tr>
<tr>
<td>Transistor version</td>
<td>5.7 W 8.1 W 9.0 W 9.2 W 9.2 W</td>
</tr>
<tr>
<td>Relay version</td>
<td>5.9 W 8.3 W 9.2 W - -</td>
</tr>
<tr>
<td>Processor module interfaces</td>
<td>RS485/RS232 (optional), Ethernet</td>
</tr>
<tr>
<td>Weight</td>
<td>- 1/O bus</td>
</tr>
<tr>
<td>Transistor version</td>
<td>225 g 253 g 257 g 265 g 265 g</td>
</tr>
<tr>
<td>Relay version</td>
<td>235 g 268 g 273 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical</td>
</tr>
</tbody>
</table>

## Detailed data

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total maximum downloadable application size 1)</td>
<td>1 MB 5 MB 7 MB 9 MB 9 MB</td>
</tr>
<tr>
<td>Thereof user program code / data memory dynamically allocated</td>
<td>256 KB 512 KB 768 KB 1 MB 1 MB</td>
</tr>
<tr>
<td>Thereof user web server memory for web visualization max.</td>
<td>no web 1.5 MB 3.2 MB 7 MB 7 MB</td>
</tr>
<tr>
<td>Flash memory for user data</td>
<td></td>
</tr>
<tr>
<td>Remaining for all other usage (project save, infra-structure...)</td>
<td>30 MB 30 MB 30 MB 30 MB 30 MB</td>
</tr>
<tr>
<td>Buffered (FRAM)</td>
<td>8 KB 32 KB 32 KB 100 KB 100 KB</td>
</tr>
<tr>
<td>VAR_RETAIN persistent</td>
<td>4 KB 16 KB 16 KB 36 KB 36 KB</td>
</tr>
<tr>
<td>%MB data</td>
<td>4 KB 16 KB 16 KB 64 KB 64 KB</td>
</tr>
<tr>
<td>Expandable memory</td>
<td>None None None None None</td>
</tr>
<tr>
<td>Integrated mass storage memory (FLASH)</td>
<td>None None None None None</td>
</tr>
<tr>
<td>Slot for pluggable memory card</td>
<td>x x x x x</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>-----------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Parameter</strong></td>
<td><strong>Value</strong></td>
</tr>
<tr>
<td>PM5012</td>
<td>PM5032</td>
</tr>
<tr>
<td>Real-time clock (RTC)</td>
<td>Optional with TA5131-RTC</td>
</tr>
<tr>
<td>Min. retention time for RTC at room temperature</td>
<td>7 days</td>
</tr>
<tr>
<td>(if at least powered for 8 hours)</td>
<td></td>
</tr>
<tr>
<td>Accuracy</td>
<td>±2 s/day</td>
</tr>
<tr>
<td>Programming languages</td>
<td>Instruction List (IL)</td>
</tr>
<tr>
<td></td>
<td>Function Block Diagram (FBD)</td>
</tr>
<tr>
<td></td>
<td>Ladder Diagram (LD)</td>
</tr>
<tr>
<td></td>
<td>Sequential Function Chart (SFC)</td>
</tr>
<tr>
<td></td>
<td>Structured Text (ST)</td>
</tr>
<tr>
<td></td>
<td>Continuous Function Chart (CFC)</td>
</tr>
<tr>
<td>Processor type</td>
<td>TI ARM Cortex-A9 32-bit-RISC</td>
</tr>
<tr>
<td>Processor clock speed</td>
<td>300 MHz</td>
</tr>
<tr>
<td>Calculation time per instructions (minimum)</td>
<td>600 MHz</td>
</tr>
<tr>
<td>Binary</td>
<td>20 ns</td>
</tr>
<tr>
<td>Word</td>
<td>50 ns</td>
</tr>
<tr>
<td>Floating point</td>
<td>600 ns</td>
</tr>
<tr>
<td>Lowest cycle time usable (also f. PTO)</td>
<td>-</td>
</tr>
<tr>
<td>Using onboard EtherCAT protocol (licensed) in preparation</td>
<td></td>
</tr>
<tr>
<td>EtherCAT onboard No. of synchronized axis</td>
<td>PM5012</td>
</tr>
<tr>
<td>axis per 1 ms CM typically</td>
<td>-</td>
</tr>
<tr>
<td>axis per 2 msCM typically</td>
<td>-</td>
</tr>
<tr>
<td>axis per 4 ms CM typically</td>
<td>-</td>
</tr>
<tr>
<td>Cyclic min. configurable</td>
<td>10 ms</td>
</tr>
<tr>
<td>Time-controlled</td>
<td>Yes</td>
</tr>
<tr>
<td>Multitasking</td>
<td>Yes</td>
</tr>
<tr>
<td>Interruption</td>
<td>Yes</td>
</tr>
<tr>
<td>LEDs</td>
<td>Power, Error, Run, MC, MOD1, States of I/Os</td>
</tr>
<tr>
<td>RUN/STOP button</td>
<td>Yes</td>
</tr>
<tr>
<td>Protection of the user program by password</td>
<td>On request</td>
</tr>
<tr>
<td>Usable accessories</td>
<td>On request</td>
</tr>
<tr>
<td>Remarks:</td>
<td></td>
</tr>
<tr>
<td>* Depending an application complexity</td>
<td></td>
</tr>
<tr>
<td>1): The values are for information only and cannot be fulfilled altogether. The available resources are limited at the end by the maximal downloadable application size for each CPU.</td>
<td></td>
</tr>
<tr>
<td>Data of I/Os</td>
<td>PM5012-x-ETH</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Onboard digital inputs</td>
<td></td>
</tr>
<tr>
<td>Channels</td>
<td>6 (incl. 2 counter inputs 5 kHz and 4 interrupts)</td>
</tr>
<tr>
<td>Signal voltage</td>
<td>24 V DC type 1</td>
</tr>
<tr>
<td>Onboard digital outputs</td>
<td></td>
</tr>
<tr>
<td>Channels for transistor version</td>
<td>4 (5 kHz standard and PWM)</td>
</tr>
<tr>
<td>Channels digital input/ output configurable (valid for both PLC version relais or transistor)</td>
<td>-</td>
</tr>
<tr>
<td>Rated voltage transistor</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Nominal current per transistor channel</td>
<td>0.5 A resistive</td>
</tr>
<tr>
<td>Channels for relay version</td>
<td>4</td>
</tr>
<tr>
<td>Rated voltage relay</td>
<td>100 V AC ... 240 V AC or 24 V DC</td>
</tr>
<tr>
<td>Nominal current per relay channel</td>
<td>2 A resistive</td>
</tr>
<tr>
<td>Analog inputs</td>
<td>Optional</td>
</tr>
<tr>
<td>Analog outputs</td>
<td>Optional</td>
</tr>
<tr>
<td>Number of option board slots</td>
<td>1</td>
</tr>
<tr>
<td>Data of I/Os</td>
<td>PM5012-x-ETH</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Usage of option board</td>
<td>Each slot can be used for all type of existing option boards, same option board for serial interface or digital/analog I/O extension can be used on several slot per CPU. Note: RTC option board is only for PM5012 possible.</td>
</tr>
<tr>
<td>KNX address switch</td>
<td>No</td>
</tr>
<tr>
<td>Real-time clock (RTC)</td>
<td>TA5131-RTC</td>
</tr>
<tr>
<td>Serial interface</td>
<td>TA5141-RS232I, TA5142-RS485/TA5142-RS485I</td>
</tr>
<tr>
<td>Digital in/out channels</td>
<td>TA5101-4DI, TA5105-4DOT, TA5110-2DI2DOT</td>
</tr>
<tr>
<td>Analog in/out channels</td>
<td>TA5120-2AI-UI, TA5123-2AI-RTD, TA5126-2AO-UI</td>
</tr>
<tr>
<td>Max. number of I/O modules on I/O bus</td>
<td>0</td>
</tr>
<tr>
<td>Digital inputs</td>
<td>Onboard I/O only</td>
</tr>
<tr>
<td>Digital outputs</td>
<td>128 byte</td>
</tr>
<tr>
<td>Number of decentralized inputs and outputs</td>
<td>Depending on the fieldbus used</td>
</tr>
<tr>
<td>Internal interfaces</td>
<td>Optional, use a dedicated serial interface option board (up to 1)</td>
</tr>
<tr>
<td>Serial COMx</td>
<td>Modbus RTU Master/Slave, ASCII</td>
</tr>
<tr>
<td>Ethernet interface RJ45</td>
<td>1</td>
</tr>
<tr>
<td>Ethernet functions</td>
<td>Programming, TCP/IP, UDP/IP, DHCP, PING, network variables, and other listed below</td>
</tr>
<tr>
<td>Modbus TCP/IP client/server</td>
<td>Yes 8 / 3</td>
</tr>
<tr>
<td>SNTP client/server</td>
<td>No</td>
</tr>
<tr>
<td>HTTPs and WebVisu number of connections</td>
<td>No</td>
</tr>
<tr>
<td>FTPs number of connections</td>
<td>No</td>
</tr>
<tr>
<td>Data of I/Os</td>
<td>PM5012-x-ETH</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>OPC UA server</td>
<td>No</td>
</tr>
<tr>
<td>number of free tags</td>
<td></td>
</tr>
<tr>
<td>MQTT and JSON library</td>
<td>No</td>
</tr>
<tr>
<td>OPC DA server</td>
<td>Yes</td>
</tr>
<tr>
<td>IEC 60870-5-104 telecontrol</td>
<td>No</td>
</tr>
<tr>
<td>protocol</td>
<td></td>
</tr>
<tr>
<td>Licensed protocols (runtime protocol per CPU)</td>
<td>No</td>
</tr>
<tr>
<td>BACnet IP B-BC</td>
<td></td>
</tr>
<tr>
<td>“Chapter 6.3.4.9 &quot;BACnet-BC&quot; on page 1733”</td>
<td>No</td>
</tr>
<tr>
<td>KNXIP</td>
<td>No</td>
</tr>
<tr>
<td>“Chapter 6.3.4.8 &quot;KNX configurator&quot; on page 1730”</td>
<td>No</td>
</tr>
<tr>
<td>IEC 61850 MMS server/goose</td>
<td>No</td>
</tr>
<tr>
<td>pub/sub</td>
<td></td>
</tr>
<tr>
<td>EtherNet/IP adapter/scanner</td>
<td>No</td>
</tr>
<tr>
<td>EtherCAT Master</td>
<td>No</td>
</tr>
</tbody>
</table>
Dimensions

The dimensions are in mm and in brackets in inch.

Ordering Data

Processor modules for AC500-eCo V3 products

To enable better product availability into the production and to provide some new features, a revision of the existing AC500-eCo V3 processor module was necessary. The existing AC500-eCo V3 processor module with rubric R007x will move to classic and will be replaced by compatible new AC500-eCo V3 processor module revision 1 with rubric R017x.

For example: The processor module revision 1 PM5012-T-ETH (1SAP122 600 R0172) replaces the existing processor module PM5012-T-ETH (1SAP 122 600 R0072) and provides the same features or functionality of the previous ones.

Following points must be considered with the processor module revision 1:

- The processor module revision 1 (R017x) requires a new BootFW / CPUFW from V3.6.x and higher.
- It cannot be downgraded and used with lower FW versions than V3.6.0.
- The processor module revision 1 (R017x) provides the same features as the processor module (R007x) existing today and is fully compatible.
- An existing application using a processor module (R007x) built with Automation Builder < 2.6 can run on a processor module revision 1 (R017x) but the application must be upgraded to at least AB 2.6.0 or higher.
What must be done using a new processor module revision 1 (R017x)?

- On a new application?
  - Just use the processor module revision 1 (R017x)
  - Use the latest Automation Builder Software from 2.6.0 or higher.

- On an existing application using an Automation Builder software version smaller than 2.6.0?
  - To use a processor module revision 1 in an existing application (e.g., replacement of the processor module), the application must be upgraded to at least AB 2.6.0 or higher.
  - If several processor module (revision 1 and revision 0) are used within the same project, all the processor modules used in the same application must be upgraded to the FW Version V3.6.x and higher.

Table 32: Processor modules for AC500-eCo V3

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 122 600</td>
<td>Basic CPU PM5012-T-ETH, AC500-eCo V3 processor module, programmable logic controller 1 MB, 6DI/4DO-Transistor, Ethernet, 24 V DC, 1 option board slot</td>
<td>Classic (replaced by processor module revision 1)</td>
</tr>
<tr>
<td>R0072 (revision 0)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1SAP 122 600</td>
<td>Basic CPU PM5012-T-ETH, AC500-eCo V3 processor module, programmable logic controller 1 MB, 6DI/4DO-Transistor, Ethernet, 24 V DC, 1 option board slot</td>
<td>Active</td>
</tr>
<tr>
<td>R0172 (revision 1)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1SAP 122 700</td>
<td>Basic CPU PM5012-R-ETH, AC500-eCo V3 processor module, programmable logic controller 1 MB, 6DI/4DO-Relay, Ethernet, 24 V DC, 1 option board slot</td>
<td>Classic (replaced by processor module revision 1)</td>
</tr>
<tr>
<td>R0072 (revision 0)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1SAP 122 700</td>
<td>Basic CPU PM5012-R-ETH, AC500-eCo V3 processor module, programmable logic controller 1 MB, 6DI/4DO-Relay, Ethernet, 24 V DC, 1 option board slot</td>
<td>Active</td>
</tr>
<tr>
<td>R0172 (revision 1)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1SAP 123 400</td>
<td>Standard CPU PM5032-T-ETH, AC500-eCo V3 processor module, programmable logic controller 2 MB, 12DI/8DO-Transistor/2DC, Ethernet, 24 V DC, 2 option board slots</td>
<td>Classic (replaced by processor module revision 1)</td>
</tr>
<tr>
<td>R0072 (revision 0)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1SAP 123 400</td>
<td>Standard CPU PM5032-T-ETH, AC500-eCo V3 processor module, programmable logic controller 2 MB, 12DI/8DO-Transistor/2DC, Ethernet, 24 V DC, 2 option board slots</td>
<td>Active</td>
</tr>
<tr>
<td>R0172 (revision 1)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1SAP 123 500</td>
<td>Standard CPU PM5032-R-ETH, AC500-eCo V3 processor module, programmable logic controller 2 MB, 12DI/6DO-Relay/2DC, Ethernet, 24 V DC, 2 option board slots</td>
<td>Classic (replaced by processor module revision 1)</td>
</tr>
<tr>
<td>R0072 (revision 0)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1SAP 123 500</td>
<td>Standard CPU PM5032-R-ETH, AC500-eCo V3 processor module, programmable logic controller 2 MB, 12DI/6DO-Relay/2DC, Ethernet, 24 V DC, 2 option board slots</td>
<td>Active</td>
</tr>
<tr>
<td>R0172 (revision 1)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Part no.</td>
<td>Description</td>
<td>Product life cycle phase *)</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>1SAP 124 000 R0072</td>
<td>Standard CPU PM5052-T-ETH, AC500-eCo V3 processor module, programmable logic controller 4 MB, 12DI/8DO-Transistor/2DC, Ethernet, 24 V DC, 3 option board slots</td>
<td>Classic (replaced by processor module revision 1)</td>
</tr>
<tr>
<td></td>
<td>(<strong>processor module revision 0</strong>)</td>
<td></td>
</tr>
<tr>
<td>1SAP 124 000 R0172</td>
<td>Standard CPU PM5052-T-ETH, AC500-eCo V3 processor module, programmable logic controller 4 MB, 12DI/8DO-Transistor/2DC, Ethernet, 24 V DC, 3 option board slots</td>
<td>Active</td>
</tr>
<tr>
<td></td>
<td>(<strong>processor module revision 1</strong>)</td>
<td></td>
</tr>
<tr>
<td>1SAP 124 100 R0072</td>
<td>Standard CPU PM5052-R-ETH, AC500-eCo V3 processor module, programmable logic controller 4 MB, 12DI/6DO-Relay/2DC, Ethernet, 24 V DC, 3 option board slots</td>
<td>Classic (replaced by processor module revision 1)</td>
</tr>
<tr>
<td></td>
<td>(<strong>processor module revision 0</strong>)</td>
<td></td>
</tr>
<tr>
<td>1SAP 124 100 R0172</td>
<td>Standard CPU PM5052-R-ETH, AC500-eCo V3 processor module, programmable logic controller 4 MB, 12DI/6DO-Relay/2DC, Ethernet, 24 V DC, 3 option board slots</td>
<td>Active</td>
</tr>
<tr>
<td></td>
<td>(<strong>processor module revision 1</strong>)</td>
<td></td>
</tr>
<tr>
<td>1SAP 124 500 R0073</td>
<td>Pro CPU PM5072-T-2ETH, AC500-eCo V3 processor module, programmable logic controller 8 MB, 12DI/8DO-Transistor/2DC, 2 Ethernet, 24 V DC, 3 option board slots</td>
<td>Classic (replaced by processor module revision 1)</td>
</tr>
<tr>
<td></td>
<td>(<strong>processor module revision 0</strong>)</td>
<td></td>
</tr>
<tr>
<td>1SAP 124 500 R0173</td>
<td>Pro CPU PM5072-T-2ETH, AC500-eCo V3 processor module, programmable logic controller 8 MB, 12DI/8DO-Transistor/2DC, 2 Ethernet, 24 V DC, 3 option board slots</td>
<td>Active</td>
</tr>
<tr>
<td></td>
<td>(<strong>processor module revision 1</strong>)</td>
<td></td>
</tr>
<tr>
<td>1SAP 124 400 R0073</td>
<td>Pro CPU PM5072-T-2ETHW, AC500-eCo V3 processor module, programmable logic controller 8 MB, 12DI/8DO-Transistor/2DC, 2 Ethernet, 24 V DC, 3 option board slots, wide temperature</td>
<td>Classic (replaced by processor module revision 1)</td>
</tr>
<tr>
<td></td>
<td>(<strong>processor module revision 0</strong>)</td>
<td></td>
</tr>
<tr>
<td>1SAP 124 400 R0173</td>
<td>Pro CPU PM5072-T-2ETHW, AC500-eCo V3 processor module, programmable logic controller 8 MB, 12DI/8DO-Transistor/2DC, 2 Ethernet, 24 V DC, 3 option board slots, wide temperature</td>
<td>Active</td>
</tr>
<tr>
<td></td>
<td>(<strong>processor module revision 1</strong>)</td>
<td></td>
</tr>
<tr>
<td>1SAP 124 600 R0173</td>
<td>Pro CPU PM5082-T-2ETH, AC500-eCo V3 processor module, programmable logic controller 8 MB, 12DI/8DO-Transistor/2DC, 2 Ethernet, 24 V DC, 3 option board slots</td>
<td>Active</td>
</tr>
<tr>
<td></td>
<td>(<strong>processor module revision 1</strong>)</td>
<td></td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
### Table 33: Accessories for AC500-eCo V3

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Required accessories</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| 1SAP 187 400 R00xx | TA52xx, terminal block set  
  ‡ Chapter 5.2.8.1.2 “TA52xx(-x) - Terminal block sets” on page 1292 | Active                      |
| **Optional accessories**                                                                                                       |
| 1SAP 187 000 R0xxx | TA51xx, option board  
  ‡ Chapter 5.2.1.1.3 “Option boards” on page 218 | Active                      |
| 1SAP 180 100 R0002 | MC5102, memory card  
  ‡ Chapter 5.2.8.1.1 “MC5102 - Micro memory card with adapter” on page 1286 | Active                      |
| 1SAP 182 800 R0001 | TA543, screw mounting accessory, 20 pieces per packing unit  
  ‡ Chapter 4.3.8.5 “Mounting a processor module on a metal plate” on page 121 | Active                      |
| 1SAP 187 500 R0003 | TA5301-CFA, cable fixing part accessory, 20 pieces per packing unit  
  ‡ Chapter 4.3.8.7 “Mounting of the cable fixing accessory TA5301-CFA” on page 123 | Active                      |
| 1SAP 187 500 R0001 | TA5300-CVR, option board slot cover, 6 pieces | Active                      |
| 1SAP 187 600 R0001 | TA5400-SIM, input simulator for testing and training purposes, 6 switches  
  ‡ Chapter 5.2.8.1.4 “TA5400-SIM - Input simulator” on page 1305 | Active                      |

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

---

5.2.1.1.2 **Onboard I/Os in processor module PM50x2**

**Functionality**

The AC500-eCo V3 processor modules PM50x2 have onboard I/Os which provide several functionalities. According to the CPU type, the number or the functionality of the onboard I/Os can be different.

With the processor modules revision 1 (rubric R017x), the fast output channels provides up to 4 PTO pulse/direction with up to 200 kHz (rubric R007x, only 100 kHz). The processor modules revision 1 are supported from AB 2.6.0 and the AB software automatically recognizes the used processor module.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Digital inputs</strong></td>
<td><strong>Value</strong></td>
</tr>
<tr>
<td>PM5012-T-ETH</td>
<td>6</td>
</tr>
<tr>
<td>PM5012-R-ETH</td>
<td></td>
</tr>
<tr>
<td>PM5032-T-ETH</td>
<td>12</td>
</tr>
<tr>
<td>PM5052-T-ETH</td>
<td></td>
</tr>
<tr>
<td>PM5072-T-2ETH(W)</td>
<td></td>
</tr>
<tr>
<td>PM5082-T-2ETH</td>
<td></td>
</tr>
<tr>
<td><strong>Functionality of</strong></td>
<td><strong>Digital inputs</strong></td>
</tr>
<tr>
<td><strong>(encoder, fast counter, counter, interrupt)</strong></td>
<td><strong>(encoder, fast counter, counter, interrupt)</strong></td>
</tr>
<tr>
<td>6 DI fast input 24 V DC (max. 5 kHz) usable as</td>
<td>6 DI fast input 24 V DC (max. 200 kHz) usable as</td>
</tr>
<tr>
<td>4 DI 24 V DC standard</td>
<td>4 DI 24 V DC standard or</td>
</tr>
<tr>
<td>2 channel 5 kHz encoder with frequency measurement or</td>
<td>4 fast counter (100 kHz) or</td>
</tr>
<tr>
<td>2 channel 5 kHz encoder with frequency measurement and with touch/reset using standard DI or</td>
<td>2 A/B encoder (200 kHz) with frequency measurement or</td>
</tr>
<tr>
<td>2 fast counter (5 kHz)</td>
<td>2 full A/B encoders 0 and 1 (200 kHz) with frequency measurement and with touch/reset using standard highspeed (5 kHz) DI</td>
</tr>
<tr>
<td>4 DI as interrupt input with 1 dedicated interrupt task and input information</td>
<td>1 full A/B encoder 0 (200 kHz) with frequency measurement and optional with touch/reset using 2 touch/sync inputs with A/B encoder 0</td>
</tr>
<tr>
<td>4 DI fast input 24 V DC (5 kHz) usable as</td>
<td>4 DI fast input 24 V DC (5 kHz) usable as</td>
</tr>
<tr>
<td>4 DI 24 V DC standard or</td>
<td>4 DI 24 V DC standard or</td>
</tr>
<tr>
<td>4 DI as interrupt input with 1 dedicated interrupt task and input information</td>
<td>4 fast counter (100 kHz) or</td>
</tr>
<tr>
<td>4 touch/sync inputs with A/B encoder 0 or 1</td>
<td>2 A/B encoder (200 kHz) with frequency measurement or</td>
</tr>
<tr>
<td>4 standard DI 24 V DC</td>
<td></td>
</tr>
</tbody>
</table>
### Functionality of digital outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 fast output DO-T</td>
<td>24 V DC/0.5 A (max. 5 kHz) usable as</td>
</tr>
<tr>
<td></td>
<td>- 4 DO-T 24 V DC/0.5 A or</td>
</tr>
<tr>
<td></td>
<td>- 4 PWM Note: The speed must be limited</td>
</tr>
<tr>
<td></td>
<td>below 100 Hz. The low speed PWM can</td>
</tr>
<tr>
<td></td>
<td>be used for heating control.</td>
</tr>
<tr>
<td></td>
<td>- 4 limit switch</td>
</tr>
<tr>
<td>4 DO-R</td>
<td>24 V DC / 120/240 V AC 2A in 2 groups</td>
</tr>
<tr>
<td>4 fast output DO-T</td>
<td>24 V DC (100 kHz) usable as</td>
</tr>
<tr>
<td></td>
<td>- 4 DO-T 24 V DC/0.5 A</td>
</tr>
<tr>
<td></td>
<td>- 4 limit/ switch outputs for encoder/</td>
</tr>
<tr>
<td></td>
<td>counter or</td>
</tr>
<tr>
<td></td>
<td>- 4 PWM (30 kHz, 2 µs accuracy and</td>
</tr>
<tr>
<td></td>
<td>maximum duty 95%) or</td>
</tr>
<tr>
<td></td>
<td>- 2 PTO (200 kHz) CW/CCW or Pulse/Dir-</td>
</tr>
<tr>
<td></td>
<td>ection</td>
</tr>
<tr>
<td></td>
<td>- 4 PTO (PWM) 100...200 kHz Pulse/Dir-</td>
</tr>
<tr>
<td></td>
<td>ection using standard output</td>
</tr>
<tr>
<td>6 DO-R</td>
<td>24 V DC / 120/240 V AC 2A in 2 groups</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>PM5012-T-ETH</td>
</tr>
<tr>
<td>4 fast output DO-T</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>4 limit/switch outputs for encoder/counter or PWM</td>
<td></td>
</tr>
<tr>
<td>Note: The speed must be limited below 100 Hz. The low speed PWM can be used for heating control.</td>
<td></td>
</tr>
<tr>
<td>4 direction outputs together with 4 high speed pulses for up to 4 PTO Pulse/Direction outputs up to 200 kHz</td>
<td></td>
</tr>
<tr>
<td>Digital inputs/outputs, configurable</td>
<td>-</td>
</tr>
<tr>
<td>Functionality of digital inputs/outputs, configurable</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>LED displays</td>
<td>For signal states</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>PM5012-T-ETH</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via processor module</td>
</tr>
<tr>
<td>External power supply</td>
<td>Via UP and ZP terminal</td>
</tr>
</tbody>
</table>

**Connections**

**General**

**WARNING!**
Risk of death by electric shock!
Hazardous voltages can be present at the terminals of the module.
Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.

**NOTICE!**
Risk of damaging the PLC modules!
The PLC modules must not be removed while the plant is connected to a power supply.
Make sure that all voltage sources (supply and process voltage) are switched off before you:
- connect or disconnect any signal or terminal block
- remove or replace a module.

**NOTICE!**
Risk of damaging the PLC modules!
Overvoltages and short circuits might damage the PLC modules.
- Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
- Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

*When replacing a processor module, it is recommended to mark each wire connected to the onboard I/O terminal block before disconnecting it. This should make sure that the wires can be reconnected in the same order.*

The connection is carried out by using removable 12-pin and 13-pin terminal blocks.
### Table 34: Assignment of the terminals for PM5012-T-ETH:

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>COM 0..5</td>
<td>Input common for digital input signals I0 to I5</td>
</tr>
<tr>
<td>2</td>
<td>I0</td>
<td>Digital input signal I0 (5 kHz)</td>
</tr>
<tr>
<td>3</td>
<td>I1</td>
<td>Digital input signal I1 (5 kHz)</td>
</tr>
<tr>
<td>4</td>
<td>I2</td>
<td>Digital input signal I2 (5 kHz)</td>
</tr>
<tr>
<td>5</td>
<td>I3</td>
<td>Digital input signal I3 (5 kHz)</td>
</tr>
<tr>
<td>6</td>
<td>I4</td>
<td>Digital input signal I4 (5 kHz)</td>
</tr>
<tr>
<td>7</td>
<td>I5</td>
<td>Digital input signal I5 (5 kHz)</td>
</tr>
<tr>
<td>8</td>
<td>O0</td>
<td>Digital output signal O0 (5 kHz)</td>
</tr>
<tr>
<td>9</td>
<td>O1</td>
<td>Digital output signal O1 (5 kHz)</td>
</tr>
<tr>
<td>10</td>
<td>O2</td>
<td>Digital output signal O2 (5 kHz)</td>
</tr>
<tr>
<td>11</td>
<td>O3</td>
<td>Digital output signal O3 (5 kHz)</td>
</tr>
<tr>
<td>12</td>
<td>UP</td>
<td>Process supply voltage UP +24 V DC</td>
</tr>
<tr>
<td>13</td>
<td>ZP</td>
<td>Process supply voltage ZP 0 V DC</td>
</tr>
</tbody>
</table>

### Table 35: Assignment of the terminals for PM5012-R-ETH:

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>COM 0..5</td>
<td>Input common for digital input signals I0 to I5</td>
</tr>
<tr>
<td>2</td>
<td>I0</td>
<td>Digital input signal I0 (5 kHz)</td>
</tr>
<tr>
<td>3</td>
<td>I1</td>
<td>Digital input signal I1 (5 kHz)</td>
</tr>
<tr>
<td>4</td>
<td>I2</td>
<td>Digital input signal I2 (5 kHz)</td>
</tr>
<tr>
<td>5</td>
<td>I3</td>
<td>Digital input signal I3 (5 kHz)</td>
</tr>
<tr>
<td>6</td>
<td>I4</td>
<td>Digital input signal I4 (5 kHz)</td>
</tr>
<tr>
<td>7</td>
<td>I5</td>
<td>Digital input signal I5 (5 kHz)</td>
</tr>
<tr>
<td>8</td>
<td>NO0</td>
<td>Normally-open relay contact of the output NO0</td>
</tr>
<tr>
<td>9</td>
<td>NO1</td>
<td>Normally-open relay contact of the output NO1</td>
</tr>
<tr>
<td>10</td>
<td>R0..1</td>
<td>Output common for signals NO0 to NO1</td>
</tr>
<tr>
<td>11</td>
<td>NO2</td>
<td>Normally-open relay contact of the output NO2</td>
</tr>
<tr>
<td>12</td>
<td>NO3</td>
<td>Normally-open relay contact of the output NO3</td>
</tr>
<tr>
<td>13</td>
<td>R2..3</td>
<td>Output common for signals NO2 to NO3</td>
</tr>
<tr>
<td>Terminal</td>
<td>Signal</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>--------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>1</td>
<td>COM 0..11</td>
<td>Input common for digital input signals I0 to I11</td>
</tr>
<tr>
<td>2</td>
<td>I0</td>
<td>Digital input signal I0 (max. 5 kHz)</td>
</tr>
<tr>
<td>3</td>
<td>I1</td>
<td>Digital input signal I1 (max. 5 kHz)</td>
</tr>
<tr>
<td>4</td>
<td>I2</td>
<td>Digital input signal I2 (max. 5 kHz)</td>
</tr>
<tr>
<td>5</td>
<td>I3</td>
<td>Digital input signal I3 (max. 5 kHz)</td>
</tr>
<tr>
<td>6</td>
<td>I4</td>
<td>Digital input signal I4 Forward counter (max. 100 kHz), Encoder (max. 200 kHz)</td>
</tr>
<tr>
<td>7</td>
<td>I5</td>
<td>Digital input signal I5 (100 kHz) Forward counter (max. 100 kHz), Encoder (max. 200 kHz)</td>
</tr>
<tr>
<td>8</td>
<td>I6</td>
<td>Digital input signal I6 (100 kHz) Forward counter (max. 100 kHz), Encoder (max. 200 kHz)</td>
</tr>
<tr>
<td>9</td>
<td>I7</td>
<td>Digital input signal I7 (100 kHz) Forward counter (max. 100 kHz), Encoder (max. 200 kHz)</td>
</tr>
<tr>
<td>10</td>
<td>I8</td>
<td>Digital input signal I8</td>
</tr>
<tr>
<td>11</td>
<td>I9</td>
<td>Digital input signal I9</td>
</tr>
<tr>
<td>12</td>
<td>I10</td>
<td>Digital input signal I10</td>
</tr>
<tr>
<td>13</td>
<td>I11</td>
<td>Digital input signal I11</td>
</tr>
<tr>
<td>14</td>
<td>O0</td>
<td>Digital output signal O0 (max. 5 kHz)</td>
</tr>
<tr>
<td>15</td>
<td>O1</td>
<td>Digital output signal O1 (max. 5 kHz)</td>
</tr>
<tr>
<td>16</td>
<td>O2</td>
<td>Digital output signal O2 (max. 5 kHz)</td>
</tr>
<tr>
<td>17</td>
<td>O3</td>
<td>Digital output signal O3 (max. 5 kHz)</td>
</tr>
<tr>
<td>18</td>
<td>O4</td>
<td>Digital output signal O4 PWM (max. 100 kHz), PTO (max. 200 kHz)</td>
</tr>
<tr>
<td>19</td>
<td>O5</td>
<td>Digital output signal O5 PWM (max. 100 kHz), PTO (max. 200 kHz)</td>
</tr>
<tr>
<td>20</td>
<td>O6</td>
<td>Digital output signal O6 PWM (max. 100 kHz), PTO (max. 200 kHz)</td>
</tr>
<tr>
<td>21</td>
<td>O7</td>
<td>Digital output signal O7 PWM (max. 100 kHz), PTO (max. 200 kHz)</td>
</tr>
<tr>
<td>22</td>
<td>C12</td>
<td>Digital input/output signal configurable C12</td>
</tr>
<tr>
<td>23</td>
<td>C13</td>
<td>Digital input/output signal configurable C13</td>
</tr>
<tr>
<td>24</td>
<td>UP</td>
<td>Process supply voltage UP +24 V DC</td>
</tr>
<tr>
<td>25</td>
<td>ZP</td>
<td>Process supply voltage ZP 0 V DC</td>
</tr>
</tbody>
</table>
Table 37: Assignment of the terminals for PM5032-R-ETH and PM5052-R-ETH:

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>COM 0..11</td>
<td>Input common for digital input signals I0 to I11</td>
</tr>
<tr>
<td>2</td>
<td>I0</td>
<td>Digital input signal I0 (max. 5 kHz)</td>
</tr>
<tr>
<td>3</td>
<td>I1</td>
<td>Digital input signal I1 (max. 5 kHz)</td>
</tr>
<tr>
<td>4</td>
<td>I2</td>
<td>Digital input signal I2 (max. 5 kHz)</td>
</tr>
<tr>
<td>5</td>
<td>I3</td>
<td>Digital input signal I3 (max. 5 kHz)</td>
</tr>
<tr>
<td>6</td>
<td>I4</td>
<td>Digital input signal I4 Forward counter (max. 100 kHz), Encoder (max. 200 kHz)</td>
</tr>
<tr>
<td>7</td>
<td>I5</td>
<td>Digital input signal I5 Forward counter (max. 100 kHz), Encoder (max. 200 kHz)</td>
</tr>
<tr>
<td>8</td>
<td>I6</td>
<td>Digital input signal I6 Forward counter (max. 100 kHz), Encoder (max. 200 kHz)</td>
</tr>
<tr>
<td>9</td>
<td>I7</td>
<td>Digital input signal I7 Forward counter (max. 100 kHz), Encoder (max. 200 kHz)</td>
</tr>
<tr>
<td>10</td>
<td>I8</td>
<td>Digital input signal I8</td>
</tr>
<tr>
<td>11</td>
<td>I9</td>
<td>Digital input signal I9</td>
</tr>
<tr>
<td>12</td>
<td>I10</td>
<td>Digital input signal I10</td>
</tr>
<tr>
<td>13</td>
<td>I11</td>
<td>Digital input signal I11</td>
</tr>
<tr>
<td>14</td>
<td>NO0</td>
<td>Normally-open relay contact of the output NO0</td>
</tr>
<tr>
<td>15</td>
<td>NO1</td>
<td>Normally-open relay contact of the output NO1</td>
</tr>
<tr>
<td>16</td>
<td>NO2</td>
<td>Normally-open relay contact of the output NO2</td>
</tr>
<tr>
<td>17</td>
<td>R0..2</td>
<td>Output common for signals NO0 to NO2</td>
</tr>
<tr>
<td>18</td>
<td>NO3</td>
<td>Normally-open relay contact of the output NO3</td>
</tr>
<tr>
<td>19</td>
<td>NO4</td>
<td>Normally-open relay contact of the output NO4</td>
</tr>
<tr>
<td>20</td>
<td>NO5</td>
<td>Normally-open relay contact of the output NO5</td>
</tr>
<tr>
<td>21</td>
<td>R3..5</td>
<td>Output common for signals NO3 to NO5</td>
</tr>
<tr>
<td>22</td>
<td>C12</td>
<td>Digital input/output signal configurable C12 PWM (max. 100 kHz), PTO (max. 200 kHz)</td>
</tr>
<tr>
<td>23</td>
<td>C13</td>
<td>Digital input/output signal configurable C13 PWM (max. 100 kHz), PTO (max. 200 kHz)</td>
</tr>
<tr>
<td>24</td>
<td>UP</td>
<td>Process supply voltage UP +24 V DC</td>
</tr>
<tr>
<td>25</td>
<td>ZP</td>
<td>Process supply voltage ZP 0 V DC</td>
</tr>
</tbody>
</table>
## Block diagrams

### Table 38: Internal structure of the onboard I/Os

<table>
<thead>
<tr>
<th>PM5012-T-ETH</th>
<th>PM5012-R-ETH</th>
<th>PM5032-ETH</th>
<th>PM5032-R-ETH</th>
</tr>
</thead>
<tbody>
<tr>
<td>COM 1 0..5 1</td>
<td>COM 1 0..5 1</td>
<td>COM 1 0..11 1</td>
<td>COM 1 0..11 1</td>
</tr>
<tr>
<td>I0 2 10</td>
<td>I0 2 10</td>
<td>I0 2</td>
<td>I0 2</td>
</tr>
<tr>
<td>I1 3 11</td>
<td>I1 3 11</td>
<td>I1 3</td>
<td>I1 3</td>
</tr>
<tr>
<td>I2 4 12</td>
<td>I2 4 12</td>
<td>I2 4</td>
<td>I2 4</td>
</tr>
<tr>
<td>I3 5</td>
<td>I3 5</td>
<td>I3 5</td>
<td>I3 5</td>
</tr>
<tr>
<td>I4 6</td>
<td>I4 6</td>
<td>I4 6</td>
<td>I4 6</td>
</tr>
<tr>
<td>I5 7</td>
<td>I5 7</td>
<td>I5 7</td>
<td>I5 7</td>
</tr>
<tr>
<td>O0 8</td>
<td>NO0 8</td>
<td>I6 8</td>
<td>NO0 14</td>
</tr>
<tr>
<td>O1 9</td>
<td>NO1 9</td>
<td>I7 9</td>
<td>NO1 15</td>
</tr>
<tr>
<td>O2 10</td>
<td>R0..1 10</td>
<td>I8 10</td>
<td>NO2 16</td>
</tr>
<tr>
<td>O3 11</td>
<td>NO2 11</td>
<td>I9 11</td>
<td>NO3 18</td>
</tr>
<tr>
<td>UP 12</td>
<td>NO3 12</td>
<td>I10 12</td>
<td>NO4 19</td>
</tr>
<tr>
<td>ZP 13</td>
<td>R2..3 13</td>
<td>I11 13</td>
<td>NO5 20</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>R3..5 21</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>C12 22</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>C13 23</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>C13 23</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>C12 22</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>UP 24</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ZP 25</td>
</tr>
</tbody>
</table>
Connection of the digital inputs

The digital inputs can be used as source inputs or as sink inputs.

**NOTICE!**
Risk of malfunctions in the plant!

A ground fault, e.g. caused by a damaged cable insulation, can bridge switches accidentally.

Use sink inputs when possible or make sure that, in case of error, there will be no risks to persons or plant.

Table 39: Connection of the digital inputs to the PM50x2 processor modules

<table>
<thead>
<tr>
<th>Connection of digital inputs (sink inputs)</th>
<th>Connection digital inputs (source inputs)</th>
</tr>
</thead>
</table>

![Diagram showing connection of digital inputs](image-url)
Connection of the digital transistor outputs (PM50xx-T-xETH only)

Fig. 29: Connection of digital transistor outputs and configurable digital inputs/outputs

C12 used as configurable digital input
C13 used as configurable digital transistor output

CAUTION!
Risk of damaging the processor module!
The outputs are not protected against short circuit and overload.
- Never short-circuit or overload the outputs.
- Never connect the outputs to other voltages.
- Use an external fuse for each output.

The configurable digital channels (C12 and C13) used as digital inputs have the same electrical characteristics as standard digital inputs.
The configurable digital channels (C12 and C13) used as digital transistor outputs have the same electrical characteristics as standard digital outputs.
Connection of the digital relay outputs (PM50xx-R-ETH only)

![Diagram showing connection of digital relay outputs and configurable digital inputs/outputs]

C12 used as configurable digital input
C13 used as configurable digital transistor output

**WARNING!**
Risk of death by electric shock!

Hazardous voltages can be present at the terminals of the module.
Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.

**CAUTION!**
Risk of damaging the processor module!

- Never short-circuit or overload the outputs.
- Never connect inductive loads without an external suppression against voltage peaks due to inductive kickback.
- Never connect voltages > 240 V. All outputs must be fed from the same phase.
- Use an external fuse for each output.
The configurable digital channels (C12 and C13) used as digital inputs have the same electrical characteristics as standard digital inputs.

The configurable digital channels (C12 and C13) used as digital transistor outputs have the same electrical characteristics as standard digital outputs.

I/O configuration

The configuration data of the onboard I/Os is stored in the processor modules PM50x2.

«Chapter 6.3.2.5 “Configure the onboard I/O channel” on page 1483

Parameterization

For information about parameterization, refer to the configuration description for onboard I/Os for processor modules PM50x2.

«“Basic CPU: PM5012-x-ETH” on page 1484
«“Standard CPU: PM5032-x-ETH, PM5052-x-ETH Pro CPU: PM5072-T-2ETH, PM5082-T-2ETH” on page 1486

Diagnosis

No diagnosis is generated for the onboard I/O.
There is only an error message if the configuration does not work. A log entry is generated. The Automation Builder already prevents faulty values from being entered in the configuration.
If the configuration does not work, there is a system error, if e.g. faulty software or wrong versions are installed.
Otherwise there are error messages from the blocks for the individual functions.

State LEDs

Table 40: States of the I/Os

<table>
<thead>
<tr>
<th>LED</th>
<th>Status</th>
<th>Color</th>
<th>LED = ON</th>
<th>LED = OFF</th>
</tr>
</thead>
<tbody>
<tr>
<td>I</td>
<td>Digital input</td>
<td>yellow</td>
<td>Input is ON</td>
<td>Input is OFF</td>
</tr>
<tr>
<td>O</td>
<td>Digital transistor output</td>
<td>yellow</td>
<td>Output is ON</td>
<td>Output is OFF</td>
</tr>
<tr>
<td>NO</td>
<td>Digital relay output</td>
<td>yellow</td>
<td>Relay contact is closed</td>
<td>Relay contact is open</td>
</tr>
<tr>
<td>C</td>
<td>Digital configurable input/output</td>
<td>yellow</td>
<td>Configured input/output is ON</td>
<td>Configured input/output is OFF</td>
</tr>
</tbody>
</table>
### Technical data of the digital inputs

**Table 41: PM5012-x-ETH**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>6</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 6 channels</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per group</td>
</tr>
<tr>
<td>Connections of the channels I0 to I11</td>
<td>Terminals 2 to 7</td>
</tr>
<tr>
<td>Reference potential for the channels I0 to I11</td>
<td>Terminal 1</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel; the LED is ON when the input signal is high (signal 1) and the module’s logic is in operation</td>
</tr>
<tr>
<td>Input type according to EN 61131-2</td>
<td>Type 1 source, Type 1 sink</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>-24 V DC, +24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-5 V ... +3 V, -3 V ... +5 V</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>-15 V ... 5 V, 5 V ... +15 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>-30 V ... -15 V, +15 V ... +30 V</td>
</tr>
<tr>
<td>Ripple with signal 0</td>
<td>Within -5 V ... +3 V, Within -3 V ... +5 V</td>
</tr>
<tr>
<td>Ripple with signal 1</td>
<td>Within -30 V ... -15 V, Within +15 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 4.6 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>Typ. 0.8 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>&gt; 2.5 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 8 mA</td>
</tr>
<tr>
<td>Max. permissible leakage current (at 2-wire proximity switches)</td>
<td>1 mA</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>On request</td>
</tr>
<tr>
<td>Max. cable length *)</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>500 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>300 m</td>
</tr>
</tbody>
</table>

*) For fast inputs, a shielded cable must be used and the max. cable length is 50 m.

**Table 42: PM5032-x-ETH, PM5052-x-ETH, PM5072-T-2ETH(W) and PM5082-T-2ETH**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>12</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 12 channels</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per group</td>
</tr>
<tr>
<td>Connections of the channels I0 to I11</td>
<td>Terminals 2 to 13</td>
</tr>
<tr>
<td>Reference potential for the channels I0 to I11</td>
<td>Terminal 1</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel; the LED is ON when the input signal is high (signal 1) and the module’s logic is in operation</td>
</tr>
<tr>
<td>Input type according to EN 61131-2</td>
<td>Type 1 source, Type 1 sink</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>-24 V DC +24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-5 V ... +3 V -3 V ... +5 V</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>-15 V ... -5 V +5 V ... +15 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>-30 V ... -15 V +15 V ... +30 V</td>
</tr>
<tr>
<td>Ripple with signal 0</td>
<td>Within -5 V ... +3 V Within -3 V ... +5 V</td>
</tr>
<tr>
<td>Ripple with signal 1</td>
<td>Within -30 V ... -15 V Within +15 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 4.6 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>Typ. 0.8 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>&gt; 2.5 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 8 mA</td>
</tr>
<tr>
<td>Max. permissible leakage current (at 2-wire proximity switches)</td>
<td>1 mA</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>On request</td>
</tr>
<tr>
<td>Max. cable length *)</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>500 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>300 m</td>
</tr>
</tbody>
</table>

*) For fast inputs, a shielded cable must be used and the max. cable length is 50 m.

**Technical data of the fast counter inputs**

*For AC500 devices the function "fast counter" is available in S500 I/O modules as of firmware version V1.3.*

*For AC500-eCo V3 devices the function "fast counter" is available in onboard I/Os of PM50xx.*

The AC500-eCo V3 processor modules with onboard I/Os provide some special functionality on the digital inputs or digital outputs. Fast counter, encoder inputs, interrupt inputs or PWM/PTO outputs are available depending on the device used.

The fast counter functionality can be activated within the onboard I/O configuration.

The fast counter can work in pulse/direction mode or A/B track counter mode.

☞ Further information about the operating modes of the fast counter
☞ Further information about the configuration of the fast counter

As AC500-eCo V3 PLCs provide the fast counters via their onboard I/Os not only the correct power distribution to the PLC has to be made, but also the correct wiring to the signal wires. How to connect and use fast counters in AC500-eCo V3 PLCs is described in an application example.

The pulse/direction counter detects the rising edge of the counter input. It will increase or decrease the count value (depending on the direction input) at every rising edge.

The A/B track counter is used to count the signal from an encoder.
The counter can count with quad phases. In the following the behavior of the A/B track counter is described.

### Fast counter

<table>
<thead>
<tr>
<th>Parameter</th>
<th>PM5012-T-ETH</th>
<th>PM5012-R-ETH</th>
<th>PM5032-T-ETH</th>
<th>PM5032-R-ETH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Useable inputs</td>
<td>2</td>
<td>2</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>Fast input max. 5 kHz</td>
<td>I4 ... I5</td>
<td>I4 ... I5</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Fast input, max. 100 kHz</td>
<td>-</td>
<td>-</td>
<td>I4 ... I7</td>
<td>I4 ... I7</td>
</tr>
</tbody>
</table>

### Technical data of the interrupt inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>PM5012-T-ETH</th>
<th>PM5012-R-ETH</th>
<th>PM5032-T-ETH</th>
<th>PM5032-R-ETH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Useable inputs</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>Fast input max. 5 kHz</td>
<td>I0 ... I3</td>
<td>I0 ... I3</td>
<td>I0 ... I3</td>
<td>I0 ... I3</td>
</tr>
</tbody>
</table>

### Technical data of the Touch/Reset inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>PM5012-T-ETH</th>
<th>PM5012-R-ETH</th>
<th>PM5032-T-ETH</th>
<th>PM5032-R-ETH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Useable inputs</td>
<td>-</td>
<td>-</td>
<td>4 together with dedicated encoder</td>
<td>4 together with dedicated encoder</td>
</tr>
</tbody>
</table>
### Technical data of the digital transistor outputs

**Table 43: PM5012-T-ETH**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>4</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 4 channels</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per group</td>
</tr>
<tr>
<td>Connection of the channels O0 to O3</td>
<td>Terminals 8 to 11</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>Terminals 12 (+24 V DC, signal name UP)</td>
</tr>
<tr>
<td>Reference potential for the channels O0 to O3</td>
<td>Terminal 13 (0 V DC, negative pole of the process voltage, signal name ZP)</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>1 yellow LED per channel; the LED is on when the output signal is high (signal 1)</td>
</tr>
<tr>
<td>Way of operation</td>
<td>Non-latching type</td>
</tr>
<tr>
<td>Min. output voltage at signal 1</td>
<td>UP - 0.1 V</td>
</tr>
<tr>
<td>Output delay (max. at rated load)</td>
<td></td>
</tr>
<tr>
<td>0 to 1</td>
<td>On request</td>
</tr>
<tr>
<td>1 to 0</td>
<td>On request</td>
</tr>
<tr>
<td>Rated protection fuse (per channel)</td>
<td>2 A fast</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated current per channel (max.)</td>
<td>0.5 A at UP 24 V DC (resistance, general use and pilot duty)</td>
</tr>
<tr>
<td>Rated current per group (max.)</td>
<td>2 A</td>
</tr>
<tr>
<td>Rated current (all channels together, max.)</td>
<td>2 A</td>
</tr>
<tr>
<td>Max. leakage current with signal 0</td>
<td>On request</td>
</tr>
<tr>
<td>Demagnetization when inductive loads are switched off</td>
<td>Must be performed externally according to driven load specification</td>
</tr>
<tr>
<td>Switching Frequencies</td>
<td></td>
</tr>
<tr>
<td>With inductive loads</td>
<td>On request</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>Short-circuit-proof / Overload-proof</td>
<td>No</td>
</tr>
<tr>
<td>Overload message</td>
<td>No</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>No</td>
</tr>
<tr>
<td>Resistance to feedback against 24 V DC</td>
<td>No</td>
</tr>
<tr>
<td>Connection of 2 outputs in parallel</td>
<td>Not possible</td>
</tr>
<tr>
<td>Max. cable length *)</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>500 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>150 m</td>
</tr>
</tbody>
</table>

*) For PWM and PTO outputs, a shielded cable must be used.

**Table 44: PM5032-T-ETH, PM5052-T-ETH, PM5072-T-2ETH(W) and PM5082-T-2ETH**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per group</td>
</tr>
<tr>
<td>Connection of the channels O0 to O7</td>
<td>Terminals 14 to 21</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>Terminals 24 (+24 V DC, signal name UP)</td>
</tr>
<tr>
<td>Reference potential for the channels O0 to O7</td>
<td>Terminal 25 (0 V DC, negative pole of the process voltage, signal name ZP)</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>1 yellow LED per channel; the LED is on when the output signal is high (signal 1)</td>
</tr>
<tr>
<td>Way of operation</td>
<td>Non-latching type</td>
</tr>
<tr>
<td>Min. output voltage at signal 1</td>
<td>UP - 0.1 V</td>
</tr>
<tr>
<td>Output delay (max. at rated load)</td>
<td></td>
</tr>
<tr>
<td>0 to 1</td>
<td>On request</td>
</tr>
<tr>
<td>1 to 0</td>
<td>On request</td>
</tr>
<tr>
<td>Rated protection fuse (per channel)</td>
<td>2 A fast</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated current per channel (max.)</td>
<td>0.5 A at UP 24 V DC (resistance, general use and pilot duty)</td>
</tr>
<tr>
<td>Rated current per group (max.)</td>
<td>4 A</td>
</tr>
<tr>
<td>Rated current (all channels together, max.)</td>
<td>4 A</td>
</tr>
<tr>
<td>Max. leakage current with signal 0</td>
<td>0.5 mA</td>
</tr>
<tr>
<td>Demagnetization when inductive loads are switched off</td>
<td>Must be performed externally according to driven load specification</td>
</tr>
<tr>
<td>Switching Frequencies</td>
<td></td>
</tr>
<tr>
<td>With inductive loads</td>
<td>On request</td>
</tr>
<tr>
<td>Short-circuit-proof / Overload-proof</td>
<td>No</td>
</tr>
<tr>
<td>Overload message</td>
<td>No</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>No</td>
</tr>
<tr>
<td>Resistance to feedback against 24 V DC</td>
<td>No</td>
</tr>
<tr>
<td>Connection of 2 outputs in parallel</td>
<td>Not possible</td>
</tr>
<tr>
<td>Max. cable length *)</td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Shielded</td>
<td>500 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>150 m</td>
</tr>
</tbody>
</table>

*) For PWM and PTO outputs, a shielded cable must be used.

### Technical data of the digital relay outputs

**Table 45: PM5012-R-ETH**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>4 normally-open relay outputs</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>2 groups for 2 channels</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per group</td>
</tr>
<tr>
<td>Connection of the channels NO0 to NO1</td>
<td>Terminals 8 to 9</td>
</tr>
<tr>
<td>Connection of the channels NO2 to NO3</td>
<td>Terminals 11 to 12</td>
</tr>
<tr>
<td>Reference potential R0..1 for the channels NO0 to NO1</td>
<td>Terminal 10</td>
</tr>
<tr>
<td>Reference potential R2..3 for the channels NO2 to NO3</td>
<td>Terminal 13</td>
</tr>
<tr>
<td>Relay output voltage</td>
<td></td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC or 100 V AC ... 240 V AC 50 Hz/60 Hz</td>
</tr>
<tr>
<td>Range</td>
<td>5 V DC ... 30 V DC or 5 V AC ... 250 V AC</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>1 yellow LED per channel; the LED is on when the output signal is high (signal 1)</td>
</tr>
<tr>
<td>Way of operation</td>
<td>Non-latching type</td>
</tr>
<tr>
<td>Output delay</td>
<td></td>
</tr>
<tr>
<td>0 to 1</td>
<td>Typ. 10 ms</td>
</tr>
<tr>
<td>1 to 0</td>
<td>Typ. 10 ms</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated current per channel (max.)</td>
<td>2.0 A (24 V DC resistance and general use, 100 V AC ... 240 V AC, resistance, general use and pilot duty)</td>
</tr>
<tr>
<td>Rated current per group (max.)</td>
<td>6 A</td>
</tr>
<tr>
<td>Rated current (all channels together, max.)</td>
<td>12 A</td>
</tr>
<tr>
<td>Demagnetization when inductive loads are switched off</td>
<td>External demagnetization measures must be implemented when switching inductive loads.</td>
</tr>
<tr>
<td>Spark suppression with inductive AC loads</td>
<td>Must be performed externally according to driven load specification</td>
</tr>
<tr>
<td>Switching frequencies</td>
<td></td>
</tr>
<tr>
<td>With resistive loads</td>
<td>Max. 1 Hz</td>
</tr>
<tr>
<td>With inductive loads</td>
<td>On request</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>With lamp loads</td>
<td>On request</td>
</tr>
<tr>
<td>Short-circuit-proof / Overload-proof</td>
<td>No, should be provided by an external fuse or circuit breaker</td>
</tr>
<tr>
<td>Rated protection fuse (for each channel)</td>
<td>5 A fast</td>
</tr>
<tr>
<td>Overload message</td>
<td>No</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>No</td>
</tr>
<tr>
<td>Resistance to feedback against 24 V DC</td>
<td>No</td>
</tr>
<tr>
<td>Connection of 2 outputs in parallel</td>
<td>Not possible</td>
</tr>
<tr>
<td>Lifetime of relay contacts (cycles)</td>
<td>100,000 at rated load</td>
</tr>
<tr>
<td>Max. cable length *)</td>
<td>Shielded 500 m</td>
</tr>
<tr>
<td></td>
<td>Unshielded 150 m</td>
</tr>
</tbody>
</table>

*) For PWM and PTO outputs, a shielded cable must be used.

### Table 46: PM5032-R-ETH and PM5052-R-ETH

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>6 normally-open relay outputs</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>2 groups for 3 channels</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per group</td>
</tr>
<tr>
<td>Connection of the channels NO0 to NO2</td>
<td>Terminals 14 to 16</td>
</tr>
<tr>
<td>Connection of the channels NO3 to NO5</td>
<td>Terminals 18 to 20</td>
</tr>
<tr>
<td>Reference potential R0..2 for the channels NO0 to NO2</td>
<td>Terminal 17</td>
</tr>
<tr>
<td>Reference potential R3..5 for the channels NO3 to NO5</td>
<td>Terminal 21</td>
</tr>
<tr>
<td>Relay output voltage</td>
<td></td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC or 100 V AC ... 240 V AC 50 Hz/60 Hz</td>
</tr>
<tr>
<td>Range</td>
<td>5 V DC ... 30 V DC or 5 V AC ... 250 V AC</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>1 yellow LED per channel; the LED is on when the output signal is high (signal 1) and the module is powered through the I/O bus</td>
</tr>
<tr>
<td>Way of operation</td>
<td>Non-latching type</td>
</tr>
<tr>
<td>Output delay</td>
<td>0 to 1 Typ. 10 ms</td>
</tr>
<tr>
<td></td>
<td>1 to 0 Typ. 10 ms</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated current per channel (max.)</td>
<td>2.0 A (24 V DC resistance and general use, 100 V AC ... 240 V AC, resistance, general use and pilot duty)</td>
</tr>
<tr>
<td>Rated current per group (max.)</td>
<td>6 A</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Rated current (all channels together, max.)</td>
<td>12 A</td>
</tr>
<tr>
<td>Demagnetization when inductive loads are switched off</td>
<td>External demagnetization measures must be implemented when switching inductive loads.</td>
</tr>
<tr>
<td>Spark suppression with inductive AC loads</td>
<td>Must be performed externally according to driven load specification</td>
</tr>
</tbody>
</table>

**Switching frequencies**

<table>
<thead>
<tr>
<th>Type</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>With resistive loads</td>
<td>Max. 1 Hz</td>
</tr>
<tr>
<td>With inductive loads</td>
<td>On request</td>
</tr>
<tr>
<td>With lamp loads</td>
<td>On request</td>
</tr>
</tbody>
</table>

| Short-circuit-proof / Overload-proof | No, should be provided by an external fuse or circuit breaker |

| Rated protection fuse (for each channel) | 5 A fast |
| Overload message | No |
| Output current limitation | No |
| Resistance to feedback against 24 V DC | No |
| Connection of 2 outputs in parallel | Not possible |
| Lifetime of relay contacts (cycles) | 100,000 at rated load |
| Max. cable length *) | |
| Shielded | 500 m |
| Unshielded | 150 m |

*) For PWM and PTO outputs, a shielded cable must be used.

**Technical data of the limit switch outputs**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>PM5012-T-ETH</th>
<th>PM5012-R-ETH</th>
<th>PM5032-T-ETH</th>
<th>PM5032-R-ETH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Useable outputs</td>
<td>4</td>
<td>-</td>
<td>8</td>
<td>2</td>
</tr>
<tr>
<td>Fast output (max. 5 kHz)</td>
<td>O0 … O3</td>
<td>-</td>
<td>O0 … O3</td>
<td>-</td>
</tr>
<tr>
<td>Fast output (max. 100 kHz)</td>
<td>-</td>
<td>-</td>
<td>O4 … O7</td>
<td>C12 … C13</td>
</tr>
</tbody>
</table>
### Technical data of the PTO outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>PM5012-T-ETH</th>
<th>PM5012-R-ETH</th>
<th>PM5032-T-ETH</th>
<th>PM5032-R-ETH</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PM5052-T-ETH</td>
<td>PM5072-T-2ETH(W)</td>
<td>PM5082-T-2ETH</td>
<td>PM5052-R-ETH</td>
</tr>
<tr>
<td>PTO</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Useable outputs</td>
<td>-</td>
<td>-</td>
<td>4</td>
<td>1 pair of output</td>
</tr>
<tr>
<td>Fast output, max. up to 200 kHz 2)</td>
<td>-</td>
<td>-</td>
<td>O4 … O7</td>
<td>C12 … C13</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>For 2 PTO 200 kHz 1) Pulse/Direction or CC/Ccw modes as pair of outputs</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>O4 … O7 as 4 PTO up to 200 kHz Pulse outputs / Direction using fast output 5kHz O0...O3 2)</td>
<td></td>
</tr>
</tbody>
</table>

1) If the load is less than 100 mA it is strongly recommended to connect an additional load resistor (240 Ω/5 W or 270 Ω/5 W) to the output to improve the pulse signal.

2) With the processor modules revision 1 (rubric R017x), the fast output provides then 200 kHz PTO Pulse output instead of 100 kHz. The processor modules revision 1 needs at least AB 2.6.0 and higher.

### Technical data of the PWM outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>PM5012-T-ETH</th>
<th>PM5012-R-ETH</th>
<th>PM5032-T-ETH</th>
<th>PM5032-R-ETH</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PM5052-T-ETH</td>
<td>PM5072-T-2ETH(W)</td>
<td>PM5082-T-2ETH</td>
<td>PM5052-R-ETH</td>
</tr>
<tr>
<td>PWM</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Useable outputs</td>
<td>4</td>
<td>-</td>
<td>8</td>
<td>2</td>
</tr>
<tr>
<td>Fast output, max. 5 kHz</td>
<td>O0 ... O3</td>
<td>-</td>
<td>O0 ... O3</td>
<td>-</td>
</tr>
<tr>
<td>Fast output, max. 100 kHz</td>
<td>-</td>
<td>-</td>
<td>O4 … O7</td>
<td>C12 … C13</td>
</tr>
</tbody>
</table>
5.2.1.3 Option boards

TA5101-4DI - Digital input option board

Features

- 4 digital inputs 24 V DC (I0 to I3) in 1 group
- Module-wise galvanically isolated
- W variant available for use in extended (wide) temperature range

1 4 yellow LEDs to display the signal states at the digital inputs I0 to I3
2 Allocation of signal name
3 5-pin terminal block for input signals

NOTICE!
Risk of damaging the PLC modules!
Overvoltages and short circuits might damage the PLC modules.
Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.

Intended purpose

The device is used as an optional I/O extension module for AC500-eCo V3 CPUs (PM50x2). The inputs/outputs are group-wise galvanically isolated from each other. All other circuitry of the module is galvanically isolated from the inputs/outputs.

Functionality

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED displays</td>
<td>For signal states</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via internal CPU connection</td>
</tr>
<tr>
<td>External power supply</td>
<td>Not necessary</td>
</tr>
</tbody>
</table>
Connections

For a detailed description of the mounting, disassembly and connection of the module, please refer to the system assembly chapter.

The connection is carried out by using a removable 5-pin terminal block. For more information, please refer to the chapter terminal blocks for AC500-eCo V3 system. The terminal blocks are included in the module’s scope of delivery and additional terminal blocks as spare parts can be ordered separately.

![Diagram of terminal block connections]

**Table 47: Assignment of the terminals:**

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>COM 0..3</td>
<td>Input common for signals I0 to I3</td>
</tr>
<tr>
<td>2</td>
<td>I0</td>
<td>Input signal I0</td>
</tr>
<tr>
<td>3</td>
<td>I1</td>
<td>Input signal I1</td>
</tr>
<tr>
<td>4</td>
<td>I2</td>
<td>Input signal I2</td>
</tr>
<tr>
<td>5</td>
<td>I3</td>
<td>Input signal I3</td>
</tr>
</tbody>
</table>

The internal power supply voltage for the module’s circuitry is carried out via the connection to CPU. Thus, the current consumption from 24 V DC power supply at the terminals L+ and M of the CPU module increases by 10 mA per TA5101-4DI.

An external power supply connection is not needed.

**WARNING!**

**Removal/Insertion under power**

The option boards are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug option boards with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you

– connect or disconnect any signal or terminal block
– remove, mount or replace an option board.

Disconnecting any powered option board while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.
NOTICE!
Risk of damaging the PLC modules!
Overvoltages and short circuits might damage the PLC modules.
Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.

The digital inputs can be used as source inputs or as sink inputs.

NOTICE!
Risk of malfunctions in the plant!
A ground fault, e. g. caused by a damaged cable insulation, can bridge switches accidentally.
Use sink inputs when possible or make sure that, in case of error, there will be no risks to persons or plant.

Table 48: Connection of the option board for digital I/O extension TA5101-4DI

<table>
<thead>
<tr>
<th>Sink inputs of TA5101-4DI</th>
<th>Source inputs of TA5101-4DI</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Connection Diagram" /></td>
<td><img src="image" alt="Connection Diagram" /></td>
</tr>
</tbody>
</table>

The module provides several diagnosis functions “Diagnosis” on page 221.
The meaning of the LEDs is described in the section ‘State LEDs’ “State LEDs” on page 221.

I/O configuration

The module itself does not store configuration data. It receives its parameterization data from the CPU module during power-up of the system.
Hence, replacing optional modules is possible without any re-parameterization via software.

Parameterization

The arrangement of the parameter data is performed with Automation Builder software.
1. In the device tree, double-click the desired option board.
2. Select the “TA51xx Parameters” tab to edit the parameterization of the desired option board.
1. In the device tree, double-click the desired option board.
2. Select the “Diagnosis” tab to view the diagnosis messages of the desired option board.

Table 49: Diagnosis messages

<table>
<thead>
<tr>
<th>Device</th>
<th>Severity</th>
<th>Error code</th>
<th>Description</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>TA5101-4DI</td>
<td>11</td>
<td>1</td>
<td>Wrong or no board plugged</td>
<td>Replace with correct functional board</td>
</tr>
<tr>
<td>TA5101-4DI</td>
<td>11</td>
<td>2</td>
<td>Board defective</td>
<td>Replace with correct functional board</td>
</tr>
<tr>
<td>TA5101-4DI</td>
<td>11</td>
<td>3</td>
<td>Failed to set direction</td>
<td>Replace with correct functional board</td>
</tr>
<tr>
<td>TA5101-4DI</td>
<td>11</td>
<td>4</td>
<td>Parameter wrong</td>
<td>Verify setting of parameter “Run on config fault”</td>
</tr>
</tbody>
</table>

State LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inputs I0...I3</td>
<td>Digital input</td>
<td>Yellow</td>
<td>Input is OFF</td>
<td>Input is ON</td>
</tr>
</tbody>
</table>

Technical data

The system data of AC500-eCo V3 apply \( \text{\textcopyright} \) Chapter 5.1.1 “System data AC500-eCo” on page 159

Only additional details are therefore documented below.
### Table 50: Technical data of the digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>4 inputs 24 V DC</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 (4 channels per group)</td>
</tr>
<tr>
<td>Connections of the channels I0 to I3</td>
<td>Terminals 2 to 5</td>
</tr>
<tr>
<td>Reference potential for the channels I0 to I3</td>
<td>Terminal 1 (plus or negative pole of the process supply voltage, signal name COM 0 ... 3)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel; the LED is ON when the input signal is high (signal 1). The module is powered through the CPU connection.</td>
</tr>
<tr>
<td>Monitoring point of input indicator</td>
<td>LED</td>
</tr>
<tr>
<td>Input type according to EN 61131-2</td>
<td>Type 1 source Type 1 sink</td>
</tr>
<tr>
<td>Input signal range</td>
<td>-24 V DC +24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-5 V ... +3 V -3 V ... +5 V</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>-15 V ... -5 V +5 V ... +15 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>-30 V ... -15 V +15 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage 24 V</td>
<td>Typ. 5 mA</td>
</tr>
<tr>
<td>Input voltage 5 V</td>
<td>Typ. 1 mA</td>
</tr>
<tr>
<td>Input voltage 14 V</td>
<td></td>
</tr>
<tr>
<td>Input voltage 15 V</td>
<td>&lt; 3 mA</td>
</tr>
<tr>
<td>Input voltage 27 V</td>
<td></td>
</tr>
<tr>
<td>Input voltage 30 V</td>
<td>&lt; 7 mA</td>
</tr>
<tr>
<td>Max. permissible leakage current (at 2-wire proximity switches)</td>
<td>1 mA</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 8 ms</td>
</tr>
<tr>
<td>Input data length</td>
<td>1 byte</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>500 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>300 m</td>
</tr>
</tbody>
</table>
Dimensions

![Diagram showing the dimensions of the product.](image)

*The dimensions are in mm and in brackets in inch.*

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase * )</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 187 000 R0001</td>
<td>TA5101-4DI: AC500-eCo V3, digital input option board, 4DI 24 V DC, spring/cable front terminal 3.50 mm pitch</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 187 000 R0201</td>
<td>TA5101-4DIW: AC500-eCo V3, digital input option board, 4DI 24 V DC, spring/cable front terminal 3.50 mm pitch, wide temperature range</td>
<td>Active</td>
</tr>
</tbody>
</table>

Spare parts

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase * )</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 187 400 R0012 **</td>
<td>TA5220-SPF5: spring terminal block, removable, 5-pin, spring front, cable front, 6 pieces per packing unit</td>
<td>Active</td>
</tr>
</tbody>
</table>
*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

***) The needed spring terminal block is always delivered with the option board. The terminal block listed in the table is for spare part only if needed.

TA5105-4DOT - Digital output option board

Features

- 4 digital outputs 24 V DC (O0 to O3) in 1 group
- Module-wise galvanically isolated
- W variant available for use in extended (wide) temperature range

1 4 yellow LEDs to display the signal states at the digital outputs O0 ... O3
2 Allocation of signal name
3 7-pin terminal block for output signals

NOTICE!
Risk of damaging the PLC modules!
Overvoltages and short circuits might damage the PLC modules.
Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.

Intended purpose

The device is used as an optional I/O extension module for AC500-eCo V3 CPUs (PM50x2). The inputs/outputs are group-wise galvanically isolated from each other.
All other circuitry of the module is galvanically isolated from the inputs/outputs.
**Functionality**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED displays</td>
<td>For signal states</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via internal CPU connection</td>
</tr>
<tr>
<td>External power supply</td>
<td>Via the terminals ZP and UP (process supply voltage 24 V DC)</td>
</tr>
</tbody>
</table>

**Connections**

*For a detailed description of the mounting, disassembly and connection of the module, please refer to the system assembly chapter.*

The connection is carried out by using a removable 7-pin terminal block. For more information, please refer to the chapter terminal blocks for AC500-eCo V3 system. The terminal blocks are included in the module's scope of delivery and additional terminal blocks as spare parts can be ordered separately.

![Internal construction of the digital outputs](image)

**Table 51: Assignment of the terminals:**

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td>2</td>
<td>O0</td>
<td>Output signal O0</td>
</tr>
<tr>
<td>3</td>
<td>O1</td>
<td>Output signal O1</td>
</tr>
<tr>
<td>4</td>
<td>O2</td>
<td>Output signal O2</td>
</tr>
<tr>
<td>5</td>
<td>O3</td>
<td>Output signal O3</td>
</tr>
<tr>
<td>6</td>
<td>UP</td>
<td>Process supply voltage UP +24 V DC</td>
</tr>
<tr>
<td>7</td>
<td>ZP</td>
<td>Process supply voltage ZP 0 V DC</td>
</tr>
</tbody>
</table>

The internal power supply voltage for the module's circuitry is carried out via the connection to CPU. Thus, the current consumption from 24 V DC power supply at the terminals L+ and M of the CPU module increases by 10 mA per TA5105-4DOT.

The external power supply connection is carried out via the UP (+24 V DC) and ZP (0 V DC) terminals.
WARNING!
Removal/Insertion under power
The option boards are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug option boards with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you
– connect or disconnect any signal or terminal block
– remove, mount or replace an option board.

Disconnecting any powered option board while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

NOTICE!
Risk of damaging the PLC modules!
Overvoltages and short circuits might damage the PLC modules.

Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.

Fig. 33: Connection of the option board for digital I/O extension TA5105-4DOT

NOTICE!
Risk of malfunctions in the plant!
Only if L+/M of the CPU is available and the outputs are already configured in the AB program, the outputs will switch on as soon as the UP/ZP is available.

This must be considered in the application planning.
NOTICE!
Risk of damaging the I/O module!
The outputs are not protected against short circuits and overload.
- Never short-circuit or overload the outputs.
- Never connect the outputs to other voltages.
- Use an external fuse for the outputs.

The module provides several diagnosis functions. Further information on page 227. The meaning of the LEDs is described in the section State LEDs “State LEDs” on page 228.

I/O configuration

The module itself does not store configuration data. It receives its parameterization data from the CPU module during power-up of the system.
Hence, replacing optional modules is possible without any re-parameterization via software.

Parameterization

The arrangement of the parameter data is performed with Automation Builder software.
1. In the device tree, double-click the desired option board.
2. Select the “TA51xx Parameters” tab to edit the parameterization of the desired option board.

Diagnosis
1. In the device tree, double-click the desired option board.
2. Select the “Diagnosis” tab to view the diagnosis messages of the desired option board.

<table>
<thead>
<tr>
<th>Device</th>
<th>Severity</th>
<th>Error code</th>
<th>Description</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>TA5105-4DOT</td>
<td>11</td>
<td>1</td>
<td>Wrong or no board plugged</td>
<td>Replace with correct functional board</td>
</tr>
<tr>
<td>TA5105-4DOT</td>
<td>11</td>
<td>2</td>
<td>Board defective</td>
<td>Replace with correct functional board</td>
</tr>
<tr>
<td>TA5105-4DOT</td>
<td>11</td>
<td>3</td>
<td>Failed to set direction</td>
<td>Replace with correct functional board</td>
</tr>
<tr>
<td>TA5105-4DOT</td>
<td>11</td>
<td>4</td>
<td>Parameter wrong</td>
<td>Verify setting of parameter “Run on config fault”</td>
</tr>
</tbody>
</table>

**State LEDs**

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outputs O0...O3</td>
<td>Digital output</td>
<td>Yellow</td>
<td>Output is OFF</td>
<td>Output is ON (The output voltage (normally 24 V DC) is only displayed if UP/ZP and L+/M (supply voltages for the module) are switched ON)</td>
</tr>
</tbody>
</table>

**Technical data**

The system data of AC500-eCo V3 apply to Chapter 5.1.1 “System data AC500-eCo” on page 159

Only additional details are therefore documented below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltage UP</td>
<td>Terminal 6 for UP (+24 V DC) and terminal 7 for ZP (0 V DC)</td>
</tr>
<tr>
<td>Connections</td>
<td></td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Current consumption via UP terminal</td>
<td>5 mA + max. 0.5 A per output</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5 %</td>
</tr>
<tr>
<td>Inrush current</td>
<td>0.0000002 A²s</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse for UP</td>
<td>On request</td>
</tr>
<tr>
<td>Current consumption from 24 V DC power supply at the L+/M terminals of the CPU</td>
<td>Ca. 10 mA</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, between the output group and the rest of the module</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Isolated groups</td>
<td>1 (4 channels per group)</td>
</tr>
<tr>
<td>Surge-voltage (max.)</td>
<td>35 V DC for 0.5 s</td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>0.5 W</td>
</tr>
<tr>
<td>Weight</td>
<td>16 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>

Table 53: Technical data of the digital outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>4 transistor outputs (24 V DC, 0.5 A max.)</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 (4 channels per group)</td>
</tr>
<tr>
<td>Connection of the channels O0 to O3</td>
<td>Terminals 2 to 5</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>Terminal 6 (positive pole of the process voltage, signal name UP)</td>
</tr>
<tr>
<td>Reference potential for the channels O0 to O3</td>
<td>Terminal 7 (negative pole of the process voltage, signal name ZP)</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>1 yellow LED per channel; the LED is on when the output signal is high (signal 1). Only internal logic is powered from CPU. Outputs are powered from UP/ZP terminals.</td>
</tr>
<tr>
<td>Way of operation</td>
<td>Non-latching type</td>
</tr>
<tr>
<td>Min. output voltage at signal 1</td>
<td>UP - 0.1 V</td>
</tr>
<tr>
<td>Output delay (max. at rated load)</td>
<td></td>
</tr>
<tr>
<td>0 to 1</td>
<td>50 µs</td>
</tr>
<tr>
<td>1 to 0</td>
<td>200 µs</td>
</tr>
<tr>
<td>Output data length</td>
<td>1 byte</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated current per channel (max.)</td>
<td>0.5 A at UP 24 V DC (resistance, general use and pilot duty)</td>
</tr>
<tr>
<td>Rated current per group (max.)</td>
<td>2 A (4 channels * 0.5 A)</td>
</tr>
<tr>
<td>Max. leakage current with signal 0</td>
<td>0.5 mA</td>
</tr>
<tr>
<td>Output type</td>
<td>Non-protected</td>
</tr>
<tr>
<td>Protection type</td>
<td>External fuse on each channel</td>
</tr>
<tr>
<td>Rated protection fuse (for each channel)</td>
<td>On request</td>
</tr>
<tr>
<td>Demagnetization when inductive loads are switched off</td>
<td>Must be performed externally according to driven load specification</td>
</tr>
<tr>
<td>Switching Frequencies</td>
<td></td>
</tr>
<tr>
<td>With resistive load</td>
<td>Limited by CPU cycle time</td>
</tr>
<tr>
<td>With inductive load</td>
<td>Max. 0.5 Hz</td>
</tr>
<tr>
<td>With lamp load</td>
<td>Max. 11 Hz at max. 5 W</td>
</tr>
<tr>
<td>Short-circuit-proof / Overload-proof</td>
<td>No</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>---------------------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Overload message</td>
<td>No</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>No</td>
</tr>
<tr>
<td>Resistance to feedback against 24 V DC</td>
<td>No</td>
</tr>
<tr>
<td>Connection of 2 outputs in parallel</td>
<td>Not possible</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>500 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>150 m</td>
</tr>
</tbody>
</table>

**Dimensions**

The dimensions are in mm and in brackets in inch.
Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 187 000 R0002</td>
<td>TA5105-4DOT: AC500-eCo V3, digital output option board, 4DO-T 24 V DC / 0.5 A, spring/cable front terminal 3.50 mm pitch</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 187 000 R0202</td>
<td>TA5105-4DOTW: AC500-eCo V3, digital output option board, 4DO-T 24 V DC / 0.5 A, spring/cable front terminal 3.50 mm pitch, wide temperature range</td>
<td>Active</td>
</tr>
</tbody>
</table>

Spare parts

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase **</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 187 400 R0014</td>
<td>TA5220-SPF7: spring terminal block, removable, 7-pin, spring front, cable front, 6 pieces per packing unit</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

**) The needed spring terminal block is always delivered with the option board. The terminal block listed in the table is for spare part only if needed.

TA5110-2DI2DOT - Digital I/O option board

Features

- 2 digital inputs 24 V DC (I0 to I1) in 1 group
- 2 digital transistor outputs 24 V DC (O0 to O1) in 1 group
- Group-wise galvanically isolated
- W variant available for use in extended (wide) temperature range
1 2 yellow LEDs to display the signal states at the digital outputs O0 to O1
2 2 yellow LEDs to display the signal states at the digital inputs I0 to I1
3 Allocation of signal name
4 7-pin terminal block for input/output signals

**NOTICE!**
Risk of damaging the PLC modules!
Overvoltages and short circuits might damage the PLC modules.
Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.

**Intended purpose**

The device is used as an optional I/O extension module for AC500-eCo V3 CPUs (PM50x2). The inputs/outputs are group-wise galvanically isolated from each other. All other circuitry of the module is galvanically isolated from the inputs/outputs.

**Functionality**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED displays</td>
<td>For signal states</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via internal CPU connection</td>
</tr>
<tr>
<td>External power supply</td>
<td>Via the terminals ZP and UP (process supply voltage 24 V DC)</td>
</tr>
</tbody>
</table>

**Connections**

*For a detailed description of the mounting, disassembly and connection of the module, please refer to the system assembly chapter.*
The connection is carried out by using a removable 7-pin terminal block. For more information, please refer to the chapter terminal blocks for AC500-eCo V3 system. The terminal blocks are included in the module’s scope of delivery and additional terminal blocks as spare parts can be ordered separately.

![Terminal Block Diagram]

**Fig. 34: Internal construction of the digital inputs and outputs**

**Table 54: Assignment of the terminals:**

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>COM 0 ... 1</td>
<td>Input common for signals I0 to I1</td>
</tr>
<tr>
<td>2</td>
<td>I0</td>
<td>Input signal I0</td>
</tr>
<tr>
<td>3</td>
<td>I1</td>
<td>Input signal I1</td>
</tr>
<tr>
<td>4</td>
<td>O0</td>
<td>Output signal O0</td>
</tr>
<tr>
<td>5</td>
<td>O1</td>
<td>Output signal O1</td>
</tr>
<tr>
<td>6</td>
<td>UP</td>
<td>Process supply voltage UP +24 V DC</td>
</tr>
<tr>
<td>7</td>
<td>ZP</td>
<td>Process supply voltage ZP 0 V DC</td>
</tr>
</tbody>
</table>

The internal power supply voltage for the module’s circuitry is carried out via the connection to CPU. Thus, the current consumption from 24 V DC power supply at the terminals L+ and M of the CPU module increases by 10 mA per TA5110-2DI2DOT.

The external power supply connection is carried out via the UP (+24 V DC) and ZP (0 V DC) terminals.

**WARNING!**

**Removal/Insertion under power**

The option boards are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug option boards with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you
- connect or disconnect any signal or terminal block
- remove, mount or replace an option board.

Disconnecting any powered option board while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.
NOTICE!
Risk of damaging the PLC modules!
Overvoltages and short circuits might damage the PLC modules.
Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.

The digital inputs can be used as source inputs or as sink inputs.

NOTICE!
Risk of malfunctions in the plant!
A ground fault, e.g. caused by a damaged cable insulation, can bridge switches accidentally.
Use sink inputs when possible or make sure that, in case of error, there will be no risks to persons or plant.

Table 55: Connection for inputs of the option board for digital I/O extension TA5110-2DI2DOT

![Table image]

Fig. 35: Connection for outputs of the option board for digital I/O extension TA5110-2DI2DOT

NOTICE!
Risk of malfunctions in the plant!
Only if L+/M of the CPU is available and the outputs are already configured in the AB program, the outputs will switch on as soon as the UP/ZP is available.
This must be considered in the application planning.
NOTICE!
Risk of damaging the I/O module!
The outputs are not protected against short circuits and overload.
– Never short-circuit or overload the outputs.
– Never connect the outputs to other voltages.
– Use an external fuse for the outputs.

The module provides several diagnosis functions Further information on page 236.
The meaning of the LEDs is described in the section State LEDs “State LEDs” on page 236.

I/O configurations
The module itself does not store configuration data. It receives its parameterization data from the CPU module during power-up of the system.
Hence, replacing optional modules is possible without any re-parameterization via software.

If the external power supply voltage via UP/ZP terminals fails, the I/O module loses its configuration data. The whole station has to be switched off and on again to re-configure the module.

Parameterization
The arrangement of the parameter data is performed with Automation Builder software.
1. In the device tree, double-click the desired option board.
2. Select the “TA51xx Parameters” tab to edit the parameterization of the desired option board.
Diagnosis

1. In the device tree, double-click the desired option board.
2. Select the “Diagnosis” tab to view the diagnosis messages of the desired option board.

### Table 56: Diagnosis messages

<table>
<thead>
<tr>
<th>Device</th>
<th>Severity</th>
<th>Error code</th>
<th>Description</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>TA5110-2DI2DOT</td>
<td>11</td>
<td>1</td>
<td>Wrong or no board plugged</td>
<td>Replace with correct functional board</td>
</tr>
<tr>
<td>TA5110-2DI2DOT</td>
<td>11</td>
<td>2</td>
<td>Board defective</td>
<td>Replace with correct functional board</td>
</tr>
<tr>
<td>TA5110-2DI2DOT</td>
<td>11</td>
<td>3</td>
<td>Failed to set direction</td>
<td>Replace with correct functional board</td>
</tr>
<tr>
<td>TA5110-2DI2DOT</td>
<td>11</td>
<td>4</td>
<td>Parameter wrong</td>
<td>Verify setting of parameter &quot;Run on config fault&quot;</td>
</tr>
</tbody>
</table>

### State LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inputs I0...I1</td>
<td>Digital input</td>
<td>Yellow</td>
<td>Input is OFF</td>
<td>Input is ON</td>
</tr>
<tr>
<td>Outputs O0...O1</td>
<td>Digital output</td>
<td>Yellow</td>
<td>Output is OFF</td>
<td>Output is ON</td>
</tr>
</tbody>
</table>

### Technical data

The system data of AC500-eCo V3 apply Chapter 5.1.1 “System data AC500-eCo” on page 159.

Only additional details are therefore documented below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltage UP</td>
<td>Terminal 6 for UP (+24 V DC) and terminal 7 for ZP (0 V DC)</td>
</tr>
<tr>
<td>Connections</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Rated value</td>
<td>5 mA + max. 0.5 A per output</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5 %</td>
</tr>
</tbody>
</table>
Parameter | Value
---|---
Inrush current | 0.000002 A’s
Protection against reversed voltage | Yes
Rated protection fuse for UP | On request
Current consumption from 24 V DC power supply at the L+/M terminals of the CPU | Ca. 10 mA
Galvanic isolation | Yes, between the input group and the output group and the rest of the module
Isolated groups | 2 groups (1 group for 2 input channels, 1 group for 2 output channels)
Surge-voltage (max.) | 35 V DC for 0.5 s
Max. power dissipation within the module | 0.7 W
Weight | 15 g
Mounting position | Horizontal or vertical
Cooling | The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.

Table 57: Technical data of the digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>2</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group for 2 channels</td>
</tr>
<tr>
<td>Connections of the channels I0 to I1</td>
<td>Terminals 2 to 3</td>
</tr>
<tr>
<td>Reference potential for the channels I0 to I1</td>
<td>Terminal 1</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel; the LED is ON when the input signal is high (signal 1)</td>
</tr>
<tr>
<td>Monitoring point of input indicator</td>
<td>LED</td>
</tr>
<tr>
<td>It is not part of input circuit (its controlled by processor side, not process side)</td>
<td></td>
</tr>
<tr>
<td>Input type according to EN 61131-2</td>
<td>Type 1 source, Type 1 sink</td>
</tr>
<tr>
<td>Input signal range</td>
<td>-24 V DC, +24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-5 V ... +3 V, -3 V ... +5 V</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>-15 V ... +5 V, +5 V ... +15 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>-30 V ... -15 V, +15 V ... +30 V</td>
</tr>
<tr>
<td>Ripple with signal 0</td>
<td>-5 V ... +3 V, -3 V ... +5 V</td>
</tr>
<tr>
<td>Ripple with signal 1</td>
<td>-30 V ... -15 V, +15 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 5 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>Typ. 1 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>&lt; 3 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 7 mA</td>
</tr>
<tr>
<td>Max. permissible leakage current (at 2-wire proximity switches)</td>
<td>1 mA</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 8 ms</td>
</tr>
<tr>
<td>Input data length</td>
<td>1 byte</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>500 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>150 m</td>
</tr>
</tbody>
</table>

Table 58: Technical data of the digital outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>2 transistor outputs (24 V DC, 0.5 A max.)</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 2 channels</td>
</tr>
<tr>
<td>Connection of the channels O0 to O1</td>
<td>Terminals 4 to 5</td>
</tr>
<tr>
<td>Reference potential for the channels O0 to O17</td>
<td>Terminal 7 (negative pole of the process voltage, name ZP)</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>Terminal 6 (positive pole of the process voltage, name UP)</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>1 yellow LED per channel; the LED is on when the output signal is high (signal 1) and the module is powered via the I/O bus</td>
</tr>
<tr>
<td>Monitoring point of output indicator</td>
<td>Controlled together with transistor</td>
</tr>
<tr>
<td>Way of operation</td>
<td>Non-latching type</td>
</tr>
<tr>
<td>Min. output voltage at signal 1</td>
<td>UP - 0.1 V</td>
</tr>
<tr>
<td>Output delay</td>
<td></td>
</tr>
<tr>
<td>0 to 1</td>
<td>50 µs</td>
</tr>
<tr>
<td>1 to 0</td>
<td>200 µs</td>
</tr>
<tr>
<td>Output data length</td>
<td>1 byte</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated current per channel (max.)</td>
<td>0.5 A at UP 24 V DC (resistance, general use and pilot duty)</td>
</tr>
<tr>
<td>Rated current per group (max.)</td>
<td>1 A</td>
</tr>
<tr>
<td>Rated current (all channels together, max.)</td>
<td>1 A</td>
</tr>
<tr>
<td>Max. leakage current with signal 0</td>
<td>0.5 mA</td>
</tr>
<tr>
<td>Output type</td>
<td>Non-protected</td>
</tr>
<tr>
<td>Protection type</td>
<td>External fuse on each channel</td>
</tr>
<tr>
<td>Rated protection fuse (for each channel)</td>
<td>On request</td>
</tr>
<tr>
<td>Demagnetization when inductive loads are switched off</td>
<td>Must be performed externally according to driven load specification</td>
</tr>
<tr>
<td>Switching Frequencies</td>
<td></td>
</tr>
<tr>
<td>With resistive load</td>
<td>Limited by CPU cycle time</td>
</tr>
<tr>
<td>With inductive load</td>
<td>Max. 0.5 Hz</td>
</tr>
<tr>
<td>With lamp load</td>
<td>Max. 11 Hz at max. 5 W</td>
</tr>
<tr>
<td>Short-circuit-proof / Overload-proof</td>
<td>No</td>
</tr>
<tr>
<td>Overload message</td>
<td>No</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>No</td>
</tr>
<tr>
<td>Resistance to feedback against 24 V DC</td>
<td>No</td>
</tr>
<tr>
<td>Connection of 2 outputs in parallel</td>
<td>Not possible</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>500 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>150 m</td>
</tr>
</tbody>
</table>

Dimensions

The dimensions are in mm and in brackets in inch.
## Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 187 000 R0003</td>
<td>TA5110-2DI2DOT: AC500-eCo V3, digital I/O option board, 2DI 24 V DC, 2DO-T 24 V DC / 0.5 A, spring/cable front terminal 3.50 mm pitch</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 187 000 R0203</td>
<td>TA5110-2DI2DOW: AC500-eCo V3, digital I/O option board, 2DI 24 V DC, 2DO-T 24 V DC / 0.5 A, spring/cable front terminal 3.50 mm pitch, wide temperature range</td>
<td>Active</td>
</tr>
</tbody>
</table>

### Spare parts

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 187 400 R0014 **)</td>
<td>TA5220-SPF7: spring terminal block, removable, 7-pin, spring front, cable front, 6 pieces per packing unit</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

**) The needed spring terminal block is always delivered with the option board. The terminal block listed in the table is for spare part only if needed.

### TA5120-2AI-UI - Analog input option board

#### Features

- 2 configurable analog inputs (I0 and I1) in 1 group
  - Resolution 12 bits including sign
- Option board is galvanically isolated
- W variant available for use in extended (wide) temperature range
## Intended purpose

The option board is used as analog input extension module for AC500-eCo V3 CPUs (PM50xx).

> The analog option boards TA5120-2AI-UI and TA5126-2AO-UI can only be used from AB 2.5.2, SystemFW 3.5.0_HF-7, BootFW 3.5.1 and higher.

> Using the option boards with lower versions will create a configuration error and the CPU will not start.

## Functionality

2 analog inputs, individually configurable for
- Unused (default setting)
- 0 V ... 10 V
- 0 mA ... 20 mA
- 4 mA ... 20 mA

### Parameter | Value
--- | ---
Resolution of the analog channels | 12 bits
Voltage 0 V ... 10 V | 12 bits
Current 0 mA ... 20 mA | 12 bits
Current 4 mA ... 20 mA | 12 bits
LED displays | 2 LEDs for signals I0 and I1
Internal power supply | Via the CPU PM50xx
External power supply | Via the terminals UP and ZP (process voltage 24 V DC)
Required CPU | PM50xx
Connection

**WARNING!**
Removal/Insertion under power
The option boards are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug option boards with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you
– connect or disconnect any signal or terminal block
– remove, mount or replace an option board.

Disconnecting any powered option board while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The option board TA5120-2AI-UI for analog input extension is plugged into an AC500-eCo V3 processor module PM50xx.

*i Chapter 4.3.11.1 “Mounting and demounting the option boards” on page 127*

The electrical connection is made via a removable 6-pin terminal block.

*The terminal block is included in the scope of delivery of the option board. Further terminal blocks can be ordered separately as spare parts.*

*i Chapter 5.2.8.1.2 “TA52xx(-x) - Terminal block sets” on page 1292*

**Table 59: Assignment of the terminals:**

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>I0+</td>
<td>Positive analog input I0</td>
</tr>
<tr>
<td>2</td>
<td>I0-</td>
<td>Negative analog input I0</td>
</tr>
<tr>
<td>3</td>
<td>I1+</td>
<td>Positive analog input I1</td>
</tr>
<tr>
<td>4</td>
<td>I1-</td>
<td>Negative analog input I1</td>
</tr>
<tr>
<td>5</td>
<td>UP</td>
<td>Process voltage UP = +24 V DC</td>
</tr>
<tr>
<td>6</td>
<td>ZP</td>
<td>Process voltage ZP = 0 V DC</td>
</tr>
</tbody>
</table>

**CAUTION!**
The negative terminal of the analog inputs (voltage 0 V...10 V) are connected internally and form an internal analog ground (AGND). This analog ground is connected to ZP via a PTC resistor. There is no galvanic isolation between the analog circuitry and ZP/UP. Hence, analog inputs can not be connected in series.

The internal power supply of the circuits of the module takes place via the connection to the CPU. Thus, the current consumption from 24 V DC power supply at the terminals L+ and M of the CPU module increases by << 1 mA per TA5120-2AI-UI.

The external power supply is connected via the terminals UP (+24 V DC) and ZP (0 V DC).
NOTICE!
Risk of damaging the PLC modules!
Overvoltages and short circuits might damage the PLC modules.

Generally, analog signals must be laid in shielded cables. The cable shields must be grounded at both sides of the cables. In order to avoid unacceptable potential differences between different parts of the installation, low resistance equipotential bonding conductors must be laid.

The following figure shows the connection of the module:

![Fig. 36: Internal construction of the analog inputs](image)

CAUTION!
By installing equipotential bonding conductors between the different parts of the system, it must be ensured that the potential difference between ZP and AGND never can exceed 1 V.

CAUTION!
The process supply voltage must be included in the grounding concept (e.g. grounding of the negative terminal).

The option board provides several diagnosis functions.

*Chapter 5.2.1.3.4.8 “Diagnosis” on page 248*
By connecting the sensor's negative terminal of the output voltage to AGND, the galvanically isolated voltage source of the sensor is referred to ZP.

Table 60: Configurable measuring ranges for TA5120-2AI-UI

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel configuration</td>
<td>0 V...+10 V</td>
</tr>
</tbody>
</table>

In order to avoid error messages or long processing times, it is useful to configure unused analog input channels as "not used".
In order to avoid error messages or long processing times, it is useful to configure unused analog input channels as "not used".

### Parameter Value

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel configuration</td>
<td>0 mA...+20 mA</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>+4 mA...+20 mA</td>
</tr>
</tbody>
</table>

Connection of active-type analog sensors (Current) with galvanically isolated power supply

Connection of active-type analog sensors (Voltage) with no galvanically isolated power supply
### CAUTION!

The potential difference between AGND and ZP at the module must not be greater than 1V, not even in case of long lines.

If AGND does not get connected to ZP, the sensor supply current flows to ZP via the AGND line. This current will distort the measuring signal, as a very small current flows through the AGND line. ZP connection should be close to the sensor. The total current through the PTC should not exceed 50 mA. This measuring method is therefore only suitable for short lines and small compensation currents via the AGND line.

### Connection of passive-type analog sensors (current)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel configuration</td>
<td>0 V...+10 V</td>
</tr>
</tbody>
</table>

In order to avoid error messages or long processing times, it is useful to configure unused analog input channels as "not used".

### Parameter Value

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel configuration</td>
<td>0 mA...+20 mA</td>
</tr>
<tr>
<td>or</td>
<td>+4 mA...+20 mA</td>
</tr>
</tbody>
</table>

In order to avoid error messages or long processing times, it is useful to configure unused analog input channels as "not used".
CAUTION!

If, during initialization, an analog current sensor supplies more than 25 mA for more than 1 second to an analog input, this input is switched off by the module (input protection). In such cases, it is recommended to protect the analog input by a 10-Volt Zener diode (in parallel to I+ and I-). But, in general, sensors with fast initialization or without current peaks higher than 25 mA are preferrable.

I/O configuration

The option board itself does not store configuration data. It receives its parameterization from the CPU module during power-up of the system.

Hence, replacing option boards is possible without any re-parameterization via software.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configurability</td>
<td>0 V...10 V</td>
</tr>
<tr>
<td></td>
<td>0 mA...20 mA</td>
</tr>
<tr>
<td></td>
<td>4 mA...20 mA (each input can be configured individually)</td>
</tr>
<tr>
<td>Unused voltage inputs</td>
<td>Must be configured as &quot;not used&quot;</td>
</tr>
<tr>
<td>Unused current inputs</td>
<td>Must be configured as &quot;not used&quot;</td>
</tr>
</tbody>
</table>

Firmware update via memory card

The following steps describe the procedure for updating the firmware for the analog option boards using a memory card. Prerequisite is the previous download of the current firmware to the memory card either from the Automation Builder or as online download from ABB.

Direct from ABB Software.

Click this link and on the next web page find the relevant firmware package and download it.

- Unpack this .zip archive file at any location of your hard disc
- Insert empty formatted (FAT16 / FAT32) memory card in the PC card reader
- Execute the unpacked *.exe file
- Select PC card reader as the final destination and confirm.

All directories, files and SDCARD.INI file will be automatically created on memory card and properly configured. After the process is complete, one has the prepared memory card with relevant updates.

Firmware update

☑️ Precondition: Prepared memory card with boot project and firmware "Preparation of memory card" on page 1427.

1. Switch off the device.
2. Insert the memory card.
3. Switch on the device.
   - The alternate flashing of the RUN and the ERR LED indicates the running update process.
   
   At the end of the update process a reboot is executed and the system firmware is started for the finishing of the update process.
   
   If RUN LED blinks (ERR LED is off), the update was successful and the display shows done.
   
   If ERR LED blinks (RUN LED is off), the update failed and the display shows FAIL.
   
   The text file “SDCARD.RDY” includes the results of the different updates. If the update fails, the file contains the reasons for the abort. Based on this, further steps can be taken to fix the problem.

4. Switch off the device.
5. Remove the memory card.
6. Switch on the device.
   - The system starts with the new firmware.

Parameterization

The arrangement of the parameter data is performed with Automation Builder software.

1. In the device tree, double-click the desired option board.
2. Select the “TA5120-2AI-UI Parameters” tab to edit the parameterization of the desired option board.

Diagnosis

1. In the device tree, double-click the desired option board.
2. Select the “Diagnosis” tab to view the diagnosis messages of the desired option board.
<table>
<thead>
<tr>
<th>Severity</th>
<th>Error</th>
<th>Description</th>
<th>Remedy</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>3</td>
<td>Timeout</td>
<td>Communication timeout to CPU</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>If the process voltage is connected properly, replace the option board.</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>51</td>
<td>Invalid slot</td>
<td>Wrong or missing option board in the appropriate slot</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Check the configuration and the hardware setup.</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>11</td>
<td>Process voltage is too low</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Check the process voltage.</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>34</td>
<td>Data not ready</td>
<td>Data synchronization warning</td>
<td>1)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Check PLC program and synchronize.</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>40</td>
<td>SW-mismatch</td>
<td>Hardware does not match the firmware version</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Replace the option board.</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>53</td>
<td>Download failed</td>
<td></td>
<td>2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Power loss during firmware update</td>
<td>Replace the option board.</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>9</td>
<td>DIAG_BUF_OVERFLOW</td>
<td>Overflow in Diagnosis buffer</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Diagnosis overflow usually means too many repeated warnings or errors.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Please check all diagnosis in detail and take the appropriate action.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>A restart will clear the diagnosis.</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>43</td>
<td>DIAG_INTERNAL_ERR</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Internal error in the option board</td>
<td>Replace the option board.</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>26</td>
<td>DIAG_CFG_PRM_ERR</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Parameterization error</td>
<td>Check the CPU parameterization.</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>19</td>
<td>DIAG_CRC_ERR</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Checksum error in option board</td>
<td>Replace the option board.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Channel warning</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>Highest level</td>
<td>Voltage measurement overflow</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Check the input value.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>Lowest level</td>
<td>Measurement underflow, or broken wire in current range 4 mA…20 mA</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Check the input value and the wiring.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>48</td>
<td>Overload wire break</td>
<td>Broken wire in voltage mode, overflow in current mode</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Check the input value and the wiring.</td>
<td></td>
</tr>
</tbody>
</table>

Remarks:

1) If no other error occurs, the programs are not identical and the parameter is set to report an error in this case.

2) Do not remove the power supply from the option board during the firmware update.
State LEDs

<table>
<thead>
<tr>
<th>Inputs</th>
<th>Analog input</th>
<th>Yellow</th>
<th>LED OFF</th>
<th>LED ON</th>
<th>LED flashes</th>
</tr>
</thead>
<tbody>
<tr>
<td>I0 ... I1</td>
<td></td>
<td></td>
<td>Input is OFF or input value is too low</td>
<td>Input is ON (brightness depends on the value of the analog signal)</td>
<td>--</td>
</tr>
</tbody>
</table>

Measuring ranges

The represented resolution corresponds to 12 bits.

**Table 61: Measuring range: 0 V ... 10 V**

<table>
<thead>
<tr>
<th>Range</th>
<th>Input [V]</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Decimal</td>
</tr>
<tr>
<td>Wire break</td>
<td>&gt; 13.1784</td>
<td>32767</td>
</tr>
<tr>
<td>Overflow</td>
<td>&gt; 11.7564</td>
<td>32767</td>
</tr>
<tr>
<td>Input voltage too high</td>
<td>11.7564</td>
<td>32504</td>
</tr>
<tr>
<td></td>
<td>10.0029</td>
<td>27656</td>
</tr>
<tr>
<td>Normal range</td>
<td>10.0000</td>
<td>27648</td>
</tr>
<tr>
<td></td>
<td>0.0029</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>0.0000</td>
<td>0</td>
</tr>
<tr>
<td>Input voltage too low</td>
<td>-0.0029</td>
<td>-8</td>
</tr>
<tr>
<td></td>
<td>-1.7593</td>
<td>-4864</td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt; -1.7593</td>
<td>-32768</td>
</tr>
</tbody>
</table>

**Table 62: Measuring range: 0 mA ... 20 mA**

<table>
<thead>
<tr>
<th>Range</th>
<th>Input [mA]</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Decimal</td>
</tr>
<tr>
<td>Overflow</td>
<td>&gt; 23.5127</td>
<td>32767</td>
</tr>
<tr>
<td>Input current too high</td>
<td>23.5127</td>
<td>32504</td>
</tr>
<tr>
<td></td>
<td>20.0058</td>
<td>27656</td>
</tr>
<tr>
<td>Normal range</td>
<td>20.0000</td>
<td>27648</td>
</tr>
<tr>
<td></td>
<td>0.0058</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>0.0000</td>
<td>0</td>
</tr>
</tbody>
</table>
### Range Input [mA] Digital value

<table>
<thead>
<tr>
<th>Range</th>
<th>Input [mA]</th>
<th>Decimal</th>
<th>Hex.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input current too low</td>
<td>-0.0058</td>
<td>-8</td>
<td>FFF8</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>-3.5185</td>
<td>-4864</td>
<td>ED00</td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt; -3.5185</td>
<td>-32768</td>
<td>8000</td>
</tr>
<tr>
<td>Negative overrange</td>
<td>&lt; -23.5185</td>
<td>-32768</td>
<td>8000</td>
</tr>
</tbody>
</table>

**Table 63: Measuring range: 4 mA ... 20 mA**

<table>
<thead>
<tr>
<th>Range</th>
<th>Input [mA]</th>
<th>Decimal</th>
<th>Hex.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overflow</td>
<td>&gt; 22.8102</td>
<td>32767</td>
<td>7FFF</td>
</tr>
<tr>
<td>Input current too high</td>
<td>22.8102</td>
<td>32504</td>
<td>7EF8</td>
</tr>
<tr>
<td></td>
<td>20.0046</td>
<td>27656</td>
<td>6C08</td>
</tr>
<tr>
<td>Normal range</td>
<td>20.0000</td>
<td>27648</td>
<td>6C00</td>
</tr>
<tr>
<td></td>
<td>4.0046</td>
<td>8</td>
<td>0008</td>
</tr>
<tr>
<td></td>
<td>4.0000</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Input current too low</td>
<td>3.9954</td>
<td>-8</td>
<td>FFF8</td>
</tr>
<tr>
<td></td>
<td>1.1898</td>
<td>-4856</td>
<td>ED08</td>
</tr>
<tr>
<td></td>
<td>1.1852</td>
<td>-4864</td>
<td>ED00</td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt; 1.1852</td>
<td>-32768</td>
<td>8000</td>
</tr>
<tr>
<td>Negative overrange</td>
<td>&lt; -14.8148</td>
<td>-32768</td>
<td>8000</td>
</tr>
</tbody>
</table>

**Technical data**

The system data of AC500-eCo V3 apply to Chapter 5.1.1 “System data AC500-eCo” on page 159.

Only additional details are therefore documented below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process voltage</td>
<td></td>
</tr>
<tr>
<td>Connections</td>
<td>Terminal 5 for +24 V (UP) as well as terminal 6 for 0 V (ZP)</td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse on UP</td>
<td>1 A slow</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per module (no isolation between channels)</td>
</tr>
<tr>
<td>Current consumption</td>
<td></td>
</tr>
</tbody>
</table>
### Technical data of the analog inputs

**NOTICE!**  
All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>2</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group of 2 channels</td>
</tr>
<tr>
<td>Connections of the channel 0</td>
<td></td>
</tr>
<tr>
<td>Voltage mode</td>
<td></td>
</tr>
<tr>
<td>Terminal I0+ and I0-</td>
<td>Terminals 1 and 2</td>
</tr>
<tr>
<td>Current mode</td>
<td></td>
</tr>
<tr>
<td>Terminal I0+ and ZP</td>
<td>Terminal 1 and 6</td>
</tr>
<tr>
<td>Connections of the channel 1</td>
<td></td>
</tr>
<tr>
<td>Voltage mode</td>
<td></td>
</tr>
<tr>
<td>Terminal I1+ and I1-</td>
<td>Terminals 3 and 4</td>
</tr>
<tr>
<td>Current mode</td>
<td></td>
</tr>
<tr>
<td>Terminal I1+ and ZP</td>
<td>Terminals 3 and 6</td>
</tr>
<tr>
<td>Input type</td>
<td>Unipolar</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per option board (no isolation between channels)</td>
</tr>
</tbody>
</table>
| Configurability | 0 V...10 V  
0 mA...20 mA  
4 mA...20 mA  
(each input can be configured individually) |
| Channel input resistance | Voltage: > 100 kΩ  
Current: ca. 330 Ω  
Not used: > 100 kΩ |
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time constant of the input filter</td>
<td>Voltage: 10 µs</td>
</tr>
<tr>
<td></td>
<td>Current: 10 µs</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 LED per channel</td>
</tr>
<tr>
<td>Conversion cycle *)</td>
<td></td>
</tr>
<tr>
<td>1 activated channel</td>
<td>1 ms</td>
</tr>
<tr>
<td>2 activated channel</td>
<td>2 ms</td>
</tr>
<tr>
<td>Resolution for all configurations</td>
<td>12 bits</td>
</tr>
<tr>
<td>Conversion error of the analog values caused</td>
<td>Max. ±0.3 % at +25 °C</td>
</tr>
<tr>
<td>by non-linearity, adjustment error at factory</td>
<td>Max. ±0.5 % over full temperature range</td>
</tr>
<tr>
<td>and resolution within the normal range</td>
<td></td>
</tr>
<tr>
<td>Temperature coefficient</td>
<td>±0.005 %/K</td>
</tr>
<tr>
<td>(is related to the max error at +25°C and max</td>
<td></td>
</tr>
<tr>
<td>error in the full range)</td>
<td></td>
</tr>
<tr>
<td>Temporary deviation during EMC disturbance</td>
<td>Max. ±1 %</td>
</tr>
<tr>
<td>Mapping between input signal and digital</td>
<td>Input ranges of voltage and current</td>
</tr>
<tr>
<td>value</td>
<td></td>
</tr>
<tr>
<td>Unused voltage inputs</td>
<td>Must be configured as &quot;not used&quot;</td>
</tr>
<tr>
<td>Unused current inputs</td>
<td>Must be configured as &quot;not used&quot;</td>
</tr>
<tr>
<td>Overvoltage protection</td>
<td>Yes</td>
</tr>
</tbody>
</table>

*) The value is the sampling time on the option board. The complete conversion cycle time is also related to the CPU cycle time.
Dimensions

The dimensions are in mm and in brackets in inch.

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 187 100 R0001</td>
<td>TA5120-2AI-UI: AC500-eCo V3, analog input option board, 2AI U/I, 12 bits, spring/cable front terminal 3.50 mm pitch</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 187 100 R0201</td>
<td>TA5120-2AI-UIW: AC500-eCo V3, analog input option board, 2AI U/I, 12 bits, spring/cable front terminal 3.50 mm pitch, wide temperature range</td>
<td>Active</td>
</tr>
<tr>
<td>Spare parts</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1SAP 187 400 R0013 **)</td>
<td>TA5220-SPF6: spring terminal block, removable, 6-pin, spring front, cable front, 6 pieces per packing unit</td>
<td>Active</td>
</tr>
</tbody>
</table>
*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

**) The needed spring terminal block is always delivered with the option board. The terminal block listed in the table is for spare part only if needed.

** TA5123-2AI-RTD - Analog input option board**

**Features**

- 2 configurable analog inputs (I0 and I1) in 1 group
  - Resolution 16 bits including sign
- Option board is galvanically isolated
- W variant available for use in extended (wide) temperature range

**Intended purpose**

The option board is used as analog input extension module for AC500-eCo V3 CPUs (PM50xx).

*The analog option board TA5123-2AI-RTD can only be used from AB 2.6.0, SystemFW 3.6.0, BootFW 3.6 and higher. Using the option board with lower versions will create a configuration error and the CPU will not start.*
In the first 5 seconds after power on, the analog option board TA5123-2AI-RTD is in self-calibration mode, so the measured values may not be accurate.

**Functionality**

2 analog inputs, individually configurable for
- Unused (default setting)
- Pt100, -50 °C...+400 °C (2-wire)
- Pt100, -50 °C...+400 °C (3-wire)
- Pt100, -50 °C...+130 °C (2-wire)
- Pt100, -50 °C...+130 °C (3-wire)
- Pt1000, -50 °C...+400 °C (2-wire)
- Pt1000, -50 °C...+400 °C (3-wire)
- Ni1000, -50 °C...+150 °C (2-wire)
- Ni1000, -50 °C...+150 °C (3-wire)
- NTC (2-wire)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution of the analog channels</td>
<td></td>
</tr>
<tr>
<td>Temperature</td>
<td>0.1 °C</td>
</tr>
<tr>
<td>LED displays</td>
<td>2 LEDs for signals I0 and I1</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via the CPU PM50xx</td>
</tr>
<tr>
<td>External power supply</td>
<td>Via the terminals UP and ZP (process voltage 24 V DC)</td>
</tr>
<tr>
<td>Required CPU</td>
<td>PM50xx</td>
</tr>
</tbody>
</table>

**Connections**

**WARNING!**

**Removal/Insertion under power**

The option boards are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug option boards with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you
- connect or disconnect any signal or terminal block
- remove, mount or replace an option board.

Disconnecting any powered option board while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The option board TA5123-2AI-RTD for analog input extension is plugged into an AC500-eCo V3 CPU PM50x2.
Insert the module and press it until it locks into place.

A detailed description of the assembly and disassembly of the module can be found in the chapter Mounting and demounting option boards.

Chapter 4.3.11.1 “Mounting and demounting the option boards” on page 127

The electrical connection is made via a removable 8-pin terminal block. For more information, please refer to the chapter TA52xx(-x) - Terminal block sets.

The terminal block is included in the scope of delivery of the option board. Further terminal blocks can be ordered separately as spare parts.

Table 64: Assignment of the terminals:

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>I0A</td>
<td>Connection for 3-wire measurement of the analog input I0</td>
</tr>
<tr>
<td>2</td>
<td>I0+</td>
<td>Positive analog input I0</td>
</tr>
<tr>
<td>3</td>
<td>I0-</td>
<td>Negative analog input I0</td>
</tr>
<tr>
<td>4</td>
<td>I1A</td>
<td>Connection for 3-wire measurement of the analog input I1</td>
</tr>
<tr>
<td>5</td>
<td>I1+</td>
<td>Positive analog input I1</td>
</tr>
<tr>
<td>6</td>
<td>I1-</td>
<td>Negative analog input I1</td>
</tr>
<tr>
<td>7</td>
<td>UP</td>
<td>Process voltage UP = +24 VDC</td>
</tr>
<tr>
<td>8</td>
<td>ZP</td>
<td>Process voltage ZP = 0 V</td>
</tr>
</tbody>
</table>

CAUTION!
The negative terminal of the analog inputs are connected internally and form an internal analog ground (AGND). This analog ground is connected to ZP via a PTC resistor. There is no galvanic isolation between the analog circuitry and ZP/UP. Hence, analog inputs can not be connected in series.

The internal power supply of the circuits of the module takes place via the connection to the CPU. Thus, the current consumption from 24 VDC power supply at the terminals L+ and M of the CPU module increases by << 1 mA per TA5123-2AI-RTD.

The external power supply is connected via the UP (+24 VDC) and the ZP (0 VDC) terminals.

NOTICE!
Risk of damaging the PLC modules!
Overvoltages and short circuits might damage the PLC modules.

Generally, analog signals must be laid in shielded cables. The cable shields must be grounded at both sides of the cables. In order to avoid unacceptable potential differences between different parts of the installation, low resistance equipotential bonding conductors must be laid.
The following block diagram shows the internal construction of the analog inputs:

![Block Diagram](image_url)

**CAUTION!**
By installing equipotential bonding conductors between the different parts of the system, it must be ensured that the potential difference between ZP and AGND never can exceed 1 V.

**CAUTION!**
The process supply voltage must be included in the grounding concept (e.g., grounding of the negative terminal).

The module provides several diagnosis functions, see section Diagnosis.

The meaning of the LEDs is described in the section State LEDs.

---

**Connection of resistance thermometers in 2-wire configuration**

![Connection Diagram](image_url)

*Fig. 37: Connection example*

The following measuring ranges can be configured in Chapter 5.2.4.4.2.3.7 “Parameterization” on page 749:
### Parameter Resistance thermometers Value

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Resistance thermometers</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel configuration</td>
<td>Pt100</td>
<td>-50 °C...+400 °C</td>
</tr>
<tr>
<td></td>
<td></td>
<td>-50 °C...+130 °C</td>
</tr>
<tr>
<td></td>
<td>Pt1000</td>
<td>-50 °C...+400 °C</td>
</tr>
<tr>
<td></td>
<td>Ni1000</td>
<td>-50 °C...+150 °C</td>
</tr>
<tr>
<td></td>
<td>NTC</td>
<td>803 Ω...100 kΩ</td>
</tr>
</tbody>
</table>

In order to avoid error messages or long processing times, it is useful to configure unused analog input channels as "not used".

#### Connection of resistance thermometers in 3-wire configuration

![Connection example](image)

**Fig. 38: Connection example**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Resistance thermometers</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel configuration</td>
<td>Pt100</td>
<td>-50 °C...+400 °C</td>
</tr>
<tr>
<td></td>
<td></td>
<td>-50 °C...+130 °C</td>
</tr>
<tr>
<td></td>
<td>Pt1000</td>
<td>-50 °C...+400 °C</td>
</tr>
<tr>
<td></td>
<td>Ni1000</td>
<td>-50 °C...+150 °C</td>
</tr>
</tbody>
</table>

The module linearizes the resistance thermometer characteristics. In order to keep measuring errors as small as possible, it is necessary by all means to have all the involved conductors in the same cable. All the conductors must have the same cross section.

In order to avoid error messages or long processing times, it is useful to configure unused analog input channels as "not used".

#### I/O configuration

The option board itself does not store configuration data. It receives its parameterization data from the CPU module during power-up of the system.

Hence, replacing option boards is possible without any re-parameterization via software.

⇔ *Further information to the option board.*
Firmware update via memory card

The following steps describe the procedure for updating the firmware for the analog option boards using a memory card. Prerequisite is the previous download of the current firmware to the memory card either from the Automation Builder or as online download from ABB. Direct from ABB Software.

Click this link and on the next web page find the relevant firmware package and download it.

- Unpack this .zip archive file at any location of your hard disc
- Insert empty formatted (FAT16 / FAT32) memory card in the PC card reader
- Execute the unpacked *.exe file
- Select PC card reader as the final destination and confirm.

All directories, files and SDCARD.INI file will be automatically created on memory card and properly configured. After the process is complete, one has the prepared memory card with relevant updates.

Precondition: Prepared memory card with boot project and firmware. Chapter 6.3.1.4.5.2.2 “Preparation of memory card” on page 1427.

1. Switch off the device.
2. Insert the memory card.
3. Switch on the device.
   - The alternate flashing of the RUN and the ERR LED indicates the running update process.
   - At the end of the update process a reboot is executed and the system firmware is started for the finishing of the update process.
   - If RUN LED blinks (ERR LED is off), the update was successful and the display shows done.
   - If ERR LED blinks (RUN LED is off), the update failed and the display shows FAIL.
   - The text file “SDCARD.RDY” includes the results of the different updates. If the update fails, the file contains the reasons for the abort. Based on this, further steps can be taken to fix the problem.
4. Switch off the device.
5. Remove the memory card.
6. Switch on the device.
   - The system starts with the new firmware.

Parameterization

The arrangement of the parameter data is performed with Automation Builder software.

1. In the device tree, double-click the desired option board.
2. Select the “TA5123-2AI-RTD Parameters” tab to edit the parameterization of the desired option board.
1. The two inputs are set to “Not used” by default. Select your 2 individually configurable analog inputs.
2. If you select Pt100 (2-wire), PT100 (3-wire), Pt100 (2-wire), PT100 (3-wire), NI1000 (2-wire) or NI1000 (3-wire) by double-clicking, parameterization is completed.
   If you select NTC (2-wire) by double-clicking, you still have to make further entries.
3. The following steps are only required for the NTC (2-wire) selection.
   If you have selected NTC (2-wire) on input 0 (1), a folder Input 0 (1) - R, T, B configuration appears.

   Data sheet of used NTC
   Take the following values from the data sheet of the NTC used.
   - Resistance at temperature T [Ω]
   - Temperature at resistance R [°C] (the reference temperature is usually 25 °C)
   - B [K] - The shape of the curve, represents the relationship between the resistance and the temperature of a particular thermistor.

4. Enter these values in the column “Value” in the respective cells R, T and B. Observe the correct units in the note.
   When you have entered the 3 values with double-click, the parameterization is completed.

   Table 68 “Measuring range: NTC” on page 265

Diagnosis

1. In the device tree, double-click the desired option board.
2. Select the “Diagnosis” tab to view the diagnosis messages of the desired option board.

The following table shows the diagnosis messages.
<table>
<thead>
<tr>
<th>Severity</th>
<th>Error</th>
<th>Description</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>3</td>
<td>Timeout</td>
<td>If the process voltage is connected properly, replace the option board.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Communication timeout to CPU</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>51</td>
<td>Invalid slot</td>
<td>Check the configuration and the hardware setup.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Wrong or missing option board in the appropriate slot</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>11</td>
<td>Process voltage is too low</td>
<td>Check the process voltage.</td>
</tr>
<tr>
<td>4</td>
<td>34</td>
<td>Data not ready</td>
<td>Check PLC program and synchronize. 1)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Data synchronization warning</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>40</td>
<td>SW-mismatch</td>
<td>Replace the option board.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Hardware does not match the firmware version</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>53</td>
<td>Download failed</td>
<td>Replace the option board. 2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Power loss during firmware update</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>9</td>
<td>DIAG_BUF_OVERFLOW</td>
<td>Diagnosis overflow usually means too many repeated warnings or errors. Please check all diagnosis in detail and take the appropriate action. A restart will clear the diagnosis.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Overflow in Diagnosis buffer</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>43</td>
<td>DIAG_INTERNAL_ERR</td>
<td>Replace the option board.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Internal error in the option board</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>26</td>
<td>DIAG_CFG_PRM_ERR</td>
<td>Check the CPU parameterization.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Parameterization error</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>19</td>
<td>DIAG_CRC_ERR</td>
<td>Replace the option board.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Checksum error in option board</td>
<td></td>
</tr>
</tbody>
</table>

Channel warning

<table>
<thead>
<tr>
<th>Severity</th>
<th>Error</th>
<th>Description</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>5</td>
<td>DIAG_HIGH_LEVEL</td>
<td>Check the NTC input and configuration.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NTC value too high</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>6</td>
<td>DIAG_LOW_LEVEL</td>
<td>Check the input value and the wiring.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NTC value too low</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>7</td>
<td>Lowest Level Measurement underflow</td>
<td>Check the input value.</td>
</tr>
<tr>
<td>4</td>
<td>47</td>
<td>DIAG_WIRE_SHORTCUT</td>
<td>Check the wiring.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Short circuit at analog input</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>48</td>
<td>Overload Cut Wire</td>
<td>Check the NTC input and configuration.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Overflow or broken wire</td>
<td></td>
</tr>
</tbody>
</table>

Remarks:

1) If no other error occurs, the programs are not identical and the parameter is set to report an error in this case.

2) Do not remove the power supply from the option board during the firmware update.
State LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
<th>LED flashes</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAS123-2AI-RTD</td>
<td>I0...I1</td>
<td>Analog</td>
<td>Input is OFF or input value is too low</td>
<td>Input is ON (brightness depends on the value of the analog signal)</td>
<td>--</td>
</tr>
</tbody>
</table>

Measuring ranges

Table 65: Measuring range: Pt100/Pt1000 -50 °C ... +400 °C

<table>
<thead>
<tr>
<th>Range/LED behavior</th>
<th>Input</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Decimal</td>
<td>Hex.</td>
</tr>
<tr>
<td>Wire break/LED OFF</td>
<td>&gt; 450.0 °C</td>
<td>32767</td>
</tr>
<tr>
<td>Overflow/LED OFF</td>
<td>&gt; 450.0 °C</td>
<td>32767</td>
</tr>
<tr>
<td>Temperature too high/LED 100 %</td>
<td>450.0 °C</td>
<td>4500</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
</tr>
<tr>
<td></td>
<td>400.1 °C</td>
<td>4001</td>
</tr>
<tr>
<td>Normal range/LED 0 % ... 100 %</td>
<td>400 °C</td>
<td>4000</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
</tr>
<tr>
<td></td>
<td>0.1 °C</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
</tr>
<tr>
<td></td>
<td>0.0000</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>-0.1 °C</td>
<td>-1</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
</tr>
<tr>
<td></td>
<td>-50.0 °C</td>
<td>-500</td>
</tr>
<tr>
<td>Temperature too low/LED OFF</td>
<td>-50.1 °C</td>
<td>-501</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
</tr>
<tr>
<td></td>
<td>-60.0 °C</td>
<td>-600</td>
</tr>
<tr>
<td>Underflow/LED OFF</td>
<td>&lt; -60.0 °C</td>
<td>-32768</td>
</tr>
<tr>
<td>Short circuit/LED OFF</td>
<td>&lt;&lt; -60.0 °C</td>
<td>-32768</td>
</tr>
</tbody>
</table>

Table 66: Measuring range: Pt100/Pt1000 -50 °C ... +130 °C

<table>
<thead>
<tr>
<th>Range/LED behavior</th>
<th>Input</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Decimal</td>
<td>Hex.</td>
</tr>
<tr>
<td>Wire break/LED OFF</td>
<td>&gt; 140.0 °C</td>
<td>32767</td>
</tr>
<tr>
<td>Overflow/LED OFF</td>
<td>&gt; 140.0 °C</td>
<td>32767</td>
</tr>
<tr>
<td>Temperature too high/LED 100 %</td>
<td>140.0 °C</td>
<td>1400</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
</tr>
<tr>
<td></td>
<td>130.1 °C</td>
<td>1301</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
</tr>
<tr>
<td>Range/LED behavior</td>
<td>Input</td>
<td>Digital value</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------</td>
<td>---------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Decimal</td>
</tr>
<tr>
<td>Normal range/LED 0 % ... 100 %</td>
<td>130.0 °C</td>
<td>1300</td>
</tr>
<tr>
<td></td>
<td>0.1 °C</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>0.0000</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>-0.1 °C</td>
<td>-1</td>
</tr>
<tr>
<td></td>
<td>-50.0 °C</td>
<td>-500</td>
</tr>
<tr>
<td>Temperature too low/LED OFF</td>
<td>-50.1 °C</td>
<td>-501</td>
</tr>
<tr>
<td></td>
<td>-60.0 °C</td>
<td>-600</td>
</tr>
<tr>
<td>Underflow/LED OFF</td>
<td>&lt; -60.0 °C</td>
<td>-32768</td>
</tr>
<tr>
<td>Short circuit/LED OFF</td>
<td>&lt;= -60.0 °C</td>
<td>-32768</td>
</tr>
</tbody>
</table>

Table 67: Measuring range: Ni1000 -50 °C ... +150 °C

<table>
<thead>
<tr>
<th>Range/LED behavior</th>
<th>Input</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Wire break/LED OFF</td>
<td>&gt;&gt; 160.0 °C</td>
</tr>
<tr>
<td>Overflow/LED OFF</td>
<td>&gt; 160.0 °C</td>
</tr>
<tr>
<td>Temperature too high/LED 100 %</td>
<td>160.0 °C</td>
</tr>
<tr>
<td></td>
<td>150.1 °C</td>
</tr>
<tr>
<td>Normal range/LED 0 % ... 100 %</td>
<td>150.0 °C</td>
</tr>
<tr>
<td></td>
<td>0.1 °C</td>
</tr>
<tr>
<td></td>
<td>0.0000</td>
</tr>
<tr>
<td></td>
<td>-0.1 °C</td>
</tr>
<tr>
<td></td>
<td>-50.0 °C</td>
</tr>
<tr>
<td>Temperature too low/LED OFF</td>
<td>-50.1 °C</td>
</tr>
<tr>
<td></td>
<td>-60.0 °C</td>
</tr>
<tr>
<td>Underflow/LED OFF</td>
<td>&lt; -60.0 °C</td>
</tr>
<tr>
<td>Short circuit/LED OFF</td>
<td>&lt;= -60.0 °C</td>
</tr>
</tbody>
</table>
Variable measuring range

With the NTC, a resistance is measured. Depending on the values $R$, $T$ and $B$ a temperature value can be calculated, from which the digital values (dec. and hex.) are derived.

The following table shows an example with the default value:

- $R = 10000 \, \Omega$
- $T = 25 \, ^\circ C$
- $B = 3435 \, K$

<table>
<thead>
<tr>
<th>Table 68: Measuring range: NTC</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Range/LED behavior</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Short circuit/LED ON</td>
</tr>
<tr>
<td>Overflow/LED ON</td>
</tr>
<tr>
<td>Temperature medium accuracy/LED 100 %</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Normal range/LED 0 % ... 100 %</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Temperature medium accuracy/LED 0 %</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Underflow/LED OFF</td>
</tr>
<tr>
<td>Wire break/LED OFF</td>
</tr>
</tbody>
</table>

Values written in italics

Values written in italics are variable and depend on the parameters $R$, $T$ and $B$. Here, the default values are used ($R$: 10000 $\Omega$, $T$: 25 °C, $B$: 3435 K)

Technical data

The system data of AC500-eCo V3 apply to Chapter 5.1.1 “System data AC500-eCo” on page 159

Only additional details are therefore documented below.
### Technical data of the analog inputs

**NOTICE!**
All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>2</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group of 2 channels</td>
</tr>
<tr>
<td>Input type</td>
<td>Unipolar with Pt100, Pt1000, Ni1000 and NTC</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per module (no isolation between channels)</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Configurability</td>
<td>Pt100 (2-wire) -50 °C...+400 °C</td>
</tr>
<tr>
<td></td>
<td>Pt100 (3-wire) -50 °C...+400 °C</td>
</tr>
<tr>
<td></td>
<td>Pt100 (2-wire) -50 °C...+130 °C</td>
</tr>
<tr>
<td></td>
<td>Pt100 (3-wire) -50 °C...+130 °C</td>
</tr>
<tr>
<td></td>
<td>Pt1000 (2-wire) -50 °C...+400 °C</td>
</tr>
<tr>
<td></td>
<td>Pt1000 (3-wire) -50 °C...+400 °C</td>
</tr>
<tr>
<td></td>
<td>Ni1000 (2-wire) -50 °C...+150 °C</td>
</tr>
<tr>
<td></td>
<td>Ni1000 (3-wire) -50 °C...+150 °C</td>
</tr>
<tr>
<td></td>
<td>NTC (2-wire)</td>
</tr>
<tr>
<td></td>
<td>(each input can be configured individually)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 LED per channel</td>
</tr>
<tr>
<td>Conversion cycle *)</td>
<td></td>
</tr>
<tr>
<td>Configurations</td>
<td>2 activated channels with 3-wire measurement</td>
</tr>
<tr>
<td></td>
<td>2 s</td>
</tr>
<tr>
<td></td>
<td>all others</td>
</tr>
<tr>
<td></td>
<td>1 s</td>
</tr>
<tr>
<td>Resolution</td>
<td>Range 16 bits including sign</td>
</tr>
<tr>
<td>Conversion error of the analog values caused by non-linearity, adjustment error at factory and resolution within the normal range</td>
<td></td>
</tr>
<tr>
<td>PT100, PT1000, Ni1000</td>
<td>0,3% max at 25 °C</td>
</tr>
<tr>
<td></td>
<td>0,5% max at full temperature range</td>
</tr>
<tr>
<td>NTC</td>
<td>0,3% max at 25 °C</td>
</tr>
<tr>
<td>Reference sensor R: 10000Ω, T: 25 °C B: 3435 K</td>
<td>0,5% max at full temperature range</td>
</tr>
<tr>
<td>accuracy specified in the range 806 Ω - 100kΩ</td>
<td></td>
</tr>
<tr>
<td>Temperature coefficient</td>
<td>+0,006 %/K</td>
</tr>
<tr>
<td>(is related to the max error at +25°C and max error in the full range)</td>
<td></td>
</tr>
<tr>
<td>Temporary deviation during EMC disturbance</td>
<td>3%</td>
</tr>
<tr>
<td>Unused temperature inputs</td>
<td>Must be configured as &quot;Not used&quot;</td>
</tr>
<tr>
<td>Overvoltage protection</td>
<td>Yes</td>
</tr>
</tbody>
</table>

*) The value is the sampling time on the option board. The complete conversion cycle time is also related to the CPU cycle time.
Dimensions

The dimensions are in mm and in brackets in inch.

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 187 100 R0002</td>
<td>TA5123-2AI-RTD: AC500-eCo V3, analog input option board, 2AI RTD, 16 bits including sign, spring/cable front terminal 3.50 mm pitch</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 187 100 R0202</td>
<td>TA5123-2AI-RTW: AC500-eCo V3, analog input option board, 2AI RTD, 16 bits including sign, spring/cable front terminal 3.50 mm pitch, wide temperature range</td>
<td>Active</td>
</tr>
<tr>
<td><strong>Spare parts</strong></td>
<td><strong>TA5220-SPF8: spring terminal block, removable, 8-pin, spring front, cable front, 6 pieces per packing unit</strong></td>
<td>Active</td>
</tr>
</tbody>
</table>
*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

**) The needed spring terminal block is always delivered with the option board. The terminal block listed in the table is for spare part only if needed.

** TA5126-2AO-UI - Analog output option board

Features

- 2 configurable analog outputs (O0 and O1) in 1 group
  Resolution 12 bits
- Option board is galvanically isolated
- W variant available for use in extended (wide) temperature range

1 Allocation of signal name
2 2 yellow LEDs to display the signal states at the analog outputs O0 and O1
3 6-pin terminal block for analog output signals and power supply (UP, ZP)
4 Output connection diagram for U and I

Intended purpose

The option board is used as analog output extension module for AC500-eCo V3 CPUs (PM50xx).

The analog option boards TA5120-2AI-UI and TA5126-2AO-UI can only be used from AB 2.5.2, SystemFW 3.5.0_HF-7, BootFW 3.5.1 and higher.

Using the option boards with lower versions will create a configuration error and the CPU will not start.
### Functionality

2 analog outputs, individually configurable for
- Not used (default setting)
- 0 V...10 V
- 0 mA...20 mA
- 4 mA...20 mA

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution of the analog channels</td>
<td></td>
</tr>
<tr>
<td>Voltage 0 V...10 V</td>
<td>12 bits</td>
</tr>
<tr>
<td>Current 0 mA...20 mA,</td>
<td>12 bits</td>
</tr>
<tr>
<td>Current 4 mA...20 mA</td>
<td>12 bits</td>
</tr>
<tr>
<td>LED displays</td>
<td>2 LEDs for signals O0 and O1</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via the CPU PM50xx</td>
</tr>
<tr>
<td>External power supply</td>
<td>Via the terminals UP and ZP (process voltage 24 V DC)</td>
</tr>
<tr>
<td>Required CPU</td>
<td>PM50xx</td>
</tr>
</tbody>
</table>

### Connections

**WARNING!**

**Removal/Insertion under power**

The option boards are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug option boards with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you
- connect or disconnect any signal or terminal block
- remove, mount or replace an option board.

Disconnecting any powered option board while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The option board TA5126-2AO-UI for analog output extension is plugged into an AC500-eCo V3 CPU PM50xx.

*Chapter 4.3.11.1 “Mounting and demounting the option boards” on page 127*

The electrical connection is made via a removable 6-pin terminal block.

The terminal block is included in the scope of delivery of the option board. Further terminal blocks can be ordered separately as spare parts

*Chapter 5.2.8.1.2 “TA52xx(-x) - Terminal block sets” on page 1292*
Table 69: Assignment of the terminals:

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>O0+</td>
<td>Positive analog output O0</td>
</tr>
<tr>
<td>2</td>
<td>O0-</td>
<td>Negative analog output O0</td>
</tr>
<tr>
<td>3</td>
<td>O1+</td>
<td>Positive analog output O1</td>
</tr>
<tr>
<td>4</td>
<td>O1-</td>
<td>Negative analog output O1</td>
</tr>
<tr>
<td>5</td>
<td>UP</td>
<td>Process voltage UP = +24 V DC</td>
</tr>
<tr>
<td>6</td>
<td>ZP</td>
<td>Process voltage ZP = 0 V DC</td>
</tr>
</tbody>
</table>

**CAUTION!**

The negative terminal of the analog outputs (voltage 0 V…10 V) are connected internally and form an internal analog ground (AGND). This analog ground is connected to ZP via a PTC resistor. There is no galvanic isolation between the analog circuitry and ZP/UP.

The internal power supply voltage for the module’s circuitry is carried out via the connection to CPU. Thus, the current consumption from 24 V DC power supply at the terminals L+ and M of the CPU module increases by $\ll 1$ mA per TA5126-2AO-UI.

The external power supply connection is carried out via the terminals UP (+24 V DC) and ZP (0 V DC).

**NOTICE!**

Risk of damaging the PLC modules!

Overvoltages and short circuits might damage the PLC modules.

Generally, analog signals must be laid in shielded cables. The cable shields must be grounded at both sides of the cables. In order to avoid unacceptable potential differences between different parts of the installation, low resistance equipotential bonding conductors must be laid.

The following figure shows the connection of the module:

![Fig. 39: Internal construction of the analog outputs](image-url)
**CAUTION!**

By installing equipotential bonding conductors between the different parts of the system, it must be ensured that the potential difference between ZP and AGND never can exceed 1 V.

**CAUTION!**

The process supply voltage must be included in the grounding concept (e.g. grounding of the negative terminal).

The module provides several diagnosis functions

☞ Chapter 5.2.1.3.6.8 "Diagnosis" on page 274

---

**Connection of analog output loads (Voltage, current)**

![Connection diagram](image)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel configuration</td>
<td>0 V...+10 V</td>
</tr>
<tr>
<td></td>
<td>0 mA...20 mA</td>
</tr>
<tr>
<td></td>
<td>4 mA...20 mA</td>
</tr>
</tbody>
</table>

In order to avoid error messages or long processing times, it is useful to configure unused analog output channels as "not used".

**I/O configuration**

The option board itself does not store configuration data. It receives its parameterization from the CPU module during power-up of the system.

Hence, replacing optional modules is possible without any re-parameterization via software.
The following steps describe the procedure for updating the firmware for the analog option boards using a memory card. Prerequisite is the previous download of the current firmware to the memory card either from the Automation Builder or as online download from ABB.

Direct from ABB Software.

Click this link and on the next web page find the relevant firmware package and download it.

- Unpack this .zip archive file at any location of your hard disc
- Insert empty formatted (FAT16 / FAT32) memory card in the PC card reader
- Execute the unpacked *.exe file
- Select PC card reader as the final destination and confirm.

All directories, files and SDCARD.INI file will be automatically created on memory card and properly configured. After the process is complete, one has the prepared memory card with relevant updates.

Precondition: Prepared memory card with boot project and firmware

The text file “SDCARD.RDY” includes the results of the different updates. If the update fails, the file contains the reasons for the abort. Based on this, further steps can be taken to fix the problem.

1. Switch off the device.
2. Insert the memory card.
3. Switch on the device.
   - The alternate flashing of the RUN and the ERR LED indicates the running update process.
   - At the end of the update process a reboot is executed and the system firmware is started for the finishing of the update process.
   - If RUN LED blinks (ERR LED is off), the update was successful and the display shows done.
   - If ERR LED blinks (RUN LED is off), the update failed and the display shows FAIL.

The system starts with the new firmware.
**Parameterization**

The arrangement of the parameter data is performed with Automation Builder software.

1. In the device tree, double-click the desired option board.
2. Select the “TA5126-2AO-UI Parameters” tab to edit the parameterization of the desired option board.

**Diagnosis**

1. In the device tree, double-click the desired option board.
2. Select the “Diagnosis” tab to view the diagnosis messages of the desired option board.

<table>
<thead>
<tr>
<th>Bus pos.</th>
<th>Type</th>
<th>Channel</th>
<th>Class</th>
<th>Error</th>
<th>Description</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>0..2</td>
<td>31</td>
<td>255</td>
<td>3</td>
<td>3</td>
<td>Timeout</td>
<td>If the process voltage is connected properly, replace the option board.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Communication timeout to CPU</td>
<td></td>
</tr>
<tr>
<td>0..2</td>
<td>31</td>
<td>255</td>
<td>3</td>
<td>51</td>
<td>Invalid slot</td>
<td>Check the configuration and the hardware setup.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Wrong or missing option board in the appropriate slot</td>
<td></td>
</tr>
<tr>
<td>0..2</td>
<td>31</td>
<td>255</td>
<td>4</td>
<td>11</td>
<td>Process voltage is too low</td>
<td>Check the process voltage.</td>
</tr>
<tr>
<td>0..2</td>
<td>31</td>
<td>255</td>
<td>4</td>
<td>34</td>
<td>Data not ready</td>
<td>Check PLC program and synchronize. 1)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Data synchronization warning</td>
<td></td>
</tr>
<tr>
<td>0..2</td>
<td>31</td>
<td>255</td>
<td>3</td>
<td>40</td>
<td>SW-mismatch</td>
<td>Replace the option board.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Hardware does not match the firmware version</td>
<td></td>
</tr>
<tr>
<td>0..2</td>
<td>31</td>
<td>255</td>
<td>3</td>
<td>53</td>
<td>Download failed</td>
<td>Replace the option board. 2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Power loss during firmware update</td>
<td></td>
</tr>
<tr>
<td>Bus pos.</td>
<td>Type</td>
<td>Channel</td>
<td>Class</td>
<td>Error</td>
<td>Description</td>
<td>Remedy</td>
</tr>
<tr>
<td>---------</td>
<td>------</td>
<td>---------</td>
<td>-------</td>
<td>-------</td>
<td>--------------------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>0..2</td>
<td>31</td>
<td>255</td>
<td>3</td>
<td>9</td>
<td>DIAG_BUF_OVERFLOW</td>
<td>Diagnosis overflow usually means too many repeated warnings or errors. Please check all diagnosis in detail and take the appropriate action. A restart will clear the diagnosis.</td>
</tr>
<tr>
<td>0..2</td>
<td>31</td>
<td>255</td>
<td>3</td>
<td>43</td>
<td>DIAG_INTERNAL_ERR</td>
<td>Replace the option board.</td>
</tr>
<tr>
<td>0..2</td>
<td>31</td>
<td>255</td>
<td>3</td>
<td>26</td>
<td>DIAG_CFG_PRM_ERR</td>
<td>Check the CPU parameterization.</td>
</tr>
<tr>
<td>0..2</td>
<td>31</td>
<td>255</td>
<td>3</td>
<td>19</td>
<td>DIAG_CRC_ERR</td>
<td>Replace the option board.</td>
</tr>
</tbody>
</table>

Channel warning

<table>
<thead>
<tr>
<th>Bus pos.</th>
<th>Type</th>
<th>Channel</th>
<th>Class</th>
<th>Error</th>
<th>Description</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>0..2</td>
<td>1</td>
<td>0..1</td>
<td>4</td>
<td>4</td>
<td>Highest level</td>
<td>Check the output value.</td>
</tr>
<tr>
<td>0..2</td>
<td>1</td>
<td>0..1</td>
<td>4</td>
<td>7</td>
<td>Lowest level</td>
<td>Check the output value.</td>
</tr>
<tr>
<td>0..2</td>
<td>1</td>
<td>0..1</td>
<td>4</td>
<td>46</td>
<td>DIAG_EXT_VOLTAGE_FEEDED</td>
<td>Check the wiring.</td>
</tr>
<tr>
<td>0..2</td>
<td>1</td>
<td>0..1</td>
<td>4</td>
<td>48</td>
<td>Overload wire break</td>
<td>Check the output value and the wiring.</td>
</tr>
</tbody>
</table>

Remarks:

1) If no other error occurs, the programs are not identical and the parameter is set to report an error in this case.

2) Do not remove the power supply from the option board during the firmware update.

3) In this case, output will be switched ON/OFF with a 10 sec cycle

4) in this case, if the output is configured as voltage output, the output will be switched ON/OFF with a 10 sec cycle
### Measuring ranges

#### Measuring ranges - Output ranges of voltage and current

The represented resolution corresponds to 12 bits.

**Table 70: Measuring range: 0 V ... 10 V**

<table>
<thead>
<tr>
<th>Range</th>
<th>Output [V]</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Decimal</td>
</tr>
<tr>
<td>Overflow</td>
<td>0 V</td>
<td>&gt; 32504</td>
</tr>
<tr>
<td>Output value too high</td>
<td>11.7564</td>
<td>32504</td>
</tr>
<tr>
<td></td>
<td></td>
<td>10.0029</td>
</tr>
<tr>
<td>Normal range</td>
<td>10.0000</td>
<td>27648</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.0029</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.0000</td>
</tr>
<tr>
<td>Output value too low</td>
<td>-0.0029</td>
<td>-8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>-1.7593</td>
</tr>
<tr>
<td>Underflow</td>
<td>0</td>
<td>&lt; -4864</td>
</tr>
</tbody>
</table>

**Table 71: Measuring range: 0 mA ... 20 mA**

<table>
<thead>
<tr>
<th>Range</th>
<th>Output [mA]</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Decimal</td>
</tr>
<tr>
<td>Overflow</td>
<td>0.0000</td>
<td>&gt; 32504</td>
</tr>
<tr>
<td>Output value too high</td>
<td>23.5127</td>
<td>32504</td>
</tr>
<tr>
<td></td>
<td></td>
<td>20.0058</td>
</tr>
<tr>
<td>Normal range</td>
<td>20.0000</td>
<td>27648</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.0058</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.0000</td>
</tr>
<tr>
<td>Underflow</td>
<td>0</td>
<td>&lt; 0</td>
</tr>
</tbody>
</table>
Table 72: Measuring range: 4 mA ... 20 mA

<table>
<thead>
<tr>
<th>Range</th>
<th>Output [mA]</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Decimal</td>
</tr>
<tr>
<td>Overflow</td>
<td>0.0000</td>
<td>&gt; 32504</td>
</tr>
<tr>
<td>Output value too high</td>
<td>22.8102</td>
<td>32504</td>
</tr>
<tr>
<td></td>
<td>20.0046</td>
<td>27656</td>
</tr>
<tr>
<td>Normal range</td>
<td>20.0000</td>
<td>27648</td>
</tr>
<tr>
<td></td>
<td>4.0046</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>4.0000</td>
<td>0</td>
</tr>
<tr>
<td>Output value too low</td>
<td>3.995</td>
<td>-8</td>
</tr>
<tr>
<td></td>
<td>0.0046</td>
<td>-6904</td>
</tr>
<tr>
<td></td>
<td>0.0000</td>
<td>-6912</td>
</tr>
<tr>
<td>Underflow</td>
<td>0</td>
<td>&lt; -6912</td>
</tr>
</tbody>
</table>

Technical data

The system data of AC500-eCo V3 apply to Chapter 5.1.1 “System data AC500-eCo” on page 159.

Only additional details are therefore documented below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process voltage</td>
<td></td>
</tr>
<tr>
<td>Connections</td>
<td>Terminal 5 for +24 V (UP) as well as terminal 6 for 0 V (ZP)</td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse on UP</td>
<td>1 A slow</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per module (no isolation between channels)</td>
</tr>
<tr>
<td>Current consumption</td>
<td></td>
</tr>
<tr>
<td>From 24 V DC power supply at the terminals UP/L+ and ZP/M of the CPU PM50xx</td>
<td>&lt;&lt; 1 mA</td>
</tr>
<tr>
<td>From UP at normal operation</td>
<td>max. 70 mA</td>
</tr>
<tr>
<td>Inrush current from UP (at power up)</td>
<td>0.005 A²s</td>
</tr>
<tr>
<td>Max. length of analog cables, conductor cross section &gt; 0.2 mm²</td>
<td>On request</td>
</tr>
<tr>
<td>Weight</td>
<td>20 g</td>
</tr>
</tbody>
</table>
### Technical data of the analog outputs

#### Parameter  | Value
--- | ---
Mounting position | Horizontal or vertical with derating (output load reduced to 50 % at +40 °C per group)
Cooling | The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.

#### NOTICE!
All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>2</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group of 2 channels</td>
</tr>
<tr>
<td>Connections of the channel 0</td>
<td></td>
</tr>
<tr>
<td>Voltage mode</td>
<td></td>
</tr>
<tr>
<td>Terminal O0+ and O0-</td>
<td>Terminals 1 and 2</td>
</tr>
<tr>
<td>Current mode</td>
<td></td>
</tr>
<tr>
<td>Terminal O0+ and ZP</td>
<td>Terminal 1 and 6</td>
</tr>
<tr>
<td>Connections of the channel 1</td>
<td></td>
</tr>
<tr>
<td>Voltage mode</td>
<td></td>
</tr>
<tr>
<td>Terminal O1+ and O1-</td>
<td>Terminals 3 and 4</td>
</tr>
<tr>
<td>Current mode</td>
<td></td>
</tr>
<tr>
<td>Terminal O1+ and ZP</td>
<td>Terminals 3 and 6</td>
</tr>
<tr>
<td>Output type</td>
<td>Unipolar</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per option board (no isolation between channels)</td>
</tr>
<tr>
<td>Configurability</td>
<td>0 V ... 10 V 0 mA ... 20 mA 4 mA ... 20 mA (each output can be configured individually)</td>
</tr>
<tr>
<td>Output resistance (load), as current output</td>
<td>0 Ω...500 Ω</td>
</tr>
<tr>
<td>Output loadability, as voltage output</td>
<td>Max. ±10 mA</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>One LED per channel</td>
</tr>
<tr>
<td>Conversion cycle</td>
<td></td>
</tr>
<tr>
<td>1 activated channel</td>
<td>250 μs</td>
</tr>
<tr>
<td>2 activated channel</td>
<td>500 μs</td>
</tr>
<tr>
<td>Resolution for all configurations</td>
<td>12 bits</td>
</tr>
<tr>
<td>Settling time for full range change (resistive load, output signal within specified tolerance)</td>
<td>Typ. 5 ms</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Conversion error of the analog values caused by non-linearity, adjustment error at factory and resolution within the normal range</td>
<td>Max. ±0.3 % at +25 °C</td>
</tr>
<tr>
<td></td>
<td>Max. ±0.3 % over full temperature range</td>
</tr>
<tr>
<td>Temperature coefficient (is related to the max error at +25°C and max error in the full range)</td>
<td>±0.003 %/K</td>
</tr>
<tr>
<td>Temporary deviation during EMC disturbance</td>
<td>Max. ±3 %</td>
</tr>
<tr>
<td>Mapping between output signal and digital value</td>
<td>Output ranges of voltage and current</td>
</tr>
<tr>
<td>Unused voltage outputs</td>
<td>Must be configured as &quot;not used&quot;</td>
</tr>
<tr>
<td>Unused current outputs</td>
<td>Must be configured as &quot;not used&quot;</td>
</tr>
</tbody>
</table>

**Dimensions**

*The dimensions are in mm and in brackets in inch.*
Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 187 100 R0003</td>
<td>TA5126-2AO-UI: AC500-eCo V3, analog output option board, 2AO U/I, 12 bits, spring/cable front terminal 3.50 mm pitch</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 187 100 R0203</td>
<td>TA5126-2AO-UIW: AC500-eCo V3, analog output option board, 2AO U/I, 12 bits, spring/cable front terminal 3.50 mm pitch, wide range temperature</td>
<td>Active</td>
</tr>
</tbody>
</table>

Spare parts

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase **)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 187 400 R0013</td>
<td>TA5220-SPF6: spring terminal block, removable, 6-pin, spring front, cable front, 6 pieces per packing unit</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

**) The needed spring terminal block is always delivered with the option board. The terminal block listed in the table is for spare part only if needed.

TA5130-KNXPB - Option board KNX address push button

Features

- W variant available for use in extended (wide) temperature range

1 State LED
2 Allocation of signal name
3 Connector
Intended purpose

This option board is only intended to be used with PM5072-T-2ETH(W) and PM5082-T-2ETH.
This option board can only be used once on one slot at a time!
The option board is not supported by other AC500-eCo V3 PLCs.

Information about the interface to KNX

Parameterization

The arrangement of the parameter data is performed with Automation Builder software.
1. In the device tree, double-click the desired option board.
2. Select the “TA51xx Parameters” tab to edit the parameterization of the desired option board.

State LEDs

<table>
<thead>
<tr>
<th>Signal</th>
<th>Color</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRG</td>
<td>Red</td>
<td>ON</td>
<td>Programming state</td>
</tr>
</tbody>
</table>

Technical data

The system data of AC500-eCo V3 apply "Chapter 5.1.1 “System data AC500-eCo” on page 159"
Only additional details are therefore documented below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Usable CPUs</td>
<td>PM5072-T-2ETH(W) and PM5082-T-2ETH</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via internal CPU connection</td>
</tr>
<tr>
<td>Additional current consumption from 24 V DC</td>
<td>Max. 25 mA</td>
</tr>
<tr>
<td>power supply at CPU</td>
<td></td>
</tr>
<tr>
<td>Weight</td>
<td>14 g</td>
</tr>
</tbody>
</table>
Dimensions

*The dimensions are in mm and in brackets in inch.*

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 187 200 R0001</td>
<td>TA5130-KNXPB: AC500-eCo V3, option board KNX address push button for AC500-eCo V3 Pro CPU only</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 187 200 R0201</td>
<td>TA5130-KNXPBW: AC500-eCo V3, option board KNX address push button for AC500-eCo V3 Pro CPU only, wide temperature range</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
TA5131-RTC - Option board for real-time clock

Features

This option board is only for the basic CPUs PM5012-T-ETH and PM5012-R-ETH. All other AC500-eCo V3 CPUs have the real-time clock already integrated.

Information about the real-time clock

1. TA5131-RTC option board

Parameterization

The arrangement of the parameter data is performed with Automation Builder software.

1. In the device tree, double-click the desired option board.
2. Select the “TA51xx Parameters” tab to edit the parameterization of the desired option board.

Technical data

The system data of AC500-eCo V3 apply Chapter 5.1.1 “System data AC500-eCo” on page 159

Only additional details are therefore documented below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Buffering time (if at least powered for 8 hours)</td>
<td>7 days at room temperature</td>
</tr>
<tr>
<td>Accuracy</td>
<td>±2 s/day</td>
</tr>
<tr>
<td>Usable CPUs</td>
<td>PM5012</td>
</tr>
</tbody>
</table>
### Parameter and Value

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal power supply</td>
<td>Via internal CPU connection</td>
</tr>
<tr>
<td>Additional current consumption from 24 V DC power supply at CPU</td>
<td>Max. 25 mA</td>
</tr>
<tr>
<td>Weight</td>
<td>16 g</td>
</tr>
</tbody>
</table>

### Dimensions

The dimensions are in mm and in brackets in inch.

### Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 187 200 R0002</td>
<td>TA5131-RTC:AC500-eCo V3, real-time clock without battery, option board for AC500-eCo V3 Basic CPU only</td>
<td>Active</td>
</tr>
</tbody>
</table>
*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

TA5141-RS232I - Option board for COMx serial communication

Features

- W variant available for use in extended (wide) temperature range

1. 2 LEDs for communication state display (TxD and RxD)
2. Allocation of signal name
3. 5-pin terminal block for communication interface

Option board for COMx serial communication TA5141-RS232I(W) is equipped with 1 RS-232 serial interface with handshake.

The serial interface option boards TA5141-RS232I(W), TA5142-RS485I(W) and TA5142-RS485(W) produced from 2023 can only be used from AB 2.5.2, SystemFW 3.5.0_HF-7, BootFW 3.5.1 and higher. These new produced option boards can be recognized with the Date/Code printed on the sticker or also on the product packaging, the date code looks like 2xx3, where 2 and 3 are for the year and the xx for the production week.

Using the option boards with lower versions will create a configuration error and the CPU will not start.

These new produced option boards cannot be used with lower Automation Builder Version and the CPU BootFW/FW and the application must be upgraded to AB 2.5.2 HF8 or higher.

Application note AC500-eCo V3 - FAQ
Connections

Serial interfaces

NOTICE!
Damage to the serial communication interface by using 5-pin terminal block of the TA5101-4DI!

If the 5-pin terminal block of the TA5101-4DI option board is plugged into a option board for COMx serial communication TA5141-RS232I, TA5142-RS485I or TA5142-RS485, the communication interface will be damaged by the 24 V.

Please do not confuse the 5-pin terminal block of the TA5101-4DI with the 5-pin terminal block for serial communication interface of TA5141-RS232I, TA5142-RS485I or TA5142-RS485.

Table 73: TA5141-RS232I

<table>
<thead>
<tr>
<th>Serial interface</th>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
</table>
|                  | 1   | RTS    | Request To Send  
DCE is ready to accept data from the DTE |
|                  | 2   | TxD    | Transmit data (output) |
|                  | 3   | GND    | Common Ground |
|                  | 4   | RxD    | Receive data (input)  
DCE is ready to accept data from the DTE |
|                  | 5   | CTS    | Clear To Send (input) |

Cable length

The maximum possible cable length of a serial connection subnet within a segment depends on the transmission rate.

RS-232 for point-to-point connection:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission rate</td>
<td>9.6 kBit/s to 115.2 kBit/s</td>
</tr>
<tr>
<td>Maximum cable length</td>
<td>On request</td>
</tr>
</tbody>
</table>

Parameterization

The arrangement of the parameter data is performed with Automation Builder software.

1. In the device tree, double-click the desired option board.
2. Select the “TA51xx Parameters” tab to edit the parameterization of the desired option board.
### State LEDs

<table>
<thead>
<tr>
<th>Signal</th>
<th>Color</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TxD</td>
<td>Yellow</td>
<td>ON (blinking)</td>
<td>Transmitting</td>
</tr>
<tr>
<td>RxD</td>
<td>Yellow</td>
<td>ON (blinking)</td>
<td>Receiving</td>
</tr>
</tbody>
</table>

### Technical data

The system data of AC500-eCo V3 apply to Chapter 5.1.1 “System data AC500-eCo” on page 159.

Only additional details are therefore documented below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol</td>
<td>Programmable with Automation Builder e.g. Modbus RTU / CAA SerialCom via serial interfaces</td>
</tr>
<tr>
<td>Interface</td>
<td>Serial interface</td>
</tr>
<tr>
<td>Serial interface standard</td>
<td>EIA RS-232</td>
</tr>
<tr>
<td>Potential separation</td>
<td>Yes, from the CPU, 500 V DC</td>
</tr>
<tr>
<td>Serial interface parameters</td>
<td>Configurable via software</td>
</tr>
<tr>
<td>Modes of operation</td>
<td>Data exchange</td>
</tr>
<tr>
<td>Transmission rate</td>
<td>9.6 kbit/s to 115.2 kbit/s</td>
</tr>
<tr>
<td>Protocol</td>
<td>Programmable</td>
</tr>
<tr>
<td>Interface connector</td>
<td>5-pin terminal block, male</td>
</tr>
<tr>
<td>Usable CPUs</td>
<td>PM50xx</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via internal CPU connection</td>
</tr>
<tr>
<td>Additional current consumption</td>
<td>Max. 25 mA</td>
</tr>
<tr>
<td>from 24 V DC power supply at CPU</td>
<td></td>
</tr>
<tr>
<td>Weight</td>
<td>Ca. 15 g</td>
</tr>
</tbody>
</table>
Dimensions

The dimensions are in mm and in brackets in inch.

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 187 300 R0001</td>
<td>TA5141-RS232I: AC500-eCo V3, RS-232 isolated option board for COMx serial communication, spring/cable front terminal, 3.50 mm pitch</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 187 300 R0201</td>
<td>TA5141-RS232IW: AC500-eCo V3, RS-232 isolated option board for COMx serial communication, spring/cable front terminal, 3.50 mm pitch, wide temperature range</td>
<td>Active</td>
</tr>
<tr>
<td>Spare parts</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1SAP 187 400 R0012 **)</td>
<td>TA5220-SPF5: spring terminal block, removable, 5-pin, spring front, cable front, 3.5 mm pitch, 6 pieces per packing unit</td>
<td>Active</td>
</tr>
</tbody>
</table>
*') Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

**) The needed spring terminal block is always delivered with the option board. The terminal block listed in the table is for spare part only if needed.

** TA5142-RS485I - Option board for COMx serial communication

Features

- W variant available for use in extended (wide) temperature range

![Option board TA5142-RS485I](image)

1 2 LEDs for communication state display (TxD and RxD)
2 2 LEDs for termination state display
3 Allocation of signal name
4 5-pin terminal block for communication interface

Option boards for COMx serial communication TA5142-RS485I(W) and TA5142-RS485(W) are equipped with 1 RS-485 (2-wire half-duplex) serial interface which can be used for communication via Modbus RTU or CAA SerialCom.

Bus terminations are built-in and configurable.
The serial interface option boards TA5141-RS232I(W), TA5142-RS485I(W) and TA5142-RS485(W) produced from 2023 can only be used from AB 2.5.2, SystemFW 3.5.0_HF-7, BootFW 3.5.1 and higher. These new produced option boards can be recognized with the Date/Code printed on the sticker or also on the product packaging, the date code looks like 2xx3, where 2 and 3 are for the year and the xx for the production week.

Using the option boards with lower versions will create a configuration error and the CPU will not start.

These new produced option boards cannot be used with lower Automation Builder Version and the CPU BootFW/FW and the application must be upgraded to AB 2.5.2 HF8 or higher.

Application note AC500-eCo V3 - FAQ

Connections
Serial interfaces

![Notice](image)

**NOTICE!**

Damage to the serial communication interface by using 5-pin terminal block of the TA5101-4DI!

If the 5-pin terminal block of the TA5101-4DI option board is plugged into an option board for COMx serial communication TA5141-RS232I, TA5142-RS485I or TA5142-RS485, the communication interface will be damaged by the 24 V.

Please do not confuse the 5-pin terminal block of the TA5101-4DI with the 5-pin terminal block for serial communication interface of TA5141-RS232I, TA5142-RS485I or TA5142-RS485.

Table 74: TA5142-RS485(I)

<table>
<thead>
<tr>
<th>Serial interface</th>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>A1 internally connected to A2</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>B1 internally connected to B2</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>GND</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>A2 internally connected to A1</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>B2 internally connected to B1</td>
</tr>
</tbody>
</table>

Protocols

<table>
<thead>
<tr>
<th>No.</th>
<th>Protocol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Modbus</td>
<td>Modbus RTU, master or slave</td>
</tr>
<tr>
<td>2</td>
<td>CAA SerialCom</td>
<td>Support for blocks contained in the CAA_SerialCom.lib library</td>
</tr>
</tbody>
</table>
### Bus cable

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Construction</td>
<td>2 cores, twisted, with common shield</td>
</tr>
<tr>
<td>Conductor cross section</td>
<td>&gt; 0.22 mm² (24 AWG)</td>
</tr>
<tr>
<td>Twisting rate</td>
<td>&gt; 10 per meter (symmetrically twisted)</td>
</tr>
<tr>
<td>Core insulation</td>
<td>Polyethylene (PE)</td>
</tr>
<tr>
<td>Resistance per core</td>
<td>&lt; 100 Ω/km</td>
</tr>
<tr>
<td>Characteristic impedance</td>
<td>ca. 120 Ω (100 Ω ... 150 Ω)</td>
</tr>
<tr>
<td>Capacitance between the cores</td>
<td>&lt; 55 nF/km (if higher, the max. bus length must be reduced)</td>
</tr>
<tr>
<td>Terminating resistors</td>
<td>120 Ω ¼ W at both line ends</td>
</tr>
<tr>
<td>Remarks</td>
<td>Commonly used telephone cables with PE insulation and a core diameter of &gt; 0.8 mm are usually sufficient. Cables with PVC core insulation and core diameter of 0.8 mm can be used up to a length of approx. 250 m. In this case, the bus terminating resistor is approx. 100 Ω.</td>
</tr>
</tbody>
</table>

### Cable length

The maximum possible cable length of a serial connection subnet within a segment depends on the transmission rate.

RS-485 for point-to-point or bus connection:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission rate</td>
<td>9.6 kbit/s to 115.2 kbit/s</td>
</tr>
<tr>
<td>Maximum cable length</td>
<td>On request</td>
</tr>
</tbody>
</table>

### Bus termination

The line ends of the bus segment must be equipped with bus terminating resistors. These resistors are integrated in the module TA5142-RS485I. The pull-up and pull-down settings must also be made on the circuit board of the module.
<table>
<thead>
<tr>
<th>Settings on the module</th>
<th>State of LEDs</th>
<th>Internal wiring diagram</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master at the bus line end, pull-up and pull-down activated, bus termination 120 Ω</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

```
<table>
<thead>
<tr>
<th>TXD</th>
<th>RXD</th>
<th>120R</th>
<th>PUD</th>
</tr>
</thead>
</table>
```

Master within the bus line, pull-up and pull-down activated

```
<table>
<thead>
<tr>
<th>TXD</th>
<th>RXD</th>
<th>120R</th>
<th>PUD</th>
</tr>
</thead>
</table>
```
<table>
<thead>
<tr>
<th>Settings on the module</th>
<th>State of LEDs</th>
<th>Internal wiring diagram</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Diagram of settings]</td>
<td>TXD</td>
<td>5 V</td>
<td>Slave at the bus line end, bus termination 120 Ω</td>
</tr>
<tr>
<td></td>
<td>RXD</td>
<td>470 Ω</td>
<td></td>
</tr>
<tr>
<td></td>
<td>120R</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PUD</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>A</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>120 Ω</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>B</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Pull-down 470 Ω</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>GND</td>
<td></td>
</tr>
</tbody>
</table>

|                       |               |                         | Slave within the bus line |
|                       |               |                         |                         |
|                       |               |                         |                         |
|                       |               |                         |                         |
|                       |               |                         |                         |

**Parameterization**

The arrangement of the parameter data is performed with Automation Builder software.
In the device tree, double-click the desired option board.

Select the “TA51xx Parameters” tab to edit the parameterization of the desired option board.

### State LEDs

<table>
<thead>
<tr>
<th>Signal</th>
<th>Color</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TxD</td>
<td>Yellow</td>
<td>ON (blinking)</td>
<td>Transmitting</td>
</tr>
<tr>
<td>RxD</td>
<td>Yellow</td>
<td>ON (blinking)</td>
<td>Receiving</td>
</tr>
<tr>
<td>120R</td>
<td>Yellow</td>
<td>ON</td>
<td>Bus termination</td>
</tr>
<tr>
<td>PUD</td>
<td>Yellow</td>
<td>ON</td>
<td>Pull-up / Pull-down</td>
</tr>
</tbody>
</table>

### Technical data

The system data of AC500-eCo V3 apply to Chapter 5.1.1 “System data AC500-eCo” on page 159

Only additional details are therefore documented below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol</td>
<td>Programmable with Automation Builder e.g. Modbus RTU / CAA_SerialCom via serial interfaces</td>
</tr>
<tr>
<td>Interface</td>
<td>Serial interface</td>
</tr>
<tr>
<td>Serial interface standard</td>
<td>EIA RS-485</td>
</tr>
<tr>
<td>Potential separation</td>
<td>Yes, from the CPU, 500 V DC</td>
</tr>
<tr>
<td>Serial interface parameters</td>
<td>Configurable via software</td>
</tr>
<tr>
<td>Modes of operation</td>
<td>Data exchange</td>
</tr>
<tr>
<td>Transmission rate</td>
<td>9.6 kbit/s to 115.2 kbit/s</td>
</tr>
<tr>
<td>Protocol</td>
<td>Programmable</td>
</tr>
<tr>
<td>Interface connector</td>
<td>5-pin terminal block, male</td>
</tr>
<tr>
<td>Usable CPUs</td>
<td>PM50xx</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via internal CPU connection</td>
</tr>
<tr>
<td>Additional current consumption from 24 V DC power supply at CPU</td>
<td>Max. 25 mA</td>
</tr>
<tr>
<td>Weight</td>
<td>Ca. 16 g</td>
</tr>
</tbody>
</table>
Dimensions

The dimensions are in mm and in brackets in inch.

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 187 300 R0002</td>
<td>TA5142-RS485i: AC500-eCo V3, RS-485 isolated option board for COMx serial communication, spring/cable front terminal, 3.50 mm pitch</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 187 300 R0202</td>
<td>TA5142-RS485IW: AC500-eCo V3, RS-485 isolated option board for COMx serial communication, spring/cable front terminal, 3.50 mm pitch, wide range temperature</td>
<td>Active</td>
</tr>
</tbody>
</table>

Spare parts

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 187 400 R0012 **)</td>
<td>TA5220-SPF5: spring terminal block, removable, 5-pin, spring front, cable front, 3.5 mm pitch, 6 pieces per packing unit</td>
<td>Active</td>
</tr>
</tbody>
</table>
*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

**) The needed spring terminal block is always delivered with the option board. The terminal block listed in the table is for spare part only if needed.

**TA5142-RS485 - Option board for COMx serial communication**

**Features**

- W variant available for use in extended (wide) temperature range

1. 2 LEDs for communication state display (TxD and RxD)
2. 2 LEDs for termination state display
3. Allocation of signal name
4. 5-pin terminal block for communication interface

Option boards for COMx serial communication TA5142-RS485I(W) and TA5142-RS485(W) are equipped with 1 RS-485 (2-wire half-duplex) serial interface which can be used for communication via Modbus RTU or CAA SerialCom.

Bus terminations are built-in and configurable.
The serial interface option boards TA5141-RS232I(W), TA5142-RS485I(W) and TA5142-RS485(W) produced from 2023 can only be used from AB 2.5.2, SystemFW 3.5.0_HF-7, BootFW 3.5.1 and higher. These new produced option boards can be recognized with the Date/Code printed on the sticker or also on the product packaging, the date code looks like 2xx3, where 2 and 3 are for the year and the xx for the production week.

Using the option boards with lower versions will create a configuration error and the CPU will not start.

These new produced option boards cannot be used with lower Automation Builder Version and the CPU BootFW/FW and the application must be upgraded to AB 2.5.2 HF8 or higher.

Application note AC500-eCo V3 - FAQ

Connections
Serial interfaces

![Notices]

NOTICE!

Damage to the serial communication interface by using 5-pin terminal block of the TA5101-4DI!

If the 5-pin terminal block of the TA5101-4DI option board is plugged into a option board for COMx serial communication TA5141-RS232I, TA5142-RS485I or TA5142-RS485, the communication interface will be damaged by the 24 V.

Please do not confuse the 5-pin terminal block of the TA5101-4DI with the 5-pin terminal block for serial communication interface of TA5141-RS232I, TA5142-RS485I or TA5142-RS485.

Table 77: TA5142-RS485(I)

<table>
<thead>
<tr>
<th>Serial interface</th>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>A1 internally connected to A2</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>B1 internally connected to B2</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>GND</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>A2 internally connected to A1</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>B2 internally connected to B1</td>
</tr>
</tbody>
</table>

Protocols

<table>
<thead>
<tr>
<th>No.</th>
<th>Protocol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Modbus</td>
<td>Modbus RTU, master or slave</td>
</tr>
<tr>
<td>2</td>
<td>CAA SerialCom</td>
<td>Support for blocks contained in the CAA_SerialCom.lib library</td>
</tr>
</tbody>
</table>
**Bus cable**

<table>
<thead>
<tr>
<th><strong>Bus line</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Construction</td>
<td>2 cores, twisted, with common shield</td>
</tr>
<tr>
<td>Conductor cross section</td>
<td>&gt; 0.22 mm² (24 AWG)</td>
</tr>
<tr>
<td>Twisting rate</td>
<td>&gt; 10 per meter (symmetrically twisted)</td>
</tr>
<tr>
<td>Core insulation</td>
<td>Polyethylene (PE)</td>
</tr>
<tr>
<td>Resistance per core</td>
<td>&lt; 100 Ω/km</td>
</tr>
<tr>
<td>Characteristic impedance</td>
<td>ca. 120 Ω (100 Ω ... 150 Ω)</td>
</tr>
<tr>
<td>Capacitance between the cores</td>
<td>&lt; 55 nF/km (if higher, the max. bus length must be reduced)</td>
</tr>
<tr>
<td>Terminating resistors</td>
<td>120 Ω ¼ W at both line ends</td>
</tr>
<tr>
<td>Remarks</td>
<td>Commonly used telephone cables with PE insulation and a core diameter of &gt; 0.8 mm are usually sufficient. Cables with PVC core insulation and core diameter of 0.8 mm can be used up to a length of approx. 250 m. In this case, the bus terminating resistor is approx. 100 Ω.</td>
</tr>
</tbody>
</table>

**Cable length**

The maximum possible cable length of a serial connection subnet within a segment depends on the transmission rate.

**RS-485 for point-to-point or bus connection:**

<table>
<thead>
<tr>
<th><strong>Parameter</strong></th>
<th><strong>Value</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission rate</td>
<td>9.6 kbit/s to 115.2 kbit/s</td>
</tr>
<tr>
<td>Maximum cable length</td>
<td>On request</td>
</tr>
</tbody>
</table>

**Bus termination**

The line ends of the bus segment must be equipped with bus terminating resistors. These resistors are integrated in the module TA5142-RS485. The pull-up and pull-down settings must also be made on the circuit board of the module.
<table>
<thead>
<tr>
<th>Settings on the module</th>
<th>State of LEDs</th>
<th>Internal wiring diagram</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Image of module settings]</td>
<td>[Image of LEDs]</td>
<td>![Diagram of master at the bus line end]</td>
<td>Master at the bus line end, pull-up and pull-down activated, bus termination 120 Ω</td>
</tr>
<tr>
<td>[Image of module settings]</td>
<td>[Image of LEDs]</td>
<td>![Diagram of master within the bus line]</td>
<td>Master within the bus line, pull-up and pull-down activated</td>
</tr>
</tbody>
</table>

Table 78: Configuration
<table>
<thead>
<tr>
<th>Settings on the module</th>
<th>State of LEDs</th>
<th>Internal wiring diagram</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>TXD RXD 120R PUD</td>
<td>5 V 470 Ω Pull-up 120 Ω Pull-down GND</td>
<td>Slave at the bus line end, bus termination 120 Ω</td>
</tr>
<tr>
<td></td>
<td>TXD RXD 120R PUD</td>
<td>5 V 470 Ω Pull-up 120 Ω Pull-down GND</td>
<td>Slave within the bus line</td>
</tr>
</tbody>
</table>

### Parameterization

The arrangement of the parameter data is performed with Automation Builder software.
1. In the device tree, double-click the desired option board.

2. Select the “TA51xx Parameters” tab to edit the parameterization of the desired option board.

---

**State LEDs**

<table>
<thead>
<tr>
<th>Signal</th>
<th>Color</th>
<th>State Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TxD</td>
<td>Yellow</td>
<td>ON (blinking) Transmitting</td>
</tr>
<tr>
<td>RxD</td>
<td>Yellow</td>
<td>ON (blinking) Receiving</td>
</tr>
<tr>
<td>120R</td>
<td>Yellow</td>
<td>ON Bus termination</td>
</tr>
<tr>
<td>PUD</td>
<td>Yellow</td>
<td>ON Pull-up / Pull-down</td>
</tr>
</tbody>
</table>

---

**Technical data**

The system data of AC500-eCo V3 apply to Chapter 5.1.1 “System data AC500-eCo” on page 159

Only additional details are therefore documented below.

**Table 79: TA5142-RS485**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol</td>
<td>Programmable with Automation Builder e.g. Modbus RTU / CAA_SerialCom via serial interfaces</td>
</tr>
<tr>
<td>Interface standard</td>
<td>EIA RS-485</td>
</tr>
<tr>
<td>Potential separation</td>
<td>No</td>
</tr>
<tr>
<td>Serial interface parameters</td>
<td>Configurable via software</td>
</tr>
<tr>
<td>Modes of operation</td>
<td>Programming or data exchange</td>
</tr>
<tr>
<td>Transmission rate</td>
<td>9.6 kbit/s to 115.2 kbit/s</td>
</tr>
<tr>
<td>Protocol</td>
<td>Programmable</td>
</tr>
<tr>
<td>Interface connector</td>
<td>5-pin terminal block, male</td>
</tr>
<tr>
<td>Usable CPUs</td>
<td>PM50xx</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via internal CPU connection</td>
</tr>
<tr>
<td>Additional current consumption from 24 V DC power supply at CPU</td>
<td>Max. 25 mA</td>
</tr>
<tr>
<td>Weight</td>
<td>Ca. 15 g</td>
</tr>
</tbody>
</table>
Dimensions

The dimensions are in mm and in brackets in inch.

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 187 300 R0003</td>
<td>TA5142-RS485: AC500-eCo V3, RS-485 non isolated option board for COMx serial communication, spring/cable front terminal, 3.50 mm pitch</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 187 300 R0203</td>
<td>TA5142-RS485W: AC500-eCo V3, RS-485 non isolated option board for COMx serial communication, spring/cable front terminal, 3.50 mm pitch, wide range temperature</td>
<td>Active</td>
</tr>
</tbody>
</table>

Spare parts

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase **</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 187 400 R0012</td>
<td>TA5220-SPF5: spring terminal block, removable, 5-pin, spring front, cable front, 3.5 mm pitch, 6 pieces per packing unit</td>
<td>Active</td>
</tr>
</tbody>
</table>
FAQs

Frequently asked and important questions about the AC500-eCo V3 serial communication option boards from 2023 are collected and answered in the application note. AC500 V3-eCo FAQ - TA514X-RSXXX Serial Option Boards.

5.2.1.2 AC500 and AC500-XC

5.2.1.2.1 Product overview and comparison

Comparison of AC500 V3 terminal bases

With the latest Automation Builder version the following terminal bases are compatible with the AC500 V3 processor modules:

<table>
<thead>
<tr>
<th>Terminal base compatibility</th>
<th>PM5630</th>
<th>PM5650</th>
<th>PM5670</th>
<th>PM5675</th>
</tr>
</thead>
<tbody>
<tr>
<td>TB5600</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TB5610</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TB5620</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TB5640</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TB5660</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The number of slots that are available on a terminal base for connecting communication modules or AC500-S modules differs within the terminal base range.

Table 80: Combination of TB56xx-2ETH(-XC) and PM56xx(-XC)

<table>
<thead>
<tr>
<th>Processor module</th>
<th>PM5630</th>
<th>PM5650</th>
<th>PM5670</th>
<th>PM5675</th>
</tr>
</thead>
<tbody>
<tr>
<td>TB5600-2ETH</td>
<td>0 slot</td>
<td>0 slot</td>
<td>0 slot</td>
<td>0 slot</td>
</tr>
<tr>
<td>TB5610-2ETH</td>
<td>1 slot</td>
<td>1 slot</td>
<td>1 slot</td>
<td>1 slot</td>
</tr>
<tr>
<td>TB5620-2ETH</td>
<td>2 slots</td>
<td>2 slots</td>
<td>2 slots</td>
<td>2 slots</td>
</tr>
<tr>
<td>TB5640-2ETH</td>
<td>-</td>
<td>4 slots</td>
<td>4 slots</td>
<td>4 slots</td>
</tr>
<tr>
<td>TB5660-2ETH</td>
<td>-</td>
<td>-</td>
<td>6 slots</td>
<td>6 slots</td>
</tr>
</tbody>
</table>

Remarks:
The slots can be used for connecting communication modules or AC500-S modules. Note that only one AC500-S module can be connected at one terminal base.

1) PM567x must have an index $\geq C0$. 

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

**) The needed spring terminal block is always delivered with the option board. The terminal block listed in the table is for spare part only if needed.
Supported devices

The AC500 V3 terminal bases can be equipped with the following supported devices:

Table 81: Comparison: TB56xx

<table>
<thead>
<tr>
<th>Processor module</th>
<th>PM5630</th>
<th>PM5650</th>
<th>PM5670</th>
<th>PM5675</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max. number of variables allowed for each communication module supported</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input variables</td>
<td>4 kB</td>
<td>4 kB</td>
<td>5 kB</td>
<td>5 kB</td>
</tr>
<tr>
<td>Output variables</td>
<td>4 kB</td>
<td>4 kB</td>
<td>5 kB</td>
<td>5 kB</td>
</tr>
</tbody>
</table>

Type of communication module supported

| CM574-RS/RCOM - serial interface | No     | No     | No     | No     |
| CM5610-2RS - 2 serial interfaces | x      | x      | x      | x      |
| CM582-DP - PROFIBUS DP V0/V1 slave | x      | x      | x      | x      |
| CM592-DP - PROFIBUS DP V0/V1 master | x      | x      | x      | x      |
| CM579-ETHCAT - EtherCAT master | x      | x      | x      | x      |
| CM579-PNIO - PROFINET IO RT controller | x      | x      | x      | x      |
| CM589-PNIO - PROFINET IO RT device | x      | x      | x      | x      |
| CM589-PNIO-4 - PROFINET IO RT with 4 devices | x      | x      | x      | x      |
| CM597-ETH - Ethernet interface | No     | No     | No     | No     |
| CM5640-2ETH - 2 Ethernet interfaces | x      | x      | x      | x      |
| CM588-CN - CAN, CANopen slave | No     | No     | No     | No     |
| CM598-CN - CAN, CANopen master | only CAN 2A/2B | only CAN 2A/2B | only CAN 2A/2B | only CAN 2A/2B |

Type of AC500-S module supported

| SM560-S - safety module | x | x | x | x |
| SM560-S-FD-1 - safety module with F-Device functionality for 1 PROFIsafe network | x | x | x | x |
| SM560-S-FD-4 - safety module with F-Device functionality for 1 PROFIsafe network | x | x | x | x |

Memory size and performance

Table 82: Comparison: PM56xx

<table>
<thead>
<tr>
<th>Processor module</th>
<th>PM5630</th>
<th>PM5650</th>
<th>PM5670</th>
<th>PM5675</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total maximum downloadable application size</td>
<td>9 MB</td>
<td>84 MB</td>
<td>176 MB</td>
<td>176 MB</td>
</tr>
<tr>
<td>Thereof user program code and data (dynamically allocated)</td>
<td>2 MB</td>
<td>9 MB</td>
<td>32 MB</td>
<td>32 MB</td>
</tr>
<tr>
<td>Thereof user webserver data max.</td>
<td>6 MB</td>
<td>72 MB</td>
<td>128 MB</td>
<td>128 MB</td>
</tr>
<tr>
<td>Flash memory for User data</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remaining for all other usage (project save, infrastructure...)</td>
<td>30 MB</td>
<td>285 MB</td>
<td>643 MB</td>
<td>643 MB</td>
</tr>
<tr>
<td>Buffered (SRAM)</td>
<td>256 kB</td>
<td>256 kB</td>
<td>1.5 MB</td>
<td>1.5 MB</td>
</tr>
<tr>
<td>Thereof VAR retain persistent</td>
<td>128 kB</td>
<td>128 kB</td>
<td>1024 kB</td>
<td>1024 kB</td>
</tr>
<tr>
<td>Processor module</td>
<td>PM5630</td>
<td>PM5650</td>
<td>PM5670</td>
<td>PM5675</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>Thereof %M memory (e.g. Modbus register)</td>
<td>128 kB</td>
<td>128 kB</td>
<td>512 kB</td>
<td>512 kB</td>
</tr>
<tr>
<td>Expandable memory</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Integrated mass storage memory (FLASH)</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>8 GB</td>
</tr>
<tr>
<td>Slot for pluggable memory card</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Processor type</td>
<td>TI ARM Cortex-A9 32-bit-RISC</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Processor clock speed</td>
<td>300 MHz</td>
<td>600 MHz</td>
<td>1 GHz</td>
<td>1 GHz</td>
</tr>
<tr>
<td>Cycle time for 1 instruction (minimum):</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Binary</td>
<td>Min. 0.02 µs</td>
<td>Min. 0.01 µs</td>
<td>Min. 0.002 µs</td>
<td>Min. 0.002 µs</td>
</tr>
<tr>
<td>Word</td>
<td>Min. 0.02 µs</td>
<td>Min. 0.01 µs</td>
<td>Min. 0.002 µs</td>
<td>Min. 0.002 µs</td>
</tr>
<tr>
<td>Floating point</td>
<td>Min. 0.12 µs</td>
<td>Min. 0.01 µs</td>
<td>Min. 0.002 µs</td>
<td>Min. 0.002 µs</td>
</tr>
<tr>
<td>Mathematic co-processor</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Motion capability</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>No. synchronized axis per 1 ms on EtherCAT CM typically</td>
<td>-</td>
<td>8*</td>
<td>16*</td>
<td>16*</td>
</tr>
<tr>
<td>No. synchronized axis per 2 ms on EtherCAT CM typically</td>
<td>4*</td>
<td>16*</td>
<td>32*</td>
<td>32*</td>
</tr>
<tr>
<td>No. synchronized axis per 4 ms on EtherCAT CM or CANopen onboard typically</td>
<td>8*</td>
<td>32*</td>
<td>64*</td>
<td>64*</td>
</tr>
<tr>
<td>Min. bus cycle time for EtherCAT using external CM579</td>
<td>2 ms</td>
<td>1 ms</td>
<td>0.5 ms</td>
<td>0.5 ms</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>* in addition: 1 virtual axis</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Max. number of central inputs and outputs (10 exp. modules):</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Digital inputs</td>
<td>320</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Digital outputs</td>
<td>320</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Analog inputs</td>
<td>160</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Analog outputs</td>
<td>160</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of decentralized inputs and outputs</td>
<td>Depends on the used fieldbus</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data backup</td>
<td>Battery</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data buffering time at 25 °C</td>
<td>Typ. 3 years</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Battery low indication</td>
<td>via application program</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Real-time clock:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>With battery backup</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Accuracy</td>
<td>Typ. ± 2 s / day at +25 °C</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Processor module</td>
<td>PM5630</td>
<td>PM5650</td>
<td>PM5670</td>
<td>PM5675</td>
</tr>
<tr>
<td>------------------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>Program execution:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cyclic</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time-controlled</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Multitasking</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Minimum cycle time configurable for cyclical task</td>
<td>1 ms</td>
<td>1 ms</td>
<td>0,5 ms</td>
<td>0,5 ms</td>
</tr>
<tr>
<td>User program protection by password</td>
<td>x (user management)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Internal interfaces for communication:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Serial interface COM1:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Physical link</td>
<td>Configurable for RS-232 or RS-485 (9.6 kb/s, 19.2 kb/s, 38.4 kb/s, 57.6 kb/s and 115.2 kb/s)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Connection</td>
<td>Pluggable terminal block, spring connection</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Usage</td>
<td>Serial ASCII communication, Modbus RTU</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAN interface:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Physical link</td>
<td>CAN 2A/2B (from 50 kb/s to 1 Mb/s)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Connection</td>
<td>Pluggable terminal block, spring connection</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Usage</td>
<td>CANopen master communication, CAN 2A/2B, J1939 protocol, CAN sync</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Max. number of variables allowed</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input variables</td>
<td>2 kB</td>
<td>4 kB</td>
<td>5 kB</td>
<td>5 kB</td>
</tr>
<tr>
<td>Output variables</td>
<td>2 kB</td>
<td>4 kB</td>
<td>5 kB</td>
<td>5 kB</td>
</tr>
<tr>
<td>Network interface ETH1, ETH2:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Usage</td>
<td>Ethernet</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Physical link</td>
<td>10/100 base-TX, configurable as internal switch or independent Interfaces</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Connection</td>
<td>2x RJ45 socket, provided on TB56xx-2ETH</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LEDs, LCD display, function keys</td>
<td>RUN / STOP, status, diagnosis, settings</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of timers</td>
<td>Unlimited</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of counters</td>
<td>Unlimited</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Programming languages:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Structured Text ST</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Instruction list IL</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Function Block Diagram FBD</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ladder Diagram LD</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sequential function chart SFC</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Continuous function chart (CFC)</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Remarks:
1): The values are for information only and cannot be fulfilled altogether. The available resources are limited at the end by the maximal downloadable application size for each CPU.

Comparison of features and protocols

<table>
<thead>
<tr>
<th>Processor module</th>
<th>PM5630</th>
<th>PM5650</th>
<th>PM5670</th>
<th>PM5675</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPC UA server</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Number of free tags</td>
<td>3.000</td>
<td>10.000</td>
<td>30.000</td>
<td>30.000</td>
</tr>
<tr>
<td>Number of connections</td>
<td>10</td>
<td>20</td>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td>Min. sampling rate (limit)</td>
<td>500 ms</td>
<td>100 ms</td>
<td>50 ms</td>
<td>50 ms</td>
</tr>
<tr>
<td>OPC DA server AE</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Number of connections</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>8</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Processor module</th>
<th>PM5630</th>
<th>PM5650</th>
<th>PM5670</th>
<th>PM5675</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modbus TCP client / server</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Number of Modbus clients ModMast in parallel on a CPU master (server)</td>
<td>30</td>
<td>50</td>
<td>120</td>
<td>120</td>
</tr>
<tr>
<td>Number of Modbus server in parallel (e.g. for SCADA access)</td>
<td>15</td>
<td>25</td>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td>IEC 60870-5-104 telecontrol protocol</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Number of free tags</td>
<td>1.000</td>
<td>5.000</td>
<td>10.000</td>
<td>10.000</td>
</tr>
<tr>
<td>Control station (number of connections)</td>
<td>5</td>
<td>10</td>
<td>20</td>
<td>20</td>
</tr>
<tr>
<td>Sub-station (number of connections)</td>
<td>5</td>
<td>10</td>
<td>20</td>
<td>20</td>
</tr>
</tbody>
</table>

Ethernet protocols and ports for AC500 V3 products

General

The communication module CM5640-2ETH acts as a port extender of the used AC500 V3 CPU. It is not offloading the CPU for the protocols.
- the stacks are still executed in CPU.
- the performance is slightly lower or the load is slightly higher than directly from the main CPU, because each communication module and the communication module bus must also be handled.

Each CM5640-2ETH provides:
- 2 additional independent onboard Ethernet interfaces controlled by the CPU and not switched.
- all Ethernet ports, wherever located - on the communication module or on the CPU - must be in different subnets.
  Addressing is not done via slot numbers but via IP addresses.
The Ethernet limitations of the CPU used together with CM5640-2ETH apply to all onboard and additional interfaces.

All interfaces of the onboard and CM5640-2ETH modules need to be in different subnets. Overlapping of subnets must be avoided. The selection of the used interface (ETH port) is done automatically according the match of the IP-address of the server and the subnet of the interfaces.
<table>
<thead>
<tr>
<th>Description</th>
<th>≥ CPU firmware</th>
<th>PM563 0-2ET H</th>
<th>PM565 0-2ET H</th>
<th>PM567 0-2ET H</th>
<th>PM567 5-2ET H</th>
<th>≥ CPU firmware</th>
<th>CM564 0-2ETH</th>
</tr>
</thead>
<tbody>
<tr>
<td>IEC 61850 (MMS server, GOOSE) ²)</td>
<td>V3.1.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>EthernetIP Scanner ¹, ²)</td>
<td>AB 2.4.1/FW 3.4.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>AB 2.6.0/FW 3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>EthernetIP Adapter ¹, ²)</td>
<td>AB 2.4.1/FW 3.4.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>AB 2.6.0/FW 3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>KNX - Building communication ²)</td>
<td>V3.2.x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>BACnet-BC - Infrastructure communication ²)</td>
<td>V3.3.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>HTTPS – secure web server on PLC with CODESYS web visualization</td>
<td>V3.1.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>WebVisu for data visualisation on web server HTML5</td>
<td>V3.0.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>HTTPS – secure FTP</td>
<td>V3.1.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>Secure online access with driver 3S UDP BlkDrvUdp</td>
<td>V3.1.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>Secure online access with driver 3S TCP/IP BlkDrvTcp</td>
<td>V3.1.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>ICMP – ping out of user project with POU ETHx_ICMP_PING or EthIcmpPing (PLCopen style)</td>
<td>V3.1.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>Modbus TCP client (master) with ModTcpMast (PLCopen style)</td>
<td>V3.1.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>Remarks:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>¹): in preparation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>²): feature is licensed</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Default open Ethernet ports of PM56xx-2ETH

After startup without a PLC project the PM56xx-2ETH contains the following Ethernet ports and sockets:

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABB NetConfig ¹)</td>
<td>UDP 24576</td>
</tr>
<tr>
<td>Online access with driver 3S Tcp/Ip BlkDrvTcp (no scan)</td>
<td>TCP 11740</td>
</tr>
</tbody>
</table>
### Protocol Port

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPC UA server</td>
<td>TCP 4840</td>
</tr>
</tbody>
</table>

### Remarks:

1): The port 24576 for ABB NetConfig protocol can be disabled via PLC configuration by deleting the protocol node from configuration tree of Ethernet interfaces ETH1 and ETH2.

2): The port 4840 for OPC UA server is closed by default as of SystemFW V3.6.0.

All other ports are closed by default.

### Overview of protocols, sockets and ports

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Port</th>
<th>Sockets</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABB netConfig</td>
<td>24576</td>
<td>1 permanent socket per interface</td>
<td></td>
</tr>
<tr>
<td>3S gateway client (e.g. CODESYS) to gateway server</td>
<td>1217</td>
<td>1 permanent socket</td>
<td></td>
</tr>
<tr>
<td>Online access with driver 3S block driver TCP/IP (no scan)</td>
<td>11740</td>
<td>1 socket per connection + 1 listen</td>
<td></td>
</tr>
<tr>
<td>Modbus TCP server</td>
<td>502 or configurable</td>
<td>1 socket listen + 1 socket per server connection, number of server connections is configurable in AB</td>
<td></td>
</tr>
<tr>
<td>Modbus TCP client with POU ModTcpMast</td>
<td>Random</td>
<td>1 socket per connection with POU ModTcpMast</td>
<td></td>
</tr>
<tr>
<td>UDP out of user program with library SysLibSockets.lib</td>
<td>1 ... 65535</td>
<td>1 socket per connection</td>
<td></td>
</tr>
<tr>
<td>TCP/IP out of user program with library SysLibSockets.lib</td>
<td>1 ... 65535</td>
<td>1 socket per connection</td>
<td></td>
</tr>
<tr>
<td>Web server on PLC with web visualization</td>
<td>80</td>
<td>1 listen and 1 per connection</td>
<td></td>
</tr>
<tr>
<td>NTP/SNTP client</td>
<td>123</td>
<td>1 permanent socket</td>
<td></td>
</tr>
<tr>
<td>IEC60870-5-104 control station</td>
<td>Random</td>
<td>1 per connection</td>
<td></td>
</tr>
<tr>
<td>IEC60870-5-104 substation</td>
<td>2404</td>
<td>1 per connection</td>
<td></td>
</tr>
<tr>
<td>FTP server</td>
<td>Command port = 21, Data active mode = 20, Data passive mode = random</td>
<td>1 per session, max. 4 allowed</td>
<td></td>
</tr>
<tr>
<td>CODESYS network variables</td>
<td>1202</td>
<td>(UDP broadcast)</td>
<td></td>
</tr>
<tr>
<td>OPC DA server (default 3S block driver)</td>
<td>UDP = 1740 or TCP/IP =11740</td>
<td>1 socket per connection</td>
<td></td>
</tr>
<tr>
<td>OPC UA server</td>
<td>4840</td>
<td>1 permanent socket</td>
<td></td>
</tr>
<tr>
<td>ICMP – ping out of user project with POU ETHx_ICMP_PING DHCP</td>
<td>none</td>
<td>No socket</td>
<td></td>
</tr>
<tr>
<td>DHCP</td>
<td>67</td>
<td>1 socket during startup</td>
<td></td>
</tr>
<tr>
<td>Protocol</td>
<td>Port</td>
<td>Sockets</td>
<td></td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>-------</td>
<td>--------------------------------</td>
<td></td>
</tr>
<tr>
<td>NTP/SNTP ((Simple) Network Time Protocol) client system solution</td>
<td>123</td>
<td>1 permanent socket</td>
<td></td>
</tr>
<tr>
<td>Chapter 6.3.4.4.2 “(S)NTP client configuration” on page 1718</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NTP/SNTP ((Simple) Network Time Protocol) server system solution</td>
<td>123</td>
<td>1 permanent socket</td>
<td></td>
</tr>
<tr>
<td>Chapter 6.3.4.4.3 “(S)NTP server configuration” on page 1720</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HTTPS – secure web server on PLC with CODESYS web visualization</td>
<td>443</td>
<td>1 listen and 1 per connection</td>
<td></td>
</tr>
<tr>
<td>Chapter 6.3.4.7.3.2 “Secure web server” on page 1727</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FTPS – secure FTP</td>
<td></td>
<td>1 per session, max. 4 allowed</td>
<td></td>
</tr>
<tr>
<td>Chapter 6.3.4.7.3.3 “Secure FTP” on page 1728</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Secure online access with driver 3S TCP/IP BlkDrvTcp</td>
<td>11740</td>
<td>1 socket per connection + 1 listen</td>
<td></td>
</tr>
<tr>
<td>ICMP – ping out of user project with POU ETHx_ICMP_PING or EthicmpPing (PLCopen style)</td>
<td>None</td>
<td>No socket</td>
<td></td>
</tr>
<tr>
<td>Modbus TCP client (master) with POU ModTcpMast (PLCopen style)</td>
<td>Random</td>
<td>1 socket per connection with POU ModTcpMast</td>
<td></td>
</tr>
</tbody>
</table>

**Limitation of connections per protocol**

The limitation for each CPU apply to all onboard Ethernet interfaces either directly on the CPU itself or also on all CM5640-2ETH interfaces that are added to this CPU.

<table>
<thead>
<tr>
<th>Protocol</th>
<th>PM5630-2ETH</th>
<th>PM5650-2ETH</th>
<th>PM5670-2ETH</th>
<th>PM5675-2ETH</th>
<th>≥ CPU firmware</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modbus TCP server (e.g. for SCADA access)</td>
<td>30</td>
<td>40</td>
<td>10</td>
<td>100</td>
<td>3.0.3</td>
</tr>
<tr>
<td></td>
<td>40</td>
<td>40</td>
<td>40</td>
<td>40</td>
<td>3.1.0</td>
</tr>
<tr>
<td></td>
<td>15</td>
<td>25</td>
<td>50</td>
<td>50</td>
<td>3.1.3</td>
</tr>
<tr>
<td>Modbus TCP client with POU ModTcpMast (PLCopen style)</td>
<td>30</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>3.1.0</td>
</tr>
<tr>
<td></td>
<td>30</td>
<td>50</td>
<td>120</td>
<td>120</td>
<td>3.1.3</td>
</tr>
<tr>
<td>IEC60870-5-104 control station incl. 2nd connection and 2nd port</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>3.1.0</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>10</td>
<td>20</td>
<td>20</td>
<td>3.4.0</td>
</tr>
<tr>
<td>IEC60870-5-104 substation incl. 2nd port</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>3.1.0</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>10</td>
<td>20</td>
<td>20</td>
<td>3.4.0</td>
</tr>
<tr>
<td>IEC60870-5-104: No. of free tags + additional license for extension ¹)</td>
<td>1.000</td>
<td>5.000</td>
<td>10.000</td>
<td>10.000</td>
<td>3.4.0</td>
</tr>
</tbody>
</table>
### Protocol

<table>
<thead>
<tr>
<th>Protocol</th>
<th>PM5630-2ETH</th>
<th>PM5650-2ETH</th>
<th>PM5670-2ETH</th>
<th>PM5675-2ETH</th>
<th>≥ CPU firmware</th>
</tr>
</thead>
<tbody>
<tr>
<td>FTP server</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>3.1.0</td>
</tr>
<tr>
<td>Online access with driver 3S TCP/IP BlkDrvTcp</td>
<td>n/a</td>
<td>8</td>
<td>n/a</td>
<td>8</td>
<td>3.0.0</td>
</tr>
<tr>
<td>OPC DA server (number of connections)</td>
<td>n/a</td>
<td>8</td>
<td>n/a</td>
<td>8</td>
<td>3.0.0</td>
</tr>
<tr>
<td>OPC UA server (number of connections)</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>3.1.0</td>
</tr>
<tr>
<td>No. of free tags + additional license for extension ¹)</td>
<td>1.000</td>
<td>5.000</td>
<td>30.000</td>
<td>30.000</td>
<td>3.4.0</td>
</tr>
<tr>
<td>min sampling rate (limit)</td>
<td>500 ms</td>
<td>100 ms</td>
<td>50 ms</td>
<td>50 ms</td>
<td>3.4.0</td>
</tr>
<tr>
<td>Secure online access with driver 3S TCP/IP BlkDrvTcp</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>3.1.0</td>
</tr>
<tr>
<td>FTPS - secure FTP server</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>3.1.0</td>
</tr>
<tr>
<td>HTTPS – Integrated webserver – number of connections</td>
<td>4</td>
<td>8</td>
<td>12</td>
<td>12</td>
<td>3.4.0</td>
</tr>
<tr>
<td>Ethernet/IP</td>
<td>0.5 kB/0.5 kB</td>
<td>0.5 kB/0.5 kB</td>
<td>0.5 kB/0.5 kB</td>
<td>0.5 kB/0.5 kB</td>
<td>3.4.1</td>
</tr>
<tr>
<td>Maximum number of Input/Output</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Remarks:

¹): in preparation

The PLC types PM5630-2ETH, PM5670-2ETH and PM5675-2ETH are available as of SystemFW 3.1.0.

### Default Ethernet configuration

<table>
<thead>
<tr>
<th>Module</th>
<th>IP Address</th>
<th>Netmask</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>PM5xx2-x-ETH</td>
<td>ETH: 192.168.0.10</td>
<td>255.255.255.0</td>
<td>The Ethernet ports must be configured in different sub networks.</td>
</tr>
<tr>
<td>PM50x2-T-2ETH</td>
<td>ETH1: 192.168.0.10, ETH2: 192.168.1.10</td>
<td>255.255.255.0</td>
<td>The Ethernet ports must be configured in different sub networks.</td>
</tr>
<tr>
<td>PM56xx-2ETH</td>
<td>ETH1: 192.168.0.10, ETH2: 192.168.1.10</td>
<td>255.255.255.0</td>
<td>The Ethernet ports must be configured in different sub networks.</td>
</tr>
</tbody>
</table>
Changing the IP addresses using the Automation Builder

Changing the IP addresses using the CFG key

**Online access**

3S TCP/IP block driver. This driver requires at least 2 sockets:

- 1x driver “BlkDrvTcp” on port 11740
- 1x listen on port 11740 if PLC has established online connection

<table>
<thead>
<tr>
<th>Online access can be established from:</th>
</tr>
</thead>
<tbody>
<tr>
<td>– Automation Builder command ‘Login’</td>
</tr>
<tr>
<td>– Chapter 6.4.1.21.3.7.2 “Command</td>
</tr>
<tr>
<td>‘Login’” on page 2624</td>
</tr>
<tr>
<td>– CODESYS OPC DA server</td>
</tr>
<tr>
<td>– Panel CP600 series</td>
</tr>
</tbody>
</table>

Each established connection needs one socket. In addition one socket on port 11740 is listening.

1. Startup the PLC.
   - One socket on port 11740 (listen).
2. Login from Automation Builder via driver “BlkDrvTcp”.
   - 2 sockets on port 11740 (1x online, 1x listen)
3. Additional login out of OPC server with the same driver.
   - 3 sockets on port 11740 (2x online, 1x listen)
4. Additional connect CP600 via driver “BlkDrvTcp”.
   - 4 sockets on port 11740 (3x online, 1x listen)

**5.2.1.2.2 PM56xx-2ETH for AC500 V3 products**

**Features**

Processor modules with onboard interfaces:

- PM5630-2ETH: processor module, memory 8 MB, with Ethernet support (onboard Ethernet) – 2 network interfaces RJ45, CAN and COM1 on the terminal base.
- PM5650-2ETH: processor module, memory 80 MB, with Ethernet support (onboard Ethernet) – 2 network interfaces RJ45, CAN and COM1 on the terminal base.
- PM5670-2ETH: processor module, memory 160 MB, with Ethernet support (onboard Ethernet) – 2 network interfaces RJ45, CAN and COM1 on the terminal base.
- PM5675-2ETH: processor module, 160 MB, 8 GB flash disk, with Ethernet support (onboard Ethernet) – 2 network interfaces RJ45, CAN and COM1 on the terminal base.
- XC version for use in extreme ambient conditions available
Short description

The processor modules are the central units of the control system AC500. The types differ in their performance (memory size, speed etc.). Each processor module must be mounted on a suitable terminal base.

The terminal base type (TB56xx) depends on the number of communication modules which are used together with the processor module.
Table 85: Comparison: TB56xx

<table>
<thead>
<tr>
<th>Processor module</th>
<th>PM5630</th>
<th>PM5650</th>
<th>PM5670</th>
<th>PM5675</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max. number of variables allowed for each communication module supported</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input variables</td>
<td>4 kB</td>
<td>4 kB</td>
<td>5 kB</td>
<td>5 kB</td>
</tr>
<tr>
<td>Output variables</td>
<td>4 kB</td>
<td>4 kB</td>
<td>5 kB</td>
<td>5 kB</td>
</tr>
<tr>
<td>Type of communication module supported</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CM574-RS/RCom - serial interface</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>CM5610-2RS - 2 serial interfaces</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>CM582-DP - PROFIBUS DP V0/V1 slave</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>CM592-DP - PROFIBUS DP V0/V1 master</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>CM579-EthCAT - EtherCAT master</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>CM579-PNIO - PROFINET IO RT controller</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>CM589-PNIO - PROFINET IO RT device</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>CM589-PNIO-4 - PROFINET IO RT with 4 devices</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>CM597-ETH - Ethernet interface</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>CM5640-2ETH - 2 Ethernet interfaces</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>CM588-CN - CAN, CANopen slave</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>CM598-CN - CAN, CANopen master</td>
<td>only CAN 2A/2B</td>
<td>only CAN 2A/2B</td>
<td>only CAN 2A/2B</td>
<td>only CAN 2A/2B</td>
</tr>
<tr>
<td>Type of AC500-S module supported</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SM560-S - safety module</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>SM560-S-FD-1 - safety module with F-Device functionality for 1 PROFIsafe network</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>SM560-S-FD-4 - safety module with F-Device functionality for 1 PROFIsafe network</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

All terminal bases (TB56xx) provide the same communication interfaces (ETH1, ETH2, CAN and COM1) \( \checkmark \) Chapter 5.2.3.1.4 “Technical data” on page 383.

All other V3 processor modules can operate multiple communication modules via their communication module interface.

The communication modules are mounted on the left side of the processor module on the same terminal base.

On the right side of the processor module, up to 10 digital or analog I/O expansion modules can be connected to the I/O bus. Each I/O module requires a suitable terminal unit depending on the module type.

Terminal bases, terminal units, I/O modules, communication modules and accessories have their own technical descriptions.

Each processor module can be used as:
- Stand-alone processor module
- Stand-alone processor module with local I/Os
- Remote IO server
- Remote IO client

The processor modules are powered with 24 V DC.
WARNING!
Removal/Insertion under power

The devices are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you
- connect or disconnect any signal or terminal block
- remove, mount or replace a module.

Disconnecting any powered devices while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The devices must not be opened when in operation. The same applies to the network interfaces.

Connections

All terminals for connection are available on the terminal base. For information on connection and available interfaces see the descriptions for
- Chapter 5.2.3.1 “TB56xx for AC500 V3 products” on page 377.

Processor modules PM56xx-2ETH can only be used with TB56xx-2ETH terminal bases.

<table>
<thead>
<tr>
<th>Processor module</th>
<th>PM5630</th>
<th>PM5650</th>
<th>PM5670</th>
<th>PM5675</th>
</tr>
</thead>
<tbody>
<tr>
<td>TB5600-2ETH</td>
<td>0 slot</td>
<td>0 slot</td>
<td>0 slot</td>
<td>0 slot</td>
</tr>
<tr>
<td>TB5610-2ETH</td>
<td>1 slot</td>
<td>1 slot</td>
<td>1 slot</td>
<td>1 slot</td>
</tr>
<tr>
<td>TB5620-2ETH</td>
<td>2 slots</td>
<td>2 slots</td>
<td>2 slots</td>
<td>2 slots</td>
</tr>
<tr>
<td>TB5640-2ETH</td>
<td>-</td>
<td>4 slots</td>
<td>4 slots</td>
<td>4 slots</td>
</tr>
<tr>
<td>TB5660-2ETH</td>
<td>-</td>
<td>-</td>
<td>6 slots</td>
<td>6 slots</td>
</tr>
</tbody>
</table>

Remarks:
The slots can be used for connecting communication modules or AC500-S modules. Note that only one AC500-S module can be connected at one terminal base.

1) PM567x must have an index ≥ C0.

Storage elements

Lithium battery

The processor modules are supplied without lithium battery. It must be ordered separately. The TA521 lithium battery is used for data (SRAM) and RTC buffering while the processor module is not powered.

Chapter 6.8.2.3.2 “AC500 battery” on page 4445
The CPU monitors the discharge degree of the battery. A warning is issued before the battery condition becomes critical (about 2 weeks before). Once the warning message appears, the battery should be replaced as soon as possible.

The technical data, handling instructions and the insertion/replacement of the battery is described in detail in the chapter TA521 lithium battery § Chapter 5.2.8.2.3 "TA521 - Battery" on page 1319.

**Memory card**

AC500 processor modules are supplied without memory card. It must be ordered separately.

The memory card can be used
- to read and write user files,
- to download a user program,
- for firmware updates,
- for program source code storage.

AC500 processor modules can be operated with and without memory cards. The processor module uses a standard file system (FAT). This allows standard card readers to read and write the memory cards.

§ Further information

**LEDs, display and function keys on the front panel**

![Diagram of AC500 processor module front panel]

§ Detailed information on using the LEDs, display and the function keys such as startup procedure and error coding

**Technical data**

The system data of AC500 and S500 are applicable to the standard version. § Chapter 5.1.2 "System data AC500" on page 166
The system data of AC500-XC are applicable to the XC version. "Chapter 5.1.3 “System data AC500-XC” on page 169"

Only additional details are therefore documented below. The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection of the supply voltage 24 V DC at the terminal base of the processor module</td>
<td>Removable 5-pin terminal block with spring connection</td>
</tr>
<tr>
<td>Current consumption on 24 V DC</td>
<td></td>
</tr>
</tbody>
</table>
| Min. typ. (module alone) | PM5630-2ETH: 110 mA  
PM5650-2ETH: 120 mA  
PM5670-2ETH: 140 mA  
PM5675-2ETH: 140 mA |
| Max. typ. (all communication modules and I/Os) | PM5630-2ETH: 850 mA  
PM5650-2ETH: 900 mA  
PM5670-2ETH: 950 mA  
PM5675-2ETH: 950 mA |
| Number of slots for processor modules | 1 (on all terminal bases) |
| Processor module interfaces at the terminal bases TB56xx | I/O bus, ETH1, ETH2, CAN, COM1 |
| Weight (processor module without terminal base) | 135 g |
| Mounting position | Horizontal or vertical |

**Table 87: Comparison: PM56xx**

<table>
<thead>
<tr>
<th>Processor module</th>
<th>PM5630</th>
<th>PM5650</th>
<th>PM5670</th>
<th>PM5675</th>
</tr>
</thead>
</table>
| Total maximum downloadable application size 1) | 9 MB  
84 MB  
176 MB  
176 MB |
| Thereof user program code and data (dynamically allocated) | 2 MB  
8 MB  
32 MB  
32 MB |
| Thereof user webservice data max. | 6 MB  
72 MB  
128 MB  
128 MB |
| Flash memory for User data |  |
| Remaining for all other usage (project save, infrastructure...) | 30 MB  
285 MB  
643 MB  
643 MB |
| Buffered (SRAM) | 256 kB  
256 kB  
1.5 MB  
1.5 MB |
| Thereof VAR retain persistent | 128 kB  
128 kB  
1024 kB  
1024 kB |
| Thereof %M memory (e.g. Modbus register) | 128 kB  
128 kB  
512 kB  
512 kB |
| Expandable memory | None  
None  
None  
None |
| Integrated mass storage memory (FLASH) | None  
None  
None  
8 GB |
| Slot for pluggable memory card | x  
x  
x  
x |
## Processor module

<table>
<thead>
<tr>
<th>Processor module</th>
<th>PM5630</th>
<th>PM5650</th>
<th>PM5670</th>
<th>PM5675</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Processor type</strong></td>
<td>TI ARM Cortex-A9 32-bit-RISC</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Processor clock speed</strong></td>
<td>300 MHz</td>
<td>600 MHz</td>
<td>1 GHz</td>
<td>1 GHz</td>
</tr>
<tr>
<td><strong>Cycle time for 1 instruction (minimum):</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Binary Min.</td>
<td>0.02 µs</td>
<td>Min. 0.01 µs</td>
<td>Min. 0.002 µs</td>
<td>Min. 0.002 µs</td>
</tr>
<tr>
<td>Word Min.</td>
<td>0.02 µs</td>
<td>Min. 0.01 µs</td>
<td>Min. 0.002 µs</td>
<td>Min. 0.002 µs</td>
</tr>
<tr>
<td>Floating point Min.</td>
<td>0.12 µs</td>
<td>Min. 0.01 µs</td>
<td>Min. 0.002 µs</td>
<td>Min. 0.002 µs</td>
</tr>
<tr>
<td><strong>Mathematic co-processor</strong></td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td><strong>Motion capability</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>No. synchronized axis per 1 ms on EtherCAT CM typically</td>
<td>-</td>
<td>8*</td>
<td>16*</td>
<td>16*</td>
</tr>
<tr>
<td>No. synchronized axis per 2 ms on EtherCAT CM typically</td>
<td>4*</td>
<td>16*</td>
<td>32*</td>
<td>32*</td>
</tr>
<tr>
<td>No. synchronized axis per 4 ms on EtherCAT CM or CANopen onboard typically</td>
<td>8*</td>
<td>32*</td>
<td>64*</td>
<td>64*</td>
</tr>
<tr>
<td>Min. bus cycle time for EtherCAT using external CM579</td>
<td>2 ms</td>
<td>1 ms</td>
<td>0.5 ms</td>
<td>0.5 ms</td>
</tr>
<tr>
<td>* in addition: 1 virtual axis</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Max. number of central inputs and outputs (10 exp. modules):</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Digital inputs</td>
<td>320</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Digital outputs</td>
<td>320</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Analog inputs</td>
<td>160</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Analog outputs</td>
<td>160</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Number of decentralized inputs and outputs</strong></td>
<td>Depends on the used fieldbus</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Data backup</strong></td>
<td>Battery</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Data buffering time at 25 °C</strong></td>
<td>Typ. 3 years</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Battery low indication</strong></td>
<td>via application program</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Real-time clock:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>With battery backup</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Accuracy</td>
<td>Typ. ± 2 s / day at +25 °C</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Program execution:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cyclic</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time-controlled</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Multitasking</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Processor module</td>
<td>PM5630</td>
<td>PM5650</td>
<td>PM5670</td>
<td>PM5675</td>
</tr>
<tr>
<td>------------------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>Minimum cycle time configurable for cyclical task</td>
<td>1 ms</td>
<td>1 ms</td>
<td>0,5 ms</td>
<td>0,5 ms</td>
</tr>
<tr>
<td>User program protection by password</td>
<td>x</td>
<td>(user management)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Internal interfaces for communication:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Serial interface COM1:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Physical link</td>
<td>Configurable for RS-232 or RS-485 (9.6 kb/s, 19.2 kb/s, 38.4 kb/s, 57.6 kb/s and 115.2 kb/s)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Connection</td>
<td>Pluggable terminal block, spring connection</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Usage</td>
<td>Serial ASCII communication, Modbus RTU</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAN interface:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Physical link</td>
<td>CAN 2A/2B (from 50 kb/s to 1 Mb/s)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Connection</td>
<td>Pluggable terminal block, spring connection</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Usage</td>
<td>CANopen master communication, CAN 2A/2B, J1939 protocol, CAN sync</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Max. number of variables allowed</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input variables</td>
<td>2 kB</td>
<td>4 kB</td>
<td>5 kB</td>
<td>5 kB</td>
</tr>
<tr>
<td>Output variables</td>
<td>2 kB</td>
<td>4 kB</td>
<td>5 kB</td>
<td>5 kB</td>
</tr>
<tr>
<td>Network interface ETH1, ETH2:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Usage</td>
<td>Ethernet</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Physical link</td>
<td>10/100 base-TX, configurable as internal switch or independent Interfaces</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Connection</td>
<td>2x RJ45 socket, provided on TB56xx-2ETH</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LEDs, LCD display, function keys</td>
<td>RUN / STOP, status, diagnosis, settings</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of timers</td>
<td>Unlimited</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of counters</td>
<td>Unlimited</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Programming languages:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Structured Text ST</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Instruction list IL</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Function Block Diagram FBD</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ladder Diagram LD</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sequential function chart SFC</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Continuous function chart (CFC)</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Remarks:**
1): The values are for information only and cannot be fulfilled altogether. The available resources are limited at the end by the maximal downloadable application size for each CPU.
Table 88: Combination of TB56xx-2ETH(-XC) and PM56xx(-XC)

<table>
<thead>
<tr>
<th>Processor module</th>
<th>PM5630</th>
<th>PM5650</th>
<th>PM5670</th>
<th>PM5675</th>
</tr>
</thead>
<tbody>
<tr>
<td>TB5600-2ETH</td>
<td>0 slot</td>
<td>0 slot</td>
<td>0 slot</td>
<td>0 slot</td>
</tr>
<tr>
<td>TB5610-2ETH</td>
<td>1 slot</td>
<td>1 slot</td>
<td>1 slot</td>
<td>1 slot</td>
</tr>
<tr>
<td>TB5620-2ETH</td>
<td>2 slots</td>
<td>2 slots</td>
<td>2 slots</td>
<td>2 slots</td>
</tr>
<tr>
<td>TB5640-2ETH</td>
<td>-</td>
<td>4 slots</td>
<td>4 slots</td>
<td>4 slots</td>
</tr>
<tr>
<td>TB5660-2ETH</td>
<td>-</td>
<td>-</td>
<td>6 slots</td>
<td>6 slots</td>
</tr>
</tbody>
</table>

Remarks:
The slots can be used for connecting communication modules or AC500-S modules. Note that only one AC500-S module can be connected at one terminal base.

1) PM567x must have an index \( \geq C0 \).

Table 89: Comparison: TB56xx

<table>
<thead>
<tr>
<th>Processor module</th>
<th>PM5630</th>
<th>PM5650</th>
<th>PM5670</th>
<th>PM5675</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max. number of variables allowed for each communication module supported</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input variables</td>
<td>4 kB</td>
<td>4 kB</td>
<td>5 kB</td>
<td>5 kB</td>
</tr>
<tr>
<td>Output variables</td>
<td>4 kB</td>
<td>4 kB</td>
<td>5 kB</td>
<td>5 kB</td>
</tr>
<tr>
<td>Type of communication module supported</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CM574-RS/RCOM - serial interface</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>CM5610-2RS - 2 serial interfaces</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>CM582-DP - PROFIBUS DP V0/V1 slave</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>CM592-DP - PROFIBUS DP V0/V1 master</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>CM579-ETHCAT - EtherCAT master</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>CM579-PNIO - PROFINET IO RT controller</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>CM589-PNIO - PROFINET IO RT device</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>CM589-PNIO-4 - PROFINET IO RT with 4 devices</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>CM597-ETH - Ethernet interface</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>CM5640-2ETH - 2 Ethernet interfaces</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>CM588-CN - CAN, CANopen slave</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>CM598-CN - CAN, CANopen master</td>
<td>only CAN 2A/2B</td>
<td>only CAN 2A/2B</td>
<td>only CAN 2A/2B</td>
<td>only CAN 2A/2B</td>
</tr>
</tbody>
</table>

Type of AC500-S module supported

<table>
<thead>
<tr>
<th>Processor module</th>
<th>PM5630</th>
<th>PM5650</th>
<th>PM5670</th>
<th>PM5675</th>
</tr>
</thead>
<tbody>
<tr>
<td>SM560-S - safety module</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>SM560-S-FD-1 - safety module with F-Device functionality for 1 PROFIsafe network</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>SM560-S-FD-4 - safety module with F-Device functionality for 1 PROFIsafe network</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

Table 90: OPC UA server / OPC DA server

<table>
<thead>
<tr>
<th>Processor module</th>
<th>PM5630</th>
<th>PM5650</th>
<th>PM5670</th>
<th>PM5675</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPC UA server</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Number of free tags</td>
<td>3,000</td>
<td>10,000</td>
<td>30,000</td>
<td>30,000</td>
</tr>
</tbody>
</table>
### Processor module

<table>
<thead>
<tr>
<th></th>
<th>PM5630</th>
<th>PM5650</th>
<th>PM5670</th>
<th>PM5675</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of connections</td>
<td>10</td>
<td>20</td>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td>Min. sampling rate (limit)</td>
<td>500 ms</td>
<td>100 ms</td>
<td>50 ms</td>
<td>50 ms</td>
</tr>
<tr>
<td>OPC DA server AE</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Number of connections</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>8</td>
</tr>
</tbody>
</table>

**Table 91: Modbus, Telecontrol**

<table>
<thead>
<tr>
<th>Processor module</th>
<th>PM5630</th>
<th>PM5650</th>
<th>PM5670</th>
<th>PM5675</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modbus TCP client / server</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Number of Modbus clients ModMast in parallel on a CPU master (server)</td>
<td>30</td>
<td>50</td>
<td>120</td>
<td>120</td>
</tr>
<tr>
<td>Number of Modbus server in parallel (e.g. for SCADA access)</td>
<td>15</td>
<td>25</td>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td>IEC 60870-5-104 telecontrol protocol</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Number of free tags</td>
<td>1.000</td>
<td>5.000</td>
<td>10.000</td>
<td>10.000</td>
</tr>
<tr>
<td>Control station (number of connections)</td>
<td>5</td>
<td>10</td>
<td>20</td>
<td>20</td>
</tr>
<tr>
<td>Sub-station (number of connections)</td>
<td>5</td>
<td>10</td>
<td>20</td>
<td>20</td>
</tr>
</tbody>
</table>

### Dimensions

1. Dimensions:
   - Width: 84.5 (3.33) mm
   - Height: 77 (3.03) mm
   - Depth: 75 (2.95) mm
   - Height 2: 21 (0.83) mm
   - Depth 2: 54 (2.13) mm
   - Height 3: 59 (2.32) mm
   - Depth 3: 28 (1.10) mm

2. Hardware descriptions
   - Device specifications > Processor modules

3. Hardware dimensions:
   - Dimensions 15 mm
   - Dimensions 7.5 mm

4. Diagram:
   - Dimensions 135 (5.31) mm
   - Dimensions 67.5 (2.66) mm

1. Din rail 15 mm
2. Din rail 7.5 mm
Ordering data

Processor modules for AC500 (Standard) V3 products

To enable better product availability into the production and to provide some new features, a revision 3 of the existing AC500 V3 processor module was necessary. The existing AC500 V3 processor module revision 2 with rubric R0278 will move to classic and will be replaced by compatible new AC500 V3 processor module revision 3 with rubric R0378.

For example:
The processor module revision 3 PM5630-2ETH (1SAP131 000 R0378) replaces the existing processor module revision 2 PM5630-2ETH (1SAP 131 000 R0278) and provides the same features or functionality of the previous ones.

Following points must be considered with the processor module revision 3:

- The processor module revision 3 (R037x) requires a new BootFW / CPUFW from V3.6.x and higher.
- It cannot be downgraded and used with lower FW versions than V3.6.0.
- The processor module revision 3 (R037x) provides the same features as the processor module revision 2 (R027x) existing today and is fully compatible.
- An existing application using a processor module revision 2 (R027x) built with Automation Builder < 2.6 can run on a processor module revision 3 (R037x) but the application must be upgraded to at least AB 2.6.0 or higher.

What must be done using a new processor module revision 3 (R037x)?

- On a new application?
  - Just use the new processor module revision 3 (R037x)
  - Use the latest Automation Builder software from 2.6.0 or higher.

- On an existing application using an Automation Builder software version smaller than 2.6.0?
  - To use a new processor module revision 3 in an existing application (e.g., replacement of the processor module revision 2), the application must be upgraded to at least AB 2.6.0 or higher.
  - If several processor module (revision 3 and revision 2) are used within the same project, all the processor modules used in the same application must be upgraded to the FW Version V3.6.x and higher.
<table>
<thead>
<tr>
<th>Part no. (processor module revision)</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 131 000 R0278 (2)</td>
<td>PM5630-2ETH, processor module, memory 8 MB, 24 V DC, memory card slot, interface 1 RS-232/485, display, 2 RJ45 independent onboard Ethernet TCP/IP interfaces with Modbus TCP, web server, IEC60870-5-104 or selectable Ethernet based protocols</td>
<td>Classic (replaced by processor module revision 3)</td>
</tr>
<tr>
<td>1SAP 131 000 R0378 (3)</td>
<td>PM5630-2ETH, processor module, memory 8 MB, 24 V DC, memory card slot, interface 1 RS-232/485, display, 2 RJ45 independent onboard Ethernet TCP/IP interfaces with Modbus TCP, web server, IEC60870-5-104 or selectable Ethernet based protocols</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 331 000 R0278 (2)</td>
<td>PM5630-2ETH-XC, processor module, memory 8 MB, 24 V DC, memory card slot, interface 1 RS-232/485, display, 2 RJ45 independent onboard Ethernet TCP/IP interfaces with Modbus TCP, web server, IEC60870-5-104 or selectable Ethernet based protocols, XC version</td>
<td>Classic (replaced by processor module revision 3)</td>
</tr>
<tr>
<td>1SAP 331 000 R0378 (3)</td>
<td>PM5630-2ETH-XC, processor module, memory 8 MB, 24 V DC, memory card slot, interface 1 RS-232/485, display, 2 RJ45 independent onboard Ethernet TCP/IP interfaces with Modbus TCP, web server, IEC60870-5-104 or selectable Ethernet based protocols, XC version</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 141 000 R0278 (2)</td>
<td>PM5650-2ETH, processor module, memory 80 MB, 24 V DC, memory card slot, interface 1 RS-232/485, display, 2 RJ45 independent onboard Ethernet TCP/IP interfaces with Modbus TCP, web server, IEC60870-5-104 or selectable Ethernet based protocols</td>
<td>Classic (replaced by processor module revision 3)</td>
</tr>
<tr>
<td>1SAP 141 000 R0378 (3)</td>
<td>PM5650-2ETH, processor module, memory 80 MB, 24 V DC, memory card slot, interface 1 RS-232/485, display, 2 RJ45 independent onboard Ethernet TCP/IP interfaces with Modbus TCP, web server, IEC60870-5-104 or selectable Ethernet based protocols</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 341 000 R0278 (2)</td>
<td>PM5650-2ETH-XC, processor module, memory 80 MB, 24 V DC, memory card slot, interface 1 RS-232/485, display, 2 RJ45 independent onboard Ethernet TCP/IP interfaces with Modbus TCP, web server, IEC60870-5-104 or selectable Ethernet based protocols, XC version</td>
<td>Classic (replaced by processor module revision 3)</td>
</tr>
<tr>
<td>Part no.</td>
<td>Description</td>
<td>Product life cycle phase *)</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>1SAP 341 000 R0378 (processor module revision 3)</td>
<td>PM5650-2ETH-XC, processor module, memory 80 MB, 24 V DC, memory card slot, interface 1 RS-232/485, display, 2 RJ45 independent onboard Ethernet TCP/IP interfaces with Modbus TCP, web server, IEC60870-5-104 or selectable Ethernet based protocols, XC version</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 151 000 R0278 (processor module revision 2)</td>
<td>PM5670-2ETH, processor module, memory 160 MB, 24 V DC, memory card slot, interface 1 RS-232/485, display, 2 RJ45 independent onboard Ethernet TCP/IP interfaces with Modbus TCP, web server, IEC60870-5-104 or selectable Ethernet based protocols</td>
<td>Classic (replaced by processor module revision 3)</td>
</tr>
<tr>
<td>1SAP 151 000 R0378 (processor module revision 3)</td>
<td>PM5670-2ETH-XC, processor module, memory 160 MB, 24 V DC, memory card slot, interface 1 RS-232/485, display, 2 RJ45 independent onboard Ethernet TCP/IP interfaces with Modbus TCP, web server, IEC60870-5-104 or selectable Ethernet based protocols, XC version</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 351 000 R0278 (processor module revision 2)</td>
<td>PM5670-2ETH-XC, processor module, memory 160 MB, 24 V DC, memory card slot, interface 1 RS-232/485, display, 2 RJ45 independent onboard Ethernet TCP/IP interfaces with Modbus TCP, web server, IEC60870-5-104 or selectable Ethernet based protocols, XC version</td>
<td>Classic (replaced by processor module revision 3)</td>
</tr>
<tr>
<td>1SAP 151 000 R0378 (processor module revision 3)</td>
<td>PM5670-2ETH-XC, processor module, memory 160 MB, 24 V DC, memory card slot, interface 1 RS-232/485, display, 2 RJ45 independent onboard Ethernet TCP/IP interfaces with Modbus TCP, web server, IEC60870-5-104 or selectable Ethernet based protocols, XC version</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 151 500 R0278 (processor module revision 2)</td>
<td>PM5675-2ETH, processor module, memory 160 MB, 8 GB flash disk, 24 V DC, memory card slot, interface 1 RS-232/485, display, 2 RJ45 independent onboard Ethernet TCP/IP interfaces with Modbus TCP, web server, IEC60870-5-104 or selectable Ethernet based protocols</td>
<td>Classic (replaced by processor module revision 3)</td>
</tr>
<tr>
<td>1SAP 151 500 R0378 (processor module revision 3)</td>
<td>PM5675-2ETH, processor module, memory 160 MB, 8 GB flash disk, 24 V DC, memory card slot, interface 1 RS-232/485, display, 2 RJ45 independent onboard Ethernet TCP/IP interfaces with Modbus TCP, web server, IEC60870-5-104 or selectable Ethernet based protocols</td>
<td>Active</td>
</tr>
<tr>
<td>Part no.</td>
<td>Description</td>
<td>Product life cycle phase *)</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>1SAP 351 500 R0278 (processor module revision 2)</td>
<td>PM5675-2ETH-XC, processor module, memory 160 MB, 8 GB flash disk, 24 V DC, memory card slot, interface 1 RS-232/485, display, 2 RJ45 independent onboard Ethernet TCP/IP interfaces with Modbus TCP, web server, IEC60870-5-104 or selectable Ethernet based protocols, XC version</td>
<td>Classic (replaced by processor module revision 3)</td>
</tr>
<tr>
<td>1SAP 351 500 R0378 (processor module revision 3)</td>
<td>PM5675-2ETH-XC, processor module, memory 160 MB, 8 GB flash disk, 24 V DC, memory card slot, interface 1 RS-232/485, display, 2 RJ45 independent onboard Ethernet TCP/IP interfaces with Modbus TCP, web server, IEC60870-5-104 or selectable Ethernet based protocols, XC version</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 131 000 R0379</td>
<td>PM5630-MC-KIT: AC500, Machine Controller Kit with PM5630-2ETH, CM579-ETHCAT, TB5610-ETH, PS5611-MC</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 141 000 R0379</td>
<td>PM5650-MC-KIT: AC500, Machine Controller Kit with PM5650-2ETH, CM579-ETHCAT, TB5610-ETH, PS5611-MC</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 151 000 R0379</td>
<td>PM5670-MC-KIT: AC500, Machine Controller Kit with PM5670-2ETH, CM579-ETHCAT, TB5610-ETH, PS5611-MC</td>
<td>Active</td>
</tr>
</tbody>
</table>

**Required accessories**

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP xxx 300 R0278</td>
<td>TB56xx, terminal base</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

<table>
<thead>
<tr>
<th>Required accessories</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP xxx 300 R0278</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

<table>
<thead>
<tr>
<th>Optional accessories</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 180 300 R0001</td>
</tr>
<tr>
<td>1SAP 180 100 R00xx</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

<table>
<thead>
<tr>
<th>Optional accessories</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 180 300 R0001</td>
</tr>
<tr>
<td>1SAP 180 100 R00xx</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
5.2.2 Communication modules for AC500(-XC) processor modules

5.2.2.1 Features

AC500 communication modules are required for

- a connection to standard fieldbus systems and
- for integration into existing networks.

AC500 communication modules

- enable communication on different fieldbuses.
- are mounted on the left side of the processor module on the same terminal base.
- are directly powered via the internal communication module bus of the terminal base.

A separate voltage source is not required.
WARNING!

Removal/Insertion under power

The devices are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you

- connect or disconnect any signal or terminal block
- remove, mount or replace a module.

Disconnecting any powered devices while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The devices must not be opened when in operation. The same applies to the network interfaces.

The communication between the processor module and the communication modules takes place via the communication module bus, which is integrated in the terminal base. Depending on the used terminal base up to 6 communication modules can be connected.

- Chapter 5.2.3.1 “TB56xx for AC500 V3 products” on page 377

There are no restrictions concerning which communication modules can be arranged for a processor module.

Within the AC500 control system, the communication modules can be used as

- bus master or
- slave.

It depends on the

- selected protocol,
- the functionality of the communication module and
- the several field buses and networks.

The following name extensions of the device names describe the supported field bus/protocol:

- CM5640-2ETH: Ethernet
- CM5x2-DP: PROFIBUS
- CM5x9-PNIO: PROFINET
- CM579-ETHCAT: EtherCAT
- CM598-CN: CANopen
- CM5610-2RS: 2 serial interfaces (COM1/COM2)

If a XC version of the device is available, for use in extreme ambient conditions (e.g. wider temperature and humidity range), this is indicated with a snowflake sign.
5.2.2.2 Compatibility of communication modules and communication interface modules

### Table 93: Modbus TCP

<table>
<thead>
<tr>
<th>Communication module</th>
<th>Communication interface module</th>
<th>I/O expansion module S500</th>
<th>I/O expansion module S500-eCo</th>
<th>I/O expansion module S500-S</th>
<th>Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Onboard Ethernet interface</td>
<td>CI521-MODTCP CI522-MODTCP</td>
<td>x</td>
<td>x</td>
<td>--</td>
<td>high availability, remote I/O</td>
</tr>
<tr>
<td>Onboard Ethernet interface</td>
<td>CI521-MODTCP CI522-MODTCP</td>
<td>x</td>
<td>--</td>
<td>--</td>
<td>hot-swap I/O</td>
</tr>
<tr>
<td>CM5640-2ETH</td>
<td>CI521-MODTCP CI522-MODTCP</td>
<td>x</td>
<td>x</td>
<td>--</td>
<td>high availability, remote I/O</td>
</tr>
<tr>
<td>CM5640-2ETH</td>
<td>CI521-MODTCP CI522-MODTCP</td>
<td>x</td>
<td>--</td>
<td>--</td>
<td>hot-swap I/O</td>
</tr>
</tbody>
</table>

### Table 94: PROFIBUS DP

<table>
<thead>
<tr>
<th>Communication module</th>
<th>Communication interface module</th>
<th>I/O expansion module S500</th>
<th>I/O expansion module S500-eCo</th>
<th>I/O expansion module S500-S</th>
<th>Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>CM592-DP master</td>
<td>CI541-DP CI542-DP</td>
<td>x</td>
<td>x</td>
<td>--</td>
<td>remote I/O</td>
</tr>
<tr>
<td>CM592-DP master</td>
<td>CI541-DP CI542-DP</td>
<td>x</td>
<td>--</td>
<td>--</td>
<td>hot-swap I/O</td>
</tr>
</tbody>
</table>

### Table 95: PROFINET IO RT

<table>
<thead>
<tr>
<th>Communication module</th>
<th>Communication interface module</th>
<th>I/O expansion module S500</th>
<th>I/O expansion module S500-eCo</th>
<th>I/O expansion module S500-S</th>
<th>Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>CM579-PNIO controller</td>
<td>CI501-PNIO CI502-PNIO</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>remote I/O, safety I/O</td>
</tr>
<tr>
<td>CM579-PNIO controller</td>
<td>CI501-PNIO CI502-PNIO</td>
<td>x</td>
<td>--</td>
<td>--</td>
<td>hot-swap I/O</td>
</tr>
</tbody>
</table>

### Table 96: CANopen

<table>
<thead>
<tr>
<th>Communication module</th>
<th>Communication interface module</th>
<th>I/O expansion module S500</th>
<th>I/O expansion module S500-eCo</th>
<th>I/O expansion module S500-S</th>
<th>Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Onboard CAN interface</td>
<td>CI581-CN CI582-CN</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>remote I/O</td>
</tr>
</tbody>
</table>
### Table 97: EtherCAT

<table>
<thead>
<tr>
<th>Communication module</th>
<th>Communication interface module</th>
<th>I/O expansion module S500</th>
<th>I/O expansion module S500-eCo</th>
<th>I/O expansion module S500-S</th>
<th>Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>CM579-ETHCAT master</td>
<td>CI511-ETHCAT CI512-ETHCAT</td>
<td>x</td>
<td>x</td>
<td>--</td>
<td>remote I/O</td>
</tr>
</tbody>
</table>

#### 5.2.2.3 Technical data (Overview)

<table>
<thead>
<tr>
<th>Communication module</th>
<th>Field bus</th>
<th>Transmission rate</th>
<th>Field bus connector</th>
<th>Processor</th>
<th>Communication module interface</th>
<th>Current consumption from 24 V DC power supply at the terminal base of the CPU</th>
</tr>
</thead>
<tbody>
<tr>
<td>CM5610-2RS</td>
<td>Serial (ASCII/Modbus)</td>
<td>9.6 ... 187.5 kBit/s</td>
<td>2 x MC 0.5/9-G-2.5, 9-pin, male</td>
<td>TI ARM Cortex-A9</td>
<td>Dual-port RAM</td>
<td>Typ. 40 mA</td>
</tr>
<tr>
<td>CM579-ETHCAT</td>
<td>EtherCAT</td>
<td>10 or 100 MBit/s</td>
<td>2 x RJ45</td>
<td>Hilscher NETX 100</td>
<td>Dual-port RAM, 16 kB</td>
<td>Typ. 85 mA</td>
</tr>
<tr>
<td>CM582-DP CM592-DP</td>
<td>PROFIBUS DP</td>
<td>9.6 kBit/s ... 12 MBit/s</td>
<td>D-sub, 9-pin, female, bended</td>
<td>Hilscher NETX 100</td>
<td>Dual-port RAM, 16 kB</td>
<td>Typ. 65 mA</td>
</tr>
<tr>
<td>CM598-CN</td>
<td>CANopen</td>
<td>10 ... 1 MBit/s</td>
<td>COMBICON 2x 5-pin, bended</td>
<td>Hilscher NETX 100</td>
<td>Dual-port RAM, 16 kB</td>
<td>Typ. 65 mA</td>
</tr>
<tr>
<td>CM579-PNIO</td>
<td>PROFINET</td>
<td>100 MBit/s</td>
<td>2 x RJ45</td>
<td>Hilscher NETX 100</td>
<td>Dual-port RAM, 16 kB</td>
<td>Typ. 85 mA</td>
</tr>
<tr>
<td>CM5640-2ETH</td>
<td>2 x Ethernet</td>
<td>10 or 100 MBit/s</td>
<td>2 x RJ45</td>
<td>TI ARM Cortex-A9</td>
<td>Dual-port RAM</td>
<td>Typ. 47 mA</td>
</tr>
</tbody>
</table>
5.2.2.4 Serial

5.2.2.4.1 CM5610-2RS with 2 serial interfaces

Features

1. 5 LEDs for state display
2. 2 rotary switches for address setting
3. Label
4. 2 serial interfaces: COM1 and COM2

CAUTION!
Risk of injury and damaging the module when using unapproved terminal blocks!
Only use terminal blocks approved by ABB to avoid injury and damage to the module.

The communication modules with 2 serial interfaces are delivered with two 9-pin terminal blocks TA532 (1SAP 182 000 R0001).
The terminal block listed in the ordering data is for spare part only if needed.
Purpose

Communication module CM5610-2RS is equipped with 2 serial interfaces (COM1 and COM2) which can be used as serial interface extension of the processor module or for communication e.g. for communication via Modbus or ASCII.

Depending on the connection, the physical interface of COM1 and COM2 is either RS-232 or RS-485.

Connections

Serial interfaces

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Interface</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Term. P</td>
<td>RS-485</td>
<td>Terminator P</td>
</tr>
<tr>
<td>2</td>
<td>RxD/TxD-P</td>
<td>RS-485</td>
<td>Receive/Transmit, positive</td>
</tr>
<tr>
<td>3</td>
<td>RxD/TxD-N</td>
<td>RS-485</td>
<td>Receive/Transmit, negative</td>
</tr>
<tr>
<td>4</td>
<td>Term. N</td>
<td>RS-485</td>
<td>Terminator N</td>
</tr>
<tr>
<td>5</td>
<td>RTS</td>
<td>RS-232</td>
<td>Request to send (output)</td>
</tr>
<tr>
<td>6</td>
<td>TxD</td>
<td>RS-232</td>
<td>Transmit data (output)</td>
</tr>
<tr>
<td>7</td>
<td>SGND</td>
<td>Signal Ground</td>
<td>Signal Ground</td>
</tr>
<tr>
<td>8</td>
<td>RxD</td>
<td>RS-232</td>
<td>Receive data (input)</td>
</tr>
<tr>
<td>9</td>
<td>CTS</td>
<td>RS-232</td>
<td>Clear to send (input)</td>
</tr>
</tbody>
</table>

Bus cable for RS-485

Bus cable

- **Bus line**
  - Construction: 2 cores, twisted, with common shield
  - Conductor cross section: > 0.22 mm² (24 AWG)
  - Twisting rate: > 10 per meter (symmetrically twisted)
  - Core insulation: Polyethylene (PE)
  - Resistance per core: < 100 Ω/km
  - Characteristic impedance: ca. 120 Ω (100 Ω ... 150 Ω)
  - Capacitance between the cores: < 55 nF/km (if higher, the max. bus length must be reduced)
  - Terminating resistors: 120 Ω ¼ W at both line ends

Remarks

- Commonly used telephone cables with PE insulation and a core diameter of > 0.8 mm are usually sufficient.
- Cables with PVC core insulation and core diameter of 0.8 mm can be used up to a length of approx. 250 m. In this case, the bus terminating resistor is approx. 100 Ω.

Cable lengths

The maximum possible cable length of a serial connection subnet within a segment depends on the transmission rate.

RS-232 (for point-to-point connection):
### Parameter | Value
---|---
Transmission rate | 9.6 kbit/s to 115.2 kbit/s
Maximum cable length | On request

RS-485 (for point-to-point or bus connection):

### Parameter | Value
---|---
Transmission rate | 9.6 kbit/s to 115.2 kbit/s
Maximum cable length | On request

**Bus termination (RS-485 only)**

The line ends of the bus segment must be equipped with bus terminating resistors. Normally, these resistors are integrated in the interface connectors.

1 Term. P
2 RxD/TxD-P
3 RxD/TxD-N
4 Term. N
A Master at the bus line end, pull-up resistor and pull-down resistor activated, bus terminating resistor 120 Ω
B Slave within the bus line
C Slave at the bus line end, bus terminating resistor 120 Ω

**State LEDs**

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR</td>
<td>Green</td>
<td>ON (light)</td>
<td>Voltage is present</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OFF (dark)</td>
<td>Voltage is missing</td>
</tr>
<tr>
<td>RDY</td>
<td>Yellow</td>
<td>Programmable</td>
<td>Depends on user program</td>
</tr>
<tr>
<td>RUN</td>
<td>Green</td>
<td>Programmable</td>
<td>Depends on user program</td>
</tr>
<tr>
<td>STA</td>
<td>Yellow</td>
<td>Programmable</td>
<td>Depends on user program</td>
</tr>
<tr>
<td>ERR</td>
<td>Red</td>
<td>Programmable</td>
<td>Depends on user program</td>
</tr>
</tbody>
</table>

**Technical data**

The system data of AC500 and S500 are applicable to the standard version *Chapter 5.1.2 “System data AC500” on page 166.*

The system data of AC500-XC are applicable to the XC version *Chapter 5.1.3 “System data AC500-XC” on page 169.*

Only additional details are therefore documented below.
The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Protocols</strong></td>
<td></td>
</tr>
<tr>
<td>Serial COM ASCII</td>
<td>Yes</td>
</tr>
<tr>
<td>Modbus RTU (master and slave)</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>State LED</strong></td>
<td></td>
</tr>
<tr>
<td>PWR</td>
<td>1</td>
</tr>
<tr>
<td>RUN</td>
<td>1</td>
</tr>
<tr>
<td>ERR</td>
<td>1</td>
</tr>
<tr>
<td>RDY</td>
<td>1</td>
</tr>
<tr>
<td>STA</td>
<td>1</td>
</tr>
<tr>
<td><strong>Rotary switch</strong></td>
<td></td>
</tr>
<tr>
<td>ADDR 00…FFhex</td>
<td>2, for station identification</td>
</tr>
<tr>
<td><strong>Serial interface 1</strong></td>
<td></td>
</tr>
<tr>
<td>Physical layer</td>
<td></td>
</tr>
<tr>
<td>RS232 / RS485 configurable</td>
<td>Isolated</td>
</tr>
<tr>
<td>Connection name</td>
<td>COM input of funktion blocks:11, 21, ... 61 depending on which slot CM5610-2RS is plugged. Counting starts from right to left on left side of CPU.</td>
</tr>
<tr>
<td>Connection type</td>
<td></td>
</tr>
<tr>
<td>Terminal block</td>
<td>Pluggable spring terminals</td>
</tr>
<tr>
<td>Transmission rate</td>
<td>Configurable from 9.6 kbit/s to 115.2 kbit/s</td>
</tr>
<tr>
<td><strong>Usage</strong></td>
<td></td>
</tr>
<tr>
<td>Programming</td>
<td>No</td>
</tr>
<tr>
<td>Modbus RTU (master and slave)</td>
<td>Yes</td>
</tr>
<tr>
<td>Serial ASCII communication</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Serial interface 2</strong></td>
<td></td>
</tr>
<tr>
<td>Physical layer</td>
<td></td>
</tr>
<tr>
<td>RS232 / RS485 configurable</td>
<td>Isolated</td>
</tr>
<tr>
<td>Connection name</td>
<td>COM input of funktion blocks:12, 22, ... 62 depending on which slot CM5610-2RS is plugged. Counting starts from right to left on left side of CPU.</td>
</tr>
<tr>
<td>Connection type</td>
<td></td>
</tr>
<tr>
<td>Terminal block</td>
<td>Pluggable spring terminals</td>
</tr>
<tr>
<td>Transmission rate</td>
<td>Configurable from 9.6 kbit/s to 115.2 kbit/s</td>
</tr>
<tr>
<td><strong>Usage</strong></td>
<td></td>
</tr>
<tr>
<td>Programming</td>
<td>No</td>
</tr>
<tr>
<td>Modbus RTU (master and slave)</td>
<td>Yes</td>
</tr>
<tr>
<td>Serial ASCII communication</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Communication module interface/bus</strong></td>
<td>Dual-port RAM (simulated)</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Net weight [kg]</td>
<td>0.12 kg</td>
</tr>
</tbody>
</table>

**Power supply**

<table>
<thead>
<tr>
<th>Nominal supply voltage</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Supply current at nominal supply</td>
<td>Typ. 40 mA per communication module at 24 V</td>
</tr>
<tr>
<td>voltage (depending on system</td>
<td>With maximum load to both COM ports: 46 mA</td>
</tr>
<tr>
<td>architecture)</td>
<td></td>
</tr>
</tbody>
</table>

**Internal power supply source**

| Communication module bus         |                                                                    |

**Hardware**

<table>
<thead>
<tr>
<th>Usable CPUs</th>
<th>PM56xx : Chapter 5.2.1.2.2 “PM56xx-2ETH for AC500 V3 products” on page 313</th>
</tr>
</thead>
<tbody>
<tr>
<td>Usable terminal bases</td>
<td>TB56xx : Chapter 5.2.3.1 “TB56xx for AC500 V3 products” on page 377</td>
</tr>
</tbody>
</table>

**Dimensions**

- 1 Din rail 15 mm
- 2 Din rail 7.5 mm

*The dimensions are in mm and in brackets in inch.*

**Ordering data**

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 176 000 R0020</td>
<td>CM5610-2RS, communication module, 2 serial RS232/485</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 376 000 R0020</td>
<td>CM5610-2RS-XC, communication module, 2 serial RS232/485, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>
*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

Table 98: Spare parts for communication modules with 2 serial interfaces

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 182 000 R0001</td>
<td>TA532: 9-pin terminal block set for communication module CM5610-2RS(-XC), 10 pieces, spring type terminal</td>
</tr>
</tbody>
</table>

The communication modules with 2 serial interfaces are delivered with two 9-pin terminal blocks TA532 (1SAP 182 000 R0001).

The terminal block listed in the ordering data is for spare part only if needed.

5.2.2.5 CANopen

5.2.2.5.1 CM598-CN - CANopen master

Features

- CANopen master 1 Mbit/s
- XC version for use in extreme ambient conditions available
Purpose

Communication module CM598-CN enables communication over the CANopen field bus. For use in extreme ambient conditions (e.g. wider temperature and humidity range), a special XC version of the device is available.

The AC500 V3 CPUs only support CAN 2A/2B protocol on the communication module CM598-CAN. Support of CANopen protocol is in preparation.
Connections

Field bus interface

<table>
<thead>
<tr>
<th>Interface socket</th>
<th>5-pin COMBICON</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission standard</td>
<td>ISO 11898, potential-free</td>
</tr>
<tr>
<td>Transmission protocol</td>
<td>CANopen (CAN), 1 Mbaud max.</td>
</tr>
<tr>
<td>Transfer rate (transmission rate)</td>
<td>10 kbit/s, 20 kbit/s, 50 kbit/s, 100 kbit/s, 125 kbit/s, 250 kbit/s, 500 kbit/s, 800 kbit/s and 1 Mbit/s,</td>
</tr>
</tbody>
</table>

Pin assignment

Table 99: Pin assignment of the CANopen connector

<table>
<thead>
<tr>
<th>Interface</th>
<th>PIN</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAN</td>
<td>CAN_GND</td>
<td>CAN reference potential</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CAN_L</td>
<td>Bus line, receive/transmit line, LOW</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CAN_SHLD</td>
<td>Shield of the bus line</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CAN_H</td>
<td>Bus line, receive/transmit line, HIGH</td>
<td></td>
</tr>
<tr>
<td></td>
<td>NC</td>
<td>Not connected</td>
<td></td>
</tr>
</tbody>
</table>

NOTICE!

Unused connector!

Make sure that the terminal block is always connected to the terminal base or communication module, even if you do not use the interface.

Bus length

The maximum possible bus length of a CAN network depends on bit rate (transmission rate) and cable type. The sum of all bus segments must not exceed the maximum bus length

<table>
<thead>
<tr>
<th>Bit Rate (speed)</th>
<th>Bus Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Mbit/s</td>
<td>40 m</td>
</tr>
<tr>
<td>800 kbit/s</td>
<td>50 m</td>
</tr>
<tr>
<td>500 kbit/s</td>
<td>100 m</td>
</tr>
<tr>
<td>250 kbit/s</td>
<td>250 m</td>
</tr>
<tr>
<td>125 kbit/s</td>
<td>500 m</td>
</tr>
<tr>
<td>50 kbit/s</td>
<td>1000 m</td>
</tr>
</tbody>
</table>

Types of bus cables

For CANopen, only bus cables with characteristics as recommended in ISO 11898 are to be used. The requirements for the bus cables depend on the length of the bus segment. Regarding this, the following recommendations are given by ISO 11898:
<table>
<thead>
<tr>
<th>Length of segment [m]</th>
<th>Bus cable (shielded, twisted pair)</th>
<th>Max. transmission rate [kbit/s]</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Conductor cross section [mm²]</td>
<td>Line resistance [Ω/km]</td>
</tr>
<tr>
<td>0...40</td>
<td>0.25 ... 0.34 / AWG23, AWG22</td>
<td>70</td>
</tr>
<tr>
<td>40...300</td>
<td>0.34 ... 0.60 / AWG22, AWG20</td>
<td>&lt; 60</td>
</tr>
<tr>
<td>300...600</td>
<td>0.50 ... 0.60 / AWG20</td>
<td>&lt; 40</td>
</tr>
<tr>
<td>600...1000</td>
<td>0.75 ... 0.80 / AWG18</td>
<td>&lt; 26</td>
</tr>
</tbody>
</table>

**Bus terminating resistors**  
The ends of the data lines have to be terminated with a 120 Ω bus terminating resistor. The bus terminating resistor is usually installed directly at the bus connector.

![Diagram of CANopen interface, bus terminating resistors connected to the line ends](image)

**Fig. 40: CANopen interface, bus terminating resistors connected to the line ends**

<table>
<thead>
<tr>
<th>Node</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CAN_GND</td>
</tr>
<tr>
<td>2</td>
<td>CAN_L</td>
</tr>
<tr>
<td>3</td>
<td>Shield</td>
</tr>
<tr>
<td>4</td>
<td>CAN_H</td>
</tr>
<tr>
<td>5</td>
<td>Data line, shielded twisted pair</td>
</tr>
<tr>
<td>6</td>
<td>COMBICON connection, CANopen interface</td>
</tr>
</tbody>
</table>
Fig. 41: DeviceNet interface, bus terminating resistors connected to the line ends

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>DeviceNet power supply</td>
</tr>
<tr>
<td>7</td>
<td>COMBICON connection, DeviceNet interface</td>
</tr>
<tr>
<td>8</td>
<td>Data lines, twisted pair cables</td>
</tr>
<tr>
<td>9</td>
<td>red</td>
</tr>
<tr>
<td>10</td>
<td>black</td>
</tr>
<tr>
<td>11</td>
<td>white</td>
</tr>
<tr>
<td>12</td>
<td>blue</td>
</tr>
<tr>
<td>13</td>
<td>bare</td>
</tr>
</tbody>
</table>

The grounding of the shield should take place at the switchgear. See Chapter 5.1.2 “System data AC500” on page 166.
State LEDs

Table 100: Meaning of the diagnosis LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR</td>
<td>Green</td>
<td>ON (light)</td>
<td>Power supply available</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OFF (dark)</td>
<td>Power supply not available or defective hardware</td>
</tr>
<tr>
<td>RDY</td>
<td>Yellow</td>
<td>ON</td>
<td>Boot procedure</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td>Boot failure</td>
</tr>
<tr>
<td>RUN</td>
<td>Green</td>
<td>ON</td>
<td>Communication module is operational</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OFF</td>
<td>Communication module is not operational</td>
</tr>
<tr>
<td>CAN-RUN</td>
<td>Green</td>
<td>ON</td>
<td>Operational: Device is in the OPERATIONAL state</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Single Flash</td>
<td>Stopped: Device is in STOPPED state</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td>Pre-operational: Device is in the PREOPERATIONAL state</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OFF</td>
<td>No communication or no power supply</td>
</tr>
<tr>
<td>CAN-ERR</td>
<td>Red</td>
<td>ON</td>
<td>CANopen bus is off</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Single flash</td>
<td>Warning limit reached: At least one of the error counters of the CAN controller has reached or exceeded the warning level (too many error frames)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Double flash</td>
<td>Error control event: A guard event (NMT Slave or NMTmaster) or a heartbeat event (Heartbeat consumer) has occurred</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OFF</td>
<td>No Error: Device is in working condition</td>
</tr>
</tbody>
</table>

- **CAN-RUN** Yellow Blinking (synchronously): No production data available, no bus communication possible.
- **CAN-ERR** Yellow Blinking (synchronously): Firmware file transfers during communication module firmware update.
- **CAN-RUN** Red Blinking (synchronously): Communication module writes the firmware file to the internal flash. Do not power off the PLC!

**Technical data**

The system data of AC500 and S500 are applicable to the standard version Chapter 5.1.2 “System data AC500” on page 166.

The system data of AC500-XC are applicable to the XC version Chapter 5.1.3 “System data AC500-XC” on page 169.

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol</td>
<td>CANopen master (in preparation), CAN2A, CAN2B</td>
</tr>
<tr>
<td>Transmission rate</td>
<td>10 kbit/s to 1 Mbit/s</td>
</tr>
<tr>
<td>Ambient temperature</td>
<td>see:</td>
</tr>
<tr>
<td></td>
<td>System data AC500  Chapter 5.1.2 “System data AC500” on page 166</td>
</tr>
<tr>
<td></td>
<td>System Data AC500-XC  Chapter 5.1.3 “System data AC500-XC” on page 169</td>
</tr>
<tr>
<td>Usable terminal bases</td>
<td>All TB5xx</td>
</tr>
<tr>
<td>Field bus connector</td>
<td>Pluggable connector COMBICON, 5-pin</td>
</tr>
<tr>
<td>Technology</td>
<td>Hilscher NETX 100</td>
</tr>
<tr>
<td>Indicators</td>
<td>5 LEDs</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via the communication module interface of the terminal base</td>
</tr>
<tr>
<td>Current consumption from 24 V DC power</td>
<td>Typ. 65 mA</td>
</tr>
<tr>
<td>supply at the Terminal Base of the CPU</td>
<td></td>
</tr>
<tr>
<td>Number of Slaves</td>
<td>Max. 126</td>
</tr>
<tr>
<td>Number of receive/transmit PDOs</td>
<td>Max. 512 (respectively for receive and transmit)</td>
</tr>
<tr>
<td>Total quantity of input and output data</td>
<td>Max. 3584 byte (respectively for input and output)</td>
</tr>
<tr>
<td>Weight</td>
<td>Ca. 150 g</td>
</tr>
</tbody>
</table>

### Dimensions

The dimensions are in mm and in brackets in inch.

1. Din rail 15 mm
2. Din rail 7.5 mm
Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 173 800 R0001</td>
<td>CM598-CN, communication module CANopen master</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 373 800 R0001</td>
<td>CM598-CN-XC, communication module CANopen master, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

5.2.2.6 EtherCAT

Two alternatives are available for using EtherCAT:
- Onboard EtherCAT for the AC500-eCo
- EtherCAT for the AC500 with the CM579 communication module

Further information can be found here:
- Onboard EtherCAT
  - EtherCAT configurator
  - Communication schema onboard Ethernet/EtherCAT
  - Motion Control
- EtherCAT
  - CM579-ETHCAT
  - Communication schema onboard Ethernet/EtherCAT
  - Motion Control
5.2.2.6.1 CM579-ETHCAT - EtherCAT master

Features

1. 5 LEDs for state display
2. 2 rotary switches for address setting (not used)
3. Label
4. 2 communication interfaces RJ45 (ETHCAT1 and ETHCAT2)

Intended purpose

Communication module CM579-ETHCAT is for EtherCAT communication.

The communication module is configured via the dual-port memory by means of a system configurator. The configuration is saved on a non-volatile Flash EPROM memory.

Chapter 6.9.3.6.2 "CM579-ETHCAT" on page 4665

Connections

Field bus interfaces

The EtherCAT communication module provides 2 RJ45 interfaces with the following pin assignment. The pin assignment is used for the EtherCAT slaves (communication interface modules CI5xy-ETHCAT) as well.
<table>
<thead>
<tr>
<th>Interface</th>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet</td>
<td>1</td>
<td>TxD+</td>
<td>Transmit data +</td>
</tr>
<tr>
<td>RJ45</td>
<td>2</td>
<td>TxD-</td>
<td>Transmit data -</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>RxD+</td>
<td>Receive data +</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>RxD-</td>
<td>Receive data -</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td>Shield</td>
<td></td>
<td>Cable shield</td>
<td>Functional earth</td>
</tr>
</tbody>
</table>

In corrosive environment, please protect unused connectors using the TA535 accessory.

Not supplied with this device.

Further information about wiring and cable types

The EtherCAT network differentiates between input-connectors (IN) and output-connectors (OUT):

At the EtherCAT slaves (communication interface modules), the ETH1-connector is IN and the ETH2-connector is OUT.

At the EtherCAT master (communication module), the ETHCAT1 connector has to be used. The ETHCAT2 connector is reserved for future extensions.
State LEDs

The EtherCAT state is shown by the EtherCAT communication module's LEDs. Some LEDs are two-colored.

Table 101: Meaning of the diagnosis LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR</td>
<td>Green</td>
<td>On</td>
<td>Power supply available</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>Power supply not available or defective hardware</td>
</tr>
<tr>
<td>RDY</td>
<td>Yellow</td>
<td>On</td>
<td>Boot procedure</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td>Boot failure</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>---</td>
</tr>
<tr>
<td>RUN</td>
<td>Green</td>
<td>On</td>
<td>Communication module is operational</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>Communication module is not operational</td>
</tr>
<tr>
<td>STA1</td>
<td>Green</td>
<td>On</td>
<td>No bus error, communication running</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td>Establishing communication</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>System error</td>
</tr>
<tr>
<td>STA2</td>
<td>Red</td>
<td>On</td>
<td>Configuration error</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>No error</td>
</tr>
<tr>
<td>STA1</td>
<td>Yellow</td>
<td>Blinking</td>
<td>No production data available,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(synchronously)</td>
<td>no bus communication possible.</td>
</tr>
<tr>
<td>STA2</td>
<td>Yellow</td>
<td>Blinking</td>
<td>---</td>
</tr>
</tbody>
</table>

The RJ45 Ethernet connector contains two LEDs showing the current Ethernet port connection state.

Table 102: Meaning of the diagnosis LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ETHCAT1 LED &quot;Link&quot;</td>
<td>Green</td>
<td>On</td>
<td>Ethernet connection established</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>No Ethernet connection</td>
</tr>
<tr>
<td>ETHCAT1 LED &quot;RX/TX&quot;</td>
<td>Yellow</td>
<td>On</td>
<td>Device sends/receives frames</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>No Ethernet connection</td>
</tr>
<tr>
<td>ETHCAT2 LED &quot;Link&quot;</td>
<td>Green</td>
<td>Blinking</td>
<td>Firmware file transfers during</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(synchronously)</td>
<td>communication module firmware update.</td>
</tr>
<tr>
<td>ETHCAT2 LED &quot;RX/TX&quot;</td>
<td>Yellow</td>
<td>Blinking</td>
<td>Communication module writes the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(alternately)</td>
<td>firmware file to the internal flash.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Do not power off the PLC!</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>Connector ETHCAT2 is not used</td>
</tr>
</tbody>
</table>
## Technical data

The system data of AC500 and S500 are applicable to the standard version "Chapter 5.1.2 "System data AC500" on page 166.

The system data of AC500-XC are applicable to the XC version "Chapter 5.1.3 "System data AC500-XC" on page 169.

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal Supply</td>
<td>Via the communication module interface of the terminal base</td>
</tr>
<tr>
<td>Protocol</td>
<td>EtherCAT</td>
</tr>
<tr>
<td>Field bus connector</td>
<td>2 x RJ45 (ETHCAT1 and ETHCAT2)</td>
</tr>
<tr>
<td>Technology</td>
<td>Hilscher NETX 100</td>
</tr>
<tr>
<td>Transfer rate</td>
<td>10/100 Mbit/s (full-duplex)</td>
</tr>
<tr>
<td>Transfer method</td>
<td>According to Ethernet II, IEEE 802.3</td>
</tr>
<tr>
<td>Ethernet</td>
<td>100 base-TX, internal switch, 2x RJ45 socket</td>
</tr>
<tr>
<td>Bus length (segment length max.)</td>
<td>100 m at 100 Mbit/s</td>
</tr>
<tr>
<td>Indicators</td>
<td>5 LEDs</td>
</tr>
<tr>
<td>Usable CPUs</td>
<td>PM56xx &quot;Chapter 5.2.1.2.2 &quot;PM56xx-2ETH for AC500 V3 products&quot; on page 313</td>
</tr>
<tr>
<td>Usable terminal bases</td>
<td>All TB56xx (not TB5600) &quot;Chapter 5.2.3.1 &quot;TB56xx for AC500 V3 products&quot; on page 377</td>
</tr>
<tr>
<td>Ambient temperature</td>
<td>System data AC500 &quot;Chapter 5.1.2 &quot;System data AC500&quot; on page 166</td>
</tr>
<tr>
<td></td>
<td>System Data AC500 XC &quot;Chapter 5.1.3 &quot;System data AC500-XC&quot; on page 169</td>
</tr>
<tr>
<td>Current consumption from 24 V DC power</td>
<td>Typ. 85 mA</td>
</tr>
<tr>
<td>supply at the terminal base of the CPU</td>
<td></td>
</tr>
<tr>
<td>Internal supply</td>
<td>Via the communication module interface of the terminal base</td>
</tr>
<tr>
<td>Number of slaves</td>
<td>Limited to 200</td>
</tr>
<tr>
<td>Quantity of input and output data for a single slave</td>
<td>Max. 5760 bytes (respectively for input and output)</td>
</tr>
<tr>
<td>Total quantity of input and output data</td>
<td>Max. 5760 bytes (only valid for asynchronous operation, for synchronous operation the reachable values depends on the additional load of SoE, CoE and EoE, typical reachable values are 1024 bytes).</td>
</tr>
<tr>
<td>Supported protocols</td>
<td>RTC - Real-time cyclic protocol, class 1</td>
</tr>
<tr>
<td></td>
<td>RTA - Real-time acyclic protocol</td>
</tr>
<tr>
<td>Acyclic services</td>
<td>• CoE upload</td>
</tr>
<tr>
<td></td>
<td>• CoE download (1500 bytes max.)</td>
</tr>
<tr>
<td></td>
<td>• Emergency</td>
</tr>
<tr>
<td>Min. bus cycle</td>
<td>1 ms</td>
</tr>
<tr>
<td>Max. size of the bus configuration file</td>
<td>2 MB</td>
</tr>
<tr>
<td>Weight</td>
<td>Ca. 170 g</td>
</tr>
</tbody>
</table>
### Dimensions

![Dimensions Diagram]

1. Din rail 15 mm
2. Din rail 7.5 mm

The dimensions are in mm and in brackets in inch.

### Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 170 902 R0101</td>
<td>CM579-ETHCAT, EtherCAT communication module</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

### 5.2.2.7 Ethernet

#### 5.2.2.7.1 CM5640-2ETH - Communication module Ethernet

**Features**

- TCP/IP with 2 independent channels
- XC version for use in extreme ambient conditions available
The communication module provides additional communication ports for the CPU. The Ethernet communication module is a port extender that provides two additional, separate, non-programmable Ethernet interfaces for the CPU processor module used.

Each communication module and port used results in a slightly higher CPU load on the CPU compared to using the same protocol via the onboard port, since the communication module and the transmission of the communication packets must be additionally processed by the CPU. The complete TCP/IP protocol and the application layers are supported.

- Each communication module port must be addressed via its IP address (not slot no.) and must be in a different subnet than the port(s) of the CPU.
- Each used communication module and port causes a slightly higher CPU load compared to using the same protocol onboard.
It is not possible to close a RSTP ring by using the two ports of the communication module.

Applications:
- TCP/IP for PC/Automation Builder (programming)
- UDP functions using SysSocket or NetBaseServices libraries
- Modbus on TCP/IP (Modbus on TCP/IP, client and server and all standard protocols from the PLC)

For use in extreme ambient conditions (e.g. wider temperature and humidity range), a special XC version of the device is available.

Connections

Field bus interfaces

The Ethernet communication module has 2 RJ45 interfaces:

<table>
<thead>
<tr>
<th>Interface</th>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet</td>
<td>1</td>
<td>TxD+</td>
<td>Transmit data +</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>TxD-</td>
<td>Transmit data -</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>RxD+</td>
<td>Receive data +</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>RxD-</td>
<td>Receive data -</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td>Shield</td>
<td></td>
<td>Cable shield</td>
<td>Functional earth</td>
</tr>
</tbody>
</table>

In corrosive environment, please protect unused connectors using the TA535 accessory.
Not supplied with this device.

Further information about wiring and cable types

State LEDs

The Ethernet state is shown by the Ethernet communication module's LEDs.
### Table 103: Meaning of the diagnosis LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR</td>
<td>Green</td>
<td>On</td>
<td>Power supply available</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>Power supply not available or defective module</td>
</tr>
<tr>
<td>RDY</td>
<td>Yellow</td>
<td>On</td>
<td>Boot procedure</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>Awaiting boot</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td>Boot failure</td>
</tr>
<tr>
<td>RUN</td>
<td>Green</td>
<td>On</td>
<td>Communication module is operational</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>Communication module is not operational</td>
</tr>
<tr>
<td>STA1</td>
<td>Green</td>
<td>On</td>
<td>Communication module is activated</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>Communication module awaiting activation</td>
</tr>
<tr>
<td>STA2</td>
<td>Red</td>
<td>On</td>
<td>Diagnosis available not fetched by PLC</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>No error</td>
</tr>
</tbody>
</table>

The RJ45 Ethernet connector contains two LEDs showing the current Ethernet port connection state.

### Table 104: Meaning of the diagnosis LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ETH1</td>
<td>Green</td>
<td>On</td>
<td>Ethernet connection established</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>No Ethernet connection</td>
</tr>
<tr>
<td>ETH1</td>
<td>Yellow</td>
<td>On</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td>Device sends/receives frames</td>
</tr>
<tr>
<td>ETH2</td>
<td>Green</td>
<td>On</td>
<td>Ethernet connection established</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>No Ethernet connection</td>
</tr>
<tr>
<td>ETH2</td>
<td>Yellow</td>
<td>On</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td>Device sends/receives frames</td>
</tr>
</tbody>
</table>

### Technical data

The system data of AC500 and S500 are applicable to the standard version "Chapter 5.1.2 "System data AC500" on page 166."

The system data of AC500-XC are applicable to the XC version "Chapter 5.1.3 "System data AC500-XC" on page 169."

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Protocols</strong></td>
<td></td>
</tr>
<tr>
<td>Ethernet</td>
<td></td>
</tr>
<tr>
<td>TCP/IP</td>
<td>Yes</td>
</tr>
<tr>
<td>UPD/IP</td>
<td>Yes</td>
</tr>
<tr>
<td>Modbus TCP</td>
<td>Yes</td>
</tr>
<tr>
<td>ICMP (Ping)</td>
<td>Yes</td>
</tr>
<tr>
<td>DNS</td>
<td>Yes</td>
</tr>
<tr>
<td>SMTP (email)</td>
<td>Yes</td>
</tr>
<tr>
<td>DHCP</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>State LED</strong></td>
<td></td>
</tr>
<tr>
<td>PWR</td>
<td>1</td>
</tr>
<tr>
<td>RUN</td>
<td>1</td>
</tr>
<tr>
<td>RDY</td>
<td>1</td>
</tr>
<tr>
<td>STA</td>
<td>2</td>
</tr>
<tr>
<td><strong>Rotary switch</strong></td>
<td></td>
</tr>
<tr>
<td>ADDR 00...FFhex</td>
<td>2, for station identification</td>
</tr>
<tr>
<td><strong>Ethernet interfaces</strong></td>
<td></td>
</tr>
<tr>
<td>Physical layer</td>
<td>10/100Base-TX</td>
</tr>
<tr>
<td>Connection name</td>
<td>ETH &lt;Slot&gt;1, ETH &lt;Slot&gt;2</td>
</tr>
<tr>
<td><strong>Connection type</strong></td>
<td></td>
</tr>
<tr>
<td>Independent channels</td>
<td>Yes, 2</td>
</tr>
<tr>
<td>Internal switch</td>
<td>No</td>
</tr>
<tr>
<td><strong>Auto negotiation</strong></td>
<td>Yes, not adjustable/changeable</td>
</tr>
<tr>
<td><strong>MAC address</strong></td>
<td>Not configurable</td>
</tr>
<tr>
<td><strong>Transmission rate</strong></td>
<td>10/100 Mbit/s</td>
</tr>
<tr>
<td><strong>Max. cable length</strong></td>
<td>100 m at 100 Mbit/s</td>
</tr>
<tr>
<td><strong>Usage</strong></td>
<td></td>
</tr>
<tr>
<td>Programming</td>
<td>3S Online Protocol</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>Yes</td>
</tr>
<tr>
<td>Modbus TCP</td>
<td>Yes</td>
</tr>
<tr>
<td>Online access</td>
<td>3S Online Protocol</td>
</tr>
<tr>
<td><strong>Communication module interface/bus</strong></td>
<td>Dual-port RAM</td>
</tr>
<tr>
<td><strong>Net weight</strong></td>
<td>0.12 kg</td>
</tr>
<tr>
<td><strong>Power supply</strong></td>
<td></td>
</tr>
<tr>
<td>Nominal supply voltage</td>
<td></td>
</tr>
<tr>
<td>Supply current at nominal supply voltage (depending on system architecture)</td>
<td>47 mA per communication module at 24 V</td>
</tr>
<tr>
<td>Internal power supply source</td>
<td>Communication module bus</td>
</tr>
</tbody>
</table>

*Hardware descriptions > Communication modules for AC500(-XC) processor modules*
### Parameter

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Usable CPUs</td>
<td>PM56xx [Chapter 5.2.1.2.2 “PM56xx-2ETH for AC500 V3 products” on page 313]</td>
</tr>
<tr>
<td>Usable terminal bases</td>
<td>TB56xx [Chapter 5.2.3.1 “TB56xx for AC500 V3 products” on page 377]</td>
</tr>
</tbody>
</table>

#### Dimensions

1. Din rail 15 mm
2. Din rail 7.5 mm

*The dimensions are in mm and in brackets in inch.*

#### Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 176 000 R0080</td>
<td>CM5640-2ETH, communication module Ethernet TCP/IP with 2 RJ45 CPU port extensions</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 376 000 R0080</td>
<td>CM5640-2ETH-XC, communication module Ethernet TCP/IP with 2 RJ45 CPU port extensions, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
### 5.2.2.8 PROFIBUS

#### 5.2.2.8.1 CM582-DP - PROFIBUS DP slave

**Features**

- PROFIBUS DP slave 12 Mbit/s
- Compatible with Automation Builder version starting from V2.0.2, and with CPU firmware version starting from V2.6
- XC version for use in extreme ambient conditions available

![CM582-DP Diagram](image)

1. 5 LEDs for state display
2. Label
3. Communication interface PROFIBUS DP D-sub, 9-pin, female
   - Sign for XC version

**Purpose**

Communication module CM582-DP enables communication over the PROFIBUS DP field bus. For use in extreme ambient conditions (e.g. wider temperature and humidity range), a special XC version of the device is available.
The PROFIBUS DP connector (9-pin, female) has the following pin assignment:

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td>2</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td>3</td>
<td>RxD/TxD-P</td>
<td>Receive/Transmit positive</td>
</tr>
<tr>
<td>4</td>
<td>CNTR-P</td>
<td>Control signal for repeater, positive</td>
</tr>
<tr>
<td>5</td>
<td>DGND</td>
<td>Reference potential for data exchange and +5 VI</td>
</tr>
<tr>
<td>6</td>
<td>VP</td>
<td>+5 V (power supply for the bus terminating resistors)</td>
</tr>
<tr>
<td>7</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td>8</td>
<td>RxD/TxD-N</td>
<td>Receive/Transmit negative</td>
</tr>
<tr>
<td>9</td>
<td>NC</td>
<td>Not connected</td>
</tr>
</tbody>
</table>

Table 105: Correlation of transmission rate, bit time and cable length:

<table>
<thead>
<tr>
<th>Transmission rate in [kbit/s]</th>
<th>Bit time [tBit]</th>
<th>Max. cable length in [m]</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.6</td>
<td>104.2 μs</td>
<td>1200</td>
</tr>
<tr>
<td>19.2</td>
<td>52.1 μs</td>
<td>1200</td>
</tr>
<tr>
<td>31.25</td>
<td>32 μs</td>
<td>1200</td>
</tr>
<tr>
<td>45.45</td>
<td>22 μs</td>
<td>1200</td>
</tr>
<tr>
<td>93.75</td>
<td>10.7 μs</td>
<td>1200</td>
</tr>
<tr>
<td>187.5</td>
<td>5.3 μs</td>
<td>1000</td>
</tr>
<tr>
<td>500</td>
<td>2 μs</td>
<td>400</td>
</tr>
<tr>
<td>1500</td>
<td>666.7 ns</td>
<td>200</td>
</tr>
<tr>
<td>3000</td>
<td>333.3 ns</td>
<td>100</td>
</tr>
<tr>
<td>6000</td>
<td>166.7 ns</td>
<td>100</td>
</tr>
<tr>
<td>12000</td>
<td>83.3 ns</td>
<td>100</td>
</tr>
</tbody>
</table>
State LEDs

The PROFIBUS state is shown by state LEDs.

Table 106: Meaning of the diagnosis LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR</td>
<td>Green</td>
<td>ON (light)</td>
<td>Power supply available.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OFF (dark)</td>
<td>Power supply not available or defective hardware</td>
</tr>
<tr>
<td>RDY</td>
<td>Yellow</td>
<td>ON</td>
<td>Boot procedure</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td>Boot failure</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OFF</td>
<td>---</td>
</tr>
<tr>
<td>RUN</td>
<td>Green</td>
<td>ON</td>
<td>Communication module is operational</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OFF</td>
<td>Communication module is not operational</td>
</tr>
<tr>
<td>STA</td>
<td>Green</td>
<td>ON</td>
<td>Communication to all slaves is established</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Flashes cyclic</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Flashes non-cyclic</td>
<td>No configuration or stack error</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OFF</td>
<td>No communication</td>
</tr>
<tr>
<td>ERR</td>
<td>Red</td>
<td>Blinking</td>
<td>No data exchange to the master module or the cable is disconnected</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OFF</td>
<td>No error</td>
</tr>
<tr>
<td>STA</td>
<td>Yellow</td>
<td>Blinking (synchronously)</td>
<td>No production data available, no bus communication possible.</td>
</tr>
<tr>
<td>ERR</td>
<td>Yellow</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

LED state during firmware update

<table>
<thead>
<tr>
<th>LED state during firmware update</th>
<th>STA</th>
<th>Green</th>
<th>Blinking (synchronously)</th>
<th>Firmware file transfers during communication module firmware update.</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERR</td>
<td>Red</td>
<td>(alternately)</td>
<td>Communication module writes the firmware file to the internal flash. Do not power off the PLC!</td>
<td></td>
</tr>
</tbody>
</table>

Technical data

The system data of AC500 and S500 are applicable to the standard version “Chapter 5.1.2 “System data AC500” on page 166.

The system data of AC500-XC are applicable to the XC version “Chapter 5.1.3 “System data AC500-XC” on page 169.

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>State indication</td>
<td>By 5 LEDs PWR, RDY, RUN, STA, ERR</td>
</tr>
<tr>
<td>Usable CPUs</td>
<td>PM57x, PM58x, PM59x</td>
</tr>
</tbody>
</table>
### Parameter Value

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Usable terminal bases</td>
<td>All TB5xx</td>
</tr>
<tr>
<td>Current consumption from 24 V DC power supply at the terminal base of the CPU</td>
<td>Typ. 65 mA</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Through the communication module interface of the terminal base</td>
</tr>
<tr>
<td>Maximum number of cyclic input data</td>
<td>244 bytes</td>
</tr>
<tr>
<td>Maximum number of cyclic output data</td>
<td>244 bytes</td>
</tr>
<tr>
<td>Maximum number of acyclic read/write</td>
<td>240 bytes</td>
</tr>
<tr>
<td>Configuration data</td>
<td>max. 244 bytes</td>
</tr>
<tr>
<td>Parameter data</td>
<td>237 bytes application specific parameters</td>
</tr>
<tr>
<td>Processor</td>
<td>Hilscher NETX 100</td>
</tr>
<tr>
<td>Internal RAM memory</td>
<td>8 MB</td>
</tr>
<tr>
<td>External Flash memory</td>
<td>8 MB</td>
</tr>
<tr>
<td>Weight</td>
<td>Ca. 150 g</td>
</tr>
</tbody>
</table>

### Technical data of the interface

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface socket</td>
<td>9-pin, D-sub socket</td>
</tr>
<tr>
<td>Transmission standard</td>
<td>EIA RS-485 acc. to IEC 61158/61784, potential-free</td>
</tr>
<tr>
<td>Transmission protocol</td>
<td>PROFIBUS DP</td>
</tr>
<tr>
<td>Transmission rate</td>
<td>9.6 kbit/s up to 12 Mbit/s</td>
</tr>
</tbody>
</table>

### Dimensions

1. Din rail 15 mm
2. Din rail 7.5 mm
The dimensions are in mm and in brackets in inch.

### Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 172 200 R0001</td>
<td>CM582-DP, communication module PROFIBUS DP slave, 12 MBit/s</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 372 200 R0001</td>
<td>CM582-DP-XC, communication module PROFIBUS DP slave, 12 MBit/s, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

### 5.2.2.8.2 CM592-DP - PROFIBUS DP master

**Features**

- Master 12 Mbit/s
- XC version for use in extreme ambient conditions available
Purpose

Communication module CM592-DP enables communication over the PROFIBUS DP field bus. For use in extreme ambient conditions (e.g. wider temperature and humidity range), a special XC version of the device is available.
Connections
Field bus interface

The PROFIBUS DP connector (9-pin, female) has the following pin assignment:

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td>2</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td>3</td>
<td>RxD/TxD-P</td>
<td>Receive/Transmit positive</td>
</tr>
<tr>
<td>4</td>
<td>CNTR-P</td>
<td>Control signal for repeater, positive</td>
</tr>
<tr>
<td>5</td>
<td>DGND</td>
<td>Reference potential for data exchange and +5 Vl</td>
</tr>
<tr>
<td>6</td>
<td>VP</td>
<td>+5 V (power supply for the bus terminating resistors)</td>
</tr>
<tr>
<td>7</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td>8</td>
<td>RxD/TxD-N</td>
<td>Receive/Transmit negative</td>
</tr>
<tr>
<td>9</td>
<td>NC</td>
<td>Not connected</td>
</tr>
</tbody>
</table>

Table 107: Correlation of transmission rate, bit time and cable length:

<table>
<thead>
<tr>
<th>Transmission rate in [kbit/s]</th>
<th>Bit time [tBit]</th>
<th>Max. cable length in [m]</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.6</td>
<td>104.2 µs</td>
<td>1200</td>
</tr>
<tr>
<td>19.2</td>
<td>52.1 µs</td>
<td>1200</td>
</tr>
<tr>
<td>31.25</td>
<td>32 µs</td>
<td>1200</td>
</tr>
<tr>
<td>45.45</td>
<td>22 µs</td>
<td>1200</td>
</tr>
<tr>
<td>93.75</td>
<td>10.7 µs</td>
<td>1200</td>
</tr>
<tr>
<td>187.5</td>
<td>5.3 µs</td>
<td>1000</td>
</tr>
<tr>
<td>500</td>
<td>2 µs</td>
<td>400</td>
</tr>
<tr>
<td>1500</td>
<td>666.7 ns</td>
<td>200</td>
</tr>
<tr>
<td>3000</td>
<td>333.3 ns</td>
<td>100</td>
</tr>
<tr>
<td>6000</td>
<td>166.7 ns</td>
<td>100</td>
</tr>
<tr>
<td>12000</td>
<td>83.3 ns</td>
<td>100</td>
</tr>
</tbody>
</table>
State LEDs

The PROFIBUS state is shown by state LEDs.

Table 108: Meaning of the diagnosis LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR</td>
<td>Green</td>
<td>ON (light)</td>
<td>Power supply available</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OFF (dark)</td>
<td>Power supply not available or defective hardware</td>
</tr>
<tr>
<td>RDY</td>
<td>Yellow</td>
<td>ON</td>
<td>Boot procedure</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td>Boot failure</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OFF</td>
<td>---</td>
</tr>
<tr>
<td>RUN</td>
<td>Green</td>
<td>ON</td>
<td>Communication module is operational</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OFF</td>
<td>Communication module is not operational</td>
</tr>
<tr>
<td>STA</td>
<td>Green</td>
<td>ON</td>
<td>Communication to all slaves is established</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Flashes cyclic</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Flashes non- cyclic</td>
<td>No configuration or stack error</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OFF</td>
<td>No communication</td>
</tr>
<tr>
<td>ERR</td>
<td>Red</td>
<td>ON</td>
<td>Communication to one/all slaves is disconnected</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Flashes cyclic</td>
<td>Communication to at least one slave is disconnected</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OFF</td>
<td>No error</td>
</tr>
<tr>
<td>STA</td>
<td>Yellow</td>
<td>Blinking (synchronously)</td>
<td>No production data available, no bus communication possible.</td>
</tr>
<tr>
<td>ERR</td>
<td>Yellow</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

LED state during firmware update

| STA  | Green | Blinking (synchronously) | Firmware file transfers during communication module firmware update. |
| ERR  | Red   | Blinking (alternately)   | Communication module writes the firmware file to the user flash memory. Do not power off the PLC! |

Technical data

The system data of AC500 and S500 are applicable to the standard version “Chapter 5.1.2 “System data AC500” on page 166.

The system data of AC500-XC are applicable to the XC version “Chapter 5.1.3 “System data AC500-XC” on page 169.

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>State indication</td>
<td>By 5 LEDs (PWR, RDY, RUN, STA, ERR)</td>
</tr>
<tr>
<td>Usable CPUs</td>
<td>PM57x, PM58x, PM59x</td>
</tr>
<tr>
<td>Usable terminal bases</td>
<td>All TB5xx</td>
</tr>
<tr>
<td>Current consumption from 24 V DC power supply at the terminal base of the CPU</td>
<td>Typ. 65 mA</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Through the communication module interface of the terminal base</td>
</tr>
<tr>
<td>Maximum number of supported slaves</td>
<td>125 (DPV0/DPV1)</td>
</tr>
<tr>
<td>Maximum number of total cyclic input data</td>
<td>5712 bytes (Status information is separately managed)</td>
</tr>
<tr>
<td>Maximum number of total cyclic output data</td>
<td>5760 bytes</td>
</tr>
<tr>
<td>Maximum number of cyclic input data</td>
<td>244 bytes/slave</td>
</tr>
<tr>
<td>Maximum number of cyclic output data</td>
<td>244 bytes/slave</td>
</tr>
<tr>
<td>Configuration data</td>
<td>max. 244 bytes per slave</td>
</tr>
<tr>
<td>Parameterization data per slave</td>
<td>7 bytes/slave standard parameters, 237 bytes/slave application specific parameters</td>
</tr>
<tr>
<td>Maximum number of acyclic read/write</td>
<td>240 bytes per slave and telegram</td>
</tr>
<tr>
<td>Processor</td>
<td>Hilscher NETX 100</td>
</tr>
<tr>
<td>Internal RAM memory</td>
<td>8 MB</td>
</tr>
<tr>
<td>External user flash memory</td>
<td>8 MB</td>
</tr>
<tr>
<td>Weight</td>
<td>Ca. 150 g</td>
</tr>
</tbody>
</table>

---

**Technical data of the interface**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface socket</td>
<td>9-pin, D-sub socket</td>
</tr>
<tr>
<td>Transmission standard</td>
<td>EIA RS-485 acc. to IEC 61158/61784, potential-free</td>
</tr>
<tr>
<td>Transmission protocol</td>
<td>PROFIBUS DP</td>
</tr>
<tr>
<td>Transmission rate</td>
<td>9.6 kbit/s up to 12 Mbit/s</td>
</tr>
</tbody>
</table>
Dimensions

The dimensions are in mm and in brackets in inch.

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 173 200 R0001</td>
<td>CM592-DP, communication module PROFIBUS DP master, 12 MBit/s</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 373 200 R0001</td>
<td>CM592-DP-XC, communication module PROFIBUS DP master, 12 MBit/s, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

5.2.2.8.3 PROFIBUS connection details

Attachment plug 9-pin D-sub connector, male for the bus cable

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fastening torque</td>
<td>0.4 Nm</td>
</tr>
</tbody>
</table>
### Assignment

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Shield</td>
<td>Shielding, protective ground</td>
</tr>
<tr>
<td>2</td>
<td>not used</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>RxD/TxD-P</td>
<td>Reception / transmission line, positive</td>
</tr>
<tr>
<td>4</td>
<td>CBTR-P</td>
<td>Control signal for repeater, positive (optional)</td>
</tr>
<tr>
<td>5</td>
<td>DGND</td>
<td>Reference potential for data lines and +5 V</td>
</tr>
<tr>
<td>6</td>
<td>VP</td>
<td>+5 V, supply voltage for bus terminating resistors</td>
</tr>
<tr>
<td>7</td>
<td>not used</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>RxD/TxD-N</td>
<td>Reception / transmission line, negative</td>
</tr>
<tr>
<td>9</td>
<td>CNTR-N</td>
<td>Control signal for repeater, negative (optional)</td>
</tr>
</tbody>
</table>

### Bus cable

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Twisted pair (shielded)</td>
</tr>
<tr>
<td>Characteristic impedance</td>
<td>135 Ω ... 165 Ω</td>
</tr>
<tr>
<td>Cable capacitance</td>
<td>&lt; 30 pF/m</td>
</tr>
<tr>
<td>Conductor diameter of the cores</td>
<td>≥ 0.64 mm</td>
</tr>
<tr>
<td>Conductor cross section of the cores</td>
<td>≥ 0.34 mm²</td>
</tr>
<tr>
<td>Cable resistance per core</td>
<td>≤ 55 Ω/km</td>
</tr>
<tr>
<td>Loop resistance (resistance of two cores)</td>
<td>≤ 110 Ω/km</td>
</tr>
</tbody>
</table>

### Cable lengths

The maximum possible cable length of a PROFIBUS subnet within a segment depends on the transmission rate (baud rate).

<table>
<thead>
<tr>
<th>Transmission Rate</th>
<th>Maximum Cable Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.6 / 19.2 / 93.75 kBaud</td>
<td>1200 m</td>
</tr>
<tr>
<td>187.5 kBaud</td>
<td>1000 m</td>
</tr>
<tr>
<td>500 kBaud</td>
<td>400 m</td>
</tr>
<tr>
<td>1.5 MBaud</td>
<td>200 m</td>
</tr>
<tr>
<td>3 MBaud to 12 MBaud</td>
<td>100 m</td>
</tr>
</tbody>
</table>

Branch lines are generally permissible for transmission rates of up to 1500 kbit/s. But in fact they should be avoided for transmission rates higher than 500 kbit/s.

### Bus terminating resistors

The line ends (of the bus segments) have to be terminated using bus terminating resistors according to the drawing below. The bus terminating resistors are usually placed inside the bus connector.
Repeater

One bus segment can have up to 32 subscribers. Using repeaters a system can be expanded to up to 126 subscribers. Repeaters are also required for longer transfer lines. Please note that a repeater's load to the bus segment is the same as the load of a normal bus subscriber. The sum of normal bus subscribers and repeaters in one bus segment must not exceed 32.

Station 1

Station 31

Station 32

Station 61

Bus segment 1:
max. 31 stations
+ 1 repeater

Bus segment 2:
max. 30 stations
+ 2 repeaters

Fig. 42: Principle example for a PROFIBUS-DP system with repeaters (1500 kbit/s baud rate)

5.2.2.9 PROFINET

5.2.2.9.1 CM579-PNIO - PROFINET IO RT controller

Features

- PROFINET IO controller
- Integrated 2-port switch
- XC version for use in extreme ambient conditions available
1 5 LEDs for state display
2 2 rotary switches for address setting (not used)
3 Label
4 2 communication interfaces RJ45 (PNIO1 and PNIO2)
5 Sign for XC version

Intended purpose

The communication module is for PROFINET RT communication.

The PROFINET communication module includes an internal Ethernet switch. The connection to the Ethernet can be established directly to the communication module. An additional switch is not necessary.

The communication module is configured via the dual-port memory by means of a system configurator. The configuration is saved on a non-volatile Flash EPROM memory.

For use in extreme ambient conditions (e.g. wider temperature and humidity range), a special XC version of the device is available.
Functionality

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol</td>
<td>PROFINET IO RT</td>
</tr>
<tr>
<td>Usable CPUs</td>
<td>PM57x, PM58x, PM59x</td>
</tr>
<tr>
<td></td>
<td>✿ Chapter 5.2.1.2.2 “PM56xx-2ETH for AC500 V3 products” on page 313</td>
</tr>
<tr>
<td>Usable terminal bases</td>
<td>All TB56xx (not TB5600)</td>
</tr>
<tr>
<td></td>
<td>✿ Chapter 5.2.3.1 “TB56xx for AC500 V3 products” on page 377</td>
</tr>
<tr>
<td>Field bus connector</td>
<td>2 RJ45 (PNIO1 and PNIO2), with integrated 2-port switch</td>
</tr>
<tr>
<td>Internal supply</td>
<td>Via the communication module interface of the terminal base</td>
</tr>
</tbody>
</table>

Connections

Field bus interfaces

The communication module provides 2 RJ45 interfaces.

Pin assignment

<table>
<thead>
<tr>
<th>Interface</th>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet RJ45</td>
<td>1</td>
<td>TxD+</td>
<td>Transmit data +</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>TxD-</td>
<td>Transmit data -</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>RxD+</td>
<td>Receive data +</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>RxD-</td>
<td>Receive data -</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td>Shield</td>
<td>1</td>
<td>Cable shield</td>
<td>Functional earth</td>
</tr>
</tbody>
</table>

In corrosive environment, please protect unused connectors using the TA535 accessory.

Not supplied with this device.

✿ Further information about wiring and cable types
State LEDs

The PROFINET state is shown by the state LEDs.

**Table 109: Meaning of the diagnosis LEDs**

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR</td>
<td>Green</td>
<td>On</td>
<td>Power supply available</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>Power supply not available or defective hardware</td>
</tr>
<tr>
<td>RDY</td>
<td>Yellow</td>
<td>On</td>
<td>Boot procedure</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td>Boot failure</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>---</td>
</tr>
<tr>
<td>RUN</td>
<td>Green</td>
<td>On</td>
<td>Communication module is operational</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>Communication module is not operational</td>
</tr>
<tr>
<td>STA1</td>
<td>Red</td>
<td>On</td>
<td>Diagnosis alarm reported. At least one device is having a diagnosis alarm. In incorporation with STA2 PNIO: License fault.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td>System error</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>No system error</td>
</tr>
<tr>
<td>STA2</td>
<td>Red</td>
<td>On</td>
<td>No connection; in incorporation with STA1 PNIO: license fault</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td>Configuration fault: some configured I/O modules are not connected</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>No bus error; communication is running</td>
</tr>
<tr>
<td>STA1</td>
<td>Yellow</td>
<td>Blinking (synchronously)</td>
<td>No production data available, no bus communication possible.</td>
</tr>
<tr>
<td>STA2</td>
<td>Yellow</td>
<td>Blinking (synchronously)</td>
<td>Firmware file transfers during communication module firmware update.</td>
</tr>
<tr>
<td>LED state during firmware update</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>STA1</td>
<td>Green</td>
<td>Blinking (alternately)</td>
<td>Communication module writes the firmware file to the internal flash. Do not power off the PLC!</td>
</tr>
<tr>
<td>STA2</td>
<td>Red</td>
<td>Blinking (alternately)</td>
<td>Communication module writes the firmware file to the internal flash. Do not power off the PLC!</td>
</tr>
</tbody>
</table>

The RJ45 Ethernet connector contains two LEDs showing the current Ethernet port connection state.

**Table 110: Meaning of the diagnosis LEDs**

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PNIO1 LED &quot;Link&quot;</td>
<td>Green</td>
<td>On</td>
<td>Ethernet connection established</td>
</tr>
<tr>
<td>PNIO1 LED &quot;RX/TX&quot;</td>
<td>Yellow</td>
<td>Off</td>
<td>No Ethernet connection</td>
</tr>
<tr>
<td>PNIO1 LED &quot;RX/TX&quot;</td>
<td>Yellow</td>
<td>On</td>
<td>---</td>
</tr>
<tr>
<td>PNIO1 LED &quot;RX/TX&quot;</td>
<td>Yellow</td>
<td>Blinking</td>
<td>PROFINET device sends/receives frames</td>
</tr>
<tr>
<td>PNIO1 LED &quot;RX/TX&quot;</td>
<td>Yellow</td>
<td>Off</td>
<td>---</td>
</tr>
<tr>
<td>PNIO2 LED &quot;Link&quot;</td>
<td>Green</td>
<td>On</td>
<td>Ethernet connection established</td>
</tr>
</tbody>
</table>
### Technical data

The system data of AC500 and S500 are applicable to the standard version [Chapter 5.1.2 “System data AC500” on page 166](#).

The system data of AC500-XC are applicable to the XC version [Chapter 5.1.3 “System data AC500-XC” on page 169](#).

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol</td>
<td>PROFINET IO RT</td>
</tr>
<tr>
<td>Bus connection</td>
<td>2 RJ45 (PNIO1 and PNIO2), with integrated 2-port switch</td>
</tr>
<tr>
<td>Switch</td>
<td>Integrated</td>
</tr>
<tr>
<td>Technology</td>
<td>Hilscher NETX 100</td>
</tr>
<tr>
<td>Transfer rate</td>
<td>100 Mbit/s (full-duplex)</td>
</tr>
<tr>
<td>Transfer method</td>
<td>According to Ethernet II, IEEE 802.3</td>
</tr>
<tr>
<td>Ethernet</td>
<td>100 base-TX, internal switch, 2x RJ45 socket</td>
</tr>
<tr>
<td>Bus length (segment length max.)</td>
<td>100 m</td>
</tr>
<tr>
<td>Indicators</td>
<td>5 LEDs</td>
</tr>
<tr>
<td>Usable terminal bases</td>
<td>All TB56xx (not TB5600) <a href="#"><em>Chapter 5.2.3.1 “TB56xx for AC500 V3 products” on page 377</em></a></td>
</tr>
<tr>
<td>Supported alarm types</td>
<td>Process alarm, diagnostic alarm, return of Sub-Module, plug alarm, pull alarm</td>
</tr>
<tr>
<td>Alarm processing</td>
<td>Requires handling in application program</td>
</tr>
<tr>
<td>Current consumption from 24 V DC power supply at the terminal base of the CPU</td>
<td>Typ. 85 mA</td>
</tr>
<tr>
<td>Internal supply</td>
<td>Via the communication module interface of the terminal base</td>
</tr>
<tr>
<td>Weight</td>
<td>Ca. 170 g</td>
</tr>
<tr>
<td>Maximum number of remote I/O stations connected</td>
<td>128</td>
</tr>
</tbody>
</table>

---

#### LED Color State Description

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PNIO2 LED &quot;RX/TX&quot;</td>
<td>Yellow</td>
<td>Off</td>
<td>No Ethernet connection</td>
</tr>
<tr>
<td></td>
<td></td>
<td>On</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td>PROFINET device sends/receives frames</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>--</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supported protocols</td>
<td>RTC - real-time cyclic protocol, class 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RTA - real-time acyclic protocol</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>DCP - discovery and configuration protocol *)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CL-RPC - connectionless remote procedure call</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Since revision FW 2.4.8.0 additionally</td>
<td>LLDP - link layer discovery protocol</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>SNMP - simply network management protocol (SNMP v1)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Acyclic services</td>
<td>PNIO read / write (max. 1392 bytes per telegram, max. 4096 bytes per service request)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total quantity of input and output data</td>
<td>1024 bytes per I/O module</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CM579-PNIO &lt; FW 2.4.8.0</td>
<td>3072 bytes in total</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CM579-PNIO = FW 2.4.8.0</td>
<td>1024 bytes per I/O module</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CM579-PNIO &gt; FW 2.4.8.0</td>
<td>4096 bytes in total</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Min. bus cycle</td>
<td>1 ms</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conformance class</td>
<td>CC A</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*) CM579-PNIO does not allow setting "Station name" by using PROFINET service "DCP SET NameOfStation".

Dimensions

1 Din rail 15 mm
2 Din rail 7.5 mm
Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 170 901 R0101</td>
<td>CM579-PNIO, PROFINET</td>
<td>Active</td>
</tr>
<tr>
<td></td>
<td>communication module</td>
<td></td>
</tr>
<tr>
<td>1SAP 370 901 R0101</td>
<td>CM579-PNIO-XC, PROFINET</td>
<td>Active</td>
</tr>
<tr>
<td></td>
<td>communication module, XC version</td>
<td></td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

5.2.2.9.2 CM589-PNIO(-4) - PROFINET IO RT with 4 devices

Features

- PROFINET IO device
- Integrated 2-port switch
- XC version for use in extreme ambient conditions available
The communication module is for PROFINET RT communication.
The PROFINET communication module includes an internal Ethernet switch. The connection to the Ethernet can be established directly to the communication module. An additional switch is not necessary.

The communication module is configured via the dual-port memory by means of a system configurator. The configuration is saved on a non-volatile Flash EPROM memory.

For use in extreme ambient conditions (e.g. wider temperature and humidity range), a special XC version of the device is available.

**CM589-PNIO(-4)**

CM589-PNIO supports one application relation to communicate to one single PROFINET IO controller.

CM589-PNIO-4 supports 4 application relations to communicate to up to 4 PROFINET IO controllers in parallel using PROFINET Shared Device technology.
Functionality

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol</td>
<td>PROFINET IO RT</td>
</tr>
<tr>
<td>Usable CPUs</td>
<td>PM57x, PM58x, PM59x</td>
</tr>
<tr>
<td></td>
<td>Chapter 5.2.1.2.2 &quot;PM56xx-2ETH for AC500 V3 products&quot; on page 313</td>
</tr>
<tr>
<td>Usable terminal bases</td>
<td>All TB56xx (not TB5600)</td>
</tr>
<tr>
<td></td>
<td>Chapter 5.2.3.1 &quot;TB56xx for AC500 V3 products&quot; on page 377</td>
</tr>
<tr>
<td>Field bus connector</td>
<td>2 RJ45 (PNI01 and PNI02), with integrated 2-port switch</td>
</tr>
<tr>
<td>Internal supply</td>
<td>Via the communication module interface of the terminal base</td>
</tr>
</tbody>
</table>

Connections

Field bus interfaces

The PROFINET communication module provides 2 RJ45 interfaces:

Pin assignment

<table>
<thead>
<tr>
<th>Interface</th>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet</td>
<td>1</td>
<td>TxD+</td>
<td>Transmit data +</td>
</tr>
<tr>
<td>RJ45</td>
<td>2</td>
<td>TxD-</td>
<td>Transmit data -</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>RxD+</td>
<td>Receive data +</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>RxD-</td>
<td>Receive data -</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td>Shield</td>
<td>Cable shield</td>
<td>Functional earth</td>
</tr>
</tbody>
</table>

- In corrosive environment, please protect unused connectors using the TA535 accessory.
- Not supplied with this device.

- Further information about wiring and cable types

Addressing

The module reads the position of the rotary switches only during power-up, i.e. changes of the switch position during operation will have no effect until the next module initialization.
State LEDs

The PROFINET state is shown by the state LEDs.

Table 111: Meaning of the diagnosis LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR</td>
<td>Green</td>
<td>On</td>
<td>Power supply available</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>Power supply not available or defective hardware</td>
</tr>
<tr>
<td>RDY</td>
<td>Yellow</td>
<td>On</td>
<td>Boot procedure</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td>Boot failure</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>RUN</td>
<td>Green</td>
<td>On</td>
<td>Communication module is operational</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>Communication module is not operational</td>
</tr>
<tr>
<td>STA1</td>
<td>Red</td>
<td>On</td>
<td>System error; watchdog timeout</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>No system error</td>
</tr>
<tr>
<td>STA2</td>
<td>Red</td>
<td>On</td>
<td>No connection; no configuration</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td>No data exchange</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>No bus error, communication is running</td>
</tr>
<tr>
<td>STA1</td>
<td>Yellow</td>
<td>Blinking</td>
<td>No production data available, no bus communication possible.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(synchronously)</td>
<td></td>
</tr>
<tr>
<td>STA2</td>
<td>Yellow</td>
<td>Blinking</td>
<td>No production data available, no bus communication possible.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(synchronously)</td>
<td></td>
</tr>
</tbody>
</table>

The RJ45 Ethernet connector contains two LEDs showing the current Ethernet port connection state.

Table 112: Meaning of the diagnosis LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PNO1 LED &quot;Link&quot;</td>
<td>Green</td>
<td>On</td>
<td>Ethernet connection established</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>No Ethernet connection</td>
</tr>
<tr>
<td>PNO1 LED &quot;RX/TX&quot;</td>
<td>Yellow</td>
<td>On</td>
<td>PROFINET device sends/receives frames</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td>PROFINET device sends/receives frames</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>PNO2 LED &quot;Link&quot;</td>
<td>Green</td>
<td>On</td>
<td>Ethernet connection established</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>No Ethernet connection</td>
</tr>
</tbody>
</table>
### LED Color State Description

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PNIO2 LED &quot;RX/TX&quot;</td>
<td>Yellow</td>
<td>On</td>
<td>PROFINET device sends/receives frames</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blinking</td>
<td>PROFINET device sends/receives frames</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>---</td>
</tr>
</tbody>
</table>

### Technical data

The system data of AC500 and S500 are applicable to the standard version see *Chapter 5.1.2 “System data AC500” on page 166.*

The system data of AC500-XC are applicable to the XC version see *Chapter 5.1.3 “System data AC500-XC” on page 169.*

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol</td>
<td>PROFINET IO RT</td>
</tr>
<tr>
<td>Bus connection</td>
<td>2 RJ45 (PNIO1 and PNIO2), with integrated 2-port switch</td>
</tr>
<tr>
<td>Switch</td>
<td>Integrated</td>
</tr>
<tr>
<td>Technology</td>
<td>Hilscher NETX 100</td>
</tr>
<tr>
<td>Transfer rate</td>
<td>100 Mbit/s (full-duplex)</td>
</tr>
<tr>
<td>Transfer method</td>
<td>According to Ethernet II, IEEE 802.3</td>
</tr>
<tr>
<td>Ethernet</td>
<td>100 base-TX, internal switch, 2x RJ45 socket</td>
</tr>
<tr>
<td>Bus length (segment length max.)</td>
<td>100 m</td>
</tr>
<tr>
<td>Indicators</td>
<td>5 LEDs</td>
</tr>
<tr>
<td>Usable terminal bases</td>
<td>All TB56xx (not TB5600) see <em>Chapter 5.2.3.1 “TB56xx for AC500 V3 products” on page 377</em></td>
</tr>
<tr>
<td>Supported alarm types</td>
<td>Process alarm, diagnostic alarm, return of SubModule, plug alarm, pull alarm</td>
</tr>
<tr>
<td>Current consumption from 24 V DC power supply at the terminal base of the CPU</td>
<td>Typ. 85 mA</td>
</tr>
<tr>
<td>Internal supply</td>
<td>Via the communication module interface of the terminal base</td>
</tr>
<tr>
<td>Setting of the I/O device identifier</td>
<td>With 2 rotary switches at the front side of the module</td>
</tr>
<tr>
<td>Weight</td>
<td>Ca. 170 g</td>
</tr>
</tbody>
</table>
### Parameter | Value
--- | ---
Supported protocols | RTC - real-time cyclic protocol, class 1
| | RTA - real-time acyclic protocol
| | DCP - discovery and configuration protocol *)
| | CL-RPC - connectionless remote procedure call
| | LLDP - link layer discovery protocol
| | SNMP - simply network management protocol
| | MRP - MRP Client

### Acyclic services
| | PNIO read / write
| | CM589-PNIO < FW 1.4.0: max. 1024 bytes
| | CM589-PNIO ≥ FW 1.4.0: max. 8096 bytes
| | CM589-PNIO-4: max. 8096 bytes

### Total quantity of input and output data
| | CM589-PNIO < FW 1.4.0 (respectively for input and output): max. 1024 byte
| | CM589-PNIO ≥ FW 1.4.0 (respectively for input and output): max. 1440 byte
| | CM589-PNIO-4 (respectively for input and output): max. 1440 byte

### Min. bus cycle
| | 1 ms

### Conformance class
| | CC B

*) Setting NameOfStation via service "DCP SET NameOfStation" is enabled only if rotary switches are adjusted to position "00".

### Dimensions

1. Din rail 15 mm
2. Din rail 7.5 mm

*The dimensions are in mm and in brackets in inch.*
Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 172 900 R0011</td>
<td>CM589-PNIO, PROFINET communication module</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 372 900 R0011</td>
<td>CM589-PNIO-XC, PROFINET communication module, XC version</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 172 900 R0111</td>
<td>CM589-PNIO-4, PROFINET communication module</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 372 900 R0111</td>
<td>CM589-PNIO-4-XC, PROFINET communication module, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

5.2.3 Terminal bases for AC500(-XC) processor modules and communication modules

5.2.3.1 TB56xx for AC500 V3 products

5.2.3.1.1 Features

- TB5600-2ETH: 1 processor module, with network interface 2 Ethernet RJ45, 1 CAN and 1 COM1
- TB5610-2ETH: 1 processor module, 1 communication module, with network interface 2 Ethernet RJ45, 1 CAN and 1 COM1
- TB5620-2ETH: 1 processor module, 2 communication modules, with network interface 2 Ethernet RJ45, 1 CAN and 1 COM1
- TB5640-2ETH: 1 processor module, 4 communication modules, with network interface 2 Ethernet RJ45, 1 CAN and 1 COM1
- TB5660-2ETH: 1 processor module, 6 communication modules, with network interface 2 Ethernet RJ45, 1 CAN and 1 COM1
- XC version for use in extreme ambient conditions available

Terminal bases TB56xx-2ETH can only be used with processor modules PM56xx-2ETH.

Table 113: Combination of TB56xx-2ETH(-XC) and PM56xx(-XC)

<table>
<thead>
<tr>
<th>Processor module</th>
<th>PM5630</th>
<th>PM5650</th>
<th>PM5670</th>
<th>PM5675</th>
</tr>
</thead>
<tbody>
<tr>
<td>TB5600-2ETH</td>
<td>0 slot</td>
<td>0 slot</td>
<td>0 slot</td>
<td>0 slot</td>
</tr>
<tr>
<td>TB5610-2ETH</td>
<td>1 slot</td>
<td>1 slot</td>
<td>1 slot</td>
<td>1 slot</td>
</tr>
<tr>
<td>TB5620-2ETH</td>
<td>2 slots</td>
<td>2 slots</td>
<td>2 slots</td>
<td>2 slots</td>
</tr>
<tr>
<td>TB5640-2ETH</td>
<td>-</td>
<td>4 slots</td>
<td>4 slots</td>
<td>4 slots</td>
</tr>
<tr>
<td>TB5660-2ETH</td>
<td>-</td>
<td>-</td>
<td>6 slots</td>
<td>6 slots</td>
</tr>
</tbody>
</table>

Remarks:

The slots can be used for connecting communication modules or AC500-S modules. Note that only one AC500-S module can be connected at one terminal base.

1) PM567x must have an index ≥ C0.

The following figure shows the TB5620-2ETH as example.
1 I/O bus (10-pin, female) to connect the I/O terminal units
2 One available slot for the processor module
3 Slots for communication modules
4 Interface for CAN (5-pin terminal block, removable)
5 Power supply (5-pin terminal block, removable)
6 Serial interface COM1 (9-pin terminal block, removable)
7 RJ45 female connector for Ethernet connection
8 Holes for screw mounting

**XC version**  
**XC = eXtreme Conditions**

Extreme conditions
Terminal bases for use in extreme ambient conditions have no sign for XC version.
The figure 3 in the Part no. 1SAP3... (label) identifies the XC version.

### 5.2.3.1.2 Short description

Terminal bases TB56xx are used as sockets for processor modules PM56xx and communication modules.

Up to 10 I/O terminal units for I/O expansion modules can be added to these terminal bases.

The terminal bases have slots for one processor module and for communication modules as well as terminals and interfaces for power supply, expansion and networking.
Table 114: Combination of TB56xx-2ETH(-XC) and PM56xx(-XC)

<table>
<thead>
<tr>
<th>Processor module</th>
<th>PM5630</th>
<th>PM5650</th>
<th>PM5670</th>
<th>PM5675</th>
</tr>
</thead>
<tbody>
<tr>
<td>TB5600-2ETH</td>
<td>0 slot</td>
<td>0 slot</td>
<td>0 slot</td>
<td>0 slot</td>
</tr>
<tr>
<td>TB5610-2ETH</td>
<td>1 slot</td>
<td>1 slot</td>
<td>1 slot</td>
<td>1 slot</td>
</tr>
<tr>
<td>TB5620-2ETH</td>
<td>2 slots</td>
<td>2 slots</td>
<td>2 slots</td>
<td>2 slots</td>
</tr>
<tr>
<td>TB5640-2ETH</td>
<td>-</td>
<td>4 slots</td>
<td>4 slots</td>
<td>4 slots</td>
</tr>
<tr>
<td>TB5660-2ETH</td>
<td>-</td>
<td>-</td>
<td>6 slots</td>
<td>6 slots</td>
</tr>
</tbody>
</table>

Remarks:
The slots can be used for connecting communication modules or AC500-S modules. Note that only one AC500-S module can be connected at one terminal base.

1) PM567x must have an index $\geq C0$.

### NOTICE!
Risk of malfunctions!
- Unused slots for communication modules are not protected against accidental physical contact.
  - Unused slots for communication modules must be covered with dummy communication modules to achieve IP20 rating. Chapter 5.2.8.2.4 “TA524 - Dummy communication module” on page 1323.
  - I/O bus connectors must not be touched during operation.

#### 5.2.3.1.3 Connections

**I/O bus**

The I/O bus is the I/O data bus for the I/O modules. Through this bus, I/O and diagnosis data are transferred between the processor module and the I/O modules. Up to 10 I/O modules can be added.

- Chapter 4.2.3 “I/O bus - Communication within the PLC” on page 97
- Chapter 5.2.4.2 “I/O bus - Data transfer” on page 387

**Power supply**

The supply voltage of 24 V DC is connected to a removable 5-pin terminal block. L+/M exist twice. It is therefore possible to feed e.g. external sensors (up to 8 A max. with 1.5 mm² conductor) via these terminals, when the ambient temperature never exceeds +60 °C.

#### Pin assignment

<table>
<thead>
<tr>
<th>Pin Assignment</th>
<th>Label</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminal block removed</td>
<td>L+</td>
<td>+24 V DC</td>
<td>Positive pin of the power supply voltage</td>
</tr>
<tr>
<td>Terminal block inserted</td>
<td>L+</td>
<td>+24 V DC</td>
<td>Positive pin of the power supply voltage</td>
</tr>
<tr>
<td>Terminal block inserted</td>
<td>M</td>
<td>0 V</td>
<td>Negative pin of the power supply voltage</td>
</tr>
<tr>
<td>Terminal block inserted</td>
<td>M</td>
<td>0 V</td>
<td>Negative pin of the power supply voltage</td>
</tr>
<tr>
<td>Terminal block inserted</td>
<td>FE</td>
<td></td>
<td>Functional earth</td>
</tr>
</tbody>
</table>
NOTICE!
Risk of damaging the PLC due to improper voltage levels!
- Never exceed the maximum tolerance values for process and supply voltages.
- Never fall below the minimum tolerance values for process and supply voltages.
Observe the system data Chapter 5.1.2 “System data AC500” on page 166 and the technical data of the module used.

NOTICE!
Risk of malfunction!
To ensure reliability and proper functionality of processor modules below index C0, the supply voltage must ramp-up from 0 V to 24 V within max. 2.5 s.

NOTICE!
Risk of damaging the terminal base and power supply!
Short circuits might damage the terminal base and power supply.
Make sure that the four clamps L+ and M (two of each) are not wrongly connected (e. g. +/- of power supply is connected to both L+/L+ or both M/M).

NOTICE!
Risk of damaging the terminal base!
Terminal base can be damaged by connecting the power supply terminal block (L+/M) to COM1.
Make sure that the COM1 terminal block is always connected to the terminal base even if you do not use COM1 to prevent this.

NOTICE!
Risk of damaging the terminal base!
Excessive current might damage the clamp and terminal base.
Make sure that the current flowing through the removable clamps never exceeds 8 A (with 1.5 mm² conductor).

NOTICE!
For applications using XC versions!
To ensure reliability and proper function, make sure the ambient temperature never exceeds +60 °C when the current flowing through the removable clamps is 8 A (with 1.5 mm² conductor).

Serial interface COM1
The serial interface COM1 is connected to a removable 9-pin terminal block.
From firmware version V3.1 it is configurable for RS-232 or RS-485 (V3.0 RS-232 only).
## Ethernet interface

This interface is the connection to a processor module with onboard Ethernet e.g. PM56xx-2ETH.

*TB56xx-2ETH for processor modules PM56xx-2ETH provide 2 independent Ethernet interfaces. The two Ethernet interfaces can be configured as independent interfaces or with switch functionality. In case of two independent interfaces they must be configured to different subnets.*

*For structured Ethernet cabling only use cables according to TIA/EIA-568-A, ISO/IEC 11801 or EN 50173.*

### Pin assignment

<table>
<thead>
<tr>
<th>Interface</th>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>8 RJ45</td>
<td>1</td>
<td>TxD+</td>
<td>Transmit data +</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>TxD-</td>
<td>Transmit data -</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>RxD+</td>
<td>Receive data +</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>NU</td>
<td>Not used</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>NU</td>
<td>Not used</td>
</tr>
<tr>
<td>Interface</td>
<td>Pin</td>
<td>Signal</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-----</td>
<td>--------</td>
<td>--------------</td>
</tr>
<tr>
<td>6</td>
<td>RxD-</td>
<td>Receive data -</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>NU</td>
<td>Not used</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>NU</td>
<td>Not used</td>
<td></td>
</tr>
<tr>
<td>Shield</td>
<td>Cable shield</td>
<td>Functional earth</td>
<td></td>
</tr>
</tbody>
</table>

![NOTICE!](image)

Risk of corrosion!
Unused connectors and slots may corrode if XC devices are used in salt-mist environments.

Protect unused connectors and slots with TA535 protective caps for XC devices

*Chapter 5.2.8.3.6 “TA535 - Protective caps for XC devices” on page 1332.*

**Supported protocols and used Ethernet ports**

**Communication via Modbus TCP/IP**

**Supported protocols and used Ethernet ports**

---

**CAN interface**

This interface is the connection to a processor module with onboard CAN e.g. PM56xx-2ETH.

<table>
<thead>
<tr>
<th>Interface socket</th>
<th>COMBICON, 5-pin, female, removable plug with spring terminals</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission standard</td>
<td>ISO 11898, potential-free</td>
</tr>
<tr>
<td>Transmission protocol</td>
<td>CANopen (CAN), 1 Mbaud max.</td>
</tr>
<tr>
<td>Transfer rate (transfer rate)</td>
<td>50 kbit/s, 100 kbit/s, 125 kbit/s, 250 kbit/s, 500 kbit/s, 800 kbit/s, and 1 Mbit/s,</td>
</tr>
</tbody>
</table>

**Pin assignment**

*Table 115: Pin assignment of the CANopen connector*

<table>
<thead>
<tr>
<th>Interface</th>
<th>PIN</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAN</td>
<td>1</td>
<td>CAN_GND</td>
<td>CAN reference potential</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>CAN_L</td>
<td>Bus line, receive/transmit line, LOW</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>CAN_SHLD</td>
<td>Shield of the bus line</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>CAN_H</td>
<td>Bus line, receive/transmit line, HIGH</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>NC</td>
<td>Not connected</td>
</tr>
</tbody>
</table>

![NOTICE!](image)

Unused connector!
Make sure that the terminal block is always connected to the terminal base or communication module, even if you do not use the interface.
Bus length

The maximum possible bus length of a CAN network depends on bit rate (transmission rate) and cable type. The sum of all bus segments must not exceed the maximum bus length.

<table>
<thead>
<tr>
<th>Bit Rate (speed)</th>
<th>Bus Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Mbit/s</td>
<td>40 m</td>
</tr>
<tr>
<td>800 kbit/s</td>
<td>50 m</td>
</tr>
<tr>
<td>500 kbit/s</td>
<td>100 m</td>
</tr>
<tr>
<td>250 kbit/s</td>
<td>250 m</td>
</tr>
<tr>
<td>125 kbit/s</td>
<td>500 m</td>
</tr>
<tr>
<td>50 kbit/s</td>
<td>1000 m</td>
</tr>
</tbody>
</table>

Types of bus cables

Only bus cables with characteristics as recommended in ISO 11898 are to be used. The requirements for the bus cables depend on the length of the bus segment.

Bus terminating resistors

Both ends of the CAN bus have to be terminated with a 120 $\Omega$ ($\geq 1/4$ W, $\leq 5\%$) bus terminating resistor, to minimize signal reflection. The bus terminating resistor should be connected directly at the bus connector between the CAN signals (CAN_H and CAN_L).

5.2.3.1.4 Technical data

The system data of AC500 and S500 are applicable to the standard version. $\odot$ Chapter 5.1.2 "System data AC500" on page 166

The system data of AC500-XC are applicable to the XC version. $\odot$ Chapter 5.1.3 "System data AC500-XC" on page 169

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection of the supply voltage 24 V DC at the terminal base of the processor module</td>
<td>Removable 5-pin terminal block spring type</td>
</tr>
<tr>
<td>Max. current consumption from 24 V DC</td>
<td>TB5600: 0.25 A $^1$</td>
</tr>
<tr>
<td></td>
<td>TB5610: 0.35 A $^1$</td>
</tr>
<tr>
<td></td>
<td>TB5620: 0.4 A $^1$</td>
</tr>
<tr>
<td></td>
<td>TB5640: 0.6 A $^1$</td>
</tr>
<tr>
<td></td>
<td>TB5660: 0.8 A $^1$</td>
</tr>
<tr>
<td>Melting integral of a fuse at 24 V DC</td>
<td>Min. 1 A's $^2$</td>
</tr>
<tr>
<td>Peak inrush current from 24 V DC</td>
<td>55 A $^2$</td>
</tr>
<tr>
<td>Number of slots for processor modules</td>
<td>1 (on all terminal bases)</td>
</tr>
<tr>
<td>Processor module interfaces at TB56xx</td>
<td>I/O bus, ETH1, ETH2, CAN, COM1</td>
</tr>
</tbody>
</table>
### Parameter

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Net weight (terminal base without processor module)</td>
<td>TB5600: 155 g</td>
</tr>
<tr>
<td></td>
<td>TB5610: 180 g</td>
</tr>
<tr>
<td></td>
<td>TB5620: 210 g</td>
</tr>
<tr>
<td></td>
<td>TB5640: 260 g</td>
</tr>
<tr>
<td></td>
<td>TB5660: 310 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical</td>
</tr>
</tbody>
</table>

1) Including processor modules, communication modules and communication interface modules

2) The inrush current and the melting integral depends on the internal power supply of the processor module and the number and type of communication modules and I/O modules connected to the I/O bus.

### Table 116: Combination of TB56xx-2ETH(-XC) and PM56xx(-XC)

<table>
<thead>
<tr>
<th>Processor module</th>
<th>PM5630</th>
<th>PM5650</th>
<th>PM5670</th>
<th>PM5675</th>
</tr>
</thead>
<tbody>
<tr>
<td>TB5600-2ETH</td>
<td>0 slot</td>
<td>0 slot</td>
<td>0 slot</td>
<td>0 slot</td>
</tr>
<tr>
<td>TB5610-2ETH</td>
<td>1 slot</td>
<td>1 slot</td>
<td>1 slot</td>
<td>1 slot</td>
</tr>
<tr>
<td>TB5620-2ETH</td>
<td>2 slots</td>
<td>2 slots</td>
<td>2 slots</td>
<td>2 slots</td>
</tr>
<tr>
<td>TB5640-2ETH</td>
<td>-</td>
<td>4 slots</td>
<td>4 slots</td>
<td>4 slots</td>
</tr>
<tr>
<td>TB5660-2ETH</td>
<td>-</td>
<td>-</td>
<td>6 slots</td>
<td>6 slots</td>
</tr>
</tbody>
</table>

Remarks:

The slots can be used for connecting communication modules or AC500-S modules. Note that only one AC500-S module can be connected at one terminal base.

1) PM567x must have an index \( \geq C0 \).
5.2.3.1.5 Dimensions

The dimensions are in mm and in brackets in inch.

1 Din rail 15 mm
2 Din rail 7.5 mm

5.2.3.1.6 Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 110 300 R0278</td>
<td>TB5600-2ETH, terminal base AC500, slots: 1 processor module, 2 Ethernet RJ45, 1 CAN connector</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 310 300 R0278</td>
<td>TB5600-2ETH-XC, terminal base AC500, slots: 1 processor module, 2 Ethernet RJ45, 1 CAN connector, XC version</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 111 300 R0278</td>
<td>TB5610-2ETH, terminal base AC500, slots: 1 processor module, 1 communication module, 2 Ethernet RJ45, 1 CAN connector</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 311 300 R0278</td>
<td>TB5610-2ETH-XC, terminal base AC500, slots: 1 processor module, 1 communication module, 2 Ethernet RJ45, 1 CAN connector, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>
Part no. | Description | Product life cycle phase *)
---|---|---
1SAP 112 300 R0278 | TB5620-2ETH, terminal base AC500, slots: 1 processor module, 2 communication modules, 2 Ethernet RJ45, 1 CAN connector | Active
1SAP 312 300 R0278 | TB5620-2ETH-XC, terminal base AC500, slots: 1 processor module, 2 communication modules, 2 Ethernet RJ45, 1 CAN connector, XC version | Active
1SAP 114 300 R0278 | TB5640-2ETH, terminal base AC500, slots: 1 processor module, 4 communication modules, 2 Ethernet RJ45, 1 CAN connector | Active
1SAP 314 300 R0278 | TB5640-2ETH-XC, terminal base AC500, slots: 1 processor module, 4 communication modules, 2 Ethernet RJ45, 1 CAN connector, XC version | Active
1SAP 116 300 R0278 | TB5660-2ETH, terminal base AC500, slots: 1 processor module, 6 communication modules, 2 Ethernet RJ45, 1 CAN connector | Active
1SAP 316 300 R0278 | TB5660-2ETH-XC, terminal base AC500, slots: 1 processor module, 6 communication modules, 2 Ethernet RJ45, 1 CAN connector, XC version | Active

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

### Table 117: Combination of TB56xx-2ETH(-XC) and PM56xx(-XC)

<table>
<thead>
<tr>
<th>Processor module</th>
<th>PM5630</th>
<th>PM5650</th>
<th>PM5670</th>
<th>PM5675</th>
</tr>
</thead>
<tbody>
<tr>
<td>TB5600-2ETH</td>
<td>0 slot</td>
<td>0 slot</td>
<td>0 slot</td>
<td>0 slot</td>
</tr>
<tr>
<td>TB5610-2ETH</td>
<td>1 slot</td>
<td>1 slot</td>
<td>1 slot</td>
<td>1 slot</td>
</tr>
<tr>
<td>TB5620-2ETH</td>
<td>2 slots</td>
<td>2 slots</td>
<td>2 slots</td>
<td>2 slots</td>
</tr>
<tr>
<td>TB5640-2ETH</td>
<td>-</td>
<td>4 slots</td>
<td>4 slots</td>
<td>4 slots</td>
</tr>
<tr>
<td>TB5660-2ETH</td>
<td>-</td>
<td>-</td>
<td>6 slots 1)</td>
<td>6 slots 1)</td>
</tr>
</tbody>
</table>

Remarks:
The slots can be used for connecting communication modules or AC500-S modules. Note that only one AC500-S module can be connected at one terminal base.

1) PM567x must have an index ≥ C0.

### Table 118: Accessories

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 180 800 R0001</td>
<td>TA526, wall mounting accessory</td>
</tr>
</tbody>
</table>
5.2.4 I/O modules

5.2.4.1 Safety instructions

**Hot swap**

System requirements for hot swapping of I/O modules:

- Types of terminal units that support hot swapping of I/O modules have the appendix TU5xx-H.
- I/O modules as of index F0.

The following I/O bus masters support hot swapping of attached I/O modules:

- Communication interface modules CI5xx as of index F0.
- Processor modules PM56xx-2ETH with firmware version as of V3.2.0.

**NOTICE!**

Risk of damage to I/O modules!

Hot swapping is only allowed for I/O modules.

Processor modules and communication interface modules must not be removed or inserted during operation.

**Conditions for hot swapping**

- Digital outputs are not under load.
- Input/output voltages above safety extra low voltage/protective extra low voltages (SELV/PELV) are switched off.
- Modules are completely plugged on the terminal unit with both snap fit engaged before switching on loads or input/output voltage.

Further information about hot swap.

5.2.4.2 I/O bus - Data transfer

The I/O bus is the I/O data bus for the I/O modules. Through this bus, I/O and diagnosis data are transferred between the processor module and the I/O modules. Up to 10 I/O modules can be added.

- Chapter 4.2.3 “I/O bus - Communication within the PLC” on page 97
- Chapter 5.2.4.2 “I/O bus - Data transfer” on page 387

The synchronized I/O bus is the I/O data bus for the I/O modules connected with the processor modules or communication interface modules. Through this bus, I/O and diagnosis data are transferred.

With its fast data transmission, the I/O bus obtains very low reaction times.

Up to 10 I/O terminal units (for one I/O module each) can be added to one terminal base or to one AC500-eCo processor module. The I/O terminal units and the AC500-eCo I/O modules, have a bus input at the left side and a bus output at the right side. Thus the length of the I/O bus increases with the number of attached I/O modules.

- Table 119 “Maximum number of I/O devices which can be connected to the I/O bus” on page 389.
1 I/O bus connection

The connection of the I/O bus is performed automatically by telescoping the modules on the DIN rail. The I/O bus provides the following signals:

- Supply voltage of 3.3 V DC for feeding the electronic interface components
- 3 data lines for the synchronized serial data exchange
- Several control signals

NOTICE!

Except when using hot swap terminal units, the I/O bus is not designed for pulling and plugging modules during operation. If a module is pulled or plugged on a terminal unit that is not hot swap capable while the bus is running, the following consequences are possible:

- Reset of the station or of the processor module
- System lockup
- Damage of the module
WARNING!
Removal/Insertion under power

Removal or insertion under power is permissible only if all conditions for hot swapping are fulfilled.

☞ Chapter 4.9.3 “Replace an I/O module with hot swap” on page 153

The devices are not designed for removal or insertion under power when the conditions for hot swap do not apply. Because of unforeseeable consequences, it is not allowed to plug in or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you
– connect or disconnect any signal or terminal block
– remove, mount or replace a module.

Disconnecting any powered devices while they are energized in a hazardous location could result in an electric arc, which could create an ignition source resulting in fire or explosion.

Prior to proceeding, make sure that power is been disconnected and that the area has been thoroughly checked to ensure that flammable materials are not present.

The devices must not be opened when in operation. The same applies to the network interfaces.

Profibus (master and slave) and CM589-PNIO are available since version 2.5.0 of the Automation Builder.

### Table 119: Maximum number of I/O devices which can be connected to the I/O bus

<table>
<thead>
<tr>
<th>Device</th>
<th>Version Automation Builder</th>
<th>Version firmware</th>
<th>Max. number of I/O devices</th>
</tr>
</thead>
<tbody>
<tr>
<td>CANopen bus modules CI581-CN and CI582-CN</td>
<td>As of V2.1.0</td>
<td>All</td>
<td>0</td>
</tr>
<tr>
<td>PROFINET bus modules CI501-PNIO and CI502-PNIO</td>
<td>As of V2.1.0</td>
<td>all</td>
<td>10</td>
</tr>
<tr>
<td>EtherCAT communication interface module CI511-ETHCAT and CI512-ETHCAT</td>
<td>As of V2.1.0</td>
<td>As of V2.0.x</td>
<td>10</td>
</tr>
<tr>
<td>Modbus communication interface module CI521 and CI522</td>
<td>Independent from Automation Builder version</td>
<td>all</td>
<td>10</td>
</tr>
</tbody>
</table>

Profibus (master and slave) and CM589-PNIO are available since version 2.5.0 of the Automation Builder.

### Table 120: General data of the I/O bus

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supply voltage, signal level</td>
<td>3.3 V DC ± 10 %</td>
</tr>
<tr>
<td>Max. supply current</td>
<td>On request</td>
</tr>
<tr>
<td>Type of the data interface</td>
<td>Synchronized serial data exchange</td>
</tr>
</tbody>
</table>
### Table 121: Wiring (bus connection)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bus connection</td>
<td>Left-side and right-side connection from module to module via a 10-pole HE plug (male at the left side, female at the right side)</td>
</tr>
<tr>
<td>Mechanical connection</td>
<td>Established by the terminal units</td>
</tr>
<tr>
<td>Max. bus length</td>
<td>1 m</td>
</tr>
</tbody>
</table>

#### 5.2.4.3 Digital I/O modules

**5.2.4.3.1 S500-eCo**

**DC562 - Digital input/output module**

**Features**

- 16 configurable digital inputs/outputs in 1 group, 24 V DC
- Module-wise galvanically isolated
Intended purpose

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g. CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.

The inputs/outputs are group-wise galvanically isolated from each other.
All other circuitry of the module is galvanically isolated from the inputs/outputs.

The I/O module must not be used as a decentralized I/O module with CI590-CS31-HA communication interface modules.
**Functionality**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED displays</td>
<td>For signal states</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via I/O bus</td>
</tr>
<tr>
<td>External power supply</td>
<td>Via the terminals ZP and UP (process voltage 24 V DC)</td>
</tr>
</tbody>
</table>

**Connections**

*For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.*

The connection is carried out by using a removable 9-pin and 11-pin terminal block. These terminal blocks differ in their connection system (spring terminals or screw terminals, cable mounting from the front or from the side). The terminal blocks are not included in the module's scope of delivery and must be ordered separately.
**Table 122: Assignment of the terminals:**

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>2</td>
<td>C0</td>
<td>Input/output signal C0</td>
</tr>
<tr>
<td>3</td>
<td>C1</td>
<td>Input/output signal C1</td>
</tr>
<tr>
<td>4</td>
<td>C2</td>
<td>Input/output signal C2</td>
</tr>
<tr>
<td>5</td>
<td>C3</td>
<td>Input/output signal C3</td>
</tr>
<tr>
<td>6</td>
<td>C4</td>
<td>Input/output signal C4</td>
</tr>
</tbody>
</table>

*Fig. 43: Internal construction of the digital inputs and outputs*
### Terminal Signal Description

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>C5</td>
<td>Input/output signal C5</td>
</tr>
<tr>
<td>8</td>
<td>C6</td>
<td>Input/output signal C6</td>
</tr>
<tr>
<td>9</td>
<td>C7</td>
<td>Input/output signal C7</td>
</tr>
<tr>
<td>10</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>11</td>
<td>C8</td>
<td>Input/output signal C8</td>
</tr>
<tr>
<td>12</td>
<td>C9</td>
<td>Input/output signal C9</td>
</tr>
<tr>
<td>13</td>
<td>C10</td>
<td>Input/output signal C10</td>
</tr>
<tr>
<td>14</td>
<td>C11</td>
<td>Input/output signal C11</td>
</tr>
<tr>
<td>15</td>
<td>C12</td>
<td>Input/output signal C12</td>
</tr>
<tr>
<td>16</td>
<td>C13</td>
<td>Input/output signal C13</td>
</tr>
<tr>
<td>17</td>
<td>C14</td>
<td>Input/output signal C14</td>
</tr>
<tr>
<td>18</td>
<td>C15</td>
<td>Input/output signal C15</td>
</tr>
<tr>
<td>19</td>
<td>UP</td>
<td>Process voltage UP +24 V DC</td>
</tr>
<tr>
<td>20</td>
<td>ZP</td>
<td>Process voltage ZP 0 V DC</td>
</tr>
</tbody>
</table>

The internal power supply voltage for the module's circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 10 mA per DC562.

The external power supply connection is carried out via the UP (+24 V DC) and ZP (0 V DC) terminals.

---

**WARNING!**

Removal/Insertion under power

The devices are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you

- connect or disconnect any signal or terminal block
- remove, mount or replace a module.

Disconnecting any powered devices while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The devices must not be opened when in operation. The same applies to the network interfaces.

---

**NOTICE!**

Risk of damaging the PLC modules!

Overvoltages and short circuits might damage the PLC modules.

- Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
- Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.
Process supply voltage must be connected to UP/ZP of the module. The inputs and UP/ZP must use the same power supply.

**Fig. 44:** Connection of the digital input/output module DC562

In this connection example, the inputs/outputs C0 ... C7 are connected as inputs and the inputs/outputs C8 ... C15 are connected as outputs.

The module provides several diagnosis functions \( \Rightarrow \) Chapter 5.2.4.3.1.1.7 “Diagnosis” on page 397.

The meaning of the LEDs is described in the section State LEDs \( \Rightarrow \) Chapter 5.2.4.3.1.1.8 “State LEDs” on page 397.
I/O configuration

The module itself does not store configuration data. It receives its parameterization data from the master device of the I/O bus (CPU or communication interface module) during power-up of the system.

Hence, replacing I/O modules is possible without any re-parameterization via software.

If the external power supply voltage via UP/ZP terminals fails, the I/O module loses its configuration data. The whole station has to be switched off and on again to re-configure the module.

Parameterization

The arrangement of the parameter data is performed with Automation Builder software.

The parameter data directly influences the functionality of modules.

For non-standard applications, it is necessary to adapt the parameters to your system configuration.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal Value</th>
<th>Internal Value, Type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Internal</td>
<td>6155 1)</td>
<td>WORD</td>
<td>6155 0x180B</td>
<td>0</td>
<td>65535</td>
<td>xx01</td>
</tr>
<tr>
<td>Ignore module</td>
<td>No</td>
<td>0</td>
<td>BYTE</td>
<td>No (0x00)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameter length 2)</td>
<td>Internal</td>
<td>1 - CPU</td>
<td>BYTE</td>
<td>0</td>
<td>0</td>
<td>255</td>
<td>xx02 3)</td>
</tr>
</tbody>
</table>

1) with CS31 and addresses less than 70, the value is increased by 1
2) the module has no additional user-configurable parameters
3) Value is hexadecimal: HighByte is slot (xx: 0 ... 7), LowByte is index (1 ... n)

GSD file:

```
Ext_User_Prm_Data_Len = 0x06
Ext_User_Prm_Data_Const(0) = 0x18, 0x0C, 0x00, 0x02, 0x00, 0x00;
```
### Diagnosis

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier 000 ... 063</th>
<th>AC500-Display</th>
<th>&lt;- Display in</th>
<th>Class</th>
<th>Comp</th>
<th>Dev</th>
<th>Mod</th>
<th>Ch</th>
<th>Err</th>
<th>PS501 PLC Browser</th>
</tr>
</thead>
<tbody>
<tr>
<td>Byte 6</td>
<td>Byte 3</td>
<td>Byte 4</td>
<td>Byte 5</td>
<td>Byte 6 Bit 0 ... 5</td>
<td>PNIO diagnosis block</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bit 6 ... 7</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Module error DC562

<table>
<thead>
<tr>
<th>3</th>
<th>14</th>
<th>1 ... 10</th>
<th>31</th>
<th>31</th>
<th>19</th>
<th>Checksum error in the I/O module</th>
<th>Replace I/O module</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>43</td>
<td>Internal error in the module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>9</td>
<td>Overflow diagnosis buffer</td>
<td>Restart</td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>26</td>
<td>Parameter error</td>
<td>Check master</td>
</tr>
</tbody>
</table>

### Remarks:

1) In AC500 the following interface identifier applies:
   14 = I/O bus, 11 = COM1 (e.g. CS31-Bus), 12 = COM2.
   The PNIO diagnosis block does not contain this identifier.

2) With "Device" the following allocation applies:
   31 = Module itself, 1...10 = expansion module 1 ... 10, ADR = hardware address (e.g. of the DC551-CS31)

3) With "Module" the following allocation applies depending on the master:
   Module error: I/O bus or PNIO: 31 = module itself; COM1/COM2: 1 ... 10 = expansion 1 ... 10
   Channel error: I/O bus or PNIO = module type (4 = DC); COM1/COM2: 1 ... 10 = expansion 1 ... 10

4) In case of module errors, with channel "31 = Module itself" is output.

### State LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Inputs/outputs</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="LED diagram" /></td>
<td>C0 ... C15</td>
<td>Digital input or digital output</td>
<td>Yellow</td>
<td>Input/output is OFF</td>
<td>Input/output is ON (the LEDs are only operating if the module's circuitry is supplied via the I/O bus)</td>
</tr>
</tbody>
</table>
Technical data

Technical data of the module

The system data of AC500-eCo apply.

Chapter 5.1.1 “System data AC500-eCo” on page 159

Only additional details are therefore documented below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process voltage UP</td>
<td></td>
</tr>
<tr>
<td>Connections</td>
<td>Terminal 19 for UP (+24 V DC) and terminal 20 for ZP (0 V)</td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Current consumption via UP terminal</td>
<td>90 mA + 0.5 A per output (max.)</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5%</td>
</tr>
<tr>
<td>Inrush current</td>
<td>0.000001 A²s</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Current consumption from 24 V DC power supply</td>
<td>Ca. 10 mA</td>
</tr>
<tr>
<td>at the L+/UP and M/ZP terminals of the CPU/</td>
<td></td>
</tr>
<tr>
<td>communication interface module</td>
<td></td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, between the input/output group and the rest of the module</td>
</tr>
<tr>
<td>Isolated groups</td>
<td>1 group for 16 channels</td>
</tr>
<tr>
<td>Surge voltage (max.)</td>
<td>35 V DC for 0.5 s</td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>4.8 W</td>
</tr>
<tr>
<td>Input data length</td>
<td>2 bytes</td>
</tr>
<tr>
<td>Output data length</td>
<td>2 bytes</td>
</tr>
<tr>
<td>Weight</td>
<td>Ca. 125 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>

No effects of multiple overloads

No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an external fuse.

Technical data of the digital inputs/outputs if used as inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>16 configurable inputs (24 V DC)</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 (16 channels per group)</td>
</tr>
<tr>
<td>Connections of the channels C0 to C15</td>
<td>Terminals 1 to 16</td>
</tr>
<tr>
<td>Reference potential for the channels C0 to</td>
<td>Terminal 20 (negative pole of the process voltage, name ZP)</td>
</tr>
<tr>
<td>C15</td>
<td></td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel; the LED is ON when the input signal is high (signal 1). The module is powered through the I/O bus.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>Input type according to EN 61131-2</td>
<td>Type 1 sink</td>
</tr>
<tr>
<td>Input signal range</td>
<td>+24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-3 V ... +5 V</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>+5 V ... +15 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>+15 V ... +30 V</td>
</tr>
<tr>
<td>Ripple with signal 0</td>
<td>-3 V ... +5 V</td>
</tr>
<tr>
<td>Ripple with signal 1</td>
<td>+15 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 5 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>Typ. 1 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>&gt; 2.5 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 8 mA</td>
</tr>
<tr>
<td>Max. permissible leakage current (at 2-wire</td>
<td>1 mA</td>
</tr>
<tr>
<td>proximity switches)</td>
<td></td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 8 ms</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>500 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>300 m</td>
</tr>
</tbody>
</table>

### Technical data of the digital inputs/outputs if used as outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>16 configurable transistor outputs</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 (16 channels per group)</td>
</tr>
<tr>
<td>Connections of the channels C0 to C15</td>
<td>Terminals 1 to 16</td>
</tr>
<tr>
<td>Reference potential for the channels C0 to C15</td>
<td>Terminal 20 (negative pole of the process voltage, signal name ZP)</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>Terminal 19 (positive pole of the process voltage, signal name UP)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel; the LED is ON when the input signal is high (signal 1). The module is powered through the I/O bus.</td>
</tr>
<tr>
<td>Way of operation</td>
<td>Non-latching type</td>
</tr>
<tr>
<td>Output voltage at signal 1</td>
<td>UP -0.3 V at max. current</td>
</tr>
<tr>
<td>Output delay (max. at rated load)</td>
<td></td>
</tr>
<tr>
<td>0 to 1</td>
<td>50 µs</td>
</tr>
<tr>
<td>1 to 0</td>
<td>200 µs</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated current per channel (max.)</td>
<td>0.5 A at UP 24 V DC</td>
</tr>
<tr>
<td>Rated current per group (max.)</td>
<td>8 A</td>
</tr>
<tr>
<td>Rated current (all channels together, max.)</td>
<td>8 A</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Lamp load (max.)</td>
<td>5 W</td>
</tr>
<tr>
<td>Max. leakage current with signal 0</td>
<td>&lt; 0.5 mA</td>
</tr>
<tr>
<td>Output type</td>
<td>Non-protected</td>
</tr>
<tr>
<td>Protection type</td>
<td>External fuse on each channel</td>
</tr>
<tr>
<td>Rated protection fuse (for each channel)</td>
<td>3 A fast</td>
</tr>
<tr>
<td>Demagnetization when inductive loads are switched off</td>
<td>Must be performed externally according to driven load specification</td>
</tr>
<tr>
<td>Switching frequency</td>
<td></td>
</tr>
<tr>
<td>With inductive loads</td>
<td>Max. 0.5 Hz</td>
</tr>
<tr>
<td>With lamp loads</td>
<td>Max. 11 Hz at max. 5 W</td>
</tr>
<tr>
<td>Short-circuit-proof / Overload-proof</td>
<td>No</td>
</tr>
<tr>
<td>Overload message</td>
<td>No</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>No</td>
</tr>
<tr>
<td>Resistance to feedback against 24 V DC signals</td>
<td>Yes</td>
</tr>
<tr>
<td>Connection of 2 outputs in parallel</td>
<td>Not possible</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>500 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>150 m</td>
</tr>
</tbody>
</table>
Dimensions

The dimensions are in mm and in brackets in inch.

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 231 900 R0000</td>
<td>DC562, digital input/output module, 16 configurable inputs/outputs, transistor output</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3101</td>
<td>Terminal block TA563-9, 9 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3102</td>
<td>Terminal block TA563-11, 11 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3103</td>
<td>Terminal block TA564-9, 9 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3104</td>
<td>Terminal block TA564-11, 11 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3105</td>
<td>Terminal block TA565-9, 9 pins, spring front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3106</td>
<td>Terminal block TA565-11, 11 pins, spring front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
</tbody>
</table>
*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

**DI561 - Digital input module**

**Features**

- 8 digital inputs 24 V DC / 24 V AC (I₀ ... I₇) in 1 group
- Module-wise galvanically isolated

---

1. I/O bus
2. 8 yellow LEDs to display the signal states of the inputs I₀ to I₇
3. Terminal number
4. Allocation of signal name
5. Terminal block for input signals (9-pin)
6. 2 holes for wall-mounting with screws
7. DIN rail
Intended purpose

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g., CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.

The inputs are group-wise galvanically isolated from each other.
All other circuitry of the module is galvanically isolated from the inputs.

The I/O module must not be used as a decentralized I/O module with CI590-CS31-HA communication interface modules.

Functionality

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED displays</td>
<td>For signal states</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via I/O bus</td>
</tr>
<tr>
<td>External power supply</td>
<td>Not necessary</td>
</tr>
</tbody>
</table>

Connections

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The connection is carried out by using a removable 9-pin terminal block. These terminal blocks differ in their connection system (spring terminals or screw terminals, cable mounting from the front or from the side). The terminal blocks are not included in the module’s scope of delivery and must be ordered separately.

Fig. 45: Internal construction of the digital inputs
Table 123: Assignment of the terminals:

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>C0 ... 7</td>
<td>Input common for signals I0 to I7</td>
</tr>
<tr>
<td>2</td>
<td>I0</td>
<td>Input signal I0</td>
</tr>
<tr>
<td>3</td>
<td>I1</td>
<td>Input signal I1</td>
</tr>
<tr>
<td>4</td>
<td>I2</td>
<td>Input signal I2</td>
</tr>
<tr>
<td>5</td>
<td>I3</td>
<td>Input signal I3</td>
</tr>
<tr>
<td>6</td>
<td>I4</td>
<td>Input signal I4</td>
</tr>
<tr>
<td>7</td>
<td>I5</td>
<td>Input signal I5</td>
</tr>
<tr>
<td>8</td>
<td>I6</td>
<td>Input signal I6</td>
</tr>
<tr>
<td>9</td>
<td>I7</td>
<td>Input signal I7</td>
</tr>
</tbody>
</table>

The internal power supply voltage for the module's circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 10 mA per DI561.

An external power supply connection is not needed.

**WARNING!**

**Removal/Insertion under power**

The devices are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug devices with the power being ON.

- Make sure that all voltage sources (supply and process voltage) are switched off before you
  - connect or disconnect any signal or terminal block
  - remove, mount or replace a module.

Disconnecting any powered devices while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The devices must not be opened when in operation. The same applies to the network interfaces.

**NOTICE!**

**Risk of damaging the PLC modules!**

- Overvoltages and short circuits might damage the PLC modules.
  - Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
  - Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

The digital inputs can be used as source inputs or as sink inputs.
**NOTICE!**

Risk of malfunctions in the plant!

A ground fault, e.g. caused by a damaged cable insulation, can bridge switches accidentally.

Use sink inputs when possible or make sure that, in case of error, there will be no risks to persons or plant.

---

### Table 124: Connection of the digital input module DI561

<table>
<thead>
<tr>
<th>1</th>
<th>C0..7</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>I0</td>
</tr>
<tr>
<td>3</td>
<td>I1</td>
</tr>
<tr>
<td>4</td>
<td>I2</td>
</tr>
<tr>
<td>5</td>
<td>I3</td>
</tr>
<tr>
<td>6</td>
<td>I4</td>
</tr>
<tr>
<td>7</td>
<td>I5</td>
</tr>
<tr>
<td>8</td>
<td>I6</td>
</tr>
<tr>
<td>9</td>
<td>I7</td>
</tr>
</tbody>
</table>

**Connection of DI561 - sink inputs**

The module provides several diagnosis functions (see Chapter 5.2.4.3.1.2.7 “Diagnosis” on page 406).

The meaning of the LEDs is described in the section State LEDs (see Chapter 5.2.4.3.1.2.8 “State LEDs” on page 407).

---

**I/O Configuration**

The module itself does not store configuration data. It receives its parameterization data from the master device of the I/O bus (CPU or communication interface module) during power-up of the system.

Hence, replacing I/O modules is possible without any re-parameterization via software.

---

**Parameterization**

The arrangement of the parameter data is performed with Automation Builder software.

The parameter data directly influences the functionality of modules.

For non-standard applications, it is necessary to adapt the parameters to your system configuration.
### Module ID

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal Value</th>
<th>Internal Value, Type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Internal</td>
<td>6105 ¹)</td>
<td>WORD</td>
<td>6105</td>
<td>0</td>
<td>65535</td>
<td>xx01</td>
</tr>
<tr>
<td>Ignore module</td>
<td>No</td>
<td>0</td>
<td>BYTE</td>
<td>No (0x00)</td>
<td>0</td>
<td>255</td>
<td>xx02 ³)</td>
</tr>
<tr>
<td>Parameter length ²)</td>
<td>Internal</td>
<td>1 - CPU</td>
<td>BYTE</td>
<td>0</td>
<td>0</td>
<td>255</td>
<td>xx02 ³)</td>
</tr>
</tbody>
</table>

¹) with CS31 and addresses smaller than 70, the value is increased by 1
²) the module has no additional user-configurable parameters
³) Value is hexadecimal: HighByte is slot (xx: 0 ... 7), LowByte is index (1 ... n)

### GSD file:

```plaintext
Ext_User_Prm_Data_Len = 0x03
Ext_User_Prm_Data_Const(0) = 0xDA, 0x17, 0x00;
```

### Diagnosis

#### E1 ... E4

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier 000 ... 063</th>
<th>AC500-Display</th>
<th>← Display in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Comp</td>
<td>Dev</td>
<td>Mod</td>
<td>Ch</td>
<td>Err</td>
<td>PS501 PLC Browser</td>
<td>PNIO diagnosis block</td>
</tr>
<tr>
<td>Byte 6</td>
<td>-</td>
<td>Byte 3</td>
<td>Byte 4</td>
<td>Byte 5</td>
<td>Byte 6 Bit 0 ... 5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bit 6 ... 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Class Interface Device Module Channel Error Identifier Error message Remedy

¹) ²) ³) ⁴)  ³)

### Module error

<table>
<thead>
<tr>
<th>3</th>
<th>14</th>
<th>1 ... 10</th>
<th>31</th>
<th>31</th>
<th>19</th>
<th>Checksum error in the I/O module</th>
<th>Replace I/O module</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>43</td>
<td>Internal error in the module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>9</td>
<td>Overflow diagnosis buffer</td>
<td>Restart</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>26</td>
<td>Parameter error</td>
<td>Check master</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Remarks:
1) In AC500 the following interface identifier applies:
   14 = I/O bus, 11 = COM1 (e.g. CS31 bus), 12 = COM2.
   The PNIO diagnosis block does not contain this identifier.

2) With "Device" the following allocation applies:
   31 = module itself,
   1 ... 10 = decentralized communication interface module 1 ... 10,
   ADR = hardware address (e.g. of the DC551-CS31)

3) With "Module" the following allocation applies depending on the master:
   Module error: I/O bus or PNIO: 31 = module itself; COM1/COM2: 1 ... 10 = expansion 1 ... 10

4) In case of module errors, with channel "31 = module itself" is output.

State LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inputs I0...I7</td>
<td>Digital input</td>
<td>Yellow</td>
<td>Input is OFF</td>
<td>Input is ON</td>
</tr>
</tbody>
</table>

*In the undefined signal range, the state LED for the inputs can be ON although the input state detected by the module is OFF.*

Technical data

Technical data of the module

The system data of AC500-eCo apply.

* Chapter 5.1.1 “System data AC500-eCo” on page 159

Only additional details are therefore documented below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Galvanic isolation</td>
<td>Yes, between the input group and the rest of the module</td>
</tr>
<tr>
<td>Isolated groups</td>
<td>1 (8 channels per group)</td>
</tr>
<tr>
<td>Current consumption from 24 V DC power supply at the L+/UP and M/ZP terminals of the CPU/communication interface module</td>
<td>Ca. 10 mA</td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>1.6 W</td>
</tr>
<tr>
<td>Weight</td>
<td>Ca. 110 g</td>
</tr>
</tbody>
</table>
### Parameter | Value
---|---
Mounting position | Horizontal or vertical
Cooling | The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.

#### Technical data of the digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8 inputs (24 V DC / 24 V AC)</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 (8 channels per group)</td>
</tr>
<tr>
<td>Connections of the channels I0 to I7</td>
<td>Terminals 2 … 9</td>
</tr>
<tr>
<td>Reference potential for the channels I0 to I7</td>
<td>Terminal 1 (plus or negative pole of the process supply voltage, signal name C0 … 7)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel; the LED is ON when the input signal is high (signal 1). The module is powered through the I/O bus.</td>
</tr>
<tr>
<td>Monitoring point of input indicator</td>
<td>LED is part of the input circuitry</td>
</tr>
<tr>
<td>Input type according to EN 61131-2</td>
<td>Type 1 source</td>
</tr>
<tr>
<td>Input signal range</td>
<td>-24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-5 V … +3 V</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>-15 V … -5 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>-30 V … -15 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage 24 V</td>
<td>Typ. 5 mA</td>
</tr>
<tr>
<td>Input voltage 5 V</td>
<td>Typ. 1 mA</td>
</tr>
<tr>
<td>Input voltage 14 V</td>
<td></td>
</tr>
<tr>
<td>Input voltage 15 V</td>
<td>&gt; 2.5 mA</td>
</tr>
<tr>
<td>Input voltage 27 V</td>
<td></td>
</tr>
<tr>
<td>Input voltage 30 V</td>
<td>&lt; 8 mA</td>
</tr>
<tr>
<td>Max. permissible leakage current (at 2-wire proximity switches)</td>
<td>1 mA</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 8 ms</td>
</tr>
<tr>
<td>Input data length</td>
<td>1 byte</td>
</tr>
<tr>
<td>Max. cable length</td>
<td>Shielded</td>
</tr>
<tr>
<td>500 m</td>
<td>300 m</td>
</tr>
</tbody>
</table>

¹) When inputs are used with 24 V AC, external surge limiting filters are required.
Dimensions

The dimensions are in mm and in brackets in inch.

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1TNE 968 902 R2101</td>
<td>DI561, digital input module, 8 DI, 24 V DC / 24 V AC</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3101</td>
<td>Terminal block TA563-9, 9 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3103</td>
<td>Terminal block TA564-9, 9 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3105</td>
<td>Terminal block TA565-9, 9 pins, spring front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

DI562 - Digital input module

Features

- 16 digital inputs 24 V DC / 24 V AC (I0 ... I15) in 2 groups
- Group-wise galvanically isolated
1 I/O bus
2 16 yellow LEDs to display the signal states of the inputs I0 ... I15
3 Terminal number
4 Allocation of signal name
5 Terminal block for input signals (9-pin)
6 Terminal block for input signals (11-pin)
7 2 holes for wall-mounting with screws
8 DIN rail

**Intended purpose**

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g. CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.

The inputs are group-wise galvanically isolated from each other.
The other electronic circuitry of the module is galvanically isolated from the inputs.

*The I/O module must not be used as a decentralized I/O module with CI590-CS31-HA communication interface modules.*
### Functionality

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED displays</td>
<td>For signal states</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via I/O bus</td>
</tr>
<tr>
<td>External power supply</td>
<td>Not necessary</td>
</tr>
</tbody>
</table>

### Connections

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The connection is carried out by using removable 9-pin and 11-pin terminal blocks. These terminal blocks differ in their connection system (spring terminals or screw-type terminals, cable mounting from the front or from the side). The terminal blocks are not included in the module's scope of delivery and must be ordered separately.

![Diagram of internal construction of digital inputs](image)

Fig. 46: Internal construction of the digital inputs
### Table 125: Assignments of the terminal

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>C0 ... C7</td>
<td>Input common for signals I0 to I7</td>
</tr>
<tr>
<td>2</td>
<td>I0</td>
<td>Input signal I0</td>
</tr>
<tr>
<td>3</td>
<td>I1</td>
<td>Input signal I1</td>
</tr>
<tr>
<td>4</td>
<td>I2</td>
<td>Input signal I2</td>
</tr>
<tr>
<td>5</td>
<td>I3</td>
<td>Input signal I3</td>
</tr>
<tr>
<td>6</td>
<td>I4</td>
<td>Input signal I4</td>
</tr>
<tr>
<td>7</td>
<td>I5</td>
<td>Input signal I5</td>
</tr>
<tr>
<td>8</td>
<td>I6</td>
<td>Input signal I6</td>
</tr>
<tr>
<td>9</td>
<td>I7</td>
<td>Input signal I7</td>
</tr>
<tr>
<td>10</td>
<td>C8 ... C15</td>
<td>Input common for signals I8 ... I15</td>
</tr>
<tr>
<td>11</td>
<td>I8</td>
<td>Input signal I8</td>
</tr>
<tr>
<td>12</td>
<td>I9</td>
<td>Input signal I9</td>
</tr>
<tr>
<td>13</td>
<td>I10</td>
<td>Input signal I10</td>
</tr>
<tr>
<td>14</td>
<td>I11</td>
<td>Input signal I11</td>
</tr>
<tr>
<td>15</td>
<td>I12</td>
<td>Input signal I12</td>
</tr>
<tr>
<td>16</td>
<td>I13</td>
<td>Input signal I13</td>
</tr>
<tr>
<td>17</td>
<td>I14</td>
<td>Input signal I14</td>
</tr>
<tr>
<td>18</td>
<td>I15</td>
<td>Input signal I15</td>
</tr>
<tr>
<td>19</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>20</td>
<td>---</td>
<td>Reserved</td>
</tr>
</tbody>
</table>

The internal power supply voltage for the module’s circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 10 mA per DI562.

An external power supply connection is not needed.

---

### WARNING!

**Removal/Insertion under power**

The devices are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you

- connect or disconnect any signal or terminal block
- remove, mount or replace a module.

Disconnecting any powered devices while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The devices must not be opened when in operation. The same applies to the network interfaces.
NOTICE!
Risk of damaging the PLC modules!
Overvoltages and short circuits might damage the PLC modules.
- Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
- Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

The module provides several diagnosis functions \(\text{§}\) Chapter 5.2.4.3.1.3.7 "Diagnosis" on page 415.

The digital inputs can be used as source inputs or as sink inputs.

NOTICE!
Risk of malfunctions in the plant!
A ground fault, e.g. caused by a damaged cable insulation, can bridge switches accidentally.

Use sink inputs when possible or make sure that, in case of error, there will be no risks to persons or plant.

---

Table 126: Connection of the digital input module DI562

Connection of DI562 - sink inputs

Connection of DI562 - source inputs
The meaning of the LEDs is described in section State LEDs ‡ Chapter 5.2.4.3.1.3.8 “State LEDs” on page 415.

I/O configuration

The module itself does not store configuration data. It receives its parameterization data from the master device of the I/O bus (CPU or communication interface module) during power-up of the system.

Hence, replacing I/O modules is possible without any re-parameterization via software.

If the external power supply voltage via UP/ZP terminals fails, the I/O module loses its configuration data. The whole station has to be switched off and on again to re-configure the module.

Parameterization

The arrangement of the parameter data is performed with Automation Builder software.

The parameter data directly influences the functionality of modules.

For non-standard applications, it is necessary to adapt the parameters to your system configuration.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal Value</th>
<th>Internal Value, Type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID Internal</td>
<td>6110</td>
<td>1) WORD</td>
<td></td>
<td>6110</td>
<td>0</td>
<td>65535</td>
<td>xx01</td>
</tr>
<tr>
<td>Ignore module</td>
<td>No</td>
<td>0 1</td>
<td>BYTE</td>
<td>No (0x00)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameter length 2)</td>
<td>Internal 1 - CPU</td>
<td>BYTE</td>
<td>0</td>
<td>0</td>
<td>255</td>
<td>xx02 3)</td>
<td></td>
</tr>
</tbody>
</table>

Remarks:

1) With CS31 and addresses less than 70, the value is increased by 1
2) The module has no additional user-configurable parameters
3) Value is hexadecimal: HighByte is slot (xx: 0 ... 7), LowByte is index (1 ... n)

GSD file:

Ext_User_Prm_Data.Len = 0x03
Ext_User_Prm_Data.Const(0) = 0xDF, 0x17, 0x00;
Diagnosis

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>1)</td>
<td>2)</td>
<td>3)</td>
<td>4)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Module error DI562

| 3 | 14 | 1 ... 10 | 31 | 31 | 19 | Checksum error in the I/O module | Replace I/O module |
| 3 | 14 | 1 ... 10 | 31 | 31 | 43 | Internal error in the module | Replace I/O module |
| 3 | 14 | 1 ... 10 | 31 | 31 | 9  | Overflow diagnosis buffer | Restart |
| 3 | 14 | 1 ... 10 | 31 | 31 | 26 | Parameter error | Check master |

Remarks:

1) In AC500 the following interface identifier applies: 14 = I/O bus, 11 = COM1 (e.g. CS31 bus), 12 = COM2. The PNIO diagnosis block does not contain this identifier.

2) With "Device" the following allocation applies: 31 = module itself, 1 ... 10 = decentralized communication interface module 1 ... 10, ADR = hardware address (e.g. of the DC551-CS31)

3) With "Module" the following allocation applies depending on the master: Module error: I/O bus or PNIO: 31 = module itself; COM1/COM2: 1 ... 10 = expansion 1 ... 10

4) In case of module errors, with channel "31 = module itself" is output.

State LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Inputs I0 ... I15</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Digital input</td>
<td>Yellow</td>
<td>Input is OFF</td>
<td>Input is ON</td>
<td></td>
</tr>
</tbody>
</table>

2024/01/05
3ADR010583, 1, en_US
In the undefined signal range, the state LED for the inputs can be ON although the input state detected by the module is OFF.

Technical data

Technical data of the module

The system data of AC500-eCo apply.

* Chapter 5.1.1 “System data AC500-eCo” on page 159

Only additional details are therefore documented below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Galvanic isolation</td>
<td>Yes, between the input groups and the rest of the module</td>
</tr>
<tr>
<td>Isolated groups</td>
<td>2 (8 channels per group)</td>
</tr>
<tr>
<td>Current consumption from 24 V DC power supply at the L+/UP and M/ZP terminals of the CPU/communication interface module</td>
<td>Ca. 10 mA</td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>3.2 W</td>
</tr>
<tr>
<td>Weight</td>
<td>Ca. 115 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>

Technical data of the digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>16 inputs (24 V DC / 24 V AC)</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>2 (8 channels per group)</td>
</tr>
<tr>
<td>Connections of the channels I0 to I7</td>
<td>Terminals 2 ... 9</td>
</tr>
<tr>
<td>Connections of the channels I8 to I15</td>
<td>Terminals 11 ... 18</td>
</tr>
<tr>
<td>Reference potential for the channels I0 to I7</td>
<td>Terminal 1 (positive or negative pole of the process supply voltage, signal name I0 ... I7)</td>
</tr>
<tr>
<td>Reference potential for the channels I8 to I15</td>
<td>Terminal 10 (positive or negative pole of the process supply voltage, signal name I8 ... I15)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel; the LED is ON when the input signal is high (signal 1). The module is powered through the I/O bus.</td>
</tr>
<tr>
<td>Monitoring point of input indicator</td>
<td>LED is part of the input circuitry</td>
</tr>
<tr>
<td>Input type according to EN 61131-2</td>
<td>Type 1 source Type 1 sink Type 1 AC ¹)</td>
</tr>
<tr>
<td>Input signal range</td>
<td>-24 V DC +24 V DC 24 V AC 50/60 Hz</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-5 V ... +3 V -3 V ... +5 V 0 V AC ... 5 V AC ³)</td>
</tr>
</tbody>
</table>
### Parameter Values

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undefined signal</td>
<td>-15 V ... -5 V</td>
</tr>
<tr>
<td></td>
<td>+5 V ... +15 V</td>
</tr>
<tr>
<td></td>
<td>5 V AC ... 14 V AC</td>
</tr>
<tr>
<td>Signal 1</td>
<td>-30 V ... -15 V</td>
</tr>
<tr>
<td></td>
<td>+15 V ... +30 V</td>
</tr>
<tr>
<td></td>
<td>14 V AC ... 27 V AC</td>
</tr>
</tbody>
</table>

#### Input current per channel

| Input voltage 24 V            | Typ. 5 mA                      |
|                              | Typ. 5 mA r.m.s.               |
| Input voltage 5 V            | Typ. 1 mA                      |
|                              | Typ. 1 mA r.m.s.               |
| Input voltage 14 V           |                                |
|                              | Typ. 2.7 mA r.m.s.             |
| Input voltage 15 V           | > 2.5 mA                       |
| Input voltage 27 V           | Typ. 5.5 mA r.m.s.             |
| Input voltage 30 V           | < 8 mA                         |

#### Max. permissible leakage current (at 2-wire proximity switches)

| 1 mA                       |
| Typ. 1 mA r.m.s.           |

#### Input delay (0->1 or 1->0)

| Typ. 8 ms                  |

#### Input data length

| 2 bytes                    |

#### Max. cable length

| Shielded 500 m             |
| Unshielded 300 m           |

1) When inputs are used with 24 V AC, external surge limiting filters are required.

### Dimensions

*The dimensions are in mm and in brackets in inch.*
Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1TNE 968 902 R2102</td>
<td>DI562, digital input module, 16 DI, 24 V DC / 24 V AC</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3101</td>
<td>Terminal block TA563-9, 9 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3102</td>
<td>Terminal block TA563-11, 11 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3103</td>
<td>Terminal block TA564-9, 9 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3104</td>
<td>Terminal block TA564-11, 11 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3105</td>
<td>Terminal block TA565-9, 9 pins, spring front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3106</td>
<td>Terminal block TA565-11, 11 pins, spring front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

DI571 - Digital input module

Features

- 8 digital inputs 100 ... 240 V AC (I0 ... I7) in 8 groups
- Module-wise galvanically isolated
1 I/O bus
2 8 yellow LEDs to display the signal states of the inputs I0 ... I7
3 Terminal number
4 Allocation of signal name
5 Terminal block for input signals (9-pin)
6 Terminal block for input signals (11-pin)
7 2 holes for wall-mounting with screws
8 DIN rail

**Intended purpose**

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g. CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.

The inputs are group-wise galvanically isolated from each other.
All other circuitry of the module is galvanically isolated from the inputs.

*The I/O module must not be used as a decentralized I/O module with CI590-CS31-HA communication interface modules.*
### Functionality

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED displays</td>
<td>For signal states</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via I/O bus</td>
</tr>
<tr>
<td>External power supply</td>
<td>Not necessary</td>
</tr>
</tbody>
</table>

### Connections

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The connection is carried out by using removable 9-pin and 11-pin terminal blocks. These terminal blocks differ in their connection system (spring terminals or screw terminals, cable mounting from the front or from the side). The terminal blocks are not included in the module's scope of delivery and must be ordered separately.
Fig. 47: Internal construction of the digital inputs

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>I0</td>
<td>Input signal I0</td>
</tr>
<tr>
<td>2</td>
<td>N0</td>
<td>Neutral conductor for the input signal I0</td>
</tr>
<tr>
<td>3</td>
<td>I1</td>
<td>Input signal I1</td>
</tr>
<tr>
<td>4</td>
<td>N1</td>
<td>Neutral conductor for the input signal I1</td>
</tr>
<tr>
<td>5</td>
<td>I2</td>
<td>Input signal I2</td>
</tr>
<tr>
<td>6</td>
<td>N2</td>
<td>Neutral conductor for the input signal I2</td>
</tr>
<tr>
<td>7</td>
<td>I3</td>
<td>Input signal I3</td>
</tr>
<tr>
<td>8</td>
<td>N3</td>
<td>Neutral conductor for the input signal I3</td>
</tr>
<tr>
<td>9</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>10</td>
<td>I4</td>
<td>Input signal I4</td>
</tr>
<tr>
<td>11</td>
<td>N4</td>
<td>Neutral conductor for the input signal I4</td>
</tr>
<tr>
<td>12</td>
<td>I5</td>
<td>Input signal I5</td>
</tr>
<tr>
<td>13</td>
<td>N5</td>
<td>Neutral conductor for the input signal I5</td>
</tr>
<tr>
<td>Terminal</td>
<td>Signal</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>--------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>14</td>
<td>I6</td>
<td>Input signal I6</td>
</tr>
<tr>
<td>15</td>
<td>N6</td>
<td>Neutral conductor for the input signal I6</td>
</tr>
<tr>
<td>16</td>
<td>I7</td>
<td>Input signal I7</td>
</tr>
<tr>
<td>17</td>
<td>N7</td>
<td>Neutral conductor for the input signal I7</td>
</tr>
<tr>
<td>18</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>19</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>20</td>
<td>---</td>
<td>Reserved</td>
</tr>
</tbody>
</table>

The internal power supply voltage for the module's circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 10 mA per DI571.

An external power supply connection is not needed.

**WARNING!**

**Risk of death by electric shock!**

Hazardous voltages can be present at the terminals of the module.

Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.

**WARNING!**

**Removal/Insertion under power**

The devices are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you

– connect or disconnect any signal or terminal block
– remove, mount or replace a module.

Disconnecting any powered devices while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The devices must not be opened when in operation. The same applies to the network interfaces.

**NOTICE!**

**Risk of damaging the PLC modules!**

Overvoltages and short circuits might damage the PLC modules.

– Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
– Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.
**Fig. 48: Connection of the digital input module DI571**

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>I0</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>N0</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>L</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>N1</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>I2</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>N2</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>I3</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>N3</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>L</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>N4</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>I5</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>N5</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>I6</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>N6</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>I7</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>N7</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>---</td>
<td></td>
</tr>
</tbody>
</table>

**NOTICE!**

Risk of damaging the PLC modules!
The PLC modules will be irreparably damaged if a voltage > 240 V is connected.

Make sure that all inputs are fed from the same phase. The module must not be connected to a 400 V voltage.

The module provides several diagnosis functions  ⇨ Chapter 5.2.4.3.1.4.8 "Diagnosis" on page 425.

The meaning of the LEDs is described in the section State LEDs  ⇨ Chapter 5.2.4.3.1.4.9 “State LEDs” on page 425.
Internal data exchange

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital inputs (bytes)</td>
<td>1</td>
</tr>
<tr>
<td>Digital outputs (bytes)</td>
<td>0</td>
</tr>
</tbody>
</table>

I/O configuration

The module itself does not store configuration data. It receives its parameterization data from the master device of the I/O bus (CPU or communication interface module) during power-up of the system.

Hence, replacing I/O modules is possible without any re-parameterization via software.

If the external power supply voltage via UP/ZP terminals fails, the I/O module loses its configuration data. The whole station has to be switched off and on again to re-configure the module.

Parameterization

The arrangement of the parameter data is performed with Automation Builder software.

The parameter data directly influences the functionality of the modules.

For non-standard applications, it is necessary to adapt the parameters to your system configuration.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal Value</th>
<th>Internal Value, Type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Internal</td>
<td>6115 ¹)</td>
<td>WORD</td>
<td>6115</td>
<td>0</td>
<td>65535</td>
<td>xx01</td>
</tr>
<tr>
<td>Ignore module</td>
<td>No</td>
<td>0</td>
<td>BYTE</td>
<td>No (0x00)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameter length ²)</td>
<td>Internal</td>
<td>1 - CPU</td>
<td>BYTE</td>
<td>0</td>
<td>0</td>
<td>255</td>
<td>xx02 ³)</td>
</tr>
</tbody>
</table>

¹) with CS31 and addresses less than 70, the value is increased by 1
²) the module has no additional user-configurable parameters
³) Value is hexadecimal: HighByte is slot (xx: 0 ... 7), LowByte is index (1 ... n)

GSD file:

```
Ext_User_Prm_Data_Len = 0x03
Ext_User_Prm_Data_Const(0) = 0xDF, 0x17, 0x00;
```
## Diagnosis

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier 000 ... 063</th>
<th>AC500-Display</th>
<th>&lt;= Display in Class Comp Dev Mod Ch Err PS501 PLC Browser</th>
</tr>
</thead>
</table>

### Byte 6 Bit 6 ... 7

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1)</td>
<td>2)</td>
<td>3)</td>
<td>4)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Module error

<table>
<thead>
<tr>
<th>3</th>
<th>14</th>
<th>1 ... 10</th>
<th>31</th>
<th>31</th>
<th>19</th>
<th>Cheksum error in the I/O module</th>
<th>Replace I/O module</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>43</td>
<td>Internal error in the module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>9</td>
<td>Overflow diagnosis buffer</td>
<td>Restart</td>
</tr>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>26</td>
<td>Parameter error</td>
<td>Check master</td>
</tr>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Remarks:**

1) In AC500 the following interface identifier applies: 14 = I/O bus, 11 = COM1 (e.g. CS31 bus), 12 = COM2. The PNIO diagnosis block does not contain this identifier.

2) With "Device" the following allocation applies: 31 = module itself, 1 ... 10 = decentralized communication interface module 1 ... 10, ADR = hardware address (e. g. of the DC551-CS31)

3) With "Module" the following allocation applies depending on the master: Module error: I/O bus or PNIO: 31 = module itself; COM1/COM2: 1 ... 10 = expansion 1 ... 10

4) In case of module errors, with channel "31 = Module itself" is output.

### State LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Inputs I0 ... I7</td>
<td>Digital input</td>
<td>Yellow</td>
<td>Input is OFF</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(the input voltage is only displayed if the supply voltage of the module is ON)</td>
</tr>
</tbody>
</table>
Technical data of the module

The system data of AC500-eCo apply.

Section 5.1.1 “System data AC500-eCo” on page 159

Only additional details are therefore documented below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Galvanic isolation</td>
<td>Yes, between the channels and the rest of the module</td>
</tr>
<tr>
<td>Isolated groups</td>
<td>8 (1 channel per group)</td>
</tr>
<tr>
<td>Current consumption from 24 V DC power supply at the L+/UP and M/ZP terminals of the CPU/communication interface module</td>
<td>Ca. 10 mA</td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>On request</td>
</tr>
<tr>
<td>Weight</td>
<td>Ca. 135 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>

Technical data of the digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8 AC inputs (100-240 V AC)</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>8 (1 channel per group)</td>
</tr>
<tr>
<td>Input voltage range</td>
<td>0 V AC ... 264 V AC (47 Hz ... 63 Hz)</td>
</tr>
<tr>
<td>Input current per channel (typically at +25 °C)</td>
<td>&lt;5 mA (at 40 V AC)</td>
</tr>
<tr>
<td></td>
<td>&gt;6 mA (at 159 V AC, 50 Hz)</td>
</tr>
<tr>
<td></td>
<td>&gt;7 mA (at 159 V AC, 60 Hz)</td>
</tr>
<tr>
<td>Connections of the channels I0 to I7</td>
<td>Terminals 1, 3, 5, 7, 10, 12, 14, 16</td>
</tr>
<tr>
<td>Reference potential for the channels I0 to I7</td>
<td>Terminals 2, 4, 6, 8, 11, 13, 15, 17</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel; the LED is ON when the input signal is high (signal 1)</td>
</tr>
<tr>
<td>Input type according to EN 61131-2</td>
<td>Type 1</td>
</tr>
<tr>
<td>Input signal range</td>
<td></td>
</tr>
<tr>
<td>Signal 0 (max.)</td>
<td>20 V AC</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>20 V AC &lt; U &lt; 79 V AC</td>
</tr>
<tr>
<td>Signal 1 (min.)</td>
<td>79 V AC</td>
</tr>
<tr>
<td>Input delay</td>
<td></td>
</tr>
<tr>
<td>Signal 0 -&gt; 1</td>
<td>Typ. 15 ms</td>
</tr>
<tr>
<td>Signal 1 -&gt; 0</td>
<td>Typ. 30 ms</td>
</tr>
<tr>
<td>Input data length</td>
<td>1 byte</td>
</tr>
<tr>
<td>Max. permissible leakage current (at 2-wire proximity switches)</td>
<td>1 mA</td>
</tr>
</tbody>
</table>
### Hardware descriptions

#### Device specifications > I/O modules

##### Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>500 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>300 m</td>
</tr>
</tbody>
</table>

#### Dimensions

The dimensions are in mm and in brackets in inch.

#### Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1TNE 968 902 R2103</td>
<td>DI571, digital input module, 8 DI, 100 V AC ... 240 V AC</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3101</td>
<td>Terminal block TA563-9, 9 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3102</td>
<td>Terminal block TA563-11, 11 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3103</td>
<td>Terminal block TA564-9, 9 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3104</td>
<td>Terminal block TA564-11, 11 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>Part no.</td>
<td>Description</td>
<td>Product life cycle phase *)</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>1TNE 968 901 R3105</td>
<td>Terminal block TA565-9, 9 pins, spring front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3106</td>
<td>Terminal block TA565-11, 11 pins, spring front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

**DI572 - Digital input module**

**Features**

- 16 digital inputs 100 ... 240 V AC (I0 ... I15) in 2 groups
- Module-wise galvanically isolated

![DI572 - Digital input module diagram](image)

1 I/O bus
2 16 yellow LEDs to display the signal states of the inputs I0 ... I15
3 Terminal number
4 Allocation of signal name
5 Terminal block for input signals (9-pin)
6 Terminal block for input signals (11-pin)
7 2 holes for wall-mounting with screws
8 DIN rail

Intended purpose
The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g., CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.

The inputs are group-wise galvanically isolated from each other.
All other circuitry of the module is galvanically isolated from the inputs.

The I/O module must not be used as a decentralized I/O module with CI590-CS31-HA communication interface modules.

Functionality

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED displays</td>
<td>For signal states</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via I/O bus</td>
</tr>
<tr>
<td>External power supply</td>
<td>Not necessary</td>
</tr>
</tbody>
</table>

Connections

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The connection is carried out by using removable 9-pin and 11-pin terminal blocks. These terminal blocks differ in their connection system (spring terminals or screw terminals, cable mounting from the front or from the side). The terminal blocks are not included in the module's scope of delivery and must be ordered separately.
Fig. 49: Block diagram for the internal construction of the digital inputs.

Table 128: Assignment of the terminals

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>I0</td>
<td>Input signal I0</td>
</tr>
<tr>
<td>2</td>
<td>I1</td>
<td>Input signal I1</td>
</tr>
<tr>
<td>3</td>
<td>I2</td>
<td>Input signal I2</td>
</tr>
<tr>
<td>4</td>
<td>I3</td>
<td>Input signal I3</td>
</tr>
<tr>
<td>5</td>
<td>I4</td>
<td>Input signal I4</td>
</tr>
<tr>
<td>6</td>
<td>I5</td>
<td>Input signal I5</td>
</tr>
<tr>
<td>7</td>
<td>I6</td>
<td>Input signal I6</td>
</tr>
<tr>
<td>8</td>
<td>I7</td>
<td>Input signal I7</td>
</tr>
<tr>
<td>9</td>
<td>N0 ... 7</td>
<td>Neutral conductor for the input signals I0 ... I7</td>
</tr>
<tr>
<td>10</td>
<td>I8</td>
<td>Input signal I8</td>
</tr>
<tr>
<td>11</td>
<td>I9</td>
<td>Input signal I9</td>
</tr>
<tr>
<td>12</td>
<td>I10</td>
<td>Input signal I10</td>
</tr>
<tr>
<td>13</td>
<td>I11</td>
<td>Input signal I11</td>
</tr>
<tr>
<td>14</td>
<td>I12</td>
<td>Input signal I12</td>
</tr>
<tr>
<td>15</td>
<td>I13</td>
<td>Input signal I13</td>
</tr>
</tbody>
</table>
Terminal | Signal | Description
--- | --- | ---
16 | I14 | Input signal I14
17 | I15 | Input signal I15
18 | N8 ... 15 | Neutral conductor for the input signals I8 ... I15
19 | --- | Reserved
20 | --- | Reserved

The internal power supply voltage for the module's circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 10 mA per DI572.

An external power supply connection is not needed.

**WARNING!**
Risk of death by electric shock!
Hazardous voltages can be present at the terminals of the module. Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.

**WARNING!**
Removal/Insertion under power
The devices are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you

– connect or disconnect any signal or terminal block
– remove, mount or replace a module.

Disconnecting any powered devices while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The devices must not be opened when in operation. The same applies to the network interfaces.

**NOTICE!**
Risk of damaging the PLC modules!
Overvoltages and short circuits might damage the PLC modules.

– Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
– Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.
NOTICE!

Risk of damaging the PLC modules!

The PLC modules will be irreparably damaged if a voltage > 240 V is connected.

Make sure that all inputs are fed from the same phase. The module must not be connected to a 400 V voltage.

The module provides several diagnosis functions \( \text{\textcopyright} \) Chapter 5.2.4.3.1.5.7 “Diagnosis” on page 434.

I/O configuration

The module itself does not store configuration data. It receives its parameterization data from the master device of the I/O bus (CPU or communication interface module) during power-up of the system.
Hence, replacing I/O modules is possible without any re-parameterization via software.

If the external power supply voltage via UP/ZP terminals fails, the I/O module loses its configuration data. The whole station has to be switched off and on again to re-configure the module.

Parameterization

The arrangement of the parameter data is performed with Automation Builder software. The parameter data directly influences the functionality of modules.

For non-standard applications, it is necessary to adapt the parameters to your system configuration.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Value Internal value</th>
<th>Data type of internal value</th>
<th>Default value</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Internal 6160 1)</td>
<td>WORD</td>
<td>6160 0x1810</td>
<td>0</td>
<td>65535</td>
<td>xx01 2)</td>
</tr>
<tr>
<td>Ignore module</td>
<td>No 0</td>
<td>BYTE</td>
<td>No 0x00</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes 1</td>
<td></td>
<td></td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal 3</td>
<td>BYTE</td>
<td>3</td>
<td>0</td>
<td>255</td>
<td>xx02 2)</td>
</tr>
<tr>
<td>Input delay</td>
<td>20 ms 0</td>
<td>BYTE</td>
<td>20 ms 0x00</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>100 ms 1</td>
<td></td>
<td></td>
<td>-</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1) With CS31 and addresses less than 70, the value is increased by 1.

2) Value is hexadecimal: HighByte is slot (xx: 0 ... 7), LowByte is index (1 ... n).

GSD file:

```
Ext_Module_Prm_Data.Len = 7
Ext_User_Prm_Data.Const(0) = 0x18, 0x11, 0x00, 0x03, 0x00, 0x00, 0x00;
```
## Diagnosis

<table>
<thead>
<tr>
<th>000 ... 063</th>
<th>E1 ... E4</th>
<th>Identifier</th>
<th>data 1</th>
<th>data 2</th>
<th>data 3</th>
<th>data 4</th>
<th>AC500-Display</th>
<th>&lt;- Display in</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>PS501 PLC Browser</td>
<td></td>
</tr>
</tbody>
</table>

### Byte 6

<table>
<thead>
<tr>
<th>Bit 6 ... 7</th>
<th>Byte 3</th>
<th>Byte 4</th>
<th>Byte 5</th>
<th>Byte 6 Bit 0 ... 5</th>
<th>PNIO diagnosis block</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Class Interface Device Module Channel Error Identifier

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>1)</td>
<td>2)</td>
<td>3)</td>
<td>4)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Remarks:

1) In AC500 the following interface identifier applies:
   - 14 = I/O bus, 11 = COM1 (e.g. CS31-Bus), 12 = COM2.
   - The PNIO diagnosis block does not contain this identifier.

2) With "Device" the following allocation applies:
   - 31 = module itself, 1 ... 10 = decentralized communication interface module 1 ... 10, ADR = hardware address (e.g. of the DC551-CS31)

3) With "Module" the following allocation applies depending on the master:
   - module error: I/O bus or PNIO: 31 = module itself, COM1/COM2: 1 ... 10 = expansion 1 ... 10

4) In case of module errors, with channel "31 = module itself" is output.

### State LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Inputs I0 ... I15</td>
<td>Digital input</td>
<td>Yellow</td>
<td>Input is OFF (the input voltage is only displayed if the supply voltage of the module is ON)</td>
</tr>
</tbody>
</table>
Technical data

Technical data of the module

The system data of AC500-eCo apply.

* Chapter 5.1.1 “System data AC500-eCo” on page 159

Only additional details are therefore documented below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Galvanic isolation</td>
<td>Yes, between the input groups and the rest of the module</td>
</tr>
<tr>
<td>Isolated groups</td>
<td>2 (8 channels per group)</td>
</tr>
<tr>
<td>Current consumption from 24 V DC power supply at the L+/UP and M/ZP terminals of the CPU/communication interface module</td>
<td>Ca. 10 mA</td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>6 W</td>
</tr>
<tr>
<td>Weight</td>
<td>Ca. 222 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>

Technical data of the digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>16 AC inputs (100-240 V AC)</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>2 (8 channels per group)</td>
</tr>
<tr>
<td>Input voltage range</td>
<td>0 V AC ... 264 V AC (47 Hz ... 63 Hz)</td>
</tr>
</tbody>
</table>
| Input current per channel (typically at +25 °C)| < 3 mA (at 40 V AC)  
> 6 mA (at 164 V AC)  
> 8 mA (at 240 V AC)                                                                                                                                 |
| Connections of the channels I0...I7            | Terminals 1... 8                                                                                                                                 |
| Connections of the channels I8...I15           | Terminals 10 ... 17                                                                                                                                 |
| Reference potential for the channels I0...I7   | Terminal 9                                                                                                                                 |
| Reference potential for the channels I8...I15  | Terminal 18                                                                                                                                 |
| Indication of the input signals                | 1 yellow LED per channel. The LED is on when the input signal is high (signal 1).                                                             |
| Input type according to EN 61131-2             | Type 1                                                                                                                                 |
| Input signal range                             |                                                                                                                                 |
| Signal 0 (max.)                                | 40 V AC                                                                                                                                 |
| Undefined signal                               | 40 V AC < U < 79 V AC                                                                                                                                 |
| Signal 1 (min.)                                | 79 V AC                                                                                                                                 |
| Input delay                                    |                                                                                                                                 |
| Signal 0 -> 1                                  | Typ. 24 ms                                                                                                                                 |
| Signal 1 -> 0                                  | Typ. 24 ms
### Parameter Table

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input data length</td>
<td>2 bytes</td>
</tr>
<tr>
<td>Max. permissible leakage current (at 2-wire proximity switches)</td>
<td>1 mA</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

### Dimensions

The dimensions are in mm and in brackets in inch.

### Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 230 500 R0000</td>
<td>DI572, digital input module, 16 DI, 100 V AC ... 240 V AC</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3101</td>
<td>Terminal block TA563-9, 9 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3102</td>
<td>Terminal block TA563-11, 11 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3103</td>
<td>Terminal block TA564-9, 9 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>Part no.</td>
<td>Description</td>
<td>Product life cycle phase *)</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>1TNE 968 901 R3104</td>
<td>Terminal block TA564-11, 11 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3105</td>
<td>Terminal block TA565-9, 9 pins, spring front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3106</td>
<td>Terminal block TA565-11, 11 pins, spring front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

DO561 - Digital output module

Features

- 8 digital outputs 24 V DC (O0 ... O7) in 1 group
- Module-wise galvanically isolated
Intended purpose

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g., CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.

The outputs are group-wise galvanically isolated from each other.

All other circuitry of the module is galvanically isolated from the outputs.

The I/O module must not be used as a decentralized I/O module with CI590-CS31-HA communication interface modules.
### Functionality

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED displays</td>
<td>For signal states</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via I/O bus</td>
</tr>
<tr>
<td>External power supply</td>
<td>Via the terminals ZP and UP (process supply voltage 24 V DC)</td>
</tr>
</tbody>
</table>

### Connections

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The connection is carried out by using removable 9-pin and 11-pin terminal blocks. These terminal blocks differ in their connection system (spring terminals or screw terminals, cable mounting from the front or from the side). The terminal blocks are not included in the module's scope of delivery and must be ordered separately.

![Diagram of terminal blocks]

**Fig. 50: Internal construction of the digital outputs**

<table>
<thead>
<tr>
<th>Terminals</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>11</td>
<td>O0</td>
<td>Output signal O0</td>
</tr>
<tr>
<td>12</td>
<td>O1</td>
<td>Output signal O1</td>
</tr>
<tr>
<td>13</td>
<td>O2</td>
<td>Output signal O2</td>
</tr>
<tr>
<td>14</td>
<td>O3</td>
<td>Output signal O3</td>
</tr>
<tr>
<td>15</td>
<td>O4</td>
<td>Output signal O4</td>
</tr>
</tbody>
</table>
### Terminals Signal Description

<table>
<thead>
<tr>
<th>Terminals</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>O5</td>
<td>Output signal O5</td>
</tr>
<tr>
<td>17</td>
<td>O6</td>
<td>Output signal O6</td>
</tr>
<tr>
<td>18</td>
<td>O7</td>
<td>Output signal O7</td>
</tr>
<tr>
<td>19</td>
<td>UP</td>
<td>Process supply voltage UP +24 V DC</td>
</tr>
<tr>
<td>20</td>
<td>ZP</td>
<td>Process supply voltage ZP 0 V</td>
</tr>
</tbody>
</table>

The internal power supply voltage for the module's circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 10 mA per DOS61.

The external power supply connection is carried out via the UP (+24 V DC) and ZP (0 V DC) terminals.

---

**WARNING!**

**Removal/Insertion under power**

The devices are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you

- connect or disconnect any signal or terminal block
- remove, mount or replace a module.

Disconnecting any powered devices while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The devices must not be opened when in operation. The same applies to the network interfaces.

---

**NOTICE!**

**Risk of damaging the PLC modules!**

Overvoltages and short circuits might damage the PLC modules.

- Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
- Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.
NOTICE!
Risk of malfunctions in the plant!
The outputs may switch on for a period of 10 to 50 µs if the process supply voltage UP/ZP is switched on.
This must be considered in the planning of the application.

NOTICE!
Risk of damaging the I/O module!
The outputs are not protected against short circuits and overload.
- Never short-circuit or overload the outputs.
- Never connect the outputs to other voltages.
- Use an external 3 A fast-protection fuse for the outputs.

The module provides several diagnosis functions "Chapter 5.2.4.3.1.6.7 “Diagnosis” on page 442.
The meaning of the LEDs is described in the section State LEDs "Chapter 5.2.4.3.1.6.8 “State LEDs” on page 443.

I/O configuration

The module itself does not store configuration data. It receives its parameterization data from the master device of the I/O bus (CPU or communication interface module) during power-up of the system.
Hence, replacing I/O modules is possible without any re-parameterization via software.
If the external power supply voltage via UP/ZP terminals fails, the I/O module loses its configuration data. The whole station has to be switched off and on again to re-configure the module.

Parameterization

The arrangement of the parameter data is performed with Automation Builder software. The parameter data directly influences the functionality of modules. For non-standard applications, it is necessary to adapt the parameters to your system configuration.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal Value</th>
<th>Internal Value, Type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Internal</td>
<td>6120 ¹)</td>
<td>WORD</td>
<td>6120</td>
<td>0</td>
<td>65535</td>
<td>xx01</td>
</tr>
<tr>
<td>Ignore module</td>
<td>No/Yes</td>
<td>0/1</td>
<td>BYTE</td>
<td>No (0x00)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal</td>
<td>1</td>
<td>BYTE</td>
<td>0/0</td>
<td>255/xx02</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

¹) with CS31 and addresses smaller than 70, the value is increased by 1
²) Value is hexadecimal: HighByte is slot (xx: 0 ... 7), LowByte is index (1 ... n)

GSD file:

```
Ext_User_Prm_Data_Len = 0x03
Ext_User_Prm_Data_Const(0) = 0xE9, 0x17, 0x00;
```

Diagnosis

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier 000 ... 063</th>
<th>AC500-Display</th>
<th>&lt;- Display in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Comp</td>
<td>Dev</td>
<td>Mod</td>
<td>Ch</td>
<td>Err</td>
<td>PS501 PLC Browser</td>
<td></td>
</tr>
<tr>
<td>Byte 6</td>
<td>Byte 3</td>
<td>Byte 4</td>
<td>Byte 5</td>
<td>Byte 6 Bit 0 ... 5</td>
<td>PNIO diagnosis block</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bit 6 ... 7</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>¹)</td>
<td>²)</td>
<td>³)</td>
<td>⁴)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Module error DO561

<table>
<thead>
<tr>
<th>3</th>
<th>14</th>
<th>1 ... 10</th>
<th>31</th>
<th>31</th>
<th>19</th>
<th>Checksum error in the I/O module</th>
<th>Replace I/O module</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Hardware descriptions

#### Device specifications > I/O modules

---

**State LEDs**

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image.png" alt="Image" /></td>
<td>Digital output</td>
<td>Yellow</td>
<td>Output is OFF</td>
<td>Output is ON (the output voltage is only displayed if the supply voltage of the module is ON)</td>
</tr>
</tbody>
</table>
**Technical data**

**Technical data of the module**

The system data of AC500-eCo apply.

*Chapter 5.1.1 “System data AC500-eCo” on page 159*

Only additional details are therefore documented below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltage UP</td>
<td>Terminal 19 for UP (+24 V DC) and terminal 20 for ZP (0 V DC)</td>
</tr>
<tr>
<td>Connections</td>
<td>Terminal 19 for UP (+24 V DC) and terminal 20 for ZP (0 V DC)</td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Current consumption via UP terminal</td>
<td>5 mA + max. 0.5 A per output</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5 %</td>
</tr>
<tr>
<td>Inrush current</td>
<td>0.000002 A²s</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse for UP</td>
<td>Recommended; the outputs must be protected by an 3 A fast-acting fuse</td>
</tr>
<tr>
<td>Current consumption from 24 V DC power</td>
<td>Ca. 10 mA</td>
</tr>
<tr>
<td>supply at the L+/UP and M/ZP terminals</td>
<td></td>
</tr>
<tr>
<td>of the CPU/communication interface</td>
<td></td>
</tr>
<tr>
<td>module</td>
<td></td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, between the output group and the rest of the module</td>
</tr>
<tr>
<td>Isolated groups</td>
<td>1 (8 channels per group)</td>
</tr>
<tr>
<td>Surge-voltage (max.)</td>
<td>35 V DC for 0.5 s</td>
</tr>
<tr>
<td>Power dissipation within the module</td>
<td>1.6 W</td>
</tr>
<tr>
<td>(max.)</td>
<td></td>
</tr>
<tr>
<td>Weight</td>
<td>Ca. 115 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or</td>
</tr>
<tr>
<td></td>
<td>other parts in the control cabinet.</td>
</tr>
</tbody>
</table>

**No effects of multiple overloads**

No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an external fuse.

**Technical data of the digital outputs**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8 transistor outputs (24 V DC, 0.5 A max.)</td>
</tr>
<tr>
<td>Distribution of the channels into</td>
<td>1 (8 channels per group)</td>
</tr>
<tr>
<td>groups</td>
<td></td>
</tr>
<tr>
<td>Connection of the channels O0 to O7</td>
<td>Terminals 11 to 18</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>Terminal 19 (positive pole of the process voltage, signal name UP)</td>
</tr>
<tr>
<td>Reference potential for the channels</td>
<td>Terminal 20 (negative pole of the process voltage, signal name ZP)</td>
</tr>
<tr>
<td>O0 to O7</td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>1 yellow LED per channel; the LED is on when the output signal is high (signal 1) and the module is powered via the I/O bus</td>
</tr>
<tr>
<td>Way of operation</td>
<td>Non-latching type</td>
</tr>
<tr>
<td>Min. output voltage at signal 1</td>
<td>20 V DC at max. current consumption</td>
</tr>
<tr>
<td>Output delay (max. at rated load)</td>
<td></td>
</tr>
<tr>
<td>0 to 1</td>
<td>50 µs</td>
</tr>
<tr>
<td>1 to 0</td>
<td>200 µs</td>
</tr>
<tr>
<td>Output data length</td>
<td>1 byte</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated current per channel (max.)</td>
<td>0.5 A at UP 24 V DC</td>
</tr>
<tr>
<td>Rated current per group (max.)</td>
<td>4 A</td>
</tr>
<tr>
<td>Lamp load (max.)</td>
<td>5 W</td>
</tr>
<tr>
<td>Max. leakage current with signal 0</td>
<td>0.5 mA</td>
</tr>
<tr>
<td>Output type</td>
<td>Non-protected</td>
</tr>
<tr>
<td>Protection type</td>
<td>External fuse on each channel</td>
</tr>
<tr>
<td>Rated protection fuse (for each channel)</td>
<td>3 A fast</td>
</tr>
<tr>
<td>Demagnetization when inductive loads are switched off</td>
<td>Must be performed externally according to driven load specification</td>
</tr>
<tr>
<td>Switching Frequencies</td>
<td></td>
</tr>
<tr>
<td>With inductive loads</td>
<td>Max. 0.5 Hz</td>
</tr>
<tr>
<td>With lamp loads</td>
<td>Max. 11 Hz at max. 5 W</td>
</tr>
<tr>
<td>Short-circuit-proof / Overload-proof</td>
<td>No</td>
</tr>
<tr>
<td>Overload message</td>
<td>No</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>No</td>
</tr>
<tr>
<td>Resistance to feedback against 24 V DC</td>
<td>No</td>
</tr>
<tr>
<td>Connection of 2 outputs in parallel</td>
<td>Not possible</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>500 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>150 m</td>
</tr>
</tbody>
</table>
The dimensions are in mm and in brackets in inch.

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1TNE 968 902 R2201</td>
<td>DO561, digital output module, 8 DO, transistor output</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3102</td>
<td>Terminal block TA563-11, 11 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3104</td>
<td>Terminal block TA564-11, 11 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3106</td>
<td>Terminal block TA565-11, 11 pins, spring front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
DO562 - Digital output module

Features

- 16 digital outputs 24 V DC (O0 ... O15) in 1 group
- Module-wise galvanically isolated

Intended purpose

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g., CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.

The outputs are group-wise galvanically isolated from each other.
All other circuitry of the module is galvanically isolated from the outputs.

The I/O module must not be used as a decentralized I/O module with CI590-CS31-HA communication interface modules.

Functionality

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED displays</td>
<td>For signal states</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via I/O bus</td>
</tr>
<tr>
<td>External power supply</td>
<td>Via the terminals ZP and UP (process supply voltage 24 V DC)</td>
</tr>
</tbody>
</table>

Connections

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The connection is carried out by using removable 9-pin and 11-pin terminal blocks. These terminal blocks differ in their connection system (spring terminals or screw terminals, cable mounting from the front or from the side). The terminal blocks are not included in the module's scope of delivery and must be ordered separately.
Table 130: Assignment of the terminals:

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>2</td>
<td>O0</td>
<td>Output signal O0</td>
</tr>
<tr>
<td>3</td>
<td>O1</td>
<td>Output signal O1</td>
</tr>
<tr>
<td>4</td>
<td>O2</td>
<td>Output signal O2</td>
</tr>
<tr>
<td>5</td>
<td>O3</td>
<td>Output signal O3</td>
</tr>
<tr>
<td>6</td>
<td>O4</td>
<td>Output signal O4</td>
</tr>
<tr>
<td>7</td>
<td>O5</td>
<td>Output signal O5</td>
</tr>
<tr>
<td>8</td>
<td>O6</td>
<td>Output signal O6</td>
</tr>
<tr>
<td>9</td>
<td>O7</td>
<td>Output signal O7</td>
</tr>
<tr>
<td>10</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>11</td>
<td>O8</td>
<td>Output signal O8</td>
</tr>
<tr>
<td>12</td>
<td>O9</td>
<td>Output signal O9</td>
</tr>
<tr>
<td>13</td>
<td>O10</td>
<td>Output signal O10</td>
</tr>
</tbody>
</table>

Fig. 52: Internal construction of the digital outputs
### Terminal Signal Description

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>14</td>
<td>O11</td>
<td>Output signal O11</td>
</tr>
<tr>
<td>15</td>
<td>O12</td>
<td>Output signal O12</td>
</tr>
<tr>
<td>16</td>
<td>O13</td>
<td>Output signal O13</td>
</tr>
<tr>
<td>17</td>
<td>O14</td>
<td>Output signal O14</td>
</tr>
<tr>
<td>18</td>
<td>O15</td>
<td>Output signal O15</td>
</tr>
<tr>
<td>19</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>20</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
</tbody>
</table>

The internal power supply voltage for the module's circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 10 mA per DO562.

The external power supply connection is carried out via the UP (+24 V DC) and ZP (0 V DC) terminals.

---

### WARNING!

**Removal/Insertion under power**

The devices are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you
- connect or disconnect any signal or terminal block
- remove, mount or replace a module.

Disconnecting any powered devices while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The devices must not be opened when in operation. The same applies to the network interfaces.

---

### NOTICE!

**Risk of damaging the PLC modules!**

Overvoltages and short circuits might damage the PLC modules.
- Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
- Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.
**NOTICE!**

**Risk of malfunctions in the plant!**

The outputs may switch on for a period of 10 to 50 $\mu$s if the process supply voltage UP/ZP is switched on.

This must be considered in the planning of the application.
NOTICE!
Risk of damaging the I/O module!
The outputs are not protected against short circuits and overload.
- Never short-circuit or overload the outputs.
- Never connect the outputs to other voltages.
- Use an external 3 A fast-protection fuse for the outputs.

The module provides several diagnosis functions © Chapter 5.2.4.3.1.7.7 “Diagnosis” on page 453.
The meaning of the LEDs is described in the section Status LEDs © Chapter 5.2.4.3.1.7.8 “State LEDs” on page 453.

I/O configuration
The module itself does not store configuration data. It receives its parameterization data from the master device of the I/O bus (CPU or communication interface module) during power-up of the system.
Hence, replacing I/O modules is possible without any re-parameterization via software.

If the external power supply voltage via UP/ZP terminals fails, the I/O module loses its configuration data. The whole station has to be switched off and on again to re-configure the module.

Parameterization
The arrangement of the parameter data is performed with Automation Builder software.
The parameter data directly influences the functionality of modules.
For non-standard applications, it is necessary to adapt the parameters to your system configuration.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal Value</th>
<th>Internal Value, Type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Internal</td>
<td>6145 1)</td>
<td>WORD</td>
<td>6145</td>
<td>0 x1801</td>
<td>0</td>
<td>65535</td>
</tr>
<tr>
<td>Ignore module</td>
<td>No Yes</td>
<td>0 1</td>
<td>BYTE</td>
<td>No</td>
<td>(0x00)</td>
<td>0</td>
<td>255</td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal</td>
<td>1</td>
<td>BYTE</td>
<td>0</td>
<td>0</td>
<td>255</td>
<td>xx02</td>
</tr>
</tbody>
</table>

1) with CS31 and addresses less than 70, the value is increased by 1
2) Value is hexadecimal: HighByte is slot (xx: 0 ... 7), LowByte is index (1 ... n)

GSD file:

```
Ext_User_Prm_Data_Len = 0x06
Ext_User_Prm_Data_Const(0) = 0x18, 0x02, 0x00, 0x02, 0x00, 0x00;
```
## Diagnosis

<table>
<thead>
<tr>
<th>E1...E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier 000 ... 063</th>
<th>AC500-Display &lt;- Display in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Comp</td>
<td>Dev</td>
<td>Mod</td>
<td>Ch</td>
<td>Err</td>
<td>PS501 PLC Browser</td>
</tr>
<tr>
<td>Byte 6</td>
<td>Bit 6 ... 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>Byte 3</td>
<td>Byte 4</td>
<td>Byte 5</td>
<td>Byte 6 Bit 0 ... 5</td>
<td>PNIO diagnosis block</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error-Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>1)</td>
<td>2)</td>
<td>3)</td>
<td>4)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Module error

| 3 | 14 | 1 ... 10 | 31 | 31 | 19 | Checksum error in the I/O module | Replace I/O module |
| 11 / 12 | ADR | 1 ... 10 |     |     |     |                                      |                    |
| 3 | 14 | 1 ... 10 | 31 | 31 | 43 | Internal error in the module | Replace I/O module |
| 11 / 12 | ADR | 1 ... 10 |     |     |     |                                      |                    |
| 3 | 14 | 1 ... 10 | 31 | 31 | 9 | Overflow diagnosis buffer | Restart |
| 11 / 12 | ADR | 1 ... 10 |     |     |     |                                      |                    |
| 3 | 14 | 1 ... 10 | 31 | 31 | 26 | Parameter error | Check master |
| 11 / 12 | ADR | 1 ... 10 |     |     |     |                                      |                    |

Remarks:

1) In AC500 the following interface identifier applies:
   14 = I/O bus, 11 = COM1 (e.g. CS31 bus), 12 = COM2.
   The PNIO diagnosis block does not contain this identifier.

2) With "Device" the following allocation applies:
   31 = module itself, 1 ... 10 = decentralized communication interface module 1 ... 10,
   ADR = hardware address (e.g. of the DC551-CS31)

3) With "Module" the following allocation depends on the master:
   Module error: I/O bus or PNIO: 31 = Module itself; COM1/COM2: 1 ... 10 = expansion 1 ... 10
   Channel error: I/O bus or PNIO = module type (2 = DO); COM1/COM2: 1 ... 10 = expansion 1 ... 10

4) In case of module errors, with channel "31 = Module itself" is output.

## State LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Outputs O0 ... O15</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Digital output</td>
<td>Yellow</td>
<td>Output is OFF</td>
<td>Output is ON</td>
<td></td>
</tr>
<tr>
<td>(the output voltage is only displayed if the supply voltage of the module is ON)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Technical data of the module

The system data of AC500-eCo apply.

*Note:* Chapter 5.1.1 “System data AC500-eCo” on page 159

Only additional details are therefore documented below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltage UP</td>
<td>Terminal 19 for UP (+24 V DC) and terminal 20 for ZP (0 V DC)</td>
</tr>
<tr>
<td>Connections</td>
<td>Terminal 19 for UP (+24 V DC) and terminal 20 for ZP (0 V DC)</td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Current consumption via UP terminal</td>
<td>20 mA + max. 0.5 A per output</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5 %</td>
</tr>
<tr>
<td>Inrush current</td>
<td>0.000002 A²s</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse for UP</td>
<td>Recommended; the outputs must be protected by an 3 A fast-acting fuse</td>
</tr>
<tr>
<td>Current consumption from 24 V DC power supply</td>
<td>Ca. 10 mA</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, between the output group and the rest of the module</td>
</tr>
<tr>
<td>Isolated groups</td>
<td>1 (16 channels per group)</td>
</tr>
<tr>
<td>Surge-voltage (max.)</td>
<td>35 V DC for 0.5 s</td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>1.4 W</td>
</tr>
<tr>
<td>Weight</td>
<td>Ca. 125 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>

No effects of multiple overloads

No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an external fuse.

Technical data of the digital outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>16 transistor outputs (24 V DC, 0.5 A max.)</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 (16 channels per group)</td>
</tr>
<tr>
<td>Connection of the channels O0 ... O7</td>
<td>Terminals 1 ... 9</td>
</tr>
<tr>
<td>Connection of the channels O8 ... O15</td>
<td>Terminals 11 ... 18</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>Terminal 19 (positive pole of the process voltage, signal name UP)</td>
</tr>
<tr>
<td>Reference potential for the channels O0 ... O15</td>
<td>Terminal 20 (negative pole of the process voltage, signal name ZP)</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>1 yellow LED per channel; the LED is on when the output signal is high (signal 1) and the module is powered via the I/O bus</td>
</tr>
<tr>
<td>Way of operation</td>
<td>Non-latching type</td>
</tr>
<tr>
<td>Min. output voltage at signal 1</td>
<td>UP -0.3 V at max. current consumption</td>
</tr>
<tr>
<td>Output delay (max. at rated load)</td>
<td></td>
</tr>
<tr>
<td>0 to 1</td>
<td>50 µs</td>
</tr>
<tr>
<td>1 to 0</td>
<td>200 µs</td>
</tr>
<tr>
<td>Output data length</td>
<td>2 bytes</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated current per channel (max.)</td>
<td>0.5 A at UP 24 V DC</td>
</tr>
<tr>
<td>Rated current per group (max.)</td>
<td>8 A</td>
</tr>
<tr>
<td>Lamp load (max.)</td>
<td>5 W</td>
</tr>
<tr>
<td>Max. leakage current with signal 0</td>
<td>0.5 mA</td>
</tr>
<tr>
<td>Output type</td>
<td>Non-protected</td>
</tr>
<tr>
<td>Protection type</td>
<td>External fuse on each channel</td>
</tr>
<tr>
<td>Rated protection fuse (for each channel)</td>
<td>3 A fast</td>
</tr>
<tr>
<td>Demagnetization when inductive loads are switched off</td>
<td>Must be performed externally according to driven load specification</td>
</tr>
<tr>
<td>Switching Frequencies</td>
<td></td>
</tr>
<tr>
<td>With inductive loads</td>
<td>Max. 0.5 Hz</td>
</tr>
<tr>
<td>With lamp loads</td>
<td>Max. 11 Hz at max. 5 W</td>
</tr>
<tr>
<td>Short-circuit-proof / Overload-proof</td>
<td>No</td>
</tr>
<tr>
<td>Overload message</td>
<td>No</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>No</td>
</tr>
<tr>
<td>Resistance to feedback against 24 V DC</td>
<td>No</td>
</tr>
<tr>
<td>Connection of 2 outputs in parallel</td>
<td>Not possible</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>500 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>150 m</td>
</tr>
</tbody>
</table>
Dimensions

The dimensions are in mm and in brackets in inch.

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 230 900 R0000</td>
<td>DO562, digital output module, 16 DO, transistor output</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3101</td>
<td>Terminal block TA563-9, 9 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3102</td>
<td>Terminal block TA563-11, 11 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3103</td>
<td>Terminal block TA564-9, 9 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3104</td>
<td>Terminal block TA564-11, 11 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3105</td>
<td>Terminal block TA565-9, 9 pins, spring front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3106</td>
<td>Terminal block TA565-11, 11 pins, spring front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
</tbody>
</table>
DO571 - Digital output module

Features

- 8 digital normally open relay outputs 24 V DC / 24 V AC or 100 V AC ... 240 V AC, 2 A max. (NO0 ... NO7) in 2 groups
- Group-wise galvanically isolated

1 I/O bus
2 8 yellow LEDs to display the signal states of the outputs O0 … O7
3 Terminal number
4 Allocation of signal name
5 Terminal block for output signals (11-pin)
6 2 holes for wall-mounting with screws
7 DIN rail
Intended purpose

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g., CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.

The outputs are group-wise galvanically isolated from each other.

All other circuitry of the module is galvanically isolated from the outputs.

![The I/O module must not be used as a decentralized I/O module with CI590-CS31-HA communication interface modules.]

Functionality

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED displays</td>
<td>For signal states</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via I/O bus</td>
</tr>
<tr>
<td>External power supply</td>
<td>Via the terminal L+ (process voltage 24 V DC). The negative pole is provided by the I/O bus.</td>
</tr>
</tbody>
</table>

Connections

![For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.]

The connection is carried out by using removable 9-pin and 11-pin terminal blocks. These terminal blocks differ in their connection system (spring terminals or screw terminals, cable mounting from the front or from the side). The terminal blocks are not included in the module’s scope of delivery and must be ordered separately.
Table 131: Assignment of the terminals:

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>NO0</td>
<td>Normally-open contact of the output NO0</td>
</tr>
<tr>
<td>11</td>
<td>NO1</td>
<td>Normally-open contact of the output NO1</td>
</tr>
<tr>
<td>12</td>
<td>NO2</td>
<td>Normally-open contact of the output NO2</td>
</tr>
<tr>
<td>13</td>
<td>NO3</td>
<td>Normally-open contact of the output NO3</td>
</tr>
<tr>
<td>14</td>
<td>R0..3</td>
<td>Output common for signals NO0 to NO3</td>
</tr>
<tr>
<td>15</td>
<td>NO4</td>
<td>Normally-open contact of the output NO4</td>
</tr>
<tr>
<td>16</td>
<td>NO5</td>
<td>Normally-open contact of the output NO5</td>
</tr>
<tr>
<td>17</td>
<td>NO6</td>
<td>Normally-open contact of the output NO6</td>
</tr>
<tr>
<td>18</td>
<td>NO7</td>
<td>Normally-open contact of the output NO7</td>
</tr>
<tr>
<td>19</td>
<td>R4..7</td>
<td>Output common for signals NO4 to NO7</td>
</tr>
<tr>
<td>20</td>
<td>L+</td>
<td>Process voltage L+ +24 V DC</td>
</tr>
</tbody>
</table>

The internal power supply voltage for the module's circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 5 mA per DO571.

The external power supply connection is carried out via the L+ (+24 V DC) terminal. The negative pole of the external power supply is realized via the I/O bus. Therefore, the CPU/communication interface module and the DO571 must have a common power supply.

**WARNING!**

**Risk of death by electric shock!**

Hazardous voltages can be present at the terminals of the module.

Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.

For screw-type terminals only:
WARNING!

For screw terminals only: Danger of death by electric shock!
The IP 20 protection degree is only provided if all terminal screws are tightened.
Tighten all screws of unused load terminals of relay outputs if voltages > 24 V are connected to the relay group.

WARNING!

Removal/Insertion under power
The devices are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug devices with the power being ON.
Make sure that all voltage sources (supply and process voltage) are switched off before you
– connect or disconnect any signal or terminal block
– remove, mount or replace a module.
Disconnected any powered devices while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.
Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.
The devices must not be opened when in operation. The same applies to the network interfaces.

NOTICE!

Risk of damaging the PLC modules!
– Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
– Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

NOTICE!

Risk of damaging the PLC modules!
The PLC modules can be damaged by overload.
Make sure that the total current of each output common terminal (R0 ... R3 and R4 ... R7) does not exceed 8 A.
Never connect total currents > 8 A per group.
If the group fuse protection is not sufficient, then individual fuse protection of the outputs should be used.

Connection of the module:
Fig. 55: Connection of 24 V DC actuators

Fig. 56: Connection of 24 V AC or 100 V AC ... 240 V AC actuators
NOTICE!
Risk of damaging the I/O module!
The outputs are not protected against short circuit and overload.
- Never short-circuit or overload the outputs.
- Never connect inductive loads without an external suppression against voltage peaks due to inductive kickback.
- Never connect voltages > 240 V. All outputs must be supplied from the same phase.
- Use an external 5 A fast protection fuse for the outputs.

Fig. 57: Power supply - the negative connection is realized via the I/O bus
1 CPU or communication interface module
2 I/O bus
3 DO571

The L+ connection of the DO571 and the 24 V supply of the CPU/communication interface module must be connected to the same 24 V power supply.

The module provides several diagnosis functions © Chapter 5.2.4.3.1.8.7 “Diagnosis” on page 464.
The meaning of the LEDs is described in the section Status LEDs © Chapter 5.2.4.3.1.8.8 “State LEDs” on page 465.

I/O configuration
The module itself does not store configuration data. It receives its parameterization data from the master device of the I/O bus (CPU or communication interface module) during power-up of the system.
Hence, replacing I/O modules is possible without any re-parameterization via software.

*If the external power supply voltage via UP/ZP terminals fails, the I/O module loses its configuration data. The whole station has to be switched off and on again to re-configure the module.*

### Parameterization

The arrangement of the parameter data is performed with Automation Builder software.

The parameter data directly influences the functionality of modules.

For non-standard applications, it is necessary to adapt the parameters to your system configuration.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal Value</th>
<th>Internal Value, Type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Internal</td>
<td>6125 (^1)</td>
<td>WORD</td>
<td>6125</td>
<td>0x17ED</td>
<td>0</td>
<td>65535 xx01</td>
</tr>
<tr>
<td>Ignore module</td>
<td>No</td>
<td>0</td>
<td>BYTE</td>
<td>No</td>
<td>(0x00)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal</td>
<td>1</td>
<td>BYTE</td>
<td>0</td>
<td>0</td>
<td>255</td>
<td>xx02 (^2)</td>
</tr>
<tr>
<td>Check supply</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>On</td>
<td>0x01</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

\(^1\) with CS31 and addresses smaller than 70, the value is increased by 1

\(^2\) Value is hexadecimal: HighByte is slot (xx: 0 ... 7), LowByte is index (1 ... n)

GSD file:

```plaintext
Ext_User_Prm_Data_Len = 0x04
Ext_User_Prm_Data_Const(0) = 0xEF, 0x17, 0x00, 0x01;
```
## Diagnosis

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error Identifier</th>
<th>Error Message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Module error

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error Identifier</th>
<th>Error Message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td></td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>19</td>
<td>Checksum error in the I/O module</td>
</tr>
<tr>
<td></td>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>43</td>
<td>Internal error in the module</td>
</tr>
<tr>
<td></td>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>9</td>
<td>Overflow diagnosis buffer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>26</td>
<td>Parameter error</td>
</tr>
<tr>
<td></td>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>11</td>
<td>Process voltage too low</td>
</tr>
<tr>
<td></td>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Remarks:

1) In AC500 the following interface identifier applies:
   - 14 = I/O bus, 11 = COM1 (e.g. CS31 bus), 12 = COM2.
   - The PNIO diagnosis block does not contain this identifier.

2) With "Device" the following allocation applies:
   - 31 = module itself, 1 ... 10 = decentralized communication interface module 1 ... 10, ADR = Hardware address (e.g. of the DC551-CS31)

3) With "Module" the following allocation applies depending on the master:
   - Module error: I/O bus or PNIO: 31 = module itself; COM1/COM2: 1 ... 10 = expansion 1 ... 10
   - Channel error: I/O bus or PNIO = module type (2 = DO); COM1/COM2: 1 ... 10 = expansion 1 ... 10

4) In case of module errors, with channel "31 = Module itself" is output.
State LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outputs O0 ... O7</td>
<td>Digital output</td>
<td>Yellow</td>
<td>Output is OFF</td>
<td>Output is ON</td>
</tr>
</tbody>
</table>

Outputs O0 to O7 Digital output Yellow Output is OFF Output is ON (the output voltage is only displayed if the supply voltage of the module is ON)

Technical data

Technical data of the module

The system data of AC500-eCo apply.

* Chapter 5.1.1 “System data AC500-eCo” on page 159

Only additional details are therefore documented below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltage L+</td>
<td>Terminal 20 for L+ (+24 V DC). The negative pole is provided by the I/O bus.</td>
</tr>
<tr>
<td>Connections</td>
<td></td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Current consumption via L+</td>
<td>50 mA</td>
</tr>
<tr>
<td>Inrush current (at power-up)</td>
<td>0.0035 A's</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5 %</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse for UP</td>
<td>Recommended; the outputs must be protected by a 3 A fast-acting fuse</td>
</tr>
<tr>
<td>Current consumption from 24 V DC power supply at the L+/UP and M/ZP terminals of the CPU/communication interface module</td>
<td>Ca. 5 mA</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, between the output group and the rest of the module</td>
</tr>
<tr>
<td>Isolated groups</td>
<td>2 (4 channels per group)</td>
</tr>
<tr>
<td>Surge-voltage (max.)</td>
<td>35 V DC for 0.5 s</td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>2.0 W</td>
</tr>
<tr>
<td>Weight</td>
<td>Ca. 150 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>

No effects of multiple overloads

No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an external fuse.
## Technical data of the digital outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8 normally-open relay outputs</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>2 (4 channels per group)</td>
</tr>
<tr>
<td>Connection of the channels O0 ... O3</td>
<td>Terminals 10 ... 13</td>
</tr>
<tr>
<td>Connection of the channels O4 ... O7</td>
<td>Terminals 15 ... 18</td>
</tr>
<tr>
<td>Reference potential for the channels O0 ... O3</td>
<td>Terminal 14 (signal name R0 ... R3)</td>
</tr>
<tr>
<td>Reference potential for the channels O4 ... O7</td>
<td>Terminal 19 (signal name R4 ... R7)</td>
</tr>
<tr>
<td>Relay coil power supply</td>
<td>Terminal 20 (positive pole of the process supply voltage, signal name L+). The negative pole is provided by the I/O bus.</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>1 yellow LED per channel; the LED is on when the output signal is high (signal 1) and the module is powered via the I/O bus</td>
</tr>
<tr>
<td>Way of operation</td>
<td>Non-latching type</td>
</tr>
<tr>
<td>Relay output voltage</td>
<td>24 V DC / 24 V AC or 120/240 V AC</td>
</tr>
<tr>
<td>Output delay</td>
<td></td>
</tr>
<tr>
<td>Switching 0 to 1 (max.)</td>
<td>Typ. 10 ms</td>
</tr>
<tr>
<td>Switching 1 to 0 (max.)</td>
<td>Typ. 10 ms</td>
</tr>
<tr>
<td>Output data length</td>
<td>1 byte</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated current per channel (max.)</td>
<td>2.0 A (24 V DC / 24 V AC / 48 V AC / 120 V AC / 240 V AC, only resistive loads)</td>
</tr>
<tr>
<td></td>
<td>2.0 A (24 V AC / 48 V AC / 120 V AC, only pilot duty)</td>
</tr>
<tr>
<td></td>
<td>1.5 A (240 V AC, only pilot duty)</td>
</tr>
<tr>
<td>Rated current per group (max.)</td>
<td>8 A</td>
</tr>
<tr>
<td>Lamp load (max.)</td>
<td>200 W (230 V AC), 30 W (24 V DC)</td>
</tr>
<tr>
<td>Spark suppression with inductive AC loads</td>
<td>Must be performed externally according to driven load specification</td>
</tr>
<tr>
<td>Switching Frequencies</td>
<td></td>
</tr>
<tr>
<td>With resistive loads</td>
<td>Max. 1 Hz</td>
</tr>
<tr>
<td>With inductive loads</td>
<td>On Request</td>
</tr>
<tr>
<td>With lamp loads</td>
<td>Max. 1 Hz</td>
</tr>
<tr>
<td>Output type</td>
<td>Non-protected</td>
</tr>
<tr>
<td>Protection type</td>
<td>External fuse ¹⁾</td>
</tr>
<tr>
<td>Rated protection fuse</td>
<td>5 A fast</td>
</tr>
<tr>
<td>Short-circuit-proof / Overload-proof</td>
<td>No, should be provided by an external fuse or circuit breaker</td>
</tr>
<tr>
<td>Overload message</td>
<td>No</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>No</td>
</tr>
<tr>
<td>Connection of 2 outputs in parallel</td>
<td>Not possible</td>
</tr>
<tr>
<td>Lifetime of relay contacts (cycles)</td>
<td>100.000 at rated load</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>500 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>150 m</td>
</tr>
</tbody>
</table>

1) Per group in case of group fuse protection. For each channel in case of channel-by-channel fuse protection. The maximum current per group must not be exceeded.

Dimensions

The dimensions are in mm and in brackets in inch.

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1TNE 968 902 R2202</td>
<td>DO571, digital output module, 8 DO, relay output</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3102</td>
<td>Terminal block TA563-11, 11 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3104</td>
<td>Terminal block TA564-11, 11 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3106</td>
<td>Terminal block TA565-11, 11 pins, spring front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
</tbody>
</table>
DO572 - Digital output module

Features

- 8 digital triac outputs (O0 ... O7) in 8 groups
- 120/240 V AC
- Module-wise galvanically isolated

1 I/O bus
2 8 yellow LEDs to display the signal states of the outputs O0 ... O7
3 Terminal number
4 Allocation of signal name
5 Terminal block for output signals (9-pin)
6 Terminal block for output signals (11-pin)
7 2 holes for wall-mounting with screws
8 DIN rail

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
Intended purpose

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g., CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.

The outputs are group-wise galvanically isolated from each other.
All other circuitry of the module is galvanically isolated from the outputs.

The I/O module must not be used as a decentralized I/O module with CI590-CS31-HA communication interface modules.

Functionality

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED displays</td>
<td>For signal states</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via I/O bus</td>
</tr>
<tr>
<td>External power supply</td>
<td>Not necessary</td>
</tr>
</tbody>
</table>

Connections

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The connection is carried out by using removable 9-pin and 11-pin terminal blocks. These terminal blocks differ in their connection system (spring terminals or screw terminals, cable mounting from the front or from the side). The terminal blocks are not included in the module's scope of delivery and must be ordered separately.
**Fig. 58: Internal construction of the digital outputs**

**Table 132: Assignment of the terminals:**

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>O0</td>
<td>Output signal O0</td>
</tr>
<tr>
<td>2</td>
<td>N0</td>
<td>Neutral conductor for the output signal O0</td>
</tr>
<tr>
<td>3</td>
<td>O1</td>
<td>Output signal O1</td>
</tr>
<tr>
<td>4</td>
<td>N1</td>
<td>Neutral conductor for the output signal O1</td>
</tr>
<tr>
<td>5</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>6</td>
<td>O2</td>
<td>Output signal O2</td>
</tr>
<tr>
<td>7</td>
<td>N2</td>
<td>Neutral conductor for the output signal O2</td>
</tr>
<tr>
<td>8</td>
<td>O3</td>
<td>Output signal O3</td>
</tr>
<tr>
<td>9</td>
<td>N3</td>
<td>Neutral conductor for the output signal O3</td>
</tr>
<tr>
<td>10</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>11</td>
<td>O4</td>
<td>Output signal O4</td>
</tr>
<tr>
<td>Terminal</td>
<td>Signal</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>12</td>
<td>N4</td>
<td>Neutral conductor for the output signal O4</td>
</tr>
<tr>
<td>13</td>
<td>O5</td>
<td>Output signal O5</td>
</tr>
<tr>
<td>14</td>
<td>N5</td>
<td>Neutral conductor for the output signal O5</td>
</tr>
<tr>
<td>15</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>16</td>
<td>O6</td>
<td>Output signal O6</td>
</tr>
<tr>
<td>17</td>
<td>N6</td>
<td>Neutral conductor for the output signal O6</td>
</tr>
<tr>
<td>18</td>
<td>O7</td>
<td>Output signal O7</td>
</tr>
<tr>
<td>19</td>
<td>N7</td>
<td>Neutral conductor for the output signal O7</td>
</tr>
<tr>
<td>20</td>
<td>---</td>
<td>Reserved</td>
</tr>
</tbody>
</table>

The internal power supply voltage for the module’s circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 10 mA per DO572.

An external power supply connection is not needed.

**WARNING!**

Risk of death by electric shock!

Hazardous voltages can be present at the terminals of the module.

Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.

**WARNING!**

Removal/Insertion under power

The devices are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you

– connect or disconnect any signal or terminal block
– remove, mount or replace a module.

Disconnecting any powered devices while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The devices must not be opened when in operation. The same applies to the network interfaces.
NOTICE!
Risk of damaging the PLC modules!

Overvoltages and short circuits might damage the PLC modules.

– Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
– Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

---

Fig. 59: Connection of the module
NOTICE!
Risk of damaging the PLC modules!
The PLC modules will be irreparably damaged if a voltage > 240 V is con-
nected.
Make sure that all inputs are fed from the same phase. The module must not be
connected to a 400 V voltage.

The module provides several diagnosis functions \( \odot \) Chapter 5.2.4.3.1.9.7 “Diagnosis”
on page 474.

The meaning of the LEDs is described in the section State LEDs \( \odot \) Chapter 5.2.4.3.1.9.8 “State
LEDs” on page 475.

I/O configuration

The module itself does not store configuration data. It receives its parameterization data from
the master device of the I/O bus (CPU or communication interface module) during power-up of
the system.
Hence, replacing I/O modules is possible without any re-parameterization via software.

If the external power supply voltage via UP/ZP terminals fails, the I/O module
loses its configuration data. The whole station has to be switched off and on
again to re-configure the module.

Parameterization

The arrangement of the parameter data is performed with Automation Builder software.
The parameter data directly influences the functionality of modules.
For non-standard applications, it is necessary to adapt the parameters to your system configura-
tion.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal Value</th>
<th>Internal Value, Type</th>
<th>Default Value</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Internal</td>
<td>6130 1)</td>
<td>WORD</td>
<td>6130 0x17F2</td>
<td>0</td>
<td>65535</td>
<td>xx01</td>
</tr>
<tr>
<td>Ignore module</td>
<td>No</td>
<td>0</td>
<td>BYTE</td>
<td>No (0x00)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameter length 2)</td>
<td>Internal</td>
<td>1 - CPU</td>
<td>BYTE</td>
<td>0</td>
<td>255</td>
<td>xx02 3)</td>
<td></td>
</tr>
</tbody>
</table>

1) With CS31 and addresses smaller than 70, the value is increased by 1
2) The module has no additional user-configurable parameters
3) Value is hexadecimal: HighByte is slot (xx: 0 ... 7), LowByte is index (1 ...

GSD file:
Diagnostic

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier</th>
<th>AC500-Display</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>000 ... 063</td>
<td>PS501 PLC Browser</td>
<td></td>
</tr>
<tr>
<td>Class</td>
<td>Comp</td>
<td>Dev</td>
<td>Mod</td>
<td>Ch</td>
<td>Err</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Byte 6</td>
<td>Bit 6 ... 7</td>
<td>Byte 3</td>
<td>Byte 4</td>
<td>Byte 5</td>
<td>Byte 6 Bit 0 ... 5</td>
<td>PNIO diagnosis block</td>
<td></td>
</tr>
<tr>
<td>Class</td>
<td>Interface</td>
<td>Device</td>
<td>Module</td>
<td>Channel</td>
<td>Error Identifier</td>
<td>Error message</td>
<td>Remedy</td>
</tr>
<tr>
<td>1)</td>
<td>2)</td>
<td>3)</td>
<td>4)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Module error

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td></td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>19</td>
<td>Checksum error in the I/O module</td>
</tr>
<tr>
<td></td>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>43</td>
<td>Internal error in the module</td>
</tr>
<tr>
<td></td>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>9</td>
<td>Overflow diagnosis buffer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>26</td>
<td>Parameter error</td>
</tr>
<tr>
<td></td>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Remarks:

1) In AC500 the following interface identifier applies:
   14 = I/O bus, 11 = COM1 (e.g. CS31-Bus), 12 = COM2.
   The PNIO diagnosis block does not contain this identifier.

2) With "Device" the following allocation applies:
   31 = module itself, 1 ... 10 = decentralized communication interface module 1 ... 10,
   ADR = hardware address (e.g. of the DC551-CS31)

3) With "Module" the following allocation applies depending on the master:
   Module error: I/O bus or PNIO: 31 = module itself; COM1/COM2: 1 ... 10 = expansion 1 ... 10
   Channel error: I/O bus or PNIO = module type (2 = DO); COM1/COM2: 1 ... 10 = expansion 1 ... 10

4) In case of module errors, with channel "31 = Module itself" is output.

Hardware descriptions
Device specifications > I/O modules
State LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Outputs O0 ... O7</td>
<td>Digital output</td>
<td>Output is OFF</td>
<td>Output is ON</td>
</tr>
</tbody>
</table>

Technical data

Technical data of the module

The system data of AC500-eCo apply.

*Chapter 5.1.1 “System data AC500-eCo” on page 159*

Only additional details are therefore documented below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Galvanic isolation</td>
<td>Yes, between the channels and the rest of the module</td>
</tr>
<tr>
<td>Isolated groups</td>
<td>8 (1 channel per group)</td>
</tr>
<tr>
<td>Current consumption from 24 V DC power supply at the L+/UP and M/ZP terminals of the CPU/communication interface module</td>
<td>Ca. 10 mA</td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>On Request</td>
</tr>
<tr>
<td>Weight</td>
<td>ca. 120 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>

No effects of multiple overloads

No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an external fuse.

Technical data of the digital outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8 triac outputs</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>8 groups (1 channel per group)</td>
</tr>
<tr>
<td>Connection of the channels O0 to O7</td>
<td>Terminals 1, 3, 5, 7, 10, 12, 14, 16</td>
</tr>
<tr>
<td>Reference potential for the channels O0 to O7</td>
<td>Terminals 2, 4, 6, 8, 11, 13, 15, 17</td>
</tr>
<tr>
<td>Output voltage for signal 1</td>
<td>On Request</td>
</tr>
<tr>
<td>Max. leakage current with signal 0</td>
<td>1.1 mA root mean square at 132 V AC and 1.8 mA root mean square at 264 V AC</td>
</tr>
<tr>
<td>Output voltage</td>
<td>120 V AC or 240 V AC</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>1 yellow LED per channel; the LED is on when the output signal is high (signal 1) and the module is powered via the I/O bus</td>
</tr>
<tr>
<td>Way of operation</td>
<td>Non-latching type</td>
</tr>
<tr>
<td>Output delay</td>
<td>On Request</td>
</tr>
<tr>
<td>Output data length</td>
<td>1 byte</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>- Rated current per channel (max.)</td>
<td>0.3 A</td>
</tr>
<tr>
<td>- Rated current per group (max.)</td>
<td>0.3 A</td>
</tr>
<tr>
<td>Surge current (max.)</td>
<td>On request</td>
</tr>
<tr>
<td>Lamp load (max.)</td>
<td>On request</td>
</tr>
<tr>
<td>Spark suppression with inductive AC loads</td>
<td>Must be performed externally according to driven load specification</td>
</tr>
<tr>
<td>Switching Frequencies</td>
<td></td>
</tr>
<tr>
<td>- With resistive loads</td>
<td>Max. 10 Hz</td>
</tr>
<tr>
<td>- With inductive loads</td>
<td>Not applicable</td>
</tr>
<tr>
<td>- With lamp loads</td>
<td>Max. 10 Hz</td>
</tr>
<tr>
<td>Output type</td>
<td>Non-protected</td>
</tr>
<tr>
<td>Protection type</td>
<td>External fuse on each channel</td>
</tr>
<tr>
<td>Rated protection fuse</td>
<td>2 A fast</td>
</tr>
<tr>
<td>Short-circuit-proof / Overload-proof</td>
<td>No, should be provided by an external fuse or circuit breaker</td>
</tr>
<tr>
<td>- Overload message</td>
<td>No</td>
</tr>
<tr>
<td>- Output current limitation</td>
<td>No</td>
</tr>
<tr>
<td>Resistance to feedback against 230 V AC</td>
<td>No</td>
</tr>
<tr>
<td>Connection of 2 outputs in parallel</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>- Shielded</td>
<td>500 m</td>
</tr>
<tr>
<td>- Unshielded</td>
<td>150 m</td>
</tr>
</tbody>
</table>
### Dimensions

The dimensions are in mm and in brackets in inch.

### Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1TNE 968 902 R2203</td>
<td>DO572, digital output module, 8 DO, triac output</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3101</td>
<td>Terminal block TA563-9, 9 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3102</td>
<td>Terminal block TA563-11, 11 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3103</td>
<td>Terminal block TA564-9, 9 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3104</td>
<td>Terminal block TA564-11, 11 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3105</td>
<td>Terminal block TA565-9, 9 pins, spring front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3106</td>
<td>Terminal block TA565-11, 11 pins, spring front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
</tbody>
</table>
DO573 - Digital output module

Features

- 16 digital normally open relay outputs 24 V DC or 100 V AC ... 240 V AC (NO0 ... NO15) in 2 groups, 2 A max.
- Group-wise galvanically isolated

1. I/O bus
2. 16 yellow LEDs to display the signal states of the outputs O0 ... O15
3. Terminal number
4. Allocation of signal name
5. Terminal block for output signals (9-pin)
6. Terminal block for output signals (11-pin)
7. 2 holes for wall-mounting with screws
8. DIN rail
Intended purpose

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e. g. CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.

The outputs are group-wise galvanically isolated from each other.

All other circuitry of the module is galvanically isolated from the outputs.

The I/O module must not be used as a decentralized I/O module with CI590-CS31-HA communication interface modules.

Functionality

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED displays</td>
<td>For signal states</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via I/O bus</td>
</tr>
<tr>
<td>External power supply</td>
<td>Via the terminals L+ (process voltage 24 V DC) and M (0 V DC); the M terminal is connected to the M terminal of the CPU via the I/O bus</td>
</tr>
</tbody>
</table>

Connections

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The connection is carried out by using removable 9-pin and 11-pin terminal blocks. These terminal blocks differ in their connection system (spring terminals or screw terminals, cable mounting from the front or from the side). The terminal blocks are not included in the module's scope of delivery and must be ordered separately.
Fig. 60: Internal construction of the digital outputs

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>NO0</td>
<td>Normally-open contact of the output NO0</td>
</tr>
<tr>
<td>2</td>
<td>NO1</td>
<td>Normally-open contact of the output NO1</td>
</tr>
<tr>
<td>3</td>
<td>NO2</td>
<td>Normally-open contact of the output NO2</td>
</tr>
<tr>
<td>4</td>
<td>NO3</td>
<td>Normally-open contact of the output NO3</td>
</tr>
<tr>
<td>5</td>
<td>NO4</td>
<td>Normally-open contact of the output NO4</td>
</tr>
<tr>
<td>6</td>
<td>NO5</td>
<td>Normally-open contact of the output NO5</td>
</tr>
<tr>
<td>7</td>
<td>NO6</td>
<td>Normally-open contact of the output NO6</td>
</tr>
<tr>
<td>8</td>
<td>NO7</td>
<td>Normally-open contact of the output NO7</td>
</tr>
<tr>
<td>9</td>
<td>R0..7</td>
<td>Output common for signals NO0 to NO7</td>
</tr>
<tr>
<td>10</td>
<td>NO8</td>
<td>Normally-open contact of the output NO8</td>
</tr>
<tr>
<td>11</td>
<td>NO9</td>
<td>Normally-open contact of the output NO9</td>
</tr>
<tr>
<td>12</td>
<td>NO10</td>
<td>Normally-open contact of the output NO10</td>
</tr>
<tr>
<td>13</td>
<td>NO11</td>
<td>Normally-open contact of the output NO11</td>
</tr>
</tbody>
</table>
Terminal | Signal | Description
--- | --- | ---
14 | NO12 | Normally-open contact of the output NO12
15 | NO13 | Normally-open contact of the output NO13
16 | NO14 | Normally-open contact of the output NO14
17 | NO15 | Normally-open contact of the output NO15
18 | R8 ... 15 | Output common for signals NO8 to NO15
19 | L+ | Process voltage L+ (24 V DC)
20 | M | Process voltage M (0 V DC)

The internal power supply voltage for the module’s circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 5 mA per DO573.

The external power supply connection is carried out via the L+ (+24 V DC) and the M (0 V DC) terminals. The M terminal is electrically interconnected to the M/ZP terminal of the CPU/communication interface module.

**WARNING!**
Risk of death by electric shock!
Hazardous voltages can be present at the terminals of the module.
Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.

For screw-type terminals only:

**WARNING!**
For screw terminals only: Danger of death by electric shock!
The IP 20 protection degree is only provided if all terminal screws are tightened.
Tighten all screws of unused load terminals of relay outputs if voltages > 24 V are connected to the relay group.

**WARNING!**
Removal/Insertion under power
The devices are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug devices with the power being ON.
Make sure that all voltage sources (supply and process voltage) are switched off before you
- connect or disconnect any signal or terminal block
- remove, mount or replace a module.

Disconnecting any powered devices while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.
Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.
The devices must not be opened when in operation. The same applies to the network interfaces.
NOTICE!

Risk of damaging the I/O module!
The outputs are not protected against short circuit and overload.
- Never short-circuit or overload the outputs.
- Never connect inductive loads without an external suppression against voltage peaks due to inductive kickback.
- Never connect voltages > 240 V. All outputs must be supplied from the same phase.
- Use an external 5 A fast protection fuse for the outputs.

NOTICE!

Risk of damaging the PLC modules!
The PLC modules can be damaged by overload.

Make sure that the total current of each output common terminal (R0..7 and R8..15) does not exceed 10 A.

Never connect total currents > 10 A per group.

If the group fuse protection is not sufficient, then individual fuse protection of the outputs should be used.

The following figure shows the connection of the module:
Fig. 61: Connection of 24 V DC actuators
The module provides several diagnosis functions.

The meaning of the LEDs is described in the section State LEDs in Chapter 5.2.4.3.1.9.8 “State LEDs” on page 475.
Fig. 63: Power supply - the negative connection is realized via the I/O bus

The L+ connection of the DO573 and the 24 V supply of the CPU/communication interface module must be connected to the same 24 V power supply.

I/O configuration

The module itself does not store configuration data. It receives its parameterization data from the master device of the I/O bus (CPU or communication interface module) during power-up of the system.

Hence, replacing I/O modules is possible without any re-parameterization via software.

If the external power supply voltage via UP/ZP terminals fails, the I/O module loses its configuration data. The whole station has to be switched off and on again to re-configure the module.

Parameterization

The arrangement of the parameter data is performed with Automation Builder software.

The parameter data directly influences the functionality of modules.

For non-standard applications, it is necessary to adapt the parameters to your system configuration.
<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal</th>
<th>Internal</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Internal</td>
<td>6150 ¹)</td>
<td>WORD</td>
<td>6150</td>
<td>0</td>
<td>65535</td>
<td>xx01</td>
</tr>
<tr>
<td>Ignore module</td>
<td>No</td>
<td>0</td>
<td>BYTE</td>
<td>No</td>
<td>0</td>
<td>(0x00)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal</td>
<td>1</td>
<td>BYTE</td>
<td>0</td>
<td>0</td>
<td>255</td>
<td>xx02 ²)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Check supply</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>On</td>
<td>0</td>
<td>0x01</td>
<td></td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td></td>
<td>On</td>
<td>0x01</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

¹) with CS31 and addresses less than 70, the value is increased by 1
²) Value is hexadecimal: HighByte is slot (xx: 0 ... 7), LowByte is index (1 ... n)

GSD file:

```
Ext_User_Prm_Data_Len = 0x07 0x18, 0x07, 0x00, 0x03, 0x01, 0x00, 0x00;
Ext_User_Prm_Data_Const(0) = 0x07 0x00, 0x03, 0x01, 0x00,
```

### Diagnosis

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier 000 ... 063</th>
<th>AC500-Display</th>
<th>Display in PLC Browser</th>
<th>PNIO diagnosis block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class Comp</td>
<td>Dev</td>
<td>Mod</td>
<td>Ch</td>
<td>Err</td>
<td>PS501 PLC Browser</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Byte 6 Bit 6 ... 7</td>
<td>Byte 3</td>
<td>Byte 4</td>
<td>Byte 5</td>
<td>Byte 6 Bit 0 ... 5</td>
<td>PNIO diagnosis block</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error-Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>¹)</td>
<td>²)</td>
<td>³)</td>
<td>⁴)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Module error**

<table>
<thead>
<tr>
<th>Module</th>
<th>Error code</th>
<th>Description</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>14 1 ... 10 31 31 19</td>
<td>Checksum error in the I/O module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td></td>
<td>11 / 12 ADR 1 ... 10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14 1 ... 10 31 31 43</td>
<td>Internal error in the module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td></td>
<td>11 / 12 ADR 1 ... 10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14 1 ... 10 31 31 9</td>
<td>Overflow diagnosis buffer</td>
<td>Restart</td>
</tr>
<tr>
<td></td>
<td>11 / 12 ADR 1 ... 10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>14 1 ... 10 31 31 26</td>
<td>Parameter error</td>
<td>Check master</td>
</tr>
<tr>
<td></td>
<td>11 / 12 ADR 1 ... 10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>E1 ... E4</td>
<td>d1</td>
<td>d2</td>
<td>d3</td>
</tr>
<tr>
<td>-----------</td>
<td>----</td>
<td>----</td>
<td>----</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Class</th>
<th>Comp</th>
<th>Dev</th>
<th>Mod</th>
<th>Ch</th>
<th>Err</th>
<th>Byte 6</th>
<th>Bit 6 ... 7</th>
<th>Byte 3</th>
<th>Byte 4</th>
<th>Byte 5</th>
<th>Byte 6</th>
<th>Bit 0 ... 5</th>
<th>PNIO diagnosis block</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error-Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1)</td>
<td>2)</td>
<td>3)</td>
<td>4)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Module error**

<table>
<thead>
<tr>
<th>3</th>
<th>14</th>
<th>1 ... 10</th>
<th>31</th>
<th>31</th>
<th>11</th>
<th>Process voltage too low</th>
<th>Check process voltage</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Remarks:

1) In AC500 the following interface identifier applies:
   14 = I/O bus, 11 = COM1 (e.g. CS31-Bus), 12 = COM2.
   The PNIO diagnosis block does not contain this identifier.

2) With "Device" the following allocation applies:
   31 = Module itself, 1 ... 10 = decentralized communication interface module 1 ... 10,
   ADR = Hardware address (e.g. of the DC551-CS31)

3) With "Module" the following allocation applies depending on the master:
   Module error: I/O bus or PNIO: 31 = module itself; COM1/COM2: 1 ... 10 = expansion 1 ... 10
   Channel error: I/O bus or PNIO = module type (2 = DO); COM1/COM2: 1 ... 10 = expansion 1 ... 10

4) In case of module errors, with channel "31 = Module itself" is output.

**State LEDs**

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="State LEDs" /></td>
<td>Outputs NO0 ... NO15</td>
<td>Digital output</td>
<td>Yellow</td>
<td>Output is OFF</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(the output voltage is only displayed if the supply voltage of the module is ON)</td>
</tr>
</tbody>
</table>

**Technical data**

Technical data of the module

The system data of AC500-eCo apply.
Only additional details are therefore documented below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltage L+</td>
<td></td>
</tr>
<tr>
<td>Connections</td>
<td>Terminals 19 for L+ (+24 V DC) and 20 for M (0 V DC)</td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Current consumption via L+</td>
<td>50 mA</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5 %</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse for L+</td>
<td>Recommended; the outputs must be protected by an 5 A fast-acting fuse</td>
</tr>
<tr>
<td>Current consumption from 24 V DC power supply at</td>
<td>Ca. 5 mA</td>
</tr>
<tr>
<td>the L+/UP and M/ZP terminals of the CPU/commu</td>
<td></td>
</tr>
<tr>
<td>nication interface module</td>
<td></td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, between the output groups and the rest of the module</td>
</tr>
<tr>
<td>Isolated groups</td>
<td>2 (8 channels per group)</td>
</tr>
<tr>
<td>Surge-voltage (max.)</td>
<td>35 V DC for 0.5 s</td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>2.0 W</td>
</tr>
<tr>
<td>Weight</td>
<td>Ca. 160 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>

**No effects of multiple overloads**

No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an external fuse.

**Technical data of the digital outputs**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>16 normally-open relay outputs</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>2 (8 channels per group)</td>
</tr>
<tr>
<td>Connection of the channels NO0 ... NO7</td>
<td>Terminals 1 ... 8</td>
</tr>
<tr>
<td>Connection of the channels NO8 ... NO15</td>
<td>Terminals 10 ... 17</td>
</tr>
<tr>
<td>Reference potential for the channels NO0 ...</td>
<td>Terminal 9 (signal name R0 ... 7)</td>
</tr>
<tr>
<td>NO7</td>
<td></td>
</tr>
<tr>
<td>Reference potential for the channels NO8 ...</td>
<td>Terminal 18 (signal name R8 ... 15)</td>
</tr>
<tr>
<td>NO15</td>
<td></td>
</tr>
<tr>
<td>Relay coil power supply</td>
<td>Terminals 19 and 20 (signal names L+ and M)</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>1 yellow LED per channel; the LED is on when the output signal is high (signal 1) and the module is powered via the I/O bus</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Way of operation</td>
<td>Non-latching type</td>
</tr>
<tr>
<td>Relay output voltage</td>
<td></td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC or 120/240 V AC</td>
</tr>
<tr>
<td>Output delay</td>
<td></td>
</tr>
<tr>
<td>Switching 0 to 1 (max.)</td>
<td>Typ. 10 ms</td>
</tr>
<tr>
<td>Switching 1 to 0 (max.)</td>
<td>Typ. 10 ms</td>
</tr>
<tr>
<td>Output data length</td>
<td>2 bytes</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated current per channel (max.)</td>
<td>2.0 A (24 V DC / 24 V AC / 48 V AC / 120 V AC / 240 V AC, only resistive loads)</td>
</tr>
<tr>
<td></td>
<td>2.0 A (24 V AC / 48 V AC / 120 V AC, only pilot duty)</td>
</tr>
<tr>
<td></td>
<td>1.5 A (240 V AC, only pilot duty)</td>
</tr>
<tr>
<td>Rated current per group (max.)</td>
<td>10 A</td>
</tr>
<tr>
<td>Lamp load (max.)</td>
<td>200 W (230 V AC), 30 W (24 V DC)</td>
</tr>
<tr>
<td>Spark suppression with inductive AC loads</td>
<td>Must be performed externally according to driven load specification</td>
</tr>
<tr>
<td>Switching Frequencies</td>
<td></td>
</tr>
<tr>
<td>With resistive loads</td>
<td>Max. 1 Hz</td>
</tr>
<tr>
<td>With inductive loads</td>
<td>On Request</td>
</tr>
<tr>
<td>With lamp loads</td>
<td>Max. 1 Hz</td>
</tr>
<tr>
<td>Output type</td>
<td>Non-protected</td>
</tr>
<tr>
<td>Protection type</td>
<td>External fuse ¹)</td>
</tr>
<tr>
<td>Rated protection fuse</td>
<td>5 A fast</td>
</tr>
<tr>
<td>Short-circuit-proof / Overload-proof</td>
<td>No, should be provided by an external fuse or circuit breaker</td>
</tr>
<tr>
<td>Overload message</td>
<td>No</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>No</td>
</tr>
<tr>
<td>Connection of 2 outputs in parallel</td>
<td>Not possible</td>
</tr>
<tr>
<td>Lifetime of relay contacts (cycles)</td>
<td>100,000 at rated load</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>500 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>150 m</td>
</tr>
</tbody>
</table>

¹) Per group in case of group fuse protection. For each channel in case of channel-by-channel fuse protection. The maximum current per group must not be exceeded.
Dimensions

The dimensions are in mm and in brackets in inch.

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 231 300 R0000</td>
<td>DO573, digital output module, 16 DO, relay output</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3101</td>
<td>Terminal block TA563-9, 9 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3102</td>
<td>Terminal block TA563-11, 11 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3103</td>
<td>Terminal block TA564-9, 9 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3104</td>
<td>Terminal block TA564-11, 11 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3105</td>
<td>Terminal block TA565-9, 9 pins, spring front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3106</td>
<td>Terminal block TA565-11, 11 pins, spring front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
</tbody>
</table>
DX561 - Digital input/output module

Features

- 8 digital inputs 24 V DC (I0 ... I7) in 1 group
- 8 digital transistor outputs 24 V DC (O0 ... O7) in 1 group
- Group-wise galvanically isolated

![DX561 Diagram]

1. I/O bus
2. 8 yellow LEDs to display the signal states of the inputs I0 ... I7
3. 8 yellow LEDs to display the signal states of the outputs O0 ... O7
4. Terminal number
5. Allocation of signal name
6. Terminal block for input signals (9-pin)
7. Terminal block for output signals (11-pin)
8. 2 holes for wall-mounting with screws
9. DIN rail
**Intended purpose**

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g., CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.

The inputs and outputs are group-wise galvanically isolated from each other.

All other circuitry of the module is galvanically isolated from the inputs.

```
The I/O module must not be used as a decentralized I/O module with CI590-CS31-HA communication interface modules.
```

**Functionality**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED displays</td>
<td>For signal states</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via I/O bus</td>
</tr>
<tr>
<td>External power supply</td>
<td>Via the terminals ZP and UP (process voltage 24 V DC)</td>
</tr>
</tbody>
</table>

**Connections**

```
For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.
```

The connection is carried out by using removable 9-pin and 11-pin terminal blocks. These terminal blocks differ in their connection system (spring terminals or screw terminals, cable mounting from the front or from the side). The terminal blocks are not included in the module's scope of delivery and must be ordered separately.
Fig. 64: Internal construction of the digital inputs and outputs

Table 134: Assignment of the terminals:

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>C0...7</td>
<td>Input common for signals I0 ... I7</td>
</tr>
<tr>
<td>2</td>
<td>I0</td>
<td>Input signal I0</td>
</tr>
<tr>
<td>3</td>
<td>I1</td>
<td>Input signal I1</td>
</tr>
<tr>
<td>4</td>
<td>I2</td>
<td>Input signal I2</td>
</tr>
<tr>
<td>5</td>
<td>I3</td>
<td>Input signal I3</td>
</tr>
<tr>
<td>6</td>
<td>I4</td>
<td>Input signal I4</td>
</tr>
<tr>
<td>7</td>
<td>I5</td>
<td>Input signal I5</td>
</tr>
<tr>
<td>8</td>
<td>I6</td>
<td>Input signal I6</td>
</tr>
<tr>
<td>9</td>
<td>I7</td>
<td>Input signal I7</td>
</tr>
<tr>
<td>10</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>11</td>
<td>O0</td>
<td>Output signal O0</td>
</tr>
<tr>
<td>12</td>
<td>O1</td>
<td>Output signal O1</td>
</tr>
<tr>
<td>13</td>
<td>O2</td>
<td>Output signal O2</td>
</tr>
</tbody>
</table>
### Terminal Signal Description

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>14</td>
<td>O3</td>
<td>Output signal O3</td>
</tr>
<tr>
<td>15</td>
<td>O4</td>
<td>Output signal O4</td>
</tr>
<tr>
<td>16</td>
<td>O5</td>
<td>Output signal O5</td>
</tr>
<tr>
<td>17</td>
<td>O6</td>
<td>Output signal O6</td>
</tr>
<tr>
<td>18</td>
<td>O7</td>
<td>Output signal O7</td>
</tr>
<tr>
<td>19</td>
<td>UP</td>
<td>Process voltage UP +24 V DC</td>
</tr>
<tr>
<td>20</td>
<td>ZP</td>
<td>Process voltage ZP 0 V DC</td>
</tr>
</tbody>
</table>

The internal power supply voltage for the module's circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 10 mA per DX561.

The external power supply connection is carried out via the UP (+24 V DC) and ZP (0 V DC) terminals.

---

**WARNING!**
**Removal/Insertion under power**

The devices are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you

- connect or disconnect any signal or terminal block
- remove, mount or replace a module.

Disconnecting any powered devices while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The devices must not be opened when in operation. The same applies to the network interfaces.

---

**NOTICE!**
**Risk of damaging the PLC modules!**

Overvoltages and short circuits might damage the PLC modules.

- Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
- Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

---

The digital inputs can be used as source inputs or as sink inputs.

---

**NOTICE!**
**Risk of malfunctions in the plant!**

A ground fault, e. g. caused by a damaged cable insulation, can bridge switches accidentally.

Use sink inputs when possible or make sure that, in case of error, there will be no risks to persons or plant.
Fig. 65: Connection of inputs to the digital input/output module - sink inputs

Fig. 66: Connection of inputs to the digital input/output module - source inputs
NOTICE!
Risk of malfunctions in the plant!
The outputs may switch on for a period of 10 to 50 µs if the process supply voltage UP/ZP is switched on.
This must be considered in the planning of the application.

NOTICE!
Risk of damaging the I/O module!
The outputs are not protected against short circuits and overload.
- Never short-circuit or overload the outputs.
- Never connect the outputs to other voltages.
- Use an external 3 A fast-protection fuse for the outputs.

The module provides several diagnosis functions © Chapter 5.2.4.3.1.11.7 “Diagnosis” on page 498.
The meaning of the LEDs is described in the Displays section © Chapter 5.2.4.3.1.11.8 “State LEDs” on page 499 chapter.

I/O configuration
The module itself does not store configuration data. It receives its parameterization data from the master device of the I/O bus (CPU or communication interface module) during power-up of the system.
Hence, replacing I/O modules is possible without any re-parameterization via software.
Parameterization

The arrangement of the parameter data is performed with Automation Builder software. The parameter data directly influences the functionality of modules.

For non-standard applications, it is necessary to adapt the parameters to your system configuration.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal Value</th>
<th>Internal Value, Type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Internal</td>
<td>6135 1)</td>
<td>WORD</td>
<td>6135</td>
<td>0</td>
<td>65535</td>
<td>xx01</td>
</tr>
<tr>
<td>Ignore module</td>
<td>No</td>
<td>0</td>
<td>BYTE</td>
<td>No</td>
<td>1</td>
<td>255</td>
<td>xx02 2)</td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal</td>
<td>1</td>
<td>BYTE</td>
<td>0</td>
<td>0</td>
<td>255</td>
<td>xx02 2)</td>
</tr>
</tbody>
</table>

1) with CS31 and addresses smaller than 70, the value is increased by 1

2) Value is hexadecimal: HighByte is slot (xx: 0 ... 7), LowByte is index (1 ... n)

GSD file:

```
Ext_User_Prm_Data_Len = 0x03
Ext_User_Prm_Data_Const(0) = 0x03
(0) = 0xF8, 0x17, 0x00, \0x01;
```
## Diagnosis

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier</th>
<th>AC500-Display</th>
<th>&lt;- Display in</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>000 ... 063</td>
<td></td>
<td>PLC Browser</td>
</tr>
</tbody>
</table>

### Class
- Comp
- Dev
- Mod
- Ch
- Err

### Byte 6
- Bit 6 ... 7

### Byte 3
- Byte 4
- Byte 5
- Byte 6
- Bit 0 ... 5

### PNIO diagnosis block

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1)</td>
<td>2)</td>
<td>3)</td>
<td>4)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Module error

<table>
<thead>
<tr>
<th>3</th>
<th>14</th>
<th>1 ... 10</th>
<th>31</th>
<th>31</th>
<th>19</th>
<th>Checksum error in the I/O module</th>
<th>Replace I/O module</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td>31</td>
<td>43</td>
<td>Internal error in the module</td>
<td>Replace I/O module</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>9</td>
<td>Overflow diagnosis buffer</td>
<td>Restart</td>
<td></td>
</tr>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td>31</td>
<td>26</td>
<td>Parameter error</td>
<td>Check master</td>
<td></td>
</tr>
</tbody>
</table>

### Remarks:

1) In AC500 the following interface identifier applies:
   - 14 = I/O bus, 11 = COM1 (e.g. CS31 bus), 12 = COM2.
   - The PNIO diagnosis block does not contain this identifier.

2) With "Device" the following allocation applies:
   - 31 = module itself,
   - 1 ... 10 = decentralized communication interface module 1 ... 10,
   - ADR = hardware address (e.g. of the DC551-CS31)

3) With "Module" the following allocation applies depending on the master:
   - Module error: I/O bus or PNIO: 31 = module itself; COM1/COM2: 1 ... 10 = expansion 1 ... 10
   - Channel error: I/O bus or PNIO = module type (2 = DO); COM1/COM2: 1 ... 10 = expansion 1 ... 10

4) In case of module errors, with channel "31 = module itself" is output.
State LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
</tr>
</thead>
<tbody>
<tr>
<td>I0</td>
<td>Digital input</td>
<td>Yellow</td>
<td>Input is OFF</td>
<td>Input is ON</td>
</tr>
<tr>
<td>I7</td>
<td>Digital input</td>
<td>Yellow</td>
<td>Input is OFF</td>
<td>Input is ON</td>
</tr>
<tr>
<td>O0</td>
<td>Digital output</td>
<td>Yellow</td>
<td>Output is OFF</td>
<td>Output is ON</td>
</tr>
<tr>
<td>O7</td>
<td>Digital output</td>
<td>Yellow</td>
<td>Output is OFF</td>
<td>Output is ON</td>
</tr>
</tbody>
</table>

Technical data

Technical data of the module

The system data of AC500-eCo apply.

*Chapter 5.1.1 “System data AC500-eCo” on page 159*

Only additional details are therefore documented below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltage UP</td>
<td></td>
</tr>
<tr>
<td>Connections</td>
<td>Terminal 19 for UP (+24 V DC) and terminal 20 for ZP (0 V DC)</td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Current consumption via UP terminal</td>
<td>5 mA + max. 0.5 A per output</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5 %</td>
</tr>
<tr>
<td>Inrush current</td>
<td>0.000002 A²s</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse for UP</td>
<td>Recommended; the outputs must be protected by an 3 A fast-acting fuse</td>
</tr>
<tr>
<td>Current consumption from 24 V DC power supply at the L+/UP and M/ZP</td>
<td>Ca. 10 mA</td>
</tr>
<tr>
<td>terminals of the CPU/communication interface module</td>
<td></td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, between the input group and the output group and the rest of the module</td>
</tr>
<tr>
<td>Isolated groups</td>
<td>2 groups (1 group for 8 input channels, 1 group for 8 output channels)</td>
</tr>
<tr>
<td>Surge-voltage (max.)</td>
<td>35 V DC for 0.5 s</td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>2.3 W</td>
</tr>
<tr>
<td>Weight</td>
<td>ca. 120 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>

No effects of multiple overloads

No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an external fuse.
## Technical data of the digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group for 8 channels</td>
</tr>
<tr>
<td>Connections of the channels I0 ... I7</td>
<td>Terminals 2 ... 9</td>
</tr>
<tr>
<td>Reference potential for the channels I0 ... I7</td>
<td>Terminal 1</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel; the LED is ON when the input signal is high (signal 1)</td>
</tr>
<tr>
<td>Monitoring point of input indicator</td>
<td>LED is part of the input circuitry</td>
</tr>
<tr>
<td>Input type according to EN 61131-2</td>
<td>Type 1 source, Type 1 sink</td>
</tr>
<tr>
<td>Input signal range</td>
<td>-24 V DC, +24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-5 V ... +3 V, -3 V ... +5 V</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>-15 V ... +5 V, +5 V ... +15 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>-30 V ... -15 V, +15 V ... +30 V</td>
</tr>
<tr>
<td>Ripple with signal 0</td>
<td>-5 V ... +3 V, -3 V ... +5 V</td>
</tr>
<tr>
<td>Ripple with signal 1</td>
<td>-30 V ... -15 V, +15 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 5 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>Typ. 1 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>&gt; 2.5 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 8 mA</td>
</tr>
<tr>
<td>Max. permissible leakage current (at 2-wire proximity switches)</td>
<td>1 mA</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 8 ms</td>
</tr>
<tr>
<td>Input data length</td>
<td>1 byte</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>500 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>300 m</td>
</tr>
</tbody>
</table>

## Technical data of the digital outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8 transistor outputs (24 V DC, 0.5 A max.)</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Connection of the channels O0 ... O7</td>
<td>Terminals 11 ... 18</td>
</tr>
<tr>
<td>Reference potential for the channels O0 ... O7</td>
<td>Terminal 20 (negative pole of the process voltage, name ZP)</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>Terminal 19 (positive pole of the process voltage, name UP)</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>1 yellow LED per channel; the LED is on when the output signal is high (signal 1) and the module is powered via the I/O bus</td>
</tr>
<tr>
<td>Monitoring point of output indicator</td>
<td>Controlled together with transistor</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Way of operation</td>
<td>Non-latching type</td>
</tr>
<tr>
<td>Max. output voltage at signal 1</td>
<td>20 V DC at max. current consumption</td>
</tr>
<tr>
<td>Output delay</td>
<td></td>
</tr>
<tr>
<td>0 to 1</td>
<td>50 µs</td>
</tr>
<tr>
<td>1 to 0</td>
<td>200 µs</td>
</tr>
<tr>
<td>Output data length</td>
<td>1 byte</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated current per channel (max.)</td>
<td>0.5 A at UP 24 V DC</td>
</tr>
<tr>
<td>Rated current per group (max.)</td>
<td>4 A</td>
</tr>
<tr>
<td>Rated current (all channels together, max.)</td>
<td>4 A</td>
</tr>
<tr>
<td>Lamp load (max.)</td>
<td>5 W</td>
</tr>
<tr>
<td>Max. leakage current with signal 0</td>
<td>0.5 mA</td>
</tr>
<tr>
<td>Output type</td>
<td>Non-protected</td>
</tr>
<tr>
<td>Protection type</td>
<td>External fuse on each channel</td>
</tr>
<tr>
<td>Rated protection fuse (for each channel)</td>
<td>3 A fast</td>
</tr>
<tr>
<td>Demagnetization when inductive loads are</td>
<td>Must be performed externally according to driven load specification</td>
</tr>
<tr>
<td>switched off</td>
<td></td>
</tr>
<tr>
<td>Switching Frequencies</td>
<td></td>
</tr>
<tr>
<td>With inductive loads</td>
<td>Max. 0.5 Hz</td>
</tr>
<tr>
<td>With lamp loads</td>
<td>Max. 11 Hz at max. 5 W</td>
</tr>
<tr>
<td>Short-circuit-proof / Overload-proof</td>
<td>No</td>
</tr>
<tr>
<td>Overload message</td>
<td>No</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>No</td>
</tr>
<tr>
<td>Resistance to feedback against 24 V DC</td>
<td>No</td>
</tr>
<tr>
<td>Connection of 2 outputs in parallel</td>
<td>Not possible</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>500 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>150 m</td>
</tr>
</tbody>
</table>
Dimensions

The dimensions are in mm and in brackets in inch.

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1TNE 968 902 R2301</td>
<td>DX561, digital input/output module, 8 DI 24 V DC, 8 DO 24 V DC, transistor output</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3101</td>
<td>Terminal block TA563-9, 9 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3102</td>
<td>Terminal block TA563-11, 11 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3103</td>
<td>Terminal block TA564-9, 9 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3104</td>
<td>Terminal block TA564-11, 11 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3105</td>
<td>Terminal block TA565-9, 9 pins, spring front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3106</td>
<td>Terminal block TA565-11, 11 pins, spring front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
</tbody>
</table>
DX571 - Digital input/output module

Features

- 8 digital inputs 24 V DC / 24 V AC (I0 ... I7) in 1 group
- 8 digital normally open relay outputs 24 V DC / 24 V AC or 100 V AC ... 240 V AC, 2 A max. (NO0 ... NO7) in 2 groups
- Group-wise galvanically isolated

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
7 Terminal block for output signals (11-pin)
8 2 holes for wall-mounting with screws
9 DIN rail

**Intended purpose**

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g. CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.

The inputs and outputs are group-wise galvanically isolated from each other. All other circuitry of the module is galvanically isolated from the inputs.

*The I/O module must not be used as a decentralized I/O module with CI590-CS31-HA communication interface modules.*

**Functionality**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED displays</td>
<td>For signal states</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via I/O bus</td>
</tr>
<tr>
<td>External power supply</td>
<td>Via the terminal L+ (process voltage 24 V DC). The negative pole is provided by the I/O bus.</td>
</tr>
</tbody>
</table>

**Connections**

*For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.*

The connection is carried out by using removable 9-pin and 11-pin terminal blocks. These terminal blocks differ in their connection system (spring terminals or screw terminals, cable mounting from the front or from the side). The terminal blocks are not included in the module's scope of delivery and must be ordered separately.
Table 135: Assignment of the terminals:

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>C0...7</td>
<td>Input common for signals I0...I7</td>
</tr>
<tr>
<td>2</td>
<td>I0</td>
<td>Input signal I0</td>
</tr>
<tr>
<td>3</td>
<td>I1</td>
<td>Input signal I1</td>
</tr>
<tr>
<td>4</td>
<td>I2</td>
<td>Input signal I2</td>
</tr>
<tr>
<td>5</td>
<td>I3</td>
<td>Input signal I3</td>
</tr>
<tr>
<td>6</td>
<td>I4</td>
<td>Input signal I4</td>
</tr>
<tr>
<td>7</td>
<td>I5</td>
<td>Input signal I5</td>
</tr>
<tr>
<td>8</td>
<td>I6</td>
<td>Input signal I6</td>
</tr>
<tr>
<td>9</td>
<td>I7</td>
<td>Input signal I7</td>
</tr>
<tr>
<td>10</td>
<td>NO0</td>
<td>Normally-open contact of the output 0</td>
</tr>
<tr>
<td>11</td>
<td>NO1</td>
<td>Normally-open contact of the output 1</td>
</tr>
</tbody>
</table>
## Terminal Signal Description

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>NO2</td>
<td>Normally-open contact of the output 2</td>
</tr>
<tr>
<td>13</td>
<td>NO3</td>
<td>Normally-open contact of the output 3</td>
</tr>
<tr>
<td>14</td>
<td>R0 ... 3</td>
<td>Output common for signals O0 ... O3</td>
</tr>
<tr>
<td>15</td>
<td>NO4</td>
<td>Normally-open contact of the output 4</td>
</tr>
<tr>
<td>16</td>
<td>NO5</td>
<td>Normally-open contact of the output 5</td>
</tr>
<tr>
<td>17</td>
<td>NO6</td>
<td>Normally-open contact of the output 6</td>
</tr>
<tr>
<td>18</td>
<td>NO7</td>
<td>Normally-open contact of the output 7</td>
</tr>
<tr>
<td>19</td>
<td>R4 ... 7</td>
<td>Output common for signals O4 ... O7</td>
</tr>
<tr>
<td>20</td>
<td>L+</td>
<td>Process voltage +24 V DC</td>
</tr>
</tbody>
</table>

The internal power supply voltage for the module's circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 5 mA per DX571.

The external power supply connection is carried out via the L+ (+24 V DC) terminal. The negative pole of the external power supply is realized via the I/O bus. Therefore, the CPU/communication interface module and the DX571 must have a common power supply.

---

**WARNING!**

**Removal/Insertion under power**

The devices are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you

- connect or disconnect any signal or terminal block
- remove, mount or replace a module.

Disconnecting any powered devices while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The devices must not be opened when in operation. The same applies to the network interfaces.
**NOTICE!**

Risk of damaging the PLC modules!

Overvoltages and short circuits might damage the PLC modules.

- Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
- Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

**NOTICE!**

Risk of damaging the PLC modules!

The PLC modules can be damaged by overload.

Make sure that the total current of each output common terminal (R0 ... 3 and R4 ... 7) does not exceed 8 A.

Never connect total currents > 8 A per group.

If the group fuse protection is not sufficient, then individual fuse protection of the outputs should be used.

The module provides several diagnosis functions (see Diagnosis Chapter 5.2.4.3.1.12.7 “Diagnosis” on page 511).

The digital inputs can be used as source inputs or as sink inputs.

**NOTICE!**

Risk of malfunctions in the plant!

A ground fault, e.g. caused by a damaged cable insulation, can bridge switches accidentally.

Use sink inputs when possible or make sure that, in case of error, there will be no risks to persons or plant.

![Connection of inputs to the digital input/output module DX571 - sink inputs](image)

*Fig. 69: Connection of inputs to the digital input/output module DX571 - sink inputs*
Fig. 70: Connection of inputs to the digital input/output module DX571 - source inputs

The following figures show the connection of the outputs to the module:

Fig. 71: Connection of 24 V DC actuators
The L+ connection of the DX571 and the 24 V supply of the CPU/communication interface module must be connected to the same 24 V power supply.

Fig. 73: Power supply - the minus connection is realized via the I/O bus
1. CPU or communication interface module
2. I/O bus
3. DX571
WARNING!
Risk of death by electric shock!
Hazardous voltages can be present at the terminals of the module.
Make sure that all voltage sources (supply voltage and process supply voltage)
are switched off before you begin with operations on the system.

For screw-type terminals only:

WARNING!
For screw terminals only: Danger of death by electric shock!
The IP 20 protection degree is only provided if all terminal screws are tightened.
Tighten all screws of unused load terminals of relay outputs if voltages > 24 V
are connected to the relay group.

NOTICE!
Risk of damaging the I/O module!
The outputs are not protected against short circuit and overload.
– Never short-circuit or overload the outputs.
– Never connect inductive loads without an external suppression against
  voltage peaks due to inductive kickback.
– Never connect voltages > 240 V. All outputs must be supplied from the
  same phase.
– Use an external 5 A fast protection fuse for the outputs.

The meaning of the LEDs is described in the Displays section Chapter 5.2.4.3.1.12.8 “State
LEDs” on page 512.

I/O configuration

The module itself does not store configuration data. It receives its parameterization data from
the master device of the I/O bus (CPU or communication interface module) during power-up of
the system.

Hence, replacing I/O modules is possible without any re-parameterization via software.

If the external power supply voltage via UP/ZP terminals fails, the I/O module
loses its configuration data. The whole station has to be switched off and on
again to re-configure the module.

Parameterization

The arrangement of the parameter data is performed with Automation Builder software.
The parameter data directly influences the functionality of modules.
For non-standard applications, it is necessary to adapt the parameters to your system configura-
tion.
<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal Value</th>
<th>Internal Value, Type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID Internal</td>
<td>6140</td>
<td>6140 1)</td>
<td>WORD</td>
<td>6140</td>
<td>0</td>
<td>65535</td>
<td>xx01</td>
</tr>
<tr>
<td>Ignore module</td>
<td>No</td>
<td>0</td>
<td>BYTE</td>
<td>No</td>
<td>0</td>
<td>255</td>
<td>xx02 2)</td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal</td>
<td>1</td>
<td>BYTE</td>
<td>0</td>
<td>0</td>
<td>255</td>
<td></td>
</tr>
<tr>
<td>Check supply</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>On</td>
<td>0x01</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1) with CS31 and addresses smaller than 70, the value is increased by 1

2) Value is hexadecimal: HighByte is slot (xx: 0 ... 7), LowByte is index (1...n)

GSD file:

```
Ext_User_Prm_Data_Len = 0x04
Ext_User_Prm_Data_Const(0) = (0x00)
```

### Diagnosis

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier 000 ... 063</th>
<th>AC500-Display</th>
<th>Display in PS501 PLC Browser PNIO diagnosis block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Comp</td>
<td>Dev</td>
<td>Mod</td>
<td>Ch</td>
<td>Err</td>
<td>PS501 PLC Browser PNIO diagnosis block</td>
<td></td>
</tr>
<tr>
<td>Byte 6</td>
<td>-</td>
<td>Byte 3</td>
<td>Byte 4</td>
<td>Byte 5</td>
<td>Byte 6 Bit 0 ... 5</td>
<td>PNIO diagnosis block</td>
<td></td>
</tr>
<tr>
<td>Bit 6 ... 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Module error

<table>
<thead>
<tr>
<th>Class</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier 000 ... 063</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>19 Checklist error in the I/O module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>43 Internal error in the module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>9 Overflow diagnosis buffer</td>
<td>Restart</td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>26 Parameter error</td>
<td>Check master</td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>11 Process voltage too low</td>
<td>Check process voltage</td>
</tr>
</tbody>
</table>

---

**GSD file:**

```
Ext_User_Prm_Data_Len = 0x04
Ext_User_Prm_Data_Const(0) = (0x00)
```
Remarks:

1) In AC500 the following interface identifier applies:
   14 = I/O bus, 11 = COM1 (e.g. CS31 bus), 12 = COM2.
   The PNIO diagnosis block does not contain this identifier.

2) With "Device" the following allocation applies:
   31 = Module itself,
   1 ... 10 = decentralized communication interface module 1 ... 10,
   ADR = hardware address (e.g. of the DC551-CS31)

3) With "Module" the following allocation applies depending on the master:
   Module error: I/O bus or PNIO: 31 = Module itself; COM1/COM2: 1 ... 10 = expansion 1 ... 10
   Channel error: I/O bus or PNIO = Module type (2 = DO); COM1/COM2: 1 ... 10 = expansion 1 ... 10

4) In case of module errors, with channel "31 = module itself" is output.

State LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Inputs I0 ... I7</td>
<td>Digital input</td>
<td>Yellow</td>
<td>Input is OFF</td>
</tr>
<tr>
<td></td>
<td>Outputs NO0 ... NO7</td>
<td>Digital output</td>
<td>Yellow</td>
<td>Output is OFF</td>
</tr>
</tbody>
</table>

In the undefined signal range, the state LED for the inputs can be ON although the input state detected by the module is OFF.

Technical data

Technical data of the module

The system data of AC500-eCo apply.

Chapter 5.1.1 “System data AC500-eCo” on page 159

Only additional details are therefore documented below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltage L+</td>
<td></td>
</tr>
<tr>
<td>Connections</td>
<td>Terminal 20 for L+ (+24 V DC). The negative pole is provided by the I/O bus.</td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Current consumption via L+</td>
<td>50 mA</td>
</tr>
<tr>
<td>Inrush current (at power-up)</td>
<td>0.0035 A(^2) s</td>
</tr>
</tbody>
</table>
Parameter | Value
---|---
Max. ripple | 5 %
Protection against reversed voltage | Yes
Rated protection fuse for L+ | Recommended; the outputs must be protected by a 3 A fast-acting fuse
Current consumption from 24 V DC power supply at the L+/UP and M/ZP terminals of the CPU/communication interface module | Ca. 5 mA
Galvanic isolation | Yes, between the input group and the output group and the rest of the module
Isolated groups | 3 groups (1 group for 8 input channels, 2 groups for 8 output channels)
Surge-voltage (max.) | 35 V DC for 0.5 s
Max. power dissipation within the module | 2.3 W
Weight | Ca. 150 g
Mounting position | Horizontal or vertical
Cooling | The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.

No effects of multiple overloads

No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an external fuse.

Technical data of the digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group for 8 channels</td>
</tr>
<tr>
<td>Connections of the channels I0 ... I7</td>
<td>Terminals 2 ... 9</td>
</tr>
<tr>
<td>Reference potential for the channels I0 ... I7</td>
<td>Terminal 1</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel; the LED is ON when the input signal is high (signal 1)</td>
</tr>
<tr>
<td>Monitoring point of input indicator</td>
<td>LED is part of the input circuitry</td>
</tr>
<tr>
<td>Input type according to EN 61131-2</td>
<td>Type 1 source</td>
</tr>
<tr>
<td>Input signal range</td>
<td>-24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-5 V ... +3 V</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>-15 V ... +5 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>-30 V ... -15 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td>Input voltage 24 V</td>
</tr>
<tr>
<td></td>
<td>Input voltage 5 V</td>
</tr>
<tr>
<td></td>
<td>Input voltage 14 V</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Input voltage 15 V</td>
<td>&gt; 2.5 mA</td>
</tr>
<tr>
<td>Input voltage 27 V</td>
<td>Typ. 5.5 mA r.m.s.</td>
</tr>
<tr>
<td>Input voltage 30 V</td>
<td>&lt; 8 mA</td>
</tr>
<tr>
<td>Max. permissible leakage current (at 2-wire proximity switches)</td>
<td>1 mA Typ. 1 mA r.m.s.</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 8 ms</td>
</tr>
<tr>
<td>Input data length</td>
<td>1 byte</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>500 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>300 m</td>
</tr>
</tbody>
</table>

1) When inputs are used with 24 V AC, external surge limiting filters are required.

**Technical data of the digital outputs**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8 normally-open relay outputs</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>2 (4 channels per group)</td>
</tr>
<tr>
<td>Connection of the channels O0 ... O3</td>
<td>Terminals 10 ... 13</td>
</tr>
<tr>
<td>Connection of the channels O4 ... O7</td>
<td>Terminals 15 ... 18</td>
</tr>
<tr>
<td>Reference potential for the channels O0 ... O3</td>
<td>Terminal 14 (signal name R0 ... 3)</td>
</tr>
<tr>
<td>Reference potential for the channels O4 ... O7</td>
<td>Terminal 19 (signal name R4 ... 7)</td>
</tr>
<tr>
<td>Relay coil power supply</td>
<td>Terminal 20 (positive pole of the process supply voltage, signal name L+). The negative pole is provided by the I/O bus.</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>1 yellow LED per channel; the LED is on when the output signal is high (signal 1) and the module is powered through the I/O bus</td>
</tr>
<tr>
<td>Monitoring point of output indicator</td>
<td>Controlled together with relay</td>
</tr>
<tr>
<td>Way of operation</td>
<td>Non-latching type</td>
</tr>
<tr>
<td>Relay output voltage</td>
<td></td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC / 24 V AC or 120/240 V AC</td>
</tr>
<tr>
<td>Output delay</td>
<td></td>
</tr>
<tr>
<td>Switching 0 to 1 (max.)</td>
<td>Typ. 10 ms</td>
</tr>
<tr>
<td>Switching 1 to 0 (max.)</td>
<td>Typ. 10 ms</td>
</tr>
<tr>
<td>Output data length</td>
<td>1 byte</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated current per channel (max.)</td>
<td>2.0 A (24 V DC / 24 V AC / 48 V AC / 120 V AC / 240 V AC, only resistive loads)</td>
</tr>
<tr>
<td></td>
<td>2.0 A (24 V AC / 48 V AC / 120 V AC, only pilot duty)</td>
</tr>
<tr>
<td></td>
<td>1.5 A (240 V AC, only pilot duty)</td>
</tr>
<tr>
<td>Rated current per group (max.)</td>
<td>8 A</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Lamp load (max.)</td>
<td>200 W (230 V AC), 30 W (24 V DC)</td>
</tr>
<tr>
<td>Spark suppression with inductive AC loads</td>
<td>Must be performed externally according to driven load specification</td>
</tr>
<tr>
<td>Switching Frequencies</td>
<td></td>
</tr>
<tr>
<td>With resistive loads</td>
<td>Max. 1 Hz</td>
</tr>
<tr>
<td>With inductive loads</td>
<td>On Request</td>
</tr>
<tr>
<td>With lamp loads</td>
<td>Max. 1 Hz</td>
</tr>
<tr>
<td>Output type</td>
<td>Non-protected</td>
</tr>
<tr>
<td>Protection type</td>
<td>External fuse 1)</td>
</tr>
<tr>
<td>Rated protection fuse</td>
<td>5 A fast</td>
</tr>
<tr>
<td>Short-circuit-proof / Overload-proof</td>
<td>No, should be provided by an external fuse or circuit breaker</td>
</tr>
<tr>
<td>Overload message</td>
<td>No</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>No</td>
</tr>
<tr>
<td>Connection of 2 outputs in parallel</td>
<td>Not possible</td>
</tr>
<tr>
<td>Lifetime of relay contacts (cycles)</td>
<td>100.000 at rated load</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>500 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>150 m</td>
</tr>
</tbody>
</table>

1) Per group in case of group fuse protection. For each channel in case of channel-by-channel fuse protection. The maximum current per group must not be exceeded.
Dimensions

The dimensions are in mm and in brackets in inch.

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1TNE 968 902 R2302</td>
<td>DX571, digital input/output module, 8 DI 24 V DC / 24 V AC, 8 DO, relay output</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3101</td>
<td>Terminal block TA563-9, 9 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3102</td>
<td>Terminal block TA563-11, 11 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3103</td>
<td>Terminal block TA564-9, 9 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3104</td>
<td>Terminal block TA564-11, 11 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3105</td>
<td>Terminal block TA565-9, 9 pins, spring front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3106</td>
<td>Terminal block TA565-11, 11 pins, spring front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
</tbody>
</table>
5.2.4.3.2 S500 and S500-XC

DC522 - Digital input/output module

Features

- 16 configurable digital inputs/outputs
- Module-wise galvanically isolated
- Fast counter
- XC version for use in extreme ambient conditions available

Hardware descriptions
Device specifications > I/O modules

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
**Intended purpose**

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g. CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.

Digital configurable input/output unit.

- 2 sensor supply voltages 24 V DC, 0.5 A, with short-circuit and overload protection
- 16 digital configurable inputs/outputs 24 V DC (C0 ... C15) in 1 group (2.0 ... 2.7 and 4.0 ... 4.7), each of which can be used
  - as an input,
  - as a transistor output with short-circuit and overload protection, 0.5 A rated current or
  - as a re-readable output (combined input/output) with the technical data of the digital inputs and outputs.
- Optional with fast counter

The configuration is performed by software. The modules are supplied with a process supply voltage of 24 V DC.

All available inputs/outputs are galvanically isolated from all other circuitry of the module. There is no potential separation between the channels within the same group.

For use in extreme ambient conditions (e.g. wider temperature and humidity range), a special XC version of the device is available.

**Functionality**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast counter</td>
<td>Integrated, many configurable operating modes (only with AC500)</td>
</tr>
<tr>
<td>LED displays</td>
<td>For signal states, errors and supply voltage</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Through the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>External power supply</td>
<td>Via the terminals ZP and UP (process voltage 24 V DC)</td>
</tr>
<tr>
<td>Required terminal unit</td>
<td>TU515 or TU516 [Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938]</td>
</tr>
<tr>
<td>Effect of incorrect input terminal connection</td>
<td>Wrong or no signal detected, no damage up to 35 V</td>
</tr>
</tbody>
</table>

The device is plugged on a terminal unit [Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938]. Position the module properly and press until it locks in place. The terminal unit is either mounted on a DIN rail or to the wall using 2 screws plus the additional accessory for wall mounting [Chapter 5.2.8.2.5 “TA526 - Wall mounting accessory” on page 1324].
Connections

The connection of the I/O channels is carried out using the 40 terminals of the I/O terminal unit. I/O modules can be replaced without re-wiring the terminal units.

The terminals 1.8... 4.8 and 1.9 ... 4.9 are electrically interconnected within the I/O terminal unit and always have the same assignment, irrespective of the inserted module:

Terminals 1.8 ... 4.8: process voltage UP = +24 V DC
Terminals 1.9 ... 4.9: process voltage ZP = 0 V DC

The assignment of the other terminals:

1  I/O bus
2  4.0 ... 4.7: Connected with UP (switch) -> Input;
   Connected with ZP (load) -> Output
3  Control cabinet earth

The assignment of the other terminals:
## Terminals Signal Description

<table>
<thead>
<tr>
<th>Terminals</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0 ... 1.3</td>
<td>+24 V</td>
<td>4 x sensor power supply sources (loadable with 0.5 A in total)</td>
</tr>
<tr>
<td>1.4 ... 1.7</td>
<td>0 V</td>
<td>0 V (reference potential)</td>
</tr>
<tr>
<td>2.0 ... 2.7</td>
<td>C0 ... C7</td>
<td>8 digital inputs/outputs</td>
</tr>
<tr>
<td>3.0 ... 3.3</td>
<td>+24 V</td>
<td>4 x sensor power supply sources (loadable with 0.5 A in total)</td>
</tr>
<tr>
<td>3.4 ... 3.7</td>
<td>0 V</td>
<td>0 V (reference potential)</td>
</tr>
<tr>
<td>4.0 ... 4.7</td>
<td>C8 ... C15</td>
<td>8 digital inputs/outputs</td>
</tr>
</tbody>
</table>

### CAUTION!
The process supply voltage must be included in the grounding concept (e.g. grounding of the negative terminal).

The internal power supply voltage for the module's circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 2 mA per DC522.

The external power supply connection is carried out via the UP (+24 V DC) and the ZP (0 V DC) terminals.

### WARNING!
Removal/Insertion under power

Removal or insertion under power is permissible only if all conditions for hot swapping are fulfilled.

 ço Chapter 4.9.3 “Replace an I/O module with hot swap” on page 153

The devices are not designed for removal or insertion under power when the conditions for hot swap do not apply. Because of unforeseeable consequences, it is not allowed to plug in or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you

- connect or disconnect any signal or terminal block
- remove, mount or replace a module.

Disconnecting any powered devices while they are energized in a hazardous location could result in an electric arc, which could create an ignition source resulting in fire or explosion.

Prior to proceeding, make sure that power is been disconnected and that the area has been thoroughly checked to ensure that flammable materials are not present.

The devices must not be opened when in operation. The same applies to the network interfaces.
NOTICE!
Risk of damaging the PLC modules!
Overvoltages and short circuits might damage the PLC modules.
– Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
– Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

NOTICE!
Risk of influences to the connected sensors!
Some sensors may be influenced by the deactivated module outputs of DC522.
Connect a 470 Ω / 1 W resistor in series to inputs C8/C9 if they are used as fast counter inputs to avoid any influences.

The modules provide several diagnosis functions.

### Internal data exchange

<table>
<thead>
<tr>
<th></th>
<th>Without the fast counter</th>
<th>With the fast counter (only with AC500)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital inputs (bytes)</td>
<td>2</td>
<td>4</td>
</tr>
<tr>
<td>Digital outputs (bytes)</td>
<td>2</td>
<td>4</td>
</tr>
<tr>
<td>Counter input data (words)</td>
<td>0</td>
<td>4</td>
</tr>
<tr>
<td>Counter output data (words)</td>
<td>0</td>
<td>8</td>
</tr>
</tbody>
</table>

### I/O Configuration

The module itself does not store configuration data. It receives its parameterization data from the master device of the I/O bus (CPU or communication interface module) during power-up of the system.

Hence, replacing I/O modules is possible without any re-parameterization via software.

*If the external power supply voltage via UP/ZP terminals fails, the I/O module loses its configuration data. The whole station has to be switched off and on again to re-configure the module.*

### Parameterization

<table>
<thead>
<tr>
<th>Firmware version</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firmware version &gt; V2.0.0</td>
<td>The arrangement of the parameter data is performed by Control Builder Plus/ Automation Builder software.</td>
</tr>
</tbody>
</table>

The parameter data directly influences the functionality of modules.

For non-standard applications, it is necessary to adapt the parameters to your system configuration.
Module: Module slot address: Y = 1 ... 10

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot/Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Internal</td>
<td>1220</td>
<td>Word</td>
<td>1220</td>
<td>0</td>
<td>65535</td>
<td>0x0Y01</td>
</tr>
<tr>
<td>Ignore module</td>
<td>No</td>
<td>0</td>
<td>Byte</td>
<td>No</td>
<td>0</td>
<td>0x00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>1</td>
<td></td>
<td>0x00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal</td>
<td>7</td>
<td>Byte</td>
<td>7-CPU 6-FBP</td>
<td>0</td>
<td>255</td>
<td>0x0Y02</td>
</tr>
<tr>
<td>Check supply</td>
<td>Off</td>
<td>0</td>
<td>Byte</td>
<td>On</td>
<td>0</td>
<td>1</td>
<td>0x0Y03</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td></td>
<td>0x01</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input delay</td>
<td>0.1 ms</td>
<td>0</td>
<td>Byte</td>
<td>8 ms</td>
<td>0</td>
<td>3</td>
<td>0x0Y04</td>
</tr>
<tr>
<td></td>
<td>1 ms</td>
<td>1</td>
<td></td>
<td>0x02</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 ms</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>32 ms</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast counter</td>
<td>0</td>
<td>0</td>
<td>Byte</td>
<td>Mode 0 0x00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Short-circuit detection of</td>
<td>Off</td>
<td>0</td>
<td>Byte</td>
<td>On</td>
<td>0</td>
<td>1</td>
<td>0x0Y05</td>
</tr>
<tr>
<td>output or sensor supply</td>
<td>On</td>
<td>1</td>
<td></td>
<td>0x01</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Behaviour of outputs at</td>
<td>Off</td>
<td>0</td>
<td>Byte</td>
<td>Off 0x00</td>
<td>0</td>
<td>2</td>
<td>0x0Y06</td>
</tr>
<tr>
<td>communication errors</td>
<td>Last value</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute value</td>
<td>1+(n*5)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2+(n*5)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>n £ 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Substitute value at outputs</td>
<td>0 ... 65535</td>
<td>0</td>
<td>Word</td>
<td>0 x00000</td>
<td>0</td>
<td>65535</td>
<td>0x0Y07</td>
</tr>
<tr>
<td>Bit 15 = Output 15</td>
<td></td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bit 0 = Output 0</td>
<td></td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Remarks:

1) With CS31 and addresses smaller than 70 and FBP, the value is increased by 1
2) Not with FBP
3) For a description of the counter operating modes, please refer to the 'Fast Counter' section Chapter 5.2.4.3.2.9 “Fast counter” on page 606
4) With FBP or CS31 without the parameter Fast Counter
GSD file:

<table>
<thead>
<tr>
<th>Ext_User_Prm_Data_Len</th>
<th>Ext_User_Prm_Data_Const(0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>0x04, 0xc5, 0x06, \</td>
</tr>
<tr>
<td></td>
<td>0x01, 0x02, 0x01, 0x00, 0x00;</td>
</tr>
</tbody>
</table>

State LEDs

During the power ON procedure, the module initializes automatically. All LEDs (except the channel LEDs) are ON during this time.

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
<th>LED flashes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inputs/outputs C0 ... C15</td>
<td>Digital input or digital output</td>
<td>Yellow</td>
<td>Input/output = OFF</td>
<td>Input/output = ON ¹</td>
<td>--</td>
</tr>
<tr>
<td>UP</td>
<td>Process supply voltage 24 V DC via terminal</td>
<td>Green</td>
<td>Process supply voltage is missing</td>
<td>Process supply voltage OK</td>
<td>--</td>
</tr>
<tr>
<td>CH-ERR1</td>
<td>Channel Error, error messages in groups (digital inputs/outputs combined into the groups 1, 2, 3, 4)</td>
<td>Red</td>
<td>No error or process supply voltage is missing</td>
<td>Severe error within the corresponding group</td>
<td>Error on one channel of the corresponding group (e.g. short circuit at an output)</td>
</tr>
<tr>
<td>CH-ERR2</td>
<td></td>
<td>Red</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CH-ERR3</td>
<td></td>
<td>Red</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CH-ERR4</td>
<td></td>
<td>Red</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CH-ERR ²</td>
<td>Module error</td>
<td>Red</td>
<td>--</td>
<td>Internal error</td>
<td>--</td>
</tr>
</tbody>
</table>

¹) Indication LED is ON even if an input signal is applied to the channel and the supply voltage is off. In this case the module is not operating and does not generate an input signal.

²) All of the LEDs CH-ERR1 to CH-ERR4 light up together

Technical data

Technical data of the module

The system data of AC500 and S500 are applicable to the standard version  “Chapter 5.1.2 “System data AC500” on page 166.

The system data of AC500-XC are applicable to the XC version  “Chapter 5.1.3 “System data AC500-XC” on page 169.

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltage UP</td>
<td></td>
</tr>
<tr>
<td>Connections</td>
<td>Terminals 1.8, 2.8, 3.8 and 4.8 for +24 V (UP) as well as 1.9, 2.9, 3.9 and 4.9 for 0 V (ZP)</td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5 %</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse on UP</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per module</td>
</tr>
<tr>
<td>Current consumption</td>
<td></td>
</tr>
<tr>
<td>From 24 V DC power supply at the L+/UP and M/ZP terminals of the CPU/communication interface module</td>
<td>Ca. 2 mA</td>
</tr>
<tr>
<td>From UP at normal operation / with outputs</td>
<td>0.15 A + max. 0.5 A per output</td>
</tr>
<tr>
<td>Inrush current from UP (at power up)</td>
<td>0.005 A·s</td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>6 W (outputs unloaded)</td>
</tr>
<tr>
<td>Sensor power supply</td>
<td></td>
</tr>
<tr>
<td>Connections</td>
<td>Terminals 1.0 ... 1.3 = +24 V, 1.4 ... 1.7 = 0 V</td>
</tr>
<tr>
<td>Voltage</td>
<td>24 V DC with short-circuit and overload protection</td>
</tr>
<tr>
<td>Loadability</td>
<td>Terminals 1.0 ... 1.3, in total max. 0.5 A</td>
</tr>
<tr>
<td>Weight (without terminal unit)</td>
<td>Ca. 125 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>

**Multiple overloads**

No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an internal smart high-side switch.

**NOTICE!**

All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.
Technical data of the configurable digital inputs/outputs

Each of the configurable I/O channels is defined as input or output by the user program. This is done by interrogating or allocating the corresponding channel.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>16 inputs/outputs (with transistors)</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 16 channels</td>
</tr>
<tr>
<td>If the channels are used as inputs</td>
<td></td>
</tr>
<tr>
<td>Channels C0 ... C7</td>
<td>Terminals 2.0 ... 2.7</td>
</tr>
<tr>
<td>Channels C8 ... C15</td>
<td>Terminals 4.0 ... 4.7</td>
</tr>
<tr>
<td>If the channels are used as outputs</td>
<td></td>
</tr>
<tr>
<td>Channels C0 ... C7</td>
<td>Terminals 2.0 ... 2.7</td>
</tr>
<tr>
<td>Channels C8 ... C15</td>
<td>Terminals 4.0 ... 4.7</td>
</tr>
<tr>
<td>Indication of the input/output signals</td>
<td>1 yellow LED per channel, the LED is ON when the input/output signal is high (signal 1)</td>
</tr>
<tr>
<td>Monitoring point of input/output indicator LED</td>
<td>LED is part of the input circuitry</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>From the rest of the module</td>
</tr>
</tbody>
</table>

Technical data of the digital inputs/outputs if used as inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>Max. 16 digital inputs</td>
</tr>
<tr>
<td>Reference potential for all inputs</td>
<td>Terminals 1.9, 2.9, 3.9 and 4.9 (negative pole of the process supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>From the rest of the module</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel, the LED is ON when the input signal is high (signal 1)</td>
</tr>
<tr>
<td>Monitoring point of input/output indicator LED</td>
<td>LED is part of the input circuitry</td>
</tr>
<tr>
<td>Input type acc. to EN 61131-2</td>
<td>Type 1</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 8 ms, configurable from 0.1 ... 32 ms</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-3 V ... +5 V *)</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>&gt; +5 V ... &lt; +15 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>+15 V ... +30 V</td>
</tr>
<tr>
<td>Ripple with signal 0</td>
<td>Within -3 V ... +5 V *)</td>
</tr>
<tr>
<td>Ripple with signal 1</td>
<td>Within +15 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 5 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>&gt; 1 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>&gt; 5 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 8 mA</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
</tbody>
</table>
*) Due to the direct connection to the output, the demagnetizing varistor is also effective at the input (see figure) above. This is why the difference between UPx and the input signal may not exceed the clamp voltage of the varistor. The varistor limits the voltage to approx. 36 V. Consequently, the input voltage must range -12 V ... +30 V when UPx = 24 V and -6 V ... +30 V when UPx = 30 V.

**Technical data of the digital inputs/outputs if used as outputs**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>Max. 16 transistor outputs</td>
</tr>
<tr>
<td>Reference potential for all outputs</td>
<td>Terminals 1.9, 2.9, 3.9 and 4.9 (negative pole of the process supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>For all outputs: terminals 1.8, 2.8, 3.8 and 4.8 (positive pole of the process supply voltage, signal name UP)</td>
</tr>
<tr>
<td>Output voltage for signal 1</td>
<td>UP (-0.8 V)</td>
</tr>
<tr>
<td>Output delay (0-&gt;1 or 1-&gt;0)</td>
<td>On request</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated value, per channel</td>
<td>500 mA at UP = 24 V</td>
</tr>
<tr>
<td>Maximum value (all channels together)</td>
<td>8 A</td>
</tr>
<tr>
<td>Leakage current with signal 0</td>
<td>&lt; 0.5 mA</td>
</tr>
<tr>
<td>Rated protection fuse on UP</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Demagnetization when inductive loads are switched off</td>
<td>With varistors integrated in the module (see figure below)</td>
</tr>
<tr>
<td>Switching frequency</td>
<td></td>
</tr>
<tr>
<td>With resistive load</td>
<td>On request</td>
</tr>
<tr>
<td>With inductive loads</td>
<td>Max. 0.5 Hz</td>
</tr>
<tr>
<td>With lamp loads</td>
<td>Max. 11 Hz with max. 5 W</td>
</tr>
<tr>
<td>Short-circuit-proof / overload-proof</td>
<td>Yes</td>
</tr>
<tr>
<td>Overload message (I &gt; 0.7 A)</td>
<td>Yes, after ca. 100 ms</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>Yes, automatic reactivation after short circuit/overload</td>
</tr>
<tr>
<td>Resistance to feedback against 24 V signals</td>
<td>Yes</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

The following drawing shows the circuitry of a digital input/output with the varistors for demagnetization when inductive loads are switched off.
Fig. 74: Digital input/output (circuit diagram)

1 UPx (+ 24 V)
2 Digital input/output
3 ZPx (0 V)
4 For demagnization when inductive loads are switched off

Technical data of the fast counter

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Used inputs C8 / C9</td>
<td></td>
</tr>
<tr>
<td>Used outputs C10</td>
<td></td>
</tr>
<tr>
<td>Counting frequency Max. 50 kHz</td>
<td></td>
</tr>
</tbody>
</table>

The fast counter of the module does not work if the module is connected to a
- FBP interface module
- CS31 bus module
- CANopen communication interface module

☞ Chapter 6.8.2.12 “Fast counters in AC500 devices” on page 4536
Dimensions

The dimensions are in mm and in brackets in inch.

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 240 600 R0001</td>
<td>DC522, digital input/output module, 16 DC, 24 V DC / 0.5 A, 2-wires</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 440 600 R0001</td>
<td>DC522-XC, digital input/output module, 16 DC, 24 V DC / 0.5 A, 2-wires, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
DC523 - Digital input/output module

Features

- 24 configurable digital inputs/outputs
- Module-wise galvanically isolated
- Fast counter
- XC version for use in extreme ambient conditions available

![Diagram of DC523 module]

[Intended purpose]

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g. CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.

1 I/O bus
2 Allocation between terminal number and signal name
3 Sensor power supply 24 V DC / 0.5 A
4 24 yellow LEDs to display the signal states at the digital inputs/outputs (C0 ... C23)
5 1 green LED to display the status of the process supply voltage UP
6 4 red LEDs to display errors
7 Label
8 Terminal unit
9 DIN rail
\(^*\) Sign for XC version
Digital configurable input/output unit.

- 1 sensor supply voltage 24 V DC, 0.5 A, with short circuit and overload protection
- 24 digital configurable inputs/outputs 24 V DC (C0 ... C23) in 1 group (2.0 ... 2.7, 3.0 ... 3.7 and 4.0 ... 4.7), of which each can be used
  - as an input,
  - as a transistor output with short circuit and overload protection, 0.5 A rated current or
  - as a re-readable output (combined input/output) with the technical data of the digital inputs and outputs.
- Optional with fast counter

The configuration is performed by software. The modules are supplied with a process supply voltage of 24 V DC.

All available inputs/outputs are galvanically isolated from all other circuitry of the module. There is no potential separation between the channels within the same group.

For use in extreme ambient conditions (e.g. wider temperature and humidity range), a special XC version of the device is available.

**Functionality**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast counter</td>
<td>Integrated, many configurable operating modes (only with AC500)</td>
</tr>
<tr>
<td>LED displays</td>
<td>For signal states, errors and supply voltage</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Through the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>External power supply</td>
<td>Via the terminals ZP and UP (process voltage 24 V DC)</td>
</tr>
<tr>
<td>Required terminal unit</td>
<td>TU515 or TU516 † Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938</td>
</tr>
<tr>
<td>Effect of incorrect input terminal connection</td>
<td>Wrong or no signal detected, no damage up to 35 V</td>
</tr>
</tbody>
</table>

**NOTICE!**

All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

The device is plugged on a terminal unit † Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938. Position the module properly and press until it locks in place. The terminal unit is either mounted on a DIN rail or to the wall using 2 screws plus the additional accessory for wall mounting † Chapter 5.2.8.2.5 “TA526 - Wall mounting accessory” on page 1324.

**Connections**

The connection of the I/O channels is carried out using the 40 terminals of the I/O terminal unit. I/O modules can be replaced without re-wiring the terminal units.

The terminals 1.8 ... 4.8 and 1.9 ... 4.9 are electrically interconnected within the I/O terminal unit and always have the same assignment, irrespective of the inserted module:

Terminals 1.8 ... 4.8: process voltage UP = +24 V DC
Terminals 1.9 ... 4.9: process voltage ZP = 0 V DC

The assignment of the other terminals:

<table>
<thead>
<tr>
<th>Terminals</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0 ... 1.3</td>
<td>+24 V</td>
<td>4 x sensor power supply sources (loadable with 0.5 A in total)</td>
</tr>
<tr>
<td>1.4 ... 1.7</td>
<td>0 V</td>
<td>0 V (reference potential)</td>
</tr>
<tr>
<td>2.0 ... 2.7</td>
<td>C0 ... C7</td>
<td>8 digital inputs/outputs</td>
</tr>
<tr>
<td>3.0 ... 3.7</td>
<td>C8 ... C15</td>
<td>8 digital inputs/outputs</td>
</tr>
<tr>
<td>4.0 ... 4.7</td>
<td>C16 ... C23</td>
<td>8 digital inputs/outputs</td>
</tr>
</tbody>
</table>
CAUTION!
The process supply voltage must be included in the grounding concept (e.g. grounding of the negative terminal).

The internal power supply voltage for the module's circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 2 mA per DC523.

The external power supply connection is carried out via the UP (+24 V DC) and the ZP (0 V DC) terminals.

WARNING!
Removal/Insertion under power
Removal or insertion under power is permissible only if all conditions for hot swapping are fulfilled.

☞ Chapter 4.9.3 "Replace an I/O module with hot swap" on page 153

The devices are not designed for removal or insertion under power when the conditions for hot swap do not apply. Because of unforeseeable consequences, it is not allowed to plug in or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you
- connect or disconnect any signal or terminal block
- remove, mount or replace a module.

Disconnecting any powered devices while they are energized in a hazardous location could result in an electric arc, which could create an ignition source resulting in fire or explosion.

Prior to proceeding, make sure that power has been disconnected and that the area has been thoroughly checked to ensure that flammable materials are not present.

The devices must not be opened when in operation. The same applies to the network interfaces.

NOTICE!
Risk of damaging the PLC modules!
- Overvoltages and short circuits might damage the PLC modules.
  - Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
  - Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

NOTICE!
Risk of influences to the connected sensors!
Some sensors may be influenced by the deactivated module outputs of DC523.

Connect a 470 Ω / 1 W resistor in series to inputs C16/C17 if they are used as fast counter inputs to avoid any influences.

The modules provide several diagnosis functions.
Internal data exchange

<table>
<thead>
<tr>
<th></th>
<th>Without the fast counter</th>
<th>With the fast counter (only with AC500)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital inputs (bytes)</td>
<td>3</td>
<td>5</td>
</tr>
<tr>
<td>Digital outputs (bytes)</td>
<td>3</td>
<td>5</td>
</tr>
<tr>
<td>Counter input data (words)</td>
<td>0</td>
<td>4</td>
</tr>
<tr>
<td>Counter output data (words)</td>
<td>0</td>
<td>8</td>
</tr>
</tbody>
</table>

I/O configuration

The module itself does not store configuration data. It receives its parameterization data from the master device of the I/O bus (CPU or communication interface module) during power-up of the system.

Hence, replacing I/O modules is possible without any re-parameterization via software.

> If the external power supply voltage via UP/ZP terminals fails, the I/O module loses its configuration data. The whole station has to be switched off and on again to re-configure the module.

Parameterization

<table>
<thead>
<tr>
<th>Firmware version</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firmware version &gt; V2.0.0</td>
<td>The arrangement of the parameter data is performed by Control Builder Plus/ Automation Builder software.</td>
</tr>
</tbody>
</table>

The parameter data directly influences the functionality of modules.

For non-standard applications, it is necessary to adapt the parameters to your system configuration.

Module: Module slot address: Y = 1 ... 10

---

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot/Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Internal</td>
<td>1215</td>
<td>Word</td>
<td>1215</td>
<td>0</td>
<td>65535</td>
<td>0x0Y01</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0x04BF</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ignore module 2)</td>
<td>No</td>
<td>0</td>
<td>Byte</td>
<td>No</td>
<td>0</td>
<td>1</td>
<td>Not for FBP</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>1</td>
<td></td>
<td>0x00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal</td>
<td>9</td>
<td>Byte</td>
<td>9-CPU</td>
<td>0</td>
<td>255</td>
<td>0x0Y02</td>
</tr>
<tr>
<td></td>
<td>8-FBP</td>
<td></td>
<td></td>
<td>8-FBP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Check supply</td>
<td>Off</td>
<td>0</td>
<td>Byte</td>
<td>On</td>
<td>0</td>
<td>1</td>
<td>0x=Y03</td>
</tr>
<tr>
<td></td>
<td>on</td>
<td>1</td>
<td></td>
<td>0x01</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Value</td>
<td>Internal value</td>
<td>Internal value, type</td>
<td>Default</td>
<td>Min.</td>
<td>Max.</td>
<td>EDS Slot/Index</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>------------------------</td>
<td>----------------</td>
<td>----------------------</td>
<td>---------</td>
<td>------</td>
<td>------</td>
<td>----------------</td>
</tr>
<tr>
<td>Input delay</td>
<td>0.1 ms</td>
<td>0</td>
<td>Byte</td>
<td>8 ms</td>
<td>0</td>
<td>3</td>
<td>0x0Y04</td>
</tr>
<tr>
<td></td>
<td>1 ms</td>
<td>1</td>
<td></td>
<td>0x02</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 ms</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>32 ms</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast counter</td>
<td>0</td>
<td>0</td>
<td>Byte</td>
<td>Mode</td>
<td>0</td>
<td></td>
<td>Not for FBP</td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>0</td>
<td></td>
<td>0x00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Short circuit detection of output or</td>
<td>Off</td>
<td>0</td>
<td>Byte</td>
<td>On</td>
<td>0</td>
<td>1</td>
<td>0x0Y05</td>
</tr>
<tr>
<td>sensor supply</td>
<td></td>
<td></td>
<td></td>
<td>0x01</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Behaviour of outputs at commu-</td>
<td>Off</td>
<td>0</td>
<td>Byte</td>
<td>Off</td>
<td>0</td>
<td>2</td>
<td>0x0Y06</td>
</tr>
<tr>
<td>nication errors</td>
<td></td>
<td></td>
<td></td>
<td>0x00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Substitute value at outputs</td>
<td>0 ...</td>
<td>0</td>
<td>DWord</td>
<td>0</td>
<td>0</td>
<td>224-1</td>
<td>0x0Y07</td>
</tr>
<tr>
<td>B23 = Output 23</td>
<td>16777215</td>
<td>0</td>
<td></td>
<td>0x0000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bit 0 = Output 0</td>
<td></td>
<td></td>
<td></td>
<td>-0000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remarks:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1) With CS31 and</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>addresses smaller than</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>70 and FBP, the value</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>is increased by 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2) Not with FBP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3) For a description of</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>the counter operating</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>modes, please refer to</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>the ‘Fast Counter’</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>section \ Chapter 5.2.4.3.2.9 “Fast counter” on page 606</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4) With FBP or CS31</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>without the parameter</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Fast Counter</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

GSD file:

```
Ext_User_Prm_Data_Len = 11
Ext_User_Prm_Data_Const(0) = 0x04, 0xc0, 0x08, \ 
0x01, 0x02, 0x01, 0x00, 0x00, 0x00, 0x00, 0x00;
```
State LEDs

During the power ON procedure, the module initializes automatically. All LEDs (except the channel LEDs) are ON during this time.

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
<th>LED flashes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inputs/outputs C0 ... C23</td>
<td>Digital input or digital output</td>
<td>Yellow</td>
<td>Input/output = OFF = OFF</td>
<td>Input/output = ON 1)</td>
<td>--</td>
</tr>
<tr>
<td>UP</td>
<td>Process supply voltage 24 V DC via terminal</td>
<td>Green</td>
<td>Process supply voltage is missing</td>
<td>Process supply voltage OK</td>
<td>--</td>
</tr>
<tr>
<td>CH-ERR1</td>
<td>Channel error, error messages in groups (digital inputs/outputs combined into the groups 1, 2, 3, 4)</td>
<td>Red</td>
<td>No error or process supply voltage is missing</td>
<td>Severe error within the corresponding group</td>
<td>Error on one channel of the corresponding group (e.g. short circuit at an output)</td>
</tr>
<tr>
<td>CH-ERR2</td>
<td></td>
<td>Red</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CH-ERR3</td>
<td></td>
<td>Red</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CH-ERR4</td>
<td></td>
<td>Red</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CH-ERR 2)</td>
<td>Module error</td>
<td>Red</td>
<td></td>
<td>Internal error</td>
<td>--</td>
</tr>
</tbody>
</table>

1) Indication LED is ON even if an input signal is applied to the channel and the supply voltage is off. In this case the module is not operating and does not generate an input signal.

2) All of the LEDs CH-ERR1 to CH-ERR4 light up together

Technical data

Technical data of the module

The system data of AC500 and S500 are applicable to the standard version “Chapter 5.1.2 “System data AC500” on page 166.”

The system data of AC500-XC are applicable to the XC version “Chapter 5.1.3 “System data AC500-XC” on page 169.”

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltage UP</td>
<td></td>
</tr>
<tr>
<td>Connections</td>
<td>Terminals 1.8, 2.8, 3.8 and 4.8 for +24 V (UP) as well as 1.9, 2.9, 3.9 and 4.9 for 0 V (ZP)</td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5 %</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse on UP</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per module</td>
</tr>
<tr>
<td>Current consumption</td>
<td></td>
</tr>
</tbody>
</table>
### Parameter | Value
--- | ---
From 24 V DC power supply at the terminals UP/L+ and ZP/M of the CPU/communication interface module | Ca. 2 mA
From UP at normal operation / with outputs | 0.1 A + max. 0.5 A per output
Inrush current from UP (at power up) | 0.008 A\(^2\)s
Max. power dissipation within the module | 6 W (outputs unloaded)
Sensor power supply | 
Connections | Terminals 1.0 ... 1.3 = +24 V, 1.4 ... 1.7 = 0 V
Voltage | 24 V DC with short circuit and overload protection
Loadability | Terminals 1.0 ... 1.3, in total max. 0.5 A
Weight (without terminal unit) | Ca. 125 g
Mounting position | Horizontal
Or vertical with derating (output load reduced to 50 % at +40 °C per group)
Cooling | The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.

**NOTICE!**

All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

### Technical data of the configurable digital inputs/outputs

Each of the configurable I/O channels is defined as input or output by the user program. This is done by interrogating or allocating the corresponding channel.

### Parameter | Value
--- | ---
Number of channels per module | 24 inputs/outputs (with transistors)
Distribution of the channels into groups | 1 group of 24 channels
If the channels are used as inputs | 
Channels C0 ... C7 | Terminals 2.0 ... 2.7
Channels C8 ... C15 | Terminals 3.0 ... 3.7
Channels C16 ... C23 | Terminals 4.0 ... 4.7
If the channels are used as outputs | 
Channels C0 ... C7 | Terminals 2.0 ... 2.7

**Multiple overloads**

No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an internal smart high-side switch.
### Technical data of the digital inputs/outputs if used as inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>Max. 24 digital inputs</td>
</tr>
<tr>
<td>Reference potential for all inputs</td>
<td>Terminals 1.9, 2.9, 3.9 and 4.9 (negative pole of the process supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>From the rest of the module</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel, the LED is ON when the input signal is high (signal 1)</td>
</tr>
<tr>
<td>Monitoring point of input/output indicator LED</td>
<td>LED is part of the input circuitry</td>
</tr>
<tr>
<td>Input type acc. to EN 61131-2</td>
<td>Type 1</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 8 ms, configurable from 0.1 to 32 ms</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-3 V ... +5 V *)</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>&gt; +5 V ... &lt; +15 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>+15 V ... +30 V</td>
</tr>
<tr>
<td>Ripple with signal 0</td>
<td>Within -3 V ... +5 V *)</td>
</tr>
<tr>
<td>Ripple with signal 1</td>
<td>Within +15 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 5 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>&gt; 1 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>&gt; 5 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 8 mA</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

*) Due to the direct connection to the output, the demagnetizing varistor is also effective at the input (see figure) above. This is why the difference between UPx and the input signal must not exceed the clamp voltage of the varistor. The varistor limits the clamp voltage to approx. 36 V. Consequently, the input voltage must range from -12 V ... +30 V when UPx = 24 V and from -6 V ... +30 V when UPx = 30 V.
### Technical data of the digital inputs/outputs if used as outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>Max. 24 transistor outputs</td>
</tr>
<tr>
<td>Reference potential for all outputs</td>
<td>Terminals 1.9, 2.9, 3.9 and 4.9 (negative pole of the process supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>For all outputs: terminals 1.8, 2.8, 3.8 and 4.8 (positive pole of the process supply voltage, signal name UP)</td>
</tr>
<tr>
<td>Output voltage for signal 1</td>
<td>UP (-0.8 V)</td>
</tr>
<tr>
<td>Output delay (0-&gt;1 or 1-&gt;0)</td>
<td>On request</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated value, per channel</td>
<td>500 mA at UP = 24 V</td>
</tr>
<tr>
<td>Maximum value (all channels together)</td>
<td>8 A</td>
</tr>
<tr>
<td>Leakage current with signal 0</td>
<td>&lt; 0.5 mA</td>
</tr>
<tr>
<td>Rated protection fuse on UP</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Demagnetization when inductive loads are switched off</td>
<td>With varistors integrated in the module (see figure below)</td>
</tr>
<tr>
<td>Switching frequency</td>
<td></td>
</tr>
<tr>
<td>With resistive load</td>
<td>On request</td>
</tr>
<tr>
<td>With inductive loads</td>
<td>Max. 0.5 Hz</td>
</tr>
<tr>
<td>With lamp loads</td>
<td>Max. 11 Hz with max. 5 W</td>
</tr>
<tr>
<td>Short-circuit-proof / overload-proof</td>
<td>Yes</td>
</tr>
<tr>
<td>Overload message (I &gt; 0.7 A)</td>
<td>Yes, after ca. 100 ms</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>Yes, automatic reactivation after short circuit/overload</td>
</tr>
<tr>
<td>Resistance to feedback against 24 V signals</td>
<td>Yes</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

The following drawing shows the circuitry of a digital input/output with the varistors for demagnetization when inductive loads are switched off.
**Fig. 75: Digital input/output (circuit diagram)**

1. UPx (+ 24 V)
2. Digital input/output
3. ZPx (0 V)
4. For demagnization when inductive loads are switched off

**Technical data of the fast counter**

- The fast counter of the module does not work if the module is connected to a
- FBP interface module
- CS31 bus module
- CANopen communication interface module

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Used inputs</td>
<td>C16 / C17</td>
</tr>
<tr>
<td>Used outputs</td>
<td>C18</td>
</tr>
<tr>
<td>Counting frequency</td>
<td>Max. 50 kHz</td>
</tr>
</tbody>
</table>

*Chapter 6.8.2.12 “Fast counters in AC500 devices” on page 4536*

How to prepare a device as fast counter and how to connect it to the PLC is described in an *application example*. 
Dimensions

The dimensions are in mm and in brackets in inch.

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 240 500 R0001</td>
<td>DC523, digital input/output module, 24 DC, 24 V DC / 0.5 A, 1-wire</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 440 500 R0001</td>
<td>DC523-XC, digital input/output module, 24 DC, 24 V DC / 0.5 A, 1-wire, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
**DC532 - Digital input/output module**

**Features**

- 16 digital inputs 24 V DC, 16 configurable digital inputs/outputs
- Module-wise galvanically isolated
- Fast counter
- XC version for use in extreme ambient conditions available

**Intended purpose**

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g. CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.
Digital configurable input / output unit.

- 16 digital inputs 24 V DC in 2 groups (1.0 ... 1.7 and 2.0 ... 2.7)
- 16 digital configurable inputs/outputs 24 V DC (C16 ... C31) in 1 group (3.0 ... 3.7 and 4.0 ... 4.7), of which each can be used
  - as an input,
  - as a transistor output with short circuit and overload protection, 0.5 A rated current or
  - as a re-readable output (combined input/output) with the technical data of the digital
    inputs and outputs.
- Optional with fast counter

The configuration is performed by software. The modules are supplied with a process supply voltage of 24 V DC.

All available inputs/outputs are galvanically isolated from all other circuitry of the module. There is no potential separation between the channels within the same group.

For use in extreme ambient conditions (e.g. wider temperature and humidity range), a special XC version of the device is available.

### Functionality

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital inputs</td>
<td>16 (24 V DC)</td>
</tr>
<tr>
<td>Digital inputs/outputs</td>
<td>16 (24 V DC)</td>
</tr>
<tr>
<td>Fast counter</td>
<td>Integrated, many configurable operating modes (only with AC500)</td>
</tr>
<tr>
<td>LED displays</td>
<td>For signal states, errors and supply voltage</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Through the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>External power supply</td>
<td>Via the terminals ZP and UP (process voltage 24 V DC)</td>
</tr>
<tr>
<td>Required terminal unit</td>
<td>TU515 or TU516 © Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938</td>
</tr>
<tr>
<td>Effect of incorrect input terminal connection</td>
<td>Wrong or no signal detected, no damage up to 35 V</td>
</tr>
</tbody>
</table>

The device is plugged on a terminal unit © Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938. Position the module properly and press until it locks in place. The terminal unit is either mounted on a DIN rail or to the wall using 2 screws plus the additional accessory for wall mounting © Chapter 5.2.8.2.5 “TA526 - Wall mounting accessory” on page 1324.

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.
Connections

The connection of the I/O channels is carried out using the 40 terminals of the I/O terminal unit. I/O modules can be replaced without re-wiring the terminal units.

The terminals 1.8 ... 4.8 and 1.9 ... 4.9 are electrically interconnected within the I/O terminal unit and always have the same assignment, irrespective of the inserted module:

Terminals 1.8 ... 4.8: process voltage UP = +24 V DC
Terminals 1.9 ... 4.9: process voltage ZP = 0 V DC

1 I/O bus
2 4.0 ... 4.7: Connected with UP (switch) -> Input;
   Connected with ZP (load) -> Output
3 Control cabinet earth

The assignment of the other terminals:
<table>
<thead>
<tr>
<th>Terminals</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0 ... 1.7</td>
<td>I0 ... I7</td>
<td>8 digital inputs</td>
</tr>
<tr>
<td>2.0 ... 2.7</td>
<td>I8 ... I15</td>
<td>8 digital inputs</td>
</tr>
<tr>
<td>3.0 ... 3.7</td>
<td>C16 ... C23</td>
<td>8 digital inputs/outputs</td>
</tr>
<tr>
<td>4.0 ... 4.7</td>
<td>C24 ... C31</td>
<td>8 digital inputs/outputs</td>
</tr>
</tbody>
</table>

**CAUTION!**
The process supply voltage must be included in the grounding concept (e.g. grounding of the negative terminal).

The internal power supply voltage for the module’s circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 2 mA per DC532.

The external power supply connection is carried out via the UP (+24 V DC) and the ZP (0 V DC) terminals.

**WARNING!**
Removal/Insertion under power
Removal or insertion under power is permissible only if all conditions for hot swapping are fulfilled.

* Chapter 4.9.3 “Replace an I/O module with hot swap” on page 153

The devices are not designed for removal or insertion under power when the conditions for hot swap do not apply. Because of unforeseeable consequences, it is not allowed to plug in or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you
- connect or disconnect any signal or terminal block
- remove, mount or replace a module.

Disconnecting any powered devices while they are energized in a hazardous location could result in an electric arc, which could create an ignition source resulting in fire or explosion.

Prior to proceeding, make sure that power is been disconnected and that the area has been thoroughly checked to ensure that flammable materials are not present.

The devices must not be opened when in operation. The same applies to the network interfaces.

**NOTICE!**
Risk of damaging the PLC modules!

Overvoltages and short circuits might damage the PLC modules.
- Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
- Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.
NOTICE!
Risk of influences to the connected sensors!
Some sensors may be influenced by the deactivated module outputs of DC532. 
Connect a 470 Ω / 1 W resistor in series to inputs C24/C25 if using them as fast counter inputs to avoid any influences.

The module provides several diagnosis functions.

### Internal data exchange

<table>
<thead>
<tr>
<th></th>
<th>Without the fast counter</th>
<th>With the fast counter (only with AC500)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital inputs (bytes)</td>
<td>4</td>
<td>6</td>
</tr>
<tr>
<td>Digital outputs (bytes)</td>
<td>2</td>
<td>4</td>
</tr>
<tr>
<td>Counter input data (words)</td>
<td>0</td>
<td>4</td>
</tr>
<tr>
<td>Counter output data (words)</td>
<td>0</td>
<td>8</td>
</tr>
</tbody>
</table>

### I/O configuration

The module itself does not store configuration data. It receives its parameterization data from the master device of the I/O bus (CPU or communication interface module) during power-up of the system.

Hence, replacing I/O modules is possible without any re-parameterization via software.

*If the external power supply voltage via UP/ZP terminals fails, the I/O module loses its configuration data. The whole station has to be switched off and on again to re-configure the module.*

### Parameterization

<table>
<thead>
<tr>
<th>Firmware version</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firmware version &gt; V2.0.0</td>
<td>The arrangement of the parameter data is performed by Control Builder Plus/ Automation Builder software.</td>
</tr>
</tbody>
</table>

The parameter data directly influences the functionality of modules.

For non-standard applications, it is necessary to adapt the parameters to your system configuration.

Module: Module slot address: $Y = 1 \ldots 10$
<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Internal</td>
<td>1200</td>
<td>Word</td>
<td>1200</td>
<td>0</td>
<td>65535</td>
</tr>
<tr>
<td>Ignore module</td>
<td>No</td>
<td>0</td>
<td>Byte</td>
<td>No</td>
<td>0</td>
<td>Not for FBP</td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal</td>
<td>7</td>
<td>Byte</td>
<td>7-CPU</td>
<td>0</td>
<td>255</td>
</tr>
<tr>
<td>Check supply</td>
<td>Off</td>
<td>0</td>
<td>Byte</td>
<td>On</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Input delay</td>
<td>0.1 ms</td>
<td>0</td>
<td>Byte</td>
<td>8 ms</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>Fast counter</td>
<td>0</td>
<td>0</td>
<td>Byte</td>
<td>Mode</td>
<td>0</td>
<td>Not for FBP</td>
</tr>
<tr>
<td>Output short circuit detection</td>
<td>Off</td>
<td>0</td>
<td>Byte</td>
<td>On</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Behaviour of outputs at communication errors</td>
<td>Off</td>
<td>0</td>
<td>Byte</td>
<td>Off</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>Substitute value at outputs</td>
<td>0 ... 65535</td>
<td>0 ... 0xffff</td>
<td>Word</td>
<td>0 0x0000</td>
<td>0</td>
<td>65535</td>
</tr>
</tbody>
</table>

Remarks:

1) With CS31 and addresses smaller than 70 and FBP, the value is increased by 1
2) Not with FBP
3) For a description of the counter operating modes, please refer to the 'Fast Counter' section Chapter 5.2.4.3.2.9 "Fast counter" on page 606
4) With FBP or CS31 without the parameter Fast Counter

GSD file:
### Ext_User_Prm_Data_Len =

Ext_User_Prm_Data_Const(0) =

<table>
<thead>
<tr>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
</tr>
<tr>
<td>0x04, 0xb1, 0x06, \</td>
</tr>
<tr>
<td>0x01, 0x02, 0x01, 0x00, 0x00, 0x00;</td>
</tr>
</tbody>
</table>

### State LEDs

During the power ON procedure, the module initializes automatically. All LEDs (except the channel LEDs) are ON during this time.

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
<th>LED flashes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inputs</td>
<td>Digital input</td>
<td>Yellow</td>
<td>Input = OFF</td>
<td>Input = ON ¹)</td>
<td>--</td>
</tr>
<tr>
<td>Inputs/ outputs</td>
<td>Digital input/output</td>
<td>Yellow</td>
<td>Input/output = OFF</td>
<td>Input/output = ON ¹)</td>
<td>--</td>
</tr>
<tr>
<td>UP</td>
<td>Process supply voltage 24 V DC via terminal</td>
<td>Green</td>
<td>Process supply voltage is missing</td>
<td>Process supply voltage OK</td>
<td>--</td>
</tr>
<tr>
<td>CH-ERR1</td>
<td>Channel Error, error messages in groups (digital inputs/outputs combined into the groups 1, 2, 3, 4)</td>
<td>Red</td>
<td>No error or process supply voltage is missing</td>
<td>Severe error within the corresponding group</td>
<td>Error on one channel of the corresponding group (e.g. short circuit at an output)</td>
</tr>
<tr>
<td>CH-ERR2</td>
<td>Red</td>
<td>--</td>
<td>Internal error</td>
<td>--</td>
<td></td>
</tr>
<tr>
<td>CH-ERR3</td>
<td>Red</td>
<td>--</td>
<td>Internal error</td>
<td>--</td>
<td></td>
</tr>
<tr>
<td>CH-ERR4</td>
<td>Red</td>
<td>--</td>
<td>Internal error</td>
<td>--</td>
<td></td>
</tr>
</tbody>
</table>

¹) Indication LED is ON even if an input signal is applied to the channel and the supply voltage is off. In this case the module is not operating and does not generate an input signal.

²) All of the LEDs CH-ERR1 to CH-ERR4 light up together

### Technical data

#### Technical data of the module

The system data of AC500 and S500 are applicable to the standard version "Chapter 5.1.2 "System data AC500" on page 166.

The system data of AC500-XC are applicable to the XC version "Chapter 5.1.3 "System data AC500-XC" on page 169.

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.
### Parameter Value

**Process supply voltage UP**

| Connections | Terminals 1.8, 2.8, 3.8 and 4.8 for +24 V (UP) as well as 1.9, 2.9, 3.9 and 4.9 for 0 V (ZP) |
| Rated value | 24 V DC |
| Max. ripple | 5 % |
| Protection against reversed voltage | Yes |
| Rated protection fuse on UP | 10 A fast |
| Galvanic isolation | Yes, per module |

**Current consumption**

| From 24 V DC power supply at the terminals UP/L+ and ZP/M of the CPU/communication interface module | Ca. 2 mA |
| From UP at normal operation / with outputs | 0.15 A + max. 0.5 A per output |
| Inrush current from UP (at power up) | 0.007 A²s |
| Max. power dissipation within the module | 6 W (outputs unloaded) |
| Weight (without terminal unit) | ca. 125 g |
| Mounting position | Horizontal |
| | Or vertical with derating (output load reduced to 50 % at +40 °C per group) |
| Cooling | The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet. |

**NOTICE!**

All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

**Multiple overloads**

No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an internal smart high-side switch.

### Technical data of the digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>16</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 16 channels</td>
</tr>
<tr>
<td>Terminals of the channels I0 ... I7</td>
<td>1.0 ... 1.7</td>
</tr>
<tr>
<td>Terminals of the channels I8 ... I15</td>
<td>2.0 ... 2.7</td>
</tr>
<tr>
<td>Reference potential for all inputs</td>
<td>Terminals 1.9, 2.8, 3.8 and 4.9 (negative pole of the process supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>From the rest of the module (I/O bus)</td>
</tr>
</tbody>
</table>
### Parameter Value

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel, the LED is ON when the input signal is high (signal 1)</td>
</tr>
<tr>
<td>Monitoring point of input indicator</td>
<td>LED is part of the input circuitry</td>
</tr>
<tr>
<td>Input type acc. to EN 61131-2</td>
<td>Type 1</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 8 ms, configurable from 0.1 to 32 ms</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-3 V ... +5 V</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>&gt; +5 V ... &lt; +15 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>+15 V ... +30 V</td>
</tr>
<tr>
<td>Ripple with signal 0</td>
<td>Within -3 V ... +5 V</td>
</tr>
<tr>
<td>Ripple with signal 1</td>
<td>Within +15 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 5 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>&gt; 1 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>&gt; 5 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 8 mA</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

### Technical data of the configurable digital inputs/outputs

Each of the configurable I/O channels is defined as input or output by the user program. This is done by interrogating or allocating the corresponding channel.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>16 inputs/outputs (with transistors)</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 16 channels</td>
</tr>
<tr>
<td>If the channels are used as inputs</td>
<td>Channels I16 ... I23 Terminals 3.0 ... 3.7</td>
</tr>
<tr>
<td>If the channels are used as outputs</td>
<td>Channels I24 ... I31 Terminals 4.0 ... 4.7</td>
</tr>
<tr>
<td>Indication of the input/output signals</td>
<td>1 yellow LED per channel, the LED is ON when the input/output signal is high (signal 1)</td>
</tr>
<tr>
<td>Monitoring point of input/output indicator</td>
<td>LED is part of the input circuitry</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>From the rest of the module</td>
</tr>
</tbody>
</table>
### Technical data of the digital inputs/outputs if used as inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>Max. 16 digital inputs</td>
</tr>
<tr>
<td>Reference potential for all inputs</td>
<td>Terminals 1.9, 2.9, 3.9 and 4.9 (negative pole of the process supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Input current, per channel</td>
<td>See 'Technical Data of the Digital Inputs' in Chapter 5.2.4.3.9.2 “Technical data of the digital inputs” on page 548</td>
</tr>
<tr>
<td>Input type acc. to EN 61131-2</td>
<td>Type 1</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 8 ms, configurable from 0.1 to 32 ms</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-3 V ... +5 V *)</td>
</tr>
<tr>
<td>undefined signal</td>
<td>&gt; +5 V ... &lt; +15 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>+15 V ... +30 V</td>
</tr>
<tr>
<td>Ripple with signal 0</td>
<td>Within -3 V ... +5 V *)</td>
</tr>
<tr>
<td>Ripple with signal 1</td>
<td>Within +15 V ... +30 V</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

*) Due to the direct connection to the output, the demagnetizing varistor is also effective at the input (see figure) above. This is why the difference between UPx and the input signal must not exceed the clamp voltage of the varistor. The varistor limits the clamp voltage to approx. 36 V. Consequently, the input voltage must range from -12 V ... +30 V when UPx = 24 V and from -6 V ... +30 V when UPx = 30 V.

### Technical data of the digital inputs/outputs if used as outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>Max. 16 transistor outputs</td>
</tr>
<tr>
<td>Reference potential for all outputs</td>
<td>Terminals 1.9, 2.9, 3.9 and 4.9 (negative pole of the process supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>For all outputs: terminals 1.8, 2.8, 3.8 and 4.8 (positive pole of the process supply voltage, signal name UP)</td>
</tr>
<tr>
<td>Output voltage for signal 1</td>
<td>UP (-0.8 V)</td>
</tr>
<tr>
<td>Output delay (0-&gt;1 or 1-&gt;0)</td>
<td>On request</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated value, per channel</td>
<td>500 mA at UP = 24 V</td>
</tr>
<tr>
<td>Maximum value (all channels together)</td>
<td>8 A</td>
</tr>
<tr>
<td>Leakage current with signal 0</td>
<td>&lt; 0.5 mA</td>
</tr>
<tr>
<td>Rated protection fuse on UP</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Demagnetization when inductive loads are switched off</td>
<td>With varistors integrated in the module (see figure below)</td>
</tr>
<tr>
<td>Switching frequency</td>
<td></td>
</tr>
<tr>
<td>With resistive load</td>
<td>On request</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>With inductive loads</td>
<td>Max. 0.5 Hz</td>
</tr>
<tr>
<td>With lamp loads</td>
<td>Max. 11 Hz with max. 5 W</td>
</tr>
<tr>
<td>Short-circuit-proof / overload-proof</td>
<td>Yes</td>
</tr>
<tr>
<td>Overload message (I &gt; 0.7 A)</td>
<td>Yes, after ca. 100 ms</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>Yes, automatic reactivation</td>
</tr>
<tr>
<td></td>
<td>after short circuit/overload</td>
</tr>
<tr>
<td>Resistance to feedback against 24 V</td>
<td>signals Yes</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

The following drawing shows the circuitry of a digital input/output with the varistors for demagnetization when inductive loads are switched off.

![Digital input/output (circuit diagram)](image)

**Fig. 76: Digital input/output (circuit diagram)**

1. UPx (+ 24 V)
2. Digital input/output
3. ZPx (0 V)
4. For demagnetization when inductive loads are switched off

**Technical data of the fast counter**

The fast counter of the module does not work if the module is connected to a

- FBP interface module
- CS31 bus module
- CANopen communication interface module

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Used inputs</td>
<td>C24 / C25</td>
</tr>
<tr>
<td>Used outputs</td>
<td>C26</td>
</tr>
<tr>
<td>Counting frequency</td>
<td>Max. 50 kHz</td>
</tr>
</tbody>
</table>
**Dimensions**

The dimensions are in mm and in brackets in inch.

**Ordering data**

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 240 100 R0001</td>
<td>DC532, digital input/output module, 16 DI, 16 DC, 24 V DC / 0.5 A, 1-wire</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 440 100 R0001</td>
<td>DC532-XC, digital input/output module, 16 DI, 16 DC, 24 V DC / 0.5 A, 1-wire, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
DI524 - Digital input module

Features

- 32 digital inputs 24 V DC in 4 groups (1.0 ... 1.7, 2.0 ... 2.7, 3.0 ... 3.7 and 4.0 ... 4.7)
- Fast counter
- Module-wise galvanically isolated
- XC version for use in extreme ambient conditions available

Intended purpose

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g. CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.
The configuration is performed by software. The modules are supplied with a process supply voltage of 24 V DC.

All available inputs/outputs are galvanically isolated from all other circuitry of the module. There is no potential separation between the channels within the same group.

For use in extreme ambient conditions (e.g. wider temperature and humidity range), a special XC version of the device is available.

### Functionality

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast counter</td>
<td>Integrated, many configurable operating modes (only with AC500)</td>
</tr>
<tr>
<td>LED displays</td>
<td>For signal states, errors and supply voltage</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>External power supply</td>
<td>Via the terminals ZP and UP (process voltage 24 V DC)</td>
</tr>
<tr>
<td>Required terminal units</td>
<td>TU515 or TU516 [Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938]</td>
</tr>
<tr>
<td>Effect of incorrect input terminal connection</td>
<td>Wrong or no signal detected, no damage up to 35 V</td>
</tr>
</tbody>
</table>

The device is plugged on a terminal unit [Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938]. Position the module properly and press until it locks in place. The terminal unit is either mounted on a DIN rail or to the wall using 2 screws plus the additional accessory for wall mounting [Chapter 5.2.8.2.5 “TA526 - Wall mounting accessory” on page 1324].

### Connections

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The connection of the I/O channels is carried out using the 40 terminals of the I/O terminal unit. I/O modules can be replaced without re-wiring the terminal units.

The terminals 1.8 ... 4.8 and 1.9 ... 4.9 are electrically interconnected within the I/O terminal unit and have always the same assignment, irrespective of the inserted module:

- Terminals 1.8 ... 4.8: process voltage UP = +24 V DC
- Terminals 1.9 ... 4.9: process voltage ZP = 0 V DC

**Table 136: Assignment of the other terminals:**

<table>
<thead>
<tr>
<th>Terminals</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0 ... 1.7</td>
<td>I0 ... I7</td>
<td>8 digital inputs</td>
</tr>
<tr>
<td>2.0 ... 2.7</td>
<td>I8 ... I15</td>
<td>8 digital inputs</td>
</tr>
<tr>
<td>3.0 ... 3.7</td>
<td>I16 ... I23</td>
<td>8 digital inputs</td>
</tr>
<tr>
<td>4.0 ... 4.7</td>
<td>I24 ... I31</td>
<td>8 digital inputs</td>
</tr>
</tbody>
</table>
The internal power supply voltage for the module's circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 2 mA per DI524.

The external power supply connection is carried out via the UP (+24 V DC) and the ZP (0 V DC) terminals.

**WARNING!**

**Removal/Insertion under power**

Removal or insertion under power is permissible only if all conditions for hot swapping are fulfilled.

☞ Chapter 4.9.3 "Replace an I/O module with hot swap" on page 153

The devices are not designed for removal or insertion under power when the conditions for hot swap do not apply. Because of unforeseeable consequences, it is not allowed to plug in or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you

- connect or disconnect any signal or terminal block
- remove, mount or replace a module.

Disconnecting any powered devices while they are energized in a hazardous location could result in an electric arc, which could create an ignition source resulting in fire or explosion.

Prior to proceeding, make sure that power has been disconnected and that the area has been thoroughly checked to ensure that flammable materials are not present.

The devices must not be opened when in operation. The same applies to the network interfaces.

**NOTICE!**

**Risk of damaging the PLC modules!**

- Overvoltages and short circuits might damage the PLC modules.
  - Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
  - Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.
1 I/O bus
2 Control cabinet earth

**CAUTION!**
The process supply voltage must be included in the grounding concept (e.g., grounding of the negative terminal).

The module provides several diagnosis functions.

**Internal data exchange**

<table>
<thead>
<tr>
<th></th>
<th>Without the fast counter</th>
<th>With the fast counter (only with AC500)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital inputs</td>
<td>4</td>
<td>6</td>
</tr>
<tr>
<td>Digital outputs</td>
<td>0</td>
<td>2</td>
</tr>
</tbody>
</table>
Without the fast counter | With the fast counter (only with AC500)
---|---
Counter input data (words) | 0 | 4
Counter output data (words) | 0 | 8

### I/O configuration

The module itself does not store configuration data. It receives its parameterization data from the master device of the I/O bus (CPU or communication interface module) during power-up of the system.

Hence, replacing I/O modules is possible without any re-parameterization via software.

>If the external power supply voltage via UP/ZP terminals fails, the I/O module loses its configuration data. The whole station has to be switched off and on again to re-configure the module.

### Parameterization

<table>
<thead>
<tr>
<th>Firmware version</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firmware version &gt; V2.0.0</td>
<td>The arrangement of the parameter data is performed by Control Builder Plus/ Automation Builder software.</td>
</tr>
</tbody>
</table>

The parameter data directly influences the functionality of modules.

For non-standard applications, it is necessary to adapt the parameters to your system configuration.

Module: Module slot address: Y = 1 ... 10

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot/Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Module ID</td>
<td>Internal</td>
<td>1000</td>
<td>1)</td>
<td>Word</td>
<td>10000x3E8</td>
<td>0</td>
<td>65535</td>
</tr>
<tr>
<td>2</td>
<td>Ignore module</td>
<td>No</td>
<td>Yes</td>
<td>0</td>
<td>1</td>
<td>Byte</td>
<td>No</td>
<td>0x00</td>
</tr>
<tr>
<td>3</td>
<td>Parameter length</td>
<td>Internal</td>
<td>3-CPU 2-FBP</td>
<td>Byte</td>
<td>3 2</td>
<td>0</td>
<td>255</td>
<td>0x0Y02</td>
</tr>
<tr>
<td>4</td>
<td>Check supply</td>
<td>Off</td>
<td>On</td>
<td>0</td>
<td>1</td>
<td>Byte</td>
<td>On</td>
<td>0x01</td>
</tr>
<tr>
<td>No.</td>
<td>Name</td>
<td>Value</td>
<td>Internal value</td>
<td>Internal value, type</td>
<td>Default</td>
<td>Min.</td>
<td>Max.</td>
<td>EDS Slot/Index</td>
</tr>
<tr>
<td>-----</td>
<td>------------------</td>
<td>------------------------</td>
<td>----------------</td>
<td>---------------------</td>
<td>---------</td>
<td>------</td>
<td>-----</td>
<td>----------------</td>
</tr>
<tr>
<td>5</td>
<td>Input delay</td>
<td>0.1 ms</td>
<td>0</td>
<td>Byte</td>
<td>8 ms</td>
<td>0</td>
<td>3</td>
<td>0x0Y04</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 ms</td>
<td>1</td>
<td></td>
<td>0x02</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>8 ms</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>32 ms</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Fast counter 4)</td>
<td>0</td>
<td>0</td>
<td>Byte</td>
<td>Mode 0</td>
<td>0</td>
<td></td>
<td>Not for FBP</td>
</tr>
<tr>
<td></td>
<td></td>
<td>10</td>
<td>0</td>
<td></td>
<td>0x00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>3)</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Remarks:

1) With CS31 and addresses smaller than 70 and FBP, the value is increased by 1
2) Not with FBP
3) For a description of the counter operating modes, please refer to the ‘Fast Counter’ section in Chapter 5.2.4.3.2.9 “Fast counter” on page 606
4) With FBP or CS31 without the parameter Fast counter

GSD file:

```
Ext_User_Prm_Data_Len = 5
Ext_User_Prm_Data_Const(0) = 0x03, 0xe9, 0x02, 0x01, 0x02;
```

State LEDs

During the power ON procedure, the module initializes automatically. All LEDs (except the channel LEDs) are ON during this time.

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
<th>LED flashes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inputs I0 ... I31</td>
<td>Digital input</td>
<td>Yellow</td>
<td>Input = OFF</td>
<td>Input = ON 1)</td>
<td>--</td>
</tr>
<tr>
<td>UP</td>
<td>Process supply voltage 24 V DC via terminal</td>
<td>Green</td>
<td>Process supply voltage is missing</td>
<td>Process supply voltage OK</td>
<td>--</td>
</tr>
</tbody>
</table>
### Technical data

#### Technical data of the module

The system data of AC500 and S500 are applicable to the standard version $\copyright$ Chapter 5.1.2 “System data AC500” on page 166.

The system data of AC500-XC are applicable to the XC version $\copyright$ Chapter 5.1.3 “System data AC500-XC” on page 169.

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltage UP</td>
<td></td>
</tr>
<tr>
<td>Connections</td>
<td>Terminals 1.8, 2.8, 3.8 and 4.8 for +24 V (UP) as well as 1.9, 2.9, 3.9 and 4.9 for 0 V (ZP)</td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5 %</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse for UP</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per module</td>
</tr>
<tr>
<td>Current consumption</td>
<td></td>
</tr>
<tr>
<td>From 24 V DC power supply at the</td>
<td>ca. 2 mA</td>
</tr>
<tr>
<td>terminals UP/L± and ZP/M of the</td>
<td></td>
</tr>
<tr>
<td>communication interface module</td>
<td></td>
</tr>
<tr>
<td>From UP at normal operation</td>
<td>0.15 A</td>
</tr>
<tr>
<td>Inrush current from UP (at power up)</td>
<td>0.008 A/s</td>
</tr>
<tr>
<td>Weight (without terminal unit)</td>
<td>ca. 105 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical with derating (output load reduced to 50 % at +40 °C per group)</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
<th>LED flashes</th>
</tr>
</thead>
<tbody>
<tr>
<td>CH-ERR1</td>
<td>Channel error, error messages in groups (digital inputs combined into the groups 1, 2, 3, 4)</td>
<td>Red</td>
<td>No error or process supply voltage is missing</td>
<td>Severe error within the corresponding group</td>
<td>Error on one channel of the corresponding group</td>
</tr>
<tr>
<td>CH-ERR2</td>
<td>Red</td>
<td>--</td>
<td>Internal error</td>
<td>--</td>
<td></td>
</tr>
<tr>
<td>CH-ERR3</td>
<td>Red</td>
<td>--</td>
<td>Internal error</td>
<td>--</td>
<td></td>
</tr>
<tr>
<td>CH-ERR4</td>
<td>Red</td>
<td>--</td>
<td>Internal error</td>
<td>--</td>
<td></td>
</tr>
</tbody>
</table>

1) Indication LED is ON even if an input signal is applied to the channel and the supply voltage is off. In this case the module is not operating and does not generate an input signal.

2) All of the LEDs CH-ERR1 to CH-ERR4 light up together.
NOTICE!
All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

Technical data of the digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>32</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 32 channels</td>
</tr>
<tr>
<td>Terminals of the channels I0 ... I7</td>
<td>1.0 ... 1.7</td>
</tr>
<tr>
<td>Terminals of the channels I8 ... I15</td>
<td>2.0 ... 2.7</td>
</tr>
<tr>
<td>Terminals of the channels I16 ... I23</td>
<td>3.0 ... 3.7</td>
</tr>
<tr>
<td>Terminals of the channels I24 ... I31</td>
<td>4.0 ... 4.7</td>
</tr>
<tr>
<td>Reference potential for all inputs</td>
<td>Terminals 1.9, 2.9, 3.9 and 4.9 (negative pole of the process supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>From the rest of the module (I/O bus)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>One yellow LED per channel, the LED is ON when the input signal is high (signal 1)</td>
</tr>
<tr>
<td>Monitoring point of input indicator</td>
<td>LED is part of the input circuitry</td>
</tr>
<tr>
<td>Input type acc. to EN 61131-2</td>
<td>Type 1</td>
</tr>
<tr>
<td>Input delay (0 -&gt; 1 or 1 -&gt; 0)</td>
<td>Typ. 8 ms, configurable from 0.1 ... 32 ms</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-3 V ... +5 V</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>&gt; +5 V ... &lt; +15 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>+15 V ... +30 V</td>
</tr>
<tr>
<td>Ripple with signal 0</td>
<td>Within -3 V ... +5 V</td>
</tr>
<tr>
<td>Ripple with signal 1</td>
<td>Within +15 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 5 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>&gt; 1 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>&gt; 5 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 8 mA</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>
Technical data of the fast counter

The fast counter of the module does not work if the module is connected to a

- FBP interface module
- CS31 bus module
- CANopen communication interface module

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Used inputs</td>
<td>I24 / I25</td>
</tr>
<tr>
<td>Used outputs</td>
<td>None</td>
</tr>
<tr>
<td>Counting frequency</td>
<td>Max. 50 kHz</td>
</tr>
</tbody>
</table>

*Chapter 6.8.2.12 “Fast counters in AC500 devices” on page 4536*

Dimensions

The dimensions are in mm and in brackets in inch.
Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 240 000 R0001</td>
<td>DI524, digital input module, 32 DI, 24 V DC, 1-wire</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 440 000 R0001</td>
<td>DI524-XC, digital input module, 32 DI, 24 V DC, 1-wire, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

DO524 - Digital output module

Features

- 32 digital outputs 24 V DC / 0.5 A in 4 groups (1.0 ... 4.7) with short circuit and overload protection
- Module-wise galvanically isolated
- XC version for use in extreme ambient conditions available
<table>
<thead>
<tr>
<th></th>
<th>I/O bus</th>
<th>Allocation between terminal number and signal name</th>
<th>32 yellow LEDs to display the signal states at the digital outputs (O0 ... O31)</th>
<th>1 green LED to display the state of the process supply voltage UP</th>
<th>4 red LEDs to display errors</th>
<th>Label</th>
<th>Terminal unit</th>
<th>DIN rail</th>
<th>Sign for XC version</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>I/O bus</td>
<td>Allocation between terminal number and signal name</td>
<td>32 yellow LEDs to display the signal states at the digital outputs (O0 ... O31)</td>
<td>1 green LED to display the state of the process supply voltage UP</td>
<td>4 red LEDs to display errors</td>
<td>Label</td>
<td>Terminal unit</td>
<td>DIN rail</td>
<td>Sign for XC version</td>
</tr>
</tbody>
</table>

**Intended purpose**

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g., CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.

The outputs are galvanically isolated from all other circuitry of the module. There is no potential separation between the channels.
### Functionality

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED displays</td>
<td>For signal states, errors and supply voltage</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>External power supply</td>
<td>Via the terminals ZP and UP (process voltage 24 V DC)</td>
</tr>
<tr>
<td>Required terminal unit</td>
<td>TU515 or TU516 [Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938]</td>
</tr>
</tbody>
</table>

The device is plugged on a terminal unit [Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938]. Position the module properly and press until it locks in place. The terminal unit is either mounted on a DIN rail or to the wall using 2 screws plus the additional accessory for wall mounting [Chapter 5.2.8.2.5 “TA526 - Wall mounting accessory” on page 1324].

#### Multiple overloads

No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an internal smart high-side switch.

### Connections

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The connection of the I/O channels is carried out using the 40 terminals of the I/O terminal unit. I/O modules can be replaced without re-wiring the terminal units. The terminals 1.8 ... 4.8 and 1.9 ... 4.9 are electrically interconnected within the I/O terminal unit and have always the same assignment, independent of the inserted module:

- Terminals 1.8 ... 4.8: process voltage UP = +24 V DC
- Terminals 1.9 ... 4.9: process voltage ZP = 0 V DC

The assignment of the other terminals:

<table>
<thead>
<tr>
<th>Terminals</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0 ... 1.7</td>
<td>O0 ... O7</td>
<td>8 digital outputs</td>
</tr>
<tr>
<td>2.0 ... 2.7</td>
<td>O8 ... O15</td>
<td>8 digital outputs</td>
</tr>
<tr>
<td>3.0 ... 3.7</td>
<td>O16 ... O23</td>
<td>8 digital outputs</td>
</tr>
<tr>
<td>4.0 ... 4.7</td>
<td>O24 ... O31</td>
<td>8 digital outputs</td>
</tr>
</tbody>
</table>

The internal power supply voltage for the module’s circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 2 mA per DO524. The external power supply connection is carried out via the UP (+24 V DC) and the ZP (0 V DC) terminals.
**WARNING!**

Removal/Insertion under power

Removal or insertion under power is permissible only if all conditions for hot swapping are fulfilled.

> Chapter 4.9.3 “Replace an I/O module with hot swap” on page 153

The devices are not designed for removal or insertion under power when the conditions for hot swap do not apply. Because of unforeseeable consequences, it is not allowed to plug in or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you

- connect or disconnect any signal or terminal block
- remove, mount or replace a module.

Disconnecting any powered devices while they are energized in a hazardous location could result in an electric arc, which could create an ignition source resulting in fire or explosion.

Prior to proceeding, make sure that power is been disconnected and that the area has been thoroughly checked to ensure that flammable materials are not present.

The devices must not be opened when in operation. The same applies to the network interfaces.

---

**NOTICE!**

Risk of damaging the PLC modules!

Overvoltages and short circuits might damage the PLC modules.

- Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
- Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

---

**Fig. 77: Internal construction of the digital outputs**

The module provides several diagnosis functions.
Internal data exchange

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital inputs (bytes)</td>
<td>0</td>
</tr>
<tr>
<td>Digital outputs (bytes)</td>
<td>4</td>
</tr>
</tbody>
</table>

I/O configuration

The module itself does not store configuration data. It receives its parameterization data from the master device of the I/O bus (CPU or communication interface module) during power-up of the system.

Hence, replacing I/O modules is possible without any re-parameterization via software.

If the external power supply voltage via UP/ZP terminals fails, the I/O module loses its configuration data. The whole station has to be switched off and on again to re-configure the module.

Parameterization

<table>
<thead>
<tr>
<th>Firmware version</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firmware version &gt; V2.0.0</td>
<td>The arrangement of the parameter data is performed by Control Builder Plus/ Automation Builder software.</td>
</tr>
</tbody>
</table>

The parameter data directly influences the functionality of modules.

For non-standard applications, it is necessary to adapt the parameters to your system configuration.

Module: Module slot address: Y = 1 ... 10

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>Max.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Internal 1101</td>
<td>WORD</td>
<td>1101 0x044D</td>
<td>0</td>
<td>65535</td>
<td>0x0Y01</td>
<td></td>
</tr>
<tr>
<td>Ignore module 2)</td>
<td>No</td>
<td>0</td>
<td>BYTE</td>
<td>No 0x00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal 7</td>
<td>BYTE</td>
<td>7-CPU 7-FBP</td>
<td>0</td>
<td>255</td>
<td>0x0Y02</td>
<td></td>
</tr>
<tr>
<td>Check supply on/off</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>On 0x01</td>
<td>1</td>
<td>0x0Y03</td>
<td></td>
</tr>
<tr>
<td>Output short circuit detection</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>On 0x01</td>
<td>1</td>
<td>0x0Y04</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Value</td>
<td>Internal</td>
<td>Internal</td>
<td>Default</td>
<td>Min.</td>
<td>Max.</td>
<td>Max.</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------</td>
<td>-----------</td>
<td>-------------</td>
<td>---------</td>
<td>------</td>
<td>------</td>
<td>------</td>
</tr>
<tr>
<td>Behaviour of outputs at communciation</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>Off</td>
<td>0</td>
<td>2</td>
<td>0x0Y05</td>
</tr>
<tr>
<td>errors</td>
<td>Last value</td>
<td>1+(n*5)</td>
<td></td>
<td>0x00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Substitute value</td>
<td>0 ...</td>
<td>2+(n*5),</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bit 31 = Output 31</td>
<td>42949672</td>
<td>n ≤ 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bit 0 = Output 0</td>
<td>95</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1) With CS31 and addresses smaller than 70 and FBP, the value is increased by 1
2) Not with FBP

GSD file:

```
Ext_User_Prm_Data_Len =
Ext_User_Prm_Data_Const(0) = 10
0x04, 0x4d, 0x07, 
0x01, 0x01, 0x00, 0x00, 0x00, 0x00;
```

State LEDs

During the power ON procedure, the module initializes automatically. All LEDs (except the channel LEDs) are ON during this time.

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
<th>LED flashes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outputs O0 ... O31</td>
<td>Digital output</td>
<td>Yellow</td>
<td>Output = OFF</td>
<td>Output = ON</td>
<td>--</td>
</tr>
<tr>
<td>UP</td>
<td>Process supply voltage 24 V DC via terminal</td>
<td>Green</td>
<td>Process supply voltage is missing</td>
<td>Process supply voltage OK</td>
<td>--</td>
</tr>
<tr>
<td>CH-ERR1</td>
<td>Channel error, error messages in groups (digital outputs combined into the groups 1, 2, 3, 4)</td>
<td>Red</td>
<td>No error or process supply voltage is missing</td>
<td>Severe error within the corresponding group</td>
<td>Error on one channel of the corresponding group (e.g. short circuit at an output)</td>
</tr>
<tr>
<td>CH-ERR2</td>
<td></td>
<td>Red</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CH-ERR3</td>
<td></td>
<td>Red</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CH-ERR4</td>
<td></td>
<td>Red</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CH-ERR *)</td>
<td>Module error</td>
<td>Red</td>
<td>--</td>
<td>Internal error</td>
<td>--</td>
</tr>
</tbody>
</table>

*) All of the LEDs CH-ERR1 to CH-ERR4 light up together
Technical data

Technical data of the module

The system data of AC500 and S500 are applicable to the standard version “Chapter 5.1.2 “System data AC500” on page 166.

The system data of AC500-XC are applicable to the XC version “Chapter 5.1.3 “System data AC500-XC” on page 169.

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltage UP</td>
<td></td>
</tr>
<tr>
<td>Connections</td>
<td>Terminals 1.8, 2.8, 3.8 and 4.8 for +24 V (UP) as well as 1.9, 2.9, 3.9 and 4.9 for 0 V (ZP)</td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5 %</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse on UP</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per module</td>
</tr>
<tr>
<td>Current consumption</td>
<td></td>
</tr>
<tr>
<td>From 24 V DC power supply at the terminals UP/L+ and ZP/M of the CPU/communication interface module</td>
<td>Ca. 2 mA</td>
</tr>
<tr>
<td>From UP at normal operation / with outputs</td>
<td>0.10 A + max. 0.5 A per output</td>
</tr>
<tr>
<td>Inrush current from UP (at power up)</td>
<td>0.005 A²s</td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>6 W (outputs unloaded)</td>
</tr>
<tr>
<td>Weight (without terminal unit)</td>
<td>Ca. 100 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal</td>
</tr>
<tr>
<td></td>
<td>Or vertical with derating (output load reduced to 50 % at +40 °C per group)</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>

NOTICE!

All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

Multiple overloads

No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an internal smart high-side switch.
## Technical data of the digital outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>32 outputs (with transistors)</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 32 channels</td>
</tr>
<tr>
<td>Connection of the channels</td>
<td></td>
</tr>
<tr>
<td>O0 ... O7</td>
<td>Terminals 1.0 ... 1.7</td>
</tr>
<tr>
<td>O8 ... O15</td>
<td>Terminals 2.0 ... 2.7</td>
</tr>
<tr>
<td>O16 ... O23</td>
<td>Terminals 3.0 ... 3.7</td>
</tr>
<tr>
<td>O24 ... O31</td>
<td>Terminals 4.0 ... 4.7</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>1 yellow LED per channel, the LED is ON if the output signal is high (signal 1)</td>
</tr>
<tr>
<td>Reference potential for all outputs</td>
<td>Terminals 1.9, 2.9, 3.9 and 4.9 (negative pole of the process supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>For all outputs: terminals 1.8, 2.8, 3.8 and 4.8 (positive pole of the process supply voltage, signal name UP)</td>
</tr>
<tr>
<td>Output voltage for signal 1</td>
<td>UP (-0.8 V)</td>
</tr>
<tr>
<td>Output delay (0 -&gt; 1 or 1 -&gt; 0)</td>
<td>On request</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated value, per channel</td>
<td>500 mA at UP = 24 V</td>
</tr>
<tr>
<td>Maximum value (channels O0 ... O15)</td>
<td>4 A</td>
</tr>
<tr>
<td>Maximum value (channels O16 ... O31)</td>
<td>4 A</td>
</tr>
<tr>
<td>Maximum value (all channels together)</td>
<td>8 A</td>
</tr>
<tr>
<td>Max. leakage current with signal 0</td>
<td>&lt; 0.5 mA</td>
</tr>
<tr>
<td>Rated protection fuse on UP</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Demagnetization when inductive loads are</td>
<td>With varistors integrated in the module (see figure below)</td>
</tr>
<tr>
<td>switched off</td>
<td></td>
</tr>
<tr>
<td>Switching frequency</td>
<td></td>
</tr>
<tr>
<td>With resistive load</td>
<td>On request</td>
</tr>
<tr>
<td>With inductive loads</td>
<td>Max. 0.5 Hz</td>
</tr>
<tr>
<td>With lamp loads</td>
<td>Max. 11 Hz with max. 5 W</td>
</tr>
<tr>
<td>Short-circuit proof / overload proof</td>
<td>Yes</td>
</tr>
<tr>
<td>Overload message (I &gt; 0.7 A)</td>
<td>Yes, after ca. 100 ms</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>Yes, automatic reactivation after short-circuit/overload</td>
</tr>
<tr>
<td>Resistance to feedback against 24 V signals</td>
<td>Yes</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

The following drawing shows the circuitry of a digital output with the varistors for demagnetization when inductive loads are switched off.
UPx (+24 V)

Digital output

ZPx (0 V)

for demagnetization when inductive loads are switched off

Dimensions

1 Din rail 15 mm
2 Din rail 7.5 mm

The dimensions are in mm and in brackets in inch.
Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 240 700 R0001</td>
<td>DO524, digital output module, 32 DO, 24 V DC / 0.5 A, 1-wire</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 440 700 R0001</td>
<td>DO524-XC, digital output module, 32 DO, 24 V DC / 0.5 A, 1-wire, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

DO526 - Digital output module

Features

- 8 digital outputs 24 V DC (O0 ... O7) in 2 groups without short circuit and without overload protection.
- Module and group-wise galvanically isolated
- XC version for use in extreme ambient conditions available
1. I/O bus
2. Allocation between terminal number and signal name
3. 8 yellow LEDs to display the signal states of the outputs O0 ... O7
4. 3 green LEDs to display the states of the process supply voltage UP, UP3 and UP4
5. 2 red LEDs to display errors
6. Label
7. Terminal unit
8. DIN-rail
9. Sign for XC version

**Intended purpose**

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g., CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.

The outputs are group-wise galvanically isolated from each other.

All other circuitry of the module is galvanically isolated from the outputs.

Potential separation between the channel groups.
### Functionality

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED displays</td>
<td>For signal states, errors and supply voltages</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via I/O bus</td>
</tr>
<tr>
<td>External power supply</td>
<td>Via the terminals ZP, ZP3, ZP4, UP, UP3 and UP4 (process voltage 24 V DC)</td>
</tr>
<tr>
<td>Required terminal unit</td>
<td>TU542 ( \odot ) Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938</td>
</tr>
</tbody>
</table>

The output module is plugged on the terminal unit TU542. Properly position the module and press until it locks in place. The terminal unit is mounted on a DIN rail or with 2 screws plus the additional accessory for wall mounting \( \odot \) Chapter 5.2.8.2.5 “TA526 - Wall mounting accessory” on page 1324.

### Connections

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The connection of the I/O channels is carried out using the 40 terminals of the I/O terminal unit. I/O modules can be replaced without re-wiring the terminal units.

The terminals 1.8 ... 2.8 and 1.9 ... 2.9 are electrically interconnected within the I/O terminal unit and always have the same assignment, irrespective of the inserted module:

<table>
<thead>
<tr>
<th>Terminals 1.8 ... 2.8:</th>
<th>Process voltage UP = +24 V DC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminals 1.9 ... 2.9:</td>
<td>Process voltage ZP = 0 V</td>
</tr>
<tr>
<td>Terminal 3.8:</td>
<td>Process voltage UP3 = +24 V DC</td>
</tr>
<tr>
<td>Terminal 3.9:</td>
<td>Process voltage ZP3 = 0 V</td>
</tr>
<tr>
<td>Terminal 4.8:</td>
<td>Process voltage UP4 = +24 V DC</td>
</tr>
<tr>
<td>Terminal 4.9:</td>
<td>Process voltage ZP4 = 0 V</td>
</tr>
</tbody>
</table>

The connection of the I/O channels is carried out using the 40 terminals of the I/O terminal unit. I/O modules can be replaced without re-wiring the terminal units.

The terminals 1.8 ... 2.8 and 1.9 ... 2.9 are electrically interconnected within the I/O terminal unit and always have the same assignment, irrespective of the inserted module:

<table>
<thead>
<tr>
<th>Terminals 3.0, 3.1, 3.4, 3.5</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>O0 ... O3</td>
<td>4 digital outputs</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Terminals 4.0, 4.1, 4.4, 4.5</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>O4 ... O7</td>
<td>4 digital outputs</td>
</tr>
</tbody>
</table>

The internal power supply voltage for the module's circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 2 mA per DO526.

The external power supply connection is carried out via the UP, UP3, UP4 (+24 V DC) and the ZP, ZP3, ZP4 (0 V DC) terminals.
NOTICE!
Risk of damaging the PLC modules!
Overvoltages and short circuits might damage the PLC modules.
– Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
– Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

Fig. 78: Internal construction of the digital outputs
1 I/O bus
2 4.0 ... 4.7: Connected with UP (switch) -> Input;
   Connected with ZP (load) -> Output
3 Control cabinet earth

CAUTION!
The process supply voltage must be included in the grounding concept (e. g. grounding of the negative terminal).

The module provides several diagnosis functions.
Internal data exchange

<table>
<thead>
<tr>
<th>Digital inputs (bytes)</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital outputs (bytes)</td>
<td>1</td>
</tr>
</tbody>
</table>

I/O configuration

The module itself does not store configuration data. It receives its parameterization data from the master device of the I/O bus (CPU or communication interface module) during power-up of the system.

Hence, replacing I/O modules is possible without any re-parameterization via software.

If the external power supply voltage via UP/ZP terminals fails, the I/O module loses its configuration data. The whole station has to be switched off and on again to re-configure the module.

Parameterization

The arrangement of the parameter data is performed with Automation Builder software, versions \( \geq 1.2.3 \).

The parameter data directly influences the functionality of modules.

For non-standard applications, it is necessary to adapt the parameters to your system configuration.

Module: Module slot address: \( Y = 1 \ldots 7 \)

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>Max.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Internal 1105</td>
<td>WORD 1105 0x0451</td>
<td>0 65535 0x0Y01</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ignore module 2)</td>
<td>No Yes 0 1</td>
<td>BYTE No 0x00</td>
<td>not for FBP</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal 6</td>
<td>BYTE 6-CPU 6-FBP</td>
<td>0 6 0x0Y02</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Check supply</td>
<td>Off on 0 1</td>
<td>BYTE On 0x01 0 1 0x0Y03</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reserve</td>
<td>0 ... 255 0 ... 0xff</td>
<td>BYTE On 0x01 0 1 0x0Y04</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Behaviour of outputs at communication errors</td>
<td>Off 0 1+(n<em>5) 2+(n</em>5), ( n \leq 2 )</td>
<td>BYTE Off 0x00 0 2 0x0Y05</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Substitute value at outputs

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>Max.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Substitute value at outputs Bit 7 = Output 7 Bit 0 = Output 0</td>
<td>0...255</td>
<td>0 ... 0xff</td>
<td>BYTE</td>
<td>0x00</td>
<td>0</td>
<td>255</td>
<td>0x0Y06</td>
</tr>
<tr>
<td>Reserve</td>
<td>0 ... 255</td>
<td>0 ... 0xff</td>
<td>BYTE</td>
<td>0x00</td>
<td>0</td>
<td>255</td>
<td>0x0Y07</td>
</tr>
<tr>
<td>Reserve</td>
<td>0 ... 255</td>
<td>0 ... 0xff</td>
<td>BYTE</td>
<td>0x00</td>
<td>0</td>
<td>255</td>
<td>0x0Y08</td>
</tr>
</tbody>
</table>

1) With CS31 and addresses smaller than 70 and FBP, the value is increased by 1

2) Not with FBP

GSD file:

```plaintext
Ext_User_Prm_Data_Len = 10
Ext_User_Prm_Data_Const(0) = 0x04, 0x51, 0x00, 0x06, 0x01, 0x01, 0x00, 0x00, 0x00, 0x0Y06
```

### State LEDs

During the power ON procedure, the module initializes automatically. All LEDs (except the channel LEDs) are ON during this time.

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
<th>LED flashes</th>
</tr>
</thead>
<tbody>
<tr>
<td>UP</td>
<td>Outputs O0 ... O7</td>
<td>Digital output</td>
<td>Yellow</td>
<td>Output = OFF</td>
<td>Output = ON 2)</td>
</tr>
<tr>
<td>UP3</td>
<td>Process supply voltage 24 V DC via terminal</td>
<td>Green</td>
<td>Process supply voltage is missing</td>
<td>Process supply voltage OK</td>
<td>--</td>
</tr>
<tr>
<td>UP4</td>
<td>Process supply voltage outputs 4 ... 7 24 V DC via terminal</td>
<td>Green</td>
<td>Process supply voltage is missing</td>
<td>Process supply voltage OK</td>
<td>--</td>
</tr>
<tr>
<td>LED</td>
<td>State</td>
<td>Color</td>
<td>LED = OFF</td>
<td>LED = ON</td>
<td>LED flashes</td>
</tr>
<tr>
<td>---------</td>
<td>---------------------------------</td>
<td>-------</td>
<td>----------------------------</td>
<td>---------------------------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>CH-ERR3</td>
<td>Channel Error, error messages in</td>
<td>Red</td>
<td>No error or process supply</td>
<td>Severe error within the corresponding</td>
<td>Error on in the corresponding group</td>
</tr>
<tr>
<td>CH-ERR4</td>
<td>groups (digital outputs combined</td>
<td>Red</td>
<td>voltage is missing</td>
<td>group</td>
<td></td>
</tr>
<tr>
<td></td>
<td>into the groups 3, 4)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CH-ERR</td>
<td>Module Error</td>
<td>Red</td>
<td>--</td>
<td>Internal error</td>
<td>--</td>
</tr>
<tr>
<td>¹)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

¹) All of the LEDs CH-ERR3 to CH-ERR4 light up together
²) The state of the LEDs corresponds to the logic state of the output. In case of missing or low process supply voltage UP3 or UP4, the signal on the output terminal is off even though the LED is on.

**Technical data**

**Technical data of the module**

The system data of AC500 and S500 are applicable to the standard version "Chapter 5.1.2 "System data AC500" on page 166."

The system data of AC500-XC are applicable to the XC version "Chapter 5.1.3 "System data AC500-XC" on page 169."

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltage UP, UP3 and UP4</td>
<td></td>
</tr>
<tr>
<td>Connections</td>
<td>Terminals 1.8 and 2.8 for +24 V (UP) as well as 1.9 and 2.9 0 V (ZP)</td>
</tr>
<tr>
<td></td>
<td>Terminals 3.8 for +24 V (UP3) as well as 3.9 for 0 V (ZP3)</td>
</tr>
<tr>
<td></td>
<td>Terminals 4.8 for +24 V (UP4) as well as 4.9 for 0 V (ZP4)</td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5 %</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse on UP, UP3 and UP4</td>
<td>10 A fast (for each process supply voltage)</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per module and per output channel groups</td>
</tr>
<tr>
<td>Current consumption</td>
<td></td>
</tr>
<tr>
<td>From 24 V DC power supply at the terminals UP/L+ and ZP/M of the CPU/communication interface module</td>
<td>Ca. 2 mA</td>
</tr>
<tr>
<td>From UP at normal operation / with outputs</td>
<td>Ca. 20 mA + 1.5 mA per output</td>
</tr>
<tr>
<td>From UP3 or UP4 at normal operation / with outputs</td>
<td>Ca. 0.01 A + max. 2 A per output</td>
</tr>
<tr>
<td>Inrush current from UP (at power up)</td>
<td>0.015 A²s</td>
</tr>
</tbody>
</table>
### Parameter | Value
--- | ---
Inrush current from UP3 or UP4 (at power up) | 0.005 A²s (without output load)
Max. power dissipation within the module | 6 W
Weight (without terminal unit) | Ca. 135 g
Mounting position | Horizontal
Or vertical with derating (output load reduced to 50 % at +40 °C per group)
Cooling | The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.

**NOTICE!**  
**Attention:**  
All I/O channels (digital and analog) are protected against reverse polarity, reverse supply and continuous overvoltage up to 30 V DC.

---

**No effects of multiple overloads**  
No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an external fuse.

#### Technical data of the digital outputs

| Parameter | Value |
--- | --- |
Number of channels per module | 8 outputs (with transistors, non-latching type) |
Distribution of the channels into groups | 2 groups of 4 channels |
Connection of the channels | |
O0 ... O3 | Terminals 3.0, 3.1, 3.4, 3.5 |
O4 ... O7 | Terminals 4.0, 4.1, 4.4, 4.5 |
Indication of the output signals | 1 yellow LED per channel, the LED is ON if the output signal is high (signal 1) |
Power supply voltage for the module | Terminals 1.8 and 2.8 (positive pole of the process supply voltage, signal name UP) |
Reference potential for module power supply | Terminals 1.9 and 2.9 (negative pole of the process supply voltage, signal name ZP) |
Power supply voltage for the outputs O0 to O3 | Terminal 3.8 (positive pole of the process supply voltage, signal name UP3) |
Reference potential for the outputs O0 to O3 | Terminal 3.9 (negative pole of the process supply voltage, signal name ZP3) |
Power supply voltage for the outputs O4 to O7 | Terminal 4.8 (positive pole of the process supply voltage, signal name UP4) |
Reference potential for the outputs O4 to O7 | Terminal 4.9 (negative pole of the process supply voltage, signal name ZP4) |
Output voltage for signal 1 | UP (-0.4 V) |
Output delay (0->1 or 1->0) | On request |
Output current | |
Rated value, per channel | 2 A at UP3 or UP4 = 24 V |
### Parameter Value

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum value (channels O0 ... O3)</td>
<td>8 A</td>
</tr>
<tr>
<td>Maximum value (channels O4 ... O7)</td>
<td>8 A</td>
</tr>
<tr>
<td>Leakage current with signal 0</td>
<td>&lt; 0.1 mA</td>
</tr>
<tr>
<td>Rated protection fuse on UP</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Demagnetization when inductive loads are switched off</td>
<td>With clamp diode in output high side driver</td>
</tr>
<tr>
<td>Switching frequency</td>
<td></td>
</tr>
<tr>
<td>With resistive load</td>
<td>On request</td>
</tr>
<tr>
<td>With inductive loads</td>
<td>Max. 2 Hz</td>
</tr>
<tr>
<td>With lamp loads</td>
<td>Max. 11 Hz with max. 48 W</td>
</tr>
<tr>
<td>Short-circuit proof / overload proof</td>
<td>No (should be done externally)</td>
</tr>
<tr>
<td>Overload message</td>
<td>No</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>No (should be done externally)</td>
</tr>
<tr>
<td>Resistance to feedback against 24 V signals</td>
<td>Yes to UP3 or UP4. No to outputs in same group.</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

### Dimensions

1. Din rail 15 mm
2. Din rail 7.5 mm
Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 240 800 R0001</td>
<td>DO526, digital output module, 8 DO, 24 V DC / 2 A, 1-wire</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 440 800 R0001</td>
<td>DO526-XC, digital output module, 8 DO, 24 V DC / 2 A, 1-wire, XC version</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 213 200 R0001</td>
<td>TU542, I/O terminal unit, 24 V DC, spring terminals</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 413 200 R0001</td>
<td>TU542-XC, I/O terminal unit, 24 V DC, spring terminals, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

DX522 - Digital input/output module

Features

- 8 digital inputs 24 V DC, module-wise galvanically isolated
- 8 relay outputs
- Fast counter
- XC version for use in extreme ambient conditions available
1 I/O bus
2 Allocation between terminal number and signal name
3 8 yellow LEDs to display the signal states at the digital inputs (I0 ... I7)
4 8 yellow LEDs to display the signal states at the digital relay outputs (R0 ... R7)
5 1 green LED to display the state of the process supply voltage UP
6 2 red LEDs to display errors
7 Label
8 Terminal unit
9 DIN rail
\$\text{Sign for XC version}\$

**Intended purpose**

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g. CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.

Digital configurable input/output unit.
- 8 digital inputs 24 V DC in 1 group (1.0...1.7)
- 8 digital relay outputs with one change-over contact each (R0...R7). All output channels are galvanically isolated from each other.
- Fast counter
The configuration is performed by software. The modules are supplied with a process supply voltage of 24 V DC.

All available inputs/outputs are galvanically isolated from all other circuitry of the module. There is no potential separation between the channels within the same group.

For use in extreme ambient conditions (e.g. wider temperature and humidity range), a special XC version of the device is available.

Functionality

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast counter</td>
<td>Integrated, many configurable operating modes (only with AC500)</td>
</tr>
<tr>
<td>LED displays</td>
<td>For signal states, errors and supply voltage</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Through the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>External power supply</td>
<td>Via the terminals ZP and UP (process supply voltage 24 V DC)</td>
</tr>
<tr>
<td>Required terminal units</td>
<td>TU531 or TU532 © Chapter 5.2.5.3 “TU531 and TU532 for I/O modules” on page 945</td>
</tr>
</tbody>
</table>

The device is plugged on a terminal unit © Chapter 5.2.5.3 “TU531 and TU532 for I/O modules” on page 945. Position the module properly and press until it locks in place. The terminal unit is either mounted on a DIN rail or to the wall using 2 screws plus the additional accessory for wall mounting © Chapter 5.2.8.2.5 “TA526 - Wall mounting accessory” on page 1324.

Connections

**WARNING!**
Risk of death by electric shock!
Hazardous voltages can be present at the terminals of the module.

Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The connection of the I/O channels is carried out using the 40 terminals of the I/O terminal unit. I/O modules can be replaced without re-wiring the terminal units.

The terminals 1.8 ... 4.8 and 1.9 ... 4.9 are electrically interconnected within the I/O terminal unit and have always the same assignment, irrespective of the inserted module:

- Terminals 1.8 ... 4.8: process supply voltage UP = +24 V DC
- Terminals 1.9 ... 4.9: process supply voltage ZP = 0 V DC
Table 137: Assignment of the other terminals:

<table>
<thead>
<tr>
<th>Terminals</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0 ... 1.7</td>
<td>I0 ... I7</td>
<td>Input signals of the 8 digital inputs</td>
</tr>
<tr>
<td>1.8 ... 4.8</td>
<td>UP</td>
<td>Process supply voltage +24 V DC</td>
</tr>
<tr>
<td>1.9 ... 4.9</td>
<td>ZP</td>
<td>Reference potential for the 8 digital inputs and the process supply voltage</td>
</tr>
<tr>
<td>2.0</td>
<td>R0</td>
<td>Common contact of the first relay output</td>
</tr>
<tr>
<td>3.0</td>
<td>NO 0</td>
<td>Normally-open contact of the first relay output</td>
</tr>
<tr>
<td>4.0</td>
<td>NC 0</td>
<td>Normally-closed contact of the first relay output</td>
</tr>
<tr>
<td>2.1</td>
<td>R1</td>
<td>Common contact of the second relay output</td>
</tr>
<tr>
<td>3.1</td>
<td>NO 1</td>
<td>Normally-open contact of the second relay output</td>
</tr>
<tr>
<td>4.1</td>
<td>NC 1</td>
<td>Normally-closed contact of the second relay output</td>
</tr>
<tr>
<td>2.7</td>
<td>R7</td>
<td>Common contact of the eighth relay output</td>
</tr>
<tr>
<td>3.7</td>
<td>NO 7</td>
<td>Normally-open contact of the eighth relay output</td>
</tr>
<tr>
<td>4.7</td>
<td>NC 7</td>
<td>Normally-closed contact of the eighth relay output</td>
</tr>
</tbody>
</table>

The internal power supply voltage for the module's circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 2 mA per DX522.

The external power supply connection is carried out via the UP (+24 V DC) and the ZP (0 V DC) terminals.
WARNING!
Removal/Insertion under power
Removal or insertion under power is permissible only if all conditions for hot swapping are fulfilled.

Chapter 4.9.3 “Replace an I/O module with hot swap” on page 153

The devices are not designed for removal or insertion under power when the conditions for hot swap do not apply. Because of unforeseeable consequences, it is not allowed to plug in or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you
– connect or disconnect any signal or terminal block
– remove, mount or replace a module.

Disconnecting any powered devices while they are energized in a hazardous location could result in an electric arc, which could create an ignition source resulting in fire or explosion.

Prior to proceeding, make sure that power is been disconnected and that the area has been thoroughly checked to ensure that flammable materials are not present.

The devices must not be opened when in operation. The same applies to the network interfaces.

NOTICE!
Risk of damaging the PLC modules!

Overvoltages and short circuits might damage the PLC modules.

– Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
– Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

The module provides several diagnosis functions.
Fig. 79: Connection of the digital input/output module DX522

1  I/O bus
2  Control cabinet earth

**NOTICE!**
- If the relay outputs have to switch inductive **DC loads**, free-wheeling diodes must be circuited in parallel to these loads.
- If the relay outputs have to switch inductive **AC loads**, spark suppressors are required.

**CAUTION!**
The process supply voltage must be included in the grounding concept (e.g. grounding of the negative terminal).
NOTICE!
Risk of damaging the PLC module!
The following has to be considered when connecting input and output voltages to the module:

– All 230 V AC feeds must be single-phase from the same supply system.
– Connection of 2 or more relay contacts in series is possible; however, voltages above 230 V AC and 3-phase loads are not allowed.
– The 8 change-over contacts of the relays are galvanically isolated from channel to channel. This allows to connect loads of 24 V DC and 120/230 V AC to relay outputs of the same module. In such cases it is necessary that both supply voltages are grounded to prevent unsafe floating grounds.

NOTICE!
Risk of damaging the PLC module!
There is no internal short-circuit or overload protection for the relay outputs. Protect the relay contacts by back-up fuses of 6 A max. (characteristic gG/gL). Depending on the application, fuses can be used for single channels or module-wise.

**Internal data exchange**

<table>
<thead>
<tr>
<th></th>
<th>Without the fast counter</th>
<th>With the fast counter (only with AC500)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital inputs (bytes)</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td>Digital outputs (bytes)</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td>Counter input data (words)</td>
<td>0</td>
<td>4</td>
</tr>
<tr>
<td>Counter output data (words)</td>
<td>0</td>
<td>8</td>
</tr>
</tbody>
</table>

**I/O configuration**

The module itself does not store configuration data. It receives its parameterization data from the master device of the I/O bus (CPU or communication interface module) during power-up of the system.

Hence, replacing I/O modules is possible without any re-parameterization via software.

*If the external power supply voltage via UP/ZP terminals fails, the I/O module loses its configuration data. The whole station has to be switched off and on again to re-configure the module.*

**Parameterization**

<table>
<thead>
<tr>
<th>Firmware version</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firmware version &gt; V2.0.0</td>
<td>The arrangement of the parameter data is performed by Control Builder Plus/ Automation Builder software.</td>
</tr>
</tbody>
</table>
The parameter data directly influences the functionality of modules.
For non-standard applications, it is necessary to adapt the parameters to your system configuration.
Module: Module slot address: Y = 1 ... 10

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value, type</th>
<th>Default Value</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot/Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Internal</td>
<td>Word</td>
<td>1210 0x04BA</td>
<td>0</td>
<td>65535</td>
<td>0x0Y01</td>
</tr>
<tr>
<td>Ignore module</td>
<td>No Yes</td>
<td>Byte</td>
<td>No 0x00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal</td>
<td>Byte</td>
<td>5-CPU 4-FBP</td>
<td>0</td>
<td>255</td>
<td>0x0Y02</td>
</tr>
<tr>
<td>Check supply</td>
<td>Off On</td>
<td>Byte</td>
<td>On 0x01</td>
<td>0</td>
<td>1</td>
<td>0x0Y03</td>
</tr>
<tr>
<td>Input delay</td>
<td>0.1 ms 1 ms 8 ms 32 ms</td>
<td>Byte</td>
<td>8 ms 0x02</td>
<td>0</td>
<td>3</td>
<td>0x0Y04</td>
</tr>
<tr>
<td>Fast Counter</td>
<td>0 : 10</td>
<td>Byte</td>
<td>Mode 0 0x00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Behaviour of outputs at com-munica-tion errors</td>
<td>Off Last value Substitute value 0 1+(n<em>5) 2+(n</em>5), n ≤ 2</td>
<td>Byte</td>
<td>Off 0x00</td>
<td>0</td>
<td>2</td>
<td>0x0Y05</td>
</tr>
<tr>
<td>Substitute value at outputs)</td>
<td>0 ... 255</td>
<td>Byte</td>
<td>0 ... 0xff</td>
<td>0</td>
<td>255</td>
<td>0x0Y06</td>
</tr>
<tr>
<td>Bit 7 = Output 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bit 0 = Output 0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Remarks:

1) With CS31 and addresses smaller than 70 and FBP, the value is increased by 1
2) Not with FBP
3) For a description of the counter operating modes, please refer to the 'Fast Counter' section Chapter 5.2.4.3.2.9 "Fast counter" on page 606
4) With FBP and without the parameter Fast Counter
State LEDs

During the power ON procedure, the module initializes automatically. All LEDs (except the channel LEDs) are ON during this time.

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
<th>LED flashes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inputs</td>
<td>Digital input</td>
<td>Yellow</td>
<td>Input = OFF</td>
<td>Input = ON ¹)</td>
<td>--</td>
</tr>
<tr>
<td>I0 ... I7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Outputs</td>
<td>Digital output</td>
<td>Yellow</td>
<td>Relay output = OFF</td>
<td>Relay output = ON</td>
<td>--</td>
</tr>
<tr>
<td>R0 ... R7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(relays)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UP</td>
<td>Process supply voltage</td>
<td>Green</td>
<td>Process supply voltage is missing</td>
<td>Process supply voltage OK</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td>24 V DC via terminal</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CH-ERR1</td>
<td>Channel Error, error</td>
<td>Red</td>
<td>No error or process supply voltage is</td>
<td>Severe error within the corresponding group</td>
<td>Error on one channel of the corresponding group</td>
</tr>
<tr>
<td></td>
<td>messages in groups</td>
<td></td>
<td>missing</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>(digital inputs/outputs combined into the groups 1 and 2)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CH-ERR2</td>
<td>Module Error</td>
<td>Red</td>
<td>--</td>
<td>Internal error</td>
<td>--</td>
</tr>
</tbody>
</table>

¹) Indication LED is ON even if an input signal is applied to the channel and the supply voltage is off. In this case the module is not operating and does not generate an input signal.

²) All of the LEDs CH-ERR1 to CH-ERR2 light up together

Technical data

Technical data of the module

The system data of AC500 and S500 are applicable to the standard version "System data AC500" on page 166.

The system data of AC500-XC are applicable to the XC version "System data AC500-XC" on page 169.

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.
### Hardware descriptions

#### Device specifications > I/O modules

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltage UP</td>
<td></td>
</tr>
<tr>
<td>Connections</td>
<td>Terminals 1.8, 2.8, 3.8 and 4.8 for +24 V (UP) as well as 1.9, 2.9, 3.9 and 4.9 for 0 V (ZP)</td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5 %</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse on UP</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per module</td>
</tr>
<tr>
<td>Current consumption</td>
<td></td>
</tr>
<tr>
<td>From 24 V DC power supply at the terminals UP/L+ and ZP/M of the CPU/communication interface module</td>
<td>ca. 2 mA</td>
</tr>
<tr>
<td>From UP at normal operation / with outputs</td>
<td>0.05 A + output loads</td>
</tr>
<tr>
<td>Inrush current from UP (at power up)</td>
<td>0.010 A·s</td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>6 W (outputs OFF)</td>
</tr>
<tr>
<td>Weight (without terminal unit)</td>
<td>ca. 300 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical with derating (output load reduced to 50 % at +40 °C per group)</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>

**NOTICE!**
All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

**No effects of multiple overloads**
No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an external fuse.

**Technical data of the digital inputs**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels I0 ... I7</td>
<td>1.0 ... 1.7</td>
</tr>
<tr>
<td>Reference potential for all inputs</td>
<td>Terminals 1.9, 2.9, 3.9 and 4.9 (negative pole of the process supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>From the rest of the module (I/O bus)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>One yellow LED per channel, the LED is ON when the input signal is high (signal 1)</td>
</tr>
<tr>
<td>Monitoring point of input indicator</td>
<td>LED is part of the input circuitry</td>
</tr>
<tr>
<td>Input type acc. to EN 61131-2</td>
<td>Type 1</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 8 ms, configurable 0.1 ... 32 ms</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-3 V ... +5 V</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>&gt; +5 V ... &lt; +15 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>+15 V ... +30 V</td>
</tr>
<tr>
<td>Ripple with signal 0</td>
<td>Within -3 V ... +5 V</td>
</tr>
<tr>
<td>Ripple with signal 1</td>
<td>Within +15 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 5 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>&gt; 1 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>&gt; 5 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 8 mA</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

**Technical data of the relay outputs**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8 relay outputs</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>8 groups of 1 channel each</td>
</tr>
<tr>
<td>Connection of the channel R0</td>
<td>Terminal 2.0 (common), 3.0 (NO) and 4.0 (NC)</td>
</tr>
<tr>
<td>Connection of the channel R1</td>
<td>Terminal 2.1 (common), 3.1 (NO) and 4.1 (NC)</td>
</tr>
<tr>
<td>Connection of the channel R6</td>
<td>Terminal 2.6 (common), 3.6 (NO) and 4.6 (NC)</td>
</tr>
<tr>
<td>Connection of the channel R7</td>
<td>Terminal 2.7 (common), 3.7 (NO) and 4.7 (NC)</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Between the channels and from the rest of the module</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>One yellow LED per channel, the LED is ON when the relay coil is energized</td>
</tr>
<tr>
<td>Monitoring point of output indicator</td>
<td>LED is controlled by process CPU</td>
</tr>
<tr>
<td>Way of operation</td>
<td>Non-latching type</td>
</tr>
<tr>
<td>Output delay (0-&gt;1 or 1-&gt;0)</td>
<td>On request</td>
</tr>
<tr>
<td>Relay power supply</td>
<td>By UP process supply voltage</td>
</tr>
<tr>
<td>Relay outputs</td>
<td></td>
</tr>
<tr>
<td>Output short circuit protection</td>
<td>Should be provided externally with a fuse or circuit breaker</td>
</tr>
<tr>
<td>Rated protection fuse</td>
<td>6 A gL/gG per channel</td>
</tr>
<tr>
<td>Min. switching current</td>
<td>10 mA</td>
</tr>
<tr>
<td>Output switching capacity</td>
<td></td>
</tr>
<tr>
<td>Resistive load, max.</td>
<td>3 A; 3 A (230 V AC), 2 A (24 V DC)</td>
</tr>
<tr>
<td>Inductive load, max.</td>
<td>1.5 A; 1.5 A (230 V AC), 1.5 A (24 V DC)</td>
</tr>
<tr>
<td>Lamp load</td>
<td>60 W (230 V AC), 10 W (24 V DC)</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>-----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Output switching capacity (XC version above +60 °C)</td>
<td>On request</td>
</tr>
<tr>
<td>Lifetime (cycles)</td>
<td>Mechanical: 300 000; Under load: 300 000 (24 V DC at 2 A), 200 000 (120 V AC at 2 A), 100 000 (230 V AC at 3 A)</td>
</tr>
<tr>
<td>Spark suppression with inductive AC load</td>
<td>Must be performed externally according to driven load specifications</td>
</tr>
<tr>
<td>Demagnetization with inductive DC load</td>
<td>A free-wheeling diode must be circuited in parallel to the inductive load</td>
</tr>
<tr>
<td>Switching frequency</td>
<td></td>
</tr>
<tr>
<td>With resistive load</td>
<td>Max. 10 Hz</td>
</tr>
<tr>
<td>With inductive load</td>
<td>Max. 2 Hz</td>
</tr>
<tr>
<td>With lamp load</td>
<td>On request</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

**Technical data of the fast counter**

The fast counter of the module does not work if the module is connected to a
- FBP interface module
- CS31 bus module
- CANopen communication interface module

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Used inputs</td>
<td>I0 / I1</td>
</tr>
<tr>
<td>Used outputs</td>
<td>None</td>
</tr>
<tr>
<td>Counting frequency</td>
<td>50 kHz max.</td>
</tr>
</tbody>
</table>

*Chapter 6.8.2.12 “Fast counters in AC500 devices” on page 4536*
### Dimensions

The dimensions are in mm and in brackets in inch.

1. Din rail 15 mm
2. Din rail 7.5 mm

### Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 245 200 R0001</td>
<td>DX522, digital input/output module, 8 DI, 24 V DC, 8 DO relays</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 445 200 R0001</td>
<td>DX522-XC, digital input/output module, 8 DI, 24 V DC, 8 DO relays, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
DX531 - Digital input/output module

Features

- 8 digital inputs 120/230 V AC
- 4 relay outputs with one change-over contacts each
- Module-wise galvanically isolated

Intended purpose

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g. CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.
Digital configurable input / output unit.

- 8 digital inputs 120/230 V AC in 1 group (2.0 ... 2.3 and 3.0 ... 3.3)
- 4 digital relay outputs with one change-over contact each (R0 ... R3). All output channels are galvanically isolated from each other.

The configuration is performed by software. The modules are supplied with a process supply voltage of 24 V DC.

All available inputs/outputs are galvanically isolated from all other circuitry of the module. There is no potential separation between the channels within the same group.

For use in extreme ambient conditions (e.g. wider temperature and humidity range), a special XC version of the device is available.

Functionality

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED displays</td>
<td>For signal states, errors and supply voltage</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Through the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>External power supply</td>
<td>Via the terminals ZP and UP (process supply voltage 24 V DC)</td>
</tr>
<tr>
<td>Required terminal units</td>
<td>TU531 or TU532 ☞ Chapter 5.2.5.3 “TU531 and TU532 for I/O modules” on page 945</td>
</tr>
</tbody>
</table>

The device is plugged on a terminal unit ☞ Chapter 5.2.5.3 “TU531 and TU532 for I/O modules” on page 945. Position the module properly and press until it locks in place. The terminal unit is either mounted on a DIN rail or to the wall using 2 screws plus the additional accessory for wall mounting ☞ Chapter 5.2.8.2.5 “TA526 - Wall mounting accessory” on page 1324.

Connections

**WARNING!**

Risk of death by electric shock!

Hazardous voltages can be present at the terminals of the module.

Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The connection of the I/O channels is carried out using the 40 terminals of the I/O terminal unit. I/O modules can be replaced without re-wiring the terminal units.

The terminals 1.8 ... 4.8 and 1.9 ... 4.9 are electrically interconnected within the I/O terminal unit and always have the same assignment, irrespective of the inserted module:
- Terminals 1.8 ... 4.8: process supply voltage UP = +24 V DC
- Terminals 1.9 ... 4.9: process supply voltage ZP = 0 V DC

Table 138: Assignment of the other terminals

<table>
<thead>
<tr>
<th>Terminals</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0 ... 1.7</td>
<td>unused</td>
<td></td>
</tr>
<tr>
<td>2.0 and 3.0</td>
<td>I0 and I1</td>
<td>Input signals for the digital inputs I0 and I1</td>
</tr>
<tr>
<td>4.0</td>
<td>N01</td>
<td>Neutral conductor for the digital inputs I0 and I1</td>
</tr>
<tr>
<td>2.1 and 3.1</td>
<td>I2 and I3</td>
<td>Input signals for the digital inputs I2 and I3</td>
</tr>
<tr>
<td>4.1</td>
<td>N23</td>
<td>Neutral conductor for the digital inputs I2 and I3</td>
</tr>
<tr>
<td>2.2 and 3.2</td>
<td>I4 and I5</td>
<td>Input signals for the digital inputs I4 and I5</td>
</tr>
<tr>
<td>4.2</td>
<td>N45</td>
<td>Neutral conductor for the digital inputs I4 and I5</td>
</tr>
<tr>
<td>2.3 and 3.3</td>
<td>I6 and I7</td>
<td>Input signals for the digital inputs I6 and I7</td>
</tr>
<tr>
<td>4.3</td>
<td>N67</td>
<td>Neutral conductor for the digital inputs I6 and I7</td>
</tr>
<tr>
<td>2.4</td>
<td>R0</td>
<td>Common contact of the first relay output</td>
</tr>
<tr>
<td>3.4 and 4.4</td>
<td>NO0 and NC0</td>
<td>NO and NC contacts of the first relay output</td>
</tr>
<tr>
<td>2.5</td>
<td>R1</td>
<td>Common contact of the second relay output</td>
</tr>
<tr>
<td>3.5 and 4.5</td>
<td>NO1 and NC1</td>
<td>NO and NC contacts of the second relay output</td>
</tr>
<tr>
<td>2.6</td>
<td>R2</td>
<td>Common contact of the third relay output</td>
</tr>
<tr>
<td>3.6 and 4.6</td>
<td>NO2 and NC2</td>
<td>NO and NC contacts of the third relay output</td>
</tr>
<tr>
<td>2.7</td>
<td>R3</td>
<td>Common contact of the fourth relay output</td>
</tr>
<tr>
<td>3.7 and 4.7</td>
<td>NO3 and NC3</td>
<td>NO and NC contacts of the fourth relay output</td>
</tr>
</tbody>
</table>
Fig. 80: Internal construction

The internal power supply voltage for the module’s circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 2 mA per DX531. The external power supply connection is carried out via the UP (+24 V DC) and the ZP (0 V DC) terminals.
WARNING!
Removal/Insertion under power
Removal or insertion under power is permissible only if all conditions for hot swapping are fulfilled.

☞ Chapter 4.9.3 “Replace an I/O module with hot swap” on page 153

The devices are not designed for removal or insertion under power when the conditions for hot swap do not apply. Because of unforeseeable consequences, it is not allowed to plug in or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you
– connect or disconnect any signal or terminal block
– remove, mount or replace a module.

Disconnecting any powered devices while they are energized in a hazardous location could result in an electric arc, which could create an ignition source resulting in fire or explosion.

Prior to proceeding, make sure that power is been disconnected and that the area has been thoroughly checked to ensure that flammable materials are not present.

The devices must not be opened when in operation. The same applies to the network interfaces.

NOTICE!
Risk of damaging the PLC modules!

Overvoltages and short circuits might damage the PLC modules.

– Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
– Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.
Fig. 81: Connection of the module

1. I/O bus
2. Control cabinet earth

**NOTICE!**
- If the relay outputs have to switch inductive **DC loads**, free-wheeling diodes must be circuited in parallel to these loads.
- If the relay outputs have to switch inductive **AC loads**, spark suppressors are required.

**CAUTION!**
The process supply voltage must be included in the grounding concept (e.g. grounding of the negative terminal).
NOTICE!
Risk of damaging the PLC module!
The following has to be considered when connecting input and output voltages to the module:

- All 230 V AC feeds must be single phase from the same supply system.
- Connection of 2 or more relay contacts in series is possible; however, voltages above 230 V AC and 3-phase loads are not allowed.
- The 4 change-over contacts of the relays are galvanically isolated from channel to channel. This allows to connect loads of 24 V DC and 120/230 V AC to relay outputs of the same module. In such cases it is necessary that both supply voltages are grounded to prevent unsafe floating grounds.
- All input signals must come from the same phase of the same supply system (together with the used neutral conductor). The module is designed for 120/230 V AC max., not for 400 V AC, not even between two input terminals.
- All neutral conductor connections must be common to the same supply system, since the terminals 4.0 ... 4.3 are interconnected within the module. Otherwise, accidental energization could occur.

NOTICE!
Risk of damaging the PLC module!
There is no internal short-circuit or overload protection for the relay outputs.
Protect the relay contacts by back-up fuses of 6 A max. (characteristic gG/gL). Depending on the application, fuses can be used for single channels or module-wise.

The module provides several diagnosis functions.

**Internal data exchange**

<table>
<thead>
<tr>
<th>Digital inputs (bytes)</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital outputs (bytes)</td>
<td>1</td>
</tr>
<tr>
<td>Counter input data (words)</td>
<td>0</td>
</tr>
<tr>
<td>Counter output data (words)</td>
<td>0</td>
</tr>
</tbody>
</table>

**I/O configuration**

The module itself does not store configuration data. It receives its parameterization data from the master device of the I/O bus (CPU or communication interface module) during power-up of the system.

Hence, replacing I/O modules is possible without any re-parameterization via software.

*If the external power supply voltage via UP/ZP terminals fails, the I/O module loses its configuration data. The whole station has to be switched off and on again to re-configure the module.*
Parameterization

<table>
<thead>
<tr>
<th>Firmware version</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firmware version &gt; V2.0.0</td>
<td>The arrangement of the parameter data is performed by Control Builder Plus/ Automation Builder software.</td>
</tr>
</tbody>
</table>

The parameter data directly influences the functionality of modules.

For non-standard applications, it is necessary to adapt the parameters to your system configuration.

Module: Module slot address: Y = 1 ... 10

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot/Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Internal</td>
<td>1205 1) Word</td>
<td>1205 0x04B5</td>
<td>0</td>
<td>65535</td>
<td></td>
<td>0x0Y01</td>
</tr>
<tr>
<td>Ignore module 2)</td>
<td>No Yes</td>
<td>0 1 Byte</td>
<td>No 0x00</td>
<td></td>
<td></td>
<td></td>
<td>not for FBP</td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal</td>
<td>4 Byte</td>
<td>4-CPU 4-FBP</td>
<td>0</td>
<td>255</td>
<td></td>
<td>0x0Y02</td>
</tr>
<tr>
<td>Check supply</td>
<td>Off on</td>
<td>0 1 Byte</td>
<td>On 0x01</td>
<td>0</td>
<td>1</td>
<td></td>
<td>0x0Y03</td>
</tr>
<tr>
<td>Input delay</td>
<td>20 ms 100 ms</td>
<td>0 1 Byte</td>
<td>20 ms 0x00</td>
<td>0</td>
<td>1</td>
<td></td>
<td>0x0Y04</td>
</tr>
<tr>
<td>Behaviour of outputs at commu-</td>
<td>Off Last value</td>
<td>0 1+(n*5) Byte</td>
<td>Off 0x00</td>
<td>0</td>
<td>2</td>
<td></td>
<td>0x0Y05</td>
</tr>
<tr>
<td>nication errors</td>
<td>Substitute value</td>
<td>2+(n*5), n ≤ 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Substitute value at outputs</td>
<td>0 ... 15 Byte</td>
<td>0 ... 0x0f</td>
<td>0 0x00</td>
<td>0</td>
<td>15</td>
<td></td>
<td>0x0Y06</td>
</tr>
<tr>
<td>Bit 3 = Output 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bit 0 = Output 0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1) With CS31 and addresses smaller than 70 and FBP, the value is increased by 1
2) Not with FBP

GSD file:

Ext_User_Prm_Data_Len = Ext_User_Prm_Data_Const
(0) = 7
0x04, 0xb6, 0x04, \ 0x01, 0x00, 0x00, 0x00;
State LEDs

During the power ON procedure, the module initializes automatically. All LEDs (except the channel LEDs) are ON during this time.

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
<th>LED flashes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inputs I0 ... I7</td>
<td>Digital input</td>
<td>Yellow</td>
<td>Input = OFF</td>
<td>Input = ON</td>
<td>--</td>
</tr>
<tr>
<td>Outputs R0 ... R3 (relays)</td>
<td>Digital output</td>
<td>Yellow</td>
<td>Relay output = OFF</td>
<td>Relay output = ON</td>
<td>--</td>
</tr>
<tr>
<td>UP</td>
<td>Process supply voltage 24 V DC via terminal</td>
<td>Green</td>
<td>Process supply voltage is missing</td>
<td>Process supply voltage OK</td>
<td>--</td>
</tr>
<tr>
<td>CH-ERR2</td>
<td>Channel error, error messages in groups (digital inputs/outputs combined into the groups 2 and 3)</td>
<td>Red</td>
<td>No error or process supply voltage is missing</td>
<td>Severe error within the corresponding group</td>
<td></td>
</tr>
<tr>
<td>CH-ERR3</td>
<td>Module Error</td>
<td>Red</td>
<td>--</td>
<td>Internal error</td>
<td>--</td>
</tr>
</tbody>
</table>

*) All of the LEDs CH-ERR2 to CH-ERR3 light up together

Technical data

Technical data of the module

The system data of AC500 and S500 are applicable to the standard version “System data AC500” on page 166.

The system data of AC500-XC are applicable to the XC version “System data AC500-XC” on page 169.

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltage UP</td>
<td></td>
</tr>
<tr>
<td>Connections</td>
<td>Terminals 1.8, 2.8, 3.8 and 4.8 for +24 V DC (UP) as well as 1.9, 2.9, 3.9 and 4.9 for 0 V DC (ZP)</td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5 %</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse on UP</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per module</td>
</tr>
<tr>
<td>Current consumption</td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>From 24 V DC power supply at the terminals UP/L+ and ZP/M of the CPU/communication interface module</td>
<td>ca. 2 mA</td>
</tr>
<tr>
<td>From UP at normal operation / with outputs</td>
<td>0.15 A + output loads</td>
</tr>
<tr>
<td>Inrush current from UP (at power up)</td>
<td>0.004 A²s</td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>6 W (outputs OFF)</td>
</tr>
<tr>
<td>Weight (without terminal unit)</td>
<td>Ca. 300 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical with derating (output load reduced to 50 % at +40 °C per group)</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>

**NOTICE!**

All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

---

**No effects of multiple overloads**

No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an external fuse.

---

**Technical data of the digital inputs**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>4 groups of 2 channels each</td>
</tr>
<tr>
<td>Terminals of the channels I0 to I7</td>
<td>§ Chapter 5.2.4.3.2.8.4 “Connections” on page 595</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>2500 V AC from the rest of the module (I/O bus)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel</td>
</tr>
<tr>
<td></td>
<td>The LEDs are only operating if the module is initialized</td>
</tr>
<tr>
<td>Monitoring point of input indicator</td>
<td>LED is controlled by process CPU</td>
</tr>
<tr>
<td>Input type acc. to EN 61131-2</td>
<td>Type 2</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 20 ms</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>230 V AC or 120 V AC</td>
</tr>
<tr>
<td>Input signal range</td>
<td>0 V AC ... 265 V AC</td>
</tr>
<tr>
<td>Input signal frequency</td>
<td>47 Hz ... 63 Hz</td>
</tr>
<tr>
<td>Input characteristic</td>
<td>According EN 61132-2 Type 2</td>
</tr>
<tr>
<td>Signal 0</td>
<td>0 V AC ... 40 V AC</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>&gt; 40 V AC ... &lt; 74 V AC</td>
</tr>
<tr>
<td>Signal 1</td>
<td>74 V AC ... 265 V AC</td>
</tr>
</tbody>
</table>
### Technical data of the relay outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>4 relay outputs</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>4 groups of 1 channel each</td>
</tr>
<tr>
<td>Connection of the four relays</td>
<td>☞ Chapter 5.2.4.3.8.4 “Connections” on page 595</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Between the channels and from the rest of the module</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>1 yellow LED per channel, the LED is ON when the relay coil is energized</td>
</tr>
<tr>
<td>Monitoring point of output indicator</td>
<td>LED is controlled by process CPU</td>
</tr>
<tr>
<td>Way of operation</td>
<td>Non-latching type</td>
</tr>
<tr>
<td>Output delay (0-&gt;1 or 1-&gt;0)</td>
<td>On request</td>
</tr>
<tr>
<td>Relay power supply</td>
<td>By UP process supply voltage</td>
</tr>
<tr>
<td>Relay outputs</td>
<td></td>
</tr>
<tr>
<td>Output short circuit protection</td>
<td>Must be provided externally with a fuse or circuit breaker</td>
</tr>
<tr>
<td>Rated protection fuse</td>
<td>6 A gL/gG per channel</td>
</tr>
<tr>
<td>Output switching capacity</td>
<td></td>
</tr>
<tr>
<td>Resistive load, max.</td>
<td>3 A; 3 A (230 V AC), 2 A (24 V DC)</td>
</tr>
<tr>
<td>Inductive load, max.</td>
<td>1.5 A; 1.5 A (230 V AC), 1.5 A (24 V DC)</td>
</tr>
<tr>
<td>Lamp load</td>
<td>60 W (230 V AC), 10 W (24 V DC)</td>
</tr>
<tr>
<td>Lifetime (cycles)</td>
<td>Mechanical: 300 000; Under load: 300 000 (24 V DC at 2 A), 200 000 (120 V AC at 2 A), 100 000 (230 V AC at 3 A)</td>
</tr>
<tr>
<td>Spark suppression with inductive AC load</td>
<td>Must be performed externally according to driven load specifications</td>
</tr>
<tr>
<td>Demagnetization with inductive DC load</td>
<td>A free-wheeling diode must be circuited in parallel to the inductive load</td>
</tr>
<tr>
<td>Switching frequency</td>
<td></td>
</tr>
<tr>
<td>With resistive load</td>
<td>Max. 10 Hz</td>
</tr>
<tr>
<td>With inductive load</td>
<td>Max. 2 Hz</td>
</tr>
<tr>
<td>With lamp load</td>
<td>On request</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>---------------</td>
<td>-------</td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

**Dimensions**

The dimensions are in mm and in brackets in inch.

1  Din rail 15 mm  
2  Din rail 7.5 mm

**Ordering data**

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase (*)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 245 000 R0001</td>
<td>DX531, digital input/output module, 8 DI, 120 / 230 V AC, 4 DO relays, 2-wires</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
Fast counter

More information can be found in the Automation Builder chapter, **"Fast counters in AC500 devices"**.

☞ Chapter 6.8.2.12 "Fast counters in AC500 devices" on page 4536

5.2.4.4 Analog I/O modules

5.2.4.4.1 S500-eCo

AI561 - Analog input module

Features

- 4 configurable analog inputs (I0 ... I3) in 1 group
- Resolution: 12 bits including sign

![Diagram of AI561 Analog Input Module]

1. I/O bus
2. 1 green LED to display power supply, 1 red LED to display error
3. Terminal number
4. Allocation of signal name
5. Terminal block for input signals (9-pin)
6. Terminal block for input signals (11-pin)
7. 2 holes for wall-mounting with screws
8. DIN rail
Intended purpose

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g., CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.

The inputs are not galvanically isolated from each other.

All other circuitry of the module is not galvanically isolated from the inputs or from the I/O bus.

![The I/O module must not be used as a decentralized I/O module with CI590-CS31-HA communication interface modules.]

Functionality

4 analog inputs, individually configurable for

- Not used (default setting)
- -2.5 V ... +2.5 V
- -5 V ... +5 V
- 0 V ... +5 V
- 0 V ... +10 V
- 0 mA ... 20 mA
- 4 mA ... 20 mA

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution of the analog channels</td>
<td></td>
</tr>
<tr>
<td>Voltage bipolar (-2.5 V ... +2.5 V; -5 V ... +5 V)</td>
<td>12 bits including sign</td>
</tr>
<tr>
<td>Voltage unipolar (0 V ... 5 V; 0 V ... 10 V)</td>
<td>12 bits</td>
</tr>
<tr>
<td>Current (0 mA ... 20 mA; 4 mA ... 20 mA)</td>
<td>12 bits</td>
</tr>
<tr>
<td>LED displays</td>
<td>2 LEDs for process voltage and error messages</td>
</tr>
<tr>
<td>Internal supply</td>
<td>Via I/O bus</td>
</tr>
<tr>
<td>External supply</td>
<td>Via the terminals L+ (process voltage 24 V DC) and M (0 V DC); the M terminal is connected to the M terminal of the CPU via the I/O bus</td>
</tr>
</tbody>
</table>

Connections

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The connection is carried out by using a removable 9-pin and 11-pin terminal block. These terminal blocks differ in their connection system (spring terminals or screw terminals, cable mounting from the front or from the side). The terminal blocks are not included in the module's scope of delivery and must be ordered separately.
The assignment of the terminals:

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>R0</td>
<td>Burden resistor for input signal 0 for current sensing</td>
</tr>
<tr>
<td>2</td>
<td>I0+</td>
<td>Positive pole of input signal 0</td>
</tr>
<tr>
<td>3</td>
<td>I0-</td>
<td>Negative pole of input signal 0</td>
</tr>
<tr>
<td>4</td>
<td>R1</td>
<td>Burden resistor for input signal 1 for current sensing</td>
</tr>
<tr>
<td>5</td>
<td>I1+</td>
<td>Positive pole of input signal 1</td>
</tr>
<tr>
<td>6</td>
<td>I1-</td>
<td>Negative pole of input signal 1</td>
</tr>
<tr>
<td>7</td>
<td>R2</td>
<td>Burden resistor for input signal 2 for current sensing</td>
</tr>
<tr>
<td>8</td>
<td>I2+</td>
<td>Positive pole of input signal 2</td>
</tr>
<tr>
<td>9</td>
<td>I2-</td>
<td>Negative pole of input signal 2</td>
</tr>
<tr>
<td>10</td>
<td>R3</td>
<td>Burden resistor for input signal 3 for current sensing</td>
</tr>
</tbody>
</table>

*Fig. 82: Internal construction of the analog inputs*
Terminal | Signal | Description
--- | --- | ---
11 | I3+ | Positive pole of input signal 3
12 | I3- | Negative pole of input signal 3
13 | --- | Reserved
14 | --- | Reserved
15 | --- | Reserved
16 | --- | Reserved
17 | --- | Reserved
18 | SG | Shield grounding
19 | L+ | Process voltage L+ (24 V DC)
20 | M | Process voltage M (0 V DC)

The internal power supply voltage for the module's circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 10 mA per AI561.

The external power supply connection is carried out via the L+ (+24 V DC) and the M (0 V DC) terminals. The M terminal is interconnected to the M/ZP terminal of the CPU/communication interface module.

**NOTICE!**

Risk of imprecise and faulty measurements!

Analog signals may be distorted seriously by external electromagnetic influences.

Use shielded wires when wiring analog signal sources. The cable shield must be grounded at both ends of the cable. Provide a potential equalisation of a low resistance to avoid high potential differences between different parts of the plant.

**NOTICE!**

Risk of damaging the PLC modules!

The PLC modules must not be removed while the plant is connected to a power supply.

Make sure that all voltage sources (supply and process voltage) are switched off before you

- connect or disconnect any signal or terminal block
- remove or replace a module.

**NOTICE!**

Risk of damaging the PLC modules!

Overvoltages and short circuits might damage the PLC modules.

- Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
- Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

The module provides several diagnosis functions  

Chapter 5.2.4.4.1.1.7 “Diagnosis” on page 615.
The following figure is an example of the internal construction of the analog input AI0. The analog inputs AI1 ... AI3 are designed in the same way.

![Diagram](image)

**CAUTION!**

**Risk of damaging the analog input!**

The 250 Ω input resistor can be damaged by overcurrent.

Make sure that the current through the resistor never exceeds 30 mA.
Table 139: Example of the connection of analog sensors (voltage) to the input I0 of the analog input module AI561 (Proceed with the inputs I1 ... I3 in the same way)

Connection of active-type analog sensors (voltage)

Connection of passive-type analog sensors (voltage)
<table>
<thead>
<tr>
<th>Connection of active-type analog sensors (voltage)</th>
<th>Connection of passive-type analog sensors (voltage)</th>
</tr>
</thead>
<tbody>
<tr>
<td>-2.5 V ... 2.5 V</td>
<td>-2.5 V ... 2.5 V</td>
</tr>
<tr>
<td>-5 V ... 5 V</td>
<td>-5 V ... 5 V</td>
</tr>
<tr>
<td>0 V ... 5 V</td>
<td>0 V ... 5 V</td>
</tr>
<tr>
<td>0 V ... 10 V</td>
<td>0 V ... 10 V</td>
</tr>
</tbody>
</table>
Table 140: Example of the connection of analog sensors to the Input I0 of the analog input module AI561 (Proceed with the inputs I1 ... I3 in the same way.)
**Connection of active-type analog sensors** (voltage)  
<table>
<thead>
<tr>
<th>Value</th>
<th>Connection of passive-type analog sensors (voltage)</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 mA ... 20 mA</td>
<td>4 mA ... 20 mA</td>
</tr>
<tr>
<td>0 mA ... 20 mA</td>
<td></td>
</tr>
</tbody>
</table>

The meaning of the LEDs is described in the Displays section of Chapter 5.2.4.1.8 “State LEDs” on page 616.

**I/O configuration**

The analog input module AI561 does not store configuration data itself.

**Parameterization**

The arrangement of the parameter data is performed with Automation Builder software.

The parameter data directly influences the functionality of modules.

For non-standard applications, it is necessary to adapt the parameters to your system configuration.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal Value</th>
<th>Internal value, Type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Intern</td>
<td>6500 1)</td>
<td>WORD</td>
<td>0x1964</td>
<td>0</td>
<td>65535</td>
<td>xx01</td>
</tr>
<tr>
<td>Ignore module</td>
<td>No</td>
<td>0</td>
<td>BYTE</td>
<td>No</td>
<td>0x00</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal</td>
<td>6</td>
<td>BYTE</td>
<td>0</td>
<td>0</td>
<td>255</td>
<td>xx02 2)</td>
</tr>
<tr>
<td>Check Supply</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>On</td>
<td>0x01</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Analog Data Format</td>
<td>Default</td>
<td>0</td>
<td>BYTE</td>
<td>Default</td>
<td>0x00</td>
<td>255</td>
<td></td>
</tr>
</tbody>
</table>

1) with CS31 and addresses smaller than 70, the value is increased by 1

2) Value is hexadecimal: HighByte is slot (xx: 0 ... 7), LowByte is index (1 ... n)

GSD file:

```
Ext_User_Prm_Data.Len = Ext_User_Prm_Data.Const(0) =
0x09 
0x65, 0x19, 0x06, \ 
0x01, 0x00, \ 
0x00, 0x00, 0x00, 0x00;
```
Input channel (4x)

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, Type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel configuration</td>
<td>see table 2)</td>
<td>see table 2)</td>
<td>BYTE</td>
<td>0</td>
<td>0x00</td>
<td>65535</td>
</tr>
</tbody>
</table>

Table 141: Channel configuration

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes for the analog inputs, individually configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not used (default)</td>
</tr>
<tr>
<td>1</td>
<td>0 V ... 10 V</td>
</tr>
<tr>
<td>3</td>
<td>0 mA ... 20 mA</td>
</tr>
<tr>
<td>4</td>
<td>4 mA ... 20 mA</td>
</tr>
<tr>
<td>6</td>
<td>0 V ... 5 V</td>
</tr>
<tr>
<td>7</td>
<td>-5 V ... +5 V</td>
</tr>
<tr>
<td>20</td>
<td>-2,5 V ... +2,5 V</td>
</tr>
</tbody>
</table>

Diagnosis

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier</th>
<th>AC500 display</th>
<th>AC500 display</th>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>000 ... 063</td>
<td></td>
<td></td>
<td></td>
<td>PLC</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Browser</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Byte 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Byte 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bit 6 ... 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Bit 0 ... 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Class</td>
<td>Interface</td>
<td>Device</td>
<td>Module</td>
<td>Channel</td>
<td>Error</td>
<td>Identifier</td>
<td>Error message</td>
<td>Remedy</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------</td>
<td>-----------</td>
<td>---------</td>
<td>---------</td>
<td>---------</td>
<td>-------</td>
<td>------------</td>
<td>----------------</td>
<td>--------</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1)</td>
<td>2)</td>
<td>3)</td>
<td>4)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Module error

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier</th>
<th>AC500 display</th>
<th>AC500 display</th>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>19</td>
<td>Checksum error in the I/O module</td>
<td>Replace I/O module</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>9</td>
<td>Overflow diagnosis buffer</td>
<td>Restart</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>26</td>
<td>Parameter error</td>
<td>Check master</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>11</td>
<td>Process voltage too low</td>
<td>Check process voltage</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Channel error

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier</th>
<th>AC500 display</th>
<th>AC500 display</th>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>1</td>
<td>48</td>
<td>Analog value overflow at an analog input</td>
<td>Check input value or terminal</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Hardware descriptions

#### Device specifications > I/O modules

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier 000 ... 063</th>
<th>AC500 display</th>
<th>&lt;-- Display in...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Comp</td>
<td>Dev</td>
<td>Mod</td>
<td>Ch</td>
<td>Err</td>
<td>PS501 PLC Browser</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Byte 6</th>
<th>Bit 6 ... 7</th>
<th>-</th>
<th>Byte 3</th>
<th>Byte 4</th>
<th>Byte 5</th>
<th>Byte 6</th>
<th>Bit 0 ... 5</th>
<th>PNIO diagnosis block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Interface</td>
<td>Device</td>
<td>Module</td>
<td>Channel</td>
<td>Error Identifier</td>
<td>Error message</td>
<td>Remedy</td>
<td></td>
</tr>
<tr>
<td>1)</td>
<td>2)</td>
<td>3)</td>
<td>4)</td>
<td>5)</td>
<td>6)</td>
<td>7)</td>
<td>8)</td>
<td>9)</td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>1</td>
<td>0...3</td>
<td>7</td>
<td>Analog value underflow at an analog input</td>
<td>Check input value</td>
<td></td>
</tr>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Remarks:**

1) In AC500, the following interface identifier applies:
   - 14 = I/O bus, 11 = COM1 (e.g. CS31 bus), 12 = COM2.
   - The PNIO diagnosis block does not contain this identifier.

2) With "Device" the following allocation applies:
   - 31 = module itself, 1 ... 10 = expansion module 1 ... 10, ADR = hardware address (e.g. of the DC551-CS31)

3) With "Module" the following allocation applies depending on the master:
   - Module error: I/O bus or PNIO: 31 = module itself; COM1/COM2: 1 ... 10 = expansion 1 ... 10
   - Channel error: I/O bus or PNIO = module type (1 = AI); COM1/COM2: 1 ... 10 = expansion 1 ... 10

4) In case of module errors, with channel "31 = Module itself" is output.

### State LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
<th>LED flashes</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR</td>
<td>Process voltage 24 V DC via terminal</td>
<td>Green</td>
<td>CPU module voltage or external 24 V DC supply voltage is missing</td>
<td>3.3 V system voltage (I/O bus) and external 24 V DC supply voltage are present</td>
<td>---</td>
</tr>
<tr>
<td>ERR</td>
<td>Channel or module error</td>
<td>Red</td>
<td>No error or process voltage is missing</td>
<td>Severe error in the module</td>
<td>Error on 1 or more channels of the module</td>
</tr>
</tbody>
</table>
### Measuring ranges

**Risk of invalid analog input values!**

The analog input values may be invalid if the measuring range of the inputs is exceeded.

Make sure that the analog signal at the connection terminals is always within the signal range.

<table>
<thead>
<tr>
<th>Range</th>
<th>-2.5 ... +2.5 V</th>
<th>-5 ... +5 V</th>
<th>0 ... 5 V</th>
<th>0 ... 10 mA</th>
<th>0 ... 20 mA</th>
<th>4 ... 20 mA</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Overflow</strong></td>
<td>&gt;2.9397</td>
<td>&gt;5.8795</td>
<td>&gt;5.8795</td>
<td>&gt;11.758</td>
<td>&gt;23.517</td>
<td>&gt;22.814</td>
<td>32767</td>
</tr>
<tr>
<td><strong>Measured value too high</strong></td>
<td>2.9397</td>
<td>5.8795</td>
<td>5.8795</td>
<td>11.758</td>
<td>23.517</td>
<td>22.814</td>
<td>32511</td>
</tr>
<tr>
<td></td>
<td>2.5014</td>
<td>5.0029</td>
<td>5.0015</td>
<td>10.0029</td>
<td>20.0058</td>
<td></td>
<td>27664</td>
</tr>
<tr>
<td><strong>Normal range</strong></td>
<td>2.5000</td>
<td>5.0000</td>
<td>5.0000</td>
<td>10.0000</td>
<td>20.0000</td>
<td>20.0000</td>
<td>27648</td>
</tr>
<tr>
<td><strong>Normal range or measured value too low</strong></td>
<td>0.0014</td>
<td>0.0029</td>
<td>0.0015</td>
<td>0.0029</td>
<td>0.0058</td>
<td></td>
<td>0008</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
<td></td>
<td>:</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
<td></td>
<td>:</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
<td></td>
<td>:</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
<td></td>
<td>:</td>
</tr>
<tr>
<td></td>
<td>-2.5000</td>
<td>-5.0000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>:</td>
</tr>
<tr>
<td><strong>Measured value too low</strong></td>
<td>-2.5014</td>
<td>-5.0029</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-27664</td>
</tr>
<tr>
<td></td>
<td>-2.9398</td>
<td>-5.8795</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-32512</td>
</tr>
<tr>
<td><strong>Underflow</strong></td>
<td>&lt;-2.9398</td>
<td>&lt;-5.8795</td>
<td>&lt;-0.0300</td>
<td>&lt;-0.0600</td>
<td>&lt;-0.1200</td>
<td>&lt;-0.1200</td>
<td>-32768</td>
</tr>
</tbody>
</table>

The represented resolution corresponds to 12 bits including sign.

### Technical data

**Technical data of the module**

The system data of AC500-eCo apply.

* Chapter 5.1.1 “System data AC500-eCo” on page 159

Only additional details are therefore documented below.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltage L+</td>
<td></td>
</tr>
<tr>
<td>Connections</td>
<td>Terminal 19 for L+ (+24 V DC) and terminal 20 for M (0 V)</td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Current consumption via L+ terminal</td>
<td>0.1 A</td>
</tr>
<tr>
<td>Inrush current (at power up)</td>
<td>0.05 A²s</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5 %</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Protection fuse for L+</td>
<td>Recommended</td>
</tr>
<tr>
<td>Current consumption from 24 V DC power</td>
<td>Ca. 10 mA</td>
</tr>
<tr>
<td>supply at the terminals UP/L+ and ZP/M</td>
<td></td>
</tr>
<tr>
<td>of the CPU/communication interface</td>
<td></td>
</tr>
<tr>
<td>module</td>
<td></td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>No</td>
</tr>
<tr>
<td>Surge-voltage (max.)</td>
<td>35 V DC for 0.5 s</td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>2.7 W</td>
</tr>
<tr>
<td>Weight</td>
<td>Ca. 120 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>

**NOTICE!**

All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

### Technical data of the analog inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>4 individually configurable voltage or current inputs</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 (4 channels per group)</td>
</tr>
<tr>
<td>Resolution</td>
<td></td>
</tr>
<tr>
<td>Unipolar</td>
<td>Voltage: 0 V ... +5 V; 0 V ... +10 V: 12 bits</td>
</tr>
<tr>
<td></td>
<td>Current 0 mA ... 20 mA; 4 mA ... 20 mA: 12 bits</td>
</tr>
<tr>
<td>Bipolar</td>
<td>Voltage -2.5 V ... +2.5 V; -5 V ... +5 V: 12 bits including sign</td>
</tr>
<tr>
<td>Connection of the signals I0- to I3-</td>
<td>Terminals 3, 6, 9, 12</td>
</tr>
<tr>
<td>Connection of the signals I0+ to I3+</td>
<td>Terminals 2, 5, 8, 11</td>
</tr>
<tr>
<td>Input type</td>
<td>Differential</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>No galvanic isolation between the inputs and the I/O bus</td>
</tr>
<tr>
<td>Common mode input range</td>
<td>Signal voltage plus common mode voltage must be within ± 12 V</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>No</td>
</tr>
<tr>
<td>Channel input resistance</td>
<td>Voltage: &gt; 1 MΩ</td>
</tr>
<tr>
<td></td>
<td>Current: ca. 250 Ω</td>
</tr>
<tr>
<td>Conversion error of the analog values caused by non-linearity, adjustment error at factory and resolution within the normal range</td>
<td>Typ. ± 0.5 % of full scale (voltage)</td>
</tr>
<tr>
<td></td>
<td>± 0.5 % of full scale (current 0 mA ... 20 mA)</td>
</tr>
<tr>
<td></td>
<td>± 0.7 % of full scale (current 4 mA ... 20 mA)</td>
</tr>
<tr>
<td></td>
<td>at +25 °C</td>
</tr>
<tr>
<td></td>
<td>Max. ± 2 % of full scale (all ranges)</td>
</tr>
<tr>
<td></td>
<td>at 0 °C ... +60 °C or EMC disturbance</td>
</tr>
<tr>
<td>Time constant of the input filter</td>
<td>Voltage: 300 µs</td>
</tr>
<tr>
<td></td>
<td>Current: 300 µs</td>
</tr>
<tr>
<td>Relationship between input signal and hex code</td>
<td>§ Chapter 5.2.4.4.1.1.9 “Measuring ranges” on page 617</td>
</tr>
<tr>
<td>Analog to digital conversion time</td>
<td>Typ. 500 µs per channel</td>
</tr>
<tr>
<td>Unused inputs</td>
<td>Can be left open and should be configured as &quot;unused&quot;</td>
</tr>
<tr>
<td>Input data length</td>
<td>8 bytes</td>
</tr>
<tr>
<td>Overvoltage protection</td>
<td>Yes, up to 30 V DC only for voltage input</td>
</tr>
<tr>
<td>Max. cable length (conductor cross section &gt; 0.14 mm²)</td>
<td>Unshielded wire 10 m</td>
</tr>
<tr>
<td></td>
<td>Shielded wire 100 m</td>
</tr>
</tbody>
</table>
Dimensions

The dimensions are in mm and in brackets in inch.

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1TNE 968 902 R1101</td>
<td>AI561, analog input module, 4 AI, U/I</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3101</td>
<td>Terminal block TA563-9, 9 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3102</td>
<td>Terminal block TA563-11, 11 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3103</td>
<td>Terminal block TA564-9, 9 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3104</td>
<td>Terminal block TA564-11, 11 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3105</td>
<td>Terminal block TA565-9, 9 pins, spring front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3106</td>
<td>Terminal block TA565-11, 11 pins, spring front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
AI562 - Analog input module

Features

- 2 configurable analog resistance temperature detector (RTD) inputs (I0 and I1) in 1 group
- Resolution: 16 bits including sign

Intended purpose

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g., CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.

The inputs are not galvanically isolated from each other.

All other circuitry of the module is galvanically isolated from the inputs.
The I/O module must not be used as a decentralized I/O module with CI590-CS31-HA communication interface modules.

Functionality

2 analog RTD-inputs, individually configurable for

- Not used (default)
- Pt100, -50 °C ... +400 °C, 2-wire
- Pt100, -50 °C ... +400 °C, 3-wire
- Pt1000, -50 °C ... +400 °C, 2-wire
- Pt1000, -50 °C ... +400 °C, 3-wire
- Ni1000, -50 °C ... +150 °C, 2-wire
- Ni1000, -50 °C ... +150 °C, 3-wire
- Ni100, -50 °C ... +150 °C, 2-wire
- Ni100, -50 °C ... +150 °C, 3-wire
- Analog input resistance 0 Ω ... 150 Ω
- Analog input resistance 0 Ω ... 300 Ω

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution of the analog channels</td>
<td></td>
</tr>
<tr>
<td>Temperature</td>
<td>+0.1 °C</td>
</tr>
<tr>
<td>LED displays</td>
<td>2 LEDs for process voltage and error messages</td>
</tr>
<tr>
<td>Internal supply</td>
<td>Via I/O bus</td>
</tr>
<tr>
<td>External supply</td>
<td>Via the terminals UP (process voltage 24 V DC) and ZP (0 V DC)</td>
</tr>
</tbody>
</table>

Connections

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The connection is carried out by using a removable 9-pin and 11-pin terminal block. These terminal blocks differ in their connection system (spring terminals or screw terminals, cable mounting from the front or from the side). The terminal blocks are not included in the module’s scope of delivery and must be ordered separately.
Fig. 83: Internal construction of the analog inputs

The assignment of the terminals:

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>O0+</td>
<td>Current source of channel 0</td>
</tr>
<tr>
<td>11</td>
<td>I0+</td>
<td>Sense input of channel 0</td>
</tr>
<tr>
<td>12</td>
<td>I0-</td>
<td>Return input of channel 0</td>
</tr>
<tr>
<td>13</td>
<td>O1+</td>
<td>Current source of channel 1</td>
</tr>
<tr>
<td>14</td>
<td>I1+</td>
<td>Sense input of channel 1</td>
</tr>
<tr>
<td>15</td>
<td>I1-</td>
<td>Return input of channel 1</td>
</tr>
<tr>
<td>16</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>17</td>
<td>SG</td>
<td>Shield grounding</td>
</tr>
<tr>
<td>18</td>
<td>SG</td>
<td>Shield grounding</td>
</tr>
<tr>
<td>19</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>20</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
</tbody>
</table>

The internal power supply voltage for the module's circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 5 mA per AI562.

The external power supply connection is carried out via the UP (+24 V DC) and the ZP (0 V DC) terminals.

**NOTICE!**

Risk of imprecise and faulty measurements!

Analog signals may be distorted seriously by external electromagnetic influences.

Use shielded wires when wiring analog signal sources. The cable shield must be grounded at both ends of the cable. Provide a potential equalisation of a low resistance to avoid high potential differences between different parts of the plant.
Notice!
Risk of damaging the PLC modules!
The PLC modules must not be removed while the plant is connected to a power supply.
Make sure that all voltage sources (supply and process voltage) are switched off before you
– connect or disconnect any signal or terminal block
– remove or replace a module.

Notice!
Risk of damaging the PLC modules!
Overvoltages and short circuits might damage the PLC modules.
– Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
– Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

The module provides several diagnosis functions ☞ Chapter 5.2.4.1.2.7 “Diagnosis” on page 626.

Table 142: Connection of RTDs to the inputs of the analog input module AI562

<table>
<thead>
<tr>
<th>2-wires input</th>
<th>3-wires input</th>
</tr>
</thead>
<tbody>
<tr>
<td>24 VDC</td>
<td>24 VDC</td>
</tr>
<tr>
<td>10 O0+</td>
<td>10 O0+</td>
</tr>
<tr>
<td>11 I0+</td>
<td>11 I0+</td>
</tr>
<tr>
<td>12 O1+</td>
<td>12 O1+</td>
</tr>
<tr>
<td>13 I1+</td>
<td>13 I1+</td>
</tr>
<tr>
<td>14 ---</td>
<td>14 ---</td>
</tr>
<tr>
<td>15 SG</td>
<td>15 SG</td>
</tr>
<tr>
<td>16 UP</td>
<td>16 UP</td>
</tr>
<tr>
<td>17 ZP</td>
<td>17 ZP</td>
</tr>
<tr>
<td>18 SG</td>
<td>18 SG</td>
</tr>
<tr>
<td>19 UP</td>
<td>19 UP</td>
</tr>
<tr>
<td>20 ZP</td>
<td>20 ZP</td>
</tr>
</tbody>
</table>

With 2-wires connection, the resistance of the connection wires influences the accuracy of the measured value. Use 3-wires connection to achieve the guaranteed measuring accuracy.

The meaning of the LEDs is described in the Displays section ☞ Chapter 5.2.4.1.2.8 “State LEDs” on page 627.

I/O configuration
The analog input module AI562 does not store configuration data itself.
Parameterization

The arrangement of the parameter data is performed with Automation Builder software. The parameter data directly influences the functionality of modules. For non-standard applications, it is necessary to adapt the parameters to your system configuration.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, Type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Intern</td>
<td>6505 1)</td>
<td>WORD</td>
<td>0x1969</td>
<td>0</td>
<td>65535</td>
<td>xx01</td>
</tr>
<tr>
<td>Ignore module</td>
<td>No</td>
<td>0</td>
<td>BYTE</td>
<td>No</td>
<td>0</td>
<td>0x00</td>
<td>xx02 2)</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameter length</td>
<td>Intern</td>
<td>4</td>
<td>BYTE</td>
<td>0</td>
<td>0</td>
<td>255</td>
<td>xx02 2)</td>
</tr>
<tr>
<td>Check Supply</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>On</td>
<td></td>
<td>0x01</td>
<td></td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Analog Data Format</td>
<td>Default</td>
<td>0</td>
<td>BYTE</td>
<td>Default</td>
<td>0x00</td>
<td>255</td>
<td></td>
</tr>
</tbody>
</table>

1) with CS31 and addresses less than 70, the value is increased by 1
2) Value is hexadecimal: HighByte is slot (xx: 0 ... 7), LowByte is index (1 ... n)

GSD file:

```
Ext_User_Prm_Data_Len = 0x07
Ext_User_Prm_Data_Const(0) = 0x6A, 0x19, 0x04, 0x01, 0x00, 0x00;
```

Input channel (2x)

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, Type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel configuration</td>
<td>see table 2)</td>
<td>see table 2)</td>
<td>BYTE</td>
<td>0</td>
<td>0x00</td>
<td>65535</td>
</tr>
</tbody>
</table>

Table 143: Channel configuration 2)

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes for the analog inputs, individually configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not used (default)</td>
</tr>
<tr>
<td>8</td>
<td>2-wire Pt100 -50 °C ... +400 °C</td>
</tr>
<tr>
<td>9</td>
<td>3-wire Pt100 -50 °C ... +400 °C</td>
</tr>
<tr>
<td>16</td>
<td>2-wire Pt1000, -50 °C ... +400 °C</td>
</tr>
</tbody>
</table>
### Internal value

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes for the analog inputs, individually configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>17</td>
<td>3-wire Pt1000, -50 °C ... +400 °C</td>
</tr>
<tr>
<td>18</td>
<td>2-wire Ni1000, -50 °C ... +150 °C</td>
</tr>
<tr>
<td>19</td>
<td>3-wire Ni1000, -50 °C ... +150 °C</td>
</tr>
<tr>
<td>22</td>
<td>2-wire Ni100, -50 °C ... +150 °C</td>
</tr>
<tr>
<td>23</td>
<td>3-wire Ni100, -50 °C ... +150 °C</td>
</tr>
<tr>
<td>32</td>
<td>Analog input resistor 0 Ω ... 150 Ω</td>
</tr>
<tr>
<td>33</td>
<td>Analog input resistor 0 Ω ... 300 Ω</td>
</tr>
</tbody>
</table>

### Diagnosis

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier</th>
<th>AC500 display</th>
<th>&lt;= Display in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Comp</td>
<td>Dev</td>
<td>Mod</td>
<td>Ch</td>
<td>Err</td>
<td>PS501 PLC Browser</td>
<td>PNIO diagnosis block</td>
</tr>
<tr>
<td>Byte 6</td>
<td>-</td>
<td>Byte 3</td>
<td>Byte 4</td>
<td>Byte 5</td>
<td>Byte 6 Bit 0 ... 5</td>
<td>PNIO diagnosis block</td>
<td></td>
</tr>
<tr>
<td>Bit 6 ... 7</td>
<td>1)</td>
<td>2)</td>
<td>3)</td>
<td>4)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Module error

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>19</td>
<td>Checksum error in the I/O module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>9</td>
<td>Overflow diagnosis buffer</td>
<td>Restart</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>26</td>
<td>Parameter error</td>
<td>Check master</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>11</td>
<td>Process voltage too low</td>
<td>Check process voltage</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Channel error

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>1</td>
<td>0...1</td>
<td>48</td>
<td>Analog value overflow at an analog input</td>
<td>Check input value or terminal</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>1</td>
<td>0...1</td>
<td>7</td>
<td>Analog value underflow at an analog input</td>
<td>Check input value</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Remarks:
1) In AC500 the following interface identifier applies:
   14 = I/O bus, 11 = COM1 (e.g. CS31 bus), 12 = COM2.
   The PNIO diagnosis block does not contain this identifier.

2) With "Device" the following allocation applies:
   31 = module itself, 1 ... 10 = expansion module 1 ... 10, ADR = hardware
   address (e.g. of the DC551-CS31)

3) With "Module" the following allocation applies dependent of the master:
   Module error: I/O bus or PNIO: 31 = module itself; COM1/COM2: 1 ... 10 =
   expansion 1...10
   Channel error: I/O bus or PNIO = module type (1 = AI); COM1/COM2: 1 ... 10
   = expansion 1 ... 10

4) In case of module errors, with channel "31 = Module itself" is output.

State LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
<th>LED flashes</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR</td>
<td>Process voltage</td>
<td>Green</td>
<td>CPU module voltage or external 24 V DC supply voltage is missing</td>
<td>3.3 V system voltage (I/O bus) and external 24 V DC supply voltage are present</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td>24 V DC via terminal</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ERR</td>
<td>Channel or module error</td>
<td>Red</td>
<td>No error or process voltage is missing</td>
<td>Severe error in the module</td>
<td>Error on 1 or more channels of the module</td>
</tr>
</tbody>
</table>

Measuring ranges

Risk of invalid analog input values!
The analog input values may be invalid if the measuring range of the inputs is exceeded.
Make sure that the analog signal at the connection terminals is always within the signal range.

Resistance temperature detectors

<table>
<thead>
<tr>
<th>Range</th>
<th>Pt100 / Pt1000 -50 °C ... +400 °C</th>
<th>Ni1000 / Ni100 -50 °C ... +150 °C</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Decimal</td>
<td>Hex.</td>
<td></td>
</tr>
<tr>
<td>Overflow</td>
<td>&gt; +450.0 °C</td>
<td>&gt; +160.0 °C</td>
<td>32767</td>
</tr>
<tr>
<td>Measured value too high</td>
<td>+450.0 °C</td>
<td></td>
<td>4500</td>
</tr>
<tr>
<td></td>
<td>+400.1 °C</td>
<td></td>
<td>4001</td>
</tr>
</tbody>
</table>

2024/01/05 3ADR010583, 1, en_US 627
<table>
<thead>
<tr>
<th>Range</th>
<th>Pt100 / Pt1000 -50 °C ... +400 °C</th>
<th>Ni1000 / Ni100 -50 °C ... +150 °C</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Decimal</td>
</tr>
<tr>
<td>Normal range</td>
<td>+160.0 °C</td>
<td>+150.0 °C</td>
<td>0640</td>
</tr>
<tr>
<td></td>
<td>+150.1 °C</td>
<td></td>
<td>05DD</td>
</tr>
<tr>
<td>Measured value</td>
<td>+400.0 °C</td>
<td>+150.0 °C</td>
<td>0FA0</td>
</tr>
<tr>
<td>too low</td>
<td></td>
<td></td>
<td>07D0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>05DC</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>02BC</td>
</tr>
<tr>
<td></td>
<td>+ 0.1 °C</td>
<td>+ 0.1 °C</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>0.0 °C</td>
<td>0.0 °C</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>-0.1 °C</td>
<td>-0.1 °C</td>
<td>-1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>FFFF</td>
</tr>
<tr>
<td></td>
<td>-50.0 °C</td>
<td>-50.0 °C</td>
<td>-51</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>FE0B</td>
</tr>
<tr>
<td></td>
<td>-50.1 °C</td>
<td>-50.1 °C</td>
<td>-501</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>F830</td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt; -60.0 °C</td>
<td>&lt; -60.0 °C</td>
<td>-32768</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>8000</td>
</tr>
</tbody>
</table>

**Resistances**

<table>
<thead>
<tr>
<th>Range</th>
<th>Resistance 0 Ω ... 150 Ω</th>
<th>Resistance 0 Ω ... 300 Ω</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Decimal</td>
</tr>
<tr>
<td>Overflow</td>
<td>&gt;176.383</td>
<td>&gt;352.767</td>
<td>32767</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>7FFF</td>
</tr>
<tr>
<td>Measured value</td>
<td>176.383</td>
<td>352.767</td>
<td>32511</td>
</tr>
<tr>
<td>too high</td>
<td>150.005</td>
<td>300.011</td>
<td>27649</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>6C01</td>
</tr>
<tr>
<td>Normal range</td>
<td>150.000</td>
<td>300.000</td>
<td>27648</td>
</tr>
<tr>
<td></td>
<td>0.005</td>
<td>0.011</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0001</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0000</td>
</tr>
</tbody>
</table>

**Technical data**

**Technical data of the module**

The system data of AC500-eCo apply.

*Chapter 5.1.1 “System data AC500-eCo” on page 159*

Only additional details are therefore documented below.
### Parameter Value

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltage UP</td>
<td>Terminal 19 for UP (+24 V DC) and terminal 20 for ZP (0 V)</td>
</tr>
<tr>
<td>Connections</td>
<td></td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Current consumption</td>
<td>0.04 A</td>
</tr>
<tr>
<td>Inrush current (at power-up)</td>
<td>0.05 A²s</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5 %</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Protection fuse for UP</td>
<td>Recommended</td>
</tr>
<tr>
<td>Current consumption from 24 V DC power supply at the terminals UP/L+ and ZP/M of the CPU/communication interface module</td>
<td>Ca. 5 mA</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, between the input group and the rest of the module</td>
</tr>
<tr>
<td>Isolated groups</td>
<td>1 (2 channels per group)</td>
</tr>
<tr>
<td>Surge-voltage (max.)</td>
<td>35 V DC for 0.5 s</td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>1.1 W</td>
</tr>
<tr>
<td>Weight</td>
<td>Ca. 120 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>

**NOTICE!**
All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

---

### Technical data of the analog inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>2 configurable RTD (resistance temperature detector) inputs</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 (2 channels per group)</td>
</tr>
<tr>
<td>Resolution</td>
<td></td>
</tr>
<tr>
<td>RTD</td>
<td>+0.1 °C / 0.1 °F</td>
</tr>
<tr>
<td>Resistance</td>
<td>16 bits including sign</td>
</tr>
<tr>
<td>Connection of the signals O0+ and O1+</td>
<td>Terminals 10 and 13</td>
</tr>
<tr>
<td>Connection of the signals I0- and I1-</td>
<td>Terminals 11 and 14</td>
</tr>
<tr>
<td>Connection of the signals I0+ and I1+</td>
<td>Terminals 12 and 15</td>
</tr>
<tr>
<td>Input type</td>
<td>Module ground referenced RTD for 2-wire and 3-wire resistance temperature detectors</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Against internal power supply and other modules</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Input ranges</td>
<td>Pt100, Pt1000, Ni100, Ni1000</td>
</tr>
<tr>
<td></td>
<td>150 Ω, 300 Ω</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>No</td>
</tr>
<tr>
<td>Module update time</td>
<td>All channels: &lt; 1 s</td>
</tr>
<tr>
<td>Channel input resistance</td>
<td>&gt; 100 kΩ</td>
</tr>
<tr>
<td>Input filter attenuation</td>
<td>-3 dB at 3.6 kHz</td>
</tr>
<tr>
<td>Conversion error of the analog values caused by non-linearity, adjustment</td>
<td>Typ. Depending on RTD max. ±0.6 % of full scale (guaranteed for 3-wires connection only) at +25 °C</td>
</tr>
<tr>
<td>error at factory and resolution within the normal range</td>
<td>Max. ± 2 % of full scale (guaranteed for 3-wires connection only) at 0 °C ... +60 °C or EMC disturbances</td>
</tr>
<tr>
<td>Measuring range</td>
<td>≃ Chapter 5.2.4.4.1.2.9 “Measuring ranges” on page 627</td>
</tr>
<tr>
<td>Analog to digital conversion time</td>
<td>Typ. 140 ms per channel</td>
</tr>
<tr>
<td>Unused inputs</td>
<td>Can be left open and should be configured as “unused”</td>
</tr>
<tr>
<td>Input data length</td>
<td>4 bytes</td>
</tr>
<tr>
<td>Power dissipation inside the sensor (max.)</td>
<td>1 mW</td>
</tr>
<tr>
<td>Suppression of interference</td>
<td>On request</td>
</tr>
<tr>
<td>Maximum input voltage</td>
<td>30 V DC (sense), 5 V DC (source)</td>
</tr>
<tr>
<td>Basic error (resistance)</td>
<td>0.1 % of full-scale</td>
</tr>
<tr>
<td>Repeatability</td>
<td>0.05 % of full-scale</td>
</tr>
<tr>
<td>Overvoltage protection</td>
<td>Yes, up to 30 V DC</td>
</tr>
<tr>
<td>Wire loop resistance</td>
<td>&lt; 20 Ω</td>
</tr>
<tr>
<td>Max. cable length (conductor cross section &gt; 0.14 mm²)</td>
<td></td>
</tr>
<tr>
<td>Unshielded wire</td>
<td>10 m</td>
</tr>
<tr>
<td>Shielded wire</td>
<td>100 m</td>
</tr>
</tbody>
</table>
Dimensions

The dimensions are in mm and in brackets in inch.

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1TNE 968 902 R1102</td>
<td>AI562, analog input module, 2 AI, RTD</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3102</td>
<td>Terminal block TA563-11, 11 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3104</td>
<td>Terminal block TA564-11, 11 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3106</td>
<td>Terminal block TA565-11, 11 pins, spring front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
AI563 - Analog input module

Features

- 4 configurable thermocouple (TC) / -80 mV ... +80 mV inputs (I0 ... I3) in 1 group
- Resolution: 16 bits including sign

Intended purpose

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g., CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.

The inputs are group-wise galvanically isolated from each other.
The other electronic circuitry of the module is galvanically isolated from the inputs.

The I/O module must not be used as a decentralized I/O module with CI590-CS31-HA communication interface modules.

Functionality

4 analog TC inputs, individually configurable for
- Not used (default)
- Voltage -80 mV ... + 80 mV
- Thermocouple J-type -210 °C ... +1200 °C
- Thermocouple K-type -270 °C ... +1372 °C
- Thermocouple R-type -50 °C ... +1768 °C
- Thermocouple S-type -50 °C ... +1768 °C
- Thermocouple T-type -270 °C ... +400 °C
- Thermocouple E-type -270 °C ... +1000 °C
- Thermocouple N-type -270 °C ... +1300 °C

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution of the analog channels</td>
<td></td>
</tr>
<tr>
<td>Temperature</td>
<td>+0.1 °C</td>
</tr>
<tr>
<td>LED displays</td>
<td>2 LEDs for process voltage and error messages</td>
</tr>
<tr>
<td>Internal supply</td>
<td>Via I/O bus</td>
</tr>
<tr>
<td>External supply</td>
<td>Via the terminals UP (process voltage 24 V DC) and ZP (0 V DC)</td>
</tr>
</tbody>
</table>

Connections

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

After powering up the system, input channels, which are configured will have undefined values/diagnosis message for typically 45 seconds, if the wires of all configured channels are broken.

If the AI563 is connected to a PROFINET communication interface module, the firmware version of PROFINET communication interface module must be 1.2 or above.

The connection is carried out by using a removable 9-pin and 11-pin terminal block. These terminal blocks differ in their connection system (spring terminals or screw terminals, cable mounting from the front or from the side). The terminal blocks are not included in the module's scope of delivery and must be ordered separately.
Fig. 84: Internal construction of the analog inputs

Table 144: Assignment of the terminals

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>I0+</td>
<td>Positive pole of channel 0</td>
</tr>
<tr>
<td>2</td>
<td>I0-</td>
<td>Negative pole of channel 0</td>
</tr>
<tr>
<td>3</td>
<td>I1+</td>
<td>Positive pole of channel 1</td>
</tr>
<tr>
<td>4</td>
<td>I1-</td>
<td>Negative pole of channel 1</td>
</tr>
<tr>
<td>5</td>
<td>I2+</td>
<td>Positive pole of channel 2</td>
</tr>
<tr>
<td>6</td>
<td>I2-</td>
<td>Negative pole of channel 2</td>
</tr>
<tr>
<td>7</td>
<td>I3+</td>
<td>Positive pole of channel 3</td>
</tr>
<tr>
<td>8</td>
<td>I3-</td>
<td>Negative pole of channel 3</td>
</tr>
<tr>
<td>9</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>10</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>11</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>12</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>13</td>
<td>---</td>
<td>Reserved</td>
</tr>
</tbody>
</table>
The internal power supply voltage for the module's circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals UP/L+ and ZP/M of the CPU/communication interface module increases by 5 mA per AI563.

The external power supply connection is carried out via the UP (+24 V DC) and the ZP (0 V DC) terminals.

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>14</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>15</td>
<td>SG</td>
<td>Shield grounding</td>
</tr>
<tr>
<td>16</td>
<td>SG</td>
<td>Shield grounding</td>
</tr>
<tr>
<td>17</td>
<td>SG</td>
<td>Shield grounding</td>
</tr>
<tr>
<td>18</td>
<td>SG</td>
<td>Shield grounding</td>
</tr>
<tr>
<td>19</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>20</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
</tbody>
</table>

NOTICE!
Risk of imprecise and faulty measurements!
Analog signals may be distorted seriously by external electromagnetic influences.
Use shielded wires when wiring analog signal sources. The cable shield must be grounded at both ends of the cable. Provide a potential equalisation of a low resistance to avoid high potential differences between different parts of the plant.

NOTICE!
Risk of damaging the PLC modules!
The PLC modules must not be removed while the plant is connected to a power supply.
Make sure that all voltage sources (supply and process voltage) are switched off before you
- connect or disconnect any signal or terminal block
- remove or replace a module.

NOTICE!
Risk of damaging the PLC modules!
Overvoltages and short circuits might damage the PLC modules.
- Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
- Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

The module provides several diagnosis functions § Chapter 5.2.4.4.1.3.7 “Diagnosis” on page 638.

The following figure shows the connection of thermocouples to the inputs of the module:
Fig. 85: Connection of thermocouples to the inputs of the module

The meaning of the LEDs is described in Displays chapter % Chapter 5.2.4.4.1.3.8 “State LEDs” on page 639.

I/O configuration

The analog input module AI563 does not store configuration data itself.

Parameterization

The arrangement of the parameter data is performed with Automation Builder software.

The parameter data directly influences the functionality of modules.

For non-standard applications, it is necessary to adapt the parameters to your system configuration.
<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, Type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Intern</td>
<td>6510 1)</td>
<td>WORD</td>
<td>0x196E</td>
<td>0</td>
<td>65535</td>
<td>xx01</td>
</tr>
<tr>
<td>Ignore module</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td>0</td>
<td>BYTE</td>
<td>No</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>1</td>
<td></td>
<td>0x00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameter length</td>
<td>Intern</td>
<td>6</td>
<td>BYTE</td>
<td>0</td>
<td>0</td>
<td>255</td>
<td>xx02 2)</td>
</tr>
<tr>
<td>Check Supply</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>On</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td></td>
<td>0x01</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Analog Data Format</td>
<td>Default</td>
<td>0</td>
<td>BYTE</td>
<td>Default</td>
<td>0x00</td>
<td>255</td>
<td></td>
</tr>
</tbody>
</table>

1) with CS31 and addresses less than 70, the value is increased by 1
2) Value is hexadecimal: HighByte is slot (xx: 0 ... 7), LowByte is index (1 ... n)

GSD file:

```
Ext_User_Prm_Data_Len = 0x09
Ext_User_Prm_Data_Const(0) = 0x6F, 0x19, 0x06, \
0x01, 0x00, \
0x00, 0x00, 0x00, 0x00;
```

Input channel (4x)

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, Type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel configuration</td>
<td>see table 2)</td>
<td>see table 2)</td>
<td>BYTE</td>
<td>0x00 see table 2)</td>
<td>0</td>
<td>65535</td>
</tr>
</tbody>
</table>

Table 145: Channel configuration 2)

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes for the analog inputs, individually configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not used (default)</td>
</tr>
<tr>
<td>21</td>
<td>Voltage -80 mV ... +80 mV</td>
</tr>
<tr>
<td>24</td>
<td>Thermocouple J-type -210 °C ... +1200 °C</td>
</tr>
<tr>
<td>25</td>
<td>Thermocouple K-type -270 °C ... +1372 °C</td>
</tr>
<tr>
<td>26</td>
<td>Thermocouple R-type -50 °C ... +1768 °C</td>
</tr>
<tr>
<td>27</td>
<td>Thermocouple S-type -50 °C ... +1768 °C</td>
</tr>
<tr>
<td>28</td>
<td>Thermocouple T-type -270 °C...+400 °C</td>
</tr>
<tr>
<td>29</td>
<td>Thermocouple E-type -270 °C ... +1000 °C</td>
</tr>
<tr>
<td>30</td>
<td>Thermocouple N-type -270 °C ... +1300 °C</td>
</tr>
</tbody>
</table>
### Diagnosis

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier 000 ... 063</th>
<th>AC500 display</th>
<th>← Display in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Comp</td>
<td>Dev</td>
<td>Mod</td>
<td>Ch</td>
<td>Err</td>
<td>PS501 PLC browser</td>
<td></td>
</tr>
<tr>
<td>Byte 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bit 6 ... 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Module error

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td></td>
<td>19</td>
<td>Checksum error in the I/O module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td></td>
<td>9</td>
<td>Overflow diagnosis buffer</td>
<td>Restart</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td></td>
<td>26</td>
<td>Parameter error</td>
<td>Check master</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td></td>
<td>11</td>
<td>Process voltage too low</td>
<td>Check process voltage</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Channel error</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>1 ... 10</td>
<td>1</td>
<td>0 ... 3</td>
<td>48</td>
<td>Analog value overflow or broken wire at an analog input</td>
<td>Check input value or terminal</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>1 ... 10</td>
<td>1</td>
<td>0 ... 3</td>
<td>7</td>
<td>Analog value underflow at an analog input</td>
<td>Check input value</td>
</tr>
</tbody>
</table>

#### Remarks:

1) In AC500 the following interface identifier applies:
   - 14 = I/O bus, 11 = COM1 (e.g. CS31 bus), 12 = COM2.
   - The PNIO diagnosis block does not contain this identifier.

2) With "Device" the following allocation applies:
   - 31 = module itself, 1 ... 10 = expansion module 1...10, ADR = hardware address (e.g. of the DC551-CS31)

3) With "Module" the following allocation applies dependent of the master:
   - Module error: I/O bus or PNIO: 31 = module itself; COM1/COM2: 1 ... 10 = expansion 1 ... 10
   - Channel error: I/O bus or PNIO = module type (1 = AI); COM1/COM2: 1 ... 10 = expansion 1 ... 10

4) In case of module errors, with channel "31 = Module itself" is output.
State LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
<th>LED flashes</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR</td>
<td>Process voltage 24 V DC via terminal</td>
<td>Green</td>
<td>CPU module voltage or external 24 V DC supply voltage is missing</td>
<td>3.3 V system voltage (I/O bus) and external 24 V DC supply voltage are present</td>
<td>---</td>
</tr>
<tr>
<td>ERR</td>
<td>Channel or module error</td>
<td>Red</td>
<td>No error or process voltage is missing</td>
<td>Severe error in the module</td>
<td>Error on 1 or more channels of the module</td>
</tr>
</tbody>
</table>

Measuring ranges

AI563 needs typ. 6 to 8 seconds for initialization after applying the process supply voltage to clamp UP/ZP. During this time, the accuracy of the measurement values is not within specification. After that, valid measurement values are provided by the module. After that, valid measurement values are provided by the module.

After an interruption of the process supply voltage > 10 ms, a re-initialization is performed by AI563.

Risk of invalid analog input values!
The analog input values may be invalid if the measuring range of the inputs is exceeded.

Make sure that the analog signal at the connection terminals is always within the signal range.

When a wire break occurs on a sensor wire, the temperature measurement value of the corresponding channel changes to Overflow (Hexadecimal 7FFF).

<table>
<thead>
<tr>
<th>Range</th>
<th>Type J -210 °C ... +1200 °C</th>
<th>Type K 270 °C ... +1372 °C</th>
<th>Type N 270 °C ... +1300 °C</th>
<th>Type T -270 °C ... +400 °C</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Decimal</td>
<td>Hex.</td>
<td>Decimal</td>
<td>Hex.</td>
<td></td>
</tr>
<tr>
<td>Overflow</td>
<td>&gt; +1200.0 °C</td>
<td>&gt; +1372.0 °C</td>
<td>&gt; +1300.0 °C</td>
<td>&gt; +400.0 °C</td>
<td>32767 7FFF</td>
</tr>
<tr>
<td>Normal range</td>
<td>&gt; +1372.0 °C</td>
<td>&gt; +1300.0 °C</td>
<td>+1372.0 °C</td>
<td>13720 3598</td>
<td></td>
</tr>
<tr>
<td></td>
<td>+1300.0 °C</td>
<td></td>
<td>:</td>
<td>:</td>
<td>13000 32C8</td>
</tr>
<tr>
<td></td>
<td>+1200.0 °C</td>
<td>:</td>
<td>+400.0 °C</td>
<td>4000 0FA0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
<td></td>
</tr>
</tbody>
</table>

2024/01/05 3ADR010583, 1, en_US 639
<table>
<thead>
<tr>
<th>Range</th>
<th>Type J</th>
<th>Type K</th>
<th>Type N</th>
<th>Type T</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>-210 °C ... +1200 °C</td>
<td>270 °C ... +1372 °C</td>
<td>270 °C ... +1300 °C</td>
<td>-270 °C ... +400 °C</td>
<td></td>
</tr>
<tr>
<td>+0.1 °C</td>
<td>+0.1 °C</td>
<td>+0.1 °C</td>
<td>+0.1 °C</td>
<td>+0.1 °C</td>
<td>1 1</td>
</tr>
<tr>
<td>+0.0 °C</td>
<td>+0.0 °C</td>
<td>+0.0 °C</td>
<td>+0.0 °C</td>
<td>+0.0 °C</td>
<td>0 0000</td>
</tr>
<tr>
<td>-0.1 °C</td>
<td>-0.1 °C</td>
<td>-0.1 °C</td>
<td>-0.1 °C</td>
<td>-0.1 °C</td>
<td>-1 FFFF</td>
</tr>
<tr>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
<td></td>
</tr>
<tr>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>-500 FE0C</td>
</tr>
<tr>
<td>-210.0 °C</td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>-2100 F7CC</td>
</tr>
<tr>
<td>-270.0 °C</td>
<td>-270.0 °C</td>
<td>-270.0 °C</td>
<td>-270.0 °C</td>
<td>-270.0 °C</td>
<td>-2700 F574</td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt; -210.0 °C</td>
<td>&lt; -270.0 °C</td>
<td>&lt; -270.0 °C</td>
<td>&lt; -270.0 °C</td>
<td>-32768 8000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Range</th>
<th>-80 mV ... +80 mV</th>
<th>Type E</th>
<th>Types R, S</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>-270 °C ... +1000 °C</td>
<td>-50 °C ... +1768 °C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overflow</td>
<td>&gt; +90 mV</td>
<td>&gt; +1000.0 °C</td>
<td>&gt; +1768.0 °C</td>
<td>32767 7FFF</td>
</tr>
<tr>
<td>Normal range</td>
<td>+80 mV</td>
<td>+1768.0 °C</td>
<td>17680 4510</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>+1000.0 °C</td>
<td>10000 2710</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>9000 2328</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 µV</td>
<td>+0.1 °C</td>
<td>+0.1 °C</td>
<td>1 1</td>
<td></td>
</tr>
<tr>
<td>0 µV</td>
<td>0.0 °C</td>
<td>0.0 °C</td>
<td>0 0000</td>
<td></td>
</tr>
<tr>
<td>-3 µV</td>
<td>-0.1 °C</td>
<td>-0.1 °C</td>
<td>-1 FFFF</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-80 mV</td>
<td></td>
<td>-50.0 °C</td>
<td>-500 FE0C</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>-270.0 °C</td>
<td>-2700 F574</td>
<td></td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt; -90 mV</td>
<td>&lt; -270.0 °C</td>
<td>&lt; -50.0 °C</td>
<td>-32768 8000</td>
</tr>
</tbody>
</table>

### Technical data
### Technical data of the module

The system data of AC500-eCo apply.

* Chapter 5.1.1 “System data AC500-eCo” on page 159

Only additional details are therefore documented below.
Parameter | Value
---|---
Process supply voltage UP | 24 V DC
Connections | Terminal 19 for UP (+24 V DC) and terminal 20 for ZP (0 V)
Rated value | 24 V DC
Current consumption | 0.10 A
Inrush current (at power-up) | 0.07 A\textsuperscript{s}
Max. ripple | 5 %
Protection against reversed voltage | Yes
Rated protection fuse for UP | Not necessary
Current consumption from 24 V DC power supply at the terminals UP/L+ and ZP/M of the CPU/communication interface module | Ca. 5 mA
Galvanic isolation | Yes, between the channels and the rest of the module
Isolated groups | 1 (4 channels per group)
Surge-voltage (max.) | 35 V DC for 0.5 s
Max. power dissipation within the module | 2.6 W
Weight | Ca. 120 g
Mounting position | Horizontal or vertical
Cooling | The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.

**NOTICE!**
All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

---

Technical data of the analog inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>4 configurable thermocouple (TC) inputs</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 (4 channels per group)</td>
</tr>
<tr>
<td>Resolution</td>
<td>0.1 °C</td>
</tr>
<tr>
<td>Temperature</td>
<td>0.1 °C</td>
</tr>
<tr>
<td>Voltage</td>
<td>16 bits including sign</td>
</tr>
<tr>
<td>Connection of the signals I0+ to I3+</td>
<td>Terminals 1, 3, 5 and 7</td>
</tr>
<tr>
<td>Connection of the signals I0- to I3-</td>
<td>Terminals 2, 4, 6 and 8</td>
</tr>
<tr>
<td>Input type</td>
<td>Floating thermocouple</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Against internal power supply and other modules</td>
</tr>
<tr>
<td>Common mode rejection</td>
<td>&gt; 120 dB at 120 V AC</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>No</td>
</tr>
<tr>
<td>Module update time</td>
<td>All channels: &lt; 1.6 s</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Channel input resistance</td>
<td>On request</td>
</tr>
<tr>
<td>Input filter attenuation</td>
<td>-3 dB at 15 kHz</td>
</tr>
<tr>
<td>Cold junction error</td>
<td>± 1.5 °C</td>
</tr>
<tr>
<td>Conversion error of the analog values caused by non-linearity, adjustment</td>
<td>Typ. 0.1 % of full-scale (voltage)</td>
</tr>
<tr>
<td>error at factory and resolution within the normal range</td>
<td>Depending on thermocouple, see table 'Accuracy of thermocouple ranges at +25 °C'</td>
</tr>
<tr>
<td></td>
<td>÷ Chapter 5.2.4.1.3.10.2.1 &quot;Accuracy of thermocouple ranges at 25 °C (with cold junction compensation)&quot; on page 642</td>
</tr>
<tr>
<td></td>
<td>Max. ± 2 % of full scale (T-Type: ± 3 % for -240 °C ... -270 °C at 0 °C ... +60 °C</td>
</tr>
<tr>
<td>Relationship between input signal and hex code</td>
<td>÷ Chapter 5.2.4.1.3.9 &quot;Measuring ranges&quot; on page 639</td>
</tr>
<tr>
<td>Analog to digital conversion time</td>
<td>400 ms per channel</td>
</tr>
<tr>
<td>Unused inputs</td>
<td>Can be left open and should be configured as &quot;unused&quot;</td>
</tr>
<tr>
<td>Input data length</td>
<td>8 bytes</td>
</tr>
<tr>
<td>Overvoltage protection</td>
<td>Yes, up to 30 V DC</td>
</tr>
<tr>
<td>Repeatability</td>
<td>On request</td>
</tr>
<tr>
<td>Wire loop resistance</td>
<td>&lt; 100 Ω</td>
</tr>
<tr>
<td>Max. cable length (conductor cross section &gt; 0.14 mm²)</td>
<td>Unshielded wire 10 m</td>
</tr>
<tr>
<td></td>
<td>Shielded wire 100 m</td>
</tr>
</tbody>
</table>

Accuracy of thermocouple ranges at 25 °C (with cold junction compensation)

<table>
<thead>
<tr>
<th>Thermocouple Type</th>
<th>Range</th>
<th>Accuracy</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>-270 °C ... -220 °C</td>
<td>± 2 %</td>
</tr>
<tr>
<td></td>
<td>-220 °C ... +1000 °C</td>
<td>± 0.6 %</td>
</tr>
<tr>
<td>J</td>
<td>-210 °C ... +1200 °C</td>
<td>± 0.6 %</td>
</tr>
<tr>
<td>K</td>
<td>-270 °C ... -220 °C</td>
<td>± 1.5 %</td>
</tr>
<tr>
<td></td>
<td>-220 °C ... +1372 °C</td>
<td>± 0.6 %</td>
</tr>
<tr>
<td>N</td>
<td>-270 °C ... -150 °C</td>
<td>± 2 %</td>
</tr>
<tr>
<td></td>
<td>-150 °C ... +1300 °C</td>
<td>± 0.6 %</td>
</tr>
<tr>
<td>R</td>
<td>-50 °C ... +150 °C</td>
<td>± 1.5 %</td>
</tr>
<tr>
<td></td>
<td>+150 °C ... +1768 °C</td>
<td>± 0.6 %</td>
</tr>
<tr>
<td>S</td>
<td>-50 °C ... +150 °C</td>
<td>± 1.5 %</td>
</tr>
<tr>
<td></td>
<td>+150 °C ... +1768 °C</td>
<td>± 0.6 %</td>
</tr>
<tr>
<td>T</td>
<td>-270 °C ... -240 °C</td>
<td>± 3 %</td>
</tr>
<tr>
<td></td>
<td>-240 °C ... 0 °C</td>
<td>± 2 %</td>
</tr>
<tr>
<td></td>
<td>0 °C ... +400 °C</td>
<td>± 0.6 %</td>
</tr>
</tbody>
</table>
These accuracy values are valid only for stable module temperatures.

Dimensions

The dimensions are in mm and in brackets in inch.

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *</th>
</tr>
</thead>
<tbody>
<tr>
<td>1TNE 968 902 R1103</td>
<td>Al563, analog input module, 4 Al, thermocouple</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3101</td>
<td>Terminal block TA563-9, 9 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3102</td>
<td>Terminal block TA563-11, 11 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3103</td>
<td>Terminal block TA564-9, 9 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3104</td>
<td>Terminal block TA564-11, 11 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
</tbody>
</table>
AO561 - Analog output module

Features

- 2 configurable analog outputs (O0 ... O1) in 1 group
- Resolution: 12 bits including sign

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
1 I/O bus
2 1 green LED to display power supply, 1 red LED to display error
3 Terminal number
4 Allocation of signal name
5 Terminal block for output signals (11-pin)
6 2 holes for wall-mounting with screws
7 DIN rail

Intended purpose

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g., CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.

The outputs are not galvanically isolated from each other.

The other electronic circuitry of the module is not galvanically isolated from the outputs or from the I/O bus.

The I/O module must not be used as communication interface module at CI590-CS31-HA bus modules.
**Functionality**

2 analog outputs, individually configurable for:
- Not used (default setting)
- \(-10 \text{ V} \ldots +10 \text{ V}\)
- \(0 \text{ mA} \ldots 20 \text{ mA}\)
- \(4 \text{ mA} \ldots 20 \text{ mA}\)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution of the analog channels</td>
<td></td>
</tr>
<tr>
<td>Voltage bipolar ((-10 \text{ V} \ldots +10 \text{ V}))</td>
<td>12 bits including sign</td>
</tr>
<tr>
<td>Current ((0 \text{ mA} \ldots 20 \text{ mA}; 4 \text{ mA} \ldots 20 \text{ mA}))</td>
<td>12 bits</td>
</tr>
<tr>
<td>LED displays</td>
<td>2 LEDs for process voltage and error messages</td>
</tr>
<tr>
<td>Internal supply</td>
<td>Via I/O bus</td>
</tr>
<tr>
<td>External supply</td>
<td>Via the terminals L+ (process voltage 24 V DC) and M (0 V DC); the M terminal is connected to the M terminal of the CPU via the I/O bus</td>
</tr>
</tbody>
</table>

**Connections**

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

If the output is configured as not used, the voltage and current output signals are undefined and must not be connected.

The connection is carried out by using a removable 9-pin and 11-pin terminal block. These terminal blocks differ in their connection system (spring terminals or screw terminals, cable mounting from the front or from the side). The terminal blocks are not included in the module's scope of delivery and must be ordered separately.
The assignment of the terminals:

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>11</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>12</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>13</td>
<td>O0U+</td>
<td>Voltage output of channel 0</td>
</tr>
<tr>
<td>14</td>
<td>O0I+</td>
<td>Current output of channel 0</td>
</tr>
<tr>
<td>15</td>
<td>O1U+</td>
<td>Voltage output of channel 1</td>
</tr>
<tr>
<td>16</td>
<td>O1I+</td>
<td>Current output of channel 1</td>
</tr>
<tr>
<td>17</td>
<td>O01-</td>
<td>Negative pole of channels O0 and O1</td>
</tr>
<tr>
<td>18</td>
<td>SG</td>
<td>Shield grounding</td>
</tr>
<tr>
<td>19</td>
<td>L+</td>
<td>Process voltage L+ (24 V DC)</td>
</tr>
<tr>
<td>20</td>
<td>M</td>
<td>Process voltage M (0 V DC)</td>
</tr>
</tbody>
</table>

The internal power supply voltage for the module’s circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals UP/L+ and ZP/M of the CPU/communication interface module increases by 5 mA per AO561.

The external power supply connection is carried out via the L+ (+24 V DC) and the M (0 V DC) terminals. The M terminal is electrically interconnected to the M/ZP terminal of the CPU/communication interface module.

NOTICE!

Risk of imprecise and faulty measurements!

Analog signals may be distorted seriously by external electromagnetic influences.

Use shielded wires when wiring analog signal sources. The cable shield must be grounded at both ends of the cable. Provide a potential equalisation of a low resistance to avoid high potential differences between different parts of the plant.
NOTICE!

Risk of damaging the PLC modules!
The PLC modules must not be removed while the plant is connected to a power supply.
Make sure that all voltage sources (supply and process voltage) are switched off before you
– connect or disconnect any signal or terminal block
– remove or replace a module.

NOTICE!

Risk of damaging the PLC modules!
Overvoltages and short circuits might damage the PLC modules.
– Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
– Never connect any voltages or signals to reserved terminals (marked with →). Reserved terminals may carry internal voltages.

The module provides several diagnosis functions \( \text{\textcopyright \ Chapter 5.2.4.1.4.7 “Diagnosis” on page 650.} \)

Table 146: Connection of analog actuators to the analog output module AO561

Connection of analog voltage actuators

\[
\begin{array}{ccccccc}
24 \text{ VDC} & 10 & 11 & 12 & 13 & 14 & 15 & 16 & 17 & 18 & 19 & 20 \\
& & & & \text{O0U+} & \text{O0I+} & \text{O1U+} & \text{O1I+} & \text{O01-} & \text{SG} & \text{L+} & \text{M} \\
\end{array}
\]

Connection of analog current actuators

\[
\begin{array}{ccccccc}
24 \text{ VDC} & 10 & 11 & 12 & 13 & 14 & 15 & 16 & 17 & 18 & 19 & 20 \\
& & & & \text{O0U+} & \text{O0I+} & \text{O1U+} & \text{O1I+} & \text{O01-} & \text{SG} & \text{L+} & \text{M} \\
\end{array}
\]

The output signal is undefined if the supply voltage at the L+ terminal is below 10 V. This can, for example, occur if the supply voltage has a slow ramp-up / ramp-down behavior and must be foreseen when planning the installation.

If the output is configured in current mode, the voltage output signal is undefined and must not be connected.
If the output is configured in voltage mode, the current output signal is undefined and must not be connected.
I/O configuration

The analog output module AO561 does not store configuration data itself.

Parameterization

The arrangement of the parameter data is performed with Automation Builder software. The parameter data directly influences the functionality of modules. For non-standard applications, it is necessary to adapt the parameters to your system configuration.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, Type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Intern</td>
<td>6515 ¹)</td>
<td>WORD</td>
<td>0x1973</td>
<td>0</td>
<td>65535</td>
<td>xx01</td>
</tr>
<tr>
<td>Ignore module</td>
<td>No</td>
<td>0</td>
<td>BYTE</td>
<td>No</td>
<td>0</td>
<td>0x00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameter length</td>
<td>Intern</td>
<td>4</td>
<td>BYTE</td>
<td>0</td>
<td>0</td>
<td>255</td>
<td>xx02 ²)</td>
</tr>
<tr>
<td>Check Supply</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>On</td>
<td>0</td>
<td>0x01</td>
<td></td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Analog Data Format</td>
<td>Default</td>
<td>0</td>
<td>BYTE</td>
<td>Default</td>
<td>0x00</td>
<td>255</td>
<td></td>
</tr>
</tbody>
</table>

¹) with CS31 and addresses less than 70, the value is increased by 1
²) Value is hexadecimal: HighByte is slot (xx: 0 ... 7), LowByte is index (1 ... n)

GSD file:

```
Ext_User_Prm_Data_Len = 0x07
Ext_User_Prm_Data_Const(0) = 0x74, 0x19, 0x04, \n0x01, 0x00, \n0x00, 0x00, 0x00, 0x00;
```

Output channel (2x)

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, Type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel configuration</td>
<td>see table ²)</td>
<td>see table ²)</td>
<td>BYTE</td>
<td>0</td>
<td>0</td>
<td>65535</td>
</tr>
</tbody>
</table>

²) Value is hexadecimal: HighByte is slot (xx: 0 ... 7), LowByte is index (1 ... n)
### Table 147: Channel configuration

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes for the analog outputs, individually configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not used (default)</td>
</tr>
<tr>
<td>128</td>
<td>-10 V ... +10 V</td>
</tr>
<tr>
<td>129</td>
<td>0 mA ... 20 mA</td>
</tr>
<tr>
<td>130</td>
<td>4 mA ... 20 mA</td>
</tr>
</tbody>
</table>

#### Diagnosis

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier</th>
<th>AC500 display</th>
<th>&lt;- Display in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Comp</td>
<td>Dev</td>
<td>Mod</td>
<td>Ch</td>
<td>Err</td>
<td>PS501 PLC Browser</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Byte 6 Bit 6 ... 7</th>
<th>Byte 3</th>
<th>Byte 4</th>
<th>Byte 5 Byte 6 Bit 0 ... 5</th>
<th>PNIO diagnosis block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Interface</td>
<td>Device</td>
<td>Module</td>
<td>Channel</td>
</tr>
<tr>
<td>--------</td>
<td>------------</td>
<td>--------</td>
<td>--------</td>
<td>---------</td>
</tr>
</tbody>
</table>

*Remarks:*

Hardware descriptions
Device specifications > I/O modules

ADR010583, 1, en_US
650
2024/01/05
1) In AC500 the following interface identifier applies:
14 = I/O bus, 11 = COM1 (e.g. CS31 bus), 12 = COM2.
The PNIO diagnosis block does not contain this identifier.

2) With "Device" the following allocation applies:
31 = module itself, 1 ... 10 = expansion module 1 ... 10, ADR = hardware
address (e.g. of the DC551-CS31)

3) With "Module" the following allocation applies depending on the master:
Module error: I/O bus or PNIO: 31 = module itself; COM1/COM2: 1 ... 10 =
exansion 1 ... 10
Channel error: I/O bus or PNIO = module type (3 = AO); COM1/COM2: 1 ... 10 =
exansion 1 ... 10

4) In case of module errors, with channel "31 = Module itself" is output.

State LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
<th>LED flashes</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR</td>
<td>Process voltage</td>
<td>Green</td>
<td>CPU module voltage or external 24 V DC supply voltage is missing</td>
<td>3.3 V system voltage (l/O bus) and external 24 V DC supply voltage are present</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td>24 V DC via terminal</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ERR</td>
<td>Channel or module error</td>
<td>Red</td>
<td>No error or process voltage is missing</td>
<td>Severe error in the module</td>
<td>Error on 1 or more channels of the module</td>
</tr>
</tbody>
</table>

Output ranges

<table>
<thead>
<tr>
<th>Range</th>
<th>-10 ... +10 V</th>
<th>0 ... 20 mA</th>
<th>4 ... 20 mA</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Decimal</td>
<td>Hex.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overflow</td>
<td>&gt;11.7589</td>
<td>32767</td>
<td>7FFF</td>
<td></td>
</tr>
<tr>
<td>Value too high</td>
<td>11.7589</td>
<td>23.5178</td>
<td>22.8142</td>
<td>32511</td>
</tr>
<tr>
<td></td>
<td>10.0058</td>
<td>20.0058</td>
<td>20.0058</td>
<td>27648</td>
</tr>
<tr>
<td></td>
<td>0.0058</td>
<td>0.0058</td>
<td>4.0058</td>
<td>0008</td>
</tr>
<tr>
<td>Normal range</td>
<td>10.0000</td>
<td>20.0000</td>
<td>20.0000</td>
<td>27648</td>
</tr>
<tr>
<td>Normal range or value too low</td>
<td>0.0000</td>
<td>0</td>
<td>4</td>
<td>0000</td>
</tr>
</tbody>
</table>
Range -10 ... +10 V 0 ... 20 mA 4 ... 20 mA Digital value

<table>
<thead>
<tr>
<th>Range</th>
<th>Decimal</th>
<th>Hex.</th>
</tr>
</thead>
<tbody>
<tr>
<td>-10.0000</td>
<td>-10</td>
<td>FFF6</td>
</tr>
<tr>
<td>-10.0058</td>
<td>-16</td>
<td>FFF0</td>
</tr>
<tr>
<td>-16</td>
<td>-4864</td>
<td>ED00</td>
</tr>
<tr>
<td>-0.0058</td>
<td>-6912</td>
<td>E500</td>
</tr>
<tr>
<td>0</td>
<td>-27648</td>
<td>9400</td>
</tr>
</tbody>
</table>

Value too low -10.0058 -27664 93F0

Underflow <-11.7589 <0.0000 -32768 8000

The represented resolution corresponds to 12 bits including sign.

Technical data

Technical data of the module

The system data of AC500-eCo apply.

*Chapter 5.1.1 “System data AC500-eCo” on page 159*

Only additional details are therefore documented below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltage L+</td>
<td>Terminal 19 for L+ (+24 V DC) and terminal 20 for M (0 V)</td>
</tr>
<tr>
<td>Connections</td>
<td></td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Current consumption</td>
<td>0.1 A + output load</td>
</tr>
<tr>
<td>Inrush current (at power-up)</td>
<td>0.05 A·s</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5 %</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Protection fuse for L+</td>
<td>Recommended</td>
</tr>
<tr>
<td>Current consumption from 24 V DC power supply at the terminals UP/L+ and ZP/M of the CPU/communication interface module</td>
<td>Ca. 5 mA</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>No</td>
</tr>
<tr>
<td>Surge-voltage (max.)</td>
<td>35 V DC for 0.5 s</td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>3.1 W</td>
</tr>
<tr>
<td>Weight</td>
<td>Ca. 120 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>
NOTICE!
All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

Technical data of the analog outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>2 configurable voltage or current outputs</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 (2 channels per group)</td>
</tr>
<tr>
<td>Connection of the signals O0U- and O1U+</td>
<td>Terminals 13 and 15</td>
</tr>
<tr>
<td>Connection of the signals O0I+ and O1I+</td>
<td>Terminals 14 and 16</td>
</tr>
<tr>
<td>Output type</td>
<td>Bipolar with voltage, unipolar with current</td>
</tr>
<tr>
<td>Resolution</td>
<td>12 bits including sign</td>
</tr>
<tr>
<td>Conversion error of the analog values</td>
<td>Typ. ( \pm 0.5% ) of full scale at +25 °C</td>
</tr>
<tr>
<td>caused by non-linearity, adjustment error at factory and resolution within the normal range</td>
<td>Max. ( \pm 2% ) of full scale at 0 °C ... +60 °C or EMC disturbances</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>No</td>
</tr>
<tr>
<td>Output Resistance (load) as current output</td>
<td>0 ( \Omega ) ... 500 ( \Omega )</td>
</tr>
<tr>
<td>Output load ability as voltage output</td>
<td>( \pm 2,\text{mA} ) max.</td>
</tr>
<tr>
<td>Output data length</td>
<td>4 bytes</td>
</tr>
<tr>
<td>Relationship between output signal and hex code</td>
<td>( \text{&amp;} ) Chapter 5.2.4.4.1.4.9 “Output ranges” on page 651</td>
</tr>
<tr>
<td>Unused outputs</td>
<td>Must not be connected and must be configured as &quot;unused&quot;</td>
</tr>
<tr>
<td>Overvoltage protection</td>
<td>Yes, up to 30 V DC</td>
</tr>
<tr>
<td>Max. cable length (conductor cross section &gt; 0.14 mm(^2))</td>
<td></td>
</tr>
<tr>
<td>Unshielded wire</td>
<td>10 m</td>
</tr>
<tr>
<td>Shielded wire</td>
<td>100 m</td>
</tr>
</tbody>
</table>
Dimensions

The dimensions are in mm and in brackets in inch.

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1TNE 968 902 R1201</td>
<td>AO561, analog output module, 2 AO, U/I</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3102</td>
<td>Terminal block TA563-11, 11 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3104</td>
<td>Terminal block TA564-11, 11 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3106</td>
<td>Terminal block TA565-11, 11 pins, spring front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
AX561 - Analog input/output module

Features

- 4 configurable analog inputs (I0 ... I3) in 1 group
- 2 configurable analog outputs (O0 and O1) in 1 group
- Resolution: 12 bits including sign

Intended purpose

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g., CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.
The inputs are not galvanically isolated from each other.
The outputs are not galvanically isolated from each other.
All other circuitry of the module is not galvanically isolated from the inputs/outputs or from the I/O bus.

The I/O module must not be used as a decentralized I/O module with CI590-CS31-HA communication interface modules.

**Functionality**

4 analog inputs, individually configurable for
- Not used (default)
- -2.5 V ... +2.5 V
- -5 V ... + 5 V
- 0 V ... +5 V
- 0 V ... +10 V
- 0 mA ... 20 mA
- 4 mA ... 20 mA

2 analog outputs, individually configurable for
- Not used (default)
- -10 V ... +10 V
- 0 mA ... 20 mA
- 4 mA ... 20 mA

**Parameter** | **Value**
--- | ---
Resolution of the analog channels | 12 bits including sign
Voltage bipolar (-2.5 V ... +2.5 V; -5 V ... +5 V) | 12 bits including sign
Voltage unipolar (0 V ... 5 V; 0 V ... 10 V) | 12 bits
Current (0 mA ... 20 mA; 4 mA ... 20 mA) | 12 bits
LED displays | 2 LEDs for process voltage and error messages
Internal supply | Via I/O bus
External supply | Via the terminals L+ (process voltage 24 V DC) and M (0 V DC); the M terminal is connected to the M terminal of the CPU via the I/O bus

**Connections**

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.
If the output is configured as not used, the voltage and current output signals are undefined and must not be connected.

The connection is carried out by using a removable 9-pin and 11-pin terminal block. These terminal blocks differ in their connection system (spring terminals or screw terminals, cable mounting from the front or from the side). The terminal blocks are not included in the module’s scope of delivery and must be ordered separately.

![Terminal block diagram]

**Fig. 87: Internal construction of the analog inputs and outputs**

**Table 148: Assignment of the terminals**

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>R0</td>
<td>Burden resistor for input signal 0 for current sensing</td>
</tr>
<tr>
<td>2</td>
<td>I0+</td>
<td>Positive pole of input signal 0</td>
</tr>
<tr>
<td>3</td>
<td>I0-</td>
<td>Negative pole of input signal 0</td>
</tr>
<tr>
<td>4</td>
<td>R1</td>
<td>Burden resistor for input signal 1 for current sensing</td>
</tr>
<tr>
<td>5</td>
<td>I1+</td>
<td>Positive pole of input signal 1</td>
</tr>
<tr>
<td>6</td>
<td>I1-</td>
<td>Negative pole of input signal 1</td>
</tr>
</tbody>
</table>
### Terminal Signal Description

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>R2</td>
<td>Burden resistor for input signal 2 for current sensing</td>
</tr>
<tr>
<td>8</td>
<td>I2+</td>
<td>Positive pole of input signal 2</td>
</tr>
<tr>
<td>9</td>
<td>I2-</td>
<td>Negative pole of input signal 2</td>
</tr>
<tr>
<td>10</td>
<td>R3</td>
<td>Burden resistor for input signal 3 for current sensing</td>
</tr>
<tr>
<td>11</td>
<td>I3+</td>
<td>Positive pole of input signal 3</td>
</tr>
<tr>
<td>12</td>
<td>I3-</td>
<td>Negative pole of input signal 3</td>
</tr>
<tr>
<td>13</td>
<td>O0U+</td>
<td>Voltage output of channel 0</td>
</tr>
<tr>
<td>14</td>
<td>O0I+</td>
<td>Current output of channel 0</td>
</tr>
<tr>
<td>15</td>
<td>O1U+</td>
<td>Voltage output of channel 1</td>
</tr>
<tr>
<td>16</td>
<td>O1I+</td>
<td>Current output of channel 1</td>
</tr>
<tr>
<td>17</td>
<td>O01-</td>
<td>Negative pole of channels O0 and O1</td>
</tr>
<tr>
<td>18</td>
<td>SG</td>
<td>Shield grounding</td>
</tr>
<tr>
<td>19</td>
<td>L+</td>
<td>Process voltage L+ (24 V DC)</td>
</tr>
<tr>
<td>20</td>
<td>M</td>
<td>Process voltage M (0 V DC)</td>
</tr>
</tbody>
</table>

The internal power supply voltage for the module's circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals UP/L+ and ZP/M of the CPU/communication interface module increases by 5 mA per AX561.

The external power supply connection is carried out via the L+ (+24 V DC) and the M (0 V DC) terminals. The M terminal is interconnected to the M/ZP terminal of the CPU/communication interface module.

---

### NOTICE!

**Risk of imprecise and faulty measurements!**

Analog signals may be distorted seriously by external electromagnetic influences.

Use shielded wires when wiring analog signal sources. The cable shield must be grounded at both ends of the cable. Provide a potential equalisation of a low resistance to avoid high potential differences between different parts of the plant.

---
WARNING!

Removal/Insertion under power

The devices are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you
– connect or disconnect any signal or terminal block
– remove, mount or replace a module.

Disconnecting any powered devices while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The devices must not be opened when in operation. The same applies to the network interfaces.

NOTICE!

Risk of damaging the PLC modules!

Overvoltages and short circuits might damage the PLC modules.
– Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
– Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

The module provides several diagnosis functions *Chapter 5.2.4.4.1.5.7 “Diagnosis” on page 665.*

![Fig. 88: Example of the internal construction of the analog input AI0 (analog inputs AI1 ... AI3 are designed in the same way)](image)

CAUTION!

Risk of damaging the analog input!

The 250 Ω input resistor can be damaged by overcurrent.

Make sure that the current through the resistor never exceeds 30 mA.

The following figures are an example of the connection of analog sensors (voltage) to the input I0 of the analog input/output module AX561. Proceed with the inputs I1 ... I3 in the same way.
Table 149: Example of the connection of analog sensors (voltage) to the input I0 of the analog input/output module AX561 (Proceed with the inputs I1 to I3 in the same way)
<table>
<thead>
<tr>
<th>Connection of active-type analog sensors (voltage)</th>
<th>Connection of passive-type analog sensors (voltage)</th>
</tr>
</thead>
<tbody>
<tr>
<td>-2.5 V ... 2.5 V</td>
<td>-2.5 V ... 2.5 V</td>
</tr>
<tr>
<td>-5 V ... 5 V</td>
<td>-5 V ... 5 V</td>
</tr>
<tr>
<td>0 V ... 5 V</td>
<td>0 V ... 5 V</td>
</tr>
<tr>
<td>0 V ... 10 V</td>
<td>0 V ... 10 V</td>
</tr>
</tbody>
</table>
Table 150: Example of the connection of analog sensors (current) to the input I0 of the analog input/output module AX561 (Proceed with the inputs I1 ... I3 in the same way)

<table>
<thead>
<tr>
<th>Connection of active-type analog sensors (current)</th>
<th>Connection of passive-type analog sensors (current)</th>
</tr>
</thead>
</table>

24 VDC — 1 — 2 — 3 — I0+ — I0- — 18 SG — 19 L+ — 20 M

[Diagram of connections]
<table>
<thead>
<tr>
<th>Connection of active-type analog sensors (voltage)</th>
<th>Connection of passive-type analog sensors (voltage)</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 mA ... 20 mA</td>
<td>4 mA ... 20 mA</td>
</tr>
<tr>
<td>0 mA ... 20 mA</td>
<td>0 mA ... 20 mA</td>
</tr>
</tbody>
</table>

Table 151: Example of the connection of analog actuators to the analog input/output module AX561

The output signal is undefined if the supply voltage at the L+ terminal is below 10 V. This can, for example, occur if the supply voltage has a slow ramp-up / ramp-down behavior and must be foreseen when planning the installation.

If the output is configured in current mode, the voltage output signal is undefined and must not be connected.

If the output is configured in voltage mode, the current output signal is undefined and must not be connected.

The meaning of the LEDs is described in the displays chapter “Chapter 5.2.4.4.1.5.8 “State LEDs” on page 666.

I/O configuration

The I/O module does not store configuration data itself.

Parameterization

The arrangement of the parameter data is performed with Automation Builder software.

The parameter data directly influences the functionality of modules.

For non-standard applications, it is necessary to adapt the parameters to your system configuration.
<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal Value</th>
<th>Internal value, Type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Internal 6520</td>
<td>WORD</td>
<td>0x1978</td>
<td>0</td>
<td>65535</td>
<td>xx01</td>
<td></td>
</tr>
<tr>
<td>Ignore module</td>
<td>No</td>
<td>0</td>
<td>BYTE</td>
<td>No</td>
<td>0x00</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal 8</td>
<td>BYTE</td>
<td>0</td>
<td>0</td>
<td>255</td>
<td>xx02</td>
<td></td>
</tr>
<tr>
<td>Check Supply</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>On</td>
<td>0x01</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Analog Data Format</td>
<td>Default</td>
<td>0</td>
<td>BYTE</td>
<td>Default</td>
<td>0x00</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1) With CS31 and addresses less than 70, the value is increased by 1
2) Value is hexadecimal: HighByte is slot (xx: 0 ... 7), LowByte is index (1 ... n)

GSD file:

```
Ext_User_Prm_Data_Len = 0x0B
Ext_User_Prm_Data_Const(0) = 0x0B, 0x79, 0x19, 0x08, \n                            0x01, 0x00, \n                            0x00, 0x00, 0x00, 0x00, \n                            0x00, 0x00;
```

Input channel (4x)

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, Type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel configuration</td>
<td>see table 2)</td>
<td>see table 2)</td>
<td>BYTE</td>
<td>0</td>
<td>0x00</td>
<td>65535</td>
</tr>
</tbody>
</table>

**Table 152: Channel configuration 2)**

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes for the analog inputs, individually configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not used (default)</td>
</tr>
<tr>
<td>1</td>
<td>0 V ... +10 V</td>
</tr>
<tr>
<td>3</td>
<td>0 mA ... 20 mA</td>
</tr>
<tr>
<td>4</td>
<td>4 mA ... 20 mA</td>
</tr>
<tr>
<td>6</td>
<td>0 V ... +5 V</td>
</tr>
<tr>
<td>7</td>
<td>-5 V ... +5 V</td>
</tr>
<tr>
<td>20</td>
<td>-2.5 V ... +2.5 V</td>
</tr>
</tbody>
</table>
Output channel (2x)

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, Type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel configuration</td>
<td>see see table 2)</td>
<td>see see table 2)</td>
<td>BYTE 0</td>
<td>0x00 see table 2)</td>
<td>0</td>
<td>65535</td>
</tr>
</tbody>
</table>

Table 153: Channel configuration 2)

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes for the analog outputs, individually configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not used (default)</td>
</tr>
<tr>
<td>128</td>
<td>-10 V ... + 10 V</td>
</tr>
<tr>
<td>129</td>
<td>0 mA ... 20 mA</td>
</tr>
<tr>
<td>130</td>
<td>4 mA ... 20 mA</td>
</tr>
</tbody>
</table>

Diagnosis

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier 000 ... 063</th>
<th>AC500 display</th>
<th>← Display in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class Comp Dev Mod Ch Err</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Byte 6 Bit 6 ... 7 - Byte 3 Byte 4 Byte 5 Byte 6 Bit 0 ... 5 PNIO diagnosis block</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1)</td>
<td>2)</td>
<td>3)</td>
<td>4)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Module error

| 3 | 14 | 1 ... 10 | 31 | 31 | 19 | Checksum error in the I/O module | Replace I/O module |
| 11 / 12 | ADR | 1 ... 10 |     |     |     |                                    |                    |
| 3 | 14 | 1 ... 10 | 31 | 31 | 9  | Overflow diagnosis buffer        | Restart            |
| 11 / 12 | ADR | 1 ... 10 |     |     |     |                                    |                    |
| 3 | 14 | 1 ... 10 | 31 | 31 | 26 | Parameter error                   | Check master      |
| 11 / 12 | ADR | 1 ... 10 |     |     |     |                                    |                    |
| 3 | 14 | 1 ... 10 | 31 | 31 | 11 | Process voltage too low           | Check process voltage |
| 11 / 12 | ADR | 1 ... 10 |     |     |     |                                    |                    |

Channel error

| 4 | 14 | 1 ... 10 | 1   | 0 ... 3 | 48 | Analog value overflow at an analog input | Check input value or terminal |
| 11 / 12 | ADR | 1 ... 10 |     |     |     |                                        |                    |
| 4 | 14 | 1 ... 10 | 1   | 0 ... 3 | 7  | Analog value underflow at an analog input | Check input value |
## Hardware descriptions

Device specifications > I/O modules

### Error Messages and Remedy

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error Identifier</th>
<th>Error Message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>3</td>
<td>0 ... 1</td>
<td>48</td>
<td>Analog value overflow at an analog output</td>
<td>Check output value or terminal</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>3</td>
<td>0 ... 1</td>
<td>7</td>
<td>Analog value underflow at an analog output</td>
<td>Check output value</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Remarks:**

1) In AC500 the following interface identifier applies:

14 = I/O bus, 11 = COM1 (e.g. CS31 bus), 12 = COM2.

The PNIO diagnosis block does not contain this identifier.

2) With "Device" the following allocation applies:

31 = module itself, 1 ... 10 = expansion module 1 ... 10, ADR = hardware address (e.g. of the DC551-CS31)

3) With "Module" the following allocation applies dependent of the master:

Module error: I/O bus or PNIO: 31 = module itself; COM1/COM2: 1 ... 10 = expansion 1 ... 10

Channel error: I/O bus or PNIO = module type (1 = AI, 3 = AO); COM1/COM2: 1 ... 10 = expansion 1 ... 10

4) In case of module errors, with channel "31 = Module itself" is output.

### State LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
<th>LED flashes</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR</td>
<td>Process voltage 24 V DC via terminal</td>
<td>Green</td>
<td>CPU module voltage or external 24 V DC supply voltage is missing</td>
<td>3.3 V system voltage (I/O bus) and external 24 V DC supply voltage are present</td>
<td>---</td>
</tr>
<tr>
<td>ERR</td>
<td>Channel or module error</td>
<td>Red</td>
<td>No error or process voltage is missing</td>
<td>Severe error in the module</td>
<td>Error on 1 or more channels of the module</td>
</tr>
</tbody>
</table>
Measuring ranges

**CAUTION!**
**Risk of wrong analog input values!**
The analog input values may be wrong if the measuring range of the inputs are exceeded.
Make sure that the analog signal at the connection terminals is always within the signal range.

<table>
<thead>
<tr>
<th>Range</th>
<th>-2.5 V ... +2.5 V</th>
<th>-5 V ... +5 V</th>
<th>0 V ... 5 V</th>
<th>0 V ... 10 V</th>
<th>0 mA ... 20 mA</th>
<th>4 mA ... 20 mA</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Decimal</td>
<td>Hex.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overflow</td>
<td>&gt;2.9397</td>
<td>&gt;5.8795</td>
<td>&gt;5.8795</td>
<td>&gt;11.7589</td>
<td>&gt;23.5178</td>
<td>&gt;22.8142</td>
<td>32767</td>
</tr>
<tr>
<td>Measured value too high</td>
<td>2.9397</td>
<td>5.8795</td>
<td>5.8795</td>
<td>11.7589</td>
<td>23.5178</td>
<td>22.8142</td>
<td>32511</td>
</tr>
<tr>
<td></td>
<td>2.5014</td>
<td>5.0029</td>
<td>5.0015</td>
<td>10.0029</td>
<td>20.0058</td>
<td>:</td>
<td>:</td>
</tr>
<tr>
<td>Normal range</td>
<td>2.5000</td>
<td>5.0000</td>
<td>5.0000</td>
<td>10.0000</td>
<td>20.0000</td>
<td>20.0000</td>
<td>27648</td>
</tr>
<tr>
<td>Normal range or measured value too low</td>
<td>0.0014</td>
<td>0.0029</td>
<td>0.0015</td>
<td>0.0029</td>
<td>0.0058</td>
<td>:</td>
<td>:</td>
</tr>
<tr>
<td></td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0</td>
<td>4</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Measured value too low</td>
<td>-2.5014</td>
<td>-5.0000</td>
<td>-5.0029</td>
<td>:</td>
<td>3.9942</td>
<td>-10</td>
<td>-16</td>
</tr>
<tr>
<td></td>
<td>-2.9398</td>
<td>-5.8795</td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>-16</td>
<td>-4864</td>
</tr>
<tr>
<td></td>
<td>-2.9398</td>
<td>-5.8795</td>
<td>:</td>
<td>:</td>
<td>-6912</td>
<td>0</td>
<td>E500</td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt;2.9398</td>
<td>&lt;5.8795</td>
<td>&lt;0.0300</td>
<td>&lt;0.0600</td>
<td>&lt;0.1200</td>
<td>&lt;0.1200</td>
<td>-32768</td>
</tr>
</tbody>
</table>

The represented resolution corresponds to 12 bits including sign.
Output ranges

<table>
<thead>
<tr>
<th>Range</th>
<th>-10 V ... +10 V mA</th>
<th>0 mA ... 20 mA</th>
<th>4 mA ... 20 mA</th>
<th>Digital value</th>
<th>Decimal</th>
<th>Hex.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overflow</td>
<td>&gt; 11.7589</td>
<td>&gt; 23.5178</td>
<td>&gt; 22.8142</td>
<td>32767</td>
<td>7FFF</td>
<td></td>
</tr>
<tr>
<td>Output value too high</td>
<td>11.7589</td>
<td>23.5178</td>
<td>22.8142</td>
<td>32511</td>
<td>7EFF</td>
<td></td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>10.0058</td>
<td></td>
<td></td>
<td>27664</td>
<td>6C10</td>
<td></td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>20.0058</td>
<td>27658</td>
<td>6C0A</td>
<td></td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>20.0058</td>
<td></td>
<td>27656</td>
<td>6C08</td>
<td></td>
</tr>
<tr>
<td>Normal range</td>
<td>10.0000</td>
<td>20.0000</td>
<td>20.0000</td>
<td>27648</td>
<td>6C00</td>
<td></td>
</tr>
<tr>
<td>Normal range or output value too low</td>
<td>0.0058</td>
<td></td>
<td>4.0058</td>
<td>16</td>
<td>0010</td>
<td></td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>10</td>
<td>000A</td>
<td></td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>0.0058</td>
<td>8</td>
<td>0008</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.0000</td>
<td>0</td>
<td>4</td>
<td>0</td>
<td>0000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>3.9942</td>
<td>-10</td>
<td>FFF6</td>
<td></td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>-4864</td>
<td>-16</td>
<td>FFF0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>-6912</td>
<td>E500</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>-27648</td>
<td>9400</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Output value too low</td>
<td>-10.0058</td>
<td>-27644</td>
<td>-32512</td>
<td>93F0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>-11.7589</td>
<td>&lt;0.0000</td>
<td>-32768</td>
<td>8000</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The represented resolution corresponds to 12 bits including sign.

Technical data

Technical data of the module

The system data of AC500-eCo apply.

Chapter 5.1.1 “System data AC500-eCo” on page 159

Only additional details are therefore documented below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltage L+</td>
<td>Terminal 19 for L+ (+24 V DC) and terminal 20 for M (0 V)</td>
</tr>
<tr>
<td>Connections</td>
<td>Terminal 19 for L+ (+24 V DC) and terminal 20 for M (0 V)</td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Current consumption via L+ terminal</td>
<td>0.14 A + output load</td>
</tr>
<tr>
<td>Inrush current (at power-up)</td>
<td>0.05 A</td>
</tr>
</tbody>
</table>
Parameter | Value
---|---
Max. ripple | 5 %
Protection against reversed voltage | Yes
Protection fuse for L+ | Recommended
Current consumption from 24 V DC power supply at the terminals UP/L+ and ZP/M of the CPU/communication interface module | Ca. 5 mA
Galvanic isolation | No
Surge-voltage (max.) | 35 V DC for 0.5 s
Max. power dissipation within the module | 4.9 W
Weight | Ca. 120 g
Mounting position | Horizontal or vertical
Cooling | The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.

**NOTICE!**
All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

### Technical data of the analog inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>4 individually configurable voltage or current inputs</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 (4 channels per group)</td>
</tr>
<tr>
<td>Resolution</td>
<td></td>
</tr>
</tbody>
</table>
| Unipolar | Voltage: 0 V ... +5 V; 0 V ... +10 V: 12 bits  
Current 0 mA ... 20 mA; 4 mA ... 20 mA: 12 bits |
| Bipolar | Voltage -2.5 V ... +2.5 V; -5 V ... +5 V: 12 bits including sign |
| Connection of the signals I0- to I3- | Terminals 3, 6, 9, 12 |
| Connection of the signals I0+ to I3+ | Terminals 2, 5, 8, 11 |
| Input type | Differential |
| Galvanic isolation | No galvanic isolation between the inputs and the I/O bus |
| Common mode input range | Signal voltage plus common mode voltage must be within ±12 V |
| Indication of the input signals | No |
| Channel input resistance | Voltage: >1 MΩ  
Current: ca. 250 Ω |
### Technical data of the analog outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
</table>
| Conversion error of the analog values caused by non-linearity, adjustment error at factory and resolution within the normal range | Typ. ±0.5 % of full scale (voltage)  
|                                                                          | ±0.5 % of full scale (current 0 mA ... 20 mA)  
|                                                                          | ±0.7 % of full scale (current 4 mA ... 20 mA) at +25 °C  
|                                                                          | Max. ±2 % of full scale (all ranges) at 0 °C ... +60 °C or EMC disturbance |
| Time constant of the input filter                                         | Voltage: 300 µs  
|                                                                          | Current: 300 µs |
| Relationship between input signal and hex code                           | Table on page 667 |
| Analog to digital conversion time                                         | Typ. 500 µs per channel |
| Unused inputs                                                            | Can be left open and should be configured as "unused" |
| Input data length                                                         | 8 bytes |
| Overvoltage protection                                                    | Yes, up to 30 V DC only for voltage input |
| Max. cable length (conductor cross section > 0.14 mm²)                   | Unshielded wire: 10 m  
|                                                                          | Shielded wire: 100 m |
| Output type                                                               | Bipolar with voltage, unipolar with current |
| Resolution                                                               | 12 bits including sign |
| Indication of the output signals                                         | No |
| Output resistance (load) as current output                                | 0 Ω ... 500 Ω |
| Output load ability as voltage output                                     | 2 mA max. |
| Relationship between input signal and hex code                           | Table Output Ranges Table on page 668 |

---

**Parameter** | **Value**
---|---
Number of channels per module | 2 configurable voltage or current outputs
Distribution of channels into groups | 1 (2 channels per group)
Connection of the signals O0U- and O1U+ | Terminals 13 and 15
Connection of the signals O0I+ and O1I+ | Terminals 14 and 16
Output type | Bipolar with voltage, unipolar with current
Resolution | 12 bits including sign
Indication of the output signals | No
Output resistance (load) as current output | 0 Ω ... 500 Ω
Output load ability as voltage output | 2 mA max.
Relationship between input signal and hex code | Table Output Ranges Table on page 668
Conversion error of the analog values caused by non-linearity, adjustment error at factory and resolution within the normal range | Typ. ±0.5 % of full scale (voltage)  
|                                                                          | ±0.5 % of full scale (current 0 mA ... 20 mA)  
|                                                                          | ±0.7 % of full scale (current 4 mA ... 20 mA) at +25°C  
|                                                                          | Max. ±2 % of full scale (all ranges) at 0 °C ... +60 °C or EMC disturbance |
### Parameter

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unused outputs</td>
<td>Can be left open and should be configured as &quot;unused&quot;</td>
</tr>
<tr>
<td>Output data length</td>
<td>4 bytes</td>
</tr>
<tr>
<td>Overvoltage protection</td>
<td>Yes, up to 30 V DC</td>
</tr>
<tr>
<td>Max. cable length (conductor cross section &gt; 0.14 mm²)</td>
<td></td>
</tr>
<tr>
<td>Unshielded wire</td>
<td>10 m</td>
</tr>
<tr>
<td>Shielded wire</td>
<td>100 m</td>
</tr>
</tbody>
</table>

### Dimensions

The dimensions are in mm and in brackets in inch.

### Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase * )</th>
</tr>
</thead>
<tbody>
<tr>
<td>1TNE 968 902 R1301</td>
<td>AX561, analog input/output module, 4 AI, 2 AO, U/I</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3101</td>
<td>Terminal block TA563-9, 9 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3102</td>
<td>Terminal block TA563-11, 11 pins, screw front, cable side, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>Part no.</td>
<td>Description</td>
<td>Product life cycle phase</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>1TNE 968 901 R3103</td>
<td>Terminal block TA564-9, 9 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3104</td>
<td>Terminal block TA564-11, 11 pins, screw front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3105</td>
<td>Terminal block TA565-9, 9 pins, spring front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
<tr>
<td>1TNE 968 901 R3106</td>
<td>Terminal block TA565-11, 11 pins, spring front, cable front, 6 pieces per unit</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

5.2.4.4.2 S500 and S500-XC
AC522 - Analog input/output module

Features

- 8 channels configurable as analog inputs/outputs in one group (2.0 ... 2.7 and 3.0 ... 3.7)
- Resolution 12 bits including sign
- Module-wise galvanically isolated
- XC version for use in extreme ambient conditions available
Intended purpose

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g., CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.

The configuration is performed by software. The modules are supplied with a process voltage of 24 V DC.

The inputs and outputs are galvanically isolated from all other circuitry of the module.

Functionality

8 channels configurable as analog inputs/outputs
If used as inputs, the following signal ranges are individually configurable:

- Unused (default setting)
- 0 V ... 10 V
- -10 V ... +10 V
- 0 mA ... 20 mA
- 4 mA ... 20 mA
- Pt100, -50 °C ... +400 °C (2-wire)
- Pt100, -50 °C ... +400 °C (3-wire), requires 2 channels
- Pt100, -50 °C ... +70 °C (2-wire)
- Pt100, -50 °C ... +70 °C (3-wire), requires 2 channels
- Pt1000, -50 °C ... +400 °C (2-wire)
- Pt1000, -50 °C ... +400 °C (3-wire), requires 2 channels
- Ni1000, -50 °C ... +150 °C (2-wire)
- Ni1000, -50 °C ... +150 °C (3-wire), requires 2 channels
- 0 V ... 10 V with differential inputs, requires 2 channels
- -10 V ... +10 V with differential inputs, requires 2 channels
- Digital signals (digital input)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution of the analog channels</td>
<td></td>
</tr>
<tr>
<td>Voltage -10 V ... +10 V</td>
<td>12 bits including sign</td>
</tr>
<tr>
<td>Voltage 0 V ... 10 V</td>
<td>12 bits</td>
</tr>
<tr>
<td>Current 0 mA ... 20 mA, 4 mA ... 20 mA</td>
<td>12 bits</td>
</tr>
<tr>
<td>Temperature</td>
<td>+0.1 °C</td>
</tr>
<tr>
<td>LED displays</td>
<td>10 LEDs for signals and error messages</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>External power supply</td>
<td>Via the terminals ZP and UP (process voltage 24 V DC)</td>
</tr>
<tr>
<td>Required terminal unit</td>
<td>TU515 or TU516 ☏ Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938</td>
</tr>
</tbody>
</table>

Connections

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The modules are plugged on an I/O terminal unit ☏ Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938. Properly position the modules and press until they lock in place. The terminal units are mounted on a DIN rail or with 2 screws plus the additional accessory for wall mounting ☏ Chapter 5.2.8.2.5 “TA526 - Wall mounting accessory” on page 1324.

The connection of the I/O channels is carried out using the 40 terminals of the I/O terminal unit. I/O modules can be replaced without re-wiring the terminal units.
The terminals 1.8, 2.8, 3.8 and 4.8 as well as 1.9, 2.9, 3.9 and 4.9 are electrically interconnected within the I/O terminal units and always have the same assignment, independent of the inserted module:

Terminals 1.8, 2.8, 3.8 and 4.8: process voltage \(UP = +24\ \text{V DC}\)

Terminals 1.9, 2.9, 3.9 and 4.9: process voltage \(ZP = 0\ \text{V DC}\)

The assignment of the other terminals:

<table>
<thead>
<tr>
<th>Terminals</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0 ... 1.7</td>
<td>Unused</td>
<td>Unused</td>
</tr>
<tr>
<td>2.0 ... 2.7</td>
<td>C0- ... C7-</td>
<td>Negative poles of the 8 analog inputs/outputs</td>
</tr>
<tr>
<td>3.0 ... 3.7</td>
<td>C0+ ... C7+</td>
<td>Positive poles of the analog inputs/outputs</td>
</tr>
<tr>
<td>4.0 ... 4.7</td>
<td>Unused</td>
<td>Unused</td>
</tr>
</tbody>
</table>

The negative poles of the analog inputs are connected to each other to form an "Analog Ground" signal for the module.

The negative poles of the analog outputs are connected to each other to form an "Analog Ground" signal for the module.

There is no galvanic isolation between the analog circuitry and ZP/UP. Therefore, the analog sensors must be galvanically isolated in order to avoid loops via the ground potential or the supply voltage.

Because of their common reference potential, analog current inputs cannot be circuited in series, neither within the module nor with channels of other modules.

For the open-circuit detection (wire break), each analog input channel is pulled up to "plus" by a high-resistance resistor. If nothing is connected, the maximum voltage will be read in then.

The internal power supply voltage for the module's circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 2 mA per I/O module. The external power supply connection is carried out via the UP (+24 V DC) and the ZP (0 V DC) terminals.
WARNING!
Removal/Insertion under power
Removal or insertion under power is permissible only if all conditions for hot swapping are fulfilled.

"Chapter 4.9.3 “Replace an I/O module with hot swap” on page 153"

The devices are not designed for removal or insertion under power when the conditions for hot swap do not apply. Because of unforeseeable consequences, it is not allowed to plug in or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you
– connect or disconnect any signal or terminal block
– remove, mount or replace a module.

Disconnecting any powered devices while they are energized in a hazardous location could result in an electric arc, which could create an ignition source resulting in fire or explosion.

Prior to proceeding, make sure that power is been disconnected and that the area has been thoroughly checked to ensure that flammable materials are not present.

The devices must not be opened when in operation. The same applies to the network interfaces.

NOTICE!
Risk of damaging the PLC modules!

– Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
– Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

Generally, analog signals must be laid in shielded cables. The cable shields must be grounded at both sides of the cables. In order to avoid unacceptable potential differences between different parts of the installation, low resistance equipotential bonding conductors must be laid.
Fig. 89: Connection of the I/O module

1 4 analog I/O channels
   as inputs for 0 V ... 10 V, -10 V ... +10 V, 0 mA ... 20 mA, 4 mA ... 20 mA, Pt100/Pt1000/Ni1000 digital signals
   as outputs for -10 V ... +10 V, 0 mA ... 20 mA, 4 mA ... 20 mA

2 4 analog I/O channels
   as inputs for 0 V ... 10 V, -10 V ... +10 V, 0 mA ... 20 mA, 4 mA ... 20 mA, Pt100/Pt1000/Ni1000 digital signals
   as outputs for -10 V ... +10 V

The process voltage must be included in the grounding concept of the control system (e.g. grounding the negative pole).

By installing equipotential bonding conductors between the different parts of the system, it must be made ensured that the potential difference between ZP and AGND never exceeds 1 V.

Connection of resistance thermometers in 2-wire configuration

When resistance thermometers (Pt100, Pt1000, Ni1000) are used, a constant current must flow through them to build the necessary voltage drop for the evaluation. For this, the I/O module provides a constant current source which is multiplexed over the 8 analog channels.
Connection of resistance thermometers in 3-wire configuration

When resistance thermometers (Pt100, Pt1000, Ni1000) are used, a constant current must flow through them to build the necessary voltage drop for the evaluation. For this, the I/O module provides a constant current source which is multiplexed over the max. 8 (depending on the configuration) analog channels.
1 Return line
2 Twisted pair within the cable

If several measuring points are adjacent to each other, only one return line is necessary. This saves wiring costs.

With the 3-wire configuration, two adjacent analog channels belong together (e.g. the channels 0 and 1). In this case, both channels are configured according to the desired operating mode. The lower address must be the even address (channel 0), the next higher address must be the odd address (channel 1).

The constant current of one channel flows through the resistance thermometer. The constant current of the other channel flows through one of the cores. The module calculates the measured value from the two voltage drops and stores it under the input with the higher channel number (e.g. C1).

In order to keep measuring errors as small as possible, it is necessary to have all the involved conductors in the same cable. All the conductors must have the same cross section.

<table>
<thead>
<tr>
<th>Resistance</th>
<th>Temperature Range</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pt100</td>
<td>-50 °C ... +70 °C</td>
<td>3-wire configuration, two channels used</td>
</tr>
<tr>
<td>Pt100</td>
<td>-50 °C ... +400 °C</td>
<td>3-wire configuration, two channels used</td>
</tr>
<tr>
<td>Pt1000</td>
<td>-50 °C ... +400 °C</td>
<td>3-wire configuration, two channels used</td>
</tr>
<tr>
<td>Ni1000</td>
<td>-50 °C ... +150 °C</td>
<td>3-wire configuration, two channels used</td>
</tr>
</tbody>
</table>

The I/O module performs a linearization of the resistance characteristic.

In order to avoid error messages from unused analog input channels, it is useful to configure them as "unused".
Connection of active-type analog sensors (Voltage) with galvanically isolated power supply

By connecting the sensor's negative pole of the output voltage to AGND, the galvanically isolated voltage source of the sensor is referred to ZP.

By connecting to AGND the galvanically isolated voltage source of the sensor is referred to ZP. The following measuring ranges can be configured:

<table>
<thead>
<tr>
<th>Voltage</th>
<th>Range</th>
<th>Channels used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>0 V ... 10 V</td>
<td>1 channel used</td>
</tr>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

In order to avoid error messages or long processing times, it is useful to configure unused analog input channels as "unused".

Connection of active-type analog sensors (Current) with galvanically isolated power supply
The following measuring ranges can be configured:

<table>
<thead>
<tr>
<th>Current</th>
<th>0 mA ... 20 mA</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>4 mA ... 20 mA</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

Unused input channels can be left open-circuited, because they are of low resistance.

Connection of active-type analog sensors (Voltage) with no galvanically isolated power supply

![Diagram of connection](image)

**CAUTION!**
The potential difference between AGND and ZP at the module must not be greater than 1V, not even in case of long lines (see figure Terminal Assignment).

*If AGND does not get connected to ZP, the sensor current flows to ZP via the AGND line. The measuring signal is distorted, as a very small current flows through the voltage line. The total current through the PTC should not exceed 50 mA. This measuring method is therefore only suitable for short lines and small sensor currents. If there are bigger distances, the difference measuring method should be applied.*

<table>
<thead>
<tr>
<th>Voltage</th>
<th>0 V ... 10 V</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V *)</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

*) if the sensor can provide this signal range

In order to avoid error messages or long processing times, it is useful to configure unused analog input channels as "unused".
Connection of passive-type analog sensors (Current)

<table>
<thead>
<tr>
<th>Current</th>
<th>4 mA ... 20 mA</th>
<th>1 channel used</th>
</tr>
</thead>
</table>

**CAUTION!**
If, during initialization, an analog current sensor supplies more than 25 mA for more than 1 second to an analog input, this input is switched off by the module (input protection). In such cases, it is recommended to protect the analog input by a 10-volt Zener diode (in parallel to I+ and ZP). But, in general, sensors with fast initialization or without current peaks higher than 25 mA are preferrable.

Unused input channels can be left open-circuited because they are of low resistance.

Connection of active-type analog sensors (Voltage) to differential inputs

Differential inputs are very useful if analog sensors are used which are remotely non-isolated (e.g. the minus terminal is remotely grounded).

The use of differential inputs helps to considerably increase the measuring accuracy and to avoid ground loops.

With differential input configurations, two adjacent analog channels belong together (e.g. the channels 0 and 1). In this case, both channels are configured according to the desired operating mode. The lower address must be the even address (channel 0), the next higher address must be the odd address (channel 1). The converted analog value is available at the higher address (channel 1).

The analog value is calculated by subtraction of the input value with the higher address from the input value of the lower address.

The converted analog value is available at the odd channel (higher address).

**CAUTION!**
The ground potential at the sensors must not have too large a potential difference with respect to ZP (max. ± 1 V within the full signal range). Otherwise, problems may occur concerning the common-mode input voltages of the involved analog inputs.
The negative pole of the sensor must be grounded next to the sensor.

<table>
<thead>
<tr>
<th>Voltage</th>
<th>0 V ... 10 V</th>
<th>with differential inputs, 2 channels used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V</td>
<td>with differential inputs, 2 channels used</td>
</tr>
</tbody>
</table>

In order to avoid error messages or long processing times, it is useful to configure unused analog input channels as "unused".

Use of analog inputs as digital inputs

Several (or all) analog inputs can be configured as digital inputs. The inputs are not galvanically isolated against the other analog channels.
Digital input  

<table>
<thead>
<tr>
<th>Digital input</th>
<th>24 V</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effect of incorrect input terminal connection</td>
<td>Wrong or no signal detected, no damage up to 35 V</td>
<td></td>
</tr>
</tbody>
</table>

Connection of analog output loads (Voltage, current)

Connection diagram

<table>
<thead>
<tr>
<th>Voltage</th>
<th>-10 V ... +10 V</th>
<th>Load max. ± 10 mA</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>0 mA ... 20 mA</td>
<td>Load 0 Ω ... 500 Ω</td>
<td>1 channel used</td>
</tr>
<tr>
<td>Current</td>
<td>4 mA ... 20 mA</td>
<td>Load 0 Ω ... 500 Ω</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

Only the channels 0 ... 3 can be configured as current output (0 mA ... 20 mA or 4 mA ... 20 mA).
Unused analog outputs can be left open-circuited.

Internal data exchange

<table>
<thead>
<tr>
<th>Analog inputs (words)</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog outputs (words)</td>
<td>8</td>
</tr>
</tbody>
</table>

I/O configuration

The module does not store configuration data itself. The 8 configurable analog channels are defined as inputs or outputs by the configuration, i.e. each of the configurable channels can used as input or output (or re-readable output in case of voltage input/output).

When a channel is used as input, the corresponding output must be configured unused.
When a channel is used as output, the corresponding input must be configured unused.
Parameterization

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot/Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Module ID</td>
<td>Internal</td>
<td>1520 (^1)</td>
<td>Word</td>
<td>1520</td>
<td>0</td>
<td>65535</td>
<td>0x0Y01</td>
</tr>
<tr>
<td>2</td>
<td>Ignore module (^2)</td>
<td>No Yes</td>
<td>0 1</td>
<td>Byte</td>
<td>No 0x00</td>
<td></td>
<td></td>
<td>not for FBP</td>
</tr>
<tr>
<td>3</td>
<td>Parameter length in bytes</td>
<td>Internal</td>
<td>37</td>
<td>Byte</td>
<td>37-CPU 37-FBP</td>
<td>0</td>
<td>255</td>
<td>0x0Y02</td>
</tr>
<tr>
<td>4</td>
<td>Check supply</td>
<td>Off On</td>
<td>0 1</td>
<td>Byte</td>
<td>On 0x01</td>
<td>0</td>
<td>1</td>
<td>0x0Y03</td>
</tr>
<tr>
<td>5</td>
<td>Analog data format</td>
<td>Default</td>
<td>0</td>
<td>Byte</td>
<td>Default 0x00</td>
<td>0</td>
<td></td>
<td>0x0Y04</td>
</tr>
<tr>
<td>6</td>
<td>Behaviour of outputs at communication errors</td>
<td>Off Last value Substitute value</td>
<td>0 1+(n<em>5) 2+(n</em>5), n ≤ 2</td>
<td>Byte</td>
<td>Off 0x00</td>
<td>0 2</td>
<td>0x0Y05</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Channel configuration Input channel 0</td>
<td>see table Channel configuration</td>
<td>Byte</td>
<td>Default 0x00</td>
<td>0 19</td>
<td>0x0Y06</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Channel monitoring Input channel 0</td>
<td>see table Channel monitoring</td>
<td>Byte</td>
<td>Default 0x00</td>
<td>0 3</td>
<td>0x0Y07</td>
<td></td>
<td></td>
</tr>
<tr>
<td>No.</td>
<td>Name</td>
<td>Value</td>
<td>Internal value</td>
<td>Internal value, type</td>
<td>Default</td>
<td>Min.</td>
<td>Max.</td>
<td>EDS Slot/Index</td>
</tr>
<tr>
<td>-----</td>
<td>------</td>
<td>-------</td>
<td>----------------</td>
<td>---------------------</td>
<td>---------</td>
<td>------</td>
<td>------</td>
<td>----------------</td>
</tr>
<tr>
<td>9 to 22</td>
<td>Channel configuration and channel monitoring of the input channels 1 to 7</td>
<td>see tables channel configuration and channel monitoring</td>
<td>Byte</td>
<td>Default</td>
<td>0x00 0x00</td>
<td>0</td>
<td>19</td>
<td>0x0Y08 to 0x0Y15</td>
</tr>
<tr>
<td>23</td>
<td>Channel configuration</td>
<td>see table Channel configuration</td>
<td>Byte</td>
<td>Default</td>
<td>0x00</td>
<td>0</td>
<td>130</td>
<td>0x0Y16</td>
</tr>
<tr>
<td>24</td>
<td>Channel monitoring</td>
<td>see table Channel monitoring</td>
<td>Byte</td>
<td>Default</td>
<td>0x00</td>
<td>0</td>
<td>3</td>
<td>0x0Y17</td>
</tr>
<tr>
<td>25</td>
<td>Substitute value</td>
<td>only valid for output channel 0</td>
<td>Word</td>
<td>Default</td>
<td>0x0000</td>
<td>0</td>
<td>65535</td>
<td>0x0Y18</td>
</tr>
<tr>
<td>26 to 31</td>
<td>Channel configuration and channel monitoring of the output channels 1 to 3</td>
<td>see tables channel configuration and channel monitoring</td>
<td>Byte</td>
<td>Default</td>
<td>0x00 0x00</td>
<td>0</td>
<td>130</td>
<td>0x0Y19 to 0x0Y1E</td>
</tr>
<tr>
<td>32</td>
<td>Channel configuration</td>
<td>see table Channel configuration</td>
<td>Byte</td>
<td>Default</td>
<td>0x00</td>
<td>0</td>
<td>128</td>
<td>0x0Y1F</td>
</tr>
<tr>
<td>No.</td>
<td>Name</td>
<td>Value</td>
<td>Internal value</td>
<td>Internal value, type</td>
<td>Default</td>
<td>Min.</td>
<td>Max.</td>
<td>EDS Slot/ Index</td>
</tr>
<tr>
<td>-----</td>
<td>------</td>
<td>-------</td>
<td>----------------</td>
<td>----------------------</td>
<td>---------</td>
<td>------</td>
<td>------</td>
<td>-----------------</td>
</tr>
<tr>
<td>33</td>
<td>Channel monitoring Output channel 4</td>
<td>see table Channel monitoring</td>
<td>Byte</td>
<td>Default 0x00</td>
<td>0</td>
<td>3</td>
<td>0x0Y20</td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>Channel configuration and channel monitoring of the output channels 5 to 7</td>
<td>see tables channel configuration and channel monitoring</td>
<td>Byte</td>
<td>Default 0x00 0x00</td>
<td>0 0</td>
<td>128 3</td>
<td>0x0Y21 to 0x0Y26</td>
<td></td>
</tr>
</tbody>
</table>

1) With CS31 and addresses less than 70 and FBP, the value is increased by 1
2) Not with FBP

GSD file:

```
Ext_User_Prm_Data_Len =
Ext_User_Prm_Data_Const(0) =
0x05, 0xf1, 0x25, \0x01, 0x00, 0x00, \
0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, \0x00, 0x00, 0x00, 0x00, 0x00, 0x00, \0x00, 0x00, 0x00, 0x00, 0x00, 0x00, \0x00, 0x00, 0x00, 0x00, 0x00, 0x00, \0x00, 0x00, 0x00, 0x00, 0x00, 0x00, \0x00, 0x00, 0x00, 0x00, 0x00, 0x00, \0x00, 0x00, 0x00, 0x00, 0x00, 0x00, \0x00, 0x00, 0x00, 0x00, 0x00, 0x00, \
```

Table 154: Input channel (8x)

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Channel configuration see table 2)</td>
<td>Byte</td>
<td>0 0x00 see table 2)</td>
</tr>
<tr>
<td>2</td>
<td>Channel monitoring see table 3)</td>
<td>Byte</td>
<td>0 0x00 see table 3)</td>
</tr>
</tbody>
</table>
### Table 155: Channel configuration

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes of the analog inputs, individually configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Unused (default)</td>
</tr>
<tr>
<td>1</td>
<td>Analog input 0 V ... 10 V</td>
</tr>
<tr>
<td>2</td>
<td>Digital input</td>
</tr>
<tr>
<td>3</td>
<td>Analog input 0 mA ... 20 mA</td>
</tr>
<tr>
<td>4</td>
<td>Analog input 4 mA ... 20 mA</td>
</tr>
<tr>
<td>5</td>
<td>Analog input -10 V ... +10 V</td>
</tr>
<tr>
<td>8</td>
<td>Analog input Pt100, -50 °C ... +400 °C (2-wire)</td>
</tr>
<tr>
<td>9</td>
<td>Analog input Pt100, -50 °C ... +400 °C (3-wire), requires 2 channels *)</td>
</tr>
<tr>
<td>10</td>
<td>Analog input 0 ... 10 V via differential inputs, requires 2 channels *)</td>
</tr>
<tr>
<td>11</td>
<td>Analog input -10 V ... +10 V via differential inputs, requires 2 channels *)</td>
</tr>
<tr>
<td>14</td>
<td>Analog input Pt100, -50 °C ... +70 °C (2-wire)</td>
</tr>
<tr>
<td>15</td>
<td>Analog input Pt100, -50 °C ... +70 °C (3-wire), requires 2 channels *)</td>
</tr>
<tr>
<td>16</td>
<td>Analog input Pt1000, -50 °C ... +400 °C (2-wire)</td>
</tr>
<tr>
<td>17</td>
<td>Analog input Pt1000, -50 °C ... +400 °C (3-wire), requires 2 channels *)</td>
</tr>
<tr>
<td>18</td>
<td>Analog input Ni1000, -50 °C ... +150 °C (2-wire)</td>
</tr>
<tr>
<td>19</td>
<td>Analog input Ni1000, -50 °C ... +150 °C (3-wire), requires 2 channels *)</td>
</tr>
</tbody>
</table>

*) In the operating modes with 3-wire configuration or with differential inputs, two adjacent analog inputs belong together (e.g. the channels 0 and 1). In these cases, both channels are configured in the desired operating mode. The lower address must be the even address (channel 0). The next higher address must be the odd address (channel 1). The converted analog value is available at the higher address (channel 1).

### Table 156: Channel monitoring

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Monitoring</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Plausibility, open-circuit (broken wire) and short circuit</td>
</tr>
<tr>
<td>1</td>
<td>Open-circuit and short-circuit</td>
</tr>
<tr>
<td>2</td>
<td>Plausibility</td>
</tr>
<tr>
<td>3</td>
<td>No monitoring</td>
</tr>
</tbody>
</table>

### Table 157: Output channel 0 (1 channel)

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Channel configuration</td>
<td>see table 4)</td>
<td>see table 4)</td>
<td>Byte</td>
<td>see table 4)</td>
</tr>
<tr>
<td>2</td>
<td>Channel monitoring</td>
<td>see table 5)</td>
<td>see table 5)</td>
<td>Byte</td>
<td>see table 5)</td>
</tr>
<tr>
<td>3</td>
<td>Substitute value</td>
<td>0 ... 65535</td>
<td>0 ... 0xffff</td>
<td>Word</td>
<td>0</td>
</tr>
</tbody>
</table>

*) In the operating modes with 3-wire configuration or with differential inputs, two adjacent analog inputs belong together (e.g. the channels 0 and 1). In these cases, both channels are configured in the desired operating mode. The lower address must be the even address (channel 0). The next higher address must be the odd address (channel 1). The converted analog value is available at the higher address (channel 1).
Table 158: Output channels 1 … 7 (7x)

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Channel configuration</td>
<td>see table 4)</td>
<td>Byte</td>
</tr>
<tr>
<td>2</td>
<td>Channel monitoring</td>
<td>see table 5)</td>
<td>Byte</td>
</tr>
</tbody>
</table>

Table 159: Channel configuration 4)

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes of the analog outputs, individually configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Unused (default)</td>
</tr>
<tr>
<td>128</td>
<td>Analog output -10 V ... +10 V</td>
</tr>
<tr>
<td>129</td>
<td>Analog output 0 mA ... 20 mA (not with the channels 4 ... 7)</td>
</tr>
<tr>
<td>130</td>
<td>Analog output 4 mA ... 20 mA (not with the channels 4 ... 7)</td>
</tr>
</tbody>
</table>

Table 160: Channel monitoring 5)

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Monitoring</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Plausibility, open circuit (broken wire) and short circuit (default)</td>
</tr>
<tr>
<td>1</td>
<td>Open-circuit (broken wire) and short-circuit</td>
</tr>
<tr>
<td>2</td>
<td>Plausibility</td>
</tr>
<tr>
<td>3</td>
<td>No monitoring</td>
</tr>
</tbody>
</table>

Table 161: Substitute value 6)

<table>
<thead>
<tr>
<th>Intended behavior of output channel when the control system stops</th>
<th>Required setting of the module parameter &quot;Behaviour of outputs in case of a communication error&quot;</th>
<th>Required setting of the channel parameter &quot;Substitute value&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output OFF</td>
<td>Off</td>
<td>0</td>
</tr>
<tr>
<td>Last value</td>
<td>Last value</td>
<td>0</td>
</tr>
<tr>
<td>Substitute value</td>
<td>Off or last value</td>
<td>1 ... 65535</td>
</tr>
</tbody>
</table>

**Diagnosis**

Table 162: Possible diagnosis of I/O channels

<table>
<thead>
<tr>
<th>Output range</th>
<th>Condition</th>
<th>Output value in the PLC underflow</th>
<th>Output value in the PLC overflow</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 mA ... 20 mA</td>
<td>Error identifier = 7</td>
<td>Error identifier = 7</td>
<td>Error identifier = 4</td>
</tr>
<tr>
<td>4 mA ... 20 mA</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-10 V ... +10 V</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input range</td>
<td>Condition</td>
<td>Wire break</td>
<td>Input value under-flow</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------</td>
<td>-----------</td>
<td>------------------------</td>
</tr>
<tr>
<td>0 mA ... 20 mA</td>
<td>no diagnosis possible</td>
<td>no diagnosis possible</td>
<td>no diagnosis possible</td>
</tr>
<tr>
<td>4 mA ... 20 mA</td>
<td>Error identifier = 7</td>
<td>Error identifier = 7</td>
<td>Error identifier = 7</td>
</tr>
<tr>
<td>-10 V ... +10 V</td>
<td>no diagnosis possible</td>
<td>Error identifier = 48</td>
<td>Error identifier = 7</td>
</tr>
</tbody>
</table>

**Table 163: Content of diagnosis messages**

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier</th>
<th>AC500 display</th>
<th>&lt;- Display in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Comp</td>
<td>Dev</td>
<td>Mod</td>
<td>Ch</td>
<td>Err</td>
<td>PS501 PLC browser</td>
<td></td>
</tr>
<tr>
<td>Byte 6</td>
<td>-</td>
<td>Byte 3</td>
<td>Byte 4</td>
<td>Byte 5</td>
<td>Byte 6 Bit 0 ... 5</td>
<td>FBP diagnosis block</td>
<td></td>
</tr>
<tr>
<td>Bit 6 ... 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Module error**

<table>
<thead>
<tr>
<th>Channel</th>
<th>Error Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>19</td>
<td>Checksum error in the I/O module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>Timeout in the I/O module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>40</td>
<td>Different hard-/firm-ware versions in the module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>43</td>
<td>Internal error in the module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>36</td>
<td>Internal data exchange failure</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>9</td>
<td>Overflow diagnosis buffer</td>
<td>New start</td>
</tr>
<tr>
<td>3</td>
<td>26</td>
<td>Parameter error</td>
<td>Check master</td>
</tr>
<tr>
<td>3</td>
<td>11</td>
<td>Process voltage too low</td>
<td>Check process voltage</td>
</tr>
<tr>
<td>4</td>
<td>45</td>
<td>Process voltage is switched off (ON -&gt; OFF)</td>
<td>Process voltage ON</td>
</tr>
</tbody>
</table>
### Hardware descriptions

#### Device specifications > I/O modules

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>1</td>
<td>0 ... 3</td>
<td>0 ... 7</td>
<td>Analog value overflow or broken wire at an analog input</td>
<td>Check input value or terminal</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>1</td>
<td>0 ... 3</td>
<td>0 ... 7</td>
<td>Analog value underflow at an analog input</td>
<td>Check input value</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>1</td>
<td>0 ... 3</td>
<td>0 ... 7</td>
<td>Short circuit at an analog input</td>
<td>Check terminal</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>3</td>
<td>4 ... 7</td>
<td>8 ... 15</td>
<td>Analog value overflow at an analog output</td>
<td>Check output value</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>3</td>
<td>4 ... 7</td>
<td>8 ... 15</td>
<td>Analog value underflow at an analog output</td>
<td>Check output value</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Remarks:**

1) In AC500, the following interface identifier applies:

   14 = I/O bus, 11 = COM1 (e.g. CS31 bus), 12 = COM2.

   The FBP diagnosis block does not contain this identifier.

2) With "Device" the following allocation applies:

   31 = module itself, 1 ... 10 = expansion module 1 ... 10, ADR = hardware address (e.g. of the DC551)

3) With "Module" the following allocation applies depending on the master:

   Module error: I/O bus or FBP: 31 = module itself; COM1/COM2: 1 ... 10 = expansion 1 ... 10

   Channel error: I/O bus or FBP = module type (1 = AI, 3 = AO); COM1/COM2: 1 ... 10 = expansion 1 ... 10

4) In case of module errors, with channel "31 = Module itself" is output.

---

**State LEDs**

During the power ON procedure, the module initializes automatically. All LEDs (except the channel LEDs) are ON during this time.
# Measuring ranges

**Input ranges of voltage, current and digital input**

The represented resolution corresponds to 16 bits.

<table>
<thead>
<tr>
<th>Range</th>
<th>0 V ... 10 V</th>
<th>-10 V ... +10 V</th>
<th>0 mA ... 20 mA</th>
<th>4 mA ... 20 mA</th>
<th>Digital input</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Overflow</strong></td>
<td>&gt;11.7589</td>
<td>&gt;11.7589</td>
<td>&gt;23.5178</td>
<td>&gt;22.8142</td>
<td></td>
<td>32767</td>
</tr>
<tr>
<td>Measured value too high</td>
<td>11.7589</td>
<td>11.7589</td>
<td>23.5178</td>
<td>22.8142</td>
<td></td>
<td>32511</td>
</tr>
<tr>
<td></td>
<td>10.0004</td>
<td>10.0004</td>
<td>20.0007</td>
<td>20.0006</td>
<td></td>
<td>27649</td>
</tr>
<tr>
<td>Normal range</td>
<td>10.0000</td>
<td>10.0000</td>
<td>20.0000</td>
<td>20.0000</td>
<td>ON</td>
<td>27648</td>
</tr>
<tr>
<td>Normal range or measured</td>
<td>0.0000</td>
<td>0.0000</td>
<td>4</td>
<td>OFF</td>
<td>0</td>
<td>0000</td>
</tr>
<tr>
<td>value too low</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overflow</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Measured value too low</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt;0.0000</td>
<td>&lt;-11.7589</td>
<td>&lt;0.0000</td>
<td>&lt;0.0000</td>
<td></td>
<td>-32768</td>
</tr>
</tbody>
</table>

- Measured value too high
- Measured value too low
- Underflow
## Input ranges resistance temperature detector

<table>
<thead>
<tr>
<th>Range</th>
<th>Pt100 / Pt1000</th>
<th>Pt100 / Pt1000</th>
<th>Ni1000</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>-50 °C ... +70 °C</td>
<td>-50 °C ... +400 °C</td>
<td>-50 °C ... +150 °C</td>
<td></td>
</tr>
<tr>
<td>Overflow</td>
<td>&gt; +80.0 °C</td>
<td>&gt; +450.0 °C</td>
<td>&gt; +160.0 °C</td>
<td>32767</td>
</tr>
<tr>
<td>Measured value too high</td>
<td>+450.0 °C</td>
<td>+160.0 °C</td>
<td>4500</td>
<td>1194</td>
</tr>
<tr>
<td></td>
<td>+ 400.1 °C</td>
<td>+150.1 °C</td>
<td>4001</td>
<td>0FA1</td>
</tr>
<tr>
<td>Normal range</td>
<td>:</td>
<td>:</td>
<td>:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>+400.0 °C</td>
<td>+150.0 °C</td>
<td>4000</td>
<td>0FA0</td>
</tr>
<tr>
<td></td>
<td>+70.0 °C</td>
<td>+70.0 °C</td>
<td>1500</td>
<td>05DC</td>
</tr>
<tr>
<td></td>
<td>+ 0.1 °C</td>
<td>+ 0.1 °C</td>
<td>700</td>
<td>02BC</td>
</tr>
<tr>
<td>0.0 °C</td>
<td>0.0 °C</td>
<td>0.0 °C</td>
<td>1</td>
<td>0001</td>
</tr>
<tr>
<td>-0.1 °C</td>
<td>-0.1 °C</td>
<td>-0.1 °C</td>
<td>-1</td>
<td>FFFF</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>:</td>
<td></td>
</tr>
<tr>
<td>-50.0 °C</td>
<td>-50.0 °C</td>
<td>-50.0 °C</td>
<td>-500</td>
<td>FE0C</td>
</tr>
<tr>
<td>Measured value too low</td>
<td>-50.1 °C</td>
<td>-50.1 °C</td>
<td>-50.1 °C</td>
<td>-501</td>
</tr>
<tr>
<td></td>
<td>-60.0 °C</td>
<td>-60.0 °C</td>
<td>-60.0 °C</td>
<td>600</td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt; -60.0 °C</td>
<td>&lt; -60.0 °C</td>
<td>&lt; -60.0 °C</td>
<td>-32768</td>
</tr>
</tbody>
</table>

## Output ranges voltage and current

The represented resolution corresponds to 16 bits.

<table>
<thead>
<tr>
<th>Range</th>
<th>-10 V ... +10 V</th>
<th>0 mA ... 20 mA</th>
<th>4 mA ... 20 mA</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>-10 V ... +10 V</td>
<td>0 mA ... 20 mA</td>
<td>4 mA ... 20 mA</td>
<td></td>
</tr>
<tr>
<td>Overflow</td>
<td>0 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>&gt; 32511</td>
</tr>
<tr>
<td>Value too high</td>
<td>11.7589 V</td>
<td>23.5178 mA</td>
<td>22.8142 mA</td>
<td>32511</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>10.0004 V</td>
<td>20.0007 mA</td>
<td>20.0006 mA</td>
<td>27649</td>
</tr>
</tbody>
</table>
### Range

<table>
<thead>
<tr>
<th>Range</th>
<th>-10 V ... +10 V</th>
<th>0 mA ... 20 mA</th>
<th>4 mA ... 20 mA</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal range</td>
<td>10.0000 V</td>
<td>20.0000 mA</td>
<td>20.0000 mA</td>
<td>27648</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
</tr>
<tr>
<td></td>
<td>0.0004 V</td>
<td>0.0007 mA</td>
<td>4.0006 mA</td>
<td>0001</td>
</tr>
<tr>
<td></td>
<td>0.0000 V</td>
<td>0.0000 mA</td>
<td>4.0000 mA</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>-0.0004 V</td>
<td>0 mA</td>
<td>3.9994 mA</td>
<td>-1 -6912 E500</td>
</tr>
<tr>
<td></td>
<td>-10.0000 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>-27648 9400</td>
</tr>
<tr>
<td>Value too low</td>
<td>-10.0004 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>-27649 93FF</td>
</tr>
<tr>
<td></td>
<td>-11.7589 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>-32512 8100</td>
</tr>
<tr>
<td>Underflow</td>
<td>0 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>&lt; -32512 &lt; 8100</td>
</tr>
</tbody>
</table>

### Technical data

#### Technical data of the module

The System Data of AC500 and S500 on page 166 are applicable to the standard version.

Only additional details are therefore documented below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process voltage</td>
<td></td>
</tr>
<tr>
<td>Connections</td>
<td>Terminals 1.8, 2.8, 3.8 and 4.8 for +24 V (UP) as well as 1.9, 2.9, 3.9 and 4.9 for 0 V (ZP)</td>
</tr>
<tr>
<td>Rated value</td>
<td>24 VDC</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5 %</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse on UP</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per module</td>
</tr>
<tr>
<td>Current consumption</td>
<td></td>
</tr>
<tr>
<td>From 24 VDC power supply at the terminals UP/L+ and ZP/M of the CPU/bus module</td>
<td>Ca. 2 mA</td>
</tr>
<tr>
<td>From UP at normal operation</td>
<td>0.10 A + output loads</td>
</tr>
<tr>
<td>Inrush current from UP (at power up)</td>
<td>0.040 A²s</td>
</tr>
<tr>
<td>Max. length of analog cables, conductor cross section &gt; 0.14 mm²</td>
<td>100 m</td>
</tr>
<tr>
<td>Weight</td>
<td>300 g</td>
</tr>
</tbody>
</table>
### Parameter Values

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical with derating (output load reduced to 50 % at +40 °C per group)</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>

**NOTICE!**

All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

### Technical Data of the Analog Inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Connections of the channels C0- ... C7-</td>
<td>Terminals 2.0 ... 2.7</td>
</tr>
<tr>
<td>Connections of the channels C0+ ... C7+</td>
<td>Terminals 3.0 ... 3.7</td>
</tr>
<tr>
<td>Input type</td>
<td>Bipolar (not with current or Pt100/Pt1000/Ni1000)</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Against internal supply and other modules</td>
</tr>
<tr>
<td>Configurability</td>
<td>0 V ... 10 V, -10 V ... +10 V, 0 mA ... 20 mA, 4 mA ... 20 mA, Pt100/1000, Ni1000 (each input can be configured individually)</td>
</tr>
<tr>
<td>Channel input resistance</td>
<td>Voltage: &gt; 100 kΩ</td>
</tr>
<tr>
<td></td>
<td>Current: ca. 330 Ω</td>
</tr>
<tr>
<td>Time constant of the input filter</td>
<td>Voltage: 100 µs</td>
</tr>
<tr>
<td></td>
<td>Current: 100 µs</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>One LED per channel</td>
</tr>
<tr>
<td>Conversion cycle</td>
<td>2 ms (for 8 inputs + 8 outputs), with Pt/Ni... 1 s</td>
</tr>
<tr>
<td>Resolution</td>
<td>Range 0 V ... 10 V: 12 bits</td>
</tr>
<tr>
<td></td>
<td>Range -10 V ... +10 V: 12 bits including sign</td>
</tr>
<tr>
<td></td>
<td>Range 0 mA ... 20 mA: 12 bits</td>
</tr>
<tr>
<td></td>
<td>Range 4 mA ... 20 mA: 12 bits</td>
</tr>
<tr>
<td>Conversion error of the analog values caused by non-linearity, adjustment error at factory and resolution within the normal range</td>
<td>Typ. ± 0.5 % of full scale at +25 °C</td>
</tr>
<tr>
<td></td>
<td>Max. ± 1 % of full scale (all ranges) at 0 °C ... +60 °C or EMC disturbance</td>
</tr>
<tr>
<td>Relationship between input signal and hex code</td>
<td>See table / Chapter 5.2.4.4.2.1.10.1 “Input ranges of voltage, current and digital input” on page 692</td>
</tr>
<tr>
<td>Unused inputs</td>
<td>Must be configured as &quot;unused&quot;.</td>
</tr>
<tr>
<td>Overvoltage protection</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Technical data of the analog inputs, if used as digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>Max. 8</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Connections of the channels C0+ ... C7+</td>
<td>Terminals 3.0 ... 3.7</td>
</tr>
<tr>
<td>Reference potential for the inputs</td>
<td>Terminals 1.9 ... 4.9 (ZP)</td>
</tr>
<tr>
<td>Input signal delay</td>
<td>Typ. 8 ms, configurable from 0.1 ... 32 ms</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 LED per channel</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 VDC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-30 V ... +5 V</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>+5 V ... +13 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>+13 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 7 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>Typ. 1.4 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>Typ. 4.3 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 9 mA</td>
</tr>
<tr>
<td>Input resistance</td>
<td>Ca. 3.5 kΩ</td>
</tr>
</tbody>
</table>

### Technical data of the analog outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8, all channels for voltage, the first 4 channels also for current</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Channels C0- ... C7-</td>
<td>Terminals 2.0 ... 2.7</td>
</tr>
<tr>
<td>Channels C0+ ... C7+</td>
<td>Terminals 3.0 ... 3.7</td>
</tr>
<tr>
<td>Output type</td>
<td>Bipolar with voltage, unipolar with current</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Against internal supply and other modules</td>
</tr>
<tr>
<td>Configurability</td>
<td>-10 V ... +10 V, 0 mA ... 20 mA, 4 mA ... 20 mA (each output can be configured individually), current outputs only channels 0 ... 3</td>
</tr>
<tr>
<td>Output resistance (load), as current output</td>
<td>0 Ω ... 500 Ω</td>
</tr>
<tr>
<td>Output loadability, as voltage output</td>
<td>Max. ± 10 mA</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>One LED per channel</td>
</tr>
<tr>
<td>Resolution</td>
<td>12 bits including sign</td>
</tr>
<tr>
<td>Settling time for full range change (resistive load, output signal within specified tolerance)</td>
<td>Typ. 5 ms</td>
</tr>
<tr>
<td>Conversion error of the analog values caused by non-linearity, adjustment error at factory and resolution within the normal range</td>
<td>Typ. ± 0.5 % of full scale at +25 °C</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Max.</td>
<td>± 1 % of full scale (all ranges)</td>
</tr>
<tr>
<td></td>
<td>at 0 °C ... +60 °C or EMC disturbance</td>
</tr>
<tr>
<td>Relationship between output signal and hex code</td>
<td>See table 'AC522 - Analog input/output module' Chapter 5.2.4.2.1.10.3 “Output ranges voltage and current” on page 693</td>
</tr>
<tr>
<td>Unused outputs</td>
<td>Must be configured as &quot;unused&quot;.</td>
</tr>
</tbody>
</table>

Dimensions

The dimensions are in mm and in brackets in inch.

1  Din rail 15 mm
2  Din rail 7.5 mm
Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 250 500 R0001</td>
<td>AC522, analog input/output module, 8 AC, U/I/RTD, 12 bits including sign, 2-wires</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 450 500 R0001</td>
<td>AC522-XC, analog input/output module, 8 AC, U/I/RTD, 12 bits including sign, 2-wires, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

AI523 - Analog input module

Features

- 16 configurable analog inputs (I0 ... I15) in 2 groups (1.0 ... 2.7 and 3.0 ... 4.7)
  Resolution 12 bits including sign
- Module-wise galvanically isolated
- XC version for use in extreme ambient conditions available
1 I/O bus
2 Allocation between terminal number and signal name
3 16 yellow LEDs to display the signal states at the analog inputs (I0 ... I15)
4 1 green LED to display the state of the process supply voltage UP
5 2 red LEDs to display errors
6 Label
7 Terminal unit
8 DIN rail

Sign for XC version

Intended purpose

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g., CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.

Functionality

16 analog inputs, individually configurable for
- Unused (default setting)
- 0 V ... 10 V
- -10 V ... +10 V
- 0 mA ... 20 mA
- 4 mA ... 20 mA
- Pt100, -50 °C ... +400 °C (2-wire)
- Pt100, -50 °C ... +400 °C (3-wire), requires 2 channels
- Pt100, -50 °C ... +70 °C (2-wire)
- Pt100, -50 °C ... +70 °C (3-wire), requires 2 channels
- Pt1000, -50 °C ... +400 °C (2-wire)
- Pt1000, -50 °C ... +400 °C (3-wire), requires 2 channels
- Ni1000, -50 °C ... +150 °C (2-wire)
- Ni1000, -50 °C ... +150 °C (3-wire), requires 2 channels
- 0 V ... 10 V with differential inputs, requires 2 channels
- -10 V ... +10 V with differential inputs, requires 2 channels
- Digital signals (digital input)

### Connections

The modules are plugged on an I/O terminal unit. Properly position the modules and press until they lock in place. The terminal units are mounted on a DIN rail or with 2 screws plus the additional accessory for wall mounting. The connection of the I/O channels is carried out using the 40 terminals of the I/O terminal unit. I/O modules can be replaced without re-wiring the terminal units.

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The terminals 1.8 ... 4.8 and 1.9 ... 4.9 are electrically interconnected within the I/O terminal units and have always the same assignment, independent of the inserted module:

- Terminals 1.8 ... 4.8: process voltage UP = +24 V DC
- Terminals 1.9 ... 4.9: process voltage ZP = 0 V

The assignment of the other terminals:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution of the analog channels</td>
<td></td>
</tr>
<tr>
<td>Voltage -10 V ... +10 V</td>
<td>12 bits including sign</td>
</tr>
<tr>
<td>Voltage 0 V ... 10 V</td>
<td>12 bits</td>
</tr>
<tr>
<td>Current 0 mA ... 20 mA, 4 mA ... 20 mA</td>
<td>12 bits</td>
</tr>
<tr>
<td>Temperature</td>
<td>0.1 °C</td>
</tr>
<tr>
<td>LED displays</td>
<td>19 LEDs for signals and error messages</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>External power supply</td>
<td>Via the terminals ZP and UP (process voltage 24 V DC)</td>
</tr>
<tr>
<td>Required terminal unit</td>
<td>TU515 or TU516 [Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938]</td>
</tr>
</tbody>
</table>
### Terminals Signal Description

<table>
<thead>
<tr>
<th>Terminals</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0 ... 1.7</td>
<td>I0- ... I7-</td>
<td>Negative poles of the first 8 analog inputs</td>
</tr>
<tr>
<td>2.0 ... 2.7</td>
<td>I0+ ... I7+</td>
<td>Positive poles of the first 8 analog inputs</td>
</tr>
<tr>
<td>3.0 ... 3.7</td>
<td>I8- ... I15-</td>
<td>Negative poles of the following 8 analog inputs</td>
</tr>
<tr>
<td>4.0 ... 4.7</td>
<td>I8+ ... I15+</td>
<td>Positive poles of the following 8 analog inputs</td>
</tr>
</tbody>
</table>

**CAUTION!**
The negative poles of the analog inputs are galvanically connected to each other. They form an "Analog Ground" signal for the module. The negative poles of the analog outputs are also galvanically connected to each other to form an "Analog Ground" signal.

**CAUTION!**
There is no galvanic isolation between the analog circuitry and ZP/UP. Therefore, the analog sensors must be galvanically isolated in order to avoid loops via the ground potential or the supply voltage.

**CAUTION!**
Because of their common reference potential, analog current inputs cannot be circuited in series, neither within the module nor with channels of other modules.

*For the open-circuit detection (wire break), each analog input channel is pulled up to "plus" by a high-resistance resistor. If nothing is connected, the maximum voltage will be read in then.*

The internal power supply voltage for the module's circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 2 mA per AI523.

The external power supply connection is carried out via the UP (+24 V DC) and the ZP (0 V DC) terminals.
WARNING!
Removal/Insertion under power
Removal or insertion under power is permissible only if all conditions for hot swapping are fullfilled.

☞ Chapter 4.9.3 “Replace an I/O module with hot swap” on page 153

The devices are not designed for removal or insertion under power when the conditions for hot swap do not apply. Because of unforeseeable consequences, it is not allowed to plug in or unplug devices with the power being ON.
Make sure that all voltage sources (supply and process voltage) are switched off before you
– connect or disconnect any signal or terminal block
– remove, mount or replace a module.
Disconnecting any powered devices while they are energized in a hazardous location could result in an electric arc, which could create an ignition source resulting in fire or explosion.
Prior to proceeding, make sure that power is been disconnected and that the area has been thoroughly checked to ensure that flammable materials are not present.
The devices must not be opened when in operation. The same applies to the network interfaces.

NOTICE!
Risk of damaging the PLC modules!
Overvoltages and short circuits might damage the PLC modules.
– Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
– Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

Generally, analog signals must be laid in shielded cables. The cable shields must be grounded at both sides of the cables. In order to avoid unacceptable potential differences between different parts of the installation, low resistance equipotential bonding conductors must be laid.

The following figure shows the connection of the module:
CAUTION!
By installing equipotential bonding conductors between the different parts of the system, it must be ensured that the potential difference between ZP and AGND never can exceed 1 V.

CAUTION!
The process supply voltage must be included in the grounding concept (e.g. grounding of the negative terminal).

The modules provide several diagnosis functions § Chapter 5.2.4.4.2.8 “Diagnosis” on page 717.
Connection of resistance thermometers in 2-wire configuration

When resistance thermometers (Pt100, Pt1000, Ni1000) are used, a constant current must flow through them to build the necessary voltage drop for the evaluation. For this, the module AI523 provides a constant current source which is multiplexed over the 8 analog channels.

![Connection example](image)

**Fig. 91: Connection example**

The following measuring ranges can be configured

<table>
<thead>
<tr>
<th>Thermometer</th>
<th>Measuring Range</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pt100</td>
<td>-50 °C ... +70 °C</td>
<td>2-wire configuration, one channel used</td>
</tr>
<tr>
<td>Pt1000</td>
<td>-50 °C ... +400 °C</td>
<td>2-wire configuration, one channel used</td>
</tr>
<tr>
<td>Ni1000</td>
<td>-50 °C ... +150 °C</td>
<td>2-wire configuration, one channel used</td>
</tr>
</tbody>
</table>

The function of the LEDs is described under Displays

The module AI523 performs a linearization of the resistance characteristic.

In order to avoid error messages from unused analog input channels, it is useful to configure them as "unused".

Connection of resistance thermometers in 3-wire configuration

When resistance thermometers (Pt100, Pt1000, Ni1000) are used, a constant current must flow through them to build the necessary voltage drop for the evaluation. For this, the module AI523 provides a constant current source which is multiplexed over the max. 8 (depending on the configuration) analog channels.
With 3-wire configuration, two adjacent analog channels belong together (e.g. the channels 0 and 1). In this case, both channels are configured according to the desired operating mode. The lower address must be the even address (channel 0), the next higher address must be the odd address (channel 1).

The constant current of one channel flows through the resistance thermometer. The constant current of the other channel flows through one of the cores. The module calculates the measured value from the two voltage drops and stores it under the input with the higher channel number (e.g. I1).

In order to keep measuring errors as small as possible, it is necessary to have all the involved conductors in the same cable. All the conductors must have the same cross section.

The following measuring ranges can be configured \( \text{Chapter 5.2.4.4.2.2.7 “Parameterization” on page 714} \)

<table>
<thead>
<tr>
<th>Temperature Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pt100 -50 °C ... +70 °C</td>
<td>3-wire configuration, two channels used</td>
</tr>
<tr>
<td>Pt100 -50 °C ... +400 °C</td>
<td>3-wire configuration, two channels used</td>
</tr>
<tr>
<td>Pt1000 -50 °C ... +400 °C</td>
<td>3-wire configuration, two channels used</td>
</tr>
<tr>
<td>Ni1000 -50 °C ... +150 °C</td>
<td>3-wire configuration, two channels used</td>
</tr>
</tbody>
</table>

The function of the LEDs is described under Displays \( \text{Chapter 5.2.4.4.2.2.8 “Diagnosis” on page 717} \).

The module AI523 performs a linearization of the resistance characteristic.

In order to avoid error messages from unused analog input channels, it is useful to configure them as "unused".
Connection of active-type analog sensors (Voltage) with galvanically isolated power supply

Fig. 93: Connection example
By connecting the sensor’s negative pole of the output voltage to AGND, the galvanically isolated voltage source of the sensor is referred to ZP.

The following measuring ranges can be configured Chapter 5.2.4.4.2.2.7 “Parameterization” on page 714 Chapter 5.2.4.4.2.2.10 “Measuring ranges” on page 719

<table>
<thead>
<tr>
<th>Voltage</th>
<th>0 V ... 10 V</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

The function of the LEDs is described under Displays Chapter 5.2.4.4.2.2.8 “Diagnosis” on page 717.

In order to avoid error messages or long processing times, it is useful to configure unused analog input channels as "unused".

Connection of active-type analog sensors (Current) with galvanically isolated power supply

Fig. 94: Connection example

The following measuring ranges can be configured Chapter 5.2.4.4.2.2.7 “Parameterization” on page 714 Chapter 5.2.4.4.2.2.10 “Measuring ranges” on page 719

<table>
<thead>
<tr>
<th>Current</th>
<th>0 mA ... 20 mA</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>4 mA ... 20 mA</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

The function of the LEDs is described under Displays Chapter 5.2.4.4.2.2.8 “Diagnosis” on page 717.

Unused input channels can be left open-circuited, because they are of low resistance.
Connection of active-type analog sensors (Voltage) with no galvanically isolated power supply

Fig. 95: Connection example
**CAUTION!**
The potential difference between AGND and ZP at the module must not be greater than 1 V, not even in case of long lines. Chapter 5.2.4.4.2.2 “AI523 - Analog input module” on page 698.

If AGND does not get connected to ZP, the sensor current flows to ZP via the AGND line. The measuring signal is distorted, as a very low current flows over the voltage line. The total current through the PTC should not exceed 50 mA. This measuring method is therefore only suitable for short lines and small sensor currents. If there are bigger distances, the difference measuring method has to be preferred.

The following measuring ranges can be configured. Chapter 5.2.4.4.2.10 “Measuring ranges” on page 719

<table>
<thead>
<tr>
<th>Voltage</th>
<th>0 V ... 10 V</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V *)</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>
| *) if the sensor can provide this signal range

The function of the LEDs is described under Displays. Chapter 5.2.4.4.2.8 “Diagnosis” on page 717.

In order to avoid error messages or long processing times, it is useful to configure unused analog input channels as "unused".
Connection of passive-type analog sensors (Current)

![Connection diagram]

**Fig. 96: Connection example**

The following measuring ranges can be configured © Chapter 5.2.4.4.2.2.7 “Parameterization” on page 714 © Chapter 5.2.4.4.2.2.10 “Measuring ranges” on page 719
The function of the LEDs is described under Displays Chapter 5.2.4.4.2.2.8 “Diagnosis” on page 717.

CAUTION!

If, during initialization, an analog current sensor supplies more than 25 mA for more than 1 second into an analog input, this input is switched off by the module (input protection). In such cases, it is recommended to protect the analog input by a 10-volt Zener diode (in parallel to \( I^+ \) and \( \text{ZP} \)). But, in general, it is a better solution to use sensors with fast initialization or without current peaks higher than 25 mA.

Unused input channels can be left open-circuited, because they are of low resistance.

Connection of active-type analog sensors (Voltage) to differential inputs

Differential inputs are very useful if analog sensors which are remotely non-isolated (e.g. the negative terminal is remotely grounded) are used.

The evaluation using differential inputs helps to considerably increase the measuring accuracy and to avoid ground loops.

With differential input configurations, two adjacent analog channels belong together (e.g. the channels 0 and 1). In this case, both channels are configured according to the desired operating mode. The lower address must be the even address (channel 0), the next higher address must be the odd address (channel 1). The converted analog value is available at the higher address (channel 1).

The analog value is calculated by subtraction of the input value with the higher address from the input value of the lower address.

The converted analog value is available at the odd channel (higher address).

CAUTION!

The ground potential at the sensors must not have too big a potential difference with respect to \( \text{ZP} \) (max. \( \pm 1 \) V within the full signal range). Otherwise problems can occur concerning the common-mode input voltages of the involved analog inputs.
Fig. 97: Connection example
The negative pole of the sensor must be grounded next to the sensor.

The following measuring ranges can be configured:

<table>
<thead>
<tr>
<th>Voltage</th>
<th>0 V ... 10 V</th>
<th>with differential inputs, 2 channels used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V</td>
<td>with differential inputs, 2 channels used</td>
</tr>
</tbody>
</table>

The function of the LEDs is described under Displays.

In order to avoid error messages or long processing times, it is useful to configure unused analog input channels as "unused".

**Use of analog inputs as digital inputs**

Several (or all) analog inputs can be configured as digital inputs. The inputs are not galvanically isolated against the other analog channels.

**Fig. 98: Connection example**

The following operating mode can be configured:

<table>
<thead>
<tr>
<th>Digital input</th>
<th>24 V</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effect of incorrect input terminal connection</td>
<td>Wrong or no signal detected, no damage up to 35 V</td>
<td></td>
</tr>
</tbody>
</table>

The function of the LEDs is described under Displays.
Internal data exchange

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital inputs (bytes)</td>
<td>0</td>
</tr>
<tr>
<td>Digital outputs (bytes)</td>
<td>0</td>
</tr>
<tr>
<td>Counter input data (words)</td>
<td>16</td>
</tr>
<tr>
<td>Counter output data (words)</td>
<td>0</td>
</tr>
</tbody>
</table>

I/O configuration

The module does not store configuration data itself. It gets its parameterization data from the master device of the I/O bus (CPU or communication interface module) during power-up of the system.

That means replacing I/O modules is possible without any re-parameterization via software.

If the external power supply voltage via UP/ZP terminals fails, the I/O module loses its configuration data. The whole station has to be switched off and on again to re-configure the module.

Parameterization

<table>
<thead>
<tr>
<th>Firmware version</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firmware version &gt; V2.0.0</td>
<td>The arrangement of the parameter data is performed by Control Builder Plus/ Automation Builder software.</td>
</tr>
</tbody>
</table>

The parameter data directly influences the functionality of modules.

For non-standard applications, it is necessary to adapt the parameters to your system configuration.

Module: Module slot address: Y = 1 ... 10

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot/Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Module ID</td>
<td>Internal</td>
<td>1515</td>
<td>Word</td>
<td>1515 0x05eb</td>
<td>0</td>
<td>65535</td>
<td>0x0Y01</td>
</tr>
<tr>
<td>2</td>
<td>Ignore module</td>
<td>No</td>
<td>Yes</td>
<td>Byte</td>
<td>No 0x00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Parameter length in</td>
<td>Internal</td>
<td>34</td>
<td>Byte</td>
<td>34-CPU 34-FBP</td>
<td>0</td>
<td>255</td>
<td>0x0Y02</td>
</tr>
<tr>
<td></td>
<td>bytes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Check supply</td>
<td>Off</td>
<td>Yes</td>
<td>Byte</td>
<td>On 0x01</td>
<td>0</td>
<td>1</td>
<td>0x0Y03</td>
</tr>
<tr>
<td>5</td>
<td>Analog data format</td>
<td>Default</td>
<td>Yes</td>
<td>Byte</td>
<td>Default 0x00</td>
<td></td>
<td></td>
<td>0x0Y04</td>
</tr>
<tr>
<td>No.</td>
<td>Name</td>
<td>Value</td>
<td>Internal value</td>
<td>Internal value, type</td>
<td>Default</td>
<td>Min.</td>
<td>Max.</td>
<td>EDS Slot/Index</td>
</tr>
<tr>
<td>-----</td>
<td>------</td>
<td>-------</td>
<td>----------------</td>
<td>---------------------</td>
<td>---------</td>
<td>------</td>
<td>------</td>
<td>----------------</td>
</tr>
<tr>
<td>6</td>
<td>Channel configuration Input channel 0</td>
<td>See table 'Channel configuration' (Table 164 “Channel configuration 2)” on page 716</td>
<td>Byte</td>
<td>Default 0x00</td>
<td>0</td>
<td>19</td>
<td>0x0Y05</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Channel monitoring Input channel 0</td>
<td>See table 'Channel monitoring' (Table 165 “Channel monitoring 4)” on page 717</td>
<td>Byte</td>
<td>Default 0x00</td>
<td>0</td>
<td>3</td>
<td>0x0Y06</td>
<td></td>
</tr>
<tr>
<td>8-35</td>
<td>Channel configuration and channel monitoring of the input channels 1 ... 14</td>
<td>See table 'Channel configuration' (Table 164 “Channel configuration 2)” on page 716 and table 'Channel monitoring' (Table 165 “Channel monitoring 4)” on page 717</td>
<td>Byte</td>
<td>Default 0x00 0x00</td>
<td>0</td>
<td>19</td>
<td>0x0Y07 to 0x0Y22</td>
<td></td>
</tr>
<tr>
<td>36</td>
<td>Channel configuration Input channel 15</td>
<td>See table 'Channel configuration' (Table 164 “Channel configuration 2)” on page 716</td>
<td>Byte</td>
<td>Default 0x00</td>
<td>0</td>
<td>19</td>
<td>0x0Y23</td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>Channel monitoring Input channel 15</td>
<td>See table 'Channel monitoring' (Table 165 “Channel monitoring 4)” on page 717</td>
<td>Byte</td>
<td>Default 0x00</td>
<td>0</td>
<td>3</td>
<td>0x0Y24</td>
<td></td>
</tr>
</tbody>
</table>

1) With CS31 and addresses less than 70 and FBP, the value is increased by 1
2) Not with FBP

GSD file:
**Input channel (16 x with AI523)**

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Channel configuration</td>
<td>see table 2)</td>
<td>see table 2)</td>
<td>Byte</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0x00 see 3)</td>
</tr>
<tr>
<td>2</td>
<td>Channel monitoring</td>
<td>see table 4)</td>
<td>see table 4)</td>
<td>Byte</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0x00 see 5)</td>
</tr>
</tbody>
</table>

**Table 164: Channel configuration 2)**

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes of the analog inputs, individually configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Unused (default)</td>
</tr>
<tr>
<td>1</td>
<td>Analog input 0 V ... 10 V</td>
</tr>
<tr>
<td>2</td>
<td>Digital input</td>
</tr>
<tr>
<td>3</td>
<td>Analog input 0 mA ... 20 mA</td>
</tr>
<tr>
<td>4</td>
<td>Analog input 4 mA ... 20 mA</td>
</tr>
<tr>
<td>5</td>
<td>Analog input -10 V ... +10 V</td>
</tr>
<tr>
<td>8</td>
<td>Analog input Pt100, -50 °C ... +400 °C (2-wire)</td>
</tr>
<tr>
<td>9</td>
<td>Analog input Pt100, -50 °C ... +400 °C (3-wire), requires 2 channels *)</td>
</tr>
<tr>
<td>10</td>
<td>Analog input 0 ... 10 V via differential inputs, requires 2 channels *)</td>
</tr>
<tr>
<td>11</td>
<td>Analog input -10 V ... +10 V via differential inputs, requires 2 channels *)</td>
</tr>
<tr>
<td>14</td>
<td>Analog input Pt100, -50 °C ... +70 °C (2-wire)</td>
</tr>
<tr>
<td>15</td>
<td>Analog input Pt100, -50 °C ... +70 °C (3-wire), requires 2 channels *)</td>
</tr>
<tr>
<td>16</td>
<td>Analog input Pt1000, -50 °C ... +400 °C (2-wire)</td>
</tr>
<tr>
<td>17</td>
<td>Analog input Pt1000, -50 °C ... +400 °C (3-wire), requires 2 channels *)</td>
</tr>
<tr>
<td>18</td>
<td>Analog input Ni1000, -50 °C ... +150 °C (2-wire)</td>
</tr>
</tbody>
</table>
Internal value | Operating modes of the analog inputs, individually configurable
---|---
19 | Analog input Ni1000, -50 °C ... +150 °C (3-wire), requires 2 channels *)

*) In the operating modes with 3-wire configuration or with differential inputs, two adjacent analog inputs belong together (e.g. the channels 0 and 1). In these cases, both channels are configured in the desired operating mode. The lower address must be the even address (channel 0). The next higher address must be the odd address (channel 1). The converted analog value is available at the higher address (channel 1).

Table 165: Channel monitoring 4)

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Monitoring</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Plausibility, open-circuit (broken wire) and short circuit 5)</td>
</tr>
<tr>
<td>1</td>
<td>Open-circuit and short circuit</td>
</tr>
<tr>
<td>2</td>
<td>Plausibility</td>
</tr>
<tr>
<td>3</td>
<td>No monitoring</td>
</tr>
</tbody>
</table>

Diagnosis

Table 166: Possible diagnosis of I/O channels

<table>
<thead>
<tr>
<th>Input range</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Short circuit</td>
</tr>
<tr>
<td>0 mA ... 20 mA</td>
<td>no diagnosis possible</td>
</tr>
<tr>
<td>4 mA ... 20 mA</td>
<td>Error identifier = 7</td>
</tr>
<tr>
<td>-10 V ... +10 V</td>
<td>no diagnosis possible</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier</th>
<th>AC500 display</th>
<th>Display in PLC browser</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Comp</td>
<td>Dev</td>
<td>Mod</td>
<td>Ch</td>
<td>Err</td>
<td>PS501 PLC browser</td>
<td>FBP diagnosis block</td>
</tr>
<tr>
<td>Byte 6</td>
<td>Time</td>
<td>Byte 3</td>
<td>Byte 4</td>
<td>Byte 5</td>
<td>Byte 6</td>
<td>Bit 0 ... 5</td>
<td></td>
</tr>
<tr>
<td>Bit 6 ... 7</td>
<td>Identifier</td>
<td>Error identifier</td>
<td>Error message</td>
<td>Remedy</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1)</td>
<td>2)</td>
<td>3)</td>
<td>4)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Module error

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADR</td>
<td>1 ... 10</td>
<td>31</td>
<td>Checksum error in the I/O module</td>
<td>Replace I/O module</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>1 ... 10</td>
<td>31</td>
<td>Timeout in the I/O module</td>
<td>Replace I/O module</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Class</td>
<td>Interface</td>
<td>Device</td>
<td>Module</td>
<td>Channel</td>
<td>Error identifier</td>
<td>Error message</td>
<td>Remedy</td>
</tr>
<tr>
<td>--------</td>
<td>-----------</td>
<td>--------</td>
<td>--------</td>
<td>---------</td>
<td>------------------</td>
<td>---------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>40</td>
<td>Different hard-/firmware versions in the module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>43</td>
<td>Internal error in the module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>36</td>
<td>Internal data exchange failure</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>9</td>
<td>Overflow diagnosis buffer</td>
<td>New start</td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>26</td>
<td>Parameter error</td>
<td>Check master</td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>11</td>
<td>Process voltage too low</td>
<td>Check process voltage</td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>45</td>
<td>Process voltage is switched off (ON -&gt; OFF)</td>
<td>Process voltage ON</td>
</tr>
</tbody>
</table>

Channel error

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>1</td>
<td>0 ... 15</td>
<td>48</td>
<td>Analog value overflow or broken wire at an analog input</td>
<td>Check input value or terminal</td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>1</td>
<td>0 ... 15</td>
<td>7</td>
<td>Analog value underflow at an analog input</td>
<td>Check input value</td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>1</td>
<td>0 ... 15</td>
<td>47</td>
<td>Short circuit at an analog input</td>
<td>Check terminal</td>
</tr>
</tbody>
</table>

Remarks:

1) In AC500, the following interface identifier applies:
   14 = I/O bus, 11 = COM1 (e.g. CS31 bus), 12 = COM2.
   The FBP diagnosis block does not contain this identifier.

2) With "Device" the following allocation applies:
   31 = module itself, 1 ... 10 = expansion module 1 ... 10, ADR = hardware address (e.g. of the DC551)
With "Module" the following allocation applies depending on the master:

Module error: I/O bus or FBP: 31 = module itself; COM1/COM2: 1 ... 10 = expansion 1 ... 10

Channel error: I/O bus or FBP = module type (1 = AI); COM1/COM2: 1 ... 10 = expansion 1 ... 10

In case of module errors, with channel "31 = Module itself" is output.

State LEDs

During the power ON procedure, the module initializes automatically. All LEDs (except the channel LEDs) are ON during this time.

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
<th>LED flashes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inputs 10 ... 17 and 18 ... 115</td>
<td>Analog input</td>
<td>Yellow</td>
<td>Input is OFF</td>
<td>Input is ON (brightness depends on the value of the analog signal)</td>
<td>--</td>
</tr>
<tr>
<td>UP</td>
<td>Process voltage 24 V DC via terminal</td>
<td>Green</td>
<td>Process voltage is missing</td>
<td>Process voltage OK</td>
<td>--</td>
</tr>
<tr>
<td>CH-ERR2</td>
<td>Channel error, error messages in groups (analog inputs or outputs combined into the groups 2 and 4)</td>
<td>Red</td>
<td>No error or process voltage is missing</td>
<td>Severe error within the corresponding group</td>
<td>Error on one channel of the group</td>
</tr>
<tr>
<td>CH-ERR4</td>
<td>Module error</td>
<td>Red</td>
<td>--</td>
<td>Internal error</td>
<td>--</td>
</tr>
</tbody>
</table>

*) Both LEDs (CH-ERR2 and CH-ERR4) light up together

Measuring ranges

Input ranges of voltage, current and digital input

The represented resolution corresponds to 16 bits.
### Input ranges resistance temperature detector

The resolution corresponds to 16 bits.

<table>
<thead>
<tr>
<th>Range</th>
<th>Pt100 / Pt 1000</th>
<th>Pt100 / Pt1000</th>
<th>Ni1000</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>-50 °C ... +70 °C</td>
<td>-50 °C ... +400 °C</td>
<td>-50 °C ... +150 °C</td>
</tr>
<tr>
<td></td>
<td>Decimal</td>
<td>Hex.</td>
<td>Decimal</td>
</tr>
<tr>
<td>Overflow</td>
<td>&gt; +80.0 °C</td>
<td>&gt; +450.0 °C</td>
<td>&gt; +160.0 °C</td>
</tr>
<tr>
<td>Measured value too high</td>
<td>+450.0 °C</td>
<td>4001</td>
<td>+160.0 °C</td>
</tr>
<tr>
<td></td>
<td>+ 400.1 °C</td>
<td></td>
<td>+150.1 °C</td>
</tr>
<tr>
<td>+80.0 °C</td>
<td>800</td>
<td>0320</td>
<td>701</td>
</tr>
<tr>
<td>Range</td>
<td>Pt100 / Pt1000</td>
<td>Pt100 / Pt1000</td>
<td>Ni1000</td>
</tr>
<tr>
<td>-------</td>
<td>----------------</td>
<td>----------------</td>
<td>--------</td>
</tr>
<tr>
<td></td>
<td>-50 °C ... +70 °C</td>
<td>-50 °C ... +400 °C</td>
<td>-50 °C ... +150 °C</td>
</tr>
<tr>
<td>Normal range</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>+400.0 °C</td>
<td>:</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>:</td>
</tr>
<tr>
<td></td>
<td>+70.0 °C</td>
<td>:</td>
<td>+150.0 °C</td>
</tr>
<tr>
<td></td>
<td>+ 0.1 °C</td>
<td>+0.1 °C</td>
<td>+ 0.1 °C</td>
</tr>
<tr>
<td>0.0 °C</td>
<td>0.0 °C</td>
<td>0.0 °C</td>
<td>0</td>
</tr>
<tr>
<td>-0.1 °C</td>
<td>-0.1 °C</td>
<td>-0.1 °C</td>
<td>-1</td>
</tr>
<tr>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
</tr>
<tr>
<td>-50.0 °C</td>
<td>-50.0 °C</td>
<td>-50.0 °C</td>
<td>-500</td>
</tr>
<tr>
<td>Measured value too low</td>
<td>-50.1 °C</td>
<td>-50.1 °C</td>
<td>-50.1 °C</td>
</tr>
<tr>
<td></td>
<td>-60.0 °C</td>
<td>-60.0 °C</td>
<td>-60.0 °C</td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt; -60.0 °C</td>
<td>&lt; -60.0 °C</td>
<td>&lt; -60.0 °C</td>
</tr>
</tbody>
</table>

**Technical data**

**Technical data of the module**

The system data of AC500 and S500 are applicable to the standard version Chapter 5.1.2 “System data AC500” on page 166.

The system data of AC500-XC are applicable to the XC version Chapter 5.1.3 “System data AC500-XC” on page 169.

Only additional details are therefore documented below. The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process voltage</td>
<td></td>
</tr>
<tr>
<td>Connections</td>
<td>Terminals 1.8, 2.8, 3.8 and 4.8 for +24 V (UP) as well as 1.9, 2.9, 3.9 and 4.9 for 0 V (ZP)</td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5 %</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse on UP</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per module</td>
</tr>
<tr>
<td>Current consumption</td>
<td></td>
</tr>
<tr>
<td>From 24 V DC power supply at the terminals UP/L+ and ZP/M of the CPU/communication interface module</td>
<td>Ca. 2 mA</td>
</tr>
<tr>
<td>From UP at normal operation / with outputs</td>
<td>0.15 A + output loads</td>
</tr>
</tbody>
</table>
### Technical data of the analog inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>16</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>2 groups of 8 channels each</td>
</tr>
<tr>
<td>Connections of the channels I0- ... I7-</td>
<td>Terminals 1.0 ... 1.7</td>
</tr>
<tr>
<td>Connections of the channels I0+ ... I7+</td>
<td>Terminals 2.0 ... 2.7</td>
</tr>
<tr>
<td>Connections of the channels I8- ... I15-</td>
<td>Terminals 3.0 ... 3.7</td>
</tr>
<tr>
<td>Connections of the channels I8+ ... I15+</td>
<td>Terminals 4.0 ... 4.7</td>
</tr>
<tr>
<td>Input type</td>
<td>Bipolar (not with current or Pt100/ Pt1000/ Ni1000)</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Against internal supply and other modules</td>
</tr>
<tr>
<td>Configurability</td>
<td>0 V ... 10 V, -10 V ... +10 V, 0/4 mA ... 20 mA, Pt100/1000, Ni1000 (each input can be configured individually)</td>
</tr>
</tbody>
</table>
| Channel input resistance | Voltage: > 100 kΩ  
Current: ca. 330 Ω |
| Time constant of the input filter | Voltage: 100 µs  
Current: 100 µs |
| Indication of the input signals | 1 LED per channel |
| Conversion cycle | 2 ms (for 16 inputs), with Pt/Ni... 1 s |
| Resolution | Range 0 V ... 10 V: 12 bits  
Range -10 V ... +10 V: 12 bits including sign  
Range 0 mA ... 20 mA: 12 bits  
Range 4 mA ... 20 mA: 12 bits |
<p>| Conversion error of the analog values caused by non-linearity, adjustment error at factory and resolution within the normal range | Typ. ±0.5 % of full scale at +25 °C |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max. ±1 % of full scale (all ranges)</td>
<td>at 0 °C ... +60 °C or EMC disturbance</td>
</tr>
<tr>
<td>Relationship between input signal and hex code</td>
<td>Chapter 5.2.4.4.2.2.10.2 “Input ranges resistance temperature detector” on page 720</td>
</tr>
<tr>
<td>Unused voltage inputs</td>
<td>Are configured as “unused”</td>
</tr>
<tr>
<td>Unused current inputs</td>
<td>Have a low resistance, can be left open-circuited</td>
</tr>
<tr>
<td>Overvoltage protection</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Technical data of the analog inputs, if used as digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>Max. 16</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>2 groups of 8 channels each</td>
</tr>
<tr>
<td>Connections of the channels I0+ ... I7+</td>
<td>Terminals 2.0 ... 2.7</td>
</tr>
<tr>
<td>Connections of the channels I8+ ... I15+</td>
<td>Terminals 4.0 ... 4.7</td>
</tr>
<tr>
<td>Reference potential for the inputs</td>
<td>Terminals 1.9, 2.9, 3.9 and 4.9 (ZP)</td>
</tr>
<tr>
<td>Input signal delay</td>
<td>Typ. 8 ms, configurable from 0.1 ... 32 ms</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 LED per channel</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-30 V ... +5 V</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>+5 V ... +13 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>+13 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 7 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>Typ. 1.4 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>Typ. 4.3 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 9 mA</td>
</tr>
<tr>
<td>Input resistance</td>
<td>Ca. 3.5 kΩ</td>
</tr>
</tbody>
</table>
Dimensions

The dimensions are in mm and in brackets in inch.

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 250 300 R0001</td>
<td>Ai523, analog input module, 16 AI, U/I/Pt100, 12 bits including sign, 2-wires</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 450 300 R0001</td>
<td>Ai523-XC, analog input module, 16 AI, U/I/Pt100, 12 bits including sign, 2-wires, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
**AI531 - Analog input module**

**Features**

- 8 configurable analog inputs (I0 ... I7) in 2 groups (1.0 ... 1.7 and 2.0 ... 2.7 as well as 3.0 ... 3.7 and 4.0 ... 4.7)
  - Resolution 16 bits including sign
- Module-wise galvanically isolated
- XC version for use in extreme ambient conditions available

![Diagram of AI531 Analog Input Module](image)

1. I/O bus
2. Allocation between terminal number and signal names
3. 4 yellow LEDs to display the states at the inputs I0 ... I3
4. 4 yellow LEDs to display the states at the inputs I4 ... I7
5. 1 green LED to display the process supply voltage UP
6. 2 red LEDs to display errors (CH-ERR2 and CH-ERR4)
7. Label
8. Terminal unit
9. DIN rail

*: Sign for XC version

**Intended purpose**

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g. CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.
Functionality

8 analog inputs, individually configurable for

- Unused (default setting)
- 0 V ... 5 V, 0 V ... 10 V
- -50 mV ... +50 mV, -500 mV ... +500 mV
- -1 V ... +1 V, -5 V ... +5 V, -10 V ... +10 V
- 0 mA ... 20 mA
- 4 mA ... 20 mA
- -20 mA ... 20 mA
- Pt100, -50 °C ... +70 °C or +400 °C (2-, 3- and 4-wire)
- Pt100, -200 °C ... +850 °C (2-, 3- and 4-wire)
- Pt1000, -50 °C ... +400 °C (2-, 3- and 4-wire)
- Ni1000, -50 °C ... +150 °C (2-, 3- and 4-wire)
- Cu50 (1.426): -50 °C ... +200 °C (2-, 3- and 4-wire)
- Cu50 (1.428): -200 °C ... +200 °C (2-, 3- and 4-wire)
- 0 Ω ... 50 kΩ
- Thermocouples of types J, K, T, N, S
- Resistance measuring bridge
- Digital signals (digital input)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution of the analog channels</td>
<td>16 bits including sign</td>
</tr>
<tr>
<td>Voltage and current</td>
<td>+0.1 °C (0.01°C at Pt100 -50 °C ... +70 °C)</td>
</tr>
<tr>
<td>Temperature</td>
<td>11 LEDs for signals and error messages</td>
</tr>
<tr>
<td>LED displays</td>
<td>through the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>via terminals (process voltage UP = 24 V DC)</td>
</tr>
<tr>
<td>External power supply</td>
<td>TU515 or TU516 ❆ Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938</td>
</tr>
<tr>
<td>Required terminal unit</td>
<td>For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.</td>
</tr>
</tbody>
</table>

Connections

The modules are plugged on an I/O terminal unit ❆ Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938. Properly position the modules and press until they lock in place. The terminal units are mounted on a DIN rail or with 2 screws plus the additional accessory for wall mounting ❆ Chapter 5.2.8.2.5 “TA526 - Wall mounting accessory” on page 1324.

The connection of the I/O channels is carried out using the 40 terminals of the I/O terminal unit. I/O modules can be replaced without re-wiring the terminal units.

The terminals 1.8, 2.8, 3.8, 4.8, 1.9, 2.9, 3.9 and 4.9 are electrically interconnected within the I/O terminal units and always have the same assignment, independent of the inserted module:
Terminals 1.8, 2.8, 3.8 and 4.8: process voltage UP = +24 V DC
Terminals 1.9, 2.9, 3.9 and 4.9: process voltage ZP = 0 V

The assignment of the other terminals:

<table>
<thead>
<tr>
<th>Terminals</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0, 2.2, 2.4, 2.6</td>
<td>I0+ ... I3+</td>
<td>Positive poles of the first 4 analog inputs</td>
</tr>
<tr>
<td>1.0, 1.2, 1.4, 1.6</td>
<td>I0- ... I3-</td>
<td>Negative poles of the first 4 analog inputs</td>
</tr>
<tr>
<td>2.1, 2.3, 2.5, 2.7</td>
<td>I0A ... I3A</td>
<td>Connections A (supply) of the first 4 analog inputs</td>
</tr>
<tr>
<td>1.1, 1.3, 1.5, 1.7</td>
<td>I0B ... I3B</td>
<td>Connections B (analog ground) of the first 4 analog inputs</td>
</tr>
<tr>
<td>4.0, 4.2, 4.4, 4.6</td>
<td>I4+ ... I7+</td>
<td>Positive poles of the following 4 analog inputs</td>
</tr>
<tr>
<td>3.0, 3.2, 3.4, 3.6</td>
<td>I4- ... I7-</td>
<td>Negative poles of the following 4 analog inputs</td>
</tr>
<tr>
<td>4.1, 4.3, 4.5, 4.7</td>
<td>I4A ... I7A</td>
<td>Connections A (supply) of the following 4 analog inputs</td>
</tr>
<tr>
<td>3.1, 3.3, 3.5, 3.7</td>
<td>I4B ... I7B</td>
<td>Connections B (analog ground) of the following 4 analog inputs</td>
</tr>
</tbody>
</table>

**CAUTION!**
Analog sensors must be galvanically isolated against the ground. In order to avoid inaccuracy with the measuring results, the analog sensors should also be isolated against the power supply.

The "IxB" clamps (x=0 ... 7) of the analog inputs are galvanically connected to each other. They form an "Analog Ground Signal" (AGND) for the module.

The negative poles of the analog inputs Ix- may accept a potential difference up to ±20 V DC with regard to the common reference potential IxB (AGND, ZP). Observing this maximum voltage difference, analog current inputs of one module can be switched in series to each other and also with current inputs of other modules.

For the open-circuit detection (wire break), each positive analog input channel Ix+ is pulled up to "plus" by a high-resistance resistor and each negative analog input channel Ix- is pulled down to "minus" by a resistor. If wire break occurs, a maximum voltage (overflow or underflow) will be read in then.

The internal power supply voltage for the module’s circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 2 mA per AI531.
The external power supply connection is carried out via the UP (+24 V DC) and the ZP (0 V DC) terminals.

**WARNING!**
Removal/Insertion under power

Removal or insertion under power is permissible only if all conditions for hot swapping are fulfilled.

☞ Chapter 4.9.3 “Replace an I/O module with hot swap” on page 153

The devices are not designed for removal or insertion under power when the conditions for hot swap do not apply. Because of unforeseeable consequences, it is not allowed to plug in or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you
– connect or disconnect any signal or terminal block
– remove, mount or replace a module.

Disconencting any powered devices while they are energized in a hazardous location could result in an electric arc, which could create an ignition source resulting in fire or explosion.

Prior to proceeding, make sure that power is been disconnected and that the area has been thoroughly checked to ensure that flammable materials are not present.

The devices must not be opened when in operation. The same applies to the network interfaces.

**NOTICE!**
Risk of damaging the PLC modules!

Overvoltages and short circuits might damage the PLC modules.

– Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
– Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

Generally, analog signals must be laid in shielded cables. The cable shields must be grounded at both sides of the cables. In order to avoid unacceptable potential differences between different parts of the installation, low resistance equipotential bonding conductors must be laid.
Fig. 99: 8 analog inputs in two groups, individually configurable

CAUTION!
By installing equipotential bonding conductors between the different parts of the system, it must be ensured that the potential difference between ZP and AGND never can exceed 1 V.

CAUTION!
The process supply voltage must be included in the grounding concept (e.g. grounding of the negative terminal).

The module provides several diagnosis functions

Chapter 5.2.4.4.2.3.3 “Functionality” on page 726

Chapter 5.2.4.4.2.3.8 “Diagnosis” on page 753.
Connection of active-type analog sensors (Voltage) with galvanically isolated power supply

Standard ranges

Fig. 100: Connection example

The measuring ranges can be configured in Chapter 5.2.4.4.2.3.7 “Parameterization” on page 749:
Voltage range: 
- 50 mV ... +50 mV
- 500 mV ... +500 mV
- 1 V ... +1 V
- 10 V ... +10 V
- 0 V ... +5 V
- 0 V ... +10 V

1 channel used

**Common mode range (±20 V)**

Fig. 101: Connection example

The measuring range can be configured by Chapter 5.2.4.4.2.3.7 “Parameterization” on page 749:

<table>
<thead>
<tr>
<th>Voltage</th>
<th>Common mode voltage</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>-50 mV ... +50 mV</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-500 mV ... +500 mV</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-10 V ... +10 V</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0 V ... +5 V</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0 V ... +10 V</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The function of the LEDs is described under diagnosis and displays/displays by Chapter 5.2.4.4.2.3.8 “Diagnosis” on page 753.

In order to avoid error messages or long processing times, it is useful to configure unused analog input channels as "unused".
Connection of active-type analog sensors (Voltage) with no galvanically isolated power supply

**Standard ranges**

![Connection diagram](image)

*Fig. 102: Connection example*

**CAUTION!**

If GND is not directly connected to ZP at the sensor, the supply current flows via the GND line to ZP. Measuring errors can only occur caused by voltage differences higher than ± 20 V DC between GND and ZP.

The measuring ranges can be configured in **Chapter 5.2.4.4.2.3.7 “Parameterization” on page 749**:

<table>
<thead>
<tr>
<th>Voltage</th>
<th>-50 mV ... +50 mV</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-500 mV ... +500 mV</td>
<td>1 channel used</td>
</tr>
<tr>
<td>Voltage</td>
<td>-1 V ... +1 V</td>
<td>1 channel used</td>
</tr>
<tr>
<td>Voltage</td>
<td>-5 V ... +5 V</td>
<td>1 channel used</td>
</tr>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V</td>
<td>1 channel used</td>
</tr>
<tr>
<td>Voltage</td>
<td>0 V ... +5 V</td>
<td>1 channel used</td>
</tr>
<tr>
<td>Voltage</td>
<td>0 V ... +10 V</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>
CAUTION!
If GND is not directly connected to ZP at the sensor, the supply current flows via the GND line to ZP. Measuring errors can only occur caused by voltage differences higher than ±20 V DC between GND and ZP.

The measuring range can be configured in Chapter 5.2.4.4.2.3.7 “Parameterization” on page 749:

<table>
<thead>
<tr>
<th>Voltage</th>
<th>Common mode voltage</th>
<th>1 channel used</th>
</tr>
</thead>
</table>

The function of the LEDs is described under diagnosis and displays/displays in Chapter 5.2.4.4.2.3.8 “Diagnosis” on page 753.

In order to avoid error messages or long processing times, it is useful to configure unused analog input channels as "unused".
Connection of active-type analog sensors (Current) with galvanically isolated power supply

![Diagram of connection example]

Fig. 104: Connection example

The following measuring ranges can be configured "Chapter 5.2.4.4.2.3.7 “Parameterization” on page 749:

<table>
<thead>
<tr>
<th>Current</th>
<th>-20 mA ... 20 mA</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>0 mA ... 20 mA</td>
<td>1 channel used</td>
</tr>
<tr>
<td>Current</td>
<td>4 mA ... 20 mA</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

The function of the LEDs is described under diagnosis and displays/displays "Chapter 5.2.4.4.2.3.8 “Diagnosis” on page 753.

Unused input channels can be left open, because they are of low resistance.
Connection of active-type analog sensors (Current) with galvanically isolated power supply and series-connection of an additional input

![Diagram of connection example]

**Fig. 105: Connection example**

1 Analog input of the second device
If series-connection of an additional input is used, the input resistance of the module (ca. 330 Ω) must be added to the input resistance of the second device. Make sure that the maximum permitted load resistance of the analog sensor is not exceeded (see the data sheet of the analog sensor).

The input of the module is not related to ZP. If the input of the second device is related to ZP, the order of sequence in the series-connection must be observed by all means (from the sensor to the module and then to the input of the second device).

The following measuring ranges can be configured "Parameterization" on page 749:

<table>
<thead>
<tr>
<th>Current</th>
<th>Measurement Range</th>
<th>Used Channels</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>-20 mA ... 20 mA</td>
<td>1 channel used</td>
</tr>
<tr>
<td>Current</td>
<td>0 mA ... 20 mA</td>
<td>1 channel used</td>
</tr>
<tr>
<td>Current</td>
<td>4 mA ... 20 mA</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

For a description of the functions of the LEDs, please refer to diagnosis and displays/displays "Diagnosis" on page 753.

Unused input channels can be left open, because they are of low resistance.

Connection of passive-type analog sensors (Current)

Fig. 106: Connection example

The following measuring ranges can be configured "Parameterization" on page 749:
<table>
<thead>
<tr>
<th>Current</th>
<th>-20 mA ... 20 mA *)</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>0 mA ... 20 mA *)</td>
<td>1 channel used</td>
</tr>
<tr>
<td>Current</td>
<td>4 mA ... 20 mA</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

*) This setting is not applicable with passive-type analog sensors (current).

The function of the LEDs is described under diagnosis and displays/display "Chapter 5.2.4.4.2.3.8 "Diagnosis" on page 753.

Unused input channels can be left open, because they are of low resistance.
Connection of passive-type analog sensors (Current) and series-connection of an additional analog sensor

Fig. 107: Connection example
1  Analog input of the second device
If series-connection of an additional input is used, the input resistance of the module (ca. 330 Ω) must be added to the input resistance of the second device. Make sure that the maximum permitted load resistance of the analog sensor is not exceeded (see the data sheet of the analog sensor).

The input of the module is not related to ZP. If the input of the second device is related to ZP, the order of sequence in the series-connection must be observed by all means (from the sensor to the module and then to the input of the second device).

The following measuring ranges can be configured

<table>
<thead>
<tr>
<th>Current</th>
<th>-20 mA ... 20 mA (*)</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>0 mA ... 20 mA (*)</td>
<td>1 channel used</td>
</tr>
<tr>
<td>Current</td>
<td>4 mA ... 20 mA</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

*) This setting is not applicable with passive-type analog sensors (current).

The function of the LEDs is described under diagnosis and displays/displays.

Unused input channels can be left open, because they are of low resistance.

Connection of digital signal sources at analog inputs

Several (or all) analog inputs can be configured as digital inputs. The inputs are not galvanically isolated against the other analog channels.

---

Table: Digital input configuration

<table>
<thead>
<tr>
<th>Digital input</th>
<th>24 V</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effect of incorrect input terminal connection</td>
<td>Wrong or no signal detected, no damage up to 35 V</td>
<td></td>
</tr>
</tbody>
</table>
Connection of resistance thermometers in 2-wire configuration

When resistance thermometers (Pt100, Pt1000, Ni1000, Cu50) are used, a constant current must flow through them to build the necessary voltage drop for the evaluation. For this, the module AI531 provides a constant current source which is multiplexed over the 4 analog channels.

![Connection example](Fig. 109: Connection example)

The following measuring ranges can be configured:

<table>
<thead>
<tr>
<th>Resistance Thermometer</th>
<th>Measuring Range</th>
<th>Used Channels</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pt100</td>
<td>-50 °C ... +70 °C / +400 °C; -200 °C ... +850 °C</td>
<td>1 channel used</td>
</tr>
<tr>
<td>Pt1000</td>
<td>-50 °C ... +400 °C</td>
<td>1 channel used</td>
</tr>
<tr>
<td>Ni1000</td>
<td>-50 °C ... +150 °C</td>
<td>1 channel used</td>
</tr>
<tr>
<td>Cu50</td>
<td>-50 °C ... +200 °C (1.426); -200 °C ... +200 °C (1.428)</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

For a description of the function of the LEDs, please refer to diagnosis and displays/displays.

Chapter 5.2.4.4.2.3.8 “Diagnosis” on page 753.

The module linearizes the resistance thermometer characteristics.

In order to avoid error messages from unused analog input channels, it is useful to configure them as "unused".

Connection of resistance thermometers in 3-wire configuration

When resistance thermometers (Pt100, Pt1000, Ni1000, Cu50) are used, a constant current must flow through them to build the necessary voltage drop for the evaluation. For this, the module AI531 provides a constant current source which is multiplexed over the 4 analog channels.
The following measuring ranges can be configured [Chapter 5.2.4.4.2.3.7 “Parameterization” on page 749):

<table>
<thead>
<tr>
<th>Material</th>
<th>Measuring Range</th>
<th>Channels Used</th>
</tr>
</thead>
</table>
| Pt100    | -50 °C ... +70 °C/+400 °C; 
           | -200 °C ... +850 °C | 1 channel used |
| Pt1000   | -50 °C ... +400 °C | 1 channel used |
| Ni1000   | -50 °C ... +150 °C | 1 channel used |
| Cu50     | -50 °C ... +200 °C (1.426); 
           | -200 °C ... +200 °C (1.428) | 1 channel used |

For a description of the function of the LEDs, please refer to diagnosis and displays/displays [Chapter 5.2.4.4.2.3.8 “Diagnosis” on page 753].

The module linearizes the resistance thermometer characteristics. In order to keep measuring errors as small as possible, it is necessary by all means to have all the involved conductors in the same cable. All the conductors must have the same cross section.

In order to avoid error messages from unused analog input channels, it is useful to configure them as "unused".

**Connection of resistance thermometers in 4-wire configuration**

When resistance thermometers (Pt100, Pt1000, Ni1000, Cu50) are used, a constant current must flow through them to build the necessary voltage drop for the evaluation. For this, the module AI531 provides a constant current source which is multiplexed over the 4 analog channels.
The following measuring ranges can be configured on page 749:

<table>
<thead>
<tr>
<th>Sensor</th>
<th>Measuring Range</th>
<th>Channels Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pt100</td>
<td>-50 °C ... +70 °C/+400 °C; -200 °C ... +850 °C</td>
<td>1 channel used</td>
</tr>
<tr>
<td>Pt1000</td>
<td>-50 °C ... +400 °C</td>
<td>1 channel used</td>
</tr>
<tr>
<td>Ni1000</td>
<td>-50 °C ... +150 °C</td>
<td>1 channel used</td>
</tr>
<tr>
<td>Cu50</td>
<td>-50 °C ... +200 °C (1.426); -200 °C ... +200 °C (1.428)</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

For a description of the function of the LEDs, please refer to diagnosis and displays/displays on page 753.

The module linearizes the resistance thermometer characteristics. In order to keep measuring errors as small as possible, it is necessary by all means, to have all the involved conductors in the same cable.

In order to avoid error messages from unused analog input channels, it is useful to configure them as "unused".

Connection of resistors in 2-wire configuration

For evaluating resistors, a constant current must flow through them to build the necessary voltage drop. For this, the module AI531 provides a constant current source which is multiplexed over the 4 analog channels.
The following measuring ranges can be configured on page 749:

<table>
<thead>
<tr>
<th>Resistor</th>
<th>50 kΩ</th>
<th>1 channel used</th>
</tr>
</thead>
</table>

For a description of the function of the LEDs, please refer to diagnosis and displays displays on page 753.

In order to avoid error messages from unused analog input channels, it is useful to configure them as "unused".

**Connection of a resistance measuring bridge with internal supply**

When resistance measuring bridges are connected, the short-circuit-proof voltage output (internal supply) at pin 10A (or 12A, 14A, 16A) must be used. This supply voltage is activated as soon as "Voltage Measurement" is configured for the relevant channel.
All voltage measuring ranges can be configured in Chapter 5.2.4.4.2.3.7 “Parameterization” on page 749.

<table>
<thead>
<tr>
<th>Voltage</th>
<th>Range</th>
<th>Channels Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>-50 mV ... +50 mV</td>
<td>1 channel used</td>
<td></td>
</tr>
<tr>
<td>-500 mV ... +500 mV</td>
<td>1 channel used</td>
<td></td>
</tr>
<tr>
<td>-1 V ... +1 V</td>
<td>1 channel used</td>
<td></td>
</tr>
<tr>
<td>-5 V ... +5 V</td>
<td>1 channel used</td>
<td></td>
</tr>
<tr>
<td>-10 V ... +10 V</td>
<td>1 channel used</td>
<td></td>
</tr>
<tr>
<td>0 V ... +5 V</td>
<td>1 channel used</td>
<td></td>
</tr>
<tr>
<td>0 V ... +10 V</td>
<td>1 channel used</td>
<td></td>
</tr>
</tbody>
</table>

The calculation of the resistor deviation must be performed via the bridge voltage by the PLC user program.

**Connection of a resistance measuring bridge with external supply**

With the connection of a resistance measuring bridge with external supply, the supply voltage is provided separately.
Fig. 114: Connection example

1 Bridge to IxB necessary with galvanically isolated supply

All voltage measuring ranges can be configured $\triangleright$ Chapter 5.2.4.4.2.3.7 “Parameterization” on page 749.
### Hardware descriptions

#### Device specifications > I/O modules

<table>
<thead>
<tr>
<th>Voltage</th>
<th>Range</th>
<th>Channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>-50 mV</td>
<td>... +50 mV</td>
<td>1 channel</td>
</tr>
<tr>
<td>-500 mV</td>
<td>... +500 mV</td>
<td>1 channel</td>
</tr>
<tr>
<td>-1 V</td>
<td>... +1 V</td>
<td>1 channel</td>
</tr>
<tr>
<td>-5 V</td>
<td>... +5 V</td>
<td>1 channel</td>
</tr>
<tr>
<td>-10 V</td>
<td>... +10 V</td>
<td>1 channel</td>
</tr>
<tr>
<td>0 V</td>
<td>... +5 V</td>
<td>1 channel</td>
</tr>
<tr>
<td>0 V</td>
<td>... +10 V</td>
<td>1 channel</td>
</tr>
</tbody>
</table>

The calculation of the resistor deviation must be performed via the bridge voltage by the PLC user program.
Connection of thermocouples

The following measuring ranges can be configured on page 749:

- **J type** -210 °C ... +1200 °C Fe-CuNi, 1 channel used
- **K type** -270 °C ... +1372 °C Ni-CrNi, 1 channel used
- **N type** -270 °C ... +1300 °C NiCrSi-NiSi, 1 channel used
- **S type** -50 °C ... +1768 °C Pt10Rh-Pt, 1 channel used
- **T type** -270 °C ... +400 °C Cu-CuNi, 1 channel used

---

**Fig. 115: Connection example**

The following measuring ranges can be configured on page 749:
For a description of the function of the LEDs, please refer to diagnosis and displays/displays
© Chapter 5.2.4.4.2.3.8 “Diagnosis” on page 753.

The module linearizes the thermocouple characteristics. It supports the following possibilities of
temperature compensation and handling with cold junctions:

Internal compensation

An internal temperature sensor which is located next to the terminal unit is used to detect the
temperature of the cold junction. So the compensating cables must be connected directly to the
terminal unit, where the cold junction is located.

The setting “Internal compensation (default)” for the parameter “Compensation channel” should
be selected.

To get more precise temperature measurements, the use of an external com-
pensation method is recommended.

External compensation with temperature input

The temperature for the cold junction can be determinated externally.

A measured or known temperature value (e.g. ambient temperature in the cabinet) is transferred
to the module via the output data word to all required channels. The possible temperature range
is -25 °C ... +60 °C and is monitored by the AI531.

The setting “External with temperature value” for the parameter “Compensation channel” should
be selected.

External compensation with compensation box

A compensation box balances the temperature difference between the cold junction and the
reference temperature by generating a bridge voltage. The reference temperature is transferred
via the output data word.

The compensation box must fit to the type of thermocouple and is located at the end of the
compensating cables, where the cold junction is located. The cabling to the AI531 can be
carried out with normal cables. The operating manual of the compensation box also has to be
considered.

The setting “External with temperature value” for the parameter “Compensation channel” should
be selected.

External compensation with flanking channel

A flanking channel of the same input group can be used for compensation, e. g. for channel
3, the channels 0, 1 and 2 can be selected as reference channels. The type of sensor for the
reference channel can be selected in the parameters for the flanking channel. For example, a
RTD sensor which is located next to the thermocouple terminal can be used as reference point
for other channels.

The setting “Channel x” for the parameter “Compensation channel” should be selected. Refer
to ‘Channel configuration’ for possible settings © Chapter 5.2.4.4.2.3.7 “Parameterization”
on page 749.

In order to avoid error messages from unused analog input channels, it is useful to configure
them as “unused”.

Hardware descriptions
Device specifications > I/O modules
Internal data exchange

<table>
<thead>
<tr>
<th>Digital inputs (bytes)</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital outputs (bytes)</td>
<td>0</td>
</tr>
<tr>
<td>Analog inputs (words)</td>
<td>8</td>
</tr>
<tr>
<td>Analog outputs (words)</td>
<td>1</td>
</tr>
</tbody>
</table>

I/O configuration

The module does not store configuration data itself. It gets its parameterization data from the master device of the I/O bus (CPU or communication interface module) during power-up of the system.

This means that replacing I/O modules is possible without any re-parameterization via software.

*If the external power supply voltage via UP/ZP terminals fails, the I/O module loses its configuration data. The whole station has to be switched off and on again to re-configure the module.*

Parameterization

<table>
<thead>
<tr>
<th>Firmware version</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firmware version &gt; V2.0.0</td>
<td>The arrangement of the parameter data is performed by Control Builder Plus/ Automation Builder software.</td>
</tr>
</tbody>
</table>

The parameter data directly influences the functionality of modules.

For non-standard applications, it is necessary to adapt the parameters to your system configuration.

Module: Module slot address: Y = 1 ... 10

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, Type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot/Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Internal</td>
<td>1535</td>
<td>Word</td>
<td>1535</td>
<td>0</td>
<td>65535</td>
<td>0x0Y01</td>
</tr>
<tr>
<td>Ignore module</td>
<td>No</td>
<td>0</td>
<td>Byte</td>
<td>No</td>
<td>0x00</td>
<td></td>
<td>Not for FBP</td>
</tr>
<tr>
<td>Parameter length in bytes</td>
<td>Internal</td>
<td>36</td>
<td>Byte</td>
<td>36</td>
<td>0</td>
<td>255</td>
<td>0x0Y02</td>
</tr>
<tr>
<td>Check supply</td>
<td>Off</td>
<td>0</td>
<td>Byte</td>
<td>On</td>
<td>0x01</td>
<td></td>
<td>0x0Y03</td>
</tr>
<tr>
<td>Analog data format</td>
<td>Default</td>
<td>0</td>
<td>Byte</td>
<td>Default</td>
<td>0x00</td>
<td></td>
<td>0x0Y04</td>
</tr>
</tbody>
</table>

1) With CS31 and addresses smaller than 70 and FBP, the value is increased by 1
Not with FBP

GSD file:

\[
\text{Ext\_User\_Prm\_Data\_Len} = 39 \\
\text{Ext\_User\_Prm\_Data\_Const(0)} = 0x05, 0xff, 0x24, 0x01, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00
\]

### Input channel (8x)

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, Type</th>
<th>Default</th>
<th>EDS Slot Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Channel configuration</td>
<td>see table 'Channel configuration' * Table 167 &quot;Channel configuration&quot; on page 751</td>
<td>see 'Channel configuration' * Table 167 &quot;Channel configuration&quot; on page 751</td>
<td>Byte</td>
<td>0</td>
<td>0x0Y07</td>
</tr>
<tr>
<td>2</td>
<td>Channel monitoring</td>
<td>see table 'Channel monitoring' * Table 168 &quot;Channel monitoring&quot; on page 752</td>
<td>see 'Channel monitoring' * Table 168 &quot;Channel monitoring&quot; on page 752</td>
<td>Byte</td>
<td>0</td>
<td>0x03</td>
</tr>
<tr>
<td>3</td>
<td>Line frequency suppression</td>
<td>see table 'Line frequency suppression' * Further information on page 752</td>
<td>see 'Line frequency suppression' * Further information on page 752</td>
<td>Byte</td>
<td>0</td>
<td>0x00</td>
</tr>
<tr>
<td>4</td>
<td>Compensation channel</td>
<td>see table 'Compensation channel' * Further information on page 752</td>
<td>see table 'Compensation channel' * Further information on page 752</td>
<td>Byte</td>
<td>0</td>
<td>0x00</td>
</tr>
<tr>
<td>Internal value</td>
<td>Operating modes for the analog inputs, individually configurable</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>Unused (default)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Digital input</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>Analog input -50 mV ... +50 mV</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td>Analog input -500 mV ... +500 mV</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>36</td>
<td>Analog input -1 V ... +1 V</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Analog input -5 V ... +5 V</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Analog input -10 V ... +10 V</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Analog input 0 V ... +5 V</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Analog input 0 V ... +10 V</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>Analog input -20 mA ... +20 mA</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Analog input 0 mA ... 20 mA</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Analog input 4 mA ... 20 mA</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Analog input Pt100 (2-wire), -50 °C ... +70 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Analog input Pt100 (3-wire), -50 °C ... +70 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>48</td>
<td>Analog input Pt100 (4-wire), -50 °C ... +70 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>57</td>
<td>Analog input Pt100 (2-wire), -50 °C ... +70 °C (resolution: 0,01 K)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>58</td>
<td>Analog input Pt100 (3-wire), -50 °C ... +70 °C (resolution: 0,01 K)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>59</td>
<td>Analog input Pt100 (4-wire), -50 °C ... +70 °C (resolution: 0,01 K)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Analog input Pt100 (2-wire), -50 °C ... +400 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Analog input Pt100 (3-wire), -50 °C ... +400 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>49</td>
<td>Analog input Pt100 (4-wire), -50 °C ... +400 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45</td>
<td>Analog input Pt100 (2-wire), -200 °C ... +850 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>46</td>
<td>Analog input Pt100 (3-wire), -200 °C ... +850 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>47</td>
<td>Analog input Pt100 (4-wire), -200 °C ... +850 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Analog input Pt1000 (2-wire), -50 °C ... +400 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Analog input Pt1000 (3-wire), -50 °C ... +400 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td>Analog input Pt1000 (4-wire), -50 °C ... +400 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>Analog input Ni1000 (2-wire), -50 °C ... +150 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>Analog input Ni1000 (3-wire), -50 °C ... +150 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>51</td>
<td>Analog input Ni1000 (4-wire), -50 °C ... +150 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>39</td>
<td>Analog input Cu50 1.426 (2-wire) -50 °C ... +200 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td>Analog input Cu50 1.426 (3-wire) -50 °C ... +200 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>41</td>
<td>Analog input Cu50 1.426 (4-wire) -50 °C ... +200 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>42</td>
<td>Analog input Cu50 1.428 (2-wire) -200 °C ... +200 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>43</td>
<td>Analog input Cu50 1.428 (3-wire) -200 °C ... +200 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>44</td>
<td>Analog input Cu50 1.428 (4-wire) -200 °C ... +200 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>Analog input J-type thermocouple -210 °C ... +1200 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>Analog input K-type thermocouple -270 °C ... +1372 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>Analog input N-type thermocouple -270 °C ... +1300 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Internal value</td>
<td>Operating modes for the analog inputs, individually configurable</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------------</td>
<td>---------------------------------------------------------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>Analog input S-type thermocouple -50 °C ... +1768 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>Analog input T-type thermocouple -270 °C ... +400 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>38</td>
<td>Analog input resistor 50 kΩ</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>52</td>
<td>Temperature-internal reference point</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>53</td>
<td>Common mode voltage</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Table 168: Channel monitoring**

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Monitoring</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Plausibility, open-circuit (wire break) and short circuit (default)</td>
</tr>
<tr>
<td>3</td>
<td>No monitoring</td>
</tr>
</tbody>
</table>

**Table 169: Line frequency suppression**

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Line frequency suppression</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>50 Hz</td>
</tr>
<tr>
<td>1</td>
<td>60 Hz</td>
</tr>
<tr>
<td>2</td>
<td>No line frequency suppression</td>
</tr>
</tbody>
</table>

**Table 170: Compensation channel**

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Compensation channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Internal compensation (default)</td>
</tr>
<tr>
<td>1</td>
<td>Channel 0 (possible with channels 1, 2, 3)</td>
</tr>
<tr>
<td>2</td>
<td>Channel 1 (possible with channels 0, 2, 3)</td>
</tr>
<tr>
<td>3</td>
<td>Channel 2 (possible with channels 0, 1, 3)</td>
</tr>
<tr>
<td>4</td>
<td>Channel 3 (possible with channels 0, 1, 2)</td>
</tr>
<tr>
<td>5</td>
<td>Channel 4 (possible with channels 5, 6, 7)</td>
</tr>
<tr>
<td>6</td>
<td>Channel 5 (possible with channels 4, 6, 7)</td>
</tr>
<tr>
<td>7</td>
<td>Channel 6 (possible with channels 4, 5, 7)</td>
</tr>
<tr>
<td>8</td>
<td>Channel 7 (possible with channels 4, 5, 6)</td>
</tr>
<tr>
<td>9</td>
<td>External with temperature value</td>
</tr>
</tbody>
</table>
## Diagnosis

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Module error

<table>
<thead>
<tr>
<th>3</th>
<th>14</th>
<th>1 ... 10</th>
<th>31</th>
<th>31</th>
<th>19</th>
<th>Checksum error in the I/O module</th>
<th>Replace I/O module</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>3</th>
<th>14</th>
<th>1 ... 10</th>
<th>31</th>
<th>31</th>
<th>3</th>
<th>Timeout in the I/O module</th>
<th>Replace I/O module</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>3</th>
<th>14</th>
<th>1 ... 10</th>
<th>31</th>
<th>31</th>
<th>40</th>
<th>Different hard-/firmware versions in the module</th>
<th>Replace I/O module</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>3</th>
<th>14</th>
<th>1 ... 10</th>
<th>31</th>
<th>31</th>
<th>43</th>
<th>Internal error in the module, e.g. internal analog voltage is not correct</th>
<th>Replace I/O module</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>3</th>
<th>14</th>
<th>1 ... 10</th>
<th>31</th>
<th>31</th>
<th>36</th>
<th>Internal data exchange failure</th>
<th>Replace I/O module</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>3</th>
<th>14</th>
<th>1 ... 10</th>
<th>31</th>
<th>31</th>
<th>9</th>
<th>Overflow diagnosis buffer</th>
<th>Restart</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>3</th>
<th>14</th>
<th>1 ... 10</th>
<th>31</th>
<th>31</th>
<th>26</th>
<th>Parameter error</th>
<th>Check master</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>3</th>
<th>14</th>
<th>1 ... 10</th>
<th>31</th>
<th>31</th>
<th>11</th>
<th>Process voltage too low</th>
<th>Check process voltage</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>4</th>
<th>14</th>
<th>1 ... 10</th>
<th>1</th>
<th>0 ... 7</th>
<th>45</th>
<th>Process voltage is switched OFF (ON -&gt; OFF)</th>
<th>Process voltage ON</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Channel error

<table>
<thead>
<tr>
<th>4</th>
<th>14</th>
<th>1 ... 10</th>
<th>1</th>
<th>0 ... 7</th>
<th>48</th>
<th>Analog value overflow or broken wire at an analog input</th>
<th>Check input value or terminal</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>4</th>
<th>14</th>
<th>1 ... 10</th>
<th>1</th>
<th>0 ... 7</th>
<th>7</th>
<th>Analog value underflow at an analog input</th>
<th>Check input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>4</th>
<th>14</th>
<th>1 ... 10</th>
<th>1</th>
<th>0 ... 7</th>
<th>47</th>
<th>Short circuit at an analog input</th>
<th>Check terminal</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>4</th>
<th>14</th>
<th>1 ... 10</th>
<th>1</th>
<th>0 ... 7</th>
<th>1</th>
<th>Possibly wrong measured value caused by inadmissible temperature of the compensation channel</th>
<th>Check the temperature compensation channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Class</td>
<td>Interface</td>
<td>Device</td>
<td>Module</td>
<td>Channel</td>
<td>Error identifier</td>
<td>Error message</td>
<td>Remedy</td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>--------</td>
<td>--------</td>
<td>---------</td>
<td>----------------</td>
<td>--------------</td>
<td>--------</td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>1</td>
<td>0 ... 7</td>
<td>2</td>
<td>Invalid measured value of the channel caused by overly high voltage difference</td>
<td>Check voltage difference; install equalizing conductors if necessary</td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>1</td>
<td>0 ... 7</td>
<td>11</td>
<td>Output voltage 10 V faulty</td>
<td>Check output load</td>
</tr>
</tbody>
</table>

**Remarks:**

1) In AC500, the following interface identifier applies:
   - 14 = I/O bus, 11 = COM1 (e.g. CS31 bus), 12 = COM2.
   - The FBP diagnosis block does not contain this identifier.

2) With "Device" the following allocation applies:
   - 31 = module itself, 1 ... 10 expansion module 1 ... 10, ADR = hardware address (e.g. of the DC551)

3) With "Module" the following allocation applies dependent of the master:
   - Module error: I/O bus or FBP: 31 = module itself; COM1/COM2: 1 ... 10 = expansion 1 ... 10
   - Channel error: I/O bus or FBP = module type (1 = AI); COM1/COM2: 1 ... 10 = expansion 1 ... 10

4) In case of module errors, with channel "31 = Module itself" is output.

**State LEDs**

During the power ON procedure, the module initializes automatically. All LEDs (except the channel LEDs) are ON during this time.

States of the LEDs (see also section diagnosis LEDs in the S500 system data):
### Measuring ranges

**Voltage input ranges**

**Bipolar voltage input range, measuring bridge**

The represented resolution corresponds to 16 bits.

<table>
<thead>
<tr>
<th>Range</th>
<th>-50 mV ... +50 mV</th>
<th>-500 mV ... +500 mV</th>
<th>-1 V ... +1 V</th>
<th>-5 V ... +5 V</th>
<th>-10 V ... +10 V</th>
<th>Commo n Mode Voltage</th>
<th>Digital value</th>
<th>Decimal</th>
<th>Hex.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overflow</td>
<td>&gt; 58.7945</td>
<td>&gt; 587.9449</td>
<td>&gt; 1.17589</td>
<td>&gt; 5.8794</td>
<td>&gt; 11.7589</td>
<td>&gt; 20.0000</td>
<td>32767</td>
<td>7FFF</td>
<td></td>
</tr>
<tr>
<td>Measured value too high</td>
<td>58.7945</td>
<td>587.9449</td>
<td>1.17589</td>
<td>5.8794</td>
<td>11.7589</td>
<td>20.0000</td>
<td>32511</td>
<td>7EFF</td>
<td>6C01</td>
</tr>
<tr>
<td>Normal range</td>
<td>50.0000</td>
<td>500.0000</td>
<td>1.00000</td>
<td>5.0000</td>
<td>10.0000</td>
<td>20.0000</td>
<td>27648</td>
<td>6C00</td>
<td>0001</td>
</tr>
<tr>
<td></td>
<td>0.0018</td>
<td>0.0001</td>
<td>0.00004</td>
<td>0.0002</td>
<td>0.0004</td>
<td>0.0008</td>
<td>0</td>
<td>0000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.000000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0</td>
<td>0</td>
<td>0000</td>
<td></td>
</tr>
<tr>
<td>Range</td>
<td>-50 mV ... +50 mV</td>
<td>-500 mV ... +500 mV</td>
<td>-1 V ... +1 V</td>
<td>-5 V ... +5 V</td>
<td>-10 V ... +10 V</td>
<td>Common Mode Voltage</td>
<td>Digital value</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------</td>
<td>--------------------</td>
<td>--------------</td>
<td>--------------</td>
<td>----------------</td>
<td>-------------------</td>
<td>---------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Normal range or Measured value too low</td>
<td>-0.0018</td>
<td>-0.0181</td>
<td>-0.00004</td>
<td>-0.0002</td>
<td>-0.004</td>
<td>-27648</td>
<td>-1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>-50.0000</td>
<td>-500.0000</td>
<td>-1.00000</td>
<td>-5.0000</td>
<td>-10.0000</td>
<td>-20.0000</td>
<td>FFFF</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Measured value too low</td>
<td>-50.0018</td>
<td>-500.018</td>
<td>-1.00004</td>
<td>-5.0002</td>
<td>-10.0004</td>
<td>-27649</td>
<td>93FF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>-58.7945</td>
<td>-587.9449</td>
<td>-1.17589</td>
<td>-5.8794</td>
<td>-11.7589</td>
<td>-32512</td>
<td>8100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt; -58.7945</td>
<td>&lt; -587.9449</td>
<td>&lt; -1.17589</td>
<td>&lt; -5.8794</td>
<td>&lt; -11.7589</td>
<td>&lt; -20.0000</td>
<td>8000</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Unipolar voltage input range, measuring bridge, digital input

<table>
<thead>
<tr>
<th>Range</th>
<th>0 V ... +5 V</th>
<th>0 V ... +10 V</th>
<th>Digital input</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measured value too high</td>
<td>5.8794</td>
<td>11.7589</td>
<td>ON</td>
<td>32511</td>
</tr>
<tr>
<td></td>
<td>5.0002</td>
<td>10.0004</td>
<td>27648</td>
<td>6C00</td>
</tr>
<tr>
<td>Normal range</td>
<td>5.0000</td>
<td>10.0000</td>
<td>OFF</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0.0002</td>
<td>0.0004</td>
<td>1</td>
<td>0001</td>
</tr>
<tr>
<td>Measured value too low</td>
<td>-0.0002</td>
<td>-0.0004</td>
<td>-1</td>
<td>FFFF</td>
</tr>
<tr>
<td></td>
<td>-0.8794</td>
<td>-1.1759</td>
<td>-4864</td>
<td>ED00</td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt; -0.8794</td>
<td>&lt; -1.1759</td>
<td>-32768</td>
<td>8000</td>
</tr>
</tbody>
</table>

Current input ranges

<table>
<thead>
<tr>
<th>Range</th>
<th>-20 mA ... +20 mA</th>
<th>0 mA ... +20 mA</th>
<th>4 mA ... 20 mA</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overflow</td>
<td>&gt; 23.5178</td>
<td>&gt; 23.5178</td>
<td>&gt; 22.8142</td>
<td>32767</td>
</tr>
<tr>
<td>Measured value too high</td>
<td>23.5178</td>
<td>23.5178</td>
<td>22.8142</td>
<td>32511</td>
</tr>
<tr>
<td></td>
<td>20.0007</td>
<td>20.0007</td>
<td>20.0006</td>
<td>27649</td>
</tr>
</tbody>
</table>

Hardware descriptions

Device specifications > I/O modules
### Resistance thermometer input ranges

The represented resolution corresponds to 16 bits.

<table>
<thead>
<tr>
<th>Range</th>
<th>Pt100</th>
<th>Pt100 / Pt1000</th>
<th>Pt100 / Pt1000</th>
<th>Ni1000</th>
<th>Cu50</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>-50 °C ... +70 °C</td>
<td>-50 °C ... +400 °C</td>
<td>-50 °C ... +850 °C</td>
<td>-50 °C ... +150 °C</td>
<td>-200 °C ... +200 °C</td>
<td>Decimal</td>
</tr>
<tr>
<td>Measured value too high</td>
<td>+450.0 °C</td>
<td>+400.1 °C</td>
<td>+160.0 °C</td>
<td>+150.1 °C</td>
<td>+200 °C</td>
<td>4500</td>
</tr>
<tr>
<td></td>
<td>-80.0 °C</td>
<td>-150.1 °C</td>
<td>-150.0 °C</td>
<td>-160.0 °C</td>
<td>-80.0 °C</td>
<td>4001</td>
</tr>
<tr>
<td></td>
<td>-50.0 °C</td>
<td>-70.1 °C</td>
<td>-70.0 °C</td>
<td>-70.0 °C</td>
<td>-50.0 °C</td>
<td>701</td>
</tr>
<tr>
<td>Range</td>
<td>Pt100</td>
<td>Pt100 / Pt1000</td>
<td>Pt100</td>
<td>Ni1000</td>
<td>Cu50</td>
<td>Digital value</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------</td>
<td>----------------</td>
<td>---------</td>
<td>----------</td>
<td>----------</td>
<td>---------------</td>
</tr>
<tr>
<td></td>
<td>-50 °C ... +70 °C 1)</td>
<td>-50 °C ... +400 °C</td>
<td>-200 °C ... +850 °C</td>
<td>-50 °C ... +150 °C</td>
<td>-200 °C ... +200 °C</td>
<td>Decimal</td>
</tr>
<tr>
<td>Normal range</td>
<td>:</td>
<td>:</td>
<td>+850.0 °C</td>
<td>:</td>
<td>:</td>
<td>8500</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>+400.0 °C</td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>4000</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>+200.0 °C</td>
<td>:</td>
<td>2000</td>
</tr>
<tr>
<td></td>
<td>+70.0 °C</td>
<td>:</td>
<td>:</td>
<td>+150.0 °C</td>
<td>:</td>
<td>1500</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>+0.1 °C</td>
<td>700</td>
</tr>
<tr>
<td></td>
<td>+0.1 °C</td>
<td>+0.1 °C</td>
<td>:</td>
<td>:</td>
<td>+0.1 °C</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>0.0 °C</td>
<td>0.0 °C</td>
<td>0.0 °C</td>
<td>0.0 °C</td>
<td>0.0 °C</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>-0.1 °C</td>
<td>-0.1 °C</td>
<td>-0.1 °C</td>
<td>-0.1 °C</td>
<td>-0.1 °C</td>
<td>-1</td>
</tr>
<tr>
<td></td>
<td>-50.0 °C</td>
<td>-50.0 °C</td>
<td>-50.0 °C</td>
<td>-50.0 °C</td>
<td>-50.0 °C</td>
<td>-501</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>-200 °C</td>
<td>-500</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>-200 °C</td>
<td>-2000</td>
</tr>
<tr>
<td>Measured value too low</td>
<td>-50.1 °C</td>
<td>-50.1 °C</td>
<td>-50.1 °C</td>
<td>-50.1 °C</td>
<td>-50.1 °C</td>
<td>-501</td>
</tr>
<tr>
<td></td>
<td>-60.0 °C</td>
<td>-60.0 °C</td>
<td>-60.0 °C</td>
<td>-60.0 °C</td>
<td>-60.0 °C</td>
<td>-600</td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt; -60.0 °C</td>
<td>&lt; -60.0 °C</td>
<td>&lt; -200 °C</td>
<td>&lt; -60.0 °C</td>
<td>&lt; -200 °C</td>
<td>-32768</td>
</tr>
</tbody>
</table>

1) also possible with resolution 0.01 K
2) if Cu50 with 1.426, -50 °C is valid; if Cu50 with 1.428, -200.0 °C is valid

**Resistor input range**

The represented resolution corresponds to 16 bits.
### Thermocouple input ranges

The represented resolution corresponds to 16 bits.

<table>
<thead>
<tr>
<th>Range</th>
<th>Typ J -210 °C ... +1200 °C</th>
<th>Typ K -270 °C ... +1372 °C</th>
<th>Typ N -270 °C ... +1300 °C</th>
<th>Typ S -50 °C ... +1768 °C</th>
<th>Typ T -270 °C ... +400 °C</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Overflow</strong></td>
<td>&gt; +1200.0 °C</td>
<td>&gt; +1372.0 °C</td>
<td>&gt; +1300.0 °C</td>
<td>&gt; +1768.0 °C</td>
<td>&gt; +400.0 °C</td>
<td>32767 7FFF</td>
</tr>
<tr>
<td>Normal range</td>
<td>+1372.0 °C</td>
<td>:</td>
<td>+1768.0 °C</td>
<td>17680 4510</td>
<td>+10.1 °C</td>
<td>:</td>
</tr>
<tr>
<td></td>
<td>13720 3598</td>
<td>:</td>
<td>13000 32C8</td>
<td>12000 2EE0</td>
<td>+0.1 °C</td>
<td>:</td>
</tr>
<tr>
<td></td>
<td>+1200.0 °C</td>
<td>:</td>
<td>+400.0 °C</td>
<td>4000 0FA0</td>
<td>-0.1 °C</td>
<td>:</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>0 °C</td>
<td>0 0000</td>
<td>-40 °C</td>
<td>:</td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt; -210.0 °C</td>
<td>&lt; -270.0 °C</td>
<td>&lt; -50.0 °C</td>
<td>-32768 8000</td>
<td>-0.1 °C</td>
<td>:</td>
</tr>
</tbody>
</table>

### Temperature-internal reference point ranges

<table>
<thead>
<tr>
<th>Range</th>
<th>Value</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Decimal</strong></td>
<td><strong>Hex.</strong></td>
</tr>
<tr>
<td><strong>Overflow</strong></td>
<td>&gt; +85 °C</td>
<td>32767 7FFF</td>
</tr>
<tr>
<td>Normal range</td>
<td>+85 °C</td>
<td>850 0352</td>
</tr>
<tr>
<td></td>
<td>0 °C</td>
<td>0 0000</td>
</tr>
<tr>
<td></td>
<td>-40 °C</td>
<td>-400 FE70</td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt; -40 °C</td>
<td>-32768 8000</td>
</tr>
</tbody>
</table>
Technical data

Technical data of the module

The system data of AC500 and S500 are applicable to the standard version \(\text{Chapter 5.1.2 "System data AC500" on page 166.}\)

The system data of AC500-XC are applicable to the XC version \(\text{Chapter 5.1.3 "System data AC500-XC" on page 169.}\)

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process voltage</td>
<td></td>
</tr>
<tr>
<td>Connections</td>
<td>Terminals 1.8, 2.8, 3.8 and 4.8 for +24 V (UP) as well as 1.9, 2.9, 3.9 and 4.9 for 0 V (ZP)</td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5 %</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse on UP</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per module</td>
</tr>
<tr>
<td>Current consumption</td>
<td></td>
</tr>
<tr>
<td>From 24 V DC power supply at the terminals UP/L+ and ZP/M of the CPU/communication interface module</td>
<td>Ca. 2 mA</td>
</tr>
<tr>
<td>Current consumption from UP in normal operation</td>
<td>130 mA</td>
</tr>
<tr>
<td>Inrush current from UP (at power up)</td>
<td>0.056 A(^2) s</td>
</tr>
<tr>
<td>Max. length of analog cables, conductor cross section &gt; 0.14 mm(^2) *)</td>
<td>100 m</td>
</tr>
<tr>
<td>Weight</td>
<td>130 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical with derating (max. temperature 40 °C)</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>

*) Please note that an additional current of approx. 3µA flows out of the input for the wire break detection. Depending on the internal resistance of the signal source and the wire, this can lead to a higher measured value due to the voltage drop.

NOTICE!

All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.
Technical data of the analog inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>2 groups of 4 channels each</td>
</tr>
<tr>
<td>Connections of the channels I0 ... I3</td>
<td>Terminals 1.0 ... 1.7 and terminals 2.0 ... 2.7</td>
</tr>
<tr>
<td>Connections of the channels I4 ... I7</td>
<td>Terminals 3.0 ... 3.7 and terminals 4.0 ... 4.7</td>
</tr>
<tr>
<td>Input type</td>
<td>Bipolar (not with current or Pt100/ Pt1000/ Ni1000/ Cu50/ resistor)</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Against internal supply and other modules</td>
</tr>
<tr>
<td>Common mode input range</td>
<td>± 20 V DC plus signal voltage</td>
</tr>
<tr>
<td>Configurability</td>
<td>Digital input, -50 mV ... +50 mV, -500mV ... +500 mV, -1 V ... +1 V, -5 V ... +5 V, -10 V ... +10 V, 0 V ... +5 V, 0 V ... +10 V, -20 mA ... +20 mA, 0 mA ... 20 mA, 4 mA ... 20 mA, Pt100, Pt1000, Ni1000, Cu50, resistor, thermocouple types J, K, N, S, T (each input can be configured individually)</td>
</tr>
<tr>
<td>Channel input resistance</td>
<td>Voltage: &gt; 100 kΩ, current: ca. 330 Ω</td>
</tr>
<tr>
<td>Time constant of the input filter</td>
<td>Line-frequency suppression 50 Hz, 60 Hz, none</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel, the brightness depends on the value of the analog signal</td>
</tr>
<tr>
<td>Conversion time</td>
<td>1 ms (none), 100 ms (50 Hz / 60 Hz) per channel</td>
</tr>
<tr>
<td>Resolution</td>
<td>16 bits including sign</td>
</tr>
<tr>
<td>Conversion error of the analog values caused by non-linearity, adjustment error at factory and resolution within the normal range</td>
<td>Typ. ± 0.1 % (voltage) ± 0.3 % (current, resistor) at 25 °C</td>
</tr>
<tr>
<td></td>
<td>Max. ± 0.7 % (voltage) ± 0.9 % (current, resistor) ± 0.5 % (thermocouple type J, N, S, T; thermocouple type K &gt; -220 °C) 1.0 K (resistance temperature detectors) at 0 °C ... 60 °C or EMC disturbance</td>
</tr>
<tr>
<td>Maximum permanent allowed overload (no damage)</td>
<td></td>
</tr>
</tbody>
</table>
When the input current exceeds the overflow value of the measurement range, the input impedance is switched to high impedance for protection. The maximum allowed overload is then 30 V. The digital value corresponds to the overflow value. Periodically, the input impedance is switched to the normal value and the input current is measured. If the input current is within the measurement range, the input impedance remains at the normal level and the digital value corresponds to the measured current.

**Voltage input**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>30 V</td>
<td></td>
</tr>
</tbody>
</table>

**Relationship between input signal and hex code**

Table 168 “Channel monitoring” on page 752

**Unused voltage inputs**

Are configured as "unused"

**Unused current inputs**

Have a low resistance, can be left open-circuited

**Overvoltage protection**

Yes

---

### Technical data of the analog inputs if used as digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>Max. 8</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>2 groups of 4 channels each</td>
</tr>
<tr>
<td>Connections of the channels I0+ to I3+</td>
<td>Terminals 2.0, 2.2, 2.4, 2.6</td>
</tr>
<tr>
<td>Connections of the channels I4+ to I7+</td>
<td>Terminals 4.0, 4.2, 4.4, 4.6</td>
</tr>
<tr>
<td>Reference potential for the inputs</td>
<td>Terminals 1.9, 2.9, 3.9 and 4.9 (ZP)</td>
</tr>
<tr>
<td>Input delay</td>
<td>Typ. 2 ms</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 LED per channel</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-30 V ... +5 V</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>+5 V ... +13 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>+13 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 5 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>Typ. 1 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>Typ. 3.1 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 7 mA</td>
</tr>
<tr>
<td>Input resistance</td>
<td>Ca. 4.8 kΩ</td>
</tr>
</tbody>
</table>
Dimensions

1  Din rail 15 mm
2  Din rail 7.5 mm

The dimensions are in mm and in brackets in inch.

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 250 600 R0001</td>
<td>AI531, analog input module, 8 AI, U/I/Pt100, TC, 16 bits including sign, 4-wires</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 450 600 R0001</td>
<td>AI531-XC, analog input module, 8 AI, U/I/Pt100, TC, 16 bits including sign, 4-wires, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
AO523 - Analog output module

**Features**

- Module-wise galvanically isolated
- XC version for use in extreme ambient conditions available

---

1. I/O bus
2. Allocation between terminal number and signal name
3. 16 yellow LEDs to display the signal states at the analog outputs (O0 ... O15)
4. 1 green LED to display the state of the process supply voltage UP
5. 2 red LEDs to display errors
6. Label
7. Terminal unit
8. DIN rail
   - Sign for XC version

---

**Intended purpose**

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g. CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.
### Functionality

- 16 analog outputs in two groups:
  - 8 channels configurable for voltage or current output (O0...O3 / O8...O11)
  - 8 channels for voltage output (O4...O7 / O12...O15)

Resolution 12 bits including sign

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution of the analog channels</td>
<td></td>
</tr>
<tr>
<td>Voltage -10 V ... +10 V</td>
<td>12 bits including sign</td>
</tr>
<tr>
<td>Current 0 mA ... 20 mA, 4 mA ... 20 mA</td>
<td>12 bits</td>
</tr>
<tr>
<td>LED displays</td>
<td>19 LEDs for signals and error messages</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Through the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>External power supply</td>
<td>Via the terminals ZP and UP (process voltage 24 V DC)</td>
</tr>
<tr>
<td>Required terminal unit</td>
<td>TU515 or TU516 “Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938</td>
</tr>
</tbody>
</table>

### Connections

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The modules are plugged on an I/O terminal unit “Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938. Properly position the modules and press until they lock in place. The terminal units are mounted on a DIN rail or with 2 screws plus the additional accessory for wall mounting “Chapter 5.2.8.2.5 “TA526 - Wall mounting accessory” on page 1324.

The connection of the I/O channels is carried out using the 40 terminals of the I/O terminal unit. I/O modules can be replaced without re-wiring the terminal units.

The terminals 1.8 ... 4.8 and 1.9 ... 4.9 are electrically interconnected within the I/O terminal units and have always the same assignment, independent of the inserted module:

- Terminals 1.8 ... 4.8: process voltage UP = +24 V DC
- Terminals 1.9 ... 4.9: process voltage ZP = 0 V DC

The assignment of the other terminals:

<table>
<thead>
<tr>
<th>Terminals</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0 ... 1.7</td>
<td>O0- ... O7-</td>
<td>Negative poles of the first 8 analog outputs</td>
</tr>
<tr>
<td>2.0 ... 2.7</td>
<td>O0+ ... O7+</td>
<td>Positive poles of the first 8 analog outputs</td>
</tr>
</tbody>
</table>
The internal power supply voltage for the module's circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 2 mA per AO523.

The external power supply connection is carried out via the UP (+24 V DC) and the ZP (0 V DC) terminals.

### WARNING!

**Removal/Insertion under power**

Removal or insertion under power is permissible only if all conditions for hot swapping are fulfilled.

- Chapter 4.9.3 “Replace an I/O module with hot swap” on page 153

The devices are not designed for removal or insertion under power when the conditions for hot swap do not apply. Because of unforeseeable consequences, it is not allowed to plug in or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you

- connect or disconnect any signal or terminal block
- remove, mount or replace a module.

Disconnecting any powered devices while they are energized in a hazardous location could result in an electric arc, which could create an ignition source resulting in fire or explosion.

Prior to proceeding, make sure that power is been disconnected and that the area has been thoroughly checked to ensure that flammable materials are not present.

The devices must not be opened when in operation. The same applies to the network interfaces.

### NOTICE!

**Risk of damaging the PLC modules!**

Overvoltages and short circuits might damage the PLC modules.

- Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
- Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

Generally, analog signals must be laid in shielded cables. The cable shields must be grounded at both sides of the cables. In order to avoid unacceptable potential differences between different parts of the installation, low resistance equipotential bonding conductors must be laid.
Fig. 116: Connection of the module: 16 analog outputs in two groups  Chapter 5.2.4.4.2.4.3 “Functionality” on page 765

CAUTION!
By installing equipotential bonding conductors between the different parts of the system, it must be ensured that the potential difference between ZP and AGND never can exceed 1 V.

CAUTION!
The process supply voltage must be included in the grounding concept (e.g. grounding of the negative terminal).

The modules provide several diagnosis functions  Chapter 5.2.4.4.2.4.8 “Diagnosis” on page 774.
Connection of analog output loads (Voltage, current)

Fig. 117: Connection example

The following measuring ranges can be configured \(\text{Chapter 5.2.4.4.2.4.7 “Parameterization” on page 769:}\)
Voltage | -10 V ... +10 V | Load max. ± 10 mA | 1 channel used  
Current | 0 mA ... 20 mA | Load 0 Ω ... 500 Ω | 1 channel used  
Current | 4 mA ... 20 mA | Load 0 Ω ... 500 Ω | 1 channel used  

Only the channels 0 ... 3 and 8 ... 11 can be configured as current output (0 mA ... 20 mA or 4 mA ... 20 mA).

The function of the LEDs is described under Displays.
Unused analog outputs can be left open-circuited.

Internal data exchange

<table>
<thead>
<tr>
<th>Digital inputs (bytes)</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital outputs (bytes)</td>
<td>0</td>
</tr>
<tr>
<td>Analog inputs (words)</td>
<td>0</td>
</tr>
<tr>
<td>Analog outputs (words)</td>
<td>16</td>
</tr>
</tbody>
</table>

I/O configuration

The module does not store configuration data itself. It gets its parameterization data from the master device of the I/O bus (CPU or communication interface module) during power-up of the system.

That means replacing I/O modules is possible without any re-parameterization via software.

If the external power supply voltage via UP/ZP terminals fails, the I/O module loses its configuration data. The whole station has to be switched off and on again to re-configure the module.

Parameterization

<table>
<thead>
<tr>
<th>Firmware version</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firmware version &gt; V2.0.0</td>
<td>The arrangement of the parameter data is performed by Control Builder Plus/ Automation Builder software.</td>
</tr>
</tbody>
</table>

The parameter data directly influences the functionality of modules.

For non-standard applications, it is necessary to adapt the parameters to your system configuration.

Module: Module slot address: Y = 1 ... 10
<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot/Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Module ID</td>
<td>Internal 1510</td>
<td>Word 1510</td>
<td>0x05e6</td>
<td>0</td>
<td>0</td>
<td>65535</td>
<td>0x0Y01</td>
</tr>
<tr>
<td>2</td>
<td>Ignore module ²⁷</td>
<td>No Yes</td>
<td>Byte No</td>
<td>No 0x000</td>
<td>0</td>
<td>0</td>
<td>255</td>
<td>0x0Y02</td>
</tr>
<tr>
<td>3</td>
<td>Parameter length in bytes</td>
<td>Internal 39</td>
<td>Byte 39-CPU</td>
<td>0x0Y01</td>
<td>0</td>
<td>0</td>
<td>255</td>
<td>0x0Y02</td>
</tr>
<tr>
<td>4</td>
<td>Check supply</td>
<td>Off On</td>
<td>Byte On</td>
<td>0x001</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0x0Y03</td>
</tr>
<tr>
<td>5</td>
<td>Analog data format</td>
<td>Default 0</td>
<td>Byte Default</td>
<td>0x000</td>
<td>0</td>
<td>0</td>
<td>130</td>
<td>0x0Y04</td>
</tr>
<tr>
<td>6</td>
<td>Behaviour of outputs at comm.</td>
<td>Off Last value</td>
<td>Byte Off</td>
<td>0x000</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>0x0Y05</td>
</tr>
<tr>
<td>7</td>
<td>Channel configuration</td>
<td>See table 'Channel configuration' on page 773</td>
<td>Byte Default</td>
<td>0x000</td>
<td>0</td>
<td>0</td>
<td>130</td>
<td>0x0Y06</td>
</tr>
<tr>
<td>8</td>
<td>Channel monitoring</td>
<td>See table 'Channel monitoring' on page 773</td>
<td>Byte Default</td>
<td>0x000</td>
<td>0</td>
<td>0</td>
<td>3</td>
<td>0x0Y07</td>
</tr>
<tr>
<td>9</td>
<td>Substitute value</td>
<td>Output channel 0</td>
<td>Word Default</td>
<td>0x0000</td>
<td>0</td>
<td>0</td>
<td>65535</td>
<td>0x0Y08</td>
</tr>
<tr>
<td>No.</td>
<td>Name</td>
<td>Value</td>
<td>Internal value</td>
<td>Internal value, type</td>
<td>Default</td>
<td>Min.</td>
<td>Max.</td>
<td>EDS Slot/Index</td>
</tr>
<tr>
<td>-----</td>
<td>------</td>
<td>-------</td>
<td>----------------</td>
<td>---------------------</td>
<td>---------</td>
<td>------</td>
<td>------</td>
<td>----------------</td>
</tr>
<tr>
<td>10 ... 15</td>
<td>Channel configuration and channel monitoring of the output channels 1 to 3</td>
<td>See table 'Channel configuration' OR Table 171 “Channel configuration 3)” on page 773 and Table 172 “Channel monitoring 4)” on page 773</td>
<td>Byte</td>
<td>Default</td>
<td>0x00</td>
<td>0x00</td>
<td>130</td>
<td>0x0Y09 to 0x0Y0E</td>
</tr>
<tr>
<td>16 ... 23</td>
<td>Channel configuration and channel monitoring of the output channels 4 to 7</td>
<td>See table 'Channel configuration' OR Table 171 “Channel configuration 3)” on page 773 and Table 172 “Channel monitoring 4)” on page 773</td>
<td>Byte</td>
<td>Default</td>
<td>0x00</td>
<td>0x00</td>
<td>128</td>
<td>0x0Y0F to 0x0Y16</td>
</tr>
<tr>
<td>24</td>
<td>Channel configuration Output channel 8</td>
<td>See table 'Channel configuration' OR Table 171 “Channel configuration 3)” on page 773</td>
<td>Byte</td>
<td>Default</td>
<td>0x00</td>
<td>0</td>
<td>130</td>
<td>0x0Y17</td>
</tr>
<tr>
<td>25</td>
<td>Channel monitoring Output channel 8</td>
<td>See table 'Channel monitoring' OR Table 172 “Channel monitoring 4)” on page 773</td>
<td>Byte</td>
<td>Default</td>
<td>0x00</td>
<td>0</td>
<td>3</td>
<td>0x0Y18</td>
</tr>
<tr>
<td>26</td>
<td>Substitute value Output channel 8</td>
<td>Output channel 8!</td>
<td>Word</td>
<td>Default</td>
<td>0x0000</td>
<td>0</td>
<td>65535</td>
<td>0x0Y19</td>
</tr>
<tr>
<td>No.</td>
<td>Name</td>
<td>Value</td>
<td>Internal value</td>
<td>Internal value, type</td>
<td>Default</td>
<td>Min.</td>
<td>Max.</td>
<td>EDS Slot/Index</td>
</tr>
<tr>
<td>-----</td>
<td>------------------------------------------------</td>
<td>-------</td>
<td>----------------</td>
<td>---------------------</td>
<td>---------</td>
<td>------</td>
<td>------</td>
<td>----------------</td>
</tr>
<tr>
<td>27</td>
<td>Channel configuration and channel monitoring of the output channels 9 to 11</td>
<td>See table 'Channel configuration' (% Table 171 “Channel configuration 3)” on page 773 and table ‘Channel monitoring’ (% Table 172 “Channel monitoring 4)” on page 773</td>
<td>Byte</td>
<td>Default</td>
<td>0x00 0x00</td>
<td>0</td>
<td>0</td>
<td>130 0x0Y1A to 0x0Y1F</td>
</tr>
<tr>
<td>33</td>
<td>Channel configuration and channel monitoring of the output channels 12 to 15</td>
<td>See table 'Channel configuration' (% Table 171 “Channel configuration 3)” on page 773 and table ‘Channel monitoring’ (% Table 172 “Channel monitoring 4)” on page 773</td>
<td>Byte</td>
<td>Default</td>
<td>0x00 0x00</td>
<td>0</td>
<td>0</td>
<td>128 0x0Y20 to 0x0Y27</td>
</tr>
</tbody>
</table>

1) With CS31 and addresses less than 70 and FBP, the value is increased by 1
2) Not with FBP

GSD file:

```
Ext_User_Prm_Data_Len =
Ext_User_Prm_Data_Const(0) =
```

```plaintext
42
0x05, 0xe7, 0x27, \n0x01, 0x00, 0x00, \n0x00, 0x00, 0x00, 0x00, \n0x00, 0x00, 0x00, 0x00, 0x00, \n0x00, 0x00, 0x00, 0x00, 0x00, 0x00, \n0x00, 0x00, 0x00, 0x00, \n0x00, 0x00, 0x00, 0x00, 0x00, \n0x00, 0x00, 0x00, 0x00, 0x00, 0x00, \n0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00;
```
<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Channel configuration</td>
<td>see below table 'Channel configuration' on page 773</td>
<td>see below table 'Channel configuration' on page 773</td>
<td>Byte</td>
<td>see below table 'Channel configuration' on page 773</td>
</tr>
<tr>
<td>2</td>
<td>Channel monitoring</td>
<td>see below table 'Channel monitoring' on page 773</td>
<td>see below table 'Channel monitoring' on page 773</td>
<td>Byte</td>
<td>see below table 'Channel monitoring' on page 773</td>
</tr>
<tr>
<td>3</td>
<td>Substitute value</td>
<td>0 ... 65535</td>
<td>0 ... 0xffff</td>
<td>Word</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Internal value, type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Channel configuration</td>
<td>Byte</td>
</tr>
<tr>
<td>2</td>
<td>Channel monitoring</td>
<td>Byte</td>
</tr>
</tbody>
</table>

**Table 171: Channel configuration**

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes of the analog outputs, individually configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Unused (default)</td>
</tr>
<tr>
<td>128</td>
<td>Analog output -10 V ... +10 V</td>
</tr>
<tr>
<td>129</td>
<td>Analog output 0 mA ... 20 mA (not with the channels 4 ... 7 and 12 ... 15)</td>
</tr>
<tr>
<td>130</td>
<td>Analog output 4 mA ... 20 mA (not with the channels 4 ... 7 and 12 ... 15)</td>
</tr>
</tbody>
</table>

**Table 172: Channel monitoring**

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Monitoring</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Plausibility, open-circuit (broken wire) and short circuit (default)</td>
</tr>
<tr>
<td>1</td>
<td>Open-circuit (broken wire) and short circuit</td>
</tr>
<tr>
<td>2</td>
<td>Plausibility</td>
</tr>
<tr>
<td>3</td>
<td>No monitoring</td>
</tr>
</tbody>
</table>
### Table 173: Substitute value

<table>
<thead>
<tr>
<th>Intended behavior of channel 0 when the control system stops</th>
<th>Required setting of the module parameter &quot;Behaviour of outputs in case of a communication error&quot;</th>
<th>Required setting of the channel parameter &quot;Substitute value&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output OFF</td>
<td>OFF</td>
<td>0</td>
</tr>
<tr>
<td>Last value</td>
<td>Last value</td>
<td>0</td>
</tr>
<tr>
<td>Substitute value</td>
<td>OFF or Last value</td>
<td>1 ... 65535</td>
</tr>
</tbody>
</table>

### Diagnosis

#### Table 174: Possible diagnosis of I/O channels

<table>
<thead>
<tr>
<th>Output range</th>
<th>Condition</th>
<th>Output value in the PLC underflow</th>
<th>Output value in the PLC overflow</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 mA ... 20 mA</td>
<td></td>
<td>Error identifier = 7</td>
<td>Error identifier = 4</td>
</tr>
<tr>
<td>4 mA ... 20 mA</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-10 V ... +10 V</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Hardware descriptions

Device specifications > I/O modules

---

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier 000 ... 063</th>
<th>AC500 display</th>
<th>&lt;= Display in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Comp</td>
<td>Dev</td>
<td>Mod</td>
<td>Ch</td>
<td>Err</td>
<td>PS501 PLC browser</td>
<td></td>
</tr>
<tr>
<td>Byte 6</td>
<td>Bit 6 ... 7</td>
<td>-</td>
<td>Byte 3</td>
<td>Byte 4</td>
<td>Byte 5</td>
<td>Byte 6 Bit 0 ... 5</td>
<td>FBP diagnosis block</td>
</tr>
</tbody>
</table>

#### Table for Module error

<table>
<thead>
<tr>
<th>3</th>
<th>14</th>
<th>1 ... 10</th>
<th>31</th>
<th>31</th>
<th>19</th>
<th>Checksum error in the I/O module</th>
<th>Replace I/O module</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>3</th>
<th>14</th>
<th>1 ... 10</th>
<th>31</th>
<th>31</th>
<th>3</th>
<th>Timeout in the I/O module</th>
<th>Replace I/O module</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>3</th>
<th>14</th>
<th>1 ... 10</th>
<th>31</th>
<th>31</th>
<th>40</th>
<th>Different hard-/firmware versions in the module</th>
<th>Replace I/O module</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>3</th>
<th>14</th>
<th>1 ... 10</th>
<th>31</th>
<th>31</th>
<th>43</th>
<th>Internal error in the module</th>
<th>Replace I/O module</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>3</th>
<th>14</th>
<th>1 ... 10</th>
<th>31</th>
<th>31</th>
<th>36</th>
<th>Internal data exchange failure</th>
<th>Replace I/O module</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>3</th>
<th>14</th>
<th>1 ... 10</th>
<th>31</th>
<th>31</th>
<th>9</th>
<th>Overflow diagnosis buffer</th>
<th>New start</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>3</th>
<th>14</th>
<th>1 ... 10</th>
<th>31</th>
<th>31</th>
<th>26</th>
<th>Parameter error</th>
<th>Check master</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### E1 ... E4

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>11</td>
<td>Process voltage too low</td>
<td>Check process voltage</td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>45</td>
<td>Process voltage is switched off (ON -&gt; OFF)</td>
<td>Process voltage ON</td>
</tr>
</tbody>
</table>

#### Channel error

<table>
<thead>
<tr>
<th>Error</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>48</td>
<td>Analog value overflow at an analog output</td>
<td>Check output value</td>
</tr>
<tr>
<td>7</td>
<td>Analog value underflow at an analog output</td>
<td>Check output value</td>
</tr>
</tbody>
</table>

**Remarks:**

1) In AC500, the following interface identifier applies:
   - 14 = I/O bus, 11 = COM1 (e.g. CS31 bus), 12 = COM2.
   - The FBP diagnosis block does not contain this identifier.

2) With "Device" the following allocation applies:
   - 31 = module itself, 1 ... 10 = expansion module 1 ... 10, ADR = hardware address (e.g. of the DC551)

3) With "Module" the following allocation applies dependent of the master:
   - Module error: I/O bus or FBP: 31 = module itself; COM1/COM2: 1 ... 10 = expansion 1 ... 10
   - Channel error: I/O bus or FBP = module type (3 = AO); COM1/COM2: 1 ... 10 = expansion 1 ... 10

4) In case of module errors, with channel "31 = Module itself" is output.

**State LEDs**

During the power ON procedure, the module initializes automatically. All LEDs (except the channel LEDs) are ON during this time.
### Outputs

<table>
<thead>
<tr>
<th>Outputs</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
<th>LED flashes</th>
</tr>
</thead>
<tbody>
<tr>
<td>O0 ... O7 and O8 ... O15</td>
<td>Analog output</td>
<td>Yellow</td>
<td>Output is OFF</td>
<td>Output is ON (brightness depends on the value of the analog signal)</td>
<td>--</td>
</tr>
</tbody>
</table>

| UP | Process voltage 24 V DC via terminal | Green | Process voltage is missing | Process voltage OK | -- |

| CH-ERR2 | Channel error, error messages in groups (analog inputs or outputs combined into the groups 2 and 4) | Red | No error or process voltage is missing | Severe error within the corresponding group | Error on one channel of the group |

| CH-ERR *) | Module error | Red | -- | Internal error | -- |

*) Both LEDs (CH-ERR2 and CH-ERR4) light up together

### Output ranges

**Output ranges voltage and current**

The represented resolution corresponds to 16 bits.

<table>
<thead>
<tr>
<th>Range</th>
<th>-10 V ... +10 V</th>
<th>0 mA ... 20 mA</th>
<th>4 mA ... 20 mA</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Dec.</td>
<td>Hex.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Normal range</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10.0000 V</td>
<td>20.0000 mA</td>
<td>20.0000 mA</td>
<td>27648</td>
<td>6C00</td>
</tr>
<tr>
<td>0.0004 V</td>
<td>0.0007 mA</td>
<td>4.0006 mA</td>
<td>1</td>
<td>0001</td>
</tr>
<tr>
<td>0.0000 V</td>
<td>0.0000 mA</td>
<td>4.0000 mA</td>
<td>0</td>
<td>0000</td>
</tr>
<tr>
<td>-0.0004 V</td>
<td>0 mA</td>
<td>3.9994 mA</td>
<td>-1</td>
<td>FFFF</td>
</tr>
<tr>
<td>-10.0000 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>-27648</td>
<td>9400</td>
</tr>
<tr>
<td>Range</td>
<td>-10 V ... +10 V</td>
<td>0 mA ... 20 mA</td>
<td>4 mA ... 20 mA</td>
<td>Digital value</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------</td>
<td>---------------</td>
<td>---------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Value too low</td>
<td>-10.0004 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>-27649 Decimal</td>
</tr>
<tr>
<td></td>
<td>-11.7589 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>93FF Hex.</td>
</tr>
<tr>
<td>Underflow</td>
<td>0 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>&lt; -32512</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>&lt; 8100</td>
</tr>
</tbody>
</table>

### Technical data

#### Technical data of the module

The system data of AC500 and S500 are applicable to the standard version “System data AC500” on page 166.

The system data of AC500-XC are applicable to the XC version “System data AC500-XC” on page 169.

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process voltage</td>
<td></td>
</tr>
<tr>
<td>Connections</td>
<td>Terminals 1.8, 2.8, 3.8 and 4.8 for +24 V (UP) as well as 1.9, 2.9, 3.9 and 4.9 for 0 V (ZP)</td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5 %</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse on UP</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per module</td>
</tr>
<tr>
<td>Current consumption</td>
<td></td>
</tr>
<tr>
<td>From 24 V DC power supply at the terminals UP/L+ and ZP/M of the CPU/communication interface module</td>
<td>Ca. 2 mA</td>
</tr>
<tr>
<td>Current consumption from UP at normal operation</td>
<td>0.15 A + output loads</td>
</tr>
<tr>
<td>Inrush current from UP (at power up)</td>
<td>0.040 A²s</td>
</tr>
<tr>
<td>Max. length of analog cables, conductor cross section &gt; 0.14 mm²</td>
<td>100 m</td>
</tr>
<tr>
<td>Weight</td>
<td>300 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical with derating (output load reduced to 50 % at +40 °C per group)</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>
NOTICE!
All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

Technical data of the analog outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>16, of which channels O0 ... O3 and O8 ... O11 for voltage and current, and channels O4 ... 7 and O12 ... 15 only for voltage</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group</td>
</tr>
<tr>
<td>Channels O0- ... O7-</td>
<td>Terminals 1.0 ... 1.7</td>
</tr>
<tr>
<td>Channels O0+ ... O7+</td>
<td>Terminals 2.0 ... 2.7</td>
</tr>
<tr>
<td>Channels O8- ... O15-</td>
<td>Terminals 3.0 ... 3.7</td>
</tr>
<tr>
<td>Channels O8+ ... O15+</td>
<td>Terminals 4.0 ... 4.7</td>
</tr>
<tr>
<td>Output type</td>
<td>Bipolar with voltage, unipolar with current</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Against internal supply and other modules</td>
</tr>
<tr>
<td>Configurability</td>
<td>-10 V ... +10 V, 0 mA ... 20 mA, 4 mA ... 20 mA (each output can be configured individually), current outputs only channels 0 ... 3 and 8 ... 11</td>
</tr>
<tr>
<td>Output resistance (load), as current output</td>
<td>0 Ω ... 500 Ω</td>
</tr>
<tr>
<td>Output loadability, as voltage output</td>
<td>Max. ± 10 mA</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>One LED per channel</td>
</tr>
<tr>
<td>Resolution</td>
<td>12 bits including sign</td>
</tr>
<tr>
<td>Settling time for full range change (resistive load, output signal within specified tolerance)</td>
<td>Typ. 5 ms</td>
</tr>
<tr>
<td>Conversion error of the analog values caused by non-linearity, adjustment error at factory and resolution within the normal range</td>
<td>Typ. ± 0.5 % of full scale at +25 °C</td>
</tr>
<tr>
<td>Max. ± 1 % of full scale (all ranges)</td>
<td>at 0 °C ... +60 °C or EMC disturbance</td>
</tr>
<tr>
<td>Relationship between output signal and hex code</td>
<td><a href="#">Section</a> Chapter 5.2.4.4.2.4.10 &quot;Output ranges&quot; on page 776</td>
</tr>
<tr>
<td>Unused outputs</td>
<td>Can be left open-circuited</td>
</tr>
</tbody>
</table>
Dimensions

1 Din rail 15 mm
2 Din rail 7.5 mm

The dimensions are in mm and in brackets in inch.

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 250 200 R0001</td>
<td>AO523, analog output module, 16 AO, U/I, 12 bits including sign, 2-wires</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 450 200 R0001</td>
<td>AO523-XC, analog output module, 16 AO, U/I, 12 bits including sign, 2-wires, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
AX521 - Analog input/output module

Features

- 4 configurable analog inputs (I0 ... I3) in 1 group (1.0 ... 2.3)
  Resolution 12 bits including sign
- 4 configurable analog outputs (O0 ... O3) in 1 group (3.0 ... 4.3)
  Resolution 12 bits including sign
- Module-wise galvanically isolated
- XC version for use in extreme ambient conditions available

1 I/O bus
2 Allocation between terminal number and signal name
3 4 yellow LEDs to display the signal states at the analog inputs (I0 ... I3)
4 4 yellow LEDs to display the signal states at the analog outputs (O0 ... O3)
5 1 green LED to display the state of the process supply voltage UP
6 2 red LEDs to display errors
7 Label
8 Terminal unit
9 DIN rail
10 Sign for XC version
**Intended purpose**

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g., CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.

**Functionality**

**AX521**

4 analog inputs (channel 0…channel 3), individually configurable for:

- Unused (default setting)
- 0 V ... 10 V
- -10 V ... +10 V
- 0 mA ... 20 mA
- 4 mA ... 20 mA
- Pt100, -50 °C ... +400 °C (2-wire)
- Pt100, -50 °C ... +400 °C (3-wire), requires 2 channels
- Pt100, -50 °C ... +70 °C (2-wire)
- Pt100, -50 °C ... +70 °C (3-wire), requires 2 channels
- Pt1000, -50 °C ... +400 °C (2-wire)
- Pt1000, -50 °C ... +400 °C (3-wire), requires 2 channels
- Pt1000, -50 °C ... +150 °C (2-wire)
- Pt1000, -50 °C ... +150 °C (3-wire), requires 2 channels
- 0 V ... 10 V with differential inputs, requires 2 channels
- -10 V ... +10 V with differential inputs, requires 2 channels
- Digital signals (digital input)

4 analog outputs (channel 0 … channel 3), individually configurable for:

- Unused (default setting)
- -10 V ... +10 V
- 0 mA ... 20 mA
- 4 mA ... 20 mA

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution of the analog channels</td>
<td></td>
</tr>
<tr>
<td>Voltage -10 V ... +10 V</td>
<td>12 bits including sign</td>
</tr>
<tr>
<td>Voltage 0 V ... 10 V</td>
<td>12 bits</td>
</tr>
<tr>
<td>Current 0 mA ... 20 mA, 4 mA ... 20 mA</td>
<td>12 bits</td>
</tr>
<tr>
<td>Temperature</td>
<td>+0.1 °C</td>
</tr>
<tr>
<td>LED displays</td>
<td>11 LEDs for signals and error messages</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>External power supply</td>
<td>Via the terminals ZP and UP (process voltage 24 V DC)</td>
</tr>
<tr>
<td>Required terminal unit</td>
<td>TU515 or TU516 \ Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938</td>
</tr>
</tbody>
</table>
Connections

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The modules are plugged on an I/O terminal unit. Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938. Properly position the modules and press until they lock in place. The terminal units are mounted on a DIN rail or with 2 screws plus the additional accessory for wall mounting. Chapter 5.2.8.2.5 “TA526 - Wall mounting accessory” on page 1324.

The connection of the I/O channels is carried out using the 40 terminals of the I/O terminal unit. I/O modules can be replaced without re-wiring the terminal units.

The terminals 1.8, 2.8, 3.8 and 4.8 as well as 1.9, 2.9, 3.9 and 4.9 are electrically interconnected within the I/O terminal units and have always the same assignment, irrespective of the inserted module:

Terminals 1.8, 2.8, 3.8 and 4.8: process voltage UP = +24 V DC
Terminals 1.9, 2.9, 3.9 and 4.9: process voltage ZP = 0 V DC

Table 175: Assignment of the other terminals

<table>
<thead>
<tr>
<th>Terminals</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0 ... 1.3</td>
<td>I0- ... I3-</td>
<td>Negative poles of the 4 analog inputs</td>
</tr>
<tr>
<td>2.0 ... 2.3</td>
<td>I0+ ... I3+</td>
<td>Positive poles of the 4 analog inputs</td>
</tr>
<tr>
<td>3.0 ... 3.3</td>
<td>O0- ... O3-</td>
<td>Negative poles of the 4 analog outputs</td>
</tr>
<tr>
<td>4.0 ... 4.3</td>
<td>O0+ ... O3+</td>
<td>Positive poles of the 4 analog outputs</td>
</tr>
</tbody>
</table>

The negative poles of the analog inputs are connected to each other to form an "Analog Ground" signal for the module.

The negative poles of the analog outputs are connected to each other to form an "Analog Ground" signal for the module.

There is no galvanic isolation between the analog circuitry and ZP/UP. Therefore, the analog sensors must be galvanically isolated in order to avoid loops via the ground potential or the supply voltage.

Hardware descriptions
Device specifications > I/O modules
Because of their common reference potential, analog current inputs cannot be circuited in series, neither within the module nor with channels of other modules.

For the open-circuit detection (wire break), each analog input channel is pulled up to "plus" by a high-resistance resistor. If nothing is connected, the maximum voltage will be read in then.

The internal power supply voltage for the module’s circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 2 mA per I/O module.

The external power supply connection is carried out via the UP (+24 V DC) and the ZP (0 V DC) terminals.

**WARNING!**

**Removal/Insertion under power**

Removal or insertion under power is permissible only if all conditions for hot swapping are fullfilled.

* Chapter 4.9.3 “Replace an I/O module with hot swap” on page 153

The devices are not designed for removal or insertion under power when the conditions for hot swap do not apply. Because of unforeseeable consequences, it is not allowed to plug in or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you

- connect or disconnect any signal or terminal block
- remove, mount or replace a module.

Disconnecting any powered devices while they are energized in a hazardous location could result in an electric arc, which could create an ignition source resulting in fire or explosion.

Prior to proceeding, make sure that power is been disconnected and that the area has been thoroughly checked to ensure that flammable materials are not present.

The devices must not be opened when in operation. The same applies to the network interfaces.

**NOTICE!**

**Risk of damaging the PLC modules!**

Overvoltages and short circuits might damage the PLC modules.

- Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
- Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.
Generally, analog signals must be laid in shielded cables. The cable shields must be grounded at both sides of the cables. In order to avoid unacceptable potential differences between different parts of the installation, low resistance equipotential bonding conductors must be laid.

![Connection of the I/O module: 4 analog inputs and 4 analog outputs, individually configurable](image)

**CAUTION!**
By installing equipotential bonding conductors between the different parts of the system, it must be ensured that the potential difference between ZP and AGND never can exceed 1 V.

**CAUTION!**
The process supply voltage must be included in the grounding concept (e.g. grounding of the negative terminal).

**Connection of resistance thermometers in 2-wire configuration**
When resistance thermometers (Pt100, Pt1000, Ni1000) are used, a constant current must flow through them to build the necessary voltage drop for the evaluation. For this, the I/O module provides a constant current source which is multiplexed over the 8 analog channels.
Fig. 119: Connection example

<table>
<thead>
<tr>
<th>Resistance Thermometer</th>
<th>Temperature Range</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pt100</td>
<td>-50 °C ... +70 °C</td>
<td>2-wire config, one channel used</td>
</tr>
<tr>
<td>Pt100</td>
<td>-50 °C ... +400 °C</td>
<td>2-wire config, one channel used</td>
</tr>
<tr>
<td>Pt1000</td>
<td>-50 °C ... +400 °C</td>
<td>2-wire config, one channel used</td>
</tr>
<tr>
<td>Ni1000</td>
<td>-50 °C ... +150 °C</td>
<td>2-wire config, one channel used</td>
</tr>
</tbody>
</table>

The I/O module performs a linearization of the resistance characteristic.

In order to avoid error messages from unused analog input channels, it is useful to configure them as "unused".

**Connection of resistance thermometers in 3-wire configuration**

When resistance thermometers (Pt100, Pt1000, Ni1000) are used, a constant current must flow through them to build the necessary voltage drop for the evaluation. For this, the I/O module provides a constant current source which is multiplexed over the max. 8 (depending on the configuration) analog channels.

Fig. 120: Connection example
If several measuring points are adjacent to each other, only one return line is necessary. This saves wiring costs.

With the 3-wire configuration, two adjacent analog channels belong together (e.g. the channels 0 and 1). In this case, both channels are configured according to the desired operating mode. The lower address must be the even address (channel 0), the next higher address must be the odd address (channel 1).

The constant current of one channel flows through the resistance thermometer. The constant current of the other channel flows through one of the cores. The module calculates the measured value from the two voltage drops and stores it under the input with the higher channel number (e.g. I1).

In order to keep measuring errors as small as possible, it is necessary to have all the involved conductors in the same cable. All the conductors must have the same cross section.

<table>
<thead>
<tr>
<th>Material</th>
<th>Temperature Range</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pt100</td>
<td>-50 °C ... +70 °C</td>
<td>3-wire configuration, two channels used</td>
</tr>
<tr>
<td>Pt100</td>
<td>-50 °C ... +400 °C</td>
<td>3-wire configuration, two channels used</td>
</tr>
<tr>
<td>Pt1000</td>
<td>-50 °C ... +400 °C</td>
<td>3-wire configuration, two channels used</td>
</tr>
<tr>
<td>Ni1000</td>
<td>-50 °C ... +150 °C</td>
<td>3-wire configuration, two channels used</td>
</tr>
</tbody>
</table>

The I/O module performs a linearization of the resistance characteristic.

In order to avoid error messages from unused analog input channels, it is useful to configure them as "unused".
Connection of active-type analog sensors (Voltage) with galvanically isolated power supply

Fig. 121: Connection example
By connecting the sensor's negative pole of the output voltage to AGND, the galvanically isolated voltage source of the sensor is referred to ZP.

The following measuring ranges can be configured for AX521, Chapter 5.2.4.4.2.5.7 “Parameterization” on page 796 and for AX522, Chapter 5.2.4.4.2.6.7 “Parameterization” on page 826:

<table>
<thead>
<tr>
<th>Voltage</th>
<th>0 V ... 10 V</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

In order to avoid error messages or long processing times, it is useful to configure unused analog input channels as "unused".

Connection of active-type analog sensors (Current) with galvanically isolated power supply

Fig. 122: Connection example

<table>
<thead>
<tr>
<th>Current</th>
<th>0 mA ... 20 mA</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>4 mA ... 20 mA</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

Unused input channels can be left open-circuited, because they are of low resistance.
Connection of active-type analog sensors (Voltage) with no galvanically isolated power supply

Fig. 123: Connection example
CAUTION!
The potential difference between AGND and ZP at the module must not be
greater than 1V, not even in case of long lines (see figure Terminal Assignment).

If AGND does not get connected to ZP, the sensor current flows to ZP via the
AGND line. The measuring signal is distorted, as a very small current flows
through the voltage line. The total current through the PTC should not exceed
50 mA. This measuring method is therefore only suitable for short lines and
small sensor currents. If there are bigger distances, the difference measuring
method should be applied.

<table>
<thead>
<tr>
<th>Voltage</th>
<th>0 V ... 10 V</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V *)</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

*) if the sensor can provide this signal range

In order to avoid error messages or long processing times, it is useful to configure unused
analog input channels as "unused".
Connection of passive-type analog sensors (Current)

Fig. 124: Connection example
| Current | 4 mA ... 20 mA | 1 channel used |

**CAUTION!**
If, during initialization, an analog current sensor supplies more than 25 mA for more than 1 second to an analog input, this input is switched off by the module (input protection). In such cases, it is recommended to protect the analog input by a 10-volt Zener diode (in parallel to I+ and ZP). But, in general, sensors with fast initialization or without current peaks higher than 25 mA are preferrable.

Unused input channels can be left open-circuited because they are of low resistance.

**Connection of active-type analog sensors (Voltage) to differential inputs**

Differential inputs are very useful if analog sensors are used which are remotely non-isolated (e.g. the minus terminal is remotely grounded).

The use of differential inputs helps to considerably increase the measuring accuracy and to avoid ground loops.

With differential input configurations, two adjacent analog channels belong together (e.g. the channels 0 and 1). In this case, both channels are configured according to the desired operating mode. The lower address must be the even address (channel 0), the next higher address must be the odd address (channel 1). The converted analog value is available at the higher address (channel 1).

The analog value is calculated by subtraction of the input value with the higher address from the input value of the lower address.

The converted analog value is available at the odd channel (higher address).

**CAUTION!**
The ground potential at the sensors must not have too large a potential difference with respect to ZP (max. ±1 V within the full signal range). Otherwise, problems may occur concerning the common-mode input voltages of the involved analog inputs.
Fig. 125: Connection example
The negative pole of the sensor must be grounded next to the sensor.

<table>
<thead>
<tr>
<th>Voltage</th>
<th>0 V ... 10 V</th>
<th>with differential inputs, 2 channels used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V</td>
<td>with differential inputs, 2 channels used</td>
</tr>
</tbody>
</table>

In order to avoid error messages or long processing times, it is useful to configure unused analog input channels as "unused".

Use of analog inputs as digital inputs

Several (or all) analog inputs can be configured as digital inputs. The inputs are not galvanically isolated against the other analog channels.

Digital input | 24 V | 1 channel used |
---------------|------|----------------|
Effect of incorrect input terminal connection | Wrong or no signal detected, no damage up to 35 V |
Connection of analog output loads (Voltage, current)

Fig. 127: Connection example
Voltage | -10 V ... +10 V | Load max. ± 10 mA | 1 channel used
---|---|---|---
Current | 0 mA ... 20 mA | Load 0 Ω ... 500 Ω | 1 channel used
Current | 4 mA ... 20 mA | Load 0 Ω ... 500 Ω | 1 channel used

Only the channels 0 ... 3 can be configured as current output (0 mA ... 20 mA or 4 mA ... 20 mA).
Unused analog outputs can be left open-circuited.

Internal data exchange

| Digital inputs (bytes) | 0 |
| Digital outputs (bytes) | 0 |
| Counter input data (words) | 4 |
| Counter output data (words) | 4 |

I/O configuration

The module does not store configuration data itself. It gets its parameterization data from the master device of the I/O bus (CPU or communication interface module) during power-up of the system.
Hence, replacing I/O modules is possible without any re-parameterization via software.

Parameterization

<table>
<thead>
<tr>
<th>Firmware version</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firmware version &gt; V2.0.0</td>
<td>The arrangement of the parameter data is performed by Control Builder Plus/ Automation Builder software.</td>
</tr>
</tbody>
</table>

The parameter data directly influences the functionality of modules.
For non-standard applications, it is necessary to adapt the parameters to your system configuration.
Module: Module slot address: Y = 1 ... 10

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot/Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Module ID</td>
<td>Internal</td>
<td>1505</td>
<td>Word</td>
<td>1505 0x05E1</td>
<td>0</td>
<td>65535</td>
<td>0x0Y01</td>
</tr>
<tr>
<td>2</td>
<td>Ignore module</td>
<td>No Yes</td>
<td>0 1</td>
<td>Byte</td>
<td>No 0x00</td>
<td>0</td>
<td>255</td>
<td>Not for FBP</td>
</tr>
<tr>
<td>3</td>
<td>Parameter length in bytes</td>
<td>Internal</td>
<td>21</td>
<td>Byte</td>
<td>21-CPU 21-FBP</td>
<td>0</td>
<td>255</td>
<td>0x0Y02</td>
</tr>
<tr>
<td>No.</td>
<td>Name</td>
<td>Value</td>
<td>Internal value</td>
<td>Internal value, type</td>
<td>Default Min.</td>
<td>Max.</td>
<td>EDS Slot/Index</td>
<td></td>
</tr>
<tr>
<td>-----</td>
<td>-------------------------------------------</td>
<td>---------</td>
<td>----------------</td>
<td>----------------------</td>
<td>--------------</td>
<td>------</td>
<td>-----------------</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Check supply</td>
<td>Off</td>
<td>0</td>
<td>Byte</td>
<td>On 0x01</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>On</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td>0x0Y03</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Analog data format</td>
<td>Default</td>
<td>0</td>
<td>Byte</td>
<td>Default 0x00</td>
<td></td>
<td>0x0Y04</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Behaviour of outputs at communication errors</td>
<td>Off</td>
<td>0</td>
<td>Byte</td>
<td>Off 0x00</td>
<td>0</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Last value</td>
<td>1+(n*5)</td>
<td></td>
<td></td>
<td></td>
<td>0x0Y05</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Substitute value</td>
<td>2+(n*5), n ≤ 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Channel configuration</td>
<td>See table 'Channel configuration' § Table 177 “Channel configuration ²)” on page 799</td>
<td>Byte</td>
<td>Default 0x00</td>
<td>0</td>
<td>19</td>
<td>0x0Y06</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Input channel 0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Channel monitoring</td>
<td>See table 'Channel monitoring' § Table 178 “Channel monitoring ³)” on page 799</td>
<td>Byte</td>
<td>Default 0x00</td>
<td>0</td>
<td>3</td>
<td>0x0Y07</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Input channel 0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Channel configuration and channel monitoring of the input channels 1 to 3</td>
<td>See tables 'Channel configuration' § Table 177 “Channel configuration ²)” on page 799 and 'Channel monitoring' § Table 178 “Channel monitoring ³)” on page 799</td>
<td>Byte</td>
<td>Default 0x00</td>
<td>0</td>
<td>19</td>
<td>0x0Y08 to 0x0Y0D</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Channel configuration</td>
<td>See table 'Channel configuration' § Table 177 “Channel configuration ²)” on page 799</td>
<td>Byte</td>
<td>Default 0x00</td>
<td>0</td>
<td>130</td>
<td>0x0Y0E</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Output channel 0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Channel monitoring</td>
<td>See table 'Channel monitoring' § Table 178 “Channel monitoring ³)” on page 799</td>
<td>Byte</td>
<td>Default 0x00</td>
<td>0</td>
<td>3</td>
<td>0x0Y0F</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Output channel 0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>No.</td>
<td>Name</td>
<td>Value</td>
<td>Internal value, type</td>
<td>Default</td>
<td>Min.</td>
<td>Max.</td>
<td>EDS Slot/Index</td>
<td></td>
</tr>
<tr>
<td>-----</td>
<td>-------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>----------------------</td>
<td>---------</td>
<td>------</td>
<td>------</td>
<td>----------------</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Substitute value</td>
<td>only valid for output channel 0</td>
<td>Word</td>
<td>0x0000</td>
<td>0</td>
<td>65535</td>
<td>0x0Y10</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Output channel 0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18 to 21</td>
<td>Channel configuration and channel monitoring of the output channels 1 to 2</td>
<td>See tables 'Channel configuration' and 'Channel monitoring'</td>
<td>Byte</td>
<td>0x00</td>
<td>0</td>
<td>130</td>
<td>0x0Y11 to 0x0Y14</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>Channel configuration</td>
<td>See table 'Channel monitoring'</td>
<td>Byte</td>
<td>0x00</td>
<td>0</td>
<td>130</td>
<td>0x0Y15</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Output channel 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>Channel monitoring</td>
<td>See table 'Channel monitoring'</td>
<td>Byte</td>
<td>0x00</td>
<td>0</td>
<td>3</td>
<td>0x0Y16</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Output channel 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1) With CS31 and addresses less than 70 and FBP, the value is increased by 1
2) Not with FBP

GSD file:

```plaintext
Ext_User_Prm_Data_Len =
Ext_User_Prm_Data_Const(0) =
```

24
0x05, 0xe2, 0x15, \ 
0x01, 0x00, 0x00 \ 
0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, \ 
0x00, 0x00, 0x00, \ 
0x00, 0x00, 0x00, 0x00, 0x00;
<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Channel configuration see table 2)</td>
<td>Byte</td>
<td>0 0x00 see table 2)</td>
</tr>
<tr>
<td>2</td>
<td>Channel monitoring see table 3)</td>
<td>Byte</td>
<td>0 0x00 see table 3)</td>
</tr>
</tbody>
</table>

### Table 177: Channel configuration 2)

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes of the analog inputs, individually configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Unused (default)</td>
</tr>
<tr>
<td>1</td>
<td>Analog input 0 V ... 10 V</td>
</tr>
<tr>
<td>2</td>
<td>Digital input</td>
</tr>
<tr>
<td>3</td>
<td>Analog input 0 mA ... 20 mA</td>
</tr>
<tr>
<td>4</td>
<td>Analog input 4 mA ... 20 mA</td>
</tr>
<tr>
<td>5</td>
<td>Analog input -10 V ... +10 V</td>
</tr>
<tr>
<td>8</td>
<td>Analog input Pt100, -50 °C ... +400 °C (2-wire)</td>
</tr>
<tr>
<td>9</td>
<td>Analog input Pt100, -50 °C ... +400 °C (3-wire), requires 2 channels *)</td>
</tr>
<tr>
<td>10</td>
<td>Analog input 0 ... 10 V via differential inputs, requires 2 channels *)</td>
</tr>
<tr>
<td>11</td>
<td>Analog input -10 V ... +10 V via differential inputs, requires 2 channels *)</td>
</tr>
<tr>
<td>14</td>
<td>Analog input Pt100, -50 °C ... +70 °C (2-wire)</td>
</tr>
<tr>
<td>15</td>
<td>Analog input Pt100, -50 °C ... +70 °C (3-wire), requires 2 channels *)</td>
</tr>
<tr>
<td>16</td>
<td>Analog input Pt1000, -50 °C ... +400 °C (2-wire)</td>
</tr>
<tr>
<td>17</td>
<td>Analog input Pt1000, -50 °C ... +400 °C (3-wire), requires 2 channels *)</td>
</tr>
<tr>
<td>18</td>
<td>Analog input Ni1000, -50 °C ... +150 °C (2-wire)</td>
</tr>
<tr>
<td>19</td>
<td>Analog input Ni1000, -50 °C ... +150 °C (3-wire), requires 2 channels *)</td>
</tr>
</tbody>
</table>

*) In the operating modes with 3-wire configuration or with differential inputs, two adjacent analog inputs belong together (e.g. the channels 0 and 1). In these cases, both channels are configured in the desired operating mode. The lower address must be the even address (channel 0). The next higher address must be the odd address (channel 1). The converted analog value is available at the higher address (channel 1).

### Table 178: Channel monitoring 3)

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Monitoring</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Plausibility, open-circuit (broken wire) and short circuit</td>
</tr>
<tr>
<td>3</td>
<td>No monitoring</td>
</tr>
</tbody>
</table>
Table 179: Output channel 0 (1 channel)

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Channel configuration</td>
<td>see table 4)</td>
<td>see table 4)</td>
<td>Byte</td>
<td>see table 4)</td>
</tr>
<tr>
<td>2</td>
<td>Channel monitoring</td>
<td>see table 5)</td>
<td>see table 5)</td>
<td>Byte</td>
<td>see table 5)</td>
</tr>
<tr>
<td>3</td>
<td>Substitute value</td>
<td>0 ... 65535</td>
<td>0 ... 0xffff</td>
<td>Word</td>
<td>0</td>
</tr>
</tbody>
</table>

Table 180: Output channels 1 ... 3 (3x)

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Internal value, type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Channel configuration</td>
<td>Byte</td>
</tr>
<tr>
<td>2</td>
<td>Channel monitoring</td>
<td>Byte</td>
</tr>
</tbody>
</table>

Table 181: Channel configuration 4)

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes of the analog outputs, individually configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Unused (default)</td>
</tr>
<tr>
<td>128</td>
<td>Analog output -10 V ... +10 V</td>
</tr>
<tr>
<td>129</td>
<td>Analog output 0 mA ... 20 mA (not with the channels 4 ... 7 and 12 ... 15)</td>
</tr>
<tr>
<td>130</td>
<td>Analog output 4 mA ... 20 mA (not with the channels 4 ... 7 and 12 ... 15)</td>
</tr>
</tbody>
</table>

Table 182: Channel monitoring 5)

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Monitoring</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Plausibility, open circuit (broken wire) and short circuit (default)</td>
</tr>
<tr>
<td>3</td>
<td>No monitoring</td>
</tr>
</tbody>
</table>

Table 183: Substitute value 6)

<table>
<thead>
<tr>
<th>Intended behaviour of output channel when the control system stops</th>
<th>Required setting of the module parameter &quot;Behaviour of outputs in case of a communication error&quot;</th>
<th>Required setting of the channel parameter &quot;Substitute value&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output OFF</td>
<td>Off</td>
<td>0</td>
</tr>
<tr>
<td>Last value infinite</td>
<td>Last value</td>
<td>0</td>
</tr>
<tr>
<td>Last value for 5 s and then turn off</td>
<td>Last value 5 sec</td>
<td>0</td>
</tr>
<tr>
<td>Last value for 10 s and then turn off</td>
<td>Last value 10 sec</td>
<td>0</td>
</tr>
<tr>
<td>Substitute value infinite</td>
<td>Substitute value</td>
<td>Depending on configuration</td>
</tr>
</tbody>
</table>
Intended behaviour of output channel when the control system stops

| Substitute value for 5 s and then turn off | Substitute value 5 sec | Depending on configuration |
| Substitute value for 10 s and then turn off | Substitute value 10 sec | Depending on configuration |

Required setting of the module parameter "Behaviour of outputs in case of a communication error"

Required setting of the channel parameter "Substitute value"

Substitute value 5 sec Depending on configuration

Substitute value 10 sec Depending on configuration

### Diagnosis

**Table 184: Possible diagnosis of I/O channels**

<table>
<thead>
<tr>
<th>Output range</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Output value in the PLC underflow</td>
</tr>
<tr>
<td>0 mA ... 20 mA</td>
<td>Error identifier = 7</td>
</tr>
<tr>
<td>4 mA ... 20 mA</td>
<td>Error identifier = 7</td>
</tr>
<tr>
<td>-10 V ... +10 V</td>
<td>Error identifier = 48</td>
</tr>
</tbody>
</table>

**Table 185: Content of diagnosis messages**

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier (000 ... 063)</th>
<th>AC500 display</th>
<th>← Display in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class Comp Dev Mod Ch</td>
<td>Err</td>
<td>PS501 PLC browser</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Byte 6 Bit 6 ... 7</td>
<td>Byte 3</td>
<td>Byte 4</td>
<td>Byte 5</td>
<td>Byte 6 Bit 0 ... 5</td>
<td>FBP diagnosis block</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Class Interface Device Module Channel Error Identifier Error message Remedy</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1)</td>
<td>2)</td>
<td>3)</td>
<td>4)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Hardware descriptions**

Device specifications > I/O modules

<table>
<thead>
<tr>
<th>Module error</th>
</tr>
</thead>
<tbody>
<tr>
<td>14 1 ... 10 31 31 19</td>
</tr>
<tr>
<td>11 / 12 ADR 1 ... 10</td>
</tr>
<tr>
<td>14 1 ... 10 31 31 3</td>
</tr>
<tr>
<td>11 / 12 ADR 1 ... 10</td>
</tr>
<tr>
<td>E1 ... E4</td>
</tr>
<tr>
<td>-----------</td>
</tr>
<tr>
<td>Class</td>
</tr>
<tr>
<td>Byte 6</td>
</tr>
<tr>
<td>Bit 6 ... 7</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>1)</td>
<td>2)</td>
<td>3)</td>
<td>4)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>40</td>
<td>Different hard-/firmware versions in the module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td></td>
<td>11 / 12 ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>43</td>
<td>Internal error in the module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td></td>
<td>11 / 12 ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>36</td>
<td>Internal data exchange failure</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td></td>
<td>11 / 12 ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>9</td>
<td>Overflow diagnosis buffer</td>
<td>New start</td>
</tr>
<tr>
<td></td>
<td>11 / 12 ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>26</td>
<td>Parameter error</td>
<td>Check master</td>
</tr>
<tr>
<td></td>
<td>11 / 12 ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>11</td>
<td>Process voltage too low</td>
<td>Check process voltage</td>
</tr>
<tr>
<td></td>
<td>11 / 12 ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>45</td>
<td>Process voltage is switched off (ON -&gt; OFF)</td>
<td>Process voltage ON</td>
</tr>
<tr>
<td></td>
<td>11 / 12 ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Channel error

<table>
<thead>
<tr>
<th>AX521</th>
<th>AX522</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>1 ... 10</td>
</tr>
<tr>
<td>11 / 12 ADR</td>
<td>1 ... 10</td>
</tr>
<tr>
<td>4</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>1 ... 10</td>
</tr>
<tr>
<td>11 / 12 ADR</td>
<td>1 ... 10</td>
</tr>
<tr>
<td>4</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>1 ... 10</td>
</tr>
<tr>
<td>11 / 12 ADR</td>
<td>1 ... 10</td>
</tr>
<tr>
<td>4</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>1 ... 10</td>
</tr>
<tr>
<td>11 / 12 ADR</td>
<td>1 ... 10</td>
</tr>
<tr>
<td>4</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>1 ... 10</td>
</tr>
<tr>
<td>11 / 12 ADR</td>
<td>1 ... 10</td>
</tr>
</tbody>
</table>

Remarks:
1) In AC500, the following interface identifier applies:
14 = I/O bus,  11 = COM1 (e.g. CS31 bus), 12 = COM2.
The FBP diagnosis block does not contain this identifier.

2) With "Device" the following allocation applies:
31 = module itself, 1 ... 10 = expansion module 1 ... 10, ADR = hardware address (e.g. of the DC551)

3) With "Module" the following allocation applies depending on the master:
Module error: I/O bus or FBP: 31 = module itself; COM1/COM2: 1 ... 10 = expansion 1 ... 10
Channel error: I/O bus or FBP = module type (1 = AI, 3 = AO); COM1/COM2: 1 ... 10 = expansion 1 ... 10

4) In case of module errors, with channel "31 = Module itself" is output.

State LEDs

During the power ON procedure, the module initializes automatically. All LEDs (except the channel LEDs) are ON during this time.

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
<th>LED flashes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inputs I0 ... I3</td>
<td>Analog input</td>
<td>Yellow</td>
<td>Input is OFF</td>
<td>Input is ON (brightness depends on the value of the analog signal)</td>
<td>--</td>
</tr>
<tr>
<td>Outputs O0 ... O3</td>
<td>Analog output</td>
<td>Yellow</td>
<td>Output is OFF</td>
<td>Output is ON (brightness depends on the value of the analog signal)</td>
<td>--</td>
</tr>
<tr>
<td>UP</td>
<td>Process voltage 24 V DC via terminal</td>
<td>Green</td>
<td>Process voltage is missing</td>
<td>Process voltage OK</td>
<td>--</td>
</tr>
<tr>
<td>CH-ERR2</td>
<td>Channel error, error messages in groups (analog inputs or outputs combined into the groups 2 and 4)</td>
<td>Red</td>
<td>No error or process voltage is missing</td>
<td>Severe error within the corresponding group</td>
<td>Error on one channel of the group</td>
</tr>
<tr>
<td>CH-ERR4</td>
<td>Module error</td>
<td>Red</td>
<td>--</td>
<td>Internal error</td>
<td>--</td>
</tr>
</tbody>
</table>

*) Both LEDs (CH-ERR2 and CH-ERR4) light up together
### Measuring ranges

**Input ranges of voltage, current and digital input**

The represented resolution corresponds to 16 bits.

<table>
<thead>
<tr>
<th>Range</th>
<th>0 V ... 10 V</th>
<th>-10 V ... +10 V</th>
<th>0 mA ... 20 mA</th>
<th>4 mA ... 20 mA</th>
<th>Digital input</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Overflow</strong></td>
<td>&gt;11.7589</td>
<td>&gt;11.7589</td>
<td>&gt;23.5178</td>
<td>&gt;22.8142</td>
<td></td>
<td>32767</td>
</tr>
<tr>
<td>Measured value too high</td>
<td>11.7589</td>
<td>11.7589</td>
<td>23.5178</td>
<td>22.8142</td>
<td></td>
<td>32511</td>
</tr>
<tr>
<td></td>
<td>10.0004</td>
<td></td>
<td>20.0007</td>
<td>20.0006</td>
<td></td>
<td>27649</td>
</tr>
<tr>
<td>Normal range</td>
<td>10.0000</td>
<td>10.0000</td>
<td>20.0000</td>
<td>20.0000</td>
<td></td>
<td>27648</td>
</tr>
<tr>
<td>Normal range or measured value too low</td>
<td>0.0004</td>
<td>0.0004</td>
<td>0.0007</td>
<td>4.0006</td>
<td>ON</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>-0.0004</td>
<td>-1.7593</td>
<td>3.9994</td>
<td>1.1858</td>
<td>-1</td>
<td>1194</td>
</tr>
<tr>
<td></td>
<td>-10.0004</td>
<td>-11.7589</td>
<td>-10.0000</td>
<td></td>
<td>-27649</td>
<td>93FF</td>
</tr>
<tr>
<td>Measured value too low</td>
<td>-27649</td>
<td>-32512</td>
<td>-1600</td>
<td>-8100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt;-1.7593</td>
<td>&lt;-11.7589</td>
<td>&lt;0.0000</td>
<td>&lt;1.1858</td>
<td>-32768</td>
<td>8000</td>
</tr>
</tbody>
</table>

### Input ranges resistance temperature detector

<table>
<thead>
<tr>
<th>Range</th>
<th>Pt100 / Pt1000&lt;br&gt;-50 °C ... +70 °C</th>
<th>Pt100 / Pt1000&lt;br&gt;50 °C ... +400 °C</th>
<th>Ni1000&lt;br&gt;-50 °C ... +150 °C</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Overflow</strong></td>
<td>&gt;+80.0 °C</td>
<td>&gt;+450.0 °C</td>
<td>&gt;+160.0 °C</td>
<td>32767</td>
</tr>
<tr>
<td>Measured value too high</td>
<td>+450.0 °C</td>
<td></td>
<td></td>
<td>4500</td>
</tr>
<tr>
<td></td>
<td>: + 400.1 °C</td>
<td></td>
<td></td>
<td>4001</td>
</tr>
<tr>
<td></td>
<td>+160.0 °C</td>
<td></td>
<td>1600</td>
<td></td>
</tr>
<tr>
<td></td>
<td>: +150.1 °C</td>
<td></td>
<td>1501</td>
<td></td>
</tr>
<tr>
<td></td>
<td>+80.0 °C</td>
<td></td>
<td></td>
<td>800</td>
</tr>
<tr>
<td></td>
<td>: +70.1 °C</td>
<td></td>
<td></td>
<td>701</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Range Pt100 / Pt1000

<table>
<thead>
<tr>
<th>Normal range</th>
<th>Pt100</th>
<th>Pt1000</th>
<th>Ni1000</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td>-50 °C ... +70 °C</td>
<td>+400.0 °C</td>
<td>+150.0 °C</td>
<td>+0.1 °C</td>
<td>4000</td>
</tr>
<tr>
<td>+70.0 °C</td>
<td></td>
<td></td>
<td></td>
<td>1500</td>
</tr>
<tr>
<td>+0.1 °C</td>
<td>+ 0.1 °C</td>
<td>+ 0.1 °C</td>
<td></td>
<td>700</td>
</tr>
<tr>
<td>0.0 °C</td>
<td>0.0 °C</td>
<td>0.0 °C</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>-0.1 °C</td>
<td>-0.1 °C</td>
<td>-0.1 °C</td>
<td></td>
<td>-1</td>
</tr>
<tr>
<td>-50.0 °C</td>
<td>-50.0 °C</td>
<td>-50.0 °C</td>
<td></td>
<td>-501</td>
</tr>
</tbody>
</table>

### Measured value too low

| Measured value too low | -50.1 °C | -60.0 °C | | -32768 | 8000 |

### Underflow

| Underflow | < -60.0 °C | | | |

**Output ranges voltage and current**

The represented resolution corresponds to 16 bits.

### Range -10 V ...+10 V 0 mA ... 20 mA 4 mA ... 20 mA Digital value

<table>
<thead>
<tr>
<th>Range</th>
<th>-10 V ...+10 V</th>
<th>0 mA ... 20 mA</th>
<th>4 mA ... 20 mA</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overflow</td>
<td>0 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>&gt; 32511</td>
</tr>
<tr>
<td>Value too high</td>
<td>11.7589 V</td>
<td>23.5178 mA</td>
<td>22.8142 mA</td>
<td>32511</td>
</tr>
<tr>
<td>Normal range</td>
<td>10.0000 V</td>
<td>20.0000 mA</td>
<td>20.0000 mA</td>
<td>27649</td>
</tr>
<tr>
<td></td>
<td>0.0004 V</td>
<td>0.0007 mA</td>
<td>4.0006 mA</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>0.0000 V</td>
<td>4.0000 mA</td>
<td>0</td>
<td>0000</td>
</tr>
<tr>
<td></td>
<td>-0.0004 V</td>
<td>0 mA</td>
<td>3.9994 mA</td>
<td>32512</td>
</tr>
<tr>
<td></td>
<td>-10.0000 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>-27649</td>
</tr>
<tr>
<td>Value too low</td>
<td>-10.0004 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>-32512</td>
</tr>
<tr>
<td>Underflow</td>
<td>0 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>&lt; -32512</td>
</tr>
</tbody>
</table>
Technical data

Technical data of the module

The system data of AC500 and S500 are applicable to the standard version “Chapter 5.1.2 “System data AC500” on page 166.

The system data of AC500-XC are applicable to the XC version “Chapter 5.1.3 “System data AC500-XC” on page 169.

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process voltage</td>
<td></td>
</tr>
<tr>
<td>Connections</td>
<td>Terminals 1.8, 2.8, 3.8 and 4.8 for +24 V (UP) as well as 1.9, 2.9, 3.9 and 4.9 for 0 V (ZP)</td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5 %</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse on UP</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per module</td>
</tr>
<tr>
<td>Current consumption</td>
<td></td>
</tr>
<tr>
<td>From 24 V DC power supply at the termin-</td>
<td>Ca. 2 mA</td>
</tr>
<tr>
<td>als UP/L+ and ZP/M of the CPU/communi-</td>
<td></td>
</tr>
<tr>
<td>cation interface module</td>
<td></td>
</tr>
<tr>
<td>From UP at normal operation</td>
<td>0.15 A + output loads</td>
</tr>
<tr>
<td>Inrush current from UP (at power up)</td>
<td>0.020 A²s</td>
</tr>
<tr>
<td>Max. length of analog cables, conductor</td>
<td>100 m</td>
</tr>
<tr>
<td>section &gt; 0.14 mm²</td>
<td></td>
</tr>
<tr>
<td>Weight</td>
<td>300 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical with derating (output load reduced to 50 % at 40 °C per group)</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>

**NOTICE!**

All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

---

Technical data of the analog inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>4</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group of 4 channels</td>
</tr>
<tr>
<td>Connections of the channels I0- … I3-</td>
<td>Terminals 1.0 ... 1.3</td>
</tr>
</tbody>
</table>
### Technical data of the analog inputs, if used as digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>Max. 4</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group of 4 channels</td>
</tr>
<tr>
<td>Connections of the channels I0+ to I3+</td>
<td>Terminals 2.0 to 2.3</td>
</tr>
<tr>
<td>Reference potential for the inputs</td>
<td>Terminals 1.9, 2.9, 3.9 and 4.9 (ZP)</td>
</tr>
<tr>
<td>Input signal delay</td>
<td>Typ. 8 ms, configurable from 0.1 to 32 ms</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 LED per channel</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-30 V ... +5 V</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>+5 V ... +13 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>+13 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 7 mA</td>
</tr>
</tbody>
</table>

### Hardware descriptions

#### Device specifications > I/O modules

- Connections of the channels I0+ ... I3+
  Terminals 2.0 ... 2.3

- Input type
  Bipolar (not with current or Pt100/Pt1000/Ni1000)

- Galvanic isolation
  Against internal supply and other modules

- Configurability
  0 V ... 10 V, -10 V ... +10 V, 0 mA ... 20 mA, 4 mA ... 20 mA, Pt100/1000, Ni1000 (each input can be configured individually)

- Channel input resistance
  Voltage: > 100 kΩ
  Current: ca. 330 Ω

- Time constant of the input filter
  Voltage: 100 µs
  Current: 100 µs

- Indication of the input signals
  One LED per channel

- Conversion cycle
  2 ms (for 8 inputs + 8 outputs), with Pt/Ni... 1 s

- Resolution
  Range 0 V ... 10 V: 12 bits
  Range -10 V ... +10 V: 12 bits including sign
  Range 0 mA ... 20 mA: 12 bits
  Range 4 mA ... 20 mA: 12 bits

- Conversion error of the analog values caused by non-linearity, adjustment error at factory and resolution within the normal range
  Typ. ± 0.5 % of full scale at 25 °C
  Max. ± 1 % of full scale (all ranges) at 0 °C ... 60 °C or EMC disturbance

- Relationship between input signal and hex code
  Chapter 5.2.4.4.2.5.10.2 “Input ranges resistance temperature detector” on page 804

- Unused voltage inputs
  Are configured as "unused"

- Unused current inputs
  Have a low resistance, can be left open-circuited

- Overvoltage protection
  Yes
### Technical data of the analog outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>4, all channels for voltage and current</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group of 4 channels</td>
</tr>
<tr>
<td>Channels O0- ... O3-</td>
<td>Terminals 3.0 ... 3.3</td>
</tr>
<tr>
<td>Channels O0+ ... O3+</td>
<td>Terminals 4.0 ... 4.3</td>
</tr>
<tr>
<td>Output type</td>
<td>Bipolar with voltage, unipolar with current</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Against internal supply and other modules</td>
</tr>
<tr>
<td>Configurability</td>
<td>-10 V ... +10 V, 0 mA ... 20 mA, 4 mA ... 20 mA (each output can be configured individually), current outputs only channels 0 ... 3</td>
</tr>
<tr>
<td>Output resistance (load), as current output</td>
<td>0 Ω ... 500 Ω</td>
</tr>
<tr>
<td>Output loadability, as voltage output</td>
<td>Max. ± 10 mA</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>One LED per channel</td>
</tr>
<tr>
<td>Resolution</td>
<td>12 bits including sign</td>
</tr>
<tr>
<td>Settling time for full range change (resistive load, output signal within specified tolerance)</td>
<td>Typ. 5 ms</td>
</tr>
<tr>
<td>Conversion error of the analog values caused by non-linearity, adjustment error at factory and resolution within the normal range</td>
<td>Typ. ± 0.5 % of full scale at 25 °C</td>
</tr>
<tr>
<td>Relationship between output signal and hex code</td>
<td></td>
</tr>
<tr>
<td>Unused outputs</td>
<td>Can be left open-circuited</td>
</tr>
</tbody>
</table>
Dimensions

The dimensions are in mm and in brackets in inch.

Ordering Data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 250 100 R0001</td>
<td>AX521, analog input/output module, 4 AI, 4 AO, U/I/Pt100, 12 bits including sign, 2-wires</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 450 100 R0001</td>
<td>AX521-XC, analog input/output module, 4 AI, 4 AO, U/I/Pt100, 12 bits including sign, 2-wires, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
AX522 - Analog input/output module

Features

- 8 configurable analog inputs (I0 ... I7) in 1 group (1.0 ... 2.7)
  Resolution 12 bits including sign
- 8 configurable analog outputs (O0 ... O7) in 1 group (3.0 ... 4.7)
  Resolution 12 bits including sign
- Module-wise galvanically isolated
- XC version for use in extreme ambient conditions available

1 I/O bus
2 Allocation between terminal number and signal name
3 8 yellow LEDs to display the signal states at the analog inputs (I0 ... I7)
4 8 yellow LEDs to display the signal states at the analog outputs (O0 ... O7)
5 1 green LED to display the state of the process supply voltage UP
6 2 red LEDs to display errors
7 Label
8 Terminal unit
9 DIN rail
$^*$ Sign for XC version
Intended purpose

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g., CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.

Functionality

8 analog inputs (channel 0 ... channel 7), individually configurable

- Unused (default setting)
- 0 V ... 10 V
- -10 V ... +10 V
- 0 mA ... 20 mA
- 4 mA ... 20 mA
- Pt100, -50 °C ... +400 °C (2-wire)
- Pt100, -50 °C ... +400 °C (3-wire), requires 2 channels
- Pt100, -50 °C ... +70 °C (2-wire)
- Pt100, -50 °C ... +70 °C (3-wire), requires 2 channels
- Pt1000, -50 °C ... +400 °C (2-wire)
- Pt1000, -50 °C ... +400 °C (3-wire), requires 2 channels
- Pt1000, -50 °C ... +150 °C (2-wire)
- Pt1000, -50 °C ... +150 °C (3-wire), requires 2 channels
- 0 V ... 10 V with differential inputs, requires 2 channels
- -10 V ... +10 V with differential inputs, requires 2 channels
- Digital signals (digital input)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution of the analog channels</td>
<td></td>
</tr>
<tr>
<td>Voltage -10 V ... +10 V</td>
<td>12 bits including sign</td>
</tr>
<tr>
<td>Voltage 0 V ... 10 V</td>
<td>12 bits</td>
</tr>
<tr>
<td>Current 0 mA ... 20 mA, 4 mA ... 20 mA</td>
<td>12 bits</td>
</tr>
<tr>
<td>Temperature</td>
<td>0.1 °C</td>
</tr>
<tr>
<td>LED displays</td>
<td>19 LEDs for signals and error messages</td>
</tr>
<tr>
<td>Internal power supply</td>
<td>Via the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>External power supply</td>
<td>Via the terminals ZP and UP (process voltage 24 V DC)</td>
</tr>
<tr>
<td>Required terminal unit</td>
<td>TU515 or TU516 % Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938</td>
</tr>
</tbody>
</table>

Connections

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.
The modules are plugged on an I/O terminal unit. Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938. Properly position the modules and press until they lock in place. The terminal units are mounted on a DIN rail or with 2 screws plus the additional accessory for wall mounting. Chapter 5.2.8.2.5 “TA526 - Wall mounting accessory” on page 1324.

The connection of the I/O channels is carried out using the 40 terminals of the I/O terminal unit. I/O modules can be replaced without re-wiring the terminal units.

The terminals 1.8, 2.8, 3.8 and 4.8 as well as 1.9, 2.9, 3.9 and 4.9 are electrically interconnected within the I/O terminal units and always have the same assignment, independent of the inserted module:

Terminals 1.8, 2.8, 3.8 and 4.8: process voltage UP = +24 V DC
Terminals 1.9, 2.9, 3.9 and 4.9: process voltage ZP = 0 V DC

The assignment of the other terminals:

<table>
<thead>
<tr>
<th>Terminals</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0 ... 1.7</td>
<td>I0- ... I7-</td>
<td>Negative poles of the 8 analog inputs</td>
</tr>
<tr>
<td>2.0 ... 2.7</td>
<td>I0+ ... I7+</td>
<td>Positive poles of the 8 analog inputs</td>
</tr>
<tr>
<td>3.0 ... 3.7</td>
<td>O0- ... O7-</td>
<td>Negative poles of the 8 analog outputs</td>
</tr>
<tr>
<td>4.0 ... 4.7</td>
<td>O0+ ... O7+</td>
<td>Positive poles of the 8 analog outputs</td>
</tr>
</tbody>
</table>

The negative poles of the analog inputs are connected to each other to form an "Analog Ground" signal for the module.

The negative poles of the analog outputs are connected to each other to form an "Analog Ground" signal for the module.

There is no galvanic isolation between the analog circuitry and ZP/UP. Therefore, the analog sensors must be galvanically isolated in order to avoid loops via the ground potential or the supply voltage.

Because of their common reference potential, analog current inputs cannot be circuited in series, neither within the module nor with channels of other modules.

For the open-circuit detection (wire break), each analog input channel is pulled up to "plus" by a high-resistance resistor. If nothing is connected, the maximum voltage will be read in then.
The internal power supply voltage for the module's circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 2 mA per I/O module. The external power supply connection is carried out via the UP (+24 V DC) and the ZP (0 V DC) terminals.

**WARNING!**

**Removal/Insertion under power**

Removal or insertion under power is permissible only if all conditions for hot swapping are fullfilled.

* Chapter 4.9.3 “Replace an I/O module with hot swap” on page 153

The devices are not designed for removal or insertion under power when the conditions for hot swap do not apply. Because of unforeseeable consequences, it is not allowed to plug in or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you
- connect or disconnect any signal or terminal block
- remove, mount or replace a module.

Disconnecting any powered devices while they are energized in a hazardous location could result in an electric arc, which could create an ignition source resulting in fire or explosion.

Prior to proceeding, make sure that power is been disconnected and that the area has been thoroughly checked to ensure that flammable materials are not present.

The devices must not be opened when in operation. The same applies to the network interfaces.

**NOTICE!**

**Risk of damaging the PLC modules!**

- Overvoltages and short circuits might damage the PLC modules.
  - Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
  - Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

**Generally, analog signals must be laid in shielded cables. The cable shields must be grounded at both sides of the cables. In order to avoid unacceptable potential differences between different parts of the installation, low resistance equipotential bonding conductors must be laid.**
Fig. 128: Connection of the I/O module: 8 analog inputs and 8 analog outputs, individually configurable. Chapter 5.2.4.4.2.6.3 “Functionality” on page 811

**CAUTION!**
By installing equipotential bonding conductors between the different parts of the system, it must be ensured that the potential difference between ZP and AGND never can exceed 1 V.

**CAUTION!**
The process supply voltage must be included in the grounding concept (e.g. grounding of the negative terminal).

Connection of resistance thermometers in 2-wire configuration

When resistance thermometers (Pt100, Pt1000, Ni1000) are used, a constant current must flow through them to build the necessary voltage drop for the evaluation. For this, the I/O module provides a constant current source which is multiplexed over the 8 analog channels.
The I/O module performs a linearization of the resistance characteristic. In order to avoid error messages from unused analog input channels, it is useful to configure them as "unused".

Connection of resistance thermometers in 3-wire configuration

When resistance thermometers (Pt100, Pt1000, Ni1000) are used, a constant current must flow through them to build the necessary voltage drop for the evaluation. For this, the I/O module provides a constant current source which is multiplexed over the max. 8 (depending on the configuration) analog channels.
If several measuring points are adjacent to each other, only one return line is necessary. This saves wiring costs.

With the 3-wire configuration, two adjacent analog channels belong together (e.g. the channels 0 and 1). In this case, both channels are configured according to the desired operating mode. The lower address must be the even address (channel 0), the next higher address must be the odd address (channel 1).

The constant current of one channel flows through the resistance thermometer. The constant current of the other channel flows through one of the cores. The module calculates the measured value from the two voltage drops and stores it under the input with the higher channel number (e.g. I1).

In order to keep measuring errors as small as possible, it is necessary to have all the involved conductors in the same cable. All the conductors must have the same cross section.

<table>
<thead>
<tr>
<th></th>
<th>Temperature Range</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pt100</td>
<td>-50 °C ... +70 °C</td>
<td>3-wire configuration, two channels used</td>
</tr>
<tr>
<td>Pt100</td>
<td>-50 °C ... +400 °C</td>
<td>3-wire configuration, two channels used</td>
</tr>
<tr>
<td>Pt1000</td>
<td>-50 °C ... +400 °C</td>
<td>3-wire configuration, two channels used</td>
</tr>
<tr>
<td>Ni1000</td>
<td>-50 °C ... +150 °C</td>
<td>3-wire configuration, two channels used</td>
</tr>
</tbody>
</table>

The I/O module performs a linearization of the resistance characteristic.

In order to avoid error messages from unused analog input channels, it is useful to configure them as "unused".
Connection of active-type analog sensors (Voltage) with galvanically isolated power supply

Fig. 131: Connection example
By connecting the sensor’s negative pole of the output voltage to AGND, the galvanically isolated voltage source of the sensor is referred to ZP.

The following measuring ranges can be configured for AX521 *Chapter 5.2.4.4.2.5.7 “Parameterization” on page 796* and for AX522 *Chapter 5.2.4.4.2.6.7 “Parameterization” on page 826*:

<table>
<thead>
<tr>
<th>Voltage</th>
<th>Range</th>
<th>Channels used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>0 V ... 10 V</td>
<td>1 channel</td>
</tr>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V</td>
<td>1 channel</td>
</tr>
</tbody>
</table>

In order to avoid error messages or long processing times, it is useful to configure unused analog input channels as “unused”.

Connection of active-type analog sensors (Current) with galvanically isolated power supply

![Connection diagram](image)

*Fig. 132: Connection example*

<table>
<thead>
<tr>
<th>Current</th>
<th>Range</th>
<th>Channels used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>0 mA ... 20 mA</td>
<td>1 channel</td>
</tr>
<tr>
<td>Current</td>
<td>4 mA ... 20 mA</td>
<td>1 channel</td>
</tr>
</tbody>
</table>

Unused input channels can be left open-circuited, because they are of low resistance.
Connection of active-type analog sensors (Voltage) with no galvanically isolated power supply

Fig. 133: Connection example
CAUTION!
The potential difference between AGND and ZP at the module must not be greater than 1V, not even in case of long lines (see figure Terminal Assignment).

If AGND does not get connected to ZP, the sensor current flows to ZP via the AGND line. The measuring signal is distorted, as a very small current flows through the voltage line. The total current through the PTC should not exceed 50 mA. This measuring method is therefore only suitable for short lines and small sensor currents. If there are bigger distances, the difference measuring method should be applied.

<table>
<thead>
<tr>
<th>Voltage</th>
<th>0 V ... 10 V</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V *)</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

*) if the sensor can provide this signal range

In order to avoid error messages or long processing times, it is useful to configure unused analog input channels as "unused".
Connection of passive-type analog sensors (Current)

Fig. 134: Connection example
CAUTION!
If, during initialization, an analog current sensor supplies more than 25 mA for more than 1 second to an analog input, this input is switched off by the module (input protection). In such cases, it is recommended to protect the analog input by a 10-volt Zener diode (in parallel to I+ and ZP). But, in general, sensors with fast initialization or without current peaks higher than 25 mA are preferrable.

Unused input channels can be left open-circuited because they are of low resistance.

Connection of active-type analog sensors (Voltage) to differential inputs

Differential inputs are very useful if analog sensors are used which are remotely non-isolated (e.g. the minus terminal is remotely grounded).

The use of differential inputs helps to considerably increase the measuring accuracy and to avoid ground loops.

With differential input configurations, two adjacent analog channels belong together (e.g. the channels 0 and 1). In this case, both channels are configured according to the desired operating mode. The lower address must be the even address (channel 0), the next higher address must be the odd address (channel 1). The converted analog value is available at the higher address (channel 1).

The analog value is calculated by subtraction of the input value with the higher address from the input value of the lower address.

The converted analog value is available at the odd channel (higher address).

CAUTION!
The ground potential at the sensors must not have too large a potential difference with respect to ZP (max. ±1 V within the full signal range). Otherwise, problems may occur concerning the common-mode input voltages of the involved analog inputs.
Fig. 135: Connection example
The negative pole of the sensor must be grounded next to the sensor.

<table>
<thead>
<tr>
<th>Voltage</th>
<th>0 V ... 10 V</th>
<th>with differential inputs, 2 channels used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V</td>
<td>with differential inputs, 2 channels used</td>
</tr>
</tbody>
</table>

In order to avoid error messages or long processing times, it is useful to configure unused analog input channels as "unused".

Use of analog inputs as digital inputs

Several (or all) analog inputs can be configured as digital inputs. The inputs are not galvanically isolated against the other analog channels.

![Connection example](image_url)

**Fig. 136: Connection example**

<table>
<thead>
<tr>
<th>Digital input</th>
<th>24 V</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effect of incorrect input terminal connection</td>
<td>Wrong or no signal detected, no damage up to 35 V</td>
<td></td>
</tr>
</tbody>
</table>
Connection of analog output loads (Voltage, current)

Fig. 137: Connection example
Voltage
-10 V ... +10 V
Load max. ± 10 mA
1 channel used

Current
0 mA ... 20 mA
Load 0 Ω ... 500 Ω
1 channel used

Current
4 mA ... 20 mA
Load 0 Ω ... 500 Ω
1 channel used

Only the channels 0 ... 3 can be configured as current output (0 mA ... 20 mA or 4 mA ... 20 mA).
Unused analog outputs can be left open-circuited.

Internal data exchange

<table>
<thead>
<tr>
<th>Digital inputs (bytes)</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital outputs (bytes)</td>
<td>0</td>
</tr>
<tr>
<td>Counter input data (words)</td>
<td>8</td>
</tr>
<tr>
<td>Counter output data (words)</td>
<td>8</td>
</tr>
</tbody>
</table>

I/O configuration

The module does not store configuration data itself. It gets its parameterization data from the master device of the I/O bus (CPU or communication interface module) during power-up of the system.

Hence, replacing I/O modules is possible without any re-parameterization via software.

Parameterization

<table>
<thead>
<tr>
<th>Firmware version</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firmware version &gt; V2.0.0</td>
<td>The arrangement of the parameter data is performed by Control Builder Plus/ Automation Builder software.</td>
</tr>
</tbody>
</table>

The parameter data directly influences the functionality of modules.
For non-standard applications, it is necessary to adapt the parameters to your system configuration.

Module: Module slot address: Y = 1 ... 10

For non-standard applications, it is necessary to adapt the parameters to your system configuration.
Module slot address: Y = 1 ... 7

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot/Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Module ID</td>
<td>Internal 1500</td>
<td>Word 1500</td>
<td>0x05dc</td>
<td>0</td>
<td>65535</td>
<td>0x0Y01</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Ignore module</td>
<td>No</td>
<td>Yes</td>
<td>Byte</td>
<td>No</td>
<td>0x00</td>
<td>not for FBP</td>
<td></td>
</tr>
<tr>
<td>No.</td>
<td>Name</td>
<td>Value</td>
<td>Internal value, type</td>
<td>Default</td>
<td>Min.</td>
<td>Max.</td>
<td>EDS Slot/Index</td>
<td></td>
</tr>
<tr>
<td>-----</td>
<td>----------------------------------------------------------------------</td>
<td>------------------------</td>
<td>----------------------</td>
<td>---------------</td>
<td>------</td>
<td>------</td>
<td>----------------</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Parameter length in bytes</td>
<td>Internal: 37 Byte</td>
<td></td>
<td>37-CPU 37-FBP</td>
<td>0</td>
<td>255</td>
<td>0x0Y02</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Check supply</td>
<td>Off/On: 0/1 Byte</td>
<td></td>
<td>On 0x01</td>
<td>0</td>
<td>1</td>
<td>0x0Y03</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Analog data format</td>
<td>Default: 0 Byte</td>
<td></td>
<td>Default 0x00</td>
<td></td>
<td></td>
<td>0x0Y04</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Behaviour of outputs at communication errors</td>
<td>Off/Last value: 0/1+(n<em>5); Substitue value: 2+(n</em>5), n ≤ 2</td>
<td>Byte Off 0x00</td>
<td></td>
<td>0</td>
<td>2</td>
<td>0x0Y05</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Channel configuration</td>
<td>See Table 187 “Channel configuration” on page 829</td>
<td>Byte Default 0x00</td>
<td></td>
<td>0</td>
<td>19</td>
<td>0x0Y06</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Channel monitoring</td>
<td>See Table 188 “Channel monitoring” on page 830</td>
<td>Byte Default 0x00</td>
<td></td>
<td>0</td>
<td>3</td>
<td>0x0Y07</td>
<td></td>
</tr>
<tr>
<td>9 to 22</td>
<td>Channel configuration and channel monitoring of the input channels 1 ... 7</td>
<td>See Table 187 “Channel configuration” on page 829 and Table 188 “Channel monitoring” on page 830</td>
<td>Byte Default 0x00</td>
<td></td>
<td>0</td>
<td>19</td>
<td>0x0Y08 to 0x0Y15</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>Channel configuration</td>
<td>See Table 187 “Channel configuration” on page 829</td>
<td>Byte Default 0x00</td>
<td></td>
<td>0</td>
<td>130</td>
<td>0x0Y16</td>
<td></td>
</tr>
<tr>
<td>No.</td>
<td>Name</td>
<td>Value</td>
<td>Internal value</td>
<td>Internal value, type</td>
<td>Default</td>
<td>Min.</td>
<td>Max.</td>
<td>EDS Slot/Index</td>
</tr>
<tr>
<td>-----</td>
<td>----------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>----------------</td>
<td>---------------------</td>
<td>---------</td>
<td>------</td>
<td>------</td>
<td>----------------</td>
</tr>
<tr>
<td>24</td>
<td>Channel monitoring</td>
<td>See table 'Channel monitoring' (% Table 188 “Channel monitoring 3)” on page 830</td>
<td></td>
<td>Byte</td>
<td>Default 0x00</td>
<td>0</td>
<td>3</td>
<td>0x0Y17</td>
</tr>
<tr>
<td>25</td>
<td>Substitute value</td>
<td>Only valid for output channel 0</td>
<td>0 ... 0xffff</td>
<td>Word</td>
<td>Default 0x0000</td>
<td>0</td>
<td>65535</td>
<td>0x0Y18</td>
</tr>
<tr>
<td>26-31</td>
<td>Channel configuration and channel monitoring of the output channels 1 ... 3</td>
<td>See table 'Channel configuration' (% Table 187 “Channel configuration 2)” on page 829 and table 'Channel monitoring' (% Table 188 “Channel monitoring 3)” on page 830</td>
<td></td>
<td>Byte</td>
<td>Default 0x00 0x00</td>
<td>0</td>
<td>130</td>
<td>0x0Y19 to 0x0Y1E</td>
</tr>
<tr>
<td>32</td>
<td>Channel configuration</td>
<td>See table 'Channel configuration' (% Table 187 “Channel configuration 2)” on page 829</td>
<td></td>
<td>Byte</td>
<td>Default 0x00</td>
<td>0</td>
<td>128</td>
<td>0x0Y1F</td>
</tr>
<tr>
<td>33</td>
<td>Channel monitoring</td>
<td>See table 'Channel monitoring' (% Table 188 “Channel monitoring 3)” on page 830</td>
<td></td>
<td>Byte</td>
<td>Default 0x00</td>
<td>0</td>
<td>3</td>
<td>0x0Y20</td>
</tr>
<tr>
<td>34-39</td>
<td>Channel configuration and channel monitoring of the output channels 5 ... 7</td>
<td>See table 'Channel configuration' (% Table 187 “Channel configuration 2)” on page 829 and table 'Channel monitoring' (% Table 188 “Channel monitoring 3)” on page 830</td>
<td></td>
<td>Byte</td>
<td>Default 0x00 0x00</td>
<td>0</td>
<td>128</td>
<td>0x0Y21 to 0x0Y26</td>
</tr>
</tbody>
</table>

1) With CS31 and addresses less than 70 and FBP, the value is increased by 1
2) Not with FBP
GSD file:

```
Ext_User_Prm_Data_Len = 24
Ext_User_Prm_Data_Const(0) = 0x05, 0xe2, 0x15, \
0x01, 0x00, 0x00 \n0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00;
```

Table 186: Input channel (4x)

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Channel configuration see table ²⁾</td>
<td>Byte</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0x00 see table ²⁾</td>
</tr>
<tr>
<td>2</td>
<td>Channel monitoring see table ³⁾</td>
<td>Byte</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0x00 see table ³⁾</td>
</tr>
</tbody>
</table>

Table 187: Channel configuration ²⁾

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes of the analog inputs, individually configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Unused (default)</td>
</tr>
<tr>
<td>1</td>
<td>Analog input 0 V ... 10 V</td>
</tr>
<tr>
<td>2</td>
<td>Digital input</td>
</tr>
<tr>
<td>3</td>
<td>Analog input 0 mA ... 20 mA</td>
</tr>
<tr>
<td>4</td>
<td>Analog input 4 mA ... 20 mA</td>
</tr>
<tr>
<td>5</td>
<td>Analog input -10 V ... +10 V</td>
</tr>
<tr>
<td>8</td>
<td>Analog input Pt100, -50 °C ... +400 °C (2-wire)</td>
</tr>
<tr>
<td>9</td>
<td>Analog input Pt100, -50 °C ... +400 °C (3-wire), requires 2 channels *)</td>
</tr>
<tr>
<td>10</td>
<td>Analog input 0 V ... 10 V via differential inputs, requires 2 channels *)</td>
</tr>
<tr>
<td>11</td>
<td>Analog input -10 V ... +10 V via differential inputs, requires 2 channels *)</td>
</tr>
<tr>
<td>14</td>
<td>Analog input Pt100, -50 °C ... +70 °C (2-wire)</td>
</tr>
<tr>
<td>15</td>
<td>Analog input Pt100, -50 °C ... +70 °C (3-wire), requires 2 channels *)</td>
</tr>
<tr>
<td>16</td>
<td>Analog input Pt1000, -50 °C ... +400 °C (2-wire)</td>
</tr>
<tr>
<td>17</td>
<td>Analog input Pt1000, -50 °C ... +400 °C (3-wire), requires 2 channels *)</td>
</tr>
<tr>
<td>18</td>
<td>Analog input Ni1000, -50 °C ... +150 °C (2-wire)</td>
</tr>
<tr>
<td>19</td>
<td>Analog input Ni1000, -50 °C ... +150 °C (3-wire), requires 2 channels *)</td>
</tr>
</tbody>
</table>

*) In the operating modes with 3-wire configuration or with differential inputs, two adjacent analog inputs belong together (e.g. the channels 0 and 1). In these cases, both channels are configured in the desired operating mode. The lower address must be the even address (channel 0). The next higher address must be the odd address (channel 1). The converted analog value is available at the higher address (channel 1).
### Table 188: Channel monitoring 3)

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Monitoring</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Plausibility, open-circuit (broken wire) and short circuit</td>
</tr>
<tr>
<td>3</td>
<td>No monitoring</td>
</tr>
</tbody>
</table>

### Table 189: Output channel 0 (1 channel)

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Channel configuration</td>
<td>see table 4)</td>
<td>Byte</td>
<td>see table 4)</td>
</tr>
<tr>
<td>2</td>
<td>Channel monitoring</td>
<td>see table 5)</td>
<td>Byte</td>
<td>see table 5)</td>
</tr>
<tr>
<td>3</td>
<td>Substitute value</td>
<td>0 ... 65535</td>
<td>Word</td>
<td>0</td>
</tr>
</tbody>
</table>

### Table 190: Output channels 1 ... 3 (3x)

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Internal value, type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Channel configuration</td>
<td>see table 4)</td>
</tr>
<tr>
<td>2</td>
<td>Channel monitoring</td>
<td>see table 6)</td>
</tr>
</tbody>
</table>

### Table 191: Channel configuration 4)

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes of the analog outputs, individually configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Unused (default)</td>
</tr>
<tr>
<td>128</td>
<td>Analog output -10 V ... +10 V</td>
</tr>
<tr>
<td>129</td>
<td>Analog output 0 mA ... 20 mA (not with the channels 4 ... 7 and 12 ... 15)</td>
</tr>
<tr>
<td>130</td>
<td>Analog output 4 mA ... 20 mA (not with the channels 4 ... 7 and 12 ... 15)</td>
</tr>
</tbody>
</table>

### Table 192: Channel monitoring 5)

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Monitoring</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Plausibility, open circuit (broken wire) and short circuit (default)</td>
</tr>
<tr>
<td>3</td>
<td>No monitoring</td>
</tr>
</tbody>
</table>

### Table 193: Substitute value 6)

<table>
<thead>
<tr>
<th>Intended behaviour of output channel when the control system stops</th>
<th>Required setting of the module parameter “Behaviour of outputs in case of a communication error”</th>
<th>Required setting of the channel parameter “Substitute value”</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output OFF</td>
<td>Off</td>
<td>0</td>
</tr>
<tr>
<td>Last value infinite</td>
<td>Last value</td>
<td>0</td>
</tr>
</tbody>
</table>
### Intended behaviour of output channel when the control system stops

<table>
<thead>
<tr>
<th>Last value for 5 s and then turn off</th>
<th>Last value 5 sec</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last value for 10 s and then turn off</td>
<td>Last value 10 sec</td>
<td>0</td>
</tr>
<tr>
<td>Substitute value infinite</td>
<td>Substitute value</td>
<td>Depending on configuration</td>
</tr>
<tr>
<td>Substitute value for 5 s and then turn off</td>
<td>Substitute value 5 sec</td>
<td>Depending on configuration</td>
</tr>
<tr>
<td>Substitute value for 10 s and then turn off</td>
<td>Substitute value 10 sec</td>
<td>Depending on configuration</td>
</tr>
</tbody>
</table>

### Required setting of the module parameter "Behaviour of outputs in case of a communication error"

### Required setting of the channel parameter "Substitute value"

#### Diagnosis

*Table 194: Possible diagnosis of I/O channels*

<table>
<thead>
<tr>
<th>Output range</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Output value in the PLC underflow</td>
</tr>
<tr>
<td>0 mA ... 20 mA</td>
<td>Error identifier = 7</td>
</tr>
<tr>
<td>4 mA ... 20 mA</td>
<td>Error identifier = 7</td>
</tr>
<tr>
<td>-10 V ... +10 V</td>
<td>Error identifier = 48</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Input range</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Short circuit</td>
</tr>
<tr>
<td>0 mA ... 20 mA</td>
<td>no diagnosis possible</td>
</tr>
<tr>
<td>4 mA ... 20 mA</td>
<td>Error identifier = 7</td>
</tr>
<tr>
<td>-10 V ... +10 V</td>
<td>no diagnosis possible</td>
</tr>
</tbody>
</table>
### Table 195: Content of diagnosis messages

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier 000 ... 063</th>
<th>AC500 display</th>
<th>Display in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Comp</td>
<td>Dev</td>
<td>Mod</td>
<td>Ch</td>
<td>Err</td>
<td>PS501 PLC browser</td>
<td></td>
</tr>
<tr>
<td>Byte 6</td>
<td>-</td>
<td>Byte 3</td>
<td>Byte 4</td>
<td>Byte 5</td>
<td>Byte 6</td>
<td>Bit 0 ... 5</td>
<td>FBP diagnosis block</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Module error

<table>
<thead>
<tr>
<th>Channel</th>
<th>Module</th>
<th>Error Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
</tr>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
</tr>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
</tr>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
</tr>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
</tr>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
</tr>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
</tr>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
</tr>
</tbody>
</table>

#### Channel error

<table>
<thead>
<tr>
<th>Channel</th>
<th>Module</th>
<th>Error Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>AX521</td>
<td>14</td>
<td>1 ... 10</td>
<td>1</td>
<td>0 ... 3</td>
</tr>
<tr>
<td>AX522</td>
<td>14</td>
<td>1 ... 10</td>
<td>1</td>
<td>0 ... 3</td>
</tr>
<tr>
<td></td>
<td>14</td>
<td>1 ... 10</td>
<td>1</td>
<td>0 ... 3</td>
</tr>
<tr>
<td>Class</td>
<td>Interface</td>
<td>Device</td>
<td>Module</td>
<td>Channel</td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>--------</td>
<td>--------</td>
<td>---------</td>
</tr>
<tr>
<td></td>
<td>1)</td>
<td>2)</td>
<td>3)</td>
<td>4)</td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>3</td>
<td>4 ... 7</td>
</tr>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>3</td>
<td>4 ... 7</td>
</tr>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Remarks:

1) In AC500, the following interface identifier applies:
   14 = I/O bus, 11 = COM1 (e.g. CS31 bus), 12 = COM2.
   The FBP diagnosis block does not contain this identifier.

2) With "Device" the following allocation applies:
   31 = module itself, 1 ... 10 = expansion module 1 ... 10, ADR = hardware address (e.g. of the DC551)

3) With "Module" the following allocation applies depending on the master:
   Module error: I/O bus or FBP: 31 = module itself; COM1/C0M2: 1 ... 10 = expansion 1 ... 10
   Channel error: I/O bus or FBP = module type (1 = AI, 3 = AO); COM1/C0M2: 1 ... 10 = expansion 1 ... 10

4) In case of module errors, with channel "31 = Module itself" is output.

State LEDs

During the power ON procedure, the module initializes automatically. All LEDs (except the channel LEDs) are ON during this time.
## Measuring ranges

### Input ranges of voltage, current and digital input

The represented resolution corresponds to 16 bits.

<table>
<thead>
<tr>
<th>Range</th>
<th>0 V ... 10 V</th>
<th>-10 V ... +10 V</th>
<th>0 mA ... 20 mA</th>
<th>4 mA ... 20 mA</th>
<th>Digital input</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overflow</td>
<td>&gt;11.7589</td>
<td>&gt;11.7589</td>
<td>&gt;23.5178</td>
<td>&gt;22.8142</td>
<td></td>
<td>32767</td>
</tr>
<tr>
<td>Measured value</td>
<td>11.7589</td>
<td>10.0004</td>
<td>23.5178</td>
<td>22.8142</td>
<td></td>
<td>32511</td>
</tr>
<tr>
<td>too high</td>
<td>11.7589</td>
<td>10.0004</td>
<td>20.0007</td>
<td>20.0006</td>
<td></td>
<td>27649</td>
</tr>
<tr>
<td>Normal range</td>
<td>10.0000</td>
<td>10.0000</td>
<td>20.0000</td>
<td>20.0000</td>
<td>ON</td>
<td>27648</td>
</tr>
<tr>
<td></td>
<td>0.0004</td>
<td>0.0004</td>
<td>0.0007</td>
<td>4.0006</td>
<td>OFF</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0.0000</td>
<td>0.0000</td>
<td>0</td>
<td>4</td>
<td>OFF</td>
<td>0</td>
</tr>
</tbody>
</table>

(*) Both LEDs (CH-ERR2 and CH-ERR4) light up together
<table>
<thead>
<tr>
<th>Range</th>
<th>0 V ... 10 V</th>
<th>-10 V ... +10 V</th>
<th>0 mA ... 20 mA</th>
<th>4 mA ... 20 mA</th>
<th>Digital input</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal range or measured value too low</td>
<td>-0.0004</td>
<td>-1.7593</td>
<td></td>
<td></td>
<td>3.9994</td>
<td>-1</td>
</tr>
<tr>
<td></td>
<td>-10.0000</td>
<td></td>
<td>1.1858</td>
<td>-4864</td>
<td></td>
<td>FFFF</td>
</tr>
<tr>
<td></td>
<td>-27648</td>
<td></td>
<td></td>
<td>9400</td>
<td></td>
<td>ED00</td>
</tr>
<tr>
<td>Measured value too low</td>
<td>-10.0004</td>
<td></td>
<td></td>
<td>-27649</td>
<td></td>
<td>93FF</td>
</tr>
<tr>
<td></td>
<td>-11.7589</td>
<td></td>
<td></td>
<td>8100</td>
<td></td>
<td>8100</td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt;-1.7593</td>
<td>&lt;-11.7589</td>
<td>&lt;-0.0000</td>
<td>&lt;-1.1858</td>
<td>-32768</td>
<td>8000</td>
</tr>
</tbody>
</table>

### Input ranges resistance temperature detector

<table>
<thead>
<tr>
<th>Range</th>
<th>Pt100 / Pt1000</th>
<th>Pt100 / Pt1000</th>
<th>Ni1000</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>-50 °C ... +70 °C</td>
<td>0 °C ... +400 °C</td>
<td>-50 °C ... +150 °C</td>
<td>Decimal</td>
</tr>
<tr>
<td>Overflow</td>
<td>&gt; +80.0 °C</td>
<td>&gt; +450.0 °C</td>
<td>&gt; +160.0 °C</td>
<td>32767</td>
</tr>
<tr>
<td>Measured value too high</td>
<td>+450.0 °C</td>
<td>+400.1 °C</td>
<td>+160.0 °C</td>
<td>4500</td>
</tr>
<tr>
<td></td>
<td></td>
<td>+150.1 °C</td>
<td>1600</td>
<td>:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>05DD</td>
<td>:</td>
</tr>
<tr>
<td>Normal range</td>
<td>:</td>
<td>+400.0 °C</td>
<td>+150.0 °C</td>
<td>4000</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>+150.1 °C</td>
<td>1500</td>
<td>05DC</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>+ 0.1 °C</td>
<td>700</td>
<td>:</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>+ 0.1 °C</td>
<td>:</td>
<td>:</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>+ 0.1 °C</td>
<td>:</td>
<td>:</td>
</tr>
<tr>
<td>Measured value too low</td>
<td>-50.1 °C</td>
<td>-50.0 °C</td>
<td>-50.0 °C</td>
<td>-501</td>
</tr>
<tr>
<td></td>
<td>-60.0 °C</td>
<td>-60.0 °C</td>
<td>-60.0 °C</td>
<td>-600</td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt;-60.0 °C</td>
<td>&lt;-60.0 °C</td>
<td>&lt;-60.0 °C</td>
<td>-32768</td>
</tr>
</tbody>
</table>
Output ranges voltage and current

The represented resolution corresponds to 16 bits.

<table>
<thead>
<tr>
<th>Range</th>
<th>-10 V ...+10 V</th>
<th>0 mA ... 20 mA</th>
<th>4 mA ... 20 mA</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Decimal</td>
<td>Hex.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overflow</td>
<td>0 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>&gt; 32511</td>
</tr>
<tr>
<td>Value too high</td>
<td>11.7589 V</td>
<td>23.5178 mA</td>
<td>22.8142 mA</td>
<td>32511</td>
</tr>
<tr>
<td></td>
<td>10.0004 V</td>
<td>20.0007 mA</td>
<td>20.0006 mA</td>
<td>7EFF</td>
</tr>
<tr>
<td>Normal range</td>
<td>10.0000 V</td>
<td>20.0000 mA</td>
<td>20.0000 mA</td>
<td>27648</td>
</tr>
<tr>
<td></td>
<td>0.0004 V</td>
<td>0.0007 mA</td>
<td>4.0006 mA</td>
<td>6C00</td>
</tr>
<tr>
<td></td>
<td>0.0000 V</td>
<td>0.0000 mA</td>
<td>4.0000 mA</td>
<td>0001</td>
</tr>
<tr>
<td>-0.0004 V</td>
<td>0 mA</td>
<td>3.9994 mA</td>
<td>-1</td>
<td>E500</td>
</tr>
<tr>
<td>-10.0000 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>-6912</td>
<td>9400</td>
</tr>
<tr>
<td>Value too low</td>
<td>-10.0004 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>-27649</td>
</tr>
<tr>
<td></td>
<td>-11.7589 V</td>
<td>0 mA</td>
<td>-32512</td>
<td>93FF</td>
</tr>
<tr>
<td>Underflow</td>
<td>0 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>&lt;-32512</td>
</tr>
</tbody>
</table>

Technical data

Technical data of the module

The system data of AC500 and S500 are applicable to the standard version “Chapter 5.1.2 “System data AC500” on page 166.”

The system data of AC500-XC are applicable to the XC version “Chapter 5.1.3 “System data AC500-XC” on page 169.”

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process voltage</td>
<td></td>
</tr>
<tr>
<td>Connections</td>
<td>Terminals 1.8, 2.8, 3.8 and 4.8 for +24 V (UP) as well as 1.9, 2.9, 3.9 and 4.9 for 0 V (ZP)</td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5 %</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse on UP</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per module</td>
</tr>
<tr>
<td>Current consumption</td>
<td></td>
</tr>
</tbody>
</table>
### Parameter
**From 24 V DC power supply at the terminals UP/L+ and ZP/M of the CPU/communication interface module**  
Ca. 2 mA

**From UP at normal operation**  
0.15 A + output loads

**Inrush current from UP (at power up)**  
0.020 A²s

**Max. length of analog cables, conductor cross section > 0.14 mm²**  
100 m

**Weight**  
300 g

**Mounting position**  
Horizontal or vertical with derating (output load reduced to 50% at 40 °C per group)

**Cooling**  
The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.

---

**NOTICE!**

All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

---

### Technical data of the analog inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Connections of the channels I0- ... I7-</td>
<td>Terminals 1.0 ... 1.7</td>
</tr>
<tr>
<td>Connections of the channels I0+ ... I7+</td>
<td>Terminals 2.0 ... 2.3</td>
</tr>
<tr>
<td>Input type</td>
<td>Bipolar (not with current or Pt100/Pt1000/Ni1000)</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Against internal supply and other modules</td>
</tr>
<tr>
<td>Configurability</td>
<td>0 V ... 10 V, -10 V, +10 V, 0 mA ... 20 mA, 4 mA ... 20 mA, Pt100/1000, Ni1000 (each input can be configured individually)</td>
</tr>
</tbody>
</table>
| Channel input resistance               | Voltage: > 100 kΩ  
Current: ca. 330 Ω                                               |
| Time constant of the input filter      | Voltage: 100 μs  
Current: 100 μs                                                   |
| Indication of the input signals        | One LED per channel                                               |
| Conversion cycle                       | 2 ms (for 8 inputs + 8 outputs), with Pt/Ni... 1 s                 |
| Resolution                             | Range 0 V ... 10 V: 12 bits  
Range -10 V ... +10 V: 12 bits including sign  
Range 0 mA ... 20 mA: 12 bits  
Range 4 mA ... 20 mA: 12 bits |
| Conversion error of the analog values  | Typ. ± 0.5 % of full scale  
at 25 °C                                                                 |
caused by non-linearity, adjustment error at factory and resolution within the normal range
### Technical data of the analog inputs, if used as digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>Max. 8</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Connections of the channels I0+ ... I7+</td>
<td>Terminals 2.0 ... 2.7</td>
</tr>
<tr>
<td>Reference potential for the inputs</td>
<td>Terminals 1.9, 2.9, 3.9 and 4.9 (ZP)</td>
</tr>
<tr>
<td>Input signal delay</td>
<td>Typ. 8 ms, configurable from 0.1 ms ... 32 ms</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 LED per channel</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-30 V ... +5 V</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>+5 V ... +13 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>+13 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 7 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>Typ. 1.4 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>Typ. 4.3 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 9 mA</td>
</tr>
<tr>
<td>Input resistance</td>
<td>Ca. 3.5 kΩ</td>
</tr>
</tbody>
</table>

### Technical data of the analog outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8, all channels for voltage, the first 4 channels also for current</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Channels O0- ... O7-</td>
<td>Terminals 3.0 ... 3.7</td>
</tr>
<tr>
<td>Channels O0+ ... O7+</td>
<td>Terminals 4.0 ... 4.7</td>
</tr>
<tr>
<td>Output type</td>
<td>Bipolar with voltage, unipolar with current</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Against internal supply and other modules</td>
</tr>
<tr>
<td>Configurability</td>
<td>-10 V ... +10 V, 0 mA ... 20 mA, 4 mA ... 20 mA (each output can be configured individually), current outputs only channels 0 ... 3</td>
</tr>
<tr>
<td>Output resistance (load), as current output</td>
<td>0 Ω ... 500 Ω</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Output loadability, as voltage output</td>
<td>Max. ± 10 mA</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>One LED per channel</td>
</tr>
<tr>
<td>Resolution</td>
<td>12 bits including sign</td>
</tr>
<tr>
<td>Settling time for full range change (resistive load, output signal within specified tolerance)</td>
<td>Typ. 5 ms</td>
</tr>
<tr>
<td>Conversion error of the analog values caused by non-linearity, adjustment error at factory and resolution within the normal range</td>
<td>Typ. ± 0.5 % of full scale at 25 °C</td>
</tr>
<tr>
<td></td>
<td>Max. ± 1 % of full scale (all ranges) at 0 °C ... 60 °C or EMC disturbance</td>
</tr>
<tr>
<td>Relationship between output signal and hex code</td>
<td></td>
</tr>
<tr>
<td>Unused outputs</td>
<td>Can be left open-circuited</td>
</tr>
</tbody>
</table>

**Dimensions**

The dimensions are in mm and in brackets in inch.

1  Din rail 15 mm
2  Din rail 7.5 mm
Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 250 000 R0001</td>
<td>AX522, analog input/output module, 8 AI, 8 AO, U/I/Pt100, 12 bits including sign, 2-wires</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 450 000 R0001</td>
<td>AX522-XC, analog input/output module, 8 AI, 8 AO, U/I/Pt100, 12 bits including sign, 2-wires, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

5.2.4.5 Digital/Analog I/O modules
5.2.4.5.1 S500 and S500-XC
DA501 - Digital/Analog input/output module

Features

- 16 digital inputs 24 V DC
- 8 configurable digital inputs/outputs 24 V DC, 0.5 A max.
- 4 analog inputs, voltage, current and RTD.
  Resolution 12 bits including sign
- 2 analog outputs, voltage and current
  Resolution 12 bits including sign
- Fast counter

- Module-wise galvanically isolated
- XC version for use in extreme ambient conditions available
Intended purpose

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g., CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.

Functionality

- 16 digital inputs 24 V DC
- 8 configurable digital inputs/outputs 24 V DC, 0.5 A max.
- 4 analog inputs, voltage, current and RTD. 
  Resolution 12 bits including sign
- 2 analog outputs, voltage and current 
  Resolution 12 bits including sign
- Fast counter

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast Counter</td>
<td>Integrated, many configurable operating modes</td>
</tr>
<tr>
<td>Power supply</td>
<td>From the process supply voltage UP</td>
</tr>
<tr>
<td>LED displays</td>
<td>For system displays, signal states, errors and power supply</td>
</tr>
<tr>
<td>Internal supply voltage</td>
<td>Via the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>External supply voltage</td>
<td>Via terminals UP and ZP (process supply voltage 24 V DC)</td>
</tr>
<tr>
<td>Effect of incorrect input terminal connection</td>
<td>Wrong or no signal detected, no damage up to 35 V</td>
</tr>
<tr>
<td>Required terminal unit</td>
<td>TU515 or TU516 © Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938</td>
</tr>
</tbody>
</table>

Connections

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The connection is carried out by using the 40 terminals of the terminal unit TU515/TU516 © Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938.

The assignment of the terminals:

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>DI0</td>
<td>Signal of the digital input DI0</td>
</tr>
<tr>
<td>1.1</td>
<td>DI1</td>
<td>Signal of the digital input DI1</td>
</tr>
<tr>
<td>1.2</td>
<td>DI2</td>
<td>Signal of the digital input DI2</td>
</tr>
<tr>
<td>1.3</td>
<td>DI3</td>
<td>Signal of the digital input DI3</td>
</tr>
<tr>
<td>1.4</td>
<td>DI4</td>
<td>Signal of the digital input DI4</td>
</tr>
<tr>
<td>1.5</td>
<td>DI5</td>
<td>Signal of the digital input DI5</td>
</tr>
<tr>
<td>1.6</td>
<td>DI6</td>
<td>Signal of the digital input DI6</td>
</tr>
<tr>
<td>1.7</td>
<td>DI7</td>
<td>Signal of the digital input DI7</td>
</tr>
<tr>
<td>1.8</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>1.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
<tr>
<td>2.0</td>
<td>DI8</td>
<td>Signal of the digital input DI8</td>
</tr>
<tr>
<td>2.1</td>
<td>DI9</td>
<td>Signal of the digital input DI9</td>
</tr>
<tr>
<td>2.2</td>
<td>DI10</td>
<td>Signal of the digital input DI10</td>
</tr>
<tr>
<td>Terminal</td>
<td>Signal</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>2.3</td>
<td>DI11</td>
<td>Signal of the digital input DI11</td>
</tr>
<tr>
<td>2.4</td>
<td>DI12</td>
<td>Signal of the digital input DI12</td>
</tr>
<tr>
<td>2.5</td>
<td>DI13</td>
<td>Signal of the digital input DI13</td>
</tr>
<tr>
<td>2.6</td>
<td>DI14</td>
<td>Signal of the digital input DI14</td>
</tr>
<tr>
<td>2.7</td>
<td>DI15</td>
<td>Signal of the digital input DI15</td>
</tr>
<tr>
<td>2.8</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>2.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
<tr>
<td>3.0</td>
<td>AI0+</td>
<td>Positive pole of analog input signal 0</td>
</tr>
<tr>
<td>3.1</td>
<td>AI1+</td>
<td>Positive pole of analog input signal 1</td>
</tr>
<tr>
<td>3.2</td>
<td>AI2+</td>
<td>Positive pole of analog input signal 2</td>
</tr>
<tr>
<td>3.3</td>
<td>AI3+</td>
<td>Positive pole of analog input signal 3</td>
</tr>
<tr>
<td>3.4</td>
<td>AI-</td>
<td>Negative pole of analog input signals 0 to 3</td>
</tr>
<tr>
<td>3.5</td>
<td>AO0+</td>
<td>Positive pole of analog output signal 0</td>
</tr>
<tr>
<td>3.6</td>
<td>AO1+</td>
<td>Positive pole of analog output signal 1</td>
</tr>
<tr>
<td>3.7</td>
<td>AO-</td>
<td>Negative pole of analog output signals 0 and 1</td>
</tr>
<tr>
<td>3.8</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>3.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
<tr>
<td>4.0</td>
<td>C16</td>
<td>Signal of the configurable digital input/output C16</td>
</tr>
<tr>
<td>4.1</td>
<td>C17</td>
<td>Signal of the configurable digital input/output C17</td>
</tr>
<tr>
<td>4.2</td>
<td>C18</td>
<td>Signal of the configurable digital input/output C18</td>
</tr>
<tr>
<td>4.3</td>
<td>C19</td>
<td>Signal of the configurable digital input/output C19</td>
</tr>
<tr>
<td>4.4</td>
<td>C20</td>
<td>Signal of the configurable digital input/output C20</td>
</tr>
<tr>
<td>4.5</td>
<td>C21</td>
<td>Signal of the configurable digital input/output C21</td>
</tr>
<tr>
<td>4.6</td>
<td>C22</td>
<td>Signal of the configurable digital input/output C22</td>
</tr>
<tr>
<td>4.7</td>
<td>C23</td>
<td>Signal of the configurable digital input/output C23</td>
</tr>
<tr>
<td>4.8</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>4.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
</tbody>
</table>

The internal power supply voltage for the module's circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 2 mA per DA501.

The external power supply connection is carried out via the UP (+24 V DC) and the ZP (0 V DC) terminals.
WARNING!
Removal/Insertion under power
Removal or insertion under power is permissible only if all conditions for hot swapping are fulfilled.

Chapter 4.9.3 “Replace an I/O module with hot swap” on page 153

The devices are not designed for removal or insertion under power when the conditions for hot swap do not apply. Because of unforeseeable consequences, it is not allowed to plug in or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you
- connect or disconnect any signal or terminal block
- remove, mount or replace a module.

Disconnecting any powered devices while they are energized in a hazardous location could result in an electric arc, which could create an ignition source resulting in fire or explosion.

Prior to proceeding, make sure that power is been disconnected and that the area has been thoroughly checked to ensure that flammable materials are not present.

The devices must not be opened when in operation. The same applies to the network interfaces.

NOTICE!
Risk of damaging the PLC modules!
Overvoltages and short circuits might damage the PLC modules.
- Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
- Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

NOTICE!
Risk of damaging the PLC modules!
The PLC modules must not be removed while the plant is connected to a power supply.
Make sure that all voltage sources (supply and process voltage) are switched off before you
- connect or disconnect any signal or terminal block
- remove or replace a module.

CAUTION!
Risk of imprecise and faulty measurements!
Analog signals may be distorted seriously by external electromagnetic influences.
Use shielded wires when wiring analog signal sources. The cable shield must be grounded at both ends of the cable. Provide a potential equalization of a low resistance to avoid high potential differences between different parts of the plant.
Connection of the digital inputs

The following figure shows the connection of the digital input DI0. Proceed with the digital inputs DI1 ... DI15 in the same way.

Fig. 139: Connection of the module

The meaning of the LEDs is described in the Displays chapter Chapter 5.2.4.5.1.9 “State LEDs” on page 863.
Connection of the configurable digital inputs/outputs

![Diagram showing connection of configurable digital inputs/outputs](image)

**Fig. 140: Connection of configurable digital inputs/outputs to the module (DC16 ... DC23) (DC16 as an input, DC17 as an output)**

**CAUTION!**

Risk of influences to the connected sensors!
Some sensors may be influenced by the deactivated module outputs of DA501. If the inputs are used as fast counter inputs, connect a 470 Ω / 1 W resistor in series to inputs DC16/DC17.

Connection of resistance thermometers in 2-wire configuration to the analog inputs

When resistance thermometers (Pt100, Pt1000, Ni1000) are used, a constant current must flow through them to build the necessary voltage drop for the evaluation. For this, the module DA501 provides a constant current source which is multiplexed over the max. 4 analog input channels.
The following measuring ranges can be configured on page 856:

<table>
<thead>
<tr>
<th>Thermometer</th>
<th>Temperature Range</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pt100</td>
<td>-50 °C ... +400 °C</td>
<td>2-wire, 1 channel used</td>
</tr>
<tr>
<td>Pt1000</td>
<td>-50 °C ... +400 °C</td>
<td>2-wire, 1 channel used</td>
</tr>
<tr>
<td>Ni1000</td>
<td>-50 °C ... +150 °C</td>
<td>2-wire, 1 channel used</td>
</tr>
</tbody>
</table>

The function of the LEDs is described under Diagnosis and displays / Displays on page 863.

The module DA501 performs a linearization of the resistance characteristic.

To avoid error messages from unused analog input channels, configure them as "unused".

**Connection of resistance thermometers in 3-wire configuration to the analog inputs**

When resistance thermometers (Pt100, Pt1000, Ni1000) are used, a constant current must flow through them to build the necessary voltage drop for the evaluation. For this, the module DA501 provides a constant current source which is multiplexed over the max. 4 analog input channels.
With 3-wire configuration, 2 adjacent analog channels belong together (e.g. the channels 0 and 1). In this case, both channels are configured according to the desired operating mode. The lower address must be the even address (channel 0), the next higher address must be the odd address (channel 1).

The constant current of one channel flows through the resistance thermometer. The constant current of the other channel flows through one of the cores. The module calculates the measured value from the two voltage drops and stores it under the input with the higher channel number (e.g. I1).

In order to keep measuring errors as small as possible, it is necessary to have all the involved conductors in the same cable. All the conductors must have the same cross section.

The following measuring ranges can be configured: Chapter 5.2.4.5.1.1.7 “Parameterization” on page 856:

<table>
<thead>
<tr>
<th>Thermometer</th>
<th>Temperature Range</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pt100</td>
<td>-50 °C ... +400 °C</td>
<td>3-wire config.</td>
</tr>
<tr>
<td>Pt1000</td>
<td>-50 °C ... +400 °C</td>
<td>3-wire config.</td>
</tr>
<tr>
<td>Ni1000</td>
<td>-50 °C ... +150 °C</td>
<td>3-wire config.</td>
</tr>
</tbody>
</table>

The function of the LEDs is described under Diagnosis and displays / Displays: Chapter 5.2.4.5.1.1.8 “Diagnosis” on page 861.

The module DA501 performs a linearization of the resistance characteristic.

To avoid error messages from unused analog input channels, configure them as "unused".

![Connection diagram of resistance thermometers in 3-wire configuration to the analog inputs (AI0 ... AI3)](image-url)
Connection of active-type analog sensors (Voltage) with galvanically isolated power supply to the analog inputs

Fig. 143: Connection of active-type analog sensors (voltage) with galvanically isolated power supply to the analog inputs (AI0 ... AI3)

The following measuring ranges can be configured "Parameterization" on page 856:

<table>
<thead>
<tr>
<th>Voltage</th>
<th>0 V ... 10 V</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

The function of the LEDs is described under Diagnosis and displays / Displays "State LEDs" on page 863.

To avoid error messages from unused analog input channels, configure them as "unused".
Connection of active-type analog sensors (Current) with galvanically isolated power supply to the analog inputs

Fig. 144: Connection of active-type analog sensors (current) with galvanically isolated power supply to the analog inputs (AI0 ... AI3)

The following measuring ranges can be configured

<table>
<thead>
<tr>
<th>Current</th>
<th>0 mA ... 20 mA</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>4 mA ... 20 mA</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

The function of the LEDs is described under Diagnosis and displays / Displays

Unused input channels can be left open-circuited, because they are of low resistance.
Connection of active-type analog sensors (Voltage) with no galvanically isolated power supply to the analog inputs

![Connection Diagram](image)

**Fig. 145:** Connection of active-type sensors (voltage) with no galvanically isolated power supply to the analog inputs (AI0 ... AI3)

**CAUTION!**

Risk of faulty measurements!

The negative pole at the sensors must not have too big a potential difference with respect to ZP (max. ± 1 V within the full signal range).

Make sure that the potential difference never exceeds ± 1 V.

The following measuring ranges can be configured [Chapter 5.2.4.5.1.1.7 “Parameterization” on page 856]:

<table>
<thead>
<tr>
<th>Voltage</th>
<th>0 V ... 10 V</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

For a description of the function of the LEDs, please refer to the Diagnosis and displays / Displays chapter [Chapter 5.2.4.5.1.1.9 “State LEDs” on page 863].

To avoid error messages from unused analog input channels, configure them as "unused".
Connection of passive-type analog sensors (Current) to the analog inputs

The following measuring ranges can be configured: Chapter 5.2.4.5.1.7 “Parameterization” on page 856:

<table>
<thead>
<tr>
<th>Current</th>
<th>4 mA ... 20 mA</th>
<th>1 channel used</th>
</tr>
</thead>
</table>

For a description of function of the LEDs, please refer to the Diagnosis and displays / Displays chapter: Chapter 5.2.4.5.1.9 “State LEDs” on page 863.

**CAUTION!**

**Risk of overloading the analog input!**

If an analog current sensor supplies more than 25 mA for more than 1 second during initialization, this input is switched off by the module (input protection).

Only use sensors with fast initialization or without current peaks higher than 25 mA. If not possible, connect a 10-volt Zener diode in parallel to I+ and ZP.

Unused input channels can be left open-circuited, because they are of low resistance.

Connection of active-type analog sensors (Voltage) to differential analog inputs

Differential inputs are very useful if analog sensors which are remotely non-isolated (e.g. the negative terminal is remotely grounded) are used.

Using differential inputs helps to considerably increase the measuring accuracy and to avoid ground loops.

With differential input configurations, two adjacent analog channels belong together (e.g. the channels 0 and 1). In this case, both channels are configured according to the desired operating mode. The lower address must be the even address (channel 0), the next higher address must be the odd address (channel 1). The converted analog value is available at the higher address (channel 1).

The analog value is calculated by subtraction of the input value with the higher address from the input value of the lower address.
The converted analog value is available at the odd channel (higher address).

**CAUTION!**
Risk of faulty measurements!
The negative pole at the sensors must not have too large a potential difference with respect to ZP (max. ± 1 V within the full signal range).
Make sure that the potential difference never exceeds ± 1 V.

The following figure shows the connection of active-type analog sensors (voltage) to differential analog inputs AI0 and AI1. Proceed with AI2 and AI3 in the same way.

![Connection diagram](image)

**Fig. 147: Connection of active-type analog sensors (voltage) to differential analog inputs (AI0 ... AI3)**

The following measuring ranges can be configured [Chapter 5.2.4.5.1.1.7 "Parameterization" on page 856]:

<table>
<thead>
<tr>
<th>Voltage</th>
<th>0 V ... 10 V</th>
<th>with differential inputs, 2 channels used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V</td>
<td>with differential inputs, 2 channels used</td>
</tr>
</tbody>
</table>

For a description of the function of the LEDs, please refer to the Diagnosis and displays / Displays chapter [Chapter 5.2.4.5.1.1.9 “State LEDs” on page 863].

To avoid error messages from unused analog input channels, configure them as "unused".

**Use of analog inputs as digital inputs**

Several (or all) analog inputs can be configured as digital inputs. The inputs are not galvanically isolated against the other analog channels.
The following measuring ranges can be configured in Chapter 5.2.4.5.1.1.7 "Parameterization" on page 856:

<table>
<thead>
<tr>
<th>Digital input</th>
<th>24 V DC</th>
<th>1 channel used</th>
</tr>
</thead>
</table>

For a description of the function of the LEDs, please refer to the Diagnosis and displays / Displays chapter in Chapter 5.2.4.5.1.1.9 "State LEDs" on page 863.

**Connection of analog output loads (Voltage)**

Fig. 149: Connection of analog output loads (voltage) to the analog outputs (AO0 and AO1)
The following measuring ranges can be configured in Chapter 5.2.4.5.1.1.7 “Parameterization” on page 856:

<table>
<thead>
<tr>
<th>Voltage</th>
<th>-10 V ... +10 V</th>
<th>Load ± 10 mA max.</th>
<th>1 channel used</th>
</tr>
</thead>
</table>

For a description of the function of the LEDs, please refer to the Diagnosis and displays / Displays chapter in Chapter 5.2.4.5.1.1.9 “State LEDs” on page 863.

Unused analog outputs can be left open-circuited.

Connection of analog output loads (Current)

![Connection diagram](image)

*Fig. 150: Connection of analog output loads (current) to the analog outputs (AO0 and AO1)*

The following measuring ranges can be configured in Chapter 5.2.4.5.1.1.7 “Parameterization” on page 856:

<table>
<thead>
<tr>
<th>Current</th>
<th>0 mA ... 20 mA</th>
<th>Load 0 Ω ... 500 Ω</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>4 mA ... 20 mA</td>
<td>Load 0 Ω ... 500 Ω</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

For a description of the function of the LEDs, please refer to the Diagnosis and displays / Displays chapter in Chapter 5.2.4.5.1.1.9 “State LEDs” on page 863.

Unused analog outputs can be left open-circuited.

Internal data exchange

<table>
<thead>
<tr>
<th></th>
<th>Without the fast counter</th>
<th>With the fast counter (only with AC500)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital inputs (bytes)</td>
<td>3</td>
<td>5</td>
</tr>
<tr>
<td>Digital outputs (bytes)</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td>Analog inputs (words)</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Without the fast counter</td>
<td>With the fast counter (only with AC500)</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>--------------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>Digital outputs (words)</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Counter input data (words)</td>
<td>0</td>
<td>4</td>
</tr>
<tr>
<td>Counter output data (words)</td>
<td>0</td>
<td>8</td>
</tr>
</tbody>
</table>

**I/O configuration**

The module does not store configuration data itself. It gets its parameterization data from the master device of the I/O bus (CPU or communication interface module) during power-up of the system.

Hence, replacing I/O modules is possible without any re-parameterization via software.

**Parameterization**

<table>
<thead>
<tr>
<th>Firmware version</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firmware version &gt; V2.0.0</td>
<td>The arrangement of the parameter data is performed by Control Builder Plus/ Automation Builder software.</td>
</tr>
</tbody>
</table>

The parameter data directly influences the functionality of modules.

For non-standard applications, it is necessary to adapt the parameters to your system configuration.

Module: Module slot address: Y = 1 ... 10

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
<th>EDS Slot / Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID (^1)</td>
<td>Internal</td>
<td>1810</td>
<td>WORD</td>
<td>1810</td>
<td>0x0Y01</td>
</tr>
<tr>
<td>Ignore module see table (^2)</td>
<td>Internal</td>
<td>Yes, No</td>
<td>BYTE</td>
<td>No</td>
<td>not for FBP</td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal</td>
<td>8</td>
<td>BYTE</td>
<td>8</td>
<td>0x0Y02</td>
</tr>
<tr>
<td>Check supply</td>
<td>off</td>
<td>0</td>
<td>BYTE</td>
<td>1</td>
<td>0x0Y03</td>
</tr>
<tr>
<td></td>
<td>on</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Fast Counter

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
<th>EDS Slot / Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast counter</td>
<td>0</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
<td>not for FBP</td>
</tr>
<tr>
<td>3)</td>
<td>10</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Behavior Outputs at Comm. Error

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Error LED lights up at errors of all error classes, Failsafe mode off</td>
</tr>
<tr>
<td>Off by E4</td>
<td>Error LED lights up at errors of error classes E1, E2 and E3, Failsafe mode off</td>
</tr>
<tr>
<td>Off by E3</td>
<td>Error LED lights up at errors of error classes E1 and E2, Failsafe mode off</td>
</tr>
<tr>
<td>On + Failsafe</td>
<td>Error LED lights up at errors of all error classes, Failsafe mode on *)</td>
</tr>
<tr>
<td>Off by E4 + Failsafe</td>
<td>Error LED lights up at errors of error classes E1, E2 and E3, Failsafe mode on *)</td>
</tr>
<tr>
<td>Off by E3 + Failsafe</td>
<td>Error LED lights up at errors of error classes E1 and E2, Failsafe mode on *)</td>
</tr>
</tbody>
</table>

Remarks:

1) With a faulty ID, the Modules reports a “parameter error” and does not perform cyclic process data transmission

2) Not for FBP

3) With FBP or CS31 without the parameter “Fast Counter”

---

*The fast counter of the module does not work if the module is connected to an FBP interface module or CS31 bus module.*

4) For counter operating modes, please refer to the description of the fast counter % Chapter 5.2.4.3.2.9 “Fast counter” on page 606

5) The parameter Behavior outputs at comm. error is only analyzed if the Failsafe-mode is ON.
**Group parameters for the digital part**

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
<th>EDS Slot / Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input delay</td>
<td>0.1 ms</td>
<td>0</td>
<td>BYTE</td>
<td>0.1 ms 0x00</td>
<td>0x0Y05</td>
</tr>
<tr>
<td></td>
<td>1 ms</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 ms</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>32 ms</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Detect short</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>On 0x01</td>
<td>0x0Y06</td>
</tr>
<tr>
<td>circuit at outputs</td>
<td>On</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Substitute value at output</td>
<td>0 ... 255</td>
<td>00h ... FFh</td>
<td>BYTE</td>
<td>0 0x0000</td>
<td>0x0Y08</td>
</tr>
</tbody>
</table>

*) The parameters Behavior DO at comm. error is only analyzed if the Failsafe mode is ON.

**Group parameters for the analog part**

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
<th>EDS Slot / Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog data format</td>
<td>Standard</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
<td>0x0Y04</td>
</tr>
<tr>
<td></td>
<td>Reserved</td>
<td>255</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*) The parameter Behavior AO at comm. error is only analyzed if the Failsafe mode is ON.

**Channel parameters for the analog inputs (4x)**

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
<th>EDS Slot / Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input 0, Channel configuration</td>
<td>see table 'Channel configuration' &amp; Table 196 “Channel configuration” on page 859</td>
<td>see table 'Channel configuration' &amp; Table 196 “Channel configuration” on page 859</td>
<td>BYTE</td>
<td>0</td>
<td>0x0Y09</td>
</tr>
<tr>
<td>Input 0, Check channel</td>
<td>see table 'Channel monitoring' &amp; Table 197 “Channel monitoring” on page 859</td>
<td>see table 'Channel monitoring' &amp; Table 197 “Channel monitoring” on page 859</td>
<td>BYTE</td>
<td>0</td>
<td>0x0Y0A</td>
</tr>
<tr>
<td>Name, Value</td>
<td>Internal value</td>
<td>Internal value, type</td>
<td>Default</td>
<td>EDS Slot / Index</td>
<td></td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------</td>
<td>---------------------</td>
<td>---------</td>
<td>------------------</td>
<td></td>
</tr>
<tr>
<td>Input 3, Channel configuration</td>
<td>see table 'Channel configuration' § Table 196 “Channel configuration” on page 859</td>
<td>see table 'Channel configuration' § Table 196 “Channel configuration” on page 859</td>
<td>BYTE</td>
<td>0</td>
<td>0x0Y0F</td>
</tr>
<tr>
<td>Input 3, Check channel</td>
<td>see table 'Channel monitoring' § Table 197 “Channel monitoring” on page 859</td>
<td>see table 'Channel monitoring' § Table 197 “Channel monitoring” on page 859</td>
<td>BYTE</td>
<td>0</td>
<td>0x0Y10</td>
</tr>
</tbody>
</table>

Table 196: Channel configuration

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes of the analog inputs, individually configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (default)</td>
<td>Not used</td>
</tr>
<tr>
<td>1</td>
<td>0 V ... 10 V</td>
</tr>
<tr>
<td>2</td>
<td>Digital input</td>
</tr>
<tr>
<td>3</td>
<td>0 mA ... 20 mA</td>
</tr>
<tr>
<td>4</td>
<td>4 mA ... 20 mA</td>
</tr>
<tr>
<td>5</td>
<td>-10 V ... +10 V</td>
</tr>
<tr>
<td>8</td>
<td>2-wire Pt100 -50 °C ... +400 °C</td>
</tr>
<tr>
<td>9</td>
<td>3-wire Pt100 -50 °C ... +400 °C *)</td>
</tr>
<tr>
<td>10</td>
<td>0 V ... 10 V (voltage diff.) *)</td>
</tr>
<tr>
<td>11</td>
<td>-10 V ... +10 V (voltage diff.) *)</td>
</tr>
<tr>
<td>14</td>
<td>2-wire Pt100 -50 °C ... +70 °C</td>
</tr>
<tr>
<td>15</td>
<td>3-wire Pt100 -50 °C ... +70 °C *)</td>
</tr>
<tr>
<td>16</td>
<td>2-wire Pt1000 -50 °C ... +400 °C</td>
</tr>
<tr>
<td>17</td>
<td>3-wire Pt1000 -50 °C ... +400 °C *)</td>
</tr>
<tr>
<td>18</td>
<td>2-wire Ni1000 -50 °C ... +150 °C</td>
</tr>
<tr>
<td>19</td>
<td>3-wire Ni1000 -50 °C ... +150 °C *)</td>
</tr>
</tbody>
</table>

*) In the operating modes with 3-wire configuration or with differential inputs, two adjacent analog inputs belong together (e.g. the channels 0 and 1). In these cases, both channels are configured in the desired operating mode. The lower address must be the even address (channel 0). The next higher address must be the odd address (channel 1). The converted analog value is available at the higher address (channel 1).

Table 197: Channel monitoring

<table>
<thead>
<tr>
<th>Internal Value</th>
<th>Check Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (default)</td>
<td>Plausibility, wire break, short circuit</td>
</tr>
<tr>
<td>3</td>
<td>Not used</td>
</tr>
</tbody>
</table>
Channel parameters for the analog outputs (2x)

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
<th>EDS Slot / Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 Output 0, Channel configuration</td>
<td>see table 'Channel configuration' § Table 198 “Channel configuration” on page 860</td>
<td>see table 'Channel configuration' § Table 198 “Channel configuration” on page 860</td>
<td>BYTE 0</td>
<td>0x0Y11</td>
<td></td>
</tr>
<tr>
<td>Output 0, Check channel</td>
<td>see table 'Channel monitoring' § Table 199 “Channel monitoring” on page 861</td>
<td>see table 'Channel monitoring' § Table 199 “Channel monitoring” on page 861</td>
<td>BYTE 0</td>
<td>0x0Y12</td>
<td></td>
</tr>
<tr>
<td>Output 0, Substitute value</td>
<td>see table 'Substitute value' § Table 200 “Substitute value” on page 861</td>
<td>see table 'Substitute value' § Table 200 “Substitute value” on page 861</td>
<td>WORD 0</td>
<td>0x0Y13</td>
<td></td>
</tr>
<tr>
<td>Output 1, Channel configuration</td>
<td>see table 'Channel configuration' § Table 198 “Channel configuration” on page 860</td>
<td>see table 'Channel configuration' § Table 198 “Channel configuration” on page 860</td>
<td>BYTE 0</td>
<td>0x0Y14</td>
<td></td>
</tr>
<tr>
<td>Output 1, Check channel</td>
<td>see table 'Channel monitoring' § Table 199 “Channel monitoring” on page 861</td>
<td>see table 'Channel monitoring' § Table 199 “Channel monitoring” on page 861</td>
<td>BYTE 0</td>
<td>0x0Y15</td>
<td></td>
</tr>
<tr>
<td>Output 1, Substitute value</td>
<td>see table 'Substitute value' § Table 200 “Substitute value” on page 861</td>
<td>see table 'Substitute value' § Table 200 “Substitute value” on page 861</td>
<td>WORD 0</td>
<td>0x0Y16</td>
<td></td>
</tr>
</tbody>
</table>

Table 198: Channel configuration

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes of the analog outputs, individually configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (default)</td>
<td>Not used</td>
</tr>
<tr>
<td>128</td>
<td>-10 V ... +10 V</td>
</tr>
<tr>
<td>129</td>
<td>0 mA ... 20 mA</td>
</tr>
<tr>
<td>130</td>
<td>4 mA ... 20 mA</td>
</tr>
</tbody>
</table>
Table 199: Channel monitoring

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Check channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Plausibility, wire break, short circuit</td>
</tr>
<tr>
<td>3</td>
<td>None</td>
</tr>
</tbody>
</table>

Table 200: Substitute value

<table>
<thead>
<tr>
<th>Intended behavior of output channel when the control system stops</th>
<th>Required setting of the module parameter &quot;Behavior of outputs in case of a communication error&quot;</th>
<th>Required setting of the channel parameter &quot;Substitute value&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output OFF</td>
<td>Off</td>
<td>0</td>
</tr>
<tr>
<td>Last value infinite</td>
<td>Last value</td>
<td>0</td>
</tr>
<tr>
<td>Last value for 5 s and then turn off</td>
<td>Last value 5 sec</td>
<td>0</td>
</tr>
<tr>
<td>Last value for 10 s and then turn off</td>
<td>Last value 10 sec</td>
<td>0</td>
</tr>
<tr>
<td>Substitute value infinite</td>
<td>Substitute value</td>
<td>Depending on configuration</td>
</tr>
<tr>
<td>Substitute value for 5 s and then turn off</td>
<td>Substitute value 5 sec</td>
<td>Depending on configuration</td>
</tr>
<tr>
<td>Substitute value for 10 s and then turn off</td>
<td>Substitute value 10 sec</td>
<td>Depending on configuration</td>
</tr>
</tbody>
</table>

Diagnosis

In cases of short circuit or overload, the digital outputs are turned off. The module performs reactivation automatically. Thus an acknowledgement of the errors is not necessary. The error message is stored via the LED.

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier 000 ... 0063</th>
<th>AC500 display</th>
<th>&lt;-- Display in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Comp</td>
<td>Dev</td>
<td>Mod</td>
<td>Ch</td>
<td>Err</td>
<td>PS501 browser</td>
<td></td>
</tr>
<tr>
<td>Byte 6</td>
<td>-</td>
<td>Byte 3</td>
<td>Byte 4</td>
<td>Byte 5</td>
<td>Byte 6 Bit 0 ... 5</td>
<td>FBP diagnosis block</td>
<td></td>
</tr>
<tr>
<td>Bit 6 ... 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>1)</td>
<td>2)</td>
<td>3)</td>
<td>4)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Module error

<p>| 0 | 3 | 14 | 1 ... 10 | 31 | 31 | 19 | Checksum error in the I/O module | Replace I/O module |
| 3 | 11/12 ADR 1 ... 10 | | |
| 3 | 14 | 1 ... 10 | 31 | 31 | 3 | Timeout in the I/O module | |
| 11/12 ADR 1 ... 10 | | |
| 3 | 14 | 1 ... 10 | 31 | 40 | Different hard-/firmware versions in the module | |</p>
<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>43</td>
<td>Internal error in the module</td>
<td>New start</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>36</td>
<td>Internal data exchange failure</td>
<td>New start</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>9</td>
<td>Overflow diagnosis buffer</td>
<td>New start</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>26</td>
<td>Parameter error</td>
<td>Check master</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>11</td>
<td>Process voltage too low</td>
<td>Check process voltage</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>45</td>
<td>Process voltage is switched off (ON -&gt; OFF)</td>
<td>Process voltage ON</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Channel error DA501**

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>2</td>
<td>22 ... 29</td>
<td>47</td>
<td>Short circuit at a digital output</td>
<td>Check connection</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Channel error DA501**

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>1</td>
<td>16 ... 19</td>
<td>48</td>
<td>Analog value overflow or broken wire at an analog input</td>
<td>Check input value or terminal</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>1</td>
<td>16 ... 19</td>
<td>7</td>
<td>Analog value underflow at an analog input</td>
<td>Check input value</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>1</td>
<td>16 ... 19</td>
<td>47</td>
<td>Short circuit at an analog input</td>
<td>Check terminal</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>3</td>
<td>20 ... 21</td>
<td>4</td>
<td>Analog value overflow at an analog output</td>
<td>Check output value</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>3</td>
<td>20 ... 21</td>
<td>7</td>
<td>Analog value underflow at an analog output</td>
<td>Check output value</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Remarks:
1) In AC500, the following interface identifier applies:
14 = I/O bus, 11 = COM1 (e.g. CS31 bus), 12 = COM2.
The FBP diagnosis block does not contain this identifier.

2) With "Device" the following allocation applies:
31 = module itself,
1 ... 10 = communication interface module 1 ... 10,
ADR = hardware address (e.g. of the DC551)

3) With "Module" the following allocation applies depending on the master:
Module error: I/O bus or FBP: 31 = module itself; COM1/COM2: 1 ... 10 = expansion 1 ... 10
Channel error: I/O bus or FBP = module type (1 = AI, 3 = AO, 4 = DC); COM1/COM2: 1 ... 10 = expansion 1 ... 10

4) In case of module errors, with channel "31 = module itself" is output.

5) Ch = 22 ... 29 indicates the digital inputs/outputs DC16 ... DC23

6) Ch = 16 ... 19 indicates the analog inputs AI0 ... AI3

7) Ch = 20 ... 21 indicates the analog outputs AO0 ... AO1

---

### State LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
<th>LED flashes</th>
</tr>
</thead>
<tbody>
<tr>
<td>DI0 ... DI15</td>
<td>Digital input</td>
<td>Yellow</td>
<td>Input is OFF</td>
<td>Input is ON 1)</td>
<td>--</td>
</tr>
<tr>
<td>DC16 ... DC23</td>
<td>Digital input/output</td>
<td>Yellow</td>
<td>Input/output is OFF</td>
<td>Input/output is ON 1)</td>
<td>--</td>
</tr>
<tr>
<td>AI0 ... AI3</td>
<td>Analog input</td>
<td>Yellow</td>
<td>Input is OFF</td>
<td>Input is ON 2)</td>
<td>--</td>
</tr>
<tr>
<td>AO0 ... AO1</td>
<td>Analog output</td>
<td>Yellow</td>
<td>Output is OFF</td>
<td>Output is ON 2)</td>
<td>--</td>
</tr>
<tr>
<td>UP</td>
<td>Process supply voltage 24 V DC via terminal</td>
<td>Green</td>
<td>Process supply voltage is missing</td>
<td>Process supply voltage OK</td>
<td>--</td>
</tr>
<tr>
<td>CH-ERR1</td>
<td>Channel error, error messages in groups (digital inputs/outputs combined into the groups 1, 2, 3, 4)</td>
<td>Red</td>
<td>No error or process supply voltage is missing</td>
<td>Severe error within the corresponding group</td>
<td>Severe error within the corresponding group (e.g. short circuit at an output)</td>
</tr>
<tr>
<td>CH-ERR2</td>
<td></td>
<td>Red</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CH-ERR3</td>
<td></td>
<td>Red</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CH-ERR4</td>
<td></td>
<td>Red</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1) Indication LED is ON even if an input signal is applied to the channel and the supply voltage is off. In this case the module is not operating and does not generate an input signal.

2) Brightness depends on the value of the analog signal

3) All of the LEDs CH-ERR1 to CH-ERR4 light up together
### Measuring ranges

#### Input ranges voltage, current and digital input

<table>
<thead>
<tr>
<th>Range</th>
<th>0 V ... +10 V</th>
<th>-10 V ... +10 V</th>
<th>0 mA ... 20 mA</th>
<th>4 mA ... 20 mA</th>
<th>Digital input</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Decimal</td>
<td>Hex.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overflow</td>
<td>&gt; 11.7589</td>
<td>&gt; 11.7589</td>
<td>&gt; 23.5178</td>
<td>&gt; 22.8142</td>
<td>32767</td>
<td>7FFF</td>
</tr>
<tr>
<td>Measured value too high</td>
<td>11.7589</td>
<td>11.7589</td>
<td>23.5178</td>
<td>22.8142</td>
<td>32511</td>
<td>7EFF</td>
</tr>
<tr>
<td></td>
<td>10.0004</td>
<td>10.0004</td>
<td>20.0007</td>
<td>20.0006</td>
<td>27649</td>
<td>6C01</td>
</tr>
<tr>
<td>Normal range</td>
<td>10.0000</td>
<td>10.0000</td>
<td>20.0000</td>
<td>20.0000</td>
<td>27648</td>
<td>6C00</td>
</tr>
<tr>
<td>Normal range or measured</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0</td>
<td>4</td>
<td>Off</td>
<td>0</td>
</tr>
<tr>
<td>value too low</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0</td>
<td>4</td>
<td>Off</td>
<td>0</td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt; 1.7593</td>
<td>&lt; -11.7589</td>
<td>&lt; 0.0000</td>
<td>&lt; 1.1858</td>
<td>-32768</td>
<td>8000</td>
</tr>
</tbody>
</table>

The represented resolution corresponds to 16 bits.

### Input ranges resistance temperature detector

<table>
<thead>
<tr>
<th>Range</th>
<th>Pt100 / Pt1000 -50 °C ... +70 °C</th>
<th>Pt100 / Pt1000 -50 °C ... +400 °C</th>
<th>Ni1000 -50 °C ... +150 °C</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Overflow</td>
<td>Measured value too high</td>
<td>Normal range</td>
</tr>
<tr>
<td></td>
<td>&gt; +80.0 °C</td>
<td>+450.0 °C</td>
<td>+400.0 °C</td>
</tr>
<tr>
<td></td>
<td></td>
<td>+160.0 °C</td>
<td>+150.0 °C</td>
</tr>
<tr>
<td>Measured value too high</td>
<td>+80.0 °C</td>
<td>+ 400.1 °C</td>
<td>+ 150.1 °C</td>
</tr>
<tr>
<td></td>
<td>+ 70.1 °C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Normal range</td>
<td></td>
<td>+400.0 °C</td>
<td>+150.0 °C</td>
</tr>
<tr>
<td></td>
<td></td>
<td>+ 0.1 °C</td>
<td>+ 0.1 °C</td>
</tr>
</tbody>
</table>
### Range

<table>
<thead>
<tr>
<th></th>
<th>Pt100 / Pt1000</th>
<th>Pt100 / Pt1000</th>
<th>Ni1000</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>-50 °C ... +70 °C</td>
<td>-50 °C ... +400 °C</td>
<td>-50 °C ... +150 °C</td>
</tr>
<tr>
<td>0.0 °C</td>
<td>0.0 °C</td>
<td>0.0 °C</td>
<td>0.0 °C</td>
</tr>
<tr>
<td>-0.1 °C</td>
<td>-0.1 °C</td>
<td>-0.1 °C</td>
<td>-0.1 °C</td>
</tr>
<tr>
<td>-50.0 °C</td>
<td>-50.0 °C</td>
<td>-50.0 °C</td>
<td>-50.0 °C</td>
</tr>
</tbody>
</table>

**Measured value too low**

<table>
<thead>
<tr>
<th></th>
<th>-50.1 °C</th>
<th>-50.1 °C</th>
<th>-50.1 °C</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>-60.0 °C</td>
<td>-60.0 °C</td>
<td>-60.0 °C</td>
</tr>
</tbody>
</table>

**Underflow**

|         | < -60.0 °C | < -60.0 °C | < -60.0 °C |

### Digital value

<table>
<thead>
<tr>
<th></th>
<th>Decimal</th>
<th>Hex.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Overflow</strong></td>
<td>32767</td>
<td>7FFF</td>
</tr>
<tr>
<td><strong>Measured value too high</strong></td>
<td>4500</td>
<td>1194</td>
</tr>
<tr>
<td></td>
<td>4001</td>
<td>0FA1</td>
</tr>
<tr>
<td></td>
<td>1600</td>
<td>0640</td>
</tr>
<tr>
<td></td>
<td>1501</td>
<td>05DD</td>
</tr>
<tr>
<td></td>
<td>800</td>
<td>0320</td>
</tr>
<tr>
<td></td>
<td>701</td>
<td>02BD</td>
</tr>
<tr>
<td><strong>Normal range</strong></td>
<td>4000</td>
<td>0FA0</td>
</tr>
<tr>
<td></td>
<td>1500</td>
<td>05DC</td>
</tr>
<tr>
<td></td>
<td>700</td>
<td>02BC</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>0001</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>0000</td>
</tr>
<tr>
<td></td>
<td>-1</td>
<td>FFFF</td>
</tr>
<tr>
<td></td>
<td>-500</td>
<td>FE0C</td>
</tr>
<tr>
<td><strong>Measured value too low</strong></td>
<td>-501</td>
<td>FE0B</td>
</tr>
<tr>
<td></td>
<td>-600</td>
<td>FDA8</td>
</tr>
<tr>
<td><strong>Underflow</strong></td>
<td>-32768</td>
<td>8000</td>
</tr>
</tbody>
</table>
## Output ranges voltage and current

<table>
<thead>
<tr>
<th>Range</th>
<th>-10 V ... +10 V</th>
<th>0 mA ... 20 mA</th>
<th>4 mA ... 20 mA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overflow</td>
<td>&gt;11.7589 V</td>
<td>&gt;23.5178 mA</td>
<td>&gt;22.8142 mA</td>
</tr>
<tr>
<td>Value too high</td>
<td>11.7589 V</td>
<td>23.5178 mA</td>
<td>22.8142 mA</td>
</tr>
<tr>
<td></td>
<td>10.0004 V</td>
<td>20.0007 mA</td>
<td>20.0006 mA</td>
</tr>
<tr>
<td>Normal range</td>
<td>10.0000 V</td>
<td>20.0000 mA</td>
<td>20.0000 mA</td>
</tr>
<tr>
<td></td>
<td>0.0004 V</td>
<td>0.0007 mA</td>
<td>4.0006 mA</td>
</tr>
<tr>
<td></td>
<td>0.0000 V</td>
<td>0.0000 mA</td>
<td>4.0000 mA</td>
</tr>
<tr>
<td>Value too low</td>
<td>-10.0004 V</td>
<td>0 mA</td>
<td>0 mA</td>
</tr>
<tr>
<td></td>
<td>-11.7589 V</td>
<td>0 mA</td>
<td>0 mA</td>
</tr>
<tr>
<td>Underflow</td>
<td>0 V</td>
<td>0 mA</td>
<td>0 mA</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Range</th>
<th>Decimal value</th>
<th>Hex.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overflow</td>
<td>&gt; 32511</td>
<td>&gt; 7EFF</td>
</tr>
<tr>
<td>Value too high</td>
<td>32511</td>
<td>7EFF</td>
</tr>
<tr>
<td></td>
<td>27649</td>
<td>6C01</td>
</tr>
<tr>
<td>Normal range</td>
<td>27648</td>
<td>6C00</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>0001</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>0000</td>
</tr>
<tr>
<td></td>
<td>-1</td>
<td>FFFF</td>
</tr>
<tr>
<td></td>
<td>-6912</td>
<td>E500</td>
</tr>
<tr>
<td></td>
<td>-27648</td>
<td>9400</td>
</tr>
<tr>
<td>Value too low</td>
<td>-27649</td>
<td>93FF</td>
</tr>
<tr>
<td></td>
<td>-32512</td>
<td>8100</td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt; -32512</td>
<td>&lt; 8100</td>
</tr>
</tbody>
</table>

The represented resolution corresponds to 16 bits.

### Technical data

#### Technical data of the module

The system data of AC500 and S500 are applicable to the standard version & Chapter 5.1.2 “System data AC500” on page 166.
The system data of AC500-XC are applicable to the XC version. Chapter 5.1.3 "System data AC500-XC" on page 169.

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltage</td>
<td></td>
</tr>
<tr>
<td>Connections</td>
<td>Terminals 1.8, 2.8, 3.8 and 4.8 for UP (+24 V DC) and 1.9, 2.9, 3.9 and 4.9 for ZP (0 V DC)</td>
</tr>
<tr>
<td>Protection against reverse voltage</td>
<td>yes</td>
</tr>
<tr>
<td>Rated protection fuse at UP</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5 %</td>
</tr>
<tr>
<td>Current consumption</td>
<td></td>
</tr>
<tr>
<td>From UP</td>
<td>0.07 A + max. 0.5 A per output</td>
</tr>
<tr>
<td>From 24 V DC power supply at the terminals UP/L+ and ZP/M of the CPU/communication interface module</td>
<td>ca. 2 mA</td>
</tr>
<tr>
<td>Inrush current from UP (at power-up)</td>
<td>0.04 A²s</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per module</td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>6 W (outputs unloaded)</td>
</tr>
<tr>
<td>Weight (without terminal unit)</td>
<td>ca. 125 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal mounting or vertical with derating (output load reduced to 50 % at +40 °C)</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>

NOTICE!

All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

Multiple overloads

No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an internal smart high-side switch.

Technical data of the digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>16</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>2 groups of 8 channels</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Terminals of the channels DI0 ... DI7</td>
<td>Terminals 1.0 ... 1.7</td>
</tr>
<tr>
<td>Terminals of the channels DI8 ... DI15</td>
<td>Terminals 2.0 ... 2.7</td>
</tr>
<tr>
<td>Reference potential for all inputs</td>
<td>Terminals 1.9 ... 3.9 (negative pole of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel, the LED is ON when the input signal is high (signal 1)</td>
</tr>
<tr>
<td>Monitoring point of input indicator</td>
<td>LED is part of the input circuitry</td>
</tr>
<tr>
<td>Input type (according EN 61131-2)</td>
<td>Type 1</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 0.1 ms, configurable from 0.1...32 ms</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>0-Signal</td>
<td>-3 V ... +5 V</td>
</tr>
<tr>
<td>Undefined Signal</td>
<td>&gt; +5 V ... &lt; +15 V</td>
</tr>
<tr>
<td>1-Signal</td>
<td>+15 V ... +30 V</td>
</tr>
<tr>
<td>Ripple with signal 0</td>
<td>Within -3 V ... +5 V</td>
</tr>
<tr>
<td>Ripple with signal 1</td>
<td>Within +15 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 5 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>&gt; 1 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>&gt; 2 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 8 mA</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

**Technical data of the configurable digital inputs/outputs**

Each of the configurable digital I/O channels can be defined as input or output by the user program. This is done by interrogating or allocating the corresponding channel.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8 inputs/outputs (with transistors)</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group for 8 channels</td>
</tr>
<tr>
<td>If the channels are used as inputs</td>
<td></td>
</tr>
<tr>
<td>Channels DC16 ... DC23</td>
<td>Terminals 4.0 ... 4.7</td>
</tr>
<tr>
<td>If the channels are used as outputs</td>
<td></td>
</tr>
<tr>
<td>Channels DC16 ... DC23</td>
<td>Terminals 4.0 ... 4.7</td>
</tr>
<tr>
<td>Indication of the input/output signals</td>
<td>1 yellow LED per channel, the LED is ON when the input/output signal is high (signal 1)</td>
</tr>
<tr>
<td>Monitoring point of input/output indicator</td>
<td>LED is part of the input circuitry</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per module</td>
</tr>
</tbody>
</table>
### Technical data of the digital inputs/outputs if used as inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels DC16 ... DC23</td>
<td>Terminals 4.0 ... 4.7</td>
</tr>
<tr>
<td>Reference potential for all inputs</td>
<td>Terminals 1.9 ... 4.9 (negative pole of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel, the LED is ON when the input signal is high (signal 1)</td>
</tr>
<tr>
<td>Monitoring point of input/output indicator</td>
<td>LED is part of the input circuitry</td>
</tr>
<tr>
<td>Input type (according EN 61131-2)</td>
<td>Type 1</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 0.1 ms, configurable 0.1 ... 32 ms</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>0-Signal</td>
<td>-3 V ... +5 V</td>
</tr>
<tr>
<td>Undefined Signal</td>
<td>&gt; +5 V ... &lt; +15 V</td>
</tr>
<tr>
<td>1-Signal</td>
<td>+15 V ... +30 V</td>
</tr>
<tr>
<td>Ripple with signal 0</td>
<td>Within -3 V ... +5 V</td>
</tr>
<tr>
<td>Ripple with signal 1</td>
<td>Within +15 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 5 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>&gt; 1 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>&gt; 2 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 8 mA</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

* Due to the direct connection to the output, the demagnetizing varistor is also effective at the input (see figure) above. This is why the difference between UPx and the input signal must not exceed the clamp voltage of the varistor. The varistor limits the clamp voltage to approx. 36 V. Consequently, the input voltage must range from -12 V ... +30 V when UPx = 24 V and from -6 V ... +30 V when UPx = 30 V.

### Technical data of the digital inputs/outputs if used as outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels DC16 ... DC23</td>
<td>Terminals 4.0 ... 4.7</td>
</tr>
<tr>
<td>Reference potential for all outputs</td>
<td>Terminals 1.9 ... 4.9 (negative pole of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>For all outputs terminals 1.8, 2.8, 3.8 and 4.8 (positive pole of the supply voltage, signal name UP)</td>
</tr>
<tr>
<td>Output voltage for signal 1</td>
<td>UP (-0.8 V)</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>------------------------------------------------------------</td>
</tr>
<tr>
<td>Output delay (0-&gt;1 or 1-&gt;0)</td>
<td>On request</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>rated value per channel</td>
<td>500 mA at UP = 24 V</td>
</tr>
<tr>
<td>max. value (all channels together)</td>
<td>4 A</td>
</tr>
<tr>
<td>Leakage current with signal 0</td>
<td>&lt; 0.5 mA</td>
</tr>
<tr>
<td>Fuse for UP</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Demagnetization with inductive DC load</td>
<td>Via internal varistors (see figure below this table)</td>
</tr>
<tr>
<td>Output switching frequency</td>
<td></td>
</tr>
<tr>
<td>With resistive load</td>
<td>On request</td>
</tr>
<tr>
<td>With inductive loads</td>
<td>Max. 0.5 Hz</td>
</tr>
<tr>
<td>With lamp loads</td>
<td>11 Hz max. at 5 W max.</td>
</tr>
<tr>
<td>Short-circuit-proof / overload-proof</td>
<td>Yes</td>
</tr>
<tr>
<td>Overload message (I &gt; 0.7 A)</td>
<td>Yes, after ca. 100 ms</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>Yes, automatic reactivation after short circuit/overload</td>
</tr>
<tr>
<td>Resistance to feedback against 24 V signals</td>
<td>Yes (software-controlled supervision)</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

The following drawing shows the circuitry of a digital input/output with the varistors for demagnetization when inductive loads are switched off.

![Circuit Diagram](image)

**Fig. 151: Digital input/output (circuit diagram)**

1. Digital input/output
2. For demagnetization when inductive loads are turned off

**Technical data of the fast counter**

*The fast counter of the module does not work if the module is connected to an FBP interface module or CS31 bus module.*
Technical data of the analog inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>4</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group with 4 channels</td>
</tr>
<tr>
<td>Connection if channels AI0+ ... AI3+</td>
<td>Terminals 3.0 ... 3.3</td>
</tr>
<tr>
<td>Reference potential for AI0+ ... AI3+</td>
<td>Terminal 3.4 (AI-) for voltage and RTD measurement</td>
</tr>
<tr>
<td></td>
<td>Terminal 1.9, 2.9, 3.9 and 4.9 for current measurement</td>
</tr>
<tr>
<td>Input type</td>
<td></td>
</tr>
<tr>
<td>Unipolar Voltage</td>
<td>Voltage 0 V ... 10 V, current or Pt100/Pt1000/Ni1000</td>
</tr>
<tr>
<td>Bipolar Voltage</td>
<td>Voltage -10 V ... +10 V</td>
</tr>
<tr>
<td>Configurability</td>
<td>0 V ... 10 V, -10 V ... +10 V, 0 mA ... 20 mA, 4 mA ... 20 mA, Pt100/1000, Ni1000 (each input can be configured individually)</td>
</tr>
<tr>
<td>Channel input resistance</td>
<td>Voltage: &gt; 100 kΩ</td>
</tr>
<tr>
<td></td>
<td>Current: ca. 330 Ω</td>
</tr>
<tr>
<td>Time constant of the input filter</td>
<td>Voltage: 100 μs</td>
</tr>
<tr>
<td></td>
<td>Current: 100 μs</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 LED per channel (brightness depends on the value of the analog signal)</td>
</tr>
<tr>
<td>Conversion cycle</td>
<td>1 ms (for 4 inputs + 2 outputs); with RTDs Pt/Ni... 1 s</td>
</tr>
<tr>
<td>Resolution</td>
<td>Range 0 V ... 10 V: 12 bits</td>
</tr>
<tr>
<td></td>
<td>Range -10 V ... +10 V: 12 bits including sign</td>
</tr>
<tr>
<td></td>
<td>Range 0 mA ... 20 mA: 12 bits</td>
</tr>
<tr>
<td></td>
<td>Range 4 mA ... 20 mA: 12 bits</td>
</tr>
<tr>
<td></td>
<td>Range RTD (Pt100, PT1000, Ni1000): 0.1 °C</td>
</tr>
<tr>
<td>Conversion error of the analog values caused</td>
<td>Typ. 0.5 %, max. 1 %</td>
</tr>
<tr>
<td>by non-linearity, adjustment error at factory</td>
<td>For XC version below 0 °C and above +60 °C: on request</td>
</tr>
<tr>
<td>and resolution within the normal range</td>
<td></td>
</tr>
<tr>
<td>Relationship between input signal and hex code</td>
<td>% Chapter 5.2.4.5.1.1.10.2 “Input ranges resistance temperature detector” on page 864</td>
</tr>
<tr>
<td>Unused inputs</td>
<td>Are configured as “unused” (default value)</td>
</tr>
<tr>
<td>Overvoltage protection</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Technical data of the analog inputs, if used as digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>Max. 4</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group of 4 channels</td>
</tr>
<tr>
<td>Connections of the channels AI0+ ... AI3+</td>
<td>Terminals 3.0 ... 3.3</td>
</tr>
<tr>
<td>Reference potential for the inputs</td>
<td>Terminals 1.9, 2.9, 3.9 and 4.9 (ZP)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 LED per channel</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-30 V ... +5 V</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>+5 V ... +13 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>+13 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 7 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>Typ. 1.4 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>Typ. 3.7 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 9 mA</td>
</tr>
<tr>
<td>Input resistance</td>
<td>ca. 3.5 kΩ</td>
</tr>
</tbody>
</table>

### Technical data of the analog outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>2</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group for 2 channels</td>
</tr>
<tr>
<td>Connection of the channels AO0+ ... AO1+</td>
<td>Terminals 3.5 and 3.6</td>
</tr>
<tr>
<td>Reference potential for AO0+ ... AO1+</td>
<td>Terminal 3.7 (AO-) for voltage output Terminals 1.9, 2.9, 3.9 and 4.9 for current output</td>
</tr>
<tr>
<td>Output type</td>
<td>Unipolar Current</td>
</tr>
<tr>
<td></td>
<td>Bipolar Voltage</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Against internal supply and other modules</td>
</tr>
<tr>
<td>Configurability</td>
<td>-10 V ... +10 V, 0 mA ... 20 mA, 4 mA ... 20 mA (each output can be configured individually)</td>
</tr>
<tr>
<td>Output resistance (load) as current output</td>
<td>0 Ω ... 500 Ω</td>
</tr>
<tr>
<td>Output loadability as voltage output</td>
<td>± 10 mA max.</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>1 LED per channel (brightness depends on the value of the analog signal)</td>
</tr>
<tr>
<td>Resolution</td>
<td>12 bits including sign</td>
</tr>
<tr>
<td>Settling time for full range change</td>
<td>Typ. 5 ms</td>
</tr>
<tr>
<td>(resistive load, output signal within specified tolerance)</td>
<td></td>
</tr>
<tr>
<td>Conversion error of the analog values caused</td>
<td>Typ. 0.5 %, max. 1 %</td>
</tr>
<tr>
<td>by non-linearity, adjustment error at factory</td>
<td></td>
</tr>
<tr>
<td>and resolution within the normal range</td>
<td></td>
</tr>
</tbody>
</table>
### Parameter Value

| Relationship between input signal and hex code | Chapter 5.2.4.5.1.1.10.3 “Output ranges voltage and current” on page 866 |
| Unused outputs | Are configured as “unused” (default value) and can be left open-circuited |

### Internal data exchange

<table>
<thead>
<tr>
<th></th>
<th>Without the fast counter</th>
<th>With the fast counter (only with AC500)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital inputs (bytes)</td>
<td>3</td>
<td>5</td>
</tr>
<tr>
<td>Digital outputs (bytes)</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td>Analog inputs (words)</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>Analog outputs (words)</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Counter input data (words)</td>
<td>0</td>
<td>4</td>
</tr>
<tr>
<td>Counter output data (words)</td>
<td>0</td>
<td>8</td>
</tr>
</tbody>
</table>

### Dimensions

1. Din rail 15 mm
2. Din rail 7.5 mm
The dimensions are in mm and in brackets in inch.

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 250 700 R0001</td>
<td>DA501, digital/analog input/output module, 16 DI, 8 DC, 4 AI, 2 AO</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 450 700 R0001</td>
<td>DA501-XC, digital/analog input/output module, 16 DI, 8 DC, 4 AI, 2 AO, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

DA502 - Digital/Analog input/output module

Features

- 16 digital outputs, 24 V DC, 0.5 A max.
- 8 configurable digital inputs/outputs 24 V DC, 0.5 A max.
- 4 analog inputs, voltage, current and RTD, resolution 12 bits including sign
- 2 analog outputs, voltage and current, resolution 12 bits including sign
- Fast counter
- Module-wise galvanically isolated
- XC version for use in extreme ambient conditions available
1 I/O bus
2 Allocation between terminal number and signal name
3 16 yellow LEDs to display the signal states of the digital outputs DO0 ... DO15
4 4 yellow LEDs to display the signal states of the analog inputs AI0 ... AI3
5 2 yellow LEDs to display the signal states of the analog outputs AO0 ... AO1
6 8 yellow LEDs to display the signal states of the configurable digital inputs/outputs DC16 ... DC23
7 1 green LED to display the state of the process supply voltage UP
8 4 red LEDs to display errors
9 Label
10 Terminal unit
11 DIN rail
\*\* Sign for XC version

**Intended purpose**

The device can be used as a decentralized I/O extension module for S500 communication interface modules (e.g., CI592-CS31, CI501-PNIO, CI541-DP, CI581-CN) or as a centralized extension module for AC500 CPUs.
**Functionality**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast counter</td>
<td>Integrated, many configurable operating modes</td>
</tr>
<tr>
<td>Power supply</td>
<td>From the process supply voltage UP</td>
</tr>
<tr>
<td>LED displays</td>
<td>For system displays, signal states, errors and power supply</td>
</tr>
<tr>
<td>Internal supply voltage</td>
<td>Via the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>External supply voltage</td>
<td>Via terminals UP and ZP (process supply voltage 24 V DC)</td>
</tr>
<tr>
<td>Effect of incorrect input terminal connection</td>
<td>Wrong or no signal detected, no damage up to 35 V</td>
</tr>
<tr>
<td>Required terminal unit</td>
<td>TU515 or TU516 ¤ Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938</td>
</tr>
</tbody>
</table>

**Connections**

> For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The connection is carried out by using the 40 terminals of the terminal unit TU515/TU516 ¥ Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938.

The assignment of the terminals:

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>DO0</td>
<td>Signal of the digital output DO0</td>
</tr>
<tr>
<td>1.1</td>
<td>DO1</td>
<td>Signal of the digital output DO1</td>
</tr>
<tr>
<td>1.2</td>
<td>DO2</td>
<td>Signal of the digital output DO2</td>
</tr>
<tr>
<td>1.3</td>
<td>DO3</td>
<td>Signal of the digital output DO3</td>
</tr>
<tr>
<td>1.4</td>
<td>DO4</td>
<td>Signal of the digital output DO4</td>
</tr>
<tr>
<td>1.5</td>
<td>DO5</td>
<td>Signal of the digital output DO5</td>
</tr>
<tr>
<td>1.6</td>
<td>DO6</td>
<td>Signal of the digital output DO6</td>
</tr>
<tr>
<td>1.7</td>
<td>DO7</td>
<td>Signal of the digital output DO7</td>
</tr>
<tr>
<td>1.8</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>1.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
<tr>
<td>2.0</td>
<td>DO8</td>
<td>Signal of the digital output DO8</td>
</tr>
<tr>
<td>2.1</td>
<td>DO9</td>
<td>Signal of the digital output DO9</td>
</tr>
<tr>
<td>2.2</td>
<td>DO10</td>
<td>Signal of the digital output DO10</td>
</tr>
<tr>
<td>2.3</td>
<td>DO11</td>
<td>Signal of the digital output DO11</td>
</tr>
<tr>
<td>2.4</td>
<td>DO12</td>
<td>Signal of the digital output DO12</td>
</tr>
<tr>
<td>2.5</td>
<td>DO13</td>
<td>Signal of the digital output DO13</td>
</tr>
<tr>
<td>2.6</td>
<td>DO14</td>
<td>Signal of the digital output DO14</td>
</tr>
<tr>
<td>Terminal</td>
<td>Signal</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>2.7</td>
<td>DO15</td>
<td>Signal of the digital output DO15</td>
</tr>
<tr>
<td>2.8</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>2.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
<tr>
<td>3.0</td>
<td>AI0+</td>
<td>Positive pole of analog input signal 0</td>
</tr>
<tr>
<td>3.1</td>
<td>AI1+</td>
<td>Positive pole of analog input signal 1</td>
</tr>
<tr>
<td>3.2</td>
<td>AI2+</td>
<td>Positive pole of analog input signal 2</td>
</tr>
<tr>
<td>3.3</td>
<td>AI3+</td>
<td>Positive pole of analog input signal 3</td>
</tr>
<tr>
<td>3.4</td>
<td>AI-</td>
<td>Negative pole of analog input signals 0 ... 3</td>
</tr>
<tr>
<td>3.5</td>
<td>AO0+</td>
<td>Positive pole of analog output signal 0</td>
</tr>
<tr>
<td>3.6</td>
<td>AO1+</td>
<td>Positive pole of analog output signal 1</td>
</tr>
<tr>
<td>3.7</td>
<td>AO-</td>
<td>Negative pole of analog output signals 0 and 1</td>
</tr>
<tr>
<td>3.8</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>3.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
<tr>
<td>4.0</td>
<td>DC16</td>
<td>Signal of the configurable digital input/output DC16</td>
</tr>
<tr>
<td>4.1</td>
<td>DC17</td>
<td>Signal of the configurable digital input/output DC17</td>
</tr>
<tr>
<td>4.2</td>
<td>DC18</td>
<td>Signal of the configurable digital input/output DC18</td>
</tr>
<tr>
<td>4.3</td>
<td>DC19</td>
<td>Signal of the configurable digital input/output DC19</td>
</tr>
<tr>
<td>4.4</td>
<td>DC20</td>
<td>Signal of the configurable digital input/output DC20</td>
</tr>
<tr>
<td>4.5</td>
<td>DC21</td>
<td>Signal of the configurable digital input/output DC21</td>
</tr>
<tr>
<td>4.6</td>
<td>DC22</td>
<td>Signal of the configurable digital input/output DC22</td>
</tr>
<tr>
<td>4.7</td>
<td>DC23</td>
<td>Signal of the configurable digital input/output DC23</td>
</tr>
<tr>
<td>4.8</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>4.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
</tbody>
</table>

The internal power supply voltage for the module’s circuitry is carried out via the I/O bus (provided by a communication interface module or a CPU). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 2 mA per DA502.

The external power supply connection is carried out via the UP (+24 V DC) and the ZP (0 V DC) terminals.
WARNING!
Removal/Insertion under power
Removal or insertion under power is permissible only if all conditions for hot swapping are fulfilled.

Chapter 4.9.3 “Replace an I/O module with hot swap” on page 153

The devices are not designed for removal or insertion under power when the conditions for hot swap do not apply. Because of unforeseeable consequences, it is not allowed to plug in or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you
– connect or disconnect any signal or terminal block
– remove, mount or replace a module.

Disconnecting any powered devices while they are energized in a hazardous location could result in an electric arc, which could create an ignition source resulting in fire or explosion.

Prior to proceeding, make sure that power is been disconnected and that the area has been thoroughly checked to ensure that flammable materials are not present.

The devices must not be opened when in operation. The same applies to the network interfaces.

NOTICE!
Risk of damaging the PLC modules!
Overvoltages and short circuits might damage the PLC modules.
– Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
– Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

NOTICE!
Risk of damaging the PLC modules!
The PLC modules must not be removed while the plant is connected to a power supply.

Make sure that all voltage sources (supply and process voltage) are switched off before you
– connect or disconnect any signal or terminal block
– remove or replace a module.

CAUTION!
Risk of imprecise and faulty measurements!
Analog signals may be distorted seriously by external electromagnetic influences.

Use shielded wires when wiring analog signal sources. The cable shield must be grounded at both ends of the cable. Provide a potential equalization of a low resistance to avoid high potential differences between different parts of the plant.
Fig. 152: Terminal assignment of the module

The module provides several diagnosis functions "Diagnosis" on page 895.

Connection of the digital outputs

Fig. 153: Connection of the digital outputs (DO0 ... DO15)

For a description of the meaning of the LEDs, please refer to the Displays chapter "State LEDs" on page 897.
Connection of the configurable digital inputs/outputs

![Diagram of configurable digital inputs/outputs](Image)

Fig. 154: Connection of the configurable digital input/outputs (DC16 ... DC23) (DC16 as an input, DC17 as an output)

**NOTICE!**

Risk of influences to the connected sensors!

- Some sensors may be influenced by the deactivated module outputs of DA502.
- Connect a 470 Ω / 1 W resistor in series to inputs DC16/DC17 if they are used as fast counter inputs to avoid any influences.

For a description of the meaning of the LEDs, please refer to the Displays Chapter 5.2.4.5.1.2.9 “State LEDs” on page 897 chapter.

Connection of resistance thermometers in 2-wire configuration to the analog inputs

When resistance thermometers (Pt100, Pt1000, Ni1000) are used, a constant current must flow through them to build the necessary voltage drop for the evaluation. For this, the module DA502 provides a constant current source which is multiplexed over max. 4 analog input channels.
The following measuring ranges can be configured:

- Pt100: -50 °C ... +400 °C, 2-wire configuration, 1 channel used
- Pt1000: -50 °C ... +400 °C, 2-wire configuration, 1 channel used
- Ni1000: -50 °C ... +150 °C, 2-wire configuration, 1 channel used

For a description of the function of the LEDs, please refer to Diagnosis and displays / Displays on page 897.

The module DA502 performs a linearization of the resistance characteristic.

To avoid error messages from unused analog input channels, configure them as "unused".

Connection of resistance thermometers in 3-wire configuration to the analog inputs

When resistance thermometers (Pt100, Pt1000, Ni1000) are used, a constant current must flow through them to build the necessary voltage drop for the evaluation. For this, the module DA502 provides a constant current source which is multiplexed over max. 4 analog input channels.
Fig. 156: Connection of resistance thermometers in 3-wire configuration to the analog inputs (AI0 ... AI3)

With 3-wire configuration, 2 adjacent analog channels belong together (e.g. the channels 0 and 1). In this case, both channels are configured according to the desired operating mode. The lower address must be the even address (channel 0), the next higher address must be the odd address (channel 1).

The constant current of one channel flows through the resistance thermometer. The constant current of the other channel flows through one of the cores. The module calculates the measured value from the two voltage drops and stores it under the input with the higher channel number (e.g. I1).

In order to keep measuring errors as small as possible, it is necessary to have all the involved conductors in the same cable. All the conductors must have the same cross section.

The following measuring ranges can be configured "Parameterization on page 890 "Measuring ranges" on page 898:

<table>
<thead>
<tr>
<th>Temperature Range</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pt100 -50 °C ... +400 °C</td>
<td>3-wire configuration, 2 channels used</td>
</tr>
<tr>
<td>Pt1000 -50 °C ... +400 °C</td>
<td>3-wire configuration, 2 channels used</td>
</tr>
<tr>
<td>Ni1000 -50 °C ... +150 °C</td>
<td>3-wire configuration, 2 channels used</td>
</tr>
</tbody>
</table>

For a description of the function of the LEDs, please refer to Diagnosis and displays / Displays "State LEDs" on page 897.

The module DA502 performs a linearization of the resistance characteristic.

To avoid error messages from unused analog input channels, configure them as "unused".
Connection of active-type analog sensors (Voltage) with galvanically isolated power supply to the analog inputs

Fig. 157: Connection of active-type analog sensors (voltage) with galvanically isolated power supply to the analog inputs (AI0 ... AI3)

The following measuring ranges can be configured

<table>
<thead>
<tr>
<th>Voltage</th>
<th>0 V ... 10 V</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

For a description of the function of the LEDs, please refer to Diagnosis and displays / Displays

Chapter 5.2.4.5.1.2.9 “State LEDs” on page 897.

To avoid error messages from unused analog input channels, configure them as "unused".
Connection of active-type analog sensors (Current) with galvanically isolated power supply to the analog inputs

![Diagram of connection]

**Fig. 158: Connection of active-type analog sensors (current) with galvanically isolated power supply to the analog inputs (AI0 ... AI3)**

The following measuring ranges can be configured:

- **Current** 0 mA ... 20 mA 1 channel used
- **Current** 4 mA ... 20 mA 1 channel used

For a description of the function of the LEDs, please refer to Diagnosis and displays / Displays  
Chapter 5.2.4.5.1.2.9 “State LEDs” on page 897.

Unused input channels can be left open-circuited, because they are of low resistance.
Connection of active-type analog sensors (Voltage) with no galvanically isolated power supply to the analog inputs

Fig. 159: Connection of active-type sensors (voltage) with no galvanically isolated power supply to the analog inputs (AI0 ... AI3)

CAUTION!
Risk of faulty measurements!
The negative pole at the sensors must not have too large a potential difference with respect to ZP (max. ±1 V within the full signal range).
Make sure that the potential difference never exceeds ±1 V.

The following measuring ranges can be configured: Chapter 5.2.4.5.1.2.7 “Parameterization” on page 890, Chapter 5.2.4.5.1.2.10 “Measuring ranges” on page 898:

<table>
<thead>
<tr>
<th>Voltage</th>
<th>0 V ... 10 V</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

For a description of the function of the LEDs, please refer to Diagnosis and displays / Displays Chapter 5.2.4.5.1.2.9 “State LEDs” on page 897.
To avoid error messages from unused analog input channels, configure them as "unused".

2024/01/05 3ADR010583, 1, en_US 885
Connection of passive-type analog sensors (Current) to the analog inputs

![Diagram of connection of passive-type analog sensors (current) to the analog inputs (AI0 ... AI3)](image)

The following measuring ranges can be configured on page 890 and Chapter 5.2.4.5.1.2.10 “Measuring ranges” on page 898:

<table>
<thead>
<tr>
<th>Current</th>
<th>4 mA ... 20 mA</th>
<th>1 channel used</th>
</tr>
</thead>
</table>

For a description of the function of the LEDs, please refer to Diagnosis and displays / Displays “State LEDs” on page 897.

**NOTICE!**

**Risk of overloading the analog input!**

If an analog current sensor supplies more than 25 mA for more than 1 second during initialization, this input is switched off by the module (input protection).

Use only sensors with fast initialization or without current peaks higher than 25 mA. If not possible, connect a 10-volt Zener diode in parallel to I+ and ZP.

Unused input channels can be left open-circuited, because they are of low resistance.

Connection of active-type analog sensors (Voltage) to differential analog inputs

Differential inputs are very useful if analog sensors which are remotely non-isolated (e.g. the negative terminal is remotely grounded) are used.

Using differential inputs helps to considerably increase the measuring accuracy and to avoid ground loops.

With differential input configurations, two adjacent analog channels belong together (e.g. the channels 0 and 1). In this case, both channels are configured according to the desired operating mode. The lower address must be the even address (channel 0), the next higher address must be the odd address (channel 1). The converted analog value is available at the higher address (channel 1).

The analog value is calculated by subtraction of the input value with the higher address from the input value of the lower address.
The converted analog value is available at the odd channel (higher address).

**CAUTION!**
Risk of faulty measurements!
The negative pole at the sensors must not have too large a potential difference with respect to ZP (max. ±1 V within the full signal range).
Make sure that the potential difference never exceeds ±1 V.

![Diagram of active-type analog sensors (voltage) to differential analog inputs (AI0 ... AI3)](image)

Fig. 161: Connection of active-type analog sensors (voltage) to differential analog inputs (AI0 ... AI3)

The following measuring ranges can be configured:

<table>
<thead>
<tr>
<th>Voltage</th>
<th>0 V ... 10 V with differential inputs, 2 channels used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V with differential inputs, 2 channels used</td>
</tr>
</tbody>
</table>

For a description of the function of the LEDs, please refer to Diagnosis and displays / Displays "State LEDs" on page 897.
To avoid error messages from unused analog input channels, configure them as "unused".

**Use of analog inputs as digital inputs**
Several (or all) analog inputs can be configured as digital inputs. The inputs are not galvanically isolated against the other analog channels.
The following measuring ranges can be configured on page 890 and Chapter 5.2.4.5.1.2.10 “Measuring ranges” on page 898:

<table>
<thead>
<tr>
<th>Digital input</th>
<th>24 V</th>
<th>1 channel used</th>
</tr>
</thead>
</table>

For a description of the function of the LEDs, please refer to Diagnosis and displays / Displays on page 897.

**Connection of analog output loads (Voltage)**

For a description of the function of the LEDs, please refer to Diagnosis and displays / Displays on page 897.
The following measuring ranges can be configured \(\text{Chapter 5.2.4.5.1.2.7 “Parameterization” on page 890} \) \(\text{Chapter 5.2.4.5.1.2.10 “Measuring ranges” on page 898}\):

<table>
<thead>
<tr>
<th>Voltage</th>
<th>-10 V ... +10 V</th>
<th>Load ± 10 mA max.</th>
<th>1 channel used</th>
</tr>
</thead>
</table>

For a description of the function of the LEDs, please refer to Diagnosis and displays / Displays \(\text{Chapter 5.2.4.5.1.2.9 “State LEDs” on page 897}\).

Unused analog outputs can be left open-circuited.

**Connection of analog output loads (Current)**

![Connection diagram](image)

*Fig. 164: Connection of analog output loads (current) to the analog outputs (AO0 ... AO1)*

The following measuring ranges can be configured \(\text{Chapter 5.2.4.5.1.2.7 “Parameterization” on page 890} \) \(\text{Chapter 5.2.4.5.1.2.10 “Measuring ranges” on page 898}\):

<table>
<thead>
<tr>
<th>Current</th>
<th>0 mA ... 20 mA</th>
<th>Load 0 Ω ... 500 Ω</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>4 mA ... 20 mA</td>
<td>Load 0 Ω ... 500 Ω</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

For a description of the function of the LEDs, please refer to Diagnosis and displays / Displays \(\text{Chapter 5.2.4.5.1.2.9 “State LEDs” on page 897}\).

Unused analog outputs can be left open-circuited.

**Internal data exchange**

<table>
<thead>
<tr>
<th></th>
<th>Without the fast counter</th>
<th>With the fast counter (only with AC500)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital inputs (bytes)</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Digital outputs (bytes)</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Analog inputs (words)</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>Analog outputs (words)</td>
<td>2</td>
<td>2</td>
</tr>
</tbody>
</table>
I/O configuration

The module itself does not store configuration data. It draws its parameterization data from the master device of the I/O bus (CPU or communication interface module) during power-up of the system.

Hence, replacing I/O modules is possible without any re-parameterization via software.

If the external power supply voltage via UP/ZP terminals fails, the I/O module loses its configuration data. The whole station has to be switched off and on again to re-configure the module.

Parameterization

<table>
<thead>
<tr>
<th>Firmware version</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firmware version &gt; V2.0.0</td>
<td>The arrangement of the parameter data is performed by Control Builder Plus/ Automation Builder software.</td>
</tr>
</tbody>
</table>

The parameter data directly influences the functionality of modules.

For non-standard applications, it is necessary to adapt the parameters to your system configuration.

Module: Module slot address: Y = 1 \ldots 10

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
<th>EDS Slot / Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID 1)</td>
<td>Internal</td>
<td>1815</td>
<td>WORD</td>
<td>1815</td>
<td>0x0Y01</td>
</tr>
<tr>
<td>Ignore module</td>
<td>Internal</td>
<td>Yes</td>
<td>BYTE</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal</td>
<td>8</td>
<td>BYTE</td>
<td>8</td>
<td>0x0Y02</td>
</tr>
<tr>
<td>Check supply</td>
<td>off</td>
<td>0</td>
<td>BYTE</td>
<td>1</td>
<td>0x0Y03</td>
</tr>
<tr>
<td></td>
<td>on</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Without the fast counter | With the fast counter (only with AC500)

<p>| Counter input data (words) | 0 | 5 |
| Counter output data (words) | 0 | 9 |</p>
<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
<th>EDS Slot / Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast counter 3)</td>
<td>0</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
<td>Not for FBP</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10 2)</td>
<td></td>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Behavior outputs at comm. error 5)</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>Off</td>
<td>0x00</td>
</tr>
<tr>
<td></td>
<td>Last value</td>
<td>16</td>
<td></td>
<td>0x0Y07</td>
<td></td>
</tr>
<tr>
<td>Last value 5 s</td>
<td></td>
<td>11</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Last value 10 s</td>
<td></td>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Substitute value</td>
<td></td>
<td>7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Substitute value 5 s</td>
<td></td>
<td>12</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Substitute value 10 s</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Error LED lights up at errors of all error classes, Failsafe mode off</td>
</tr>
<tr>
<td>Off by E4</td>
<td>Error LED lights up at errors of error classes E1, E2 and E3, Failsafe mode off</td>
</tr>
<tr>
<td>Off by E3</td>
<td>Error LED lights up at errors of error classes E1 and E2, Failsafe mode off</td>
</tr>
<tr>
<td>On +Failsafe</td>
<td>Error LED lights up at errors of all error classes, Failsafe mode on *)</td>
</tr>
<tr>
<td>Off by E4 + Failsafe</td>
<td>Error LED lights up at errors of error classes E1, E2 and E3, Failsafe mode on *)</td>
</tr>
<tr>
<td>Off by E3 + Failsafe</td>
<td>Error LED lights up at errors of error classes E1 and E2, Failsafe mode on *)</td>
</tr>
</tbody>
</table>

1) With a faulty ID, the module reports a "parameter error" and does not perform cyclic process data transmission

2) For a description of the counter operating modes, please refer to the 'Fast Counter' section 5 Chapter 5.2.4.3.2.9 "Fast counter" on page 606

3) With CS31 without the parameter "Fast Counter"

The fast counter of the module does not work if the module is connected to a CS31 bus module.

5) The parameter Behavior outputs at comm. error is only analyzed if the Failsafe mode is ON.
### Group parameters for the digital part

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
<th>EDS Slot / Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input delay</td>
<td>0.1 ms</td>
<td>0</td>
<td>BYTE</td>
<td>0.1 ms 0x00</td>
<td>0x0Y05</td>
</tr>
<tr>
<td></td>
<td>1 ms</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 ms</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>32 ms</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Detect short circuit at outputs</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>On 0x1</td>
<td>0x0Y06</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Substitute value at output</td>
<td>0 ... 255</td>
<td>00h ... FFh</td>
<td>BYTE</td>
<td>0 0x0000</td>
<td>0x0Y08</td>
</tr>
</tbody>
</table>

*) The parameters Behavior DO at comm. error is only analyzed if the Failsafe mode is ON.

### Group parameters for the analog part

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
<th>EDS Slot / Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog data format</td>
<td>Standard</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
<td>0x0Y04</td>
</tr>
<tr>
<td></td>
<td>Reserved</td>
<td>255</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*) The parameter Behaviour AO at comm. error is only analyzed if the Failsafe mode is ON.

### Channel parameters for the analog inputs (4x)

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
<th>EDS Slot / Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input 0, Channel config.</td>
<td>see table 'Channel configuration' &amp; Table 201 “Channel configuration” on page 893</td>
<td>see table 'Channel configuration' &amp; Table 201 “Channel configuration” on page 893</td>
<td>BYTE</td>
<td>0</td>
<td>0x0Y09</td>
</tr>
<tr>
<td>Check channel</td>
<td>see table 'Channel monitoring' &amp; Table 202 “Channel monitoring” on page 893</td>
<td>see table 'Channel monitoring' &amp; Table 202 “Channel monitoring” on page 893</td>
<td>BYTE</td>
<td>0</td>
<td>0x0Y0A</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
</tr>
</tbody>
</table>

Hardware descriptions
Device specifications > I/O modules
<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
<th>EDS Slot / Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input 3, Channel configuration</td>
<td>see table 'Channel configuration' on page 893</td>
<td>see table 'Channel configuration' on page 893</td>
<td>BYTE</td>
<td>0</td>
<td>0x0Y0F</td>
</tr>
<tr>
<td>Input 3, Check channel</td>
<td>see table 'Channel monitoring' on page 893</td>
<td>see table 'Channel monitoring' on page 893</td>
<td>BYTE</td>
<td>0</td>
<td>0x0Y10</td>
</tr>
</tbody>
</table>

Table 201: Channel configuration

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes of the analog inputs, individually configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (default)</td>
<td>Not used</td>
</tr>
<tr>
<td>1</td>
<td>0 V ... 10 V</td>
</tr>
<tr>
<td>2</td>
<td>Digital input</td>
</tr>
<tr>
<td>3</td>
<td>0 mA ... 20 mA</td>
</tr>
<tr>
<td>4</td>
<td>4 mA ... 20 mA</td>
</tr>
<tr>
<td>5</td>
<td>-10 V ... +10 V</td>
</tr>
<tr>
<td>8</td>
<td>2-wire Pt100 -50 °C ... +400 °C</td>
</tr>
<tr>
<td>9</td>
<td>3-wire Pt100 -50 °C ... +400 °C *)</td>
</tr>
<tr>
<td>10</td>
<td>0 V ... 10 V (voltage diff.) *)</td>
</tr>
<tr>
<td>11</td>
<td>-10 V ... +10 V (voltage diff.) *)</td>
</tr>
<tr>
<td>14</td>
<td>2-wire Pt100 -50 °C ... +70 °C</td>
</tr>
<tr>
<td>15</td>
<td>3-wire Pt100 -50 °C ... +70 °C *)</td>
</tr>
<tr>
<td>16</td>
<td>2-wire Pt1000 -50 °C ... +400 °C</td>
</tr>
<tr>
<td>17</td>
<td>3-wire Pt1000 -50 °C ... +400 °C *)</td>
</tr>
<tr>
<td>18</td>
<td>2-wire Ni1000 -50 °C ... +150 °C</td>
</tr>
<tr>
<td>19</td>
<td>3-wire Ni1000 -50 °C ... +150 °C *)</td>
</tr>
</tbody>
</table>

*) In the operating modes with 3-wire configuration or with differential inputs, two adjacent analog inputs belong together (e.g. the channels 0 and 1). In these cases, both channels are configured in the desired operating mode. The lower address must be the even address (channel 0). The next higher address must be the odd address (channel 1). The converted analog value is available at the higher address (channel 1).

Table 202: Channel monitoring

<table>
<thead>
<tr>
<th>Internal Value</th>
<th>Check Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (default)</td>
<td>Plausibility, wire break, short circuit</td>
</tr>
<tr>
<td>3</td>
<td>Not used</td>
</tr>
</tbody>
</table>
Channel parameters for the analog outputs (2x)

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
<th>EDS Slot / Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Output 0, Channel configuration</td>
<td>see table 'Channel configuration' % Table 203 &quot;Channel configuration&quot; on page 894</td>
<td>see table 'Channel configuration' % Table 203 &quot;Channel configuration&quot; on page 894</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>Output 0, Check channel</td>
<td>see table 'Channel monitoring' % Table 204 &quot;Channel monitoring&quot; on page 895</td>
<td>see table 'Channel monitoring' % Table 204 &quot;Channel monitoring&quot; on page 895</td>
<td>BYTE</td>
<td>0</td>
<td>0x0Y12</td>
</tr>
<tr>
<td>Output 0, Substitute value</td>
<td>see table 'Substitute values' % Table 205 &quot;Substitute value&quot; on page 895</td>
<td>see table 'Substitute values' % Table 205 &quot;Substitute value&quot; on page 895</td>
<td>WORD</td>
<td>0</td>
<td>0x0Y13</td>
</tr>
<tr>
<td>Output 1, Channel configuration</td>
<td>see table 'Channel configuration' % Table 203 &quot;Channel configuration&quot; on page 894</td>
<td>see table 'Channel configuration' % Table 203 &quot;Channel configuration&quot; on page 894</td>
<td>BYTE</td>
<td>0</td>
<td>0x0Y14</td>
</tr>
<tr>
<td>Output 1, Check channel</td>
<td>see table 'Channel monitoring' % Table 204 &quot;Channel monitoring&quot; on page 895</td>
<td>see table 'Channel monitoring' % Table 204 &quot;Channel monitoring&quot; on page 895</td>
<td>BYTE</td>
<td>0</td>
<td>0x0Y15</td>
</tr>
<tr>
<td>Output 1, Substitute value</td>
<td>see table 'Substitute values' % Table 205 &quot;Substitute value&quot; on page 895</td>
<td>see table 'Substitute values' % Table 205 &quot;Substitute value&quot; on page 895</td>
<td>WORD</td>
<td>0</td>
<td>0x0Y16</td>
</tr>
</tbody>
</table>

Table 203: Channel configuration

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes of the analog outputs, individually configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (default)</td>
<td>Not used</td>
</tr>
<tr>
<td>128</td>
<td>-10 V ... +10 V</td>
</tr>
<tr>
<td>129</td>
<td>0 mA ... 20 mA</td>
</tr>
<tr>
<td>130</td>
<td>4 mA ... 20 mA</td>
</tr>
</tbody>
</table>
### Table 204: Channel monitoring

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Check channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Plausibility, wire break, short circuit</td>
</tr>
<tr>
<td>3</td>
<td>None</td>
</tr>
</tbody>
</table>

### Table 205: Substitute value

<table>
<thead>
<tr>
<th>Intended behavior of output channel when the control system stops</th>
<th>Required setting of the module parameter &quot;Behavior of outputs in case of a communication error&quot;</th>
<th>Required setting of the channel parameter &quot;Substitute value&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output OFF</td>
<td>Off</td>
<td>0</td>
</tr>
<tr>
<td>Last value infinite</td>
<td>Last value</td>
<td>0</td>
</tr>
<tr>
<td>Last value for 5 s and then turn off</td>
<td>Last value 5 s</td>
<td>0</td>
</tr>
<tr>
<td>Last value for 10 s and then turn off</td>
<td>Last value 10 s</td>
<td>0</td>
</tr>
<tr>
<td>Substitute value infinite</td>
<td>Substitute value</td>
<td>Depending on configuration</td>
</tr>
<tr>
<td>Substitute value for 5 s and then turn off</td>
<td>Substitute value 5 s</td>
<td>Depending on configuration</td>
</tr>
<tr>
<td>Substitute value for 10 s and then turn off</td>
<td>Substitute value 10 s</td>
<td>Depending on configuration</td>
</tr>
</tbody>
</table>

### Diagnosis

In cases of short circuit or overload, the digital outputs are turned off. The module performs reactivation automatically. Thus, an acknowledgement of the errors is not necessary. The error message is stored via the LED.

### Module error

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>19</td>
<td>Checksum error in the I/O module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>3</td>
<td>Timeout in the I/O module</td>
<td></td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>40</td>
<td>Different hard-/firmware versions in the module</td>
<td></td>
</tr>
<tr>
<td>Class</td>
<td>Interface</td>
<td>Device</td>
<td>Module</td>
<td>Channel</td>
<td>Error Identifier</td>
<td>Error message</td>
<td>Remedy</td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>--------</td>
<td>--------</td>
<td>---------</td>
<td>-----------------</td>
<td>---------------</td>
<td>--------</td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>43</td>
<td>Internal error in the module</td>
<td></td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>36</td>
<td>Internal data exchange failure</td>
<td></td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>9</td>
<td>Overflow diagnosis buffer</td>
<td>New start</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>26</td>
<td>Parameter error</td>
<td>Check master</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>11</td>
<td>Process voltage too low</td>
<td>Check process voltage</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>31</td>
<td>31</td>
<td>45</td>
<td>Process voltage is switched off (ON -&gt; OFF)</td>
<td>Process voltage ON</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Channel error DA502

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>2</td>
<td>0 ... 15</td>
<td>47</td>
<td>Short-circuit at a digital output</td>
<td>Check connection</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Channel error DA502

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>1</td>
<td>16 ... 19</td>
<td>48</td>
<td>Analog value overflow or broken wire at an analog input</td>
<td>Check input value or terminal</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>1</td>
<td>16 ... 19</td>
<td>7</td>
<td>Analog value underflow at an analog input</td>
<td>Check input value</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>1</td>
<td>16 ... 19</td>
<td>47</td>
<td>Short circuit at an analog input</td>
<td>Check terminal</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>3</td>
<td>20 ... 21</td>
<td>4</td>
<td>Analog value overflow at an analog output</td>
<td>Check output value</td>
</tr>
<tr>
<td></td>
<td>11 / 12</td>
<td>ADR</td>
<td>1 ... 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1 ... 10</td>
<td>3</td>
<td>20 ... 21</td>
<td>7</td>
<td>Analog value underflow at an analog output</td>
<td>Check output value</td>
</tr>
</tbody>
</table>
1) In AC500, the following interface identifier applies:
   14 = I/O bus,  11 = COM1 (e.g. CS31 bus),  12 = COM2.

2) With "Device" the following allocation applies:
   31 = module itself,
   1 ... 10 = communication interface module 1 ... 10,
   ADR = hardware address (e.g. of the DC551)

3) With "Module" the following allocation applies depending on the master:
   Module error: I/O bus: 31 = Module itself; COM1/COM2: 1 ... 10 = expansion
   Channel error: I/O bus = module type (1 = AI, 3 = AO, 4 = DC); COM1/COM2:
   1 ... 10 = expansion 1 ... 10

4) In case of module errors, with channel "31 = module itself" is output.

5) Ch = 22 ... 29 indicate the digital inputs/outputs DC16 ... DC23

6) Ch = 16 ... 19 indicates the analog inputs AI0 ... AI3

7) Ch = 20 ... 21 indicates the analog outputs AO0 ... AO1

State LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
<th>LED flashes</th>
</tr>
</thead>
<tbody>
<tr>
<td>DO0 ... DO15</td>
<td>Digital output</td>
<td>Yellow</td>
<td>Output is OFF</td>
<td>Output is ON</td>
<td>--</td>
</tr>
<tr>
<td>DC16 ... DC23</td>
<td>Digital input/output</td>
<td>Yellow</td>
<td>Input/output is OFF</td>
<td>Input/output is ON 1)</td>
<td>--</td>
</tr>
<tr>
<td>AI0 ... AI3</td>
<td>Analog input</td>
<td>Yellow</td>
<td>Input is OFF</td>
<td>Input is ON 2)</td>
<td>--</td>
</tr>
<tr>
<td>AO0 ... AO1</td>
<td>Analog output</td>
<td>Yellow</td>
<td>Output is OFF</td>
<td>Output is ON 2)</td>
<td>--</td>
</tr>
<tr>
<td>UP</td>
<td>Process supply voltage 24 V DC via terminal</td>
<td>Green</td>
<td>Process supply voltage is missing</td>
<td>Process supply voltage OK</td>
<td>--</td>
</tr>
<tr>
<td>CH-ERR1</td>
<td>Channel error, error messages in groups (digital inputs/outputs combined into the groups 1, 2, 3, 4)</td>
<td>Red</td>
<td>No error or process supply voltage is missing</td>
<td>Severe error within the corresponding group</td>
<td>Severe error within the corresponding group (e.g. short circuit at an output)</td>
</tr>
<tr>
<td>CH-ERR2</td>
<td>--</td>
<td>Red</td>
<td>--</td>
<td>Internal error</td>
<td>--</td>
</tr>
</tbody>
</table>

1) Indication LED is ON even if an input signal is applied to the channel and the supply voltage is off. In this case the module is not operating and does not generate an input signal.

2) Brightness depends on the value of the analog signal

3) All of the LEDs CH-ERR1 to CH-ERR4 light up together
## Measuring ranges

### Input ranges voltage, current and digital input

<table>
<thead>
<tr>
<th>Range</th>
<th>0 V ... +10 V</th>
<th>-10 V ... +10 V</th>
<th>0 mA ... 20 mA</th>
<th>4 mA ... 20 mA</th>
<th>Digital input</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Decimal</td>
<td>Hex.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overflow</td>
<td>&gt; 11.7589</td>
<td>&gt; 11.7589</td>
<td>&gt; 23.5178</td>
<td>&gt; 22.8142</td>
<td></td>
<td>32767</td>
</tr>
<tr>
<td>Measured value too high</td>
<td>11.7589</td>
<td>11.7589</td>
<td>23.5178</td>
<td>22.8142</td>
<td></td>
<td>32511</td>
</tr>
<tr>
<td></td>
<td>10.0004</td>
<td>10.0004</td>
<td>20.0007</td>
<td>20.0006</td>
<td></td>
<td>27649</td>
</tr>
<tr>
<td>Normal range</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Digital</td>
<td>6C01</td>
</tr>
<tr>
<td>Normal range or measured value too low</td>
<td>10.0000</td>
<td>10.0000</td>
<td>20.0000</td>
<td>20.0000</td>
<td>0</td>
<td>27648</td>
</tr>
<tr>
<td></td>
<td>0.0004</td>
<td>0.0004</td>
<td>0.0007</td>
<td>4.0006</td>
<td>4</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>0.0000</td>
<td>0.0000</td>
<td>0</td>
<td>4</td>
<td>Off</td>
<td>0</td>
</tr>
<tr>
<td>Measured value too low</td>
<td>-10.0004</td>
<td>-10.0004</td>
<td>3.9994</td>
<td>1.1858</td>
<td>-1</td>
<td>FFFF</td>
</tr>
<tr>
<td></td>
<td>-1.7593</td>
<td></td>
<td>1.1858</td>
<td></td>
<td>-4864</td>
<td>ED00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-27648</td>
<td>9400</td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt; 1.7593</td>
<td>&lt; -11.7589</td>
<td>&lt; 0.0000</td>
<td>&lt; 1.1858</td>
<td>-32768</td>
<td>8000</td>
</tr>
</tbody>
</table>

The represented resolution corresponds to 16 bits.

## Input ranges resistance temperature detector

<table>
<thead>
<tr>
<th>Range</th>
<th>Pt100 / Pt1000</th>
<th>Pt100 / Pt1000</th>
<th>Ni1000</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>-50°C ... +70 °C</td>
<td>-50°C ... +400 °C</td>
<td>-50°C ... +150 °C</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Decimal</td>
<td>Hex.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overflow</td>
<td>&gt; +80.0 °C</td>
<td>&gt; +450.0 °C</td>
<td>&gt; +160.0 °C</td>
<td>32767</td>
</tr>
<tr>
<td>Measured value too high</td>
<td>+450.0 °C</td>
<td>+400.1 °C</td>
<td>4500</td>
<td>1194</td>
</tr>
<tr>
<td></td>
<td>+160.0 °C</td>
<td>+150.1 °C</td>
<td>1600</td>
<td>0640</td>
</tr>
<tr>
<td></td>
<td>+80.0 °C</td>
<td></td>
<td>800</td>
<td>0320</td>
</tr>
<tr>
<td></td>
<td>+70.1 °C</td>
<td></td>
<td>701</td>
<td>02BD</td>
</tr>
<tr>
<td>Range</td>
<td>Pt100 / Pt1000</td>
<td>Pt100 / Pt1000</td>
<td>Ni1000</td>
<td>Digital value</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------</td>
<td>----------------</td>
<td>----------</td>
<td>---------------</td>
</tr>
<tr>
<td></td>
<td>-50°C ... +70°C</td>
<td>-50°C ... +400°C</td>
<td>-50 °C ... +150 °C</td>
<td>Dec.</td>
</tr>
<tr>
<td>Normal range</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>+500.0 °C</td>
<td>+0.1 °C</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1500</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>700</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>0.0 °C</td>
<td>0.0 °C</td>
<td>0.0 °C</td>
<td>0</td>
<td>0000</td>
</tr>
<tr>
<td>-0.1 °C</td>
<td>-0.1 °C</td>
<td>-0.1 °C</td>
<td>-1</td>
<td>FFFF</td>
</tr>
<tr>
<td>-50.0 °C</td>
<td>-50.0 °C</td>
<td>-50.0 °C</td>
<td>-500</td>
<td>FE0C</td>
</tr>
<tr>
<td>Measured value too low</td>
<td>-50.1 °C</td>
<td>-50.1 °C</td>
<td>-501</td>
<td>FE0B</td>
</tr>
<tr>
<td></td>
<td>-60.0 °C</td>
<td>-60.0 °C</td>
<td>-600</td>
<td>FDA8</td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt; -60.0 °C</td>
<td>&lt; -60.0 °C</td>
<td>-32768</td>
<td>8000</td>
</tr>
</tbody>
</table>

Output ranges voltage and current

<table>
<thead>
<tr>
<th>Range</th>
<th>-10 V ... +10 V</th>
<th>0 mA ... 20 mA</th>
<th>4 mA ... 20 mA</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Dec.</td>
</tr>
<tr>
<td>Overflow</td>
<td>0 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>&gt; 32511</td>
</tr>
<tr>
<td>Value too high</td>
<td>11.7589 V</td>
<td>23.5178 mA</td>
<td>22.8142 mA</td>
<td>32511</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
</tr>
<tr>
<td></td>
<td>10.0004 V</td>
<td>20.0007 mA</td>
<td>20.0006 mA</td>
<td>27649</td>
</tr>
<tr>
<td>Normal range</td>
<td>10.0000 V</td>
<td>20.0000 mA</td>
<td>20.0000 mA</td>
<td>27648</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
</tr>
<tr>
<td></td>
<td>0.0004 V</td>
<td>0.0007 mA</td>
<td>4.0006 mA</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>0.0000 V</td>
<td>0.0000 mA</td>
<td>4.0000 mA</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>-0.0004 V</td>
<td>0 mA</td>
<td>3.9994 mA</td>
<td>-1</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
</tr>
<tr>
<td>Value too low</td>
<td>-10.0004 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>-27649</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>:</td>
</tr>
<tr>
<td></td>
<td>-11.7589 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>-32512</td>
</tr>
<tr>
<td>Underflow</td>
<td>0 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>&lt; -32512</td>
</tr>
</tbody>
</table>

The represented resolution corresponds to 16 bits.
Technical data

Technical data of the module

The system data of AC500 and S500 are applicable to the standard version “Chapter 5.1.2 ‘System data AC500’ on page 166.”

The system data of AC500-XC are applicable to the XC version “Chapter 5.1.3 ‘System data AC500-XC’ on page 169.”

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltage</td>
<td></td>
</tr>
<tr>
<td>Connections</td>
<td>Terminals 1.8, 2.8, 3.8 and 4.8 for UP (+24 V DC) and 1.9, 2.9, 3.9 and 4.9 for ZP (0 V)</td>
</tr>
<tr>
<td>Protection against reverse voltage</td>
<td>yes</td>
</tr>
<tr>
<td>Rated protection fuse at UP</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5 %</td>
</tr>
<tr>
<td>Current consumption</td>
<td></td>
</tr>
<tr>
<td>From UP</td>
<td>0.07 A + max. 0.5 A per output</td>
</tr>
<tr>
<td>From 24 V DC power supply at the terminals UP/L+ and ZP/M of the CPU/communication interface module</td>
<td>ca. 2 mA</td>
</tr>
<tr>
<td>Inrush current from UP (at power-up)</td>
<td>0.04 A²s</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per module</td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>6 W (outputs unloaded)</td>
</tr>
<tr>
<td>Weight (without terminal unit)</td>
<td>ca. 125 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal mounting or vertical with derating (output load reduced to 50% at +40 °C)</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>

**NOTICE!**

All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

**Multiple overloads**

No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an internal smart high-side switch.
Technical data of the digital outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>16 outputs (with transistors)</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 16 channels</td>
</tr>
<tr>
<td>Connection of the channels</td>
<td>DO0 ... DO7 Terminals 1.0 ... 1.7</td>
</tr>
<tr>
<td></td>
<td>DO8 ... DO15 Terminals 2.0 ... 2.7</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>1 yellow LED per channel, the LED is ON if the output signal is high (signal 1)</td>
</tr>
<tr>
<td>Monitoring point of output indicator</td>
<td>LED is controlled by process CPU</td>
</tr>
<tr>
<td>Reference potential for all outputs</td>
<td>Terminals 1.9, 2.9, 3.9 and 4.9 (negative pole of the process supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>For all outputs: terminals 1.8, 2.8, 3.8 and 4.8 (positive pole of the process supply voltage, signal name UP)</td>
</tr>
<tr>
<td>Output voltage for signal 1</td>
<td>UP (-0.8 V)</td>
</tr>
<tr>
<td>Output delay (0-&gt;1 or 1-&gt;0)</td>
<td>On request</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated value, per channel</td>
<td>500 mA at UP = 24 V</td>
</tr>
<tr>
<td>Maximum value (channels O0 to O15)</td>
<td>4 A</td>
</tr>
<tr>
<td>Leakage current with signal 0</td>
<td>&lt; 0.5 mA</td>
</tr>
<tr>
<td>Rated protection fuse on UP</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Demagnetization when inductive loads are switched off</td>
<td>With varistors integrated in the module (see figure below)</td>
</tr>
<tr>
<td>Switching frequency</td>
<td></td>
</tr>
<tr>
<td>With resistive load</td>
<td>On request</td>
</tr>
<tr>
<td>With inductive loads</td>
<td>Max. 0.5 Hz</td>
</tr>
<tr>
<td>With lamp loads</td>
<td>Max. 11 Hz with max. 5 W</td>
</tr>
<tr>
<td>Short-circuit-proof / overload-proof</td>
<td>Yes</td>
</tr>
<tr>
<td>Overload message (I &gt; 0.7 A)</td>
<td>Yes, after ca. 100 ms</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>Yes, automatic reactivation after short circuit/overload</td>
</tr>
<tr>
<td>Resistance to feedback against 24 V signals</td>
<td>Yes</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

Technical data of the configurable digital inputs/outputs

Each of the configurable digital I/O channels can be defined as input or output by the user program. This is done by interrogating or allocating the corresponding channel.
Technical data of the digital inputs/outputs if used as inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8 inputs/outputs (with transistors)</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group for 8 channels</td>
</tr>
<tr>
<td>If the channels are used as inputs</td>
<td></td>
</tr>
<tr>
<td>Channels DC16 ... DC23</td>
<td>Terminals 4.0 ... 4.7</td>
</tr>
<tr>
<td>If the channels are used as outputs</td>
<td></td>
</tr>
<tr>
<td>Channels DC16 ... DC23</td>
<td>Terminals 4.0 ... 4.7</td>
</tr>
<tr>
<td>Indication of the input/output signals</td>
<td>1 yellow LED per channel, the LED is ON when the input/output signal is high (signal 1)</td>
</tr>
<tr>
<td>Monitoring point of input/output indicator</td>
<td>LED is part of the input circuitry</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per module</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels DC16 ... DC23</td>
<td>Terminals 4.0 ... 4.7</td>
</tr>
<tr>
<td>Reference potential for all inputs</td>
<td>Terminals 1.9 ... 4.9 (Negative pole of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel, the LED is ON when the input signal is high (signal 1)</td>
</tr>
<tr>
<td>Monitoring point of input/output indicator</td>
<td>LED is part of the input circuitry</td>
</tr>
<tr>
<td>Input type (according EN 61131-2)</td>
<td>Type 1</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 0.1 ms, configurable from 0.1 ms ... 32 ms</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>0-Signal</td>
<td>-3 V ... +5 V</td>
</tr>
<tr>
<td>Undefined Signal</td>
<td>&gt; +5 V ... &lt; +15 V</td>
</tr>
<tr>
<td>1-Signal</td>
<td>+15 V ... +30 V</td>
</tr>
<tr>
<td>Ripple with signal 0</td>
<td>Within -3 V ... +5 V</td>
</tr>
<tr>
<td>Ripple with signal 1</td>
<td>Within +15 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 5 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>&gt; 1 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>&gt; 2 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 8 mA</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

* Due to the direct connection to the output, the demagnetizing varistor is also effective at the input (see figure) above. This is why the difference between UPx and the input signal must not exceed the clamp voltage of the varistor. The varistor limits the clamp voltage to approx. 36 V. Consequently, the input voltage must range from -12 V ... +30 V when UPx = 24 V and from -6 V ... +30 V when UPx = 30 V.
### Technical data of the digital inputs/outputs if used as outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels DC16 ... DC23</td>
<td>Terminals 4.0 ... 4.7</td>
</tr>
<tr>
<td>Reference potential for all outputs</td>
<td>Terminals 1.9 ... 4.9 (negative pole of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>For all outputs terminals 1.8, 2.8, 3.8 and 4.8 (positive pole of the supply voltage, signal name UP)</td>
</tr>
<tr>
<td>Output voltage for signal 1</td>
<td>UP (-0.8 V)</td>
</tr>
<tr>
<td>Output delay (0-&gt;1 or 1-&gt;0)</td>
<td>On request</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>rated value per channel</td>
<td>500 mA at UP = 24 V</td>
</tr>
<tr>
<td>max. value (all channels together)</td>
<td>4 A</td>
</tr>
<tr>
<td>Leakage current with signal 0</td>
<td>&lt; 0.5 mA</td>
</tr>
<tr>
<td>Fuse for UP</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Demagnetization with inductive DC load</td>
<td>Via internal varistors (see figure below this table)</td>
</tr>
<tr>
<td>Output switching frequency</td>
<td></td>
</tr>
<tr>
<td>With resistive load</td>
<td>On request</td>
</tr>
<tr>
<td>With inductive loads</td>
<td>Max. 0.5 Hz</td>
</tr>
<tr>
<td>With lamp loads</td>
<td>11 Hz max. at 5 W max.</td>
</tr>
<tr>
<td>Short-circuit-proof / overload-proof</td>
<td>Yes</td>
</tr>
<tr>
<td>Overload message (I &gt; 0.7 A)</td>
<td>Yes, after ca. 100 ms</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>Yes, automatic reactivation after short circuit/overload</td>
</tr>
<tr>
<td>Resistance to feedback against 24 V signals</td>
<td>Yes (software-controlled supervision)</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

The following drawing shows the circuitry of a digital input/output with the varistors for demagnetization when inductive loads are switched off.

![Circuit Diagram](image.png)

**Fig. 165: Digital input/output (circuit diagram)**

1. Digital input/output
2. For demagnetization when inductive loads are turned off
Technical data of the fast counter

The fast counter of the module does not work if the module is connected to a CS31 bus module.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Counting frequency</td>
<td>Max. 50 kHz</td>
</tr>
</tbody>
</table>

Chapter 6.8.2.12 “Fast counters in AC500 devices” on page 4536

Technical data of the analog inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>4</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group with 4 channels</td>
</tr>
<tr>
<td>Connection if channels AI0+ ... AI3+</td>
<td>Terminals 3.0 ... 3.3</td>
</tr>
<tr>
<td>Reference potential for AI0+ ... AI3+</td>
<td>Terminal 3.4 (AI-) for voltage and RTD measurement</td>
</tr>
<tr>
<td></td>
<td>Terminal 1.9, 2.9, 3.9 and 4.9 for current measurement</td>
</tr>
<tr>
<td>Input type</td>
<td></td>
</tr>
<tr>
<td>Unipolar</td>
<td>Voltage 0 V ... 10 V, current or Pt100/Pt1000/Ni1000</td>
</tr>
<tr>
<td>Bipolar</td>
<td>Voltage -10 V ... +10 V</td>
</tr>
<tr>
<td>Configurability</td>
<td>0 V ... 10 V, -10 V ... +10 V, 0 mA ... 20 mA, 4 mA ... 20 mA, Pt100/1000, Ni1000 (each input can be configured individually)</td>
</tr>
<tr>
<td>Channel input resistance</td>
<td>Voltage: &gt; 100 kΩ</td>
</tr>
<tr>
<td></td>
<td>Current: ca. 330 Ω</td>
</tr>
<tr>
<td>Time constant of the input filter</td>
<td>Voltage: 100 µs</td>
</tr>
<tr>
<td></td>
<td>Current: 100 µs</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 LED per channel (brightness depends on the value of the analog signal)</td>
</tr>
<tr>
<td>Conversion cycle</td>
<td>1 ms (for 4 inputs + 2 outputs); with RTDs Pt/ Ni... 1 s</td>
</tr>
<tr>
<td>Resolution</td>
<td>Range 0 V ... 10 V: 12 bits</td>
</tr>
<tr>
<td></td>
<td>Range -10 V ... +10 V: 12 bits including sign</td>
</tr>
<tr>
<td></td>
<td>Range 0 mA ... 20 mA: 12 bits</td>
</tr>
<tr>
<td></td>
<td>Range 4 mA ... 20 mA: 12 bits</td>
</tr>
<tr>
<td></td>
<td>Range RTD (Pt100, PT1000, Ni1000): +0.1 °C</td>
</tr>
<tr>
<td>Conversion error of the analog values</td>
<td>Typ. 0.5 %, max. 1 %</td>
</tr>
<tr>
<td>caused by non-linearity, adjustment</td>
<td>For XC version below 0 °C and above +60 °C: on request</td>
</tr>
<tr>
<td>error at factory and resolution within</td>
<td></td>
</tr>
<tr>
<td>the normal range</td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Relationship between input signal and hex code</td>
<td>% Chapter 5.2.4.5.1.2.10.2 “Input ranges resistance temperature detector” on page 898</td>
</tr>
<tr>
<td>Unused inputs</td>
<td>Are configured as “unused” (default value)</td>
</tr>
<tr>
<td>Overvoltage protection</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Technical data of the analog inputs, if used as digital inputs**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>Max. 4</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group of 4 channels</td>
</tr>
<tr>
<td>Connections of the channels AI0+ ... AI3+</td>
<td>Terminals 3.0... 3.3</td>
</tr>
<tr>
<td>Reference potential for the inputs</td>
<td>Terminals 1.9, 2.9, 3.9 and 4.9 (ZP)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 LED per channel</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-30 V ... +5 V</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>+5 V ... +13 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>+13 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 7 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>Typ. 1.4 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>Typ. 3.7 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 9 mA</td>
</tr>
<tr>
<td>Input resistance</td>
<td>ca. 3.5 kΩ</td>
</tr>
</tbody>
</table>

**Technical data of the analog outputs**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>2</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group for 2 channels</td>
</tr>
<tr>
<td>Connection of the channels AO0+ ... AO1+</td>
<td>Terminals 3.5 and 3.6</td>
</tr>
<tr>
<td>Reference potential for AO0+ ... AO1+</td>
<td>Terminal 3.7 (AO-) for voltage output Terminals 1.9, 2.9, 3.9 and 4.9 for current output</td>
</tr>
<tr>
<td>Output type</td>
<td>Current</td>
</tr>
<tr>
<td>Unipolar</td>
<td>Voltage</td>
</tr>
<tr>
<td>Bipolar</td>
<td></td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Against internal supply and other modules</td>
</tr>
<tr>
<td>Configurability</td>
<td>-10 V ... +10 V, 0 mA ... 20 mA, 4 mA ... 20 mA (each output can be configured individually)</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Output resistance (load), as current output</td>
<td>0 Ω … 500 Ω</td>
</tr>
<tr>
<td>Output loadability, as voltage output</td>
<td>± 10 mA max.</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>1 LED per channel (brightness depends on the value of the analog signal)</td>
</tr>
<tr>
<td>Resolution</td>
<td>12 bits including sign</td>
</tr>
<tr>
<td>Settling time for full range change (resistive load, output signal within specified tolerance)</td>
<td>Typ. 5 ms</td>
</tr>
<tr>
<td>Conversion error of the analog values caused by non-linearity, adjustment error at factory and resolution within the normal range</td>
<td>Typ. 0.5 %, max. 1 %</td>
</tr>
<tr>
<td>Relationship between input signal and hex code</td>
<td>§ Chapter 5.2.4.5.1.2.10.3 “Output ranges voltage and current” on page 899</td>
</tr>
<tr>
<td>Unused outputs</td>
<td>Are configured as &quot;unused&quot; (default value) and can be left open-circuited</td>
</tr>
</tbody>
</table>

Dimensions

The dimensions are in mm and in brackets in inch.
### Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 250 800 R0001</td>
<td>DA502, digital/analog input/output module, 16 DO, 8 DC, 4 AI, 2 AO</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 450 800 R0001</td>
<td>DA502-XC, digital/analog input/output module, 16 DO, 8 DC, 4 AI, 2 AO, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

---

### 5.2.4.6 Function modules

#### 5.2.4.6.1 S500 and S500-XC

**CD522 - Encoder, counter and PWM module**

**Features**

- 2 encoder inputs with 2 integrated 5-V-power-supplies for the encoders
- 2 PWM outputs - 2 digital inputs 24 V DC
- 8 configurable digital inputs/outputs 24 V DC
- Fast counter
- Module-wise galvanically isolated
- XC version for use in extreme ambient conditions available
1 I/O bus
2 Allocation of terminal No. and signal name
3 3 yellow LEDs to display the signal states of the encoder 0 input
4 3 yellow LEDs to display the signal states of the encoder 1 input
5 2 green LEDs to display the 5-V-power-supply states
6 2 yellow LEDs to display the signal state of the digital input I3 and I11
7 8 yellow LEDs to display the input/output signal states
8 2 yellow LEDs to display the signal states of the PWM/pulse outputs
9 1 green LED to display the process voltage UP
10 3 red LEDs to display errors
11 Label
12 Terminal unit
13 DIN rail
14 Sign for XC version

**Intended purpose**

The encoder and PWM module CD522 can be used at the following devices:

- Communication interface modules (e.g. CI501-PNIO, CI541-DP)
- Processor modules

**Features:**

- 2 independent counting functions with up to 12 configurable modes (including incremental position encoder and frequency input up to 300 kHz)
- 2 independent PWM (pulse-width modulator) or pulse outputs with push-pull driver
- Dedicated inputs/outputs for specific counting functions (e.g. touch, set, reset)
- All unused inputs/outputs can be used with the specifications of standard inputs/outputs range

For use in extreme ambient conditions (e.g. wider temperature and humidity range), a special XC version of the device is available.

Depending on the configuration used, some inputs and outputs are dedicated to specific counting functions (touch, set, reset...). All unused inputs and outputs can be used with the specification of standard inputs/outputs range.

**Functionality**

<table>
<thead>
<tr>
<th>Digital inputs/outputs</th>
<th>24 V DC, dedicated inputs/outputs can be used for specific counting functions:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- Catch/touch operation, counter value stored in separate variable on external event (rising or falling edge)</td>
</tr>
<tr>
<td></td>
<td>- Set input to preset counter register with predefined value</td>
</tr>
<tr>
<td></td>
<td>- Set input to reset counter register</td>
</tr>
<tr>
<td></td>
<td>- End value output; the output is set when predefined value is reached</td>
</tr>
<tr>
<td></td>
<td>- Reference point initialization (RPI) input for incremental encoder initialization</td>
</tr>
</tbody>
</table>

All unused inputs/outputs can be used with the specification of standard input/output range.

Effect of incorrect input terminal connection: Wrong or no signal detected, no damage up to 35 V.

<table>
<thead>
<tr>
<th>Fast counter/encoder</th>
<th>integrated, 2 counters (hardware interface with +24 V DC, +5 V DC, differential and 1 Vpp sinus input) with up to 12 configurable operation modes:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- 32 bits one counter mode</td>
</tr>
<tr>
<td></td>
<td>- 16 bits two counter mode</td>
</tr>
<tr>
<td></td>
<td>- Incremental position encoder</td>
</tr>
<tr>
<td></td>
<td>- Absolute SSI encoder</td>
</tr>
<tr>
<td></td>
<td>- Time frequency meter</td>
</tr>
<tr>
<td></td>
<td>- Frequency input up to 300 kHz</td>
</tr>
</tbody>
</table>
PWM/pulse outputs 2 pulse-width-modulators or pulse outputs

Output specification
- Push-pull output: 24 V DC, 100 mA max.
- Current limitation (thermal and over current)

PWM specification
- Frequency from 1 Hz to 100 kHz
- Value from 0 to 100 %

Pulse specification
- Frequency from 1 Hz to 15 kHz
- Pulse emission from 1 to 65535 pulses
- Number of pulses emitted indicator (0 to 100 %)

Frequency specification
- Frequency output = 100 kHz when duty cycle set to 50 %

Power supply for encoders 2 5V power supplies, max. 100 mA

LED displays For signal states, errors and supply voltage

Internal power supply Via I/O bus

External power supply Via the terminals UP (process voltage 24 V DC) and ZP (0 V DC)

Required terminal unit TU515 or TU516 & Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938

How to prepare a device as fast counter and how to connect it to the PLC is described in an application example.

Connections

The function module CD522 can be connected to the following devices via the I/O bus connector:
- CS31 bus module DC551-CS31
- AC500 CPU
- Other AC500 I/O devices.

The connection is carried out by using the 40 terminals of the terminal unit TU515/TU516 & Chapter 5.2.5.2 “TU515, TU516, TU541 and TU542 for I/O modules” on page 938.

Table 206: Assignment of the terminals

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>/A0</td>
<td>Inverted input signal A of encoder 0</td>
</tr>
<tr>
<td>1.1</td>
<td>/B0</td>
<td>Inverted input signal B of encoder 0</td>
</tr>
<tr>
<td>1.2</td>
<td>/Z0</td>
<td>Inverted input signal Z of encoder 0</td>
</tr>
<tr>
<td>1.3</td>
<td>5V0</td>
<td>+5 V DC power supply output 0 for sensors</td>
</tr>
<tr>
<td>1.4</td>
<td>0V</td>
<td>0 V reference input</td>
</tr>
<tr>
<td>1.5</td>
<td>O0</td>
<td>Output signal of the fast output O0</td>
</tr>
<tr>
<td>1.6</td>
<td>0V</td>
<td>0 V reference input</td>
</tr>
<tr>
<td>1.7</td>
<td>O1</td>
<td>Output signal of the fast output O1</td>
</tr>
<tr>
<td>Terminal</td>
<td>Signal</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>1.8</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>1.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
<tr>
<td>2.0</td>
<td>A0</td>
<td>Input signal A of encoder 0</td>
</tr>
<tr>
<td>2.1</td>
<td>B0</td>
<td>Input signal B of encoder 0</td>
</tr>
<tr>
<td>2.2</td>
<td>Z0</td>
<td>Input signal Z of encoder 0</td>
</tr>
<tr>
<td>2.3</td>
<td>I3</td>
<td>Input signal I3 (standard input)</td>
</tr>
<tr>
<td>2.4 ... 2.7</td>
<td>C4 ... C7</td>
<td>Signal of the configurable digital input/output C4 ... C7</td>
</tr>
<tr>
<td>2.8</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>2.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
<tr>
<td>3.0</td>
<td>/A1</td>
<td>Inverted input signal A of encoder 1</td>
</tr>
<tr>
<td>3.1</td>
<td>/B1</td>
<td>Inverted input signal B of encoder 1</td>
</tr>
<tr>
<td>3.2</td>
<td>/Z1</td>
<td>Inverted input signal Z of encoder 1</td>
</tr>
<tr>
<td>3.3</td>
<td>5V1</td>
<td>+5 V DC power supply output 1 for sensors</td>
</tr>
<tr>
<td>3.4 ... 3.7</td>
<td>0V</td>
<td>0 V reference input</td>
</tr>
<tr>
<td>3.8</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>3.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
<tr>
<td>4.0</td>
<td>A1</td>
<td>Input signal A of encoder 1</td>
</tr>
<tr>
<td>4.1</td>
<td>B1</td>
<td>Input signal B of encoder 1</td>
</tr>
<tr>
<td>4.2</td>
<td>Z1</td>
<td>Input signal Z of encoder 1</td>
</tr>
<tr>
<td>4.3</td>
<td>I11</td>
<td>Input signal I11 (standard input)</td>
</tr>
<tr>
<td>4.4 ... 4.7</td>
<td>C12 ... C15</td>
<td>Signal of the configurable digital input/output C12 ... C15</td>
</tr>
<tr>
<td>4.8</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>4.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
</tbody>
</table>

The internal power supply voltage for the module's circuitry is carried out via the I/O bus (provided by a communication interface module or a processor module). Thus, the current consumption from 24 V DC power supply at the terminals L+/UP and M/ZP of the CPU/communication interface module increases by 2 mA per CD522.

The external power supply connection is carried out via the UP (+24 V DC) and the ZP (0 V DC) terminals.
**WARNING!**

**Removal/Insertion under power**

The devices are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you

– connect or disconnect any signal or terminal block
– remove, mount or replace a module.

Disconnecting any powered devices while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The devices must not be opened when in operation. The same applies to the network interfaces.

**NOTICE!**

**Risk of damaging the PLC modules!**

Overvoltages and short circuits might damage the PLC modules.

– Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
– Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

**Connection of encoders with differential RS-422 signal**

The encoder is powered by the 5 V power supply which is integrated in CD522.

![Diagram of encoder connection](image-url)
The encoder is powered by the 5 V power supply which is integrated in the CD522.

Connection of encoders with 5 V TTL signal

Connection of encoders with 24 V totem pole signal
The wires A, B and Z need not to be connected to the module. They are left open.

When using different power supplies for the encoder device and the CD522, make sure that the reference potentials of both power supplies are interconnected.

Connection of encoders with 1 Vpp sine signal

The encoder is powered through the 5 V power supply which is integrated in the CD522.

Connection of absolute encoders with SSI interface and differential RS-422 signal

The encoder is powered by the 5 V power supply which is integrated in the CD522.
Connection of absolute encoders with an SSI interface and an optocoupler interface at CLK input

The encoder can optionally be powered by the 5 V power supply which is integrated in the CD522.
Connection of output loads to the PWM/Pulse outputs

Notice!
Risk of damaging the module
The PWM outputs have no protection against reverse polarity.

Connection of standard inputs/outputs
Proceed with the inputs/outputs I11 and C12 ... C15 in the same way.

Connection of sensors with frequency outputs
Proceed with the A0, B0, A1, B1 and Z1 in the same way.
Fig. 166: Example of the connection of sensors with frequency outputs to the input Z0 of the CD522

NOTICE!
Risk of malfunctions!
The edges of a signal must be strong enough (0.4 V/µs) to be recognized correctly by the module.
Put a 1 kΩ resistor between 0 V and the Z terminal when using a standard output as time generator.

Connection of sensors to the 5 V power supply

Proceed with the 5 V power supply 1 in the same way.

Each 5-V-power supply provides a current of 100 mA max. It is possible to parallel both integrated power supplies. In this case, the max. current is 200 mA.
NOTICE!
Risk of damaging the module
The integrated 2 A fuse cannot be replaced. If it blows, the module must be replaced.
Ensure that the current per 0 V connection does not exceed 0.5 A.

NOTICE!
Risk of damaging the module
The two 5 V outputs have no protection against reverse polarity.

Internal data exchange

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital inputs (bytes)</td>
<td>0</td>
</tr>
<tr>
<td>Digital outputs (bytes)</td>
<td>0</td>
</tr>
<tr>
<td>Analog inputs (words)</td>
<td>12</td>
</tr>
<tr>
<td>Analog outputs (words)</td>
<td>16</td>
</tr>
</tbody>
</table>

The data will be transferred in 16-bit words and not in bytes. Two bytes are packed into one 16-bit word.
The bit strings are transmitted in big-endian byte order, so the bytes within the word are swapped. If several bytes are considered, the first byte (lowest address) is the largest (High Byte).

If used with AC500 please check the chapter how to configure CD522 within Automation Builder and use the CD522 library.

The types “structCD522In” and “structCD522Out” can be added in Automation Builder by using the command “Generate DUT” via the context menu of the CD522 device.
To use CD522 with CI50x-PNIO or CI54x-DP as unbundled IOs with other PLCs find the meaning of the IO-Data in following tables below:

### From CD522 to PLC

<table>
<thead>
<tr>
<th>TYPE structCD522In</th>
</tr>
</thead>
<tbody>
<tr>
<td>STRUCT</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>StateBytePWM0</td>
</tr>
<tr>
<td>High Byte</td>
</tr>
<tr>
<td>0..100</td>
</tr>
<tr>
<td>Percentage of pulses already sent on channel 0</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>StateBytePWM1</td>
</tr>
<tr>
<td>Low Byte</td>
</tr>
<tr>
<td>0..100</td>
</tr>
<tr>
<td>Percentage of pulses already sent on channel 1</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>StateByteC0</td>
</tr>
<tr>
<td>High Byte</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>InputC0</td>
</tr>
<tr>
<td>Low Byte</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Input A 0</td>
</tr>
<tr>
<td>Input B 1</td>
</tr>
<tr>
<td>Input Z 2</td>
</tr>
<tr>
<td>Input I3 3</td>
</tr>
<tr>
<td>Input I4 4</td>
</tr>
<tr>
<td>Input I5 5</td>
</tr>
<tr>
<td>Input I6 6</td>
</tr>
<tr>
<td>Input I7 7</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>TouchCounterHiC0</td>
</tr>
<tr>
<td>WORD</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>TouchCounterLoC0</td>
</tr>
<tr>
<td>WORD</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>CounterHiC0</td>
</tr>
<tr>
<td>WORD</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>CounterLoC0</td>
</tr>
<tr>
<td>WORD</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>CounterHiC1</td>
</tr>
<tr>
<td>WORD</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>CounterLoC1</td>
</tr>
<tr>
<td>WORD</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>ReservedWC1</td>
</tr>
<tr>
<td>WORD</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>StateByteC1</td>
</tr>
<tr>
<td>High Byte</td>
</tr>
<tr>
<td>*)</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>InputC1</td>
</tr>
<tr>
<td>Low Byte</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Input A 0</td>
</tr>
<tr>
<td>Input B 1</td>
</tr>
<tr>
<td>Input Z 2</td>
</tr>
<tr>
<td>Input I3 3</td>
</tr>
<tr>
<td>Input I4 4</td>
</tr>
<tr>
<td>Input I5 5</td>
</tr>
</tbody>
</table>
**TYPE structCD522In**

<table>
<thead>
<tr>
<th></th>
<th>Input I6</th>
<th>6</th>
<th>Digital Input I6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Touch-CounterHiC1</td>
<td>WORD</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Touch-CounterLoC1</td>
<td>WORD</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**END_STRUCT**

**END_TYPE**

**Table 207: *) Status Byte C0/C1**

<table>
<thead>
<tr>
<th>Bit</th>
<th>One Counter Modes (1,2,5,6,11,12,13,14)</th>
<th>Two Counter Modes (3,4)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>CF0</td>
<td>not used</td>
</tr>
<tr>
<td></td>
<td>1=End value 0 reached</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>not used</td>
<td>not used</td>
</tr>
<tr>
<td>2</td>
<td>NCATCH</td>
<td>not used</td>
</tr>
<tr>
<td></td>
<td>1=New catch available</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>OVRFLW0</td>
<td>OVRFLW0</td>
</tr>
<tr>
<td></td>
<td>1=Counter 0 overflow (see Note 3 below)</td>
<td>1=Counter 0 overflow (0x0000 ←→ 0xFFFF)</td>
</tr>
<tr>
<td>4</td>
<td>SET0_INPUT</td>
<td>OVRFNW1</td>
</tr>
<tr>
<td></td>
<td>Logical OR on all inputs configured as set0 input</td>
<td>1=Counter 1 overflow (0x0000 ←→ 0xFFFF)</td>
</tr>
<tr>
<td>5</td>
<td>RESET0_INPUT</td>
<td>RESETO_INPUT</td>
</tr>
<tr>
<td></td>
<td>Logical OR on all inputs configured as reset0 input</td>
<td>Logical OR on all inputs configured as reset0 input</td>
</tr>
<tr>
<td>6</td>
<td>not used</td>
<td>not used</td>
</tr>
<tr>
<td>7</td>
<td>not used</td>
<td>not used</td>
</tr>
</tbody>
</table>

**Bit**

<table>
<thead>
<tr>
<th>16-bit One Counter Mode (8)</th>
<th>Time frequency meter mode (15)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>CF0</td>
</tr>
<tr>
<td></td>
<td>1=Zero crossover detected</td>
</tr>
<tr>
<td>1</td>
<td>not used</td>
</tr>
<tr>
<td>2</td>
<td>NCATCH</td>
</tr>
<tr>
<td></td>
<td>1=New catch available</td>
</tr>
<tr>
<td>3</td>
<td>not used</td>
</tr>
<tr>
<td>4</td>
<td>SET0_INPUT</td>
</tr>
<tr>
<td></td>
<td>Logical OR on all inputs configured as set0 input</td>
</tr>
</tbody>
</table>
### Bit 16-bit One Counter Mode (8) Time frequency meter mode (15)

<table>
<thead>
<tr>
<th>Bit</th>
<th>Description</th>
<th>Time frequency meter mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>RESET0_INPUT Logical OR on all inputs configured as reset0 input</td>
<td>not used</td>
</tr>
<tr>
<td>6</td>
<td>not used</td>
<td>not used</td>
</tr>
<tr>
<td>7</td>
<td>not used</td>
<td>NEW 1=New timing value available</td>
</tr>
</tbody>
</table>

---

### From PLC to CD522

#### TYPE structCD522Out

**STRUCT**

<table>
<thead>
<tr>
<th>FIELD</th>
<th>TYPE</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FreqPWM0</td>
<td>WORD</td>
<td>0…65535 PWM frequency of channel 0</td>
</tr>
<tr>
<td>DutyPulsePWM0</td>
<td>WORD</td>
<td>0…1000 PWM mode:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PWM duty cycle of channel 0 in 1/10 percentage</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0…65535 Pulse mode:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Number of pulses to sent on channel 0</td>
</tr>
<tr>
<td>ControlPWM0</td>
<td>High Bit</td>
<td>Bit Description</td>
</tr>
<tr>
<td></td>
<td>Low Byte</td>
<td>0 FREQU_X10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FREQU_X10 1 = Frequency multiplier x10 enabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 not used</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 not used</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 PULSE_START</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Rising edge = Start pulse emission channel 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4 not used</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5 not used</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6 not used</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7 1 = Enable Pulse/PWM channel 0</td>
</tr>
<tr>
<td>ReservedBPWM0</td>
<td>Low Byte</td>
<td></td>
</tr>
<tr>
<td>ReservedWPWM0</td>
<td>WORD</td>
<td></td>
</tr>
<tr>
<td>FreqPWM1</td>
<td>WORD</td>
<td>0…65535 PWM frequency of channel 1</td>
</tr>
<tr>
<td>DutyPulsePWM1</td>
<td>WORD</td>
<td>0…1000 PWM mode:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PWM duty cycle of channel 1 in 1/10 percentage</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0…65535 Pulse mode:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Number of pulses to sent on channel 1</td>
</tr>
<tr>
<td>ControlPWM1</td>
<td>High Byte</td>
<td>Bit Description</td>
</tr>
</tbody>
</table>

---
Table 208: **) Counter Control Byte C0/C1

<table>
<thead>
<tr>
<th>Bit</th>
<th>One Counter Modes (1,2,5,6,8)</th>
<th>Two Counter Modes (3,4)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>EN</td>
<td>EN</td>
</tr>
<tr>
<td></td>
<td>0=count counter disabled</td>
<td>0=count counter disabled</td>
</tr>
<tr>
<td></td>
<td>1=count counter enabled</td>
<td>1=count counter enabled</td>
</tr>
<tr>
<td>1</td>
<td>SET_0</td>
<td>not used</td>
</tr>
<tr>
<td></td>
<td>1=set counter 0</td>
<td></td>
</tr>
<tr>
<td>Bit</td>
<td>One Counter Modes (1,2,5,6,8)</td>
<td>Two Counter Modes (3,4)</td>
</tr>
<tr>
<td>-----</td>
<td>-----------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>2</td>
<td>RESET_0</td>
<td>RESET_0</td>
</tr>
<tr>
<td></td>
<td>1=reset counter 0</td>
<td>1=reset counter 0</td>
</tr>
<tr>
<td>3</td>
<td>not used</td>
<td>UP_DWN0</td>
</tr>
<tr>
<td></td>
<td>0=up counter 0</td>
<td>0=up counter 0</td>
</tr>
<tr>
<td></td>
<td>1=down counter</td>
<td>1=down counter 0</td>
</tr>
<tr>
<td>4</td>
<td>not used</td>
<td>RESET_1</td>
</tr>
<tr>
<td></td>
<td>1=reset counter 1</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>UPDWN</td>
<td>UP_DWN1</td>
</tr>
<tr>
<td></td>
<td>0=up counter</td>
<td>0=up counter 1</td>
</tr>
<tr>
<td></td>
<td>1=down counter</td>
<td>1=down counter 1</td>
</tr>
<tr>
<td>6</td>
<td>NCATCH</td>
<td>NCATCH</td>
</tr>
<tr>
<td></td>
<td>0=no catch operation</td>
<td>0=no catch operation</td>
</tr>
<tr>
<td></td>
<td>1=enable next catch operation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1=enable next catch operation</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>EDGECATCH</td>
<td>EDGECATCH</td>
</tr>
<tr>
<td></td>
<td>0=catch on falling edge</td>
<td>0=catch on falling edge</td>
</tr>
<tr>
<td></td>
<td>1=catch on rising edge</td>
<td>1=catch on rising edge</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Bit</th>
<th>Relative encoder modes (Modes 11,12,13)</th>
<th>Time frequency meter (Mode 15)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>EN</td>
<td>EN</td>
</tr>
<tr>
<td></td>
<td>0=counter disabled</td>
<td>0=counter disabled</td>
</tr>
<tr>
<td></td>
<td>1=counter enabled</td>
<td>1=counter enabled</td>
</tr>
<tr>
<td>1</td>
<td>SET_0</td>
<td>EN_1_0</td>
</tr>
<tr>
<td></td>
<td>1=set counter 0</td>
<td>1=enable time capture on falling edge</td>
</tr>
<tr>
<td>2</td>
<td>RESET_0</td>
<td>EN_0_1</td>
</tr>
<tr>
<td></td>
<td>1=reset counter 0</td>
<td>1=enable time capture on rising edge</td>
</tr>
<tr>
<td>3</td>
<td>not used</td>
<td>FREQ_0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0=time measure mode</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1=frequency and RPM measure mode</td>
</tr>
<tr>
<td>4</td>
<td>RPI, Reference Point Indicator</td>
<td>RESET_NEW</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1=time/frequency/RPM measurement is in reset. NEW flag is cleared.</td>
</tr>
<tr>
<td>5</td>
<td>not used</td>
<td>not used</td>
</tr>
<tr>
<td>6</td>
<td>NCATCH</td>
<td>not used</td>
</tr>
<tr>
<td></td>
<td>0=no catch operation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1=enable next catch operation</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>EDGECATCH</td>
<td>not used</td>
</tr>
<tr>
<td></td>
<td>0=catch on falling edge</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1=catch on rising edge</td>
<td></td>
</tr>
</tbody>
</table>
**I/O configuration**

The module itself does not store configuration data. It receives its parameterization data from the master device of the I/O bus (CPU or communication interface module) during power-up of the system.

Hence, replacing I/O modules is possible without any re-parameterization via software.

*If the external power supply voltage via UP/ZP terminals fails, the I/O module loses its configuration data. The whole station has to be switched off and on again to re-configure the module.*

**Parameterization**

<table>
<thead>
<tr>
<th>Firmware version</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firmware version &gt; V2.0.0</td>
<td>The arrangement of the parameter data is performed by Control Builder Plus/Automation Builder software.</td>
</tr>
</tbody>
</table>

The parameter data directly influences the functionality of modules.

For non-standard applications, it is necessary to adapt the parameters to your system configuration.

Module: Module slot address: Y = 1 ... 10

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, Type</th>
<th>Default</th>
<th>Min.</th>
<th>Max.</th>
<th>EDS Slot Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Intern</td>
<td>1805 1)</td>
<td>WORD</td>
<td>0x070D</td>
<td>0</td>
<td>65535</td>
<td>0x0Y01</td>
</tr>
<tr>
<td>Ignore module 2)</td>
<td>No</td>
<td>0</td>
<td>BYTE</td>
<td>No</td>
<td>0x00</td>
<td>Not for FBP</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Value</td>
<td>Internal value</td>
<td>Internal value, Type</td>
<td>Default</td>
<td>Min.</td>
<td>Max.</td>
<td>EDS Slot Index</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------</td>
<td>----------------</td>
<td>----------------------</td>
<td>---------</td>
<td>------</td>
<td>------</td>
<td>----------------</td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal</td>
<td>42 BYTE</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>255</td>
<td>xx02 3)</td>
</tr>
<tr>
<td>Check supply</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>On</td>
<td>0x01</td>
<td></td>
<td>0x0Y03</td>
</tr>
<tr>
<td>Input delay</td>
<td>0.1 ms</td>
<td>0</td>
<td>BYTE</td>
<td>8 ms</td>
<td>0x02</td>
<td>3</td>
<td>0x0Y04</td>
</tr>
<tr>
<td>Mode</td>
<td>see table below</td>
<td>0 BYTE</td>
<td>0x00</td>
<td>0</td>
<td>15</td>
<td></td>
<td>0x0Y05</td>
</tr>
<tr>
<td>Counter 0 frequency limit</td>
<td>No filter</td>
<td>0</td>
<td>BYTE</td>
<td>No filter</td>
<td>0x00</td>
<td>4</td>
<td>0x0Y06</td>
</tr>
<tr>
<td>Counter 0 input level</td>
<td>0-24 V DC</td>
<td>0</td>
<td>BYTE</td>
<td>0-24 V DC</td>
<td>0x00</td>
<td>3</td>
<td>0X0Y07</td>
</tr>
<tr>
<td>SSI 0 frequency</td>
<td>200 kHz</td>
<td>2</td>
<td>BYTE</td>
<td>200 kHz</td>
<td>0x02</td>
<td>4</td>
<td>0x0Y08</td>
</tr>
<tr>
<td>SSI 0 resolution (in bit)</td>
<td>8 to 32 bit</td>
<td>3</td>
<td>BYTE</td>
<td>16 bit</td>
<td>8</td>
<td>32</td>
<td>0x0Y09</td>
</tr>
<tr>
<td>SSI 0 code type</td>
<td>Binary</td>
<td>0</td>
<td>BYTE</td>
<td>Binary</td>
<td>0</td>
<td>0</td>
<td>0x0Y0A</td>
</tr>
<tr>
<td>SSI 0 polling time</td>
<td>10 ms</td>
<td>10</td>
<td>BYTE</td>
<td>10</td>
<td>1</td>
<td>255</td>
<td>0x0Y0B</td>
</tr>
<tr>
<td>5 V sensor 0 supply</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>Off</td>
<td>0x00</td>
<td>1</td>
<td>0x0Y0C</td>
</tr>
<tr>
<td>Mode</td>
<td>see table below</td>
<td>0 BYTE</td>
<td>0x00</td>
<td>0</td>
<td>15</td>
<td></td>
<td>0x0Y0D</td>
</tr>
<tr>
<td>Counter 1 frequency limit</td>
<td>No filter</td>
<td>0</td>
<td>BYTE</td>
<td>No filter</td>
<td>0x00</td>
<td>4</td>
<td>0x0Y0E</td>
</tr>
<tr>
<td>Name</td>
<td>Value</td>
<td>Internal value</td>
<td>Internal value, Type</td>
<td>Default</td>
<td>Min.</td>
<td>Max.</td>
<td>EDS Slot Index</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>------------------------------------------</td>
<td>----------------</td>
<td>---------------------</td>
<td>--------------------------</td>
<td>------</td>
<td>------</td>
<td>----------------</td>
</tr>
<tr>
<td>Counter 1 input level</td>
<td>0-24 V DC 0-5 V DC Differential 1 Vpp sinus</td>
<td>0 1 2 3</td>
<td>BYTE</td>
<td>0-24 V DC 0x00</td>
<td>0</td>
<td>3</td>
<td>0x0Y0F</td>
</tr>
<tr>
<td>SSI 1 frequency</td>
<td>200 kHz 500 kHz 1 MHz</td>
<td>2 3 4</td>
<td>BYTE</td>
<td>200 kHz 0x02</td>
<td>2</td>
<td>4</td>
<td>0x0Y10</td>
</tr>
<tr>
<td>SSI 1 resolution (in bit)</td>
<td>8 to 32 bit</td>
<td></td>
<td>BYTE</td>
<td>16 bit 16</td>
<td>8</td>
<td>32</td>
<td>0x0Y11</td>
</tr>
<tr>
<td>SSI 1 code type</td>
<td>Binary</td>
<td>0</td>
<td>BYTE</td>
<td>Binary 0</td>
<td>0</td>
<td>0</td>
<td>0x0Y12</td>
</tr>
<tr>
<td>SSI 1 polling time</td>
<td>10 ms</td>
<td></td>
<td>BYTE</td>
<td>10</td>
<td>1</td>
<td>255</td>
<td>0x0Y13</td>
</tr>
<tr>
<td>5 V sensor 1 supply</td>
<td>Off On</td>
<td>0</td>
<td>BYTE</td>
<td>Off 0x00</td>
<td>0</td>
<td>1</td>
<td>0x0Y14</td>
</tr>
<tr>
<td>Detection SC on sensors</td>
<td>Off On</td>
<td>0</td>
<td>BYTE</td>
<td>Off 0x00</td>
<td>0</td>
<td>1</td>
<td>0x0Y15</td>
</tr>
<tr>
<td>Output behaviour com fault</td>
<td>Off Last value Substitute Last value 5s Substitute 5s Last value 10s Substitute 10s</td>
<td>0 1 2 3 4 5 6</td>
<td>BYTE</td>
<td>Off 0x00</td>
<td>0</td>
<td>1</td>
<td>0x0Y16</td>
</tr>
<tr>
<td>Substitute value</td>
<td>0</td>
<td>0</td>
<td>WORD</td>
<td>Default 0x0000</td>
<td>0</td>
<td>65536</td>
<td>0x0Y17</td>
</tr>
</tbody>
</table>

1) With CS31 and addresses smaller than 70 and FBP, the value is increased by 1
2) Not with FBP
3) Value is hexadecimal: HighByte is slot (xx: 1 ... 10), LowByte is index (1 ... n)

Table 209: Operating modes for counters 0 and 1, configuration table

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes of counter</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No counter / No PWM (default value)</td>
</tr>
<tr>
<td>1</td>
<td>1-1 UpDown counter (A)</td>
</tr>
<tr>
<td>2</td>
<td>2-1 UpDown with release input</td>
</tr>
<tr>
<td>Internal value</td>
<td>Operating modes of counter</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>3</td>
<td>3-2 UpDown counters (A, B)</td>
</tr>
<tr>
<td>4</td>
<td>4-2 UpDown (A, B on falling edges)</td>
</tr>
<tr>
<td>5</td>
<td>5-1 UpDown dynamic set (B) / rising edge</td>
</tr>
<tr>
<td>6</td>
<td>6-1 UpDown dynamic set (B) / falling edge</td>
</tr>
<tr>
<td>7</td>
<td>Not used</td>
</tr>
<tr>
<td>8</td>
<td>8-1 UpDown with release (B), 0 cross detection</td>
</tr>
<tr>
<td>9 - 19</td>
<td>Not used</td>
</tr>
<tr>
<td>20</td>
<td>11-1 Incremental encoder</td>
</tr>
<tr>
<td>21</td>
<td>12-2 Incremental encoder X2</td>
</tr>
<tr>
<td>22</td>
<td>13-1 Incremental encoder X4</td>
</tr>
<tr>
<td>30</td>
<td>14-1 SSI, absolute encoder</td>
</tr>
<tr>
<td>40</td>
<td>15-1 Time frequency meter</td>
</tr>
</tbody>
</table>

**Table 210: GSD file**

```
Ext_User_Prm_Data_Len = 25
Ext_User_Prm_Data_Const(0) = 0x07, 0x0E, 0x17, \n                             0x01, 0x02, \n                             0x00, 0x00, 0x00, 0x02, 0x10, 0x00, 0x0A, \n                             0x00, \n                             0x00, 0x00, 0x02, 0x10, 0x00, 0x0A, \n                             0x00, \n                             0x00, 0x00, 0x00, 0x00;
```

**Diagnosis**

<table>
<thead>
<tr>
<th>E1...E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier 000 ... 063</th>
<th>AC500 display</th>
<th>← Display in</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>14</td>
<td>1...10</td>
<td>31</td>
<td>31</td>
<td>19</td>
<td>Checksum error in the I/O module</td>
<td>PS501 PLC browser</td>
</tr>
<tr>
<td></td>
<td>11 / 12 ADR</td>
<td>1...10</td>
<td>3</td>
<td>3</td>
<td>9</td>
<td>Overflow diagnosis buffer</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1...10</td>
<td>31</td>
<td>31</td>
<td>26</td>
<td>Parameter error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>11 / 12 ADR</td>
<td>1...10</td>
<td>3</td>
<td>3</td>
<td>9</td>
<td>New start</td>
<td></td>
</tr>
<tr>
<td>Class</td>
<td>Interface</td>
<td>Device</td>
<td>Module</td>
<td>Channel</td>
<td>Error identifier</td>
<td>Error message</td>
<td>Remedy</td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>--------</td>
<td>--------</td>
<td>---------</td>
<td>-----------------</td>
<td>---------------</td>
<td>--------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1)</td>
<td>2)</td>
<td>3)</td>
<td>4)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1...10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>1...10</td>
<td>31</td>
<td>31</td>
<td>11</td>
<td>Process voltage too low</td>
<td>Check process voltage</td>
</tr>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1...10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 211: Channel error CD522

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1)</td>
<td>2)</td>
<td>3)</td>
<td>4)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1...10</td>
<td>1</td>
<td>0...15</td>
<td>47</td>
<td>Output short circuit</td>
<td>Check output connection or terminal</td>
</tr>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1...10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1...10</td>
<td>1</td>
<td>0, 1, 8, 9</td>
<td>10</td>
<td>Input frequency too high</td>
<td>Check frequency filter parameter or sensor</td>
</tr>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1...10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1...10</td>
<td>1</td>
<td>0, 1</td>
<td>2</td>
<td>PWM frequency too high</td>
<td>Clamp min/max value in program</td>
</tr>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1...10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1...10</td>
<td>1</td>
<td>0, 1</td>
<td>10</td>
<td>PWM duty cycle out of range (0-1000)</td>
<td>Clamp min value to 0 in program</td>
</tr>
<tr>
<td>11 / 12</td>
<td>ADR</td>
<td>1...10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>14</td>
<td>1...10</td>
<td>1</td>
<td>0, 1</td>
<td>11</td>
<td>5 V sensor supply too low</td>
<td>Check wiring &amp; sensor power</td>
</tr>
<tr>
<td>Class</td>
<td>Interface</td>
<td>Device</td>
<td>Module</td>
<td>Channel</td>
<td>Error identifier</td>
<td>Error message</td>
<td>Remedy</td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>--------</td>
<td>--------</td>
<td>---------</td>
<td>-----------------</td>
<td>--------------</td>
<td>--------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Remarks:

1) In AC500, the following interface identifier applies:
   14 = I/O bus, 11 = COM1 (e.g. CS31 bus), 12 = COM2.
   The FBP diagnosis block does not contain this identifier.

2) With "Device" the following allocation applies:
   31 = module itself, 1...10 = decentralized communication interface module 1...10,
   ADR = hardware address (e.g. of the DC551)

3) With "Module" the following allocation applies depending on the master:
   Module error: I/O bus or FBP: 31 = module itself; COM1/COM2: 1...10 = expansion 1...10
   Channel error: I/O bus or FBP = module type (2 = DO); COM1/COM2: 1...10 = expansion 1...10

4) In case of module errors, with channel "31 = Module itself" is output.

State LEDs

During the power-on procedure, the module initializes automatically. All LEDs (except the LEDs for the signal states) are on during the initialization.
### Technical data

The system data of AC500 and S500 are applicable to the standard version \textcopyright{Chapter 5.1.2 “System data AC500” on page 166.}

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = OFF</th>
<th>LED = ON</th>
<th>LED flashes</th>
</tr>
</thead>
<tbody>
<tr>
<td>A0, B0, Z0</td>
<td>Encoder 0 inputs</td>
<td>Yellow</td>
<td>Input ON</td>
<td>Input OFF</td>
<td>LED follows the state of the inputs, depending on frequency</td>
</tr>
<tr>
<td>A1, B1, Z1</td>
<td>Encoder 1 inputs</td>
<td>Yellow</td>
<td>Input ON</td>
<td>Input OFF</td>
<td>LED follows the state of the inputs, depending on frequency</td>
</tr>
<tr>
<td>I3 and I11</td>
<td>Digital inputs</td>
<td>Yellow</td>
<td>Input = ON (the input voltage is even displayed if the supply voltage is OFF).</td>
<td>Input = OFF</td>
<td>---</td>
</tr>
<tr>
<td>C4 ... C7 and C12 ... C15</td>
<td>Configurable digital inputs/outputs</td>
<td>Yellow</td>
<td>Input/output = ON (the input voltage is even displayed if the supply voltage is OFF).</td>
<td>Input/output = OFF</td>
<td>---</td>
</tr>
<tr>
<td>O0 and O1</td>
<td>Digital PWM outputs</td>
<td>Yellow</td>
<td>Output = ON</td>
<td>Output = OFF</td>
<td>LED follows the state of the outputs, depending on frequency and operation mode</td>
</tr>
<tr>
<td>5V0 and 5V1</td>
<td>Power supply for encoders</td>
<td>Green</td>
<td>Configuration ON and power 5-V power ready</td>
<td>Configuration OFF or power failure</td>
<td>Power supply outputs are short-circuited</td>
</tr>
<tr>
<td>UP</td>
<td>Process supply voltage</td>
<td>Green</td>
<td>Process voltage OK</td>
<td>Process voltage is missing</td>
<td>---</td>
</tr>
<tr>
<td>CH-ERR1, CH-ERR2, CH-ERR4</td>
<td></td>
<td>Red</td>
<td>Severe error within the corresponding group</td>
<td>No error or process voltage is missing</td>
<td>Error on one channel of the corresponding group (e.g. short circuit at an output)</td>
</tr>
<tr>
<td>CH-ERR *)</td>
<td>Error indication</td>
<td>Red</td>
<td>Internal error or configuration is not loaded</td>
<td>---</td>
<td>---</td>
</tr>
</tbody>
</table>

*) All LEDs CH-ERR1, CH-ERR2 and CH-ERR4 light up simultaneously
The system data of AC500-XC are applicable to the XC version, Chapter 5.1.3 “System data AC500-XC” on page 169.

Only additional details are therefore documented below. The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltage</td>
<td></td>
</tr>
<tr>
<td>Connections</td>
<td>Terminals 1.8, 2.8, 3.8 and 4.8 for UP (+24 V DC) and 1.9, 2.9, 3.9 and 4.9 for ZP (0 V)</td>
</tr>
<tr>
<td>Protection against reverse voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse at UP</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5 %</td>
</tr>
<tr>
<td>Current consumption</td>
<td></td>
</tr>
<tr>
<td>From UP</td>
<td>0.07 A + max. 0.008 A per input + max. 0.5 A per output + 0.01 A for A, B and Z inputs</td>
</tr>
<tr>
<td>Via I/O bus</td>
<td>Ca. 5 mA</td>
</tr>
<tr>
<td>Inrush current from UP (at power-up)</td>
<td>0.04 A(^2)s</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Yes, per module</td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>6 W (outputs unloaded)</td>
</tr>
<tr>
<td>Weight (without terminal unit)</td>
<td>Ca. 125 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal mounting or vertical with derating (output load reduced to 50 % at +40 °C)</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>

**NOTICE!**

All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

**Multiple overloads**

No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an internal smart high-side switch.

Technical data of the digital inputs/outputs if used as standard inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels</td>
<td>2 + 8 configurable digital inputs/outputs</td>
</tr>
<tr>
<td>Reference potential for all inputs</td>
<td>Terminals 1.9…4.9 (negative pole of the process supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>From the rest of the module</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel, the LED is ON when the input signal is high (signal 1)</td>
</tr>
<tr>
<td>Input type acc. to EN 61131-2</td>
<td>Type 1</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 8 ms, configurable from 0.1 to 32 ms</td>
</tr>
<tr>
<td>Input data length</td>
<td>24 bytes</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-3 V ... +5 V *</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>&gt; +5 V ... &lt; +15 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>+15 V ... +30 V</td>
</tr>
<tr>
<td>Ripple with signal 0</td>
<td>Within -3 V ... +5 V *</td>
</tr>
<tr>
<td>Ripple with signal 1</td>
<td>Within +15 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 5 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>&gt; 1 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>&gt; 5 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 8 mA</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

* Due to the direct connection to the output, the demagnetizing varistor is also effective at the input (see figure) above. This is why the difference between UPx and the input signal must not exceed the clamp voltage of the varistor. The varistor limits the clamp voltage to approx. 36 V. Consequently, the input voltage must range from -12 V ... +30 V when UPx = 24 V and from -6 V ... +30 V when UPx = 30 V.

---

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels</td>
<td>8 configurable digital inputs/outputs</td>
</tr>
<tr>
<td>Reference potential for all outputs</td>
<td>Terminals 1.9 ... 4.9 (negative pole of the process supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>For all outputs: terminals 1.8 ... 4.8 (positive pole of the process supply voltage, signal name UP)</td>
</tr>
<tr>
<td>Output voltage for signal 1</td>
<td>UP (-0.8 V)</td>
</tr>
<tr>
<td>Output delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 10 μs</td>
</tr>
<tr>
<td>Output data length</td>
<td>32 bytes</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated value, per channel</td>
<td>500 mA at UP = 24 V</td>
</tr>
<tr>
<td>Maximum value (all channels together, PWM included)</td>
<td>8 A</td>
</tr>
<tr>
<td>Leakage current with signal 0</td>
<td>&lt; 0.5 mA</td>
</tr>
<tr>
<td>Rated protection fuse on UP</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Demagnetization when inductive loads are switched off</td>
<td>With varistors integrated in the module (see figure below)</td>
</tr>
<tr>
<td>Switching frequency</td>
<td></td>
</tr>
</tbody>
</table>
### Technical data of the high-speed inputs (A0, B0, Z0; A1, B1, Z1)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>6</td>
</tr>
<tr>
<td>Reference potential for all inputs</td>
<td>Terminal 1.9, 2.9, 3.9 and 4.9 (negative pole of the process voltage, signal name ZP)</td>
</tr>
<tr>
<td>Input Type</td>
<td>24 V DC / Differential Sinus 1 Vpp</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 14 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>&gt; 4.8 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>&gt; 12 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 15 mA</td>
</tr>
<tr>
<td>Input type acc. to EN 61131-2</td>
<td>Type 1</td>
</tr>
<tr>
<td>Input frequency max. (fast counter)</td>
<td>300 kHz</td>
</tr>
</tbody>
</table>

---

**Figure 167: Digital input/output (circuit diagram)**

1. UPx (+ 24 V)
2. Digital input/output
3. ZPx (0 V)
4. For demagnetization when inductive loads are switched off
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input frequency max. (frequency measurement)</td>
<td>5 kHz</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-3 V ... +5 V</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>&gt; +5 V ... &lt; +15 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>+15 V ... +30 V</td>
</tr>
<tr>
<td>Ripple with signal 0</td>
<td>Within -3 V ... +5 V</td>
</tr>
<tr>
<td>Ripple with signal 1</td>
<td>Within +15 V ... +30 V</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

### Technical data of the fast outputs O0 and O1

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels</td>
<td>2</td>
</tr>
<tr>
<td>Reference potential for all outputs</td>
<td>Terminals 1.9 ... 4.9</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>For all outputs: terminals 1.8 ... 4.8</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>Brightness of the LED</td>
</tr>
<tr>
<td>Output voltage for signal 1</td>
<td>UP (-0.1 V)</td>
</tr>
<tr>
<td>Output voltage for signal 0</td>
<td>ZP (+0.3 V)</td>
</tr>
<tr>
<td>Output delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 1 µs</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated value, per channel</td>
<td>100 mA at UP = 24 V</td>
</tr>
<tr>
<td>Maximum value (all channels together, configurable outputs included))</td>
<td>8 A</td>
</tr>
<tr>
<td>Leakage current with signal 0</td>
<td>&lt; 0.5 mA</td>
</tr>
<tr>
<td>Rated protection fuse on UP</td>
<td>10 A fast</td>
</tr>
<tr>
<td>De-magnetization when inductive loads are switched off</td>
<td>With varistors integrated in the module (see figure above)</td>
</tr>
<tr>
<td>Switching frequency</td>
<td>PWM: up to 100 kHz</td>
</tr>
<tr>
<td>Short-circuit-proof / overload-proof</td>
<td>Yes</td>
</tr>
<tr>
<td>Overload message (I &gt; 0.1x A)</td>
<td>Yes, after ca. 100 ms</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>Yes, automatic reactivation after short-circuit/overload</td>
</tr>
<tr>
<td>Resistance to feedback against 24 V signals</td>
<td>Yes</td>
</tr>
<tr>
<td>Resistance to feedback against reverse polarity</td>
<td>No</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
</tbody>
</table>
### Technical data of the fast outputs (SSI CLK output B0, B1 for optical interface)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels</td>
<td>2</td>
</tr>
<tr>
<td>Reference potential for all outputs</td>
<td>Terminals 1.9...4.9 (negative pole of the process supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>For all outputs: terminals 1.8 ... 4.8 (positive pole of the process supply voltage, signal name UP)</td>
</tr>
<tr>
<td>Output voltage for signal 0</td>
<td>≤ 1.5 V at 10 mA</td>
</tr>
<tr>
<td>Output delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 0.3 µs</td>
</tr>
<tr>
<td>Output current</td>
<td>≤ 10 mA</td>
</tr>
<tr>
<td>Switching frequency</td>
<td>&lt; 1 MHz (depending on firmware)</td>
</tr>
<tr>
<td>Short-circuit-proof / overload-proof</td>
<td>Yes</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>Yes, automatic reactivation after short circuit/overload</td>
</tr>
<tr>
<td>Resistance to feedback against 24 V signals</td>
<td>Yes</td>
</tr>
<tr>
<td>Resistance to feedback against reverse polarity</td>
<td>No</td>
</tr>
<tr>
<td>Max. cable length (shielded)</td>
<td>Typ. 12.5 m at 500 kHz (depending on sensor)</td>
</tr>
</tbody>
</table>

### Technical data of the fast outputs (SSI CLK Output Differential)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels</td>
<td>2</td>
</tr>
<tr>
<td>Reference potential for all outputs</td>
<td>Terminals 1.9 ... 4.9 (negative pole of the process supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>For all outputs: terminals 1.8 ... 4.8 (positive pole of the process supply voltage, signal name UP)</td>
</tr>
<tr>
<td>Output voltage for signal 1</td>
<td>≥ 2.9 V at 10 mA</td>
</tr>
<tr>
<td>Output voltage for signal 0</td>
<td>≤ 1.3 V at 10 mA</td>
</tr>
<tr>
<td>Output delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 0.3 µs</td>
</tr>
<tr>
<td>Output current</td>
<td>≤ 10 mA</td>
</tr>
<tr>
<td>Switching frequency</td>
<td>&lt; 1 MHz (depending on firmware)</td>
</tr>
<tr>
<td>Short-circuit-proof / overload-proof</td>
<td>Yes</td>
</tr>
<tr>
<td>Overload message (I &gt; 0.1x A)</td>
<td>Yes, after ca. 100 ms</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>Yes, automatic reactivation after short-circuit/overload</td>
</tr>
<tr>
<td>Resistance to feedback against 24 V signals</td>
<td>Yes</td>
</tr>
<tr>
<td>Resistance to feedback against reverse polarity</td>
<td>No</td>
</tr>
<tr>
<td>Max. cable length (shielded)</td>
<td>100 m</td>
</tr>
</tbody>
</table>
### Technical data of the 5 V sensor supply

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of supplies</td>
<td>2, independently configuration</td>
</tr>
<tr>
<td>Voltage supply (outputs unloaded)</td>
<td>5 V DC +/- 5%</td>
</tr>
<tr>
<td>Resistance to feedback against reverse polarity</td>
<td>No</td>
</tr>
<tr>
<td>Output current</td>
<td>100 mA max. (independently)</td>
</tr>
<tr>
<td></td>
<td>200 mA max. (parallel use)</td>
</tr>
<tr>
<td>Output diagnosis</td>
<td>Yes, with diagnosis LED and error message</td>
</tr>
</tbody>
</table>

### Technical data of the 0 V reference input

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of reference inputs (internally connected to ZP through internal fuse)</td>
<td>6</td>
</tr>
<tr>
<td>Max. current per connection</td>
<td>0.5 A</td>
</tr>
<tr>
<td>Internal fuse protection</td>
<td></td>
</tr>
<tr>
<td>Terminals 1.4 and 1.6</td>
<td>2 A</td>
</tr>
<tr>
<td>Terminals 3.4 ... 3.7</td>
<td>2 A</td>
</tr>
</tbody>
</table>

### Dimensions

[Diagram showing dimensions with labels 1 and 2 for Din rail 15 mm and Din rail 7.5 mm]
The dimensions are in mm and in brackets in inch.

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 260 300 R0001</td>
<td>CD522, encoder &amp; PWM module, 2 encoder inputs, 2 PWM outputs, 2 digital inputs 24 V DC, 8 digital outputs 24 V DC</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 460 300 R0001</td>
<td>CD522-XC, encoder &amp; PWM module, 2 encoder inputs, 2 PWM outputs, 2 digital inputs 24 V DC, 8 digital outputs 24 V DC, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
5.2.5 Terminal units for S500(-XC) I/O modules

5.2.5.1 Safety instructions

Hot swap

System requirements for hot swapping of I/O modules:

- Types of terminal units that support hot swapping of I/O modules have the appendix TU5xx-H.
- I/O modules as of index F0.

The following I/O bus masters support hot swapping of attached I/O modules:

- Communication interface modules CI5xx as of index F0.
- Processor modules PM56xx-2ETH with firmware version as of V3.2.0.

NOTICE!

Risk of damage to I/O modules!

Hot swapping is only allowed for I/O modules. Processor modules and communication interface modules must not be removed or inserted during operation.

Conditions for hot swapping

- Digital outputs are not under load.
- Input/output voltages above safety extra low voltage/protective extra low voltages (SELV/PELV) are switched off.
- Modules are completely plugged on the terminal unit with both snap fit engaged before switching on loads or input/output voltage.

Further information about hot swap.

5.2.5.2 TU515, TU516, TU541 and TU542 for I/O modules

5.2.5.2.1 Features

- TU515, I/O terminal unit, 24 V DC, screw terminals
- TU516, I/O terminal unit, 24 V DC, spring terminals
- TU516-XC, I/O terminal unit, 24 V DC, spring terminals, XC version
- TU516-H, I/O terminal unit, hot swap, 24 V DC, spring terminals
- TU516-H-XC, I/O terminal unit, hot swap, 24 V DC, spring terminals, XC version
- TU541, I/O terminal unit, 24 V DC, screw terminals
- TU542, I/O terminal unit, 24 V DC, spring terminals
- TU542-XC, I/O terminal unit, 24 V DC, spring terminals, XC version
- TU542-H, I/O terminal unit, hot swap, 24 V DC, spring terminals
- TU542-H-XC, I/O terminal unit, hot swap, 24 V DC, spring terminals, XC version

The input/output modules plug into the I/O terminal unit. When properly seated, they are secured with two mechanical locks. All the connections are established via the terminal unit, which allows removal and replacement of the I/O modules without disturbing the wiring at the terminal unit.
1 I/O bus (10 pins, male) to connect the previous terminal unit, the CPU terminal base or the communication interface module to the terminal unit
2 I/O bus (10 pins, female) to connect other terminal units
3a Plug (2 x 25 pins) to connect the inserted I/O modules
3b Plug (2 x 19 pins) to connect the inserted I/O modules
4 With a screwdriver inserted in this place, the terminal unit and the adjacent terminal unit can be shoved from each other
5 Holes for screw mounting
6 40 terminals for signals and process supply voltage
7 DIN rail
8 White border signifies hot swap capability of the terminal unit

**XC version**  
**XC = eXtreme Conditions**

---

**Extreme conditions**

Terminal units for use in extreme ambient conditions have no sign for XC version.

*The figure 4 in the Part no. 1SAP4... (table) identifies the XC version.*
The following terminals are used for connection of the process supply voltage.

<table>
<thead>
<tr>
<th>Terminals</th>
<th>Screw terminals</th>
<th>Spring terminals</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conductor</td>
<td>1.5, 1.6, 1.7, 1.8, 1.9</td>
<td>1.5, 1.6, 1.7, 1.8, 1.9</td>
</tr>
<tr>
<td>Screwdriver</td>
<td></td>
<td>Screwdriver (opens terminal)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Type</th>
<th>1.8</th>
<th>2.8</th>
<th>3.8</th>
<th>4.8</th>
<th>1.9</th>
<th>2.9</th>
<th>3.9</th>
<th>4.9</th>
</tr>
</thead>
<tbody>
<tr>
<td>TU515, TU516 and TU516-H</td>
<td>These terminals are internally connected with assignment: process supply voltage UP = +24 V DC</td>
<td>These terminals are internally connected with assignment: process supply voltage ZP = 0 V</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TU541, TU542 and TU542-H</td>
<td>These terminals are internally connected with assignment: process supply voltage UP = +24 V DC</td>
<td>Separate process supply voltage UP3 = +24 V DC</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Separate process supply voltage UP4 = +24 V DC</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>These terminals are internally connected with assignment: process supply voltage ZP = 0 V</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Separate process supply voltage ZP = 0 V</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Separate process supply voltage ZP = 0 V</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The assignment of the other terminals depends on the inserted communication interface module (see the description of the respective module used).

### 5.2.5.2.2 Technical data

The system data of AC500 and S500 are applicable to the standard version ☞ *Chapter 5.1.2 “System data AC500” on page 166.*

The system data of AC500-XC are applicable to the XC version ☞ *Chapter 5.1.3 “System data AC500-XC” on page 169.*

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>Max. 32</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>4 groups of 8 channels each (1.0 ... 1.7, 2.0 ... 2.7, 3.0 ... 3.7, 4.0 ... 4.7), the allocation of the channels is given by the inserted I/O module</td>
</tr>
<tr>
<td>Rated voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Max. permitted total current</td>
<td>10 A, per separated process voltage terminal or for internal connection of process voltages</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Grounding</td>
<td>Direct connection to the grounded DIN rail or via the screws with wall mounting</td>
</tr>
<tr>
<td>Screw terminals</td>
<td>Front terminal, conductor connection vertically with respect to the printed circuit board</td>
</tr>
<tr>
<td>Spring terminals</td>
<td>Front terminal, conductor connection vertically with respect to the printed circuit board</td>
</tr>
<tr>
<td>Weight</td>
<td>200 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical</td>
</tr>
</tbody>
</table>

### 5.2.5.2.3 Hot swap

#### Hot swap

**WARNING!**
Risk of explosion or fire in hazardous environments during hot swapping!

Hot swap must not be performed in flammable environments to avoid life-threatening injury and property damage resulting from fire or explosion.

---

**WARNING!**
Electric shock due to negligent behavior during hot swapping!

To avoid electric shock:
- make sure the following conditions apply:
  - Digital outputs are not under load.
  - Input/output voltages above safety extra low voltage/protective extra low voltage (SELV/PELV) are switched off.
  - Modules are fully interlocked with the terminal unit with both snap-fits engaged before switching on loads or input/output voltage.
- Never touch exposed contacts (dangerous voltages).
- Stay away from electrical contacts to avoid arc discharge.
- Do not operate a mechanical installation improperly.

---

**NOTICE!**
Risk of damage to I/O modules!

Hot swapping is only allowed for I/O modules. Processor modules and communication interface modules must not be removed or inserted during operation.

H = Hot swap
Hot swap
System requirements for hot swapping of I/O modules:
– Types of terminal units that support hot swapping of I/O modules have the appendix TU5xx-H.
– I/O modules as of index F0.

The following I/O bus masters support hot swapping of attached I/O modules:
– Communication interface modules CI5xx as of index F0.
– Processor modules PM56xx-2ETH with firmware version as of V3.2.0.

Hot swap is not supported by AC500-eCo V3 CPU!

The index of the module is in the right corner of the label.

NOTICE!
Risk of damage to I/O modules!
Modules with index below F0 can be damaged when inserted or removed from the terminal unit in a powered system.

NOTICE!
Risk of damage to I/O modules!
Do not perform hot swapping if any I/O module with firmware version lower than 3.0.14 is part of the I/O configuration.
For min. required device index see table below.
<table>
<thead>
<tr>
<th>Device</th>
<th>Min. required device index for I/O module as of FW Version 3.0.14</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC522(-XC)</td>
<td>F0</td>
</tr>
<tr>
<td>AI523 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AI531</td>
<td>D4</td>
</tr>
<tr>
<td>AI531-XC</td>
<td>D2</td>
</tr>
<tr>
<td>AI561</td>
<td>B2</td>
</tr>
<tr>
<td>AI562</td>
<td>B2</td>
</tr>
<tr>
<td>AI563</td>
<td>B3</td>
</tr>
<tr>
<td>AO523 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AO561</td>
<td>B2</td>
</tr>
<tr>
<td>AX521 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AX522 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AX561</td>
<td>B2</td>
</tr>
<tr>
<td>CD522 (-XC)</td>
<td>D1</td>
</tr>
<tr>
<td>DA501 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DA502 (-XC)</td>
<td>F0</td>
</tr>
<tr>
<td>DC522 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DC523 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DC532 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DC562</td>
<td>A2</td>
</tr>
<tr>
<td>DI524 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DI561</td>
<td>B2</td>
</tr>
<tr>
<td>DI562</td>
<td>B2</td>
</tr>
<tr>
<td>DI571</td>
<td>B2</td>
</tr>
<tr>
<td>DI572</td>
<td>A1</td>
</tr>
<tr>
<td>DO524 (-XC)</td>
<td>A3</td>
</tr>
<tr>
<td>DO526</td>
<td>A2</td>
</tr>
<tr>
<td>DO526-XC</td>
<td>A0</td>
</tr>
<tr>
<td>DO561</td>
<td>B2</td>
</tr>
<tr>
<td>DO562</td>
<td>A2</td>
</tr>
<tr>
<td>DO571</td>
<td>B3</td>
</tr>
<tr>
<td>DO572</td>
<td>B2</td>
</tr>
<tr>
<td>DO573</td>
<td>A1</td>
</tr>
<tr>
<td>DX522 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DX531</td>
<td>D2</td>
</tr>
<tr>
<td>DX561</td>
<td>B2</td>
</tr>
<tr>
<td>DX571</td>
<td>B3</td>
</tr>
<tr>
<td>FM562</td>
<td>A1</td>
</tr>
</tbody>
</table>
5.2.5.2.4 Dimensions

| 1 | Din rail 15 mm |
| 2 | Din rail 7.5 mm |

The dimensions are in mm and in brackets in inch.

5.2.5.2.5 Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 212 200 R0001</td>
<td>TU515, I/O terminal unit, 24 V DC, screw terminals</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 212 000 R0001</td>
<td>TU516, I/O terminal unit, 24 V DC, spring terminals</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 412 000 R0001</td>
<td>TU516-XC, I/O terminal unit, 24 V DC, spring terminals, XC version</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 215 000 R0001</td>
<td>TU516-H, I/O terminal unit, hot swap, 24 V DC, spring terminals, XC version</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 415 000 R0001</td>
<td>TU516-H-XC, I/O terminal unit, hot swap, 24 V DC, spring terminals</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 213 000 R0001</td>
<td>TU541, I/O terminal unit, 24 V DC, screw terminals</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 213 200 R0001</td>
<td>TU542, I/O terminal unit, 24 V DC, spring terminals</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 413 200 R0001</td>
<td>TU542-XC, I/O terminal unit, 24 V DC, spring terminals, XC version</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 215 200 R0001</td>
<td>TU542-H, I/O terminal unit, hot swap, 24 V DC, spring terminals</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 415 200 R0001</td>
<td>TU542-H-XC, I/O terminal unit, hot swap, 24 V DC, spring terminals, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>
5.2.5.3  TU531 and TU532 for I/O modules

5.2.5.3.1  Features

- TU531, I/O terminal unit, 120/230 V AC, screw terminals
- TU532, I/O terminal unit, 120/230 V AC, spring terminals
- TU532-XC, I/O terminal unit, 120/230 V AC, spring terminals, XC version
- TU532-H, I/O terminal unit, hot swap, 120/230 V AC, spring terminals
- TU532-H-XC, I/O terminal unit, hot swap, 120/230 V AC, spring terminals, XC version

1  I/O bus (10 pins, male) to connect the previous terminal unit, the CPU terminal base or the communication interface module to the terminal unit
2  I/O bus (10 pins, female) to connect other terminal units
3a Plug (2 x 25 pins) to connect the inserted I/O modules
3b Plug (3 x 19 pins) to connect the inserted I/O modules
4  With a screwdriver inserted in this place, the terminal unit and the adjacent I/O terminal unit can be shoved from each other
5  Holes for screw mounting
6  40 terminals for signals and process supply voltage
7  DIN rail
8  White border signifies hot swap capability of the terminal unit
The input/output modules (I/O modules) plug into the I/O terminal unit. When properly plugged-in, they are secured with two mechanical locks. All the connections are established via the terminal unit, which allows removal and replacement of the I/O modules without disturbing the wiring at the terminal unit.

The terminal units TU531 and TU532 are specifically designed for use with AC500/S500 I/O modules that incorporate 115 V AC ... 230 V AC inputs and/or 120/230 V AC relay outputs.

**XC version**  
XC = eXtreme Conditions

**Extreme conditions**  
Terminal units for use in extreme ambient conditions have no eXtreme sign for XC version.

The figure 4 in the Part no. 1SAP4... (label) identifies the XC version.

### Terminals

<table>
<thead>
<tr>
<th>Screw terminals</th>
<th>Spring terminals</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Conductor</strong></td>
<td><strong>Conductor</strong></td>
</tr>
<tr>
<td>1.5</td>
<td>1.5</td>
</tr>
<tr>
<td>1.6</td>
<td>1.6</td>
</tr>
<tr>
<td>1.7</td>
<td>1.7</td>
</tr>
<tr>
<td>1.8</td>
<td>1.8</td>
</tr>
<tr>
<td>1.9</td>
<td>1.9</td>
</tr>
<tr>
<td><strong>Screwdriver</strong></td>
<td><strong>Screwdriver</strong></td>
</tr>
<tr>
<td></td>
<td>(opens terminal)</td>
</tr>
</tbody>
</table>

The terminals 1.8 ... 4.8 and 1.9 ... 4.9 are electrically interconnected within the terminal unit and always have the same assignment, independent of the inserted module:

- Terminals 1.8 ... 4.8: process supply voltage UP = +24 V DC
- Terminals 1.9 ... 4.9: process supply voltage ZP = 0 V

The assignment of the other terminals depends on the inserted communication interface module (see the description of the respective module used).

The supply voltage of 24 V DC for the module's circuitry comes from the I/O expansion bus (I/O bus).

### 5.2.5.3.2 Technical data

The system data of AC500 and S500 are applicable to the standard version ☞ Chapter 5.1.2 “System data AC500” on page 166.

The system data of AC500-XC are applicable to the XC version ☞ Chapter 5.1.3 “System data AC500-XC” on page 169.
Only additional details are therefore documented below.
The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>32</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>4 groups of 8 channels each (1.0 ... 1.7, 2.0 ... 2.7, 3.0 ... 3.7, 4.0 ... 4.7), the allocation of the channels is given by the inserted I/O module</td>
</tr>
<tr>
<td>Terminals 1.8 ... 4.8 and 1.9 ... 4.9</td>
<td></td>
</tr>
<tr>
<td>Max. voltage</td>
<td>30 V DC</td>
</tr>
<tr>
<td>Max. permitted total current</td>
<td>10 A</td>
</tr>
<tr>
<td>Terminals 1.0 ... 1.7, 2.0 ... 2.7, 3.0 ... 3.7, 4.0 ... 4.7</td>
<td></td>
</tr>
<tr>
<td>Max. voltage</td>
<td>300 V AC ¹)</td>
</tr>
<tr>
<td>Max. permitted current</td>
<td>3 A ²)</td>
</tr>
<tr>
<td>Grounding</td>
<td>Direct connection to the grounded DIN rail or via the screws with wall mounting</td>
</tr>
<tr>
<td>Screw terminals</td>
<td>Front terminal, conductor connection vertically with respect to the printed circuit board</td>
</tr>
<tr>
<td>Spring terminals</td>
<td>Front terminal, conductor connection vertically with respect to the printed circuit board</td>
</tr>
<tr>
<td>Weight</td>
<td>200 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical</td>
</tr>
</tbody>
</table>

¹) Only when the voltage is not limited by the specification of the I/O channel or the supply input which is internally connected to the terminal.

²) The terminals are connected to the electronic module via internal connectors (X22 (or 3b), X23 (or 3b), X32, X33 and X34). The current per terminal is limited by the permitted current of these connectors.

### 5.2.5.3.3 Hot swap

**Hot swap**

**WARNING!**
Risk of explosion or fire in hazardous environments during hot swapping!
Hot swap must not be performed in flammable environments to avoid life-threatening injury and property damage resulting from fire or explosion.
WARNING!
Electric shock due to negligent behavior during hot swapping!
To avoid electric shock
– make sure the following conditions apply:
  – Digital outputs are not under load.
  – Input/output voltages above safety extra low voltage/protective extra low voltage (SELV/PELV) are switched off.
  – Modules are fully interlocked with the terminal unit with both snap-fits engaged before switching on loads or input/output voltage.
  – Never touch exposed contacts (dangerous voltages).
  – Stay away from electrical contacts to avoid arc discharge.
  – Do not operate a mechanical installation improperly.

NOTICE!
Risk of damage to I/O modules!
Hot swapping is only allowed for I/O modules.
Processor modules and communication interface modules must not be removed or inserted during operation.

H = Hot swap

Hot swap
System requirements for hot swapping of I/O modules:
– Types of terminal units that support hot swapping of I/O modules have the appendix TU5xx-H.
– I/O modules as of index F0.
The following I/O bus masters support hot swapping of attached I/O modules:
– Communication interface modules CI5xx as of index F0.
– Processor modules PM56xx-2ETH with firmware version as of V3.2.0.

Hot swap is not supported by AC500-eCo V3 CPU!
**NOTICE!**
**Risk of damage to I/O modules!**
Modules with index below F0 can be damaged when inserted or removed from the terminal unit in a powered system.

**NOTICE!**
**Risk of damage to I/O modules!**
Do not perform hot swapping if any I/O module with firmware version lower than 3.0.14 is part of the I/O configuration.
For min. required device index see table below.

<table>
<thead>
<tr>
<th>Device</th>
<th>Min. required device index for I/O module as of FW Version 3.0.14</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC522(-XC)</td>
<td>F0</td>
</tr>
<tr>
<td>AI523 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AI531</td>
<td>D4</td>
</tr>
<tr>
<td>AI531-XC</td>
<td>D2</td>
</tr>
<tr>
<td>AI561</td>
<td>B2</td>
</tr>
<tr>
<td>AI562</td>
<td>B2</td>
</tr>
<tr>
<td>AI563</td>
<td>B3</td>
</tr>
<tr>
<td>AO523 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AO561</td>
<td>B2</td>
</tr>
<tr>
<td>AX521 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AX522 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AX561</td>
<td>B2</td>
</tr>
<tr>
<td>CD522 (-XC)</td>
<td>D1</td>
</tr>
<tr>
<td>DA501 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DA502 (-XC)</td>
<td>F0</td>
</tr>
<tr>
<td>DC522 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DC523 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DC532 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DC562</td>
<td>A2</td>
</tr>
<tr>
<td>DI524 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DI561</td>
<td>B2</td>
</tr>
<tr>
<td>DI562</td>
<td>B2</td>
</tr>
<tr>
<td>DI571</td>
<td>B2</td>
</tr>
<tr>
<td>DI572</td>
<td>A1</td>
</tr>
</tbody>
</table>
### Device specifications > Terminal units for S500(-XC) I/O modules

<table>
<thead>
<tr>
<th>Device</th>
<th>Min. required device index for I/O module as of FW Version 3.0.14</th>
</tr>
</thead>
<tbody>
<tr>
<td>DO524 (-XC)</td>
<td>A3</td>
</tr>
<tr>
<td>DO526</td>
<td>A2</td>
</tr>
<tr>
<td>DO526-XC</td>
<td>A0</td>
</tr>
<tr>
<td>DO561</td>
<td>B2</td>
</tr>
<tr>
<td>DO562</td>
<td>A2</td>
</tr>
<tr>
<td>DO571</td>
<td>B3</td>
</tr>
<tr>
<td>DO572</td>
<td>B2</td>
</tr>
<tr>
<td>DO573</td>
<td>A1</td>
</tr>
<tr>
<td>DX522 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DX531</td>
<td>D2</td>
</tr>
<tr>
<td>DX561</td>
<td>B2</td>
</tr>
<tr>
<td>DX571</td>
<td>B3</td>
</tr>
<tr>
<td>FM562</td>
<td>A1</td>
</tr>
</tbody>
</table>

#### 5.2.5.3.4 Dimensions

<table>
<thead>
<tr>
<th>Dimension</th>
<th>mm</th>
<th>inch</th>
</tr>
</thead>
<tbody>
<tr>
<td>DIN rail 15 mm</td>
<td>28</td>
<td>1.10</td>
</tr>
<tr>
<td>DIN rail 7.5 mm</td>
<td>67.5</td>
<td>2.66</td>
</tr>
</tbody>
</table>

*The dimensions are in mm and in brackets in inch.*
5.2.5.3.5 Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 217 200 R0001</td>
<td>TU531, terminal unit, 120/230 V AC, relays, screw terminals</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 217 000 R0001</td>
<td>TU532, terminal unit, 120/230 V AC, relays, spring terminals</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 417 000 R0001</td>
<td>TU532-XC, terminal unit, 120/230 V AC, relays, spring terminals, XC version</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 215 100 R0001</td>
<td>TU532-H, terminal unit, hot swap, 120/230 V AC, relays, spring terminals</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 415 100 R0001</td>
<td>TU532-H-XC, terminal unit, hot swap, 120/230 V AC, relays, spring terminals, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

5.2.6 Communication interface modules

5.2.6.1 Safety instructions

**Hot swap**

System requirements for hot swapping of I/O modules:

- Types of terminal units that support hot swapping of I/O modules have the appendix TU5xx-H.
- I/O modules as of index F0.

The following I/O bus masters support hot swapping of attached I/O modules:

- Communication interface modules CI5xx as of index F0.
- Processor modules PM56xx-2ETH with firmware version as of V3.2.0.

**NOTICE!**

Risk of damage to I/O modules!

Hot swapping is only allowed for I/O modules.

Processor modules and communication interface modules must not be removed or inserted during operation.

**Conditions for hot swapping**

- Digital outputs are not under load.
- Input/output voltages above safety extra low voltage/protective extra low voltages (SELV/PELV) are switched off.
- Modules are completely plugged on the terminal unit with both snap fit engaged before switching on loads or input/output voltage.

*Further information about hot swap.*
5.2.6.2 Compatibility of communication modules and communication interface modules

**Table 212: Modbus TCP**

<table>
<thead>
<tr>
<th>Communication module</th>
<th>Communication interface module</th>
<th>I/O expansion module S500</th>
<th>I/O expansion module S500-eCo</th>
<th>I/O expansion module S500-S</th>
<th>Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Onboard Ethernet interface</td>
<td>CI521-MODTCP CI522-MODTCP</td>
<td>x</td>
<td>x</td>
<td>--</td>
<td>high availability, remote I/O</td>
</tr>
<tr>
<td>Onboard Ethernet interface</td>
<td>CI521-MODTCP CI522-MODTCP</td>
<td>x</td>
<td>--</td>
<td>--</td>
<td>hot-swap I/O</td>
</tr>
<tr>
<td>CM5640-2ETH</td>
<td>CI521-MODTCP CI522-MODTCP</td>
<td>x</td>
<td>x</td>
<td>--</td>
<td>high availability, remote I/O</td>
</tr>
<tr>
<td>CM5640-2ETH</td>
<td>CI521-MODTCP CI522-MODTCP</td>
<td>x</td>
<td>--</td>
<td>--</td>
<td>hot-swap I/O</td>
</tr>
</tbody>
</table>

**Table 213: PROFIBUS DP**

<table>
<thead>
<tr>
<th>Communication module</th>
<th>Communication interface module</th>
<th>I/O expansion module S500</th>
<th>I/O expansion module S500-eCo</th>
<th>I/O expansion module S500-S</th>
<th>Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>CM592-DP master</td>
<td>CI541-DP CI542-DP</td>
<td>x</td>
<td>x</td>
<td>--</td>
<td>remote I/O</td>
</tr>
<tr>
<td>CM592-DP master</td>
<td>CI541-DP CI542-DP</td>
<td>x</td>
<td>--</td>
<td>--</td>
<td>hot-swap I/O</td>
</tr>
</tbody>
</table>

**Table 214: PROFINET IO RT**

<table>
<thead>
<tr>
<th>Communication module</th>
<th>Communication interface module</th>
<th>I/O expansion module S500</th>
<th>I/O expansion module S500-eCo</th>
<th>I/O expansion module S500-S</th>
<th>Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>CM579-PNIO controller</td>
<td>CI501-PNIO CI502-PNIO</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>remote I/O, safety I/O</td>
</tr>
<tr>
<td>CM579-PNIO controller</td>
<td>CI501-PNIO CI502-PNIO</td>
<td>x</td>
<td>--</td>
<td>--</td>
<td>hot-swap I/O</td>
</tr>
</tbody>
</table>

**Table 215: CANopen**

<table>
<thead>
<tr>
<th>Communication module</th>
<th>Communication interface module</th>
<th>I/O expansion module S500</th>
<th>I/O expansion module S500-eCo</th>
<th>I/O expansion module S500-S</th>
<th>Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Onboard CAN interface</td>
<td>CI581-CN CI582-CN</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>remote I/O</td>
</tr>
</tbody>
</table>
Table 216: EtherCAT

<table>
<thead>
<tr>
<th>Communication module</th>
<th>Communication interface module</th>
<th>I/O expansion module S500</th>
<th>I/O expansion module S500-eCo</th>
<th>I/O expansion module S500-S</th>
<th>Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>CM579-ETHCAT master</td>
<td>CI511-ETHCAT</td>
<td>x</td>
<td>x</td>
<td>--</td>
<td>remote I/O</td>
</tr>
<tr>
<td></td>
<td>CI512-ETHCAT</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

5.2.6.3 CANopen

5.2.6.3.1 Comparison CI581 and CI582

The devices differ in their input and output characteristics.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inputs and outputs</td>
<td>8 digital inputs (24 V DC; delay time configurable via software) 8 digital transistor outputs (24 V DC, 0.5 A max.) 4 analog inputs, configurable as:</td>
</tr>
<tr>
<td></td>
<td>-10 V ... +10 V 0 V ... +10 V -10 V ... +10 V (differential voltage) 0 mA ... 20 mA 4 mA ... 20 mA Pt100, Pt1000, Ni1000 (for each 2-wire and 3-wire) 24 V digital input function</td>
</tr>
<tr>
<td>Resolution of the analog channels</td>
<td>12 bits</td>
</tr>
<tr>
<td>Fast counter</td>
<td>Integrated, configurable operating modes</td>
</tr>
</tbody>
</table>

CI582-CN: Input/Output characteristics

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inputs and outputs</td>
<td>8 digital inputs (24 V DC) 8 digital transistor outputs (24 V DC, 0.5 A max.) 8 configurable digital inputs/outputs (24 V DC, 0.5 A max.)</td>
</tr>
</tbody>
</table>

5.2.6.3.2 CI581-CN

Features

- 4 analog inputs (resolution 12 bits including sign)
- 2 analog outputs (resolution 12 bits including sign)
- 8 digital inputs 24 V DC
- 8 digital outputs 24 V DC, 0.5 A max
- Module-wise galvanically isolated
- Fast counter
- XC version for use in extreme ambient conditions available

### Hardware descriptions
#### Device specifications > Communication interface modules

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>I/O bus</td>
</tr>
<tr>
<td>2</td>
<td>Allocation between terminal No. and signal name</td>
</tr>
<tr>
<td>3</td>
<td>6 yellow LEDs to display the signal states of the analog inputs/outputs (AI0 ... AI3, AO0 ... AO1)</td>
</tr>
<tr>
<td>4</td>
<td>8 yellow LEDs to display the signal states of the digital inputs (DI0 ... DI7)</td>
</tr>
<tr>
<td>5</td>
<td>8 yellow LEDs to display the signal states of the digital outputs (DO0 ... DO7)</td>
</tr>
<tr>
<td>6</td>
<td>2 green LEDs to display the supply voltage UP and UP3</td>
</tr>
<tr>
<td>7</td>
<td>3 red LEDs to display errors (CH-ERR1, CH-ERR2, CH-ERR3)</td>
</tr>
<tr>
<td>8</td>
<td>5 System LEDs: PWR/RUN, CN-RUN, CN-ERR, S-ERR, I/O-Bus</td>
</tr>
<tr>
<td>9</td>
<td>Label</td>
</tr>
<tr>
<td>10</td>
<td>2 rotary switches for setting the CANopen Node ID</td>
</tr>
<tr>
<td>11</td>
<td>10 terminals to connect the CANopen bus signals</td>
</tr>
<tr>
<td>12</td>
<td>Terminal unit</td>
</tr>
<tr>
<td>13</td>
<td>DIN rail</td>
</tr>
<tr>
<td></td>
<td>Sign for XC version</td>
</tr>
</tbody>
</table>
Intended purpose

The CANopen communication interface module CI581-CN is used as decentralized I/O module in CANopen networks. Depending on the used terminal unit the network connection is performed either via 9-pin female D-sub or via 10 terminals (screw or spring terminals) which are integrated in the terminal unit. The communication interface module contains 22 I/O channels with the following properties:

- 4 analog inputs (2.0 ... 2.3)
- 2 analog outputs (2.5 ... 2.6)
- 8 digital inputs 24 V DC in 1 group (3.0 ... 3.7)
- 8 digital outputs 24 V DC in 1 group (4.0 ... 4.7)

The inputs/outputs are galvanically isolated from the CANopen network. There is no potential separation between the channels. The configuration of the analog inputs/outputs is performed by software.

For use in extreme ambient conditions (e.g. wider temperature and humidity range), a special XC version of the device is available.

Functionality

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface</td>
<td>CAN</td>
</tr>
<tr>
<td>Protocol</td>
<td>CANopen</td>
</tr>
<tr>
<td>Power supply</td>
<td>From the process supply voltage UP</td>
</tr>
<tr>
<td>Supply of the electronic circuitry of the I/O modules attached</td>
<td>Through the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>Rotary switches</td>
<td>For setting the CANopen Node ID for configuration purposes (00h to FFh)</td>
</tr>
<tr>
<td>LED displays</td>
<td>For system displays, signal states, errors and power supply</td>
</tr>
<tr>
<td>External supply voltage</td>
<td>Via terminals ZP, UP and UP3 (process supply voltage 24 V DC)</td>
</tr>
<tr>
<td>Transmission rates</td>
<td>10 / 20 / 50 / 125 / 250 / 500 / 800 kbit/s 1 Mbit/s Auto transmission rate detection is supported</td>
</tr>
<tr>
<td>Bus connection</td>
<td>Depending on used terminal unit TU510: 9-pin D-sub connector TU518: 10-pin terminal block</td>
</tr>
<tr>
<td>Processor</td>
<td>Hilscher NETX 100</td>
</tr>
<tr>
<td>Expandability</td>
<td>CI58x can only be used on onboard CAN interface and without any I/O expansion module ⇒ Table 215 “CANopen” on page 952.</td>
</tr>
<tr>
<td>State display</td>
<td>Module state: PWR/RUN, CN-RUN, CN-ERR, E-ERR, I/O bus</td>
</tr>
<tr>
<td>Adjusting elements</td>
<td>2 rotary switches for generation of the node address</td>
</tr>
<tr>
<td>Ambient temperature</td>
<td>System data AC500 ⇒ Chapter 5.1.2 “System data AC500” on page 166</td>
</tr>
<tr>
<td></td>
<td>System data AC500 XC ⇒ Chapter 5.1.3 “System data AC500-XC” on page 169</td>
</tr>
<tr>
<td>Current consumption</td>
<td>UP: 0.2 A UP3: 0.06 A + 0.5 A max. per output</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Weight (without terminal unit)</td>
<td>Ca. 125 g</td>
</tr>
<tr>
<td>Process supply voltages UP/UP3</td>
<td></td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC (for inputs and outputs)</td>
</tr>
<tr>
<td>Max. load for the terminals</td>
<td>10 A</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse on UP/UP3</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>CANopen interface against the rest of the module</td>
</tr>
<tr>
<td>Inrush current from UP (at power up)</td>
<td>On request</td>
</tr>
<tr>
<td>Current consumption via UP (normal operation)</td>
<td>0.2 A</td>
</tr>
<tr>
<td>Current consumption via UP3</td>
<td>0.06 A + 0.5 A max. per output</td>
</tr>
<tr>
<td>Connections</td>
<td></td>
</tr>
<tr>
<td>Terminals 2.8 and 3.8 for +24 V (UP)</td>
<td></td>
</tr>
<tr>
<td>Terminal 4.8 for +24 V (UP3)</td>
<td></td>
</tr>
<tr>
<td>Terminals 2.9, 3.9 and 4.9 for 0 V (ZP)</td>
<td></td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>6 W</td>
</tr>
<tr>
<td>Reference potential for all digital inputs and outputs</td>
<td>Negative pole of the supply voltage, signal name ZP</td>
</tr>
<tr>
<td>Setting of the CANopen Node ID identifier</td>
<td>With 2 rotary switches at the front side of the module</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal</td>
</tr>
<tr>
<td>Or vertical with derating (output load reduced to 50 % at +40 °C per group)</td>
<td></td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
<tr>
<td>Effect of incorrect input terminal connection</td>
<td>Wrong or no signal detected, no damage up to 35 V</td>
</tr>
<tr>
<td>Required terminal unit</td>
<td>TU509, TU510, TU517 or TU518</td>
</tr>
</tbody>
</table>

All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and continuous overvoltage up to 30 V DC.
### CI581-CN: Input/Output characteristics

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inputs and outputs</td>
<td>8 digital inputs (24 V DC; delay time configurable via software)</td>
</tr>
<tr>
<td></td>
<td>8 digital transistor outputs (24 V DC, 0.5 A max.)</td>
</tr>
<tr>
<td></td>
<td>4 analog inputs, configurable as:</td>
</tr>
<tr>
<td></td>
<td>● -10 V ... +10 V</td>
</tr>
<tr>
<td></td>
<td>● 0 V ... +10 V</td>
</tr>
<tr>
<td></td>
<td>● -10 V ... +10 V (differential voltage)</td>
</tr>
<tr>
<td></td>
<td>● 0 mA ... 20 mA</td>
</tr>
<tr>
<td></td>
<td>● 4 mA ... 20 mA</td>
</tr>
<tr>
<td></td>
<td>● Pt100, Pt1000, Ni1000 (for each 2-wire and 3-wire)</td>
</tr>
<tr>
<td></td>
<td>● 24 V digital input function</td>
</tr>
<tr>
<td></td>
<td>2 analog outputs, configurable as:</td>
</tr>
<tr>
<td></td>
<td>● -10 V ... +10 V</td>
</tr>
<tr>
<td></td>
<td>● 0 mA ... 20 mA</td>
</tr>
<tr>
<td></td>
<td>● 4 mA ... 20 mA</td>
</tr>
<tr>
<td>Resolution of the analog channels</td>
<td>12 bits</td>
</tr>
<tr>
<td>Fast counter</td>
<td>Integrated, configurable operating modes</td>
</tr>
</tbody>
</table>

### Connections

#### General

The CANopen communication interface module is plugged on the I/O terminal units TU517
\[6\] Chapter 5.2.7.4 “TU517 and TU518 for communication interface modules” on page 1278 or TU518 \[6\] Chapter 5.2.7.4 “TU517 and TU518 for communication interface modules” on page 1278 and accordingly TU509 or TU510. Properly position the module and press until it locks in place.

The connection of the I/O channels is established using the 30 terminals of the I/O terminal unit. I/O modules can be replaced without re-wiring the terminal units.

The terminals 2.8, 3.8, 2.9, 3.9 and 4.9 are electrically interconnected within the terminal unit and always have the same assignment, irrespective of the inserted module:

- Terminals 2.8 and 3.8: process supply voltage UP = +24 V DC
- Terminal 4.8: process supply voltage UP3 = +24 V DC
- Terminals 2.9, 3.9 and 4.9: process supply voltage ZP = 0 V

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

With a separate UP3 power supply, the digital outputs can be switched off externally. This way, an emergency-off functionality can be realized.
Do not connect any voltages externally to the digital outputs!
Reason: External voltages at an output or several outputs may cause other outputs to be supplied via that voltage instead of voltage UP3 (reverse voltage). This is not the intended use.

CAUTION!
Risk of malfunctions by unintended use!
If the function cut-off of the digital outputs is to be used by deactivation of the supply voltage UP3, be sure that no external voltage is connected at the outputs DO0 ... DO7 and DC0 ... DC7.

Possibilities of connection
Mounting on terminal units TU509 or TU510

The assignment of the 9-pin female D-sub for the CANopen signals

<table>
<thead>
<tr>
<th>Pin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>--- Reserved</td>
</tr>
<tr>
<td>2</td>
<td>CAN- Inverted signal of the CAN bus</td>
</tr>
<tr>
<td>3</td>
<td>CAN_GND Ground potential of the CAN bus</td>
</tr>
<tr>
<td>4</td>
<td>--- Reserved</td>
</tr>
<tr>
<td>5</td>
<td>--- Reserved</td>
</tr>
<tr>
<td>6</td>
<td>--- Reserved</td>
</tr>
<tr>
<td>7</td>
<td>CAN+ Non-inverted signal of the CAN bus</td>
</tr>
<tr>
<td>8</td>
<td>--- Reserved</td>
</tr>
<tr>
<td>9</td>
<td>--- Reserved</td>
</tr>
</tbody>
</table>

Shield: Cable shield, Functional earth

Bus terminating resistors
The ends of the data lines have to be terminated with a 120 Ω bus terminating resistor. The bus terminating resistor is usually installed directly at the bus connector.

Fig. 168: CANopen interface, bus terminating resistors connected to the line ends
1 CAN_GND
2 CAN_L
3 Shield
4 CAN_H
5 Data line, shielded twisted pair
6 COMBICON connection, CANopen interface

Fig. 169: DeviceNet interface, bus terminating resistors connected to the line ends

6 DeviceNet power supply
7 COMBICON connection, DeviceNet interface
8 Data lines, twisted pair cables
9 red
10 black
11 white
12 blue
13 bare

The grounding of the shield should take place at the switchgear ◎ Chapter 5.1.2 “System data AC500” on page 166.
Table 217: Assignment of the terminals

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>CAN+</td>
<td>Non-inverted signal of the CAN bus</td>
</tr>
<tr>
<td>1.1</td>
<td>CAN+</td>
<td>Non-inverted signal of the CAN bus</td>
</tr>
<tr>
<td>1.2</td>
<td>CAN-</td>
<td>Inverted signal of the CAN bus</td>
</tr>
<tr>
<td>1.3</td>
<td>CAN-</td>
<td>Inverted signal of the CAN bus</td>
</tr>
<tr>
<td>1.4</td>
<td>Term+</td>
<td>CAN bus termination for CAN+ (for bus termination, Term+ must be connected with CAN+)</td>
</tr>
<tr>
<td>1.5</td>
<td>Term+</td>
<td>CAN bus termination for CAN+ (connecting alternative for terminal 1.4)</td>
</tr>
<tr>
<td>1.6</td>
<td>Term-</td>
<td>CAN bus termination for CAN- (for bus termination, Term- must be connected with CAN-)</td>
</tr>
<tr>
<td>1.7</td>
<td>Term-</td>
<td>CAN bus termination for CAN- (connecting alternative for terminal 1.6)</td>
</tr>
<tr>
<td>1.8</td>
<td>CAN-GND</td>
<td>Ground potential of the CAN bus</td>
</tr>
<tr>
<td>1.9</td>
<td>CAN-GND</td>
<td>Ground potential of the CAN bus</td>
</tr>
</tbody>
</table>

At the line ends of a bus segment, terminating resistors must be connected. If TU517 or TU518 is used, the bus terminating resistors can be enabled by connecting the terminals Term+ and Term- to the data lines CAN+ and CAN- (no external terminating resistors are required, see figure below).

The following figures show the different connection options for the CANopen communication interface module:
In the case of TU517/TU518, the terminating resistors are not located inside the TU but inside the communication interface module CI581-CN. Hence, when removing the device from the TU, the bus terminating resistors are no longer connected to the bus. The bus itself will not be disconnected if a device is removed.

The grounding of the shield should take place at the control cabinet. Please refer to the AC500 System-Data Chapter 5.1.2 "System data AC500" on page 166.

Table 218: Assignment of the other terminals

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0</td>
<td>AI0+</td>
<td>Positive pole of analog input signal 0</td>
</tr>
<tr>
<td>2.1</td>
<td>AI1+</td>
<td>Positive pole of analog input signal 1</td>
</tr>
<tr>
<td>2.2</td>
<td>AI2+</td>
<td>Positive pole of analog input signal 2</td>
</tr>
<tr>
<td>2.3</td>
<td>AI3+</td>
<td>Positive pole of analog input signal 3</td>
</tr>
<tr>
<td>2.4</td>
<td>AI-</td>
<td>Negative pole of analog input signals 0 to 3</td>
</tr>
<tr>
<td>2.5</td>
<td>AO0+</td>
<td>Positive pole of analog output signal 0</td>
</tr>
<tr>
<td>2.6</td>
<td>AO1+</td>
<td>Positive pole of analog output signal 1</td>
</tr>
<tr>
<td>2.7</td>
<td>AI-</td>
<td>Negative pole of analog output signals 0 and 1</td>
</tr>
<tr>
<td>2.8</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>2.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
<tr>
<td>3.0</td>
<td>DI0</td>
<td>Signal of the digital input DI0</td>
</tr>
<tr>
<td>3.1</td>
<td>DI1</td>
<td>Signal of the digital input DI1</td>
</tr>
<tr>
<td>3.2</td>
<td>DI2</td>
<td>Signal of the digital input DI2</td>
</tr>
<tr>
<td>3.3</td>
<td>DI3</td>
<td>Signal of the digital input DI3</td>
</tr>
</tbody>
</table>
### Terminal Signal Description

<table>
<thead>
<tr>
<th></th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.4</td>
<td>DI4</td>
<td>Signal of the digital input DI4</td>
</tr>
<tr>
<td>3.5</td>
<td>DI5</td>
<td>Signal of the digital input DI5</td>
</tr>
<tr>
<td>3.6</td>
<td>DI6</td>
<td>Signal of the digital input DI6</td>
</tr>
<tr>
<td>3.7</td>
<td>DI7</td>
<td>Signal of the digital input DI7</td>
</tr>
<tr>
<td>3.8</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>3.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
<tr>
<td>4.0</td>
<td>DO0</td>
<td>Signal of the digital output DO0</td>
</tr>
<tr>
<td>4.1</td>
<td>DO1</td>
<td>Signal of the digital output DO1</td>
</tr>
<tr>
<td>4.2</td>
<td>DO2</td>
<td>Signal of the digital output DO2</td>
</tr>
<tr>
<td>4.3</td>
<td>DO3</td>
<td>Signal of the digital output DO3</td>
</tr>
<tr>
<td>4.4</td>
<td>DO4</td>
<td>Signal of the digital output DO4</td>
</tr>
<tr>
<td>4.5</td>
<td>DO5</td>
<td>Signal of the digital output DO5</td>
</tr>
<tr>
<td>4.6</td>
<td>DO6</td>
<td>Signal of the digital output DO6</td>
</tr>
<tr>
<td>4.7</td>
<td>DO7</td>
<td>Signal of the digital output DO7</td>
</tr>
<tr>
<td>4.8</td>
<td>UP3</td>
<td>Process voltage UP3 (24 V DC)</td>
</tr>
<tr>
<td>4.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
</tbody>
</table>

---

**WARNING!**

**Removal/Insertion under power**

The devices are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you

- connect or disconnect any signal or terminal block
- remove, mount or replace a module.

Disconnecting any powered devices while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The devices must not be opened when in operation. The same applies to the network interfaces.

---

**NOTICE!**

**Risk of damaging the PLC modules!**

Overvoltages and short circuits might damage the PLC modules.

- Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
- Never connect any voltages or signals to reserved terminals (marked with ```--`). Reserved terminals may carry internal voltages.
For the open-circuit detection (wire break), each analog input channel is pulled up to "plus" by a high-resistance resistor. If nothing is connected, the maximum voltage will be read in then.

Generally, analog signals must be laid in shielded cables. The cable shields must be grounded at both sides of the cables. In order to avoid unacceptable potential differences between different parts of the installation, low resistance equipotential bonding conductors must be laid.

For the measuring ranges that can be configured, please refer to the sections Measuring Ranges on page 984 and Parameterization on page 974.

The meaning of the LEDs is described in the section for the state LEDs on page 982.

The maximum possible bus length of a CAN network depends on bit rate (transmission rate) and cable type. The sum of all bus segments must not exceed the maximum bus length.

<table>
<thead>
<tr>
<th>Bit Rate (speed)</th>
<th>Bus Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Mbit/s</td>
<td>40 m</td>
</tr>
<tr>
<td>800 kbit/s</td>
<td>50 m</td>
</tr>
<tr>
<td>500 kbit/s</td>
<td>100 m</td>
</tr>
<tr>
<td>250 kbit/s</td>
<td>250 m</td>
</tr>
</tbody>
</table>
## Bit Rate (speed) vs. Bus Length

<table>
<thead>
<tr>
<th>Bit Rate (speed)</th>
<th>Bus Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>125 kbit/s</td>
<td>500 m</td>
</tr>
<tr>
<td>50 kbit/s</td>
<td>1000 m</td>
</tr>
</tbody>
</table>

---

### Connection of the digital inputs

![Diagram of digital inputs](image1.png)

*Fig. 171: Connection of the digital inputs to the module CI581-CN*

### Connection of the digital outputs

![Diagram of digital outputs](image2.png)

*Fig. 172: Connection of configurable digital outputs to the module CI581-CN*
Connection of resistance thermometers in 2-wire configuration to the analog inputs

When resistance thermometers (Pt100, Pt1000, Ni1000) are used, a constant current must flow to build the necessary voltage drop for the evaluation. For this, the module CI581-CN provides a constant current source which is multiplexed over the max. 4 analog input channels.

![Connection diagram]

Fig. 173: Connection of resistance thermometers in 2-wire configuration to the analog inputs

<table>
<thead>
<tr>
<th>Thermometer</th>
<th>Configuration</th>
<th>Channels Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pt100</td>
<td>2-wire</td>
<td>1</td>
</tr>
<tr>
<td>Pt1000</td>
<td>2-wire</td>
<td>1</td>
</tr>
<tr>
<td>Ni1000</td>
<td>2-wire</td>
<td>1</td>
</tr>
</tbody>
</table>

For the measuring ranges that can be configured, please refer to sections Measuring Ranges "Chapter 5.2.6.3.2.11 “Measuring ranges” on page 984 and Parameterization "Chapter 5.2.6.3.2.8 “Parameterization” on page 974."

The module CI581-CN performs a linearization of the resistance characteristic.

To avoid error messages, configure unused analog input channels as "unused".

Connection of resistance thermometers in 3-wire configuration to the analog inputs

When resistance thermometers (Pt100, Pt1000, Ni1000) are used, a constant current must flow through them to build the necessary voltage drop for the evaluation. For this, the module CI581-CN provides a constant current source which is multiplexed over the max. 4 analog input channels.
With 3-wire configuration, 2 adjacent analog channels belong together (e. g. the channels 0 and 1). In this case, both channels are configured according to the desired operating mode. The lower address must be the even address (channel 0), the next higher address must be the odd address (channel 1).

The constant current of one channel flows through the resistance thermometer. The constant current of the other channel flows through one of the cores. The module calculates the measured value from the two voltage drops and stores it under the input with the higher channel number (e. g. I1).

In order to keep measuring errors as small as possible, it is necessary to have all the involved conductors in the same cable. All the conductors must have the same cross section.

For the measuring ranges that can be configured, please refer to the sections Measuring Ranges \(\text{Chapter 5.2.6.3.2.11 "Measuring ranges" on page 984}\) and Parameterization \(\text{Chapter 5.2.6.3.2.8 "Parameterization" on page 974}\).

The module CI581-CN performs a linearization of the resistance characteristic.

To avoid error messages, configure unused analog input channels as "unused".
Connection of active-type analog sensors (Voltage) with galvanically isolated power supply to the analog inputs

Fig. 175: Connection of active-type analog sensors (Voltage) with galvanically isolated power supply to the analog inputs

<table>
<thead>
<tr>
<th>Voltage</th>
<th>0 ... 10 V</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

For the measuring ranges that can be configured, please refer to the sections Measuring Ranges § Chapter 5.2.6.3.2.11 “Measuring ranges” on page 984 and Parameterization § Chapter 5.2.6.3.2.8 “Parameterization” on page 974.

To avoid error messages, configure unused analog input channels as "unused".
Connection of active-type analog sensors (Current) with galvanically isolated power supply to the analog inputs

Fig. 176: Connection of active-type analog sensors (current) with galvanically isolated power supply to the analog input AI0 (Proceed with the analog inputs AI1 ... AI3 in the same way)

<table>
<thead>
<tr>
<th>Current</th>
<th></th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 ... 20 mA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 ... 20 mA</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For the measuring ranges that can be configured, please refer to the sections Measuring Ranges "Chapter 5.2.6.3.2.11 "Measuring ranges" on page 984 and Parameterization "Chapter 5.2.6.3.2.8 "Parameterization" on page 974.

Unused input channels can be left open-circuited, because they are of low resistance.
Connection of active-type analog sensors (Voltage) with no galvanically isolated power supply to the analog inputs

Fig. 177: Connection of active-type sensors (voltage) with no galvanically isolated power supply to the analog inputs (AO ... AI3)

**NOTICE!**
**Risk of faulty measurements!**

The negative pole/ground potential at the sensors must not have too large a potential difference with respect to ZP (max. ± 1 V within the full signal range).

Make sure that the potential difference never exceeds ± 1 V.

<table>
<thead>
<tr>
<th>Voltage</th>
<th>0 ... 10 V</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

For the measuring ranges that can be configured, please refer to the sections Measuring Ranges \(\text{Chapter 5.2.6.3.2.11 “Measuring ranges” on page 984 and Parameterization \(\text{Chapter 5.2.6.3.2.8 “Parameterization” on page 974.}}

To avoid error messages, configure unused analog input channels as "unused".
Connection of passive-type analog sensors (Current) to the analog inputs

![Connection diagram]

Fig. 178: Connection of passive-type analog sensors (current) to the analog inputs (A0 ... A3)

<table>
<thead>
<tr>
<th>Current</th>
<th>4 ... 20 mA</th>
<th>1 channel used</th>
</tr>
</thead>
</table>

CAUTION!
Risk of overloading the analog input!

If an analog current sensor supplies more than 25 mA for more than 1 second during initialization, this input is switched off by the module (input protection).

Only use sensors with fast initialization or without current peaks higher than 25 mA. If not possible, connect a 10-volt Zener diode in parallel to I+ and I-.

Unused input channels can be left open-circuited, because they are of low resistance.

Connection of active-type analog sensors (Voltage) to differential analog inputs

Differential inputs are very useful if analog sensors which are remotely non-isolated (e.g. the negative terminal is remotely grounded) are used.

Using differential inputs helps to considerably increase the measuring accuracy and to avoid ground loops.

With differential input configurations, two adjacent analog channels belong together (e.g. the channels 0 and 1). In this case, both channels are configured according to the desired operating mode. The lower address must be the even address (channel 0), the next higher address must be the odd address (channel 1). The converted analog value is available at the higher address (channel 1).

The analog value is calculated by subtraction of the input value with the higher address from the input value of the lower address.

The converted analog value is available at the odd channel (higher address).
**NOTICE!**

Risk of faulty measurements!

The negative pole/ground potential at the sensors must not have too large a potential difference with respect to ZP (max. ± 1 V within the full signal range). Make sure that the potential difference never exceeds ± 1 V.

![Diagram](image)

**Fig. 179: Connection of active-type analog sensors (voltage) to differential analog inputs (AI0 ... AI3)**

<table>
<thead>
<tr>
<th>Voltage</th>
<th>0 ... 10 V</th>
<th>with differential inputs, 2 channels used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V</td>
<td>with differential inputs, 2 channels used</td>
</tr>
</tbody>
</table>

For the measuring ranges that can be configured, please refer to the sections Measuring Ranges `Chapter 5.2.6.3.2.11 “Measuring ranges” on page 984` and Parameterization `Chapter 5.2.6.3.2.8 “Parameterization” on page 974.`

To avoid error messages, configure unused analog input channels as "unused".

**Use of analog inputs as digital inputs**

Several (or all) analog inputs can be configured as digital inputs. The inputs are not galvanically isolated against the other analog channels.
Fig. 180: Connection of digital sensors to the analog input (AI0 ... AI3)

<table>
<thead>
<tr>
<th>Digital input</th>
<th>24 V</th>
<th>1 channel used</th>
</tr>
</thead>
</table>

For the measuring ranges that can be configured, please refer to the sections Measuring Ranges © Chapter 5.2.6.3.2.11 “Measuring ranges” on page 984 and Parameterization © Chapter 5.2.6.3.2.8 “Parameterization” on page 974.

Connection of analog output loads (Voltage)

Fig. 181: Connection of analog output loads (voltage) to the analog outputs (AO0 ... AO1)

<table>
<thead>
<tr>
<th>Voltage</th>
<th>-10 V ... +10 V</th>
<th>Load ± 10 mA max.</th>
<th>1 channel used</th>
</tr>
</thead>
</table>
For the measuring ranges that can be configured, please refer to the sections Measuring Ranges "Chapter 5.2.6.3.2.11 "Measuring ranges" on page 984 and Parameterization "Chapter 5.2.6.3.2.8 "Parameterization" on page 974.

Unused analog outputs can be left open-circuited.

Connection of analog output loads (Current)

![Connection diagram](image)

**Fig. 182: Connection of analog output loads (current) to the analog outputs (AO0 ... AO1)**

<table>
<thead>
<tr>
<th>Current</th>
<th>0 ... 20 mA</th>
<th>Load 0 ... 500 Ω</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>4 ... 20 mA</td>
<td>Load 0 ... 500 Ω</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

For the measuring ranges that can be configured, please refer to the sections Measuring Ranges "Chapter 5.2.6.3.2.11 "Measuring ranges" on page 984 and Parameterization "Chapter 5.2.6.3.2.8 "Parameterization" on page 974.

Unused analog outputs can be left open-circuited.

**Internal data exchange**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital inputs (bytes)</td>
<td>3</td>
</tr>
<tr>
<td>Digital outputs (bytes)</td>
<td>3</td>
</tr>
<tr>
<td>Analog inputs (words)</td>
<td>4</td>
</tr>
<tr>
<td>Analog outputs (words)</td>
<td>2</td>
</tr>
<tr>
<td>Counter input data (words)</td>
<td>4</td>
</tr>
<tr>
<td>Counter output data (words)</td>
<td>8</td>
</tr>
</tbody>
</table>
Addressing

A detailed description concerning addressing can be found in the documentation of ABB Control Builder Plus Software.

The CANopen communication interface module reads the position of the rotary switches only during power-up, i.e. changes of the switch position during operation will have no effect until the next module initialization.

The range of permitted CANopen slave addresses is 1 to 127. Setting a higher address (> 128) does not lead to an error response, but results in a special mode (DS401). In this special mode, the device creates the node address by subtracting the value 128 from the address switch’s value.

I/O configuration

The CI582-CN CANopen bus configuration is handled by CANopen master with the exception of the slave node ID (via rotary switches) and the transmission rate (automatic detection).

The digital I/O channels and the fast counter are configured via software.

Parameterization

Parameters of the module

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID ¹)</td>
<td>Internal</td>
<td>0x1C84</td>
<td>WORD</td>
<td>0x1C84</td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal</td>
<td>54</td>
<td>BYTE</td>
<td>54</td>
</tr>
<tr>
<td>Error LED / Fail-safe function</td>
<td>On</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>(table error LED /</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Failsafe function)</td>
<td>Off by E4</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>§ Further information on page 974</td>
<td>Off by E3</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>On + failsafe</td>
<td>16</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off by E4 + failsafe</td>
<td>17</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off by E3 + failsafe</td>
<td>18</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reserved</td>
<td>0</td>
<td>0</td>
<td>ARRAY of 24</td>
<td></td>
</tr>
<tr>
<td>Check supply (UP and UP3)</td>
<td>On</td>
<td>0</td>
<td>BYTE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>1</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Fast counter</td>
<td>0</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>10 ²)</td>
<td>10</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

¹) With a faulty ID, the module reports a "parameter error" and does not perform cyclic process data transmission

²) For a description of the counter operating modes, please refer to the fast counter section § Chapter 5.2.4.3.2.9 "Fast counter" on page 606.
### Table 219: Settings "Error LED / Failsafe function"

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Error LED (S-ERR) lights up at errors of all error classes, failsafe mode off</td>
</tr>
<tr>
<td>Off by E4</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1, E2 and E3, failsafe mode off</td>
</tr>
<tr>
<td>Off by E3</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1 and E2, failsafe mode off</td>
</tr>
<tr>
<td>On +Failsafe</td>
<td>Error LED (S-ERR) lights up at errors of all error classes, failsafe mode on *)</td>
</tr>
<tr>
<td>Off by E4 + Failsafe</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1, E2 and E3, failsafe mode on *)</td>
</tr>
<tr>
<td>Off by E3 + Failsafe</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1 and E2, failsafe mode on *)</td>
</tr>
</tbody>
</table>

*) The parameters Behaviour analog outputs at communication error and Behaviour digital outputs at communication error are only evaluated if the failsafe function is enabled.

### Group parameters for the analog part

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog data format</td>
<td>Standard</td>
<td>0</td>
<td>BYTE 0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reserved</td>
<td>255</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Behavior analog outputs at communication error *)</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Last value</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Last value 5 s</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Last value 10 s</td>
<td>11</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute value</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute value 5 s</td>
<td>7</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute value 10 s</td>
<td>12</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*) The parameter Behavior analog outputs at communication error is only analyzed if the failsafe mode is ON.

### Channel parameters for the analog inputs (4x)

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input 0, Channel configuration</td>
<td>Operation modes of analog inputs</td>
<td>Operation modes of analog inputs</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>Input 0, Check channel</td>
<td>Settings channel monitoring</td>
<td>Settings channel monitoring</td>
<td>BYTE</td>
<td>0</td>
</tr>
</tbody>
</table>
### Table 220: Channel configuration - Operating modes of the analog inputs

<table>
<thead>
<tr>
<th>Internal Value</th>
<th>Operating Modes (individually configurable)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (default)</td>
<td>Not used</td>
</tr>
<tr>
<td>1</td>
<td>0 ... 10 V</td>
</tr>
<tr>
<td>2</td>
<td>Digital input</td>
</tr>
<tr>
<td>3</td>
<td>0 ... 20 mA</td>
</tr>
<tr>
<td>4</td>
<td>4 ... 20 mA</td>
</tr>
<tr>
<td>5</td>
<td>-10 V ... +10 V</td>
</tr>
<tr>
<td>8</td>
<td>2-wire Pt100 -50 °C ... +400 °C</td>
</tr>
<tr>
<td>9</td>
<td>3-wire Pt100 -50 °C ... +400 °C *)</td>
</tr>
<tr>
<td>10</td>
<td>0 ... 10 V (voltage diff.) *)</td>
</tr>
<tr>
<td>11</td>
<td>-10 V ... +10 V (voltage diff.) *)</td>
</tr>
<tr>
<td>14</td>
<td>2-wire Pt100 -50 °C ... +70 °C</td>
</tr>
<tr>
<td>15</td>
<td>3-wire Pt100 -50 °C ... +70 °C *)</td>
</tr>
<tr>
<td>16</td>
<td>2-wire Pt1000 -50 °C ... +400 °C</td>
</tr>
<tr>
<td>17</td>
<td>3-wire Pt1000 -50 °C ... +400 °C *)</td>
</tr>
<tr>
<td>18</td>
<td>2-wire Ni1000 -50 °C ... +150 °C</td>
</tr>
<tr>
<td>19</td>
<td>3-wire Ni1000 -50 °C ... +150 °C *)</td>
</tr>
</tbody>
</table>

*) In the operating modes with 3-wire configuration or with differential inputs, two adjacent analog inputs belong together (e.g. the channels 0 and 1). In these cases, both channels are configured in the desired operating mode. The lower address must be the even address (channel 0). The next higher address must be the odd address (channel 1). The converted analog value is available at the higher address (channel 1).

### Table 221: Channel monitoring

<table>
<thead>
<tr>
<th>Internal Value</th>
<th>Check Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (default)</td>
<td>Plausibility, wire break, short circuit</td>
</tr>
<tr>
<td>3</td>
<td>Not used</td>
</tr>
</tbody>
</table>
Channel parameters for the analog outputs (2x)

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output 0, Channel configuration</td>
<td>Operation modes of analog outputs</td>
<td>Operation modes of analog outputs</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>Output 0, Check channel</td>
<td>Channel monitoring</td>
<td>Channel monitoring</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>Output 0, Substitute value</td>
<td>Substitute value</td>
<td>Substitute value</td>
<td>WORD</td>
<td>0</td>
</tr>
<tr>
<td>Output 1, Channel configuration</td>
<td>Operation modes of analog outputs</td>
<td>Operation modes of analog outputs</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>Output 1, Check channel</td>
<td>Channel monitoring</td>
<td>Channel monitoring</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>Output 1, Substitute value</td>
<td>Substitute value</td>
<td>Substitute value</td>
<td>WORD</td>
<td>0</td>
</tr>
</tbody>
</table>

Table 222: Channel configuration - Operating modes of the analog outputs

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating Modes (individually configurable)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (default)</td>
<td>Not used</td>
</tr>
<tr>
<td>128</td>
<td>-10 V ... +10 V</td>
</tr>
<tr>
<td>129</td>
<td>0 mA ... 20 mA</td>
</tr>
<tr>
<td>130</td>
<td>4 mA ... 20 mA</td>
</tr>
</tbody>
</table>

Table 223: Channel monitoring

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Check channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Plausibility, wire break, short circuit</td>
</tr>
<tr>
<td>3</td>
<td>None</td>
</tr>
</tbody>
</table>

Table 224: Substitute value

<table>
<thead>
<tr>
<th>Intended Behavior of Output Channel when the Control System Stops</th>
<th>Required Setting of the Module Parameter &quot;Behavior of Outputs in Case of a Communication Error&quot;</th>
<th>Required Setting of the Channel Parameter &quot;Substitute value&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output OFF</td>
<td>Off</td>
<td>0</td>
</tr>
<tr>
<td>Last value infinite</td>
<td>Last value</td>
<td>0</td>
</tr>
<tr>
<td>Last value for 5 s and then turn off</td>
<td>Last value 5 sec</td>
<td>0</td>
</tr>
<tr>
<td>Last value for 10 s and then turn off</td>
<td>Last value 10 sec</td>
<td>0</td>
</tr>
<tr>
<td>Substitute value infinite</td>
<td>Substitute value</td>
<td>Depending on configuration</td>
</tr>
</tbody>
</table>
## Intended Behavior of Output Channel when the Control System Stops

<table>
<thead>
<tr>
<th>Required Setting of the Module Parameter &quot;Behavior of Outputs in Case of a Communication Error&quot;</th>
<th>Required Setting of the Channel Parameter &quot;Substitute value&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Substitute value for 5 s and then turn off</td>
<td>Substitute value 5 sec</td>
</tr>
<tr>
<td>Substitute value for 10 s and then turn off</td>
<td>Substitute value 10 sec</td>
</tr>
</tbody>
</table>

## Required Setting of the Module Parameter "Substitute value"

- Substitute value for 5 s and then turn off: Substitute value 5 sec
- Substitute value for 10 s and then turn off: Substitute value 10 sec

## Group parameters for the digital part

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input delay</td>
<td>0.1 ms</td>
<td>0</td>
<td>BYTE</td>
<td>0.1 ms 0x00</td>
</tr>
<tr>
<td></td>
<td>1 ms</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 ms</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>32 ms</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Detect short circuit at outputs</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>On 0x01</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Behavior digital outputs at communication error</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>Off 0x00</td>
</tr>
<tr>
<td></td>
<td>Last value</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Last value 5 sec</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Last value 10 sec</td>
<td>11</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute value</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute value 5 sec</td>
<td>7</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute value 10 sec</td>
<td>12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Substitute value at output</td>
<td>0 ... 255</td>
<td>00h ... FFh</td>
<td>BYTE</td>
<td>0 0x00</td>
</tr>
<tr>
<td>Detect voltage overflow at outputs</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>Off 0x00</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1) The parameter Behavior digital outputs at communication error is only analyzed if the failsafe mode is ON.

2) The state "externally voltage detected" appears if the output of a channel DC0 ... DC7 is to be switched on while an external voltage is connected to Chapter 5.2.6.3.2.4 “Connections” on page 957. In this case, the start-up is disabled as long as the external voltage is connected. The monitoring of this state and the resulting diagnosis message can be disabled by setting the parameters to "OFF".
In cases of short circuit or overload, the digital outputs are turned off. The module performs reactivation automatically. Thus, an acknowledgement of the errors is not necessary. The error message is stored via the LED.

In cases of short circuit or overload, the digital outputs are turned off. The module performs reactivation automatically. Thus, an acknowledgement of the errors is not necessary. The error message is stored via the LED.
<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error-Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>43</td>
<td>Internal error in the module</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>36</td>
<td>Internal data exchange failure</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>9</td>
<td>Overflow diagnosis buffer</td>
<td>Restart</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>26</td>
<td>Parameter error</td>
<td>Check Master</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>11</td>
<td>Process voltage UP too low</td>
<td>Check process supply voltage</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>45</td>
<td>Process voltage UP gone</td>
<td>Check process supply voltage</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>17</td>
<td>No communication with I/O module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>32</td>
<td>Wrong I/O module type on socket</td>
<td>Replace I/O module / check configuration</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>31</td>
<td>At least one module does not support failsafe function</td>
<td>Check modules and parameterization</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>46</td>
<td>Voltage feedback on activated digital outputs</td>
<td>Check terminals</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>34</td>
<td>No response during initialization of the I/O module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>11</td>
<td>Process voltage UP 3 too low</td>
<td>Check process supply voltage</td>
</tr>
<tr>
<td>E1..E4</td>
<td>d1</td>
<td>d2</td>
<td>d3</td>
<td>d4</td>
<td>Identifier</td>
<td>AC500-Display</td>
<td>← Display in</td>
</tr>
<tr>
<td>-------</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>-------------</td>
<td>----------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Class</td>
<td>Comp</td>
<td>Dev</td>
<td>Mod</td>
<td>Ch</td>
<td>Err</td>
<td>PS501 PLC Browser</td>
<td></td>
</tr>
<tr>
<td>Byte 4</td>
<td>Byte 1</td>
<td>Byte 2</td>
<td>Byte 3</td>
<td>Byte 4</td>
<td>CANope n diagnosis block</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bit 6 ... 7</td>
<td>Bit 0 ... 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error-Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>45</td>
<td>Process voltage UP3 gone</td>
<td>Check process supply voltage</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>10</td>
<td>Voltage overflow on outputs (above UP3 level)</td>
<td>Check terminals/ check process supply voltage</td>
</tr>
</tbody>
</table>

**Channel error digital**

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error-Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>2</td>
<td>0...7</td>
<td>46</td>
<td>Voltage feedback on deactivated digital output</td>
<td>Check terminals</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>2</td>
<td>0...7</td>
<td>47</td>
<td>Short circuit at digital output</td>
<td>Check terminals</td>
</tr>
</tbody>
</table>

**Channel error analog**

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error-Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>1</td>
<td>0..3</td>
<td>48</td>
<td>Analog value overflow or broken wire at an analog input</td>
<td>Check value or check terminals</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>1</td>
<td>0..3</td>
<td>7</td>
<td>Analog value underflow at an analog input</td>
<td>Check value</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>1</td>
<td>0..3</td>
<td>47</td>
<td>Short circuit at an analog input</td>
<td>Check terminals</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>3</td>
<td>0..1</td>
<td>4</td>
<td>Analog value overflow at an analog output</td>
<td>Check output value</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>3</td>
<td>0..1</td>
<td>7</td>
<td>Analog value underflow at an analog output</td>
<td>Check output value</td>
</tr>
</tbody>
</table>

Remarks:
1) In AC500, the following interface identifier applies:
   "-" = Diagnosis via bus-specific function blocks; 0 ... 4 or 10 = position of the
   communication module; 14 = I/O bus; 31 = module itself
   The identifier is not contained in the CI541-DP diagnosis block.

2) With "Device" the following allocation applies: 31 = module itself; 1 ... 10 =
   decentralized communication interface module

3) With "Module" the following allocation applies:
   31 = module itself
   Channel error: module type (1 = AI, 2 = DO, 3 = AO)

4) This message appears if external voltages at one or more terminals DO0 ... DO7
   cause other digital outputs to be fed by that voltage "Connections" on page 957. All outputs of the digital output groups will be turned off for 5 seconds. The diagnosis message appears for the whole output group.

5) The voltage on digital outputs DO0 ... DO7 has overrun the process supply voltage UP3 "Connections" on page 957. Diagnosis message appears for the whole module.

6) This message appears if the output of a channel DO0 ... DO7 is to be switched on while an external voltage is connected. In this case, start-up is disabled while the external voltage is connected. Otherwise, this could produce reverse voltage flowing from this output to other digital outputs. This diagnosis message appears for each channel.

7) Short circuit: After a short circuit has been detected, the output is deactivated for 100ms seconds. Subsequently, a new start-up will be executed. This diagnosis message appears for each channel.

---

State LEDs

The state LEDs are located at the front of module. There are 2 different groups:
- The 5 system LEDs (PWR, CN-RUN, CN-ERR, S-ERR and I/O bus) show the operation states of the module and display possible errors.
- The 27 process LEDs (UP, UP3, inputs, outputs, CH-ERR1 to CH-ERR3) show the process supply voltage and the states of the inputs and outputs and display possible errors.

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>OFF</th>
<th>ON</th>
<th>Flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR/RUN</td>
<td>Green</td>
<td>Process supply voltage missing</td>
<td>Internal supply voltage OK, module ready for communication with I/O controller</td>
<td>Start-up / preparing communication</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>CN-RUN</td>
<td>Green</td>
<td>---</td>
<td>Device configured, CANopen bus in OPERATIONAL state and cyclic data exchange running</td>
<td>Flashing: CANopen bus in PRE-OPERATIONAL state and slave is being configured Single flash: CANopen bus in STOPPED state Flickering: Auto-detect is active</td>
</tr>
</tbody>
</table>

---

States of the 5 system LEDs

---

Hardware descriptions
Device specifications > Communication interface modules
<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>OFF</th>
<th>ON</th>
<th>Flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>CN-ERR</td>
<td>Red</td>
<td>No system error</td>
<td>CANopen Bus is OFF</td>
<td>Flasing: Configuration error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Single flash: error counter overflow due to too many error frames</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Double flash: A node-guard or a heartbeat event occurred</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Flickering: Auto-detect is active</td>
</tr>
<tr>
<td>S-ERR</td>
<td>Red</td>
<td>No error</td>
<td>Internal error</td>
<td>--</td>
</tr>
<tr>
<td>I/O bus</td>
<td>Green</td>
<td>No decentralized I/O modules connected or communication error</td>
<td>Decentralized I/O modules connected and operational</td>
<td>---</td>
</tr>
</tbody>
</table>

### States of the 27 process LEDs:

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>OFF</th>
<th>ON</th>
<th>Flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>AI0 ... AI3</td>
<td>Yellow</td>
<td>Input is OFF</td>
<td>Input is ON (brightness depends on the value of the analog signal)</td>
<td>--</td>
</tr>
<tr>
<td>AO0 ... AO1</td>
<td>Yellow</td>
<td>Output is OFF</td>
<td>Output is ON (brightness depends on the value of the analog signal)</td>
<td>--</td>
</tr>
<tr>
<td>DI0 ... DI7</td>
<td>Yellow</td>
<td>Input is OFF</td>
<td>Input is ON (the input voltage is even displayed if the supply voltage is OFF)</td>
<td>--</td>
</tr>
<tr>
<td>DO0 ... DO7</td>
<td>Yellow</td>
<td>Output is OFF</td>
<td>Output is ON</td>
<td>--</td>
</tr>
<tr>
<td>UP</td>
<td>Green</td>
<td>Process supply voltage missing</td>
<td>Process supply voltage OK and initialization finished</td>
<td>--</td>
</tr>
<tr>
<td>UP3</td>
<td>Green</td>
<td>Process supply voltage missing</td>
<td>Process supply voltage OK</td>
<td>--</td>
</tr>
<tr>
<td>CH-ERR1 to CH-ERR3</td>
<td>Red</td>
<td>No error or process supply voltage missing</td>
<td>Internal error</td>
<td>Error on one channel of the corresponding group</td>
</tr>
</tbody>
</table>
## Measuring ranges

### Input ranges voltage, current and digital input

<table>
<thead>
<tr>
<th>Range</th>
<th>0 V ... +10 V</th>
<th>-10 V ... +10 V</th>
<th>0 mA ... 20 mA</th>
<th>4 mA ... 20 mA</th>
<th>Digital input</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Decimal</td>
<td>Hex.</td>
<td>Decimal</td>
<td>Hex.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overflow</td>
<td>&gt; 11.7589</td>
<td>&gt; 11.7589</td>
<td>&gt; 23.5178</td>
<td>&gt; 22.8142</td>
<td>32767</td>
<td>7FFF</td>
</tr>
<tr>
<td>Measured value too high</td>
<td>11.7589</td>
<td>11.7589</td>
<td>23.5178</td>
<td>22.8142</td>
<td>32511</td>
<td>7EFF</td>
</tr>
<tr>
<td></td>
<td>10.0004</td>
<td>10.0004</td>
<td>20.0007</td>
<td>20.0006</td>
<td>27649</td>
<td>6C01</td>
</tr>
<tr>
<td>Normal range</td>
<td>10.0000</td>
<td>10.0000</td>
<td>20.0000</td>
<td>20.0000</td>
<td>27648</td>
<td>6C00</td>
</tr>
<tr>
<td>Normal range or measured value too low</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0</td>
<td>4</td>
<td>Off</td>
<td>0</td>
</tr>
<tr>
<td>Measured value too low</td>
<td>-0.0004</td>
<td>-0.0004</td>
<td>3.9994</td>
<td>-1</td>
<td>FFFF</td>
<td>ED00</td>
</tr>
<tr>
<td></td>
<td>-1.7593</td>
<td></td>
<td>1.1858</td>
<td>-4864</td>
<td>27648</td>
<td>9400</td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt; 1.7593</td>
<td>&lt; -11.7589</td>
<td>&lt; 0.0000</td>
<td>&lt; 1.1858</td>
<td>-32768</td>
<td>8000</td>
</tr>
</tbody>
</table>

The represented resolution corresponds to 16 bits.

### Input ranges resistance temperature detector

<table>
<thead>
<tr>
<th>Range</th>
<th>Pt100 / Pt1000 -50 °C ... +400 °C</th>
<th>Ni1000 -50 °C ... +150 °C</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Decimal</td>
<td>Hex.</td>
<td></td>
</tr>
<tr>
<td>Overflow</td>
<td>&gt; +450.0 °C</td>
<td>&gt; +160.0 °C</td>
<td>32767</td>
</tr>
<tr>
<td>Measured value too high</td>
<td>+450.0 °C</td>
<td>+400.1 °C</td>
<td>4500</td>
</tr>
<tr>
<td></td>
<td></td>
<td>+160.0 °C</td>
<td>1600</td>
</tr>
<tr>
<td></td>
<td></td>
<td>+150.1 °C</td>
<td>1501</td>
</tr>
<tr>
<td></td>
<td></td>
<td>800</td>
<td>0320</td>
</tr>
<tr>
<td></td>
<td></td>
<td>701</td>
<td>02BD</td>
</tr>
</tbody>
</table>
### Range

<table>
<thead>
<tr>
<th>Range</th>
<th>Pt100 / Pt1000 -50 °C ... +400 °C</th>
<th>Ni1000 -50 °C ... +150 °C</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Decimal</td>
<td>Hex.</td>
<td>Decimal</td>
</tr>
<tr>
<td>Normal range</td>
<td>+400.0 °C</td>
<td>4000</td>
<td>0FA0</td>
</tr>
<tr>
<td></td>
<td>+0.1 °C</td>
<td>1</td>
<td>0001</td>
</tr>
<tr>
<td></td>
<td>-50.0 °C</td>
<td>-500</td>
<td>FE0C</td>
</tr>
<tr>
<td></td>
<td>-0.1 °C</td>
<td>-1</td>
<td>FFFF</td>
</tr>
<tr>
<td>Measured value too low</td>
<td>-50.1 °C</td>
<td>-501</td>
<td>FE0B</td>
</tr>
<tr>
<td></td>
<td>-60.0 °C</td>
<td>-600</td>
<td>FDA8</td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt; -60.0 °C</td>
<td>-32768</td>
<td>8000</td>
</tr>
</tbody>
</table>

### Output ranges voltage and current

<table>
<thead>
<tr>
<th>Range</th>
<th>-10 V ...+10 V</th>
<th>0 mA ... 20 mA</th>
<th>4 mA ... 20 mA</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Decimal</td>
<td>Hex.</td>
<td>Decimal</td>
<td>Hex.</td>
</tr>
<tr>
<td>Overflow</td>
<td>0 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>&gt; 32511</td>
</tr>
<tr>
<td></td>
<td>&gt; 7EFF</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Measured value too high</td>
<td>11.7589 V</td>
<td>23.5178 mA</td>
<td>22.8142 mA</td>
<td>32511</td>
</tr>
<tr>
<td></td>
<td>10.0004 V</td>
<td>20.0007 mA</td>
<td>20.0006 mA</td>
<td>27649</td>
</tr>
<tr>
<td></td>
<td>6C01</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Normal range</td>
<td>10.0000 V</td>
<td>20.0000 mA</td>
<td>20.0000 mA</td>
<td>27648</td>
</tr>
<tr>
<td></td>
<td>0.0004 V</td>
<td>0.0007 mA</td>
<td>4.0006 mA</td>
<td>1 0001</td>
</tr>
<tr>
<td></td>
<td>0.0000 V</td>
<td>0.0000 mA</td>
<td>4.0000 mA</td>
<td>0 0000</td>
</tr>
<tr>
<td></td>
<td>-0.0004 V</td>
<td>0 mA</td>
<td>3.9994 mA</td>
<td>-1 FFFF</td>
</tr>
<tr>
<td></td>
<td>-10.0000 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>-6912 E500</td>
</tr>
<tr>
<td></td>
<td>-11.7589 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>-27649 9400</td>
</tr>
<tr>
<td>Measured value too low</td>
<td>-10.0004 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>-27649 93FF</td>
</tr>
<tr>
<td></td>
<td>-11.7589 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>-32512 8100</td>
</tr>
<tr>
<td>Underflow</td>
<td>0 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>&lt; -32512 &lt; 8100</td>
</tr>
</tbody>
</table>

The represented resolution corresponds to 16 bits.
Technical data

Technical data of the module

The system data of AC500 and S500 are applicable to the standard version "Chapter 5.1.2 “System data AC500” on page 166.

The system data of AC500-XC are applicable to the XC version "Chapter 5.1.3 “System data AC500-XC” on page 169.

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.

Multiple overloads

No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an internal smart high-side switch.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface</td>
<td>CAN</td>
</tr>
<tr>
<td>Protocol</td>
<td>CANopen</td>
</tr>
<tr>
<td>Power supply</td>
<td>From the process supply voltage UP</td>
</tr>
<tr>
<td>Supply of the electronic circuitry of the I/O modules attached</td>
<td>Through the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>Rotary switches</td>
<td>For setting the CANopen Node ID for configuration purposes (00h to FFh)</td>
</tr>
<tr>
<td>LED displays</td>
<td>For system displays, signal states, errors and power supply</td>
</tr>
<tr>
<td>External supply voltage</td>
<td>Via terminals ZP, UP and UP3 (process supply voltage 24 V DC)</td>
</tr>
<tr>
<td>Transmission rates</td>
<td>10 / 20 / 50 / 125 / 250 / 500 / 800 kbit/s 1 Mbit/s Auto transmission rate detection is supported</td>
</tr>
<tr>
<td>Bus connection</td>
<td>Depending on used terminal unit TU510: 9-pin D-sub connector TU518: 10-pin terminal block</td>
</tr>
<tr>
<td>Processor</td>
<td>Hilscher NETX 100</td>
</tr>
<tr>
<td>Expandability</td>
<td>CI58x can only be used on onboard CAN interface and without any I/O expansion module &quot;Table 215 “CANopen” on page 952.</td>
</tr>
<tr>
<td>State display</td>
<td>Module state: PWR/RUN, CN-RUN, CN-ERR, E-ERR, I/O bus</td>
</tr>
<tr>
<td>Adjusting elements</td>
<td>2 rotary switches for generation of the node address</td>
</tr>
<tr>
<td>Ambient temperature</td>
<td>System data AC500 &quot;Chapter 5.1.2 “System data AC500” on page 166</td>
</tr>
<tr>
<td></td>
<td>System data AC500 XC &quot;Chapter 5.1.3 “System data AC500-XC” on page 169</td>
</tr>
<tr>
<td>Current consumption</td>
<td>UP: 0.2 A UP3: 0.06 A + 0.5 A max. per output</td>
</tr>
<tr>
<td>Weight (without terminal unit)</td>
<td>Ca. 125 g</td>
</tr>
<tr>
<td>Process supply voltages UP/UP3</td>
<td></td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC (for inputs and outputs)</td>
</tr>
</tbody>
</table>
### Parameter | Value
---|---
Max. load for the terminals | 10 A
Protection against reversed voltage | Yes
Rated protection fuse on UP/UP3 | 10 A fast
Galvanic isolation | CANopen interface against the rest of the module
Inrush current from UP (at power up) | On request
Current consumption via UP (normal operation) | 0.2 A
Current consumption via UP3 | 0.06 A + 0.5 A max. per output
Connections | Terminals 2.8 and 3.8 for +24 V (UP)
| Terminal 4.8 for +24 V (UP3)
| Terminals 2.9, 3.9 and 4.9 for 0 V (ZP)
Max. power dissipation within the module | 6 W
Reference potential for all digital inputs and outputs | Negative pole of the supply voltage, signal name ZP
Setting of the CANopen Node ID identifier | With 2 rotary switches at the front side of the module
Mounting position | Horizontal
| Or vertical with derating (output load reduced to 50 % at +40 °C per group)
Cooling | The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.
Effect of incorrect input terminal connection | Wrong or no signal detected, no damage up to 35 V
Required terminal unit | TU509, TU510, TU517 or TU518

*All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and continuous overvoltage up to 30 V DC.*

---

### Technical data of the digital inputs

| Parameter | Value |
---|---
Number of channels per module | 8
Distribution of the channels into groups | 1 group of 8 channels
Terminals of the channels DI0 ... DI7 | Terminals 3.0 ... 3.7
Reference potential for all inputs | Terminals 2.9 ... 4.9 (negative pole of the supply voltage, signal name ZP)
Indication of the input signals | 1 yellow LED per channel, the LED is ON when the input signal is high (signal 1)
Input type (according EN 61131-2) | Type 1
### Technical data of the digital outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels DO0 to DO7</td>
<td>Terminals 4.0 to 4.7</td>
</tr>
<tr>
<td>Reference potential for all outputs</td>
<td>Terminals 2.9 ... 4.9 (negative pole of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>For all outputs terminal 4.8 (positive pole of the supply voltage, signal name UP3)</td>
</tr>
<tr>
<td>Output voltage for signal 1</td>
<td>UP3 (-0.8 V)</td>
</tr>
<tr>
<td>Output delay (0-&gt;1 or 1-&gt;0)</td>
<td>On request</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated value per channel</td>
<td>500 mA at UP3 = 24 V</td>
</tr>
<tr>
<td>Max. value (all channels together)</td>
<td>4 A</td>
</tr>
<tr>
<td>Leakage current with signal 0</td>
<td>&lt; 0.5 mA</td>
</tr>
<tr>
<td>Fuse for UP3</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Demagnetization with inductive DC load</td>
<td>Via internal varistors (see figure below this table)</td>
</tr>
<tr>
<td>Output switching frequency</td>
<td></td>
</tr>
<tr>
<td>With resistive load</td>
<td>On request</td>
</tr>
<tr>
<td>With inductive loads</td>
<td>Max. 0.5 Hz</td>
</tr>
<tr>
<td>With lamp loads</td>
<td>11 Hz max. at 5 W max.</td>
</tr>
<tr>
<td>Short-circuit-proof / overload-proof</td>
<td>Yes</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Overload message (I &gt; 0.7 A)</td>
<td>Yes, after ca. 100 ms</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>Yes, automatic reactivation after short circuit/overload</td>
</tr>
<tr>
<td>Resistance to feedback against 24 V signals</td>
<td>Yes (software-controlled supervision)</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

Fig. 183: Circuitry of a digital input/output with the varistors for demagnetization when inductive loads are switched off

1. Digital output
2. Varistors for demagnetization when inductive loads are turned off

Technical data of the analog inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>4</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group with 4 channels</td>
</tr>
<tr>
<td>Connection if channels AI0+ to AI3+</td>
<td>Terminals 2.0 to 2.3</td>
</tr>
<tr>
<td>Reference potential for AI0+ to AI3+</td>
<td>Terminal 2.4 (AI-) for voltage and RTD measurement</td>
</tr>
<tr>
<td></td>
<td>Terminal 2.9, 3.9 and 4.9 for current measurement</td>
</tr>
<tr>
<td>Input type</td>
<td></td>
</tr>
<tr>
<td>Unipolar Voltage</td>
<td>Voltage 0...10 V, current or Pt100/Pt1000/Ni1000</td>
</tr>
<tr>
<td>Bipolar Voltage</td>
<td>Voltage -10...+10 V</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Against CANopen Bus</td>
</tr>
<tr>
<td>Configurability</td>
<td>0...10 V, -10...+10 V, 0/4...20 mA, Pt100/1000, Ni1000 (each input can be configured individually)</td>
</tr>
<tr>
<td>Channel input resistance</td>
<td>Voltage: &gt; 100 kΩ</td>
</tr>
<tr>
<td></td>
<td>Current: ca. 330 Ω</td>
</tr>
<tr>
<td>Time constant of the input filter</td>
<td>Voltage: 100 μs</td>
</tr>
<tr>
<td></td>
<td>Current: 100 μs</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 LED per channel (brightness depends on the value of the analog signal)</td>
</tr>
</tbody>
</table>
### Technical data of the analog inputs if used as digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>Max. 4</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group of 4 channels</td>
</tr>
<tr>
<td>Connections of the channels AI0+ to AI3+</td>
<td>Terminals 2.0 to 2.3</td>
</tr>
<tr>
<td>Reference potential for the inputs</td>
<td>Terminals 2.9, 3.9 and 4.9 (ZP)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 LED per channel</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 VDC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-30 V...+5 V</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>+5 V...+15 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>+15 V...+30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 7 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>Typ. 1.4 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>Typ. 3.7 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 9 mA</td>
</tr>
<tr>
<td>Input resistance</td>
<td>Ca. 3.5 kΩ</td>
</tr>
</tbody>
</table>

### Technical data of the analog outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>2</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group for 2 channels</td>
</tr>
<tr>
<td>Connection of the channels AO0+...AO1+</td>
<td>Terminals 1.5...1.6</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reference potential for AO0+ to AO1+</td>
<td>Terminal 2.7 (AO-) for voltage output</td>
</tr>
<tr>
<td></td>
<td>Terminal 2.9, 3.9 and 4.9 for current output</td>
</tr>
<tr>
<td>Output type</td>
<td></td>
</tr>
<tr>
<td>Unipolar</td>
<td>Current</td>
</tr>
<tr>
<td>Bipolar</td>
<td>Voltage</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Against internal supply and other modules</td>
</tr>
<tr>
<td>Configurability</td>
<td>-10...+10 V, 0...20 mA, 4...20 mA (each output can be configured individually)</td>
</tr>
<tr>
<td>Output resistance (load), as current output</td>
<td>0...500 Ω</td>
</tr>
<tr>
<td>Output loadability, as voltage output</td>
<td>±10 mA max.</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>1 LED per channel (brightness depends on the value of the analog signal)</td>
</tr>
<tr>
<td>Resolution</td>
<td>12 bits including sign</td>
</tr>
<tr>
<td>Settling time for full range change (resistive load, output signal within specified tolerance)</td>
<td>Typ. 5 ms</td>
</tr>
<tr>
<td>Conversion error of the analog values caused by non-linearity, adjustment error at factory and resolution within the normal range</td>
<td>Typ. 0.5 %, max. 1 %</td>
</tr>
<tr>
<td>Relationship between input signal and hex code</td>
<td>% Chapter 5.2.6.3.2.11.3 “Output ranges voltage and current” on page 985</td>
</tr>
<tr>
<td>Unused outputs</td>
<td>Are configured as &quot;unused&quot; (default value) and can be left open-circuited</td>
</tr>
</tbody>
</table>

**Technical data of the fast counter**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Used inputs</td>
<td>Terminal 3.0 (DI0), 3.1 (DI1)</td>
</tr>
<tr>
<td>Used outputs</td>
<td>Terminal 4.0 (DO0)</td>
</tr>
<tr>
<td>Counting frequency</td>
<td>Depending on operation mode:</td>
</tr>
<tr>
<td></td>
<td>Mode 1 - 6: max. 200 kHz</td>
</tr>
<tr>
<td></td>
<td>Mode 7: max. 50 kHz</td>
</tr>
<tr>
<td></td>
<td>Mode 9: max. 35 kHz</td>
</tr>
<tr>
<td></td>
<td>Mode 10: max. 20 kHz</td>
</tr>
<tr>
<td>Detailed description</td>
<td>Fast Counter % Chapter 5.2.4.3.2.9 “Fast counter” on page 606</td>
</tr>
<tr>
<td>Operating modes</td>
<td>Operating modes % Chapter 5.2.4.3.2.9 “Fast counter” on page 606</td>
</tr>
</tbody>
</table>
Dimensions

1 Din rail 15 mm
2 Din rail 7.5 mm

The dimensions are in mm and in brackets in inch.

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 228 100</td>
<td>CI581-CN, CANopen communication interface module with 8 DI, 8 DO, 4 AI and 2 AO</td>
<td>Active</td>
</tr>
<tr>
<td>R0001</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1SAP 428 100</td>
<td>CI581-CN-XC, CANopen communication interface module with 8 DI, 8 DO, 4 AI and 2 AO, XC version</td>
<td>Active</td>
</tr>
<tr>
<td>R0001</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
5.2.6.3.3 CI582-CN

Features

- 8 digital inputs 24 V DC
- 8 digital outputs 24 V DC, 0.5 A max.
- 8 configurable digital inputs/outputs 24 V DC, 0.5 A max.
- Module-wise galvanically isolated
- Fast counter
- XC version for use in extreme ambient conditions available

Hardware descriptions
Device specifications > Communication interface modules
Intended purpose

The CANopen communication interface module CI582-CN is used as decentralized I/O module in CANopen networks. Depending on the terminal unit used, the network connection is performed either via a female 9-pin D-sub connector or via 10 terminals (screw or spring terminals) which are integrated in the terminal unit. The communication interface module contains 24 I/O channels with the following properties:
- 8 digital configurable inputs/outputs in 1 group (1.0 ... 1.7)
- 8 digital inputs 24 V DC in 1 group (2.0 ... 2.7)
- 8 digital outputs 24 V DC in 1 group (3.0 ... 3.7)

The inputs/outputs are galvanically isolated from the CANopen network. There is no potential separation between the channels. The configuration of the analog inputs/outputs is performed by software.

For use in extreme ambient conditions (e.g. wider temperature and humidity range), a special XC version of the device is available.

Functionality

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface</td>
<td>CAN</td>
</tr>
<tr>
<td>Protocol</td>
<td>CANopen</td>
</tr>
<tr>
<td>Power supply</td>
<td>From the process supply voltage UP</td>
</tr>
<tr>
<td>Supply of the electronic circuitry of the I/O modules attached</td>
<td>Through the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>Rotary switches</td>
<td>For setting the CANopen Node ID for configuration purposes (00h to FFh)</td>
</tr>
<tr>
<td>LED displays</td>
<td>For system displays, signal states, errors and power supply</td>
</tr>
<tr>
<td>External supply voltage</td>
<td>Via terminals ZP, UP and UP3 (process supply voltage 24 V DC)</td>
</tr>
<tr>
<td>Transmission rates</td>
<td>10 / 20 / 50 / 125 / 250 / 500 / 800 kbit/s 1 Mbit/s Auto transmission rate detection is supported</td>
</tr>
<tr>
<td>Bus connection</td>
<td>Depending on used terminal unit TU510: 9-pin D-sub connector TU518: 10-pin terminal block</td>
</tr>
<tr>
<td>Processor</td>
<td>Hilscher NETX 100</td>
</tr>
<tr>
<td>Expandability</td>
<td>CI58x can only be used on onboard CAN interface and without any I/O expansion module Table 215 “CANopen” on page 952.</td>
</tr>
<tr>
<td>State display</td>
<td>Module state: PWR/RUN, CN-RUN, CN-ERR, E-ERR, I/O bus</td>
</tr>
<tr>
<td>Adjusting elements</td>
<td>2 rotary switches for generation of the node address</td>
</tr>
<tr>
<td>Ambient temperature</td>
<td>System data AC500 Chapter 5.1.2 “System data AC500” on page 166</td>
</tr>
<tr>
<td>Current consumption</td>
<td>UP: 0.2 A UP3: 0.06 A + 0.5 A max. per output</td>
</tr>
<tr>
<td>Weight (without terminal unit)</td>
<td>Ca. 125 g</td>
</tr>
</tbody>
</table>
### Parameter Value

**Process supply voltages UP/UP3**
- **Rated value**: 24 V DC (for inputs and outputs)
- **Max. load for the terminals**: 10 A
- **Protection against reversed voltage**: Yes
- **Rated protection fuse on UP/UP3**: 10 A fast

**Galvanic isolation**
- CANopen interface against the rest of the module

**Inrush current from UP (at power up)**
- On request

**Current consumption via UP (normal operation)**
- 0.2 A

**Current consumption via UP3**
- 0.06 A + 0.5 A max. per output

**Connections**
- Terminals 2.8 and 3.8 for +24 V (UP)
- Terminal 4.8 for +24 V (UP3)
- Terminals 2.9, 3.9 and 4.9 for 0 V (ZP)

**Max. power dissipation within the module**
- 6 W

**Reference potential for all digital inputs and outputs**
- Negative pole of the supply voltage, signal name ZP

**Setting of the CANopen Node ID identifier**
- With 2 rotary switches at the front side of the module

**Mounting position**
- Horizontal
  - Or vertical with derating (output load reduced to 50 % at +40 °C per group)

**Cooling**
- The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.

**Effect of incorrect input terminal connection**
- Wrong or no signal detected, no damage up to 35 V

**Required terminal unit**
- TU509, TU510, TU517 or TU518
  - Chapter 5.2.7.4 “TU517 and TU518 for communication interface modules” on page 1278

---

**CI582-CN: Input/Output characteristics**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inputs and outputs</td>
<td>8 digital inputs (24 V DC)</td>
</tr>
<tr>
<td></td>
<td>8 digital transistor outputs (24 V DC, 0.5 A max.)</td>
</tr>
<tr>
<td></td>
<td>8 configurable digital inputs/outputs (24 V DC, 0.5 A max.)</td>
</tr>
</tbody>
</table>

*All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and continuous overvoltage up to 30 V DC.*
Connections

General

The CANopen communication interface module is plugged on the I/O terminal units TU517 or TU518. Chapter 5.2.7.4 “TU517 and TU518 for communication interface modules” on page 1278 or TU518 Chapter 5.2.7.4 “TU517 and TU518 for communication interface modules” on page 1278 and accordingly TU509 or TU510. Properly position the module and press until it locks in place.

The connection of the I/O channels is established using the 30 terminals of the I/O terminal unit. I/O modules can be replaced without re-wiring the terminal units.

The terminals 2.8, 3.8, 2.9, 3.9 and 4.9 are electrically interconnected within the terminal unit and always have the same assignment, irrespective of the inserted module:

Terminals 2.8 and 3.8: process supply voltage UP = +24 V DC
Terminal 4.8: process supply voltage UP3 = +24 V DC
Terminals 2.9, 3.9 and 4.9: process supply voltage ZP = 0 V

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

With a separate UP3 power supply, the digital outputs can be switched off externally. This way, an emergency-off functionality can be realized.

Possibilities of connection

Mounting on terminal units

TU509 or TU510

The assignment of the 9-pin female D-sub for the CANopen signals

<table>
<thead>
<tr>
<th>1</th>
<th>---</th>
<th>Reserved</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>CAN-</td>
<td>Inverted signal of the CAN bus</td>
</tr>
<tr>
<td>3</td>
<td>CAN_GND</td>
<td>Ground potential of the CAN bus</td>
</tr>
<tr>
<td>4</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>5</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>6</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>7</td>
<td>CAN+</td>
<td>Non-inverted signal of the CAN bus</td>
</tr>
<tr>
<td>8</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>9</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>Shield</td>
<td>Cable shield</td>
<td>Functional earth</td>
</tr>
</tbody>
</table>

Bus terminating resistors

The ends of the data lines have to be terminated with a 120 Ω bus terminating resistor. The bus terminating resistor is usually installed directly at the bus connector.
Fig. 184: CANopen interface, bus terminating resistors connected to the line ends

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CAN_GND</td>
</tr>
<tr>
<td>2</td>
<td>CAN_L</td>
</tr>
<tr>
<td>3</td>
<td>Shield</td>
</tr>
<tr>
<td>4</td>
<td>CAN_H</td>
</tr>
<tr>
<td>5</td>
<td>Data line, shielded twisted pair</td>
</tr>
<tr>
<td>6</td>
<td>COMBICON connection, CANopen interface</td>
</tr>
</tbody>
</table>

Fig. 185: DeviceNet interface, bus terminating resistors connected to the line ends

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>DeviceNet power supply</td>
</tr>
<tr>
<td>7</td>
<td>COMBICON connection, DeviceNet interface</td>
</tr>
<tr>
<td>8</td>
<td>Data lines, twisted pair cables</td>
</tr>
<tr>
<td>9</td>
<td>red</td>
</tr>
</tbody>
</table>
The grounding of the shield should take place at the switchgear "Chapter 5.1.2 “System data AC500" on page 166.

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>CAN+</td>
<td>Non-inverted signal of the CAN bus</td>
</tr>
<tr>
<td>1.1</td>
<td>CAN+</td>
<td>Non-inverted signal of the CAN bus</td>
</tr>
<tr>
<td>1.2</td>
<td>CAN-</td>
<td>Inverted signal of the CAN bus</td>
</tr>
<tr>
<td>1.3</td>
<td>CAN-</td>
<td>Inverted signal of the CAN bus</td>
</tr>
<tr>
<td>1.4</td>
<td>Term+</td>
<td>CAN bus termination for CAN+ (for bus termination, Term+ must be connected with CAN+)</td>
</tr>
<tr>
<td>1.5</td>
<td>Term+</td>
<td>CAN bus termination for CAN+ (connecting alternative for terminal 1.4)</td>
</tr>
<tr>
<td>1.6</td>
<td>Term-</td>
<td>CAN bus termination for CAN- (for bus termination, Term- must be connected with CAN-)</td>
</tr>
<tr>
<td>1.7</td>
<td>Term-</td>
<td>CAN bus termination for CAN- (connecting alternative for terminal 1.6)</td>
</tr>
<tr>
<td>1.8</td>
<td>CAN-GND</td>
<td>Ground potential of the CAN bus</td>
</tr>
<tr>
<td>1.9</td>
<td>CAN-GND</td>
<td>Ground potential of the CAN bus</td>
</tr>
</tbody>
</table>

At the line ends of a bus segment, terminating resistors must be connected. If TU517 or TU518 is used, the bus terminating resistors can be enabled by connecting the terminals Term+ and Term- to the data lines CAN+ and CAN- (no external terminating resistors are required, see figure below).

The following figures show the different connection options for the CANopen communication interface module:
In the case of TU517/TU518, the terminating resistors are not located inside the TU but inside the communication interface module CI581-CN. Hence, when removing the device from the TU, the bus terminating resistors are no longer connected to the bus. The bus itself will not be disconnected if a device is removed.

The grounding of the shield should take place at the control cabinet. Please refer to the AC500 System-Data Chapter 5.1.2 “System data AC500” on page 166.
### Table 226: Assignment of the other terminals

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0</td>
<td>DC0</td>
<td>Signal of the configurable digital input/output DC0</td>
</tr>
<tr>
<td>2.1</td>
<td>DC1</td>
<td>Signal of the configurable digital input/output DC1</td>
</tr>
<tr>
<td>2.2</td>
<td>DC2</td>
<td>Signal of the configurable digital input/output DC2</td>
</tr>
<tr>
<td>2.3</td>
<td>DC3</td>
<td>Signal of the configurable digital input/output DC3</td>
</tr>
<tr>
<td>2.4</td>
<td>DC4</td>
<td>Signal of the configurable digital input/output DC4</td>
</tr>
<tr>
<td>2.5</td>
<td>DC5</td>
<td>Signal of the configurable digital input/output DC5</td>
</tr>
<tr>
<td>2.6</td>
<td>DC6</td>
<td>Signal of the configurable digital input/output DC6</td>
</tr>
<tr>
<td>2.7</td>
<td>DC7</td>
<td>Signal of the configurable digital input/output DC7</td>
</tr>
<tr>
<td>2.8</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>2.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
<tr>
<td>3.0</td>
<td>DI8</td>
<td>Signal of the digital input DI8</td>
</tr>
<tr>
<td>3.1</td>
<td>DI9</td>
<td>Signal of the digital input DI9</td>
</tr>
<tr>
<td>3.2</td>
<td>DI10</td>
<td>Signal of the digital input DI10</td>
</tr>
<tr>
<td>3.3</td>
<td>DI11</td>
<td>Signal of the digital input DI11</td>
</tr>
<tr>
<td>3.4</td>
<td>DI12</td>
<td>Signal of the digital input DI12</td>
</tr>
<tr>
<td>3.5</td>
<td>DI13</td>
<td>Signal of the digital input DI13</td>
</tr>
<tr>
<td>3.6</td>
<td>DI14</td>
<td>Signal of the digital input DI14</td>
</tr>
<tr>
<td>3.7</td>
<td>DI15</td>
<td>Signal of the digital input DI15</td>
</tr>
<tr>
<td>3.8</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>3.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
<tr>
<td>4.0</td>
<td>DO8</td>
<td>Signal of the digital output DO8</td>
</tr>
<tr>
<td>4.1</td>
<td>DO9</td>
<td>Signal of the digital output DO9</td>
</tr>
<tr>
<td>4.2</td>
<td>DO10</td>
<td>Signal of the digital output DO10</td>
</tr>
<tr>
<td>4.3</td>
<td>DO11</td>
<td>Signal of the digital output DO11</td>
</tr>
<tr>
<td>4.4</td>
<td>DO12</td>
<td>Signal of the digital output DO12</td>
</tr>
<tr>
<td>4.5</td>
<td>DO13</td>
<td>Signal of the digital output DO13</td>
</tr>
<tr>
<td>4.6</td>
<td>DO14</td>
<td>Signal of the digital output DO14</td>
</tr>
<tr>
<td>4.7</td>
<td>DO15</td>
<td>Signal of the digital output DO15</td>
</tr>
<tr>
<td>4.8</td>
<td>UP3</td>
<td>Process voltage UP3 (24 V DC)</td>
</tr>
<tr>
<td>4.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
</tbody>
</table>
WARNING!
Removal/Insertion under power

The devices are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you
  – connect or disconnect any signal or terminal block
  – remove, mount or replace a module.

Disconnecting any powered devices while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The devices must not be opened when in operation. The same applies to the network interfaces.

NOTICE!
Risk of damaging the PLC modules!

Overvoltages and short circuits might damage the PLC modules.

  – Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
  – Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

---

Fig. 186: Connection of the communication interface module CI582-CN

For a description of the meaning of the LEDs, please refer to the section for the state LEDs ∘ Chapter 5.2.6.3.10 “State LEDs” on page 1010.
**Bus length**

The maximum possible bus length of a CAN network depends on bit rate (transmission rate) and cable type. The sum of all bus segments must not exceed the maximum bus length.

<table>
<thead>
<tr>
<th>Bit Rate (speed)</th>
<th>Bus Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Mbit/s</td>
<td>40 m</td>
</tr>
<tr>
<td>800 kbit/s</td>
<td>50 m</td>
</tr>
<tr>
<td>500 kbit/s</td>
<td>100 m</td>
</tr>
<tr>
<td>250 kbit/s</td>
<td>250 m</td>
</tr>
<tr>
<td>125 kbit/s</td>
<td>500 m</td>
</tr>
<tr>
<td>50 kbit/s</td>
<td>1000 m</td>
</tr>
</tbody>
</table>

**Connection of the digital inputs**

*Fig. 187: Connection of the digital inputs (DI8 ... DI15) to the module CI582-CN*
Connection of the digital outputs

Fig. 188: Connection of configurable digital outputs (DO8 ... DO15) to the module CI582-CN

Connection of the configurable digital inputs/outputs

Fig. 189: Connection of configurable digital inputs/outputs (DC0 ... DC7) to the module CI582-CN
Internal data exchange

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital inputs (bytes)</td>
<td>5</td>
</tr>
<tr>
<td>Digital outputs (bytes)</td>
<td>5</td>
</tr>
<tr>
<td>Counter input data (words)</td>
<td>4</td>
</tr>
<tr>
<td>Counter output data (words)</td>
<td>8</td>
</tr>
</tbody>
</table>

Addressing

A detailed description concerning addressing can be found in the documentation of ABB Control Builder Plus Software.

> The CANopen communication interface module reads the position of the rotary switches only during power-up, i.e. changes of the switch position during operation will have no effect until the next module initialization.

> The range of permitted CANopen slave addresses is 1 to 127. Setting a higher address (> 128) does not lead to an error response, but results in a special mode (DS401). In this special mode, the device creates the node address by subtracting the value 128 from the address switch's value.

I/O configuration

The CI582-CN CANopen bus configuration is handled by CANopen master with the exception of the slave node ID (via rotary switches) and the transmission rate (automatic detection).

The digital I/O channels and the fast counter are configured via software.

Parameterization

Parameters of the module

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID 1)</td>
<td>Internal</td>
<td>0x1C89</td>
<td>WORD</td>
<td>0x1C89</td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal</td>
<td>38</td>
<td>BYTE</td>
<td>38</td>
</tr>
<tr>
<td>Error LED / failsafe function</td>
<td>On</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Off by E4</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off by E3</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>On + failsafe</td>
<td>16</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off by E4 + failsafe</td>
<td>17</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off by E3 + failsafe</td>
<td>18</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reserved</td>
<td>0</td>
<td>0</td>
<td>ARRAY of 24 BYTES</td>
<td></td>
</tr>
<tr>
<td>Check supply</td>
<td>On</td>
<td>0</td>
<td>BYTE</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
1) With a faulty ID, the module reports a "parameter error" and does not perform cyclic process data transmission.

2) For a description of the counter operating modes, please refer to the 'Fast Counter' section Chapter 5.2.4.3.2.9 “Fast counter” on page 606.

Table 227: Error LED / Failsafe function

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Error LED (S-ERR) lights up at errors of all error classes, failsafe mode off</td>
</tr>
<tr>
<td>Off by E4</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1, E2 and E3, failsafe mode off</td>
</tr>
<tr>
<td>Off by E3</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1 and E2, failsafe mode off</td>
</tr>
<tr>
<td>On + Failsafe</td>
<td>Error LED (S-ERR) lights up at errors of all error classes, failsafe mode on *)</td>
</tr>
<tr>
<td>Off by E4 + Failsafe</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1, E2 and E3, failsafe mode on *)</td>
</tr>
<tr>
<td>Off by E3 + Failsafe</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1 and E2, failsafe mode on *)</td>
</tr>
</tbody>
</table>

*) The parameter Behavior DO at comm. error is only analyzed if the failsafe mode is ON.

Group parameters for the digital part

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input delay</td>
<td>0.1 ms</td>
<td>0</td>
<td>BYTE</td>
<td>0.1 ms</td>
</tr>
<tr>
<td></td>
<td>1 ms</td>
<td>1</td>
<td></td>
<td>0x00</td>
</tr>
<tr>
<td></td>
<td>8 ms</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>32 ms</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Detect short-circuit at outputs</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>On</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td></td>
<td>0x01</td>
</tr>
<tr>
<td>Behavior DO at comm. error 1)</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>Off</td>
</tr>
<tr>
<td></td>
<td>Last value</td>
<td>1</td>
<td></td>
<td>0x00</td>
</tr>
<tr>
<td></td>
<td>Last value 5 sec</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Last value 10 sec</td>
<td>11</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute value</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute value 5 sec</td>
<td>7</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute value 10 sec</td>
<td>12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Value</td>
<td>Internal value</td>
<td>Internal value, type</td>
<td>Default</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------</td>
<td>----------------</td>
<td>----------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Substitute value at output</td>
<td>0 ... 65535</td>
<td>0000h ... FFFFh</td>
<td>WORD</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0x0000</td>
<td></td>
</tr>
<tr>
<td>Preventive voltage feedback monitoring for</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>Off</td>
</tr>
<tr>
<td>DC0 ... DC7</td>
<td>On</td>
<td>1</td>
<td></td>
<td>0x00</td>
</tr>
<tr>
<td>Detect voltage overflow at outputs 3)</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>Off</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td></td>
<td>0x00</td>
</tr>
</tbody>
</table>

Remarks:

1) The parameter Behavior DO at comm. error is applied to DC and DO channels and only analyzed if the failsafe mode is ON.

2) The state "externally voltage detected" appears if the output of a channel DC0 ... DC7 is to be switched on while an external voltage is connected. In this case, start-up is disabled while the externally voltage is connected. The monitoring of this state and the resulting diagnosis message can be disabled by setting the parameters to "OFF".

3) The error state "voltage overflow at outputs" appears if external voltage at digital outputs DC0 ... DC7 and DO0 ... DO7 has exceeded the process supply voltage UP3. The according diagnosis message "Voltage overflow on outputs" can be disabled by setting the parameters to "OFF". This parameter should only be disabled in exceptional cases as voltage overflow may produce reverse voltage.

**Diagnosis**

<table>
<thead>
<tr>
<th>Byte Number</th>
<th>Description</th>
<th>Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Diagnosis byte, slot number</td>
<td>31 = CI582-CN (e. g. error at integrated 8 DI / 8 DO)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = 1st connected S500 I/O module</td>
</tr>
<tr>
<td></td>
<td></td>
<td>...</td>
</tr>
<tr>
<td></td>
<td></td>
<td>10 = 10th connected S500 I/O module</td>
</tr>
<tr>
<td>2</td>
<td>Diagnosis byte, module number</td>
<td>According to the I/O bus specification passed on by modules to the fieldbus master</td>
</tr>
<tr>
<td>3</td>
<td>Diagnosis byte, channel</td>
<td>According to the I/O bus specification passed on by modules to the fieldbus master</td>
</tr>
</tbody>
</table>
In cases of short circuit or overload, the digital outputs are turned off. The module performs reactivation automatically. Thus, an acknowledgement of the errors is not necessary. The error message is stored via the LED.

<table>
<thead>
<tr>
<th>Byte Number</th>
<th>Description</th>
<th>Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Diagnosis byte, error code</td>
<td>According to the I/O bus specification</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bit 7 and bit 6, coded error class</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 = E1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = E2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 = E3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 = E4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bit 0 to Bit 5, coded error description</td>
</tr>
<tr>
<td>5</td>
<td>Diagnosis byte, flags</td>
<td>According to the I/O bus specification</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bit 7: 1 = coming error</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bit 6: 1 = leaving error</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>E1..E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier</th>
<th>AC500 display</th>
<th>&lt;- Display in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Comp</td>
<td>Dev</td>
<td>Mod</td>
<td>Ch</td>
<td>Err</td>
<td>PS501 PLC Browser</td>
<td></td>
</tr>
<tr>
<td>Byte 4</td>
<td>-</td>
<td>Byte 1</td>
<td>Byte 2</td>
<td>Byte 3</td>
<td>Byte 4</td>
<td>CANope n diagnosis block</td>
<td></td>
</tr>
<tr>
<td>Bit 6 ... 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Module errors

<table>
<thead>
<tr>
<th>3</th>
<th>-</th>
<th>31</th>
<th>31</th>
<th>31</th>
<th>19</th>
<th>Checksum error in the I/O module</th>
<th>Replace I/O module</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>3</td>
<td>Timeout in the I/O module</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>40</td>
<td>Different hard-/firmware versions in the module</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>43</td>
<td>Internal error in the module</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>36</td>
<td>Internal data exchange failure</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>9</td>
<td>Overflow diagnosis buffer</td>
<td>Restart</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>26</td>
<td>Parameter error</td>
<td>Check Master</td>
</tr>
<tr>
<td>E1..E4</td>
<td>d1</td>
<td>d2</td>
<td>d3</td>
<td>d4</td>
<td>Identifier</td>
<td>AC500 display</td>
<td>&lt;- Display in</td>
</tr>
<tr>
<td>--------</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>------------</td>
<td>---------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Class</td>
<td>Comp</td>
<td>Dev</td>
<td>Mod</td>
<td>Ch</td>
<td>Err</td>
<td>PS501 PLC Browser</td>
<td></td>
</tr>
<tr>
<td>Byte 4</td>
<td>Bit 6 ... 7</td>
<td>Byte 1</td>
<td>Byte 2</td>
<td>Byte 3</td>
<td>Byte 4</td>
<td>CANope n diag-</td>
<td>nosis block</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>11</td>
<td>Process voltage UP too low</td>
<td>Check process supply voltage</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>45</td>
<td>Process voltage UP gone</td>
<td>Check process supply voltage</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31/1...10</td>
<td>31</td>
<td>31</td>
<td>17</td>
<td>No communication with I/O module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>31</td>
<td>32</td>
<td>Wrong I/O module type on socket</td>
<td>Replace I/O module / check configuration</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>At least one module does not support failsafe function</td>
<td>Check modules and parameterization</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>45</td>
<td>Process voltage UP3 too low</td>
<td>Check process voltage</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>46</td>
<td>Voltage feedback on activated digital outputs 4</td>
<td>Check terminals</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31/1...10</td>
<td>31</td>
<td>31</td>
<td>34</td>
<td>No response during initialization of the I/O module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>11</td>
<td>Process voltage UP3 too low</td>
<td>Check process supply voltage</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>45</td>
<td>Process voltage UP3 gone</td>
<td>Check process supply voltage</td>
</tr>
</tbody>
</table>

Hardware descriptions
Device specifications > Communication interface modules
<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Voltage overflow on outputs (above UP3 level)</td>
<td>Check terminals/ check process supply voltage</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Externally voltage detected at digital output DO0 ... DO7</td>
<td>Check terminals</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>4</td>
<td>0...7</td>
<td>46</td>
<td>Externally voltage detected at digital output DC0 ... DC7</td>
<td>Check terminals</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>4</td>
<td>0...7</td>
<td>47</td>
<td>Short circuit at digital output DC0 ... DC7</td>
<td>Check terminals</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>2</td>
<td>8...15</td>
<td>47</td>
<td>Short circuit at digital output DO0 ... DO7</td>
<td>Check terminals</td>
</tr>
</tbody>
</table>

Remarks:

1) In AC500, the following interface identifier applies:
   *"* = Diagnosis via bus-specific function blocks; 0 ... 4 or 10 = position of the communication module; 14 = I/O bus; 31 = module itself
   The identifier is not contained in the CI542-DP diagnosis block.

2) With "Device" the following allocation applies: 31 = module itself, 1..10 = expansion module

3) With "Module" the following allocation applies depending on the master:
   Module error: 31 = module itself
   Channel error: module type (1 = AI, 2 = DO, 3 = AO)
4) This message appears if external voltages at one or more terminals DC0 ... DC7 or DO0 ... DO7 cause other digital outputs to be supplied by that voltage. All outputs of the digital output groups will be turned off for 5 seconds. The diagnosis message appears for the whole output group.

5) The voltage at digital outputs DC0 ... DC7 and DO0 ... DO7 has exceeded the process supply voltage UP3. A diagnosis message appears for the whole module.

6) This message appears if the output of a channel DC0 ... DC7 or DO0 ... DO7 should be switched on while an external voltage is connected. In this case the start-up is disabled while the external voltage is connected. Otherwise, this could produce reverse voltage flowing from this output to other digital outputs. This diagnosis message appears for each channel.

7) Short circuit: After a short circuit has been detected, the output is deactivated for 100ms. Subsequently, a new start-up will be executed. This diagnosis message appears for each channel.

State LEDs

The LEDs are located at the front of the module. There are 2 different groups:

- The 5 system LEDs (PWR, CN-RUN, CN-ERR, S-ERR and I/O bus) show the operation states of the module and display possible errors.
- The 29 process LEDs (UP, UP3, inputs, outputs, CH-ERR1 to CH-ERR3) show the process supply voltage and the states of the inputs and outputs and display possible errors.

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>OFF</th>
<th>ON</th>
<th>Flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR/RUN</td>
<td>Green</td>
<td>Process supply voltage missing</td>
<td>Internal supply voltage OK, module ready for communication with I/O controller</td>
<td>Start-up / preparing communication</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>CN-RUN</td>
<td>Green</td>
<td>---</td>
<td>Device configured, CANopen bus in OPERATIONAL state and cyclic data exchange running</td>
<td>Flashing: CANopen bus in PRE-OPERATIONAL state and slave is being configured Single flash: CANopen bus in STOPPED state. Flickering: Auto-detect is active</td>
</tr>
<tr>
<td>LED</td>
<td>Color</td>
<td>OFF</td>
<td>ON</td>
<td>Flashing</td>
</tr>
<tr>
<td>---------</td>
<td>-------</td>
<td>------------------------------------------</td>
<td>------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CN-ERR</td>
<td>Red</td>
<td>No system error</td>
<td>CANopen Bus is OFF</td>
<td>Flashing: Configuration error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Single flash: error counter overflow due to too many error frames</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Double flash: A node-guard or a heartbeat event occurred</td>
</tr>
<tr>
<td>S-ERR</td>
<td>Red</td>
<td>No error</td>
<td>Internal error</td>
<td>Flickering: Autodetect is active</td>
</tr>
<tr>
<td>I/O bus</td>
<td>Green</td>
<td>No decentralized I/O modules connected or communication error</td>
<td>Decentralized I/O modules connected and operational</td>
<td>---</td>
</tr>
</tbody>
</table>

### States of the 29 process LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>OFF</th>
<th>ON</th>
<th>Flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC0 ... DC7</td>
<td>Yellow</td>
<td>Input/output is OFF</td>
<td>Input/output is ON</td>
<td>--</td>
</tr>
<tr>
<td>DI8 ... DI15</td>
<td>Yellow</td>
<td>Input is OFF</td>
<td>Input is ON (the input voltage is even displayed if the supply voltage is OFF)</td>
<td>--</td>
</tr>
<tr>
<td>DO8 ... DO15</td>
<td>Yellow</td>
<td>Output is OFF</td>
<td>Output is ON</td>
<td>--</td>
</tr>
<tr>
<td>UP</td>
<td>Green</td>
<td>Process supply voltage missing</td>
<td>Process supply voltage OK and initialization finished</td>
<td>--</td>
</tr>
<tr>
<td>UP3</td>
<td>Green</td>
<td>Process supply voltage missing</td>
<td>Process supply voltage OK</td>
<td>--</td>
</tr>
<tr>
<td>CH-ERR1 to CH-ERR3</td>
<td>Red</td>
<td>No error or process supply voltage missing</td>
<td>Internal error</td>
<td>Error on one channel of the corresponding group</td>
</tr>
</tbody>
</table>

### Technical data

**Technical data of the module**

The system data of AC500 and S500 are applicable to the standard version "Chapter 5.1.2 "System data AC500" on page 166."

The system data of AC500-XC are applicable to the XC version "Chapter 5.1.3 "System data AC500-XC" on page 169."

Only additional details are therefore documented below.
The technical data are also applicable to the XC version.

---

**Multiple overloads**

No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an internal smart high-side switch.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface</td>
<td>CAN</td>
</tr>
<tr>
<td>Protocol</td>
<td>CANopen</td>
</tr>
<tr>
<td>Power supply</td>
<td>From the process supply voltage UP</td>
</tr>
<tr>
<td>Supply of the electronic circuitry of the I/O modules attached</td>
<td>Through the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>Rotary switches</td>
<td>For setting the CANopen Node ID for configuration purposes (00h to FFh)</td>
</tr>
<tr>
<td>LED displays</td>
<td>For system displays, signal states, errors and power supply</td>
</tr>
<tr>
<td>External supply voltage</td>
<td>Via terminals ZP, UP and UP3 (process supply voltage 24 V DC)</td>
</tr>
<tr>
<td>Transmission rates</td>
<td>10 / 20 / 50 / 125 / 250 / 500 / 800 kbit/s 1 Mbit/s Auto transmission rate detection is supported</td>
</tr>
<tr>
<td>Bus connection</td>
<td>Depending on used terminal unit TU510: 9-pin D-sub connector TU518: 10-pin terminal block</td>
</tr>
<tr>
<td>Processor</td>
<td>Hilscher NETX 100</td>
</tr>
<tr>
<td>Expandability</td>
<td>CI58x can only be used on onboard CAN interface and without any I/O expansion module Table 215 “CANopen” on page 952.</td>
</tr>
<tr>
<td>State display</td>
<td>Module state: PWR/RUN, CN-RUN, CN-ERR, E-ERR, I/O bus</td>
</tr>
<tr>
<td>Adjusting elements</td>
<td>2 rotary switches for generation of the node address</td>
</tr>
<tr>
<td>Ambient temperature</td>
<td>System data AC500 % Chapter 5.1.2 “System data AC500” on page 166</td>
</tr>
<tr>
<td></td>
<td>System data AC500 XC % Chapter 5.1.3 “System data AC500-XC” on page 169</td>
</tr>
<tr>
<td>Current consumption</td>
<td>UP: 0.2 A UP3: 0.06 A + 0.5 A max. per output</td>
</tr>
<tr>
<td>Weight (without terminal unit)</td>
<td>Ca. 125 g</td>
</tr>
<tr>
<td>Process supply voltages UP/UP3</td>
<td></td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC (for inputs and outputs)</td>
</tr>
<tr>
<td>Max. load for the terminals</td>
<td>10 A</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse on UP/UP3</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>CANopen interface against the rest of the module</td>
</tr>
<tr>
<td>Inrush current from UP (at power up)</td>
<td>On request</td>
</tr>
<tr>
<td>Current consumption via UP (normal operation)</td>
<td>0.2 A</td>
</tr>
<tr>
<td>Current consumption via UP3</td>
<td>0.06 A + 0.5 A max. per output</td>
</tr>
<tr>
<td>Connections</td>
<td>Terminals 2.8 and 3.8 for +24 V (UP)</td>
</tr>
<tr>
<td></td>
<td>Terminal 4.8 for +24 V (UP3)</td>
</tr>
<tr>
<td></td>
<td>Terminals 2.9, 3.9 and 4.9 for 0 V (ZP)</td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>6 W</td>
</tr>
</tbody>
</table>
Technical data of the digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels DI0 ... DI7</td>
<td>Terminals 3.0 ... 3.7</td>
</tr>
<tr>
<td>Reference potential for all inputs</td>
<td>Terminals 2.9 ... 4.9 (negative pole of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel, the LED is ON when the input signal is high (signal 1)</td>
</tr>
<tr>
<td>Input type (according EN 61131-2)</td>
<td>Type 1</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 0.1 ms, configurable from 0.1 ms ... 32 ms</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-3 V ... +5 V</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>&gt; +5 V ... &lt; +15 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>+15 V ... +30 V</td>
</tr>
<tr>
<td>Ripple with signal 0</td>
<td>Within -3 V ... +5 V</td>
</tr>
<tr>
<td>Ripple with signal 1</td>
<td>Within +15 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 5 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>&gt; 1 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>&gt; 2 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 8 mA</td>
</tr>
</tbody>
</table>
### Technical data of the digital outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels DO0 to DO7</td>
<td>Terminals 4.0 to 4.7</td>
</tr>
<tr>
<td>Reference potential for all outputs</td>
<td>Terminals 2.9 ... 4.9 (negative pole of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>For all outputs terminal 4.8 (positive pole of the supply voltage, signal name UP3)</td>
</tr>
<tr>
<td>Output voltage for signal 1</td>
<td>UP3 (-0.8 V)</td>
</tr>
<tr>
<td>Output delay (0-&gt;1 or 1-&gt;0)</td>
<td>On request</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated value per channel</td>
<td>500 mA at UP3 = 24 V</td>
</tr>
<tr>
<td>Max. value (all channels together)</td>
<td>4 A</td>
</tr>
<tr>
<td>Leakage current with signal 0</td>
<td>&lt; 0.5 mA</td>
</tr>
<tr>
<td>Fuse for UP3</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Demagnetization with inductive DC load</td>
<td>Via internal varistors (see figure below this table)</td>
</tr>
<tr>
<td>Output switching frequency</td>
<td></td>
</tr>
<tr>
<td>With resistive load</td>
<td>On request</td>
</tr>
<tr>
<td>With inductive loads</td>
<td>Max. 0.5 Hz</td>
</tr>
<tr>
<td>With lamp loads</td>
<td>11 Hz max. at 5 W max.</td>
</tr>
<tr>
<td>Short-circuit-proof / overload-proof</td>
<td>Yes</td>
</tr>
<tr>
<td>Overload message (I &gt; 0.7 A)</td>
<td>Yes, after ca. 100 ms</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>Yes, automatic reactivation after short circuit/overload</td>
</tr>
<tr>
<td>Resistance to feedback against 24 V signals</td>
<td>Yes (software-controlled supervision)</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

### Parameter Value

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>
Technical data of the configurable digital inputs/outputs

Each of the configurable I/O channels is defined as input or output by the user program. This is done by interrogating or allocating the corresponding channel.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8 inputs/outputs (with transistors)</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group for 8 channels</td>
</tr>
<tr>
<td>If the channels are used as inputs</td>
<td></td>
</tr>
<tr>
<td>Channels DC0...DC07</td>
<td>Terminals 2.0...2.7</td>
</tr>
<tr>
<td>If the channels are used as outputs</td>
<td></td>
</tr>
<tr>
<td>Channels DC0...DC07</td>
<td>Terminals 2.0...2.7</td>
</tr>
<tr>
<td>Indication of the input/output signals</td>
<td>1 yellow LED per channel, the LED is ON when the input/output signal is high (signal 1)</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>From the CANopen network</td>
</tr>
</tbody>
</table>

Please refer to the Technical Data of the Digital Inputs "Chapter 5.2.6.3.3.11 “Technical data” on page 1011. Deviation:

Technical data of the digital inputs/outputs if used as inputs

Terminals of the channels DC0 to DC7: Terminals 2.0 to 2.7

Due to the direct connection to the output, the demagnetizing varistor is also effective at the input. This is why the difference between UPx and the input signal must not exceed the clamp voltage of the varistor. The varistor limits the clamp voltage to approx. 36 V. Consequently, the input voltage must range from -12 V to +30 V when UPx = 24 V and from -6 V to +30 V when UPx = 30 V.

Please refer to the Technical Data of the Digital Outputs "Chapter 5.2.6.3.3.11 “Technical data” on page 1011. Deviation:

Technical data of the digital inputs/outputs if used as outputs

Terminals of the channels DC0 to DC7: Terminals 2.0 to 2.7

The following drawing shows the circuitry of a digital input/output with the varistors for demagnetization when inductive loads are switched off.
**Fig. 191: Digital input/output (circuit diagram)**

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Digital input/output</td>
</tr>
<tr>
<td>2</td>
<td>For demagnetization when inductive loads are turned off</td>
</tr>
</tbody>
</table>

### Technical data of the fast counter

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Used inputs</td>
<td>Terminal 3.0 (DI8), 3.1 (DI9)</td>
</tr>
<tr>
<td>Used outputs</td>
<td>Terminal 4.0 (DO8)</td>
</tr>
<tr>
<td>Counting frequency</td>
<td>Depending on operation mode:</td>
</tr>
<tr>
<td></td>
<td>Mode 1 - 6: max. 200 kHz</td>
</tr>
<tr>
<td></td>
<td>Mode 7: max. 50 kHz</td>
</tr>
<tr>
<td></td>
<td>Mode 9: max. 35 kHz</td>
</tr>
<tr>
<td></td>
<td>Mode 10: max. 20 kHz</td>
</tr>
<tr>
<td>Detailed description</td>
<td>Fast Counter [Chapter 5.2.4.3.2.9 “Fast counter” on page 606]</td>
</tr>
<tr>
<td>Operating modes</td>
<td>Operating modes [Chapter 5.2.4.3.2.9 “Fast counter” on page 606]</td>
</tr>
</tbody>
</table>
Dimensions

1 Din rail 15 mm
2 Din rail 7.5 mm

The dimensions are in mm and in brackets in inch.

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 228 200 R0001</td>
<td>CI582-CN, CANopen communication interface module with 8 DI, 8 DO and 8 DC</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 428 200 R0001</td>
<td>CI582-CN-XC, CANopen communication interface module with 8 DI, 8 DO and 8 DC, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
5.2.6.4 EtherCAT
5.2.6.4.1 CI511-ETHCAT

Features

- 4 analog inputs (resolution 12 bits including sign)
- 2 analog outputs (resolution 12 bits including sign)
- 8 digital inputs 24 V DC
- 8 digital outputs 24 V DC, 0.5 A max.
- Cam switch functionality (see also Extended Cam Switch Library)
- Extended Cam switch functionality *) (see also Extended Cam Switch Library)
- Module-wise galvanically isolated - Expandability with up to 10 S500 I/O Modules *)

*) Applicable for device index C0 and above.

1. I/O bus
2. Allocation between terminal number and signal name
3. 6 yellow LEDs to display the signal states of the analog inputs/outputs (AI0 ... AI3, AO0 ... AO1)
4. 8 yellow LEDs to display the signal states of the digital inputs (DI0 ... DI7)
5. 8 yellow LEDs to display the signal states of the digital outputs (DO0 ... DO7)
6. 2 green LEDs to display the supply voltage UP and UP3
7. 3 red LEDs to display errors (CH-ERR1, CH-ERR2, CH-ERR3)
8. 5 system LEDs: PWR/RUN, NET, DC, S-ERR, I/O-Bus
9. 2 rotary switches (reserved for future extensions)
10. Label
11 Ethernet interfaces (ETH1, ETH2) on the terminal unit
12 Terminal unit
13 DIN rail

Intended purpose

The EtherCAT communication interface module CI511-ETHCAT is used as decentralized I/O module in EtherCAT networks. The network connection is performed via 2 RJ45 connectors which are integrated in the terminal unit. The communication interface module contains 22 I/O channels with the following properties:

- 4 analog inputs (1.0 ... 1.3)
- 2 analog outputs (1.5 ... 1.6)
- 8 digital inputs 24 V DC in 1 group (2.0 ... 2.7)
- 8 digital outputs 24 V DC in 1 group (3.0 ... 3.7)
- Cam switch functionality

The inputs/outputs are galvanically isolated from the Ethernet network. There is no potential separation between the channels. The configuration of the analog inputs/outputs is performed by software.

Functionality

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface</td>
<td>Ethernet</td>
</tr>
<tr>
<td>Protocol</td>
<td>EtherCAT</td>
</tr>
<tr>
<td>Power supply</td>
<td>From the process supply voltage UP</td>
</tr>
<tr>
<td>Supply of the electronic circuitry of the I/O expansion modules attached</td>
<td>Through the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>Rotary switches</td>
<td>Not used; reserved for future extensions</td>
</tr>
<tr>
<td>Analog inputs</td>
<td>4 (configurable via software)</td>
</tr>
<tr>
<td>Analog outputs</td>
<td>2 (configurable via software)</td>
</tr>
<tr>
<td>Digital inputs</td>
<td>8 (24 V DC; delay time configurable via software)</td>
</tr>
<tr>
<td>Digital outputs</td>
<td>8 (24 V DC, 0.5 A max.)</td>
</tr>
<tr>
<td>LED displays</td>
<td>For system displays, signal states, errors and power supply</td>
</tr>
<tr>
<td>External supply voltage</td>
<td>Via terminals ZP, UP and UP3 (process supply voltage 24 V DC)</td>
</tr>
<tr>
<td>Effect of incorrect input terminal connection</td>
<td>Wrong or no signal detected, no damage up to 35 V</td>
</tr>
<tr>
<td>Required terminal unit</td>
<td>TU507 or TU508 * Chapter 5.2.7.2 “TU507-ETH and TU508-ETH for Ethernet communication interface modules” on page 1270</td>
</tr>
</tbody>
</table>
Connections

General

The Ethernet communication interface module CI51-ETHCAT is plugged on the I/O terminal unit TU507-ETH or TU508-ETH. Properly seat the module and press until it locks in place. The terminal unit is mounted on a DIN rail or with 2 screws plus the additional accessory for wall mounting (TA526).

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The connection of the I/O channels is carried out using the 30 terminals of the I/O terminal unit. I/O modules can be replaced without re-wiring the terminal units.

The terminals 1.8 and 2.8 as well as 1.9, 2.9 and 3.9 are electrically interconnected within the terminal unit and have always the same assignment, independent of the inserted module:

Terminals 1.8 and 2.8: Process supply voltage UP = +24 V DC
Terminal 3.8: Process supply voltage UP3 = +24 V DC
Terminals 1.9, 2.9 and 3.9: Process supply voltage ZP = 0 V

With a separate UP3 power supply, the digital outputs can be switched off externally. This way, an emergency-off functionality can be realized.

The assignment of the other terminals:

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0 ... 1.3</td>
<td>AI0 ... AI3</td>
<td>Positive pole of the 4 analog inputs</td>
</tr>
<tr>
<td>1.4</td>
<td>AI-</td>
<td>Negative pole of the analog inputs</td>
</tr>
<tr>
<td>1.5 ... 1.6</td>
<td>AO0 ... AO1</td>
<td>Positive pole of the 2 analog outputs</td>
</tr>
<tr>
<td>1.7</td>
<td>AO-</td>
<td>Negative pole of the analog outputs</td>
</tr>
<tr>
<td>2.0 ... 2.7</td>
<td>DI0 ... DI7</td>
<td>8 digital inputs</td>
</tr>
<tr>
<td>3.0 ... 3.7</td>
<td>DO0 ... DO7</td>
<td>8 digital outputs</td>
</tr>
</tbody>
</table>
WARNING!

Removal/Insertion under power

The devices are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you
- connect or disconnect any signal or terminal block
- remove, mount or replace a module.

Disconnecting any powered devices while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The devices must not be opened when in operation. The same applies to the network interfaces.

CAUTION!

There is no galvanic isolation between the analog circuitry and ZP/UP. Therefore, the analog sensors must be galvanically isolated in order to avoid loops via the ground potential or the supply voltage.

CAUTION!

Because of their common reference potential, analog current inputs cannot be circuited in series, neither within the module nor with channels of other modules.

For the open-circuit detection (wire break), each channel is pulled up to "plus" by a high-resistance resistor. If nothing is connected, the maximum voltage will be read in then.

Analog signals are always laid in shielded cables. The cable shields are grounded at both ends of the cables. In order to avoid unacceptable potential differences between different parts of the installation, low resistance equipotential bonding conductors must be laid.

For simple applications (low disturbances, no high requirement on precision), the shielding can also be omitted.
Fig. 192: Connection of the communication interface module CI511-ETHCAT

1 4 analog inputs, configurable for 0 ... 10 V, -10 ... +10 V, 0/4 ... 20 mA, Pt100/Pt1000, Ni1000 and digital signals
2 2 analog outputs, configurable for -10 ... +10 V, 0/4 ... 20 mA
3 8 digital inputs 24 V DC
4 8 digital outputs 24 V DC, 0.5 A max.

In case of voltage feedback, 2 cases are distinguished:

1. The outputs are already active
   The output group will be switched off. A diagnosis message will appear. After 5 seconds, the module tries automatic reactivation.

2. The outputs are not active
   Only the output with voltage feedback will not be set to active. A diagnosis message will appear.

NOTICE!
Risk of faulty measurements!
The negative pole/ground potential at the sensors must not have too large a potential difference with respect to ZP (max. ± 1 V within the full signal range).
Make sure that the potential difference never exceeds ± 1 V.

CAUTION!
The process supply voltage must be included within the grounding concept of the plant (e.g. grounding of the negative pole).

The module provide several diagnosis functions § Chapter 5.2.6.4.1.9 “Diagnosis” on page 1039.
The measuring ranges are described in the section Measuring Ranges § Chapter 5.2.6.4.1.11 “Measuring ranges” on page 1042.
The function of the LEDs is described in the section State LEDs Chapter 5.2.6.4.1.9 “Diagnosis” on page 1039.

Connection of resistance thermometers in 2-wire configuration

When resistance thermometers (Pt100, Pt1000, Ni1000) are used, a constant current must flow through them to build the necessary voltage drop for the evaluation. For this, the module CI511-ETHCAT provides a constant current source which is multiplexed over the max. 4 analog input channels.

![Connection of resistance thermometers in 2-wire configuration](image)

**Fig. 193: Connection of resistance thermometers in 2-wire configuration**

1. Pt100 (2-wire), Pt1000 (2-wire), Ni1000 (2-wire); 1 analog sensor requires 1 channel

<table>
<thead>
<tr>
<th>Thermometer</th>
<th>Measurement Range</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pt100</td>
<td>-50 °C ... +400 °C</td>
<td>2-wire, 1 channel used</td>
</tr>
<tr>
<td>Pt1000</td>
<td>-50 °C ... +400 °C</td>
<td>2-wire, 1 channel used</td>
</tr>
<tr>
<td>Ni1000</td>
<td>-50 °C ... +150 °C</td>
<td>2-wire, 1 channel used</td>
</tr>
</tbody>
</table>

The measuring ranges are described in the section Measuring Ranges Chapter 5.2.6.4.1.8 “Parameterization” on page 1033 Chapter 5.2.6.4.1.11 “Measuring ranges” on page 1042.

The module CI511-ETHCAT performs a linearization of the resistance characteristic.

In order to avoid error messages from unused analog input channels, it is useful to configure them as "unused".

Connection of resistance thermometers in 3-wire configuration

When resistance thermometers (Pt100, Pt1000, Ni1000) are used, a constant current must flow through them to build the necessary voltage drop for the evaluation. For this, the module CI511-ETHCAT provides a constant current source which is multiplexed over the max. 4 analog input channels.
Fig. 194: Connection of resistance thermometers in 3-wire configuration

1. Pt100 (3-wire), Pt1000 (3-wire), Ni1000 (3-wire); 1 analog sensor requires 2 channels
2. Twisted pair within the cable
3. Return line: The return line is only needed once if measuring points are adjacent to each other. This saves wiring costs.

With 3-wire configuration, two adjacent analog channels belong together (e.g. the channels 0 and 1). In this case, both channels are configured according to the desired operating mode. The lower address must be the even address (channel 0), the next higher address must be the odd address (channel 1).

The constant current of one channel flows through the resistance thermometer. The constant current of the other channel flows through one of the cores. The module calculates the measured value from the two voltage drops and stores it under the input with the higher channel number (e.g. I1).

In order to keep measuring errors as small as possible, it is necessary, to have all the involved conductors in the same cable. All the conductors must have the same cross section.

<table>
<thead>
<tr>
<th>Sensor</th>
<th>Measuring Range</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pt100</td>
<td>-50 °C ... +400 °C</td>
<td>3-wire used, 2 channels</td>
</tr>
<tr>
<td>Pt1000</td>
<td>-50 °C ... +400 °C</td>
<td>3-wire used, 2 channels</td>
</tr>
<tr>
<td>Ni1000</td>
<td>-50 °C ... +150 °C</td>
<td>3-wire used, 2 channels</td>
</tr>
</tbody>
</table>

The measuring ranges are described in the section Measuring Ranges “Parameterization” on page 1033 “Measuring ranges” on page 1042.

The module CI511-ETHCAT performs a linearization of the resistance characteristic.

In order to avoid error messages from unused analog input channels, it is useful to configure them as "unused".
Connection of active-type analog sensors (Voltage) with galvanically isolated power supply

Fig. 195: Connection of active-type analog sensors (voltage) with galvanically isolated power supply

1. **1 analog sensor requires 1 channel**
2. By connecting to AI–, the galvanically isolated voltage source of the sensor is referred to ZP
3. Galvanically isolated power supply for the analog sensor

<table>
<thead>
<tr>
<th>Voltage</th>
<th>Range</th>
<th>Channels</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 ... 10 V</td>
<td>1 channel used</td>
<td></td>
</tr>
<tr>
<td>-10 V ... +10 V</td>
<td>1 channel used</td>
<td></td>
</tr>
</tbody>
</table>

The measuring ranges are described in the section Measuring Ranges "Parameterization" on page 1033 and "Measuring ranges" on page 1042.

In order to avoid error messages or long processing times, it is useful to configure unused analog input channels as "unused".
Connection of active-type analog sensors (Current) with galvanically isolated power supply

![Diagram of connection]

Fig. 196: Connection of active-type analog sensors (current) with galvanically isolated power supply

1. 1 analog sensor requires 1 channel
2. Galvanically isolated power supply for the analog sensor

<table>
<thead>
<tr>
<th>Current</th>
<th>0 ... 20 mA</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>4 ... 20 mA</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

The measuring ranges are described in the section Measuring Ranges § Chapter 5.2.6.4.1.8 “Parameterization” on page 1033 § Chapter 5.2.6.4.1.11 “Measuring ranges” on page 1042.

Unused input channels can be left open-circuited, because they are of low resistance.
Connection of active-type analog sensors (Voltage) with no galvanically isolated power supply

Fig. 197: Connection of active-type sensors (voltage) with no galvanically isolated power supply

1 1 analog sensor requires 1 channel
2 Power supply not galvanically isolated
3 The connection between the negative pole of the sensor and ZP has to be performed
4 Long cable

**NOTICE!**

Risk of faulty measurements!

The negative pole/ground potential at the sensors must not have too large a potential difference with respect to ZP (max. ± 1 V within the full signal range).

Make sure that the potential difference never exceeds ± 1 V.

<table>
<thead>
<tr>
<th>Voltage</th>
<th>0 ... 10 V</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V *)</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

*) if the sensor can provide this signal range

The measuring ranges are described in the section Measuring Ranges ☞ Chapter 5.2.6.4.1.8 "Parameterization" on page 1033 ☞ Chapter 5.2.6.4.1.11 "Measuring ranges" on page 1042.

In order to avoid error messages or long processing times, it is useful to configure unused analog input channels as "unused".
Connection of passive-type analog sensors (Current)

Fig. 198: Connection of passive-type analog sensors (current)

1 1 analog sensor requires 1 channel

<table>
<thead>
<tr>
<th>Current</th>
<th>4 ... 20 mA</th>
<th>1 channel used</th>
</tr>
</thead>
</table>

The measuring ranges are described in the section Measuring Ranges "Parameterization" on page 1033 "Measuring ranges" on page 1042.

**CAUTION!**

If, during initialization, an analog current sensor supplies more than 25 mA for more than 1 second into an analog input, this input is switched off by the module (input protection). In such cases, it is recommended, to protect the analog input by a 10-volt Zener diode (in parallel to I+ and ZP). But, in general, it is a better solution to prefer sensors with fast initialization or without current peaks higher than 25 mA.

Unused input channels can be left open-circuited, because they are of low resistance.

Connection of active-type analog sensors (Voltage) to differential inputs

Differential inputs are very useful, if analog sensors are used which are remotely non-isolated (e.g. the minus terminal is remotely grounded).

The evaluation using differential inputs helps to considerably increase the measuring accuracy and to avoid ground loops.

With differential input configurations, two adjacent analog channels belong together (e.g. the channels 0 and 1). In this case, both channels are configured according to the desired operating mode. The lower address must be the even address (channel 0), the next higher address must be the odd address (channel 1). The converted analog value is available at the higher address (channel 1).

The analog value is calculated by subtraction of the input value with the higher address from the input value of the lower address.
The converted analog value is available at the odd channel (higher address).

Important: The ground potential at the sensors must not have a too big potential difference with respect to ZP (max. ±1 V within the full signal range). Otherwise problems can occur concerning the common-mode input voltages of the involved analog inputs.

Fig. 199: Connection of active-type analog sensors (voltage) to differential inputs

1 1 analog sensor requires 2 channels
2 Galvanically isolated power supply for the analog sensor
3 Grounding at the sensor
4 0 V ... 10 V / -10 V ... +10 V connected to differential inputs

<table>
<thead>
<tr>
<th>Voltage</th>
<th>0 V ... 10 V</th>
<th>with differential inputs, 2 channels used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V</td>
<td>with differential inputs, 2 channels used</td>
</tr>
</tbody>
</table>

The measuring ranges are described in the section Measuring Ranges « Chapter 5.2.6.4.1.8 "Parameterization" on page 1033 « Chapter 5.2.6.4.1.11 "Measuring ranges" on page 1042.

In order to avoid error messages or long processing times, it is useful to configure unused analog input channels as "unused".

Use of analog inputs as digital inputs

Several (or all) analog inputs can be configured as digital input. The inputs are not galvanically isolated against the other analog channels.
Fig. 200: Use of analog inputs as digital inputs

1 1 digital signal requires 1 channel

<table>
<thead>
<tr>
<th>Digital input</th>
<th>24 V</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Al0+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Al1+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Al-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZP</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The measuring ranges are described in the section Measuring Ranges Chapter 5.2.6.4.1.8 “Parameterization” on page 1033 Chapter 5.2.6.4.1.11 “Measuring ranges” on page 1042.
Connection of analog output loads (Voltage, current)

![Diagram of analog output loads](image)

**Fig. 201: Connection of analog output loads (voltage, current)**

1. 1 analog load requires 1 channel

<table>
<thead>
<tr>
<th>Voltage</th>
<th>-10 V ... +10 V</th>
<th>Load ± 10 mA max.</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>0 ... 20 mA</td>
<td>Load 0 Ω ... 500 Ω</td>
<td>1 channel used</td>
</tr>
<tr>
<td>Current</td>
<td>4 ... 20 mA</td>
<td>Load 0 Ω ... 500 Ω</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

The measuring ranges are described in the section Measuring Ranges Chapter 5.2.6.4.1.8 “Parameterization” on page 1033 Chapter 5.2.6.4.1.11 “Measuring ranges” on page 1042.

Unused analog outputs can be left open-circuited.

**Assignment of the Ethernet ports**

The terminal unit for the communication interface module provides two Ethernet interfaces with the following pin assignment. The pin assignment is used for the EtherCAT master (communication module CM5xy-ETHCAT) as well.
**Pin assignment**

<table>
<thead>
<tr>
<th>Interface</th>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>TxD+</td>
<td>Transmit data +</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>TxD-</td>
<td>Transmit data -</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>RxD+</td>
<td>Receive data +</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>RxD-</td>
<td>Receive data -</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td>Shield</td>
<td>Cable shield</td>
<td>Functional earth</td>
</tr>
</tbody>
</table>

In corrosive environment, please protect unused connectors using the TA535 accessory.

Not supplied with this device.

**Further information about wiring and cable types**

The EtherCAT network differentiates between input-connectors (IN) and output-connectors (OUT):

- At the EtherCAT slaves (communication interface modules), the ETH1-connector is IN and the ETH2-connector is OUT.
- At the EtherCAT master (communication module), the ETHCAT1 connector has to be used. The ETHCAT2 connector is reserved for future extensions.

**Internal data exchange**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital inputs (bytes)</td>
<td>1</td>
</tr>
<tr>
<td>Digital outputs (bytes)</td>
<td>1</td>
</tr>
<tr>
<td>Analog inputs (words)</td>
<td>4</td>
</tr>
<tr>
<td>Analog outputs (words)</td>
<td>2</td>
</tr>
</tbody>
</table>

**Addressing**

The Ethernet bus module CI511-ETHCAT does not consider the position of the rotary switches at the front side of the module. The function of the rotary switches is reserved for future expansions.
I/O configuration

In order to be able to use the CI51X-ETHCAT with device index C0 or above properly, please download the corresponding device description (.xml-)files from http://www.abb.com/plc and install them to the device repository of your Automation Builder. This will allow you to use up to 10 Expandable S500 I/O modules as well as the Extended Cam Switch Library with your CI51X-ETHCAT device.

The CI511-ETHCAT does not store configuration data itself.
The analog I/O channels are configured via software.

Parameterization
Module parameter

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Internal</td>
<td>48155</td>
<td>WORD</td>
<td>48155</td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal</td>
<td>28</td>
<td>BYTE</td>
<td>28</td>
</tr>
<tr>
<td>Error LED / Failsafe function ¹)</td>
<td>On</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Off by E4</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off by E3 On + failsafe Off by E4 + failsafe Off by E3 + failsafe</td>
<td>3, 16, 17, 19</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Check Supply</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 228: Error LED / Failsafe function ¹)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Error LED lights up at errors of all error classes, Failsafe-mode off</td>
</tr>
<tr>
<td>Off by E4</td>
<td>Error LED lights up at errors of error classes E1, E2 and E3, Failsafe-mode off</td>
</tr>
<tr>
<td>Off by E3</td>
<td>Error LED lights up at errors of error classes E1 and E2 auf, Failsafe-mode off</td>
</tr>
<tr>
<td>On + failsafe</td>
<td>Error LED lights up at errors of all error classes, Failsafe-mode on *)</td>
</tr>
<tr>
<td>Off by E4 + failsafe</td>
<td>Error LED lights up at errors of error classes E1, E2 and E3, Failsafe-mode on *)</td>
</tr>
<tr>
<td>Off by E3 + failsafe</td>
<td>Error LED lights up at errors of error classes E1 and E2, Failsafe-mode on *)</td>
</tr>
</tbody>
</table>

*) The parameters behaviourAOatCommunicationFault and behaviourDOatCommunicationFault are only analyzed if the Failsafe-mode is ON.
### Group parameters of the cam switch

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>numOfUsedCams 1)</td>
<td>0 ... 32</td>
<td>0 ... 32</td>
<td>WORD</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>128 ... 160</td>
<td>218 ... 160</td>
<td></td>
<td></td>
</tr>
<tr>
<td>resolution 2)</td>
<td>0 ... 2</td>
<td>0 ... 2</td>
<td>DWORD</td>
<td>36000</td>
</tr>
<tr>
<td></td>
<td>-1</td>
<td>-1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>zeroShift 3)</td>
<td>0 ... 2</td>
<td>0 ... 2</td>
<td>DWORD</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>-1</td>
<td>-1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EncoderBitResolution 4)</td>
<td>8 ... 32</td>
<td>8 ... 32</td>
<td>WORD</td>
<td>18</td>
</tr>
<tr>
<td>Reserve</td>
<td>-</td>
<td>-</td>
<td>WORD</td>
<td>-</td>
</tr>
</tbody>
</table>

1) The parameter numOfUsedCams defines the interrupt cycle time (Therefore, it takes effect to the accuracy of the track) and the behavior of the module if the DC information is lost.

<table>
<thead>
<tr>
<th>Parameter setting for numOfUsedCams</th>
<th>Number of cams used</th>
<th>Interrupt cycle time</th>
<th>Behavior if DC information is lost</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>50 µs</td>
<td>Module changes to &quot;safe-operational&quot; state; the outputs are activated through the user program</td>
</tr>
<tr>
<td>1...8</td>
<td>1...8</td>
<td>80 µs</td>
<td></td>
</tr>
<tr>
<td>9...16</td>
<td>9...16</td>
<td>100 µs</td>
<td></td>
</tr>
<tr>
<td>17...32</td>
<td>17...32</td>
<td>200 µs</td>
<td></td>
</tr>
<tr>
<td>128</td>
<td>0</td>
<td>50 µs</td>
<td>Module keeps in &quot;operational&quot; state; the outputs are activated through the user program</td>
</tr>
<tr>
<td>129 ... 136</td>
<td>1 ... 8</td>
<td>80 µs</td>
<td>Module keeps in &quot;operational&quot; state; the cam switch outputs are activated according to an interpolated timing information</td>
</tr>
<tr>
<td>137 ... 144</td>
<td>9 ... 16</td>
<td>100 µs</td>
<td></td>
</tr>
<tr>
<td>145 ... 170</td>
<td>17 ... 32</td>
<td>200 µs</td>
<td></td>
</tr>
</tbody>
</table>

2) The parameter resolution defines the angle resolution of the track. The value gives the number of increments related to 360°; e.g. the value 36,000 corresponds to an angle resolution of 0.01°.

3) The parameter zeroShift defines the zero shift. With it the encoder can be adjusted to the mounting position. The value of zeroShift is set in encoder-increments. It is not assigned to the parameter resolution of the cam switch.

4) The parameter EncoderBitResolution defines the resolution of the used encoder (in bits), e.g. with the default setting 18 bits the encoder has 196,608 divisions.
Channel parameters for the cam switch (max. 32x)

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>camToTrack0</td>
<td>Digital Output 0 ... 7, none</td>
<td>0 ... 7, FF</td>
<td>BYTE</td>
<td>FF</td>
</tr>
<tr>
<td>camToTrack31</td>
<td>Digital Output 0 ... 7, none</td>
<td>0 ... 7, FF</td>
<td>BYTE</td>
<td>FF</td>
</tr>
</tbody>
</table>

*) The value of the parameter camToTrack# defines which DO (digital output) is assigned to the track. camToTrack0 = 3 for example means that track 0 is assigned to the digital output 3. If the value FFh is set to a track, no digital output is assigned to it.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Referred FB from extended Cam Switch Library 2)</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>camType[0] 1)</td>
<td>Common Pulsed Timed Comfort Cam shift Binary shift Multiturn cam Time timed Reference Multiturn timed</td>
<td>MCX_CamSwitchSimple_c MCX_CamSwitchSimple_dc MCX_PulseSwitch_dc MCX_CamSwitchTimed_dc MCX_CamSwitchComfort_dc MCX_CamShift_dc MCX_BinaryShift_dc MCX_CamSwitchMulti_dc MCX_SwitchTimeTimed_dc MCX_BinaryReference_dc MCX_CamSwitchMultiTimed_dc</td>
<td>0 1 2 3 4 5 6 7 8 9</td>
<td>BYTE</td>
<td>0</td>
</tr>
</tbody>
</table>

1) camType additionally to camToTrack identifies the type of each cam switch and enables the use of a specific function block from the Extended Cam Switch Library.

2) camType parameters and the Extended Camswitch Library are only available for CI511-ETHCAT and CI512-ETHCAT with device index C0 and above.
Group parameters for the analog part

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog data format</td>
<td>Standard</td>
<td>0</td>
<td>BYTE 0</td>
<td>0</td>
</tr>
<tr>
<td>Behaviour AO at comm. error *)</td>
<td>Off</td>
<td>0 1 6 11 2 7 12</td>
<td>BYTE 0</td>
<td>0</td>
</tr>
</tbody>
</table>

*) The parameter Behaviour AO at comm. error is only analyzed if the Failsafe-mode is ON.

Channel parameters for the analog inputs (4x)

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input 0, channel configuration</td>
<td>see 1)</td>
<td>see 1)</td>
<td>BYTE 0</td>
<td>0</td>
</tr>
<tr>
<td>Input 0, check channel</td>
<td>see 2)</td>
<td>see 2)</td>
<td>BYTE 0</td>
<td>0</td>
</tr>
<tr>
<td>Input 3, channel configuration</td>
<td>see 1)</td>
<td>see 1)</td>
<td>BYTE 0</td>
<td>0</td>
</tr>
<tr>
<td>Input 3, channel configuration</td>
<td>see 2)</td>
<td>see 2)</td>
<td>BYTE 0</td>
<td>0</td>
</tr>
</tbody>
</table>

Channel configuration *)

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes of the analog inputs, individually configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (default)</td>
<td>Not used</td>
</tr>
<tr>
<td>1</td>
<td>0 ... 10 V</td>
</tr>
<tr>
<td>2</td>
<td>Digital input</td>
</tr>
<tr>
<td>3</td>
<td>0 ... 20 mA</td>
</tr>
<tr>
<td>4</td>
<td>4 ... 20 mA</td>
</tr>
<tr>
<td>5</td>
<td>-10 V ... +10 V</td>
</tr>
<tr>
<td>8</td>
<td>2-wire Pt100 -50 °C ... +400 °C</td>
</tr>
<tr>
<td>9</td>
<td>3-wire Pt100 -50 °C ... +400 °C *)</td>
</tr>
<tr>
<td>10</td>
<td>0 V ... 10 V (voltage diff.) *)</td>
</tr>
<tr>
<td>11</td>
<td>-10 V ... +10 V (voltage diff.) *)</td>
</tr>
<tr>
<td>14</td>
<td>2-wire Pt100 -50 °C ... +70 °C</td>
</tr>
<tr>
<td>15</td>
<td>3-wire Pt100 -50 °C ... +70 °C *)</td>
</tr>
</tbody>
</table>
Internal value | Operating modes of the analog inputs, individually configurable
--- | ---
16 | 2-wire Pt1000 -50 °C ...+400 °C
17 | 3-wire Pt1000 -50 °C ...+400 °C *)
18 | 2-wire Ni1000 -50 °C ...+150 °C
19 | 3-wire Ni1000 -50 °C ...+150 °C *)

*) In the operating modes with 3-wire configuration or with differential inputs, two adjacent analog inputs belong together (e.g. the channels 0 and 1). In these cases, both channels are configured in the desired operating mode. The lower address must be the even address (channel 0). The next higher address must be the odd address (channel 1). The converted analog value is available at the higher address (channel 1).

Table 229: Channel monitoring 2)

<table>
<thead>
<tr>
<th>Internal Value</th>
<th>Check channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Plausibility, wire break, short circuit</td>
</tr>
<tr>
<td>3</td>
<td>not used</td>
</tr>
</tbody>
</table>

Channel parameters for the analog outputs (2x)

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output 0, channel configuration</td>
<td>see 3)</td>
<td>see 3)</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>Output 0, check channel</td>
<td>see 4)</td>
<td>see 4)</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>Output 0, substitute value</td>
<td>see 5)</td>
<td>see 5)</td>
<td>WORD</td>
<td>0</td>
</tr>
<tr>
<td>Output 1, channel configuration</td>
<td>see 3)</td>
<td>see 3)</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>Output 1, check channel</td>
<td>see 4)</td>
<td>see 4)</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>Output 1, substitute value</td>
<td>see 5)</td>
<td>see 5)</td>
<td>WORD</td>
<td>0</td>
</tr>
</tbody>
</table>

Table 230: Channel configuration 3)

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes of the analog outputs, individually configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not used (default)</td>
</tr>
<tr>
<td>128</td>
<td>-10 V ... +10 V</td>
</tr>
<tr>
<td>129</td>
<td>0 ... 20 mA</td>
</tr>
<tr>
<td>130</td>
<td>4 ... 20 mA</td>
</tr>
</tbody>
</table>
Table 231: Channel monitoring 4)

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Check channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Plausibility, wire break, short circuit</td>
</tr>
<tr>
<td>3</td>
<td>None</td>
</tr>
</tbody>
</table>

Table 232: Substitute value 5)

<table>
<thead>
<tr>
<th>Intended behavior of output channel when the control system stops</th>
<th>Required setting of the module parameter &quot;Behaviour of outputs in case of a communication error&quot;</th>
<th>Required setting of the channel parameter &quot;Substitute value&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output OFF</td>
<td>Off</td>
<td>0</td>
</tr>
<tr>
<td>Last value infinite</td>
<td>Last value</td>
<td>0</td>
</tr>
<tr>
<td>Last value for 5 s</td>
<td>Last value 5 s</td>
<td>0</td>
</tr>
<tr>
<td>Last value for 10 s</td>
<td>Last value 10 s</td>
<td>0</td>
</tr>
<tr>
<td>Substitute value infinite</td>
<td>Substitute value</td>
<td>Depending on configuration</td>
</tr>
<tr>
<td>Substitute value for 5 s</td>
<td>Substitute value 5 s</td>
<td>Depending on configuration</td>
</tr>
<tr>
<td>Substitute value for 10 s</td>
<td>Substitute value 10 s</td>
<td>Depending on configuration</td>
</tr>
</tbody>
</table>

Group parameters for the digital part

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input delay</td>
<td>0.01 ms</td>
<td>0</td>
<td>BYTE</td>
<td>0.01 ms 0x00</td>
</tr>
<tr>
<td></td>
<td>1 ms</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 ms</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>32 ms</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Detect short circuits at outputs</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>On 0x01</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Behaviour DO at comm. error *)</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>Off 0x00</td>
</tr>
<tr>
<td></td>
<td>Last value</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Last value 5 sec</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Last value 10 sec</td>
<td>11</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute value</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute 5 sec</td>
<td>7</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute 10 sec</td>
<td>12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Substitute value at output</td>
<td>0 ... 255</td>
<td>00h ... FFh</td>
<td>BYTE</td>
<td>0 0x0000</td>
</tr>
</tbody>
</table>

*) The parameter behaviourDOatCommunicationFault is only analyzed if the Failsafe-mode is ON.
Diagnosis

In cases of short circuit or overload, the digital outputs are turned off. The modules performs reactivation automatically. Thus an acknowledgement of the errors is not necessary. The error message is stored via the LED.

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier</th>
<th>AC500-Display</th>
<th>&lt;-- Display in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Comp</td>
<td>Dev</td>
<td>Mod</td>
<td>Ch</td>
<td>Err</td>
<td>PS501 PLC Browser</td>
<td></td>
</tr>
<tr>
<td>Byte 6</td>
<td>Bit 6 ... 7</td>
<td>-</td>
<td>Byte 3</td>
<td>Byte 4</td>
<td>Byte 5</td>
<td>Byte 6 Bit 0 ... 5</td>
<td>ETHCAT Diagnosis block</td>
</tr>
<tr>
<td>Class</td>
<td>Interface</td>
<td>Device</td>
<td>Module</td>
<td>Channel</td>
<td>Error identifier</td>
<td>Error message</td>
<td>Remedy</td>
</tr>
<tr>
<td>1)</td>
<td>2)</td>
<td>3)</td>
<td>4)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Module error**

<table>
<thead>
<tr>
<th>3</th>
<th>-</th>
<th>31</th>
<th>31</th>
<th>31</th>
<th>19</th>
<th>Checksum error in the I/O module</th>
<th>Replace I/O module</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>3</td>
<td>Timeout in the I/O module</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>40</td>
<td>Different hard-/firmware versions in the module</td>
<td>Check configuration</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>43</td>
<td>Internal error in the module</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>36</td>
<td>Internal data exchange failure</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>20</td>
<td>Slave-to-Slave malfunction</td>
<td>Check configuration</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>41</td>
<td>Distributed Clock malfunction</td>
<td>Check configuration</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>9</td>
<td>Overflow diagnosis buffer</td>
<td>Restart</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>26</td>
<td>Parameter error</td>
<td>Check master</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>11</td>
<td>Process voltage UP too low</td>
<td>Check process supply voltage UP</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>45</td>
<td>Process voltage UP3 too low</td>
<td>Check process voltage</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>34</td>
<td>No response during initialization of the I/O module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>Class</td>
<td>Interface</td>
<td>Device</td>
<td>Module</td>
<td>Channel</td>
<td>Error identifier</td>
<td>Error message</td>
<td>Remedy</td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>--------</td>
<td>--------</td>
<td>---------</td>
<td>-----------------</td>
<td>--------------</td>
<td>--------</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>46</td>
<td>Voltage feedback on activated digital outputs</td>
<td>Check terminals</td>
</tr>
</tbody>
</table>

**Channel error digital**

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>2</td>
<td>0..7</td>
<td>46</td>
<td>Voltage feedback on deactivated digital output</td>
<td>Check terminals</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>2</td>
<td>0..7</td>
<td>47</td>
<td>Short circuit at digital output</td>
<td>Check terminals</td>
</tr>
</tbody>
</table>

**Channel error analog**

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>1</td>
<td>0..3</td>
<td>48</td>
<td>Analog value overflow or broken wire at an analog input</td>
<td>Check value or check terminals</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>1</td>
<td>0..3</td>
<td>7</td>
<td>Analog value underflow at an analog input</td>
<td>Check value</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>1</td>
<td>0..3</td>
<td>47</td>
<td>Short circuit at an analog input</td>
<td>Check terminals</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>3</td>
<td>0..1</td>
<td>48</td>
<td>Analog value overflow at an analog output</td>
<td>Check output value</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>3</td>
<td>0..1</td>
<td>7</td>
<td>Analog value underflow at an analog output</td>
<td>Check output value</td>
</tr>
</tbody>
</table>

**Remarks:**

1) In AC500 the following interface identifier applies:
   
   ".-" = Diagnosis via bus-specific function blocks; 0 ... 4 or 10 = Position of the Communication Module; 14 = I/O bus; 31 = Module itself
   
   The identifier is not contained in the CI511-ETHCAT diagnosis block.

2) With "Device" the following allocation applies:
   
   31 = Module itself or ADR = Hardware address (e. g. of the DC551)
3) With "Module" the following allocation applies dependent of the master:
31 = Module itself (Module error) or Module type (1=AI, 2=DO, 3=AO; channel error)

4) Diagnosis message appears for the whole output group and not per channel. The message occurs if the output channel is already active.

5) Diagnosis message appears per channel. The message occurs if the output channel is not active.

State LEDs

The LEDs are located at the front of module. There are 2 different groups:
- The 5 system LEDs (PWR, NET, DC, S-ERR and I/O-Bus) show the operation state of the module and display possible errors.
- The 27 process LEDs (UP, UP3, inputs, outputs, CH-ERR1 to CH-ERR3) show the process supply voltage and the states of the inputs and outputs and display possible errors.

Table 233: States of the 5 system LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>Off</th>
<th>On</th>
<th>Flashing</th>
<th>1x Flash</th>
<th>2x Flash</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR/RUN</td>
<td>Green</td>
<td>Error in the internal supply voltage or process voltage missing</td>
<td>Internal supply voltage OK</td>
<td>Module is not configured</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>NET</td>
<td>Green</td>
<td>Init</td>
<td>Operational</td>
<td>Pre-operational</td>
<td>Safe-operational</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td>Red</td>
<td>No error</td>
<td>PDI Watchdog Timeout</td>
<td>Invalid Configuration</td>
<td>Unsolicited State Change</td>
<td>Application time out</td>
</tr>
<tr>
<td>DC *)</td>
<td>Green</td>
<td>Distributed Clock not active</td>
<td>Distributed Clock active</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td>Red</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>S-ERR</td>
<td>Red</td>
<td>No error</td>
<td>Internal error</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>I/O-Bus</td>
<td>Green</td>
<td>No communication interface modules connected or communication error</td>
<td>---</td>
<td>---</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>ETH1</td>
<td>Green</td>
<td>No EtherCAT connection</td>
<td>Link OK</td>
<td>Link OK</td>
<td>Data transfer OK</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>LED</td>
<td>Color</td>
<td>Off</td>
<td>On</td>
<td>Flashing</td>
<td>1x Flash</td>
<td>2x Flash</td>
</tr>
<tr>
<td>----------</td>
<td>-------</td>
<td>----------------------</td>
<td>----------------------</td>
<td>---------------------</td>
<td>----------</td>
<td>----------</td>
</tr>
<tr>
<td>ETH2</td>
<td>Green</td>
<td>No EtherCAT connection</td>
<td>Link OK</td>
<td>Link OK</td>
<td>Data transfer</td>
<td>Data transfer OK</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
</tbody>
</table>

* The state of this LED is only significant if the cam switch functionality is enabled

**Table 234: States of the 27 process LEDs**

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>OFF</th>
<th>ON</th>
<th>Flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>AI0 ... AI3</td>
<td>Yellow</td>
<td>Input is OFF</td>
<td>Input is ON</td>
<td>(brightness depends on the value of the analog signal)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AO0 ... AO1</td>
<td>Yellow</td>
<td>Output is OFF</td>
<td>Output is ON</td>
<td>(brightness depends on the value of the analog signal)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DI0 ... DI7</td>
<td>Yellow</td>
<td>Input is OFF</td>
<td>Input is ON</td>
<td>(the input voltage is even displayed if the supply voltage is OFF)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DO0 ... DO7</td>
<td>Yellow</td>
<td>Output is OFF</td>
<td>Output is ON</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UP</td>
<td>Green</td>
<td>Process supply voltage missing</td>
<td>Process supply voltage OK and initialization finished</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UP3</td>
<td>Green</td>
<td>Process supply voltage missing</td>
<td>Process supply voltage OK</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CH-ERR1 to CH-ERR3</td>
<td>Red</td>
<td>No error or process supply voltage missing</td>
<td>Internal error</td>
<td>Error on one channel of the corresponding group</td>
</tr>
</tbody>
</table>

**Measuring ranges**

**Input ranges voltage, current and digital input**

<table>
<thead>
<tr>
<th>Range</th>
<th>0 V ... +10V</th>
<th>-10 V ... +10V</th>
<th>0 mA ... 20 mA</th>
<th>4 mA ... 20 mA</th>
<th>Digital input</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overflow</td>
<td>&gt; 11.7589</td>
<td>&gt; 11.7589</td>
<td>&gt; 23.5178</td>
<td>&gt; 22.8142</td>
<td></td>
<td>32767</td>
</tr>
<tr>
<td>Measured value too high</td>
<td>11.7589</td>
<td>11.7589</td>
<td>23.5178</td>
<td>22.8142</td>
<td>32511</td>
<td>7EFF</td>
</tr>
<tr>
<td></td>
<td>10.0004</td>
<td>10.0004</td>
<td>20.0007</td>
<td>20.0006</td>
<td>27649</td>
<td>6C01</td>
</tr>
</tbody>
</table>
The represented resolution corresponds to 16 bits.

### Input ranges resistance temperature detector

<table>
<thead>
<tr>
<th>Range</th>
<th>Pt100 / Pt1000</th>
<th>Ni1000</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>-50 °C ... +400 °C</td>
<td>-50 °C ... +150 °C</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Decimal</td>
</tr>
<tr>
<td>Overflow</td>
<td>&gt; +450.0 °C</td>
<td>&gt; +160.0 °C</td>
<td>32767</td>
</tr>
<tr>
<td>Measured value too high</td>
<td>+450.0 °C</td>
<td>+400.1 °C</td>
<td>4500</td>
</tr>
<tr>
<td></td>
<td>+160.0 °C</td>
<td>+150.1 °C</td>
<td>1600</td>
</tr>
<tr>
<td></td>
<td>800</td>
<td>701</td>
<td>0320</td>
</tr>
<tr>
<td>Normal range</td>
<td>+400.0 °C</td>
<td>+150.0 °C</td>
<td>4000</td>
</tr>
<tr>
<td></td>
<td>+0.1 °C</td>
<td>+ 0.1 °C</td>
<td>1500</td>
</tr>
<tr>
<td></td>
<td>700</td>
<td>1</td>
<td>02BC</td>
</tr>
<tr>
<td></td>
<td>0.0 °C</td>
<td>0.0 °C</td>
<td>0</td>
</tr>
<tr>
<td>-0.1 °C</td>
<td>-0.1 °C</td>
<td>-1</td>
<td>FFFF</td>
</tr>
<tr>
<td>-50.0 °C</td>
<td>-50.0 °C</td>
<td>-500</td>
<td>FEOC</td>
</tr>
<tr>
<td>Range</td>
<td>Pt100 / Pt1000 -50 °C ... +400 °C</td>
<td>Ni1000 -50 °C ... +150 °C</td>
<td>Digital value</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------</td>
<td>---------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td></td>
<td>Decimal</td>
<td>Hex.</td>
<td></td>
</tr>
<tr>
<td>Measured value too low</td>
<td>-50.1 °C</td>
<td>-50.1 °C</td>
<td>-501</td>
</tr>
<tr>
<td></td>
<td>-60.0 °C</td>
<td>-60.0 °C</td>
<td>-600</td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt; -60.0 °C</td>
<td>&lt; -60.0 °C</td>
<td>-32768</td>
</tr>
</tbody>
</table>

Output ranges voltage and current

<table>
<thead>
<tr>
<th>Range</th>
<th>-10 V ... +10 V</th>
<th>0 mA ... 20 mA</th>
<th>4 mA ... 20 mA</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Decimal</td>
<td>Hex.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overflow</td>
<td>0 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>&gt; 32511</td>
</tr>
<tr>
<td>Measured value too high</td>
<td>11.7589 V</td>
<td>23.5178 mA</td>
<td>22.8142 mA</td>
<td>32511</td>
</tr>
<tr>
<td></td>
<td>10.0004 V</td>
<td>20.0007 mA</td>
<td>20.0006 mA</td>
<td>27649</td>
</tr>
<tr>
<td>Normal range</td>
<td>10.0000 V</td>
<td>20.0000 mA</td>
<td>20.0000 mA</td>
<td>27648</td>
</tr>
<tr>
<td></td>
<td>0.0004 V</td>
<td>0.0007 mA</td>
<td>4.0006 mA</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>0.0000 V</td>
<td>0.0000 mA</td>
<td>4.0000 mA</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>-0.0004 V</td>
<td>0 mA</td>
<td>3.9994 mA</td>
<td>-1</td>
</tr>
<tr>
<td></td>
<td>-10.0000 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>-6912</td>
</tr>
<tr>
<td>Measured value too low</td>
<td>-10.0004 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>-27649</td>
</tr>
<tr>
<td></td>
<td>-11.7589 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>-32512</td>
</tr>
<tr>
<td>Underflow</td>
<td>0 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>&lt; -32512</td>
</tr>
</tbody>
</table>

The represented resolution corresponds to 16 bits.

Technical data

Technical data of the module

The system data of AC500 and S500 are applicable to the standard version "Chapter 5.1.2 “System data AC500” on page 166.

The system data of AC500-XC are applicable to the XC version "Chapter 5.1.3 “System data AC500-XC” on page 169.

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.
## Parameter Value

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bus connection</strong></td>
<td>2 x RJ45</td>
</tr>
<tr>
<td><strong>Technology</strong></td>
<td>Hilscher NETX 100</td>
</tr>
<tr>
<td><strong>Transfer rate</strong></td>
<td>10/100 Mbit/s (full-duplex)</td>
</tr>
<tr>
<td><strong>Transfer method</strong></td>
<td>According to Ethernet II, IEEE 802.3</td>
</tr>
<tr>
<td><strong>Ethernet</strong></td>
<td>100 base-TX, internal switch, 2x RJ45 socket</td>
</tr>
<tr>
<td><strong>Expandability (S500 I/O modules)</strong></td>
<td>Up to 10 S500 I/O modules (Index C0 and above), not available (Index below C0)</td>
</tr>
<tr>
<td><strong>Indicators</strong></td>
<td>5 LEDs for state indication</td>
</tr>
<tr>
<td><strong>Adjusting elements</strong></td>
<td>2 rotary switches (used for future topology extensions)</td>
</tr>
<tr>
<td><strong>Quantity of input/output data</strong></td>
<td>CI512-ETHCAT: 10 bytes input and 14 bytes output CI511-ETHCAT: 18 bytes input and 18 bytes output</td>
</tr>
<tr>
<td><strong>Limit of data for input and output</strong></td>
<td>144 byte</td>
</tr>
<tr>
<td><strong>Acyclic services</strong></td>
<td>SDO (1500 bytes max.) Emergency ECAT_SLV_DIAG</td>
</tr>
</tbody>
</table>
| **Protective functions (according to CODESYS)** | Protected against:  
- short circuit  
- reverse supply  
- overvoltage  
- reverse polarity  
Galvanic isolation to network |

## Parameter Value

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Process supply voltage UP/UP3</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Rated value</strong></td>
<td>24 V DC (for inputs and outputs)</td>
</tr>
<tr>
<td><strong>Max. load for the terminals</strong></td>
<td>10 A</td>
</tr>
<tr>
<td><strong>Protection against reversed voltage</strong></td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Rated protection fuse on UP/UP3</strong></td>
<td>10 A fast</td>
</tr>
<tr>
<td><strong>Galvanic isolation</strong></td>
<td>Ethernet interface against the rest of the module</td>
</tr>
<tr>
<td><strong>Inrush current from UP (at power up)</strong></td>
<td>On request</td>
</tr>
<tr>
<td><strong>Current consumption via UP (normal operation)</strong></td>
<td>0.2 A</td>
</tr>
<tr>
<td><strong>Current consumption via UP3</strong></td>
<td>0.06 A + 0.5 A max. per output</td>
</tr>
<tr>
<td><strong>Connections</strong></td>
<td>Terminals 1.8 and 2.8 for +24 V (UP) Terminal 3.8 for +24 V (UP3) Terminals 1.9, 2.9 and 3.9 for 0 V (ZP)</td>
</tr>
<tr>
<td><strong>Max. power dissipation within the module</strong></td>
<td>6 W</td>
</tr>
<tr>
<td><strong>Number of digital inputs</strong></td>
<td>8</td>
</tr>
<tr>
<td><strong>Number of digital outputs</strong></td>
<td>8</td>
</tr>
<tr>
<td><strong>Number of analog inputs</strong></td>
<td>4</td>
</tr>
</tbody>
</table>
**Parameter** | **Value**  
--- | ---  
Number of analog outputs | 2  
Reference potential for all digital inputs and outputs | Negative pole of the supply voltage, signal name ZP  
Diagnosis | See Diagnosis and Displays * Chapter 5.2.6.4.1.9 “Diagnosis” on page 1039  
Operation and error displays | 32 LEDs (totally)  
Weight (without terminal unit) | ca. 125 g  
Mounting position | Horizontal  
Or vertical with derating (output load reduced to 50 % at +40 °C per group)  
Cooling | The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.  

**NOTICE!**  
All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

**Multiple overloads**  
No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an internal smart high-side switch.

### Technical data of the digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels DI0 ... DI7</td>
<td>Terminals 2.0 ... 2.7</td>
</tr>
<tr>
<td>Reference potential for all inputs</td>
<td>Terminals 1.9 ... 3.9 (Negative pole of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel, the LED is ON when the input signal is high (signal 1)</td>
</tr>
<tr>
<td>Input type (according EN 61131-2)</td>
<td>Type 1</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 0.1 ms, configurable from 0.1 ms ... 32 ms</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>0-Signal</td>
<td>-3 V ... +5 V</td>
</tr>
<tr>
<td>Undefined Signal</td>
<td>&gt; +5 V ... &lt; +15 V</td>
</tr>
<tr>
<td>1-Signal</td>
<td>+15 V ... +30 V</td>
</tr>
<tr>
<td>Ripple with signal 0</td>
<td>Within -3 V ... +5 V</td>
</tr>
<tr>
<td>Ripple with signal 1</td>
<td>Within +15 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 5 mA</td>
</tr>
</tbody>
</table>
### Technical data of the digital outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels DO0 ... DO7</td>
<td>Terminals 3.0 ... 3.7</td>
</tr>
<tr>
<td>Reference potential for all outputs</td>
<td>Terminals 1.9 ... 3.9 (Negative pole of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>For all outputs terminal 3.8 (positive pole of the supply voltage, signal name UP3)</td>
</tr>
<tr>
<td>Output voltage for signal 1</td>
<td>UP3 (-0.8 V)</td>
</tr>
<tr>
<td>Output delay (0-&gt;1 or 1-&gt;0)</td>
<td>On request</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated value per channel</td>
<td>500 mA at UP3 = 24 V</td>
</tr>
<tr>
<td>Max. value (all channels together)</td>
<td>4 A</td>
</tr>
<tr>
<td>Leakage current with signal 0</td>
<td>&lt; 0.5 mA</td>
</tr>
<tr>
<td>Fuse for UP3</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Demagnetization with inductive DC load</td>
<td>Via internal varistors (see figure below this table)</td>
</tr>
<tr>
<td>Output switching frequency</td>
<td></td>
</tr>
<tr>
<td>With resistive load</td>
<td>On request</td>
</tr>
<tr>
<td>With inductive loads</td>
<td>Max. 0.5 Hz</td>
</tr>
<tr>
<td>With lamp loads</td>
<td>11 Hz max. at 5 W max.</td>
</tr>
<tr>
<td>Short-circuit-proof / overload-proof</td>
<td>Yes</td>
</tr>
<tr>
<td>Overload message (I &gt; 0.7 A)</td>
<td>Yes, after ca. 100 ms</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>Yes, automatic reactivation after short circuit/overload</td>
</tr>
<tr>
<td>Resistance to feedback against 24 V signals</td>
<td>Yes (software-controlled supervision)</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

The following drawing shows the circuitry of a digital input/output with the varistors for demagnetization when inductive loads are switched off.
Fig. 202: Digital input/output (circuit diagram)

1  Digital output
2  Varistors for demagnetization when inductive loads are turned off

### Technical data of the analog inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>4</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group with 4 channels</td>
</tr>
<tr>
<td>Connection if channels AI0+ ... AI3+</td>
<td>Terminals 1.0 ... 1.3</td>
</tr>
<tr>
<td>Reference potential for AI0+ ... AI3+</td>
<td>Terminal 1.4 (AI-) for voltage and RTD measurement</td>
</tr>
<tr>
<td></td>
<td>Terminals 1.9, 2.9 and 3.9 for current measurement</td>
</tr>
<tr>
<td>Input type</td>
<td></td>
</tr>
<tr>
<td>Unipolar</td>
<td>Voltage 0 V ... 10 V, current or Pt100/Pt1000/Ni1000</td>
</tr>
<tr>
<td>Bipolar</td>
<td>Voltage -10 V ... +10 V</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Against Ethernet network</td>
</tr>
<tr>
<td>Configurability</td>
<td>0 V ... 10 V, -10 V ... +10 V, 0/4 mA ... 20 mA, Pt100/1000, Ni1000 (each input can be configured individually)</td>
</tr>
<tr>
<td>Channel input resistance</td>
<td>Voltage: &gt; 100 kΩ</td>
</tr>
<tr>
<td></td>
<td>Current: ca. 330 Ω</td>
</tr>
<tr>
<td>Time constant of the input filter</td>
<td>Voltage: 100 μs</td>
</tr>
<tr>
<td></td>
<td>Current: 100 μs</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 LED per channel (brightness depends on the value of the analog signal)</td>
</tr>
<tr>
<td>Conversion cycle</td>
<td>1 ms (for 4 inputs + 2 outputs); with RTDs Pt/ Ni... 1 s</td>
</tr>
<tr>
<td>Resolution</td>
<td>Range 0 ... 10 V: 12 bits</td>
</tr>
<tr>
<td></td>
<td>Range -10 ... +10 V: 12 bits including sign</td>
</tr>
<tr>
<td></td>
<td>Range 0 ... 20 mA: 12 bits</td>
</tr>
<tr>
<td></td>
<td>Range 4 ... 20 mA: 12 bits</td>
</tr>
<tr>
<td></td>
<td>Range RTD (Pt100, PT1000, Ni1000): +0.1 °C</td>
</tr>
<tr>
<td>Conversion error of the analog values</td>
<td>Typ. 0.5 %, max. 1 %</td>
</tr>
<tr>
<td>caused by non-linearity, adjustment</td>
<td></td>
</tr>
<tr>
<td>error at factory and resolution within</td>
<td></td>
</tr>
<tr>
<td>the normal range</td>
<td></td>
</tr>
</tbody>
</table>
### Technical data of the analog inputs, if used as digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>Max. 4</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group of 4 channels</td>
</tr>
<tr>
<td>Connections of the channels AI0+ ... AI3+</td>
<td>Terminals 1.0 ... 1.3</td>
</tr>
<tr>
<td>Reference potential for the inputs</td>
<td>Terminals 1.9, 2.9 and 3.9 (ZP)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 LED per channel</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-30 V ... +5 V</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>+5 V ... +13 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>+13 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 7 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>Typ. 1.4 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>Typ. 3.7 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 9 mA</td>
</tr>
<tr>
<td>Input resistance</td>
<td>Ca. 3.5 kΩ</td>
</tr>
</tbody>
</table>

### Technical data of the analog outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>2</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group for 2 channels</td>
</tr>
<tr>
<td>Connection of the channels AO0+...AO1+</td>
<td>Terminals 1.5 ... 1.6</td>
</tr>
<tr>
<td>Reference potential for AO0+ ... AO1+</td>
<td>Terminal 1.7 (AO-) for voltage outputTerminals 1.9, 2.9 and 3.9 (ZP) for current output</td>
</tr>
<tr>
<td>Output type</td>
<td></td>
</tr>
<tr>
<td>Unipolar</td>
<td>Current</td>
</tr>
<tr>
<td>Bipolar</td>
<td>Voltage</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Against Ethernet network</td>
</tr>
<tr>
<td>Configurability</td>
<td>-10 V ... +10 V, 0 mA ... 20 mA, 4 mA ... 20 mA (each output can be configured individually)</td>
</tr>
<tr>
<td>Output resistance (load), as current output</td>
<td>0 Ω ... 500 Ω</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Output loadability, as voltage output</td>
<td>± 10 mA max.</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>1 LED per channel (brightness depends on the value of the analog signal)</td>
</tr>
<tr>
<td>Resolution</td>
<td>12 bits including sign</td>
</tr>
<tr>
<td>Settling time for full range change (resistive load, output signal within specified tolerance)</td>
<td>Typ. 5 ms</td>
</tr>
<tr>
<td>Conversion error of the analog values caused by non-linearity, adjustment error at factory and resolution within the normal range</td>
<td>Typ. 0.5 %, max. 1 %</td>
</tr>
<tr>
<td>Relationship between input signal and hex code</td>
<td>Table Output Ranges Voltage and Current</td>
</tr>
<tr>
<td>Unused outputs</td>
<td>Are configured as unused (default value) and can be left open-circuited</td>
</tr>
</tbody>
</table>

### Dimensions

![Dimensions Diagram](image)

1  Din rail 15 mm  
2  Din rail 7.5 mm

*The dimensions are in mm and in brackets in inch.*
Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 220 900 R0001</td>
<td>CI511-ETHCAT, EtherCAT communication interface module, 8 DI, 8 DO, 4 AI and 2 AO</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

5.2.6.4.2 CI512-ETHCAT

Features

- 8 digital inputs 24 V DC
- 8 digital outputs 24 V DC, 0.5 A max.
- 8 configurable digital inputs/outputs 24 V DC, 0.5 A max.
- Cam switch functionality (see also Extended Cam Switch Library)
- Extended Cam switch functionality *)
  (see also Extended Cam Switch Library)
- Module-wise galvanically isolated
- Expandability with up to 10 S500 I/O modules *)

*) Applicable for device index C0 and above.
1 I/O bus
2 Allocation between terminal number and signal name
3 8 yellow LEDs to display the signal states of the digital configurable inputs/outputs (DC0 ... DC7)
4 8 yellow LEDs to display the signal states of the digital inputs (DI0 ... DI7)
5 8 yellow LEDs to display the signal states of the digital outputs (DO0 ... DO7)
6 2 green LEDs to display the supply voltage UP and UP3
7 3 red LEDs to display errors (CH-ERR1, CH-ERR2, CH-ERR3)
8 5 System LEDs: PWR/RUN, NET, DC, S-ERR, I/O-Bus
9 2 rotary switches (reserved for future extensions)
10 Label
11 Ethernet interfaces (ETH1, ETH2) on the terminal unit
12 Terminal unit
13 DIN rail

**Intended purpose**

The EtherCAT communication interface module CI512-ETHCAT is used as decentralized I/O module in EtherCAT networks. The network connection is performed via 2 RJ45 connectors which are integrated in the terminal unit. The communication interface module contains 24 I/O channels with the following properties:

- 8 digital configurable inputs/outputs in 1 group (1.0 ... 1.7)
- 8 digital inputs 24 V DC in 1 group (2.0 ... 2.7)
- 8 digital outputs 24 V DC in 1 group (3.0 ... 3.7)
- Cam switch functionality
The inputs/outputs are galvanically isolated from the Ethernet network. There is no potential separation between the channels. The configuration of the configurable digital inputs/outputs is performed by software.

### Functionality

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface</td>
<td>Ethernet</td>
</tr>
<tr>
<td>Protocol</td>
<td>EtherCAT</td>
</tr>
<tr>
<td>Power supply</td>
<td>From the process supply voltage UP</td>
</tr>
<tr>
<td>Supply of the electronic circuitry of the I/O expansion modules attached</td>
<td>Through the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>Rotary switches</td>
<td>Not used; reserved for future extensions</td>
</tr>
<tr>
<td>Configurable digital inputs/outputs</td>
<td>8 (configurable via software)</td>
</tr>
<tr>
<td>Digital inputs</td>
<td>8 (24 V DC; delay time configurable via software)</td>
</tr>
<tr>
<td>Digital outputs</td>
<td>8 (24 V DC, 0.5 A max.)</td>
</tr>
<tr>
<td>LED displays</td>
<td>For system displays, signal states, errors and power supply</td>
</tr>
<tr>
<td>External supply voltage</td>
<td>Via terminals ZP, UP and UP3 (process supply voltage 24 V DC)</td>
</tr>
<tr>
<td>Effect of incorrect input terminal connection</td>
<td>Wrong or no signal detected, no damage up to 35 V</td>
</tr>
<tr>
<td>Required terminal unit</td>
<td>TU507 or TU508 ☞ Chapter 5.2.7.2 “TU507-ETH and TU508-ETH for Ethernet communication interface modules” on page 1270</td>
</tr>
</tbody>
</table>

### Connections

The Ethernet communication interface module CI512-ETHCAT is plugged on the I/O terminal unit TU507-ETH or TU508-ETH. Properly seat the module and press until it locks in place. The terminal unit is mounted on a DIN rail or with 2 screws plus the additional accessory for wall mounting (TA526).

The connection of the I/O channels is carried out using the 30 terminals of the I/O terminal unit. I/O modules can be replaced without re-wiring the terminal units.

*For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.*

The terminals 1.8 and 2.8 as well as 1.9, 2.9 and 3.9 are electrically interconnected within the terminal unit and have always the same assignment, independent of the inserted module:

- Terminals 1.8 and 2.8: Process supply voltage UP = +24 V DC
- Terminal 3.8: Process supply voltage UP3 = +24 V DC
- Terminals 1.9, 2.9 and 3.9: Process supply voltage ZP = 0 V
With a separate UP3 power supply, the digital outputs can be switched off externally. This way, an emergency-off functionality can be realized.

The assignment of the other terminals:

<table>
<thead>
<tr>
<th>Terminals</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0 ... 1.7</td>
<td>DC0 ... DC7</td>
<td>8 digital inputs/outputs (configurable via software)</td>
</tr>
<tr>
<td>2.0 ... 2.7</td>
<td>DI0 ... DI7</td>
<td>8 digital inputs (delay time configurable via software)</td>
</tr>
<tr>
<td>3.0 ... 3.7</td>
<td>DO0 ... DO7</td>
<td>8 digital outputs</td>
</tr>
</tbody>
</table>

**WARNING!**

**Removal/Insertion under power**

The devices are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you

- connect or disconnect any signal or terminal block
- remove, mount or replace a module.

Disconnecting any powered devices while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The devices must not be opened when in operation. The same applies to the network interfaces.

**NOTICE!**

**Risk of damaging the PLC modules!**

Overvoltages and short circuits might damage the PLC modules.

- Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
- Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.
Fig. 203: Connection of the communication interface module CI512-ETHCAT

1 8 digital configurable inputs/outputs 24 V DC
2 8 digital inputs 24 V DC
3 8 digital outputs 24 V DC

In case of voltage feedback, 2 cases are distinguished:

1. The outputs are already active
   The output group will be switched off. A diagnosis message will appear. After 5 seconds, the module tries automatic reactivation.

2. The outputs are not active
   Only the output with voltage feedback will not be set to active. A diagnosis message will appear.

CAUTION!
The process supply voltage must be included within the grounding concept of the plant (e.g. grounding of the negative pole).

The module provides several diagnosis functions Chapter 5.2.6.4.2.10 “Diagnosis” on page 1060.

Assignment of the Ethernet ports

The terminal unit for the communication interface module provides two Ethernet interfaces with the following pin assignment. The pin assignment is used for the EtherCAT master (communication module CM5xy-ETHCAT) as well.
## Pin assignment

<table>
<thead>
<tr>
<th>Interface</th>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet</td>
<td>1</td>
<td>TxD+</td>
<td>Transmit data +</td>
</tr>
<tr>
<td>RJ45</td>
<td>2</td>
<td>TxD-</td>
<td>Transmit data -</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>RxD+</td>
<td>Receive data +</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>RxD-</td>
<td>Receive data -</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td>Shield</td>
<td>Cable shield</td>
<td>Functional earth</td>
</tr>
</tbody>
</table>

In corrosive environment, please protect unused connectors using the TA535 accessory.

Not supplied with this device.

## Further information about wiring and cable types

The EtherCAT network differentiates between input-connectors (IN) and output-connectors (OUT):

At the EtherCAT slaves (communication interface modules), the ETH1-connector is IN and the ETH2-connector is OUT.

At the EtherCAT master (communication module), the ETHCAT1 connector has to be used. The ETHCAT2 connector is reserved for future extensions.

## Internal data exchange

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital inputs (bytes)</td>
<td>1</td>
</tr>
<tr>
<td>Digital outputs (bytes)</td>
<td>1</td>
</tr>
<tr>
<td>Configurable digital inputs/outputs (bytes)</td>
<td>1 + 1</td>
</tr>
</tbody>
</table>

## Addressing

The Ethernet communication interface module CI512-ETHCAT does not consider the position of the rotary switches at the front side of the module. The function of the rotary switches is reserved for future expansions.
I/O configuration

In order to be able to use the CI51X-ETHCAT with device index C0 or above properly, please download the corresponding device description (.xml-)files from http://www.abb.com/plc and install them to the device repository of your Automation Builder. This will allow you to use up to 10 Expandable S500 I/O modules as well as the Extended Cam Switch Library with your CI51X-ETHCAT device.

The CI512-ETHCAT does not store configuration data itself. The analog I/O channels are configured via software.

Parameterization

Module parameter

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Internal</td>
<td>49435</td>
<td>WORD</td>
<td>49435</td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal</td>
<td>10</td>
<td>BYTE</td>
<td>10</td>
</tr>
<tr>
<td>Error LED / Failsafe function ¹)</td>
<td>On Off by E4 Off by E3 On + failsafe Off by E4 + failsafe Off by E3 + failsafe</td>
<td>0 1 3 16 17 19</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>Check Supply</td>
<td>Off On</td>
<td>0 1</td>
<td>BYTE</td>
<td>1</td>
</tr>
</tbody>
</table>

Table 235: Error LED / Failsafe function ¹)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Error LED lights up at errors of all error classes, Failsafe mode off</td>
</tr>
<tr>
<td>Off by E4</td>
<td>Error LED lights up at errors of error classes E1, E2 and E3, Failsafe mode off</td>
</tr>
<tr>
<td>Off by E3</td>
<td>Error LED lights up at errors of error classes E1 and E2 auf, Failsafe mode off</td>
</tr>
<tr>
<td>Off by E3 + failsafe</td>
<td>Error LED lights up at errors of error classes E1, E2 and E3, Failsafe mode on *)</td>
</tr>
<tr>
<td>Off by E4 + failsafe</td>
<td>Error LED lights up at errors of error classes E1, E2 and E3, Failsafe mode on *)</td>
</tr>
<tr>
<td>Off by E3 + failsafe</td>
<td>Error LED lights up at errors of error classes E1 and E2, Failsafe mode on *)</td>
</tr>
</tbody>
</table>

¹) The parameter behaviourDOatCommunicationFault is only analyzed if the Failsafe-mode is ON.
**Group parameters of the cam switch**

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>numOfUsedCams ¹)</td>
<td>0 ... 32</td>
<td>0 ... 32</td>
<td>WORD</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>128 ... 160</td>
<td>218 ... 160</td>
<td></td>
<td></td>
</tr>
<tr>
<td>resolution ²)</td>
<td>0 ... 2</td>
<td>0 ... 2</td>
<td>DWORD</td>
<td>36000</td>
</tr>
<tr>
<td></td>
<td>-1</td>
<td>-1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>zeroShift ³)</td>
<td>0 ... 2</td>
<td>0 ... 2</td>
<td>DWORD</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>-1</td>
<td>-1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EncoderBitResolution ⁴)</td>
<td>8 ... 32</td>
<td>8 ... 32</td>
<td>WORD</td>
<td>18</td>
</tr>
<tr>
<td>Reserve</td>
<td>-</td>
<td>-</td>
<td>WORD</td>
<td>-</td>
</tr>
</tbody>
</table>

Remarks:

¹) The parameter numOfUsedCams defines the interrupt cycle time (Therefore, it takes effect to the accuracy of the track) and the behavior of the module if the DC information is lost.

²) The parameter resolution defines the angle resolution of the track. The value gives the number of increments related to 360°; e.g. the value 36,000 corresponds to an angle resolution of 0.01°.

³) The parameter zeroShift defines the zero shift. With it the encoder can be adjusted to the mounting position. The value of zeroShift is set in encoder-increments. It is not assigned to the parameter resolution of the cam switch.

⁴) The parameter EncoderBitResolution defines the resolution of the used encoder (in bits), e.g. with the default setting 18 bits the encoder has 196,608 divisions.

---

<table>
<thead>
<tr>
<th>Parameter setting for numOfUsedCams</th>
<th>Number of cams used</th>
<th>Interrupt cycle time</th>
<th>Behavior if DC information is lost</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>50 µs</td>
<td>Module changes to &quot;safe-operational&quot; state; the outputs are activated through the user program</td>
</tr>
<tr>
<td>1 ... 8</td>
<td>1 ... 8</td>
<td>80 µs</td>
<td></td>
</tr>
<tr>
<td>9 ... 16</td>
<td>9 ... 16</td>
<td>100 µs</td>
<td></td>
</tr>
<tr>
<td>17 ... 32</td>
<td>17 ... 32</td>
<td>200 µs</td>
<td></td>
</tr>
<tr>
<td>128</td>
<td>0</td>
<td>50 µs</td>
<td>Module keeps in &quot;operational&quot; state; the outputs are activated through the user program</td>
</tr>
<tr>
<td>129 ... 136</td>
<td>1 ... 8</td>
<td>80 µs</td>
<td>Module keeps in &quot;operational&quot; state; the cam switch outputs are activated according to an interpolated timing information</td>
</tr>
<tr>
<td>137 ... 144</td>
<td>9 ... 16</td>
<td>100 µs</td>
<td></td>
</tr>
<tr>
<td>145 ... 170</td>
<td>17 ... 32</td>
<td>200 µs</td>
<td></td>
</tr>
</tbody>
</table>
Channel parameters for the cam switch (max. 32x)

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>camToTrack0</td>
<td>Digital Output</td>
<td>0 ... 15, FF</td>
<td>BYTE</td>
<td>FF</td>
</tr>
<tr>
<td></td>
<td>0 ... 15, none</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>camToTrack31</td>
<td>Digital Output</td>
<td>0 ... 15, FF</td>
<td>BYTE</td>
<td>FF</td>
</tr>
<tr>
<td></td>
<td>0 ... 15, none</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1) The value of the parameter camToTrack# defines which DO (digital output) is assigned to the track. camToTrack0 = 3 for example means that track 0 is assigned to the digital output 3. If the value FFh is set to a track, no digital output is assigned to it.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Referred FB from extended Cam Switch Library 2)</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>cam-Type[0]</td>
<td>Common</td>
<td>MCX_CamSwitchSimple_c</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Pulsed</td>
<td>MCX_CamSwitchSimple_dc</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Timed</td>
<td>MCX_PulseSwitch_dc</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Comfort</td>
<td>MCX_CamSwitchTimed_dc</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cam shift</td>
<td>MCX_CamSwitchComfort_dc</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Binary shift</td>
<td>MCX_CamShift_dc</td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Multiturn cam</td>
<td>MCX_BinaryShift_dc</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Time timed</td>
<td>MCX_CamSwitchMulti_dc</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reference</td>
<td>MCX_SwitchTimeTimed_dc</td>
<td>7</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Multiturn timed</td>
<td>MCX_BinaryReference_dc</td>
<td>8</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>MCX_CamSwitchMulti-Timed_dc</td>
<td>9</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1) camType additionally to camToTrack identifies the type of each cam switch and enables the use of a specific function block from the Extended Cam Switch Library.

2) camType parameters and the Extended Camswitch Library are only available for CI511-ETHCAT and CI512-ETHCAT with device index C0 and above.

Group parameters for the digital part

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input delay</td>
<td>0.01 ms</td>
<td>0</td>
<td>BYTE</td>
<td>0.01 ms</td>
</tr>
<tr>
<td></td>
<td>1 ms</td>
<td>1</td>
<td></td>
<td>0x00</td>
</tr>
<tr>
<td></td>
<td>8 ms</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>32 ms</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Detect short circuit at outputs</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>On</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td></td>
<td>0x01</td>
</tr>
</tbody>
</table>
### Behaviour DO at comm. error *)

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Behaviour DO at comm. error *)</td>
<td>Off Last value Last value 5 sec Last value 10 sec Substitute value Substitute value 5 sec Substitute value 10 sec</td>
<td>0 1 6 11 2 7 12</td>
<td>BYTE</td>
<td>Off 0x00</td>
</tr>
</tbody>
</table>

**Substitute values DO**

| 0 ... 65535 | 0000h ... FFFH | WORD | 0 | 0x0000 |

*) The parameter behaviourDOatCommunicationFault is only analyzed if the Failsafe-mode is ON.

### Diagnosis

In cases of short circuit or overload, the digital outputs are turned off. The modules performs reactivation automatically. Thus an acknowledgement of the errors is not necessary. The error message is stored via the LED.

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier 000 ... 063</th>
<th>AC500-Display</th>
<th>Display in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Comp</td>
<td>Dev</td>
<td>Mod</td>
<td>Ch</td>
<td>Err</td>
<td>PS501 PLC Browser</td>
<td>&lt;- Display in</td>
</tr>
<tr>
<td>Byte 6</td>
<td>Bit 6 ... 7</td>
<td>Byte 3</td>
<td>Byte 4</td>
<td>Byte 5</td>
<td>Byte 6 Bit 0 ... 5</td>
<td>ETHCAT Diagnosis block</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>1)</td>
<td>2)</td>
<td>3)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Module error

<p>| 3    | - | 31 | 31 | 31 | 43 | Internal error in the module | Replace I/O module |
| 3    | - | 31 | 31 | 31 | 20 | Slave-to-Slave malfunction | Check configuration |
| 3    | - | 31 | 31 | 31 | 41 | Distributed Clock malfunction | Check configuration |
| 3    | - | 31 | 31 | 31 | 26 | Parameter error | Check master |
| 3    | - | 31 | 31 | 31 | 11 | Process voltage UP too low | Check process supply voltage |</p>
<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier</th>
<th>AC500-Display</th>
<th>'&lt;-' Display in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Comp</td>
<td>Dev</td>
<td>Mod</td>
<td>Ch</td>
<td>Err</td>
<td>PS501 PLC Browser</td>
<td></td>
</tr>
<tr>
<td>Byte 6</td>
<td>-</td>
<td>Byte 3</td>
<td>Byte 4</td>
<td>Byte 5</td>
<td>Byte 6 Bit 0 ... 5</td>
<td>ETHCAT Diagnosis block</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>45</td>
<td>Process voltage UP3 too low</td>
<td>Check process voltage</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>34</td>
<td>No response during initialization of the I/O module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>46</td>
<td>Voltage feedback on activated digital outputs (^{4)} )</td>
<td>Check terminals</td>
</tr>
</tbody>
</table>

**Channel error digital**

| 4 | - | 31 | 2 | 0 ... 15 | 46 | Voltage feedback on deactivated digital output \(^{5)} \) | Check terminals |
| 4 | - | 31 | 4 | 0 ... 7 | 47 | Short circuit at digital output | Check terminals |
| 4 | - | 31 | 2 | 8 ... 15 | 47 | Short circuit at digital output | Check terminals |

**Remarks:**

1) In AC500 the following interface identifier applies:
   "." = Diagnosis via bus-specific function blocks; 0 ... 4 or 10 = Position of the Communication Module; 14 = I/O bus; 31 = Module itself
   The identifier is not contained in the CI512-ETHCAT diagnosis block.

2) With "Device" the following allocation applies:
   31 = Module itself or ADR = Hardware address (e.g. of the DC551)

3) With "Module" the following allocation applies dependent of the master:
   31 = Module itself (Module error) or Module type (1=AI, 2=DO, 3=AO; channel error)

4) Diagnosis message appears for the whole output group and not per channel. The message occurs if the output channel is already active.

5) Diagnosis message appears per channel. The message occurs if the output channel is not active.
State LEDs

The LEDs are located at the front of module. There are 2 different groups:

- The 5 system LEDs (PWR, NET, DC, S-ERR and I/O-Bus) show the operation state of the module and display possible errors.
- The 29 process LEDs (UP, UP3, inputs, outputs, CH-ERR1 to CH-ERR3) show the process supply voltage and the states of the inputs and outputs and display possible errors.

Table 236: States of the 5 system LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>Off</th>
<th>On</th>
<th>Flashing</th>
<th>1x flash</th>
<th>2x flash</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR/RUN</td>
<td>Green</td>
<td>Error in the internal supply voltage or process voltage missing</td>
<td>Internal supply voltage OK</td>
<td>Module is not configured</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>NET</td>
<td>Green</td>
<td>Init</td>
<td>Operational</td>
<td>Pre-operational</td>
<td>Safe-operational</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td>Red</td>
<td>No error</td>
<td>PDI Watchdog Timeout</td>
<td>Invalid Configuration</td>
<td>Unsolicited State Change</td>
<td>Application time out</td>
</tr>
<tr>
<td>DC *)</td>
<td>Green</td>
<td>Distributed Clock not active</td>
<td>Distributed Clock active</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td>Red</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>S-ERR</td>
<td>Red</td>
<td>No error</td>
<td>Internal error</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>I/O-Bus</td>
<td>Green</td>
<td>No communication interface modules connected or communication error</td>
<td>---</td>
<td>---</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>ETH1</td>
<td>Green</td>
<td>No EtherCAT connection</td>
<td>Link OK</td>
<td>Link OK Data transfer OK</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>ETH2</td>
<td>Green</td>
<td>No EtherCAT connection</td>
<td>Link OK</td>
<td>Link OK Data transfer OK</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
</tbody>
</table>

*) The state of this LED is only significant if the camswitch functionality is enabled.
### Table 237: States of the 29 process LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>OFF</th>
<th>ON</th>
<th>Flasching</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC0 ... DC7</td>
<td>Yellow</td>
<td>Input/Output is OFF</td>
<td>Input/Output is ON</td>
<td>--</td>
</tr>
<tr>
<td>DI8 ... DI15</td>
<td>Yellow</td>
<td>Input is OFF</td>
<td>Input is ON (the input voltage is even displayed if the supply voltage is OFF)</td>
<td>--</td>
</tr>
<tr>
<td>DO8 ... DO15</td>
<td>Yellow</td>
<td>Output is OFF</td>
<td>Output is ON</td>
<td>--</td>
</tr>
<tr>
<td>UP</td>
<td>Green</td>
<td>Process supply voltage missing</td>
<td>Process supply voltage OK and initialization finished</td>
<td>--</td>
</tr>
<tr>
<td>UP3</td>
<td>Green</td>
<td>Process supply voltage missing</td>
<td>Process supply voltage OK</td>
<td>--</td>
</tr>
<tr>
<td>CH-ERR1 to CH-ERR3</td>
<td>Red</td>
<td>No error or process supply voltage missing</td>
<td>Internal error</td>
<td>Error on one channel of the corresponding group</td>
</tr>
</tbody>
</table>

### Technical data

#### Technical data of the module

The system data of AC500 and S500 are applicable to the standard version "Chapter 5.1.2 "System data AC500" on page 166."

The system data of AC500-XC are applicable to the XC version "Chapter 5.1.3 "System data AC500-XC" on page 169."

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bus connection</td>
<td>2 x RJ45</td>
</tr>
<tr>
<td>Technology</td>
<td>Hilscher NETX 100</td>
</tr>
<tr>
<td>Transfer rate</td>
<td>10/100 Mbit/s (full-duplex)</td>
</tr>
<tr>
<td>Transfer method</td>
<td>According to Ethernet II, IEEE 802.3</td>
</tr>
<tr>
<td>Ethernet</td>
<td>100 base-TX, internal switch, 2x RJ45 socket</td>
</tr>
<tr>
<td>Expandability (S500 I/O modules)</td>
<td>Up to 10 S500 I/O modules (Index C0 and above), not available (Index below C0)</td>
</tr>
<tr>
<td>Indicators</td>
<td>5 LEDs for state indication</td>
</tr>
<tr>
<td>Adjusting elements</td>
<td>2 rotary switches (used for future topology extensions)</td>
</tr>
<tr>
<td>Quantity of input/output data</td>
<td>CI512-ETHCAT: 10 bytes input and 14 bytes output&lt;br&gt;Ci511-ETHCAT: 18 bytes input and 18 bytes output</td>
</tr>
<tr>
<td>Limit of data for input and output</td>
<td>144 byte</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Acyclic services</td>
<td>SDO (1500 bytes max.)</td>
</tr>
<tr>
<td></td>
<td>Emergency ECAT_SLV_DIAG</td>
</tr>
<tr>
<td>Protective functions (according to CODESYS)</td>
<td>Protected against:</td>
</tr>
<tr>
<td></td>
<td>● short circuit</td>
</tr>
<tr>
<td></td>
<td>● reverse supply</td>
</tr>
<tr>
<td></td>
<td>● overvoltage</td>
</tr>
<tr>
<td></td>
<td>● reverse polarity</td>
</tr>
<tr>
<td></td>
<td>Galvanic isolation to network</td>
</tr>
<tr>
<td>Process supply voltages UP/UP3</td>
<td></td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC (for inputs and outputs)</td>
</tr>
<tr>
<td>Max. load for the terminals</td>
<td>10 A</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse on UP/UP3</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Ethernet interface against the rest of the module</td>
</tr>
<tr>
<td>Inrush current from UP (at power up)</td>
<td>On request</td>
</tr>
<tr>
<td>Current consumption via UP (normal operation)</td>
<td>0.15 A</td>
</tr>
<tr>
<td>Current consumption via UP3</td>
<td>0.06 A + 0.5 A max. per output</td>
</tr>
<tr>
<td>Connections</td>
<td>Terminals 1.8 and 2.8 for +24 V (UP)</td>
</tr>
<tr>
<td></td>
<td>Terminal 3.8 for +24 V (UP3)</td>
</tr>
<tr>
<td></td>
<td>Terminals 1.9, 2.9 and 3.9 for 0 V (ZP)</td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>6 W</td>
</tr>
<tr>
<td>Number of digital inputs</td>
<td>8</td>
</tr>
<tr>
<td>Number of digital outputs</td>
<td>8</td>
</tr>
<tr>
<td>Number of configurable digital inputs/outputs</td>
<td>8</td>
</tr>
<tr>
<td>Reference potential for all digital inputs and outputs</td>
<td>Negative pole of the supply voltage, signal name ZP</td>
</tr>
<tr>
<td>Diagnosis</td>
<td>See Diagnosis and Displays § Chapter 5.2.6.4.2.10 “Diagnosis” on page 1060</td>
</tr>
<tr>
<td>Operation and error displays</td>
<td>34 LEDs (totally)</td>
</tr>
<tr>
<td>Weight (without terminal unit)</td>
<td>Ca. 125 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal</td>
</tr>
<tr>
<td></td>
<td>Or vertical with derating (output load reduced to 50 % at +40 °C per group)</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>
NOTICE!
All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

Multiple overloads
No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an internal smart high-side switch.

Technical data of the digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels DI0 ... DI7</td>
<td>Terminals 2.0 ... 2.7</td>
</tr>
<tr>
<td>Reference potential for all inputs</td>
<td>Terminals 1.9 ... 3.9 (negative pole of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel, the LED is ON when the input signal is high (signal 1)</td>
</tr>
<tr>
<td>Input type (according EN 61131-2)</td>
<td>Type 1</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 0.1 ms, configurable from 0.1 ms ... 32 ms</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>0-Signal</td>
<td>-3 V ... +5 V</td>
</tr>
<tr>
<td>undefined Signal</td>
<td>&gt; +5 V ... &lt; +15 V</td>
</tr>
<tr>
<td>1-Signal</td>
<td>+15 V ... +30 V</td>
</tr>
<tr>
<td>Ripple with signal 0</td>
<td>Within -3 V ... +5 V</td>
</tr>
<tr>
<td>Ripple with signal 1</td>
<td>Within +15 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 5 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>&gt; 1 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>&gt; 2 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 8 mA</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

Technical data of the digital outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Terminals of the channels DO0 ... DO7</td>
<td>Terminals 3.0 ... 3.7</td>
</tr>
<tr>
<td>Reference potential for all outputs</td>
<td>Terminals 1.9 ... 3.9 (negative pole of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>For all outputs terminal 3.8 (positive pole of the supply voltage, signal name UP3)</td>
</tr>
<tr>
<td>Output voltage for signal 1</td>
<td>UP3 (-0.8 V)</td>
</tr>
<tr>
<td>Output delay (0-&gt;1 or 1-&gt;0)</td>
<td>On request</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated value per channel</td>
<td>500 mA at UP3 = 24 V</td>
</tr>
<tr>
<td>Max. value (all channels together)</td>
<td>4 A</td>
</tr>
<tr>
<td>Leakage current with signal 0</td>
<td>&lt; 0.5 mA</td>
</tr>
<tr>
<td>Fuse for UP3</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Demagnetization with inductive DC load</td>
<td>Via internal varistors (see figure below this table)</td>
</tr>
<tr>
<td>Output switching frequency</td>
<td></td>
</tr>
<tr>
<td>With resistive load</td>
<td>On request</td>
</tr>
<tr>
<td>With inductive loads</td>
<td>Max. 0.5 Hz</td>
</tr>
<tr>
<td>With lamp loads</td>
<td>11 Hz max. at 5 W max.</td>
</tr>
<tr>
<td>Short-circuit-proof / overload-proof</td>
<td>Yes</td>
</tr>
<tr>
<td>Overload message (I &gt; 0.7 A)</td>
<td>Yes, after ca. 100 ms</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>Yes, automatic reactivation after short circuit/overload</td>
</tr>
<tr>
<td>Resistance to feedback against 24V signals</td>
<td>Yes (software-controlled supervision)</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

The following drawing shows the circuitry of a digital input/output with the varistors for demagnetization when inductive loads are switched off.

![Circuit Diagram](image)

**Fig. 204: Digital input/output (circuit diagram)**

1. Digital output
2. Varistors for demagnetization when inductive loads are turned off

Figure:
Technical data of the configurable digital inputs/outputs

Each of the configurable I/O channels is defined as input or output by the user program. This is done by interrogating or allocating the corresponding channel.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8 inputs/outputs (with transistors)</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group for 8 channels</td>
</tr>
<tr>
<td>If the channels are used as inputs</td>
<td></td>
</tr>
<tr>
<td>Channels DC0 ... DC07</td>
<td>Terminals 1.0 ... 1.7</td>
</tr>
<tr>
<td>If the channels are used as outputs</td>
<td></td>
</tr>
<tr>
<td>Channels DC0 ... DC07</td>
<td>Terminals 1.0 ... 1.7</td>
</tr>
<tr>
<td>Indication of the input/output signals</td>
<td>1 yellow LED per channel, the LED is ON when the input/output signal is high (signal 1)</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>From the Ethernet network</td>
</tr>
</tbody>
</table>

Technical data of the digital inputs/outputs if used as inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels DC0 ... DC7</td>
<td>Terminals 1.0 ... 1.7</td>
</tr>
<tr>
<td>Reference potential for all inputs</td>
<td>Terminals 1.9 ... 3.9 (negative pole of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel, the LED is ON when the input signal is high (signal 1)</td>
</tr>
<tr>
<td>Input type (according EN 61131-2)</td>
<td>Type 1</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 0.1 ms, configurable from 0.1 ms ... 32 ms</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>0-Signal</td>
<td>-3 V ... +5 V *)</td>
</tr>
<tr>
<td>Undefined Signal</td>
<td>&gt; +5 V ... &lt; +15 V</td>
</tr>
<tr>
<td>1-Signal</td>
<td>+15 V ... +30 V</td>
</tr>
<tr>
<td>Ripple with signal 0</td>
<td>Within -3 V ... +5 V *)</td>
</tr>
<tr>
<td>Ripple with signal 1</td>
<td>Within +15 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 5 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>&gt; 1 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>&gt; 2 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 8 mA</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>
*) Due to the direct connection to the output, the demagnetizing varistor is also effective at
the input (see figure) above. This is why the difference between UPx and the input signal may
not exceed the clamp voltage of the varistor. The varistor limits the voltage to approx. 36 V.
Following this, the input voltage must range from -12 V ... +30 V when UPx = 24 V and from
-6 V ... +30 V when UPx = 30 V.

Technical data of the digital inputs/outputs if used as outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels DC0 ... DC7</td>
<td>Terminals 1.0 ... 1.7</td>
</tr>
<tr>
<td>Reference potential for all outputs</td>
<td>Terminals 1.9 ... 3.9 (negative pole of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>For all outputs terminal 3.8 (positive pole of the supply voltage, signal name UP3)</td>
</tr>
<tr>
<td>Output voltage for signal 1</td>
<td>UP3 (-0.8 V)</td>
</tr>
<tr>
<td>Output delay (0-&gt;1 or 1-&gt;0)</td>
<td>On request</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated value per channel</td>
<td>500 mA at UP3 = 24 V</td>
</tr>
<tr>
<td>Max. value (all channels together)</td>
<td>4 A</td>
</tr>
<tr>
<td>Leakage current with signal 0</td>
<td>&lt; 0.5 mA</td>
</tr>
<tr>
<td>Fuse for UP3</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Demagnetization with inductive DC load</td>
<td>Via internal varistors (see figure below this table)</td>
</tr>
<tr>
<td>Output switching frequency</td>
<td></td>
</tr>
<tr>
<td>With resistive load</td>
<td>On request</td>
</tr>
<tr>
<td>With inductive loads</td>
<td>Max. 0.5 Hz</td>
</tr>
<tr>
<td>With lamp loads</td>
<td>11 Hz max. at 5 W max.</td>
</tr>
<tr>
<td>Short-circuit-proof / overload-proof</td>
<td>Yes</td>
</tr>
<tr>
<td>Overload message (I &gt; 0.7 A)</td>
<td>Yes, after ca. 100 ms</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>Yes, automatic reactivation after short circuit/overload</td>
</tr>
<tr>
<td>Resistance to feedback against 24V signals</td>
<td>Yes (software-controlled supervision)</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

The following drawing shows the circuitry of a digital input/output with the varistors for demag-
netization when inductive loads are switched off.
Fig. 205: Digital input/output (circuit diagram)

1. Digital input/output
2. For demagnetization when inductive loads are turned off

Dimensions

1. Din rail 15 mm
2. Din rail 7.5 mm

The dimensions are in mm and in brackets in inch.
Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 221 000 R0001</td>
<td>CI512-ETHCAT, EtherCAT communication interface module, 8 DI, 8 DO and 8 DC</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

5.2.6.5 Modbus

5.2.6.5.1 CI521-MODTCP

Features

- 4 analog inputs (resolution 12 bits including sign)
- 2 analog outputs (resolution 12 bits including sign)
- 8 digital inputs 24 V DC
- 8 digital outputs 24 V DC, 0.5 A max.
- Module-wise galvanically isolated
- Fast counter
- XC version for usage in extreme ambient conditions available
1 I/O bus
2 Allocation between terminal number and signal name
3 6 yellow LEDs to display the signal states of the analog inputs/outputs (AI0 ... AI3, AO0 ... AO1)
4 8 yellow LEDs to display the signal states of the digital inputs (DI0 ... DI7)
5 8 yellow LEDs to display the signal states of the digital outputs (DO0 ... DO7)
6 2 green LEDs to display the process supply voltage UP and UP3
7 3 red LEDs to display errors (CH-ERR1, CH-ERR2, CH-ERR3)
8 5 system LEDs: PWR/RUN, STA1 ETH, STA2 ETH, S-ERR, I/O-Bus
9 Label
10 2 rotary switches for setting the IP address
11 Ethernet interfaces (ETH1, ETH2) on the terminal unit
12 Terminal unit
13 DIN rail
*: Sign for XC version
Intended purpose

The Modbus TCP communication interface module CI521-MODTCP is used as decentralized I/O module in Modbus TCP networks. The network connection is performed via 2 RJ45 connectors which are integrated in the terminal unit. The communication interface module contains 22 I/O channels with the following properties:

- 4 analog inputs (1.0 ... 1.3)
- 2 analog outputs (1.5 ... 1.6)
- 8 digital inputs 24 V DC in 1 group (2.0 ... 2.7)
- 8 digital outputs 24 V DC in 1 group (3.0 ... 3.7)

The inputs/outputs are galvanically isolated from the Ethernet network. There is no potential separation between the channels. The configuration of the analog inputs/outputs is performed by software.

For usage in enhanced ambient conditions (e.g. wider temperature and humidity range), a special XC version of the device is available.

Functionality

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface</td>
<td>Ethernet</td>
</tr>
<tr>
<td>Protocol</td>
<td>Modbus TCP</td>
</tr>
<tr>
<td>Power supply</td>
<td>From the process supply voltage UP</td>
</tr>
<tr>
<td>Supply of the electronic circuitry of the I/O</td>
<td>Through the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>expansion modules attached</td>
<td></td>
</tr>
<tr>
<td>Rotary switches</td>
<td>for setting the last BYTE of the IP (00h to FFh)</td>
</tr>
<tr>
<td>Analog inputs</td>
<td>4 (configurable via software)</td>
</tr>
<tr>
<td>Analog outputs</td>
<td>2 (configurable via software)</td>
</tr>
<tr>
<td>Digital inputs</td>
<td>8 (24 V DC; delay time configurable via software)</td>
</tr>
<tr>
<td>Digital outputs</td>
<td>8 (24 V DC, 0.5 A max.)</td>
</tr>
<tr>
<td>LED displays</td>
<td>For system displays, signal states, errors and power supply</td>
</tr>
<tr>
<td>External supply voltage</td>
<td>Via terminals ZP, UP and UP3 (process supply voltage 24 V DC)</td>
</tr>
<tr>
<td>Required terminal unit</td>
<td>TU507 or TU508  ( \copyright ) Chapter 5.2.7.2 “TU507-ETH and TU508-ETH for Ethernet communication interface modules” on page 1270</td>
</tr>
</tbody>
</table>

Connections

General

The Ethernet communication interface module CI521-MODTCP is plugged on the I/O terminal unit TU507-ETH or TU508-ETH  \( \copyright \) Chapter 5.2.7.2 “TU507-ETH and TU508-ETH for Ethernet communication interface modules” on page 1270. Properly seat the module and press until it locks in place. The terminal unit is mounted on a DIN rail or with 2 screws plus the additional accessory for wall mounting  \( \copyright \) Chapter 5.2.8.2.5 “TA526 - Wall mounting accessory” on page 1324.

The connection of the I/O channels is carried out using the 30 terminals of the I/O terminal unit. I/O modules can be replaced without re-wiring the terminal units.
For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The terminals 1.8 and 2.8 as well as 1.9, 2.9 and 3.9 are electrically interconnected within the terminal unit and have always the same assignment, independent of the inserted module:

Terminals 1.8 and 2.8: Process supply voltage UP = +24 V DC
Terminal 3.8: Process supply voltage UP3 = +24 V DC
Terminals 1.9, 2.9 and 3.9: Process supply voltage ZP = 0 V

With a separate UP3 power supply, the digital outputs can be switched off externally. This way, an emergency-off functionality can be realized.

Conditions for undisturbed operating with older I/O expansion modules

All I/O expansion modules that are attached to the CI52x-MODTCP must be powered up together with the CI52x-MODTCP if the firmware version of these I/O expansion modules is V1.9 or lower.

The firmware version is related to the index. The index is printed on the module type label on the right side.

Modules as of index listed in the following table can be powered up independently.

<table>
<thead>
<tr>
<th>S500 I/O module type</th>
<th>First index with firmware version above 1.9</th>
</tr>
</thead>
<tbody>
<tr>
<td>AI523</td>
<td>D0</td>
</tr>
<tr>
<td>AI523-XC</td>
<td>D0</td>
</tr>
<tr>
<td>AI531</td>
<td>A3</td>
</tr>
<tr>
<td>AI531-XC</td>
<td>A0</td>
</tr>
<tr>
<td>AO523</td>
<td>D0</td>
</tr>
<tr>
<td>AO523-XC</td>
<td>D0</td>
</tr>
<tr>
<td>AX521</td>
<td>D0</td>
</tr>
<tr>
<td>AX521-XC</td>
<td>D0</td>
</tr>
<tr>
<td>AX522</td>
<td>D0</td>
</tr>
<tr>
<td>AX522-XC</td>
<td>D0</td>
</tr>
<tr>
<td>CD522</td>
<td>A2</td>
</tr>
<tr>
<td>CD522-XC</td>
<td>A0</td>
</tr>
<tr>
<td>DA501</td>
<td>A2</td>
</tr>
<tr>
<td>DA501-XC</td>
<td>A0</td>
</tr>
<tr>
<td>DA502</td>
<td>A1</td>
</tr>
<tr>
<td>DA502-XC</td>
<td>A1</td>
</tr>
<tr>
<td>DC522</td>
<td>D0</td>
</tr>
<tr>
<td>DC522-XC</td>
<td>D0</td>
</tr>
<tr>
<td>DC523</td>
<td>D0</td>
</tr>
</tbody>
</table>
Do not connect any voltages externally to digital outputs!
Reason: Externally voltages at an output or several outputs may cause that other outputs are supplied through that voltage instead of voltage UP3 (reverse voltage). This is not intended usage.

**CAUTION!**
Risk of malfunction by unintended usage!
If the function cut-off of the digital outputs is to be used by deactivation of the supply voltage UP3, be sure that no external voltage is connected at the outputs DO0..DO7.

**Table 238: Assignment of the other terminals**

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>AI0+</td>
<td>Positive pole of analog input signal 0</td>
</tr>
<tr>
<td>1.1</td>
<td>AI1+</td>
<td>Positive pole of analog input signal 1</td>
</tr>
<tr>
<td>1.2</td>
<td>AI2+</td>
<td>Positive pole of analog input signal 2</td>
</tr>
<tr>
<td>1.3</td>
<td>AI3+</td>
<td>Positive pole of analog input signal 3</td>
</tr>
<tr>
<td>1.4</td>
<td>AI-</td>
<td>Negative pole of analog input signals 0 to 3</td>
</tr>
<tr>
<td>1.5</td>
<td>AO0+</td>
<td>Positive pole of analog output signal 0</td>
</tr>
<tr>
<td>1.6</td>
<td>AO1+</td>
<td>Positive pole of analog output signal 1</td>
</tr>
<tr>
<td>1.7</td>
<td>AI-</td>
<td>Negative pole of analog output signals 0 and 1</td>
</tr>
<tr>
<td>1.8</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>1.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
<tr>
<td>2.0</td>
<td>DI0</td>
<td>Signal of the digital input DI0</td>
</tr>
<tr>
<td>2.1</td>
<td>DI1</td>
<td>Signal of the digital input DI1</td>
</tr>
<tr>
<td>2.2</td>
<td>DI2</td>
<td>Signal of the digital input DI2</td>
</tr>
<tr>
<td>2.3</td>
<td>DI3</td>
<td>Signal of the digital input DI3</td>
</tr>
<tr>
<td>2.4</td>
<td>DI4</td>
<td>Signal of the digital input DI4</td>
</tr>
<tr>
<td>Terminal</td>
<td>Signal</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>2.5</td>
<td>DI5</td>
<td>Signal of the digital input DI5</td>
</tr>
<tr>
<td>2.6</td>
<td>DI6</td>
<td>Signal of the digital input DI6</td>
</tr>
<tr>
<td>2.7</td>
<td>DI7</td>
<td>Signal of the digital input DI7</td>
</tr>
<tr>
<td>2.8</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>2.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
<tr>
<td>3.0</td>
<td>DO0</td>
<td>Signal of the digital output DO0</td>
</tr>
<tr>
<td>3.1</td>
<td>DO1</td>
<td>Signal of the digital output DO1</td>
</tr>
<tr>
<td>3.2</td>
<td>DO2</td>
<td>Signal of the digital output DO2</td>
</tr>
<tr>
<td>3.3</td>
<td>DO3</td>
<td>Signal of the digital output DO3</td>
</tr>
<tr>
<td>3.4</td>
<td>DO4</td>
<td>Signal of the digital output DO4</td>
</tr>
<tr>
<td>3.5</td>
<td>DO5</td>
<td>Signal of the digital output DO5</td>
</tr>
<tr>
<td>3.6</td>
<td>DO6</td>
<td>Signal of the digital output DO6</td>
</tr>
<tr>
<td>3.7</td>
<td>DO7</td>
<td>Signal of the digital output DO7</td>
</tr>
<tr>
<td>3.8</td>
<td>UP3</td>
<td>Process voltage UP3 (24 V DC)</td>
</tr>
<tr>
<td>3.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
</tbody>
</table>

**WARNING!**

Removal/Insertion under power

The devices are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you

- connect or disconnect any signal or terminal block
- remove, mount or replace a module.

Disconnecting any powered devices while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The devices must not be opened when in operation. The same applies to the network interfaces.

**NOTICE!**

Risk of damaging the PLC modules!

Overvoltages and short circuits might damage the PLC modules.

- Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
- Never connect any voltages or signals to reserved terminals (marked with `---`). Reserved terminals may carry internal voltages.

For the open-circuit detection (wire break), each analog input channel is pulled up to "plus" by a high-resistance resistor. If nothing is connected, the maximum voltage will be read in then.
Generally, analog signals must be laid in shielded cables. The cable shields must be grounded at both sides of the cables. In order to avoid unacceptable potential differences between different parts of the installation, low resistance equipotential bonding conductors must be laid.

Fig. 206: Connection of the communication interface module CI521-MODTCP

© Chapter 6.8.4.1 “Modbus communication interface module” on page 4568
Connection of the digital inputs

Fig. 207: Connection of the digital inputs (DO0 ... DO7) to the module CI521-MODTCP

The meaning of the LEDs is described in Displays Chapter 5.2.6.5.1.10 “State LEDs” on page 1101.
Connection of the digital outputs

![Diagram showing the connection of digital outputs DO0 to DO7 to the module CI521-MODTCP.]

Fig. 208: Connection of configurable digital inputs/outputs (DO0 ... DO7) to the module CI521-MODTCP

The meaning of the LEDs is described in Displays 5.2.6.5.1.10 “State LEDs” on page 1101.

Connection of resistance thermometers in 2-wire configuration to the analog inputs

When resistance thermometers (Pt100, Pt1000, Ni1000) are used, a constant current must flow through them to build the necessary voltage drop for the evaluation. For this, the module CI521-MODTCP provides a constant current source which is multiplexed over the max. 4 analog input channels.
Fig. 209: Connection of resistance thermometers in 2-wire configuration to the analog inputs (AI0 ... AI3)

The following measuring ranges can be configured § Chapter 5.2.6.5.1.8 "Parameterization" on page 1090 § Chapter 5.2.6.5.1.11 "Measuring ranges" on page 1102:

<table>
<thead>
<tr>
<th>Thermometer</th>
<th>Range</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pt100</td>
<td>-50 °C ... +70 °C</td>
<td>2-wire configuration, 1 channel used</td>
</tr>
<tr>
<td>Pt100</td>
<td>-50 °C ... +400 °C</td>
<td>2-wire configuration, 1 channel used</td>
</tr>
<tr>
<td>Pt1000</td>
<td>-50 °C ... +400 °C</td>
<td>2-wire configuration, 1 channel used</td>
</tr>
<tr>
<td>Ni1000</td>
<td>-50 °C ... +150 °C</td>
<td>2-wire configuration, 1 channel used</td>
</tr>
</tbody>
</table>

The function of the LEDs is described under Diagnosis and displays / Displays § Chapter 5.2.6.5.1.9 "Diagnosis" on page 1096.

The module CI521-MODTCP performs a linearization of the resistance characteristic.

To avoid error messages from unused analog input channels, configure them as "unused".

Connection of resistance thermometers in 3-wire configuration to the analog inputs

When resistance thermometers (Pt100, Pt1000, Ni1000) are used, a constant current must flow through them to build the necessary voltage drop for the evaluation. For this, the module CI521-MODTCP provides a constant current source which is multiplexed over the max. 4 analog input channels.
Fig. 210: Connection of resistance thermometers in 3-wire configuration to the analog inputs (AI0 ... AI3)

With 3-wire configuration, 2 adjacent analog channels belong together (e. g. the channels 0 and 1). In this case, both channels are configured according to the desired operating mode. The lower address must be the even address (channel 0), the next higher address must be the odd address (channel 1).

The constant current of one channel flows through the resistance thermometer. The constant current of the other channel flows through one of the cores. The module calculates the measured value from the two voltage drops and stores it under the input with the higher channel number (e. g. I1).

In order to keep measuring errors as small as possible, it is necessary to have all the involved conductors in the same cable. All the conductors must have the same cross section.

The following measuring ranges can be configured: Chapter 5.2.6.5.1.8 "Parameterization" on page 1090 and Chapter 5.2.6.5.1.11 "Measuring ranges" on page 1102:

<table>
<thead>
<tr>
<th>Material</th>
<th>Measuring Range</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pt100</td>
<td>-50 °C ... +70 °C</td>
<td>3-wire configuration, 2 channels used</td>
</tr>
<tr>
<td>Pt100</td>
<td>-50 °C ... +400 °C</td>
<td>3-wire configuration, 2 channels used</td>
</tr>
<tr>
<td>Pt1000</td>
<td>-50 °C ... +400 °C</td>
<td>3-wire configuration, 2 channels used</td>
</tr>
<tr>
<td>Ni1000</td>
<td>-50 °C ... +150 °C</td>
<td>3-wire configuration, 2 channels used</td>
</tr>
</tbody>
</table>

The function of the LEDs is described under Diagnosis and displays / Displays Chapter 5.2.6.5.1.9 "Diagnosis" on page 1096.

The module CI521-MODTCP performs a linearization of the resistance characteristic.
To avoid error messages from unused analog input channels, configure them as "unused".
Connection of active-type analog sensors (voltage) with galvanically isolated power supply to the analog inputs

![Connection diagram](image)

Fig. 211: Connection of active-type analog sensors (voltage) with galvanically isolated power supply to the analog inputs (AI0 ... AI3)

The following measuring ranges can be configured 

<table>
<thead>
<tr>
<th>Voltage</th>
<th>0 ... 10 V</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

The function of the LEDs is described under Diagnosis and displays / Displays 

Chapter 5.2.6.5.1.9 “Diagnosis” on page 1096.

To avoid error messages from unused analog input channels, configure them as "unused".
Connection of active-type analog sensors (Current) with galvanically isolated power supply to the analog inputs

Fig. 212: Connection of active-type analog sensors (current) with galvanically isolated power supply to the analog inputs (AI0 ... AI3)

The following measuring ranges can be configured § Chapter 5.2.6.5.1.8 “Parameterization” on page 1090 § Chapter 5.2.6.5.1.11 “Measuring ranges” on page 1102:

<table>
<thead>
<tr>
<th>Current</th>
<th>0 mA ... 20 mA</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>4 mA ... 20 mA</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

The function of the LEDs is described under Diagnosis and displays / Displays § Chapter 5.2.6.5.1.9 “Diagnosis” on page 1096.

Unused input channels can be left open-circuited, because they are of low resistance.

To avoid error messages through unused analog input channels in measuring range 4 mA ... 20 mA, these channels should be configured as "Not used".
Connection of active-type analog sensors (Voltage) with no galvanically isolated power supply to the analog inputs

**Fig. 213: Connection of active-type sensors (voltage) with no galvanically isolated power supply to the analog inputs (AI0 ... AI3)**

**CAUTION!**
Risk of faulty measurements!
The negative pole at the sensors must not have too big a potential difference with respect to ZP (max. ± 1 V).
Make sure that the potential difference never exceeds ± 1 V (also not with long cable lengths).

The following measuring ranges can be configured:

- **Chapter 5.2.6.5.1.8 “Parameterization” on page 1090**
- **Chapter 5.2.6.5.1.11 “Measuring ranges” on page 1102.**

<table>
<thead>
<tr>
<th>Voltage</th>
<th>0 ... 10 V</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

The function of the LEDs is described under Diagnosis and displays / Displays:

**Chapter 5.2.6.5.1.9 “Diagnosis” on page 1096.**

To avoid error messages from unused analog input channels, configure them as "unused".

Connection of passive-type analog sensors (Current) to the analog inputs

The following figure shows the connection of passive-type analog sensors (current) to the analog input AI0. Proceed with the analog inputs AI1 ... AI3 in the same way.
The function of the LEDs is described under Diagnosis and displays (Chapter 5.2.6.5.1.9 “Diagnosis” on page 1096).

**CAUTION!**
**Risk of overloading the analog input!**
If an analog current sensor supplies more than 25 mA for more than 1 second during initialization, this input is switched off by the module (input protection).

Use only sensors with fast initialization or without current peaks higher than 25 mA. If not possible, connect a 10-volt Zener diode in parallel to AIx+ and ZP.

Unused input channels can be left open-circuited, because they are of low resistance.

To avoid error messages through unused analog input channels in measuring range 4 mA ... 20 mA, these channels should be configured as "Not used".

**Connection of active-type analog sensors (Voltage) to differential analog inputs**

Differential inputs are very useful, if analog sensors are used which are remotely non-isolated (e.g. the minus terminal is remotely grounded).

The evaluation using differential inputs helps to considerably increase the measuring accuracy and to avoid ground loops.
With differential input configurations, two adjacent analog channels belong together (e.g. the channels 0 and 1). In this case, both channels are configured according to the desired operating mode. The lower address must be the even address (channel 0), the next higher address must be the odd address (channel 1). The converted analog value is available at the higher address (channel 1).

The analog value is calculated by subtraction of the input value with the higher address from the input value of the lower address.

The converted analog value is available at the odd channel (higher address).

**CAUTION!**

Risk of faulty measurements!

The negative pole at the sensors must not have too big a potential difference with respect to ZP (max. ±1 V).

Make sure that the potential difference never exceeds ±1 V.

The following figure shows the connection of active-type analog sensors (voltage) to differential analog inputs AI0 and AI1. Proceed with AI2 and AI3 in the same way.

**Fig. 215: Connection of active-type analog sensors (voltage) to differential analog inputs (AI0 ... AI3)**

The following measuring ranges can be configured: Chapter 5.2.6.5.1.8 "Parameterization" on page 1090 Chapter 5.2.6.5.1.11 "Measuring ranges" on page 1102:

<table>
<thead>
<tr>
<th>Voltage</th>
<th>0 V ... 10 V</th>
<th>With differential inputs, 2 channels used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V</td>
<td>With differential inputs, 2 channels used</td>
</tr>
</tbody>
</table>
Use of analog inputs as digital inputs

Several (or all) analog inputs can be configured as digital inputs Chapter 5.2.6.5.1.12.5 “Technical data of the analog inputs if used as digital inputs” on page 1108. The inputs are not galvanically isolated against the other analog channels.

![Diagram of digital sensors connection](image)

**Fig. 216: Connection of digital sensors to the analog inputs (AI0 ... AI3)**

The following measuring ranges can be configured Chapter 5.2.6.5.1.8 “Parameterization” on page 1090 and Chapter 5.2.6.5.1.11 “Measuring ranges” on page 1102:

<table>
<thead>
<tr>
<th>Digital input</th>
<th>24 V</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital input</td>
<td>24 V</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

The function of the LEDs is described under Diagnosis and displays / Displays Chapter 5.2.6.5.1.9 “Diagnosis” on page 1096.

To avoid error messages from unused analog input channels, configure them as "unused".
Connection of analog output loads (Voltage)

The following measuring ranges can be configured

<table>
<thead>
<tr>
<th>Voltage</th>
<th>-10 V ... +10 V</th>
<th>Load ± 10 mA max.</th>
<th>1 channel used</th>
</tr>
</thead>
</table>

The function of the LEDs is described under Diagnosis and displays / Displays

Unused analog outputs can be left open-circuited.
Connection of analog output loads (Current)

Fig. 218: Connection of analog output loads (current) to the analog outputs (AO0 and AO1)

The following measuring ranges can be configured % Chapter 5.2.6.5.1.8 “Parameterization” on page 1090 % Chapter 5.2.6.5.1.11 “Measuring ranges” on page 1102:

<table>
<thead>
<tr>
<th>Current</th>
<th>0 mA ... 20 mA</th>
<th>Load 0 ... 500 Ω</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>4 ... 20 mA</td>
<td>Load 0 ... 500 Ω</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

The function of the LEDs is described under Diagnosis and displays / Displays % Chapter 5.2.6.5.1.9 “Diagnosis” on page 1096.

Unused analog outputs can be left open-circuited.

Assignment of the Ethernet ports

The terminal unit for the communication interface module provides two Ethernet interfaces with the following pin assignment:

<table>
<thead>
<tr>
<th>Pin assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface</td>
</tr>
<tr>
<td>----------------</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>Interface</td>
</tr>
<tr>
<td>-----------</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

In corrosive environment, please protect unused connectors using the TA535 accessory.
Not supplied with this device.

Further information about wiring and cable types

Internal data exchange

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital inputs (bytes)</td>
<td>3</td>
</tr>
<tr>
<td>Digital outputs (bytes)</td>
<td>3</td>
</tr>
<tr>
<td>Analog inputs (words)</td>
<td>4</td>
</tr>
<tr>
<td>Analog outputs (words)</td>
<td>2</td>
</tr>
<tr>
<td>Counter input data (words)</td>
<td>4</td>
</tr>
<tr>
<td>Counter output data (words)</td>
<td>8</td>
</tr>
</tbody>
</table>

Replacement of a Modbus TCP communication interface module:
The module must be powered off before it is replaced. If the configuration data is stored in the module, then the configuration data must be downloaded into the new module, either by using Modbus communication or by using the Modbus configurator which is contained in the Automation Builder distribution.

Chapter 6.3.2.12.2 “Unbundled Cl52x-MODTCP configuration” on page 1565

Addressing

The module reads the position of the rotary switches only during power-up, i.e., changes of the switch position during operation will have no effect until the next module initialization.

The IP address of the Cl521-MODTCP Module can be set with the “ABB IP Configuration Tool”.

Chapter 6.3.2.4.3 “Configuration of the IP settings with the IP configuration tool” on page 1457.

If the last byte of the IP is set to 0, the address switch will be used instead.
Address switch position 255 is mapped to fixed IP 192.168.0.254 independent of other stored settings. This is a backup so the module can always get a valid IP address and can be configured by the “ABB IP Configuration Tool”.
Address switch position 0 is mapped to last byte equal 1 and DHCP enabled.
The factory setting for the IP is 192.168.0.x (last byte is address switch).

### I/O configuration

The CI521-MODTCP stores configuration parameters (IP address configuration, module parameters).

The analog/digital I/O channels are configured via software.

Details about configuration are described in Parameterization &gt; Chapter 5.2.6.5.1.8 “Parameterization” on page 1090.

### Parameterization

#### Parameters of the module

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID ¹)</td>
<td>Internal</td>
<td>7400</td>
<td>WORD</td>
<td>7000</td>
</tr>
<tr>
<td>Ignore Module</td>
<td>Internal</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal</td>
<td>63</td>
<td>BYTE</td>
<td>63</td>
</tr>
<tr>
<td>Error LED / Fail-safe function</td>
<td>On</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Off by E4</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off by E3</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>On + failsafe</td>
<td>16</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off by E4 + failsafe</td>
<td>17</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off by E3 + failsafe</td>
<td>19</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master IP for Write restriction ²)</td>
<td>No master IP Master IP</td>
<td>0,0,0,0 W,X,y,z</td>
<td>ARRAY[0..3] OF BYTE</td>
<td>0,0,0,0</td>
</tr>
<tr>
<td>Master IP for Write restriction ²)</td>
<td>No master IP Master IP</td>
<td>0,0,0,0 W,X,y,z</td>
<td>ARRAY[0..3] OF BYTE</td>
<td>0,0,0,0</td>
</tr>
<tr>
<td>Master IP for Write restriction ²)</td>
<td>No master IP Master IP</td>
<td>0,0,0,0 W,X,y,z</td>
<td>ARRAY[0..3] OF BYTE</td>
<td>0,0,0,0</td>
</tr>
<tr>
<td>Master IP for Write restriction ²)</td>
<td>No master IP Master IP</td>
<td>0,0,0,0 W,X,y,z</td>
<td>ARRAY[0..3] OF BYTE</td>
<td>0,0,0,0</td>
</tr>
<tr>
<td>Master IP for Write restriction ²)</td>
<td>No master IP Master IP</td>
<td>0,0,0,0 W,X,y,z</td>
<td>ARRAY[0..3] OF BYTE</td>
<td>0,0,0,0</td>
</tr>
<tr>
<td>Master IP for Write restriction ²)</td>
<td>No master IP Master IP</td>
<td>0,0,0,0 W,X,y,z</td>
<td>ARRAY[0..3] OF BYTE</td>
<td>0,0,0,0</td>
</tr>
</tbody>
</table>

¹) Internal ²) Parameter length ³) Error LED / Fail-safe function on page 1091 ⁴) Master IP for Write restriction
### Table 239: Error LED / Failsafe function

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Error LED (S-ERR) lights up at errors of all error classes, Failsafe-mode off</td>
</tr>
<tr>
<td>Off by E4</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1, E2 and E3, Failsafe-mode off</td>
</tr>
<tr>
<td>Off by E3</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1 and E2, Failsafe-mode off</td>
</tr>
<tr>
<td>On +Failsafe</td>
<td>Error LED (S-ERR) lights up at errors of all error classes, Failsafe-mode on *)</td>
</tr>
<tr>
<td>Off by E4 + Failsafe</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1, E2 and E3, Failsafe-mode on *)</td>
</tr>
</tbody>
</table>

1) With a faulty ID, the Modules reports a "parameter error" and does not perform cyclic process data transmission.

2) Counter operating modes ⇣ Chapter 6.8.2.12 "Fast counters in AC500 devices" on page 4536.

3) Fixed Mapping means each module has its own Modbus registers for data transfer independent of the IO bus constellation ⇣ Chapter 6.8.4.1.2 “Modbus TCP registers" on page 4570.

Dynamic mapping means the structure of the IO Date is dependent on the I/O bus constellation. Each I/O bus expansion module starts directly after the module before on the next Word address.

4) If none of the parameters is set all masters / clients in the network have read and write rights on the CI52x-MODTCP device and its connected expansion modules.

If at least one parameter is set only the configured masters / clients have write rights on the CI52x-MODTCP device, all other masters / clients still have read access to the CI52x-MODTCP device.
### Setting Description

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off by E3 + Failsafe</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1 and E2, Failsafe-mode on *)</td>
</tr>
</tbody>
</table>

*) The parameters Behaviour AO at comm. error and Behaviour DO at comm. error are only analyzed if the Failsafe-mode is ON.

### Group parameters for the analog part

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog data format</td>
<td>Standard Reserved</td>
<td>0 255</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>Behaviour AO at comm. error *)</td>
<td>Off Last value Last value 5 s Last value 10 s Substitute value Substitute value 5 s Substitute value 10 s</td>
<td>0 1 6 11 2 7 12</td>
<td>BYTE</td>
<td>0</td>
</tr>
</tbody>
</table>

*) The parameter Behaviour AO at comm. error is only analyzed if the Failsafe-mode is ON.

### Channel parameters for the analog inputs (4x)

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input 0, Channel configuration</td>
<td>Table Operating modes of the analog inputs Table 240 “Channel configuration” on page 1093</td>
<td>Table Operating modes of the analog inputs Table 240 “Channel configuration” on page 1093</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>Input 0, Check channel</td>
<td>Table Channel monitoring Table 241 “Channel monitoring” on page 1093</td>
<td>Table Channel monitoring Table 241 “Channel monitoring” on page 1093</td>
<td>BYTE</td>
<td>0</td>
</tr>
</tbody>
</table>
### Table 240: Channel configuration

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes of the analog inputs, individually configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (default)</td>
<td>Not used</td>
</tr>
<tr>
<td>1</td>
<td>0 ... 10 V</td>
</tr>
<tr>
<td>2</td>
<td>Digital input</td>
</tr>
<tr>
<td>3</td>
<td>0 ... 20 mA</td>
</tr>
<tr>
<td>4</td>
<td>4 ... 20 mA</td>
</tr>
<tr>
<td>5</td>
<td>-10 V ... +10 V</td>
</tr>
<tr>
<td>8</td>
<td>2-wire Pt100 -50 ... +400 °C</td>
</tr>
<tr>
<td>9</td>
<td>3-wire Pt100 -50 ... +400 °C *)</td>
</tr>
<tr>
<td>10</td>
<td>0 ... 10 V (voltage diff.) *)</td>
</tr>
<tr>
<td>11</td>
<td>-10 V ... +10 V (voltage diff.) *)</td>
</tr>
<tr>
<td>14</td>
<td>2-wire Pt100 -50 ... +70 °C</td>
</tr>
<tr>
<td>15</td>
<td>3-wire Pt100 -50 ... +70 °C *)</td>
</tr>
<tr>
<td>16</td>
<td>2-wire Pt1000 -50 ... +400 °C</td>
</tr>
<tr>
<td>17</td>
<td>3-wire Pt1000 -50 ... +400 °C *)</td>
</tr>
<tr>
<td>18</td>
<td>2-wire Ni1000 -50 ... +150 °C</td>
</tr>
<tr>
<td>19</td>
<td>3-wire Ni1000 -50 ... +150 °C *)</td>
</tr>
</tbody>
</table>

*) In the operating modes with 3-wire configuration or with differential inputs, two adjacent analog inputs belong together (e.g. the channels 0 and 1). In these cases, both channels are configured in the desired operating mode. The lower address must be the even address (channel 0). The next higher address must be the odd address (channel 1). The converted analog value is available at the higher address (channel 1).

### Table 241: Channel monitoring

<table>
<thead>
<tr>
<th>Internal Value</th>
<th>Check Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (default)</td>
<td>Plausibility, wire break, short circuit</td>
</tr>
<tr>
<td>3</td>
<td>Not used</td>
</tr>
</tbody>
</table>
Channel parameters for the analog outputs (2x)

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
</table>
| Output 0, Channel configuration | Table Operating modes of the analog outputs  
\(\uparrow\) Table 242 “Channel configuration” on page 1094 | Table Operating modes of the analog outputs  
\(\uparrow\) Table 242 “Channel configuration” on page 1094 | BYTE                | 0       |
| Output 0, Check channel   | Table Channel monitoring  
\(\uparrow\) Table 243 “Channel monitoring” on page 1094       | Table Channel monitoring  
\(\uparrow\) Table 243 “Channel monitoring” on page 1094                   | BYTE                | 0       |
| Output 0, Substitute value | Table Substitute value  
\(\uparrow\) Table 244 “Substitute value” on page 1095       | Table Substitute value  
\(\uparrow\) Table 244 “Substitute value” on page 1095                   | WORD                | 0       |
| Output 1, Channel configuration | Table Operating modes of the analog outputs  
\(\uparrow\) Table 242 “Channel configuration” on page 1094 | Table Operating modes of the analog outputs  
\(\uparrow\) Table 242 “Channel configuration” on page 1094 | BYTE                | 0       |
| Output 1, Check channel   | Table Channel monitoring  
\(\uparrow\) Table 243 “Channel monitoring” on page 1094       | Table Channel monitoring  
\(\uparrow\) Table 243 “Channel monitoring” on page 1094                   | BYTE                | 0       |
| Output 1, Substitute value | Table Substitute value  
\(\uparrow\) Table 244 “Substitute value” on page 1095       | Table Substitute value  
\(\uparrow\) Table 244 “Substitute value” on page 1095                   | WORD                | 0       |

Table 242: Channel configuration

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes of the analog outputs, individually configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (default)</td>
<td>Not used</td>
</tr>
<tr>
<td>128</td>
<td>-10 V ... +10 V</td>
</tr>
<tr>
<td>129</td>
<td>0 ... 20 mA</td>
</tr>
<tr>
<td>130</td>
<td>4 ... 20 mA</td>
</tr>
</tbody>
</table>

Table 243: Channel monitoring

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Check channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Plausibility, wire break, short circuit</td>
</tr>
<tr>
<td>3</td>
<td>None</td>
</tr>
<tr>
<td>Intended behavior of output channel when the control system stops</td>
<td>Required setting of the module parameter &quot;Behavior of outputs in case of a communication error&quot;</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Output OFF</td>
<td>Off</td>
</tr>
<tr>
<td>Last value infinite</td>
<td>Last value</td>
</tr>
<tr>
<td>Last value for 5 s and then turn off</td>
<td>Last value 5 sec</td>
</tr>
<tr>
<td>Last value for 10 s and then turn off</td>
<td>Last value 10 sec</td>
</tr>
<tr>
<td>Substitute value infinite</td>
<td>Substitute value</td>
</tr>
<tr>
<td>Substitute value for 5 s and then turn off</td>
<td>Substitute value 5 sec</td>
</tr>
<tr>
<td>Substitute value for 10 s and then turn off</td>
<td>Substitute value 10 sec</td>
</tr>
</tbody>
</table>

**Group parameters for the digital part**

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input delay</td>
<td>0.1 ms</td>
<td>0</td>
<td>BYTE</td>
<td>0.1 ms 0x00</td>
</tr>
<tr>
<td></td>
<td>1 ms</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 ms</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>32 ms</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Detect short circuit at outputs</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>On 0x01</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Behaviour DO at comm. error 1)</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>Off 0x00</td>
</tr>
<tr>
<td></td>
<td>Last value</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Last value 5 sec</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Last value 10 sec</td>
<td>11</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute value</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute value 5 sec</td>
<td>7</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute value 10 sec</td>
<td>12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Substitute value at output</td>
<td>0 ... 255</td>
<td>00h ... FFh</td>
<td>BYTE</td>
<td>0 0x0000</td>
</tr>
<tr>
<td>Detect voltage overflow at outputs 2)</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>On 0x01</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1) The parameters Behaviour DO at comm. error is only analyzed if the Failsafe-mode is ON.
2) The state "externally voltage detected" appears, if the output of a channel DC0 ... DC7 should be switched on while an externally voltage is connected. See Chapter 5.2.6.5.1.4 "Connections" on page 1072. In this case the start up is disabled, as long as the externally voltage is connected. The monitoring of this state and the resulting diagnosis message can be disabled by setting the parameters to "OFF".
Diagnosis

**Table 245: Structure of the diagnosis block**

<table>
<thead>
<tr>
<th>Byte Number</th>
<th>Description</th>
<th>Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Diagnosis Byte, slot number</td>
<td>31 = CI521-MODTCP (e. g. error at integrated 8 DI / 8 DO)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = 1st connected S500 I/O Module</td>
</tr>
<tr>
<td></td>
<td></td>
<td>...</td>
</tr>
<tr>
<td></td>
<td></td>
<td>10 = 10th connected S500 I/O Module</td>
</tr>
<tr>
<td>2</td>
<td>Diagnosis Byte, module number</td>
<td>According to the I/O bus specification passed on by modules to the fieldbus master</td>
</tr>
<tr>
<td>3</td>
<td>Diagnosis Byte, channel</td>
<td>According to the I/O bus specification passed on by modules to the fieldbus master</td>
</tr>
<tr>
<td>4</td>
<td>Diagnosis Byte, error code</td>
<td>According to the I/O bus specification</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bit 7 and bit 6, coded error class</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 = E1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = E2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 = E3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 = E4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bit 0 to bit 5, coded error description</td>
</tr>
<tr>
<td>5</td>
<td>Diagnosis Byte, flags</td>
<td>According to the I/O bus specification</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bit 7: 1 = coming error</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bit 6: 1 = leaving error</td>
</tr>
</tbody>
</table>

In cases of short circuit or overload, the digital outputs are turned off. The modules performs reactivation automatically. Thus an acknowledgement of the errors is not necessary. The error message is stored via the LED.

*For diagnosis firmware version ≥ 3.2.6 is required.*
<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier</th>
<th>AC500-Display</th>
<th>← Display in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Comp</td>
<td>Dev</td>
<td>Mod</td>
<td>Ch</td>
<td>Err</td>
<td>PS501 PLC Browser</td>
<td></td>
</tr>
<tr>
<td>Byte 4 Bit 6 ... 7</td>
<td>-</td>
<td>Byte 1</td>
<td>Byte 2</td>
<td>Byte 3</td>
<td>Byte 4 Bit 0 ... 5</td>
<td>PNIO diagnosis block</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error-Identi-</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>1)</td>
<td>2)</td>
<td>3)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Module errors**

<table>
<thead>
<tr>
<th>Module errors</th>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error-Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 - 31 31 31 19</td>
<td>Checksum error in the I/O module</td>
<td>Replace I/O module</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 - 31 31 31 3</td>
<td>Timeout in the I/O module</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 - 31 31 31 40</td>
<td>Different hard-/firmware versions in the module</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 - 31 31 31 43</td>
<td>Internal error in the module</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 - 31 31 31 36</td>
<td>Internal data exchange failure</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 - 31 31 31 9</td>
<td>Overflow diagnosis buffer</td>
<td>Restart</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 - 31 31 31 26</td>
<td>Parameter error</td>
<td>Check Master</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 - 31 31 31 11</td>
<td>Process voltage UP too low</td>
<td>Check process supply voltage</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 - 31 31 31 45</td>
<td>No process voltage UP</td>
<td>Check process supply voltage</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 - 31/1...10 31 31 17</td>
<td>No communication with I/O module</td>
<td>Replace I/O module</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 - 1...10 31 31 32</td>
<td>Wrong I/O module type on socket</td>
<td>Replace I/O module / Check configuration</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 - 1...10 31 31 31</td>
<td>At least one module does not support failsafe function</td>
<td>Check modules and parameterization</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Class</td>
<td>Device Module</td>
<td>Channel</td>
<td>Error Identifier</td>
<td>Error message</td>
<td>Remedy</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>----------------</td>
<td>---------</td>
<td>------------------</td>
<td>--------------</td>
<td>--------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 -</td>
<td>1...10</td>
<td>31</td>
<td>5 8</td>
<td>I/O module removed from hot swap terminal unit or defective module on hot swap terminal unit 9)</td>
<td>Plug I/O module, replace I/O module</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 -</td>
<td>1...10</td>
<td>31</td>
<td>5 28</td>
<td>Wrong I/O module plugged on hot swap terminal unit 9)</td>
<td>Remove wrong I/O module and plug projected I/O module</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 -</td>
<td>1...10</td>
<td>31</td>
<td>5 42</td>
<td>No communication with I/O module on hot swap terminal unit 9)</td>
<td>Replace I/O module</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 -</td>
<td>1...10</td>
<td>31</td>
<td>5 54</td>
<td>I/O module does not support hot swap 8) 9)</td>
<td>Power off system and replace I/O module</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 -</td>
<td>1...10</td>
<td>31</td>
<td>6 8</td>
<td>Hot swap terminal unit configured but not found</td>
<td>Replace terminal unit by hot swap terminal unit</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 -</td>
<td>1...10</td>
<td>31</td>
<td>6 42</td>
<td>No communication with hot swap terminal unit 9)</td>
<td>Restart, if error persists replace terminal unit</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 -</td>
<td>31</td>
<td>31</td>
<td>46</td>
<td>Voltage feedback on activated digital outputs DO0...DO7 on UP3 4)</td>
<td>Check terminals</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Class</td>
<td>Interface</td>
<td>Device</td>
<td>Module</td>
<td>Channel</td>
<td>Error-Identifer</td>
<td>Error message</td>
<td>Remedy</td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>--------</td>
<td>--------</td>
<td>---------</td>
<td>----------------</td>
<td>---------------</td>
<td>--------</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31/1...10</td>
<td>31</td>
<td>31</td>
<td>34</td>
<td>No response during initialization of the I/O module</td>
<td>Replace I/O module</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>11</td>
<td>Process voltage UP3 too low</td>
<td>Check process supply voltage</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>45</td>
<td>No process voltage UP3</td>
<td>Check process supply voltage</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>10</td>
<td>Voltage overflow on outputs (above UP3 level) 5)</td>
<td>Check terminals/ check process supply voltage</td>
<td></td>
</tr>
</tbody>
</table>

**Channel error digital**

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error-Identifer</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>2</td>
<td>0...7</td>
<td>46</td>
<td>Externally voltage detected at digital output DO0...DO7 6)</td>
<td>Check terminals</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>2</td>
<td>0...7</td>
<td>47</td>
<td>Short circuit at digital output 7)</td>
<td>Check terminals</td>
</tr>
</tbody>
</table>

**Channel error analog**

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error-Identifer</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>1</td>
<td>0..3</td>
<td>48</td>
<td>Analog value overflow or broken wire at an analog input</td>
<td>Check value or check terminals</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>1</td>
<td>0..3</td>
<td>7</td>
<td>Analog value underflow at an analog input</td>
<td>Check value</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>1</td>
<td>0..3</td>
<td>47</td>
<td>Short circuit at an analog input</td>
<td>Check terminals</td>
</tr>
</tbody>
</table>
### Remarks:

1) In AC500 the following interface identifier applies:
   
   "-" = Diagnosis via bus-specific function blocks; 0 ... 4 or 10 = Position of the Communication Module; 14 = I/O bus; 31 = Module itself
   
The identifier is not contained in the CI521-MODTCP diagnosis block.

2) With "Device" the following allocation applies: 31 = Module itself; 1..10 = Expansion module

3) With "Module" the following allocation applies:
   
   31 = Module itself
   
   Module type (1 = AI, 2 = DO, 3 = AO)

4) This message appears, if externally voltages at one or more terminals DO0...DO7 cause that other digital outputs are supplied through that voltage.

   *Chapter 5.2.6.5.1.4 “Connections” on page 1072.* All outputs of the apply digital output groups will be turned off for 5 seconds. The diagnosis message appears for the whole output group.

5) The voltage on digital outputs DO0...DO7 has overrun the process supply voltage UP3.

   *Chapter 5.2.6.5.1.4 “Connections” on page 1072.* Diagnosis message appears for the whole module.

6) This message appears, if the output of a channel DO0...DO7 should be switched on while an externally voltage is connected. In this case the start up is disabled, as long as the externally voltage is connected. Otherwise this could produce reverse voltage from this output to other digital outputs. This diagnosis message appears per channel.

7) Short circuit: After a detected short circuit, the output is deactivated for 100ms. Then a new start up will be executed. This diagnosis message appears per channel.
State LEDs

The LEDs are located at the front of module. There are 2 different groups:

- The 5 system LEDs (PWR, STA1 ETH, STA2 ETH, S-ERR and I/O-Bus) show the operation state of the module and display possible errors.
- The 27 process LEDs (UP, UP3, inputs, outputs, CH-ERR1 to CH-ERR3) show the process supply voltage and the states of the inputs and outputs and display possible errors.

Table 246: States of the 5 system LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>OFF</th>
<th>ON</th>
<th>Flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR/RUN</td>
<td>Green</td>
<td>Process supply voltage missing</td>
<td>Internal supply voltage OK, module ready for communication with IO Controller</td>
<td>Start-up / preparing communication</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>STA1 ETH</td>
<td>Green</td>
<td>---</td>
<td>Device configured, cyclic data exchange running</td>
<td>Device configured, acyclic data exchange running</td>
</tr>
<tr>
<td>(System LED &quot;BF&quot;)</td>
<td></td>
<td></td>
<td></td>
<td>IP address error</td>
</tr>
<tr>
<td></td>
<td>Red</td>
<td>---</td>
<td>Communication error (timeout) appeared</td>
<td></td>
</tr>
<tr>
<td>STA2 ETH</td>
<td>Green</td>
<td>Device has valid parameters</td>
<td>Device is running parameterization sequenze</td>
<td>Device has no parameters</td>
</tr>
<tr>
<td>(System LED &quot;SF&quot;)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Red</td>
<td>---</td>
<td>---</td>
<td>Device has invalid parameters</td>
</tr>
<tr>
<td>S-ERR</td>
<td>Red</td>
<td>No error</td>
<td>Internal error</td>
<td>--</td>
</tr>
<tr>
<td>I/O-Bus</td>
<td>Green</td>
<td>No expansion modules connected or communication error</td>
<td>Expansion modules connected and operational</td>
<td>--</td>
</tr>
<tr>
<td>ETH1</td>
<td>Green</td>
<td>No connection at Ethernet interface</td>
<td>Connected to Ethernet interface</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>---</td>
<td>Device is transmitting telegrams</td>
<td>Device is transmitting telegrams</td>
</tr>
<tr>
<td>ETH2</td>
<td>Green</td>
<td>No connection at Ethernet interface</td>
<td>Connected to Ethernet interface</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>---</td>
<td>Device is transmitting telegrams</td>
<td>Device is transmitting telegrams</td>
</tr>
</tbody>
</table>
## Table 247: States of the 27 process LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>OFF</th>
<th>ON</th>
<th>Flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>AI0 ... AI3</td>
<td>Yellow</td>
<td>Input is OFF</td>
<td>Input is ON (brightness depends on the value of the analog signal)</td>
<td>--</td>
</tr>
<tr>
<td>AO0 ... AO1</td>
<td>Yellow</td>
<td>Output is OFF</td>
<td>Output is ON (brightness depends on the value of the analog signal)</td>
<td>--</td>
</tr>
<tr>
<td>DI0 ... DI7</td>
<td>Yellow</td>
<td>Input is OFF</td>
<td>Input is ON (the input voltage is even displayed if the supply voltage is OFF)</td>
<td>--</td>
</tr>
<tr>
<td>DO0 ... DO7</td>
<td>Yellow</td>
<td>Output is OFF</td>
<td>Output is ON</td>
<td>--</td>
</tr>
<tr>
<td>UP</td>
<td>Green</td>
<td>Process supply voltage missing</td>
<td>Process supply voltage OK and initialization finished</td>
<td>--</td>
</tr>
<tr>
<td>UP3</td>
<td>Green</td>
<td>Process supply voltage missing</td>
<td>Process supply voltage OK</td>
<td>--</td>
</tr>
<tr>
<td>CH-ERR1 to CH-ERR3</td>
<td>Red</td>
<td>No error or process supply voltage missing</td>
<td>Internal error</td>
<td>Error on one channel of the corresponding group</td>
</tr>
</tbody>
</table>

### Measuring ranges

**Input ranges voltage, current and digital input**

<table>
<thead>
<tr>
<th>Range</th>
<th>0 V ... +10 V</th>
<th>-10 V ... +10 V</th>
<th>0 mA ... 20 mA</th>
<th>4 mA ... 20 mA</th>
<th>Digital input</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Decimal</td>
<td>Hex.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overflow</td>
<td>&gt; 11.7589</td>
<td>&gt; 11.7589</td>
<td>&gt; 23.5178</td>
<td>&gt; 22.8142</td>
<td>32767</td>
<td>7FFF</td>
</tr>
<tr>
<td>Normal range</td>
<td>10.0000 : 0.0004</td>
<td>10.0000 : 0.0004</td>
<td>20.0000 : 4.0006</td>
<td>20.0000 : On</td>
<td>27648 : 6C00</td>
<td>1 : 0001</td>
</tr>
<tr>
<td>Normal range or measured value too low</td>
<td>0.0000 : 0.0000</td>
<td>0 : 4</td>
<td>Off</td>
<td>0 : 0000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-0.0004 : -1.7593</td>
<td>-0.0004 : -10.0000</td>
<td>3.9994 : 1.1858</td>
<td>-1 : -4864</td>
<td>-27648 : 9400</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Range of Voltage

<table>
<thead>
<tr>
<th>Range</th>
<th>0 V ... +10 V</th>
<th>-10 V ... +10 V</th>
<th>0 mA ... 20 mA</th>
<th>4 mA ... 20 mA</th>
<th>Digital input</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measured value too low</td>
<td>-10.0004 : -11.7589</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-27649 : 93FF</td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt; 1.7593</td>
<td>&lt; -11.7589</td>
<td>&lt; 0.0000</td>
<td>&lt; 1.1858</td>
<td>-32768</td>
<td>8000</td>
</tr>
</tbody>
</table>

The represented resolution corresponds to 16 bits.

### Input Ranges Resistance Temperature Detector

<table>
<thead>
<tr>
<th>Range</th>
<th>Pt100 / Pt1000</th>
<th>Pt100 / Pt1000</th>
<th>Ni1000</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>-50 °C ... +70 °C</td>
<td>-50 °C ... +400 °C</td>
<td>-50 °C ... +150 °C</td>
<td>°C</td>
</tr>
<tr>
<td></td>
<td>Decimal</td>
<td>Hex.</td>
<td>Decimal</td>
<td>Hex.</td>
</tr>
<tr>
<td>Overflow</td>
<td>&gt; +80.0 °C</td>
<td>&gt; +450.0 °C</td>
<td>&gt; +160.0 °C</td>
<td>32767</td>
</tr>
<tr>
<td>Measured value too high</td>
<td>+450.0 °C : +400.1 °C</td>
<td>4500 : 4001</td>
<td>1194 : 0FA1</td>
<td>+160.0 °C : +150.1 °C</td>
</tr>
<tr>
<td>Normal range</td>
<td>+70.0 °C : +0.1 °C</td>
<td>+400.0 °C : +0.1 °C</td>
<td>+150.0 °C : + 0.1 °C</td>
<td>4000 : 1500 : 1</td>
</tr>
<tr>
<td>Normal range</td>
<td>0.0 °C : 0.0 °C</td>
<td>0.0 °C</td>
<td>0.0 °C</td>
<td>0</td>
</tr>
<tr>
<td>Normal range</td>
<td>-0.1 °C : -50.0 °C</td>
<td>-0.1 °C : -50.0 °C</td>
<td>-0.1 °C : -50.0 °C</td>
<td>-1 : -500</td>
</tr>
<tr>
<td>Measured value too low</td>
<td>-50.1 °C : -60.0 °C</td>
<td>-50.1 °C : -60.0 °C</td>
<td>-50.1 °C : -60.0 °C</td>
<td>-501 : -600</td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt; -60.0 °C</td>
<td>&lt; -60.0 °C</td>
<td>&lt; -60.0 °C</td>
<td>-32768</td>
</tr>
</tbody>
</table>
Output ranges voltage and current

<table>
<thead>
<tr>
<th>Range</th>
<th>-10 V ... +10 V</th>
<th>0 mA ... 20 mA</th>
<th>4 mA ... 20 mA</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overflow</td>
<td>0 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>&gt; 32511</td>
</tr>
<tr>
<td>Measured value too high</td>
<td>11.7589 V</td>
<td>23.5178 mA</td>
<td>22.8142 mA</td>
<td>32511</td>
</tr>
<tr>
<td></td>
<td>10.0004 V</td>
<td>20.0007 mA</td>
<td>20.0006 mA</td>
<td>27649</td>
</tr>
<tr>
<td>Normal range</td>
<td>10.0000 V</td>
<td>20.0000 mA</td>
<td>20.0000 mA</td>
<td>27648</td>
</tr>
<tr>
<td></td>
<td>0.0004 V</td>
<td>0.0007 mA</td>
<td>4.0006 mA</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>0.0000 V</td>
<td>0.0000 mA</td>
<td>4.0000 mA</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>-0.0004 V</td>
<td>0 mA</td>
<td>3.9994 mA</td>
<td>-1</td>
</tr>
<tr>
<td></td>
<td>-10.0000 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>-6912</td>
</tr>
<tr>
<td>Measured value too low</td>
<td>-10.0004 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>-27649</td>
</tr>
<tr>
<td></td>
<td>-11.7589 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>-32512</td>
</tr>
<tr>
<td>Underflow</td>
<td>0 V</td>
<td>0 mA</td>
<td>0 mA</td>
<td>&lt; -32512</td>
</tr>
</tbody>
</table>

The represented resolution corresponds to 16 bits.

Technical data

Technical data of the module

The system data of AC500 and S500 are applicable to the standard version “System data AC500” on page 166.

The system data of AC500-XC are applicable to the XC version “System data AC500-XC” on page 169.

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltages UP/UP3</td>
<td></td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC (for inputs and outputs)</td>
</tr>
<tr>
<td>Max. load for the terminals</td>
<td>10 A</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse on UP/UP3</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Ethernet interface against the rest of the module</td>
</tr>
<tr>
<td>Inrush current from UP (at power up)</td>
<td>On request</td>
</tr>
<tr>
<td>Current consumption via UP (normal operation)</td>
<td>0.2 A</td>
</tr>
<tr>
<td>Current consumption via UP3</td>
<td>0.06 A + 0.5 A max. per output</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Connections</td>
<td>Terminals 1.8 and 2.8 for +24 V (UP)</td>
</tr>
<tr>
<td></td>
<td>Terminal 3.8 for +24 V (UP3)</td>
</tr>
<tr>
<td></td>
<td>Terminals 1.9, 2.9 and 3.9 for 0 V (ZP)</td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>6 W</td>
</tr>
<tr>
<td>Number of digital inputs</td>
<td>8</td>
</tr>
<tr>
<td>Number of digital outputs</td>
<td>8</td>
</tr>
<tr>
<td>Number of analog inputs</td>
<td>4</td>
</tr>
<tr>
<td>Number of analog outputs</td>
<td>2</td>
</tr>
<tr>
<td>Reference potential for all digital inputs and outputs</td>
<td>Negative pole of the supply voltage, signal name ZP</td>
</tr>
<tr>
<td>Ethernet</td>
<td>10/100 base-TX, internal switch, 2 x RJ45 socket</td>
</tr>
<tr>
<td>Setting of the IP address</td>
<td>With ABB IP config tool and 2 rotary switches at the front side of the module</td>
</tr>
<tr>
<td>Diagnose</td>
<td>See Diagnosis and Displays % Chapter 5.2.6.5.1.9 &quot;Diagnosis&quot; on page 1096</td>
</tr>
<tr>
<td>Operation and error displays</td>
<td>32 LEDs (totally)</td>
</tr>
<tr>
<td>Weight (without terminal unit)</td>
<td>Ca. 125 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical with derating (output load reduced to 50 % at +40 °C per group)</td>
</tr>
<tr>
<td>Extended ambient temperature (XC version)</td>
<td>&gt; +60 °C on request</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>

**NOTICE!**

All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

### Technical data of the digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels DI0 ... DI7</td>
<td>Terminals 2.0 ... 2.7</td>
</tr>
<tr>
<td>Reference potential for all inputs</td>
<td>Terminals 1.9 ... 3.9 (negative pole of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel, the LED is ON when the input signal is high (signal 1)</td>
</tr>
<tr>
<td>Input type (according EN 61131-2)</td>
<td>Type 1</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 0.1 ms, configurable from 0.1...32 ms</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>0-Signal</td>
<td>-3 V ... +5 V</td>
</tr>
</tbody>
</table>
### Technical data of the digital outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels DO0 ... DO7</td>
<td>Terminals 3.0 ... 3.7</td>
</tr>
<tr>
<td>Reference potential for all outputs</td>
<td>Terminals 1.9 ... 3.9 (negative pole of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>For all outputs terminal 3.8 (positive pole of the supply voltage, signal name UP3)</td>
</tr>
<tr>
<td>Output voltage for signal 1</td>
<td>UP3 (-0.8 V)</td>
</tr>
<tr>
<td>Output delay (0-&gt;1 or 1-&gt;0)</td>
<td>On request</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated value per channel</td>
<td>500 mA at UP3 = 24 V</td>
</tr>
<tr>
<td>Max. value (all channels together)</td>
<td>4 A</td>
</tr>
<tr>
<td>Leakage current with signal 0</td>
<td>&lt; 0.5 mA</td>
</tr>
<tr>
<td>Fuse for UP3</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Demagnetization with inductive DC load</td>
<td>Via internal varistors (see figure below this table)</td>
</tr>
<tr>
<td>Output switching frequency</td>
<td></td>
</tr>
<tr>
<td>With resistive load</td>
<td>On request</td>
</tr>
<tr>
<td>With inductive loads</td>
<td>Max. 0.5 Hz</td>
</tr>
<tr>
<td>With lamp loads</td>
<td>11 Hz max. at 5 W max.</td>
</tr>
<tr>
<td>Short-circuit-proof / overload-proof</td>
<td>Yes</td>
</tr>
<tr>
<td>Overload message (I &gt; 0.7 A)</td>
<td>Yes, after ca. 100 ms</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>Yes, automatic reactivation after short-circuit/overload</td>
</tr>
<tr>
<td>Resistance to feedback against 24 V signals</td>
<td>Yes (software-controlled supervision)</td>
</tr>
</tbody>
</table>
The following drawing shows the circuitry of a digital input/output with the varistors for demagnetization when inductive loads are switched off.

![Circuit Diagram]

**Fig. 219: Digital input/output (circuit diagram)**

1. Digital Output
2. Varistors for demagnetization when inductive loads are turned off

### Technical data of the analog inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>4</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group with 4 channels</td>
</tr>
<tr>
<td>Connection if channels AI0+ ... AI3+</td>
<td>Terminals 1.0 ... 1.3</td>
</tr>
<tr>
<td>Reference potential for AI0+ ... AI3+</td>
<td>Terminal 1.4 (AI-) for voltage and RTD measurement</td>
</tr>
<tr>
<td></td>
<td>Terminal 1.9, 2.9 and 3.9 for current measurement</td>
</tr>
<tr>
<td>Input type</td>
<td></td>
</tr>
<tr>
<td>Unipolar</td>
<td>Voltage 0 V ... 10 V, current or Pt100/Pt1000/ Ni1000</td>
</tr>
<tr>
<td>Bipolar</td>
<td>Voltage -10 V ... +10 V</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Against Ethernet network</td>
</tr>
<tr>
<td>Configurability</td>
<td>0 V ... 10 V, -10 V ... +10 V, 0/4 mA ... 20 mA, Pt100/1000, Ni1000 (each input can be configured individually)</td>
</tr>
<tr>
<td>Channel input resistance</td>
<td>Voltage: &gt; 100 kΩ</td>
</tr>
<tr>
<td></td>
<td>Current: ca. 330 Ω</td>
</tr>
<tr>
<td>Time constant of the input filter</td>
<td>Voltage: 100 μs</td>
</tr>
<tr>
<td></td>
<td>Current: 100 μs</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 LED per channel (brightness depends on the value of the analog signal)</td>
</tr>
<tr>
<td>Conversion cycle</td>
<td>1 ms (for 4 inputs + 2 outputs); with RTDs Pt/Ni ... 1 s</td>
</tr>
</tbody>
</table>
### Technical data of the analog inputs if used as digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>Max. 4</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group of 4 channels</td>
</tr>
<tr>
<td>Connections of the channels AI0+ ... AI3+</td>
<td>Terminals 1.0 ... 1.3</td>
</tr>
<tr>
<td>Reference potential for the inputs</td>
<td>Terminals 1.9, 2.9 and 3.9 (ZP)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 LED per channel</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-30 V ... +5 V</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>+5 V ... +13 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>+13 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 7 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>Typ. 1.4 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>Typ. 3.7 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 9 mA</td>
</tr>
<tr>
<td>Input resistance</td>
<td>Ca. 3.5 kΩ</td>
</tr>
</tbody>
</table>

### Technical data of the analog outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>2</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group for 2 channels</td>
</tr>
<tr>
<td>Connection of the channels AO0+ ... AO1+</td>
<td>Terminals 1.5 ... 1.6</td>
</tr>
<tr>
<td>Reference potential for AO0+ ... AO1+</td>
<td>Terminal 1.7 (AO-) for voltage outputTerminal 1.9, 2.9 and 3.9 for current output</td>
</tr>
</tbody>
</table>
### Parameter Value

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output type</td>
<td></td>
</tr>
<tr>
<td>Unipolar</td>
<td>Current</td>
</tr>
<tr>
<td>Bipolar</td>
<td>Voltage</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Against internal supply and other modules</td>
</tr>
<tr>
<td>Configurability</td>
<td>-10 V ... +10 V, 0 mA ... 20 mA, 4 mA ... 20 mA (each output can be configured individually)</td>
</tr>
<tr>
<td>Output resistance (load), as current output</td>
<td>0 Ω ... 500 Ω</td>
</tr>
<tr>
<td>Output loadability, as voltage output</td>
<td>± 10 mA max.</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>1 LED per channel (brightness depends on the value of the analog signal)</td>
</tr>
<tr>
<td>Resolution</td>
<td>12 bits including sign</td>
</tr>
<tr>
<td>Settling time for full range change (resistive load, output signal within specified tolerance)</td>
<td>Typ. 5 ms</td>
</tr>
<tr>
<td>Conversion error of the analog values caused by non-linearity, adjustment error at factory and resolution within the normal range</td>
<td>Typ. 0.5 %, max. 1 %</td>
</tr>
<tr>
<td>Relationship between input signal and hex code</td>
<td>Table Output ranges voltage and current “Output ranges voltage and current” on page 1104</td>
</tr>
<tr>
<td>Unused outputs</td>
<td>Are configured as &quot;unused&quot; (default value) and can be left open-circuited</td>
</tr>
</tbody>
</table>

#### Technical data of the fast counter

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Used inputs</td>
<td>Terminal 2.0 (DI0), 2.1 (DI1)</td>
</tr>
<tr>
<td>Used outputs</td>
<td>Terminal 3.0 (DO0)</td>
</tr>
<tr>
<td>Counting frequency</td>
<td>Depending on operation mode:</td>
</tr>
<tr>
<td></td>
<td>Mode 1 - 6: max. 200 kHz</td>
</tr>
<tr>
<td></td>
<td>Mode 7: max. 50 kHz</td>
</tr>
<tr>
<td></td>
<td>Mode 9: max. 35 kHz</td>
</tr>
<tr>
<td></td>
<td>Mode 10: max. 20 kHz</td>
</tr>
</tbody>
</table>

*Chapter 6.8.2.12 “Fast counters in AC500 devices” on page 4536*
**Dimensions**

![Dimensions Diagram]

The dimensions are in **mm** and in brackets in **inch**.

**Ordering data**

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 222 100 R0001</td>
<td>CI521-MODTCP, Modbus TCP communication interface module, 4 AI, 2 AO, 8 DI and 8 DO</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 422 100 R0001</td>
<td>CI521-MODTCP-XC, Modbus TCP communication interface module, 4 AI, 2 AO, 8 DI and 8 DO, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
5.2.6.5.2 CI522-MODTCP

Features

- 8 digital inputs 24 V DC
- 8 digital outputs 24 V DC, 0.5 A max.
- 8 configurable digital inputs/outputs 24 V DC, 0.5 A max.
- Module-wise galvanically isolated
- Fast counter
- XC version for usage in extreme ambient conditions available

Hardware descriptions
Device specifications > Communication interface modules
10 2 rotary switches for setting the IP address
11 Ethernet interfaces (ETH1, ETH2) on the terminal unit
12 Terminal unit
13 DIN rail
\*: Sign for XC version

### Intended purpose

Modbus TCP communication interface module CJ522-MODTCP is used as decentralized I/O module in Modbus TCP networks. The network connection is performed via 2 RJ45 connectors which are integrated in the terminal unit. The communication interface module contains 24 I/O channels with the following properties:

- 8 digital configurable inputs/outputs in 1 group (1.0 ... 1.7)
- 8 digital inputs 24 V DC in 1 group (2.0 ... 2.7)
- 8 digital outputs 24 V DC in 1 group (3.0 ... 3.7)

The inputs/outputs are galvanically isolated from the Ethernet network. There is no potential separation between the channels. The configuration of the configurable digital inputs/outputs is performed by software.

For usage in extreme ambient conditions (e.g. wider temperature and humidity range), a special XC version of the device is available.

### Functionality

<table>
<thead>
<tr>
<th>Interface</th>
<th>Ethernet</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol</td>
<td>Modbus TCP</td>
</tr>
<tr>
<td>Power supply</td>
<td>From the process supply voltage UP</td>
</tr>
<tr>
<td>Supply of the electronic circuitry of the I/O expansion modules attached</td>
<td>Through the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>Rotary switches</td>
<td>for setting the last BYTE of the IP ADDRESS (00h ... FFh)</td>
</tr>
<tr>
<td>Configurable digital inputs/outputs</td>
<td>8 (configurable via software)</td>
</tr>
<tr>
<td>Digital inputs</td>
<td>8 (24 V DC; delay time configurable via software)</td>
</tr>
<tr>
<td>Digital outputs</td>
<td>8 (24 V DC, 0.5 A max.)</td>
</tr>
<tr>
<td>LED displays</td>
<td>For system displays, signal states, errors and power supply</td>
</tr>
<tr>
<td>External supply voltage</td>
<td>Via terminals ZP, UP and UP3 (process supply voltage 24 V DC)</td>
</tr>
<tr>
<td>Required terminal unit</td>
<td>TU507 or TU508 * Chapter 5.2.7.2 “TU507-ETH and TU508-ETH for Ethernet communication interface modules” on page 1270</td>
</tr>
</tbody>
</table>
Connections

General

The Ethernet communication interface module CI522-MODTCP is plugged on the I/O terminal unit TU507-ETH. Chapter 5.2.7.2 “TU507-ETH and TU508-ETH for Ethernet communication interface modules” on page 1270 or TU508-ETH. Chapter 5.2.7.2 “TU507-ETH and TU508-ETH for Ethernet communication interface modules” on page 1270. Properly seat the module and press until it locks in place. The terminal unit is mounted on a DIN rail or with 2 screws plus the additional accessory for wall mounting. Chapter 5.2.8.2.5 “TA526 - Wall mounting accessory” on page 1324.

The connection of the I/O channels is carried out using the 30 terminals of the I/O terminal unit. I/O modules can be replaced without re-wiring the terminal units.

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The terminals 1.8 and 2.8 as well as 1.9, 2.9 and 3.9 are electrically interconnected within the terminal unit and have always the same assignment, independent of the inserted module:

Terminals 1.8 and 2.8: Process supply voltage UP = +24 V DC
Terminal 3.8: Process supply voltage UP3 = +24 V DC
Terminals 1.9, 2.9 and 3.9: Process supply voltage ZP = 0 V

With a separate UP3 power supply, the digital outputs can be switched off externally. This way, an emergency-off functionality can be realized.

Conditions for undisturbed operating with older I/O expansion modules

All I/O expansion modules that are attached to the CI52x-MODTCP must be powered up together with the CI52x-MODTCP if the firmware version of these I/O expansion modules is V1.9 or lower.

The firmware version is related to the index. The index is printed on the module type label on the right side.

Modules as of index listed in the following table can be powered up independently.

<table>
<thead>
<tr>
<th>S500 I/O module type</th>
<th>First index with firmware version above 1.9</th>
</tr>
</thead>
<tbody>
<tr>
<td>AI523</td>
<td>D0</td>
</tr>
<tr>
<td>AI523-XC</td>
<td>D0</td>
</tr>
<tr>
<td>AI531</td>
<td>A3</td>
</tr>
<tr>
<td>AI531-XC</td>
<td>A0</td>
</tr>
<tr>
<td>AO523</td>
<td>D0</td>
</tr>
<tr>
<td>AO523-XC</td>
<td>D0</td>
</tr>
<tr>
<td>AX521</td>
<td>D0</td>
</tr>
<tr>
<td>AX521-XC</td>
<td>D0</td>
</tr>
<tr>
<td>AX522</td>
<td>D0</td>
</tr>
<tr>
<td>AX522-XC</td>
<td>D0</td>
</tr>
<tr>
<td>CD522</td>
<td>A2</td>
</tr>
</tbody>
</table>
Do not connect any voltages externally to digital outputs!

This ist not intended usage.

Reason: Externally voltages at one or more terminals DC0 ... DC7 or DO8 ... DO15 may cause that other digital outputs are supplied through that voltage instead of voltage UP3 (reverse voltage).

This is also possible, if DC channels are used as inputs. For this, the source for the input signals should be the impressed UP3 of the device.

This limitation does not apply for the input channels DI0 ... DI7.

CAUTION!
Risk of malfunction by unintended usage!

If the function cut-off of the digital outputs is to be used by deactivation of the supply voltage UP3, be sure that no external voltage is connected at the outputs DO8 ... DO15 and DC0 ... DC7.

The assignment of the other terminals:

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>DC0</td>
<td>Signal of the configurable digital input/output DC0</td>
</tr>
<tr>
<td>1.1</td>
<td>DC1</td>
<td>Signal of the configurable digital input/output DC1</td>
</tr>
<tr>
<td>Terminal</td>
<td>Signal</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>1.2</td>
<td>DC2</td>
<td>Signal of the configurable digital input/output DC2</td>
</tr>
<tr>
<td>1.3</td>
<td>DC3</td>
<td>Signal of the configurable digital input/output DC3</td>
</tr>
<tr>
<td>1.4</td>
<td>DC4</td>
<td>Signal of the configurable digital input/output DC4</td>
</tr>
<tr>
<td>1.5</td>
<td>DC5</td>
<td>Signal of the configurable digital input/output DC5</td>
</tr>
<tr>
<td>1.6</td>
<td>DC6</td>
<td>Signal of the configurable digital input/output DC6</td>
</tr>
<tr>
<td>1.7</td>
<td>DC7</td>
<td>Signal of the configurable digital input/output DC7</td>
</tr>
<tr>
<td>1.8</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>1.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
<tr>
<td>2.0</td>
<td>DI8</td>
<td>Signal of the digital input DI8</td>
</tr>
<tr>
<td>2.1</td>
<td>DI9</td>
<td>Signal of the digital input DI9</td>
</tr>
<tr>
<td>2.2</td>
<td>DI10</td>
<td>Signal of the digital input DI10</td>
</tr>
<tr>
<td>2.3</td>
<td>DI11</td>
<td>Signal of the digital input DI11</td>
</tr>
<tr>
<td>2.4</td>
<td>DI12</td>
<td>Signal of the digital input DI12</td>
</tr>
<tr>
<td>2.5</td>
<td>DI13</td>
<td>Signal of the digital input DI13</td>
</tr>
<tr>
<td>2.6</td>
<td>DI14</td>
<td>Signal of the digital input DI14</td>
</tr>
<tr>
<td>2.7</td>
<td>DI15</td>
<td>Signal of the digital input DI15</td>
</tr>
<tr>
<td>2.8</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>2.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
<tr>
<td>3.0</td>
<td>DO8</td>
<td>Signal of the digital output DO8</td>
</tr>
<tr>
<td>3.1</td>
<td>DO9</td>
<td>Signal of the digital output DO9</td>
</tr>
<tr>
<td>3.2</td>
<td>DO10</td>
<td>Signal of the digital output DO10</td>
</tr>
<tr>
<td>3.3</td>
<td>DO11</td>
<td>Signal of the digital output DO11</td>
</tr>
<tr>
<td>3.4</td>
<td>DO12</td>
<td>Signal of the digital output DO12</td>
</tr>
<tr>
<td>3.5</td>
<td>DO13</td>
<td>Signal of the digital output DO13</td>
</tr>
<tr>
<td>3.6</td>
<td>DO14</td>
<td>Signal of the digital output DO14</td>
</tr>
<tr>
<td>3.7</td>
<td>DO15</td>
<td>Signal of the digital output DO15</td>
</tr>
<tr>
<td>3.8</td>
<td>UP3</td>
<td>Process voltage UP3 (24 V DC)</td>
</tr>
<tr>
<td>3.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
</tbody>
</table>
WARNING!
Removal/Insertion under power
The devices are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you
- connect or disconnect any signal or terminal block
- remove, mount or replace a module.

Disconnecting any powered devices while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The devices must not be opened when in operation. The same applies to the network interfaces.

NOTICE!
Risk of damaging the PLC modules!
Overvoltages and short circuits might damage the PLC modules.

- Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
- Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

Fig. 220: Connection of the communication interface module CI522-MODTCP
☞ Chapter 6.8.4.1 "Modbus communication interface module" on page 4568
Connection of the digital inputs

Fig. 221: Connection of the digital inputs (DI8 ... DI15) to the module CI522-MODTCP
The meaning of the LEDs is described in Displays § Chapter 5.2.6.5.2.10 “State LEDs” on page 1128.
Connection of the digital outputs

![Diagram of digital output connection]

*Fig. 222: Connection of the digital output DO8. Proceed with the digital outputs DO9 … DO15 in the same way.*

The meaning of the LEDs is described in Displays Chapter 5.2.6.5.2.10 “State LEDs” on page 1128.

Connection of the configurable digital inputs/outputs

The following figure shows the connection of the configurable digital input/output DC0 and DC1. DC0 is connected as an input and DC1 is connected as an output. Proceed with the configurable digital inputs/outputs DC2 … DC7 in the same way.

**CAUTION!**

If a DC channel is used as input, the source for the input signals should be the impressed UP3 of the device Chapter 5.2.6.5.2.4 “Connections” on page 1113.
The meaning of the LEDs is described in Displays § Chapter 5.2.5.2.10 “State LEDs” on page 1128.

Assignment of the Ethernet ports

The terminal unit for the communication interface module provides two Ethernet interfaces with the following pin assignment:

<table>
<thead>
<tr>
<th>Pin assignment</th>
<th>Interface</th>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Ethernet</td>
<td>1</td>
<td>TxD+</td>
<td>Transmit data +</td>
</tr>
<tr>
<td></td>
<td>RJ45</td>
<td>2</td>
<td>TxD-</td>
<td>Transmit data -</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3</td>
<td>RxD+</td>
<td>Receive data +</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6</td>
<td>RxD-</td>
<td>Receive data -</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td></td>
<td>8</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Shield</td>
<td>Cable shield</td>
<td>Functional earth</td>
</tr>
</tbody>
</table>

In corrosive environment, please protect unused connectors using the TA535 accessory.

Not supplied with this device.

❖ Further information about wiring and cable types
Internal data exchange

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital inputs (bytes)</td>
<td>5</td>
</tr>
<tr>
<td>Digital outputs (bytes)</td>
<td>5</td>
</tr>
<tr>
<td>Counter input data (words)</td>
<td>4</td>
</tr>
<tr>
<td>Counter output data (words)</td>
<td>8</td>
</tr>
</tbody>
</table>

Replacement of a Modbus TCP communication interface module:

The module must be powered off before it is replaced. If the configuration data is stored in the module, then the configuration data must be downloaded into the new module, either by using Modbus communication or by using the Modbus configurator which is contained in the Automation Builder distribution.

* Chapter 6.3.2.12.2 “Unbundled CI52x-MODTCP configuration” on page 1565

Addressing

The IP address of the CI5221-MODTCP Module can be set with the “ABB IP Configuration Tool” * Chapter 6.3.2.2.4.3 “Configuration of the IP settings with the IP configuration tool” on page 1457.

If the last byte of the IP is set to 0, the address switch will be used instead.

Address switch position 255 is mapped to fixed IP 192.168.0.254 independent of other stored settings. This is a backup so the module can always get a valid IP address and can be configured by the “ABB IP Configuration Tool”.

Address switch position 0 is mapped to last byte equal 1 and DHCP enabled.

The factory setting for the IP is 192.168.0.x (last byte is address switch).

The module reads the position of the rotary switches only during power-up, i.e. changes of the switch position during operation will have no effect until the next module initialization.

I/O configuration

The CI522-MODTCP stores configuration parameters (IP address configuration, module parameters).

The digital I/O channels are configured via software.

Details about configuration are described in Parameterization * Chapter 5.2.6.5.2.8 “Parameterization” on page 1120.

Parameterization

Parameters of the module

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID 1)</td>
<td>Internal</td>
<td>7405</td>
<td>WORD</td>
<td>7405</td>
</tr>
<tr>
<td>Ignore Module</td>
<td>Internal</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal</td>
<td>47</td>
<td>BYTE</td>
<td>47</td>
</tr>
<tr>
<td>Name</td>
<td>Value</td>
<td>Internal value</td>
<td>Internal value, type</td>
<td>Default</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>----------------</td>
<td>----------------</td>
<td>----------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Error LED / Fail-safe function (Table Error LED / Failsafe function</td>
<td>On</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>§ Table 248 &quot;Table Error LED / Failsafe function&quot; on page 1122)</td>
<td>Off by E4</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off by E3</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>On + failsafe</td>
<td>16</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off by E4 + fail-safe</td>
<td>17</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off by E3 + failsafe</td>
<td>19</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master IP for Write restriction 4)</td>
<td>No master IP</td>
<td>0,0,0,0 W,X,y,z</td>
<td>ARRAY[0..3] OF BYTE</td>
<td>0,0,0</td>
</tr>
<tr>
<td>Master IP for Write restriction 4)</td>
<td>Master IP</td>
<td>0,0,0,0 W,X,y,z</td>
<td>ARRAY[0..3] OF BYTE</td>
<td>0,0,0</td>
</tr>
<tr>
<td>Master IP for Write restriction 4)</td>
<td>No master IP</td>
<td>0,0,0,0 W,X,y,z</td>
<td>ARRAY[0..3] OF BYTE</td>
<td>0,0,0</td>
</tr>
<tr>
<td>Master IP for Write restriction 4)</td>
<td>Master IP</td>
<td>0,0,0,0 W,X,y,z</td>
<td>ARRAY[0..3] OF BYTE</td>
<td>0,0,0</td>
</tr>
<tr>
<td>Master IP for Write restriction 4)</td>
<td>No master IP</td>
<td>0,0,0,0 W,X,y,z</td>
<td>ARRAY[0..3] OF BYTE</td>
<td>0,0,0</td>
</tr>
<tr>
<td>Master IP for Write restriction 4)</td>
<td>Master IP</td>
<td>0,0,0,0 W,X,y,z</td>
<td>ARRAY[0..3] OF BYTE</td>
<td>0,0,0</td>
</tr>
<tr>
<td>Master IP for Write restriction 4)</td>
<td>No master IP</td>
<td>0,0,0,0 W,X,y,z</td>
<td>ARRAY[0..3] OF BYTE</td>
<td>0,0,0</td>
</tr>
<tr>
<td>Master IP for Write restriction 4)</td>
<td>Master IP</td>
<td>0,0,0,0 W,X,y,z</td>
<td>ARRAY[0..3] OF BYTE</td>
<td>0,0,0</td>
</tr>
<tr>
<td>Master IP for Write restriction 4)</td>
<td>No master IP</td>
<td>0,0,0,0 W,X,y,z</td>
<td>ARRAY[0..3] OF BYTE</td>
<td>0,0,0</td>
</tr>
<tr>
<td>Master IP for Write restriction 4)</td>
<td>Master IP</td>
<td>0,0,0,0 W,X,y,z</td>
<td>ARRAY[0..3] OF BYTE</td>
<td>0,0,0</td>
</tr>
<tr>
<td>Master IP for Write restriction 4)</td>
<td>No master IP</td>
<td>0,0,0,0 W,X,y,z</td>
<td>ARRAY[0..3] OF BYTE</td>
<td>0,0,0</td>
</tr>
<tr>
<td>Master IP for Write restriction 4)</td>
<td>Master IP</td>
<td>0,0,0,0 W,X,y,z</td>
<td>ARRAY[0..3] OF BYTE</td>
<td>0,0,0</td>
</tr>
<tr>
<td>Timeout for Bus supervision</td>
<td>No supervision</td>
<td>0,1,2</td>
<td></td>
<td>No supervision</td>
</tr>
<tr>
<td></td>
<td>10 ms timeout</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>20 ms timeout</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IO Mapping Structure 3)</td>
<td>Dynamic Mapping</td>
<td>0,1</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Fixed Mapping</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reserved</td>
<td>Internal</td>
<td>0</td>
<td>ARRAY[0..2] OF BYTE</td>
<td>0,0,0</td>
</tr>
<tr>
<td>Check supply</td>
<td>off</td>
<td>0,1</td>
<td>BYTE</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>on</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast counter</td>
<td>0,10 2)</td>
<td>0,10</td>
<td>BYTE</td>
<td>0</td>
</tr>
</tbody>
</table>

Remarks:
With a faulty ID, the module reports a "parameter error" and does not perform cyclic process data transmission.

Counter operating modes \(\text{\textcopyright Chapter 5.2.4.3.2.9 "Fast counter" on page 606}\) 

Fixed Mapping means each module has its own Modbus registers for data transfer independent of the I/O bus constellation description \(\text{\textcopyright Chapter 6.8.4.1.2 "Modbus TCP registers" on page 4570}\). Dynamic mapping means the structure of the IO Date is dependent on the I/O bus constellation. Each I/O bus expansion module starts directly after the module before on the next Word address.

If none of the parameters is set all masters / clients in the network have read and write rights on the CI52x-MODTCP device and its connected expansion modules.

If at least one parameter is set only the configured masters / clients have write rights on the CI52x-MODTCP device, all other masters / clients still have read access to the CI52x-MODTCP device.

### Table 248: Table Error LED / Failsafe function

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Error LED (S-ERR) lights up at errors of all error classes, Failsafe-mode off</td>
</tr>
<tr>
<td>Off by E4</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1, E2 and E3, Failsafe-mode off</td>
</tr>
<tr>
<td>Off by E3</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1 and E2, Failsafe-mode off</td>
</tr>
<tr>
<td>On + Failsafe</td>
<td>Error LED (S-ERR) lights up at errors of all error classes, Failsafe-mode on *)</td>
</tr>
<tr>
<td>Off by E4 + Failsafe</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1, E2 and E3, Failsafe-mode on *)</td>
</tr>
<tr>
<td>Off by E3 + Failsafe</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1 and E2, Failsafe-mode on *)</td>
</tr>
</tbody>
</table>

*) The parameter Behaviour DO at comm. error is only analyzed if the Failsafe-mode is ON.

### Group parameters for the digital part

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input delay</td>
<td>0.1 ms</td>
<td>0</td>
<td>BYTE</td>
<td>0.1 ms</td>
</tr>
<tr>
<td></td>
<td>1 ms</td>
<td>1</td>
<td></td>
<td>0x00</td>
</tr>
<tr>
<td></td>
<td>8 ms</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>32 ms</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Detect short circuit at outputs</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>On</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td></td>
<td>0x01</td>
</tr>
</tbody>
</table>
### Table 249: Structure of the Diagnosis Block

<table>
<thead>
<tr>
<th>Byte Number</th>
<th>Description</th>
<th>Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Diagnosis Byte, slot number</td>
<td>31 = CI502-PNIO (e.g. error at integrated 8 DI / 8 DO)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = 1st connected S500 I/O Module</td>
</tr>
<tr>
<td></td>
<td></td>
<td>...</td>
</tr>
<tr>
<td></td>
<td></td>
<td>10 = 10th connected S500 I/O Module</td>
</tr>
<tr>
<td>2</td>
<td>Diagnosis Byte, module number</td>
<td>According to the I/O bus specification passed on by modules to the fieldbus master</td>
</tr>
<tr>
<td>Byte Number</td>
<td>Description</td>
<td>Possible Values</td>
</tr>
<tr>
<td>-------------</td>
<td>------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>3</td>
<td>Diagnosis Byte, channel</td>
<td>According to the I/O bus specification passed on by modules to the fieldbus master</td>
</tr>
</tbody>
</table>
| 4           | Diagnosis Byte, error code   | According to the I/O bus specification
Bit 7 and bit 6, coded error class
0 = E1
1 = E2
2 = E3
3 = E4
Bit 0 to bit 5, coded error description |
| 5           | Diagnosis Byte, flags        | According to the I/O bus specification
Bit 7: 1 = coming error
Bit 6: 1 = leaving error |
| 6           | Reserved                      | 0                                                                                                                                                |

In cases of short circuit or overload, the digital outputs are turned off. The modules performs reactivation automatically. Thus an acknowledgement of the errors is not necessary. The error message is stored via the LED.

For diagnosis firmware version \( \geq 3.2.6 \) is required.

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier</th>
<th>AC500-Display</th>
<th>&lt;= Display in</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>000 ... 063</td>
<td>PS501 PLC Browser</td>
<td>PLC Browser</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Byte 4</th>
<th>Bit 6 ... 7</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1) Byte 1</td>
</tr>
<tr>
<td></td>
<td>2) Byte 2</td>
</tr>
<tr>
<td></td>
<td>3) Byte 3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error-Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Module errors

<table>
<thead>
<tr>
<th>Byte</th>
<th>Channel</th>
<th>Error-Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>19</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>3</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>40</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>43</td>
</tr>
<tr>
<td>Class</td>
<td>Interface</td>
<td>Device</td>
<td>Module</td>
<td>Channel</td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>--------</td>
<td>--------</td>
<td>---------</td>
</tr>
<tr>
<td>Byte 4 Bit 6 ... 7</td>
<td>Byte 1</td>
<td>Byte 2</td>
<td>Byte 3</td>
<td>Byte 4 Bit 0 ... 5</td>
</tr>
<tr>
<td>Class</td>
<td>Interface</td>
<td>Device</td>
<td>Module</td>
<td>Channel</td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>--------</td>
<td>--------</td>
<td>---------</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31/1...10</td>
<td>31</td>
<td>31</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>31</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>31</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>5</td>
</tr>
<tr>
<td>Class</td>
<td>Interface</td>
<td>Device</td>
<td>Module</td>
<td>Channel</td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>--------</td>
<td>--------</td>
<td>---------</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>5</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>5</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>5</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>6</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>6</td>
</tr>
<tr>
<td>4</td>
<td>1...6</td>
<td>255</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>45</td>
</tr>
</tbody>
</table>
### Hardware descriptions

#### Device specifications > Communication interface modules

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier</th>
<th>AC500-Display</th>
<th>&lt;= Display in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Comp</td>
<td>Dev</td>
<td>Mod</td>
<td>Ch</td>
<td>Err</td>
<td>PS501 PLC Browser</td>
<td></td>
</tr>
<tr>
<td>Byte 4</td>
<td>Bit 6 ... 7</td>
<td>Byte 1</td>
<td>Byte 2</td>
<td>Byte 3</td>
<td>Byte 4 Bit 0 ... 5</td>
<td>PNIO diagnosis block</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error- Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1)</td>
<td>2)</td>
<td>3)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>46</td>
<td>Reverse voltage from digital outputs DO8...DO15 to UP3 4)</td>
<td>Check terminals</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>34</td>
<td>No response during initialization of the I/O module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>11</td>
<td>Process voltage UP3 too low</td>
<td>Check process supply voltage</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>45</td>
<td>Process voltage UP3 gone</td>
<td>Check process supply voltage</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>10</td>
<td>Voltage overflow at outputs (above UP3 level) 5)</td>
<td>Check terminals/ check process supply voltage</td>
</tr>
</tbody>
</table>

### Channel error digital

| 4     | -         | 31     | 2      | 8...15   | 46               | Externally voltage detected at digital output DO8...DO15 6) | Check terminals |
| 4     | -         | 31     | 4      | 0...7    | 46               | Externally voltage detected at digital output DC0...DC7 6) | Check terminals |
| 4     | -         | 31     | 4      | 0...7    | 47               | Short circuit at digital output DC0...DC7 7) | Check terminals |
| 4     | -         | 31     | 2      | 8...15   | 47               | Short circuit at digital output DO8...DO15 7) | Check terminals |

Remarks:
1) In AC500 the following interface identifier applies:
"." = Diagnosis via bus-specific function blocks; 0 ... 4 or 10 = Position of the Communication Module; 14 = I/O bus; 31 = Module itself

The identifier is not contained in the CI502-PNIO diagnosis block.

2) With "Device" the following allocation applies: 31 = Module itself, 1..10 = Expansion module

3) With "Module" the following allocation applies dependent of the master:
Module error: 31 = Module itself
Channel error: Module type (1 = AI, 2 = DO, 3 = AO)

4) This message appears, if externally voltages at one or more terminals DC0 ... DC7 oder DO8 ... DO15 cause that other digital outputs are supplied through that voltage (voltage feedback, see description in 'Connections' Chapter 5.2.6.5.2.4 "Connections" on page 1113. All outputs of the apply digital output groups will be turned off for 5 seconds. The diagnosis message appears for the whole output group.

5) The voltage at digital outputs DC0 ... DC7 and accordingly DO8 ... DO15 has exceeded the process supply voltage UP3 Chapter 5.2.6.5.2.4 "Connections" on page 1113. Diagnosis message appears for the whole module.

6) This message appears, if the output of a channel DC0 ... DC7 or DO8 ... DO15 should be switched on while an externally voltage is connected. In this case the start up is disabled, as long as the externally voltage is connected. Otherwise this could produce reverse voltage from this output to other digital outputs. This diagnosis message appears per channel.

7) Short circuit: After a detected short circuit, the output is deactivated for 2000ms. Then a new start up will be executed. This diagnosis message appears per channel.

8) In case of an I/O module doesn't support hot swapping, do not perform any hot swap operations (also not on any other terminal units (slots)) as modules may be damaged or I/O bus communication may be disturbed.

9) Diagnosis for hot swap available as of version index F0.

State LEDs

The LEDs are located at the front of module. There are 2 different groups:

- The 5 system LEDs (PWR, STA1 ETH, STA2 ETH, S-ERR and I/O-Bus) show the operation state of the module and display possible errors.
- The 29 process LEDs (UP, UP3, inputs, outputs, CH-ERR1 to CH-ERR3) show the process supply voltage and the states of the inputs and outputs and display possible errors.

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>OFF</th>
<th>ON</th>
<th>Flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR/RUN</td>
<td>Green</td>
<td>Process supply voltage missing</td>
<td>Internal supply voltage OK, module ready for communication with I/O Controller</td>
<td>Start-up / preparing communication</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>***</td>
<td>***</td>
<td>***</td>
</tr>
</tbody>
</table>
### Table 251: States of the 29 process LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>OFF</th>
<th>ON</th>
<th>Flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>STA1 ETH (System LED &quot;BF&quot;)</td>
<td>Green</td>
<td>---</td>
<td>Device configured, cyclic data exchange running</td>
<td>Device configured, acyclic data exchange running</td>
</tr>
<tr>
<td></td>
<td>Red</td>
<td>---</td>
<td>Communication error (timeout) appeared</td>
<td>IP address error</td>
</tr>
<tr>
<td>STA2 ETH (System LED &quot;SF&quot;)</td>
<td>Green</td>
<td>Device has valid parameters</td>
<td>Device is running parameterization sequence</td>
<td>Device has no parameters</td>
</tr>
<tr>
<td></td>
<td>Red</td>
<td>---</td>
<td>---</td>
<td>Device has invalid parameters</td>
</tr>
<tr>
<td>S-ERR</td>
<td>Red</td>
<td>No error</td>
<td>Internal error</td>
<td>--</td>
</tr>
<tr>
<td>I/O-Bus</td>
<td>Green</td>
<td>No expansion modules connected or communication error</td>
<td>Expansion modules connected and operational</td>
<td>---</td>
</tr>
<tr>
<td>ETH1</td>
<td>Green</td>
<td>No connection at Ethernet interface</td>
<td>Connected to Ethernet interface</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>---</td>
<td>Device is transmitting telegrams</td>
<td>Device is transmitting telegrams</td>
</tr>
<tr>
<td>ETH2</td>
<td>Green</td>
<td>No connection at Ethernet interface</td>
<td>Connected to Ethernet interface</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>---</td>
<td>Device is transmitting telegrams</td>
<td>Device is transmitting telegrams</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>OFF</th>
<th>ON</th>
<th>Flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC0 ... DC7</td>
<td>Yellow</td>
<td>Input/Output is OFF</td>
<td>Input/Output is ON</td>
<td>--</td>
</tr>
<tr>
<td>DI8 ... DI15</td>
<td>Yellow</td>
<td>Input is OFF</td>
<td>Input is ON (the input voltage is even displayed if the supply voltage is OFF)</td>
<td>--</td>
</tr>
<tr>
<td>DO8 ... DO15</td>
<td>Yellow</td>
<td>Output is OFF</td>
<td>Output is ON</td>
<td>--</td>
</tr>
<tr>
<td>UP</td>
<td>Green</td>
<td>Process supply voltage missing</td>
<td>Process supply voltage OK and initialization finished</td>
<td>--</td>
</tr>
<tr>
<td>UP3</td>
<td>Green</td>
<td>Process supply voltage missing</td>
<td>Process supply voltage OK</td>
<td>--</td>
</tr>
<tr>
<td>CH-ERR1 to CH-ERR3</td>
<td>Red</td>
<td>No error or process supply voltage missing</td>
<td>Internal error</td>
<td>Error on one channel of the corresponding group</td>
</tr>
</tbody>
</table>
Technical data

Technical data of the module

The system data of AC500 and S500 are applicable to the standard version "Chapter 5.1.2 "System data AC500" on page 166."

The system data of AC500-XC are applicable to the XC version "Chapter 5.1.3 "System data AC500-XC" on page 169."

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltages UP/UP3</td>
<td></td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC (for inputs and outputs)</td>
</tr>
<tr>
<td>Max. load for the terminals</td>
<td>10 A</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse on UP/UP3</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Ethernet interface against the rest of the module</td>
</tr>
<tr>
<td>Inrush current from UP (at power up)</td>
<td>On request</td>
</tr>
<tr>
<td>Current consumption via UP (normal operation)</td>
<td>0.15 A</td>
</tr>
<tr>
<td>Current consumption via UP3</td>
<td>0.06 A + 0.5 A max. per output</td>
</tr>
<tr>
<td>Connections</td>
<td>Terminals 1.8 and 2.8 for +24 V (UP)</td>
</tr>
<tr>
<td></td>
<td>Terminal 3.8 for +24 V (UP3)</td>
</tr>
<tr>
<td></td>
<td>Terminals 1.9, 2.9 and 3.9 for 0 V (ZP)</td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>6 W</td>
</tr>
<tr>
<td>Number of digital inputs</td>
<td>8</td>
</tr>
<tr>
<td>Number of digital outputs</td>
<td>8</td>
</tr>
<tr>
<td>Number of configurable digital inputs/outputs</td>
<td>8</td>
</tr>
<tr>
<td>Reference potential for all digital inputs and outputs</td>
<td>Negative pole of the supply voltage, signal name ZP</td>
</tr>
<tr>
<td>Ethernet</td>
<td>10/100 base-TX, internal switch, 2 x RJ45 socket</td>
</tr>
<tr>
<td>Setting of the I/O device identifier</td>
<td>With 2 rotary switches at the front side of the module</td>
</tr>
<tr>
<td>Diagnosis</td>
<td>See Diagnosis and Displays &quot;Chapter 5.2.6.5.2.9 “Diagnosis” on page 1123</td>
</tr>
<tr>
<td>Operation and error displays</td>
<td>34 LEDs (totally)</td>
</tr>
<tr>
<td>Weight (without terminal unit)</td>
<td>Ca. 125 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical with derating (output load reduced to 50 % at +40°C per group)</td>
</tr>
<tr>
<td>Extended ambient temperature (XC version)</td>
<td>&gt; +60 °C on request</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>
NOTICE!
All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

Multiple overloads
No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an internal smart high-side switch.

Technical data of the digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels DI8 ... DI15</td>
<td>Terminals 2.0 ... 2.7</td>
</tr>
<tr>
<td>Reference potential for all inputs</td>
<td>Terminals 1.9 ... 3.9 (negative pole of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel, the LED is ON when the input signal is high (signal 1)</td>
</tr>
<tr>
<td>Input type (acc. EN 61131-2)</td>
<td>Type 1</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 0.1 ms, configurable from 0.1 ms ... 32 ms</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-3 V ... +5 V</td>
</tr>
<tr>
<td>Undef. Signal</td>
<td>&gt; +5 V ... &lt; +15 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>+15 V ... +30 V</td>
</tr>
<tr>
<td>Ripple with signal 0</td>
<td>Within -3 V ... +5 V</td>
</tr>
<tr>
<td>Ripple with signal 1</td>
<td>Within +15 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 5 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>&gt; 1 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>&gt; 2 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 8 mA</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

Technical data of the digital outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Terminals of the channels DO8 ... DO15</td>
<td>Terminals 3.0 ... 3.7</td>
</tr>
<tr>
<td>Reference potential for all outputs</td>
<td>Terminals 1.9 ... 3.9 (negative pole of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>For all outputs terminal 3.8 (positive pole of the supply voltage, signal name UP3)</td>
</tr>
<tr>
<td>Output voltage for signal 1</td>
<td>UP3 (-0.8 V)</td>
</tr>
<tr>
<td>Output delay (0-&gt;1 or 1-&gt;0)</td>
<td>On request</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated value per channel</td>
<td>500 mA at UP3 = 24 V</td>
</tr>
<tr>
<td>Max. value (all channels together)</td>
<td>4 A</td>
</tr>
<tr>
<td>Leakage current with signal 0</td>
<td>&lt; 0.5 mA</td>
</tr>
<tr>
<td>Fuse for UP3</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Demagnetization with inductive DC load</td>
<td>Via internal varistors (see figure below this table)</td>
</tr>
<tr>
<td>Output switching frequency</td>
<td></td>
</tr>
<tr>
<td>With resistive load</td>
<td>On request</td>
</tr>
<tr>
<td>With inductive loads</td>
<td>Max. 0.5 Hz</td>
</tr>
<tr>
<td>With lamp loads</td>
<td>11 Hz max. at 5 W max.</td>
</tr>
<tr>
<td>Short-circuit-proof / overload-proof</td>
<td>Yes</td>
</tr>
<tr>
<td>Overload message (I &gt; 0.7 A)</td>
<td>Yes, after ca. 100 ms</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>Yes, automatic reactivation after short circuit/overload</td>
</tr>
<tr>
<td>Resistance to feedback against 24V signals</td>
<td>Yes (software-controlled supervision)</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

The following drawing shows the circuitry of a digital input/output with the varistors for demagnetization when inductive loads are switched off.

![Circuit Diagram](image.png)

**Fig. 223: Digital input/output (circuit diagram)**
1. Digital output
2. Varistors for demagnetization when inductive loads are turned off

**Technical data of the configurable digital inputs/outputs**
Each of the configurable I/O channels is defined as input or output by the user program. This is done by interrogating or allocating the corresponding channel.
Parameter | Value
---|---
Number of channels per module | 8 inputs/outputs (with transistors)
Distribution of the channels into groups | 1 group for 8 channels
If the channels are used as inputs | 
Channels DC0 ... DC7 | Terminals 1.0 ... 1.7
If the channels are used as outputs | 
Channels DC0 ... DC7 | Terminals 1.0 ... 1.7
Indication of the input/output signals | 1 yellow LED per channel, the LED is ON when the input/output signal is high (signal 1)
Galvanic isolation | From the Ethernet network

Technical data of the digital inputs/outputs if used as inputs

Parameter | Value
---|---
Number of channels per module | 8
Distribution of the channels into groups | 1 group of 8 channels
Terminals of the channels DC0 ... DC7 | Terminals 1.0 ... 1.7
Reference potential for all inputs | Terminals 1.9 ... 3.9 (negative pole of the supply voltage, signal name ZP)
Indication of the input signals | 1 yellow LED per channel, the LED is ON when the input signal is high (signal 1)
Input type (according EN 61131-2) | Type 1
Input delay (0->1 or 1->0) | Typ. 0.1 ms, configurable from 0.1 ms ... 32 ms
Input signal voltage | 24 V DC
Signal 0 | -3 V ... +5 V *)
Undefined Signal | > +5 V ... < +15 V
Signal 1 | +15 V ... +30 V
Ripple with signal 0 | Within -3 V ... +5 V *)
Ripple with signal 1 | Within +15 V ... +30 V
Input current per channel | 
Input voltage +24 V | Typ. 5 mA
Input voltage +5 V | > 1 mA
Input voltage +15 V | > 2 mA
Input voltage +30 V | < 8 mA
Max. cable length | 
Shielded | 1000 m
Unshielded | 600 m

*) Due to the direct connection to the output, the demagnetizing varistor is also effective at the input (see figure) above. This is why the difference between UPx and the input signal may not exceed the clamp voltage of the varistor. The varistor limits the voltage to approx. 36 V. Following this, the input voltage must range from -12 V ... +30 V when UPx = 24 V and from -6 V ... +30 V when UPx = 30 V.
Technical data of the digital inputs/outputs if used as outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels DC0 ... DC7</td>
<td>Terminals 1.0 ... 1.7</td>
</tr>
<tr>
<td>Reference potential for all outputs</td>
<td>Terminals 1.9 ... 3.9 (negative pole of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>For all outputs terminal 3.8 (positive pole of the supply voltage, signal name UP3)</td>
</tr>
<tr>
<td>Output voltage for signal 1</td>
<td>UP3 (-0.8 V)</td>
</tr>
<tr>
<td>Output delay (0-&gt;1 or 1-&gt;0)</td>
<td>On request</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated value per channel</td>
<td>500 mA at UP3 = 24 V</td>
</tr>
<tr>
<td>Max. value (all channels together)</td>
<td>4 A</td>
</tr>
<tr>
<td>Leakage current with signal 0</td>
<td>&lt; 0.5 mA</td>
</tr>
<tr>
<td>Fuse for UP3</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Demagnetization with inductive DC load</td>
<td>Via internal varistors (see figure below this table)</td>
</tr>
<tr>
<td>Output switching frequency</td>
<td></td>
</tr>
<tr>
<td>With resistive load</td>
<td>On request</td>
</tr>
<tr>
<td>With inductive loads</td>
<td>Max. 0.5 Hz</td>
</tr>
<tr>
<td>With lamp loads</td>
<td>11 Hz max. at 5 W max.</td>
</tr>
<tr>
<td>Short-circuit-proof / overload-proof</td>
<td>Yes</td>
</tr>
<tr>
<td>Overload message (I &gt; 0.7 A)</td>
<td>Yes, after ca. 100 ms</td>
</tr>
<tr>
<td>Output current limitation</td>
<td>Yes, automatic reactivation after short circuit/overload</td>
</tr>
<tr>
<td>Resistance to feedback against 24V signals</td>
<td>Yes (software-controlled supervision)</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

The following drawing shows the circuitry of a digital input/output with the varistors for demagnetization when inductive loads are switched off.

![Fig. 224: Digital input/output (circuit diagram)](image)

1 Digital input/output
2 For demagnetization when inductive loads are turned off
**Technical data of the fast counter**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Used inputs</td>
<td>Terminal 2.0 (DI8), Terminal 2.1 (DI9)</td>
</tr>
<tr>
<td>Used outputs</td>
<td>Terminal 3.0 (DO8)</td>
</tr>
<tr>
<td>Counting frequency</td>
<td>Depending on operation mode:</td>
</tr>
<tr>
<td></td>
<td>Mode 1-6: max. 200 kHz</td>
</tr>
<tr>
<td></td>
<td>Mode 7: max. 50 kHz</td>
</tr>
<tr>
<td></td>
<td>Mode 9: max. 35 kHz</td>
</tr>
<tr>
<td></td>
<td>Mode 10: max. 20 kHz</td>
</tr>
</tbody>
</table>

*Chapter 6.8.2.12 “Fast counters in AC500 devices” on page 4536*

How to prepare a device as fast counter and how to connect it to the PLC is described in an application example.

**Dimensions**

The dimensions are in mm and in brackets in inch.
## Ordering data

<table>
<thead>
<tr>
<th>Ordering No.</th>
<th>Scope of delivery</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 222 200 R0001</td>
<td>CI522-MODTCP, Modbus TCP communication interface module, 8 DC, 8 DI and 8 DO</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 422 200 R0001</td>
<td>CI522-MODTCP-XC, Modbus TCP communication interface module, 8 DC, 8 DI and 8 DO, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

## 5.2.6.6 PROFIBUS

### 5.2.6.6.1 CI541-DP

**Features**

- 4 configurable analog inputs (2-wire/single-ended) or 2 configurable analog inputs (3-wire/differential)
  - Resolution 12 bits including sign
- 2 analog outputs
  - Resolution 12 bits including sign
- 8 digital inputs 24 V DC in 1 group
- 8 digital outputs 24 V DC in 1 group, 0.5 A max.
- Fast counter
- Module-wise galvanically isolated
- XC version for usage in extreme ambient conditions available
1 I/O bus
2 Allocation between terminal number and signal name
3 6 yellow LEDs to display the signal states of the analog inputs/outputs (AI0 ... AI3, AO0 ... AO1)
4 8 yellow LEDs to display the signal states of the digital inputs (DI0 ... DI7)
5 8 yellow LEDs to display the signal states of the digital outputs (DO0 ... DO7)
6 2 green LEDs to display the process supply voltage UP and UP3
7 3 red LEDs to display errors (CH-ERR1, CH-ERR2, CH-ERR3)
8 5 system LEDs: PWR/RUN, STA1 DP, STA2 DP, S-ERR, I/O-Bus
9 Label
10 2 rotary switches for setting the PROFIBUS ID
11 9-pin D-SUB connector to connect the PROFIBUS DP signals
12 Terminal unit
13 DIN rail
$^{*}$ Sign for XC version

**Intended purpose**

The PROFIBUS DP communication interface module is used as decentralized I/O module in PROFIBUS DP networks. Depending on the used terminal unit the network connection is performed either via 9-pole female D-sub or via 10 terminals (screw-type or spring terminals) which are integrated in the terminal unit. The communication interface module contains 22 I/O channels.

The inputs/outputs are galvanically isolated from the PROFIBUS DP network. There is no potential separation between the channels. The configuration of the analog inputs/outputs is performed by software.

For usage in extreme ambient conditions (e.g. wider temperature and humidity range), a special XC version of the device is available.
- 4 configurable analog inputs (2-wire/single-ended) or 2 configurable analog inputs (3-wire/differential)
  Resolution 12 bits including sign
- 2 analog outputs
  Resolution 12 bits including sign
- 8 digital inputs 24 V DC in 1 group
- 8 digital outputs 24 V DC in 1 group, 0.5 A max.
- Fast counter
- Module-wise galvanically isolated
- XC version for usage in extreme ambient conditions available

Diagnosis settings

The current CI54x does not run in combination with a V3 PLC if in the “General” tab the parameter “Diagnosis behavior” is set to “AC500 V3 compatible”. How to change the setting in your AB project is described below.

1. Double click in the “Device” tree on “CI541_IO”.
   ⇒ The tab for the various settings opens.
2. Double click on the “General” tab.
3. Double click on the “Value” of the parameter “Diagnosis behavior”.
4. Click on the small arrow.
   ⇒ A submenu with two values opens.
5. Click on “AC500 V2 compatible” as setting.
6. Close the tab.

After changing the parameter to “AC500 V2 compatible” the CI54x get in “RUN”.

If the CI54x indicates a S500 diagnosis message, following AC500 diagnosis entry (“655374 CI54x communication interface module is sending not supported diagnosis format - Check configuration and FW revision of communication interface module”) is shown in the diagnosis editor and history. This diagnosis message does not have impact to cyclic data exchange between the master and the CI54x.

In case of a parameter change from V2 to V3 the parameter at the CI54x of V3 has the same value than at the CI54x below V2 (that means AC500 V2 compatible).

Functionality

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface</td>
<td>PROFIBUS</td>
</tr>
<tr>
<td>Protocol</td>
<td>PROFIBUS DP (DP-V0 and DP-V1)</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Power supply</td>
<td>From the process supply voltage UP</td>
</tr>
<tr>
<td>Supply of the electronic circuitry of the I/O</td>
<td>Through the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>expansion modules attached</td>
<td></td>
</tr>
<tr>
<td>Rotary switches</td>
<td>For setting the PROFIBUS ID for configuration purposes (00h to FFh)</td>
</tr>
<tr>
<td>Expandability</td>
<td>Max. 10 S500 I/O modules</td>
</tr>
<tr>
<td>Fast counter</td>
<td>Integrated, configurable operating modes</td>
</tr>
<tr>
<td>LED displays</td>
<td>For system displays, signal states, errors and power supply</td>
</tr>
<tr>
<td>External supply voltage</td>
<td>Via terminals ZP, UP and UP3 (process supply voltage 24 V DC)</td>
</tr>
<tr>
<td>Effect of incorrect input terminal connection</td>
<td>Wrong or no signal detected, no damage up to 35 V</td>
</tr>
<tr>
<td>Required terminal unit</td>
<td>TU509, TU510, TU517 or TU518 ( \in ) Chapter 5.2.7.3 “TU509 and TU510 for communication interface modules” on page 1274 ( \in ) Chapter 5.2.7.4 “TU517 and TU518 for communication interface modules” on page 1278</td>
</tr>
</tbody>
</table>

**Connections**

**General**

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The PROFIBUS DP communication interface module CI541-DP is plugged on the I/O terminal units TU509 \( \in \) Chapter 5.2.7.3 “TU509 and TU510 for communication interface modules” on page 1274 or TU510 \( \in \) Chapter 5.2.7.3 “TU509 and TU510 for communication interface modules” on page 1274 and accordingly TU517 \( \in \) Chapter 5.2.7.4 “TU517 and TU518 for communication interface modules” on page 1278 or TU518 \( \in \) Chapter 5.2.7.4 “TU517 and TU518 for communication interface modules” on page 1278. Properly seat the module and press until it locks in place. The terminal unit is mounted on a DIN rail or with 2 screws plus the additional accessory for wall mounting \( \in \) Chapter 5.2.8.2.5 “TA526 - Wall mounting accessory” on page 1324.

The connection of the I/O channels is carried out using the 30 terminals of the I/O terminal unit. I/O modules can be replaced without re-wiring the terminal units.

The terminals 2.8 and 3.8 as well as 2.9, 3.9 and 4.9 are interconnected within the terminal unit and have always the same assignment, independent of the inserted module:

- Terminals 2.8 and 3.8: Process supply voltage UP = +24 V DC
- Terminal 4.8: Process supply voltage UP3 = +24 V DC
- Terminals 2.9, 3.9 and 4.9: Process supply voltage ZP = 0 V

With a separate UP3 power supply, the digital outputs can be switched off externally. This way, an emergency-off functionality can be realized.
Do not connect any voltages externally to digital outputs!

Reason: Externally voltages at an output or several outputs may cause that other outputs are supplied through that voltage instead of voltage UP3 (reverse voltage). This is not intended usage.

CAUTION!
Risk of malfunction by unintended usage!
If the function cut-off of the digital outputs is to be used by deactivation of the supply voltage UP3, be sure that no external voltage is connected at the outputs DO0 ... DO7.

Possibilities of connection
Connection on terminal units TU509 or TU510

The assignment of the 9-pole female D-sub for the PROFIBUS signals:

<table>
<thead>
<tr>
<th>1</th>
<th>---</th>
<th>Reserved</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>3</td>
<td>B</td>
<td>Data line B (receive and send line, positive)</td>
</tr>
<tr>
<td>4</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>5</td>
<td>DGND</td>
<td>Reference potential for data transmissions and +5 V</td>
</tr>
<tr>
<td>6</td>
<td>VP (5 V)</td>
<td>+5 V (Power supply voltage for terminating resistors)</td>
</tr>
<tr>
<td>7</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>8</td>
<td>A</td>
<td>Data line A (receive and send line, negative)</td>
</tr>
<tr>
<td>9</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>Shield</td>
<td>Shield</td>
<td>Shield, functional earth</td>
</tr>
</tbody>
</table>

Bus termination
The line ends of the bus segment must be equipped with bus terminating resistors. Normally, these resistors are integrated in the interface connectors.

| VP (+5 V) | 6 |
|-----------|
| 390 Ohms |
| Data Line B | RxD/TxD-P | 3 |
| 220 Ohms |
| Data Line A | RxD/TxD-N | 8 |
| 390 Ohms |
| GND (0 V) | 5 |
Mounting on terminal units TU517 or TU518

The assignment of the terminals 1.0 ... 1.9:

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>B</td>
<td>Data line B (receive and send line, positive)</td>
</tr>
<tr>
<td>1.1</td>
<td>B</td>
<td>Data line B (receive and send line, positive)</td>
</tr>
<tr>
<td>1.2</td>
<td>A</td>
<td>Data line A (receive and send line, negative)</td>
</tr>
<tr>
<td>1.3</td>
<td>A</td>
<td>Data line A (receive and send line, negative)</td>
</tr>
<tr>
<td>1.4</td>
<td>TermB</td>
<td>Bus termination data line B</td>
</tr>
<tr>
<td>1.5</td>
<td>TermB</td>
<td>Bus termination data line B</td>
</tr>
<tr>
<td>1.6</td>
<td>TermA</td>
<td>Bus termination data line A</td>
</tr>
<tr>
<td>1.7</td>
<td>TermA</td>
<td>Bus termination data line A</td>
</tr>
<tr>
<td>1.8</td>
<td>DGND</td>
<td>Reference potential for data transmission</td>
</tr>
<tr>
<td>1.9</td>
<td>DGND</td>
<td>Reference potential for data transmission</td>
</tr>
</tbody>
</table>

At the line ends of a bus segment, terminating resistors must be connected. If using TU517/TU518, the bus terminating resistors can be enabled by connecting the terminals TermA and TermB to the data lines A and B (no external terminating resistors are required, see figure below).
If using TU517/TU518, note that the terminating resistors are not located inside the TU, but inside the communication interface module CI541-DP. I.e. when removing the device from the TU, the bus terminating resistors are not connected to the bus any more. The bus itself will not be disconnected if a device is removed.

If using TU517/TU518 the max. permitted transmission rate is limited to 1.5 MBaud.

The grounding of the shield should take place at the control cabinet "Chapter 5.1.2 “System data AC500” on page 166."

**Technical data bus cable**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Twisted pair (shielded)</td>
</tr>
<tr>
<td>Characteristic impedance</td>
<td>135...165 Ω</td>
</tr>
<tr>
<td>Cable capacitance</td>
<td>&lt; 30 pF/m</td>
</tr>
<tr>
<td>Conductor diameter of the cores</td>
<td>≥ 0.64 mm</td>
</tr>
<tr>
<td>Conductor cross section of the cores</td>
<td>≥ 0.34 mm²</td>
</tr>
<tr>
<td>Cable resistance per core</td>
<td>≤ 55 Ω/km</td>
</tr>
<tr>
<td>Loop resistance (resistance of two cores)</td>
<td>≤ 110 Ω/km</td>
</tr>
</tbody>
</table>

**Cable length**

The maximum possible cable length of a PROFIBUS subnet within a segment depends on the transmission rate (baud rate).
### Transmission rate vs. Maximum cable length

<table>
<thead>
<tr>
<th>Transmission rate</th>
<th>Maximum cable length</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.6 kBaud to 93.75 kBaud</td>
<td>1200 m</td>
</tr>
<tr>
<td>187.5 kBaud</td>
<td>1000 m</td>
</tr>
<tr>
<td>500 kBaud</td>
<td>400 m</td>
</tr>
<tr>
<td>1.5 MBaud</td>
<td>200 m</td>
</tr>
<tr>
<td>3 MBaud to 12 MBaud</td>
<td>100 m</td>
</tr>
</tbody>
</table>

The assignment of the other terminals:

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0</td>
<td>AI0+</td>
<td>Positive pole of analog input signal 0</td>
</tr>
<tr>
<td>2.1</td>
<td>AI1+</td>
<td>Positive pole of analog input signal 1</td>
</tr>
<tr>
<td>2.2</td>
<td>AI2+</td>
<td>Positive pole of analog input signal 2</td>
</tr>
<tr>
<td>2.3</td>
<td>AI3+</td>
<td>Positive pole of analog input signal 3</td>
</tr>
<tr>
<td>2.4</td>
<td>AI-</td>
<td>Negative pole of analog inputs 0 to 3</td>
</tr>
<tr>
<td>2.5</td>
<td>AO0+</td>
<td>Positive pole of analog output signal 0</td>
</tr>
<tr>
<td>2.6</td>
<td>AO1+</td>
<td>Positive pole of analog output signal 1</td>
</tr>
<tr>
<td>2.7</td>
<td>AI-</td>
<td>Negative pole of analog output signals 0 and 1</td>
</tr>
<tr>
<td>2.8</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>2.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
<tr>
<td>3.0</td>
<td>DI0</td>
<td>Signal of the digital input DI0</td>
</tr>
<tr>
<td>3.1</td>
<td>DI1</td>
<td>Signal of the digital input DI1</td>
</tr>
<tr>
<td>3.2</td>
<td>DI2</td>
<td>Signal of the digital input DI2</td>
</tr>
<tr>
<td>3.3</td>
<td>DI3</td>
<td>Signal of the digital input DI3</td>
</tr>
<tr>
<td>3.4</td>
<td>DI4</td>
<td>Signal of the digital input DI4</td>
</tr>
<tr>
<td>3.5</td>
<td>DI5</td>
<td>Signal of the digital input DI5</td>
</tr>
<tr>
<td>3.6</td>
<td>DI6</td>
<td>Signal of the digital input DI6</td>
</tr>
<tr>
<td>3.7</td>
<td>DI7</td>
<td>Signal of the digital input DI7</td>
</tr>
<tr>
<td>3.8</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>3.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
<tr>
<td>4.0</td>
<td>DO0</td>
<td>Signal of the digital output DO0</td>
</tr>
<tr>
<td>4.1</td>
<td>DO1</td>
<td>Signal of the digital output DO1</td>
</tr>
<tr>
<td>4.2</td>
<td>DO2</td>
<td>Signal of the digital output DO2</td>
</tr>
<tr>
<td>4.3</td>
<td>DO3</td>
<td>Signal of the digital output DO3</td>
</tr>
<tr>
<td>4.4</td>
<td>DO4</td>
<td>Signal of the digital output DO4</td>
</tr>
<tr>
<td>4.5</td>
<td>DO5</td>
<td>Signal of the digital output DO5</td>
</tr>
<tr>
<td>4.6</td>
<td>DO6</td>
<td>Signal of the digital output DO6</td>
</tr>
<tr>
<td>4.7</td>
<td>DO7</td>
<td>Signal of the digital output DO7</td>
</tr>
<tr>
<td>4.8</td>
<td>UP3</td>
<td>Process voltage UP3 (24 V DC)</td>
</tr>
<tr>
<td>4.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
</tbody>
</table>
WARNING!

Removal/Insertion under power

The devices are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you

– connect or disconnect any signal or terminal block
– remove, mount or replace a module.

Disconnecting any powered devices while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The devices must not be opened when in operation. The same applies to the network interfaces.

NOTICE!

Risk of damaging the PLC modules!

Overvoltages and short circuits might damage the PLC modules.

– Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
– Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

For the open-circuit detection (cut wire), each channel is pulled up to "plus" by a high-resistance resistor. If nothing is connected, the maximum voltage will be read in then.

Analog signals are always laid in shielded cables. The cable shields are grounded at both ends of the cables. In order to avoid unacceptable potential differences between different parts of the installation, low resistance equipotential bonding conductors must be laid.

For simple applications (low electromagnetic disturbances, no high requirement on precision), the shielding can also be omitted.
Connection of the digital inputs

Fig. 225: Connection of the PROFIBUS DP communication interface module CI541-DP

Fig. 226: Connection of the digital input DI0 (Proceed with the digital inputs DI1 ... DI7 in the same way)

The meaning of the LEDs is described in Displays § Chapter 5.2.6.6.1.11 “State LEDs” on page 1165.
Connection of the digital outputs

![Diagram of digital outputs connection]

**Fig. 227: Connection of the digital output DO0 (Proceed with the digital outputs DO1 ... DO7 in the same way)**

The meaning of the LEDs is described in Displays § Chapter 5.2.6.6.1.11 “State LEDs” on page 1165.

Connection of resistance thermometers in 2-wire configuration to the analog inputs

When resistance thermometers (Pt100, Pt1000, Ni1000) are used, a constant current must flow through them to build the necessary voltage drop for the evaluation. For this, the module CI541-DP provides a constant current source which is multiplexed over the max. 4 analog input channels.

![Diagram of resistance thermometers connection]

**Fig. 228: Connection of resistance thermometers in 2-wire configuration to the analog input AI0 (Proceed with the analog inputs AI1 ... AI3 in the same way)**
The following measuring ranges can be configured:

<table>
<thead>
<tr>
<th>Sensor</th>
<th>Temperature Range</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pt100</td>
<td>-50 °C ... +400 °C</td>
<td>2-wire configuration, 1 channel used</td>
</tr>
<tr>
<td>Pt1000</td>
<td>-50 °C ... +400 °C</td>
<td>2-wire configuration, 1 channel used</td>
</tr>
<tr>
<td>Ni1000</td>
<td>-50 °C ... +150 °C</td>
<td>2-wire configuration, 1 channel used</td>
</tr>
</tbody>
</table>

The function of the LEDs is described under Diagnosis and displays / Displays:

The module CI541-DP performs a linearization of the resistance characteristic.

To avoid error messages from unused analog input channels, configure them as "unused".

**Connection of resistance thermometers in 3-wire configuration to the analog inputs**

When resistance thermometers (Pt100, Pt1000, Ni1000) are used, a constant current must flow through them to build the necessary voltage drop for the evaluation. For this, the module CI541-DP provides a constant current source which is multiplexed over the max. 4 analog input channels.

![Diagram of connection](image)

**Fig. 229: Connection of resistance thermometers in 3-wire configuration to the analog inputs AI0 and AI1 (Proceed with the analog inputs AI2 and AI3 in the same way)**

With 3-wire configuration, 2 adjacent analog channels belong together (e.g. the channels 0 and 1). In this case, both channels are configured according to the desired operating mode. The lower address must be the even address (channel 0), the next higher address must be the odd address (channel 1).

The constant current of one channel flows through the resistance thermometer. The constant current of the other channel flows through one of the cores. The module calculates the measured value from the two voltage drops and stores it under the input with the higher channel number (e.g. I1).

In order to keep measuring errors as small as possible, it is necessary to have all the involved conductors in the same cable. All the conductors must have the same cross section.
The following measuring ranges can be configured "Parameterization" on page 1155 "Measuring ranges" on page 1166:

<table>
<thead>
<tr>
<th>Sensor</th>
<th>Range</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pt100</td>
<td>-50 °C ... +400 °C</td>
<td>3-wire configuration, 2 channels used</td>
</tr>
<tr>
<td>Pt1000</td>
<td>-50 °C ... +400 °C</td>
<td>3-wire configuration, 2 channels used</td>
</tr>
<tr>
<td>Ni1000</td>
<td>-50 °C ... +150 °C</td>
<td>3-wire configuration, 2 channels used</td>
</tr>
</tbody>
</table>

The function of the LEDs is described under Diagnosis and displays / Displays "State LEDs" on page 1165.

To avoid error messages from unused analog input channels, configure them as "unused".

Connection of active-type analog sensors (Voltage) with galvanically isolated power supply to the analog inputs

![Connection diagram](image)

**Fig. 230: Connection of active-type analog sensors (voltage) with galvanically isolated power supply to the analog input AI0 (Proceed with the analog inputs AI1 ... AI3 in the same way)**

The following measuring ranges can be configured "Parameterization" on page 1155 "Measuring ranges" on page 1166:

<table>
<thead>
<tr>
<th>Signal</th>
<th>Range</th>
<th>Channels used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>0 V ... 10 V</td>
<td>1 channel used</td>
</tr>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

The function of the LEDs is described under Diagnosis and displays / Displays "State LEDs" on page 1165.

To avoid error messages from unused analog input channels, configure them as "unused".
Connection of active-type analog sensors (Current) with galvanically isolated power supply to the analog inputs

The following measuring ranges can be configured:

<table>
<thead>
<tr>
<th>Current</th>
<th>0 mA ... 20 mA</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>4 mA ... 20 mA</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

The function of the LEDs is described under ‘State LEDs’.

Unused input channels can be left open-circuited, because they are of low resistance.
To avoid error messages through unused analog input channels in measuring range 4 ... 20 mA, these channels should be configured as “Not used”.

Connection of active-type analog sensors (Voltage) with no galvanically isolated power supply to the analog inputs

The following figure shows the connection of active-type analog sensors (voltage) with no galvanically isolated power supply to the analog input AI0. Proceed with the analog inputs AI1 ... AI3 in the same way.

Fig. 231: Connection of active-type analog sensors (current) with galvanically isolated power supply to the analog input AI0 (Proceed with the analog inputs AI1 ... AI3 in the same way)

The following measuring ranges can be configured:

- Chapter 5.2.6.6.1.9 “Parameterization” on page 1155
- Chapter 5.2.6.6.1.12 “Measuring ranges” on page 1166:

<table>
<thead>
<tr>
<th>Current</th>
<th>0 mA ... 20 mA</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>4 mA ... 20 mA</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

The function of the LEDs is described under ‘State LEDs’.

Unused input channels can be left open-circuited, because they are of low resistance.
To avoid error messages through unused analog input channels in measuring range 4 ... 20 mA, these channels should be configured as “Not used”.

Connection of active-type analog sensors (Voltage) with no galvanically isolated power supply to the analog inputs

The following figure shows the connection of active-type analog sensors (voltage) with no galvanically isolated power supply to the analog input AI0. Proceed with the analog inputs AI1 ... AI3 in the same way.
Fig. 232: Connection of active-type analog sensors (voltage) with no galvanically isolated power supply to the analog input AI0 (Proceed with the analog inputs AI1 ... AI3 in the same way)

CAUTION!
Risk of faulty measurements!
The negative pole at the sensors must not have too big a potential difference with respect to ZP (max. ± 1 V).
Make sure that the potential difference never exceeds ± 1 V (also not with long cable lengths).

The following measuring ranges can be configured § Chapter 5.2.6.6.1.9 “Parameterization” on page 1155 § Chapter 5.2.6.6.1.12 “Measuring ranges” on page 1166:

<table>
<thead>
<tr>
<th>Voltage</th>
<th>0 V ... 10 V</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

The function of the LEDs is described under Diagnosis and displays / Displays § Chapter 5.2.6.6.1.11 “State LEDs” on page 1165.

To avoid error messages from unused analog input channels, configure them as "unused".
Connection of passive-type analog sensors (Current) to the analog inputs

![Diagram of passive-type analog sensors connection]

Fig. 233: Connection of passive-type analog sensors (current) to the analog input AI0 (Proceed with the analog inputs AI1 ... AI3 in the same way)

The following measuring ranges can be configured:

- **Current**: 4 mA ... 20 mA, 1 channel used

The function of the LEDs is described under Diagnosis and displays / Displays.

**CAUTION! Risk of overloading the analog input!**

If an analog current sensor supplies more than 25 mA for more than 1 second during initialization, this input is switched off by the module (input protection).

Use only sensors with fast initialization or without current peaks higher than 25 mA. If not possible, connect a 10-volt Zener diode in parallel to AIx+ and ZP.

Unused input channels can be left open-circuited, because they are of low resistance.

To avoid error messages through unused analog input channels in measuring range 4 mA ... 20 mA, these channels should be configured as "Not used".

Connection of active-type analog sensors (Voltage) to differential analog inputs

Differential inputs are very useful, if analog sensors are used which are remotely non-isolated (e.g. the minus terminal is remotely grounded).

The evaluation using differential inputs helps to considerably increase the measuring accuracy and to avoid ground loops.

With differential input configurations, two adjacent analog channels belong together (e.g. the channels 0 and 1). In this case, both channels are configured according to the desired operating mode. The lower address must be the even address (channel 0), the next higher address must be the odd address (channel 1). The converted analog value is available at the higher address (channel 1).
The analog value is calculated by subtraction of the input value with the higher address from the input value of the lower address.

The converted analog value is available at the odd channel (higher address).

**CAUTION!**

Risk of faulty measurements!

The negative pole at the sensors must not have too big a potential difference with respect to ZP (max. ±1 V).

Make sure that the potential difference never exceeds ±1 V.

---

**Fig. 234:** Connection of active-type analog sensors (voltage) to differential analog inputs AI0 and AI1 (Proceed with AI2 and AI3 in the same way)

The following measuring ranges can be configured:

- **Voltage 0 V ... 10 V with differential inputs, 2 channels used**
- **Voltage -10 V ... +10 V with differential inputs, 2 channels used**

The function of the LEDs is described under Diagnosis and displays / Displays.

To avoid error messages from unused analog input channels, configure them as "unused".

**Use of analog inputs as digital inputs**

Several (or all) analog inputs can be configured as digital inputs. The inputs are not galvanically isolated against the other analog channels.
Fig. 235: Connection of digital sensors to the analog input AI0 (Proceed with the analog inputs AI1 ... AI3 in the same way)

The following measuring ranges can be configured \( \text{Chapter 5.2.6.6.1.9 "Parameterization" on page 1155} \) \( \text{Chapter 5.2.6.6.1.12 "Measuring ranges" on page 1166} \):

<table>
<thead>
<tr>
<th>Digital input</th>
<th>24 V</th>
<th>1 channel used</th>
</tr>
</thead>
</table>

The function of the LEDs is described under Diagnosis and displays / Displays \( \text{Chapter 5.2.6.6.1.11 "State LEDs" on page 1165} \).

Connection of analog output loads (Voltage)

Fig. 236: Connection of analog output loads (voltage) to the analog output AO0 (Proceed with the analog output AO1 in the same way)
The following measuring ranges can be configured: "Parameterization" on page 1155 and "Measuring ranges" on page 1166:

<table>
<thead>
<tr>
<th>Voltage</th>
<th>-10 V ... +10 V</th>
<th>Load ± 10 mA max.</th>
<th>1 channel used</th>
</tr>
</thead>
</table>

The function of the LEDs is described under Diagnosis and displays / Displays: "State LEDs" on page 1165.

Unused analog outputs can be left open-circuited.

**Connection of analog output loads (Current)**

![Connection diagram]

*Fig. 237: Connection of analog output loads (current) to the analog output AO0 (Proceed with the analog output AO1 in the same way)*

The following measuring ranges can be configured: "Parameterization" on page 1155 and "Measuring ranges" on page 1166:

<table>
<thead>
<tr>
<th>Current</th>
<th>0 mA ... 20 mA</th>
<th>Load 0 Ω ... 500 Ω</th>
<th>1 channel used</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Current</th>
<th>4 mA ... 20 mA</th>
<th>Load 0 Ω ... 500 Ω</th>
<th>1 channel used</th>
</tr>
</thead>
</table>

The function of the LEDs is described under Diagnosis and displays / Displays: "Diagnosis" on page 1160.

Unused analog outputs can be left open-circuited.

**Internal data exchange**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital inputs (bytes)</td>
<td>3</td>
</tr>
<tr>
<td>Digital outputs (bytes)</td>
<td>3</td>
</tr>
<tr>
<td>Analog inputs (words)</td>
<td>4</td>
</tr>
<tr>
<td>Analog outputs (words)</td>
<td>2</td>
</tr>
</tbody>
</table>
Parameter | Value |
---|---|
Counter input data (words) | 4 |
Counter output data (words) | 8 |

**Addressing**

The module reads the position of the rotary switches only during power-up, i.e. changes of the switch position during operation will have no effect until the next module initialization.

**I/O configuration**

The CI541-DP PROFIBUS DP bus configuration is handled by PROFIBUS DP master with the exception of the slave bus ID (via rotary switches) and the transmission rate (automatic detection).

The analog/digital I/O channels and the fast counter are configured via software.

Details about configuration are described in Parameterization © Chapter 5.2.6.1.9 “Parameterization” on page 1155.

**Parameterization**

**Parameters of the module**

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID ¹)</td>
<td>Internal</td>
<td>0x1C20</td>
<td>WORD</td>
<td>0x1C20</td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal</td>
<td>47</td>
<td>BYTE</td>
<td>47</td>
</tr>
<tr>
<td>Reserved (1 byte)</td>
<td>0</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>Error LED / Fail-safe function (see © Table 253 “Settings &quot;Error LED / Failsafe function&quot; on page 1156)</td>
<td>On</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Off by E4</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off by E3</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>On + failsafe</td>
<td>16</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off by E4 + failsafe</td>
<td>17</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off by E3 + failsafe</td>
<td>18</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reserved (20 bytes)</td>
<td>0</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>Check supply (UP and UP3)</td>
<td>On</td>
<td>0</td>
<td>BYTE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Fast counter</td>
<td>0</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
</tr>
</tbody>
</table>
1) With a faulty ID, the Modules reports a "parameter error" and does not perform cyclic process data transmission.

2) Counter operating modes, see description of the fast counter (\(\$\) Chapter 5.2.4.3.2.9 “Fast counter” on page 606.

Table 253: Settings “Error LED / Failsafe function”

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Error LED (S-ERR) lights up at errors of all error classes, Failsafe mode off</td>
</tr>
<tr>
<td>Off by E4</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1, E2 and E3, Failsafe mode off</td>
</tr>
<tr>
<td>Off by E3</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1 and E2, Failsafe mode off</td>
</tr>
<tr>
<td>On +Failsafe</td>
<td>Error LED (S-ERR) lights up at errors of all error classes, Failsafe mode on *)</td>
</tr>
<tr>
<td>Off by E4 + Failsafe</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1, E2 and E3, Failsafe mode on *)</td>
</tr>
<tr>
<td>Off by E3 + Failsafe</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1 and E2, Failsafe mode on *)</td>
</tr>
</tbody>
</table>

*) The parameters Behaviour analog outputs at communication error and Behaviour digital outputs at communication error are only evaluated if failsafe function is enabled.

Group parameters for the analog part

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog data format</td>
<td>Standard</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Reserved</td>
<td>255</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Behaviour analog outputs at comm-</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>unication error *)</td>
<td>Last value</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Last value 5 s</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Last value 10 s</td>
<td>11</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute value</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute value 5 s</td>
<td>7</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute value 10 s</td>
<td>12</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*) The parameter Behaviour analog outputs at communication error is only analyzed if the Failsafe mode is ON.
### Channel parameters for the analog inputs (4x)

#### General

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input 0, Channel configuration</td>
<td>Operation modes of analog inputs § Table 254 &quot;Operation modes of analog inputs:&quot; on page 1157</td>
<td>Operation modes of analog inputs § Table 254 &quot;Operation modes of analog inputs:&quot; on page 1157</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>Input 0, Check channel</td>
<td>Settings channel monitoring § Further information on page 1158</td>
<td>Settings channel monitoring § Further information on page 1158</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>Input 3, Channel configuration</td>
<td>Operation modes of analog inputs § Table 254 &quot;Operation modes of analog inputs:&quot; on page 1157</td>
<td>Operation modes of analog inputs § Table 254 &quot;Operation modes of analog inputs:&quot; on page 1157</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>Input 3, Check channel</td>
<td>Settings channel monitoring § Further information on page 1158</td>
<td>Settings channel monitoring § Further information on page 1158</td>
<td>BYTE</td>
<td>0</td>
</tr>
</tbody>
</table>

#### Channel configuration

*Table 254: Operation modes of analog inputs:*

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes of the analog inputs, individually configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (default)</td>
<td>Not used</td>
</tr>
<tr>
<td>1</td>
<td>0 ... 10 V</td>
</tr>
<tr>
<td>2</td>
<td>Digital input</td>
</tr>
<tr>
<td>3</td>
<td>0 mA ... 20 mA</td>
</tr>
<tr>
<td>4</td>
<td>4 mA ... 20 mA</td>
</tr>
<tr>
<td>5</td>
<td>-10 V ... +10 V</td>
</tr>
<tr>
<td>8</td>
<td>2-wire Pt100 -50 °C ... +400 °C</td>
</tr>
<tr>
<td>9</td>
<td>3-wire Pt100 -50 °C ... +400 °C *)</td>
</tr>
<tr>
<td>10</td>
<td>0 V ... 10 V (voltage diff.) *)</td>
</tr>
<tr>
<td>11</td>
<td>-10 V ... +10 V (voltage diff.) *)</td>
</tr>
<tr>
<td>14</td>
<td>2-wire Pt100 -50 °C ... +70 °C</td>
</tr>
<tr>
<td>15</td>
<td>3-wire Pt100 -50 °C ... +70 °C *)</td>
</tr>
<tr>
<td>16</td>
<td>2-wire Pt1000 -50 °C ... +400 °C</td>
</tr>
<tr>
<td>17</td>
<td>3-wire Pt1000 -50 °C ... +400 °C *)</td>
</tr>
<tr>
<td>18</td>
<td>2-wire Ni1000 -50 °C ... +150 °C</td>
</tr>
</tbody>
</table>
19 3-wire Ni1000 -50 °C ... +150 °C *)

*) In the operating modes with 3-wire configuration or with differential inputs, two adjacent analog inputs belong together (e.g. the channels 0 and 1). In these cases, both channels are configured in the desired operating mode. The lower address must be the even address (channel 0). The next higher address must be the odd address (channel 1). The converted analog value is available at the higher address (channel 1).

Channel monitoring

Table 255: Table settings channel monitoring:

<table>
<thead>
<tr>
<th>Internal Value</th>
<th>Check Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (default)</td>
<td>Plausibility, cut wire, short circuit</td>
</tr>
<tr>
<td>3</td>
<td>Not used</td>
</tr>
</tbody>
</table>

Channel parameters for the analog outputs (2x)

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output 0, Channel config-</td>
<td>Operation modes of analog outputs</td>
<td>Operation modes of analog outputs</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>uration</td>
<td>Table 256 “Table operation modes of analog</td>
<td>Table 256 “Table operation modes of analog outputs:”</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>outputs:” on page 1159</td>
<td>on page 1159</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Output 0, Check channel</td>
<td>Channel monitoring</td>
<td>Channel monitoring</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Table 257 “Table channel monitoring:”</td>
<td>Table 257 “Table channel monitoring:”</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>on page 1159</td>
<td>on page 1159</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Output 0, Substitute value</td>
<td>Substitute value</td>
<td>Substitute value</td>
<td>WORD</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Table 258 “Table substitute value:”</td>
<td>Table 258 “Table substitute value:”</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>on page 1159</td>
<td>on page 1159</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Output 1, Channel config-</td>
<td>Operation modes of analog outputs</td>
<td>Operation modes of analog outputs</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>uration</td>
<td>Table 256 “Table operation modes of analog</td>
<td>Table 256 “Table operation modes of analog outputs:”</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>outputs:” on page 1159</td>
<td>on page 1159</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Output 1, Check channel</td>
<td>Channel monitoring</td>
<td>Channel monitoring</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Table 257 “Table channel monitoring:”</td>
<td>Table 257 “Table channel monitoring:”</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>on page 1159</td>
<td>on page 1159</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Output 1, Substitute value</td>
<td>Substitute value</td>
<td>Substitute value</td>
<td>WORD</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Table 258 “Table substitute value:”</td>
<td>Table 258 “Table substitute value:”</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>on page 1159</td>
<td>on page 1159</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Channel configuration

**Table 256: Table operation modes of analog outputs:**

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes of the analog outputs, individually configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (default)</td>
<td>Not used</td>
</tr>
<tr>
<td>128</td>
<td>-10 V ... +10 V</td>
</tr>
<tr>
<td>129</td>
<td>0 mA ... 20 mA</td>
</tr>
<tr>
<td>130</td>
<td>4 mA ... 20 mA</td>
</tr>
</tbody>
</table>

### Channel monitoring

**Table 257: Table channel monitoring:**

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Check channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Plausibility, cut wire, short circuit</td>
</tr>
<tr>
<td>3</td>
<td>None</td>
</tr>
</tbody>
</table>

### Substitute value

**Table 258: Table substitute value:**

<table>
<thead>
<tr>
<th>Intended behavior of output channel when the control system stops</th>
<th>Required setting of the module parameter &quot;Behaviour of outputs in case of a communication error&quot;</th>
<th>Required setting of the channel parameter &quot;Substitute value&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output OFF</td>
<td>Off</td>
<td>0</td>
</tr>
<tr>
<td>Last value infinite</td>
<td>Last value</td>
<td>0</td>
</tr>
<tr>
<td>Last value for 5 s and then turn off</td>
<td>Last value 5 sec</td>
<td>0</td>
</tr>
<tr>
<td>Last value for 10 s and then turn off</td>
<td>Last value 10 sec</td>
<td>0</td>
</tr>
<tr>
<td>Substitute value infinite</td>
<td>Substitute value</td>
<td>depending on configuration</td>
</tr>
<tr>
<td>Substitute value for 5 s and then turn off</td>
<td>Substitute value 5 sec</td>
<td>depending on configuration</td>
</tr>
<tr>
<td>Substitute value for 10 s and then turn off</td>
<td>Substitute value 10 sec</td>
<td>depending on configuration</td>
</tr>
</tbody>
</table>

### Group parameters for the digital part

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input delay</td>
<td>0.1 ms</td>
<td>0</td>
<td>BYTE</td>
<td>0.1 ms</td>
</tr>
<tr>
<td></td>
<td>1 ms</td>
<td>1</td>
<td></td>
<td>0x00</td>
</tr>
<tr>
<td></td>
<td>8 ms</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>32 ms</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Detect short circuit at outputs</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>On</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td></td>
<td>0x01</td>
</tr>
</tbody>
</table>
### Behaviour digital outputs at communication error

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>Off 0x00</td>
</tr>
<tr>
<td></td>
<td>Last value</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Last value 5 sec</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Last value 10 sec</td>
<td>11</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute value</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute value 5 sec</td>
<td>7</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute value 10 sec</td>
<td>12</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1) The parameters Behaviour digital outputs at communication error is only analyzed if the Failsafe-mode is ON.

2) The state "externally voltage detected" appears, if the output of a channel DC0 ... DC7 should be switched on while an externally voltage is connected. In this case the start up is disabled, as long as the externally voltage is connected. The monitoring of this state and the resulting diagnosis message can be disabled by setting the parameters to "OFF".

### Substitute value at output

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0 ... 255</td>
<td>00h ... FFh</td>
<td>BYTE</td>
<td>Off 0x00</td>
</tr>
</tbody>
</table>

### Detect voltage overflow at outputs

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>Off 0x00</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Diagnosis

Structure of the diagnosis block via DPM_SLV_DIAG function block.

<table>
<thead>
<tr>
<th>Byte Number</th>
<th>Description</th>
<th>Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Data length (header included)</td>
<td>7</td>
</tr>
<tr>
<td>2</td>
<td>PROFIBUS DP V1 coding: Vendor specific</td>
<td>129</td>
</tr>
<tr>
<td>3</td>
<td>Diagnosis Byte, slot number</td>
<td>31 = CI541-DP (e. g. error at integrated 8 DI / 8 DO)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = 1st connected S500 I/O Module</td>
</tr>
<tr>
<td></td>
<td></td>
<td>...</td>
</tr>
<tr>
<td></td>
<td></td>
<td>10 = 10th connected S500 I/O Module</td>
</tr>
<tr>
<td>4</td>
<td>Diagnosis Byte, module number</td>
<td>According to the I/O bus specification passed on by modules to the fieldbus master</td>
</tr>
<tr>
<td>5</td>
<td>Diagnosis Byte, channel</td>
<td>According to the I/O bus specification passed on by modules to the fieldbus master</td>
</tr>
</tbody>
</table>
### Byte Number Description Possible Values

| 6 | Diagnosis Byte, error code | According to the I/O bus specification  
|   | Bit 7 and bit 6, coded error class  
|   | 0 = E1  
|   | 1 = E2  
|   | 2 = E3  
|   | 3 = E4  
|   | Bit 0 to bit 5, coded error description |

| 7 | Diagnosis Byte, flags | According to the I/O bus specification  
|   | Bit 7: 1 = coming error  
|   | Bit 6: 1 = leaving error |

In cases of short circuit or overload, the digital outputs are turned off. The modules performs reactivation automatically. Thus an acknowledgement of the errors is not necessary. The error message is stored via the LED.

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier 000 ... 063</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error-Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
</table>

**Module errors**

<table>
<thead>
<tr>
<th>3</th>
<th>-</th>
<th>31</th>
<th>31</th>
<th>31</th>
<th>19</th>
<th>Checksum error in the I/O module</th>
<th>Replace I/O module</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>3</td>
<td>Timeout in the I/O module</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>40</td>
<td>Different hard-/firmware versions in the module</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>43</td>
<td>Internal error in the module</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>36</td>
<td>Internal data exchange failure</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>9</td>
<td>Overflow diagnosis buffer</td>
<td>Restart</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>26</td>
<td>Parameter error</td>
<td>Check master</td>
</tr>
<tr>
<td>Class</td>
<td>Interface</td>
<td>Device</td>
<td>Module</td>
<td>Channel</td>
<td>Error-Identifier</td>
<td>Error Message</td>
<td>Remedy</td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>--------</td>
<td>--------</td>
<td>---------</td>
<td>------------------</td>
<td>---------------</td>
<td>--------</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>11</td>
<td>Process voltage UP too low</td>
<td>Check process supply voltage</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>45</td>
<td></td>
<td>Process voltage UP gone</td>
<td>Check process supply voltage</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31/1...10</td>
<td>31</td>
<td>31</td>
<td>17</td>
<td>No communication with I/O device</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>31</td>
<td>32</td>
<td>Wrong I/O module type on socket</td>
<td>Replace I/O module / Check configuration</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>At least one module does not support failsafe function</td>
<td>Check modules and parameterization</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>5</td>
<td>8</td>
<td>I/O module removed from hot swap terminal unit or defective module on hot swap terminal unit 9)</td>
<td>Plug I/O module, replace I/O module</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>5</td>
<td>28</td>
<td>Wrong I/O module plugged on hot swap terminal unit 9)</td>
<td>Remove wrong I/O module and plug projected I/O module</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>5</td>
<td>42</td>
<td>No communication with I/O module on hot swap terminal unit 9)</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>Class</td>
<td>Interface</td>
<td>Device</td>
<td>Module</td>
<td>Channel</td>
<td>Error-Identifier</td>
<td>Error message</td>
<td>Remedy</td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>--------</td>
<td>--------</td>
<td>---------</td>
<td>------------------</td>
<td>---------------</td>
<td>--------</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>5</td>
<td>54</td>
<td>I/O module does not support hot swap 6) 5)</td>
<td>Power off system and replace I/O module</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>6</td>
<td>8</td>
<td>Hot swap terminal unit configured but not found</td>
<td>Replace terminal unit by hot swap terminal unit</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>6</td>
<td>42</td>
<td>No communication with hot swap terminal unit 9)</td>
<td>Restart, if error persists replace terminal unit</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>46</td>
<td>Reverse voltage from digital outputs DO0...DO7 to UP3 4)</td>
<td>Check connection</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31/1...10</td>
<td>31</td>
<td>31</td>
<td>34</td>
<td>No response during initialization of the I/O module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>11</td>
<td>Process voltage UP3 too low</td>
<td>Check process supply voltage</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>45</td>
<td>Process voltage UP3 gone</td>
<td>Check process supply voltage</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>10</td>
<td>Voltage overflow on outputs (above UP3 level) 5)</td>
<td>Check terminals/ check process supply voltage</td>
</tr>
</tbody>
</table>
### Hardware descriptions

#### Device specifications > Communication interface modules

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier 000 ... 063</th>
<th>AC500-Display</th>
<th>Display in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Comp</td>
<td>Dev</td>
<td>Mod</td>
<td>Ch</td>
<td>Err</td>
<td>PS501 PLC Browser</td>
<td></td>
</tr>
<tr>
<td>Byte 6</td>
<td>Bit</td>
<td>6 ... 7</td>
<td>Byte 3</td>
<td>Byte 4</td>
<td>Byte 5</td>
<td>Byte 6 Bit 0 ... 5</td>
<td>PROFIB US DP diagnosis block</td>
</tr>
</tbody>
</table>

#### Class Interface Device Module Channel Error-Identifier Error message Remedy

#### Channel error digital

| 4 |-| 31 | 2 | 0...7 | 46 | Externally voltage detected on digital output DO0...DO7 6) | Check terminals |
| 4 |-| 31 | 2 | 0...7 | 47 | Short circuit at digital output 7) | Check terminals |

#### Channel error analog

| 4 |-| 31 | 1 | 0...3 | 48 | Analog value overflow or broken wire at an analog input | Check value or check terminals |
| 4 |-| 31 | 1 | 0...3 | 7 | Analog value underflow at an analog input | Check value |
| 4 |-| 31 | 1 | 0...3 | 47 | Short-circuit at an analog input | Check terminals |
| 4 |-| 31 | 1 | 0...1 | 4 | Analog value overflow at an analog output | Check output value |
| 4 |-| 31 | 1 | 0...1 | 7 | Analog value underflow at an analog output | Check output value |

#### Remarks:

1) In AC500 the following interface identifier applies:
   "=" = Diagnosis via bus-specific function blocks; 0...4 or 10 = Position of the Communication Module; 14 = I/O bus; 31 = Module itself
   The identifier is not contained in the CI541-DP diagnosis block.

2) With "Device" the following allocation applies: 31 = Module itself; 1...10 = Expansion module

3) With "Module" the following allocation applies:
   31 = Module itself
   Channel error: Module type (1 = AI, 2 = DO, 3 = AO)
This message appears, if externally voltages at one or more terminals DO0...DO7 cause that other digital outputs are supplied through that voltage (voltage feedback, see description in section 'Connection' Chapter 5.2.6.6.1.5 “Connections” on page 1139). All outputs of the apply digital output groups will be turned off for 5 seconds. The diagnosis message appears for the whole output group.

The voltage on digital outputs DO0 ... DO7 has overrun the process supply voltage UP3 (see description in section 'Connection' Chapter 5.2.6.6.1.5 “Connections” on page 1139). Diagnosis message appears for the whole module.

This message appears, if the output of a channel DO0 ... DO7 should be switched on while an externally voltage is connected. In this case the start up is disabled, as long as the externally voltage is connected. Otherwise this could produce reverse voltage from this output to other digital outputs. This diagnosis message appears per channel.

Short circuit: After a detected short circuit, the output is deactivated for 100ms. Then a new start up will be executed. This diagnosis message appears per channel.

In case of an I/O module doesn’t support hot swapping, do not perform any hot swap operations (also not on any other terminal units (slots)) as modules may be damaged or I/O bus communication may be disturbed.

Diagnosis for hot swap available as of version index F0.

**State LEDs**

The LEDs are located at the front of module. There are 2 different groups:

- The 5 system LEDs (PWR, STA1-DP, STA2-DP, S-ERR and I/O-Bus) show the operation state of the module and display possible errors.
- The 27 process LEDs (UP, UP3, inputs, outputs, CH-ERR1 to CH-ERR3) show the process supply voltage and the states of the inputs and outputs and display possible errors.

**Table 259: States of the 5 system LEDs:**

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>OFF</th>
<th>ON</th>
<th>Flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR/RUN</td>
<td>Green</td>
<td>Process supply voltage missing</td>
<td>Internal supply voltage OK, module ready for communication with I/O Controller</td>
<td>Start-up / preparing communication</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>STA1-DP</td>
<td>Green</td>
<td>---</td>
<td>PROFIBUS running</td>
<td>Invalid device parameters</td>
</tr>
<tr>
<td>STA2-DP</td>
<td>Red</td>
<td>No error</td>
<td>Bus timeout</td>
<td>No communication to master</td>
</tr>
<tr>
<td>S-ERR</td>
<td>Red</td>
<td>No error</td>
<td>Internal error</td>
<td>---</td>
</tr>
<tr>
<td>I/O-Bus</td>
<td>Green</td>
<td>No communication interface modules connected or communication error</td>
<td>Communication interface modules connected and operational</td>
<td>---</td>
</tr>
</tbody>
</table>
Table 260: States of the 27 process LEDs:

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>OFF</th>
<th>ON</th>
<th>Flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>AI0 to AI3</td>
<td>Yellow</td>
<td>Input is OFF</td>
<td>Input is ON (brightness depends on the value of the analog signal)</td>
<td>--</td>
</tr>
<tr>
<td>AO0 to AO1</td>
<td>Yellow</td>
<td>Output is OFF</td>
<td>Output is ON (brightness depends on the value of the analog signal)</td>
<td>--</td>
</tr>
<tr>
<td>DI0 to DI7</td>
<td>Yellow</td>
<td>Input is OFF</td>
<td>Input is ON (the input voltage is even displayed if the supply voltage is OFF)</td>
<td>--</td>
</tr>
<tr>
<td>DO0 to DO7</td>
<td>Yellow</td>
<td>Output is OFF</td>
<td>Output is ON</td>
<td>--</td>
</tr>
<tr>
<td>UP</td>
<td>Green</td>
<td>Process supply voltage missing</td>
<td>Process supply voltage OK and initialization finished</td>
<td>--</td>
</tr>
<tr>
<td>UP3</td>
<td>Green</td>
<td>Process supply voltage missing</td>
<td>Process supply voltage OK</td>
<td>--</td>
</tr>
<tr>
<td>CH-ERR1 to CH-ERR3</td>
<td>Red</td>
<td>No error or process supply voltage missing</td>
<td>Internal error</td>
<td>Error on one channel of the corresponding group</td>
</tr>
</tbody>
</table>

Measuring ranges

Input ranges voltage, current and digital input

<table>
<thead>
<tr>
<th>Range</th>
<th>0 V ... +10 V</th>
<th>-10 V ... +10 V</th>
<th>0 mA ... 20 mA</th>
<th>4 mA ... 20 mA</th>
<th>Digital input</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Decimal</td>
<td>Hex.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overflow</td>
<td>&gt; 11.7589</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Measured value too high</td>
<td>&gt; 11.7589</td>
<td>&gt; 23.5178</td>
<td>&gt; 22.8142</td>
<td></td>
<td></td>
<td>32767</td>
</tr>
<tr>
<td>Normal range</td>
<td>10.0000</td>
<td>0.0004</td>
<td>20.0000</td>
<td>20.0000</td>
<td>On</td>
<td>27648</td>
</tr>
<tr>
<td>Normal range or measured value too low</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0</td>
<td>4</td>
<td>Off</td>
<td>0000</td>
</tr>
<tr>
<td></td>
<td>-0.0004</td>
<td>-10.0000</td>
<td>3.9994</td>
<td>1.1858</td>
<td>-1</td>
<td>-27648</td>
</tr>
</tbody>
</table>
### Input ranges resistance temperature detector

<table>
<thead>
<tr>
<th>Range</th>
<th>Pt100 / Pt1000 -50 ... +70 °C</th>
<th>Pt100 / Pt1000 -50 ... +400 °C</th>
<th>Ni1000 -50 ... +150 °C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measured value too high</td>
<td>+450.0 °C : + 400.1 °C</td>
<td>+150.0 °C : +0.1 °C</td>
<td>+160.0 °C : +150.1 °C</td>
</tr>
<tr>
<td>Normal range</td>
<td>0.0 °C : -0.1 °C : -50.0 °C</td>
<td>0.0 °C : -0.1 °C : -50.0 °C</td>
<td></td>
</tr>
<tr>
<td>Measured value too low</td>
<td>-50.1 °C : -60.0 °C</td>
<td>-50.1 °C : -60.0 °C</td>
<td></td>
</tr>
<tr>
<td>Underflow</td>
<td>-60.0 °C</td>
<td>-60.0 °C</td>
<td>-60.0 °C</td>
</tr>
</tbody>
</table>

### Measured value too low

- Underflow: -60.0 °C
- Measured value too low: -50.1 °C, -60.0 °C
- Measured value too high: +450.0 °C, +400.1 °C
- Normal range: 0.0 °C, -0.1 °C, -50.0 °C
- Overflow: > +80.0 °C, > +450.0 °C, > +160.0 °C

### Hardware descriptions

Device specifications > Communication interface modules

---

The represented resolution corresponds to 16 bits.
### Range vs Digital value

<table>
<thead>
<tr>
<th>Range</th>
<th>Decimal</th>
<th>Hex.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Normal range</td>
<td>4000</td>
<td>0FA0</td>
</tr>
<tr>
<td></td>
<td>1500</td>
<td>05DC</td>
</tr>
<tr>
<td></td>
<td>700</td>
<td>02BC</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Measured value too low</td>
<td>-501</td>
<td>FE0B</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Underflow</td>
<td>-32768</td>
<td>8000</td>
</tr>
</tbody>
</table>

### Output ranges voltage and current

<table>
<thead>
<tr>
<th>Range</th>
<th>-10...+10 V</th>
<th>0...20 mA</th>
<th>4...20 mA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overlow</td>
<td>&gt;11.7589 V</td>
<td>&gt;23.5178 mA</td>
<td>&gt;22.8142 mA</td>
</tr>
<tr>
<td>Measured value too high</td>
<td>11.7589 V</td>
<td>23.5178 mA</td>
<td>22.8142 mA</td>
</tr>
<tr>
<td></td>
<td>10.0004 V</td>
<td>20.0007 mA</td>
<td>20.0006 mA</td>
</tr>
<tr>
<td>Normal range</td>
<td>10.0000 V</td>
<td>20.0000 mA</td>
<td>20.0000 mA</td>
</tr>
<tr>
<td></td>
<td>0.0004 V</td>
<td>0.0007 mA</td>
<td>4.0006 mA</td>
</tr>
<tr>
<td></td>
<td>0.0000 V</td>
<td>0.0000 mA</td>
<td>4.0000 mA</td>
</tr>
<tr>
<td></td>
<td>-0.0004 V</td>
<td>0 mA</td>
<td>3.9994 mA</td>
</tr>
<tr>
<td></td>
<td>-10.0000 V</td>
<td>0 mA</td>
<td>0 mA</td>
</tr>
<tr>
<td>Measured value too low</td>
<td>-10.0004 V</td>
<td>0 mA</td>
<td>0 mA</td>
</tr>
<tr>
<td></td>
<td>-11.7589 V</td>
<td>0 mA</td>
<td>0 mA</td>
</tr>
<tr>
<td>Underflow</td>
<td>0 V</td>
<td>0 mA</td>
<td>0 mA</td>
</tr>
<tr>
<td>Range</td>
<td>Digital value</td>
<td>Decimal</td>
<td>Hex</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------</td>
<td>---------</td>
<td>------</td>
</tr>
<tr>
<td>Overflow</td>
<td>&gt; 32511</td>
<td>&gt; 7EFF</td>
<td></td>
</tr>
<tr>
<td>Measured value too high</td>
<td>32511</td>
<td>7EFF</td>
<td></td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>27649</td>
<td>6C01</td>
<td></td>
</tr>
<tr>
<td>Normal range</td>
<td>27648</td>
<td>6C00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>0001</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>0000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>-1</td>
<td>FFFF</td>
<td></td>
</tr>
<tr>
<td></td>
<td>-6912</td>
<td>E500</td>
<td></td>
</tr>
<tr>
<td></td>
<td>-27648</td>
<td>9400</td>
<td></td>
</tr>
<tr>
<td>Measured value too low</td>
<td>-27649</td>
<td>93FF</td>
<td></td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>-32512</td>
<td>8100</td>
<td></td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt; -32512</td>
<td>&lt; 8100</td>
<td></td>
</tr>
</tbody>
</table>

The represented resolution corresponds to 16 bits.

Technical data

Technical data of the module

The system data of AC500 and S500 are applicable to the standard version “System data AC500” on page 166.

The system data of AC500-XC are applicable to the XC version “System data AC500-XC” on page 169.

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltages UP/UP3</td>
<td></td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC (for inputs and outputs)</td>
</tr>
<tr>
<td>Max. load for the terminals</td>
<td>10 A</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse on UP/UP3</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>PROFIBUS interface against the rest of the module</td>
</tr>
<tr>
<td>Inrush current from UP (at power up)</td>
<td>On request</td>
</tr>
<tr>
<td>Current consumption via UP (normal operation)</td>
<td>0.2 A</td>
</tr>
<tr>
<td>Current consumption via UP3</td>
<td>0.06 A + 0.5 A max. per output</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Connections</td>
<td>Terminals 2.8 and 3.8 for +24 V (UP)</td>
</tr>
<tr>
<td></td>
<td>Terminal 4.8 for +24 V (UP3)</td>
</tr>
<tr>
<td></td>
<td>Terminals 2.9, 3.9 and 4.9 for 0 V (ZP)</td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>6 W</td>
</tr>
<tr>
<td>Configurable digital inputs/outputs</td>
<td>8</td>
</tr>
<tr>
<td>Number of digital inputs</td>
<td>8</td>
</tr>
<tr>
<td>Number of digital outputs</td>
<td>8</td>
</tr>
<tr>
<td>Reference potential for all digital inputs and</td>
<td>Negative pole of the supply voltage, signal name ZP</td>
</tr>
<tr>
<td>outputs</td>
<td></td>
</tr>
<tr>
<td>Setting of the PROFIBUS DP identifier</td>
<td>With 2 rotary switches at the front side of the module</td>
</tr>
<tr>
<td>Diagnose</td>
<td>See Diagnosis ( \text{Chapter} \ 5.2.6.6.1.10 \text{ &quot;Diagnosis&quot; on page 1160} )</td>
</tr>
<tr>
<td>Operation and error displays</td>
<td>32 LEDs (totally)</td>
</tr>
<tr>
<td>Weight (without terminal unit)</td>
<td>Ca. 125 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal</td>
</tr>
<tr>
<td></td>
<td>Or vertical with derating (output load reduced to 50 % at +40 °C per group)</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>

**NOTICE!**

All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

**Multiple overloads**

No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an internal smart high-side switch.

### Technical data of the digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels DI0 ... DI7</td>
<td>Terminals 3.0 ... 3.7</td>
</tr>
<tr>
<td>Reference potential for all inputs</td>
<td>Terminals 2.9 ... 4.9 (negative pole of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel, the LED is ON when the input signal is high (signal 1)</td>
</tr>
<tr>
<td>Input type (according EN 61131-2)</td>
<td>Type 1</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 0.1 ms, configurable from 0.1 ms ... 32 ms</td>
</tr>
</tbody>
</table>
### Technical data of the digital outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels DO0 ... DO7</td>
<td>Terminals 4.0 ... 4.7</td>
</tr>
<tr>
<td>Reference potential for all outputs</td>
<td>Terminals 2.9 ... 4.9 (negative pole of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>For all outputs terminal 4.8 (positive pole of the supply voltage, signal name UP3)</td>
</tr>
<tr>
<td>Output voltage for signal 1</td>
<td>UP3 (-0.8 V)</td>
</tr>
<tr>
<td>Output delay (0-&gt;1 or 1-&gt;0)</td>
<td>On request</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated value per channel</td>
<td>500 mA at UP3 = 24 V</td>
</tr>
<tr>
<td>Max. value (all channels together)</td>
<td>4 A</td>
</tr>
<tr>
<td>Leakage current with signal 0</td>
<td>&lt; 0.5 mA</td>
</tr>
<tr>
<td>Fuse for UP3</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Demagnetization with inductive DC load</td>
<td>Via internal varistors (see figure below this table)</td>
</tr>
<tr>
<td>Output switching frequency</td>
<td></td>
</tr>
<tr>
<td>With resistive load</td>
<td>On request</td>
</tr>
<tr>
<td>With inductive loads</td>
<td>Max. 0.5 Hz</td>
</tr>
<tr>
<td>With lamp loads</td>
<td>11 Hz max. at 5 W max.</td>
</tr>
<tr>
<td>Short-circuit-proof / overload-proof</td>
<td>Yes</td>
</tr>
<tr>
<td>Overload message (I &gt; 0.7 A)</td>
<td>Yes, after ca. 100 ms</td>
</tr>
</tbody>
</table>
### Technical data of the analog inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>4</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group with 4 channels</td>
</tr>
<tr>
<td>Connection if channels AI0+ ... AI3+</td>
<td>Terminals 2.0 ... 2.3</td>
</tr>
<tr>
<td>Reference potential for AI0+ ... AI3+</td>
<td>Terminal 2.4 (AI-) for voltage and RTD measurement</td>
</tr>
<tr>
<td></td>
<td>Terminal 2.9, 3.9 and 4.9 for current measurement</td>
</tr>
<tr>
<td>Input type</td>
<td></td>
</tr>
<tr>
<td>Unipolar</td>
<td>Voltage 0 V ... 10 V, current or Pt100/Pt1000/Ni1000</td>
</tr>
<tr>
<td>Bipolar</td>
<td>Voltage -10 V ... +10 V</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Against PROFIBUS</td>
</tr>
<tr>
<td>Configurability</td>
<td>0 V ... 10 V, -10 V ... +10 V, 0/4 mA ... 20 mA, Pt100/1000, Ni1000 (each input can be configured individually)</td>
</tr>
<tr>
<td>Channel input resistance</td>
<td>Voltage: &gt; 100 kΩ</td>
</tr>
<tr>
<td></td>
<td>Current: ca. 330 Ω</td>
</tr>
<tr>
<td>Time constant of the input filter</td>
<td>Voltage: 100 µs</td>
</tr>
<tr>
<td></td>
<td>Current: 100 µs</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 LED per channel (brightness depends on the value of the analog signal)</td>
</tr>
</tbody>
</table>
### Technical data of the analog inputs if used as digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>Max. 4</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group of 4 channels</td>
</tr>
<tr>
<td>Connections of the channels AI0+ ... AI3+</td>
<td>Terminals 2.0 ... 2.3</td>
</tr>
<tr>
<td>Reference potential for the inputs</td>
<td>Terminals 2.9, 3.9 and 4.9 (ZP)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 LED per channel</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-30 V ... +5 V</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>+5 V ... +15 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>+15 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 7 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>Typ. 1.4 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>Typ. 3.7 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 9 mA</td>
</tr>
<tr>
<td>Input resistance</td>
<td>Ca. 3.5 kΩ</td>
</tr>
</tbody>
</table>

### Technical data of the analog outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>2</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group for 2 channels</td>
</tr>
</tbody>
</table>
**Parameter** | **Value**
--- | ---
Connection of the channels AO0+ ... AO1+ | Terminals 2.5 ... 2.6
Reference potential for AO0+ ... AO1+ | Terminal 2.7 (AO-) for voltage output
 | Terminal 2.9, 3.9 and 4.9 for current output
Output type | 
 | Unipolar: Current
 | Bipolar: Voltage
Galvanic isolation | Against PROFIBUS
Configurability | -10 V ... +10 V, 0 mA ... 20 mA, 4 mA ... 20 mA (each output can be configured individually)
Output resistance (load), as current output | 0 Ω ... 500 Ω
Output loadability, as voltage output | ± 10 mA max.
Indication of the output signals | 1 LED per channel (brightness depends on the value of the analog signal)
Resolution | 12 bits including sign
Settling time for full range change (resistive load, output signal within specified tolerance) | Typ. 5 ms
Conversion error of the analog values caused by non-linearity, adjustment error at factory and resolution within the normal range | Typ. 0.5 %, max. 1 %
Relationship between input signal and hex code | Table Output Ranges Voltage and Current
 | “Output ranges voltage and current” on page 1168
Unused outputs | Are configured as "unused" (default value) and can be left open-circuited

**Technical data of the fast counter**

| Parameter | Value |
--- | ---
Used inputs | Terminal 3.0 (DI0), 3.1 (DI1)
Used outputs | Terminal 4.0 (DO0)
Counting frequency | Depending on operation mode:
 | Mode 1 - 6: max. 200 kHz
 | Mode 7: max. 50 kHz
 | Mode 9: max. 35 kHz
 | Mode 10: max. 20 kHz

* Chapter 6.8.2.12 “Fast counters in AC500 devices” on page 4536
**Dimensions**

The dimensions are in mm and in brackets in inch.

1. Din rail 15 mm
2. Din rail 7.5 mm

**Ordering data**

<table>
<thead>
<tr>
<th>Ordering No.</th>
<th>Scope of delivery</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 224 100 R0001</td>
<td>CI541-DP, PROFINET communication interface module, 8 DI, 8 DO, 4 AI and 2 AO</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 424 100 R0001</td>
<td>CI541-DP-XC, PROFINET communication interface module, 8 DI, 8 DO, 4 AI and 2 AO, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
5.2.6.6.2 CI542-DP

Features

- 8 digital inputs 24 V DC
- 8 digital outputs 24 V DC, 0.5 A max.
- 8 configurable digital inputs/outputs 24 V DC, 0.5 A max.
- Module-wise galvanically isolated
- Fast counter
- XC version for usage in extreme ambient conditions available
Intended purpose

The PROFIBUS DP communication interface module is used as decentralized I/O module in PROFIBUS networks. Depending on the used terminal unit the network connection is performed either via 9-pole female D-sub or via 10 terminals (screw-type or spring terminals) which are integrated in the terminal unit.

The inputs/outputs are galvanically isolated from the PROFIBUS network. There is no potential separation between the channels. The configuration of the configurable digital inputs/outputs is performed by software.

For usage in extreme ambient conditions (e.g. wider temperature and humidity range), a special XC version of the device is available.

Diagnosis settings

The current CI54x does not run in combination with a V3 PLC if in the “General” tab the parameter “Diagnosis behavior” is set to “AC500 V3 compatible”. How to change the setting in your AB project is described below.

1. Double click in the “Device” tree on “CI541_IO”.
   ⇒ The tab for the various settings opens.
2. Double click on the “General” tab.
3. Double click on the “Value” of the parameter “Diagnosis behavior”.
4. Click on the small arrow.
   ⇒ A submenu with two values opens.
5. Click on “AC500 V2 compatible” as setting.
6. Close the tab.

After changing the parameter to “AC500 V2 compatible” the CI54x get in “RUN”.

If the CI54x indicates a S500 diagnosis message, following AC500 diagnosis entry (“655374 CI54x communication interface module is sending not supported diagnosis format - Check configuration and FW revision of communication interface module”) is shown in the diagnosis editor and history. This diagnosis message does not have impact to cyclic data exchange between the master and the CI54x.

In case of a parameter change from V2 to V3 the parameter at the CI54x of V3 has the same value than at the CI54x below V2 (that means AC500 V2 compatible).
Connections
General

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The PROFIBUS DP communication interface module CI542-DP is plugged on the I/O terminal units TU509 \(\text{\&} \) Chapter 5.2.7.3 “TU509 and TU510 for communication interface modules” on page 1274 or TU510 \(\text{\&} \) Chapter 5.2.7.3 “TU509 and TU510 for communication interface modules” on page 1274 and accordingly TU517 \(\text{\&} \) Chapter 5.2.7.4 “TU517 and TU518 for communication interface modules” on page 1278 or TU518 \(\text{\&} \) Chapter 5.2.7.4 “TU517 and TU518 for communication interface modules” on page 1278. Properly seat the module and press until it locks in place. The terminal unit is mounted on a DIN rail or with 2 screws plus the additional accessory for wall mounting \(\text{\&} \) Chapter 5.2.8.2.5 “TA526 - Wall mounting accessory” on page 1324.

The connection of the I/O channels is carried out using the 30 terminals of the I/O terminal unit. I/O modules can be replaced without re-wiring the terminal units.

The terminals 2.8 and 3.8 as well as 2.9, 3.9 and 4.9 are electrically interconnected within the terminal unit and have always the same assignment, independent of the inserted module:

Terminals 2.8 and 3.8: Process supply voltage UP = +24 V DC
Terminal 4.8: Process supply voltage UP3 = +24 V DC
Terminals 2.9, 3.9 and 4.9: Process supply voltage ZP = 0 V

With a separate UP3 power supply, the digital outputs can be switched off externally. This way, an emergency-off functionality can be realized.

Do not connect any voltages externally to digital outputs!
This is not intended usage.
Reason: Externally voltages at one or more terminals DC0...DC7 or DO0...DO7 may cause that other digital outputs are supplied through that voltage instead of voltage UP3 (reverse voltage).
This is also possible, if DC channels are used as inputs. For this, the source for the input signals should be the impressed UP3 of the device.
This limitation does not apply for the input channels DI0...DI7.

CAUTION!
Risk of malfunction by unintended usage!
If the function cut-off of the digital outputs is to be used by deactivation of the supply voltage UP3, be sure that no external voltage is connected at the outputs DO0...DO7 and DC0...DC7.

Possibilities of connection
Assignment

Mounting on terminal units TU509 or TU510:
The assignment of the 9-pole female D-sub for the PROFIBUS DP signals.
### Serial Interface

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>2</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>3</td>
<td>B</td>
<td>PROFIBUS DP signal B</td>
</tr>
<tr>
<td>4</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>5</td>
<td>DGND</td>
<td>Ground for 5 V power supply</td>
</tr>
<tr>
<td>6</td>
<td>VP (5 V)</td>
<td>5 V power supply</td>
</tr>
<tr>
<td>7</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>8</td>
<td>A</td>
<td>PROFIBUS DP signal A</td>
</tr>
<tr>
<td>9</td>
<td>---</td>
<td>Reserved</td>
</tr>
<tr>
<td>Shield</td>
<td>Cable shield</td>
<td>Functional earth</td>
</tr>
</tbody>
</table>

### Bus termination

The line ends of the bus segment must be equipped with bus terminating resistors. Normally, these resistors are integrated in the interface connectors.

- VP (+5 V) 6 390 Ohms
- Data Line B RxD/TxD-P 3 220 Ohms
- Data Line A RxD/TxD-N 8 390 Ohms
- GND (0 V) 5

*The grounding of the shield should take place at the control cabinet, see System-Data AC500 % Chapter 5.1.2 “System data AC500” on page 166.*

Mounting on terminal units TU517 or TU518:

The assignment of the terminals 1.0 - 1.9:

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>B</td>
<td>Data line B (receive and send line, positive)</td>
</tr>
<tr>
<td>1.1</td>
<td>B</td>
<td>Data line B (receive and send line, positive)</td>
</tr>
<tr>
<td>1.2</td>
<td>A</td>
<td>Data line A (receive and send line, negative)</td>
</tr>
<tr>
<td>1.3</td>
<td>A</td>
<td>Data line A (receive and send line, negative)</td>
</tr>
<tr>
<td>1.4</td>
<td>TermB</td>
<td>Bus termination data line B</td>
</tr>
<tr>
<td>1.5</td>
<td>TermB</td>
<td>Bus termination data line B</td>
</tr>
<tr>
<td>1.6</td>
<td>TermA</td>
<td>Bus termination data line A</td>
</tr>
<tr>
<td>Terminal</td>
<td>Signal</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>---------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>1.7</td>
<td>TermA</td>
<td>Bus termination data line A</td>
</tr>
<tr>
<td>1.8</td>
<td>DGND</td>
<td>Reference potential for data transmission</td>
</tr>
<tr>
<td>1.9</td>
<td>DGND</td>
<td>Reference potential for data transmission</td>
</tr>
</tbody>
</table>

At the line ends of a bus segment, terminating resistors must be connected. If using TU517/TU518, the bus terminating resistors can be enabled by connecting the terminals TermA and TermB to the data lines A and B (no external terminating resistors are required, see figure below).
If using TU517/TU518, note that the terminating resistors are not located inside the TU, but inside the communication interface module CI541-DP. I. e. when removing the device from the TU, the bus terminating resistors are not connected to the bus any more. The bus itself will not be disconnected if a device is removed.

If using TU517/TU518 the max. permitted transmission rate is limited to 1.5 MBaud.

Technical data bus cable

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Twisted pair (shielded)</td>
</tr>
<tr>
<td>Characteristic impedance</td>
<td>135 Ω...165 Ω</td>
</tr>
<tr>
<td>Cable capacitance</td>
<td>&lt; 30 pF/m</td>
</tr>
<tr>
<td>Conductor diameter of the cores</td>
<td>≥ 0.64 mm</td>
</tr>
<tr>
<td>Conductor cross section of the cores</td>
<td>≥ 0.34 mm²</td>
</tr>
<tr>
<td>Cable resistance per core</td>
<td>≤ 55 Ω/km</td>
</tr>
<tr>
<td>Loop resistance (resistance of two cores)</td>
<td>≤ 110 Ω/km</td>
</tr>
</tbody>
</table>

Cable length

The maximum possible cable length of a PROFIBUS subnet within a segment depends on the transmission rate (baud rate).

<table>
<thead>
<tr>
<th>Transmission rate</th>
<th>Maximum cable length</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.6 kBaud to 93.75 kBaud</td>
<td>1200 m</td>
</tr>
<tr>
<td>187.5 kBaud</td>
<td>1000 m</td>
</tr>
<tr>
<td>500 kBaud</td>
<td>400 m</td>
</tr>
<tr>
<td>1.5 MBaud</td>
<td>200 m</td>
</tr>
<tr>
<td>3 MBaud to 12 MBaud</td>
<td>100 m</td>
</tr>
</tbody>
</table>

The assignment of the other terminals:

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0</td>
<td>DC0</td>
<td>Signal of the configurable digital input/output DC0</td>
</tr>
<tr>
<td>2.1</td>
<td>DC1</td>
<td>Signal of the configurable digital input/output DC1</td>
</tr>
<tr>
<td>2.2</td>
<td>DC2</td>
<td>Signal of the configurable digital input/output DC2</td>
</tr>
<tr>
<td>2.3</td>
<td>DC3</td>
<td>Signal of the configurable digital input/output DC3</td>
</tr>
<tr>
<td>2.4</td>
<td>DC4</td>
<td>Signal of the configurable digital input/output DC4</td>
</tr>
<tr>
<td>2.5</td>
<td>DC5</td>
<td>Signal of the configurable digital input/output DC5</td>
</tr>
<tr>
<td>2.6</td>
<td>DC6</td>
<td>Signal of the configurable digital input/output DC6</td>
</tr>
<tr>
<td>2.7</td>
<td>DC7</td>
<td>Signal of the configurable digital input/output DC7</td>
</tr>
</tbody>
</table>
### Terminal Signal Description

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.8</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>2.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
<tr>
<td>3.0</td>
<td>DI8</td>
<td>Signal of the digital input DI8</td>
</tr>
<tr>
<td>3.1</td>
<td>DI9</td>
<td>Signal of the digital input DI9</td>
</tr>
<tr>
<td>3.2</td>
<td>DI10</td>
<td>Signal of the digital input DI10</td>
</tr>
<tr>
<td>3.3</td>
<td>DI11</td>
<td>Signal of the digital input DI11</td>
</tr>
<tr>
<td>3.4</td>
<td>DI12</td>
<td>Signal of the digital input DI12</td>
</tr>
<tr>
<td>3.5</td>
<td>DI13</td>
<td>Signal of the digital input DI13</td>
</tr>
<tr>
<td>3.6</td>
<td>DI14</td>
<td>Signal of the digital input DI14</td>
</tr>
<tr>
<td>3.7</td>
<td>DI15</td>
<td>Signal of the digital input DI15</td>
</tr>
<tr>
<td>3.8</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>3.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
<tr>
<td>4.0</td>
<td>DO8</td>
<td>Signal of the digital output DO8</td>
</tr>
<tr>
<td>4.1</td>
<td>DO9</td>
<td>Signal of the digital output DO9</td>
</tr>
<tr>
<td>4.2</td>
<td>DO10</td>
<td>Signal of the digital output DO10</td>
</tr>
<tr>
<td>4.3</td>
<td>DO11</td>
<td>Signal of the digital output DO11</td>
</tr>
<tr>
<td>4.4</td>
<td>DO12</td>
<td>Signal of the digital output DO12</td>
</tr>
<tr>
<td>4.5</td>
<td>DO13</td>
<td>Signal of the digital output DO13</td>
</tr>
<tr>
<td>4.6</td>
<td>DO14</td>
<td>Signal of the digital output DO14</td>
</tr>
<tr>
<td>4.7</td>
<td>DO15</td>
<td>Signal of the digital output DO15</td>
</tr>
<tr>
<td>4.8</td>
<td>UP3</td>
<td>Process voltage UP3 (24 V DC)</td>
</tr>
<tr>
<td>4.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
</tbody>
</table>

#### WARNING!

**Removal/Insertion under power**

The devices are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you

- connect or disconnect any signal or terminal block
- remove, mount or replace a module.

Disconnecting any powered devices while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The devices must not be opened when in operation. The same applies to the network interfaces.
**NOTICE!**

**Risk of damaging the PLC modules!**

Overvoltages and short circuits might damage the PLC modules.

- Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
- Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

---

**Fig. 238: Connection of the PROFIBUS DP communication interface module CI542-DP**
Connection of the digital inputs

Fig. 239: Connection of the digital input DI8 (Proceed with the digital inputs DI9 to DI15 in the same way)

The meaning of the LEDs is described in Displays Chapter 5.2.6.2.10 “State LEDs” on page 1193.
Connection of the digital outputs

![Diagram of digital output connections]

Fig. 240: Connection of the digital output DO8 (Proceed with the digital outputs DO9 - DO15 in the same way)

The meaning of the LEDs is described in Displays "Chapter 5.2.6.6.10 "State LEDs" on page 1193.

Connection of the configurable digital inputs/outputs

![CAUTION!]

CAUTION!
If a DC channel is used as input, the source for the input signals should be the impressed UP3 of the device "Chapter 5.2.6.6.2.4 "Connections" on page 1178."
Fig. 241: Connection of the configurable digital input/output DC0 and DC1 (Proceed with the configurable digital inputs/outputs DC2 to DC7 in the same way)

The meaning of the LEDs is described in Displays § Chapter 5.2.6.6.2.10 “State LEDs” on page 1193.

Internal data exchange

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital inputs (bytes)</td>
<td>5</td>
</tr>
<tr>
<td>Digital outputs (bytes)</td>
<td>5</td>
</tr>
<tr>
<td>Counter input data (words)</td>
<td>4</td>
</tr>
<tr>
<td>Counter output data (words)</td>
<td>8</td>
</tr>
</tbody>
</table>

Addressing

The module reads the position of the rotary switches only during power-up, i.e. changes of the switch position during operation will have no effect until the next module initialization.
I/O configuration

The CI542-DP PROFIBUS DP bus configuration is handled by PROFIBUS DP master with the exception of the slave bus ID (via rotary switches) and the transmission rate (automatic detection).

The digital I/O channels and the fast counter are configured via software. Details about configuration are described in Parameterization.

Parameterization

Parameters of the module

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID 1)</td>
<td>Internal</td>
<td>0x1C25</td>
<td>WORD</td>
<td>0x1C25</td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal</td>
<td>31</td>
<td>BYTE</td>
<td>31</td>
</tr>
<tr>
<td>Reserved (1 byte)</td>
<td>0</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>Error LED / Fail-safe function</td>
<td>On</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Off by E4</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off by E3</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>On + failsafe</td>
<td>16</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off by E4 + failsafe</td>
<td>17</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off by E3 + failsafe</td>
<td>18</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reserved (20 bytes)</td>
<td>0</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>Check supply</td>
<td>On</td>
<td>0</td>
<td>BYTE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>1</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Fast counter</td>
<td>0</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>10 2)</td>
<td>10</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1) With a faulty ID, the module reports a "parameter error" and does not perform cyclic process data transmission.

2) Counter operating modes, see 'Fast Counter' Chapter 5.2.4.3.2.9 "Fast counter" on page 606.

Table 261: Settings “Error LED / Failsafe function”

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Error LED (S-ERR) lights up at errors of all error classes, Failsafe mode off</td>
</tr>
<tr>
<td>Off by E4</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1, E2 and E3, Failsafe mode off</td>
</tr>
<tr>
<td>Off by E3</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1 and E2, Failsafe mode off</td>
</tr>
<tr>
<td>On + Failsafe</td>
<td>Error LED (S-ERR) lights up at errors of all error classes, Failsafe mode on *)</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Off by E4 + Failsafe</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1, E2 and E3, Failsafe mode on *)</td>
</tr>
<tr>
<td>Off by E3 + Failsafe</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1 and E2, Failsafe mode on *)</td>
</tr>
</tbody>
</table>

*) The parameter Behaviour DO at comm. error is only analyzed if the Failsafe mode is ON.

### Group parameters for the digital part

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input delay</td>
<td>0.1 ms</td>
<td>0</td>
<td>BYTE</td>
<td>0.1 ms 0x00</td>
</tr>
<tr>
<td></td>
<td>1 ms</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 ms</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>32 ms</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Detect short circuit at outputs</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>On 0x01</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Behaviour DO at comm. error ¹)</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>Off 0x00</td>
</tr>
<tr>
<td></td>
<td>Last value</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Last value 5 sec</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Last value 10 sec</td>
<td>11</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute value</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute value 5 sec</td>
<td>7</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute value 10 sec</td>
<td>12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Substitute value at output</td>
<td>0 ... 65535</td>
<td>0000h ... FFFFh</td>
<td>WORD</td>
<td>0 0x0000</td>
</tr>
<tr>
<td>Preventive voltage feedback monitoring for DC0 ... DC7 ²)</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>Off 0x00</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Detect voltage overflow at outputs ³)</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>Off 0x00</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Remarks:
1) The parameter Behaviour DO at comm. error is apply to DC and DO channels and only analyzed if the Failsafe-mode is ON.

2) The state "externally voltage detected" appears, if the output of a channel DC0 ... DC7 should be switched on while an externally voltage is connected. In this case the start up is disabled, as long as the externally voltage is connected. The monitoring of this state and the resulting diagnosis message can be disabled by setting the parameters to "OFF".

3) The error state "voltage overflow at outputs" appears, if externally voltage at digital outputs DC0 ... DC7 and accordingly DO0 ... DO7 has exceeded the process supply voltage UP3. The according diagnosis message "Voltage overflow on outputs " can be disabled by setting the parameters on "OFF". This parameter should only be disabled in exceptional cases for voltage overflow may produce reverse voltage.

### Diagnosis

Structure of the diagnosis block via DPM_SLV_DIAG function block.

<table>
<thead>
<tr>
<th>Byte Number</th>
<th>Description</th>
<th>Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Data length (header included)</td>
<td>7</td>
</tr>
<tr>
<td>2</td>
<td>PROFIBUS DP V1 coding: Vendor specific</td>
<td>129</td>
</tr>
<tr>
<td>3</td>
<td>Diagnosis Byte, slot number</td>
<td>31 = CI542-DP (e.g. error at integrated 8 DI / 8 DO)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = 1st connected S500 I/O module</td>
</tr>
<tr>
<td></td>
<td></td>
<td>...</td>
</tr>
<tr>
<td></td>
<td></td>
<td>10 = 10th connected S500 I/O module</td>
</tr>
<tr>
<td>4</td>
<td>Diagnosis Byte, module number</td>
<td>According to the I/O bus specification passed on by modules to the fieldbus master</td>
</tr>
<tr>
<td>5</td>
<td>Diagnosis Byte, channel</td>
<td>According to the I/O bus specification passed on by modules to the fieldbus master</td>
</tr>
<tr>
<td>6</td>
<td>Diagnosis Byte, error code</td>
<td>According to the I/O bus specification</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bit 7 and bit 6, coded error class</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 = E1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = E2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 = E3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 = E4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bit 0 to bit 5, coded error description</td>
</tr>
<tr>
<td>7</td>
<td>Diagnosis Byte, flags</td>
<td>According to the I/O bus specification</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bit 7: 1 = coming error</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bit 6: 1 = leaving error</td>
</tr>
</tbody>
</table>

In cases of short circuit or overload, the digital outputs are turned off. The modules performs reactivation automatically. Thus an acknowledgement of the errors is not necessary. The error message is stored via the LED.
<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier</th>
<th>AC500-Display</th>
<th>&lt;- Display in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Comp</td>
<td>Dev</td>
<td>Mod</td>
<td>Ch</td>
<td>Err</td>
<td>PS501 PLC Browser</td>
<td></td>
</tr>
<tr>
<td>Byte 6 Bit 6 ... 7</td>
<td>Byte 3</td>
<td>Byte 4</td>
<td>Byte 5</td>
<td>Byte 6 Bit 0 ... 5</td>
<td>PROFIBUS DP diagnosis block</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Class</td>
<td>Interface</td>
<td>Device</td>
<td>Module</td>
<td>Channel</td>
<td>Error-Identifier</td>
<td>Error message</td>
<td>Remedy</td>
</tr>
<tr>
<td>1)</td>
<td>2)</td>
<td>3)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Module errors

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error-Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>19</td>
<td>Checksum error in the I/O module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>3</td>
<td>Timeout in the I/O module</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>40</td>
<td>Different hard-/firmware versions in the module</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>43</td>
<td>Internal error in the module</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>36</td>
<td>Internal data exchange failure</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>9</td>
<td>Overflow diagnosis buffer</td>
<td>Restart</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>26</td>
<td>Parameter error</td>
<td>Check master</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>11</td>
<td>Process voltage UP too low</td>
<td>Check process supply voltage</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>45</td>
<td>Process voltage UP gone</td>
<td>Check process supply voltage</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>17</td>
<td>No communication with I/O module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>31</td>
<td>32</td>
<td>Wrong I/O module type on socket</td>
<td>Replace I/O module / Check configuration</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>At least one module does not support failsafe function</td>
<td>Check modules and parameterization</td>
</tr>
<tr>
<td>Class</td>
<td>Interface</td>
<td>Device</td>
<td>Module</td>
<td>Channel</td>
<td>Error-Identifier</td>
<td>Error message</td>
<td>Remedy</td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>--------</td>
<td>--------</td>
<td>---------</td>
<td>-----------------</td>
<td>--------------</td>
<td>--------</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>5</td>
<td>8</td>
<td>I/O module removed from hot swap terminal unit or defective module on hot swap terminal unit</td>
<td>Plug I/O module, replace I/O module</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>5</td>
<td>28</td>
<td>Wrong I/O module plugged on hot swap terminal unit</td>
<td>Remove wrong I/O module and plug projected I/O module</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>5</td>
<td>42</td>
<td>No communication with I/O module on hot swap terminal unit</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>5</td>
<td>54</td>
<td>I/O module does not support hot swap</td>
<td>Power off system and replace I/O module</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>6</td>
<td>8</td>
<td>Hot swap terminal unit configured but not found</td>
<td>Replace terminal unit by hot swap terminal unit</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>6</td>
<td>42</td>
<td>No communication with hot swap terminal unit</td>
<td>Restart, if error persists replace terminal unit</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>45</td>
<td></td>
<td>Process voltage UP3 too low</td>
<td>Check process voltage</td>
</tr>
<tr>
<td>Class</td>
<td>Interface</td>
<td>Device</td>
<td>Module</td>
<td>Channel</td>
<td>Error-Identifier</td>
<td>Error message</td>
<td>Remedy</td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>--------</td>
<td>--------</td>
<td>---------</td>
<td>------------------</td>
<td>---------------</td>
<td>--------</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>46</td>
<td>Reverse voltage from digital outputs DO0..DO7 to UP3</td>
<td>Check terminals</td>
</tr>
<tr>
<td>4</td>
<td>31/1...10</td>
<td>31</td>
<td>31</td>
<td>34</td>
<td></td>
<td>No response during initialization of the I/O module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>11</td>
<td></td>
<td>Process voltage UP3 too low</td>
<td>Check process supply voltage</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>45</td>
<td></td>
<td>Process voltage UP3 gone</td>
<td>Check process supply voltage</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>10</td>
<td></td>
<td>Voltage overflow at outputs (above UP3 level)</td>
<td>Check terminals/ check process supply voltage</td>
</tr>
</tbody>
</table>

Channel error digital

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error-Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>2</td>
<td>8...15</td>
<td>46</td>
<td>Externally voltage detected at digital output DO0 ... DO7</td>
<td>Check terminals</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>4</td>
<td>0...7</td>
<td>46</td>
<td>Externally voltage detected at digital output DC0 ... DC7</td>
<td>Check terminals</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>4</td>
<td>0...7</td>
<td>47</td>
<td>Short circuit at digital output DC0 ... DC7</td>
<td>Check terminals</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>2</td>
<td>8...15</td>
<td>47</td>
<td>Short circuit at digital output DO0 ... DO7</td>
<td>Check terminals</td>
</tr>
</tbody>
</table>

Remarks:
In AC500 the following interface identifier applies:

- \(".\) = Diagnosis via bus-specific function blocks; 0 ... 4 or 10 = Position of the Communication Module; 14 = I/O bus; 31 = Module itself

The identifier is not contained in the CI542-DP diagnosis block.

With "Device" the following allocation applies: 31 = Module itself, 1..10 = expansion module

With "Module" the following allocation applies dependent of the master:

Module error: 31 = Module itself
Channel error: Module type (1 = AI, 2 = DO, 3 = AO)

This message appears, if externally voltages at one or more terminals DC0 ... DC7 oder DO0 ... DO7 cause that other digital outputs are supplied through that voltage.

All outputs of the apply digital output groups will be turned off for 5 seconds. The diagnosis message appears for the whole output group.

The voltage at digital outputs DC0 .. DC7 and accordingly DO0 ... DO7 has exceeded the process supply voltage UP3. Diagnosis message appears for the whole module.

This message appears, if the output of a channel DC0 ... DC7 or DO0 ... DO7 should be switched on while an externally voltage is connected. In this case the start up is disabled, as long as the externally voltage is connected. Otherwise this could produce reverse voltage from this output to other digital outputs. This diagnosis message appears per channel.

Short circuit: After a detected short circuit, the output is deactivated for 100ms. Then a new start up will be executed. This diagnosis message appears per channel.

In case of an I/O module doesn’t support hot swapping, do not perform any hot swap operations (also not on any other terminal units (slots)) as modules may be damaged or I/O bus communication may be disturbed.

Diagnosis for hot swap available as of version index F0.

---

### State LEDs

The LEDs are located at the front of module. There are 2 different groups:

- The 5 system LEDs (PWR, STA1 DP, STA2 DP, S-ERR and I/O-Bus) show the operation state of the module and display possible errors.
- The 29 process LEDs (UP, UP3, inputs, outputs, CH-ERR1 to CH-ERR3) show the process supply voltage and the states of the inputs and outputs and display possible errors.

---

**Table 262: States of the 5 system LEDs:**

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>OFF</th>
<th>ON</th>
<th>Flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR/RUN</td>
<td>Green</td>
<td>Process supply voltage missing</td>
<td>Internal supply voltage OK, module ready for communication with I/O Controller</td>
<td>Start-up / preparing communication</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>STA1-DP</td>
<td>Green</td>
<td>---</td>
<td>PROFIBUS running</td>
<td>Invalid device parameters</td>
</tr>
</tbody>
</table>
Table 263: States of the 29 process LEDs:

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>OFF</th>
<th>ON</th>
<th>Flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>STA2-DP</td>
<td>Red</td>
<td>No error</td>
<td>Bus timeout</td>
<td>No communication to master</td>
</tr>
<tr>
<td>S-ERR</td>
<td>Red</td>
<td>No error</td>
<td>Internal error</td>
<td>--</td>
</tr>
<tr>
<td>I/O-Bus</td>
<td>Green</td>
<td>No communication interface modules connected or communication error</td>
<td>Communication interface module connected and operational</td>
<td>---</td>
</tr>
</tbody>
</table>

Table 263: States of the 29 process LEDs:

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>OFF</th>
<th>ON</th>
<th>Flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC0 ... DC7</td>
<td>Yellow</td>
<td>Input/Output is OFF</td>
<td>Input/Output is ON</td>
<td>--</td>
</tr>
<tr>
<td>DI8 ... DI15</td>
<td>Yellow</td>
<td>Input is OFF</td>
<td>Input is ON (the input voltage is even displayed if the supply voltage is OFF)</td>
<td>--</td>
</tr>
<tr>
<td>DO8 ... DO15</td>
<td>Yellow</td>
<td>Output is OFF</td>
<td>Output is ON</td>
<td>--</td>
</tr>
<tr>
<td>UP</td>
<td>Green</td>
<td>Process supply voltage missing</td>
<td>Process supply voltage OK and initialization finished</td>
<td>--</td>
</tr>
<tr>
<td>UP3</td>
<td>Green</td>
<td>Process supply voltage missing</td>
<td>Process supply voltage OK</td>
<td>--</td>
</tr>
<tr>
<td>CH-ERR1 to CH-ERR3</td>
<td>Red</td>
<td>No error or process supply voltage missing</td>
<td>Internal error</td>
<td>Error on one channel of the corresponding group</td>
</tr>
</tbody>
</table>

Technical data

Technical data of the module

The system data of AC500 and S500 are applicable to the standard version Chapter 5.1.2 “System data AC500” on page 166.

The system data of AC500-XC are applicable to the XC version Chapter 5.1.3 “System data AC500-XC” on page 169.

Only additional details are therefore documented below.
The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltages UP/UP3</td>
<td></td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC (for inputs and outputs)</td>
</tr>
<tr>
<td>Max. load for the terminals</td>
<td>10 A</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse on UP/UP3</td>
<td>10 A fast</td>
</tr>
</tbody>
</table>
### Technical data

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Galvanic isolation</td>
<td>PROFIBUS interface against the rest of the module</td>
</tr>
<tr>
<td>Inrush current from UP (at power up)</td>
<td>On request</td>
</tr>
<tr>
<td>Current consumption via UP (normal operation)</td>
<td>0.2 A</td>
</tr>
<tr>
<td>Current consumption via UP3</td>
<td>0.06 A + 0.5 A max. per output</td>
</tr>
</tbody>
</table>
| Connections | Terminals 2.8 and 3.8 for +24 V (UP)  
Terminal 4.8 for +24 V (UP3)  
Terminals 2.9, 3.9 and 4.9 for 0 V (ZP) |
| Max. power dissipation within the module | 6 W |
| Number of digital inputs | 8 |
| Number of digital outputs | 8 |
| Number of analog inputs | 4 |
| Number of analog outputs | 2 |
| Reference potential for all digital inputs and outputs | Negative pole of the supply voltage, signal name ZP |
| Setting of the PROFIBUS DP identifier | With 2 rotary switches at the front side of the module |
| Diagnose | See Diagnosis Chapter 5.2.6.6.2.9 “Diagnosis” on page 1189 |
| Operation and error displays | 34 LEDs (totally) |
| Weight (without terminal unit) | Ca. 125 g |
| Mounting position | Horizontal  
Or vertical with derating (output load reduced to 50 % at +40 °C per group) |
| Cooling | The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet. |

### NOTICE!
All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

### Multiple overloads
No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an internal smart high-side switch.

### Technical data of the digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Terminals of the channels DI0 ... DI7</td>
<td>Terminals 3.0 ... 3.7</td>
</tr>
<tr>
<td>Reference potential for all inputs</td>
<td>Terminals 2.9 ... 4.9 (negative pole of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel, the LED is ON when the input signal is high (signal 1)</td>
</tr>
<tr>
<td>Input type (according EN 61131-2)</td>
<td>Type 1</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 0.1 ms, configurable from 0.1 ms ... 32 ms</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-3 V ... +5 V</td>
</tr>
<tr>
<td>Undefined Signal</td>
<td>&gt; +5 V ... &lt; +15 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>+15 V ... +30 V</td>
</tr>
<tr>
<td>Ripple with signal 0</td>
<td>Within -3 V ... +5 V</td>
</tr>
<tr>
<td>Ripple with signal 1</td>
<td>Within +15 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 5 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>&gt; 1 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>&gt; 2 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 8 mA</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

**Technical data of the digital outputs**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels DO0 ... DO7</td>
<td>Terminals 4.0 ... 4.7</td>
</tr>
<tr>
<td>Reference potential for all outputs</td>
<td>Terminals 2.9 ... 4.9 (negative pole of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>For all outputs terminal 4.8 (positive pole of the supply voltage, signal name UP3)</td>
</tr>
<tr>
<td>Output voltage for signal 1</td>
<td>UP3 (-0.8 V)</td>
</tr>
<tr>
<td>Output delay (0-&gt;1 or 1-&gt;0)</td>
<td>On request</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated value per channel</td>
<td>500 mA at UP3 = 24 V</td>
</tr>
<tr>
<td>Max. value (all channels together)</td>
<td>4 A</td>
</tr>
<tr>
<td>Leakage current with signal 0</td>
<td>&lt; 0.5 mA</td>
</tr>
<tr>
<td>Fuse for UP3</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Demagnetization with inductive DC load</td>
<td>Via internal varistors (see figure below this table)</td>
</tr>
<tr>
<td>Output switching frequency</td>
<td></td>
</tr>
</tbody>
</table>
### Technical data of the configurable digital inputs/outputs

Each of the configurable I/O channels is defined as input or output by the user program. This is done by interrogating or allocating the corresponding channel.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8 inputs/outputs (with transistors)</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group for 8 channels</td>
</tr>
<tr>
<td>If the channels are used as inputs</td>
<td></td>
</tr>
<tr>
<td>Channels DC0 ... DC07</td>
<td>Terminals 2.0 ... 2.7</td>
</tr>
<tr>
<td>If the channels are used as outputs</td>
<td></td>
</tr>
<tr>
<td>Channels DC0 ... DC07</td>
<td>Terminals 2.0 ... 2.7</td>
</tr>
<tr>
<td>Indication of the input/output signals</td>
<td>1 yellow LED per channel, the LED is ON when the input/output signal is high (signal 1)</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>From the PROFINET network</td>
</tr>
</tbody>
</table>
**Technical data of the digital inputs/outputs if used as inputs**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels DC0 ... DC7</td>
<td>Terminals 2.0 .... 2.7</td>
</tr>
<tr>
<td>Reference potential for all inputs</td>
<td>Terminals 2.9 ... 4.9 (negative pole of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel, the LED is ON when the input signal is high (signal 1)</td>
</tr>
<tr>
<td>Input type (according EN 61131-2)</td>
<td>Type 1</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 0.1 ms, configurable from 0.1 ms ... 32 ms</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td><strong>Signal 0</strong></td>
<td>-3 V ... +5 V</td>
</tr>
<tr>
<td><strong>Undefined Signal</strong></td>
<td>&gt; +5 V ... &lt; +15 V</td>
</tr>
<tr>
<td><strong>Signal 1</strong></td>
<td>+15 V ... +30 V</td>
</tr>
<tr>
<td>Ripple with signal 0</td>
<td>Within -3 V ... +5 V</td>
</tr>
<tr>
<td>Ripple with signal 1</td>
<td>Within +15 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 5 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>&gt; 1 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>&gt; 2 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 8 mA</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

*) Due to the direct connection to the output, the demagnetizing varistor is also effective at the input (see figure) above. This is why the difference between UPx and the input signal may not exceed the clamp voltage of the varistor. The varistor limits the voltage to approx. 36 V. Following this, the input voltage must range from -12 V ... +30 V when UPx = 24 V and from -6 V ... +30 V when UPx = 30 V.

**Technical data of the digital inputs/outputs if used as outputs**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels DC0 ... DC7</td>
<td>Terminals 2.0 .... 2.7</td>
</tr>
<tr>
<td>Reference potential for all outputs</td>
<td>Terminals 2.9 ... 4.9 (negative pole of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>For all outputs terminal 4.8 (positive pole of the supply voltage, signal name UP3)</td>
</tr>
<tr>
<td>Output voltage for signal 1</td>
<td>UP3 (-0.8 V)</td>
</tr>
<tr>
<td>Output delay (0-&gt;1 or 1-&gt;0)</td>
<td>On request</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
</tbody>
</table>
## Technical data of the fast counter

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Used inputs</td>
<td>Terminal 3.0 (DI0), Terminal 3.1 (DI1)</td>
</tr>
<tr>
<td>Used outputs</td>
<td>Terminal 4.0 (DO0)</td>
</tr>
<tr>
<td>Counting frequency</td>
<td>Depending on operation mode:</td>
</tr>
<tr>
<td></td>
<td>Mode 1-6: max. 200 kHz</td>
</tr>
<tr>
<td></td>
<td>Mode 7: max. 50 kHz</td>
</tr>
<tr>
<td></td>
<td>Mode 9: max. 35 kHz</td>
</tr>
<tr>
<td></td>
<td>Mode 10: max. 20 kHz</td>
</tr>
</tbody>
</table>

Chapter 6.8.2.12 “Fast counters in AC500 devices” on page 4536
Dimensions

1 Din rail 15 mm
2 Din rail 7.5 mm

*The dimensions are in mm and in brackets in inch.*

Ordering Data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 224 200 R0001</td>
<td>CI542-DP, PROFIBUS DP communication interface module, 8 DI, 8 DO and 8 DC</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 424 200 R0001</td>
<td>CI542-DP-XC, PROFIBUS DP communication interface module, 8 DI, 8 DO and 8 DC, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
5.2.6.7 PROFINET

5.2.6.7.1 Comparison of the CI5xx-PNIO modules

The PROFINET IO devices combine the advantages of decentralized I/O modules with the reaction time of AC500 mounted central I/O modules. The devices for PROFINET provide the extension -PNIO in the device name.

The communication module CM579-PNIO acts as I/O controller in a PROFINET network. It is connected to the processor module via an internal communication bus. Depending on the terminal base, several communication modules can be used for one processor module.

The communication interface modules CI5xx-PNIO act as I/O devices in a PROFINET network. Additionally the communication module CM589-PNIO(-4) can be used to setup a AC500 PLC to act as I/O module in a PROFINET network.

The difference of the CI5xx-PNIO devices can be found in their input and output characteristics Chapter 5.2.6.7.1.1 “Characteristics of CI50x-PNIO” on page 1201.

Characteristics of CI50x-PNIO

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bus connection</td>
<td>2 x RJ45</td>
</tr>
<tr>
<td>Switch</td>
<td>Integrated</td>
</tr>
<tr>
<td>Technology</td>
<td>Hilscher NETX 100</td>
</tr>
<tr>
<td>Transfer rate</td>
<td>10/100 Mbit/s (full-duplex)</td>
</tr>
<tr>
<td>Transfer method</td>
<td>According to Ethernet II, IEEE 802.3</td>
</tr>
<tr>
<td>Ethernet</td>
<td>100 base-TX, internal switch, 2x RJ45 socket</td>
</tr>
<tr>
<td>Expandability</td>
<td>Max. 10 S500 I/O modules</td>
</tr>
<tr>
<td>Adjusting elements</td>
<td>2 rotary switches for generation of an explicit name</td>
</tr>
<tr>
<td>Supported protocols</td>
<td>RTC - real time cyclic protocol, class 1 *)</td>
</tr>
<tr>
<td></td>
<td>RTA - real time acyclic protocol</td>
</tr>
<tr>
<td></td>
<td>DCP - discovery and configuration protocol</td>
</tr>
<tr>
<td></td>
<td>CL-RPC - connectionless remote procedure Call</td>
</tr>
<tr>
<td></td>
<td>LLDP - link layer discovery protocol</td>
</tr>
<tr>
<td></td>
<td>MRP - MRP Client</td>
</tr>
<tr>
<td>Acyclic services</td>
<td>PNIO read / write sequence (max. 1024 bytes per telegram)</td>
</tr>
<tr>
<td></td>
<td>Process-Alarm service</td>
</tr>
<tr>
<td>Supported alarm types</td>
<td>Process Alarm, Diagnostic Alarm, Return of SubModule, Plug Alarm, Pull Alarm</td>
</tr>
<tr>
<td>Min. bus cycle</td>
<td>1 ms</td>
</tr>
</tbody>
</table>
### Input/Output characteristics of CI501-PNIO

The PROFINET communication interface module CI501-PNIO is used as decentralized I/O module in PROFINET networks. The network connection is performed via 2 RJ45 connectors which are integrated in the terminal unit. The communication interface module contains 22 I/O channels with the following properties:

- 4 analog inputs (1.0 ... 1.3), configurable as:
  - -10 V ... +10 V
  - 0 V ... +10 V
  - -10 V ... +10 V (differential voltage)
  - 0 mA ... 20 mA
  - 4 mA ... 20 mA
  - Pt100, Pt1000, Ni1000 (for each 2-wire and 3-wire)
  - 24 V digital input function
- 2 analog outputs (1.5 ... 1.6), configurable as:
  - -10 V ... +10 V
  - 0 mA ... 20 mA
  - 4 mA ... 20 mA
- 8 digital inputs 24 V DC in 1 group (2.0 ... 2.7)
- 8 digital transistor outputs 24 V DC (0.5 A max.) in 1 group (3.0 ... 3.7)
- Resolution of the analog channels: 12 bits

The inputs/outputs are galvanically isolated from the Ethernet network. There is no potential separation between the channels. The configuration of the analog inputs/outputs is performed by software.

For usage in enhanced ambient conditions (e.g. wider temperature and humidity range), a special XC version of the device is available.

### Input/Output characteristics of CI502-PNIO

- 8 digital inputs 24 V DC
- 8 digital transistor outputs 24 V DC, 0.5 A max.
- 8 configurable digital inputs/outputs 24 V DC, 0.5 A max.
- Module-wise galvanically isolated
- XC version for usage in extreme ambient conditions available
Technical data of the serial interfaces of CI504-PNIO

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of serial interfaces</td>
<td>3</td>
</tr>
<tr>
<td>Connectors for serial interfaces</td>
<td>X11 for COM1</td>
</tr>
<tr>
<td></td>
<td>X12 for COM2</td>
</tr>
<tr>
<td></td>
<td>X13 for COM3</td>
</tr>
<tr>
<td>Supported physical layers</td>
<td>RS-232</td>
</tr>
<tr>
<td></td>
<td>RS-422</td>
</tr>
<tr>
<td></td>
<td>RS-485</td>
</tr>
<tr>
<td>Supported protocols</td>
<td>ASCII</td>
</tr>
<tr>
<td>Transmission rate</td>
<td>Configurable from 300 bit/s to 115.200 bit/s</td>
</tr>
</tbody>
</table>

5.2.6.7.2 CI501-PNIO

Features

- 4 analog inputs, 2 analog outputs, 8 digital inputs, 8 digital outputs
- Resolution 12 bits including sign
- Module-wise galvanically isolated
- Fast counter
- XC version for usage in extreme ambient conditions available
1 I/O bus
2 Allocation between terminal number and signal name
3 6 yellow LEDs to display the signal states of the analog inputs/outputs (AI0 ... AI3, AO0 ... AO1)
4 8 yellow LEDs to display the signal states of the digital inputs (DI0 ... DI7)
5 8 yellow LEDs to display the signal states of the digital outputs (DO0 ... DO7)
6 2 green LEDs to display the process supply voltage UP and UP3
7 3 red LEDs to display errors (CH-ERR1, CH-ERR2, CH-ERR3)
8 5 system LEDs: PWR/RUN, STA1 ETH, STA2 ETH, S-ERR, I/O-Bus
9 Label
10 2 rotary switches for setting the I/O device identifier
11 Ethernet interfaces (ETH1, ETH2) on the terminal unit
12 Terminal unit
13 DIN rail
* Sign for XC version
Intended purpose

The PROFINET communication interface modules CI501-PNIO and CI502-PNIO are used as communication interface modules in PROFINET networks. The network connection is performed by Ethernet cables which are inserted in the RJ45 connectors in the terminal unit. An Ethernet switch in the communication interface module allows daisy chaining of the network.

For usage in enhanced ambient conditions (e.g. wider temperature and humidity range), a special XC version of the device is available.

Functionality

The communication interface module contains 22 I/O channels with the following properties:

- 4 configurable analog inputs (2-wire / single-ended) or 2 configurable analog inputs (3-wire / differential) (1.0 ... 1.3)
- 2 analog outputs (1.5 ... 1.6)
- 8 digital inputs 24 V DC in 1 group (2.0 ... 2.7)
- 8 digital outputs 24 V DC, 0.5 A max. in 1 group (3.0 ... 3.7)

The inputs/outputs are galvanically isolated from the PROFINET network. There is no potential separation between the channels. The configuration of the analog inputs/outputs is performed by software.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface</td>
<td>Ethernet</td>
</tr>
<tr>
<td>Protocol</td>
<td>PROFINET IO RT</td>
</tr>
<tr>
<td>Power supply</td>
<td>From the process supply voltage UP</td>
</tr>
<tr>
<td>Supply of the electronic circuitry of the I/O expansion modules attached</td>
<td>Through the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>Rotary switches</td>
<td>For setting the I/O device identifier for configuration purposes (00h to FFh)</td>
</tr>
<tr>
<td>LED displays</td>
<td>For system displays, signal states, errors and power supply</td>
</tr>
<tr>
<td>External supply voltage</td>
<td>Via terminals ZP, UP and UP3 (process supply voltage 24 V DC)</td>
</tr>
<tr>
<td>Effect of incorrect input terminal connection</td>
<td>Wrong or no signal detected, no damage up to 35 V</td>
</tr>
<tr>
<td>Required terminal unit</td>
<td>TU507 or TU508  ( \text{ Chapter 5.2.7.2 &quot;TU507-ETH and TU508-ETH for Ethernet communication interface modules&quot; on page 1270} )</td>
</tr>
</tbody>
</table>

Connections

General

The Ethernet communication interface module CI501-PNIO is plugged on the I/O terminal unit TU507-ETH or TU508-ETH  \( \text{ Chapter 5.2.7.2 "TU507-ETH and TU508-ETH for Ethernet communication interface modules" on page 1270} \). Properly seat the module and press until it locks in place. The terminal unit is mounted on a DIN rail or with 2 screws plus the additional accessory for wall mounting  \( \text{ Chapter 5.2.8.2.5 "TA526 - Wall mounting accessory" on page 1324} \).

The connection of the I/O channels is carried out using the 30 terminals of the I/O terminal unit. I/O modules can be replaced without re-wiring the terminal units.
For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The terminals 1.8 and 2.8 as well as 1.9, 2.9 and 3.9 are electrically interconnected within the terminal unit and have always the same assignment, independent of the inserted module:

Terminals 1.8 and 2.8: Process supply voltage UP = +24 V DC
Terminal 3.8: Process supply voltage UP3 = +24 V DC
Terminals 1.9, 2.9 and 3.9: Process supply voltage ZP = 0 V

With a separate UP3 power supply, the digital outputs can be switched off externally. This way, an emergency-off functionality can be realized.

Do not connect any voltages externally to digital outputs!
Reason: External voltages at an output or several outputs may cause that other outputs are supplied through that voltage instead of voltage UP3 (reverse voltage). This is unintended usage.

CAUTION!
Risk of malfunction by unintended usage!
If the function cut-off of the digital outputs is to be used by deactivation of the supply voltage UP3, be sure that no external voltage is connected at the outputs DO0 ... DO7.

Table 264: Assignment of the other terminals

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>AI0+</td>
<td>Positive terminal of analog input signal 0</td>
</tr>
<tr>
<td>1.1</td>
<td>AI1+</td>
<td>Positive terminal of analog input signal 1</td>
</tr>
<tr>
<td>1.2</td>
<td>AI2+</td>
<td>Positive terminal of analog input signal 2</td>
</tr>
<tr>
<td>1.3</td>
<td>AI3+</td>
<td>Positive terminal of analog input signal 3</td>
</tr>
<tr>
<td>1.4</td>
<td>AI-</td>
<td>Negative terminal of analog input signals 0 to 3</td>
</tr>
<tr>
<td>1.5</td>
<td>AO0+</td>
<td>Positive terminal of analog output signal 0</td>
</tr>
<tr>
<td>1.6</td>
<td>AO1+</td>
<td>Positive terminal of analog output signal 1</td>
</tr>
<tr>
<td>1.7</td>
<td>AI-</td>
<td>Negative terminal of analog output signals 0 and 1</td>
</tr>
<tr>
<td>1.8</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>1.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
<tr>
<td>2.0</td>
<td>DI0</td>
<td>Signal of the digital input DI0</td>
</tr>
<tr>
<td>2.1</td>
<td>DI1</td>
<td>Signal of the digital input DI1</td>
</tr>
<tr>
<td>2.2</td>
<td>DI2</td>
<td>Signal of the digital input DI2</td>
</tr>
<tr>
<td>2.3</td>
<td>DI3</td>
<td>Signal of the digital input DI3</td>
</tr>
<tr>
<td>2.4</td>
<td>DI4</td>
<td>Signal of the digital input DI4</td>
</tr>
<tr>
<td>2.5</td>
<td>DI5</td>
<td>Signal of the digital input DI5</td>
</tr>
</tbody>
</table>
Terminal | Signal | Description
--- | --- | ---
2.6 | DI6 | Signal of the digital input DI6
2.7 | DI7 | Signal of the digital input DI7
2.8 | UP | Process voltage UP (24 V DC)
2.9 | ZP | Process voltage ZP (0 V DC)
3.0 | DO0 | Signal of the digital output DO0
3.1 | DO1 | Signal of the digital output DO1
3.2 | DO2 | Signal of the digital output DO2
3.3 | DO3 | Signal of the digital output DO3
3.4 | DO4 | Signal of the digital output DO4
3.5 | DO5 | Signal of the digital output DO5
3.6 | DO6 | Signal of the digital output DO6
3.7 | DO7 | Signal of the digital output DO7
3.8 | UP3 | Process voltage UP3 (24 V DC)
3.9 | ZP | Process voltage ZP (0 V DC)

**WARNING!**
Removal/Insertion under power

The devices are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you
– connect or disconnect any signal or terminal block
– remove, mount or replace a module.

Disconnecting any powered devices while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The devices must not be opened when in operation. The same applies to the network interfaces.

**NOTICE!**
Risk of damaging the PLC modules!

Overvoltages and short circuits might damage the PLC modules.
– Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
– Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

*For the open-circuit detection (wire break), each analog input channel is pulled up to “plus” by a high-resistance resistor. If nothing is connected, the maximum voltage will be read in then.*
Generally, analog signals must be laid in shielded cables. The cable shields must be grounded at both sides of the cables. In order to avoid unacceptable potential differences between different parts of the installation, low resistance equipotential bonding conductors must be laid.

Fig. 242: Connection of the Ethernet bus module CI501-PNIO

☞ Chapter 6.8.4.2 “PROFINET communication interface module” on page 4596
Connection of the digital inputs

Fig. 243: Connection of the digital inputs (DI0 ... DI7)

☞ Chapter 5.2.6.7.2.10 “State LEDs” on page 1233
Connection of the digital outputs

![Diagram of digital output connections](image)

*Fig. 244: Connection of the digital output (DO0 ... DO7)*

☞ *Chapter 5.2.6.7.2.10 “State LEDs” on page 1233*

Connection of resistance thermometers in 2-wire configuration to the analog inputs

When resistance thermometers (Pt100, Pt1000, Ni1000) are used, a constant current must flow through them to build the necessary voltage drop for the evaluation. For this, the module CI501-PNIO provides a constant current source which is multiplexed over the max. 4 analog input channels.
Fig. 245: Connection of resistance thermometers in 2-wire configuration to the analog inputs (AI0 ... AI3)

Table 265: Configurable measuring ranges

<table>
<thead>
<tr>
<th>Sensor</th>
<th>Measuring Range</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pt100</td>
<td>-50 °C ... +400 °C</td>
<td>2-wire configuration, 1 channel used</td>
</tr>
<tr>
<td>Pt1000</td>
<td>-50 °C ... +400 °C</td>
<td>2-wire configuration, 1 channel used</td>
</tr>
<tr>
<td>Ni1000</td>
<td>-50 °C ... +150 °C</td>
<td>2-wire configuration, 1 channel used</td>
</tr>
</tbody>
</table>

*Chapter 5.2.6.7.2.8 “Parameterization” on page 1222
*Chapter 5.2.6.7.2.9 “Diagnosis” on page 1228

The module CI501-PNIO performs a linearization of the resistance characteristic.
To avoid error messages from unused analog input channels, configure them as "unused".

**Connection of resistance thermometers in 3-wire configuration to the analog inputs**

When resistance thermometers (Pt100, Pt1000, Ni1000) are used, a constant current must flow through them to build the necessary voltage drop for the evaluation. For this, the module CI501-PNIO provides a constant current source which is multiplexed over the max. 4 analog input channels.
With 3-wire configuration, 2 adjacent analog channels belong together (e.g. the channels 0 and 1). In this case, both channels are configured according to the desired operating mode. The lower address must be the even address (channel 0), the next higher address must be the odd address (channel 1).

The constant current of one channel flows through the resistance thermometer. The constant current of the other channel flows through one of the cores. The module calculates the measured value from the two voltage drops and stores it under the input with the higher channel number (e.g. I1).

In order to keep measuring errors as small as possible, it is necessary to have all the involved conductors in the same cable. All the conductors must have the same cross section.

Table 266: Configurable measuring ranges

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>3-wire configuration, 2 channels used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pt100</td>
<td>-50 °C ... +70 °C</td>
<td></td>
</tr>
<tr>
<td>Pt100</td>
<td>-50 °C ... +400 °C</td>
<td></td>
</tr>
<tr>
<td>Pt1000</td>
<td>-50 °C ... +400 °C</td>
<td></td>
</tr>
<tr>
<td>Ni1000</td>
<td>-50 °C ... +150 °C</td>
<td></td>
</tr>
</tbody>
</table>

Chapter 5.2.6.7.2.8 “Parameterization” on page 1222

Chapter 5.2.6.7.2.9 “Diagnosis” on page 1228

The module CI501-PNIO performs a linearization of the resistance characteristic.

To avoid error messages from unused analog input channels, configure them as "unused".
Connection of active-type analog sensors (Voltage) with galvanically isolated power supply to the analog inputs

![Diagram showing the connection of active-type analog sensors (voltage) with galvanically isolated power supply to the analog inputs (AI0 … AI3).]

**Fig. 247:** Connection of active-type analog sensors (voltage) with galvanically isolated power supply to the analog inputs (AI0 … AI3)

**Table 267:** Configurable measuring ranges

<table>
<thead>
<tr>
<th>Voltage</th>
<th>0 V ... 10 V</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

*Chapter 5.2.6.7.2.8 “Parameterization” on page 1222*

*Chapter 5.2.6.7.2.9 “Diagnosis” on page 1228*

To avoid error messages from unused analog input channels, configure them as "unused".
Connection of active-type analog sensors (Current) with galvanically isolated power supply to the analog inputs

![Diagram of connection](image)

**Fig. 248: Connection of active-type analog sensors (current) with galvanically isolated power supply to the analog inputs (AI0 ... AI3)**

**Table 268: Configurable measuring ranges**

<table>
<thead>
<tr>
<th>Current</th>
<th>0 mA ... 20 mA</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>4 mA ... 20 mA</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

☞ **Chapter 5.2.6.7.2.8 “Parameterization” on page 1222**

☞ **Chapter 5.2.6.7.2.9 “Diagnosis” on page 1228**

Unused input channels can be left open-circuited, because they are of low resistance.

To avoid error messages through unused analog input channels in measuring range 4 mA ... 20 mA, these channels should be configured as "Not used".
Connection of active-type analog sensors (Voltage) with no galvanically isolated power supply to the analog inputs

**CAUTION!**
Risk of faulty measurements!
The negative pin at the sensors must not have too big a potential difference with respect to ZP (max. ± 1 V).
Make sure that the potential difference never exceeds ± 1 V (also not with long cable lengths).

Table 269: Configurable measuring ranges

<table>
<thead>
<tr>
<th>Voltage</th>
<th>Range</th>
<th>Channels Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage 0 V</td>
<td>0 V ... 10 V</td>
<td>1 channel</td>
</tr>
<tr>
<td>Voltage -10</td>
<td>-10 V ... +10 V</td>
<td>unused</td>
</tr>
</tbody>
</table>

* Chapter 5.2.6.7.2.8 “Parameterization” on page 1222
* Chapter 5.2.6.7.2.8 “Parameterization” on page 1222
* Chapter 5.2.6.7.2.9 “Diagnosis” on page 1228

To avoid error messages from unused analog input channels, configure them as "unused".
Connection of passive-type analog sensors (Current) to the analog inputs

![Connection diagram](image)

Fig. 250: Connection of passive-type analog sensors (current) to the analog inputs (AI0 ... AI3)

### Table 270: Configurable measuring ranges

<table>
<thead>
<tr>
<th>Current</th>
<th>4 mA ... 20 mA</th>
<th>1 channel used</th>
</tr>
</thead>
</table>

- Chapter 5.2.6.7.2.8 “Parameterization” on page 1222
- Chapter 5.2.6.7.2.9 “Diagnosis” on page 1228

**CAUTION!**

Risk of overloading the analog input!

If an analog current sensor supplies more than 25 mA for more than 1 second during initialization, this input is switched off by the module (input protection).

Use only sensors with fast initialization or without current peaks higher than 25 mA. If not possible, connect a 10-volt zener diode in parallel to AIx+ and ZP.

Unused input channels can be left open-circuited, because they are of low resistance.

To avoid error messages through unused analog input channels in measuring range 4 mA ... 20 mA, these channels should be configured as “Not used”.

Connection of active-type analog sensors (Voltage) to differential analog inputs

Differential inputs are very useful, if analog sensors are used which are remotely non-isolated (e.g. the minus terminal is remotely grounded).

The evaluation using differential inputs helps to considerably increase the measuring accuracy and to avoid ground loops.
With differential input configurations, two adjacent analog channels belong together (e.g. the channels 0 and 1). In this case, both channels are configured according to the desired operating mode. The lower address must be the even address (channel 0), the next higher address must be the odd address (channel 1). The converted analog value is available at the higher address (channel 1).

The analog value is calculated by subtraction of the input value with the higher address from the input value of the lower address.

The converted analog value is available at the odd channel (higher address).

**CAUTION!**
Risk of faulty measurements!
The negative pin at the sensors must not have too big a potential difference with respect to ZP (max. ± 1 V).

Make sure that the potential difference never exceeds ± 1 V.

Fig. 251: Connection of active-type analog sensors (voltage) to differential analog inputs (AI0 ... AI3)

Table 271: Configurable measuring ranges

<table>
<thead>
<tr>
<th>Voltage</th>
<th>0 V ... 10 V</th>
<th>With differential inputs, 2 channels used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>-10 V ... +10 V</td>
<td>With differential inputs, 2 channels used</td>
</tr>
</tbody>
</table>

☞ Chapter 5.2.6.7.2.8 “Parameterization” on page 1222

☞ Chapter 5.2.6.7.2.9 “Diagnosis” on page 1228

To avoid error messages from unused analog input channels, configure them as "unused".
Use of analog inputs as digital inputs

Several (or all) analog inputs can be configured as digital inputs. The inputs are not galvanically isolated against the other analog channels.

![Connection of digital sensors to the analog inputs (AI0 ... AI3)](image)

**Fig. 252: Connection of digital sensors to the analog inputs (AI0 ... AI3)**

<table>
<thead>
<tr>
<th>Table 272: Configurable measuring ranges</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital input</td>
</tr>
<tr>
<td>Effect of incorrect input terminal connection</td>
</tr>
</tbody>
</table>

Chapter 5.2.6.7.2.8 “Parameterization” on page 1222

Chapter 5.2.6.7.2.9 “Diagnosis” on page 1228
Connection of analog output loads (Voltage)

Fig. 253: Connection of analog output loads (voltage) to the analog outputs (AO0 ... AO1)

Table 273: Configurable measuring ranges

<table>
<thead>
<tr>
<th>Voltage</th>
<th>-10 V ... +10 V</th>
<th>Load ± 10 mA max.</th>
<th>1 channel used</th>
</tr>
</thead>
</table>

Chapter 5.2.6.7.2.8 “Parameterization” on page 1222

Chapter 5.2.6.7.2.9 “Diagnosis” on page 1228

Unused analog outputs can be left open-circuited.
Connection of analog output loads (Current)

![Connection diagram](image)

**Fig. 254: Connection of analog output loads (current) to the analog outputs (AO0 and AO1)**

**Table 274: Configurable measuring ranges**

<table>
<thead>
<tr>
<th>Current</th>
<th>0 mA ... 20 mA</th>
<th>Load 0 Ω...500 Ω</th>
<th>1 channel used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>4 mA ... 20 mA</td>
<td>Load 0 Ω...500 Ω</td>
<td>1 channel used</td>
</tr>
</tbody>
</table>

☞ Chapter 5.2.6.7.2.8 “Parameterization” on page 1222

☞ Chapter 5.2.6.7.2.9 “Diagnosis” on page 1228

Unused analog outputs can be left open-circuited.

**Assignment of the Ethernet ports**

The terminal unit for the communication interface module provides two Ethernet interfaces with the following pin assignment:

**Pin assignment**

<table>
<thead>
<tr>
<th>Interface</th>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet RJ45</td>
<td>1</td>
<td>TxD+</td>
<td>Transmit data +</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>TxD-</td>
<td>Transmit data -</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>RxD+</td>
<td>Receive data +</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>RxD-</td>
<td>Receive data -</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>NC</td>
<td>Not connected</td>
</tr>
</tbody>
</table>
### Interface Pin Signal Description

<table>
<thead>
<tr>
<th>Interface</th>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>NC</td>
<td>Not connected</td>
<td></td>
</tr>
<tr>
<td>Shield</td>
<td></td>
<td>Cable shield</td>
<td>Functional earth</td>
</tr>
</tbody>
</table>

- In corrosive environment, please protect unused connectors using the TA535 accessory.
- Not supplied with this device.

**Further information about wiring and cable types**

#### Internal data exchange

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital inputs (bytes)</td>
<td>3</td>
</tr>
<tr>
<td>Digital outputs (bytes)</td>
<td>3</td>
</tr>
<tr>
<td>Analog inputs (words)</td>
<td>4</td>
</tr>
<tr>
<td>Analog outputs (words)</td>
<td>2</td>
</tr>
<tr>
<td>Counter input data (words)</td>
<td>4</td>
</tr>
<tr>
<td>Counter output data (words)</td>
<td>8</td>
</tr>
</tbody>
</table>

#### Addressing

The module has 2 rotary switches to set an explicit name to the PROFINET IO device before commissioning. No engineering tool is needed in this case.

The device gets its name (including the fixed part of the device name) with the switch settings (01h...FFh). This name can be used directly within the device configuration: “CI5xx-pn-yy”

- “CI5xx-pn-yy” xx is the fixed part of the device name (e.g. CI501) and yy represents the position of the rotary switch (0..FFh). The rotary switch values must be entered in hexadecimal format. For example, to set the name to “CI5xx-pn-08”, set the upper rotary switch to “0” and the lower switch to “8”.

- The module reads the position of the rotary switches only during power-up, i.e. changes of the switch position during operation will have no effect until the next module initialization.

#### I/O configuration

The CI501-PNIO stores some PROFINET configuration parameters (I/O device identifier, I/O device type and IP address configuration). No more configuration data is stored.

The analog/digital I/O channels are configured via software.

- Chapter 5.2.6.7.2.8 “Parameterization” on page 1222
## Parameterization

### Parameters of the module

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID 1)</td>
<td>Internal</td>
<td>7000</td>
<td>WORD 7000</td>
<td></td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal</td>
<td>25</td>
<td>BYTE 25</td>
<td></td>
</tr>
<tr>
<td>Error LED / Fail-safe function</td>
<td>see table Error LED / Failsafe function</td>
<td></td>
<td>Table 275 “Error LED / Failsafe function” on page 1223</td>
<td></td>
</tr>
<tr>
<td>On</td>
<td>0</td>
<td>BYTE 0</td>
<td>On + failsafe 16</td>
<td></td>
</tr>
<tr>
<td>Off by E4</td>
<td>1</td>
<td>17</td>
<td>Off by E3 + failsafe 19</td>
<td></td>
</tr>
<tr>
<td>Off by E3</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>On + failsafe</td>
<td>16</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Off by E4 + failsafe</td>
<td>17</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Off by E3 + failsafe</td>
<td>19</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Process cycle time 2)</td>
<td>1 ms process cycle time</td>
<td>1</td>
<td>BYTE 1</td>
<td>1 ms</td>
</tr>
<tr>
<td></td>
<td>2 ms process cycle time</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3 ms process cycle time</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 ms process cycle time</td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 ms process cycle time</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>6 ms process cycle time</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>7 ms process cycle time</td>
<td>7</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 ms process cycle time</td>
<td>8</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>9 ms process cycle time</td>
<td>9</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>10 ms process cycle time</td>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>11 ms process cycle time</td>
<td>11</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>12 ms process cycle time</td>
<td>12</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>13 ms process cycle time</td>
<td>13</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>14 ms process cycle time</td>
<td>14</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>15 ms process cycle time</td>
<td>15</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>16 ms process cycle time</td>
<td>16</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Check supply</td>
<td>off</td>
<td>0</td>
<td>BYTE 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>on</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Value</td>
<td>Internal value</td>
<td>Internal value, type</td>
<td>Default</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------</td>
<td>----------------</td>
<td>----------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Input delay</td>
<td>8 ms</td>
<td>8 ms</td>
<td>BYTE</td>
<td>8 ms</td>
</tr>
<tr>
<td>Fast counter</td>
<td>0</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>Fast counter</td>
<td>10 3)</td>
<td>10</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>Detect short-circuit at outputs</td>
<td>On</td>
<td>1</td>
<td>BYTE</td>
<td>On</td>
</tr>
<tr>
<td>Behavior digital outputs at comm. error</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>Off</td>
</tr>
<tr>
<td>Substitute value digital outputs</td>
<td>0</td>
<td>0..255</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td>Overvoltage behavior on output</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>Off</td>
</tr>
<tr>
<td>Behavior analog outputs atcomm. error</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>Off</td>
</tr>
<tr>
<td>I/O-Bus reset</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>Off</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td>BYTE</td>
<td>Off</td>
</tr>
</tbody>
</table>

Remarks:

1) With a faulty ID, the module reports a "parameter error" and does not perform cyclic process data transmission.

2) As for device index C0, the parameter is no longer evaluated.

3) Counter operating modes, see description of the Fast counter "Fast counter on page 606.

Table 275: Error LED / Failsafe function

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Error LED (S-ERR) lights up at errors of all error classes, Failsafe-mode off</td>
</tr>
<tr>
<td>Off by E4</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1, E2 and E3, Failsafe-mode off</td>
</tr>
<tr>
<td>Off by E3</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1 and E2, Failsafe-mode off</td>
</tr>
<tr>
<td>On + Failsafe</td>
<td>Error LED (S-ERR) lights up at errors of all error classes, Failsafe-mode on *)</td>
</tr>
<tr>
<td>Off by E4 + Failsafe</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1, E2 and E3, Failsafe-mode on *)</td>
</tr>
<tr>
<td>Off by E3 + Failsafe</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1 and E2, Failsafe-mode on *)</td>
</tr>
</tbody>
</table>

*) The parameters Behaviour AO at comm. error and Behaviour DO at comm. error are only analyzed if the Failsafe-mode is ON.
IO-BUS reset after PROFINET reconnection controls the behavior of PROFINET CI modules in relation to connected I/O modules (both safety and non-safety I/O modules).

- **IO-BUS reset after PROFINET reconnection = “On”** resets and, thus, re-parameterizes all attached I/O modules. All internal I/O modules states are reset, including the related diagnosis information.
  
  Note that if the parameter is set to “On” then:
  - The bumpless re-start of non-safety I/O modules will not be supported. It means, for example, that non-safety output channels will go from fail-safe values to “0” values during the re-connection and re-parameterization time and after that go to new output values.
  - Safety I/O modules will be re-parameterized and re-started as newly started modules, which may not require their PROFIsafe reintegration, depending on safety CPU state, in the safety application.

- **IO-BUS reset after PROFINET reconnection = “Off”** will not reset all attached I/O modules. It will re-parameterize I/O modules only if parameter change is detected during the reconnection. All internal I/O modules states are not reset, including the related diagnosis information.
  
  Note that if the parameter is set to “Off” then:
  - The bumpless re-start of non-safety I/O modules is supported (if no parameters are changed). It means, for example, that non-safety output channels will not go from fail-safe values to “0” values during the re-connection and re-parameterization time, but directly from fail-safe values to new output values.
  - Safety I/O modules will not be re-parameterized (if no parameters are changed). Thus, they may continue their operation, which may require their PROFIsafe reintegration in the safety application on the safety CPU, e.g., if PROFIsafe watchdog time for this safety I/O module has expired. Any reintegration of such safety I/O modules will be not only application specific but also PROFIsafe specific and depend on the safety I/O handling in the safety application.

### Group parameters for the analog part

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog data format</td>
<td>Standard</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Reserved</td>
<td>255</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Behaviour AO at comm. error *)</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Last value</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Last value 5 s</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Last value 10 s</td>
<td>11</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute value</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute value 5 s</td>
<td>7</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Substitute value 10 s</td>
<td>12</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*) The parameter Behaviour AO at comm. error is only analyzed if the Failsafe-mode is ON.
Channel parameters for the analog inputs (4x)

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input 0, Channel configuration</td>
<td>Table Operating modes of the analog inputs</td>
<td>Table Operating modes of the analog inputs</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Table 276 “Channel configuration” on page 1225</td>
<td>Table 276 “Channel configuration” on page 1225</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input 0, Check channel</td>
<td>Table Channel monitoring</td>
<td>Table Channel monitoring</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Table 277 “Channel monitoring” on page 1226</td>
<td>Table 277 “Channel monitoring” on page 1226</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input 3, Channel configuration</td>
<td>Table Operating modes of the analog inputs</td>
<td>Table Operating modes of the analog inputs</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Table 276 “Channel configuration” on page 1225</td>
<td>Table 276 “Channel configuration” on page 1225</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input 3, Check channel</td>
<td>Table Channel monitoring</td>
<td>Table Channel monitoring</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Table 277 “Channel monitoring” on page 1226</td>
<td>Table 277 “Channel monitoring” on page 1226</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 276: Channel configuration

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes of the analog inputs, individually configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (default)</td>
<td>Not used</td>
</tr>
<tr>
<td>1</td>
<td>0 V ... 10 V</td>
</tr>
<tr>
<td>2</td>
<td>Digital input</td>
</tr>
<tr>
<td>3</td>
<td>0 mA ... 20 mA</td>
</tr>
<tr>
<td>4</td>
<td>4 mA ... 20 mA</td>
</tr>
<tr>
<td>5</td>
<td>-10 V ... +10 V</td>
</tr>
<tr>
<td>8</td>
<td>2-wire Pt100 -50 °C ... +400 °C</td>
</tr>
<tr>
<td>9</td>
<td>3-wire Pt100 -50 °C ... +400 °C *)</td>
</tr>
<tr>
<td>10</td>
<td>0 V ... 10 V (voltage diff.) *)</td>
</tr>
<tr>
<td>11</td>
<td>-10 V ... +10 V (voltage diff.) *)</td>
</tr>
<tr>
<td>14</td>
<td>2-wire Pt100 -50 °C ... +70 °C</td>
</tr>
<tr>
<td>15</td>
<td>3-wire Pt100 -50 °C ... +70 °C *)</td>
</tr>
<tr>
<td>16</td>
<td>2-wire Pt1000 -50 °C ... +400 °C</td>
</tr>
<tr>
<td>17</td>
<td>3-wire Pt1000 -50 °C ... +400 °C *)</td>
</tr>
<tr>
<td>18</td>
<td>2-wire Ni1000 -50 °C ... +150 °C</td>
</tr>
</tbody>
</table>
Internal value | Operating modes of the analog inputs, individually configurable
---|---
19 | 3-wire Ni1000 -50 °C ... +150 °C *)

*) In the operating modes with 3-wire configuration or with differential inputs, two adjacent analog inputs belong together (e.g. the channels 0 and 1). In these cases, both channels are configured in the desired operating mode. The lower address must be the even address (channel 0). The next higher address must be the odd address (channel 1). The converted analog value is available at the higher address (channel 1).

Table 277: Channel monitoring

<table>
<thead>
<tr>
<th>Internal Value</th>
<th>Check Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (default)</td>
<td>Plausibility, wire break, short circuit</td>
</tr>
<tr>
<td>3</td>
<td>Not used</td>
</tr>
</tbody>
</table>

Channel parameters for the analog outputs (2x)

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output 0, Channel configuration</td>
<td>Table Operating modes of the analog outputs</td>
<td>Table Operating modes of the analog outputs</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>☞ Further information on page 1227</td>
<td>☞ Further information on page 1227</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Output 0, Check channel</td>
<td>Table Channel monitoring</td>
<td>Table Channel monitoring</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>☞ Table 279 “Channel monitoring” on page 1227</td>
<td>☞ Table 279 “Channel monitoring” on page 1227</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Output 0, Substitute value</td>
<td>Table Substitute value</td>
<td>Table Substitute value</td>
<td>WORD</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>☞ Table 280 “Substitute value” on page 1227</td>
<td>☞ Table 280 “Substitute value” on page 1227</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Output 1, Channel configuration</td>
<td>Table Operating modes of the analog outputs</td>
<td>Table Operating modes of the analog outputs</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>☞ Further information on page 1227</td>
<td>☞ Further information on page 1227</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Output 1, Check channel</td>
<td>Table Channel monitoring</td>
<td>Table Channel monitoring</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>☞ Table 279 “Channel monitoring” on page 1227</td>
<td>☞ Table 279 “Channel monitoring” on page 1227</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Output 1, Substitute value</td>
<td>Table Substitute value</td>
<td>Table Substitute value</td>
<td>WORD</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>☞ Table 280 “Substitute value” on page 1227</td>
<td>☞ Table 280 “Substitute value” on page 1227</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 278: Channel configuration

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Operating modes of the analog outputs, individually configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (default)</td>
<td>Not used</td>
</tr>
<tr>
<td>128</td>
<td>-10 V ... +10 V</td>
</tr>
<tr>
<td>129</td>
<td>0 mA ... 20 mA</td>
</tr>
<tr>
<td>130</td>
<td>4 mA ... 20 mA</td>
</tr>
</tbody>
</table>

### Table 279: Channel monitoring

<table>
<thead>
<tr>
<th>Internal value</th>
<th>Check channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Plausibility, wire break, short circuit</td>
</tr>
<tr>
<td>3</td>
<td>None</td>
</tr>
</tbody>
</table>

### Table 280: Substitute value

<table>
<thead>
<tr>
<th>Intended behavior of output channel when the control system stops</th>
<th>Required setting of the module parameter &quot;Behaviour of outputs in case of a communication error&quot;</th>
<th>Required setting of the channel parameter &quot;Substitute value&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output OFF</td>
<td>Off</td>
<td>0</td>
</tr>
<tr>
<td>Last value infinite</td>
<td>Last value</td>
<td>0</td>
</tr>
<tr>
<td>Last value for 5 s and then turn off</td>
<td>Last value 5 sec</td>
<td>0</td>
</tr>
<tr>
<td>Last value for 10 s and then turn off</td>
<td>Last value 10 sec</td>
<td>0</td>
</tr>
<tr>
<td>Substitute value infinite</td>
<td>Substitute value</td>
<td>Depending on configuration</td>
</tr>
<tr>
<td>Substitute value for 5 s and then turn off</td>
<td>Substitute value 5 sec</td>
<td>Depending on configuration</td>
</tr>
<tr>
<td>Substitute value for 10 s and then turn off</td>
<td>Substitute value 10 sec</td>
<td>Depending on configuration</td>
</tr>
</tbody>
</table>

### Group parameters for the digital part

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input delay</td>
<td>0.1 ms</td>
<td>0</td>
<td>BYTE</td>
<td>0.1 ms</td>
</tr>
<tr>
<td></td>
<td>1 ms</td>
<td>1</td>
<td></td>
<td>0x00</td>
</tr>
<tr>
<td></td>
<td>8 ms</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>32 ms</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Detect short circuit at outputs</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>On</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td></td>
<td>0x01</td>
</tr>
</tbody>
</table>
**Table 281: Structure of the diagnosis block via PNIO_DEV_ALARM function block**

<table>
<thead>
<tr>
<th>Byte Number</th>
<th>Description</th>
<th>Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Diagnosis Byte, slot number</td>
<td>31 = CI501-PNIO (e. g. error at integrated 8 DI / 8 DO)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = 1st connected S500 I/O module</td>
</tr>
<tr>
<td></td>
<td></td>
<td>...</td>
</tr>
<tr>
<td></td>
<td></td>
<td>10 = 10th connected S500 I/O module</td>
</tr>
<tr>
<td>2</td>
<td>Diagnosis Byte, module number</td>
<td>According to the I/O bus specification passed on by modules to the fieldbus master</td>
</tr>
<tr>
<td>3</td>
<td>Diagnosis Byte, channel</td>
<td>According to the I/O bus specification passed on by modules to the fieldbus master</td>
</tr>
<tr>
<td>Byte Number</td>
<td>Description</td>
<td>Possible Values</td>
</tr>
<tr>
<td>-------------</td>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| 4           | Diagnosis Byte, error code  | According to the I/O bus specification  
Bit 7 and bit 6, coded error class  
0 = E1  
1 = E2  
2 = E3  
3 = E4  
Bit 0 to bit 5, coded error description |
| 5           | Diagnosis Byte, flags       | According to the I/O bus specification  
Bit 7: 1 = coming error  
Bit 6: 1 = leaving error |

In cases of short circuit or overload, the digital outputs are turned off. The modules performs reactivation automatically. Thus an acknowledgement of the errors is not necessary. The error message is stored via the LED.

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifier</th>
<th>AC500-Display</th>
<th>Display in</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>000 ... 063</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error-Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Byte 4</td>
<td>Bit 6 ... 7</td>
<td>Byte 1</td>
<td>Byte 2</td>
<td>Byte 3</td>
<td>Byte 4 Bit 0 ... 5</td>
<td>PNIO diagnosis block</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error-Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module errors</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<p>| 3 | - | 31 | 31 | 31 | 19 | Checksum error in the I/O module | Replace I/O module |
| 3 | - | 31 | 31 | 31 | 3 | Timeout in the I/O module | |
| 3 | - | 31 | 31 | 31 | 40 | Different hard-/firmware versions in the module | |
| 3 | - | 31 | 31 | 31 | 43 | Internal error in the module | |
| 3 | - | 31 | 31 | 31 | 36 | Internal data exchange failure | |
| 3 | - | 31 | 31 | 31 | 9 | Overflow diagnosis buffer | Restart |
| 3 | - | 31 | 31 | 31 | 26 | Parameter error | Check master |</p>
<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error-Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>11</td>
<td>Process voltage UP too low</td>
<td>Check process supply voltage</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>45</td>
<td>No process voltage UP</td>
<td>Check process supply voltage</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31/1...10</td>
<td>31</td>
<td>31</td>
<td>17</td>
<td>No communication with I/O module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>31</td>
<td>32</td>
<td>Wrong I/O module type on socket</td>
<td>Replace I/O module / Check configuration</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>At least one module does not support failsafe function</td>
<td>Check modules and parameterization</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>5</td>
<td>8</td>
<td>I/O module removed from hot swap terminal unit or defective module on hot swap terminal unit 9)</td>
<td>Plug I/O module, replace I/O module</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>5</td>
<td>28</td>
<td>Wrong I/O module plugged on hot swap terminal unit 9)</td>
<td>Remove wrong I/O module and plug projected I/O module</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1...10</td>
<td>31</td>
<td>5</td>
<td>42</td>
<td>No communication with I/O module on hot swap terminal unit 9)</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>E1 ... E4</td>
<td>d1</td>
<td>d2</td>
<td>d3</td>
<td>d4</td>
<td>Identifier</td>
<td>AC500-Display</td>
<td>Display in</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>000 ... 063</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Byte 4</td>
<td>Byte 1</td>
<td>Byte 2</td>
<td>Byte 3</td>
<td>Bit 0 ... 5</td>
<td>PNIO diagnosis block</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Class</td>
<td>Byte 4</td>
<td>Bit 6 ... 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>-</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Class</td>
<td></td>
<td>Device</td>
<td>Module</td>
<td>Channel</td>
<td>Error-Identifier</td>
<td>Error message</td>
</tr>
<tr>
<td></td>
<td>Interface</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Error message**: I/O module does not support hot swap
- **Remedy**: Power off system and replace I/O module

- **Error message**: Hot swap terminal unit configured but not found
- **Remedy**: Replace terminal unit by hot swap terminal unit

- **Error message**: No communication with hot swap terminal unit
- **Remedy**: Restart, if error persists replace terminal unit

- **Error message**: Voltage feedback on activated digital outputs DO0...DO7 on UP3
- **Remedy**: Check terminals

- **Error message**: No response during initialization of the I/O module
- **Remedy**: Replace I/O module

- **Error message**: Process voltage UP3 too low
- **Remedy**: Check process supply voltage

- **Error message**: The connected Communication Module has no connection to the network
- **Remedy**: Check cabling

- **Error message**: No process voltage UP3
- **Remedy**: Check process supply voltage
<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error-Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>1)</td>
<td>2)</td>
<td>3)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>10</td>
<td>Voltage overflow on outputs (above UP3 level) 5)</td>
<td>Check terminals/ check process supply voltage</td>
</tr>
</tbody>
</table>

**Channel error digital**

| 4     | -         | 31     | 2      | 0...7    | 46              | Externally voltage detected at digital output DO0...DO7 6) | Check terminals |

| 4     | -         | 31     | 2      | 0...7    | 47              | Short circuit at digital output 7) | Check terminals |

**Channel error analog**

| 4     | -         | 31     | 1      | 0...3    | 48              | Analog value overflow or broken wire at an analog input | Check value or check terminals |

| 4     | -         | 31     | 1      | 0...3    | 7               | Analog value underflow at an analog input | Check value |

| 4     | -         | 31     | 1      | 0...3    | 47              | Short circuit at an analog input | Check terminals |

| 4     | -         | 31     | 3      | 0...1    | 4               | Analog value overflow at an analog output | Check output value |

| 4     | -         | 31     | 3      | 0...1    | 7               | Analog value underflow at an analog output | Check output value |

**Remarks:**

- Hardware descriptions
- Device specifications > Communication interface modules
In AC500 the following interface identifier applies:
"-" = Diagnosis via bus-specific function blocks; 0 ... 4 or 10 = Position of the
communication module; 14 = I/O bus; 31 = Module itself
The identifier is not contained in the CI501-PNIO diagnosis block.

With "Device" the following allocation applies: 31 = Module itself; 1 ... 10 =
Expansion module

With "Module" the following allocation applies:
31 = Module itself
Module type (1 = AI, 2 = DO, 3 = AO)

This message appears, if externally voltages at one or more terminals
DO0 ... DO7 cause that other digital outputs are supplied through that
voltage © Chapter 5.2.6.7.2.4 "Connections" on page 1205. All outputs of
the apply digital output groups will be turned off for 5 seconds. The diagnosis
message appears for the whole output group.

The voltage on digital outputs DO0 ... DO7 has overrun the process supply
voltage UP3 © Chapter 5.2.6.7.2.4 "Connections" on page 1205. Diagnosis
message appears for the whole module.

This message appears, if the output of a channel DO0 ... DO7 should be
switched on while an externally voltage is connected. In this case the start
up is disabled, as long as the externally voltage is connected. Otherwise this
could produce reverse voltage from this output to other digital outputs. This
diagnosis message appears per channel.

Short circuit: After a detected short circuit, the output is deactivated for
100 ms. Then a new start up will be executed. This diagnosis message
appears per channel.

In case of an I/O module doesn’t support hot swapping, do not perform any
hot swap operations (also not on any other terminal units (slots)) as modules
may be damaged or I/O bus communication may be disturbed.

Diagnosis for hot swap available as of version index F0.

State LEDs

The LEDs are located at the front of module. There are 2 different groups:

- The 5 system LEDs (PWR, STA1 ETH, STA2 ETH, S-ERR and I/O-Bus) show the operation
  state of the module and display possible errors.
- The 27 process LEDs (UP, UP3, inputs, outputs, CH-ERR1 to CH-ERR3) show the process
  supply voltage and the states of the inputs and outputs and display possible errors.

Table 282: States of the 5 system LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>OFF</th>
<th>ON</th>
<th>Flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR/RUN</td>
<td>Green</td>
<td>Process supply voltage missing</td>
<td>Internal supply voltage OK, module ready for communication with I/O Controller</td>
<td>Start-up / preparing communication</td>
</tr>
<tr>
<td>Yellow</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>STA1 ETH</td>
<td>Green</td>
<td>---</td>
<td>Device configured, cyclic data exchange running</td>
<td>---</td>
</tr>
<tr>
<td>(System LED &quot;BF&quot;)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 283: States of the 27 process LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>OFF</th>
<th>ON</th>
<th>Flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED Color</td>
<td></td>
<td>OFF</td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td>Red</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>Device is not configured</td>
</tr>
<tr>
<td>STA2 ETH</td>
<td>Green</td>
<td>---</td>
<td>---</td>
<td>Got identification request from I/O controller</td>
</tr>
<tr>
<td>(System LED</td>
<td>Red</td>
<td>No system error</td>
<td>System error (collective error)</td>
<td>---</td>
</tr>
<tr>
<td>&quot;SF&quot;)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>S-ERR</td>
<td>Red</td>
<td>No error</td>
<td>Internal error</td>
<td>--</td>
</tr>
<tr>
<td>I/O-Bus</td>
<td>Green</td>
<td>No expansion</td>
<td>Expansion modules connected and operational</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>modules connected</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>or communication</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>error</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ETH1</td>
<td>Green</td>
<td>No connection at</td>
<td>Connected to Ethernet interface</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ethernet interface</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>---</td>
<td>Device is transmitting telegrams</td>
<td>Device is transmitting telegrams</td>
</tr>
<tr>
<td>ETH2</td>
<td>Green</td>
<td>No connection at</td>
<td>Connected to Ethernet interface</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ethernet interface</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>---</td>
<td>Device is transmitting telegrams</td>
<td>Device is transmitting telegrams</td>
</tr>
</tbody>
</table>

#### Table 283: States of the 27 process LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>OFF</th>
<th>ON</th>
<th>Flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>AI0 ... AI3</td>
<td>Yellow</td>
<td>Input is OFF</td>
<td>Input is ON</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(brightness depends on the value of the analog signal)</td>
<td></td>
</tr>
<tr>
<td>AO0 ... AO1</td>
<td>Yellow</td>
<td>Output is OFF</td>
<td>Output is ON</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(brightness depends on the value of the analog signal)</td>
<td></td>
</tr>
<tr>
<td>DI0 ... DI7</td>
<td>Yellow</td>
<td>Input is OFF</td>
<td>Input is ON</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(the input voltage is even displayed if the supply voltage is OFF)</td>
<td></td>
</tr>
<tr>
<td>DO0 ... DO7</td>
<td>Yellow</td>
<td>Output is OFF</td>
<td>Output is ON</td>
<td>--</td>
</tr>
<tr>
<td>UP</td>
<td>Green</td>
<td>Process supply</td>
<td>Process supply voltage OK and initialization finished</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td></td>
<td>voltage missing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UP3</td>
<td>Green</td>
<td>Process supply</td>
<td>Process supply voltage OK</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td></td>
<td>voltage missing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CH-ERR1 to CH-ERR3</td>
<td>Red</td>
<td>No error or process supply voltage missing</td>
<td>Internal error</td>
<td>Error on one channel of the corresponding group</td>
</tr>
</tbody>
</table>
Measuring ranges
Input ranges voltage, current and digital input

<table>
<thead>
<tr>
<th>Range</th>
<th>0 V ... +10 V</th>
<th>-10 V ... +10 V</th>
<th>0 mA ... 20 mA</th>
<th>4 mA ... 20 mA</th>
<th>Digital input</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Decimal</td>
<td>Hex.</td>
<td>Decimal</td>
<td>Hex.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overflow</td>
<td>&gt; 11.7589</td>
<td>&gt; 11.7589</td>
<td>&gt; 23.5178</td>
<td>&gt; 22.8142</td>
<td></td>
<td>32767</td>
</tr>
<tr>
<td>Measured value too high</td>
<td>11.7589</td>
<td>11.7589</td>
<td>23.5178</td>
<td>22.8142</td>
<td></td>
<td>32511</td>
</tr>
<tr>
<td></td>
<td>10.0004</td>
<td>10.0004</td>
<td>20.0007</td>
<td>20.0006</td>
<td></td>
<td>27649</td>
</tr>
<tr>
<td>Normal range</td>
<td>10.0000</td>
<td>10.0000</td>
<td>20.0000</td>
<td>20.0000</td>
<td>Digital</td>
<td>27648</td>
</tr>
<tr>
<td>Normal range or measured value too low</td>
<td>0.0000</td>
<td>0.0000</td>
<td>4.0006</td>
<td>On</td>
<td>1</td>
<td>0001</td>
</tr>
<tr>
<td></td>
<td>-0.0004</td>
<td>-0.0004</td>
<td>3.9994</td>
<td>1.1858</td>
<td>Digital</td>
<td>-1</td>
</tr>
<tr>
<td></td>
<td>-1.7593</td>
<td></td>
<td>4.0007</td>
<td>-27648</td>
<td></td>
<td>-4864</td>
</tr>
<tr>
<td>Measured value too low</td>
<td>-10.0004</td>
<td>-11.7589</td>
<td>1.8000</td>
<td>1.1858</td>
<td></td>
<td>-27649</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1501</td>
<td>1.1858</td>
<td></td>
<td>-32512</td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt; 1.7593</td>
<td>&lt; -11.7589</td>
<td>&lt; 0.0000</td>
<td>&lt; 1.1858</td>
<td></td>
<td>-32768</td>
</tr>
</tbody>
</table>

The represented resolution corresponds to 16 bits.

Input ranges resistance temperature detector

<table>
<thead>
<tr>
<th>Range</th>
<th>Pt100 / Pt1000 -50 ... +70 °C</th>
<th>Pt100 / Pt1000 -50 ... +400 °C</th>
<th>Ni1000 -50 ... +150 °C</th>
<th>Digital value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Decimal</td>
<td>Hex.</td>
<td>Decimal</td>
<td>Hex.</td>
</tr>
<tr>
<td>Overflow</td>
<td>&gt; +80.0 °C</td>
<td>&gt; +450.0 °C</td>
<td>&gt; +160.0 °C</td>
<td>32767</td>
</tr>
<tr>
<td>Measured value too high</td>
<td>+80.0 °C</td>
<td>+450.0 °C</td>
<td>+160.0 °C</td>
<td>4500</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>+400.1 °C</td>
<td>:</td>
<td>4001</td>
</tr>
<tr>
<td></td>
<td>+160.0 °C</td>
<td>:</td>
<td>+150.1 °C</td>
<td>1600</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>1501</td>
</tr>
<tr>
<td>Normal range</td>
<td>+400.0 °C</td>
<td>+150.0 °C</td>
<td>+0.1 °C</td>
<td>8000</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td>:</td>
<td>701</td>
</tr>
<tr>
<td>Range</td>
<td>Pt100 / Pt1000 -50 ... +70 °C</td>
<td>Pt100 / Pt1000 -50 ... +400 °C</td>
<td>Ni1000 -50 ... +150 °C</td>
<td>Digital value</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------</td>
<td>--------------------------------</td>
<td>------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td></td>
<td>0.0 °C</td>
<td>0.0 °C</td>
<td>0.0 °C</td>
<td>4000</td>
</tr>
<tr>
<td></td>
<td>-0.1 °C</td>
<td>-0.1 °C</td>
<td>0</td>
<td>700</td>
</tr>
<tr>
<td></td>
<td>-50.0 °C</td>
<td>-50.0 °C</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Measured value too low</td>
<td>&lt; -60.0 °C</td>
<td>-50.1 °C</td>
<td>-50.1 °C</td>
<td>-1</td>
</tr>
<tr>
<td></td>
<td>-60.0 °C</td>
<td>-60.0 °C</td>
<td>-500</td>
<td></td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt; -60.0 °C</td>
<td>&lt; -60.0 °C</td>
<td>&lt; -60.0 °C</td>
<td>-501</td>
</tr>
</tbody>
</table>

Output ranges voltage and current

<table>
<thead>
<tr>
<th>Range</th>
<th>-10...+10 V</th>
<th>0...20 mA</th>
<th>4...20 mA</th>
<th>Digital value</th>
<th>Decimal</th>
<th>Hex.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overflow</td>
<td>&gt; 11.7589 V</td>
<td>&gt; 23.5178 mA</td>
<td>&gt; 22.8142 mA</td>
<td>&gt; 32511</td>
<td>&gt; 7EFF</td>
<td></td>
</tr>
<tr>
<td>Measured value too high</td>
<td>11.7589 V : 10.0004 V</td>
<td>23.5178 mA : 20.0007 mA</td>
<td>22.8142 mA : 20.0006 mA</td>
<td>32511 : 27649</td>
<td>7EFF : 6C01</td>
<td></td>
</tr>
<tr>
<td>Normal range</td>
<td>10.0000 V : 0.0004 V</td>
<td>20.0000 mA : 0.0007 mA</td>
<td>20.0000 mA : 4.0006 mA</td>
<td>27648 : 0001</td>
<td>6C00 :</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.0000 V : 0.0000 mA</td>
<td>4.0000 mA : 0 mA</td>
<td>0 : 0 mA</td>
<td>0000</td>
<td>0000 :</td>
<td></td>
</tr>
<tr>
<td></td>
<td>-0.0004 V : -10.0000 V</td>
<td>0 mA : 0 mA</td>
<td>3.9994 mA : 0 mA</td>
<td>-1 : -6912</td>
<td>FFFF : E500</td>
<td></td>
</tr>
<tr>
<td>Measured value too low</td>
<td>-10.0004 V : -11.7589 V</td>
<td>0 mA : 0 mA</td>
<td>0 mA : 0 mA</td>
<td>-27649 : -32512</td>
<td>93FF : 8100</td>
<td></td>
</tr>
<tr>
<td>Underflow</td>
<td>&lt; -11.7589 V</td>
<td>0 mA : 0 mA</td>
<td>0 mA : 0 mA</td>
<td>&lt; -32512 : &lt; -8100</td>
<td>:</td>
<td></td>
</tr>
</tbody>
</table>

The represented resolution corresponds to 16 bits.
Technical data

Technical data of the module

The system data of AC500 and S500 are applicable to the standard version “System data AC500” on page 166.

The system data of AC500-XC are applicable to the XC version “System data AC500-XC” on page 169.

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltages UP/UP3</td>
<td></td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC (for inputs and outputs)</td>
</tr>
<tr>
<td>Max. load for the terminals</td>
<td>10 A</td>
</tr>
<tr>
<td>Protection against reversed voltage</td>
<td>Yes</td>
</tr>
<tr>
<td>Rated protection fuse on UP/UP3</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Ethernet interface against the rest of the module</td>
</tr>
<tr>
<td>Inrush current from UP (at power up)</td>
<td>On request</td>
</tr>
<tr>
<td>Current consumption via UP (normal operation)</td>
<td>0.2 A</td>
</tr>
<tr>
<td>Current consumption via UP3</td>
<td>0.06 A + 0.5 A max. per output</td>
</tr>
<tr>
<td>Connections</td>
<td>Terminals 1.8 and 2.8 for +24 V (UP)</td>
</tr>
<tr>
<td></td>
<td>Terminal 3.8 for +24 V (UP3)</td>
</tr>
<tr>
<td></td>
<td>Terminals 1.9, 2.9 and 3.9 for 0 V (ZP)</td>
</tr>
<tr>
<td>Max. power dissipation within the module</td>
<td>6 W</td>
</tr>
<tr>
<td>Number of digital inputs</td>
<td>8</td>
</tr>
<tr>
<td>Number of digital outputs</td>
<td>8</td>
</tr>
<tr>
<td>Number of analog inputs</td>
<td>4</td>
</tr>
<tr>
<td>Number of analog outputs</td>
<td>2</td>
</tr>
<tr>
<td>Input data length</td>
<td>19 bytes</td>
</tr>
<tr>
<td>Output data length</td>
<td>23 bytes</td>
</tr>
<tr>
<td>Reference potential for all digital inputs and outputs</td>
<td>Negative terminal of the supply voltage, signal name ZP</td>
</tr>
<tr>
<td>Setting of the I/O device identifier</td>
<td>With 2 rotary switches at the front side of the module</td>
</tr>
<tr>
<td>Diagnose</td>
<td>See Diagnosis and Displays “Diagnosis” on page 1228</td>
</tr>
<tr>
<td>Operation and error displays</td>
<td>32 LEDs (totally)</td>
</tr>
<tr>
<td>Weight (without terminal unit)</td>
<td>Ca. 125 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical with derating (output load reduced to 50 % at +40 °C per group)</td>
</tr>
<tr>
<td>Extended ambient temperature (XC version)</td>
<td>&gt;+60 °C on request</td>
</tr>
<tr>
<td>Cooling</td>
<td>The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.</td>
</tr>
</tbody>
</table>
**NOTICE!**

All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

---

**Multiple overloads**

No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an internal smart high-side switch.

---

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bus connection</td>
<td>2 x RJ45</td>
</tr>
<tr>
<td>Switch</td>
<td>Integrated</td>
</tr>
<tr>
<td>Technology</td>
<td>Hilscher NETX 100</td>
</tr>
<tr>
<td>Transfer rate</td>
<td>10/100 Mbit/s (full-duplex)</td>
</tr>
<tr>
<td>Transfer method</td>
<td>According to Ethernet II, IEEE 802.3</td>
</tr>
<tr>
<td>Ethernet</td>
<td>100 base-TX, internal switch, 2x RJ45 socket</td>
</tr>
<tr>
<td>Expandability</td>
<td>Max. 10 S500 I/O modules</td>
</tr>
<tr>
<td>Adjusting elements</td>
<td>2 rotary switches for generation of an explicit name</td>
</tr>
<tr>
<td>Supported protocols</td>
<td>RTC - real time cyclic protocol, class 1 *)</td>
</tr>
<tr>
<td></td>
<td>RTA - real time acyclic protocol</td>
</tr>
<tr>
<td></td>
<td>DCP - discovery and configuration protocol</td>
</tr>
<tr>
<td></td>
<td>CL-RPC - connectionless remote procedure Call</td>
</tr>
<tr>
<td></td>
<td>LLDP - link layer discovery protocol</td>
</tr>
<tr>
<td></td>
<td>MRP - MRP Client</td>
</tr>
<tr>
<td>Acyclic services</td>
<td>PNIO read / write sequence (max. 1024 bytes per telegram)</td>
</tr>
<tr>
<td></td>
<td>Process-Alarm service</td>
</tr>
<tr>
<td>Supported alarm types</td>
<td>Process Alarm, Diagnostic Alarm, Return of SubModule, Plug Alarm, Pull Alarm</td>
</tr>
<tr>
<td>Min. bus cycle</td>
<td>1 ms</td>
</tr>
<tr>
<td>Conformance class</td>
<td>CC A</td>
</tr>
<tr>
<td>Protective functions (according to IEC 61131-3)</td>
<td>Protected against:</td>
</tr>
<tr>
<td></td>
<td>• short circuit</td>
</tr>
<tr>
<td></td>
<td>• reverse supply</td>
</tr>
<tr>
<td></td>
<td>• overvoltage</td>
</tr>
<tr>
<td></td>
<td>• reverse polarity</td>
</tr>
<tr>
<td></td>
<td>Galvanic isolation from the rest of the module</td>
</tr>
</tbody>
</table>

*) Priorization with the aid of VLAN-ID including priority level
### Technical data of the digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels DI0 ... DI7</td>
<td>Terminals 2.0 ... 2.7</td>
</tr>
<tr>
<td>Reference potential for all inputs</td>
<td>Terminals 1.9 ... 3.9 (negative terminal of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel, the LED is ON when the input signal is high (signal 1)</td>
</tr>
<tr>
<td>Input type (according EN 61131-2)</td>
<td>Type 1</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 0.1 ms, configurable from 0.1 ms ... 32 ms</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>0-Signal</td>
<td>-3 V ... +5 V</td>
</tr>
<tr>
<td>Undefined Signal</td>
<td>&gt; +5 V ... &lt; +15 V</td>
</tr>
<tr>
<td>1-Signal</td>
<td>+15 V ... +30 V</td>
</tr>
<tr>
<td>Ripple with signal 0</td>
<td>Within -3 V ... +5 V</td>
</tr>
<tr>
<td>Ripple with signal 1</td>
<td>Within +15 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 5 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>&gt; 1 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>&gt; 2 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 8 mA</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

### Technical data of the digital outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels DO0 ... DO7</td>
<td>Terminals 3.0 ... 3.7</td>
</tr>
<tr>
<td>Reference potential for all outputs</td>
<td>Terminals 1.9 ... 3.9 (negative terminal of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>For all outputs terminal 3.8 (positive terminal of the supply voltage, signal name UP3)</td>
</tr>
<tr>
<td>Output voltage for signal 1</td>
<td>UP3 (-0.8 V)</td>
</tr>
<tr>
<td>Output delay (0-&gt;1 or 1-&gt;0)</td>
<td>On request</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated value per channel</td>
<td>500 mA at UP3 = 24 V</td>
</tr>
<tr>
<td>Max. value (all channels together)</td>
<td>4 A</td>
</tr>
<tr>
<td>Leakage current with signal 0</td>
<td>&lt; 0.5 mA</td>
</tr>
</tbody>
</table>
### Technical data of the analog inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>4</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group with 4 channels</td>
</tr>
<tr>
<td>Connection if channels AI0+ ... AI3+</td>
<td>Terminals 1.0 ... 1.3</td>
</tr>
<tr>
<td>Reference potential for AI0+ ... AI3+</td>
<td>Terminal 1.4 (AI-) for voltage and RTD measurement</td>
</tr>
<tr>
<td></td>
<td>Terminal 1.9, 2.9 and 3.9 for current measurement</td>
</tr>
<tr>
<td>Input type</td>
<td></td>
</tr>
<tr>
<td>Unipolar</td>
<td>Voltage 0 V ... 10 V, current or Pt100/Pt1000/Ni1000</td>
</tr>
<tr>
<td>Bipolar</td>
<td>Voltage -10 V ... +10 V</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Against Ethernet network</td>
</tr>
</tbody>
</table>

The following drawing shows the circuitry of a digital input/output with the varistors for demagnetization when inductive loads are switched off.

![Circuit Diagram](image-url)

1. Digital output
2. Varistors for demagnetization when inductive loads are turned off
### Technical data of the analog inputs, if used as digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>Max. 4</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group of 4 channels</td>
</tr>
<tr>
<td>Connections of the channels AI0+ ... Al3+</td>
<td>Terminals 1.0 ... 1.3</td>
</tr>
<tr>
<td>Reference potential for the inputs</td>
<td>Terminals 1.9, 2.9 and 3.9 (ZP)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 LED per channel</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-30 V ... +5 V</td>
</tr>
<tr>
<td>Undefined signal</td>
<td>+5 V ... +13 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>+13 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 7 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>Typ. 1.4 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>Typ. 3.7 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 9 mA</td>
</tr>
<tr>
<td>Input resistance</td>
<td>Ca. 3.5 kΩ</td>
</tr>
</tbody>
</table>
### Technical data of the analog outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>2</td>
</tr>
<tr>
<td>Distribution of channels into groups</td>
<td>1 group for 2 channels</td>
</tr>
<tr>
<td>Connection of the channels AO0+ ... AO1+</td>
<td>Terminals 1.5 ... 1.6</td>
</tr>
<tr>
<td>Reference potential for AO0+ ... AO1+</td>
<td>Terminal 1.7 (AO-) for voltage output terminal 1.9, 2.9 and 3.9 for current output</td>
</tr>
<tr>
<td>Output type</td>
<td></td>
</tr>
<tr>
<td>Unipolar</td>
<td>Current</td>
</tr>
<tr>
<td>Bipolar</td>
<td>Voltage</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>Against internal supply and other modules</td>
</tr>
<tr>
<td>Configurability</td>
<td>-10 V ... +10 V, 0 mA ... 20 mA, 4 mA ... 20 mA (each output can be configured individually)</td>
</tr>
<tr>
<td>Output resistance (load), as current output</td>
<td>0 Ω ... 500 Ω</td>
</tr>
<tr>
<td>Output loadability, as voltage output</td>
<td>± 10 mA max.</td>
</tr>
<tr>
<td>Indication of the output signals</td>
<td>1 LED per channel (brightness depends on the value of the analog signal)</td>
</tr>
<tr>
<td>Resolution</td>
<td>12 bits including sign</td>
</tr>
<tr>
<td>Settling time for full range change (resistive load, output signal within specified tolerance)</td>
<td>Typ. 5 ms</td>
</tr>
<tr>
<td>Conversion error of the analog values caused by non-linearity, adjustment error at factory and resolution within the normal range</td>
<td>Typ. 0.5 %, max. 1 %</td>
</tr>
</tbody>
</table>
| Relationship between input signal and hex code          | Table Output ranges voltage and current
  Chapter 5.2.6.7.2.11.3 “Output ranges voltage and current” on page 1236 |
| Unused outputs                                          | Are configured as "unused" (default value) and can be left open-circuited |

### Technical data of the fast counter

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Used inputs</td>
<td>Terminal 2.0 (DI0), 2.1 (DI1)</td>
</tr>
<tr>
<td>Used outputs</td>
<td>Terminal 3.0 (DO0)</td>
</tr>
<tr>
<td>Counting frequency</td>
<td>Depending on operation mode:</td>
</tr>
<tr>
<td></td>
<td>Mode 1 - 6: max. 200 kHz</td>
</tr>
<tr>
<td></td>
<td>Mode 7: max. 50 kHz</td>
</tr>
<tr>
<td></td>
<td>Mode 9: max. 35 kHz</td>
</tr>
<tr>
<td></td>
<td>Mode 10: max. 20 kHz</td>
</tr>
</tbody>
</table>

*Chapter 6.8.2.12 “Fast counters in AC500 devices” on page 4536*
Dimensions

1  Din rail 15 mm
2  Din rail 7.5 mm

The dimensions are in mm and in brackets in inch.

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 220 600 R0001</td>
<td>CI501-PNIO (V3), PROFINET communication interface module, 8 DI, 8 DO, 4 AI and 2 AO</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 420 600 R0001</td>
<td>CI501-PNIO-XC (V3), PROFINET communication interface module, 8 DI, 8 DO, 4 AI and 2 AO, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
5.2.6.7.3 CI502-PNIO

Features

- 8 digital inputs 24 V DC
- 8 digital outputs 24 V DC, 0.5 A max.
- 8 configurable digital inputs/outputs 24 V DC, 0.5 A max.
- Module-wise galvanically isolated
- Fast counter
- XC version for usage in extreme ambient conditions available
### Intended purpose

The PROFINET communication interface module CI502-PNIO is used as communication interface module in PROFINET networks. The network connection is performed via 2 RJ45 connectors which are integrated in the terminal unit.

For usage in extreme ambient conditions (e.g. wider temperature and humidity range), a special XC version of the device is available.

### Functionality

The CI502 communication interface module contains 24 I/O channels with the following properties:

- 8 digital configurable inputs/outputs
- 8 digital inputs: 24 V DC
- 8 digital outputs: 24 V DC, 0.5 A max.

The inputs/outputs are galvanically isolated from the Ethernet network. There is no potential separation between the channels. The configuration of the analog inputs/outputs is performed by software.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface</td>
<td>Ethernet</td>
</tr>
<tr>
<td>Protocol</td>
<td>PROFINET IO RT</td>
</tr>
<tr>
<td>Power supply</td>
<td>From the process supply voltage UP</td>
</tr>
<tr>
<td>Supply of the electronic circuitry of the I/O expansion modules attached</td>
<td>Through the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>Rotary switches</td>
<td>For setting the IO device identifier for configuration purposes (00h to FFh)</td>
</tr>
<tr>
<td>Configurable digital inputs/outputs</td>
<td>8 (configurable via software)</td>
</tr>
<tr>
<td>Digital inputs</td>
<td>8 (24 V DC; delay time configurable via software)</td>
</tr>
<tr>
<td>Digital outputs</td>
<td>8 (24 V DC, 0.5 A max.)</td>
</tr>
<tr>
<td>LED displays</td>
<td>For system displays, signal states, errors and power supply</td>
</tr>
<tr>
<td>External supply voltage</td>
<td>Via terminals ZP, UP and UP3 (process supply voltage 24 V DC)</td>
</tr>
<tr>
<td>Effect of incorrect input terminal connection</td>
<td>Wrong or no signal detected, no damage up to 35 V</td>
</tr>
<tr>
<td>Required terminal unit</td>
<td>TU507-ETH or TU508-ETH 🌐 Chapter 5.2.7.2 “TU507-ETH and TU508-ETH for Ethernet communication interface modules” on page 1270</td>
</tr>
</tbody>
</table>
Connections

General

The Ethernet communication interface module CI502-PNIO is plugged on the I/O terminal unit TU507-ETH or TU508-ETH. Properly seat the module and press until it locks in place. The terminal unit is mounted on a DIN rail or with 2 screws plus the additional accessory for wall mounting.

The connection of the I/O channels is carried out using the 30 terminals of the I/O terminal unit. I/O modules can be replaced without re-wiring the terminal units.

For a detailed description of the mounting, disassembly and connection of the module, please refer to the installation instructions.

The terminals 1.8 and 2.8 as well as 1.9, 2.9 and 3.9 are electrically interconnected within the terminal unit and have always the same assignment, independent of the inserted module:

- Terminals 1.8 and 2.8: Process supply voltage UP = +24 V DC
- Terminal 3.8: Process supply voltage UP3 = +24 V DC
- Terminals 1.9, 2.9 and 3.9: Process supply voltage ZP = 0 V.

The assignment of the other terminals:

With a separate UP3 power supply, the digital outputs can be switched off externally. This way, an emergency-off functionality can be realized.

Do not connect any voltages externally to digital outputs!

This ist not intended usage.

Reason: Externally voltages at one or more terminals DC0 ... DC7 or DO0 ... DO7 may cause that other digital outputs are supplied through that voltage instead of voltage UP3 (reverse voltage).

This is also possible, if DC channels are used as inputs. For this, the source for the input signals should be the impressed UP3 of the device.

This limitation does not apply for the input channels DI0 ... DI7.

CAUTION!
Risk of malfunction by unintended usage!

If the function cut-off of the digital outputs is to be used by deactivation of the supply voltage UP3, be sure that no external voltage is connected at the outputs DO0 ... DO7 and DC0 ... DC7.
<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>DC0</td>
<td>Signal of the configurable digital input/output DC0</td>
</tr>
<tr>
<td>1.1</td>
<td>DC1</td>
<td>Signal of the configurable digital input/output DC1</td>
</tr>
<tr>
<td>1.2</td>
<td>DC2</td>
<td>Signal of the configurable digital input/output DC2</td>
</tr>
<tr>
<td>1.3</td>
<td>DC3</td>
<td>Signal of the configurable digital input/output DC3</td>
</tr>
<tr>
<td>1.4</td>
<td>DC4</td>
<td>Signal of the configurable digital input/output DC4</td>
</tr>
<tr>
<td>1.5</td>
<td>DC5</td>
<td>Signal of the configurable digital input/output DC5</td>
</tr>
<tr>
<td>1.6</td>
<td>DC6</td>
<td>Signal of the configurable digital input/output DC6</td>
</tr>
<tr>
<td>1.7</td>
<td>DC7</td>
<td>Signal of the configurable digital input/output DC7</td>
</tr>
<tr>
<td>1.8</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>1.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
<tr>
<td>2.0</td>
<td>DI8</td>
<td>Signal of the digital input DI8</td>
</tr>
<tr>
<td>2.1</td>
<td>DI9</td>
<td>Signal of the digital input DI9</td>
</tr>
<tr>
<td>2.2</td>
<td>DI10</td>
<td>Signal of the digital input DI10</td>
</tr>
<tr>
<td>2.3</td>
<td>DI11</td>
<td>Signal of the digital input DI11</td>
</tr>
<tr>
<td>2.4</td>
<td>DI12</td>
<td>Signal of the digital input DI12</td>
</tr>
<tr>
<td>2.5</td>
<td>DI13</td>
<td>Signal of the digital input DI13</td>
</tr>
<tr>
<td>2.6</td>
<td>DI14</td>
<td>Signal of the digital input DI14</td>
</tr>
<tr>
<td>2.7</td>
<td>DI15</td>
<td>Signal of the digital input DI15</td>
</tr>
<tr>
<td>2.8</td>
<td>UP</td>
<td>Process voltage UP (24 V DC)</td>
</tr>
<tr>
<td>2.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
<tr>
<td>3.0</td>
<td>DO8</td>
<td>Signal of the digital output DO8</td>
</tr>
<tr>
<td>3.1</td>
<td>DO9</td>
<td>Signal of the digital output DO9</td>
</tr>
<tr>
<td>3.2</td>
<td>DO10</td>
<td>Signal of the digital output DO10</td>
</tr>
<tr>
<td>3.3</td>
<td>DO11</td>
<td>Signal of the digital output DO11</td>
</tr>
<tr>
<td>3.4</td>
<td>DO12</td>
<td>Signal of the digital output DO12</td>
</tr>
<tr>
<td>3.5</td>
<td>DO13</td>
<td>Signal of the digital output DO13</td>
</tr>
<tr>
<td>3.6</td>
<td>DO14</td>
<td>Signal of the digital output DO14</td>
</tr>
<tr>
<td>3.7</td>
<td>DO15</td>
<td>Signal of the digital output DO15</td>
</tr>
<tr>
<td>3.8</td>
<td>UP3</td>
<td>Process voltage UP3 (24 V DC)</td>
</tr>
<tr>
<td>3.9</td>
<td>ZP</td>
<td>Process voltage ZP (0 V DC)</td>
</tr>
</tbody>
</table>
WARNING!
Removal/Insertion under power

The devices are not designed for removal or insertion under power. Because of unforeseeable consequences, it is not allowed to plug or unplug devices with the power being ON.

Make sure that all voltage sources (supply and process voltage) are switched off before you
  – connect or disconnect any signal or terminal block
  – remove, mount or replace a module.

Disconnecting any powered devices while energized in a hazardous location could result in an electric arc, which could create a flammable ignition resulting in fire or explosion.

Make sure that power is removed and that the area has been thoroughly checked to ensure that flammable materials are not present prior to proceeding.

The devices must not be opened when in operation. The same applies to the network interfaces.

NOTICE!
Risk of damaging the PLC modules!

Overvoltages and short circuits might damage the PLC modules.

  – Make sure that all voltage sources (supply voltage and process supply voltage) are switched off before you begin with operations on the system.
  – Never connect any voltages or signals to reserved terminals (marked with ---). Reserved terminals may carry internal voltages.

Fig. 255: Connection of the Ethernet communication interface module CI502-PNIO

▷ Chapter 6.8.4.2 “PROFINET communication interface module” on page 4596
Connection of the Digital inputs

Fig. 256: Connection of the digital inputs (DI8 ... DI15)

The meaning of the LEDs is described in 'Displays' Chapter 5.2.6.7.3.10 “State LEDs” on page 1261.
Connection of the Digital outputs

![Diagram showing the connection of digital outputs DO8 to DO15](image)

Fig. 257: Connection of the digital outputs (DO8 … DO15)

The meaning of the LEDs is described in 'Displays' Chapter 5.2.6.7.3.10 “State LEDs” on page 1261.
Connection of the configurable digital inputs/outputs

The following figure shows the connection of the configurable digital input/output DC0 and DC1. DC0 is connected as an input and DC1 is connected as an output. Proceed with the configurable digital inputs/outputs DC2 ... DC7 in the same way.

CAUTION!
If a DC channel is used as input, the source for the input signals should be the impressed UP3 of the device "Chapter 5.2.6.7.3.4 "Connections" on page 1246.

Fig. 258: Connection of the configurable digital inputs/outputs (DC0 ... DC7)(DC0 as input, DC1 as output)

The meaning of the LEDs is described in 'Displays' "Chapter 5.2.6.7.3.10 “State LEDs” on page 1261.

Assignment of the Ethernet ports

The terminal unit for the communication interface module provides two Ethernet interfaces with the following pin assignment:

<table>
<thead>
<tr>
<th>Pin assignment</th>
<th>Interface</th>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ethernet RJ45</td>
<td>1</td>
<td>TxD+</td>
<td>Transmit data +</td>
</tr>
<tr>
<td>2</td>
<td>Ethernet RJ45</td>
<td>2</td>
<td>TxD-</td>
<td>Transmit data -</td>
</tr>
<tr>
<td>3</td>
<td>Ethernet RJ45</td>
<td>3</td>
<td>RxD+</td>
<td>Receive data +</td>
</tr>
<tr>
<td>4</td>
<td>Ethernet RJ45</td>
<td>4</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td>5</td>
<td>Ethernet RJ45</td>
<td>5</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td>6</td>
<td>Ethernet RJ45</td>
<td>6</td>
<td>RxD-</td>
<td>Receive data -</td>
</tr>
<tr>
<td>7</td>
<td>Ethernet RJ45</td>
<td>7</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td>8</td>
<td>Ethernet RJ45</td>
<td>8</td>
<td>NC</td>
<td>Not connected</td>
</tr>
<tr>
<td></td>
<td>Shield</td>
<td></td>
<td>Cable shield</td>
<td>Functional earth</td>
</tr>
</tbody>
</table>
In corrosive environment, please protect unused connectors using the TA535 accessory.
Not supplied with this device.

Further information about wiring and cable types

### Internal data exchange

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital inputs (bytes)</td>
<td>5</td>
</tr>
<tr>
<td>Digital outputs (bytes)</td>
<td>5</td>
</tr>
<tr>
<td>Counter input data (words)</td>
<td>4</td>
</tr>
<tr>
<td>Counter output data (words)</td>
<td>8</td>
</tr>
</tbody>
</table>

### Addressing

The module has 2 rotary switches to set an explicit name to the PROFINET IO device before commissioning. No engineering tool is needed in this case.

The device gets its name (including the fixed part of the device name) with the switch settings (01h...FFh). This name can be used directly within the device configuration: “CI5xx-pn-yy”

"CI5xx-pn-yy" xx is the fixed part of the device name (e.g. CI501) and yy represents the position of the rotary switch (0..FFh). The rotary switch values must be entered in hexadecimal format. For example, to set the name to “CI5xx-pn-08”, set the upper rotary switch to “0” and the lower switch to “8”.

The module reads the position of the rotary switches only during power-up, i.e. changes of the switch position during operation will have no effect until the next module initialization.

### I/O configuration

The CI502-PNIO stores some PROFINET configuration parameters (I/O device identifier, I/O device type and IP address configuration). No more configuration data is stored.

The digital I/O channels are configured via software.

Details about configuration are described in 'Parameterization' Chapter 5.2.6.7.3.8 “Parameterization” on page 1253.
### Parameterization

#### Parameters of the module

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Internal value</th>
<th>Internal value, type</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Internal</td>
<td>7005</td>
<td>WORD</td>
<td>7005</td>
</tr>
<tr>
<td>Parameter length</td>
<td>Internal</td>
<td>8</td>
<td>BYTE</td>
<td>8</td>
</tr>
<tr>
<td>Error LED / Fail-safe function</td>
<td>On</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Off by E4</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off by E3</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>On + failsafe</td>
<td>16</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off by E4 + fail-safe</td>
<td>17</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off by E3 + fail-safe</td>
<td>19</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Process cycle time</td>
<td>1 ms process cycle time</td>
<td>1</td>
<td>BYTE</td>
<td>1 ms</td>
</tr>
<tr>
<td></td>
<td>2 ms process cycle time</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3 ms process cycle time</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 ms process cycle time</td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 ms process cycle time</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>6 ms process cycle time</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>7 ms process cycle time</td>
<td>7</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 ms process cycle time</td>
<td>8</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>9 ms process cycle time</td>
<td>9</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>10 ms process cycle time</td>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>11 ms process cycle time</td>
<td>11</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>12 ms process cycle time</td>
<td>12</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>13 ms process cycle time</td>
<td>13</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>14 ms process cycle time</td>
<td>14</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>15 ms process cycle time</td>
<td>15</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>16 ms process cycle time</td>
<td>16</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Check supply</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Value</td>
<td>Internal value</td>
<td>Internal value, type</td>
<td>Default</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------</td>
<td>----------------</td>
<td>-----------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Fast counter</td>
<td>0</td>
<td>0</td>
<td>BYTE</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>I/O-Bus reset</td>
<td>Off</td>
<td>0</td>
<td>BYTE</td>
<td>Off</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>1</td>
<td>BYTE</td>
<td>Off</td>
</tr>
</tbody>
</table>

1) With a faulty ID, the module reports a "parameter error" and does not perform cyclic process data transmission.

2) Counter operating modes \( \text{Chapter 5.2.4.3.2.9 "Fast counter" on page 606} \)

### Table 285: Table Error LED / Failsafe function

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Error LED (S-ERR) lights up at errors of all error classes, Failsafe-mode off</td>
</tr>
<tr>
<td>Off by E4</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1, E2 and E3, Failsafe-mode off</td>
</tr>
<tr>
<td>Off by E3</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1 and E2, Failsafe-mode off</td>
</tr>
<tr>
<td>On + Failsafe</td>
<td>Error LED (S-ERR) lights up at errors of all error classes, Failsafe-mode on *)</td>
</tr>
<tr>
<td>Off by E4 + Failsafe</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1, E2 and E3, Failsafe-mode on *)</td>
</tr>
<tr>
<td>Off by E3 + Failsafe</td>
<td>Error LED (S-ERR) lights up at errors of error classes E1 and E2, Failsafe-mode on *)</td>
</tr>
</tbody>
</table>

*) The parameter Behaviour DO at comm. error is only analyzed if the Failsafe-mode is ON.

**IO-BUS reset after PROFINET reconnection**

IO-BUS reset after PROFINET reconnection controls the behavior of PROFINET CI modules in relation to connected I/O modules (both safety and non-safety I/O modules).
• IO-BUS reset after PROFINET reconnection = “On” resets and, thus, re-parameterizes all attached I/O modules. All internal I/O modules states are reset, including the related diagnosis information.
  Note that if the parameter is set to “On” then:
  – The bumpless re-start of non-safety I/O modules will not be supported. It means, for example, that non-safety output channels will go from fail-safe values to “0” values during the re-connection and re-parameterization time and after that go to new output values.
  – Safety I/O modules will be re-parameterized and re-started as newly started modules, which may not require their PROFIsafe reintegration, depending on safety CPU state, in the safety application.
• IO-BUS reset after PROFINET reconnection = “Off” will not reset all attached I/O modules. It will re-parameterize I/O modules only if parameter change is detected during the reconnection. All internal I/O modules states are not reset, including the related diagnosis information.
  Note that if the parameter is set to “Off” then:
  – The bumpless re-start of non-safety I/O modules is supported (if no parameters are changed). It means, for example, that non-safety output channels will not go from fail-safe values to “0” values during the re-connection and re-parameterization time, but directly from fail-safe values to new output values.
  – Safety I/O modules will not be re-parameterized (if no parameters are changed). Thus, they may continue their operation, which may require their PROFIsafe reintegration in the safety application on the safety CPU, e.g., if PROFIsafe watchdog time for this safety I/O module has expired. Any reintegration of such safety I/O modules will be not only application specific but also PROFIsafe specific and depend on the safety I/O handling in the safety application.

<table>
<thead>
<tr>
<th>Group parameters for the digital part</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
</tr>
<tr>
<td>-------------------------------------</td>
</tr>
<tr>
<td>Input delay</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Detect short circuit at outputs</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Behaviour DO at comm. error 1)</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Substitute value at output</td>
</tr>
</tbody>
</table>
### Name

<table>
<thead>
<tr>
<th>Preventive voltage feedback monitoring for DC0..DC7 2)</th>
<th>Off</th>
<th>On</th>
<th>0</th>
<th>1</th>
<th>BYTE</th>
<th>Off</th>
<th>0x00</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detect voltage overflow at outputs 3)</td>
<td>Off</td>
<td>On</td>
<td>0</td>
<td>1</td>
<td>BYTE</td>
<td>Off</td>
<td>0x00</td>
</tr>
</tbody>
</table>

**Remarks:**

1) The parameter Behaviour DO at comm. error is apply to DC and DO channels and only analyzed if the Failsafe-mode is ON.

2) The state "externally voltage detected" appears, if the output of a channel DC0 ... DC7 should be switched on while an externally voltage is connected. In this case the start up is disabled, as long as the externally voltage is connected. The monitoring of this state and the resulting diagnosis message can be disabled by setting the parameters to "OFF".

3) The error state "voltage overflow at outputs" appears, if externally voltage at digital outputs DC0 ... DC7 and accordingly DO0 ... DO7 has exceeded the process supply voltage UP3. The according diagnosis message "Voltage overflow on outputs " can be disabled by setting the parameters on "OFF". This parameter should only be disabled in exceptional cases for voltage overflow may produce reverse voltage.

### Diagnosis

Structure of the Diagnosis Block via function block PNIO_DEV_ALARM.

<table>
<thead>
<tr>
<th>Byte Number</th>
<th>Description</th>
<th>Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Diagnosis Byte, slot number</td>
<td>31 = CI502-PNIO (e.g. error at integrated 8 DI / 8 DO)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = 1st connected S500 I/O module</td>
</tr>
<tr>
<td></td>
<td></td>
<td>...</td>
</tr>
<tr>
<td></td>
<td></td>
<td>10 = 10th connected S500 I/O module</td>
</tr>
<tr>
<td>2</td>
<td>Diagnosis Byte, module number</td>
<td>According to the I/O bus specification passed on by modules to the fieldbus master</td>
</tr>
<tr>
<td>3</td>
<td>Diagnosis Byte, channel</td>
<td>According to the I/O bus specification passed on by modules to the fieldbus master</td>
</tr>
</tbody>
</table>
### Byte Number 4

<table>
<thead>
<tr>
<th>Description</th>
<th>Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diagnosis Byte, error code</td>
<td>According to the I/O bus specification</td>
</tr>
<tr>
<td></td>
<td>Bit 7 and bit 6, coded error class</td>
</tr>
<tr>
<td></td>
<td>0 = E1</td>
</tr>
<tr>
<td></td>
<td>1 = E2</td>
</tr>
<tr>
<td></td>
<td>2 = E3</td>
</tr>
<tr>
<td></td>
<td>3 = E4</td>
</tr>
<tr>
<td></td>
<td>Bit 0 to bit 5, coded error description</td>
</tr>
</tbody>
</table>

### Byte Number 5

<table>
<thead>
<tr>
<th>Description</th>
<th>Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diagnosis Byte, flags</td>
<td>According to the I/O bus specification</td>
</tr>
<tr>
<td></td>
<td>Bit 7: 1 = coming error</td>
</tr>
<tr>
<td></td>
<td>Bit 6: 1 = leaving error</td>
</tr>
</tbody>
</table>

In cases of short circuit or overload, the digital outputs are turned off. The modules performs reactivation automatically. Thus an acknowledgement of the errors is not necessary. The error message is stored via the LED.

<table>
<thead>
<tr>
<th>E1 ... E4</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Identifer</th>
<th>AC500-Display</th>
<th>Display in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Comp</td>
<td>Dev</td>
<td>Mod</td>
<td>Ch</td>
<td>Err</td>
<td>PS501 PLC Browser</td>
<td></td>
</tr>
<tr>
<td>Byte 4</td>
<td>-</td>
<td>Byte 1</td>
<td>Byte 2</td>
<td>Byte 3</td>
<td>Byte 4</td>
<td>Bit 0 ... 5</td>
<td>PNIO diag-nosis block</td>
</tr>
<tr>
<td>Bit 6 ... 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error-Identifer</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Module errors

<table>
<thead>
<tr>
<th>Byte</th>
<th>Error-Identifer</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>19</td>
<td>Checksum error in the I/O module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>Timeout in the I/O module</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>40</td>
<td>Different hard-/firmware versions in the module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>43</td>
<td>Internal error in the module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>36</td>
<td>Internal data exchange failure</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>9</td>
<td>Overflow diagnosis buffer</td>
<td>Restart</td>
</tr>
<tr>
<td>3</td>
<td>26</td>
<td>Parameter error</td>
<td>Check master</td>
</tr>
</tbody>
</table>

---

Hardware descriptions

Device specifications > Communication interface modules

2024/01/05 3ADR010583, 1, en_US 1257
### Hardware descriptions

**Device specifications > Communication interface modules**

<table>
<thead>
<tr>
<th>Class</th>
<th>Interface</th>
<th>Device</th>
<th>Module</th>
<th>Channel</th>
<th>Error-Identifier</th>
<th>Error message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>11</td>
<td>Process voltage UP too low</td>
<td>Check process supply voltage</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>45</td>
<td>Process voltage UP gone</td>
<td>Check process supply voltage</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>17</td>
<td>No communication with I/O device</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>1</td>
<td>31</td>
<td>31</td>
<td>32</td>
<td>Wrong I/O device type on socket</td>
<td>Replace I/O module / Check configuration</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>At least one module does not support failsafe function</td>
<td>Check modules and parameterization</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1</td>
<td>31</td>
<td>5</td>
<td>8</td>
<td>I/O module removed from hot swap terminal unit or defective module on hot swap terminal unit ³)</td>
<td>Plug I/O module, replace I/O module</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1</td>
<td>31</td>
<td>5</td>
<td>28</td>
<td>Wrong I/O module plugged on hot swap terminal unit ³)</td>
<td>Remove wrong I/O module and plug projected I/O module</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1</td>
<td>31</td>
<td>5</td>
<td>42</td>
<td>No communication with I/O module on hot swap terminal unit ³)</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>Class</td>
<td>Interface</td>
<td>Device</td>
<td>Module</td>
<td>Channel</td>
<td>Error- Identifier</td>
<td>Error message</td>
<td>Remedy</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1 ... 10</td>
<td>31</td>
<td>5</td>
<td>54</td>
<td>I/O module does not support hot swap</td>
<td>Power off system and replace I/O module</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1 ... 10</td>
<td>31</td>
<td>6</td>
<td>8</td>
<td>Hot swap terminal unit configured but not found</td>
<td>Replace terminal unit by hot swap terminal unit</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1 ... 10</td>
<td>31</td>
<td>6</td>
<td>42</td>
<td>No communication with hot swap terminal unit</td>
<td>Restart, if error persists replace terminal unit</td>
</tr>
<tr>
<td>4</td>
<td>1...6</td>
<td>255</td>
<td>2</td>
<td>0</td>
<td>45</td>
<td>The connected Communication Module has no connection to the network</td>
<td>Check cabling</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>45</td>
<td>Process voltage UP3 too low</td>
<td>Check process voltage</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>46</td>
<td>Reverse voltage from digital outputs DO0..DO7 to UP3</td>
<td>Check terminals</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31/1 ... 10</td>
<td>31</td>
<td>31</td>
<td>34</td>
<td>No response during initialization of the I/O module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>11</td>
<td>Process voltage UP3 too low</td>
<td>Check process supply voltage</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>45</td>
<td>Process voltage UP3 gone</td>
<td>Check process supply voltage</td>
</tr>
<tr>
<td>Class</td>
<td>Interface</td>
<td>Device</td>
<td>Module</td>
<td>Channel</td>
<td>Error-Identifier</td>
<td>Error message</td>
<td>Remedy</td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>--------</td>
<td>--------</td>
<td>---------</td>
<td>-----------------</td>
<td>---------------</td>
<td>--------</td>
</tr>
<tr>
<td>1)</td>
<td>2)</td>
<td>3)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>31</td>
<td>31</td>
<td>31</td>
<td>10</td>
<td>Voltage overflow at outputs (above UP3 level) 5)</td>
<td>Check terminals/ check process supply voltage</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Externally voltage detected at digital output DO0 ... DO7 6)</td>
<td>Check terminals</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Externally voltage detected at digital output DC0 ... DC7 6)</td>
<td>Check terminals</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Short circuit at digital output DC0 ... DC7 7)</td>
<td>Check terminals</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Short circuit at digital output DO0 ... DO7 7)</td>
<td>Check terminals</td>
</tr>
</tbody>
</table>

Remarks:

1) In AC500 the following interface identifier applies: "-" = Diagnosis via bus-specific function blocks; 0 ... 4 or 10 = Position of the Communication Module; 14 = I/O-Bus; 31 = Module itself
The identifier is not contained in the CI502-PNIO diagnosis block.

2) With "Device" the following allocation applies: 31 = Module itself, 1 ... 10 = Expansion module

3) With "Module" the following allocation applies dependent of the master:
Module error: 31 = Module itself
Channel error: Module type (1 = AI, 2 = DO, 3 = AO)
This message appears, if externally voltages at one or more terminals DC0 ... DC7 oder DO0 ... DO7 cause that other digital outputs are supplied through that voltage (voltage feedback, see description in 'Connections' Chapter 5.2.6.7.3.4 “Connections” on page 1246. All outputs of the apply digital output groups will be turned off for 5 seconds. The diagnosis message appears for the whole output group.

The voltage at digital outputs DC0 ... DC7 and accordingly DO0 ... DO7 has exceeded the process supply voltage UP3 (see Chapter 5.2.6.7.3.4 “Connections” on page 1246. Diagnosis message appears for the whole module.

This message appears, if the output of a channel DC0 ... DC7 or DO0 ... DO7 should be switched on while an externally voltage is connected. In this case the start up is disabled, as long as the externally voltage is connected. Otherwise this could produce reverse voltage from this output to other digital outputs. This diagnosis message appears per channel.

Short circuit: After a detected short circuit, the output is deactivated for 2000 ms. Then a new start up will be executed. This diagnosis message appears per channel.

In case of an I/O module doesn’t support hot swapping, do not perform any hot swap operations (also not on any other terminal units (slots)) as modules may be damaged or I/O bus communication may be disturbed.

Diagnosis for hot swap available as of version index F0.

State LEDs

The LEDs are located at the front of module. There are 2 different groups:

- The 5 system LEDs (PWR, STA1 ETH, STA2 ETH, S-ERR and I/O-Bus) show the operation state of the module and display possible errors.
- The 29 process LEDs (UP, UP3, inputs, outputs, CH-ERR1 to CH-ERR3) show the process supply voltage and the states of the inputs and outputs and display possible errors.

Table 286: States of the 5 system LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>OFF</th>
<th>ON</th>
<th>Flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR/RUN</td>
<td>Green</td>
<td>Process supply voltage missing</td>
<td>Internal supply voltage OK, module ready for communication with IO Controller</td>
<td>Start-up / preparing communication</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>STA1 ETH</td>
<td>Green</td>
<td>---</td>
<td>Device configured, cyclic data exchange running</td>
<td>---</td>
</tr>
<tr>
<td>(System-LED &quot;BF&quot;)</td>
<td>Red</td>
<td>---</td>
<td>---</td>
<td>Device is not configured</td>
</tr>
<tr>
<td>STA2 ETH</td>
<td>Green</td>
<td>---</td>
<td>---</td>
<td>Got identification request from I/O controller</td>
</tr>
<tr>
<td>(System LED &quot;SF&quot;)</td>
<td>Red</td>
<td>No system error</td>
<td>System error (collective error)</td>
<td>---</td>
</tr>
<tr>
<td>S-ERR</td>
<td>Red</td>
<td>No error</td>
<td>Internal error</td>
<td>---</td>
</tr>
<tr>
<td>LED</td>
<td>Color</td>
<td>OFF</td>
<td>ON</td>
<td>Flashing</td>
</tr>
<tr>
<td>---------</td>
<td>-------</td>
<td>------------------------------------------</td>
<td>-----------------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>I/O-Bus</td>
<td>Green</td>
<td>No expansion modules connected or comm-</td>
<td>Expansion modules connected and</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>unication error</td>
<td>operational</td>
<td></td>
</tr>
<tr>
<td>ETH1</td>
<td>Green</td>
<td>No connection at Ethernet interface</td>
<td>Connected to Ethernet interface</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>---</td>
<td>Device is transmitting telegrams</td>
<td></td>
</tr>
<tr>
<td>ETH2</td>
<td>Green</td>
<td>No connection at Ethernet interface</td>
<td>Connected to Ethernet interface</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>---</td>
<td>Device is transmitting telegrams</td>
<td></td>
</tr>
</tbody>
</table>

Table 287: States of the 29 process LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>OFF</th>
<th>ON</th>
<th>Flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC0 ... DC7</td>
<td>Yellow</td>
<td>Input/Output is OFF</td>
<td>Input/Output is ON</td>
<td>--</td>
</tr>
<tr>
<td>DI8 ... DI15</td>
<td>Yellow</td>
<td>Input is OFF</td>
<td>Input is ON (the input voltage is even displayed if the supply voltage is OFF)</td>
<td>--</td>
</tr>
<tr>
<td>DO8 ... DO15</td>
<td>Yellow</td>
<td>Output is OFF</td>
<td>Output is ON</td>
<td>--</td>
</tr>
<tr>
<td>UP</td>
<td>Green</td>
<td>Process supply voltage missing</td>
<td>Process supply voltage OK and</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>initialization finished</td>
<td></td>
</tr>
<tr>
<td>UP3</td>
<td>Green</td>
<td>Process supply voltage missing</td>
<td>Process supply voltage OK</td>
<td>--</td>
</tr>
<tr>
<td>CH-ERR1 to CH-ERR3</td>
<td>Red</td>
<td>No error or process supply voltage missing</td>
<td>Internal error</td>
<td>Error on one channel of the corresponding group</td>
</tr>
</tbody>
</table>

**Technical data**

**Technical data of the module**

The system data of AC500 and S500 are applicable to the standard version “Chapter 5.1.2 ‘System data AC500’ on page 166.”

The system data of AC500-XC are applicable to the XC version “Chapter 5.1.3 ‘System data AC500-XC’ on page 169.”

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.
### Parameter | Value
---|---
Process supply voltages UP/UP3 |  
Rated value | 24 V DC (for inputs and outputs)
Max. load for the terminals | 10 A
Protection against reversed voltage | Yes
Rated protection fuse on UP/UP3 | 10 A fast
Galvanic isolation | Ethernet interface against the rest of the module
Inrush current from UP (at power up) | On request
Current consumption via UP (normal operation) | 0.15 A
Current consumption via UP3 | 0.06 A + 0.5 A max. per output
Connections | Terminals 1.8 and 2.8 for +24 V (UP)
| Terminal 3.8 for +24 V (UP3)
| Terminals 1.9, 2.9 and 3.9 for 0 V (ZP)
Max. power dissipation within the module | 6 W
Number of digital inputs | 8
Number of digital outputs | 8
Number of configurable digital inputs/outputs | 8
Input data length | 12 bytes
Output data length | 20 bytes
Reference potential for all digital inputs and outputs | Negative terminal of the supply voltage, signal name ZP
Setting of the I/O device identifier | With 2 rotary switches at the front side of the module
Diagnosis | See Diagnosis and Displays \( \text{\textcopyright Chapter 5.2.6.7.3.9} \) “Diagnosis” on page 1256
Operation and error displays | 34 LEDs (totally)
Weight (without terminal unit) | Ca. 125 g
Mounting position | Horizontal or vertical with derating (output load reduced to 50 % at +40 °C per group)
Extended ambient temperature (XC version) | > +60 °C on request
Cooling | The natural convection cooling must not be hindered by cable ducts or other parts in the control cabinet.

**NOTICE!**
All I/O channels (digital and analog) are protected against reverse polarity, reverse supply, short circuit and temporary overvoltage up to 30 V DC.

**Multiple overloads**
No effects of multiple overloads on isolated multi-channel modules occur, as every channel is protected individually by an internal smart high-side switch.
### Technical data of the digital inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels DI0 ... DI7</td>
<td>Terminals 2.0 ... 2.7</td>
</tr>
<tr>
<td>Reference potential for all inputs</td>
<td>Terminals 1.9 ... 3.9 (Negative terminal of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel, the LED is ON when the input signal is high (signal 1)</td>
</tr>
<tr>
<td>Input type (according EN 61131-2)</td>
<td>Type 1</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 0.1 ms, configurable from 0.1 ms ... 32 ms</td>
</tr>
</tbody>
</table>
### Technical data of the digital outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels DO0 ... DO7</td>
<td>Terminals 3.0 ... 3.7</td>
</tr>
<tr>
<td>Reference potential for all outputs</td>
<td>Terminals 1.9 ... 3.9 (negative terminal of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>For all outputs terminal 3.8 (positive terminal of the supply voltage, signal name UP3)</td>
</tr>
<tr>
<td>Output voltage for signal 1</td>
<td>UP3 (-0.8 V)</td>
</tr>
<tr>
<td>Output delay (0-&gt;1 or 1-&gt;0)</td>
<td>On request</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated value per channel</td>
<td>500 mA at UP3 = 24 V</td>
</tr>
<tr>
<td>Max. value (all channels together)</td>
<td>4 A</td>
</tr>
<tr>
<td>Leakage current with signal 0</td>
<td>&lt; 0.5 mA</td>
</tr>
<tr>
<td>Fuse for UP3</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Demagnetization with inductive DC load</td>
<td>Via internal varistors (see figure below this table)</td>
</tr>
<tr>
<td>Output switching frequency</td>
<td></td>
</tr>
<tr>
<td>With resistive load</td>
<td>On request</td>
</tr>
<tr>
<td>With inductive loads</td>
<td>Max. 0.5 Hz</td>
</tr>
<tr>
<td>With lamp loads</td>
<td>11 Hz max. at 5 W max.</td>
</tr>
<tr>
<td>Short-circuit-proof / overload-proof</td>
<td>Yes</td>
</tr>
<tr>
<td>Overload message (I &gt; 0.7 A)</td>
<td>Yes, after ca. 100 ms</td>
</tr>
</tbody>
</table>
The following drawing shows the circuitry of a digital input/output with the varistors for demagnetization when inductive loads are switched off.

```
 1  Digital output
 2  Varistors for demagnetization when inductive loads are turned off
```

### Technical data of the configurable digital inputs/outputs

Each of the configurable I/O channels is defined as input or output by the user program. This is done by interrogating or allocating the corresponding channel.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8 inputs/outputs (with transistors)</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group for 8 channels</td>
</tr>
<tr>
<td>If the channels are used as inputs</td>
<td></td>
</tr>
<tr>
<td>Channels DC0 ... DC07</td>
<td>Terminals 1.0 ... 1.7</td>
</tr>
<tr>
<td>If the channels are used as outputs</td>
<td></td>
</tr>
<tr>
<td>Channels DC0 ... DC07</td>
<td>Terminals 1.0 ... 1.7</td>
</tr>
<tr>
<td>Indication of the input/output signals</td>
<td>1 yellow LED per channel, the LED is ON when the input/output signal is high (signal 1)</td>
</tr>
<tr>
<td>Galvanic isolation</td>
<td>From the Ethernet network</td>
</tr>
</tbody>
</table>

### Technical data of the digital inputs/outputs if used as inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels DC0 ... DC7</td>
<td>Terminals 1.0 ... 1.7</td>
</tr>
<tr>
<td>Reference potential for all inputs</td>
<td>Terminals 1.9 ... 3.9 (Negative terminal of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Indication of the input signals</td>
<td>1 yellow LED per channel, the LED is ON when the input signal is high (signal 1)</td>
</tr>
<tr>
<td>Input type (according EN 61131-2)</td>
<td>Type 1</td>
</tr>
<tr>
<td>Input delay (0-&gt;1 or 1-&gt;0)</td>
<td>Typ. 0.1 ms, configurable from 0.1 ms ... 32 ms</td>
</tr>
<tr>
<td>Input signal voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Signal 0</td>
<td>-3 V ... +5 V</td>
</tr>
<tr>
<td>Undefined Signal</td>
<td>&gt; +5 V ... &lt; +15 V</td>
</tr>
<tr>
<td>Signal 1</td>
<td>+15 V ... +30 V</td>
</tr>
<tr>
<td>Ripple with signal 0</td>
<td>Within -3 V ... +5 V</td>
</tr>
<tr>
<td>Ripple with signal 1</td>
<td>Within +15 V ... +30 V</td>
</tr>
<tr>
<td>Input current per channel</td>
<td></td>
</tr>
<tr>
<td>Input voltage +24 V</td>
<td>Typ. 5 mA</td>
</tr>
<tr>
<td>Input voltage +5 V</td>
<td>&gt; 1 mA</td>
</tr>
<tr>
<td>Input voltage +15 V</td>
<td>&gt; 2 mA</td>
</tr>
<tr>
<td>Input voltage +30 V</td>
<td>&lt; 8 mA</td>
</tr>
<tr>
<td>Max. cable length</td>
<td></td>
</tr>
<tr>
<td>Shielded</td>
<td>1000 m</td>
</tr>
<tr>
<td>Unshielded</td>
<td>600 m</td>
</tr>
</tbody>
</table>

*) Due to the direct connection to the output, the demagnetizing varistor is also effective at the input (see figure) above. This is why the difference between UPx and the input signal may not exceed the clamp voltage of the varistor. The varistor limits the voltage to approx. 36 V. Following this, the input voltage must range from -12 V ... +30 V when UPx = 24 V and from -6 V ... +30 V when UPx = 30 V.

Technical data of the digital inputs/outputs if used as outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels per module</td>
<td>8</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>1 group of 8 channels</td>
</tr>
<tr>
<td>Terminals of the channels DC0 ... DC7</td>
<td>Terminals 1.0 ... 1.7</td>
</tr>
<tr>
<td>Reference potential for all outputs</td>
<td>Terminals 1.9 ... 3.9 (negative terminal of the supply voltage, signal name ZP)</td>
</tr>
<tr>
<td>Common power supply voltage</td>
<td>For all outputs terminal 3.8 (positive terminal of the supply voltage, signal name UP3)</td>
</tr>
<tr>
<td>Output voltage for signal 1</td>
<td>UP3 (-0.8 V)</td>
</tr>
<tr>
<td>Output delay (0-&gt;1 or 1-&gt;0)</td>
<td>On request</td>
</tr>
<tr>
<td>Output current</td>
<td></td>
</tr>
<tr>
<td>Rated value per channel</td>
<td>500 mA at UP3 = 24 V</td>
</tr>
<tr>
<td>Max. value (all channels together)</td>
<td>4 A</td>
</tr>
<tr>
<td>Leakage current with signal 0</td>
<td>&lt; 0.5 mA</td>
</tr>
<tr>
<td>Fuse for UP3</td>
<td>10 A fast</td>
</tr>
<tr>
<td>Demagnetization with inductive DC load</td>
<td>Via internal varistors (see figure below this table)</td>
</tr>
</tbody>
</table>
### Technical data of the fast counter

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Used inputs</td>
<td>Terminal 2.0 (DI8), Terminal 2.1 (DI9)</td>
</tr>
<tr>
<td>Used outputs</td>
<td>Terminal 3.0 (DO8)</td>
</tr>
<tr>
<td>Counting frequency</td>
<td>Depending on operation mode:</td>
</tr>
<tr>
<td></td>
<td>Mode 1- 6: max. 200 kHz</td>
</tr>
<tr>
<td></td>
<td>Mode 7: max. 50 kHz</td>
</tr>
<tr>
<td></td>
<td>Mode 9: max. 35 kHz</td>
</tr>
<tr>
<td></td>
<td>Mode 10: max. 20 kHz</td>
</tr>
</tbody>
</table>

*Chapter 6.8.2.12 “Fast counters in AC500 devices” on page 4536*
## Dimensions

![Diagram of dimensions]

1. Din rail 15 mm
2. Din rail 7.5 mm

*The dimensions are in mm and in brackets in inch.*

## Ordering data

<table>
<thead>
<tr>
<th>Active</th>
<th>Active</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 220 700 R0001</td>
<td>CI502-PNIO (V3), PROFINET communication interface module, 8 DI, 8 DO and 8 DC</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 420 700 R0001</td>
<td>CI502-PNIO-XC (V3), PROFINET communication interface module, 8 DI, 8 DO and 8 DC, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
5.2.7 Terminal units for communication interface modules

5.2.7.1 Safety instructions

**Hot swap**

System requirements for hot swapping of I/O modules:
- Types of terminal units that support hot swapping of I/O modules have the appendix TU5xx-H.
- I/O modules as of index F0.

The following I/O bus masters support hot swapping of attached I/O modules:
- Communication interface modules CI5xx as of index F0.
- Processor modules PM56xx-2ETH with firmware version as of V3.2.0.

---

**NOTICE!**

Risk of damage to I/O modules!

- Hot swapping is only allowed for I/O modules.
- Processor modules and communication interface modules must not be removed or inserted during operation.

---

**Conditions for hot swapping**

- Digital outputs are not under load.
- Input/output voltages above safety extra low voltage/protective extra low voltages (SELV/PELV) are switched off.
- Modules are completely plugged on the terminal unit with both snap fit engaged before switching on loads or input/output voltage.

Further information about hot swap.

5.2.7.2 TU507-ETH and TU508-ETH for Ethernet communication interface modules

5.2.7.2.1 Features

- TU507-ETH, Ethernet terminal unit, 24 V DC, screw terminals
- TU508-ETH, Ethernet terminal unit, 24 V DC, spring terminals
- TU508-ETH-XC, Ethernet terminal unit, 24 V DC, spring terminals, XC version
1 I/O bus (10 pins, female) to connect the first terminal unit
2a Plug (2x 25 pins) to connect the inserted Ethernet communication interface module
2b Plug (3x 19 pins) to connect the inserted Ethernet communication interface module
3 With a screwdriver, inserted in this place, the terminal unit and the adjacent terminal unit can be shoved from each other
4 2 holes for wall mounting
5 2 RJ45 interfaces with indication LEDs for connection with the Ethernet network
6 30 terminals for signals and process supply voltages (UP and UP3)
7 DIN rail

The Ethernet communication interface modules plug into the Ethernet terminal unit. When properly seated, they are secured with two mechanical locks. All the connections are made through the Ethernet terminal unit, which allows removal and replacement of the Ethernet communication interface modules without disturbing the wiring at the Ethernet terminal unit.

The Ethernet terminal units TU507-ETH and TU508-ETH are specifically designed for use with AC500/S500 Ethernet communication interface modules (e.g. CI501-PNIO).
**Extreme conditions**

Terminal units for use in extreme ambient conditions have no sign for XC version.

The figure 4 in the Part no. 1SAP4... (label) identifies the XC version.

### Terminals

<table>
<thead>
<tr>
<th>Screw terminals</th>
<th>Spring terminals</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Conductor</strong></td>
<td><strong>Conductor</strong></td>
</tr>
<tr>
<td>1.5</td>
<td>1.5</td>
</tr>
<tr>
<td>1.6</td>
<td>1.6</td>
</tr>
<tr>
<td>1.7</td>
<td>1.7</td>
</tr>
<tr>
<td>1.8</td>
<td>1.8</td>
</tr>
<tr>
<td>1.9</td>
<td>1.9</td>
</tr>
<tr>
<td><strong>Screwdriver</strong></td>
<td><strong>Screwdriver</strong></td>
</tr>
<tr>
<td>(opens terminal)</td>
<td>(opens terminal)</td>
</tr>
</tbody>
</table>

The terminals 1.8 and 2.8 as well as 1.9, 2.9 and 3.9 are electrically interconnected within the terminal unit and have always the same assignment, independent of the inserted module:

- Terminals 1.8 and 2.8: Process supply voltage $UP = +24 \, V \, DC$
- Terminal 3.8: Process supply voltage $UP3 = +24 \, V \, DC$
- Terminals 1.9, 2.9 and 3.9: Process supply voltage $ZP = 0 \, V$

The assignment of the other terminals is dependent on the inserted communication interface module.

**NOTICE!**

Risk of corrosion!

Unused connectors and slots may corrode if XC devices are used in salt-mist environments.

Protect unused connectors and slots with TA535 protective caps for XC devices

*Chapter 5.2.8.3.6 “TA535 - Protective caps for XC devices” on page 1332.*

### 5.2.7.2 Technical data

The system data of AC500 and S500 are applicable to the standard version

*Chapter 5.1.2 “System data AC500” on page 166.*
The system data of AC500-XC are applicable to the XC version. Chapter 5.1.3 “System data AC500-XC” on page 169.

Only additional details are therefore documented below. The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of I/O channels per module</td>
<td>Max. 24 (depending on the inserted communication interface module)</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>3 groups of max. 8 channels each (1.0 ... 1.7, 2.0 ... 2.7, 3.0 ... 3.7), the allocation of the channels is given by the inserted Ethernet bus module</td>
</tr>
<tr>
<td>Network interface connector</td>
<td>2 RJ45, 8-pole</td>
</tr>
<tr>
<td>Rated voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Max. permitted total current</td>
<td>10 A via the supply terminals (UP, UP3 and ZP)</td>
</tr>
<tr>
<td>Ethernet</td>
<td>10/100 base-TX or 100 base-TX (depending on CI5xx module plugged in), 2 RJ45 socket</td>
</tr>
<tr>
<td>Grounding</td>
<td>Direct connection to the grounded DIN rail or via the screws with wall mounting</td>
</tr>
<tr>
<td>Screw terminals</td>
<td>Front terminal, conductor connection vertically with respect to the printed circuit board</td>
</tr>
<tr>
<td>Spring-type terminals</td>
<td>Front terminal, conductor connection vertically with respect to the printed circuit board</td>
</tr>
<tr>
<td>Weight</td>
<td>200 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical</td>
</tr>
</tbody>
</table>

### 5.2.7.2.3 Dimensions

![Dimensions Diagram](image)

1. Din rail 15 mm
2. Din rail 7.5 mm
5.2.7.4 Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 214 200 R0001</td>
<td>TU507-ETH, Ethernet terminal unit, 24 V DC, screw terminals</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 214 000 R0001</td>
<td>TU508-ETH, Ethernet terminal unit, 24 V DC, spring terminals</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 414 000 R0001</td>
<td>TU508-ETH-XC, Ethernet terminal unit, 24 V DC, spring terminals, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

5.2.7.3 TU509 and TU510 for communication interface modules

5.2.7.3.1 Features

- TU509, terminal unit, 24 V DC, screw terminals
- TU510, terminal unit, 24 V DC, spring terminals
- TU510-XC, terminal unit, 24 V DC, spring terminals, XC version
1 I/O bus (10 pins, female) to connect the first terminal unit
2a Plug (2 25 pins) to connect the inserted communication interface module
2b Plug (3 19 pins) to connect the inserted communication interface module
3 With a screwdriver, inserted in this place, the terminal unit and the adjacent terminal unit can be shoved from each other
4 2 holes for wall mounting
5 D-sub 9 (female) for connection with the PROFIBUS network
6 30 terminals for signals and process supply voltages (UP and UP3)
7 DIN rail

The communication interface modules plug into the terminal unit. When properly plugged-in, they are secured with two mechanical locks. All the connections are established via the terminal unit, which allows removal and replacement of the communication interface modules without disturbing the wiring at the terminal unit.

The terminal units TU509 and TU510 are specifically designed for use with AC500/S500 communication interface modules (e.g. CI451-DP).
**Terminals**

<table>
<thead>
<tr>
<th>Screw terminals</th>
<th>Spring terminals</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Conductor</strong></td>
<td><strong>Conductor</strong></td>
</tr>
<tr>
<td>1.5</td>
<td>1.5</td>
</tr>
<tr>
<td>1.6</td>
<td>1.6</td>
</tr>
<tr>
<td>1.7</td>
<td>1.7</td>
</tr>
<tr>
<td>1.8</td>
<td>1.8</td>
</tr>
<tr>
<td>1.9</td>
<td>1.9</td>
</tr>
<tr>
<td><strong>Screwdriver</strong></td>
<td><strong>Screwdriver (opens terminal)</strong></td>
</tr>
</tbody>
</table>

The terminals 2.8, 3.8, 2.9, 3.9 and 4.9 are electrically interconnected within the terminal unit and always have the same assignment, irrespective of the inserted module:

- Terminals 2.8 and 3.8: process supply voltage UP = +24 V DC
- Terminal 4.8: process supply voltage UP = +24 V DC
- Terminals 2.9, 3.9 and 4.9: process supply voltage ZP = 0 V

The assignment of the other terminals depends on the inserted communication interface module (see communication interface modules for CANopen and PROFIBUS).

**NOTICE!**

Risk of corrosion!

- Unused connectors and slots may corrode if XC devices are used in salt-mist environments.

Protect unused connectors and slots with TA535 protective caps for XC devices 

Chapter 5.2.8.3.6 “TA535 - Protective caps for XC devices” on page 1332.

### 5.2.7.3.2 Technical data

The system data of AC500 and S500 are applicable to the standard version Chapter 5.1.2 “System data AC500” on page 166.
The system data of AC500-XC are applicable to the XC version. Chapter 5.1.3 “System data AC500-XC” on page 169.

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of I/O channels per module</td>
<td>Max. 24 (depending on the inserted communication interface module)</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>3 groups of max. 8 channels each (2.0 ... 2.7, 3.0 ... 3.7, 4.0 ... 4.7), the allocation of the channels is given by the inserted communication interface module</td>
</tr>
<tr>
<td>Network interface connector</td>
<td>9-pin D-sub connector, female</td>
</tr>
<tr>
<td>Rated voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Max. permitted total current</td>
<td>10 A via the supply terminals (UP, UP3 and ZP)</td>
</tr>
<tr>
<td>Grounding</td>
<td>Direct connection to the grounded DIN rail or via the screws with wall mounting</td>
</tr>
<tr>
<td>Screw terminals</td>
<td>Front terminal, conductor connection vertically with respect to the printed circuit board</td>
</tr>
<tr>
<td>Spring terminals</td>
<td>Front terminal, conductor connection vertically with respect to the printed circuit board</td>
</tr>
<tr>
<td>Weight</td>
<td>200 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical</td>
</tr>
</tbody>
</table>

5.2.7.3.3 Dimensions

The dimensions are in mm and in brackets in inch.
5.2.7.3.4 Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 211 000 R0001</td>
<td>TU509, terminal unit, 24 V DC, screw terminals</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 210 800 R0001</td>
<td>TU510, terminal unit, 24 V DC, spring terminals</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 410 800 R0001</td>
<td>TU510-XC, terminal unit, 24 V DC, spring terminals, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

5.2.7.4 TU517 and TU518 for communication interface modules

5.2.7.4.1 Features

- TU517, terminal unit, 24 V DC, screw terminals
- TU518, terminal unit, 24 V DC, spring terminals
- TU518-XC, terminal unit, 24 V DC, spring terminals, XC version
1  I/O bus (10 pins, female) to connect the first terminal unit
2a Plug (2 25 pins) to connect the inserted communication interface module
2b Plug (2 19 pins) to connect the inserted communication interface module
3  With a screwdriver, inserted in this place, the terminal unit and the adjacent I/O terminal unit can be shoved from each other
4  2 holes for wall mounting
5  10 terminals for connection with the bus system
6  30 terminals for signals and process supply voltages (UP and UP3)
7  DIN rail

The communication interface modules plug into the terminal unit. When properly plugged-in, they are secured with two mechanical locks. All the connections are established via the terminal unit, which allows removal and replacement of the communication interface modules without disturbing the wiring at the terminal unit.

The terminal units TU517 and TU518 are specifically designed for use with AC500/SS500 communication interface modules (e.g. CI581-CN, CI541-DP):

- CANopen communication interface modules
- DeviceNet modules
- PROFIBUS DP communication interface modules
**Extreme conditions**

Terminal units for use in extreme ambient conditions have no sign for XC version. The figure 4 in the Part no. 1SAP4... (label) identifies the XC version.

---

### Terminals

<table>
<thead>
<tr>
<th>Screw terminals</th>
<th>Spring terminals</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conductor</td>
<td>Screwdriver</td>
</tr>
<tr>
<td>1.5</td>
<td>1.5</td>
</tr>
<tr>
<td>1.6</td>
<td>1.6</td>
</tr>
<tr>
<td>1.7</td>
<td>1.7</td>
</tr>
<tr>
<td>1.8</td>
<td>1.8</td>
</tr>
<tr>
<td>1.9</td>
<td>1.9</td>
</tr>
<tr>
<td>Conductor</td>
<td>Screwdriver</td>
</tr>
<tr>
<td>1.5</td>
<td>1.5</td>
</tr>
<tr>
<td>1.6</td>
<td>1.6</td>
</tr>
<tr>
<td>1.7</td>
<td>1.7</td>
</tr>
<tr>
<td>1.8</td>
<td>1.8</td>
</tr>
<tr>
<td>1.9</td>
<td>1.9</td>
</tr>
</tbody>
</table>

The terminals 2.8, 3.8, 2.9, 3.9 and 4.9 are electrically interconnected within the terminal unit and always have the same assignment, irrespective of the inserted communication interface module:

- Terminals 2.8 and 3.8: process supply voltage UP = +24 V DC
- Terminal 4.8: process supply voltage UP3 = +24 V DC
- Terminals 2.9, 3.9 and 4.9: process supply voltage ZP = 0 V

The assignment of the other terminals depends on the inserted communication interface module (see communication interface modules for CANopen and PROFIBUS).

---

### 5.2.7.4.2 Technical data

The system data of AC500 and S500 are applicable to the standard version "Chapter 5.1.2 "System data AC500" on page 166.

The system data of AC500-XC are applicable to the XC version "Chapter 5.1.3 "System data AC500-XC" on page 169.

Only additional details are therefore documented below.

The technical data are also applicable to the XC version.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of I/O channels per module</td>
<td>Max. 24 (depending on the inserted communication interface module)</td>
</tr>
<tr>
<td>Distribution of the channels into groups</td>
<td>3 groups of max. 8 channels each (2.0 ... 2.7, 3.0 ... 3.7, 4.0 ... 4.7), the allocation of the channels is given by the inserted communication interface module</td>
</tr>
<tr>
<td>Network interface connector</td>
<td>10 screw or spring terminals (1.0 ... 1.9)</td>
</tr>
<tr>
<td>Rated voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Max. permitted total current</td>
<td>10 A via the supply terminals (UP, UP3 and ZP)</td>
</tr>
<tr>
<td>Grounding</td>
<td>Direct connection to the grounded DIN rail or via the screws with wall mounting</td>
</tr>
<tr>
<td>Screw terminals</td>
<td>Front terminal, conductor connection vertically with respect to the printed circuit board</td>
</tr>
<tr>
<td>Spring terminals</td>
<td>Front terminal, conductor connection vertically with respect to the printed circuit board</td>
</tr>
<tr>
<td>Weight</td>
<td>200 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical</td>
</tr>
</tbody>
</table>

### 5.2.7.4.3 Dimensions

The dimensions are in mm and in brackets in inch.

1. Din rail 15 mm
2. Din rail 7.5 mm
5.2.7.4 Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 211 400 R0001</td>
<td>TU517, terminal unit, 24 V DC, screw terminals</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 211 200 R0001</td>
<td>TU518, terminal unit, 24 V DC, spring terminals</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 411 200 R0001</td>
<td>TU518-XC, terminal unit, 24 V DC, spring terminals, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

5.2.7.5 TU520-ETH for PROFINET communication interface modules

5.2.7.5.1 Features

- TU520-ETH, 2 RJ45 interfaces for connection to PROFIBUS network, 3 removable connectors for bus systems
- TU520-ETH-XC, 2 RJ45 interfaces for connection to PROFIBUS network, 3 removable connectors for bus systems, XC version
The PROFINET communication interface modules plug into the PROFINET IO terminal unit. When properly plugged-in, they are secured with two mechanical locks. All the connections are established via the PROFINET IO terminal unit, which allows removal and replacement of the communication interface modules without disturbing the wiring at the PROFINET IO terminal unit.

The PROFINET IO terminal unit TU520-ETH are specifically designed for use with AC500/S500 PROFINET communication interface modules (e. g. CI504-PNIO, CI506-PNIO).
**Extreme conditions**

Terminal units for use in extreme ambient conditions have no sign for XC version.

*The figure 4 in the Part no. 1SAP4... (label) identifies the XC version.*

---

**NOTICE!**

Risk of corrosion!

- Unused connectors and slots may corrode if XC devices are used in salt-mist environments.

Protect unused connectors and slots with TA535 protective caps for XC devices

☞ Chapter 5.2.8.3.6 “TA535 - Protective caps for XC devices” on page 1332.

---

### Spring terminals

<table>
<thead>
<tr>
<th>Conductor</th>
<th>Screwdriver (opens terminal)</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Spring terminals diagram" /></td>
<td></td>
</tr>
</tbody>
</table>

The terminals 1.0, 2.0, 3.0, 1.1, 2.1 and 3.1 are electrically interconnected within the PROFINET IO terminal unit and always have the same assignment, irrespective of the inserted PROFINET communication interface module:

- Terminals 1.0, 2.0 and 3.0: process supply voltage $UP = +24 \text{ V DC}$
- Terminals 1.1, 2.1 and 3.1: process supply voltage $ZP = 0 \text{ V}$

The assignment of the bus system terminals depends on the inserted PROFINET communication interface module (see Ethernet communication interface modules overview).

---

### 5.2.7.5.2 Technical data

The system data of AC500 and S500 are applicable to the standard version

☞ Chapter 5.1.2 “System data AC500” on page 166.

The system data of AC500-XC are applicable to the XC version

☞ Chapter 5.1.3 “System data AC500-XC” on page 169.
Only additional details are therefore documented below.
The technical data are also applicable to the XC version.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet</td>
<td>10/100 base-TX or 100 base-TX (depending on the plugged CI5xx module), 2 RJ45 socket</td>
</tr>
<tr>
<td>Number of bus system connectors</td>
<td>3 (the type of bus system depends on the PROFINET IO communication interface module)</td>
</tr>
<tr>
<td>Rated voltage</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Max. permitted total current</td>
<td>10 A via the supply terminals (UP and ZP)</td>
</tr>
<tr>
<td>Grounding</td>
<td>Direct connection to the grounded DIN rail or via the screws with wall mounting</td>
</tr>
<tr>
<td>Spring terminals</td>
<td>Front terminal, conductor connection vertically with respect to the printed circuit board</td>
</tr>
<tr>
<td>Weight</td>
<td>200 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical</td>
</tr>
</tbody>
</table>

5.2.7.5.3 Dimensions

The dimensions are in mm and in brackets in inch.
5.2.7.4 Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 214 400 R0001</td>
<td>TU520-ETH, PROFINET I/O terminal unit, 24 V DC, spring terminals</td>
<td>Active</td>
</tr>
<tr>
<td>1SAP 414 400 R0001</td>
<td>TU520-ETH-XC, PROFINET I/O terminal unit, 24 V DC, spring terminals, XC version</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

5.2.8 Accessories

5.2.8.1 AC500-eCo

5.2.8.1.1 MC5102 - Micro memory card with adapter
- Solid state flash memory storage

Memory card type | AC500 V2 | AC500-XC V2 | AC500 V3 | AC500-XC V3 | AC500-eCo V3 |
---|---|---|---|---|---|
MC5141 | x | x | x | x | - |
MC5102 with TA5350-AD micro memory card adapter | x 1) | x 1) 2) | x | x 2) | - |
MC5102 without TA5350-AD micro memory card adapter | - | - | - | - | x |

1) As of firmware 2.5.x
2) Temporary use of MC5102 is possible under normal environmental conditions, but MC5141 should be preferred.

The use of other micro memory cards is prohibited. ABB is not responsible nor liable for consequences resulting from use of unapproved memory cards.

**Purpose**

Processor modules can be operated with and without (micro) memory card. Processor modules are supplied without (micro) memory card. It must be ordered separately.

The micro memory card is used to store or backup application data and/or application programs or project source codes as well as to update the internal CPU firmware.

The micro memory card can only be used temporarily in standard and XC applications.

The memory card can be read/written on a PC with a SDHC compatible memory card reader when using TA5350-AD micro memory card adapter.

*Further information on using the micro memory card in AC500 PLCs*

**Dimensions**

**Micro memory card**

The dimensions are in mm and in brackets in inch.
Insert the micro memory card

AC500 V3

Fig. 259: Insert micro memory card into PM56xx

1. Unpack the micro memory card and insert it into the supplied micro memory card adapter.
2. Insert the micro memory card adapter with integrated micro memory card into the memory card slot of the processor module until locked.
AC500-eCo V3

1. Open the micro memory card slot cover by turning it upwards.
2. Carefully insert the micro memory card into the micro memory card slot as far as it will go. Observe orientation of card.
3. Close the micro memory card slot cover by turning it downwards.

NOTICE!

Disturbed PLC operation

Do not remove the micro memory card when it is working!
Otherwise the micro memory card and/or files on it might get corrupted and/or normal PLC operation might be disturbed.

- AC500 V3: Remove the micro memory card only when no black square (■) is shown next to MC in the display.
- AC500-eCo V3: Remove the micro memory card only when the MC LED is not blinking.
Fig. 260: Remove micro memory card from PM56xx

1. To remove the micro memory card adapter with the integrated micro memory card, push on the micro memory card adapter until it moves forward.
2. By this, the micro memory card adapter is unlocked and can be removed.
NOTICE!
Disturbed PLC operation
Do not remove the memory card when it is working!
Otherwise the memory card and/or files on it might get corrupted and/or normal PLC operation might be disturbed.

- Remove the memory card only when no black square ( ) is shown next to MC in the display.

1. Open the micro memory card slot cover by turning it upwards.
2. Micro memory card can be removed from the micro memory card slot by gripping and pulling with two fingers.
3. Close the micro memory card slot cover by turning it downwards.

Technical data

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory capacity</td>
<td>8 GB</td>
</tr>
<tr>
<td>Total bytes written (TBW)</td>
<td>On request</td>
</tr>
<tr>
<td>Data retention</td>
<td></td>
</tr>
<tr>
<td>at beginning</td>
<td>10 years at +40 °C</td>
</tr>
<tr>
<td>when number of write processes has been 90 % of lifetime of each cell</td>
<td>1 year at +40 °C</td>
</tr>
<tr>
<td>Write protect switch</td>
<td></td>
</tr>
<tr>
<td>Micro memory card</td>
<td>No</td>
</tr>
<tr>
<td>Micro memory card adapter</td>
<td>Yes</td>
</tr>
<tr>
<td>Weight</td>
<td>0.25 g</td>
</tr>
<tr>
<td>Dimensions</td>
<td>15 mm x 11 mm x 0.7 mm</td>
</tr>
</tbody>
</table>

It is not possible to use 100 % of a device's memory space. About 10 % of the total available space must remain unused at any time to maintain normal device operation.
<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 180 100 R0002</td>
<td>MC5102, micro memory card with TA5350-AD micro memory card adapter</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

5.2.8.1.2 TA52xx(-x) - Terminal block sets

**Intended purpose**

Removable terminal blocks are used for power supply and for I/O connectors on AC500-eCo V3 processor modules PM50x2.

For option boards there are different removable terminal blocks in spring version.

For the AC500-eCo V3 Basic CPUs a 3-pin terminal block for power supply and a 13-pin terminal block for I/O connectors are used.

For the AC500-eCo V3 Standard CPUs and Pro CPUs a 3-pin terminal block for power supply, a 13-pin terminal block and a 12-pin terminal block for I/O connectors are used.

For all CPUs there is a screw and a spring variant available.

<table>
<thead>
<tr>
<th>Basic CPU</th>
<th>Standard and Pro CPUs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spring terminal TA5211-TSPF-B</td>
<td>Screw terminal TA5211-TSCL-B</td>
</tr>
<tr>
<td>Spring terminal TA5212-TSPF</td>
<td>Screw terminal TA5212-TSCL</td>
</tr>
</tbody>
</table>
Various removable spring terminal blocks are available for option boards. The following spare parts are available (depending on the number of pins).

<table>
<thead>
<tr>
<th>Spring terminals</th>
</tr>
</thead>
<tbody>
<tr>
<td>TA5220-SPF5</td>
</tr>
</tbody>
</table>

**CAUTION!**
Risk of injury and damaging the product!
Improper installation and maintenance may result in injury and can damage the product!
- Installation and maintenance have to be performed according to the technical rules, codes and relevant standards, e.g. EN 60204-1.
- Read product documentation carefully before wiring. Improper wiring or wrong terminal block from other devices can damage the product!
- Only by qualified personnel.

**CAUTION!**
Risk of injury and damaging the module when using unapproved terminal blocks!
Only use terminal blocks approved by ABB to avoid injury and damage to the module.

**Terminal block set for PM50x2**
Processor modules PM50x2 CPU are not delivered with terminal blocks.
Screw terminal block set:
- TA5211-TSCL-B (1SAP187400R0001) for PM5012-x-ETH
- TA5212-TSCL (1SAP187400R0004) for PM5032-x-ETH, PM5052-x-ETH, PM5072-T-2ETH(W), PM5082-T-2ETH

Spring terminal block set:
- TA5211-TSPF-B (1SAP187400R0002) for PM5012-x-ETH
- TA5212-TSPF (1SAP187400R0005) for PM5032-x-ETH, PM5052-x-ETH, PM5072-T-2ETH(W), PM5082-T-2ETH
Dimensions

3-pin terminal block for power supply
Screw terminal

Spring terminal
13-pin terminal block for I/O connectors

Screw terminal

Spring terminal
12-pin terminal block for I/O connectors

Screw terminal

Spring terminal
x-PIN terminal blocks for option boards

Only these x-pin terminal blocks are available for the option boards. TA5220-SPFx, with $x = 5 \ldots 8$

This results in these dimensions for the available spring terminal blocks.

<table>
<thead>
<tr>
<th>Description</th>
<th>Pin</th>
<th>Length [mm]</th>
<th>Wide [mm]</th>
<th>Height [mm]</th>
</tr>
</thead>
<tbody>
<tr>
<td>TA5220-SPF5</td>
<td>5</td>
<td>18.2</td>
<td>7.7</td>
<td>22.9</td>
</tr>
<tr>
<td>TA5220-SPF6</td>
<td>6</td>
<td>21.7</td>
<td>7.7</td>
<td>22.9</td>
</tr>
<tr>
<td>TA5220-SPF7</td>
<td>7</td>
<td>25.2</td>
<td>7.7</td>
<td>22.9</td>
</tr>
<tr>
<td>TA5220-SPF8</td>
<td>8</td>
<td>28.7</td>
<td>7.7</td>
<td>22.9</td>
</tr>
</tbody>
</table>
Table 288: Screw terminal block for power supply

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>TA5211-TSCL-B TA5212-TSCL</td>
</tr>
<tr>
<td></td>
<td>Removable 3-pin terminal block:</td>
</tr>
<tr>
<td></td>
<td>screw front/cable side 5.00 mm pitch</td>
</tr>
<tr>
<td>Usage</td>
<td>Power supply for AC500-eCo V3 processor modules</td>
</tr>
<tr>
<td>Conductor cross section</td>
<td>Solid (copper) 0.5 mm² ... 2.5 mm²</td>
</tr>
<tr>
<td></td>
<td>Flexible (copper) 0.5 mm² ... 2.5 mm²</td>
</tr>
<tr>
<td></td>
<td>Stripped conductor end 7 mm</td>
</tr>
</tbody>
</table>
### Table 289: Spring terminal block for power supply

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fastening torque</td>
<td>0.5 Nm</td>
</tr>
<tr>
<td>Dimensions</td>
<td></td>
</tr>
<tr>
<td>3-pin terminal block</td>
<td>15 mm x 12.4 mm x 26.05 mm</td>
</tr>
<tr>
<td>Weight</td>
<td></td>
</tr>
<tr>
<td>TA5211-TSCL-B</td>
<td>150 g (2 terminal blocks)</td>
</tr>
<tr>
<td>TA5212-TSCL</td>
<td>200 g (3 terminal blocks)</td>
</tr>
</tbody>
</table>

### Table 290: Screw terminal block for onboard I/Os

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fastening torque</td>
<td>0.5 Nm</td>
</tr>
<tr>
<td>Dimensions</td>
<td></td>
</tr>
<tr>
<td>13-pin terminal block</td>
<td>65 mm x 12.4 mm x 26.05 mm</td>
</tr>
<tr>
<td>12-pin terminal block</td>
<td>60 mm x 12.4 mm x 26.05 mm</td>
</tr>
</tbody>
</table>

---

**Device specifications > Accessories**

---

2024/01/05 3ADR010583, 1, en_US 1299
### Table 291: Spring terminal block for onboard I/Os

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td></td>
</tr>
<tr>
<td>TA5211-TSCL-B</td>
<td>Removable 13-pin terminal block: spring front/cable front 5.00 mm pitch</td>
</tr>
<tr>
<td>TA5212-TSCL</td>
<td>Removable 13-pin and 12-pin terminal block: spring front/cable front 5.00 mm pitch</td>
</tr>
<tr>
<td><strong>Usage</strong></td>
<td>Onboard I/Os for AC500-eCo V3 processor modules</td>
</tr>
<tr>
<td><strong>Conductor cross section</strong></td>
<td></td>
</tr>
<tr>
<td>Solid (copper)</td>
<td>0.5 mm² ... 2.5 mm²</td>
</tr>
<tr>
<td>Flexible (copper)</td>
<td>0.5 mm² ... 2.5 mm²</td>
</tr>
<tr>
<td>Stripped conductor end</td>
<td>11 mm</td>
</tr>
<tr>
<td><strong>Dimensions</strong></td>
<td></td>
</tr>
<tr>
<td>13-pin terminal block</td>
<td>65 mm x 15 mm x 25.95 mm</td>
</tr>
<tr>
<td>12-pin terminal block</td>
<td>60 mm x 15 mm x 25.95 mm</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td></td>
</tr>
<tr>
<td>TA5211-TSPF-B</td>
<td>150 g (2 terminal blocks)</td>
</tr>
<tr>
<td>TA5212-TSPF</td>
<td>200 g (3 terminal blocks)</td>
</tr>
</tbody>
</table>

### Table 292: Spring terminal block for option boards

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td></td>
</tr>
<tr>
<td>TA5220-SPF5</td>
<td>Removable 5-pin terminal block: spring front, cable front 3.50 mm pitch</td>
</tr>
<tr>
<td>TA5220-SPF6</td>
<td>Removable 6-pin terminal block: spring front, cable front 3.50 mm pitch</td>
</tr>
<tr>
<td>TA5220-SPF7</td>
<td>Removable 7-pin terminal block: spring front, cable front 3.50 mm pitch</td>
</tr>
<tr>
<td>TA5220-SPF8</td>
<td>Removable 8-pin terminal block: spring front, cable front 3.50 mm pitch</td>
</tr>
<tr>
<td><strong>Usage</strong></td>
<td>Connectors for AC500-eCo V3 option boards</td>
</tr>
<tr>
<td><strong>Conductor cross section</strong></td>
<td></td>
</tr>
<tr>
<td>Solid (copper)</td>
<td>0.2 mm² ... 1.5 mm²</td>
</tr>
<tr>
<td>Flexible (copper)</td>
<td>0.2 mm² ... 1.5 mm²</td>
</tr>
<tr>
<td>Stripped conductor end</td>
<td>8 mm ... 10 mm</td>
</tr>
<tr>
<td><strong>Dimensions</strong></td>
<td></td>
</tr>
<tr>
<td>TA5220-SPF5</td>
<td>18.2 mm x 7.7 mm x 22.9 mm</td>
</tr>
<tr>
<td>TA5220-SPF6</td>
<td>21.7 mm x 7.7 mm x 22.9 mm</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>TA5220-SPF7</td>
<td>25.2 mm x 7.7 mm x 22.9 mm</td>
</tr>
<tr>
<td>TA5220-SPF8</td>
<td>28.7 mm x 7.7 mm x 22.9 mm</td>
</tr>
</tbody>
</table>

**Weight**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>TA5220-SPF5</td>
<td>150 g</td>
</tr>
<tr>
<td>TA5220-SPF6</td>
<td>170 g</td>
</tr>
<tr>
<td>TA5220-SPF7</td>
<td>180 g</td>
</tr>
<tr>
<td>TA5220-SPF8</td>
<td>200 g</td>
</tr>
</tbody>
</table>

---

### Ordering data

**Table 293: Terminal block sets for AC500-eCo V3 Basic**

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 187 400 R0001</td>
<td>TA5211-TSCL-B: screw terminal block set for AC500-eCo V3 CPU Basic</td>
</tr>
<tr>
<td></td>
<td>screw front, cable side 5.00 mm pitch</td>
</tr>
<tr>
<td></td>
<td>● 1 removable 3-pin terminal block for power supply</td>
</tr>
<tr>
<td></td>
<td>● 1 removable 13-pin terminal block for I/O connectors</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 187 400 R0002</td>
<td>TA5211-TSPF-B: spring terminal block set for AC500-eCo V3 CPU Basic</td>
</tr>
<tr>
<td></td>
<td>spring front, cable front 5.00 mm pitch</td>
</tr>
<tr>
<td></td>
<td>● 1 removable 3-pin terminal block for power supply</td>
</tr>
<tr>
<td></td>
<td>● 1 removable 13-pin terminal block for I/O connectors</td>
</tr>
</tbody>
</table>

**Table 294: Terminal block sets for AC500-eCo V3 Standard and Pro**

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 187 400 R0004</td>
<td>TA5212-TSCL: screw terminal block set for AC500-eCo V3 Standard and Pro CPU</td>
</tr>
<tr>
<td></td>
<td>screw front, cable side 5.00 mm pitch</td>
</tr>
<tr>
<td></td>
<td>● 1 removable 3-pin terminal block for power supply</td>
</tr>
<tr>
<td></td>
<td>● 1 removable 13-pin terminal block for I/O connectors</td>
</tr>
<tr>
<td></td>
<td>● 1 removable 12-pin terminal block for I/O connectors</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 187 400 R0005</td>
<td>TA5212-TSPF: spring terminal block set for AC500-eCo V3 Standard and Pro CPU</td>
</tr>
<tr>
<td></td>
<td>spring front, cable front 5.00 mm pitch</td>
</tr>
<tr>
<td></td>
<td>● 1 removable 3-pin terminal block for power supply</td>
</tr>
<tr>
<td></td>
<td>● 1 removable 13-pin terminal block for I/O connectors</td>
</tr>
<tr>
<td></td>
<td>● 1 removable 12-pin terminal block for I/O connectors</td>
</tr>
</tbody>
</table>

**Table 295: Spare parts**

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 187 400 R0012</td>
<td>TA5220-SPF5: spring terminal block, removable, 5-pin, spring front, cable front, 6 pieces per packing unit</td>
</tr>
<tr>
<td>1SAP 187 400 R0013</td>
<td>TA5220-SPF6: spring terminal block, removable, 6-pin, spring front, cable front, 6 pieces per packing unit</td>
</tr>
<tr>
<td>1SAP 187 400 R0014</td>
<td>TA5220-SPF7: spring terminal block, removable, 7-pin, spring front, cable front, 6 pieces per packing unit</td>
</tr>
<tr>
<td>1SAP 187 400 R0015</td>
<td>TA5220-SPF8: spring terminal block, removable, 8-pin, spring front, cable front, 6 pieces per packing unit</td>
</tr>
</tbody>
</table>
5.2.8.1.3 TA5300-CVR - Option board slot cover

**Intended purpose**
TA5300-CVR option board slot covers for PM50xx processor modules are necessary to protect not used option board slots.

---

**CAUTION!**
Risk of injury and damaging the product!
Always plug in the option board slot cover when the option board is not inserted.
If the option board slot cover is lost, please order the replacement TA5300-CVR (1SAP187500R0001).
Never power up the CPU with uncovered option board slot, otherwise it may cause serious injury and/or damage the product.

---

*The AC500-eCo V3 processor modules are delivered with option board slot cover(s).*

*The option board slot cover has to be removed before inserting an option board.*

*The TA5300-CVR option board slot covers are available as spare parts.*

---

**Dimensions**

*The dimensions are in mm and in brackets in inch.*
1. Press on the option board slot cover to insert it in the not used option board slot of the processor module PM50xx.

2. The option board slot cover must click into the not used option board slot.

1. Press the side of the inserted option board slot cover.

2. At the same time, pull the option board slot cover out of the option board slot of the processor module PM50xx.

The system data of AC500-eCo V3 apply to Chapter 5.1.1 “System data AC500-eCo” on page 159

Only additional details are therefore documented below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>47 g</td>
</tr>
<tr>
<td>Dimensions</td>
<td>42.1 mm x 30.8 mm x 23.55</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 187 500 R0001</td>
<td>TA5300-CVR: option board slot cover, removable plastic part, 6 pieces per packing unit</td>
<td>Active</td>
</tr>
</tbody>
</table>
*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
5.2.8.1.4 TA5400-SIM - Input simulator

- TA5400-SIM input simulator for 6 digital inputs 24 V DC
- For usage with AC500-eCo V3 processor modules

1. Contacts for connecting the input simulator to the terminal block for I/O connectors
2. 6 switches for the digital inputs DI0 ... DI5 (0 means opened switch, 1 means closed switch)
3. Screw terminal block for power supply
4. Screw terminal block(s) for I/O connectors

**Intended purpose**

**TA5400-SIM**

The TA5400-SIM input simulator is only intended for testing and training purposes for AC500-eCo V3 processor modules PM50x2.

Continuous operation in a productive system is not permitted.

The TA5400-SIM input simulator may only be used with screw-type terminal blocks.

The TA5400-SIM input simulator must not be used with spring-type terminal blocks.
**Environmental conditions for testing and training purposes**

In order not to impair the functionality of the product, avoid any kind of disturbing environmental influences:

- mechanical disturbances
- climatic influences

Make sure that the parameters are within the normal range:

- temperature
- air pressure
- humidity
- altitude

The TA5400-SIM input simulator can simulate 6 digital 24 V DC input signals to the digital inputs I0 ... I5 of onboard I/Os.

With the TA5400-SIM input simulator, the digital 24 V DC inputs I0 ... I5 can be turned OFF and ON separately:

- If the lever of the switch is on the right side (1), the input is ON.
- If the lever of the switch is on the left side (0), the input is OFF.

**Dimensions**

The dimensions are in mm and in brackets in inch.

**Electrical diagram**

The diagram below shows the connection of the TA5400-SIM input simulator.
NOTICE!
Risk of damage to the TA5400-SIM input simulator!
- Do not remove the terminal block while the TA5400-SIM input simulator is connected.
- Do not apply mechanical forces to the input simulator when it is connected to the terminal block.
- In both cases the input simulator could be damaged.

Assembly

Insertion of the input simulator
1. Make sure that the power supply of the processor module is turned off.

CAUTION!
Risk of damaging the PLC modules!
The PLC modules can be damaged by overvoltages and short circuits.
- Make sure, that all voltage sources (supply and process voltage) are switched off before you start working on the system.
- Never connect voltages > 24 V DC to the terminal block of the TA5400-SIM input simulator.

CAUTION!
Risk of damaging the input simulator and/or PLC modules!
The TA5400-SIM input simulator may only be used with AC500-eCo V3 processor modules PM50x2.
- Never use the input simulator with other devices.
- The input simulator may only be used with screw-type terminal blocks.
- The input simulator is only intended for testing and training purposes.
- Never use it within productive systems.
2. Make sure that all clamps of the onboard I/Os are totally open.
3. Insert the TA5400-SIM input simulator into the screw terminal block as shown in the figure.

4. Tighten all screws of the onboard I/O clamps.
5. Make sure all switches are in OFF state (0).
6. Connect 24 V DC to the power supply of the TA5400-SIM (L+ and M). Tighten the screws.
7. Connect the processor module power supply wires (24 V DC) “Pin assignment” on page 184.

Disassembly

Removal of the input simulator
1. Make sure that the power supply of the processor module is turned off.

   CAUTION!
   Risk of damaging the PLC modules!
   The PLC modules can be damaged by overvoltages and short circuits.
   Make sure that all voltage sources (supply and process voltage) are switched off before you start working on the system.

2. Disconnect the TA5400-SIM power supply wires (24 V DC) with a flat-blade screwdriver from the terminal block for power supply (L+ and M).
3. Loosen all screws of the onboard I/Os.
4. Remove the input simulator by pulling it to the left side.

Technical data
The system data of AC500-eCo V3 apply "Chapter 5.1.1 “System data AC500-eCo” on page 159

Only additional details are therefore documented below.
Table 296: Technical data of the module

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process supply voltage</td>
<td>Terminal (L+) for +24 V DC and terminal (M) for 0 V DC</td>
</tr>
<tr>
<td>Connections</td>
<td>Terminal (L+) for +24 V DC and terminal (M) for 0 V DC</td>
</tr>
<tr>
<td>Rated value</td>
<td>24 V DC</td>
</tr>
<tr>
<td>Max. ripple</td>
<td>5 %</td>
</tr>
<tr>
<td>Weight</td>
<td>18 g</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Horizontal or vertical</td>
</tr>
</tbody>
</table>

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 187 600 R0001</td>
<td>TA5400-SIM, input simulator for PM50x2</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

5.2.8.2 AC500 and AC500-XC

5.2.8.2.1 MC5102 - Micro memory card with adapter

- Solid state flash memory storage

1 Micro memory card
2 TA5350-AD micro memory card adapter, necessary for use in AC500 processor modules

The MC5102 micro memory card has no write protect switch.
The TA5350-AD micro memory card adapter has a write protect switch.
In the position "LOCK", the inserted micro memory card can only be read.
Memory card type | AC500 V2 | AC500-XC V2 | AC500 V3 | AC500-XC V3 | AC500-eCo V3
---|---|---|---|---|---
MC5141 | x | x | x | x | -
MC5102 with TA5350-AD micro memory card adapter | x 1) | x 1) 2) | x | x 2) | -
MC5102 without TA5350-AD micro memory card adapter | - | - | - | - | x

1) As of firmware 2.5.x
2) Temporary use of MC5102 is possible under normal environmental conditions, but MC5141 should be preferred.

**Purpose**

Processor modules can be operated with and without (micro) memory card. Processor modules are supplied without (micro) memory card. It must be ordered separately.

The micro memory card is used to store or backup application data and/or application programs or project source codes as well as to update the internal CPU firmware.

The micro memory card can only be used temporarily in standard and XC applications.

The memory card can be read/written on a PC with a SDHC compatible memory card reader when using TA5350-AD micro memory card adapter.

Further information on using the micro memory card in AC500 PLCs

**Dimensions**

**Micro memory card**

The dimensions are in mm and in brackets in inch.
1. Unpack the micro memory card and insert it into the supplied micro memory card adapter.
2. Insert the micro memory card adapter with integrated micro memory card into the memory card slot of the processor module until locked.

Fig. 261: Insert micro memory card into PM56xx

1. Micro memory card
2. TA5350-AD micro memory card adapter
3. Memory card slot

The dimensions are in mm and in brackets in inch.
1. Open the micro memory card slot cover by turning it upwards.
2. Carefully insert the micro memory card into the micro memory card slot as far as it will go. Observe orientation of card.
3. Close the micro memory card slot cover by turning it downwards.

**NOTICE!**

**Disturbed PLC operation**

Do not remove the micro memory card when it is working!

Otherwise the micro memory card and/or files on it might get corrupted and/or normal PLC operation might be disturbed.

- AC500 V3: Remove the micro memory card only when no black square (□) is shown next to MC in the display.
- AC500-eCo V3: Remove the micro memory card only when the MC LED is not blinking.
Fig. 262: Remove micro memory card from PM56xx

1. To remove the micro memory card adapter with the integrated micro memory card, push on the micro memory card adapter until it moves forward.

2. By this, the micro memory card adapter is unlocked and can be removed.
AC500-eCo V3

NOTICE!

Disturbed PLC operation
Do not remove the memory card when it is working!
Otherwise the memory card and/or files on it might get corrupted and/or normal PLC operation might be disturbed.
- Remove the memory card only when no black square (■) is shown next to MC in the display.

1 Micro memory card slot cover
2 Micro memory card
3 Micro memory card slot

1. Open the micro memory card slot cover by turning it upwards.
2. Micro memory card can be removed from the micro memory card slot by gripping and pulling with two fingers.
3. Close the micro memory card slot cover by turning it downwards.

Technical data

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory capacity</td>
<td>8 GB</td>
</tr>
<tr>
<td>Total bytes written (TBW)</td>
<td>On request</td>
</tr>
<tr>
<td>Data retention</td>
<td></td>
</tr>
<tr>
<td>at beginning</td>
<td>10 years at +40 °C</td>
</tr>
<tr>
<td>when number of write processes has been 90 % of lifetime of each cell</td>
<td>1 year at +40 °C</td>
</tr>
<tr>
<td>Write protect switch</td>
<td></td>
</tr>
<tr>
<td>Micro memory card</td>
<td>No</td>
</tr>
<tr>
<td>Micro memory card adapter</td>
<td>Yes</td>
</tr>
<tr>
<td>Weight</td>
<td>0.25 g</td>
</tr>
<tr>
<td>Dimensions</td>
<td>15 mm x 11 mm x 0.7 mm</td>
</tr>
</tbody>
</table>

It is not possible to use 100 % of a device’s memory space. About 10 % of the total available space must remain unused at any time to maintain normal device operation.
Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 180 100 R0002</td>
<td>MC5102, micro memory card with TA5350-AD micro memory card adapter</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

5.2.8.2.2 MC5141 - Memory card

- Solid state flash memory storage

The memory card has a write protect switch.

In the position "LOCK", the memory card can only be read.

<table>
<thead>
<tr>
<th>Memory card type</th>
<th>AC500 V2</th>
<th>AC500-XC V2</th>
<th>AC500 V3</th>
<th>AC500-XC V3</th>
<th>AC500-eCo V3</th>
</tr>
</thead>
<tbody>
<tr>
<td>MC5141</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MC5102 with TA5350-AD micro memory card adapter</td>
<td>x ¹)</td>
<td>x ¹) ²)</td>
<td>x</td>
<td>x ²)</td>
<td>-</td>
</tr>
<tr>
<td>MC5102 without TA5350-AD micro memory card adapter</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>x</td>
</tr>
</tbody>
</table>

¹) As of firmware 2.5.x

²) Temporary use of MC5102 is possible under normal environmental conditions, but MC5141 should be preferred.
The use of other memory cards is prohibited. ABB is not responsible nor liable for consequences resulting from use of unapproved memory cards.

**Purpose**

Processor modules can be operated with and without (micro) memory card. Processor modules are supplied without (micro) memory card. It must be ordered separately.

The memory card is used to store or backup application data and/or application programs or project source codes as well as to update the internal CPU firmware.

The memory card is intended for long-term use in standard and XC application.

The memory card can be read/written on a PC with a SDHC compatible memory card reader. See Further information on using the memory card in AC500 PLC.

**Dimensions**

The dimensions are in mm and in brackets in inch.

**Insert the memory card**

AC500 V3

1. Unpack the memory card.
2. Insert the memory card into the memory card slot of the processor module until locked.
**Fig. 263: Insert memory card into PM56xx**

1. Memory card
2. Memory card slot

---

**Remove the memory card**

**AC500 V3**

**NOTICE!**

**Disturbed PLC operation**

- Do not remove the memory card when it is working!

  Otherwise the memory card and/or files on it might get corrupted and/or normal PLC operation might be disturbed.

  - Remove the memory card only when no black square (■) is shown next to MC in the display.

1. To remove the memory card, push on the memory card until it moves forward.
2. By this, the memory card is unlocked and can be removed.
**Technical data**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory capacity</td>
<td>2 GB</td>
</tr>
<tr>
<td>Total bytes written (TBW)</td>
<td>On request</td>
</tr>
<tr>
<td>Data retention</td>
<td></td>
</tr>
<tr>
<td>at beginning</td>
<td>10 years at +40 °C</td>
</tr>
<tr>
<td>when number of write processes has been</td>
<td>1 year at +40 °C</td>
</tr>
<tr>
<td>90 % of lifetime of each cell</td>
<td></td>
</tr>
<tr>
<td>Write protect switch</td>
<td>Yes, at the edge of the memory card</td>
</tr>
<tr>
<td>Weight</td>
<td>2 g</td>
</tr>
<tr>
<td>Dimensions</td>
<td>24 mm x 32 mm x 2.1 mm</td>
</tr>
</tbody>
</table>

*It is not possible to use 100 % of a device's memory space. About 10 % of the total available space must remain unused at any time to maintain normal device operation.*

**Ordering data**

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 180 100 R0041</td>
<td>MC5141, memory card</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
5.2.8.2.3 TA521 - Battery

- Manganese dioxide lithium battery, 3 V, 560 mAh
- Non-rechargeable

The TA521 battery is the only applicable battery for the AC500 processor modules. It cannot be recharged.

The processor modules are supplied without lithium battery. It must be ordered separately. The TA521 lithium battery is used for data (SRAM) and RTC buffering while the processor module is not powered.

The CPU monitors the discharge degree of the battery. A warning is issued before the battery condition becomes critical (about 2 weeks before). Once the warning message appears, the battery should be replaced as soon as possible.

Handling instructions

- Do not short-circuit or re-charge the battery! It can cause excessive heating and explosion.
- Do not disassemble the battery!
- Do not heat up the battery and not put into fire! Risk of explosion.
- Store the battery in a dry place.
- Replace the battery with supply voltage ON in order not to risk data being lost.
- Recycle exhausted batteries meeting the environmental standards.

Battery lifetime

The battery lifetime is the time, the battery can store data while the processor module is not powered. As long as the processor module is powered, the battery will only be discharged by its own leakage current.

To avoid a short battery discharge, the battery should always be inserted or replaced while the process module is under power, then the battery is correctly recognized and will not shortly discharged.

Insertion

To ensure proper operation and to prevent data loss, the battery insertion or replacement must be always done with the system under power. Without battery and power supply there is no data buffering possible.
WARNING!
Risk of fire or explosion!
Use of incorrect Battery may cause fire or explosion.

1. Open the battery compartment with the small locking mechanism, press it down and slip down the door. The door is attached to the front face of the processor module and cannot be removed.

2. Remove the TA521 battery from its package and hold it by the small cable. Remove then the small connector from the socket, do this best by lifting it out with a screwdriver.

3. Insert the battery connector into the small connector port of the compartment. The connector is keyed to find the correct polarity (red = positive pole = above).

4. Insert first the cable and then the battery into the compartment, push it until it reaches the bottom of the compartment.

5. Arrange the cable in order not to inhibit the door to close.

6. Pull-up the door and press until the locking mechanism snaps.

In order to prevent data losses or problems, the battery should be replaced after 3 years of utilisation or at least as soon as possible after receiving the "low battery warning" indication.

Do not use a battery older than 3 years for replacement, do not keep batteries too long in stock.

Replacement of the battery

To ensure proper operation and to prevent data loss, the battery insertion or replacement must be always done with the system under power. Without battery and power supply there is no data buffering possible.
1. Open the battery compartment with the small locking mechanism, press it down and slip down the door. The door is attached to the front view of the processor module and cannot be removed.

2. Remove the old TA521 battery from the battery compartment by pulling it by the small cable. Remove then the small connector from the socket, do this best by lifting it out with a screwdriver.

3. Follow the previous instructions to insert a new battery.

---

**CAUTION!**

Risk of explosion!

Do not open, re-charge or disassemble lithium batteries. Attempting to charge lithium batteries will lead to overheating and can cause explosions.

Protect them from heat and fire and store them in a dry place.

Never short-circuit or operate lithium batteries with the polarities reversed. The batteries are likely to overheat and explode. Avoid unintentional short circuiting do not store batteries in metal containers and do not place them on metallic surfaces. Escaping lithium is a health hazard.

---

In order to prevent data losses or problems, the battery should be replaced after 3 years of utilisation or at least as soon as possible after receiving the "low battery warning" indication.

Do not use a battery older than 3 years for replacement, do not keep batteries too long in stock.

---

### Technical data

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nominal voltage</td>
<td>3 V</td>
</tr>
<tr>
<td>Nominal capacity</td>
<td>560 mAh</td>
</tr>
<tr>
<td>Temperature range (index below C0)</td>
<td>Operating: 0 °C ... +60 °C</td>
</tr>
<tr>
<td></td>
<td>Storage: -20 °C ... +60 °C</td>
</tr>
<tr>
<td></td>
<td>Transport: -20 °C ... +60 °C</td>
</tr>
</tbody>
</table>
## Parameter

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
</table>
| Temperature range (index C0 and above) | Operating: -40 °C ... +70 °C  
Storage: -40 °C ... +85 °C  
Transport: -40 °C ... +85 °C |
| Battery lifetime | Typ. 3 years at +25 °C |
| Self-discharge | 2 % per year at +25 °C  
5 % per year at +40 °C  
20 % per year at +60 °C |
| Protection against reverse polarity | Yes, by mechanical coding of the plug. |
| Insulation | The battery is completely insulated. |
| Connection | Red = positive pole = above at plug, black = negative pole, |
| Weight | 7 g |
| Dimensions | Diameter of the button cell: 24.5 mm  
Thickness of the button cell: 5 mm |

### Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 180 300 R0001</td>
<td>TA521, lithium battery</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
5.2.8.2.4 TA524 - Dummy communication module

1 Type
2 Label

Purpose
TA524 is used to cover an unused communication module slot of a terminal base. It protects the terminal base from dust and inadvertent touch.

Chapter 5.2.3.1 “TB56xx for AC500 V3 products” on page 377

Handling instructions
TA524 is mounted in the same way as a common communication module.

Chapter 4.3.5 “Mounting and demounting the communication module” on page 109

Technical data

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>50 g</td>
</tr>
<tr>
<td>Dimensions</td>
<td>135 mm x 28 mm x 62 mm</td>
</tr>
</tbody>
</table>

Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 180 600 R0001</td>
<td>TA524, dummy communication module</td>
<td>Active</td>
</tr>
</tbody>
</table>
5.2.8.2.5 TA526 - Wall mounting accessory

### Purpose
If a terminal base or a terminal unit should be mounted with screws, the wall mounting accessories TA526 must be inserted at the rear side first. This plastic parts prevent bending of terminal bases and terminal units while screwing up.

- **Handling of the wall mounting accessory with terminal units**
- **Handling of the wall mounting accessory with terminal bases**

### Technical data

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>5 g</td>
</tr>
<tr>
<td>Dimensions</td>
<td>67 mm x 35 mm x 5.5 mm</td>
</tr>
</tbody>
</table>

### Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 180 800 R0001</td>
<td>TA526, wall mounting access- sory</td>
<td>Active</td>
</tr>
</tbody>
</table>

*') Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
5.2.8.3 S500 and S500-XC

5.2.8.3.1 CP-E - Economic range

The power supplies feature series and parallel connection as well as a true redundant setup via a redundancy module.

- Wide-range input voltage
- Mounting on DIN rail
- High efficiency of up to 90 %
- Low power dissipation and low heating
- Wide ambient temperature range from -40 °C ... +70 °C
- No-load-proof, overload-proof, continuous short-circuit-proof
- Power factor correction (depending on the type)
- Approved in accordance with all relevant international standards
## Table 297: Ordering data

<table>
<thead>
<tr>
<th>Order No.</th>
<th>Type</th>
<th>Input</th>
<th>Output</th>
<th>Overload capacity</th>
<th>Module width [mm]</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SVR427030R0000</td>
<td>CP-E</td>
<td>24/0.75</td>
<td>100-240 V AC or 120-370 V DC</td>
<td>24 V DC, 0.75 A</td>
<td>22.5</td>
</tr>
<tr>
<td>1SVR427031R0000</td>
<td>CP-E</td>
<td>24/1.25</td>
<td>100 V AC ... 240 V AC or 90 V DC ... 375 V DC</td>
<td>24 V DC, 1.25 A</td>
<td>40.5</td>
</tr>
<tr>
<td>1SVR427032R0000</td>
<td>CP-E</td>
<td>24/2.5</td>
<td>100 V AC ... 240 V AC or 90 V DC ... 375 V DC</td>
<td>24 V DC, 2.5 A</td>
<td>40.5</td>
</tr>
<tr>
<td>1SVR427034R0000</td>
<td>CP-E</td>
<td>24/5.0</td>
<td>115/230 V AC auto select or 210 V DC ... 370 V DC</td>
<td>24 V DC, 5 A</td>
<td>63.2</td>
</tr>
<tr>
<td>1SVR427035R0000</td>
<td>CP-E</td>
<td>24/10.0</td>
<td>115/230 V AC auto select or 210 V DC ... 370 V DC</td>
<td>24 V DC, 10 A</td>
<td>83</td>
</tr>
<tr>
<td>1SVR427036R0000</td>
<td>CP-E</td>
<td>24/20.0</td>
<td>115 V AC ... 230 V AC or 120 V DC ... 370 V DC</td>
<td>24 V DC, 20 A</td>
<td>175</td>
</tr>
</tbody>
</table>
The power supplies feature series and parallel connection as well as a true redundant setup via a redundancy module.

The CP-C.1 power supplies are ABB’s high performance and most advanced range. With excellent efficiency, high reliability and innovative functionality it is prepared for the most demanding industrial applications. These power supplies have a 50 % integrated power reserve and operate at an efficiency of up to 94 %. They are equipped with overheat protection and active power factor correction. Combined with a broad AC and DC input range and extensive worldwide approvals the CP-C.1 power supplies are the preferred choice for professional DC applications.

- Typical efficiency of up to 94 %
- Power reserve design delivers up to 150 % of the nominal output current
- Signaling outputs for DC OK and power reserve mode
- High power density leads to very compact and small devices
- No-load-proof, overload-proof, continuous short-circuit-proof
- Active power factor correction (PFC)
### Table 298: Ordering data

<table>
<thead>
<tr>
<th>Order No.</th>
<th>Type</th>
<th>Input</th>
<th>Output</th>
<th>Overload capacity</th>
<th>Module width [mm]</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SVR360563R1001</td>
<td>CP-C.1</td>
<td>110 V AC ... 240 V AC or 90 V DC ... 300 V DC</td>
<td>24 V DC, 5 A</td>
<td>+50 %</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>24/5.0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1SVR360663R1001</td>
<td>CP-C.1</td>
<td>110 V AC ... 240 V AC or 90 V DC ... 300 V DC</td>
<td>24 V DC, 10 A</td>
<td>+50 %</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>24/10.0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1SVR360763R1001</td>
<td>CP-C.1</td>
<td>110 V AC ... 240 V AC or 90 V DC ... 300 V DC</td>
<td>24 V DC, 20 A</td>
<td>+30 %</td>
<td>82</td>
</tr>
<tr>
<td></td>
<td>24/20.0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### 5.2.8.3.3 TA523 - Pluggable label mounting

For labelling the channels of S500 I/O modules.
1 Pluggable label mounting TA523
2 Plastic labels to be inserted into the holder

Purpose
The pluggable label mounting is used to hold 4 plastic labels, on which the meaning of the I/O channels of I/O modules can be written down. The holder is transparent so that after snapping it onto the module the LEDs shine through.

Handling instructions
The plastic labels can be printed out from TA523.doc.

Technical data
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use</td>
<td>For labelling channels of I/O modules</td>
</tr>
<tr>
<td>Mounting</td>
<td>Snap-on to the module</td>
</tr>
<tr>
<td>Weight</td>
<td>20 g</td>
</tr>
<tr>
<td>Dimensions</td>
<td>82 mm x 67 mm x 13 mm</td>
</tr>
</tbody>
</table>
Part no. Description Product life cycle phase *)
1 SAP 180 500 R0001 TA523, pluggable label mounting (10 pieces) Active

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

### 5.2.8.3.4 TA525 - Plastic labels

Accessory to label AC500 and S500 modules.

**Purpose**

The plastic labels are suitable for labelling AC500 and S500 modules (CPUs, communication modules and I/O modules). The small plastic parts can be written on with a standard waterproof pen.

**Handling instructions**

The plastic labels are inserted under a slight pressure. For disassembly, a small screwdriver is inserted at the lower edge of the module.

**Technical data**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use</td>
<td>For labelling AC500 and S500 modules</td>
</tr>
<tr>
<td>Mounting</td>
<td>Insertion under a slight pressure</td>
</tr>
</tbody>
</table>

1 Module without plastic label TA525

2 Module with plastic label TA525
### Parameter Value

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disassembly</td>
<td>With a small screwdriver</td>
</tr>
<tr>
<td>Scope of delivery</td>
<td>10 pieces</td>
</tr>
<tr>
<td>Weight</td>
<td>1 g per piece</td>
</tr>
<tr>
<td>Dimensions</td>
<td>8 mm x 20 mm x 5 mm</td>
</tr>
</tbody>
</table>

### Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 180 700 R0001</td>
<td>TA525, Set of 10 white plastic labels</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

### 5.2.8.3.5 TA526 - Wall mounting accessory

#### Purpose

If a terminal base or a terminal unit should be mounted with screws, the wall mounting accesso-
ries TA526 must be inserted at the rear side first. This plastic parts prevent bending of terminal
bases and terminal units while screwing up.

- Handling of the wall mounting accessory with terminal units
- Handling of the wall mounting accessory with terminal bases

#### Technical data

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>5 g</td>
</tr>
<tr>
<td>Dimensions</td>
<td>67 mm x 35 mm x 5,5 mm</td>
</tr>
</tbody>
</table>

#### Ordering data

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 180 800 R0001</td>
<td>TA526, wall mounting acces-sory</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.
5.2.8.3.6 TA535 - Protective caps for XC devices

**Purpose**
Accessory to cover unused connectors of XC devices in salt mist environments.
One TA535 package includes different cap types for the following connectors:
- RJ45 connectors
- 9-pole D-sub connector
- FieldBusPlug connector
Protection should be done for all unused slots of -XC devices.

<table>
<thead>
<tr>
<th>Part no.</th>
<th>Description</th>
<th>Product life cycle phase *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1SAP 182 300 R0001</td>
<td>TA535, Protective Caps for XC devices</td>
<td>Active</td>
</tr>
</tbody>
</table>

*) Modules in lifecycle Classic are available from stock but not recommended for planning and commissioning of new installations.

5.2.9 Storage devices
5.2.9.1 Overview
AC500 PLCs offer a variety of storage devices. The following table gives a short overview and a description on these storage devices:

- **IEC access means that the storage device can be accessed by function blocks of an IEC program.**
- **FTP access means that the device can be accessed via FTP server on the PLC (if available).**
<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
<th>IEC access</th>
<th>FTP access</th>
<th>Processor modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>userdisk</td>
<td>User disk for custom data (flash)</td>
<td>Yes</td>
<td>Yes</td>
<td>All</td>
</tr>
<tr>
<td>home/userdisk</td>
<td>Internal persistent mass storage placed in the internal flash device</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(customer data)</td>
<td>Can be used for any application purpose</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PLCLogic</td>
<td>Internal persistent mass storage placed in the internal flash device</td>
<td>Yes</td>
<td>Yes</td>
<td>All</td>
</tr>
<tr>
<td>home/PLCLogic</td>
<td>Used for configuration data, user application (boot project), WebVisu files, etc.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(customer data)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SRAM</td>
<td>Battery-buffered device, non-volatile RAM</td>
<td>Yes</td>
<td>No</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>Used for retain/persistent and %M variables</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>system</td>
<td>System RAM disk (Temp directory) for storing the firmware</td>
<td>Yes</td>
<td>No</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>For internal firmware use only!</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>flash disk</td>
<td>Internal persistent mass storage device</td>
<td>Yes</td>
<td>Yes</td>
<td>PM5675-2ETH</td>
</tr>
<tr>
<td></td>
<td>Can be used for any application purpose</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>memory card</td>
<td>memory card (removable)</td>
<td>Yes</td>
<td>Yes</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>Removable persistent mass storage device</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Can be used for any application purpose</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Functionalities

<table>
<thead>
<tr>
<th>Filesystem Name</th>
<th>As of CPU firmware</th>
<th>Description</th>
</tr>
</thead>
</table>
| userdisk        | V3.0.0             | Boot project (size depends on PLC type)  
WebVisu files for web server  
Symbol file for OPC server and CP600 panels  
User data via CAA_File_xxx.lib *)  
Files via Automation Builder file download  
Files via FTP server |
|                 | V3.1.0             | Save persistent data |
| SRAM            | V3.1.0             | Save retain and persistent data |
| system          | V3.0.0             | Load / save boot project  
Firmware update  
Internal system files |
| flash disk      | V3.1.0             | User data via CAA_File_xxx.lib *)  
Files via Automation Builder file download  
Files via FTP server |
| sdcard          | V3.0.0             | Firmware update  
User data via CAA_File_xxx.lib *)  
Files via Automation Builder file download  
Files via FTP server |
|                 | V3.1.0             | Save persistent data  
Boot project (size depends on PLC type) |

*) Examples for the filename with path (sFileName for FILE.Open) specified by the user ('mydir' is optional, but must be an existing directory):

- 'userdisk/myfile.txt'
- 'sdcard/mydir/myfile.txt'
- 'flashdisk/myfile.txt'

The maximum number of files opened at the same time is limited to 1007.
The max. length of the user string (path and filename) is 241 characters.

Unlike the PLC's memory areas like %M or Retain, where 1 byte actually consumes 1 byte, all storage device utilize a file system.

That means there is a difference between a files size and its size on the disk.

On disks the files are stored in so-called clusters which are a group of disk sectors. "Size on disk" refers to the amount of cluster(s) a file is taking up, while "file size" is an actual byte count of the file data. So you will usually find that the size on disk is larger than the file size. This is not an error, but a result of the disk organization via a file system. Since sector and cluster sizes vary depending on a disk's size and the used file system, the ratios between the size on disk and the file size also vary between the various storage devices.
### 5.2.9.3 Memory sizes

#### AC500-eCo V3 processor modules

<table>
<thead>
<tr>
<th>PLC type</th>
<th>system RAM disk</th>
<th>userdisk</th>
<th>Retain, %M area</th>
<th>flash disk</th>
<th>memory card</th>
</tr>
</thead>
<tbody>
<tr>
<td>PM5012-x-ETH</td>
<td>Dynamically /max. 7.6 MB</td>
<td>30 MB</td>
<td>8 kB Retain and persistent 4 kB (of which 88 byte are reserved for allocation table and are not available to the user)</td>
<td>None</td>
<td>% Chapter 5.2.8.2.1 “MC5102 - Micro memory card with adapter” on page 1309</td>
</tr>
<tr>
<td>PM5032-x-ETH</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PM5052-x-ETH</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PM5072-T-2ETH(W)</td>
<td></td>
<td></td>
<td>100 kB Retain and persistent 36 kB (of which 88 byte are reserved for allocation table and are not available to the user)</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>PM5082-T-2ETH</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### AC500 V3 processor modules

<table>
<thead>
<tr>
<th>PLC type</th>
<th>system RAM disk</th>
<th>userdisk</th>
<th>SRAM Retain, %M area</th>
<th>flash disk</th>
<th>memory card</th>
</tr>
</thead>
<tbody>
<tr>
<td>PM5630-2ETH</td>
<td>Dynamically /max. 7.6 MB</td>
<td>40 MB</td>
<td>256 kB Retain and persistent 128 kB (of which 88 byte are reserved for allocation table and are not available to the user)</td>
<td>None</td>
<td>% Chapter 5.2.8.2.2 “MC5141 - Memory card” on page 1315</td>
</tr>
<tr>
<td>PM5650-2ETH</td>
<td>Dynamically /max. 16 MB</td>
<td>246 MB (as of V3.0.x)</td>
<td>381 MB (as of V3.1)</td>
<td>285.75 (as of V3.4.0)</td>
<td>% Chapter 5.2.8.2.1 “MC5102 - Micro memory card with adapter” on page 1309</td>
</tr>
<tr>
<td>PLC type</td>
<td>system RAM disk</td>
<td>userdisk</td>
<td>SRAM Retain, %M area</td>
<td>flash disk</td>
<td>memory card</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------</td>
<td>----------</td>
<td>----------------------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>PM5670-2ET H</td>
<td>Dynamically /max. 69 MB</td>
<td>858 MB 643.50 MB (as of V3.4.0)</td>
<td>1536 MB 1 MB retain and persistent (of which 68 byte are reserved for allocation table and are not available to the user) 512 kB %M</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PM5675-2ET H</td>
<td></td>
<td></td>
<td></td>
<td>8 GB</td>
<td></td>
</tr>
</tbody>
</table>

It is not possible to use 100 % of a device’s memory space. About 10 % of the total available space must remain unused at any time to maintain normal device operation.

5.2.9.4 Storage device details

5.2.9.4.1 SRAM

The SRAM is a battery-buffered, nonvolatile RAM and is used for the retain/persistent and the %M variables. If a battery is inserted into the processor module, the data stored in the SRAM will not get lost during a power-down cycle.

During PLC startup, the SRAM will be deleted automatically if no or an empty battery is inserted into the processor module. In this case the information

ABBInitSram_SetupMemory : SRAM cleared

and the warning

Retain size in config changed, or retain area got corrupted

are written into the log file.

Chapter 6.8.2.1 “Handling of remanent variables for AC500 V3 products” on page 4412

5.2.9.4.2 Flash disk

The flash disk is an internal persistent mass storage device and can be used for any application purpose.

It has a memory capacity of 8 GB (preformatted).

The flash disk is capable of high data throughput, however, the actual values to be achieved depend on the use cases. If the performance seems to get insufficient, check the following:

- If the PLCs CPU load is high, reduce overall CPU load of the PLC to have more performance for file operations.
- If the device has low free space, cleanup the disk.

Please consider the cluster size of 4 kB in your application design to achieve optimal usage of the flash disks space and access performance. For example, 10 files with 10 byte each require 10*4 kB disk space, while 1 file with 100 byte requires only 4 kB.

Number of max. write cycles

Technically, the flash chip used in the V3 flash disk has 20000 erase cycles (Write cycles).
Due to the produced write overhead, the optimum achievable number of write cycles is 10000 (for typical payload sizes of 256 kB).

**Example**

The write overhead is indicated by the *write amplification factor (WAF)*.

\[ WAF = \frac{\text{Flash Write (in Bytes)}}{\text{Host Write (in Bytes)}} \]

<table>
<thead>
<tr>
<th>Typical payload sizes</th>
<th>WAF</th>
<th>Max. write cycles</th>
</tr>
</thead>
<tbody>
<tr>
<td>256 kB</td>
<td>2</td>
<td>10000</td>
</tr>
<tr>
<td>128 kB</td>
<td>4</td>
<td>5000</td>
</tr>
<tr>
<td>64 kB</td>
<td>8</td>
<td>2500</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>1024 Byte</td>
<td>512</td>
<td>&lt; 40</td>
</tr>
<tr>
<td>512 Byte</td>
<td>1024</td>
<td>&lt; 20</td>
</tr>
</tbody>
</table>

*Table 299: Rule of thumb for assessing the flash lifetime for an application:*

For monitoring the status

*It is recommended to use the respective function blocks to monitor the status of the flash disk.*

Since FW version 3.3.0, there is also a diagnosis event supported when the user flash memory reaches the end of its life cycle.

Lifetime of flash disk will also depend on the operating environment.

*E.g. high ambient temperatures will impose stress on the user flash memory and reduce the total overwrites achievable.*

- Max. write speed is 20 MB/s (continuous write of sequential data)
- Read cycles are unlimited.

### 5.2.9.4.3 Memory card

The memory card is a removable persistent mass storage device and can be used for any application purpose. Both firmware updates and boot project updates can be run from the memory card.

*Chapter 6.3.1.4.5 “Firmware installation and update with memory card” on page 1426*

<table>
<thead>
<tr>
<th>Size</th>
<th>Product specific</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><em>Chapter 5.2.9.3 “Memory sizes ” on page 1335</em></td>
</tr>
</tbody>
</table>

### 5.2.9.4.4 Further information

*Further details on the storage device sizes*
5.3 Status LEDs, display and control elements

Depending on the device type, various operating elements provided on the front panel can be used to control the devices of the PLC system and/or to change the operating mode.

Operating elements:

- Status LEDs:
  Indicates the availability of devices and components such as communication modules, communication interface modules or function modules. Functionality and diagnosis of the status LEDs depends on the specific module and is described in the device description of the appropriate module. Possible status: on/off/blinking

- I/O LEDs:
  Displays the status of the inputs and outputs.

- Display:
  Available for some processor modules. It can be used for simple configurations and for reading out diagnosis information.
  - Chapter 6.8.2.5 “Display, LEDs and function keys on the front panel” on page 4452
  - Chapter 6.9.1.3 “Diagnosis in CPU display” on page 4607
  - Chapter 4.8 “Troubleshooting” on page 149

- Function keys and switches:
  Allows to change the current operating modes/status manually
  - Chapter 6.8.2.5.5 “Description of the function keys” on page 4457.
6 Configuration and programming
6.1 Cyber security

6.1.1 General

**Cyber security disclaimer**

This product is designed to be connected to and to communicate information and data via a network interface. It is your sole responsibility to provide and continuously ensure a secure connection between the product and your network or any other network (as the case may be). You shall establish and maintain any appropriate measures (such as but not limited to the installation of firewalls, application of authentication measures, encryption of data, installation of anti-virus programs, etc.) to protect the product, the network, its system and the interface against any kind of security breaches, unauthorized access, interference, intrusion, leakage and/or theft of data or information. ABB Ltd and its affiliates are not liable for damages and/or losses related to such security breaches, any unauthorized access, interference, intrusion, leakage and/or theft of data or information.

Although ABB provides functionality testing on the products and updates that we release, you should institute your own testing program for any product updates or other major system updates (to include but not limited to code changes, configuration file changes, third party software updates or patches, hardware exchanges, etc.) to ensure that the security measures that you have implemented have not been compromised and system functionality in your environment is as expected. This also applies to the operating system. Security measures (such as but not limited to the installation of latest patches, installation of firewalls, application of authentication measures, installation of anti-virus programs, etc.) are in your responsibility. You have to be aware that operating systems provide a considerable number of open ports that should be monitored carefully for any threats.

It has to be considered that online connections to any devices are not secured. It is your responsibility to assure that connections are established to the correct device (and e.g. not to an unknown device pretending to be a known device type). Furthermore you have to take care that confidential data exchanged with the PLC is either compiled or encrypted.

**Security related deployment guidelines for industrial automation**

Security details for industrial automation is provided on ABB website in a whitepaper.

**Signed firmware updates**

The firmware update files for the AC500 V3 PLC are digitally signed releases by ABB. During the update process, these signatures are validated by a hardware security component in the PLC. This way, the AC500 V3 PLC will only update with valid, authentic firmware, signed by ABB.

**Open ports and services**

As part of the ABB security concept the AC500 V3 PLC comes with minimal services opened by default. Only the services needed for initial setup and programming are open before any user application is downloaded. Chapter 5.2.1.2.1.3 “Ethernet protocols and ports for AC500 V3 products” on page 307.

Only used services/ports should be enabled (e.g. to enable the functionality of an FTPS server).

**Encrypted and signed applications**

An application can be encrypted and signed in order to protect a running application in an AC500 V3 PLC and to protect a configured project. How to set-up the user management, the communication and the boot application in order to prevent unauthorized access is explained in the application note AC500 V3 - Encrypt and sign your application.

**Secure communication**

Whenever possible, use an encrypted communication between AC500 V3 devices and third party devices, such as HMI devices. This is necessary to protect passwords and other data.
Secure shell access for ABB service

The AC500 V3 PLC contains a secure shell service to access core logging data in case of problems which need a deeper analysis. This service is inactive by default, which means that no one can access this privileged shell in the normal operating state.

To activate this service, local access to the PLC is necessary and activation is only valid until the next power cycle of the PLC. Once activated, the service run on TCP port 22. Each PLC also protects the secure shell access by an individual password.

Frequently asked questions

For more information around cyber security please see our AC500 cyber security FAQ.

6.1.2 Defense in depth

The defense in depth approach implements multi-layer IT security measures. Each layer provides its special security measures. All deployed security mechanisms in the system must be updated regularly. It is also important to follow the system vendor’s recommendations on how to configure and use these mechanisms. As a basis, the components must include security functions such as:

- Virus protection
- Firewall protection
- Strong and regularly changed passwords
- User management
- Using VPN tunnels for connections between networks

Additional security components such as routers and switches with integrated firewalls should be available. A defined user and rights concept managing access to the controllers and their networks is mandatory. Finally, the manufacturer of the components should be able to quickly discover weaknesses and provide patches.

References: CODESYS Security Whitepaper

Security zones

IT resources vary in the extent to which they can be trusted. A common security architecture is therefore based on a layered approach that uses zones of trust to provide increasing levels of security according to increasing security needs. Less-trusted zones contain more-trusted zones and connections between the zones are only possible through secure interconnections such as firewalls Fig. 265. All resources in the same zone must have the same minimum level of trust. The inner layers, where communication interaction needs to flow freely between nodes, must have the highest level of trust. This is the approach described in the IEC 62443 series of standards.

Firewalls, gateways, and proxies are used to control network traffic between zones of different security levels, and to filter out any undesirable or dangerous material. Traffic that is allowed to pass between zones should be limited to what is absolutely necessary because each type of service call or information exchange translates into a possible route that an intruder may be able to exploit. Different types of services represent different risks. Internet access, incoming e-mail and instant messaging, for example, represent very high risks.
Fig. 265: Security zones

Fig. 265 shows three safety zones, but the number of zones is not necessarily decisive, there can also be more or less - depending on the safety requirement. The use of multiple zones allows access between zones of different trust levels to be controlled to protect a trusted resource from attack by a less trusted one.

High-security zones should be kept small and independent. They need to be physically protected, i.e. physical access to computers, network equipment and network cables must be limited by physical means to authorized persons only. A high-security zone should obviously not depend on resources in a less secure zone for its security. Therefore, it should form its own domain that is administered from the inside, and not depend on, e.g., a domain controller in a less secure network.

Even if a network zone is regarded as trusted, an attack is still possible: by a user or compromised resource that is inside the trusted zone, or by an outside user or resource that succeeds to penetrate the secure interconnection. Trust therefore depends also upon the types of measures taken to detect and prevent compromise of resources and violation of the security policy.

References: *Security for industrial automation and control systems*

### 6.1.3 Secure operation

The controller must be located in a protected environment in order to avoid accidental or intended access to the controller or the application.

A protected environment can be:

- Locked control cabinets without connection from outside
- No direct internet connection
- Use firewalls and VPN to separate different networks
- Separate different production areas with different access controls

To increase security, physical access protection measures such as fences, turnstiles, cameras or card readers can be added.

Follow these rules for the protected environment:

- Keep the trusted network as small as possible and independent from other networks.
- Protect the cross-communication of controllers and the communication between controllers and field devices via standard communication protocols (fieldbus systems) using appropriate measures.
- Protect such networks from unauthorized physical access.
- Use fieldbus systems only in protected environments. They are not protected by additional measures, such as encryption. Open physical or data access to fieldbus systems and their components is a serious security risk.
Physically protect all equipment, i.e., ensure that physical access to computers, network equipment and cables, controllers, I/O systems, power supplies, etc., is limited to authorized persons.

When connecting a trusted network zone to outer networks, make sure that all connections are through properly configured secure interconnections only, such as a firewall or a system of firewalls, which is configured for “deny by default”, i.e., blocks everything except traffic that is explicitly needed to fulfill operational requirements.

Allow only authorized users to log on to the system, and enforce strong passwords that are changed regularly.

Continuously maintain the definitions of authorized users, user groups, and access rights, to properly reflect the current authorities and responsibilities of all individuals at all times. Users should not have more privileges than they need to do their job.

Do not use the system for e-mail, instant messaging, or internet browsing. Use separate computers and networks for these functions if they are needed.

Do not allow installation of any unauthorized software in the system.

Restrict temporary connection of portable computers, USB memory sticks and other removable data carriers. Computers that can be physically accessed by regular users should have ports for removable data carriers disabled.

If portable computers need to be connected, e.g., for service or maintenance purposes, they should be carefully scanned for viruses immediately before connection.

All CDs, DVDs, USB memory sticks and other removable data carriers, and files with software or software updates, should also be checked for viruses before being introduced into the trusted zone.

Continuously monitor the system for intrusion attempts.

Define and maintain plans for incident response, including how to recover from potential disasters.

Regularly review the organization as well as technical systems and installations with respect to compliance with security policies, procedures and practices.

A protected local control cabinet could look like in figure 266, page 1343. This network is not connected to any external network. Security is primarily a matter of physically protecting the automation system and preventing unauthorized users from accessing the system and from connecting or installing unauthorized hardware and software.

**Fig. 266: Isolated automation system**

Servers and workplaces that are not directly involved in the control and monitoring of the process should preferably be connected to a subnet that is separated from the automation system network by means of a router/firewall. This makes it possible to better control the network load and to limit access to certain servers on the automation system network. Note that servers and workplaces on this subnet are part of the trusted zone and thus need to be subject to the same security precautions as the nodes on the automation system network.
For the purposes of process control security, a general-purpose information system (IS) network should not be considered a trusted network, not the least since such networks are normally further connected to the Internet or other external networks. The IS network is therefore a different lower-security zone, and it should be separated from the automation system by means of a firewall. The IS and automation system networks should form separate domains.

Fig. 267: Plant information network connected to an automation system
6.1.4 Hardening

System hardening means to eliminate as many security risks as possible. Hardening your system is an important step to protect your personal data and information. This process intends to eliminate attacks by patching vulnerabilities and turning off inessential services. Hardening a system involves several steps to form layers of protection.

Commissioning phase
- Protect the hardware from unauthorized access
- Be sure the hardware is based on a secure environment
- Disable unused software and services (network ports)
- Install firewalls
- Disallow file sharing among programs

Fig. 268: Automation system and IS network
- Install virus and spyware protection
- Use containers or virtual machines
- Create strong passwords by applying a strong password policy
- Create and keep backups
- Use encryption when possible
- Disable weak encryption algorithms
- Separate data and programs
- Enable and use disk quotas
- Strong logical access control
- Adjust default settings, especially passwords

Verification phase
- Verification of antivirus - Check antivirus is active and updated
- Verification of the identification - Check that test and unauthorized accounts are removed
- Verification of intrusion detection systems - Check malicious traffic is blocked
- Verification of audit logging - Check audit log is enabled
- You can use the checklist out of the cyber security white paper

Operation phase
- Keep software up-to-date, especially by applying security patches
- Keep antivirus up and running
- Keep antivirus definitions up-to-date
- Delete unused user accounts
- Lock an active session whenever it is unattended, e.g., lock the screen of the PC or of the control panel (HMI)

Decommissioning phase
- Delete all credentials stored in the device like certificates and user data  

6.1.5 Certificates factory default - no encryption

As of Automation Builder Release 2.6.0, the encryption of the AC500 communication policy is set to "No encryption" by default. The reason for that is that the PLC clock defaults to 01/01/1970 when shipped from the factory, any pre-installed certificate would already be expired when the user attempts to connect.

Preliminary work
- Connection of the PLC to the Automation Builder and internet access.
- The PLC must be equipped with a battery to keep the date in case of power off.  
- The PLC must be set to the current date and time.  

1. If necessary reboot the PLC.
2. Connect the PLC to the Automation Builder again.

Create an CA-signed certificate

The basis for an official trusted signed certificate is the creation of a Certificate Signing Request.  

As an example, the creation of a certificate for a FTP server is described.
1. Double-click to the PLC main node and select the “PLC Shell” tab. Command line input is on the bottom. Find the index number for the FTP server and type `[cert-getapplist]` in the below command line.

2. Type `[cert-createcsr <index number> encoding=Base64]` in the command line e.g. here: `[cert-createcsr 1 encoding=Base64]` and press [ENTER].

   For some users it may be necessary to swap “Base64” for “ASN1” if the user’s PKI needs this format.

3. Change to the “Log” tab.
4. Click the refresh button.
   → Wait until the log entry of CSR file created pops up.

5. Change to the “Files” tab.
6. Click the refresh button.
7. Open the “cert” folder in the PLC.
8. Open the “export” folder.
9. Copy the certificate request file `[1_IoDrvFTPServer.csr]` to any folder on your PC.

10. This file, here `[1_IoDrvFTPServer.csr]` must then be signed by your Public Key Infrastructure (PKI).

   The signing process itself is outside the scope of this documentation. There are sufficient sources on the internet for building your own PKI (e.g. PKI tutorial) - or get in touch with your IT department.

**Integrate a certificate**

After the signed certificate comes back from the PKI and is stored on the PC, it has to be imported into the controller.
Be sure to import into the “Own Certificates” folder.

1. Change to the “Security Screen”.
2. Select tab “Devices”, the folder “Own Certificates” and press the import button.

3. Select the certificate (f1_IoDrvFTPServer.cer) to be imported in the opening file manager.
4. Press the “Open” button.
   ⇨ The new certificate will be shown as “IoDrvFTPServer” in the information column. The previous self-signed certificate will lose its name and is therefore not valid anymore.

   DON’T delete any of the installed certificates.

5. Check the validation and “Issued by” of the new certificate by activating the top PLC branch.
6. Download and reboot the PLC (repower or use “PLC Shell” and command [reboot].)

   We recommend changing the communication policy accordingly so that only encrypted connections are allowed.

---

**Encrypted and signed applications**

An application can be encrypted and signed in order to protect a running application in an AC500 V3 PLC and to protect a configured project. How to set-up the user management, the communication and the boot application in order to prevent unauthorized access is explained in the application note **AC500 V3 - Encrypt and sign your application**.

**Enforced signing**

As of Automation Builder 2.6.0 there is also the possibility to activate the “Enforced signing” mode in the “Change Runtime Security Policy”. Then the controller accepts ONLY signed downloads.

“Tab Communication Settings ➔ Device ➔ Change Runtime Security Policy... ➔ Code Signing ➔ New policy ➔ Enforced signing”
More information about certificates and cyber security can be found in the white paper AC500 cyber security.

6.1.6 Open Ports and Services

6.1.6.1 Default open Ethernet ports of AC500 V3 and AC500-eCo V3 CPUs

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABB NetConfig 1)</td>
<td>UDP 24576</td>
</tr>
<tr>
<td>Online access with driver 3S Tcp/Ip BlkDrvTcp (no scan)</td>
<td>TCP 11740</td>
</tr>
<tr>
<td>OPC UA server 2)</td>
<td>TCP 4840</td>
</tr>
</tbody>
</table>

Remarks:
1): The port 24576 for ABB NetConfig protocol can be disabled via PLC configuration by deleting the protocol node from configuration tree of Ethernet interfaces ETH1 and ETH2.
2): The port 4840 for OPC UA server is closed by default as of SystemFW V3.1.0.

6.1.6.2 Open ports and services of the Automation Builder (Engineering PC)

<table>
<thead>
<tr>
<th>Port</th>
<th>Protocol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1217</td>
<td>TCP</td>
<td>CODESYS Gateway V3</td>
</tr>
<tr>
<td>1210</td>
<td>TCP</td>
<td>CODESYS Gateway V2</td>
</tr>
<tr>
<td>1211</td>
<td>TCP</td>
<td>CODESYS Gateway V2</td>
</tr>
<tr>
<td>Port</td>
<td>Protocol</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>----------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>22350</td>
<td>TCP/UDP</td>
<td>CodeMeter License Server (runtime) – license</td>
</tr>
<tr>
<td>22352</td>
<td>HTTP</td>
<td>CodeMeter License Server (runtime) – WebAdmin</td>
</tr>
<tr>
<td>22353</td>
<td>HTTPS</td>
<td>CodeMeter License Server (runtime) – WebAdmin</td>
</tr>
<tr>
<td>11040</td>
<td>HTTP</td>
<td>Python editor server</td>
</tr>
</tbody>
</table>

### 6.2 Engineering software Automation Builder

#### 6.2.1 Introduction

ABB Automation Builder is the integrated software suite for machine builders and system integrators wanting to automate their machines and systems in a productive way. Combining the tools required for configuring, programming, debugging and maintaining automation projects from a common intuitive interface, Automation Builder addresses the largest single cost element of most of today’s industrial automation projects: software. ABB Automation Builder covers the engineering of ABB PLCs, Safety PLCs, control panels, drives, motion and robots.

```
Before starting Automation Builder configuration read the version specific information provided in the Automation Builder readme file. It describes new features and functions as well as workarounds on known problems. The readme file is stored in the installation directory of Automation Builder, however can be downloaded as well from ABB website http://new.abb.com/plc/automationbuilder.
```

#### 6.2.2 Automation Builder updates

An update notification dialog will be shown during Automation Builder startup in case there are any updates available for the installed version.

The user has the possibility to check for updates manually: “Help → Check for Updates”

☞ Chapter 4.8.3 “Execution of a hotfix” on page 151

#### 6.2.3 Use of open source components

ABB Automation Builder and AC500 V3 firmware are using open source components. A detailed overview of these open source components and the corresponding licenses are available from Automation Builder via “Help → About… → License Terms”.

There are separate lists available for Automation Builder and AC500 V3 firmware.

#### 6.2.4 Managing your licenses

##### 6.2.4.1 Identifying the installed license

The title bar of the Automation Builder shows the version and the license information (Basic, Standard or Premium).

Be aware of the following rule for this information:

The info in the title bar is taken in this order from the first found license.
- local licenses (on PC)
- on a dongle (USB key)
- network licenses

So if a local license is only basic and a dongle with premium license is inserted the functionality is premium (the highest available) but the information in the title bar is basic.

To check your installed licenses, the CodeMeter Control Center tool can be used.

\[\text{Chapter 6.2.4.3 “Checking licenses with “CodeMeter Control Center” on page 1352}\]

### 6.2.4.2 Selecting the license used on Automation Builder startup

You can select, which license the Automation Builder should use on startup.

To select which license should be used:

1. In the Automation Builder menu select “Tools ➔ Options”.
   - The “Options” window is opened.
2. In “Startup settings” under “License” select which license should be used.
   - Default: The most comprehensive available license will be selected
   - Use only local license: Network licenses will never be selected
   - Display licenses selection dialog if shared licenses are available: On every Automation Builder startup, you will be asked to select a license
3. To apply the setting select [OK].
6.2.4.3 Checking licenses with “CodeMeter Control Center”

1. Open the “CodeMeter Control Center” via the “Windows start menu ➔ CodeMeter ➔ CodeMeter Control Center”.

2. In the “CodeMeter Control Center” window you can see the different license “tickets” / “CmContainers” that are installed on your PC.

   To see more details, open the “CodeMeter WebAdmin” by selecting [WebAdmin]
3. Select “Container ➔ All Container”

⇒ Here the details of the license containers can be checked.

6.2.4.4 Setting dedicated network servers in search list

In case of a new installation CodeMeter will check for licenses also in the network. If there is a run-out or wrongly installed license found, the service is closed without any further hint. This looks like Automation Builder starts and closes after a few moments.

To set the search for licenses to your local machine only follow these steps:

1. Open the CodeMeter Control Center ➔ Chapter 6.2.4.3 “Checking licenses with “CodeMeter Control Center” on page 1352.

2. Open the CodeMeter WebAdmin by selecting [WebAdmin]

2024/01/05 3ADR010583, 1, en_US 1353
3. Select “Configuration ➔ Basic ➔ Server Search List”

4. Select “add new Server”
5. Enter "localhost" in the Server's names field
6. Select [Add]
7. Confirm by selecting [Apply]
   The "localhost" is added to the Server Search List

8. Restart the license check
9. Add more servers to the search list by entering the IP address or name of the license servers you know.

### 6.2.4.5 Restarting license check with a dongle bound license

In case of using a dongle bound license it might be necessary to restart the check for license on the PC, e.g. if the dongle was removed and reinserted.
1. Open the CodeMeter Control Center
   Chapter 6.2.4.3 “Checking licenses with “CodeMeter Control Center” on page 1352.

2. Select “Process ➔ Restart CodeMeter Service”

6.2.4.6 Removing trial license to remove expiring message

If an unlimited license is installed after having a trial license activated, the warning message for expiring date of the trial license still pops up at the Startup of the Automation Builder.

To avoid this message the trial license can be removed.

CAUTION!

– If you remove a license from your PC it will be permanently lost.
– Be aware that the trial license includes all premium functionalities, which will not be available any more if your unlimited license is not a premium license, e.g. standard.
1. Check for the Trial CmContainer number in CodeMeter WebAdmin Interface

2. Search CmContainer number in CodeMeter Control Center

3. Remove this selected license in CodeMeter Control Center

6.2.4.7 Network licenses

6.2.4.7.1 General

It allows sharing of licenses between team members, easy switchover between several workstations with a single license and allows centralized administration (ordering, registration, activation).

The Automation Builder License Manager and CodeMeter need to be used to configure the network server.

- In a typical office LAN (Local Area Network) setup on Client side the default settings of the Automation Builder (and CodeMeter) are sufficient to get the Network Licenses working.
- If an opened Automation Builder is losing contact to the network server (e.g. due to network problems) Automation Builder will prompt the user to restore the network. After 30 minutes without connection to the network server Automation Builder will fall back to basic edition. Opened editors for non-basic features stay open and usable. So your work will not be lost in case of troubles with the network.

Information on how to borrow and return a network license.

The network licenses can be used as of Automation Builder 1.2.0.

6.2.4.7.2 Setting up a network license

General

The following setup works in typical environments.
Configuring a network license server

- Network license must be registered.
- Automation Builder license must be activated.

1. Launch CodeMeter WebAdmin as described in chapter 'Managing your licenses' & Chapter 6.2.4 “Managing your licenses” on page 1350
2. Select “Configuration ➔ Server ➔ Server Access”

3. Enable Network Server
   Keep the default port settings. These should work in most cases.
4. Select [Apply]

5. For the changes to take effect, restart CodeMeter Control Center & Chapter 6.2.4.5 “Restarting license check with a dongle bound license” on page 1355
NOTICE!

- In case you want to control usage of network licenses please refer to chapter "View network server license usage" on page 1360.
- Activation keys for network licenses are valid for one network license each. This one license can be shared among many people but only one Automation Builder instance at the same time. If you want to run more than one Automation Builder instance at the same time you have to activate more than one network license. This means you have to purchase and enter more than one activation key (one per license).

Configuring the client side

The default settings of Automation Builder and the CodeMeter (on client side) are sufficient in most cases to get the network licenses working. In case of problems accessing the network license, please set the server search list on the client side.

6.2.4.7.3 View network server licenses

On the Network Server side you can find information on existing network licenses and their current allocation.
1. Launch CodeMeter WebAdmin ➔ Chapter 6.2.4.3 “Checking licenses with “CodeMeter Control Center”” on page 1352.

2. Select “License Monitoring ➔ All Licenses”

### Available Licenses on 'OVAEXPWIN10'

<table>
<thead>
<tr>
<th>Product Code</th>
<th>Name</th>
<th>Feature Map</th>
<th>License Quantity</th>
<th>User Limit (Reserved)</th>
<th>Re-User Limit</th>
<th>Exclusive</th>
<th>Shared</th>
<th>Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>R&amp;D unbonded license</td>
<td>998</td>
<td>0x3</td>
<td>1</td>
<td>0 (0)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>CSV Device Import Export</td>
<td>1006</td>
<td>0x3</td>
<td>1</td>
<td>0 (0)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>CSV/EI/Mapping Export</td>
<td>1001</td>
<td>0x3</td>
<td>1</td>
<td>0 (0)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>ECAD Import Export</td>
<td>1002</td>
<td>0x3</td>
<td>1</td>
<td>0 (0)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Project Compare</td>
<td>1004</td>
<td>0x3</td>
<td>1</td>
<td>0 (0)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Project Scripting</td>
<td>1005</td>
<td>0x3</td>
<td>1</td>
<td>0 (0)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Automation Builder Premium 2.x</td>
<td>1006</td>
<td>0x3</td>
<td>1</td>
<td>0 (0)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>-</td>
<td>1011</td>
<td>0x3</td>
<td>1</td>
<td>0 (0)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>-</td>
<td>1012</td>
<td>0x3</td>
<td>1</td>
<td>0 (0)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>-</td>
<td>1013</td>
<td>0x3</td>
<td>1</td>
<td>0 (0)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
</tbody>
</table>

6.2.4.74 View network server license usage

1. Launch CodeMeter WebAdmin ➔ Chapter 6.2.4.3 “Checking licenses with “CodeMeter Control Center”” on page 1352.

2. Select “License Monitoring ➔ Sessions”

### Sessions

<table>
<thead>
<tr>
<th>Client</th>
<th>Firm Name</th>
<th>Product Item</th>
<th>Access Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>localhost</td>
<td>ABB R&amp;D non-bind License</td>
<td>128-17149289</td>
<td>Station Share</td>
</tr>
<tr>
<td>localhost</td>
<td>ABB R&amp;D non-bind License</td>
<td>128-17149289</td>
<td>Station Share</td>
</tr>
<tr>
<td>localhost</td>
<td>ABB R&amp;D non-bind License</td>
<td>128-17149289</td>
<td>Station Share</td>
</tr>
<tr>
<td>localhost</td>
<td>ABB R&amp;D non-bind License</td>
<td>128-17149289</td>
<td>Station Share</td>
</tr>
<tr>
<td>localhost</td>
<td>ABB R&amp;D non-bind License</td>
<td>128-17149289</td>
<td>Station Share</td>
</tr>
<tr>
<td>localhost</td>
<td>ABB R&amp;D non-bind License</td>
<td>128-17149289</td>
<td>Station Share</td>
</tr>
<tr>
<td>localhost</td>
<td>ABB R&amp;D non-bind License</td>
<td>128-17149289</td>
<td>Station Share</td>
</tr>
<tr>
<td>localhost</td>
<td>ABB R&amp;D non-bind License</td>
<td>128-17149289</td>
<td>Station Share</td>
</tr>
<tr>
<td>localhost</td>
<td>ABB R&amp;D non-bind License</td>
<td>128-17149289</td>
<td>Station Share</td>
</tr>
<tr>
<td>localhost</td>
<td>ABB R&amp;D non-bind License</td>
<td>128-17149289</td>
<td>Station Share</td>
</tr>
<tr>
<td>localhost</td>
<td>ABB R&amp;D non-bind License</td>
<td>128-17149289</td>
<td>Station Share</td>
</tr>
<tr>
<td>localhost</td>
<td>ABB R&amp;D non-bind License</td>
<td>128-17149289</td>
<td>Station Share</td>
</tr>
<tr>
<td>localhost</td>
<td>ABB R&amp;D non-bind License</td>
<td>128-17149289</td>
<td>Station Share</td>
</tr>
</tbody>
</table>
6.2.4.7.5 Controlling network server license usage

On the Network Server side you can define settings managing the client access to CodeMeter License Server on a network.

1. Launch CodeMeter WebAdmin \(\rightarrow\) Chapter 6.2.4.3 “Checking licenses with “CodeMeter Control Center”’ on page 1352.

2. Select “Configuration \(\rightarrow\) Server \(\rightarrow\) Server Access”

3. Add entries of PCs you want to share licenses with by adding client computers and IP addresses for accessing CodeMeter License Server on a network.
6.2.4.8 License borrowing manager

6.2.4.8.1 Introduction

The license borrowing manager allows you to borrow a network license for offline use and return it.

The license borrowing manager is not part of the default software distribution, but will be handed out on request.

The license borrowing manager is supported as of Automation Builder 2.2.3.

6.2.4.8.2 Borrowing a network license

- Network access to the license server required.
- Opened the license borrowing manager.

1. Select the license you want to borrow.

2. Select [Borrow License].

3. Select the target CmContainer.

   Alternatively a new CmContainer can be created.

4. Select the end of the borrowing period.
5. Select [Ok].

- The license has successfully been borrowed.
- The list of available licenses has been updated.

6.2.4.8.3 Returning a network license

Automatic return of a license

Network licenses will be returned automatically after the expiration of the maximum borrowing period. No licenses server access is required.
Manual return of a network license

- Network access to the license server required.
- Opened the license borrowing manager.
  1. Select a borrowed license.

2. Select [Return License]
   - The license has successfully been returned.

6.2.4.9 Transferring an Automation Builder license

6.2.4.9.1 General

- It is possible to transfer normal licenses from a PC to another PC or dongle (DM-Key).
- This is not possible for ABB internal or temporary licenses, e.g. the 30 day Trial license.
- The process consists of two main steps:
  1. Return the actual license from the actual PC
  2. Reactivate the license on the new PC

6.2.4.9.2 Getting activation code

- For all license transfer processes the activation code is required. It is available from the license paper from purchasing the license.
- For Automation Builder licenses purchased April 2020 or later, the activation code is available from the activated license:
1. Open CodeMeter Control Center and navigate to the [WebAdmin].

2. Identify the right product code.
   Automation Builder editions consist of multiple product codes. The activation ID is available from the product code containing the edition name, e.g. "Automation Builder Standard".

3. Select product code to access the product code details. Under “License Information” you can find the activation code.
6.2.4.9.3 Returning an Automation Builder license

- You need the License Activation code of the license you want to return.
- Go to the following website: http://lc.codemeter.com/32838/depot-return/index.php

  The website is also available through the Automation Builder menu under "Help ➔ Return of Automation Builder license".

- Insert your Activation code in the field "Ticket"
- Select [Next]
4. Select [Re-Host License]

If the CmContainer is found, continue with Online licenses transfer  Chapter 6.2.4.9.4 “Online license transfer” on page 1367

If the CmContainer is not found, continue with Offline license transfer  Chapter 6.2.4.9.5 “Offline license transfer” on page 1369

6.2.4.9.4 Online license transfer

- Wait till the CmContainer is found, then select [Deactivate Selected License Now]
Re-Hostable Licenses

To re-host licenses from one CrmContainer to another CrmContainer:
1. Make sure that the CrmContainer with Serial 128-1765656 is connected to the computer. If this CrmContainer is not connected to the computer, connect it now and click "Reassign to CrmContainer".
2. Select the licenses you want to re-host.
3. Click "Deactivate Selected Licenses Now".
4. After the successful deactivation of the selected licenses, you can activate them again in another CrmContainer.

<table>
<thead>
<tr>
<th>Name</th>
<th>Activated On</th>
<th>CrmContainer</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMGO01-TOOL – Standard license</td>
<td>2021-06-28 14:32:30</td>
<td>128-1765656</td>
<td>Activated</td>
</tr>
</tbody>
</table>

Deactivate Selected Licenses Now

Online License Transfer

Starting license transfer.
Creating license request.
Downloading license update.
Importing license update to CrmContainer.
Creating receipt.
Uploading receipt.

License transfer completed successfully!

OK
6.2.4.9.5 Offline license transfer

If the CmContainer is not found on this PC, select “file-based license transfer” workflow.

The following dialog opens

The instructions will lead you through the main steps of the offline license transfer:
1. On the offline PC open the CodeMeter Control Center.
2. Select [License Update].

The CmFAS Assistant opens.

3. Select “Create a license request file”.
4. Select a location to store the license request file.
5. Transfer the license request file from the offline PC to an online PC.

Please select the desired action

- **Create license request**: Choose this option if you want to create a license request file in order to send it to the vendor of the software.
- **Import license update**: Choose this option if you received a license update file from the software vendor and want to import this file.
- **Create receipt**: Choose this option if you want to confirm the successful import of a license update file for the software vendor.
6. On the online PC choose the license request file and select [Upload Request And Continue Now].

7. Select [Download License Update File Now].
8. Save the license update file to a location on your computer.
9. Transfer the license update file from the online PC to the offline PC.
10. On the offline PC open the CmFAS Assistant.
11. Select "Import license update".
12. Select the license update file, to import the new license to the offline PC.
13. To confirm a successful license transfer return to the online PC and select [Next].

14. On the offline PC open the CmFAS Assistant.

15. Select “Create receipt”.

The last dialog is opened.
16. Choose a location to save the license receipt file.

17. Transfer the license receipt file from the offline PC to the online PC.
18. On the online PC choose the license receipt file and select [Upload Receipt Now].

After a successful license transfer you will receive the following message:

6.2.4.9.6 Return of unconfirmed license

If customers do not complete the offline activation process by uploading the receipt file, they won't be able to return the license. However, working with Automation Builder is possible. When the customer tries to return the license, they will see that the license is available, but they won't be able to rehost the license because the button is not visible. The only way to proceed here is to either create a receipt file from “CodeMeter” and upload it, or contact ABB Support who will manually confirm the activation after reviewing the “CmDust”.

Below are the steps to enable the “Re-Host” button again.

Initial situation: No [Re-Host Licenses] button is visible in the “CodeMeter License Central WebDepot”.
1. Open the “CodeMeter Control Center” on the PC.
2. Select the correct container under the “License” tab so that it is grayed out.
3. Click the [License Update] button.

! The “CmFAS Assistant” opens.

4. Click the [Next >] button.
5. In the window which appears, select the option [Create receipt].

6. Click the [Next >] button.

7. Select a file name for storing the receipt file.
8. Click the [Commit] button.

9. Click the [Finish] button.

10. Open the CodeMeter License Central WebDepot

11. Click on the [Upload activation receipt] button.
12. Click the [Choose File] button and select the receipt file that has just been created by “CodeMeter”. A new window will open.

13. Click the [Upload activation receipt] button and wait for the success message.
14. Go again to the return WebDepot and try to return license. Now the [Re-Host Licenses] button is visible.

6.2.4.10 Generating license information file for support
To create a license information file which includes all license information for the support:
1. Select “Windows start menu ➔ CodeMeter ➔ Tools ➔ CmDust”.
   ➔ The explorer window opens and shows the folder where the created log file CmDust-Result.log is stored.
2. Please attach this file to any support request regarding your licenses.

6.2.4.11 Generating log files for support
Sometimes more detailed log files are needed to analyse a situation.
Then please also zip the following folder and attach it to your support request.
C:\ProgramData\CodeMeter\Logs
This folder includes
- CmActDiagLogyyyy-mm-dd-hhmmss.log
- CodeMeteryyyy-mm-dd-hhmmss.log
To make it easier to distinguish when the files were created, they are named as follows:
- yyyy – year, mm – month, hh – hour; mm – minutes, ss – seconds.

6.2.4.12 Further information
For more information about the installation and activation of the Automation Builder see:
Automation Builder Installation and Activation

6.2.5 Setting up of communication parameters in Windows
Setting up of communication parameters
To set up the communication between the PC and the PLC, e.g., for downloading the compiled program, you have to set up the communication parameters.
The IP address of your PC must be in the same class as the IP address of the CPU.
The factory setting of the IP address of the CPU is 192.168.0.10.
The IP address of your PC should be 192.168.0.X. Avoid X = 10 in order to prevent an IP conflict with the CPU.
Subnet mask should be 255.255.255.0.
Changing of the IP address

1. Open Windows control panel. Click “Network and Internet ➔ Network and Sharing Center”.
2. Click “Change adapter settings”.
   
   If using existing network with several devices, please pay attention on given network rules or contact your system administrator.

3. Right-click “Local Area Connection (Ethernet)” and select [Properties].

5. Enter your desired IP address and subnet mask.

6.2.6 **Version information**

Information on the installed Automation Builder version such as installed packages or license terms can be found in menu “Help ➤ About”.
6.2.7 PLC runtime and demo licensing

The use of some libraries and devices require the PLC to have a runtime license. Further it is possible to try out device features or library features by using a demo license © Chapter 6.3.2.2.2 “PLC runtime licensing” on page 1446.

6.2.8 Create log files for support

If a problem persists, contact ABB technical support. In order to be able to solve your problem as soon as possible, please provide the affected Automation Builder project or Panel Builder project, the log files and the firmware versions. How to read out log files is described in the application note How to get log information.
6.2.9 Menues, views, windows

6.2.9.1 Display settings

Ensure the full display of Automation Builder editors by choosing the option “Smaller - 100 % (default)” in “Start ➔ Control Panel ➔ Appearance and Personalization ➔ Display”.

6.2.9.2 Start page and menus

After start-up of Automation Builder software the start page is displayed.

All items of the Automation Builder user interface are described in the CODESYS documentation:
6.2.9.3 “All Messages” window

Errors, warning and success messages are written to the “All messages” window:

![Image of the "All Messages" window]

6.2.10 Device repository

The Device Repository of Automation Builder manages the pool of devices that can be used in the PLC configuration.

You install or uninstall devices in the “Device Repository” dialog box. The system installs a device by reading the device description files, which define the device properties for configurability, programmability, and possible connections to other devices.

You can use the devices provided in the device repository by adding them to the device tree of your project.
1. Click “Tools ➔ Device Repository”.
   ⇨ The “Device Repository” dialog box opens.

[Edit Locations]: Changes the default repository location. The devices can be managed at different locations.

[Install] / [Uninstall]: Installs or uninstalls devices.

[Renew device repository]: Updates the device list, e.g. after uninstallation of a device.

[Details]: Provides technical details on the selected device.

2. Select the install location. “System Repository” is set by default.
1. Click [Install] and select the appropriate file format.
   ⇒ The “Install Device Description” dialog box opens.

2. Select the file path of the device description.

3. Select the file type filter of the required device description.
   ⇒ All device descriptions of the selected file type are listed.

4. Select the required device description and click [Open].
   ⇒ Automation Builder adds the device description to the matching category of your device repository.
      If errors occur during installation (for example, missing files that are referenced by the device description), then Automation Builder displays them in the lower part of the “Device Repository” dialog box.

During the installation the device description files and all additional files referenced by that description will be copied to an internal location. Altering the original files will have no further effects to an internal location.

The changes take only effect after reinstalling the corresponding device(s). The version number shown in the information section of the device should be verified.

Uninstalling devices
Select the device you want to remove and click [Uninstall].
The device is removed from the list.

Uninstalled devices which are used in existing projects are indicated by the symbol 🚨. The device will not be configured properly.
### 6.2.11 Creating and configuring projects

#### What is a project?

- A project contains the objects which are necessary to create a controller program ("application"):
  - Pure POUs, for example programs, function blocks, functions, and GVLs.
  - Objects that are also required to be able to run the application on a PLC. For example, task configuration, Library Manager, symbol configuration, device configuration, visualizations, and external files.
- In a project, you can program multiple applications and connect multiple controller devices.
- CODESYS manages device-specific and application-specific POUs in the "Devices" view ("device tree") and project-wide POUs in the "POUs" view.
- For the creation of projects, there are templates that already contain certain objects.
- Basic configurations and information for the project are defined in the "Project Settings" and "Project Information". For example:
  - Compiler settings
  - User management
  - Author
  - Data about the project file

There are settings for the version compatibility of the project in the configuration dialogs in the "Project Environment".
- You save a project as a file in the file system. As an option, you can pack it together with project-relevant files and information into a project archive. It is also possible to save files in a source code management system such as SVN.
- Each project contains the information about the CODESYS version with which it was created. When you open it in another version, CODESYS will notify you about possible or necessary updates regarding file format, library versions, etc.
- You can compare, import/export projects, and create documentation for them.
- You can protect a project from being changed, or even completely protect it from being read. By using user management, you can selectively control the access to the project and even to individual objects in the project.

- Chapter 6.4.1.21.2.2 “Object ‘Application’” on page 2410
- Chapter 6.4.1.21.2 “Objects” on page 2409
- Chapter 6.4.1.21.4 “Dialogs” on page 2745
- Chapter 6.4.1.21.3.5.13 “Command ‘Project information’” on page 2604
- Chapter 6.4.1.6 “Protecting and Saving Projects” on page 1819

#### Auto generated files

When creating, saving or exporting, files may be created and their extensions are briefly listed here for better understanding. Some of the files are generated when you login for the first time to the PLC and the boot application is created. The list does not claim to be complete.

<table>
<thead>
<tr>
<th>File extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*.opt</td>
<td>Project specific options.</td>
</tr>
<tr>
<td>*.bootinfo</td>
<td>Will be created during boot project creation.</td>
</tr>
<tr>
<td>*.bootinfo_guids</td>
<td>Contains the CRC of the bootinfo.</td>
</tr>
<tr>
<td>*.crc</td>
<td>Checksum of the boot application.</td>
</tr>
</tbody>
</table>
Handling of AC500 projects such as project creation, export/import, comparison of projects etc. is described in the sections for AC500 V3 products.

☞ Chapter 6.3.1.1 “Project handling” on page 1398

### 6.2.12 Handling of AC500 projects

Handling of AC500 projects such as project creation, export/import, comparison of projects etc. is described in the sections for AC500 V3 products.

☞ Chapter 6.3.1.1 “Project handling” on page 1398

Copy-and-paste from one project to another project in two different Automation Builder instances is possible. After copying parts of a project to a higher Automation Builder version the copied components have to be updated.

- It is not possible to downgrade a project to an earlier Automation Builder version.
- Import of export files is only allowed in the same profile version.
- Copy-and-paste of configurations must not be used to copy objects to an earlier version.
- Automation Builder performs an integrity check for the PLC configuration before generating the configuration.

### Project archive

Automation Builder supports the creation and the import of project archive files. Archive files contain all relevant project data including the PLC configuration, the CODESYS project files and all device descriptions. This allows exchanging Automation Builder projects without taking care of the target environment General Settings.

☞ Chapter 6.3.1 “General settings” on page 1398
User and access rights of a project

The 'User Management' provides functions for defining user accounts and configure the access rights within a project. The rights to access project objects via specified actions are assigned only to user groups, not to a single user account. So each user must be member of a group General Settings.  

6.2.13 Connection of devices

6.2.13.1 Configuring devices

All installed devices that are available in Automation Builder are listed in the device repository.

Modify your Automation Builder project by adding device objects. Preset items can be replaced in the same way.

1. In the device tree, right-click an item node. Select [Add object].

2. Select the desired object and click [Add object].

3. Double-click the new object in the device tree to configure the device settings. Depending on the selected item different configuration tabs are available.
6.2.13.2 Symbolic names for variables, inputs and outputs

The IEC naming rules are not checked during input in Automation Builder.

Input and output mapping

Devices with I/Os provide an “I/O Mapping” tab in their configuration editor where the available I/O channels can directly be mapped to a global variable.

The corresponding variable declarations are automatically available in the project.

All available I/O channels can easily be assigned to a variable.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Mapping</th>
<th>Channel</th>
<th>Address</th>
<th>Type</th>
<th>Default Value</th>
<th>Unit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>b_Input_1B0</td>
<td></td>
<td>Digital inputs 10 - 17</td>
<td>%I0</td>
<td>BYTE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x_Input1B0</td>
<td></td>
<td>Digital input 10</td>
<td>%D0,0</td>
<td>BOOL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x_Input1B1</td>
<td></td>
<td>Digital input 11</td>
<td>%D0,1</td>
<td>BOOL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x_Input1B2</td>
<td></td>
<td>Digital input 12</td>
<td>%D0,2</td>
<td>BOOL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x_Input1B3</td>
<td></td>
<td>Digital input 13</td>
<td>%D0,3</td>
<td>BOOL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x_Input1B4</td>
<td></td>
<td>Digital input 14</td>
<td>%D0,4</td>
<td>BOOL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x_Input1B5</td>
<td></td>
<td>Digital input 15</td>
<td>%D0,5</td>
<td>BOOL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x_Input1B6</td>
<td></td>
<td>Digital input 16</td>
<td>%D0,6</td>
<td>BOOL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x_Input1B7</td>
<td></td>
<td>Digital input 17</td>
<td>%D0,7</td>
<td>BOOL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast counter</td>
<td></td>
<td>Digital inputs 18 - 115</td>
<td>%I81</td>
<td>BYTE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Digital inputs 116 - 125</td>
<td>%I82</td>
<td>BYTE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Digital inputs 124 - 131</td>
<td>%I83</td>
<td>BYTE</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

AC500 uses Intel Byte Order (Little Endian).

Only entries with a data type set in column “Type” can be mapped. These entries can be expanded to show the available I/O channels.

If the project has been imported from a previous Automation Builder version, all variables should be checked to avoid inconsistencies concerning the I/O mapping.

6.2.13.3 Update of AC500 devices

Perform a firmware update to update AC500 V3 devices. ⇕ Chapter 6.3.1.4.3 “Installation and update of the AC500 V3 firmware” on page 1422

6.2.13.4 Comparing objects

To compare similar objects within a project (such as the project configuration) select both objects. Right-click and select “Compare Objects” to see the differences.
6.2.14 Connection of serial interfaces

Depending on the device type, the configuration of serial interfaces is different.

☞ Chapter 6.3.2.14 “Serial interface” on page 1586

6.2.15 Converting an AC500 V2 project to an AC500 V3 project

Application example

A project that has been configured for an AC500 V2 PLC can be converted to a project for an AC500 V3 PLC. Essentially, the conversion is done in Automation Builder, however, some additional actions have to be executed manually. The complete conversion procedure of a V2 project to a V3 project is described in the application note Converting an AC500 V2 project to an AC500 V3 project.
6.2.16 Automation Builder installation manager

6.2.16.1 Introduction

Automation Builder installation manager allows you to install customer specific software packages, modify the existing installation, update installation information and to uninstall Automation Builder software packages in a comfortable and flexible way.

You can launch installation manager from the main menu of Automation Builder, “Tools → Installation Manager”, or from Windows start menu.

Installation manager starts.

Uninstall all Uninstalls the currently installed Automation Builder software. ✓ Chapter 6.2.16.5 “Uninstalling Automation Builder” on page 1397
Install Package Installs customer specific software packages. ✓ Chapter 6.2.16.2 “Installing customer specific package” on page 1395
Modify Adds or removes installed software packages. ✓ Chapter 6.2.16.3 “Adding or removing installed software packages” on page 1396
Info Export Exports detailed information of installed packages in a notepad.
Check for new service release Checks if your installed version of Automation Builder is up to date and checks for updates. ✓ Chapter 6.2.16.4 “Checking for updates” on page 1396

6.2.16.2 Installing customer specific package

Installation manager allows you to install customer specific software packages (CABPKG files). These packages are separately distributed to the customer based on the customer requirement.
1. In the installation manager, click **[Install Package]**.
2. Select the package to be installed (.cabpkg file) from the file system.
3. Select the components to be installed.
4. Click **[Install]**.
   - Data installation starts.
5. Successfully installed components are indicated with ![Check](https://example.com/check.png).
   Errors during data download are indicated with ![Error](https://example.com/error.png). Errors during download of any package component aborts the installation. In this case click “Show Log” and save the log data. Send the log file to ABB support team.
   Click **[Finish]** to end the wizard.

### 6.2.16.3 Adding or removing installed software packages

1. In the installation manager, click “**Modify**”.
   - The selection page opens.
   - The selected software packages are installed already.
   - The not selected software packages are not installed.
2. Select the software packages you want to install.
   Unselect the software packages you want to uninstall.
   ```
   You cannot unselect the main Automation Builder software package.
   ```
3. Click “**Continue**”.
   - First, the unselected software packages will uninstall.
   - Afterwards, the new selected software packages will be downloaded and installed.
4. Successfully downloaded components are indicated with ![Check](https://example.com/check.png).
   Errors during data download are indicated with ![Error](https://example.com/error.png). Errors during download of any package component aborts the installation. In this case click “Show Log” and save the log data. Send the log file to ABB support team.
   Click **[Finish]** to end the wizard.

### 6.2.16.4 Checking for updates

- In the installation manager, click “**Check for new service release**”.
- If a newer Automation Builder version is available, you will get an option to download and install the new version.

Create a project archive before upgrading Automation Builder. Project archives contain all project data, including data that is not stored with a *.project file, e.g. device description files for third party devices.

[Chapter 6.3.1.1.8.2 “Creation of an archive” on page 1408](#)
6.2.16.5 Uninstalling Automation Builder

Installation manager offers a comfortable way to uninstall the Automation Builder software. This will uninstall all related packages of Automation Builder platform as well, such as Mint Plug-in, Automation Builder Extensions, Drive Manager etc.

1. In the installation manager, click [Uninstall all].
   - A warning message is displayed to uninstall Automation Builder software.
     Click [Yes] to continue.

2. If Automation Builder instances are running, a warning message is displayed.
   Close running instances of Automation Builder and click [Retry] to continue uninstallation.
   With [Abort] uninstallation of the current package is stopped. Uninstallation is continued with the next package. With [Ignore], uninstallation is forced. As this can lead to an erroneous uninstallation, we recommend you, not to use this option.

3. If installation manager was launched with “Tools ➤ Installation Manager”, the following message is displayed as Automation Builder is still running:
   With [Yes] Automation Builder software is closed to continue uninstallation procedure.
   With [No] uninstallation of the current package is stopped. Uninstallation is continued with the next package.

4. For each of the packages being uninstalled, system may prompt to continue uninstallation.
5. Successfully uninstalled components are indicated with ![Icon](image).
   Errors during uninstallation are indicated with ![Icon](image). Errors during uninstallation of any package component aborts the uninstallation. In this case click “Show Log” and save the log data. Send the log file to ABB support team.
   Click [Finish] to end the wizard.
6.3 Configuration in Automation Builder for AC500 V3 products

6.3.1 General settings

6.3.1.1 Project handling

6.3.1.1.1 General

What is a project?

- A project contains the objects which are necessary to create a controller program ("application"): 
  - Pure POUs, for example programs, function blocks, functions, and GVLs.
  - Objects that are also required to be able to run the application on a PLC. For example, task configuration, Library Manager, symbol configuration, device configuration, visualizations, and external files.
- In a project, you can program multiple applications and connect multiple controller devices.
- CODESYS manages device-specific and application-specific POUs in the “Devices” view (“device tree”) and project-wide POUs in the “POUs” view.
- For the creation of projects, there are templates that already contain certain objects.
- Basic configurations and information for the project are defined in the “Project Settings” and “Project Information”. For example:
  - Compiler settings
  - User management
  - Author
  - Data about the project file

There are settings for the version compatibility of the project in the configuration dialogs in the “Project Environment”.

- You save a project as a file in the file system. As an option, you can pack it together with project-relevant files and information into a project archive. It is also possible to save files in a source code management system such as SVN.
- Each project contains the information about the CODESYS version with which it was created. When you open it in another version, CODESYS will notify you about possible or necessary updates regarding file format, library versions, etc.
- You can compare, import/export projects, and create documentation for them.
- You can protect a project from being changed, or even completely protect it from being read. By using user management, you can selectively control the access to the project and even to individual objects in the project.

Additional information:

- Chapter 6.4.1.21.2.2 “Object ‘Application’” on page 2410
- Chapter 6.4.1.21.2 “Objects” on page 2409
- Chapter 6.4.1.21.4 “Dialogs” on page 2745
- Chapter 6.4.1.21.3.5.13 “Command ‘Project information’” on page 2604
- Chapter 6.4.1.6 “Protecting and Saving Projects” on page 1819

6.3.1.2 Creating a new project

1. Select “File ➔ New Project”.
2. Select “AC500 project”, enter a project name and specify the storage location for the new project.

   With “Empty project” a project without a PLC is created.
3. Select the device type for the new project and click [Add object].

A new project is created and can be configured.

6.3.1.3 Opening an existing project

**NOTICE!**
Risk of damaging Automation Builder projects!
Projects created with Automation Builder are incompatible with CODESYS V2.3.9.x. Do not open projects with CODESYS V2.3.9.x as this can cause corrupted Automation Builder projects.

Automation Builder performs an integrity check for the PLC configuration before generating the configuration.
Opening a project

1. Select “File ➔ Open Project”.
   ➔ The “Open Project” dialog appears.
2. Select a previously saved project from the file system.
   ➔ Automation Builder switches to the version of the project and opens the project.

6.3.1.1.4 Exporting and importing a project

Configuration of a complete PLC or of single devices can be reused within the same project by copy-and-paste the desired nodes in the device tree.

In order to reuse a PLC configuration cross-over projects, the project configuration can be exported and imported afterwards into another project.

An exported project configuration can only be imported to a project with the same Automation Builder version. If the versions are not the same, the import fails with an error message.

Automation Builder performs an integrity check for the PLC configuration before generating the configuration.

Project export

From the menu, select “Project ➔ Export ➔ Project”. Select the objects to be exported. The configuration of the selected items will be added to an export file (*.export).

“One file per subtree”: If this option is activated, all objects belonging to the same subtree will be exported into the same export file, otherwise a separate file will be created for each particular object.
**Project import**

For importing a project a basic and an advanced function is available.

*“Basic project import”:* Users with a basic or a standard Automation Builder license can perform a basic project import. Command: *“Project ➔ Import ➔ Project”.*

A previously exported project configuration is imported into the current project. With this, the current project configuration is overwritten.

In order to supplement the current project with the project configuration of a previously exported project, use the compare function. Command: *“Project ➔ Compare”.*

☞ Chapter 6.3.1.1.7 “Comparing projects” on page 1405

*“Advanced project import”:* Users with a premium Automation Builder license can perform an advanced project import. Command: *“Project ➔ Import ➔ Project with compare”*. This command allows to compare two projects, to check on differences and to adapt single parts of the project configuration easily.

**Basic project import**

1. From the menu, select *“Project ➔ Import ➔ Project”*.  

A previously exported project configuration is imported into the current project. With this, the current project configuration is overwritten.

In order to supplement the current project with the project configuration of a previously exported project, use the compare function. Command: *“Project ➔ Compare”*.  

☞ Chapter 6.3.1.1.7 “Comparing projects” on page 1405

2. Select the export file from the file system and click *[Open]* to import the project configuration.

*An exported project configuration can only be imported to a project with the same Automation Builder version. If the versions are not the same, the import fails with an error message.*

**Advanced project import**

Perform an advanced project import in order to compare two projects, to check on differences and to adapt single parts of a previously exported project configuration easily.

1. From the menu, select *“Project ➔ Import ➔ Project with compare”*.  

2. Select the export file from the file system and click *[Open]* to import the project configuration.  

☞ The project import is started.
3. Once the project file is imported, a compare view is displayed. The left pane represents the current project, the right pane represents the imported project.

Differences between the current project and the imported project are highlighted in red color.

Additional modules in the current project that are not available in the imported project are highlighted in green color.

Additional modules in the the imported project or deleted modules in the current project are highlighted in blue color.

A summary of all differences within the projects is given in the “Comparison statistics” under the device tree.

4. Every highlighted item of both projects can be handled individually and can either be transferred to the current project or skipped.

- **[Accept Block]**: All items of the selected node are transferred to the current project with one click. Use this function for example to copy all nodes of a PLC configuration from the imported project to the current project (select “I/O_Bus” node).

- **[Accept Single]**: Only a single item from a node is transferred to the current project. Use this function for example to copy certain I/O modules from the imported project to the current project.

All accepted items are highlighted in the current project in yellow color.

To undo a selection, again, click [Accept Block] or [Accept Single].

To accept all changes on the current project, close the “Project Comparison - Differences” tab and confirm the prompted dialog.
5. If in the import project the PLC contains an AC500-S safety module, a security check is performed which requires user authentication:

![Logon window](image)

6. After a successful user authentication the AC500-S safety modules are added to the compare view and can be imported to the current project.

![AC500-S safety modules](image)

### 6.3.1.1.5 Upgrade a project to a new Automation Builder version or profile

With the Automation Builder version 2.6.0 a side-by-side installation is possible, i.e. any Automation Builder versions can be installed in parallel.

Automation Builder 2.5 or a lower version can be installed for access to all required previous versions.

When updating the Automation Builder version, a previously configured project must be converted in order to be used in a new Automation Builder version.

1. Create a project archive before upgrading Automation Builder. Project archives contain all project data, including data that is not stored with a ".project" file, e.g. device description files for third party devices.

   Chapter 6.3.1.1.8.2 “Creation of an archive” on page 1408

   “File ➔ Project Archive ➔ Save/Send Archive...”
2. Use the Automation Builder update notification to initiate the software update.
   \(\Rightarrow\) Chapter 6.2.2 “Automation Builder updates” on page 1350
   or:

3. Download the file from the PLC website - all versions of the Automation Builder are available.

4. Install the new Automation Builder and follow the instructions.

5. Open a previously configured project.
   \(\Rightarrow\) Automation Builder performs an integrity check for the PLC configuration before generating the configuration.
   Automatically a window appears with the request to upgrade the project.

6. Click the [OK] button.
   \(\Rightarrow\) During the project upgrade, an option for migration of third party devices can be selected.
7. Click the [OK] button to upgrade third party devices. If this option was not selected during the upgrade procedure, migration can be initiated manually after an Automation Builder upgrade in order to migrate all third party devices to the project.

☞ Chapter 6.3.1.5 “Migration of third party devices” on page 1439

8. The firmware of the communication interface modules will not automatically be upgraded. You can do this with the IP configuration tool. For this, the IP configuration tool must be used as stand-alone variant.

Follow the instructions for the firmware upgrade for communication interface modules.

☞ Chapter 6.3.2.4.3.2 “Stand-alone installation” on page 1457

**Application example**

A project that has been configured for an AC500 V2 PLC can be converted to a project for an AC500 V3 PLC. Essentially, the conversion is done in Automation Builder, however, some additional actions have to be executed manually. The complete conversion procedure of a V2 project to a V3 project is described in the application note

_Converting an AC500 V2 project to an AC500 V3 project_.

---

It is not possible to downgrade a project to an earlier Automation Builder version.

### 6.3.1.6 I/O mapping export and import

**Export I/O mapping**

To exchange information on I/O mapping only, data can be exported as .csv file. This allows maintenance of I/O data outside Automation Builder, e.g. in MS Excel.

Right-click the “Processor Module” node or “I/O_Bus” node in the device tree and select “Export -> I/O mapping”. To export the I/O Mapping for the complete project, e.g. with more than one configured processor modules, I/O data of the complete project can be exported “Project -> Export -> I/O mapping”.

**Import I/O mapping**

A previously exported .csv file can be imported to the project: “Project -> Import -> I/O mapping”.

### 6.3.1.7 Comparing projects

**Introduction**

You can compare the currently open project with another project – a reference project. The differences in contents, properties, or access rights are detected and shown in a comparison view.

**Application example**

_How to compare Automation Builder projects for an AC500 V3 PLC is described in the application note Project Comparison - Compare AC500 Projects and Integrate the Differences._
Clicking “Project ➔ Compare” opens the “Project Compare” dialog for you to configure and run the comparison. Then the result is shown in the comparison view “Project Compare – Differences” where the objects are aligned in a tree structure. Objects that indicate differences from the respective reference object are identified by colors and symbols. This is how you detect whether or not the contents, properties, or access rights are different.

For differences in the contents, you can also open the detailed compare view “Project Compare - <object name> Differences” in order to zoom into the object. In the detailed compare view, the contents of the object and reference object are displayed or their source code aligned. The detected differences are marked. Previously opened views are not closed. In this way, you can have any number of comparison views open and read them, in addition to the project compare view.

You can accept the detected differences from the reference project into the current project. This is possible only from the reference project into the open project. To do this, you activate differences (for example in the code) that should be accepted in the current project with the commands ✅, ✗, or ✖ in the active comparison view for accepting. These positions are highlighted in yellow. Make sure that any other open compare views are inactive (write-protected, read-only). Therefore, you can activate differences to be accepted in exactly one comparison view only. When exiting the active compare view, if you confirm that the differences that are activated for acceptance are actually accepted into the current project, then the current project is modified.

In order to exit the project comparison completely, close the project compare view.

Creating a comparison view

Requirement: You have made changes in your current project and wish, for example, to compare it with the last-saved version. In the meantime, for example, you have added further POUs, removed a POU, changed single lines of code or the object properties in function blocks.

1. Select the command “Project ➔ Compare”.
   ➔ The “Project Comparison” dialog box opens.
2. Enter the path to the reference project, for example the path to the last-saved version of your current project.
3. Leave the activation of the comparison option “Ignore Spaces” as it is.
4. Click on “OK”.
   ➔ The comparison view opens. Title: “Project Comparison – Differences”. The Device trees of the current project and the reference project are displayed alongside each other and the changed objects are marked in color.
5. Select an object marked in blue in the tree of the reference project (right). The current project no longer contains this object.
   Click on ✅ “Accept Single”
   ➔ The object is added to the tree of the current project (left). The line has a yellow background. ✅ appears in the middle column.
6. Select an object marked in green in the tree of the current project (left). The reference project does not contain this object.
   Click on ✗ “Accept Single”
   ➔ The object is removed again from the tree of the current project (left). The line has a yellow background. ❌ appears in the middle column.
7. If changes are detected in the content of an object that is contained in both the current project and the reference project, this is indicated by red lettering. You can then switch to the detailed comparison view for the object by double-clicking on the object.
8. Close the comparison view and answer the query whether the changes made are to be saved with “Yes”.
   ➔ The changes become effective in the project.
Opening the detailed compare view

Requirement: For example, a user modified the code in a POU of the current project. You have performed the project comparison by clicking “Project ➔ Compare”. The project compare view shows this POU highlighted in red in the aligned in the project tree.

1. Double-click the line of the aligned POU versions.
   ⇒ The compare view switches to the detailed compare view of the POU. The modified code lines are highlighted in gray and written in red.
2. Click .
   ⇒ Code lines with changes (red) are extended by two lines: an line with insert (left, green) and a line with delete (right, blue).
3. Click  again.
   ⇒ The code line is marked again as modified.
4. Move the mouse pointer to the code line marked as modified and click “Accept Single”.
   ⇒ The code line from the reference project is activated for acceptance into the current project.
5. Click .
   ⇒ The project compare view opens for the entire project. It is write-protected (read-only) to prevent you from activating differences for acceptance. The link highlighted in yellow above the tree view also indicates this.
6. Click the link: “Project compare view is read only because there are uncommitted changes in another view. Click here to switch to the modified view.”
   ⇒ The detailed compare view opens again. The unconfirmed changes are highlighted in yellow.
7. Click  in the tab of the view and confirm that the changes should be saved.
   ⇒ The detail project view is closed and the POU is overwritten. Now it corresponds to the POU of the reference project. The project view is active again so that you can continue working with project compare.

If you do not click the link, but click  instead to close the editor of the project compare view, then you will also confirm the acceptance of changes into the current project. The detail changes are accepted and then the project compare is closed completely.

See also

- § Chapter 6.4.1.5 “Comparing projects” on page 1817
- § Chapter 6.4.1.21.3.5.21 “Command “Compare”” on page 2607
- § Chapter 6.3.1.1.7.2 “Creating a comparison view” on page 1406

6.3.1.1.8 Project archive

General

Automation Builder supports the creation and the import of project archive files. Archive files contain all relevant project data including the PLC configuration, the project files of the CODESYS and all device descriptions. This allows exchanging Automation Builder projects without taking care of the target environment.
Creation of an archive

The following steps describe the creation archive file from an Automation Builder project:

1. Select “File ➔ Project Archive ➔ Save/Send Archive”.
2. Select the information which should be included in the archive file from the list box.

<table>
<thead>
<tr>
<th>Section/Control</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information selection list box</td>
<td>Options</td>
<td>Not supported</td>
</tr>
<tr>
<td>Referred devices</td>
<td>Referenced devices</td>
<td>The referenced devices can be selected by expanding the &quot;Referenced devices&quot; item of the list box. It is strongly recommended to include all devices in the project archive to maintain consistency.</td>
</tr>
<tr>
<td>Additional files</td>
<td>-</td>
<td>Not supported</td>
</tr>
<tr>
<td>Comment</td>
<td>-</td>
<td>Opening a control window which allows the input of a comment to the project archive.</td>
</tr>
<tr>
<td>Save</td>
<td>-</td>
<td>Opening a dialog window to determine the path and the file name of the project archive and storing it to the file system.</td>
</tr>
<tr>
<td>Send</td>
<td>-</td>
<td>Not supported</td>
</tr>
<tr>
<td>Cancel</td>
<td>-</td>
<td>Canceling the operation and closing the dialog window.</td>
</tr>
</tbody>
</table>

With [Comment] additional information can be added to the project archive, for example to add a brief description or some information concerning the project.

3. Proceed with [Save...].

It is strongly recommended to keep the default settings.

Section “Options” of the list box is not support. Do not enable this option.

Extraction of an archive

The currently loaded project will be closed automatically when extracting the selected project archive. It is recommended to open a new instance of Automation Builder before starting the extraction process.
The following steps describe the extraction of an archive file and the import to Automation Builder.

1. Select “File ➔ Project Archive ➔ Extract Archive”.
2. Select the desired project file and click [Open].

<table>
<thead>
<tr>
<th>Section/Control</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locations</td>
<td>Extract into the same folder where the archive is located</td>
<td>The project archive will be extracted to the same path where the archive is located.</td>
</tr>
<tr>
<td></td>
<td>Extract into the following folder</td>
<td>Path to which the project archive should be extracted.</td>
</tr>
<tr>
<td></td>
<td>Button ...</td>
<td>Opening a folder selection dialog which allows selecting the desired path.</td>
</tr>
<tr>
<td>Contents</td>
<td>Items</td>
<td>Select the items which should be extracted.</td>
</tr>
<tr>
<td></td>
<td>Comment</td>
<td>Displaying comments included inside the Project archive file.</td>
</tr>
<tr>
<td></td>
<td>Extract</td>
<td>Triggering the extraction process. Automation Builder extracts the archive and creates a project from out the archive. After creating the project Automation Builder checks the version of the project. If the project version and the activated Automation Builder version is not identical the workflow is the same as described in &quot;Opening an Existing Project&quot;.</td>
</tr>
<tr>
<td></td>
<td>Cancel</td>
<td>Closing the Extract Project Archive dialog and canceling the extraction process.</td>
</tr>
</tbody>
</table>

6.3.1.2 User and access rights management
6.3.1.2.1 User and access rights

General

The “User Management” provide functions for defining user accounts and configure the access rights within a project. The rights to access project objects via specified actions are assigned only to user groups, not to a single user account. So each user must be member of a group.

User management

With the help of the integrated user management, user groups with different access rights and authorizations can be defined. Configuration and handling of the user management in Automation Builder and a AC500 V3 is decribed in the application note User Management with V3 - Configuration and Handling.
NOTICE!
For security reasons we recommend activating the user administration for the PLC (and the Visualization).

Please note that when user management for the PLC is enabled, the username and password are always required to connect to the PLC.

If you have lost the administrator password, there is no way to recover it and the PLC must be sent in for reset!

Chapter 6.1 “Cyber security” on page 1340

Before setting up users and user groups, notice the following: The configuration of users and groups is done in the Project Settings dialog.

Chapter 6.3.1.2.3 “Project Settings - Users and groups” on page 1413

- Automatically there is always a group "Everyone" and by default primarily each defined user or other groups are members of this group. Thus each user account at least automatically is provided with defined default settings. Group "Everyone" cannot be deleted, just renamed, and no members can be removed from this group.
- Also automatically there is always a group "Owner" containing one user "Owner". Users can be added to or removed from this group, but at least one user must remain. This group also cannot be deleted and always has all access rights. Thus it is not possible to make a project unusable by denying the respective rights to all groups. Both group and user "owner" might be renamed.
- When starting the programming system resp. a project, primarily no user is logged on the project. But then the user optionally might log on via a defined user account with user name and password in order to have a special set of access rights.

Notice that each project has its own user management!

So, for example to get a special set of access rights for a library included in a project, the user must separately log on to this library. Also users and groups, set up in different projects, are not identical even if they have identical names.

CAUTION!
The user passwords are stored irreversibly!
If a password gets lost, the respective user account gets unusable. If the "Owner"-password gets lost, the entire project might get unusable!

Access right management
User management in a project is only useful in combination with the access right management. Notice the following:

- In a new project basically all rights are not yet defined explicitly but set to a default value. This default value usually is: "granted".
- In the further run of working on the project each right can be explicitly granted or denied resp. set back to default. The access right management of a project is done in the Permissions dialog “Permissions” on page 1411.
- Access rights on objects get "inherited". If an object has a "father" object (example: if an action is assigned to a program object, that is inserted in the structure tree below the program, then the program is the "father" of the action object), the current rights of the father automatically will become the default settings of the child. Father-child relations of objects concerning the access rights usually correspond with the relations shown in the POU or Devices tree and are indicated in the Permissions dialog by the syntax "<father object>.<child object>".
Example

Action ACT is assigned to POU object PLC_PRG. So in the POUs window ACT is shown in the objects tree indented below PLC_PRG. In the Permissions dialog ACT is represented by "PLC_PRG.ACT" indicating that PLC_PRG is the "father" of ACT. If the "modify" right would be denied explicitly for PLC_PRG and a certain user group, the default value of the "modify" right for ACT automatically also would be "denied".

6.3.1.2.2 User management commands

The 'User Management UI' plug-in provides commands for command category 'User Management'.

These are used for:

- Configuration of access rights on the project objects
- Logging on or off to/from the project via a defined user account in order to get the access rights which are associated to this account

The configuration of user accounts and groups is done in the “Project Settings” subdialog “User Management” & Chapter 6.3.1.2.3 “Project Settings - Users and groups” on page 1413.

By default the following commands are part of submenu “User Management” in the “Project” menu: “Logon”, “Logoff”, “Permissions”.

Logon

Symbol: ⏩

This command opens the “Logon” dialog for logging on to a project or library via a defined user account.

Logging on with a certain user account means to log on with those object access rights which are granted to the group which the user belongs to. The configuration of user accounts and groups is done in the “Project Settings” subdialog “User Management”.

To log on select the project or an included library from the selection list in the Project/Library field. Enter User name and Password of a valid user account, noticing that each project or library has its own user and access rights management. Log on with OK.

If already another user is logged on the project, this one will be logged out automatically by the new log-on action.

When you are logged on to a project or library and try to perform an action for which you have no right, automatically a Logon dialog will be opened, giving the possibility to log on with another user account provided with the appropriate rights.

The status bar always displays which user currently is logged on the project.

Logoff

Symbol: ⏭

This command logs off the currently logged on user. If no user had been logged on to the currently opened project or to a referenced library an appropriate message will appear when trying to log off.

If the user currently is logged on to more than one project or referenced library (not necessarily with the same user account) a “Logoff” dialog will appear when trying to log off.

From the Project/Library selection list choose those project/library for which you want to log off. The name of the current user is displayed just for information.

The status bar always displays which user currently is logged on the project.

Permissions

This command opens the “Permissions” dialog, where the rights to work on objects or to perform commands in the current project can be configured.
Any changes made in this dialog will be applied immediately.

The Actions window displays all possible rights, that is all actions which might be performed on any object of the current project.

The tree is structured in the following way:

- Top-level see the names of some categories, which have been set up just for the purpose of optical structuring the rights management.
  They are grouping concerning the execution of commands, the configuration of User accounts and Groups, the creation of Object Types, the viewing, editing, removing and handling of child objects of Project Objects.

- Below each category node there are nodes for the particular actions which might be performed on the command, user account, group, object type or project object. These nodes also only have optical function. Possible Actions:
  - execute (execution of a menu command)
  - create (creating a new object in the current project)
  - add or remove children (adding or removing of "child" objects to an existing object)
  - modify (editing an object in an editor)
  - remove (deleting or cutting an object)
  - view (viewing an object in an editor)

Below each action node find the possible targets, that is project objects, of the respective action.

The Permissions window provides a list of all currently available user groups (except the "Owner" group) and a toolbar for configuring rights to a group.

Select the group and configure it’s permissions.

Left to each group name one of the following icons indicates the currently assigned permission concerning the target which is currently selected in the Actions window:

- The action(s) for the target(s) currently selected in the Actions window are granted for the selected group.
- The action(s) for the target(s) currently selected in the Actions window are denied for the selected group.
The right to perform the action(s) which are currently selected for the selected target(s) in the Actions window, has not been granted explicitly, but is granted by default, for example because the corresponding right has been granted to the "father" object. (Example: The group has got the right for object "myplc", thus it by default it also has got it for object "myplc.pb_1". ) Basically this is the default setting for all rights which not explicitly have been configured.

The right to perform the action(s) which are currently selected for the selected target(s) in the Actions window, has not been denied explicitly, but is denied by default, for example in case because the corresponding right has been assigned to the "father" object.

If currently multiple actions are selected in the Actions window, which do not have unique settings referring to the currently selected group, no icon will be displayed.

To configure the rights for a group select the desired action(s) and target in the Actions window and the desired group in the Permissions window. Then use the appropriate button in the toolbar of the Permissions window:

- **Grant**: Explicit granting.
- **Deny**: Explicit denying.
- **Clear**: The currently granted right for the action(s) currently selected in the Actions window will be deleted, that is set back to the default.

### 6.3.1.2.3 Project Settings - Users and groups

#### General

The “Project Settings” dialog in category “Users and Groups” provides three subdialogs for the user management for the current project: Users, Groups, Settings.

- **General description on users and access rights management**

#### Users dialog

The currently registered users are listed in a tree structure. The ownerships of each user is displayed and each user is a member of a group by default.

- **Chapter 6.3.1.2.1 “User and access rights” on page 1409**

#### Define a new user account

1. Click “Add” to open the “Add User” dialog.
2. Define the user credentials and click [OK] to set up the new user. If there are incorrect entries (no login name, password mismatch, user already existing) you will get an appropriate error message.

#### Modify a user account

Click “Edit” to open the “Edit User” dialog. The entry fields are the same as in the “Add User” dialog. The password fields however - for security reasons - will show 32 * characters. After having modified the desired entries close the dialog with [OK] to get applied the new settings.

#### Remove user accounts

Enable the entries to be removed in the Users list and click “Remove”. Note that you will get no further inquiry! An error message appears if you try to delete all users from a group. At least one entry must remain.
Groups dialog

Add a group  The currently available groups are displayed in a tree structure. A member also might be a group.

1. Click “Add” to open the “Add Group” dialog.
2. Define a name for the new group and enable all entries (single users or groups) which should be members of the new group.
3. Click [OK] to set up the new group. If there are incorrect entries (no name defined, group already existing, in Members having selected a group which would cause a "group cycle", you will get an appropriate error message.

Modify a group  Click “Edit” to open the “Edit User” dialog. The entry fields are the same as in the “Add Group” dialog (see above). After having modified the desired entries close the dialog with [OK] to get applied the new settings.

Remove groups  Enable the entries to be removed in the groups tree and click “Remove”. Note that you will get no further inquiry! The members of the deleted groups will remain unmodified. An error message appears if you try to delete the groups “Everyone” and/or “Owner”.

Settings dialog

The following basic options and settings concerning the user accounts can be made:

- “Maximum number of authentication trials”: If activated, the user account will be set invalid after the specified number of trials to log in with a wrong password. If not activated, the number of erroneous trials is unlimited. Default: option activated, number of trials: 3; permissible values: 1-10.
- “Automatically log out after time of inactivity”: If activated, the user account will be logged out automatically after the specified number of minutes of inactivity (no user actions via mouse or keyboard registered in the programming system). Default: option activated, time: 10 minutes; permissible time values: 1-180 minutes.

6.3.1.3 Later change-over of a target system

6.3.1.3.1 Changing the processor module type

General

In a project, you can change the target system by changing the type of processor module or terminal base type. If possible, the device configuration of fieldbuses and interfaces is kept and switched over to the device configuration of the new module.

Target change options:

- between platforms: from V2 platform to V3 platform (and vice versa)
- between module types: from AC500 (standard) to AC500-eCo (and vice versa)
- a combination of changed platform and changed module type

Target change from a V2 processor module to a V3 processor module

Target change options:

- AC500 V2 processor module to AC500 V3 processor module
- AC500 V2 processor module to AC500-eCo V3 processor module
- AC500-eCo V2 processor module to AC500-eCo V3 processor module
- AC500-eCo V2 processor module to AC500 V3 processor module
Procedure:

1. Close CODESYS.

2. Double-click the “PLC_AC500_V2 <...>” node and open the “PM5<...> Hardware” tab.

3. Enable “Change to AC500 V3 PLC” and select the desired V3 processor module from the “PM5xx Type” drop-down list.

4. Click [Create V3 PLC].
   - The new V3 processor module is displayed in the navigation tree.
   - Change the node name of the processor module, if desired.

In case of a target change from AC500-eCo V2 to AC500-eCo V3, the I/O bus and Ethernet configuration is kept.

Target change from a V3 processor module to another V3 processor module

Target change options:
- AC500 V3 processor module to AC500 V3 processor module
- AC500 V3 processor module to AC500-eCo V3 processor module
- AC500-eCo V3 processor module to AC500 V3 processor module
- AC500-eCo V3 processor module to AC500-eCo V3 processor module

Procedure:

1. Close CODESYS.

2. Double-click the “PLC_AC500_V3 <...>” node and open the “PM5<...> Hardware” tab.
3. Select the desired V3 processor module from the “PM5xx Type” drop-down list.

Fig. 269: Change_Hardware_V3
4. Ensure the correct “Terminal Base Type” is selected and click [Change PM / TB type].
   ➜ If possible, the device configurations from the previous processor module will be kept and switched over to the new processor module.

   The device configurations that cannot be kept are listed in a prompted information dialog.

   By default, all device configurations which cannot be switched over will be copied to a “device pool” section in the navigation tree (option “Copy all objects that cannot be added to the new PLC into a device pool for further access”). If required, this backed-up configuration can be used in another project or in another processor module configuration.

   If the checkbox is deactivated all device configurations that cannot be switched will be lost after the execution of the target change.

   **Target change from AC500-eCo V3 to AC500 V3**

   The configuration of the onboard I/Os, the option board slots and the onboard RTC cannot be changed-over to the new module.

   **Target change from AC500 V3 to AC500-eCo V3**

   The configuration of COM1, CAN and the I/O bus cannot be changed-over to the new module. Depending on the selected target, also the I/O bus configuration and ETH2 configuration cannot be switched.

   ETH1 configuration is kept even if the configured protocols are not allowed for the selected AC500-eCo V3 PLC. In this case error messages are displayed in the messages window.
Libraries which are not used anymore are not deleted with the target change. Libraries of option boards are kept in the Library Manager even if no longer available at the target module.

6.3.1.3.2 Customer libraries

CODESYS for AC500 V2 products contains different types of libraries:
- Standard CODESYS libraries
- Specific AC500 libraries
- Customer libraries

In general, the Standard CODESYS libraries and the AC500 libraries are automatically converted during a target change from AC500 V2 to AC500 V3. Those libraries that cannot be converted (e.g. because there is no matching in V3) are created automatically in the V3 Library Manager and must be manually deleted by the user after the target change.

The customer libraries have to be converted manually using the Library Converter integrated into the Automation Builder installation:

1. In Automation Builder click “File ➔ Open project”.
2. Select the CODESYS library for AC500 V2 products which has to be converted.
3. After conversion of the library, open the view POUs in the device navigator and double-click “Project Information”.
4. To have the library automatically available in the V3 project, enter “Company”, “Title” and “Version” in the specific fields of the dialog.

Then, open the “Properties” tab. For the target change the new “Key” “CoDeSysV2Library” has to be added. Under “value”, enter the name of the CODESYS library and click the “Add” button.

![Project Information](image)
Click “File ➔ Save project” and install into the library repository.

6.3.1.4 Firmware identification and update

6.3.1.4.1 General information

Without direct access to the internet, a firmware update with the memory card is also possible.

Chapter 6.3.1.4.5 “Firmware installation and update with memory card” on page 1426

6.3.1.4.2 Device state firmware version

Introduction

As a process participant, whether as a user, machine builder, plant operator or maintenance engineer, it is helpful to be able to see at a glance which component has which firmware version.

If necessary, an error can then be quickly corrected or versions adjusted. The possible ways of displaying the various components are shown below.

- CPU
- Communication modules
- AC500-eCo option boards
- Field devices

CPU firmware

Version query via Automation Builder tab “Version information”

Version information

Information on the firmware versions of the processor modules or communication modules, is provided on the “Version information” tab.

Remarks:

- The “Version information” tab displays the version identified on the device and the version provided with Automation Builder.
- The firmware on the devices must match to the Automation Builder supported versions. It might be required to upgrade or downgrade the current firmware for using the PLC with the current Automation Builder.
- The “Required Version” might contain more than one user selectable version (drop-down list), this is indicated by an asterisk after the file name.
Firmware version on device matches version supplied with Automation Builder.

Firmware version (or type) on device is different from version supplied with Automation Builder. Upgrade/downgrade to version supplied with Automation Builder is recommended.

Only for communication modules if CPU firmware must be updated first. This happens when CPU firmware has version below 2.5.0.0.

Firmware version (or type) on device is different from version supplied with Automation Builder. Upgrade/downgrade to version supplied with Automation Builder is recommended.

Identified device is different from configured device, thus no firmware update is possible. Happens only for Communication Modules.

Firmware of device is not updateable or no newer firmware than the initial version is available.

[Update Firmware] to download the new firmware is only enabled if there is updateable firmware.

Version query via Automation Builder tab “PLC Shell”

The PLC shell is used for requesting specific information from the controller. By entering a device specific command the response is returned in a result window. The PLC shell can be issued without login.

Proceed as follows:
1. Ensure the gateway is configured properly and a connection to the controller can be established.
2. In Automation Builder double-click the PLC node and open the tab “PLC Shell”.
3. Enter versioninfo or rtsinfo in the command line of the tab window. The current firmware versions are listed.

Version query via application

The version information are accessible via the function block PmVersion, production data accessible via function block PmProdReadAsync.

Chapter 6.5.14 “Reference, function blocks” on page 4086
Version query via IP configuration tool

The IP configuration tool is part of Automation Builder and can be called via “Tools → IP-Configuration”.

- Chapter 6.3.2.4.3.2 “Stand-alone installation” on page 1457
- Further information on page 1459

Communication modules

Version query via Automation Builder tab “Version information”

- Chapter 6.3.1.4.2.2.1 “Version query via Automation Builder tab “Version information”” on page 1419

Version query via Automation Builder tab “PLC Shell”

The PLC shell is used for requesting specific information from the controller. By entering a device specific command the response is returned in a result window. The PLC shell can be issued without login.

Proceed as follows:

1. Ensure the gateway is configured properly and a connection to the controller can be established.
2. In Automation Builder double-click the PLC node and open the tab “PLC Shell”.
3. Enter `coupler desc` in the command line of the tab window. The current firmware versions are listed.

Version query via application

The version information are accessible in the property “DeviceInfo” of the module.

AC500-eCo V3 option boards

Version query via Automation Builder tab “Version information”

- Chapter 6.3.1.4.2.2.1 “Version query via Automation Builder tab “Version information”” on page 1419

Version query via Automation Builder tab “PLC Shell”

- Chapter 6.3.1.4.2.2.2 “Version query via Automation Builder tab “PLC Shell”” on page 1420

Version query via application

The version information are accessible in the property “DeviceInfo” of the module.

Field devices

Version query via Automation Builder

The firmware versions of the ABB communication interface devices for PROFINET (CI50x-PNIO) and EtherCAT (CI51x-ETHCAT) is available from the respective editor in online mode in the Automation Builder.
Version query via application

PROFINET, PROFIBUS, EtherCAT, CANopen: According to standard of the corresponding fieldbus protocol.

Version query via IP configuration tool

© Chapter 6.3.1.4.2.2.4 “Version query via IP configuration tool” on page 1421

Only for Ethernet-based fieldbuses!

6.3.1.4.3 Installation and update of the AC500 V3 firmware

The multi download tool can be used to update multiple PLCs with firmware or an application at the same time.

© Chapter 6.6.4 “Multi download tool” on page 4306

Firmware update with activated user management

The PLC user management will remain also after a firmware update or downgrade.

Due to a structural change in the PLC user management in firmware version 3.5 there are some limitations when updating the PLC firmware from a version 3.4 or lower to 3.5 or higher with activated user management.

If you update the PLC firmware from version 3.4 or lower to version 3.6 or higher this must be done in two steps. First an update to 3.5 must be done via Automation Builder. Afterwards the firmware can be updated to any later firmware version – either via Automation Builder or via memory card.

The PLC firmware can be updated via Automation Builder.

This is also necessary for commissioning V3 CPUs.

A very new CPU has no pre-installed firmware. To guarantee the authenticity of delivered AC500 firmware, V3 CPUs are delivered with a boot loader only. You need to download a valid firmware to the CPU. After download, the functionality of the CPU is given.

- An Automation Builder project with an AC500 V3 CPU is open.
- CPU is in "stop" mode or shows uPdAtE (update) on the display.
- After update the CPU shows either donE or StoP on the display.
For new modules: IP address is set. (The default IP address is 192.168.0.10)

1. Double-click CPU “PLC_AC500_V3”.

2. Select “Version information”.

3. Select “Update Firmware”.
   - While the update process is running, the RUN and ERR LEDs are toggling, i.e., they are flashing alternating.

4. Wait for the PLC to finish the update.

---

Firmware updates that include “UpdateFW” changes must be performed in two steps:

First, the “UpdateFW” is updated, and once this is done click the update button again to execute the “SystemFW” update.

Note: Firmware updates via memory card automatically cover both updates in one step.

A completed update is indicated by a message on the display. Either done, or Stop.

---

NOTICE!

Do not disconnect the power supply during the update process! The PLC could be damaged.

- **Stop** indicates a restart has been performed by the CPU. When done is displayed sometimes it is necessary to re-boot the CPU manually, e.g., by powering-off. Manual re-boot might be, e.g., for some older CPU versions or if downgrading to an older firmware version according to application settings.

The CPU display shows **Stop** after re-boot. The update process is finished.
5. If necessary, refresh the version information by switching to another tab and back.

⇒ Successful firmware update:

![Firmware Update Status](image)

### Behavior of LEDs during firmware update

<table>
<thead>
<tr>
<th>LED</th>
<th>LED flashes</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>RUN and ERR</td>
<td>Toggling</td>
<td>Update pending</td>
</tr>
<tr>
<td>RUN</td>
<td>Flashing slow</td>
<td>Done successful</td>
</tr>
<tr>
<td>ERR</td>
<td>Flashing slow</td>
<td>Done failed</td>
</tr>
</tbody>
</table>

6.3.1.4.4 AC500-eCo V3 firmware installation and update

The multi download tool can be used to update multiple PLCs with firmware or an application at the same time.

⇒ Chapter 6.6.4 “Multi download tool” on page 4306
The PLC firmware can be updated via Automation Builder.

This is also necessary for commissioning AC500-eCo V3 CPUs.

A very new CPU has no pre-installed firmware. To guarantee the authenticity of delivered AC500-eCo firmware, V3 CPUs are delivered with a boot loader only. You need to download a valid firmware to the CPU. After download, the functionality of the CPU is given.

- An Automation Builder project with an AC500-eCo V3 CPU is open.
- CPU is in "stop" mode without firmware.
- The power LED is ON.
- For new modules: IP address is set. (The default IP address is 192.168.0.10)

1. Double-click CPU “PLC_AC500_V3”.
2. Select “Version information”.

3. Select [Update Firmware].
   - While the update process is running, the RUN and ERR LEDs are toggling, i.e., they are flashing alternating.
4. Wait for the PLC to finish the update.

NOTICE!
Do not disconnect the power supply during the update process! The PLC could be damaged.
5. If necessary, refresh the version information by switching to another tab and back.

Successful firmware update:

- CPU without firmware, only the power LED is on.
- While the firmware update process is running, the RUN and ERR LEDs are toggling, i.e., they are flashing alternating.

<table>
<thead>
<tr>
<th>LED</th>
<th>LED flashes</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>RUN and ERR</td>
<td>Toggling</td>
<td>Update pending</td>
</tr>
<tr>
<td>RUN</td>
<td>Flashing slow</td>
<td>Done successful</td>
</tr>
<tr>
<td>ERR</td>
<td>Flashing slow</td>
<td>Done failed</td>
</tr>
</tbody>
</table>

- CPU with installed firmware, only the power LED is on.
- If the CPU is running, then the RUN LED is on.
- If the CPU is in STOP mode, the RUN LED is off.

6.3.1.4.5 Firmware installation and update with memory card

General

The memory card is a removable persistent mass storage device and can be used for any application purpose. Both firmware updates and boot project updates can be run from the memory card.

**NOTICE!**

**Removal of the memory card**

Do not remove the memory card when it is working. For memory card activity the black square ( ) is shown on PLC display as long as a file is open on the memory card. Remove the memory card only when no black square ( ) is shown next to memory card in the display. Otherwise the memory card and/or files on it might get corrupted and/or normal PLC operation might be disturbed.
Firmware and/or application installation and update

Notes

ABB recommends that users carry out the firmware update via Automation Builder. Chapter 6.3.1.4 “Firmware identification and update” on page 1419

Not every user has an Automation Builder at his disposal with which a firmware or boot project update can be easily realized. In this case, the user must be provided with a prepared memory card from his client.

It is not possible to update the communication interface modules with a memory card. The firmware of the communication interface modules can only be updated with the IP configuration tool.

Firmware update with activated user management

The PLC user management will remain also after a firmware update or downgrade.

Due to a structural change in the PLC user management in firmware version 3.5 there are some limitations when updating the PLC firmware from a version 3.4 or lower to 3.5 or higher with activated user management.

If you update the PLC firmware from version 3.4 or lower to version 3.5 this must be done via Automation Builder. An update via memory card with activated user management will result in losing all access rights to the PLC.

If you update the PLC firmware from version 3.4 or lower to version 3.6 or higher this must be done in two steps. First an update to 3.5 must be done via Automation Builder. Afterwards the firmware can be updated to any later firmware version – either via Automation Builder or via memory card.

Chapter 6.3.1.4.3 “Installation and update of the AC500 V3 firmware” on page 1422

Preparation of memory card

MC5141 - memory card
MC5102 - micro memory card with adapter

Firmware packages can be downloaded from ABB website or exported from Automation Builder.

In Automation Builder, you can choose if you want to export the firmware only or, in addition, the boot project as well. If the boot project does not exist yet, it will be created automatically.

The memory card will contain the firmware of the PLC, the firmware of the communication modules, the application, the visualizations and all related objects (like text lists).
Fig. 270: Example

1. Right-click “Application” in the device tree.
2. Select “Export ➔ Boot project and firmware” or “Export ➔ Firmware”.
3. Choose a location for the export folder.
   Select [Make New Folder] and type in "MEMORY CARD".
4. Select [OK] to add the folder.
5. Select folder "MEMORY CARD".

The "MEMORY CARD" structure has been created and the firmware and application have been exported.

The created "MEMORY CARD" folder does not contain user data, remanent data, config data, safety PLC power dip data and safety PLC password.

Add this data if required by the used application.

6. Copy all subfolders and files of the "MEMORY CARD" folder to a memory card.

The copy process can be performed with the Automation Builder software with the memory card inserted in the processor module or with the PC with a suitable memory card slot.

1. Insert memory card into the processor module.
2. Connect the PC to the processor module with an Ethernet cable.
3. In Automation Builder, log-in to the processor module.
4. Double-click on the processor module in the device tree and select "Files".
5. On the right side, select and open the folder "sdcard".
6. On the left side, select all the subfolders and files of the MEMORY CARD folder, but not the folder itself.
7. Copy all selected subfolders and files from the left side to the memory card by clicking to the right side.

**Copy process on the PC**

1. Insert the memory card into the PC.

2. Mark all subfolders and files of the "MEMORY CARD" folder, but not the "MEMORY CARD" folder itself, and copy them.

3. Select the memory card and paste the copied subfolders and files.

**Execution of update via memory card**

- **Boot project and firmware update**
  - Precondition: Prepared memory card with boot project and firmware

  1. Switch off the device.
  2. Insert the memory card.
3. Switch on the device.
   ⇨ The alternate flashing of the RUN and the ERR LED indicates the running update process.
   At the end of the update process a reboot is executed and the boot project and system firmware is started for the finishing of the update process.
   If RUN LED blinks (ERR LED is off), the update was successful and the display shows “done”.
   If ERR LED blinks (RUN LED is off), the update failed and the display shows “FAIL”.
   The text file “SDCARD.RDY” includes the results of the different updates. If the update fails, the file contains the reasons for the abort. Based on this, further steps can be taken to fix the problem.

4. Switch off the device.
5. Remove the memory card.
6. Switch on the device.
   ⇨ The system starts with the new boot project and firmware.

Firmware update

 Preconditions: Prepared memory card with boot project and firmware ⇨ Chapter 6.3.1.4.5.2.2 “Preparation of memory card” on page 1427.
1. Switch off the device.
2. Insert the memory card.
3. Switch on the device.
   ⇨ The alternate flashing of the RUN and the ERR LED indicates the running update process.
   At the end of the update process a reboot is executed and the system firmware is started for the finishing of the update process.
   If RUN LED blinks (ERR LED is off), the update was successful and the display shows “done”.
   If ERR LED blinks (RUN LED is off), the update failed and the display shows “FAIL”.
   The text file “SDCARD.RDY” includes the results of the different updates. If the update fails, the file contains the reasons for the abort. Based on this, further steps can be taken to fix the problem.

4. Switch off the device.
5. Remove the memory card.
6. Switch on the device.
   ⇨ The system starts with the new firmware.

Description of LEDs

The LEDs below the display indicate the state of the processor module:
### LED States and Colors

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = ON</th>
<th>LED = OFF</th>
<th>LED flashes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power LED (PWR)</td>
<td>Denotes the power supply state of the processor module</td>
<td>Green</td>
<td>Voltage is present (24 V DC)</td>
<td>Voltage is missing</td>
<td>-</td>
</tr>
<tr>
<td>Run LED (RUN)</td>
<td>Denotes the activity state of the processor module</td>
<td>Green</td>
<td>Processor module is in RUN mode</td>
<td>Processor module is in STOP mode</td>
<td>If the LED flashes fast (4 Hz) a firmware update is finished with no errors.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>If the Run LED flashes fast (4 Hz), alternating with a flashing Run LED the firmware is updated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>To enforce boot mode 1, keep the RUN function key pressed during the boot procedure. In this case, the Run LED flashes slowly (1 Hz). A subsequent project download (from within Automation Builder) cancels the blinking.</td>
</tr>
<tr>
<td>Error LED (ERR)</td>
<td>Denotes an error</td>
<td>Red</td>
<td>An error has occurred.</td>
<td>No errors or only warnings have occurred.</td>
<td>If the Error LED flashes slowly (1 Hz) a firmware update from the memory card is finished with errors.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>If the Error LED flashes fast with AC500 on display a fatal system error has occurred.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>If the Error LED flashes fast (4 Hz) alternating with a flashing Run LED the firmware is updated.</td>
</tr>
</tbody>
</table>

A running processor module is indicated with the state RUN on the display, a deactivated processor module is indicated with the state STOP. In both cases the display's backlight is off.

### Advanced Memory Card Handling for Firmware/Application Update

**Memory card file content: Firmware version V3.x**

Only advanced users should apply the instructions in this chapter.

### General Update Process

*Chapter 6.3.1.4.3 “Installation and update of the AC500 V3 firmware” on page 1422*

The main components of the V3 CPU firmware are:

- **BootFW** (boot firmware): responsible for the starting of the UpdateFW or the SystemFW
- **UpdateFW** (update firmware): responsible for the update of BootFW, UpdateFW, SystemFW, UpdateHook and boot project
- **SystemFW** (system firmware, CPUFW): Runtime system of the PLC, additionally responsible for the update of the DisplayFW (display firmware) and the firmware of the communication module
- **DisplayFW** (display firmware): Firmware of the display
Additionally the update process includes the following parts:

- Communication module (communication module firmware): Firmware of the different communication module
- UpdateHook: Specific patches for the PLC
- UserProgram: Boot project of the application
- License features: Import and export of license files. The license file for the "ImportLicense" is a Wbb or a WibuCmRaU file. The license file of the "ExportLicense" is a WibuCmRaC file.

The firmware updates are triggered by the command file `SDCARD.INI`. In addition a result file of the firmware update is generated (`SDCARD.RDY`, identical path as `SDCARD.INI`). For the group [FirmwareUpdate] the parameters 0, 11, 12 and 13 are defined. For each firmware update two files are necessary. The firmware file and the corresponding signature file.

For example:

```
AC500_V3_SystemFirmware_V3.0.1.73.tar.bz2
AC500_V3_SystemFirmware_V3.0.1.73.tar.bz2.sig
AC500_V3_DisplayFirmware_V3.0.0.0.app
AC500_V3_DisplayFirmware_V3.0.0.0.app.sig
```

For the user program the application file and the application CRC are necessary. For example:

```
Application.app
Application.crc
```

If the signature file and the firmware file do not match, no update is performed and the correspondent error result is written to the file `SDCARD.RDY`.

If the update firmware is running the display shows the text `update`. The blinking of the RUN and the ERR LED’s indicates the update process.

The file “SDCARD.RDY” includes the results of the different updates. After an update of a communication module CODESYS Control is started in safe mode (no download or starting of the application is possible) and the PLC needs a reboot (power down/up; the display shows please and reboot alternately).

As of system firmware 3.2 the compatibility file "Version.txt" (with the corresponding signature file "Version.txt.sig", identical path as "SDCARD.INI") is necessary for the update process. The update firmware checked the compatibility of the following parts:

- CPUFW (system firmware)
- BootFW (boot firmware)
- UpdateFW (update firmware)
- DisplayFW (display firmware)

A missing "Version.txt" or a missing/corrupt "Version.txt.sig" file is signalled at the component "CPUFW" (file "SDCARD.RDY").

If the update process would result in incompatible parts of firmware no update is performed in the update firmware. After starting of the system firmware the compatibility of the communication module firmware is checked additionally. The check of the compatibility of the firmware is executed always (independent of the parameter for the component). Incompatibility is signalled at the corresponding component (file SDCARD.RDY”).

As of system firmware 3.2 the compatibility file "Version.txt" (with the corresponding signature file "Version.txt.sig", identical path as "SDCARD.INI") is necessary for the update process. The update firmware checked the compatibility of the following parts:

- CPUFW (system firmware)
- BootFW (boot firmware)
- UpdateFW (update firmware)
- DisplayFW (display firmware)

A missing "Version.txt" or a missing/corrupt "Version.txt.sig" file is signalled at the component "CPUFW" (file "SDCARD.RDY").

If the update process would result in incompatible parts of firmware no update is performed in the update firmware. After starting of the system firmware the compatibility of the communication module firmware is checked additionally. The check of the compatibility of the firmware is executed always (independent of the parameter for the component). Incompatibility is signalled at the corresponding component (file SDCARD.RDY”).

If a firmware or boot application update is currently being performed via an memory card, the PLC will wait for the user. To remove the memory card and do a power cycle for completing the update process.

In the case of an unattended remote update via memory card, this is an obstacle because there may be no one on site to perform the power cycle. To avoid this situation, additional options have been added to SDCARD.ini to enable an unattended automatic restart when entering RTS safe mode after a successful firmware or boot project update.

Automated reboot of the PLC

If a firmware or boot application update is currently being performed via an memory card, the PLC will wait for the user. To remove the memory card and do a power cycle for completing the update process.

In the case of an unattended remote update via memory card, this is an obstacle because there may be no one on site to perform the power cycle. To avoid this situation, additional options have been added to SDCARD.ini to enable an unattended automatic restart when entering RTS safe mode after a successful firmware or boot project update.
The changes are an optional behavior that is triggered by the user setting in SDCARD.ini! The default behavior (RTS stays in safe mode until manual power cycle) is maintained!

The “FunctionOfCard” is reset from (4-6) to 0 after the update. Which means after a successful update operation the memory card cannot be used for updating another PLC without manual modification of the “FunctionOfCard”.

The intended use case is for the memory card to always remain in the respective PLC to be used as mass storage and for the unattended update.

In case of changed boot parameters, an additional reboot is required. This additional reboot is never done automatically and therefore it has to be done manually.

Command file SDCARD.ini for AC500 V3 Products

Only advanced users should apply the instructions in this chapter.

<table>
<thead>
<tr>
<th>[FirmwareUpdate]</th>
<th>0 = No update</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPUFW=x</td>
<td>11 = Update system firmware always with the file specified in module's section [CPU] and component's path key “CPUFW”.</td>
</tr>
<tr>
<td>x= 0, 11, 12, 13</td>
<td>12 = Update with different version, the update is only performed if the version of the file specified by the component path key “CPUFW” in module’s section [CPU] differs from the current version of the CPU.</td>
</tr>
<tr>
<td></td>
<td>13 = Update with newer version, the update is only performed if the version of the file specified by the component path key “CPUFW” in module’s section [CPU] is newer than the current version of the CPU.</td>
</tr>
</tbody>
</table>

| BootFW=x          | See description CPUFW. The component's path key for the boot firmware in module's section [CPU] is “BootFW”. |
| x= 0, 11, 12, 13  |

| UpdateFW=x        | See description CPUFW. The component's path key for the update firmware in module’s section [CPU] is “UpdateFW”. |
| x= 0, 11, 12, 13  |

| DisplayFW=x       | See description CPUFW. The component's path key for the display firmware in module's section [CPU] is “DisplayFW”. |
| x= 0, 11, 12, 13  |

| UpdateHook=x      | 11 = Execute UpdateHook always with the file specified in module's section [CPU] and component's path key "UpdateHook". |
| x= 0, 11           |

| ImportLicense=x   | 12 = Import the license always with the file specified in module's section [CPU] and component's path key "ImportLicense". The license file is a Wbb or a WibuCmRaU file. The update process imports this file into the plc. |
| x= 0, 12           |
| Note: Do not use parameter 11 for license import. |

| ExportLicense=x   | 12 = Export the license always to the file specified in module's section [CPU] and component's path key “ExportLicense”. The exported license file is a WibuCmRaC file. |
| x= 0, 12           |
| Note: Do not use parameter 11 for license export. |
Coupler0=x
x= 0, 11, 12, 13
0 = No update.
11 = Update firmware always with the file specified in module's section [Coupler0] and component's path key "Boot" and/or "Firmware".
12 = Update with different version, the update is only performed if the version of the file specified by the component path key "Boot" and/or "Firmware" in module's section [Coupler0] differs from the current version of the communication module.
13 = Update with newer version, the update is only performed if the version of the file specified by the component key "Boot" and/or "Firmware" in module's section [Coupler0] is newer than the current version of the communication module.

Update module slot 1; see description Coupler0, module section is [Coupler1]*.

Update module slot 2; see description Coupler0, module section is [Coupler2]*.

Update module slot 3; see description Coupler0, module section is [Coupler3]*.

Update module slot 4; see description Coupler0, module section is [Coupler4]*.

Update module slot 5; see description Coupler0, module section is [Coupler5]*.

Update module slot 6; see description Coupler0, module section is [Coupler6]*.

UserProgram=x
x= 0, 11
0 = No update.
11 = Update user program always with the file specified in module's section [CPU] and component's path key "UserProgram".

Example: SDCARD.INI as of CPU firmware V3.x

Only advanced users should apply the instructions in this chapter.

[Status]
# FunctionOfCard $FocValue (0, 1, 2, 3, 4, 5, 6) from SDCARD.INI
# 0 = No update
# 1: Load user program according to entry in group [UserProg] and the PLC prompts for manual reboot.
# 2: Start firmware update according to entry in group [FirmwareUpdate] and the PLC prompts for manual reboot.
# 3: Update firmware according to entry in group [FirmwareUpdate] and load user program according to entry in group [UserProg] and the PLC prompts for manual reboot.
# 4: Load user program according to entry in group [UserProg] and the PLC reboots automatically.
# 5: Start firmware update according to entry in group [FirmwareUpdate] and the PLC reboots automatically.

# 6: Update firmware according to entry in group [FirmwareUpdate] and load user program according to entry in group [UserProg] and the PLC reboots automatically.

[FirmwareUpdate] ;
0 = No update ;
11 = Update with file specified in module's section <modsec>, component's path key <pathkey> ;
12 = Like 11, but check version of file to be updated differs from current one. ;
13 = Like 11, but check version of file to be updated is newer than current one.
CPUPFW=0 ;<modsec>=|CPU|, <pathkey>= CPUPFW
BootFW=0 ;<modsec>=|CPU|, <pathkey>= BootFW
UpdateFW=0 ;<modsec>=|CPU|, <pathkey>= UpdateFW
DisplayFW=0 ;<modsec>=|CPU|, <pathkey>=DisplayFW
UpdateHook=0 ;<modsec>=|CPU|, <pathkey>=UpdateHook
ImportLicense=0 ;<modsec>=|CPU|, <pathkey>=ImportLicense
ExportLicense=0 ;<modsec>=|CPU|, <pathkey>=ExportLicense
Coupler0=0 ;<modsec>=|Coupler0|, <pathkey>=Firmware
Coupler1=0 ;<modsec>=|Coupler1|, <pathkey>=Firmware
Coupler2=0 ;<modsec>=|Coupler2|, <pathkey>=Firmware
Coupler3=0 ;<modsec>=|Coupler3|, <pathkey>=Firmware
Coupler4=0 ;<modsec>=|Coupler4|, <pathkey>=Firmware
Coupler5=0 ;<modsec>=|Coupler5|, <pathkey>=Firmware
Coupler6=0 ;<modsec>=|Coupler6|, <pathkey>=Firmware

[UserProg] ;
0 = No update ;
11 = Update with file specified in module's section <modsec>, component's path key <pathkey>
UserProgram=0 ;Update user program. <modsec>=|CPU|, <pathkey>= UserProgram

[CPU];
CPUPFW= ;Path/file of CPU's system firmware to update
BootFW= ;Path/file of CPU's boot firmware to update
UpdateFW= ;Path/file of CPU's update firmware to update
UpdateHook = ;Path/file of UpdateHook to update
DisplayFW= ;Path/file of Display's firmware to update
ImportLicense= ;Path/file of import license file
ExportLicense= ;Path/file for export license file
UserProgram= ;Path/File of user program to update

[Coupler0]
Firmware= ;Path/file of internal coupler's firmware to update

[Coupler1]
Firmware= ;Path/file of external coupler's firmware slot 1 to update
Firmware= ;Path/file of external coupler's firmware slot 2 to update
[Coupler3]
Firmware= ;Path/file of external coupler's firmware slot 3 to update
[Coupler4]
Firmware= ;Path/file of external coupler's firmware slot 4 to update
[Coupler5]
Firmware= ;Path/file of external coupler's firmware slot 5 to update
[Coupler6]
Firmware= ;Path/file of external coupler's firmware slot 6 to update

Example content and description of the SDCARD.INI folder

SDCARD.INI for memory card for update only the system firmware (SystemFW):

[Status]
FunctionOfCard=2

[FirmwareUpdate]
CPUFW=11

[CPU]
CPUFW=/SystemFirmware/AC500_V3_SystemFirmware_V3.7.0.99_zzz.tar.bz2

6.3.1.4.6 Update CI52x-Modbus firmware

Precondition

Requirement: A firmware update file is available, e.g. AC500_CI52x_Firmware_V3.2.8.bin.

The CI52x Modbus firmware update is only available in the Automation Builder IP Configuration Tool.

Installation of the IP configuration tool

1. In Automation Builder click “Tools ➔ Installation Manager” to start the Installation Manager.
2. Close any other running instances of Automation Builder. Then, click “Modify” in the Installation Manager.
3. Select the option “IP Configuration Tool” from the list and start the installation of the IP Configuration Tool.

Firmware update procedure

1. In the IP Configuration Tool click “Scan” to initialize a device scan.
2. From the list select the CI52x-MODTCP device(s) which shall be updated and click “FW Update”.

2024/01/05 3ADR010583, 1, en_US 1437
3. Select the firmware update file (e.g. AC500_CI52x_Firmware_V3.2.8.bin) to initialize a signature check and start the update procedure.

   *During the firmware update the operation of the device(s) is stopped. After the update, all outputs are set to zero.*

4. After the update, click “Scan” again to retrieve the firmware version of the device.

### Troubleshooting

<table>
<thead>
<tr>
<th>Fault description</th>
<th>Cause</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI firmware update failed</td>
<td>General hints:</td>
<td>Close all unused applications on the update PC and do not open Automation Builder or any other applications during the firmware update. Stop the communication between AC500 PLC and the CI52x devices and disconnect the Ethernet connection of the update PC and the CI Modbus device(s). Do not close the IP Configuration Tool during a firmware update and do not switch off a CI Modbus device during the firmware update. Locate the PC on which the update is performed as near as possible to the stationed CI Modbus devices. Avoid network switches.</td>
</tr>
<tr>
<td>Error 1: Package Timeout</td>
<td>Due to a primitive firmware update protocol a fast and stable network connection is required. Otherwise the update packages cannot be transferred within the requested time and a timeout occurs.</td>
<td>Locate the PC on which the update is performed as near as possible to the stationed CI Modbus devices. Avoid network switches.</td>
</tr>
<tr>
<td>Error 2: Unable to read device status</td>
<td>After the firmware update the IP Configuration Tool reads out the status of the updated device in order to check if the update was successful.</td>
<td>Rescan and repeat the update. If this doesn’t work, power cycle the device and retry the update.</td>
</tr>
<tr>
<td>Error 3: IP is not unique</td>
<td>If more than one device hold the same IP address, a firmware update is not possible as the update command is IP based.</td>
<td>Correct the IP address, rescan and repeat the update. If this doesn’t work, power cycle the device and retry the update.</td>
</tr>
<tr>
<td>Error 4: Internal Error</td>
<td>An internal error on the CI52x Modbus device occurred during the firmware update.</td>
<td>Rescan and repeat the update. If this doesn’t work, power cycle the device and retry the update.</td>
</tr>
<tr>
<td>Error 5: Cannot connect to device</td>
<td>The TCP communication is not sufficient for a connection. Increase the connection quality.</td>
<td>Locate the PC on which the update is performed as near as possible to the stationed CI Modbus devices. Avoid network switches.</td>
</tr>
<tr>
<td>Signatur check failed</td>
<td>After the selection of the firmware file (*.bin) a signature check is performed. If either the firmware file or the signature file is corrupt, the signature check fails.</td>
<td>Example file names: Name of the firmware file: c:\AC500\AC500_CI52x_Firmware_V3.2.8.bin Correct name of the signature file: c:\AC500\AC500_CI52x_Firmware_V3.2.8.bin.sig Wrong name of the signature file: c:\AC500\AC500_CI52x_Firmware_V3.2.8.sig</td>
</tr>
</tbody>
</table>
### Fault description

<table>
<thead>
<tr>
<th>Fault Description</th>
<th>Cause</th>
<th>Remedy</th>
</tr>
</thead>
</table>
| Indeterminate device firmware version  | If the firmware version of the device cannot be determined, an error occurs. | Example: Result OK  
- PC: 192.168.14.71 / 255.255.255.0  
- Device: 192.168.14.10 / 255.255.255.0  
Example: Result OK  
- PC: 192.168.10.71 / 255.255.0.0  
- Device: 192.168.14.10 / 255.255.0.0  
Example: Result ERROR  
- PC: 192.168.10.71 / 255.255.255.0  
- Device: 192.168.14.10 / 255.255.255.0 |

### 6.3.1.5 Migration of third party devices

After an update of Automation Builder the device repository contains only ABB devices. The third party devices which were installed into previous versions of Automation Builder are not automatically installed in the newest version profile. This has to be triggered by the user.

The feature “Migrate third party devices” is available as of Automation Builder 2.1.1.

1. Click “Tools” in the main menu of Automation Builder.
2. Click “Migrate third party devices” in the drop-down list.
   - The window “Version profile selection” appears.
3. Select a version profile in the drop-down list containing previous Automation Builder / Control Builder Plus profiles. The active profile does not appear in the list.

⇒ After selection of a previous version profile, all the third party devices which have been installed inside this version profile are listed.

It is not possible to select or deselect some third party devices. Importing will affect all the third party devices which are listed in the list view.
4. Select [Import].

During the migration the message window displays success or failure of device migration.

In case of failure during the migration the affected third party device description has to be installed manually via main menu “Tools ➔ Device Repository ➔ Install”.

In the status bar, the third party device which is on “Migrating: <...>” is displayed on the left side.

The import operation can be cancelled by clicking the “Click here to CANCEL this operation” link on the right side of the status bar. This becomes effective when the migration of the just migrating third party device is finished.

5. To close the dialog select the [Close] button of the Version profile selection.

6.3.1.6 Advanced IO device handling

6.3.1.6.1 General

Automation Builder provides the Advanced IO Device Handling feature for configuring identical IO device types at multiple instances.

This feature is supported by the following commands that works with IO devices only.

- Generate DUT
  - Chapter 6.3.1.6.2 “Generating DUT” on page 1442
- Map to Existing DUT
  - Chapter 6.3.1.6.3 “Mapping to existing DUT” on page 1442
- Release DUT mapping
  - Chapter 6.3.1.6.4 “Releasing DUT mapping” on page 1442

These commands work on individual nodes and on CI level nodes.
6.3.1.6.2 Generating DUT
Each device generates two DUTs. One for the input and one for the output. Some devices contain only input or output type. In such cases, the device generates only one DUT of the relevant type.

- Right-click on the desired IO device and select “Generate DUT” to generate a DUT for an IO device.

The following example shows how to generate DUTs at CI level node.

- In the device tree, right-click on a master node such as PNIO_Controller and select “Generate DUT” to create DUTs for the child nodes.
- The DUTs of child nodes are generated in “Application ➔ App ➔ IO_Device_Generated_Items” folder.
- Generated DUT considers channels with BYTE datatype as members. If channels with BYTE datatype are not present in the given hierarchy, it adds the members with another higher datatype.
- Channels with BOOL datatype are not considered.

6.3.1.6.3 Mapping to existing DUT
This command is enabled for the IO device when the IO device is not mapped and when DUTs of matching size (calculated based on device channel list) are available in “Application ➔ App ➔ IO_Device_Generated_Items” folder.

1. Right-click on an IO device and select “Map to Existing DUT”:
   - Enter Instance Name dialog is displayed.
2. Enter the instance name which satisfies IEC naming validations and unique name in global scope.
3. Click [OK] to create a global variable associated with the mappings in DI (PRG).
   - If you want to view mapped instances, double-click “DI (PRG)”.

With the “Map to Existing DUT” command:

- Any device can be mapped only to one input DUT and one output DUT. If you have already mapped an input DUT, only the output DUT is shown in the options list and vice-versa.
- Mapping is also supported at CI level nodes. To create global variables for CI level nodes, the address of the first child is considered.

6.3.1.6.4 Releasing DUT mapping
This command is enabled on an IO device only when an IO device is mapped either to input, output or both DUTs. You can use this command to release (or revert) mappings and to delete global variables created during ’Map to Existing DUT’.

Right-click on an IO device and select “Release DUT Mapping”. The mapped DUT instance is deleted.

6.3.1.6.5 Using DUT variables in CODESYS application
1. In the Automation Builder project, double-click “Application” to launch CODESYS application.
   - CODESYS application is launched. CODESYS application contains mapped DUT instances.
2. Double-click “PLC_PRG” to create DUT variables.
3. Add DUT variables based on mapped DUTs.
For further information on mapping DUTs, see section “Chapter 6.3.1.6.3 ‘Mapping to existing DUT’” on page 1442.

For example, in the PLC_PRG, add analog I/O and digital I/O. If you insert a dot at a position where an identifier should be inserted, then a selection list is open, offering all the input and output variables which are found in the project.

After adding DUT variables, rebuild the program in CODESYS application using “Project ➔ Rebuild”.

6.3.1.6.6 Support for CI level node

The user can create DUTs for the entire hierarchy of CI level node (for example, IO_BUS), by right-clicking on the desired CI level node and by selecting “Generate DUT”. Further, all the DUTs are generated in “Application ➔ App ➔ IO_Device_Generated_Items” folder.

- The command generates DUT for the node itself and also for all child nodes.
- The DUT generated for the CI level node contains generated DUTs for the child nodes as their members.
- For every execution, the command checks, if any new child node is added and generates DUT.

If you delete child nodes in CI level node (for example, IO_BUS), the DUTs generated for these child nodes are not deleted automatically. You should delete the DUTs manually in the “Application ➔ App ➔ IO_Device_Generated_Items” folder if desired.

6.3.1.6.7 Configuration check

Configuration check for size is enabled to ensure that all devices are mapped with DUTs of the correct size. In case of any changes in the mapped DUT, configuration check verifies the size of the DUT. If it fails, an error message is displayed in Automation Builder messages window and does not allow to launch the application. This check can be performed in “Create configuration data”.

6.3.1.6.8 Flexible Configuration

For improved maintenance AC500 V3 PLCs provide the functionality to handle several S500 devices with a flexible configuration. The application example AC500 V3 - Flexible Configuration demonstrates how to configure a flexible configuration scenario in AC500 V3 PLCs.

6.3.2 PLC devices and components

6.3.2.1 Device repository

The Device Repository of Automation Builder manages the pool of devices that can be used in the PLC configuration.

You install or uninstall devices in the “Device Repository” dialog box. The system installs a device by reading the device description files, which define the device properties for configurability, programmability, and possible connections to other devices.

You can use the devices provided in the device repository by adding them to the device tree of your project.
Dialog device repository

1. Click “Tools ➔ Device Repository”.
   ⇒ The “Device Repository” dialog box opens.

   [Edit Locations]: Changes the default repository location. The devices can be managed at different locations.
   [Install] / [Uninstall]: Installs or uninstalls devices.
   [Renew device repository]: Updates the device list, e.g. after uninstallation of a device.
   [Details]: Provides technical details on the selected device.

2. Select the install location. “System Repository” is set by default.

Installing devices

The device repository cannot be changed manually, e.g. by copying or deleting files. Use always the “Device Repository” dialog to add or remove devices.
1. Click [Install] and select the appropriate file format.
   ⇒ The “Install Device Description” dialog box opens.

2. Select the file path of the device description.
3. Select the file type filter of the required device description.
   ⇒ All device descriptions of the selected file type are listed.
4. Select the required device description and click [Open].
   ⇒ Automation Builder adds the device description to the matching category of your device repository.
   If errors occur during installation (for example, missing files that are referenced by the device description), then Automation Builder displays them in the lower part of the “Device Repository” dialog box.

During the installation the device description files and all additional files referenced by that description will be copied to an internal location. Altering the original files will have no further effects to an internal location.

The changes take only effect after reinstalling the corresponding device(s).

The version number shown in the information section of the device should be verified.

Uninstalling devices

Select the device you want to remove and click [Uninstall].
The device is removed from the list.

Uninstalled devices which are used in existing projects are indicated by the symbol 📣. The device will not be configured properly.
6.3.2.2  PLC start-up
6.3.2.2.1  Initialization of AC500 V3 CPU

To initialize an AC500 V3 CPU, you need to download the firmware. A new CPU has no pre-installed firmware, it is delivered with a boot loader only. You need to download a valid firmware to the CPU. See Chapter 6.3.1.4.3 “Installation and update of the AC500 V3 firmware” on page 1422. After download, the functionality of the CPU is given.

6.3.2.2.2  PLC runtime licensing

Introduction

The use of some libraries and devices require the PLC to have a runtime license. If you have purchased such a license, activate the license.

Chapter 6.3.2.2.2.2 “Activating a runtime license via license key” on page 1446

If you want to test device functionality or library features in advance, you can activate a demo license in advance.

Chapter 6.3.2.2.3 “Activating a demo license” on page 1450

The license status of a PLC can be displayed at any time.

Chapter 6.3.2.2.2.6 “View license information” on page 1453

Activating a runtime license

The linked application note provides step-by-step instructions on how to activate the runtime license for the PLC.

AC500 V3 Activating a runtime license

Activating a runtime license via license key

General

The use of some libraries and devices require the PLC to have a runtime license.

☐ PC and PLC are connected. In case of no connection, perform the activation via memory card Chapter 6.3.2.2.2.4 “Licensing via memory card” on page 1450.

☐ There is a connection to the Internet. In case of no connection, perform the activation on another PC with internet connection Chapter 6.3.2.2.2.2 “Activation without internet connection” on page 1447.

1. Right-click on the PLC and select “PLC runtime licensing” from the “Runtime Licensing” menu.
   ➔ A wizard starts. Follow the instructions.

2. Enter the license activation key and select “Next” to finish the licensing procedure.
   ➔ The license is activated on the PLC device.

   If the license shall be used on another PLC device, the installed license can be returned Chapter 6.3.2.2.2.5 “Returning a license” on page 1452.
Activation without internet connection

1. If an error occurs when communicating with the ABB license server, or if Automation Builder is running on a PC without internet connection, then it is possible to manually complete the ABB license server interaction by using another PC (with internet connection).

2. In the error dialog select [Next] and save the license activation request file to a storage location the other PC can access, e.g. a file share.
3. In the dialog the web address of the ABB license server is displayed (http://lc.codemeter.com/32838/depot/index.php). From the PC with internet connection, upload the license activation request file.

4. After the upload, download and save the license activation file from the ABB license server. Transfer this file to the PC without Internet connection.

5. Select [Next] to continue the license activation process. Click [Cancel] to continue the license activation process at a later time. Further information on page 1449.
6. Select [Browse] and select the license activation file (*.WibuCmRaU) from the defined storage location.
   - The license is validated by the ABB license server and afterwards activated on the PLC device.
   - If the license shall be used on another PLC device, the installed license can be returned
     \(\Rightarrow\) Chapter 6.3.2.2.2.5 “Returning a license” on page 1452.

7. To complete the licensing process, a license receipt file must be uploaded to the ABB license server.
   - Save the license receipt file and upload it manually from a PC with internet connection to
     \(\text{http://lc.codemeter.com/32838/depot/index.php}\).
   - A license confirmation is returned.

**Offline activation**

If the runtime licensing process was closed between saving the license activation request file and obtaining the license activation file from the ABB license server, perform an offline activation:

1. Right-click on the PLC node and select “PLC runtime licensing” from the “Runtime Licensing” menu.
   - A wizard starts. Follow the instructions.

2. Select the option “Complete offline licensing process”.

3. Select [Browse] and select the license activation file (*.WibuCmRaU) from the defined storage location.
   - The license is activated on the PLC device.
   - If the license shall be used on another PLC device, the installed license can be returned
     \(\Rightarrow\) Chapter 6.3.2.2.2.5 “Returning a license” on page 1452.

4. To complete the licensing process, a license receipt file must be uploaded to the ABB license server.
   - Save the license receipt file and upload it manually from a PC with internet connection to
     \(\text{http://lc.codemeter.com/32838/depot/index.php}\).
   - A license confirmation is returned.
Activating a demo license

It is possible to try out device features or library features by using a demo license on the PLC. With this, you can use the features for a limited time period.

- PC and PLC device are connected. In case of no connection, perform the activation via memory card ⇒ Chapter 6.3.2.2.4 “Licensing via memory card” on page 1450.
- There is a connection to the Internet. In case of no connection, perform the activation on another PC with Internet connection ⇒ Chapter 6.3.2.2.2.2 “Activation without internet connection” on page 1447.

1. Right-click on the PLC node and select “PLC runtime licensing” from the “Runtime Licensing” menu.
   ⇒ A wizard is started. Follow the instructions.
2. Select the option “Create a demo license” and click [Next] to finish the licensing procedure.
   ⇒ The demo license is validated by the ABB license server and afterwards activated on the PLC device.

The demo license is valid for all licensed features and the duration of the demo license is 10 days PLC in run.

As it is a demo license, there is no grace period after expiration (product licenses do not have an expiration date).

The demo license can be extended any numbers of times. After expiration, the PLC will not switch back to run mode until a new license is activated or the features requiring a runtime license are removed from the PLC application.

For AC500 V3 it is visible on the display, if the PLC is running on demo license.

Licensing via memory card

Wibu memory card

NOTICE!
After removing a Wibu memory card (which holds the AC500 runtime license), the PLC system moves into 'Stop' mode after 24 h.
Ensure to insert the Wibu memory card at the time.

The Wibu memory card is different from the "normal" memory card that is required in the following section. The Wibu memory card is an external product that allows you to use the runtime license on different PLCs if you have several PLCs. Please note the notice at the beginning of the chapter.

When you have no connection between your PC and the PLC device the licensing procedure can be done via a memory card.

On the PC:
Create a license request

- There is a connection to the internet.
- The memory card can be used with AC500 V3 products.
NOTICE!
If a SDCard.ini file is stored on the memory card, the file will be overwritten.

1. Place the memory card in the PC.
2. Right-click on the PLC node and select “Prepare PLC license SD memory card” from the “Runtime Licensing” menu.
3. From the file system select the root folder of the memory card.
   ➨ A success message is displayed when the creation of the memory card files is completed.
   The license request files are stored to the selected folder.

On the PLC:
Transfer the license data

1. Insert the memory card into the PLC device and reboot the PLC.
   ➨ When the license request file is successfully created by the PLC, “done” is shown on the display of the PLC.
2. Remove the memory card from the PLC.

On the PC:
Enter the license activation key

1. Place the memory card into the PC.
2. Open the PLC project in Automation Builder. Ensure the PLC is logged out.
3. Right-click on the PLC node and select “PLC runtime licensing” from the “Runtime Licensing” menu.
   ➨ A wizard is started. Follow the instructions.
4. Enter the license activation key.
5. From the filesystem, select the root folder of the memory card.
   ➨ The previously created license request files are sent to the ABB license server. A license activation is created on the memory card.
6. Remove the memory card from the PC.

On the PLC:
Complete license activation for the PLC

1. Insert the memory card into the PLC device and reboot the PLC.
   ➨ “done” is displayed on the PLC if license activation was successful.
2. Remove the memory card from the PLC.
Trying to activate a runtime license, that has already been activated (e.g. via an online connection), will result in following error in the sdcard.rdy file:

;Result of license file import
ImportLicense=13;Internal Error (1)

For this action, internet connection is required.

To complete the licensing process, the license receipt file must be uploaded to the ABB license server.

1. Place the memory card into the PC.

The license receipt on the memory card is located in the subfolder license

⇒ A license confirmation is returned.

Returning a license

NOTICE!
After returning a AC500 runtime license, the PLC system moves into “Stop” mode after 24 h.

Returning a license without memory card

A license which has been installed on a PLC device can be returned and installed on another PLC device.

☐ PC and PLC device are connected. In case of no connection, perform the activation via memory card ⇒ “Returning a license via memory card” on page 1452.
1. Right-click on the PLC node and select “Return active license” from the “Runtime Licensing” menu.
   ⇒ A wizard is started. Follow the instructions.
2. Enter the license activation key and click “Return license”.
   ⇒ The results of the return process will be displayed in the dialog.
   The license from the PLC device is removed and can be used now for another PLC device.

Returning a license via memory card

When the PLC is not connected to the PC (PLC logged out) it is possible to return a license via memory card.
1. Insert the memory card in the PC and execute “Runtime Licensing ➔ Prepare PLC license SD card” on the PLC node.
2. Place the memory card into the PLC.
3. Perform “power cycle” after a successful update reboot the PLC and connect to the PLC.
   ➔ The License is removed from the PLC.
4. Place the memory card into the PC.
5. Right-click on the PLC node and select “Return active license” from the “Runtime Licensing” menu.
   ➔ A wizard is started. Follow the instructions.
6. Enter the license activation key and click “Return license”.

7. Click [Browse] and select the root folder of the memory card.
   ➔ Returning of the license is started.
8. Place the memory card in the PLC device and reboot the PLC.
   ➔ The license from the PLC device is removed and can be used now for another PLC device.
9. To complete the licensing process, a license receipt file must be uploaded to the ABB license server.
   Save the license receipt file and upload it manually from a PC with internet connection to http://lc.codemeter.com/32838/depot/index.php.
   ➔ A license confirmation is returned.

View license information

To view the license information of AC500 V3 products:
1. In the Automation Builder device tree double-click on the PLC node.  
   ⇒ The PLC tab is opened.

2. In the PLC tab select “License Information”.

   ⇒ The project is scanned for required licenses.
   If you are logged into a PLC, then the licenses available on the PLC are displayed.
   Missing required licenses are highlighted.
6.3.2.2.3 Connection of devices

Configuring devices

All installed devices that are available in Automation Builder are listed in the device repository.  
\(\text{Chapter 6.3.2.1 “Device repository” on page 1443}\)

Modify your Automation Builder project by adding device objects. Preset items can be replaced in the same way.

1. In the device tree, right-click an item node. Select [Add object].

2. Select the desired object and click [Add object].

3. Double-click the new object in the device tree to configure the device settings. Depending on the selected item different configuration tabs are available.

Update of AC500 devices

Perform a firmware update to update AC500 V3 devices.  
\(\text{Chapter 6.3.1.4.3 “Installation and update of the AC500 V3 firmware” on page 1422}\)
Comparing objects

To compare similar objects within a project (such as the project configuration) select both objects. Right-click and select "Compare Objects" to see the differences.

6.3.2.4 IP settings

Configuration of the IP address

The IP address for AC500 devices can be set or changed in Automation Builder using

● the IP configuration tool which is described in the following.
● the Communication Settings. Chapter 6.3.2.4.4 "Configuration of communication via Ethernet (TCP/IP)" on page 1469

As an alternative the IP address can be changed at the hardware device itself. Chapter 6.8.2.5.5 "Description of the function keys" on page 4457

NOTICE!

For any AC500-ETH device where the IP address can be set, the IP: 0.0.0.0 is invalid and should not be set.

This may cause damage to the PLC and/or the communication module.

Configuration of the IP settings with the LED display

The IP settings for the PLC can be set directly on the processor module via keypad and LED display.

Chapter 6.8.2.5.5.5 "CFG - configuration" on page 4462
Configuration of the IP settings with the IP configuration tool

Introduction

The IP configuration tool can be used
● to set or change the IP address of devices.
● to scan the network for available hardware devices.
● to update the firmware of devices.
    This functionality is only supported if the IP configuration tool is used stand-alone.
● to activate certain functionality on hardware devices.
    This feature is only available on AC500 V3 devices.

The IP configuration tool is part of Automation Builder and can be called via “Tools ➔ IP-Configuration”.

Further the IP configuration tool can be used stand-alone without an Automation Builder application running. The stand-alone variant requires a separate installation via the Installation Manager ➔ Chapter 6.3.2.2.4.3.2 “Stand-alone installation” on page 1457.

After the installation, the IP configuration tool is started via .exe file / desktop icon.

Some functionality is only supported if the IP configuration tool is used stand-alone, e.g. for firmware updates for communication interface devices.

Stand-alone installation

The IP configuration tool is part of Automation Builder and can be called via “Tools ➔ IP-Configuration”. A separate installation is only required if the IP configuration tool shall be used stand-alone.
1. Open the Installation Manager in Automation Builder: “Tools ➤ Installation Manager”.

2. Close all other instances of Automation Builder as only one instance of the program can be executed at a time.
3. Click [Modify] and select the “IP Configuration Tool” from the structure tree.

4. Click [Continue] to start the installation.

   ⇒ After a successful installation the IP configuration tool is available as stand-alone tool (.exe).

   ⇒ To start the IP configuration tool, click the new created desktop icon.

**Network scan**

With a network scan all devices that have been found in the network by the scan process are listed, i.e. ABB devices such as AC500 processor modules, AC500 communication interface modules or ABB drives.
1. Start the IP configuration tool in Automation Builder (“Tools ➔ IP-Configuration”) or start it stand-alone (.exe).

2. The “IP-Configuration” dialog opens. Define the device type for the network scan by selecting the desired option under “Scan Protocol”:
   - “ABB Net config protocol”: Use this option for AC500 devices such as processor modules, Cl5xx-Modbus devices or ABB drives. The device(s) to be scanned must be connected to the PC via a direct Ethernet connection.
   - “Profinet Dynamic Configuration Protocol (DCP)”: Use this option for PROFINET communication interface modules. The device(s) to be scanned must be connected to the PC via a direct Ethernet connection (not via CM579). For the scan, a NPcap driver needs to be installed separately.
   - “EtherCAT”: Use this option for EtherCAT communication interface modules. The Ethernet cable must be connected directly to the first EtherCAT slave device of the EtherCAT fieldbus. Ensure that no EtherCAT master device is available on the bus when a scan is performed. “Emergency” option: Enable this option to check on failures in the EtherCAT assembly during the scan process, i.e. a frame loss or interchanged ports. Errors are displayed. For the scan, a NPcap driver needs to be installed separately.

3. Click [Scan] to start the scan process.
4. All devices that have been found in the network are listed including hardware and connection details. The following details can be changed under “IP settings”:
   - “IP Address”: Current IP address of the device.
   - “Conf. IP Address”: Configured IP address of the device. A changed IP address will update this column.
   - “FW Version”: Current installed firmware version of the device. This field is visible not until a first network scan. If this field is still empty after a network scan, check on connection errors.

   The IP address of some devices, e.g. EtherCAT devices cannot be changed.

Changing the IP address

1. In order to change the IP address of devices perform a network scan.
   - Chapter 6.3.2.4.3.3 “Network scan” on page 1459
2. Select a device from the list and select the appropriate protocol under “Scan protocol”.
   - “DHCP” or “BOOTP” option: If required, DHCP or BOOTP can be used to receive the IP address for the device from the server.
   - “IP address”, “subnet mask”, “Std. gateway”: Use these fields to change the IP address settings including the settings for the subnet mask and the standard gateway. Ensure that the combination of connection settings is correct.

   Note for CI52x-Modbus devices
   Consider the behavior of CI52x-Modbus devices if the last number of the IP address is set to “0”.
   - “Check last number of IP address” on page 1462
3. Change the settings for the IP configuration and click [Send settings] to transmit the data to the device.

![IP-Configuration screenshot](image)

**Note for PROFINET devices**

The device name of PROFINET devices can be edited. If changing the name, ensure the following rules apply:
- Labels must be separated by "."
- Total length: 1 to 240
- Label length: 1 to 63
- Labels can consist of characters [a-z] and numbers [0-9]
- Labels are not allowed to start with "-"
- Labels are not allowed to end with "-"

4. In order to keep all IP changes after a power cycle, the settings can be stored permanently. Confirm the prompted message during the scan process.

**Check last number of IP address**

This hint is only valid for CI52x-Modbus devices.

Check the last number of the IP address. If it is set to "0", the IP address setting for this last number will be used from the rotary switches on the hardware device.

**Example:**
## Automation Builder

<table>
<thead>
<tr>
<th>IP address:</th>
<th>192.168.14.0</th>
<th>IP address:</th>
<th>6</th>
</tr>
</thead>
</table>

As a result, in the field “IP Address” the last number is set to “6”:

### Firmware update

The firmware of AC500 communication interface modules can be updated with the IP configuration tool.

For this, the IP configuration tool must be used as stand-alone variant.

☞ Chapter 6.3.2.2.4.3.2 “Stand-alone installation” on page 1457

It is not possible to perform a firmware update out of Automation Builder.

- For PROFINET communication interface modules a firmware update is only supported for devices with firmware version ≥ 3.3.3.
- For EtherCAT communication interface modules a firmware update is only supported for devices with firmware version ≥ 2.1.4.
- For Modbus communication interface modules a firmware update is only supported for devices with firmware version ≥ 3.2.13.

### Requirements:

**Before the firmware update**

- Ensure a fast and stable network connection
- Close all unused applications on the executing PC
- Stop the communication between AC500 PLC and the communication interface module that shall be updated
During the firmware update

- Do not close the IP configuration tool
- Do not open Automation Builder software or any other application
- Do not switch-off the communication interface module that shall be updated
- Do not disconnect the Ethernet connection of a communication interface module or the executing PC

The firmware update will stop the operation of the affected device(s). Hence, the device(s) will become unresponsive for 1 - 2 minutes.

Procedure:

1. Start the IP configuration tool stand-alone (.exe).
2. Perform a network scan.
   - Chapter 6.3.2.2.4.3.3 “Network scan” on page 1459
3. Select the devices that shall be updated from the list and click [Scan] to trigger the scan process.
   A multiple selection of several devices is possible via control key, however, ensure to select only devices of the same protocol at a time. Otherwise the firmware update fails.
4. This step is only required for devices that require an installed NPcap driver. In this case an appropriate message including a download link is prompted in the IP-Configuration dialog:

   - Click on the displayed link https://nmap.org/download.html and download the latest version of the npcap-X.X.exe file.

   - After the download, execute the file as administrator and restart the scan process.
   - The devices that have been scanned are listed.
5. Click [Update Firmware] to start the firmware update for the selected devices.

6. For CI50x, CI51x and CI52x devices a signature check is started. Select the appropriate firmware update file (*.bin) for the device(s). Example: C:\AC500\AC500_CI52x_Firmware_V3.2.8.bin.

After a successful signature check the firmware update file (*.bin) and the respective signature file (*.bin.sig) are transferred to the device. This can last up to 3 minutes.

If the signature check fails, check the availability of the *.bin file and the *.bin.sig file.

7. A status check followed by a device reboot followed by a second status check is performed automatically.

   After the firmware update all outputs of the updated devices are set to '0'.

   ![Image of IP-Configuration interface]
8. After a successful firmware update the update status or the new firmware version is displayed in the “FW Version” field.

If this field is empty, there possibly is a connection error between the device and the executing PC.

Exception: For EtherCAT devices an empty “FW Version” field does not indicate a connection error.

If the firmware update fails

- check the requirements for the update procedure.
  - “Requirements:” on page 1463
- check the hints for trouble-shooting.
- perform a network scan and repeat the update. If the error still persists power cycle the device and try the update again.
**Blink functionality**

This function activates flashing of the backlight of an AC500 LED display.

1. From the menu, select “Tools ➔ IP-Configuration”.
2. Click [Scan] to trigger the scan process for devices in the network.
   - A progress bar shows the progress. The IP settings of a selected device is displayed below the list and can be edited.
3. Adjust your desired time and click [Blink] to activate flashing.

**Troubleshooting for IP configuration tool**

**Firewall exceptions:** On a standard Windows 7 installation without third party firewall or security tools installed the IP configuration tool should work properly.

The Automation Builder setup installs rules or exceptions for the built-in Windows firewall to allow IPConfig to receive the responses for the IPConfig scan.

To check the Windows firewall is set correctly check the firewall settings.

**Windows 7/ Windows 10:** On the network that is used for communication with the PLC, set “Incoming connections” to “Block all connections to programs that are not on the list of allowed programs”.

If a third party firewall is used these exceptions must be configured manually.

Either exceptions for applications can be entered: Automation Builder and IP configuration tool must be added as application.

Or the protocol and the port number must be given (for IPConfig: UDP protocol and port number 24576).

<table>
<thead>
<tr>
<th>Fault description</th>
<th>Cause</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error - general</td>
<td></td>
<td>Ensure that all requirements have been considered before and during the update procedure.</td>
</tr>
<tr>
<td>The “FW Version” field is empty</td>
<td>Connection error between the device and the executing PC.</td>
<td></td>
</tr>
<tr>
<td>after the network scan or the firmware version has not been updated after the update procedure (only for Modbus devices and PROFINET devices)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fault description</td>
<td>Cause</td>
<td>Remedy</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------</td>
<td>------------------------------------------------------</td>
</tr>
<tr>
<td>Signature check failed</td>
<td>During the firmware update of CI50x, CI51x and CI52x devices a signature check is started. The update procedure expects a firmware update file (<em>.bin) and a signature file (</em>.bin.sig) in the same directory. Without a signature file the signature check will fail.</td>
<td>Example: Firmware update file: C:\AC500\AC500_CI52x_Firmware_V3.2.8.bin Signature file: C:\AC500\AC500_CI52x_Firmware_V3.2.8.bin.sig</td>
</tr>
<tr>
<td>Error: Package timeout</td>
<td>A timeout error may occur due to an unstable network.</td>
<td>Keep the executing PC as near as possible to the devices that shall be updated. Avoid network switches.</td>
</tr>
<tr>
<td>Error: Unable to read device status</td>
<td>A read error may occur due to errors in the firmware update protocol. After the firmware update the IP configuration tool reads out the status of the updated device in order to check if the update was successful.</td>
<td>Perform the update again.</td>
</tr>
<tr>
<td>Error: IP is not unique</td>
<td>If an IP address is obtained by more than one device an error occurs. A firmware update is not possible.</td>
<td>Change the IP addresses.</td>
</tr>
<tr>
<td>Error: Error State</td>
<td>Internal device error during the firmware update.</td>
<td></td>
</tr>
<tr>
<td>Error: Can’t connect to device</td>
<td>The TCP communication is not sufficient.</td>
<td>Increase the connection quality. Keep the executing PC as near as possible to the devices that shall be updated. Avoid network switches.</td>
</tr>
</tbody>
</table>

**Configuration of communication via Ethernet (TCP/IP)**

**General**

Programming via Ethernet is only possible on a PC with Ethernet board and installed network. Programming can be done via the internal (onboard) Ethernet communication module.

An application note describes the configuration of an AC500 V3 PLC for **EtherNet/IP communication**.
Enter a known PLC IP address

1. Right-click the top node “PLC_AC500 <...>” and select “Communication Settings” from the context menu.
   ⇒ Dialog box “Communication Settings <...>” appears.

2. Enter your PLC IP Address and click [OK].

Enter PLC IP address by scanning devices

1. Right-click the top node “PLC_AC500 <...>” and select “Communication Settings” from the context menu.
   ⇒ Dialog box “Communication Settings <...>” appears.

2. Click […].
   ⇒ Dialog box “Communication Settings <...>” appears.
3. Click [Scan], select your desired PLC and click [OK].
   ⇒ Entry is transferred to the dialog box “Communication Settings <...>”.
   Click [OK].

4. Click to log in the “PLC_AC500_V3” project.

Enter PLC IP address by [Advanced Settings...]

If a remote gateway instead of a local one has to be used it can be configured in the [Advanced Settings...].

1. Right-click the top node “PLC_AC500 <...>” and select “Communication Settings” from the context menu.
   ⇒ Dialog box “Communication Settings <...>” appears.

2. Enable checkbox “Use advanced settings” and click [Advanced Settings...].
   ⇒ Tab “Communication Settings” opens.

3. Check gateway or change if required.
   ⇒ Successful connection is indicated by green dot on the gateway icon.
4. **Manual entry of the IP address.**

Check IP address or change if required.

5. **Press ENTER to confirm changed IP address.**

   - Successful communication is indicated by green dot on the PLC icon.

6. **Or instead of the last two steps:**

   **Set the IP address via a scan.**

   Click [Scan Network], select your desired PLC and click [OK].

   - Successful connection is indicated by green dot on the gateway icon.

7. Click to log in the “PLC_AC500_V3” project.

**Connect to PLC via hostname**

Automation Builder supports the connection to PLCs via hostname.

To access a V3 PLC via hostname, the user should add the prefix “dns:” in the editor view “Communication Settings” of that PLC.

This enables a login to a V3 PLC via hostname.
Firmware update of a V3 PLC via Automation Builder requires the configuration of the IP-Address in bytes and will not work with any hostname.

6.3.2.5 Online program modification
A fast online program modification of the user program is possible without interrupting the running operation. If data areas should be saved during power OFF/ON, they can be stored in the flash EPROM. An optional battery saves data in the RAM.

6.3.2.3 Processor modules
6.3.2.3.1 Configure a processor module in the device tree

1. Add a processor module to your project. Chapter 6.3.1.2 “Creating a new project” on page 1398
2. Double-click the PLC node in the device tree.
   This will open a new window with tabs for the device configuration:
   - “Communication Settings” Chapter 6.4.1.21.2.8.3 “Tab ‘Communication Settings’” on page 2427
   - “PLC Settings” Chapter 6.4.1.21.2.8.10 “Tab ‘PLC Settings’” on page 2439
   - “Version information” Chapter 6.3.1.4.2.2.1.1 “Version information” on page 1419
   - “Statistics” Chapter 6.9.2.4.2 “Statistics” on page 4646
   - “Files” Chapter 6.4.1.21.2.8.8 “Tab ‘Files’” on page 2437
   - “Log” Chapter 6.9.2.4.3 “Log” on page 4647
   - “PLC Shell” Chapter 6.3.5.6 “PLC shell commands” on page 1756
   - “Users and Groups” Chapter 6.4.1.21.2.8.14 “Tab ‘Users and Groups’” on page 2450
   - “Access Rights” Chapter 6.4.1.21.2.8.15 “Tab ‘Access Rights’” on page 2453
   - “Symbol Rights” Chapter 6.4.1.21.2.8.16 “Tab ‘Symbol Rights’” on page 2458
   - “PM5xxx Hardware” Chapter 6.3.2.3.2 “Changing the processor module type” on page 1475
   - “CPU Parameters” Chapter 6.4.1.21.2.8.4 “Tab ‘Parameters’” on page 2433
   - “IEC Objects” Chapter 6.4.1.21.2.8.13 “Tab ‘<device name> IEC Objects’” on page 2449
   - “I/O mapping list” Chapter 6.3.2.13.8 “I/O mapping list” on page 1572
   - “I/O-Bus I/O Mapping” Chapter 6.9.2.5 “Live values in views with I/O components” on page 4649
   - “Task Deployment” Chapter 6.4.1.21.2.8.18 “Tab ‘Task deployment’” on page 2459
   - “Applications” Chapter 6.4.1.21.2.8.5 “Tab ‘Applications’” on page 2434
   - “Backup and Restore” Chapter 6.4.1.21.2.8.6 “Tab ‘Backup and Restore’” on page 2435
   - “Status” Chapter 6.9.2.4.5 “Status” on page 4648
   - “Diagnosis” Chapter 6.9.1.4.4 “Device diagnosis” on page 4613
   - “Diagnosis History” Chapter 6.9.1.4.5 “Diagnosis history” on page 4614
   - “License Information” Chapter 6.3.2.2.2.6 “View license information” on page 1453
   - “Information” General information about the device (name, vendor, version etc.)
3. Select the “CPU Parameters” tab to configure the parameters for the processor module. Table on page 1555
4. Use the “PM5xxx Hardware” tab for later on changes of “Terminal Base Type” or “Processor Module Type” \( \text{\textcopyright Chapter 6.3.2.3.2 “Changing the processor module type” on page 1475.} \)

5. Select the “I/O mapping list” tab to create mapping variables with better usability support compared to the tree structured view. \( \text{\textcopyright Chapter 6.3.2.13.8 “I/O mapping list” on page 1572.} \)

6. Select the “Backup and Restore” tab to create a backup or restore the project. \( \text{\textcopyright Chapter 6.4.1.21.2.8.6 “Tab ‘Backup and Restore’” on page 2435.} \)

7. Select the “Diagnosis” tab to know what errors have occurred in the project. \( \text{\textcopyright Chapter 6.9.1.4.4 “Device diagnosis” on page 4613.} \)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error LED</td>
<td>On</td>
<td>On</td>
<td>The error LED lights up for errors of all classes, no fail-safe function activated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off by E4</td>
<td>Warnings (E4) are not indicated by the error LED, no fail-safe function activated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off by E3</td>
<td>Warnings (E4) and minor errors (E3) are not indicated by the error LED, no fail-safe function activated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>POU control</td>
<td>Control LED ERR with POU PmErrLedSet</td>
</tr>
<tr>
<td>Check battery</td>
<td>On</td>
<td>On</td>
<td>The presence of the battery and the battery status are checked. If no battery is available or the battery is empty, a warning (E4) is generated and the ERR LED lights up.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>The presence of the battery is not checked. No warning (E4) is generated. The LCD display “Batt” (triangle) can not be acknowledged! This also applies if a battery is installed but empty.</td>
</tr>
<tr>
<td>Stop on error class</td>
<td>Diagnosis of at least error class 2</td>
<td>Diagnosis of at least error class 2</td>
<td>In case of a fatal or severe error (E1-E2), the user program is stopped.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Diagnosis of at least error class 3</td>
<td>In case of a fatal, severe or minor error (E1-E3), the user program is stopped.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Diagnosis of at least error class 4</td>
<td>In case of a fatal, severe or minor error (E1-E3) or a warning (E4) the user program is stopped.</td>
</tr>
<tr>
<td>Diagnosis - Add PLC name to node name</td>
<td>Off</td>
<td>Off</td>
<td>Diagnosis - Add PLC name to node name.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>PLC behavior after voltage dip</td>
<td>Halt</td>
<td>Halt</td>
<td>Behavior of the PLC after short voltage dip: reboot or halt.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Reboot</td>
<td></td>
</tr>
<tr>
<td>Diagnosis history</td>
<td>On</td>
<td>On</td>
<td>Enable the diagnosis history.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>Disable the diagnosis history.</td>
</tr>
<tr>
<td>Max. Diagnosis history entries</td>
<td>1000</td>
<td>1000</td>
<td>Max. number of entries kept by the diagnosis history.</td>
</tr>
<tr>
<td>Missed cycle behavior</td>
<td>Next</td>
<td>Next</td>
<td>Skip the current cycle and start task in time on next cycle.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ASAP</td>
<td>Start the task immediately.</td>
</tr>
</tbody>
</table>
### 6.3.2.3.2 Changing the processor module type

**General**

In a project, you can change the target system by changing the type of processor module or terminal base type. If possible, the device configuration of fieldbuses and interfaces is kept and switched over to the device configuration of the new module.

Target change options:
- between platforms: from V2 platform to V3 platform (and vice versa)
- between module types: from AC500 (standard) to AC500-eCo (and vice versa)
- a combination of changed platform and changed module type

**Target change from a V2 processor module to a V3 processor module**

Target change options:
- AC500 V2 processor module to AC500 V3 processor module
- AC500 V2 processor module to AC500-eCo V3 processor module
- AC500-eCo V2 processor module to AC500-eCo V3 processor module
- AC500-eCo V2 processor module to AC500 V3 processor module

**Procedure:**

1. Close CODESYS.
2. Double-click the “PLC_AC500_V2 <...>” node and open the “PM<...> Hardware” tab.
3. Enable “Change to AC500 V3 PLC” and select the desired V3 processor module from the “PM5xx Type” drop-down list.

4. Click [Create V3 PLC].
   - The new V3 processor module is displayed in the navigation tree.
   - Change the node name of the processor module, if desired.

In case of a target change from AC500-eCo V2 to AC500-eCo V3, the I/O bus and Ethernet configuration is kept.

Target change from a V3 processor module to another V3 processor module

Target change options:
- AC500 V3 processor module to AC500 V3 processor module
- AC500 V3 processor module to AC500-eCo V3 processor module
- AC500-eCo V3 processor module to AC500 V3 processor module
- AC500-eCo V3 processor module to AC500-eCo V3 processor module

Procedure:
1. Close CODESYS.
2. Double-click the “PLC_AC500_V3 <...>” node and open the “PM5<...> Hardware” tab.
3. Select the desired V3 processor module from the "PMxx Type" drop-down list.

Fig. 271: Change_Hardware_V3
4. Ensure the correct "Terminal Base Type" is selected and click [Change PM / TB type].
   
   - If possible, the device configurations from the previous processor module will be kept and switched over to the new processor module.
   - The device configurations that cannot be kept are listed in a prompted information dialog.

   ![Automation Builder](image)

   By default, all device configurations which cannot be switched over will be copied to a "device pool" section in the navigation tree (option "Copy all objects that cannot be added to the new PLC into a device pool for further access"). If required, this backed-up configuration can be used in another project or in another processor module configuration.

   If the checkbox is deactivated all device configurations that cannot be switched will be lost after the execution of the target change.

   ![Configuration and programming](image)

   **Target change from AC500-eCo V3 to AC500 V3**

   The configuration of the onboard I/Os, the option board slots and the onboard RTC cannot be changed-over to the new module.

   **Target change from AC500 V3 to AC500-eCo V3**

   The configuration of COM1, CAN and the I/O bus cannot be changed-over to the new module. Depending on the selected target, also the I/O bus configuration and ETH2 configuration cannot be switched.

   ETH1 configuration is kept even if the configured protocols are not allowed for the selected AC500-eCo V3 PLC. In this case error messages are displayed in the messages window.
Libraries which are not used anymore are not deleted with the target change. Libraries of option boards are kept in the Library Manager even if no longer available at the target module.

### 6.3.2.3 Changing the processor module type for AC500-eCo V3 CPU

It is not possible to change from an AC500 V3 processor module to an AC500-eCo V3 processor module! Changing an AC500-eCo V3 processor module to another AC500-eCo V3 processor module is possible and the same limitation as listed before are applying, only the available or possible feature from the new processor module will be kept from the old processor module.

- Close CODESYS.

1. Double-click the “PLC_AC500_V3 <...>” node.

2. Open the “PM50xx Hardware” tab and select the new “PM50xx Type” from the drop-down list.

### 6.3.2.3.4 Parameters of the processor module

**Automated reboot after E2 error**

The parameter “Automated reboot after E2 error” allows to set the behavior of the CPU in case of severe errors (class E2).
If the default setting “Off” is used, no automated rebot after an E2 error is performed. If the setting “On” is used, an automated rebot after an E2 error is performed.

PLC behaviour after voltage dip

The parameter “PLC behaviour after voltage dip” allows to set the behavior of the CPU in case of short voltage dips.

If the default setting “Halt” is used, the CPU is changed to STOP mode if a short voltage dip >10 ms occurs. A new powercycle is required. If the setting “Reboot” is used, CPU will reboot after power supply has recovered to nominal value.

Floating point values

A calculation with floating points can lead to the following values:

0 (zero)

If a calculation results in an underrun, the value is set to 0 (result near 0, but not presentable). Depending on the sign bit, it can be a positive zero or a negative zero. The operator “=” of -0 and 0 returns TRUE.

Infinity

If a calculation results in an overrun, the value is set to Infinity (the result is not presentable). Depending on the sign bit, it can be a positive infinity (Infinity) or negative infinity (-Infinity). If Infinity is converted into another data type it results in the maximum value of the other data type (e.g., conversion into DWORD with REAL_TO_DWORD: 16#FFFFFFFF, into DINT with REAL_TO_DINT: 16#7FFFFFFF).

If -Infinity is converted into another data type it results in the maximum value of the other data type (e.g., conversion into DWORD with REAL_TO_DWORD: 16#00000000, into DINT with REAL_TO_DINT: 16#80000000).

Except for:
TRUE := REAL_TO_BOOL(Infinity);
'Inf' := REAL_TO_STRING(Infinity);
'-Inf' := REAL_TO_STRING(-Infinity);
Infinity := 1.0 / 0.0 -Infinity := -1.0 / 0.0
Infinity := Infinity + Infinity -Infinity := -Infinity -Infinity
Infinity := Infinity + 1.0 -Infinity := -Infinity + 1.0
Infinity := LREAL_TO_REAL(Infinity) -Infinity := LREAL_TO_REAL(-Infinity)

Examples:

NaN

If a calculation results in an undefined value the result is set to NaN (Not a Number). The result of each calculation with NaN is NaN. The operators "<", "<=", ">" and ">=" return FALSE if either or both operands are NaN.

Operator "=" returns FALSE if one operand is NaN.
Operator "<>" returns TRUE if one operand is NaN.
If NaN is converted into another data type the result is 0.
Except for:

TRUE := REAL_TO_BOOL(NaN);
'NaN' := REAL_TO_STRING(NaN);

Examples:
NaN := SQRT(-2.0)
NaN := 0.0 / 0.0
NaN := Infinity -Infinity
NaN := 0.0 * Infinity
NaN := Infinity / Infinity

The result of an operation can be checked with the following program parts:

Check for NaN (REAL):

Check for NaN (LREAL):

| rX: REAL; | lrX: LREAL; |
| IF (rX <> rX) THEN | IF (lrX <> lrX) THEN |
| (* rX is a NaN *) | (* lrX is a NaN *) |
| ...; | ...; |
| END_IF; | END_IF; |
### Check for Infinity (REAL):

Infinity is represented with sign bit 0, exponent of all 1s and a fraction of all 0s.

- Infinity is represented with sign bit 1, exponent of all 1s and a fraction of all 0s.

```pascal
rX: REAL;
prX: POINTER TO REAL;
pdwX: POINTER TO DWORD;
prX := ADR(rX);
pdwX := prX;
IF (pdwX^ = 16#7F800000) THEN (* rX is Infinity *)
    ...;
END_IF;
IF (pdwX^ = 16#FF800000) THEN (* rX is -Infinity *)
    ...;
END_IF;
```

```pascal
lrX: LREAL;
plrX: POINTER TO LREAL;
plwX: POINTER TO LWORD;
plrX := ADR(lrX);
plwX := plrX;
IF (plwX^ = 16#7FF0000000000000) THEN (* lrX is Infinity *)
    ...;
END_IF;
IF (plwX^ = 16#FFF0000000000000) THEN (* lrX is -Infinity *)
    ...;
END_IF;
```

### 6.3.2.4 AC500-eCo V3 onboard I/Os

According to the used AC500-eCo V3 processor module, the onboard I/Os are different and the functionality of the I/Os are adapted to the processor module type.

<table>
<thead>
<tr>
<th>Onboard I/O combination</th>
<th>PM5012-x-ETH</th>
<th>PM5032-x-ETH</th>
<th>PM5052-x-ETH</th>
<th>PM5072-T-2ETH(W)</th>
<th>PM5082-T-2ETH</th>
</tr>
</thead>
<tbody>
<tr>
<td>6 DI, digital input 24 V DC / 4 DO, digital output transistor 24 V DC / 0.5 A</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6 DI, digital input 24 V DC / 4 DO, digital output relay 240 V AC / 2 A</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12 DI, digital input 24 V DC / 8 DO, digital output transistor 24 V DC / 0.5 A / 2 DC, digital in/out configurable 24 V DC, 24 V DC / 0.5 A</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>12 DI, digital input 24 V DC / 6 DO, digital output relay 240 V AC / 2A / 2 DC, digital in/out configurable 24 V DC, 24 V DC / 0.5 A</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Configure the onboard I/O channel

The onboard I/Os support the following channels functions according to the processor module type:

<table>
<thead>
<tr>
<th>Onboard I/O type</th>
<th>Channel function</th>
<th>PM5012-T-ETH</th>
<th>PM5012-R-ETH</th>
<th>Channel name when available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital input channel total thereof as</td>
<td>Digital input</td>
<td>6</td>
<td>6</td>
<td>D10 ... D15</td>
</tr>
<tr>
<td>Fast input x, max. 5 kHz</td>
<td>Digital input</td>
<td>6</td>
<td>6</td>
<td>D10 ... D15</td>
</tr>
<tr>
<td></td>
<td>Interrupt input</td>
<td>4</td>
<td>4</td>
<td>D10 ... D13</td>
</tr>
<tr>
<td></td>
<td>Fast counter</td>
<td>2</td>
<td>2</td>
<td>D14 ... D15</td>
</tr>
<tr>
<td>Digital output channel total thereof as</td>
<td>Digital output</td>
<td>4</td>
<td>4</td>
<td>DO0 ... DO3</td>
</tr>
<tr>
<td>Fast output x, max. 5 kHz</td>
<td>Digital output</td>
<td>4</td>
<td>4</td>
<td>DO0 ... DO3</td>
</tr>
<tr>
<td></td>
<td>Limit switch</td>
<td>4</td>
<td>-</td>
<td>DO0 ... DO3</td>
</tr>
<tr>
<td></td>
<td>PWM output</td>
<td>4</td>
<td>-</td>
<td>DO0 ... DO3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Onboard I/O type</th>
<th>Channel function</th>
<th>PM5032-T-ETH</th>
<th>PM5052-T-ETH</th>
<th>PM5072-T-ETH(W)</th>
<th>PM5082-T-ETH</th>
<th>Channel name when available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital input channel total thereof as</td>
<td>Digital input</td>
<td>12</td>
<td>12</td>
<td>D10 ... D11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast input x, max. 5 kHz</td>
<td>Digital input</td>
<td>4</td>
<td>4</td>
<td>D10 ... D13</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Interrupt input</td>
<td>4</td>
<td>4</td>
<td>D10 ... D13</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Touch/Reset</td>
<td>4, together with dedicated encoder</td>
<td>4, together with dedicated encoder</td>
<td>D10 ... D13</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast input x, max. 100 kHz</td>
<td>Digital input</td>
<td>4</td>
<td>4</td>
<td>D14 ... D17</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Encoder input</td>
<td>2, with A/B tracks</td>
<td>2, with A/B tracks</td>
<td>D14 ... D17</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Fast counter</td>
<td>4</td>
<td>4</td>
<td>D14 ... D17</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standard input</td>
<td>Digital input</td>
<td>4</td>
<td>4</td>
<td>D18 ... D11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Digital output channel total thereof as</td>
<td>Digital output</td>
<td>8</td>
<td>6</td>
<td>DO0 ... DO7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast output x, max. 5 kHz</td>
<td>Digital output</td>
<td>4</td>
<td>-</td>
<td>DO0 ... DO3</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Limit switch</td>
<td>4</td>
<td>-</td>
<td>DO0 ... DO3</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PWM output</td>
<td>4</td>
<td>-</td>
<td>DO0 ... DO3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast output x, max. 100 kHz</td>
<td>Digital output</td>
<td>4</td>
<td>-</td>
<td>DO4 ... DO7</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Limit switch</td>
<td>4</td>
<td>-</td>
<td>DO4 ... DO7</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PWM output</td>
<td>4</td>
<td>-</td>
<td>DO4 ... DO7</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Onboard I/O

<table>
<thead>
<tr>
<th>Onboard I/O type</th>
<th>Channel function</th>
<th>PM5032-T-ETH</th>
<th>PM5052-T-ETH</th>
<th>PM5072-T-2ETH(W)</th>
<th>PM5082-T-2ETH</th>
<th>Channel name when available</th>
</tr>
</thead>
<tbody>
<tr>
<td>PTO output</td>
<td>2, pair of output, in CW/CCW or Pulse/Direction mode or 4 as Pulse with standard outputs as Direction</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>DO4 ... DO7</td>
</tr>
<tr>
<td>Digital in/output configurable channel total thereof as Digital in/output</td>
<td>2</td>
<td>2</td>
<td>DC12 ... DC13</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standard dig. channel</td>
<td>Digital In/output</td>
<td>2</td>
<td>2</td>
<td>DC12 ... DC13</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast output, max. 100 ... 200 kHz</td>
<td>Limit switch</td>
<td>-</td>
<td>2</td>
<td>DC12 ... DC13</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PWM output</td>
<td>-</td>
<td>2</td>
<td>DC12 ... DC13</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PTO output</td>
<td>-</td>
<td>1, pair of output, in CW/CCW or Pulse/Direction mode</td>
<td>DC12 ... DC13</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

> When debugging AC500-eCo V3 applications and reaching a breakpoint, the onboard outputs are set to zero.

### Basic CPU: PM5012-x-ETH

For all CPU versions the configuration of the input channels is the same. The configuration of the output channels is only available on CPU version with transistor output channels:

![Configuration and programming](image)

Version with relay outputs, same configuration for the input channels, no configuration for the output channels relay:
The following parameter can be configured:

<table>
<thead>
<tr>
<th>Onboard I/O type</th>
<th>Parameter</th>
<th>Channel name</th>
<th>Default value</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital inputs</td>
<td>Input X, input delay</td>
<td>Channel 0..5</td>
<td>8 ms</td>
<td></td>
<td>No delay Confirms input with no delay</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1 ms</td>
<td>Confirms 1 ms input delay</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>8 ms</td>
<td>Confirms 8 ms input delay</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>32 ms</td>
<td>Confirms 32 ms input delay</td>
</tr>
<tr>
<td>Input X, channel configuration</td>
<td>Channel 0..3</td>
<td>Input/Interrupt</td>
<td>Input/Interrupt</td>
<td></td>
<td>Configures the channel as normal digital or interrupt input</td>
</tr>
<tr>
<td>The configuration /function of the following channels is realized using function blocks in the program</td>
<td>Channel 4..5</td>
<td>Input</td>
<td>Input</td>
<td>Encoder 0 track-A or B</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Configures the pair of channels as encoder input track A or B. When that value is configured then both channels are reserved for that functionality</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Forward counter</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Configures the channel as forward counter</td>
</tr>
</tbody>
</table>

The configuration of output channel is only available on the CPU with transistor outputs

<table>
<thead>
<tr>
<th>Digital outputs</th>
<th>Output X, channel configuration</th>
<th>Channel 0..3</th>
<th>Output</th>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Configures the channel as digital output</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Limit switch</td>
<td>Configures the channel as limit switch output</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>PWM</td>
<td>Configures the channel as PWM output</td>
</tr>
</tbody>
</table>
For all CPU versions the configuration of the input channels is the same. The configuration of the output channels is only available on CPU version with transistor output channels, the digital configurable In/Output channels are present on both version (transistor or relay output) but with different features configurable:

### Onboard I/O type

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Channel name</th>
<th>Default value</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital inputs</td>
<td>Input X, input delay</td>
<td>Channel 0..11</td>
<td>8 ms</td>
<td>No delay</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 ms</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>8 ms</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>32 ms</td>
<td></td>
</tr>
<tr>
<td>Fast inputs</td>
<td>Input X, channel configuration</td>
<td>Channel 0..1</td>
<td>Input/Interrupt</td>
<td>Configures the channel as normal digital or interrupt input</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Touch/Reset 0</td>
<td>Configures the pair of adjacent channels as Touch/Reset inputs together with encoder 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Channel 2..3</td>
<td>Input/Interrupt</td>
</tr>
<tr>
<td>Onboard I/O type</td>
<td>Parameter</td>
<td>Channel name</td>
<td>Default value</td>
<td>Value</td>
</tr>
<tr>
<td>----------------</td>
<td>-----------</td>
<td>--------------</td>
<td>---------------</td>
<td>-------</td>
</tr>
<tr>
<td></td>
<td>Touch/Reset</td>
<td>Channel 4..5</td>
<td>Input</td>
<td>Input</td>
</tr>
<tr>
<td>Fast inputs max. 100/200 kHz</td>
<td>The function of the following channels is realized using function blocks in the program</td>
<td>Channel 4..5</td>
<td>Input</td>
<td>Input</td>
</tr>
<tr>
<td>Max. frequency 200 kHz</td>
<td>When that value is configured then both channels are reserved for that functionality</td>
<td>Channel 6..7</td>
<td>Input</td>
<td>Input</td>
</tr>
<tr>
<td>Max. frequency 100 kHz</td>
<td></td>
<td>Channel 6..7</td>
<td>Input</td>
<td>Input</td>
</tr>
<tr>
<td>Fast inputs max. 100/200 kHz</td>
<td>When that value is configured then both channels are reserved for that functionality</td>
<td>Channel 6..7</td>
<td>Input</td>
<td>Input</td>
</tr>
<tr>
<td>Max. frequency 200 kHz</td>
<td></td>
<td>Channel 6..7</td>
<td>Input</td>
<td>Input</td>
</tr>
<tr>
<td>Max. frequency 100 kHz</td>
<td></td>
<td>Channel 6..7</td>
<td>Input</td>
<td>Input</td>
</tr>
</tbody>
</table>

The following configuration of output channel is only available on the CPU with transistor:

<p>| Fast outputs, max. 5 kHz | Output X, channel configuration | Channel 0..3 | Output | Output | Configures the channel as digital output |</p>
<table>
<thead>
<tr>
<th>Onboard I/O type</th>
<th>Parameter</th>
<th>Channel name</th>
<th>Default value</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The configu-</td>
<td>Channel 4..7</td>
<td>Output</td>
<td>Output</td>
<td>Configures \nthe channel as digital output</td>
</tr>
<tr>
<td></td>
<td>ration / fun-</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>cction of the</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>following</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>channels is</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>realized</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>using func-</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>tion blocks</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>in the</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>program</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The func-</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>tion of the</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>following</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>channels is</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>realized</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>using func-</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>tion blocks</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>in the</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>program</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Depending</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>on the OBIO-</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>MotionPTO</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>or OBIO-</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>MotionPWM</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>function</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>block used</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Limit switch</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Configures \nthe channel as limit switch output</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PWM</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Configures \nthe channel as PWM output</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PTO</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Configures \nthe pair of adjacent channels as PTO output or one as pulse and a standard output as direction</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Input/Output</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Configures \nthe channel as digital input/output</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The following configuration of output channel is only available on the CPU with relay outputs

<table>
<thead>
<tr>
<th>Onboard I/O type</th>
<th>Parameter</th>
<th>Channel name</th>
<th>Default value</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The func-</td>
<td>Channel DC12..DC13</td>
<td>Input/Output</td>
<td>Input/Output</td>
<td>Configures \nthe channel as digital input/output</td>
</tr>
<tr>
<td></td>
<td>tion of the following channels is realized using function blocks in the program</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Limit switch</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Configures \nthe channel as limit switch output</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PWM</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Configures \nthe channel as PWM output</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PTO</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Configures \nthe pair of channels as PTO output</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
6.3.2.6 Mapping of the onboard I/O channels

2. Select “12DI/8DO-T/2DC I/O Mapping”.
   ➤ Here, you will map variable names (symbols) for the channels you will need in the program.

3. Open the list of the digital inputs.
4. Fill in the variable names:

<table>
<thead>
<tr>
<th>Channel</th>
<th>Type</th>
<th>Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital input DI0</td>
<td>BOOL</td>
<td>xDI_00_OnBoard_IO_I0</td>
</tr>
</tbody>
</table>
5. Open the list of the digital outputs.
6. Fill in the variable names:

<table>
<thead>
<tr>
<th>Channel</th>
<th>Type</th>
<th>Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital output DO0</td>
<td>BOOL</td>
<td>xStartDrilling1</td>
</tr>
</tbody>
</table>

The suggested name convention is based on the "Hungarian notation". A name prefix is describing variable type: e.g., "x" = variable of type BOOL, "w" = WORD, "i" = INT (integer) etc. This increases the code readability and is helpful for program analysis.

6.3.2.7 Configuration of the onboard I/Os of AC500-eCo V3 PLC
6.3.2.7.1 Digital inputs from the onboard I/Os

Depending on the processor module used, several configurations are possible for the onboard I/Os mostly different per group of channels.

<table>
<thead>
<tr>
<th>Functionality to be realized</th>
<th>Processor module type</th>
<th>Digital input channels</th>
<th>Configuration of the channel to be selected in Automation Builder</th>
<th>Dedicated function block to be used in the user program</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital inputs</td>
<td>PM5012-x-ETH</td>
<td>I0 … I3</td>
<td>Input/Interrupt</td>
<td>Not needed</td>
<td>Input delay can be sometimes configured according to channels type</td>
</tr>
<tr>
<td></td>
<td></td>
<td>I4 … I5</td>
<td>Input</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PM5032-x-ETH, PM5052-x-ETH, PM5072-T-2ETH(W), PM5082-T-2ETH</td>
<td>I0 … I3</td>
<td>Input/Interrupt</td>
<td>Not needed</td>
<td>Input delay can be sometimes configured according to channels type, for the PLC with relay outputs, the digital</td>
</tr>
<tr>
<td>Functionality to be realized</td>
<td>Processor module type</td>
<td>Digital input channels</td>
<td>Configuration of the channel to be selected in Automation Builder</td>
<td>Dedicated function block to be used in the user program</td>
<td>Comments</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------------------</td>
<td>-----------------------</td>
<td>---------------------------------------------------------------</td>
<td>------------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>I8 ... I11</td>
<td></td>
<td>Always inputs, not configurable</td>
<td></td>
<td></td>
<td>configurable channels have some other configurable features.</td>
</tr>
<tr>
<td>C12 … C13</td>
<td></td>
<td>Input/Output</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**6.3.2.7.2 Fast counters in the onboard I/Os**

- General details on fast counters.
- Details on the configuration of the onboard I/Os channels.

Depending on the configuration for the input channels of the onboard I/O from the processor module different functionality are possible which must be used together with the dedicated function block of the user program.
### Functionality to be realized

<table>
<thead>
<tr>
<th>Processor module type</th>
<th>Digital input channels</th>
<th>Configura-</th>
<th>Dedicated function block to be used in the user program</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Forward counter</strong></td>
<td>I0 … I3</td>
<td>I4 … I5</td>
<td>OBIOForwardCounter</td>
<td>Up to 2 forward counters with up to 5 kHz can be used, the other inputs can be used for other purpose</td>
</tr>
<tr>
<td>PM5032-x-ETH,</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PM5052-x-ETH,</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PM5072-T-2ETH(W)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PM5082-T-2ETH</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### A/B Encoder in the onboard I/Os

Depending on the configuration for the input channels of the onboard I/O from the processor module different functionality are possible which must be used together with the dedicated function block of the user program.

<table>
<thead>
<tr>
<th>Functionality to be realized</th>
<th>Processor module type</th>
<th>Digital input channels</th>
<th>Configura-</th>
<th>Dedicated function block to be used in the user program</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>A/B encoder 5 kHz with touch/reset inputs</td>
<td>PM5012-x-ETH</td>
<td>I0</td>
<td>Touch/Reset0</td>
<td>OBIOEncoderCounter</td>
<td>The functionality uses the 4 digital inputs, the other can be used for other purpose</td>
</tr>
<tr>
<td>Functionality to be realized</td>
<td>Processor module type</td>
<td>Digital input channels</td>
<td>Configuration of the channel to be selected in Automation Builder</td>
<td>Dedicated function block to be used in the user program</td>
<td>Comments</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------</td>
<td>------------------------</td>
<td>---------------------------------------------------------------</td>
<td>----------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Up to 2 A/B encoders 200kHz possible with touch/reset standard inputs</td>
<td>PM5032-x-ETH, PM5052-x-ETH, PM5072-T-2ETH(W) PM5082-T-2ETH</td>
<td>I4, I5</td>
<td>Encoder 0 Track A, Encoder 0 Track B</td>
<td>OBIOEncoderCounter</td>
<td>The functionality uses up to the 4 digital fast inputs 200 kHz and the 4 5 kHz, the other inputs can be used for other purpose. Select encoder x track A for an input (I4 or I7) automatically selects the adjacent input for B track</td>
</tr>
<tr>
<td>One A/B encoder 200 kHz with touch/reset</td>
<td>PM5032-x-ETH, PM5052-x-ETH, PM5072-T-2ETH(W) PM5082-T-2ETH</td>
<td>I0, I1, I2, I3, I4, I5, I6, I7, I8 ... I11</td>
<td>Touch/Reset0, Touch/Reset1, Encoder 0 Track A, Encoder 0 Track B, Touch/Reset, Encoder 1 Track A, Encoder 1 Track B, Not relevant for the functionality</td>
<td>OBIOEncoderCounter</td>
<td>The functionality uses the 4 digital fast inputs 200 kHz, the other inputs can be used for other purpose. Select encoder x track A for an input (I4) automatically selects the adjacent input for B track</td>
</tr>
</tbody>
</table>
Example with one encoder

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Value</th>
<th>Default Value</th>
<th>Unit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run on config fault</td>
<td>Enumeration of BYTE</td>
<td>No</td>
<td>No</td>
<td></td>
<td>Start PLC program even on configuration fault</td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 0, input delay</td>
<td>8 ms</td>
<td>8 ms</td>
<td>Fast input 0 - Input delay</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 6, channel configuration</td>
<td>Input/Interrupt</td>
<td>Input/Interrupt</td>
<td>Fast input 0 - Configuration (max. 5 kHz)</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 0, input delay</td>
<td>8 ms</td>
<td>8 ms</td>
<td>Fast input 1 - Input delay</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 6, channel configuration</td>
<td>Input/Interrupt</td>
<td>Input/Interrupt</td>
<td>Fast input 1 - Configuration (max. 5 kHz)</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 2, input delay</td>
<td>8 ms</td>
<td>8 ms</td>
<td>Fast input 2 - Input delay</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 6, channel configuration</td>
<td>Input/Interrupt</td>
<td>Input/Interrupt</td>
<td>Fast input 2 - Configuration (max. 5 kHz)</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 3, input delay</td>
<td>8 ms</td>
<td>8 ms</td>
<td>Fast input 3 - Input delay</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 6, channel configuration</td>
<td>Input/Interrupt</td>
<td>Input/Interrupt</td>
<td>Fast input 3 - Configuration (max. 5 kHz)</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 4, input delay</td>
<td>8 ms</td>
<td>8 ms</td>
<td>Fast input 4 - Input delay</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 6, channel configuration</td>
<td>Encoder 0 Track-A</td>
<td>Input</td>
<td>Fast input 4 - Configuration Forward Counter (max. 100 kHz), Encoder (max. 200 kHz)</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 5, input delay</td>
<td>8 ms</td>
<td>8 ms</td>
<td>Fast input 5 - Input delay</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 6, channel configuration</td>
<td>Encoder 0 Track-B</td>
<td>Input</td>
<td>Fast input 5 - Configuration Forward Counter (max. 100 kHz), Encoder (max. 200 kHz)</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 6, input delay</td>
<td>8 ms</td>
<td>8 ms</td>
<td>Fast input 6 - Input delay</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 6, channel configuration</td>
<td>Encoder 1 Track-A</td>
<td>Input</td>
<td>Fast input 6 - Configuration Forward Counter (max. 100 kHz), Encoder (max. 200 kHz)</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 7, input delay</td>
<td>8 ms</td>
<td>8 ms</td>
<td>Fast input 7 - Input delay</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 6, channel configuration</td>
<td>Encoder 1 Track-B</td>
<td>Input</td>
<td>Fast input 7 - Configuration Forward Counter (max. 100 kHz), Encoder (max. 200 kHz)</td>
<td></td>
</tr>
</tbody>
</table>

Example with two encoders

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Value</th>
<th>Default Value</th>
<th>Unit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run on config fault</td>
<td>Enumeration of BYTE</td>
<td>No</td>
<td>No</td>
<td></td>
<td>Start PLC program even on configuration fault</td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 0, input delay</td>
<td>8 ms</td>
<td>8 ms</td>
<td>Fast input 0 - Input delay</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 6, channel configuration</td>
<td>Input/Interrupt</td>
<td>Input/Interrupt</td>
<td>Fast input 0 - Configuration (max. 5 kHz)</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 0, input delay</td>
<td>8 ms</td>
<td>8 ms</td>
<td>Fast input 1 - Input delay</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 6, channel configuration</td>
<td>Input/Interrupt</td>
<td>Input/Interrupt</td>
<td>Fast input 1 - Configuration (max. 5 kHz)</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 2, input delay</td>
<td>8 ms</td>
<td>8 ms</td>
<td>Fast input 2 - Input delay</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 6, channel configuration</td>
<td>Input/Interrupt</td>
<td>Input/Interrupt</td>
<td>Fast input 2 - Configuration (max. 5 kHz)</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 3, input delay</td>
<td>8 ms</td>
<td>8 ms</td>
<td>Fast input 3 - Input delay</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 6, channel configuration</td>
<td>Input/Interrupt</td>
<td>Input/Interrupt</td>
<td>Fast input 3 - Configuration (max. 5 kHz)</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 4, input delay</td>
<td>8 ms</td>
<td>8 ms</td>
<td>Fast input 4 - Input delay</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 6, channel configuration</td>
<td>Encoder 0 Track-A</td>
<td>Input</td>
<td>Fast input 4 - Configuration Forward Counter (max. 100 kHz), Encoder (max. 200 kHz)</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 5, input delay</td>
<td>8 ms</td>
<td>8 ms</td>
<td>Fast input 5 - Input delay</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 6, channel configuration</td>
<td>Encoder 0 Track-B</td>
<td>Input</td>
<td>Fast input 5 - Configuration Forward Counter (max. 100 kHz), Encoder (max. 200 kHz)</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 6, input delay</td>
<td>8 ms</td>
<td>8 ms</td>
<td>Fast input 6 - Input delay</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 6, channel configuration</td>
<td>Encoder 1 Track-A</td>
<td>Input</td>
<td>Fast input 6 - Configuration Forward Counter (max. 100 kHz), Encoder (max. 200 kHz)</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 7, input delay</td>
<td>8 ms</td>
<td>8 ms</td>
<td>Fast input 7 - Input delay</td>
<td></td>
</tr>
<tr>
<td>Digital inputs 24 VDC</td>
<td>Input 6, channel configuration</td>
<td>Encoder 1 Track-B</td>
<td>Input</td>
<td>Fast input 7 - Configuration Forward Counter (max. 100 kHz), Encoder (max. 200 kHz)</td>
<td></td>
</tr>
</tbody>
</table>

6.3.2.7.4 Configuration of interrupt inputs

Depending on the configuration for the input channels of the onboard I/O from the processor module different functionality are possible which must be used together with the dedicated function block of the user program.
### Functionality to be realized

| Processor module type | Digital input channels | Configura- 
<table>
<thead>
<tr>
<th>module type</th>
<th>to be selected in Automation Builder</th>
<th>tion of the channel to be selected in Automation Builder</th>
<th>Dedicated function block to be used in the user program</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interrupt inputs</td>
<td>PM5012-x-ETH</td>
<td>I0 … I3</td>
<td>Input/Interrupt</td>
<td>OBIO</td>
</tr>
<tr>
<td></td>
<td></td>
<td>I4 … I5</td>
<td>Not relevant for the functionality</td>
<td>InterruptInfo</td>
</tr>
<tr>
<td></td>
<td>PM5032-x-ETH,</td>
<td>I0 … I3</td>
<td>Input/Interrupt</td>
<td>OBIO</td>
</tr>
<tr>
<td></td>
<td>PM5052-x-ETH,</td>
<td>I4 … I11</td>
<td>Not relevant for the functionality</td>
<td>InterruptInfo</td>
</tr>
<tr>
<td></td>
<td>PM5072-T-2ETH(W)</td>
<td></td>
<td></td>
<td>OBIO</td>
</tr>
<tr>
<td></td>
<td>PM5082-T-2ETH</td>
<td></td>
<td></td>
<td>InterruptPara</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Up to 4 interrupt input channels can be used, the other inputs can be used for other purpose</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Creating an interrupt task

After configuring the parameter, the user needs to create a new task with the “Type” set to “External” and the “External event” set to “OnBoard_Binary_Input”.
Please see “Use the onboard I/Os as interrupt input with dedicated interrupt task” in the system technology how to use the function. \(\text{\textcopyright} \) Chapter 6.8.2.15.3.4 “Use the onboard I/Os as interrupt input with dedicated interrupt task” on page 4550

### 6.3.2.7.6 Configuration of digital outputs

According to the processor module type, the digital outputs have several functionalities. To use them as digital output and as default configuration the following configuration is needed:

<table>
<thead>
<tr>
<th>Functionality to be realized</th>
<th>Processor module type</th>
<th>Digital output channels</th>
<th>Configuration of the channel to be selected in Automation Builder</th>
<th>Dedicated function block to be used in the user program</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital Outputs</td>
<td>PM5012-T-ETH</td>
<td>O0 … O3</td>
<td>Output</td>
<td>Not needed</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>PM5012-R-ETH</td>
<td>NO0 ... NO1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>NO2 ... NO3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PM5032-T-ETH,</td>
<td>O0 … O3</td>
<td>Output</td>
<td>Not needed</td>
<td>No other configuration needed</td>
</tr>
<tr>
<td></td>
<td>PM5052-T-ETH,</td>
<td>O4 ... O7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PM5072-T-2ETH(W)</td>
<td>C12 … C13</td>
<td>Input/Output</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PM5082-T-2ETH</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PM5032-R-ETH,</td>
<td>NO0 ... NO2</td>
<td>Output</td>
<td>Not needed</td>
<td>No other configuration needed</td>
</tr>
<tr>
<td></td>
<td>PM5052-R-ETH</td>
<td>NO3 ... NO5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>C12 … C13</td>
<td>Input/Output</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### 6.3.2.7.7 Configuration of outputs as limit switch

The AC500-eCo V33 processor modules provide according to the output variants transistor or relay some output which can be used as limit switch. For the process modules with relay outputs, only the digital configurable channels provide this functionality.

<table>
<thead>
<tr>
<th>Functionality to be realized</th>
<th>Processor module type</th>
<th>Digital output channels</th>
<th>Configuration of the channel to be selected in Automation Builder</th>
<th>Dedicated function block to be used in the user program</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limit switch</td>
<td>PM5012-T-ETH</td>
<td>O0 … O3</td>
<td>Limit Switch</td>
<td>OBIO-LimitSwitch</td>
<td>Up to 4 limit switches</td>
</tr>
<tr>
<td></td>
<td>PM5012-R-ETH</td>
<td>NO0 … NO1</td>
<td>Not relevant for the functionality</td>
<td></td>
<td>Relay outputs without other functions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NO2 … NO3</td>
<td>Not relevant for the functionality</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PM5032-T-ETH,</td>
<td>O0 … O3</td>
<td>Limit Switch</td>
<td>OBIO-LimitSwitch</td>
<td>Up to 8 limit switches</td>
</tr>
<tr>
<td></td>
<td>PM5052-T-ETH,</td>
<td>O4 … O7</td>
<td>Limit Switch</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PM5072-T-2ETH(W)</td>
<td>C12 … C13</td>
<td>Not relevant for the functionality</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PM5082-T-2ETH</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PM5032-R-ETH,</td>
<td>NO0 … NO2</td>
<td>Not relevant for the functionality</td>
<td>OBIO-LimitSwitch</td>
<td>Relay outputs without other functions</td>
</tr>
<tr>
<td></td>
<td>PM5052-R-ETH</td>
<td>NO3 … NO5</td>
<td>Not relevant for the functionality</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>C12 … C13</td>
<td>Limit Switch</td>
<td></td>
<td>Up to 2 limit switches</td>
</tr>
</tbody>
</table>
6.3.2.7.8 Operating the limit switch output with user program

The OBIOLimitSwitch function block of the library must be used to operate the outputs with help of user program.

6.3.2.7.9 Configuration of PWM outputs (Pulse Width Modulation)

The AC500-eCo V3 processor modules provide up to 8 PWM output channels with a maximum frequency of 100 kHz ... 200 kHz. The parameter of PWM output channel of onboard I/O must be configured before it can be used. User should take these steps to configure the PWM output function.

<table>
<thead>
<tr>
<th>Functionality to be realized</th>
<th>Processor module type</th>
<th>Digital output channels</th>
<th>Configuration of the channel to be selected in Automation Builder</th>
<th>Dedicated function block to be used in the user program</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWM outputs</td>
<td>PM5012-T-ETH</td>
<td>O0 ... O3</td>
<td>PWM</td>
<td>OBIOPwm</td>
<td>Up to 4 PWM with 5 kHz</td>
</tr>
<tr>
<td></td>
<td>PM5012-R-ETH</td>
<td>NO0 ... NO1</td>
<td>Not relevant for the functionality</td>
<td></td>
<td>Relay outputs without other functions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NO2 ... NO3</td>
<td>Not relevant for the functionality</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PM5032-T-ETH,</td>
<td>O0 ... O3</td>
<td>PWM</td>
<td>OBIOPwm</td>
<td>Up to 4 PWM with 5 kHz</td>
</tr>
<tr>
<td></td>
<td>PM5052-T-ETH,</td>
<td>O4 ... O7</td>
<td>PWM / PTOx LS Pulse</td>
<td></td>
<td>Up to 4 PWM with 100...200 kHz</td>
</tr>
<tr>
<td></td>
<td>PM5072-T-2ETH(W)</td>
<td>C12 ... C13</td>
<td>Not relevant for the functionality</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PM5082-T-2ETH</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PM5032-R-ETH,</td>
<td>NO0 ... NO2</td>
<td>Not relevant for the functionality</td>
<td>OBIOPwm</td>
<td>Relay outputs without other functions</td>
</tr>
<tr>
<td></td>
<td>PM5052-R-ETH</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Functionality to be realized | Processor module type | Digital output channels | Configuration of the channel to be selected in Automation Builder | Dedicated function block to be used in the user program | Comments
---|---|---|---|---|---
NO3 … NO5 |  |  | Not relevant for the functionality |  |  
C12 … C13 |  |  | PWM |  | Up to 2 PWM with 100 kHz only on these channels

### 6.3.2.7.10 Operating the PWM output with user program

The OBIOPwm function block of the library must be used to operate the PWM outputs with help of user program.

### 6.3.2.7.11 Configuration of PTO outputs (HW fast outputs for Pulse Train Output)

The AC500-eCo V3 processor modules provide up to 2 PTO hardware dedicated output channels with a maximum frequency of 200 kHz. The parameter of PTO output channel of onboard I/O must be configured before it can be used. User should takes these steps to configure the PTO output function.

The PTO outputs can be used with 2 different modes either Pulse / Direction or Cc/Ccw mode.

Please refer to the technical data of the onboard I/Os Chapter 5.2.1.1.2.7.8 “Technical data of the PTO outputs” on page 217.

The PTO channels are always requiring 2 consecutive output channels for the function.

### Functionality to be realized | Processor module type | Digital output channels | Configuration of the channel to be selected in Automation Builder | Dedicated function block to be used in the user program | Comments
---|---|---|---|---|---
PTO outputs | PM5012-T-ETH | O0 … O3 | Not possible | - | No PTO available
| PM5012-R-ETH | NO0 … NO1 NO2 … NO3 |  |  |  |  

---
### Functionality to be realized

<table>
<thead>
<tr>
<th>Processor module type</th>
<th>Digital output channels</th>
<th>Configuration of the channel to be selected in Automation Builder</th>
<th>Dedicated function block to be used in the user program</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>PM5032-T-ETH, PM5052-T-ETH, PM5072-T-2ETH(W), PM5082-T-2ETH</td>
<td>O0 … O3</td>
<td>Not relevant for the functionality</td>
<td>OBIOPulseTrainOutput</td>
<td>Up to 2 PTO with Pulse/Direction or Cw/Ccw mode</td>
</tr>
<tr>
<td></td>
<td>O4 … O7</td>
<td>PTO0 HS Pulse/Cw -&gt; O4 and automatically for O5 also PTO1 HS Pulse/Cw -&gt; O6 and automatically for O7 also</td>
<td>OBIOMotionPTO</td>
<td></td>
</tr>
<tr>
<td></td>
<td>C12 … C13</td>
<td>Not relevant for the functionality</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PM5032-R-ETH, PM5052-R-ETH</td>
<td>NO0 … NO2</td>
<td>Not relevant for the functionality</td>
<td>OBIOPulseTrainOutput</td>
<td>Relay outputs without other functions</td>
</tr>
<tr>
<td></td>
<td>NO3 … NO5</td>
<td>Not relevant for the functionality</td>
<td>OBIOMotionPTO</td>
<td></td>
</tr>
<tr>
<td></td>
<td>C12 … C13</td>
<td>PTO 1 -&gt; C12 and automatically for C13 also</td>
<td>Up to 1 PTO with Pulse/Direction or Cc/Ccw mode</td>
<td></td>
</tr>
</tbody>
</table>

### 6.3.2.7.12 Operating the PTO hardware output with user program

The OBIOPulseTrainOutput function block of the library can be used to operate the PTO outputs with help of user program. This FB allows to control the output in PTO mode. The OBIOMotionPTO function block is a dedicated Motion control block to realize point-to-point movement or velocity control of a motion axis. 

Chapter 6.8.2.15.3.6 “Use the onboard I/Os as pulse-train output (PTO)” on page 4553.
### 6.3.2.7.13 Configuration of SW PTO (PWM) outputs (HW fast outputs and standard outputs with software dedicated function block)

The AC500-eCo V3 processor modules could also provide up to 4 PTO (PWM) software output channels. To use that mode, the parameter of output channel of onboard I/O must be configured before it can be used. User should take these steps to configure this special PTO output function. The PTO outputs channels can be only used as Pulse / Direction mode. Please refer to the technical data "Chapter 5.2.1.1.2.7.8 “Technical data of the PTO outputs” on page 217" "Chapter 5.2.1.1.2.7.9 “Technical data of the PWM outputs” on page 217."

The PTO channel is using a digital fast output configured as PWM output to generate the Pulse output and a standard digital output to indicate the direction. A dedicated PTO motion block will then control the channel to realize the functionality.

Up to 4 PTO can be then provided each using 2 digital outputs.

A mixed configuration of one HW PTO channel (e.g. Output 04 ... 05) and Pulse/Direction or Cc/Ccw mode together with up to 2 other software PTO Channels (e.g. O6, O7 + dedicated output) and only Pulse/Direction mode is then possible. Please refer to the technical data "Further information on page 217."

To achieve such a software PTO mode the following channel configuration must be done.

<table>
<thead>
<tr>
<th>Functionality to be realized</th>
<th>Processor module type</th>
<th>Digital output channels</th>
<th>Configuration of the channel to be selected in Automation Builder</th>
<th>Dedicated function block to be used in the user program</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>PTO outputs (HW fast outputs PWM and software PTO)</td>
<td>PM5012-T-ETH</td>
<td>O0 ... O3</td>
<td>Not possible</td>
<td>-</td>
<td>No PTO available</td>
</tr>
<tr>
<td></td>
<td>PM5012-R-ETH</td>
<td>NO0 ... NO1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>NO2 ... NO3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PM5032-T-ETH,</td>
<td>O0</td>
<td>Output / PTO0 Dir</td>
<td>OBIOMotionPWM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PM5052-T-ETH,</td>
<td>O1</td>
<td>Output / PTO1 Dir</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PM5072-T-2ETH(W)</td>
<td>O2</td>
<td>Output / PTO2 Dir</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PM5082-T-2ETH</td>
<td>O3</td>
<td>Output / PTO3 Dir</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>O4</td>
<td>PWM / PTO0 LS Pulse or CPU revision 1 PTO HS Single 0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>O5</td>
<td>PWM / PTO1 LS Pulse or CPU revision 1 PTO HS Single 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>O6</td>
<td>PWM / PTO2 LS Pulse or CPU revision 1 PTO HS Single 2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The 4 software PTO channels will use the fast outputs O4... O7 PWM to generate the Pulse signal of each SW PTO and the outputs O0... O3 will generate the direction signals.
<table>
<thead>
<tr>
<th>Functionality to be realized</th>
<th>Processor module type</th>
<th>Digital output channels</th>
<th>Configuration of the channel to be selected in Automation Builder</th>
<th>Dedicated function block to be used in the user program</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>C12 … C13</td>
<td>PWM / PTO3 LS Pulse or CPU revision 1 PTO HS Single 3</td>
<td>OBIOMotionPWM</td>
<td>Not relevant for the functionality</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NO0 … NO2</td>
<td>Not relevant for the functionality</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>NO3 … NO5</td>
<td>Not relevant for the functionality</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>C12 … C13</td>
<td>PWM</td>
<td></td>
<td>Theoretically possible up to 2 software PTO with Pulse/Direction but need an additional digital output module for the direction signal</td>
</tr>
</tbody>
</table>

**Functionality**

**Processor module type**

**Digital output channels**

**Configuration of the channel to be selected in Automation Builder**

**Dedicated function block to be used in the user program**

**Comments**

---

### 2 PTO Cw/Ccw

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Value</th>
<th>Default Value</th>
<th>Unit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run-on-fault</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>Start PLC program even on configuration fault</td>
<td></td>
</tr>
<tr>
<td>Digital output</td>
<td>PWM</td>
<td>Out</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>Out (PTO0 Out), last switch, PWM (max. 5 ms)</td>
</tr>
<tr>
<td>Digital output</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>Out (PTO0 Out), last switch, PWM (max. 5 ms)</td>
<td></td>
</tr>
<tr>
<td>Digital output</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>Out (PTO0 Out), last switch, PWM (max. 5 ms)</td>
<td></td>
</tr>
<tr>
<td>Digital output</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>Out (PTO0 Out), last switch, PWM (max. 5 ms)</td>
<td></td>
</tr>
<tr>
<td>Digital output</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>Out (PTO0 Out), last switch, PWM (max. 5 ms)</td>
<td></td>
</tr>
<tr>
<td>Digital output</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>Out (PTO0 Out), last switch, PWM (max. 5 ms)</td>
<td></td>
</tr>
<tr>
<td>Digital output</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>Out (PTO0 Out), last switch, PWM (max. 5 ms)</td>
<td></td>
</tr>
</tbody>
</table>

---

### 4 PTO Pulse/Direction – Configuration PTO HS Single x and Output / PTOx Dir

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Value</th>
<th>Default Value</th>
<th>Unit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run-on-fault</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>Start PLC program even on configuration fault</td>
<td></td>
</tr>
<tr>
<td>Digital output</td>
<td>PTO</td>
<td>Out</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>Out (PTO0 Out), last switch, PWM (max. 5 ms)</td>
</tr>
<tr>
<td>Digital output</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>Out (PTO0 Out), last switch, PWM (max. 5 ms)</td>
<td></td>
</tr>
<tr>
<td>Digital output</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>Out (PTO0 Out), last switch, PWM (max. 5 ms)</td>
<td></td>
</tr>
<tr>
<td>Digital output</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>Out (PTO0 Out), last switch, PWM (max. 5 ms)</td>
<td></td>
</tr>
<tr>
<td>Digital output</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>Out (PTO0 Out), last switch, PWM (max. 5 ms)</td>
<td></td>
</tr>
<tr>
<td>Digital output</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>Out (PTO0 Out), last switch, PWM (max. 5 ms)</td>
<td></td>
</tr>
<tr>
<td>Digital output</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>Out (PTO0 Out), last switch, PWM (max. 5 ms)</td>
<td></td>
</tr>
<tr>
<td>Digital output</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>PTO0 Out</td>
<td>Out (PTO0 Out), last switch, PWM (max. 5 ms)</td>
<td></td>
</tr>
</tbody>
</table>

---
6.3.2.14 Operating the software PTO output channels with user program

The OBIOMotionPWM function block is a dedicated motion control block to realize point-to-point movement or velocity control of a motion axis. This block will then control the output channels as PTO mode Pulse/Direction only up to 100 kHz. See the dedicated chapter in the system technology "Chapter 6.8.2.15.3.6 "Use the onboard I/Os as pulse-train output (PTO)" on page 4553.

6.3.2.8 Option board for processor modules PM50xx

6.3.2.8.1 Select the option board

Depending on processor module type, up to 3 option board slot are available and for each several option board modules are available.

To add an option board on the processor module, select the desired OptionSlot to be configured and attach the needed option board from the list.
There is no limitation on the number of same option board used on the CPU, no dedicated slot for a specific function and no specific order to place the option board module. Depending on the type of option board selected and attached to the CPU some further configuration of channels or function may be needed.

### 6.3.2.8.2 Attach an option board for digital I/O extension

Just select and attached the module, no other channel configuration is needed. The I/O channels are directly mapped in the I/O mapping and variables can then be defined.

### 6.3.2.8.3 Attach an option board for analog I/O extension

The desired analog I/O option board type for the desired option board slot must be selected and added.

The option board may require some other channel configuration according to your need.

Following example shows how to add a TA5120-2AI-UI analog option board and the desired channel types which can be selected.

### 6.3.2.8.4 Attach an option board for COMx serial communication

The desired serial interface option board type for the desired option board slot must be selected and added.

The option board may require some other channel configuration according to your need.

Following example shows how to add a TA5142-RS485I isolated interface and the desired protocol.
The desired protocol has also to be added according to your needs, e.g. Modbus RTU client:

The parameter for the serial interface can also be adapted like baudrate, data bit, stop bit or parity.

6.3.2.9 Onboard Ethernet configuration

6.3.2.9.1 General

Onboard Ethernet is provided for device types with -ETH extension.

6.3.2.9.2 Configuration of the IP settings with the IP configuration tool

Introduction

The IP configuration tool can be used

- to set or change the IP address of devices.
- to scan the network for available hardware devices.
● to update the firmware of devices.
   This functionality is only supported if the IP configuration tool is used stand-alone.

● to activate certain functionality on hardware devices.
   This feature is only available on AC500 V3 devices.

The IP configuration tool is part of Automation Builder and can be called via “Tools ➔ IP-Configuration”.

Further the IP configuration tool can be used stand-alone without an Automation Builder application running. The stand-alone variant requires a separate installation via the Installation Manager ➔ Chapter 6.3.2.9.2.2 “Stand-alone installation” on page 1507.

After the installation, the IP configuration tool is started via .exe file / desktop icon.

---

**Stand-alone installation**

The IP configuration tool is part of Automation Builder and can be called via “Tools ➔ IP-Configuration”. A separate installation is only required if the IP configuration tool shall be used stand-alone.
1. Open the Installation Manager in Automation Builder: "Tools ➔ Installation Manager".
2. Close all other instances of Automation Builder as only one instance of the program can be executed at a time.
3. Click [Modify] and select the “IP Configuration Tool” from the structure tree.

4. Click [Continue] to start the installation.
   - After a successful installation the IP configuration tool is available as stand-alone tool (.exe).
   - To start the IP configuration tool, click the new created desktop icon.

**Network scan**

With a network scan all devices that have been found in the network by the scan process are listed, i.e. ABB devices such as AC500 processor modules, AC500 communication interface modules or ABB drives.
1. Start the IP configuration tool in Automation Builder ("Tools ➔ IP-Configuration") or start it stand-alone (.exe).

2. The "IP-Configuration" dialog opens. Define the device type for the network scan by selecting the desired option under "Scan Protocol":

   ● "ABB Net config protocol":
     Use this option for AC500 devices such as processor modules, Cl5xx-Modbus devices or ABB drives. The device(s) to be scanned must be connected to the PC via a direct Ethernet connection.

   ● "Profinet Dynamic Configuration Protocol (DCP)":
     Use this option for PROFINET communication interface modules. The device(s) to be scanned must be connected to the PC via a direct Ethernet connection (not via CM579).
     For the scan, a NPcap driver needs to be installed separately.

   ● "EtherCAT":
     Use this option for EtherCAT communication interface modules. The Ethernet cable must be connected directly to the first EtherCAT slave device of the EtherCAT fieldbus. Ensure that no EtherCAT master device is available on the bus when a scan is performed.
     "Emergency" option: Enable this option to check on failures in the EtherCAT assembly during the scan process, i.e. a frame loss or interchanged ports. Errors are displayed.
     For the scan, a NPcap driver needs to be installed separately.

3. Click [Scan] to start the scan process.
4. All devices that have been found in the network are listed including hardware and connection details. The following details can be changed under “IP settings”:

- “IP Address”:
  Current IP address of the device.
- “Conf. IP Address”:
  Configured IP address of the device. A changed IP address will update this column.
- “FW Version”:
  Current installed firmware version of the device. This field is visible not until a first network scan. If this field is still empty after a network scan, check on connection errors.

The IP address of some devices, e.g. EtherCAT devices cannot be changed.

Changing the IP address

1. In order to change the IP address of devices perform a network scan.
   "Chapter 6.3.2.9.2.3 “Network scan” on page 1509"
2. Select a device from the list and select the appropriate protocol under “Scan protocol”.
   “DHCP” or “BOOTP” option: If required, DHCP or BOOTP can be used to receive the IP address for the device from the server.
   “IP address”, “subnet mask”, “Std. gateway”: Use these fields to change the IP address settings including the settings for the subnet mask and the standard gateway. Ensure that the combination of connection settings is correct.

Note for CI52x-Modbus devices

Consider the behavior of CI52x-Modbus devices if the last number of the IP address is set to “0”.

"Check last number of IP address” on page 1512
3. Change the settings for the IP configuration and click [Send settings] to transmit the data to the device.

Note for PROFINET devices
The device name of PROFINET devices can be edited. If changing the name, ensure the following rules apply:
- Labels must be separated by "."
- Total length: 1 to 240
- Label length: 1 to 63
- Labels can consist of characters [a-z] and numbers [0-9]
- Labels are not allowed to start with ":"
- Labels are not allowed to end with ":"

4. In order to keep all IP changes after a power cycle, the settings can be stored permanently. Confirm the prompted message during the scan process.

Check last number of IP address
This hint is only valid for Cl52x-Modbus devices.
Check the last number of the IP address. If it is set to "0", the IP address setting for this last number will be used from the rotary switches on the hardware device.

Example:
**Firmware update**

The firmware of AC500 communication interface modules can be updated with the IP configuration tool.

For this, the IP configuration tool must be used as stand-alone variant.

*Chapter 6.3.2.9.2.2 “Stand-alone installation” on page 1507*

It is not possible to perform a firmware update out of Automation Builder.

- For PROFINET communication interface modules a firmware update is only supported for devices with firmware version ≥ 3.3.3.
- For EtherCAT communication interface modules a firmware update is only supported for devices with firmware version ≥ 2.1.4.
- For Modbus communication interface modules a firmware update is only supported for devices with firmware version ≥ 3.2.13.

**Requirements:** Before the firmware update

- Ensure a fast and stable network connection
- Close all unused applications on the executing PC
- Stop the communication between AC500 PLC and the communication interface module that shall be updated
During the firmware update

- Do not close the IP configuration tool
- Do not open Automation Builder software or any other application
- Do not switch-off the communication interface module that shall be updated
- Do not disconnect the Ethernet connection of a communication interface module or the executing PC

The firmware update will stop the operation of the affected device(s). Hence, the device(s) will become unresponsive for 1 - 2 minutes.

Procedure:

1. Start the IP configuration tool stand-alone (.exe).
2. Perform a network scan.
   - Chapter 6.3.2.9.2.3 “Network scan” on page 1509
3. Select the devices that shall be updated from the list and click [Scan] to trigger the scan process.
   - A multiple selection of several devices is possible via control key, however, ensure to select only devices of the same protocol at a time. Otherwise the firmware update fails.
4. This step is only required for devices that require an installed NPcap driver. In this case an appropriate message including a download link is prompted in the IP-Configuration dialog:

   - Click on the displayed link [https://nmap.org/download.html](https://nmap.org/download.html) and download the latest version of the npcap-X.X.exe file.

   - After the download, execute the file as administrator and restart the scan process.
   - The devices that have been scanned are listed.
5. Click [Update Firmware] to start the firmware update for the selected devices.

6. For CI50x, CI51x and CI52x devices a signature check is started. Select the appropriate firmware update file (*.bin) for the device(s). Example: C:\AC500\AC500_CI52x_Firmware_V3.2.8.bin.

   After a successful signature check the firmware update file (*.bin) and the respective signature file (*.bin.sig) are transferred to the device. This can last up to 3 minutes.

   If the signature check fails, check the availability of the *.bin file and the *.bin.sig file.

7. A status check followed by a device reboot followed by a second status check is performed automatically.

   After the firmware update all outputs of the updated devices are set to '0'.
8. After a successful firmware update the update status or the new firmware version is displayed in the “FW Version” field. If this field is empty, there possibly is a connection error between the device and the executing PC.

Exception: For EtherCAT devices an empty “FW Version” field does not indicate a connection error.

دير If the firmware update fails
  ● check the requirements for the update procedure. **“Requirements:” on page 1513**
  ● check the hints for trouble-shooting.
  ● perform a network scan and repeat the update. If the error still persists power cycle the device and try the update again.
**Blink functionality**

This function activates flashing of the backlight of an AC500 LED display.

1. From the menu, select “Tools ➔ IP-Configuration”.
2. Click [Scan] to trigger the scan process for devices in the network.
   - A progress bar shows the progress. The IP settings of a selected device is displayed below the list and can be edited.
3. Adjust your desired time and click [Blink] to activate flashing.

![Image of IP Configuration tool](image)

**Troubleshooting for IP configuration tool**

**Firewall exceptions:**

On a standard Windows 7 installation without third party firewall or security tools installed the IP configuration tool should work properly.

The Automation Builder setup installs rules or exceptions for the built-in Windows firewall to allow IPConfig to receive the responses for the IPConfig scan.

To check the Windows firewall is set correctly check the firewall settings.

**Windows 7/ Windows 10:**

On the network that is used for communication with the PLC, set “Incoming connections” to “Block all connections to programs that are not on the list of allowed programs”.
If a third party firewall is used these exceptions must be configured manually.

Either exceptions for applications can be entered: Automation Builder and IP configuration tool must be added as application.

Or the protocol and the port number must be given (for IPConfig: UDP protocol and port number 24576).

<table>
<thead>
<tr>
<th>Fault description</th>
<th>Cause</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error - general</td>
<td></td>
<td>Ensure that all requirements have been considered before and during the update procedure.</td>
</tr>
<tr>
<td>The “FW Version” field is empty after the network scan or the firmware version has not been updated after the update procedure (only for Modbus devices and PROFINET devices)</td>
<td>Connection error between the device and the executing PC.</td>
<td></td>
</tr>
<tr>
<td>Fault description</td>
<td>Cause</td>
<td>Remedy</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Signature check failed</td>
<td>During the firmware update of CI50x, CI51x and CI52x devices a signature check is started. The update procedure expects a firmware update file (<em>.bin) and a signature file (</em>.bin.sig) in the same directory. Without a signature file the signature check will fail.</td>
<td>Example: Firmware update file: C:\AC500\AC500_CI52x_Firmware_V3.2.8.bin Signature file:C:\AC500\AC500_CI52x_Firmware_V3.2.8.bin.sig</td>
</tr>
<tr>
<td>Error: Package timeout</td>
<td>A timeout error may occur due to an instable network.</td>
<td>Keep the executing PC as near as possible to the devices that shall be updated. Avoid network switches.</td>
</tr>
<tr>
<td>Error: Unable to read device status</td>
<td>A read error may occur due to errors in the firmware update protocol. After the firmware update the IP configuration tool reads out the status of the updated device in order to check if the update was successful.</td>
<td>Perform the update again.</td>
</tr>
<tr>
<td>Error: IP is not unique</td>
<td>If an IP address is obtained by more than one device an error occurs. A firmware update is not possible.</td>
<td>Change the IP addresses.</td>
</tr>
<tr>
<td>Error: Error State</td>
<td>Internal device error during the firmware update.</td>
<td>Perform the update again.</td>
</tr>
<tr>
<td>Error: Can’t connect to device</td>
<td>The TCP communication is not sufficient.</td>
<td>Increase the connection quality. Keep the executing PC as near as possible to the devices that shall be updated. Avoid network switches.</td>
</tr>
</tbody>
</table>
6.3.2.9.3 Switch functionality of Ethernet interfaces ETH1/ETH2

As of SystemFW 3.1.0 the Ethernet interfaces ETH1/ETH2 can be configured as an Ethernet switch.

The default setting is “Two separate interfaces”.

The change of the PLC Boot parameter ETH1 / ETH2 mode will become active after a PLC reboot.
Create and download a Boot project before rebooting the PLC!

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ETH1 / ETH2 mode</td>
<td>Two separate interfaces</td>
<td>Two separate Ethernet interfaces ETH1 and ETH2</td>
</tr>
<tr>
<td>Switch functionality ETH1-ETH2</td>
<td>Switch between ETH1 and ETH2</td>
<td></td>
</tr>
</tbody>
</table>

If the Switch functionality ETH1-ETH2 is active, only the Ethernet interface ETH1 is available (see Chapter 6.8.2.5.5.5 “CFG - configuration” on page 4462). Any protocols configured under Ethernet interface ETH2 must be deleted. Otherwise a compile error will be created.

The setting of ETH1 / ETH2 mode can be checked on LED display with soft key <CFG> (see Chapter 6.8.2.5.5.5 “CFG - configuration” on page 4462).

6.3.2.10 Onboard CAN configuration

AC500 V3 PLCs provide the following methods for CAN integration:

- Onboard CAN interface
- CANopen master-slave arrangement (with CM598-CN as a master device)
Table 300: Differences in supported protocols

<table>
<thead>
<tr>
<th></th>
<th>Onboard CAN</th>
<th>CM598-CN</th>
</tr>
</thead>
<tbody>
<tr>
<td>CANopen Manager</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CAN 2A/2B</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>J1939</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

Onboard CAN interface is not available on AC500-eCo V3!

Supported protocols

Onboard CAN interface supports the following protocols

- CANopen Manager: Connection of CI581 and CI582 without additional I/O modules
- CAN 2A/2B
- J1939

Configuration in Automation Builder is described in chapter 'CANopen' Chapter 6.3.2.11.1.1 “CM598-CAN - CANopen Manager communication module” on page 1521.

Further information can be found in chapter 'CAN onboard' Chapter 6.3.2.16 “CAN onboard” on page 1594

6.3.2.11 Communication modules
6.3.2.11.1 CANopen

CM598-CAN - CANopen Manager communication module

Configuration of the communication module

- Click menu “Tools” Options” and select “Device editor” in the “Options” window.
- Enable first checkbox “Show generic device configuration views” and click [OK].

Append a CM598-CAN

1. Right-click on your desired Slot below node “Extension Bus” and click “Add object”.

Dialog “Replace object:” appears.

2. Click “CM598_CAN” in the list and click [Replace object].

3. Double-click “CM598_CAN (CM598-CAN)” to get the “CM598-CAN Parameters” in the editor window.

The following parameters are available:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default value</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run on config fault</td>
<td>No</td>
<td>No</td>
<td>In case of a configuration error, the user program is not started.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Yes</td>
<td>The user program is started independent of a faulty configuration of the CM598-CAN communication module.</td>
</tr>
</tbody>
</table>
The tab “CAN Bus” contains the basic settings of the CAN bus and special settings for the CAN 2.0 B protocol.

The settings at “29 Bit COB-ID” are only valid for CAN 2.0 B protocol. Ensure the option “Enable 29 Bit COB-ID” is enabled. Otherwise no CAN 2.0 B frames can be received. With the other parameters at “Enable 29 Bit COB-ID” the receive filter is configured.

SAE J1939 An example project which demonstrates using and handling the SAE J1939 protocol in AC500 V3 PLCs is given in the application example AC500 SAE J1939 protocol.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default value</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CANopen Sync mode</td>
<td>Sync Bus only</td>
<td>Sync Bus only</td>
<td>The “CANopen Manager” sends sync messages (if enabled) to CAN bus only. The properties of the sync message are configured in the “CANopen Manager” parameters.</td>
</tr>
<tr>
<td>Sync Bus and task</td>
<td></td>
<td>“CANopen Manager” sends sync messages to CAN bus and triggers IEC task. Chapter 6.3.2.11.1.1.4 “Configuration of SYNC task” on page 1532</td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>Default value</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------</td>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Bus parameters</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transmission rate</td>
<td>250 kBit/s</td>
<td>10 kBit/s</td>
<td>Transmission speed in [kBit/s]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>20 kBit/s</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>50 kBit/s</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>100 kBit/s</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>125 kBit/s</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>250 kBit/s</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>500 kBit/s</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>800 kBit/s</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1000 kBit/s</td>
<td></td>
</tr>
<tr>
<td><strong>Node settings</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stop in case of monitoring error</td>
<td>Disabled</td>
<td>Disabled</td>
<td>The manager does not stop in case of a monitoring error (Node Guarding or Heartbeat Error). A loss of communication to one node has no influence to other nodes. The manager tries to reestablish the communication to the error affected nodes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Enabled</td>
<td>If this function is enabled, the manager will also stop the communication to all responding and active nodes.</td>
</tr>
<tr>
<td>Send “Global Start Node”</td>
<td>Enabled</td>
<td>Disabled</td>
<td>No “Global Start Node” message is sent after configuring the nodes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Enabled</td>
<td>A “Global Start Node” message is sent after configuring the nodes. This synchronize all nodes again.</td>
</tr>
<tr>
<td><strong>29 Bit COB-ID</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable 29 bit COB-ID</td>
<td>Disabled</td>
<td>Disabled</td>
<td>29 bit CAN-IDs are disabled, but 11 bit CAN-IDs are still enabled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Enabled</td>
<td>29 bit CAN-IDs are additional enabled.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Default value</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------</td>
<td>--------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Acceptance mask</td>
<td>0</td>
<td>29 bit</td>
<td>Specifies the bits of a CAN-ID which will be evaluated by the filter. For instance, with an acceptance mask = 0x1FFFFFFF all bits are evaluated.</td>
</tr>
<tr>
<td>Acceptance code</td>
<td>0</td>
<td>29 bit</td>
<td>Specifies the bits of a CAN-ID which has to be set to pass the filter. Only those bits which are set in the acceptance mask are relevant.</td>
</tr>
</tbody>
</table>

The tab “CM598-CAN I/O Mapping” contains bus cycle option used for CANopen configuration. The following parameters are available:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default value</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bus cycle task</td>
<td>Use parent bus cycle setting</td>
<td>Use parent bus cycle settings</td>
<td>Settings from “PLC settings” tab are used. Task Name of the task that triggers the bus cycle</td>
</tr>
</tbody>
</table>

The tab “CM598-CAN IEC Objects” contains the created instance of the IO driver.

Configuration of the CANopen Manager

By adding “CM598-CN” to configuration, “CANopen Manager” is added automatically.

Double click at “CANopen Manager” to show related parameters/information in a new window.

The tab “General” contains the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default value</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Node-ID</td>
<td>1</td>
<td>1-127</td>
<td>Unique node id for “CANopen Manager”.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Default value</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>---------------</td>
<td>-------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Check and fix configuration</td>
<td></td>
<td></td>
<td>This button opens the dialog that allows checking and fixing the current configuration.</td>
</tr>
<tr>
<td>Autostart “CANopen Manager”</td>
<td></td>
<td></td>
<td>Not supported (“CANopen Manager” always starts automatically).</td>
</tr>
<tr>
<td>Polling of optional slaves</td>
<td></td>
<td></td>
<td>Not supported</td>
</tr>
<tr>
<td>Start slaves</td>
<td></td>
<td></td>
<td>Not supported</td>
</tr>
<tr>
<td>NMT start all (if possible)</td>
<td></td>
<td></td>
<td>Not supported</td>
</tr>
<tr>
<td>NMT error behavior</td>
<td></td>
<td></td>
<td>Not supported</td>
</tr>
<tr>
<td><strong>Guarding</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable heartbeat producing</td>
<td>Disabled</td>
<td>Disabled</td>
<td>The heartbeat generation is disabled. Nodeguarding is enabled instead. Note that CANopen remote devices can also be configured as heartbeat producers.</td>
</tr>
<tr>
<td></td>
<td>Enabled</td>
<td></td>
<td>The “CANopen Manager” sends heartbeats according to the interval defined in parameter “Heartbeat time”. If new remote devices with heartbeat functionality are added their behavior will automatically be enabled and configured appropriately.</td>
</tr>
<tr>
<td>Node-ID</td>
<td>1</td>
<td>0 -127</td>
<td>Unique node id for “CANopen Manager”.</td>
</tr>
<tr>
<td>Producer time (ms) (only if heartbeat producing is active)</td>
<td>200</td>
<td>1..65535</td>
<td>Interval length between successive heartbeats (in milliseconds).</td>
</tr>
<tr>
<td><strong>SYNC</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable SYNC producing</td>
<td>Disabled</td>
<td>Disabled</td>
<td>No SYNC telegrams are sent.</td>
</tr>
<tr>
<td></td>
<td>Enabled</td>
<td></td>
<td>The “CANopen Manager” sends SYNC telegrams. The synchronus PDOs are sent directly after the SYNCH telegram.</td>
</tr>
<tr>
<td>COB-ID (Hex)</td>
<td>80</td>
<td>1-2047</td>
<td>COB-ID of the SYNCH telegram.</td>
</tr>
<tr>
<td>Cycle period (µs)</td>
<td>1000</td>
<td>1000-65535000</td>
<td>Interval length (in microseconds) after which the SYNC telegram is sent.</td>
</tr>
<tr>
<td>Window length (µs)</td>
<td>1200</td>
<td></td>
<td>Not supported</td>
</tr>
<tr>
<td>Enable SYNC consuming</td>
<td></td>
<td></td>
<td>Not supported</td>
</tr>
<tr>
<td><strong>TIME</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable TIME producing</td>
<td></td>
<td></td>
<td>Not supported</td>
</tr>
</tbody>
</table>
### Configuration of the CANopen remote devices

1. To add CANopen remote devices, right-click on “CANopen Manager” and click “Add objects”.
   - A dialog is shown where you can choose a CANopen remote device.

2. Double-click at a CANopen remote device to show related parameters/information in a new window.

The tab “General” contains the following parameters:
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default value</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Node-ID</td>
<td>Next unused value</td>
<td>1-127</td>
<td>Unique node id for CANopen remoter device.</td>
</tr>
<tr>
<td>Enable expert settings</td>
<td>Enabled</td>
<td>Enabled</td>
<td>All settings are displayed that are predefined by the device description (EDS file) for the device.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Disabled</td>
<td>Only basic settings are shown</td>
</tr>
<tr>
<td>SDO channels (only if expert settings are enabled)</td>
<td></td>
<td></td>
<td>Click this button to open a dialog for activating the SDO channels that are predefined in the EDS file. Service data objects (SDOs) allow access to all entries in the CANopen object directory. An SDO creates a peer-to-peer communication channel between two devices (SDO server and client channel).</td>
</tr>
<tr>
<td>Enable SYNC producing</td>
<td></td>
<td></td>
<td>Not supported</td>
</tr>
<tr>
<td>Optional device (only if expert settings are enabled)</td>
<td></td>
<td></td>
<td>Not supported</td>
</tr>
<tr>
<td>No initialization (only if expert settings are enabled)</td>
<td></td>
<td></td>
<td>Not supported</td>
</tr>
<tr>
<td>Reset node (only if expert settings are enabled)</td>
<td></td>
<td></td>
<td>Not supported</td>
</tr>
<tr>
<td><strong>Guarding</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable nodeguarding (Only available if heartbeat producing is disabled)</td>
<td>Enabled</td>
<td>Enabled</td>
<td>The “CANopen Manager” sends a message to the node in a configured interval. If the node does not respond, then the “CANopen Manager” resends this message as many times as defined in “Lifetime factor” or until the node responds. If the node does not respond, then it is marked as “unavailable”.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Disabled</td>
<td>Nodeguarding is disabled</td>
</tr>
<tr>
<td>Guard time (ms) (only if nodeguarding is enabled)</td>
<td>200</td>
<td></td>
<td>Interval in which node guarding telegram is sent.</td>
</tr>
<tr>
<td>Enable heartbeat producing (only available if nodeguarding is disabled)</td>
<td>2</td>
<td>1-255</td>
<td>Maximum allowed number of responses to node-guarding message before remote device is marked as “unavailable”.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Default value</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>---------------</td>
<td>-------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Life time factor (only if nodeguarding is enabled)</td>
<td>Disabled</td>
<td>Disabled</td>
<td>The remote device doesn’t send heartbeat messages.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Enabled</td>
<td>The remote device sends heartbeat messages.</td>
</tr>
<tr>
<td>Producer time (ms) (only if heartbeat producing is enabled)</td>
<td>10</td>
<td>1-65535</td>
<td>Time interval in which heartbeat messages are sent.</td>
</tr>
<tr>
<td>Heartbeat consuming</td>
<td></td>
<td></td>
<td>Opens a “Heartbeat Consuming Properties” dialog. There you activate the CANopen devices that you want to watch.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The number of possible devices to be monitored is defined in the EDS file. To do this, you must select the “Enable” check box and enter the Node-ID of the device and the required values in the “Heartbeat time” field (in milliseconds).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>When a remote device is monitoring, a green check mark is displayed on the “Heartbeat Consuming” button.</td>
</tr>
<tr>
<td>Emergency (EMCY)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable emergency (EMCY)</td>
<td>Enabled</td>
<td>Enabled</td>
<td>When internal errors occur, the node sends emergency messages. The diagnosis is shown in diagnosis tab of node respectively I/O module in case of S500 diagnosis of CI58x (see CM598-CN CAN manager diagnosis for list of possible diagnosis messages).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>COB-ID ( only if “Enable emergency” is enabled)</td>
<td>“Node-ID” +0x80</td>
<td>0x1-0x7FF</td>
<td>COB-ID auf EMCY message.</td>
</tr>
<tr>
<td>TIME</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable TIME producing</td>
<td></td>
<td>Not supported</td>
<td></td>
</tr>
<tr>
<td>COB-ID (Hex)</td>
<td></td>
<td>Not supported</td>
<td></td>
</tr>
<tr>
<td>Enable TIME consuming</td>
<td></td>
<td>Not supported</td>
<td></td>
</tr>
</tbody>
</table>

Within the tab “PDO Mapping” PDOs for the CANopen remote device can be configured.

The PDOs are split into RPDOs and TPDOs. For each PDO corresponding I/Os are shown. The following options are available for TPDOs and RPDOs:
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default value</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COB-ID</td>
<td>calculated</td>
<td>0x180-0x57F 0x681-0x6DF</td>
<td>The COB-ID is filled in automatically dependent to the node id and number of PDO but can be changed manually.</td>
</tr>
<tr>
<td>Type</td>
<td>Asynchronous – device profile specific</td>
<td>Asynchronous – device profile specific</td>
<td>The PDO is transmitted according to the CiA device profile.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Acyclic - synchronous</td>
<td>When a change is made, the PDO is transmitted synchronously, but not periodically.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Asynchronous – manufacturer specific</td>
<td>The PDO is transmitted only after specific events.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cyclic - synchronous</td>
<td>PDO is transmitted using SYNC mechanism.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Synchronous – only RTR (TPDOs only)</td>
<td>After a synchronization message, the PDO is updated, but not transmitted. Transmission is by explicit request only (Remote Transmission Request).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Asynchronous – only RTR (TPDOs only)</td>
<td>The PDO is updated and transmitted by explicit request only (Remote Transmission Request).</td>
</tr>
<tr>
<td>Num of syncs (only for Type “Cyclic – synchronous”)</td>
<td>1</td>
<td>1-240</td>
<td>Number of SYNC messages before PDO is sent.</td>
</tr>
</tbody>
</table>

The following options are only available for TPDOs.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default value</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inhibit time (x 100µs)</td>
<td>0</td>
<td>0-65535</td>
<td>Device-dependant. The inhibit time is the minimum time between two messages of a specific PDO. You can use this setting for preventing PDOs from being sent too often when their values are edited. Default: “0”. Possible values: 0–65535.</td>
</tr>
<tr>
<td>Event time (x 1ms) (only for types “asynchronous – manufacturer specific” and “asynchronous – device profile”)</td>
<td>0</td>
<td>0-65535</td>
<td>Device-dependant. Indicate the time span that should be between two PDO transmissions PDOs (in milliseconds).</td>
</tr>
<tr>
<td>Parameter</td>
<td>Default value</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------------</td>
<td>--------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>RTR</td>
<td>Disabled</td>
<td>Disabled</td>
<td>RTR (Remote transmission request) not used.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Enabled</td>
<td>A RTR frame can be used for interrogating the PDO externally.</td>
</tr>
</tbody>
</table>

The “Bootconfiguration” tab allows the configuration of the boot up behavior of the CANopen remote device.

The following options are available and can be set by either clicking on the graphics or selecting the corresponding check box on the right side of the editor window. The graphic illustrates the order of execution:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default value</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node ID-active</td>
<td>Enabled</td>
<td>Disabled</td>
<td>The remote device is inactive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Enabled</td>
<td>The remote device is active.</td>
</tr>
</tbody>
</table>

**Node BootUp**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default value</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node reset (send the reset-node command)</td>
<td>Enabled</td>
<td>Disabled</td>
<td>No specific node reset communication command is sent.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Enabled</td>
<td>The manager sends the CANopen specific node reset communication command.</td>
</tr>
<tr>
<td>Check node type and profile (compare the configured profile and type object 1000H with real value)</td>
<td>Disabled</td>
<td>Disabled</td>
<td>The content of the node object 1000H are not compared with the current parameters.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Enabled</td>
<td>The “CANopen Manager” compares the content of the mandatory node object 1000H. If the values are different, the manager will report a parameterization error.</td>
</tr>
<tr>
<td>Configuration Guard Protocol (configure the guard time and lifetime factor)</td>
<td>Enabled</td>
<td>Disabled</td>
<td>The guard time and Life-Time factor of the remote device configuration are not written.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Enabled</td>
<td>A CANopen has 2 specific register responsible for the Node guarding protocol. The “CANopen Manager” writes the guard time and Life-Time factor of the node configuration into the corresponding objects of the remote device during startup.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Default value</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>---------------</td>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Configuration SYNC COB-ID (configure the COB-ID for the synchronization-telegram)</td>
<td>Enabled</td>
<td>Disabled</td>
<td>The “CANopen Manager” does not write the SYNC COB-ID of the configuration into the corresponding objects of the remote device.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Enabled</td>
<td>The “CANopen Manager” will write the SYNC COB-ID of the configuration into the corresponding objects of the remote device during startup.</td>
</tr>
<tr>
<td>Configuration EMCY COB-ID (configure the COB-ID for the emergency-telegram)</td>
<td>Enabled</td>
<td>Disabled</td>
<td>The “CANopen Manager” does not write the EMCY COB-ID of the configuration into the corresponding objects of the remote device.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Enabled</td>
<td>The “CANopen Manager” writes the EMCY COB-ID of the configuration into the corresponding objects of the remote device during startup.</td>
</tr>
<tr>
<td>Configuration download of objects (download the object configuration to the node)</td>
<td>Enabled</td>
<td>Disabled</td>
<td>Enabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>To get a PDO communication to a remote device working, the “CANopen Manager” has to send all relevant configuration objects to the remote device. For example, the COB-IDs of PDOs are covered here in the mapping table.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>If enabled, all these parameter and also the user specific objects which are added manually in the remote device object configuration window are written down to the remote device by the manager.</td>
</tr>
<tr>
<td>Start node (send the start-node command)</td>
<td>Enabled</td>
<td>Disabled</td>
<td>No start node command is sent.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Enabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>To reach the operational state in CANopen, a remote device has to get the CANopen specific start node command. The “CANopen Manager” sends the start node command to the remote device at the end of the boot-up procedure.</td>
</tr>
</tbody>
</table>
### Parameter Table

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default value</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initiate PDO data (remote request all TxPDOs and send current RxPDOs once after)</td>
<td>Enabled</td>
<td>Disabled</td>
<td>PDOs are not written and read by the manager automatically.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Enabled</td>
<td>This item selects if the installed PDOs shall be automatically written and read by the “CANopen Manager” directly after the startup once. This ensures that the latest output data which can be found within the “CANopen Manager” output process data area is sent to the remote device and that the latest remote device input data is read from the remote device and be placed into the input process data area.</td>
</tr>
</tbody>
</table>

The tab “CI58x IEC Objects” contains the created instance used for diagnosis access. Only available for CI58x devices.

### Configuration of SYNC task

To create a SYNC task, which is triggered after each SYNC message, several steps are needed:

1. Set CANopen sync mode to “Sync Bus and Task” at CM598 communication module.
2. Enable “SYNC producing” at CANopen manager.
3. Set at least one PDO to transmission type “cyclic synchronous”.
4. Build the project.

   ⇒ A new task is created automatically which is called “ABB SyncTask <slot>” there you can add POUs which should be executed if the task is triggered.

**DO NOT CHANGE task settings!**
Configuration of the protocols CAN 2.0 A / CAN 2.0 B

The communication module CM598-CAN can be used to realize CAN bus based networks in combination with library ABB_CM598Can_AC500.library.

To enable the support for the desired protocol it must be appended to CM598-CAN.

1. Right-click “CM598_CAN (CM598-CAN)” in the device tree and select “Add device” in the context menu.
   - Window “Add object below: CM598_CAN_1” appears.

2. Select “CAN 2.0 A” or “CAN 2.0 B” from the list.

Parameterization

The CAN data transmission requires a buffer for the incoming data that can be read with function blocks of library ABB_CM598Can_AC500.library.

1. Right-click “CAN_2_0A_11_bit_identifier_ (CAN 2.0A)” or “CAN_2_0B_29_bit_identifier_ (CAN 2.0B)” and select “Add object”.

2. Select “Buffer for CAN 2A” for CAN 2.0A. Or select “Buffer for CAN 2B” for CAN 2.0B from the list.

3. Double-click on “Buffer_for_CAN_2A (Buffer for CAN2A)” or “Buffer_for_CAN_2B (Buffer for CAN2B)” in the device tree to open the “Buffer configuration” in the editor window.

The following parameters are available:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default value</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifier</td>
<td>0</td>
<td>CAN 2A: 0 ... 2047&lt;br&gt;CAN 2B: 0 ... 53687091</td>
<td>The value of the CAN identifier that is compared with the identifier of the incoming telegrams. The telegrams will be added to the buffer if the identifier matches.</td>
</tr>
<tr>
<td>Number of receive buffers</td>
<td>1</td>
<td>1 ... 16</td>
<td>The size of the buffer in number of telegrams.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Default value</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Behavior on receive buffer overflow</td>
<td>Overwrite</td>
<td>Overwrite</td>
<td>The oldest telegram in the buffer is overwritten by the incoming telegram.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Discard</td>
<td>Incoming telegrams are discarded as long as the buffer is full.</td>
</tr>
<tr>
<td>Enable triggering of IEC task</td>
<td>No</td>
<td>No</td>
<td>Disables the triggering of the execution of the related IEC task.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Yes</td>
<td>Enables the triggering of the execution of the related IEC task as soon as a CAN frame with the specified CAN-ID arrives.</td>
</tr>
</tbody>
</table>

Configuration of the CANopen manager

☞ Chapter 6.3.2.16.1.2 “CANopen manager (master)” on page 1594

6.3.2.11.2 PROFINET
CM579-PNIO – PROFINET IO communication module
Configuration of the communication module

Configuration is valid as of Automation Builder 2.2.0 and CPU firmware 3.2.0.

Until Automation Builder 2.5.x and CPU firmware 3.5.x the minimum firmware version 2.8.4.0 is required for communication module CM579-PNIO.

As of Automation Builder 2.6.0 and CPU firmware 3.6.0 the minimum firmware version 3.0.0.21 is required for communication module CM579-PNIO.

☞ Description of configuration with Automation Builder < 2.2.0

As of Automation Builder 2.6.0 some component changes of the PROFINET IO controller stack require a manual upgrade of projects created in Automation Builder versions < 2.6.0. How to perform those steps is described in the application note AC500 V3 - Upgrade of projects with PROFINET.

1. Right-click on your desired Slot below node “Extension_Bus” and click “Add object”.
   ⇒ Dialog “Replace object:” appears.
2. Click “CM579_PNIO” in the list and click [Replace object].
3. Double-click “CM579_PNIO (CM579-PNIO)” to get the “CM579-PNIO Parameters” in the editor window.

The following parameters are available:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run on config fault</td>
<td>No</td>
<td>No</td>
<td>In case of a configuration error, the user program is not started.</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td></td>
<td>The user program is started independent of a faulty configuration of the CM579-PNIO communication module.</td>
</tr>
</tbody>
</table>

4. Click on tab “CM579-PNIO I/O Mapping” to open the “Bus Cycle Options” in the editor window.

The following parameters are available:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bus cycle task</td>
<td>Use parent bus cycle settings</td>
<td>Use parent bus cycle settings</td>
<td>Settings from “PLC Settings” tab are used.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Task</td>
<td>Name of the task that triggers the bus cycle.</td>
</tr>
</tbody>
</table>

In the tab “CM579-PNIO IEC-Objects” the list of used IEC Objects for information instantiated I/O driver function block class is shown.

The library “CM579PROFINET” will be added automatically to “Library Manager” when a CM579-PNIO is appended.

Configuration of the PROFINET IO controller

PROFINET IO controller - Configuration

The PROFINET IO controller node appears automatically below the added communication module CM579-PNIO.

Double-click on “PNIO_Controller” and open the tab “General” in the editor window.

The following parameters are available:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Station name</td>
<td>cm579-pnio</td>
<td>Up to 240 characters</td>
<td>Network name of the PROFINET IO controller station. Must be conform to PROFINET standard.</td>
</tr>
<tr>
<td>IP parameters</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP-Address</td>
<td>192.168.0.1</td>
<td>Valid IP address</td>
<td>IP address of the PROFINET IO controller station.</td>
</tr>
<tr>
<td>Subnet mask</td>
<td>255.255.255.0</td>
<td>Valid subnet mask</td>
<td>Network mask of the PROFINET IO controller station.</td>
</tr>
</tbody>
</table>
### PROFINET IO controller - Parameters

The tab “PROFINET-IO-Controller Parameters" is a generic view of all PROFINET IO controller parameters. It is normally hidden and is normally not needed for configuration.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Value</th>
<th>Description</th>
<th>Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default gateway</td>
<td>0.0.0.0</td>
<td>Valid gateway address</td>
<td>Gateway address of the PROFINET IO controller station.</td>
<td>Default gateway</td>
</tr>
<tr>
<td><strong>Address settings for device</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>First IP-Address</td>
<td>192.168.0.2</td>
<td>Valid IP address</td>
<td>First IP address of the PROFINET IO devices. This parameter determines the address range of the PROFINET IO devices in combination with parameter Last IP address.</td>
<td>First IP address</td>
</tr>
<tr>
<td>Last IP-Address</td>
<td>192.168.0.254</td>
<td>Valid IP address</td>
<td>Last IP address of the PROFINET IO devices. This parameter determines the address range of the PROFINET IO devices in combination with parameter First IP address.</td>
<td>Last IP address</td>
</tr>
<tr>
<td>Subnet mask</td>
<td>255.255.255.0</td>
<td>Valid subnet mask</td>
<td>Network mask of the PROFINET IO devices.</td>
<td>Default subnet mask</td>
</tr>
<tr>
<td>Default gateway</td>
<td>0.0.0.0</td>
<td>Valid gateway</td>
<td>Gateway address of the PROFINET IO devices.</td>
<td>Default gateway address</td>
</tr>
<tr>
<td><strong>Bus State</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bus State in Stop</td>
<td>Stop</td>
<td></td>
<td>Defines the behavior of the fieldbus when the PLC is in Stop. In “PLC Settings” IO update and behavior of outputs in stop can be configured.</td>
<td>Bus State in Stop</td>
</tr>
<tr>
<td></td>
<td>Stop</td>
<td></td>
<td>The protocol of the fieldbus is stopped. There is no communication between PROFINET controller and devices.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Operation</td>
<td></td>
<td>The protocol of the fieldbus is executed. The communication between PROFINET controller and devices is enabled.</td>
<td></td>
</tr>
</tbody>
</table>

*Use tab “PROFINET-IO-Controller Parameters" only, if you need to change a parameter, which is not visible in other dialogs.*
Activating tab
1. Click “Tools ➔ Options” and select “Device editor”.
   ⇒ The “Device editor” dialog opens.
2. Enable checkbox “Show generic device configuration views” and click [OK]
   ⇒ The tab is now available.

Configuration of PROFINET IO devices
Add PROFINET IO device
1. Right-click on node “PNIO_Controller (PROFINET-IO-controller)” and click “Add object.”
   ⇒ A list with all installed PROFINET IO devices appears.
2. Select the desired device and click [Add object].
   ⇒ The device is added to the PROFINET IO controller in the device tree.

PROFINET IO device - Configuration
Double-click on “PNIO-Device” to open the device configuration in the editor window.
The following parameters are available:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Value</th>
<th>Description</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identification</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Station name</td>
<td></td>
<td>Device-spe-</td>
<td>This is a system wide unique name for addressing the device. Must be confo</td>
<td>Slave parameters -&gt; Identifi-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>cific</td>
<td>rm to PROFINET standard.</td>
<td>cation -&gt; Station name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Up to 240</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>characters</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Chapter</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>6.9.2.6.1.4 “PROFINET scan and comparison view”</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>on page 4651</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Communication</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Send clock</td>
<td></td>
<td>Device-spe-</td>
<td>The Send cycle is divided into several phases. The Send clock specifies the</td>
<td>Slave parameters -&gt; Send</td>
</tr>
<tr>
<td>(ms)</td>
<td></td>
<td>cific</td>
<td>length of a phase. It is a multiple of time base 31.25 µs. Send clock and</td>
<td>clock</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>2</td>
<td>Reduction ratio determine the Send cycle:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4</td>
<td>Send cycle = Send clock x Reduction ratio</td>
<td></td>
</tr>
</tbody>
</table>

With “Device live list” view the PROFINET IO bus can be scanned for available devices and the device names and IP addresses can be assigned.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Value</th>
<th>Description</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reduction ratio</td>
<td>Device-specific</td>
<td>1 ... 16384</td>
<td>The Reduction ratio determines how often the IO data is sent within the Send cycle. Send clock and Reduction ratio determine the Send cycle: Send cycle = Send clock x Reduction ratio</td>
<td>Slave parameters -&gt; Reduction ratio</td>
</tr>
<tr>
<td>Phase</td>
<td>1</td>
<td>1 ... Reduction ratio</td>
<td>Defines the part of the Send cycle at which the IO data is sent.</td>
<td>Phase</td>
</tr>
<tr>
<td>Watchdog</td>
<td>3</td>
<td>1 ... 65535</td>
<td>Time that is used to monitor the communication between IO controller and IO device.</td>
<td>Watchdog interval</td>
</tr>
<tr>
<td>RT class</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RT class</td>
<td>RT Class 1</td>
<td></td>
<td>Defines the Realtime Class of cyclic data. Currently only RT Class 1 (legacy) and RT Class 1 are supported.</td>
<td>Slave parameters -&gt; RT Class</td>
</tr>
<tr>
<td>IP Parameter</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP-Address</td>
<td>192.168.0.2</td>
<td></td>
<td>IP address of the PROFINET IO controller station.</td>
<td>Slave parameters -&gt; Identification -&gt; IP address</td>
</tr>
<tr>
<td>Subnetmask</td>
<td>255.255.255.0</td>
<td></td>
<td>Network mask of the PROFINET IO controller station.</td>
<td>Slave parameters -&gt; Identification -&gt; Subnet mask</td>
</tr>
<tr>
<td>Default gateway</td>
<td>0.0.0.0</td>
<td></td>
<td>Default gateway address of the PROFINET IO controller station.</td>
<td>Slave parameters -&gt; Identification -&gt; Default gateway address</td>
</tr>
</tbody>
</table>

The following parameter is only supported up to Automation Builder version 2.5.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Value</th>
<th>Description</th>
<th>Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>VLAN ID</td>
<td>0</td>
<td>0 ... 4095 or 0 ... 32767</td>
<td>In case of VLAN usage the parameter VLAN ID represents the ID of the virtual network. For VLAN type 802.1Q the range is 0..4095 while VLAN type ISL accepts values from 0 to 32767. The supported type depends on the used device.</td>
<td>Slave parameters -&gt; VLAN ID</td>
</tr>
</tbody>
</table>
PROFINET IO device – PNIO parameters

The tab “PNIO Parameters” is a generic view of all PROFINET IO device parameters. It is normally hidden and is normally not needed for configuration.

Use tab “PNIO Parameters” only, if you need to change a parameter, which is not visible in other dialogs.

Activating tab

1. Click “Tools ➔ Options” and select “Device editor”.
   ⇒ The “Device editor” dialog opens.
2. Enable checkbox “Show generic device configuration views” and click [OK]
   ⇒ The tab is now available.

Configuration of 3rd party PROFINET IO devices

Before a 3rd party PROFINET IO device can be used, the provided GSDML file has to be installed in the “Device Repository”.

Installation

Go to “Tools ➔ Device Repository ➔ Install”.

Configuration

☞ Chapter 6.3.2.11.2.1.3 “Configuration of PROFINET IO devices” on page 1537.

I/O mapping of the PROFINET IO devices

Open I/O mapping list

1. Double-click on the “PNIO_Controller” or below on the “<...>PNIO-Device” or below on the “I/O-Module” in the device tree.

2. Select tab “I/O mapping list” to show the list of I/O channels.

The content of the list depends on the selected node.

For instance:

- When the “PNIO_Controller” node is selected all I/O channels of all configured devices are shown.
- When a “PNIO-Device” is selected all I/O channels of the configured modules are shown.

An IEC variable for an I/O channel that is available in the “Application” can be defined by double-clicking in column “Variable”.

2024/01/05
Provider and consumer status

Provider and consumer status functionality is available as of Automation Builder 2.7.0 and CPU firmware 3.7.0.

The provider and consumer status of a PROFINET submodule is in the I/O editor available. For each submodule 4 additional I/O channels exists that can be used to read or write the provider and consumer status. These channels are updated with the cycle of the specified buscycle task.

<table>
<thead>
<tr>
<th>Channel</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Input PS” (submodule name)</td>
<td>input</td>
<td>Provider status of the input channels</td>
</tr>
<tr>
<td>“Output CS” (submodule name)</td>
<td>input</td>
<td>Consumer status of output channels</td>
</tr>
<tr>
<td>“Output PS” (submodule name)</td>
<td>output</td>
<td>Provider status of the output channels</td>
</tr>
<tr>
<td>“Input CS” (submodule name)</td>
<td>output</td>
<td>Consumer status of the input channels</td>
</tr>
</tbody>
</table>

The channels “Output PS” and “Input CS” are handled by the IO driver of the communication module CM579-PNIO when no mapping variable is assigned. The status value is set to “Bad_By_Controller” when the PLC is in “Stop” and to “Good” when the PLC is in “Run”.

In case of a mapping variable is assigned the correct status value has to be set in the PLC application.

The channels “Input PS” and “Output CS” contains the status values as received form the PROFINET device. If the Application Relation (AR) between PROFINET device and controller is closed the status is set to “Bad_By_Controller”.

The channels “Output PS” and “Input CS” are handled by the IO driver of the communication module CM579-PNIO when no mapping variable is assigned. The status value is set to “Bad_By_Controller” when the PLC is in “Stop” and to “Good” when the PLC is in “Run”.

In case of a mapping variable is assigned the correct status value has to be set in the PLC application.

The channels “Input PS” and “Output CS” contains the status values as received form the PROFINET device. If the Application Relation (AR) between PROFINET device and controller is closed the status is set to “Bad_By_Controller”.
Remanent data

The remanent data of the communication module CM579-PNIO is stored in the PLC filesystem. It will be read and evaluated by the communication module during configuration.

When a new project is loaded or the communication module is replaced the data is not deleted. It can be deleted either manually in the file browser or in the Automation Builder menu "Online ➔ Reset Origin" command.

Shared device

Shared device functionality is available as of Automation Builder 2.6.0 and CPU firmware 3.6.0.

The shared device functionality allows it to use the same IO device with multiple IO controllers at the same time. The sharing of an IO device is done on submodule level. A submodule of PROFINET IO device must be uniquely assigned to a PROFINET IO controller.

The example below shows the configuration of 2 IO controllers using a CM589-PNIO-4 as shared device. The modules or submodules that are assigned to an IO controller are shown in black style. The unassigned ones are in gray style.
The following workflow applies to an IO device configuration:

1. Add an IO device to an IO controller.
2. Add IO modules and submodules according to IO device hardware.
3. Setup required parameters of IO device.
4. Repeat the IO device configuration in the same way for further IO controllers.
5. Select the assigned IO submodules for each IO controller with disconnect/connect module function in context menu.
6. Define one IO controller to be responsible to connect to DAP.

To disconnect DAP and port submodules from IO controller use option “Shared device”:

1. Double-click on “PNIO-Device” to open the device configuration in the editor window.
2. Select tab “Options” to show option “Shared device”.
### Parameter Default Value Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shared device</td>
<td>unchecked</td>
<td>unchecked</td>
<td>DAP and Port sub-modules are connected.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>checked</td>
<td>DAP and Port sub-modules are disconnected.</td>
</tr>
</tbody>
</table>

### Rules to be followed on using PROFINET “Shared device” configurations:

- All configurations of the IO device at IO controllers using this IO device have to look the same.
- IP configuration (IP address, subnet mask) have to be the same.
- The station names have to be the same.
- Each IO submodule has to be connected at one single IO controller only.

*Automation Builder is not able to check these details for consistency.*

### CM589-PNIO / CM589-PNIO-4-PROFINET IO device communication module

Configuration is valid as of CPU firmware 3.5.0 (“CM589-PNIO”) respectively CPU firmware 3.6.0 (“CM589-PNIO-4”) and “CM589-PNIO” FW 1.6.2.20.

The configuration of the “CM589-PNIO” PROFINET I/O module has to be done in the following steps:

- Parameterization of the AC500 communication module interface ⇨ “Parameterization - communication module interface” on page 1543
- Parameterization of the PROFINET IO device protocol stack ⇨ “Parameterization - PROFINET I/O stack” on page 1544
- Configuring PROFINET IO device module structure ⇨ “Configuring PROFINET IO structure” on page 1544
- Parameterization of the PROFINET IO device modules ⇨ “Parameterization - PROFINET IO device modules” on page 1545
- Mapping of the I/Os ⇨ “Mapping of the I/Os” on page 1546
- Configuration specific to CM589-PNIO-4 ⇨ “Configuration CM589-PNIO-4” on page 1547

Configuration procedure for “CM589-PNIO” and “CM589-PNIO-4” are basically the same. Thus this description refers to “CM589-PNIO” only. Differences between “CM589-PNIO” and “CM589-PNIO-4” will be highlighted explicitly if necessary!

### Parameterization - communication module interface

For connecting a PLC as “PROFINET-IO-Device”, plug “CM589-PNIO” / “CM589-PNIO-4” at the “Extension_Bus” node.

Double-click on “CM589-PNIO” to open the “CM589-PNIO” configuration in the editor window.

The following parameter is available:
Click on tab “CM589-PNIO I/O Mapping” to get “Bus Cycle Options” in the editor window. The following parameter is available:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bus cycle task</td>
<td>Use parent bus cycle settings</td>
<td>Use parent bus cycle settings</td>
<td>Settings from “PLC settings” tab are used. Name of task that triggers the bus cycle.</td>
</tr>
</tbody>
</table>

Click on tab “CM589-PNIO IEC Objects”. Here the IO driver instance of communication module is specified.

**Parameterization - PROFINET I/O stack**

All parameters for “PROFINET-IO-Device” protocol configuration are set automatically by Automation Builder. These parameters are displayed just for information and in read-only mode. Double-click on “PROFINET-IO-Device” in tree view will show the parameter set in tab “PROFINET-IO-Device Parameters”.

- **“Station name”:** The default name is displayed. The real name used on acting at the field bus is combined out of this default name and the used setting of the rotary switches at the CM589 module (“cm589-pnio-00”, “00” will be replaced by rotary switch value) or the name set via PROFINET set name service.
- **Parameter “IP address”, “Subnet Mask”, “Default gateway”:** The default values are displayed here. These values are not used as communication settings. PROFINET IO controller supplies the IO devices with IP settings on communication establishing.

**Configuring PROFINET IO structure**

“CM589-PNIO” provides I/O data as modules with different data types and directions. Create an application specific I/O structure by compiling an appropriate combination of modules.

To assign I/O modules to “PROFINET-IO-Device” node open “Add object” dialog.
The maximum image size available for I/O data depends on “CM589-PNIO” modules firmware revision. If firmware revision run by connected “CM589-PNIO” module does not support the number of I/O data configured, download configuration will fail. Currently see “Calculating size of I/O data” on page 1546 how to calculate number of I/O data occupied by certain configuration.

PROFIsafe modules can only be used if a SM560-S-FD1 (for “CM589-PNIO”) respectively SM560-S-FD4 (for “CM589-PNIO-4”) was configured in project. For details see safety documentation.

**Parameterization - PROFINET IO device modules**

PROFINET IO device modules do not need user configuration. All needed parameters are set automatically by Automation Builder. Double-click on a module node shows the parameter set just for information. This parameter set is identical for all module types and is displayed in read-only mode.
- “API”: Shows the API which is used by the “CM589-PNIO” modules. As API 0 is supported only “CM589-PNIO” modules do not provide configuration capabilities for this parameter.
- “Slot number”, “SubSlot-Number”, “Offset in DPM”, inputs/outputs: Will be set to default values on inserting a module. On creating configuration data Automation Builder calculates real values and overwrites the defaults.
- “Offset IOPS” provider/consumer: Not used and set to 0 values.
- “PROFIsafe module”: “FALSE” if module is not a safety module.

Calculating size of I/O data

PROFINET defines I/O data and status information to be exchanged between IO controller and IO device. The status information is called “Provider Status” and “Consumer Status”. Both (I/O data and status information) have to be considered on calculating allocated memory in input and output image.

- The number of status bytes depends on the type of module used.
- The different types of modules input, output and in/output have to be considered different.
- Some status bytes are reserved for predefined submodules have to be considered additionally.

A configured I/O module allocates memory space at the corresponding I/O image for data and status bytes. Additionally memory is allocated at the opposite directions I/O image to store further status bytes. E.g. an input module allocates memory at the input image but additionally it allocates one byte for status at the output image. Summarized size of input and output data and status has to fit to the corresponding image.

Table 301: Overview of I/O module types and corresponding status bytes

<table>
<thead>
<tr>
<th>Module type</th>
<th>Input data</th>
<th>Output data</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Inputs</td>
<td>Provider status inputs</td>
</tr>
<tr>
<td>Reserved</td>
<td>0 bytes</td>
<td>4 bytes</td>
</tr>
<tr>
<td>Input module</td>
<td>n input bytes</td>
<td>1 byte</td>
</tr>
<tr>
<td>(e.g. 4 byte input)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Output module</td>
<td>0 input bytes</td>
<td>0 bytes</td>
</tr>
<tr>
<td>Input/output module</td>
<td>n input bytes</td>
<td>1 byte</td>
</tr>
</tbody>
</table>

Following expressions calculate allocated sizes of input and output data:

Size input = \( \text{Input} + \text{status} + 4 \text{ bytes (reserved status)} \)

Size output = \( \text{Output} + \text{status} + 4 \text{ bytes (reserved status)} \)

- Input = Summarized number input bytes all modules.
- Output = Summarized number output bytes all modules.
- Status = Count input modules + count output modules + 2 * count input/output modules.

Mapping of the I/Os

Double-click on the desired “PROFINET-IO-Device” module object in the device tree to show current I/O mappings connected to this module.
Symbolic names for variables, inputs and outputs for further details on mapping inputs and outputs.

*Chapter 6.3.2.13.7 “Symbolic names for variables, inputs and outputs” on page 1572*

**Configuration CM589-PNIO-4**

“CM589-PNIO-4” adds PROFINET “Shared Device” feature to already described “CM589-PNIO” device functionality. Thus “CM589-PNIO-4” is able to communicate to 4 different PROFINET IO controllers in parallel.

Shared device usage of a “CM589-PNIO-4” does not need to be considered on doing the configuration of the “CM589-PNIO-4” coupler device itself. It has to be considered only on doing the configuration of “CM589-PNIO-4” as child to the “CM579-PNIO” IO controller. See “CM579-PNIO” configuration for details.

**Diagnosis and debugging for AC500 V3 products**

“CM589-PNIO” – PROFINET device diagnosis

The diagnosis messages of communication module “CM589-PNIO” are displayed in tab “Diagnosis” of node “CM589-PNIO” in device tree of Automation Builder. Within PLC application they can be read with the diagnosis methods of IO driver or function block “Diag”.

*Chapter 6.9.1.5.4.2 “Device state” on page 4629

*Chapter 6.9.1.5.3.3.2 “Method Ack / DiagAck: acknowledgement” on page 4623

In PLC display the diagnosis messages of “CM589-PNIO” are not shown.

*Chapter 6.9.3.6.3 “CM589-PNIO(-4) errors” on page 4688

**CM589-PNIO - PROFINET IO slave**

Configuration in Automation Builder is described in PROFINET IO slave configuration.

*Chapter 6.3.2.18 “PROFINET IO Configurator” on page 1640

**6.3.2.11.3 EtherCAT**

**CM579-ETHCAT - EtherCAT I/O master**

*Configuration in Automation Builder.*

- Double-click on “CM579_ECAT (CM579-ECAT)” to open the CM579-ECAT configuration in the editor window.

The following parameters are available:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default value</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run on config fault</td>
<td>No</td>
<td>No</td>
<td>In case of a configuration error, the user program is not started.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Yes</td>
<td>The user program is started independent of a faulty configuration of the EtherCAT communication module.</td>
</tr>
<tr>
<td>Broken slave behavior</td>
<td>Leave all broken slaves down</td>
<td>Leave all broken slaves down</td>
<td>Broken slaves will not be served.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Leave addressless slaves down</td>
<td>Only slaves without address will be left down.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Leave no slaves down</td>
<td>Broken slaves will be ignored.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Default value</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------</td>
<td>--------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>Distributed clocks</td>
<td>Inactive</td>
<td>Inactive</td>
<td>Distributed clocks are inactive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Active</td>
<td>Distributed clocks are active.</td>
</tr>
<tr>
<td>Bus Target State</td>
<td>Operational, OP</td>
<td>Operational, OP</td>
<td>Target state of the EtherCAT bus at application start.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Safe-Operational, SAFEOP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Pre-Operational, PREo</td>
<td></td>
</tr>
<tr>
<td>Bus behavior</td>
<td>Asynchronous (IEC bus cycle)</td>
<td>Asynchronous (IEC bus cycle)</td>
<td>Type of bus behavior (asynchronous/synchronous)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Synchronous (Sync mode 1)</td>
<td>Minimum lag (1 bus cycle) between input and output values.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Synchronous (Sync mode 2)</td>
<td>Extended application time, higher lag (2 bus cycles) between input and output values.</td>
</tr>
<tr>
<td>Optimize I/O update</td>
<td>Off</td>
<td>On</td>
<td>When activated, consecutive I/Os are merged in one block to optimize the performance.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td></td>
</tr>
</tbody>
</table>

**EtherCAT-Master - ABB functionality for sync units**

With the EtherCAT sync units, several slaves are configured into groups and subdivided into smaller units. For each group, the working counter can be monitored for granular input data validation. As soon as a slave is missing in a sync unit group, the input data of all other slaves in the same group becomes invalid.

Detection occurs immediately in the next bus cycle, as the working counter is continuously checked. Unaffected groups remain operable without any interference.

Right click on the “Application” node and press “Create configuration data”.

Automation Builder creates a set of global variables defining the working counter state of a “SyncUnit” command.

The variables use the following naming scheme:

```
"SLOT_" + "CouplerSlot_" + "SyncUnitName" + "_CMD_" + "LogicalAccess" + "_FRAME_" + "FrameID CouplerSlot".
```

**CouplerSlot**

The communication module slot is the ID of the slot where the communication module is plugged in.

**SyncUnitName**

The sync unit name is as defined in the “Sync Unit Assignment” tab.

**LogicalAccess**

The logical access defines the command List of logical access commands:

- Read = 10;
- Write = 11
- Read/Write = 12

**FrameID**

The frame ID starts with 1 and increments if the cyclic exchanged data is larger than the maximum Ethernet frame boundary.

Values
● FALSE: Working counter is as expected (data from slaves is valid)
● TRUE: Working counter is different to expected value (data from slaves is invalid)

The variables can be used by conditional consumption of slave data in the application:

```plaintext
IF NOT SLOT_1_default_CMD_10_FRAME_1 THEN
  (* Consume SyncUnit default slave data *)
END_IF;
```

**EtherCAT diagnosis**

Automation Builder 2.3 provides an enhanced diagnosis interface for the EtherCAT fieldbus. The user can get EtherCAT diagnosis information from different editor views. All these views are accessible within the EtherCAT master device editor and provide information about the master and all configured or connected slaves. The main diagnosis overview is given in the EtherCAT master view “Diagnostics main”.

“Diagnostics main” shows EtherCAT state “Operate”.

If the EtherCAT bus state shows “Operate”, the user does not need to check for any more information.

If the “Diagnostics main” shows any error, like “Topology mismatch detected”, the user can continue to the next level of information by opening editor view “Master State Control”.

“Diagnostics main” shows EtherCAT state “Topology error”. 
“Master State Control” shows EtherCAT state “Operate”.

In editor view “Master State Control” the user can request a master state change or get information about configured parameters as well as events and latest communication errors. In case of any topology error (e.g. slaves are configured in a different order than they exist in hardware) the Automation Builder shows a hint to the user that it might be helpful to execute a bus scan in editor view “Diagnostics live list” to compare the scan result of the real hardware with the configures slaves in the Automation Builder project.

Bus scan result in editor view “Diagnostics live list” shows the connected hardware.
The bus scan result list shows the following information for each connected slave:

<table>
<thead>
<tr>
<th>ID</th>
<th>Position of the found slave device</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Slave identification (name or Vendor/Device ID number)</td>
</tr>
<tr>
<td>State</td>
<td>The connection/link state of all ports (0-3) of the given slave</td>
</tr>
<tr>
<td></td>
<td>Connected =&gt; Cable is plugged in</td>
</tr>
<tr>
<td></td>
<td>+ Link =&gt; Physically connected to another slave</td>
</tr>
<tr>
<td></td>
<td>+ Communication =&gt; Communication works fine</td>
</tr>
<tr>
<td>Name</td>
<td>Not used for EtherCAT</td>
</tr>
<tr>
<td>Address</td>
<td>Not used for EtherCAT</td>
</tr>
<tr>
<td>Details</td>
<td>E.g. revision number of the slave device</td>
</tr>
</tbody>
</table>

*The bus scan shows information about the real connected hardware.*

*Note that a bus scan will always restart the EtherCAT bus.*

*This should not be a problem during commissioning but it might not be applicable in a running system.*

For runtime diagnosis the Automation Builder provides cyclic information of all configured slaves and their states in the editor view “Slave diagnosis”.

Slave diagnosis information shows that configured slaves are ok.

“Slave diagnosis” view shows wrong slave at position 1.

The editor view “Slave diagnosis” shows information about the configured slaves. If these slaves are found in hardware, the states of all slaves are ok. If there is a mismatch between hardware and configuration the view shows at which position that mismatch was detected.
The “Slave diagnosis” shows the following information for each configured slave:

<table>
<thead>
<tr>
<th>Topology Position</th>
<th>Position of the configured slave device.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configured Station Address</td>
<td>Address that is defined by configuration. This address is not topology dependent.</td>
</tr>
<tr>
<td>Slave Name</td>
<td>Configured name of the slave device.</td>
</tr>
<tr>
<td>Slave State</td>
<td>The state of the slave. Possible slave states are:</td>
</tr>
<tr>
<td></td>
<td>NOT CONNECTED ¹ )</td>
</tr>
<tr>
<td></td>
<td>INIT</td>
</tr>
<tr>
<td></td>
<td>PREOP</td>
</tr>
<tr>
<td></td>
<td>SAFEOP</td>
</tr>
<tr>
<td></td>
<td>OP</td>
</tr>
<tr>
<td></td>
<td>INIT ERR</td>
</tr>
<tr>
<td></td>
<td>PREOP ERR</td>
</tr>
<tr>
<td></td>
<td>SAFEOP ERR</td>
</tr>
<tr>
<td>Port State ² )</td>
<td>The state of all ports (0-3) of the given slave. Shows how many connections this slave has to other slaves and if the connections are working fine:</td>
</tr>
<tr>
<td>Connected</td>
<td>=&gt; Cable is plugged in</td>
</tr>
<tr>
<td>+ Link</td>
<td>=&gt; Physically connected to another slave</td>
</tr>
<tr>
<td>+ Communication</td>
<td>=&gt; Communication works fine</td>
</tr>
<tr>
<td>Last Error</td>
<td>The last error that occurred in this slave. As text, if available, and error number. If this is any topology error, the editor view will show a hint to perform a bus scan.</td>
</tr>
<tr>
<td>Emergency [CAN application protocol over EtherCAT (CoE)]</td>
<td>This column contains up to 5 CoE emergency entries. Each entry has</td>
</tr>
<tr>
<td>Error code</td>
<td></td>
</tr>
<tr>
<td>Address of the error register</td>
<td></td>
</tr>
<tr>
<td>Error data (1 byte)</td>
<td></td>
</tr>
<tr>
<td>If there are more than five emergencies reported by the slave, the columns show a hint that some emergency entries have been lost. The column is empty, if no CoE emergencies exist.</td>
<td></td>
</tr>
</tbody>
</table>

Frame Error Counters ² ) | Counts transmission errors on frame layer, detected by CRC check of frames. Fast growing values show a serious problem. Possible root causes include damaged cables, high electromagnetic noise or misbehavior of EtherCAT slave devices. Four counter values are shown, one for each port 0-3. Column has red background in case of any value other than 0. |

Physical Layer Error Counters ² ) | Counts transmission errors on physical layer. Possible root causes include electromagnetic disturbance or faulty devices. Four counter values are shown, one for each port 0-3. Column has red background in case of any value other than 0. |
Link Lost Counters 2) | Optional feature of EtherCAT slave devices, not supported by every device. Counts loss of physical connection (no link, LED off). Even short interruptions can be detected. Possible root causes include power dips, device reset, poor cables or connectors, loose contact. Four counter values are shown, one for each port 0-3. Column has red background in case of any value other than 0.

1) Note that columns “Port State”, “Frame Error Counters”, “Physical Layer Error Counters” and “Link Lost Counters” show “LLD: Timeout”, if this state is NOT CONNECTED, because this information is not accessible.

2) Note that this column contains “LLD: Timeout”, if slave state is NOT CONNECTED.

General note on the counters

Please note that this kind of errors will be detected by devices when power state changes, e.g. when the device itself or a neighboring device is powered on, caused by switching artifacts on the cable. This does not signal an issue, only counters increasing during normal operation should trigger deeper analysis. Counters can be reset by the PLC program using corresponding function blocks.

6.3.2.11.4 PROFIBUS

General

The fieldbus PROFIBUS is supported in AC500 PLC as master and slave. The communication modules “CM592-DP PROFIBUS DP V0/V1 master module” and “CM582-DP PROFIBUS DP slave module” are provided for these purposes.

Parameterization of the CM592-DP/CM582-DP communication modules

Configuration is valid as of CPU FW 3.5.0.

To append a communication module, add the communication module to the “Extension_Bus” node.

- Right-click the desired slot and select “Add object”.
- Select the communication module from the list and click [Replace object].

- Double-click the new node to open the CM592-DP/CM582-DP PROFIBUS DP configuration in the editor window. Click on tab “CM592-DP/CM582-DP Parameters” if not already opened.

The following parameters are available:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default value</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run on config fault</td>
<td>No</td>
<td>No</td>
<td>In case of a configuration error, the user program is not started.</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td></td>
<td>The user program is started independent of a faulty configuration of the PROFIBUS communication module.</td>
</tr>
</tbody>
</table>
Click on tab “CM592-DP/CM582-DP I/O Mapping” to open the “Bus Cycle Options” in the editor window.

The following parameter is available:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default value</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bus cycle task</td>
<td>Use parent bus cycle settings</td>
<td>Use parent bus cycle</td>
<td>Settings from “PLC settings” tab are used.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>settings</td>
<td>Task</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Name of the task that triggers the bus cycle</td>
</tr>
</tbody>
</table>

Click on tab “CM592-DP/CM582-DP IEC-Objects” to open the list of used IEC Objects. For information instantiated I/O driver function block class is shown.

CM592-DP PROFIBUS DP master communication module

Configuration of a PROFIBUS DP master

Double-click on “Profibus_Master_x (Profibus_Master)” to open the “Profibus_Master” configuration in the editor window:

Click on “General” tab if not already opend.

Most of the parameters are calculated automatically. Uncheck [Use defaults] to enable values to be edited individually. Checking [Use defaults] again will revert all parameters to default values.

All times for the PROFIBUS parameters are given in bit time [tBit]. The bit time is the result of the reciprocal of the transmission rate:

\[ tBit = \frac{1}{\text{transmission rate in [bit/s]}} \]

The conversion from milliseconds into a bit time is shown in following formula:

\[ tBit = \text{Time in [ms]} \times \text{transmission rate in [bit/s]} \]
The following parameters are available:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Value</th>
<th>Description</th>
<th>Parameter (Remark 1)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Adresses</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Station address</td>
<td>1</td>
<td>0 ... 125</td>
<td>The individual device address of the master device on the bus.</td>
<td></td>
</tr>
<tr>
<td>Highest station address</td>
<td>126</td>
<td>0 ... 126</td>
<td>The highest bus address up to which a master searches for another master at the bus in order to pass on the token. This station address must on no account be smaller than the master station address.</td>
<td></td>
</tr>
<tr>
<td><strong>Mode</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auto-Clear mode</td>
<td>Enabled</td>
<td>Disabled</td>
<td>The master operation mode will stay in the mode 'Operate' and the communication to all available slaves is kept up.</td>
<td>AutoClear-Supported</td>
</tr>
<tr>
<td>Automatic startup</td>
<td>Enable</td>
<td>Disable</td>
<td>Do not perform automatic startup</td>
<td>AutoStart</td>
</tr>
<tr>
<td></td>
<td>Enable</td>
<td></td>
<td>Perform automatic startup</td>
<td></td>
</tr>
<tr>
<td><strong>Parameters</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Baud rate</td>
<td>1500</td>
<td>9.6</td>
<td>Data transfer speed in [kBits/s]. The baud rate must be set to the same value for all devices on the bus. The result of changing the baud rate is that all other parameters must be recalculated.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>19.2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>45.45</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>93.75</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>187.5</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>50</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1500</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>3000</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>6000</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>12000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>T_SL Slot time</td>
<td>300</td>
<td>37 ... 65535</td>
<td>Monitoring time of the sender (requester) of a telegram for the acknowledgement of the recipient (responder). After expiration, a retry occurs in accordance with the value of maximum telegram retries.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>65535</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>Default</td>
<td>Value</td>
<td>Description</td>
<td>Parameter</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------</td>
<td>-----------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>min. T_SDR</td>
<td>11</td>
<td>1 ... 65535</td>
<td>Shortest time period that must elapsed before a remote recipient (responder) may send an acknowledgement of a received query telegram. The shortest time period between reception of the last bit of a telegram to the sending of the first bit of a following telegram.</td>
<td>DpParameter</td>
</tr>
<tr>
<td>Minimum station delay responder time</td>
<td></td>
<td></td>
<td></td>
<td>-&gt; min. TSDR</td>
</tr>
<tr>
<td>max. T_SDR</td>
<td>150</td>
<td>1 ... 65535</td>
<td>Longest time period that must elapse before a sender (requestor) may send a further query telegram. Greatest time period between reception of the last bit of a telegram to the sending of the first bit of a following telegram. The sender (requestor, master) must wait at least for this time period after the sending of an unacknowledged telegram (e.g. broadcast only) before a new telegram is sent.</td>
<td>DpParameter</td>
</tr>
<tr>
<td>Maximum station delay responder time</td>
<td></td>
<td></td>
<td></td>
<td>-&gt; max. TSDR</td>
</tr>
<tr>
<td>T_QUI</td>
<td>0</td>
<td>0 ... 127</td>
<td>Time delay that occurs for modulators (modulator-trip time) and repeaters (repeater-switch time) for the change over from sending to receiving.</td>
<td>DpParameter</td>
</tr>
<tr>
<td>Quiet time</td>
<td></td>
<td></td>
<td></td>
<td>-&gt; TQUI</td>
</tr>
<tr>
<td>T_SET</td>
<td>1</td>
<td>0 ... 255</td>
<td>Minimum period reaction time between the receipt of an acknowledgement to the sending of a new query telegram (reaction) by the sender (requestor).</td>
<td>DpParameter</td>
</tr>
<tr>
<td>Setup time</td>
<td></td>
<td></td>
<td></td>
<td>-&gt; TSET</td>
</tr>
<tr>
<td>T_TR</td>
<td>11894</td>
<td>1 ... 2</td>
<td>Pre-set nominal token cycle time within the sender authorization (token). The available time for the master to send data telegrams to the slaves depends on the difference between the nominal and the actual token cycle time. The Target rotation time (TTR) is shown in Bit times [tBit] like the other bus parameters. Below the displayed bit time, the Target rotation time is also displayed in [ms]. The default value depends on the number of slaves attached to the master and their module configuration.</td>
<td>DpParameter</td>
</tr>
<tr>
<td>Target rotation time</td>
<td></td>
<td>-1 (=16777215)</td>
<td></td>
<td>-&gt; TTR</td>
</tr>
<tr>
<td>Parameter</td>
<td>Default</td>
<td>Value</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------</td>
<td>-------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Gap</td>
<td>10</td>
<td>0 ... 255</td>
<td>Factor for determining after how many token cycles an added participant is accepted into the token ring. After expiry of the time period G*TTR, the station searches to see whether a further participant wishes to be accepted into the logical ring.</td>
<td></td>
</tr>
<tr>
<td>Gap update factor</td>
<td></td>
<td></td>
<td></td>
<td>DpParameter -&gt; Gap update factor</td>
</tr>
<tr>
<td>Retry limit</td>
<td>1</td>
<td>1 ... 15</td>
<td>Maximum number of repeats in order to reach a station.</td>
<td>DpParameter -&gt; max. retry limit</td>
</tr>
<tr>
<td>Data control time</td>
<td>120</td>
<td>1 ... $2^{24}$-1</td>
<td>Defines the time in [ms] within the Data_Transfer_List is updated at least once. After the expiration of this period, the master (class 1) reports its operating condition automatically via the Global_Control command. The default value depends on the transmission rate.</td>
<td>DpParameter -&gt; Data control time</td>
</tr>
<tr>
<td>Slave interval</td>
<td>2000</td>
<td>1 ... 65535</td>
<td>Defines the minimum time period between two slave list cycles in [$\mu$s]. The maximum value the active stations require is always given. The default value depends on the slave types.</td>
<td>DpParameter -&gt; min. slave interval</td>
</tr>
<tr>
<td>Poll timeout</td>
<td>10</td>
<td></td>
<td>Sets the maximum period of time in [ms] during which the response has to be received.</td>
<td>DpParameter -&gt; Poll timeout</td>
</tr>
</tbody>
</table>

Remark 1:
To display the parameters of this column, enable the option “Show generic device configuration views” under “Tools -> Options -> Device editor”.

**Configuration of a PROFIBUS DP slave**

A PROFIBUS DP slave can be added by right-clicking on “Profibus_Master_x (Profibus_Master)” and selecting “Add object”.

If the desired device is not listed it can be installed via the “Device Repository” (menu item “Tools” -> “Device Repository”).

The slave configuration parameters can be edited in slave related editor window. To open this editor window, double-click the corresponding slave in the device tree.

Click on tab “General” if not already opened.
All times for the PROFIBUS parameters are given in bit time \( [t_{\text{Bit}}] \). The bit time is the result of the reciprocal of the transmission rate:

\[
t_{\text{Bit}} = \frac{1}{\text{transmission rate in [bit/s]}}
\]

The conversion from milliseconds into a bit time is shown in following formula:

\[
t_{\text{Bit}} = \frac{\text{Time in [ms]}}{\text{transmission rate in [bit/s]}}
\]

The following parameters are available:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Value</th>
<th>Description</th>
<th>Parameter (Remark 1)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Identification</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Station address</td>
<td>1</td>
<td>0 ... 126</td>
<td>Station address of the PROFIBUS DP slave device.</td>
<td>StationAddress</td>
</tr>
<tr>
<td>Ident number</td>
<td>GSD file specific</td>
<td>----</td>
<td>Ident number of the PROFIBUS DP slave device.</td>
<td>SlavePrmData -&gt; identNumber</td>
</tr>
<tr>
<td><strong>Parameter</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>T_SDR (tBit)</td>
<td>11</td>
<td>11 ... 255</td>
<td>The parameter T_SDR (tBit) represents the minimum station delay of a responder (time a responder waits before generating the reply frame).</td>
<td>SlavePrmData -&gt; minTsdr</td>
</tr>
<tr>
<td>Lock/unlock</td>
<td>2 (Lock)</td>
<td>0 (T_SDR unlock)</td>
<td>The TSDR and slave-specific parameter may be overwritten.</td>
<td>Bit 6 = 0 and bit 7 = 0 of bitmask SlavePrmData -&gt; stationStatus</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 (Will be unlocked)</td>
<td>The slave is released to other masters.</td>
<td>Bit 6 = 1 and bit 7 = 0 of bitmask SlavePrmData -&gt; stationStatus</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 (Lock)</td>
<td>The slave is locked to other masters, all parameters are accepted.</td>
<td>Bit 6 = 0 and bit 7 = 1 of bitmask SlavePrmData -&gt; stationStatus</td>
</tr>
</tbody>
</table>
## Table

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 (Unlock)</td>
<td>The slave is released to other masters.</td>
<td>Bit 6 = 1 and bit 7 = 1 of bitmask Slave-PrmData -&gt; stationStatus</td>
<td></td>
</tr>
</tbody>
</table>

### Watchdog

<table>
<thead>
<tr>
<th>Watchdog control</th>
<th>Enabled</th>
<th>Disabled</th>
<th>The PROFIBUS Slave does not utilize the Watchdog Control Time setting.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>The PROFIBUS slave utilizes the Watchdog Control Time setting in order to detect communication errors to the assigned Master. When the Slave finds an interruption of an already operational communication, defined by a Watchdog time, then the Slave carries out an independent Reset and places the outputs into the secure condition.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Time (ms)</th>
<th>400</th>
<th>0 ... 2540</th>
<th>Watchdog time in [ms]. The default value depends on the number of slaves attached to the master and their configuration.</th>
</tr>
</thead>
<tbody>
<tr>
<td>SlavePrmData -&gt; wdFact1</td>
<td>SlavePrmData -&gt; wdFact2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### User parameter

<table>
<thead>
<tr>
<th>Symbolic values</th>
<th>Enabled</th>
<th>Disabled</th>
<th>No symbolic names for the user parameters.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>The values for the parameters are shown with symbolic names.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Length of user parameter (Byte)</th>
<th>3</th>
<th>Device-specific</th>
<th>The length of the user parameters in [bytes]. By default this value is 3 due to the existing reserved values.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Defaults</th>
<th>-</th>
<th>-</th>
<th>The button restores the default values of the user parameters.</th>
</tr>
</thead>
</table>

**Remark 1:**

To display the parameters of this column, enable the option "Show generic device configuration views" under "Tools → Options → Device editor".

Click on tab "Check configuration".

Following dialog shows values for input/output/parameter data occupied by your configuration. Here it can be checked how much data is left for further configuration.
CM582-DP PROFIBUS DP slave communication module

Configuration of PROFIBUS DP slave

Double-click on “PROFIBUS_DP_Slave” to open the PROFIBUS slave configuration in the editor window:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default value</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bus address</td>
<td>1</td>
<td>0 ... 126</td>
<td>The bus address is the individual device address of the slave device on the bus.</td>
</tr>
</tbody>
</table>

Configuration of I/O data objects

To append I/O data, add the desired input / output objects to the Communication Module node.

Right-click the Communication Module node and select “Add object”.

Different types of data objects group I/O variables by size and direction. The I/O driver of the PLC firmware copies the amount of data bytes configured by these data objects cyclically.
Select the desired I/O objects from the list and click [Add object].

To keep basic load of PLC low, only configure as much I/O data objects as actually required. If further I/O variables need to be added later, additional data objects can be inserted.

Technical details on the device such as the maximum amount of bytes used for I/O data is described in the device specification for Chapter 5.2.2.8.1 “CM582-DP - PROFIBUS DP slave” on page 354.

Double-click an added I/O object node to open the preset configuration. As the I/O objects do not need user configuration all parameters in the “Parameters” tab are read-only.

Open the “I/O Mapping” tab to configure the mapping configuration for the I/O object.

**Possible inconsistency**

On using CM582-DP slave device configured with modules types combining input and output data the following situation may happen:
Example

CM582-DP communication module configuration uses module type 16 Byte In/Out. The device representation assigned to CM592-DP master uses module types 16 Byte Output and 16 Byte Input at the same place instead.

This mismatch will not be detected; neither by Automation Builder nor by PROFIBUS master and slave. However, the communication will run stable and I/O data exchange is executed successfully.

Reason:
AC500 defines modules combining input and output directions to be split to two separated module configurations internally with output direction first.
Thus in AC500 the PROFIBUS configuration data for one module of type 16 Byte In/Out looks the same as for the combination of module types 16 Byte Output and 16 Byte Input.

Mapping of the I/Os

Double-click on the desired I/O data object in the device tree to show current I/O mapping connected to this data object. See Chapter 6.3.2.13.7 “Symbolic names for variables, inputs and outputs” on page 1572.

6.3.2.11.5 Ethernet

CM5640-2ETH – Ethernet communication module

Configuration is valid as of CPU FW 3.6.0.

Configuration of the communication module

Append a CM5640-2ETH.

All interfaces of the onboard and CM5640-2ETH modules need to be in different subnets. Overlapping of subnets must be avoided. The selection of the used interface (ETH port) is done automatically according the match of the IP-address of the server and the subnet of the interfaces.
1. Right-click on your desired Slot below node “Extension Bus” and click “Add object.”
   ⇒ Dialog “Replace object:” appears.
2. Click “CM5640-2ETH” in the list and click the button [Replace object].

Double-click “CM5640-2ETH (CM5640-2ETH)” to get the “CM5640-2ETH Parameters” in the editor window.

The communication module CM5640-2ETH is a port extender of the processor module used. Each communication module adds 2 additional independent ethernet interfaces. The communication module in the configuration tree is displayed in the same way as the processor module onboard ethernet interfaces.

The configuration of both interfaces is done as for the onboard ethernet interfaces from a processor module.

Double-click “ETH1_1 (IP Setting)” will open the windows to select the possible server protocols and all non-available protocols for that interface are greyed.

The added feature appears below “NetConfig (NetConfig)” for example and the configuration of each feature is done by clicking on the selected feature and opening new windows.

Both interfaces can be independently configured and the available server protocols always displayed when available or greyed when disabled.

Selecting “Protocols_1 (Client Protocols)” and right click and use “Add object”, a new window opens showing the available client protocols.
The configuration of each protocol either server or client is done in the same way as for onboard ethernet of the processor module.

6.3.2.12 Communication interface modules

6.3.2.12.1 Configuration of communication interface modules

Automation Builder can be used to configure the parameters of CI5xx devices.

Configuration of S500 I/O modules can be performed without CI5xx devices connected.

Adding CI5xx device to the device tree

1. Right click in the device tree on the node “Slot1” or “Slot2” of the “Extension_Bus” and click “Add object”.
   ➞ The window “Replace object : Slot <...>” opens.
2. Select your “CM5xx master module” and click [Add object].
   ➞ The “CM5xx master” appears in the Slot.
3. Right click on “CM5xx master module” and click “Add object”.
   ➞ The window “Add object below : <...>_Master” opens.
4. Select your “CI5xx” device and click [Add object].
   ➞ The “CI5xx” device appears in your device tree.
Adding S500 I/O modules

1. Right click on your “CI5xx” device and click [Add object].
   ⇒ The window “Add object below:” opens.
2. Select your I/O module and click [Add object].
   ⇒ The I/O module is added.

Configure parameters

⇒ Double-click the “CI5xx” device to open editors and select the “CI5xx_I/O Parameters” tab.

This editor shows the parameters that can be set for each device , and .

6.3.2.12.2 Unbundled CI52x-MODTCP configuration

Automation Builder can be used to configure the parameters of CI52x-MODTCP devices.

A direct Ethernet connection is required between the PC running Automation Builder and the CI52x-MODTCP module.

Configuration of S500 I/O modules can be performed without CI52x-MODTCPs modules connected.

Start a project from template

1. Select “New Project” in menu item “File”.
   ⇒ The window “New Project” appears.
2. Select the “CI52x-MODTCP Configuration Project” and click “OK”.
   ⇒ The window “Select PLC” opens.
3. Select a “CI52x-MODTCP” device and click “Add device”.
   ⇒ A project is created. More modules can be added.

Add CI52x-MODTCP to a project

1. Right click in the device tree on the root of the “Project” and click “Add object”.
   ⇒ The window “Add object below” opens.
2. Select “Modbus devices” and click “Add object”.
   ⇒ The node “Modbus_devices” appears in your device tree.
3. Right click on the node “Modbus_devices” and click “Add object”.
   ⇒ The window “Select PLC” opens.
4. Select your “CI52x-MODTCP” device and click “Add device”.
   ⇒ The “CI52x-MODTCP” device appears in your device tree.

Add S500 I/O modules

1. “Add object” to your “CI52x-MODTCP” device.
   ⇒ The window “Add object below: CI52x-MODTCP” opens.
2. Select your I/O module and click “Add object”.
   ⇒ The I/O module is added.

Configure parameters

⇒ Double-click the device to open editors and select the “CI52x-MODTCP Parameters” tab.

This editor shows the parameters that can be set for each device. For more information see ☞ Chapter 5.2.6.5.1.8.1 “Parameters of the module” on page 1090 CI521, ☞ Chapter 5.2.6.5.2.8.1 “Parameters of the module” on page 1120 CI522 and .

Connect to device

To read or write parameters, the CI52x-MODTCP module must be connected to the PC with an Ethernet connection.

See ☞ Chapter 5.2.6.5.1.6 “Addressing” on page 1089 CI521 and ☞ Chapter 5.2.6.5.2.6 “Addressing” on page 1120 CI522 of the CI52x-MODTCP hardware documentation for information on configuring the IP address of the device.

On the CI52x-MODTCP device editor, the “Connection Settings” tab allows the IP address of the device to be entered.
Read Reads the parameters from the CI52x-MODTCP and also for the attached S500 I/O modules.

Write Sends the parameters from the editors to the CI52x-MODTCP and also the S500 I/O modules.

**Device checking**  
The CI52x-MODTCP module knows which I/O modules are attached.

While reading and writing parameters, the project must match the physical hardware. Otherwise an error will be given.

Communication errors will also result in error messages.

When the parameters have been read or written correctly, a message is seen in the “All messages” window:

**Attached S500 modules**  
It is possible to read and write parameters when the S500 I/O modules are not attached to the CI52x-MODTCP module.

A warning will be shown if an I/O module is not detected:

When writing parameters, the CI52x-MODTCP configuration is overwritten so the current configuration of missing (unplugged) modules does not matter.

If the I/O modules are attached, then the project must match the hardware, otherwise an error will be given.

**Firmware update**  
As of Automation Builder 2.2.1, the IP Configuration Tool can be used to perform firmware updates for CI52x-MODTCP devices.
6.3.2.13 I/O bus and I/O modules

6.3.2.13.1 Hot swap configuration

Table 302: Parameters for hot swap configuration of I/O extension modules

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Purpose</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hot-swap terminal unit required</td>
<td>To include diagnosis for missing hot-swap terminal unit</td>
<td>Yes: Communication interface provides extended diagnosis for missing hot-swap terminal unit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No (default): Extended diagnosis not available</td>
</tr>
<tr>
<td>Start-up with missing module on hot-swap terminal unit</td>
<td>Ignore missing module during start-up on hot-swap terminal unit. Incomplete I/O configurations must not prevent the system from starting.</td>
<td>Yes: Module is optional, start-up if there is no module available on hot-swap terminal unit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No (default): Module is mandatory, start-up only if correct module is available</td>
</tr>
</tbody>
</table>

In the Automation Builder projects for V3 PLCs, hot-swap parameters can be configured from “Module Parameters” tab of respective I/O module.

By default, the “Module Parameters” tab is not visible for parameter configuration.

Follow the below steps to enable this tab:
1. In the Automation Builder menu select “Tools ➔ Options”
2. Select “Device editor” option from “Options” dialog.
3. Enable the option “Show generic device configuration views” (if not already done)
4. To save the settings and close the dialog select [OK]
6.3.13.2 Parameterization of the I/O bus

Double-click the “IO_Bus” node in the device tree to open the I/O bus configuration.

The following parameters are available:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run on config fault</td>
<td>No</td>
<td>No</td>
<td>In case of configuration fault the user program will not be launched.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Yes</td>
<td>The user program will be also launched in case of configuration error on the I/O Bus.</td>
</tr>
<tr>
<td>Max wait run</td>
<td>3000</td>
<td>0...120000</td>
<td>Maximum waiting time for valid inputs.</td>
</tr>
</tbody>
</table>

In case of a digital I/O Module, the channels are provided as WORD, BYTE and BOOL. Because the analog inputs can also be configured as digital inputs, bit 0 of each channel is also available as BOOL.

The symbolic name of a channel can be entered in front of the string “AT” in the channel declaration.

All channels should have a symbolic name and only symbolic names should be used in the program code. If the hardware configuration has changed or if you want to download the project to a PLC with another hardware configuration and thus the PLC configuration has to be changed, the addresses of the inputs and outputs can change. In case of symbolic programming (i.e., symbolic names are used), the program code does not have to be changed.
6.3.2.13.3 Parameter 'Ignore module'

All I/O devices provide the parameter “Ignore module”. This parameter can be used for simulation purposes and determines whether an I/O device is considered or ignored during a PLC configuration check.

This allows to use an existing Automation Builder project/PLC configuration though some hardware devices are not physically available in a hardware installation.

Example

The Automation Builder project for machine A shall be used for machine B. However, the second DC523 device is missing in the hardware installation of machine B. Hence, for machine B the value for “Ignore module” is set to “YES”.

6.3.2.13.4 I/O bus - Bus cycle task

The term "bus" includes all fieldbuses as well as the I/O bus. Consider that there is no bus cycle task for Modbus as Modbus does not provide I/O mapping and is controlled by POU.s.

It's recommended to define a dedicated bus cycle task for each fieldbus configured in the project. It's strongly recommended not to use "unspecified" in the "PLC Settings" to avoid unexpected behavior. The task defined in "PLC Settings" determines the bus cycle task of I/O bus and, depending on the configuration, of the additional fieldbuses (the setting is by default inherited).

Especially in case of EtherCAT, a dedicated bus cycle task should be used which is not shared with other fieldbuses. If [unspecified] is set in the "PLC Settings", the EtherCAT task might be automatically used by other fieldbuses, potentially causing the EtherCAT task processing to fail. This should be avoided by specifying a task different to the EtherCAT task in the "PLC Settings".

As a rule, for each IEC task the used input data is read at the start of each task and the written output data is transferred to the I/O driver at the end of the task. The implementation in the I/O driver is decisive for further transfer of the I/O data. The implementation is therefore responsible for the timeframe and the specific time when the actual transmission occurs on the respective bus system.

Other tasks copy only the I/O data from an internal buffer that is exchanged only with the physical hardware in the bus cycle task.
Using tasks

The "Task Deployment" provides an overview of used I/O channels, the set bus cycle task, and the usage of channels.

**WARNING!**

If an output is written in various tasks, then the status is undefined, as this can be overwritten in each case.

When the same inputs are used in various tasks, the input could change when a task is processed. This happens if the task is interrupted by a task with a higher priority and causes the process map to be read again. Solution: At the beginning of the IEC task, copy the input variables to variables and then work only with the local variables in the rest of the code.

Conclusion: Using the same inputs and outputs in several tasks does not make any sense and can lead to unexpected reactions in some cases.

### 6.3.2.13.5 Insertion of S500 I/O devices

1. Right-click "IO_Bus" in device tree and select [Add object].
   -> The “Add Device” dialog window where all available S500 I/O devices are listed will open.

2. Append the S500 I/O devices in the same order as they are mounted on the hardware.
   Input and output modules connected to the I/O bus occupy the I/O following area: %IB0 ... %IB999 or %QB0 ... %QB999.

**AC500 (Standard): PM56xx support up to 10 S500 I/O devices.**
6.3.2.13.6 Configuring the input and output modules and channels

The I/O channel configuration depends on the corresponding S500 I/O device. The individual configuration parameters can be opened in the editor window via double-click on the corresponding module and are listed in tab “S500 I/O device name Configuration”.

6.3.2.13.7 Symbolic names for variables, inputs and outputs

The IEC naming rules are not checked during input in Automation Builder.

Input and output mapping

Devices with I/Os provide an “I/O Mapping” tab in their configuration editor where the available I/O channels can directly be mapped to a global variable. The corresponding variable declarations are automatically available in the project. All available I/O channels can easily be assigned to a variable.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Mapping</th>
<th>Channel</th>
<th>Address</th>
<th>Type</th>
<th>Default Value</th>
<th>Unit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>b_Input.IO0</td>
<td></td>
<td>Digital inputs 10 - 17</td>
<td>%IB0</td>
<td>BYTE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x_Input.IO0.X0</td>
<td></td>
<td>Digital input 10</td>
<td>%DI0.0</td>
<td>BOOL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x_Input.IO0.X1</td>
<td></td>
<td>Digital input 11</td>
<td>%DI0.1</td>
<td>BOOL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x_Input.IO0.X2</td>
<td></td>
<td>Digital input 12</td>
<td>%DI0.2</td>
<td>BOOL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x_Input.IO0.X3</td>
<td></td>
<td>Digital input 13</td>
<td>%DI0.3</td>
<td>BOOL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x_Input.IO0.X4</td>
<td></td>
<td>Digital input 14</td>
<td>%DI0.4</td>
<td>BOOL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x_Input.IO0.X5</td>
<td></td>
<td>Digital input 15</td>
<td>%DI0.5</td>
<td>BOOL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x_Input.IO0.X6</td>
<td></td>
<td>Digital input 16</td>
<td>%DI0.6</td>
<td>BOOL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x_Input.IO0.X7</td>
<td></td>
<td>Digital input 17</td>
<td>%DI0.7</td>
<td>BOOL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Digital inputs 18 - 23</td>
<td>%IB1</td>
<td>BYTE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Digital inputs 18 - 23</td>
<td>%IB2</td>
<td>BYTE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Digital inputs 18 - 23</td>
<td>%IB3</td>
<td>BYTE</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

AC500 uses Intel Byte Order (Little Endian).

Only entries with a data type set in column “Type” can be mapped. These entries can be expanded to show the available I/O channels. If the project has been imported from a previous Automation Builder version, all variables should be checked to avoid inconsistencies concerning the I/O mapping.

6.3.2.13.8 I/O mapping list

Introduction

Automation Builder contains an I/O mapping list feature for creating mapping variables with better usability support compared to the tree structured view.

Details on the tree structured view.
Functionalities of the I/O mapping list:

- Displays I/O mappings for current node and all valid subsequent child nodes.
- Displays channel information with additional columns.
- Supports keyboard functions such as cut, copy, paste, delete, and select all within the editor and within Excel spreadsheet (for bulk editing).
- Contains a toolbar for various actions, e.g. filtering, undo/redo and clear mappings.
- Supports single click edit and easy navigation using arrow keys.
- Improvised error handling:
  - Allows to enter invalid mapping variables. This provides flexibility in bulk editing. Only when saving the project, the errors - according to IEC 61131 standard - are displayed.
  - In the message window, the error log is visible. The user can track the errors to their corresponding channel in the editor.
- Allows multi-selection of rows and columns. (Random selection is not allowed.)

**Editing I/O mapping list**

1. In the device tree, double-click "IO_Bus" to configure entire I/O mapping list of different I/O devices.
2. Enter the variables and descriptions to map the I/O devices.
   
   **Do not start variable names with a number or a special character. When saving the project, this generates an error. Example: 12input3, @input4.**

3. Click “Save Project” to save the I/O mapping changes.

**Configuring I/O mapping list**

Automation Builder supports tree and list based editors for creating I/O mapping variables.

1. From the “Tools” menu, select “Options”.
2. Under Automation Builder, select the “Editors” tab.
3. Choose your desired mapping dialog and click [OK].
   - Choose “tree based” to display the I/O mapping in tree structure.
   - Choose “list based” to display the I/O mapping as list with the functionalities of the ToolBar.
   - Choose “both” to display both the tree structure (“I/O Mapping” tab) and the list view (“I/O mapping list” tab).

**Available channel information**

The I/O mapping list displays the channel information in offline and online mode. In online mode, all columns are read-only. In offline mode, some columns are editable.

The order of the devices in I/O mapping list is synchronized with the order in the device tree.

The channels of a device are ordered by the device description file. If channels have a section, the channel information is represented in a specific format.

Example: Fast counter: Actual value 1. These channels are listed at last position of a device.

**Filtering**

Especially in case of long I/O mapping lists, it might be helpful to filter the I/O mappings. For this, click the “Filter” icon to display all available criteria for filter options.

*When reducing the width of the editor, some filters might be hidden.*

**Undo, redo and clear**

- “Undo”: Cancels the last change.
- “Redo”: Repeats the last change.
- “Clear mappings”: Deletes all variables and descriptions.

### 6.3.2.13.9 Fast counter

#### Configuration for S500 I/O modules

**Configuring the fast counter**

1. In the device tree, add a digital I/O module to the “IO-Bus” node.
2. Double-click the node for the I/O module, open the “Parameters” tab and set the operating mode of the “Fast counter” parameter.

   ≈ Chapter 6.3.2.13.9.1.3 “Operating modes” on page 1577

<table>
<thead>
<tr>
<th>Fast counter</th>
<th>Enumeration of BYTE</th>
<th>0-No counter</th>
<th>0-No counter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detect short circuit at output</td>
<td>Enumeration of BYTE</td>
<td>0-No counter</td>
<td>0-No counter</td>
</tr>
<tr>
<td>Behaviour outputs at comm. erro...</td>
<td>Enumeration of BYTE</td>
<td>0-No counter</td>
<td>0-No counter</td>
</tr>
<tr>
<td>Substitute value</td>
<td>WORD(0..65535)</td>
<td>1-1 Up counter</td>
<td>OFF</td>
</tr>
</tbody>
</table>

3. In the “I/O Mapping” tab channel configuration is displayed.

   ≈ Chapter 6.3.2.13.9.3 “Control of the fast counter” on page 1583
## Operands

### Table 303: Input information

<table>
<thead>
<tr>
<th>Description of the input information</th>
<th>Output information of the user program</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start value 1</td>
<td>Output double word 0</td>
<td>Double word</td>
</tr>
<tr>
<td>Start value 2</td>
<td>Output double word 1</td>
<td>Double word</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Set values for the counters 1 and 2: Each counter can be set to a start value. Start values are loaded into the counter by the user program. Using the set signal (depending on the operating mode either via a terminal or the bit SET within the control byte 1 or 2), the values of the double word variables are loaded into the counter 1 or 2.</td>
</tr>
<tr>
<td>End value 1</td>
<td>Output double word 2</td>
<td>Double word</td>
</tr>
<tr>
<td>End value 2</td>
<td>Output double word 3</td>
<td>Double word</td>
</tr>
<tr>
<td></td>
<td></td>
<td>End value for the counters 1 and 2: The end values for the two counters are stored as comparison values into the module by the user program. Both counters compare continuously whether or not their programmed end value is equal to their actual value. When the counter (actual value) reaches its programmed end value, the binary output CF of the status byte is set permanently.</td>
</tr>
<tr>
<td>Description of the input information</td>
<td>Output information of the user program</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>---------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Control byte 1 &lt;br&gt;see 1)</td>
<td>Output byte 0</td>
<td>Control bytes for the counter 1:</td>
</tr>
<tr>
<td></td>
<td>Byte:</td>
<td><strong>UP/DWN:</strong> In some operating modes, the counter can count downwards, too. If counting down is desired, set the bit UP/DWN to TRUE and the bit SET to 1. When doing so, the counter starts counting downwards from the start value (set value) to the end value (max. from 4,294,967,295 to 0 or hexadecimal from FF FF FF FF to 00 00 00 00). After reaching 0 the counter jumps to 4,294,967,295.</td>
</tr>
<tr>
<td></td>
<td>Bit 0 = UP/DWN</td>
<td><strong>EN:</strong> Processing of the counter signals must be enabled. Depending on the operating mode, enabling is done via a terminal or by the bit EN = TRUE within the control byte.</td>
</tr>
<tr>
<td></td>
<td>Bit 1 = EN</td>
<td><strong>SET:</strong> The counter can be set to a start value (see the description of the set values for the counters 1 and 2 at the beginning of this table.</td>
</tr>
<tr>
<td></td>
<td>Bit 2 = SET</td>
<td><strong>CF_HW</strong></td>
</tr>
<tr>
<td></td>
<td>Bit 3 = CF_HW</td>
<td>0 = state of CF is set to hardware channel (only for mode 1 and 2)</td>
</tr>
<tr>
<td></td>
<td>Bit 4 to Bit 7 free</td>
<td>1 = normal output is set to hardware channel</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bit 3 is evaluated only in control byte of counter 1.</td>
</tr>
<tr>
<td>Control byte 2 &lt;br&gt;see 1)</td>
<td>Output byte 0</td>
<td>Control bytes for the counter 2:</td>
</tr>
<tr>
<td></td>
<td>Byte:</td>
<td><strong>UP/DWN:</strong> In some operating modes, the counter can count downwards, too. If counting down is desired, set the bit UP/DWN to TRUE and the bit SET to 1. When doing so, the counter starts counting downwards from the start value (set value) to the end value (max. from 4,294,967,295 to 0 or hexadecimal from FF FF FF FF to 00 00 00 00). After reaching 0 the counter jumps to 4,294,967,295.</td>
</tr>
<tr>
<td></td>
<td>Bit 0 = UP/DWN</td>
<td><strong>EN:</strong> Processing of the counter signals must be enabled. Depending on the operating mode, enabling is done via a terminal or by the bit EN = TRUE within the control byte.</td>
</tr>
<tr>
<td></td>
<td>Bit 1 = EN</td>
<td><strong>SET:</strong> The counter can be set to a start value (see the description of the set values for the counters 1 and 2 at the beginning of this table.</td>
</tr>
<tr>
<td></td>
<td>Bit 2 = SET</td>
<td><strong>CF_HW</strong></td>
</tr>
<tr>
<td></td>
<td>Bit 3 = CF_HW</td>
<td>0 = state of CF is set to hardware channel (only for mode 1 and 2)</td>
</tr>
<tr>
<td></td>
<td>Bit 4 to Bit 7 free</td>
<td>1 = normal output is set to hardware channel</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bit 3 is evaluated only in control byte of counter 1.</td>
</tr>
</tbody>
</table>
Description of the input information | Output information of the user program | Description
--- | --- | ---

| SET: The counter can be set to a start value (see the description of the set values for the counters 1 and 2 at the beginning of this table.

1) Only for CI581-CN/CI582-CN: Control bytes 1 and 2 are available twice on grounds of data consistency. Hence, a Start and End evaluation is only effected if the signals "Control Byte1_0" and "Control Byte1_1" or "Control Byte2_0" and "Control Byte2_1" (process image) are identical.

### Table 304: Output information

<table>
<thead>
<tr>
<th>Output information</th>
<th>Input information for the user program</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual Value 0</td>
<td>Input double word 0</td>
<td>Double word</td>
</tr>
<tr>
<td>Actual Value 1</td>
<td>Input double word 1</td>
<td>Double word</td>
</tr>
<tr>
<td>Status Byte 0</td>
<td>Input byte 0</td>
<td>Byte: Bit 0 = CF Bit 1 to Bit 7 free</td>
</tr>
<tr>
<td>Status Byte 1</td>
<td>Input byte 1</td>
<td></td>
</tr>
</tbody>
</table>

### Operating modes

Inputs and outputs which are not used by the counters, are available for other tasks.

Legend:

- A refers to input channel A
- B refers to input channel B
- C refers to output channel C

<table>
<thead>
<tr>
<th>Operating mode</th>
<th>Function</th>
<th>Used inputs and outputs</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No counter</td>
<td>none</td>
<td>This operating mode is selected if the integrated fast counter is not necessary.</td>
</tr>
<tr>
<td>1</td>
<td>One count up counter</td>
<td>A = Counting input C = End value reached</td>
<td>The counting input and the output &quot;End value reached&quot; are enabled by the bit EN = TRUE within the control byte.</td>
</tr>
<tr>
<td>Operating mode</td>
<td>Function</td>
<td>Used inputs and outputs</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------</td>
<td>----------</td>
<td>-------------------------</td>
<td>-------</td>
</tr>
</tbody>
</table>
| 2              | One count up counter with enable input via terminal | A = Counting input  
B = Enable input  
C = End value reached | The enable input enables the counting input and the output "end value reached". The counter is only enabled if the enable input = TRUE (signal 1) AND the bit EN = TRUE within the control byte. |
| 3              | Two up/down counters | A = Counting input 0  
B = Counting input 1 | With this operating mode, two counters exist, which are independent of each other. The state "End value reached" is only readable from the two status bytes. It is not readable from output terminals. The counting direction is defined by the bit UP/DWN within the control byte. |
| 4              | Two up/down counters (1 counting input inverted) | A = Counting input 0  
B = Counting input 1 | This operating mode equals operating mode 3 with one exception: The counting input B (of counter 1) is inverted. It counts the TRUE/FALSE edges at input B. |
| 5              | One bidirectional counter with a dynamic set input via terminal | A = Counting input  
B = Dynamic set input | With this operating mode, one bidirectional counter is available which has a dynamic set input. Dynamic means that the set operation is performed at the FALSE/TRUE signal edge (0/1 edge) of the set input and not while the signal is TRUE. The state "End value reached" is only readable from the status byte, not from an output terminal. |
| 6              | One bidirectional counter with a dynamic set input via terminal | A = Counting input  
B = Dynamic set input | This operating mode equals operating mode 5 with one exception: The dynamic set input operates at the TRUE/FALSE edge (1-0 edge). |
<table>
<thead>
<tr>
<th>Operating mode</th>
<th>Function</th>
<th>Used inputs and outputs</th>
<th>Notes</th>
</tr>
</thead>
</table>
| 7              | One bidirectional counter for position sensors | A = Trace A of the position sensor  
B = Trace B of the position sensor | With this operating mode, incremental position sensors can be used which interchange their counting signals on tracks A and B in a 90° phase sequence. Depending on the sequence of the signals at A and B, the counter counts up or down. There is no pulse-multiplier function (e.g. x2 or x4). The position sensor must provide 24 V signals. Signals of 5 V sensors must be converted. Zero traces are not processed. The state "End value reached" is only readable from the state byte 0, not from an output terminal. 
The bit UP/DWN within the control byte must be FALSE. Otherwise, a parameter error occurs. In this operating mode, the maximum counting frequency is:  
I/O modules 35 kHz. Communication interface modules 50 kHz. |
<p>| 8              | Reserved |                        |       |</p>
<table>
<thead>
<tr>
<th>Operating mode</th>
<th>Function</th>
<th>Used inputs and outputs</th>
<th>Notes</th>
</tr>
</thead>
</table>
| 9              | One bidirectional counter for position sensors (pulse multiplier x2) | A = Trace A of the position sensor  
B = Trace B of the position sensor | This operating mode equals operating mode 7 with one exception: There is a pulse multiplication x2 with the evaluation of the counting inputs. This means, that the counter counts both the positive edges and the negative edges of trace A. This results in the double number of counting pulses. The precision increases correspondingly. In this operating mode, the maximum counting frequency is:  
I/O modules 30 kHz.  
Communication interface modules 35 kHz. |
| 10             | One bidirectional counter for position sensors (pulse multiplier x4) | A = Trace A of the position sensor  
B = Trace B of the position sensor | This operating mode equals operating mode 7 with one exception: There is a pulse multiplication x4 with the evaluation of the counting inputs. This means, that the counter counts the positive and negative edges of the traces A and B. This results in the fourfold number of counting pulses. The precision increases correspondingly.  
In this operating mode, the maximum counting frequency is:  
I/O modules 15 kHz.  
Communication interface modules 20 kHz. |
Configuration for onboard I/Os

Configuring the fast counter

1. In the device tree, double-click the “Onboard I/O” node (OBIO).
2. In the “Parameters” tab set the counting mode for the fast counter.

☞ Chapter 6.3.2.13.9.2.2 “Counting modes” on page 1582

3. In the “I/O Mapping” tab channel configuration is displayed.

☞ Chapter 6.3.2.13.9.3 “Control of the fast counter” on page 1583

The parameter of the fast counter channels of the Onboard I/O must be configured before they can be used. User should take these steps to configure the fast counter:

<table>
<thead>
<tr>
<th>Channel</th>
<th>Direction</th>
<th>Width</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual value X</td>
<td>Input</td>
<td>DWORD</td>
<td>Current value of the fast counter.</td>
</tr>
</tbody>
</table>
| State byte X  | Input     | BYTE  | Bit 0 = CF
If the counter reaches the programmed end value, the counter output is stored permanently as CF = TRUE (end value reached). Only, if the counter is set again (set value), CF is reset to FALSE.

**Bit 1 to Bit 7 free**

<table>
<thead>
<tr>
<th>Start value X</th>
<th>Output</th>
<th>DWORD</th>
<th>Each counter can be set to a start value. Start values are loaded into the counter by the user program. Using the set signal (dependent on the operating mode either via a terminal or the bit SET within the control byte X), the values of the double word variables are loaded into the counter X.</th>
</tr>
</thead>
<tbody>
<tr>
<td>End value X</td>
<td>Output</td>
<td>DWORD</td>
<td>The end values for the two counters are stored as comparison values into the module by the user program. Both counters compare continuously, whether or not their programmed end value is equal to their actual value. If the counter (actual value) reaches its programmed end value, the binary output CF of the status byte is set permanently.</td>
</tr>
<tr>
<td>Channel</td>
<td>Direction</td>
<td>Width</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------</td>
<td>-------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Control byte 1</td>
<td>Output</td>
<td>BYTE</td>
<td><strong>Bit 0 = UP/DWN</strong>&lt;br&gt;In some operating modes, the counter can count downwards, too. If counting down is desired, the bit UP/DWN must be set to TRUE. When doing so, the counter starts counting downwards at the start value (set value) to the end value (max. from 4,294,967,295 to 0 or hexadecimal from FF FF FF FF to 00 00 00 00). After reaching 0, the counter jumps to 4,294,967,295.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Bit 1 = EN</strong>&lt;br&gt;The processing of the counter signals must be enabled. Depending on the operating mode, enabling is done via a terminal or by the bit EN = TRUE within the control byte.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Bit 2 = SET</strong>&lt;br&gt;The counter can be set to a start value (see the description of the set values for the counters 1 and 2 at the beginning of this table).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Bit 3 = CF_HW</strong>&lt;br&gt;0 = state of CF is set to hardware channel (only for mode 1 and 2)&lt;br&gt;1 = normal output is set to hardware channel&lt;br&gt;Bit 3 is evaluated only in control byte of counter 1.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Bit 4 to Bit 7 free</strong></td>
</tr>
<tr>
<td>Control byte 2</td>
<td>Output</td>
<td>BYTE</td>
<td><strong>Bit 0 = UP/DWN</strong>&lt;br&gt;In some operating modes, the counter can count downwards, too. If counting down is desired, the bit UP/DWN must be set to TRUE. When doing so, the counter starts counting downwards at the start value (set value) to the end value (max. from 4,294,967,295 to 0 or hexadecimal from FF FF FF FF to 00 00 00 00). After reaching 0, the counter jumps to 4,294,967,295.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Bit 1 = EN</strong>&lt;br&gt;The processing of the counter signals must be enabled. Depending on the operating mode, enabling is done via a terminal or by the bit EN = TRUE within the control byte.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Bit 2 = SET</strong>&lt;br&gt;The counter can be set to a start value (see the description of the set values for the counters 1 and 2 at the beginning of this table).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Bit 3 to Bit 7 free</strong></td>
</tr>
</tbody>
</table>

**Counting modes**

The fast counter can be configured as one mode out of 10 possible modes. The desired operating mode is selected in the PLC configuration using configuration parameters. Inputs and outputs which are not used by the counter are available for other tasks. In the following table, A means input channel A, B means input channel B and C means output channel C.
<table>
<thead>
<tr>
<th>CPUs</th>
<th>Integrated fast counter</th>
<th>Assigned inputs</th>
<th>Assigned Outputs</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>PM50xx</td>
<td>Yes</td>
<td>Input channel 0</td>
<td>Output channel 0</td>
<td>Only 1 fast counter is available on the module. Input channel 0 is the default channel for fast counter. Input channel 1 can be used as another fast counter channel depending on fast counter mode.</td>
</tr>
</tbody>
</table>

Only “Forward Counter” can be configured as fast counter mode for onboard IOs on eCo V3 PLCs.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>PM5012-x-ETH</th>
<th>PM5032-x-ETH</th>
<th>PM5052-x-ETH</th>
<th>PM5072-T-2ETH(W)</th>
<th>PM5082-T-2ETH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Onboard digital inputs</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Channels</td>
<td>6 (incl. 2 fast counter inputs 5 kHz and 4 interrupts)</td>
<td>12 (incl. 4 fast counter/encoder inputs (100 kHz/200 kHz), counter inputs (5 kHz), 4 standard inputs)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Onboard digital outputs</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Channels for transistor version</td>
<td>4 (5 kHz standard and PWM)</td>
<td>8 (incl. 4 fast outputs or 4 PWM/2PTO (100 kHz/200 kHz), 4 standard outputs (5 kHz))</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Chapter 5.2.1.1.2 “Onboard I/Os in processor module PM50x2” on page 196

Control of the fast counter

To control the fast counter configuration open the “I/O Mapping” tab.

The channels can be mapped as described in Symbolic Names for Variables, Inputs and Outputs and have the following meaning. *Chapter 6.3.2.13.7 “Symbolic names for variables, inputs and outputs” on page 1572.*
### Fast counter

<table>
<thead>
<tr>
<th>Channel</th>
<th>Direction</th>
<th>Width</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual value X</td>
<td>Input</td>
<td>DWORD</td>
<td>Current value of the fast counter</td>
</tr>
</tbody>
</table>
| State byte X     | Input     | BYTE     | Bit 0 = CF  
If the counter reaches the programmed end value, the counter output is stored permanently as CF = TRUE (end value reached). Only if the counter is set again (set value), CF is reset to FALSE.  
Bit 1 to Bit 7 free |
<p>| Start value X    | Output    | DWORD    | Each counter can be set to a start value. Start values are loaded into the counter by the user program. Using the set signal (dependent on the operating mode either via a terminal or the bit SET within the control byte X), the values of the double word variables are loaded into the counter X. |
| End value X      | Output    | DWORD    | The end values for the 2 counters are stored as comparison values into the module by the user program. Both counters compare continuously whether or not their programmed end value is equal to their actual value. When the counter (actual value) reaches its programmed end value, the binary output CF of the status byte is set permanently. |</p>
<table>
<thead>
<tr>
<th>Channel</th>
<th>Direction</th>
<th>Width</th>
<th>Description</th>
</tr>
</thead>
</table>
| Control byte 1 | Output    | BYTE | Bit 0 = UP/DWN  
In some operating modes, the counter can count downwards, too. If counting down is desired, the bit UP/DWN must be set to TRUE. If doing so, the counter starts counting downwards at the start value (set value) to the end value (max. from 4,294,967,295 to 0 or hexadecimal from FF FF FF FF to 00 00 00 00). After reaching 0 the counter jumps to 4,294,967,295. |
|            |           |       | Bit 1 = EN  
The processing of the counter signals must be enabled. Depending on the operating mode, enabling is done via a terminal or by the bit EN = TRUE within the control byte. |
|            |           |       | Bit 2 = SET  
The counter can be set to a start value (see the description of the set values for the counters 1 and 2 at the beginning of this table. CF = 0 |
|            |           |       | Bit 3 = CF_HW  
0 = state of CF is set to hardware channel (only for mode 1 and 2)  
1 = normal output is set to hardware channel |
|            |           |       | Bit 3 is evaluated only in control byte of counter 1. |
|            |           |       | Bit 4 to Bit 7 free |
| Control byte 2 | Output    | BYTE | Bit 0 = UP/DWN  
In some operating modes, the counter can count downwards, too. If counting down is desired, the bit UP/DWN must be set to TRUE. If doing so, the counter starts counting downwards at the start value (set value) to the end value (max. from 4,294,967,295 to 0 or hexadecimal from FF FF FF FF to 00 00 00 00). After reaching 0 the counter jumps to 4,294,967,295. |
|            |           |       | Bit 1 = EN  
The processing of the counter signals must be enabled. Depending on the operating mode, enabling is done via a terminal or by the bit EN = TRUE within the control byte. |
Configuration and programming
Configuration in Automation Builder for AC500 V3 products > PLC devices and components

<table>
<thead>
<tr>
<th>Channel</th>
<th>Direction</th>
<th>Width</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Bit 2 = SET</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The counter can be set to a start value (see the description of the set values for the counters 1 and 2 at the beginning of this table.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Bit 3 to Bit 7 free</td>
</tr>
</tbody>
</table>

6.3.2.14   Serial interface
6.3.2.14.1 Setting up a serial interface

General

The configuration for serial interfaces and their protocols is done via two nodes:

- One node represents the common serial parameters related to the hardware port.
- The node below represents the parameterization for the particularly attached protocol.

Supported protocols

- 3S CAA SerialCom (common serial communication, send/receive data)
  - Chapter 6.3.2.14.3 “Configuring CAA SerialCom on serial interface” on page 1590
- Modbus RTU (client & server)
  - Chapter 6.3.2.14.2 “Configuring Modbus RTU on serial interface” on page 1588
  - How to switch between the protocols.

Configuration

The following parameters are available in the configuration view of the COM port node:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value ranges</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run on config fault</td>
<td>No, Yes</td>
<td>If this parameter is set to “Yes” the IEC application will not be prevented from switching to RUN state, independent from possibly existing configuration errors of the particular COM port.</td>
</tr>
<tr>
<td>Transmission rate</td>
<td>9600 baud/sec</td>
<td>Sets up the transmission rate to use for the COM port.</td>
</tr>
<tr>
<td></td>
<td>19200</td>
<td></td>
</tr>
<tr>
<td></td>
<td>38400</td>
<td></td>
</tr>
<tr>
<td></td>
<td>57600</td>
<td></td>
</tr>
<tr>
<td></td>
<td>115200</td>
<td></td>
</tr>
<tr>
<td>Parity</td>
<td>None, Odd, Even</td>
<td>Sets up the parity to use for the COM port.</td>
</tr>
<tr>
<td>Data bits</td>
<td>5 data bits, 6 data bits, 7 data bits</td>
<td>Sets up the number of data bits to use for the COM port.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value ranges</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>8 data bits</td>
<td></td>
</tr>
<tr>
<td>Stop bits</td>
<td>1 stop bits</td>
<td>Sets up the number of stop bits to use for the COM port.</td>
</tr>
<tr>
<td></td>
<td>2 stop bits</td>
<td></td>
</tr>
<tr>
<td>Flow control</td>
<td>No flow control</td>
<td>Allows to switch between different flow control modes (either RTS/CTS hardware or Xon/Xoff software or none). This setting is only valid for RS-232 serial interface mode. In case RS-485 is used for parameter “Serial interface”, flow control must set to “No flow control”. Otherwise a configuration error is triggered.</td>
</tr>
<tr>
<td></td>
<td>Hardware RTS/CTS</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Software Xon/Xoff</td>
<td></td>
</tr>
<tr>
<td>Boot parameter</td>
<td>RS-232</td>
<td>Allows to switch between RS-232 and RS-485. Due to technical reasons, it’s not possible to dynamically switch between the modes. This means, a reboot (or power cycle) of the PLC is required to activate the particular setting once changed.</td>
</tr>
<tr>
<td>Serial interface</td>
<td>RS-485</td>
<td></td>
</tr>
</tbody>
</table>

**Comparison to AC500 V2 PLCs**

The following table shows the differences between AC500 V2 and V3 PLCs regarding the parameter set for serial interfaces:

<table>
<thead>
<tr>
<th>V2 Parameter</th>
<th>Representation in V3</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run on config fault</td>
<td>Run on config fault</td>
<td>Exactly the same</td>
</tr>
<tr>
<td>RTS control</td>
<td>Flow control (partially)</td>
<td>Special modes which allow to use PLC as modem and mode implicitly setting RS-485 will not be taken over. Flow control settings will be limited and only support hardware, software or none.</td>
</tr>
<tr>
<td>Transmission rate</td>
<td>Transmission rate</td>
<td>For V3, the transmission rate range will be 9600 to 115200. Low modes will not be supported due to lack of support in Linux. High rates were only realized in V2 to support field bus plug as well as CS31 field bus. Both protocols are not supported anymore in V3, so these transmission rates won’t be available in V3. Approach: Only support most common transmission rates</td>
</tr>
<tr>
<td>Parity</td>
<td>Parity (subset)</td>
<td>AC500 V3 doesn’t allow to configure parity modes “mark” and “space”. This means, only “none”, “odd” and “even” are configurable.</td>
</tr>
<tr>
<td>Data Bits</td>
<td>Data Bits</td>
<td>Exactly the same</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>Stop Bits</td>
<td>Exactly the same</td>
</tr>
</tbody>
</table>

**6.3.2.14.2 Configuring Modbus RTU on serial interface**

**Enable Modbus RTU**

To enable Modbus RTU on a serial interface the protocol setup per default has to be replaced by either Modbus RTU client or server, depending on required operation mode.

A serial interface supports only one protocol/operation mode at once.
1. Right-click node “CAA_SerialCom” and click “Add object”.
2. Select “Modbus RTU Client” or “Modbus RTU Server” and click “Add object”.
  ⇒ “CAA_SerialCom” is replaced by your selection.

**Parameters**

**Serial**

Serial parameters to be set selecting the interfaces node “COM_1”. They are common for both operating modes client and server.

- The parameter “Data bits” always **has to be** set to “8” for Modbus.

**Modbus RTU server**

Server specific parameters to be set selecting the protocol’s node “Modbus_RTU_Server”.

- **Address**
  Bus address of the PLC as Modbus RTU Server on that interface
- **Byte Order**
Format/Endianness for the transmission of WORD values (register) within the request/response telegram (default: Big Endian)

"Disable"

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable write to %MB from</td>
<td>0</td>
<td>0 ... 65535 Disable write access starting at %MBx</td>
</tr>
<tr>
<td>Disable write to %MB to</td>
<td>0</td>
<td>0 ... 65535 Disable write access up to %MBx</td>
</tr>
<tr>
<td>Disable read from %MB from</td>
<td>0</td>
<td>0 ... 65535 Disable read access starting at %MBx</td>
</tr>
<tr>
<td>Disable read from %MB to</td>
<td>0</td>
<td>0 ... 65535 Disable read access up at %MBx</td>
</tr>
</tbody>
</table>

It is possible to disable read and/or write access to individual segments. Reading/writing is disabled beginning at the set start address and is valid up to the set end address (inclusive).

Modbus RTU client

"Modbus RTU Client" does not have any protocol parameters.

6.3.2.14.3 Configuring CAA SerialCom on serial interface

Enable CAA_SerialCom

The "CAA SerialCom" protocol is the serial standard protocol from CODESYS. It allows users to implement a custom protocol.

How to implement a serial communication for ASCII code via RS232 or RS485 within a AC500 V3 or AC500-eCo V3 PLC is described in an application example. The described implementation is based on the AC500_Com library which implements the CAA SerialCom library to establish a connection via the COM interfaces.

Default setting

When creating a new project, the protocol "CAA SerialCom" is automatically attached to the "COM_1" port of a V3 PLC.
Right-click on the node attached to “COM_1” node in the device tree and click “Delete”.
⇒ The node is switched back to the “CAA SerialCom” protocol.

Parameters

Since “CAA SerialCom” doesn’t represent a “real” protocol, there are no specific parameters required. All common settings can be found at the “COM_1” tab after double-click on the “COM_1” node.

⇒ Chapter 6.3.2.14.1 “Setting up a serial interface” on page 1587

Activate particular configuration parameters

The parameters set up in the Automation Builder device tree are NOT automatically taken over in the PLC.

It is still required to use the “3S IEC POU”s” to activate the particular configuration parameters.
ABB provides the library AC500_Com ("ABB - AC500 / Use Cases / Serial Communication") which contains a POU called “ComGetCaaSerialComConfig”.

The function block can be used to obtain the configuration data which is set up in Automation Builder to directly pass it to “CAA SerialCom-POU Open”. This avoids manual creation of a parameter list.

The following code snippet shows how the COM port is identified by its node name and how the parameter list for the function block is read from the configuration data of the currently loaded IEC application:

```plaintext
FUNCTION_BLOCK GET_CAA_COM_CFG
VAR_INPUT
END_VAR
VAR_OUTPUT
END_VAR
VAR
  ComGetCaaSerialComConfig: ComGetCaaSerialComConfig;
  bExecGetCfg: BOOL := FALSE;
  bDoneGetCfg: BOOL := FALSE;
  bErrorGetCfg: BOOL := FALSE;
  bBusyGetCfg: BOOL := FALSE;
  ErrorIdGetCfg: AC500_Com.ERROR_ID := AC500_Com.ERROR_ID.NO_ERROR;
  asParamList: ARRAY[0..31] OF AC500_Com.Serial_Communication.COM.PARAMETER;
  uiNumParams: UINT := 32;
  uiStep: UINT := 0;
  szNodeName: STRING(80) := 'COM1';
  ComID: AC500_Com.COM_PORT_ID;
  bSuccess: BOOL := FALSE;
  bError: BOOL := FALSE;
END_VAR
VAR CONSTANT
```

Configuration and programming
Configuration in Automation Builder for AC500 V3 products > PLC devices and components
STEP_INIT: UINT := 0;
STEP_GET_ID: UINT := 1;
STEP_FAILED_GET_ID: UINT := NOT STEP_GET_ID;
STEP_GET_CFG_CAA: UINT := (STEP_GET_ID + 1);
STEP_FAILED_GET_CFG_CAA: UINT := NOT STEP_GET_CFG_CAA;
STEP_DONE_SUCCESS: UINT := (STEP_GET_CFG_CAA + 1);
END_VAR

IF uiStep = STEP_GET_ID THEN
    ComId := ComGetIdByName(szNodeName);
    IF ComId = AC500_Com.COM_PORT.COM_ID_INVALID THEN
        uiStep := STEP_FAILED_GET_ID;
    ELSE
        bExecGetCfg := TRUE;
        uiStep := STEP_GET_CFG_CAA;
    END_IF
END_IF

IF uiStep = STEP_GET_CFG_CAA THEN
    ComGetCaaSerialComConfig(
        Execute:= bExecGetCfg,
        Done=> bDoneGetCfg,
        Busy=> bBusyGetCfg,
        Error=> bErrorGetCfg,
        ComID:= ComID,
        pCaaParamList:= ADR(asParamList[0]),
        NumParams:= uiNumParams,
        ErrorID=> ErrorIdGetCfg);
    IF bDoneGetCfg THEN
        uiStep := STEP_DONE_SUCCESS;
    ELSIF bErrorGetCfg THEN
        uiStep := STEP_FAILED_GET_CFG_CAA;
    END_IF
END_IF

IF uiStep = STEP_DONE_SUCCESS THEN
    bSuccess := TRUE;
END_IF

IF uiStep = STEP_FAILED_GET_ID THEN
    bError := TRUE;
END_IF

IF uiStep = STEP_FAILED_GET_CFG_CAA THEN
    bError := TRUE;
END_IF

6.3.2.15 Gateway configuration

1. In the Automation Builder project, right-click the topmost PLC tree node and select "Communication Settings".
   ⇨ The dialog window "Communication Settings" appears.

2. Click "Advanced Settings" to open the dialog ⇨ Chapter 6.4.1.21.2.8.3 "Tab 'Communication Settings'" on page 2427.
   ⇨ This information will be stored in the project file.
6.3.2.15.1 Gateway settings on windows server

Gateway as a service
To allow multiple concurrent users from different user sessions on the server to connect to PLCs, the user has to run CODESYS gateway as a system service. This is managed by a service called "CoDeSys V2.3 Gateway Service Wrapper". The service starts on system start-up and launch the gateway.

If you want to restart the gateway, use "Services management console" to restart "CoDeSys V2.3 Gateway Service Wrapper".

This executable is installed only on a windows server system and a related service (CoDeSys V2.3 Gateway Service Wrapper) is created and started.

For V3 PLC the V3 gateway always runs as a service on windows servers and also on other Windows OS variants (e.g. Windows 10).

Gateway settings
You can set the communication settings in the Automation Builder project for every PLC. Otherwise, an error message is displayed while trying to open CODESYS.

See the description for Gateway configuration and select "TCP/IP" under "Connection" Chapter 6.3.2.15 "Gateway configuration" on page 1593.

Windows server usage in Automation Builder requires modifications of the system environment and of the settings in Automation Builder, e.g. permissions, licensing, session handling etc. How to setup system and software for Windows server is described in the application note Windows Server 2016 - RDM access.

6.3.2.16 CAN onboard

6.3.2.16.1 CANopen

General
In Automation Builder, a CANopen network consists of one CANopen manager which acts as master device and optional CANopen remote devices which act as slave devices.

CANopen manager (master)
General

Tab 'CANopen Manager - General'

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Node-ID&quot;</td>
<td>The node number identifies the CANopen Manager as unique (range of values: 1...127).</td>
</tr>
<tr>
<td>&quot;Check and Fix Configuration&quot;</td>
<td>Opens the dialog of the same name. See below for details.</td>
</tr>
</tbody>
</table>
“Autostart CANopen Manager”

- The CANopen Manager starts automatically (switches to OPERATIONAL mode) after all required slaves are ready.
- The CANopen Manager has to be started from the application. The function block Cia405.NMT can be used to do this.
  
  Hint: As long as the CANopen Manager is not in OPERATIONAL mode, no PDOs are sent (outputs refreshed).

“Polling of optional slaves”

- When a slave does not respond during the boot sequence, the CANopen Manager interrogates it every second until it does respond.

  Constantly polling the slave increases the bus cycle time, which can interfere with the application (especially motion applications). You can deactivate polling to avoid this behavior. If polling is deactivated, then a slave is detected again when it sends a bootup message.

“Start slaves”

- The CANopen Manager is responsible for starting the slaves.
- You have to start the slaves from the application. Use the Cia405 NMT function block to do this.

“NMT start all (if possible)”

- If the “Start slaves” option is activated, then the CANopen Manager starts all slaves with an "NMT Start All" command. The "NMT Start All" command is not executed as long as optional slaves are not yet ready to be started. In this case, the CANopen Manager starts each slave individually. The "NMT Start All" command can be guaranteed only in a project without optional slaves.

“NMT error behavior”

- "Restart slave". If an error occurs during slave monitoring (NMT Error Event), then the slave is restarted automatically by the stack (NMT Reset + SDO Configuration + NMT Start).
- "Stop slave". If an error occurs during slave monitoring (NMT Error Event), then the slave is stopped. Then you have to reset the slave from the application, using the Cia405 NMT function block.

Table 306: “Guarding”

Working with heartbeat messages is an alternative method of monitoring. It can be executed from both master and slave nodes, as opposed to node guarding. Normally the master sends heartbeat messages to the slaves.

“Enable heartbeat producing”

The master sends heartbeats. They define the time interval in the “Producer time”. When the slaves are provided with the heartbeat function, a heartbeat consuming entry from the slave is created for the master. Then the Node-ID and the 1.5x heartbeat interval of the master are applied.

- Node guarding is enabled for the slaves. The settings from the EDS file of the slaves are used for this. If the values there cannot be used, then default values are used. Note that a CANopen Slave device can also be configured as a heartbeat producer.

“Node-ID”

Unique identification (1-127) of the heartbeat producer on the bus

“Producer time (ms)”

Interval length between successive heartbeats (in milliseconds)

“Redundancy Node-ID”

Requirement: A “Redundancy Configuration” object is inserted below the application.

Unique identification (1-127) of the redundant heartbeat producer on the bus

“Redundancy wait time (µs)”

Requirement: A “Redundancy Configuration” object is inserted below the application.

Duration of how long the passive controller waits for the heartbeat of the active controller. If this time is exceeded, then the passive controller takes on the active role.
Table 307: “SYNC”

<table>
<thead>
<tr>
<th>“Enable SYNC producing”</th>
<th>(disabled by default). The CANopen manager sends SYNC telegrams. The synchronous PDOs are sent directly after the SYNC telegram.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“COB-ID (Hex)”</td>
<td>CAN-ID of the SYNC telegram. Range of possible values: [1...2047].</td>
</tr>
<tr>
<td>“Cycle period (µs)”</td>
<td>Interval length (in microseconds) after which the SYNC telegram is sent.</td>
</tr>
<tr>
<td>“Window length (µs)”</td>
<td>Length of the time frame for synchronous PDOs (in microseconds).</td>
</tr>
<tr>
<td>“Enable SYNC consuming”</td>
<td>(disabled by default). Another device must produce the SYNC telegrams that are received by the CANopen Manager.</td>
</tr>
</tbody>
</table>

NOTICE!
If SYNC producing is enabled for the CANopen manager, then you are not permitted to select the “Enable SYNC producing” option for all other bus devices.

Table 308: “TIME”

<table>
<thead>
<tr>
<th>“Enable TIME producing”</th>
<th>(disabled by default). The CANopen Manager sends TIME messages.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“COB-ID (Hex)”</td>
<td>(Communication Object Identifier): identifies the time stamp of the message. Default values: [0...2047], preset 16#100</td>
</tr>
<tr>
<td>“Producer time (ms)”</td>
<td>Interval (in milliseconds) when the time stamp is sent. This value has to be a multiple of the task cycle time. Possible values [0, 65535]</td>
</tr>
</tbody>
</table>

The run time has to support high resolution timestamps. If not, then an error message is displayed.

See also
- Chapter 6.3.2.16 “CAN onboard” on page 1594
- Chapter 6.3.2.16.1.3.2 “Tab 'CANopen Remote Device - General'” on page 1597

Dialog 'Check and Fix Configuration'
If you insert several devices below the CANopen manager, then error messages may report multiple assigned Node-IDs or invalid COB-IDs. The “Check and Fix Configuration” button opens a dialog for solving these conflicts.
For conflicts with Node-IDs or PDO COB-IDs, you can click “Edit Conflicts” to open a dialog with detailed information.

Table 309: “Node-ID and COB-ID conflicts”

<table>
<thead>
<tr>
<th>“Doubled node number”</th>
<th>List of all devices with identical IDs. In the field of the “Node-ID” column, you can enter new node numbers for the affected devices.</th>
</tr>
</thead>
</table>
| “Incorrect and double assignment of PDO COB-IDs” | The COB-IDs that are generated automatically from the device description files may not be permitted. All incorrect entries are listed with the respective device names, Node-IDs, and indexes. There are three options for correcting invalid COB-IDs:
  * Correct the displayed formula for calculating the COB-IDs so that a valid COB-ID results. You can change the formula in the respective table element.
  * Accept the automatic suggestion for the COB-ID by clicking the respective button.
  * Accept all automatic suggestions by clicking the “Use Suggested COB-ID” button. |

Corrected entries are removed from the displayed list automatically.
You can solve timing problems automatically by using the “Automatic Repair”. The command modifies all timing values to compatible values. (The time should be a multiple of the task time.)

CANopen remote device (slave)

General

In CODESYS, a CANopen Remote Device is a slave device that you insert below a CANopen Manager in the device tree of a project. A distinction is made between modular and non-modular slaves:

- **Modular slaves**: You can insert CANopen modules (submodules) below a modular slave. These modules provide a “I/O Mapping” tab to map their inputs and outputs. Modular slaves can also have fixed I/Os. Then these devices also provide the “I/O Mapping” tab. Modular devices provide the “Configure PDO mapping automatically” option, which we recommend for standard applications. You find this option in the “CANopen Remote Device” dialog, on the “General” tab.

- **Non-modular slaves**: You cannot insert additional modules below a non-modular device. The inputs and outputs of these devices are mapped in the “I/O Mapping” dialog. Automatic mapping is not possible here.

See also

- Chapter 6.3.2.16.1.3.2 “Tab ‘CANopen Remote Device - General’” on page 1597

Tab 'CANopen Remote Device - General'

The general settings of the CANopen Slave are defined in this dialog of a CANopen Remote Device (slave).

### Table 310: “General”

<table>
<thead>
<tr>
<th><strong>Node-ID</strong></th>
<th>The node number identifies the CANopen Remote Device uniquely. It corresponds to the number (value between 1 and 127) set on the device (hardware). You have to provide the Node-ID as a decimal.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Expert settings</strong></td>
<td>☑: All settings are displayed that are predefined by the device description (EDS file) for the device.</td>
</tr>
<tr>
<td><strong>SDO channels (...)</strong></td>
<td>Click this button to open a dialog for activating the SDO channels that are predefined in the EDS file. Service data objects (SDOs) allow access to all entries in the CANopen object directory. An SDO creates a peer-to-peer communication channel between two devices (SDO server and client channel).</td>
</tr>
<tr>
<td><strong>Optional device</strong></td>
<td>☑: The slave is optional and not required for starting the CAN network.</td>
</tr>
<tr>
<td><strong>Sync producing</strong></td>
<td>Available only when the “Enable sync producing” option is cleared in the CANopen Manager. ☑: The I/O transmission is synchronized on the bus. The slave works as a sync producer. The parameters of the sync interval are defined in the settings of the CANopen Manager.</td>
</tr>
<tr>
<td><strong>No initialization</strong></td>
<td>This option is for non-configurable slave that already start with a valid configuration. ☑: The master does not send configuration SDOs or NMT start commands to the slave. PDO communication and monitoring (heartbeat, node guarding) are performed when this has been configured in the configurator. If the slave does not start automatically, then the user can use the CiA405 NMT function block to send an NMT start command to the slave.</td>
</tr>
</tbody>
</table>
"Default settings"  The availability of this option depends on the contents of the device description file.

- Activated by default. The slave nodes are reset to the default parameters before the configuration is loaded to the device or always when the slave is configured. Which parameters can be set is device-specific. The concrete task is performed from the subindex of the list box.
  - "Sub:001": All parameters are reset.
  - "Sub:002": Communication parameters (index 1000h - 1FFFh manufacturer-specific communication parameters) are reset.
  - "Sub:003": Application parameters (index 6000h - 9FFFh manufacturer-specific application parameters) are reset.
  - "Sub:004" - "Sub:127": Manufacturer-specific, individual selection of parameters is reset.
  - "Sub:128" - "Sub254": Reserved for future purposes

"Autoconfig PDO mapping"  This option is available for modular devices only.

- PDO mapping is generated automatically from the definitions in the device description and then cannot be changed in the two mapping dialogs. If the automatically generated mapping does not match your application, then you can deactivate the option and configure the mapping manually. We recommend that this option is activated for standard applications.

---

**Table 311: “Node Guarding”**

Node guarding is an outdated monitoring method and should not be used anymore because it uses RTR frames. You should always use heartbeats whenever possible. In some exceptions, such as for older slaves, you can use only node guarding.

- **"Enable node guarding"**  ☑: The CANopen Manager sends a message to the slave in the “Guard time (ms)” interval. If the slave does not respond with the given “Guard COB-ID” (Communication Object Identifier), then the CANopen Manager resends this message as many times as defined in “Lifetime factor” or until the slave responds.

  If the slave does not respond, then it is marked as "unavailable".

- **“Guard time (ms)”**  Interval for sending messages (default: 200 ms)

- **“Lifetime factor”**  When the slave does not respond, a node-guarding error is established according to the “Lifetime factor” time multiplied by the “Guard time”.

- **“Enable heartbeat producing”**  ☑: The module sends heartbeats in the time intervals as given in “Producer time (ms)”.

- **“Producer time (ms)”**:  The default setting is 200 as long as there is no special entry or the entry in the device description file is 0.

- **“Heartbeat consuming (…)”**  Opens a “Heartbeat Consuming Properties” dialog. There you activate the slaves that you want to watch.

  The number of possible slaves to be monitored is defined in the EDS file. To do this, you must select the "Enable" check box and enter the Node-ID of the slave and the required values in the “Heartbeat time” field (in milliseconds). Then the slave monitors the heartbeats that are sent from the affected slaves (defined by the Node-ID). When no more heartbeats are received, the slave switches off the I/Os.

  When a slave is monitoring, a green check mark is displayed on the “Heartbeat Consuming” button.

**Note:** When you insert a device with the heartbeat function, its heartbeat settings are harmonized automatically with the master (CANopen Manager).
**Table 312: “Emergency”**

<table>
<thead>
<tr>
<th>“Activate Emergency”</th>
<th>When internal errors occur, the slave sends emergency messages with a unique COB-ID. You can read these messages by using the function blocks from the library CAA Can Low Level Extern (RECV_EMCY_DEF, RECV_EMCY).</th>
</tr>
</thead>
<tbody>
<tr>
<td>“COB-ID”</td>
<td>CAN ID of the EMCY message. Range of possible values: [1...2047].</td>
</tr>
</tbody>
</table>

**Table 313: “TIME”**

The availability of this function depends on the device description.

| “Enable TIME producing” | ☑: The device sends TIME messages. |
| “COB-ID (Hex)”          | (Communication Object Identifier): identifies the time stamp of the message. |
| “Enable TIME consuming” | ☑: The device processes TIME messages. |

**Table 314: “Checks at Startup”**

The respective information is read from the firmware of the CANopen Slave (0x1018 identity object) and compared to the information from the EDS file. In case of disparities, the configuration is stopped and the slaves are not started.

| “Vendor ID” | ☑: Check of the vendor ID at startup |
| “Product number” | ☑: Check of the product number at startup |
| “Revision number” | ☑: Check of the revision number at startup |

See also
- ☇ Chapter 6.3.2.16.1.2.2 “Tab ‘CANopen Manager - General’” on page 1594
- ☇ Chapter 6.3.2.16 “CAN onboard” on page 1594

**Tab 'CANopen Device - PDOs'**

Object: CANopen Remote Device, CANopen Local Device

This dialog is available only in the device editor of a CANopen Slave of version V3.5.6.0 or higher. It shows all PDOs and their default settings. In this dialog, you can add new objects and delete or edit existing objects.

On the left side, there are the PDOs that the slave receives from the master. On the right side, there are the PDOs that the slave sends to the master.

| “Add PDO” | Opens the “Select PDO” dialog where all available PDOs are displayed. In this dialog, you select the PDOs to be added to “Receive PDOs” or “Transmit PDOs”. |
| “Add Mapping” | Opens the “Select Item from Object Directory” dialog. Objects are listed there that you can add to the PDO mapping. |
| “Edit” | When a PDO is selected, the “PDO Properties” dialog opens. When a PDO mapping is selected, the “Select Item from Object Directory” dialog opens. |
| “Delete” | Deletes the selected objects from the list |
| “Move Up” | Moves the selected object upwards by one line. |
| “Move Down” | Moves the selected object downwards by one line. |

See also
- ☇ Chapter 6.3.2.16 “CAN onboard” on page 1594
Every PDO message must have a COB-ID (Communication Object Identifier). You can input explicit values (example: 16#201) or formulas (example: NODEID+16#200).

Remote Transmission Request. This option is available for transmit PDOs only. You can use an RTR frame for interrogating the PDO externally.

You can edit this field only if the device supports this functionality. The inhibit time is the minimum time between two messages of a specific PDO. You can use this setting for preventing PDOs from being sent too often when their values are edited. Default: "0". Possible values: 0–65535.

- **Acyclic - synchronous**: When a change is made, the PDO is transmitted synchronously, but not periodically. (default)
- **Cyclic - synchronous**: The PDO is transmitted every nth sync.
- **Synchronous – only RTR**: Available for transmit PDOs only. After a synchronization message, the PDO is updated, but not transmitted. Transmission is by explicit request only (Remote Transmission Request).
- **Asynchronous – only RTR**: Available for transmit PDOs only. The PDO is updated and transmitted by explicit request only (Remote Transmission Request).
- **Asynchronous – manufacturer specific**: The PDO is transmitted only after specific events.
- **Asynchronous – device profile**: The PDO is transmitted according to the CiA device profile.

For transmission type "Cyclic - synchronous" only. Indicate the interval for transmitting the PDOs. The value is a multiple of the "Cycle period (µs)" of the CANopen Manager. Default: 1. Possible values: 1–240. Example: Number of syncs = 4, Cycle Period = 1000 µs → transmission interval = 4000 µs

Only for transmission types "Asynchronous - manufacturer specific" and "Asynchronous - device profile".

You can edit this field only if the device supports this functionality. Indicate the time span that should be between two PDO transmissions PDOs (in milliseconds). Default: "0". Possible values: 0–65535.
| “Access type” | ● “RW”: Read/Write  
|               | ● “RO”: Read Only  
|               | ● “WO”: Write Only  
|               | ● “RWW”: Read/Write per SDO; write permission per PDO (==> RxPDO, output from the master viewpoint, input from point of view of the slave).  
|               | ● “RWR”: Read/Write per SDO; read permission per PDO (==> TxPDO, input from the master viewpoint, output from the point of view of the slave).  
|               | ● CONST=constant |

| “Type” | Data type of the object |
| “Default value” | Default value of the object |
| “Bit length” | Length of the object |

Tab 'CANopen Remote Device - SDOs'

During the initialization of the CAN bus, CODESYS transmits the current configuration settings by using SDOs (service data objects).

On this tab, you configure the necessary SDOs. You configure the necessary SDOs and determine the transmission order of the objects and the actions taken in case of a transmission error.

The object order in this list corresponds to the transmission order of SDOs to the module.

**NOTICE!**
If the “Expert settings” option is not activated for the current device, then only the user-defined SDOs are shown here.

| “Add SDO” | Opens the “Select Item from Object Directory” dialog where all available SDOs are displayed. The selected object is inserted after the selected object. |
| “Edit” | Opens the “Select Item from Object Directory” dialog and marks the corresponding object. You can modify the object parameters or replace the object with another one. |
| “Delete” | Deletes the selected objects from the list |
| “Move Up” | Moves the selected object upwards by one line. |
| “Move Down” | Moves the selected object downwards by one line. |
| “Abort on Error” | ☑: If an error is detected for this SDO, then the stack stops the configuration phase of the current slave. The slave remains in PREOPERATIONAL mode. |
| “Jump to Line on Error” | ☑: The transmission is continued with the SDO that you indicated in the “Next Line” column. |
| “Next Line” | Line number where processing continues if there is an error detected |
| “SDO Timeout (ms)” | Timeout for the SDO transmission. If the slave does not respond to the SDO request within this time, then the transmission is canceled with a timeout. |
“Create all SDOs”  
☑: Creates an SDO for all writable objects starting at index 16#2000 for which a default value is given in the EDS. Only experts should use this option. It should be deactivated for standard use.

“Write complete PDO configuration”  
☑: This option forces the writing of all PDO configuration objects. In this way, you make sure that the settings in the project correspond to those of the slave.  
☐: PDOs are not deactivated explicitly. The requirement is that the “Default settings” option is activated in the common settings of the slave and the PDOs are also deactivated in the EDS. If the default values in the EDS do not match the default settings of the slave firmware, then this procedure may cause problems. In this case, you should activate this option.

See also
●  Chapter 6.3.2.16 “CAN onboard” on page 1594

Dialog ‘Select Item from Object Directory’

The table shows all object directory entries from the device EDS file for each SDO that are writable and not larger than 4 bytes. Before you add an SDO for selection in the SDO dialog, you can modify its parameters in the fields below the table. In this way, you can also created an SDO that is not writable in the EDS file by entering a new index/subindex value.

| “Name” | COB-ID of the PDO or the name of the mapped object as it is used in the device description and in the object directory. |
| “Index” | Index of the object |
| “Subindex” | Subindex of the object |
| “Access type” | ● "RW": Read/Write  
● "WO": Write Only  
● "RWW": Read/Write per SDO; write permission per PDO (==> RPDO, output from the master viewpoint, input from point of view of the slave).  
● "RWR": Read/Write per SDO; read permission per PDO (==> TPDO, input from the master viewpoint, output from the point of view of the slave). |
| “Type” | Data type of the object |
| “Default value” | Default value of the object |
| “Bit length” | Length of the object |
| “Value” | |

CANopen module

CANopen modules are components that you insert below a CANopen remote device.

6.3.2.16.2 J1939

General

J1939 is a CAN-based protocol (CAN stands for "Controller Area Network"). It was developed for serial data transmission between electronic control units (ECU) in heavy goods vehicles. The CODESYS plug-in 'DeviceEditorJ1939' provides dialogs to configure J1939 devices according to SAE J1939 standards.

See also
●  Chapter 6.3.2.16 “CAN onboard” on page 1594
Bus Cycle Task

Behavior of the bus cycle for J1939

(1) Receive single package PG
(4) Receive multi-package PGs, send PGs

See also
- Tab `<device name> I/O Mapping`

J1939 manager

General

The J1939 Manager is inserted in the device tree below the CAN bus node. It provides the J1939 parameter groups and signal database. The ECUs are inserted below the J1939 Manager.

The “Scan Devices” command is not available for J1939.
(1) CANopen Manager    (2): J1939 Manager    (3) J1939 ECU
See also
● ☺ Chapter 6.3.2.16 “CAN onboard” on page 1594
● ☺ Chapter 6.3.2.16.2.3.2 “Tab ‘J1939 Manager - General’” on page 1604

Tab ‘J1939 Manager - General’

In CODESYS version 3.5 SP17 and CODESYS J1939 Manager SL version 4.0.0.0, the J1939 configurator is no longer supplied with a parameter group / signal database. The old database is no longer supported.

However, you can post-install a DBC database in the J1939 Manager. A database can be purchased, for example from CSS Electronics:

If you do not install a database, then you can also configure parameter groups and signals manually on the “User-Defined” tab.

<table>
<thead>
<tr>
<th>&quot;Databases&quot;</th>
<th>List with names of installed databases (DBC or DB format)</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Install&quot;</td>
<td>Opens the file manager to select a J1939 file (DBC or DB format). The J1939 files are usually stored in &quot;C:\ProgramData\CODESYS\J1939 Databases&quot;.</td>
</tr>
<tr>
<td>&quot;Uninstall&quot;</td>
<td>Uninstalls the selected database</td>
</tr>
<tr>
<td>&quot;Set as default&quot;</td>
<td>Sets a database as the default database. This database is then set as default in the “Add Parameter Group” and “Add Signal” dialogs.</td>
</tr>
</tbody>
</table>

See also
● ☺ Chapter 6.3.2.16 “CAN onboard” on page 1594

J1939 ECU

6.3.2.16.2.4.1  Tab ‘J1939 ECU - General’…………………………………………………………… 1604
6.3.2.16.2.4.2  Tab ‘J1939 ECU - TX Signals’……………………………………………………… 1605
6.3.2.16.2.4.3  Tab ‘J1939 ECU - P2P RX Signals’…………………………………………………… 1607

Tab ‘J1939 ECU - General’

In this dialog of the J1939 ECU editor, the general parameters of a J1939 ECU can be displayed and modified.

Table 315: “General”

| “Preferred address” | Address of the ECU. If more than one ECU with the same address exists in the network, then all affected ECUs get a new address. The requirement is that the ECUs allow an address change (“Arbitrary Address Capable”). |
| "Local Device"    | ☑ You can configure any number of local ECUs. Then every local ECU is its own ECU instance in the J1939 network. For local devices, an additional “RX Signals (P2P)” dialog is provided to configure received signals. |
Table 316: “ECU NAME”

<table>
<thead>
<tr>
<th><strong>“NAME (64 bit): 16#”</strong></th>
<th>Hexadecimal 64-bit code that contains complete information about the subsequent parameters. Each time this code is modified, the respective parameter is also modified. The same is true for the other direction.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Arbitrary address capable”</strong></td>
<td>If the ECU detects an address conflict, then it tries independently to set another address.</td>
</tr>
<tr>
<td><strong>“Industry group”</strong></td>
<td>List of industry groups according to the definition from SAE J1939.</td>
</tr>
<tr>
<td><strong>“Vehicle system instance”</strong></td>
<td>The parameter depends on the “Vehicle system”. The 4-bit value assigns a number to each instance of the “Vehicle system”.</td>
</tr>
<tr>
<td><strong>“Vehicle system”</strong></td>
<td>The value is defined in the SAE J1939 standard.</td>
</tr>
<tr>
<td><strong>“Reserved”</strong></td>
<td>Always deactivated and reserved for future SAE definitions.</td>
</tr>
<tr>
<td><strong>“Function”</strong></td>
<td>The parameter is defined and assigned by SAE. The range of values is 0...255, but not all values are assigned. The interpretation of values, which are greater than or equal to 127, depends on the “Industry” selection. For example, the value “133” means “Product Flow” in the &quot;Agricultural and Forestry Equipment” industry. If &quot;Construction Equipment&quot; is selected for “Industry”, then the same value means “Land Leveling System Display”. If the value is less than 128 (0 – 127), then there is no dependency to other parameters.</td>
</tr>
<tr>
<td><strong>“Function instance”</strong></td>
<td>The parameter is related to the “Function” field. A J1939 network can consist of multiple ECUs with the same “Function”. The 5-bit “Function instance” assigns a number to each instance of the “Function”, where 0 is assigned to the first instance.</td>
</tr>
<tr>
<td><strong>“ECU instance”</strong></td>
<td>A J1939 network can include multiple ECUs that have the same task. For example, a vehicle can have two identical ECUs, where one measures vehicle speed and the other measures the trailer speed.</td>
</tr>
<tr>
<td><strong>“Manufacturer code”</strong></td>
<td>The 11-bit manufacturer code is assigned by SAE and indicates the company that manufactured the ECU. This code is defined in the SAE J1939 document.</td>
</tr>
<tr>
<td><strong>“Identity number”</strong></td>
<td>The 21-bit identity number is assigned by the manufacturer and should be used for assuring unique names in a product line. The manufacturer can also add more information to the identity number, such as serial number and date of manufacture.</td>
</tr>
</tbody>
</table>

Table 317: “Communication Watchdog”

| **“Enable communication watchdog”** | The stack checks whether the ECU transmits data within the given “Watchdog time”. If this does not happen, then the device is classified as "not available" and highlighted in red in the device tree. |

See also

- § Chapter 6.3.2.16 “CAN onboard” on page 1594

Tab ‘J1939 ECU - TX Signals’

This dialog shows the parameter groups that are transmitted to all other ECUs (broadcast) or to a specific ECU (P2P). In this dialog, you can activate and deactivate individual groups and modify their parameters. You can also add new groups or signals to the list.
“Enable”

- The parameter group is transmitted.
- The parameter group is not transmitted for a local device. For a remote device, the PLC does not process this group.

“Type”

- “Broadcast”: The parameter group is transmitted to all ECUs.
- “Peer-to-Peer P2P”: The parameter group is transmitted to a specific ECU.

“Add PG”

Opens the “Add Parameter Groups” dialog.

“Add Signal”

Opens the “Add Signal” dialog. The button is enabled only if you have selected a parameter group.

Parameter group properties

Table 318: “General”

| “PGN” | The “parameter group number” is a unique number for addressing a parameter group. |
| “Name” | Name of the parameter group |
| “Description” | Description of the parameter group |
| “Length” | The length of the message data (0…1785 bytes). Due to the maximum array length of 8 bytes, messages with over 8 bytes are transmitted as multipackages. |

Table 319: “Transmission settings”

These settings are provided only for the TX parameter groups of local devices.

| “Priority” | Priority of the parameter group (0..7). Priority 0 is the highest and 7 is the lowest. |
| “Target address” | The target address is needed for P2P parameter groups only. |
| “Transmission mode” | Determines the time when a parameter group is transmitted (for local devices). |
| “Mode change” | The PG is transmitted when the value of the signal changes. |
| “Cyclic” | The PG is transmitted after a specified number of PLC cycles (see cycle time factor). |
| “On request” | The PG is transmitted on request of another device. |
| “Application-controlled” | The PG is transmitted when triggered by the application. |
| “Cycle time factor” | Number of PLC cycles after which the parameter group is transmitted. Only applies for cyclic transmission. |

Signal parameters

Table 320: “General”

| “SPN” | Suspect Parameter Number. One of the numbers assigned by the SAE for a specific parameter in a parameter group. |
| “Name” | Name of the parameter |
| “Description” | Description of the parameters |
| “Length (bits)” | Length of the signal (in bits: 1…14280). |
| “Byte position (0..1784)” | Start byte in the parameter group (0…1784). |
| “Bit position (0..7)” | Bit position of the start byte (0..7). |
Table 321: “Conversion”

<table>
<thead>
<tr>
<th>“Conversion”</th>
<th>TRUE: The value is calculated with scaling and offset.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“RAW data type”</td>
<td>Format of the raw data: Unsigned / Signed / Float / Double</td>
</tr>
<tr>
<td>“Byte order”</td>
<td>Little endian or big endian of the raw signal</td>
</tr>
<tr>
<td>“Scaling”</td>
<td>Factor (for “Conversion” = TRUE)</td>
</tr>
<tr>
<td>“Offset”</td>
<td>Offset (for “Conversion” = TRUE)</td>
</tr>
<tr>
<td>“Minimum value”</td>
<td>Expected minimum value of the converted signal (for informational purposes only)</td>
</tr>
<tr>
<td>“Maximum value”</td>
<td>Expected maximum value of the converted signal (for informational purposes only)</td>
</tr>
<tr>
<td>“Unit”</td>
<td>Unit of the converted signal</td>
</tr>
<tr>
<td>“ICE data type”</td>
<td>Resulting data type of the I/O channels</td>
</tr>
</tbody>
</table>

See also
- Æ Chapter 6.3.2.16 “CAN onboard” on page 1594

Tab 'J1939 ECU - P2P RX Signals'

This dialog is available for local ECUs only. It shows all PGs (parameter groups) that should be received by other ECUs. In this dialog, individual groups can be activated and deactivated as well as their parameters modified. New groups or signals can also be added to the list.

The commands and parameters of this dialog are the same as those on the “TX Signals” tab.

See also
- Æ Chapter 6.3.2.16.2.4.2 “Tab 'J1939 ECU - TX Signals’” on page 1605

6.3.2.16.3 Command ‘Scan for Devices’

Function: The command establishes a brief connection to the hardware and determines the devices in the network. Then you can apply the devices found into the device tree of your project.

Call: Menu bar: “Project”; context menu of a device object in the device tree

Requirement: The communication settings to the controller are correct. The gateway and the PLC are started. The device supports the scan function.

The following devices provide the scan function: EtherCAT master, EtherNet/IP Scanner (IEC), Sercos master, CANopen Manager, CANopen Manager SIL2, PROFINET controller and PROFIBUS DP master.

You can perform the device scan immediately if the scan function is permanently implemented in the PLC. When scan function is implemented in a library, you have to log in only one time to download the library to the controller.

The command refers to the master controller selected in the device tree. For example, an already inserted PROFINET IO controller can be selected and the command used to determine the I/O devices and I/O modules assigned to it.

After performing the scan operation, the “Scan Devices” dialog opens and displays the found devices.
### Dialog 'Scan Devices'

#### Table 322: “Scanned Devices”

<table>
<thead>
<tr>
<th>Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Device name, Device type, Address, Station name, etc.</strong></td>
<td>Data about the scanned device depending on network type.</td>
</tr>
<tr>
<td></td>
<td>When you change a value in the list of scanned devices, the value is shown in italics. This indicates that the new value has been changed in the editor in CODESYS, but not in the device. When you download the value to the device, it is shown normally.</td>
</tr>
<tr>
<td></td>
<td>Value that indicate differences between the project and the scanned device are shown in orange.</td>
</tr>
<tr>
<td></td>
<td>If multiple device descriptions are available for the scanned device, then the name is displayed in bold. The selection of the matching device description is resolved differently for different fieldbuses. For more detailed information, see the corresponding fieldbus chapters.</td>
</tr>
<tr>
<td></td>
<td>If a device description cannot be found, then the following message is shown: “Attention! The device was not found in the repository.” Depending on the bus system, additional information is displayed, such as manufacturer number and product number. The device cannot be inserted into the project without the installed device description.</td>
</tr>
</tbody>
</table>

- **Show differences to project**
  - ✓: The table in the dialog also shows additional configured devices (in the device tree of the project).
  - ☐: The table shows all scanned devices. The configured devices are not shown.

- **Scan for Devices**
  - Starts a new search.

- **Copy All Devices to Project**
  - The device that is selected in the table is inserted into the device tree in the project. If nothing is selected, then all scanned devices are shown.

### NOTICE!

If you insert devices, which are available in the device tree, to the device tree with “Copy All Devices to Project”, then the following should be noted. The data of the “Process Data” and “<...> I/O Mapping” tabs of the existing devices can be overwritten with the data of the recently inserted devices.

### Table 323: “Configured Devices”

This part of the dialog is visible only when you select the “Show differences to project” option.

Differences between the scanned and configured devices are color-coded. Devices displayed in green are identical on both sides. Devices displayed in red are available only in the view of the scanned or configured devices.

- If you have selected a device in both views, then the scanned devices are inserted above the selected configured device.
- If you have selected a device in both views, then the scanned devices are inserted below the selected configured device.
- If you have selected a device in both views, then the configured devices are replaced by the selected scanned device.
- All scanned devices are copied to the project.
- Deletes the selected configured device.
6.3.2.16.4 Tab 'CANbus - General'
Table 324: “General”

| “Network” | Number of the CAN network that is linked via the CAN bus interface. Permitted values: 0 to 100. |
| "Baud rate" | Baud rate (in bits per second) for transmitting data on the bus. The default value is used from the device description file (*.devdesc) of the CAN bus device. You can select the baud rate from the list box or type it directly into the input field. |

See also
● § Chapter 6.3.2.16 “CAN onboard” on page 1594

6.3.2.17 EtherCAT configurator
6.3.2.17.1 General

Onboard EtherCAT support is currently limited to AC500-eCo PM5072-ETH and PM5082-ETH. It is not supported by any other AC500 PLC.

Two alternatives are available for using EtherCAT:

- Onboard EtherCAT for the AC500-eCo
- EtherCAT for the AC500 with the CM579 communication module

Further information can be found here:
Onboard EtherCAT
§ EtherCAT configurator
§ Communication schema onboard Ethernet/EtherCAT
§ Motion Control

EtherCAT
§ CM579-ETHCAT
§ Communication schema onboard Ethernet/EtherCAT
§ Motion Control
Refer to the general description for information about the following tabs of the device editor.

- Chapter 6.4.1.21.2.8.12 “Tab '<device name> I/O Mapping'” on page 2444
- Chapter 6.4.1.21.2.8.13 “Tab '<device name> IEC Objects'” on page 2449
- Chapter 6.4.1.21.2.8.4 “Tab 'Parameters'” on page 2433
- Chapter 6.4.1.21.2.8.19 “Tab 'Status'” on page 2460
- Chapter 6.4.1.21.2.8.20 “Tab 'Information'” on page 2460

Only in the case of special features is there an additional help page for the specific device editor.

If the "<device name> Parameters" tab is not shown, then select the "Show generic device configuration editors" option in the CODESYS options ("Device Editor" category).

The configuration of EtherCAT modules is based on the device description files for the used master and slave devices employed and can be adapted in the project in configuration dialogs. In order to make sure that the simplest and most error-free use possible, we recommend for standard applications that you enable the option for the "Automatic Configuration" of the master, so that the majority of the configuration settings are done automatically.

Optional devices

The “Optional devices” function can be used for variable hardware configurations. At the start of the stack, the system checks whether optional devices are available. If the devices are not found, then they are deactivated automatically. However, the devices can also be activated at a later date if, for example, it is a device at the end of the network line. On the other hand, if the "Automatically restart slaves" option is selected, then the activated devices are automatically switched to "operational", thereby activating the process data.

The bus cycle task is set in the general PLC settings.

Access to the EtherCAT configuration by the application takes place via instances of the EtherCAT master and EtherCAT slave. If the EtherCAT master or EtherCAT slaves are inserted as objects into a project, instances are automatically created for master and slaves which can be addressed in the application program. For example a restart, a stop or a status check of the EtherCAT device can be performed from the application.

Furthermore, the EtherCAT library offers function blocks for the reading and writing of individual parameters, even during bus operation.

See also

- Chapter 6.3.2.17.2.1 “Tab 'EtherCAT Master - General' " on page 1610
- Chapter 6.4.1.21.4.14.7 “Dialog 'Options' - 'Device Editor'” on page 2786
- Chapter 6.4.1.21.2.8.10 “Tab 'PLC Settings'” on page 2439

6.3.2.17.2 EtherCAT master

Tab 'EtherCAT Master - General'

Object: EtherCAT Master

The tab is used for the configuration of the basic settings for the EtherCAT Master. The basic settings are preset from the device description file.
NOTICE!
The auto-configuration mode ("Autoconfig master/slaves" option) is selected by default and is adequate for standard applications. If the mode is not selected, then all configuration settings for the master and the slave(s) have to be done manually. Expert knowledge is required to do this. The auto-configuration mode option has to be switched off to configure slave-to-slave communication.

| “Autoconfig master/slaves” | The main part of the master and slave configuration is done automatically, based on the device description file and implicit calculations. The dialog for the FMMU/Sync settings is not available. Even if this option of the master is selected, an expert mode can be enabled explicitly for each individual slave, which allows for manual editing of the automatically generated process data configuration. |

Table 325: “EtherCAT NIC Settings”

| “Target address (MAC)” | MAC address of the device in the EtherCAT network that is to receive the telegrams. |
| “Source address (MAC)” | MAC address of the controller (target system) or network name (name of the adapter or PLC (target system)) |
| “Network name” | Name or MAC of the network, depending on which of the following options is selected: |
| “Select network by MAC” | Yes: The network is specified by the MAC ID. Then the project cannot be used on another device because each network adapter has a unique MAC ID. |
| “Select network by name” | Yes: Network is identified by the network name and the project is device-independent. |
| “Scan” | Scans the network for the MAC IDs or names of the target devices that are currently available. |

Table 326: “Redundancy EtherCAT NIC Settings”

These settings are displayed only when the “Redundancy” option is selected. Here the parameters of the additional device are defined according to the description for “EtherCAT NIC Settings”.
Table 327: “Distributed Clock”

| “Cycle time (µs)” | Time span after which a new data telegram is dispatched on the bus. When the “Distributed Clock” function is enabled in the slave, the master cycle time specified here is transferred to the slave clocks. As a result, a precise synchronization of the data exchange can be achieved. This is particularly important when spatially distributed processes require simultaneous actions. An example of a simultaneous action is applications in which multiple axes have to execute coordinated movements at the same time. A very precise, network-wide-time base with a jitter of considerably less than 1 microsecond can be achieved in this way. |
| “Sync offset” | Parameter for setting the delay time between the DC time base of the EtherCAT Slave and the cycle start of the PLC. The default value is 20%. This time is active at the same time for all slaves with DC. An offset of 20% means that the timer interrupt in the EtherCAT Slave takes place 20% before the next IEC cycle. This means in the case of

- FrameAtTaskStart = FALSE when the EtherCAT data is sent at the end of the PLC cycle:
  The PLC cycle may require 80% of the bus cycle time minus the delay time in the runtime, and this without the master no longer placing the current process data on the bus in time (assuming that the EtherCAT Slave expects the new data exactly with the sync interrupt).
- FrameAtTaskStart = TRUE (default value when using CODESYS SoftMotion):
  For the controller program, nearly 100% of the cycle is always available. Here the “Sync offset” determines only when the EtherCAT data of the master is exchanged to and from the slaves relative to the time base of the EtherCAT Slave.

If DC is active at the corresponding slave, then the default settings come from the respective ESI file. The device manufacturer can define additional offsets here in the form of the Shift time for both Sync 0 and Sync 1 timer interrupts. When the expert setting is enabled at the slave, these times can be changed manually. The Shift time is entered into the register 0x990 as an additional start time. A positive value means that the start takes place later and therefore the sync interrupt is executed later.

IMPORTANT It must be prevented at all costs that the sync interrupt takes place near the time of the IEC cycle because otherwise no data can exist for one cycle and devices go into synchronization error. Both offsets from the master and the individual offset of each slave have to be considered for this. With the normal setting of 20% offset for the master and 0% for the slaves, the jitter of the IEC cycle and the delays of the transmission timing by the system can be a maximum of +80% and –20%.

Table 328: “Options”

| “Use LRW instead of LWR/LRD” | Direct communication from slave to slave is possible. Combined read/write commands (LRW) are used instead of separate read commands (LRD) and write commands (LWR). |
| “Messages per task” | Read and write commands (the handling of the input and output messages) can be controlled by means of various tasks. |
| “Automatically restart slaves” | The master immediately attempts to restart the slaves in the case of a communication breakdown. |
Table 329: “Master Settings”

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Image In Address”</td>
<td>First logical address of the first slave for input data</td>
</tr>
<tr>
<td>“Image Out Address”</td>
<td>First logical address of the first slave for output data</td>
</tr>
</tbody>
</table>

See also
- Chapter 6.3.2.17.3.1 “Tab 'EtherCAT Slave - General'” on page 1613
- Chapter 6.3.2.17 “EtherCAT configurator” on page 1609

Tab 'EtherCAT Master - Sync Unit Assignment'

Sync unit assignment is not supported in Onboard EtherCAT.

Tab 'EtherCAT Master - Parameters'

Object: EtherCAT Master

The tab contains the master parameters which are defined in the device description file.

When the auto-configuration mode is selected in the “Master” dialog, the parameters are set here automatically according to the specifications from the device description file and the network topology. Nothing should be changed in the generic editor because an invalid configuration can be set here.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Value”</td>
<td>Editable: A change is effective only when the auto-configuration mode is disabled. Whether or not the change becomes effective depends on the respective parameter.</td>
</tr>
</tbody>
</table>

See also
- Chapter 6.3.2.17.3.9 “Tab 'EtherCAT Slave - Parameters’” on page 1623
- Chapter 6.3.2.17 “EtherCAT configurator” on page 1609
- Chapter 6.4.1.21.2.8.4 “Tab 'Parameters’” on page 2433

6.3.2.17.3 EtherCAT slave

Tab 'EtherCAT Slave - General'

Object: EtherCAT Slave

The basic settings for the EtherCAT Slave are configured on this tab. The basic settings are preset from the device description file.
Table 330: "Address"

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;AutoInc address&quot;</td>
<td>Self-incrementing address (16-bit) that results from the position of the slave in the network. The address is used only during the system boot when the master assigns the EtherCAT addresses to its slaves. When the first message runs through all the slaves for this purpose, each slave increments its &quot;AutoInc address&quot; by 1. The slave with address 0 then gets the data. A possible input here is &quot;.-8&quot;.</td>
</tr>
<tr>
<td>&quot;EtherCAT address&quot;</td>
<td>Final address of the slaves, assigned by the master during bootup. The address is independent of the position of the slave in the network.</td>
</tr>
</tbody>
</table>

Table 331: "Additional"

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Expert settings&quot;</td>
<td>Additional settings are possible for the startup checking and time monitoring (see below). The &quot;Expert Process Data&quot; tab is also available in the device editor. However, expert settings are not required for standard applications. The auto-configuration mode is recommended and sufficient for standard applications.</td>
</tr>
<tr>
<td>&quot;Optional&quot;</td>
<td>At the start of the stack, the system checks whether optional devices are available. A slave is defined as optional and no error message is generated if the device is missing from the bus system. If a device is not found, then it is disabled automatically and displayed in gray in the device tree. A corresponding message is displayed in the logger. Note: If you define a slave as &quot;optional&quot;, then it has to have a unique identification. You can change this by means of the three possible settings in the &quot;Identification&quot; section. Available only when the &quot;Autoconfig master/slaves&quot; option is selected in the settings of the EtherCAT Master and the EtherCAT Slave supports this function.</td>
</tr>
</tbody>
</table>

Table 332: "Distributed Clock"

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Select DC&quot;</td>
<td>List box with all settings for the distributed clocks of the device description file</td>
</tr>
<tr>
<td>&quot;Enable &quot;</td>
<td>Cycle time for the data exchange. It is displayed in the &quot;Sync unit cycle (µs)&quot; input field and determined by the cycle time of the master. As a result, the master clock can synchronize the data exchange in the network. The &quot;Sync0&quot; and &quot;Sync1&quot; settings described below are slave-dependent.</td>
</tr>
</tbody>
</table>

Table 333: "Sync0"

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Enable Sync 0&quot;</td>
<td>Synchronization unit &quot;Sync0&quot; is used. A synchronization unit describes a set of process data that is exchanged synchronously.</td>
</tr>
<tr>
<td>&quot;Sync unit cycle&quot;</td>
<td>The master cycle time (multiplied by the factor selected from the list box) is used as the synchronization cycle time for the slave. &quot;Cycle time (µs)&quot; displays the cycle time currently set.</td>
</tr>
<tr>
<td>&quot;User-defined&quot;</td>
<td>A custom cycle time (in microseconds) can be specified in the &quot;Cycle time (µs)&quot; field.</td>
</tr>
</tbody>
</table>
### Table 334: “Sync1”

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Enable Sync 1”</td>
<td>☑️: Synchronization unit “Sync1” is used. A synchronization unit describes a set of process data that is exchanged synchronously.</td>
</tr>
<tr>
<td>“Sync unit cycle”</td>
<td>☑️: The master cycle time (multiplied by the factor selected from the list box) is used as the synchronization cycle time for the slave. The “Cycle time (µs)” field displays the cycle time currently set.</td>
</tr>
<tr>
<td>“User-defined”</td>
<td>☑️: A custom cycle time (in microseconds) can be specified in the “Cycle time (µs)” field.</td>
</tr>
</tbody>
</table>

### Table 335: “Diagnosis”

This area is only displayed in online mode.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Current State”</td>
<td>State of the slave</td>
</tr>
<tr>
<td></td>
<td>Possible states: “Init”, “Preoperational”, “Safe Operational”, and “Operational”</td>
</tr>
<tr>
<td></td>
<td>The state Operational indicates that the slave configuration has been correctly completed and that process data (inputs and outputs) are being accepted.</td>
</tr>
</tbody>
</table>

### Table 336: “Startup Checking”

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Check vendor ID”</td>
<td>By default the vendor ID and product ID of the device are checked against the current configuration settings when the system boots up. If they do not agree, then the bus is stopped and no further actions are executed. This is done to prevent an incorrect configuration from being loaded onto the bus system. Options for deactivating the corresponding check.</td>
</tr>
<tr>
<td>“Check product ID”</td>
<td>☑️: The revision number is checked during the system bootup according to your selection in the list box.</td>
</tr>
<tr>
<td>“Check revision number”</td>
<td>☑️: For online verification of the configured and actual module configuration. If the configurations do not match, then the device still switches to “Run”. In this case, an entry is made in the device logbook.</td>
</tr>
</tbody>
</table>

### Table 337: “Timeouts”

By default, watchdog is not defined for the following actions. If necessary, an appropriate timeout can be specified here (in milliseconds):

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“SDO access”</td>
<td>Transmits the SDO list at system start. Specified in milliseconds.</td>
</tr>
<tr>
<td>“I -&gt; P”</td>
<td>Switch from “Init” mode to “Preoperational” mode. Specified in milliseconds.</td>
</tr>
<tr>
<td>“P -&gt; S / S -&gt; O”</td>
<td>Switch from “Preoperational” mode to “Safe Operational” mode, or from “Safe Operational” mode to “Operational” mode. Specified in milliseconds.</td>
</tr>
</tbody>
</table>

### Table 338: “DC Cyclic Unit Control: Assign to Local µC”

One or more options for the “Distributed Clock” function can be activated here that should be used on the local microprocessor. The check is performed in the registry at 0x980 in the EtherCAT Slave. Possible settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Cycle unit”</td>
<td></td>
</tr>
<tr>
<td>“Latch unit 0”</td>
<td></td>
</tr>
<tr>
<td>“Latch unit 1”</td>
<td></td>
</tr>
</tbody>
</table>
Table 339: “Watchdog”

| “Set multiplier” | The PDI watchdog and SM watchdog receive their impulses from the local terminal clock divided by the watchdog multiplier. |
| “Set PDI watchdog” | This watchdog triggers when there is no PDI communication with the EtherCAT Slave controller for longer than the PDI (Process Data Interface) watchdog time which has been set and activated. |
| “Set SM watchdog” | This watchdog triggers when there is no EtherCAT process data communication with the terminal for longer than the SM (SyncManager) watchdog time that has been set and activated. |

Table 340: “Identification”

In this section, you set the device identification of the slave. As a result, you can make the address of the slave independent of its position in the bus.

The following options are visible only when the “Activate expert settings” option or “Optional” option is selected.

If you have identified the slave as “Optional”, then you have to assign a unique ID to it.

| “Disabled” | The identification of the slave is not checked. |
| “Configured station alias (ADO 0x0012)” | Address that is stored in the EEPROM of the device. You can change the value in the “Scan Devices” dialog or in online mode. For stock devices, you need to assign this number one time. This means that you have to connect the device one time to an EtherCAT Master and save the number. |
| “Write to EEPROM” | Visible in online mode only for “Configured station alias”. Writes the defined address for “Value” to the EEPROM of the slave. |
| “Explicit device identification (ADO 0x0134)” | The device identification is hard set on the hardware (for example, by DIP switches). It is displayed in “Actual address”. |
| “Data Word (2 Bytes)” | A 2-byte value for the identification is saved in the slave. |
| “Value” | Expected value for the check. If the actual value does not correspond to this setting, then an error is issued. |
| “ADO (hex)” | Initial value from the device description. You can change this value in the “Data word” option. |
| “Actual address” | Visible in online mode only. Displays the address of the slave. You can use this display for checking the success of the “Write to EEPROM” command. |

Tab 'EtherCAT Slave - FMMU/Sync'

Object: EtherCAT Slave

The tab shows the FMMUs and Sync Manager of the EtherCAT Slave as they are defined in the device description file. There is an option to edit the FMMUs and Sync Manager (for example, for the configuration of slave-to-slave communication).

Requirement: The auto-configuration mode in the EtherCAT Master is disabled.

Note that these are expert settings which are not usually required for standard applications.
Table 341: "FMMU"

The table shows the Fieldbus Memory Management Units of the slave, which are used for handling the process data. In each case the allocation of the logical address ("Global Start Address") to a physical address ("Phys. start address") is defined. Bit-by-bit mapping is possible.

- "Edit"
- "Add"
- "Delete"

Table 342: "Edit FMMU"

<table>
<thead>
<tr>
<th>&quot;Global Start Address&quot;</th>
<th>&quot;Length&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Start bit&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;End bit&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Phys. start address&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Phys. start bit&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Access&quot;</td>
<td>&quot;Read&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Write&quot;</td>
</tr>
<tr>
<td>&quot;Flags&quot;</td>
<td>&quot;Enable&quot;</td>
</tr>
</tbody>
</table>

Table 343: "Sync Manager"

Display and editing of the synchronization manager of the slave. The physical start address, the type of access, the buffer, and the physical address to which the interrupts are to be sent (as well as others) are defined for each available Sync Manager type (mailbox in, mailbox out, inputs, outputs).

Table 344: "Edit Syncman"

<table>
<thead>
<tr>
<th>&quot;Phys. start address&quot;</th>
<th>&quot;Length&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Buffer&quot;</td>
<td>&quot;1&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;3&quot;</td>
</tr>
<tr>
<td>&quot;Access&quot;</td>
<td>&quot;Read&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Write&quot;</td>
</tr>
<tr>
<td>&quot;Interrupts&quot;</td>
<td>&quot;to EtherCAT&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;to PDI&quot;</td>
</tr>
<tr>
<td>&quot;Flag control&quot;</td>
<td>&quot;Activate&quot;</td>
</tr>
<tr>
<td>&quot;Watchdog&quot;</td>
<td>&quot;Trigger&quot;</td>
</tr>
<tr>
<td>&quot;SyncMan type&quot;</td>
<td>&quot;&quot;</td>
</tr>
</tbody>
</table>

Tab 'EtherCAT Slave - Expert Mode Process Data'

Object: EtherCAT Slave

The tab provides another more detailed view of the process data, which is also displayed in the "Process Data" dialog. Moreover, the download of the PDO assignment and the PDO configuration is enabled here.

Requirement: The expert settings for the slave are selected.
Chapter 6.3.2.17.3.1 "Tab 'EtherCAT Slave - General' " on page 1613

Table 345: “Sync Manager ”
List of the Sync Managers with data size and PDO type

Table 346: “PDO assignment (16#1C12)”
List of the PDOs assigned to the selected “Sync-Manager”.
When a check box is selected, the PDOs are enabled and I/O channels are created. This is similar to the simple PDO configuration view.

Table 347: “PDO list”
List of the PDOs assigned to the selected “Sync-Manager”.
You can add new entries or edit or delete existing entries by executing the respective commands (“Add”, “Delete”, “Edit”) in the command bar or context menu.

Table 348: “Edit PDO list”
<table>
<thead>
<tr>
<th>“Name”</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“Index”</td>
<td></td>
</tr>
</tbody>
</table>
| “Direction” | ● “TxPDO (input)”: The PDO is transmitted from the master to the slave.  
● “RxPDO (output)”: The PDO is transmitted from the slave to the master. |
| “Flags”  | ● “Required”: The PDO is required and cannot be disabled in the “PDO assignment”.  
● “Windows contents”: The contents of the PDO are fixed and cannot be modified. It is then not possible to add entries in “PDO contents”.
● “Virtual PDO”: Reserved for future use |
| “Exclude PDOs” | It is possible to define an exclusion list. When a PDO is enabled in the “PDO assignment”, others are disabled and cannot be enabled. |
| “Sync unit”  | ID of the Sync Manager to which the PDO is to be assigned |

Table 349: “PDO Contents”
Displays the contents of the PDOs selected in the “PDO list”. You can add new entries or edit or delete existing entries by executing the respective commands (“Add”, “Delete”, “Edit”) in the command bar or context menu. You can change the PDO order by clicking “Move Up” and “Move Down”.

Table 350: “Download”
| “PDO assignment”                          | ✓: Specific CoE commands for initializing the 0x1cxx objects are generated and written to the slave. |
| “PDO configuration”                       | ✓: The CoE commands for 0x16xx or 0x1axx are generated, and then the PDO mapping is downloaded to the slave. Normally, the default values originate from the ESI file and the device has to support this functionality. For example, if a device has a fixed configuration, then these commands are regarded as flawed. |
| “Load PDO info from the device”           | The current PDO configuration is read from the slave and entered into the configuration. The lists in the upper and lower right are then deleted and filled with the read data. This is especially useful when the ESI file is incomplete and the configuration is available only on the slave. |
Tab 'EtherCAT Slave - Process Data'

Object: EtherCAT Slave

The tab of the EtherCAT configurator displays the process data for the inputs and outputs of the slave. The data is preset from the device description file.

Table 351: “Select the Outputs”

The table shows the outputs of the slave defined by “Start address”, “Type”, and “Index”.

If outputs of the device are enabled here (for writing), then these outputs can be assigned to project variables in the “EtherCAT I/O Mapping” dialog.

Table 352: “Select the Inputs”

The table shows the inputs of the slave defined by “Name”, “Type”, and “Index”.

If inputs of the device are enabled here (for reading), then these inputs can be assigned to project variables in the “EtherCAT I/O Mapping” dialog.

See also

- § Chapter 6.3.2.17.3.1 “Tab 'EtherCAT Slave - General’ ” on page 1613
- § Chapter 6.3.2.17 “EtherCAT configurator ” on page 1609

Tab 'EtherCAT Slave - Startup Parameters'

Object: EtherCAT Slave

On the tab, the SDOs (service data objects) for 'CAN over EtherCAT' (CoE) or the IDNs (identification numbers) for 'Servodrive over EtherCAT' (SoE) are defined for the current slave. These parameters are determined for the device when the system is started.

The object directory with the required data objects is described in the EtherCAT XML description file or in an EDS file that is referenced in the XML file.

Requirement: The device supports 'CAN over EtherCAT' or 'Servodrive over EtherCAT'.

Some modules that are inserted below a slave have their own startup parameters. These parameters are also displayed in this list but cannot be edited here. The parameters are modified in the editor of the corresponding module.

List of SDOs or IDNs

The order (from top to bottom) specifies the order in which the objects are transferred to the module.

| “Line” | Line number |
| “Index:Subindex” | For CoE only |
| “IDN” | For SoE only |
| Identification number |

Name

| “Bit length” | Bit length of the SDO or IDN |
| “Abort on Error” | In case of error, the transfer is aborted with an error status. |
| “Jump to Line on Error” | In case of error, the transfer is resumed with the SDO or IDN at the specified “Line”. |
**Table 353: “CAN over EtherCAT”**

<table>
<thead>
<tr>
<th>Column “Index:Subindex”</th>
<th>Identifies the entry in the object directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column “Name”</td>
<td>Display of access flags: RW (read/write), RO (read only), WO (write only)</td>
</tr>
<tr>
<td>Column “Base Value”</td>
<td>Editable (double-click to open)</td>
</tr>
</tbody>
</table>

**Input fields**

- **“Name”**
  - Input field for displaying and changing the name
- **“Index: 16#”**
  - By specifying new index/subindex entries, a new object can be added to the SDO that is not yet described in the EDS file.
- **“Subindex: 16#”**
  - Range of values of the object
- **“Value”**
  - Each value may be max. one byte (0-255). It can also be a hexadecimal in IEC syntax (for example, 16#ad).
  - If the “Byte array” option is enabled, then the values have to be specified as a comma-separated list (for example, 1,2,3,4).
- **“Full access”**
  - The complete object is written with one access and all subindexes are set at the same time. The time needed for the transfer is reduced because not every subindex has to be transferred individually.
- **“Byte array”**
  - Values can be specified as a comma-separated byte array.

**Table 354: Servodrive over EtherCAT**

<table>
<thead>
<tr>
<th>Column “IDN”</th>
<th>Identification number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column “Base Value”</td>
<td>Base value of the IDN. Double-click to modify.</td>
</tr>
</tbody>
</table>

**Input fields**

- **“IDN”**
  - Identification number: Composed from the subsequent parameters
    - “S”: Standard data
    - “P”: Product-specific data
    - “PSet”: Parameter set
    - “Offset”
"Bit length" | List box for selecting the bit length
---|---
"Value" | List box for selecting the value
"Channel" | If the object has multiple subobjects, then this list box is displayed automatically.
"As list" | Parameters are loaded as a list. The first four bytes indicate the length. The length is calculated automatically.

See also
- ☞ Chapter 6.3.2.17.3.1 “Tab 'EtherCAT Slave - General' " on page 1613
- ☞ Chapter 6.3.2.17 “EtherCAT configurator ” on page 1609

Tab 'EtherCAT Slave - Diagnostics History'
Object: EtherCAT Slave
The tab reads the diagnosis data \(0x10f3\) object of the slave and displays it in a tree structure. Moreover, the messages are issued in plain language.

Requirement: The application is in online mode. The attribute \texttt{DiagHistory} in the ESI file is set.

| "Update history" | The data is read again and the view is refreshed. New messages are displayed in the “\texttt{Flags}” column with “\texttt{N}” (New). Acknowledged messages with “\texttt{Q}”. |
| "Auto update" | The data is updated automatically. |
| "New messages only" | Acknowledged messages are not displayed. |
| "Acknowledge messages" | All messages with the “\texttt{N}” flag are acknowledged. Then the flag changes to “\texttt{Q}”. |

See also
- ☞ Chapter 6.3.2.17.3.1 “Tab 'EtherCAT Slave - General' " on page 1613

Tab 'EtherCAT Slave - Online'
Object: EtherCAT Slave
The tab provides slave status information and functions for the file transfer to the slave via EtherCAT (FoE).

Requirement: The expert settings for the slave are selected and the application is logged in to the controller.

Table 355: “State machine”

| "Init" | Use for debugging purposes |
| "Boot Strap" | The slave is switched to \texttt{Bootstrap Mode}. Required if firmware files should be transferred to or from the slave |
| "Pre-Op" | Use for debugging purposes |
| "Safe-Op" | Use for debugging purposes |
| "Op" | Use for debugging purposes |
Table 356: “DLL status”

<table>
<thead>
<tr>
<th>Port</th>
<th>Status Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>No Carrier / Open: No carrier signal exists at the port, but the port is open.</td>
</tr>
<tr>
<td></td>
<td>No Carrier / Closed: No carrier signal exists at the port and the port is closed.</td>
</tr>
<tr>
<td>B</td>
<td>Carrier / Open: A carrier signal exists at the port and the port is open.</td>
</tr>
<tr>
<td>C</td>
<td>Carrier / Closed: A carrier signal exists at the port, but the port is closed.</td>
</tr>
</tbody>
</table>

Note: If the function is not supported, then the status can be hidden.

Table 357: “File Access over EtherCAT”

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Download</td>
<td>A dialog opens to save the firmware file. In this dialog, the input of a string as well as a password is necessary in order to execute the file transfer. The information should be taken from the data sheet of the slave.</td>
</tr>
<tr>
<td>Upload</td>
<td>A dialog opens to open the firmware file. In this dialog, the input of a string as well as a password is necessary in order to execute the file transfer. The information should be taken from the data sheet of the slave.</td>
</tr>
</tbody>
</table>

Table 358: “E²PROM access”

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Write E²PROM</td>
<td>Writes the configuration of the slave to the E²PROM. A dialog for storing the configuration opens in the same way as for “File access over EtherCAT”.</td>
</tr>
<tr>
<td>Read E²PROM</td>
<td>Reads the configuration of the slave from the E²PROM. Upload of firmware files A dialog for opening the configuration opens in the same way as for “File access over EtherCAT”.</td>
</tr>
<tr>
<td>Write E²PROM XML</td>
<td>Writes the slave configuration directly from the XML file into the device. Can be executed only when configuration data exists in the XML file (&lt;Config-Data&gt; section).</td>
</tr>
</tbody>
</table>

- % Chapter 6.3.2.17.2.1 “Tab 'EtherCAT Master - General' ” on page 1610
- % Chapter 6.3.2.17.3.1 “Tab 'EtherCAT Slave - General' ” on page 1613

Tab 'EtherCAT Slave - CoE Online'

Object: EtherCAT Slave

The tab shows the object directory of the ESI file or the slave.

Requirement: The application is in online mode. The expert settings in the “Slave” dialog have to be enabled and the slave has to support CoE.
**Read objects** The object directory is read one time.

**Auto update** The objects are read in cycles.

**Offline from ESI file** The dialog shows the contents of the object directory from the device description.

**Online from device** The dialog shows the contents of the object directory of the device. **SDOInfo** has to be enabled in the ESI file.

**Flags**
- **“RO”**: The value is write-protected.
- **“RW”**: The value can be modified.

**Type** Data type of the parameter

**Value** You can double-click in the text field to edit this value.

- `% Chapter 6.3.2.17.2.1 “Tab 'EtherCAT Master - General' ” on page 1610
- `% Chapter 6.3.2.17.3.1 “Tab ‘EtherCAT Slave - General’ ” on page 1613

Tab ‘EtherCAT Slave - Parameters’

Object: EtherCAT Slave

The tab contains the slave parameters which are defined in the device description file.

When the auto-configuration mode of the master is selected, the parameters are set here automatically according to the specifications from the description file and the network topology. For standard applications, it is also not normally required to edit them.

**Value** Only a few parameters are editable. A change is effective only when the auto-configuration mode is disabled.

Basically, the user should not modify anything here because doing so could create an invalid configuration, which would prevent the slave from entering into the operational state.

- `% Chapter 6.3.2.17.3.1 “Tab ‘EtherCAT Slave - General’ ” on page 1613
- `% Chapter 6.3.2.17.2.3 “Tab ‘EtherCAT Master - Parameters’ ” on page 1613
- `% Chapter 6.3.2.17 “EtherCAT configurator ” on page 1609

Tab ‘EtherCAT Slave - EoE Settings’

Object: EtherCAT Slave

This tab is used to configure the communication settings for the individual slaves that support Ethernet over EtherCAT (EoE).

**Table 359: “Settings”**

| “Virtual Ethernet Port” | 🟢: Enables the EOE functionality of the slave. A unique “Virtual MAC ID” has to be defined.
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“Virtual MAC ID”</td>
<td>Input field for the “Virtual MAC ID”</td>
</tr>
<tr>
<td>“Switch port”</td>
<td>🟢: The device acts as a switch. No additional network settings are required.</td>
</tr>
<tr>
<td>“IP port”</td>
<td>🟢: The device acts as an IP port. The “IP Settings” have to be configured.</td>
</tr>
</tbody>
</table>
Table 360: “IP Settings”

<table>
<thead>
<tr>
<th><strong>“IP address”</strong></th>
<th>IP address of the slave in the network (length: 4 bytes)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The IP port has to be in the same range as the virtual Ethernet adapter. For example, if the address of the network adapter is 192.168.1.1 and the subnet mask is 255.255.255.0, then the IP port has to be in the range from 192.168.1.2 to 192.168.1.254.</td>
</tr>
<tr>
<td><strong>“Subnet mask”</strong></td>
<td>Subnet mask (length: 4 bytes)</td>
</tr>
<tr>
<td><strong>“Default gateway”</strong></td>
<td>Default gateway (length: 4 bytes)</td>
</tr>
<tr>
<td><strong>“DNS server”</strong></td>
<td>IP address of the DNS server</td>
</tr>
<tr>
<td><strong>“DNS name”</strong></td>
<td>Name of the DNS server</td>
</tr>
</tbody>
</table>

6.3.2.17.4 EtherCAT module

Tab 'EtherCAT Module - Startup Parameters'

Object: EtherCAT Module

The SDOs (Service Data Objects) or IDNs that transmit specified parameters to the device at the system start are defined on this tab for the current module.

The object directory with the required data objects is described in the EtherCAT XML description file or in an EDS file that is referenced in the XML file.

Requirement: The device supports CAN over EtherCAT or Servodrive over EtherCAT

Some modules have their own start parameters which are displayed on the tab. The parameters can be modified there. Likewise, the parameters are also displayed in the slave, but they are blocked there.

Table 361: SDO table

<table>
<thead>
<tr>
<th><strong>“Line”</strong></th>
<th>Line number</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Idn”</strong></td>
<td>Bit length of the SDO</td>
</tr>
<tr>
<td><strong>“Bit length”</strong></td>
<td>Bit length of the SDO</td>
</tr>
<tr>
<td><strong>Abort on Error”</strong></td>
<td>In case of error, the transfer is aborted with an error status.</td>
</tr>
<tr>
<td><strong>“Jump to Line on Error”</strong></td>
<td>The transfer is resumed with the SDO at the specified “Line” in case of error.</td>
</tr>
<tr>
<td><strong>“Next Line”</strong></td>
<td>The transfer is resumed with the SDO at the next line.</td>
</tr>
<tr>
<td><strong>“Comment”</strong></td>
<td>Input field for comments</td>
</tr>
<tr>
<td><strong>“Move Up”</strong></td>
<td>Moves the selected line upwards by one line</td>
</tr>
<tr>
<td><strong>“Move Down”</strong></td>
<td>Moves the selected line downwards by one line</td>
</tr>
</tbody>
</table>
“Add” Opens the “Select Item from Object Directory” dialog. In this dialog you can change the parameters of the SDO before the SDO is added to the configuration. By specifying new index/subindex entries, a new object can be added to the SDO that is not yet described in the EDS file. This is useful if only an incomplete object directory or none at all exists.

“Delete” Removes the selected entry.

“Modify” Opens the “Select Item from Object Directory” dialog for changing the parameters of the selected SDO or IDN in the table.

---

Servodrive over EtherCAT

Table 362: “Select Item from Object Directory”

<table>
<thead>
<tr>
<th>Column “Idn”</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Column “Base Value”</td>
<td>Base value of the IDN. Editable (double-click to open)</td>
</tr>
</tbody>
</table>

Input fields

| “IDN” | “S” |
| “P” |

| “PSet” | By specifying new “PSet”/“Offset” entries, a new object can be added to the IDN that is not yet described in the XML file. This is useful if only an incomplete object directory or none at all exists. |

| “Offset” | By specifying new PSet/Offset-entries, a new object can be added to the IDN that is not yet described in the XML file. This is useful if only an incomplete object directory or none at all exists. |

| “Bit length” | List box for selecting the bit length |
| “Value” | List box for selecting the value |
| “Channel” | If the object has multiple subobjects, then this list box is displayed automatically. |
| “As list” | Parameters are loaded as a list. The first four bytes indicate the length. ✓: The length is calculated automatically |

---

“CAN over EtherCAT”

Table 363: “Select Item from Object Directory”

| Column “Flags” | Display of access flags: RW (read/write), RO (read only), WO (write only) |
| Column “Base Value” | Editable (double-click to open) |

Input fields

| “Name” | Input field for displaying and changing the name |
| “Index: 16#” | By specifying new index/subindex entries, a new object can be added to the SDO that is not yet described in the EDS file. |
| “Subindex: 16#” |
| “Bit length” | Range of values of the object |
Each value may be max. one byte (0-255). It can also be a hexadecimal in IEC syntax (for example, 16#ad).

If the “Byte array” option is enabled, then the values have to be specified as a comma-separated list (for example, 1,2,3,4).

The complete object is written with one access and all subindexes are set at the same time. The time needed for the transfer is reduced because not every subindex has to be transferred individually.

Values can be specified as a comma-separated byte array.

See also
- Chapter 6.3.2.17.3.1 “Tab 'EtherCAT Slave - General' ” on page 1613
- Chapter 6.3.2.17 “EtherCAT configurator ” on page 1609

6.3.2.17.5 Bus Cycle Task - EtherCAT

The term "bus" includes all fieldbuses as well as the I/O bus. Consider that there is no bus cycle task for Modbus as Modbus does not provide I/O mapping and is controlled by POUs.

It's recommended to define a dedicated bus cycle task for each fieldbus configured in the project. It's strongly recommended not to use "unspecified" in the "PLC Settings" to avoid unexpected behavior. The task defined in "PLC Settings" determines the bus cycle task of I/O bus and, depending on the configuration, of the additional fieldbuses (the setting is by default inherited).

Especially in case of EtherCAT, a dedicated bus cycle task should be used which is not shared with other fieldbuses. If [unspecified] is set in the "PLC Settings", the EtherCAT task might be automatically used by other fieldbuses, potentially causing the EtherCAT task processing to fail. This should be avoided by specifying a task different to the EtherCAT task in the "PLC Settings".

As a rule, for each IEC task the used input data is read at the start of each task and the written output data is transferred to the I/O driver at the end of the task. The implementation in the I/O driver is decisive for further transfer of the I/O data. The implementation is therefore responsible for the timeframe and the specific time when the actual transmission occurs on the respective bus system.

Other tasks copy only the I/O data from an internal buffer that is exchanged only with the physical hardware in the bus cycle task.
(1) Read inputs from input buffer       (2) IEC task
(3) Write outputs to output buffer      (4) Bus cycle
(5) Input buffer                        (6) Output buffer
(7) Copy data to/from bus
(9) Bus cycle task, priority 1, 1 ms
(10) Bus cycle task, priority 5
(11) Bus cycle task, priority 10, interrupted by task 5

Using tasks
The "Task Deployment" provides an overview of used I/O channels, the set bus cycle task, and the usage of channels.

WARNING!
If an output is written in various tasks, then the status is undefined, as this can be overwritten in each case.

When the same inputs are used in various tasks, the input could change when a task is processed. This happens if the task is interrupted by a task with a higher priority and causes the process map to be read again. Solution: At the beginning of the IEC task, copy the input variables to variables and then work only with the local variables in the rest of the code.

Conclusion: Using the same inputs and outputs in several tasks does not make any sense and can lead to unexpected reactions in some cases.

Behavior of the bus cycle for EtherCAT
Before the IEC inputs are copied, the pending network messages of the last cycle are read.

When the "Messages per task" option is enabled in the settings of the EtherCAT Master, additional telegrams are transmitted to the devices employed per task and input or output employed. Channels that are used in a slow task are also transmitted less frequently. As a result, the bus load can be reduced.
6.3.2.17.6 Command 'Scan for Devices'

Function: The command establishes a brief connection to the hardware and determines the devices in the network. Then you can apply the devices found into the device tree of your project.

Call: Menu bar: "Project"; context menu of a device object in the device tree

Requirement: The communication settings to the controller are correct. The gateway and the PLC are started. The device supports the scan function.

The following devices provide the scan function: EtherCAT master, EtherNet/IP Scanner (IEC), Sercos master, CANopen Manager, CANopen Manager SIL2, PROFINET controller and PROFIBUS DP master.

You can perform the device scan immediately if the scan function is permanently implemented in the PLC. When scan function is implemented in a library, you have to log in only one time to download the library to the controller.

The command refers to the master controller selected in the device tree. For example, an already inserted PROFINET IO controller can be selected and the command used to determine the I/O devices and I/O modules assigned to it.

After performing the scan operation, the "Scan Devices" dialog opens and displays the found devices.

Dialog 'Scan Devices'
Table 364: “Scanned Devices”

“Device name, Device type, Address, Station name, etc.”

Data about the scanned device depending on network type.

When you change a value in the list of scanned devices, the value is shown in italics. This indicates that the new value has been changed in the editor in CODESYS, but not in the device. When you download the value to the device, it is shown normally.

Value that indicate differences between the project and the scanned device are shown in orange.

If multiple device descriptions are available for the scanned device, then the name is displayed in bold. The selection of the matching device description is resolved differently for different fieldbuses. For more detailed information, see the corresponding fieldbus chapters.

If a device description cannot be found, then the following message is shown: “Attention! The device was not found in the repository.” Depending on the bus system, additional information is displayed, such as manufacturer number and product number. The device cannot be inserted into the project without the installed device description.

“Show differences to project”

☑: The table in the dialog also shows additional configured devices (in the device tree of the project).

☐: The table shows all scanned devices. The configured devices are not shown.

“Scan for Devices”

Starts a new search.

“Copy All Devices to Project”

The device that is selected in the table is inserted into the device tree in the project. If nothing is selected, then all scanned devices are shown.

NOTICE!

If you insert devices, which are available in the device tree, to the device tree with “Copy All Devices to Project”, then the following should be noted. The data of the “Process Data” and “<...> I/O Mapping” tabs of the existing devices can be overwritten with the data of the recently inserted devices.

Table 365: “Configured Devices”

This part of the dialog is visible only when you select the “Show differences to project” option.

Differences between the scanned and configured devices are color-coded. Devices displayed in green are identical on both sides. Devices displayed in red are available only in the view of the scanned or configured devices.

- If you have selected a device in both views, then the scanned devices are inserted above the selected configured device.
- If you have selected a device in both views, then the scanned devices are inserted below the selected configured device.
- If you have selected a device in both views, then the configured devices are replaced by the selected scanned device.
- All scanned devices are copied to the project.
- Deletes the selected configured device.
6.3.2.17.7 Diagnosis
Diagnosis in the Application
EtherCAT Status

An instance of data type IoDrvEtherCAT is created for each EtherCAT Master that is inserted into the device tree. The name of the instance corresponds to the name of the master in the device tree. The availability of the instance is displayed on the “IEC Objects” tab of the device editor.

An instance of data type ETCSlave is created for each EtherCAT Slave that is inserted into the device tree. The name of the instance corresponds to the name of the slave in the device tree. The availability of the instance is displayed on the “IEC Objects” tab of the device editor. The slave instance is used in the application to query or change the state of the slave at runtime.

If the device diagnosis is enabled in the PLC settings, then the data type is IoDrvEtherCAT_Diag or ETCSlave_Diag.

See also
- FB IoDrvEtherCAT (FB)
- ETCSlave (FB)
- Chapter 6.3.2.17.7.2.9 “Status Page (Master and Slave)” on page 1637

Emergency

When an EtherCAT device supports CoE (CANopen over EtherCAT), emergency messages at the slave instance can be determined with the following properties:
- LastEmergency: Evaluation of the last received message in the application
- ClearEmergency: Deletion of the last received message and resetting of the property LastEmergency

The emergency messages are also recorded in the logger.

See also
- ETCSlaveStack.LastEmergency (PROP)
- ETCSlaveStack.ClearEmergency (METH)

Error codes

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>16#00xx</td>
<td>Error Reset or No Error</td>
</tr>
<tr>
<td>16#10xx</td>
<td>Generic error</td>
</tr>
<tr>
<td>16#20xx</td>
<td>Current</td>
</tr>
<tr>
<td>16#21xx</td>
<td>Current, device input side</td>
</tr>
<tr>
<td>16#22xx</td>
<td>Current, inside the device</td>
</tr>
<tr>
<td>16#23xx</td>
<td>Current, device output side</td>
</tr>
<tr>
<td>16#30xx</td>
<td>Voltage</td>
</tr>
<tr>
<td>16#31xx</td>
<td>Main voltage</td>
</tr>
<tr>
<td>16#32xx</td>
<td>Voltage, inside the device</td>
</tr>
</tbody>
</table>
## Error Code

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>16#33xx</td>
<td>Output voltage</td>
</tr>
<tr>
<td>16#40xx</td>
<td>Temperature</td>
</tr>
<tr>
<td>16#41xx</td>
<td>Ambient temperature</td>
</tr>
<tr>
<td>16#42xx</td>
<td>Device temperature</td>
</tr>
<tr>
<td>16#50xx</td>
<td>Device hardware</td>
</tr>
<tr>
<td>16#60xx</td>
<td>Device software</td>
</tr>
<tr>
<td>16#61xx</td>
<td>Internal software</td>
</tr>
<tr>
<td>16#62xx</td>
<td>User software</td>
</tr>
<tr>
<td>16#63xx</td>
<td>Data set</td>
</tr>
<tr>
<td>16#70xx</td>
<td>Additional modules</td>
</tr>
<tr>
<td>16#80xx</td>
<td>Monitoring</td>
</tr>
<tr>
<td>16#81xx</td>
<td>Communication</td>
</tr>
<tr>
<td>16#82xx</td>
<td>Protocol error</td>
</tr>
<tr>
<td>16#8210</td>
<td>PDO not processed due to length error</td>
</tr>
<tr>
<td>16#8220</td>
<td>PDO length exceeded</td>
</tr>
<tr>
<td>16#90xx</td>
<td>External error</td>
</tr>
<tr>
<td>16#A0xx</td>
<td>ESM transition error</td>
</tr>
<tr>
<td>16#F0xx</td>
<td>Additional functions</td>
</tr>
<tr>
<td>16#FFxx</td>
<td>Device specific</td>
</tr>
</tbody>
</table>

Manufacturer-specific error codes need to be checked in the respective documentation from the vendor.

### AL Status

The property `ALStatus` returns any errors at the start of the stack. For example, configuration errors at the slave instance are displayed.

The AL status messages are also recorded in the logger.

See also
- `ETCSlaveStack.ALStatus (PROP)`

### Error codes

<table>
<thead>
<tr>
<th>Value</th>
<th>Error Text</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>16#0</td>
<td>No error</td>
<td></td>
</tr>
<tr>
<td>16#1</td>
<td>Unspecified error</td>
<td></td>
</tr>
<tr>
<td>16#2</td>
<td>No memory</td>
<td></td>
</tr>
<tr>
<td>16#11</td>
<td>Invalid requested state change</td>
<td></td>
</tr>
<tr>
<td>16#12</td>
<td>Unknown requested state</td>
<td></td>
</tr>
<tr>
<td>Value</td>
<td>Error Text</td>
<td>Comment</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>16#13</td>
<td>Bootstrap not supported</td>
<td></td>
</tr>
<tr>
<td>16#14</td>
<td>No valid firmware</td>
<td></td>
</tr>
<tr>
<td>16#15</td>
<td>Invalid mailbox configuration</td>
<td>The configuration is not accepted by the device because, for example, data from the ESI file does not match the device.</td>
</tr>
<tr>
<td>16#16</td>
<td>Invalid mailbox configuration</td>
<td></td>
</tr>
<tr>
<td>16#17</td>
<td>Invalid sync manager configuration</td>
<td></td>
</tr>
<tr>
<td>16#18</td>
<td>No valid inputs available</td>
<td></td>
</tr>
<tr>
<td>16#19</td>
<td>No valid outputs</td>
<td></td>
</tr>
<tr>
<td>16#1A</td>
<td>Synchronization error</td>
<td>The DC settings may be incorrect.</td>
</tr>
<tr>
<td>16#1B</td>
<td>Sync manager watchdog</td>
<td>Interruption in the connection, for example due to a brief disconnection of the cable, or the PLC has been stopped.</td>
</tr>
<tr>
<td>16#1C</td>
<td>Invalid sync manager types</td>
<td></td>
</tr>
<tr>
<td>16#1D</td>
<td>Invalid output configuration</td>
<td>The configuration is not accepted by the device because, for example, data from the ESI file does not match the device.</td>
</tr>
<tr>
<td>16#1E</td>
<td>Invalid input configuration</td>
<td>The configuration is not accepted by the device because, for example, data from the ESI file does not match the device.</td>
</tr>
<tr>
<td>16#1F</td>
<td>Invalid watchdog configuration</td>
<td></td>
</tr>
<tr>
<td>16#20</td>
<td>Slave needs cold start</td>
<td>Switch device off and back on</td>
</tr>
<tr>
<td>16#21</td>
<td>Slave needs INIT</td>
<td></td>
</tr>
<tr>
<td>16#22</td>
<td>Slave needs PREOP</td>
<td></td>
</tr>
<tr>
<td>16#23</td>
<td>Slave needs SAFEOP</td>
<td></td>
</tr>
<tr>
<td>16#24</td>
<td>Invalid input mapping</td>
<td></td>
</tr>
<tr>
<td>16#25</td>
<td>Invalid output mapping</td>
<td></td>
</tr>
<tr>
<td>16#26</td>
<td>Inconsistent settings</td>
<td></td>
</tr>
<tr>
<td>16#27</td>
<td>Free-Run not supported</td>
<td>The device has to be configured with &quot;Distributed Clock&quot;.</td>
</tr>
<tr>
<td>16#28</td>
<td>Synchronization not supported</td>
<td>The device does not support &quot;Distributed Clock&quot;.</td>
</tr>
<tr>
<td>16#29</td>
<td>Free-Run needs 3 buffer mode</td>
<td></td>
</tr>
<tr>
<td>16#2A</td>
<td>Background watchdog</td>
<td></td>
</tr>
<tr>
<td>16#2B</td>
<td>No valid inputs and outputs</td>
<td></td>
</tr>
<tr>
<td>16#2C</td>
<td>Fatal Sync error</td>
<td></td>
</tr>
<tr>
<td>16#2D</td>
<td>No sync error</td>
<td>The synchronization with DC is not successful, possibly because the jitter of the runtime is too large.</td>
</tr>
<tr>
<td>16#30</td>
<td>Invalid DC SYNCH configuration</td>
<td></td>
</tr>
<tr>
<td>16#31</td>
<td>Invalid DC latch configuration</td>
<td></td>
</tr>
<tr>
<td>Value</td>
<td>Error Text</td>
<td>Comment</td>
</tr>
<tr>
<td>--------</td>
<td>-------------------------------</td>
<td>--------------------------------------------------------------</td>
</tr>
<tr>
<td>16#32</td>
<td>PLL error</td>
<td>The slave synchronization is not successful.</td>
</tr>
<tr>
<td>16#33</td>
<td>Invalid DC IO error</td>
<td></td>
</tr>
<tr>
<td>16#34</td>
<td>Invalid DC timeout error</td>
<td></td>
</tr>
<tr>
<td>16#35</td>
<td>DC invalid sync cycle time</td>
<td>The configuration of &quot;Distributed Clock&quot; does not match the device.</td>
</tr>
<tr>
<td>16#36</td>
<td>DC Sync0 cycle time</td>
<td>The configuration of &quot;Distributed Clock&quot; does not match the device.</td>
</tr>
<tr>
<td>16#37</td>
<td>DC Sync1 cycle time</td>
<td>The configuration of &quot;Distributed Clock&quot; does not match the device.</td>
</tr>
<tr>
<td>16#41</td>
<td>MBX_AOE</td>
<td></td>
</tr>
<tr>
<td>16#42</td>
<td>MBX_EOE</td>
<td></td>
</tr>
<tr>
<td>16#43</td>
<td>MBX_COE</td>
<td></td>
</tr>
<tr>
<td>16#44</td>
<td>MBX_FOE</td>
<td></td>
</tr>
<tr>
<td>16#45</td>
<td>MBX_SOE</td>
<td></td>
</tr>
<tr>
<td>16#4F</td>
<td>MBX_VOE</td>
<td></td>
</tr>
<tr>
<td>16#50</td>
<td>EEPROM no access</td>
<td></td>
</tr>
<tr>
<td>16#51</td>
<td>EEPROM error</td>
<td></td>
</tr>
<tr>
<td>16#60</td>
<td>Slave restarted locally</td>
<td></td>
</tr>
</tbody>
</table>

**Diagnosis in the User Interface**

**Device Tree**

In online mode, the device tree allows for a pinpointing of a pending diagnosis.

- Green symbol: The device is in the **OPERATIONAL** state.
- Orange triangle: The device is in the **PREOPERATIONAL** state and is configured, and it is still not in the **OPERATIONAL** state.
- Error flag (red triangle): Hard error, such as an incorrect/missing device or connection interruption.
- Diagnosis flag (red exclamation mark): Indicates that a diagnosis entry is currently available for exactly this device. The details are then displayed on the status page of the respective device.
- Error-cleared flag (gray exclamation mark): Indicates that a previously pending error has been corrected.
EtherCAT – General (Master and Slave)

In online mode, the state of the device is displayed on the “General” tab for the EtherCAT Master and Slave.

In the case of the master, any errors or messages are displayed as text as well as the bus load:

- Diagnostics message: startup finished; all slaves in operational!
- Bus load: 0 %

In the case of the slave, the current state of the device is displayed.

- Diagnostics
  - Current State: Operational

See also
- Chapter 6.3.2.17.2.1 “Tab ‘EtherCAT Master - General’ “ on page 1610
- Chapter 6.3.2.17.3.1 “Tab ‘EtherCAT Slave - General’ “ on page 1613

Table 366: State of the slave

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bootstrap</td>
<td>State for firmware downloads</td>
</tr>
<tr>
<td>Init</td>
<td>Communication is established.</td>
</tr>
<tr>
<td>Pre-Operational</td>
<td>Mailbox communication is possible, but process data is not transferred</td>
</tr>
</tbody>
</table>
### Value Description

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safe Operational</td>
<td>Process data has already been transferred. Inputs are read, but outputs are not given.</td>
</tr>
<tr>
<td>Operational</td>
<td>Communication has been established, and all process data is transferred.</td>
</tr>
</tbody>
</table>

### Overview Page in the Master

All slaves and their statuses are displayed together on the “Overview” tab.

Each EtherCAT Slave is listed with its physical address, status, and any error counters. The error counters (CRC) are read from each device for the active connection and also show problems (EMC) with the wiring between the devices.

<table>
<thead>
<tr>
<th>Name</th>
<th>Address</th>
<th>State</th>
<th>CRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>AXL_F_8K_EC</td>
<td>1001</td>
<td>OP</td>
<td>0,0</td>
</tr>
<tr>
<td>BK1100</td>
<td>1002</td>
<td>OP</td>
<td>0,0</td>
</tr>
<tr>
<td>EL2008</td>
<td>1003</td>
<td>OP</td>
<td>0,0</td>
</tr>
<tr>
<td>EL1008</td>
<td>1004</td>
<td>OP</td>
<td>0,0</td>
</tr>
<tr>
<td>EL5142</td>
<td>1005</td>
<td>OP</td>
<td>0,0</td>
</tr>
<tr>
<td>EL4152</td>
<td>1006</td>
<td>OP</td>
<td>0,0</td>
</tr>
</tbody>
</table>

### IEC Objects – Master

The driver instance and its inputs and outputs are displayed on the “IEC Objects” tab of the master. You can use the outputs to check whether or not the configuration has completed. In the case of “Distributed Clock”, you can see whether or not the controller is synchronized.

<table>
<thead>
<tr>
<th>Expression</th>
<th>Type</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device.Application.EtherCAT_Master</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SUPER</td>
<td>IoDrvEt...</td>
<td></td>
</tr>
<tr>
<td>xRestart</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
<tr>
<td>xStopBus</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
<tr>
<td>xConfigFinished</td>
<td>BOOL</td>
<td>TRUE</td>
</tr>
<tr>
<td>xDistributedClockInSync</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
<tr>
<td>xError</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
<tr>
<td>xSyncInWindow</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
</tbody>
</table>

### IEC Objects – Slave

The respective slave instance is displayed on the “IEC Objects” tab of the slave. The “wState” output returns the current state of the slave.
Online Page for the Slave

If the controller is in online mode and the “Expert settings” option is selected, then the additional “Online” tab is displayed. The current status of the device is displayed on this tab.

In addition, the status of the EtherCAT connections are displayed.

<table>
<thead>
<tr>
<th>State Machine</th>
<th>Current state</th>
<th>Requested State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Init</td>
<td>Operational</td>
<td>Operational</td>
</tr>
<tr>
<td>Pre-Op</td>
<td>Safe-Op</td>
<td>Operational</td>
</tr>
<tr>
<td>Op</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>DLL Status</th>
<th>Port A</th>
<th>Port B</th>
<th>Port C</th>
<th>Port D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Carrier / Open</td>
<td>No Carrier / Closed</td>
<td>Carrier / Open</td>
<td>No Carrier / Closed</td>
<td></td>
</tr>
</tbody>
</table>

CoE Online Display for the Slave

If the “Expert settings” option is selected, then the additional “CoE Online” tab is displayed with all CoE objects and their current values.

Here you can find and directly correct an incorrect parameters.

See also

- Chapter 6.3.2.17.3.7 “Tab ‘EtherCAT Slave - Online’” on page 1621

CoE Online Display for the Slave

If the “Expert settings” option is selected, then the additional “CoE Online” tab is displayed with all CoE objects and their current values.

Here you can find and directly correct an incorrect parameters.
Diagnosis History for the Slave

All messages in the respective slave are displayed on the diagnosis history tab. The visibility of this tab depends on the devices used.

Status Page (Master and Slave)

Different error counters are displayed on the “Status” tab of the master. Normally all counters should be 0.
The different times values indicate the time requirement for sending and receiving the messages. As a result, they display the properties of the respective operating system and network driver.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LostFrameCount</td>
<td>Number of lost packages. This usually indicates connection errors or EMC problems.</td>
</tr>
<tr>
<td>TxErrorCount</td>
<td>Shows the packages that cannot be sent if for example the internal buffer of the operating system is insufficient</td>
</tr>
<tr>
<td>RxErrorCount</td>
<td>Lost or late messages are displayed here if for example the operating system is overloaded and the incoming messages are not forwarded to the EtherCAT stack in time.</td>
</tr>
</tbody>
</table>

A diagnosis message is displayed on the “Status” tab of the slave if errors have occurred. For example, an emergency message is displayed.

See also
- Chapter 6.3.2.17.7.1.1 “EtherCAT Status” on page 1630

Logger Page (Master and Slave)

**Master**

All messages of the master and all slaves below it are displayed on the “Log” tab of the master.
Slave

Only the messages from this one slave are displayed on the “Log” tab of the slave.

6.3.2.17.8 Libraries

Only the “EtherCATStack” library is to be used for onboard EtherCAT applications.

☞ Chapter 6.5.14 “Reference, function blocks” on page 4086

Reference documentation

“CODESYS - Intern ➔ IoDrivers ➔ EtherCATStack (LIB)”

☞ Chapter 6.5.3.3 “View embedded documentation of all libraries” on page 3775
6.3.2.18 PROFINET IO Configurator

6.3.2.18.1 General

PROFINET IO (Process Field Network) is an industrial Ethernet standard widely used in the field of manufacturing and process automation. It is managed by the user organization PI (PROFIBUS&PROFINET International) and is considered the successor of PROFIBUS (see https://www.profibus.com/).

6.3.2.18.2 PROFINET IO controller

Controller – General

Object: PROFINET IO Controller

The PROFINET IO controller, like the slaves, is identified by the station name. For AC500 communication modules, you can also configure the IP settings here. Otherwise the settings apply from the superordinate Ethernet node.

<table>
<thead>
<tr>
<th>“Station name”</th>
<th>The station name of the device. It is used for unique identification of the device in the network.</th>
</tr>
</thead>
</table>

Table 367: IP Parameters

| “IP address” | Note: Available for AC500 communication module only. |
| “Subnet mask” | If you insert the controller below an Ethernet adapter, then you have to define the IP parameters in the dialog of the Ethernet adapter. |
| “Default gateway” | |

Table 368: Default Slave IP Parameter

| “First IP address” | Range of IP addresses that CODESYS uses by default when inserting PROFINET IO devices into the device tree. If you use the “Auto-IP” function in the scan dialog, then IP addresses are also used from this range. The next free IP address is selected here. |
| “Last IP address” | |
| “Subnet mask” | |
| “Default gateway” | |

Table 369: IO Provider / Consumer Status

| “Application stop --> Substitute values” | When the user stops the application, the provider state is set to “BAD”. Then the slaves set the inputs and outputs to predefined substitute values. For more information, see “CODESYS default values – PROFINET IO substitute values” at the end of this chapter. |
| “Add to I/O mapping” | ☑: The incoming status information is added to the I/O mapping for all modules; provider state for the input data and consumer state for the output data. |
| “Substitute input data” | ● “Zero” ● “Last valid value” |
Table 370: Port Data

<table>
<thead>
<tr>
<th>“Peer station/port”</th>
<th>Neighboring device with port that is connected to this port. You can accept this setting in the “PROFINET IO Controller Topology” tab.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Check cable length”</td>
<td>Length of the network cable (in meters)</td>
</tr>
<tr>
<td></td>
<td>● &lt; 10</td>
</tr>
<tr>
<td></td>
<td>● &lt; 25</td>
</tr>
<tr>
<td></td>
<td>● &lt; 50</td>
</tr>
<tr>
<td></td>
<td>● &lt; 100</td>
</tr>
<tr>
<td></td>
<td>When the cable length is specified, it is checked when the controller is powered up. An incorrect cable length causes an error message.</td>
</tr>
<tr>
<td>“Check MAU type”</td>
<td>Type of network cable</td>
</tr>
</tbody>
</table>

Table 371: Watchdog

<table>
<thead>
<tr>
<th>“Activate”</th>
<th>Note: Available for AC500 communication module only. If the AC500 communication module firmware is not set within the given time (for example, in the case of an exception error in the application), then it is reset. The connection is terminated and the slaves switch to their substitute values. The defaults for the watchdog originate from the device description.</th>
</tr>
</thead>
</table>

PROFINET IO devices set their inputs and outputs to predefined substitute values when there is an interruption. These values are defined in the field device in contrast with default values. These values are usually zero, but specific substitute values can also be configured depending on the device.

The substitute values are set in the following cases:

- The connection is interrupted.
- The controller sets the provider state for the incoming data to "BAD".
- Other interruptions occur (for example, exception in host application, incorrect parameterization)

If the “Application stop --> Substitute values” option is enabled, then the controller sets the provider states to "BAD" at application stop. In this case, the slaves set their substitute values. All incoming data from the controller is ignored (including default values).

If the default values defined in the application should be set for an application stop, then you have to disabled this option. Moreover, you should select the “Update IO while stop” option (in the “PLC Settings”). Otherwise, the CODESYS PROFINET IO controller is stopped.

PROFINET IO Controller - Bus Cycle Task

The term "bus" includes all fieldbuses as well as the I/O bus. Consider that there is no bus cycle task for Modbus as Modbus does not provide I/O mapping and is controlled by POU s.

It's recommended to define a dedicated bus cycle task for each fieldbus configured in the project. It's strongly recommended not to use "unspecified" in the "PLC Settings" to avoid unexpected behavior. The task defined in "PLC Settings" determines the bus cycle task of I/O bus and, depending on the configuration, of the additional fieldbuses (the setting is by default inherited).

Especially in case of EtherCAT, a dedicated bus cycle task should be used which is not shared with other fieldbuses. If [unspecified] is set in the "PLC Settings", the EtherCAT task might be automatically used by other fieldbuses, potentially causing the EtherCAT task processing to fail. This should be avoided by specifying a task different to the EtherCAT task in the "PLC Settings".
As a rule, for each IEC task the used input data is read at the start of each task and the written output data is transferred to the I/O driver at the end of the task. The implementation in the I/O driver is decisive for further transfer of the I/O data. The implementation is therefore responsible for the timeframe and the specific time when the actual transmission occurs on the respective bus system.

Other tasks copy only the I/O data from an internal buffer that is exchanged only with the physical hardware in the bus cycle task.

![Diagram of I/O cycle](image)

(1) Read inputs from input buffer  
(2) IEC task  
(3) Write outputs to output buffer  
(4) Bus cycle  
(5) Input buffer  
(6) Output buffer  
(7) Copy data to/from bus  
(9) Bus cycle task, priority 1, 1 ms  
(10) Bus cycle task, priority 5  
(11) Bus cycle task, priority 10, interrupted by task 5

**Using tasks**

The “*Task Deployment*” provides an overview of used I/O channels, the set bus cycle task, and the usage of channels.

**WARNING!**

If an output is written in various tasks, then the status is undefined, as this can be overwritten in each case.

When the same inputs are used in various tasks, the input could change when a task is processed. This happens if the task is interrupted by a task with a higher priority and causes the process map to be read again. Solution: At the beginning of the IEC task, copy the input variables to variables and then work only with the local variables in the rest of the code.

Conclusion: Using the same inputs and outputs in several tasks does not make any sense and can lead to unexpected reactions in some cases.

**PROFINET IO**

**bus cycle behavior**

PROFINET IO does not provide any additional settings. Its functionality corresponds to the general description.

**PROFINET IO device**

**Device – General**

Object: PROFINET IO Device
In this dialog, you configure a communication link (PROFINET IO: application relation) to a PROFINET IO Field Device.

For all settings in the present dialog, the device description determines if the values here are editable and the values that are predefined or possible.

<table>
<thead>
<tr>
<th>“Station name”</th>
<th>The station name of the device. It is used for unique identification of the device in the network.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Station status”</td>
<td>32-bit error code compliant with the PROFINET IO specification. In case of error, the status is provided here, for example, when establishing a connection fails or a link is interrupted. A description is also displayed.</td>
</tr>
<tr>
<td>“IP Parameters”</td>
<td></td>
</tr>
<tr>
<td>“IP address”</td>
<td>The IP settings of the device. Set when establishing the connection to the controller.</td>
</tr>
<tr>
<td>“Subnet mask”</td>
<td></td>
</tr>
<tr>
<td>“Default gateway”</td>
<td></td>
</tr>
<tr>
<td>“Communication Settings”</td>
<td></td>
</tr>
<tr>
<td>“Send clock (ms)”</td>
<td>Send clock (in milliseconds).</td>
</tr>
<tr>
<td>“Reduction ratio”</td>
<td>Scaling factor. The send cycle is defined by “Send clock” * “Reduction ratio”. Therefore, a “Send clock” of 1ms and a “Reduction ratio” of 4 means that I/O data is sent every 4ms.</td>
</tr>
<tr>
<td>“Phase”</td>
<td>With a “Reduction ratio” of n, the send cycle is divided into phases 1 to n (where data is sent in one phase only). You can determine in which phase the data is sent for the purpose of load distribution. If “Send clock” = 1 and “Reduction ratio” = 4 (as in the example above), then you could configure phases 1–4. For four slaves with this send clock and reduction ratio settings, you could assign one of the four phases to each of the four slaves. In this way, only one data packet is sent in each of the four phases of the send cycle and the load is distributed equally.</td>
</tr>
<tr>
<td>“Watchdog (ms)”</td>
<td>Monitoring time. A multiple of the send cycle (send cycle = “Send Clock” * “Reduction Ratio”). Possible values: 3 ms – 1920 ms. A connection is terminated when the controller or the PROFINET IO Device does not receive I/O data from the communication peer within this time period. The device enters failure mode and switches the outputs to substitute values.</td>
</tr>
<tr>
<td>“VLAN ID”</td>
<td>VLAN identifier: Number between 0 and 4095 for VLAN type 802.1Q. Note: For newer devices compliant with PROFINET IO specification V2.3, only “0” is still permitted.</td>
</tr>
<tr>
<td>“RT class”</td>
<td>If available, you can select the required RT class from the list (real-time communication).</td>
</tr>
<tr>
<td>“User Parameters”</td>
<td></td>
</tr>
<tr>
<td>“Set All Default Values”</td>
<td>CODESYS resets all settings to default values (see default value column) from the GSDML file.</td>
</tr>
<tr>
<td>“Read All Values”</td>
<td>CODESYS reads the current values from the device and updates them in the editor.</td>
</tr>
<tr>
<td>“Write All Values”</td>
<td>CODESYS writes the current values from the editor to the IO device. Not all IO devices support parameter updates in run mode. If not, then an error message is displayed.</td>
</tr>
</tbody>
</table>

See also
- Chapter 6.3.2.18 “PROFINET IO Configurator” on page 1640
PROFINET IO - Module
Module – General

Object: PROFINET IO Module

Table 372: “Module Information”

| “ID number” | Identification of the module (from the device description). |
| “Slot number” | Position of the I/O module below the I/O device, starting at "1" for the first module and incremented for each additional module. This results automatically from the current structure in the device tree. |

Table 373: “User Parameters”

| “Set All Default Values” | CODESYS resets all settings to default values (see default value column) from the GSDML file. |
| “Read All Values” | CODESYS reads the current values from the device and updates them in the editor. |
| “Write All Values” | CODESYS writes the current values from the editor to the I/O module. Not all I/O modules support parameter updates in run mode. If not, then an error message is displayed. |

See also
- § Chapter 6.3.2.18 “PROFINET IO Configurator” on page 1640

6.3.2.18.3 PROFINET IO - Field Device
General

The configuration of the PROFINET IO field device consists of the device itself as well as the modules inserted below.

CODESYS provides two different PROFINET IO field devices:
- A variant especially for Communication Module CM579-PNIO
- A variant which is hardware-independent, the CODESYS PROFINET IO field device This variant runs on any number of Ethernet adapters and is also available in a purely programmatically configurable variant.

When inserting the Ethernet-based CODESYS field device, two tasks are created implicitly that are required by the PROFINET IO communication stack.
- “Profinet_CommunicationTask”: This task includes the acyclic communication services, such as establishing connections and diagnostics. These services are not time-critical due to very weak real-time demands. Therefore the task is low priority.
- “Profinet_IOTask”: This is where the actual PROFINET IO real-time data exchange takes place. Pending I/O data packets are processed in each cycle (see Slave Configurator: “Send clock”). Therefore, a cycle time of 1ms is required (for 1ms send clock).

(6) § Chapter 6.3.2.18.3.3 “Field Device NetX – General” on page 1646
(3) § Chapter 6.3.2.18.2.4.1 “Module – General” on page 1644
(4) Ethernet adapter
(7) § Chapter 6.3.2.18.3.2 “Field Device – General” on page 1645
For maximum IO performance with minimum delay when reading/writing, I/O data can be updated in this task (→ insert own POU that updates IOs in this task). No blocking or persisting operations should be executed in the IO task, such as visualization or file access. If the task is blocked too long, then the watchdog cancels the connection for communicating with the slave (see Slave Configurator: “Watchdog”).

**NOTICE!**

We recommend that you activate the “Refresh I/Os in Stop” option in the PLC settings. Otherwise the communication is canceled when the application stops at a breakpoint.

See also

- *Device Editor Options*
- ≪ Chapter 6.3.2.18.3.2 “Field Device – General” on page 1645
- ≪ Chapter 6.3.2.18.3.3 “Field Device NetX – General” on page 1646

### Field Device – General

Object: PROFINET IO Field Device

The tab displays the basic communication settings.

According to the PROFINET IO standard, the PROFINET IO device is responsible for the IP settings of the used adapter. It has to save remanent IP settings and be able to reset or modify at the request of the controller (IP=0.0.0.0). Initial state (Reset to factory) is with deactivated IP suite (IP=0.0.0.0).

To allow this full reset of the IP configuration, some settings have to be done on most systems (see chapter ≪ Chapter 6.3.2.18 “PROFINET IO Configurator” on page 1640 ).

However, if the PROFINET IO device is a programmable logic controller and connected with the (CODESYS) programming environment via one and the same Ethernet adapter, then modifying and resetting the IP address is interruptive (connection termination between IDE and PLC). Therefore, one of the modes is provided that deviates from the standard (“Use project parameters”).

#### Table 374: “IP and Name Assignment”

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Use remanent data”</td>
<td>The IP settings and the station name of the file are used. The file is stored in the file system. The data is set by the controller and saved to a file by the device.</td>
</tr>
<tr>
<td>“Use project parameters”</td>
<td>The IP settings and the station name of the project are used (settings of the Ethernet adapter). This option must be selected for Windows, VxWorks, and WinCE, because changing the IP address is not possible for these systems.</td>
</tr>
<tr>
<td>“Station name”</td>
<td>Station name of the PROFINET IO Device</td>
</tr>
</tbody>
</table>
Table 375: “IO Provider / Consumer Status”

| “Use incoming” | ☑ The I/O data for the provider and consumer states is generated which is received by the controller. |
| “Use outgoing” | ☑ The I/O data for the provider and consumer states is generated which is sent to the controller. |
| “Substitute values” | The substitute values for the output data become active when the corresponding provider status (Output Data PS) is set to Bad. The output data is sent by the controller and copied to the %I area of the Profinet modules. The following options are available for the substitute values: 
  - “Inactive”: The outputs are set to “inactive” (example: 0).
  - “Last value”: The output data retains the last valid value (provider status = GOOD). The value is retained even if the connection to the controller has been interrupted. |

In online mode, the station name and the IP settings are displayed “Status” tab.

See also
- Chapter 6.3.2.18 “PROFINET IO Configurator” on page 1640

Field Device NetX – General

Object: PROFINET IO Field Device

The tab displays the basic communication settings.

| “Use remanent data” | The IP settings and the station name of the file are used. Initially, the IP address is 0.0.0.0 according to the standard and the station name is blank. When a controller sets these values with the "store remanent" option, then they are stored here. |
| “Use project parameters” | When starting the device, the values defined in the project for IP configuration and station name are always used initially. |
| “Station name” | The name of the device in the network. Note: The station name and the IP settings can deviate from the (default) settings configured in the project. They can be set by the controller in runtime mode and in some cases stored persistently (this means when this is specified for the controller in the Set IP or Set station name commands). After a restart, the device is configured with these values as long as the “Use remanent data” option is set. |
| “IP address” | Initial IP settings |
| “Subnet mask” | Caution: This data can be modified by the PROFINET IO Controller. The remanent data is stored on the file system of the controller. After the controller is restarted, this stored data goes into effect. The settings here are then ignored. |

In online mode, the station name and the IP settings are displayed “Status” tab.

See also
- Chapter 6.3.2.18 “PROFINET IO Configurator” on page 1640
6.3.3 Windows server

Windows server usage in Automation Builder requires modifications of the system environment and of the settings in Automation Builder, e.g. permissions, licensing, session handling etc. How to setup system and software for Windows server is described in the application note *Windows Server 2016 - RDM access*.

6.3.4 Protocols and special servers

6.3.4.1 IEC60870-5-104 (Telecontrol)

6.3.4.1.1 General information IEC 60870

Introduction

The implemented IEC60870-5-104 protocol allows link-ups between AC500 CPUs with onboard Ethernet and external systems. The link-up takes place via the onboard Ethernet interface of the CPU. The telecontrol protocol according to IEC60870-5 is used.

The CPU can work as both control station and substation. In control direction, setpoints and commands can be set; in monitoring direction the substation sends status values, real values and discrete values to the control station. Via general inquiry, the control station requests the substation to send all status values, real values and discrete values. Otherwise, these values are sent by the substation on a change-driven basis, cyclically or when triggered by an application. Status values, real values and discrete values may contain timestamps. These are filled in with the time of the process station when sent. The CPU can time-synchronize the telecontrol link.

A module accepts the configuration of the physical interface (link layer) and the general protocol parts (application layer).

Send and receive blocks are available for data exchange. These blocks exist for the IEC60870-5 data types setpoint value, command value, double command value, status value, double status value, real value and discrete value. The inputs/outputs of the send and receive blocks are combined with the signals to be communicated. See documentation of IEC60870 library for more information.

Limits of supported devices

AC500 V3 (Standard):
- PM5630: Support of 5 control stations and/or substations with 1.000 information objects overall on ETH1 and ETH2.
- PM5650: Support of 10 control stations and/or substations with 5.000 information objects overall on ETH1 and ETH2.
- PM5670: Support of 20 control stations and/or substations with 10.000 information objects overall on ETH1 and ETH2.

AC500-eCo V3:
- PM5012/PM5032/PM5052: no support of IEC60870-5-104 protocol.
- PM5072/PM5082: Support of 5 substations with up to 1.000 information objects overall on ETH1 and ETH2. IEC60870 control stations are not supported.

The S500 I/O modules do not support the functionality to create and transfer a timestamp with an event directly at the I/O channel. A workaround is using SoE logging (Sequence of Event) for a root-cause analysis. For a better understanding on how events are processed on a AC500 V3 PLC, refer to the application example AC500 sequence of events with V3.
Data flow control

Each send or receive block can only process one data message. Ideally, new data are available at each user task run-through or new data can be sent.

If the output OV (send block only) indicates TRUE, the function block computes more quickly than the data can be sent. This can happen if the receive block is not computed quickly enough and has thus not collected all the data.

Alternatively, this block sends either cyclically or if the input value is changed. Ideally, the topical data can be sent via the telecontrol link in connection with every user task run-through.

Data integrity

With IEC60870-5 protocol, a distinction is made between data transmission in the monitoring direction (status values, real values, discrete values) and in the control direction (commands and setpoints).

All data transmissions are acknowledged from the link communication level by the receiver. This acknowledgement is not sent to the sender of the data in every telecontrol link.

For data transmission in control direction, additional acknowledgement (e.g. ACTTERM) is possible. These acknowledgements are not sent by every telecontrol link either. For safe data transmission, it is necessary, in such cases, to configure data readback. The receiver then sends the data received back to the sender via the corresponding send blocks.

Information in the monitoring direction is acknowledged by the receiver on the lowest communication level (link level) when received. This acknowledgement is generated by the telecontrol head itself with some telecontrol heads. In the event of overload/overrun, a data message may be lost. For data in the control direction, so-called ACTTERM acknowledgement can be used. This additional acknowledgement is sent back to the sender when the data have been executed in the process. If data are to be sent in the monitoring direction with guaranteed transmission, it is necessary to read back the sent value via another variable and, after observing a monitoring time, resend in the event of an error.

Data transmission

Send blocks

On the basis of the communication protocol, it is sensible to restrict the data types at one send block to one type. Therefore, there are 5 types of send blocks: send of status values, commands, real values, setpoints and discrete values. These types are mapped to the IEC1131 data types BOOL, REAL and DINT. See documentation of IEC60870 Library for more information.

Operating modes of the send blocks

The send blocks know three operating modes to send their data:

- Caused by request pin (SEND)
- Send in connection with a change of data (AUTO)
- Cyclic send of data (CYCLE)
Send via request pin

The SEND signal is evaluated on the rising edge, the RDY signal remains applied for one computation cycle. If a rising edge is generated again at the SEND signal although no acknowledgement has yet been received from the receiver, the OV pin is set in order to indicate that an overrun has happened. The evaluation of the receive acknowledgement is carried out before the evaluation of whether transmission is to take place. This means, assuming that there is an appropriately fast telecontrol link, that in connection with change-driven and cyclic transmission, a transmission job can be sent in connection with every computation of the block. In connection with send via the request pin it is possible to send only in connection with every second computation (send takes place only with a rising edge).

Change-driven send of data

Data are always sent when the value of the input variables changes. When changes take place, there is an internal simulation that the SEND pin changed from 0 to 1.

In order to prevent unnecessarily frequent send in the event of mild fluctuations in the input value, a threshold value can be configured for real values and setpoints. The input value is not sent until it differs positively or negatively from the value last sent by more than the threshold value.

If the input value changes again although no acknowledgement has yet been received from the receiver, the OV pin is set in exactly the same way as in connection with send via the request pin. If an error occurs during send, the job is automatically retried until the value has been sent without error.

Cyclic send

The data are automatically sent after expiration of a configurable cycle time (SCANDOWN). This cycle time is indicated in multiples of the task cycle time in which the block is computed. In this operating mode, an overrun error can occur if the transmission is faster than the response time of the receiver. For setpoints, it is necessary to ensure that an acknowledgement is generated by the receiver which is not sent until the setpoint is accepted. The send block is not ready for transmission again until after this acknowledgement has been received.

Receive blocks

In receive direction, the jobs enter the device module via the interface. The device module selects the correct receive block using the telecontrol address. To this end, during installation the receive blocks pass their parameterized telecontrol addresses to the device module. The device module stores the data received and the receive blocks make the data available at their output pins in connection with the next computation of the user task.

6.3.4.1.2 Configuration

Configuration changes >= Automation Builder 1.1/CBP 2.4

The IEC 60870 protocol allows link-ups between AC500 CPUs with onboard Ethernet (e.g. PM595-4ETH and PM591-2ETH) and external systems.

The link-up takes place via the onboard Ethernet interface of the CPU. As of Automation Builder Version 1.1 telecontrol is also supported for CPUs that provide more than one Ethernet interface (e.g. PM595-4ETH and PM591-2ETH). This allows to use different Ethernet interfaces for IEC 60870 connections, hence, telecontrol configuration is changed. Further, as of this version terminology is aligned with IEC 60870 standard and provides additional features that are described in this chapter. For a description on principle telecontrol configuration.
For further information on configuration changes, see the following chapters:

Control and Substations ≥ CBP 2.4 "Control station and substation configuration" on page 1650

Import Export ≥ CBP 2.4 "Configuration changes >= Automation Builder 1.1/CBP 2.4" on page 1649

Validity Check of Configuration ≥ CBP 2.4 "Validity check of configuration" on page 1670

Control station and substation configuration

General

The CPU can work as both, control station and substation.

<table>
<thead>
<tr>
<th>Control station</th>
<th>Client, master, controlling station: Synonyms for a higher-level station (central station, monitors other stations)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control direction</td>
<td>Data transfer direction from the control station to the substation</td>
</tr>
<tr>
<td>Substation</td>
<td>Server, slave, controlled station; synonyms for a subordinate IEC 60870-5-104 telecontrol station (which is monitored)</td>
</tr>
<tr>
<td>Monitoring direction</td>
<td>Data transfer direction from the substation to the controlling station</td>
</tr>
</tbody>
</table>

Configure a control station in the device tree “PLC”---> “Interfaces”---> “Ethernet”---> “Protocols”:

1. Right-click “ETHx” ➔ Add objects”.
2. Select the control station from the list and click “Add object”. Configure substations and further control stations in the same way. As of Automation Builder 1.1 any combination of control stations and substations can be configured, in due consideration of a total number of 10 stations.
3. Double-click the “new control station” node to open parameter configuration. In the “Link Layer” tab access to the Ethernet interface is configured.
As of Automation Builder 2.2.1 the V3 PLC telecontrol station objects from GVL IEC60870_5_104_Connection_GVL can only be used in Structured Text by adding the namespace of the GVL as prefix.

Example:

```
byteValue := IEC60870_5_104_Connection_GVL.IEC_60870_5_104_Control-station.Con;
```

“Link layer” tab

In order to provide flexible usage of control stations and substations as of Automation Builder 1.1 configuration of substations has been changed. As several substations can be operated with several Ethernet interfaces, select the Ethernet interface to be used from the pull-down menu. Enter the IP address to the control station and if required to another control station (redundant connection). If no IP address is defined, the substation accepts connection to any control station.

This field is not available in the “Link Layer” tab of control stations. Selection of ETH interface is only possible for substations. The control station is always configured on both interfaces by default.

**Timeout settings**

T1, T2, T3: The values for the connection control and message replication; timeout1/2/3.

**Buffer settings**

This parameter gives the maximum number of outstanding messages and acknowledgement behavior.

Send buffer (k): Maximum difference receive sequence number to send state variable.

Rec buffer (w): Latest acknowledge after receiving w I format APDUs.
Network settings

Network settings are available for control stations and for substations. The IP address of the control station and if available the IP address of another control station (redundant IP address) can be selected by the user.

For an overview on the configured Ethernet interfaces for the control stations and substations, double-click the “Protocols” node.

“Application layer” tab

Settings

The application layer is the communication layer with which the send and receive blocks work.

![Application layer settings](image)

**Use ACTTERM**
This parameter concerns only setpoints and commands. If this parameter is checked, an acknowledgement with set ‘actterm’ is generated as reason for transmission at the time at which the receive block is computed and outputs its telecontrol data at its output pins. On transmission side, the data block awaits the reception of this ACTTERM acknowledgement and reacts with its corresponding output to the reception of this acknowledgement. For commands with execution time, the acknowledgement is generated when the command is terminated, for commands with continuous execution time and for setpoints, the acknowledgement is generated when the data are output to the output pins.

**Foreign Acknowledgement**
If this option is not enabled (default), a message that was sent is considered as ok as soon as transmission was successful. If you enable this option, a message that was sent is not considered as ok until a success message (foreign acknowledge) is returned from the receiver.

**Application timeout**
This time indicates how long an acknowledgement will be awaited on the application level. An acknowledgement is generated only for commands and setpoints on the application level.

**Station address**
The station address defines which station will be subject to a count query. The values define the 2 bytes for the common telecontrol address (Common addr.). The values concerned are as follows:
0: The station address is not used.
1 ... 254: The count is queried on the station defined by the station address.
255: The count is queried on all accessible stations.

**Timesync**
After each new establishment of a link and once per hour, a ‘coarse time synchronisation’ message is generated. This time synchronisation is only supported from AC500 to external systems. Time synchronisation from an external system to AC500 is not provided! Incoming time synchronisation messages are confirmed by the process station but not executed. Greenwich Mean Time (GMT) is used as the time for the synchronisation.

**Send 'Init end' after reconnection**
After each establishment of a link or only in connection with the first establishment of a link and after reconfiguration, an init end message is generated. After the init end message, there is a general inquiry, if configured.

**General inquiry**
**Activated**
This parameter concerns only real values, discrete values and status values. The device module generates a general inquiry message after each new establishment of a link. The other side then generates a message with the reason for transmission ‘general inquiry’ for every data point and subsequently an init end message. This procedure ensures that, in the event of a new establishment of a link, all data are available on the reception side in topical form.

**With parameters**
If general inquiry is activated the parameter values are sent.

**Without integrated totals**
With a general inquiry no integrated total values are sent.

**Counter interrogation**
**Group**
General, 1 ... 4: The count inquiry is executed for a specific group of counters (1 ... 4). The count inquiry is executed for all groups of counters.

**With reset**
The reset quality bit is sent along with the count inquiry.

**With relocate**
The relocate quality bit is sent along with the count inquiry.

**“Information objects” tab**
**General**
Open the “Information object” tab to configure so called information objects and a common address (known as 'data points' and 'Global address' in former Automation Builder versions). In this tab different information objects and their services for transmission are defined. A data point or information object is identified via a system-wide unambiguous address containing a maximum 5 bytes.

1. Right-click in the empty view and select “Add Information Object with ASDU” to add a data group. Select the desired object from the list (e.g. M_SP_NA_1).
   - An information object with a corresponding ASDU (Application Service Data Unit) is created.
2. Configure the settings in the “Information Object” tab to your convenience.

3. Double-click a table cell to modify pre-set values. For some ASDUs additional sub information objects can be configured. For this, right-click the already existing ASDU and select “Add Information Object” to selected ASDU option. This allows configuration of 16 data points at the most (depending on the ASDU type). With “Remove Information Object” the selected ASDU is deleted.

**Description of the columns**
- ASDU name: node name of the information object (name of the ASDU).
- Data type: Data type of the ASDU.
- ASDU type: Type of ASDU.
- Common addr: Common address of the ASDU (known as ‘Global Address’ in former AB Versions). Byte 1/2 of the common telecontrol address of the block (range: 0 ... 255).
- Info obj addr: Together with common address Info obj addr defines the endpoint (range: 0 ... 255).
- Norm start: Low limit (0 %) of the normalized range for real values and setpoints.
- Norm end: High limit (100 %) of the normalized range for real values and setpoints.
- Threshold: Threshold limit beyond which a change of the input value referred to.
- Description: Table cell for free text. Use this field to describe your configuration settings e.g. differences between configuration variants.

**Format of common addr and info obj addr**

The following address formats of your entries in the columns Common addr and Info obj addr of the “Information Objects” tab are possible:
- 1.2 and 3.4.5 (Default format)
- 1-2 and 3-4-5
- 258 or hex 0x102 and 197637 or hex 0x30405
- 513 or hex 0x201 and 328707 or hex 0x50403

Previously you have to choose your preferred address format:
1. Click “Tools” and then “Options...”
   ⇒ The window “Options” appears

2. Select “IEC 60870-5-104”, make your choice and click [OK].

Import options of information objects
The User can accept the imported IEC60870 information objects as single change or change as block.
IEC60870-5-104 Multiple connections

General

An AC500 with more than one substation connection must be able to identify the corresponding control station clearly. This identification takes place exclusively via the control station’s IP address. In order to make it possible for a non-redundant control station to have redundant access to a substation with 2 Ethernet connections. The local substation address is ignored during connection establishment.

In the following descriptions, the term station must not be confused with the individual connection. One station can have several connections. An IEC60870-5-104 communication always takes place between a control station and a substation. A control station can manage several substations and also simultaneously be a substation for one or several control stations. However, these must then be realized using different stations.

A PLC may **not** be configured for another PLC repeatedly as a substation or a control station unless a disjunctive Ethernet infrastructure is used for this.

Redundant connections must be specified as such in the configuration.

An AC500 can be used only once as control station for another AC500, it makes no sense to use the same AC500 repeatedly as a control station for the same substation. Such a structure is configured as a redundant control station as long as only one AC500 exists as a control station per substation. However, this control station may have 2 IP addresses. Therefore, this configuration must either have the IP address 0.0.0.0 entered on the substation for the control station, meaning that all IP addresses are accepted and no other control station can access this AC500 or alternatively the possible control station addresses must be specified (ETH1 and ETH2).
PM57x/- PM58x/- PM59x-ETH, PM5650-2ETH:

If you plan to control several substations with the AC500, they can be cascaded. This results in a tree structure.

1. 2 control stations
2. Substation and 3 control stations
3. Substation and 3 control stations
4. Substation
5. Substation

In the following, the notation 192.168.1.0/24 is used for TCP/IP networks. Here, the figure /24 specifies the network mask with 255.255.255.0 and 192.168.1.0 describes the network. The valid addresses for this Class C network are 192.168.1.1 to 192.168.1.254! Only the last byte of the address is provided on the respective devices, with e.g. .10. This means that the respective device has the address 192.168.1.10.
Minimal structure

A control station with an Ethernet interface is connected to a substation with an Ethernet interface.

Configuration at control station

PM57x-/ PM58x-/ PM59x-ETH, PM5650-2ETH:
The respective substation IP address must be specified at the control station. For this, in the network settings of the control station (1) enter the IP address of the substation (in the example: 192.168.1.25). Option "Enable redundant connection" must be disabled.

Configuration at substation

PM57x-/ PM58x-/ PM59x-ETH, PM5650-2ETH:
Either the control station IP address or the general address 0.0.0.0 must be specified at the substation (2). For this, in the network settings of the substation enter the IP address of the control station (in the example: 192.168.1.10). Option "Enable redundant connection" must be disabled.

If the general address 0.0.0.0 is used at the substation, no further control station can be configured on this controller for a further substation.
Minimal redundancy structure

The most simple redundant structure with an AC500 consists of a redundant control station (not AC500) which is connected to the AC500 substation with 2 different IP addresses. These redundant control stations must synchronize which control station is active.

Only one control station can be active at any given time.

![Diagram of redundant structure]

(1) Control station 1A (Not AC500)
(2) Control station 1B (Not AC500)
(3) Substation
(4) Redundancy link

**Configuration at control stations**
The respective substation IP address must be specified at the control stations 1 and 2 (not AC500). For this, in the network settings of both control stations enter the IP address of the substation (in the example: 192.168.1.25).

**Configuration at substation**
PM57x-/ PM58x-/ PM59x-ETH, PM5650-2ETH:
Either the control station IP addresses or the general address 0.0.0.0 must be specified at the substation (3). For this, in the network settings of the substation enter the IP addresses of the control station (in the example: 192.168.1.10 and 192.168.1.11). Option “Enable redundant connection” must be enabled.

---

*If the general address 0.0.0.0 is used at the substation, no further control station can be configured on this controller for a further substation.*
Network redundancy

General
For network redundancy a control station can reach a substation via 2 paths.
Both the control station and the substation can have 2 different IP addresses. Without special network routing, 2 separate networks should exist, within which both the substation and the control station each have 2 interfaces.
Possible variants of network redundancy are described in the following.

Network redundancy with 2 separate networks

1. Control station with 2 redundant paths
2. 1 Substation with 2 Ethernet interfaces

Configuration at control stations
PM591-2ETH, PM595-4ETH, PM5650-2ETH:
The substation’s IP addresses must be specified at the control stations (1). For this, in the network settings of the control station enter the IP addresses of the substation (in the example: 192.168.1.25 and 192.168.2.26). Option “Enable redundant connection” must be enabled.

Configuration at substation
PM591-2ETH, PM595-4ETH, PM5650-2ETH:
Either the control station's IP addresses or the general address 0.0.0.0 must be specified at the substation (2). For this, in the network settings of the substation enter the IP addresses of the control station (in the example: 192.168.1.10 and 192.168.2.11). Option “Enable redundant connection” must be enabled.
If the general address 0.0.0.0 is used at the substation, no further control station on another substation can be configured on this controller. Equally, the substation connection must be activated for both interfaces.

Network redundancy with 1 network and 2 Ethernet ports in substation

(1) Control station with 2 paths to reach substation
(2) 1 Substation with 2 Ethernet interfaces

Configuration at control stations PM591-2ETH, PM595-4ETH, PM5650-2ETH:
The substation’s IP addresses must be specified at the control stations (1). For this, in the network settings of the control station enter the IP addresses of the substation (in the example: 192.168.1.25 and 192.168.1.26). Option “Enable redundant connection” must be enabled.

Configuration at substation PM591-2ETH, PM595-4ETH, PM5650-2ETH:
Either the control station's IP addresses or the general address 0.0.0.0 must be specified at the substation (2). For this, in the network settings of the substation enter the IP addresses of the control station (in the example: 192.168.1.10 and 192.168.2.11). Option “Enable redundant connection” must be enabled.
If the general address 0.0.0.0 is used at the substation, no further control station on another substation can be configured on this controller. Equally, the substation connection must be activated for both interfaces.

Network redundancy with 1 network and 1 Ethernet port in substation

- No online redundancy.
- Only one connection will be established.

Configuration at control stations

PM591-2ETH, PM595-4ETH, PM5650-2ETH:

The substation's IP addresses must be specified at the control stations (1). For this, in the network settings of the control station enter the IP addresses of the substation (in the example: 192.168.1.25 and 0.0.0.0). Option “Enable redundant connection” must be disabled.

Configuration at substation

PM591-2ETH, PM595-4ETH, PM5650-2ETH:

Either the control station's IP addresses or the general address 0.0.0.0 must be specified at the substation (2). For this, in the network settings of the substation enter the IP addresses of the control station (in the example: 192.168.1.10 and 192.168.2.11). Option “Enable redundant connection” must be enabled.
If the general address 0.0.0.0 is used at the substation, no further control station on another substation can be configured on this controller. Equally, the substation connection must be activated for both interfaces.

Network redundancy with 2 Ethernet ports in substation

(1) Control station with 2 paths to reach substation
(2) 1 Substation with 2 Ethernet interfaces

Configuration at control stations
PM591-2ETH, PM595-4ETH, PM5650-2ETH:
The substation’s IP addresses must be specified at the control stations (1). For this, in the network settings of the control station enter the IP addresses of the substation (in the example: 192.168.1.25 and 192.168.1.26). Option “Enable redundant connection” must be enabled.

Configuration at substation
PM591-2ETH, PM595-4ETH, PM5650-2ETH:
Either the control station's IP addresses or the general address 0.0.0.0 must be specified at the substation (2). For this, in the network settings of the substation enter the IP addresses of the control station (in the example: 192.168.1.11 and 0.0.0.0). Option “Enable redundant connection” must be disabled.

If the general address 0.0.0.0 is used at the substation, no further control station on another substation can be configured on this controller. Equally, the substation connection must be activated for both interfaces.
Full control station redundancy

A control station can consist of two fully redundant units (not AC500s), which are connected via a redundancy link. These control stations must ensure that only one of them at a time is actively connected to the substation and communicates with it. The inactive control station, however, can establish non-active connection with a substation and monitor it with keep alive packages.

(1) 2 redundant Control stations (Not AC500)
(2) 1 Substation with redundant Control station and 2 Ethernet interfaces (2nd port)
(3) Redundancy link

Configuration at control stations

The substation's IP address must be specified at the control stations (1) (not AC500). For this, in the network settings of the control station enter the IP addresses of the substation (in the example: 192.168.1.25 and 192.168.2.26).

Configuration at substation

PM591-2ETH, PM595-4ETH, PM5650-2ETH:

Either the control station's IP addresses or the general address 0.0.0.0 must be specified at the substation (2). For this, in the network settings of the substation enter the IP addresses of the control station (in the example: 192.168.1.10 and 192.168.2.11). Option "Enable redundant connection" must be enabled.

If the general address 0.0.0.0 is used at the substation, no further control station on another substation can be configured on this controller. Equally, the substation connection must be activated for both interfaces.
Multiple control stations on the same network

As of firmware version 2.4, an AC500 can be used as a substation for several control stations. For this, the control stations must be distinguished by their IP addresses. Should a control station have more than one IP address (redundancy), both possible IP addresses should also be entered for the allocated substation connection. As a result, even despite being equipped with several Ethernet interfaces, a device can only be one allocated control station at a time for a determined substation. Thus, several substations can be configured for different control stations on a AC500.

(1) Control station 1
(2) Control station 2
(3) 2 Substations (IEC60870-5-104 2nd Connection)

**Configuration at control stations**
PM57x/- PM58x/- PM59x-ETH, PM5650-2ETH:
The substation’s IP address must be specified at the control stations. For this, in the network settings of the control station (1 and 2) enter the IP addresses of the substation (in the example: 192.168.1.25). Option “Enable redundant connection” must be disabled.

**Configuration at substations**
PM57x/- PM58x/- PM59x-ETH, PM5650-2ETH:
Both control station’s IP addresses must be specified at the substation (3). For this, in the network settings of the substation enter the IP addresses of the control stations (in the example: 192.168.1.10 and 192.168.1.11). Option “Enable redundant connection” must be disabled.
Multiple control stations on different networks

As of firmware version 2.4, an AC500 can have several local Ethernet interfaces which can be used for separate control station connections. For this, a control station must be identified via its IP address. The substation address used locally is not used to distinguish a connection in order to enable a network and therefore route redundancy. On AC500, the acception of IEC60870-5-104 connections on an interface can only be prevented.

(1) Control station 1
(2) Control station 2
(3) 2 Substations with 2 Ethernet interfaces (2\textsuperscript{nd} port and 2\textsuperscript{nd} connection)

**Configuration at control stations**

PM57x/- PM58x/- PM59x-ETH, PM5650-2ETH:

The substation's IP addresses must be specified at the control stations (1 and 2). For this, in the network settings of the control station enter the IP addresses of the substation (in the example: 192.168.1.25 and 192.168.2.26). Option “Enable redundant connection” must be disabled.

**Configuration at substations**

PM591-ETH, PM595-ETH, PM5650-2ETH:

Both control station's IP addresses must be specified at the substation (3) under both substation connections. For this, in the network settings of the substation enter the IP addresses of the control stations (in the example: 192.168.1.10 and 192.168.2.11). Option “Enable redundant connection” must be disabled.
Double connection

<table>
<thead>
<tr>
<th><img src="image" alt="Diagram" /></th>
</tr>
</thead>
</table>

This configuration does work. 
But it is senseless!

It is possible to configure a double connection between 2 stations using 2 separate networks (at least logically separated sub-networks).

However, such a setup has no advantages via-à-vis the minimal structure right at the start.

For this setup, connection data must be double configured and double resources are also required at the stations, not providing any advantages whatsoever.

Rather the opposite is true, because such configurations are highly prone to errors.

(1) 2 Control stations with 2 Ethernet interfaces  
(2) 2 Substations with 2 Ethernet interfaces
Faulty configuration

This configuration does not work!

If an AC500 is configured as a control station, the interface which is used to reach the substation is not defined.

The decision as to which interface is used for this is taken by TCP/IP when running.

It is also dependent on the current network configuration.

Here, the current link status and the order of link recognition may be decisive for the interface to be used.

Such a scenario would not result in stable communication as both substations cannot clearly distinguish the control stations.

Instead, the connection management for a substation will assume that the control station has lost the connection and then establishes a connection.

(1) 2 Control stations with 2 Ethernet interfaces
(2) 2 Substations with 2 Ethernet interfaces

Export a CSV file

As an alternative many values can be modified at a time by exporting the configuration to a CSV file. After modifying the file data, import the CSV file.

☑ Chapter 6.3.4.1.2.3 “Import/Export functionality” on page 1669
Import/Export functionality

As of Automation Builder 1.1 (CBP >= 2.4) configuration of control stations and substations can be exported/imported via CSV file. Open the CSV file with a spreadsheet software (e.g. Microsoft Excel) and modify the values within the file to your convenience:

1. Export configuration data: right-click the node of the control station or substation to be exported.

2. Click “Export → IEC 60870-5-104 information objects (CSV)” and store the CSV file to a desired directory.

3. Open the CSV file with a spreadsheet software (e.g. Microsoft Excel) and change the values to your convenience. Added table columns are only accepted after the last column.

4. Import configuration data: right-click the node of the control station or substation that has been exported previously.

5. Click “Import → IEC 60870-5-104 information objects (CSV)” and select the CSV file from the file system. Configuration data is imported.

As of Automation Builder 1.1.1 during file import the project data is compared with the project data that is already available. In order to prevent data from being overwritten inadvertently, you can select the data that shall be imported in the “Project Compare - Differences” window:

Data on the left side of the window refers to already available project data. This data is displayed under “Control station → Information objects” tab. Data on the right side of the window refers to new data that can be imported after your confirmation. Decide whether to import (and overwrite) the data or not.
- Data in black color means the existing data and the data to be imported is identical.
- Data in red color means the existing data and the data to be imported differ. Decide whether to import the new data (and to overwrite the existing data) or not.
- Data in blue color means, the data to be imported is new and will be added to the existing data.
- Data that has been confirmed for the import already is displayed in green color (after clicking [Accept Single]).

In order to move data from one side of the window to another, select the data and click [Accept Single]. Data is highlighted in yellow.

To confirm the import of all new data, click the top entry (here: All: ASDU name - ASDU type - Common addr - ...). Then, click [Accept Single].

Close the "Project Compare - Differences" tab, save your project and confirm the message. The changes are displayed in the "Information objects" tab.

Validity check of configuration

We recommend you to verify the IEC configuration of control stations and substations: Right-click a control station or substation -> "Check configuration".
The check will look for the following topics:

- Duplicate addresses.
- Stations without any Information objects.
- ASDU names, which are not unique.

When a check finds errors or incompatibilities this will be reported in a separate messages view at the bottom of the window:

![Messages view](image)

With a double-click on the error line, the part of the configuration with the violation will be opened. Now, you can correct the error.

### 6.3.4.1.3 IEC60870 compatibility list

In order to implement specific telecontrol systems, this companion standard presents sets of parameters and alternatives from which subsets must be selected.

*AC500 – IEC60870-5-104 Protocol Interoperability / Compatibility List*

### 6.3.4.2 IEC 61850 Server

#### 6.3.4.2.1 Introduction to IEC 61850

The IEC 61850 communication protocol standard for electrical substations enables the integration of all protection, control, measurement, and monitoring functions by one common protocol. It provides the means of high-speed substation applications, station wide interlocking and other functions requiring intercommunication between IEDs = blue boxes in the following figure.
The well described data modelling, the specified communication services for the most recent tasks in a station makes the standard to a key element in modern substation systems.

This manual describes mainly how the IEC 61850 standard is applied in AC500. References and brief descriptions of the IEC 61850 standard are also included in this introduction chapter. Anyhow, it is assumed that the reader has basic knowledge about the IEC 61850.

To understand the IEC 61850 standard and to be able to find the related information, the following parts of the standard are important:
IEC 61850-5 explains how substation functions are realized by logical nodes = function blocks which are running in the IEDs. Operating an isolator from station level for example requires the logical nodes: “IHMI”, “CSWI”, “CILO” and “XSWI”.

The logical nodes and their data objects are defined in IEC 61850-7-4, for example “CSWI”, which is an abbreviation for “Switch controller”.

### CSWI class

<table>
<thead>
<tr>
<th>Data object name</th>
<th>Common data class</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Status information</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LocKey</td>
<td>SPS</td>
<td>Local or remote key</td>
</tr>
<tr>
<td>Loc</td>
<td>SPS</td>
<td>Local control behavior</td>
</tr>
<tr>
<td>OpOpn</td>
<td>ACT</td>
<td>Operation “Open switch”</td>
</tr>
<tr>
<td>SelOpn</td>
<td>SPS</td>
<td>Selection “Close switch”</td>
</tr>
<tr>
<td>OpClIs</td>
<td>ACT</td>
<td>Operation “Open switch”</td>
</tr>
<tr>
<td>SelCLIs</td>
<td>SPS</td>
<td>Selection “Close switch”</td>
</tr>
<tr>
<td><strong>Controls</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OpCntRs</td>
<td>INC</td>
<td>Resettable operation counter</td>
</tr>
<tr>
<td>LocSta</td>
<td>SPC</td>
<td>Switching authority at station level</td>
</tr>
<tr>
<td>Pos</td>
<td>DPC</td>
<td>Switch, general</td>
</tr>
<tr>
<td>PosA</td>
<td>DPC</td>
<td>Switch L1</td>
</tr>
<tr>
<td>PosB</td>
<td>DPC</td>
<td>Switch L2</td>
</tr>
<tr>
<td>PosC</td>
<td>DPC</td>
<td>Switch L3</td>
</tr>
</tbody>
</table>

### DPC class

<table>
<thead>
<tr>
<th>Attribute name</th>
<th>Attribute type</th>
<th>FC</th>
<th>TrgOp</th>
<th>Value / Value range</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Control and status</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ctlVal</td>
<td>BOOLEAN</td>
<td>CO</td>
<td></td>
<td>off (FALSE), on (TRUE)</td>
</tr>
<tr>
<td>operTm</td>
<td>TimeStamp</td>
<td>CO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>origin</td>
<td>Originator</td>
<td>CO, ST</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ctlNum</td>
<td>INT8U</td>
<td>CO, ST</td>
<td>0...255</td>
<td></td>
</tr>
<tr>
<td>stVal</td>
<td>CODED ENUM</td>
<td>ST</td>
<td>dchg</td>
<td>Intermediate-state, off, on, bad-state</td>
</tr>
<tr>
<td>q</td>
<td>Quality</td>
<td>ST</td>
<td>dchg</td>
<td></td>
</tr>
<tr>
<td>t</td>
<td>TimeStamp</td>
<td>ST</td>
<td></td>
<td></td>
</tr>
<tr>
<td>stSeld</td>
<td>BOOLEAN</td>
<td>ST</td>
<td>dchg</td>
<td></td>
</tr>
<tr>
<td><strong>Configuration, description and extension</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>pulseConfig</td>
<td>PulseConfig</td>
<td>CF</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ctlModel</td>
<td>CtlModels</td>
<td>CF</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### DPC class

<table>
<thead>
<tr>
<th>Data attribute</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sboTimeout</td>
<td>INT32U</td>
<td>CF</td>
</tr>
<tr>
<td>sboClass</td>
<td>SboClasses</td>
<td>CF</td>
</tr>
<tr>
<td>d</td>
<td>VISIBLE</td>
<td>STRING255</td>
</tr>
<tr>
<td>dU</td>
<td>UNICODE</td>
<td>STRING255</td>
</tr>
</tbody>
</table>

Data attributes can be addressed by their full path, for example “CSWI.Pos.stVal” contains the switch status of a certain isolator and can have the values: on, intermediate-state or off (bad-state only in case of defect auxiliary switches).

---

### Part 7-2: Abstract Communication Service Interface (ACSI)

Abstract communication services between logical nodes are described in IEC 61850-7-2. Following figure shows how a client (e.g. “IHMI”) sends an operate command (“Oper_req”) to a control object (e.g. “CSWI”). The control objects sends a confirmation (“Oper_rsp”) immediately and a report with the updated status (“Report_req”) after the “CSWI.Pos.stVal” has changed to off.

![Diagram](image)

Another service is GOOSE (Generic Object Oriented Substation Event), which is used for fast communication like tripping a circuit breaker or interlocking. GOOSE messages are always retransmitted. Slowly in stable conditions and fast after an event has occurred.

![Diagram](image)

- **T0** Retransmission in stable conditions (no event for a long time).
- **(T0)** Retransmission in stable conditions may be shortened by an event.
- **T1** Shortest retransmission time after the event.
- **T2, T3** Retransmission times until achieving the stable conditions time.
Communication profile (IEC 61850 stack) is described in IEC 61850-8-1. This part of the standard maps the abstract services from IEC 61850-7-2 to concrete communication profiles: While core ASCI services like control and reporting are using MMS and TCP/IP, the fast GOOSE service is working directly on the Ethernet layer.

<table>
<thead>
<tr>
<th>IEC 61850-7-2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Application</strong></td>
</tr>
<tr>
<td>MMS (ISO 9506)</td>
</tr>
<tr>
<td><strong>Presentation</strong></td>
</tr>
<tr>
<td>ASN.1</td>
</tr>
<tr>
<td><strong>Session</strong></td>
</tr>
<tr>
<td>Session</td>
</tr>
<tr>
<td><strong>Transport</strong></td>
</tr>
<tr>
<td>TCP</td>
</tr>
<tr>
<td><strong>Network</strong></td>
</tr>
<tr>
<td>IP</td>
</tr>
<tr>
<td><strong>Data Link</strong></td>
</tr>
<tr>
<td>Ethernet</td>
</tr>
<tr>
<td><strong>Physical</strong></td>
</tr>
<tr>
<td>Physical</td>
</tr>
</tbody>
</table>

SCL (Substation Configuration Language) is described in IEC 61850-6. The SCL is an XML based definition of how to describe substation single line, IEDs with logical nodes and their communication through a communication bus. The following types of SCL files are distinguished:

- SSD (System Specification Description), describing the single line and required logical nodes.
- ICD (IED Capability Description), containing the capability (possible logical nodes) of one IED type.
- CID (Configured IED Description), containing the configuration of a concrete IED with instantiated logical nodes, services and communication addresses.
- SCD (Substation Configuration Description), containing description of the complete substation, consisting of single line, communication bus and IEDs with logical nodes, which are linked to the primary equipment in the substation section.

The part IEC 61850-6 also includes the roles of different tools as well as the engineering concepts. It distinguishes between system wide engineering with a system configurator and IED specific engineering with an IED Configurator.
Part 10: Conformance testing

Conformance tests and the basis for conformance documents are handled in IEC 61850-10.

Abbreviations

Short list of IEC 61850 related abbreviations.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASCI</td>
<td>Abstract Common Services Interface</td>
</tr>
<tr>
<td>CID</td>
<td>SCL type: Configured IED Description</td>
</tr>
<tr>
<td>CILO</td>
<td>Logical node in Group &quot;C - Control functions&quot;: Interlocking</td>
</tr>
<tr>
<td>CSWI</td>
<td>Logical node in Group &quot;C - Control functions&quot;: Switch Controller</td>
</tr>
<tr>
<td>DPC</td>
<td>Common data class “controllable double point”</td>
</tr>
<tr>
<td>GOOSE</td>
<td>Generic object oriented substation event</td>
</tr>
<tr>
<td>ICD</td>
<td>SCL type: IED Capability Description</td>
</tr>
<tr>
<td>IED</td>
<td>Intelligent Electronic Device (e.g. control or protection relay, AC500, …)</td>
</tr>
<tr>
<td>IHMI</td>
<td>Logical node in Group &quot;I - Interface and archiving&quot;: Generic human – machine interface</td>
</tr>
<tr>
<td>MICS</td>
<td>Modeling Information Conformance Statement</td>
</tr>
<tr>
<td>MMS</td>
<td>Manufacturing Message Specification, ISO 9506</td>
</tr>
<tr>
<td>PICS</td>
<td>Protocol Information Conformance Statement</td>
</tr>
<tr>
<td>PIXIT</td>
<td>Protocol Extra Information</td>
</tr>
<tr>
<td>Pos</td>
<td>Position of a switch or circuit breaker</td>
</tr>
<tr>
<td>SCD</td>
<td>SCL type: Substation Configuration Description</td>
</tr>
<tr>
<td>SCL</td>
<td>Substation Configuration Language</td>
</tr>
<tr>
<td>SSD</td>
<td>SCL type: System Specification Description</td>
</tr>
<tr>
<td>stVal</td>
<td>status Value</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>Transmission Control Protocol / Internet Protocol</td>
</tr>
<tr>
<td>TICS</td>
<td>Tissue Information Conformance Statement</td>
</tr>
<tr>
<td>XSWI</td>
<td>Logical node in Group &quot;X - Switchgear&quot;: Switch, disconnector or earth-switch</td>
</tr>
</tbody>
</table>

Further abbreviations can be found in the standard:

IEC 61850-2: Glossary – Terms and definitions, abbreviations
IEC 61850-7-3: List of all Common data classes, like DPC
IEC 61850-7-4: List of all Logical nodes, like CSWI

6.3.4.2.2 AC500 and IEC 61850

General

After installation of the IEC 61850 - server package, the AC500 can act as an Intelligent Electronic Device (IED) in an IEC 61850 network. The AC500 IEC 61850 package allows to connect substation automation systems to PLC applications Automation Builder is used as IED configurator tool for modelling IEC 61850 data and communication in AC500.

Capabilities

This IEC 61850 server package 4.x allows the AC500 V3 to act as an IED with IEC61850 server, Edition 1, providing following functionality:
- Configure a data model with logical nodes and map their data attributes to IEC 61131 application.
- Configure data sets to bundle data objects and attributes for publishing them as MMS reports or GOOSE control blocks.
- MMS server for core ASCI services like sending MMS reports over TCP/IP.
- GOOSE Publisher, sending GOOSE control blocks in a very fast way by bypassing TCP/IP layers.
- GOOSE Subscriber, receiving GOOSE reports from other IEDs and map their data attributes to the IEC 61131 application.
- SNPT client or server for time synchronization (included in the standard package of AC500).

To get information and an understanding about the implemented possibilities of IEC 61850 in the AC500, the details are described in the IEC 61850 conformance documents. Conformance documents, which can be found in the example folder.

Example projects for the libraries can be found in the example folder: “Help ➔ Project examples” in the Automation Builder menu.

Prerequisite: Install the related library package with “Automation Builder ➔ Tools ➔ Installation Manager” - [Modify].

- MICS (Modeling Information Conformance Statement), contains the declaration of the used logical node types.
- PICS (Protocol Information Conformance Statement), contains the details and what is supported regarding protocol facilities.
- PIXIT (Protocol Extra Information), contains additional information on how the IEC 61850 is implemented and used.
- TICS (Tissue Information Conformance Statement), contains the supported tissues, which are handled in the tissues process as defined by UCA, Utility Communication Architecture forum. The tissues handling is found in IEC TICS.
The same folder also contains the TÜV certificate for AC500 midrange CPUs: PM5630, PM5650, PM5670 and PM5675. AC500-eCo V3 as released after the certification but is capable of IEC 61850 as well. The certificates can also be accessed online from the UCA database. Search for organization “ABB Automation GmbH”.

Automation Builder is used as IED configurator tool according to IEC 61850-6 for modelling the IEC 61850 data structures and connecting them to the PLC application. It allows import and export of SCL to transfer detailed configuration information between Automation Builder and other IEC 61850 configuration tools:

- .cid file (from another IED) or .scd file (complete substation with several IEDs) can be imported.
- .cid file (AC500 configured as IED) can be exported.

**Limits/technical data**

- Edition 1 of IEC 61850 is supported only.
- MMS server only.
- Data sets for MMS and GOOSE reporting: Max. 20 data sets with max 50 entries each.
- MMS reporting: Max. 5 MMS clients.
- GOOSE Subscriber: Max. 50 Ethernet frames per cycle.
  - If this is not sufficient, the workaround is to reduce the cycle time.
- Not possible to have 2 or more IEC 61850 server in one Automation Builder project.
  - Workaround: Create 2 or more projects.
- Only one logical device per IEC 61850 server.
- Only one report per data set.
- Automation Builder is an IED Configurator but no system configurator tool as defined in IEC 61850-6. It cannot export .ssd or .scd files.

**Installation**

The “IEC 61850 Server (PS5602)” package can be installed with the Automation Builder - Installation Manager.

**Automation Builder Engineering Productivity**

To set the IEC 61850 server into RUN, a runtime license PS5602-61850 per CPU must be purchased through the local sales support.
Engineering workflow

Examples

AC500 as IED can act as IEC 61850 MMS server (Example A) and / or GOOSE Publisher and Subscriber (Example B). Most of the engineering steps are common and are explained in this chapter. The examples projects A and B can be found in the Automation Builder example folder.

Example projects for the libraries can be found in the example folder: “Help → Project examples” in the Automation Builder menu.

Prerequisite: Install the related library package with Automation Builder Installation Manager - [Modify].

Example A

Communicating through MMS server:

A simulated switch in AC500 which can be operated from an operator IED and sends back its status through an MMS report.

Example B

Communication though GOOSE:

AC500 publishes a GOOSE control block (e.g. “ping”) to another IED (for example REF615 or a second AC500), which itself sends back a GOOSE control block (e.g. “pong”), that is subscribed by AC500 IED.
For engineering of the above functionalities, the Automation Builder is acting as IED configurator tool according to IEC 61850-6. The following engineering steps (yellow circles in the figures above) need to be executed:

1. Configure the "IEC 61850 Server" with logical nodes, which are connected to global variables in the IEC 61131 application.
   - Chapter 6.3.4.2.2.5.2 "Configuration of IEC 61850 server with logical nodes" on page 1680

2. Group data objects and attributes of the logical nodes into data sets.
   - Chapter 6.3.4.2.2.5.5 "DataSet" on page 1688

3. Publish data sets as MMS report.
   - Chapter 6.3.4.2.2.5.6 "Report (MMS)" on page 1689

4. Publish data sets as GOOSE Publisher.
   - Chapter 6.3.4.2.2.5.7 "GOOSE Publisher" on page 1691

5. Export server as *.cid file. So that other IEDs can access logical nodes and data sets and subscribe to MMS reports or GOOSE control blocks.
   - Chapter 6.3.4.2.2.5.8 "Export Server " on page 1693

6. Configure GOOSE Subscriber to subscribe GOOSE control blocks from other IEDs after importing *.cid or *.scd files. The control blocks are connected to the "PLC_PRG (PRG)" application.
   - Chapter 6.3.4.2.2.5.9 "GOOSE Subscriber" on page 1694

7. Generate code for IEC 61850 POUs.
   - Chapter 6.3.4.2.2.5.10 "Generate IEC61850 code" on page 1696

8. Generate the application "PLC_PRG (PRG)" including logical node functionality.
   - Chapter 6.3.4.2.2.5.11 "Generate the application" on page 1697

Configuration of IEC 61850 server with logical nodes

The following describes how to create an "IEC 61850 Server" and configure the IEC 61850 data model with logical nodes, data objects and data attributes which can be connected to global variables in the IEC 61131 application. Starting point is a new or existing project with AC500 V3 CPU.

Add IEC 61850 Server

Add an "IEC 61850 Server" object below Ethernet port "ETH1" or "ETH2", depending on which IP address the MMS server should use. The IP addresses of "ETH1" and "ETH2" are configured with the "IP-Configuration" tool.
GOOSE Publisher and Subscriber is independent of the IP address. Instead, the Ethernet MAC addresses must be configured in GOOSE Publisher and/or Subscriber. Even if only GOOSE is configured like in example B, an "IEC 61850 Server" is required, which can be placed below any Ethernet port.

Chapter 6.3.4.2.2.5.7 “GOOSE Publisher” on page 1691

Chapter 6.3.4.2.2.5.9 “GOOSE Subscriber” on page 1694

The properties of the "IEC 61850 Server" can be configured. For basic functionality, the default values can be used.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Name</td>
<td>Name of the server.</td>
</tr>
<tr>
<td>Max.client count</td>
<td>The maximum number of clients that can connect to the IED, possible values: 1, 2, 3, 4, 5</td>
</tr>
<tr>
<td>Allowed IPs</td>
<td>Allowed IPs for clients 1...5. Default is 0.0.0.0, whereby an IP address that equals 0.0.0.0 means that no IP address validity test will take place. If more than one client connection was selected above, additional IPs must be configured for each one. As soon as an IP address is parameterized with 0.0.0.0, testing for all connected clients is deactivated.</td>
</tr>
</tbody>
</table>
### Property Description

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Time synchronisation  | **Selection:** SNTP  
SNTP (only possible option): (S)NTP time synchronization  
博士学位 Chapter 6.3.4.2.2.7.1 “Time sync” on page 1707  
The following values should only be used if the PLC time is interpreted as UTC time:  
1. **Input field Time zone:** Offset between Greenwich (GMT)- and the local time (for Germany 1 h, for example). The value is limited between -12 and +14.  
2. **Input field: DLS Mode:** Day light saving. Possible values:  
   - 0 = No automatic summertime/wintertime changeover.  
   - 1 = Timeover from wintertime to summertime on last the Sunday in March, changeover from summertime to wintertime on the last Sunday in October. |

| Task Prio I Interval  | Task, which will be generated by Generate IEC 61850 code:  
1. Input field - entry of the priority,  
2. Input field - entry of the interval in ms. |
| TCP KeepAlive [sec]   | The KeepAlive is to check the connection to the client. |
| User application name | Enter the name of the user application for optimized GOOSE performance.  
The IEC 61850 task will execute in the following order:  
1. GOOSE Subscriber  
2. User application  
3. GOOSE Publisher and MMS reporting  
If this field is empty, the user application (step 2) will not be called by the IEC 61850 task, but by the standard task.  
Two tasks are asynchronous and might lead to slower performance.  
博士学位 Chapter 6.3.4.2.2.6.7 “GOOSE performance optimization” on page 1705 |

The server is the root object for creating the IEC 61850 data model consisting of ‘LogicalDevice’, logical nodes, data objects and data attributes.

**Add LogicalDevice**  
Add the “LogicalDevice” by selecting it in the left window and inserting it below the server with the arrow button “>”.

Following properties of the logical device can be configured.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Name</td>
<td>Name of the LogicalDevice</td>
</tr>
</tbody>
</table>
Two standard logical nodes ("LLN0" and "LPHD1") are added automatically. Further logical nodes (e.g. "XSWI") can be added by selecting them from the left window and inserting them below the logical device with the arrow button "->".

Following properties of the logical device can be configured.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node prefix</td>
<td>Optional prefix for the selected LNC instance. The prefix is put in front of the LN name in the server tree.</td>
</tr>
<tr>
<td>Logical Node index</td>
<td>Index to differentiate between several instances of the same logical node type. It is assigned automatically with increasing order, starting with 1. If it is changed manually, duplicates should be avoided.</td>
</tr>
</tbody>
</table>

Logical nodes are instantiated with their mandatory data objects "DO". Optional data objects can be added by selecting them in the left window and inserting them below the logical node with the button "->".

Data objects have no properties to be configured.
Data objects are instantiated with their mandatory data attributes "DA". Optional data attributes can be added by selecting them in the left window and inserting them below the data object with the button ">".

Data attributes can be mapped to variables in the IEC 61131 application by the following properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitoring Var I Initvalue</td>
<td>Name of the monitoring variable, which can be written by AC500 and read by an IEC 61850 client, for example the status stVal of a switch position / An initial value can be defined optionally.</td>
</tr>
<tr>
<td>Control Variable</td>
<td>Name of the control variable which can be written from an IEC 61850 client and read by AC500, for example a switch command Oper.ctlVal.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Autom. declare</td>
<td>By activating the Autom. declare checkbox the variable is declared by the IEC 61850 configurator and stored in the IEC61850.Generated_GVL (of the IEC61850 generated POUs folder) after generate code of the IEC 61850 server. If it is not declared automatically, the variable must be declared by the user. Instead, an IO point can be chosen as monitoring or control variable.</td>
</tr>
<tr>
<td>Trigger options</td>
<td>With the trigger options you select the events which might trigger a report. The selected trigger option is displayed in the status bar. Chapter 6.3.4.2.2.5.4 “Status bar” on page 1686</td>
</tr>
</tbody>
</table>

**Monitoring - and control direction, reading and writing**

It may be the case that the IEC 61850 client will read the monitoring variable of an attribute and will write the control variable of the same attribute. Monitoring variable and control variable must not be the same CODESYS variable.

In monitoring direction, the data flow takes place from the “IEC 61850 Server” to the connected IEC 61850 client to read the CODESYS monitoring variable, for example MMS report service.

In control direction the data flow takes place from the connected IEC 61850 client to the “IEC 61850 Server” to write the CODESYS control variable, for example operate service.

The following figure shows an example where the “ctrlModel” can be changed from server side (Monitoring variable “control_model_mon” with initial value 1) or from client side (Control variable “control_model_ctrl”).
In the status bar of the IEC 61850 editor you find object-specific detail information about the selected object.

Only the information “Name” is displayed for the server and the logical device.
<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the selected LN instance.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the selected LN instance.</td>
</tr>
<tr>
<td>Group</td>
<td>Associated group of the LN instance.</td>
</tr>
<tr>
<td></td>
<td>Examples:</td>
</tr>
<tr>
<td></td>
<td>[Axxx]-Automatic</td>
</tr>
<tr>
<td></td>
<td>[Cxxx]-Control</td>
</tr>
<tr>
<td></td>
<td>[Gxxxx]-Generic</td>
</tr>
<tr>
<td></td>
<td>...</td>
</tr>
<tr>
<td>Prefix</td>
<td>Prefix of the LNC instance, entered by the user.</td>
</tr>
</tbody>
</table>

Object information: Common Data Class Object (CDC Object)

<table>
<thead>
<tr>
<th>Name</th>
<th>Beschreibung</th>
<th>Option</th>
<th>CDC</th>
<th>Instnr</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beh</td>
<td>Behaviour</td>
<td>M</td>
<td>INS</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the attribute.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the selected CDC instance.</td>
</tr>
<tr>
<td>Option</td>
<td>Option of the selected CDC instance.</td>
</tr>
<tr>
<td></td>
<td>M = Mandatory</td>
</tr>
<tr>
<td></td>
<td>O = Optional</td>
</tr>
<tr>
<td>CDC</td>
<td>Type of the selected CDC instance.</td>
</tr>
<tr>
<td>Instno</td>
<td>Instance number of the CDC instance.</td>
</tr>
<tr>
<td></td>
<td>Only optional CDCs can have instance numbers. If there is only one optional</td>
</tr>
<tr>
<td></td>
<td>CDC, it has no instance number. Otherwise 1 to n.</td>
</tr>
</tbody>
</table>

Objects with the mandatory options are inserted automatically when adding the logical device.

Object information: Attribute (DA)

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the attribute.</td>
</tr>
<tr>
<td>FC</td>
<td>Functional constraint of the selected attribute.</td>
</tr>
<tr>
<td>Option</td>
<td>Option of the selected attribute:</td>
</tr>
<tr>
<td></td>
<td>M = Mandatory</td>
</tr>
<tr>
<td></td>
<td>O = Optional</td>
</tr>
<tr>
<td>Type</td>
<td>Data type of the attribute.</td>
</tr>
<tr>
<td>Status</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Trigger option</td>
<td>Trigger option of the attribute.</td>
</tr>
<tr>
<td></td>
<td>dchg = data change</td>
</tr>
<tr>
<td></td>
<td>dupd = data update</td>
</tr>
<tr>
<td></td>
<td>qchg = quality change</td>
</tr>
<tr>
<td></td>
<td>&lt;empty&gt; = no trigger option</td>
</tr>
<tr>
<td>Value</td>
<td>Associated variable</td>
</tr>
<tr>
<td>Writeable</td>
<td>Access for the attribute.</td>
</tr>
<tr>
<td></td>
<td>R = Read</td>
</tr>
<tr>
<td></td>
<td>W = Write</td>
</tr>
<tr>
<td></td>
<td>RW = Read and write</td>
</tr>
</tbody>
</table>

**DataSet**

In the tab of the IEC 61850 editor it is possible to create and delete data sets, assign data attributes (DA) and data objects (DO) to a data set and delete existing assignments.

“DataSet” tab with “LLN0.DS1” data set consisting of data objects and data attributes.

**Structure of the tab**

The left window displays the created “IEC 61850 Server”.

- Chapter 6.3.4.2.2.5.2 “Configuration of IEC 61850 server with logical nodes” on page 1680

The right part is for creating, editing and deleting of data sets. In the upper right window data sets are listed. In the lower right window, the attributes and data objects can be inserted by selecting them in the left window and inserting them by the button “>”.

The maximum number of data sets is given in Limits/technical data.

- Chapter 6.3.4.2.2.3 “Limits/technical data” on page 1678

The status bar at the bottom shows more details of the chosen items.
The order of the attributes of a data set is important for the receiving and the sending of GOOSE messages. Type and order of the entries from sender and recipient must be identical for GOOSE communication.

Chapter 6.3.4.2.2.5.9 “GOOSE Subscriber” on page 1694

Buttons:
- **[New]**: Create a new data set. This is displayed in the “DataSets” section and is named “LLN0.DataSet_Suffix”. The suffix is incremented beginning with 0 (1: Data set: LLN0.DataSet_0 ...)
- **[Delete]**: Delete a data set: Select the desired data set in the “DataSets” section and activate the [Delete] button.
- **[>]**: Assign an attribute or a data object to the selected data set. First select the data set in the upper right window then select the attribute or the data object in the left window and activate the “>” button.
- **[<]**: Deletes an element from a data set. First select the data set in the upper right window then select the attribute or the data object in the lower right window and activate the “<” button.
- **↑**: Moves the selected entry one row up.
- **↓**: Moves the selected entry one row down.

Input field:
- **“Name: ”**: Name of the data set can be edited. The name gets the prefix “LLN0.”.

Report (MMS)

In this tab of the IEC 61850 editor it is possible to create and parameterize buffered und unbuffered reports. A report transports the data, that are assigned to it, to the connected client in the event of a trigger. Each report a data set must be assigned to.

In the left part the created report control blocks (RCB) are listed. The following buttons are available:
- **[New]**: Create a new report control block.
- **[Delete]**: Delete the selected report control block.

In the middle part you make general settings for the reporting configuration.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Buffersize</td>
<td>Buffer size of buffered reports (in bytes).</td>
</tr>
<tr>
<td>Name</td>
<td>Unique report block name within the logical node.</td>
</tr>
</tbody>
</table>
### Setting Description

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Description of the report block.</td>
</tr>
<tr>
<td>Integrity Period [ms]</td>
<td>Stealthy general interrogation. After this time the referenced data set will be actuated. Time (ms) between two messages. The messages are transferred cyclic, independent from other events.</td>
</tr>
<tr>
<td>Buffered</td>
<td>Enable / disable the report buffering. A buffered report stores the data, even if there's no connection to the client. In the case of an unbuffered report, the messages will get lost, if there is no connection to the client.</td>
</tr>
<tr>
<td>Buffer Time [ms]</td>
<td>Buffer time is the amount of time that the server waits to transfer a report after a given event occurs. Events that occur during this time period are collected and then transferred as a batch. If the buffer time is 0, the telegram will be sent immediately. For example, if the buffer time 10s the telegram will be sent after this time period or when the value changes the second time.</td>
</tr>
<tr>
<td>Config Revision</td>
<td>Versioning is used to identify whether or not a member was deleted from a data set or whether member order has changed. Such changes cause values to not be transferred, or cause values to be in a different location within the report. Such an event is communicated to the client with a new version number. Since all data sets are firmly defined, this identifier does not apply to the solution described here.</td>
</tr>
<tr>
<td>DataSet</td>
<td>Data set reference.</td>
</tr>
</tbody>
</table>

The right part is for the setting of the following options:

- **“General options”**: Control of the reporting behavior. An activated checkbox means, that the information is transferred by the message.
- **“Buffered specific options”**: can be activated, if the option “Buffered:” is activated.
- **“Trigger options”**: Determining of attributes to select the events which may trigger a message.

If the checkbox is activated the information will be transferred by the message.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send Config Revision</td>
<td>“Config Revision” information.</td>
</tr>
<tr>
<td>Send Data Reference</td>
<td>Enable/disable to transfer the complete reference information, for example: LogicalDevice/GGIO1.ST.Mod.ctlNum</td>
</tr>
<tr>
<td>Send DataSet name</td>
<td>Enable/disable to transfer the data set name.</td>
</tr>
<tr>
<td>Send Reason for Inclusion</td>
<td>Enable/disable to transfer the reason of transmission for each attribute.</td>
</tr>
<tr>
<td>Send Sequence Number</td>
<td>Enable/disable to transfer a unique sequence number for each message.</td>
</tr>
<tr>
<td>Send Time Stamp</td>
<td>Enable/disable to transfer the timestamp of transmission for each message.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send Entry ID</td>
<td>Enable/disable to transfer the entry ID.</td>
</tr>
<tr>
<td>Send Buffer overflow</td>
<td>Enable/disable to transfer the message if a buffer overflow occurs.</td>
</tr>
</tbody>
</table>
### Setting

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Change</td>
<td>Enable/disable to trigger the report if a “Data Change” event occurred.</td>
</tr>
<tr>
<td>Data Update</td>
<td>Enable/disable to trigger the report if a “Data Update” event of an attribute occurred.</td>
</tr>
<tr>
<td>Quality Chance</td>
<td>Enable/disable to trigger the report if a “Quality Change” event of an attribute occurred.</td>
</tr>
<tr>
<td>Integrity</td>
<td>Enable/disable the cyclic transmission of the report independent of any data changes (Stealthy general interrogation). The time period has to be defined in the “Integrity Period” general setting.</td>
</tr>
</tbody>
</table>

### General Interrogation

1. Activate the [New] button.
2. Select the desired data set from the “DataSet” selection list.

### GOOSE Publisher

In the “GOOSE Publisher” tab of the IEC 61850 editor you create, edit and delete GOOSE messages. If a value changes in the selected data set, a GOOSE message is sent.

**NOTICE!**

The order of the attributes of a “DataSet” is important for the receiving and the sending of GOOSE messages. Type and order of the entries from sender and recipient must be identical for GOOSE communication.

**NOTICE!**

To receive a GOOSE message from an IED, sender and recipient must have the identical settings in the following input fields:
- “APPID”
- “GOOSE ID”
- “DataSet” structure (with regard to order and data type of the attributes).
After the data set is sent, it is sent again after a time interval of 500 ms. The repeat time then doubles and the data set is sent again. The data set is sent repeatedly until the value set in the “Repeat Time” input field is reached. The data set is then sent again at the “Repeat Time” interval.

Sections of the tab:

List of the GOOSE control blocks (GCB) in the left part.

A GOOSE control block is a GOOSE message.

Buttons:

- **[New]**: Create a new GOOSE control block.
- **[Delete]**: Delete the selected GOOSE control block.

General settings in the top right part:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the GOOSE control block, editable.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the GOOSE control block.</td>
</tr>
<tr>
<td>GOOSE ID</td>
<td>Unique character string of the GOOSE control block, editable.</td>
</tr>
<tr>
<td>DataSet</td>
<td>Data set sent as a GOOSE message.</td>
</tr>
<tr>
<td>MAC</td>
<td>Multicast addressing &lt;br&gt; Multicast addressing is used to send GOOSE messages. Addressing allows an entire group of devices to exchange data with each other. &lt;br&gt; Requirement: Unique address allocation of the different device groups. &lt;br&gt; Valid range of values: 01-0C-CD-01-00-00....01-0C-CD-01-01-FF</td>
</tr>
<tr>
<td>APPID</td>
<td>Application-ID &lt;br&gt; Number for the system-wide unique identification of a GOOSE control block. To exchange GOOSE telegrams, this number must be identical for sender and recipient. &lt;br&gt; Valid range of values: 0 ... 4095</td>
</tr>
<tr>
<td>Source Address (MAC)</td>
<td>[Browse] button: Looks for an Ethernet port in the network. &lt;br&gt; Requirement - an existing network path to the PLC.</td>
</tr>
</tbody>
</table>

GOOSE Publisher settings in the middle right part:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Needs Commissioning</td>
<td>Indicates whether the control block must be checked. &lt;br&gt; Value is provided from the configurator. Usage of the flag is customer-specific.</td>
</tr>
<tr>
<td>DataSet Config Revision</td>
<td>Integer value with the version of the GOOSE control block.</td>
</tr>
<tr>
<td>Max. Time [ms]</td>
<td>“timeAllowedToLive” = 2 * resend-time. &lt;br&gt; “timeAllowedToLive”&lt;sup&gt;*&lt;/sup&gt; = 2 * resend-time. &lt;br&gt; ⇨ Chapter 6.3.4.2.6.6 “Resend of GOOSE messages” on page 1704</td>
</tr>
<tr>
<td>Min. Time [ms]</td>
<td>Resend-time of first package after change of values. “timeAllowedToLive”&lt;sup&gt;*&lt;/sup&gt; = 2 * resend-time, This value should be greater than the cycle time of the IEC61850 task. &lt;br&gt; ⇨ Chapter 6.3.4.2.6.6 “Resend of GOOSE messages” on page 1704</td>
</tr>
</tbody>
</table>
Setting | Description
--- | ---
VLAN | 'Virtual Local Area Network'
Logical subnet within a physical network. Multicast messages can be passed through and filtered. The configuration is done in managed Ethernet switches.
If the “VLAN” checkbox is activated, values can be entered into the “VLAN-ID” and “VLAN-Priority” input fields, concerning the passed through of messages via switches.

VLAN-ID | A value of 0 is a non-configured “VLAN” in which the switch performs no filtering. This value is recommended when no logical network should be set up.
Valid range of values: 0 … 4095.

VLAN-Priority | Messages within a managed Ethernet switch can be forwarded depending on the priority.
Valid range of values: 0 … 7.
Default value for GOOSE: 4.

Content of the data set assigned to the GOOSE control block in the bottom part.
1. Activate the [New] button.
2. Select the desired data set from the “DataSet” selection list.

Export Server

After configuration of the “IEC 61850 Server” including logical nodes, data sets, MMS reports and GOOSE control blocks the configured IED can be exported as .cid file, by the menu entry “IEC61850 ➔ Export Server”.

You can choose a folder and a filename, for example: IEC61850_ExampleA_AC500.cid. This file is based on XML and can be opened in any text editor:
The extension "*.cid" (Configured IED Description) contains the configuration of a concrete IED with instantiated logical nodes (line 41, 61 and 62), data sets (line 42) services (line 47) and communication addresses (line 8-17).

This file can be imported in other IEC 61850 engineering tools, either system configurator or IED configurator for other IEDs.

The IP address information (line 9-11) is empty, since in AC500 the IP address configuration is decoupled; it is done in the "IP-Configuration" tool, possibly in a later step.

If the correct IP address of the AC500 IED is required by the other IEC 61850 engineering tool, it must be updated in the "*.cid" file, which can be done using any text editor:

```
Chapter 6.3.2.9.2 “Configuration of the IP settings with the IP configuration tool” on page 1506
```

GOOSE Subscriber

In the tab “GOOSE Subscriber” of the IEC 61850 editor you make settings for the receiving of GOOSE messages.
NOTICE!
The order of the attributes of a “DataSet” is important for the receiving and the sending of GOOSE messages. Type and order of the entries from sender and recipient must be identical for GOOSE communication.

NOTICE!
To receive a GOOSE message from an IED, sender and recipient must have the identical settings in the following input fields:
- “APPID”
- “GOOSE ID”
- “DataSet” structure (with regard to order and data type of the attributes).

Sections of this tab:
List of the GOOSE control blocks in the left part.
Buttons:
- [New]: Create a new GOOSE control block.
- [Delete]: Delete the selected GOOSE control block.
- [Import]: Import a GOOSE control block in the SCL format.

General settings in the top middle part:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the GOOSE control block, editable.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the GOOSE control block.</td>
</tr>
<tr>
<td>GOOSE ID</td>
<td>Unique character string of the GOOSE control block, editable.</td>
</tr>
<tr>
<td>Dataset</td>
<td>Data set sent as a GOOSE message.</td>
</tr>
<tr>
<td>MAC</td>
<td>Multicast addressing</td>
</tr>
<tr>
<td></td>
<td>Multicast addressing is used to send GOOSE messages. Addressing allows an</td>
</tr>
<tr>
<td></td>
<td>entire group of devices to exchange data with each other.</td>
</tr>
<tr>
<td></td>
<td>Requirement: Unique address allocation of the different device groups.</td>
</tr>
<tr>
<td></td>
<td>Valid range of values: 01-0C-CD-01-00-00....01-0C-CD-01-01-FF</td>
</tr>
</tbody>
</table>
### Setting Description

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>APPID</td>
<td>Application-ID Number for the system-wide unique identification of a GOOSE control block. To exchange GOOSE telegrams, this number must be identical for sender and recipient. Valid range of values: 0 ... 4095</td>
</tr>
<tr>
<td>Source Address (MAC)</td>
<td>[Browse...] button: Looks for an Ethernet port in the network. Requirement - an existing network path to the PLC.</td>
</tr>
</tbody>
</table>

List to assign GOOSE messages to global variables in the bottom right part.

All attributes within the selected data set are listed in this list. You can assign incoming GOOSE messages to global CODESYS variables. For this, select the desired attribute in the list and edit the name of a global variable in the "Varname" column. If you edit a new variable name a global variable will be created, if you activate the "Use default name" checkbox, a variable name is generated automatically. This variable will be written by incoming GOOSE messages.

The variables will be stored "IEC61850_Generated_GVL" (of the "IEC61850 Generated POUs" folder) after generating the code of the "IEC 61850 Server".

- Chapter 6.3.4.2.2.8.1 “Generate code” on page 1712

### Generate IEC61850 code

When all IEC 61850 related configuration is done according to the previous chapters, it must be translated into IEC 61131 code using the menu entry "IEC61850 ➔ Generate code".

After a few seconds (depending on the IEC 61850 server size), the following IEC 61131 code is generated below "Application" in the "Devices" tree:

- Folder "IEC61850 Generated POUs", containing IEC 61131 code for all IEC 61850 functionality including the global variable list "IEC61850_Generated_GVL", which contains auto generated variables which must be connected to the application "PLC_PRG (PRG)"
- Task "IEC61850Task1", calling the code in a task which is configured in the configuration window of IEC 61850 Server object.

- Chapter 6.3.4.2.2.5.2 “Configuration of IEC 61850 server with logical nodes” on page 1680
Generate the application

Finally, the application (typically “PLC_PRG (PRG)”) including the logical node functionality needs to be configured. The IEC 61850 generated code only contains the logical node interfaces = control and monitoring values.

The “PLC_PRG (PRG)” application consumes the control values which were received by the “IEC 61850 Server” (e.g. Operate) or GOOSE Subscriber and calculates monitoring values which are then sent by the “IEC 61850 Server” (e.g. MMS Report) or GOOSE Publisher.

The following figure shows a simple example of a switch simulation in “PLC_PRG (PRG)”, based on the global variables which were mapped to “XSWI.Pos”.

Chapter 6.3.4.2.5.2 “Configuration of IEC 61850 server with logical nodes” on page 1680

The simulated switch is controlled by the control variable “oper_var_ctrl” and the resulting status (_ON or _OFF) is written to the monitoring variable “status_var_mon”.

Real applications will contain more logic and connections to physical inputs or outputs.

Runtime and diagnosis

General

After the engineering workflow is completed, the resulting code (“IEC 61850 generated POU’s” and “PLC_PRG (PRG)”) can be compiled and downloaded to the CPU.

In the following, the runtime behavior of operate, reporting and GOOSE, as well as possible diagnostic and performance optimizations are described.

Operate and reporting

The following explanation is based on the example A, which was configured according to engineering workflow as MMS server with a switch simulation. The project file of this example can be found in the example folder of Automation Builder - Example A.
Example projects for the libraries can be found in the example folder: “Help ➔ Project examples” in the Automation Builder menu.

Prerequisite: Install the related library package with Automation Builder Installation Manager - [Modify].

First step is to create a physical Ethernet connection between AC500 IED and operator IED = MMS client and configure IP addresses in a common IP address range. Then, both devices can be commissioned.

**AC500 IED**

1. Configure AC500 according to engineering workflow as MMS server with a switch simulation or load the example project “IEC61850_ExampleA_ABxxx.project”.
2. Download program to AC500 and set it to RUN.

   Now the IEC 61850 server is running and ready to operate.

**Operator IED**

Any IEC 61850 MMS client can be used. In this example the Omicron tool “IEDScout” is used. Following figure shows the menu bar.

1. Click on menu button [Discover IED] and enter IP address of AC500.
   “IEDScout” will find the AC500 IED through Ethernet and read its configuration dynamically.
2. Click on the menu button [Open SCL] and browse for the .cid file which was exported in chapter Export Server, for example “IEC61850_ExampleA_AC500_withIpcid”.
   Chapter 6.3.4.2.5.8 “Export Server “ on page 1693

The browser opens and shows the active connection to the AC500, indicated by the green checkmark.
1. Browse to “DataModel ➔ Logical Device ➔ XSW11”

2. Ensure that “Pos.ctrlModel” is set to “direct-with-normal-security”. Otherwise, set the value to “direct-with-normal-security” by clicking the menu button [Write].

3. Click on “XSW11 ➔ .Pos”.

4. Click the menu button [Control] to open the “Control” dialog.

5. Choose the “Value” (false or true) and press the button [Operate] to send this value to AC500 IED.

In AC500 online mode, the control and status variables can be monitored in “IEC61850_Generated_GVL” as well as in the “PLC_PRG” containing the switch simulation.
The Operator IED (Omicron IED Scout), can subscribe (menu button [Enable]) the MMS report "SwitchReport", which contains "XSW11.Pos" including data attributes status ("stVal"), quality ("q") and timestamp ("t").
**MMS diagnosis**

The IEC 61850 generated POUs – “Logical Nodes” contain more details and can be used for diagnosis in online mode. For example, the following property shows, that the MMS report “SwitchReport” was enabled by one MMS client: “IEC61850_LLN0.fbSwitchReport.fbSwitchReport[1].rptEna”.

**GOOSE**

The following explanation is based on the example B, which was configured according to engineering workflow with GOOSE Publisher and Subscriber. The project file of this example can be found in the example folder of Automation Builder: Example B.

First step is to create a physical Ethernet connection between AC500 IED and another IED. Then, both devices can be commissioned.

**AC500 IED**

1. Configure AC500 according to engineering workflow with GOOSE Publisher and GOOSE Subscriber or load the example project “IEC61850_ExampleB1_ABxxx.project”.
2. Ensure that the source MAC address for GOOSE Publisher and GOOSE Subscriber are set correctly.
   - Chapter 6.3.4.2.2.5.7 “GOOSE Publisher” on page 1691
   - Chapter 6.3.4.2.2.5.9 “GOOSE Subscriber” on page 1694
3. After a change of MAC address it is required to generate IEC61850 code again.
   - Chapter 6.3.4.2.2.5.10 “Generate IEC61850 code” on page 1696
4. Download program to AC500 and set it to RUN.  
   ⇒ Now the IEC 61850 server with GOOSE Publisher and Subscriber is running and ready to operate.

Another IED
1. Configure any other IED as bay IED with GOOSE Publisher and GOOSE Subscriber or load the example project “IEC61850_ExampleB2_ABxxx.project”.
2. Set the source MAC addresses correctly.
3. Generate the IEC 61850 code.
4. Download to a second AC500 CPU.

The ping-pong between the two IEDs can be monitored by opening the 2 projects with 2 Automation Builder instances.

GOOSE diagnosis and troubleshooting

The IEC 61850 library has an object “IEC61850_GooseManager” with several variables, which can be accessed for diagnosis of the GOOSE manager. Example B1 contains a “GooseDiagnosis (PRG)”, showing the relevant diagnosis variables.
● “IEC61850_GooseManager.iAdapterCnt”
Number of the Ethernet adapters used for GOOSE Publisher and GOOSE Subscriber, should be at least 1.

● “IEC61850_GooseManager.wRxCounter”
Counter for received GOOSE messages. Should increase continuously, when other IEDs are sending GOOSE, otherwise:
  – Check if the ‘Source Address (MAC)’ is configured correctly in the GOOSE Subscriber.
  – Check with Wireshark if there are GOOSE messages in the network of the configured adapter.

● “IEC61850_GooseManager.wRxCounterSubscribed”
Counter for received GOOSE messages, which are subscribed. Should increase continuously, when other IEDs are sending GOOSE and same GOOSE messages are subscribed in AC500. If not:
  – Check if “IEC61850_GooseManager.wSubscriberCnt” is > 0.
  – Check configuration in GOOSE Subscriber
  – Check further diagnosis properties in “prgIEC61850Subscriber”.

● “IEC61850_GooseManager.wMaxLoopCnt”
Maximum number of received Ethernet packages in one cycle. Maximum value is 50. If the maximum value is reached, reset it by setting “IEC61850_GooseManager.xResetIndications” to TRUE for one cycle. If “wMaxLoopCnt” immediately reaches again the maximum value, the IEC 61850 cycle time is too slow for the high network traffic and GOOSE messages might be lost. Workaround is to reduce the IEC 61850 cycle time to make the GOOSE Subscriber faster.

● “IEC61850_GooseManager.wTxCounter”
Counter for transmitted GOOSE messages. Should increase continuously when GOOSE Publisher is configured. If not:
  – Check GOOSE Publisher.
  – Check “IEC61850_GooseManager.sStatus”.

● “IEC61850_GooseManager.sStatus”
Contains error status of the GOOSE manager and can have the following values:
  – ’.’: empty: → OK.
  – Sending of GOOSE messages failed! Result: 20 (or other results). → Check if the ‘Source Address (MAC)’ is configured correctly in GOOSE Publisher.
  – GOOSE Publisher Eth. frame length ≥ 1500 bytes, reduce DO/DAs in data set. → Reduce the number of data objects and/or data attributes in a data set.
For the GOOSE Subscriber there is an additional possibility for diagnosis. The "prgIEC61850Subscriber" has an array "afbSubscriber", containing one entry for each subscription.

Following properties should be checked in case of problems:

- "dtLastAction" and "wRxCounter":
  Should increase continuously, when other IEDs are sending GOOSE and same GOOSE messages are subscribed in this subscriber.

- "sStatus":
  Should show "GOOSE Block receive <GOOSE ID> successfull".

- "xErrorTimeAllowedToLive":
  Should always be "FALSE". If not, a GOOSE message was received only after the "timeAllowedtoLive" (as indicated in the previous GOOSE message) expired.
  - Decrease cycle time of the IEC 61850 task.
  - Chapter 6.3.4.2.5.2 “Configuration of IEC 61850 server with logical nodes” on page 1680
  - Check Ethernet connection between GOOSE Publisher and GOOSE Subscriber.
  - Check in Wireshark if GOOSE Publisher is sending next packages fast enough. Resend of GOOSE messages shows a correct example where "timeAllowedtoLive" is always double of the resend time, so that the subscriber has enough time to receive it.

Resend of GOOSE messages

Resending of GOOSE is done according to the IEC 61580 specification.

Chapter 6.3.4.2.1 “Introduction to IEC 61850” on page 1671

In example B as described in the previous chapters, there are not resends because the ping-pong values are changing quickly before the configured GOOSE “Publish Min. Time” has expired.

The resend gets visible in Wireshark when the quick value changing is stopped (e.g. by stopping the other IED in the ping-pong example B). The following figure shows an AC500 GOOSE Publisher with max. time = 4000 ms, min. time = 20 ms and configured IEC 61850 task cycle time = 5 ms.
Two phases are visible in the Wireshark screenshot.

1. Slow retransmission in stable conditions (no event for a long time) above the blue line. When the value does not change (column “integer” = pong value = 2):
   - The GOOSE message is resent continuously and slowly.
     - “timeAllowedtoLive” is 4000 ms (= max. time).
     - Message is retransmitted every 2000 ms (half of “timeAllowedtoLive” according to IEC61850-8-1).
     - “sqNum” is increasing, “stNum” is not changing.

2. Change of value and fast retransmission. When the value changes (column integer = pong value was forced from 2 to 3):
   - A new package (“stNum” increased, “sqNum” = 0) is sent immediately (*), see blue line.
     - Same package is resent continuously, starting with a high frequency.
     - The resend time is starting at 20 ms (= configured min. time) and doubled with every resend until it has reached half of the max. time to go back to slow retransmission.
     - The “timeAllowedtoLive” is always double of the next resend time (*).

---

The configured GOOSE min. time should always be higher than the configured IEC 61850 task cycle time!

(*) Sending GOOSE messages is executed in the IEC 61850 task and therefore can be delayed by the configured task cycle time (worst case).

---

GOOSE performance optimization

The automatic generated IEC 61850 task is optimized in such a way, that GOOSE Publisher and GOOSE Subscriber is executed the same task. Anyhow, the example B needs 60 ms for one complete ping-pong procedure. This is plausible and can be explained with the following figure.
Although the application task ("PLC_PRG") could increase the ping or pong every 10 ms, it must wait for the IEC 61850 task (20 ms cycle time) to subscribe or publish the new data from or to the other PLC. In consequence it takes 70-10 = 60 ms for one complete ping-pong.

**Optimization steps**

1. Reduce the cycle time of the IEC 61850 task to 10 ms as well. This would increase the performance, but both tasks are still asynchronous and have to wait for each other.

2. Merge both tasks and by that optimize the execution order according to the IPO principle.
   - Input: GOOSE Subscriber
   - Process: In this example - Increase ping or pong.
   - Output: GOOSE Publisher

This behavior can be achieved by the following configuration in the IEC 61850 editor.
1. Set “Task Prio I Interval” of IEC 61850 task to 10 ms.

2. Enter the “User application name” (was empty before), here: “PLC_PRG”.

3. Since now the “PLC_PRG” is called by the IEC 61850 task, the “normal” task calling the “PLC_PRG” must be deleted (red cross in the figure above).

4. Do the same procedure for example B1.

With these settings the total ping-pong roundtrip time is reduced to 10 ms, which can be observed in Wireshark.

The time format in Wireshark was set to “Seconds since the previous displayed packet”. In this log the ping takes ~ 4.5 ms, the pong takes ~ 5.5 ms ➔ ping-pong = 10 ms.

Depending on the CPU type and the size of the application, the performance can be further improved by reducing the IEC 61850 task interval to less than 10 ms.

**Advanced features**

**Time sync**

If a (S)NTP server (e. g. Meinberg clock) is available in the network, the AC500 should be configured as (S)NTP client in order to receive the correct time information, which is set in the MMS and GOOSE reports along with the correct status bits. This is done in two steps:

1. **Configuration**
   - **Protocol Configuration**
     - Configuration in Automation Builder for AC500 V3 products > Protocols and special servers

2. **Programming**
   - Set the AC500 as (S)NTP client to receive the correct time information.
1. A (S)NTP client node must be added below “Protocols” and the IP address of the (S)NTP server must be entered (192.168.84.250 in this example).

2. Set the time quality bit “ClockNotSynchronized” of the IEC 61850 time correctly. Therefore, the bit must be read from the “fbPmSntpInfo1.SourceInfo1.SrcState” and written to the IEC 61850 variable “IEC61850_SyncClockOnRTC.xClockNotSynchronized”.

Example A contains a program “prgSNTP”, which reads and updates this time quality bit every 30 seconds.

If the SNTP time is working correctly the “ClockNotSynchronized” is false.

If the SNTP server fails or connection is broken, the “ClockNotSynchronized” is true.
Bulk data engineering

When many logical nodes, related data sets and reports need to be created, there are repeating configuration steps for similar modules. Copy and paste of such modules or working with MS Excel is currently not possible, but there is a way to do bulk data engineering via XML file.

1. Create an IEC 61850 configuration by the engineering workflow steps 1 (logical nodes), 2 (DataSets), 3 (Report (MMS)), 4 (GOOSE Publisher).

2. Export the configuration as XML: “Menu ➔ IEC61850 ➔ Export Server” Save as type XML.

   The exported XML file is not according to SCL, but an AC500 propriety format which contains all configurations done in the IEC 61850 editor.
3. Enhance XML file by copying logical nodes, related data sets and reports.

Ensure that new instances have new and unique IDs.

For example, when duplicating logical node “XSWI1”, the new logical node should be renamed to XSWI2 by modifying the tags “NodeText” and “NodeInstanz”.

This step requires some experience with XML and an understanding how the IEC 61850 logical nodes, data sets and reports are represented and related to each other inside this XML.

4. Import the configuration from the enhanced XML: “Menu → IEC61850 → Import Server”, type XML.

⇒ The existing configuration is overwritten by the enhanced configuration.

5. Perform the remaining engineering workflow steps: 5 (Export Server (as .cid)), 6 (GOOSE Subscriber), 7 (Generate IEC61850 code) and 8 (Generate the application).

Additional or new logical node types

Basic logical nodes are defined in IEC 61850, part 8, further logical nodes are defined in related standards, for example IEC 61400-25.

AC500 was certified according to IEC61850 for a subset of logical nodes which is listed in the MICS document.
Documents can be found in the example folder: “Help ➔ Project examples ➔ PS5602-IEC61850 ➔ Datasheets” in the Automation Builder menu.

**Prerequisite:** Install the related library package with Automation Builder Installation Manager - [Modify].

Anyhow, additional logical nodes can be enabled, and even new logical node types can be defined.

Logical nodes for AC500 are defined in the IEC61850 device description file: “C ➔ ProgramData ➔ AutomationBuilder ➔ AB_Devices_2.5 ➔ 512 ➔ 1020 0001 ➔ 4.0.7.2 ➔ IEC61850DeviceDesc.xml”. This file can be edited in order to enable prepared logical nodes or to create new ones.

In this example the “<enable>” of “CSWI” is set from 0 to 1.

After restart of the Automation Builder, the “CSWI” can be chosen.

Limitation of logical nodes which are not enabled by default:

- Their compliance to IEC 61850-7-4 (Ed1) is not fully tested.
- Common Data Classes ("CDC") are not fully implemented.
They are needed by some (not enabled) logical nodes, for example “MHAI”. Enabling such a logical node leads to compilation errors.

Disable GOOSE Publisher

For some applications it might be useful to disable the GOOSE activity, for example for high availability solutions where one of two parallel CPUs should act in standby and not send GOOSE messages.

Since Automation Builder 2.4.0 and “IEC61850_Server” library 4.0.5.7, the “IEC61850_GooseManager” has a new property “xEnable”. This property is “TRUE” by default, but can be set to “FALSE” if required.

Menu Command sorted by Categorie

Generate code

Symbol:

On activating the “Generate code” command of the “IEC61850” category the code generation is started and the generated IEC 61850 code is stored in the folder “IEC61850 Generated POUs” in the device tree.

☞ Chapter 6.3.4.2.2.5.10 “Generate IEC61850 code” on page 1696
Export Server

This command of the “IEC61850” category exports the current configuration. In the “Safe as” dialog select the format filter:

- XML files: For IEC 61850 format with all specific data, variable mapping, for example.
- SCL-Files: For IEC 61850 format to export data to other IEC 61850 tools.

If you have changed the configuration since the latest code generation, you will be asked whether new code should be generated before export.

Import Server

This command of the “IEC61850” category discards the current configuration and imports a new configuration. In the “Save as” dialog select the format filter:

- XML files: For IEC 61850 format with all specific data, variable mapping, for example.
- SCL Files: For IEC 61850 format to import data from other IEC 61850 tools.

Options

The “Options” command of the “IEC61850” category opens a dialog for the setting of different display options for the IEC 61850 configurator.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Show FC besides data attribute”</td>
<td>Display option, shows functional constraint of attribute as a comment.</td>
</tr>
<tr>
<td>“Show type besides data attribute”</td>
<td>Display option, shows type of attribute as a comment.</td>
</tr>
<tr>
<td>“Show trigger option besides data attribute”</td>
<td>Display option, shows trigger option of attribute as a comment.</td>
</tr>
<tr>
<td>“Show description besides data objects”</td>
<td>Display option, shows description of attribute as a comment.</td>
</tr>
<tr>
<td>“Enable SCL Private block”</td>
<td></td>
</tr>
<tr>
<td>“Select all Data Objects”</td>
<td>Debug-Option: Selection of all data objects (DO).</td>
</tr>
<tr>
<td>“Select all Data Attributes”</td>
<td>Debug-Option: Selection of all data attributes (DA).</td>
</tr>
</tbody>
</table>

6.3.4.3 Modbus protocol

6.3.4.3.1 Modbus on TCP/IP protocol

Modbus TCP/IP is simply the Modbus RTU protocol with a TCP interface running on Ethernet. The Modbus message structure is the application protocol that defines the rules for organizing and interpreting the data independent of the data transmission medium.

A client is a device that actively polls for data from one or more devices. A server device is the passive component that waits for the client to poll for data in order to actually send it.

☞ Chapter 6.8.2.10.1 “Protocol description” on page 4523
6.3.4.3.2 Configuration of Modbus TCP/IP server

Adding a Modbus TCP/IP server to device tree

A “Modbus TCP/IP Server” instance can be added to any specific Ethernet interface/IP address. Each interface supports max. one instance of “Modbus TCP/IP Server”. Other protocols can be added in parallel.

1. Right click on ETH interface and click “Add object”.
   ➞ The window “Add object below: ETH” appears.
2. Select “Modbus TCP/IP Server” and click “Add object”.
   ➞ The node “Modbus_TCP_IP_Server” is added.

Setting the parameters of Modbus_TCP_IP_Server

**Byte Order**
Format/Endianness for the transmission of WORD values (register) within the request/response telegram (default: “Big Endian”).

**Port**
TCP port on which the server listens.

**Startup Behaviour**
This parameter specifies how the server behaves when configuration data is loaded (e.g. on download). Its default value is “Active”. This means the server is immediately addressable after configuration has been performed. In case the server should be activated later on during runtime by means of function block ModTcpServOnOff this parameter value has to be set to “No activity”. Parameter **Behaviour in state inactive** then specifies the server's behaviour during the inactive phase.

**Behaviour in state inactive**
This parameter specifies how the server behaves in inactive state. This state may be set at the very beginning (parameter *Startup Behaviour* = “No activity”) and/or requested during run time calling function block *ModTcpServOnOff*. It's default value is “No activity”. This means the server is not addressable at all (no listening socket on TCP/IP) when it is inactive. Using this setting, any requests by Modbus TCP clients lead to the result *Failed to connect to Server or Timeout*. All other parameter values make the server respond with an exception code to any requests by Modbus TCP clients.

The presentation of the icon next to the “Modbus TCP/IP Server” in the device tree depends on the state of the server:

### Inactive

![Inactive Icon]

### Active

![Active Icon]

**Attention:**

Exception code 9 is actually not defined by Modbus specification. This may cause problems using a different Modbus TCP client than AC500 V3.

### Disable

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable write to %MB from</td>
<td>0</td>
<td>0 ... 65535</td>
<td>Disable write access starting at %MBx</td>
</tr>
<tr>
<td>Disable write to %MB to</td>
<td>0</td>
<td>0 ... 65535</td>
<td>Disable write access up to %MBx</td>
</tr>
<tr>
<td>Disable read from %MB from</td>
<td>0</td>
<td>0 ... 65535</td>
<td>Disable read access starting at %MBx</td>
</tr>
<tr>
<td>Disable read from %MBx to</td>
<td>0</td>
<td>0 ... 65535</td>
<td>Disable read access up to %MBx</td>
</tr>
</tbody>
</table>

It is possible to disable read and/or write access to individual segments. Reading/writing is disabled beginning at the set start address and is valid up to the set end address (inclusive).

*Chapter 6.8.2.10.1 “Protocol description” on page 4523*
6.3.4.3.3 Configuration of Modbus TCP/IP client

Adding a Modbus TCP/IP client to the device tree

The “Modbus_TCP_IP_Client” instance has to be added to the common Ethernet client protocols’ node. This node supports max. one instance of Modbus TCP/IP client. Other protocols can be added in parallel.

1. Right click on the node “Protocols” and click “Add object”.
   ⇨ The window “Add object below: Protocols” appears.
2. Select “Modbus TCP/IP Client” and click “Add object”.
   ⇨ Node “Modbus_TCP_IP_Client” is added.

Depending on a server’s IP address the client sends it’s requests via the Ethernet interfaces available.

☞ Chapter 6.8.2.10.1 “Protocol description” on page 4523

Setting the parameters of Modbus_TCP_IP_Client

Modbus TCP/IP client does not have any parameters.

☞ Chapter 6.8.2.10.1 “Protocol description” on page 4523

6.3.4.4 Modbus on RTU protocol

Protocol description can be found in the chapter for serial interfaces.

☞ Chapter 6.3.2.14.2 “Configuring Modbus RTU on serial interface” on page 1588.
☞ Chapter 6.8.2.9.1 “Protocol description” on page 4506

6.3.4.4 NTP/SNTP protocol

6.3.4.4.1 Introduction of the NTP/SNTP protocol

AC500 V3 support the NTP and the SNTP protocol ((Simple) Network Time Protocol). Compared to SNTP, the NTP protocol achieves higher accuracy in time synchronization, meeting advanced requirements for accuracy and reliability of a PLC solution.

In case a configured NTP protocol cannot be used, SNTP protocol is used as a fallback solution.
The S500 I/O modules do not support the functionality to create and transfer a timestamp with an event directly at the I/O channel. A workaround is using SoE logging (Sequence of Event) for a root-cause analysis. For a better understanding on how events are processed on a AC500 V3 PLC, refer to the application example AC500 sequence of events with V3.

The protocols NTP and SNTP provide the functionality to synchronize the clock of a PLC to an external time source. The application example AC500 V3 - SNTP demonstrates how to synchronize the PLC time with a time server.

A specification of the (S)NTP protocol itself can be found in the document RFC4330.

The following modes are supported by the implementation of the AC500 V3 PLC:

- (S)NTP client
- (S)NTP server
- (S)NTP client and server

The function block PmSntpInfo can be used to read diagnosis information of the protocol. Refer to the documentation of the library ABB_Pm_AC500.lib for further information.

- If a high precision of system time is wanted, use a fully functional NTP server or at least an SNTP server with a high-precision time-source (e.g. DCF-77 receiver). Avoid cascading several levels of (S)NTP server / (S)NTP clients.
- Client requests are normally sent at intervals depending on the frequency tolerance of the client clock and the required accuracy. However, under no conditions requests should be sent at less than one minute intervals (see RFC 4330). Keep that in mind when setting polling-interval of the (S)NTP client, especially if a huge amount of clients use one single server.
- Be sure not to use broadcast or multicast addresses as server or backup-server since current (S)NTP implementation does not support manycast mode.
6.3.4.4.2  (S)NTP client configuration

Implementation of (S)NTP client and (S)NTP server is based on protocol version 4.

For (S)NTP client configuration add a new object “SNTP Client” under “Protocols (Client Protocols)”.

For a PLC only one instance of an (S)NTP client is possible.

The following parameters are available:

Not all parameters are shown in the user interface.

It should not be necessary to change the default values of the other parameters for the most applications.

But there is the possibility to edit them in the generic parameter editor.
### Server 1

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP address</td>
<td>0.0.0.0</td>
<td>Valid IP address</td>
<td>IP address of a server which is used as external time source.</td>
</tr>
<tr>
<td>Minimum polling rate</td>
<td>6</td>
<td>2^6 = 64 s</td>
<td>Specifies the lower limit of the polling rate. It is calculated as power of 2 and has the unit [s]. The actual polling rate is determined by the protocol itself but it will not be lower than this limit.</td>
</tr>
<tr>
<td>Maximum polling rate</td>
<td>10</td>
<td>2^10 = 1024 s</td>
<td>Specifies the upper limit of the polling rate. It is calculated as power of 2 and has the unit [s]. The actual polling rate is determined by the protocol itself but it will not be higher than this limit.</td>
</tr>
</tbody>
</table>

### Server 2

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>FALSE</td>
<td>TRUE or FALSE</td>
<td>Enable server</td>
</tr>
<tr>
<td>IP address</td>
<td>0.0.0.0</td>
<td>Valid IP address</td>
<td>IP address of a server which is used as external time source.</td>
</tr>
<tr>
<td>Minimum polling rate</td>
<td>6</td>
<td>2^6 = 64 s</td>
<td>Specifies the lower limit of the polling rate. It is calculated as power of 2 and has the unit [s]. The actual polling rate is determined by the protocol itself but it will not be lower than this limit.</td>
</tr>
<tr>
<td>Maximum polling rate</td>
<td>10</td>
<td>2^10 = 1024 s</td>
<td>Specifies the upper limit of the polling rate. It is calculated as power of 2 and has the unit [s]. The actual polling rate is determined by the protocol itself but it will not be higher than this limit.</td>
</tr>
</tbody>
</table>

### Time jumps

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>TRUE</td>
<td>TRUE or FALSE</td>
<td>Enables the option 'Time jumps'</td>
</tr>
<tr>
<td>Time jump threshold</td>
<td>1.0 s</td>
<td>0 ... 3.403e+38</td>
<td>Specifies the threshold value for time steps in seconds</td>
</tr>
<tr>
<td>Limit</td>
<td>-1</td>
<td>-1 ... 2147483647</td>
<td>Number of first clock updates after that this option is deactivated, a negative value activates this option permanently.</td>
</tr>
</tbody>
</table>
6.3.4.3 (S)NTP server configuration

Implementation of (S)NTP client and (S)NTP server is based on protocol version 4.

For (S)NTP server configuration add a new object “SNTP Server” under of the available “Ethernet interfaces (ETH1-ETHn)”.

For a PLC only one instance of an (S)NTP server is possible.

The following parameters are available:

Not all parameters are shown in the user interface.
It should not be necessary to change the default values of the other parameters for the most applications.
But there is the possibility to edit them in the generic parameter editor.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>FALSE</td>
<td>TRUE or FALSE</td>
<td>Enables Access Control</td>
</tr>
<tr>
<td>Network address</td>
<td>0.0.0.0</td>
<td>Valid IP address</td>
<td>Network address of allowed clients</td>
</tr>
<tr>
<td>Subnet mask</td>
<td>24</td>
<td>8 ... 32</td>
<td>Subnet mask of the network address</td>
</tr>
</tbody>
</table>

**Local server**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>FALSE</td>
<td>TRUE or FALSE</td>
<td>This option enables the protocol to run as local server. That means without synchronization to an external time source.</td>
</tr>
<tr>
<td>Stratum</td>
<td>10</td>
<td>1 ... 15</td>
<td>Stratum of the server when it is used as local server</td>
</tr>
<tr>
<td>Distance</td>
<td>1 s</td>
<td>0 ... 3.403e+38</td>
<td>Distances in seconds of the server when it is used as local server</td>
</tr>
<tr>
<td>Orphan</td>
<td>FALSE</td>
<td>TRUE or FALSE</td>
<td>Enables or disables the orphan mode</td>
</tr>
</tbody>
</table>

**6.3.4.5 FTP server**

As of SystemFW 3.1.0 the FTP server is listening only on the Ethernet interface, which the protocol is configured on. It is not possible to have an FTP server on both Ethernet interfaces.

AC500 V3 PLCs only support explicit authorization. AC500 V3 PLCs do not support implicit authorization.

1. Under “Ethernet -> ETH [1,2,...]” add a new object and select “FTP Server” from the list.
2. Double-click the “FTP_Server ” item to open FTP server configuration and change the default settings of the parameters, if required.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FTP Server</td>
<td></td>
<td></td>
<td>Do not change the default setting. The parameter specifies the port which is used to connect to the FTP server on the PLC.</td>
</tr>
<tr>
<td>Port</td>
<td>21</td>
<td>21</td>
<td></td>
</tr>
<tr>
<td>Sessions</td>
<td>1</td>
<td>1...4</td>
<td>Enter the max. number of allowed simultaneous and parallel connections to the FTP server. Each session uses one socket. Note: Some FTP clients require several connections to work.</td>
</tr>
</tbody>
</table>

Passwords

- Set each user’s passwords for login. No entry = no password.

- system - System RAM disk
- sdcard - Inserted memory card.
- userdisk - User section of the flash disk.
- flashdisk - Only available with PM5675-2ETH
6.3.4.6 MQTT client protocol

6.3.4.6.1 System technology

NOTICE!
If the MQTT client protocol is enabled, we recommend using the secure (TLS) variant of the MQTT protocol for protection of information.

> Chapter 6.1 “Cyber security” on page 1340

The MQTT protocol is a lightweight communication protocol which is widely used on the internet to connect embedded device to the cloud.

The MQTT (Message Queuing Telemetry Transport) client library allows to integrate an AC500 processor module to act as a client in the MQTT protocol. Thus, it is possible to exchange data between the AC500 and other devices connected to the MQTT network.

In the figure below, there is an MQTT network with one broker (MQTT broker in the middle) and five clients. The figure shows the main functions of MQTT to send and receive data: publish and subscribe. The clients can publish messages with a specific topic to send data (e.g., the temperature of a connected sensor with a timestamp) to the MQTT broker. For example, the client “AC500_1” publishes a message to topic “topic/2”. On the other hand, clients can also subscribe to topics to receive data. For example, the client “Laptop” has subscribed topic “topic/2”. So all messages with the topic “topic/2” which has been published to the MQTT broker will be sent immediately to the client “Laptop”. This creates a message flow from the client “AC500_1” to the laptop.

![MQTT Network Diagram](image)

To realize the MQTT behavior, there are several function blocks implemented in the > Chapter 6.5.11 “MQTT client library” on page 4048.
Table 376: Function blocks overview

<table>
<thead>
<tr>
<th>Function Block</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MqttConnectWithCertBuffer</td>
<td>Every MQTT use case starts with establishing a connection to an MQTT broker. Therefore, a connection structure needs to be created. The connection structure is used to identify the connection for subsequent operations like publish or subscribe. It is possible to establish an SSL connection. Using an SSL connection, at least a certificate for the server is needed. Certificates can be loaded from a buffer (program variable) or a file which is stored on the PLC.</td>
</tr>
<tr>
<td>MqttConnectWithCertFile</td>
<td></td>
</tr>
<tr>
<td>MqttGetReceivedPacket</td>
<td>These function blocks can be used on an established MQTT connection to realize the desired use case.</td>
</tr>
<tr>
<td>MqttPing</td>
<td></td>
</tr>
<tr>
<td>MqttPublish</td>
<td></td>
</tr>
<tr>
<td>MqttSubscribe</td>
<td></td>
</tr>
<tr>
<td>MqttUnsubscribe</td>
<td></td>
</tr>
<tr>
<td>MqttDisconnect</td>
<td>This function block is the end of each use case.</td>
</tr>
</tbody>
</table>

One MQTT send use case could look like this:

- MqttConnectWithCertBuffer(FB)
- MqttPublish(FB)
- MqttPublish(FB)
- MqttDisconnect(FB)*

* It makes sense for several publish messages in a row (e.g. one message per second) not always open a new connection.

One MQTT receive use case could look like this:

- MqttConnectWithCertBuffer(FB)
- MqttSubscribe(FB)
- MqttGetReceivedPacket(FB)
- MqttGetReceivedPacket(FB)
- MqttUnsubscribe(FB)
- MqttDisconnect(FB)

TLS version

The MQTT client uses the TLS version 1.2.

Configuration in Automation Builder

For the MQTT client no configuration is needed.

Configuration in CODESYS

All function blocks have to be called in tasks with cyclically processing.

You can use the function blocks with:

- PLC_PRG with automatic task configuration or manual task configuration.
- One single program or different programs.
- One single task or different tasks.

With different programs assigned to different tasks you can define different cycle times and priorities.
Limitations

- No persistent session. After an interrupted connection, the client needs to subscribe on topics again in case of reconnect.
- One connection (MQTT_CONNECTION) cannot be shared between multiple tasks. Different connections can be used by different tasks or even within the same task.
- Only one FB can operate on a single connection at the same time. Always wait for the FB to complete before calling the next FB. To use two different FB’s in parallel (like publish and receive) it is necessary to have two different connections, otherwise they must be called one after the other.

Hardware

The MQTT protocol requires AC500 devices with integrated Ethernet.

6.3.4.6.2 Application examples

MQTT can be used with an MQTT client library or JSON. Application examples are available for both methods, which demonstrate the practical implementation:

JSON programming

An introduction to programming with JSON is given in the application example JSON programming.

MS Azure cloud

How to set-up a cloud-based condition monitoring system with AC500 and the MS Azure cloud is described in the application example PLC configuration and MS Azure cloud.

Setting up an MQTT message broker

How to set-up a local MQTT message broker is described in the application example PLC configuration and Mosquitto message broker.

Connecting an MQTT message broker

How to connect an MQTT message broker with an AC500 PLC is described in the application example Connection to Mosquitto message broker.

Use cases and how to handle the function blocks of a certain library is described in sample projects. After the respective library has been installed the corresponding sample projects are available in the default path AutomationBuilder Examples. If the default path is inaccessible, click “Help ➔ Project examples” in the Automation Builder menu.

6.3.4.7 AC500 V3 secure protocols

6.3.4.7.1 Introduction

The following protocols can be secured using certificates:

- Communication between Automation Builder and the PLC (e.g. Programming, Monitoring)
- Communication between the PLC’s webserver and visualization clients (browsers)
- Communication between the PLC’s FTP server and FTP clients
- Communication between the OPC UA server and OPC UA clients

As a prerequisite to enable secure communication on one or more protocols, the required certificates need to be present on the PLC.
6.3.4.7.2 Certificate handling

Automation Builder offers a convenient “Security Screen” to manage certificates on connected PLCs.

It can be accessed through the shield icon on the lower right corner of the main window:

Use the tab “Devices” to manage certificates on the PLC.

It offers to:
- show certificates available on the PLC
- import and export certificates
- create new (self-signed) certificates
- trust or untrust certificates
6.3.4.7.3 Configuring secure protocols

Encrypted communication between Automation Builder and the PLC

Via tab “Communication Settings”

Via “Security Screen” in Automation Builder
Ensure the PLC clock is set to the current time and date when using certificates on the PLC. Otherwise the certificate cannot be used to secure a protocol (see also Chapter 6.8.2.3.2 “AC500 battery” on page 4445 and Chapter 6.3.4.4.2 “(S)NTP client configuration” on page 1718).

When trying to log in or when you set the PLC as active path, there will be a one-time pop-up asking you to add the PLC’s certificate to the trusted certificates:

![Certificate pop-up](image)

After trusting the PLC’s certificate, the communication between the Automation Builder and the PLC is now encrypted.

This is shown by additional yellow lines around the communication path on the “Communication Settings” page.

### Secure web server

**NOTICE!**

We recommend configuring an HTTPS connection (encryption with SSL/TLS) between the visualization clients and the web server to protect the system from unwanted access.

- Chapter 6.1 “Cyber security” on page 1340

1. Generate or import a certificate for the web server

   Ensure the PLC clock is set to the current time and date when using certificates on the PLC. Otherwise the certificate cannot be used to secure a protocol (see also Chapter 6.8.2.3.2 “AC500 battery” on page 4445 and Chapter 6.3.4.4.2 “(S)NTP client configuration” on page 1718).
2. Attach a web server node to either ETH1 or ETH2 or both and configure security mode.
   ⇒ This will automatically insert a visualization into the project.
   
The available modes of operation are:
   ● http only
   ● https only
   ● Both (http and https)
   ● Redirect http to https

3. Download and set the PLC to RUN.

4. Connect to the web server using the configured method: https://<your PLC’s IP address>/webvisu.htm.

   In case you are using a self-signed certificate, your browser will show some warnings.
   
   If you are aware of the risks of self-signed certificates, this can be ignored.
   
   ≈ Further information on page 1724

Secure FTP

1. Import a certificate to the PLC for FTP or create a self-signed certificate.

   Ensure the PLC clock is set to the current time and date when using certificates on the PLC. Otherwise the certificate cannot be used to secure a protocol (see also ≈ Chapter 6.8.2.3.2 “AC500 battery” on page 4445 and ≈ Chapter 6.3.4.4.2 “(S)NTP client configuration” on page 1718).

2. Add an FTP server to either ETH1 or ETH2

3. Set the parameter “Security Mode” to either “BOTH” or “FTPS only”.
   ⇒ You can use any FTP client that supports FTPS explicit mode (FTPES).

   In case you are using a self-signed certificate, the FTP client will show some warnings or notice that it does not know the certificate and wants you to check it.
   
   ≈ Further information on page 1724

OPC UA secure

OPC UA uses mutual authentication, which means that both partners must have their own certificate and know the other’s certificate, before being able to establish a connection!
1. Create a new certificate in your OPC UA client.

   Ensure the PLC clock is set to the current time and date when using certificates on the PLC. Otherwise the certificate cannot be used to secure a protocol (see also Chapter 6.8.2.3.2 “AC500 battery” on page 4445 and Chapter 6.3.4.4.2 “(S)NTP client configuration” on page 1718).

2. Import that certificate to the “Trusted Certificates” in your PLC using the “Security Screen”.
3. Import a certificate for the OPC UA server on the PLC or create a self-signed certificate.
4. Export that cert to the PC and provide it as a trusted certificate to your OPC UA client.
5. Reboot the PLC and check that it is in RUN and both certificates are on the PLC (via the “Security Screen”).
6. Add the PLC as OPC UA server in your OPC UA client.
7. Connect to the OPC UA Server.
   ⇒ You can interact normal with the UA server.

---

In case you are using a self-signed certificate, you will see some warning message (depending on the OPC UA client).

If you are aware of the risks of self-signed certificates, this can be ignored.

Further information on page 1724

The certificate warnings will disappear only when using a certificate from a trusted certification authority or a certificate derived from this by an intermediate certification authority (e.g. a company CA).

That process is done via PLCShell command “cert-createcsr”, then getting the file from the PLC via the filebrowser tab in “cert/export” and getting that signing request turned into a real certificate by a certification authority.

Import the certificate generated by your certification authority using the security screen.
6.3.4.8 KNX configurator

6.3.4.8.1 Introduction

Refer to the general description for information about the following tabs of the device editor:

- Chapter 6.4.1.21.2.8.12 “Tab '<device name> I/O Mapping’” on page 2444
- Chapter 6.4.1.21.2.8.13 “Tab '<device name> IEC Objects’” on page 2449
- Chapter 6.4.1.21.2.8.14 “Tab 'Parameters’” on page 2433
- Chapter 6.4.1.21.2.8.19 “Tab ‘Status’” on page 2460
- Chapter 6.4.1.21.2.8.20 “Tab 'Information’” on page 2460

Only in the case of special features is there an additional help page for the specific device editor.

If the "<device name> Parameters" tab is not shown, then select the “Show generic device configuration editors” option in the CODESYS options (“Device Editor” category).

With the KNX editor from CODESYS, you define the communication objects of your building automation. The communication objects are exported and made available to the ETS5 program. Linking the communication objects to the different KNX devices is performed exclusively in the ETS5 program. Therefore, only the objects are generated in CODESYS. The objects are linked to variables from the PLC program by means of “I/O mapping”.

You add an Ethernet adapter below the controller. Then you add the KNX device below the adapter. You can insert only one KNX device per controller.

See also

- Chapter 6.4.1.21.4.14.7 “Dialog 'Options’ - 'Device Editor’” on page 2786

6.3.4.8.2 ETS5 Software - 'DCA' Plug-In

Linking the communication objects of the different KNX devices is performed exclusively in the ETS5 program. To do this, you need the ETS5 software (light or professional version). You also need the KNX product file available from KNX.
Programming steps

1. Create a project in CODESYS.

2. Download the CODESYS project to the controller.
   ⇒ The checksum (CRC) is also downloaded to the controller.

3. Create an export file in CODESYS.
   ⇒ The checksum (CRC) is also saved in the export file.

4. Read the export file into the configuration of ETS5.

5. Parameterize the objects in ETS5.

6. Start the program on the controller.

7. Transfer the KNX configuration to the controller.
   ⇒ The checksum (CRC) is also transferred. The runtime system checks whether or not both checksums match. When they match, the KNX device is identified as functional by the green arrow. If not, then an error is issued in the logger. In case of error, the process data (inputs/outputs) is not updated.

6.3.4.8.3 Tab 'KNX - General'

Object: KNX

The tab in the configurator of the KNX editor shows an overview of all communication objects. The I/Os of the communication objects are applied automatically to the I/O mapping.

Entries can be edited directly in the table or in the “Communication object” dialog. Existing entries can be copied via copy&paste. The next free channel number is used automatically in this case.

<table>
<thead>
<tr>
<th>Table 377: “Address settings”</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Add”</td>
</tr>
<tr>
<td>“Edit”</td>
</tr>
<tr>
<td>“Delete”</td>
</tr>
<tr>
<td>“Export to ETS”</td>
</tr>
<tr>
<td>“Export CSV”</td>
</tr>
<tr>
<td>“Import CSV”</td>
</tr>
<tr>
<td>“Identification”</td>
</tr>
</tbody>
</table>

Dialog 'Communication object'

| “Group Object Number” | Unique channel number. Gaps in the numbering is permitted. If the channel number is already assigned, then an error text is displayed and the “OK” button is disabled. |
| “Type” | Determines whether or not the object in CODESYS is used as “Input” or “Output”. |
| “Data point type” | The data types (DPT = Data Point Types) are specified in the KNX standard. In CODESYS, a selection of the most common data types is available. Only the basic data type can be selected, without units (for example, DPT9.*). |
"Group Object Name" | Any object name. Depending on the data type, a predefined text is automatically added.
---|---
"Group Object Function" | Any function name. Depending on the data type, a predefined text is automatically added.
"Watchdog Timeout" | If a new message has not been received after this elapsed time, then the Timeout status bit is set.

6.3.4.8.4 Tab 'I/O Mapping'

Object: KNX

The I/O channels are generated for each communication object:

Table 378: General I/Os

<table>
<thead>
<tr>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Program LED Status&quot;</td>
<td>This input is set by the ETS program. The signal can be used for identifying a special controller when several controllers are used (for example, by switching a LED). The status is also set when the &quot;Program Button&quot; is set to TRUE. Then the device is in programming mode. As soon as ETS5 has successfully set the physical address, this input switches to FALSE.</td>
</tr>
<tr>
<td>&quot;Program Button&quot;</td>
<td>The &quot;Program Button&quot; is needed for assigning the physical address from ETS5. If the output is set to TRUE, then the device is in programming mode and then ETS5 can assign the address specified there to the device.</td>
</tr>
</tbody>
</table>

Table 379: I/O channels of the communication object

<table>
<thead>
<tr>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Status byte&quot;</td>
<td>Status byte as defined in the KNX stack. This allows you to determine in the application whether or not data has been received. The status can be reset by means of the ResetStatusFlags method.</td>
</tr>
</tbody>
</table>
| "Trigger/Disable Cyclic, send on change" | Depending on the configuration in the ETS program, this output has the following function:  
  ● If at least one of the options "send on difference", "send on change", or "Cyclic sending" is enabled, then the output is defined as deactivation. If it is set to TRUE, then cyclic sending or send on change is stopped.  
  ● If none of the options "send on difference", "send on change", or "Cyclic sending" is enabled, then sending is triggered by a rising edge. |
| "Trigger Output"               |                                                                                                                |
| "Value"                        | Value for the input or outputs – depending on the corresponding communication object.                           |

6.3.4.8.5 ETS5 - Tab 'Parameter'

The parameter page of the ETS5 configuration software is available only after you have imported the CODESYS configuration file. The parameter page is where you define the sending behavior of the values.
6.3.4.9 BACnet-BC

6.3.4.9.1 Introduction to BACnet

BACnet is a standardized data communication protocol for Building Automation and Control networks as defined in the ANSI/ASHRAE standard 135 and ISO 16484-5.

The advantage is interoperability between devices of different vendors.

The BACnet protocol defines services to allow communication between devices. Examples include 'Who is', 'I am', 'Who has' and 'I have' for device and object search and identification, "Read Property" and "Write Property" for the exchange of data, up to more complex services for alarm and event management, scheduling and trending.

<table>
<thead>
<tr>
<th>Table 380: “General Information”</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Default gateway”</td>
</tr>
<tr>
<td>“Telegram rate”</td>
</tr>
<tr>
<td>Note: This restriction should be applied in exceptional cases only, because this causes the reaction times to be extended.</td>
</tr>
<tr>
<td>“Project title”</td>
</tr>
<tr>
<td>“Application date”</td>
</tr>
<tr>
<td>“Identifier”</td>
</tr>
<tr>
<td>“Version”</td>
</tr>
<tr>
<td>“Application state”</td>
</tr>
<tr>
<td>“Description”</td>
</tr>
</tbody>
</table>

The objects are subdivided into groups of ten (1 .. 10, 11 .. 20, 21 .. 30, etc.). A maximum of 1000 communication objects is possible.

<table>
<thead>
<tr>
<th>Table 381: “Object 1 .. 10”</th>
</tr>
</thead>
<tbody>
<tr>
<td>“&lt;type&gt;”</td>
</tr>
<tr>
<td>The parameter cannot be changed.</td>
</tr>
<tr>
<td>“Communication direction”</td>
</tr>
<tr>
<td>“Input (KNX to PLC)”: The value is sent to the CODESYS controller.</td>
</tr>
<tr>
<td>The parameter cannot be changed.</td>
</tr>
<tr>
<td>“Send condition”</td>
</tr>
<tr>
<td>“Send on change”: Sending each time value is changed</td>
</tr>
<tr>
<td>“Send on difference”: Sending when the change in value corresponds to at least the value for “Sending difference”.</td>
</tr>
<tr>
<td>“Sending difference”</td>
</tr>
<tr>
<td>The value is passed when its change is at least this value.</td>
</tr>
<tr>
<td>“Cyclic sending”</td>
</tr>
<tr>
<td>“Enable (seconds)”, “Enable (minutes)”: Cyclic sending – regardless of the “Send condition”.</td>
</tr>
<tr>
<td>“Cycle time [hh:mm:ss]”</td>
</tr>
<tr>
<td>Requirement: “Cyclic sending” is set to “Enable (seconds)”.</td>
</tr>
<tr>
<td>“Cycle time [hh:mm]”</td>
</tr>
<tr>
<td>Requirement: “Cyclic sending” is set to “Enable (minutes)”.</td>
</tr>
</tbody>
</table>
The BACnet protocol defines a number of object types on which the services operate. Each object is characterized by its properties.

The BACnet objects are combined in a BACnet device. A BACnet device represents the functionality of a physical device.

More background information and introduction can be found here:
http://www.bacnet.org
http://www.bacnet.org/Bibliography

### 6.3.4.9.2 AC500 and BACnet

A BACnet device can be described by its “BACnet Interoperability Building Blocks” (BIBBs), which are needed to establish services. They are grouped in different areas:

- “Data Sharing” (DS)
- “Alarm and Event Management” (AE)
- “Scheduling” (SCHED)
- “Trending” (T)
- “Device and Network Management” (DM)

“Data Sharing” for example contains two BIBBs which are needed for the “Service Read Property”:

- Client side: DS-RP-A (Data Sharing - Read Property - A)
- Server side: DS-RP-B (Data Sharing - Read Property - B)

The BACnet standard defines profiles by the minimum required BIBBs, see table below. “BACnet Simple Sensor” (B-SS) is the simplest one, only containing one BIBB. More complex devices contain more BIBBs (from right to left).

<table>
<thead>
<tr>
<th>Interoperability Areas (IA)</th>
<th>BACnet Device profiles</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>B-OWS</td>
</tr>
<tr>
<td></td>
<td>DS-V-A</td>
</tr>
<tr>
<td>Scheduling</td>
<td>SCHED-A</td>
</tr>
<tr>
<td></td>
<td>SCHED-1-A</td>
</tr>
<tr>
<td></td>
<td>DM-UTC-A</td>
</tr>
</tbody>
</table>
The AC500 V2 supports BIBBs qualifying it as "BACnet Application Specific Controller" (B-ASC), by installing the BACnet B-ASC library.

AC500 V3 supports many more BIBBs qualifying it as "BACnet Building Controller" (B-BC), which contains a server (all BIBBs ending with -B) and a client (all BIBBs ending with -A). In fact, the AC500 contains some more BIBBs. All BIBBs under B-BC in the table above, plus:

- DS-COV-A, -B (Change of Value-A, -B)
- DS-COV-A, -B (Change of Value of Properties-A, -B)
- AE-N-E-B (Alarm and Event-Notification External-B)
- AE-ASUM-B (Alarm and Event-Alarm Summary-B)
- SCHED-I-B (Scheduling-Internal-B)
- T-VMT-E-B (Viewing and Modifying Trends External-B)
- DM-TS-B (Time Synchronization-B)
- DM-UTC-B (UTC Time Synchronization-B)
- DM-MTS-A (Manual Time Synchronization-A)
- DM-LM-B (List Manipulation-B)
- DM-OCD-B (Object Creation and Deletion-B)
- NM-BBMDC-B (BBMD Configuration-B)

... 

A list with all details can be found in the Automation Builder pdf document ABB-B-BC-PICS-AC500_V3.pdf. Direction: Help/Project examples/Examples.

The figure below shows a typical application for an AC500 V3, acting as B-BC.

A drive with several actuators and sensors is acting as B-ASC, for example providing a temperature value as "Analog Input" (AI) object on the MS/TP network.
AC500 B-BC as client can read this temperature value, perform some processing (scaling, limit check) and on the server side provide the processed value as “Analog Value” (AV) object and as “Trend” object on the IP network. Higher level clients like BACnet Operator Workstation (B-OWS) can access the processed objects “Analog Value” and “Trend” for supervision.

The following chapters describe the possible applications and how to configure an AC500 V3 as B-BC.

**6.3.4.3 AC500 V3 as BACnet Building Controller (B-BC)**

**General**

The BACnet integration into CODESYS implements the ANSI/ASHRAE standard 135-2012 (ISO 16484-5) protocol revision 14 and is based on the AMEV AS-A and AS-B standards. Integration allows access to the properties of BACnet objects and the configuration parameters of a BACnet device by means of an IEC application. You can program a dynamic BACnet configuration and have access to the BACnet functions in the BACnet network by reading and writing BACnet object properties.

**Supported BACnet networks**

BACnet can run on different local area network types. The AC500 B-BC supports the following ones:

- MS/TP (Master Slave / Token Passing), based on serial RS-485
- BACnet IP, based on Ethernet / UDP / IP

Different networks can be combined to one common “BACnet internetwork”. The figure above shows an example of some BACnet devices in one “BACnet internetwork”. Each device has a device ID (10 to 15) which must be unique on application level. Services on application level (e.g. read or write request) are working with these device IDs and need no addressing information of the lower levels.

The example “BACnet internetwork” consists of different BACnet networks:

- BACnet MS/TP network connecting device 10, 11 and 12
- BACnet IP network (UDP port 47808), consisting of one IP subnets with IP range 192.168.0.x, connecting device 12, 13 and 14
- BACnet IP network (UDP port 47809), consisting of one IP subnet with IP range 192.168.2.x, connecting device 14 and 15

Addressing in a BACnet network is done through datalinks which must have a unique BACnet MAC address (which is different to an Ethernet MAC address).

- In a MS/TP network the BACnet MAC address is just one octet (1, 2, 3 in the example).
- In an IP network the BACnet MAC address is the combination of the IP address and the UDP port number (for example 192.168.0.130.47808 for device 13). The following 16 UDP ports are reserved for BACnet: BAC0 (=47808 decimal) to BACF.
To form a common “BACnet internetwork” the single BACnet networks must be combined by BACnet routers. AC500 can act as a BACnet router between BACnet MS/TP and IP networks (device 12 in the figure above) or between two different BACnet IP networks (device 14).

Two IP subnets using the same UDP ports can be combined to one BACnet IP network with an internet router.

The problem is that internet routers block local broadcast messages, which are required for BACnet communication. This can be solved by “Broadcast Management Devices” (BBDM). AC500 V3 can be configured as BBDM. In the figure above the devices 12 and 14 should be configured as BBDM in order to enable the BACnet communication across the internet router.

An alternative is to configure AC500 V3 as foreign BACnet device if an IP subnet contains no BBDM device to pass broadcast messages over internet routers.

Configuring the AC500 as BBDM or foreign device is described in Chapter 6.3.4.9.3.5.5 “Configuration of datalinks” on page 1745.

Supported objects and properties

Communication with BACnet is done through objects and properties.

The AC500 B-BC server of the figure below is represented as a BACnet device object with “ID 12”. The device contains more objects like the Analog Input object, representing the input of a temperature measurement device. An object contains several properties, like “ID, Description, Present Value, Unit” etc.

Further possible objects of an AC500 B-BC are:

- “Binary Input” for example from connected to a switch
- “Analog / Binary Output” for actuators
- “Analog / Binary Values” for local variables
- “Calender”
- “Schedule”
- “Trend Log”
- ...

A list with all details can be found in the Automation Builder pdf document ABB-B-BC-PICS-AC500_V3.pdf. Help/Project examples/.
Supported BIBBs and services

While objects and properties describe which data are communicated, the communication itself is done with services between clients and servers. A certain service can only be executed if client and server have the related BIBBs. The Fig. 273 BACnet objects, properties, services and BIBBs shows a simple “Service Read Property” which is possible because the client on the right supports DS-RP-A and the server on the left supports DS-RP-B. The service is executed in two steps:

1. The client initiates a confirmed request “Read Property”, asking for the present value of the “Analog Input” of object with “ID 1010”.
2. The server answers with an acknowledge, sending the present value which is 21.89°C in the example.

A list of all supported BIBBs and services of AC500 V3 is given in the Automation Builder pdf document ABB-B-BC-PICS-AC500_V3.pdf. Help/Project examples/Examples.

BACnet configuration in Automation Builder

General

To act as a BACnet server or client, the AC500 must be configured accordingly. The figure below shows the basic configuration of a BACnet server (left) and a BACnet server with client functionality (right). It is also possible to have server and client functionality in parallel.
Following objects need to be created:

1. "BACnet Server" root object. This is the root object for the server functionality, as well as for the client functionality. It is mandatory, even if only client functionality is required. Chapter 6.3.4.9.3.5.2 “Configuration of BACnet server root object” on page 1739

2. BACnet server objects, for example "BACnet Analog Input" temperature. The properties of the objects must be controlled (written or read) by the PLC logic. Chapter 6.3.4.9.3.5.3 “Adding BACnet server objects” on page 1741

3. BACnet client objects, represented by a different symbol. For example, "BACnet Client Read Property". The functionality of the client objects must be programmed in the PLC logic. Inserting the client objects below the server is optional. It is also possible to instantiate the objects only in a PLC logic. Chapter 6.3.4.9.3.5.4 “Adding BACnet client functionality” on page 1742

4. Datalink for the physical layer. This object links the physical interface (Ethernet IP or serial MS/TP) to the "BACnet Server" object. In the example above the IP address of ETH1 is automatically retrieved by inserting the "BACnet IP datalink" below the ETH1 port. Configuration of an IP datalink” on page 1746. For MS/TP refer to “Configuration of an MS/TP datalink” on page 1745.

Configuration of BACnet server root object

1. Create an empty project with an AC500 V3 CPU type and call it for example “Device_12”.

2. Insert a “BACnet Server” object below the interfaces object in the device tree.
3. Set the device `InstanceNumber` in the “BACnet Parameters” of the “BACnet Server”, e.g. to 12 and the `InstanceName` to `Device_12` (according to Fig. 273 BACnet objects, properties, services and BIBBs).

4. Add a datalink, IP or MS/TP. In the example an IP datalink is inserted below ETH1. Default parameters are sufficient if only one datalink is used.
   
   “Configuration of an IP datalink” on page 1746

5. Build the project, download to the PLC and set it to [RUN]. The status of the “BACnet Server” should be green (running). If not, please ensure that you have installed the runtime license BACnet Protocol B-BC Runtime, verifiable by right-click on the PLC node and select [Show license information] from the runtime licensing menu. The project is scanned for required licenses. If you are logged in to a PLC, then the licenses available on the PLC are displayed. A missing required license is highlighted.
   
   Chapter 6.3.2.2.2 “PLC runtime licensing” on page 1446
6. Start any BACnet client to find the server, for example Inneasoft BACnet Explorer.

Adding BACnet server objects

Goal is to publish an analog value as BACnet server object. This example is according to Fig. 273 BACnet objects, properties, services and BIBBs, left part containing a temperature value.

1. Configure a “BACnet Server” root object according to Chapter 6.3.4.9.3.5.2 “Configuration of BACnet server root object” on page 1739.

2. Add a “BACnet Analog Input” object below the “BACnet Server”.

3. Rename it to Temperature, adjust the parameters: InstanceNumber: 1010, Description: Temperature, Units: UNIT DEGREES C.
4. The present value of the objects Temperature needs to be fed with the value from the real temperature device. Alternatively, a simple PLC program can simulate this value.

5. Download the program and observe the temperature value in the BACnet client.

Adding BACnet client functionality

Goal is to configure a second AC500 controller as BACnet client which reads an analog value from a server. This example is according to Fig. 273 BACnet objects, properties, services and BIBBs, right part.

1. Add a new controller and configure a “BACnet Server” root object according to Chapter 6.3.4.9.3.5.2 “Configuration of BACnet server root object ” on page 1739.

2. Set InstanceNumber to 14 and InstanceName to Device 14.
3. In addition to BACnet objects, BACnet clients can also be inserted as devices under a “BACnet Server”. Add a “BACnet Client Read Property” below the “BACnet Server” node.

4. The created object “BACnet Client Read Property” generates a function block instance which can be used to program the client read functionality. The figure below shows a simple example.

In line 1-5 of the code part the function block is called with the following parameter:

- Device ID of the server to read from (12) "Chapter 6.3.4.9.3.3 "Supported objects and properties " on page 1737
- Object ID of the object to read from (1010 for the “Analog Input”)
- Object type (“Analog Input”)
- Property to read (“present value”)
- triggerRead to start the read operation

When the user (or another program part) sets the variable triggerRead from FALSE to TRUE the edge triggered function block BACnet_Client_Read_Property starts operation and sends the read request to the server device. After receiving the reply from the Server, the output .xDone gets TRUE (line 8) and the temperature value can be read from the output .result (line 14).
5. Download this program to another AC500 V3 controller, which is in the same IP network as the server. Set it to run and read the temperature value by setting `triggerRead` to `TRUE`. In online mode the read temperature value can be observed in line 14.

**Alternative configuration**

Unlike BACnet objects, a BACnet client does not require a complex (static) configuration, thus a client function block can be used without creating a BACnet client as device.

There is no `BACnet_Client_Read_Property` object created below the “BACnet Server”. Instead a function block `BACnet_Client_Read_Property` must be declared in the PRG (line 6 in the declaration) and initially "connected" to its "BACnet Server" in IEC-code via `RegisterToServer()`, and thus get activated (line 2 in the code) © Chapter 6.5.14 “Reference, function blocks” on page 4086.
Configuration of datalinks

For communication with other BACnet devices AC500 provides two different possibilities: MS/TP and IP.

Chapter 6.3.4.9.3.2 “Supported BACnet networks” on page 1736

For a non-routing device one MS/TP or IP datalink must be configured.

If more than one datalink is configured, routing between the datalinks is automatically enabled.

Configuration of an MS/TP datalink

- Add the “BACnet MS/TP COM” object below the COM port.

In fact the empty COM port is replaced by the “BACnet MS/TP COM”. By that the COM port is configured as RS-485 with fixed settings for MS/TP: No parity, 8 data bits, 1 stop bits.

- Below the “BACnet MS/TP COM” port object an “BACnet MS/TP datalink” is inserted automatically which can be configured according to the requirements.
● NetworkNumber: Use the default value 1 if no routing is required. For routing, use a unique network number in one controller.

● ConnectionType: Use the default value Master if no routing is required. For routing, use “Master – answering always postponed”.

● Baudrate: can be set according to requirements in the range of from 9600 to 38400 bits/s, higher values (57600 and 115200 bits/s) are not recommended.

● DatalayerAddress: This is the MAC address as described in Chapter 6.3.4.9.3.2 “Supported BACnet networks” on page 1736. The MAC address must be unique in the MS/TP network.

● For all other parameters the default values are recommended for typical applications.

Configuration of an IP datalink

● Add a “BACnet_IP_datalink” object below the Ethernet port ETH1 or ETH2.

Configuration of Routing

Routing enables the combination of different BACnet networks to one common “BACnet internetwork”.

Chapter 6.3.4.9.3.2 “Supported BACnet networks” on page 1736
BACnet devices from different BACnet networks can communicate with each other.

If more than one datalink is configured in one CPU, routing between the different networks is automatically enabled. It must only be ensured that the network number is unique in one controller.

Chapter 6.3.4.9.3.2 “Supported BACnet networks” on page 1736
For MS/TP the ConnectionType must be set to “Master – answering always postponed”. An example for routing can be found in the example folder.

Time synchronisation

The BACnet clients expect to receive the local time. Currently the AC500 V3 does not distinguish between UTC time and local time and its time zone is set to 0. This will be improved in the near future. In the meantime, it is recommended to store the local time (green color in the following figure) in the AC500 as a workaround.
Using this workaround, the following time sync mechanisms can be used:

- Set local time from Automation Builder Tab “PLC Shell”:
  Set the time by the command “time hh:mm:ss”

- Read the local time from the Automation Builder Tab “Statistics”:
  “Current PLC Date and time” shows the PLC time as local time without conversion, if the tab “Show PLC time in UTC” is enabled.

For storing the local time in AC500, do not use the button [Set PLC to PC Time] (Tab “Statistics”), since this is always converting from local time to UTC time.
BACnet clients can read local or UTC time, both requests will deliver the same (local) time information, since the timezone is 0.

If an SNTP time sync is required (for example with a Meinberg clock), UTC times are exchanged. For conversion of UTC to local time in AC500 a proprietary STNP client must be programmed.

Please contact the PLC support for more information.

Package content

General

The BACnet package PS5607-BACnet-BC can be installed with the Installation Manager and contains the following components:

- BACnet runtime component, part of AC500 firmware.
- Automation Builder package: CODESYS BACnet
  - BACnet plug-in component
  - Device descriptions for "BACnet Server", BACnet objects, BACnet client and datalinks

幢 Chapter 6.3.4.9.3.6.2 “BACnet libraries" on page 1748

Example folder

- Example folder
  - Examples and example documentation
  
幢 Chapter 6.3.4.9.3.6.3 "Application examples” on page 1749
  - Datasheet and FAQ
    BACnet Protocol Implementation Conformance Statement (PICS), acting as a data-sheet, describing all BACnet objects, services and communication capabilities.
    BACnet Conformance Certificate
    FAQ – Frequently Asked Questions, including AC500 specific information, performance and limit

BACnet libraries

The IEC library CmpBACnet represents the integration of the BACnet stack into a CODESYS IEC environment and provides the BACnet data types as well as the BACstack methods. The sole use of the IEC library CmpBACnet (without the BACnet and BACnetDefaultImpl libraries) would result in complex and lengthy IEC application code.

The BACnet library simplifies BACnet application development considerably as compared to the sole use of CmpBACnet, especially in the following areas:

- Starting and stopping the BACnet stack
- Using BACnet server objects and their properties
- Triggering asynchronous requests (mainly client service requests) and processing the request transaction
- Processing of callbacks from the BACnet stack (see IBACnetEventConsumer) and distributing the callbacks to multiple receivers in the application

Furthermore, the BACnet library provides a plug-in mechanism (BACnetServerPlugin) for extending certain aspects of the BACnet library. BACnetServerPlugin is the basis for the BACnetDefaultImpl library.

The BACnetDefaultImpl library is used for the additional simplification of BACnet application development. The BACnet standard ASHRAE 135 leaves some aspects of the practical use of BACnet open. The most notable examples include the following:

- Persistence of server objects
- Storage and persistence of Trend Log, Trend Log Multiple, and Event Log entries
- Update of the date/time information of the device object
The IEC library BACnet is intended as a layer over the IEC library CmpBACnet. However, the
layer does not hide the library because this would require the BACnet library to have “facade”
functions for CmpBACnet functions. These facade functions would result in larger application
code and increased runtime requirements. This is difficult for the PLC to accept. For this reason,
it is necessary to know when elements from the BACnet library or CmpBACnet library are to be
used.

General rules:

- **Starting and stopping the BACnet stack**
  Always use BACnetServer.StartBACnetStack and BACnetServer.StopBACnetStack or AutoStart. Never directly use the corresponding functions of the CmpBACnet library, such as CmpBACnet.BACnetServerInit.

- **Using BACnet server objects and their properties**
  Always use the specified function blocks in IEC-lib-BACnet, such as BACnetAnalogValue. Never directly use the corresponding functions of the BACnet library, such as CmpBACnet.BACnetStorePropertyInstance.

- **Triggering of asynchronous requests**
  Always use the specified client function blocks of the BACnet library, such as BACnetClientReadProperty. Never directly use the corresponding functions of the CmpBACnet library, such as CmpBACnet.BACnetReadProperty. All functions of the CmpBACnet library that require a BACnetAsyncTransactionToken belong to this category and should never be used directly.

- **Processing of callbacks from the BACnet stack and distributing the callbacks to multiple receivers in the application**
  Always use IBACnetEventConsumer and BACnetServer.RegisterHook/UnregisterHook/RegisterCallback/UnregisterCallback. Never directly use the corresponding functions of the CmpBACnet library, such as CmpBACnet.BACnetSetHook or CmpBACnet.BACnetSetCallback.

When is it appropriate and safe to directly call the functions of the CmpBACnet library?

Basically, it is only necessary to call functions of CmpBACnet directly when a corresponding functionality is not provided in the BACnet library. Check the BACnet library first before trying to use CmpBACnet directly. It is possible to use blocking functions in CmpBACnet, such as BACnet*CbCompletion, BACnetIam(Ex), or BACnetIHave(Ex), BACnetUnconf*.

Most often, you will use BACnet*CbCompletion to implement your specific IBACnetEventConsumer, BACnetEventCallback. But first check whether or not the BACnetDefaultImpl library already contains an appropriate standard implementation.

**Application examples**

- **AC500_V3_BACnet_B-BC_Example_ABxxx.project** including simple read and write operations between client and server.
  - Use case 1: AC500 as BACnet client, read and write (with priority)
  - Use case 2: AC500 as “BACnet Server”, publish the analog value

- **AC500_V3_BACnet_B-BC_Example_Routing_ABxxx.project**

- **Examples from 3S**, including
  - Read and write operations with more options, notification class, calendar, scheduler, etc.
  - Device discovery
  - BBMD
  - Persistence
  - Logging
  - Routing
6.3.4.10 UDP protocol

6.3.4.10.1 Contents of the UDP protocol configuration

Functionality

UDP and TCP are widely used in network communication. UDP is a connectionless transport protocol. It has a similar task as the connection oriented TCP. This means that the sender does not know whether the data packets it has sent have arrived. While TCP sends acknowledgments when receiving data, UDP does without. This has the advantage that the packet header is much smaller, and the transmission link does not have to transmit acknowledgements.

Typically, UDP is used for DNS requests, VPN connections, audio and video streaming.

UDP in V3 is no longer configured in the hardware tree but only implemented applicatively via a library.

There are two libraries, one that works on the lowest level (SysSocket2, library, to get access to the socket interface for TCP/IP communication on the target.) and a user library (Net Base Services, this library implements a TCP server, TCP client and a UDP peer as a collection of base services for Ethernet).

- Chapter 6.5.3 “Library Manager functionality” on page 3773
- Chapter 5.2.1.2.1.3.3 “Overview of protocols, sockets and ports” on page 310
- Chapter 6.5.14 “Reference, function blocks” on page 4086
- “Data synchronization via UDP” on page 3882
- Chapter 6.3.4.9.3.2 “Supported BACnet networks ” on page 1736

The application example Communication via UDP protocol demonstrates the communication between a AC500 V2 PLC and a AC500 V3 PLCs via UDP protocol.

6.3.4.11 OPC UA

AC500 V3 controllers support the OPC UA protocol - a machine-to-machine communication protocol for industrial automation. For details on installation and configuration of an OPC UA server refer to the OPC UA server description Chapter 6.3.6.2 “OPC UA server for AC500 products” on page 1787.

How to connect robot controllers to OPC UA is described in the ABB News.

Application note

Details on OPC UA communication with an AC500 V3 PLC are given in the application note AC500 V3 and OPC UA.

Application example

The application example How to use OPC server V3 - for DA and UA is available to gain a deeper understanding of the OPC protocol and to configure AC500 V3 accordingly.

6.3.5 Data transfer and programming

6.3.5.1 Data exchange between AC500 V3 PLCs via network variables

Network variables can be used to exchange data between two AC500 V3 PLCs. The variables must be defined in strict and identical lists on both PLCs which are sender and receiver. The lists can be in one or more projects.

A step-by-step description on how to use network variables can be found in the application example.
6.3.5.2 Data exchange between AC500 V3 PLCs via EtherCAT

An EtherCAT bridge can be used to exchange data between two AC500 V3 PLCs in real time. The procedure is described in the *application example* using an EL6695 bridge terminal.

6.3.5.3 Source download/upload

**Source download**

- **Prerequisites**
  - Communication settings are correct
  - Project is saved on PC
  - PLC is connected

1. Login to the PLC.
2. In the menu click "Online ➔ Source download to connected device".
   - Project archive will be downloaded to PLC.
3. To verify download double-click node "PLC_AC500_V3", select view "Files" and double-click folder "PlcLogic" of the Runtime view (if necessary click refresh button of Runtime view).
   - File *Archive.prj* will appear if download was successful.
Source upload  Prerequisite

- Project archive on PLC available (from previous source download)
- PLC is connected

Depending on the used version of Automation Builder, the layout of the opened windows may vary.

1. Open the Automation Builder.
2. In the menu click “File ➔ Source upload...”.
   ⇐ A window “Pick the device from where you want to upload the source archive...” appears.

   If you get an error click [Scan for other devices].

3. Select your PLC with the archive and click [OK].
   ⇐ Dialog “Extract Project Archive” appears.

4. Select your preferred folder and click [Extract].
Then you are prompted to open the project archive.

5. Click [Yes].

⇒ The project opens.

Upload was successful.

### 6.3.5.4 Programming and testing

For information on programming see
- Chapter 6.4.1.9 “Programming of Applications” on page 1844
- Chapter 6.4.1.11.2 “Configuring the Connection to the PLC” on page 1965
- Chapter 6.3.5.5.2 “Enter a known PLC IP address” on page 1754
- Chapter 6.4.1.11 “Downloading an Application to the PLC” on page 1965

For information on testing/debugging see Chapter 6.4.1.12 “Testing and Debugging” on page 1980

### 6.3.5.5 Configuration of communication via Ethernet (TCP/IP)

#### 6.3.5.5.1 General

Programming via Ethernet is only possible on a PC with Ethernet board and installed network. Programming can be done via the internal (onboard) Ethernet communication module.

An application note describes the configuration of an AC500 V3 PLC for **EtherNet/IP communication**.
6.3.5.5.2 Enter a known PLC IP address

1. Right-click the top node “PLC_AC500 <...>” and select “Communication Settings” from the context menu.
   ⇒ Dialog box “Communication Settings <...>” appears.

2. Enter your PLC IP Address and click [OK].

6.3.5.5.3 Enter PLC IP address by scanning devices

1. Right-click the top node “PLC_AC500 <...>” and select “Communication Settings” from the context menu.
   ⇒ Dialog box “Communication Settings <...>” appears.

2. Click […].
   ⇒ Dialog box “Communication Settings <...>” appears.
3. Click [Scan], select your desired PLC and click [OK].
   ⇒ Entry is transferred to the dialog box “Communication Settings <...>”.
   Click [OK].

4. Click to log in the “PLC_AC500_V3” project.

6.3.5.5.4 Enter PLC IP address by [Advanced Settings...]

If a remote gateway instead of a local one has to be used it can be configured in the [Advanced Settings...].

1. Right-click the top node “PLC_AC500 <...>” and select “Communication Settings” from the context menu.
   ⇒ Dialog box “Communication Settings <...>” appears.

2. Enable checkbox “Use advanced settings” and click [Advanced Settings...].
   ⇒ Tab “Communication Settings” opens.

3. Check gateway or change if required.
   ⇒ Successful connection is indicated by green dot on the gateway icon.
4. **Manual entry of the IP address.**

Check IP address or change if required.

5. Press ENTER to confirm changed IP address.
   - Successful communication is indicated by green dot on the PLC icon.

6. Or instead of the last two steps:

   **Set the IP address via a scan.**

   Click [Scan Network], select your desired PLC and click [OK].

   ![Communication Settings](image)

   - Successful connection is indicated by green dot on the gateway icon.

7. Click to log in the “PLC_AC500_V3” project.

### 6.3.5.6 PLC shell commands

The PLC shell is used for requesting specific information from the controller. By entering a device-specific command the response is returned in a result window. The PLC shell can be issued without login.

**Proceed as follows:**

1. Ensure the gateway is configured properly and a connection to the controller can be established.
2. In Automation Builder double-click the PLC node and open the tab “PLC Shell”.
3. Enter “?” in the command line of the tab window. All available PLC commands are listed.

If the gateway is able to establish a connection to the controller, an online connection to the PLC is opened automatically.
The commands listed in online mode can differ from the commands shown when pressing the button [...] as Automation Builder version and firmware version can differ.

- Chapter 6.4.1.21.2.8.11 “Tab 'PLC Shell'” on page 2441
- Chapter 6.2.6 “Version information” on page 1384
- Chapter 6.3.1.4 “Firmware identification and update” on page 1419.

6.3.5.7 Watchlists

- Chapter 6.4.1.13.2.3 “Using watch lists” on page 2002
- Chapter 6.4.1.13.2.4 “Changing Values with Recipes” on page 2003

6.3.5.8 Reference to libraries

Library configuration is described in the chapter.

6.3.5.9 Reference to application libraries

Application libraries can be used in AC500 V3 PLCs. The requirements for the use of the function blocks of the application libraries and information and prerequisites for the general handling of application libraries are described in the application examples:

**HTTP library**
In order to be able to use the PLC as a client for web services, the HTTP function block library can be used. Setup and use of the HTTP library are described in the application example [AC500 Webservices - HTTP Function Block Library](#).

**MySQL library**
With the help of the MySQL function block library, MySQL databases can be used to store and access AC500 V3 data. Setup and use are described in an [application example](#).

**MSSQL library**
With the help of the MSSQL function block library, MSSQL databases can be used to store and access AC500 V3 data. Setup and use are described in an [application example](#).
6.3.6 Server installation

6.3.6.1 OPC server for AC500 V3 products

6.3.6.1.1 Introduction

Architecture of the CODESYS OPC server
Essential documents

Further information

<table>
<thead>
<tr>
<th>File name</th>
<th>Comment</th>
<th>Where to find</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPC_V3_how_to_use_E.pdf</td>
<td>OPC V3</td>
<td>C:\Program Files\ABB\CoDeSys OPC Server 3 AE</td>
</tr>
<tr>
<td>OPC_V3_how_to_use_D.pdf</td>
<td>OPC V3</td>
<td>C:\Program Files (x86)\3S CODESYS\CODESYS OPC Server 3</td>
</tr>
<tr>
<td>AeConfigurator_User-Guide.pdf</td>
<td>OPC V3</td>
<td>Installation ABB DM Suit 1.0.: \PLC - AC500\OPC Server\OPC-ServerV3.xAE\</td>
</tr>
<tr>
<td>ReadMe.rtf</td>
<td>OPC V3</td>
<td>Installation ABB DM Suit 1.0.: \PLC - AC500\OPC Server\OPC-ServerV3.xAE\</td>
</tr>
<tr>
<td>ReleaseNotesOPCV3 AE for HA</td>
<td>OPC V3</td>
<td></td>
</tr>
</tbody>
</table>

Work flow

Consideration and preparation

*) Chapter 6.3.6.1.2.2 “Installation of OPC server” on page 1766
Commission OPC server

*) © Chapter 6.3.6.1.2.3.1 “Define symbols” on page 1769
Chapter 6.3.6.1.2.5 “Configure AlarmEvents” on page 1782

Chapter 6.3.6.1.2.5.1 “Check AlarmEvents” on page 1782
Adjustment to target OPC client

1) Chapter 6.3.6.1.1.2 “Essential documents” on page 1759 REF4.

2) Chapter 6.3.6.1.2.6 “Configure user account for OPC server” on page 1783
### 6.3.6.1.2 Hints

#### Default folder and contents

**Windows 7, Windows Server 2008/2016 (64-bit)**

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>WinCoDeSysOPC.exe</td>
<td>C:\Program Files (x86)\3S CoDeSys\CoDeSys OPC Server 3\</td>
</tr>
<tr>
<td>OPCConfig.exe</td>
<td></td>
</tr>
<tr>
<td>AEConfiguration.exe</td>
<td></td>
</tr>
<tr>
<td>CoDeSys_OPC_Server_V3_User_Guide.pdf</td>
<td></td>
</tr>
<tr>
<td>CoDeSys_OPC_Server_V3_Benutzerhandbuch.pdf</td>
<td></td>
</tr>
<tr>
<td>AeConfigurator_UserGuide.pdf</td>
<td></td>
</tr>
<tr>
<td>OPCServer.ini</td>
<td>C:\ProgramData\CoDeSysOPC\</td>
</tr>
<tr>
<td>OPCServerA.ini</td>
<td></td>
</tr>
<tr>
<td>OPCServer.log</td>
<td></td>
</tr>
<tr>
<td>Symbol file *.SDB, *.SYM</td>
<td>CBP open, after project build or rebuild all: in the project folder</td>
</tr>
<tr>
<td>Symbol file *.SDB</td>
<td>After login in AC500:</td>
</tr>
<tr>
<td></td>
<td>C:\ProgramData\Gateway Files\</td>
</tr>
<tr>
<td></td>
<td>After starting the OPC server:</td>
</tr>
<tr>
<td></td>
<td>C:\ProgramData\Gateway Files\Upload\</td>
</tr>
<tr>
<td>Gateway.exe</td>
<td>C:\Windows\SysWOW64\</td>
</tr>
</tbody>
</table>

Configuration and programming

Configuration in Automation Builder for AC500 V3 products > Server installation

2024/01/05  3ADR010583, 1, en_US  1763
## Windows 7 (32-bit), Windows Server 2008/2016 (32-bit)

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>WinCoDeSysOPC.exe</td>
<td>C:\Program Files\3S CoDeSys\CoDeSys OPC Server 3\</td>
</tr>
<tr>
<td>OPCConfig.exe</td>
<td></td>
</tr>
<tr>
<td>AEConfiguration.exe</td>
<td></td>
</tr>
<tr>
<td>CoDeSys_OPC_Server_V3_User_Guide.pdf</td>
<td></td>
</tr>
<tr>
<td>CoDeSys_OPC_Server_V3_Benutzerhandbuch.pdf</td>
<td></td>
</tr>
<tr>
<td>AeConfigurator_UserGuide.pdf</td>
<td></td>
</tr>
<tr>
<td>OPCServer.ini</td>
<td>C:\ProgramData\CoDeSysOPC\</td>
</tr>
<tr>
<td>OPCServerA.ini</td>
<td></td>
</tr>
<tr>
<td>OPCServer.log</td>
<td></td>
</tr>
<tr>
<td>Symbol file *.SDB, *.SYM</td>
<td>CBP open, after project build or rebuild all: in the project folder</td>
</tr>
<tr>
<td>Symbol file *.SDB</td>
<td>After login in AC500:</td>
</tr>
<tr>
<td></td>
<td>C:\ProgramData\Gateway Files\</td>
</tr>
<tr>
<td></td>
<td>After starting the OPC server:</td>
</tr>
<tr>
<td></td>
<td>C:\ProgramData\Gateway Files\Upload\</td>
</tr>
<tr>
<td>Gateway.exe</td>
<td>C:\Windows\System32\</td>
</tr>
</tbody>
</table>
### Windows Server 2008/2016 (32-bit)

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>WinCoDeSysOPC.exe</td>
<td>C:\Program Files\3S CoDeSys\CoDeSys OPC Server 3\</td>
</tr>
<tr>
<td>OPCConfig.exe</td>
<td></td>
</tr>
<tr>
<td>AEConfiguration.exe</td>
<td></td>
</tr>
<tr>
<td>CoDeSys_OPC_Server_V3_User_Guide.pdf</td>
<td></td>
</tr>
<tr>
<td>CoDeSys_OPC_Server_V3_Benutzerhandbuch.pdf</td>
<td></td>
</tr>
<tr>
<td>AeConfigurator_UserGuide.pdf</td>
<td></td>
</tr>
<tr>
<td>OPCServer.ini</td>
<td></td>
</tr>
<tr>
<td>OPCServerA.ini</td>
<td></td>
</tr>
<tr>
<td>OPCServer.log</td>
<td></td>
</tr>
</tbody>
</table>

Symbol file ".SDB", ".SYM"

<table>
<thead>
<tr>
<th>Symbol file &quot;.SDB&quot;</th>
<th>CBP open, after project build or rebuild all: in the project folder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symbol file &quot;.SDB&quot;</td>
<td>After login in AC500:</td>
</tr>
<tr>
<td></td>
<td>C:\WINDOWS\Gateway Files\</td>
</tr>
<tr>
<td></td>
<td>After start CODESYS OPC server:</td>
</tr>
<tr>
<td></td>
<td>C:\WINDOWS\Gateway Files\Upload\</td>
</tr>
</tbody>
</table>

Gateway.exe

| Gateway.exe                                           | C:\Windows\System32\                                               |

If folder C:\ProgramData\ is missing, select “Show hidden files, folders and drives” at “Control Panel ➔ All Control Panel Items ➔ Folder Options ➔ View ➔ Hidden files and folders”.

---

2024/01/05 3ADR010583, 1, en_US 1765
Installation of OPC server

Prerequisites

<table>
<thead>
<tr>
<th>The following applications are closed:</th>
</tr>
</thead>
<tbody>
<tr>
<td>– All OPC clients</td>
</tr>
<tr>
<td>– ABB OPC tunnel</td>
</tr>
<tr>
<td>– CODESYS gateway server</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Ensure termination of the following processes:</th>
</tr>
</thead>
<tbody>
<tr>
<td>– Gateway.exe</td>
</tr>
<tr>
<td>– CoDeSysOPC.exe</td>
</tr>
<tr>
<td>– WinCoDeSysOPC.exe</td>
</tr>
<tr>
<td>– OCTsvc.exe</td>
</tr>
</tbody>
</table>

Installing with Automation Builder

2. Click [Latest Automation Builder version (recommended)] and run the installer.

3. Open “Installer Options and Additional Tools” and click [Install Additional Tools].
4. Agree to the “License Terms”.

5. Select “Version 2 and/or 3” and install.
   ☑ All required files are installed for OPC and the OPC server is registered automatically as user application.
Manual registration and unregistration

It is possible to register or to uninstall the OPC server manually either as COM server (user application) or as a service.

Register the OPC server as interactive software in the Windows registry:

**Command for OPC 3:** `WinCoDeSysOPC/RegServer`

Register the OPC server as system service:

**Command for OPC 3:** `WinCoDeSysOPC/Service`

Unregister the OPC server from the Windows registry and from the service entry:

**Command for OPC 3:** `WinCoDeSysOPC/UnRegServer`

Please see REF1 chapter 3 (OPC 3) Table on page 1759 for details.

Example: Register OPC server V3 as a system service

- Prerequisites: All programs, processes and services which connect to the OPC server are closed.
  1. Start the “Command Prompt” with command “cmd” in the “Start → Run...” window.
  2. Go to the CoDeSysOPC V2 installation folder.
  3. Unregister the OPC server with `WinCoDeSysOPC/UnRegServer`.
  4. Register the OPC server as system service with `WinCoDeSysOPC/Service`.

OPC clients for tests

Free of charge test clients can be found in the web:

- [https://industrial.softing.com](https://industrial.softing.com)
Symbol file
Define symbols

1. Right-click on “Application” in CODESYS V3 project and click “Add Object”.

2. Choose “Symbol Configuration” and click [Add object].

3. Select your programs and/or single symbols and click [Build].
   → A symbol file will be automatically downloaded to the PLC with Project Download.

With double-click in the device tree to “Symbol Configuration” you can change the “Symbol Configuration” settings.

To restrict traffic and load, choose only symbols you need.
Configure OPC server

Configure OPC Server V3

2. If the configuration is needed furthermore, save the configuration. The actual configuration at start of OPC server will always be read from \textit{OPCServer.ini}. 

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{image}
\caption{Configuration and programming Configuration in Automation Builder for AC500 V3 products > Server installation}
\end{figure}

\begin{itemize}
\item \textbf{Update rate}
\begin{itemize}
\item The “Update Rate” may not be 0 (ms)!
\item The default value of 200 ms is a suitable value of many applications.
\item The adjustment for the “Update Rate” depends on the number of symbols (variables).
\item For a big number of symbols it can be better to increase the “Update Rate”.
\end{itemize}
\item The checkboxes “Sync Init” and “Enable logging (Defaultevents)” must be enabled.
\end{itemize}
3. Select “PLC_FW3”.

- If the *.sdb files should be loaded from the “Gateway Files” directory on PC, the project name must be identical with project name in CODESYS. The extension is not necessary.
- If the symbol information should be loaded from AC500 V2.x, the project name is not required and can also be empty.
- The parameters displayed in the screenshot above are recommended default settings.
- The checkbox “Active” must be enabled.
- Enabled checkbox “Enable logging” allows a later diagnosis.
4. Select "Connection" and click [Edit].

5. Enter the TCP/IP address of the target PLC at "PLC name or address" and enable "Use Tcp/Ip blockdriver".

6. Enter the TCP/IP address of the target PLC at "IP Address of PLC" and click [OK].

7. Click "File ➔ Save" OPCserver.ini and "File ➔ Exit" OPCConfig.

Check OPC function with AC500

Prerequisites

It is urgently recommended to check the function of the configuration steps.

* Chapter 6.3.6.1.2.4.1 "Configure OPC Server V3" on page 1770
Check OPC server V3

1. Start OPCExplorer.exe and connect “CoDeSys.OPC.DA”.

2. Add Group, add Items, select available Items in Server “CoDeSys.OPC.DA”. Add to Tag List, close the Item browser.

→ If anything is right, then “CoDeSys.OPC.DA” is connected, is running and the “Quality” of the items is good.

Check processes with windows task manager

Correct configuration: All processes run with the same “User Name” and with the same “Session ID”.
Test OPC function without AC500

AC500 project

1. Open CoDeSys Application.

2. Collect all OPC variables in a separate “Global Variables” list.
3. Under “Project ➔ Options” select the “Symbol configuration”. Enable checkbox “Dump symbol entries” and click [Configure symbol file].

4. Disable all the checkboxes and confirm twice with [OK].
5. Under “Project ➔ Options” “Symbol configuration” click [Configure symbol file] again.

6. Select the variables which should be communicated as symbol. Enable the following checkboxes:
   - “Export variables of object”
   - “Export structure components”
   - “Export array entries”
   - “Write access”

7. Confirm twice with [OK].

8. Under “Project ➔ Rebuild all” rebuild the project.
9. In the project folder is the subfolder “OPC_test1__AC500_PM573_ETH__OPC_test1”. It contains symbol files *.SYM and *.SDB with the time of the “Rebuild all”. The items in the file *.SYM can be checked with Notepad. The binary file *.SDB contains the items for the OPC server. With <Online> <Login> it will copied in the gateway files directory and optionally on the AC500.

10. The folder “OPC_test1__AC500_PM573_ETH__OPC_test1” is a temporary folder, if the CBP project is opened. For the simulation of the server OPC it is copied *.SDB by hand.
Configure OPC server V3

1. Select “Edit”, append “PLC” and keep the default values.

2. You must specify “Project name” with the “directory name”. Connection settings are not required for the simulation.
Check OPC server with MatrikonOPCExplorer


2. The OPC Server V3 (“CoDeSys.OPC.DA”) is connected, running and the “Quality” is good.
   One OPC client can read / write the values of the items.
3. Similar configuration as above.
   The OPC Server V2 ("CoDeSys.OPC.02") is connected, running and the configured items are found. But the “Quality” is bad. One OPC client can not read / write the values of the items.

Check processes with windows task manager

Correct configuration: All “Processes” run with the same “User Name” and with the same “Session ID”.

Summary

The correct function of OPC Server V2 and V3 can be checked without AC500.

With OPC Server V3 with the configuration “SIMULATION” the Project name with the directory name has to be specified. The values of the items can be read and write by one OPC client.

With OPC Server V2, as well as with OPC Server V3 in configuration “GATEWAY”, only the project name may be specified. The configured items are found, but the quality is bad. The values of the items can not be read and not write by one OPC client.

Refer to REF5 Online Help of PS501 chapter OPC for details © Table on page 1759.

Configure AlarmEvents

Check AlarmEvents

The function of the “AlarmEvents” can be checked with “MatrikonOPC Explorer”.

The “AlarmEvents” can be simulated by writing the value of the Items.

Further information

Refer to REF2 AeConfigurer_UserGuide.pdf for details © Table on page 1759.
Configure user account for OPC server


When running the OPC server V3 on Windows Server 2003/2008/2012/2016 multiple sessions need to be supported. Therefore the installation of the OPC server as service running with a dedicated user account is recommended.

**Configuration steps**

- Create specific user, no administrator account is required
- Register V3 OPC server as service
- Configure V3 OPC server as service

Create specific user

![Create specific user](image1.png)

Registration

![Registration](image2.png)

Register the OPC Server executable as service from the command line.
With command “WinCoDeSysOPC /Service” WinCoDeSysOPC.exe gets installed as system service. Started once, the service will stay “started” until the system gets terminated. The communication to the configured PLCs survives. Also here the service gets installed in the current position of WinCoDeSysOPC.exe.

Configuration

At “Computer Management ➔ Services and Applications ➔ Services” open the “Properties” of the “CoDeSysOPCDAService”.

Complete the Service Configuration
Testing

Check Users and Session during Test Cases

Check the “Session ID” and “User Name” of
Further information

Please refer to REF3 ReadMe.rtf and REF4 ReleaseNotes OPCV3 AE for HA.

Table on page 1759

6.3.6.1.3 Potential issues

Session isolation

Situation
With Windows Server 2003, Windows Server 2008, Windows Server 2016 the Windows 7 services are alone in session 0. User applications run in session 1 (2 and so on).

Services:
A Windows service is a computer program that operates in the background.

Windows services can be configured to start when the operating system is started or can be started manually and run in the background as long as Windows is running. They can operate when a user is not logged on.

Services are:
Windows operating systems include numerous services. OPC client like S+ OPC scanner PGIM, Aspen CIM-IO Manager, ICONICS, .. can also installed as a service.

User applications are:
Microsoft Word, Notepad, MatrikonExplorer, ControlBuilderPlus.exe and Codesys.exe

Problem
Service and user application are isolated in their session. They can not communicate with each other directly.

OPC Server uses, like the CBP and CODESYS, the gateway server from CODESYS (gateway.exe) for the communication with the AC500 and starts the gateway in their session. That creates undefined behavior, if the OPC Server runs as a service. The gateway server is not able to run in multi sessions.

Resolutions
● Install all OPC clients and OPC Server, which use the gateway server, in the same session.
● The OPC Server as a service (session 0) may not be connected at the same time (in parallel) with an OPC server as a user application or CBP or CODESYS (all in session 1) with the AC500. If this function is necessary, different PC or virtual machines must be used.
● Use tools like OPC tunnel. In a DigiVis 500 setup context the OPC server must not be registered as service. The OPC tunnel itself starts the OPC server within its service.

See also
6.3.6.2 OPC UA server for AC500 V3 products

6.3.6.2.1 General

OPC UA server can be added as an object below the Ethernet interfaces ETH1 or ETH2.

The user can access the variable interface of the PLC via a client. At the same time, communication can be protected by means of encryption.

The CODESYS OPC UA server supports the following features:

- Browsing of data types and variables
- Standard read/write services
- Notification for value changes: subscription and monitored item services
- Encrypted communication according to "OPC UA standard (profile: Basic256SHA256)"
- Imaging of the IEC application according to "OPC UA Information Model for IEC 61131-3"
- Supported profile: Micro Embedded Device server Profile
- By default, there is no restriction in the number of sessions, monitored items, and subscriptions. The number depends on the performance of the respective platform.
- Sending of events according to the OPC UA standard.

Application note How to install and configure an OPC V2 or OPC V3 server and how to use it for AC500 PLCs is described in the application note How to use OPC server.

Application example The application example How to use OPC server V3 - for DA and UA is available to gain a deeper understanding of the OPC protocol and to configure AC500 V3 accordingly.

6.3.6.2.2 Creating a project for OPC UA access

1. Click "File ➔ New Project ➔ AC500 project" in Automation Builder 2.1 or newer.
2. Choose a PLC - AC500 V3 and click [Add object].
3. Right-click on node ETH1 or ETH2 and "Add object".
4. Choose OPC UA Server in the dialog and click [Add object].
5. Declare some variables of different types in the program.
6. Right-click "Application ➔ Add object". Choose "Symbol configuration" and click [Add object].
7. Enable checkbox “Support OPC UA Features” in the dialog “Add symbol configuration”.
8. Double-click “Symbol configuration” in the Devices tree to open the editor “Symbol configuration”.
9. Click [Build].
   ◦ The variables are displayed in a tree structure.
10. Activate the variables that you want to publish to an OPC UA client. Specify the access rights.
11. Download the project to the PLC.

6.3.6.2.3 Use node name

1. Double-click node “OPC_UA_Server”.
2. Set parameter “Use node name” to TRUE.
3. Double-click node “PLC_AC500_V3 <...>”.
4. Click “Device” and “Rename active device...”
5. Enter new device name in the following dialog and click [OK].
6.3.6.2.4 Use UaExpert client

The OPC UA client UaExpert is available for download from the Unified Automation website and can be used free of charge (freeware license).

Using this client, you can connect to the AC500 OPC UA server.

The following description refers to this program. Other OPC UA clients work in a similar way.

1. Start the UaExpert program.

2. Click on the “blue cross symbol”.


4. Enter URL and click [OK].
   - The URL appears in the “Add Server” dialog.

5. Select “Advanced” tab and click [OK].

6. Click [Connect].
7. Expand the project tree in the "Address Space" window.

8. Drag and drop the needed symbols to "Data Access View".

### 6.3.6.2.5 Working with encryption

#### Creating a certificate for the OPC UA server

- **Prerequisite:** A battery is inserted and the clock is set to actual time.
- 1. Double-click the Security symbol in the lower right corner of Automation Builder.
- 2. Select the "Devices" tab.
   - The certificate information opens.
- 3. Select the PLC in the left "Information" view.
   - All services of the PLC that require a certificate are displayed in the right Information view.
- 4. Select the service "OPC UA Server".
- 5. Click the icon to create a new certificate for the device.
   - "Certificate Settings" dialog appears.
6. Define the certificate parameters according to the figure above and click [OK].
   ⇒ The certificate is created on the PLC.

7. Upload the certificate to your PC.
8. Restart the runtime system.

For further information see Chapter 6.3.4.7.3.4 “OPC UA secure” on page 1728.

**Encrypted connection with UaExpert client**

1. Start the UaExpert program.

2. Click on the “blue cross symbol”.
4. Enter URL and click [OK].
   ⇒ The URL appears in the “Add Server” dialog.
5. Select “Advanced” tab.

6. Choose option “Basic256ha256” of drop-down list “Security Policy” and “Sign & Encrypt” of drop-down list “Message Security Mode” and click [OK].
7. Click menu “Settings” and “Manage Certificates”

8. Click [Create new Application Certificate...].
   ⇒ Dialog “New Application Instance Certificate” opens.
9. Enter the required informations and click [OK].
   ⇒ Dialog “Manage Certificates” opens

10. Click [Copy Application Certificate To...] your PC.

11. Download the certificate to AC500 via the “Security Screen” view.

Dialog “Certificate Validation” opens.

Working with a trusted certificate will avoid this error message.

14. Enable checkbox Accept the server certificate temporarily for this session and click [Continue].

Dialog “Connect Error” opens.
15. Click [Ignore]

16. Check settings in dialog “Manage Certificates”.

6.3.6.2.6 Changing variables via UaExpert client

1. Expand in view “Address Space” “Objects ➔ DeviceSet ➔ PM5670 ➔ Resources ➔ Application ➔ PLC_PRG”.
   - The variables of the global variable list are visible.
2. Drag and drop the variables to the Data Access View.
3. Change values in the column Value.

6.3.6.2.7 Configuring OPC UA client

Operating modes

Polling
- Objects will be continuously updated in a defined interval
- Create higher load then Subscription
- Is recommended only for a few Symbols

Pub/Sub
Not yet supported

Subscription (recommended mode)
- Updated objects depending on the publishing interval and filters
- Method to reduce load
- Different intervals
- Filter possible (coming in AC500)

<table>
<thead>
<tr>
<th>Client defines a group of symbols with</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publishing interval</td>
<td>Interval, in which server publish data to client</td>
</tr>
<tr>
<td>Sampling interval</td>
<td>Interval for sampling and storing data at server and send in each publishing interval</td>
</tr>
<tr>
<td>Queue size</td>
<td>Array of data to save data if sampling Interval is faster than publishing Interval (At AC500 in the moment only 1)</td>
</tr>
</tbody>
</table>
| Data change filter                   | Can be used to reduce traffic from server to client. Criteria:  
  - Change of data,  
  - Change of status  
  - Change of time stamp  
  AC500 is fix configured for change of data and change of status. |

![Diagram of OPC UA client interfaces](image-url)
Using OPC UA with subscription mode

Recommendations:
- Define only variables you need as symbols
- Do not configure publishing Intervals to short (increase load)
- Use different subscriptions with different publishing intervals in order to decrease load
- Do not use sampling intervals faster then publishing intervals as long as AC500 OPC UA server don't support Queue Size different from 1
- Be careful: Setting „0“ at sampling Interval at client will be interpreted in server as „as fast as possible“, which is 100ms at AC500 and create a high load.

Publishing and sampling intervals in UaExpert
1. Right-Click on an Item in “Data Access View” and click “Subscription Settings”.

![Subscription Settings](image)

2. Set the recommended values.

   **Life Time Count**: Number of publishing intervals in which client has to send publish requests to the server. After this period without request from client, subscription in server will be deleted.

   **Max Keep Alive Count**: If there are no new data to send, server can skip a publishing interval. After the alive count, server has to send, even if there are no new data.

   Click [OK].

3. Right-Click on an Item in “Data Access View” and click “Monitored Item Settings”.

![Monitored Item Settings](image)

4. Set the recommended values.

6.3.6.3 Web server

**HTTP library**

In order to be able to use the PLC as a client for web services, the HTTP function block library can be used. Setup and use of the HTTP library are described in the application example *AC500 Webservices - HTTP Function Block Library*.
6.3.6.4 Windows server

Windows server usage in Automation Builder requires modifications of the system environment and of the settings in Automation Builder, e.g. permissions, licensing, session handling etc. How to setup system and software for Windows server is described in the application note *Windows Server 2016 - RDM access*.

6.3.7 Converting an AC500 V2 project to an AC500 V3 project

**Application example**

A project that has been configured for an AC500 V2 PLC can be converted to a project for an AC500 V3 PLC. Essentially, the conversion is done in Automation Builder, however, some additional actions have to be executed manually. The complete conversion procedure of a V2 project to a V3 project is described in the application note *Converting an AC500 V2 project to an AC500 V3 project*.
6.4 Programming with CODESYS

6.4.1 CODESYS Development System

6.4.1.1 Introduction

The CODESYS Development System IEC 61131-3 programming tool forms the core of the CODESYS software platform for tasks in industrial automation technology. With additional, integrated solutions for motion control, visualizations, and fieldbus connections, the usual practical requirements are covered in one system.

Features

The free CODESYS Development System is a IEC 61131-3 programming platform for automation devices with control tasks. It provides diverse and comfortable engineering solutions to support you in your developing tasks:

<table>
<thead>
<tr>
<th>Feature</th>
<th>For this see in this Online Help:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project configuration through wizards.</td>
<td>✔ Chapter 6.4.1.3 “Creating and Configuring a Project” on page 1808</td>
</tr>
<tr>
<td>Adaptability of the user interface.</td>
<td>✔ Chapter 6.4.1.2.2 “Customizing the user interface” on page 1802</td>
</tr>
<tr>
<td>Creation of professional IEC 61131-3 controller applications wit a host of standard features.</td>
<td>✔ Chapter 6.4.1.9 “Programming of Applications” on page 1844</td>
</tr>
<tr>
<td>User-friendly programming with mouse and keyboard in all IEC 61131-3 languages.</td>
<td>✔ Chapter 6.4.1.20.1 “Programming Languages and Editors” on page 2047</td>
</tr>
<tr>
<td>Appropriate editors for FBD, LD, IL, ST, SFC, additionally the variants CFC and Extended CFC.</td>
<td>✔ Chapter 6.4.1.9.7 “Using input assistance” on page 1885</td>
</tr>
<tr>
<td>Input assistance for the input and configuration of data.</td>
<td>✔ Chapter 6.4.1.9.7 “Using input assistance” on page 1885</td>
</tr>
</tbody>
</table>
### Support of object-oriented programming.
Real object-oriented programming (OOP) fully compliant with the IEC 61131-3 standard in all IEC 61131-3 languages, without any additional tools.
Inheritance of POUS to similar application parts to reduce development time and errors.
Object-orientation is not a must: Functional and object-oriented programming can be used and mixed as required.

### Comprehensive project comparison, also for graphic editors.

### Library concept for an easy reutilization of application.

### Debugging and online features for the fast optimization of the application code and to speed up testing and commissioning.

### Integrated compilers for many different CPU platforms for optimizing the controller performance.

### Security features for the protection of the source code and the operation of the controller.

### Field bus support and programming of devices from different manufacturers.

### Extensibility and adaptability without leaving the framework.

### For this see in this Online Help:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Online Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support of object-oriented programming.</td>
<td>Chapter 6.4.1.9 “Programming of Applications” on page 1844</td>
</tr>
<tr>
<td>Real object-oriented programming (OOP) fully compliant with the IEC 61131-3 standard in all IEC 61131-3 languages, without any additional tools.</td>
<td></td>
</tr>
<tr>
<td>Inheritance of POUS to similar application parts to reduce development time and errors.</td>
<td></td>
</tr>
<tr>
<td>Object-orientation is not a must: Functional and object-oriented programming can be used and mixed as required.</td>
<td></td>
</tr>
<tr>
<td>Comprehensive project comparison, also for graphic editors.</td>
<td>Chapter 6.4.1.5 “Comparing projects” on page 1817</td>
</tr>
<tr>
<td>Library concept for an easy reutilization of application.</td>
<td>Chapter 6.4.1.17 “Using Libraries” on page 2034</td>
</tr>
<tr>
<td>Debugging and online features for the fast optimization of the application code and to speed up testing and commissioning.</td>
<td>Chapter 6.4.1.12 “Testing and Debugging” on page 1980</td>
</tr>
<tr>
<td>Integrated compilers for many different CPU platforms for optimizing the controller performance.</td>
<td>Chapter 6.4.1.21.4.13.3 “Dialog 'Project Environment' - 'Compiler Version'” on page 2778</td>
</tr>
<tr>
<td></td>
<td>Chapter 6.4.1.21.4.12.4 “Dialog Box 'Project Settings' - 'Compileoptions'” on page 2769</td>
</tr>
<tr>
<td>Security features for the protection of the source code and the operation of the controller.</td>
<td>Chapter 6.4.1.6 “Protecting and Saving Projects” on page 1819</td>
</tr>
<tr>
<td></td>
<td>Chapter 6.4.1.9.18 “Protecting an application” on page 1915</td>
</tr>
<tr>
<td></td>
<td>Chapter 6.4.1.11.4 “Handling of Device User Management” on page 1971</td>
</tr>
<tr>
<td>Field bus support and programming of devices from different manufacturers.</td>
<td>Chapter 6.4.1.8 “Configuring I/O Links” on page 1835</td>
</tr>
<tr>
<td>Extensibility and adaptability without leaving the framework.</td>
<td></td>
</tr>
</tbody>
</table>

### Additionally:
Many seamlessly integrated tools for different kinds of automation tasks, for example CODESYS Visualization, CODESYS SoftMotion, CODESYS Application Composer.

Please always note the possibility to extend the functionalities by "AddOn"-Packages, provided in the CODESYS Store.

### Customization of the user interface language
In the “Option ➤ International Settings” dialog you can customize the language of the user interface of the development system. This change will take effect the next time you start Automation Builder. You can adjust the help language separately.

If you start Automation Builder from the command line, you can add a parameter to adjust the user interface language.

- Chapter 6.4.1.16 “Using the Command-Line Interface” on page 2028

### Copyrights and trademarks
All rights are reserved by the individual copyright holders. Technical specifications are subject to change. Reproduction or further use of this help resp. of parts of it require the express prior authorization of ABB AG.
6.4.1.2 Configuring CODESYS

6.4.1.2.1 Introduction
Setting CODESYS options

You can configure the behavior and appearance of the CODESYS Development System in the different tabs of the "Options" dialog. The dialog opens by clicking "Tools ➔ Options". Here you can configure the default settings for different editors and functionalities. These settings apply throughout CODESYS.

The settings are stored in your current user profile on your local system. For use on other systems, option settings, either user-specific or machine-specific (computer), can be exported to an XML file.

In V3.5 SP13 and later, CODESYS checks whether an older version is already installed when the development system is started for the first time. If this is the case, then the "Import Assistant" dialog opens for transferring the CODESYS options set with the older version.

See also
● Chapter 6.4.1.21.3.9.17 “Command ‘Options’” on page 2667
● Chapter 6.4.1.21.3.9.18 “Command ‘Import and Export Options’” on page 2668
● Chapter 6.4.1.21.4.2 “Dialog ‘Import Assistant’” on page 2745
● Chapter 6.4.1.2.2.2 “Customizing menus” on page 1802
● Chapter 6.4.1.2.2.5 “Customizing keyboard shortcuts” on page 1805
● Chapter 6.4.1.2.2.3 “Customizing toolbars” on page 1804

6.4.1.2.2 Customizing the user interface

Introduction

In CODESYS, you can customize the user interface by changing the window layout as well as the appearance of menus and commands according to your requirements.

Customizing menus

You can customize the menu commands of the CODESYS user interface. In a configuration dialog, you can add or remove menus.

Removing menus and commands

1. Choose the command “Tools ➔ Customize”.
   ⇔ The "Customize" dialog box opens. The "Menu" tab is visible.
2. Select a menu in the menu tree or a command in a menu.
3. Click “Delete”.
   ⇔ The menu or command is deleted from the menu tree.
4. Click “OK”.
   ⇔ The dialog box closes and the menu is customized.
Adding menus

1. Choose the command “Tools ➔ Customize”.
   ⇒ The “Customize” dialog box opens. The “Menu” tab is visible.
2. Scroll to the end of the menu tree.
3. Select the blank symbol ( ).
4. Click “Add Popup Menu”.
   ⇒ The “Add Popup Menu” dialog box opens.
5. Type a name for the new menu in the “Default text” field.
   If localization is unnecessary, then skip to step 9.
6. Click “Add Language”.
   ⇒ A drop-down list opens with available languages.
7. Choose the required language.
   ⇒ The language is added to the list of languages.
8. Click into the “Text” field and type the language-specific text.
9. Click “OK”.
   ⇒ The new menu is added at the bottom of the menu tree.
10. Change the menu order by clicking “Move up” and “Move down”. Click “OK” to close the “Customize” dialog box.

   The new menu is displayed only when it contains a command.

Adding commands

1. Choose the command “Tools ➔ Customize”.
   ⇒ The “Customize” dialog box opens. The “Menu” tab is visible.
2. Expand the branch of the menu where the new command should be added.
3. Select the blank symbol ( ).
4. Click “Add Command”.
   ⇒ The “Add Command” opens dialog box.
   The dialog box lists all commands grouped by category.
5. Select the command to be added. Click “OK”.
   ⇒ The new command is added to the menu tree.
6. Change the menu order by clicking “Move up” and “Move down”. Click “Add separator” to add a border between commands. Click “OK” to close the “Customize” dialog box.
   ⇒ The new command is now available in the menu.

See also

- Chapter 6.4.1.21.4.15.2 “Dialog ’Customize’ - ’Menu’” on page 2801
- Chapter 6.4.1.2.2.3 “Customizing toolbars” on page 1804
Customizing toolbars

You can customize the toolbars of the CODESYS user interface. In a configuration dialog, you can add or remove toolbars.

Removing toolbars and commands

1. Choose the command “Tools ➔ Customize”.
   ⇒ The “Customize” dialog box opens.
2. Choose the “Toolbars” tab.
3. Select a toolbar or a command from a toolbar tree.
4. Click “Delete”.
   ⇒ The toolbar or command is deleted.
5. Click “OK”.
   ⇒ The dialog box closes and the toolbar or command is removed.

Adding toolbars

1. Choose the command “Tools ➔ Customize”.
   ⇒ The “Customize” dialog box opens.
2. Choose the “Toolbars” tab.
3. Select the blank toolbar.
4. Click “Add Toolbar”.
   ⇒ The cursor blinks in the new toolbar.
5. Type a name.
6. Change the toolbar order by clicking “Move up” and “Move down”. Click “OK” to close the “Customize” dialog box.

   CODESYS displays the new toolbar only when it contains a command.

Adding commands

1. Choose the command “Tools ➔ Customize”.
   ⇒ The “Customize” dialog box opens.
2. Choose the “Toolbars” tab.
3. Expand the tree of the toolbar where the new command should be added.
4. Select the blank symbol ( ).
5. Click “Add Command”.
   ⇒ The “Add Command” dialog box opens.
   The dialog box lists all commands grouped by category.
6. Select the command to be added. Click “OK”.
   ⇒ The new command is added to the toolbar tree.
7. Change the toolbar order by clicking “Move up” and “Move down”. Click “Add separator” to add a border between commands. Click “OK” to close the “Customize” dialog box.

⇒ The new command is available in the toolbar.

See also

- § Chapter 6.4.1.21.4.15.4 “Dialog 'Customize' - 'Toolbars'” on page 2802
- § Chapter 6.4.1.2.2.2 “Customizing menus” on page 1802

**Customize command icon**

CODESYS provides the capability of assigning customized icons to commands.

1. Select the command “Tools ➤ Customize”.
⇒ The “Customize” dialog box opens.

2. Click the “Command icons” tab.

3. Select the category “Help” from the list on the left.
⇒ All commands in this category are listed on the right.

4. Select the command “Information”.

5. Click “Assign”.
⇒ A dialog box opens for selecting the icon file (*.ico).


7. Click the “Open” button.
⇒ The icon is assigned to the selected command.

8. Click “OK”.

See also

- § Chapter 6.4.1.21.4.15.3 “Dialog 'Customize' - 'Command Icons' ” on page 2801

**Customizing keyboard shortcuts**

CODESYS provides the capability of executing commands directly via keyboard shortcuts. You can customize or extend predefined keyboard shortcuts.

1. Choose the command “Tools ➤ Customize”.
⇒ The “Customize” dialog box opens.

2. Choose the “Keyboard” tab.

3. Select the category “Help” from the list on the left.
⇒ All commands in this category are listed on the right.

4. Select the command “Search”.

5. Click into the field “Press Shortcut Keys”.

6. Press [Ctrl]+[Shift]+[S].
⇒ CODESYS adds the key combination to the field.
7. Click “Assign”.
   ⇒ The keyboard shortcut is assigned to the command.

8. Click “OK”.
   ⇒ You can call the “Search” command by pressing [Ctrl]+[Shift]+[S].

See also
● Chapter 6.4.1.21.4.15.5 “Dialog Box ‘Customize’ - ‘Keyboard’ ” on page 2802

Changing the window layout

In CODESYS, you can easily customize the layout of different views to your individual needs.

1. Drag the view by the caption bar or by the tab.
   ⇒ Arrows are shown to mark possible destinations. Example: 

2. Drag the view to one of the arrows.
   ⇒ The destination is displayed as a blue-shaded area.

3. Release the left mouse button.
   ⇒ The window is inserted into the selected destination.

   The window can also be placed outside of the CODESYS programming interface.

See also
● Chapter 6.4.1.2.2.7 “Resizing windows” on page 1806
● Chapter 6.4.1.2.2.8 “Auto-hiding windows” on page 1807
● Chapter 6.4.1.2.2.9 “Switching between windows” on page 1807

Resizing windows

1. Move the mouse pointer over the border between two windows or views.
   ⇒ The cursor becomes a left-right arrow.

2. Drag the border to another position.

   You can resize detached views by moving the frame lines.

See also
● Chapter 6.4.1.2.2.6 “Changing the window layout” on page 1806
● Chapter 6.4.1.2.2.8 “Auto-hiding windows” on page 1807
● Chapter 6.4.1.2.2.9 “Switching between windows” on page 1807
Auto-hiding windows

Hiding windows
When you hide a view, it is minimized to a tab in the frame of the user interface. When you move the pointer over the tab, the window is shown automatically.

1. Click into the window to be hidden.
2. Click “Window ➔ Auto Hide”.
   Or click the PIN symbol (ציג) in the upper right corner of the view.
   ⇒ The window is hidden and only visible by a small tab on the edge of the main window.
3. Move the mouse pointer over the tab.
   ⇒ The window is shown as long as the mouse pointer hovers over the tab.

Showing windows

1. Click the tab of the hidden window.
2. Clear the check box “Window ➔ Auto Hide”.
   Or click the PIN symbol (การออกแบบ) in the upper right corner of the view.
   ⇒ The window is permanently shown.

See also
● § Chapter 6.4.1.2.2.6 “Changing the window layout” on page 1806
● § Chapter 6.4.1.2.2.7 “Resizing windows” on page 1806
● § Chapter 6.4.1.2.2.9 “Switching between windows” on page 1807

Switching between windows

It is possible to switch directly between the currently opened views and the editor windows.
1. Press the keystroke combination [Ctrl]+[Tab]. Continue pressing the [Ctrl] key.
   ⇒ An overview opens with all active views and editors.
2. Continue pressing the [Ctrl] key and select a window using the arrow keys.
   ⇒ The selected view or editor is activated.

See also
● § Chapter 6.4.1.2.2.6 “Changing the window layout” on page 1806
● § Chapter 6.4.1.2.2.7 “Resizing windows” on page 1806
● § Chapter 6.4.1.2.2.8 “Auto-hiding windows” on page 1807
6.4.1.3 Creating and Configuring a Project

6.4.1.3.1 Introduction

What is a project?

- A project contains the objects which are necessary to create a controller program ("application"):
  - Pure POUs, for example programs, function blocks, functions, and GVLs.
  - Objects that are also required to be able to run the application on a PLC. For example, task configuration, Library Manager, symbol configuration, device configuration, visualizations, and external files.
- In a project, you can program multiple applications and connect multiple controller devices.
- CODESYS manages device-specific and application-specific POUs in the "Devices" view ("device tree") and project-wide POUs in the "POUs" view.
- For the creation of projects, there are templates that already contain certain objects.
- Basic configurations and information for the project are defined in the "Project Settings" and "Project Information". For example:
  - Compiler settings
  - User management
  - Author
  - Data about the project file

There are settings for the version compatibility of the project in the configuration dialogs in the "Project Environment".

- You save a project as a file in the file system. As an option, you can pack it together with project-relevant files and information into a project archive. It is also possible to save files in a source code management system such as SVN.
- Each project contains the information about the CODESYS version with which it was created. When you open it in another version, CODESYS will notify you about possible or necessary updates regarding file format, library versions, etc.
- You can compare, import/export projects, and create documentation for them.
- You can protect a project from being changed, or even completely protect it from being read. By using user management, you can selectively control the access to the project and even to individual objects in the project.

- Chapter 6.4.1.21.2.2 "Object 'Application'" on page 2410
- Chapter 6.4.1.21.2 “Objects” on page 2409
- Chapter 6.4.1.21.4 “Dialogs” on page 2745
- Chapter 6.4.1.21.3.5.13 “Command ‘Project information’” on page 2604
- Chapter 6.4.1.6 “Protecting and Saving Projects” on page 1819

6.4.1.3.2 Opening a V3 Project

You can open projects, library projects, or project archives in CODESYS which have been created with different installations. When a project is opened, it is automatically checked whether or not the active installation is appropriate to load the project. At this time, deficiencies can be detected, such as missing add-ons or deprecated installations. You can correct these deficiencies. Then you can load the project with an appropriate installation.

The following actions are possible to correct deficiencies:

- Update existing add-ons and install missing add-ons
- Start another installation which is appropriate for the project
- Install an additional CODESYS version with the appropriate state

Moreover, you can load and read write-protected projects. You have to specify an appropriate location where you have the necessary write permissions only when you save the file.
Loading a project with access restrictions

You can load restricted projects only if you have the access credentials, such as user name and password.

Loading a project with a security key

You have selected a project which is protected by a security key. If the security key is not plugged into the computer, then you are prompted to plug it in. Otherwise CODESYS opens the project without any information about the protection.

Loading a backup of a project

Backups are created when the “Automatically save” project option is selected. When CODESYS is not ended properly after a change, the project is saved as a backup.

When you have selected a project, the “Auto Save Backup” dialog opens first when loading. There you can handle the backup.

See also

- Chapter 6.4.1.3.3 “Opening a V2.3 project” on page 1809
- Chapter 6.4.1.21.4.14.17 “Dialog ‘Options’ – ‘Load and Save’” on page 2791
- Chapter 6.4.1.6.2 “Setting up write protection” on page 1823
- Chapter 6.4.1.6.3 “Assigning Passwords” on page 1824
- Chapter 6.4.1.21.3.2.2 “Command ‘Open Project’” on page 2553

See also

- Help on CODESYS Installer

6.4.1.3.3 Opening a V2.3 project

A CoDeSys V2.3 project can be converted into a CODESYS V3 project only if the CODESYS V2.3 Converter package is installed in CODESYS V3. The package is available in the CODESYS Store.

Requirement: CODESYS is started (or a project is already open). You should be aware of the restrictions described below the following instructions.

1. Click “File ➔ Open Project”.

2. In the “Open Project” dialog, click any CoDeSys V2.3 project or project archive in the file system. For searching, you can set the file filter on the bottom right corner of the dialog.
   - If another project is still open, CODESYS instructs you to close it accordingly. After that the CoDeSys V2.3 converter automatically starts.

3. The V2.3 converter checks that the project can be compiled without errors. If so, then it processes the project automatically.

4. NOTE: If the project contains visualization objects with placeholder variables that the converter cannot resolve, the respective visualizations are shown as a group in place of the visualization references.

5. Device conversion: When a device (target system) is referenced in the project to be opened and no conversion rules are defined for the device, then the “Device Conversion” dialog opens. Specify here whether and how the converter should replace the previous device reference with a current one.
   - For replacement, the converter added the new device in the place of the old one in the device tree of the converted project.
6. **Library conversion**: if a library, for which no conversion rule has so far been defined, is referenced in the project to be opened, then the “Conversion of Library Reference” dialog opens. Specify here whether and how the converter should replace the existing library reference with a current one. If you select a library for which the project information is missing, then the “Enter Project Information” dialog opens in order to specify this information.

⇒ The converter loads the adapted project. Note: The redefined library references are to be found in the global Library Manager in the POUs view.

| **Compilaton** | The project has to be compilable without errors in CoDeSys V2.3. Note: CODESYS stills issues warnings in V3 when compiling. These are caused by implicit conversions, which can lead to a loss of information (for example through sign changes). CODESYS checks "case" statements against the switch variable: CASE USINT OF INT is not checked in CoDeSys V2.3, but it issues an error message when imported into V3. |
| **Controller configuration** | The "Controller Configuration" of a CoDeSys V2.3 project cannot be imported into V3. You have to recreate the device configuration and re-declare the variables used in the controller configuration. |
| **Network variables** | For network variables, CODESYS creates V3 GVL objects and imports the variable declarations. However, the network properties are not imported. See the description of the network variable exchange for this. |
| **Libraries** | All variables and constants that are used in a library also have to be declared in the library. It must be possible to compile the library in CoDeSys V2.3 without errors. |
| **Syntactic and semantic restrictions since CoDeSys V2.3** | ● FUNCTIONBLOCK is not a valid keyword instead of FUNCTION_BLOCK. ● TYPE (declaration of a structure) must be followed by a “:”. ● ARRAY initialization** must have parentheses. ● INIT is no longer supported (you have to replace this in the code by the Init method). ● In function calls it is no longer possible to mix explicit with implicit parameter assignments. Therefore the order of the parameter input assignments can be changed:
  
  ```
  fun(formal1 := actual1, actual2); // -> error message
  fun(formal2 := actual2, formal1 := actual1); // same semantics as the following line:
  fun(formal1 := actual1, formal2 := actual2);
  ```
  ● CoDeSys V2.3 pragmas are not converted. They produce an warning in V3.
  ● The TRUNC operator now converts to the data type DINT instead of INT. CODESYS automatically adds a corresponding type conversion for a CoDeSys V2.3 import. |
<p>| <strong>Visualization</strong> | | | |
| <strong>Placeholders and their replacement</strong> | Placeholders | VAR_INPUT | Usage | Replacement |
| | PLC_PRG.$Local Var$.aArr[0] | localVar: MyStruct; localVar.aArr[0] | localVar := PLC_PRG.myStructVar |</p>
<table>
<thead>
<tr>
<th>$Var$.aArr[0]</th>
<th>Var : MyStruct; Var.aArr[0]</th>
<th>Var := PLC_PRG.myStructVar</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLC_PRG.myStructVar.aArr[$Index$]</td>
<td>Index : INT; PLC_PRG.myStructVar.aArr[Index]</td>
<td>Index := 0</td>
</tr>
</tbody>
</table>

### Problematic placeholders

- **Placeholders within a text:**
  - Text: $axle$-Axis
  - Correction: localVar : STRING;
  - Text: %s-Axis
  - Text variable: localVar

- **Placeholder describes only one part of a variable name:**
  - axis$axis$spur$spur$.fActPosition
  - Correction: Define only one placeholder for the axis$axis$spur$spur$ placeholder. axis_spur : MyFunctionBlock;
  - Then directly transfer the corresponding instance of the function block. axis_spur := PLC_PRG.axis1spur2;

- **Placeholder is replaced by an expression:**
  - $Expression$ -> PLC_PRG.var1 + PLC_PRG.var2
  - Correction: You must transfer the expression to an auxiliary variable and then transfer this auxiliary variable as an instance.

- **The placeholder describes a program name:** $Program$.bToggle -> PLC_PRG.bToggle
  - The converter cannot transfer this form of setting placeholders in V3. However, you will rarely use it in practice.

- **Placeholder is replaced by different types:**
  - $Var$
  - -> replacement 1: PLC_PRG.n (INT)
  - -> replacement 2: PLC_PRG.st (STRING)
  - Correction: Define two different placeholders in the interface for this.

- **The visualization is located in a library. You replace the placeholder later from any desired project when you use the visualization there.**
  - Correction: Here you have to replace the TYPE_NONE data types manually. However, there is also the possibility for you to integrate the library in a project and the placeholder is correctly replaced. If you now import this project, the data type is also determined correctly in the library.

### Non-importable elements:

- Trend, ActiveX – the import is not possible, because the implementation differs a great deal. In V3, a corresponding warning is issued and a corresponding manual reproduction is required.

### Programming languages:

- ST, IL, FBD:
  - No restrictions
LD: CODESYS imports function blocks with parallel branches in such a way that the part before the branch is repeated for each branch. This corresponds to the generated code that CoDeSys V2.3 creates for parallel branches.

SFC: ● Step variables explicitly declared by the user must be declared locally in the SFC editor. You may not declare them as VAR_INPUT, VAR_OUTPUT or VAR_INOUT, because CODESYS cannot automatically adapt the calls. Explanation: Steps no longer use Boolean variables for the management of the internal states in V3, but also structures of the type SFCStepType.
   ● Identifier: the following identifiers may not begin with an underscore character:
     – Names of IEC actions in the tree
     – Variables that are called in an IEC association list
     – Names of transitions that have been programmed out
   Explanation: In V3 the implicit variables that CODESYS creates for actions are given an underscore character as prefix. An invalid identifier with a double underscore character would result.

CFC: ● Large boxes: The layout of large boxes can lose quality due to an import. The boxes may overlap one another too much. (Correction planned).
   ● Macros: Macros cannot be imported. (Correction planned).

Chapter 6.4.1.21.2.24 “Object 'Project Information'” on page 2515
Chapter 6.4.1.21.4.5 “Dialog 'Device Conversion'” on page 2747
Chapter 6.4.1.21.4.3 “Dialog 'Library Reference Conversion'” on page 2746

6.4.1.3.4 Configuring a Project

General

You can configure your project using the following dialogs:

● “Project Settings”: Basic settings on the behaviour of editors and of the compiler, on user management etc.
   % Chapter 6.4.1.21.4.12 “Dialog 'Project Settings’” on page 2766
● “Project Information”: Adding of individual and tagging information to the project
   % Chapter 6.4.1.21.2.24 “Object 'Project Information’” on page 2515
● “Project Environment”: Defining which versions of the external and internal modules should be used, with the aim of achieving up-to-dateness and compatibility with each other.
   % Chapter 6.4.1.21.4.13 “Dialog 'Project Environment'” on page 2778
Retrieving and Editing Project Information

You can use the “Project Information” object to retrieve information about your project and the associated file, and edit certain information.

The object contains information about

- File attributes
- Meta-information, such as manufacturer, title, or author
- Properties with keys
- Statistics
- Licensing
- Signing: This way of signing translated libraries is deprecated, and for security reasons should only be used if compatibility with older versions is required. If this method is used, then later you can use a public key token to verify that the library was last signed by the library vendor. As a library vendor, it is therefore crucial that you make the public key used available to the customer, for example in the documentation.

CODESYS saves the project information as an object within the project. When you transfer a project to another system, the “Project Information” object is transferred with it. There is no need for a project archive.

You can use property keys to access the project information externally via function blocks. For a library project, you can also query information about the licensing.

Editing meta-information

1. Click “Project ➔ Project Information”.
   ⇨ The “Project Information” dialog opens.
2. Click the “Summary” tab.
3. Specify your data in the input fields (example: 0.0.0.1 in the “Version” input field).
   ⇨ CODESYS creates a property with a key for each given value and manages them on the “Properties” tab. For a library project, CODESYS still uses the properties and sorts later in the library repository.
   
   If you select the option for CODESYS to create a functions block for these properties, then you can access the properties programmatically.

Creating functions for accessing properties

1. Click “Project ➔ Project Information”.
   ⇨ The “Project Information” dialog opens.
2. Select the “Automatically generate 'Project Information' POU’s” option.

Example

<table>
<thead>
<tr>
<th>Requirement: The following property is defined.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key = nProp1</td>
</tr>
<tr>
<td>Type= number</td>
</tr>
<tr>
<td>Value= 333</td>
</tr>
</tbody>
</table>

1. Select the “Automatically generate 'Project Information' POU’s” option.
2. Declare a property of the type DINT, for example showprop : DINT;.
3. Call the function `GetNumberProperty`: `showprop := GetNumberProperty("nProp1");`
   ⇒ You are granted access to the value in the application.

Note: The functions that are created with the “Automatically generate 'Project Information' POUs” option can be used only if the runtime supports the `WSTRING` data type. If this is not the case, then instead you can apply the “Automatically generate 'Library Information' POUs” option. You can use the functions created in this way at least in the application to access properties. These functions are not registered in the runtime.

### Licensing library projects
If your project is a library project, then you can activate the library licensing in use here. The CODESYS Security Key is a dongle.

- Requirement: The project is a library project.
  1. Click “Project ➔ Project Information”.
     ⇒ The “Project Information” dialog opens.
  2. Click the “Licensing” tab.
  3. Select the “Activate dongle licensing” option.
  4. Specify the dongle data in “Firm code”, “Product code”, “Activation URL”, and “Activation mail”.
     ⇒ The library is licensed.

### Creating private key files
1. Click “Project ➔ Project Information”.
2. Click the “Signing” tab.
3. Click the “Create Private Key File” button.
   ⇒ The “Create Private Key File” dialog opens.
4. Select a safe location, e.g. D:\for lib developers only\mycomp_libkey.libpk and exit the dialog with “Save”.

- Chapter 6.4.1.21.2.24 “Object ‘Project Information’” on page 2515

### Making project settings
You can configure settings that affect the behavior of CODESYS and that of certain editors in the “Project Settings” object. The settings are valid throughout the project and are applied immediately for active editors. You can also access the dialog boxes of the object with the command “Project ➔ Project Settings”.

CODESYS saves the project settings as an object directly in the project. If you then transfer a project to another system, the “Project Settings” object is also transferred with it, without a project archive being required.
See also

- Chapter 6.4.1.9.13.3 “Analyzing code statically” on page 1904
- Chapter 6.4.1.21.3.5.14 “Command ’Project Settings’” on page 2604
- Chapter 6.4.1.21.4.12.2 “Dialog ’Project Settings’ - ’SFC’” on page 2767
- Chapter 6.4.1.21.4.12.3 “Dialog ’Project Settings’ - ’Users and Groups’” on page 2768
- Chapter 6.4.1.21.4.12.4 “Dialog Box ’Project Settings’ - ’Compileoptions’” on page 2769
- Chapter 6.4.1.21.4.12.5 “Dialog Box ’Project Settings’ - ’Compiler Warnings’” on page 2770
- Chapter 6.4.1.21.4.12.6 “Dialog ’Project Settings’ – ’Source Download’” on page 2770
- Chapter 6.4.1.21.4.12.7 “Dialog ’Project Settings’ - ’Page Setup’” on page 2772
- Chapter 6.4.1.21.4.12.8 “Dialog ’Project Settings’ - ’Security’” on page 2772
- Chapter 6.4.1.21.4.12.9 “Dialog ’Project Settings’ - ’Static Analysis Light’” on page 2773
- Chapter 6.4.1.21.4.12.10 “Dialog ’Project Settings’ - ” on page 2776
- Chapter 6.4.1.21.4.12.11 “Dialog ’Project Settings’ - ” on page 2777

6.4.1.4 Exporting and Transferring Projects

6.4.1.4.1 General

Export and import functions are available to you for the exchange of the data from CODESYS projects with other programs.

An exchange of CODESYS projects between CODESYS development systems takes place by way of a copy of the project file (*.project) or project archive (*.projectarchive).

See also

- Chapter 6.4.1.4.2 “Exporting and importing projects” on page 1815
- Chapter 6.4.1.4.3 “Transferring Projects” on page 1816

6.4.1.4.2 Exporting and importing projects

CODESYS offers commands for the export and import of objects to and from a file. Two possibilities are available to you here:

- Export to or import from a CODESYS XML file (*.export)
  This format is completely compatible with the CODESYS project format. The objects are saved in a machine-readable XML format.
- Export to or import from an XML file in the PLCopen format (*.xml)
  You can use this format to exchange information with other programs (for example program editors or documentation tools). PLCopen XML defines a subset of the elements known in CODESYS. 100% compatibility is thus not guaranteed.

Exporting projects

Requirement: A project is open in CODESYS.

1. Select the command “Project ➔ Export…” or “Project ➔ Export PLCopenXML”
2. Select the objects that you wish to export in the dialog box “Export” or “Export PLCopenXML”.
3. Click on “OK”.
4. Enter the file name and the location and click on “Save”.

Importing projects

Requirement: A project is open in CODESYS.
1. Select the command “Project ➔ Import…” or “Project ➔ Import PLCopenXML”.
2. In the dialog box “Import” or “Import PLCopenXML”, select the export file that you wish to import.
   ⇒ A dialog box opens and displays the objects in a tree structure, which can be inserted at this point.
3. Select the object in the object tree, under which the objects to be imported are to be inserted.
4. Select the objects and click “OK”.
   ⇒ The objects are added to the existing object tree.

See also
● Chapter 6.4.1.21.4.14.20 “Dialog ‘Options’ - ‘PLCopenXML’” on page 2793
● Chapter 6.4.1.21.3.5.26 “Command ‘Export PLCopenXML’” on page 2612
● Chapter 6.4.1.21.3.5.27 “Command ‘Import PLCopenXML’” on page 2612
● Chapter 6.4.1.21.3.5.25 “Command ‘Import’” on page 2612

6.4.1.4.3 Transferring Projects

If you wish to transfer a project to another computer and connect from there to the same PLC, without an online change or download being required, observe the following points.

- Make sure that the project requires only fixed versions of libraries (exception: interface libraries), visualization profile and compiler.
- Make sure that the boot application is up to date.

Then create a project archive, which you unpack on the other computer.

Transferring a project to another system

Requirement: A project is open on computer “PC1” that you transfer to another computer “PC2” and reconnect from there to the same controller.

1. Make sure that only libraries with fixed versions are integrated in the project, with the exception of pure interface libraries. To do this, open the “Library Manager” and check all entries that have a "*" instead of a fixed version specification.
2. Make sure that a fixed compiler version is set in the project settings. To check, select “Project ➔ Project Settings” and the “Compiler Options” category.
3. Make sure that a fixed visualization profile is defined in the project settings. To check, select “Project ➔ Project Settings” and the “Visualization Profile” category.
4. Make sure that the application that is presently open is the same as that which is presently in use on the PLC. This means that the “boot application” must be identical to the project in the programming system. To check, look at the project name in the title bar of the programming system window: If an asterisk is displayed behind the name, this means that the project has been modified, but not yet saved. It is then possible that the application and boot application do not correspond!

In this case, first create a (new) boot application. It depends on the PLC and the application properties, whether this takes place automatically during the download of the application. For explicit creation, select the command “Online ➔ Create boot application”. Then execute a download with the help of the commands “Online ➔ Login” and “Online ➔ Load”.

After that, start the application on the controller with the command “Debug ➔ Start”.

⇒ Now the desired application is running on the PLC, to which you wish to reconnect from the same project later on PC2.
5. Generate a project archive: Select "File ➔ Project Archive ➔ Save/Send Archive". In the "Project Archive" dialog box, also select the following information:

- "Download information files"
- "Library profile"
- "Referenced devices"
- "Referenced libraries"
- "Visualization profile"

Save the project archive in a place that is accessible by PC2.

6. Log out from the controller: To do this, select "Online ➔ Logout". You can stop and restart the PLC without reservations, before you reconnect from PC2.

7. Extract the project archive to PC2: Select "File ➔ Project Archive ➔ Extract Archive" and open the archive saved above. In the "Extract Project Archive" dialog box, activate the same information as described above when generating the archive.

8. Open the project and log in to PLC "xy" again.

⇒ CODESYS does not demand an online change or download; the project runs.

See also
- Chapter 6.4.1.21.4.12.4 “Dialog Box ‘Project Settings’ - ‘Compileoptions’” on page 2769
- Project Settings - Visualization Profile
- Chapter 6.4.1.21.3.7.4 “Command ‘Create Boot Application’” on page 2627
- Chapter 6.4.1.21.3.2.8 “Command ‘Save/Send Archive’” on page 2557

6.4.1.5 Comparing projects
6.4.1.5.1 Introduction

You can compare the currently open project with another project – a reference project. The differences in contents, properties, or access rights are detected and shown in a comparison view.

Application example

How to compare Automation Builder projects for an AC500 V3 PLC is described in the application note Project Comparison - Compare AC500 Projects and Integrate the Differences.

Clicking “Project ➔ Compare” opens the “Project Compare” dialog for you to configure and run the comparison. Then the result is shown in the comparison view “Project Compare - Differences” where the objects are aligned in a tree structure. Objects that indicate differences from the respective reference object are identified by colors and symbols. This is how you detect whether or not the contents, properties, or access rights are different.

For differences in the contents, you can also open the detailed compare view “Project Compare - <object name> Differences” in order to zoom into the object. In the detailed compare view, the contents of the object and reference object are displayed or their source code aligned. The detected differences are marked. Previously opened views are not closed. In this way, you can have any number of comparison views open and read them, in addition to the project compare view.
You can accept the detected differences from the reference project into the current project. This is possible only from the reference project into the open project. To do this, you activate differences (for example in the code) that should be accepted in the current project with the commands \( \checkmark \), \( \checkmark \), or \( \checkmark \) in the active comparison view for accepting. These positions are highlighted in yellow. Make sure that any other open compare views are inactive (write-protected, read-only). Therefore, you can activate differences to be accepted in exactly one comparison view only. When exiting the active compare view, if you confirm that the differences that are activated for acceptance are actually accepted into the current project, then the current project is modified.

In order to exit the project comparison completely, close the project compare view.

### 6.4.1.5.2 Creating a comparison view

**Requirement:** You have made changes in your current project and wish, for example, to compare it with the last-saved version. In the meantime, for example, you have added further POUs, removed a POU, changed single lines of code or the object properties in function blocks.

1. Select the command “Project ➤ Compare”.
   - The “Project Comparison” dialog box opens.
2. Enter the path to the reference project, for example the path to the last-saved version of your current project.
3. Leave the activation of the comparison option “Ignore Spaces” as it is.
4. Click on “OK”.
   - The comparison view opens. Title: “Project Comparison – Differences”. The Device trees of the current project and the reference project are displayed alongside each other and the changed objects are marked in color.
5. Select an object marked in blue in the tree of the reference project (right). The current project no longer contains this object.
   - Click on “Accept Single”.
   - The object is added to the tree of the current project (left). The line has a yellow background. \( \checkmark \) appears in the middle column.
6. Select an object marked in green in the tree of the current project (left). The reference project does not contain this object.
   - Click on “Accept Single”.
   - The object is removed again from the tree of the current project (left). The line has a yellow background. \( \checkmark \) appears in the middle column.
7. If changes are detected in the content of an object that is contained in both the current project and the reference project, this is indicated by red lettering. You can then switch to the detailed comparison view for the object by double-clicking on the object.
8. Close the comparison view and answer the query whether the changes made are to be saved with “Yes”.
   - The changes become effective in the project.

### 6.4.1.5.3 Opening the detailed compare view

**Requirement:** For example, a user modified the code in a POU of the current project. You have performed the project comparison by clicking “Project ➤ Compare”. The project compare view shows this POU highlighted in red in the aligned in the project tree.

1. Double-click the line of the aligned POU versions.
   - The compare view switches to the detailed compare view of the POU. The modified code lines are highlighted in gray and written in red.
2. Click  
   ⇒ Code lines with changes (red) are extended by two lines: an line with insert (left, 
green) and a line with delete (right, blue).
3. Click  
   ⇒ The code line is marked again as modified.
4. Move the mouse pointer to the code line marked as modified and click ✔“Accept Single”.  
   ⇒ The code line from the reference project is activated for acceptance into the current 
project.
5. Click . 
   ⇒ The project compare view opens for the entire project. It is write-protected (read-only) 
to prevent you from activating differences for acceptance. The link highlighted in 
yellow above the tree view also indicates this.
6. Click the link: “Project compare view is read only because there are uncommitted changes 
in another view. Click here to switch to the modified view.” 
   ⇒ The detailed compare view opens again. The unconfirmed changes are highlighted in 
yellow.
7. Click × in the tab of the view and confirm that the changes should be saved.  
   ⇒ The detail project view is closed and the POU is overwritten. Now it corresponds to 
the POU of the reference project. The project view is active again so that you can 
continue working with project compare.

If you do not click the link, but click × instead to close the editor of the project 
compare view, then you will also confirm the acceptance of changes into the current project. The detail changes are accepted and then the project compare 
is closed completely.

See also
- ✔ Chapter 6.3.1.1.7 “Comparing projects” on page 1405
- ✔ Chapter 6.4.1.21.3.5.21 “Command ‘Compare’” on page 2607
- ✔ Chapter 6.4.1.5.2 “Creating a comparison view” on page 1818

6.4.1.6 Protecting and Saving Projects

6.4.1.6.1 Introduction

You can protect a project against unintentional changes by means of access and write protection. You can also provide it with read protection (knowledge protection).

Write protection:
The following options are available for providing the entire project with simple write protection:
- Select the “Open Read-Only” option when opening the project.
- You set the “Released” status in the “Project Information”.
- You select the “read-only” option in the properties of the project file in the local file system.

In order to protect only certain objects in a project against changes, or to allow access only to certain users, you can use a user and access rights management (see below). Some target devices similarly support user and rights management. The access of CODESYS to objects and files of the target device can thus be restricted.

However, write protection and access protection do not serve as protection of expertise of the POUs. Both CODESYS itself, automation platform plug-ins and persons with knowledge of the project file format can view or modify function blocks created with CODESYS.

Knowledge protection:
Knowledge protection of a project is done by encrypting the project file. Either with a project password, the CODESYS Security Key (dongle), or a certificate. We recommend protection by means of the key or the certificate because in this case no secret needs to be shared between authorized users. The desired type of project encryption is enabled in the project settings.

You can attain knowledge protection of a library by providing it as a target-system-independent "protected library" (*.compiled-library, *.compiled-library-v3). The library file no longer contains source code in this format, but only encrypted precompile context. The compiler is still able to interpret these data. Whether access by other CODESYS components or additional plug-ins is possible depends on their functionality and is to be observed in individual cases. Signing can increase protection even more.

Knowledge protection and copy protection of a boot application can be done by means of a runtime system dongle (simple or licensed) or encryption with a certificate. One of these options is enabled in the object properties of the application.

See also
- “User management and password manager” on page 1821
- Chapter 6.4.1.6.4 “Protecting Projects Using a Dongle” on page 1825
- Chapter 6.4.1.6.3 “Assigning Passwords” on page 1824
- Chapter 6.4.1.6.6 “Protecting Objects in the Project by Access Rights” on page 1826
- Chapter 6.4.1.17.3 “Information for Library Developers” on page 2035
- Chapter 6.4.1.9.18 “Protecting an application” on page 1915

In CODESYS, projects and applications can be encrypted with certificates and signed in order to protect them from unauthorized access.

To do this, you can configure specific security settings for each individual user profile. These settings are always used automatically when the user works with CODESYS projects. Therefore, they do not have to be redone for each project. The general configuration of the security features for a user profile is done in the “Security Screen” view of CODESYS. See the individual instructions below.

You can also encrypt a project file or an application for download or online change directly with a certificate:
- User-independent encryption for the current project is configured in the “Security” category of the “Project Settings”.
- User-independent encryption of the application is configured in the “Properties” dialog of the application object.

**NOTICE!**
When you encrypt a project, an application, or online code with a certificate, you will always require the certificate with a private key in order to open the object again.

*If the CODESYS Security Agent add-on product is installed, then the “Security Screen” view provides an additional tab: “Devices”. This allows for the configuration of certificates for the encrypted communication with controllers.*

**Certificates, Windows Certificate Store**
All available certificates are located in the Windows Certificate Store (“certmgr”) on your computer. There are two types of keys:
- Certificates with private keys
  - for file decryption
  - for digital signatures
- Certificates with public keys
  - for file encryption
  - for verifying digital signatures
The local Windows Certificate Store is usually filled with certificates by the IT administrator of the computer. Certificates are either created using special tools or the creation is requested by a trusted certification authority (CA).

If you receive a certificate file that you need to install yourself in the Windows Certificate Store, then double-click the file in the store directory. Depending on the type (certificate with private or public key only), the appropriate import wizard will appear.

See also

- Chapter 6.4.1.19.2 “General Information” on page 2039
- Chapter 6.4.1.6.8 “Encrypting Projects with Certificates” on page 1829

User accounts with different rights can be managed in CODESYS. For each account you can define the actions with which the user can access a project object.

The user management is configured in the “Project settings” in the category “Users and Groups”.

Before the creation of users and groups, please note the following:

- Rights can only be assigned to user groups. Therefore, you must assign each user to a group.
- There is automatically always a group 'Everyone' and by default every user and every other group is initially a member of this group. Thus each user account is automatically equipped with at least the defined standard rights.
  You cannot delete the group 'Everyone', you can only rename it, and you cannot remove members from this group.
  Caution: by default "Everyone" does not have the right to change the current user, group and rights configuration!
- There is automatically always a group 'Owner' containing a user 'Owner'. From V3.5 only the 'Owner' initially has the right to change the current user, group and rights configuration in a new project! Hence, only 'Owner' can assign this right to another group.
  Initially the 'Owner' can log in with user name 'Owner' and an empty password. You can add further users to the group 'Owner' or remove users from it, but at least one member must be retained. Like 'Everyone', you cannot delete the group 'Owner' and it always possesses all access rights. This prevents a project from being rendered unusable by denying all access rights to all groups.
  You can rename both the group 'Owner' and the user 'Owner'.
- If the programming system or a project is restarted, no user is initially logged in to the project. However, the user can then log in via a certain user account with user name and password in order to obtain the access rights defined for the account.
- Each project has its own user management! Therefore, in order to obtain certain access rights to a library integrated into the project, for example, the user must explicitly log in to the library project.
  Users and groups defined in different projects are not the same, even if they have the same names.
- A user management in a project only makes sense if it is connected with corresponding rights assignment for the access to project and objects. The project rights are generally managed in the dialog box “Rights” of the “User Management”. You can also change the access rights to an individual project object on the “Access control” tab of the “Properties” of the object.
- There are standard menu commands under “Project ➔ User Management” for logging into and out of a project as a defined user. A password manager permits the management of the login data on your computer.

From V3.5 only the 'Owner' initially has the right to change the current user, group and rights configuration in a new project! Hence, only 'Owner' can assign this right to another group.
NOTICE!
CODESYS stores the user passwords inaccessibly. If you forget a password, the user account becomes unusable. If you forget the 'Owner' password, the entire project may become unusable!

Password manager
The password manager enables you to save login data records that you enter during the login procedures for projects. It is accessible via a button in the login dialog box and offers fast access to the login data currently required. This can be helpful, for example, if you are working in parallel on several library projects that are protected by different passwords.

The password manager itself is protected by an individual master password. If you wish to use the password manager for the first time, CODESYS requests you to define this password in the password manager configuration dialog box. CODESYS notes the master password until you terminate the current CODESYS session. You must always input the password when you wish to log in to the password manager for the first time during a new session, or after you have changed it.

See also
- Chapter 6.4.1.6.6 “Protecting Objects in the Project by Access Rights” on page 1826
- Chapter 6.4.1.6.7 “Logging in via User Account and Password Manager” on page 1827
- Chapter 6.4.1.11.4 “Handling of Device User Management” on page 1971

Rights management
Rights management for access to a project and objects in a project is necessary in order to make a user management meaningful.

The rights for a project are generally managed in the “Rights” editor of the “User Management”. You can also change the access rights to an individual project object on the “Access control” tab of the “Properties” dialog box of the object.

Before assigning rights, please observe the following:
- In a new project CODESYS always sets all rights for the execution of actions on objects with the default value 'allowed' (standard right). The only exception to this is the right to change the current user, group and rights configuration. Initially only the 'Owner' group has this right.
- If you are member of a group that is permitted to change rights, you can do this at any time for each right when working further on a project. You change a right by switching between 'allowed' and 'forbidden' or by resetting to the default.

See also
- Chapter 6.4.1.6.5 “Setting up a user management” on page 1825
- Chapter 6.4.1.6.6 “Protecting Objects in the Project by Access Rights” on page 1826

Filing, saving
Provide the project file with the desired protection before saving it in the file system; see above. For a read-only project file you are given various options so that you can still save the file, depending on the type of write protection.

If the project is to be opened later in an older CODESYS version, it makes sense to save the project for precisely this version (file type), since CODESYS will also inform you immediately about possible losses of data in the course of saving it.

If you wish to save library projects, please observe the rules for the creation of libraries. Also consider the possibility of installing a library directly in a library repository.

If you wish to continue to use a project on another computer, it makes sense not only to save the project file, but also to create a project archive from all relevant auxiliary files.

You can make a setting so that a backup copy of this project is created each time the project is saved. In addition you can configure CODESYS so that projects are generally automatically saved at certain time intervals.

If you wish to keep projects in a source control system, observe the corresponding add-ons for CODESYS. For example, the link to SVN is supported.
See also

- Chapter 6.4.1.21.4.17 “Dialog ‘Options’ – ‘Load and Save’” on page 2791
- Chapter 6.4.1.4 “Exporting and Transferring Projects” on page 1815
- Chapter 6.4.1.6.9 “Saving the Project” on page 1831
- Chapter 6.4.1.6.10 “Saving/Sending the project archive” on page 1832
- Chapter 6.4.1.17.3 “Information for Library Developers” on page 2035
- Chapter 6.4.1.6.11 “Linking a project to the source control system” on page 1833

6.4.1.6.2 Setting up write protection

A project can be protected against inadvertent changes by means of access and write protection. In addition, however, it can also be provided with read protection (know-how protection).

You have the following options:

Open the project with write protection

Requirement: No project is opened.

1. Select “File → Open Project”.
   - The dialog box “Open project” appears.
2. Select the project.
3. Click on the arrow button next to the “Open” button and select “Open read-only” from the menu.
   - CODESYS opens the project. At the top right in the main window a line appears “Project file cannot be saved...”. You must now select one of the offered options if you wish to save the project file.

- Chapter 6.4.1.3.2 “Opening a V3 Project” on page 1808

Providing projects with the attribute 'Released'

Requirement: project is opened.

1. Select “Project → Project Information”, then the “Summary” tab.
2. Activate the option “Released”, confirm with “OK”.
3. Save the project, for example with [Ctrl]+[S].
4. Open the project again with the command “File → Open Project”.
   - CODESYS opens the project. At the top right in the main window a line appears “Project file cannot be saved...”. You can now directly remove the status “Released” again via the offered option if you wish to save the project file.

- Chapter 6.4.1.21.2.24 “Object ‘Project Information’” on page 2515
Providing a project in the file system with the property 'Read-only'

Provide the project file in its local file system with the property attribute 'Read-only'.

⇒ If you had already opened the project and you now attempt to save it under the same name, a dialog box appears informing you about the existent write protection. This dialog box provides you with the following options:

You can save the project under another name or another path using the button “Save As…”.

You can deliberately save the project under the same name and path and thus overwrite the existing version in the file system using the button “Overwrite”.

You can abort the saving procedure using the “Cancel” button, for example to remove the write protection on the disk.

If you re-open the project, a line appears at the top right in the main window 'The project cannot not be saved...'. You must now select one of the offered options if you wish to save the project file.

● “General information about write and access protection” on page 1819

6.4.1.6.3 Assigning Passwords

Requirement: The project is open.

1. Click “Project ⇒ Project Settings” and then select the “Security” category.

⇒ The dialog “Project Settings / Security” opens.

2. Select the “Encryption” option.

⇒ The option fields “Password”, “Dongle”, and “Certificates” are selectable.

3. Select the option “Password”.

⇒ The input fields for the encryption password appear.

4. Enter the encryption password in the input field “New Password”.

5. Enter the encryption password for confirmation in the input field “Confirm new password”.

6. Click “OK”.

⇒ CODESYS saves the encryption password for the project. You must enter this password in order to be able to open the project again, even if it is to be loaded as a library reference.

CAUTION!

If you no longer know the encryption password, you can no longer open or restore the project!

See also

● “Chapter 6.4.1.6 “Protecting and Saving Projects” on page 1819
6.4.1.6.4 Protecting Projects Using a Dongle

Requirement: The project is opened and you have connected the CODESYS Security Key (dongle) to your computer.

1. Click “Project ➔ Project Settings” and then select the “Security” category.
   ⇨ The dialog “Project Settings / Security” opens.
2. Select the “Encryption” option.
   ⇨ The option fields “Password”, “Dongle”, and “Certificates” are selectable.
3. Select the option “Dongle”.
   ⇨ The dialog with the drop-down list “Registered Dongles” and the buttons “Add”, “Remove”, “Comment” and “Flash” opens.
4. Click “Add”.
   ⇨ The “Add Registered Dongle” dialog opens.
5. Select the CODESYS Security Key (dongle) from the “Dongle” drop-down list and optionally enter a comment.
6. Click “OK”.
   ⇨ The added dongle is listed in the list “Registered Dongles”.
7. Click “OK”.
   ⇨ The dongle is registered for the project. You must connect the dongle to your computer in order to be able to open the project again, even if it is to be loaded as a library reference.

NOTICE!
If the CODESYS Security Key registered for the project is lost, you can no longer open the project or restore it.

See also
- Chapter 6.4.1.2.14.12.8 “Dialog ‘Project Settings’ - ‘Security’” on page 2772
- Chapter 6.4.1.6 “Protecting and Saving Projects” on page 1819

6.4.1.6.5 Setting up a user management

With the help of the integrated user management, user groups with different access rights and authorizations can be defined. Configuration and handling of the user management in Automation Builder and a AC500 V3 is described in the application note User Management with V3 - Configuration and Handling.

This concerns a user management for a CODESYS project file. Visualizations and devices can have their own user management.

The following guide describes how you can adapt the user management for the first time in a project. It deals with the definition of a user and a group to which he belongs.

Requirement: the project for which the user management is to be set up is opened. There is no adapted user configuration yet.
1. Select “Project Settings ➔ Users and Groups” and then the “Users” tab. The user Owner is already created by default.

2. Click on “Add”.
   ⇒ The dialog box “Add User” appears.

3. Enter a login name, for example 'Dev1', and a password. Leave the option “Activated” activated. Click on “OK”.
   ⇒ On creating a group for the first time, CODESYS now requests you to authenticate yourself to perform this action.
   
   In this case, enter 'Owner' as the “current user”. Do not enter a “password”, just click on “OK”.
   
   The user Dev1 appears in the list and is automatically a member of the group 'Everyone'.

4. Change to the tab “Groups”, in order to add the user to a new group.
   ⇒ The groups Everyone and Owner have already been created.

5. Click on “Add” in order to open the dialog box “Add Group”.

6. Specify at least one name for the new group, for example 'Developers'. Activate the checkbox next to the entry “User 'Dev1’” in the field “Members”. Click on “OK”.
   ⇒ The group “Developers” now appears with has user member 'Dev1'.

7. Switch to the “Users” tab.
   ⇒ The user “Dev1” now appears as a member of the groups 'Everyone' and 'Developers'.

You can take over the user management configuration from another project by using the “Export/Import” functions in the dialog box “Project Settings”, category “Users and Groups”.

See also
● § Chapter 6.4.1.6 “Protecting and Saving Projects” on page 1819
● § “User management and password manager” on page 1821
● § Chapter 6.4.1.21.4.12.3 “Dialog ‘Project Settings’ - ‘Users and Groups’” on page 2768
● § Chapter 6.4.1.11.4 “Handling of Device User Management” on page 1971

6.4.1.6.6 Protecting Objects in the Project by Access Rights

Protection of individual objects by setting access rights in the “Rights” editor

1. Select “Project ➔ User Management ➔ Rights”
   ⇒ The window of the “Rights” editor opens. On the left you can see the action categories, on the right the currently existing user groups.

2. Expand the relevant action category and below it the action for which you wish to change a right.

3. Select the goal of the action in the “Actions” window. In the “Rights” window, select the group for which you would like to change the right. Multiple selection is possible.
   ⇒ The buttons in the symbol bar are active.
4. Click on the appropriate button in order to change the right of the group for the action on the target object.

⇒ CODESYS updates the symbol in front of the group according to the new right. The right is immediately effective.

See also
● Chapter 6.4.1.21.4.7 “Dialog ‘Permissions’” on page 2748

Protection of individual objects by setting access rights in the object properties

Here you can configure whether the members of a group have the right to view, edit or remove the object and to add/remove child objects to/from the object.

1. Select the object in the navigator tree.
2. In the context menu, select the command “Properties” and in the dialog box select the category “Access Control”.
3. In the table under “Groups, Actions and Permissions”, double-click on the symbol of the right that you wish to change.

⇒ A selection list of the possible rights appears: “Grant”, “Deny”, “Clear”.
4. Select the desired right and click on “Accept” or “OK”.

⇒ The right is immediately effective for the action and group. The symbol changes accordingly.

See also
● Chapter 6.4.1.21.4.11.7 “Dialog ‘Properties’ - ‘Access Control’” on page 2757

6.4.1.6.7 Logging in via User Account and Password Manager

Logging in to a project without using the password manager functions

Requirement: A project is open. You wish to log in as a defined user for this project or for a library integrated in it in order to edit one or the other with certain rights. You have the required login data for the respective project or the library.

1. Select “Project ➔ User Management ➔ User Logon”.

⇒ The dialog box “Logon” opens.
2. Select the project file from “Project/Library” and enter the required access data “User name” and “Password”.
3. Log in with “OK”.

⇒ If another user is already logged in, this user will automatically be logged out by the new login.

Setting a master password for the password manager

Requirement: A project is open. The dialog box “Login” is open for you to log in as a defined user for a project or for a library integrated in the project. You wish to use the password manager in order to save login data in it.
1. Select “Project ➔ User Management ➔ User Logon”.

2. In the dialog box “Logon”, click on the button [ ].
   - If you are working for the first time with the password manager, the dialog box “Password Manager Configuration” opens.

3. Enter a character string as the future master password. Confirm it in the second line and click on “OK”.
   - CODESYS notes the master password until you terminate the current CODESYS session. You must always input this password when you wish to log in to the password manager for the first time during a new session, or after you have changed it.

**NOTICE!**
If you have forgotten your master password, you no longer have any possibility to access the login data already saved! In this case you can only reset the password manager. After that you must start again to save passwords in the manager!

---

### Saving login data in the password manager

Requirement: A project is open. You wish to log in as a defined user for this project or for a library integrated in it in order to edit one or the other with certain rights. You have the required login data for the respective project or the library. These login data have not yet been saved in the password manager.

1. Select “Project ➔ User Management ➔ User Logon”, in order to open the “Logon” dialog box.

2. Select the project file from “Project/Library”.

3. Enter the user name and password for the project or the library.

4. Click on the button [ ].
   - If you are working for the first time with the password manager, you will be requested to define a master password. Refer to the above guide ‘Setting a master password for the password manager’ for this.

   When you call the password manager for the first time in this CODESYS session, you will be requested to enter the master password.

5. Enter the master password when requested to do so.
   - The password manager menu appears.

6. Select the option “Save the credentials locally on this computer”.
   - The login takes place. The data are saved in the password manager.

### Getting the login data from the password manager

Requirement: A project is open. You wish to log in as a defined user for this project or for a library integrated in it in order to edit one or the other with certain rights. The login data required for this are already saved in the password manager.

1. Select “Project ➔ User Management ➔ User Logon” in order to open the “Logon” dialog box.

2. Click on the button [ ].
   - If you are working for the first time with the password manager, you will be requested to define a master password. Refer to the above guide ‘Setting a master password for the password manager’ for this.

   When you call the password manager for the first time in this CODESYS session, you will be requested to enter the master password.
3. Enter the master password when requested to do so.
   ⇒ The password manager menu appears.

4. Select the appropriate entry “Use the stored credentials for <user name>”.
   ⇒ The login takes place automatically with the data read from the password manager.

Opening the password manager, changing the master password

Requirement: A project is open. You wish to open the password manager in order to view and/or edit the entries or to change the master password. You have already logged in once with the master password.

1. Select “Project ➔ User Management ➔ User Logon”, in order to open the “Logon” dialog box.

2. Click on the button .
   Select “Open the Password Manager”.
   ⇒ The password manager window opens.

3. Click on “Change Master Password” and make the change.

Logging out from the project

Requirement: A project is open. A user is logged in, which is recognizable by a name entry in the field “Current User” in the status bar.

⇒ Select “Project ➔ User Management ➔ User Logoff”. Alternatively, double-click on the field “Current User” in the status bar.

⇒ If the user is logged in to only one project, he will now be logged out without further interaction. “(nobody)” appears again in the field “Current User” in the status bar.

If the user is logged in to several projects, the dialog box “Logoff” opens. There, select the specific project or library project from which the user is to be logged out.

See also
● § “User management and password manager” on page 1821
● § Chapter 6.4.1.21.3.5.28 “Command ‘User management’ – ‘Log in User’” on page 2613
● § Chapter 6.4.1.6.5 “Setting up a user management” on page 1825

6.4.1.6.8 Encrypting Projects with Certificates

Configuring a certificate for project file encryption in a user profile

When a project is encrypted with a certificate, this certificate is needed for decryption to open the project. You can assign this certificate to specific user profiles. To do this, select the certificate from the Windows Certificate Store on the “User” tab of the “Security Screen”.

1. Double-click in the status bar or click “View ➔ Security Screen”.
   ⇒ The “Security Screen” view opens.

2. In the “User” tab, select the user profile for which the communication will be encrypted. By default, the specified user profile is the one you have used on your computer to sign into Windows. You can also create a new user profile with  .

3. Click the button in the “Project file decryption” area.
   ⇒ The “Certificate Selection” dialog opens.

4. Select a certificate with a private key from the list “Available certificates in the local Windows Certificate Store”. Certificates with a private key are identified by the symbol.

5. Click .
6. The certificate is added to the upper part of the dialog.

7. Click “OK” to confirm your selection.
   ⇨ The selected certificate is displayed in the “Security Screen” in the “Project file decryption” area.

Encrypting a project with a certificate

A project encrypted with a certificate in connection with a user management allows you to restrict access to the project.

1. Click “Project ➔ Project Settings” and then select the “Security” category.
   ⇨ The “Project Settings / Security” dialog opens.

2. Select the “Encryption” option.
   ⇨ The option fields “Password”, “Dongle”, and “Certificates” are available.

3. Select the “Encryption” option.
   ⇨ The certificates available for project encryption are listed in the lower part of the dialog. If no certificate has been specified yet, then click to select a relevant certificate in the “Certificate Selection” dialog. Then return to the “Project Settings” dialog. Now the certificate is specified for encryption. Now the project can only be edited on computers of users who also have the certificate for file decryption.

Deleting a certificate in the user profile

You delete the certificate in the “Security Screen” view, either directly on the “User” tab or in the “Certificate Selection” dialog. The deletion will follow in the other dialog.

- Dialog “Security Screen”, tab “User”, “Digital Signature”, or “Project Data Decryption”: Select a certificate and click [X].
- Dialog “Certificate Selection”: in the “Security Screen” dialog, click [X] on the “User” tab. In the upper field of the “Certificate Selection” dialog, select the certificate to be deleted and click [X].

Configuring a certificate for the digital signature in a user profile

To ensure that the project is not only encrypted with a certificate, but also that its authorship and integrity can be verified, you can add a signature to the project:

1. Double-click 📢 in the status bar or click “View ➔ Security Screen”.
   ⇨ The “Security Screen” view opens.

2. In the “User” tab, select the user profile for which the digital signature will be created. By default, the specified user profile is the one you have used on your computer to sign into Windows. You can also create a new user profile with [+].

3. Click the [+] button in the “Digital signature” area.
   ⇨ The “Certificate Selection” dialog opens.

4. Select a certificate with a private key from the list “Available certificates in the local Windows Certificate Store”. Certificates with a private key are identified by the [+] symbol.

5. Click [X].
   ⇨ The certificate is added to the upper part of the dialog.

6. Click “OK” to confirm your selection.
   ⇨ The selected certificate is displayed in the “Security Screen” in the “Digital signature” area.
6.4.1.6.9 Saving the Project

Saving a project under the same name

Requirement: The project is open. The project file is not write-protected.

Select “File ➔ Save”.

CODESYS saves the project file with the current project name, which appears in the title bar of the main window. If the project has been changed since it was last saved, then the project name is provided with an asterisk. If this is set in the CODESYS options in the category “Load and Save”, then a backup copy will also be made.

4. Select add-ons to extend the memory profile in order for the add-on data to be saved.

5. To save the memory profile permanently, click “Save Profile” and specify a name in the “Enter profile name” dialog box.

6. In the “Extend Profile” dialog box, select the “Use saved profile” option and click “Yes”.

CODESYS saves the project with the saved profile.

Saving a project under a different name or format

Requirement: The project is open.

1. Select “File ➔ Save Project as”.

The “Save Project” dialog box opens.

2. Select a storage location in the file system and the desired “File Type” (project file or library file) and the desired storage version. If you want to open the project later in an older version, then it makes sense to save for precisely this version, as you will then be informed immediately in the message window about possible data loss.

If the project file is not write protected, then CODESYS saves it in the selected path. Otherwise you will be informed how to proceed.

3. If the current project contains add-ons that are not available in the selected memory format, then the “Extend Profile” dialog box opens.

4. Select the add-ons to extend the memory profile in order for the add-on data to be saved.

5. To save the memory profile permanently, click “Save Profile” and specify a name in the “Enter profile name” dialog box.

6. In the “Extend Profile” dialog box, select the “Use saved profile” option and click “Yes”.

CODESYS saves the project with the saved profile.

Saving a read-only project

Requirement: A read-only project is open.

Select “File ➔ Save”.

If the write protection was assigned in CODESYS, then it will be displayed by a line in the top right corner of the main window. Depending on the current situation you will be offered one or more of the following actions so that you can still save the project:

- “Save project under a different file name on the disk”: Always appears and continues to the “Save File” dialog box, as for the “Save File as” command
- “Exit read-only mode”: Appears if the “Open read-only” option is selected when opening the project.
“Remove read-only attribute from the project on the disk”: Appears if the project file was provided with the ‘Read-only’ property in the local file system at the time of opening.

“Remove identification ‘Released’ in the project information”: Appears only if this attribute is currently set.

If the write protection was assigned outside of CODESYS in the properties of the project file in the file system, you will be offered the following options when you attempt to save under the same name and path:

1. “Save as”: You can save under a different name as with the “Save Project as” command.
2. “Overwrite”: The write protection is removed from the project file and the file is saved under its existing name.

1. Click on the line in the top right corner of the main window that indicates the write protection.

   ⇒ The current options with which you can still save the project appear in a selection menu.

2. Select one of the options offered and perform any necessary actions.
3. Click “File ⇒ Save” or “File ⇒ Save as”.

   ⇒ The project can be saved.

**Saving of the project automatically; creating a backup copy**

Requirement: The project is open.

1. Click “Tools ⇒ Options” (category “Load and Save”).

   ⇒ The “Load and Save” dialog box opens.

2. Activate the “Create backup files” option.

3. Activate the “Automatically save every … minutes” option and select a time interval.

4. Click “OK” to close the “Options” dialog box.

   ⇒ Each time the project is saved, CODESYS also creates a backup copy <project name>.backup.

   CODESYS saves the project automatically at the specified time interval to a file <project name>.autosave in the project directory. If you open the project again after the development system was closed irregularly, then this file will be offered to you as an alternative to the file last saved by the user.

See also

- ☝️ Chapter 6.4.1.6 “Protecting and Saving Projects” on page 1819

**6.4.1.6.10 Saving/Sending the project archive**

You can configure a project archive and then save it in the file system or send it directly in an e-mail.

To send, follow the guide below as far as point 9. There, click on the button “Send” instead of “Save” in order to directly open the standard e-mail program, in which a new mail will automatically be created with the project archive file as an attachment.

**Requirement**: A project is opened.

1. Select “File ⇒ Project Archive ⇒ Save/Send Archive”.

   ⇒ The dialog box “Project Archive” appears.
2. Activate the checkbox next to each object that is to be saved in the archive.

In order to guarantee know-how protection, CODESYS will not automatically add unprotected libraries, not available as "compiled-library", to a project archive. If you explicitly select such a library in the list of additional files, you will get an appropriate warning.

3. If you want to pack further files in the archive, click on "Additional Files".
   ⇒ The dialog box "Additional Files" opens.

4. Click on "Add".

5. Select the files and click "Open".
   ⇒ The files are added to the list of additional files.

6. Click on "OK".

7. Click on "Comment".
   ⇒ The dialog box "Comment" opens.

8. Enter a comment and click on "OK".

9. Click on the button "Save".

10. Select a storage location and a file name and click on "Save".
    ⇒ The project archive is saved in the file directory.

See also
- Chapter 6.4.1.21.3.2.4 “Command ‘Save project’” on page 2554
- Chapter 6.4.1.21.3.2.5 “Command ‘Save Project as’” on page 2555

6.4.1.6.11 Linking a project to the source control system

To link your CODESYS projects to a source control system, check the following option:

The Professional Version Control add-on provides the capability of directly linking to an SVN database. You can get the package at the CODESYS Store and install it with the help of the Package Manager.

Refer to the corresponding help when using Professional Version Control.

6.4.1.7 Localizing projects

You can display your project in different languages when you create and link localization files. The localization files correspond to those of the GNU gettext system. The format of the localization template files is *.pot (Portable Object Template), from which localization files *.po (Portable Object) are generated after translation.

The project can be localized in different languages. However, editing is possible only in the original version.
You configure which categories of text information are localized in the project. Then you export these texts into a translation template. This template is a file in *.pot format (example: project_1.pot). You produce localization files in the format *.po (example: de.po, en.po, or es.po), either automatically with a corresponding external translation tool or manually with a neutral text editor. You can import the *.po files back into CODESYS and use them for localization.

The commands for using project localization are located in the menu “Project ➔ Project localization”.

See also

● Chapter 6.4.1.21.3.5.16 “Command 'Project Localization' - 'Create Localization Template'” on page 2604

Generating localization templates

Requirement: A project is open.

1. Click “Project ➔ Project Localization ➔ Create Localization Template”.
   ⇨ The “Create Localization Template” dialog box opens.
2. Activate the categories of text information that should be included in the localization template.
3. “Position information” can also be included in the template. For each text to be translated, specify its location in the project. Select the positions to be displayed in the translation template: only the first position found, all positions found, or none.
4. Click the “Generate” button.
   ⇨ The dialog box opens for saving a *.pot file to the file system. Save the localization template. Then you can process the file in a translation tool and generate localization files <language>.po in the required languages.

Format of the localization template: file *.pot

In the first line, the text categories are specified that were selected for the translation when generating the template:
Example: #: Content:Comments|Identifiers|Names|Strings: All four categories were selected.
Then each text to be translated is segmented in the form as in the following example:

Example

```
#: D:\Projects\p1.project\Project_Settings:1
msgid "Project Settings"
msgstr ""
```
Line 1: Position information displayed as source code reference. Displayed only if this has been configured when generating the translation file.
Line 2: Untranslated text as entry msgid (example: msgid "Project settings").
Line 3: Placeholder for the translation: msgstr ". Between the single straight quotation marks, the translation in the *.po file must be inserted in the respective language.

Format of the localization file: *
<language>.po

You can generate a *.po file with a translation tool or create one using a neutral text editor based on the *.pot file. For this purpose, you could change the file extension from *.pot to *.po and edit the according to *.po standard format.

It is imperative to specify the language in the form of the usual culture abbreviation in the metadata of the file (example: "Language: de" for German. Then you insert the translations of the individual texts between the straight quotation marks for the msgstr "" entries.
Example

"Language: de\n"
#: Content:Names
#: D:\projects\pl.project\Project_Settings:1
msgid "Project Settings"
msgstr "Projekteinstellungen"

Importing localization files / localizing projects

Requirement: For your project, localization files (<language>.po) were generated based on the translation template *.pot. The project is open.

1. Click “Project ➔ Project Localization ➔ Manage Localizations”.
2. Click on the “Add” button.
   → The “Open Localization File” dialog box appears for selecting a *.po file from the file system.
3. Select one of the localization files (example: <project name>-de.po).
   → The dialog box closes and the affected texts appear in the project in the respective language. For example, if you specify the translation msgstr "Main program" for the POU name "PLC_PRG" in the English localization file, then the object name "Main program" appears in the device tree.
4. In the same way, you import the localization files for other language targets.

Switching localization, adding and removing localization files

Requirement: All required language are stored in the project by importing the corresponding *.po file. The project is open.

1. Click “Project ➔ Project Localization ➔ Manage Localization”.
   → The “Manage Localization” dialog box opens. All stored localization files *-<language>.po appear in “Files”, as well as the entry “<original version>”.
2. Select the desired language and click the “Switch Localization” button.
   → The project appears in the selected language. When you select “<original version>”, the project is displayed in the original, unlocalized version and it cannot be edited.

Optional: Defining a default localization, toggling localizations

Select one of the available localizations and activate the “Default Localization” option.
→ Click “Project ➔ Project Localization ➔ Toggle Localization” to toggle the localization between the default localization and original version. By default, this command is also available with the button on the toolbar.

▷ Chapter 6.4.1.21.3.5.17 “Command ’Project Localization’ - ’Manage Localizations’” on page 2605
▷ Chapter 6.4.1.21.3.5.18 “Command ’Project Localization’ - ’Toggle Localization’” on page 2606

6.4.1.8 Configuring I/O Links
6.4.1.8.1 General

With the help of device objects you can map hardware to be controlled in a tree structure in your CODESYS project. This makes the linking of hardware and application easy to handle.
In the configuration editors of the device objects, you can configure the settings for the communication between CODESYS and the controller, and above all for I/O mapping. The I/O mapping is the linking of the inputs and outputs of the controller with the variables of your application.

Access to control objects at runtime can be controlled, depending on the device, via an 'online user management', which you can edit – likewise depending on the device – in the CODESYS Development System. Moreover, communication with the controller depends on the current security settings.

See also

- Chapter 6.4.1.8.2 “Configuring Devices and I/O Mapping” on page 1836
- Chapter 6.4.1.11.3 “Encrypting Communication, Changing Security Settings” on page 1967
- Chapter 6.4.1.11.4 “Handling of Device User Management” on page 1971

6.4.1.8.2 Configuring Devices and I/O Mapping

Configuring devices

You can configure the device objects inserted into the device tree in the associated device editor. The possibilities depend on the device description. The 'generic device editor' provides tabs that are supplemented as necessary by device-specific tabs.

Requirement: You have opened a standard project in whose device tree a standard PLC and below that a fieldbus device object are inserted.

1. Double-click the device object of the standard PLC in the device tree of your project.
   - The "<device name>" editor opens in the CODESYS main window. The "Communication Settings" tab is in the foreground. Change to the other tabs in order to make configuration settings for the controller. See the help pages for the generic device editor.

2. Double-click the fieldbus device object in the device tree of your project.
   - The "<fieldbus device name>" editor opens in the CODESYS main window. Specific tabs are available depending on the device. For the configuration options, see the help pages for the respective device editor. If the "Show generic device configuration views" option is selected in "Tools ➔ Options", in the "Device Editor" category, then see also the tabs contributed by the generic device editor.

See also

- Chapter 6.4.1.21.2.8.2 “Generic device editor” on page 2427

General information about I/O mapping

Whether or not you can configure an I/O mapping to project variables or even to the entire function blocks depends on the type of device. Configuring an I/O map means linking input and output channels of the device with variables of the project. We also use the term 'mapping' for this.

Pay attention in general to the following for the mapping of inputs and outputs of a device to variables in CODESYS:

- You do not have write access to variables that are mapped to an input.
- You can map an existing variable to one input only.
- You can directly generate new global implicit variables in the I/O map and map them to a device channel.
- The memory layout of structures is specified by the device.
- You can change addresses and fix values in the I/O map.
- For each variable that is assigned to an I/O channel in the "I/O Mapping" dialog, you can cause 'force variables' to be generated during the compilation of the application (see further below). Using these variables you can, for example during the commissioning of a plant, force a value on the input or output via a visualization/HMI.
- Changes in the I/O map can be transferred to the controller with an online change.
● If a pointer to a device input is used, the access is considered to be a write access, for example `pTest := ADR(input);`. This leads to a compiler warning when the code is generated: "...invalid assignment target". If you require a construct of this kind, you have to first copy the input value `input` to a variable with write access.

● An I/O address can also be linked with a variable via the 'AT declaration' in the IEC code. Since a device configuration often changes again, however, we recommend that you make the assignments only in the device editor.

If you use the AT declaration, note the following:
- An AT declaration is permissible only with local or global variables, not with input or output variables of function blocks.
- Implicit 'force variables' for I/Os (see below) cannot be generated for AT declarations.
- If you use an AT declaration with structure variables or function block variables, all instances will access the same memory location. This then corresponds to the use of 'static variables' in classic programming languages such as 'C'.

NOTICE!
- If a pointer to a device input is used, then the access (for example, `pTest := ADR(input);`) applies as write access. This leads to a compiler warning when the code is generated: "...invalid assignment target".
- If you require a construct of this kind, you have to first copy the input value (`input`) to a variable with write access.

As an alternative, you can assign a variable to an address in the programming code using the AT declaration. In view of possible changes of the device configuration, however, we recommend that you make the assignments only in the device editor.

You can export the I/O mapping configuration of a device to a csv file or import it from such a file.

See also
- § Chapter 6.4.1.21.2.8.12 “Tab "<device name> I/O Mapping”” on page 2444
- § Chapter 6.4.1.21.3.5.37 “Command ‘Export Mappings to CSV’”” on page 2616
- § “Generating implicit variables for the forcing of I/Os” on page 1843

Linking a device input with an existing project variable ("mapping")

Requirement: A device that supports an I/O mapping configuration in CODESYS is inserted in the device tree of your project. On the "I/O Mapping" tab in the device editor you thus get a tabular display of the input and output channels of the device with specification of the addresses and data types.

NOTICE!
- Mapping 'too large' data types
  - If a variable of a data type that is larger than a byte is mapped to a byte address, the value of the variable will be truncated to byte size there. For monitoring the variable value in the "I/O Mapping" dialog, this means that, in the root element of the address, the value is displayed which the variable currently has in the project. The current individual bit values of the byte are displayed in succession in the bit elements below that, but this may not be sufficient for the entire variable value.
If a UNION is represented by I/O channels in the mapping dialog, it depends on the device whether mapping to the root element is also possible.

1. In a POU, declare, for example, a variable `xBool4` of the type `BOOL` with which you want to access an input of the target device from the application.

2. To open the device editor, double-click the device object in the device tree, and then the “<device name> I/O Mapping” tab.

3. Observe the “Variable” column with the display of the device input channels 🔄 and device output channels 📂, which can still be sorted by organizational nodes 🍃, depending on the device. We assume that there is a device input of the type `BYTE`. It is displayed with its individual bit addresses (bit channels) below the `BYTE` node.

4. Note: When mapping structured variables, the editor prevents you from entering both the structure variable (example: `%QB0`) and individual structure elements (example: `%QB0.1` and `%QB0.2`). Therefore, if there is a main entry with a subtree of bit channel entries in the mapping table, then the following applies: Then you can specify a variable either into the line of the main entry, or into the lines of the subelements (bit channels), but not into both.

You can now occupy either the entire channel with a variable of a suitable type OR its individual bit-channel addresses with suitable variables of the type `BOOL` or `BIT`. First of all, double-click a bit input channel in the “Variables” column.

⁻ An input field opens.

5. In order to place an existing variable on the channel, you have to enter the desired project variable with the complete path. Press 📝 to open the Input Assistant. Select, for example, the variable `Application.PLC_PRG.xBool4` declared in `PLC_PRG`.

⁻ The variable is inserted. The HMI symbol (❖) is displayed in the “Mapping” column. The address is now struck through. That does not mean that the address is no longer available, because values of existing variables are managed at another memory space. But: in order to avoid ambiguities when writing the values, you should nevertheless not occupy the address with a further variable, especially in the case of outputs.

Note: For compiler version V3.5 SP11 and higher, the initialization value of the variables is used automatically as the default value when mapping to an existing variable. You can edit the “Default value” field only if you map to a new created variable or if no mapping is specified. In older versions, users had to specify explicitly that the default value and initialization value were identical.
6. Delete the variable assignment again. Click the root of the channel, the BYTE node. Use the Input Assistant again to select the variable Application.PLC_PRG.byte_gotodevice.

The variable is inserted, all bit addresses of the main channel are struck through and you should not additionally occupy them.

![Image of channels table and device input mapping](image)

See also

- Chapter 6.4.1.21.2.8.12 “Tab '<device name> I/O Mapping’” on page 2444

In the following you will map a device output to a global implicit variable, which you recently create for this purpose directly in the “I/O Mapping” dialog.

The “I/O Mapping” dialog is thus a further place for declaring a global variable.

Requirement: A device that supports an I/O mapping configuration in CODESYS is inserted in the device tree of your project. On the “I/O Mapping” tab in the device editor you will thus see a tabular display of the input and output channels of the device with specification of the addresses and data types.

1. To open the device editor, double-click the device object in the device tree, and then the “<device name> I/O Mapping” tab.
2. Click in the mapping table on a channel entry in the “Variable” column in order to open an input field.
3. Enter a simple name (without '.') for a new variable (for example, myBool).

   → CODESYS creates the variable as an implicit global variable in the project and assigns it directly to the channel address. Therefore in this case the address does not appear struck through as in the case of mappings to existing variables.

   ![Variable Mapping Table]

   Linking a device with a function block instance

   If supported by the device, you can map entire function blocks to an input or output channel. This allows you to count the frequency of signal changes or scale a channel value for maintenance purposes, for example.

   Here you will map a device output channel to a function block. In this example, the block scales the channel output value.

   Requirement: A device with a digital output that supports FB mapping is linked in the project. There is a function block "Scale_Output_Int" with the following implementation. The attributes of the function block itself and before the output parameter with which the channel output is processed are important.

   ```
   {attribute 'io_function_block'}
   FUNCTION_BLOCK Scale_Output_Int
   VAR_INPUT
   iInput : INT;
   iNumerator : INT;
   iDenominator : INT := 1;
   iOffset : INT := 0;
   END_VAR
   VAR_OUTPUT
   {attribute 'io_function_block_mapping'}
   iOutput : INT;
   END_VAR
   VAR
   END_VAR
   IF iDenominator <> 0 THEN
   iOutput := TO_INT(TO_DINT(iInput) * TO_DINT(iNumerator) / TO_DINT(iDenominator)) + iOffset;
   END_IF
   ```

   → After clicking "Ok", the path of the function block parameter iOutput in the "Variable" is entered in the mapping dialog. The path comprises the application name, the device channel name, and the selected FB output (example: Appl.Out_4_Int_myScale_Output_Int_1.iOutput).

   ![Diagram]
3. Select the channel and click "Go to Instance".

⇒ The focus switches to the "<device name> IEC Objects" tab and the created entry for the new IEC object Out_4_Int_myScale_Output_Int_1. In this view in online mode, you see the current value of the parameter iOutput for the channel Out_4_Int scaled by the FB. You can also write and force the value as in other monitoring views.

See also
- Chapter 6.4.1.21.4.4 “Dialog 'Select Function Block’" on page 2746
- Chapter 6.4.1.21.2.8.12 “Tab <device name> I/O Mapping’" on page 2444
- Chapter 6.4.1.21.2.8.13 “Tab <device name> IEC Objects’" on page 2449
- Chapter 6.4.1.20.6.3.23 “Attribute ‘io_function_block’, ‘io_function_block_mapping’" on page 2293

You can change the address value of an entire channel (but not that of an individual subelement of the channel!) in the mapping table of the "<device name> I/O Mapping’" tab. This allows you to adapt the addressing to a specified machine configuration and to retain the address value even if the layout of the modules changes. By default, a change of the layout leads to an automatic adaptation of the address values.

Requirement: Your project has I/O mapping. See the corresponding sections of the help page above.

1. To open the device editor, double-click the device object in the device tree, and then the "<device name> I/O Mapping’" tab.

2. Click in the mapping table on a channel entry in the “Address’" column in order to open an input field. This is only possible for the 'root' address of a channel, not for a particular one of its subelements.

Therefore, change the top address entry of a channel in the table, for example from QB0 to QB1. Exit the input field.

⇒ The address value is changed. The symbol ☰ is displayed before the address. It indicates that the address is fixed. The addresses of the subelements of the channel are also changed accordingly. If you now change the position of the device object inside other device objects with input/output channels in the device tree, CODESYS does not adapt these addresses to the new order as would be the case without fixing.

3. In order to undo the manual change or fixing, open the input field of the address value again, delete the address entry and press the Enter key.

⇒ CODESYS resets the address and the subsequent addresses concerned to the values they had before the change and removes the symbol ☰.

See also
- Chapter 6.4.1.21.2.8.12 “Tab <device name> I/O Mapping’" on page 2444
- Chapter 6.4.1.20.4.12 “Addresses” on page 2231
Depending on the device that you link in the project, CODESYS updates the variables applied to its inputs and outputs in different ways. You can explicitly change the settings for this in the “I/O Mapping” dialog.

See also

- Chapter 6.4.1.21.2.8.12 “Tab ‘<device name> I/O Mapping’” on page 2444

### Configuration of the I/O variable update

**Requirement:** You have compiled an application with a device configuration containing I/O maps without error. The associated hardware and the bus system are running. You have connected to the controller by means of the “Online Login” command and have loaded and started the application.

1. Open the “I/O Mapping” tab of the PLC in the device editor. To open the editor, double-click the device object in the device tree.
   
   The mapping table now additionally contains the “Current Value” and “New Value” columns.

   If a structure variable is mapped to the ‘root’ element of an address\(^1\), CODESYS does not display a value in this line in online mode. If, for example, a DWORD variable is mapped to the address, however, the respective values are monitored both in the ‘root’ line and in the indented bit-channel lines below it.

   As a matter of principle, the field in the ‘root’ line always remains empty if the value would be composed of several subelements.

   \(^1\) ‘root’ = top element of this address in the Mapping dialog

2. Enter a certain variable value for an entry in the column “New value” and press \([F7]\) to force or \([Ctrl]+[F7]\) to write the value.

   As in the case of monitoring in the declaration editor or in watch lists, the forced variable value is displayed in the column “Current Value” with a prefixed red F-symbol or the written value.

### Monitoring of variables in the I/O map in online mode

**NOTICE!**

Inputs and outputs that the PLC code does NOT use are not read by the PLC in online mode, as a result of which the displayed value could be incorrect. The “Current Value” of the variables concerned is displayed with a gray background.

(1) Forced values on the controller
(2) Values not used on the controller, value shown in gray
During the commissioning of a plant or machine it may be necessary to 'force' the values applied at the inputs and outputs. If a device supports this you can cause special 'force variables' to be generated for this purpose and use them, for example, in an HMI visualization.

Requirement: The device supports the functionality. You have a project in which an I/O map is configured for the device and which contains a program object PLC_PRG.

1. Open the device editor, "PLC Settings" tab, by double-clicking the device object in the device tree.
2. Activate the option "Generate force variables for I/O mapping".

⇒ Two variables are created for each I/O channel in accordance with the following syntax, in the process of which spaces in the channel name are replaced by underscores:

```
<device name>_<channel name>_<IEC address>_Force of type BOOL for the activation and deactivation of forces.
<device name>_<channel name>_<IEC address>_Value of the data type of the channel for defining the value that you want to force on the channel.
```

These variables are available in the Input Assistant in the category "Variables"/"IoConfig_Globals_Force_Variables." You can use them in CODESYS in programming objects, in visualizations, in the symbol configuration, etc.

4. Open the function block "PLC_PRG", set the focus in the implementation part and press F2.

⇒ The Input Assistant opens. The variables are available in the category "Variables"/"IoConfig_Globals_Force_Variables" as described above.

A rising edge at the 'Force variable' input activates the forcing of the respective input or output with the value given by the 'Value variable'. A falling edge deactivates the forcing. Deactivation by resetting the 'Force' variable to FALSE is the requirement for being able to force a new value.

Take note of the following restrictions.

- Forcing via the implicit force variables is only possible for channels that are mapped in the "I/O Mapping" of the device to an existing or recently created variable.
- Forcing via the implicit force variables is not possible for unused inputs and outputs or those that are mapped to a variable via an AT declaration in an application program.
- I/O channels that you want to force via the mechanism have to be used by CODESYS in at least one task.
- CODESYS identifies forced inputs in the monitoring by the red Force symbol, but not forced input/outputs. The forced value is used only implicitly by the I/O driver for writing to the device.

See also

- ☞ Chapter 6.4.1.21.2.8.10 "Tab 'PLC Settings'" on page 2439
- ☞ Chapter 6.4.1.12.5 "Forcing and Writing of Variables" on page 1987

I/O mapping in one dialog for multiple devices

There is a table that displays the I/O map of a device plus the I/O maps of all subelements inserted below it in the device tree. There you can edit the I/O maps in exactly the same way as in the individual mapping tables of the respective device editors.

Requirement: In the device tree of your project there are several PLCs inserted that each enable an I/O mapping configuration.

1. Select the root node of the device tree and click "Edit I/O Mapping" in the context menu.

⇒ The "Edit I/O Mapping" dialog opens, in which the I/O mapping configurations of all devices inserted in the project are displayed in a table. You can edit the entries in the same way as in the "I/O Mapping" dialog of the associated device editor.
2. Now select one of the control objects in the device tree and select the “Edit I/O Mapping” command once again in the context menu.
   ⇒ The “Edit I/O Mapping” dialog now shows only the I/O table for the I/O mapping configurations found in and under the selected object.

3. Set a desired “Filter” in the bar above the table or enter a variable name in the “Search for variable” field in order to see the use of this variable in the mapping.
   ⇒ The method of working in this window is the same as that described for the “<device name> I/O Mapping” tab.

See also
- Chapter 6.4.1.21.3.5.35 “Command ’Edit I/O Mapping’” on page 2615

6.4.1.9 Programming of Applications

6.4.1.9.1 Introduction
To create an application program which can be run on the controller, you fill POUs with declarations and implementation code (source code), establish the link from the controller I/Os to application variables, and configure the task assignment. After checking and debugging, the CODESYS compiler creates the application code which can be downloaded to the controller.

The programming of the application POUs is supported by the programming language editors and other features such as text lists, image pools, alarm configurations, pragmas, refactoring, and ready-to-use POUs from CODESYS Development System or libraries.

There are features for syntax checking and code analysis, for achieving data persistence, and for encrypting the application code which is downloaded to the controller.

6.4.1.9.2 Designating identifiers
Identifiers are names of variables and programming objects (for example programs, function blocks, and methods) and names of other objects of the application and project. There are rules that you must follow when assigning identifiers. Furthermore, there are also recommendations to help you designate uniform and expressive identifiers.

You designate variables identifiers in the variables declaration. These identifiers can be changed in the declaration section of the programming object. You designate identifiers for programming objects and other objects in the dialog box when adding the object. You can change the identifier of an existing object of the application or of the project in the properties dialog of the object. However, you cannot change the identifiers of objects that can be available only one time per application or project (for example, the “Library Manager” and “ImagePool” identifiers).

See also
- Chapter 6.4.1.20.7 “Identifiers” on page 2327

6.4.1.9.3 UTF-8 Encoding
Basics
Applications in CODESYS can process a wide variety of characters, for example, to output an error message in various languages. Or to display visualizations in a language selected by the user which accepts user input in a wide variety of languages, characters, or symbols. If a comprehensive character set is not necessary, or if a project should not be changed, then strings which are encoded Latin-1 format can still be used.
Table 382: Character set tables

<table>
<thead>
<tr>
<th>Character set</th>
<th>Code page number</th>
<th>Description</th>
<th>Character encoding</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASCII</td>
<td>20127</td>
<td>• 128 characters</td>
<td>7-bit encoded character</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Suitable for english texts</td>
<td></td>
</tr>
<tr>
<td>DOS-Latin-1</td>
<td>819, 850</td>
<td>• Complies with ISO 8859</td>
<td>8-bit encoded character</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Suitable for western european languages in the Windows command line window.</td>
<td></td>
</tr>
<tr>
<td>Latin-1</td>
<td>28591</td>
<td>• Complies with ISO-8859</td>
<td>8-bit encoded character</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Often used for HTML pages with äöüß but without € or for example without special french characters.</td>
<td></td>
</tr>
<tr>
<td>Windows 1252 Encoding</td>
<td>1252</td>
<td>• Default Windows character set for western european countries</td>
<td>8-bit encoded character</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Windows uses the UTF-16 format internally</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Contains all characters from ISO 8859-1 and ISO 8859-15, but partly with different encoding</td>
<td></td>
</tr>
<tr>
<td>Unicode</td>
<td></td>
<td>• Universal character set for all possible languages, including historical languages, Braille, music, or emojis.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• More than 100,000 characters can be displayed.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Each character has a numeric code.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• In contrast to ASCII, a separation is made between the assignment of code points to characters and the encoding of the characters.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Numeric code &lt; 128 are ASCII compatible</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Numeric codes &lt; 256 are ISO 8859-1 compatible</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>For more information, see <a href="http://unicode.org">unicode.org</a></td>
<td></td>
</tr>
<tr>
<td>Unicode 14.0</td>
<td>144,697</td>
<td>144,697 characters</td>
<td></td>
</tr>
</tbody>
</table>
UTF-16

- Special Unicode
- Used in some operating systems (Windows, OS X) and programming languages (Java, .NET) for internal character representation.
- It should be noted that different computer architectures encode the 4-byte characters differently. Little endian byte order for UTF-16LE.

UTF-8

- Byte-oriented encoding format of Unicode characters.
- Most widespread
- Used in GNU/Linux and Unix operating systems, and in various Internet services (email, web, browser).
- Compatible with ASCII characters in the first 128 characters (0–127).

UTF-8 encoding is the encoding with the most comprehensive character set. Therefore, it is recommended that you enable UTF-8 encoding for new projects as well as for existing projects to be used in a new context.

Table 383: Project-wide encoding in CODESYS

<table>
<thead>
<tr>
<th>Data type</th>
<th>Compile option: UTF8 Encoding for STRING</th>
<th>Which encoding is used project-wide?</th>
</tr>
</thead>
<tbody>
<tr>
<td>STRING</td>
<td>Enabled</td>
<td>UTF-8</td>
</tr>
<tr>
<td></td>
<td>Disabled</td>
<td>Windows 1252 encoding (default Windows encoding)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Latin-1</td>
</tr>
<tr>
<td>WSTRING</td>
<td>Enabled</td>
<td>UTF-16</td>
</tr>
<tr>
<td></td>
<td>Disabled</td>
<td>UTF-16</td>
</tr>
</tbody>
</table>

In CODESYS, the “STRING” data type can be encoded in Latin-1 or UTF-8 formats. The “WSTRING” data type always encodes its characters as Unicode in UTF-16.

Encoding a single string literal in UTF-8 format

Even if the project-wide encoding format is set to Latin-1, you can encode a single literal in UTF-8 format. To do this, add the “UTF8#” type prefix to the literal.

```
(attribute 'monitoring_encoding' := 'UTF-8')
strVarUtf8: STRING := UTF8#'你好,世界!ÜüÄäÖö';
```

For more information, see:
Constant: UTF8# String; % Chapter 6.4.1.20.4.6 “Constant: UTF8# String” on page 2222
Pragma Attribute: `monitoring_encoding`

**String conversion for UTF-8 encoding**

If you have enabled UTF-8 encoding project-wide, then you can use the string conversion functions as usual.

**String manipulation**

Use library functions to manipulate your strings.

If “STRING” variables should be manipulated, then an index access to a variable in ASCII format often leads to the desired result. It is better not to use this construct. It is not just a bad programming style. To make matters worse, with UTF-8 encoding, index access leads to unwanted string manipulation.

---

**UTF-8 encoding only for project-wide configuration**

A UTF-8 encoding is used if the project-wide compile option `UTF8 encoding for STRING` is enabled. Library functions and add-ons are then also oriented according to this setting.

If you use single UTF-8 encoded strings, then you have to make sure that they are interpreted correctly wherever they are used. For example, a string variable in the OPC server will be converted to UTF-8 before being transferred to a client if the setting is not selected. Values such as “UTF8#äöü” would then be misinterpreted. Similar problems can arise when outputting strings in the visualization.

---

### 6.4.1.9.4 Declaration of Variables

**General**

**Variable declaration: Where and how?**

You can declare variables at the following locations:

- Declaration part of a POU
  
  The “Declare Variable” dialog helps you with this.
  
  Hint: If you define a variable in the tabular declaration editor, the correct syntax is automatically produced.

- Declaration part of the GVL or NVL editor

- I/O mapping configuration of an I/O device object

**Syntax**

```plaintext
( <pragma> )*
<scope> ( <type qualifier> )?
  <identifier> (AT <address> )? : <data type> ( := <initial value> )? ;
END_VAR
```
### Declaration

See also
- % Chapter 6.4.1.9.4.2 “Using the declaration editor” on page 1851
- % Chapter 6.4.1.9.4.3 “Using the 'Declare variable' dialog box” on page 1852
- % Chapter 6.4.1.21.3.3.32 “Command 'Auto Declare’” on page 2572

### <pragma>

Pragma (none, one, or multiple)

**Note:** By adding a pragma, you can affect the behavior and the properties of one or more variables.

**See also**
- % Chapter 6.4.1.9.8 “Using Pragmas” on page 1888
- % Chapter 6.4.1.20.6 “Pragmas” on page 2269

### <scope>

**Scope**

- VAR
- VAR_CONFIG
  **Note:** If variables with incomplete address information are declared in function blocks (for example, AT %I*), then the variables in the variable declaration VAR_CONFIG have to be completely declared. You can access these variables in a local instance only when this is done.
- VAR_EXTERNAL
- VAR_GLOBAL
- VAR_INPUT
- VAR_INST
- VAR_IN_OUT
- VAR_OUTPUT
- VAR_STAT
- VAR_TEMP

**See also**
- % Chapter 6.4.1.20.2.2 “Local variables - VAR” on page 2113
- % Chapter 6.4.1.20.2.11 “Configuration variables - VAR_CONFIG” on page 2121
- % Chapter 6.4.1.20.2.9 “External variables - VAR_EXTERNAL” on page 2120
- % Chapter 6.4.1.20.2.6 “Global variables - VAR_GLOBAL” on page 2118
  % Chapter 6.4.1.21.2.12 “Object ‘GVL’ - Global Variable List” on page 2465
- % Chapter 6.4.1.20.2.3 “Input variables - VAR_INPUT” on page 2113
- % Chapter 6.4.1.20.2.10 “Instance variables - VAR_INST” on page 2120
- % Chapter 6.4.1.20.2.5 “Input/Output Variable (VAR_IN_OUT)” on page 2114
- % Chapter 6.4.1.20.2.4 “Output variables - VAR_OUTPUT” on page 2114
- % Chapter 6.4.1.20.2.8 “Static variables - VAR_STAT” on page 2119
- % Chapter 6.4.1.20.2.7 “Temporary variable - VAR_TEMP” on page 2119
### Type Qualifier

<table>
<thead>
<tr>
<th>Type qualifier</th>
<th>See also</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONST</td>
<td>% Chapter 6.4.1.20.2.12 “Constant Variables - ‘CONSTANT’” on page 2121</td>
</tr>
<tr>
<td>RETAIN</td>
<td>% Chapter 6.4.1.20.2.14 “Retain Variable - RETAIN” on page 2124</td>
</tr>
<tr>
<td>PERSISTENT</td>
<td>% Chapter 6.4.1.20.2.13 “Persistent Variable - PERSISTENT” on page 2122</td>
</tr>
</tbody>
</table>

### Identifier

**Note:** The rules listed in the chapter "Identifiers" must be followed without exception when assigning an identifier. In addition, you will find recommendations for uniform naming.

See also

% Chapter 6.4.1.20.7 “Identifiers” on page 2327

### AT Address

Assignment of an address in the input, output, or flag memory range (I, Q, or M)

AT % <memory area prefix> ( <size prefix> )? <memory position>

**Example**

- AT %I* // Incomplete address
- AT %I7.5
- AT %IW0
- AT %QX7.5
- AT %MD48

See also

% Chapter 6.4.1.8.2 “Configuring Devices and I/O Mapping” on page 1836
% Chapter 6.4.1.9.12.3 “AT declaration” on page 1902
% Chapter 6.4.1.20.4.12 "Addresses” on page 2231

### Data Type

- <elementary data type>
- <user defined data type>
- <function block>

See also

% Chapter 6.4.1.20.5 “Data Types” on page 2234
% Chapter 6.4.1.21.2.9 “Object ‘DUT’” on page 2461
% Chapter 6.4.1.21.2.21.3 “Object ‘Function Block’” on page 2479

### Initial Value

**Literal value** | **Identifier** | **Expression**

See also

% Chapter 6.4.1.20.7 “Identifiers” on page 2327
% “Constants and literals” on page 2219
% Chapter 6.4.1.20.1.4.3 “ST expressions” on page 2050

( ... )? Optional

( ... )* Optional repetition
Example

GVL

VAR_GLOBAL CONSTANT
  g_ciMAX_A : INT := 100;
  g_ciSPECIAL : INT := g_ciMAX_A - 10;
END_VAR

GVL_CONFIG

VAR_CONFIG
  // Generated instance path of variable at incomplete address
  PLC_PRG.fbDoItNow.XLOCINPUT AT %I*: BOOL := TRUE;
END_VAR

FB_DoIt (FB)

METHOD METH_Last : INT
  VAR_INPUT
    iVar : INT;
  END_VAR
  VAR_INST
    iLast : INT := 0;
  END_VAR
  METH_Last := iLast;
iLast := iVar;

FUNCTION_BLOCK FB_DoIt
  VAR_INPUT
    wInput AT %IW0 : WORD; (* Input variable *)
  END_VAR
  VAR_OUTPUT
    wOutput AT %QW0 : WORD; (* Output variable *)
  END_VAR
  VAR_IN_OUT
    aData_A : ARRAY[0..1] OF DATA_A; // Formal variable
  END_VAR
  VAR_EXTERNAL
    GVL.g_ciMAX_A : INT; // Declared in object GVL
  END_VAR
  VAR_STAT
    iNumberFBCalls : INT;
  END_VAR
  VAR
    iCounter: INT;
    xLocInput AT %I* : BOOL := TRUE; // VAR_CONFIG
  END_VAR

  iNumberFBCalls := iNumberFBCalls + 1;

PROGRAM PLC_PRG

VAR
  iLoop: INT;
iTest: INT;
fbDoItNow : FB_DoIt;
iTest_200 : INT;
aData_Now : ARRAY[0..1] OF DATA_A := [
  (iA_1 := 1, iA_2 := 10, dwA_3 := 16#00FF),
  (iA_1 := 2, iA_2 := 20, dwA_3 := 16#FF00)];
END_VAR

iTest := GVL.g_ciMAX_A;
iTest_200 := 2 * GVL.g_ciMAX_A;
fbDoItNow(aData_A := aData_Now);
FOR iLoop := 0 TO GVL.g_ciSPECIAL DO
  END_FOR
Variable initialization

The standard initialization value for all declarations is 0. In the declaration part you can also specify user-defined initialization values for each variable and each data type. The user-defined initialization starts with the assignment operator := and consists of any valid expression of the programming language ST (structured text). You thus define the initialization value with the help of constants, other variables or functions. If you use a variable, you must also initialize it.

Examples

```
VAR
  var1:INT := 12;                 // initialization
  x : INT := 13 + 8;              // initialization
  y : INT := x + fun(4);          // initialization
  z : POINTER TO INT := ADR(y);   // not described in
  // the standard IEC61131-3:
END_VAR
```

Notes on the order of initialization

> From compiler version 3.5.3.40, variables in a function block are initialized in the following order: firstly, all constants in accordance with the order of their declarations, then all other variables in accordance with the order of their declarations.

**NOTICE!**

> From compiler version 3.3.2.0, variables from global variable lists are always initialized before the local variables of a POU.

See also

- § Chapter 6.4.1.20.5.15 “Data Type ‘ARRAY’” on page 2247
- § “Declaration and initialization of structure variables” on page 2262
- § Chapter 6.4.1.20.5 “Data Types” on page 2234
- § Chapter 6.4.1.20.6.3.16 “Attribute ‘global_init_slot’” on page 2285

Using the declaration editor

The declaration editor is used for declaring variables in the variable lists and POU's.

The declaration editor offers two possible views: textual and tabular.
in the dialog in “Tools ➔ Options ➔ Declaration Editor”, you define whether only the textual view or only the tabular view is available, or whether you can switch between both views by means of the buttons on the right side of the editor view.

If the declaration editor is used in conjunction with a programming language editor, it appears as the declaration part at the top of the window of a POU.

**Declaring in the textual declaration editor**

The behavior and the appearance of the textual editor are configured with the settings in the dialog “Tools ➔ Options ➔ Text Editor”. The settings concern colors, line numbers, tab widths, indentations etc. The usual Windows functions are available, plus the IntelliMouse functions if necessary.

Requirement: You have opened a programming object (POU, GVL or NVL) of a project. The textual declaration editor has the focus.

▷ Enter the variable declarations in correct syntax. With [F2] you can open the dialog “Input Assistant” for the selection of the data type or a keyword.

**Declaring in the tabular declaration editor**

In the tabular declaration editor, you add variable declarations to a table with the following columns: “Scope”, “Name”, “Address”, “Data type”, “Initialization”, “Comment”, and “Attributes” (pragmas).

Requirement: A programming object (POU or GVL) of a project is open. The tabular declaration editor has the focus.

1. Click the button in the declaration header or select the command “Insert” in the context menu.
   ⇒ CODESYS inserts a new row for a variable declaration and the input field for the variable name opens.
2. Specify a valid variable identifier.
3. Open the other fields of the declaration line as required with a double-click and select the desired specifications from the drop-down lists or with the help of the dialogs which appear.

See also
- Chapter 6.4.1.20.1.2 “Declaration Editor” on page 2047
- Chapter 6.4.1.21.3.3.32 “Command ‘Auto Declare’” on page 2572
- Chapter 6.4.1.9.4.3 “Using the 'Declare variable' dialog box” on page 1852
- Chapter 6.4.1.21.3.17.2 “Command ‘Edit Declaration Header’” on page 2717
- “Dialog ‘Input Assistant’ - Tab ’Categories’” on page 2575

**Using the ‘Declare variable’ dialog box**

Requirement: A programming object (POU or GVL) of a project is open.

1. Select the command “Edit ➔ Auto Declare”.
   ⇒ The dialog box “Auto Declare” opens.
2. Select the desired scope for the variable from the selection list “Scope”.
3. Enter a variable name in the input field “Name”.
4. Select the desired data type from the selection list “Type”.
5. If the initialization value deviates from the standard initialization value, enter an initialization value for the variable.
6. Complete your entries with a click on “OK”.
   ⇒ CODESYS lists the newly declared variable in the declaration part of your programming object.
With the help of pragmas in the declaration part you can affect the processing of the declaration by the compiler.

See also

- Chapter 6.4.1.21.3.3.32 “Command ‘Auto Declare” on page 2572
- Chapter 6.4.1.20.5 “Data Types” on page 2234
- Chapter 6.4.1.9.8 “Using Pragmas” on page 1888

Declaring arrays

Requirement: A programming object (POU or GVL) of a project is open.

1. Click “Edit ➔ Declare Variable”.
   ⇒ The “Declare Variable” dialog opens.
2. Select the desired scope for the array from the drop-down list “Scope”.
3. Enter an identifier for the array in the “Name” input field.
4. Click the arrow button (◇) next to the “Data type” input field and select the “Array Assistant” entry from the selection menu.
5. In the input fields “Dimension 1”, type in the lower and upper limit of the first dimension of the array (example: 1 and 3).
   ⇒ The field “Result” displays the 1st dimension of the array (example: ARRAY [1..3] OF ?).
6. In the input field “Basic type”, type in the data type of the array or use the “Input Assistant” (◇) or the “Array Assistant” (example: DINT).
   ⇒ The field “Result” displays the data type of the array now (example: ARRAY [1..3] OF DINT).
7. Define the second and third dimensions of the array according to steps 5 and 6 (example: Dimension 2: 1 and 4, Dimension 3: 1 and 2).
   ⇒ The “Result” field displays the array with the defined dimensions: ARRAY [1..3, 1..4, 1..2] OF DINT. The array consists of 3 * 4 * 2 = 24 elements.

In an array of variable length, declare the dimension limits with an asterisk placeholder (*). Arrays of variable length are permitted to be used only in VAR_IN_OUT declarations of function blocks, methods, or functions.

Example of a 2-dimensional array of variable length:

aiUnknownLengthData : ARRAY [*,*] OF INT;

8. Click “OK”.
   ⇒ In the dialog “Declare Variable” the field “Data type” displays the array.
9. To modify the initialization values of the array, click the arrow button (◇) next to the “Initialization value” input field.
   ⇒ The “Initialization Value” dialog opens.
10. Select the line of the array element whose initialization value you wish to modify. Example: Select array component [1, 1, 1].
11. Enter the desired initialization value in the input field below the list and click button “Use value on selected lines” (example: value 4).
   ⇒ CODESYS displays the changed initialization value of the selected line.
12. Click “OK”.
   ⇒ In the “Initialization value” field of the “Declare Variable” dialog, CODESYS displays the initialization values of the array (example: \{4, 23\(0\)\}).
13. You can optionally enter a “Comment” in the input field.
14. Click “OK” in order to conclude the declaration of the array.
   ⇒ CODESYS adds the declaration of the array to the declaration part of the programming object.

See also
● Chapter 6.4.1.21.3.3.32 “Command ‘Auto Declare’” on page 2572
● Chapter 6.4.1.20.5.15 “Data Type ‘ARRAY’” on page 2247

Declaring global variables

Declaring global variables that are available within the application.

Requirement: A project is open.

1. In the Device tree of your project, select the application in which the global variables are to be valid.
2. Select the context menu command “Add Object ➔ Global Variable List”.
   ⇒ CODESYS inserts the “GVL” in the Device tree under the application and opens it in the editor.
3. Select the menu command “Edit ➔ Auto Declare”.
   ⇒ The dialog box “Auto Declare” opens.
4. In the selection list “Scope”, select the entry “VAR_GLOBAL”.
5. In the field “Name”, enter a name for the global variable.
6. Select a data type from the selection list “Type”.
7. If your variable is to have an initialization value other than the standard initialization value, click on ➔ next to the field “Initialization”.
   ⇒ The dialog box “Initialization Value” opens.
8. Double-click on the cell “Init value” of your variable and enter the desired valid value.
9. Click on “OK”.
   ⇒ The initialization value is displayed in the dialog box “Auto Declare”.
10. Activate one of the “Flags” if necessary.
11. Confirm your entries by clicking on the button “OK”.
   ⇒ CODESYS inserts the declared variable in the GVL.
   The global variable is available in the total application of your project.
Declaring global variables that are available in the entire project.

1. Select the menu command “View ➔ POU”.
   - The “POUs” view opens.
2. In the “POUs” view, select the uppermost node with the project name and select the context menu command “Add Object ➔ Global Variable List”.
   - CODESYS inserts the “GVL” in the “POUs” view and opens it in the editor.
3. Select the menu command “Edit ➔ Auto Declare”.
   - The dialog box “Auto Declare” opens.
4. In the selection list “Scope”, select the entry “VAR_GLOBAL”.
5. In the field “Name”, enter a name for the global variable.
6. Select a data type from the selection list “Type”.
7. If your variable is to have an initialization value other than the standard initialization value, enter it in the column “Initialization”.
8. Activate one of the “Flags” if necessary.
9. Confirm your entries by clicking on the button “OK”.
   - CODESYS inserts the declared variable in the GVL.
   The global variable is now available in the entire project.

See also
- “Chapter 6.4.1.21.3.3.32 “Command ‘Auto Declare’” on page 2572

Using Task-Local Variables

Task-local variables are cycle-consistent. In a task cycle, they are written only by a defined task, while all other tasks have read-only access. It is taken into account that tasks can be interrupted by other tasks or can run simultaneously. The cycle consistency also applies above all if the application is running on a system with a multicore processor.

Therefore, using task local global variable lists is one way to automatically achieve a synchronization (by the compiler) when multiple tasks are processing the same variables. This is not the case when using ordinary GVLs. Multiple tasks can write simultaneously to ordinary GVL variables during a cycle.

However, it is imperative to note: The synchronization of task-local variables requires a relatively large amount of time and memory and is not always the best solution for every application. For this reason, see below for more detailed technical information and best practice guidance to help you make the right decision.

In the CODESYS project, the “Variable List (Task-Local)” object is available for defining task-local variables. Syntactically, it corresponds to a normal GVL, but also contains the information of the task that has write access to the variables. Then all variables in such a GVL are not changed by another task during a cycle of a task.

The next section contains a simple example that demonstrates the principle and functionality of task-local variables. It includes a writing program and a reading program. The programs run in different tasks, but they access the same data that is stored in a task-local global variable list so that they are processed cycle-consistently.
See below for Instructions on reprogramming this sample application.

Sample application

```plaintext
(* task-local GVL, object name: "Tasklocals" *)
VAR_GLOBAL
  g_diaData : ARRAY [0..99] OF DINT;
END_VAR

PROGRAM ReadData
VAR
  diIndex : DINT;
  bTest : BOOL;
  diValue : DINT;
END_VAR
bTest := TRUE;
diValue := TaskLocals.g_diaData[0];
FOR diIndex := 0 TO 99 DO
  bTest := bTest AND (diValue = Tasklocals.g_diaData[diIndex]);
END_FOR

PROGRAM WriteData
VAR
  diIndex : DINT;
  diCounter : DINT;
END_VAR
diCounter := diCounter + 1;
FOR diCounter := 0 TO 99 DO
  Tasklocals.g_diaData[diIndex] := diCounter;
END_FOR
```

The programs “WriteData” and “ReadData” are called by different tasks.

In the program WriteData, the array g_diaData is populated with values. The program ReadData tests whether or not the values of the array are as expected. If so, then the variable bTest yields the result TRUE.

The array data that is tested is declared via the variable g_diaData in the object Tasklocals of type Global Variable List (Task-Local). This synchronizes the data access in the compiler and guarantees cycle consistency, even when the accessing programs are called from different tasks. In the sample program, this means that the variable test is always TRUE in the program ReadData.

If the variable g_diaData were declared only as a global variable list in this example, then the test (the variable test in the program ReadData) would yield FALSE more often. In this case, this is because one of the two tasks in the FOR loop could be interrupted by the other task, or both tasks could run simultaneously (multicore controllers). And therefore the values could be changed by the writer while the reader reads the list.

**Constraints in the declaration**

- **NOTICE!**
  An online change of the application is not possible after changes in declarations in the list of task-local variables.

Note the following when declaring a global task-local variable list:
- Do not assign direct addresses by means of an AT declaration.
- Do not map to task-local variables in the controller configuration.
- Do not declare any pointers.
- Do not declare any references.
Do not instantiate any function blocks.
Do not declare any task-local variables as PERSISTENT and RETAIN at the same time.

The compiler reports write access in a task without write access as an error. However, not all write-access violations can be detected. The compiler can only assign static calls to a task. However, the call of a function block by means of a pointer or an interface is not assigned to a task, for example. As a result, any write access is not recorded there either. Moreover, pointers can point to task-local variables. Therefore, data can be manipulated in a read task. In this case, a runtime error is not issued. However, values that are modified by means of pointer access are not copied back in the shared reference of variables.

The variables are located at a different address in the list for each task. For read access, this means: ADR(variable name) yields a different address in each task.

The synchronization mechanism guarantees the following:

- Cycle consistency
- Freedom from locked states: A task never waits for an action from another task at any time.

With this method, however, no time can be determined when a reading task securely receives a copy of the writing task. Fundamentally, the copies can deviate. In the example above, it cannot be concluded that each written copy is processed one time by the reader. For example, the reading task can edit the same array over multiple cycles, or the contents of the array can skip one or more values between two cycles. Both can occur and have to be considered.

The writing task can be paused for one cycle between two accesses to the shared reference by each reading task. This means that when \( n \) reading tasks exist, the writing task can have \( n \) cycles of delay until the next update of the shared reference.

In each task, the writing task can prevent a reading task from getting a reading copy. As a result, no maximum number of cycles can be specified after which a reading task will definitely receive a copy.

In particular, this can become problematic if very slow running tasks are involved. Assuming a task runs only every hour and cannot access the task-local variables during this time, then the task works with a very old copy of the list. Therefore, it can be useful to insert a time stamp in the task-local variables so that the reading tasks can at least determine whether or not the list is up-to-date. You can set a time stamp as follows: Add a variable of type LTIME to the list of task-local variables and add the following code to the writing task, for example:

```
tasklocal.g_timestamp := LTIME();
```

Task-local variables are designed for the use case "Single writer - multiple readers". When you implement a code that is called by different tasks, using task-local variables is a significant advantage. For example, this is the case for the sample application appTasklocal as described above when it is extended by multiple reading tasks that all access the same array and use the same functions.

Task-local variables are especially useful on multicore systems. On these systems, you cannot synchronize tasks by priority. Then other synchronization mechanisms become necessary.

Do not use task-local variables when a reading task always has to work on the newest copy of the variable. Task-local variables are not suitable for this purpose.

A similar issue is the "Producer - Consumer" dilemma. This happens when a task produces data and another task processes the data. Choose another type of synchronization for this configuration. For example, the producer could use a flag to notify that a new date exists. Then the consumer can use a second flag to notify that it has processed its data and is waiting for new input. In this way, both can work on the same data. This removes the overhead for cyclic copying of data, and the consumer does not lose any data generated by the producer.

At runtime, multiple different copies of the task-local variable list may exist in memory. When monitoring a position, not all values can be displayed. Therefore, the values from the shared reference are displayed for inline monitoring, in the watch list, and in the visualization for a task-local variable.
When you set a breakpoint, the data of the task is displayed that ran to the breakpoint and was halted as a result. Meanwhile, the other tasks continue running. Under certain circumstances, the shared copy can be changed. In the context of the halted task, however, the values remain unchanged and are displayed as they are. You need to be aware of this.

For a list of task-local variables, the compiler creates a copy for each task, as well as a shared reference copy for all tasks. This creates a structure that contains the same variables as the list of task-local variables. Moreover, an array with this structure is created in which an array dimension is created for each task. As a result, an array element is indexed for each task. If a variable in the list is accessed now in the code, then the task-local copy of the list is actually accessed. Furthermore, it is determined in which task the block is currently running and the access is indexed accordingly.

For example, the line of code
```
diValue := TaskLocals.g_diaData[0];
```
from the above example is replaced by:
```
diValue := __TaskLocalVarsArray[__CURRENTTASK.TaskIndex].__g_diarr[0];
```

`__CURRENTTASK` is an operator that is available in CODESYS V3.5 SP13 and later in order to determine the current task index quickly.

At runtime, at the end of the writing task, the contents of the task-local list are written to the global list. For a reading task at the beginning, the contents of the shared reference are copied to the task-local copy. Therefore, for n tasks, there are n+1 copies of the list: One list serves as a shared reference and every task also has its own copy of the list.

A scheduler controls the time-based execution of multiple tasks and therefore also task switching. The strategy, which is tracked by the scheduler in order to control the allocation of the execution time, has the goal of preventing a task from being blocked. The synchronization mechanism is therefore optimized to the properties of task-local variables to prevent blocking states (lock states) and at no time does a task wait for the action of another task.

Synchronization strategy:
- As long as the writing task writes a copy back to the shared reference, none of the reading tasks gets a copy.
- As long as a reading task gets a copy of the common reference, the writing task does not write back a copy.

Aim: With a program `ReadData`, you want to access the same data that is written by a program `WriteData`. Both programs should run in different tasks. You make the data available in a task-local variable list so that it is processed automatically in a cycle-consistent manner.

**Background:**

**Technical implementation**

Instructions for creating the sample application as described above

1. Rename the application from Application to appTasklocal.
2. Below `appTasklocal`, add a program in ST named `ReadData`.
3. Below `appTasklocal`, add another program in ST named `WriteData`.
4. Below the object Task Configuration, rename the default task from MainTask to Read.
5. In the “Configuration” dialog of the task Read, click the “Add Call” button to call the program `ReadData`.
6. Below the “Task Configuration” object, add another task named Write, and add the call of the program `Write` to this task.
7. Select the application `appTasklocal` and add an object of type “Global Variable List (Task-Local)”.

Now there are two tasks `Write` and `Read` in the task configuration which call the programs `WriteData` and `ReadData`, respectively.

The “Add Global Variable List (Task-Local)” dialog opens.
8. Specify the name Tasklocals.
9. Select the Write task from the “Task with write access” list box.

⇒ The object structure for using task-local variables within an application is complete. Now you can code the objects as described in the example above.

See also
- Chapter 6.4.1.21.3.3.32 “Command ‘Auto Declare’” on page 2572
- Chapter 6.4.1.9.4.5 “Declaring global variables” on page 1854
- Chapter 6.4.1.21.2.13 “Object ‘GVL’ - Global Variable List (task-local)” on page 2466
- Chapter 6.4.1.9.12.3 “AT declaration” on page 1902
- Chapter 6.4.1.13.2.2 “Calling of monitoring in programming objects” on page 1996

6.4.1.9.5 Creating Source Code in IEC

General

Source code:

"Source code" is a term used for the implementation code, which you insert in the programming modules by using the appropriate programming language editors. The following programming module types are available for this purpose: POU (Program, Function, Function Block), Action, Method, Property, Interface.

Programming Language:

When creating a POU, you define, in which programming language the implementation should be inserted. Besides the IEC languages also CFC is available.

Programming Language:Editors:

You get a programming module editable in the corresponding programming language editor on a double-click on the programming module object. So, the module will appear either in the textual ST editor or in one of the graphical editors for FBD/LD/IL or CFC. Each editor consists of two windows: In the upper window you insert the declarations, in textual or tabular form, depending on the setting. In the lower window you insert the implementation code. The display and behaviour of each editor can be configured in the corresponding tab of the CODESYS “Options” dialog.

Regard the possibility to open a programming module for offline-editing even while the application is in online mode.
FBD/LD/IL

General

A combined editor enables programming in the languages FBD (function block diagram), LD (ladder diagram) and IL (instruction list).

The basic unit of the FBD and LD programming is a network. Each network contains a structure that can represent the following: a logical or arithmetic expression, the call of a POU (function, function block, program etc.), a jump or a return instruction. IL actually requires no networks. In CODESYS, however, an IL program also consists of at least one network in order to support conversion to FBD or LD. In view of this you should also divide an IL program meaningfully into networks.

See also

- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor" on page 2082

Function block diagram (FBD)

The function block diagram is a graphically oriented IEC 61131 programming language. It works with a list of networks, where each network contains a structure that can contain logical and arithmetic expressions, calls of function blocks, a jump or a return instruction.

Boxes familiar from boolean algebra are used here. Boxes and variables are connected by connecting lines. The signal flow in the network runs from left to right. The signal flow in the editor runs from top to bottom, starting with network 1.

Example

CFC is also a programming language based on the same principle as FBD, but with the following differences:

- The CFC editor is not network-oriented.
- You can freely place the elements in the CFC editor.
- Direct insertion of feedbacks is possible.
- The order of execution is determined by a list of currently inserted elements, which you can change.

See also

- Chapter 6.4.1.9.5.2.2 “Programming function block diagrams (FBD)” on page 1862
- Chapter 6.4.1.21.3.14 “Menu ‘FBD/LD/IL’” on page 2700
- Chapter 6.4.1.9.5.3 “Continuous Function Chart (CFC)” on page 1866

Ladder diagram (LD)

The ladder diagram (LD) is a graphically oriented programming language that approximates an electrical circuit diagram. On the one hand the ladder diagram is suitable for designing logical switching units, but on the other you can also create networks just as in FBD. Therefore you can use LD very well for controlling calls of other program blocks.
The ladder diagram consists of a series of networks. A network is bounded on the left side by a vertical line (bus bar). A network contains a circuit diagram of contacts, coils, optional boxes (POUs) and connecting lines. On the left side of a network there is a contact or a series of contacts that relay the ON or OFF state, which corresponds to the boolean values `TRUE` and `FALSE`, from left to right. A boolean variable is associated with each contact. If this variable is `TRUE`, the status is relayed from left to right via the connection line. Otherwise OFF is relayed. Thus the coil(s) in the right part of the network receive(s) the value ON and OFF coming from the left and the value `TRUE` or `FALSE` is written accordingly into the boolean variable assigned to them.

If the elements are connected in series, this means an AND operation. If they are connected in parallel, this means an OR operation. A line through an element means a negation of the element. The negation of an input or an output is indicated by a circle symbol.

IEC 61131-3 defines a complete LD command set, consisting of different types of contacts and coils. Contacts conduct the current (according to their type) from left to right. Coils store the incoming value. Contacts and coils are assigned to boolean variables. You can supplement an LD network by jumps, returns, labels and comments.

See also
- Chapter 6.4.1.9.5.2.3 “Programming ladder diagrams (LD)” on page 1864
- Chapter 6.4.1.21.3.14 “Menu ‘FBD/LD/IL’” on page 2700 (Befehle)

The instruction list is an assembler-like IEC 61131-compliant programming language. It supports accumulator-based programming.

An instruction list (IL) consists of a series of instructions. Each instruction starts in a new line and contains an operator and, depending on the type of operation, one or more operands separated by commas. A label, followed by a colon, can be placed in front of an instruction. It serves the identification of the instruction and you can use the label as a jump destination. A comment must be the last element in a line. Empty lines can be inserted between instructions.

All IEC 61131-3 operators are supported, as are multiple inputs, multiple outputs, negations, comments, set/reset of outputs and conditional/unconditional jumps.

Each instruction is based primarily on the loading of values into the accumulator (LD instruction). After that the corresponding operation is executed with the parameter from the accumulator. The result of the operation is written again into the accumulator, from where you should store it purposefully with the help of an ST instruction.

The instruction list supports comparison operators (EQ, GT, LT, GE, LE, NE) and jumps for programming of conditional executions or loops. Jumps can be unconditional (JMP) or conditional (JMPC / JMPCN). In the case of conditional jumps, a check is performed as to whether the value in the accumulator is `TRUE` or `FALSE`.

IEC 61131-3 defines a complete LD command set, consisting of different types of contacts and coils. Contacts conduct the current (according to their type) from left to right. Coils store the incoming value. Contacts and coils are assigned to boolean variables. You can supplement an LD network by jumps, returns, labels and comments.

See also
- Chapter 6.4.1.9.5.2.3 “Programming ladder diagrams (LD)” on page 1864
- Chapter 6.4.1.21.3.14 “Menu ‘FBD/LD/IL’” on page 2700 (Befehle)
Programming function block diagrams (FBD)

Creating a POU in the function block diagram (FBD) implementation language

1. Select an application in the device tree.
2. Select the command “Project ➔ Add Object ➔ POU”.
   ➔ The dialog box “Add POU” opens.
3. Enter a name and select the implementation language “Function Block Diagram (FBD)”.
   Click on “Add”.
   ➔ The POU is added to the device tree and opened in the editor. It consists of the declaration editor in the top part and the implementation part with an empty network in the lower part. The view “ToolsBox” is also automatically opened, in which the suitable elements, operators and function blocks for FBD programming are available.

See also

● Chapter 6.4.1.9.5.2.4 “Programming in instruction list (IL)” on page 1865
● Chapter 6.4.1.20.1.6.3 “Modifiers and operators in IL” on page 2087

Programming a network

1. Click inside the automatically inserted empty network in the implementation part.
   ➔ The network is given a yellow background and the area at the left-hand side with the network number is given a red background.
2. Open the context menu with the right mouse button.
   ⇒ You obtain amongst other things the insert commands for the elements that can be inserted at this point.
3. Insert the elements required for your programming using the menu commands or by dragging in the elements from the toolbox.
4. For example, select the command “Insert Assignment”.
   ⇒ An assignment line is inserted. In each case three question marks stand for assignment source and assignment target.
5. Select the question marks and replace them with the desired variable. Input assistance is available for this purpose.
6. Move the cursor over the assignment line.
   ⇒ The possible insertion positions for further elements are displayed as grey diamonds. A click on a diamond selects that position and the suitable insert commands are once again available.
7. Alternatively, you can drag an element with the mouse from the toolbox into the network. For example, click in the tool box on the box element, keep the mouse button pressed and move the cursor over the network.
   ⇒ Each possible insertion position lights up green.
8. Release the mouse button in order to insert the box.
   ⇒ The box is displayed in the network. The type of box on the inside and the instance name above the box, which is required in the case of a function block, are still kept free with three question marks.
9. Select the string ?? inside the box and replace it with the name of the box. Input assistance is available for this purpose.
   ⇒ The inputs and outputs of the selected box are displayed. They are still kept free with question marks, as is the instance name in the case of a function block.

See also

- Chapter 6.4.1.21.3.14 “Menu ‘FBD/LD/IL’” on page 2700
- Chapter 6.4.1.9.5.2 “FBD/LD/IL” on page 1860

Programming line branches (subnetworks)

1. In the implementation part of your POU, insert a new network using the command “FBD/LD/IL Insert network” or drag it in from the tool box.
2. For example, drag an “ADD” operator into the empty network and replace the characters ?? with two variables of the type INT.
3. Drag the element “Branch” from the tool box into your implementation and release the mouse button at the green insertion position directly at the output of the operator.
   ⇒ The line branch splits the processing line at the output of the operator box into 2 subnetworks.
4. Further FBD elements and also further line branches can now be added to each of the two subnetworks.

See also

- Chapter 6.4.1.20.1.6.4.9 “FBD/LD/IL element ‘Branch’” on page 2093
- Chapter 6.4.1.21.3.14.33 “Command ’Insert Branch’” on page 2709
Programming ladder diagrams (LD)

Creating a POU in the ladder diagram (LD) implementation language

1. Select the application in the Device tree.
2. Select the command “Project ➔ Add Object ➔ POU”.
   ⇒ The dialog box “Add POU” opens.
3. Enter a name and select the implementation language “Ladder Diagram (LD)”.
   Click on “Add”.
   ⇒ CODESYS adds the POU to the Device tree and opens it in the editor. An empty network is inserted in the implementation part. The empty network is bounded on the left by a vertical line, which represents a bus bar. The view “ToolBox” is also automatically opened, in which the suitable elements, operators and function blocks for LD programming are available.

Adding a contact and a function block (TON)

☐ Requirement: a POU with the implementation language LD is opened in the editor and an empty network is inserted.

1. Click on the category “Ladder Elements” in the view “ToolBox”
2. Click on the “Contact” element, drag it into your network and release the mouse button at the insertion position “Start here”.
   ⇒ The contact is added on the left in the network directly against the vertical line.
3. Click on ??? and enter the identifier of a boolean variable. The input assistant is also available to you for this.
4. Click on the category “Function Blocks” in the view “ToolBox” and drag the function block “TON” onto an insertion position on the connecting line to the right of the inserted contact.
   ⇒ CODESYS inserts the box “TON” to the right of the contact. The contact is connected with the input IN of the TON box.
5. Enter a time constant at the input PT, for example T#3s.
   ⇒ If the variable of your contact goes TRUE, then the input IN of the TON box also goes TRUE. The TON box forwards the value TRUE to the output Q with a switch-on delay of T#3s, for example.

Inserting a closed line branch

Requirement: a POU with the implementation language LD is opened in the editor and an empty network is inserted.

1. Click inside the empty network and select the command “FBD/LD/IL ➔ Insert Contact”.
2. Select the connecting line to the left of the contact and select the command “FBD/LD/IL ➔ Set Branch Start Point”.
   ⇒ The starting point on the connecting line is marked by a red rectangle. CODESYS marks all possible end points of the branch with a blue rectangle.

See also

- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082
3. Click on a blue rectangle in order to set the end point of your closed line branch.

   CODESYS inserts the line branch between the starting and end points. The program flow will go through both branches up to the end point.

   If you insert the line branch at a box instead of at a contact, the box will only be called if none of the other branches is **TRUE**.

See also
- \(\text{\textcircled{C}}\) Chapter 6.4.1.20.1.6.1 "FBD/LD/IL Editor" on page 2082
- \(\text{\textcircled{C}}\) Chapter 6.4.1.20.1.6.4.14 "Closed branch" on page 2096
- \(\text{\textcircled{C}}\) Chapter 6.4.1.20.1.6.4.11 "LD element 'Contact'" on page 2094

---

**Programming in instruction list (IL)**

```
If necessary, IL can be activated in the CODESYS options.
```

---

**Creating POUs in the instruction list (IL) implementation language**

1. Select the application in the device tree.
2. Click “Project ➔ Add Object ➔ POU”.
   - The “Add POU” dialog opens.
3. Enter a name and select the implementation language “Instruction List (IL)”. Click “Add”.
   - CODESYS adds the POU to the device tree and opens it in the editor. A network is already inserted in the implementation part.

**Programming networks (example: ADD operation)**

Requirement: A POU (IL) is opened in the editor and possesses an empty network.

1. Click the line marked in color in the 1st column and enter the operator **LD**.
2. Press the [Tab] key.
   - The cursor jumps to the 2nd column
3. Enter the first summand of your ADD operation, for example 6.
4. Press [Ctrl]+[Enter] or select the command “FBD/LD/IL ➔ Insert IL Line After”.
   - CODESYS inserts a new instruction line. The first column of this line has the focus.
5. Enter **ADD** and press [Tab].
6. Enter the second summand of your ADD operation, for example 12.
7. Press [Ctrl]+[Enter]
8. Enter the operator **ST** and press [Tab].
9. Specify a variable of the data type INT, for example iVar.
   ⇒ The result – 16 in the example – is stored in the iVar.

Calling function blocks

Requirement: A POU (IL) is opened in the editor and possesses an empty network. A variable of the data type <function block> is declared in the declaration part (example: Cl:CTU;).

1. Click the line marked in color in the 1st column and select the command “FBD/LD/IL è Insert Box”.
   ⇒ The input assistant opens.

2. Select the desired function block in the category “Function Blocks” or “Boxes”, for example the “CTU” counter from the “Standard” library, and click “OK”.
   ⇒ CODESYS inserts the selected function block “CTU” as follows:

3. Replace the strings ??? with the variable name and the values or variables for the inputs/outputs of the function block.

4. As an alternative to inserting the function block via the input assistant, you can directly enter the call in the editor as shown in the picture at step 4.

See also
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082
- Chapter 6.4.1.20.1.6.3 “Modifiers and operators in IL” on page 2087

Continuous Function Chart (CFC)

General

The “Continuous Function Chart (CFC)” implementation language is a graphical programming language which extends the standard languages of IEC 61131-3.

You can graphically program a system by means of a POU in CFC. You insert elements and position them freely. You insert connections and wire the elements to a network so that a well-structured function block diagram is created. You can also insert feedback. You can read function block diagrams like an circuit diagram or a block diagram.

The execution order of a function block diagram is based on data flow. Moreover, a POU can process multiple data flows. Then the data flows do not have any common data. In the editor, multiple networks do not have any connections to each other.

On the other hand, POUs in FBD, LD, or IL have a network-based execution order.
Unfortunately, it is not possible to switch a POU between the “Continuous Function Chart (CFC) - page-oriented” and “Continuous Function Chart (CFC)” implementation languages.

The "Continuous Function Chart (CFC) - page-oriented" implementation language is a variant of CFC. The difference from simple CFC is that the code can be distributed on any number of "pages" in the editor. In this way, you can create extensive function block diagrams which are still easy to print.

Each page has edge areas where you arrange the connections to the other pages.

- Creating pages
- Setting the page size
- Copying and inserting pages in the page navigator
- Copying the implementation of a POU in the CFC implementation language and inserting into a page
- Well-structured and space-saving arranging of inputs, outputs, and connection marks in the border areas
- Connection over pages with connection marks

▶ Chapter 6.4.1.20.1.7.2 “CFC Editor” on page 2098
▶ Chapter 6.4.1.20.1.7.3 “CFC editor, page-oriented” on page 2101
▶ Chapter 6.4.1.21.3.13 “Menu ‘CFC’” on page 2685
▶ Chapter 6.4.1.21.4.11.14 “Dialog ‘Properties’ - ‘CFC Execution Order’” on page 2761

Automatic Execution Order by Data Flow

The execution order in POUs is uniquely determined in text-based and network-based editors. In the CFC editor, however, you can position the elements freely, so the execution order is initially not unique. For this reason, CODESYS determines the execution order by data flow and, in the case of multiple networks, by the topological position of the elements. The elements are sorted from top to bottom and left to right. Now the execution order is unique and makes sure that the POU is processed while optimized by time and by cycle.

You can get information about the chronological order of the elements in the chart and temporarily display the execution order. When you program networks with feedback you can define an element as the starting point in the feedback loop.

You can also explicitly edit the processing order in a CFC object if necessary. To do this, switch the “Auto Data Flow Mode” property of the CFC object to “Explicit Execution Order Mode”. In this mode, you have the option of editing the execution order by means of menu commands.

Before CODESYS Development System V3.5 SP15, you had to define the execution order explicitly for each POU. The was no mode switching.

Data flow

In general, data flow is described as the chronological order in which data is read or written when and how in which programming objects. A POU can process any number of data flows, which can also be executed independently of each other.

Displaying the execution order

By default, the execution order of a CFC object is determined automatically. The “Auto Data Flow Mode” property is selected for this. You can temporarily display the automatically determined execution order in the CFC editor.
1. Create a new project using the “Standard project” template and specify the name Minimal for example.

2. Extend the application with the function block FB_DoIt in the “ST” implementation language with inputs and outputs.

   ```
   FUNCTION_BLOCK FB_DoIt
   VAR_INPUT
   iAlfa : INT;
   iBravo: INT;
   sCharlie : STRING := 'Charlie';
   xItem : BOOL;
   END_VAR
   VAR_OUTPUT
   iResult : INT;
   sResult : STRING;
   xResult : BOOL;
   END_VAR
   VAR
   END_VAR
   iResult := iAlfa + iBravo;
   IF xItem = TRUE THEN
   xResult := TRUE;
   END_IF
   ```

3. Create the function block ExecuteCFC in the “CFC” implementation language.

   ```
   PROGRAM ExecuteCFC
   VAR
   fb_DoIt_0: FB_DoIt;
   fb_DoIt_1: FB_DoIt;
   iFinal_1: INT;
   iFinal_0: INT;
   xFinal: BOOL;
   END_VAR
   ```

Recently created programming objects in CFC have the Auto Data Flow Mode selected. The execution order of the programming object is optimally defined internally.
4. Click “CFC ➔ Execution Order ➔ Display Execution Order”.
   ⇒ The execution order of the object is shown. The boxes and inputs are numbered accordingly and reflect the chronological processing order. The numbering is hidden as soon as you click again in the CFC editor.

Determining the execution order in feedback networks

1. Create a CFC program with feedback.
   ⇒ The POU `PrgPositiveFeedback` counts.

   ```plaintext
   PROGRAM PrgPositiveFeedback
   VAR
     iResult: INT;
   END_VAR
   ```

2. Select an element within the feedback.
   ⇒ The selected element is highlighted in red.

3. Click “CFC ➔ Execution Order ➔ Set Start of Feedback”.
   ⇒ At run time, this POU is processed first. The start POU of the feedback is defined and decorated with the ▶ symbol. The execution order is resorted and the selected element gets the number 0. (This is the lowest number of the feedback.)

4. Select the start POU again.
5. Click “CFC ➔ Execution Order ➔ Set Start of Feedback”.  
   ⇒ The POU is not selected as the start POU.

   ![Diagram of ADD operation with numbers 1 and 1 connected to iResult]
   The execution order is defined internally.

6. Click “CFC ➔ Execution Order ➔ Display Execution Order”.  
   ⇒ The execution order by data flow is displayed.

   ![Diagram of ADD operation with numbers 0, 1, and 1 connected to iResult]
   The automatically defined execution order by data flow results in time- and cycle-optimized execution of the POU. You do not need any information about the internally managed execution order during the development process.

   In “Explicit Execution Order Mode”, it is your responsibility to adapt the execution order and to assess the consequences and impacts. This is another reason why the execution order is always displayed.

   You can change the automatically defined execution order of a CFC object explicitly when you select the “Explicit Execution Order Mode” option for the object.

   1. In the “Devices” or “POUs” view, select a CFC object.
   2. In the context menu, click “Properties”.
   3. Click the “CFC Execution Order” tab.  
      ⇒ The “Execution order” list box displays the currently selected mode.
   4. In the “Execution order” list box, select “Explicit Execution Order Mode”.
   5. Click “OK” to confirm the dialog.  
      ⇒ The Explicit Execution Order Mode property is selected. The networks are numbered in the CFC editor, and the following commands are provided in the “CFC ➔ Execution Order” menu for editing the execution order.
   6. Open a CFC object.
   7. Select a numbered element and click “CFC ➔ Execution Order ➔ Send to Front”.  
      ⇒ The execution order is resorted and the selected element has the number 0.

   See also
   - “CFC Editor” on page 2098
   - “CFC editor, page-oriented” on page 2101
   - “Menu ‘CFC’” on page 2685
   - “Dialog 'Properties' - 'CFC Execution Order’” on page 2761
Programming in the CFC editor

In the CFC editor, you can wire POUs to each other and create well-structured block diagrams. The editor supports you in the following ways:

- Programming with elements and connecting lines
- Dragging instances and variables to the editing area
- Auto-routing the connecting lines
- Automatic linking
- Fixing of connecting lines by control points
- Collision detection
- Input assistance for connection marks
- Forcing and writing of values in online mode
- Movement of selection using arrow keys
- Reduced display of a POU without disconnected pins

Inserting elements and wiring with connecting lines

1. Drag a “Box” element and an “Output” element into the editor.
2. Click the output of the “Box” element.
   - The output is marked with a red box.
3. Drag a connecting line from the box output of the “Box” element to the box input of the “Output” element.
   - The cursor symbol changes when it reaches the box input.
4. Release the left mouse button.
   - The output pin of the box is wired to the input pin of the output.

![Diagram of a CFC block diagram with an input and output connected by a NOT function.

You can also hold down the [Ctrl] key, select each pin, and then right-click “Connected Selected Pins”.

Calling of instances

1. Create a new project using the standard template and specify the name First for example.
   - The project First.project is created.
2. Extend the application with the function block FB_DoIt in the “ST” implementation language with inputs and outputs.

FUNCTION_BLOCK FB_DoIt
VAR_INPUT
  iAlfa : INT;
  iBravo: INT;
  sCharlie : STRING := 'Charlie';
  xItem : BOOL;
END_VAR
VAR_OUTPUT
  iResult : INT;
  sResult : STRING;
  xResult : BOOL;
END_VAR
VAR
  iResult := iAlfa + iBravo;
  IF xItem = TRUE THEN
    xResult := TRUE;
  END_IF
END_FUNCTION_BLOCK

3. Select the application and click “Add Object ➔ POU” in the context menu. Select the “Continuous Function Chart (CFC)” implementation language and the type Program. Specify the name PrgFirst for example.

Click “OK” to confirm the dialog.

- The program PrgFirst is created and it opens in the editor. It is still empty.

4. Instantiate function blocks and declare variables.

PROGRAM PrgFirst
VAR
  iCounter: INT;
  fbDoIt_1 : FB_DoIt;
  fbDoIt_2 : FB_DoIt;
  iOut : INT;
  sOut: STRING;
  xOut: BOOL;
END_VAR

5. Drag a “Box” element from the “ToolBox” view into the editor.

6. Click the ??? field and type in ADD.

- The box type is ADD. The box acts as an adder.

7. Click line 3 in the declaration editor.

- The declaration line of iCounter is selected.

8. Click in the selection and drag the selected variable into the implementation. Focus there on an input of the ADD box.

- An input has been created, declared, and connected to the box.

9. Click again in the selection and drag the variable to the output of the ADD box.

- An output has been created, declared, and connected to the box.

10. Drag an “Input” element from the “ToolBox” view to the implementation. Click its ??? field and type in 1.
11. Connect the 1 input to an input of the ADD box.
   ➞ A network is programmed. At runtime, the network counts the bus cycles and stores
   the result in iCounter.

12. Click line 5 in the declaration editor.
   ➞ The line is selected.
13. Click in the selection and drag the selected instance into the implementation.

⇒ The instance appears as a POU in the editor. The type, name, and POU pins are displayed accordingly.
14. Drag the fbDoIt_2 instance to the editor. Interconnect the instances to each other and to inputs and outputs.

Example:

A program in ST with the same functionality might look like this:

```st
PROGRAM PrgFirstInSt
VAR
  iCounter: INT;
  fbDoIt_1: FB_DoIt;
  fbDoIt_2: FB_DoIt;
  iOut: INT;
  sOut: STRING;
  xOut: BOOL;
END_VAR

iCounter := iCounter + 1;
fbDoIt_1(iAlfa := 16, iBravo := 32, sCharlie := 'First',
xItem := TRUE, iDelta := 2, iResult => fbDoIt_2.iAlfa, xResult
=> fbDoIt_2.xItem);
fbDoIt_2(iBravo := fbDoIt_1.iResult, sCharlie := 'Second',
iDelta := 2, iResult => iOut, sResult=> sOut, xResult =>
xOut);
```

Creating connection marks

- Requirement: A CFC POU has connected elements.
- 1. Select a connecting line between two elements.
   - The connecting line is displayed as selected. The ends of the connecting line are marked with red boxes (■).
- 2. Click “CFC ➔ Connection Mark”.
   - The connection is separated into a “Connection Mark - Source” and a “Connection Mark - Sink”. The name of the mark is generated automatically.
3. Click in the source connection marks.
   ⇒ You can edit the name.

4. Specify a name `SimpleMark` for the source connection mark.
   ⇒ The source connection mark and sink connection mark have the same name.

The following example shows how to use the “Route All Connections” command with control points.

1. Position the “Input” and “Output” elements. Connect the elements.

2. Position two “Box” elements on the line.
   ⇒ The connecting line and the boxes are marked red because of the collision.

3. Click “CFC ➔ Routing ➔ Route All Connections”.
   ⇒ The collision is resolved.
4. Change the connecting lines gradually.

5. Select the connecting line and click “CFC ➔ Routing ➔ Create Control Point”.

6. Change the connecting line as seen in the following example.

7. In the context menu, click “CFC ➔ Routing ➔ Remove Control Point” to remove the control point.

8. Unlock the connection by clicking “Unlock Connection” or by clicking the lock symbol.

9. Select the connecting line and click “Route All Connections”.

The connecting line has been changed manually and is now blocked for auto-routing. This is shown by a lock symbol at the end of the connection.

You can also drag a control point from the “ToolBox” view to a line.
Reducing the display of a POU

- Requirement: A CFC POU is open. In the editor, its POUs with all declared pins are displayed.

1. Select a POU whose pins are partially disconnected.
   - Example: fb_DoIt_1

   ![Diagram of fb_DoIt_1 POU with all pins displayed]

   The POU needs space for all of the pins.

2. Click “CFC ➔ Pins ➔ Remove Unused Pins”.
   - Now the POU needs less space and is displayed only with the functionally relevant pins.

   ![Diagram of fb_DoIt_1 POU with only functionally relevant pins displayed]

See also
- § Chapter 6.4.1.20.1.3 “Common functions in graphical editors” on page 2048
- § Chapter 6.4.1.20.1.7.2 “CFC Editor” on page 2098
- § Chapter 6.4.1.20.1.7.3 “CFC editor, page-oriented” on page 2101
- § Chapter 6.4.1.20.1.7.6 “Elements” on page 2109

Structured Text (ST), Extended Structured Text (ExST)

General

The ST editor is used for the programming of POUs in the IEC-61131-3 programming language. Structured Text (ST) and Extended Structured Text. The Extended Structured Text offers some additional functions with regard to the IEC 61131-3 standard.
Structured Text is a programming language, comparable with other high-level languages such as C or PASCAL, which permits the development of complex algorithms. The program code consists of a combination of expressions and instructions, which can also be executed conditionally (IF... THEN... ELSE) or in loops (WHILE... DO).

An expression is a construct that returns a value following its evaluation. Expressions are also operators and operands together. You can also use assignments as expressions. An operand can be a constant, a variable, a function call or a further expression.

Instructions control how the expressions are to be processed.

For this text editor you can make various settings with regard to behavior, appearance and menus in the dialog boxes “Options” and “Adapt” in the “Tools” menu. The familiar Windows functions (for example Intellimouse) are also available for this editor.

See also

- Chapter 6.4.1.9.5.4.2 “Programming structured text (ST)” on page 1879
- Chapter 6.4.1.21.4.14.26 “Dialog 'Options' - ‘Text Editor’” on page 2798
- Chapter 6.4.1.21.4.15.2 “Dialog 'Customize' - 'Menu’” on page 2801

ExST - Extended structured text

Extended Structured Text (ExST) is a CODESYS-specific extension of the IEC 61131-3 standard for Structured Text (ST).

See also

- Chapter 6.4.1.20.1.4.4.4 “ExST assignment ’R’=” on page 2053
- Chapter 6.4.1.20.1.4.4.3 “ExST assignment ’S’=” on page 2052
- Chapter 6.4.1.20.1.4.4.5 “ExST – Assignment as expression” on page 2054

Programming structured text (ST)

Principle

The programming languages 'Structured Text' and 'Extended Structured Text' are programmed in the ST editor. The program code consists of a combination of expressions and instructions, which can also be executed conditionally or in loops. You must conclude each instruction with a semicolon ;.

The variables are declared in the declaration editor.

Creating a POU in the structured text (ST) implementation language

1. Select an application in the device tree.
2. Select the command “Project ➔ Add Object ➔ POU”.
   - The dialog box “Add POU” opens.
3. Enter a name and select the “Implementation language” “Structured Text (ST)”.
   - The POU is added to the device tree and opened in the editor.
   - Now insert the variable declarations in the upper part of the POU and enter the ST program code in the lower part of the POU.

See also

- Chapter 6.4.1.20.1.4.3 “ST expressions” on page 2050
- Chapter 6.4.1.20.1.4 “Structured Text and Extended Structured Text (ExST)” on page 2049
- Chapter 6.4.1.20.1.4.5.10 “ST function block call” on page 2060
Sequential Function Chart (SFC)

General

Use the SFC editor for programming POUs in the IEC 61131-3 compliant SFC implementation language. SFC is a graphical programming language for describing the chronological sequence of individual actions in a program. For this purpose, actions (discrete programming objects) are assigned to step elements. Transition elements control the processing order of steps.

See also

- Chapter 6.4.1.20.1.5.1 “SFC editor” on page 2062

Programming in SFC

Creating a POU in SFC

1. Select an application in the device tree.
2. Click “Project ➔ Add Object ➔ POU”.
   ⇨ The “Add POU” dialog opens.
3. Specify a name and select the “Sequential Function Chart (SFC)” implementation language.
   Click “Add”.
   ⇨ CODESYS adds the POU to the device tree and opens it in the editor.

Adding a step-transition

1. Select the transition after the initial step.
   ⇨ The transition is marked in red.
2. Click “SFC ➔ Insert Step-Transition After”.
   ⇨ CODESYS inserts the “Step0” step and the “Trans0” transition.
3. Select the “Trans0” transition and click “SFC ➔ Insert Step-Transition”.
   ⇨ CODESYS inserts the “Trans1” transition and the “Step1” step before the “Trans0” transition.

You can also drag the “Step” and “Transition” elements into the diagram from the “Toolbox” view.

See also

- Chapter 6.4.1.20.1.5.8.1 “SFC elements 'Step' and 'Transition’” on page 2073
- Chapter 6.4.1.21.3.12.6 “Command 'Insert Step-Transition’” on page 2677
- Chapter 6.4.1.21.3.12.7 “Command 'Insert Step-Transition After’” on page 2677
Adding an entry action

1. Select the “Step0” step.
2. Click “SFC ➔ Add Entry Action”.
   ➞ By default, you are prompted to select the duplication mode for the step actions. You decide whether the reference information about the existing step action objects is copied when the step is copied, or the objects are embedded. Embedding results in new step action objects being created when the step is copied. The duplication mode is defined in the “Duplicate when copying” step property. When this property is deactivated, the copied steps call the same actions as the current step.
   
   You can deactivate the prompt completely in the SFC properties.
   
   The display of embedded objects in the “Devices” and “POUs” views can be deactivated by means of a menu command.

3. For this example, accept the “Copy reference” default setting and click “OK” to confirm.
   ➞ The “Add Entry Action” dialog opens.

4. Enter the name “Step0_entry” and select the “Structured Text (ST)” implementation language. Click “Add”.
   ➞ CODESYS inserts the “Step0_entry” action below the POU in the device tree and opens the action in the editor.
   
   In the Step0_entry entry action, you program statements to be executed one time when the “Step0” step becomes active.

5. Close the editor of Step0_entry.
   ➞ The “Step0” step is now marked with an “E” in the lower left corner. Double-click this marker to open the editor.

   ![Step0 Entry Action](image)

   The entry action Step0_entry is now available in the properties of the step in “Entry action”. Other actions can also be selected there as needed.

6. Select the “Step0” step. Press [Ctrl]+[V] to copy the step.
   ➞ The same entry actions inserted above are available in the inserted copy of the step. The new step then calls the same exact action.

See also

- Chapter 6.4.1.21.3.12.8 “Command ‘Add Entry Action’” on page 2678
- “2. Step actions” on page 2076
- Chapter 6.4.1.21.4.14.23 “Dialog ‘Options’ - ‘SFC Editor’” on page 2795

Adding an exit action

1. Select the “Step0” step.
2. Click “SFC ➔ Insert Exit Action”.
   ➞ By default, you are prompted to select the duplication mode for the step actions of the step. See above for adding an entry action. Then the “Insert Exit Action” dialog opens.
3. Enter the name "Step0_exit" and select the “Structured Text (ST)” implementation language. Click “Add”.
   ⇨ CODESYS inserts the “Step0_exit” action below the POU in the device tree and opens the action in the editor.
   In the Step0_exit exit action, you program statements to be executed one time before the “Step0” step becomes inactive.

4. Close the editor of Step0_exit.
   ⇨ The “Step0” step is now marked with an “X” in the lower right corner. Double-click this marker to open the editor.

You can define the exit action in the properties of the step in “Exit action”. Other actions can also be selected there.

See also
- § 6.4.1.21.3.12.9 “Command ‘Add Exit Action’” on page 2678
- § 2. Step actions” on page 2076

Adding an action

1. Double-click the “Step0” step.
   ⇨ By default, you are prompted to select the duplication mode for the step actions of the step. See above for adding an entry action. The “Add Action” dialog opens.

2. Type in the name “Step0_active” and select the “Structured Text (ST)” implementation language. Click “Add”.
   ⇨ CODESYS inserts the “Step0_active” action below the POU in the device tree and opens the action in the editor.
   In the Step0_active step action, you program statements to be executed as long as the step is active.

3. Close the editor of Step0_active.
   ⇨ The “Step0” step is now marked with a black triangle in the upper right corner.

You can define the action in the properties of the step in “Step action”. Other actions can also be selected there.

See also
- § 2. Step actions” on page 2076
Adding an alternative branch

1. Select the “Step1” step.
2. Click “SFC ➔ Insert Branch Right”.
   ⇒ CODESYS inserts the “Step2” step to the right of “Step1”. The steps are connected as a parallel branch signified by two pairs of double lines.
3. Select one of the double lines.
   ⇒ The double line is marked red.
4. Click “SFC ➔ Alternative”
   ⇒ CODESYS converts the branch into an alternative branch. The double lines change into a single line.

You can click “SFC ➔ Parallel” to convert an alternative branch into a parallel branch.

See also
● § Chapter 6.4.1.20.1.5.8.3 “SFC element ‘Branch’” on page 2078
● § Chapter 6.4.1.21.3.12.10 “Command ‘Parallel’” on page 2678
● § Chapter 6.4.1.21.3.12.12 “Command ‘Insert Branch’” on page 2679
● § Chapter 6.4.1.21.3.12.13 “Command ‘Insert Branch Right’” on page 2679

Adding a jump

1. Select the “Step2” step.
2. Click “SFC ➔ Insert Jump After”.
   ⇒ CODESYS inserts the “Step” jump after the “Step2” step.
3. Select the “Step” jump destination.
   ⇒ You can type the jump destination manually or select it by using the Input Assistant. Select Step0.

See also
● § Chapter 6.4.1.20.1.5.8.4 “SFC element ‘Jump’” on page 2079
● § Chapter 6.4.1.21.3.12.16 “Command ‘Insert Jump’” on page 2681
● § Chapter 6.4.1.21.3.12.17 “Command ‘Insert Jump After’” on page 2681

Adding a macro

1. Select the “Step1” step.
2. Click “SFC ➔ Insert Macro After”.
   ⇒ CODESYS inserts the “Macro0” macro after the “Step1” step.
3. Double-click the "Macro0" element.
   ⇒ The macro opens in the implementation section of the editor. The name "Macro0" is displayed in the caption.

4. Click “SFC ➔ Insert Step-Transition”.
   ⇒ CODESYS inserts a step-transition combination.

5. Click “SFC ➔ Zoom out of Macro”.
   ⇒ The implementation section returns to the main diagram.

See also
- % Chapter 6.4.1.20.1.5.8.5 “SFC element 'Macro'” on page 2079
- % Chapter 6.4.1.21.3.12.18 “Command 'Insert Macro'” on page 2682
- % Chapter 6.4.1.21.3.12.19 “Command 'Insert Macro After'” on page 2682

Adding an association

1. Select the “Step2” step.

2. Click “SFC ➔ Insert Action Association”.
   ⇒ CODESYS inserts an association to the right of the “Step2” step.

3. Click in the left field of the association to select the qualifier.
   ⇒ You can enter the qualifier manually or use the Input Assistant. Select "P".

4. Click in the right field of the association to select the action.
   ⇒ You can type the action or select it by using the Input Assistant.

See also
- % “1. IEC actions” on page 2075
- % Chapter 6.4.1.20.1.5.4 “Qualifiers for Actions in SFC” on page 2065
- % Chapter 6.4.1.21.3.12.14 “Command 'Insert Action Association'” on page 2680
- % Chapter 6.4.1.21.3.12.15 “Command 'Insert Action Association After'” on page 2681

Using the library 'analyzation.library' for the analyzation of expressions

The library analyzation.library allows for the analyzation of expressions. It can be used, for example, in the SFC diagram to examine the result of the flag SFCError. This flag is used to monitor timeouts in the SFC diagram.

See also
- % Chapter 6.4.1.20.1.5.7 “Library "Analyzation"” on page 2072

See also
- % Chapter 6.4.1.20.1.5.1 “SFC editor” on page 2062
6.4.1.9.6 Function block — Calling functions or methods with external implementation

A runtime system can include the implementation of a function block, function, or method (for example, from a library). If you create a POU in your application with the same name by using the “External implementation” without an implementation, then you can execute the existing implementation. Please make sure that you declare local variables only in an external function block. External functions and methods must not contain local variables.

When the application is downloading, CODESYS searches for and links the associated implementation in the runtime system for each external POU.

Objects with the property “External implementation” are postfixed with (EXT) after the object name in the “Devices” or “POUs” view.

See also

● Chapter 6.4.1.21.4.11.5 “Dialog ‘Properties’ - ‘Build’” on page 2755

Creating POUs with external implementation

1. Click “Project ➔ Add Object ➔ POU”.
2. Activate “Function block”, Method, or “Function” and specify the name of the associated implementation of the runtime system. Close the dialog box by clicking “Add”.
   ⇒ The runtime system POU is created in the “POUs” view. The name is postfixed with (EXT).
3. Right-click the POU and select “Properties”.
   ⇒ The dialog box opens.
4. Click the “Build” tab.
5. Select the “External implementation (Late link in the runtime system)” check box.
   ⇒ The POU is declared and you can implement a POU call.

Creating methods with external implementation

1. Select a function block in the device tree or in the POUs view.
2. Select “Add Object ➔ Method” and type the name of the associated implementation of the runtime system. Click “Add” to close the dialog box.
   ⇒ The method is created.
3. Right-click the method and select “Properties”.
   ⇒ The dialog box opens.
4. Click the “Build” tab.
5. Select the “External implementation (Late link in the runtime system)” check box.
   ⇒ The method is declared and you can implement a method call. The method name is postfixed with (EXT) in the “Devices” or “POUs” view.

6.4.1.9.7 Using input assistance

CODESYS provides tools and features to help you code when creating programs.
**Input assistant**

The input assistant provides all program elements that you can insert at the current cursor position. Open the “Input Assistant” dialog by clicking “Edit → Input Assistant” or by pressing 

[F2].

See also

- “Dialog 'Input Assistant' - Tab 'Categories'” on page 2575

**Dialog 'Auto Declare'**

This dialog supports the declaration of variables.

See also

- Chapter 6.4.1.21.3.3.32 “Command 'Auto Declare’” on page 2572

**"List components"**

The "List components" function is an input tool in textual editors to help you input valid identifiers. Activate this function by clicking “Tools → Options” and then the “SmartCoding” category. Select the “List components after typing a dot (.)” check box.

- If you type a dot (.) instead of a global variable, then a drop-down list opens with all available global variables. You insert the selected variable after the dot by double-clicking a variable in the drop-down list or by pressing [Enter].
- If you type a dot (.) instead of a global variable after a function block instance variable or a structure variable, then CODESYS opens a drop-down list with all global variables, all input and output variables for the function block, or all structure members. You insert the selected variable after the dot by double-clicking a variable in the drop-down list or by pressing [Enter].
  
  Note: When you also want to choose from the local variables of function block instances, select the “Show all instance variables in input assistant” option in the CODESYS options (SmartCoding category).
- If a component access (with a dot) for a drop-down list has already happened, then the last selected entry is preselected at the next component access.
- When you type any sequence of characters and then press [Ctrl]+[Space], a drop-down list opens with all available POU and global variables. The first element in this list that starts with the sequence of characters is selected by default and you can insert it by double-clicking it or by pressing [Enter].
  
  Matches with the entered character string are highlighted in yellow in the drop-down list.
  
  If the entered character string is changed, then the displayed drop-down list is refreshed.
- In the ST editor, you can filter the displayed drop-down list by scopes:
  
  Depending on the displayed drop-down list, you can use the [Arrow right] and [Arrow left] keys to toggle between the following drop-down lists:
  
  – “All items”
  – “Keywords”
  – “Global declarations”
  – “Local declarations”
- CODESYS displays a tooltip if you type an opening parenthesis for a POU parameter when calling a function block, a method, or a function. This tooltip includes information about the parameters as they are declared in the POU. The tooltip remains open until you click to close it or you change the focus away from the current view. If you accidentally close the tooltip, then you can reopen it by pressing [Ctrl]+[Shift]+[Space].

You can use the pragma attribute ‘hide’ for excluding variables from the "List components" feature.
Typing structure variables:

- list

Calling a function block:

See also

- Chapter 6.4.1.20.6.3.17 “Attribute ‘hide’” on page 2286

**Short form feature**

The short form feature allows you to type abbreviated forms for variable declarations in the declaration editor and in textual editors where variables declarations are possible. Use this feature by pressing `[Ctrl]+[Enter]` to end a declaration line.

CODESYS supports the following short forms:

- All identifiers become variable identifiers except the last identifier of a line.
- The data type of the declaration is determined by the last identifier of the line. The following applies:
  - `B` or `BOOL` yields `BOOL`
  - `I` or `INT` yields `INT`
  - `R` or `BOOL` yields `BOOL`
  - `S` or `STRING` yields `STRING`
- If a data type is not defined using this rule, then the data type is automatically `BOOL`, and the last identifier is not used as the data type (see Example 1).
- Depending on the type of declaration, every defined constant becomes an initialization or string length definition (see Example 2 and 3).
- An address, such as `%MD12`, is automatically extended with the AT attribute (see Example 4).
- Any text after a semicolon (:) is converted into a comment (see Example 3).
- All other characters in the line are ignored (see exclamation mark in Example 5).

### Examples

<table>
<thead>
<tr>
<th>Example</th>
<th>Short Form</th>
<th>Resulting declaration</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A</td>
<td>A: BOOL</td>
</tr>
<tr>
<td>2</td>
<td>A B I 2</td>
<td>A, B: INT := 2;</td>
</tr>
<tr>
<td>3</td>
<td>ST S 2; A string</td>
<td>ST:STRING(2); (* A string *)</td>
</tr>
<tr>
<td>4</td>
<td>X %MD12 R 5 Real Number</td>
<td>X AT %MD12: REAL := 5.0;(* Real Number *)</td>
</tr>
<tr>
<td>5</td>
<td>B !</td>
<td>B: BOOL</td>
</tr>
</tbody>
</table>
See also

- Chapter 6.4.1.9.4 “Declaration of Variables” on page 1847

**Smart tag functions**

Smart tags make it easier to write program code by suggest appropriate commands directly at the programming element. When you place the cursor over a programming element that has a smart tag function, the symbol appears. When you click the symbol, the commands that you can choose from are shown. Available smart tags:

- The smart tag function provides the “Declare Variable” command for undeclared variables in the implementation part of the ST editor.

See also

- Chapter 6.4.1.21.3.3.32 “Command ‘Auto Declare’” on page 2572

**6.4.1.9.8 Using Pragmas**

**Pragma in CODESYS**

A pragma is a text in the source code of the application that is enclosed in curly brackets. Pragmas are used to insert special statements in the code, which the compiler can evaluate. This allows a pragma to influence the properties of one or more variables with respect to precompilation or compilation (code generation). Pragmas that the compiler does not recognize are passed over as a comment.

The statement string of a pragma can also extend over multiple lines. For more details about the syntax, see the descriptions of the individual CODESYS pragmas.

There are different pragmas for different purposes (example: initialization of a variable, monitoring of a variable, adding a variable to the symbol configuration, forcing the display of messages during the compilation process, and behavior of a variable under certain conditions).

**NOTICE!**

Uppercase and lowercase characters have to be respected.

**Examples**

```
{warning 'This is not allowed'}

{attribute 'obsolete' := 'datatype fb1 not valid!'}

{attribute 'Test':='TestValue1;
 TestValue2;
 TestValue3'}
```

**Possible insertion positions**

**NOTICE!**

Pragmas in CODESYS are not one-to-one implementations of C preprocessor directives. You have to position a pragma like an ordinary statement. You must not use a pragma within an expression.

A pragma that the CODESYS compiler should evaluate can be inserted at the following positions:
● In the declaration part of a POU:
  – In the textual declaration editor, specify pragmas directly as line(s), either at the beginning of the POU or before a variable declaration.
  – In the tabular editor, you specify pragmas that should be located before the first declaration line in the “Edit Declaration Part” / “Attributes” dialog.
● In a global variable list
● In the implementation part of a POU:
  – The pragma has to be at a "statement position", meaning at the beginning of a POU on a separate line, or after a ";" or END_IF, END WHILE, etc.
  – FBD/LD/IL editor: In networks of the FBD/LD/IL editor, you insert pragmas like a label by means of the “FBD/LD/IL ➔ Insert Label” command. Then, in the text field of the label with the corresponding pragma statement, replace the default text “Label:”. To use a pragma in addition to a label, you specify the pragma first and then the label.

Incorrect and correct positions for a conditional pragma

INCORRECT: 
{IF defined(abc)}
IF x = abc THEN
{ELSE}
IF x = 12 THEN
{END_IF}
y := {IF defined(cde)} 12; {ELSE} 13; {END_IF}
END_IF

CORRECT: 
{IF defined(abc)}
IF x = abc THEN
{IF defined(cde)}
y := 12;
{ELSE}
y := 13;
{END_IF}
END_IF
{ELSE}
IF x = 12 THEN
{IF defined(cde)}
y := 12;
{ELSE}
y := 13;
{END_IF}
END_IF
{END_IF}

In the “Properties” dialog (“Compile” category), you can specify "defines" that can be queried in pragmas.

Scope:
Depending on the type and contents of a pragma, it may influence the following:
● Subsequent declarations
● Exactly the next statement
● All subsequent statements until it is canceled by a corresponding pragma
● All subsequent statements until the same pragma is executed with other parameters or the end of the code is reached. In this context, "code" means the declaration part, implementation part, global variable list, and type declaration. Therefore, a pragma influences the entire object when the pragma is alone on the first line of the declaration part and is not superseded or canceled by another pragma.
The CODESYS pragmas are divided into the following categories:

- Attribute pragmas (influence compiling and precompiling)
- Message pragmas (print user-defined messages when compiling)
- Conditional pragmas (influence code generation)
- User-defined pragmas

See also

- Chapter 6.4.1.9.4.3 “Using the ‘Declare variable’ dialog box” on page 1852
- Chapter 6.4.1.20.6.3 “Attribute Pragmas” on page 2271
- Chapter 6.4.1.20.6.2 “Message Pragmas” on page 2269
- Chapter 6.4.1.20.6.4 “Conditional Pragmas” on page 2318

### 6.4.1.9.9 Using Library POUs

Libraries are collections of objects that you can link to your application. You can use the objects contained in libraries in exactly the same way as objects that you have defined in the project.

Libraries can contain the following objects:

- POUs (for example function blocks, or functions)
- Interfaces and their methods and attributes
- Data types (for example enumerations, structures, aliases, and unions)
- Global variables, constants, and parameter lists
- Text lists, image pools, visualizations, and visual elements
- External files (for example, documentation)
- Cam plate tables

Libraries in a project are managed in the Library Manager. You use the dialog of the library repository to perform the previous installation of the library on the system.

For "visibility" of library POUs and namespaces of libraries, see also the help page for the library properties.

See also

- Chapter 6.4.1.21.3.15.3 “Command ‘Properties’” on page 2714
- Chapter 6.4.1.17 “Using Libraries” on page 2034
- Chapter 6.4.1.21.3.15.3 “Command ‘Properties’” on page 2714

### Using library POUs

The following instructions describe the example of how to insert the counter POU CTUD from the library Standard into your program.

1. Open a POU in the editor and place the cursor in the declaration part.
2. Specify the name for the function block instance, followed by a colon (example: iCounter1:).
4. In the category “Structured Types”, select the CTUD function block from the Standard library (subfolder “Counter”).
   - Select the “Insert with namespace prefix” option.
5. Click “OK” to exit the dialog.

   The function block is inserted with a namespace prefix into the declaration part: iCounter1:Standard.CTUD.
See also

- Chapter 6.4.1.17 “Using Libraries” on page 2034

### 6.4.1.9.10 Managing text in text lists

#### General

Text lists are used for preparing visualization texts for multiple languages. You can specify the texts in Unicode format so that all languages and characters are possible. You can export text lists and then translate the texts outside of the current project.

CODESYS differentiates between static text (managed in the “GlobalTextList” object) and dynamic text (managed in objects of type “TextList”). Static texts exist in the visualization and can change only the displayed language while in runtime mode. The text ID stays the same. Dynamic texts can be controlled by means of an IEC variable that contains the text ID. In this way, you can display varying text in a visualization element in runtime mode. For example, you can configure a text field so that it shows an error text for an error number.

Both text list types include a table with text entries. An entry consists of an ID for identification, the output text, and its translation. In a text list or global text list, you can translate an output text in any number of languages. The translations are the basis for the language selection and the language switch in visualizations.

#### Adding a language and translating text

**Requirement:** A project is open with a text list or global text.

1. Double-click an object of type “TextList” or “GlobalTextList” in the device tree or POUs view.
   - The “Textlist” menu is shown in the menu bar and the text list opens in the editor.

2. Click “Textlist ➔ Add Language”.

3. Specify a name for the language (example: en-US). Click “OK” to close the dialog.
   - A column is displayed with the heading en-US.

4. Type in the translation of the source text into the column.

You can correct the name of a language in the table by means of the command “Rename Language” in the context menu of the text list.

#### Exporting a text list

**Requirement:** A project is open with a text list or global text.

1. Double-click the object “GlobalTextList” or an object of type “TextList”.
   - The object opens.

2. Click “Textlist ➔ Import/Export Text Lists”.
   - The “Import/Export” dialog opens.

3. At “Choose export file”, click for more (⋮) and select the directory and file name (example: Text_lists_exported).

4. Select the “Export” option.
5. Click “OK” to close the “Import/Export” dialog.

→ CODESYS exports to a file the text list entries of all text lists of the project. The table contains a column with the text list names.

Example

<table>
<thead>
<tr>
<th>TextList</th>
<th>Id</th>
<th>Default</th>
<th>en_US</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text_list_A</td>
<td>A</td>
<td>Information A</td>
<td>Information A en</td>
</tr>
<tr>
<td>Text_list_A</td>
<td>B</td>
<td>Information B: OK</td>
<td>Information B_en: OK</td>
</tr>
<tr>
<td>Text_list_A</td>
<td>C</td>
<td>Information C</td>
<td>Information C en</td>
</tr>
<tr>
<td>Text_list_A</td>
<td>D</td>
<td>Information D</td>
<td>Information D en</td>
</tr>
<tr>
<td>Text_list_A</td>
<td>E</td>
<td>Information E</td>
<td>Information E en</td>
</tr>
<tr>
<td>Text_list_A</td>
<td>F</td>
<td>Information F</td>
<td>Information F en</td>
</tr>
<tr>
<td>AlarmGroup</td>
<td>2</td>
<td>Warning 2</td>
<td></td>
</tr>
<tr>
<td>AlarmGroup</td>
<td>1</td>
<td>Warning 1</td>
<td></td>
</tr>
<tr>
<td>GlobalTextList</td>
<td>1</td>
<td>Information B</td>
<td>Information B en</td>
</tr>
<tr>
<td>GlobalTextList</td>
<td>2</td>
<td>Information A</td>
<td>Information A en</td>
</tr>
<tr>
<td>GlobalTextList</td>
<td>3</td>
<td>Switch</td>
<td>Switch</td>
</tr>
<tr>
<td>GlobalTextList</td>
<td>4</td>
<td>Counter: %i</td>
<td>Counter : %i</td>
</tr>
</tbody>
</table>

Preparing the exported file for input assistance

☑ Requirement: A file is created (example: Text_lists_exported) by means of the command “Import/Export Text Lists”. It contains the texts of the text lists of the project.


2. Click in “Text file for textual “List components” ” and select a file (example: Text_lists_exported). Click “OK” to close the dialog.

→ When you specify a static text in the “Texts” property for an element in a visualization, CODESYS offers the source text of the file as input assistance when typing in the first letter.

(1): “Texts”, “Text"

“List components” on page 1886

Importing files with text list entries

A file to be imported has the .csv format. The first line is a header (example: TextList Id Default en_US). The other lines contain text list entries. You get this kind of file by exporting the text lists of the project to a file. There you can edit the text list entries and then import the file outside of CODESYS. When importing, CODESYS handles the text list entries differently for the GlobalTextList and for dynamic text lists.
GlobalTextList

- CODESYS does not create new text list entries for an unknown ID.
- CODESYS ignores changes that affect the ID or the source text.
- CODESYS accepts changes in the translations.

TextList

- For a new ID, CODESYS supplements the corresponding text list with a text list entry.
- For an existing ID that does not agree in the source text, the source text of the text list is overwritten with the source text of the file.
- CODESYS accepts changes in the translations.

Importing a file

☐ Requirement: A project is open with a text list or global text.

1. Double-click the object “GlobalTextList” or an object of type “TextList”.
   ⊳ The object opens.

2. Click “Textlist ➔ Import/Export Text Lists”.
   ⊳ The “Import/Export” dialog opens.

3. In the “Choose file to compare or to import” input field, click for more (…) and select the directory and file (example: Text_lists_corrected.csv).

4. Select the “Import” option.

5. Click “OK” to close the dialog.
   ⊳ CODESYS imports the text list entries of the file into the respective text lists.

Example

<table>
<thead>
<tr>
<th>Contents of the file</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text_lists_corrected.csv</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TextList</th>
<th>Id</th>
<th>Default</th>
<th>en_US</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text_list_A</td>
<td>A</td>
<td>Information A</td>
<td>Information A2_en</td>
</tr>
<tr>
<td>Text_list_A</td>
<td>B</td>
<td>Information B: OK</td>
<td>Information B_en: OK</td>
</tr>
<tr>
<td>Text_list_A</td>
<td>C</td>
<td>Information C</td>
<td>Information C_en</td>
</tr>
<tr>
<td>Text_list_A</td>
<td>D</td>
<td>Information D</td>
<td>Information D_en</td>
</tr>
<tr>
<td>Text_list_A</td>
<td>E</td>
<td>Information E</td>
<td>Information E_en</td>
</tr>
<tr>
<td>Text_list_A</td>
<td>F</td>
<td>Information F</td>
<td>Information F_en</td>
</tr>
<tr>
<td>Text_list_A</td>
<td>G</td>
<td>Information G</td>
<td>Information G_en</td>
</tr>
<tr>
<td>AlarmGroup</td>
<td>2</td>
<td>Warning 2</td>
<td></td>
</tr>
<tr>
<td>AlarmGroup</td>
<td>1</td>
<td>Warning 1</td>
<td></td>
</tr>
<tr>
<td>GlobalTextList</td>
<td></td>
<td>Information B</td>
<td>Information B_en</td>
</tr>
<tr>
<td>GlobalTextList</td>
<td></td>
<td>Information A</td>
<td>Information A_en</td>
</tr>
<tr>
<td>GlobalTextList</td>
<td></td>
<td>Switch</td>
<td>Switch</td>
</tr>
<tr>
<td>GlobalTextList</td>
<td></td>
<td>Counter: %i</td>
<td>Counter: %i</td>
</tr>
</tbody>
</table>

These contents are applied to the text lists with the same name in the project.

☞ Chapter 6.4.1.21.3.21.6 “Command ‘Import/Export Text Lists’” on page 2729

Comparing text lists with a file and exporting differences

☐ Requirement: A project is open with a text list or global text.

1. Double-click the object “GlobalTextList” or an object of type “TextList”.
   ⊳ The object opens.

2. Click “Textlist ➔ Import/Export Text Lists” in the context menu.
   ⊳ The “Import/Export” dialog opens.

3. In the “Choose file to compare or to import” input field, click for more (…) and select the directory and file name of the comparison file (example: Text_lists_corrected.csv).
4. For “Choose export file”, click [ ] and select the directory and file that contains the comparison result.
5. Select the “Export only text differences” option.
6. Click “OK” to close the dialog.

⇒ CODESYS reads the import file and compares the text list entries that have the same ID. If they do not agree, then CODESYS writes the text list entries of the text list to the export file.

For the global text list, CODESYS compares the translations of the same source texts. If they do not agree, then CODESYS writes the text list entries to the export file.

Managing static text in global text lists

The global text list is the central location for texts that are displayed in the visualization.

When you configure a text for the first time in visualization element, CODESYS creates the global text list. CODESYS fills in the table as you create more texts. Therefore, the table includes all texts automatically that you create in the project visualizations. CODESYS assigns incremental IDs as integers, beginning at 0.

You can check, update, and compare the global text list with the static texts of the visualization. You cannot edit the source text or the ID directly in the table. However, you can replace a source text with another source text by creating and importing a replacement file. Menu commands are provided for this purpose.

Configuring visualization elements with static text

A text in a “GlobalTextList” can contain a format definition.

☐ Requirement: A project is open with a visualization. The “GlobalTextList” object contains the texts that are defined in the project visualizations.

1. Double-click the visualization.
   ⇒ The editor opens.

2. Select an element with the “Text” property (example: “Text field”).

3. Type in some text in the “Text” property (example: Static Information A).
   ⇒ CODESYS adds the text to the global text list in the POU view.

Checking the global text list

☐ Requirement: A project is open with a visualization. The “GlobalTextList” object contains the texts that are defined in the project visualizations.

1. Double-click the “GlobalTextList” object in the POUs tree.
   ⇒ The table opens with the static texts.
2. Click “Text List ➔ Check Visualization Text IDs”.
   - CODESYS reports when a source text of the text list does not match the static text that is identified by the ID. The source text in the global text list and the text in the visualization with the same ID do not match.

Updating IDs of the global text list

- Requirement: A project is open with a visualization. The “GlobalTextList” object contains the texts that are defined in the project visualizations.
  1. Double-click the “GlobalTextList” object in the POUs tree.
     - The list opens with the text list entries.
  2. Click “Text List ➔ Update Visualization Text IDs”.
     - CODESYS adds text to the global text list when a text in the “Static Text” property does not match the source text in the project visualizations.

Removing the global text list and creating current IDs again

- Requirement: A project is open with a visualization. The “GlobalTextList” object contains the texts that are defined in the project visualizations.
  1. Right-click the “GlobalTextList” object in the POUs tree and select the “Delete” command.
     - The object is removed.
  2. Open a visualization.
  3. Click “Visualization ➔ Create Global Text List”.
     - In the POU view, a new “GlobalTextList” object is created. The global text list contains the static text from the existing project visualizations.

Removing IDs from the global text list

- Requirement: A project is open with a visualization. The “GlobalTextList” object contains the texts that were defined in the project visualizations.
  1. Double-click the “GlobalTextList” object in the POUs tree.
     - The table opens with the texts.
  2. Click “Text List ➔ Remove Unused Text List Entries”.
     - CODESYS removes the text list entries with IDs not referenced in the project visualizations.

Updating the global text list with a replacement file

A replacement file has the CSV format. The first row is a header: defaultold defaultnew REPLACE. The following rows contain the old source texts, the new source texts, and then the REPLACE command. Tabs, commas, and semicolons are permitted separators. A combination of separator characters in a file is not permitted.

Example (tab as separator character)

<table>
<thead>
<tr>
<th>defaultold</th>
<th>defaultnew</th>
<th>REPLACE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information A</td>
<td>Information A1</td>
<td>REPLACE</td>
</tr>
</tbody>
</table>
When you import a replacement file, CODESYS processes the replacement file row by row and performs the specified replacements in the “GlobalTextList”. In addition, CODESYS replaces the previous text with the replacement text in the visualizations. If the replacement text already exists as static text, then CODESYS recognizes this and harmonizes the static text and leaves only one text list entry.

☑ Requirement: A project is open with a text list or global text.
1. Double-click the “GlobalTextList” object.
   ⇒ The object opens.
2. Click “Text List ➔ Import/Export Text Lists”.
   ⇒ The “Import/Export” dialog opens.
3. At the “Choose file to compare or to import” input field, click for more (…) and select the directory and file (example: ReplaceGlobalTextList.csv).
4. Select the “Import replacement file” check box.
5. Click “OK” to close the dialog.
   ⇒ The texts in the text lists and the visualizations are replaced.
Example

The global text list contains the following source texts:

- GlobalTextList Counter: %i
- GlobalTextList Information A
- GlobalTextList Information Aa
- GlobalTextList Switch

The replacement file contains the following replacements:

- defaultold defaultnew REPLACE
- Counter: %i Counter2: %i REPLACE
- Information A Information A2 REPLACE
- Information a Information A2 REPLACE
- Information Aa Information A2 REPLACE
- Switch Switch2 REPLACE

CODESYS detects duplicate text list entries and removes them. Afterwards, the global text list contains the following source texts:

![Text visualization]

The texts in the visualization have been replaced.

See also

- [% Chapter 6.4.1.21.3.21.2 “Command ‘Create Global Text List’” on page 2728
- [% Chapter 6.4.1.21.3.21.10 “Command ‘Check Visualization Text IDs’” on page 2731
- [% Chapter 6.4.1.21.3.21.11 “Command ‘Update Visualization Text IDs’” on page 2731
- [% Chapter 6.4.1.21.2.11 “Object ‘GlobalTextList’” on page 2465
Managing dynamic text in text lists

You can create and translate texts in a text list for dynamic texts in order to show them dynamically in a visualization or in the alarm management. The object of type “Text list” can be located globally in the POUs view or below an application in the device tree. It contains a table with text list entries that you can edit and extend. A text list entry consists of an ID for identification, the output text, and its translation. You can add new text list entries to a text list. Menu commands are provided for this purpose.

Creating text lists for dynamic text output

Requirement: A project is open with a visualization.

1. Select an application in the POUs view or device tree and click “Project ➔ Add Object”.
2. Select “Text list”.
3. Type a name (example: Textliste_A). Click “Add” to close the dialog.
   ➞ An object of type “Text list” is created.
4. Click below the “Default” column and open the input field. Type a text (example: Information).
   ➞ The source text is created. It is used as a key in the table and as a source text for translations.
5. Type any string in the “ID” column (example: A).
   ➞ A text list entry is defined with source text and ID. If you configure the “Dynamic texts” property of an element in a visualization, then you can select the text list Textliste_A and assign the ID A.
6. Double-click in the blank line at the end of the table below “Default” and type in more text list entries.

<table>
<thead>
<tr>
<th>ID</th>
<th>Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Information A</td>
</tr>
<tr>
<td>B</td>
<td>Information B</td>
</tr>
<tr>
<td>C</td>
<td>Information: OK</td>
</tr>
</tbody>
</table>

Displaying text dynamically

In a visualization, you can configure the dynamic output of texts that were created in a text list by configuring the “Dynamic texts” property of an element. You can directly assign a text list and an ID, as well as IEC variables, where you set the values programmatically.

Requirement: A project with visualization is open and a text list is in the device tree.

1. Open the text list (example: Text_list_A).
2. Double-click the visualization.
   ➞ The editor opens.
3. Drag an element to the visualization (example: a “Text field”).
4. Configure its “Dynamic texts” property by selecting one in the “Text list” property (example: 'Text_list_A') and add an ID from the text list into the “Text index” (example: 'A'). Pay attention to the single straight quotation marks. You can also assign an IEC variable of type STRING for the text list name and ID.

   ⇒ The IEC variables allow for programmatic access to the texts of the text lists.

5. Build the application, download it to the controller, and start it.

   ⇒ The visualization shows the text from the text list in the text field: Information A.

See also
● Chapter 6.4.1.21.2.28 “Object 'Text List’” on page 2532

6.4.1.9.11 Using image pools

An image pool is a table of image files. CODESYS references image files for use in the project (for example, in a visualization) uniquely by the ID and name of the image pool. A project can include several image pools. You can create image pools in the device tree below the application or in the POU pool. In a library project, you can use the object properties of an image pool to turn it into a symbol library for the visualization.

We recommend that you reduce the size of image files as much as possible integrating them. This will optimize the loading time of the visualization in every visualization type: TargetVisu, WebVisu and development system.

If you insert an image element into a visualization and enter an ID (“Static ID”) in the element properties, then CODESYS automatically creates a global image pool. CODESYS uses the default name “GlobalImagePool” for this.

Please note the following when the ID of an image file appears in several image pools.

● Search order: If you selected an image managed in “GlobalImagePool”, then you do not have to enter the name of the image pool. The search order for image files is as follows:
  1. GlobalImagePool
  2. Image pools assigned to the currently active application
  3. Image pools next to the GlobalImagePool in the POU window
  4. Image pools in libraries

● Unique access: You can reference a selected image directly and uniquely by appending the image ID to the name of the image pool in the following syntax:\"<pool name>.<image ID>\".

See also
● Chapter 6.4.1.21.2.15 “Object 'Image Pool’” on page 2468
● Chapter 6.4.1.21.4.11.18 “Dialog 'Properties' - 'Image Pool’” on page 2764

Creating image pools

1. Select the “Application” object in the device tree.
   Click “Project ➔ Add Object ➔ Image Pool”.
   ⇒ The “Add Image Pool” dialog box opens.

2. Type a name for the image pool (for example, "Images1") and click “Add”.
   ⇒ The image pool is added to the device tree.

3. Select the image pool object and open by choosing the command “Project ➔ Edit Object”.
4. Double-click the field in the “ID” column and assign an appropriate ID (for example, “Icon1”).
   You can also add new images to the list by clicking “Imagepool ➔ Add Image File”.
5. Double-click the field in the “File name” column. Click for more settings (…).
   The “Select Image” dialog box opens.
6. Click for more settings (….) and select the image file.
   A thumbnail of the image file is displayed in the field of the column “Image”. The name
   of the file is displayed in the field of the column “File name”.

The image file can be references only by the name Images1.Icon1.

See also
- Chapter 6.4.1.21.3.16.1 “Command ‘Insert Image’” on page 2717

**Using image files in the 'Image' visualization element**

When you insert an image element into a visualization, you can define the image type.
- Static image: Enter the image ID of the image file or the name of the image pool plus the
  image ID into the element configuration (property “Static ID”). Please note the comments for
  the search order and access.
- Dynamic image: Type the variable for defining the image file ID (for example,
  PLC_PRG.imagevar) in the element configuration (“Bitmap ID variable” property). You can
  exchange a dynamic element in online mode depending on a variable.

See also
- Chapter 6.4.5.20.1.5 “Visualization Element 'Image'” on page 3038

**Using image files for the visualization background**

You can set an image in the background definition of a visualization. You can define the
image by the name of the image pool plus the filename, as described above for a visualization
element.

See also
- Chapter 6.4.5.21.2.10 “Command ‘Background’” on page 3349

**6.4.1.9.12 Programmatic Access to I/Os**

**General**

CODESYS provides the following features for mapping project variables to input, output and
memory addresses:
- Assignment of project variables to input, output and memory addresses in the “I/O Mapping”
  tab of the device editor
- Programmed access to I/Os
  - Variables configuration
  - AT declaration

**NOTICE!**

We recommend that you define the mapping of project variables to input, output
and memory addresses in the “I/O Mapping” of the editor of the respective
device.

See also
- Chapter 6.4.1.8.2 “Configuring Devices and I/O Mapping” on page 1836
Variables configuration - VAR_CONFIG

Use the variables configuration for mapping variables of functions blocks to the process map. For declarations in the function block, assign the variables to the device inputs/outputs without providing the full address. Later, the exact address is provided centrally for all function block instances of the application in a global variable list including VAR_CONFIG declarations. This global variables list with the VAR_CONFIG declarations is termed the "variables configuration".

**NOTICE!**
For changes to variables that are assigned to I/O addresses, CODESYS displays them immediately in the process map. For changes to variables that are mapped by a variables configuration, CODESYS displays them not until the end of the responsible task.

Declaration of variables in functions blocks

When declaring variables in a function block, declare the variables between the keywords VAR and END_VAR and assign incomplete addresses to the variables. Mark these incomplete addresses with an asterisk (*).

Syntax:

```
<identifier> AT %<I|Q>*:<data type>;
```

**Example**
Define two local I/O variables: the input variable xLocIn and the output variable xLocOut.

```plaintext
FUNCTION_BLOCK locio
VAR
  xLocIn AT %I*: BOOL := TRUE;
  xLocOut AT %Q*: BOOL;
END_VAR
```

Final definition of addresses in the variables configuration of the global variables list

In the global variables list that you use as the variables configuration, define the variable declarations with the absolute addresses between the keywords VAR_CONFIG and END_VAR.

You must declare the VAR_CONFIG variables with the complete instance path, separating the individual POU and instance name by a dot (.). The declaration must include an address whose class (input/output) agrees with the class of the incomplete address (%I*, %Q*) in the function block. The data type must also agree.

Syntax:

```
<instance variable path> AT %<I|Q><location>: <data type>;
```

If the path instance does not exist, then an error is reported. CODESYS prints an error also if there is not an address configuration available for a variable that you declared with an incomplete address.

**Example**
The locio function block in the example above is used in a program as follows:

```plaintext
PROGRAM PLC_PRG
VAR
  locioVar1: locio;
  locioVar2: locio;
END_VAR
```

A correct variables configuration in a global variable list could then look like this:

```
VAR_CONFIG
  PLC_PRG.locioVar1.xLocIn AT %IX1.0 : BOOL;
  PLC_PRG.locioVar1.xLocOut AT %QX0.0 : BOOL;
  PLC_PRG.locioVar2.xLocIn AT %IX1.0 : BOOL;
  PLC_PRG.locioVar2.xLocOut AT %QX0.3 : BOOL;
END_VAR
```
Creating a variables configuration

Requirement: You have a project open that includes a controller configuration with a field device. The project contains a program (e.g. PLC_PRG) and a function block (e.g. func1). The field device has inputs and outputs. The textual view is selected in the options for the declaration editor.

1. Double-click a function block in the device tree (e.g. func1).
   → The function block editor opens.
2. Type the following between the keywords VAR and END_VAR:
   xLocIn AT %I*: BOOL := TRUE;
   and
   XLocOut AT %Q*:BOOL; in the next line.
   → You have declared an input variable xLocIn and assigned it to the incomplete input address %I* of a field device. You have assigned the declared output variables have to the incomplete output address %Q*.
3. Click the PLC_PRG object in the device tree and add the following to the declaration section of the program between VAR and END_VAR:
   locioVar1: func;
   locioVar2: func;
4. Right-click the “Application” object in the device tree and click “Add Object → Global Variable List” and then click “Add” in the “Add Global Variable List” dialog box.
   → The global variables list is added to the device tree and opens in the editor.
5. Change the keyword VAR_GLOBAL to VAR_CONFIG.
6. Click “Declarations → Add All Instance Paths”.
   → The following instance paths are added:
   PLC_PRG.logioVar1.xLocIn AT %I*;
   PLC_PRG.logioVar2.xLocIn AT %I*;
   PLC_PRG.logioVar1.xLocOut AT %Q*;
   PLC_PRG.logioVar2.xLocOut AT %Q*;
7. Now, replace the incomplete addresses %I* and %Q* with the absolute, complete addresses.

See also
- Chapter 6.4.1.20.2.11 “Configuration variables - VAR_CONFIG” on page 2121
- Chapter 6.4.1.9.12.3 “AT declaration” on page 1902
- Chapter 6.4.1.20.4.12 “Addresses” on page 2231

AT declaration

In the variables declaration, the code AT assigns a project variable to a specific input address, output address, or memory address of the PLC that is configured in the device tree. You can also define the assignment of variables to an address in the “I/O Mapping” dialog of the device in the PLC configuration.

Syntax

<variable name> AT <address> : <data type>;

<address> : %<memory area prefix> ( <size prefix> )? <memory position>
The AT declaration allows you to give the address a meaningful name. You can make any necessary changes for the input or output signals at just one location, for example in the declaration.

### Examples

<table>
<thead>
<tr>
<th>Declaration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VAR wInput AT %IW0 : WORD; END_VAR</td>
<td>Variable declaration with address information of an input word</td>
</tr>
<tr>
<td>VAR xActuator AT %QW0 : BOOL; END_VAR</td>
<td>Boolean variable declaration</td>
</tr>
<tr>
<td>Note: For Boolean variables, one byte is allocated internally if a single bit address is not specified. A change in the value of \textit{xActuator} affects the range from \textit{QX0.0} to \textit{QX0.7}.</td>
<td></td>
</tr>
<tr>
<td>VAR xSensor AT IX7.5 : BOOL; END_VAR</td>
<td>Boolean variable declaration with explicit specification of a single bit address. On access, only the input bit 7.5 is read.</td>
</tr>
<tr>
<td>VAR xSensor AT IX* : BOOL; END_VAR</td>
<td>For the address specification, the placeholder * is given instead of the memory position. The final address specification is done in the variables configuration.</td>
</tr>
<tr>
<td>Note: This is possible in function blocks.</td>
<td></td>
</tr>
</tbody>
</table>

If you assign a variable to an address, please note the following:

- You cannot write to variables that are placed at inputs. This will cause a compiler error.
- You can perform AT declarations only for local and global variables, not for input/output variables of POU's.
- Furthermore, AT declarations cannot be used in persistent variable lists.
- If you use AT declarations for structure components or function block variables, then all instances use the same memory. This is just like using static variables in classic programming languages, such as C.
- The memory layout of structures also depends on the target system.

**NOTICE!**

If you do not specify a single bit address explicitly, then Boolean variables are allocated byte-by-byte.

**Example**

```plaintext
PROGRAM PLC_PRG
VAR
    xVar AT %QW0 : BOOL;
END_VAR

xVar := TRUE;
```

When the variable \textit{xVar} is written, the output memory range from \textit{QX0.0} to \textit{QX0.7} is affected.

See also

- § Chapter 6.4.1.9.12.2 “Variables configuration - VAR_CONFIG” on page 1901
- § Chapter 6.4.1.20.2.11 “Configuration variables - VAR_CONFIG” on page 2121
- § Chapter 6.4.1.20.4.12 “Addresses” on page 2231
6.4.1.9.13 Checking Syntax and Analyzing Code

General

CODESYS provides useful functions for detecting errors and assisting you while you create programs. The syntax check flags errors and prints them to the message view as early as the programming phase.

The static code analysis in CODESYS also assists you in complying with defined coding guidelines and detecting weak constructs.

See also
- Chapter 6.4.1.9.13.2 “Checking Syntax” on page 1904
- Chapter 6.4.1.9.13.3 “Analyzing code statically” on page 1904

Checking Syntax

When you input code, the precompile in CODESYS already runs some basic checks. Then, wavy underlines appear under buggy code in the editor and an error message is printed to the messages view.

CODESYS automatically generates the application code from the source code that was written in the development system. This is done automatically before downloading the application to the PLC. Before the application code is generated, a test is performed for checking the allocations, the data types, and the availability of libraries. Moreover, the memory addresses are allocated when the application code is generated. You can click "Build ➔ Generate Code" to execute this command explicitly, or press the [F11] key. This is useful for detecting any errors in your source code, even when the PLC is not connected yet.

CODESYS prints all errors and warnings to the "Build" category of the messages view. Double-clicking the error message opens the respective POU in the editor with the buggy code marked. As an alternative, you can also jump to the buggy code by right-clicking the error message.

Note the settings for this in the CODESYS options.

See also
- Chapter 6.4.1.21.4.14.24 “Dialog ‘Options’ - ‘SmartCoding’” on page 2796

Analyzing code statically

You can subject your source code also to static analysis (lint) during the code generation. This determines whether or not your source code complies with the coding guidelines that you defined - according to the idea behind the lint analysis tool.

- You activate the rules to the checked in the “Project Settings” dialog in the “Static Analysis Light” category. The check itself is performed automatically each time code is generated, for example when you click “Build ➔ Generate Code”. If divergence from the rules is determined, then it is reported as an error message in the “Build” category of the message view. The reported errors have the prefix `SA<number>`.

**NOTICE!**

For static code analysis with “Static Analysis Light”, only the application code of the project is checked. Libraries are excluded from the check.

GVL variables in the “POUs” view are not necessarily checked: If you have a project with several applications, then only the objects in the active application are checked. If you have only one application, then the objects in the common POU pool are also checked.
“Static Analysis Light” includes only a reduced set of rules in the default development system. A larger set of rules, additional naming conventions, and metrics are available when you install the CODESYS Static Analysis add-on.

Deactivating lines of code in the implementations with pragmas from the static analysis

By means of the pragma `{analysis ...}`, you can mark code so that the specified rules are not checked. As a result, the marked lines of code are not subjected to static analysis. The marked code is ignored during the check.

Syntax:
```
{analysis <sign><rule number>|,<other combinations of signs and rules, comma-separated>}
```
- `<rule number>`: Deactivate the rule SA<rule number>.
- `<rule number>`: Activate the rule SA<rule number>.

Requirement: Rules are activated in the “Project Settings” dialog.

1. Add the pragma `{analysis -<number>}` above the line of code that contains code not to be checked first of all. For example, for the rule SA0024
   - The line of code is the first line of the code snippet that is not checked with rule 24.
2. Add the pragma `{analysis -<number>}` below the line of code that contains code not to be checked first of all. For example, for the rule SA0024
   - The line of code above is the last line of the code snippet that is not checked with rule 24.

Example:
Ignore untyped literal

```
{analysis -24}
nTest := 99;
iVar := INT#2;
{analysis +24}
```

The rule “SA0024: Untyped literals only” is deactivated for two lines. An error is not issued although the code does not correct to: `nTest := DINT#99;`

Example:
Ignore several rules

```
{analysis -10, -24, -18}
...{analysis +10, +24, +18}
```

“SA0010: Arrays with only one component”
“SA0018: Unusual bit access”
“SA0024: Untyped literals only”

However, you cannot deactivate the rule SA0004: “Multiple Write Access on Output” with a pragma.
Excluding programming objects with pragmas from the static analysis

Syntax:
{attribute 'analysis' := '-<rule number>[,<other negative rule numbers, comma-separated>]'}

When you insert the attribute pragma in the declaration part of a programming object, the specified rules are excluded for the entire programming object. If multiple rules are excluded, then the rules are each comma-separated with a dash and a number. A pragma statement for activation is not required.

Example

```plaintext
{attribute 'analysis' := '-33, -31'}
TYPE LocalData :
  STRUCT
    iLocal : INT;
    uiLocal : UINT;
    udiLocal : UDINT;
  END_STRUCT
END_TYPE
```

The rules SA0033 and SA0031 are ignored for the structure LocalData.

```plaintext
{attribute 'analysis' := '-100'}
big: ARRAY[1..10000] OF DWORD;
```

The rule SA0100 is ignored for the array big.

See also
- Chapter 6.4.1.21.4.12.9 “Dialog ‘Project Settings’ - ‘Static Analysis Light’” on page 2773

6.4.1.9.14 Orientation and Navigation

Using the cross-reference list to find occurrences

The occurrences of symbols of a variable, a POU (program, function block, function), or a DUT can be displayed in a cross-reference list. Then you can jump from the list directly to the corresponding locations in the project.

There are two ways to search for occurrence locations of a symbol:
- Plain text search: You manually specify a text (symbol name, placeholder) in the “Cross-Reference list” view.
- Search for a specific declaration:
  - In the “Cross-Reference List” view, you select the declaration from the input assistant.
  - The focus is on a symbol name in the POU editor and you start the cross-reference search from the context menu.
  - The focus is on a symbol name in the POU editor, the “Cross-Reference List” view is open, and the cross-reference search executes automatically.
  - In the “Cross-Reference List” view which already lists occurrence locations for several declarations, you limit these results to a specific declaration.
Requirement: The “Cross-Reference List” view is open.

1. Specify a string in the field next to the name, for example the identifier of the variable for which you want to find the occurrence location in the project. Example: "iCounter".
   For the text search, you can use the asterisk "*" (for any number of characters) or the question mark "?" (for an exact number of characters) combined with a substring of a variable identifier.
   Use the percent sign "%" to search for IEC addresses. Examples: "%MW8", "%M%".
2. Click the ➡ button to start a text search in the project.
   ➡ The view “Cross-Reference List” opens and displays the occurrence locations for the iCounter variable. The declaration parts are always displayed in the project with the occurrence location indented.
3. Double-click an occurrence location in the cross-reference list.
   ➡ The respective object opens in the editor with the marked occurrence location.

Requirement: A POU is open in the editor.

From the POU editor, with a menu command

1. Set the cursor at the identifier of the symbol (variable, POU) in the declaration part or implementation part.
2. Click “Browse for Symbol ➔ Browse Cross-References” in the context menu or “Edit” menu.
   ➡ The “Cross-Reference List” view opens and shows the occurrence locations of the variables or POU.

If the “Cross-Reference List” view is already open, then you can also search the occurrence locations for a specific result as follows:

From the POU editor, automatic

Select the “Automatically list selection in cross reference view” check box in “Tools ➔ Options” (“SmartCoding” category). Select the name of the symbol in the POU, or set the cursor in the name.
   ➡ Depending on the position of the selection or cursor, the cross-reference list automatically shows the occurrence locations for the respective symbol.

In the cross-reference list view, with input assistance

In the “Cross-Reference List” view, use the input assistant 🔍 to specify a symbol name in the field next to “By declaration”.
   ➡ The cross-reference list displays the occurrence locations for the symbol.

In the cross-reference list view, limited to a specific declaration

If multiple declarations for a symbol are listed in the “Cross-Reference List” view, for example after a text search, then you can reduce the display to one result: Select the line with the desired declaration and click the ➡ button or click “Limit Results to Current Declaration” in the context menu.
   ➡ The cross-reference list includes only the occurrence locations for the selected declaration.
Finding declarations

CODESYS provides the capability of searching the entire project for the definition location of a variable or function. The block that includes the definition opens in the editor with the marked declaration.

Finding the declaration of a variable

Requirement: You have opened a POU in the editor.

1. Set the cursor at an identifier in the implementation section.
2. Click “Edit ➔ Browse ➔ Go to Definition”.

⇒ The POU with the declaration opens in the editor with the variable definition marked. If the definition is located in a compiled library, then the respective block opens in the library manager.

You can execute this command in both online and offline mode.

Examples

The following block includes a function block definition (fbinst), a program call (prog_y()), and a function block call (fbinst.out):

VAR fbinst:fb1; ivar:INT; END_VAR prog_y(); ivar:=prog_y.y;
res1:=fbinst.out;

If the cursor is located at prog_y, then the command opens the program prog_y in the editor.
If the cursor is located at fbinst, then this command focuses in the declaration section at line fbinst:fb1;
If you set the cursor at out, then this command opens the function block fb1 in its editor.

Setting and using bookmarks

Bookmarks are used for easy navigation through long programs. You can use bookmarks in all implementation language editors, except SFC (sequential function chart). Commands help to navigate directly to the marked position in the program.

Setting and deleting bookmarks

Requirement: The POU is open in the editor.
1. Set the cursor at any program line.
2. Click “Edit ➔ Bookmarks ➔ Toggle Bookmark”.
   ⇒ A bookmark is set at this position in the program. This is marked by the bookmark symbol ▶.
3. Set several bookmarks at different places in the program.
4. Set the cursor at a bookmarked program line.
5. Click “Edit ➔ Bookmarks ➔ Toggle Bookmark”.
   ⇒ The bookmark is removed. The bookmark symbol ▶ is deleted.

As an alternative to this, you can delete one or more bookmarks in the “Bookmarks” view by clicking the X button. For this purpose, the corresponding bookmarks have to be selected in the “Bookmarks” view.

Click “Edit ➔ Bookmarks ➔ Clear All Bookmarks (Active Editor)” to remove all bookmarks from the active POU.

In order to delete all bookmarks in a project, click “Clear All Bookmarks”. However, for this command to be available, you first have to add it to a menu by means of the command “Tools ➔ Customize”.

See also
• Chapter 6.4.1.21.3.3.22 “Command ‘Toggle Bookmark’” on page 2569
• Chapter 6.4.1.21.3.3.27 “Command ‘Clear All Bookmarks (Active Editor)’” on page 2571
• Chapter 6.4.1.21.3.3.28 “Command ‘Clear All Bookmarks’” on page 2571

Jumping to bookmarks within a POU

Requirement: The POU is open in the editor. Multiple bookmarks are set.

1. Click “Edit ➔ Bookmarks ➔ Next Bookmark (Active Editor)”.
   ⇒ Depending on the current cursor position, the cursor jumps to the next bookmark (see below).
2. Click “Edit ➔ Bookmarks ➔ Previous Bookmark (Active Editor)”.
   ⇒ Depending on the current cursor position, the cursor jumps to the previous bookmark (see above).

See also
• Chapter 6.4.1.21.3.3.23 “Command ‘Next Bookmark (Active Editor)’” on page 2570
• Chapter 6.4.1.21.3.3.25 “Command ‘Previous Bookmark (Active Editor)’” on page 2570

Jumping to bookmarks of different POUs in a project

A project is open with multiple POUs. Multiple bookmarks are set in different POUs.
1. Click “View ➔ Bookmarks”.  
   ➔ The “Bookmarks” view opens.  
   All bookmarks in the project are listed in a table in the view.
2. Click the “Next Bookmark” button.  
   ➔ In the “Bookmarks” view, the bookmark in the row below the selected bookmark is selected.  
   The POU with the recently selected bookmark in the table opens in the editor and the row with the bookmark is selected in the POU.
3. As in step 2, you can click the “Previous Bookmark” button to jump to the bookmark in the project that is displayed in the row above it in the “Bookmarks” view.

See also
- Chapter 6.4.1.21.3.4.11 “Command 'Bookmarks'” on page 2585
- Chapter 6.4.1.21.3.3.26 “Command 'Previous Bookmark'” on page 2570
- Chapter 6.4.1.21.3.3.24 “Command 'Next Bookmark'” on page 2570

6.4.1.15 Searching and replacing in the entire project
In CODESYS you can search for strings in single objects or project-wide. If required, you can replace the string found.
1. Choose the command “Search” in the main menu “Edit ➔ Search Replace”.  
   ➔ The dialog “Find” opens.
2. Enter the string to be found in the field “Find what”.  
3. Activate the search options  
4. Define the objects to be searched by choosing an entry from the combobox “Search”.  
5. Click on the button “Find Next”.  
   ➔ The first hit is displayed.
6. Click on the button “Replace” to replace the string found by a different one.  
7. Click on the button “Find All” to get a list of all hits.

See also
- Chapter 6.4.1.21.3.3.2 “Command 'Find', 'Find in Project'” on page 2563
- Chapter 6.4.1.21.3.3.3 “Command 'Replace', 'Replace in Project'” on page 2564

6.4.1.16 Refactoring
In general, refactoring is a technique for improving the design of existing software code without changing the way it functions.
In CODESYS, refactoring provides functions for renaming objects and variables and updating referenced pins. You can display all occurrences of renamed objects and variables and then rename them all at once or individually. In “Tools ➔ Options”, you can also configure where CODESYS will prompt you for refactoring.

Renaming global variables
Requirement: A project is open that includes at least a function block “FB” and a global variable list. The global variable list “GVL” is open in the editor and contains a variable declaration (example: iGlobal). “FB” uses iGlobal.
Renaming global variables throughout the project

1. Select the global variable name `iGlobal`.
2. Right-click the variable and click “Refactoring ➔ Rename `iGlobal`”.
3. In the “Rename” dialog, type a name in the “New name” input field, for example `iGlobalOK`, and click “OK”.
   - The “Refactoring” dialog opens. In the device tree view on the left, the “GVL” and “FB” objects are highlighted in red and yellow. In the view on the right, “FB” is in open in its editor and `iGlobal` has already been renamed as `iGlobalOK`.
4. Click “OK”.
   - No global variable `iGlobal` is in your project. Now `iGlobalOK` is everywhere.

Renaming global variables throughout the project (except for a POU)

1. Select the global variable name `iGlobal`.
2. Right-click the variable and click “Refactoring ➔ Rename `iGlobal`”.
3. In the “Rename” dialog, type a name in the “New name” input field, for example `iGlobalTest`, and click “OK”.
   - The “Refactoring” dialog opens. In the device tree view on the left, the “GVL” and “FB” objects are highlighted in red and yellow. In the window on the right, the function block “FB” is open in its editor. `iGlobalTest` is listed instead of `iGlobal`.
4. Right-click in the view on the right.
5. Click “Reject this Object” and click “OK”.
   - The global variable `iGlobal` is available in “FB” in your project. The variable `iGlobalTest` is now specified in the objects where the previous variable occurred.
   - The error message in the message view reports that the `iGlobal` identifier is not defined.

Adding and removing input variables

In the declaration part of blocks, you can add and delete input and output variables by using the refactoring commands. CODESYS performs updates at the occurrence locations and calling locations of the blocks. You can accept or reject these updates individually. The “Refactoring” dialog also opens for this purpose.

Requirement: The FCT (function type) POU is open in the editor. The function already contains the input variables `input1`, `input2`, and `inputx`. They are called in the PLC_PRG and POU programs.

1. Set the focus in the declaration part of the FCT function.
2. Click “Refactoring ➔ Add Variable”.
   - The default dialog opens for declaring variables.
3. Declare the variable `input_3` with the scope of `VAR_INPUT` and data type `INT`. Click “OK” to close the dialog.
   - The “Refactoring” dialog opens (see figure below). The affected locations are marked in yellow. (1)+(2)
4. In the upper right corner, select “Add inputs with placeholder text” from the drop-down list. (3).
5. In the left side of the window, click one of the highlighted objects (for example, PLC_PRG). Right-click and choose the “Accept Whole Project” command to add the new variable at the new location of use in FCT for the entire project.
   - You see the change in the implementation part of PLC_PRG in the view on the right: The placeholder `_REFACTOR_` appears at the location where the new variable was added.
6. Click “OK” to close the “Refactoring” dialog.
7. Click “Edit ➤ Find”. Search the project for "_REFACTOR_" to check and edit the affected locations.

8. Note: As an alternative, you can insert the new variable with another initialization value without working with a placeholder first. In this case, in Step 4 you select "Add inputs with the following value" and type the value in the field on the right side of the drop-down list.

Example of a new variable with placeholder text in a CFC block:

Please note that you can also remove variables with refactoring.

Reordering variables in the declaration

In the declaration part of function blocks, you can change the order of declarations by refactoring. This is possible for declarations with scope VAR_INPUT, VAR_OUTPUT, or VAR_IN_OUT.

Requirement: The declaration part of a POU is open and includes declarations, for example:
VAR_INPUT
  invar2 : INT;
  invar1 : INT;
  in : DUT;
  bvar : BOOL;
  invar3 : INT;
END_VAR

1. Right-click in this declaration block to access the context menu.
2. Click “Refactoring ➔ Reorder Variables”.
   ⇨ The “Reorder” dialog opens with a list of VAR_INPUT variables.
3. Drag the “invar1 : INT;” entry to the position before the “invar2.” entry.
   ⇨ The invar1 declaration is now at the top position.
4. Click “OK” to close the dialog.
   ⇨ The “Refactoring” dialog opens. The affected locations are marked in yellow (see figure above).
5. Click “OK” to accept the new order for the function block.

Changing a variable declaration and applying refactoring automatically

Refactoring helps you in the declaration when renaming variables (by means of "Auto declare").

☐ Requirement: Function block fb_A.
1. Click “Tools ➔ Options”.
   ⇨ The “Options” dialog opens.
2. Select the “Refactoring” category.
3. In “Auto-Declare”, activate the options “On renaming variables” and “On adding or removing variables, or for changing the namespace”.
4. Double-click the function block fb_A.
5. Select a variable in the declaration of fb_A, for example iA. As an alternative, you can set the cursor before or in the variable.
6. Specify “Edit ➔ Declare variable” ([Shift]+[F2]).
   ⇨ The “Declare Variable” dialog opens. The dialog includes the settings of iA.
7. Change the name of iA to iCounter_A.
8. The option “Changes by means of refactoring” appears and is activated.
9. Click “OK”.
   ⇨ The dialog “Refactoring “Renaming from iA to iCounterA” opens. All locations affected by the variable renaming are marked there.
10. Click “OK” to close the dialog.
    ⇨ The changes are applied.

See also
- Chapter 6.4.1.21.3.3.40 “Command 'Refactoring' - 'Rename <...>’” on page 2577
- Chapter 6.4.1.21.3.3.41 “Command 'Refactoring' - 'Update Referenced Pins’” on page 2578
- Chapter 6.4.1.21.3.3.42 “Command 'Refactoring' - 'Add Variable’” on page 2578
- Chapter 6.4.1.21.3.3.43 “Command 'Refactoring' - 'Remove <variable>’” on page 2580
6.4.1.9.17 Task Configuration

General

In the task configuration, you define one or more tasks for controlling and executing the application program in the controller. Each application must include a “Task Configuration” object.

A task is a time-based flow unit of an IEC program. You define a task with a name, a priority, and a type, which determines which condition triggers the start of the task. You can define this condition either by time (cyclic-interval, freewheeling) or by the occurrence of an internal or external event to process the task. Examples of an event are the rising edge of a global project variable or an interrupt event of the controller.

A task calls one or more program blocks (POUs). These programs can be application-specific (objects below the application in the device tree) or project-specific (objects available in the POU window). In the case of a project-specific program, the application instances the project-global program. If CODESYS processes the task in the current cycle, then the programs are executed for the duration of a cycle.

With the combination of priority and condition, you define the order in which the tasks are processed. You can configure a watchdog for each task, and you can link a start, stop, and reset directly to the execution of the project block.

Rules for the processing order of the defined tasks:

- If the task condition is satisfied, then CODESYS processes the task.
- If several tasks satisfy the condition for processing at the same time, then CODESYS processes the tasks with the highest priority first.
- If several tasks with the same priority level satisfy the condition for processing at the same time, then CODESYS processes the longest waiting task first.
- The program calls are processed in the order they appear in the configuration dialog of the task.
- If a called program has the same name in the device tree of the application and in a library or project-global in the POU window, then the application program is used.

Attention

All tasks share one process map. The reason is as follows: When each task has its own individual process map, performance is compromised. However, the process map can be consistent only with one task. When you create a project, you must ensure that the application copies the input and output data to a safe location in case of conflicts. Modules, such as the library SysSem, provide the capability of solving consistency and synchronization problems.

Consistency problems can also occur when accessing other global objects, such as global variables or blocks. Consistency problems always occur if several tasks read and write to one variable. Modules, such as the library SysSem, are available as a solution.

Creating a task configuration

Requirement: The open project includes a program-type POU and a “Task Configuration” with a “Task” object has been inserted below “Application” in the device tree.

1. Double-click the task object below “Task Configuration” in the device tree.
   - The “Configuration” tab of the task object opens.
2. In the “Type” dropdown list, click “Cyclic”.
   - The “Interval (e.g. t#200ms)” input field appears.
3. Enter t#300ms in the “Interval (e.g. t#200ms)” input field.
4. Click “Add Call”.
   - The Input Assistant opens.
5. In “Input Assistant ➔ Categories” ➔ “Programs”, click the desired POU and then click “OK”.

   CODESYS inserts the selected POU into the POU list of the “Configuration” tab and below the task object in the device tree.

   When the application is executed from the controller, CODESYS executes the selected POU in cyclical intervals of 300 ms.

   ● % Chapter 6.4.1.21.2.30.2 “Tab ‘Configuration’” on page 2538

**Definitions of Jitter and Latency**

In the “Task Configuration” object, on the “Watchdog” tab, you can monitor the periodic jitter values of the individual tasks at runtime. The periodic jitter is differentiated from latency-based release jitter. See the following definitions:

**Periodic jitter**

Periodic jitter ($J_{\text{per}}$) is the deviation of the cycle time of a task ($T_{\text{per}}$) from the desired task cycle time ($T_0$).

\[ J_{\text{per}} = T_{\text{per}} - T_0 \]

The desired (ideal) cycle time $T_0$ is specified in the configuration of the task as “Interval”.

You can monitor the current value, as well as the maximum and minimum value of the periodic jitter, on the “Watchdog” tab of the “Task Configuration”.

*If the sum of all negative $J_{\text{per}}$ values and the sum of all positive $J_{\text{per}}$ values do not balance each other, then a drift results.*

**Latency**

Latency is the delay between the invocation of a task and the actual start of its release.

**Release jitter**

The release jitter $J_r$ is the difference between the maximum and the minimum latency ($L$) that has ever occurred.

\[ J_r = L_{\text{max}} - L_{\text{min}} \]

In the case that $L_{\text{max}} = L_{\text{min}}$, a release jitter $J_r$ of 0. results. This corresponds to a plain offset shift.

See also

- % Chapter 6.4.1.9.17 “Task Configuration” on page 1914
- % Chapter 6.4.1.21.2.30.2 “Tab ‘Configuration’” on page 2538
- % Chapter 6.4.1.21.2.29.4 “Tab ‘Monitor’” on page 2536

**6.4.1.9.18 Protecting an application**

You achieve the know-how protection and copy protection of a boot application with the help of PLC-specific license management and its settings in the object properties of the application. The download code and the boot application can be encrypted and signed.
**Encryption with a dongle**

Requirements: You have a project with an application that you want to download to the controller as an encrypted boot application. A security key for license management is connected to your computer.

1. Select the application in the device tree.
2. Select the “Properties” command in the context menu.
   ð The “Properties - <application name>” dialog opens.
3. Click the “Security” tab.
4. For “Encryption Technology”, select the “Simple Encryption” option and type the “Product Code” that you received from the hardware manufacturer for the controller. Depending on the controller, it is protected either by a security key (firmcode is shown automatically) or by an integrated Wibu memory card for example.
5. Click “Online ➔ Login” and download the application.
   ð If the matching security key and/or valid license is available, then you can download the application to the controller. By default, a boot application is automatically created at this time in the controller directory. The default setting is defined in the application “Properties”, in the “Boot Application” category.
6. Logout, change the application, and login again.
   ð You are prompted to perform an online change. The dialog provides the option of updating the boot application on the PLC. If the security key and license match, then you can log in. If not, then you receive a corresponding message.

**Encrypting with certificates**

Requirements: You have a project with an application that you want to download to the controller as an encrypted boot application. In the Windows Certificate Store of your computer, you have a certificate of this controller for encrypting the application. Note: In case you want to download the application to different controllers, you will need the appropriate certificate for each controller.

1. Select the application in the device tree.
2. Select the “Properties” command in the context menu.
   ð The “Properties - <application name>” dialog opens.
3. Click the “Security” tab.
   ð The “Certificates” group is enabled.
5. If there are not any certificates listed in the table, then click the button.
   ð The “Certificate Selection” dialog opens for selecting a certificate from the local Windows Certificate Store.
6. In the lower area, select a certificate and add it to the upper area by clicking the button, Click “OK” to confirm.
   ð The certificate is shown in the “Certificates” group of the “Encryption” dialog.
7. Select the certificate and click “Apply” or “OK”.
   ð The certificate is now used to encrypt the application. It can only be transferred to the controller on computers that have an corresponding key installed in the Windows Certificate Store.

See also

- ☰ Chapter 6.4.1.19.4 “Security for the Runtime/PLC” on page 2041
- ☰ Chapter 6.4.1.6 “Protecting and Saving Projects” on page 1819
- ☰ Chapter 6.4.1.6.8 “Encrypting Projects with Certificates” on page 1829
- ☰ Chapter 6.4.1.21.4.11.4 “Dialog: Properties: Security” on page 2754
1. Click in the status bar of CODESYS to open the “Security Screen” view. Then select a certificate with a private key for a user profile for the “Digital signature”. The procedure is described in the instructions "Configuring a certificate for the digital signature in a user profile".

2. Double-click the certificate for the “Digital signature” in the “User” tab.
   - The “Certificate” dialog opens.

3. On the “Details” tab, click “Copy to file”.
   - The “Certificate Export Wizard” starts.

4. In the “Export Private Key” prompt, select the “No, do not export the private key” option.

5. For “Export File Format”, select the “DER encoded binary X.509 (.CER)” option.

6. In the next step, select a file name and the location for the certificate.

7. After the last step “Finish”, a message appears that the export was successful.

8. After successful export to CODESYS, open the device editor by double-clicking the controller in the device tree and selecting the “Files” tab for the file transfer.

9. Select the “Path” cert/import in the right side of the “Runtime” dialog.

10. On the left side of the dialog for “Host”, select the path in the file system where you saved the exported certificate and selected the certificate.

11. Click ➡️.  
   - The certificate is copied to the cert/import folder.

12. Click the “PLC Shell” tab.

13. Type the command cert-import trusted <file name of the certificate.cer> in the input line of the tab and press the [Enter] key. Note that the file name is specified with the extension .cer; otherwise the certificate is not imported successfully.
   - The certificate is created on the controller under trusted. With this certificate, the controller can test the integrity of the boot application.

14. Open the “Security Screen” by double-clicking in the status bar.

15. If you want that downloads, online changes, and boot applications of your project are always encrypted, then select the “Enforce signing of downloads, online changes and boot applications” option in the “Security level” group on the “User” tab. To do this, the “Enforce encryption of downloads, online changes and boot applications” option also has to be selected.

See also
- Chapter 6.4.1.6.8 “Encrypting Projects with Certificates” on page 1829
- “Encryption, signature” on page 2039
- Chapter 6.4.1.21.3.4.18 “Command ‘Security Screen’” on page 2592
- Chapter 6.4.1.21.4.11.4 “Dialog: Properties: Security” on page 2754

Requirement: The CODESYS Security Agent add-on product is installed.

The “Security Screen” view provides an additional tab: “Devices”. This allows for the configuration of certificates for the encrypted communication with controllers. In this case, see the help for CODESYS Security Agent.

Alternatives:
If you the CODESYS Security Agent is not available to you, then you can proceed as follows by means of the PLC shell of the device editor:

In order to use certificates on the controller for the encryption of downloads, online changes, and boot applications, these certificates first have to be generated on the controller and loaded from the controller and installed in the Windows Certificate Store.

- **Requirement:** You are connected to the controller.

1. **Open the device editor by double-clicking the controller in the device tree, and select the “PLC Shell” tab.**
   - The tab appears with a blank display window. Below that is a command line.
2. **Type ? in the command line and press the [Enter] key.**
   - All commands are listed in the display window.
3. **Type the following command in the command line: cert-getapplist.**
   - All used certificates are listed with information about components and availability with certificates.
4. **If no certificate is available for the CmpApp component, then type the command cert-genselfsigned <Number of the Component in the applist>.**
5. **Click the “Log” tab and then the refresh button (✓).**
   - The display shows whether or not the certificate was generated successfully.
6. **Type in cert-getcertlist and press the [Enter] key.**
   - Your own certificates are listed that can be used for encryption. The information Number and Key usage(s) are useful in the next step.
     - **Number:** The number is specified as a parameter in the next step.
     - **Key usage(s): Data encryption** means that this is a certificate of the controller for a download, online change, and boot application.
7. **Export the required certificate by typing in the command cert-export own 0 and press the [Enter] key.**
   - 0 is the **Number of the certificate with Key usage(s): Data encryption.**
   - The display shows that the certificate has been exported to a cert directory.
8. **Click the “Files” tab of the device editor.**
9. **Click the refresh button (✓) in the right part of the dialog in “Runtime”.**
   - The list of files and directories is refreshed.
10. **Open the “cert” folder in the list and then the “export” subfolder.**
11. **In the left part of the dialog in “Host”, open the directory where the certificate of the controller will be loaded.**
12. **In the right part of the dialog, select the certificate that you have exported and click ➦.**
    - The certificate is copied to the selected directory.
13. **In the file explorer, go to the directory where the certificate was copied and double-click the certificate.**
    - The “Certificate” dialog opens and shows the information about this certificate.
14. **On the “General” tab, click “Install Certificate”.**
    - The “Certificate Import Wizard” starts.
15. **In the “Certificate Storage” dialog, for “Certificate Import Wizard”, select the “Store all certificates in the following store” option and then select the “Controller Certificates” folder.**
    - The controller certificate is imported into the Windows Certificate Store in the “Controller Certificates” folder. Now the certificate is available for the encryption of boot applications, downloads, and online changes.
16. Open the “Security Screen” by double-clicking 📊 in the status bar.

17. If you want that downloads, online changes, and boot applications of your project are always encrypted, then select the “Enforce encryption of downloads, online changes and boot applications” option in the “Security level” group on the “User” tab.

18. Open the “Project” tab and double-click the application in the “Encryption of boot application, download and online change” area.
   ⇒ The properties dialog of the application opens.

19. Click the “Encryption” tab, select “Encryption with certificates” in the “Encryption technology” list box, and click 📊.
   If the “Enforce encryption of downloads, online changes and boot applications” option is selected in the “Security Screen”, then “Encryption with certificates” is already selected.

20. In the “Certificate Selection” dialog, select the respective certificate from the “Controller Certificates” folder and click 📊.

21. Click “OK” to confirm the dialog.
   ⇒ The certificate is displayed in the properties dialog.

22. Confirm the properties dialog of the application.
   ⇒ The certificate is shown on the “Project” tab of the “Security Screen” in the “Encryption of boot application, download and online change” group.

The boot application, download, and online change are encrypted.

See also
● Help for the CODESYS Security Agent add-on product
● Chapter 6.4.1.21.2.8.11 “Tab ‘PLC Shell’” on page 2441
● Chapter 6.4.1.21.3.4.18 “Command ‘Security Screen’” on page 2592

### Deleting a certificate for the encryption of boot application, download and, online change

Requirement: The CODESYS Security Agent add-on product is installed. A certificate with the information "Encrypted Application" is already installed on your computer.

1. In the “Security Screen” view, on the “Project” tab, in the bottom view, click the entry for the application.
   ⇒ The “Properties” dialog for the application opens with the “Encryption” tab.

2. For “Encryption Technology”, select “Encryption with certificates”. In the “Certificates” group, click 📊.

3. In the “Certificate Selection” dialog, delete the certificate as described above.

4. Click “OK” to close the “Certificate Selection” dialog.
   ⇒ The certificate is no longer displayed in the “Properties” dialog.

See also
● Help for the CODESYS Security Agent add-on product
● Chapter 6.4.1.21.3.4.18 “Command ‘Security Screen’” on page 2592
6.4.1.9.19 Data Persistence

General

The lifespan of a variable and its data begins at the time when the variable is created and ends at the time when the variable is deleted and its memory is freed. The time when the variable is created, initialized, or instantiated depends on the declared scope. The time when the memory is freed usually depends on the scope as well. For example, the memory of global variables is freed by exiting the application.

They can retain data longer than usual. The following mechanisms are provided for this purpose.

Mechanisms for data retention

- **(A): Persistent global variable list** with the keyword `PERSISTENT RETAIN`
  Persistent variables retain their values when the application is reloaded. Moreover, the values are restored after a download, warm start, or cold start.

- **(B): Retain variables with the keyword `RETAIN`**
  Retain variables retain their values after a warm start, but not after reloading the application, a download, or a cold start.

- **(C): Variables of the Persistence Manager of the CODESYS Application Composer**
  Variables of the Persistence Manager are stored in an external file.

- **(D): Recipe variables**
  Recipe variables and their values are stored in a recipe file.

See also

- Chapter 6.4.1.9.19.4 “Retaining data with variables of the persistence manager” on page 1926
- Chapter 6.4.1.9.19.3 “Preserving data with retain variables” on page 1925
- Chapter 6.4.1.9.19.5 “Preserving data with recipes” on page 1926
- Chapter 6.4.1.20.2.13 “Persistent Variable - PERSISTENT” on page 2122
- Chapter 6.4.1.20.2.14 “Retain Variable - RETAIN” on page 2124
- Chapter 6.4.1.21.2.20 “Object 'Persistent variable list'” on page 2476

Mechanisms in comparison

Which mechanism is suitable for which application? Some common use cases are considered in the table. The specific examples refer to a building control system.
### Table 384: Comparison of mechanisms and use cases

<table>
<thead>
<tr>
<th>Uses case</th>
<th>(A) Persistent variables</th>
<th>(B) Retain variables</th>
<th>(C) Variables of the Persistence Manager</th>
<th>(D) Recipe variables</th>
</tr>
</thead>
</table>
| 1 The application must maintain device settings.  
Example: After a power failure, the building control has to have information available about how long a window blind needs to be raised. | Suitable¹ Preferred use case  
In this case, you can also use retain variables instead of persistent variables. This is advantageous for variables whose declaration is often changed. | Suitable | Suitable²  
This is advantageous for controllers that do not have any hardware support. Special functionalities make this possible, such as double file buffering. | Possible, but very complicated and therefore not recommended. |
| 2 The application must maintain values also after program changes or extensions.  
2a: Rare extensions  
Example: An application programmer extends the program with a new switch and installs a new light. The building control must still have saved values available until then. | Suitable¹ Preferred use case | Suitable | Suitable² | Possible, but complicated. |
| 2b: Unrestricted changes, including deleting or changing the data type of variables  
The building control is running and is persistent. When an application programmer adds a new functionality to the controller and therefore adds another persistent variable to a function block, the values saved up to that point must be retained. For example, the program in an FB is extended with a variable that controls the automatic switching off of a previously uncontrolled lamp after a certain time. The building control must have the times of all controlled lamps available after the extension. | Not suitable | Suitable²  
Data from retain variables are preserved as far as possible after an online change. | Suitable²  
Preferred use case | Possible if textual, but complicated |
<p>| 2c: The application must maintain values after a download. | Suitable | Not suitable | Suitable | Suitable |</p>
<table>
<thead>
<tr>
<th>Uses case</th>
<th>(A) Persistent variables</th>
<th>(B) Retain variables</th>
<th>(C) Variables of the Persistence Manager</th>
<th>(D) Recipe variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 The application must be able to use different value sets. Example: The operating settings for summer, winter, and holidays must be saved and imported when needed.</td>
<td>Not suitable</td>
<td>Not suitable</td>
<td>Not suitable</td>
<td>Suitable Preferred use case</td>
</tr>
<tr>
<td>4 The application must be able to use settings from another system. It must be possible to transfer settings to another plant using similar variables.</td>
<td>Not suitable</td>
<td>Not suitable</td>
<td>Suitable²</td>
<td>Suitable³</td>
</tr>
<tr>
<td>5 The application must provide human readable data. The user must be able to read, compare, and edit the data.</td>
<td>Not suitable</td>
<td>Not suitable</td>
<td>Suitable²</td>
<td>Suitable³</td>
</tr>
</tbody>
</table>

¹ Disadvantage: Only possible if the runtime system supports this mechanism and an NVRAM memory or UPS is available. Advantage: Speed; recommended application: 1 and 2a

² Disadvantage: In the case of large variable sets (> 10000), long delays during initialization and shutdown are to be expected. Advantage: No special memory is required; value retention exists even in case of changes, extensions, or deletions.

³ Advantage: Editable remotely, transferable. Disadvantage: Complicated

---

### Lifespan of variables when calling online commands

<table>
<thead>
<tr>
<th>User input in the “Online” menu</th>
<th>Variable with usual lifespan</th>
<th>RETAIN</th>
<th>PERSISTENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command “Online Change”</td>
<td>Neither RETAIN nor PERSISTENT</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Command “Reset Warm”</td>
<td></td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Command “Reset Cold”</td>
<td></td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Command “Download”</td>
<td></td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Command “Reset Origin”</td>
<td></td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

x : The variable retains its value.

i : The variable is initialized.

¹ Note: For the structure of persistent data, see the information in "Mechanism for downloading".

See also

- % “Mechanism for downloading” on page 1923
- % Chapter 6.4.1.21.3.7.6 “Command ‘Online Change’” on page 2629
- % Chapter 6.4.1.21.3.7.12 “Command ‘Reset Origin’” on page 2635
- % Chapter 6.4.1.21.3.7.10 “Command ‘Reset Cold’” on page 2633
- % Chapter 6.4.1.21.3.7.5 “Command ‘Load’” on page 2628
Lifespan of variables when downloading a boot project

The values of ordinary variables lose their value and are reinitialized.
The values of persistent variables are protected when:
- The structure of the persistent variable in memory matches the structure in the persistent data list.

The values of retain variables are protected when:
- The structure of the persistent variable in memory matches the structure in the persistent data list.
- The persistent variables match the application (GUID has to agree).

A "Retain mismatch" occurs when the requirements for restoring the values of retain variables and persistent variables are not met when the application is booted. The response to this discrepancy is described in the documentation of the hardware manufacturer.

Note: For the structure of persistent data, refer to the information in "Mechanism for downloading".

See also
- “Mechanism for downloading” on page 1923

Preserving data with persistent variables

Persistent variables retain their values after reloading the application, and after a download, warm start, or cold start.

A special non-volatile memory area on the controller, for example as NVRAM or UPS, is required to extend the lifespan. Securing the data in such a memory does not require any additional time, which is an advantage over data retention with the Persistence Manager. If the controller does not provide hardware support, then the data is usually stored in a file. Then the data will be retained if you shut down the controller correctly. In the event of a power failure or a pulled plug, however, data will be lost.

Behavior

Value retained for
- Uncontrolled exit
- Warm start by calling the “Reset Warm” command
- Cold start by calling the “Reset Cold” command
- Repeated download of the application

Reinitialization for
- Call of the “Reset Origin” command

Therefore, persistent variables are reinitialized only if you reset the controller to the factory settings (for example, when you click “Online ➔ Reset Origin”).

If, on the other hand, you download the application again, the persisted data is retained if possible. That depends on how profound the changes that led to the download were. Changing the application name always leads to a full reinitialization. Changes to the implementations never lead to a reinitialization: the data persistence is completely preserved. Changes to the declarations lead to an initialization of the new variables only if the existing variables are persistent, when you change the declarations so that the persistent variable list remains consistent. This is the case when you add a new variable or delete an existing one. Inconsistencies can occur if you edit and change the identifiers or data types of previously declared persistent variables.

Mechanism for downloading

Editing the variable list in the persistence editor causes the variable list to be edited automatically before it is saved, not to be saved as it is shown in the editor.
During post-processing, a variable that you have removed is replaced by a placeholder variable with the same memory requirement. As a result, the subsequent variables retain their addresses in the process image. Moreover, a variable you add is moved to the end of the list. Post-processing can neutralize changes that would lead to a loss of persistence. But you create gaps that use additional memory.

When downloading, the CRC value of the variable list and the length of the list (number of variables) are stored on the controller. When downloading again, the new test value is compared with the test value currently on the controller. Then the variable list is compared successively up to the specified length. If you have edited a declaration (for example, the name or data type), then the variable is reinitialized. Otherwise its value is retained. When the download is repeated, CODESYS checks whether the variable list declared in the persistence editor is still consistent with the variable list already on the controller.

The mechanism works well when the variables themselves are not modified significantly. Too extensive changes of the identifiers and the data types continue to lead to a reinitialization and the loss of persistence. If you anticipate frequent changes due to your application requirements, then this kind of a list is not recommended. Moreover, in an online change after a data type change, a persistent variable is less robust than a variable with a normal lifespan.

It is good practice to clear any gaps in the variable list after a while (command “Reorder List and Clear Gaps”). After cleaning, however, the list no longer matches the list on the controller and you have triggered an initialization of all persistent variables. The persistence of all variables is lost.

For versions before V3.5 SP1, changes in the persistence editor always lead to reinitialization.

Recovering data with the recipe manager

To clean up the global persistent variable list without losing persistence, you can save the data in a recipe using the Recipe Manager. This creates a list for all variables of the persistent variable list in the recipe manager, and at the same time its current values are stored by the controller as a recipe. Then execute the command “Reorder List and Clear Gaps” and perform a download again. Now when you execute the command “Restore Values from Recipe”, the values saved in the recipe are restored.

Changing an existing declaration in the persistent variable list

if you change the name or data type of a variable, this is interpreted as a new declaration and causes a re-initialization of the variables at the next online change or download. For complex data types, a change occurs when a new component is added, or when you change the type of a variable from INT to UINT in the depth of a used structure used, for example.

Basically, complex user-defined data types are not suitable for administration in a persistent variable list, because even small changes cause the variable to be initialized with all components.

Double allocation of memory in the case of instance paths

You can persist global variables or variables declared locally in a function block or program. To do this, add the keyword PERSISTENT to the declaration. In addition, you insert the instance path to this variable in the persistent global variable list. To do this, execute the “Add All Instance Paths” command in the persistence editor.

Persistence is guaranteed by the following mechanism:

- The cyclic tasks in which the variable is accessed are determined.
- At the end of the first cyclic task (in each cycle), the variable is copied to the persistent global variable list.
- After restarting the controller, the value of the persistent variable is copied to the ordinary variable.
The disadvantage of this mechanism is that memory is allocated both at the place of declaration and at the place of the instance path. This persistent variable has a double memory allocation. Moreover, the data is copied to both places in each cycle. This can be time consuming, especially when large structured values are involved.

**Memory location in the case of persistent function block instances**

A function block instance is always stored completely in memory. This is necessary so that the same code can work on different instances. If only one variable in a function block is marked with `PERSISTENT`, then the function block instance is stored completely with all variables in remanent memory, although only the one variable is treated as persistent. However, non-volatile memory is not available to the same extent as main memory.

A function block with a pointer to an instance in SRAM as a variable is not stored in the protected memory.

**Importing from CoDeSys V2.3 projects**

When you open a CoDeSys V2.3 project to import it into CODESYS V3, the declarations of persistent variables are not preserved. You have to revise the declarations and create then again in a separate persistent global variable list.

See also

- % Chapter 6.4.1.20.2.13 “Persistent Variable - PERSISTENT” on page 2122
- % Chapter 6.4.1.21.3.18.4 “Command ‘Add all instance paths’” on page 2720
- % Chapter 6.4.1.3.3 “Opening a V2.3 project” on page 1809

**Preserving data with retain variables**

Retain variables preserve their values after a warm start. However, the degree of value retention for persistent variables is higher.

A special non-volatile memory area on the controller, for example as NVRAM or UPS, is required to extend the lifespan. Securing the retain variables in such a memory does not require any additional time, which is an advantage over data retention with the Persistence Manager. If the controller does not provide hardware support, then the data is usually stored in a file. Then the data will be retained if you shut down the controller correctly. In the event of a power failure or a pulled plug, however, data will be lost.

**Declaration**

To declare a retain variable, add the `RETAIN` keyword to a variable declaration.

**Behavior**

Value retained for

- Uncontrolled exit
- Call of the “Reset Warm” command

Reinitialization for

- Repeated download of the application
- Call of the “Reset Cold” command (in contrast to persistent variables)
- Call of the “Reset Origin” command

When you restart an application, its variables are usually initialized with an explicitly preset initial value or with a default value. Variables marked with the `RETAIN` keyword are managed in a separate memory area depending on the target system and retain their value. Then the variables are protected from power failure, for example. This means that you can apply retain variables to a parts counter in a production line so that you can continue counting even after a power failure.
Memory location of persistent function block instances

Function block instances are stored as one block in memory. This is necessary so that the same code can work on different instances. If a variable is marked with `RETAIN` in a function block, then each instance of the function block is protected with all variables. This is also true for the variables of the function block that are not marked this way. However, non-volatile memory is not available to the same extent as main memory.

A function block with a pointer to an instance in SRAM as a variable is not stored in the protected memory.

Importing of CoDeSys V2.3 projects

When you open a CoDeSys V2.3 project to import it into CODESYS V3, the declarations of retain variables are preserved and remain effective as before.

See also

- Chapter 6.4.20.2.14 “Retain Variable - RETAIN” on page 2124
- Chapter 6.4.1.3.3 “Opening a V2.3 project” on page 1809

Retaining data with variables of the persistence manager

Persistent variables are managed in the Persistence Manager of the CODESYS Application Composer. The functionality of the "Persistence Manager" does not need any special memory on the controller in order to preserve values and data.

Declaration

In the declarations, the variables managed in the Persistence Manager are marked with the `pragma` `{attribute 'acPersist'}`.

The pragma makes sure that the variable with this attribute is managed in the Persistence Manager of the Application Composer. The variable value is retained even if you change the declaration of the variable, delete a variable from the application, or add a new one. The value is retained even if you change the data type and use the appropriate conversions.

Mechanism

The variables of the Persistence Manager are stored with their values in an external archive file in TXT format.

The application code is extended with the code of the Persistence Manager, which leads to a greater memory requirement. This is at the expense of performance. Moreover, reading and especially writing a large number of persistent variables can take a long time. As a result, the executing task also blocks the execution for a long time.

Functionality

- You can load and edit the TXT file in an external editor such as Notepad++.
- You can use the persistent variables of the file in another application.
- You can configure the behavior of persistent variables by defining persistence groups, assigning variables to them, and configuring the groups with their own save and read behavior.

Preserving data with recipes

Variables are managed persistently in the Recipe Manager. The Recipe Manager does not need any special memory on the controller in order to preserve values and data.

Declaration

A recipe definition consists of a set of variables with values and is created and edited in the "Recipe Manager" object and saved to a file.
You can include a variable in multiple recipes, each with different values.

In online mode, you can read in the actual values of the variables from the controller and save them as recipe values (specified value).

You can use the Recipe Management library to programmatically implement the creation and editing of a recipe.

You can save and backup a recipe as a recipe file.

See also

- Chapter 6.4.1.13.2.4 “Changing Values with Recipes” on page 2003
- Chapter 6.4.1.21.3.18.2 “Command ‘Save Current Values to Recipe’” on page 2719
- Chapter 6.4.1.21.3.18.1 “Command ‘Reorder List and Clean Gaps’” on page 2719
- Chapter 6.4.1.21.3.18.3 “Command ‘Restore Values from Recipe’” on page 2719
- Chapter 6.4.1.21.2.25 “Object ‘Recipe Manager’” on page 2719
- Chapter 6.4.1.21.2.26 “Object ‘Recipe Definition’” on page 2722

### Declaring VAR PERSISTENT Variables

Below you will declare persistent variables in a persistent variable list and in a POU.

**Requirement:** A project is opened and contains a program POU. You have selected the option for the textual view in the “Declaration Editor” category of the options (menu command in “Tools → Options”).

1. Add the “Persistent Variables” object to the application object with the menu command “Project → Add Object”.

   ➞ CODESYS adds the persistent variable list "PersistentVars" below the application object in the device tree and the editor opens.

2. In the editor, enter a variable declaration, for example `ivarpersist1 : INT;` between `VAR_GLOBAL PERSISTENT RETAIN` and `END_VAR`.

3. Double-click the POU in the device tree.

   ➞ The editor of the POU opens.

4. Specify the following declaration in the declaration part:

   ```
   VAR PERSISTENT RETAIN
   ivarpersist2 : INT;
   END_VAR
   ```

5. Click “Build → Build”.

   ➞ The message view opens. If CODESYS has compiled the application without errors, then close the message window and continue with the next step. Otherwise, correct the error(s) and select the menu command “Build → Build” again.

6. Set the focus in the “PersistentVars” editor. Click “Declarations → Add All Instance Paths”

   ➞ CODESYS adds the persistent variable from the persistent variable list “PersistentVars” to the POU:

   ```
   // instance path of the persistent variables created
   POU.IVARPERSIST2 : INT
   ```

See also

- Chapter 6.4.1.20.2.13 “Persistent Variable - PERSISTENT” on page 2122
- Chapter 6.4.1.20.2.14 “Retain Variable - RETAIN” on page 2124
- Chapter 6.4.1.21.2.20 “Object ‘Persistent variable list’” on page 2476
- Chapter 6.4.1.21.3.18.4 “Command ‘Add all instance paths’” on page 2720
Saving the values of a persistent variable list in a recipe

Requirement: a project is opened and a persistent variable list with declarations of persistent variables exists under an application object.

1. Double-click on the controller in the device tree and select the tab “Communication Settings”.
2. Select your gateway and click on the button “Scan Network”.
   ⇒ Your device is shown in bold in the tree view of the gateway.
3. Select your device and click on the button “Set Active Path”.
4. Select your application object in the device tree and select the context menu command “Set Active Application”.
   ⇒ The application object is displayed in bold.
5. Select the menu command “Online ➔ Login”.
   ⇒ Your application is logged in to the controller and the controller and the application object in the device tree have a green background.
6. Double-click on the persistent variable list and select the command “Declarations ➔ Save Current Values to Recipe”.
   ⇒ CODESYS creates the objects “Recipe Manager” and “PersistentVariables” under the application object.
7. Select the menu command “Online ➔ Logout”.
   ⇒ The application is logged out from the controller.

See also
- Chapter 6.4.1.21.3.18.2 “Command ‘Save Current Values to Recipe’” on page 2719
- Chapter 6.4.1.9.19 “Data Persistence” on page 1920

6.4.1.9.20 Alarm Management

For information about alarm management and alarm visualization, see the help for CODESYS Visualization.

6.4.1.9.21 Using POUs for implicit checks

CODESYS provides special POUs that implement implicit monitoring functions. At runtime, these functions check the array limits or subrange types, the validity of pointer addresses, or division by zero.

1. Select the “Application” object in the device tree.
   Click “Project ➔ Add Object ➔ POU for Implicit Checks”
   ⇒ The “Add POU for Implicit Checks” dialog box opens.
2. Select the desired functions.
3. Click “Add”.
   ⇒ The selected POUs are inserted below the “Application” in the device tree.
4. Open the POUs in the editor.
5. Adapt the implementation suggestion to your requirements.

CAUTION!
To obtain the feature for monitoring functions, do not edit the declaration section. However, you are permitted to add local variables.

See also
- Chapter 6.4.1.21.2.21 “Object ‘POU’” on page 2477
- Chapter 6.4.1.21.2.22 “Object ‘POUs for Implicit Checks’” on page 2500

6.4.1.22 Object-Oriented Programming

General

CODESYS supports object oriented programming with function blocks and for this purpose provides the following features and objects:
- Methods
- Interfaces
- Properties
- Inheritance
- Method call, virtual function call
- Definition of function blocks as extensions of other function blocks

Application example
Basic information on dealing with object-oriented programming (OOP) with AC500 V3 PLCs is given in an application example.

Application example
In CODESYS V3, keywords can be used in object-oriented programming (OOP), e.g. to improve the programming style, debugging, etc. The application note OOP keywords explains how these keywords are used.

See also
- Chapter 6.4.1.21.2.21.5 “Object ‘Interface’” on page 2484

Extension of function blocks
The extension of a function block is based on the concept of inheritance in object-oriented programming. A derived function block thereby extends a basic function block and in doing so is given the properties of the basic function block in addition to its own properties.

The extension of a function block means:
• The inherited function block contains all data and methods that are defined by the basic function block. You can use an instance of the basic function block in every context in which CODESYS expects a function block of the type of the basic function block.
• The derived function block can overwrite the methods that you have defined in the base function block. This means that the inherited function block can define a method with the same name, the same inputs and the same output as is defined by the basic function block. Tip: You have the following support when overwriting methods, actions, attributes, and transitions that are inherited by the base block: When you insert a method, action, etc. below an inherited block, the “Add Object” dialog includes a combo box with a list of methods, actions, etc. used in the base block. You can accept these and adapt them accordingly.
• The derived function block may not contain function block variables with the same names as used by the basic function block. The compiler reports this as an error. The only exception: If you have declared a variable in the basic function block as VAR_TEMP, then the inherited function block may define a variable with the same name. In this case, the inherited function block can no longer access the variable of the basic function block.
• You can directly address the variables and methods of the basic function block within the scope of the inherited function block by using the SUPER pointer.

NOTICE!
Multiple inheritance is not permitted.
Exception: A function block can implement multiple interfaces, and an interface can extend other interfaces.

Extension of a basic function block by a new function block

Requirement: the currently opened project possesses a basic function block, for example “POU_1(FB)”, which is to be extended by a new function block.

1. Right-click the “Application” object in the device tree and select “Project ➔ Add Object ➔ POU”.
   ⇔ The “Add POU” dialog opens.
2. Type the name for the new POU in the “Name” input field, for example “POU_Ex”.
3. Select “Function block”.
4. Click “Advanced” and then the more button (°).
5. In the category “Function blocks” under “Application” in the input assistant, select the POU(FB) that is to serve as the basic function block, for example POU_1, and click “OK”.
6. As an option, you can select an “Access modifier” for the new function block from the drop-down list.
7. Select from the “Implementation language” combo box (example: “Structured text (ST)”.
8. Click “Add”.
   ⇔ CODESYS adds the POU_Ex function block to the device tree and opens the editor. The first line contains the text:
   
   FUNCTION_BLOCK POU_Ex EXTENDS POU_1
   
   The function block POU_Ex extends the basic function block POU_1.

Extension of a basic function block by an existing function block

Requirement: The open project possesses a base function block (example: POU_1(FB)) and another function block (example: POU_Ex(FB)). The function block POU_Ex(FB) is also to be given the properties of the basic function block. This means that POU_Ex(FB) should extend POU_1(FB).
1. Double-click the function block `POU_Ex(FB)` in the device tree.
   ⇒ The function block editor opens.

2. Extend the existing entry in the top line `FUNCTION_BLOCK POU_Ex with EXTENDS POU_1`.
   ⇒ The function block `POU_Ex` extends the basic function block `POU_1`.

See also

- Chapter 6.4.1.9.22.3 “Implementing interfaces” on page 1931
- Chapter 6.4.1.9.22.4 “Extending interfaces” on page 1933
- Chapter 6.4.1.20.2.15 “SUPER” on page 2125
- Chapter 6.4.1.20.2.16 “THIS” on page 2126
- Chapter 6.4.1.21.2.21.3 “Object ‘Function Block’” on page 2479
- Chapter 6.4.1.21.2.21.9 “Object ‘Property’” on page 2493
- Chapter 6.4.1.21.2.21.10 “Object ‘Action’” on page 2497
- Chapter 6.4.1.21.2.21.11 “Object ‘Transition’” on page 2499

Implementing interfaces

Implementing interfaces is based on the concept of object-oriented programming. With common interfaces, you can use different but similar function blocks the same way.

A function block that implements an interface has to include all methods and attributes that are defined in that interface (interface methods and interface attributes). This means that the name and the inputs and outputs of the methods or attributes must be exactly the same. When you create a new function block that implements an interface, CODESYS adds all methods and attributes of the interface automatically to the tree below the new function block.

**NOTICE!**

If you add more interface methods afterwards, then CODESYS does not add these methods automatically to the affected function block. To perform this update, you must execute the “Implement Interfaces” command explicitly.

For inherited function blocks, you have to make sure that any methods or attributes that were derived through the inheritance of an interface also receive the appropriate implementation. Otherwise they should be deleted in case the implementation that was provided in the basis should be used. Respective compile error messages or warnings are displayed, prompted automatically by added pragma attributes. For more information, refer to the help page for the “Implementing Interfaces” command.

**NOTICE!**

- You must assign the interface of a function block to a variable of the interface type before a method can be called via the variable.
- A variable of the interface type is always a reference of the assigned function block instance.

A variable of the interface type is a reference to instances of function blocks. This kind of variable can refer to every function block that implements the interface. If there is no assignment to a variable, then the variable in online mode contains the value 0.
The I1 interface contains the GetName method.

METHOD GetName : STRING

The functions blocks A and B implements the interface I1:

FUNCTION_BLOCK A IMPLEMENTS I1
FUNCTION_BLOCK B IMPLEMENTS I1

For this reason, both function blocks must include a method named GetName and the return type STRING. Otherwise the compiler reports an error.

A function includes the declaration of a variable of interface I1 type.

FUNCTION DeliverName : STRING
VAR_INPUT
  l_i : I1;
END_VAR

Function blocks that implement the I1 interface can be assigned to these input variables.

Examples of function calls:

DeliverName(l_i := A_instance); // call with instance of type A
DeliverName(l_i := B_instance); // call with instance of type B

Calling of interface methods:

In this case, it depends on the actual type of l_i whether the application calls A.GetName or B.GetName.

DeliverName := l_i.GetName();

Examples: Chapter 6.4.1.21.3.23.2 "Command 'Implement Interfaces" on page 2744

Implementing an interface in a new function block

- Requirement: The open project has at least one interface object.

1. Right-click "Application" in the device tree and select "Project ➔ Add Object ➔ POU".
   ⇒ The "Add POU" dialog box opens.

2. Type the name for the new POU in the "Name" input field, for example "POU_Im".

3. Select "Function block".

4. Click "Implemented" and then the more button ( ).

5. In the input assistant, select the interface from the category "Interfaces", for example ITF1, and click on "OK".

6. To insert more interfaces, click and select a another interface.

7. As an option, you can select an "Access modifier" for the new function block from the selection list.

8. Select from the "Implementation language" combo box (example: "Structured text (ST)").

9. Click "Add".
   ⇒ CODESYS adds the "POU_Ex" function block to the device tree and opens the editor.
   The first line contains the text:

   FUNCTION_BLOCK POU_Im IMPLEMENTS ITF1

   The interface and its methods and properties are now inserted below the function block in the device tree. Now you can type program code into the implementation part of the interface and its methods.
Implementing an interface in an existing function block

- Requirement: The currently open project has a function block (example: “POU_Im”) and at least one interface object (example: “ITF1”).

1. Double-click the “POU_Ex(FB)” POU in the device tree.
   - The POU editor opens.
2. Extend the existing entry in the uppermost line with `FUNCTION_BLOCK POU_Im with IMPLEMENTS ITF1`.
   - The “POU_Im” function block implements the “ITF1” interface.

See also
- Chapter 6.4.1.21.2.21.3 “Object ‘Function Block’” on page 2479

Extending interfaces

You can extend interfaces just like function blocks. The interface is then also given the interface methods and interface properties of the basic interface in addition to its own.

1. Select the object “Application” in the device tree.
2. Select the command “Project → Add Object → Interface”.
   - The dialog box “Add Interface” opens.
3. Enter a name for the new interface.
4. Activate the option “Extended” and click on the button.
5. The input assistant opens.
6. From the category “Interfaces”, select the interface that is to be extended by the new interface.

- Chapter 6.4.1.21.2.21.5 “Object ‘Interface’” on page 2484

Calling methods

To implement a method call, the actual parameters (arguments) are passed to the interface variables. As an alternative, the parameter names can be omitted.

Depending on the declared access modifier, a method can be called only within its own namespace (INTERNAL), only within its own programming module and its derivatives (PROTECTED), or only within its own programming module (PRIVATE). For PUBLIC, the method can be called from anywhere.

Within the implementation, a method can call itself recursively, either directly by means of the THIS pointer, or by means of a local variable for the assigned function block.

Method call as a virtual function call

Virtual function calls can occur due to inheritance.

Virtual function calls enable one and the same call to call various methods in a program source code during the runtime.
In the following cases the method call is dynamically bound:

- You call a method via a pointer to a function block (for example `pfub^.method`).
  In this situation the pointer can point to instances of the type of the function block and to instances of all derived function blocks.
- You call the method of an interface variable (for example `interface1.method`).
  The interface can refer to all instances of function blocks that implement this interface.
- A method calls another method of the same function block. In this case the method can also call the method of a derived function block with the same name.
- The call of a method takes place by means of a reference to a function block. In this situation the reference can point to instances of the type of the function block and to instances of all derived function blocks.
- You assign `VAR_IN_OUT` variables of a basic function block type to an instance of a derived FB type.
  In this situation the variable can point to instances of the type of the function block and to instances of all derived function blocks.

**Example**

<table>
<thead>
<tr>
<th>Overloading methods</th>
<th>The function blocks <code>fub1</code> and <code>fub2</code> extend the function block <code>fubbase</code> and implement the interface <code>interface1</code>. The methods <code>method1</code> and <code>method2</code> exist.</th>
</tr>
</thead>
</table>
| PROGRAM PLC_PRG     | **VAR_INPUT**  
|                     | `b` : BOOL; |
| END_VAR             | **VAR**  
|                     | `pInst` : POINTER TO `fubbase`;  
|                     | `instBase` : `fubbase`;  
|                     | `inst1` : `fub1`;  
|                     | `inst2` : `fub2`;  
|                     | `instRef` : REFERENCE to `fubbase`;  
| END_VAR             | **IF** `b` **THEN**  
|                     | `instRef` REF= `inst1`;  
|                     | `pInst` := ADR(`instBase`);  
|                     | **ELSE**  
|                     | `instRef` REF= `inst2`;  
|                     | `pInst` := ADR(`inst1`);  
|                     | **END_IF**  
|                     | `pInst^.method1();`;  
|                     | (* If `b` is TRUE, `fubbase.method1` will be called, otherwise `fub1.method1` is called *)  
|                     | `instRef.method1();`;  
|                     | (* If `b` is TRUE, `fub1.method1` will be called, otherwise `fub2.method1` is called *)  

On the assumption that `fubbase` in the above example contains two methods `method1` and `method2`, it overwrites `fub1 method2`, but not `method1`. The call of `method1` takes place as follows:

- `pInst^.method1();`
- If `b` is TRUE, then CODESYS calls `fubbase.method1`. If not, then `fub1.method1` is called.

**Additional outputs**

In accordance with the IEC 61131-3 standard, methods can have additional outputs declared, like normal functions. With the method call, you assign variables to the additional outputs.

Detailed information about this can be found in the topic “Function”.

---

**Note:**

- The use of `VAR_IN_OUT` variables is generally not recommended due to potential side effects and should be used sparingly. The recommended approach is to use instance variables or pass parameters instead.
- The code snippets are illustrative and may need to be adapted to specific use cases. Always ensure that the changes made are compatible with the intended system architecture and requirements.

---

**Configuration and programming**

**Programming with CODESYS > CODESYS Development System**

---

**Example**

<table>
<thead>
<tr>
<th>Overloading methods</th>
<th>The function blocks <code>fub1</code> and <code>fub2</code> extend the function block <code>fubbase</code> and implement the interface <code>interface1</code>. The methods <code>method1</code> and <code>method2</code> exist.</th>
</tr>
</thead>
</table>
| PROGRAM PLC_PRG     | **VAR_INPUT**  
|                     | `b` : BOOL; |
| END_VAR             | **VAR**  
|                     | `pInst` : POINTER TO `fubbase`;  
|                     | `instBase` : `fubbase`;  
|                     | `inst1` : `fub1`;  
|                     | `inst2` : `fub2`;  
|                     | `instRef` : REFERENCE to `fubbase`;  
| END_VAR             | **IF** `b` **THEN**  
|                     | `instRef` REF= `inst1`;  
|                     | `pInst` := ADR(`instBase`);  
|                     | **ELSE**  
|                     | `instRef` REF= `inst2`;  
|                     | `pInst` := ADR(`inst1`);  
|                     | **END_IF**  
|                     | `pInst^.method1();`;  
|                     | (* If `b` is TRUE, `fubbase.method1` will be called, otherwise `fub1.method1` is called *)  
|                     | `instRef.method1();`;  
|                     | (* If `b` is TRUE, `fub1.method1` will be called, otherwise `fub2.method1` is called *)  

On the assumption that `fubbase` in the above example contains two methods `method1` and `method2`, it overwrites `fub1 method2`, but not `method1`. The call of `method1` takes place as follows:

- `pInst^.method1();`
- If `b` is TRUE, then CODESYS calls `fubbase.method1`. If not, then `fub1.method1` is called.
Syntax for the call:

```
<function block name>.<method name>(<first input name> := <value> (, <second input name> := <value> (,... ,<further input assignments>)+ , <first output name> => <first output variable name> (,<further output assignments>)+
```

### Example Declaration

**METHOD PUBLIC DoIt : BOOL**

**VAR_INPUT**

- `iInput_1 : DWORD;
- `iInput_2 : DWORD;

**END_VAR**

**VAR_OUTPUT**

- `iOutput_1 : INT;
- `sOutput_2 : STRING;

**ENDVAR**

**fbInstance.DoIt(iInput_1 := 1, iInput_2 := 2, iOutput_1 => iLocal_1, sOutput_2 => sLocal_2);**

When the method is called, the values of the method outputs are written to the locally declared output variables.

### Calling a method even if the application is in the STOP state

In the device description it is possible to define that a certain function block instance (of a library function block) always calls a certain method in each task cycle. If the method contains the input parameters of the following example, CODESYS processes the method even if the active application is presently in the STOP state:

**Example**

```
VAR_INPUT
- `pTaskInfo : POINTER TO DWORD;
- `pApplicationInfo: POINTER TO _IMPLICIT_APPLICATION_INFO;

**END_VAR**

(*Now the status of the application can be queried via

**pApplicationInfo^..state = RUNNING THEN <instructions> END_IF;**

### Calling methods recursively

Use recursions mainly for processing recursive data types such as linked lists. Generally, we recommend that you be careful when using recursion. An unexpectedly deep recursion can lead to stack overflow and therefore to machine downtime.

Within their implementation, a method can call itself:

- Directly by means of the THIS pointer
- Indirectly by means of a local function block instance of the basic function block

Usually, a compiler warning is issued for such a recursive call. If the method is provided with the pragma `{attribute 'estimated-stack-usage' := '<estimated_stack_size_in_bytes>'}`, then the compiler warning is suppressed. For an implementation example, refer to the section "Attribute 'estimated-stack-usage"."
6.4.1.10 Working with Controller Networks

6.4.1.10.1 General

With the following functionalities, CODESYS supports communication between controllers (PLC) and the insertion of a safety controller below a PLC:

- **Symbol Configuration**: CODESYS creates symbols with certain access rights for the variables in an application. With these symbols, you can access the variables from outside, for example from an OPC server.

- **Data Source Manager**: Manages the connection settings and the data transmission to remote devices (data sources). The transmitted data is mapped in data source variables that are accessed in the visualization or local application. An example of this is a control panel that controls remote devices and displays the state of the device as an HMI application.

- **Network Variables**: Network variables are variables whose values are accessible to different controllers in the network. The variables have to be defined in rigid, identical lists in both the transmitter device and the receiver device. These lists are assigned to applications, but can be located in different projects.

- A safety controller can be inserted below a PLC in the device tree. The communication links of the safety controller to the field devices, controller networks, and development system are routed through this controller.

---

See also

- § Chapter 6.4.1.20.6.3.14 “Attribute ‘estimated-stack-usage’” on page 2281
- § Chapter 6.4.1.20.2.16 “THIS” on page 2126
- § Chapter 6.4.1.20.2.15 “SUPER” on page 2125
- § Chapter 6.4.1.21.2.21.9 “Object ‘Property’” on page 2493

---

6.4.1.10.2 Network and Addressing

General

Constructing a control network hierarchically, so that extensive self-configuration is possible.

In CODESYS the network topology is mapped to clear addresses and the routing algorithm is kept simple by structured addresses. There is direct and relative addressing and automatic address determination during the bootup of the system.
Network topology

Information and recommendations for the topology of a control network

It is recommended to set up a network system so that the following are possible:

- Extensive self-configuration (address assignment)
- Transparent support for every communication medium
- Transport of data packets between different networks

The routing mechanism should be so simple that each network node can reroute data packets, even if it has a low memory capacity. Therefore, avoid extensive routing tables, complex calculations or queries at runtime.

Construct the control network hierarchically. Each node may possess a parent node and any number of child nodes. A node without a parent is a "top level" node. Cycles are not permitted, i.e. each control network has the structure of a tree.

Parent-child relationships results from the specification of certain network areas. A network area can be, for example, a local Ethernet or a serial point-to-point connection. We differentiate between the main network (mainnet) and the subnetworks (subnet). Each node belongs at the most to one main network, to which its parent node, if one exists, also belongs. For each node any desired number of subnets can be configured, for which the node acts in each case as a parent.

A network area may have only one parent node. Therefore, a configuration in which a network area is defined at the same time as a subnet of several nodes is invalid.

See also

- Chapter 6.4.1.10.2.2 “Network topology” on page 1937
- Chapter 6.4.1.10.2.3 “Addressing and Routing” on page 1937
- Chapter 6.4.1.10.2.4 “Address Structures” on page 1939

Addressing and Routing

Addressing means: the topology of the control network is mapped to unique addresses.

A node address is composed hierarchically: for each network connection the associated block driver determines a local address, which uniquely identifies the node within the local network. The complete node address is formed as follows: The local address is placed in front of the subnet index of the local network assigned by the parent. In turn, the subnet index is placed in front of the node address of the parent. The length of the subnet index (in bits) is thereby determined by the device. The length of the local address, conversely, is determined by the type of network. A node without a main network is a top level node with address 0. A node with a main network that contains no parent is likewise a top level node. It is given the local address of the main network.

See an example of a control network here:
In the example the addresses of the nodes are represented in hexadecimal notation. The first 4 digits represent the address of the respective parent in the main network, for example 0x007A=122 for PLC1. The next byte (in blue lettering) is reserved for the subnet index and is followed by the local address, for example C=12 for node ID 12. The structuring of the addresses makes a lean routing algorithm possible. Routing tables, for example, are thus unnecessary. Information is queried only locally: via its own address and via the address of the parent node. On this basis a node can correctly process the data packets:

- If the destination address corresponds to the address of the current node, then this is meant to be the receiver.
- If the destination address starts with the address of the current node, then the data packet is either meant directly for a child or for a descendant of the node and must be forwarded.
- In all other cases the receiver is not a descendant of the current node and the data packet must be forwarded to its own parent.

Relative addressing is a special case: relative addresses do not contain the node number of the receiver, but directly describe the path from the sender to the receiver. The principle is similar to the relative path in the file system: the address consists of the number of steps via which the packet must be transported upwards. These are the steps to the corresponding parent and from the subsequent path downwards to the destination node.

The advantage of relative addressing is that two nodes in the same subtree can continue to communicate if the complete subtree is shifted to another place in the entire network. Whereas the absolute node addressing has to be modified due to this shift, the relative addressing is still valid.

Address determination

For a node to know its own address it must either know the address of its parent node or know that it is a top level node. For this purpose the node dispatches a message during the bootup to all network devices for address determination. As long as it receives no response to this message, the node considers itself to be a top level node, but continues to search for a possible parent. A parent node responds by announcing its address. The node will thus independently complete its address and will announce it to the subnets. An address determination can be accomplished during the bootup or at the request of the PC used for programming.
Address Structures

Network addresses

Network addresses represent a mapping of the addresses of the network type (for example IP) to logical addresses within a control network. This mapping is carried out by the corresponding block driver. The first three bytes of the IP address are identical for all network devices within an Ethernet network with "Class C" IP addresses. Consequently, the last 8 bits of the IP address suffice as network address, since they enable unambiguous mapping between the two addresses on the block driver.

A node has a different network address for each network connection. Different network connections can have the same network address, since each address need only be locally unique.

Terminology: the network address in the main network is usually designated as the network address of a node with no specification of the network connection.

The length of a network address is specified in bits and can be chosen by the block driver as required. The same length must be used for all nodes within a network area. A network address is represented by an array of bytes in accordance with the following coding:

- Length of the network address: \( n \) bits
- Necessary bytes: \( b = \frac{n + 7}{8} \)
- The \( (n \mod 8) \) bits of lowest rank of the first byte and all others \( (n \div 8) \) are used for the network address.

Example of network address coding

Length: 11 bit
Address: 111 1000 1100

Node addresses

The node address indicates the absolute address of a node within a control network and is therefore unique within the whole "network tree". The address is composed of up to 15 address components, each of which occupies 2 bytes. The lower a node is located within the network hierarchy, the longer its address.

The complete node address consists of the partial addresses of all preceding nodes and the partial address of the node itself. Each partial address consists of one or more address components. The length is therefore always a multiple of 2 bytes. The partial address of a node is formed from the network address of the node in its main network and the subnet index of the main network in the case of the parent node. The bits required for the subindex are determined by the router of the parent node. Filler bits can be inserted between the subnet index and the network address in order to ensure that the length of the partial address is a multiple of 2 bytes.

Special cases:

- A node without a main network: this means that there is neither a subnet index nor a network address in the main network. In this case the address is set to 0x0000.
- A node in the main network without a parent: In this case a subnet index with the length 0 is assumed. The partial address corresponds to the network address, if necessary extended by filler bits.
The node address is always specified in hexadecimal. The individual address components (two bytes in each case) are separated by a colon "::". Since this represents an array of bytes and not a 16-bit value, the components are not displayed in the Intel format. For manually input addresses, missing parts in an address component are supplemented by leading zeros: "274" = "0274". In order to improve the legibility, the display should also always contain the leading zeros.

**Absolute and relative addresses**

Communication between two nodes can be based on relative or absolute addresses. Absolute addresses are identical to node addresses. Relative addresses specify a path from the sender to the receiver. They consist of an address offset and the descending path to the receiver.

The (negative) address offset describes the number of address components by which a packet must be passed upwards in the tree before it can be passed back down by the common parent node. Since nodes can use partial addresses that consist of more than one component, the number of parent components to be passed is always equal to the address offset. This means that the demarcation between the parent nodes is no longer clear. For that reason the common start of the address of the communication partners is used as the parent address. Each error resulting from this assumption can be detected by the corresponding parent node and must be handled by it accordingly.

After achieving the common parent node the relative path, as an array of address components, is followed downwards as usual. Formal: the node address of the receiver is formed by removing the last address offset components from the node address of the sender and by appending the relative path to the remaining address.
In the following example each address component is represented by a letter; in each case a dot separates nodes from each other. Since a node can carry several address components, there are some in the example that are represented with several letters.

Node A: a.bc.d.ef.g
Node B: a.bc.i.j.kl.m

- Address of the lowest common parent: a.bc
- Relative address from A to B: -4/i.j.kl.m (The number 4 results from the 4 components, d, e, f and g, which must pass on the data packet in the upward direction)

In order to guarantee correct operation of the routing, the relative address must be adapted each time it passes an intermediate node. It is sufficient to adapt the address offset. This is always done by the parent node: If a node receives a data packet from one of its subnets, the address offset is increased by the length of the address component of this subnet.

- If the new address offset is < 0, then the data packet must be passed further upward.
- If the address offset is >= 0, then the data packet must be passed on to the child node whose local address corresponds to the relative path, starting from the address offset. First of all, however, the address offset must be increased by the length of the local address of the child node, so that the child node sees the correct address.

A special situation results if the error mentioned above occurs during the determination of the common parent node. In this case the address offset of the actual parent node is negative, but this value is larger than the length of the partial address of the subnet from which the packet originated. So that the next node sees a correct relative address in this case, the node concerned must do the following: it must discover the error, calculate the local address of the child node on the basis of the address of the predecessor node and the length difference, and adapt the address offset accordingly. In this case, too, the address components as such remain unchanged; only the offset is changed.

---

**Broadcast addresses**

There are two types of broadcast - global and local. A global broadcast is sent to all the nodes in a network. The empty node address with a length of 0 is reserved for this purpose.

Local broadcasts are sent to all the devices in a network area. For this purpose, all the bits of the network address are set to 1. This is permissible both in relative and in absolute addresses.

A block driver must be able to process both kinds of broadcast addresses. This means: empty network addresses as well as network addresses whose bits were all set to 1 must be interpreted and sent to all devices concerned.

---

**6.4.1.10.3 Symbol Configuration**

Use the symbol configuration for preparing symbols with specific access rights for project variables. You can use these symbols to access the variables externally.

For providing symbols to an OPC UA Server, we recommend using the new configuration editor (IEC Symbol Set Configuration) for CODESYS 3.5 SP18 and higher.

☞ Chapter 6.4.1.10.4 “IEC Symbol Set Configuration” on page 1945

When generating code, CODESYS also generates a symbol file (*.xml) which includes the description of the symbols.

The symbol file is stored in the project directory. The name of the symbol file is composed as follows: `<project name>.<device name>.<application name>.xml`

**Example**

proj_xy.PLL1.application.xml
You can also generate the symbol file with the “Generate Code” command. This is very useful when downloading to the PLC is not possible.

The variables that you export as symbols can be bundled in the symbol configuration editor or defined in the variables declaration using the `{attribute 'symbol'}` pragma. Another option is using the element in the SFC editor, where you can define the implicitly generated element variables that should be exported to the symbol configuration.

The name of the symbol is generated in the symbol configuration in the following syntax: `<application name>..<POU name>..<variable name>`. When accessing the variable, you must always provide the complete symbol name in this syntax.

Example

MyApplication.PLC_PRG.a or MyApplication.SymFB.a

As a rule, read-only access applies to symbols for input addresses and for variables that are mapped to input channels. Write access is possible for testing purposes in simulation mode only.

The number of symbols which can be exchanged via OPC UA is limited based on the used AC500 V3 PLC type. OPC UA symbols can be configured via two ways:

- Select the symbols in the “Symbol Configuration” object and enable the flag “Support OPC UA features”. All selected symbols are counted for the OPC UA tag limitation.
- Define the symbols in the “Symbol Set” object(s) below “Communication Manager → OPC UA Server”. All defined symbols are counted for the OPC UA symbol limitation, independently if they are defined in several “Symbol Set” objects.

In case both ways are used in parallel the sum of the symbols is considered for the OPC UA symbols limitation.

The symbol file is downloaded together with the application to the PLC. Depending on the device description, this file can be generated as an additional (child) application. This application is then listed on the “Application” tab of the device editor.

Syntax: `<application name>._symbols`.

The symbol application is regarded as a “normal” application with respect to the maximum number of applications on the PLC.

If your controller has a user management, then you can assign different access rights to a symbol to the individual user groups (clients). To do this, place the same symbol in different symbol sets and allow the individual user groups (clients) either to access a symbol set or not. An on-site operator or an operating data record, for example, receives more information and access to the same symbols as remote maintenance.

NOTICE!

When attribute pragmas are used for POUs and variables, the behavior of these POUs and variables can change with respect to the symbol configuration.

See also

- Chapter 6.4.1.21.2.27 “Object ‘Symbol Configuration’” on page 2523
- Chapter 6.4.1.20.6.3.43 “Attribute ‘symbol’” on page 2314
- Chapter 6.4.1.20.6.3.46 “Effects of Pragmas on Symbols ” on page 2315
Creating a symbol configuration

Requirement: The project can be compiled without any errors.

1. Select the “Application” object in the device tree.
2. Click “Project ➔ Add Object ➔ Symbol Configuration”.
   ➔ The “Symbol Configuration” object is added to the device tree and the objects editor opens.
3. Open the “View” menu of the editor and activate the categories of variables that should be provided in the configuration editor. Click “Build” in the symbol configuration editor.
   ➔ All variables (according to the currently defined filter in the “View” menu) are displayed in a tree structure.
4. Select the check boxes of individual variables.
   Note: Pay attention to the current settings (see the “Settings” button in the menu bar of the editor).
   ➔ In the field below the menu bar of the editor, information is provided about the current situation with accompanying instructions, as well as controls for corrective actions.
5. Follow the prompt in the field below the menu bar. In the following case, this should be only the information that the modified symbol configuration is transferred with the next download or online change.
   Click “Build ➔ Generate Code” on the CODESYS menu bar.
   ➔ The <project name>..<device name>..<application name>.xml file is generated in the project directory.

CODESYS transmits the symbol configuration to the PLC for an application download or online change.

See also
- Chapter 6.4.1.21.2.27 “Object ‘Symbol Configuration’” on page 2523

Creating symbol sets with different access rights for different control clients

A symbol set is a defined set of symbols. If supported by the target device, you can combine different symbol sets from the symbols of the application in the symbol configuration editor. The information about the symbol sets is downloaded to the controller. Then you can define the user group that has access to each symbol set. Rights are assigned on the “Symbol Rights” tab of the device editor.

As a result, symbol sets allow different client-specific access rights to a symbol in the controller.

You can download changes to a symbol set definition to the controller in an online change. When the application is deleted on the controller, the symbol sets are also deleted. When building the application, you can create and save a symbol file in XML format for each symbol set.

When symbol sets should be used with OPC UA, it is a requirement that a certificate has to be stored for OPC UA.

As a requirement for creating symbol sets and for granting permissions on the controller, the user management has to be configured both for optional and for forced device user management:
1. In the editor of the controller, open the “Users and Groups” tab and click the button.

2. When the user management is still not enabled, first click [Yes] to acknowledge the prompt about enabling the user management. In the “Add Device User” dialog, specify a new user name and a password for a user of the Administrator group. Then confirm the password and click [OK].

3. In the “Device User Logon” dialog, specify the “User name” and “Password”. Then click [OK]. The user and groups are displayed on the “Users and Groups” tab.

In the following section, you will see an example of steps for creating symbol sets and the assignment of rights on the controller.

Requirements

- The application has a defined symbol configuration in the project.
- A user management is configured for the controller (see above). For the example here, there should be a user group that has the necessary rights for the servicing of the plant. By default, this type of user group, named "Service", is already created.
- The “Enable symbol sets” option is enabled in the settings of the symbol configuration.
- The connection to the controller is configured in the “Communication Settings” of the device editor.

1. Click the button in the editor of the “Symbol Configuration” in order to create a new symbol set. In the “Add New Symbol Set” dialog, specify "Startup" as the name for the group.

2. In the toolbar of the dialog, click the button ([Build]) in order to display all symbols which are available in the project. Select the users who should belong to the group. Save the project.

3. Click Online → Login to connect the application to the controller. Click [Yes] to the prompt of whether or not the application should be downloaded to the device.

4. In the editor of the symbol configuration, click the button ([Configure Symbol Rights]) button. The “Symbol Rights” tab of the device editor opens.

5. Click the button([Synchronization]) to synchronize the display of the symbol sets with the device.

- In “Symbol Sets”, you see all sets that have currently been downloaded for the application (for this example, at least "Startup"). In “Rights”, a table shows the user groups that are created in the user management of the controller. In the example, we assume that the default groups “Administrator” and “Service” have been created. When a symbol set is selected on the left, you see on the right the permissions of the individual user groups to this symbol set (access granted; access denied). The possible type of access is already defined for each symbol in the symbol configuration (read, write, execute).

6. On the left, select the [Startup] symbol set and double-click the preset minus sign for "Administrator" as well as for "Service".

- The symbol changes into a plus sign. The "Administrator" and "Service" groups now have access to the symbols in the [Startup] symbol set.

See also

- Chapter 6.4.1.11.4 “Handling of Device User Management” on page 1971
- Chapter 6.3.6.2.1 “General” on page 1787
The number of symbols which can be exchanged via OPC UA is limited based on the used AG500 V3 PLC type. OPC UA symbols can be configured via two ways:

- Select the symbols in the “Symbol Configuration” object and enable the flag “Support OPC UA features”. All selected symbols are counted for the OPC UA tag limitation.
- Define the symbols in the “Symbol Set” object(s) below “Communication Manager ➔ OPC UA Server”. All defined symbols are counted for the OPC UA symbol limitation, independently if they are defined in several “Symbol Set” objects.

In case both ways are used in parallel the sum of the symbols is considered for the OPC UA symbols limitation.

In addition to the known “Symbol Configuration Editor”, with CODESYS Communication there is also a new editor for configuring IEC symbols for exchanging with other controllers.

Currently, the “IEC Symbol Publishing” object for the publication of symbols via “OPC UA” is available. The object has to be inserted in the device tree below the application below the “Communication Manager” object and there again below an “OPC UA Server” object.

You can insert multiple “IEC Symbol Publishing” type objects to configure different symbol sets for different purposes. Individually assign the object names accordingly. In the OPC UA Client, a separate folder with the assigned name is then created for each symbol set.

The IEC symbol set configuration is based on precompile information. In contrast to the known “Symbol Configuration”, the project does not necessarily have to be in an error-free compilable state to get the variables and types available in the project for a configuration in the editor. Discrepancies between the editor and the project, which may result due to changes in the project, will be brought to your attention and you will be assisted in making corrections.

Chapter 6.4.1.10.3 “Symbol Configuration” on page 1941

Creating and configuring a symbol set

Requirement:

You have a project with IEC variables and IEC data types. You want to exchange a specific set of variables as symbols with other OPC UA Clients via an OPC UA Server. For the following instructions: To control the publication, you have also created a data source of type OPC UA in the project. See here: Establishing the Connection of a Data Source OPC UA Client to an OPC UA Server.

Chapter 6.4.1.10.6.7 “Data Source OPC UA Client” on page 1960

In the following, you create the required symbol configuration for a symbol set in the editor of an object of type “IEC Symbol Publishing”:

Chapter 6.4.1.21.2.14 “Object: IEC Symbol Publishing” on page 2466

1. Click [Add Object] to add a “Communication Manager” below the application.
2. Add an “OPC UA Server” below the communication manager.
3. Add an “IEC Symbol Publishing” object below the “OPC UA Server” and rename the object (for example, "webvisu", or "client xy", depending on the intended use of the symbol set to be configured).
4. Double-click the symbol publishing object to open the editor.
   ⇒ Below “Precompile Sets” in the left part of the window, the variables and types which are currently supported in the project for publishing are listed.
5. Select one or more variables or a POU containing variables and drag the selection to the right part of the window.
   ⇒ The variable(s) are inserted into the table.
6. Configure all desired variables in the table for export as symbols. If necessary, assign a different symbol name and set the access rights. When assigning the access rights, note the "Use access rights defined in the user management" option at the top of the editor. When this option is selected, the rights assigned in the user management of the controller for the symbol set are also considered in addition to the access rights set here in the editor. The stronger restriction is applied.

7. If you have structured data types in the project, then on the "Symbol Type Editor" tab you can make a specific symbol configuration for different variants of the type:

8. For example, on the "Symbol Type Editor" tab, drag a POU of type STRUCT to the table on the right side of the window. Click the button to open the Data type members of <STRUCT> dialog.

9. Select the members of the <STRUCT> POU to be exported as symbols and configure accordingly. Close the dialog.

10. Option: On the "Symbol Type Editor" tab, drag the same POU of type STRUCT to the table a second time and configure it with the corresponding name as a "variant" of the first one.

11. In the project, change something in the declaration of the STRUCT type, for example, add another member. Then click "Refresh" in the symbol editor.

   An icon is displayed at the corresponding entry in the table. In the tooltip of the icon, you will be prompted to click the button to resynchronize between the editor and the project.

12. Click the button.

   The "Data type members of<STRUCT>" dialog opens and by clicking [D] the editor and project are synchronized again. The new member is added to the configuration table.

13. When the symbol configuration is finished, log in to the controller and open the data source object created for OPC UA to check the symbols for publishing.

   On the "Variables" tab, you can see the symbol set(s) with the variables and types you have defined as symbols.

6.4.10.5 Network Variables

Network variables can be used to exchange data between two AC500 V3 PLCs. The variables must be defined in strict and identical lists on both PLCs which are sender and receiver. The lists can be in one or more projects.

A step-by-step description on how to use network variables can be found in the application example.

The network variable list in the sender is a global variable list where specific log and transfer parameters are defined in their object properties. By adding these properties, you create a "network variable list (sender)" from an ordinary "GVL". You can also insert a "Network Variable List (Sender)" object directly into the device tree when this object already has these parameters set.

The network variable list in the receiver is of type "Network Variable List (Receiver)". When creating one, select the respective network variable list of the server. As an alternative, you can read this variable list from an export file that was generated from the sender list. An export file is required anyway for defining the sender list in another project.

The network variables are transmitted as broadcasting in one direction only: sender to receiver. However, it is also possible for a device to contain both sender and receiver lists.

For the NetVarUdp library version 3.5.7.0 and later, a receiver channel is no longer assigned when confirmed transfer is not selected. In this way, network variable exchange is also possible between two controllers on one hardware device.
NOTICE!

- If the exchanging devices should be senders and receivers, then the variable list identifiers must be unique in order to prevent abnormal operation. The variable list identifiers are defined in the “Properties” dialog of an object GVL.
- Data exchange via network variables is not possible when:
  - The device (target system) does not support it.
  - A firewall blocks the communication.
  - Another client or application is using the UDP port that is set in the properties of the network variable list.
  - More than one application per sender device and receiver device use network variable lists.
- Only arrays that have limits defined with a literal or constant are transmitted to the receiver application. Constant expressions are not permitted for this purpose.
  Example: "arrVar : ARRAY[0..g_iArraySize-1] OF INT ;" is not transmitted, but "arrVar : ARRAY[0..10] OF INT ;" is transmitted.
- The maximum size of a network variable is 255 bytes. The possible number of network variables is unlimited.
- If the size of the GVL exceeds the maximum length of the network telegram, then the data is split into multiple telegrams. Depending on the configuration, this can result in data inconsistencies.

See also

- § Chapter 6.4.1.21.4.11.12 “Dialog ‘Properties’ - ‘Network Variables’” on page 2760
- § Chapter 6.4.1.21.2.12 “Object ‘GVL’ - Global Variable List” on page 2465
- § Chapter 6.3.5.2 “Data exchange between AC500 V3 PLCs via EtherCAT” on page 1751

6.4.1.10.6 Data Link with Data Sources

General

In order to have read/write access to the remote devices and their running applications, you can add a data source manager to your application with one or more data sources.

The functionality of the data source manager allows for establishing connections and communication to remote devices, and it makes its data available through data source variables. At this time, the partners communicate by means of a point-to-point connection. Depending on the network where the controllers are located, a connection is established via the CODESYS data source types or CODESYS ApplicationV3.

Data source type CODESYS Symbolic

The data source type CODESYS Symbolic is available only together with a CODESYS HMI device. However, then it is advantageous to use this type.

Below a CODESYS HMI device, you can configure the data link either with data source type CODESYS Symbolic or with data source type CODESYS ApplicationV3. We recommend that you select the data source type CODESYS ApplicationV3 only when there are no resources for the symbol configuration available on the remote device. For example, this is the case with embedded or mini PLCs whose applications often do not contain a symbol configuration.

The requirement for a connection setup is that symbols have been configured in the remote device and as a result a symbol file exists. The application in the remote device has a symbol configuration. Then the data link can take place via symbolic monitoring.
In the case of symbolic monitoring, the symbol file on the remote device is read and the stored variable information is used for the data source variables and the data transfer. The advantage is that the application does not have to be updated in the local device when someone modifies the remote application without updating its symbol configuration. If the symbol file is also located on your development system (either a file or a symbol configuration object as part of your project), then the local symbol file can also be read. Then you can work offline during the development phase.

During the development phase, you can create a variable list offline by means of local symbol configuration files. In this way, you can develop a local application offline based on the symbol information without a connection to a data source.

The following connection types are possible:

- **“CODESYS V2”**
  The devices exist in the same network. The V2 runtime on the remote PLC provides a communication interface.

- **“CODESYS V2 (Via gateway)”**
  The devices do not exist in the same network. They are connected via a V2 gateway. Note: For this connection, a “CoDeSys V2.3 Gateway Server” (V2 gateway) has to be installed on the development computer where CODESYS V3 is running.

- **“CODESYS V3”**
  The devices exist in the same network. The V3 runtime on the remote PLC provides a communication interface.

- **“CODESYS V3 (Via gateway)”**
  The devices do not exist in the same network. They are connected via a V3 gateway.

This data source type is available below all device types.

The data link with CODESYS ApplicationV3 data source type is done by means of address monitoring. This requires that the address information between the remote PLC and the local device match. The runtime system of the local application needs valid communication parameters in order to establish the connection.

Disadvantage: If you modify the remote application, then you also have to update the local application afterwards (for example, the HMI application.

The advantage is that a symbol configuration is not required in the remote application.

At runtime of the local application, the data source variables that appear in the data source editor of the “Variables” tab are updated in configurable time intervals. The remote application is also executed at this time. Variables that are configured in the visualization, in the trend, as alarms, or for recipes are transferred and stored automatically. When a variable is accessed in IEC code only, the variable is not updated automatically. In this case, you have to select the “Update always” option in the data source editor of the “Variables” tab.

The data source types support the (read or write) data access to variables of the source PLC for the following data types:

- **Scalar value at top level**
  
  Example: PLC_PRG.hugo

- **Property to a program or GVL by means of a call when it is marked with**
  
  Example: PLC_PRG.PropertyCall

- **Variable which is mapped to bit addresses**
  
  Example: PLC_PRG.x AT %MX0.5 : BOOL;
• Variable (type BIT) in a function block
  Example: Declaration in DUT: x, y : BIT, bit access: PLC_PRG.dutInst.y

• Structured obtainable variable
  Example: PLC_PRG.outerInst.innerInst.dwVar

• Property to POU instance when it is marked with [attribute monitoring := 'call'].
  Example: PLC_PRG.instance.PropertyCall

• Property at top level and to an instance when it is marked with [attribute monitoring := 'variable'].
  Note: This cannot be written by monitoring or by the data sources.

• Array access with literal index
  Example: PLC_PRG.arrOfInts[3], PLC_PRG.inst.arrOfBool[1]

• Nested access (for example, array of structures or structure of arrays)

CAUTION!
Bit access used in visualizations that are transferred via a data source connection function only if they contain literal offset specifications. A visualization cannot process an offset specification by defined constants.

Initially Adding a Data Source

For data exchange between your local device and a remote device, add a “Data Source Manager” object and then a “Data Source” below your application in the device tree. A wizard guides you through the configuration of the data source. Afterwards, you can change the settings at any time in the editor of the object. However, it is not possible to modify the data source type later.

Use the “CODESYS Symbolic” data source type unless there are no resources available in the remote PLC for a symbol configuration. As long as the symbol configuration in the remote device is not impacted by an application change, you have the advantage that the application in the local device does not have to be updated.

When adding a data source, select a data source type. Then specify the connection settings of the point-to-point connection to the remote device. Ideally, the remote device is running during this time and CODESYS can establish the connection to it immediately. Then all available data source variables from the remote PLC are displayed. Select the variables that should be transferred. You can also select all variables. Then the data source is initialized automatically, the data source variables are created below the “DataSources_Objects” folder, and another data source is added below the data source manager.

If the data is transferred using symbolic monitoring and the symbol file is stored on your development system, then you can read the variable information from the symbol file and work offline. The symbol file is stored either as a file on your development system or as a symbol configuration object as part of your project (in CODESYS).

The initial settings can be changed at any time in the data source editor.

See also

• ‡ Chapter 6.4.1.21.2.5 “Object ‘Data Source Manager’” on page 2412
A “CODESYS Control Win V3” is running on the remote device. Moreover, an application is running with a symbol configuration.

1. Below your application in the device tree, insert a “Data Source Manager” object.
2. Select the “Data Source Manager” object and click “Add Object ➤ Data Source”.
   ⇒ The “Add Data Source” dialog opens.
3. In the “Name” field, specify the data source name.
   ⇒ Example: ds_Remote_Device
4. As the data source type, select “CODESYS Symbolic”.
   ⇒ The data transfer is done via symbolic monitoring. The “Initialize Data Source Wizard - Provider settings” dialog opens.
5. As the connection type, select “CODESYS V3”.
6. For “Type of name or address”, select the “Node name” option.
7. In the “Connection Settings” group, specify the connection parameters for configuring the remote device. Example: “[03A7]”
   ⇒ The connection to the remote device is established and the application is read. The “Initialize Data Source Wizard - Browse data items” dialog also opens. The read remote control variables are displayed in the tree view on the “Variables” entry. The top node is the application, which is displayed with its remote application name.
8. In the tree view, select which control variables should be transferred. Then click “Finish”.
   ⇒ The data source is initially configured. The ds_Remote_Device object is added below the “Data Source Manager” node. The object is open, and on the “Variables” tab, the data source variables to be generated are displayed in the tree view. The GVL ds_Remote_Device, where the data source variables are declared, is located below the “DataSource_Objects” folder.

A “CODESYS Control Win V3” is running on the remote device. Moreover, an application is running with a symbol configuration. The remote device exists in another network so that the communication has to be routed via a gateway.

1. Below your application in the device tree, insert a “Data Source Manager” object.
2. Select the “Data Source Manager” object and click “Add Object ➤ Data Source”.
   ⇒ The “Add Data Source” dialog opens.
3. In the “Name” field, specify the data source name.
   ⇒ Example: ds_Remote_Device
4. As the data source type, select “CODESYS Symbolic”.
   ⇒ The data transfer is done via symbolic monitoring. The “Initialize Data Source Wizard - Provider settings” dialog opens.
5. As the connection type, select “CODESYS V3 (Via gateway)”.
   ⇒ You can also specify the communication parameters for the gateway.
6. For “Type of name or address”, select the “Node name” option.
7. In the “Connection Settings” group, specify the connection parameters for configuring the remote device. Example: “[03A7]”
   ⇒ The connection to the remote device is established and the application is read. The “Initialize Data Source Wizard - Browse data items” dialog also opens. The read remote control variables are displayed in the tree view on the “Variables” entry. The top node is the application, which is displayed with its remote application name.
8. In the tree view, select which control variables should be transferred. Then click “Finish”.

The data source is initially configured. The `ds_Remote_Device` object is added below the “Data Source Manager” node. The object is open, and on the “Variables” tab, the data source variables to be generated are displayed in the tree view. The GVL `ds_Remote_Device`, where the data source variables are declared, is located below the “DataSource_Objects” folder.

Initially connecting devices symbolically via 'CODESYS V2’

A “CoDeSys V2.3 SP PLCWinNT V2.4” is running on the remote device. Moreover, an application is running with a symbol configuration.

1. Below your application in the device tree, insert a “Data Source Manager” object.
2. Select the “Data Source Manager” object and click “Add Object  Data Source”.

The “Add Data Source” dialog opens.
3. In the “Name” field, specify the data source name.
   Example: `ds_Remote_Device`
4. As the data source type, select “CODESYS Symbolic”.

The data transfer is done via symbolic monitoring. The “Initialize Data Source Wizard - Provider settings” dialog opens.
5. As the connection type, select “CODESYS V2”.
6. In the “Connection Settings” group, specify the connection parameters for configuring the remote device.
   Example: driver type TCP/IP (Level 2 Route), address localhost, port 1200

The connection to the remote device is established and the application is read. The “Initialize Data Source Wizard - Browse data items” dialog also opens. The read remote control variables are displayed in the tree view on the “Variables” entry.
7. In the tree view, select which control variables should be transferred. Then click “Finish”.

The data source is initially configured. The `ds_Remote_Device` object is added below the “Data Source Manager” node. The object is open, and on the “Variables” tab, the data source variables to be generated are displayed in the tree view. The GVL `ds_Remote_Device`, where the data source variables are declared, is located below the “DataSource_Objects” folder.

Initially connecting devices symbolically via 'CODESYS V2 (Via gateway)’

A “CoDeSys V2.3 SP PLCWinNT V2.4” is running on the remote device. Moreover, an application is running with a symbol configuration. The remote device exists in another network so that the communication has to be routed via a gateway.

1. Below your application in the device tree, insert a “Data Source Manager” object.
2. Select the “Data Source Manager” object and click “Add Object  Data Source”.

The “Add Data Source” dialog opens.
3. In the “Name” field, specify the data source name.
   Example: `ds_Remote_Device`
4. As the data source type, select “CODESYS Symbolic”.

The data transfer is done via symbolic monitoring. The “Initialize Data Source Wizard - Provider settings” dialog opens.
5. As the connection type, select “CODESYS V2 (Via gateway)”. You can also specify the communication parameters for the gateway.
6. In the “Connection Settings” group, specify the connection parameters for both the gateway and the device configuring the remote device.

Example: driver type TCP/IP (Level 2 Route), address localhost, port 1200

⇒ The connection to the remote device is established and the application is read. The “Initialize Data Source Wizard - Browse data items” dialog opens. The remote control variables are displayed in the tree view on the “Variables” entry.

7. In the “Connection Settings” group, specify the connection parameters for configuring the remote device. Example: “[03A7]”

⇒ The connection to the remote device is established and the application is read. The “Initialize Data Source Wizard - Browse data items” dialog opens. The read remote control variables are displayed in the tree view on the “Variables” entry. The top node is the application, which is displayed with its remote application name.

8. In the tree view, select which control variables should be transferred. Then click “Finish”.

⇒ The data source is initially configured. The ds_Remote_Device object is added below the “Data Source Manager” node. The object is open, and on the “Variables” tab, the data source variables to be generated are displayed in the tree view. The GVL ds_Remote_Device, where the data source variables are declared, is located below the “DataSource_Objects” folder.

Initially adding data source variables from a symbol file

Ideally, the same symbol file on the remote device is saved on your development system.

1. Below your application in the device tree, insert a “Data Source Manager” object.

2. Select the “Data Source Manager” object and click “Add Object ➔ Data Source” in the context menu.

⇒ The “Add Data Source” dialog opens.

3. In the “Name” field, specify the data source name.

⇒ Example: ds_Symbols

4. As the data source type, select “CODESYS Symbolic”.

⇒ The data transfer is done via symbolic monitoring. The “Initialize Data Source Wizard - Provider settings” dialog opens.

5. In “Variable information”, click the “From symbol file” entry.

6. In “Select symbol file”, specify the location and the file name of the symbol file. When the code is generated, an XML symbol file is created in the project directory by default.

⇒ Example: D:\Projects\V3.5 SP11\Project_A.Device.Application.xml

Hint: When a symbol file is specified, no additional connection settings have to be configured. A connection is not established. You are working offline. You have to configure the connection settings only when you need current data from the controller which is transferred online. In the “Variable information” settings, select the “From connection settings” option.

7. Click the “Next” button.

⇒ The “Initialize Data Source Wizard - Browse data items” dialog opens. The read symbols are displayed in the tree view on the “Variables” entry.

8. In the tree view, select the symbols to be transferred. Then click “Finish”.

⇒ The data source is initially configured. The ds_Symbols object is added below the “Data Source Manager” node. The object is open, and on the “Variables” tab, the data source variables that were generated based on the symbol file are displayed in the tree view. The GVL ds_Symbols, where the data source variables are declared, is located below the “DataSource_Objects” folder.
Your active project contains the control application for the remove device. The control application includes a symbol configuration with symbols that are added to your local application as data source variables.

1. Below your local application in the device tree, insert the “Data Source Manager” object.
2. Select the “Data Source Manager” object and click “Add Object ➔ Data Source”.
   ➦ The “Add Data Source” dialog opens.
3. In the “Name” field, specify the data source name.
   ➦ Example: ds_Symbols
4. As the data source type, select “CODESYS Symbolic”.
   ➦ The data transfer is done via symbolic monitoring. The “Initialize Data Source Wizard - Provider settings” dialog opens.
5. In “Variable information”, select the “<remote device>.<application>.symbol configuration” entry.
   ➦ Example: Device.Application.Symbol Configuration
   Hint: When a symbol file is specified, no additional connection settings have to be configured. A connection is not established. You are working offline.
6. Click the “Next” button.
   ➦ The “Initialize Data Source Wizard - Browse data items” dialog opens. The read symbols are displayed in the tree view on the “Variables” entry.
7. In the tree view, select the symbols to be transferred. Click “Finish”.
   ➦ The data source is initially configured. The ds_Symbols object is added below the “Data Source Manager” node. The object is open, and on the “Variables” tab, the data source variables that were generated based on the symbol configuration are displayed in the tree view. The GVL ds_Symbols, where the data source variables are declared, is located below the “DataSource_Objects” folder.

A “CODESYS Control Win V3” is running on the remote device. The project of the remote device is located on your development computer. The engineered application there does not contain a symbol configuration.

Use this communication link only if there are no resources available in the remote PLC for a symbol configuration.

1. Below your application in the device tree, insert a “Data Source Manager” object.
2. Select the “Data Source Manager” object and click “Add Object ➔ Data Source”.
   ➦ The “Add Data Source” dialog opens.
3. In the “Name” field, specify the data source name.
   ➦ Example: ds_Remote_Device
4. As the data source type, select “CODESYS ApplicationV3”.
   ➦ The data transfer is done by means of address monitoring. The “Initialize Data Source Wizard - Provider settings” dialog opens.
5. For “Select the project type”, select the “Other Project” option.
6. For “Choose file”, specify the file and location of the project on the remote device. Example: C:\Data\Projects\PLC_A.project.
   The remote device is displayed in the tree view of the window below, and as a result the connection was established.

7. Click the “From device” link.
   The connection parameters to the remote device are read and displayed in the dialog. The connection is configured.

8. Click “Next>”.
   The “Initialize Data Source Wizard - Browse data items” dialog opens. The remote control variables are displayed in the tree view on the “Variables” entry.

9. In the tree view, select which control variables should be transferred. Then click “Finish”.
   The data source is configured. A connection is established. The settings are stored in the object and can be modified in the editor of the object.

   The data source is initially configured. The ds_Remote_Device object is added below the “Data Source Manager” node. The object is open, and on the “Variables” tab, the data source variables to be generated are displayed in the tree view. The GVL ds_Remote_Device, where the data source variables are declared, is located below the “DataSource_Objects” folder.

See also
● Appendix A 6.4.1.21.2.6.4 “Tab 'Communication' via CODESYS Symbolic” on page 2417
● Appendix A 6.4.1.21.2.6.5 “Tab 'Communication' via CODESYS ApplicationV3” on page 2422

### Editing data source variables

In runtime mode, the remote data is saved to the data source variables. The data source variables and their mapping to the remote variables are displayed in the data source editor below of the “Variables” tab. If the local and remote variables have the same names and the same data types, then the data is mapped 1:1. The variables and the data types are created automatically. That is the regular procedure.

You can also map to existing variables. This is necessary, for example, if a visualization includes a data type in an interface. Then the same data must be passed to this visualization. In this case, the declared local variable and the remote variable have the same data type, for example from one library. Moreover, you can map a local variable with a conforming data type to a remote variable. The data type can be created in the “Type Mappings” tab.

The specifically created variables and data types are declared in the “DataSource_Objects” folder. For each data source, a global variable list of the same name as the data source is declared there. Moreover, the data source variables usually have the identical or conforming data type as the remote control variable and they are declared as user-defined data types (DUT objects). Considering all data sources, multiple declaration of the same data types is avoided.

Do not edit the data interface in the “DataSource_Objects” folder manually. It is created initially when adding a data source. Changes can be made later in the editor of the data source.

See also
● Appendix A 6.4.1.10 “Working with Controller Networks” on page 1936
● Appendix A 6.4.1.10.6.5 “Updating data interfaces” on page 1957
● Appendix A 6.4.1.21.2.6.2 “Tab ‘Variables’” on page 2415

### Selecting variables for data transfer

You can edit the selection of the data source variables.
Requirement: The remote device and its application are running. A data source manager is already inserted below the local application with a data source.

1. Open the editor of the data source.
2. Select the “Variables” tab.
3. Click “Update Variables”.
   ⇨ The “Browse Variables” dialog opens.
4. Activate the variables that should be transferred and click “OK” to close the dialog.
   ⇨ The data source variables are modified according to the selection. The declaration of variables and data types is also modified.

   The “Variables” tab shows the modified selection. Moreover, the mapped remote variable is listed in the “Remote variable” column.

See also
- "Chapter 6.4.1.10 “Working with Controller Networks” on page 1936"
- "Chapter 6.4.1.10.6.5 “Updating data interfaces” on page 1957"
- "Chapter 6.4.1.21.2.6.2 “Tab Variables” on page 2415"

### Mapping remote variables to a new variables

You need to map a remote variable to a global implicit variable that is created new. That is the regular procedure for transposing data source to 1:1.

Requirement: A project is open. A data source manager and a data source below it are located in the device tree of the local application.

1. Open the editor of the data source.
2. Select the “Variables” tab.
   ⇨ The data source variables are listed.
3. Select a variable and click the symbol in the “Create or map” column.
4. Specify a name in “Local variable”.
   ⇨ A variable is declared automatically and it contains the same value as the mapped remote variable.

### Mapping remote variables to an existing variables

You need to map a remote variable to an existing variable.

Requirement: A data source manager and a data source below it are located in the device tree of the local application. The remote data that should be transferred is displayed in the editor of the data source in the “Variables” tab

1. Open the editor of the data source.
2. Select the “Variables” tab.
3. Select a variable and click the symbol in the “Create or map” column.
   ⇨ A variable contains the same value as the mapped remote variable.
First, create a conforming data type and then use it for a variable.

- **Requirement:** A data source manager and a data source below it are located in the device tree of the local application. The remote data that should be transferred is displayed in the editor of the data source in the “Variable” tab.

  1. Open the editor of the data source.
  2. Select the “Type Mappings” tab.
  3. Select the data type in the list that you want to edit.
     - The elements of the data type are listed in the window below the data type list.
  4. Specify a name for the data type. Example: `DataType_A`. Select the name for the remote data types to which the local type should conform. Example: `Library1.DataType_A`.
  5. Modify it in the window below the data type list and remove the elements that are not necessary for the data transfer.
  6. Select the symbol for this data type in the “Create or map” column.
     - The data type `DataType_A` is declared in the “DataSources_Objects” folder.
  7. Select the “Variables” tab.
  8. Specify a name in the “Local variable” column. Example: `Var_A`.
  9. Select the symbol in the “Create or map” column.
  10. Specify the data type `DataType_A` in the “Mapping type” column.
  11. Select the remote variable with the data that should be transferred. Example: `appPLC_A.Data_A`. Use the input assistance for this.
     - A variable `Var_A` is declared automatically with the user-defined data type `DataType_A`. During data transfer, it receives the data of the mapped remote variables.
The example demonstrates how variables of the data source are created. At this time, new variables are created, data is mapped to existing data types and their variables, and new data types are created with type-conforming mapping.

The remote PLC uses POU instances from the **SnakeUtil** library and the HMI device visualizes these POU instances. This is why the HMI application requires a variable in the operating interface that has a data type appropriate for a visualization template. As a result, the **SnakeUtil** library is linked integrated into the HMI application and the HMI variables instantiate the **SnakeUtil.SnakeVisu** visualization function block.

The following library function blocks from the **SnakeUtil** library are used in the remote PLC.

- Function block **SnakeUtil.Snake**: Equipped with much logic and calling from external functions.
- **DUT**: **SnakeUtil.PositionInfo**: Two values (of the variables x and y)
- **DUT**: **SnakeUtil.DrawingInfo**: Image ID
- The **SnakeUtil.SnakeVisu** visualization function block with transfer parameter **SnakeUtil.Snake** visualizes the **Snake** function block.

The following settings are entered in the editor of the “Type Mappings” tab:

In the visualization, a frame is inserted with a reference to **SnakeUtil.SnakeVisu**. This expects to have the type **SnakeUtil.Snake**.

The data types **SnakeUtil.PositionInfo** and **SnakeUtil.DrawingInfo** are mapped to existing data types (symbol in the “Create or map” column). The data types are small and contain data only.

The **SnakeUtil.Snake** function block is very complex and calls external functions that are not available in the HMI visualization. The function block with code is not required in the visualization. You need a less extensive but compatible and conforming type in the HMI visualization. Therefore, do not create the original data type directly. Instead, first modify the original data type and remove the unnecessary elements. Then create the new data type **Snake** by selecting the symbol in the “Create or map” column.

**Editing Communication**

You have added a “Data Source Manager” object and below it a “Data Source” object below your application in the device tree. The connection parameters are displayed in the data source editor of the “Communication” tab. You can modify it there.

The data source type and the current connection type are listed in the status bar. It is not possible to modify the data source type later.

See also

- § Chapter 6.4.1.10.6.2 “Initially Adding a Data Source” on page 1949
- § Chapter 6.4.1.21.2.6.4 “Tab ‘Communication’ via CODESYS Symbolic” on page 2417
- § Chapter 6.4.1.21.2.6.5 “Tab ‘Communication’ via CODESYS ApplicationV3” on page 2422

**Updating data interfaces**

The data source variables are updated cyclically in runtime mode. Only the data is updated that either is used in the current visualization or has the property “Update always”.

---

**Library**

**SnakeUtil**

---
You can define the time interval. Moreover, you can define variables whose data is transferred in each update interval, and therefore they are always update. To update variables that are not used in the application code, you can implement an update programmatically with the help of interface functions from the data source manager.

**NOTICE!**
If data traffic between the remote and local device is too high, then the update rate is reduced automatically. This can lead to an incomplete transfer.

See also
- Chapter 6.4.1.21.2.6.2 “Tab ‘Variables’” on page 2415

### Setting the update rate

1. Open the editor of the data source.
2. Click the “General and Diagnosis” tab.
3. Specify a value in the “Update rate” field.
   
   Example: 100
   
   The data from the remote device to the local device is transferred every 100 ms.

See also
- Chapter 6.4.1.21.2.6.7 “Tab ‘General and Diagnosis’” on page 2426

### Selecting the variable for ‘Update always’

**NOTICE!**
Avoid updating too many variables always. Each update produces additional data traffic at the connection between the remote and local devices. When data traffic is too high, the update rate is reduced automatically. This can lead to an incomplete transfer.

1. Open the editor of the data source.
2. Activate the option “Update always” for a variable.
   
   The data of the variables is transferred at each update cycle, even when the data has not changed.

See also
- Further information on page 2415

### Updating data programmatically

The data source manager provides interface functions in the Datasources library. If a data source manager is integrated in the application code, then the global variable `g_Datasources` is instantiated automatically. This provides access to the interface functions.

Then you can update individual variables that are not called in the active visualization.
The variable `ivar` is activated and deactivated by means of methods from the `Datasources` library so that its value is transferred. Furthermore, you can configure that the variable is updated only over a defined duration in order to save transfer capacity.

```c
//Synchronize with DatasourcesTask and block until access is possible
//Regard the feedback in ERR_OK or in ERR_DE_MULTITASKING_LOCKED
_`g_DataServer.UseData(ADR('RemoteDevice.Application.PLC_PRG.iVar'));`
// Activate variable
// Deactivate variable
//`g_DataServer.ReleaseData(ADR('RemoteDevice.Application.PLC_PRG.iVar'));`
_`g_DataServer.EndDataConfiguration();`
```

The data configuration is started with `BeginDataConfiguration(TRUE)`, thus initializing the synchronization of the task `DatasourceTask` with the application task. The value `TRUE` blocks the processing until the access to the variable is possible; `FALSE` repeats access attempts without blocking. The return values `ERR_OK` and `ERR_DS_MULTITASKING_LOCKED` provide feedback about the access attempts.

When synchronization is successful, the variable is activated by means of the `UseData` method. Then the data configuration is completed with the `EndDataConfiguration` method and the synchronization triggered again with the task `DatasourceTask`.

The `ReleaseData` method is used in the same way for deactivating the variable again at the desired processing time.

### Using remote data

The variables that are listed in the data source editor of the “Variables” tab (and declared in the “DataSources_Objects” folder) can be used in your application like IEC variables. For example, you can visualize the variables.

If multiple data sources are available and therefore conflicts occur regarding unique variable names, then you must specify the data source name as the prefix. If no conflicts occur, then this is not necessary and you can map the variables without a data source prefix.

```
<data source name>.<function block name>.<variable name>
```

### Displaying variable values from the remote device

You need to show the variable value `iTemp` of a remote device in a visualization element of a visualization in the local application (with the data source manager).

Initial situation: A data source `dsRemotePLC` is below the local data source manager where the connection to the remote device is configured. In addition, the variable `iTemp` is selected in the data source editor of the “Variables” tab.

1. Select the visualization element in the editor view. Select the properties “Text variables”-“Text variable” in the “Properties” view.
2. Select the `iTemp` variable.
   ⇒ The variable mapping is qualified. Example: `dsRemotePLC.PLC_PRG.iTemp`.
3. Select the “Text” property of the visualization element and type in the following:
   `Temperature: %s`
   ⇒ The value of the `iTemp` variable from the remote device `RemoteDevice` is displayed.
4. Download and start the remote application.
5. Download and start the local application.
   ⇒ The visualization starts and displays the actual value of `iTemp`. 
NOTICE!
The visualization integrated in CODESYS does not display actual values of variables that are transferred by means of a data source connection. The integrated visualization displays only the initialization values or the last otherwise delivered values because they do not establish a connection to the data sources.

NOTICE!
If variables are used that are not called in the visualization code, then the variables must be updated in the application code by means of functions from the data source interface.

Data Source OPC UA Client

Establishing the Connection of a Data Source OPC UA Client to an OPC UA Server

Requirement:
- An OPC UA Server is available. For a description of the OPC UA Server which is included in the standard installation CODESYS, see the chapter "OPC UA Server". 
  Chapter 6.3.6.2 “OPC UA server for AC500 V3 products” on page 1787
- You have installed the CODESYS Security Agent add-on in CODESYS.
- CODESYS is open.
- The “Allow anonymous login” option is selected for your controller in the “Change Communication Policy” dialog of the device editor (“Communication Settings” tab, “Change Communication Policy” command, “Device” menu). Or the user management has been explicitly disabled (for example, by switching to “Optional user management” in the “Change Communication Policy” dialog and then “Reset Origin”).

1. Start the OPC UA Server.
2. Create a new CODESYS project.
3. Add a “Data Source Manager” object to the application.
4. Add a “Data Source” “OPC UA-Client” to the “Data Source Manager”.
   The “Initialize Data Source” dialog opens.
5. In the “Initialize Data Source” dialog, configure the data source for communication in the following.

With the option “Read Connection Settings from IEC Variable” option, you can dynamically configure the connection settings instead of defining them here in the dialog. For more information, see: Using a Dynamic Connection to an OPC UA Server

- Chapter 6.4.1.21.2.6.6 “Tab ‘Communication’ via OPC UA Server” on page 2424
- Chapter 6.4.1.10.6.7.3 “Using a Dynamic Connection to an OPC UA Server” on page 1963

The settings from this dialog are reflected accordingly on the Communication tab of the data source manager:

- For “Where to find the server layout”, define how the information about the existing variables and types should be detected. When you select the “Browse Live Server” option, the OPC UA Client connects to the OPC UA Server for this purpose and reads the information there. When you select “From Information Model”, the client reads the same information from an installed information model and does not require a running OPC UA Server to do this.
- Click the [Show All Endpoints] button to open the “Available Endpoints” dialog.
- Select an endpoint which defines an “Encrypt & Sign” message security mode and a corresponding security strategy. After the dialog is closed, these settings are transferred to the “Security” section of the “Initialize Data Source” dialog.
- Choose a suitable “Client certificate” to access the server for browsing purposes. If a certificate is not available for selection yet, then you can have one generated immediately. To do this, click the button to open the “Generate self-signed certificate” dialog. Define a password for your private key and a file name for the certificate. When you click [OK], the certificate is generated and automatically entered into the certificate store. The *.cer and *.pfx certificate files are stored with the project file. As a result, you can "give" the certificate with the public key (*.cer) to the server so that it "knows" the certificate. You can also share the private key (*.pfx) to make the project usable on another machine (for browsing).

Note that this certificate can be used only for browsing the server for variables and data types. An additional certificate is required for data exchange in online mode. Its creation is described below.

6. Click “Next”. Now the client scans the OPC UA Server to find the variables and types of the OPC UA Server. The OPC UA Server has to be online to do this.

7. Now select one or more variables.

These variables can be exchanged later via encrypted communication between the OPC UA Client and the OPC UA Server. For the variables, components are created in the “Devices” view, in the “DataSources_Objects” folder. The variables can be used in the application.

8. In the next steps, you create a certificate for the encrypted communication from the OPC UA Client to the OPC UA Server.

9. Click “View ➔ Security Screen”.

10. Switch to the “Devices” tab.

11. In the view on the left, select the controller.

In the right view, all services of the controller are displayed which require a certificate.

12. Select the service “CmpOPCUAClient”.

13. Create a new certificate for the device. To do this, click the icon.

The “Certificate Settings” dialog opens.
14. Define the certificate parameters and click “OK” to close the dialog.
   ⇨ The certificate is created on the controller.

15. Click the button and save the certificate to the local file directory of the OPC UA Server, in the folder certs.
   ⇨ Now when you restart the OPC UA Server, it will recognize the client certificate. The server sends its certificate to the client. In the following steps, this certificate will be made "trusted" to the client.

16. To do this, in the “Security Screen” view, on the “Devices” tab, click the “Certificates in Quarantine” folder in the left area.
   ⇨ The certificate is displayed in the right area.

17. Drag this certificate to the “Trusted Certificates” folder.
   ⇨ Now the server certificate is "trusted" by the client.

18. Now when you connect to the controller and the application starts, the data source variables of the OPC UA Client can be exchanged with the OPC UA Server via the encrypted connection.

See also
- ☉ Chapter 6.4.1.21.2.6.6 “Tab ‘Communication’ via OPC UA Server” on page 2424

Error Messages

Error 8448  
Message: Identity mismatch
Typical error cause: The application information on the target device and the HMI to not match.
Correction: A new download should be done on the HMI to update the application information.

Error 8449  
Message: Login failed
Typical error cause
- The communication settings are incorrect.
- The user name or password is not correct.
Correction: Check the communication settings for the target device. Make sure that the user name and password are correct.

Error 8450  
Message: Login necessary
Typical error cause: There is no connection to the controller.
Correction: Check the communication settings for the target device. Make sure that the user name and password are correct.

Error 8452  
Message: The device cannot be reached.
Typical error cause
- The device is switched off.
- The communication settings are incorrect.
- The network connection does not work.
Correction: Make sure that the target device is switched on. Check the communication settings and the network connection to the target device.
Using a Dynamic Connection to an OPC UA Server

The settings for the communication of an OPC UA Client data source to an OPC UA Server can be dynamically configured from the IEC code and can also be changed at runtime. For this purpose, a structure is available in the DatasourceOpcUAServer library.

When using this kind of "dynamic connection", at runtime, for example, the server URL can be changed again if the device is located in a different network than at the time of configuration. It can also be used to configure detailed settings on the OPC UA connection.

**Requirement**

- You have created an OPC UA Client data source in the CODESYS project. For more information, see: Establishing the Connection of a Data Source OPC UA Client to an OPC UA Server.

  © Chapter 6.4.1.10.6.7 “Data Source OPC UA Client” on page 1960

1. On the “Communication” tab of the data source, now select the “Read Connection Settings from IEC Variable” option.
2. In static memory (for example, in a GVL or in a program in your project), create a variable of type DatasourceOpcUaServer.UserConfigurationV1.

**Example:** config variable in the PLC_PRG program

```plaintext
PROGRAM PLC_PRG
VAR
  config : DatasourceOpcUaServer.UserConfigurationV1 := (  
    SessionName := 'MyCustomSession',
    EndpointUrl := 'opc.tcp://DevXY:4840',
    SecurityPolicyUri := DatasourceOpcUaServer.CmpOpcUaStack_Interfaces.OpcUa_SecurityPolicy_None);
  value : INT;
END_VAR
```

**Error 8453**

Message: The device name is not unique.

Typical error cause: Multiple devices with the same name were found in the target system.

Correction: Make sure that the target device has a unique name.

**Error 8454**

Message: No symbols available

Typical error cause: Either no application has been downloaded to the target device, or an application with another symbol configuration.

Correction: Make sure that the application is downloaded with the correct symbol configuration to the target device.

**Error 8457**

Message: The connection is denied due to no resources.

Typical error cause: All available communication channels of the target device are used.
3. In the input field below the “Read Connection Settings from IEC Variable” option, reference the variable created in step 2:

Example: PLC_PRG.config

Now at any time you can fill the fields of this UserConfigurationV1 structure with values. For example, this can be done when starting the controller, from a configuration file, or from a visualization dialog.

When filling the structure with setting values, the following applies:

- The EndpointUrl setting always has to be defined.
- All other settings can be assigned as desired. They allow, for example, the use of a different security mode than in the usual editor. Some settings, which are not available in the editor, can also be configured on the OPC-UA connection.

When all connection settings are configured, you can set the xValid parameter of the UserkonfigurationV1 to TRUE.

Example: In the implementation part of PLC_PRG:

```plaintext
config.SubscriptionPublishingInterval := config.SamplingInterval := TIME#2S;
config.xValid := TRUE;
```

Then the data source starts to establish the connection in the next cycle.

Changes to the settings while a connection is established have no effect and are only applied the next time a new connection is established.

When the xValid setting is set to FALSE, the data source automatically disconnects from the server and the settings can be changed again.

In the documentation view of the DatasourceOpcUAServer library, you can see an overview of the currently available setting parameters of the structure and their default values in the library manager. New versions of the data sources might provide new options.

---

6.4.1.10.7 Subordinate safety controller

If a safety controller is below the standard controller, then the communication with the development system and the data exchange run via the standard controller. The communication links of the safety controller can interrupted the execution of commands that affect the standard controller. You find a notice about this for each these command.

Possible interruptions

- Temporary interruption: During the execution of the command (for example: download), the connections with the safety controller are interrupted first and then are automatically available again afterwards. If the interruption time is too long, then safety-oriented reactions can occur in the output devices and connected network variable receiver safety controllers. Then in the safety controller, the corresponding communication errors must be acknowledged (if not done automatically) in order to end the safety-oriented reactions. This affects the connection to their field devices and network variable receiver connections to other sender safety controllers. In the case of a connected safety controller with network variable senders, the communication errors must be acknowledged in the other safety controllers.

- Permanent interruption: The execution of commands (for example: delete) leads to an interruption that is ended again by another action (for example: download). As a result of the interruption, safety-oriented reactions can occur in the output devices and connected network variable receiver safety controllers. After ending the interruption, the corresponding communication errors must be acknowledged in the safety controller (if not done automatically) in order to end the safety-oriented reactions.

For a subordinate safety controller, the routing runs via “<Name of SafetyApp>_Mapping”. In some cases, it can happen that the user can see this application in the device tree.
6.4.11 Downloading an Application to the PLC

6.4.11.1 General

The multi download tool can be used to update multiple PLCs with firmware or an application at the same time.

* Chapter 6.6.4 "Multi download tool" on page 4306

In order to transfer your application to the PLC, the program has to be compiled without any errors and the connection settings for the PLC have to be set.

* Chapter 6.4.11.4 “Handling of Device User Management” on page 1971
* Chapter 6.4.1.9.18 “Protecting an application” on page 1915

You can edit the basic security policy for communication with the device in a dialog on the “Communication Settings” tab of the device editor. See here:

* Chapter 6.4.1.11.3 “Encrypting Communication, Changing Security Settings” on page 1967

When these requirements are fulfilled, the application is downloaded to the PLC at login.

6.4.11.2 Configuring the Connection to the PLC

The connection to the controller is established by means of a gateway. This gateway can be your development computer or another network computer connected to the controller. The “Communication Settings” dialog is available for configuring the connection path. This dialog opens automatically when you attempt to log in, but the communication settings have not been configured yet.
If the communication with the controller is encrypted and secured by means of user management, then you need a corresponding certificate and credentials to establish the connection to the controller. In this case, see the relevant instructions on the "Encrypting communication and Changing Security Settings" help page.

Requirement: The project can be compiled without any errors. A programmable logic controller (PLC) is inserted in the device tree. The use of a user management is required for the device, but it is not enabled.

1. In the device tree, select the PLC and click “Project ➔ Edit Object”.
   – The PLC opens in the editor.
2. Click the “Communication Settings” tab.
3. On the menu bar, click “Scan Network”.
   – The “Select Device” dialog opens. All available devices in the network are shown on the left side.
4. Select the desired device and click “OK”.
   – A dialog prompt is displayed with the notice that a user management is required for the device, but it is not enabled yet. You are prompted to enable the user management if you want. The notice is displayed that in this case you have to create a new administrator account and then log in as this user.
5. Click “Yes” to close the dialog prompt.
   – The “Add Device User” dialog opens to create an initial device administrator.
6. Define the credentials (“Name” and “Password”) for the device administrator. Select the “Password can be changed by the user” option.
   
   **NOTICE!**
   
   Remember the seriousness of the password: From within the development system, there is no way to access the controller again if you forget the password.

   Click “OK” to close the dialog.
   – The “Device User Logon” dialog opens.
7. Enter the credentials for the device administrator which you defined in the previous step.
   – The connection path for the PLC is set.

You can reset the communication settings view to the original view in the CODESYS options of the device editor.

See also

- % Chapter 6.4.1.11.3 “Encrypting Communication, Changing Security Settings” on page 1967
- % Chapter 6.4.1.21.2.8.3 “Tab 'Communication Settings'” on page 2427
- % Chapter 6.4.1.21.4.14.7 “Dialog 'Options' - 'Device Editor'” on page 2786
6.4.1.11.3 Encrypting Communication, Changing Security Settings

![NOTICE! Recommendations for data protection](image)

In order to minimize the risk of data security violations, we recommend the following organizational and technical actions for the system where your applications are running. Whenever possible, avoid exposing the PLC and control networks to open networks and the Internet. Use additional data link layers for protection, such as a VPN for remote access. Install firewall mechanisms. Restrict access to authorized persons. Use high-strength passwords. Change any default passwords regularly before and after commissioning.

Use the security features supported by CODESYS and the respective controller, such as encryption of communication with the controller and intentionally restricted user access.

Communication with the device can be protected by means of encryption and user management on the device. You can change the current security preset on the “Communication Settings” tab of the device editor.

Establishing a connection to the controller, logging in, installing a trusted certificate for encrypted communication

- Requirement: Encrypted communication with the controller and user management are enforced on the controller. However, an individual password does not exist yet. A certificate has not been installed on your computer and the connection to the controller has not been configured yet.

1. In the device tree, double-click the controller.
   - The device editor opens.
2. Click the “Communication Settings” tab.
3. Click “Scan Network”.

---

2024/01/05 3ADR010583, 1, en_US 1967
4. Select a controller.
   ⇒ A dialog opens, informing you that the certificate of the device does not have a trusted signature for communication. You are prompted whether or not to install this certificate as trusted in the local "Controller Certificates" store on your computer, or accept a session only for this one.

   NOTICE!
   A controller certificate installed in this way is valid for only 30 days.
   This gives you time for the following long-term solutions:
   - Creation of an additional self-signed certificate with a longer term (for example, 365 days). You can do this on the security screen if you have installed the CODESYS Security Agent, even if a certificate already exists. Using the PLC shell of the device editor is not a convenient workaround. See below: "Configuring encrypted communication with a controller certificate with a more long-term validity period"
   - Importing a CA-signed certificate. This is currently only possible via the PLC shell commands of the runtime. Therefore, we recommend to use self-signed certificates first.

5. If you want to install the certificate, then select the first option and click "OK" to confirm the dialog prompt.
   ⇒ The certificate is listed as trusted. After accepting the self-signed certificate for the first time, you can establish an encrypted connection with the controller again and again without further prompts.
   A dialog prompt is displayed with the notice that a user management is required for the device, but it is not enabled yet. You are prompted to enable the user management if you want. The notice is displayed that in this case you have to create a new administrator account and then log in as this user.

6. Click "Yes" to close the dialog prompt.
   ⇒ The "Add Device User" dialog opens to create an initial device administrator.

7. Create a device user in order to edit the user management as this user. In this case, only the "Administrator" group is available. Specify a "Name" and "Password" for the user. The password strength is displayed. Note also the set options regarding a password change. By default, the password can be changed by the user at any time. Click "OK" to confirm.
   ⇒ The "Device User Logon" dialog opens.

8. Enter the credentials for the device administrator which you defined in the previous step.
   ⇒ You are logged in on the controller. On the "Users and Groups" tab, you can use the button to switch to synchronized mode. The device user management is displayed there and you can edit it.
   After you click "OK" to confirm, the device user management is displayed in the editor view. It contains the user of the "Administrator" group who you just defined. The name of this user is also displayed in the taskbar of the window as "Device User".

9. All saved controller certificates (from Step 5) are stored in the local Windows Certificate Store on your computer. You can access this memory by means of the "Execute", certmgr.msc command.
   ⇒ All registered certificates for encrypted communication with controllers are listed here in "Controller Certificates".

---

**Configuring a controller certificate with a more long-term validity period**

Requirement: The CODESYS Security Agent add-on product is installed. You want to replace the temporary certificate (as described above) acquired the first time you connected to the protected controller with a certificate with a longer validity period.
In this case, the “Security Screen” view provides an additional tab: “Devices”. This allows for the simple configuration of certificates for the encrypted communication with controllers. For operation, see the help for CODESYS Security Agent: “Encrypted Communication with Devices via Controller Certificates”.

Choose this less convenient method when the CODESYS Security Agent is unavailable to you. In this case, you can set up a certificate with a more long-term validity period for communication encryption on the “PLC Shell” tab of the device editor.

☑ Requirement: You are connected to the controller.

1. At first, you check if a qualified certificate is already on the controller. If no certificate is available, then you create a new certificate.

Open the device editor by double-clicking the controller in the device tree, and select the “PLC Shell” tab.

⇒ The tab appears with a blank display window. Below that is a command line.

2. Type the following command in the command line: cert-getapplist.

⇒ All used certificates are listed. The list includes information about the runtime component and whether or not the certificate is available.

3. If a certificate still does not exist for the component CmpSecureChannel, then type the following command in the input line:

   cert-genselfsigned <number of the component in the applist>

4. Click the “Log” tab and then the refresh button (✓).

⇒ The display shows whether or not the certificate was generated successfully.

5. Change back again to the “PLC Shell” tab and type the command cert-getapplist.

⇒ The new certificate for the component CmpSecureChannel is displayed.

6. In the next two steps, activate encrypted communication in the security screen of CODESYS.

7. Open the “Security Screen” by double-clicking 🛡️ in the status bar.

8. On the “User” tab, select the “Enforce encrypted communication” option in the “Security Level” group.

⇒ The communication to all controllers is encrypted. If there is not a certificate on a controller, then you cannot log in to it.

   The connecting line between the development system, the gateway, and the controller is displayed in yellow on the “Communication Settings” tab of the device editor of the controller.

9. As an alternative to the “Enforce encrypted communication” option which applies to all controllers, you can also define encrypted communication for specific controllers only. To do this, select the “Communication Settings” tab in the editor of the respective controller. Then click “Encrypted Communication” in the “Device” list box.

⇒ The communication with this controller is encrypted. If there is not a certificate on the controller, then you cannot log in to it.

   The connecting line between the development system, the gateway, and the controller is displayed in yellow on the “Communication Settings” tab of the device editor of the controller.
10. When you log in to the controller for the first time, a dialog opens with information that the certificate of the controller is not signed by a trustworthy authority. In addition, the dialog displays information about the certificate and prompts you to install it as a trustworthy certificate in the local store in the “Controller Certificates” folder. When you confirm the dialog, the certificate is installed in the local store and you are logged in to the controller. In the future, communication with the controller will be encrypted automatically with this control certificate.

11. To increase security for key exchange for controllers < V3.5 13.0, you can generate Diffie-Hellman parameters on the controller. To do this, type the command `cert-gendhparams` in the input line. This is no longer required for controllers >= V3.5.13.0.

**NOTICE!**

Caution: Generating the Diffie-Hellman parameters can last for several minutes or even several hours. However, this process must be executed only one time for each controller. The Diffie-Hellman parameters increase security for key exchange and for future attacks against encrypted data recording.

---

### Changing the communication policy (encryption, user management)

- **Requirement:** The connection to the device is established.
- **1.** In the device tree, double-click the controller.
  - The device editor opens.
- **2.** Click the “Communication Settings” tab.
- **3.** Open the “Device” menu in the header of the editor. Click “Change Communication Policy”.
  - The “Change Communication Policy” dialog opens.
- **4.** In the upper part of the dialog, you can toggle between the “Optional encryption”, “Enforced encryption”, and “No encryption” settings.
- **5.** In the lower part of the dialog, you can toggle between the “Optional user management” and “Enforced user management” settings.

### Enabling and disabling enforced encrypted communication

- **Requirement:** The device supports encrypted communication.
- **1.** In the device tree, double-click the controller.
  - The device editor opens.
- **2.** Click the “Communication Settings” tab.
3. Open the “Device” menu in the header of the editor. Click “Encrypted Communication”. The status toggles between enabled and disabled.

⇒ If the “Encrypted communication” option is selected, then the connection line between the development system, the gateway, and the device is highlighted in the editor in bold and in color in the graphical representation.

See also

- Chapter 6.4.11.4 “Handling of Device User Management” on page 1971
- “Encryption with certificates” on page 1820

### 6.4.11.4 Handling of Device User Management

**NOTICE!**

**Recommendations for data protection**

In order to minimize the risk of data security violations, we recommend the following organizational and technical actions for the system where your applications are running. Whenever possible, avoid exposing the PLC and control networks to open networks and the Internet. Use additional data link layers for protection, such as a VPN for remote access. Install firewall mechanisms. Restrict access to authorized persons. Use high-strength passwords. Change any default passwords regularly before and after commissioning.

Use the security features supported by CODESYS and the respective controller, such as encryption of communication with the controller and intentionally restricted user access.

For devices that support a device user management, the device editor includes the “Users and Groups” tab and the “Access Rights”. When offered by the device, you can view the user management for the device here as well as edit it in synchronization mode (not in online mode). Here, you can grant or deny specific permissions on the controller to the defined user groups.

The device user management can already be set up in the device description.

**Note the commands in the “Online ➔ Security” menu. You can easily add, edit, or remove a user account on the controller where you are currently logged in.**

**In order for the “Access Rights” tab to be available in the device editor, the corresponding CODESYS option must be selected in the device editor and unlocked in the device description. If the device editor is not available, then contact the manufacturer of the controller.**

In order to grant access rights to a user group, first the users and user groups have to be configured on the “Users and Groups” tab of the device editor. User management first has to be set up on the controller before access rights can be configured on it. In case the user management of a device is not enabled yet, it can be enabled in the following way: Either by switching to the synchronized mode on the “Users and Groups” tab, or by adding a new user by means of the command “Online ➔ Security ➔ Add Device User”.
For the CODESYS Control devices, a user management is enforced by default.

Access rights can be granted to groups only, not individual users. Therefore every user has to be a member of a group.

Access rights can be granted for the following actions which are executed on the individual objects of the controller:

- Add/Remove
- Modify
- View
- Execute

An object on the controller is usually assigned to just one controller component.

Each object can use all of the listed actions, but usually only the permissions for the following actions are needed on an object:

- "View"
- "Modify"

The objects are organized in a tree structure. There are two root objects for the two kinds of objects:

- "Runtime objects ➔ Device": In these objects, all objects are managed that have online access in the controller and therefore have to control the access rights.
- "File system objects ➔ /": In these objects, the permissions can be granted to folders of the current execution directory of the controller.

The child objects inherit the access rights from the root object (also "Device" or "/"). If a permission of a user group is denied or explicitly granted to a parent object, then this affects all child objects.

A single permission can be explicitly granted or denied (green plus sign or red minus sign), or remain "neutral" (light gray character). Neutral means that the permission has been neither explicitly granted nor denied. In this case, the permission of the parent object applies.

If no permission has been explicitly granted or denied in the entire hierarchy of the object, then it is by definition denied. As a result, all permissions are initially denied (exception: the access right for the "View" action). Initially, this permission is explicitly granted for every user group both on the "Device" runtime object as well as on the "/" file system object. This allows read access to all objects, unless it is explicitly denied in child objects.

For an overview table for the objects, see the "Tab 'Access Rights'" chapter.

See the following instructions for handling the editor for the device user management:

1. Double-click the controller device object in the device tree.
   ➞ The device editor opens.

2. Click the "Users and Groups" tab.

3. Click 🏷️.
   ➞ A dialog opens prompting whether the device user management should be activated.

4. Click "Yes" to acknowledge the dialog prompt.
   ➞ The "Add Device User" dialog opens.
5. Now create a device user in order to edit the user management as this user. In this case, only the “Administrator” group is available. Specify a “Name” and “Password” for the user. The password strength is displayed. Note also the set options regarding a password change. By default, the password can be changed by the user at any time. Click “OK” to confirm.

⇒ The “Device User Logon” dialog opens.

6. Specify a “User name” and “Password” for the user who you just defined.

⇒ After you click “OK” to confirm, the device user management is displayed in the editor view. It contains the user of the administrator group who you just defined. The name of this user is also displayed in the taskbar of the window as “Device User”.

**Setting up a new user in the user management of the controller**

Requirement: The controller has a device user management. You have the corresponding access data.

1. Double-click the controller device object in the device tree.

⇒ The device editor opens.

2. Click the “Users and Groups” tab.

3. Click (Synchronization) to load the user management configuration from the controller to the editor. If you are not logged in to the device yet, then the “Device User Logon” dialog opens for entering the user name and password.

⇒ The user management configuration of the device is shown in the editor.

4. In the “Users” view, click “Add”.

⇒ The “Add User” dialog opens.

5. Specify the name of the new user and assign the user to a group. This counts as the user's minimum required default group. The user can be assigned to other groups later. Define and confirm a “Password” for the user. Define whether the user can change the password and whether the user has to change the password at the first login. Click “OK” to confirm.

⇒ The new user appears in the “Users” view as a new node and in the “Groups” view as a new subentry of the selected default group.

**Changing of access rights to controller objects in the user management of the controller**

Requirement: The controller has a device user management. You have the corresponding access data.

1. Double-click the controller device object in the device tree.

⇒ The device editor opens.

2. Click the “Access Rights” tab.
3. Click (Synchronization) to load the rights management configuration from the controller to the editor. If you are not logged in to the device yet, then the “Device User Logon” dialog opens for entering the access data.

⇒ The access rights management configuration of the device is shown in the editor.

4. Select the object whose access right you want to change to the left in the object tree.

⇒ In the “Rights” view, a table shows the access rights to this object for all configured user groups.

5. Double-click the right in the table that you want to change.

⇒ If the object has child objects, then a dialog prompts whether you want to modify the permissions for the child objects.

6. Click “Yes” or “No” to close the prompt.

⇒ The permissions are switched from "allowed" to "not allowed", or the other way around. The symbol in the table cell changes accordingly. Explicitly set permissions appear in the table as green or red symbols. Rights that are inherited from a parent object appear as gray symbols.

1. Double-click the controller device object in the device tree.

⇒ The device editor opens.

2. Click the “Users and Groups” tab.

3. Click （）.

⇒ The dialog for selecting a file from the local file system opens.

4. Select the file (*.dum2) with the desired user management from the local file system and click “Open” to confirm.

⇒ The “Enter Password” dialog opens.
5. Specify the password that was assigned when the user management file was exported (possible by means of the button).  
**CAUTION:** The import of a device user management by means of a *.dum2 file completely overwrites the existing user management on the device. In order to log in to the device again afterwards, you need authentication data from the recently imported user management.

⇒ When the password is entered correctly, the configuration from the downloaded user management file is now displayed in the editor view.

6. Edit the configuration however you like. For example, change the user password or add a new user.

⇒ Every change is downloaded immediately to the device.

**See also**

- Chapter 6.4.1.21.2.8.15 “Tab 'Access Rights’” on page 2453
- Chapter 6.4.1.21.4.14.7 “Dialog 'Options' - 'Device Editor’” on page 2786
- Chapter 6.4.1.21.2.8.14 “Tab 'Users and Groups’” on page 2450
- Chapter 6.4.1.8.2 “Configuring Devices and I/O Mapping” on page 1836
- Chapter 6.4.1.11.3 “Encrypting Communication, Changing Security Settings” on page 1967

**Configuring the password policy and login lock**

You can configure a password policy and login lock for the runtime system. Using these two mechanisms makes sure that the credentials configured for the controller are as secure as possible and that attackers cannot guess the credential by repeated attempts. By default, a password policy is not enabled. The login lock is enabled by default for the administrator user group because this user group needs to fulfill increased security criteria and should also be better protected. When the maximum number of login attempts has been exceeded, the user will be locked out for the configured amount of time (3600 seconds by default).

**Unlocking a locked user**

The following options are available for unlocking a user who has been locked for a specific period of time:

- An administrator or a member of a user group with write permission for the user group of the locked user assigns a new password for the user.
- The runtime system is restarted.

1. In the device tree, double-click the controller.

⇒ The device editor opens. The “Communication Settings” tab is displayed.

2. In the header, click the “Scan Network” button, and in the “Select Device” dialog, select the desired device. Then click “OK”.

⇒ The active path to the controller is set.

3. In the “Device” menu, select “Change Runtime System Password Policy”.

4. In the “Change Runtime System Password Policy” dialog, select the “Password policy is active” option.

⇒ The password policy with the displayed password settings is enabled.

⇒ The detailed default password settings can be found in the description of the dialog.

5. Change individual password settings as needed.

6. Click “OK” to confirm the changes made.

⇒ The configured password policy is immediately applied when creating a new user and when changing the password for an existing user. Only new passwords which fulfill the password policy can be created.
1. In the device tree, double-click the controller.
   ➔ The device editor opens. The “Communication Settings” tab is displayed.

2. In the header, click the “Scan Network” button, and in the “Select Device” dialog, select the desired device. Then click “OK”.
   ➔ The active path to the controller is set.

3. In the “Device” menu, select “Change Runtime System Password Policy”.

4. In the “Change Runtime System Password Policy” dialog, you can change the default settings for the login lock or disable the login lock.

5. Click “OK” to confirm the changes made.
   ➔ The configured login lock is immediately applied when logging in to the device user management for users of the user group selected in the “Scope”.
   ➔ When the number of login attempts specified in the “Maximal Retries” field is exceeded, the user will be locked out for the amount of time which is specified in the “Lock duration” field.

6.4.11.5 Generating Application Code

The application code is the machine code that a PLC executes when you start an application. CODESYS automatically generates the application code from the source code that was written in the development system. This is done automatically before downloading the application to the PLC. Before the application code is generated, a test is performed for checking the allocations, the data types, and the availability of libraries. Moreover, the memory addresses are allocated when the application code is generated.

You can click “Build ➔ Generate Code” to execute this command explicitly. This is useful for detecting any errors in your source code, even when the PLC is not connected yet. The errors are output in the message view in the “Build” category.

NOTICE!
If you have encrypted the application, then consider the following information: If a (new) boot application is generated on request after an online change, then the boot application is formed in the RAM with the current code that is not encrypted.

Explicitly generating the application code

Requirement: The application can be compiled without any errors.

➢ Click “Build ➔ Generate Code”.
   ➔ The application code is generated. Detailed information about memory allocation is output in the message view.

See also

● § Chapter 6.4.11.7 “Generating boot applications” on page 1978
● § Chapter 6.4.1.21.3.6.1 “Command ‘Generate Code’” on page 2618

Messages when generating the application code

When you generate the application code, CODESYS outputs information about memory allocation in the message view. Gaps form in the memory because reallocation is only for new and changed POUs and variables due to the incremental memory build. Online changes have the same effect. This fragmentation reduces the amount of available memory. However, you can completely reallocate the memory by clicking “Clean” and therefore increase the amount of free memory.
Syntax errors and bugs that CODESYS detects during the code generation and memory allocation are also output in the message view ("Build" category).

Output information about memory allocation:

- "Size of the generated code" (in bytes): Sum of all code segments
- "Size of global data" (in bytes): Total memory used by the global variables. Inputs and outputs are not included unless inputs or outputs are mapped in the area of the global variables.
- "Total allocated memory size for code and data" (in bytes): The total allocated memory is composed of the already used memory areas plus the reserved, not yet used memory for incremental builds and online changes. After the first build, the already used memory is approximately equal to the highest used address (see below). The largest contiguous memory gap (see below) still corresponds approximately to the difference to the total allocated memory. However, as the number of incremental builds and online changes increases, the number of memory gaps also increases, and the largest contiguous memory gap becomes smaller.
- "Memory area <n>": Contents of the individual reserved memory areas

Background: It depends on the PLC which data and code is stored in which memory areas. For example, code and data are located in the same area on the CODESYS Control Win V3. For the addresses %I, %M, and %Q, memory is always reserved, even when a variable is not assigned to an address. After cleaning the application, the memory is reallocated completely. In this case, small gaps could result from the predefined alignment (normally 8). Larger gaps result from changing a date without cleaning, for example by increasing an array area. In this case, only the affected POU's are recompiled. Furthermore, in the case of an online change, the memory is used only for new variables and new code. Memory that was previously reserved by deleted variables and code is made available again. As a result, memory fragmentation can occur after many incremental builds and online changes. This creates many small gaps that might not be usable at all in some cases. To clarify how much memory is safely available, the "largest contiguous memory gap" of the memory area is output during code generation.

- "highest used address" (Byte): This is the highest reserved address in the entire allocated memory area. During the first build after a "Clean" operation, the memory addresses are output to variables in ascending order, taking into consideration the alignment (usually 8 bytes). As a result, the highest address used at this time corresponds approximately to the amount of memory used. The rest of the allocated memory area is still completely available for incremental builds and online changes.

- "Largest contiguous memory gap" (in bytes): This is the memory size that is available for backup. Resulting gaps in the allocated memory are reused whenever possible for other changes. When, for example, a global variable of type Byte is added, it is placed in the first free byte of the memory. Even just a small gap is enough for this. However, an FB instance, a variable of the type structure or array, or the code for a POU has to be stored contiguously and therefore occupies more memory accordingly. As a result, they can be allocated only to the largest contiguous memory area. This is why during code generation the "largest contiguous memory gap" that is safely available is output (in bytes), as well as its percentage of the total memory.

Note the options for generating applications.

See also

- Chapter 6.4.1.21.4.11.10 "Dialog 'Properties - Application Build Options'" on page 2759

Encrypting the application code

See also

- Chapter 6.4.1.9.18 “Protecting an application” on page 1915

6.4.11.6 Downloading the application code, logging in, and starting the PLC

In order to download the source code of your application to the PLC, you must log in to the PLC with application. If there are several applications in the project, then you must switch explicitly to the correct application first.
When you download an application to the PLC, CODESYS performs the following checks:

The list of applications on the PLC is compared with the applications available in the project. If they do not match, then you are prompted to download the application that is not on the PLC yet or delete existing applications.

For "externally implemented" blocks in the application to be downloaded, CODESYS checks whether these are available on the PLC. If they are not available, then the message "unresolved reference(s)" is printed to a dialog prompt and to the message view. Then CODESYS compares the parameters (variables) of the blocks in the application to be downloaded and the parameters of the same-named blocks in the application that exists on the PLC (signature check). If there are any discrepancies, then the message "invalid signature(s)" is printed to a dialog prompt and to the message view.

If the "Download Application Info" check box is selected in the application properties, then additional information about the application contents are downloaded to the PLC.

If multiple applications exist for the same device, then notice that the "I/O Mapping" dialog contains the definition for which of the applications is used for the I/O mapping of the device.

See also

- Chapter 6.4.1.21.2.2 “Object ´Application´” on page 2410

**Transferring an application and starting the program**

Requirement: The application contains no errors and the communication settings of the PLC are correct. The application does not exist yet on the PLC: The application and the communication with the controller are not encrypted.

1. Select the required application in the device tree. Skip to Step 3 if you have only one application.
2. Click “Set Active Application”.
   - The application name appears in bold typeface.
3. Click “Online ➔ Login”.
   - A dialog prompts you whether the application should be created on the PLC.
4. Click “Yes” to confirm.
   - The application is downloaded to the PLC.
5. Click “Debug ➔ Start” or press the [F5] key.
   - The application is running on the controller.

**6.4.11.7 Generating boot applications**

A boot application is the application that is started automatically when the controller is switched on or started. For this to happen, the application on the controller must exist as a file `<application name>.app`.

For each application that is running on the controller, a boot application can also be saved there.

By default, CODESYS generates the boot application automatically when an application is downloaded and transfers them to the PLC. The defaults for generating automatically are located in the “Boot application” category of the application “Properties”. When logging in with a changed application, you are still prompted whether or not to generate a new boot application.

In addition, you can create a (new) boot application at any time in online mode by clicking “Online ➔ Create boot application”.

You can create and save a local copy of a boot application in offline mode as well. Then, you can copy this application to the controller with external tools. In this way, you transfer an application to the controller, even when there is no connection to CODESYS.
Generating boot applications on the controller automatically and explicitly

Requirement: Offline mode; the application is compiled without errors. The connection to the controller is configured and the controller is running. The application is active. The following steps demonstrate the options:

1. Click “Online ➔ Login”.
   ⇒ The boot application file `application name`.app is created on the controller with the checksum of the boot application `application name`.crc.

2. Click “Online ➔ Create Boot Application” explicitly.
   ⇒ The files on the controller are replaced by new files.

3. Log out.

4. Change the application. Log back in to the controller.
   ⇒ You are prompted whether an online change should be performed. You see the “Update boot application” check box in the same dialog box. This is cleared by default, but this can be changed in the “Boot Application” category of the application “Properties”.

5. Keep the check box cleared and continue login.
   ⇒ A new boot application file is not created.

   ⇒ The boot application that was created above is running on the controller.

You can save the encrypted boot application on the controller. These settings are defined in the “Application Build Options” category of the application “Properties”.

See also
- § Chapter 6.4.1.21.4.11.10 “Dialog ‘Properties - Application Build Options’” on page 2759
- § Chapter 6.4.1.21.4.11.3 “Dialog ‘Properties’ - ‘Boot Application’” on page 2754
- § Chapter 6.4.1.14.2 “Executing the online change” on page 2025
- § Chapter 6.4.1.21.3.7.4 “Command ‘Create Boot Application’” on page 2627

Creating boot applications in offline mode

Requirement: Offline mode; the application is compiled without errors. You want to generate a boot application for an application and save it in the file directory for copying it later to the controller by using external tools (without CODESYS).

1. Click “Online ➔ Create Boot Application”.
   ⇒ A dialog box opens for specifying a save location in the local file system.

2. Click a save path and then click “Save”.

3. If the application has changed since the last boot application was generated, then you are prompted to use a new code for the boot application. In this case, click “Yes”.
   ⇒ The “Save as” dialog box opens.

4. Select a directory and click “Save”.
   ⇒ The boot application file `application name`.app is created in the given path.

You are prompted whether or not the build information for the boot application is saved.
5. Click “Yes”.

⇒ The build information is saved to the project directory as a file named `<application name>.compileinfo`. It is a requirement for a possible online change the next time the application is updated. Please note: Clicking “Build ➔ Clean” deletes this file.

See also

- § Chapter 6.4.1.21.3.7.4 “Command ‘Create Boot Application’” on page 2627

6.4.11.8 Downloading source code to and from the PLC

The source code of an AC500 V3 project can be downloaded to a V3 PLC memory. At a later point in time, this project can be uploaded and restored directly from the PLC without the engineering PC being required for this § Chapter 6.3.5.3 “Source download/upload” on page 1751.

6.4.12 Testing and Debugging

6.4.12.1 General

CODESYS provides various options for testing your application and detecting errors. You can start your application in simulation mode, even without connecting any hardware. Using breakpoints and stepping commands, you can examine specific parts of a program. By writing values to variables, you can influence the running program.

Commands are provided that reset your application in various different ways, from resetting only non-persistent variables to completely resetting the controller to factory settings.

See also

- § Chapter 6.4.1.12.3 “Using Breakpoints” on page 1981
- § Chapter 6.4.1.12.4 “Stepping Through a Program” on page 1985
- § Chapter 6.4.1.12.6 “Resetting applications” on page 1990

6.4.12.2 Testing in simulation mode

Use simulation mode for testing and debugging your program when you do not have a physical target device. In this mode, the application is started on a simulated device.

The command is available only when you are logged out.

Requirement: You program contains no errors (compiler error messages or compile errors) and you are not logged in.

1. Activate simulation mode as follows:

- Click “Online ➔ Simulation”, or
- Right-click the controller in the device tree and click “Simulation”.

⇒ The name of the controller in the device tree is displayed in italics. In the status line, “Simulation” appears highlighted in red. The “Simulation” command is selected in the main menu.

2. Click “Online ➔ Login”.

3. When logging in with the active application, you will be prompted whether the application "Sim.<device name>,<application name>" should be created and loaded. Click “Yes” to confirm.

⇒ The application is logged onto the PLC.

4. Now you can check and correct the program flow with the commands provided in the main menu in “Debug”.

5. Log out from the controller and end the simulation mode.
See also

- Chapter 6.4.1.21.3.7.23 “Command ‘Simulation’” on page 2640

Limitations

- The focus of the simulation mode is testing and debugging your program of the PLC. That means the functionality of the simulated PLC is limited. Keep in mind that some POUs have no function. They are not creating any compile or download errors, they will simply not work.
- Without an extra available “Virtual Commissioning” license the “Online mode” of the simulated PLC is limited to 2 hours. After 2 hours starting from the “Login”, the “Online mode” is automatically terminated and the PLC is logged out.
- It is not possible to create a “Boot Application” in the simulated PLC. Every “Login” starts with an empty simulated PLC and a download of the application is required.
- When logging in to a simulated PLC the first time a “Windows Security Alert” is displayed. Depending on the application, e.g. if any network communication is implemented, it might be necessary to allow the “Virtual AC500” to communicate on one or multiple network types.

6.4.12.3 Using Breakpoints

Breakpoints are commonly used for debugging programs. CODESYS supports breakpoints in all IEC editors.

You can set breakpoints at specific positions in the program to force an execution stop and to monitor variable values. You can set special data breakpoints to halt program execution when the value of a specific variable changes.

The halt at a breakpoint or data breakpoint can be linked to additional conditions. You can also redefine breakpoints and data breakpoints as execution points where specific code is executed instead of stopping the program.

The “Breakpoints” view provides an overview of all defined breakpoints. It also includes additional commands for processing batch changes to multiple breakpoints.

In the editor, the following symbols identify the status of a breakpoint or execution point:

- The breakpoint is enabled.
- The breakpoint is disabled.
- Breakpoint is set in another instance of the POU open in the editor.
- The program is halted at the breakpoint.
- The conditional breakpoint is enabled.
- The conditional breakpoint is disabled.
- The execution point is enabled.
- The execution point is disabled.
- The conditional execution point is enabled.
- The conditional execution point is disabled.
- The data breakpoint is enabled.
- The data breakpoint is disabled.
- Halt at data breakpoint
- The data execution point is enabled.
- The data execution point is disabled.
- Halt at data execution point
- The conditional data execution point is enabled.
- The conditional data breakpoint is enabled.

See also

- Chapter 6.4.1.21.3.4.12 “Command ‘Breakpoints’” on page 2586
The function of data breakpoints depends on the target system. Currently, data breakpoints are possible only with the CODESYS Control Win V3.

Program execution stops at a data breakpoint when the value of a particular variable or memory address changes. As with ordinary breakpoints, the halt can be linked to an additional condition, or specific code can be processed instead of the halt (converted to a data execution point).

You set a data breakpoint either by means of the “New Data Breakpoint” command in the “Debug” menu or by means of the “New” button in the “Breakpoints” view. You specify a qualified variable name or a memory address directly which is to be monitored for changes in its value.

In the following sample code, the memory of the variable iNumber is overwritten unintentionally. However, a data breakpoint at the variable iNumber will detect when its value changes. The processing then stops with a corresponding message at the array access, which overwrites the variable value: Idx = 7. See also below: “Setting a data breakpoint”.

```
PROGRAM PLC_PRG
VAR
  Idx : INT;
  Ary : ARRAY[0..3] OF BYTE;
  iNumber : INT := 55;
END_VAR
FOR idx := 0 TO 6 DO
  Ary[idx] := 0;
END_FOR
```

Basically, debugging is not possible for multiple tasks at the same time. While you are working on a task with breakpoints or stepping, breakpoints are ignored in other tasks.

If a POU containing a breakpoint is used by multiple tasks, then only the debug task is halted because it reaches the breakpoint first. All other tasks continue. The “Call Stack” dialog shows which task is currently halted.

If you need a breakpoint to affect only one specific task, then you can define this in the breakpoint properties.

Breakpoints operate separately for each application so that a "HALT ON BP" does not affect any other applications. This applies also to parent/child applications, even if the breakpoint is set in a block that is used by several applications and whose code is located only once on the PLC.

**NOTICE!**

The I/Os that are called by the debug task are not updated at a halt in the breakpoint, even if you select the "Refresh I/Os in Stop" check box in the PLC settings.

If the application stops at a breakpoint on the PLC, then an online change or download causes all tasks to halt which means the PLC will stop. In this case, CODESYS prompts you whether or not to continue with the login.

See also
- Chapter 6.4.1.21.3.4.15 “Command ‘Call Stack’” on page 2590
Setting a single breakpoint (example in ST editor)

Requirement: The application is in online mode and running. The operating mode is “Debug”.

1. In the editor, open a POU programmed in structured text (ST).
2. Place the cursor in the line where a breakpoint will be set.
3. Click “Debug ➔ Toggle Breakpoint” or press [F9].
   ➔ The line is marked in red and identified by the “breakpoint enabled” symbol (●). If the program is halted at the breakpoint, then the line is marked by the “stop at breakpoint” symbol (●). The processing of the program is stopped. This is identified in the status line by the HALT ON BP status highlighted in red.
4. Click “Debug ➔ Start” or press [F5].
   ➔ The program continues.
5. Set more breakpoints and check the variable values at the break position.
6. Place the cursor in the line where a breakpoint should be removed.
7. Click “Debug ➔ Toggle Breakpoint” or press [F9].
   ➔ The marking disappears. The breakpoint is deleted.

See also
● Chapter 6.4.1.21.3.8.9 “Command ‘Toggle Breakpoint’” on page 2646

Defining a breakpoint condition (example in ST editor)

1. In the editor, open a POU programmed in structured text (ST).
2. Place the cursor in the line where a breakpoint will be set.
3. Click “Debug ➔ New Breakpoint”.
   ➔ The “Breakpoint Properties” dialog opens.
4. Click the “Condition” tab.
5. Click “Break when the hit count is a multiple of” in the “Hit Count” list box.
   Specify the value “5” in the field to the right.
6. In addition, you can define a Boolean condition for when the breakpoint should be active. Select the “Break, when true” check box. Specify a Boolean variable in the text field to the right.
7. Select the “Enable breakpoint immediately” check box.
8. Close the dialog.
   ➔ The line is marked red and identified by the “conditional breakpoint enabled” symbol (●)

Monitor the running program. As long as the Boolean variable for the condition is FALSE, the breakpoint condition is not fulfilled and the program continues to run. If you set the variable to TRUE, then the condition is fulfilled and the program halts at the breakpoint every 5th pass.

See also
● Chapter 6.4.1.21.4.6 “Dialog ‘Breakpoint Properties’” on page 2747
Defining an execution point (example in ST editor)

1. In the editor, open a POU programmed in structured text (ST).
2. Place the cursor at the position for an execution point.
3. Click “Debug ➤ New Breakpoint”.
   ➤ The “Breakpoint Properties” dialog opens.
4. Click the “Execution Point Settings” tab.
5. Select the “Execution point” option.
   In the “Execute the following code” field, type the following statement: iCounter := iCounter + 1;
   In the “Print a message in the device log” field, type the following text: Execution point reached {iCounter}
6. Close the dialog.

When the program reaches the execution point, it does not halt, but executes the code defined above. In addition, a message is issued to the device log.

See also
● Chapter 6.4.1.21.4.6 “Dialog ‘Breakpoint Properties’” on page 2747

Setting a data breakpoint

Requirement: The application is in online mode and running.

1. Click “View ➤ Breakpoints”.
2. Click “Debug ➤ New Data Breakpoint”.
3. Click the button in the “New breakpoint” dialog (“Data” tab).
4. In the “Input assistant” dialog (“Watch Variables” tab), select the variables for which the program should halt when changed.
   As an alternative, specify the qualified name of the variable on the “Data” tab directly in the input line. Example: PLC_PRG.iNumber. The exact number of bytes to be monitored is specified as the “Size”. A value that corresponds to the data type is set here automatically by default. You can also specify fewer bytes to be monitored.
5. In the “Breakpoints” view, select the line with the data breakpoint and click the button.
   ➤ The line is marked and identified by the “Data breakpoint enabled” symbol (●). When the program reaches the data breakpoint (meaning when the value of the selected variables changes), the program processing halts. In the implementation part of the POU, the next line is identified by an arrow ●. This is identified in the status line by the HALT ON BP status highlighted in red.
6. Click “Debug ➤ Start” or press [F5].
   ➤ The program continues running and halts again when the value of the variables changes again.

See also
● Chapter 6.4.1.21.4.6 “Dialog ‘Breakpoint Properties’” on page 2747
6.4.12.4 Stepping Through a Program

You can step through an application and navigate the code. This is useful to check the status of your code at runtime. You can examine the call process, track variable values, or locate errors.

Stepping commands are provided in the “Debug” menu for this purpose. The commands become available when you set breakpoints in online mode and then halt execution at a breakpoint: the application is in “HALT ON BP” state (debug mode). During debug mode, the current break position is highlighted in yellow and marked with the symbol in the text editors.

Switching to debug mode

1. Download your application to a controller.
   ➤ The application is highlighted in green. CODESYS and the editors of the POUs are in online mode.

2. In the POUs, set breakpoints at the locations in the code that you want to examine.
   ➤ All breakpoints are listed in the “Breakpoints” view.

3. Start the application.
   ➤ The application starts and the code is processed until the first breakpoint.

   Now the application is in debug mode. In the device tree, the application is labeled with “[halt on breakpoint]”. The status bar provides information about the operating state:

   ![Device Tree](image)

   The editor was opened at the current break position. The line of code with an active breakpoint where program execution was halted is highlighted in yellow and marked by the symbol. This statement highlighted in yellow has not been executed yet.

   ![Code Highlight](image)

   Now you can select the various stepping commands or display the call tree.
Alternatively, you can first start the application and then set a breakpoint.

Behavior of the stepping command in the 'Debug' menu

- Command “Step Over”
  The statement at the breakpoint position is executed. Program execution halts before the next statement in the POU.
  If the statement contains a call (from a program, function block instance, function, method, or action), then the subordinate POU is processed completely in one step.

- Command “Step Into”
  The statement at the breakpoint position is executed. Program execution halts before the next statement.
  If the statement contains a call (from a program, function block instance, function, method, or action), then the program execution jumps to this subordinate POU. The first statement there is executed and the program execution halts before the next statement. The new current breakpoint position is then in the called POU.

- Command “Step Out”
  The command executes the POU from the current breakpoint position to the end of the POU and then jumps back to the calling POU. Program execution halts at the calling position (in the line with the call).
  If the current breakpoint position is in the main program, then the POU is run through to the end. Then the program execution jumps back to the beginning (to the program start at the first line of code in the POU) and halts there.

- Command “Run to Cursor”
  First set the cursor at any line of code and then execute the command. The program is executed from the current breakpoint position and halts at the current cursor position without executing the code of this line.

- Command “Set Next Statement”
  First set the cursor at any line of code (also before the current breakpoint position) and then execute the command. The statement marked with the cursor is executed next. All statements in between are ignored and skipped.

- Command “Show Next Statement”
  If you do not see the current breakpoint position, then execute the command. Then the window with the current breakpoint position comes into focus and the breakpoint position is visible.

Click “View Call Stack” to completely show the previous call tree for the breakpoint position currently reached in the program processing.

The “Call Stack” view shows the location of the block in the call structure of the program at all times, even before compiling the application.

See also

- Chapter 6.4.1.21.3.8.11 “Command ‘Step Into’” on page 2647
- Chapter 6.4.1.21.3.8.10 “Command ‘Step Over’” on page 2646
- Chapter 6.4.1.21.3.8.12 “Command ‘Step Out’” on page 2647
- Chapter 6.4.1.21.3.8.13 “Command ‘Run to Cursor’” on page 2648
- Chapter 6.4.1.21.3.8.14 “Command ‘Set Next Statement’” on page 2648
- Chapter 6.4.1.21.3.8.15 “Command ‘Show Next Statement’” on page 2648
- Chapter 6.4.1.21.3.4.16 “Command ‘Call tree’” on page 2590
6.4.12.5 Forcing and Writing of Variables

CAUTION!
Unusual changes to variable values in an application currently running on the controller can lead to undesired behavior of the controlled machinery. Evaluate possible dangers before forcing variable values. Take the respective safety precautions. Depending on the controlled machinery, the result may lead to damage to machinery and equipment or injury to health and life of personnel.

In CODESYS, variable values in the PLC can be changed in online mode. Here we make a distinction between forcing and writing a previously prepared value.

Writing is done with the “Write Values” command ([Ctrl]+[F7]) and sets the variable to the prepared value one time. In this way, the value can be overwritten again by the program at any time.

Forcing is done with the “Force Values” command ([F7]) and sets the prepared value permanently. For more information, see below.

The preparation of a value for forcing or writing is possible at different places:
- Declaration part: “Prepared value” field
- Implementation part of the FBD/LD/IL editor: inline monitoring field
- Watch view: “Prepared value” field

For instructions about this, see below. In the case that you want to prepare a value again for an already forced value, the “Prepare Value” dialog opens with options for handling the current force value.

Functionality of forcing

The prepared value is set to the respective variable at the beginning and end of a task cycle (or of a processing loop in the case of other task types).

The processing order in each cycle of a task is as follows:
1. Read the inputs
2. Force: Before the first program call, all prepared values are written to the variables by the runtime system, regardless of whether or not they are used by the task.
3. Process the IEC code
4. Force: After the last program call, all prepared values are written to the variables by the runtime system, regardless of whether or not they are used by the task.
5. Write the outputs

Note: It is possible that a forced variable temporarily gets a different value in the cycle while the code is being processed because the IEC code performs an assignment. Then the variable receives the forced value again only at the end of the cycle. The variable value can also be overwritten by the write access of a client to symbols of the application in mid-cycle. For this case, see the “Access variables in sync with IEC tasks” option in the “Properties” of the device object, or the “Configure synchronization with IEC tasks” setting in the symbol configuration. In this way, a PLC handler-supported synchronization of the write accesses by clients can be enabled with the task cycle.
NOTICE!
Forced values are marked with the symbol. CODESYS does the forcing until the user lifts it explicitly by one of the following actions:

- Executing the “Cancel forcing for all values” command
- Lifting the force operation in the “Prepare Value” dialog
- Logging out of the application

If forced variables still exist when logging out, then a dialog opens, prompting whether or not forcing should be lifted for all variables. If you respond by clicking “No”, then the forced values are applied again at the next login.

See also
- Chapter 6.4.1.9.17 “Task Configuration” on page 1914
- Chapter 6.4.1.21.4.11.20 “Dialog ‘Properties’ - ‘Options’” on page 2765
- “Setting: Configure synchronization with IEC tasks” on page 2527

**Forcing in the declaration part**

Requirement: Your application includes a POU with declarations. The application is in online mode.

1. Open the POU in the editor by choosing the command “Project ➔ Edit Object”.
2. In the declaration part of the editor, double-click in column (1) “Prepared Value” of a variable.
   - The field can be edited and a value can be entered. When it is a Boolean value, you change the value by clicking in the field.

3. Perform Step 2 for other variables.
4. Click “Debug ➔ Force Values”.
   - The variable values are overwritten with the prepared values. The values are marked with the symbol.
Forcing in the implementation part

Requirement: The application is in online mode.

1. Open the POU in the editor by choosing the command “Project ➤ Edit Object”.
2. In the implementation part of the editor, double-click an inline monitoring field (1).
   ➤ The “Prepare Value” dialog opens.
3. Enter the new value in the field “Prepare a new value for the next write or force operation”.
   ➤ The prepared value appears in the inline monitoring field.
4. Click “Debug ➤ Force Values”.
   ➤ The value of the variables is overwritten with the prepared values. The values are marked with the symbol.

Viewing and editing all forced variables one list

Requirement: The application is in online mode. Multiple variables are forced.

1. Click “View ➤ Watch ➤ Watch all Forces”.
   ➤ The “Watch all Forces” view opens. It contains all currently forced variables of the application in the form of a watch list.
2. Select all lines in the list and click “Unforce ➤ Unforce and Keep All Selected Values” in the list box in the upper left part of the view.
   ➤ The variables are unforced and they get the values that they had before forcing.

Forcing a function block input in CFC

Requirement: An application has a CFC POU that contains a function block, and the application is in offline mode.

NOTICE!

This kind of forcing uses a data breakpoint internally and is therefore different from forcing with the “Force Values” command or [F7].

Values that were forced by the command “Force FB Input” do not respond to the commands “Show All Forces” or “Unforce Values.”
1. Open the editor of the CFC POU by double-clicking the object in the tree.
2. When using compiler version 3.5.11.x or 3.5.12.x, enable the "forceability" for the desired function block. Select the POU element in CFC and click "CFC ➔ Prepare Box for Forcing".
3. Log in to the application on the target device. In CFC, select the input of the POU and click "Force Function Block Input" in the context menu.
   ➔ The "Force Value" dialog opens.
4. Set a new value for the input. Example in the case of a TON POU: FALSE for the Boolean input IN, or t#4s for the PT input (TIME). Click "OK" to confirm.
   ➔ The set value is forced immediately. A green circle is displayed at the upper left of the POU element and the name of the input in the element is highlighted in green. In the case of a Boolean value, a small monitoring view with the value also opens at the input. In the monitoring views, the forced value is displayed, for example in the "Value" column, as in the declaration part.
5. To remove the forced value, click "Force Function Block Input" again. In the "Force Value" dialog, select the "Remove value" option.
   ➔ Forcing is canceled. The input gets the current value from the controller.

See also
● Chapter 6.4.1.21.3.13.34 “Command 'Prepare Box for Forcing'” on page 2697
● Chapter 6.4.1.21.3.13.35 “Command 'Force Function Block Input'” on page 2697
● Chapter 6.4.1.21.4.8 "Dialog Box 'Prepare Value'” on page 2749
● Chapter 6.4.1.21.3.8.16 “Command 'Force Values'” on page 2649
● Chapter 6.4.1.21.3.8.18 “Command 'Unforce Values'” on page 2650
● Chapter 6.4.1.21.3.8.17 “Command 'Write Values'” on page 2649
● Chapter 6.4.1.13.2.3 “Using watch lists” on page 2002

6.4.1.12.6 Resetting applications
Resetting the application stops the program and resets the variables to their initialization values. Depending on the type of reset, retain variables and persistent variables are also reset.

● Reset warm: All variables are reset, except RETAIN and PERSISTENT variables.
● Reset cold: All variables are reset, except PERSISTENT variables.
● Reset origin: All variables are reset.
● Reset origin device: All variables are reset and all applications are deleted.

The following sample program and statements clarify the functionality of the various resets.

See also
● “Lifespan of variables when calling online commands” on page 1922
Example
Declaration

VAR
  iVar: INT := 0;
END_VAR
VAR RETAIN
  iVarRetain: INT := 0;
END_VAR
VAR PERSISTENT
  iVarPersistent: INT := 0;
END_VAR

Implementation

iVar := 100;
iVarRetain := 200;
iVarPersistent := 300;

1. Insert the “Persistent Variables” object below the application and open it in the editor.
2. Click “Build ➔ Build”.
3. Click “Declare ➔ Add All Instance Paths”.
   ⇒ The instance path of the persistent variables is inserted.
4. Download the application to the controller.

Executing a "Reset warm", "Reset cold", and "Reset origin"

Requirement: The sample program runs on the controller.

1. Click “Online ➔ Login” to switch to online mode.
2. Monitor the variables iVar, iVarRetain, and iVarPersistent.
3. Click “Online ➔ Reset Warm”.
   ⇒ You are prompted whether you really want to execute the command.
4. Click “Yes” to confirm the dialog.
   ⇒ The application is reset. The iVar variable is set to the initialization value 0. Both of
   the other variables retain their values.
5. Click “Online ➔ Reset Cold”.
   ⇒ You are prompted whether you really want to execute the command.
6. Click “Yes” to confirm the dialog.
   ⇒ The application is reset. The iVar and iVarRetain variables are set to the initialization
   value 0. The iVarPersistent variable retains its value.
7. Click “Online ➔ Reset Origin”.
   ⇒ You are prompted whether you really want to execute the command.
8. Click “Yes” to confirm the dialog.
   ⇒ The application is reset. All variables are reset to their initialization values.
6.4.1.12.7 Flow Control

With flow control, you can monitor the processing of the application program. Flow control is provided for the ST, FBD, LD, and CFC language editors.

With an activated flow control, CODESYS displays the variable values and results from function calls and operations at the respective processing location and time. In this way, the exact lines of code and networks that process the current cycle are marked in colors. Compare this to standard monitoring, in which CODESYS delivers only the value that a variable has between two processing cycles.

Flow control works in all parts of the editor view that are currently visible. “Flow control enabled” is then displayed in the status line as long as the function is active and flow control positions (processed parts of code) are visible in an editor view.

You can write values in the declaration part and implementation part. Forcing is not possible.

**NOTICE!**

Values are written at the end of the current cycle.

**NOTICE!**

When you enable flow control, the cycle time of the application is prolonged.

When “Confirmed Online Mode” is selected in the communication settings, a dialog prompt appears when switching on the flow control to cancel the operation.

When flow control is enabled, it is not possible to use breakpoints or step through the program.

See also

- Chapter 6.4.1.21.2.8.3 “Tab ’Communication Settings’” on page 2427
- Chapter 6.4.1.21.3.8.22 “Command ’Flow Control’” on page 2652

By default, CODESYS displays the flow control positions of the processed parts of code as green fields. Unprocessed parts of code are displayed in white.

*Note that the displayed value of an unprocessed code position is an ordinary monitoring value. This is the value between two task cycles.*
In network editors, CODESYS marks the processed networks with bars on the left edge in the flow control color.

In LD, CODESYS displays the currently processed connecting lines in green and all others in gray. The actual value of the connection is also displayed: TRUE by a bold blue line, FALSE by a bold black line, and unknown or analog values by thin black lines. Combinations of these lines are displayed as dashed lines.

In IL, for each statement CODESYS uses two fields for the display of the actual values. One is located to the left of the operator with the current accumulator value, and one is located to the right of the operand with the operand value.
### 6.4.12.8 Determining the current processing position with the call stack

You can use the call stack for determining the current position of the program flow. This function is very useful when stepping into programs.

**Requirement:** The application is in online mode. The program is halted at a breakpoint or you are stepping into it.

- Open the call stack by clicking **View → Call Stack**.

  The call stack opens. The list shows the current location with the complete call path.

The call stack is also available in offline mode and normal online mode (without using debugging functions). In this case, it receives the last displayed location during a stepped execution, but it is displayed in gray.

**See also**

- Chapter 6.4.1.21.3.4.15 “Command ‘Call Stack’” on page 2590
- Chapter 6.4.1.12.4 “Stepping Through a Program” on page 1985

### 6.4.12.9 Checking the Task Deployment

The Tab **Task Deployment** of the device editor indicates in an overview the tasks that process the individual inputs and outputs of the I/O mapping of your application and the priority with which they do so. You can check here whether an unintentional overwriting of values is caused, which can lead to undefined values.
1. Generate code for the application: to do this select, for example, the command “Build ➔ Generate Code”.

2. Open the device editor by double-clicking on the device object in the device tree. Select the “Task Deployment” tab.

   ⇒ You obtain a display of the inputs and outputs of your application and the assignment of the tasks and their priorities. See the description of the “Task Deployment” tab for details.

See also

- % Chapter 6.4.1.21.2.8.18 “Tab ‘Task deployment’” on page 2459
- % “General information about I/O mapping” on page 1836

6.4.1.13 Application at Runtime

6.4.1.13.1 General

When the application is running on the PLC, in the CODESYS Development System there are some features for monitoring and changing the values of the variables as well as for recording and storing the value charts.

Furthermore, you can poll some information from the PLC, you can have a look into the PLC-log, display a core dump and monitor the time behavior of the tasks.

Regard also the possibility to restrict the access on the running application in critical states of the machine via online commands provided by CODESYS Development System. For this purpose some system variables are available in a module of the ComponentManager library.

6.4.1.13.2 Monitoring of Values

General

In runtime mode, you can monitor the current variable values of a programming object at different places in a project. The following is what we refer to as monitoring:

- Online view of the programming editor of an object: inline monitoring
- Online view of the declaration editor of an object
- Object-independent, configurable watchlists

When you set the (attribute ‘monitoring’...) pragma, you can monitor the results from function calls and the current variable values in property-type objects.

More options for recording current variable values:

- Read and save recipes
- Record values on a timeline for displaying the history immediately or later: trace and trend features
See also
- Chapter 6.4.1.20.6.3.26 “Attribute ‘monitoring’” on page 2295
- Chapter 6.4.1.13.2.3 “Using watch lists” on page 2002
- Chapter 6.4.1.13.2.4 “Changing Values with Recipes” on page 2003
- Chapter 6.4.1.13.3 “Data Recording with Trace” on page 2007
- Chapter 6.4.1.13.4 “Data Recording with Trend” on page 2016

Calling of monitoring in programming objects

When an application is running on the controller, the actual values of variables are displayed in the editors of the POUs. This is how the values of variables are monitored.

- Requirement: The “Enable inline monitoring” option is activated in “Tools ➔ Options” in the “Text Editor” category on the “Monitoring” tab.

1. Download an application to the controller and start it.
2. Click “Debug ➔ Display Mode ➔ Decimal”.
   - The display format of the actual values is set.
3. Click a programming object in the “Devices” view or “POUs” view.
   - The respective editor opens. Actual values of the variables are refreshed continually for both the declaration and implementation.

Monitoring in the declaration editor

The actual value of an expression (1) is displayed in the “Value” column (3).
You can write and force a value in the “Prepared Value” (4) column. During the forcing, the actual value is decorated with a red symbol (📸).
The expression of an interface reference can be expanded. If the interface points to a global instance, then this global instance is displayed as the first entry below the reference. Afterwards, if the interface reference changes, then the displayed reference is collapsed.

Monitoring in the implementation (inline monitoring)

Inline monitoring is the display of the current variable value in the implementation.
Depending on the implementation language, the following displays are possible in the implementation part:
- Variables have a window with the current value displayed after their name: nResult2
  - If you have prepared values for variables for forcing or writing, then they are displayed in angle brackets in the inline monitoring view after the current value.
  - After forcing, the respective values are identified by the 📸 symbol.
- Network editors and the CFC editor:
  - Connecting lines are displayed in color according to their actual Boolean value (blue means TRUE, black means FALSE).
● LD editor:
The contact and coil elements are also marked.
For contacts and coils, a prepared value (TRUE or FALSE) is shown in a small view next to the element.

● SFC editor:
Transitions with the value TRUE are displayed in color according to their actual Boolean value (blue means TRUE, black means FALSE).
Active steps are displayed in blue.
Forced transition values are displayed in red in the implementation.

● IL tabular editor:
Current values are displayed in a separate column.
You can deactivate the inline monitoring function in “Tools ➔ Options”, in the “Text Editor” category on the “Monitoring” tab.

See also

- % Chapter 6.4.1.20.1.4.1 “ST Editor” on page 2049
- % Chapter 6.4.1.20.1.4.2 “ST editor in online mode” on page 2050
- % Chapter 6.4.1.20.1.6.2 “FBD/LD/IL editor in online mode” on page 2086
- % Chapter 6.4.1.20.1.5.2 “SFC Editor in Online Mode” on page 2063
- % Chapter 6.4.1.20.1.7.5 “CFC Editor in Online Mode” on page 2103

Partial monitoring of an array

An expanded array shows the actual values for up to 1000 elements. However, this can be confusing. In addition, an array can contain more than 1000 elements. Then it is helpful to limit the range of displayed elements. You can do this in online mode in the following way.

☐ Requirement: An application is running. It contains a multidimensional array variable with more than 1000 elements. Example:

```
arrBig : ARRAY [0..100, -9..10, -19..20] OF INT;
```

1. Click in the field of the “Data Type” column for the `arrBig` variable.
   ➤ The “Monitoring Range” dialog opens.

2. Specify the value `[1, -9, -19]` for “Start”.

3. Specify the value `[1, 10, 20]` for “End”.
   ➤ The actual values of 800 array elements are displayed in the declaration editor. The range is limited to the elements of the index `[1, <i>, <j>]` with i from -9 to 10 and j from -19 to 20.

See also

- % Chapter 6.4.1.20.1.2 “Declaration Editor” on page 2047
- % Chapter 6.4.1.12.5 “Forcing and Writing of Variables” on page 1987
- % Chapter 6.4.1.21.4.10 “Dialog ‘Monitoring Range’” on page 2752

Limiting the monitoring range

Monitoring a function block

When you double-click the editor view of a function block in online mode, a dialog opens where you can choose between viewing the basic implementation or a specific instance.

If you select the basic implementation, then the code is displayed in the editor without current values. Now set a breakpoint in the basic implementation. If the execution halts there, then the current values of the instance that is processed first in the program flow are displayed. Now you can step successively through all instances.

If you select one of the instances, then the editor opens with the code of the function block instance. The current values are displayed in the declaration and, if applicable, in the implementation, and are updated continuously.

See also

- % Chapter 6.4.1.21.2.21.3 “Object ‘Function Block’” on page 2479
- % Chapter 6.4.1.12.3 “Using Breakpoints” on page 1981

Monitoring a property

You can monitor variables in a property object by setting a breakpoint in the function during online mode. When halted there, the current values are displayed.

In addition to your own values, the values of the variables of the superordinate instance are displayed automatically. In the declaration part of the property, the `THIS` pointer, which points to the superordinate instance, appears in the first line with the current data type information and values.
FUNCTION_BLOCK FB_BaseAlfa
VAR
  iBaseLocal : INT;
  sBaseLocal : STRING;
END_VAR
iBaseLocal := iBaseLocal + 1;
sBaseLocal := 'Testing Text';

FB_BaseAlfa.PorpBeta.Get
iBaseLocal := iBaseLocal + 1;
IF iBaseLocal > 0 THEN
  PropBeta := TRUE;
END_IF

FB_BaseAlfa.PorpBeta.Set
IF PropBeta = TRUE THEN
  iBaseLocal := 0;
  sBaseLocal := 'Tested IF';
END_IF

PROGRAM PLC_PRG
VAR
  fb_BaseAlfa : FB_BaseAlfa;
END_VAR

fb_BaseAlfa();

IF fb_BaseAlfa.PorpBeta = TRUE THEN
  xResult := TRUE;
END_IF
IF xReset THEN
  fb_BaseAlfa.PorpBeta := TRUE;
  xReset := FALSE;
END_IF

See also
- Chapter 6.4.1.21.2.21.9 “Object ’Property’” on page 2493
Monitoring of property access in the superordinate programming object

You can monitor the values of subordinate properties in a function block or program in addition to the variable values.

To do this, add either the pragma `{attribute 'monitoring' = 'variable'}` or `{attribute 'monitoring' = 'call'}` to the subordinate property object in the declaration. If you open the superordinate program instance or function block instance at runtime, then the current property values are displayed in the editor in addition to the current variable values.

See also

- Chapter 6.4.1.21.21.9 “Object ‘Property’” on page 2493
- Chapter 6.4.1.20.6.3.26 “Attribute ‘monitoring’” on page 2295

Monitoring a method

You can monitor variables in a method object by setting a breakpoint in the method during online mode. When halted there, the current values are displayed.

In addition to your own values, the values of the variables of the superordinate instance are displayed automatically. In the declaration part of the method, the `THIS` pointer, which points to the superordinate instance, appears in the first line with the current data type information and values.
FUNCTION_BLOCK FB_BaseAlfa
VAR
   iBaseLocal : INT;
   sBaseLocal : STRING;
END_VAR
iBaseLocal := iBaseLocal + 1;
sBaseLocal := 'Testing Text';

METHOD MethBaseAlfa : BOOL // Method of FB_BaseAlfa
VAR_INPUT
END_VAR
VAR
   iMethLocal : INT;
END_VAR
iMethLocal := iMethLocal + 1;

PROGRAM PLC_PRG
VAR
   fb_BaseAlfa : FB_BaseAlfa;
END_VAR
fb_BaseAlfa();
fb_BaseAlfa.MethBaseAlfa();

See also
- Chapter 6.4.1.21.2.21.9 “Object ‘Property’” on page 2493
- Chapter 6.4.1.21.2.21.6 “Object ‘Method’” on page 2485

Monitoring a function
You can monitor variables in a function object by setting a breakpoint in the function during online mode. When halted there, the current values are displayed.

Monitoring the return value of a function call
In the ST editor of a POU, the current return value is displayed as inline monitoring at the position of the POU where a function is called.

The following conditions must be fulfilled:
- The value can be interpreted as a 4-byte numeric value. Example: INT, SINT, or LINT.
- The pragma (attribute 'monitoring' := 'call') is inserted into the function.
Using watch lists

What is a watch list?

A watch list is a user-defined list of project variables that are collected in one view for the purpose of monitoring their values. In online mode, you can write and force variable values in a watch list. Monitoring, writing, and forcing are handled the same way as the declaration editor in online mode. You can customize the format of the representation of floating-point values in the options for monitoring.

There are four, ready-to-use watch lists (Watch <n>) available in a project. Click “View ➔ Watch”.

Information:

If the expression is an interface reference, then it can be expanded. If the interface points to a global instance, then this global instance is displayed as the first entry below the reference. If the interface reference changes, then the displayed reference is collapsed.

Creating and editing a watch list (offline or online mode)

Requirement: The project is in either online or offline mode. It includes an application with declared variables that you want added to one of the four possible watch lists.

1. Click “View ➔ Watch ➔ Watch <n>”.
   ⇒ The Watch <n> view opens. It contains a blank table row.

2. Double-click the field in the “Expression” column and type a variable to monitor, either manually or with the input assistant.
   Syntax: <device name>.<application name>.<object name>.<variable name>
   Example: "Dev1.Appl.PLC_PRG.ivar"
   If you type the name of a structured variable, then the individual components are displayed automatically in other lines in online mode.

3. Define all successive variables that will be monitored with this list. You can change the order by using drag and drop operations.
   ⇒ The “Execution point”, “Type”, “Address”, “Comment” fields are filled in automatically according to the variables declaration. The symbol before the expression indicates the type of variable: input variable (✓), output variable (✓), or ordinary variable (✓).

In online mode, you can also create or edit watch lists by right-clicking and choosing the “Add Watch” command.

See also

● Chapter 6.4.1.20.1.2 “Declaration Editor” on page 2047
● Chapter 6.4.1.21.4.19 “Dialog ‘Options’ - ‘Monitoring” on page 2792
Requirement: A project is open and running. It includes an application with declared variables that you want added to a possible watch list.

1. Click “View ➔ Watch <n>” to open the watch list.
2. Place the cursor on a variable in the declaration or implementation part of a POU and right-click to choose the “Add Watch” command.
   ⇒ This adds an entry to the list for the selected variable.
3. You can add other variables in this way or by typing directly into the list in the “Expression” field as described above.
   ⇒ The watch lists are updated immediately.

If a watch list is not open when you click “Add Watch” for a variable, then it is added automatically to the “Watch 1” list.

Writing and forcing variable values is also possible in the watch lists. In online mode, the “Prepared value” column is also available.

See also
- § Chapter 6.4.1.21.3.23.1 “Command ‘Add Watch’” on page 2743
- § Chapter 6.4.1.13.2.2 “Calling of monitoring in programming objects ” on page 1996
- § Chapter 6.4.1.12.5 “Forcing and Writing of Variables” on page 1987

Changing Values with Recipes

Use recipes to change or read recipes values for a specific set of variables (recipe definition) on the controller at the same time.

You define the basic settings for recipes, such as location and format, in the “Recipe Manager” object. Insert one or more recipe definitions below this object. A recipe definition is composed of one or more recipes for the contained variable. The recipe consists of specific variable values.

You can save a recipe to a file or write directly from files to the PLC.

Recipes can be loaded via the CODESYS development interface, the visualization element, or the application program.

Using recipes on remote devices

The variable values from recipes are transferred automatically to and from another controller when they are data source variables and a data source exchange is configured. Reading and writing occurs synchronously. Therefore, CODESYS updates all variables in a recipe at the same time. After reading or writing, you can use the call g_RecipeManager.LastError to check whether or not the transfer was successful (g_RecipeManager.LastError = 0).
Calling recipe commands in the CODESYS user interface

The development interface of CODESYS provides commands for generating recipes as well as reading/writing in online mode.

See also

- Chapter 6.4.1.21.3.20 “Menu ‘Recipes’” on page 2723

Calling recipe commands programmatically or in a visualization

At runtime, the recipe definition and the recipe commands can be called in the application program. To do this, you implement the process for writing, reading, or monitoring recipe definitions in your code by using the methods of the `RecipeManCommands` function block from the `RecipeManagement` library.

In the visualization, the call of the recipe commands is implemented by using the for a visualization element. By doing this, a visualization user can control the execution of recipe commands.

**During the initialization process, the recipe management reads the values of the variables that are defined in the recipe definition. This operation takes place at the end of the initialization phase of the application. At this point, all initial values of the application variables are set. This is done to initialize missing values from recipe files correctly.**

See also

- `RecipeManCommands`
- `Input Configuration`

Special functionality for floating-point numbers

For variables of type `REAL` or `LREAL`, a distinction is made whether or not the value is exactly convertible.

- If it is possible to convert the value exactly, then only the numerical value is saved in the recipe file.
- If exact conversion is not possible, then a hexadecimal encoded string is written in the recipe file next to the numeric value. This should have the effect that also a non-convertible floating-point number returns the same value.

This feature can be disabled with the `RECIPE_GENERATE_SIMPLE_STRINGREAL` compiler define.

**In the object properties of the parent application under “Build”, you can enter this `RECIPE_GENERATE_SIMPLE_STRINGREAL` compiler define in the “Compiler Defines” option. As a result, no hexadecimal encoded string is stored.**

For more information, see: Dialog: Properties: Build
Creating a recipe

1. In the device tree, select the “Application” object.
2. Click “Project → Add Object → Recipe Manager”.
   ⇒ The Recipe Manager is added to the device tree.
3. In the device tree, click the “Recipe Manager” object.
4. Click “Project → Add Object → Recipe Manager”.
   ⇒ The recipe definition is added below the Recipe Manager.
5. Open the editor of the recipe definition by double-clicking the object.
6. Double-click the blank field below “Variable”. Specify the name of a variable to define a recipe for. You can use the Input Assistant ()... button) for this.
7. Click “Recipes ➔ Add a New Recipe” and specify a name for the new recipe.
   ⇒ A column with the new recipe name appears in the editor.
8. Enter the variable value for this recipe in this field.
9. Insert additional fields as needed.
10. Select a variable value for the recipe and click “Recipes ➔ Save Recipe”. Select a location and file name.
   ⇒ The recipe is saved in the format which was defined in the Recipe Manager.

See also
- ☞ Chapter 6.4.1.21.2.25 “Object ‘Recipe Manager’” on page 2519
- ☞ Chapter 6.4.1.21.2.26 “Object ‘Recipe Definition’” on page 2522
- ☞ Chapter 6.4.1.21.3.20 “Menu ‘Recipes’” on page 2723

Loading a recipe from a file

Requirement: A Recipe Manager is available in the application. In a recipe definition, there is a “myRec” recipe with variable values. A myRec.txt recipe file is located on the file system and contains the entries for this recipe.

Example of the recipe file:
PLC_PRG.bVar:=0
PLC_PRG.iVar:=2
PLC_PRG.dwVar:=35232
PLC_PRG.stVar:='first'
PLC_PRG.wstVar:='12343245'

1. Double-click the “Recipe Definition” object in the device tree to open the tabular editor for the definition of the individual recipes.
   ⇒ You see the myRec column with the current values for this recipe.
2. Edit the myRec.txt file in an external text editor and replace the variable values with other values that you want to load into the recipe definition in CODESYS. Save the file.
3. In the recipe definition, click the “myRec” column and in the context menu click “Load Recipe”.
   ⇒ A dialog prompt notifies you about the possibly needing to perform an online change when logging in again. An online change is necessary when you change the current values of the recipe variables by loading the recipe.
4. Click “Yes” to close the dialog and continue. Select the myRec.txt file from the file explorer for loading.

If you want to overwrite only individual recipe variables with new values, then remove the values for the other variables before loading to the recipe file. Entries without value definitions are not read, and therefore updating leaves these variables unchanged on the controller and in the project.

For values of the data type REAL/LREAL, the hexadecimal value is also written to the recipe file in some cases. This is necessary so that the exactly identical value is restored when converting back. In this case, you change the decimal value and delete the hexadecimal value.

Recipe management on the controller; memory usage

When you clear the “Recipe management in the PLC” option, the Recipe Manager and recipe definitions will not use any memory on the PLC.

If you select this option, then code is generated for the Recipe Manager and all recipe definitions, and this code is stored on the PLC. The size of the used memory primarily depends on the number of recipes and their variables, as well as the data type of the variables. Whether or not the fields of the recipe definition are filled also has an effect. The memory usage of recipes cannot be calculated. It has to be determined by experimentation at the time it is needed. The following table merely provides some guiding principles.

<table>
<thead>
<tr>
<th>Recipe definition</th>
<th>Code Size (bytes)</th>
<th>Data Size (bytes)</th>
<th>Total (bytes)</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 INT variables</td>
<td>194406</td>
<td>79400</td>
<td>267352</td>
</tr>
<tr>
<td>200 INT variables</td>
<td>238318</td>
<td>121284</td>
<td>459344</td>
</tr>
<tr>
<td>300 INT variables</td>
<td>282230</td>
<td>163084</td>
<td>543856</td>
</tr>
<tr>
<td>100 BOOL variables</td>
<td>192742</td>
<td>69884</td>
<td>343168</td>
</tr>
<tr>
<td>200 BOOL variables</td>
<td>235446</td>
<td>101568</td>
<td>436872</td>
</tr>
<tr>
<td>300 BOOL variables</td>
<td>278146</td>
<td>133284</td>
<td>510072</td>
</tr>
<tr>
<td>100 string variables</td>
<td>203278</td>
<td>870084</td>
<td>1154000</td>
</tr>
<tr>
<td>200 string variables</td>
<td>255570</td>
<td>1709784</td>
<td>2973296</td>
</tr>
<tr>
<td>300 string variables</td>
<td>307886</td>
<td>2549484</td>
<td>2964112</td>
</tr>
</tbody>
</table>

Loading recipe values from the controller

You can apply recipe values on the controller to recipe definitions in the project, even if these definitions have been modified in the project.

Requirement: The “Recipe management in the PLC” option is selected in the Recipe Manager.
1. Create a recipe definition RecDef1 in the project, containing the variables PLC_PRG.ivar and PLC_PRG.bvar. Insert a recipe "R1". value for PLC_PRG.ivar: 33; value for PLC_PRG.bvar: TRUE.

2. Log in to the controller and download the application.
   - The recipe file R1.RecDef1.txtrecipe is saved to the default directory of the controller ($PlcLogic$).

3. Logout and add another variable PLC_PRG.dwvar to the recipe definition in the project.

4. Edit the recipe definition file R1.RecDef1.txtrecipe on the device by changing the value for PLC_PRG.ivar from 33 to 34.
   - Moreover, add another recipe “R2” on the device. To do this, copy the R1.RecDef1.txtrecipe and rename it to R2.RecDef1.txtrecipe. Then edit this file and change the recipe values: PLC_PRG.ivar: 1, PLC_PRG.bvar: FALSE.
   - Now two recipes “R1” and “R2” are available on the device. In the project, there is only “R1”, and it also contains other values than “R1” on the device.

5. Log in to the controller by means of an online change.

6. Click “Load Recipes from Device” from the context menu.
   - A dialog prompt notifies you that executing the command at the next login may trigger an online change, and that the recipes on the runtime system will overwrite the recipes of the current recipe definition.

7. Confirm that you want to continue.
   - A dialog prompt notifies you that the recipe for PLC_PRG.dwvar loaded on the device cannot yield a value from the controller.

8. Confirm that you want to continue.
   - The value of PLC_PRG.ivar in recipe “R1” of the recipe definition in the project changes to 34. The recipe “R2” with the values 1 and FALSE is also listed in the recipe definition now. PLC_PRG.dwvar remains in the recipe definition.

### 6.4.1.13.3 Data Recording with Trace

#### General

You can use a "Trace" to follow the value history of variables on the controller in a similar way as a digital sampling oscilloscope. When the application is in runtime mode with trace, all statements are executed first within the task cycle. Then, data recording starts with value storage including time stamps. These time stamps are relative and refer to the start time of the data recording. The data yields a discrete time signal and CODESYS displays its course in the trace editor.

A sample (data record) is composed of the value and the time stamp. The runtime system writes the samples to a buffer with a definable size. CODESYS requests the data, saves it in the trace editor buffer, and displays it in the trace diagram as a function of time. You can monitor the value history of the configured variables continually because CODESYS displays the latest data.

You can trigger the data recording. When this happens, the application saves the data from the time of the trigger and CODESYS displays the data at the time of the trigger.

The configuration and the display of a trace are possible in the CODESYS project by means of trace objects in the trace editor. There are the following two object types:
“Trace”: Inserted below the IEC application in the device tree. This kind of object always contains a purely application-specific trace configuration. You can download this trace configuration to the controller and run it with the application.

“DeviceTrace”: Inserted below the device object in the device tree. If the PLC supports a trace manager, then you can use one or more “DeviceTrace” objects to access one or more traces that are running on the controller. These can be both application-specific or controller-specific traces. For example, a controller can support traces for recording the processor load. Menu commands allow for access from the CODESYS project to the trace manager in the device.

Access to the trace manager from IEC code is possible by means of the functions from the library CmpTraceMgr.library. For more information, refer to the library documentation.

**NOTICE!**

A running data recording with trace can lead to a significant increase in the cycle time of the IEC task.

**NOTICE!**

Data recording with trace also continues running after logging out of the device.

**Runtime system component CmpTraceMgr, ”Trace manager”**

The device description of a runtime system with trace manager includes the tracemanager entry in the TargetSettings section.

In this case, CODESYS transfers only the trace configuration when downloading the application to the PLC. When you start the trace, the application interprets the configuration on the RTS by means of the trace manager, executes the data recording, and buffers the data sets on the PLC.

The CmpTraceMgr runtime system component provides extended functionality, as compared to data recording with IEC code.

Data recording is therefore possible as follows:

- Parameters on the PLC (for example, the processor load (cpuload, plcload), or the temperature curve of a CPU or a battery). The measurement of the processor load per CPU core (cpuload) is interesting for multicore controllers.
- Device signals (for example, the current path of a drive)
- System variables of another runtime system component

You can configure parameters like IEC variables in the “Trace Configuration” dialog of the “Variable Settings”.

The display of traces that run on the controller is possible in the trace editor of a DeviceTrace object.

See also

- Chapter 6.4.1.13.3.5 “Accessing All Traces on the Controller” on page 2014
- Chapter 6.4.1.21.2.7 “Object 'DeviceTrace’” on page 2426
- Chapter 6.4.1.21.4.16.2 “Dialog 'Trace Configuration’” on page 2804

**Data recording after triggering**

To monitor data that depends on an event or a condition, you can free the data recording that depends on a trigger. At runtime, the application checks whether the event has occurred or the condition is fulfilled, and then it buffers the data accordingly.

The trace configuration enables triggering by:

- a trigger variable that maps the event
- a condition as expression
- a combination of trigger variable and condition
**Saving samples to a file**  You can save samples from the development system to a file. The file can also include the trace configuration.

### Table 385: Possible file formats

<table>
<thead>
<tr>
<th>File Extension</th>
<th>File type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*.trace</td>
<td>&quot;Trace file&quot;</td>
<td>Contains the samples and the trace configuration in XML format. You can execute the &quot;Load Trace&quot; command to load the file to the trace editor when offline and analyze the samples without a controller.</td>
</tr>
<tr>
<td>*.txt</td>
<td>&quot;Text File&quot;</td>
<td>Contains the samples in ASCII format. You can edit the file with an external tool.</td>
</tr>
<tr>
<td>*.trace.csv</td>
<td>&quot;Trace dump&quot;</td>
<td>File in CSV format includes the trace configuration and optional samples. You can create the file by clicking &quot;Export Symbolic Trace Config&quot;. You can transfer the file to the controller and load it to the application. Then you can execute the &quot;Load Trace&quot; command in CODESYS to display this in the trace editor. You can also click &quot;Trace ➜ Save Trace&quot; and select the *.trace.csv file format. You can transfer the file to the controller and load it with an HMI for analysis.</td>
</tr>
<tr>
<td>*.traceconfig</td>
<td>&quot;Symbolic trace configuration&quot;</td>
<td>Contains the trace configuration CSV format. You can create the file by clicking &quot;Export Symbolic Trace Config&quot;. The CmpTraceMgr runtime system component can read the file.</td>
</tr>
</tbody>
</table>

See also
- % Chapter 6.4.1.21.3.22.15 “Command ‘Save Trace’” on page 2741
- % Chapter 6.4.1.21.3.22.8 “Command ‘Load Trace’” on page 2737
- % Chapter 6.4.1.21.3.22.7 “Command ‘Export Symbolic Trace Config’” on page 2735
- % Chapter 6.4.1.21.2.27 “Object ‘Symbol Configuration’” on page 2523

- % Chapter 6.4.1.21.2.31 “Object ‘Trace’” on page 2541
- % Chapter 6.4.1.21.2.7 “Object ‘DeviceTrace’” on page 2426

### Getting started

**Program**  PLC_PRG

```plaintext
PROGRAM PLC_PRG
VAR
  iVar : INT;
  rSin : REAL;
  rVar : REAL;
END_VAR
```

2024/01/05  3ADR010583, 1, en_US  2009
iVar := iVar + 1;
iVar := iVar MOD 33;

rVar := rVar + 0.1;
rSin := 30 * SIN(rVar);

☑ Requirement: The application is running the PLC_PRG program on the controller.

1. In the device tree, select the application and add a new trace object by clicking "Project ➔ Add Object".
   ➔ The respective trace editor opens with the commands available in the "Trace" menu.

2. Click "Trace ➔ Configuration".
   ➔ The "Trace Configuration" dialog box opens.

3. Select a task for running the trace feature. Normally this is the same task that is running in PLC_PRG.

4. Click "Add Variable" to add an entry to the tree view of the trace configuration and assign an IEC variable (for example, PLC_PRG.rSin).

5. Click "Trace ➔ Download Trace".
   ➔ CODESYS loads the trace configuration to the controller. The application starts recording data and transmits the data to CODESYS, where it is displayed in the trace diagram as a graph. Commands are provided for navigating through the samples and controlling the data recording.

Example

The PLC_PRG program is running on the controller. When you follow the instructions for "Getting Started", CODESYS displays the following trace diagram.

- (1) : "Configuration"
- (2) : "Add Variable"

See also

- ☑ Chapter 6.4.1.21.2.31 “Object ‘Trace’” on page 2541

Creating trace configuration

For a complete trace configuration, specify at least one task and one variable. In order to trigger the data recording, activate the trigger option and select a trigger variable or specify a recording condition.
Assigning a task

In this task, the data recording is executed in runtime mode. Usually the same task is selected where the variables are written.

1. Double-click the trace object.
   - The trace editor opens with the commands available in the “Trace” menu.
2. Click “Trace ➔ Configuration”.
   - The “Trace Configuration” dialog opens. In the tree view “Trace Record”, the top item is selected and the subdialog “Record Settings” is shown on the right.
3. Click the "arrow down" symbol (▼) in the “Task” drop-down list.
   - The drop-down list opens with all tasks that are available throughout the application.
4. Select a task for the trace.

Configuring a trace variable

1. Double-click the trace object.
   - The trace editor opens. The commands of the “Trace” menu are available.
2. Click “Add Variable”.
   - The “Trace Configuration” dialog opens. The subdialog “Variable Settings” is displayed on the right.
3. Click in the input field of the “Variable” setting and select a trace variable in the “Input Assistant” dialog.
   - The variable is configured for data recording. The trace record tree and the display tree were extended by the variable.
4. Click the “Add Variable” link.
   - The trace record tree and the display tree receive a new variable. The settings of the variables are available on the right.
5. Select a trace variable.
6. Click “OK” to close the dialog.
   - The variables are trace variables and are displayed in the trace variable list.

Deleting a trace variable

1. Double-click the trace object.
2. Click a variable in the trace record tree.
3. Click the “Delete Variable” command or press [Del].
4. Click “OK” to close the dialog.
   - The variable is removed from the trace variable list.
Tracing a parameter

1. Double-click the trace object.
2. Click “Add Variable”.
   ⇨ The “Trace Configuration” dialog opens. The subdialog “Variable Settings” is displayed on the right.
3. Click (right of the “Variable” setting, left of the input field).
4. Select the “Parameter” option in the drop-down list.
5. Click and select a parameter from the “Input Assistant” dialog.
6. Configure how the parameter is displayed.
7. Click “OK” to close the dialog.
   ⇨ The parameter will be traced and displayed in the trace variable list.

Configuring a trigger

1. Double-click the trace object.
   ⇨ The trace editor opens with the commands available in the “Trace” menu.
2. Click “Trace ➤ Configuration”.
   ⇨ The “Trace Configuration” dialog opens. The subdialog “Record Settings” is displayed on the right.
3. Select the “Enable trigger” check box.
4. Select the task in which the trend record is to be executed.
5. Select a variable from the “Trigger Variable” field.
6. Click “OK” to close the dialog.
   ⇨ The data recording will be triggered.

The trigger time is displayed as a black line in the diagram in runtime mode.

1. Download the application and start it.
2. Click “Trace ➤ Download Trace”.
   ⇨ The trace configuration is loaded. After triggering, the runtime system saves the value graph of the trace variables. The data is displayed in the trace editor. The trigger time is displayed as a black line in the diagram.

Configuring the display of the time axis

1. Double-click a trace object.
2. Click the “Configuration” link above the configuration tree.
   ⇨ The “Trace Configuration” dialog opens.
3. Select “Time axis” in the display tree (below “Presentation (Diagrams)”).
   ⇨ The display settings of the time axis are shown on the right.
4. Edit the presets and click the “Preview” link.
   ⇨ The changes are seen in the coordinate system preview.
5. Click “Y-axis” in the display tree. The “Y-axis” item is below every configured diagram. Therefore, the display of the value axis is set for each diagram.  
⇒ The subdialog “Display Settings” of the selected axis is displayed on the right.

6. Change the preset value.
⇒ The changes are applied in the coordinate system preview.

7. Click OK to close the “Trace Configuration” dialog.
⇒ The display changes are visible in the affected diagrams.

---

**Configuring the display of the trace variable**

1. Double-click a trace object.
2. Click the “Configuration” link.  
⇒ The “Trace Configuration” dialog opens.
3. Select a variable below “Trace Record”.
⇒ The subdialog “Variable Settings” of the selected variable is displayed on the right.
4. Change a setting, for example the “Line type”.
5. Click “OK” to close the dialog.  
⇒ The display changes are visible in the affected diagrams.

---

**Configuring the buffer for data on the runtime system**

1. Double-click a trace object.
2. Click “Trace ➔ Configuration”.  
⇒ The “Trace Configuration” dialog opens. The subdialog “Record Settings” is displayed on the right.
3. Click “Advanced”.
⇒ The “Advanced Trace Settings” dialog opens.
4. Change the setting “Measure in every n-th cycle” or “Recommended runtime buffer size (samples)”.  
5. Click “OK” to close the dialog.  
⇒ The buffer settings are reconfigured. It is applied after the trace configuration is loaded to the RTS the next time.

---

**Editing the trace configuration in runtime mode**

Requirement: The application is running on the controller and a trace configuration is loaded.

1. Double-click a variable in the trace record tree.  
⇒ The “Trace Configuration” dialog opens.
2. Change the color, for example.  
⇒ The variable is displayed in the new color in the affected diagrams without interrupting the execution of the application.
Operating the data recording

Use menu commands for controlling how data is recorded.

Requirement: The application is loaded on the runtime system and a trace is configured.

Menu commands

- “Trace ➔ Download Trace”
- “Trace ➔ Start Trace”
- “Trace ➔ Stop Trace”
- “Trace ➔ Reset Trigger”

See also

- Chapter 6.4.1.21.3.22.6 “Command ‘Download Trace’” on page 2734
- Chapter 6.4.1.21.3.22.16 “Command ‘Start Trace’” on page 2741
- Chapter 6.4.1.21.3.22.17 “Command ‘Stop Trace’” on page 2741
- Chapter 6.4.1.21.3.22.13 “Command ‘Reset Trigger’” on page 2740

Accessing All Traces on the Controller

If the controller supports the runtime system component CmpTraceMgr (Trace Manager), then you can access all traces from a CODESYS project which are running on the controller. In addition to application-related traces that capture the values of IEC variables, these can also be entirely controller-specific traces (for example, for recording device signal values or the CPU load).

For each trace running on the controller that you want to present in your project, you have to insert an individual “DeviceTrace” object in the device tree.

In order to show a trace from the device in this object, the connection to the PLC has to be configured correctly (“Communication Settings”). Then use one of the following menu commands:

- “Trace ➔ Upload Trace”: Establishes the connection to the PLC and opens the “Online List” dialog for selecting a trace from the controller.
- “Trace ➔ Online List”: Available in online mode only: Also opens the “Online List” dialog.

Now the trace uploaded from the controller can be started and traced in the editor of the DeviceTrace object. The configuration of the presentation (colors, labels, etc.) is the same as with traces for application variables configured in the project.

NOTICE!
Closing the DeviceTrace editor terminates the connection to the controller.

Please note that the connections to the controller is also terminated when the last open “DeviceTrace” editor is closed. In order for device traces to be displayed again in the project, you have to reload them into the “DeviceTrace” objects.

At this time, closing the editor is also the recommended procedure for deliberately terminating the connection to the controller. Logging out is not enough for this.
Requirement: The PLC device supports the Trace Manager. For the example described here, this is CODESYS Control Win V3. The device provides traces of the individual CPU loads (\textit{CpuLoad}), as well as traces of the CPU load caused by the runtime system (\textit{PlcLoad}). The possible display of the CPU load in the project can be helpful when using multicore functionality.

1. In the project, define the “\textit{Communication Settings}” for the controller.
2. Select the PLC entry in the device tree and add a “\textit{DeviceTrace}” object.
3. Rename “\textit{DeviceTrace}” to “\textit{Trace_PlcLoad}” (“\textit{Properties}”).
   - The connection to the controller is established and the “\textit{Online List}” dialog opens.
4. Set the focus in the trace editor and click “\textit{Trace \rightarrow Upload Trace}”.
   - The connection to the controller is established and the “\textit{Online List}” dialog opens.
5. Select the “\textit{PlcLoad}” entry in the dialog and click “\textit{Upload}”. Click OK to close the dialog.
   - Multiple trace views open in the trace editor to show the CPU load in the runtime system. There are the traces for the particular CPUs and one trace for the average value. The following text appears for each: “No samples have been recorded.”
6. Click “\textit{Trace \rightarrow Start Trace}”.
   - The trace recording for the four parameters is displayed.
7. If you also want to display the traces for the \textit{CpuLoad} per CPU with their average value in the project, then insert another “\textit{DeviceTrace}” object into the device tree. Name it “\textit{Trace_CpuLoad}” for example. Load and start the traces for “\textit{CpuLoad}” in the editor as described above.
   - Now you can monitor all traces in the project:

8. If you want to change the appearance of the presentation, then click “\textit{Configuration}” in the respective trace editor window to access the configuration dialogs. You can use these dialogs (except variable assignments) in the same way as for an IEC variable trace created in a project.
9. To disconnect from the controller, close all open DeviceTrace editor windows. If you are logged in to the device, then logging out is enough to terminate the connection.

See also
- Chapter 6.4.1.21.2.8.3 “\textit{Tab \textquoteleft Communication Settings\textquoteright}” on page 2427

Navigating into trace data

Use menu commands to navigate the data in the trace diagram.

Requirement: The application is in online mode.

Menu commands
- “\textit{Trace \rightarrow Cursor}”
- “\textit{Trace \rightarrow Mouse Zooming}”
Managing trace

Use menu commands to load and save traces in various formats.

Menu commands

- “Trace ➔ Reset View”
- “Trace ➔ AutoFit”
- “Trace ➔ Compress”
- “Trace ➔ Stretch”
- “Trace ➔ Convert to Single-Channel”
- “Trace ➔ Convert to Multi-Channel”

See also

- § Chapter 6.4.1.21.3.22.15 “Command ‘Save Trace’” on page 2741
- § Chapter 6.4.1.21.3.22.8 “Command ‘Load Trace’” on page 2737
- § Chapter 6.4.1.21.3.22.7 “Command ‘Export Symbolic Trace Config’” on page 2735

Showing statistics

CODESYS evaluates and displays the recorded data with an option of saving the data to the clipboard. Click “Trace ➔ Statistics”.

See also

- § Chapter 6.4.1.21.3.22.20 “Command ‘Statistics’” on page 2742

6.4.13.4 Data Recording with Trend

General

When you want to monitor the development of data over a long period of time for the purpose of reading a trend, you can save the data with “Trend Recording”. You can configure any number of variables or parameters to save their values in a persistent database. This database is located on the PLC and is populated continually at runtime.
Trend recording comprises the following objects:

1. "Trend recording task" of type "Task"
2. Object of type "Trend Recording Manager"
3. Object of type "Trend Recording"

NOTICE!

Timeout for trend recording

During a trend recording, it can happen that the application task triggers a timeout that is caught with an exception when transitioning from "Running" to "Stop". Causes can be that file operations with the SQLite database are taking too long or that too many variables are being recorded. This usually happens on a target device with weak performance.

You can avoid the occurrence of an exception:

- Configure the trend recording with less memory demand so that the amount of data that is stored is adapted to the target system.
- Reduce the number of variables.

To display the collected data, you design a visualization with a "Trend" element. This kind of visualization accesses the database for visualizing the data.

See also

- Chapter 6.4.1.21.2.32 “Object ‘Trend Recording Manager’” on page 2545
- Chapter 6.4.1.21.2.33 “Object ‘Trend Recording’” on page 2545
- Chapter 6.4.1.21.2.34 “Object ‘Trend Recording Task’” on page 2548

Getting started with trend recording

To execute trend recording on a runtime system, you need an application with a "Trend Recording Manager" object that contains at least one "Trend Recording" object. Then you can configure a database on the runtime system and the data buffering.
1. Add a "Trend Recording Manager" object below your application.
2. Select the "Trend Recording Manager" object and click "Add Object ➔ Trend Recording". Type a name in the "Add Trend Recording" dialog box.
   ➞ CODESYS creates the object. The editor opens.
3. Type a task in "Record Settings".
4. Click "Add Variable".
   ➞ CODESYS adds another variables. The blank settings open in the "Variable Settings" to the right of the tree view.
5. Select a valid IEC variable from the "Variable" field.
   ➞ The IEC variable is configured for trend recording.
6. Build the application.
7. Download the application to the controller and click "Start".
   ➞ The application records data in runtime mode and saves it to a database.

See also
● ☰ Chapter 6.4.1.21.2.33 “Object 'Trend Recording’” on page 2545
● ☰ Chapter 6.4.5.13.2 “Getting Started with Trend Visualization” on page 2928

Configuring trend recording
You can configure a database on the runtime system and the data buffering.

NOTICE!
Timeout for trend recording

During a trend recording, it can happen that the application task triggers a timeout that is caught with an exception when transitioning from "Running" to "Stop". Causes can be that file operations with the SQLite database are taking too long or that too many variables are being recorded. This usually happens on a target device with weak performance.

You can avoid the occurrence of an exception:
– Configure the trend recording with less memory demand so that the amount of data that is stored is adapted to the target system.
– Reduce the number of variables.

Assigning tasks
In this task, the runtime system records the trend.

In general, trend recording runs in the same task as the main program (for example, PLC_PRG).

1. Double-click a “Trend Recording” object in the device tree.
   ➞ The respective editor opens. In the tree view of the trend configuration, the top entry is selected, and on the right you see the current configuration in "Record Settings".
2. Click the "arrow down" symbol (▼) in the “Task” drop-down list.
   ➞ The drop-down list opens with all tasks that are available throughout the application.
3. Select a task for trend recording.
Adding IEC variables

NOTICE!
The number of variables is limited for trend recording. You can change this number in the “Trend storage” dialog.

1. Double-click a “Trend Recording” object in the device tree.
   ⇒ The respective editor opens. In the tree view of the trend configuration, the top entry is selected, and on the right you see the current configuration in “Record Settings”.
2. Right-click an entry in the tree view.
3. Click “Add Variable”.
   ⇒ CODESYS adds another variable. The blank settings open in the “Variable Settings” to the right of the tree view.
4. Select a valid IEC variable from the “Variable” field.
   ⇒ The IEC variable is configured for trend recording.
5. Configure how the variable is displayed in the trend diagram.
6. Configure how the alert color is displayed in the trend diagram.

See also
● ° Chapter 6.4.1.21.2.33 “Object ‘Trend Recording’” on page 2545

Removing variables from the configuration

1. Double-click a “Trend Recording” object in the device tree.
2. Click a variable in the tree view of the configuration.
3. Click “Delete Variable” or press [Del].

Starting conditional trend recording

You can configure conditional trend recording for execution. Configuration is not possible when depending on triggering. For that you need a “Trace” object.

1. Double-click a “Trend Recording” object in the device tree.
2. Click the top node in the tree view of the trend configuration.
   ⇒ The name of the trend configuration is selected and on the right you see the current configuration in “Record Settings”.
3. Assign a Boolean variable, an access to a bit, or a property to the “Record condition” field.
   ⇒ When the application is in runtime mode, data is recorded only if the value is TRUE.

See also
● ° Chapter 6.4.1.13.3 “Data Recording with Trace” on page 2007
Adding parameter

1. Double-click a “Trend Recording” object in the device tree.
   ⇒ The respective editor opens. In the tree view of the trend configuration, the top entry is selected, and on the right you see the current configuration in “Record Settings”.

2. Right-click an entry in the tree view.

3. Click “Add Variable”.
   ⇒ CODESYS inserts a new variable. The blank settings open in the “Variable Settings” to the right of the tree view.

4. Click the “down” symbol (▼) to the right of the “Variable” label.

5. Select “Parameter” from the drop-down list.

6. Click and select a parameter from the “Input Assistant” dialog.

7. Configure how the parameter is displayed in the trend diagram.

8. Configure how the alert color is displayed in the trend diagram.

See also
● Chapter 6.4.1.21.2.33 “Object 'Trend Recording'” on page 2545

Configuring data buffering on the RTS

1. Double-click a “Trend Recording” object in the device tree.
   ⇒ The respective editor opens. In the tree view of the trend configuration, the top entry is selected, and on the right you see the current configuration in “Record Settings”.

2. Click “Trend Storage”.
   ⇒ The “Trend Storage” dialog opens.

3. Now you can change the settings.

See also
● Chapter 6.4.1.21.4.17 “Dialog Box 'Trend storage'” on page 2809

Configuring additional buffering

1. Double-click a “Trend Recording” object in the device tree.
   ⇒ The respective editor opens. In the tree view of the trend configuration, the top entry is selected, and on the right you see the current configuration in “Record Settings”.

2. Click “Advanced”.
   ⇒ The “Advanced Trace Settings” dialog opens.

3. Now you can change the settings.

See also
● Chapter 6.4.1.21.4.18 “Dialog Box 'Advanced Trend Settings'” on page 2810
6.4.13.5 Monitoring tasks

In online mode, you can display some statistical values of the tasks in the runtime system. This information is very useful for testing clock cycles or solving problems in the runtime performance.

1. Switch to online mode.
2. Select the “Task Configuration” object in the device tree.
   - Click “Project ➔ Edit Object”.
   - The task configuration opens in the editor.
3. Click the “Monitor” tab.

See also
- Chapter 6.4.1.3.3 “Creating trace configuration” on page 2010

6.4.13.6 Reading the PLC log

CODESYS provides the capability to display the events and error messages logged in the controller.

See also
- Chapter 6.4.1.21.2.8.9 “Tab 'Log'” on page 2437

Reading the log

Requirement: The controller is running.

1. Select the controller in the device tree.
2. Choose the command “Project ➔ Edit Object”.
   - The device editor opens.
3. Choose the tab “Log”.
4. Click on  to update the view.
   - A connection to the controller is established. The controller in the device tree is highlighted in green.
   - All controller log information are displayed.
5. Click on  to delete the current list.
6. Filter the view by clicking on the desired category (for example "Information").
7. Save the log entries. Click on  and choose a file name.

See also
- Chapter 6.4.1.21.2.8.9 “Tab 'Log'” on page 2437
6.4.1.13.7 Using PLC shell for requesting information

The "PLC shell" in CODESYS is a text-based control monitor (terminal) on a tab of the device editor. There you can enter commands for the request of specific information from the controller, as well as execute actions like starting, stopping or downloading applications. Also a description on the meaning and syntax of the possible commands you can get directly via the PLC shell.

Requesting information about the application on the controller

Requirement: Your project is connected with a controller; Example: CODESYS Control Win V3, on which an application App1 is running.

1. Open the device editor double-clicking on the object CODESYS Control Win V3 in the device tree, and activate tab "PLC Shell".
   ⇒ The tab shows an empty output data window. Below there is an entry field for a command.
2. Click button ...
   ⇒ The "Insert Standard Command" dialog appears with a list of commands.
3. Choose command "?” and click button “Execute”.
   ⇒ The dialog closes and in the output data window you see a list of the supported commands and their possible parameters. Each the syntax for how to enter the command is displayed.
4. Click again [ ] and choose command “pid”. In the input assistant supplement the command as follows: pid App1. Press the Enter key.
   ⇒ In the output data window the following gets displayed (the GUIDs are just examples):
   
   pid App1  
   Project Identification  
   Application: App1  
   Code GUID:0x08a893c0  
   Data GUID:0x762d0e90  
5. Click button ▼ in the command line.
   ⇒ Command pid App1 is added to the history of already entered commands.

See also
● © Chapter 6.4.1.21.2.8.11 “Tab 'PLC Shell'” on page 2441

6.4.1.13.8 PLC operation control via system variables

CAUTION!
You are responsible for runtime system services being enabled under safe application conditions and disabled only under critical conditions.

At runtime, the state of an application or facility can become sensitive and disruptive actions can endanger the entire machine or facility. However, in this state you can suppress certain commands and prevent dangerous actions. The "PlcOperationControl" function block and "Component Manager" library are provided for this purpose.
Examples of CODESYS commands that can suppress operations when executed:

- “Online Change”, “Download”
- “Enable Breakpoint”
- “Reset Application”, “Stop Application”
- “Transmit Data”
- “Force Values”, “Write Values”

In order that a backup solution is always in place, you are not permitted to suppress the “Reset origin” and “Delete” commands.

CODESYS will notify you if a currently disabled runtime system service is required when the application is in runtime mode. Then, you can respond with an appropriate countermeasure.

**Function block PlcOperationControl for operation control**

This function block is used for enabling and disabling operations.

<table>
<thead>
<tr>
<th>Name</th>
<th>Data Type</th>
<th>Initial value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>xDisableApplicationOnlineChange</td>
<td>BOOL</td>
<td>FALSE</td>
<td>TRUE: Online change is suppressed.</td>
</tr>
<tr>
<td>xDisableApplicationDownload</td>
<td>BOOL</td>
<td>FALSE</td>
<td>TRUE: Download is suppressed.</td>
</tr>
<tr>
<td>xDisableApplicationStop</td>
<td>BOOL</td>
<td>FALSE</td>
<td>TRUE: Application stop is suppressed.</td>
</tr>
<tr>
<td>xDisableApplicationBP</td>
<td>BOOL</td>
<td>FALSE</td>
<td>TRUE: Setting breakpoints is suppressed.</td>
</tr>
<tr>
<td>xDisableApplicationWrite</td>
<td>BOOL</td>
<td>FALSE</td>
<td>TRUE: Writing variables is suppressed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>This can also be suppressed via PLCHandler/lec-VarAccess.</td>
</tr>
<tr>
<td>xDisableApplicationForce</td>
<td>BOOL</td>
<td>FALSE</td>
<td>TRUE: Forcing variables is suppressed.</td>
</tr>
<tr>
<td>xDisableApplicationReset</td>
<td>BOOL</td>
<td>FALSE</td>
<td>TRUE: Resetting the application (not &quot;Reset origin&quot;) is suppressed.</td>
</tr>
<tr>
<td>xDisableAll</td>
<td>BOOL</td>
<td>FALSE</td>
<td>TRUE: All operations are suppressed.</td>
</tr>
</tbody>
</table>

**Implementing operation control**

**Requirement**

- Compiler version >= 3.4.3.0
- In the device description, the PLC operation control is enabled by system variables.

1. Declare an instance of the PlcOperationControl function block (for example, PlcOpCtrl_Inst).
    
    ```
    PlcOpCtrl_Inst : PlcOperationControl;
    ```

2. Suppress a command by assigning the respective TRUE property (for example, "Stop Application").
    
    ```
    PlcOpCtrl_Inst.xDisableApplicationStop := TRUE;
    ```
6.4.1.13.9 Backup and restore

CODESYS and the CODESYS standard runtime systems (with version 3.5.8.0 and later) support backing up application-specific files on the PLC. You can execute the required actions in the “Backup and Restore” tab of the generic device editor.

A backup consists of creating and saving a file in zip archive that contains the application-related files and an information file `meta.info`. This backup file has the extension `TBF` ("Target Backup File") and can be saved in the local file system or on the PLC.

The following applies when restoring the software status from the backup file:

- A dialog opens with a list of affected files on the PLC, and you can deactivate optional components.
- We highly recommend to set the application to STOP mode for backup or restore. A dialog prompt will open to warn you about this.
- The user interface is blocked when restoring to the PLC.
- Existing files are overwritten without warning.
- Existing boot applications are deactivated as soon as at least one new boot application is part of the restore.

See also

- Chapter 6.4.1.21.3.7.6 “Command ‘Online Change’” on page 2629
- Chapter 6.4.1.21.3.8.16 “Command ’Force Values’” on page 2649
- Chapter 6.4.1.12.5 “Forcing and Writing of Variables” on page 1987

Creating backup files

Requirement: A project is open with an application that is running on the required device. In addition, for this example an external file `myExternalFile.txt` is inserted as an object below the application. This file is downloaded to the PLC implicitly when downloading the application.

1. Open the device editor by double-clicking the device entry in the device tree. Click the “Backup and Restore” tab.
   - The tab opens with a menu bar including the “Backup” and “Restore” menus.
2. In the “Backup” menu, select the “Read Backup Information from Device” item.
   - If the PLC is not connected at the moment, then CODESYS opens a temporary connection to the device and reads the relevant files from the `$PlcLogic$/Application/Application.app`, `$PlcLogic$/Application/Application.crc`, and `$PlcLogic$/Application/myExternalFile.txt`. In addition, other external, project-dependent files are listed, which have been inserted below the application in the device tree. Furthermore, the source code archive file `$PlcLogic$/Archive.prj` is listed if you have set the project setting for this (“Implicitly at program download and online change”) as the loading time.
3. In the table, clear the check box for the `$PlcLogic$/Application//myExternalFile.txt` file in the “Active” column.
4. Select “Save Backup File to Device” in the “Backup” menu.
   - The “Save as” dialog opens. The file type is predefine as “Backup files (*.tbf)”.
5. Select a location for the backup file and click “Save”.

See also

- Chapter 6.4.1.21.2.8.6 “Tab ’Backup and Restore’” on page 2435
- Chapter 6.4.1.21.4.12.6 “Dialog ’Project Settings’ – ’Source Download’” on page 2770
Restoring from backup files

Requirement: A project is open with a PLC device connected. A backup file is saved to the local file system as described above.

1. Open the device editor by double-clicking the device entry in the device tree. Click the "Backup and Restore" tab.
   - Click “Restore ➔ Load Backup File from Disc”.
   - The default prompt opens for selecting a backup file tbf in the local file system.
2. Select the backup file and click “Open”.
   - The files are read from the backup file and shown in the table of the dialog below.
   - The file $PlcLogic$/Application/myExternalFile.txt that was excluded in the backup is missing.
3. Click “Restore ➔ Restore Backup to Device”.
   - A dialog prompt opens with information about the actions when restoring.
4. Click “OK” to start restoring the files to the PLC file system.
   - When restore is complete, you are prompted to restart the PLC in order to activate the loaded application.

6.4.1.14 Updating an Application on the PLC

6.4.1.14.1 General

CODESYS basically provides two options to transfer a modified application to the controller: download and online change.

A download results in a recompilation of the application. In that time, a syntax check is performed and application code is also created and downloaded to the controller. This leads to the running program being stopped. A download is the recommended method of data transfer because a defined starting state is always created due to the program stop and the reinitialization.

In the case of an online change, only the modified parts are downloaded again to the controller. A running program is not stopped for this. You should perform an online change only in the case of minor changes to the application. For extensive changes, the behavior of a program cannot be safely predicted. For more information, read the notes in the description of the “Online Change” command.

See also
- “Chapter 6.4.1.14.2 “Executing the online change” on page 2025
- “Chapter 6.4.1.14.3 “Execution of a download” on page 2026
- “Chapter 6.4.1.21.3.7.5 “Command 'Load'” on page 2628
- “Chapter 6.4.1.21.3.7.6 “Command 'Online Change'” on page 2629

6.4.1.14.2 Executing the online change

CODESYS automatically offers you an online change if you log in with an application that is already present on the controller, but has been changed since the last download in the programming system. With this procedure only the modified parts are reloaded to the controller. A running program on the controller is not stopped during the online change.

In the view “Memory reserve for online change”, you can configure memory reserves for the online change for function blocks of a project. In this way, instance variables do not have to be moved to the memory after changes are made to a function block for an online change.

NOTICE!

When carrying out the online change, pay attention to the notes in the description of the “Online Change” command.
See also
- Chapter 6.4.1.21.3.7.6 “Command ‘Online Change’” on page 2629
- Chapter 6.4.1.21.3.7.2 “Command ‘Login’” on page 2624
- Chapter 6.4.1.11.5 “Generating Application Code” on page 1976

Executing the online change when logging in

Requirement: The connection settings of the controller are correctly set. The applications in the project and on the controller are identical. The project on the controller is running. The application is logged out.

1. Change your application.
2. Click “Online ➔ Login”.
   - A dialog appears with the information that the application has been changed since the last download.
3. Click the “Details…” button
4. Check the details in the “Application information” tab.
   - If you have not generated any code since the last change, the command “Application is not up to date. Generate code now?” appears at the bottom edge of the dialog. In this case click this command.
   - You are shown a comparison view of the objects (objects marked red are different).
5. Close the dialog.
6. Select the option “Login with Online Change” and click “OK”.
   - The change is loaded to the controller. The running program on the controller is not stopped while doing this. The application is logged in.

See also
- “View ‘Project Comparison’ - ‘Differences’” on page 2607

Execute online change in the logged-in state (online operation)

Requirement: The connection settings of the controller are correctly set. The applications in the project and on the controller are identical. The project on the controller is running. The application is logged in.

1. Select an object in the device tree. It is best to select a POU or a GVL here.
2. Click “Project ➔ Edit Object (Offline)”.
   - The object opens in the editor.
3. Change the object. For example, you can declare a new variable or change a value assignment here.
4. Click “Online ➔ Online Change”.
   - A query will appear, asking whether you really want to execute the online change.
5. Click “Yes” to confirm the dialog.
   - The change is loaded to the controller.

6.4.1.14.3 Execution of a download

A download of the application causes a compilation of the active application. In the process, a syntax check is performed and application code is also created and loaded to the controller. A program running on the controller is stopped during the download.
NOTICE!
During the download, pay attention to the notes in the description of the "Download" command.

See also
- ▶️ Chapter 6.4.1.21.3.7.5 “Command ‘Load’” on page 2628
- ▶️ Chapter 6.4.1.21.3.7.2 “Command ‘Login’” on page 2624
- ▶️ Chapter 6.4.1.11.5 “Generating Application Code” on page 1976

### Downloading when logging in

Requirement: the connection settings of the controller are correctly set. The applications in the project and on the controller are identical. The project on the controller is running. The application is logged out.

1. Change your application.
2. Select the command “Online ➔ Login”
   
   ➔ A dialog box appears with the information that the application has been changed since the last download.
3. Select the option “Login with download” and click on “OK”.
   
   ➔ The running program on the controller is stopped and the change is loaded to the controller. The application is logged in.

### Downloading in the logged-in state (online mode)

Requirement: the connection settings of the controller are correctly set. The applications in the project and on the controller are identical. The project on the controller is running. The application is logged in.

1. Select an object in the device tree. It is best to select a POU or a GVL here.
2. Select the command “Project ➔ Edit Object (Offline)”
   
   ➔ The object opens in the editor.
3. Change the object. For example, you can declare a new variable or change a value assignment here.
4. Select the command “Online ➔ Download”.
   
   ➔ A query will appear, asking whether you really want to execute the download.
5. Confirm the dialog box with “Yes”.
   
   ➔ The running program on the controller is stopped and the change is loaded to the controller.

### 6.4.1.15 Copying files to/from PLC

In the generic “Files” tab of the device editor, you can copy files to and from the local file system and the controller.

Requirement: The vendor has unlocked the tab. In the device tree, the connection to the controller is configured. The device is running.

1. Double-click the PLC device object in the device tree to open the device editor.
2. Click the “Files” tab.
3. In “Host” | “Location” on the left part of the view, set the path in the local file system where files will be copied to and from. Example: D:\FileTransferWithPLC. If necessary, create a new directory by clicking the folder symbol ( ).
   ➔ The files and directories are shown like in a file manager. Click the refresh symbol ( ) to update the display.

4. In “Runtime” on the right side of the view, set the required directory for the data transfer in the same way.
   ➔ CODESYS shows the files on the controller.

5. Select the required files from the file system tree for the file transfer (multiple selection is possible). You can also select a directory for transferring all files in a folder.

6. Click the left and right arrow symbols ( ), ( ) between the two parts of the view.
   ➔ CODESYS copies the selected files to the other file system immediately. If a file is not already available in the target directory, then it is created. If it is already available and not write-protected, then it is overwritten. Otherwise a message is shown.

See also
● ❯ Chapter 6.4.1.21.2.8.8 “Tab ‘Files’” on page 2437

6.4.16 Using the Command-Line Interface

You can start the command line with the following options and arguments.

Syntax:

(folder)Automation Builder.exe --<option>

Paths or option parameters must be written inside straight quotation marks when they contain spaces, dashes, or slash marks.

Option --culture (language of the user interface)
CodeSYS is started in the specified language.

Syntax:

--culture=<culture>

<Culture>: Typical language codes are as follows: de, en, fr, it, es, zh-CHS.

Example

Starting CodeSYS with the user interface in English:
Automation Builder.exe --culture=en

See also

Option --profile (CODESYS profile)
CODESYS is started directly with the specified profile. When you start CODESYS without this option, the “Select Profile” opens.

Syntax:

--profile="<profile name>"

<profile name>: You have to specify the profile name exactly as it is displayed in the “Help ➔ About” splash screen of the development system or in the start menu on your computer.
After CODESYS is started, the comparison of two CODESYS projects is begun immediately. Type the path of the project file as arguments after the option and then the path of the reference project. CODESYS starts and opens the "Project Comparison - Differences" view.

Syntax:
```
--compare="<path of project file>" "<path of reference project file>"
```

Example
```
Automation Builder.exe --compare "D:\proj\project1.project" "D:\proj\project2.project"
```

See also
- § Chapter 6.4.1.21.3.5.21 “Command ‘Compare’” on page 2607

CODESYS is started and the specified project is opened.

Syntax:
```
--project="<path of project file>"
```

Example
```
Open the test project:
Automation Builder.exe --culture=de --
project="D:\projects\test.project"
```

See also
- § Chapter 6.4.1.21.3.2.2 “Command ‘Open Project’” on page 2553

CODESYS is started, the specified project archive is extracted, and the project is opened.

Syntax:
```
--projectarchive="<path of project archive file>"
```

Example
```
Extract the test.projectarchive and open the project in the development system:
Automation Builder.exe --
projectarchive="D:\projects\test.projectarchive"
```

See also
- § Chapter 6.4.1.21.3.2.9 “Command ‘Extract Archive’” on page 2558
The specified script file is run by CODESYS.

**Option --runscript (run script)**

**Table 387: Command-line options for --runscript**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>--runscript=&quot;&lt;scriptfile&gt;.py&quot;</td>
<td>CODESYS runs the <code>&lt;scriptfile&gt;.py</code> script file at startup. You have to provide the complete path of the script file.</td>
</tr>
<tr>
<td>--scriptargs:'&lt;arg1&gt; &lt;arg2&gt; ... &lt;argn&gt;'</td>
<td>Use this option with the --runscript option. As a result, the arguments <code>&lt;arg1&gt; ... </code>&lt;argn&gt;<code>are passed to the script. The arguments are passed to the Python variable</code>sys.argv`.</td>
</tr>
<tr>
<td>--noUI</td>
<td>Use this option with the --runscript option. The CODESYS user interface is not opened. CODESYS prints all errors, warnings, compiler reports, and command-line messages generated from the script. The script messages (1: Severity Text) can be separated from other messages (2: Severity FatalError, Error, Warning, Information) with the &quot;&gt;&quot; operator.</td>
</tr>
<tr>
<td>--enablescripttracing</td>
<td>Use this option with the --runscript option. As a result, each command of the script file is shown in the output.</td>
</tr>
<tr>
<td>--textPrompts</td>
<td>Use this option with the --noUI option. As a result, message service methods and default dialogs are output in the command line for user input. If you do not specify --textPrompts, then all message service prompts are confirmed automatically with default values.</td>
</tr>
<tr>
<td>scriptdebugger {=&quot;&lt;debugger&gt;&quot;}</td>
<td>Use this option with the --runscript option. It sets IronPython in debug mode so that external debuggers can be used to debug Python scripts. The following values are defined for <code>&lt;debugger&gt;</code> (uppercase/lowercase is irrelevant).</td>
</tr>
<tr>
<td></td>
<td><strong>auto</strong>: Automatically detects if a debugger is included in every script for the current process. At this time, only .NET-based debuggers can be detected automatically. A detected debugger overwrites the --enablescripttracing flag.</td>
</tr>
<tr>
<td></td>
<td><strong>.NET</strong>: Activates debugging for .NET-based debuggers, such as &quot;Python Tools for Visual Studio&quot; (PTVS) and SharpDevelop. With this option, a debugger can also be included in running scripts, as opposed to &quot;auto&quot;. Note: This is currently the default value when --scriptdebugger is used without providing a value.</td>
</tr>
<tr>
<td></td>
<td><strong>disabled</strong>: Deactivates debugging and automatic detection.</td>
</tr>
<tr>
<td></td>
<td><strong>script</strong>: Switches the IronPython script engine to debug mode for activating the debugging for set-trace debuggers. The script itself must connect to and disconnect from the debugger.</td>
</tr>
<tr>
<td></td>
<td><strong>tracing</strong>: Activates the simple integrated script tracing mode and deactivates the automatic detection (same as the option --scripttracing).</td>
</tr>
<tr>
<td></td>
<td>$absolute_path.py$**: Absolute path to a Python script that initiates the connection to a Python-based debugger. The IronPython script engine is switched to debug mode for allowing the debugging for set-trace debuggers. This script is run one time during the initialization and should define the following non-parameterized functions:</td>
</tr>
<tr>
<td></td>
<td>scriptdebuggersetup is run immediately before running the user script to establish the connection to the debugger.</td>
</tr>
<tr>
<td></td>
<td>scriptdebuggershutdown is called immediately after running the user script or when the script engine is downloaded and should close the connection to the debugger.</td>
</tr>
</tbody>
</table>
Examples of using transfer parameters in script files with 'sys.argv'

```
start /b /wait Automation Builder.exe
--runscript="D:\Script\ArgvAnd__main__Test.py"
--scriptargs:'username password 3.14 "path="C:\temp\"

Script file: ArgvAnd__main__Test.py

from __future__ import print_function
import sys
print("sys.argv: ", len(sys.argv), " elements:")
for arg in sys.argv:
    print(" - ", arg)
print() print("__name__: ", __name__)
```

Output result: stdout:
sys.argv: 6 elements:
- D:\TestScripts\ArgvAnd__main__Test.py
- username
- password
- 3.14
- path= "C:temp"
__name__: __main__

For more information about the __name__ global variable, see the Python documentation.

Examples of the message output

```
start /b /wait Automation Builder.exe --runscript="D:\Script\AmpelTest.py" --noUI 1>ScriptMessages.txt

CODESYS passes all messages that are generated by the script to the ScriptMessages.txt file. Other messages are printed to the command line.

start /b /wait Automation Builder.exe --runscript="D:\Script\AmpelTest.py" --noUI 2>NUL

CODESYS suppresses all messages, except for script messages. The script messages are printed to the command line.
The following initdebug.py script was tested successfully with pydevd-based debuggers, such as PyDev / LiClipse and PyCharm. To use this script, start CODESYS with the following command line:

```
--profile="Fanta Development Build" --scriptdebugger="D:\test\charmdebug\initdebug.py"
```

File: initdebug.py:

```python
from _future_ import print_function
from _future_ import unicode_literals
import sys
sys.path.append(r"D:\test\Env2\Lib\site-packages\pycharm-debug.egg")
import pydevd
def scriptdebuggersetup():
    pydevd.settrace('localhost', port=51234, stdoutToServer=True, stderrToServer=True)
def scriptdebuggershutdown():
    pydevd.stoptrace()
```

See also
- [http://docs.python.org/tutorial/modules.html](http://docs.python.org/tutorial/modules.html)

Option --ignorewhitespace (ignore whitespace in project comparison)

If you add this option after the option `--compare <project1> <project2>`, then whitespace is ignored in the project comparison. Note that semantically relevant spaces, for example in STRING literals, are still taken into account.

Syntax:

```
--compare="<path of project file>" "<path of reference project file>" --ignorewhitespace="true"|"false"
```

Example

```
Automation Builder.exe --compare "D:\proj\project1.project" "D:\proj\project2.project" --ignorewhitespace="true"
```

See also
- [Chapter 6.4.1.21.3.5.21 “Command ‘Compare’” on page 2607](#)

Option --ignorecomments (ignore comments in project comparison)

If you add this option after the option `--compare <project1> <project2>`, then comments are ignored in the project comparison.

Syntax:

```
--compare="<path of project file>" "<path of reference project file>" --ignorecomments="true"|"false"
```

Example

```
Automation Builder.exe --compare "D:\proj\project1.project" "D:\proj\project2.project" --ignorecomments="true"
```

See also
- [Chapter 6.4.1.21.3.5.21 “Command ‘Compare’” on page 2607](#)
If you add this option after the option `--compare <project1> <project2>`, then object properties (permissions, compile settings, directories, bitmaps, etc.) are ignored in the project comparison.

Syntax:

```
--compare="<path of project file>" "<path of reference project file>"
--ignoreproperties="true"|"false"
```

Example

```
Automation Builder.exe --compare "D:\proj\project1.project"
"D:\proj\project2.project" --ignoreproperties="true"
```

See also

- § Chapter 6.4.1.21.3.5.21 “Command ‘Compare’” on page 2607

CODESYS is started. In this case, the query as to whether unlicensed components should still be loaded is skipped. If so, then CODESYS does not load these components by implication.

Example

```
Automation Builder.exe --skipunlicensedplugins
```

If you add this option after the option `--project="<path of project file>"`, then the project is opened and the thumbprint of the certificate for signing compiled libraries is passed.

Syntax:

```
--signaturethumbprint="<thumbprint of digital signature>"
```

Example

```
Automation Builder.exe --project="D:\projects\test.project"
signaturethumbprint="3E96C9B61010CBDC31B6021A1CAA64946DDCAAF3"
```

See also

- § Chapter 6.4.1.21.3.4.18 “Command ‘Security Screen’” on page 2592

If you add this option after the option `--project="<path of project file>"`, then the “Enforce signing of compiled libraries” option is enabled in the project in the “Security Screen” on the “User” tab.

```
NOTICE!
When the “Security Screen” is opened and closed, the current settings are applied in the user options, even when no active changes have been made.
```

Syntax:

```
--enforcesignedcompiledlibraries="true"|"false"
```
Option --timestampingserverurl (set the time stamp server address)

If you add this option after the option --project="<path of project file>", then the Internet address of the RFC-3161 time stamp server ("Timestamping server") is set in the project in the “Security Screen” on the “User” tab.

**NOTICE!**

When the “Security Screen” is opened and closed, the current settings are applied in the user options, even when no active changes have been made.

Syntax:

--timestampingserverurl="<URL of RFC-3161 timestamping server>"

Example

Automation Builder.exe --timestampingserverurl="http://timestamp.comodoca.com/rfc3161"

See also

● § Chapter 6.4.1.21.3.4.18 “Command ‘Security Screen’” on page 2592

6.4.1.17 Using Libraries

6.4.1.17.1 Library repository

The library repository is the storage location on the development system for libraries and associated metadata. You can link any installed the libraries into your project by means of a library manager. Moreover, the libraries are installed with version management for easy library updates.

You can create and edit more repositories in addition to the preinstalled System repository.

§ Chapter 6.4.1.21.3.9.5 “Command ‘Library Repository’” on page 2657

6.4.1.17.2 Library Manager

In order to be able to use POU’s, which are provided in a library POU, in the application, the library has to be integrated in the Library Manager in the project. The requirement for this is the installation of the library in the library repository.

The Library Manager displays all integrated libraries according to their library type and the respective properties. In the Library Manager, you can add more libraries from the library repository, remove libraries, and edit library properties.
The Library Manager can be inserted into the “POUs” view or the “Devices” view. As a result, a project can have a Library Manager for each application, as well as a Library Manager in the “POUs” view for use across all applications. The library POUs of the integrated libraries in the “POUs” view can be called regardless of the application. The library POUs of the integrated libraries in the “Devices” view can be called in the respective application code only. Furthermore, placeholder libraries behave differently when downloading depending on their positions.

Libraries that are integrated to a specific version in the project also have a placeholder for that version (placeholder library). You can define special placeholder resolutions. You can also use the placeholder resolution that is defined for a device in the device description or that is stored in the library repository for a library. The Library Manager notifies you about the actual placeholder resolution and shows the version that will be loaded when an application is downloaded (effective version).

When a Library Manager in the “POUs” view is integrated across all applications, you can access its contents globally. If placeholder libraries are integrated, then only the placeholder resolutions in the device description or library repository are checked.

A Library Manager is usually integrated in the “Devices” view. Then only the application code below it calls library POUs from it. Moreover, the special placeholder resolutions are checked first for placeholder libraries. Only after that are the placeholder resolutions checked that are in the device description or that originate from the library repository.

In order to avoid consistency problems and to adequately support the user, be sure to adhere to certain rules for the creation, referencing, encryption, protection, and documentation of libraries. The following description provides only an overview of the library development possibilities. For a more detailed description of these topics, see the “LibDev-Summary” guidelines for library development.

See also
- Chapter 6.4.1.21.2.16 “Object 'Library Manager’” on page 2469
- Chapter 6.4.1.9.9 “Using Library POUs” on page 1890

6.4.17.3 Information for Library Developers

In order to avoid consistency problems and to adequately support the user, be sure to adhere to certain rules for the creation, referencing, encryption, protection, and documentation of libraries.

The following description provides only an overview of the library development possibilities. For a more detailed description of these topics, see the “LibDev-Summary” guidelines for library development.

See also
- Chapter 6.4.1.17 “Using Libraries” on page 2034

General
- You can define categories for libraries. The libraries are then displayed in the library repository below these categories.
- You can define a namespace for a library in order to enable unambiguous access to the integrated objects. The access becomes unambiguous by adding the namespace in front of the POU name:
  <namespace>.<variable name>
- Example: AC.Module
- You can open the POUs of unencrypted libraries (*.library) by double-clicking the respective entry in the Library Manager.
You can create the following library types:
- *.library: Implementation library (source code of the library)
- *.compiled-library, *.compiled-library-v3: Protected library; source code no longer accessible.
- *_Itfs.library: Interface library; contains only objects that are used for the interface definition of a component (for example, constants, structures, or interfaces) and do not generate any code.
- *_Cnt.library: Container library; does not contain any POUs; instead contains exclusively other libraries; therefore used to conveniently integrate an entire set of libraries whose POUs are published on the top level of the container library.

You can integrate external libraries into the application. External libraries are programmed outside of CODESYS in a different programming language, for example C.

Protection of libraries
- Source code protection:
  When a library is prepared in "compiled-library" format, the source code of the library POUs is no longer visible after the library is integrated into a project.
- Signing:
  In CODESYS V3 SP15 and higher, a certificate is always used for the signing of library projects (*.compiled-library-v3). The signing can be enforced by means of a setting in the security screen. Then for generating a compiled library, you need a certificate suitable for code signing in your user profile.
  For library projects that have to be compatible with CODESYS < V3 SP15 (*.compiled-library), only the less safe signing is possible with a private key and a corresponding token. These deprecated methods should only be used for reasons of compatibility. Settings are configured in the "Project Information" on the "Signing" tab.
  Note: For signing libraries, you should use compiler version 3.5.15.0 or higher because a better storage format is used.
- Licensing:
  You can protect libraries by means of a license (dongle or soft container). License-protected libraries can be installed in the library repository. However, for use in the project, the valid license has to exist on the computer. Licenses are managed in the License Manager.

Library versions
- You can have several versions of a library installed on the system at the same time.
- You can have several versions of a library integrated into your project at the same time. However, we do not recommend doing this. In this case, each of the libraries must be assigned a unique namespace and access to the symbols must be qualified. Examples: V1.SendBlob, V2.SendBlob

Referenced libraries
- You can integrate a library into other libraries (referenced libraries). The nesting can be of any depth.
- You can define whether referenced libraries should be visible in the Library Manager.
- You can integrate referenced libraries via library placeholders. This way you avoid the problems that could occur due to version dependencies or the necessity to use vendor-specific libraries.

See also
- Chapter 6.4.1.3.4.2 “Retrieving and Editing Project Information” on page 1813

Adding a Library to the Application
The following instructions describe how to integrate for example the library Util into your application in order to use its library POUs.
6.4.1.17.5 Adding a library to the repository

The following instructions describe how to install a library in the library repository.

1. Select the command “Tools ➤ Library Repository”.
   ⇒ The dialog box “Library Repository” opens.
2. Click on the “Install” button.
3. Select the library that you wish to install. You can set a file filter here. Click on “Open”.
   ⇒ The library is added to the repository. The library can now be added in the Library Manager.

See also
- Chapter 6.4.1.17.4 “Adding a Library to the Application” on page 2036

6.4.1.17.6 Exporting library files

You can export a library from the library manager of a project or from the library repository and then save it as a file to the hard disk.

Export from the library manager

1. Open a library manager of an application in a project.
2. Select a library in the library manager.
3. Click the export command in the context menu.
   ⇒ The “Export Library” dialog box opens.
4. If the selected library is linked in the project not only as a compiled library, but also in source format, then both file types are in the drop-down list for “File type”. Otherwise, the filter automatically shows the available type: “*.library” or “*.compiled-library”.
5. Select the file type and storage location and click “Save”.

Export from the library manager

1. Open the CODESYS library repository (“Tools” menu).
2. Select a library version in the window of the installed libraries.
3. Click the "Export" button.
   ⇒ The “Export Library” dialog box opens.

4. As step 4 and 5 for "Export from the library manager”.

See also
- Chapter 6.4.1.21.2.16 “Object 'Library Manager'” on page 2469
- Chapter 6.4.1.21.3.9.5 “Command 'Library Repository'” on page 2657

6.4.1.18 Managing devices
6.4.1.18.1 General
CODESYS manages the installed devices in the device repository. A device repository is a defined location in the file system. In the default CODESYS installation, it is defined with an absolute path as the system repository. You install or uninstall devices in the “Device Repository” dialog. The system installs a device by reading the device description file. The properties of a device are defined in these files regarding configurability, programmability, and possible connections to other devices.
You can use the devices provided in the device repository by adding them to the device tree of your project.

See also
- Chapter 6.4.1.21.3.9.8 “Command 'Device Repository’” on page 2663
- Chapter 6.4.1.18.2 “Installing devices” on page 2038

6.4.1.18.2 Installing devices
Install a device in the device repository in order to include it in your project.
1. Click “Tools ➔ Device Repository”.
   ⇒ The “Device Repository” dialog box opens.
2. Select the install location. “System Repository” is set by default.
3. Click “Install”.
   ⇒ The “Install Device Description” dialog box opens.
4. Select the file path of the device description.
5. Select the file type filter of the required device description.
   ⇒ All device descriptions of the selected file type are listed.
6. Select the required device description and click “Open”.
   ⇒ CODESYS adds the device description to the matching category of your device repository.
   If errors occur during installation (for example, missing files that are referenced by the device description), then CODESYS displays them in the lower part of the device repository dialog box.

See also
- Chapter 6.4.1.21.3.9.8 “Command 'Device Repository’” on page 2663
6.4.1.19 Security

6.4.1.19.1 General

Due to the increased networking of controllers and plants, potential threats are also quickly rising. Therefore, you should carefully consider all possible security measures.

Security measures are absolutely necessary to protect data and communication channels from unauthorized access.

On the following help pages, you can learn more about the safety functions of CODESYS and the controller.

6.4.1.19.2 General Information

The following provides some general information about safety functions (security measures). This information applies regardless of the usage in CODESYS or one with a connection controller.

Access protection with user management

As a means of protecting against unauthorized access to data, it is necessary to configure user accounts with specific access rights. Only a user with the credentials has access to the data or functions.

Creating passwords according to the general recommendations for achieving a high password strength is a tremendous contribution to security.

The following types of user management are roughly distinguished as follows:

- Simple user management:
  To access data, only a password or the valid combination of user name and password has to be entered. This means that access can only be granted or denied. Graduated permissions cannot be configured.

- Group-based user management:
  The access rights are assigned to user groups. Users who belong to a group can access the data or functions after entering the credentials with precisely these assigned and different permissions.

Encryption, signature

Encryption:

Encryption of data means the following: Data is converted into an unreadable form and can only be made readable again with a matching key. In the simplest case, the key is a password or a key pair.

There are two types of encryption methods:
Symmetric method: (the only type of encryption until the mid-1970s)

- Characteristic: Use of a secret key
- Advantages: Fast, simple encoding
- Disadvantages: The key has to be shared secretly.

Asymmetric method:

- Characteristic: Use of a key pair (private/secret key and public key)
- Advantages: The public key can be made accessible to anyone, and authentication possible with it.
- Disadvantages: Slow (approx. 1,000 to 10,000 times slower than symmetric methods); complex encoding; long key lengths

Key exchange is usually performed by asymmetric methods; encryption and decryption by symmetric methods.

Signature:

In order for the irrefutable ownership and integrity of a message to be verifiable, it should be provided with a signature. These are usually the steps involved:

- Sender: Determines a unique hash value over the data (H)
- Sender: Encrypts the hash value with private key (He)
- Recipient: Also calculates the hash value and decrypts the He with the public key and compares the two values. This allows the sender to be identified uniquely and verifies that the sender owns the private key.

In the case of asymmetric encryption, a public key contained in a certificate is first exchanged between the sender and the recipient. In addition, each participant needs a private key with which they can decrypt the data if they have the certificate. So if you want to access a certificate, you need a certificate AND a private key.

Hash methods are necessary for this:

- Hash method:
  - Characteristic: Unique thumbprint of the data (for example, checksum of the data)
  - As low a collision as possible (it is very difficult to find / construct two different data for a single hash value)

Certificates

In order to assign the public key to an identity, it is usually embedded in a certificate.

In certificate-based systems, each user receives a digital certificate. The certificate is used for digital identification. It contains information about the identity and the public key of the user.

Each certificate is authenticated by an issuing authority, which in turn may be authenticated by higher authorities. The trust system of this PKI (Public Key Infrastructure) is strictly hierarchical. The common trust anchor is a root certificate.

Contents of a certificate:

- Version
- Serial number
- Algorithm ID
- Issuer (authority or company)
- Validity from (not before) to (not after)
- Certificate owner (subject)
- Certificate owner key information (subject public key)
  - Public key algorithm
  - Public key of the certificate owner
- Unique ID of the issuer (optional)
- Unique ID of the owner (optional) The owner possess a private key matching the public key.
- Extensions
  - Purpose (extended key usage)
  - ...

The certificate consists of 2 parts/files:
• Public X.509 certificate (can be issued to anyone)
• Private key that matches the certificate or its public key only (has to be kept secret).

To manage the certificates in your local "Windows Certificate Store", see the following help page:

• Chapter 6.4.1.6 "Protecting and Saving Projects" on page 1819

6.4.1.19.3 Security for the development system

In CODESYS, you can apply access protection to projects, libraries, as well as individual applications. In addition to a simple write protection for a project, a user management (credentials, access rights) and encryption using certificates should be used.

See current help:

• Chapter 6.4.1.6 "Protecting and Saving Projects" on page 1819
• Chapter 6.4.1.9.18 "Protecting an application" on page 1915

6.4.1.19.4 Security for the Runtime/PLC

Communication with the controller connected in the CODESYS project should be protected against unauthorized access in the following ways:

• Enabling user management: simple or group-based
• Certificate-based encryption of communication with the controller

Enabling the security features

First switch the communication to encryption so that you do not reveal any credentials to other participants in the network when transferring the user management.

Enforcing encrypted communication

• On the controller:
  – Runtime version >= 3.5 SP14: Encryption can be enabled for “Communication Policy” and enforced for all clients.

• In CODESYS:
  – Encrypted communication can be selected as an option in the device editor on the “Communication Settings” tab (command or “Change Communication Policy” dialog) or in the “Security Screen” view.

    See the current help regarding this:
    • Chapter 6.4.11.3 “Encrypting Communication, Changing Security Settings” on page 1967

    If the CODESYS Security Agent is installed, then see the help for CODESYS Security Agent.

Enforcing a user management

• On the controller:
  – Runtime version >= 3.5 SP17: User management is enforced by default for “Communication Policy”.

    Note: For enabling the user management, at least a CODESYS development system V3.5 SP16 is necessary. This means that, in the case of enforced user management which has not been enabled yet, you cannot connect to an older development system.

• In CODESYS:
  – See the current help regarding this:
    • Chapter 6.4.11.3 “Encrypting Communication, Changing Security Settings” on page 1967
    • Chapter 6.4.11.4 “Handling of Device User Management” on page 1971
6.4.19.5 Security for CODESYS WebVisu

Protect the connection between the web server of the controller and the visualization client with the following measures against unwanted access:

- Configure an HTTPS connection (encryption with SSL/TSL) between the visualization client and the web server.
- Restrict access to the visualization and configure a visualization user management.

Configure an encrypted connection.

An HTTPS connection between the web server and the visualization client requires authentication of the web server by means of a certificate. You can create a self-signed certificate in the "Security Screen".

1. Click “View ➔ Security Screen”.
2. Create a certificate for the web server on your controller.
   - The certificate data for the web server is displayed.
3. Stop your controller.
4. Restart the controller.
   - The new certificate is active.
5. Download your application to the controller.
6. Open your browser and specify the URL address of your web server.
   - The URL of a secure connection corresponds to the following format:
     https://<IP address/URL>:443/<name of HTM file>.htm

   - The HTML file name has to match the configured name as it is set in the "Visualization Manager" object below the WebVisu variant. You will find the IP address of the controller in the device editor when a connection is active.
   - Example: https://localhost:443/webvisu.htm
     - The browser establishes a connection. If the certificate is not rated as trusted, then a security notice appears.
7. Confirm that you know the risk and want to proceed.
   - You have created self-signed certificate and confirmed it as trusted.
   - Now start the web application with the visualization. The lock symbol in the browser indicates secure communication.

See the chapter "Run as CODESYS WebVisu", which describes in detail how you use certificates in the security screen.

See also

- Chapter "Run as CODESYS WebVisu"
- Chapter "User management of the visualization"
- Chapter 6.4.1.11.3 "Encrypting Communication, Changing Security Settings" on page 1967
- Chapter 6.4.1.11.4 "Handling of Device User Management" on page 1971
6.4.19.6 FAQ

6.4.19.6.1 Certificate expired

If the certificate from the controller for encrypted communication has expired (valid from "not before" until "not after"), you get a prompt with a corresponding message in CODESYS when you attempt to access the controller. For example, to renew the expired certificate, you can accept the expired certificate and connect to the controller.

You will see this message again every time you try to login until a valid certificate is installed on the controller.

If you have created or imported a new certificate on the controller, then this new certificate will be available for you to accept the next time you login.

See also

- Chapter 6.4.11.3 “Encrypting Communication, Changing Security Settings” on page 1967

6.4.19.6.2 New certificate (while the current one is still valid)

A new certificate can be issued before the existing certificate expires. This makes it possible for the encrypted communication to continue seamlessly. As soon as a new certificate is available on the controller parallel to the one currently used, the new certificate will be offered by the controller at the next login attempt. All you have to do is accept it.

See also

- “Installing a controller certificate for encrypted communication via the PLC shell of the device editor” on page 1969

6.4.19.6.3 Client does not support security feature

User management

The following CODESYS clients do not support user management yet:

- WebServer < V3.5.14.0

In order for these clients to be able to establish a connection to the controller, the user management must not be enabled.

Encrypted communication

The following CODESYS clients do not support encrypted communication yet:
Data servers with compiler version =< V3.5.9.0
- WebVisu < V3.5.14.0 or in the case of enabled file transfer
- WebServer < V3.5.14.0
- Remote TargetVisu
- Data source ApplicationV3
- OPC Server V3
- PLCHandler < V3.5.14.0

In order for these clients to be able to establish a connection to the controller, the encrypted communication can be set as optional. Therefore clients can establish either an encrypted or an unencrypted connection.

Do not use the same user or password for encrypted and unencrypted communication.

See also
- Chapter 6.4.1.11.3 “Encrypting Communication, Changing Security Settings” on page 1967

CA-signed certificates preferred (PLC shell)

Using CA-signed certificates is not conveniently supported yet in CODESYS. However, you can still request and use these types of certificates. In the device editor, on the “PLC Shell” tab, you export the required CSR files to the file system and import from there the CER files sent from the certification authority.

Requesting and providing a CA-signed certificate

1. You are connected to the controller.
2. First you generate certificate signing requests (CSR) of all server certificates.
   For this purpose, click the “PLC Shell” tab of the controller and type the command `cert-createcsr` in the input line.
3. Click the “Log” tab and then the refresh button (⟳).
   ⇒ In the log entries, you can see that the CSR files were generated.
4. Click the “Files” tab and open the file path `cert/export` in the right side of the “Runtime” dialog.
   ⇒ The export folder contains the generated CSR files, for example `0_CmpsecureChannel.csr, 1_CmpApp.csr, 2_CmpWebServer.csr`.
5. Select a file path where you wish to insert the CSR files in the left side of the “Host” dialog,
   mark the CSR files in the right side of the dialog, and click `<<`.
   ⇒ The CSR files are copied to the required folder.
6. These requests can be signed for certification signing by a certificate authority (CA), and then you receive a signed certificate from the certification authority.
6. In the steps that follow, you import these signed server certificates to your controller.

**NOTICE!**

Caution: Self-signed certificates of the server must be deleted before importing the CA-signed certificates.

7. Select the “Path” cert/import in the right side of the “Runtime” dialog.

8. In the left side of the “Host” dialog, select the path in the file system where you saved the signed certificates and selected the certificates.

9. Click ➤ .

   ➤ The certificates are copied to the cert/import folder.

10. Click the “PLC Shell” tab.

11. Type the command `cert-import own <file name of the certificate.cer>` in the input line of the tab and press the [Enter] key.

    ➤ The signed certificates are available to the runtime system servers.

**See also**

- +% Chapter 6.4.1.21.2.8.11 “Tab 'PLC Shell'” on page 2441
- +% Chapter 6.4.1.21.2.8.9 “Tab 'Log'” on page 2437
- +% Chapter 6.4.1.21.2.8.8 “Tab 'Files'” on page 2437

**Problems at login**

If you have entered an incorrect password when logging in to the user management of the controller, then the login dialog reappears immediately afterwards. After three incorrect attempts, the controller is locked for a defined period of time. However, stricter policies on the controller can lead to the user being locked out and only authorized again by an administrator.

**See also**

- +% Chapter 6.4.1.21.3.7.2 “Command 'Login'” on page 2624

**Disabling User Management**

**NOTICE!**

After disabling the user management, your controller is accessible again for everyone in the network of the controller. Therefore, you should only do this in justified exceptional cases or if the clients used do not support any user management.

For enabling the user management, at least a CODESYS development system V3.5 SP16 is necessary. This means that, in the case of enforced user management which has not been enabled yet, you cannot connect to an older development system.
1. If the security policy for device user management is set to "Enforced", first set it back to "Optional".

2. Execute the "Reset Origin Device" command. This deletes the user management and you can then reconnect to the controller without having to enter user credentials. Note: In CODESYS Version 3.5 SP16 Patch 20 and higher, you can exclude the boot application from the delete operation when you execute "Reset Origin Device".

See also
- "Changing the communication policy (encryption, user management)" on page 1970
- Chapter 6.4.1.21.3.7.13 "Command 'Reset Origin Device'" on page 2636
- Chapter 6.4.1.11.4 "Handling of Device User Management" on page 1971
- Chapter 6.4.1.6 "Protecting and Saving Projects" on page 1819

Permitting encrypted communication again

Remember that not every controller supports the deactivation of encrypted communication.

NOTICE!
We strongly advise against disabling encrypted communication. Especially in connection with an enabled user management, encrypted communication should be enabled so that credentials do not fall into the wrong hands.

To disable encrypted communication with the controller again, proceed as follows:

1. If the communication policy for encrypted communication is set to "Enforced", first set it back to "Optional".

2. In the device editor, on the "Communication Settings" tab in the "Device" menu, disable "Encrypted communication". If you have installed the CODESYS Security Agent, then you can also change the setting in the "Security Screen".

   CODESYS establishes unencrypted communication again with the controller. Other clients can also communicate again without encryption.

See also
- Chapter 6.4.1.11.3 “Encrypting Communication, Changing Security Settings” on page 1967
- Chapter 6.4.1.21.3.4.18 “Command 'Security Screen'” on page 2592
### 6.4.1.20 Programming Languages and Editors

- **6.4.1.20.1 Introduction**
- **6.4.1.20.2 Declaration Editor**
- **6.4.1.20.3 Common functions in graphical editors**
- **6.4.1.20.4 Structured Text and Extended Structured Text (ExST)**
- **6.4.1.20.5 Sequential Function Chart (SFC)**
- **6.4.1.20.6 Function Block Diagram / Ladder Diagram / Instruction List (FBD/LD/IL)**
- **6.4.1.20.7 Continuous Function Chart (CFC) and Page-Oriented CFC**

## Introduction

You program a POU in each case in the editor for the implementation language that you selected when creating the POU. CODESYS offers a text editor for ST and graphic editors for SFC, FBD/LD/IL and CFC.

The editor opens with a double-click on the POU in the device tree or in the “POUs” view.

Each of the programming language editors consists of two sub-windows:

- In the upper part you make declarations in the “declaration editor”, in text or tabular form depending on the setting.
- In the lower part you insert the implementation code in the respective language.

You can configure the display and the behavior of each editor project-wide on the associated tab of the CODESYS options.

## Declaration Editor

In the declaration editor, you declare variables in variable lists and POUs.

If the declaration editor is used with an implementation language editor, then it opens in a view above the implementation language editor.

The declaration editor offers two possible views: textual and tabular. In the “Tools > Options > Declaration Editor” dialog, you define whether only the textual view or only the tabular view is available, or whether you can switch between both views by means of the buttons on the right side of the editor view.

A rectangle selection is possible in the textual view of the declaration editor. The key combinations for the rectangle selection are located on the help page for the ST editor.

See also

- § Chapter 6.4.1.9.4.2 “Using the declaration editor” on page 1851
- § Chapter 6.4.1.9.4 “Declaration of Variables” on page 1847
In online mode, you see the tabular view of the editor. The header always contains the current object path: `<device name>..<application name>..<object name>`. In contrast to offline mode, the table also contains the "Value" and "Prepared Value" columns.

The "Value" column shows the actual value on the PLC, offering monitoring functionality. If the expression is an array with more than 1,000 elements, then you can define the range of the array indices to monitor. To do this, double-click in the "Data Type" column to open the "Monitoring Area" dialog. In this dialog, the declared array range is specified as the "Valid area" for monitoring. A maximum of 20,000 elements can be monitored per array. You define the range of the array indices to be monitored by specifying the "Start" and "End" indices. In order to move this area more easily while maintaining the same size, the available scrollbars can be used coupled. To toggle between coupled and not coupled, click the symbol on the right of the bar. In non-coupled state, you can increase or decrease the size of the area to be monitored as desired.

The "Prepared Value" column contains the value that you prepared for forcing or writing. If you double-click a "Prepared value" field, then you can specify a value explicitly for writing or forcing. In the case of enumerations, a combo box opens from which you can select a value. In the case of a Boolean variable you can toggle the prepared value with the help of the [Enter] key or the [Space] bar. If an expression (variable) is of a structured data type, for example the instance of a function block or an array variable, then a plus or a minus sign is placed in front. You can customize the format of the representation of floating-point values in the options for monitoring.

See also

- Chapter 6.4.1.9.4.2 “Using the declaration editor” on page 1851
- Chapter 6.4.1.21.4.8 "Dialog Box 'Prepare Value'" on page 2749
- “Forcing in the declaration part” on page 1988
- Chapter 6.4.1.21.4.14.19 “Dialog 'Options' - 'Monitoring'” on page 2792

Common functions in graphical editors

The implementation part of the graphical editors for FBD, LD, CFC, and SFC contains a toolbar in the lower right corner.

- Return to normal editing mode: The mouse pointer changes back to the shape of the default arrow. You can select and edit elements in the editor view.

- Panning tool: The mouse pointer changes to the shape of two crossed arrows. You can click and drag anywhere in the editor view to move the visible area of the FBD/LD/IL editor or also pivot a CFC chart.

- Magnification tool: A magnified window opens in the lower right corner of the editor view and the mouse pointer changes to the shape of a cross. As you move the mouse pointer over your diagram, the magnification tool shows the area of the diagram under the cross at 100% magnification. Note: If you click in the view, then the magnification tool closes and the part of the diagram that the tool contained is displayed at 100% magnification. If you want to retain the set zoom factor, then you should use the default arrow ( ) for returning to the default editing mode.

- Zooming tool: This opens a drop-down list with a selection of zoom factors. Clicking more selections ( . . . ) will open the “Zoom” dialog for typing other values. The current zoom factor is always shown to the left of the symbol.
Zooming with the scroll wheel: By holding down the [Ctrl] key and moving the scroll wheel, you can change the zoom factor in steps of 10%.

Every graphical editor has its own “ToolBox” view that is located on the right of the editor view by default. The toolbox contains elements that you can drag to insertion points in the editor view. CODESYS highlights the insertion points with gray position flags in the shape of diamonds, triangles, or arrows. These flags are green when you move the mouse pointer over them. When you release the mouse button, CODESYS inserts the element at the selected position.

It is also possible to use the mouse for moving elements in the editor.

You can drag function block declarations in the FBD, LD, and CFC graphical editors to the editor view. To do this, select the full declaration (variable name and data type) and drag it to a suitable position in the editor view. In the ladder diagram, you can also drag Boolean declarations to the editor and insert them as contacts.

See also
- Chapter 6.4.1.20.1.5.1 “SFC editor” on page 2062
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082
- Chapter 6.4.1.20.1.7.2 “CFC Editor” on page 2098

Structured Text and Extended Structured Text (ExST)

6.4.1.20.1.4.1 ST Editor........................................................................................................... 2049
6.4.1.20.1.4.2 ST editor in online mode.................................................................................. 2050
6.4.1.20.1.4.3 ST expressions................................................................................................ 2050
6.4.1.20.1.4.4 Assignments ................................................................................................. 2051
6.4.1.20.1.4.5 Statements.................................................................................................... 2055

ST Editor

The ST editor is a textual editor used for the implementation of code in Structured Text (ST) and Extended Structured Text (ExST).

The line numbering is displayed on the left side of the editor. When inputing programming elements, the "List components" functionality (activated in the CODESYS options, “SmartCoding” category) and the Input Assistant [F2] are also useful. When the cursor is placed over a variable, CODESYS shows a tooltip with information for declaring variables.

The box selection can be made with the following key combinations:
- [Shift]+[Alt]+[Arrow Right]: The selected area is extended one position to the right.
- [Shift]+[Alt]+[Arrow Left]: The selected area is extended one position to the left.
- [Shift]+[Alt]+[Arrow Up]: The selected area is extended one position up.
- [Shift]+[Alt]+[Arrow Down]: The selected area is extended one position down.

The behavior (for example parentheses, mouse actions, tabs) and appearance of the editor are configured in the CODESYS options in the “Text Editor” category.

For an incremental search for strings in the editor, open an input field at the bottom edge of the editor by means of the key combination [Ctrl]+[Shift]+[i]. As soon as you start typing in characters, the corresponding search locations are highlighted in color in the editor. The number of found matches is shown to the right of the input field. You can set the cursor at the search location by using the arrow keys or the key combinations [Alt]+[Page Up] or [Alt]+[Page Down].

When you place the cursor on a symbol name, all occurrence locations of the symbol within the editor are highlighted in color. The search locations correspond to the hits in the cross-reference list. For very large projects, this can cause input delays. In this case, you can disable the function in the options of the text editor.

CODESYS identifies syntax errors already when inputing in the editor and shows the corresponding messages in the message view (“Precompile” category). If the corresponding option is selected in the CODESYS options (“SmartCoding” category), then the error locations in the text are also underlined with a wavy red line.
The “Format Document” command provides an automatic formatting of syntactically correct ST code.

See also

- Chapter 6.4.1.5.4.2 “Programming structured text (ST)” on page 1879
- Chapter 6.4.1.20.1.4.3 “ST expressions” on page 2050
- Chapter 6.4.1.20.1.4.5.11 “ST – Comments” on page 2061
- Chapter 6.4.1.20.1.4 “Structured Text and Extended Structured Text (ExST)” on page 2049
- Chapter 6.4.1.21.4.14.26 “Dialog ‘Options’ - ‘Text Editor’” on page 2798
- Chapter 6.4.1.21.3.4.5 “Command ‘Messages’” on page 2583
- Chapter 6.4.1.21.3.3.45 “Command ‘Advanced’ - ‘Format Document’” on page 2581

ST editor in online mode

In online mode CODESYS displays the variables and expressions in the ST editor. The writing and forcing of the variables and expressions as well as debugging functions (breakpoints, single step execution) are also possible.

If you use assignments as expressions in ST programming, no further breakpoint positions are created within a line.

See also

- Chapter 6.4.1.13.2.2 “Calling of monitoring in programming objects” on page 1996
- Chapter 6.4.1.12.5 “Forcing and Writing of Variables” on page 1987
- Chapter 6.4.1.13.2.3 “Using watch lists” on page 2002
- Chapter 6.4.1.12.3 “Using Breakpoints” on page 1981
- Chapter 6.4.1.12 “Testing and Debugging” on page 1980
- Chapter 6.4.1.12 “Testing and Debugging” on page 1980
- Chapter 6.4.1.12.4 “Stepping Through a Program” on page 1985
- Chapter 6.4.1.12.7 “Flow Control” on page 1992
- Chapter 6.4.1.12.8 “Determining the current processing position with the call stack” on page 1994

ST expressions

An expression is a construct that returns a value following its evaluation.

Expressions are composed of operators and operands. In Extended Structured Text (ExST) you can also use assignments as expressions. An operand can be a constant, a variable, a function call or a further expression.

<table>
<thead>
<tr>
<th>Examples</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2014</td>
<td>(* Constant *)</td>
</tr>
<tr>
<td>iVar</td>
<td>(* Variable *)</td>
</tr>
<tr>
<td>fct(a,b)</td>
<td>(* Function call *)</td>
</tr>
<tr>
<td>(x*y)/z</td>
<td>(* Expression *)</td>
</tr>
<tr>
<td>real_var2 := int.var;</td>
<td>(* in ExST: Assignment *) *</td>
</tr>
</tbody>
</table>

See also

- “ExST - Extended structured text” on page 1879

Evaluation of expressions

The evaluation of an expression takes place by processing the operators according to certain rules of binding. CODESYS processes the operator with the strongest binding first. Operators with the same binding strength are processed from left to right.
<table>
<thead>
<tr>
<th>Operation</th>
<th>Symbol</th>
<th>Binding strength</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parenthesize</td>
<td>(Expression)</td>
<td>Strongest binding</td>
</tr>
<tr>
<td>Function Call</td>
<td>Function name (parameter list)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>all operators with syntax: &lt;operator&gt; ()</td>
<td></td>
</tr>
<tr>
<td>Exponentiate</td>
<td>EXPT</td>
<td></td>
</tr>
<tr>
<td>Negate Complementation</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Multiplication</td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>Division</td>
<td>/</td>
<td></td>
</tr>
<tr>
<td>Modulo</td>
<td>MOD</td>
<td></td>
</tr>
<tr>
<td>Addition</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Subtraction</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Comparison</td>
<td>&lt;,&gt;,&lt;,,&gt;=</td>
<td></td>
</tr>
<tr>
<td>Equality</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Inequality</td>
<td>&lt;&gt;</td>
<td></td>
</tr>
<tr>
<td>Bool AND</td>
<td>AND</td>
<td></td>
</tr>
<tr>
<td></td>
<td>AND_THEN</td>
<td></td>
</tr>
<tr>
<td>Bool XOR</td>
<td>XOR</td>
<td>Weakest binding</td>
</tr>
<tr>
<td>Bool OR</td>
<td>OR</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OR_ELSE</td>
<td></td>
</tr>
</tbody>
</table>

See also
- Chapter 6.4.1.20.3 “Operators” on page 2129

Assignments

6.4.1.20.1.4.4.1  ST assignment operator……………………………………………… 2051
6.4.1.20.1.4.4.2  ST assignment operator for outputs…………………………………….. 2052
6.4.1.20.1.4.4.3  ExST assignment ‘S=’……………………………………………………… 2052
6.4.1.20.1.4.4.4  ExST assignment ‘R=’……………………………………………………… 2053
6.4.1.20.1.4.4.5  ExST – Assignment as expression………………………………………. 2054
6.4.1.20.1.4.4.6  Assignment Operator ‘REF=’………………………………………….. 2054

ST assignment operator

Syntax:

<operand> := <expression>

This assignment operator executes the same function as the MOVE operator.

See also
- Chapter 6.4.1.20.3.7 “Operator MOVE” on page 2137
ST assignment operator for outputs

The assignment operator => assigns the output of a function, a function block, or a method to a variable. The position on the right side of the operator can also be blank.

Syntax

<output> => <variable>

Example

FBcomp_Output1 => bVar1;
FBcomp_Output2 => ;

FBcom_Output1 and FB_Output2 are outputs of a function block. The value of FBcom_Output1 is assigned to the variable bVar1.

ExST assignment 'S='

When the operand of the Set assignment switches to TRUE, then TRUE is assigned to the variable to the left of the operator. The variable is set.

<variable name> S= <operand name> ;

The variables and the operand have the data type BOOL.

Example

PROGRAM PLC_PRG
VAR
  xOperand: BOOL := FALSE;
  xSetVariable: BOOL := FALSE;
END_VAR

  xSetVariable S= xOperand;

When the operand xOperand switches from FALSE to TRUE, then TRUE is also assigned to the variable xSetVariable. But then the variable keeps this state, even if the operand continues to change its state.

Multiple assignments

NOTICE!

In the case of multiple assignments within a code line, the individual assignments are not processed from right to left, but all assignments refer to the operands at the end of the code line.
FUNCTION funCompute : BOOL
VAR_INPUT
  xIn : BOOL;
END_VAR
IF xIn = TRUE THEN
  funCompute := TRUE;
RETURN;
END_IF

PROGRAM PLC_PRG
VAR
  xSetVariable: BOOL;
  xResetVariable: BOOL := TRUE;
  xVar: BOOL;
END_VAR
xSetVariable S= xResetVariable R= funCompute(xIn := xVar);
xResetVariable gets the R= assignment of the return value of funCompute.
xSetVariable gets the S= assignment of ht return value of funCompute, but not from xResetVariable.

See also
- “ExST - Extended structured text” on page 1879
- Chapter 6.4.1.20.1.4.4.4 “ExST assignment 'R='” on page 2053

ExST assignment 'R='
When the operand of the Reset assignment switches to TRUE, then FALSE is assigned to the variable to the left of the operator. The variable is reset.
<variable name> R= <operand name> ;
The variables and the operand have the data type BOOL.

Example

VAR
  xOperand: BOOL := FALSE;
  xResetVariable: BOOL := TRUE;
END_VAR
xResetVariable R= xOperand;

When the operand xOperand switches from FALSE to TRUE, then FALSE is also assigned to the variable xResetVariable. But then the variable keeps its state, even if the operand continues to change its state.

Multiple assignments

NOTICE!
In the case of multiple assignments within a code line, the individual assignments are not processed from right to left, but all assignments refer to the operands at the end of the code line.
Example

```plaintext
FUNCTION funCompute : BOOL
VAR_INPUT
  xIn : BOOL;
END_VAR
IF xIn = TRUE THEN
  funCompute := TRUE;
RETURN;
END_IF

PROGRAM PLC_PRG
VAR
  xSetVariable: BOOL;
  xResetVariable: BOOL := TRUE;
  xVar: BOOL;
END_VAR
xSetVariable := xResetVariable R= funCompute(xIn := xVar);
```

See also

- “ExST - Extended structured text” on page 1879
- Chapter 6.4.1.20.1.4.4.3 “ExST assignment ’S=’” on page 2052

ExST – Assignment as expression

In ExST, as an extension to the IEC 61131-3 standard, CODESYS permits the use of assignments as expressions.

<table>
<thead>
<tr>
<th>Examples</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>int_var1 := int_var2 := int_var3 + 9;</code></td>
<td>(‘int_var1 and int_var2 receive the value of int_var3 + 9 ’)</td>
</tr>
<tr>
<td><code>real_var1 := real_var2 := int_var;</code></td>
<td>(‘real_var1 and real_var2 receive the value of int_var ’)</td>
</tr>
<tr>
<td><code>int_var := real_var1 := int_var;</code></td>
<td>(‘incorrect assignment, the data types do not correspond! ’)</td>
</tr>
<tr>
<td>IF b := (i = 1) THEN i := i + 1; END_IF</td>
<td></td>
</tr>
</tbody>
</table>

See also

- “ExST - Extended structured text” on page 1879

Assignment Operator ‘REF=’

The operator generates a reference (pointer) to a value.

Syntax:

```
<variable name> REF= <variable name>;  
```
**Example**

```plaintext
refA : REFERENCE TO DUT;
B : DUT;
C : DUT;

A REF= B; // corresponds to A := ADR(B);
A := C; // corresponds to A^ := C;
```

See also

- § Chapter 6.4.1.20.5.14 “Reference” on page 2245
- § Chapter 6.4.1.21.3.13.8 “Command 'REF= (Reference Assignment)’” on page 2687

**Statements**

- 6.4.1.20.1.4.5.1 ST statement 'IF'................................................................. 2055
- 6.4.1.20.1.4.5.2 ST instruction 'FOR'.......................................................... 2056
- 6.4.1.20.1.4.5.3 ST instruction 'CASE'....................................................... 2057
- 6.4.1.20.1.4.5.4 ST instruction 'WHILE'...................................................... 2058
- 6.4.1.20.1.4.5.5 ST Statement 'REPEAT'.................................................. 2058
- 6.4.1.20.1.4.5.6 ST statement 'RETURN'.................................................. 2059
- 6.4.1.20.1.4.5.7 ST instruction 'JMP'....................................................... 2059
- 6.4.1.20.1.4.5.8 ST instruction 'EXIT'...................................................... 2060
- 6.4.1.20.1.4.5.9 EXST Statement 'CONTINUE'........................................... 2060
- 6.4.1.20.1.4.5.10 ST function block call.................................................. 2060
- 6.4.1.20.1.4.5.11 ST – Comments.................................................................... 2061

**ST statement 'IF'**

The **IF** statement is used for checking a condition and, depending on this condition, for executing the subsequent statements.

A condition is coded as an expression that returns a Boolean value. If the expression returns **TRUE**, then the condition is fulfilled and the corresponding statements after **THEN** are executed. If the expression returns **FALSE**, then the following conditions, which are identified with **ELSIF**, are evaluated. If an **ELSIF** condition returns **TRUE**, then the statements are executed after the corresponding **THEN**. If all conditions return **FALSE**, then the statements after **ELSE** are executed.

Therefore, at most one branch of the **IF** statement is executed. **ELSIF** branches and the **ELSE** branch are optional.

**Syntax**

```plaintext
IF <condition> THEN
 <statements>
 ( ELSIF <condition> THEN
   <statements> )* 
 ( ELSE
   <statements> )?
END_IF;
// // { ... }* None, once or several times
// // { ... }? Optional
```
Example

PROGRAM PLC_PRG
VAR
  iTemp: INT;
  xHeatingOn: BOOL;
  xOpenWindow: BOOL;
END_VAR

IF iTemp < 17 THEN
  xHeatingOn := TRUE;
ELSIF iTemp > 25 THEN
  xOpenWindow := TRUE;
ELSE
  xHeatingOn := FALSE;
END_IF;

The program is run as follows at runtime:
For the evaluation of the expression iTemp < 17 = TRUE, the subsequent statement is executed and the heating is switched on. For the evaluation of the expression iTemp < 17 = FALSE, the subsequent ELSIF condition iTemp > 25 is evaluated. If this is true, then the statements in ELSIF are executed and the view is opened. If all conditions are FALSE, then the statement in ELSE is executed and the heating is switched off.

See also
- Chapter 6.4.1.20.1.4.3 “ST expressions” on page 2050

ST instruction ‘FOR’

The FOR loop is used to execute instructions with a certain number of repetitions.

Syntax:
FOR <counter> := <start value> TO <end value> {BY <increment>} DO <instructions>
END_FOR;

The section inside the curly parentheses {} is optional.
CODESYS executes the <instructions> as long as the <counter> is not greater, or - in case of negative increment - is not smaller than the <end value>. This is checked before the execution of the <instructions>.

Every time the instructions <instructions> have been executed, the counter <counter> is automatically increased by the increment <increment>. The increment <increment> can have any integral value. If you do not specify an increment, the standard increment is 1.

Example

FOR iCounter := 1 TO 5 BY 1 DO
  iVar1 := iVar1*2;
END_FOR;

Erg := iVar1;

If you have pre-configured iVar1 with 1, iVar1 has the value 32 after the FOR loop.
CAUTION!
The end value <end value> may not attain the same value as the upper limit of the data type of the counter.

If the end value of the counter is equal to the upper limit of the data type of the counter, an endless loop results. For example, an endless loop results in the above example if iCounter is of the data type SINT and the <end value> equals 127, since the data type SINT has the upper limit 127.

As an extension to the IEC 61131-3 standard you can use the CONTINUE instruction within the FOR loop.

See also
- § Chapter 6.4.1.20.5.3 “Integer data types” on page 2235
- § Chapter 6.4.1.20.1.4.5.9 "EXST Statement 'CONTINUE'" on page 2060

ST instruction 'CASE'

Use this dialog box for pooling several conditional instructions containing the same condition variable into a construct.

Syntax:
CASE <Var1> OF
<value1>:<instruction1>
<value2>:<instruction2>
<value3, value4, value5>:<instruction3>
<value6 ... value10>:<instruction4>
...
<value n>:<instruction n>
{ELSE <ELSE-instruction>}
END_CASE;

The section within the curly brackets {} is optional.

Processing scheme of a CASE instruction.

- If the value of the variable <Var1> is <value i>, then the instruction <insturction i> is executed.
- If the variable <Var1> has non of the given values, then the <ELSE-instruction> is executed.
- If the same instruction is executed for several values of the variable, then you can write the values in sequence, separated by commas.

Example
CASE iVar OF
1, 5: bVar1 := TRUE;
   bVar3 := FALSE;
2: bVar2 := FALSE;
   bVar3 := TRUE;
10..20: bVar1 := TRUE;
   bVar3 := TRUE;
ELSE
   bVar1 := NOT bVar1;
   bVar2 := bVar1 OR bVar2;
END_CASE;
ST instruction 'WHILE'

The WHILE loop is used like the FOR loop in order to execute instructions several times until the abort condition occurs. The abort condition of a WHILE loop is a boolean expression.

Syntax:

```
WHILE <boolean expression> DO
    <instructions>
END_WHILE;
```

CODESYS repeatedly executes the <instructions> for as long as the <boolean expression> returns TRUE. If the boolean expression is already FALSE at the first evaluation, then CODESYS never executes the instructions. If the boolean expression never adopts the value FALSE, then the instructions are repeated endlessly, as a result of which a runtime error results.

Example

```
WHILE iCounter <> 0 DO
    Var1 := Var1*2
    iCounter := iCounter-1;
END_WHILE;
```

NOTICE!

You must ensure by programming means that no endless loops are caused.

In a certain sense the WHILE and REPEAT loops are more powerful than the FOR loop, since you don’t need to already know the number of executions of the loop before its execution. In some cases it is thus only possible to work with these two kinds of loop. If the number of executions of the loop is clear, however, then a FOR loop is preferable in order to avoid endless loops.

As an extension to the IEC 61131-3 standard you can use the CONTINUE instruction within the WHILE loop.

See also

- Chapter 6.4.1.20.1.4.5.2 “ST instruction ‘FOR’” on page 2056
- Chapter 6.4.1.20.1.4.5.9 “EXST Statement ‘CONTINUE’” on page 2060

ST Statement 'REPEAT'

The REPEAT loop is used like the WHILE loop, but with the difference that CODESYS only checks the abort condition after the execution of the loop. The consequence of this behavior is that the REPEAT loop is executed at least once, regardless of the abort condition.

Syntax:

```
REPEAT
    <instructions>
UNTIL <boolean expression>
END_REPEAT;
```

CODESYS executes the <instructions> until the <boolean expression> returns TRUE. If the boolean expression already returns TRUE at the first evaluation, CODESYS executes the instructions precisely once. If the boolean expression never adopts the value TRUE, then the instructions are repeated endlessly, as a result of which a runtime error results.
**Example**

```plaintext
REPEAT
  Var1 := Var1 * 2;
  iCounter := iCounter - 1;
UNTIL
  iCounter = 0
END_REPEAT;
```

In a certain sense the **WHILE** and **REPEAT** loops are more powerful than the **FOR** loop, since the number of executions of the loop doesn’t already need to be known before its execution. In some cases you can only work with these two kinds of loop. If the number of executions of the loop is clear, however, then a **FOR** loop is preferable in order to avoid endless loops.

As an extension to the IEC 61131-3 standard you can use the **CONTINUE** instruction within the **WHILE** loop.

See also
- § Chapter 6.4.1.20.1.4.5.4 “ST instruction ‘WHILE’” on page 2058
- § Chapter 6.4.1.20.1.4.5.2 “ST instruction ‘FOR’” on page 2056
- § Chapter 6.4.1.20.1.4.5.9 “EXST Statement ‘CONTINUE’” on page 2060

**ST statement ‘RETURN’**

Use the **RETURN** statement in order to exit from a function block. You can make this dependent on a condition, for example.

**Example**

```plaintext
IF xIsDone = TRUE THEN
  RETURN;
END_IF;

  iCounter := iCounter + 1;
```

If the value of **xIsDone** is equal to **TRUE**, then the function block is exited immediately and the statement **iCounter := iCounter + 1;** is not executed.

See also
- § Chapter 6.4.1.20.1.4.5.1 “ST statement ‘IF’” on page 2055

**ST instruction ‘JMP’**

The **JMP** instruction is used to execute an unconditional jump to a program line that is marked by a jump label.

**Syntax:**

```plaintext
<label>: <instructions>
JMP <label>;
```

The jump label **<label>** is any unique identifier that you place at the beginning of a program line. On reaching the **JMP** instruction, a return to the program line with the **<label>** takes place.
Example
iVar1 := 0;
_label1: iVar1 := iVar1+1;
(* instructions *)
IF (iVar1 < 10) THEN
  JMP _label1;
END_IF;

NOTICE!
You must ensure by programming means that no endless loops are caused. For example, you can make the jump conditional.

ST instruction 'EXIT'
The EXIT instruction is used in a FOR, WHILE or REPEAT loop in order to end the loop regardless of other abort conditions.
See also
- % Chapter 6.4.1.20.1.4.5.2 “ST instruction ‘FOR’” on page 2056
- % Chapter 6.4.1.20.1.4.5.4 “ST instruction ‘WHILE’” on page 2058
- % Chapter 6.4.1.20.1.4.5.5 “ST Statement ‘REPEAT’” on page 2058

EXST Statement 'CONTINUE'
CONTINUE is an instruction of the Extended Structured Text (ExST).
The instruction is used inside FOR, WHILE and REPEAT loops in order to jump to the beginning of the next execution of the loop.

Example
FOR Counter:=1 TO 5 BY 1 DO
  INT1:=INT1/2;
  IF INT1=0 THEN
    CONTINUE; (* to avoid a division by zero *)
    END_IF
  Var1:=Var1/INT1; (* executed, if INT1 is not 0 *)
  END_FOR;
  Erg:=Var1;

See also
- % Chapter 6.4.1.20.1.4.5.2 “ST instruction ‘FOR’” on page 2056
- % Chapter 6.4.1.20.1.4.5.4 “ST instruction ‘WHILE’” on page 2058
- % Chapter 6.4.1.20.1.4.5.5 “ST Statement ‘REPEAT’” on page 2058

ST function block call
Syntax
<FB-instance>(<FB input variable>:=<value or address>, <other FB input variables>);
Example

TMR:TON;

TMR (IN:=%Ox5, PT:=T#300ms);
varA:=TMR.Q;

The timer function block TON is instanced in TMR:TON and called with assignments for the parameters IN and PT.

The output Q is addressed with TMR.Q and assigned to the variable varA.

See also

● Chapter 6.4.1.21.2.21.3 “Object ‘Function Block’” on page 2479

ST – Comments

<table>
<thead>
<tr>
<th>Comment</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single-line</td>
<td>There are two ways of marking:</td>
<td>/// This is a comment.</td>
</tr>
<tr>
<td></td>
<td>• Starts with // and ends at the end of the line</td>
<td>/// This is a comment.</td>
</tr>
<tr>
<td></td>
<td>• Starts with ///// and ends at the end of the line</td>
<td></td>
</tr>
<tr>
<td></td>
<td>In CODESYS, these comments are handled the same way.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>However, if library documentation is created using the LibDoc Scripting Collection, the following applies:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• When the property LibDocContent = DocsOnly is entered in the project information, only comments marked with /// are processed into library documentation. See the example for this below the table.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• When LibDocContent = CommentsAndDocs (default setting) is defined, all comments are processed into library documentation.</td>
<td></td>
</tr>
<tr>
<td>Multiline</td>
<td>Starts with (* and ends with *).</td>
<td>(* This is a multiline comment *)</td>
</tr>
<tr>
<td>Nested</td>
<td>Starts with (* and ends with <em>). Additional comments (</em>,....*) can be contained within this comment.</td>
<td>(* a:=inst.out; (* comment 1 <em>) b:=b+1; (</em> comment 2 *) *)</td>
</tr>
</tbody>
</table>
Comments for tooltips and POU documentation

A tooltip in the header of a POU is defined by the following comment:
// tooltip text – line 1
// tooltip text – line 2
// tooltip text – line 3

Afterwards the documentation is defined as follows:
/// reStructuredText

Note: It is not recommended to mix the different comment types because this can cause unwanted side-effects when the documentation is generated.

Sequential Function Chart (SFC)

6.4.1.20.1.5.1  SFC editor............................................................................... 2062
6.4.1.20.1.5.2  SFC Editor in Online Mode...................................................... 2063
6.4.1.20.1.5.3  Processing order in SFC......................................................... 2064
6.4.1.20.1.5.4  Qualifiers for Actions in SFC................................................... 2065
6.4.1.20.1.5.5  Implicit variables...................................................................... 2066
6.4.1.20.1.5.6  SFC Flags................................................................................ 2067
6.4.1.20.1.5.7  Library "Analyzation".................................................................. 2072
6.4.1.20.1.5.8  Elements................................................................................. 2073

SFC editor

The SFC editor is graphical editor. A new SFC POU includes an Init step and a subsequent transition.

In the SFC editor, you can insert individual elements into the diagram by means of commands in the “SFC” menu, the context menu, or the “ToolBox” view.

When inserting by means of a menu command, the elements that can be inserted at the currently selected position are available.

Before inserting branches parallel to multiple actions and transitions, you must highlight these actions and transitions in a multiple selection.

You can also drag SFC elements from the “ToolBox” view to the diagram. When you drag an element over the editor, CODESYS marks all possible insertion points with gray boxes. If you move the mouse over a gray box, then the color of the box changes to green. When you release the mouse button, the object is inserted at that location.

If you drag a branch into the diagram, then you must set the beginning and the end of the branch using the mouse pointer. You set the beginning of the branch by releasing the mouse button at an insertion point. The color of the box then changes to red. You set the end of the branch by clicking the second insertion point. Then CODESYS inserts a branch around the objects between the beginning and end markers.

For copying step and transition elements that call action objects or transition objects, two different duplication modes can be set. Either the references are copied at the same time, or the referenced objects are embedded and duplicated when copying.

You define the look and feel of the editor in the CODESYS options ("SFC Editor").

See also

●  § Chapter 6.4.1.20.1.3 “Common functions in graphical editors” on page 2048
●  § Chapter 6.4.1.20.1.5 “Sequential Function Chart (SFC)” on page 2062
SFC Editor in Online Mode

In the SFC editor, the variables and expressions in use on the controller can be displayed at runtime. You can also write and force variables and expressions. Debugging functions, such as breakpoints and step-by-step execution, are not available yet.

In the SFC editor options, you can set the online representation of the SFC elements and attributes.

In the case that you have declared SFC flags explicitly, then they are displayed in the declaration part in online mode. They are not displayed in offline mode.

Note the processing order of elements in an SFC diagram.

In online mode, CODESYS displays active steps in blue.

See also

- Chapter 6.4.1.20.1.5.5 “Implicit variables” on page 2066
- Chapter 6.4.1.9.4.2 “Using the declaration editor” on page 1851
- Chapter 6.4.1.20.1.5.3 “Processing order in SFC” on page 2064
- Chapter 6.4.1.21.4.14.23 “Dialog ‘Options’ - ‘SFC Editor’” on page 2795
Processing order in SFC

Basic element behavior

- Active step: An active step includes actions currently being executed. In online mode, CODESYS displays active steps in blue.
- Initial step: In the first cycle after calling a POU in SFC, the initial step is activated automatically and the step action is executed.
- CODESYS executes IEC actions at least two times: the first time is when the step is activated, and the second time when the step is deactivated (but not until the next cycle).
- Alternative branches: If the step before the branch is active, then CODESYS passes the first transition of each alternative branch line from left to right. CODESYS activates the subsequent step in the first branch line with a transition yielding TRUE.
- Parallel branches: If the step before the branch (horizontal double line) is active and the transition before the branch yields TRUE, then CODESYS activates the first steps in every branch line. The branch lines are then processed at the same time. The step after the end of the branch is activated when every last step in each branch line is active and the transition after the double line yields TRUE.

Processing order

1. Reset IEC actions
   CODESYS resets the internal action control flags of the action qualifiers (N, R, S, L, D, P, SD, DS, SL). These flags control IEC actions. However, flags are not reset when they are called within actions.

2. Execute exit actions
   CODESYS verifies whether all steps fulfill the condition for executing the exit action for each step. The order of verification follows the layout in the SFC diagram, from top to bottom and from left to right.
   CODESYS executes an exit action when the step is deactivated (after any entry and step actions have been executed in the preceding cycle and the condition for the subsequent step yields TRUE).

3. Execute entry actions
   CODESYS verifies whether all steps fulfill the condition for executing the entry action for each step. The order of verification follows the layout in the SFC diagram, from top to bottom and from left to right. If the conditions are fulfilled, then CODESYS executes the entry actions.
   CODESYS executes an entry action as soon as the transition of the preceding step has been processed and yields TRUE, thus indicating that the step has been activated.

4. Time check / Execute step actions
   CODESYS performs the following check for each step in the order of the SFC layout:
   - CODESYS copies the elapsed time of the active step to the respective implicit step variable <step name>.t. (not yet implemented)
   - If a timeout occurs, then CODESYS sets the respective error flags. (not yet implemented)
   - For non-IEC steps: CODESYS executes the step action.

5. Execute IEC actions
   CODESYS executes the IEC actions in alphabetical order, passing through the list of actions two times. In the first pass, CODESYS executes the IEC actions for each step that was deactivated in the preceding cycle. In the second pass, the IEC actions are executed for each active step.

6. Transition check / Activate next steps
   The transitions are passed as follows: If a step is active in the current cycle and the subsequent transition yields TRUE and any defined minimum time of the step has elapsed, then the subsequent step is activated.
NOTICE!

Please note when executing actions:

An action can be executed multiple times within the same cycle if you use it in multiple SFC diagrams. For example, if a sequential function chart includes two IEC actions A and B, both of which are programmed in SFC and call an IEC action C, then the IEC action C is called two times.

If you use the same IEC action at the same time in different levels of an SFC diagram, then this can lead to unpredictable results when processing. For this reason, CODESYS issues a corresponding error message. This error message can appear for projects that have been created in an earlier version of the development system.

Please note: It is possible to use implicit variables to monitor the processing status of steps and actions and to control processing.

See also
- Chapter 6.4.1.20.1.5.5 “Implicit variables” on page 2066
- Chapter 6.4.1.20.1.5.4 “Qualifiers for Actions in SFC” on page 2065

Qualifiers for Actions in SFC

You assign qualifiers to IEC steps. Qualifiers describe how a step action is processed.

Qualifiers are processed by the SFCActionControl function block in the library IecSfc.library. The library is automatically integrated into the project by the SFC plug-in.

<table>
<thead>
<tr>
<th>Qualifier</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>N</td>
<td>Non-stored</td>
</tr>
<tr>
<td>R</td>
<td>Overriding Reset</td>
</tr>
<tr>
<td>S</td>
<td>Set (Stored)</td>
</tr>
<tr>
<td>L</td>
<td>Time Limited</td>
</tr>
<tr>
<td>D</td>
<td>Time Delayed</td>
</tr>
<tr>
<td>P</td>
<td>Pulse</td>
</tr>
<tr>
<td>SD</td>
<td>Stored and Time Delayed</td>
</tr>
<tr>
<td>DS</td>
<td>Delayed and Stored</td>
</tr>
<tr>
<td>SL</td>
<td>Stored and Time Limited</td>
</tr>
</tbody>
</table>

You have to specify the times for the L, D, SD, DS, and SL qualifiers in the format of a TIME constant.
When an IEC action is deactivated, it is executed one more time. This means that CODESYS executes this kind of action at least two times. This also applies to actions with the \( P \) qualifier.

See also

- Chapter 6.4.1.9.5.5.2 “Programming in SFC” on page 1880

Implicit variables

Every SFC object supplies implicit variables for you to monitor the status of steps and IEC actions at runtime. These implicit variables are declared automatically by CODESYS for each step and each IEC action.

The implicit variables are structure instances of the type \( SFCStepType \) for steps and type \( SFCActionType \) for actions. The variables have the same names as their elements, for example "step1" variable name for "step1" step name. The structure members describe the status of a step or action or the currently elapsed time in an active step.

In the element properties, you can define whether CODESYS should export a symbol definition for this flag to the symbol configuration.

See also

- Chapter 6.4.1.20.1.5.8.6 “SFC element properties” on page 2080

**Step and action status**

Syntax for the implicit variable declaration:

- \(<\text{step name}>:\text{SFCStepType};\)
- \(_<\text{action name}>:\text{SFCActionType};\)

**Table 389: The following implicit variables are available for step or IEC action status:**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(&lt;\text{step name}&gt;.x)</td>
<td>Shows the activation status in the current cycle. When (&lt;\text{step name}&gt;.x = \text{TRUE}), CODESYS processes the step in the current cycle.</td>
</tr>
<tr>
<td>(&lt;\text{step name}&gt;._x)</td>
<td>Shows the activation status for the next cycle. When (&lt;\text{step name}&gt;._x = \text{TRUE} \text{ and } &lt;\text{step name}&gt;.x = \text{FALSE}), CODESYS processes the step in the next cycle. This means that (&lt;\text{step name}&gt;._x) is copied to (&lt;\text{step name}&gt;.x) at the beginning of a cycle.</td>
</tr>
<tr>
<td>(&lt;\text{step name}&gt;.t)</td>
<td>The flag ( t ) yields the current elapsed time since the step was activated. This applies only to steps, regardless of whether a minimum time has been defined or not in the step properties. Also see SFC flag ( \text{SFCError} ).</td>
</tr>
<tr>
<td>(&lt;\text{step name}&gt;._t)</td>
<td>For internal use only</td>
</tr>
<tr>
<td>(_&lt;\text{action name}&gt;.x)</td>
<td>\text{TRUE} when the action is being executed.</td>
</tr>
<tr>
<td>(_&lt;\text{action name}&gt;._x)</td>
<td>\text{TRUE} when the action is active.</td>
</tr>
</tbody>
</table>
NOTICE!
You can use the above variables to force a specific status value to a step (activate a step). However, note that this can cause an unstable status in the SFC.

See also
● § Chapter 6.4.1.20.1.5.6 “SFC Flags” on page 2067

Access to implicit variables
Syntax for access:
Assign the implicit variable directly in the POU: <variable name>:=<step name>.<implicit variable> or <variable name>:=_<action name>.<implicit variable>

Example
status:=step1._x;

From another POU, with the POU name: <variable name>:=<POU name>.<step name>.<implicit variable> or <variable name>:=<POU name>._<action name>.<implicit variable>

Example
status:=SFC_prog.step1._x;

Symbol generation
In the element properties of a step or action, you define whether CODESYS should add a symbol definition for the step or action flag. In the “Properties” view, you have to select the necessary access rights in the “Symbol” column.

See also
● § Chapter 6.4.1.20.1.5.8.6 “SFC element properties” on page 2080

SFC Flags
SFC flags are implicitly generated variables with predefined names. You can use them to influence the processing of an SFC diagram. You can use these flags, for example, to display timeouts or reset step step chains. In addition, you can activate jogging mode specifically to activate transitions. You have to declare and activate these variables in order to have access to them.

SFC flags

<table>
<thead>
<tr>
<th>Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SFCInit</td>
<td>Bool</td>
<td>TRUE: CODESYS resets the sequence to the initial step. The other SFC flags are also reset (initialization). While the variable is TRUE, the initial step remains set (active), but its actions are not executed. Only when you set SFCInit again to FALSE is the POU further processed normally.</td>
</tr>
<tr>
<td>SFCReset</td>
<td>Bool</td>
<td>This function behaves similar to SFCInit. However, CODESYS continues processing after the initialization of the initial step. For example, in the initial step, you could immediately reset the SFCReset flag to FALSE.</td>
</tr>
<tr>
<td>SFCError</td>
<td>Bool</td>
<td>TRUE if a timeout occurs in an SFC diagram. If second timeout occurs in the program, it is not registered unless you previously reset the variable SFCError. The declaration of SFCError is a requirement for other flag variables to function for controlling the chronological sequence (“SFCErrorStep”, SFCErrorPOU, SFCQuitError).</td>
</tr>
<tr>
<td>Name</td>
<td>Data Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SFCEnableLimit</td>
<td>Bool</td>
<td>Used specifically for activating (TRUE) and deactivating (FALSE) the timeout control in steps using SFCError. If you declare and activate this variable (SFC settings), you must set it to TRUE for SFCerror to work. If you do not, then the timeouts are ignored. The is useful, for example, at start-up or in manual operation. If you do not declare the variable, then SFCError will work automatically. The requirement is the declaration of SFCError.</td>
</tr>
<tr>
<td>SFCErrorStep</td>
<td>String</td>
<td>Stores the name of the step that caused a timeout, which was registered by SFCError. The name is kept until the registered step error is reset by means of SFCQuitError (FALSE -&gt; TRUE). The requirement is the declaration of SFCError.</td>
</tr>
<tr>
<td>SFCErrorPOU</td>
<td>String</td>
<td>Stores the name of the block in which a timeout occurred and was registered by SFCError. The name is saved until the timeout is reset by SFCQuitError. The requirement is the declaration of SFCError.</td>
</tr>
<tr>
<td>SFCQuitError</td>
<td>Bool</td>
<td>As long as this Boolean variable is TRUE, CODESYS pauses the processing of the SFC diagram and any timeout, saved in the variable SFCError, is reset. If you reset the variable to FALSE, then all previous times in the active steps are reset. The requirement is the declaration of SFCError.</td>
</tr>
<tr>
<td>SFCPause</td>
<td>Bool</td>
<td>As long as this variable is TRUE, CODESYS pauses the processing of the SFC diagram.</td>
</tr>
<tr>
<td>SFCTrans</td>
<td>Bool</td>
<td>TRUE if a transition is active.</td>
</tr>
<tr>
<td>SFCCurrentStep</td>
<td>String</td>
<td>Shows the name of the active step, regardless of the time monitoring. In parallel branches, the name of the step of the rightmost branch line is always stored.</td>
</tr>
<tr>
<td>SFCTip, SFCTipMode</td>
<td>Bool</td>
<td>Controls the jogging mode of the SFC block. If you enable this flag with SFCTipMode=TRUE, then you can activate the next step only by setting SFCTip to TRUE. While SFCTipMode is set to FALSE, transitions can also be used to continue activation.</td>
</tr>
<tr>
<td>SFCErrorAnalyzation</td>
<td></td>
<td>Contains as string all variables that contribute to the total value TRUE of SFCError (timeout in one step). SFCError needs to be activated for this. SFCErrorAnalyzation implicitly uses the function of the POU AnalyzeExpression of the library Analyzation.</td>
</tr>
<tr>
<td>SFCErrorAnalyzationTable</td>
<td></td>
<td>Contains in a table all variables that contribute to the total value TRUE of SFCError (timeout in one step). SFCError needs to be activated for this. SFCErrorAnalyzationTable implicitly uses the function of the POU AnalyzeExpressionTable of the library Analyzation.</td>
</tr>
</tbody>
</table>

**Implicit generation of SFC flags**

CODESYS declares SFC flags automatically when you activate the respective options. You can set this option in the “SFC Settings” tab of the properties dialog for each POU, or in the “SFC” project settings dialog for each SFC POU in the project.

*The SFC settings for the SFC flags of individual POUs are effective only if you have not selected the "Use defaults" option. When you select this option, the settings apply that were defined in the project settings.*
SFC flags that you declare in the SFC settings dialog are visible only in the online view of the SFC block.

See also

- “Flag” on page 2763

**Explicit generation of SFC flags**

Manual declaration, which was necessary in CoDeSys V2.3, is now only required to enable write access from another block. In this case, you should note that when you declare the flag in a global variable list, you must deactivate its “Declare” setting in the SFC settings dialog. If you do not do this, then a local SFC flag is implicitly declared that CODESYS uses instead of the global variable.
You have created an SFC block named `sfc1`, which contains the `s1` step. You have defined timeouts in the step properties. (See "Online view of SFC block `sfc1`" below.)

If for any reason the `s1` step remains active longer than its time properties have permitted (timeout), then CODESYS sets the `SFCError` flag to permit access by the application.

To permit access, you have to declare and activate the SFC flag in the SFC settings. If you have only declared it, then the SFC flag is only displayed in the online view of `sfc1` in the declaration part, but it has no function.

Now the SFC flag can be referenced within the POU, for example in an action (2) or outside of the block (1).

Online view of the SFC block `sfc1`
SFCErr is TRUE as soon as a timeout occurs within sfc2.

Note that you can use the flags SFCErrorAnalyzation and SFCErrorAnalyzationTable to determine the components of the expression that contributes to the value TRUE of the SFCErr.

See also
- § Chapter 6.4.1.20.1.5.7 “Library “Analyzation”” on page 2072

### Access to the flags

Syntax for access:
You assign the flag directly within the POU: `<variable name>:=<SFC flag>`

**Example**
```
checkerror:=SFCErr;
```

From another POU with POU name: `<variable name>:=<POU name>..<SFC flag>`

**Example:**
```
checkerror:=SFC_prog.SFCErr;
```

If you need write access from another block, then you also have to declare the SFC flag explicitly as a VAR_INPUT variable in the SFC block or globally in a GVL.
Example
Local declaration:

```plaintext
PROGRAM SFC_prog
VAR_INPUT
  SFCinit:BOOL;
END_VAR
```

Global declaration in a global variable list:

```plaintext
VAR_GLOBAL
  SFCinit:BOOL;
END_VAR
```

```plaintext
PROGRAM PLC_PRG
VAR
  setinit: BOOL;
END_VAR
SFC_prog.SFCinit:=setinit;  // write access to SFCinit in SFC_prog
```

See also

- § Chapter 6.4.1.20.1.5.7 “Library "Analyzation"” on page 2072

Library "Analyzation"

This library contains POU:s for the analysis of expressions. When a composite expression has the total value of FALSE, those of its components that contribute to this result can be determined. In the SFC editor, the flags SFCErrorAnalyzation and SFCErrorAnalyzationTable use these functions implicitly to examine the transition expressions. Then the flags provide the identifiers of the variables that contributed to a timeout error. They keep this information until they are reset explicitly by means of the SFC flag SFCQuitError.

An analysis POU cannot be called by means of a pointer. This kind of call is ignored. Call the POU as a single instance.

For a description of the library POU:s and an example of how the SFC flags display the analysis results in CODESYS, see the documentation for the library (online help or directly in the Library Manager).

See also

- § Chapter 6.4.1.9.5.5.2 “Programming in SFC” on page 1880
- § Chapter 6.4.1.20.1.5.6 “SFC Flags” on page 2067
SFC elements 'Step' and 'Transition'

Step symbol 🔄; Transition symbol ➡

As a rule, CODESYS inserts steps and transitions as combinations. Inserting a step without a transition or a transition without a step causes an error when compiling. You can modify this by double-clicking the name.

**NOTICE!**

Step names must be unique within the scope of the parent block. Consider this especially when using actions that were also programmed in SFC.

Please note that you can convert a step into an initial step by clicking “Init step” or by setting the respective property in the SFC properties.

All steps are defined by the step properties, which you can display and edit in the “Properties” view, depending on the set options.

You have to add those actions to the step which are to be executed when the step is active. A distinction is made between IEC actions and step actions. Details for this are found in the chapter about the SFC element "Action".

A transition must include the condition for the subsequent step to be active as soon as the value of the condition yields **TRUE**. Therefore, a transition condition must yield **TRUE** or **FALSE**. It can be defined in one of two ways:

1. Inline condition (direct): You replace the default transition name with either the name of a Boolean variable, a Boolean address, a Boolean constant, or a statement with a Boolean result, for example *(i<100) AND b*. You cannot specify programs, function blocks, or assignments here.
2. Multi-use condition (separate transition or property object): You replace the default transition name with the name of a transition or property object *(condition_xy)*. You create these objects by clicking “Project ➔ Add Object”. This allows multiple use of transitions, for example “condition_xy” in the figures below. Like an inline condition, the object can contain a Boolean variable, Boolean address, Boolean constant, or an statement with a Boolean result. In addition, it can also contain multiple statements with any code.
NOTICE!
The user is responsible for assigning the required expression to a transition variable if the transition includes multiple instructions.

Transitions that reference a transition or property object are marked with a small triangle in the upper right corner of the transition box.

As opposed to CoDeSys V2.3, now CODESYS treats a transition condition like a method call. The entry has the following syntax:

\(<\text{transition name}>:=<\text{transition condition}>\)
(for example \texttt{trans1:= a=100})

or only

\texttt{<transition condition>}

(for example \texttt{a=100})

You will find an example (condition\_xy) in the figure above.

See also

\begin{itemize}
\item \textit{Chapter 6.4.1.9.5.5.2 “Programming in SFC” on page 1880}
\item \textit{Chapter 6.4.1.21.3.12.6 “Command ‘Insert Step-Transition’” on page 2677}
\item \textit{Chapter 6.4.1.20.1.5.8.2 “SFC Element ‘Action’” on page 2075}
\item \textit{Chapter 6.4.1.21.3.12.1 “Command ‘Init Step’” on page 2675}
\item \textit{Chapter 6.4.1.20.1.5.8.6 “SFC element properties” on page 2080}
\item \textit{Chapter 6.4.1.9.22.5 “Calling methods” on page 1933}
\end{itemize}

\textbf{SFC Element ‘Action’}

Symbol: \includegraphics[width=1cm]{symbol_action}

An action includes one or more statements in one of the valid implementation languages. You can assign an action to a step.

Actions that you use in SFC steps have to be created as POUs in the project.

Exception: In the case of IEC actions, which you add to a step as action association, you can also specify a Boolean variable instead of an action object. The value of these variables is switched between FALSE and TRUE each time the action is executed.

\begin{center}
\textbf{NOTICE!}
\end{center}

You have to define unique step names within the scope of the parent block. An action written in SFC must not contain a step with a name identical to the step to which the action is assigned.

A distinction is made between IEC actions and step actions:

1. \textbf{IEC actions}

IEC actions comply with the IEC 61131-3 standard. They are executed according to their qualifiers.

IEC actions are executed two times: first when the step is activated and second when the step is deactivated. If you assign multiple actions to one step, then the action list is processed from top to bottom.

Each action box includes the qualifier in the first column and the action name in the second column. Both can be edited directly.
**NOTICE!**
When the same global Boolean variable is associated as an IEC action in different SFC POUs, unwanted overwriting can result.

In contrast to step actions, you can use different qualifiers for IEC actions. Moreover, each IEC action is provided with a control flag. This directs CODESYS to execute an action only one time at any moment, even if the action is called by another step at the same time. This cannot be guaranteed for step actions.

You assign IEC actions to steps by clicking “SFC ➔ Insert Action Association”.

See also
- Chapter 6.4.1.21.3.12.14 “Command ‘Insert Action Association’” on page 2680
- Chapter 6.4.1.20.1.5.4 “Qualifiers for Actions in SFC” on page 2065

### 2. Step actions
These are actions that you can use to extend the IEC standard.
- **Entry action:**
  CODESYS executes this action after the step is activated and before the main action is executed.
  You reference a new action, or an action created below the SFC object, from a step by means of the “Entry action” element property (2). You can also add a new action to the step by means of the “Add Entry Action” command. The entry action is marked with an E in the lower left corner of the step box.

- **Main action:**
  CODESYS executes this action when the step is active and any entry actions have already been processed. However, in contrast to IEC actions (see above), these step actions are not executed a second time when the step is deactivated. Moreover, you cannot use qualifiers here.
  You add an existing action to a step by means of the “Main action” element property (1). You can create and add a new action by clicking the step element. A main action is marked with a filled triangle in the upper right corner of the step box.

- **Exit action:**
  CODESYS executes this action one time when the step is deactivated. However, note that an exit action is not executed in the same cycle, but at the beginning of the next cycle.
  You reference a new action, or an action created below the SFC object, from a step by means of the “Exit action” element property (3). You can also add a new action to the step by means of the “Insert Exit Action” command. The exit action is marked with an X in the lower right corner of the step box.
The main difference between step actions and IEC actions with a qualifier N is that an IEC action is always executed two times: when the step is activated and when the step is deactivated. See the following example:

You have attached the `Action_AS1` action to the `AS1` step as a step action (left) and as an IEC action with qualifier N (right). Because two transitions are activated in each case, the time to reach the initial step again is two PLC cycles. This is true as long as the `iCounter` counter variable was initialized at 0 and then incremented in the `Action_AS1` action. After the `Init` step is reactivated, `iCounter` returns a value of 1 in the example on the left. In the example on the right, a value of 2 is returned because the IEC action is executed a second time due to the deactivation of `AS1`.

Another difference: Step actions can be pseudo-embedded. In this case, they can be called only from the related step. If you copy this step, CODESYS creates new action objects automatically and copies the respective implementation code. You define whether or not a step action is embedded, either when the first action is inserted into the step, or later in the "Duplicate when copying" element property. In general, this behavior can also be preset in the SFC options.

Moreover, for IEC actions, a Boolean variable can be specified instead of an action object. This is not possible for step actions.
SFC element 'Branch'

Symbol ▼

Use branches to program parallel or alternative sequences in the sequential function chart.

For alternative branches, CODESYS processes just one of the branch lines at a time, depending on the preceding transition condition. Parallel branches are processed at the same time.

See also
- Chapter 6.4.1.20.1.5.3 “Processing order in SFC” on page 2064
- Chapter 6.4.1.9.5.5.2 “Programming in SFC” on page 1880
- Chapter 6.4.1.21.3.12.13 “Command ‘Insert Branch Right’” on page 2679

Parallel branch

For parallel branches, the branch lines must begin and end with steps. Parallel branch lines can contain additional branches.

The horizontal lines before and after the branch are double lines.

Processing in online mode: If the preceding transition (t2 in the example) yields TRUE, then the first steps in all parallel branch lines are active (Step11 and Step21). CODESYS processes the individual branch lines at the same time and the subsequent transition is passed afterwards (t3).

The "Branch<n>" jump marker is added automatically to the horizontal line that indicates the beginning of a branch. You can define this marker as the jump destination.

Please note that you can convert a parallel branch into an alternative branch by clicking “Alternative”.

See also
- Chapter 6.4.1.21.3.12.11 “Command ‘Alternative’” on page 2679

Alternative branch

The horizontal line before and after the branch is a single line.

In an alternative branch, the branch lines must begin and end with transitions. The branch lines can contain additional branches.
If the step before the branch is active, then CODESYS passes the first transition of each alternative branch line from left to right. For the first transition that yields TRUE, the associated branch line opens, thus activating the step following the transition.

Please note that you can convert an alternative branch into a parallel branch by clicking "Parallel".

See also

- Chapter 6.4.1.21.3.12.10 “Command ’Parallel’” on page 2678

SFC element 'Jump'

Symbol ₋

Use a jump to define which actions in a step should be executed next as soon as the transition preceding the jump is TRUE. Jumps may become necessary, as execution paths cannot cross or lead upwards.

Excluding the required jump at the end of a diagram, you can generally insert jumps only at the end of a branch.

The destination of a jump is defined by the added text string, which you can edit directly. The jump destination can be a step name or the marker for a parallel branch.

See also

- Chapter 6.4.1.9.5.5.2 “Programming in SFC” on page 1880
- Chapter 6.4.1.21.3.12.16 “Command ’Insert Jump’” on page 2681

SFC element 'Macro'

Symbol ₋
A macro includes part of the SFC diagram, but it is not displayed in detail in the main view of the editor.

Using macros does not influence the processing flow. Macros are used for hiding specific parts of the diagram, for example to increase overall clarity.

You open the macro editor by double-clicking the macro box or by clicking “SFC → Zoom Into Macro”. You can program here just like in the main view of the SFC editor. To close the macro editor, click “SFC → Zoom Out of Macro”.

Macros can also include other macros. The caption of the macro editor always shows the path of the open macro within the diagram, for example:

```
Macro1 → Macro2
```

See also
- Chapter 6.4.1.9.5.5.2 “Programming in SFC” on page 1880
- Chapter 6.4.1.21.3.12.20 “Command ‘Zoom Into Macro’” on page 2682
- Chapter 6.4.1.21.3.12.21 “Command ‘Zoom Out of Macro’” on page 2682

### SFC element properties

You edit the properties of an SFC element in the “Properties” view. Click “View → Element Properties” to open this view. The properties to be displayed depend on the currently selected element.
The properties that are displayed in the SFC diagram next to the element depend on the settings in the "View" tab of the SFC editor options.

### General

<table>
<thead>
<tr>
<th>Property</th>
<th>Value description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Name&quot;</td>
<td>Element name, by default &quot;&lt;element&gt;&lt;consecutive number&gt;&quot;*, for example step name &quot;Step0&quot;, &quot;Step1&quot;, branch name &quot;Branch0&quot;, etc.</td>
</tr>
<tr>
<td>&quot;Comment&quot;</td>
<td>Element comment in text, for example &quot;counter reset&quot;. You can insert line breaks by pressing [Ctrl]+[Enter].</td>
</tr>
<tr>
<td>&quot;Symbol&quot;</td>
<td>For each SFC element, CODESYS declares an implicit variable with the same name as the element. The configuration determines whether this flag variable should be exported to the symbol configuration and which access rights for the symbol should be applied in the PLC.</td>
</tr>
<tr>
<td></td>
<td>● &quot;No access&quot;: The symbol is exported to the symbol configuration but cannot be accessed from the PLC.</td>
</tr>
<tr>
<td></td>
<td>● &quot;Read&quot;: The symbol is exported to the symbol configuration and can be read from the PLC.</td>
</tr>
<tr>
<td></td>
<td>● &quot;Write&quot;: The symbol is exported to the symbol configuration and can be written from the PLC.</td>
</tr>
<tr>
<td></td>
<td>● &quot;Read/Write&quot;: Combination of read and write.</td>
</tr>
<tr>
<td></td>
<td>● Empty: A symbol is not exported to the symbol configuration.</td>
</tr>
</tbody>
</table>

### Specific

<table>
<thead>
<tr>
<th>Property</th>
<th>Value description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Init step&quot;</td>
<td>✅: This option is activated only for the defined initial step. By default, this is the first step in an SFC diagram. Note: If you activate this property for another step, then it must be deactivated in the previous step to prevent compilation errors.</td>
</tr>
<tr>
<td>&quot;Duplicate when copying&quot;</td>
<td>This option is available for steps that contain a step action (entry action, main action, or exit action), and for transitions that are linked to a transition object.</td>
</tr>
<tr>
<td></td>
<td>✅: When copying the step or transition, a new object is created for each called action or transition. It contains a copy of the implementation code of the copied object.</td>
</tr>
<tr>
<td></td>
<td>⬜: When copying a step or transition, the link to the called object is retained for the respective action or transition. No new objects are generated. The source and the copies of the step or transition call the same action or transition.</td>
</tr>
</tbody>
</table>
### Property Value description

<table>
<thead>
<tr>
<th>Property</th>
<th>Value description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Times”</td>
<td>Minimum time that the step is active, even when the subsequent transition is TRUE. Maximum time that the step can be active. If this time is exceeded, then CODESYS sets the SFCError implicit variable to TRUE. Times according to IEC syntax (for example t#8s) or the TIME variable; default: t#0s.</td>
</tr>
<tr>
<td>“Actions”</td>
<td>“Entry action”: CODESYS executes these actions after activating the step. “Step action”: CODESYS executes this action when the step is active and any entry actions have already been processed. “Exit action”: CODESYS executes this action in the subsequent cycle when the step is deactivated.</td>
</tr>
</tbody>
</table>

Please note the processing sequence.

When using the respective implicit SFC variables and flags, you receive information about the status of a step or an action or about timeouts.

See also
- % Chapter 6.4.1.21.4.14.23 “Dialog ‘Options’ - ‘SFC Editor’” on page 2795
- % Chapter 6.4.1.20.1.5.5 “Implicit variables” on page 2066
- % Chapter 6.4.1.20.1.5.8.2 “SFC Element ‘Action’” on page 2075

### Function Block Diagram / Ladder Diagram / Instruction List (FBD/LD/IL)

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.4.1.20.1.6.1 FBD/LD/IL Editor..........................................................</td>
<td>2082</td>
</tr>
<tr>
<td>6.4.1.20.1.6.2 FBD/LD/IL editor in online mode..................................</td>
<td>2086</td>
</tr>
<tr>
<td>6.4.1.20.1.6.3 Modifiers and operators in IL.....................................</td>
<td>2087</td>
</tr>
<tr>
<td>6.4.1.20.1.6.4 Elements.......................................................................</td>
<td>2091</td>
</tr>
</tbody>
</table>

### FBD/LD/IL Editor

The FBD/LD/IL editor is a combined editor of the programming languages FBD, LD and IL.

If necessary, IL can be activated in the CODESYS options.

There is a common set of commands and elements and CODESYS automatically converts the 3 programming languages into one another internally.

The code in the implementation part is structured in all three languages with the aid of networks.

The “FBD/LD/IL” menu provides the commands for working in the editor.

In offline and online modes, you can switch editors at any time by using the menu command in “View”.

The behavior of the FBD/LD/IL editor is defined by the settings in “Tools ➔ Options” (category “FBD, LD and IL”).

---

Configuration and programming
Programming with CODESYS > CODESYS Development System
NOTICE!
There are some special elements that CODESYS cannot convert and thus it displays only in the applicable language. There are also constructs that are not clearly convertible between IL and FBD and are therefore 'normalized', i.e. nullified, when converted back to FBD. This concerns: negation of expressions and explicit/implicit assignment of function block inputs and outputs.

An error-free conversion between the languages requires syntactically correct code. Otherwise parts of the implementation can be lost.

See also
- Chapter 6.4.1.9.5.2 “FBD/LD/IL” on page 1860 (programming)
- Chapter 6.4.1.21.3.14 “Menu ‘FBD/LD/IL’” on page 2700 (commands)
- Chapter 6.4.1.21.4.14.10 “Dialog ‘Options’ - 'FBD, LD, and IL’” on page 2787
- Chapter 6.4.1.20.1.3 “Common functions in graphical editors” on page 2048

FBD and LD editor

Inserting and arranging elements

You can drag elements with the mouse from the view “Tools” (toolbox) into the implementation part of the editor. Alternatively you can use the commands of the context menu or the “FBD/LD/IL” menu.

Settings for the display and interface are defined in the CODESYS options, category "FBD/LD/IL".

If you drag an element with the mouse over a network in the editor, all possible insertion positions are displayed with gray diamond-shaped, triangular or arrow-shaped position marks. As soon as the mouse pointer is located over one of these marks, the mark turns green. If the mouse button is now released, CODESYS inserts the element at this position.

Example

If you drag a function block or an operator from the toolbox or a network at the left-hand side of the network onto one of the two arrows, then CODESYS automatically creates a new network and inserts the element there.

In order to replace an element, drag a suitable other element onto its position with the mouse. Elements that you can replace by the new element are marked by CODESYS in the editor with text fields, for example “Replace”, “Attach input”.

You can use the usual commands in the menu “Edit” for cutting, copying, pasting and deleting elements. Copying also works with drag-and-drop by holding down the [Ctrl] key.

NOTICE!
The operators with EN/ENO functionality can only be inserted in the FBD and IL editors.

Selecting elements

A box or a connecting line in the editor is selected by clicking on it with the mouse so that it has the focus. Multiple selection is possible by keeping the [Ctrl] key pressed. A selected element is shaded red.

Tooltip
If the cursor points to certain elements, for example to a variable or to an input, a tooltip appears showing information about this element.

In the case of elements underlined with a wavy red line, the tooltip shows the pre-compile error message of the error that occurs with this element.

**Navigating in the editor**

**Table 390: Navigating in the editor**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[←]</td>
<td>Change to the neighboring cursor position, along the signal flow, i.e. from left to right and vice versa.</td>
</tr>
<tr>
<td>[→]</td>
<td>Change to the next cursor position above or below the current position, if this neighboring position belongs to the same logical group. For example, all connections of a box form a logical group. If such a logical group does not exist: change to the first cursor position in the next higher or lower neighboring element. In the case of parallel-connected elements, navigation takes place along the first branch.</td>
</tr>
<tr>
<td>[Ctrl] + [Home]</td>
<td>Change to the first network; this will be selected.</td>
</tr>
<tr>
<td>[Ctrl] + [End]</td>
<td>Change to the last network; this will be selected.</td>
</tr>
<tr>
<td>[Page Up]</td>
<td>Scroll upwards by one page; the highest network on this page is selected.</td>
</tr>
<tr>
<td>[Page Down]</td>
<td>Scroll downwards by one page; the lowest network on this page is selected.</td>
</tr>
<tr>
<td>Command “Go to…”</td>
<td>Change to a certain network.</td>
</tr>
</tbody>
</table>

Opening function blocks

If a function block is inserted in the editor, then you can open its implementation by a double-click or with the context menu command “Browse for symbol ➔ Go to Definition”.

See also

- “Function block diagram (FBD)” on page 1860
- “Ladder diagram (LD)” on page 1860
- Chapter 6.4.1.9.5.2.2 “Programming function block diagrams (FBD)” on page 1862
- Chapter 6.4.1.9.5.2.3 “Programming ladder diagrams (LD)” on page 1864
- Chapter 6.4.1.20.1.6.4 “Elements” on page 2091
- Chapter 6.4.1.21.4.14.10 “Dialog ‘Options’ - ‘FBD, LD, and IL’” on page 2787
- Chapter 6.4.1.20.1.6.2 “FBD/LD/IL editor in online mode” on page 2086
- Chapter 6.4.1.21.3.14.44 “Command ‘Go to’” on page 2712

**IL editor**

**Inserting and arranging elements:**

You can insert elements with the help of the commands of the menu “FBD/LD/IL” in the context menu. You can also drag a new network from the tool box into the implementation part of the editor by drag-and-drop.

You can use the usual commands in the menu “Edit” for cutting, copying, pasting and deleting elements. Copying also works with drag-and-drop by holding down the [Ctrl] key.

**NOTICE!**

Please note that operators with EN/ENO functionality can only be inserted in the FBD and IL editors.
Each program line is entered in a table row.

**Table 391: Structure of networks in the IL editor**

<table>
<thead>
<tr>
<th>Column</th>
<th>Contents</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Operator</td>
<td>Contains the IL operator (LD, ST, CAL, AND, OR, etc.) or a function name. If you call a function block, you must additionally specify the corresponding parameters here; in the preceding field you must enter in this case := or =&gt;.</td>
</tr>
<tr>
<td>2</td>
<td>Operand</td>
<td>Contains precisely one operand or the name of a jump label.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In the case of several operands you must enter them in several rows and when doing so insert a comma directly behind the individual operands. (See example below)</td>
</tr>
<tr>
<td>3</td>
<td>Address</td>
<td>Contains the address of the operand as defined in its declaration.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>non-editable</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can activate/deactivate the display via the option &quot;Display symbol address&quot;. To do this, select the command &quot;Tools ➔ Options&quot; and the &quot;General&quot; tab in the category &quot;FBD, LD and IL&quot;.</td>
</tr>
<tr>
<td>4</td>
<td>Symbol comment</td>
<td>Contains the comment that was specified for the operand if necessary in the declaration.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>non-editable</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can activate/deactivate the display via the option &quot;Display symbol comment&quot; if you select the command &quot;Tools ➔ Options&quot; and the &quot;General&quot; tab in the category &quot;FBD, LD and IL&quot;.</td>
</tr>
<tr>
<td>5</td>
<td>Operand comment</td>
<td>Comment for the current program line.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can activate/deactivate the display via the option &quot;Operand comment&quot; if you select the command &quot;Tools ➔ Options&quot; and the &quot;General&quot; tab in the category &quot;FBD, LD and IL&quot;.</td>
</tr>
</tbody>
</table>

**Example**

<table>
<thead>
<tr>
<th>Column 1</th>
<th>Column 2</th>
<th>Column 3</th>
<th>Column 4</th>
<th>Column 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>cal</td>
<td>tonInst1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IM:= bVar,</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FT:= tl,</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ET:= t0ut1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LD</td>
<td>tonInst1.Q</td>
<td>is TRUE, FT seconds after IM had a rising edge, reset.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ST</td>
<td>tonInst2.IN</td>
<td>starts timer with rising edge, reset.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cal</td>
<td>tonInst2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FT:= t2,</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G:= bReady,</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ET:= t0ut2)</td>
<td>4Q81</td>
<td>for tonInst2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 392: Navigating in the editor

<table>
<thead>
<tr>
<th>Key(s)/command</th>
<th>Cursor movement</th>
</tr>
</thead>
<tbody>
<tr>
<td>↑</td>
<td>Jumps to the field located above/below.</td>
</tr>
<tr>
<td>↓</td>
<td>Jumps to the field located below.</td>
</tr>
<tr>
<td>[Tab]</td>
<td>Jumps one field to the right within the row.</td>
</tr>
<tr>
<td>[Shift] + [Tab]</td>
<td>Jumps to the left to the preceding field within the row.</td>
</tr>
<tr>
<td>[Space]</td>
<td>Opens the editing frame for the selected field. Alternatively you can click with the mouse on the field. If applicable the button for the input assistant dialog box is available.</td>
</tr>
<tr>
<td>[Ctrl] + [Enter]</td>
<td>Inserts a new row below the current row.</td>
</tr>
<tr>
<td>[Del]</td>
<td>Deletes the current row.</td>
</tr>
<tr>
<td>[Ctrl] + [Home]</td>
<td>Sets the focus at the start of the document and marks the first network.</td>
</tr>
<tr>
<td>[Ctrl] + [End]</td>
<td>Sets the focus at the end of the document and marks the last network.</td>
</tr>
<tr>
<td>[Page Down]</td>
<td>Scrolls up by one page and marks the top rectangle.</td>
</tr>
<tr>
<td>[Page Up]</td>
<td>Scrolls down by one page and marks the top rectangle.</td>
</tr>
</tbody>
</table>

See also
- “Instruction list (IL)” on page 1861
- Chapter 6.4.1.9.5.2.4 “Programming in instruction list (IL)” on page 1865
- Chapter 6.4.1.20.1.6.3 “Modifiers and operators in IL” on page 2087
- Chapter 6.4.1.21.4.14.10 “Dialog ‘Options’ - ‘FBD, LD, and IL’” on page 2787
- Chapter 6.4.1.20.1.6.2 “FBD/LD/IL editor in online mode” on page 2086

FBD/LD/IL editor in online mode

In online mode the current value of each variable is displayed behind the variable in the editor. Writing/forcing and the setting of breakpoints is possible.

If the variable is presently forced, this is indicated directly in front of the forced value by ☑. If a value has been prepared for writing or forcing, this value is displayed directly behind the current value in square brackets <value>.

Example

Forced variable:

![BVar1 TRUE](image)

Prepared value

![iVar1 0<12>](image)

In the online view of a ladder diagram (LD) the connecting lines are marked in color: connections with the value TRUE are displayed as a thick blue line, connections with the value FALSE as a thick black line. Conversely, connections with an unknown or analog value are displayed normally (thin black line).

NOTICE!

Note that values of the connections are calculated from the monitored variables.

This is not a genuine flow control.

Breakpoints
Possible positions for breakpoints are in principle the positions at which values of variables can change (instructions), at which the program branches or at which another box is called.

Possible breakpoint positions:

- On the entire network: causes the breakpoint to be set at the first possible position in the network.
- On a box, if the box contains an assignment. Not possible with operator boxes, for example ADD, DIV.
- On assignments.
- At the end of the box at the position of the return to the calling box. In online mode an empty network automatically appears here; it is marked by 'RET' in place of a network number.

**NOTICE!**

At present you cannot directly set a breakpoint on the first box in the network. However, if you set a breakpoint on the entire network, this breakpoint marking is transferred automatically to the first box in online mode.

**NOTICE!**

Breakpoints in methods: CODESYS automatically sets a breakpoint in all methods that can be called. Therefore, if a method managed by an interface is called, breakpoints are set in all methods that occur in function blocks that implement this interface as well as in all derived function blocks that use the method. If a method is called by a pointer to a function block, CODESYS sets the breakpoints in the method of the function block and in all derived function blocks that use the method.

See also

- § Chapter 6.4.1.12.5 “Forcing and Writing of Variables” on page 1987
- § Chapter 6.4.1.12.3 “Using Breakpoints” on page 1981

Modifiers and operators in IL

**Table 393: Modifiers**

<table>
<thead>
<tr>
<th>Modifier</th>
<th>Combined with operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>JMP, CAL, RET</td>
<td>The command is only executed if the result of the preceding expression is <strong>TRUE</strong>.</td>
</tr>
<tr>
<td>N</td>
<td>JMPC, CALC, RETC</td>
<td>The command is only executed if the result of the preceding expression is <strong>FALSE</strong>.</td>
</tr>
<tr>
<td>N</td>
<td>otherwise</td>
<td>negation of the operand (not of the accumulator).</td>
</tr>
</tbody>
</table>

**Table 394: Operators with the possible modifiers**

<table>
<thead>
<tr>
<th>Operator</th>
<th>N</th>
<th>Meaning</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>LD</td>
<td>N</td>
<td>Loads the (negated) the value of the operand into the accumulator.</td>
<td>LD iVar</td>
</tr>
<tr>
<td>ST</td>
<td>N</td>
<td>Stores the (negated) content of the accumulator in the operand.</td>
<td>ST iErg</td>
</tr>
<tr>
<td>S</td>
<td></td>
<td>Sets the operand (type <strong>BOOL</strong>) to <strong>TRUE</strong> if the content of the accumulator is <strong>TRUE</strong>.</td>
<td>S bVar1</td>
</tr>
<tr>
<td>Operator</td>
<td>N</td>
<td>Meaning</td>
<td>Example</td>
</tr>
<tr>
<td>----------</td>
<td>----</td>
<td>-------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>R</td>
<td></td>
<td>Sets the operand (type BOOL) to FALSE if the content of the accumulator is TRUE.</td>
<td>R bVar1</td>
</tr>
<tr>
<td>AND</td>
<td>N, (</td>
<td>Bitwise AND of the accumulator value and (negated) operand</td>
<td>AND bVar2</td>
</tr>
<tr>
<td>OR</td>
<td>N, (</td>
<td>Bitwise OR of the accumulator value and (negated) operand</td>
<td>OR xVar</td>
</tr>
<tr>
<td>XOR</td>
<td>N, (</td>
<td>Bitwise exclusive OR of the accumulator value and (negated) operand</td>
<td>XOR N, (bVar1,bVar2)</td>
</tr>
<tr>
<td>NOT</td>
<td></td>
<td>Bitwise negation of the accumulator value</td>
<td></td>
</tr>
<tr>
<td>ADD</td>
<td></td>
<td>Addition of the accumulator value and the operand; result is written into the accumulator.</td>
<td>ADD iVar1</td>
</tr>
<tr>
<td>SUB</td>
<td></td>
<td>Subtraction of the operand from the accumulator value; result is written into the accumulator.</td>
<td>SUB iVar2</td>
</tr>
<tr>
<td>MUL</td>
<td></td>
<td>Multiplication of accumulator value and operand; result is written into the accumulator.</td>
<td>MUL iVar2</td>
</tr>
<tr>
<td>DIV</td>
<td></td>
<td>Division of the accumulator value by the operand; result is written into the accumulator.</td>
<td>DIV 44</td>
</tr>
<tr>
<td>GT</td>
<td></td>
<td>Checks whether the accumulator value is greater than the operand value; result (BOOL) is written into the accumulator; &gt;</td>
<td>GT 23</td>
</tr>
<tr>
<td>GE</td>
<td></td>
<td>Checks whether the accumulator value is greater than or equal to the operand value; result (BOOL) is written into the accumulator.</td>
<td>GE iVar2</td>
</tr>
<tr>
<td>EQ</td>
<td></td>
<td>Checks whether the accumulator value is equal to the operand value; result (BOOL) is written into the accumulator.</td>
<td>EQ iVar2</td>
</tr>
<tr>
<td>NE</td>
<td></td>
<td>Checks whether the accumulator value is not equal to the operand value; result (BOOL) is written into the accumulator.</td>
<td>NE iVar1</td>
</tr>
<tr>
<td>LE</td>
<td></td>
<td>Checks whether the accumulator value is smaller than or equal to the operand value; result (BOOL) is written into the accumulator.</td>
<td>LE 5</td>
</tr>
<tr>
<td>LT</td>
<td></td>
<td>Checks whether the accumulator value is smaller than the operand value; result (BOOL) is written into the accumulator.</td>
<td>LT cVar1</td>
</tr>
<tr>
<td>JMP</td>
<td>CN</td>
<td>Unconditional (conditional) jump to the specified jump label</td>
<td>JMPN next</td>
</tr>
<tr>
<td>CAL</td>
<td>CN</td>
<td>(Conditional) call of a program or a function block (if the accumulator value is TRUE)</td>
<td>CAL prog1</td>
</tr>
<tr>
<td>RET</td>
<td></td>
<td>Exit the box and return to the calling box.</td>
<td>RET</td>
</tr>
<tr>
<td>RET C</td>
<td></td>
<td>If the accumulator value is TRUE: exit the box and return to the calling box.</td>
<td>RETC</td>
</tr>
<tr>
<td>RET CN</td>
<td></td>
<td>If the accumulator value is FALSE: exit the box and return to the calling box.</td>
<td>RETCN</td>
</tr>
<tr>
<td>)</td>
<td></td>
<td>Evaluation of the reset operation</td>
<td></td>
</tr>
</tbody>
</table>
**Example**

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>AND</td>
<td>TRUE</td>
</tr>
<tr>
<td>2</td>
<td>AND</td>
<td>bVar1</td>
</tr>
<tr>
<td>3</td>
<td>DMOV</td>
<td>#1</td>
</tr>
<tr>
<td>4</td>
<td>LD</td>
<td>bVar2</td>
</tr>
<tr>
<td></td>
<td>ST</td>
<td>bRes</td>
</tr>
<tr>
<td></td>
<td>ni:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>LD</td>
<td>bVar2</td>
</tr>
<tr>
<td></td>
<td>ST</td>
<td>bRes</td>
</tr>
</tbody>
</table>

**Application Description Examples**

### Several operands for 1 operator

<table>
<thead>
<tr>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>You enter the operands into consecutive rows, separated by commas in the 2nd column.</td>
</tr>
<tr>
<td>You repeat the operator in consecutive rows.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Variant 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>LD</td>
</tr>
<tr>
<td>ADD</td>
</tr>
<tr>
<td>ST</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Variant 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>LD</td>
</tr>
<tr>
<td>ADD</td>
</tr>
<tr>
<td>ADD</td>
</tr>
<tr>
<td>ADD</td>
</tr>
<tr>
<td>ST</td>
</tr>
</tbody>
</table>

### Complex operands

For a complex operand, you enter the opening parenthesis in the first column. You enter the closing parenthesis in the first column in a separate row following the operand entries of the following rows.

A string is rotated by a character each cycle:

```plaintext
LD   stRotate
RIGHT ( stRotate
LEN   SUB   1
)    )
CONCRT ( stRotate
LEFT   1
)    )
ST   stRotate
```
<table>
<thead>
<tr>
<th>Application</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
</table>
| Function block call, program call  | Column 1: Operator **CAL** or **CALC**  
Column 2: Name of the function block instance or the program and opening parenthesis ( . If no parameters follow, the closing parenthesis ) is entered here.  
rows following that:  
Column 1: parameter name followed by : = for input parameter or => for output parameter  
Column 2: parameter value followed by a comma , if further parameters follow. The closing parenthesis ) is input after the last parameter.  
As a limitation according to the IEC standard, complex expressions cannot be used here. You must assign such constructs to the function block or the program before the call. | ![Function Call Row 1: Column 1: LD Column 2: input variable Row 2: Column 1: Function name Column 2: further input parameters separated by commas. CODESYS writes the return value into the accumulator. Row 3: Column 1: ST Column 2: variable into which the return value is written](image) |
| Function Call                       | Row 1: Column 1: **LD**  
Column 2: input variable  
Row 2: Column 1: Function name Column 2: further input parameters separated by commas.  
CODESYS writes the return value into the accumulator.  
Row 3: Column 1: **ST** Column 2: variable into which the return value is written | ![Function Call Row 1: Column 1: LD Column 2: input variable Row 2: Column 1: Function name Column 2: further input parameters separated by commas. CODESYS writes the return value into the accumulator. Row 3: Column 1: ST Column 2: variable into which the return value is written](image) |
| Action call                         | Like function block call or program call.  
The action name is appended to the name of the FB instance or the program. | ![Action call](image) |
Application Description Examples

| Jump | Column 1: operator JMP or JMPC. Column 2: Name of the jump label of the destination network. In the case of an unconditional jump, the preceding instruction sequence must end with one of the following commands: ST, STN, S, R, CAL, RET, JMP In the case of a conditional jump the execution of the jump depends on the loaded value. | [Example Table] |

See also
- % Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082
- % “Instruction list (IL)” on page 1861
- % Chapter 6.4.1.9.5.2.4 “Programming in instruction list (IL)” on page 1865

Elements

| 6.4.1.20.1.6.4.1 | FBD/LD/IL element 'Network'............................... 2091 |
| 6.4.1.20.1.6.4.2 | FBD/LD/IL element 'Box'........................................ 2092 |
| 6.4.1.20.1.6.4.3 | FBD/LD/IL element 'Assignment'........................... 2092 |
| 6.4.1.20.1.6.4.4 | FBD/LD/IL element 'Box with EN/ENO'.......................... 2092 |
| 6.4.1.20.1.6.4.5 | FBD/LD/IL element 'Input'..................................... 2093 |
| 6.4.1.20.1.6.4.6 | FBD/LD/IL element 'Label'.................................... 2093 |
| 6.4.1.20.1.6.4.7 | FBD/LD/IL element 'Jump'.................................... 2093 |
| 6.4.1.20.1.6.4.8 | FBD/LD/IL element 'Return'................................... 2093 |
| 6.4.1.20.1.6.4.9 | FBD/LD/IL element 'Branch'................................... 2093 |
| 6.4.1.20.1.6.4.10 | FBD/LD/IL element 'Execute'.................................. 2094 |
| 6.4.1.20.1.6.4.11 | LD element 'Contact'........................................... 2094 |
| 6.4.1.20.1.6.4.12 | LD element 'Coil'............................................... 2095 |
| 6.4.1.20.1.6.4.13 | LD element 'Branch Start/End'............................... 2095 |
| 6.4.1.20.1.6.4.14 | Closed branch.................................................... 2096 |

FBD/LD/IL element 'Network'

Symbol [Network]

A network is the base unit of an FBD or LD program. In the FBD/LD/IL editor, the networks are arranged in a list. Each network is provided with a sequential network number on the left side and can include: logical and arithmetic expressions, program/function/function block calls, jumps, or return statements.

An IL program consists of at least one network. This network can include all IL statements of the program.

You can provide each network with a title, comment, or label. In the CODESYS options (category "FBD, LD, and IL", you can define whether network title, comment, and separator between individual networks are displayed in the editor.

Click the first line of the network to enter a network title. Click the second line of the network to enter a network comment.
FBD/LD/IL element 'Box'

Symbol: 

A box and its call can represent additional functions, for example IEC function blocks, IEC functions, library function blocks, operators.

A box can have any number of inputs and outputs.

If the box also provides an image file, the box icon is displayed inside the box. The requirement is that the option “Show box symbol” is activated in the CODESYS options, category “FBD, LD and IL”.

If you have changed the box interfaces, you can update the box parameters with the command “FBD/LD/IL Update Parameters” without having to re-insert the box.

See also

- Chapter 6.4.1.21.3.14.5 “Command ’Insert Box”’ on page 2701
- Chapter 6.4.1.21.4.14.10 “Dialog ’Options’ - ’FBD, LD, and IL’” on page 2787
- Chapter 6.4.1.21.3.14.38 “Command ’Update Parameters”’ on page 2710

FBD/LD/IL element 'Assignment'

Symbol: 

The FBD editor shows a newly inserted assignment as a line with 3 question marks after it. The LD editor shows a newly inserted assignment as a coil with 3 question marks located above it.

After insertion you can replace the placeholder ??? by the name of the variable to which the signal coming from the left is to be assigned. The input assistant is available to you for this.

In IL an assignment is programmed via the operators LD and ST.

See also

- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082
- Chapter 6.4.1.21.3.14.4 “Command ’Insert Assignment”’ on page 2701

FBD/LD/IL element 'Box with EN/ENO'

Symbol: 

The element is available only in the FBD and LD editors.

The box generally corresponds to the FBD/LD/IL element “Box”; however, this box additionally contains an EN input and an ENO output. EN and ENO have the data type BOOL.

Function of the EN input and ENO output: if the input EN has the value FALSE at the time of the calling the box, the operations defined in the box are not executed. Otherwise, i.e. if EN has the value TRUE, these operations are executed. The ENO output has the same value as the EN input.

See also

- Chapter 6.4.1.21.3.14.6 “Command ’Insert Box with EN/ENO”’ on page 2702
- Chapter 6.4.1.20.1.6.4.2 “FBD/LD/IL element ’Box”’ on page 2092
FBD/LD/IL element 'Input'

Symbol: %

The maximum number of inputs depends on the type of box.

A newly added input is first marked with ???. You can replace the string ?? by a variable or a
constant.

See also

- % Chapter 6.4.1.21.3.14.13 “Command 'Insert Input'” on page 2703
- % Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082

FBD/LD/IL element 'Label'

The label is an optional identifier for a network in FBD and LD, which you can specify as a
destination for a jump.

If you insert a jump label in a network, it will be added as an editable field “Label:” in the
network.

See also

- % Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082
- % Chapter 6.4.1.21.3.14.11 “Command 'Insert Label'” on page 2703

FBD/LD/IL element 'Jump'

Symbol →

In FBD or LD a jump is inserted either directly before an input, directly after an output or at the
end of the network, depending on the current cursor position.

You enter a jump label as the jump destination directly behind the jump element.

In IL you program a jump with the instruction JMP.

See also

- % Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082
- % Chapter 6.4.1.21.3.14.10 “Command 'Insert Jump'” on page 2703
- % Chapter 6.4.1.20.1.6.4.6 “FBD/LD/IL element 'Label'” on page 2093

FBD/LD/IL element 'Return'

This element immediately interrupts the execution of the box if the input of the RETURN element
goes TRUE.

In an FBD or LD network you can place the Return instruction parallel to or after the preceding
elements.

In IL the RET instruction is available to you for this purpose.

See also

- % Chapter 6.4.1.21.3.14.12 “Command 'Insert Return'” on page 2703
- % Chapter 6.4.1.20.1.6.3 “Modifiers and operators in IL” on page 2087

FBD/LD/IL element 'Branch'

Symbol: ➕
The element is available in the LD and FBD editor and represents an open line branch. A line
branch splits the processing line from the current cursor position onwards into 2 subnetworks,
which are executed in succession from top to bottom. You can branch each subnetwork further,
as a result of which multiple branches are created within a network.

Each subnetwork is given a marker symbol (rectangle) at the branch point, which you can select
in order to execute further commands.

The commands “Copy”, “Cut” and “Paste” are not available for subnetworks.

In order to delete a subnetwork, you must first delete all elements of the network and then the
marker symbol of the subnetwork.

See also
- § Chapter 6.4.1.21.3.14.33 “Command 'Insert Branch’” on page 2709
- § Chapter 6.4.1.21.3.14.34 “Command 'Insert Branch Above’” on page 2709
- § Chapter 6.4.1.21.3.14.35 “Command 'Insert Branch Below'” on page 2709

**FBD/LD/IL element 'Execute'**

Symbol: 

The element is a box that enables you to directly enter ST code in the FBD and LD editors.
You can drag the “Execute” element with the mouse from the “Tools” view into the implementa-
tion part of your POU. If you click on “Enter ST code here…”, an input field opens where you can
input multiple-line ST code.

- § Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082

**LD element 'Contact'**

Symbol: 

The element is available only in the LD editor.
A contact passes on the signal \texttt{TRUE} (ON) or \texttt{FALSE} (OFF) from left to right until the signal finally reaches a coil in the right-hand part of the network. For this purpose a boolean variable containing the signal is assigned to the contact. To do this, replace the placeholder ??? above the contact with the name of a boolean variable.

You can arrange several contacts both in series and in parallel. In the case of two parallel contacts, only one needs to obtain the value \texttt{TRUE} in order for ON to be passed on to the right. If contacts are connected in series, all of them must obtain the value \texttt{TRUE} in order for ON to be passed on to the right by the last contact in the series. Hence, you can program electrical parallel and series connections with LD.

A negated contact forwards the signal \texttt{TRUE} if the variable value is \texttt{FALSE}. You can negate an inserted contact with the help of the command \texttt{"FBD/LD/IL \rightarrow Negation"} or insert a negated contact from the \texttt{"Tools"} view.

If you place the mouse pointer on a contact with the left mouse button pressed and with a network selected, the button \texttt{"Convert to coil"} appears in the network. If you now move the mouse pointer onto this button, still with the mouse button pressed, and then release the mouse button over this button, CODESYS converts the contact into a coil.

See also

- Chapter 6.4.1.21.3.14.17 “Command 'Insert Contact’’ on page 2704
- Chapter 6.4.1.21.3.14.22 “Command 'Insert Negated Contact'’ on page 2706
- Chapter 6.4.1.21.3.14.18 “Command 'Insert Contact (Right)'” on page 2705
- Chapter 6.4.1.21.3.14.20 “Command 'Insert Contact in Parallel (Above)'” on page 2705
- Chapter 6.4.1.21.3.14.19 “Command 'Insert Contact in Parallel (Below)'” on page 2705
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082

\section*{LD element 'Coil' }

Symbol: \texttt{\langle \rangle}, in the editor \texttt{\langle \rangle }

The element is available only in the LD editor.

A coil adopts the value supplied from the left and saves it in the boolean variable assigned to the coil. Its input can have the value \texttt{TRUE} (ON) or \texttt{FALSE} (OFF).

Several coils in a network can only be arranged in parallel.

In a negated coil \texttt{\langle \rangle } the negated value of the incoming signal is stored in the boolean variable that is assigned to the coil.

\subsection*{Set coil, Reset coil}

Symbol: \texttt{\langle \rangle \langle \rangle \langle \rangle \langle \rangle}, in the editor: \texttt{\langle \rangle \langle \rangle \langle \rangle \langle \rangle}

Set coil: If the value \texttt{TRUE} arrives at a set coil, the coil retains the value \texttt{TRUE}. As long as the application is running, the value can no longer be overwritten here.

Reset coil: If the value \texttt{TRUE} arrives at a reset coil, the coil retains the value \texttt{FALSE}. As long as the application is running, the value can no longer be overwritten here.

You can define an inserted coil as a set or reset coil with the help of the command \texttt{"FBD/LD/IL \rightarrow Set/Reset"} or insert it as an element “Set Coil” and “Reset Coil” from the “Tools” view.

See also

- Chapter 6.4.1.21.3.14.14 “Command 'Insert Coil'” on page 2704
- Chapter 6.4.1.21.3.14.16 “Command 'Insert Reset Coil'” on page 2704
- Chapter 6.4.1.21.3.14.29 “Command 'Negation’” on page 2708
- Chapter 6.4.1.21.3.14.31 “Command 'Set/Reset’’ on page 2708

\section*{LD element 'Branch Start/End' }

Symbol: \texttt{\langle \rangle}
The element serves the closed line branch.

See also

-  Chapter 6.4.1.20.1.6.4.14 “Closed branch” on page 2096
-  Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082
-  Chapter 6.4.1.21.3.14.36 “Command ‘Set Branch Start Point’” on page 2709
-  Chapter 6.4.1.21.3.14.37 “Command ‘Set Branch End Point’” on page 2710

Closed branch

A closed branch is available in LD only, and it contains a starting point and an end point. It is used for implementing parallel analyses of logical elements.

Inserting a closed branch

- Command “FBD/LD/IL ➔ Insert Contact Parallel (Below) ”
- Command “FBD/LD/IL ➔ Insert Contact Parallel (Above) ”
- Command “FBD/LD/IL ➔ Set Branch Start/End Point”

Closed branch at a contact

When you select one or more contacts and then execute the command “Insert Contact in Parallel”, a parallel branch is added with a single vertical line. For this kind of branching, the signal flow passes through both branches. This is an OR construct of both branches.

Closed branch at a block, OR evaluation, or short-circuit evaluation

New: When you select a box and execute the command “Insert Contact in Parallel”, a parallel branch is inserted with a double vertical line. This indicates that a short-circuit evaluation (SCE) is implemented. SCE allows for the execution of a function block with a Boolean output to be bypassed if a specific condition is TRUE. The condition can be displayed in the LD editor as a branch connected parallel to the function block branch. The short circuit condition is defined by one or more contacts in this branch that are interconnected parallel or sequentially.

Functional principle:

The branches that do not include the function block are processed first. If CODESYS detects the value TRUE for one of these branches, then the function block is not called in the parallel branch. In this case, the value at the input of the function block is sent directly to the output. If CODESYS determines FALSE for the SCE condition, then the box will be called and the Boolean result of its processing is passed on. If all branches contain function blocks, they are analyzed from top to bottom and their outputs are logically ORed. If there are no branches with function blocks, normal OR operations are performed.
The function block instance \( x_1 \) (TON) has a Boolean input and a Boolean output. The execution of \( x_1 \) is skipped if \( \text{TRUE} \) is determined for the condition in the parallel line branch. The condition value results from the OR and AND operations that connect contacts \( \text{cond1}, \text{cond2} \) and \( \text{cond3} \).

\( x_1 \) is executed if the condition value from the connection of the contacts \( \text{cond1}, \text{cond2} \) and \( \text{cond3} \) is \( \text{FALSE} \).

(1) Indicates from the double vertical connections that it is a construct subject to an SCE.

(2) Indicates from the single vertical connections that it is an OR construct.

The given LD example is shown below as ST code. \( \text{P_IN} \) and \( \text{P_OUT} \) are the Boolean values at the input (split point) and output (reunification point) of the parallel line branch.

\[
\text{P_IN} := \text{b1 AND b2};
\]

\[
\text{IF} \ ((\text{P_IN AND cond1}) \ AND \ (\text{cond2 OR cond3})) \ \text{THEN} \ \\
\quad \text{P_OUT} := \text{P_IN};
\]

\[
\text{ELSE} \ \\
\quad x1(\text{IN} := \text{P_IN}, \text{PT} := \{\text{p 10}\}\text{t#2s}); \\
\quad t\text{Elapsed} := x1.\text{ET}; \\
\quad \text{P_OUT} := x1.\text{Q}; \\
\quad \text{END IF}
\]

\[
\text{bRes} := \text{P_OUT AND b3};
\]

See also

- § Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082
- § Chapter 6.4.1.21.3.14.36 “Command 'Set Branch Start Point'” on page 2709
- § Chapter 6.4.1.21.3.14.37 “Command 'Set Branch End Point'” on page 2710
- § Chapter 6.4.1.21.3.14.20 “Command 'Insert Contact in Parallel (Above)’” on page 2705
- § Chapter 6.4.1.21.3.14.19 “Command 'Insert Contact in Parallel (Below)’” on page 2705
- § Chapter 6.4.1.21.3.14.21 “Command 'Toggle Parallel Mode’” on page 2706
General

From an external point of view, a Function Block Diagrams consists of inputs and outputs, with data being processed between them. From an internal point of view, a Function Block Diagrams consists of POUs and their connections which represent data (signals) and act as assignment operators in ST. The overall behavior is composed of the behavior of the inserted POUs which call other POUs or library POUs.

Code in the “Continuous Function Chart (CFC)” implementation language mainly illustrates the data flow through the system. Therefore, a continuous function chart is also referred to as a “signal flow chart”.

In the page-oriented CFC editor, you can wire POUs to each other and create well-structured Function Block Diagrams distributed over multiple pages. The page-oriented editor behaves like the CFC editor, but provides the following functionality:

The page-oriented editor behaves like the CFC editor, but provides additional functionality.

The editor supports you with the following functions:
- Creating pages
- Setting the page size
- Copying and inserting pages in the page navigator
- Copying the implementation of a POU in the CFC implementation language and inserting into a page
- Well-structured and space-saving arranging of inputs, outputs, and connection marks in the border areas
- Connection over pages with connection marks

CFC Editor

Configuring the editor

You can configure the appearance, behavior, and printing for the entire project in the CODESYS options in the “CFC Editor” category. For example, on the “View” tab, you can configure the color of the connecting lines depending on the data type.

Editing

<table>
<thead>
<tr>
<th>Cursor symbol:</th>
<th>Requirement: “Pointer” is selected in the “Toolbox” view.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The symbol indicates that you can edit in the editor. Select elements or connections to move them or to execute commands.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Cursor symbol:</th>
<th>Requirement: An element is selected in the “Toolbox” view.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Clicking in the editor inserts the selected element. You can also drag an element to the editor.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Dragging a function block instance from the declaration to the editor</th>
<th>Requirement: A line is selected in the declaration of the CFC.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The instance is inserted as a box with name, type, and all pins.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Dragging a variable from the declaration to a box pin to the editor</th>
<th>The variable is inserted as an input or output with a connection to the box pin in focus.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Hint: The cursor indicates when your focused location is valid for a variable:</td>
</tr>
</tbody>
</table>

```plaintext
                        ADD
                        +
```
| Dragging a variable from the declaration part to the editor | Requirement: The respective element is selected in the declaration.  
- Function block instance: A POU with the corresponding data type is created.  
- Declaration of **VAR_INPUT** or **CONSTANT**: An input element is inserted.  
- Declaration of **VAR_OUTPUT**: An output element is inserted.  
- Declaration of **VAR**, **VAR_GLOBAL**: A window opens at the insert location, where you can select whether an input element or output element should be inserted.  
When a variable is dragged from the declaration part to an existing replaceable element, the existing element is replaced. |
|---------------------------------------------------------------|
| Dragging a function block or POU to the editor from the “Devices” view, “POUs” view, or from the Library Manager. | A box element with the corresponding type is inserted.  
- When a box is dragged to an existing connecting line and both the input and output of the box are compatible with the data type of the line, the box is inserted in the line. Here its first matching input and output are connected to the elements that were previously connected by the connecting line.  
- When a box is dragged to an existing box, the existing box is replaced. |
| Resorting the order of inputs and outputs within a function block by means of drag&drop | Requirement: The text field of the input or output, which should be resorted to another location, is selected. |
| **[Ctrl]** + click in the programing area | Requirement: An element is selected in the “Toolbox” view.  
As long as you hold down the **[Ctrl]** key, a selected element is created each time you click in the programming area. |
| **[Ctrl]**+[Right Arrow] | Requirement: In the CFC program, **exactly** one output pin is selected for an element.  
The selection is moved so that the input pin at the end of the connecting line is selected. In the case of multiple pins, all are selected. |
Requirement: In the CFC program, exactly one input pin is selected for an element.
The selection is moved so that the output pin at the beginning of the connecting line is selected. In the case of multiple pins, all are selected.

Example:

![Diagram of CFC program with selected input and output pins.]

See also

- § Chapter 6.4.1.20.1.3 “Common functions in graphical editors” on page 2048

Connecting

You can insert connecting lines between element connections. Connecting lines are inserted by means of auto-routing so that connecting lines are automatically optimal and as short as possible. The connecting lines are checked for collisions.

<table>
<thead>
<tr>
<th>Dragging a pin to another</th>
<th>A connecting line is inserted between the two element pins.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dragging a pin to a function block</td>
<td>Dropping can be done on a pin or on the text field of a pin. In the case of extendable operators (example: ADD), dropping can also be done within the box. The following behavior applies for this: If there are still unconnected input pins, then the top free pin is connected. If there are no more unconnected input pins, then a new pin is automatically inserted below.</td>
</tr>
<tr>
<td>Command “Connect Selected Pins”</td>
<td>Requirement: Multiple pins are selected. The pins are marked in red.</td>
</tr>
<tr>
<td>Move an inserted element so that it touches the pin of another element.</td>
<td>Requirement: The “Enable AutoConnect” option is selected. The touching pins are connected automatically.</td>
</tr>
<tr>
<td>![Connection icon]</td>
<td>The connection icon is located in the upper right corner of the editor. A green icon indicates collision-free connections. A red icon indicates collisions. Clicking the icon opens a menu with commands for collision processing, for example the “Show Next Collision” command.</td>
</tr>
<tr>
<td>![Connection mark]</td>
<td>Requirement: A connection is selected and the “Connection Mark” command is executed. Instead of a long connecting line, a connection is represented by connection marks.</td>
</tr>
</tbody>
</table>

See also

- § Chapter 6.4.1.21.3.13.22 “Command ’Show Next Collision’” on page 2694
- § Chapter 6.4.1.21.3.13 “Menu ’CFC’” on page 2685
CFC editor, page-oriented

POUs generated in the “Continuous Function Chart (CFC) - page-oriented” cannot be converted into “Continuous Function Chart (CFC)” POUs or back.

- (1) Page navigator
- (2) Page header with name and description
- (3) Left border area reserved for inputs and sink connection marks
- (4) Program area
- (5) Right border area reserved for outputs and source connection marks

Editing

You can drag a “Page” element from the “ToolBox” view to the page navigation. Then an additional page is inserted.

You can select existing pages in the page navigation and duplicated them by clicking “Edit ➔ Copy” and “Edit ➔ Paste”.

The size of the page is changed by means of the “Edit Page Size” command.

Connections over multiple pages are established by means of the “Connection Mark - Source” and “Connection Mark - Sink” elements. When you drag a connecting line from an input pin or an output pin to the border area, a new connection mark is created automatically. The advantage is that the "List components" input assistance provides all previously defined connection mark sources.

If you have selected an element in the editor, then you can use the arrow keys to move the selection from one element to the next to navigate through the circuit. If you then select a connection mark and press another arrow key, even the corresponding connection mark of the next/previous page will be selected.

See also

- Chapter 6.4.1.20.1.3 “Common functions in graphical editors” on page 2048
- Chapter 6.4.1.9.5.3.3 “Programming in the CFC editor” on page 1871
- Chapter 6.4.1.21.3.13 “Menu ‘CFC’” on page 2685
- Chapter 6.4.1.21.4.11.14 “Dialog ‘Properties’ - ‘CFC Execution Order’” on page 2761
You can transfer networks from a CFC POU to the program area of a page-oriented CFC by clicking “Edit ➔ Copy” and “Edit ➔ Paste” (from the clipboard). You can also use drag&drop.

**Execution order**

The execution order is determined automatically according to the order of the pages as they are sorted in the page navigator of the editor. Within a page, a page-oriented CFC object behaves like a CFC object. Therefore, you can switch between “Auto Data Flow Mode” and “Explicit Execution Order Mode”.

**Additional commands in “CFC page-oriented”**

See also

- Chapter 6.4.1.21.3.13.2 “Command 'Edit Page Size’” on page 2686
- Chapter 6.4.1.21.3.13.1 “Command ‘Edit Worksheet’” on page 2685

See also

- Chapter 6.4.1.20.1.3 “Common functions in graphical editors” on page 2048
- Chapter 6.4.1.20.1.3 “Programming in the CFC editor” on page 1871
- Chapter 6.4.1.9.5.3.2 “Automatic Execution Order by Data Flow” on page 1867
- Chapter 6.4.1.21.3.13 “Menu ‘CFC’” on page 2685
- Chapter 6.4.1.21.4.11.14 “Dialog 'Properties' - 'CFC Execution Order’” on page 2761

### Keyboard Shortcuts in the CFC Editors

<table>
<thead>
<tr>
<th>Keyboard shortcuts</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Ctrl]+[Shift]+[A]</td>
<td>Select All</td>
</tr>
</tbody>
</table>

#### Insert elements:

<table>
<thead>
<tr>
<th>Keyboard shortcuts</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Ctrl]+[B]</td>
<td>Insert Box</td>
</tr>
<tr>
<td>[Ctrl]+[B]</td>
<td>The “Input Assistant” dialog opens in order to select the box.</td>
</tr>
<tr>
<td>[Ctrl]+[Shift]+[B]</td>
<td>Insert Empty Box</td>
</tr>
<tr>
<td>[Ctrl]+[Shift]+[E]</td>
<td>Insert Box with EN/ENO</td>
</tr>
<tr>
<td>[Ctrl]+[Q]</td>
<td>The “Input Assistant” dialog opens in order to select the box.</td>
</tr>
<tr>
<td>[Ctrl]+[A]</td>
<td>Insert Input</td>
</tr>
<tr>
<td>[Ctrl]+[L]</td>
<td>Inserts an input element</td>
</tr>
<tr>
<td>[Ctrl]+[A]</td>
<td>Insert Output</td>
</tr>
<tr>
<td>[Ctrl]+[L]</td>
<td>Inserts an output element</td>
</tr>
<tr>
<td>[Ctrl]+[N]</td>
<td>Insert Jump</td>
</tr>
</tbody>
</table>

#### Edit already inserted elements:

<table>
<thead>
<tr>
<th>Keyboard shortcuts</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Ctrl]+[N]</td>
<td>Negate</td>
</tr>
<tr>
<td>[Ctrl]+[M]</td>
<td>Toggle between Set, Reset, REF, and None</td>
</tr>
<tr>
<td>[Ctrl]+[U]</td>
<td>Reset Pins</td>
</tr>
</tbody>
</table>

After inserting an element, the inserted element is selected in the editor.

See also

- Chapter 6.4.1.20.1.7.6.5 “CFC Element 'Box’” on page 2110
- Chapter 6.4.1.20.1.7.6.3 “CFC Element 'Input’” on page 2109
- Chapter 6.4.1.20.1.7.6.4 “CFC Element 'Output’” on page 2109
- Chapter 6.4.1.20.1.7.6.6 “CFC element 'Jump’” on page 2110
CFC Editor in Online Mode

In online mode, you can monitor and change variable values of the controller. In addition, debugging features are provided such as breakpoints and stepping.

Monitoring

As usual, you can monitor values in the declaration part as well as in the implementation part (with inline monitoring).

Inline monitoring of a function block is possible only when an instance of the function block is open. No values are displayed in the basic implementation view.

Monitoring a Boolean variable

The connections between Boolean variables are displayed in color according to their actual value: TRUE in blue and FALSE in black. The element pins are decorated with the actual value.
An application contains a CFC POU. An internal Boolean variable is switched there. With each cycle, the variable `iToggle` switches its state from `TRUE` to `FALSE`.

Example

Monitoring a scalar variable

In the case of scalar variables, the element pins are decorated with the actual values.
In online mode in the declaration editor, you can prepare a value for forcing or writing a monitored variable.

When you select the "Prepare values in implementation part" check box in the "CFC Editor" category of the CODESYS options, you can also prepare values in the implementation part.

To do this, open the "Prepare Value" dialog by double-clicking an element or the monitoring box next to an element. No dialog appears for Boolean variables. However, with each mouse click on the value displayed next to the variable, the values TRUE and FALSE are toggled.

Prepared values are displayed in angle brackets. After executing a write or a force, a red "F" is shown in the monitoring box.

You can write input parameters of function block instances of type VAR_INPUT CONSTANT in online mode and modify the parameters in this way. After logging out, you save these parameters by clicking "Save Prepared Parameters to Project".
Requirement: A CFC editor is active. An instantiated function block has VAR_INPUT CONSTANT variables in its declaration.

1. In the editor, open the POU by calling the function block instance.

   ```
   FUNCTION_BLOCK FB_DoIt
   VAR_INPUT
   iAlfa : INT;
   iBravo : INT;
   sCharlie : STRING := 'Charlie';
   xItem : BOOL;
   iDelta : INT;
   END_VAR
   VAR_INPUT CONSTANT
   MAXIMUM : INT := 12;
   END_VAR
   VAR_OUTPUT
   iResult : INT;
   sResult : STRING;
   xResult : BOOL;
   END_VAR
   
   The declaration of FB_DoIt has been supplemented by the constant MAXIMUM.
   ```

2. Login to the controller.
3. Click the "Parameters" button of the function block instance.
   ⇒ The "Edit Parameters" dialog opens.
4. Click the "Value" column in an inline monitoring field of a parameter.
   ⇒ The "Prepare Value" dialog opens.
5. Type 20 in the "Prepare a new value for the next write or force operation" field.
6. Click "OK" to confirm the entry.
   ⇒ The prepared value is shown in angle brackets next to the current value (for example, <20>).
7. Click “Debug ➔ Write Values”.

- The prepared value is written. The parameter is changed and displayed in the project in brackets after the value.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Value</th>
<th>Initial value</th>
<th>Min</th>
<th>Max</th>
<th>Unit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>[20]</td>
<td>20</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The difference between both values is shown by a red cross next to the parameter field of the function block instance.

8. Click “Edit Parameters” to close the dialog. Logout.

9. Click “CFC ➔ Save Prepared Parameters to Project”.

- The change parameter values are saved to the project. The asterisk next to the parameter field disappears.

Breakpoint locations

- Possible position of a breakpoint
  - Element “Output”
    - Variables are described.
  - Element “Box”
    - POU’s are called.
  - Element “RETURN”
    - The program flow is branched.
  - Element “Selector”
    - Structure elements are described.

Click “Debug ➔ Toggle Breakpoint” to set a new breakpoint or delete an existing breakpoint. A red circle in the block diagram represents an active breakpoint.
NOTICE!

A breakpoint is set automatically in all methods that can be called.

Therefore, if a method is called that is defined over an interface, then breakpoints are set in all methods of function blocks that implement this interface. This also applies to all inherited function blocks that define methods.

You can process a POU in steps in debug mode. A called POU is supplemented internally by a `RETURN` at the beginning before the element with the number 0 and at the end after the last element. When stepping, these are started automatically.

**Stepping into a POU**

**Commands in online mode**

See also

- Chapter 6.4.1.21.3.13.35 “Command 'Force Function Block Input'” on page 2697
- Chapter 6.4.1.21.3.13.34 “Command 'Prepare Box for Forcing'” on page 2697
- Chapter 6.4.1.21.3.13.18 “Command 'Edit Parameters'” on page 2692
- Chapter 6.4.1.21.3.13.19 “Command 'Save Prepared Parameters to Project'” on page 2693

See also

- Chapter 6.4.1.13.2 “Monitoring of Values” on page 1995
- Chapter 6.4.1.12.5 “Forcing and Writing of Variables” on page 1987
- “Forcing a function block input in CFC” on page 1989
- Chapter 6.4.1.12.3 “Using Breakpoints” on page 1981
- Chapter 6.4.1.12.4 “Stepping Through a Program” on page 1985
Elements

6.4.1.20.1.7.6.1  CFC element 'Page'.............................................................. 2109
6.4.1.20.1.7.6.2  CFC element 'Control Point'................................................. 2109
6.4.1.20.1.7.6.3  CFC Element 'Input'.............................................................. 2109
6.4.1.20.1.7.6.4  CFC Element 'Output'........................................................... 2109
6.4.1.20.1.7.6.5  CFC Element 'Box'................................................................ 2110
6.4.1.20.1.7.6.6  CFC element 'Jump'............................................................. 2110
6.4.1.20.1.7.6.7  CFC element 'Label'.............................................................. 2111
6.4.1.20.1.7.6.8  CFC element 'Return'............................................................ 2111
6.4.1.20.1.7.6.9  CFC element 'Composer'...................................................... 2111
6.4.1.20.1.7.6.10 CFC element 'Selector'.......................................................... 2111
6.4.1.20.1.7.6.11 CFC element 'Comment'....................................................... 2111
6.4.1.20.1.7.6.12 CFC element 'Connection Mark - Source/Sink'.................. 2112
6.4.1.20.1.7.6.13 CFC element 'Input Pin'...................................................... 2112
6.4.1.20.1.7.6.14 CFC element 'Output Pin'................................................... 2112
6.4.1.20.1.7.6.15 CFC element 'Comment'..................................................... 2111
6.4.1.20.1.7.6.16 CFC element 'Connection Mark - Source/Sink'.................. 2112
6.4.1.20.1.7.6.17 CFC element 'Input Pin'...................................................... 2112
6.4.1.20.1.7.6.18 CFC element 'Output Pin'................................................... 2112

CFC element 'Page'
Symbol: ☐

The element inserts a new page into the editor. It is available only in the page-oriented CFC editor. The number of the page is automatically assigned in accordance with its position. You can enter the name and the description of the page into the orange header. The page size is adapted with the “Edit Page Size” command.

See also
● § Chapter 6.4.1.21.3.13.2 “Command ‘Edit Page Size’” on page 2686

CFC element 'Control Point'
Symbol: ▲

Use a control point in order to fix points of a connection before you adapt the line routing. To do this, drag the element to the desired position on a connecting line. Connecting lines with control points are no longer routed automatically.

See also
● § Chapter 6.4.1.9.5.3.3 “Programming in the CFC editor” on page 1871
● § Chapter 6.4.1.21.3.13.30 “Command ‘Create Control Point’” on page 2696
● § Chapter 6.4.1.21.3.13.29 “Command ‘Remove Control Point’” on page 2695

CFC Element 'Input'
Symbol: ➡

Keyboard shortcuts for inserting the element: [Ctrl]+[Q]

By default, CODESYS inserts an input element with the text "???. You can edit this input field directly by clicking it and typing in a constant value or a variable name. Alternatively, you could click [.] to open the Input Assistant to select a variable.

CFC Element 'Output'
Symbol: ➢

Keyboard shortcuts for inserting the element: [Ctrl]+[A]
By default, CODESYS inserts an output element with the text "???. You can edit this input field directly by clicking it and typing in a constant value or a variable name. Alternatively, you could click ... to open the Input Assistant to select a variable.

CFC Element 'Box'

Symbol: ⧭

Keyboard shortcuts for inserting the element

- [Ctrl]+[B]: Empty box
- [Ctrl]+[Shift]+[B]: Box with EN/ENO

You use the element in order to insert an operator, a function, a function block, or a program. By default, CODESYS inserts the element with the name "???. You can edit this field directly by clicking it and typing in a function block name. Alternatively, you could click ... to open the Input Assistant and select a function block.

In the case of a function block, CODESYS also displays an input field ("???) above the function block symbol. You have to replace this name with the name of the function block instance. If you instantiate a function block with constant input parameters, then the function block element displays the "Parameter..." field in the bottom left corner. You click on this field to edit the parameters.

In order to replace an existing box, you replace only the currently inserted identifier with the new desired name. When you do this, note that CODESYS adapts the number of input and output pins according to the definition of the POU and that existing assignments may be deleted as a result.

**NOTICE!**

Because feedback is allowed in CFC, implicit variables with the data type of the input variable are created at the output of a box (in the example: temp_USINT). If the result of the operation of a function block is a value which exceeds the number range of the data type of the input variable, then the overflow is written to the implicit variable. The actual output variable gets the value of the implicit variable, thus the overflow and not the actual result of the operation (see example).

**Example**

Implicitly generated variables at the box output:

![Diagram](image)

Implicitly generated code:

```plaintext
temp_USINT := USINT1 * temp_USINT;
UDINT1 := temp_USINT;
```

See also

- Section 6.4.1.2.3.13.18 "Command 'Edit Parameters'" on page 2692

**CFC element 'Jump'

Symbol: ⫸
You use the element in order to define a position at which program execution is to continue. You must define this target position by a label. To do this, enter the name of the mark in the input field “???”. If you have already inserted the corresponding label, you can also select it via the input assistant (↵). See also

- Chapter 6.4.1.20.1.7.6.7 “CFC element 'Label'” on page 2111

**CFC element 'Label'**

Symbol: 

A label defines a position to which program execution jumps with the help of a jump element. In online mode CODESYS automatically inserts a RETURN flag at the end of a CFC function block.

See also

- Chapter 6.4.1.20.1.7.6.6 “CFC element 'Jump'” on page 2110

**CFC element 'Return'**

Symbol: ➡

Use the element in order to exit the function block.

Please note that in online mode in the CFC editor a return element is automatically inserted before the first line and after the last element. In single-step execution CODESYS automatically jumps to the return element at the end before exiting the function block.

**CFC element 'Composer'**

Symbol: 

The composer element is for handling structural components. The individual components of a structure are made available to you as an input. For this purpose you must name the composer element like the structure concerned (replace the “???”).

The composer element is the counterpart to the selector element.

See also

- Chapter 6.4.1.20.1.7.6.10 “CFC element 'Selector'” on page 2111

**CFC element 'Selector'**

Symbol: 

The selector element is for handling structural components. The individual components of a structure are made available to you as an output. For this purpose you must name the selector element like the structure concerned (replace the “???”).

The selector element is the counterpart to the composer element.

See also

- Chapter 6.4.1.20.1.7.6.9 “CFC element 'Composer'” on page 2111

**CFC element 'Comment'**

Symbol: 

128x765 2024/01/05 3ADR010583, 1, en_US 2111
With this element you input a comment in the CFC editor. Replace the placeholder text in the element by the comment text. A line break can be inserted with the aid of the shortcut [Ctrl] + [Enter].

**CFC element 'Connection Mark - Source/Sink'**

Symbol: ➔, ➙

You can use connection marks instead of a connecting line between elements. That helps you to display complex diagrams more clearly.

For a valid connection you must connect an element “Connection Mark - Source” with the output of an element and an element “Connection Mark - Sink” with the input of another element. Both marks must bear the same name. The names are not case-sensitive.

Notes on naming

- The standard name for connection marks is C-<nr>. <nr> is a sequential number starting with 1.
- You can rename the standard name. In doing so, you must make sure that the connection mark - source and connection mark - sink have the same name.
- If you change the name of the connection mark - source, the destination name is automatically renamed.
- If you change the name of the connection mark - sink, the source name is retained.

Observe the command “Connection Mark” for the automatic transformation of an existing connection.

See also

- Chapter 6.4.1.21.3.13.31 “Command ‘Connection Mark’” on page 2696
- Chapter 6.4.1.20.1.7.2 “CFC Editor” on page 2098

**CFC element 'Input Pin'**

Symbol: ⬃

Depending on the type of function block you can add further inputs to an inserted function block element. To do this you must select the function block element and drag the function block input element onto the body of the function block.

Please note: You can drag an input or output connection to another position on the function block with the [Ctrl] key pressed.

See also

- Chapter 6.4.1.20.1.7.6.14 “CFC element 'Output Pin’” on page 2112

**CFC element 'Output Pin'**

Symbol: ⬄

Depending on the type of function block you can add further outputs to an inserted function block element. To do this you must select the function block element and drag the function block output element onto the body of the function block.

Please note: You can drag an input or output connection to another position on the function block with the [Ctrl] key pressed.

See also

- Chapter 6.4.1.20.1.7.6.13 “CFC element 'Input Pin’” on page 2112
### Variables

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.4.1.20.2.1</td>
<td>General</td>
</tr>
<tr>
<td>6.4.1.20.2.2</td>
<td>Local variables - VAR</td>
</tr>
<tr>
<td>6.4.1.20.2.3</td>
<td>Input variables - VAR_INPUT</td>
</tr>
<tr>
<td>6.4.1.20.2.4</td>
<td>Output variables - VAR_OUTPUT</td>
</tr>
<tr>
<td>6.4.1.20.2.5</td>
<td>Input/Output Variable (VAR_IN_OUT)</td>
</tr>
<tr>
<td>6.4.1.20.2.6</td>
<td>Global variables - VAR_GLOBAL</td>
</tr>
<tr>
<td>6.4.1.20.2.7</td>
<td>Temporary variable - VAR_TEMP</td>
</tr>
<tr>
<td>6.4.1.20.2.8</td>
<td>Static variables - VAR_STAT</td>
</tr>
<tr>
<td>6.4.1.20.2.9</td>
<td>External variables - VAR_EXTERNAL</td>
</tr>
<tr>
<td>6.4.1.20.2.10</td>
<td>Instance variables - VAR_INST</td>
</tr>
<tr>
<td>6.4.1.20.2.11</td>
<td>Configuration variables - VAR_CONFIG</td>
</tr>
<tr>
<td>6.4.1.20.2.12</td>
<td>Constant Variables - 'CONSTANT'</td>
</tr>
<tr>
<td>6.4.1.20.2.13</td>
<td>Persistent Variable - PERSISTENT</td>
</tr>
<tr>
<td>6.4.1.20.2.14</td>
<td>Retain Variable - RETAIN</td>
</tr>
<tr>
<td>6.4.1.20.2.15</td>
<td>SUPER</td>
</tr>
<tr>
<td>6.4.1.20.2.16</td>
<td>THIS</td>
</tr>
</tbody>
</table>

#### General

The scope of a variable defines how and where you can use a variable. You define the scope in the variable declaration.

#### Local variables - VAR

Local variables are declared between the keywords **VAR** and **END_VAR** in the declaration part of programming objects.

You have read-only access to local variables by using the instance path.

You can extend local variables with an attribute keyword.

##### Example

```plaintext
VAR
  iVar1 : INT;
END_VAR
```

See also

- Chapter 6.4.1.9.19 “Data Persistence” on page 1920

#### Input variables - VAR_INPUT

Input variables are used at the inputs of function blocks.

**VAR_INPUT** variables are declared between the keywords **VAR_INPUT** and **END_VAR** in the declaration part of programming objects.

You can extend input variables with an attribute keyword.
Output variables - VAR_OUTPUT

Output variables are used at the outputs of function blocks. VAR_OUTPUT variables are declared between the keywords VAR_OUTPUT and END_VAR in the declaration part of programming objects. CODESYS returns the values of this variable to the calling POU. There you can retrieve the values and continue using them.

You can extend output variables with an attribute keyword.

Example

```
VAR_OUTPUT
   iOut1 : INT; (* 1st output variable *)
END_VAR
```

See also

- § Chapter 6.4.1.9.19 “Data Persistence” on page 1920

Output variables in functions and methods

According to the IEC 61131-3 standard, functions and methods have additional outputs. You have to assign these additional outputs when calling the function, as shown below.

Example

```
fun(iIn1 := 1, iIn2 := 2, iOut1 => iLoc1, iOut2 => iLoc2);
```

Input/Output Variable (VAR_IN_OUT)

A VAR_IN_OUT variable is an input/output variable, which is part of a POU interface and serves as a formal pass-by-reference parameter.

Syntax declaration

```
<keyword> <POU name>
VAR_IN_OUT
   <variable name> : <data type> ( := <initialization value> )? ;
END_VAR
<keyword> : FUNCTION | FUNCTION_BLOCK | METHOD | PRG
```

You can declare an input/output variable in the VAR_IN_OUT declaration section in the POU's PRG, FUNCTION_BLOCK, METHOD, or FUNCTION. As an option, a constant of the declared data type can be assigned as an initialization value. The VAR_IN_OUT variable can be read and written.
Usage

- **Call**: When a POU is called, the formal `VAR_IN_OUT` variable receives the actual variable (pass-by-reference variable) as the argument. At runtime, no copies are generated when parameters are passed. Instead, the formal variable receives a reference to the actual variable passed remotely. The referential variables contain a memory address internally as a value to the actual value (pass as pointer, call-by reference). It is not possible to specify a constant (literal) or a bit variable directly as an argument.

- **Read/write access within the POU**: If the variable is written to within the POU, then this affects the passed variable. When the POU is exited, any performed changes are retained. This means that a POU uses its `VAR_IN_OUT` variables just like the calling POU uses its variables. Read access is always permitted.

- **Read/write access remotely**: `VAR_IN_OUT` variables cannot be directly read or written remotely via `<function block instance name>..<variable name>`. This works only for `VAR_INPUT` and `VAR_OUTPUT` variables.

- **Passing string variables**: If a string variable is passed as an argument, then the actual variable and the formal variable should have the same length. Otherwise the passed string can be manipulated unintentionally. This problem does not occur in the case of `VAR_OUTPUT CONSTANT` parameters.

- **Passing bit variables**: A bit variable cannot be passed directly to a `VAR_IN_OUT` variable because it needs an intermediate variable.

- **Passing properties**: Not permitted.

---

| If a string is passed as a variable or a constant to a formal `VAR_IN_OUT CONSTANT` variable, then the string is automatically passed completely. You do not have to check the string length. |

---

See also

- Chapter “Transfer variable `VAR_IN_OUT CONSTANT`” on page 2117
Example

Passing arrays

```
TYPE DUT_A :
  STRUCT
    xA: BOOL;
    iB: INT;
  END_STRUCT
END_TYPE

FUNCTION_BLOCK FB_SetArray
  VAR_IN_OUT
    aData_A : ARRAY[0..1] OF DUT_A; // Formal variable
  END_VAR

  aData_A[0].xA := TRUE;
  aData_A[0].iB := 100;

PROGRAM PLC_PRG
  VAR
    fbSetA : FB_SetArray;
    aSpecialData : ARRAY[0..1] OF DUT_A; // Actual variable
  END_VAR

  fbSetA(aData_A := aSpecialData);
```

Passing strings

```
{attribute 'qualified_only'}
  VAR_GLOBAL
    g_sDEV_STATUS : STRING(25) := 'Device_A';
  END_VAR

  FUNCTION_BLOCK FB_SetStatus
    VAR_IN_OUT
      sDeviceStatus : STRING(25); // Formal parameter
    END_VAR

    sDeviceStatus := CONCAT(sDeviceStatus, ' Activ');

  PROGRAM PLC_PRG
    VAR
      fbDoB : FB_SetStatus;
    END_VAR

    fbDoB(sDeviceStatus := GVL.g_sDEV_STATUS); // Call with actual parameter

The variable sDeviceStatus is part of the POU interface of FB_B. When calling fbDoB, first a device name is assigned to the string and then the string is manipulated.
```

Passing bit variables

```
  VAR_GLOBAL
    xBit0 AT %MX0.1 : BOOL;
    xTemp : BOOL;
  END_VAR

  FUNCTION_BLOCK FB_DoSomething
    VAR_INPUT

```

{attribute 'qualified_only'}

PROGRAM PLC_PRG

VAR
  xIn : BOOL;
  DoSomething_1 : FB_DoSomething;
  DoSomething_2 : FB_DoSomething;
END_VAR

// The following line of code causes a compiler error:
// C0201: Typ 'BIT' is not equal to type 'BOOL' of VAR_IN_OUT 'xInOut'
DoSomething_1(xIn := xIn, xInOut := xBit0);

// Workaround
xTemp := xBit0;
DoSomething_2(xIn := xIn, xInOut := xTemp);
xBit0 := xTemp;

The program calls the function block instances DoSomething_1 and DoSomething_2. As a result of the direct assignment of the bit variable xBit0 to the VAR_IN_OUT input, a compiler error is generated when the DoSomething_1 instance is called. In contrast, calling the DoSomething_2 instance with the assignment of an intermediate variable is correct code.
**Example**

**Passing parameters of string constants and string variables**

```plaintext
FUNCTION funManipulate : BOOL
VAR_IN_OUT
  sReadWrite : STRING(16); (* Can be read or written here in POU *)
  dwVarReadWrite : DWORD; (* Can be read or written here in POU *)
END_VAR

VAR_IN_OUT CONSTANT
  c_sReadOnly : STRING(16); (* Constant string variable can only be read here in POU *)
END_VAR

sReadWrite := 'String_from_POU';
dwVarReadWrite := STRING_TO_DWORD(c_sReadOnly);

PROGRAM PRG_A
VAR
  sVarFits : STRING(16);
  sValFits : STRING(16) := '1234567890123456';
  dwVar : DWORD;
END_VAR

// The following line of code causes the compiler error C0417:
// C0417: VAR_IN_OUT parameter 'sReadWrite' needs a variable with write access as input.
funManipulate(sReadWrite:='1234567890123456',
c_sReadOnly:='1234567890123456',
dwVarReadWrite := dwVar);

// Correct code
funManipulate(sReadWrite := sValFits,
c_sReadOnly := '23',
dwVarReadWrite := dwVar);

funManipulate(sReadWrite := sVarFits,
c_sReadOnly := sValFits,
dwVarReadWrite := dwVar);
```

In the code, strings are passed to the `funManipulate` function via different `VAR_IN_OUT` variables. When passing a string literal, a compiler error is output to a `VAR_IN_OUT` variable. When passing a constant variable to a `VAR_IN_OUT` CONSTANT variable, correct code is generated even for passing string variables.

---

**See also**
- Chapter 6.4.1.9.4 “Declaration of Variables” on page 1847
- Chapter 6.4.1.21.4.12.4 “Dialog Box ‘Project Settings’ - ‘Compileoptions” on page 2769
- Chapter 6.4.1.21.2.21.4 “Object ‘Function’” on page 2482
- Chapter 6.4.1.21.2.21.3 “Object ‘Function Block’” on page 2479
- Chapter 6.4.1.21.2.21.6 “Object ‘Method’” on page 2485
- Chapter 6.4.1.21.2.21.5 “Object ‘Interface’” on page 2484
- Chapter 6.4.1.21.2.21.7 “Object ‘Interface Method’” on page 2490
- Chapter 6.4.1.20.2.12 “Constant Variables - ‘CONSTANT’” on page 2121

---

**Global variables - VAR_GLOBAL**

Global variables are ordinary variables, constants, external or remanent variables that are recognized within the entire project. You declare global variables in global variable lists or in the declaration section of programming objects between the keywords `VAR_GLOBAL` and `END_VAR`. 
The system recognizes a global variable when you prepend the variable name with a dot (for example,.iGlobVar1).

NOTICE!
If a local variable that is declared in a block has the same name as a global variable, then it has precedence within the block.

NOTICE!
For compiler version 3.2.0.0 and later, CODESYS always initializes global variables before the local POU variables.

Example

```plaintext
VAR_GLOBAL
   iVarGlob1 : INT;
END_VAR
```

See also
- Chapter 6.4.1.21.2.12 “Object ‘GVL’ - Global Variable List” on page 2465
- Chapter 6.4.1.20.3.70 “Operator - Global namespace” on page 2216

Temporary variable - VAR_TEMP

This function is an extension of the IEC 61131-3 standard.
You declare temporary variables locally between the keywords VAR_TEMP and END_VAR.

VAR_TEMP declarations are possible only in program blocks and function blocks.
CODESYS initializes temporary variables each time the block is called.
The application can access the temporary variables only in the implementation section of a program block or a function block.

Example

```plaintext
VAR_TEMP
   iVarTmp1 : INT; (*1st temporary variable *)
END_VAR
```

Static variables - VAR_STAT

This function is an extension of the IEC 61131-3 standard.
You declare static variables locally between the keywords VAR_STAT and END_VAR. CODESYS initializes static variables the first time each block is called.
You can access static variables only from within the namespace where the variables are declared (like static variables in C). But static variables retain their values when the application leaves the block. For example, you can use static variables as counters for function calls.
You can extend static variables with an attribute keyword.
Example

```plaintext
VAR_STAT
   iVarStat1 : INT;
END_VAR
```

See also

- Chapter 6.4.1.9.19 “Data Persistence” on page 1920

External variables - **VAR_EXTERNAL**

External variables are global variables that are imported into a block.

You declare these variables between the keywords **VAR_EXTERNAL** and **END_VAR**. If the global variable does not exist, then an error message is printed.

**NOTICE!**

CODESYS does not require you to declare a global variable as external in order to use it in a POU. The keyword exists only for maintaining compliance with IEC 61131-3.

Syntax

```
<POU keyword> <POU name>
VAR_EXTERNAL
    <variable name> : <data type>;
END_VAR
```

Initialization is not permitted.

Example

```plaintext
FUNCTION_BLOCK FB_DoSomething
VAR_EXTERNAL
   iVarExt1 : INT; (* 1st external variable *)
END_VAR
```

See also

- Chapter 6.4.1.21.2.12 “Object ‘GVL’ - Global Variable List” on page 2465

Instance variables - **VAR_INST**

CODESYS does not save a **VAR_INST** method variable in a method stack, but in the stack of the function block instance. This means that the **VAR_INST** variable functions like other Variables of the function block instance, and it is not reinitialized each time the method is called.

**VAR_INST** variables are permitted in methods only and you can access these variables only within the method. The variable values of instance variables are monitored in the declaration section of the method.

You can extend instance variable with an attribute keyword.
Example

```plaintext
METHOD meth_last : INT
VAR_INPUT
  iVar : INT;
END_VAR
VAR_INST
  iLast : INT := 0;
END_VAR
meth_last := iLast;
iLast := iVar;
```

Configuration variables - VAR_CONFIG

Use configuration variables for assigning complete addresses to variables that are declared in function blocks with incomplete addresses and will be mapped on device I/Os.

Declare the variables in a global variables list between VAR_CONFIG and END_VAR. The global variables list is termed "variables configuration", where you type the configuration variables with a complete instance path and the correct address.

Example

Declaration of the variable `xLocIn` with incomplete address `%I*` in a function block:

```plaintext
FUNCTION_BLOCK locio
VAR
  xLocIn AT %I* : BOOL := TRUE;
END_VAR
```

The `locio` function block is used in the `PLC_PRG` program:

```plaintext
PROGRAM PLC_PRG
VAR
  locioVar1 : locio;
END_VAR
```

The correct variables configuration in the global variable list is as follows:

```plaintext
VAR_CONFIG
  PLC_PRG.locioVar1.xLocIn AT %IX1.0 : BOOL;
END_VAR
```

See also

- Chapter 6.4.1.9.12.2 “Variables configuration - VAR_CONFIG” on page 1901

Constant Variables - 'CONSTANT'

Constant variables are declared in global variable lists or in the declaration part of programming objects. In implementations, constant variables can be accessed as read-only via the instance path.
CONSTANT

<identifier> : <data type> := <initial value> ;
END_VAR

VAR : VAR | VAR_INPUT | VAR_STAT | VAR_GLOBAL
<data type>: <elementary data type> | <user defined data type> |
<function block>
<initial value> : <literal value> | <identifier> | <expression>

Always assign an initialization value when declaring a constant variable. Then the constant cannot be written any more.

Example

Declaration

VAR CONSTANT
  c_rTAXFACTOR : REAL := 1.19;
END_VAR

Call

rPrice := rValue * c_rTAXFACTOR;

You have read-only access to constant variables in an implementation. Constant variables are located to the right of the assignment operator.

See also

- % Chapter 6.4.1.20.2.5 “Input/Output Variable (VAR_IN_OUT)” on page 2114
- % “Constants and literals” on page 2219

Persistent Variable - PERSISTENT

Persistent variables are declared in the declaration section VAR_GLOBAL RETAIN PERSISTENT in the persistent global variable list. For variables that are marked with the PERSISTENT keyword outside of the persistence editor, instance paths are added there.

As of CODESYS version 3.3.0.1, a variable declaration with PERSISTENT RETAIN has the same effect as with RETAIN PERSISTENT or PERSISTENT.

Syntax of the declaration in the global persistent variable list PersistentVars:

VAR_GLOBAL PERSISTENT RETAIN
  <identifier> : <data type> (:= <initialization>)?;
  <instance path to POU variable>
END_VAR

Syntax of the declaration in POU:

<scope> PERSISTENT RETAIN
  <identifier> : <data type> ( := <initialization> )?; // ( ... )? : Optional
  END_VAR
<scope> : VAR | VAR_INPUT | VAR_OUTPUT | VAR_IN_OUT | VAR_STAT | VAR_GLOBAL

An assignment of inputs, outputs, or memory addresses with the AT keyword is not permitted.

Never use the POINTER TO data type in persistent variable lists. If the application is downloaded again, their addresses could change. The corresponding compiler warnings are shown in the message window.
If you frequently change the names or data types of remanent variables, then it is better to declare them as retain variables with the `RETAIN` keyword only.

**NOTICE!**
Avoid inserting instance paths because in this case twice as much memory is used and a higher cycle time can occur. Instead, declare variables in the list of persistent variables.

**Example**

**Declaration in the persistent variable list**

```
{attribute 'qualified_only'}
VAR_GLOBAL PERSISTENT RETAIN
  g_iCounter : INT;
  // Generated instance path of persistent variable
  PLC_PRG.fb_A.iPersistentCounter_A: INT;
END_VAR
```

**Declaration in the function block FB_A:**

```
FUNCTION_BLOCK FB_A
  VAR_INPUT
  END_VAR
  VAR_OUTPUT
  END_VAR
  VAR PERSISTENT
    iPersistentCounter_A : INT;
  END_VAR
  VAR
    fb_A1 : FB_A;
  END_VAR
```

**Declaration in the program PLC_PRG:**

```
VAR
  fb_A1 : FB_A;
END_VAR
```

### Possible declaration locations

<table>
<thead>
<tr>
<th>Directly in the persistent global variable list</th>
<th>The variable is persistent and lies in the protected memory area.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locally in a program with an instance path in the persistent variable list</td>
<td>The variable is persistent and located in the protected memory area and in the memory (double allocation).</td>
</tr>
<tr>
<td>Locally in a function block with an instance path in the persistent variable list</td>
<td></td>
</tr>
<tr>
<td>Only locally in a program</td>
<td>This variable is not persistent. A warning is shown in the message window.</td>
</tr>
<tr>
<td>Only locally in a function block</td>
<td>Hint: Click &quot;Declarations ➔ Add All Instance Paths&quot; to import the variables into the persistent variable list.</td>
</tr>
<tr>
<td>Locally in a function</td>
<td>This declaration does not have any effect. The variable is not persistent.</td>
</tr>
</tbody>
</table>
In the persistence editor, click “Declarations ➔ Add All Instance Paths” if local variables are marked with `PERSISTENT`.

Whenever possible, avoid marking variables, which are declared in a function block, with `PERSISTENT`. This is because the function block instance is stored entirely in remanent memory and not just the marked variable.

See also
- § Chapter 6.4.1.9.19 “Data Persistence” on page 1920
- § Chapter 6.4.1.21.3.18.4 “Command ‘Add all instance paths’” on page 2720

**Retain Variable - RETAIN**

Retain variables are declared by the keyword `RETAIN` is added in programming objects in the scope `VAR`, `VAR_INPUT`, `VAR_OUTPUT`, `VAR_IN_OUT`, `VAR_STAT`, or `VAR_GLOBAL`.

**Syntax for the declaration**

```
<scope> RETAIN
   <identifier>: <data type> ( := <initialization> )? // ( ... )? :
Optional
END_VAR
```

```
<scope> : VAR | VAR_INPUT | VAR_OUTPUT | VAR_IN_OUT | VAR_STAT | VAR_GLOBAL
```

An assignment of inputs, outputs, or memory addresses with the `AT` keyword is not permitted.

**Example**

**In a POU:**

```
VAR RETAIN
   iVarRetain: INT;
END_VAR
```

**In a GVL:**

```
VAR_GLOBAL RETAIN
   g_iVarRetain: INT;
END_VAR
```

**Possible declaration locations**

<table>
<thead>
<tr>
<th>Locally in a program</th>
<th>Only the variable is located in the retain memory area.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Info: When using redundancy, the entire program with all of its data is located in the retain memory area.</td>
</tr>
<tr>
<td>Globally in a global variable list</td>
<td>Only the variable is located in the retain memory area.</td>
</tr>
<tr>
<td></td>
<td>Info: When using redundancy, the entire global variable list with all of its data is located in the retain memory area.</td>
</tr>
<tr>
<td>Locally in a function block</td>
<td>The entire instance of the function block with all of its data is located in the retain memory area. Only the declared retain variable is protected.</td>
</tr>
<tr>
<td>Locally in a function</td>
<td>The variable is not located in the retain memory area. This declaration does not have any effect.</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Locally and persistently in a function</td>
<td>The variable is not located in the retain memory area. This declaration does not have any effect.</td>
</tr>
</tbody>
</table>

Whenever possible, avoid using `retain` to mark the variables of a function block.

See also
- [Chapter 6.4.1.9.19 “Data Persistence” on page 1920](#)
- [Chapter 6.4.1.21.3.18.4 “Command ‘Add all instance paths’” on page 2720](#)

**SUPER**

`SUPER` is a special variable and is used for object-oriented programming.

`SUPER` is the pointer of a function block to the basic function block instance from which the function block was generated. The `SUPER` pointer thus also permits access to the implementation of the methods of the basic function block (basic class). A `SUPER` pointer is automatically available for each function block.

You can use `SUPER` only in methods and in the associated function block implementations.

Dereferencing of the pointer: `SUPER^`

Use of the `SUPER` pointer: with the help of the keyword `SUPER` you call a method that is valid in the instance of the basic class or parent class.

**Examples**

ST:

```
SUPER^.METH_DoIt();
```

FBD/CFC/LD

![Diagram](image)

**THIS** is not yet implemented for the instruction list (IL).
Examples

Use of SUPER and THIS pointers

```plaintext
FUNCTION_BLOCK FB_Base
  VAR_OUTPUT
    iCnt : INT;
  END_VAR

  METHOD METH_DoIt : BOOL
    iCnt := -1;
  END_METHOD

  METHOD METH_DoAlso : BOOL
    METH_DoAlso := TRUE;
  END_METHOD

FUNCTION_BLOCK FB_1 EXTENDS FB_Base
  VAR_OUTPUT
    iBase : INT;
  END_VAR

  THIS^.METH_DoIt();  //Call of the methods of FB_1
  THIS^.METH_DoAlso();

  SUPER^.METH_DoIt();   //Call of the methods of FB_Base
  SUPER^.METH_DoAlso();
  iBase := SUPER^.iCnt;

  METHOD METH_DoIt : BOOL
    iCnt := 1111;
    METH_DoIt := TRUE;
  END_METHOD

PROGRAM PLC_PRG
  VAR
    myBase : FB_Base;
    myFB_1 : FB_1;
    iTHIS : INT;
    iBase : INT;
  END_VAR

  myBase();
  iBase := myBase.iCnt;
  myFB_1();
  iTHIS := myFB_1.iCnt;
```

See also
- Chapter 6.4.1.20.5 “Data Types” on page 2234
- Chapter 6.4.1.20.2.16 “THIS” on page 2126

THIS

THIS is a special variable and is used for object-oriented programming. THIS is the pointer of a function block to its own function block instance. A THIS pointer is automatically available for each function block.

You can use THIS only in methods and in function blocks. THIS is available for the implementation in the input assistant in the category “Keywords”.

Dereferencing of the pointer: THIS^
Use of the **THIS** pointer

- If a local variable obscures a function block variable in a method, you can set the function block variable with the **THIS** pointer. See example below (1)
- If the pointer to the function block's own function block instance is referenced for use in a function. (See example below (2))

**Examples**

**ST:**

```
THIS^.METH_DoIt();
```

**FBD/CFC/LD:**

![Diagram]

**THIS** is not yet implemented for the instruction list (IL).
Examples

(1) The local variable iVarB obscures the function block variable iVarB.

```plaintext
FUNCTION_BLOCK fbA
  VAR_INPUT
  iVarA: INT;
  END_VAR
  iVarA := 1;

FUNCTION_BLOCK fbB EXTENDS fbA
  VAR_INPUT
  iVarB: INT := 0;
  END_VAR
  iVarA := 11;
  iVarB := 2;

METHOD DoIt : BOOL
  VAR_INPUT
  END_VAR
  iVarB: INT;
  END_VAR
  iVarB := 22;    // The local variable iVarB is set.
  THIS^.iVarB := 222;    // The function block variable iVarB is set even though iVarB is obscured.

PROGRAM PLC_PRG
  VAR
    MyfbB: fbB;
  END_VAR
  MyfbB(iVarA:=0, iVarB:= 0);
  MyfbB.DoIt();
```

(2) A function call requires the reference to its own instance.

```plaintext
FUNCTION funA
  VAR_INPUT
  pFB: fbA;
  END_VAR
  ...;

FUNCTION_BLOCK fbA
  VAR_INPUT
  iVarA: INT;
  END_VAR
  ...;

FUNCTION_BLOCK fbB EXTENDS fbA
  VAR_INPUT
  iVarB: INT := 0;
  END_VAR
  iVarA := 11;
  iVarB := 2;

METHOD DoIt : BOOL
  VAR_INPUT
  END_VAR
  iVarB: INT;
  END_VAR
  iVarB := 22;    // The local variable iVarB is set.
  funA(pFB := THIS^);    // funA is called via THIS^.

PROGRAM PLC_PRG
```
VAR
  MyfbB: fbB;
END_VAR
MyfbB(iVarA:=0 , iVarB:= 0);
MyfbB.DoIt();

See also
- "Chapter 6.4.1.20.5.13 "Pointers" on page 2243"
- "Chapter 6.4.1.20.2.15 "SUPER" on page 2125"

6.4.1.20.3 Operators

General

CODESYS V3 supports all IEC-61131-3 operators. These operators are recognized implicitly throughout the project. In addition to these IEC operators, CODESYS also supports some non-IEC 61131-3 operators.

Operators are used in blocks, such as functions.

> For information about the processing order (binding strength) of the ST operators, please refer to the section on ST expressions.

> CAUTION!
For operations with floating-point data types, the computational result depends on the applied target system hardware.

> CAUTION!
For operations with overflow or underflow in the data type, the computational result depends on the applied target system hardware.

Overflow/underflow in the data type

The CODESYS compiler generates code for the target device and computes temporary results always with the native size that is defined by the target device. For example, computation is performed at least with 32-bit temporary values on x86 and ARM systems and always with 64-bit temporary values on x64 systems. This provides considerable advantages in the computation speed and often also produces the desired result. But this also means that an overflow or underflow in the data type is not truncated in some cases.
**Examples**

**Example 1**
The result of this addition is not truncated and the result in `dwVar` is 65536.

```plaintext
VAR
wVar : WORD;
dwVar: DWORD;
END_VAR

wVar := 65535;
dwVar := wVar + 1;
```

**Example 2**
The overflow and underflow in the data type is not truncated and the results (`bVar1`, `bVar2`) of both comparisons are `FALSE` on 32-bit and 64-bit hardware.

```plaintext
VAR
wVar1 : WORD;
wVar2 : WORD;
bVar1 : BOOL;
bVar2 : BOOL;
END_VAR

wVar1 := 65535;
wVar2 := 0;
bVar1 := (wVar1 + 1) = wVar2;
bVar2 := (wVar2 - 1) = wVar1;
```

**Example 3**
By the assignment to `wVar3`, the value is truncated to the target data type `WORD` and the result `bVar1` is `TRUE`.

```plaintext
VAR
wVar1 : WORD;
wVar2 : WORD;
wVar3 : WORD;
bVar1 : BOOL;
END_VAR

wVar1 := 65535;
wVar2 := 0;
wVar3 := (wVar1 + 1);
bVar1 := wVar3 = wVar2;
```

**Example 4**
In order to force the compiler to truncate the temporary results, a conversion can be inserted. The type conversion makes sure that both comparisons are 16-bit only and the results (`bVar1`, `bVar2`) of both comparisons are each `TRUE`.

```plaintext
VAR
wVar1 : WORD;
wVar2 : WORD;
bVar1 : BOOL;
bVar2 : BOOL;
END_VAR

wVar1 := 65535;
wVar2 := 0;
bVar1 := TO_WORD(wVar1 + 1) = wVar2;
bVar2 := TO_WORD(wVar2 - 1) = wVar1;
```
### Arithmetic operators
- Chapter 6.4.1.20.3.2 “Operator ‘ADD’” on page 2133
- Chapter 6.4.1.20.3.4 “Operator ‘SUB’” on page 2135
- Chapter 6.4.1.20.3.3 “Operator ‘MUL’” on page 2134
- Chapter 6.4.1.20.3.5 “Operator ‘DIV’” on page 2136
- Chapter 6.4.1.20.3.6 “Operator ‘MOD’” on page 2137
- Chapter 6.4.1.20.3.7 “Operator ‘MOVE’” on page 2137
- Chapter 6.4.1.20.3.8 “Operator ‘INDEXOF’” on page 2137
- Chapter 6.4.1.20.3.9 “Operator ‘SIZEOF’” on page 2138
- Chapter 6.4.1.20.3.10 “Operator ‘XSIZEOF’” on page 2138

### Bitstring operators
- Chapter 6.4.1.20.3.12 “Operator ‘AND’” on page 2139
- Chapter 6.4.1.20.3.13 “Operator ‘OR’” on page 2139
- Chapter 6.4.1.20.3.14 “Operator ‘XOR’” on page 2140
- Chapter 6.4.1.20.3.11 “Operator ‘NOT’” on page 2139
- Chapter 6.4.1.20.3.15 “Operator ‘AND_THEN’” on page 2140
- Chapter 6.4.1.20.3.16 “Operator ‘OR_ELSE’” on page 2140

### Bitshift operators
- Chapter 6.4.1.20.3.17 “Operator ‘SHL’” on page 2141
- Chapter 6.4.1.20.3.18 “Operator ‘SHR’” on page 2142
- Chapter 6.4.1.20.3.19 “Operator ‘ROL’” on page 2143
- Chapter 6.4.1.20.3.20 “Operator ‘ROR’” on page 2144

### Selection operators
- Chapter 6.4.1.20.3.21 “Operator ‘SEL’” on page 2145
- Chapter 6.4.1.20.3.22 “Operator ‘MAX’” on page 2146
- Chapter 6.4.1.20.3.23 “Operator ‘MIN’” on page 2146
- Chapter 6.4.1.20.3.24 “Operator ‘LIMIT’” on page 2147
- Chapter 6.4.1.20.3.25 “Operator ‘MUX’” on page 2147

### Comparison operators
A comparison operator is a Boolean that compares two inputs (first and second operand).
- Chapter 6.4.1.20.3.26 “Operator ‘GT’” on page 2148
- Chapter 6.4.1.20.3.27 “Operator ‘LT’” on page 2148
- Chapter 6.4.1.20.3.28 “Operator ‘LE’” on page 2148
- Chapter 6.4.1.20.3.29 “Operator ‘GE’” on page 2149
- Chapter 6.4.1.20.3.30 “Operator ‘EQ’” on page 2149
- Chapter 6.4.1.20.3.31 “Operator ‘NE’” on page 2149

### Address operators
- Chapter 6.4.1.20.3.32 “Operator ‘ADR’” on page 2150
- Chapter 6.4.1.20.3.33 “Operator ‘Content Operator’” on page 2151
- Chapter 6.4.1.20.3.34 “Operator ‘BITADR’” on page 2151

### Call operators
- Chapter 6.4.1.20.3.35 “Operator ‘CAL’” on page 2152
You can explicitly call type conversion operators. The type conversion operators described below are available for typed conversions from one elementary type to another elementary type, as well as for overloading. Conversions from a larger type to a smaller type are also implicitly possible (for example, from `INT` to `BYTE` or from `DINT` to `WORD`).

**Typed conversion**: `<elementary data type> _TO_ <another elementary data type>`

**Overloaded conversion**: `TO_ <elementary data type>`

**Elementary data types:**

- `<elementary data type> =
  - UXINT | XINT | _XWORD | BIT | BOOL | BYTE | DATE | DATE_AND_TIME |
  - DINT | DT | DWORD | INT | LDATE | LDATE_AND_TIME | LDT | LINT |
  - LREAL | LTIME | LTOD | LWORD | REAL | SINT | TIME | TOD | UDINT |
  - UINT | ULINT | USINT | WORD`

The keywords `T`, `TIME_OF_DAY` and `DATE_AND_TIME` are alternative forms for the data types `TIME`, `TOD`, and `DT`. `T`, `TIME_OF_DAY` and `DATE_AND_TIME` are not represented as a type conversion command.

**NOTICE!**

If the operand value for a type conversion operator is outside of the value range of the target data type, then the result output depends on the processor type and is therefore undefined. This is the case, for example, when a negative operand value is converted from `LREAL` to the target data type `UINT`.

Information can be lost when converting from larger data types to smaller data types.

**NOTICE!**

String manipulation when converting to STRING or WSTRING

When converting the type to STRING or WSTRING, the typed value is left-aligned as a character string and truncated if it is too long. Therefore, declare the return variable for the type conversion operators `<>_TO_STRING` and `<>_TO_WSTRING` long enough that the character string has enough space without any manipulation.

See also

- Chapter 6.4.1.20.3.39 “Floating-Point Number Conversion” on page 2171
- Chapter 6.4.1.20.3.41 “Time Conversion” on page 2182
- Chapter 6.4.1.20.3.42 “Date and Time Conversion” on page 2187
- Chapter 6.4.1.20.3.40 “String Conversion” on page 2174
- Chapter 6.4.1.20.3.43 “Operator ‘TRUNC’ ” on page 2193
- Chapter 6.4.1.20.3.44 “Operator ‘TRUNC_INT’ ” on page 2193

**Numeric Operators**

- Chapter 6.4.1.20.3.45 “Operator ‘ABS’” on page 2194
- Chapter 6.4.1.20.3.46 “Operator ‘SQRT’” on page 2194
- Chapter 6.4.1.20.3.47 “Operator ‘LN’” on page 2194
- Chapter 6.4.1.20.3.48 “Operator ‘LOG’” on page 2195
- Chapter 6.4.1.20.3.49 “Operator ‘EXP’” on page 2195
- Chapter 6.4.1.20.3.50 “Operator ‘EXPT’” on page 2195
- Chapter 6.4.1.20.3.51 “Operator ‘SIN’” on page 2196
- Chapter 6.4.1.20.3.54 “Operator ‘ASIN’” on page 2197
- Chapter 6.4.1.20.3.52 “Operator ‘COS’” on page 2196
Namespace operators

Namespaces operators are extended from IEC 61131-3 operators. They make it possible for you to provide unique access to variables and modules, even when you use the same name multiple times for variables or modules in a project.

- Chapter 6.4.1.20.3.70 “Operator - Global namespace” on page 2216
- Chapter 6.4.1.20.3.71 “Operator - Namespace for global variables lists” on page 2216
- Chapter 6.4.1.20.3.73 “Operator - Enumeration namespace” on page 2217
- Chapter 6.4.1.20.3.72 “Operator - Library namespace” on page 2217
- Chapter 6.4.1.20.3.74 “Operator '__POOL''” on page 2217

Multicore operators

Working with different tasks requires the synchronization of these tasks. This is especially true when working on multicore platforms. Some special operators are provided in CODESYS to support this synchronization.

These operators are extensions of IEC-61131-3. The operators TEST_AND_SET and __COMPARE_AND_SWAP are used for similar tasks.

- Chapter 6.4.1.20.3.69 “Operator 'TEST_AND_SET'” on page 2215
- Chapter 6.4.1.20.3.65 “Operator '__COMPARE_AND_SWAP” on page 2212
- Chapter 6.4.1.20.3.66 “Operator '__XADD''” on page 2213

Other operators

- Chapter 6.4.1.20.3.57 “Operator 'DEL__ELE''” on page 2198
- Chapter 6.4.1.20.3.58 “Operator '__ISVALIDREF’'' on page 2201
- Chapter 6.4.1.20.3.59 “Operator '__NEW’” on page 2201
- Chapter 6.4.1.20.3.60 “Operator '__QUERYINTERFACE’’ on page 2204
- Chapter 6.4.1.20.3.61 “Operator '__QUERYPOINTER’’ on page 2205
- Chapter 6.4.1.20.3.75 “Operator '__POINTER’’ on page 2218
- Chapter 6.4.1.20.3.62 “Operators '__TRY', '__CATCH', '__FINALLY', '__ENDTRY’’ on page 2206
- Chapter 6.4.1.20.3.67 “Operator '__POSITION’’ on page 2214
- Chapter 6.4.1.20.3.68 “Operator '__POUNAME’’ on page 2214

Operator 'ADD'

The IEC operator adds variables.

Permitted data types: __UXINT | __XINT | __XWORD | BYTE | DATE | DATE_AND_TIME | DINT | DT | DWORD | INT | LDATE | LDATE_AND_TIME | LDT | LINT | LREAL | LTOD | LWORD | REAL | SINT | TIME | TIME_OF_DAY | TOD | UDINT | UINT | USINT | WORD

Possible combinations for time data types:

- TIME + TIME = TIME
- TIME + LTIME = LTIME
- LTIME + LTIME = LTIME
Possible combinations for date and time data types:

- TOD + TIME = TOD
- DT + TIME = DT
- TOD + LTIME = LTOD
- DT + LTIME = LDT
- LTOD + TIME = LTOD
- LDT + LTIME = LDT
- LTOD + LTIME = LTOD
- LDT + LTIME = LDT

Feature in the FBD/LD editor: You can extend the **ADD** operator to function block inputs. The number of additional function block inputs is limited.

**Examples**

**ST:**

```plaintext
var1 := 7+2+4+7;
```

**FBD:**

![FBD diagram showing variable addition]

**Operator 'MUL'**

This IEC operator is used for multiplying variables.

**Permitted data types:** BYTE, WORD, DWORD, LWORD, SINT, USINT, INT, UINT, DINT, UDINT, LINT, ULINT, REAL, LREAL, TIME

Feature in the FBD/LD editor: You can extend the **MUL** operator to additional function block inputs. The number of additional function block inputs is limited.
Examples

\[
\text{ST:} \\
\text{var1 := 7*2*4*7;}
\]

\[
\text{FBD:}
\]

Operator 'SUB'

The IEC operator subtracts variables.

Permitted data types: BYTE, WORD, DWORD, LWORD, SINT, USINT, INT, UINT, DINT, UDINT, LINT, ULINT, REAL, LREAL, TIME, LTIME, TIME_OF_DAY (TOD), LTIME_OF_DAY (LTOD), DATE, LDATE, DATE_AND_TIME (DT), LDATE_AND_TIME (LDT)

Possible combinations for time data types:
- TIME - TIME = TIME
- LTIME - LTIME = LTIME

Possible combinations for date and time data types:
- DATE - DATE = TIME
- LDATE - LDATE = LTIME
- TOD - TIME = TOD
- LTOD - LTIME = LTOD
- TOD - TOD = TIME
- LTOD - LTOD = LTIME
- DT - TIME = DT
- LDT - LTIME = LDT
- DT - DT = TIME
- LDT - LDT = LTIME

Negative TIME/LTIME values are undefined.
Examples

**ST:**

```plaintext
var1 := 7-2;
```

**FBD:**

```
7 SUB Var1
```

---

**Operator 'DIV'**

This IEC operator is used for dividing variables.

**Permitted data types:** BYTE, WORD, DWORD, LWORD, SINT, USINT, INT, UINT, DINT, UDINT, LINT, ULINT, REAL, LREAL, TIME

---

**NOTICE!**

Division by zero may have different results depending on the target system.

---

Examples

**ST:**

```plaintext
var1 := 8/2;
```

**FBD:**

1. Series of DIV blocks, 2. Single DIV block, 3. DIV blocks with EN/ENO parameters

---

```
var1 66 DIV 66 var3 1
```

```
var1 66 DIV 66 var3 1
```

```
var1 66 DIV 66 var3 1
```

```
start TRUE 66 DIV 66 var3 1 end TRUE
```

---

*Please note that it is possible to monitor division by zero at runtime by using the implicit monitoring functions CheckDivInt, CheckDivLInt, CheckDivReal, and CheckDivLReal.*

---

**See also**

- ☞ Chapter 6.4.1.21.2.22.3 “POU 'CheckDivInt'” on page 2505
- ☞ Chapter 6.4.1.21.2.22.4 “POU 'CheckDivLInt'” on page 2505
- ☞ Chapter 6.4.1.21.2.22.5 “POU 'CheckDivReal'” on page 2506
- ☞ Chapter 6.4.1.21.2.22.6 “POU 'CheckDivLReal'” on page 2507
Operator 'MOD'

This IEC operator is used for modulo division.
The result of the function is the integer remainder of division.
Permitted data types: BYTE, WORD, DWORD, LWORD, SINT, USINT, INT, UINT, DINT, UDINT, LINT, ULINT

```
NOTICE!
Division by zero may have different results depending on the target system.
```

### Examples

Result in Var1: 1

**ST:**

```
var1 := 9 MOD 2;
```

**FBD:**

![MOD block diagram]

Operator 'MOVE'

This IEC operator is used for assigning a variable to another variable of a corresponding type.
Because the MOVE block is available in the CFC, FBD, and LD editors, you can also use the EN/ENO functionality for variable assignment.

**CFC with EN/ENO function:**

CODESYS assigns the value of var1 to var2 only if "en_i" yields TRUE.

```
ST:
ivar2 := MOVE(ivar1);
```

This corresponds to:
```
ivar2 := ivar1;
```

Operator 'INDEXOF'

This operator is an extension of the IEC 61131-3 standard.
Instead of the INDEXOF operator, the ADR operator is provided in CODESYS V3 for obtaining a pointer at the index of a block.

See also
- Chapter 6.4.1.20.3.32 “Operator ‘ADR’” on page 2150
Operator ‘SIZEOF’

The operator is an extension of the IEC 61131-3 standard.

The operator is used for defining the number of bytes that are required by the variable \(x\). The operator \(\text{SIZEOF}\) always yields an unsigned value. The type of return variable adapts to the detected size of the variable \(x\).

In compiler version 3.5.16.0 and higher, the operator \(\text{XSIZEOF}\) should be used instead of this operator.

<table>
<thead>
<tr>
<th>Return value of (\text{SIZEOF}(x))</th>
<th>Data type of the constant which CODESYS uses implicitly for the detected size.</th>
</tr>
</thead>
<tbody>
<tr>
<td>(0 \leq \text{size of } x &lt; 256)</td>
<td>(\text{USINT})</td>
</tr>
<tr>
<td>(256 \leq \text{size of } x &lt; 65536)</td>
<td>(\text{UINT})</td>
</tr>
<tr>
<td>(65536 \leq \text{size of } x &lt; 4294967296)</td>
<td>(\text{UDINT})</td>
</tr>
<tr>
<td>(4294967296 \leq \text{size of } x)</td>
<td>(\text{ULINT})</td>
</tr>
</tbody>
</table>

Examples

Result in \(\text{var1} : 10\).

\[
\text{ST:}
\[
\begin{align*}
\text{arr1} & : \text{ARRAY}[0..4] \text{ OF INT;} \\
\text{var1} & : \text{INT;} \\
\text{var1} & := \text{SIZEOF(arr1); (}\ast \text{ var1} := \text{USINT#10; }\ast
\end{align*}
\]

See also

- Chapter 6.4.1.20.3.10 “Operator ‘XSIZEOF’” on page 2138

Operator ‘XSIZEOF’

The operator is an extension of the IEC 61131-3 standard.

The operator is used for defining the number of bytes that are required by the variable \(x\). The data type of the return value is \(\text{ULINT}\) on 64-bit platforms and \(\text{UDINT}\) on all other platforms.

The operator \(\text{XSIZEOF}\) should be used instead of the operator \(\text{SIZEOF}\). Because the data type of the return value is fixed, problems do not occur for \(\text{XSIZEOF}\), which do occur in the case of the operator \(\text{SIZEOF}\).

Example

Variable \(\text{udiVarX}\) is

\[
\text{ST:}
\[
\begin{align*}
\text{udiVarX} & : \text{UDINT;} (\ast \text{ Data type for 64-bit platforms: ULINT }\ast) \\
\text{udiVarX} & := \text{XSIZEOF(<variable>)};
\end{align*}
\]

The variable \(\text{udiVarX}\) contains the number of bytes that the variable \(<\text{variable}>\) requires.

See also

- Chapter 6.4.1.20.3.9 “Operator ‘SIZEOF’” on page 2138
Operator 'NOT'

This IEC operator is used for the bitwise NOT of a bit operand. When the respective input bit yields 0, the output bit also yields 1, and vice-versa.

Permitted data types: BOOL, BYTE, WORD, DWORD, LWORD

Examples

Result in var1: 2#0110_1100

ST:
var1 := NOT 2#1001_0011;

FBD:

Operator 'AND'

This IEC operator is used for the bitwise AND of bit operands. When the input bits all yield 1, the output bit also yields 1; otherwise 0.

Permitted data types: BOOL, BYTE, WORD, DWORD, LWORD

Examples

Result in var1: 2#1000_0010

ST:
var1 := 2#1001_0011 AND 2#1000_1010;

FBD:

Operator 'OR'

This IEC operator is used for the bitwise OR of bit operands. When at least one of the input bits yields 1, the output bit also yields 1; otherwise 0.

Permitted data types: BOOL, BYTE, WORD, DWORD, LWORD

Examples

Result in Var1: 2#1001_1011

ST:
Var1 := 2#1001_0011 OR 2#1000_1010;

FBD:
Operator 'XOR'

This IEC operator is used for the bitwise XOR of bit operands.

When only one of the two input bits yields 1, the output bit also yields 1. When both inputs yield 1 or 0, then the output yields 0.

Permitted data types: BOOL, BYTE, WORD, DWORD, LWORD

NOTICE!

Please note the following behavior of the XOR block in extended form (more than two inputs): CODESYS compares the inputs in pairs and then the corresponding results (according to the standard, but not necessarily according to expectations).

Example:

Result in var1: 2#0001_1001

ST:

var1 := 2#1001_0011 XOR 2#1000_1010;

FBD:

Operator 'AND_THEN'

This operator is an extension of the IEC 61131-3 standard.

The AND_THEN operator is permitted only for programming in structured text with the AND operation of BOOL and BIT operands with short-circuit evaluation. This means that:

When all operands yield TRUE, the result of the operands also yield TRUE; otherwise FALSE.

However, CODESYS also executes the expressions on other operands only if the first operand of the AND_THEN operator is TRUE. This can prevent problems with null pointers, for example in conditions such as IF (ptr <> 0 AND_THEN ptr^ = 99) THEN....

In contrast, CODESYS always evaluates all operands when using the AND IEC operator.

See also

● Chapter 6.4.1.20.3.12 “Operator ‘AND’” on page 2139

Operator 'OR_ELSE'

This operator is an extension of the IEC 61131-3 standard.

The OR_ELSE operator is permitted only for programming in structured text: OR operation of BOOL and BIT operands; with short-circuit evaluation. This means:

When at least one of the operands yields TRUE, the result of the operation also yields TRUE; otherwise FALSE.

In contrast to using the OR IEC operator, for OR_ELSE the expressions on all other operators are not evaluated as soon as one of the operands is evaluated as TRUE.
Example

VAR
   bEver: BOOL;
   bX: BOOL;
   dw: DWORD := 16#000000FF;
END_VAR
bEver := FALSE;
bX := dw.8 OR_ELSE dw.1 OR_ELSE dw.1 OR_ELSE (bEver := TRUE);

\textit{dw.8} is FALSE and \textit{dw.1} is TRUE; therefore \textit{bX} is the result of the operation TRUE. However, the expression at the third input is not executed, and \textit{bEver} remains FALSE. On the other hand, if the standard OR operation was used, \textit{bEver} would be set to TRUE.

See also

- Chapter 6.4.1.20.3.13 “Operator ‘OR’” on page 2139

Operator ‘SHL’

This IEC operator is used for bitwise shift of an operand to the left.

\[ \text{erg} := \text{SHL} \left( \text{in}, \ n \right) \]

\textit{in}: Operand that is shifted to the left
\textit{n}: Number of bits to shift \textit{in} to the left

\begin{itemize}
\item \textbf{NOTICE!}
\begin{itemize}
\item If \textit{n} overwrites the data type width, then it depends on the target system how the \texttt{BYTE}, \texttt{WORD}, \texttt{DWORD}, and \texttt{LWORD} operands are padded. The target systems cause padding with zeros or \textit{n} MOD \texttt{<tab width>}
\end{itemize}
\end{itemize}

\begin{itemize}
\item \textbf{NOTICE!}
\begin{itemize}
\item Please note the number of bits that CODESYS uses for this operation as defined by the data type of the input variable \textit{in}.
\end{itemize}
\end{itemize}
The results for \texttt{erg\_byte} and \texttt{erg\_word} are different, although the values of the \texttt{in\_byte} and \texttt{in\_word} input variables are the same and the data types of the input variables are different.

\textbf{ST:}

\begin{verbatim}
PROGRAM shl_st
VAR
  in\_byte : BYTE := 16#45; (* 2#01000101 *)
  in\_word : WORD := 16#0045; (* 2#0000000001000101 *)
  erg\_byte : BYTE;
  erg\_word : WORD;
  n: BYTE := 2;
END_VAR

  erg\_byte := SHL(in\_byte,n); (* Result is 16#14, 2#00010100 *)
  erg\_word := SHL(in\_word,n); (* Result is 16#0114, 2#0000000100010100 *)
\end{verbatim}

\textbf{FBD:}

\begin{center}
\includegraphics[width=0.3\textwidth]{shl.png}
\end{center}

\textbf{Operator 'SHR'
}

This IEC operator is used for bitwise shift of an operand to the right.

\begin{verbatim}
  erg := SHR (in, n)
\end{verbatim}

\texttt{in}: Operand that is shifted to the right

\texttt{n}: Number of bits for shifting \texttt{in} to the right

\begin{center}
\begin{tabular}{|c|}
\hline
\textbf{NOTICE!} \\
If \texttt{n} overwrites the data type width, then it depends on the target system how the \texttt{BYTE}, \texttt{WORD}, \texttt{DWORD}, and \texttt{LWORD} operands are padded. The target systems cause padding with zeros or \texttt{n MOD <tab width>}. \\
\hline
\end{tabular}
\end{center}
**Examples**

```plaintext
PROGRAM shr_st
VAR
  in_byte : BYTE := 16#45; (* 2#01000101 *)
  in_word : WORD := 16#0045; (* 2#0000000001000101 *)
  erg_byte : BYTE;
  erg_word : WORD;
  n: BYTE := 2;
END_VAR

  erg_byte := SHR(in_byte, n); (* Result is 16#11, 2#00010001 *)
  erg_word := SHR(in_word, n); (* Result is 16#0011, 2#00000000010001 *)

FBD:
```

**Operator 'ROL'**

This IEC operator is used for bitwise rotation of an operand to the left.

**Permitted data types:** BYTE, WORD, DWORD, LWORD

```plaintext
erg := ROL (in, n)
```

CODESYS moves `in` `n`-times one bit to the left and adds the bit to the leftmost position from the right.

**NOTICE!**

Please note the number of bits that CODESYS uses for this operation as defined by the data type of the input variable `in`. If this is a constant, then CODESYS uses the smallest possible data type. The data type of the output variables still does not influence this operation.
The results for erg_byte and erg_word are different depending on the data type of the input variables, although the values of the in_byte and in_word input variables are the same.

**ST:**

```plaintext
PROGRAM rol_st

VAR
  in_byte : BYTE := 16#45;
  in_word : WORD := 16#45;
  erg_byte : BYTE;
  erg_word : WORD;
  n: BYTE := 2;
END_VAR

  erg_byte := ROL(in_byte,n); (* Result: 16#15 *)
  erg_word := ROL(in_word,n); (* Result: 16#0114 *)
```

**FBD:**

```
FBD:
```

**IL:**

```
IL:
LD in_byte
ROL n
ST erg_byte
```

---

**Examples**

**Operator 'ROR'**

This IEC operator is used for bitwise rotation of an operand to the right.

Permitted data types: BYTE, WORD, DWORD, LWORD

```plaintext
erg := ROR(in,n)
```

CODESYS moves in n-times one bit to the right and adds the bit to the rightmost position from the left.

Please note the number of bits that CODESYS uses for this operation as defined by the data type of the input variable in. If this is a constant, then CODESYS uses the smallest possible data type. The data type of the output variables still does not influence this operation.
The results for `erg_byte` and `erg_word` are different depending on the data type of the input variables, although the values of the `in_byte` and `in_word` input variables are the same.

**ST:**

```plaintext
PROGRAM ror_st

VAR
    in_byte : BYTE := 16#45;
    in_word : WORD := 16#45;
    erg_byte : BYTE;
    erg_word : WORD;
    n: BYTE := 2;
END_VAR

erg_byte := ROR(in_byte,n); (* Result: 16#51 *)
erg_word := ROR(in_word,n); (* Result: 16#4011 *)
```

**FBD:**

The IEC operator is used for bitwise selection.

```plaintext
OUT := SEL(G, IN0, IN1)
```

**NOTICE!**

When `G` is TRUE, CODESYS does not compute an expression that precedes `IN0`. When `G` is FALSE, CODESYS does not compute an expression that precedes `IN1`.

Caution: In the case of graphical programming languages, the expressions at `IN0` and `IN1` are computed independently of the `G` input when a “Box”, “Jump”, “Return”, “Line Branch”, or “Edge Detection” precedes.

Permitted data types:

- `IN0`, ..., `INn` and `OUT`: Any identical data type. Make sure that variables of the identical type are used at all three positions, especially when using user-defined data types. The compiler checks for type identity and returns any compile errors. The assignment of function block instances to interface variables is specifically not supported.

```plaintext
G: BOOL
```
Examples

ST:
Var1 := SEL(TRUE, 3, 4); (* Result: 4 *)

FBD:

Operator 'MAX'
This IEC operator is used for the maximum function. It yields the largest value of two values.

OUT := MAX(IN0, IN1)

Permitted data types: all

Examples

ST:
Result: 90
Var1 := MAX(30, 40);
Var1 := MAX(40, MAX(90, 30));

FBD:
Result: 90

Operator 'MIN'
This IEC operator is used for the minimum function. It yields the smallest value of two values.

OUT := MIN(IN0, IN1)

Permitted data types: all
Examples

Result: 30

ST:
Var1 := MIN(90, 30);
Var1 := MIN(MIN(90, 30), 40);

FBD:

![FBD Diagram]

Operator 'LIMIT'

This IEC selection operator is used for limiting.

\[
\text{OUT} := \text{LIMIT} (\text{Min}, \text{IN}, \text{Max})
\]

**Means:**
\[
\text{OUT} := \text{MIN} \left( \text{MAX} \left( \text{IN}, \text{Min} \right), \text{Max} \right)
\]

Max is the upper limit and Min is the lower limit for the result. If the IN value is above the Max upper limit, then LIMIT yields Max. If the value of IN is below the Min lower limit, then the result is Min.

Permitted data types for IN and OUT: all

Examples

Result in Var1 is 80

ST:
Var1 := LIMIT(30, 90, 80);

Operator 'MUX'

This IEC operator is used as a multiplexer.

\[
\text{OUT} := \text{MUX} (\text{K}, \text{IN0}, ..., \text{INn})
\]

**Means:**
\[
\text{OUT} = \text{IN}_K
\]

Permitted data type for K: BYTE, WORD, DWORD, LWORD, SINT, USINT, INT, UINT, DINT, LINT, ULINT, UDINT.

IN0, ..., INn, and OUT: Any identical data type. Make sure that variables of the identical type are used at all three positions, especially when using user-defined data types. The compiler checks for type identity and returns any compile errors. The assignment of function block instances to interface variables is specifically not supported.

MUX selects the K-th value from a set of values. The first value is K=0. If K is greater than the number of other inputs (n), then CODESYS passes on the last value (INn).

**NOTICE!**

For runtime optimization, CODESYS computes only the expression that precedes \text{IN}_K. However, CODESYS computes all branches in simulation mode.
**Examples**

Result in Var1 is 30.

**ST:**

```
Var1 := MUX(0, 30, 50, 60, 70, 80);
```

---

**Operator 'GT'**

This IEC operator is used for the "greater than" function.
Permitted data types of the operands: any basic data type.
If the first operand is greater than the second operand, then the operator yields the result **TRUE**; otherwise **FALSE**.

**Examples**

Result: FALSE

**ST:**

```
VAR1 := 20 > 30;
```

**FBD:**

---

**Operator 'LT'**

This IEC operator is used for the "less than" function.
Permitted data types of the operands: any basic data type.
If the first operand is less than the second operand, then the operator yields the result **TRUE**; otherwise **FALSE**.

**Examples**

Result: TRUE

**ST:**

```
Var1 := 20 < 30;
```

---

**Operator 'LE'**

This IEC operator is used for the "less than or equal to" function.
Permitted data types of the operands: any basic data type.
If the first operand is less than or equal to the second operand, then the operator yields the result **TRUE**; otherwise **FALSE**.
Examples

Result in `Var1`: TRUE

**ST:**

\[ Var1 := 20 \leq 30; \]

---

**Operator 'GE'**

This IEC operator is used for the "greater than or equal to" function.

Permitted data types of the operands: any basic data type.

If the first operand is greater than or equal to the second operand, then the operator yields the result TRUE; otherwise FALSE.

Examples

Result: TRUE

**ST:**

\[ VAR1 := 60 \geq 40; \]

**FBD:**

---

**Operator 'EQ'**

This IEC operator is used for the "equals" function.

Permitted data types of the operands: any basic data type, depending on target system and compiler version: structure data type.

If the operands are equal, then then the operator yields the result TRUE, otherwise FALSE.

Examples

Result: TRUE

**ST:**

\[ VAR1 := 40 = 40; \]

**FBD:**

---

**Operator 'NE'**

This IEC operator is used for the "does not equal" function.

Permitted data types of the operands: any basic data type, depending on target system and compiler version: structure data type.
If the operands are not equal, then the operator yields the result \texttt{TRUE}; otherwise \texttt{FALSE}.
If the target system supports the data type, then as from compiler version $\geq 3.5.7.0$ also operands of type \texttt{STRUCT} (structure) can be compared. Example: \texttt{IF (stStruct1 := stStruct2) THEN...}.

**Examples**

Result in \texttt{Var1} is \texttt{FALSE}

**ST:**

\texttt{Var1 := 40 <> 40;}

**FBD:**

\begin{figure}[h]
\centering
\includegraphics[width=0.3\textwidth]{ne.png}
\caption{Example of \texttt{NE} in FBD}
\end{figure}

**Operator \texttt{`ADR`}**

The operator is an extension of the IEC 61131-3 standard. \texttt{ADR} yields the 32-bit address (or the 64-bit address, if possible) of its argument. You can pass this address to the manufacturer functions or assign them to a pointer in the project.

**Syntax**

\begin{verbatim}
VAR <address name> : DWORD | LWORD | POINTER TO < basis data type>
END_VAR

<address name> := ADR( <variable name> );
\end{verbatim}

**Example**

\begin{verbatim}
FUNCTION_BLOCK FB_Address
VAR
   piAddress1: POINTER TO INT;
   iNumber1: INT := 5;
   lwAddress2
   iNumber2: INT := 10;
END_VAR

piAddress1 := ADR(iNumber1); // piNumber is assigned to address of iNumber1
lwAddress2 := ADR(iNumber2); // 64 bit runtime system
\end{verbatim}

**NOTICE!**

In contrast to CoDeSys V2.3, you can use the \texttt{ADR} operator with function names, program names, function block names, and method names. Therefore, \texttt{ADR} replaces the \texttt{INDEXOF} operator.

When using function pointers, note that you can pass a function pointer to external libraries, but it is not possible to call a function pointer from within CODESYS. To enable a system call (runtime system), you must set the respective object property ("Build" tab) for the function object.
CAUTION!
When you use an online change, the contents of addresses can shift. As a result, POINTER TO variables could point to an invalid memory area. To avoid problems, you should make sure that the value of pointers is updated in every cycle.

CAUTION!
Do not return Pointer-TO variables of functions and methods to the caller or assign them to global variables.

See also
● § Chapter 6.4.1.20.5.13 “Pointers” on page 2243

Operator 'Content Operator'

This operator is an extension of the IEC 61131-3 standard.

You can use this operator to dereference pointers by appending the operator as ^ to the pointer identifier.

CAUTION!
When using pointers to addresses, please note that applying an online change can shift address contents.

Example

ST:

pt : POINTER TO INT;
var_int1 : INT;
var_int2 : INT;
pt := ADR(var_int1);
var_int2 := pt^;

Operator 'BITADR'

The operator is an extension of the IEC 61131-3 standard.

BITADR yields the bit offset within a segment in a DWORD.

NOTICE!
The offset depends on whether the "Byte addressing" option is selected or cleared in the target system settings.

The highest value nibble (4 bits) in this DWORD defines the memory range:

Marker M: 16#40000000
Input I: 16#80000000
Output Q: 16#C0000000
CAUTION!
When using pointers to addresses, note that applying an online change can shift the contents of addresses.

Example

ST implementation language:

VAR
  xVar AT %IX2.3 : BOOL;
  dwBitoffset : DWORD;
END_VAR

dwBitoffset := BITADR(xVar); (* If byte addressing = TRUE, result = 16#80000013; if byte addressing = FALSE, result = 16#80000023 *)

Operator 'CAL'

This IEC operator is used for calling function blocks.
In IL, CAL calls the instance of a function block.

CAL <function block> (<input variable1> := <value>, <input variableN> := <value>)

Example

Call of the Inst instance of a function block with assignment of the input variables Par1 and Par2 with 0 or TRUE.

CAL Inst(Par1 := 0, Par2 := TRUE);

Overloading

NOTICE!
If the operand value for a type conversion operator is outside of the value range of the target data type, then the result output depends on the processor type and is therefore undefined. This is the case, for example, when a negative operand value is converted from IREAL to the target data type UINT.

Information can be lost when converting from larger data types to smaller data types.

NOTICE!
The rounding logic for borderline cases depends on the target system or the FPU (Floating Point Unit) of the target system. For example, a value of -1.5 can be converted differently on different controllers.

Catch value ranges overflows across the application to program code-independent from the target system.
The IEC61131-3 specification does not provide for overloaded functions.

If you want to program strictly according to IEC61131-3, then you should use the operators of the syntax `<type> _TO_ <another type>` as described in the following sections.

The rules for typed conversions also apply here for overloading.

The operators convert values into other data types, explicitly specifying only a target data type and no initial data type (data type of the operands) ("overloaded conversion"). Overloading is not part of the IEC 61131-3 specification.

### Call syntax

<variable name> := <TO operator> ( <operand> )
<operand> = <variable name> | <literal>

### Operators

- TO__UXINT
- TO__XINT
- TO__XWORD
- TO_BIT
- TO_BYTE
- TO_BOOL
- TO_DATE
- TO_DIINT
- TO_DT
- TO_DWORD
- TO_INT
- TO_LDATE
- TO_LDT
- TO_LINT
- TO_LREAL
- TO_LTIME
- TO_LTOD
- TO_LWORD
- TO_REAL
- TO_SINT
- TO_STRING
- TO_TIME
- TO_TOD
- TO_UDINT
- TO_UINT
- TO_ULINT
- TO_USINT
- TO_WORD
- TO_WSTRING
Examples

ST implementation language:

VAR
  iNumber_1 : INT;
  rNumber_2 : REAL := 123.456;
  iNumber_2 : INT;
  xIsTrue : BOOL;
  sOutputText : STRING;
  sText : STRING := 'Hello World!';
  wsText : WSTRING;
  dateEvent : DATE := D#2019-9-3;
  uiEvent : UINT;
  uxiData : __UXINT;
END_VAR

iNumber_1 := TO_INT(4.22); (* Result: 4 *)
iNumber_2 := TO_INT(rNumber_2); (* Result: 123 *)
xIsTrue := TO_BOOL(1); (* Result: TRUE *)
sOutputText := TO_STRING(342); (* Result: '342' *)
wsText := TO_WSTRING(sText); (* Result: "Hello World!" *)
uiEvent := TO_UINT(dateEvent); (* Result: 44288 *)
uxiData := TO___UXINT(iNumber_2); (* Result: 123 *)

See also

- “Type conversion operators” on page 2132
- Chapter 6.4.1.20.3.37 “Boolean Conversion” on page 2154
- Chapter 6.4.1.20.3.38 “Integer Conversion” on page 2159
- Chapter 6.4.1.20.3.39 “Floating-Point Number Conversion” on page 2171
- Chapter 6.4.1.20.3.40 “String Conversion” on page 2174
- Chapter 6.4.1.20.3.41 “Date and Time Conversion” on page 2187
- Chapter 6.4.1.20.3.42 “Time Conversion” on page 2182

Boolean Conversion

**NOTICE!**

String manipulation when converting to STRING or WSTRING

When converting the type to STRING or WSTRING, the typed value is left-aligned as a character string and truncated if it is too long. Therefore, declare the return variable for the type conversion operators <> TO_STRING and <> TO WSTRING long enough that the character string has enough space without any manipulation.

The operators convert a Boolean value into the specified data types and return a type-converted value.

Call syntax

<variable name> := <BOOL to operator> ( <operand> );
<operand> = <variable name> | <literal>
Operators

BOOL_TO___UXINT
BOOL_TO___XINT
BOOL_TO___XWORD
BOOL_TO_BIT
BOOL_TO_BYTE
BOOL_TO_DATE
BOOL_TO_DINT
BOOL_TO_DT
BOOL_TO_DWORD
BOOL_TO_INT
BOOL_TO_LDATE
BOOL_TO_LDT
BOOL_TO_LINT
BOOL_TO_LREAL
BOOL_TO_LTIME
BOOL_TO_LTOD
BOOL_TO_LWORD
BOOL_TO_REAL
BOOL_TO_SINT
BOOL_TO_STRING
BOOL_TO_TIME
BOOL_TO_TOD
BOOL_TO_UDINT
BOOL_TO_UINT
BOOL_TO_ULINT
BOOL_TO_USINT
BOOL_TO_WORD
BOOL_TO_WSTRING

When the operand value is **TRUE**, the following typed values are returned:

- **BOOL_TO_DATE**: D#1970-1-1 // The zeroth bit is set, but does not effect the display.
- **BOOL_TO_DT**: DT#1970-01-01-0:0:0:1
- **BOOL_TO_LTIME**: LTIME#1NS
- **BOOL_TO_REAL**: '1'
- **BOOL_TO_STRING**: 'TRUE'
- **BOOL_TO_TOD**: TOD#0:0:0.001
- **BOOL_TO_TIME**: T#1MS
- **BOOL_TO_WSTRING**: "TRUE"

When the operand value is **FALSE**, the following typed values are returned:

- **BOOL_TO_DATE**: D#1970-1-1
- **BOOL_TO_DT**: DT#1970-01-01-00:00:00
- **BOOL_TO_LTIME**: LTIME#0NS
- **BOOL_TO_REAL**: '0.0'
- **BOOL_TO_STRING**: 'FALSE'
- **BOOL_TO_TOD**: TOD#0:0:0
- **BOOL_TO_TIME**: T#0MS
- **BOOL_TO_WSTRING**: "FALSE"
FUNCTION_BLOCK FB_ConvertFromBool
VAR
  uxiReturn_1: __UXINT;
  uxiReturn_10: __UXINT;
  iReturn_2: __XINT;
  iReturn_20: __XINT;
  xwReturn_3: __XWORD;
  xwReturn_30: __XWORD;
  bitReturn_4: BOOL;
  bitReturn_40: BOOL;
  bReturn_6: BYTE;
  bReturn_60: BYTE;
  dateReturn_7: DATE;
  dateReturn_70: DATE;
  dtReturn_8: DATE_AND_TIME;
  dtReturn_80: DATE_AND_TIME;
  diReturn_9: DINT;
  diReturn_90: DINT;
  dtReturn_10: DATE_AND_TIME;
  dtReturn_100: DATE_AND_TIME;
  dwReturn_11: DWORD;
  dwReturn_110: DWORD;
  iReturn_12: INT;
  iReturn_120: INT;
  liReturn_13: LINT;
  liReturn_130: LINT;
  lrReturn_14: LREAL;
  lrReturn_140: LREAL;
  lwReturn_15: LWORD;
  lwReturn_150: LWORD;
  rReturn_16: REAL;
  rReturn_160: REAL;
  siReturn_17: SINT;
  siReturn_170: SINT;
  sReturn_18: STRING;
  sReturn_180: STRING;
  todReturn_19: TIME_OF_DAY;
  todReturn_190: TIME_OF_DAY;
  timReturn_20: TIME;
  timReturn_200: TIME;
  todReturn_21: TIME_OF_DAY;
  todReturn_210: TIME_OF_DAY;
  udiReturn_22: UDINT;
  udiReturn_220: UDINT;
  uiReturn_23: UINT;
  uiReturn_230: UINT;
  uliReturn_24: ULINT;
  uliReturn_240: ULINT;
  usiReturn_25: USINT;
  usiReturn_250: USINT;
  wReturn_26: WORD;
  wReturn_260: WORD;
  wsReturn_27: WSTRING;
  wsReturn_270: WSTRING;
END_VAR

  // Return value of operand = TRUE or FALSE
  uxiReturn_1 := BOOL_TO__UXINT(TRUE);
uxiReturn_10 := BOOL_TO__UXINT(FALSE);
iReturn_2 := BOOL_TO__XINT(TRUE);
iReturn_20 := BOOL_TO__XINT(FALSE);
xwReturn_3 := BOOL_TO__XWORD(TRUE);
xwReturn_30 := BOOL_TO__XWORD(FALSE);
bitReturn_4 := BOOL_TO_BIT(TRUE);
bitReturn_40 := BOOL_TO_BIT(FALSE);
bReturn_6 := BOOL_TO_BYTE(TRUE);
bReturn_60 := BOOL_TO_BYTE(FALSE);
dateReturn_7 := BOOL_TO_DATE(TRUE);
dateReturn_70 := BOOL_TO_DATE(FALSE);
dtReturn_8 := BOOL_TO_DT(TRUE);
dtReturn_80 := BOOL_TO_DT(FALSE);
diReturn_9 := BOOL_TO_DINT(TRUE);
diReturn_90 := BOOL_TO_DINT(FALSE);
dwReturn_11 := BOOL_TO_DWORD(TRUE);
dwReturn_110 := BOOL_TO_DWORD(FALSE);
iReturn_12 := BOOL_TO_INT(TRUE);
iReturn_120 := BOOL_TO_INT(FALSE);
liReturn_13 := BOOL_TO_LINT(TRUE);
liReturn_130 := BOOL_TO_LINT(FALSE);
lrReturn_14 := BOOL_TO_LREAL(TRUE);
lrReturn_140 := BOOL_TO_LREAL(FALSE);
lwReturn_15 := BOOL_TO_LWORD(TRUE);
lwReturn_150 := BOOL_TO_LWORD(FALSE);
rReturn_16 := BOOL_TO_REAL(TRUE);
rReturn_160 := BOOL_TO_REAL(FALSE);
siReturn_17 := BOOL_TO_SINT(TRUE);
siReturn_170 := BOOL_TO_SINT(FALSE);
sReturn_18 := BOOL_TO_STRING(TRUE);
sReturn_180 := BOOL_TO_STRING(FALSE);
timReturn_20 := BOOL_TO_TIME(TRUE);
timReturn_200 := BOOL_TO_TIME(FALSE);
todReturn_21 := BOOL_TO_TOD(TRUE);
todReturn_210 := BOOL_TO_TOD(FALSE);
udiReturn_22 := BOOL_TO_UDINT(TRUE);
udiReturn_220 := BOOL_TO_UDINT(FALSE);
uiReturn_23 := BOOL_TO_UINT(TRUE);
uiReturn_230 := BOOL_TO_UINT(FALSE);
uliReturn_24 := BOOL_TO_ULINT(TRUE);
uliReturn_240 := BOOL_TO_ULINT(FALSE);
usiReturn_25 := BOOL_TO_USINT(TRUE);
usiReturn_250 := BOOL_TO_USINT(FALSE);
wReturn_26 := BOOL_TO_WORD(TRUE);
wReturn_260 := BOOL_TO_WORD(FALSE);
wStrReturn_27 := BOOL_TO_WSTRING(TRUE);
wStrReturn_270 := BOOL_TO_WSTRING(FALSE);
See also

- "Type conversion operators" on page 2132
- Chapter 6.4.1.20.3.36 “Overloading” on page 2152
- Chapter 6.4.1.20.3.38 “Integer Conversion” on page 2159
- Chapter 6.4.1.20.3.39 “Floating-Point Number Conversion” on page 2171
- Chapter 6.4.1.20.3.40 “String Conversion” on page 2174
- Chapter 6.4.1.20.3.41 “Date and Time Conversion” on page 2187
- Chapter 6.4.1.20.3.42 “Time Conversion” on page 2182

Integer Conversion

**NOTICE!**

If the operand value for a type conversion operator is outside of the value range of the target data type, then the result output depends on the processor type and is therefore undefined. This is the case, for example, when a negative operand value is converted from `LREAL` to the target data type `UINT`.

Information can be lost when converting from larger data types to smaller data types.

The operators convert an integer value into the specified data types and return this type-converted value. If the number to be converted exceeds the range limit, then the first bytes of the number are ignored.

**Call syntax**

```plaintext
<variable name> := <integer conversion type operator> ( <integer operand> );

<integer conversion type operator> = <integer data type> _TO_ <data type>
<integer operand> = <variable name> | <literal>

<integer data type> =
  __UXINT | __XINT | __XWORD | BIT | BYTE | DINT | DWORD | INT | LINT |
  LWORD | SINT | UDINT | UINT | UINT | USINT | WORD
```

**Operators**

- __UXINT_TO__XINT
- __UXINT_TO__XWORD
- __UXINT_TO_BIT
- __UXINT_TO_BOOL
- __UXINT_TO_BYTE
- __UXINT_TO_DATE
- __UXINT_TO_DINT
- __UXINT_TO_DT
- __UXINT_TO_DWORD
- __UXINT_TO_INT
- __UXINT_TO_LDATE
- __UXINT_TO_LDINT
- __UXINT_TO_LINT
- __UXINT_TO_LREAL
- __UXINT_TO_LTIME
- __UXINT_TO_LTOD
- __UXINT_TO_LWORD
- __UXINT_TO_REAL
- __UXINT_TO_SINT
- __UXINT_TO_STRING
__UXINT_TO_TIME
__UXINT_TO_TOD
__UXINT_TO_UDINT
__UXINT_TO_UINT
__UXINT_TO_ULINT
__UXINT_TO_USINT
__UXINT_TO_WORD
__UXINT_TO_WSTRING
__XINT_TO__UXINT
__XINT_TO__XWORD
__XINT_TO_BIT
__XINT_TO_BOOL
__XINT_TO_BYTE
__XINT_TO_DATE
__XINT_TO_DINT
__XINT_TO_DT
__XINT_TO_DWORD
__XINT_TO_INT
__XINT_TO_LDATE
__XINT_TO_LDT
__XINT_TO_LINT
__XINT_TO_LREAL
__XINT_TO_LTIME
__XINT_TO_LTOD
__XINT_TO_LWORD
__XINT_TO_REAL
__XINT_TO_SINT
__XINT_TO_STRING
__XINT_TO_TIME
__XINT_TO_TOD
__XINT_TO_UDINT
__XINT_TO_UINT
__XINT_TO_ULINT
__XINT_TO_USINT
__XINT_TO_WORD
__XINT_TO_WSTRING

__XWORD_TO_UXINT
__XWORD_TO_XINT
__XWORD_TO_BIT
__XWORD_TO_BOOL
__XWORD_TO_BYTE
__XWORD_TO_DATE
__XWORD_TO_DINT
__XWORD_TO_DT
__XWORD_TO_DWORD
__XWORD_TO_INT
__XWORD_TO_LDATE
__XWORD_TO_LDT
__XWORD_TO_LINT
__XWORD_TO_LREAL
__XWORD_TO_LTIME
__XWORD_TO_LTOD
__XWORD_TO_LWORD
__XWORD_TO_REAL
__XWORD_TO_SINT
__XWORD_TO_STRING
__XWORD_TO_TIME
__XWORD_TO_TOD
__XWORD_TO_UDINT
__XWORD_TO_UINT
__XWORD_TO_ULINT
__XWORD_TO_USINT
__XWORD_TO_WORD
Configuration and programming
Programming with CODESYS > CODESYS Development System

__XWORD_TO_WSTRING

BIT_TO___UXINT
BIT_TO___XINT
BIT_TO___XWORD
BIT_TO_BOOL
BIT_TO_BYTE
BIT_TO_DATE
BIT_TO_DINT
BIT_TO_DT
BIT_TO_DWORD
BIT_TO_INT
BIT_TO_LDATE
BIT_TO_LDT
BIT_TO_LINT
BIT_TO_LREAL
BIT_TO_LTIME
BIT_TO_LTOD
BIT_TO_LWORD
BIT_TO_REAL
BIT_TO_SINT
BIT_TO_STRING
BIT_TO_TIME
BIT_TO_TOD
BIT_TO_UDINT
BIT_TO_UINT
BIT_TO_ULINT
BIT_TO_USINT
BIT_TO_WORD
BIT_TO_WSTRING

BYTE_TO___UXINT
BYTE_TO___XINT
BYTE_TO___XWORD
BYTE_TO_BOOL
BYTE_TO_BIT
BYTE_TO_DATE
BYTE_TO_DINT
BYTE_TO_DT
BYTE_TO_DWORD
BYTE_TO_INT
BYTE_TO_LDATE
BYTE_TO_LDT
BYTE_TO_LINT
BYTE_TO_LREAL
BYTE_TO_LTIME
BYTE_TO_LTOD
BYTE_TO_LWORD
BYTE_TO_REAL
BYTE_TO_SINT
BYTE_TO_STRING
BYTE_TO_TIME
BYTE_TO_TOD
BYTE_TO_UDINT
BYTE_TO_UINT
BYTE_TO_ULINT
BYTE_TO_USINT
BYTE_TO_WORD
BYTE_TO_WSTRING

DINT_TO___UXINT
DINT_TO___XINT
DINT_TO___XWORD
DINT_TO_BOOL
DINT_TO_BIT
DINT_TO_BYTE
DINT_TO_DATE
DINT_TO_DT
DINT_TO_DWORD
DINT_TO_INT
DINT_TO_LDATE
DINT_TO_LDT
DINT_TO_LINT
DINT_TO_LREAL
DINT_TO_LTIME
DINT_TO_LTOD
DINT_TO_LWORD
DINT_TO_REAL
DINT_TO_SINT
DINT_TO_STRING
DINT_TO_TIME
DINT_TO_TOD
DINT_TO_UDINT
DINT_TO_UINT
DINT_TO_ULINT
DINT_TO_USINT
DINT_TO_WORD
DINT_TO_WSTRING

DWORD_TO__UXINT
DWORD_TO__XINT
DWORD_TO__XWORD
DWORD_TO_BIT
DWORD_TO_BOOL
DWORD_TO_BYTE
DWORD_TO_DATE
DWORD_TO_DINT
DWORD_TO_DT
DWORD_TO_INT
DWORD_TO_LDATE
DWORD_TO_LDT
DWORD_TO_LINT
DWORD_TO_LREAL
DWORD_TO_LTIME
DWORD_TO_LTOD
DWORD_TO_LWORD
DWORD_TO_REAL
DWORD_TO_SINT
DWORD_TO_STRING
DWORD_TO_TIME
DWORD_TO_TOD
DWORD_TO_UDINT
DWORD_TO_UINT
DWORD_TO_ULINT
DWORD_TO_USINT
DWORD_TO_WORD
DWORD_TO_WSTRING

INT_TO__UXINT
INT_TO__XINT
INT_TO__XWORD
INT_TO_BIT
INT_TO_BOOL
INT_TO_BYTE
INT_TO_DATE
INT_TO_DINT
INT_TO_DT
INT_TO_DWORD
INT_TO_LDATE
INT_TO_LDT
LWORD_TO_STRING
LWORD_TO_TIME
LWORD_TO_TOD
LWORD_TO_UDINT
LWORD_TO_UINT
LWORD_TO_ULINT
LWORD_TO_USINT
LWORD_TO_WORD
LWORD_TO_WSTRING

SINT_TO___UXINT
SINT_TO___XINT
SINT_TO___XWORD
SINT_TO_BIT
SINT_TO_BOOL
SINT_TO_BYTE
SINT_TO_DATE
SINT_TO_DINT
SINT_TO_DT
SINT_TO_DWORD
SINT_TO_INT
SINT_TO_LDATE
SINT_TO_LDT
SINT_TO_LINT
SINT_TO_LREAL
SINT_TO_LTIME
SINT_TO_LTOD
SINT_TO_LWORD
SINT_TO_REAL
SINT_TO_STRING
SINT_TO_TIME
SINT_TO_TOD
SINT_TO_UDINT
SINT_TO_UINT
SINT_TO_ULINT
SINT_TO_USINT
SINT_TO_WORD
SINT_TO_WSTRING

UDINT_TO___UXINT
UDINT_TO___XINT
UDINT_TO___XWORD
UDINT_TO_BIT
UDINT_TO_BOOL
UDINT_TO_BYTE
UDINT_TO_DATE
UDINT_TO_DINT
UDINT_TO_DT
UDINT_TO_DWORD
UDINT_TO_INT
UDINT_TO_LDATE
UDINT_TO_LDT
UDINT_TO_LINT
UDINT_TO_LREAL
UDINT_TO_LTIME
UDINT_TO_LTOD
UDINT_TO_LWORD
UDINT_TO_REAL
UDINT_TO_SINT
UDINT_TO_STRING
UDINT_TO_TIME
UDINT_TO_TOD
UDINT_TO_UINT
UDINT_TO_ULINT
UDINT_TO_USINT
USINT_TO_BOOL  
USINT_TO_BYTE  
USINT_TO_DATE  
USINT_TO_DINT  
USINT_TO_DT  
USINT_TO_DWORD  
USINT_TO_INT  
USINT_TO_LDATE  
USINT_TO_LDT  
USINT_TO_LINT  
USINT_TO_LREAL  
USINT_TO_LTIME  
USINT_TO_LTOD  
USINT_TO_LWORD  
USINT_TO_REAL  
USINT_TO_SINT  
USINT_TO_STRING  
USINT_TO_TIME  
USINT_TO_TOD  
USINT_TO_UDINT  
USINT_TO_UINT  
USINT_TO_ULINT  
USINT_TO_WORD  
USINT_TO_WSTRING  

WORD_TO___XINT  
WORD_TO___XINT  
WORD_TO___XWORD  
WORD_TO_BIT  
WORD_TO_BOOL  
WORD_TO_BYTE  
WORD_TO_DATE  
WORD_TO_DINT  
WORD_TO_DT  
WORD_TO_DWORD  
WORD_TO_INT  
WORD_TO_LDATE  
WORD_TO_LDT  
WORD_TO_LINT  
WORD_TO_LREAL  
WORD_TO_LTIME  
WORD_TO_LTOD  
WORD_TO_LWORD  
WORD_TO_REAL  
WORD_TO_SINT  
WORD_TO_STRING  
WORD_TO_TIME  
WORD_TO_TOD  
WORD_TO_UDINT  
WORD_TO_UINT  
WORD_TO_ULINT  
WORD_TO_USINT  
WORD_TO_WSTRING
**NOTICE!**

String manipulation when converting to `STRING` or `WSTRING`

When converting the type to `STRING` or `WSTRING`, the typed value is left-aligned as a character string and truncated if it is too long. Therefore, declare the return variable for the type conversion operators `<>_TO_STRING` and `<>_TO_WSTRING` long enough that the character string has enough space without any manipulation.

The operators that convert a value into a character string of type `STRING` or `WSTRING` require an operand that matches the target data type.
When a larger data type is converted to a smaller data type, the more high-order (front) bytes are truncated. When a smaller data type is converted to a larger data type, the more high-order bytes filled with zeros.

```
FUNCTION_BLOCK FB_ConvertIntegersFromInt
VAR_INPUT
END_VAR
VAR_OUTPUT
END_VAR
VAR
uxiReturn: __UXINT;
xReturn: __XINT;
xwReturn: __XWORD;
bitReturn: BIT;
dateReturn: DATE;
bitReturn: DATE_AND_TIME;
dwReturn: DINT;
liReturn: LINT;
lrReturn: LREAL;
lwReturn: LWORD;
uiReturn: SINT;
sReturn: STRING;
timReturn: TIME;
todReturn: TIME_OF_DAY;
diReturn: UDINT;
uiReturn: UINT;
bsiReturn: USINT;
wReturn: WORD;
ulReturn: ULINT;
FUNCTION_BLOCK FB_ConvertIntegersToInt
VAR_INPUT
END_VAR
VAR_OUTPUT
END_VAR
VAR
uxiReturn := INT_TO__UXINT(127);
xReturn := INT_TO__XINT(127);
xwReturn := INT_TO__XWORD(127);
bitReturn := INT_TO_BIT(127);
return := INT_TO_BOOL(127);
bReturn := INT_TO_BYTE(127);
liReturn := INT_TO_DATE(127);
return := INT_TO_DINT(127);
dtReturn := INT_TO_DATE_AND_TIME(127);
dwReturn := DINT;
liReturn := LINT;
lrReturn := LREAL;
lwReturn := LWORD;
siReturn := SINT;
sReturn := STRING;
timReturn := TIME;
todReturn := TIME_OF_DAY;
ulReturn := UDINT;
uiReturn := UINT;
bsiReturn := USINT;
wReturn := WORD;
ulReturn := ULINT;
FUNCTION_BLOCK FB_ConvertIntegersToInt
VAR_INPUT
END_VAR
VAR_OUTPUT
```
VAR

iReturn_uxi: INT;
iReturn_xi: INT;
iReturn_xw: INT;
iReturn_bit: INT;
iReturn_bool: INT;
iReturn_b: INT;
iReturn_d: INT;
iReturn_di: INT;
iReturn_dt: INT;
iReturn_dw: INT;
iReturn_li: INT;
iReturn_lr: INT;
iReturn_lw: INT;
iReturn_r: INT;
iReturn_si: INT;
iReturn_s: INT;
iReturn_tim: INT;
iReturn_tod: INT;
iReturn_tod_0: INT;
iReturn_udi: INT;
iReturn_ui: INT;
iReturn_uli: INT;
iReturn_usi: INT;
iReturn_w: INT;
iReturn_ws: INT;

END_VAR

iReturn_uxi := __UXINT_TO_INT(18446744073709551615);
iReturn_xi := __XINT_TO_INT(9223372036854775807);
iReturn_xw := __XWORD_TO_INT(16#FFFF_FFFF_FFFF_FFFF);
iReturn_bit := BIT_TO_INT(1);
iReturn_bool := BOOL_TO_INT(TRUE);
iReturn_b := BYTE_TO_INT(2#1111_0000);
iReturn_d := DATE_TO_INT(DATE#2019-9-13);
iReturn_di := DINT_TO_INT(2147483647);
iReturn_dt := DT_TO_INT(DT#1979-1-1-00:00:00);
iReturn_dw := DWORD_TO_INT(16#FFFF_FFFF);
// iReturn_i := INT_TO_<>(iData_12);
iReturn_li := LINT_TO_INT(9223372036854775807);
iReturn_lr := LREAL_TO_INT(1.7976931348623157E+30);
iReturn_lw := LWORD_TO_INT(16#FFFF_FFFF_FFFF_FFFF);
iReturn_r := REAL_TO_INT(3.402823E+38);
iReturn_si := SINT_TO_INT(127);
iReturn_s := STRING_TO_INT("127");
iReturn_tim := TIME_TO_INT(T#49D17H2M47S295MS);
iReturn_tod := TOD_TO_INT(TOD#23:59:59.999);
iReturn_tod_0 := TOD_TO_INT(TOD#1:1:1.001);
iReturn_udi := UDINT_TO_INT(4294967295);
iReturn_ui := UINT_TO_INT(65535);
iReturn_uli := ULINT_TO_INT(18446744073709551615);
iReturn_usi := USINT_TO_INT(255);
iReturn_w := WORD_TO_INT(16#FFFF);
iReturn_ws := WSTRING_TO_INT("1234567890");

PROGRAM PLC_PRG

VAR

fbConvertIntegersFromInt : FB_ConvertIntegersFromInt;
fbConvertIntegersToInt : FB_ConvertIntegersToInt;

END_VAR

fbConvertIntegersFromInt();
fbConvertIntegersToInt();
See also

- “Type conversion operators” on page 2132
- Chapter 6.4.1.20.3.37 “Boolean Conversion” on page 2154
- Chapter 6.4.1.20.3.36 “Overloading” on page 2152
Floating-Point Number Conversion

NOTICE!
If the operand value for a type conversion operator is outside of the value range of the target data type, then the result output depends on the processor type and is therefore undefined. This is the case, for example, when a negative operand value is converted from LREAL to the target data type UINT.

Information can be lost when converting from larger data types to smaller data types.

NOTICE!
If the floating-point number is within the value range of the target data type, then the conversion operates the same way on all systems.

NOTICE!
If the floating-point number to be converted exceeds the range limit, then the first bytes of the number are ignored.

The operators convert a floating-point number into the specified data types and return a type-converted value. If applicable, the conversion is rounded.

Call Syntax

<variable name> := <floating-point conversion operator> ( <floating-point operand> );

<floating-point operand> = <variable name> | <literal>

<floating-point type> =
REAL | LREAL

Operators

REAL_TO___UXINT
REAL_TO___XINT
REAL_TO___XWORD
REAL_TO_BIT
REAL_TO_BOOL
REAL_TO_BYTE
REAL_TO_DATE
REAL_TO_DINT
REAL_TO_DT
REAL_TO_DWORD
REAL_TO_INT
REAL_TO_LINT
REAL_TO_LREAL
REAL_TO_LTIME
REAL_TO_LWORD
REAL_TO_SINT
REAL_TO_STRING
REAL_TO_TIME
REAL_TO_TOD
REAL_TO_UDINT
REAL_TO_UINT
REAL_TO_ULINT
REAL_TO_USINT
REAL_TO_WORD
REAL_TO_WSTRING
LREAL_TO__UXINT
LREAL_TO__XINT
LREAL_TO__XWORD
LREAL_TO_BIT
LREAL_TO_BOOL
LREAL_TO_BYTE
LREAL_TO_DATE
LREAL_TO_DINT
LREAL_TO_DT
LREAL_TO_DWORD
LREAL_TO_INT
LREAL_TO_LINT
LREAL_TO_LTIME
LREAL_TO_LWORD
LREAL_TO_REAL
LREAL_TO_SINT
LREAL_TO_STRING
LREAL_TO_TIME
LREAL_TO_TOD
LREAL_TO_UDINT
LREAL_TO_UINT
LREAL_TO_ULINT
LREAL_TO_USINT
LREAL_TO_WORD
LREAL_TO_WSTRING

**Rounding**

When converting to an integer, the operand is rounded up or down to an integer value. For 1 to 4 after the decimal point, the number is rounded down. For 5 to 9, the number is rounded up. Then the rounded number is converted to the specified integer type. If the rounded value is outside of the integer value range, then an undefined, target system-dependent value is returned. An exception error is also possible then.

**NOTICE!**
The rounding logic for borderline cases depends on the target system or the FPU (Floating Point Unit) of the target system. For example, a value of \(-1.5\) can be converted differently on different controllers.

To program target system-independent code, you have to catch value range overflows across the application.

**Converting to a string**

**NOTICE!**

String manipulation when converting to STRING or WSTRING

When converting the type to STRING or WSTRING, the typed value is left-aligned as a character string and truncated if it is too long. Therefore, declare the return variable for the type conversion operators <>_TO_STRING and <>_TO_WSTRING long enough that the character string has enough space without any manipulation.
For a floating-point number conversion to a string, the number of decimal places of the mantissa is limited to 6. If the number is $< 1$, then the mantissa is $1 \leq m < 10$. If the mantissa has more digits after the comma, then it is rounded to the 6th digit and then converted.

The string variable may also be declared too short for the return value. In this case, the return string is truncated on the right.
Examples

ST implementation language

<table>
<thead>
<tr>
<th>Function</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>xvReturn</td>
<td>( \text{REAL TO XMWORD}(3.402823E+38) )</td>
</tr>
<tr>
<td>xReturn</td>
<td>( \text{REAL TO BOOL}(3.402823E+35) )</td>
</tr>
<tr>
<td>bReturn</td>
<td>( \text{REAL TO BYTE}(3.402823E+38) )</td>
</tr>
<tr>
<td>dateReturn</td>
<td>( \text{REAL TO DDATE}(3.402823E+35) )</td>
</tr>
<tr>
<td>d1Return</td>
<td>( \text{REAL TO DINT}(3.402823E+38) )</td>
</tr>
<tr>
<td>dtReturn</td>
<td>( \text{REAL TO DT}(3.402823E+38) )</td>
</tr>
<tr>
<td>dvReturn</td>
<td>( \text{REAL TO DWORD}(3.402823E+38) )</td>
</tr>
<tr>
<td>iReturn</td>
<td>( \text{REAL TO INT}(-1.5) )</td>
</tr>
<tr>
<td>iReturn_0</td>
<td>( \text{REAL TO INT}(-1.4) )</td>
</tr>
<tr>
<td>iReturn_1</td>
<td>( \text{REAL TO INT}(1.4) )</td>
</tr>
<tr>
<td>iReturn_2</td>
<td>( \text{REAL TO INT}(1.5) )</td>
</tr>
<tr>
<td>iReturn_3</td>
<td>( \text{REAL TO INT}(1.234567890123456789E4) )</td>
</tr>
<tr>
<td>l1Return</td>
<td>( \text{REAL TO LINT}(3.402823E+35) )</td>
</tr>
<tr>
<td>lxReturn</td>
<td>( \text{REAL TO LREAL}(3.402823E+38) )</td>
</tr>
<tr>
<td>lvReturn</td>
<td>( \text{REAL TO LWORD}(3.402823E+38) )</td>
</tr>
<tr>
<td>siReturn</td>
<td>( \text{REAL TO SINT}(3.402823E+38) )</td>
</tr>
<tr>
<td>sReturn</td>
<td>( \text{REAL TO STRING}(3.402823E+38) )</td>
</tr>
<tr>
<td>timReturn</td>
<td>( \text{REAL TO TIME}(3.402823E+38) )</td>
</tr>
<tr>
<td>todReturn</td>
<td>( \text{REAL TO TOD}(3.402823E+38) )</td>
</tr>
<tr>
<td>udiReturn</td>
<td>( \text{REAL TO UDINT}(3.402823E+38) )</td>
</tr>
<tr>
<td>uiReturn</td>
<td>( \text{REAL TO UINT}(3.402823E+38) )</td>
</tr>
<tr>
<td>ulReturn</td>
<td>( \text{REAL TO UUINT}(3.402823E+38) )</td>
</tr>
<tr>
<td>usReturn</td>
<td>( \text{REAL TO USINT}(3.402823E+38) )</td>
</tr>
<tr>
<td>wReturn</td>
<td>( \text{REAL TO WORD}(3.402823E+38) )</td>
</tr>
<tr>
<td>wstring</td>
<td>( \text{REAL TO WSTRING}(3.402823E+38) )</td>
</tr>
</tbody>
</table>

See also

- “Type conversion operators” on page 2132
- Chapter 6.4.1.20.3.37 “Boolean Conversion” on page 2154
- Chapter 6.4.1.20.3.36 “Overloading” on page 2152
- Chapter 6.4.1.20.3.38 “Integer Conversion” on page 2159
- Chapter 6.4.1.20.3.40 “String Conversion” on page 2174
- Chapter 6.4.1.20.3.42 “Date and Time Conversion” on page 2187
- Chapter 6.4.1.20.3.41 “Time Conversion” on page 2182

String Conversion

**NOTICE!**

If the operand value for a type conversion operator is outside of the value range of the target data type, then the result output depends on the processor type and is therefore undefined. This is the case, for example, when a negative operand value is converted from \( \text{LREAL} \) to the target data type \( \text{UINT} \).

Information can be lost when converting from larger data types to smaller data types.
The operators convert a character string (STRING or WSTRING) into the specified target data type and return a type-converted value.

A conversion with a meaningful result is only possible when the operand matches the target data type according to the IEC 61131-3 standard. This is the case if the value of the operand corresponds to a valid constant (literal) of the target data type.

Convertible strings contain:

- Number with type prefix (example: '16#FFFFFFFF')
- Number with grouping characters (example: '2#1111_1111')
  
  Note: The international weight and measure grouping character (thin space) is not accepted. Only the underscore is accepted.
- Floating-point number, also in exponential notation (example: '9.876' or '1.2E-34')
  
  Note: Floating-point numbers are not convertible. The comma is treated and truncated like a following character.
- Time, time of day, and date specification with prefix and size (example: 'T#2h', 'DT#2019-9-9-12:30:30.9')
- Infinite values (example: '1.7E+400')
- Additional character after a number (example: '2m' or '3.14'). These are truncated.
- Additional characters before a number are not permitted.
- Spaces before (example: ' 3.14')

**Call syntax**

```plaintext
<variable name> := <string to operator> ( <operand> );
<operand> = <variable name> | <literal>
```

**Operators**

- STRING_TO__UXINT
- STRING_TO__XINT
- STRING_TO__XWORD
- STRING_TO_BIT
- STRING_TO_BOOL
- STRING_TO_BYTE
- STRING_TO_DATE
- STRING_TO_DINT
- STRING_TO_DT
- STRING_TO_DWORD
- STRING_TO_INT
- STRING_TO_LDATE
- STRING_TO_LDT
- STRING_TO_LINT
- STRING_TO_LREAL
- STRING_TO_LTIME
- STRING_TO_LWORD
- STRING_TO_LTIME
- STRING_TO_LTOD
- STRING_TO_REAL
- STRING_TO_SINT
- STRING_TO_TIME
- STRING_TO_TOD
- STRING_TO_UDINT
- STRING_TO_UINT
- STRING_TO_ULINT
- STRING_TO_USINT
- STRING_TO_WORD
- STRING_TO_WSTRING

- WSTRING_TO__UXINT
- WSTRING_TO__XINT
- WSTRING_TO__XWORD
Converting to a Boolean value

Operator STRING_TO_BOOL: A value of TRUE is returned only if the operand value is 'TRUE' or 'true'. On the other hand, FALSE is returned for 'True'.

Operator WSTRING_TO_BOOL: A value of TRUE is returned only if the operand value is "TRUE" or "true". On the other hand, FALSE is returned for "True".
FUNCTION_BLOCK FB_ConvertStrings
VAR_INPUT
END_VAR
VAR_OUTPUT
END_VAR
VAR
  xReturn_0: BOOL;
  xReturn_1: BOOL;
  dateReturn: DATE;
  dtReturn: DATE_AND_TIME;
  iReturn: INT;
  lrReturn: LREAL;
  lrReturn_0: LREAL;
  lwReturn: LWORD;
  lwReturn_0: LWORD;
  ltReturn: LTIME;
  ltReturn_0: LTIME;
  ltReturn_1: LTIME;
  ltReturn_2: LTIME;
  rReturn: REAL;
  rReturn_0: REAL;
  timReturn: TIME;
  timReturn0: TIME;
  timReturn1: TIME;
  timReturn2: TIME;
  todReturn: TIME_OF_DAY;
  todReturn0: TIME_OF_DAY;
  todReturn1: TIME_OF_DAY;
  todReturn2: TIME_OF_DAY;
  uliReurn: ULINT;
  uliReurn_0: ULINT;
  uliReurn_1: ULINT;
  wReturn: WORD;
  wReturn_0: WORD;
  wReturn_1: WORD;
  wstrReturn: WSTRING;
  wstrReturn_0: WSTRING;
END_VAR
xReturn_0 := STRING_TO_BOOL('FALSE');
  xReturn_1 := STRING_TO_BOOL('TRUE');
dateReturn := STRING_TO_DATE('DATE#2019-9-9');
dtReturn := STRING_TO_DT('DT#2019-9-9-1:1:1.1');
iReturn := STRING_TO_INT('123abc');
lrReturn := STRING_TO_LREAL('4.94E-323');
lrReturn_0 := STRING_TO_LREAL('1.7E+308');
lwReturn := STRING_TO_LWORD('16#FFFF_FFFF_FFFF_FFFF');
lwReturn_0 := STRING_TO_LWORD('16#0123456789ABCDEF');
lwReturn_1 := STRING_TO_LWORD('16#0123456789ABCDEF');
lReturn := STRING_TO_LTIME('LTIME#213503d23h34m33s709ms551us615ns');
lReturn_0 := STRING_TO_LTIME('LTIME#0ns');
lReturn_1 := STRING_TO_LTIME('LTIME#1ms');
lReturn_2 := STRING_TO_LTIME('LTIME#2s');
rReturn := STRING_TO_REAL('6.543e21');
rReturn_0 := STRING_TO_REAL('1.234');
timReturn := STRING_TO_TIME('T#5d4h3m2s');
timReturn0 := STRING_TO_TIME('TIME#1s');
timReturn1 := STRING_TO_TIME('1s');
```
<table>
<thead>
<tr>
<th>Device.App_ConvertStrings.PL_PROG.AConvertStrings</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>wReturn[0] := STRING_TOBOOL('FALSE');</td>
</tr>
<tr>
<td>2</td>
<td>wReturn[1] := STRING_TOBOOL('TRUE');</td>
</tr>
<tr>
<td>3</td>
<td>dateReturn[0x05-13] := STRING_TODATE('DATE#2019-9-9');</td>
</tr>
<tr>
<td>5</td>
<td>intReturn := STRING_TOINT('123abc');</td>
</tr>
<tr>
<td>6</td>
<td>intReturn[0x05-33] := STRING_TOINT('55432');</td>
</tr>
<tr>
<td>7</td>
<td>rtReturn[1E-300] := STRING_TO_REAL('1.7E+300');</td>
</tr>
<tr>
<td>8</td>
<td>ulReturn[1E6+73730000015520] := STRING_TO_LLONG('1E6+73730000015520');</td>
</tr>
<tr>
<td>9</td>
<td>ulReturn[1E6+73730000015520] := STRING_TO_LLONG('1E6+73730000015520');</td>
</tr>
<tr>
<td>10</td>
<td>rtReturn[1E6+73730000015520] := STRING_TO_REAL('1E6+73730000015520');</td>
</tr>
<tr>
<td>11</td>
<td>rtReturn[1E6+73730000015520] := STRING_TO_REAL('1E6+73730000015520');</td>
</tr>
<tr>
<td>12</td>
<td>rtReturn[1E6+73730000015520] := STRING_TO_REAL('1E6+73730000015520');</td>
</tr>
<tr>
<td>13</td>
<td>rtReturn[1E6+73730000015520] := STRING_TO_REAL('1E6+73730000015520');</td>
</tr>
<tr>
<td>14</td>
<td>rtReturn[1E6+73730000015520] := STRING_TO_REAL('1E6+73730000015520');</td>
</tr>
<tr>
<td>15</td>
<td>rtReturn[1E6+73730000015520] := STRING_TO_REAL('1E6+73730000015520');</td>
</tr>
<tr>
<td>16</td>
<td>rtReturn[1E6+73730000015520] := STRING_TO_REAL('1E6+73730000015520');</td>
</tr>
<tr>
<td>17</td>
<td>rtReturn[1E6+73730000015520] := STRING_TO_REAL('1E6+73730000015520');</td>
</tr>
<tr>
<td>18</td>
<td>rtReturn[1E6+73730000015520] := STRING_TO_REAL('1E6+73730000015520');</td>
</tr>
<tr>
<td>19</td>
<td>rtReturn[1E6+73730000015520] := STRING_TO_REAL('1E6+73730000015520');</td>
</tr>
<tr>
<td>20</td>
<td>rtReturn[1E6+73730000015520] := STRING_TO_REAL('1E6+73730000015520');</td>
</tr>
<tr>
<td>21</td>
<td>rtReturn[1E6+73730000015520] := STRING_TO_REAL('1E6+73730000015520');</td>
</tr>
<tr>
<td>22</td>
<td>rtReturn[1E6+73730000015520] := STRING_TO_REAL('1E6+73730000015520');</td>
</tr>
<tr>
<td>23</td>
<td>rtReturn[1E6+73730000015520] := STRING_TO_REAL('1E6+73730000015520');</td>
</tr>
<tr>
<td>24</td>
<td>ulReturn[1E6+73730000015520] := STRING_TO_LLONG('1E6+73730000015520');</td>
</tr>
<tr>
<td>25</td>
<td>ulReturn[1E6+73730000015520] := STRING_TO_LLONG('1E6+73730000015520');</td>
</tr>
<tr>
<td>26</td>
<td>ulReturn[1E6+73730000015520] := STRING_TO_LLONG('1E6+73730000015520');</td>
</tr>
<tr>
<td>27</td>
<td>ulReturn[1E6+73730000015520] := STRING_TO_LLONG('1E6+73730000015520');</td>
</tr>
<tr>
<td>28</td>
<td>ulReturn[1E6+73730000015520] := STRING_TO_LLONG('1E6+73730000015520');</td>
</tr>
<tr>
<td>29</td>
<td>wReturn[0] := STRING_TOWORD('16#FFFF_0000');</td>
</tr>
<tr>
<td>30</td>
<td>wReturn[1] := STRING_TOWORD('34abc');</td>
</tr>
<tr>
<td>31</td>
<td>wstrReturn := STRING_TOWSTRING('Hello World!');</td>
</tr>
<tr>
<td>32</td>
<td>wstrReturn[0] := STRING_TOWSTRING('123456789');</td>
</tr>
</tbody>
</table>
```
FUNCTION_BLOCK FB_ConvertWstrings
  VAR
    xReturn_0: BOOL;
    xReturn_1: BOOL;
    dateReturn: DATE;
    dtReturn: DATE_AND_TIME;
    iReturn: INT;
    lrReturn: LREAL;
    lwReturn_0: LWORD;
    lwReturn_1: LWORD;
    ltReturn: LTIME;
    ltReturn_0: LTIME;
    ltReturn_1: LTIME;
    ltReturn_2: LTIME;
    rReturn: REAL;
    rReturn_0: REAL;
    timReturn: TIME;
    timReturn0: TIME;
    timReturn1: TIME;
    timReturn2: TIME;
    todReturn: TIME_OF_DAY;
    todReturn0: TIME_OF_DAY;
    todReturn1: TIME_OF_DAY;
    todReturn2: TIME_OF_DAY;
    uliReturn: ULINT;
    uliReturn_0: ULINT;
    uliReturn_1: ULINT;
    wReturn: WORD;
    wReturn_0: WORD;
    wReturn_1: WORD;
    wstrReturn: WSTRING;
    wstrReturn_0: WSTRING;
  END_VAR
  xReturn_0 := WSTRING_TO_BOOL("FALSE");
  xReturn_1 := WSTRING_TO_BOOL("TRUE");
  dateReturn := WSTRING_TO_DATE("DATE#2019-9-9");
  dtReturn := WSTRING_TO_DT("DT#2019-9-9-1:1:1.1");
  iReturn := WSTRING_TO_INT("123abc");
  lrReturn := WSTRING_TO_LREAL("4.94E-323");
  lrReturn_0 := WSTRING_TO_LREAL("1.7E+308");
  lwReturn := WSTRING_TO_LWORD("16#FFFF_FFFF_FFFF_FFFF");
  lwReturn_0 := WSTRING_TO_LWORD("16#0123456789ABCDEF");
  lwReturn_1 := WSTRING_TO_LWORD("16#0123456789ABCDEF");
  ltReturn := WSTRING_TO_LTIME("LTIME#213503d23h34m33s709ms551us615ns");
  ltReturn_0 := WSTRING_TO_LTIME("LTIME#0ns");
  ltReturn_1 := WSTRING_TO_LTIME("LTIME#1ms");
  ltReturn_2 := WSTRING_TO_LTIME("LTIME#2s");
  rReturn := WSTRING_TO_REAL("6.543e21");
  rReturn_0 := WSTRING_TO_REAL("1.234");
  timReturn := WSTRING_TO_TIME("T#5d4h3m2s");
  timReturn0 := WSTRING_TO_TIME("TIME#1s");
  timReturn1 := WSTRING_TO_TIME("1s");
  timReturn2 := WSTRING_TO_TIME("TIME#5s");
  todReturn := WSTRING_TO_TOD("TOD#12:0:0.1");
  todReturn0 := WSTRING_TO_TOD("TOD#0:0:0.0");
  todReturn1 := WSTRING_TO_TOD("20:15");
  todReturn2 := WSTRING_TO_TOD("TOD#20:15");
END_FUNCTION_BLOCK
uliReurn := WSTRING_TO_ULINT("18446744073709551615");
uliReurn_0 := WSTRING_TO_ULINT("1");
uliReurn_1 := WSTRING_TO_ULINT("0");
wReturn := WSTRING_TO_WORD("16#FFFF_0000");
wReturn_0 := WSTRING_TO_WORD("34abc");
wReturn_1 := WSTRING_TO_WORD("16#34abc");

FBD implementation language
Time Conversion

NOTICE!

If the operand value for a type conversion operator is outside of the value range of the target data type, then the result output depends on the processor type and is therefore undefined. This is the case, for example, when a negative operand value is converted from `LREAL` to the target data type `UINT`.

Information can be lost when converting from larger data types to smaller data types.

The operators convert time values (`TIME` or `LIME`) into the specified data types and return this type-converted value.

Call syntax

```
<variable name> := <time conversion operator> ( <operand> );
<operand> = <variable name> | <literal>
```

Operators

```
TIME_TO__UXINT
TIME_TO___XINT
TIME_TO___XWORD
TIME_TO_BIT
TIME_TO_BOOL
TIME_TO_BYTE
TIME_TO_DATE
TIME_TO_DINT
TIME_TO_DT
TIME_TO_DWORD
TIME_TO_INT
TIME_TO_LDATE
TIME_TO_LDINT
TIME_TO_LINT
TIME_TO_LREAL
TIME_TO_LTIME
TIME_TO_LTOD
TIME_TO_LWORD
TIME_TO_REAL
TIME_TO_SINT
TIME_TO_STRING
TIME_TO_TOD
TIME_TO_UDINT
TIME_TO_UINT
TIME_TO_ULINT
TIME_TO_USINT
TIME_TO_WORD
TIME_TO_WSTRING
```
The operator returns **FALSE** if and only if the operand value can be interpreted as "0".

### Converting to Boolean values

<table>
<thead>
<tr>
<th>Expression</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>xTime := TIME_TO_BOOL(T#0MS);</code></td>
<td><code>xTime = FALSE</code></td>
</tr>
<tr>
<td><code>xLongTime := TIME_TO_BOOL(T#0NS);</code></td>
<td><code>xLongTime = FALSE</code></td>
</tr>
<tr>
<td><code>xTime := TIME_TO_BOOL(T#1MS);</code></td>
<td><code>xDate = TRUE</code></td>
</tr>
<tr>
<td><code>xLongTime := TIME_TO_BOOL(T#1NS);</code></td>
<td><code>xLongTime = TRUE</code></td>
</tr>
</tbody>
</table>

### Converting to a string

**NOTICE!**

String manipulation when converting to STRING or WSTRING

When converting the type to **STRING** or **WSTRING**, the typed value is left-aligned as a character string and truncated if it is too long. Therefore, declare the return variable for the type conversion operators `<>` TO STRING and `<>` TO WSTRING long enough that the character string has enough space without any manipulation.

<table>
<thead>
<tr>
<th>Expression</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>sTime := TIME_TO_STRING(T#0MS);</code></td>
<td><code>sTime = 'T#0MS'</code></td>
</tr>
<tr>
<td><code>wsLongTime := LTIME_TO_WSTRING(T#0US);</code></td>
<td><code>wsLongTime = &quot;T#0US&quot;</code></td>
</tr>
</tbody>
</table>
FUNCTION_BLOCK FB_ConvertTimeAndDate
VAR_INPUT
END_VAR
VAR_OUTPUT
END_VAR
VAR
  ltReturn_1: LTIME;
  lwReturn_2: LWORD;
  rReturn_3: REAL;
  strReturn_4: STRING;
  timReturn_5: TIME;
  todReturn_6: TIME_OF_DAY;
  uliReturn_7: ULINT;
  wstrReturn_8: WSTRING;
  wstrReturn_80: WSTRING;
  uliReturn_70: ULINT;
  todReturn_60: TIME_OF_DAY;
  timReturn_50: TIME;
  strReturn_40: STRING;
  rReturn_30: REAL;
  lwReturn_20: LWORD;
  ltReturn_10: LTIME;
  ltReturn_11: LTIME;
  lwReturn_21: LWORD;
  rReturn_31: REAL;
  strReturn_41: STRING;
  timReturn_51: TIME;
  todReturn_61: TIME_OF_DAY;
  uliReturn_71: ULINT;
  wstrReturn_81: WSTRING;
  ltReturn_12: LTIME;
  xReturn_9: BOOL;
  xReturn_90: BOOL;
  xReturn_91: BOOL;
  xReturn_92: BOOL;
  dateReturn_6: DATE;
  timReturn_60: TIME;
  wReturn_61: WORD;
  todReturn_61: TIME_OF_DAY;
END_VAR

ltReturn_1 := DT_TO_LTIME(DT#2019-9-9-23:59:59);
ltReturn_10 := DT_TO_LTIME(DT#1970-1-1-0:0:0);
ltReturn_11 := DT_TO_LTIME(DT#1970-1-2-0:0:1);
ltReturn_12 := DT_TO_LTIME(DT#1970-1-3-12:30:30);

lwReturn_2 := TIME_TO_LWORD(T#5D4H2M3S2MS);
lwReturn_20 := TIME_TO_LWORD(T#0D0H0M0S0MS);

rReturn_3 := TIME_TO_REAL(T#5D4H2M3S2MS);
rReturn_30 := TIME_TO_REAL(T#0D0H0M0S0MS);

strReturn_4 := TIME_TO_STRING(T#5D4H2M3S2MS);
strReturn_40 := TIME_TO_STRING(T#0D0H0M0S0MS);

timReturn_5 := TOD_TO_TIME(TOD#23:59:59.999);
timReturn_50 := TOD_TO_TIME(TOD#0:0:0.000);
timReturn_51 := TOD_TO_TIME(TOD#0:0:0.001);
FBD implementation language
See also

- “Type conversion operators” on page 2132
- Chapter 6.4.1.20.3.37 “Boolean Conversion” on page 2154
- Chapter 6.4.1.20.3.36 “Overloading” on page 2152
- Chapter 6.4.1.20.3.38 “Integer Conversion” on page 2159
- Chapter 6.4.1.20.3.39 “Floating-Point Number Conversion” on page 2171
- Chapter 6.4.1.20.3.40 “String Conversion” on page 2174
- Chapter 6.4.1.20.3.42 “Date and Time Conversion” on page 2187

Date and Time Conversion

**NOTICE!**

If the operand value for a type conversion operator is outside of the value range of the target data type, then the result output depends on the processor type and is therefore undefined. This is the case, for example, when a negative operand value is converted from LREAL to the target data type UINT.

Information can be lost when converting from larger data types to smaller data types.

The operators convert a date and time value into the specified data type and return a type-converted value.

Call syntax

<variable name> := <date and time conversion operator> ( <operand> )
<operand> = <variable name> | <literal>

The data types DATE and DT use the same memory format internally and are stored as DWORD. The resolution for DATE is 1 day. The resolution for DT is 1 second. Both begin at January 1, 1970. TOD is stored as DWORD with a resolution of 1 millisecond.

Operators

DATE_TO___UXINT
DATE_TO___XINT
DATE_TO___XWORD
DATE_TO_BIT
DATE_TO_BOOL
DATE_TO_BYTE
DATE_TO_DINT
DATE_TO_DT
DATE_TO_DWORD
DATE_TO_INT
DATE_TO_LINT
DATE_TO_LREAL
DATE_TO_LTIME
DATE_TO_LWORD
DATE_TO_REAL
DATE_TO_SINT
DATE_TO_STRING
DATE_TO_TIME
DATE_TO_TOD
DATE_TO_UDINT
DATE_TO_UINT
DATE_TO_ULINT
DATE_TO_USINT
DATE_TO_WORD
DATE_TO_WSTRING
DT_TO__UXINT
DT_TO__XINT
DT_TO__XWORD
DT_TO_BIT
DT_TO_BOOL
DT_TO_BYTE
DT_TO_DATE
DT_TO_DINT
DT_TO_DWORD
DT_TO_INT
DT_TO_LINT
DT_TO_LREAL
DT_TO_LTIME
DT_TO_LWORD
DT_TO_REAL
DT_TO_SINT
DT_TO_STRING
DT_TO_TIME
DT_TO_TOD
DT_TO_UDINT
DT_TO_UINT
DT_TO_ULINT
DT_TO_USINT
DT_TO_WORD
DT_TO_WSTRING
TOD_TO__UXINT
TOD_TO__XINT
TOD_TO__XWORD
TOD_TO_BOOL
TOD_TO_BIT
TOD_TO_BYTE
TOD_TO_DATE
TOD_TO_DINT
TOD_TO_DT
TOD_TO_DWORD
TOD_TO_INT
TOD_TO_LINT
TOD_TO_LREAL
TOD_TO_LTIME
TOD_TO_LWORD
TOD_TO_REAL
TOD_TO_SINT
TOD_TO_STRING
TOD_TO_TIME
TOD_TO_TOD
TOD_TO_UDINT
TOD_TO_UINT
TOD_TO_ULINT
TOD_TO_USINT
TOD_TO_WORD
TOD_TO_WSTRING
Long operators
LDATE_TO__UXINT
LDATE_TO__XINT
LDATE_TO__XWORD
LDATE_TO_BIT
LDATE_TO_BOOL
LDATE_TO_BYTE
LDATE_TO_DATE
LDATE_TO_DINT
LDATE_TO_DT
LDATE_TO_DWORD
The operator returns FALSE if and only if the operand value can be interpreted as "0".

<table>
<thead>
<tr>
<th>Date</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Value</td>
</tr>
<tr>
<td>DateAndTime</td>
<td>Value</td>
</tr>
<tr>
<td>TimeOfDay</td>
<td>Value</td>
</tr>
</tbody>
</table>

The data types DATE and DT use the same memory format internally, namely a DWORD. The resolution for DATE is 1 day. The resolution for DT is 1 second. Both begin at January 1, 1970.

TOD is stored as DWORD with a resolution of 1 millisecond.

<table>
<thead>
<tr>
<th>Integer</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integer</td>
<td>Value</td>
</tr>
<tr>
<td>Integer</td>
<td>Value</td>
</tr>
<tr>
<td>Integer</td>
<td>Value</td>
</tr>
<tr>
<td>Integer</td>
<td>Value</td>
</tr>
</tbody>
</table>
**NOTICE!**

String manipulation when converting to STRING or WSTRING

When converting the type to STRING or WSTRING, the typed value is left-aligned as a character string and truncated if it is too long. Therefore, declare the return variable for the type conversion operators `<>_TO_STRING` and `<>_TO_WSTRING` long enough that the character string has enough space without any manipulation.

---

The operands of type `DATE`, `DATE_AND_TIME`, `TIME_OF_DAY`, `DT`, or `TOD`, which are passed to an operator for a data and time conversion, are converted to their constant syntax (literal syntax). The generated string contains the keyword `D#`, `DT#` or `TOD#` and then the size with its data and time unit, as indicated in the IEC 61131-3 specification.

### Examples

```plaintext
DEVICE_APP_ConvertToWStrings.PLC_PRG.Device.App_ConvertToWStrings
```

<table>
<thead>
<tr>
<th>Line</th>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>WRITE</td>
<td><code>DATE_TO_WSTRING(21111_1111)</code></td>
</tr>
<tr>
<td>2</td>
<td>WRITE</td>
<td><code>DATE_TO_WSTRING(D1970-2-1)</code></td>
</tr>
<tr>
<td>3</td>
<td>WRITE</td>
<td><code>DATE_TO_WSTRING(D1970-1-3)</code></td>
</tr>
<tr>
<td>4</td>
<td>WRITE</td>
<td><code>DATE_TO_WSTRING(D1970-1-1)</code></td>
</tr>
<tr>
<td>5</td>
<td>WRITE</td>
<td><code>DT_TO_WSTRING(D1970-1-2-0:0:0)</code></td>
</tr>
<tr>
<td>6</td>
<td>WRITE</td>
<td><code>DT_TO_WSTRING(D1970-1-2-0:0:0)</code></td>
</tr>
<tr>
<td>7</td>
<td>WRITE</td>
<td><code>DM em_TO_WSTRING(164 FFFF FFFF)</code></td>
</tr>
<tr>
<td>8</td>
<td>WRITE</td>
<td><code>INT_TO_WSTRING(-3276)</code></td>
</tr>
<tr>
<td>9</td>
<td>WRITE</td>
<td><code>INT_TO_WSTRING(3)</code></td>
</tr>
<tr>
<td>10</td>
<td>WRITE</td>
<td><code>LREAL_TO_WSTRING(1.1E+50)</code></td>
</tr>
<tr>
<td>11</td>
<td>WRITE</td>
<td><code>LREAL_TO_WSTRING(L64F FFFF_FFFF_FFFF)</code></td>
</tr>
<tr>
<td>12</td>
<td>WRITE</td>
<td><code>REAL_TO_WSTRING(1.234)</code></td>
</tr>
<tr>
<td>13</td>
<td>WRITE</td>
<td><code>REAL_TO_WSTRING(0)</code></td>
</tr>
<tr>
<td>14</td>
<td>WRITE</td>
<td><code>SINT_TO_WSTRING(123)</code></td>
</tr>
<tr>
<td>15</td>
<td>WRITE</td>
<td><code>STRING_TO_WSTRING(15)</code></td>
</tr>
<tr>
<td>16</td>
<td>WRITE</td>
<td><code>TD_TO_WSTRING(TOD#1:1)</code></td>
</tr>
<tr>
<td>17</td>
<td>WRITE</td>
<td><code>TIME_TO_WSTRING(850)</code></td>
</tr>
<tr>
<td>18</td>
<td>WRITE</td>
<td><code>UT_TO_WSTRING(4284667295)</code></td>
</tr>
<tr>
<td>19</td>
<td>WRITE</td>
<td><code>UT_TO_WSTRING(4623)</code></td>
</tr>
<tr>
<td>20</td>
<td>WRITE</td>
<td><code>UT_TO_WSTRING(1)</code></td>
</tr>
<tr>
<td>21</td>
<td>WRITE</td>
<td><code>UT_TO_WSTRING(1)</code></td>
</tr>
<tr>
<td>22</td>
<td>WRITE</td>
<td><code>WSTRING_TO_WSTRING(1F4F4FF)</code></td>
</tr>
</tbody>
</table>
The controller is in online mode in order to monitor the variables.

See also

- “Type conversion operators” on page 2132
- Chapter 6.4.1.20.3.37 “Boolean Conversion” on page 2154
- Chapter 6.4.1.20.3.36 “Overloading” on page 2152
- Chapter 6.4.1.20.3.38 “Integer Conversion” on page 2159
- Chapter 6.4.1.20.3.39 “Floating-Point Number Conversion” on page 2171
- Chapter 6.4.1.20.3.40 “String Conversion” on page 2174
- Chapter 6.4.1.20.3.41 “Time Conversion” on page 2182
Operator 'TRUNC'

The IEC operator is used for converting the REAL data type into the DINT data type. CODESYS takes only the integer part of the number.

In CoDeSys V2.3, the TRUNC operator converts REAL into INT. If you import a V2.3 project, then CODESYS automatically replaces TRUNC with TRUNC_INT.

If CODESYS cannot represent the input value by a DINT or INT, then the result of this function is undefined. The behavior of such input values is platform-dependent.

```
NOTICE!

If the operand value for a type conversion operator is outside of the value range of the target data type, then the result output depends on the processor type and is therefore undefined. This is the case, for example, when a negative operand value is converted from LREAL to the target data type UINT.

Information can be lost when converting from larger data types to smaller data types.
```

Examples

Result in diVar: 1

```
ST

diVar := TRUNC(1.9); (* Result: 1 *)
d iVar := TRUNC(-1.4); (* Result: -1 *)
```

See also

- “Type conversion operators” on page 2132

Operator 'TRUNC_INT'

The IEC operator is used for converting the REAL data type into the INT data type. CODESYS takes only the integer part of the number.

TRUNC_INT corresponds to the TRUNC operator in CoDeSys V2.3, and it is used automatically at this point when importing V2.3 projects. Note the change function of TRUNC.

If CODESYS cannot represent the input value by a DINT or INT, then the result of this function is undefined. The behavior of such input values is platform-dependent.

```
NOTICE!

If the operand value for a type conversion operator is outside of the value range of the target data type, then the result output depends on the processor type and is therefore undefined. This is the case, for example, when a negative operand value is converted from LREAL to the target data type UINT.

Information can be lost when converting from larger data types to smaller data types.
```
**Operator 'ABS'**

This IEC operator yields the absolute value of a number.

Permitted data types for input and output variables and numeric constants: any numeric basic data type

```
Examples
Result in i: 2

ST:
i := ABS(-2);
```

**Operator 'SQRT'**

This IEC of course yields the square root of a number.

Permitted data types for input variables: any numeric basic data type
Permitted data types for output variables: REAL or LREAL

```
Examples
Result in q: 4

ST:
q := SQRT(16);
```

**Operator 'LN'**

This IEC operator yields the natural logarithm of a number.

Permitted data types for input variables: any numeric basic data type
Permitted data types for output variables: REAL and LREAL
**Examples**

Result: 3.80666

ST:

q := LN(45);

FBD:

![LN block](image)

---

**Operator 'LOG'**

This IEC operator yields the base-10 logarithm of a number.
The input variable can be any numeric basic data type, but the output variable must be the data type REAL or LREAL.

**Examples**

Result in q: 2.49762

ST:

q := LOG(314.5);

FBD:

![LOG block](image)

---

**Operator 'EXP'**

This IEC operator yields the exponential function.
Permitted data types for input variables: any numeric basic data type
Permitted data types for output variables: REAL and LREAL

**Examples**

Result in q: 7.389056099

ST:

q := EXP(2);

FBD:

![EXP block](image)

---

**Operator 'EXPT'**

This IEC operator raises a number to a higher power and returns the power of the base raised to the exponent: power = base^exponent. The input values (parameters) are the base and the exponent. The power function is undefined if the base is zero and the exponent is negative. However, the behavior depends on the platform in this case.

Syntax:

EXPT(<base>, <exponent>)
Permitted data types for the input values: Numeric base data types (SINT, USINT, INT, UINT, DINT, UDINT, LINT, ULINT, REAL, LREAL, BYTE, WORD, DWORD, and LWORD)

Permitted data types for the return value: Floating-point number types (REAL and LREAL)

Example
Power function with literals
Var1 := EXPT(7,2);
FBD:

Return value: Var1 = 49

Example
Power function with variables
PROGRAM PLC_PRG
VAR
  lrPow : LREAL;
  iBase : INT := 2;
  iExponent : INT := 7;
END_VAR

  lrPow := EXPT(iBase, iExponent);
Return value: lrPow = 128

Operator 'SIN'
The IEC operator yields the sine value of a number.
Permitted data types for input variables that measure the angle in radians: any numeric basic data type
Permitted data types for output variable: REAL and LREAL

The permitted range for the input value is -2^{63} to +2^{63}. On x86 and x64 systems:
If the input value is outside of the permitted range, the function returns the input value

Examples
Result in q: 0.479426
ST:
  q := SIN (0.5);
FBD:

Operator 'COS'
The IEC operator yields the cosine value of a number.
Permitted data types for input variables that measure the angle in radians: any numeric basic data type
Permitted data types for output variables: REAL and LREAL

The permitted range for the input value is \(-2^{63}\) to \(+2^{63}\). On x86 and x64 systems: If the input value is outside of the permitted range, the function returns the input value

### Examples

**Result in q: 0.877583**
```
ST:
q := COS(0.5);
```
```
FBD:
```

### Operator 'TAN'

This IEC operator yields the tangent value of a number.
Permitted data types for input variables that measure the angle in radians: any numeric basic data type
Permitted data types for output variables: REAL and LREAL

**Result in q: 0.546302**
```
ST:
q := TAN(0.5);
```
```
FBD:
```

### Operator 'ASIN'

This IEC operator yields the arcsine value of a number.
Permitted data types for input variables: any numeric basic data type
Permitted data types for output variables: REAL and LREAL

**Result in q: 0.523599**
```
ST:
q := ASIN(0.5);
```
```
FBD:
```
Operator 'ACOS'

This IEC operator yields the arccosine value of a number. The value is computed in radians.
Permitted data types for input variables that measure the angle in radians: any numeric basic data type
Permitted data types for output variables: REAL and LREAL

Examples
Result in q: 1.0472

ST:
q := ACOS(0.5);

FBD:

---

Operator 'ATAN'

This IEC operator yields the arctangent value of a number. The value is computed in radians.
Permitted data types for input variables that measure the angle in radians: any numeric basic data type
Permitted data types for output variables: REAL and LREAL

Examples
Result in q: 0.463648

ST:
q := ATAN(0.5);

FBD:

---

Operator '__DELETE'

This operator is an extension of the IEC 61131-3 standard.

NOTICE!
For compatibility, the compiler version must be >= 3.3.2.0.

The operator releases the memory of instances that the "__NEW" operator generated dynamically. The __DELETE operator does not have a return value and the operand is set to zero after this operation.

Requirement: In the properties dialog of the application, the “Use dynamic memory allocation” check box is selected in the “Application Build Options” tab.

__DELETE (<pointer>)
NOTICE!

Two tasks should not call __DELETE simultaneously. Either you use a semaphore (SysSemEnter) or comparable method to prevent any concurrent calling of __DELETE, or you use __DELETE in one tasks only (recommended).

You can use a semaphore (SysSemEnter) to prevent two tasks from allocating memory at the same time. As a consequence, the extensive use of __DELETE causes higher jitter.

If Pointer references a function block, then CODESYS calls the associated FB_EXIT method before the pointer is set to zero.
FUNCTION_BLOCK FBDynamic

VAR_INPUT
  in1, in2 : INT;
END_VAR

VAR_OUTPUT
  out : INT;
END_VAR

VAR
  test1 : INT := 1234;
  _inc : INT := 0;
  _dut : POINTER TO DUT;
  neu : BOOL;
END_VAR

out := in1 + in2;

METHOD FB_Exit : BOOL

VAR_INPUT
  bInCopyCode : BOOL;
END_VAR

__Delete(_dut);

METHOD FB_Init : BOOL

VAR_INPUT
  bInitRetains : BOOL;
  bInCopyCode : BOOL;
END_VAR

_dut := __NEW(DUT);

METHOD INC : INT

VAR_INPUT
END_VAR

_inc := _inc + 1;
INC := _inc;

PLC_PRG(PRG)

VAR
  pFB : POINTER TO FBDynamic;
  bInit: BOOL := TRUE;
  bDelete: BOOL;
  loc : INT;
END_VAR

IF (bInit) THEN
  pFB := __NEW(FBDynamic);
  bInit := FALSE;
END_IF
IF (pFB <> 0) THEN
  pFB^.(in1 := 1, in2 := loc, out => loc);
  pFB^.INC();
END_IF

IF (bDelete) THEN
  __DELETE(pFB);
END_IF

Operator '__ISVALIDREF'

This operator is an extension of the IEC 61131-3 standard.
The operator is used for checking whether a reference refers to a valid value. For a description of use and an example, refer to the description for the REFERENCE data type.

See also

● § Chapter 6.4.1.20.5.14 “Reference” on page 2245

Operator '__NEW'

The operator is an extension of the IEC 61131-3 standard.
The __NEW operator reserves dynamic memory to instantiate function blocks, user-defined data types, or arrays of standard types. The operator returns a matching typed pointer.

Requirement: In the properties dialog of the parent application, on the “Application Build Options” tab, the “Use dynamic memory allocation” option is selected.

Syntax

<pointer name> := __NEW( <type> ( , <size> )? );
__DELETE( <pointer name> );

<type>: <function block> | <data unit type> | <standard data type>

The operator generates an instance of the type <type> and returns a pointer to this instance. Then the initialization of the instance is called. If <type> is a scalar standard data type, then the optional operand <size> is also evaluated. Then the operator generates an array of type <standard data type> and size <size>. If the attempt to allocate memory fails, then __NEW returns the value 0.

Use the operator within the assignment ":=". Otherwise an error message is displayed.

A function block or a user-defined data type whose instance is created dynamically with __NEW uses a fixed memory area. Here it is required that you mark the objects with the pragma (attribute 'enable_dynamic_creation'). It is not required for function blocks that are part of a library.

If you change the data layout of the function block in online mode, then you cannot execute a login with an online change afterwards. This is because the memory area of the function block instance has been invalidated. You change the data layout when you add new variables to the function block, delete existing variables, or change the data types of variables.
PROGRAM PLC_PRG
VAR
  pdwScalar : POINTER TO DWORD; //Typed pointer
  xInit : BOOL := TRUE;
  xDelete : BOOL;
END_VAR

IF (xInit) THEN
  pdwScalar := __NEW(DWORD, 16); // Allocates memory (16 dwords)
  and assigns them to pointer pdwScalar
END_IF

IF (xDelete) THEN
  __DELETE(pdwScalar); // Frees memory of pointer
END_IF

FUNCTION_BLOCK FBComputeGamma
VAR_INPUT
  iAlpha : INT;
  iBeta : INT;
END_VAR
VAR_OUTPUT
  iGamma : INT;
END_VAR
VAR
END_VAR

iGamma := iAlpha + iBeta;

PROGRAM PLC_PRG
VAR
  pComputeGamma : POINTER TO FBComputeGamma; // Typed pointer
  xInit : BOOL := TRUE;
  xDelete : BOOL;
  iResult : INT;
END_VAR

IF (xInit) THEN
  pComputeGamma := __NEW(FBComputeGamma); // Allocates memory
  xInit := FALSE;
END_IF

pComputeGamma^.iAlpha := (pComputeGamma^.iAlpha + 1)MOD 100; // Sets first input of pComputeGamma
pComputeGamma^.iBeta := 10; // Sets second input of pComputeGamma
pComputeGamma^(); // Calls the FB pComputeGamma is pointing to
iResult := pComputeGamma^.iGamma; // Reads output of pComputeGamma
IF (xDelete) THEN
  __DELETE(pComputeGamma); // Frees memory
END_IF

TYPE ABCDATA :
  STRUCT
    iA, iB, iC, iD : INT;
  END_STRUCT
END_TYPE

PROGRAM PLC_PRG
VAR
  pABCDATA : POINTER TO ABCDATA; // Typed pointer
  xInit : BOOL := TRUE;
Array (BYTE):

PROGRAM PLC_PRG
VAR
   pbDataAlpha: POINTER TO BYTE;
   pbDataBeta: POINTER TO BYTE;
   xInit: BOOL := TRUE;
   xDelete: BOOL;
   usiCnt: USINT;
   bTestC: BYTE;
END_VAR

IF (xInit) THEN
   pbDataAlpha := __NEW(BYTE, 16); // Allocates 16 bytes for pbDataAlpha
   pbDataBeta := __NEW(BYTE); // Allocates memory for pbDataBeta
   xInit := FALSE;
   FOR usiCnt := 0 TO 15 DO
      pbDataAlpha[usiCnt] := usiCnt; // Writes to new array
   END_FOR
   pbDataBeta^:= 16#FF; // Writes to new data
END_IF

bTestC := pbDataAlpha[12]; // Reads new array by index access

IF (xDelete) THEN // Frees memory
   __DELETE(pbDataAlpha);
   __DELETE(pbDataBeta);
END_IF

NOTICE!
We do not recommend the simultaneous execution of two tasks that both call the __NEW operator. You use either a semaphore (SysSemEnter) or a comparable technique to prevent a concurrent call of __NEW. However, this results in a higher jitter when __NEW is applied extensively.

We recommend that you call __NEW operators in one task only.

See also
- Chapter 6.4.1.21.4.11.10 “Dialog ‘Properties - Application Build Options’” on page 2759
- Chapter 6.4.1.21.2.9 “Object ‘DUT’” on page 2461
- Chapter 6.4.1.21.2.21.3 “Object ‘Function Block’” on page 2479
- Chapter 6.4.1.20.6.3.13 “Attribute ‘enable_dynamic_creation’” on page 2281
- Chapter 6.4.1.20.11.159 “Compiler error C0509” on page 2403
**Operator '__QUERYINTERFACE'**

This operator is an extension of the IEC 61131-3 standard.

At runtime, the operator executes a type conversion of an interface reference into another type. The operator returns a `BOOL` result. `TRUE` means that CODESYS has performed the conversion successfully.

`__QUERYINTERFACE(<ITF_Source>,<ITF_Dest>);`

1. Operand: Interface reference or FB interface
2. Operand: Interface reference with required target type

The requirement for the explicit conversion is that both the ITF_Source and ITF_Dest are derived from `Interface __System.IQueryInterface`. This interface is implicitly available does not require a library.
Example

INTERFACE ItfBase EXTENDS __System.IQueryInterface
METHOD mbase : BOOL
END_METHOD

INTERFACE ItfDerived1 EXTENDS ItfBase
METHOD mderived1 : BOOL
END_METHOD

INTERFACE ItfDerived2 EXTENDS ItfBase
METHOD mderived2 : BOOL
END_METHOD

FUNCTION_BLOCK FB1 IMPLEMENTS ItfDerived1
METHOD mbase : BOOL
  mbase := TRUE;
END_METHOD
METHOD mderived1 : BOOL
  mderived1 := TRUE;
END_METHOD
END_FUNCTION_BLOCK

FUNCTION_BLOCK FB2 IMPLEMENTS ItfDerived2
METHOD mbase : BOOL
  mbase := FALSE;
END_METHOD
METHOD mderived2 : BOOL
  mderived2 := TRUE;
END_METHOD
END_FUNCTION_BLOCK

PROGRAMM POU
VAR
  inst1 : FB1;
  inst2 : FB2;
  itfbase1 : ItfBase := inst1;
  itfbase2 : ItfBase := inst2;
  itfderived1 : ItfDerived1 := 0;
  itfderived2 : ItfDerived2 := 0;
  xResult1, xResult2, xResult3, xResult4: BOOL;
END_VAR

xResult1 := __QUERYINTERFACE(itfbase1, itfderived1); // xResult = TRUE, itfderived1 <> 0  // references the instance inst1
xResult2 := __QUERYINTERFACE(itfbase1, itfderived2); // xResult = FALSE, itfderived2 = 0
xResult3 := __QUERYINTERFACE(itfbase2, itfderived1); // xResult = FALSE, itfderived1 = 0
xResult4 := __QUERYINTERFACE(itfbase2, itfderived2); // xResult = TRUE, itfderived2 <> 0  // references the instance inst2

Operator '__QUERYPOINTER'
This operator is an extension of the IEC 61131-3 standard.
At runtime, the operator makes it possible to convert the type of an interface reference of a function block to a pointer. The operator returns a BOOL result. TRUE means that CODESYS has performed the conversion successfully.

**NOTICE!**

For compatibility, the definition of the pointer to be converted must be an extension of the base interface "__SYSTEM.IQueryInterface".

```__QUERYPOINTER (<ITF_Source>, <Pointer_Dest>)```

The operator receives an interface reference or a FB instance with the required target types as the first operand and a pointer as the second operand. After processing `__QUERYPOINTER`, Pointer_Dest receives the pointer to the reference or instance of a function block that the ITF_Source interface reference currently refers to. Pointer_Dest is not typed and can be cast to any type. You have to make sure of the type. For example, the interface could offer a method that returns a type code.

### Operators '__TRY', '__CATCH', '__FINALLY', '__ENDTRY'

These operators are extended from the IEC 61131-3 standard and they are used for specific exception handling in IEC code.

**Syntax**

```__TRY
    <statements_try>
__CATCH(exec)
    <statements_catch>
__FINALLY
    <statements_finally>
__ENDTRY
    <statements_next>```

When a statement in the __Try operator throws an exception, the application does not stop. Instead, the application executes the statements in __Catch, starts the exception handling, and then executes the statements in __FINALLY. The exception handling ends with __ENDTRY, and the application executes the subsequent statements.

An IEC variable for an exception has the data type __System.ExceptionCode.
If the statement in \_TRY throws an exception, then program execution is not stopped. Instead, the statement in \_CATCH is executed. Therefore, in this example, the application executes the \texttt{exc} function, then the statement in \_FINALLY, and finally the statement in \_ENDTRY.

```plaintext
FUNCTION Tester : UDINT
VAR_INPUT
  count : UDINT;
END_VAR
VAR_OUTPUT
  strExceptionText : STRING;
END_VAR
VAR
  exc : __SYSTEM.ExceptionCode;
END_VAR
TRY
  Tester := tryFun(count := count, testcase := g_testcase);  // This statement is tested. If it throws an exception, then the statement in \_CATCH is executed first, and then the statement in \_FINALLY.
  \_CATCH(exc)
  HandleException(exc, strExceptionText => strExceptionText);
  \_FINALLY
  GVL.g_count := GVL.g_count + 2;
ENDTRY
```

See also
- § Chapter 6.4.1.21.3.7.19 “Command 'Stop Execution on Handled Exceptions'” on page 2639

### Data Type '\_System.ExceptionCode'

```plaintext
TYPE ExceptionCode :
  (RTSEXCPT_UNKNOWN := 16#FFFFFFFF,
   RTSEXCPT_NOEXCEPTION := 16#00000000,
   RTSEXCPT_WATCHDOG := 16#00000010,
   RTSEXCPT_HARDWAREWATCHDOG := 16#00000011,
   RTSEXCPT_IO_CONFIG_ERROR := 16#00000012,
   RTSEXCPT_PROGRAMCHECKSUM := 16#00000013,
   RTSEXCPT_FIELDBUS_ERROR := 16#00000014,
   RTSEXCPT_IOUPDATE_ERROR := 16#00000015,
   RTSEXCPT_CYCLE_TIME_EXCEED := 16#00000016,
   RTSEXCPT_ONLCHANGE_PROGRAM_EXCEEDED := 16#00000017,
   RTSEXCPT_UNRESOLVED_EXTREFS := 16#00000018,
   RTSEXCPT_DOWNLOAD_REJECTED := 16#00000019,
   RTSEXCPT_BOOTPROJECT_REJECTED_DUE_RETAIN_ERROR := 16#0000001A,
   RTSEXCPT_LOADBOOTPROJECT_FAILED := 16#0000001B,
   RTSEXCPT_OUT_OF_MEMORY := 16#0000001C,
   RTSEXCPT_RETAIN_MEMORY_ERROR := 16#0000001D,
   RTSEXCPT_BOOTPROJECT_CRASH := 16#0000001E,
   RTSEXCPT_BOOTPROJECTTARGETMISMATCH := 16#00000021,
   RTSEXCPT_SCHEDULEERROR := 16#00000022,
   RTSEXCPT_FILE_CHECKSUM_ERR := 16#00000023,
   RTSEXCPT_RETAIN_IDENTITY_MISMATCH := 16#00000024,
   RTSEXCPT_IEC_TASK_CONFIG_ERROR := 16#00000025,
   RTSEXCPT_APP_TARGET_MISMATCH := 16#00000026,
   RTSEXCPT_ILLEGAL_INSTRUCTION := 16#00000050,
   RTSEXCPT_ACCESS_VIOLATION := 16#00000051,
```
RTSEXCPT_PRIV_INSTRUCTION := 16#00000052,
RTSEXCPT_IN_PAGE_ERROR := 16#00000053,
RTSEXCPT_STACK_OVERFLOW := 16#00000054,
RTSEXCPT_INVALID_DISPOSITION := 16#00000055,
RTSEXCPT_INVALID_HANDLE := 16#00000056,
RTSEXCPT_GUARD_PAGE := 16#00000057,
RTSEXCPT_DOUBLE_FAULT := 16#00000058,
RTSEXCPT_INVALID_OPCODE := 16#00000059,
RTSEXCPT_MISALIGNMENT := 16#000000100,
RTSEXCPT_ARRAYBOUNDS := 16#000000101,
RTSEXCPT_DIVIDEBYZERO := 16#000000102,
RTSEXCPT_OVERFLOW := 16#000000103,
RTSEXCPT_NONCONTINUABLE := 16#000000104,
RTSEXCPT_PROCESSORLOAD_WATCHDOG := 16#000000105,
RTSEXCPT_FPU_ERROR := 16#000000150,
RTSEXCPT_FPU_DENORMAL_OPERAND := 16#000000151,
RTSEXCPT_FPU_DIVIDEBYZERO := 16#000000152,
RTSEXCPT_FPU_INEXACT_RESULT := 16#000000153,
RTSEXCPT_FPU_INVALID_OPERATION := 16#000000154,
RTSEXCPT_FPU_OVERFLOW := 16#000000155,
RTSEXCPT_FPU_STACK_CHECK := 16#000000156,
RTSEXCPT_FPU_UNDERFLOW := 16#000000157,
RTSEXCPT_VENDOR_EXCEPTION_BASE := 16#00002000
RTSEXCPT_USER_EXCEPTION_BASE := 16#00010000
) UDINT ;
END_TYPE

Operator '__VARINFO'

This operator is an extension of the IEC 61131-3 standard.

The operator yields information about a variable. You can save the information as data structure in a variable of data type __SYSTEM.VAR_INFO.

Syntax in the declaration:

<name of the info variable> : __SYSTEM.VAR_INFO; // Data structure for info variable

Syntax for the call:

<name of the info variable> := __VARINFO( <variable name> ); // Call of the operator
FUNCTION_BLOCK FB_Velocity
VAR_INPUT
  rVelocity: REAL := 1.2;
END_VAR
VAR_OUTPUT
END_VAR
VAR
  infoVelocity: __SYSTEM.VAR_INFO; // Info of Velocity
END_VAR

infoVelocity := __VARINFO(rVelocity); // Gets the info of Velocity locally

PROGRAM PLC_PRG
VAR
  iCounter : INT := 0; // Counts the calls
  infoCounter : __SYSTEM.VAR_INFO; // Info of Counter
  arrA : ARRAY [1..2, 1..2, 1..2] OF INT := [0, 1, 2, 3, 4, 5, 6, 7]; // Stores the A data
  infoA : __SYSTEM.VAR_INFO; // Info of A
  fbVel : FB_Velocity;
END_VAR

iCounter := iCounter + 1;
infoCounter := __VARINFO(iCounter);
infoA := __VARINFO(arrA);
fbVel();

The iCounter and arrA variables are recognized in the application code. The variable information is saved in the infoCounter and infoA variables. Moreover, the FB_Velocity function block is instantiated.

<table>
<thead>
<tr>
<th>Name</th>
<th>Data type</th>
<th>Initialization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ByteAddress</td>
<td>DWORD</td>
<td>0</td>
<td>Address of the variable &lt;variable name&gt;, Example: 16#072E35EC</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Note: For bit access of a variable &lt;variable name&gt;.&lt;bit index&gt;, the address of the variable that contains the bit is given.</td>
</tr>
<tr>
<td>ByteOffset</td>
<td>DWORD</td>
<td>0</td>
<td>Offset of the variable address (in bytes). Example: 13936 bytes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Note: If the variable is global, then the offset is relative to the beginning of the area. If the variable is a local variable in a function or method, then the offset is relative to the current stack frame. If the variable is a local variable in a function block, then the offset is relative to the function block instance.</td>
</tr>
<tr>
<td>Name</td>
<td>Data type</td>
<td>Initialization</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------</td>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Area</td>
<td>DINT</td>
<td>0</td>
<td>Memory area number <code>Area</code> in the runtime system. Example: <code>-1</code>: Means that the variable is not global in the memory, but relative to an instance or on the stack. Note: The memory areas are device-dependent.</td>
</tr>
<tr>
<td>BitNr</td>
<td>INT</td>
<td>0</td>
<td>Number of bits (in bytes) Example: <code>16#00FF</code> bytes. Note: If the variable is not an integer data type, then: <code>BitNr = -1 = 16#FFFF</code>.</td>
</tr>
<tr>
<td>BitSize</td>
<td>INT</td>
<td>0</td>
<td>Memory size of the variable (in bits) Example: 16 bits</td>
</tr>
<tr>
<td>BitAddress</td>
<td>UDINT</td>
<td>0</td>
<td>Bit address of the variable Requirement: The variable is located in the input memory area <code>I</code>, output memory area <code>Q</code>, or marker memory area <code>M</code>. Otherwise the value is undefined.</td>
</tr>
<tr>
<td>TypeClass</td>
<td>TYPE_CLASS</td>
<td>TYPE_BOOL</td>
<td>Data type class of the variable Example: <code>TYPE_INT, TYPE_ARRAY</code> Note: For user-defined data types or function block instances, <code>TYPE_USERDEF</code> is output as the data type class.</td>
</tr>
<tr>
<td>TypeName</td>
<td>STRING(79)</td>
<td>&quot;</td>
<td>Date type name of the variable as <code>STRING(79)</code> Note: For user-defined data types, the function block name or the DUT name is output. Example: 'INT', 'ARRAY'</td>
</tr>
<tr>
<td>NumElements</td>
<td>UDINT</td>
<td>0</td>
<td>Number of array elements Requirement: The variable has the data type <code>ARRAY</code>. Example: 8</td>
</tr>
<tr>
<td>BaseTypeClass</td>
<td>TYPE_CLASS</td>
<td>TYPE_BOOL</td>
<td>Elementary basic data type of the array elements. Requirement: The variable has the data type <code>ARRAY</code>. Example: <code>TYPE_INT</code> for <code>arrA : ARRAY [1..2,1..2,1..2] OF INT;</code></td>
</tr>
<tr>
<td>ElemBitSize</td>
<td>UDINT</td>
<td>0</td>
<td>Memory size of the array element (in bits) Requirement: The variable has the data type <code>ARRAY</code>. Example: 16 bits for <code>arrA : ARRAY [1..2,1..2,1..2] OF INT;</code></td>
</tr>
<tr>
<td>Name</td>
<td>Data type</td>
<td>Initialization</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------</td>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>MemoryArea</td>
<td>MEMORY_AREA</td>
<td>MEM_MEMORY</td>
<td>Information about the memory area</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- MEM_GLOBAL: Global memory area</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>For example in Area 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- MEM_LOCAL: Local memory area</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>in Area -1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- MEM_MEMORY: Marker memory area %M</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>For example in 16#10 in Area 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- MEM_INPUT: Input memory area %I</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>For example in 16#04 in Area 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- MEM_OUTPUT: Output memory area %Q</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>For example in 16#08 in Area 3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- MEM_RETAIN: Retain memory area</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>For example in 16#20 in Area 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Example: MEM_GLOBAL</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Note: The memory area configuration is device-dependent.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Symbol</th>
<th>STRING(39)</th>
<th>&quot;&quot;</th>
<th>Variable name as STRING(39)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Example: 'iCounter', 'arrA'</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Comment</th>
<th>STRING(79)</th>
<th>&quot;&quot;</th>
<th>Comment of the variable declaration</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Example: 'Counts the calls' or 'Stores the A data'</td>
</tr>
</tbody>
</table>

**Operator '__CURRENTTASK'**

This operator is an extension of the IEC 61131-3 standard.

In runtime mode, the operator provides information about the IEC task that is currently running.

*The operator is supported only on target systems in which the target system setting memory-layout\max-stack-size is set to a value > 0.*

The operator allows for access to a structure with two variables:

- TaskIndex: Zero-based index that identifies the task
- pTaskInfo: Detailed information about the currently running task. It can be assigned to a POINTER TO Task_Info2 from the library CmpIecTask.

The operator cannot be used in the declaration of a POU. This would result in an error message. If the current task cannot be determined, then the TaskIndex -1 and the pTaskInfo are zero.
**Example**

```plaintext
//Declaration
VAR
    idx : INT;
    pInfo : POINTER TO Task_Info2;
END_VAR

//Program code
idx := __CURRENTTASK.TaskIndex;
pInfo := __CURRENTTASK.pTaskInfo;
```

**Operator '__COMPARE_AND_SWAP'**

The multicore operator is an extension of the IEC 61131-3 standard.

The operator can be used for implementing a semaphore, for example to guarantee exclusive access to a variable written to by different tasks.

__COMPARE_AND_SWAP gets a pointer to a data type __XWORD variable, an old value, and a new value as its input (example: bMutex := __COMPARE_AND_SWAP(ADR(dwSynch), dwOld, dwNew);). The old and new values can also be data type __XWORD variables. The referenced __XWORD variable is compared with the old value and if both are equal, then the new value is written. The result of the function is TRUE when the new value could be written.

The compiler automatically replaces the data type __XWORD with DWORD on 32-bit systems and LWORD on 64-bit systems.

This operation is atomic, so it cannot be interrupted by another task, even on multicore platforms.
**Example**

The following example shows a typical usage. Exclusive access to a type STRING variable, which is addressed via the pstrOutput pointer, should be implemented.

The access to a string is not atomic. If multiple tasks write to the same string at the same time, then the contents may be inconsistent.

With this function, it is now possible to write the same STRING variable in different tasks.

```pascal
FUNCTION ExclusiveStringWrite : BOOL
VAR_INPUT
    strToWrite : STRING;
    pstrOutput : POINTER TO STRING;
END_VAR
VAR_STAT
    dwSynch : __XWORD;
END_VAR
VAR
    bMutex : BOOL;
END_VAR

bMutex := __COMPARE_AND_SWAP(ADR(dwSynch), 0, 1); (* compare with 0 and write 1 as atomic operation *)
IF bMutex THEN // bMutex is TRUE if write could be done
    pstrOutput^ := strToWrite; // Now you can write safely on the string
    dwSynch := 0; // The __XWORD variable must be reset.
    ExclusiveStringWrite := TRUE; // Writing was successful
ELSE
    ExclusiveStringWrite := FALSE; // Writing was not successful
END_IF
```

See also

- ☼ “Multicore operators” on page 2133
- ☼ Chapter 6.4.1.20.3.69 “Operator ‘TEST_AND_SET’” on page 2215

**Operator '__XADD'**

The multicore operator is an extension of the IEC 61131-3 standard.

The operator can be used for implementing an atomic counter. If an integer variable is incremented by means of ordinary addition, for example iTest := iTest + 1;, then this operation is not executed atomically. Another access to the variable could take place between reading and writing the variable.

If the counter is incremented in multiple tasks, then the counter result can be less than the number of counting cycles. So if two tasks execute the above code one time and the variable previously had the value 0, then the variable can then have the value 1. This is especially problematic if arrays are being processed in multiple tasks and a unique index is required for the array in each processing cycle.

When the __XADD operator is called, it gets a pointer to a type DINT variable as the first summand and a type DINT value as the second summand. __XADD returns the old value of the first summand and in the same step adds the second summand to the first summand.

For example, the function call can look like this: diOld := __XADD(ADR(diVar), deAdd);
The following example shows a typical usage. An array should be populated from two tasks. In the process, all positions in the array should be used and no position should be overwritten.

With this function, multiple tasks can populate a Boolean array.

```plaintext
FUNCTION WriteToNextArrayPosition : BOOL
VAR_EXTERNAL
  g_diIndex : DINT;  // Index and array are globally defined and used by multiple tasks
  g_boolArray : ARRAY [0..1000] OF BOOL;
END_VAR
VAR_INPUT
  bToWrite : BOOL;
END_VAR
VAR
  diIndex : DWORD;
END_VAR

diIndex := __XADD(ADR(g_diIndex), 1);        // Returns a unique index
WriteToNextArrayPosition := FALSE;
IF (diIndex >= 0 AND diIndex <= 1000) THEN
  g_boolArray[diIndex] := bToWrite;         //Writes to unique index
  WriteToNextArrayPosition := TRUE;         // TRUE: Array was not full yet
END_IF
```

Example

See also

- "Multicore operators" on page 2133

Operator '__POSITION'

The operator is an extension of the IEC 61131-1 standard.

At runtime, the operator yields the position of a variable in the declaration part or in the implementation part of a POU. The operator has to be assigned the variables of type STRING in the declaration part or in the implementation part.

Result of __POSITION

- **Declaration part**: 'Line <line number> (Decl)'
- **Implementation part**: 'Line <line number>, Column <column number> (Impl)'

Example

```plaintext
PROGRAM PROG1
VAR
  strPOS : STRING := __POSITION();  //Yields the line number of this declaration
  strLocalPOS : STRING;
END_VAR

  strLocalPOS := __POSITION();  //Yields the line and column number of this assignment
```

Operator '__POUNAME'

The operator is an extension of the IEC 61131-1 standard.
At runtime, the operator yields the name of the POU that contains the operator `__POUNAME`. The result is of type `STRING`.

The result of `__POUNAME` depends where it is used:

- In a program: program name
- In a function name: function name
- In a function block: function block name
- In a method: the method name qualified with the FB name
- In a Get/Set accessor of a property: the property name + Get/Set qualified with the FB name
- In a GVL: GVL name
- In a structure: structure name
- In a data structure `UNION`: union name

### Example

```plaintext
PROGRAM PROG1
VAR
    strPOU : STRING := __POUNAME(); //Yields 'PROG1'
    strlocalPOU : STRING;
END_VAR
strlocalPOU := __POUNAME(); //Yields 'PROG1'
```

### Operator `TEST_AND_SET`

The multicore operator is an extension of the IEC 61131-3 standard.

The operator can be used for implementing a semaphore, for example to guarantee exclusive access to a variable written to by different tasks.

`TEST_AND_SET` gets a type `DWORD` variable as its input. Write access to this variable must be possible. The variable is set to `1` and the previous value is returned as the result.

The operation is atomic, which means that it cannot be interrupted by another task. This also applies to multicore platforms.

For example, the call in the program is `dwOldValue := TEST_AND_SET(dw);`, in which the variables `dwOldValue` and `dw` must be of data type `DWORD`. 
Example

The following example shows a typical usage. Exclusive access to a type STRING variable, which is addressed via the pstrOutput pointer, should be implemented. The access to a string is not atomic. If multiple tasks write to the same string at the same time, then the contents may be inconsistent. With the TEST_AND_SET function, it is now possible to write the same STRING variable in different tasks.

```plaintext
FUNCTION ExclusiveStringWrite : BOOL
VAR_INPUT
    strToWrite : STRING;
    pstrOutput : POINTER TO STRING;
END_VAR
VAR_STAT
    dwSynch : DWORD;
END_VAR
VAR
    dwOldValue: DWORD;
END_VAR

dwOldValue := TEST_AND_SET(dwSynch);  // Write the 1 and read the old value at the same time
IF dwOldValue = 0 THEN                // 0 means: no other task is currently writing
    pstrOutput^ := strToWrite;         // Now you can write safely on the string
    dwSynch := 0;                      // The DWORD must be reset
    ExclusiveStringWrite := TRUE;      // Writing was successful
ELSE
    ExclusiveStringWrite := FALSE;     // Writing was not successful
```

See also
- Chapter 6.4.1.20.3.65 “Operator '__COMPARE_AND_SWAP” on page 2212
- “Multicore operators” on page 2133

Operator - Global namespace

This operator is an extension of the IEC 61131-3 standard.

An instance path that begins with a dot (.) always opens a global namespace. If there is a local variable that has the same name <varname> as a global variable, then you refer to the global variable as .<varname>.

Operator - Namespace for global variables lists

This operator is an extension of the IEC 61131-3 standard.

You can use the name of a global variables list (GVL) as a namespace identifier for the variables that are defined in the list. This makes it possible to use variables with the same name in different global variables lists and still access specific variables uniquely. You use a dot (.) to prepend the name of the global variables list to the variable name.

<global variable list name>.<variable>

Example

```plaintext
globlist1.varx := globlist2.varx;
```

The globlist1 and globlist2 global variables lists each contain a varx variable. CODESYS copies the varx global variable from the globlist2 list to varx in the globlist1 list.
If you reference a variable that is declared in several global variables lists without referencing the prepended list name, then an error message is printed.

**Operator - Library namespace**

This operator is an extension of the IEC 61131-3 standard.

**Syntax:** `<library namespace>..<library identifier>`

**Example:** `LIB_A.FB_A`

A library module identifier is appended with the library namespace (as a prefix separated by a dot) for unique and qualified access to the library module. The namespace usually coincides with the library name.

**Example**

A library is included in a project and contains the module `FB_A`. However, the function block with the same name is already available locally in the project. Identify the library module as `LIB_A.FB_A` in order to access the library module, not the local function block.

```plaintext
var1 := FB_A(in := 12); // Call of the project function FB_A
var2 := LIB_A.FB_A(in := 22); // Call of the library function FB_A
```

You can define another identifier for the namespace. To do this, specify a namespace in the project information (library developers: when creating a library project). As an alternative, you can specify a specific namespace for a library in the library manager in the "Properties" dialog box (application developers: when creating an application).

**See also**

- Chapter 6.4.1.17 “Using Libraries” on page 2034
- Chapter 6.4.1.21.3.15.4 “Command 'Placeholders’” on page 2716
- Chapter 6.4.1.21.2.16 “Object 'Library Manager’” on page 2469

**Operator - Enumeration namespace**

This operator is an extension of the IEC 61131-3 standard.

You can use the TYPE name of an enumeration for unique access to an enumeration constant. In this way, you can use the same constant names in different enumerations.

The enumeration name is prepended to the constant name with a dot (.)

```plaintext
<enumeration name>..<constant name>
```

**Example**

The constant `Blue` is a component of both the enumeration `Colors` and the enumeration `Feelings`.

```plaintext
color := Colors.Blue; // Access to component blue in enumeration Colors
feeling := Feelings.Blue; // Access to component blue in enumeration Feelings
```

**Operator '__POOL'**

The operator is an extension of the IEC 61131-3 standard.

The operator is used to reference objects which are managed in the global POU pool (in the “POUs” view). The operator directly accesses objects in the “POUs” view.
Example

PROGRAM PLC_PRG
VAR
    svar_pou : STRING;
END_VAR
    svar_pou := __POOL.POU();

See also

- % Chapter 6.4.1.20.8 “Shadowing Rules” on page 2333

Operator 'INI'

The INI operator is a CoDeSys V2.3 operator. In CODESYS V3, the FB_init method replaces the INI operator. You can still use this operator in projects that are imported from CoDeSys V2.3.

The INI operator is used for initializing retain variables of a function block instance used in a POU.

Assign the operator to a Boolean variable.

Syntax:

<Boolean variable name> := INI <FB instance name> , <Boolean value> );
<Boolean value> : TRUE | FALSE

If the second parameter of the operator yields TRUE, then CODESYS initializes all retain variables that are defined in the function block <FB instance name>.

Examples

fbinst is the instance of the function block fb1, where the retain variable retvar is defined.

ST:

Declaration in the block:

VAR
    fbinst : fb1;
    b : BOOL;
END_VAR

Program part:

b := INI(fbinst, TRUE);
ivar := fbinst.retvar; (* => retvar is initialized *)

FBD

See also

- % Chapter 6.4.1.20.10 “Methods 'FB_Init', 'FB_Reinit', and 'FB_Exit’” on page 2336
- % Chapter 6.4.1.9.19 “Data Persistence” on page 1920
6.4.1.20.4 Operands

General

Constants and literals

Constants are identifiers for unchangeable values. You can declare constants locally within a POU or globally within a global variable list. The declaration segment is extended with the keyword CONSTANT.

Constants are also character strings that represent the value of a base type, such as integers or floating-point numbers (for example, 16#FFFF_FFFF, T#5s, -1.234 E-5). To distinguish between them, these constants are also called literals, literal constants, or unnamed constants.

There are logical (TRUE, FALSE) or numeric literals (3.1415, T#5s), but also character string literals ('Hello world!', "black").

Syntax declaration

```
<scope> CONSTANT
    <identifier> : <data type> := <initial value> ;
END_VAR
```

```
<scope> : VAR | VAR_INPUT | VAR_STAT | VAR_GLOBAL
<data type>: <elementary data type | user defined data type | function block >
<initial value> : literal value | identifier | expression
```

Allowed initial values:

- Literal (example: TRUE, FALSE, 16#FFFF_FFFF)
- Named constant that was declared at another location
- Simple expression composed of literals, also combined with simple operators, such as +-*

Inputs or function calls cannot be specified as an initial value.

Example

```
VAR_GLOBAL CONSTANT
    g_ciMAX_A : INT := 100;
    g_ciSPECIAL : INT := g_ciMAX_A - 10;
END_VAR
```

Constants are defined only for the declaration. The assignment of an initial value is required. Within an implementation, constants are only read and therefore always appear on the right of the assignment operator in a statement.

The constants are replaced with the initial value when the code is compiled. It also has to be possible to calculate the initial value at compile time.

Constants of structured or user-defined types are calculated not until runtime. Structured constants in programs or GVLs are calculated one time at program start. Structured constants in functions or methods are calculated every time the function or method is called. Therefore, the initialization of structured constants can depend on inputs or execute function calls.

See also

- Chapter 6.4.1.20.4.2 “BOOL constants” on page 2220
- Chapter 6.4.1.20.4.3 “Numeric constants” on page 2220
- Chapter 6.4.1.20.4.4 “REAL/LREAL constants” on page 2221
- Chapter 6.4.1.20.4.5 “String Constants” on page 2221
- Chapter 6.4.1.20.4.8 "Date and Time Constants" on page 2225
- Chapter 6.4.1.20.4.7 "TIME/LTIME Constant" on page 2223
- Chapter 6.4.1.20.4.9 “Typed literals” on page 2228

Variables

You can declare variables as either local in the declaration part of a POU or in a global variable list. The allowed location of a variable depends on its data type.
See also

- § Chapter 6.4.1.20.4.10 “Access to Variables in Arrays, Structures, and Blocks” on page 2228
- § Chapter 6.4.1.20.4.11 “Bit Access in Variables” on page 2229

Other

- § Chapter 6.4.1.20.4.12 “Addresses” on page 2231
- § Chapter 6.4.1.20.4.13 “Functions” on page 2233

- § Chapter 6.4.1.9.4 “Declaration of Variables” on page 1847
- § Chapter 6.4.1.9.7 “Using input assistance” on page 1885
- § Chapter 6.4.1.20.2.12 “Constant Variables - ‘CONSTANT’” on page 2121
- § Chapter 6.4.1.20.1.4.3 “ST expressions” on page 2050

### BOOL constants

BOOL constants are the truth values TRUE (1) and FALSE (0).

See also

- § Chapter 6.4.1.20.5.2 “Data type ‘BOOL’” on page 2235

### Numeric constants

Numeric values can be binary, octal, decimal, and hexadecimal numbers. If an integer value is not a decimal number, then you must write its base followed by the number sign (#) before the integer constant. You enter the hexadecimal digit values for the numbers 10 to 15 as usual with the letters A-F.

You can use an underscore within a numeric value.

<table>
<thead>
<tr>
<th>Examples:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>14</td>
<td>decimal number</td>
</tr>
<tr>
<td>#1001_0011</td>
<td>binary number</td>
</tr>
<tr>
<td>8#67</td>
<td>octal number</td>
</tr>
<tr>
<td>16#A</td>
<td>hexadecimal number</td>
</tr>
<tr>
<td>DINT#16#A1</td>
<td>typed data type DINT# and base 16# combined</td>
</tr>
</tbody>
</table>

This type of numeric value can be BYTE, WORD, DWORD, SINT, USINT, INT, UINT, DINT, UDINT, REAL, or LREAL.

Implicit conversions from “larger” to “smaller” types are not permitted. You cannot simply use a DINT variable as an INT variable. For this, you have to use a type conversion function.

See also

- § Chapter 6.4.1.20.3 “Operators” on page 2129
- § Chapter 6.4.1.20.4.9 “Typed literals” on page 2228
As number constants basically are treated as integers, in divisions you must enter a constant in the format of a floating-point number in order not to loose the remainder. For example: Division \( \frac{1}{10} \) results in 0, division \( \frac{1.0}{10} \) results in 0.1.

REAL/LREAL constants

You can specify floating-point numbers as REAL and LREAL constants either in decimal notation or exponential notation with mantissa and exponent. The decimal point serves as the decimal separator according to the International System of Units (English).

Syntax of exponential notation

\[
\text{<significand>} \ e \ | \ E \ \text{<exponent>}
\]

exponent : -44..38 // REAL
exponent : -324..308 // LREAL

Example

<table>
<thead>
<tr>
<th>Table 395: REAL literal</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.4</td>
</tr>
<tr>
<td>1/3.0</td>
</tr>
<tr>
<td>Note: In the case of division of integer types, the result remains an integer type. In this case, the value is rounded. For example, ( \frac{1}{3} ) yields 0 as the result.</td>
</tr>
<tr>
<td>1.64e+009</td>
</tr>
<tr>
<td>-3.402823e+38</td>
</tr>
<tr>
<td>-1E-44</td>
</tr>
<tr>
<td>1.0E-44</td>
</tr>
<tr>
<td>3.402823e+38</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 396: LREAL literal</th>
</tr>
</thead>
<tbody>
<tr>
<td>-1.7976931348623157E+308</td>
</tr>
<tr>
<td>-4.94065645841247E-324</td>
</tr>
<tr>
<td>4.94065645841247E-324</td>
</tr>
<tr>
<td>1.7976931348623157E+308</td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.1.20.5.4 “Data type ‘REAL’ / ‘LREAL’” on page 2236

String Constants

A string constant is a character string enclosed in single straight quotation marks. The characters are coded according to the character set specified in ISO/IEC 8859-1. Therefore, a string constant can include spaces and accented characters, as these belong to this character set. This is also referred to as a string literal, or simply a string.
Example: 'Hello world!'

When a dollar sign ($) is in a string constant, the following two characters are interpreted as a hexadecimal code according to the coding in ISO/IEC 8859-1. The code also corresponds to ASCII code. In addition, please note the special cases.

**Table 397: Hexadecimal code**

<table>
<thead>
<tr>
<th>String with $ code</th>
<th>Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>'$&lt;8-bit code&gt;'</td>
<td>8-bit code: Two-digit hexadecimal number that is interpreted according to ISO/IEC 8859-1.</td>
</tr>
<tr>
<td>'$41'</td>
<td>A</td>
</tr>
<tr>
<td>'$A9'</td>
<td>©</td>
</tr>
<tr>
<td>'$40'</td>
<td>@</td>
</tr>
<tr>
<td>'$0D'</td>
<td>Control character: Line break (corresponds to '$R')</td>
</tr>
<tr>
<td>'$0A'</td>
<td>Control character: New line (corresponds to '$L' and '$N')</td>
</tr>
</tbody>
</table>

**Table 398: Special cases**

<table>
<thead>
<tr>
<th>String with $ code</th>
<th>Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>'$L', '$l'</td>
<td>Control character: Line feed (corresponds to '$0A')</td>
</tr>
<tr>
<td>'$N', '$n'</td>
<td>Control character: New line (corresponds to '$0A')</td>
</tr>
<tr>
<td>'$P', '$p'</td>
<td>Control character: Form feed</td>
</tr>
<tr>
<td>'$R', '$r'</td>
<td>Control character: Line break (corresponds to '$0D')</td>
</tr>
<tr>
<td>'$T', '$t'</td>
<td>Control character: Tab</td>
</tr>
<tr>
<td>'$S'</td>
<td>Dollar sign: $</td>
</tr>
<tr>
<td>'$'</td>
<td>Single straight quotation mark: '</td>
</tr>
</tbody>
</table>

**Example**

```pascal
VAR CONSTANT
    constA : STRING := 'Hello world';
    constB : STRING := 'Hello world $21'; // Hello world!
END_VAR
```

**Constant: UTF8# String**

With compiler version >= 3.5.18.0, UTF-8 encoded string literals are possible as a single-byte string with base “STRING”.

**Syntax:**

UTF8# '<string literal> '

**Constant declaration**

```pascal
VAR CONSTANT
    constA : STRING := UTF8#'ääöüü';
    constB : STRING := UTF8#'Hello Allgäu $21'; // Hello Allgäu!
END_VAR
```
To ensure correct monitoring, the 'monitoring_encoding' := 'UTF-8' attribute can be added.

NOTICE!
UTF-8 encoding only for project-wide configuration

A UTF-8 encoding is used if the project-wide compile option UTF8 encoding for STRING is enabled. Library functions and add-ons are then also oriented according to this setting.

If you use single UTF-8 encoded strings, then you have to make sure that they are interpreted correctly wherever they are used. For example, a string variable in the OPC server will be converted to UTF-8 before being transferred to a client if the setting is not selected. Values such as UTF8#äöü would then be misinterpreted. Similar problems can arise when outputting strings in the visualization.

TIME/LTIME Constant

You can use TIME constants to operate the standard timer modules. The constant has a size of 32 bits and a resolution in milliseconds.

In addition, the time constant LTIME is available as a time basis for high-resolution timers. The LTIME constant has a dimension of 64 bits and a resolution in nanoseconds.

TIME constant

Syntax

<time keyword> # <length of time>

<time keyword> : TIME | time | T | t
<length of time> : ( <number of days>d )? ( <number of hours>h )? ( <number of minutes>m )? ( <number of seconds>s )? <number of milliseconds>ms)? // ( ...)? Optional

The order of time units must not be changed. However, it is not required to specify all units. It is permitted to specify the units in uppercase.

Time units

- D | d: Days
- H | h: Hours
- M | m: Minutes
- s | s: Seconds
- MS | ms: Milliseconds
Examples
Correct time constants of an ST assignment

VAR
timLength : TIME := T#14ms;
timLength1 : TIME := T#100s12ms; // Overflow in the highest unit is allowed.
timLength2 : TIME := T#12h34m15s;
timCompare : TIME;
xIsOK: BOOL;

timLongest := T#49D17H2M47S295MS; // 4294967295
END_VAR

IF timLength < T#15MS THEN
  IF timCompare < timLength1 THEN
    xIsOK := TRUE;
  END_IF;
END_IF

Table 399: Incorrect usage:

| timIncorrect := t#5m68s; | Overflow at a lower position |
| timIncorrect1 := 15ms;   | Time marker T# missing      |
| timIncorrect2 := t#4ms13d; | Incorrect order of time units |

LTIME constant

Syntax

<long time keyword> # <length of high resolution time>

<long time keyword> : LTIME | ltime
<length of high resolution time> : <length of time> ( <number of microseconds>us )? ( <number of nanoseconds>ns )? // ( ...)? Optional

You can use the same units for LTIME constants as for TIME constants. You can also specify microseconds and nanoseconds because the specified time is calculated in higher time resolution. LTIME literals are treated internally as data type LWORD and therefore the value resolved in nanoseconds.

Additional time units

- US | us: Microseconds
- NS | ns: Nanoseconds

Examples of correct usage of an ST assignment:

PROGRAM PLC_PRG
VAR
  ltimLength := LTIME#1000d15h23m12s34ms2us44ns;
  ltimLength1 := LTIME#345343m3424732874823ns;
END_VAR
See also

- Chapter 6.4.1.20.5.6 “Data Type ‘TIME’” on page 2237
- Chapter 6.4.1.20.4.8 “Date and Time Constants” on page 2225

Date and Time Constants

32-bit date specifications ‘DATE’

Use the keyword DATE (D) to specify a date.

Syntax

```
<date keyword>#<year>-<month>-<day>
```

```
<date keyword> : DATE | date | D | d
<year> : 1970-2106
<month> : 1-12
<day> : 1-31
```

DATE literals are treated internally as data type DWORD, which corresponds to an upper limit of DATE#2106-2-7.

Example

```
PROGRAM PRG_Date
VAR
    dateStart : DATE := DATE#2018-8-8;
    dateEnd : DATE := D#2018-8-31;
    dateCompare : DATE := date#1996-05-06;
    xIsDuringTheTime: BOOL;
    dateEarliest : DATE := d#1970-1-1; // = 0
    dateLatest : DATE := DATE#2106-2-7; // = 4294967295
END_VAR

IF dateStart < dateCompare THEN
    IF dateCompare < dateEnd THEN
        xIsDuringTheTime := TRUE;
    END_IF;
END_IF
```

64-bit date specifications ‘LDATE’

Use the keyword LDATE (LD) to specify a date.

Syntax

```
<date keyword>#<year>-<month>-<day>
```

```
<date keyword> : LDATE | ldate | LD | ld
<year> : 1970-2262
<month> : 1-12
<day> : 1-31
```

LDATE literals are treated internally as data type LWORD, which corresponds to an upper limit of DATE#2554-7-21.
PROGRAM PRG_Ldate
VAR
  ldateStart : LDATE := LDATE#2018-8-8;
  ldateEnd : LDATE := ldate#2018-8-31;
  ldateCompare : LDATE := LD#1996-05-06;
  xIsDuringTheTime : BOOL;
  ldateEarliest : LDATE := ld#1970-1-1; // = 0
  ldateLatest : LDATE := LDATE#2262-4-10; // = 16#7FFF63888C620000
  lwValue : LWORD;
END_VAR

IF ldateStart < ldateCompare THEN
  IF ldateCompare < ldateEnd THEN
    xIsDuringTheTime := TRUE;
  END_IF;
END_IF
lwValue := LDATE_TO_LWORD(ldateCompare);

Example

PROGRAM PRG_Ldate
VAR
  ldateStart : LDATE := LDATE#2018-8-8;
  ldateEnd : LDATE := ldate#2018-8-31;
  ldateCompare : LDATE := LD#1996-05-06;
  xIsDuringTheTime : BOOL;
  ldateEarliest : LDATE := ld#1970-1-1; // = 0
  ldateLatest : LDATE := LDATE#2262-4-10; // = 16#7FFF63888C620000
  lwValue : LWORD;
END_VAR

IF ldateStart < ldateCompare THEN
  IF ldateCompare < ldateEnd THEN
    xIsDuringTheTime := TRUE;
  END_IF;
END_IF
lwValue := LDATE_TO_LWORD(ldateCompare);

32-bit date and time specifications

Use the keyword DATE_AND_TIME (DT) to specify a date and time.

Syntax

<date and time keyword>#:<date and time value>

<date and time keyword> : DATE_AND_TIME | date_and_time | DT | dt
<date and time value> : <year>-<month>-<day>-<hour>:<minute>:<second>
<year> : 1970-2106
<month> : 1-12
<day> : 1-31
<hour> : 0-24
<minute> : 0-59
<second> : 0-59

DATE_AND_TIME literals are treated internally as data type DWORD. The time is processed in seconds and as a result can take on values from January 1, 1970 00:00:00 to February 7, 2106 06:28:15.

Example

PROGRAM PLC_PRG
VAR
  dtDate : DATE_AND_TIME := DATE_AND_TIME#1996-05-06-15:36:30;
  dtDate1: DATE_AND_TIME := DT#1972-03-29-00:00:00;
  dtDate2: DATE_AND_TIME := DT#2018-08-08-13:33:20.5;
  dtEarliest : DATE_AND_TIME :=
    DATE_AND_TIME#1979-1-1-00:00:00; // 0
  dtLatest : DATE_AND_TIME := DATE_AND_TIME#2106-2-7-6:28:15; // 4294967295
END_VAR
Use the keyword `LDATE_AND_TIME` (LDT) to specify a date and time.

Syntax

```
<date and time keyword>#<long date and time value>
```

```
<date and time keyword> : LDATE_AND_TIME | ldate_and_time | LDT | ldt
<date and time value> : <year>-<month>-<day>-<hour>:<minute>:<second>
<year> : 1970-2106
<month> : 1-12
<day> : 1-31
<hour> : 0-24
<minute> : 0-59
<second> : 0-59 LDATE_AND_TIME#2262-4-10-23:59:59.999999999
```

`DATE_AND_TIME` literals are treated internally as data type LWORD. The time is processed in seconds and as a result can take on values from January 1, 1970 00:00 to July 21, 2554 23:59:59.999999999.

Example

```
PROGRAM PLC_PRG
VAR
  ldtDate : LDATE_AND_TIME := LDATE_AND_TIME#1996-05-06-15:36:30;
  ldtDate1: LDATE_AND_TIME := LDT#1972-01-29-00:00:00;
  ldtDate2: LDATE_AND_TIME := LDT#2018-08-08-13:33:20.5;
  dtEarliest : LDT := LDT#1979-1-1-00:00:00; // 0
  dtLatest : LDT := LDT#2266-4-10-23:59:59; // = 16#7FFF63888C620000
END_VAR
```

Use the keyword `TIME_OF_DAY` (TOD) to specify a time.

Syntax

```
<time keyword>#<time value>
```

```
<time keyword> : TIME_OF_DAY | time_of_day | TOD | tod
<time value> : <hour>:<minute>:<second>
<hour> : 0-23
<minute> : 0-59
<second> : 0.000-59.999
```

You can also specify fractions of a second. `TIME_OF_DAY` literals are treated internally as DWORD and the value is resolved in milliseconds.

Examples

```
PROGRAM POU
VAR
  todClockTime : TIME_OF_DAY := TIME_OF_DAY#15:36:30.123;
  todEarliest : TIME_OF_DAY := TIME_OF_DAY#0:0:0.000;
  todLatest : TOD := TOD#23:59:59.999;
END_VAR
```
Use the keyword LTIME_OF_DAY (LTOD) to specify a time.

**'LTIME_OF_DAY'**

**Syntax**

```
<time keyword>#:<time value>
```

- `<time keyword>`: LTIME_OF_DAY | ltime_of_day | LTOD | ltod
- `<time value>`: <hour>:<minute>:<second>
- `<hour>`: 0-23
- `<minute>`: 0-59
- `<second>`: 0.000-59.999999999

You can also specify fractions of a second. LTIME_OF_DAY literals are treated internally as LWORD and the value is resolved in nanoseconds.

**Examples**

```plaintext
PROGRAM POU
VAR
  ltodClockTime : LTIME_OF_DAY := TIME_OF_DAY#15:36:30.123456789;
  todEarliest : TIME_OF_DAY := TIME_OF_DAY#0:0:0;
  todLatest : TOD := TOD#23:59:59.999999999;
END_VAR
```

See also

- Chapter 6.4.1.20.5.8 “Date and Time Data Types” on page 2238

**Typed literals**

With the exception of REAL/LREAL constants (LREAL is always used here), CODESYS uses the smallest possible data type when calculating with IEC constants. If you want to use another data type, then you can use typed literals without having to declare the constants explicitly. When doing this, provide the constants with a prefix that indicates the type.

**Syntax:**

```
<type>#<literal>
```

- `<type>` defines the desired data type; possible values: BOOL, SINT, USINT, BYTE, INT, UINT, WORD, DINT, UDINT, DWORD, REAL, LREAL. You must capitalize the entire type name.
- `<literal>` defines the constants. The entry must match the data type defined in `<Type>`.

**Example:**

```
var1 := DINT#34;
```

If CODESYS cannot convert the constant into the target type without data loss, then an error message is issued.

You can use typed constants wherever you can use normal constants.

**Access to Variables in Arrays, Structures, and Blocks**

**Syntax for access to**

- Two-dimensional array component: `<array name> [ <1st dimension> , <2nd dimension> ]`
- Structural variable: `<structure name> . <component name>`
- Function block and program variable: `<function block name> | <program name> . <variable name>`
Bit Access in Variables

NOTICE!
Implement concurrent bit access by two tasks only if the processor can execute bit access directly on the memory. All x86 and x64 systems have commands for bit access in memory. Systems such as ARM and PPC cannot access bits directly in the memory.

If two tasks execute bit access simultaneously, even though the processor cannot perform bit access directly in the memory, then proceed as follows. Use a semaphore (SysSemEnter) or a similar technique to prevent competing bit access. However, it is best to execute the bit access within a task.

With index access, individual bits can be addressed in integer variables. Using a structure variable or a function block instance, individual bits can be addressed symbolically.

Index access to bits integer variables
You can address individual bits in integer variables. To do this, append the variable with a dot and the index of the addressed bit. The bit-index can be given by any constant. Indexing is 0-based.

Syntax
<integer variable name> . <index>
<integer data type> = BYTE | WORD | DWORD | LWORD | SINT | USINT | INT | UINT | DINT | UDINT | LINT | ULINT

Example
In the program, the third bit of the variable wA is set to the value of variable xB. The constant c_usiENABLE acts as an index to access the third bit of the variable iX.

Index access
PROGRAM PLC_PRG
VAR
   wA : WORD := 16#FFFF;
   xB : BOOL := 0;
END_VAR

   // Index access in an integer variable
   wA.2 := xB;

Result: wA = 2#1111_1111_1111_1011 = 16#FFFB

Constant as index
   // GVL declaration
   VAR_GLOBAL CONSTANT
c_usiENABLE : USINT := 2;
   END_VAR

PROGRAM PLC_PRG
VAR
   iX : INT := 0;
END_VAR

   // Constant as index
   iX.gc_usiENABLE := TRUE;   // Third bit in iX is set TRUE

Result: iX = 4
**Symbolic bit access in structure variables**

With the **BIT** data type, you can combine individual bits into a structure and then access them individually. Then the bit is addressed with the component name.

**Example**

**Type declaration of the structure:**

```plaintext
TYPE S_CONTROLLER :
  STRUCT
    bitOperationEnabled : BIT;
    bitSwitchOnActive : BIT;
    bitEnableOperation : BIT;
    bitError : BIT;
    bitVoltageEnabled : BIT;
    bitQuickStop : BIT;
    bitSwitchOnLocked : BIT;
    bitWarning : BIT;
  END_STRUCT
END_TYPE
```

**Declaration and write access to a bit:**

```plaintext
PROGRAM PLC_PRG
VAR
  ControlDriveA : S_CONTROLLER;
END_VAR

// Symbolic bit access to bitEnableOperation
ControlDriveA.bitEnableOperation := TRUE;
```

**Symbolic bit access in function block instances**

In function blocks, you can declare variables for individual bits.

**Example**

```plaintext
FUNCTION_BLOCK FB_Controller
  VAR_INPUT
    bitSwitchOnActive : BIT;
    bitEnableOperation : BIT;
    bitVoltageEnabled : BIT;
    bitQuickStop : BIT;
    bitSwitchOnLocked : BIT;
  END_VAR
  VAR_OUTPUT
    bitOperationEnabled : BIT;
    bitError : BIT;
    bitWarning : BIT;
  END_VAR
END_FUNCTION_BLOCK

PROGRAM PLC_PRG
VAR
  fbController : FB_Controller;
END_VAR

// Symbolic bit access to bitSwitchOnActive
fbController(bitSwitchOnActive := TRUE);
```
 Addresses

**CAUTION!**
If you use pointers to addresses, then the contents of addresses can be moved during an online change. If you use absolute addresses, then the contents of addresses does not change during an online change.

Syntax:

```
%<memory area prefix> ( <size prefix> )? <memory position>
```

- `<memory area prefix>`: I | Q | M
- `<size prefix>`: X | B | W | D
- `<memory position>`: <number> ( .<number> )* // Depends on the target system

When defining an address, you use specific character strings to express memory position and size. An address is marked with the percent sign (%), followed by the memory range prefix, the optional size prefix, and the memory range position. The numbering that you use for addressing the memory position depends on the target system.

<table>
<thead>
<tr>
<th>Memory Range Prefix</th>
<th>Memory Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I</td>
<td>Input memory range for &quot;Inputs&quot;</td>
</tr>
<tr>
<td></td>
<td>For physical inputs via input drivers, &quot;Sensors&quot;</td>
</tr>
<tr>
<td>Q</td>
<td>Output memory range for &quot;Outputs&quot;</td>
</tr>
<tr>
<td></td>
<td>For physical outputs via output drivers, &quot;Actuators&quot;</td>
</tr>
<tr>
<td>M</td>
<td>Flag memory range</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Size Prefix</th>
<th>Data Type</th>
<th>Data Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>No size prefix</td>
<td>Single bit</td>
<td></td>
</tr>
<tr>
<td>X</td>
<td>Single bit</td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>BYTE</td>
<td>8 bits</td>
</tr>
<tr>
<td>W</td>
<td>WORD</td>
<td>16 bits</td>
</tr>
<tr>
<td>D</td>
<td>DWORD</td>
<td>32 bits</td>
</tr>
</tbody>
</table>
Examples

<table>
<thead>
<tr>
<th>Address</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>%QX7.5</td>
<td>Single bit address of the output bit 7.5</td>
</tr>
<tr>
<td>%Q7.5</td>
<td></td>
</tr>
<tr>
<td>%IW215</td>
<td>Word address of the input word 215</td>
</tr>
<tr>
<td>%QB7</td>
<td>Byte address of the output byte 7</td>
</tr>
<tr>
<td>%MD48</td>
<td>Address of a double word at memory position 48 in flag memory</td>
</tr>
<tr>
<td>%IW2.5.7.1</td>
<td>Word address of an input word; interpretation dependent on the current controller configuration</td>
</tr>
<tr>
<td>VAR wVar AT %IW0 : WORD; END_VAR</td>
<td>Variable declaration with address information of an input word</td>
</tr>
<tr>
<td>VAR xActuator AT %QW0 : BOOL; END_VAR</td>
<td>Boolean variable declaration</td>
</tr>
<tr>
<td>VAR xSensor AT IX7.5 : BOOL; END_VAR</td>
<td>Boolean variable declaration with explicit specification of a single bit address. On access, only the input bit 7.5 is read.</td>
</tr>
</tbody>
</table>

Memory position

Make sure that the address is valid as follows:

To map a valid address in an application, you must know the required position (applicable memory range) in the process image: input memory range (I), output memory range (Q), and flag memory range (M) — see above. Furthermore, you have to specify the required size prefix: bit, BYTE, WORD, DWord (see above: X, B, W, D).

The current device configuration and device settings (hardware structure, device description, I/O settings) play a decisive part. Note specifically the differences in the interpretation of bit addresses for devices with "byte addressing mode" and devices with "word-oriented IEC addressing mode". For example, in a byte addressing device, the number before the point of bit address %IX5.5 addresses byte 5. On the other hand, in a word-addressed device, it addresses word 5. In contrast, addressing with a word or byte address is independent of the device type: with %IW5 always word 5 is addressed and with byte address %IB5 always byte 5. Regardless of size and addressing mode, you can address different memory cells therefore with the same address information.

The following table shows the comparison of byte addressing and word-oriented IEC addressing for bits, bytes, words, and double words. It also shows the overlapping memory ranges that are present in the case of byte addressing (see also the example below the table).

Regarding syntax, note that the IEC addressing mode is always word-oriented. In this case, the word number is located before the point and the bit number after the point.
### Functions

In ST, you can use a function call as an operand.

**Example:**

```
Result := Fct(7) + 3;
```

### TIME() function

This function yields the time (in milliseconds) that has elapsed since system boot. The data type is TIME.

**Example in ST:**

```
systime := TIME();
```

See also
- Chapter 6.4.1.9.1.2.1.4 “Object 'Function’” on page 2482
6.4.1.20.5  Data Types

General

In the programming, a variable is identified by its name and has an address in the memory of the target system. Accordingly, variable names are identifiers under which the allocated memory is addressed. The size of the variable is determined by its data type. This determines how much memory is reserved for the variable and how the values in memory are to be interpreted. The data type also determines which operators are allowed.

In CODESYS, there is also the capability of instantiating function blocks. Function block instances then use memory like variables do. The memory requirement is determined by the function block.

The following groups of data types are available.

Standard data types

A standard data type (or standard data type) is an elementary data type or a string data type.

<standard data type> : __UXINT | __XINT | __XWORD | BIT | BOOL | BYTE | DATE | DATE_AND_TIME | DINT | DT | DWORD | INT | LDATE | LDATE_AND_TIME | LDT | LINT | LREAL | LTOD | LWORD | REAL | SINT | STRING | TIME | TOD | TIME_OF_DAY | UDINT | UINT | ULINT | USINT | WORD | WSTRING

See also

- Chapter 6.4.1.20.5.11 “Data Type ‘BIT’” on page 2243
- Chapter 6.4.1.20.5.2 “Data type ‘BOOL’” on page 2235
- Chapter 6.4.1.20.5.3 “Integer data types” on page 2235
- Chapter 6.4.1.20.5.12 “Special Data Types ‘__UXINT’, __XINT, and ‘__XWORD’” on page 2243
- Chapter 6.4.1.20.5.4 “Data type ‘REAL’ / ‘LREAL’” on page 2236
- Chapter 6.4.1.20.5.5 “Data Type ‘STRING’” on page 2237
- Chapter 6.4.1.20.5.10 “Data type ‘WSTRING’” on page 2242
- Chapter 6.4.1.20.5.6 “Data Type ‘TIME’” on page 2237
- Chapter 6.4.1.20.5.7 “Data Type ‘LTIME’” on page 2237
- Chapter 6.4.1.20.5.8 “Date and Time Data Types” on page 2238

Extensions of the IEC 61131-3 standard

See also

- Chapter 6.4.1.20.5.11 “Data Type ‘BIT’” on page 2243
- Chapter 6.4.1.20.5.13 “Pointers” on page 2243
- Chapter 6.4.1.20.5.20 “Data type ‘UNION’” on page 2268
- Chapter 6.4.1.20.5.16 “Data Type ‘__VECTOR’” on page 2253

User-defined data types

You can declare your own data types which are based on the default predefined data types or existing data types.

These kinds of data types are called user-defined or user-specific. The data types are either organized as its own DUT object or declared within the declaration part of a programming object. Moreover, they are differentiated according to their purpose and syntax.

<table>
<thead>
<tr>
<th>User-Defined Data Type</th>
<th>Declaration</th>
<th>See also</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alias</td>
<td>DUT object</td>
<td>Chapter 6.4.1.20.5.19 “Alias” on page 2267</td>
</tr>
<tr>
<td>Arrays</td>
<td>Programming object</td>
<td>Chapter 6.4.1.20.5.15 “Data Type ‘ARRAY’” on page 2247</td>
</tr>
<tr>
<td>Enumeration</td>
<td>DUT object, programeer object</td>
<td>Chapter 6.4.1.20.5.18 “Enumerations” on page 2263</td>
</tr>
</tbody>
</table>
### User-Defined Data Type Declaration

<table>
<thead>
<tr>
<th>User-Defined Data Type</th>
<th>Declaration</th>
<th>See also</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference</td>
<td>Programming object</td>
<td>§ Chapter 6.4.1.20.5.14 “Reference” on page 2245</td>
</tr>
<tr>
<td>Pointer</td>
<td>Programming object</td>
<td>§ Chapter 6.4.1.20.5.13 “Pointers” on page 2243</td>
</tr>
<tr>
<td>Structure</td>
<td>DUT object</td>
<td>§ Chapter 6.4.1.20.5.17 “Structure” on page 2261</td>
</tr>
<tr>
<td>Subrange type</td>
<td>Programming object</td>
<td>§ Chapter 6.4.1.20.5.21 “Subrange types” on page 2268</td>
</tr>
<tr>
<td>Union</td>
<td>DUT object</td>
<td>§ Chapter 6.4.1.20.5.20 “Data type 'UNION’” on page 2268</td>
</tr>
<tr>
<td>Vector</td>
<td>DUT object</td>
<td>§ Chapter 6.4.1.20.5.16 “Data Type ‘__VECTOR’” on page 2253</td>
</tr>
</tbody>
</table>

---

**NOTICE!**

Note the recommendations for naming an identifier.

See also

- § Chapter 6.4.1.20.7 “Identifiers” on page 2327

---

### Data type 'BOOL'

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Values</th>
<th>Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOL</td>
<td>TRUE (1), FALSE (0)</td>
<td>8 bit</td>
</tr>
</tbody>
</table>

See also

- § Chapter 6.4.1.20.4.2 “BOOL constants” on page 2220

---

### Integer data types

CODESYS provides the following integer data types.

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Lower Limit</th>
<th>Upper Limit</th>
<th>Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>BYTE</td>
<td>0</td>
<td>255</td>
<td>8 bit</td>
</tr>
<tr>
<td>WORD</td>
<td>0</td>
<td>65535</td>
<td>16 bit</td>
</tr>
<tr>
<td>DWORD</td>
<td>0</td>
<td>4294967295</td>
<td>32 bit</td>
</tr>
<tr>
<td>LWORD</td>
<td>0</td>
<td>$2^{64}-1$</td>
<td>64 bit</td>
</tr>
<tr>
<td>SINT</td>
<td>-128</td>
<td>127</td>
<td>8 bit</td>
</tr>
<tr>
<td>USINT</td>
<td>0</td>
<td>255</td>
<td>8 bit</td>
</tr>
<tr>
<td>INT</td>
<td>-32768</td>
<td>32767</td>
<td>16 bit</td>
</tr>
<tr>
<td>UINT</td>
<td>0</td>
<td>65535</td>
<td>16 bit</td>
</tr>
<tr>
<td>DINT</td>
<td>-2147483648</td>
<td>2147483647</td>
<td>32 bit</td>
</tr>
<tr>
<td>UDINT</td>
<td>0</td>
<td>4294967295</td>
<td>32 bit</td>
</tr>
</tbody>
</table>
Data Type | Lower Limit | Upper Limit | Memory
---|---|---|---
LINT | $-2^{63}$ | $2^{63}-1$ | 64 bit
ULINT | 0 | $2^{64}-1$ | 64 bit

**NOTICE!**
Information can be lost when converting from larger to smaller types.

See also
- ☰ Chapter 6.4.1.20.4.3 “Numeric constants” on page 2220

**Data type 'REAL' / 'LREAL'**
The data types REAL and LREAL are floating-point types according to IEEE 754. They are necessary when using decimal numbers and floating-point numbers in decimal notation or exponential notation.

**Example**

```
PROGRAM PLC_PRG
VAR
    rMax: REAL := 3.402823E+38; // Largest number
    rPosMin : REAL := 1.0E-44; // Smallest positive number
    rNegMax: REAL := -1.0E-44; // Largest negative number
    rMin: REAL := -3.402823E+38; // Smallest number
    lrMax: LREAL := 1.7976931348623157E+308; // Largest number
    lrPosMin : LREAL := 4.94065645841247E-324; // Smallest positive number
    lrNegMax: LREAL := -4.94065645841247E-324; // Largest negative number
    lrMin: LREAL := -1.7976931348623157E+308; // Smallest number
END_VAR
```

**NOTICE!**
Support for the LREAL data type depends on the target device in use. Refer to the respective documentation as to whether or not the 64-bit type LREAL is converted to REAL or remains as LREAL when compiling the application. Conversion may result in the loss of information.

**NOTICE!**
If the value of the REAL/LREAL number is outside of the value range of the integer, then an undefined result is yielded from a data type conversion from REAL or LREAL to SINT, USINT, INT, UINT, DINT, UDINT, LINT, or ULINT. The result depends on the target system. An exception error is also possible. To get code that is independent of the target system, the application must catch value range violations.

If the REAL/LREAL number is within the value range of the integer data type, then the conversion operates the same way on all systems.
Data Type 'STRING'

A variable of data type STRING can have contain any character string. The amount of memory that is reserved during a declaration refers to characters and is shown in parentheses or brackets. If a size is not defined, then CODESYS allocates 80 characters by default.

As a rule, CODESYS does not limit the string length. However, the string function processes lengths of 1–255 only. If a variable is initialized with a string that is too long for the data type, then CODESYS truncates the string accordingly from the right.

**NOTICE!**
The memory required for a STRING variable is always one byte per character plus one additional byte (for example, 81 bytes for a "STRING(80)" declaration).

**Example of a string declaration with 35 characters:**

```plaintext
str : STRING(35):= 'This is a String';
```

See also

- § Chapter 6.4.1.20.4.5 “String Constants” on page 2221
- § Chapter 6.4.1.20.5.10 “Data type 'WSTRING’” on page 2242

Data Type 'TIME'

The data type is treated internally as DWORD. TIME is resolved in milliseconds.

<table>
<thead>
<tr>
<th>Data type</th>
<th>Lower limit</th>
<th>Upper limit</th>
<th>Storage space</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIME</td>
<td>T#0d0h0m0s0ms</td>
<td>T#49d17h2m47s29</td>
<td>32 bit</td>
<td>Milliseconds</td>
</tr>
</tbody>
</table>

**See also**

- § Chapter 6.4.1.20.5.7 “Data Type 'LTIME’” on page 2237
- § Chapter 6.4.1.20.4.7 “TIME/LTIME Constant” on page 2223
- § Chapter 6.4.1.20.4.8 “Date and Time Constants” on page 2225

Data Type 'LTIME'

You can use the data type LTIME as a time base for high-resolution timer. A high-resolution timer has a resolution in nanoseconds.

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Lower Limit</th>
<th>Upper Limit</th>
<th>Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>LTIME</td>
<td>LTIME#0NS</td>
<td>LTIME#213503D23H34M3 3S709MS551US615NS</td>
<td>64 bits</td>
</tr>
</tbody>
</table>

**Syntax:**
LTIME\#<long time declaration>

The time declaration can include units of time that apply for the TIME constant as well as:

- "US": microseconds
- "NS": nanoseconds

Example: 
LTIME1 := LTIME\#1000D15H23M12S34MS2US44NS

See also:
- § Chapter 6.4.1.20.5.6 “Data Type 'TIME’” on page 2237
- § Chapter 6.4.1.20.3.41 “Time Conversion” on page 2182

Date and Time Data Types

The data types DATE, DATE_AND_TIME (DT), and TIME_OF_DAY (TOD) are handled internally like a DWORD (32-bit value).

The data types LDATE, LDATE_AND_TIME (LDT), and LTIME_OF_DAY (LTOD) are treated internally like an LWORD (64-bit value).

The values of these data types are measured in seconds, milliseconds, and nanoseconds since 01/01/1970.

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Lower Limit</th>
<th>Upper Limit</th>
<th>Memory</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>DATE</td>
<td>DATE#1970-01-01 D#1970-01-01</td>
<td>DATE#2106-02-07 D#2106-02-07</td>
<td>32-bit</td>
<td>Seconds (although only the day is displayed)</td>
</tr>
<tr>
<td>DATE_AND_TIME</td>
<td>DATE_AND_TIME#1970-1-1-0:0:0 DT#1970-1-1-0:0:0</td>
<td>DATE_AND_TIME#2106-02-07-06:28:15 DT#2106-02-07-06:28:15</td>
<td>32-bit</td>
<td>Seconds</td>
</tr>
<tr>
<td>TIME_OF_DAY</td>
<td>TIME_OF_DAY#0:0:0 TOD#0:0:0</td>
<td>TIME_OF_DAY#23:59:59.999 TOD#23:59:59.999</td>
<td>32-bit</td>
<td>Milliseconds</td>
</tr>
<tr>
<td>LDATE</td>
<td>LDATE#1970-1-1 LD#1970-1-1</td>
<td>LDATE#2554-7-21 LD#2554-7-21</td>
<td>64-bit</td>
<td>Nanoseconds (although only the day is displayed)</td>
</tr>
<tr>
<td>LDATE_AND_TIME</td>
<td>LDATE_AND_TIME#1970-1-1-0:0:0 LDT#1970-1-1-0:0:0</td>
<td>LDATE_AND_TIME#2554-7-21-23:59:59.99999999 LDT#2554-7-21-23:59:59.99999999</td>
<td>64-bit</td>
<td>Nanoseconds</td>
</tr>
<tr>
<td>LTIME_OF_DAY</td>
<td>LTIME_OF_DAY#0:0:0 LTOD#0:0:0</td>
<td>LTIME_OF_DAY#23:59:59.9999999999 LTOD#23:59:59.9999999999</td>
<td>64-bit</td>
<td>Nanoseconds</td>
</tr>
</tbody>
</table>
Example

VAR

//Date
dateBottom : DATE := DATE#1970-1-1;
dateTop : DATE := DATE#2106-2-7;
dateAppointment : DATE := D#2020-2-7; // D prohibited

//Date and time
dtBottom : DATE_AND_TIME := DATE_AND_TIME#1970-1-1-0:0:0;
dtTop : DT := DATE_AND_TIME#2106-02-07-06:28:15;
dtAppointment : DT := DT#2020-2-7-12:55:1.234;

//Time of day
todBottom : TIME_OF_DAY := TIME_OF_DAY#0:0:0;
todTop : TOD := TIME_OF_DAY#23:59:59.999;
todAppointment : TOD := TOD#12:3:4.567;

//Long date
dateBottom : LDATE := LDATE#1970-1-1;
dateTop : LDATE := LDATE#2106-2-7;
dateAppointment : LDATE := LD#2020-2-7; // LD prohibited

//Long date and time
ldtBottom : LDATE_AND_TIME := LDATE_AND_TIME#1970-1-1-0:0:0;
ldtTop : LDT := LDATE_AND_TIME#2262-4-10-23:59:59.99999999;
ldtAppointment : LDT := LDT#2020-2-7-12:55:1.234567891;

//Long time of day
ltodBottom : LTIME_OF_DAY := LTIME_OF_DAY#0:0:0;
ltodTop : LTOD := LTIME_OF_DAY#23:59:59.999999999;
ltodAppointment : LTOD := LTOD#12:3:4.567890123;

END_VAR

See also

● % Chapter 6.4.1.20.4.8 "Date and Time Constants" on page 2225

Data Type 'ANY' and 'ANY_<type>'

The data types ANY or ANY_<type> are used in interfaces of functions, function blocks, or methods in order to type input parameters whose type is unknown or unspecified: The input variables (VAR_INPUT) have a generic data type.

The compiler replaces the type of input variable internally with the data structure described below, whereby the value is not passed directly. Instead, a pointer is passed to the actual value so only a variable can be passed. Therefore, the data type is only specified when it is called. As a result, calls of such POUs can be made using arguments which each have different data types.

Literal, replaced constants, and results of function calls or expressions cannot be passed to input variables (VAR_IN_OUT).

Internal data structure for 'ANY' and 'ANY_<type>'

When code is compiled, the input variables are typed internally with ANY data type by the following structure. When the POU is called (at runtime), the argument is passed to a reference parameter.

2024/01/05  3ADR010583, 1, en_US  2239
TYPE AnyType :
STRUCT
  // the type of the actual parameter
  typeclass : __SYSTEM.TYPE_CLASS;
  // the pointer to the actual parameter
  pvalue : POINTER TO BYTE;
  // the size of the data, to which the pointer points
  diSize : DINT;
END_STRUCT
END_TYPE

You can access the input variable within the POU via this structure by means of this structure, and for example query the passed value.

Example
This compares whether or not two input variables have the same type and the same value.

FUNCTION funGenericCompare : BOOL
VAR_INPUT
  any1 : ANY;
  any2 : ANY;
END_VAR
VAR
  pTest : POINTER TO ARRAY [0..100] OF POINTER TO DWORD;
  diCount: DINT;
END_VAR

  pTest := ADR(any1);
  Generic_Compare := FALSE;
  IF any1.typeclass <> any2.typeclass THEN
    RETURN;
  END_IF
  IF any1.diSize <> any2.diSize THEN
    RETURN;
  END_IF
  // Byte comparison
  FOR iCount := 0 TO any1.diSize-1 DO
    IF any1.pvalue[iCount] <> any2.pvalue[iCount] THEN
      RETURN;
    END_IF
  END_FOR
  Generic_Compare := TRUE;
  RETURN;
END_FUNCTION

Declaration
The syntax descriptions refer to a POU with exactly one parameter (an input variable).

Syntax
FUNCTION | FUNCTION_BLOCK | METHOD <POU name> ( : <return data type> )?
VAR_INPUT
  <input variable name> : <generic data type>;
END_VAR

<generic data type> = ANY | ANY_BIT | ANY_DATE | ANY_NUM | ANY_REAL | ANY_INT | ANY_STRING
**Example**

```plaintext
FUNCTION funComputeAny : BOOL
VAR_INPUT
    anyInput1 : ANY; // valid data type see table
END_VAR
// END_FUNCTION

FUNCTION_BLOCK FB_ComputeAny
VAR_INPUT
    anyInput1 : ANY;
END_VAR
// END_FUNCTION_BLOCK

FUNCTION_BLOCK FB_ComputeMethod
METHOD methComputeAny : BOOL
VAR_INPUT
    anyInput1 : ANY_INT; // valid data types are SINT, INT, DINT,
    LINT, USINT, UINT, UDINT, ULINT
END_VAR
//END_METHOD
```

*With compiler versions > 3.5.1.0, the generic IEC data types in the table are supported.*

The table represents the hierarchy of the generic data types and provides information as to which generic data type of the formal parameter (declaration) allows which elementary data types of the argument (call).

<table>
<thead>
<tr>
<th>Generic data type in the case of a formal parameter</th>
<th>Permitted elementary data type in the case of an actual parameter (argument)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANY</td>
<td>ANY_BIT</td>
</tr>
<tr>
<td>ANY_DATE</td>
<td>DATE, DATE_AND_TIME, DT, TIME_OF_DAY, TOD, LDATE, LDATE_AND_TIME, LDT, LTIME_OF_DAY, LTOD</td>
</tr>
<tr>
<td>ANY_NUM</td>
<td>ANY_REAL, REAL, LREAL</td>
</tr>
<tr>
<td>ANY_INT</td>
<td>USINT, UINT, UDINT, ULINT, SINT, INT, DINT, LINT</td>
</tr>
<tr>
<td>ANY_STRING</td>
<td>STRING, WSTRING</td>
</tr>
</tbody>
</table>

**Call**

The syntax descriptions refer to a POU with exactly one parameter, to which an argument is passed. As a result, the data type of the argument specifies the generic data type of the input variable. For example, arguments of the type BYTE, WORD, DWORD, LWORD can be passed to a type ANY_BIT input variable.
Syntax of function call
<variable name> := <function name> ( <argument name> );
<argument name> : variable with valid data type

Syntax of function block call
<function block name> ( <input variable name> := <argument name> );

Syntax of method call
<function block name> . <method name> ( <input variable name> := <argument name> );

Example

PROGRAM PLC_PRG
VAR
byValue : BYTE := 16#AB;
iValue : INT := -1234;
xResultByte : BOOL;
xResultInt : BOOL;

fbComputeAnyByte : FB_ComputeAny;
fbComputeAnyInt : FB_ComputeAny;

fbComputeM1 : FB_ComputeMethod;
fbComputeM2 : FB_ComputeMethod;

byN : BYTE := 1;
wBitField1 : WORD := 16#FFFF;
wBitField2 : WORD := 16#0001;
xInit : BOOL;
xResult : BOOL;
END_VAR

xResultByte := funComputeAny(byValue);
xResultInt := funComputeAny(iValue);

xResult := funGenericCompare(wBitField1, wBitField2);

fbComputeAnyByte(anyInput1 := byValue);
fbComputeAnyInt(anyInput1 := iValue);

fbComputeM1.methComputeAny(byValue);
fbComputeM2.methComputeAny(iValue);
// END_PRG

Data type 'WSTRING'
The data type WSTRING is interpreted in Unicode format as opposed to the data type STRING (ASCII). As a result of this coding, the number of displayed characters for WSTRING depends on the characters. A length of 10 for WSTRING means that the length of the WSTRING can take a maximum of 10 WORDS. However, for some characters in Unicode, multiple WORDS are required for coding a character so that the number of characters do not have to correspond to the length of the WSTRING (10 in this case). The data type requires 1 WORD of memory per character plus 1 WORD of extra memory. Each STRING requires only 1 byte. The data type WSTRING is terminated with a 0.

Example:

wstr : WSTRING := "This is a WString";

See also
- Chapter 6.4.1.20.5.5 “Data Type "STRING"” on page 2237
- Chapter 6.4.1.20.4.5 “String Constants” on page 2221
Data Type 'BIT'

The data type **BIT** is valid only in structures for the declaration of structure members or in a function block for the declaration of variables. A **BIT** variable can have the values **TRUE** (1) and **FALSE** (0). In this case, the variable requires exactly one bit of memory.

As a result, you can symbolically address individual bits by a name. **BIT** variables that are declared in succession are bundled in bytes. In this way, you can optimize memory use as opposed to **BOOL** types, which reserve 8 bits each. On the other hand, bit access is significantly more time-consuming. Therefore, you should use the **BIT** data type only when you need to define data in a predefined format.

See also

- Chapter 6.4.1.20.4.11 “Bit Access in Variables” on page 2229
- Chapter 6.4.1.20.5.17 “Structure” on page 2261

Special Data Types '__UXINT', '__XINT', and '__XWORD'

Variables with these data types are converted to a platform-compliant data type, depending on the target system.

CODESYS supports systems with address registers of 32-bit and 64-bit widths. For making the IEC code as independent from the target system as possible, you use the pseudo data types __UXINT, __XINT, and __XWORD. The compiler checks which target system types are current and then converts these data types into the appropriate standard data types.

Moreover, type conversion operators are provided for variables of these data types.

<table>
<thead>
<tr>
<th>__UXINT</th>
<th>Type conversion on 64-bit platforms</th>
<th>Type conversion on 32-bit platforms</th>
</tr>
</thead>
<tbody>
<tr>
<td>__XINT</td>
<td>ULINT</td>
<td>UDINT</td>
</tr>
<tr>
<td>__XWORD</td>
<td>LWORD</td>
<td>DWORD</td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.1.20.3.38 “Integer Conversion” on page 2159
- Chapter 6.4.1.20.3.36 “Overloading” on page 2152

Pointers

A pointer stores the memory address of objects, such as variables or function block instances, at runtime.

**Syntax of the pointer declaration:**

<pointer name>: POINTER TO <data type | data unit type | function block>;
**Example**

FUNCTION_BLOCK FB_Point
VAR
    piNumber: POINTER TO INT;
    iNumber1: INT := 5;
    iNumber2: INT;
END_VAR

piNumber := ADR(iNumber1); // piNumber is assigned to address of iNumber1
iNumber2 := piNumber^; // value 5 of iNumber1 is assigned to variable iNumber2 by dereferencing of pointer piNumber

Dereferencing a pointer means obtaining the value to which the pointer points. A pointer is dereferenced by appending the content operator ^ to the pointer identifier (for example, piNumber^ in the example above). To assign the address of an object to a pointer, the address operator ADR is applied to the object: ADR(iNumber1).

In online mode, you can click “Edit ➔ Browse ➔ Go to Reference” to jump from a pointer to the declaration location of the referenced variable.

**NOTICE!**

When a pointer points to an I/O input, write access applies. This leads to the compiler warning “’<pointer name>’ is not a valid assignment target” when the code is generated. Example: pwInput := ADR(wInput);

If you require a construct of this kind, you have to first copy the input value (wInput) to a variable with write access.

**Index access to pointers**

CODESYS permits the index access [ ] to variables of type POINTER TO, as well as to the data types STRING or WSTRING.

The data, which the pointer points to, can also be accessed by appending the bracket operator [ ] to the pointer identifier(for example, piData[i]). The base data type of the pointer determines the data type and the size of the indexed component. In this case, the index access to the pointer is done arithmetically by adding the index dependent offset i * SIZEOF( <base type> ) to the address of the pointer. The pointer is dereferenced implicitly at the same time.

**Calculation:** piData[i] := (piData + i * SIZEOF(INT))^;

This is not: piData[i] != (piData + i)^.

**Index access STRING**

When you use the index access with a variable of the type STRING, you get the character at the offset of the index expression. The result is of type BYTE. For example, sData[i] returns the i-th character of the character string sData as SINT (ASCII).

**Index access WSTRING**

When you use the index access with a variable of the type WSTRING, you get the character at the offset of the index expression. The result is of type WORD. For example, wsData[i] returns the i-th character of the character string as INT (Unicode).

**Subtracting pointers**

The result of the difference between two pointers is a value of type DWORD, even on 64-bit platforms when the pointers are 64-bit pointers.
Using references provides the advantage of guaranteeing type safety. That is not the case with pointers.

The memory access of pointers can be checked at runtime by the implicit monitoring function `CheckPointer`.

See also
- § Chapter 6.4.1.21.3.3.38 “Command ‘Go To Reference’” on page 2576
- § Chapter 6.4.1.21.4.11.5 “Dialog ‘Properties’ - ‘Build’” on page 2755
- § Chapter 6.4.1.20.3.33 “Operator ‘Content Operator’” on page 2151
- § Chapter 6.4.1.20.3.32 “Operator ‘ADR’” on page 2150
- § Chapter 6.4.1.21.2.22.11 “POU ‘CheckPointer’” on page 2513

Reference

A reference implicitly refers to another object. When accessed, the reference is implicitly dereferenced, and therefore does not need a special content operator ^ such as a pointer.

Syntax

```
<identifier> : REFERENCE TO <data type> ;
<data type>: base type of the reference
```

Example

```plaintext
PROGRAM PLC_PRG
VAR
    rspeA : REFERENCE TO DUT_SPECIAL;
    pspeA : POINTER TO DUT_SPECIAL;
    speB : DUT_SPECIAL;
END_VAR
rspeA REF= speB; // Reference rspeA is alias for speB. The code corresponds to pspeA := ADR(speB);
rspeA := speD; // The code corresponds to pspeA^ := speB;
```

The readability of a program is made difficult when the same memory cell is accessed simultaneously by means of an identifier and its alias (for example, `speB` and `rspeA`).

NOTICE!

With compiler version >= V3.3.0.0, references are initialized (at 0).
NOTICE!

If a reference refers to a device input, then the access (for example, rInput REF= Input;) is applies as write access. This leads to a compiler warning when the code is generated: "...invalid assignment target".

If you require a construct of this kind, you have to first copy the input value (rInput) to a variable with write access.

**Invalid declarations**

ariTest : ARRAY[0..9] OF REFERENCE TO INT;
priTest : POINTER TO REFERENCE TO INT;
rrrTest : REFERENCE TO REFERENCE TO INT;
rbitTest : REFERENCE TO BIT;

A reference type must not be used as the base type of an array, pointer, or reference. Furthermore, a reference must not refer to a bit variable. These kinds of constructs generate compiler errors.

**Comparison of reference and pointer**

A reference has the following advantages over a pointer:

- Easier to use:
  A reference can access the contents of the referenced object directly and without dereferencing.

- Finer and simpler syntax when passing values:
  Call of a function block which passes a reference without an address operator instead of a pointer
  - Example: fbDoIt(riInput:=iValue);
  - Instead of: fbDoIt_1(piInput:=ADR(iValue));

- Type safety:
  When assigning two references, the compiler checks whether their base types match. This is not checked in the case of pointers.

**Testing the validity of a reference**

You can use the operator __ISVALIDREF to check whether or not a reference points to a valid value (meaning a value not equal to 0).

```plaintext
<Boolean variable name> := __ISVALIDREF( <reference name> );
<reference name>: Identifier declared with REFERENCE TO
```

The Boolean variable is TRUE when the reference points to a valid value. Otherwise it is FALSE.
Example

PROGRAM PLC_PRG
VAR
iAlfa : INT;
riBravo : REFERENCE TO INT;
riCharlie : REFERENCE TO INT;
bIsRef_Bravo : BOOL := FALSE;
bIsRef_Charlie : BOOL := FALSE;
END_VAR

iAlfa := iAlfa + 1;
riBravo REF= iAlfa;
riCharlie REF= 0;
bIsRef_Bravo := __ISVALIDREF(riBravo); (* becomes TRUE, because riBravo references to iAlfa, which is non-zero *)
bIsRef_Charlie := __ISVALIDREF(riCharlie); (* becomes FALSE, because riCharlie is set to 0 *)

In compiler version 3.5.7.40 and later, the implicit monitoring function “CheckPointer” acts on variables of type REFERENCE TO in the same way as for pointer variables.

See also
- % Chapter 6.4.1.20.1.4.4.6 “Assignment Operator ‘REF=’” on page 2054
- % Chapter 6.4.1.21.2.22.11 “POU ‘CheckPointer’” on page 2513

Data Type ‘ARRAY’

An array is a collection of data elements of the same data type. CODESYS supports one- and multi-dimensional arrays of fixed or variable length.

As of Automation Builder 2.6.0 array initializations within type definitions are no longer allowed.

Array of fixed length
Syntax of the declaration of a one-dimensional array

<variable name> : ARRAY[ <dimension> ] OF <data type> ( := <initialization> )? ;

<dimension> : <lower index bound>..<upper index bound>
<data type> : elementary data types | user defined data types | function block types
// (...)? : Optional

Syntax of the declaration of a multi-dimensional array

<variable name> : ARRAY[ <1st dimension> ( , <next dimension> )+ ] OF <data type> ( := <initialization> )? ;

<1st dimension> : <1st lower index bound>..<1st upper index bound>
<next dimension> : <next lower index bound>..<next upper index bound>  
<data type> : elementary data types | user defined data types |  
function block types  
// (...)+ : One or more further dimensions  
// (...)? : Optional

The index limits are integers; maximum of the data type DINT.

Syntax for data access

```
<variable name>[ <index of 1st dimension> ( , <index of next dimension> )* ]  
// (....)* : 0, one or more further dimensions
```

Example

### One-dimensional array of 10 integer elements

```
VAR  
  aiCounter : ARRAY[0..9] OF INT;  
END_VAR  
```

Lower index limit: 0
Upper index limit: 9

#### Initialization

```
aiCounter : ARRAY[0..9] OF INT := [0, 10, 20, 30, 40, 50, 60, 70, 80, 90];
```

#### Data access

```
iLocalVariable := aiCounter[2];  
The value 20 is assigned to the local variable.
```

### 2-dimensional array

```
VAR  
  aiCardGame : ARRAY[1..2, 3..4] OF INT;  
END_VAR  
```

1st dimension: 1 to 2  
2nd dimension: 3 to 4

#### Initialization

```
```

#### Data access

```
iLocal_1 := aiCardGame[1, 3]; // Assignment of 10  
iLocal_2 := aiCardGame[2, 4]; // Assignment of 20
```

Note the capability of using the implicit monitoring function CheckBounds() to monitor the maintenance of the index limits at runtime.
Example

3-dimensional array

VAR
  aiCardGame : ARRAY[1..2, 3..4, 5..6] OF INT;
END_VAR

1st dimension: 1 to 2
2nd dimension: 3 to 4
3rd dimension: 5 to 6
2 * 2 * 2 = 8 array elements

Initialization

aiCardGame : ARRAY[1..2, 3..4, 5..6] OF INT := [10, 20, 30, 40, 50, 60, 70, 80];

Data access

iLocal_1 := aiCardGame[1, 3, 5]; // Assignment of 10
iLocal_2 := aiCardGame[2, 3, 5]; // Assignment of 20
iLocal_3 := aiCardGame[1, 4, 5]; // Assignment of 30
iLocal_4 := aiCardGame[2, 4, 5]; // Assignment of 40
iLocal_5 := aiCardGame[1, 3, 6]; // Assignment of 50
iLocal_6 := aiCardGame[2, 3, 6]; // Assignment of 60
iLocal_7 := aiCardGame[1, 4, 6]; // Assignment of 70
iLocal_8 := aiCardGame[2, 4, 6]; // Assignment of 80

Initialization

aiCardGame : ARRAY[1..2, 3..4, 5..6] OF INT := [2(10), 2(20), 2(30), 2(40)]; // Short notation for [10, 10, 20, 20, 30, 30, 40, 40]

Data access

iLocal_1 := aiCardGame[1, 3, 5]; // Assignment of 10
iLocal_2 := aiCardGame[2, 3, 5]; // Assignment of 10
iLocal_3 := aiCardGame[1, 4, 5]; // Assignment of 20
iLocal_4 := aiCardGame[2, 4, 5]; // Assignment of 20
iLocal_5 := aiCardGame[1, 3, 6]; // Assignment of 30
iLocal_6 := aiCardGame[2, 3, 6]; // Assignment of 30
iLocal_7 := aiCardGame[1, 4, 6]; // Assignment of 40
iLocal_8 := aiCardGame[2, 4, 6]; // Assignment of 40
**Example**

### 3-dimensional arrays of a user-defined structure

```plaintext
TYPE DATA_A
STRUCT
  iA_1 : INT;
  iA_2 : INT;
  dwA_3 : DWORD;
END_STRUCT
END_TYPE

PROGRAM PLC_PRG
VAR
  aData_A : ARRAY[1..3, 1..3, 1..10] OF DATA_A;
END_VAR

The array aData_A consists of a total of 3 * 3 * 10 = 90 array elements of data type DATA_A.

### Initialize partially

```plaintext
aData_A : ARRAY[1..3, 1..3, 1..10] OF DATA_A := [(iA_1 := 1, iA_2 := 10, dwA_3 := 16#00FF),
  (iA_1 := 2, iA_2 := 20, dwA_3 := 16#FF00),
  (iA_1 := 3, iA_2 := 30, dwA_3 := 16#FFFF)];
```

In the example, only the first 3 elements are initialized explicitly. Elements to which no initialization value is assigned explicitly are initialized internally with the default value of the basic data type. This initializes the structure components at 0 starting with the element aData_A[2, 1, 1].

### Data access

```plaintext
iLocal_1 := aData_A[1,1,1].iA_1; // Assignment of 1
dwLocal_2 := aData_A[3,1,1].dwA_3; // Assignment of 16#FFFF
```

---

**Example**

### Array of a function block

```plaintext
FUNCTION BLOCK FObject_A
VAR
  iCounter : INT;
END_VAR
...

PROGRAM PLC_PRG
VAR
  aObject_A : ARRAY[1..4] OF FObject_A;
END_VAR

The array aObject_A consists of 4 elements. Each element instantiates a FObject_A function block.

### Function call

```plaintext
aObject_A[2]();
```
The function block FB_Something has a method FB_Init that requires 2 parameters.

The declaration of an "array of arrays" is an alternative syntax for multidimensional arrays. A collection of elements is nested instead of dimensioning the elements. The nesting depth is unlimited.

Syntax for declaration

```
<variable name> : ARRAY[<first>] ( OF ARRAY[<next>] )+ OF <data type> ( := <initialization> )? ;
```

Syntax for data access

```
<variable name>[<index of first array>] ( [<index of next array>] )+ ;
```

// (...) : One or more further arrays
// (...) : Optional
Example

PROGRAM PLC_PRG
VAR
    aiPoints : ARRAY[1..2,1..3] OF INT := [1,2,3,4,5,6];
    ai2Boxes : ARRAY[1..2] OF ARRAY[1..3] OF INT := [ [1,2,3], [4,5,6] ];
        [ [ [1,2,3,4], [5,6,7,8] ], [9,10,11,12] ], [ [13,14,15,16], [17,18,19,20], [21,22,23,24] ] ];
        ARRAY[1..5] OF INT;
END_VAR
aiPoints[1, 2] := 1200;
ai2Boxes[1][2] := 1200;

The variables aiPoints and ai2Boxes collect the same data elements, however the syntax for the declaration differs from that of the data access.

Array of variable length

In function blocks, functions, or methods, you can declare arrays of variable length in the VAR_IN_OUT declaration section.

The LOWER_BOUND and UPPER_BOUND operators are provided for determining the index limits of the actual used array at runtime.

Only statically declared arrays (not arrays generated by means of the operator __NEW) may be passed to an array with variable length.
Syntax of the declaration of a one-dimensional array of variable length

```plaintext
<variable name> :  ARRAY[*] OF <data type> ( := <initialization> )? ;
```

Syntax of the declaration of a multi-dimensional array of variable length

```plaintext
<variable name> :  ARRAY[* ( , * )+ ] OF <data type> ( := <initialization> )? ;
```

Syntax of the operators for calculating the limit index

```plaintext
LOWER_BOUND( <variable name> , <dimension number> )
UPPER_BOUND( <variable name> , <dimension number> )
```

Example

The `SUM` function adds the integer values of the array elements and returns the calculated sum as a result. The sum is calculated across all array elements available at runtime. As the actual number of array elements will only be known at runtime, the local variable is declared as a one-dimensional array of variable length.

```plaintext
FUNCTION SUM: INT;
VAR_IN_OUT
    aiData : ARRAY[*] OF INT;
END_VAR
VAR
    diCounter : DINT;
    iResult : INT;
END_VAR

iResult := 0;
FOR diCounter := LOWER_BOUND(aiData, 1) TO UPPER_BOUND(aiData, 1) DO // Calculates the length of the current array
    iResult := iResult + aiData[diCounter];
END_FOR;
SUM := iResult;
```

See also
- § Chapter 6.4.1.9.4.4 “Declaring arrays” on page 1853
- § Chapter 6.4.1.21.22.2 “POU 'CheckBounds'” on page 2502

Data Type '_VECTOR'

Vector operations are supported natively only on 64-bit processors and offer a performance advantage only on these processors. The data sheet of the controller provides information about the processor used on the controller. Currently, vector operations on the x86/64-bit platforms with SSE2 and ARM64 with NEON are supported natively. On all other platforms, vector operations are translated into individual statements. For example, vector addition is then executed with multiple single addition operations.
The command set extensions of the processors are SIMD extensions. SIMD (Single Instruction, Multiple Data) describes a computer architecture in which multiple data sets of the same type are processed simultaneously in parallel and therefore faster with one command call. In vector operations, for example, 4 pairs of numbers can then be added at the same time.

Syntax

<variable name> : __VECTOR[ <vector size> ] OF <element type> ( := <initialization> )? ;

<vector size> : 1 | 2 | 3 | 4 | 5 | 6 | 7 | 8
<element type> : REAL | LREAL

// (...)? : Optional

A vector data type is an array of floating-point numbers with a maximum of 8 elements. The operators __vc<operator name> are available for this data type. You can use these to implement vector operations without additional function calls.

Syntax for index access

<variable name>[ <index> ]

<index> : 0 | 1 | 2 | 3 | 4 | 5 | 6 | 7

When indexing a vector variable, you can access a single element of the vector. The index starts at 0 and goes until <vector size> - 1.

Example

```plaintext
PROGRAM PLC_PRG
VAR
   vcA : __VECTOR[3] OF REAL;
END_VAR

vcA[0] := 1.1;
vcA[1] := 2.2;
vcA[2] := 3.3;
```

Determining the optimal vector size

Use the optimal vector size depending on your target system as the vector size in order to program the most efficient code possible.

For target systems whose computer architecture is generally suitable for vector processing, we do not recommend using vectors of arbitrary size. There is an optimal vector size depending on the type of data processing of the processor. Vectors that are declared with this array size are processed as quickly as possible. Vectors that are declared as a larger array do not have an advantage in speed. Vectors that are declared as smaller arrays do not take full advantage of the processor's capabilities.

You can query the optimal size at runtime. You can find the information in the constants Constants.vcOptimalREAL (for vectors with REAL elements) and Constants.vcOptimalLREAL (for vectors with LREAL elements). The constants have the LREAL data type. If a constant returns the value 1 as the optimal value, then this means that accelerated vector processing is not available for the target system.
Example

PROGRAM PLC_PRG
VAR
  iOVS_REAL : INT; // Optimal vector size for REAL elements
  iOVS_LREAL : INT; // Optimal vector size for LREAL elements
END_VAR

iOVS_REAL := Constants.vcOptimalREAL;
'iOVS_LREAL := Constants.vcOptimalLREAL;

An application that is loaded on the CODESYS Control Win V3 x64 target system returns the following values at runtime:

![Table showing values](image)

Operator __VCADD
Syntax

<vector variable> := <1st vector operand> __VCADD <2nd vector operand>;

Example of addition

FUNCTION_BLOCK FB_ADD
VAR
  vcA : __VECTOR[3] OF REAL := __VCSET_REAL(3, 3, 3);
  vcB : __VECTOR[3] OF REAL := __VCSET_REAL(1, 2, 3);
  vcResult : __VECTOR[3] OF REAL;
END_VAR

vcResult := vcA __VCADD vcB;

Operator __VCSUB
Syntax

<vector variable> := <vector minuend> __VCSUB <vector subtrahend>;

The operator calculates the sum of two vectors.

The operator calculates the difference between two vectors.
Example of subtraction

```plaintext
FUNCTION_BLOCK FB_SUB
VAR
  vcA : __VECTOR[3] OF REAL := __VCSET_REAL(3, 3, 3);
  vcB : __VECTOR[3] OF REAL := __VCSET_REAL(1, 2, 3);
  vcResult0 : __VECTOR[3] OF REAL;
  vcResult1 : __VECTOR[3] OF REAL;
END_VAR

vcResult0 := vcA __VCSUB vcB;
vcResult1 := vcB __VCSUB vcA;
```

Operator __VCMUL

The operator calculates the product of two vectors or a scalar (floating-point number) and a vector.

Syntax

```plaintext
<vector variable> := <1st vector operand> __VCMUL <2nd vector operand> | <scalar operand> __VCMUL <vector operand> | <vector operand> __VCMUL <scalar operand> ;
```

Example of multiplication

```plaintext
FUNCTION_BLOCK FB_MUL
VAR
  rScalar : REAL := 1.1;
  vcA : __VECTOR[3] OF REAL;
  vcB : __VECTOR[3] OF REAL;
  vcResult0 : __VECTOR[3] OF REAL;
  vcResult1 : __VECTOR[3] OF REAL;
END_VAR

vcResult0 := vcA __VCMUL vcB;
vcResult1 := rScalar __VCMUL vcB;
vcResult2 := vcA __VCMUL 3.3;
```

Operator __VCDIV

The operator calculates the quotient of two vectors or a vector and a scalar.

Syntax

```plaintext
<vector variable> := <vector dividend> __VCDIV <vector divisor> | <vector dividend> __VCMUL <scalar divisor> ;
```
Example of division

FUNCTION_BLOCK FB_DIV
VAR
  iScalar : INT := 3;
  rScalar : REAL := 1.5;
  vcA : __VECTOR[3] OF REAL := __VCSET_REAL(3, 3, 3);
  vcB : __VECTOR[3] OF REAL := __VCSET_REAL(1, 2, 3);
  vcResult0 : __VECTOR[3] OF REAL;
  vcResult1 : __VECTOR[3] OF REAL;
END_VAR
vcResult0 := vcA __VCDIV vcB;
// ERROR CODE vcResult1 := rScalar __VCDIV vcB;
// ERROR CODE vcResult1 := iScalar __VCDIV vcB;
// ERROR CODE vcResult1 := 3.3 __VCDIV vcB;
vcResult2 := vcA __VCDIV 1.5;
vcResult2 := vcA __VCDIV iScalar;
vcResult2 := vcA __VCDIV rScalar;

Operator __VCDOT

Syntax

<scalar variable> := <1st vector operand> __VCDOT <2nd vector operand> ;

Example of a dot product

FUNCTION_BLOCK FB_DOT
VAR
  rResult : REAL;
  vcA : __VECTOR[3] OF REAL := __VCSET_REAL(3, 3, 3);
  vcB : __VECTOR[3] OF REAL := __VCSET_REAL(1, 2, 3);
END_VAR
rResult := vcA __VCDOT vcB; // = 18

Operator __VCSQRT

Syntax

<vector variable> := __VCSQRT( <vector operand> );

Example of a square root

FUNCTION_BLOCK FB_SQRT
VAR
  vcA : __VECTOR[3] OF REAL := __VCSET_REAL(4, 9, 16);
END_VAR
vcResult0 := __VCSQRT(vcA);
The operator calculates the maximum vector of two vectors. The maximum is determined element by element.

**Syntax**

\[ <\text{vector variable}> := \text{__VCMAX}( <\text{1st vector operand}>, <\text{2nd vector operand}>); \]

**Example of a maximum vector**

```plaintext
FUNCTION_BLOCK FB_MAX
VAR
  vcA : __VECTOR[3] OF REAL := __VCSET_REAL(3, 3, 3);
  vcB : __VECTOR[3] OF REAL := __VCSET_REAL(1, 2, 6);
  vcResult0 : __VECTOR[3] OF REAL;
END_VAR
vcResult0 := __VCMAX(vcA, vcB);
```

The operator calculates the minimum vector of two vectors. The minimum is determined element by element.

**Syntax**

\[ <\text{vector variable}> := \text{__VCMIN}( <\text{1st vector operand}>, <\text{2nd vector operand}>); \]

**Example of a minimum vector**

```plaintext
FUNCTION_BLOCK FB_MIN
VAR
  vcA : __VECTOR[3] OF REAL := __VCSET_REAL(3, 3, 3);
  vcB : __VECTOR[3] OF REAL := __VCSET_REAL(1, 2, 6);
  vcResult0 : __VECTOR[3] OF REAL;
END_VAR
vcResult0 := __VCMIN(vcA, vcB);
```

The operator sets all elements of a vector in a statement. The elements have the REAL data type.

**Syntax**

\[ <\text{vector variable}> := \text{__VCSET_REAL}( <\text{first literal}>, ( <\text{next literal}>)^+) ; ( ... )^+ // number of elements have to match \]

**Example**

```plaintext
FUNCTION_BLOCK FB_SET
VAR
  vcA : __VECTOR[3] OF REAL := __VCSET_REAL(3, 3, 3);
  vcB : __VECTOR[3] OF REAL := __VCSET_REAL(1, 2, 3);
END_VAR
vcA := __VCSET_REAL(4, 4, 4);
vcB := __VCSET_REAL(1.1, 2.2, 3.3);
```
The operator sets all elements of a vector at once in a statement. The elements have the \texttt{LREAL} data type.

They can be used wherever variables are valid, such as in assignments in implementations or as parameters in function calls.

\texttt{<vector variable>} := \texttt{\_VCSET\_LREAL( <first literal>, ( <next literal> )+ )};
\texttt{(...)+} // number of elements have to match

**Example**

\begin{verbatim}
FUNCTION_BLOCK FB_SET
VAR
  vc1A : __VECTOR[3] OF LREAL := __VCSET\_LREAL(3, 3, 3);
  vc1B : __VECTOR[3] OF LREAL := __VCSET\_LREAL(1, 2, 3);
END_VAR
vc1A := __VCSET\_LREAL(-1.7976931348623158E+308, 0.0, 1.7976931348623158E+308);
vc1B := __VCSET\_LREAL(-1.7976931348623158E+308, 0.0, 1.7976931348623158E+308);
\end{verbatim}

The operator interprets any arbitrary memory area as a vector. This is helpful for connecting vector variables to existing code. The operator requires 2 parameters. The first parameter indicates the number of vector elements. The second parameter is a pointer to the \texttt{REAL} data.

\texttt{<vector variable>} := \texttt{\_VCLOAD\_REAL( <vector size>, <pointer to data of type REAL> )};

\begin{verbatim}
VECTOR size : 2 | 3 | 4 | 5 | 6 | 7 | 8
\end{verbatim}

**Example of vectorization**

\begin{verbatim}
FUNCTION_BLOCK FB_LOAD
VAR_INPUT
  rData0 : REAL := 1.234;
  rData1 : REAL := 5.678;
  rData2 : REAL := 9.123;
  pData : POINTER TO REAL := ADR(rData0);
VAR_OUTPUT
  vcA : __VECTOR[3] OF REAL := __VCSET\_REAL(3, 3, 3);
END_VAR
vcA := __VCLOAD\_REAL(3, pData);
\end{verbatim}

The operator interprets any arbitrary memory area as a vector. This is helpful for connecting vector variables to existing code. The operator requires 2 parameters. The first parameter indicates the number of vector elements. The second parameter is a pointer to the \texttt{LREAL} data.

\texttt{<vector variable>} := \texttt{\_VCLOAD\_LREAL( <vector size>, <pointer to data of type LREAL> )};

\begin{verbatim}
NUMBER OF VECTOR ELEMENTS : 1 | 2 | 3 | 4 | 5 | 6 | 7 | 8
\end{verbatim}
Example of vectorization

```plaintext
FUNCTION_BLOCK FB_LOAD
VAR_INPUT
END_VAR
VAR_OUTPUT
END_VAR
VAR
  lrData0 : LREAL := -1.7976931348623158E+308;
  lrData1 : LREAL := 1.6E+308;
  lrData2 : LREAL := 1.7E+308;
  lrData3 : LREAL := -1.6E+308;
  plData: POINTER TO LREAL := ADR(lrData0);
  vclA : __VECTOR[4] OF LREAL := __VCSET_LREAL(4, 4, 4, 4);
END_VAR
vclA := __VCLOAD_LREAL(4, plData);
```

Example of storage

```plaintext
FUNCTION_BLOCK FB_STORE
VAR_INPUT
END_VAR
VAR_OUTPUT
END_VAR
VAR
  rData0 : REAL := 3;
  rData1: REAL := 3;
  rData2 : REAL := 3;
  pData: POINTER TO REAL := ADR(rData0);

  lrData0 : LREAL := 4;
  lrData1: LREAL := 4;
  lrData2 : LREAL := 4;
  lrData3 : LREAL := 4;
  plData: POINTER TO LREAL := ADR(lrData0);

  vcA : __VECTOR[3] OF REAL := __VCSET_REAL( 1.234, 5.678, 9.123);
  vclA : __VECTOR[4] OF LREAL :=
    __VCSET_LREAL(-1.7976931348623158E+308, 1.6E+308, 1.7E+308,
    -1.6E+308);
END_VAR
__VCSTORE(pData, vcA);
__VCSTORE(plData, vclA);
```

See also

- ☀ Chapter 6.4.1.9.4.4 “Declaring arrays” on page 1853
- ☀ Chapter 6.4.1.21.22.22 “POU ‘CheckBounds’” on page 2502
Structure

A structure is a user-defined data type, which combines multiple variables of any data type into a logical unit. The variables declared within a structure are called members.

You make the type declaration of a structure in a “DUT” object which you create in the “Project ➔ Add Object ➔ DUT” menu or in the context menu of an application.

Syntax

```
TYPE <structure name> :
  STRUCT
    ( <variable declaration optional with initialization> )+
  END_STRUCT
END_TYPE
```

<structure name> is an identifier which is valid in the entire project so that you can use it like a standard data type. Moreover, you can declare any number of variables (at least one) which are supplemented optionally by an initialization.

Structures can also be nested. This means that you declare a structure member with an existing structure type. Then the only restriction is that you must not assign any address to the variable (structure member). (The AT declaration is not permitted here.)

Example

Type declaration

```
TYPE S_POLYGONLINE :
  STRUCT
    aiStart : ARRAY[1..2] OF INT := [-99, -99];
    aiPoint1 : ARRAY[1..2] OF INT;
    aiPoint2 : ARRAY[1..2] OF INT;
    aiPoint3 : ARRAY[1..2] OF INT;
    aiPoint4 : ARRAY[1..2] OF INT;
    aiEnd : ARRAY[1..2] OF INT := [99, 99];
  END_STRUCT
END_TYPE
```

Extension of a type declaration

An additional structure is declared from an existing structure. In addition to its own members, the extended structure also has the same structure members as the base structure.

Syntax

```
TYPE <structure name> EXTENDS <basis structure> :
  STRUCT
    ( <variable declaration optional with initialization> )+
  END_STRUCT
END_TYPE
```

Example

Type declaration

```
TYPE S_PENTAGON EXTENDS S_POLYGONLINE :
  STRUCT
    aiPoint5 : ARRAY[1..2] OF INT;
  END_STRUCT
END_TYPE
```
### Declaration and initialization of structure variables

**Example**

```plaintext
PROGRAM progLine
VAR
  sPolygon : S_POLYGONLINE := (aiStart:=\[1,1\], aiPoint1:=\[5,2\],
  aiPoint2:=\[7,3\], aiPoint3:=\[8,5\], aiPoint4:=\[5,7\], aiEnd:=\[1,1\]);
  sPentagon : S_PENTAGON := (aiStart:=\[0,0\], aiPoint1:=\[1,1\],
  aiPoint2:=\[2,2\], aiPoint3:=\[3,3\], aiPoint4:=\[4,4\], aiPoint5:=\[5,5\],
  aiEnd:=\[0,0\]);
END_VAR
```

You must not permitted to use initializations with variables. For an example of initializing an array of a structure, see the help page for the data type `ARRAY`.

**Access to a structure member**

You access structure members with the following syntax:

```
<variable name> . <component name>
```

**Example**

```plaintext
PROGRAM prog_Polygon
VAR
  sPolygon : S_POLYGONLINE := (aiStart:=\[1,1\], aiPoint1:=\[5,2\],
  aiPoint2:=\[7,3\], aiPoint3:=\[8,5\], aiPoint4:=\[5,7\], aiEnd:=\[1,1\]);
  iPoint: INT;
  END_VAR

// Assigns 5 to aiPoint
iPoint := sPolygon.aiPoint1[1];

Result: iPoint = 5
```

### Symbolic bit access in structure variables

You can declare a structure with variables of data type `BIT` to combine individual bits into a logical unit. Then you can symbolically address individual bits by a name (instead of by a bit index).

**Syntax declaration**

```plaintext
TYPE <structure name> :
  STRUCT
    ( <bit name> : BIT; )+
  END_STRUCT
END_TYPE
```

**Syntax of bit access**

```
<structure name> . <bit name>
```
**Example**

**Type declaration**

```
TYPE S_CONTROL :
STRUCT
  bitOperationEnabled : BIT;
  bitSwitchOnActive : BIT;
  bitEnableOperation : BIT;
  bitError : BIT;
  bitVoltageEnabled : BIT;
  bitQuickStop : BIT;
  bitSwitchOnLocked : BIT;
  bitWarning : BIT;
END_STRUCT
END_TYPE
```

**Bit access**

```
FUNCTION_BLOCK FB_Controller
VAR_INPUT
  xStart : BOOL;
END_VAR
VAR_OUTPUT
END_VAR
VAR
  ControlDriveA : S_CONTROL;
END_VAR
IF xStart = TRUE THEN
  // Symbolic bit access
  ControlDriveA.bitEnableOperation := TRUE;
END_IF
```

---

References and pointers to **BIT** variables are **invalid** declarations, as well as array elements with base type **BIT**.

See also

- § Chapter 6.4.1.20.4.11 “Bit Access in Variables” on page 2229

See also

- § Chapter 6.4.1.20.5.15 “Data Type ‘ARRAY’” on page 2247
- § Chapter 6.4.1.20.5.11 “Data Type ‘BIT’” on page 2243
- § Chapter 6.4.1.21.2.9 “Object ‘DUT’” on page 2461

---

**Enumerations**

An enumeration is a user-defined data type composed of a series of comma-separated components (enumeration values) for declaring user-defined variables. Moreover, you can use the enumeration components like constants whose identifier `<enumeration name>.<component name>` is recognized globally in the project.
You declare an enumeration in a DUT object, which you have already created in the project by clicking “Add Object”.

Declaration

Syntax

```plaintext
( {attribute 'strict'} )? // Pragma optional but recommended
TYPE <enumeration name> :
{
    <first component declaration>,
    ( <component declaration> ,|) +
    <last component declaration>
}( <basic data type> )? ( := <default variable initialization> )? ;
END_TYPE

( ... )? : Optional
<component declaration> : <component name> ( := <component initialization> )?
<basic data type> : INT | UINT | SINT | USINT | DINT | UDINT | LINT |
ULINT | BYTE | WORD | DWORD | LWORD
<variable initialization> : <one of the component names>
```

In an enumeration declaration, at least 2 components are usually declared. However, you can declare as many as you want. Every single component can be assigned its own initialization. Enumerations automatically have the basic data type INT, but you can specify another basic data type. Moreover, you can specify a component in the declaration with which an enumeration variable is then initialized.

The pragma {attribute 'strict'} causes a strict type test to be performed as described below.

Example

```plaintext
{attribute 'qualified_only'}
{attribute 'strict'}
TYPE COLOR_BASIC :
{
    yellow,
    green,
    blue,
    black
} // Basic data type is INT, default initialization for all COLOR_BASIC variables is yellow
END_TYPE
```

Enumeration with explicit basic data type

Extensions to the IEC 61131-3 standard

The basic data type for an enumeration declaration is INT by default. However, you can also declare enumerations that are based explicitly on another integer data type.

```plaintext
<basic data type> : INT | UINT | SINT | USINT | DINT | UDINT | LINT |
ULINT | BYTE | WORD | DWORD | LWORD
```
Example

Enumeration with basic data type DWORD

```
TYPE COLOR :
{
  white := 16#FFFFFF00,
  yellow := 16#FFFFFF00,
  green := 16#FF00FF00,
  blue := 16#FF0000FF,
  black := 16#88000000
} DWORD := black; // Basic data type is DWORD, default initialization for all COLOR variables is black
END_TYPE
```

Strict programming rules

**NOTICE!**
In CODESYS V3.5 SP7 and later, the pragma `attribute 'strict'` is added automatically in the first line when declaring an enumeration.

The strict programming rules are activated when adding the pragma `attribute 'strict'`.

The following code is considered a compiler error:

- Arithmetic operations with enumeration components
  For example, an enumeration variable cannot be used as a counter variable in a `FOR` loop.
- Assignment of a constant value, which does not correspond to an enumeration value, to an enumeration component
- Assignment of a non-constant variable, which has another data type as the enumeration, to an enumeration component

Arithmetic operations can lead to undeclared values being assigned to enumeration components. A better programming style is to use `SWITCH/CASE` statements for processing component values.

Declaration and initialization of enumeration variables

**Syntax**

```
<variable name> : <enumeration name> ( := <initialization> )? ;
```

For a declaration of an enumeration variable with user-defined data type `<enumeration name>`, this can be initialized with an enumeration component.

Example

```
PROGRAM PLC_PRG
VAR
  colorCar : COLOR;
  colorTaxi : COLOR := COLOR.yellow;
END_VAR

The variable `colorCar` is initialized with `COLOR.black`. That is the default initialization for all enumeration variables of type `COLOR` and defined this way in the type declaration. The variable `colorTaxi` has its own initialization.

If no initializations are specified, then the initialization value is 0.
```
The variable `cbFlower` is initialized with `COLOR_BASIC.yellow`. That is the default initialization for all enumeration variables of type `COLOR_BASIC`. Because the enumeration declaration does not specify a component for initialization, the system automatically initializes with the component that has the value 0. This is usually the first of the enumeration components. However, it can also be another component that is not in the first position but explicitly initialized with 0.

The variable `cbTree` has an explicit initialization.

If no value is specified for both the type and the variable, then the following rule applies: If an enumeration contains a value for 0, then this value is the default initialization, and if not, then the first component in the list.

The variable `e` is initialized with `ENUM.e2`.

The variable `e2` is initialized with `ENUM.e1`.

Extensions to the IEC 61131-3 standard

The enumeration components can also be used as constant variables with the identifier `<enumeration name>.<component name>`. Enumeration components are recognized globally in the project and access to them is unique. Therefore, a component name can be used in different enumerations.
PROGRAM PLC_PRG
VAR
  cbFlower : COLOR_BASIC;
  colorCar : COLOR;
END_VAR

(* unambiguous identifiers although the component names are identical *)
cbFlower := COLOR_BASIC.blue;
colorCar := COLOR.blue;

(* invalid code *)
cbFlower := blue;
colorCar := blue;

See also
- § Chapter 6.4.1.20.3.73 “Operator - Enumeration namespace” on page 2217

Alias

An alias is a user-defined data type with which an alternative name for a basic type, data type, or function block is generated.

You make the type declaration of an alias in a “DUT” object which you create in the “Project ➔ Add Object ➔ DUT” menu or in the context menu of an application.

Syntax

```plaintext
TYPE <DUT name> : <basic type> | <data type> | <function block name> ;
END_TYPE
```

Example

```plaintext
FUNCTION_BLOCK FB_Machine
VAR_INPUT
END_VAR
VAR_OUTPUT
END_VAR
VAR
  iCounter : INT;
END_VAR
iCounter := iCounter + 1;

// Alias for FB_Machine
TYPE A_ROBOT : FB_Machine;
END_TYPE

PROGRAM prog_Robot
VAR
  fbRobot : A_ROBOT;
END_VAR
fbRobot();
```
Data type 'UNION'

A UNION is a data structure that usually contains different data types.

In a union, all components have the same offset and therefore the same amount of memory. In the following declaration example of a union, an assignment to name.a will also affect name.b.

Example

```plaintext
TYPE name:
  UNION
      a : LREAL;
      b : LINT;
  END_UNION
END_TYPE
```

Subrange types

A subrange type is a data type whose value range is a subset of a base type.

Syntax for the declaration:

```
<name> : <int type> (<lower limit>..<upper limit>);
```

<table>
<thead>
<tr>
<th>&lt;name&gt;</th>
<th>valid IEC identifier</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;int type&gt;</td>
<td>data type of the subrange</td>
</tr>
<tr>
<td></td>
<td>(SINT, USINT, INT, UINT, DINT, UDINT, BYTE, WORD, DWORD, LINT, ULINT, LWORD).</td>
</tr>
<tr>
<td>&lt;lower limit&gt;</td>
<td>Lower limit of the range: constants that have to be compatible with the basic data type. The lower limit is also included in this range.</td>
</tr>
<tr>
<td>&lt;upper limit&gt;</td>
<td>Upper limit of the range: constants that have to be compatible with the base data type. The upper limit is also included in this range.</td>
</tr>
</tbody>
</table>

Examples:

```plaintext
VAR
  i : INT (-4095..4095);
  ui : UINT (0..10000);
END_VAR
```

If you assign a value to a subrange type in the declaration or implementation section that is not within this range (example: i:=5000), then CODESYS issues an error message.

Please note: In runtime mode, it is possible to monitor the range limits of a subrange type by using the implicit monitoring functions CheckRangeSigned and CheckRangeUnsigned.

See also

- § Chapter 6.4.1.21.2.22.8 “POU 'CheckLRangeSigned'” on page 2510
- § Chapter 6.4.1.21.2.22.10 “POU 'CheckLRangeUnsigned'” on page 2512


### Pragmas

<table>
<thead>
<tr>
<th>Section</th>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.4.1.20.6</td>
<td>General</td>
<td>2269</td>
</tr>
<tr>
<td>6.4.1.20.6.2</td>
<td>Message Pragmas</td>
<td>2269</td>
</tr>
<tr>
<td>6.4.1.20.6.3</td>
<td>Attribute Pragmas</td>
<td>2271</td>
</tr>
<tr>
<td>6.4.1.20.6.4</td>
<td>Conditional Pragmas</td>
<td>2318</td>
</tr>
<tr>
<td>6.4.1.20.6.5</td>
<td>Region Pragma</td>
<td>2327</td>
</tr>
</tbody>
</table>

#### General

Pragma instructions affect the properties of one or more variables with regard to the compilation or pre-compilation process. Various categories of pragmas are available to you for this.

Pragma are special statements that influence the behavior of an AC500 V3 project during compilation (build) and precompilation. The basic functionalities and use cases for AC500 V3 PLCs are described in the application note *AC500 V3 Using Pragmas*.

#### Message Pragmas

Message pragmas serve to force the display of messages in the Message window during the compilation process.

Insertion position: separate or already existing line in the text editor of a POU.

**Table 400: 4 types of message pragmas**

<table>
<thead>
<tr>
<th>Pragma</th>
<th>Message type</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>{text '&lt;textstring&gt;'}</code></td>
<td>&quot;Text&quot; : display of &lt;textstring&gt;.</td>
</tr>
<tr>
<td><code>{info '&lt;textstring&gt;'}</code></td>
<td>&quot;Information&quot; : display of &lt;textstring&gt;.</td>
</tr>
<tr>
<td><code>{warning '&lt;textstring&gt;'}</code></td>
<td>&quot;Warning&quot; : display of &lt;textstring&gt;.</td>
</tr>
<tr>
<td><code>{error '&lt;textstring&gt;'}</code></td>
<td>&quot;Error&quot; : display of &lt;textstring&gt;.</td>
</tr>
</tbody>
</table>

In the CODESYS Message window you can jump with the help of the commands “Next Message” and “Previous Message” from a message of the category “Information”, “Warning” and “Error” to the source position of the message. This means you jump to the position where the pragma is added in the source code.
Example

VAR
    var : INT; {info 'TODO: should get another name'}
    bvar : BOOL;
    arrTest : ARRAY [0..10] OF INT;
    i:INT;
END_VAR

arrTest[i] := arrTest[i]+1;
ivar:=ivar+1;

{warning 'This is a warning'}
{text 'Part xy has been compiled completely'}

Display in the Message window:

<table>
<thead>
<tr>
<th>Description</th>
<th>Project</th>
<th>Object</th>
<th>Position</th>
</tr>
</thead>
<tbody>
<tr>
<td>------ Build started: Application: Res.App2 ------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>typedef code ...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Compile time before typification: 6 ms</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Compile time after typification: 15 ms</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TODO: should get another name!</td>
<td>TS pragma NewPOU</td>
<td>Line 3 (Decl)</td>
<td></td>
</tr>
<tr>
<td>This is a warning</td>
<td>TS pragma NewPOU</td>
<td>Line 7 (Impl)</td>
<td></td>
</tr>
<tr>
<td>Part xy has been compiled completely</td>
<td>TS pragma NewPOU</td>
<td>Line 10 (Impl)</td>
<td></td>
</tr>
<tr>
<td>Compile complete -- 1 errors, 2 warnings</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.1.20.6.4 “Conditional Pragmas” on page 2318
### Attribute Pragmas

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.4.1.20.6.3.1</td>
<td>General...</td>
<td>2271</td>
</tr>
<tr>
<td>6.4.1.20.6.3.2</td>
<td>User-defined attributes...</td>
<td>2272</td>
</tr>
<tr>
<td>6.4.1.20.6.3.3</td>
<td>Attribute 'call_after_global_init_slot'</td>
<td>2273</td>
</tr>
<tr>
<td>6.4.1.20.6.3.4</td>
<td>Attribute 'call_after_init'</td>
<td>2273</td>
</tr>
<tr>
<td>6.4.1.20.6.3.5</td>
<td>Attribute 'call_after_online_change_slot'</td>
<td>2274</td>
</tr>
<tr>
<td>6.4.1.20.6.3.6</td>
<td>Attribute 'call_before_global_exit_slot'</td>
<td>2275</td>
</tr>
<tr>
<td>6.4.1.20.6.3.7</td>
<td>Attribute 'call_on_type_change'</td>
<td>2275</td>
</tr>
<tr>
<td>6.4.1.20.6.3.8</td>
<td>Attribute 'conditionalshow'</td>
<td>2276</td>
</tr>
<tr>
<td>6.4.1.20.6.3.9</td>
<td>Attribute 'conditionalshow_all_locals'</td>
<td>2277</td>
</tr>
<tr>
<td>6.4.1.20.6.3.10</td>
<td>Attribute 'const_replaced', Attribute 'const_non_replaced'...</td>
<td>2278</td>
</tr>
<tr>
<td>6.4.1.20.6.3.11</td>
<td>Attribute 'dataflow'</td>
<td>2279</td>
</tr>
<tr>
<td>6.4.1.20.6.3.12</td>
<td>Attribute 'displaymode'</td>
<td>2280</td>
</tr>
<tr>
<td>6.4.1.20.6.3.13</td>
<td>Attribute 'enable_dynamic_creation'</td>
<td>2281</td>
</tr>
<tr>
<td>6.4.1.20.6.3.14</td>
<td>Attribute 'estimated-stack-usage'</td>
<td>2281</td>
</tr>
<tr>
<td>6.4.1.20.6.3.15</td>
<td>Attribute 'ExpandFully'</td>
<td>2284</td>
</tr>
<tr>
<td>6.4.1.20.6.3.16</td>
<td>Attribute 'global_init_slot'</td>
<td>2285</td>
</tr>
<tr>
<td>6.4.1.20.6.3.17</td>
<td>Attribute 'hide'</td>
<td>2286</td>
</tr>
<tr>
<td>6.4.1.20.6.3.18</td>
<td>Attribute 'hide_all_locals'</td>
<td>2289</td>
</tr>
<tr>
<td>6.4.1.20.6.3.19</td>
<td>Attribute 'initialize_on_call'</td>
<td>2290</td>
</tr>
<tr>
<td>6.4.1.20.6.3.20</td>
<td>Attribute 'init_namespace'</td>
<td>2291</td>
</tr>
<tr>
<td>6.4.1.20.6.3.21</td>
<td>Attribute 'init_on_onlchange'</td>
<td>2291</td>
</tr>
<tr>
<td>6.4.1.20.6.3.22</td>
<td>Attribute 'instance-path'</td>
<td>2292</td>
</tr>
<tr>
<td>6.4.1.20.6.3.23</td>
<td>Attribute 'io_function_block', 'io_function_block_mapping'...</td>
<td>2293</td>
</tr>
<tr>
<td>6.4.1.20.6.3.24</td>
<td>Attribute 'is_connected'</td>
<td>2293</td>
</tr>
<tr>
<td>6.4.1.20.6.3.25</td>
<td>Attribute 'linkalways'</td>
<td>2294</td>
</tr>
<tr>
<td>6.4.1.20.6.3.26</td>
<td>Attribute 'monitoring'</td>
<td>2295</td>
</tr>
<tr>
<td>6.4.1.20.6.3.27</td>
<td>Attribute 'monitoring_encoding'</td>
<td>2297</td>
</tr>
<tr>
<td>6.4.1.20.6.3.28</td>
<td>Attribute 'no_assign', Attribute 'no_assign_warning'...</td>
<td>2298</td>
</tr>
<tr>
<td>6.4.1.20.6.3.29</td>
<td>Attribute 'no_check'</td>
<td>2298</td>
</tr>
<tr>
<td>6.4.1.20.6.3.30</td>
<td>Attribute 'no_copy'</td>
<td>2299</td>
</tr>
<tr>
<td>6.4.1.20.6.3.31</td>
<td>Attribute 'no-exit'</td>
<td>2299</td>
</tr>
<tr>
<td>6.4.1.20.6.3.32</td>
<td>Attribute 'noinit'</td>
<td>2299</td>
</tr>
<tr>
<td>6.4.1.20.6.3.33</td>
<td>Attribute 'no_instance_in_retain'</td>
<td>2300</td>
</tr>
<tr>
<td>6.4.1.20.6.3.34</td>
<td>Attribute 'no_virtual_actions'</td>
<td>2300</td>
</tr>
<tr>
<td>6.4.1.20.6.3.35</td>
<td>Attribute 'pingroup'</td>
<td>2302</td>
</tr>
<tr>
<td>6.4.1.20.6.3.36</td>
<td>Attribute 'pin_presentation_order_inputs/outputs'...</td>
<td>2303</td>
</tr>
<tr>
<td>6.4.1.20.6.3.37</td>
<td>Attribute 'obsolete'</td>
<td>2304</td>
</tr>
<tr>
<td>6.4.1.20.6.3.38</td>
<td>Attribute 'pack_mode'</td>
<td>2305</td>
</tr>
<tr>
<td>6.4.1.20.6.3.39</td>
<td>Attribute 'ProcessValue'</td>
<td>2312</td>
</tr>
<tr>
<td>6.4.1.20.6.3.40</td>
<td>Attribute 'qualified_only'</td>
<td>2312</td>
</tr>
<tr>
<td>6.4.1.20.6.3.41</td>
<td>Attribute 'reflection'</td>
<td>2313</td>
</tr>
<tr>
<td>6.4.1.20.6.3.42</td>
<td>Attribute 'subsequent'</td>
<td>2313</td>
</tr>
<tr>
<td>6.4.1.20.6.3.43</td>
<td>Attribute 'symbol'</td>
<td>2314</td>
</tr>
<tr>
<td>6.4.1.20.6.3.44</td>
<td>Attribute 'to_string'</td>
<td>2314</td>
</tr>
<tr>
<td>6.4.1.20.6.3.45</td>
<td>Attribute 'warning disable', attribute 'warning restore'...</td>
<td>2315</td>
</tr>
<tr>
<td>6.4.1.20.6.3.46</td>
<td>Effects of Pragmas on Symbols</td>
<td>2315</td>
</tr>
</tbody>
</table>

### General

Attribute pragmas affect the compilation and the pre-compilation.
CODESYS supports a series of pre-defined attribute pragmas. In addition you can use user-defined pragmas, which you can query with the help of conditional pragmas before the compilation of the project.

Attributes are defined within the declaration part. Exception: For the objects Action and Transition, which have no own declaration part, you can define the attributes at the beginning of the implementation part.

When you define own attributes, please make them unambiguous. Uniqueness can be reached for example by adding a prefix to the attribute name. OEMs can use the vendor prefix for this purpose.

User-defined attributes

User-defined attributes are any application-defined or user-defined attributes that you can apply to POUs, actions, data type definitions and variables. You can query a user-defined attribute with the help of conditional pragmas before the compilation of the application.

You can query user-defined attributes with conditional pragmas with the operator hasattribute.

More detailed information and examples can be found in the chapter 'Conditional pragmas'.

Syntax:

\{attribute 'attribute'\}

Example for POUs and actions

Attribute 'vision' for function “fun1”

```plaintext
{attribute 'vision'}
FUNCTION fun1 : INT
VAR_INPUT
  i : INT;
END_VAR
```

Example for variables

Attribute 'DoCount' for variable ivar:

```plaintext
PROGRAM PLC_PRG
VAR
  {attribute 'DoCount'};
  ivar:INT;
  bvar:BOOL;
END_VAR
```
Example for data types

Attribute 'aType' for data type DUT_1:

```cpp
{attribute 'aType'}
TYPE DUT_1 :
  STRUCT
    a:INT;
    b:BOOL;
  END_STRUCT
END_TYPE
```

See also

- Chapter 6.4.1.20.6.4 “Conditional Pragmas” on page 2318

Attribute 'call_after_global_init_slot'

**NOTICE!**

VAR_INPUT declarations in functions or methods that use the attribute lead to compile errors. Reason: Input variables are unknown in this case at the time of the call, which occurs implicitly during the online change.

The effect of this pragma is that all functions and programs containing this attribute are called after the global initialization. You define the order of calling by means of the attribute value.

Syntax:

```cpp
{attribute 'call_after_global_init_slot' := '<slot>'}
```

<slot>: Integer value that defines the ranking in the order of the calls; the lower the value, the earlier the call takes place. If several function blocks have the same ranking for the attribute, then the order of their calls remains indefinite.

Insert location: First line above the declaration part of functions and programs

If a method possesses the attribute, CODESYS determines all instances of the corresponding function block and calls all instances in the specified slot. In this case you have no influence on the order of the instances among themselves.

See also

- Chapter 6.4.1.20.10 “Methods 'FB_Init', 'FB_Reinit', and 'FB.Exit'” on page 2336

Attribute 'call_after_init'

**NOTICE!**

VAR_INPUT declarations in functions or methods that use the attribute lead to compile errors. Reason: Input variables are unknown in this case at the time of the call, which occurs implicitly during the online change.

The effect of this pragma is that a method is called implicitly after the initialization of a function block instance. For reasons of performance you must add the attribute both to the function block and to the method in its own first line above the declaration part.
Syntax:

{attribute 'call_after_init'}

Call: First line above the declaration part of the method and the function block.
CODESYS calls the method after the method FB_init and after the variable values of an initialization expression in the instance declaration have become valid.
This functionality is supported from compiler version 3.4.1.0.

Example

Definition:

{attribute 'call_after_init'}
FUNCTION_BLOCK FB
... <function block definition>

{attribute 'call_after_init'}
METHOD FB_AfterInit
... <method definition>

The definition implements, for example, the following declaration in the subsequent code processing:

inst : FB := (in1 := 99);

Code processing:

inst.FB_Init();
inst.in1 := 99;
inst.FB_AfterInit();

This allows a reaction to the user-defined initialization in FB_AfterInit.

See also

● ☞ Chapter 6.4.1.20.10 “Methods 'FB_Init', 'FB_Reinit', and 'FB_Exit'” on page 2336

Attribute 'call_after_online_change_slot'

NOTICE!

VAR_INPUT declarations in functions or methods that use the attribute lead to compile errors. Reason: Input variables are unknown in this case at the time of the call, which occurs implicitly during the online change.

The effect of this pragma is that all functions and programs containing this attribute are called after an online change. You define the order of calling by means of the attribute <slot>.

Syntax:

{attribute 'call_after_online_change_slot' := '<slot>'}

<slot>: Integer value that defines the ranking in the order of the calls; the lower the value, the earlier the call takes place. If several function blocks have the same ranking for the attribute, then the order of their calls remains indefinite.

Call: First line above the declaration part of functions and programs.
If a method possesses the attribute, then CODESYS determines all instances of the function block concerned. CODESYS calls all instances in the specified slot. In this case you have no influence on the order of the instances among themselves.
NOTICE!
Since the application cannot run during the online change, each code executed in this situation can lead to a jitter. Therefore, keep the extent of the executive code as small as possible.

See also
● § Chapter 6.4.1.21.3.7.6 “Command 'Online Change’” on page 2629

Attribute 'call_before_global_exit_slot'

NOTICE!
VAR_INPUT declarations in functions or methods that use the attribute lead to compile errors. Reason: Input variables are unknown in this case at the time of the call, which occurs implicitly during the online change.

The effect of this pragma is that all functions and programs containing this attribute in a dedicated first line of their declaration are called before the GlobalExit. The GlobalExit takes place before a new download or a reset. Function blocks provided with an FB_Exit method are affected. The order of calling is defined by means of the attribute value.

Syntax:
{attribute 'call_before_global_exit_slot' := '<slot>'}

Insert location: First line above the declaration part of functions and programs.

<slot>: Integer value that defines the ranking in the order of the calls; the lower the value, the earlier the call takes place. If several function blocks have the same ranking for the attribute, then the order of their calls remains indefinite.

If a method possesses the attribute, then the method is called for all instances of the function block concerned. CODESYS calls all instances in the specified slot. In this case you have no influence on the order of the instances among themselves.

See also
● § Chapter 6.4.1.20.10 “Methods 'FB_Init', 'FB_Reinit', and 'FB_Exit’” on page 2336

Attribute 'call_on_type_change'

With this pragma, you can mark a method of a function block A that should be called when the data type changes for one or more function blocks B, C, etc. that are referenced by A. The referencing can be defined by a pointer variable or a REFERENCE variable.

Syntax:
{attribute 'call_on_type_change' := '<name of the first referenced function block>|<name of the second referenced function block>|<name of the ... referenced function block>'}

Insert location: Line above the first line in the method declaration.
Example

Function blocks with references

FUNCTION_BLOCK FB_A
...
VAR
    var_pt: POINTER TO FB_B;
    var_ref: REFERENCE TO FB_C;
END_VAR
...

{attribute 'call_on_type_change' := 'FB_B, FB_C'}
METHOD METH_react_on_type_change : INT
VAR_INPUT
...

Method for reaction to a type change in the references FB_B and FB_C

Attribute 'conditionalshow'

The pragma has the effect that the identifiers of an integrated compiled library <library name>.compiled-library, which are decorated with the pragma, are hidden before programming an application. The POUs can be called but the variables are invisible in the CODESYS user interface.

Affected features

- Library management
- Debugging
- Input Assistant
- Function "List components"
- Monitoring
- Symbol configuration

This is useful when you develop libraries. As the library developer, you decorate function blocks or variables with the pragma. As a result, you determine which identifiers are hidden in an application after integration. If you want to show the hidden identifiers later, for example for debugging or further development of the library, you can reactivate its visibility.

Syntax

{attribute 'conditionalshow' ( := ' <some text> ' )? }

<some text>: Optional string literal to control the visibility of the identifiers decorated with this kind of pragma by means of a command-line command and this literal. When the pragma is specified without a literal, the variables in the CODESYS development environment are always hidden, regardless of how CODESYS was started. For more help about this, see the document "Library Development Summary".

Insert location: Top line in the declaration part of a function block, above a variable
## Example

**Hiding a variable**

For more examples, see the document "Library Development Summary".

```plaintext
FUNCTION_BLOCK FB_DataManager
VAR
    {attribute 'conditionalshow' := 'Library_Developer'}
    iLocal : INT;
    iCounter : INT;
END_VAR

The variable iLocal is invisible.
```

**Hiding a function block**

```plaintext
FUNCTION_BLOCK FB_DataManager
VAR
    iLocal : INT;
    iCounter : INT;
END_VAR

The identifiers FB_DataManager, iLocal, and iCounter are invisible.
```

## Visibility in case of existing source code file

When the source code file `<library name> .library` from an integrated library also exists at the same memory location (repository), the identifiers are visible despite the pragmas. That is regardless of whether or not an attribute value has been specified in the declaration.

## Command-line call to activate visibility

You can also enable the visibility of the hidden variable without a source code file by starting CODESYS with the command-line option `conditionalshowsymbols`. To enable the visibility, specify the attribute values of the pragma which are separated by commas.

### Syntax

```
codesys.exe --conditionalshowsymbols=" <some text> (,<next text>)*
"  
```

**Example**

```
codesys.exe --conditionalshowsymbols="Library_Developer"

codesys.exe --conditionalshowsymbols="Group_A,Group_B"
```

## See also

- § Chapter 6.4.1.16 “Using the Command-Line Interface” on page 2028
- § Chapter 6.4.1.20.6.3.17 “Attribute ‘hide’” on page 2286
- § Chapter 6.4.1.20.6.3.9 “Attribute ‘conditionalshow_all_locals’” on page 2277
- "Library Development Summary", "Visibility Control" Chapter

## Attribute 'conditionalshow_all_locals'

The pragma has the effect that all local variables of a library POU decorated with the pragma are hidden from application programmers. The POUs of an integrated compiled library `<library name> .compiled-library` can be called, but the variables are invisible in the CODESYS user interface.

### Affects features:

- Library management
- Debugging
- Input Assistant
- Function "List components"
- Monitoring
- Symbol configuration
This is useful when you develop libraries. As the library developer, you decorate function blocks with the pragma. As a result, you determine that their identifiers are hidden in an application after integration. If you want to show these identifiers later, for example for debugging or further development of the library, you can re-activate its visibility.

Syntax

```plaintext
{attribute 'conditionalshow_all_locals' ( := ' <some text> ' )? }
```

<some text>: Optional string literal to control the visibility of the identifiers decorated with this kind of pragma by means of a command-line command and this literal. When the pragma is specified without a literal, the variables in the CODESYS development environment are always hidden, regardless of how CODESYS was started. For more help about this, see the document "Library Development Summary".

Insert location: Top line in the declaration part of the function block.

### Example

**Hiding all local variables**

```plaintext
{attribute 'conditionalshow_all_locals' := 'Library_Developer'}
FUNCTION_BLOCK FB_DataManager
VAR
  iLocal : INT;
  iCounter : INT;
END_VAR
```

For more examples, see the document "Library Development Summary".

### Visibility in case of existing source code file

When the source code file `<library name>.library` from an integrated library also exists at the same memory location (repository), the library POU variables are visible despite the pragmas. That is regardless of whether or not an attribute value has been specified in the declaration.

### Command-line call to activate visibility

You can also enable the visibility of the hidden variable without a source code file by starting CODESYS with the command-line option `conditionalshowsymbols`. To enable the visibility, specify the attribute values of the pragma which are separated by commas.

```plaintext
codesys.exe --conditionalshowsymbols=" <some text> ( ,<next text> )* "
```

**Example**

```plaintext
codesys.exe --conditionalshowsymbols="Library_Developer"
codesys.exe --conditionalshowsymbols="Group_A,Group_B"
```

See also

- § Chapter 6.4.1.20.6.3.18 “Attribute 'hide_all_locals'” on page 2289
- § Chapter 6.4.1.20.6.3.8 “Attribute 'conditionalshow'” on page 2276
- "Library Development Summary", chapter "Visibility Control"

### Attribute 'const_replaced', Attribute 'const_non_replaced'

The attribute 'const_replaced' has the effect that the constant is replaced in the code, independently of the setting of the “Replace constants” compiler option. The attribute has an effect for variables of scalar types only, but not for compound types like arrays and structures.

You insert the pragma `{attribute 'const_non_replaced'}` accordingly in order to explicitly deactivate the “Replace constants” compiler option. This has the effect, for example in the symbol configuration, that the constant is available and can be exported despite the compiler option.
The “Replace constants” option in the “Compile Options” category of the “Project Settings” dialog is preset for the entire project, because replacing constants generally leads to faster code and less memory usage.

**Syntax:**

{attribute 'const_replaced'}
{attribute 'const_non_replaced'}

Insert location: Line above the declaration line of the global variables.

---

**Example**

The constants `iTestCon` and `xTestCon` are available in the symbol configuration because the “Replace constants” option deactivated.

```plaintext
{attribute 'qualified_only'}
VAR_GLOBAL CONSTANT
    {attribute 'const_non_replaced'}
iTestCon : INT := 12;
{xattribute 'const_non_replaced'}
xTestCon : BOOL := TRUE;
rTestCon : REAL := 1.5;
END_VAR

VAR_GLOBAL
    iTestVar : INT := 12;
{xattribute 'const_non_replaced'}
xTestVar : BOOL := TRUE;
END_VAR
```

---

**Attribute 'dataflow'**

With this pragma you control the data flow in the processing of function blocks in the FBD/LD/IL editor. The attribute defines the input or output of a function block to which the continuing connection to the next or previous function block is connected.

You may provide only 1 input and 1 output with the attribute in the declaration of a function block.

**Syntax:**

{attribute 'dataflow'}

Insertion position: line above the line with the declaration of the corresponding variables.

In the case of function blocks without the attribute `dataflow`, CODESYS determines the data flow as follows: first of all the connection is placed between an output and an input of same data type. The highest input or output variable of the function blocks is always taken. If there are no variables of a corresponding data type, CODESYS connects the highest output with the highest input of the neighboring function blocks.

---
The connection between FB and the preceding function block is established via the input variable i1. The connection between FB and the following function block is established via the output variable outRes1.

```
FUNCTION_BLOCK FB
VAR_INPUT
  r1 : REAL;
  {attribute 'dataflow'}
  i1 : INT;
  i2 : INT;
  r2 : REAL;
END_VAR

VAR_OUTPUT
  {attribute 'dataflow'}
  outRes1 : REAL;
  out1 : INT;
  g1 : INT;
  g2 : REAL;
END_VAR
```

See also

- Chapter 6.4.1.9.5.2.2 “Programming function block diagrams (FBD)” on page 1862

**Attribute 'displaymode'**

With this pragma you define the display mode of an individual variable. This definition overwrites the global setting for the display of the monitoring variable, which takes place via the commands in the menu “Debug ➔ Display Mode”.

**Syntax:**

```
{attribute 'displaymode':=<displaymode>}
```

The following definitions are possible

- **Binary format**
  - {attribute 'displaymode':='bin'}
  - {attribute 'displaymode':='binary'}

- **Decimal format**
  - attribute 'displaymode':='dec'}
  - {attribute 'displaymode':='decimal'}

- **Hexadecimal format**
  - {attribute 'displaymode':='hex'}
  - attribute 'displaymode':='hexadecimal'}

Insertion position: line above the line with the declaration of the corresponding variables.

```
VAR
  {attribute 'displaymode':='hex'}
  dwVar1: DWORD;
END_VAR
```

See also

Attribute 'enable_dynamic_creation'

The pragma `enable_dynamic_creation` is needed for using the `__NEW` operator for function blocks.

**Syntax:**
```
{attribute 'enable_dynamic_creation'}
```

Insert location: First line in the declaration of the function block.

See also
- chapter 6.4.1.20.3.59 “Operator ‘__NEW’” on page 2201

Attribute 'estimated-stack-usage'

The pragma provides an estimated value for the stack size requirement.

Methods with recursive calls cannot pass a stack check because stack usage cannot be determined. As a result, a warning is issued. To prevent this warning, you can give the method an estimated value (in bytes) for the stack size requirement. Then the method passes the stack check successfully.

**Syntax**
```
{attribute 'estimated-stack-usage' := '<estimated stack size in bytes>'}
```

**Example**
```
{attribute 'estimated-stack-usage' := '127'} // 127 bytes
METHOD PUBLIC DoIt : BOOL
  VAR_INPUT
  END_VAR
```

Insert location: First line above the declaration part of the method.

The section "Method call" includes an example that uses this pragma.

**Recursive method call**

Within its implementation, a method can call itself, either directly by means of the `THIS` pointer, or by means of a local variable for the assigned function block.

- Use recursions mainly for processing recursive data types such as linked lists.
- In general, we recommend to be careful when using recursion, as unexpectedly deep recursions can cause stack overflow and machine downtime.
The following program PLC_PRG calculates the factorial of a number in the FB_Factorial function block in a different way, each in its own method.

- Method m_Iterative: Iterative
- Method m_Pragmaed: Recursive with warning suppression
- Method m_Recursive: Recursive
- Method m_Temp: Temporary with warning suppression

A warning is issued for the m_Recursive method only.

```
// Contains the data of the factorial calculation of uiNumber
TYPE FACTORIAL_RESULT :
  STRUCT
    uiNumber : UINT;
    udiIterative : UDINT;
    udiRecursive : UDINT;
    udiPragmaed : UDINT;
    udiTemp : UDINT;
  END_STRUCT
END_TYPE

PROGRAM PLC_PRG
VAR
  fb_Factorial_A : FB_Factorial;
  factorial_A : FACTORIAL_RESULT := (uiNumber := 9,
    udiIterative := 0, udiRecursive := 0, udiPragmaed := 0);
END_VAR
fb_Factorial_A.p_Number := factorial_A.uiNumber;
factorial_A.udiIterative := fb_Factorial_A.m_Iterative();
factorial_A.udiRecursive := fb_Factorial_A.m_Recursive(uiN :=
    factorial_A.uiNumber);
factorial_A.udiPragmaed := fb_Factorial_A.m_Pragmaed(uiN :=
    factorial_A.uiNumber);
factorial_A.udiTemp := fb_Factorial_A.m_Temp(uiN :=
    factorial_A.uiNumber);
```
FUNCTION_BLOCK FB_Factorial
VAR_INPUT
END_VAR
VAR_OUTPUT
END_VAR
VAR
uiN : UINT;
udiIterative : UDINT;
udiPragmaed : UDINT;
udiRecursive : UDINT;
END_VAR

// Iterative calculation
METHOD PUBLIC m_Iterative : UDINT
VAR
uiCnt : UINT;
END_VAR
m_Iterative := 1;
IF    uiN > 1 THEN
    FOR uiCnt := 1 TO uiN DO
        m_Iterative := m_Iterative * uiCnt;
    END_FOR;
    RETURN;
ELSE
    RETURN;
END_IF;

// Recursive calculation with suppressed warning
{attribute 'estimated-stack-usage' := '99'}
METHOD PUBLIC m_Pragmaed : UDINT
VAR_INPUT
uiN : UINT;
END_VAR
VAR
END_VAR
m_Pragmaed := 1;
IF    uiN > 1 THEN
    m_Pragmaed := uiN * THIS^.m_Pragmaed(uiN := (uiN - 1));
    RETURN;
ELSE
    RETURN;
END_IF;

METHOD PUBLIC m_Recursive : UDINT
VAR_INPUT
uiN : UINT;
END_VAR
VAR
END_VAR
m_Recursive := 1;
IF    uiN > 1 THEN
    m_Recursive := uiN * THIS^.m_Recursive(uiN := (uiN - 1) );
    RETURN;
ELSE
    RETURN;
END_IF;

// Called by temporary FB instance
{attribute 'estimated-stack-usage' := '99'}
METHOD PUBLIC m_Temp : UDINT
VAR_INPUT
uiN : UINT;
END_VAR
VAR
  fb_Temp : FB_Factorial;
END_VAR
m_Temp := 1;
IF uiN > 1 THEN
  m_Temp := uiN * fb_Temp.m_Temp(uiN := (uiN - 1));
  RETURN;
ELSE
  RETURN;
END_IF;

PROPERTY p_Number : UINT
uiN := p_Number; //Setter method

Only the m_Recursive issues a warning when the program is executed.

See also
- Chapter 6.4.1.9.22.5 “Calling methods” on page 1933
- Chapter 6.4.1.9.22 “Object-Oriented Programming” on page 1929
- Chapter 6.4.1.21.2.21.6 “Object ‘Method’” on page 2485
- Chapter 6.4.1.21.2.21.9 “Object ‘Property’” on page 2493

Attribute 'ExpandFully'
The effect of this pragma is that the components of an array used as an input variable for referenced visualizations are made visible in the Properties dialog box of the visualization.

Syntax:
(attribute 'ExpandFully')

Insertion position: the line above the line with the declaration of the array.
The visualization "visu" is to be inserted into a frame inside the visualization "visu_main". `arr` is defined as an input variable in the interface editor of "visu" and will thus be available later for assignments in the Properties dialog box of the frames in "visu_main". In order to also make the individual components of `arr` available in this Properties dialog box, you must insert the attribute 'ExpandFully' directly before `arr` in the interface editor of visu. Declaration in the interface editor of "visu":

```
VAR_INPUT
{attribute 'ExpandFully')
  arr : ARRAY[0..5] OF INT;
END_VAR
```

Example

The visualization "visu" is to be inserted into a frame inside the visualization "visu_main". `arr` is defined as an input variable in the interface editor of "visu" and will thus be available later for assignments in the Properties dialog box of the frames in "visu_main". In order to also make the individual components of `arr` available in this Properties dialog box, you must insert the attribute 'ExpandFully' directly before `arr` in the interface editor of visu. Declaration in the interface editor of "visu":

```
VAR_INPUT
{attribute 'ExpandFully')
  arr : ARRAY[0..5] OF INT;
END_VAR
```

Attribute 'global_init_slot'

The pragma defines the initialization order of programming blocks and global variable lists. Variables in a list (GVL or POU) are initialized from top to bottom.

If there are several global variable lists, then the initialization order is not defined.

The initialization does not apply for the initialization of literal values, for example 1, 'hello', 3.6, or constants of base data types. However, you must define the initialization order yourself if there are dependencies between the lists. You can assign a defined initialization slot to a GVL or POU with the 'global_init_slot' attribute.

Constants are initialized before the variables and in the same order as the variables. During initialization, the POUs are sorted according to the value for `<slot>`. Then the code for initializing the constants is generated and afterwards the code for initializing the variables.

Syntax:

```
{attribute 'global_init_slot' := '<slot>'}
```

`<slot>`: Integer value that defines the position in the call order. The default value for a POU (program, function block) is 50000. The default value for a GVL is 49990. A lower value means an earlier initialization. Caution: If several blocks or GVLs receive the same value for the 'global_init_slot' attribute, then the initialization order remains undefined.
The pragma always affects the entire GVL or POU and therefore it must be located above the VAR_GLOBAL or POU declaration.

If several programming blocks have got assigned the same value for the attribute 'global_init_slot', the order of their initialization remains undefined.

Example

The program includes two global variable lists GVL_1 and GVL_2, as well as a PLC_PRG program that uses variables from both lists. GVL_1 uses the variable B for initializing a variable A, which is initialized in GVL_2 with a value of 1000.

GVL_1

VAR_GLOBAL //49990
A : INT := GVL_2.B*100;
END_VAR

GVL_2

VAR_GLOBAL //49990
B : INT := 1000;
C : INT := 10;
END_VAR

PLC_PRG

PROGRAM PLC_PRG //50000
VAR
ivar: INT := GVL_1.A;
ivar2: INT;
END_VAR

ivar:=ivar+1;
ivar2:=GVL_2.C;

In this case, the compiler prints an error because GVL_2.B is used for initializing GVL_1.A before GVL_2 has been initialized. You can prevent this by using the global_init_slot attribute to position GVL_2 before GVL_1 in the initialization sequence.

In this example, GVL_1 must have at least one slot value of 49989 in order to achieve the earliest initialization within the program. Every lower value has the same effect:

GVL_2

{attribute 'global_init_slot' := '100'}

VAR_GLOBAL
B : INT := 1000;
END_VAR

Using GVL_2.C in the implementation part of PLC_PRG is also not critical even without using a pragma because both GVLs are initialized before the program in either case.

Attribute 'hide'

Using the pragma {attribute 'hide'} to hide variables and POUs does not have the desired effect in most cases. Instead, you should use the pragma {attribute 'conditionalshow'}.

The pragma prevents the variables and POUs defined with it from being shown in the CODESYS user interface. As a result, you can intentionally hide these identifiers without restricting the access. This can be useful when you develop libraries.

Affected features:

- Library management
- Debugging
- Input Assistant
- Function "List components"
The variables or POUs defined with the pragma are neither visible in the Library Manager nor are they suggested in the Input Assistant or in the "List components" function. The pragma prevents those marked variables from being displayed in the symbol configuration. As a result, you cannot export these kinds of variables as symbols. The variables are also invisible in online mode, and therefore their values cannot be monitored. Moreover, you cannot use any debugging functionalities and you do not have any support when checking for bugs.

**Syntax:**

{attribute 'hide'}

Insert location: For variables, above the line with the declaration of the variables. For POUs, in the first line.

If you, the application developer, know the exact instance path of the hidden POUs and variables, then you can access them in the code.

---

**Example of hidden variable**

The function block `FB_MyA` contains the attribute pragma `{attribute 'hide'}` to hide the local variable `xInvisibleIn`.

```
FUNCTION_BLOCK FB_MyA
VAR_INPUT
   iInA : INT;
   {attribute 'hide'}
   xInvisibleIn : BOOL;
   xInit: BOOL;
END_VAR
VAR_OUTPUT
   iOutA : INT;
END_VAR
VAR
   iCounter : INT;
END_VAR
```

Two instances of the function block `FB_MyA` are defined in the main program.

```
PROGRAM PLC_PRG
VAR
   fbMyA1, fbMyA2 : FB_MyA;
   xVar2 : BOOL;
   iVar1 : INT;
   iVar2 : INT;
END_VAR
fbMyA1(iInA := 1, xInit := TRUE, xInvisibleIn := TRUE, iOutA => iVar1);
fbMyA2(iInA := 1, xInit := TRUE, iOutA => iVar2);
```

When the input value for `fbMyA1` is implemented, the "List components" function, which opens when you type `fbMyA1` (in the implementation part of `PLC_PRG`), displays the variables `iInA, xInit, and iOutA, but not the hidden variable `xInvisibleIn`.
FB_A is a function block of the library HiddenFunctionality with the default namespace HIDDEN. To hide the identifier and the POU code from application developers, begin the declaration of the POU with the attribute pragma {attribute 'hide'}. To hide the subordinate POUs (actions, methods, properties, and transitions) in the same way, also begin their declarations with {attribute 'hide'}.

```plaintext
{attribute 'hide'}
FUNCTION_BLOCK FB_A
VAR_INPUT
END_VAR
VAR_OUTPUT
END_VAR
VAR
iA : INT;
iCount : INT;
iInvisible : INT;
END_VAR

{attribute 'hide'}
METHOD METH_Count : INT
VAR_INPUT
END_VAR
iCount := iCount + 1;

{attribute 'hide'}
METHOD METH_Invisible : BOOL
VAR_INPUT
END_VAR
iInvisible := iInvisible + 1;

{attribute 'hide'}
PROPERTY PUBLIC prop_iA : INT
```

For you as the application developer, all POUs are invisible. You can use them only if you know the instance path.

```plaintext
PROGRAM PLC_PRG
VAR
   fbHidden : HIDDEN.FB_A; // Hidden function block from library
   iCounter : INT;
END_VAR
fbHidden.METH_Invisible();
iCounter := fbHidden.iInvisible;
```

In online mode, no monitoring is performed.
With the pragma `hide_all_locals` you can hide all local variables of a POU.

See also
- Chapter 6.4.1.20.6.3.18 “Attribute 'hide_all_locals'” on page 2289
- Chapter 6.4.1.20.6.3.8 “Attribute 'conditionalshow'” on page 2276
- Chapter 6.4.1.20.6.3.9 “Attribute 'conditionalshow_all_locals'” on page 2277

**Attribute 'hide_alllocals'**

The pragma prevents all local variables of a signature from being visible in the display of the 'List components' function, in the Input Assistant or in the declaration part in online mode. Moreover, these variables are hidden in the symbol configuration and therefore cannot be exported as symbols. The pragma is especially useful in library POUs to hide POU variables from users.

**Affected features**
- Library management
- Debugging
- Input Assistant
- Function "List components"
- Monitoring
- Symbol configuration

**Syntax:**

```
{attribute 'hide_all_locals'}
```

Insert location: First line above the declaration part of the POU
Example

The function block `FB_MyB` uses the attribute:

```plaintext
{attribute 'hide_all_locals'}
FUNCTION_BLOCK FB_MyB
VAR_INPUT
  iInB : INT;
  {attribute 'hide'}
  xInvisibleIn : BOOL;
  xInit: BOOL;
END_VAR
VAR_OUTPUT
  iOutB : INT;
END_VAR
VAR
  iCounter : INT;
  xVar : BOOL;
END_VAR
```

Two instances of the function block `FB_MyB` are defined in the main program.

```plaintext
PROGRAM PLC_PRG
VAR
  fbMyB1, fbMyB2: FB_MyB;
  iVar3: INT;
  iVar4: INT;
END_VAR
fbMyB1(iInB := 2, xInvisibleIn := TRUE, iOutB => iVar3);
fbMyB2(iInB := 2, iOutB => iVar4);
IF fbMyB2.iCounter > 100 THEN
  fbMyB2.xInit := TRUE;
END_IF
```

Now when you download the program to the controller, start it, and switch to online mode, the variables `iInB`, `xInit`, `iOutB`, and `xReset` are displayed in the declaration editor. However, the hidden local variables `iCounter` and `xVar` are not displayed.

See also

- Chapter 6.4.1.20.6.3.17 “Attribute ‘hide’” on page 2286

Attribute 'initialize_on_call'

The pragma causes input variables of a function block to be initialized on each call of the function block. If an input variable is affected which expects a pointer and this pointer has been removed during an online change, then the variable is initialized to zero.

Syntax:

```plaintext
{attribute 'initialize_on_call'}
```

Insert location: Always in the first line of the declaration part for the entire function block, and also in a line above the declaration of the individual input variable.
**Example**

```plaintext
{attribute 'initialize_on_call'}
FUNCTION_BLOCK fb
VAR_INPUT
    {attribute 'initialize_on_call'}
pInt : POINTER TO INT := 0;
    {attribute 'initialize_on_call'}
iVal : INT := 0;
END_VAR
```

**Attribute 'init_namespace'**

The effect of this pragma is that a variable of the type `STRING` or `WSTRING`, which is declared in a library function block with this pragma, is initialized when used in the project with the current namespace of the library.

**Syntax**

```plaintext
{attribute 'init_namespace'}
```

Insertion position: the line above the line with the declaration of the variables in a library function block.

**Example**

The function block “POU” is provided with the necessary attributes:

```plaintext
FUNCTION_BLOCK POU
VAR_OUTPUT
    {attribute 'init_namespace'}
myStr: STRING;
END_VAR
```

An instance `fb` of the function block POU is defined within the main program PLC_PRG:

```plaintext
PROGRAM PLC_PRG
VAR
    fb:POU;
    newString: STRING;
END_VAR
newString := fb.myStr;
```

The variable `myStr` is initialized with the current namespace, for example `MyLib`. This value is assigned to `newString` in the main program.

**See also**
- [Chapter 6.4.1.21.2.16 “Object 'Library Manager’” on page 2469](#)
NOTICE!

For compiler version 3.5.0.0 and later, a fast online change is performed for minor changes. In this case, only the modified blocks are compiled and downloaded. In particular, no initialization code is generated. This means that also no code is generated when variables with the `init_on_onlchange` attribute are initialized. As a rule, this has no effect because the attribute is used primarily for initializing variables with addresses. However, it cannot happen that a variable changes its address during an online change.

To secure the effect of the `init_on_onlchange` attribute in the entire application code, you must deactivate the fast online change in general for the application by using the compiler definition `no_fast_online_change`. To do this, insert the definition in the application “Properties” (“Build” tab).

Syntax:

```
{attribute 'init_on_onlchange' }
```

Insert location: The line above the line with the declaration of the variables.

See also

- § Chapter 6.4.1.21.4.11.5 “Dialog ‘Properties’ - ‘Build’” on page 2755

Attribute 'instance-path'

This pragma can be applied to a local STRING variable and causes this local STRING variable to be initialized in sequence with the device tree path of the POU to which it belongs. This can be useful for error messages. The application of the pragma requires the application of the attribute 'reflection' to the associated POU, as well as the application of the additional attribute 'noinit' to the STRING variable.

Syntax:

```
{attribute 'instance-path'}
```

Insertion position: the line above the line with the declaration of the STRING variable.

Example

The following function block contains the attributes 'reflection', 'instance-path' and 'noinit'.

```
{attribute 'reflection'}
FUNCTION_BLOCK POU
VAR
 {attribute 'instance-path'}
{attribute 'noinit'}
str: STRING;
END_VAR
```

An instance “myPOU” of the function block “POU” is defined within the main program “PLC_PRG”:

```
PROGRAM PLC_PRG
VAR
 myPOU:POU;
 myString: STRING;
END_VAR
myPOU();
myString:=myPOU.str;
```

Following the initialization of the instance myPOU, the path of the instance myPOU is assigned to the string variable str, in the example PLCWinNT.Application.PLCS_PRG.myPOU. This path is assigned in the main program to the variable myString.
NOTICE!
You can define the length of a string to be whatever you like (even >255), but you must consider that the string will be truncated at the end if it is assigned to a variable whose data type is too small for it.

See also
- % Chapter 6.4.1.20.6.3.41 “Attribute ‘reflection’” on page 2313
- % Chapter 6.4.1.20.6.3.32 “Attribute ‘noinit’” on page 2299

Attribute 'io_function_block', 'io_function_block_mapping'

With the 'io_function_block' attribute, you mark a function block in order to prepare it for the assignment to a channel in the I/O mapping of the device configuration. Then it is shown in the “Select function block” dialog.

With the 'io_function_block_mapping' attribute, you mark a parameter that should be used when mapping the FB to a device channel in this kind of function block. You can provide the attribute to multiple parameters of the function block. For I/O mapping, the first one is used automatically whose type matches the channel (input, output, data type).

Syntax:

```
{attribute 'io_function_block'}
{attribute 'io_function_block_mapping'}
```

Insert location: The line above the first line in the declaration of the function block, or the line above the parameter declaration.

Example

```
{attribute 'io_function_block'}
FUNCTION_BLOCK Scale_Output_Int
VAR_INPUT
  iInput : INT;
  iNumerator : INT;
  iDenominator : INT := 1;
  iOffset : INT := 0;
END_VAR
VAR_OUTPUT
  {attribute 'io_function_block_mapping'}
  iOutput : INT;
END_VAR
```

See also
- % Chapter 6.4.1.21.4.4 “Dialog ‘Select Function Block’” on page 2746
- % “Linking a device with a function block instance” on page 1840

Attribute 'is_connected'

You use the pragma 'is_connected' to mark a Boolean function block variable which, when a function module instance is called, provides information about whether the associated input of the POU has an assignment.

The use of the pragma requires the use of the attribute 'reflection' on the affected function block.

Syntax:
```
{attribute 'is_connected' := '<input variable>'}
```
In the function block FB, a local variable is declared for each input variable (in1 and in2) and the attribute 'is connected' is prepended to it each time with the name of the input variable. The func itself gets the pragma attribute 'reflection'.

When an instance of the function block is called, the local variable is True in the case that the input assigned to it has received an assignment.

```
{attribute 'reflection'}
FUNCTION_BLOCK FB
VAR_INPUT
  in1: INT;
  in2: INT;
END_VAR
VAR
  {attribute 'is_connected' := 'in1'}
  in1_connection_info: BOOL;
  {attribute 'is_connected' := 'in2'}
  in2_connection_info: BOOL;
END_VAR
```

Assumption: When the function block instance is called, in1 receives an external assignment and in 2 does not receive an assignment. This results in the following code:

```
in1_connection_info := TRUE;
in2_connection_info := FALSE;
```

See also
- Chapter 6.4.1.20.6.3.41 “Attribute ‘reflection’” on page 2313
- Chapter 6.4.1.21.2.21.3 “Object ‘Function Block’” on page 2479

**Attribute 'linkalways'

The pragma {attribute 'linkalways'} instructs the compiler to always include a POU or a library POU in the compile information. During the build, the POU is compiled and is part of the application code. During the download, the POU is downloaded to the PLC.

**Syntax:**

```
{attribute 'linkalways'}
```

**Insertion location:** The first line in the declaration part of the POU or library POU

The POU may be valid throughout the project (saved in the “POUs” view) or throughout the application (saved in the “Devices” view).

You can also select the “Link always” option in the “Build” tab of a POU’s object properties.
The “MoreSymbols” GVL contains the pragma `{attribute 'linkalways'}`. The variables declared there are also part of the application code, regardless of any access.

```c
VAR_GLOBAL
  g_iAlpha: INT;
  g_iBravo: INT;
  g_iCharlie: INT;
END_VAR
```

The symbol configuration also accesses the compile information. As a result, the variables of the `MoreSymbols` GVL are always provided for selection in the “Symbol Configuration” editor.

Attribute 'monitoring'

The effect of this pragma is that you can monitor values of properties or function calls in the online view of the IEC editor or in a watch list. There are two possible attribute values for this: 'variable' and 'call'

Syntax

```c
{attribute 'monitoring' := 'variable'}
{attribute 'monitoring' := 'call'}
```

Monitoring of programming objects and their properties

In the online view of a function block or program, you can monitor the subordinate properties in addition to the local variables. This allows you to monitor the values of the Get and Set methods.

Insert either the pragma `{attribute 'monitoring' := 'variable'} or `{attribute 'monitoring' := 'call'}` in the declaration of the property block. The current values of the property are then displayed automatically in the IEC editor or in a watch list.
In online mode, the PLC_PRG object shows the value of the Minutes property at the call location inline in the ST editor. This is because the pragma \{attribute 'monitoring':='variable'} is located in the declaration of the Minutes property.

Example

Check carefully for each application which attribute pragma is suitable for displaying the desired value. This depends on whether further operations with the variables are implemented within the property.

1.Pragma \{attribute 'monitoring':='variable'}:

An implicit variable is created for the property, which is then always given the current property value when the application calls the Set or Get method. The value stored last in this variable is displayed in the monitoring.

2.Pragma \{attribute 'monitoring':='call'}:

You can use this attribute only for properties that return simple data types or pointers, but not for structured types. The value to be monitored is read or written by calling the property directly. This means that the monitoring service of the runtime executes the Get or Set method of the property.

---

**NOTICE!**

When you insert the pragma \{attribute 'monitoring':='call'} for monitoring, you have to pay attention to possible side effects. These kinds of side effects can occur if additional operations are implemented in the property.

**NOTICE!**

The pragma \{attribute 'monitoring'} is also evaluated for the symbol configuration. Only read access is possible for the value 'variable'.

---

*With the context menu command “Add Watch”, a variable on which the cursor is currently positioned is applied directly into the monitoring list in online mode.*
The forcing or writing of functions is not supported. However, you can implicitly implement forcing by adding an additional input parameter for the respective function, which serves as an internal force flag.

Function monitoring is not possible in the compact runtime.

See also

- Chapter 6.4.1.21.21.9 “Object ‘Property’” on page 2493

Attribute 'monitoring_encoding'

The attribute pragma is allowed for string variables and aliases. The attribute has the effect that the values of the variables are marked with it to be decoded in UTF-8 format during monitoring.

Syntax

{attribute 'monitoring_encoding' := 'UTF8'}

Example

PROGRAM PLC_PRG
VAR

{attribute 'monitoring.encoding' := 'UTF8'}
strDat : STRING := 'abc';
attribute 'monitoring_encoding' := 'UTF-8'
strVarUtf8 : STRING := UTF8#'你好,世界!ÜüÄäÖö';
{attribute 'monitoring_encoding' := 'UTF-8'}
str1: STRING := UTF8#'AÄyyy';
{attribute 'monitoring_encoding' := 'UTF-8'}
str2: STRING := UTF8#'AÄxxxÜÜÜ';

strVarUtf8_1: STRING := '#你好,世界!ÜüÄäÖö';
str1_1: STRING := '#AÄyyy';
str2_1: STRING := '#AÄxxxÜÜÜ';
END_VAR

Example Syntax

Configuration and programming
Programming with CODESYS > CODESYS Development System
Attribute 'no_assign', Attribute 'no_assign_warning'

The pragma 'no_assign' results in compiler errors being displayed if an instance of the function block is assigned to another instance of the same function block. Such assignments are often to be avoided if the function block contains pointers and pointers lead to problems, because they are copied as well during the value assignment.

The pragma 'no_assign_warning' results in the same as for the pragma 'no_assign' with compiler warnings instead of compiler errors.

**Syntax:**

```plaintext
{attribute 'no_assign'}
```

Insert location: First line in the declaration part of a function block.

---

**Example**

Assignment of function block instances containing pointers.

In this example the value assignment of the function block instances will lead to problems during the execution of `fb_exit`:

```plaintext
VAR_GLOBAL
    inst1 : TestFB;
    awsBufferLogFile : ARRAY [0..9] OF WSTRING(66);(* Area: 0, Offset: 0x1304 (4868)*)
    LogFile : SEDL.LogRecord := (sFileName := 'LogFile.log', pBuffer := ADR(awsBufferLogFile), udiMaxEntriesFile := UDINT#10000, udiMaxBuffered := UDINT#10, uiLineSize := UINT#64, wsSep := " ", xCircular := TRUE, siDateFormat := SINT#0, siTimeFormat := SINT#0);
END_VAR

PROGRAM PLC_PRG
VAR
    inst2 : TestFB := inst1;
    LogFileNew
END_VAR

In this case `LogFile` manages a list of pointers, for which various actions are executed in the case of `fb_exit`. Problems result due to the assignment, because `fb_exit` will be executed twice. You should prevent this by adding the attribute 'no_assign' in the declaration of the function block "TestFB":

```plaintext
{attribute 'no_assign'}

FUNCTION_BLOCK TestFB
VAR_INPUT
...

The following compiler errors are then displayed:

C0328: Assignment not allowed for type TestFB
C0328: Assignment not allowed for type LogRecord

If the pragma no_assign_warning is used instead of the pragma no_assign for the function block "TestFB", then the C0328 message is issued as compiler warning, not as a compiler error.

---

Attribute 'no_check'

This pragma prevents the check function being called for the POU (POUs for implicit checks). Since the check functions can affect the processing speed of the program, it can be useful to apply the attribute to function blocks that have already been checked or are frequently called.

You add the pragma to the declaration of a POU.

**Syntax:**

```plaintext
{attribute 'no_check'}
```

Insertion position: first line in the declaration part of the POU.
Attribute 'no_copy'

In general an online change requires a re-allocation of instances, for example of a POU. In the process, the value of the variable contained in the instance is copied.

The pragma prevents the value of the variable contained in the instance from being copied in the course of an online change; instead, the variable is re-initialized in the course of an online change. This can be useful for a local pointer variable that points to a variable that has just been shifted by the online change and thus has a changed address.

You insert the attribute in the declaration part above the line of the declaration of the variables concerned.

Syntax:

{attribute 'no_copy'}

Attribute 'no-exit'

This attribute suppresses the call of the FB_exit method of a function block for a certain one of its instances. To do this you insert the attribute in the line before the declaration of the function block instance.

Syntax:

{attribute 'no-exit'}

Example

The method “FB_exit” is added to the function block “POU_ex”. Two instances of the function block “POU_ex” are created in the main program “PLC_PRG”.

```
PROGRAM PLC_PRG
VAR
  POU1 : POU_ex;
  {attribute 'no-exit'}
  POU2 : POU_ex;
END_VAR
```

POU1 is called, POU2 is not called.

See also

- Chapter 6.4.1.20.10 “Methods ‘FB_Init’, ‘FB_Reinit’, and ‘FBExit’” on page 2336

Attribute 'noinit'

This pragma is applied to variables that should not be implicitly initialized.

Syntax:

{attribute 'no_init'}
{attribute 'no-init'}
{attribute 'noinit'}

Insertion position: line above the declaration line of the variables concerned in the declaration part.
Example

PROGRAM PLC_PRG
VAR
  A : INT;
  {attribute 'no_init'}
  B : INT;
END_VAR

When the associated application is reset, the integer variable A is implicitly re-initialized with 0, whereas the variable B retains its current value.

Attribute 'no_instance_in_retain'

You can use this pragma to prevent the instance of a function block from being stored in the retain memory.

Syntax:
{attribute 'no_instance_in_retain'}

Insert location:
Lines above the FUNCTION_BLOCK declaration in the declaration part of the function block.

Now when you declare an instance declaration of the function block as a RETAIN variable, an error message is issued.

See also
- Chapter 6.4.1.9.19 “Data Persistence” on page 1920

Attribute 'no_virtual_actions'

The pragma is used for function blocks that are derived from a function block implemented in SFC and use the fundamental SFC sequence of this base class. The actions called from it exhibit the same virtual behavior as methods. This means that the implementations of the actions in the base class can be replaced by the derived class with its own specific implementations.

If you apply the pragma to the base class, then its actions are protected against overloading.

Syntax:
{attribute 'no_virtual_actions'}

Insert location: Top line in the declaration part of the function block
The function block POU_SFC is the base class for the derived function block POU_child. The derived class POU_child calls the sequence of the base class written in SFC with the special variable SUPER.

The exemplary implementation of this sequence is limited to the initial step, followed by a single step with a linked step action ActiveAction. This step with a linked step action takes care of the configuration of the output variables.

```plaintext
an_int:=an_int+1; // Counting the action calls
test_act:='father_action';
METH(); // Call of the method METH in order to set the string variable test_meth
```

In the case of the derived class POU_child the step action is replaced by a special implementation of ActiveAction. Active Action differs from the original only by the assignment of the string 'child_action' in place of 'father_action' at the variable test_act.

Likewise, the method METH, which assigns the string 'father_method' to the variable test_meth in the base class, is overwritten so that test_meth now gets the value 'child_method'. The main program PLC_PRG calls an instance of the function block POU_child, named Child. As expected, the value of the strings reflects the call of the action and method of the derived class:
Now, however, you place the pragma `{attribute 'no_virtual_actions'}` in front of
the base class:

```plaintext
{attribute 'no_virtual_actions'}

FUNCTION_BLOCK POU_SFC...
```

This changes the behavior: While the implementation of the derived class is still used
for the method `METH`, the call of the step action now results in a call of the action `ActiveAction`
of the base class. Therefore `test_act` is now given the value `'father_action'`:

```
<table>
<thead>
<tr>
<th>Expression</th>
<th>Type</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Child</td>
<td>POU_child</td>
<td></td>
</tr>
<tr>
<td>test_meth</td>
<td>STRING</td>
<td>'child_method'</td>
</tr>
<tr>
<td>test_act</td>
<td>STRING</td>
<td>'child_action'</td>
</tr>
<tr>
<td>an_int</td>
<td>INT</td>
<td>33</td>
</tr>
</tbody>
</table>
```

**Attribute 'pingroup'**

The effect of this pragma is that the input pins or output pins (parameters) are grouped in the
declaration of a function block. In the FBD/LD editor a pin group defined in this way can be
displayed as an enlarged or reduced unit on the inserted function block. Several groups are
possible and are distinguished by their names. CODESYS saves the respective state (reduced)
per function block box with the project options.

**Syntax:**

```plaintext
{attribute 'pingroup' := '<group name>'}
```

Insertion position: line above the declaration of the input or output variables concerned in the
declaration part of a function block.
Two groups are defined: general (i1, out1) and group1 (i2, g1). r1, r2, outRes1 and g2 are always displayed.

FUNCTION_BLOCK FB
VAR_INPUT
  r1 : REAL;
  {attribute 'pingroup' := 'general'}
  i1 : INT;
  {attribute 'pingroup' := 'group1'}
  i2 : INT;
  r2 : REAL;
END_VAR

VAR_OUTPUT
  outRes1 : REAL;
  {attribute 'pingroup' := 'general'}
  out1 : INT;
  {attribute 'pingroup' := 'group1'}
  g1 : INT;
  g2 : REAL;
END_VAR

Example

Attribute 'pin_presentation_order_inputs/outputs'

The pragmas are evaluated in the CFC, FBD, and LD graphical editors, causing the order of inputs/outputs of the affected function block to be displayed as specified. You program the order by assigning the names of the inputs/outputs to the attribute in the desired order.

Syntax

{attribute 'pin_presentation_order_inputs' := '<First/Input_Name>,
  (<Next/Input_Name>,)* ( *, )? (<Next/Input_Name>,)*
  <Last/Input_Name>}'
{attribute 'pin_presentation_order_outputs' := '<First/Output_Name>,
  (<Next/Output_Name>,)* ( *, )? (<Next/Output_Name>,)*
  <Last/Output_Name>'}

- *
  The terminal character serves as a wildcard for all inputs/outputs that are not specified in the display order. If the terminal character is missing, then the missing inputs/outputs are appended at the end.

- ( ... )?
  The contents of the parentheses are optional.

- ( ... )*
  The contents of the parentheses are optional again and can therefore occur not at all, one time, or several times.

- Insert location: First line in the declaration part of a function block.

NOTICE!

This pragma is not evaluated when pragma {attribute 'pingroup' := '
  '<Group_Name>'} is used.
In the representation of function module instance pouBase_A, the pragmas result in the following arrangement of input and output pins:

![Diagram of function module instance](image)

See also

- Chapter 6.4.1.20.6.3.35 “Attribute ‘pingroup’” on page 2302

**Attribute ‘obsolete’**

The effect of this pragma is that a defined warning is displayed for a data type definition during compilation if the data type (structure, function block, etc.) is used in the project. This enables you, for example, to draw attention to the fact that a data type is no longer valid because, for example, an interface has changed and this should also be implemented in the project.

In contrast to a message pragma this warning is defined centrally for all instances of a data type.

**Syntax:**

```
{attribute 'obsolete' := 'user defined text'}
```

Insertion position: line of the data type definition or in a line above it.
The pragma is inserted in the definition function block `fb1`:

```plaintext
{attribute 'Obsolete' := 'datatype fb1 not valid!'}
FUNCTION_BLOCK fb1
  VAR_INPUT
  i:INT;
  END_VAR
If you use fb1 as a data type, for example in `fbinst:fb1`, the following warning will be displayed when compiling the project: "datatype fb1 not valid".
```

See also
- [Chapter 6.4.1.20.6.2 "Message Pragmas" on page 2269](#)

**Attribute 'pack_mode'**

The pragma defines how a data structure is packed during the allocation. The attribute has to be inserted above the data structure and affects the packing of the entire structure.

**Syntax:**

```plaintext
{attribute 'pack_mode' := ' <pack mode value>' }
```

Insert location: above the declaration of the data structure

**Table 401: Possible values for `<value>`:**

<table>
<thead>
<tr>
<th><code>&lt;pack mode value&gt;</code></th>
<th>Associated packing method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Aligned</td>
<td>All variables are allocated to byte addresses. There are no memory gaps.</td>
</tr>
<tr>
<td>1</td>
<td>1-byte-aligned</td>
<td>All variables at byte addresses. 2-byte variables at addresses divisible by 2. A maximum gap of 1 byte results.</td>
</tr>
<tr>
<td>2</td>
<td>2-byte-aligned</td>
<td>All variables at byte addresses. 2-byte variables at addresses divisible by 2. A maximum gap of 1 byte results. 4-byte variables at addresses divisible by 2. A maximum gap of 1 byte results. 8-byte variables at addresses divisible by 2. A maximum gap of 1 byte results. Strings always at byte addresses. No gaps result.</td>
</tr>
</tbody>
</table>
### Table: Associated Packing Method

<table>
<thead>
<tr>
<th>&lt;pack mode value&gt;</th>
<th>Associated packing method</th>
<th>Description</th>
</tr>
</thead>
</table>
| 4                 | 4-byte-aligned            | There are:
|                   |                           | - 1-byte variables at byte addresses |
|                   |                           | - 2-byte variables at addresses divisible by 2. A maximum gap of 1 byte results. |
|                   |                           | - 4-byte variables at addresses divisible by 4. A maximum gap of 3 byte results. |
|                   |                           | - 8-byte variables at addresses divisible by 4. A maximum gap of 3 byte results. |
|                   |                           | - Strings always at byte addresses. No gaps result. |
| 8                 | 8-byte-aligned            | There are:
|                   |                           | - 1-byte variables at byte addresses |
|                   |                           | - 2-byte variables at addresses divisible by 2. A maximum gap of 1 byte results. |
|                   |                           | - 4-byte variables at addresses divisible by 4. A maximum gap of 3 byte results. |
|                   |                           | - 8-byte variables at addresses divisible by 8. A maximum gap of 7 byte results. |
|                   |                           | - Strings always at byte addresses. No gaps result. |

#### Notice

Depending on the structure, there may be no difference in the memory mapping of the individual modes. Therefore, the memory allocation of a structure with <pack mode value> = 4 can correspond to that of <pack mode value> = 8.

Arrays of structures: If the structures are combined in arrays, then bytes are added at the end of the structure so that the next structure is aligned.

#### Notice!

If the “Compatibility layout” option is selected in the symbol configuration and at the same time the attribute ‘pack_mode’ is used in the code, then problems can occur due to unintentional memory misalignment.

See also
- § Chapter 6.4.1.21.2.27 “Object ‘Symbol Configuration’” on page 2523
Example 1

Example

{attribute 'pack_mode' := '1'}

TYPE myStruct:
  STRUCT
    Enable: BOOL;
    Counter: INT;
    MaxSize: BOOL;
    MaxSizeReached: BOOL;
  END_STRUCT
END_TYPE

The memory range for a variable of the data type myStruct is allocated 'aligned'. If the storage address of its component Enable is 0x0100, for example, then the component Counter follows at the address 0x0101, MaxSize at address 0x0103 and MaxSizeReached at address 0x0104. In the case of 'pack_mode':=2, Counter would be at 0x0102, MaxSize at 0x0104 and MaxSizeReached at 0x0106.
### Example 2

**Example**

```plaintext
STRUCT
  Var1 : BOOL := 16#01;
  Var2 : BYTE := 16#11;
  Var3 : WORD := 16#22;
  Var4 : BYTE := 16#44;
  Var5 : DWORD := 16#88776655;
  Var6 : BYTE := 16#99;
  Var7 : BYTE := 16#AA;
  Var8 : DWORD := 16#AA;
END_TYPE
```

<table>
<thead>
<tr>
<th>pack_mode = 0</th>
<th>pack_mode = 1</th>
<th>pack_mode = 2</th>
<th>pack_mode = 4</th>
<th>pack_mode = 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable</td>
<td>Value</td>
<td>Variable</td>
<td>Value</td>
<td>Variable</td>
</tr>
<tr>
<td>0</td>
<td>Var1</td>
<td>01</td>
<td>Var1</td>
<td>01</td>
</tr>
<tr>
<td>1</td>
<td>Var2</td>
<td>11</td>
<td>Var2</td>
<td>11</td>
</tr>
<tr>
<td>2</td>
<td>Var3</td>
<td>22</td>
<td>Var3</td>
<td>22</td>
</tr>
<tr>
<td>3</td>
<td>...</td>
<td>00</td>
<td>...</td>
<td>00</td>
</tr>
<tr>
<td>4</td>
<td>Var4</td>
<td>44</td>
<td>Var4</td>
<td>44</td>
</tr>
<tr>
<td>5</td>
<td>Var5</td>
<td>55</td>
<td>Var5</td>
<td>55</td>
</tr>
<tr>
<td>6</td>
<td>...</td>
<td>66</td>
<td>...</td>
<td>66</td>
</tr>
<tr>
<td>7</td>
<td>...</td>
<td>77</td>
<td>...</td>
<td>77</td>
</tr>
<tr>
<td>8</td>
<td>...</td>
<td>88</td>
<td>...</td>
<td>88</td>
</tr>
<tr>
<td>9</td>
<td>Var6</td>
<td>99</td>
<td>Var6</td>
<td>99</td>
</tr>
<tr>
<td>10</td>
<td>Var7</td>
<td>AA</td>
<td>Var7</td>
<td>AA</td>
</tr>
<tr>
<td>11</td>
<td>Var8</td>
<td>AA</td>
<td>Var8</td>
<td>AA</td>
</tr>
<tr>
<td>12</td>
<td>...</td>
<td>00</td>
<td>...</td>
<td>00</td>
</tr>
<tr>
<td>13</td>
<td>...</td>
<td>00</td>
<td>...</td>
<td>00</td>
</tr>
<tr>
<td>14</td>
<td>...</td>
<td>00</td>
<td>...</td>
<td>00</td>
</tr>
<tr>
<td>15</td>
<td>...</td>
<td>00</td>
<td>...</td>
<td>00</td>
</tr>
<tr>
<td>16</td>
<td>...</td>
<td>...</td>
<td>Var8</td>
<td>AA</td>
</tr>
<tr>
<td>17</td>
<td>...</td>
<td>00</td>
<td>...</td>
<td>00</td>
</tr>
<tr>
<td>18</td>
<td>...</td>
<td>00</td>
<td>...</td>
<td>00</td>
</tr>
<tr>
<td>19</td>
<td>...</td>
<td>00</td>
<td>...</td>
<td>00</td>
</tr>
<tr>
<td>20</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>21</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>22</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>23</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>24</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>25</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>26</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>27</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
</tbody>
</table>
```
<table>
<thead>
<tr>
<th>pack_mode = 0</th>
<th>pack_mode = 1</th>
<th>pack_mode = 2</th>
<th>pack_mode = 4</th>
<th>pack_mode = 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable</td>
<td>Value</td>
<td>Variable</td>
<td>Value</td>
<td>Variable</td>
</tr>
<tr>
<td>28</td>
<td>29</td>
<td>30</td>
<td>31</td>
<td></td>
</tr>
</tbody>
</table>

Configuration and programming
Programming with CODESYS > CODESYS Development System
Example 3

Example

```plaintext
STRUCT
  Var1 : BYTE  := 16#01;
  Var2 : LWORD := 16#11;
  Var3 : BYTE  := 16#22;
  Var4 : BYTE  := 16#44;
  Var5 : DWORD := 16#88776655;
  Var6 : BYTE  := 16#99;
  Var7 : BYTE  := 16#AA;
  Var8 : WORD  := 16#AA;
END_TYPE
```

<table>
<thead>
<tr>
<th>pack_mode = 0</th>
<th>pack_mode = 1</th>
<th>pack_mode = 2</th>
<th>pack_mode = 4</th>
<th>pack_mode = 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable</td>
<td>Value</td>
<td>Variable</td>
<td>Value</td>
<td>Variable</td>
</tr>
<tr>
<td>0</td>
<td>Var1</td>
<td>01</td>
<td>Var1</td>
<td>01</td>
</tr>
<tr>
<td>1</td>
<td>Var2</td>
<td>11</td>
<td>...</td>
<td>00</td>
</tr>
<tr>
<td>2</td>
<td>...</td>
<td>00</td>
<td>Var2</td>
<td>11</td>
</tr>
<tr>
<td>3</td>
<td>...</td>
<td>00</td>
<td>...</td>
<td>00</td>
</tr>
<tr>
<td>4</td>
<td>...</td>
<td>00</td>
<td>...</td>
<td>00</td>
</tr>
<tr>
<td>5</td>
<td>...</td>
<td>00</td>
<td>...</td>
<td>00</td>
</tr>
<tr>
<td>6</td>
<td>...</td>
<td>00</td>
<td>...</td>
<td>00</td>
</tr>
<tr>
<td>7</td>
<td>...</td>
<td>00</td>
<td>...</td>
<td>00</td>
</tr>
<tr>
<td>8</td>
<td>...</td>
<td>00</td>
<td>...</td>
<td>00</td>
</tr>
<tr>
<td>9</td>
<td>Var3</td>
<td>22</td>
<td>Var3</td>
<td>22</td>
</tr>
<tr>
<td>10</td>
<td>Var4</td>
<td>44</td>
<td>Var4</td>
<td>44</td>
</tr>
<tr>
<td>11</td>
<td>Var5</td>
<td>55</td>
<td>Var5</td>
<td>55</td>
</tr>
<tr>
<td>12</td>
<td>...</td>
<td>66</td>
<td>Var5</td>
<td>55</td>
</tr>
<tr>
<td>13</td>
<td>...</td>
<td>77</td>
<td>...</td>
<td>66</td>
</tr>
<tr>
<td>14</td>
<td>...</td>
<td>88</td>
<td>...</td>
<td>88</td>
</tr>
<tr>
<td>15</td>
<td>Var6</td>
<td>99</td>
<td>Var6</td>
<td>99</td>
</tr>
<tr>
<td>16</td>
<td>Var7</td>
<td>AA</td>
<td>Var7</td>
<td>AA</td>
</tr>
<tr>
<td>17</td>
<td>Var8</td>
<td>AA</td>
<td>Var8</td>
<td>AA</td>
</tr>
<tr>
<td>18</td>
<td>...</td>
<td>00</td>
<td>Var8</td>
<td>AA</td>
</tr>
<tr>
<td>19</td>
<td>...</td>
<td>00</td>
<td>...</td>
<td>88</td>
</tr>
<tr>
<td>20</td>
<td>...</td>
<td>00</td>
<td>...</td>
<td>88</td>
</tr>
<tr>
<td>21</td>
<td>Var8</td>
<td>AA</td>
<td>...</td>
<td>77</td>
</tr>
<tr>
<td>22</td>
<td>...</td>
<td>00</td>
<td>...</td>
<td>88</td>
</tr>
<tr>
<td>23</td>
<td>...</td>
<td>00</td>
<td>...</td>
<td>88</td>
</tr>
<tr>
<td>24</td>
<td>...</td>
<td>00</td>
<td>...</td>
<td>88</td>
</tr>
<tr>
<td>25</td>
<td>...</td>
<td>00</td>
<td>...</td>
<td>88</td>
</tr>
<tr>
<td>26</td>
<td>...</td>
<td>00</td>
<td>...</td>
<td>88</td>
</tr>
<tr>
<td>27</td>
<td>...</td>
<td>00</td>
<td>...</td>
<td>00</td>
</tr>
</tbody>
</table>
If pack mode is not used, then the compiler typically uses pack mode 4 or 8, depending on the device description. In each case, a pack mode which is particularly beneficial for the processor is used so that memory access can be performed. This is also called natural alignment or a natural alignment of data.

Unaligned memory access can be the result of using the attribute 'pack_mode'. This means, for example, that a data type with a size of 4 bytes is then located at an address which is not divisible by 4. Normally, on a 32-bit system a 32-bit data type can be read and written with a single memory access. On some platforms, for example on ARM platforms, this is possible only when this value is aligned in the memory. On other platforms, it can be that the access is possible but it is performed much more slowly.

Example

```plaintext
{attribute 'pack_mode':=1}

TYPE DUT
STRUCT
    by1 : BYTE;
    dw1 : DWORD;
END_STRUCT
END_TYPE
```

On an ARM platform, the value dw1 cannot be read with a single access. When an attempt is made to access this element directly, the ARM processor will throw an exception.

Assumption: The following read access is performed: `dwTest := dut1.dw1;`

For this access to the DWORD dw1, four memory accesses are required because each byte is read, shifted, and disjuncted individually. The flow is somewhat the same as in the following example in which a DWORD is generated from an array of four bytes:

```plaintext
dwHelp := bytes[0];
dwResult := dwHelp;
dwHelp := bytes[1];
dwHelp := SHL(dwHelp, 8);
dwResult := dwResult OR dwHelp;
dwHelp := bytes[2];
dwHelp := SHL(dwHelp, 16);
dwResult := dwResult OR dwHelp;
dwHelp := bytes[3];
dwHelp := SHL(dwHelp, 24);
dwResult := dwResult OR dwHelp;
```

Obviously, this kind of access is much slower than access to a DWORD, which is aligned appropriately in the memory.

```plaintext
pdw := ADR(dut1.dw1);
dwTest := pdw^;
```
However, the compiler will not generate the access of the example when this kind of member is accessed by means of a pointer. This means that the following code results in an exception on an ARM platform.

```pascal
pdw := ADR(dut1.dw1);
dwTest := pdw^;
```

For performance reasons, you should therefore avoid working with structures which are not naturally aligned.

A packed structure must not contain an unpacked structure.

---

**Attribute 'ProcessValue'**

With the 'ProcessValue' attribute, you mark a component of a structure. In the CFC editor, you can then use the command “Use attributed member as input” in order to connect this structure to an input of scalar type.

**Syntax:**

```pascal
{attribute 'ProcessValue'}
```

**Insert location:** Line above the affected structure variable.

**Example**

```pascal
TYPE QINT :
  STRUCT
    Status : STRING;
    {attribute 'ProcessValue'}
    Value1 : INT;
    Value2 : INT;
  END_STRUCT
END_TYPE
```

**See also**

- Chapter 6.4.1.21.3.13.36 “Command 'Use Attributed Member as Input’” on page 2698

---

**Attribute 'qualified_only'**

The effect of this pragma is that variables of a global variable list are only addressed by specifying the global variable name, for example `gvl.g_var`. This also applies to variables of the type Enumeration and can be helpful in avoiding being mistaken for local variables.

**Syntax:**

```pascal
{attribute 'qualified_only'}
```

**Insertion position:** line above `VAR_GLOBAL` in a GVL
Example

Global Variable List “GVL”:

{attribute 'qualified_only'}
VAR_GLOBAL
  iVar:INT;
END_VAR

Within a POU, for example “PLC_PRG”, the global variable iVar can only be addressed using the prefix GVL:

GVL.iVar:=5;

Conversely, the following incomplete call of the variable will create an error:

iVar:=5;

Attribute 'reflection'

The pragma is used to identify POUs in which some variables require special treatment and are tagged with a specific attribute for this purpose. Currently, this applies to the attributes 'instance-path' and 'is-connected' for function block variables. The compiler searches only blocks marked with 'reflection' for variables with these attributes and therefore needs less time.

Syntax:

{attribute 'reflection'}

For examples, see the description of the attributes 'instance-path' and 'is-connected'.

See also

- Chapter 6.4.1.20.6.3.22 “Attribute 'instance-path’” on page 2292
- Chapter 6.4.1.20.6.3.24 “Attribute 'is_connected’” on page 2293

Attribute 'subsequent'

The pragma is used to allocate consecutive variables in memory. When the list changes, the entire variable list is allocated to a new memory area. This pragma is used in programs and global variable lists.

Syntax:

{attribute 'subsequent'}

NOTICE!

VAR_TEMP in a program with attribute 'subsequent' leads to a compiler error.

When a variable in the list is qualified with RETAIN, all variables of the declaration part are stored in the memory area for RETAIN.
**Attribute 'symbol'**

The pragma `{attribute 'symbol'}` defines which variables of a program or a global variable list are to be adopted into the symbol configuration. This means that the variables are exported as symbols to a symbol list. This symbol list is then available for external access both as an XML file in the project directory and as a file that is invisible to the user on the target system. For example, the symbol list is then available for access by an OPC server. The variables thus equipped with a symbol are loaded by CODESYS to the controller, even if they are not explicitly configured or visible in the editor of the symbol configuration.

In any case, however, an object “Symbol configuration” must be created below the application concerned in the device tree.

**Syntax:**

```
{attribute 'symbol' := '<access possibilities>'}
```

- `<access possibilities>`: `none`, `read`, `write`, `readwrite`. The default value `readwrite` applies if no parameter is specified.

**Insertion position:**
- In order to affect only an individual variable, you must place the pragma in the line before the variable declaration.
- In order to be effective for all variables in the declaration part of a program, you must place the pragma in the first line of the declaration editor. In this case, too, you can still set instructions for individual variables explicitly in the respective line.

**Example**

With the following configuration the variables A and B are exported with read and write permission. Variable C is exported with read permission.

```
{attribute 'symbol' := 'readwrite'}
PROGRAM PLC_PRG
VAR
  A : INT;
  B : INT;
  {attribute 'symbol' := 'none'}
  C : INT;
  {attribute 'symbol' := 'read'}
  D : INT;
END_VAR
```

**See also**

- § Chapter 6.4.1.9.8 “Using Pragmas” on page 1888
- § Chapter 6.4.1.10.3 “Symbol Configuration” on page 1941

**Attribute 'to_string'**

The pragma affects how the result of converting an enumeration component with the `TO_STRING` operator is output. If the enumeration declaration has the pragma, then the name of the enumeration component appears as a string instead of the numeric value.

**Syntax:**

```
{attribute 'to_string'}
```

Insert location: First line above the declaration part of the enumeration.
Declaration of the enumeration color:

```plaintext
{attribute 'to_string'}
TYPE color :
{
    red := 0,
    blue := 1,
    green := 2
};
END_TYPE
```

Conversion with TO_STRING:

```plaintext
PROGRAM PLC_PRG
VAR
    i_color: Color;
    s_show_color: STRING;
END_VAR
i_color := 1;
s_show_color := TO_STRING(i_color);
```

In this case, `s_show_color` gets the value 'blue' instead of '1' as the conversion result.

See also
- Chapter 6.4.1.20.5.18 “Enumerations” on page 2263

Attribute 'warning disable', attribute 'warning restore'

This pragma causes certain warnings to be suppressed. The `warning restore` pragma causes a suppressed message to be reactivated.

**Syntax:**

```plaintext
{warning disable <compiler ID>}
{warning restore <compiler ID>}
```

`<compiler ID>`: ID located at the beginning of an error or a warning message.

**Example**

Compiler message:

```plaintext
typify code ...
C0196: Implicit conversion from unsigned Type 'UINT' to signed Type 'INT': possible change of sign
```

Apply the pragma to a variable declaration:

```plaintext
VAR
    {warning disable C0195}
    test1 : UINT := -1;
    {warning restore C0195}
    test2 : UINT := -1;
END_VAR
```

`test1` does not generate an error message, `test2` generates an error message.

**Effects of Pragmas on Symbols**

POUs and variables can change their behavior with respect to the symbol configuration as a result of pragmas. A detailed description can be found on the help page of each pragma.
<table>
<thead>
<tr>
<th>Pragma with attribute</th>
<th>Effect</th>
<th>See also</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>{attribute 'call_after_global_init_slot' := ' &lt;slot&gt;'}</code></td>
<td>None</td>
<td></td>
</tr>
<tr>
<td><code>{attribute 'call_after_init'}</code></td>
<td>None</td>
<td></td>
</tr>
<tr>
<td><code>{attribute 'call_after_online_change_slot' := ' &lt;slot&gt;'}</code></td>
<td>None</td>
<td></td>
</tr>
<tr>
<td><code>{attribute 'call_before_global_exit_slot' := ' &lt;slot&gt;'}</code></td>
<td>None</td>
<td></td>
</tr>
<tr>
<td><code>{attribute 'call_on_type_change':= 'comma separated list of referenced function blocks&gt;'}</code></td>
<td>None</td>
<td></td>
</tr>
<tr>
<td><code>{attribute 'conditionalshow' := ' &lt;some text&gt;'}</code></td>
<td>The marked variables are hidden and therefore cannot be exported. However, if the source code file from the compiled library is available, or if CODESYS has been started with the command-line option <code>conditionalshowsymbols</code>, then the marked variables are visible despite the pragma.</td>
<td>Chapt 6.4.1.20.6.3.8 “Attribute 'conditionalshow'” on page 2276</td>
</tr>
<tr>
<td><code>{attribute 'conditionalshow'}</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>{attribute 'conditionalshow_all_locals' := ' &lt;some text&gt;'}</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>{attribute 'conditionalshow_all_locals'}</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>{attribute 'const_replaced'}</code></td>
<td>Replaced constants are not available in the symbol configuration editor and therefore cannot be exported. A constant being replaced depends on whether or not the “Replace constants” compiler option has been selected for all constants and whether or not pragmas overwrite the compiler option for individual constants.</td>
<td>Chapt 6.4.1.20.6.3.10 “Attribute 'const_replaced', Attribute 'const_non_replaced'” on page 2277</td>
</tr>
<tr>
<td><code>{attribute 'const_non_replaced'}</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>{attribute 'dataflow'}</code></td>
<td>None</td>
<td></td>
</tr>
<tr>
<td><code>{attribute 'displaymode' :&lt;displaymode&gt; }</code></td>
<td>None</td>
<td></td>
</tr>
<tr>
<td><code>{attribute 'enable_dynamic_creation'}</code></td>
<td>None</td>
<td></td>
</tr>
<tr>
<td><code>{attribute 'estimated-stack-usage' := ' &lt;estimated stack size in bytes&gt;'}</code></td>
<td>None</td>
<td></td>
</tr>
<tr>
<td><code>{attribute 'ExpandFully'}</code></td>
<td>None</td>
<td></td>
</tr>
<tr>
<td><code>{attribute 'global_init_slot' := ' &lt;slot&gt;'}</code></td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>Pragma with attribute</td>
<td>Effect</td>
<td>See also</td>
</tr>
<tr>
<td>------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>{attribute 'hide'}</td>
<td>Variables are hidden and therefore cannot be exported.</td>
<td>Ch.6.4.1.20.6.3.17 &quot;Attribute 'hide'&quot; on page 2286</td>
</tr>
<tr>
<td>{attribute 'hide_all_locals'}</td>
<td>Variables are hidden and therefore cannot be exported.</td>
<td>Ch.6.4.1.20.6.3.18 &quot;Attribute 'hide_all_locals'&quot; on page 2289</td>
</tr>
<tr>
<td>{attribute 'initialize_on_call'}</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>{attribute 'init_namespace'}</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>{attribute 'init_on_onlchange'}</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>{attribute 'instance-path'}</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>{attribute 'io_function_block'}</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>{attribute 'io_function_block_mapping'}</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>{attribute 'is_connected' := '&lt;input variable&gt; '</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>{attribute 'linkalways'}</td>
<td>POUs and library POUs are integrated in the compile list and therefore cannot be exported.</td>
<td>Ch.6.4.1.20.6.3.25 &quot;Attribute 'linkalways'&quot; on page 2294</td>
</tr>
<tr>
<td>{attribute 'monitoring' := 'variable' }</td>
<td>Properties PROPERTY or functions (FUNCTION) are provided as symbols.</td>
<td>Ch.6.4.1.20.6.3.26 &quot;Attribute 'monitoring'&quot; on page 2295</td>
</tr>
<tr>
<td>{'no_assign'}</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>{'no_assign_warning'}</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>{attribute 'no_check'}</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>{attribute 'no_copy'}</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>{attribute 'no-exit'}</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>{attribute 'no_init'}</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>{attribute 'noinit'}</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>{attribute 'no_instance_in_retain'}</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>{attribute 'no_virtual_actions'}</td>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>
### Pragma with attribute

<table>
<thead>
<tr>
<th>Pragma with attribute</th>
<th>Effect</th>
<th>See also</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>{attribute 'pingroup' := ' &lt;group name&gt; '}</code></td>
<td>None</td>
<td></td>
</tr>
<tr>
<td><code>{attribute 'pin_presentation_order_inputs' := '&lt;input name&gt; ' (, &lt;next input name&gt;)* }</code></td>
<td>None</td>
<td></td>
</tr>
<tr>
<td><code>{attribute 'pin_presentation_order_outputs' := '&lt;output name&gt; ' (, &lt;next output name&gt;)* }</code></td>
<td>None</td>
<td></td>
</tr>
<tr>
<td><code>{attribute 'obsolete' := 'user defined text'}</code></td>
<td>None</td>
<td>Chapt 6.4.1.21.2.27 “Object 'Symbol Configuration'” on page 2523</td>
</tr>
<tr>
<td><code>{attribute 'pack_mode' := ' &lt;pack mode value&gt; '}</code></td>
<td>Can lead to intentional memory misalignment</td>
<td></td>
</tr>
<tr>
<td><code>{attribute 'ProcessValue'}</code></td>
<td>None</td>
<td></td>
</tr>
<tr>
<td><code>{attribute 'qualified_only'}</code></td>
<td>None</td>
<td></td>
</tr>
<tr>
<td><code>{attribute 'reflection'}</code></td>
<td>None</td>
<td></td>
</tr>
<tr>
<td><code>{attribute 'subsequent'}</code></td>
<td>None</td>
<td></td>
</tr>
<tr>
<td><code>{attribute 'symbol' := '&lt;access possibilities&gt;'}</code></td>
<td>Variable is displayed as symbol. The variable is displayed in the symbol list only when the &quot;View&quot;, &quot;Symbols Exported via Attribute&quot; option is selected in the symbol configuration editor. The access rights, which have been defined with the pragma, are displayed in the &quot;Attribute&quot; column.</td>
<td>Chapt 6.4.1.20.6.3.43 “Attribute 'symbol'” on page 2314</td>
</tr>
<tr>
<td><code>{attribute 'to_string'}</code></td>
<td>None</td>
<td></td>
</tr>
<tr>
<td><code>{warning disable &lt;compiler ID&gt; }</code></td>
<td>None</td>
<td></td>
</tr>
<tr>
<td><code>{warning restore &lt;compiler ID&gt; }</code></td>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>

See also
- Chapt 6.4.1.10.3 “Symbol Configuration” on page 1941
- Chapt 6.4.1.21.2.27 “Object 'Symbol Configuration'” on page 2523

### Conditional Pragmas

The purpose of conditional pragmas is to influence the generation of code in the pre-compilation process or the compilation process. The ST implementation language supports these pragmas.
NOTICE!
They use conditional pragmas in the implementations of POUs. CODESYS does not evaluate these conditional pragmas if you use them in the declaration part.

With conditional pragmas you affect whether implementation code is taken into account for the compilation. For example, you can make this dependent on whether a certain variable is declared, whether a certain function block exists, etc.

<table>
<thead>
<tr>
<th>Pragma</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>{define &lt;identifier&gt; &lt;string&gt;}</td>
<td>The value can be queried and compared later with hasvalue.</td>
</tr>
<tr>
<td>{undefine &lt;identifier&gt;}</td>
<td>The {define} statement of the identifier &lt;identifier&gt; is canceled, and the identifier is 'undefined' again from now on. The pragma is ignored if the specified identifier is not defined at all.</td>
</tr>
<tr>
<td>{IF &lt;expr&gt;}...</td>
<td>These are pragmas for the conditional compilation.</td>
</tr>
<tr>
<td>{ELSIF &lt;expr&gt;}...</td>
<td>The specified expressions &lt;expr&gt; must be constant at the time of compilation; they are evaluated in the order in which they appear here until one of the expressions indicates a non-zero value. The text linked to the instruction is compiled; the other lines are ignored. The order of the sections is fixed. The ELSIF and ELSE sections are optional. The ELSIF-segments may occur any number of times. You can use several conditional compilation operators within the constants &lt;expr&gt;.</td>
</tr>
<tr>
<td>{ELSE}...</td>
<td>You can use one or more operators within the constant expression &lt;expr&gt; within the conditional compilation pragma {IF} or {ELSIF}.</td>
</tr>
</tbody>
</table>

You can enter expressions and define definitions as “compiler definitions” in the “Build” tab in the Properties dialog of POUs. If you enter define definitions in the properties dialog, you must omit the term {define}, contrary to the definition in the implementation code. In addition, you can specify several define definitions in the properties dialog, separated by commas.

This operator causes the expression to be given the value TRUE. The requirement is that the identifier <identifier> was defined with the help of a {define} instruction and not undefined again afterwards with an {undefine} instruction; otherwise FALSE is returned.

**Example**

Requirement: The applications App1 and App2 exist. The variable pdef1 is defined by a {define} statement in App1, but not in App2.

```plaintext
{IF defined (pdef1)}
(* This code is processed in App1 *)
{info 'pdef1 defined'}
    hugo := hugo + SINT#1;
{ELSE}
(* the following code is only processed in App2 *)
{info 'pdef1 not defined'}
    hugo := hugo - SINT#1;
{END_IF}
```

This also contains an example of a message pragma: Only the message pdef1 defined is displayed in the message view when the application is compiled, because pdef1 is actually defined. The message pdef1 not defined is displayed if pdef1 is not defined.
This operator causes the expression to be given the value TRUE if the variable \(<variable\_name>\) is declared within the current scope; otherwise FALSE is returned.

**Example**

Requirement: The two applications App1 and App2 exist. The variable \(g\_bTest\) is declared in App1, but not in App2.

```plaintext
{IF defined (variable: g_bTest)}
(* the following code is only processed in App2*)
  g_bTest := x > 300;
{END_IF}
```

The operator causes the expression to be given the value TRUE if a data type is declared with the identifier \(<identifier>\); otherwise FALSE is returned.

**Example**

Requirement: The two applications App1 and App2 exist. The data type \(DUT\) is declared in App1, but not in App2.

```plaintext
{IF defined (type: DUT)}
(* the following code is only processed in App1*)
  bDutDefined := TRUE;
{END_IF}
```

The operator causes the expression to be given the value TRUE if a function block or an action with name \(<pou\_name>\) exists; otherwise FALSE is returned.

**Example**

Requirement: The two applications App1 and App2 exist. The function block \(CheckBounds\) exists in App1, but not in App2.

```plaintext
{IF defined (pou: CheckBounds)}
(* the following code is only processed in App1 *)
  arrTest[CheckBounds(0,i,10)] := arrTest[CheckBounds(0,i,10)] + 1;
{ELSE}
(* the following code is only processed in App2 *)
  arrTest[i] := arrTest[i]+1;
{END_IF}
```

Not yet implemented!

The operator causes the expression to be given the value TRUE if a task is defined with the name \(<task\_name>\); otherwise FALSE is returned.

**Example**

```plaintext
{IF | ELSIF defined (task: <task name> )
```
Example

Requirement: The two applications App1 and App2 exist. The task PLC_PRG_Task is defined in App1, but not in App2.

```plaintext
{END_IF}
{IF defined (task: PLC_PRG_Task)}
(* the following code is only processed in App1 *)
  erg := plc_prg.x;
{ELSE}
(* the following code is only processed in App2 *)
  erg := prog.x;
{END_IF}
```

Not yet implemented!

The operator causes the expression to be given the value TRUE if a resource object with the name <identifier> exists for the application; otherwise FALSE is returned.

Example

Requirement: The two applications App1 and App2 exist. A resource object glob_var1 of the global variable list exists for App1, but not for App2.

```plaintext
{IF defined (resource:glob_var1)}
(* the following code is only processed in App1 *)
  gvar_x := gvar_x + ivar;
{ELSE}
(* the following code is only processed in App2 *)
  x := x + ivar;
{END_IF}
```

Operator defined (resource: <identifier>)

The operator causes the expression to be given the value TRUE if a resource object with the name <identifier> exists for the application; otherwise FALSE is returned.

Operator defined (IsSimulation Mode)

The operator causes the expression to be given the value TRUE if the application runs on a simulated device, i.e. in simulation mode.

See also

- Chapter 6.4.1.12.2 “Testing in simulation mode” on page 1980

Operator defined (IsLittleEndian)

The operator causes the expression to be given the value FALSE, if the CPU memory is organized in Big Endian (Motorola byte order).

Operator defined (IsFPUSupported)

If the expression returns the value TRUE, then the code generator produces an FPU code (for the floating-point unit processor) when calculating with REAL values. Otherwise CODESYS emulates FPU operations, which is much slower.

Operator hasattribute (pou: <pou name>, '<attribute>' )

This operator causes the expression to be given the value TRUE if the attribute <attribute> is specified in the first line of the declaration part of the function block <pou name>; otherwise FALSE is returned.
Example

Requirement: The two applications App1 and App2 exist. The function fun1 is declared in App1 and App2. However, in App1 it is also provided with the pragma \{attribute 'vision'\}.

In App1:

\[
\begin{align*}
\{\text{attribute 'vision'}\} \\
\text{FUNCTION fun1 : INT} \\
\text{VAR_INPUT} \\
\quad i : \text{INT;} \\
\text{END_VAR} \\
\text{VAR} \\
\text{END_VAR}
\end{align*}
\]

In App2:

\[
\begin{align*}
\text{FUNCTION fun1 : INT} \\
\text{VAR_INPUT} \\
\quad i : \text{INT;} \\
\text{END_VAR} \\
\text{VAR} \\
\text{END_VAR}
\end{align*}
\]

Pragma instruction:

\[
\{\text{IF hasattribute (pou: fun1, 'vision')}\} \\
\{\text{END_IF}\}
\]

Example

Declaration of \texttt{g\_globalInt} in App1

\[
\begin{align*}
\text{VAR_GLOBAL} \\
\quad \{\text{attribute 'DoCount'}\} \\
\quad \text{g\_globalInt : INT;} \\
\quad \text{g\_multiType : STRING;} \\
\text{END_VAR}
\end{align*}
\]

Pragma instruction:

\[
\{\text{IF hasattribute (variable: g\_globalInt, 'DoCount')}\} \\
\{\text{END_IF}\}
\]

See also

- § Chapter 6.4.1.20.6.3.2 “User-defined attributes” on page 2272

Operator \texttt{hasattribute} (\texttt{variable:\ <variable>, '<attribute>'})

This operator causes the expression to be given the value \texttt{TRUE} if the pragma \{attribute '<attribute>'\} is assigned to the variable in the line before the variable declaration; otherwise \texttt{FALSE} is returned.

Requirement: The two applications App1 and App2 exist. The variable \texttt{g\_globalInt} is used in App1 and App2, but in App1 the attribute 'DoCount' is assigned to it in addition.

Declaration of \texttt{g\_GlobalInt} in App1

\[
\begin{align*}
\text{VAR_GLOBAL} \\
\quad \{\text{attribute 'DoCount'}\} \\
\quad \text{g\_globalInt : INT;} \\
\quad \text{g\_multiType : STRING;} \\
\text{END_VAR}
\end{align*}
\]

Declaration of \texttt{g\_GlobalInt} in App2:

\[
\begin{align*}
\text{VAR_GLOBAL} \\
\quad \text{g\_globalInt : INT;} \\
\quad \text{g\_multiType : STRING;} \\
\text{END_VAR}
\end{align*}
\]

Pragma instruction:

\[
\{\text{IF hasattribute (variable: g\_globalInt, 'DoCount')}\} \\
\{\text{END_IF}\}
\]
The operator checks whether or not the constant, which is identified with <constant name>, has been replaced. The second parameter (Boolean value) controls what is checked:

- TRUE: Checks if the constant has been replaced
- FALSE: Checks if the constant has not been replaced

When the respective case occurs, the operator returns TRUE.

**Syntax**

```plaintext
{ IF hasconstanttype( <constant name> , <boolean literal> ) }
{ ELIF hasconstanttype( <constant name> , <boolean literal> ) }
```

**Example**

```plaintext
{IF hasconstanttype(PLC_PRG.aConst, TRUE)}
```

The automatic replacement of constants in principle depends on the following:

- Compile option
- Replace constants
- Constant type (For example, STRING types are never replaced.)
- Usage of the attribute `{attribute 'const_non_replaced'}`
- Usage of the attribute `{attribute 'const_replaced'}`

**Example**

```plaintext
VAR
  iCntMAXIsReplaced: INT;
  xErrorOccured : BOOL;
END_VAR
VAR CONSTANT
  c_iMAX: INT := 99;
END_VAR

{IF hasconstanttype(c_iMAX, TRUE)}
iCntMAXIsReplaced := iCntMAXIsReplaced + 1;
{ELSE}
xErrorOccured := FALSE;
{END_IF}
```

The operator compares the value of the constant, which is identified with <constant name>, with the value of the second parameter. The second parameter can be specified either as a literal <literal> or as a variable <variable name>.

**Comparison operators <comparison operator>:**

- Greater than (>)
- Greater than or equal to (>=)
- Equal to (=)
- Not equal to (<>)
- Less than or equal to (<=)
- Less than (<)
Syntax

(IF hasconstantvalue(<constant name>, <variable name>, <comparison operator>)
(IF hasconstantvalue(<constant name>, <literal>, <comparison operator>)
(ELSIF hasconstantvalue(<constant name>, <variable name>, <comparison operator>)
(ELSIF hasconstantvalue(<constant name>, <literal>, <comparison operator>)

Example

(IF hasconstantvalue(PLC_PRG.aConst, 99, >))
(ELSIF hasconstantvalue(PLC_PRG.aConst, GVL.intconst99, =))

Example

PROGRAM PRG_ConditionConstantValue
VAR
  iCntMAX: INT;
  iCntGlobalMAX: INT;
  iCntABC: INT;
  iCntGlobalABC: INT;
  xErrorOccured: BOOL;
END_VAR
VAR CONSTANT
  c_iMAX: INT := 999;
  c_sABC: STRING := 'ABC';
  c_iNonReplaceable: INT := 888;
END_VAR
(IF hasconstantvalue(c_iMAX, 999, =))
  iCntMAX := iCntMAX + 1;
(ELSE)
  xErrorOccured := FALSE;
(END_IF)
(IF hasconstantvalue(c_iMAX, GVL.gc_iMAX, =))
  iCntGlobalMAX := iCntGlobalMAX + 1;
(ELSE)
  xErrorOccured := FALSE;
(END_IF)
(IF hasconstantvalue(c_sABC, 'ABC', =))
  iCntABC := iCntMAX + 1;
(ELSE)
  xErrorOccured := FALSE;
(END_IF)
(IF hasconstantvalue(c_sABC, GVL.gc_sABC, =))
  iCntGlobalABC := iCntMAX + 1;
(ELSE)
  xErrorOccured := FALSE;
(END_IF)
This operator causes the expression to be given the value TRUE if the variable `<variable>` is of the data type `<type-spec>`; otherwise FALSE is returned.

Possible data types for `<type-spec>`:
- BOOL
- BYTE
- DATE
- DATE_AND_TIME (DT)
- DINT
- DWORD
- INT
- LDATE
- LDATE_AND_TIME (LDT)
- LINT
- LREAL
- LTIME
- LTIME_OF_DAY (LTOD)
- LWORD
- REAL
- SINT
- STRING
- TIME
- TIME_OF_DAY (TOD)
- ULINT
- UDINT
- UINT
- USINT
- WORD
- WSTRING

**Example**

Requirement: The two applications App1 and App2 exist. The variable `g_multitype` is declared in App1 with data type LREAL, in App2 with data type STRING.

```plaintext
{IF (hastype (variable: g_multitype, LREAL))
 (* the following code is only processed in App1 *)
 g_multitype := (0.9 + g_multitype) * 1.1;
{ELSIF (hastype (variable: g_multitype, STRING))}
 (* the following code is only processed in App2 *)
 g_multitype := 'this is a multitalent';
{END_IF}
```

**Operator**

`hastype (variable: <variable>, <type-spec>)`

The checked pack mode depends on the device description, not on the pragma that can be specified for individual DUTs.

**Operator**

`hasvalue (PackMode, '<pack mode value>')`

**Operator**

`hasvalue (RegisterSize, '<register size>')`

`<register size>`: Size of a CPU register (in bits) The operator causes the expression to return the value TRUE when the size of a CPU register is equal to `<register size>`.

Possible values for `<register size>`
- 16 for C16x
- 64 for X86-64 bit
- 32 for X86-32 bit
Operator \texttt{hasvalue} (\texttt{<define-ident>, '<char-string>'})

This operator causes the expression to be given the value \texttt{TRUE} if a variable is defined with the identifier \texttt{<define-ident>} and has the value \texttt{<char-string>}; otherwise \texttt{FALSE} is returned.

\textbf{Example}

Requirement: The two applications \texttt{App1} and \texttt{App2} exist. The variable \texttt{test} is used in the applications \texttt{App1} and \texttt{App2}; in \texttt{App1} it is given the value \texttt{1}, in \texttt{App2} the value \texttt{2}.

\begin{verbatim}
{IF hasvalue(test,'1')}
(* the following code is only processed in App1 *)
x := x + 1;
{ELSIF hasvalue(test,'2')}
(* the following code is only processed in App2 *)
x := x + 2;
{END_IF}
\end{verbatim}

Operator \texttt{NOT} \texttt{<operator>}

The expression is given the value \texttt{TRUE} if the reverse value of \texttt{<operator>} returns the value \texttt{TRUE}. \texttt{<operator>} can be one of the operators described in this chapter.

\textbf{Example}

Requirement: The two applications \texttt{App1} and \texttt{App2} exist. \texttt{PLC_PRG1} exists in \texttt{App1} and \texttt{App2}, and the POU \texttt{CheckBounds} exists only in \texttt{App1}.

\begin{verbatim}
{IF defined (pou: PLC_PRG1) AND NOT (defined (pou: CheckBounds))}
(* the following code is only processed in App2 *)
bANDNotTest := TRUE;
{END_IF}
\end{verbatim}

Operator \texttt{<operator>} \texttt{AND} \texttt{<operator>}

The expression is given the value \texttt{TRUE} if the two specified operators return \texttt{TRUE}. \texttt{<operator>} can be one of the operators described in this chapter.

\textbf{Example}

Requirement: The applications \texttt{App1} and \texttt{App2} exist. \texttt{PLC_PRG1} exists in \texttt{App1} and \texttt{App2}, the POU \texttt{CheckBounds} only in \texttt{App1}.

\begin{verbatim}
{IF defined (pou: PLC_PRG1) AND (defined (pou: CheckBounds))}
(* the following code is only processed in App1 *)
bANDTest := TRUE;
{END_IF}
\end{verbatim}

Operator \texttt{<operator>} \texttt{OR} \texttt{<operator>}

The expression returns \texttt{TRUE} if one of the two specified operators returns \texttt{TRUE}. \texttt{<operator>} can be one of the operators described in this chapter.

\textbf{Example}

Requirement: The two applications \texttt{App1} and \texttt{App2} exist. The POU \texttt{PLC_PRG1} exists in \texttt{App1} and \texttt{App2}, and the POU \texttt{CheckBounds} exists only in \texttt{App1}.

\begin{verbatim}
{IF defined (pou: PLC_PRG1) OR (defined (pou: CheckBounds))}
(* the following code is only processed in App1 and in App2 *)
bORTTest := TRUE;
{END_IF}
\end{verbatim}
Operator

\(<\text{operator}>\)

() parenthesizes the operators.

See also

- %Chapter 6.4.1.20.6.3.2 “User-defined attributes” on page 2272

Region Pragma

This pragma is used for grouping several lines into one block in a text editor. The block can be named. Region pragmas can also be nested.

Code with region pragma: Expanded and collapsed views

![Region Pragma Example](image)

The pragma can be used in the ST editor and all declaration editors. Syntax highlighting can be customized in the options.

See also

- %Chapter 6.4.1.21.3.3.18 “Command ‘Collapse All Folds’” on page 2568
- %Chapter 6.4.1.21.3.3.17 “Command ‘Expand All Folds’” on page 2568

6.4.1.20.7 Identifiers

Rules for identifier designation

- An identifier must not contain spaces or special characters.
- Capitalization is ignored. For example, VAR1 and var1 refer to the same variable.
- The underscore is recognized. For example, A_BCD and AB_CD are treated as two different identifiers. Multiple consecutive underscores are not permitted.
- The length of an identifier is unrestricted.

Rules for multiple use of identifiers (namespaces)

- An identifier must not be declared two times locally.
- An identifier can be used more than one time globally. If a local variable has the same name as a global variable, then the local variable has priority within the POU.
- An identifier must not be identical to a keyword, such as the scope VAR_Global.
- A variable that is declared in a global variable list can have the same name as a variable defined in another GVL. CODESYS provides features that extend the standard for the namespace or scope of variables:
  - Global namespace operator:
    An instance path that begins with a dot always opens a global namespace. If there is a local variable (for example, `ivar`) that has the same name as a global variable, then you refer to the global variable as `.ivar`.
  - The name of a global variable list can define the namespace uniquely for the include variables. Therefore, you can declare variables with the same name in different global variables list and still uniquely reference by prepending the list name.
    
    For example, `globlist1.ivar := globlist2.ivar; (* ivar from GVL globlist2 is copied to ivar in GVL globlist1 *)`.
  - Variables that are defined in the global variable list of a library included in the project can be addressed uniquely according to the following syntax:
    `<name scope library>..< GVL name>..<variable name>`
    
    For example, `globlist1.ivar := lib1.globlist1.ivar (* ivar from GVL globlist1 in library lib1 is copied to ivar in GVL globlist1 *)`.

- When inserting a library, you also use the Library Manager to define a namespace. In this way, you can make unique references to a library block or library variable by `<namespace library>..<block name|variable name>`. Note that when libraries are nested, you have to reference the namespaces of all libraries in succession.
  
  Example: If `Lib1` is referenced by `Lib0`, then the POU `func` in `Lib1` is addressed by `Lib0.Lib1.fun:ivar := Lib0.Lib1.func(4, 5); (* return value from func is copied to variable ivar in the project *)`

We recommend that you apply the following rules in addition to the items that you have to consider specifically for variables declaration. By doing this, you get the best possible harmonization when assigning names.

**Recommendations for variable names**
Whenever possible, you should name variables in Hungarian notation in applications and libraries. Find a meaningful, short, English name for each variable as a base name, which can consist of several words. Write the first letter of each word in uppercase, the remaining letters in lowercase. In front of the base name, append a prefix in lowercase to indicate the data type of the variable.

**Example:** `iFileSize : INT;`

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Prefix</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOL</td>
<td>x</td>
<td>We expressly recommend <code>x</code> as the prefix for Boolean variables in order to distinguish them from identifiers of the data type <code>BYTE</code>. The prefix indicates the view of an IEC programmer.</td>
</tr>
<tr>
<td>BYTE</td>
<td>by</td>
<td>Reserved</td>
</tr>
<tr>
<td>WORD</td>
<td>w</td>
<td>Bit string; not for arithmetic operations</td>
</tr>
<tr>
<td>DWORD</td>
<td>dw</td>
<td>Bit string; not for arithmetic operations</td>
</tr>
<tr>
<td>LWORD</td>
<td>lw</td>
<td>Bit string; not for arithmetic operations</td>
</tr>
<tr>
<td>SINT</td>
<td>si</td>
<td>Arithmetic integer data type, 8-bit</td>
</tr>
<tr>
<td>USINT</td>
<td>usi</td>
<td>Arithmetic integer data type, 8-bit</td>
</tr>
<tr>
<td>INT</td>
<td>i</td>
<td>Arithmetic integer data type, 16-bit</td>
</tr>
<tr>
<td>UINT</td>
<td>ui</td>
<td>Arithmetic integer data type, 16-bit</td>
</tr>
<tr>
<td>DINT</td>
<td>di</td>
<td>Arithmetic integer data type, 32-bit</td>
</tr>
<tr>
<td>Data Type</td>
<td>Prefix</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>--------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>UDINT</td>
<td>udi</td>
<td>Arithmetic integer data type, 32-bit</td>
</tr>
<tr>
<td>LINT</td>
<td>li</td>
<td>Arithmetic integer data type, 64-bit</td>
</tr>
<tr>
<td>ULIINT</td>
<td>uli</td>
<td>Arithmetic integer data type, 64-bit</td>
</tr>
<tr>
<td>REAL</td>
<td>r</td>
<td>Arithmetic floating-point data type, 32-bit</td>
</tr>
<tr>
<td>LREAL</td>
<td>lr</td>
<td>Arithmetic floating-point data type, 64-bit</td>
</tr>
<tr>
<td>STRING</td>
<td>s</td>
<td>Single-byte character string of variable length (default setting: 80 characters)</td>
</tr>
<tr>
<td>WSTRING</td>
<td>ws</td>
<td>Double-byte character string of variable length (default setting: 80 characters)</td>
</tr>
<tr>
<td>TIME</td>
<td>tim</td>
<td>Time duration, 32-bit</td>
</tr>
<tr>
<td>LTIME</td>
<td>ltim</td>
<td>Time duration, 64-bit</td>
</tr>
<tr>
<td>● TIME_OF_DAY</td>
<td>tod</td>
<td>Time of day, 32-bit</td>
</tr>
<tr>
<td>● TOD</td>
<td></td>
<td></td>
</tr>
<tr>
<td>● LTIME_OF_DAY</td>
<td>ltod</td>
<td>Time of day, 64-bit</td>
</tr>
<tr>
<td>● DT</td>
<td>dt</td>
<td>Date and time</td>
</tr>
<tr>
<td>● DATE_AND_TIME</td>
<td>ldt</td>
<td>Calender date</td>
</tr>
<tr>
<td>● LDATE_AND_TIME</td>
<td></td>
<td></td>
</tr>
<tr>
<td>● DATE</td>
<td>dat</td>
<td>Calender date</td>
</tr>
<tr>
<td>● LDATE</td>
<td>ldat</td>
<td></td>
</tr>
<tr>
<td>● d</td>
<td></td>
<td></td>
</tr>
<tr>
<td>● ld</td>
<td></td>
<td></td>
</tr>
<tr>
<td>POINTER</td>
<td>p</td>
<td></td>
</tr>
<tr>
<td>ARRAY</td>
<td>a</td>
<td></td>
</tr>
<tr>
<td>Enumeration</td>
<td>e</td>
<td></td>
</tr>
</tbody>
</table>

**Example**

```plaintext
VAR
    bySubIndex: BYTE;
    xFlag: BOOL;
    udiCounter: UDINT;
END_VAR
```
### Nested declaration
Prefixes are attached successively in the order of declaration.

**Example**
```
pabyTelegramData: POINTER TO ARRAY [0..7] OF BYTE;
```

### Function block instance
Prefix: Abbreviation for the name of the function block or data type

**Example**
```
cansdoReceivedTelegram: CAN_SDOTelegram;
TYPE CAN_SDOTelegram : (* prefix: sdo *)
  STRUCT
    wIndex: WORD;
    bySubIndex:BYTE;
    byLen:BYTE;
    aby: ARRAY [0..3] OF BYTE;
  END_STRUCT
END_TYPE
```

### Local constant
Prefix: `c_`, followed by the type prefix and the variable name

**Example**
```
VAR CONSTANT
c_uiSyncID: UINT := 16#80;
END_VAR
```

### Global variable
An additional prefix is appended to the library prefix.

**Example**
```
VAR_GLOBAL
can_g_iTest: INT;
END_VAR
```

### Global constants
An additional prefix is appended to the library prefix.

**Example**
```
VAR_GLOBAL CONSTANT
can_gc_dwExample: DWORD;
END_VAR
```

### Recommendations for variable names
**CODESYS V3.x libraries**

<table>
<thead>
<tr>
<th>Identifier</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable</td>
<td>Corresponds to the description for variable names, with the exception that global variables and constants do not require library prefixes because the namespace replaces the function.</td>
<td>g_iTest: INT; // Declaration CAN.g_iTest; // Implementation; call in the program</td>
</tr>
</tbody>
</table>

### Recommendations for identifiers for user-defined data types (DUT)
<table>
<thead>
<tr>
<th>Identifier for</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
</table>
| **Structures** | Library prefix followed by an underscore and a short, informative description of the structure. The associated prefix for created variables of this structure should follow the colon as a comment. | TYPE CAN_SDOTelegram : (* prefix: sdo *)
|   |   | STRUCT |
|   |   | wIndex : WORD; |
|   |   | bySubIndex : BYTE; |
|   |   | byLen : BYTE; |
|   |   | abyData: ARRAY [0..3] OF BYTE; |
|   |   | END_STRUCT |
|   |   | END_TYPE |
| **Enumerations** | Library prefix followed by an underscore and the identifier in uppercase. Note: In past CODESYS versions, enumeration values > 16#7FFF caused errors because they were not automatically converted to INT. For this reason, enumerations should always be declared with correct INT values. | TYPE CAL_Day :
| | | ( |
| | | CAL_MONDAY, |
| | | CAL_TUESDAY, |
| | | CAL_WEDNESDAY, |
| | | CAL_THURSDAY, |
| | | CAL_FRIDAY, |
| | | CAL_SATURDAY, |
| | | CAL_SUNDAY |
| | | ); |
| | Declaration: |
| | eToday: CAL_Day; |

**Recommendations for identifiers for user-defined data types (DUT) in CODESYS V3 libraries**
### Identifier for DUT names in CODESYS V3 libraries

<table>
<thead>
<tr>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
</table>
| The namespace replaces the need for the library prefix. Therefore, it is omitted. Enumeration values are also defined without a library prefix. | Library with namespace CAL TYPE DAY :
| | ( MONDAY |
| | TUESDAY, |
| | WEDNESDAY, |
| | THURSDAY, |
| | FRIDAY, |
| | SATURDAY, |
| | SUNDAY |
| ); Declaration: |
| eToday: CAL.Day; |
| Usage in the application |
| IF eToday = CAL.Day.MONDAY THEN |

---

### Recommendations for identifiers for POUs, functions, function blocks, programs

<table>
<thead>
<tr>
<th>Identifier for</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>POUs: Functions, function blocks, programs</td>
<td>Library prefix followed by an underscore and a short, informative POU name. Like for variables, the first letter of each word is uppercase and all other letters are lowercase. We recommend that you compose the POU name from a verb and a noun. For function blocks, the associated prefix for created instances should follow the name as a comment.</td>
<td>FUNCTION_BLOCK CAN_SendTelegram (* prefix: canst *)</td>
</tr>
<tr>
<td>Actions</td>
<td>Only actions that the block itself calls, beginning with prv_. Otherwise, actions do not have a prefix.</td>
<td></td>
</tr>
</tbody>
</table>

---

### Recommendations for identifiers for POUs in CODESYS V3 libraries
6.4.1.20.8 Shadowing Rules

In CODESYS, you are generally allowed to use the same identifier for different elements. For example, a POU and a variable can be named the same. However, you should avoid this practice in order to prevent confusion.

Negative example: In the following code snippet, a local function block instance has the same name as a function:

Example

```plaintext
FUNCTION YYY : INT
;
END_FUNCTION

FUNCTION_BLOCK XXX
;
END_FUNCTION_BLOCK

PROGRAM PLC_PRG
VAR
    YYY : XXX;
END_VAR
    YYY();
END_PROGRAM
```

In such a case as this, it is unclear whether the instance or the function is called in the program.

To make sure that names are always unique, you should follow naming conventions, such as certain prefixes for variables. Rules for assigning identifiers can be found in the "Identifiers" chapter of the help.

Naming conventions can be checked automatically using the static code analysis of CODESYS. Static code analysis could also detect the duplicate use of the name YYY and report it as an error.
The consistent use of the attribute `qualified_only` for enumerations and global variable lists and the use of qualified libraries can also prevent ambiguous situations.

To make sure that a POU of the same name in the "Devices" view is not called when a POU in the "POUs" view is called, the operator `__POOL` should be prepended (for example, `svar_pou := __POOL.POU();`) when the name of the POU is called.

**Shadowing:** The compiler does not report any errors or warnings if the same identifier is used for different elements. Instead, the compiler searches the code in a specific order for the declaration of the identifier. If a declaration is found, then the compiler does not search for any other declarations elsewhere. If other declarations do exist, then they are "shadowed" for the compiler. The following section describes the shadowing rules (that is, the search order that the compiler uses when searching for the declaration for identifiers). The section "Ambiguous access and qualified access" provides ways to prevent ambiguous access and bypass shadowing rules.

### Search order in the application

When the compiler encounters a single identifier in the code of an application, it searches for the corresponding declaration in the following order:

1. Local variables of a method
2. Local variables in the function block, program, or function, and in any base function blocks
3. Local methods of the POU
4. Global variables in the application, if the `qualified_only` attribute is not set in the variable list where the global variables are declared
5. Global variables in a parent application, if the `qualified_only` attribute is not set in the variable list where the global variables are declared
6. Global variables in referred libraries when neither the library nor the variable list requires qualified access
7. POU or type names from the application (that is, names of global variable lists, function blocks, and so on)
8. POU or type names from a parent application
9. POU or type names from a library
10. Namespaces of locally referred libraries and libraries that are published by libraries
11. Global variables in the "POUs" view, unless the `qualified_only` attribute is set in the variable list where they are declared
12. POU or type names from the "POUs" view (that is, names of global variable lists, function blocks, and so on)

### Search order in the library

When the compiler encounters a single identifier in the code of a library, it searches for the corresponding declaration in the following order:

1. Local variables of a method
2. Local variables in the function block, program, or function, and in any base function blocks
3. Local methods of the POU
4. Global variables in the local library, if the `qualified_only` attribute is not set in the variable list where the global variables are declared
5. Global variables in referred libraries when neither the library nor the variable list requires qualified access

---

*Libraries that are inserted in the Library Manager of the “POUs” view are mirrored in the Library Manager in all applications in the project with the appropriate placeholder resolution. These libraries then form a common namespace with the libraries in the application. Therefore, there is no shadowing of libraries in the pool by libraries in the application.*
6. POU or type names from the local library (that is, names of global variable lists, function blocks, and so on)

7. POU or type names from a referred library

8. Namespaces of locally referred libraries and libraries that are published by locally refereed libraries

**Ambiguous access and qualified access**

Despite these search orders, ambiguous access can still occur. For example, this is the case when a variable with the same name exists in two global variable lists that do not require qualified access. Such a case is reported by the compiler as an error (for example: **ambiguous use of the name XXX**).

This kind of ambiguous usage can be made unique by means of qualified access, for example by accessing via the name of the global variable list (example: **GVL.XXX**).

Qualified access can also always be used to avoid shadowing rules.

- The name of the global variable list can be used to uniquely access a variable in the list.
- The name of a library can be used to uniquely access elements in the library.
- The **THIS** pointer be used to uniquely access variables in a function block, even if a local variable with the same name exists in a method of the function block.

To find the declaration location of an identifier at any time, use the command "**Edit ➔ Browse ➔ Go to Definition**". This can be especially helpful if the compiler produces an apparently obscure error message.

**Searching in instance paths**

The search orders described above do not apply to identifiers that exist as components in an instance path or to identifiers that are used as inputs in calls.

For access of the following type **yy.component**, it depends on the entity described by **yy** where the declaration of **component** is searched for.

If **yy** denotes a variable with a structured data type (that is, type **STRUCT** or **UNION**), then **component** is searched for in the following order:

- Local variables of the function block
- Local variables of the base function block
- Methods of the function block
- Methods of the base function block

If **yy** denotes a global variable list or a program, then **component** is searched for in this list only.

If **yy** denotes a namespace of a library, then **component** is searched for in this library exactly as described in the section above "Search order in the library".

Only in the second instance does the compiler decide whether access to the found element is granted (that is, whether the variable is only locally accessible, or whether a method is private). If access is not allowed, an error is issued.

See also

- § Chapter 6.4.1.20.7 “Identifiers” on page 2327
- § Chapter 6.4.1.20.6.3.40 “Attribute ‘qualified_only’” on page 2312
- § Chapter 6.4.1.20.2.16 “THIS” on page 2126
- § Chapter 6.4.1.20.3.74 “Operator ‘__POOL’” on page 2217

**6.4.1.20.9 Keywords**

In all editors, you must capitalize keywords that for example denote scopes, data types, or operators.

Keywords cannot be used as variable names.
### Examples

```plaintext
VAR
END_VAR
BOOL_TO_INT
IF
THEN
ELSE
LTIME
MUL
XOR
PERSISTENT
PROGRAM
```

CODESYS checks the correct use of keywords automatically and highlights errors immediately during input with a wavy underline.

When CODESYS creates implicit code, variables and functions are generally given a name that is prepended with two underscores (_). The use of double underscores in the implementation code is prevented automatically. This eliminates conflicts between internal system identifiers and identifiers assigned by the programmer.

The following keywords are used in the CODESYS export format. Therefore, you may not use them as identifiers:

- ACTION
- END_ACTION
- END_FUNCTION
- END_FUNCTION_BLOCK
- END_PROGRAM

Other valid keywords:

- VAR_ACCESS
- READ_ONLY
- READ_WRITE
- PARAMS

### 6.4.1.20.10 Methods 'FB_Init', 'FB_Reinit', and 'FB_Exit'

You can declare the methods explicitly in order to influence the initialization of function block variables, as well as the behavior when exiting function blocks.

The type of the return value for the implicit methods is `BOOL`. The value is not evaluated by the system, but the type should not be changed.

`FB_Init` is always available implicitly and it is used primarily for initialization. For a specific influence, you can also declare the methods explicitly and provide additional code there with the standard initialization code.

`FB_Reinit` must be implemented explicitly. If this method exists, then it is called after the instance of the affected function block is **copied**. That happens during an online change after changes to the function block declaration (signature change) in order to reinitialize the new instance module. To reinitialize the basic implementation of the function block, you must call `FB_Reinit` explicitly.
FB.Exit must be implemented explicitly. If there is an implementation, then the method is called before the controller removes the code of the function block instance (implicit call).

The following shows some use cases of these methods for different operating conditions.

**Operating condition "First download"**

When downloading an application to a PLC with factory settings, the memory of all variables must be offset to the required initial state. In this way, the data areas of function block instances are assigned the required values. By the explicit implementation of FB_Init for function blocks, you can react specifically to this situation in the application code. By evaluating the method parameters bInCopyCode(FALSE) and bInitRetains(TRUE), you can detect this operating condition clearly. (See "Operating condition "Online Change"" and "Operating condition "Re-download"".)

**Operating condition "Online Change"**

Within the scope of the online change, you can influence the initialization of function block instances by means of the methods FB.Exit, FB_Init, and FB_Reinit. During the online change, the changes to the application that were made in offline mode are applied in the running PLC. This is the reason that the old instances of the function blocks are replaced by new instances as much as possible without incident. If no changes were made to the declaration part of a function block in the application before login, but in the implementation only, then the data areas are not replaced. Only code blocks are replaced. Then the methods FB.Exit, FB_Init, and FB_Reinit are not called.

If you have made changes to the declaration of a function block that lead to the copying operation described above, then you receive a message during the online change about possible unintended effects. In the “Details” of the message view, you see a list of all instances to be copied.

In the code of the FB_Init method, the parameter bInCopyCode(TRUE) can be evaluated to detect whether or not an online change is being executed.

The following calls occur in succession during an online change:

1. **FB.Exit**
   ```
   old_inst.FB.Exit(bInCopyCode := TRUE);
   ```
   You can call FB.Exit when exiting the old instance in order to trigger specific cleanup tasks before the copy operation. In this way, you can prepare the data for the following copy operation and influence the state of the new instance. You can notify other parts of the application about the pending change in location in the memory. Pay special attention to the variables of type POINTER and REFERENCE. These may no longer refer to the required memory locations after the online change. Interface variables (INTERFACE) are handled separately by the compiler and they are adapted accordingly during the online change. External resources such as sockets, files, or other handles can be applied by the new instance, in some case unchanged. Often they do not have to be treated specially during an online change. (See "Operating condition "Re-download""

2. **FB_Init**
   ```
   new_inst.FB_Init(bInitRetains := FALSE, bInCopyCode := TRUE);
   ```
   FB_Init is called before the copy operation and can be used in order to execute specific operations for the online change. For example, you can initialize variables accordingly at the new location in the memory, or notify other parts of the application about the new location of specific variables in the memory.

3. **Copy operation:**
   ```
   copy(
   old_inst, new_inst);
   ```
   Existing values remain unchanged. For this purpose, they are copied from the old instance into the new instance.
4. FB_Reinit
   new_inst.FB_Reinit();

   This method is called after the copy operation and should set defined values for the
   variables of the instance. For example, you can initialize variables accordingly at the new
   location in the memory, or notify other parts of the application about the new location of
   specific variables in the memory. Design the implementation independent of the online
   change. The method can also be called from the application at any time in order to reset a
   function block instance to its original state.

   With the {attribute 'no_copy'} attribute, you can prevent that this is
   copied during the online change for a single variable of the function block. It
   always retains the initial value.

See also
- Chapter 6.4.1.21.3.4.19 “Command 'Settings of Memory Reserve for Online Change' ”
on page 2595

Operating condition "New download"
When downloading an application, an existing application may be replaced on the PLC. There-
fore, the provision of memory for the present function blocks must be regulated. You can use
the FB_Exit method for implementing the required steps for this. For example, you can offset
external resources (with socket and file handles) in a defined state.

   You can detect this operating condition by checking whether or not the parameter
   bInCopyCode = FALSE for the FB_Exit method.

Operating condition "Start of application"
The initial assignments are processed before the first cycle of the application tasks.

Example
   T1 : TON := (PT:=t#500ms);

   These kinds of assignments are executed only after calling FB_Init. In order to control the
   effects of these assignments, you can provide a function block or a method of a function
   block with the {attribute 'call_after_init'} attribute. You must add the attribute
   above the declaration part of the function block body and above the declaration part of
   the corresponding method. A POU that extends another POU which uses the {attribute
   'call_after_init'} attribute must also have the attribute. For the benefit of clarity, we
   recommend that the corresponding methods are overwritten with the same name, the same
   signature, and the same attribute. This requires calling SUPER^.MyInit. The name of the
   method can be chosen without restriction. (Exceptions: FB_Init, FB_Reinit, and FB_Exit).
   The method is called after processing the initial assignments and before starting the application
   tasks. Therefore, the method can react to user input.

   When using FB_Init or {attribute 'call_after_init'}, remember that detecting
   errors in the FB_Init method or in methods decorated with the {attribute
   'call_after_init'} attribute is tedious, because the setting of breakpoints may not have
   the expected effect.

   NOTICE!
   If the explicitly defined initialization code is reached during execution, then the
   function block instance is already completely initialized via the implicit initialization
   code. Therefore, there must not be a SUPER^.FB_Init call.
NOTICE!

FB_Init replaces the INI operator used in CoDeSys V2.3. The methods cannot be compared to the design of a constructor, such as in C#, C++, or Java. This has consequences for function blocks that extend other function blocks. (See below: "Derived function blocks")

**Interface of method FB_Init**

METHOD FB_Init : BOOL
VAR_INPUT
  bInitRetains : BOOL; // TRUE: the retain variables are initialized (reset warm / reset cold)
  bInCopyCode : BOOL; // TRUE: the instance will be copied to the copy code afterward (online change)
END_VAR

You can declare additional function block inputs in an FB_init method. Then you have to set these inputs in the declaration of the function block instance.

**Example**

**Method FB_Init for the serialdevice function block**

METHOD PUBLIC FB_Init : BOOL
VAR_INPUT
  bInitRetains : BOOL; // initializing of retain variable
  bInCopyCode : BOOL; // instance is copied to copy code
  iCOMnum : INT; // additional input: number of the COM interface, that is to be observed
END_VAR

Instantiation of the serialdevice function block:

com1: serialdevice(iCOMnum:=1);
com0: serialdevice(iCOMnum:=0);

**Interface of method FB_Reinit**

METHOD FB_Reinit : BOOL

There is the mandatory parameter bInCopyCode.

**Interface of method FB_Exit**

METHOD FB_Exit : BOOL
VAR_INPUT
  bInCopyCode : BOOL; // TRUE: the exit method is called in order to leave the instance which will be copied afterwards (online change).
END_VAR
Behavior for derived function blocks

If a function block is derived from another function block, then the FB_Init method of the derived function block must define the same parameters as the FB_Init method of the basic function block. However, you can add further parameters in order to set up a special initialization for the instance.

Example

The function blocks MainFB, SubFB, and SubSubFB are derived from each other. Therefore, SubFB EXTENDS MainFB and SubSubFB EXTENDS SubFB apply.

Calling order of methods FB_Init and FB_Init:

1. fbSubSubFb.FB_Init(...);
2. fbSubFb.FB_Init(...);
3. fbMainFb.FB_Init(...);
4. fbMainFb.FB_Init(...);
5. fbSubFb.FB_Init(...);
6. fbSubSubFb.FB_Init(...);

See also

- Chapter 6.4.1.21.2.21.6 “Object ’Method’” on page 2485
- Chapter 6.4.1.20.6.3.4 “Attribute ’call_after_init’” on page 2273
- Chapter 6.4.1.20.6.3.30 “Attribute ’no_copy’” on page 2299
- Chapter 6.4.1.20.2.15 “SUPER” on page 2125
### 6.4.1.20.11 Error Messages and Warnings

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>C0001</td>
<td>Compiler error C0001...</td>
</tr>
<tr>
<td>C0002</td>
<td>Compiler error C0002...</td>
</tr>
<tr>
<td>C0003</td>
<td>Compiler error C0003...</td>
</tr>
<tr>
<td>C0004</td>
<td>Compiler Error C0004...</td>
</tr>
<tr>
<td>C0005</td>
<td>Compiler error C0005...</td>
</tr>
<tr>
<td>C0006</td>
<td>Compiler error C0006...</td>
</tr>
<tr>
<td>C0007</td>
<td>Compiler error C0007...</td>
</tr>
<tr>
<td>C0008</td>
<td>Compiler error C0008...</td>
</tr>
<tr>
<td>C0009</td>
<td>Compiler error C0009...</td>
</tr>
<tr>
<td>C0010</td>
<td>Compiler error C0010...</td>
</tr>
<tr>
<td>C0011</td>
<td>Compiler error C0011...</td>
</tr>
<tr>
<td>C0012</td>
<td>Compiler error C0012...</td>
</tr>
<tr>
<td>C0013</td>
<td>Compiler error C0013...</td>
</tr>
<tr>
<td>C0014</td>
<td>Compiler error C0014...</td>
</tr>
<tr>
<td>C0015</td>
<td>Compiler error C0015...</td>
</tr>
<tr>
<td>C0016</td>
<td>Compiler error C0016...</td>
</tr>
<tr>
<td>C0017</td>
<td>Compiler error C0017...</td>
</tr>
<tr>
<td>C0018</td>
<td>Compiler error C0018...</td>
</tr>
<tr>
<td>C0019</td>
<td>Compiler error C0019...</td>
</tr>
<tr>
<td>C0020</td>
<td>Compiler error C0020...</td>
</tr>
<tr>
<td>C0021</td>
<td>Compiler error C0021...</td>
</tr>
<tr>
<td>C0022</td>
<td>Compiler error C0022...</td>
</tr>
<tr>
<td>C0023</td>
<td>Compiler error C0023...</td>
</tr>
<tr>
<td>C0024</td>
<td>Compiler error C0024...</td>
</tr>
<tr>
<td>C0025</td>
<td>Compiler error C0025...</td>
</tr>
<tr>
<td>C0026</td>
<td>Compiler error C0026...</td>
</tr>
<tr>
<td>C0027</td>
<td>Compiler error C0027...</td>
</tr>
<tr>
<td>C0028</td>
<td>Compiler error C0028...</td>
</tr>
<tr>
<td>C0029</td>
<td>Compiler error C0029...</td>
</tr>
<tr>
<td>C0030</td>
<td>Compiler error C0030...</td>
</tr>
<tr>
<td>C0031</td>
<td>Compiler error C0031...</td>
</tr>
<tr>
<td>C0032</td>
<td>Compiler error C0032...</td>
</tr>
<tr>
<td>C0033</td>
<td>Compiler Error C0033...</td>
</tr>
<tr>
<td>C0034</td>
<td>Compiler error C0034...</td>
</tr>
<tr>
<td>C0035</td>
<td>Compiler error C0035...</td>
</tr>
<tr>
<td>C0036</td>
<td>Compiler Error C0036...</td>
</tr>
<tr>
<td>C0037</td>
<td>Compiler error C0037...</td>
</tr>
<tr>
<td>C0038</td>
<td>Compiler error C0038...</td>
</tr>
<tr>
<td>C0039</td>
<td>Compiler error C0039...</td>
</tr>
<tr>
<td>C0040</td>
<td>Compiler error C0040...</td>
</tr>
<tr>
<td>C0041</td>
<td>Compiler error C0041...</td>
</tr>
<tr>
<td>C0042</td>
<td>Compiler error C0042...</td>
</tr>
<tr>
<td>C0043</td>
<td>Compiler error C0043...</td>
</tr>
<tr>
<td>C0044</td>
<td>Compiler error C0044...</td>
</tr>
<tr>
<td>C0045</td>
<td>Compiler error C0045...</td>
</tr>
<tr>
<td>C0046</td>
<td>Compiler error C0046...</td>
</tr>
<tr>
<td>C0047</td>
<td>Compiler error C0047...</td>
</tr>
<tr>
<td>C0048</td>
<td>Compiler error C0048...</td>
</tr>
<tr>
<td>C0049</td>
<td>Compiler error C0049...</td>
</tr>
<tr>
<td>C0050</td>
<td>Compiler error C0050...</td>
</tr>
<tr>
<td>C0051</td>
<td>Compiler Error C0051...</td>
</tr>
<tr>
<td>C0052</td>
<td>Compiler error C0052...</td>
</tr>
<tr>
<td>C0053</td>
<td>Compiler Error C0053...</td>
</tr>
<tr>
<td>C0054</td>
<td>Compiler error C0054...</td>
</tr>
<tr>
<td>C0055</td>
<td>Compiler error C0055...</td>
</tr>
<tr>
<td>C0056</td>
<td>Compiler error C0056...</td>
</tr>
<tr>
<td>C0057</td>
<td>Compiler error C0057...</td>
</tr>
<tr>
<td>C0058</td>
<td>Compiler error C0058...</td>
</tr>
<tr>
<td>C0059</td>
<td>Compiler error C0059...</td>
</tr>
<tr>
<td>C0060</td>
<td>Compiler error C0060...</td>
</tr>
<tr>
<td>C0061</td>
<td>Compiler error C0061...</td>
</tr>
<tr>
<td>C0062</td>
<td>Compiler error C0062...</td>
</tr>
<tr>
<td>C0063</td>
<td>Compiler error C0063...</td>
</tr>
<tr>
<td>C0064</td>
<td>Compiler error C0064...</td>
</tr>
<tr>
<td>C0065</td>
<td>Compiler error C0065...</td>
</tr>
<tr>
<td>C0066</td>
<td>Compiler error C0066...</td>
</tr>
<tr>
<td>C0067</td>
<td>Compiler error C0067...</td>
</tr>
<tr>
<td>C0068</td>
<td>Compiler error C0068...</td>
</tr>
<tr>
<td>C0069</td>
<td>Compiler error C0069...</td>
</tr>
<tr>
<td>C0070</td>
<td>Compiler error C0070...</td>
</tr>
<tr>
<td>C0071</td>
<td>Compiler error C0071...</td>
</tr>
<tr>
<td>C0072</td>
<td>Compiler error C0072...</td>
</tr>
<tr>
<td>Line</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>6.4.1.20.11.51</td>
<td>Compiler error C0074.</td>
</tr>
<tr>
<td>6.4.1.20.11.52</td>
<td>Compiler error C0075.</td>
</tr>
<tr>
<td>6.4.1.20.11.53</td>
<td>Compiler error C0076.</td>
</tr>
<tr>
<td>6.4.1.20.11.54</td>
<td>Compiler error C0077.</td>
</tr>
<tr>
<td>6.4.1.20.11.55</td>
<td>Compiler error C0078.</td>
</tr>
<tr>
<td>6.4.1.20.11.56</td>
<td>Compiler error C0080.</td>
</tr>
<tr>
<td>6.4.1.20.11.57</td>
<td>Compiler error C0081.</td>
</tr>
<tr>
<td>6.4.1.20.11.58</td>
<td>Compiler error C0082.</td>
</tr>
<tr>
<td>6.4.1.20.11.59</td>
<td>Compiler error C0084.</td>
</tr>
<tr>
<td>6.4.1.20.11.60</td>
<td>Compiler error C0085.</td>
</tr>
<tr>
<td>6.4.1.20.11.61</td>
<td>Compiler error C0086.</td>
</tr>
<tr>
<td>6.4.1.20.11.62</td>
<td>Compiler error C0087.</td>
</tr>
<tr>
<td>6.4.1.20.11.63</td>
<td>Compiler error C0089.</td>
</tr>
<tr>
<td>6.4.1.20.11.64</td>
<td>Compiler error C0090.</td>
</tr>
<tr>
<td>6.4.1.20.11.65</td>
<td>Compiler error C0091.</td>
</tr>
<tr>
<td>6.4.1.20.11.66</td>
<td>Compiler error C0094.</td>
</tr>
<tr>
<td>6.4.1.20.11.67</td>
<td>Compiler error C0096.</td>
</tr>
<tr>
<td>6.4.1.20.11.68</td>
<td>Compiler error C0097.</td>
</tr>
<tr>
<td>6.4.1.20.11.69</td>
<td>Compiler error C0098.</td>
</tr>
<tr>
<td>6.4.1.20.11.70</td>
<td>Compiler Error C0099 (Compiler Version &lt; 3.5.7.0)</td>
</tr>
<tr>
<td>6.4.1.20.11.71</td>
<td>Compiler error C0101.</td>
</tr>
<tr>
<td>6.4.1.20.11.72</td>
<td>Compiler error C0102.</td>
</tr>
<tr>
<td>6.4.1.20.11.73</td>
<td>Compiler error C0104.</td>
</tr>
<tr>
<td>6.4.1.20.11.74</td>
<td>Compiler error C0114.</td>
</tr>
<tr>
<td>6.4.1.20.11.75</td>
<td>Compiler Error C0115.</td>
</tr>
<tr>
<td>6.4.1.20.11.76</td>
<td>Compiler error C0116.</td>
</tr>
<tr>
<td>6.4.1.20.11.77</td>
<td>Compiler error C0117.</td>
</tr>
<tr>
<td>6.4.1.20.11.78</td>
<td>Compiler error C0118.</td>
</tr>
<tr>
<td>6.4.1.20.11.79</td>
<td>Compiler error C0119.</td>
</tr>
<tr>
<td>6.4.1.20.11.80</td>
<td>Compiler error C0120.</td>
</tr>
<tr>
<td>6.4.1.20.11.81</td>
<td>Compiler error C0122.</td>
</tr>
<tr>
<td>6.4.1.20.11.82</td>
<td>Compiler error C0124.</td>
</tr>
<tr>
<td>6.4.1.20.11.83</td>
<td>Compiler error C0125.</td>
</tr>
<tr>
<td>6.4.1.20.11.84</td>
<td>Compiler error C0126.</td>
</tr>
<tr>
<td>6.4.1.20.11.85</td>
<td>Compiler error C0130.</td>
</tr>
<tr>
<td>6.4.1.20.11.86</td>
<td>Compiler error C0131.</td>
</tr>
<tr>
<td>6.4.1.20.11.87</td>
<td>Compiler error C0132.</td>
</tr>
<tr>
<td>6.4.1.20.11.88</td>
<td>Compiler error C0136.</td>
</tr>
<tr>
<td>6.4.1.20.11.89</td>
<td>Compiler Error C0138.</td>
</tr>
<tr>
<td>6.4.1.20.11.90</td>
<td>Compiler error C0139.</td>
</tr>
<tr>
<td>6.4.1.20.11.91</td>
<td>Compiler error C0140.</td>
</tr>
<tr>
<td>6.4.1.20.11.92</td>
<td>Compiler error C0141.</td>
</tr>
<tr>
<td>6.4.1.20.11.93</td>
<td>Compiler error C0142.</td>
</tr>
<tr>
<td>6.4.1.20.11.94</td>
<td>Compiler error C0143.</td>
</tr>
<tr>
<td>6.4.1.20.11.95</td>
<td>Compiler error C0144.</td>
</tr>
<tr>
<td>6.4.1.20.11.96</td>
<td>Compiler error C0145.</td>
</tr>
<tr>
<td>6.4.1.20.11.97</td>
<td>Compiler error C0149.</td>
</tr>
<tr>
<td>6.4.1.20.11.98</td>
<td>Compiler error C0161.</td>
</tr>
<tr>
<td>6.4.1.20.11.99</td>
<td>Compiler error C0162.</td>
</tr>
<tr>
<td>6.4.1.20.11.100</td>
<td>Compiler Error C0164.</td>
</tr>
<tr>
<td>6.4.1.20.11.101</td>
<td>Compiler Error C0165.</td>
</tr>
</tbody>
</table>
6.4.1.20.11.102  Compiler error C0168........................................................... 2382
6.4.1.20.11.103  Compiler error C0169........................................................... 2382
6.4.1.20.11.104  Compiler Error C0173........................................................... 2383
6.4.1.20.11.105  Compiler error C0174........................................................... 2383
6.4.1.20.11.106  Compiler error C0175........................................................... 2383
6.4.1.20.11.107  Compiler error C0177........................................................... 2384
6.4.1.20.11.108  Compiler error C0178........................................................... 2384
6.4.1.20.11.109  Compiler Error C0179........................................................... 2385
6.4.1.20.11.110  Compiler Error C0180........................................................... 2385
6.4.1.20.11.111  Compiler error C0182........................................................... 2385
6.4.1.20.11.112  Compiler Error C0183........................................................... 2386
6.4.1.20.11.113  Compiler error C0185........................................................... 2386
6.4.1.20.11.114  Compiler Error C0186........................................................... 2386
6.4.1.20.11.115  Compiler Error C0188........................................................... 2387
6.4.1.20.11.116  Compiler error C0189........................................................... 2387
6.4.1.20.11.117  Compiler error C0190........................................................... 2388
6.4.1.20.11.118  Compiler error C0191........................................................... 2388
6.4.1.20.11.119  Compiler error C0195........................................................... 2388
6.4.1.20.11.120  Compiler error C0196........................................................... 2388
6.4.1.20.11.121  Compiler error C0197........................................................... 2389
6.4.1.20.11.122  Compiler error C0198........................................................... 2389
6.4.1.20.11.123  Compiler error C0199........................................................... 2389
6.4.1.20.11.124  Compiler error C0201........................................................... 2390
6.4.1.20.11.125  Compiler error C0203........................................................... 2390
6.4.1.20.11.126  Compiler error C0204........................................................... 2391
6.4.1.20.11.127  Compiler error C0205........................................................... 2391
6.4.1.20.11.128  Compiler error C0206........................................................... 2391
6.4.1.20.11.129  Compiler Error C0207........................................................... 2391
6.4.1.20.11.130  Compiler error C0208........................................................... 2392
6.4.1.20.11.131  Compiler Error C0209........................................................... 2392
6.4.1.20.11.132  Compiler error C0211........................................................... 2392
6.4.1.20.11.133  Compiler error C0212........................................................... 2393
6.4.1.20.11.134  Compiler Error C0215........................................................... 2393
6.4.1.20.11.135  Compiler error C0216........................................................... 2393
6.4.1.20.11.136  Compiler error C0217........................................................... 2393
6.4.1.20.11.137  Compiler error C0218........................................................... 2394
6.4.1.20.11.138  Compiler error C0219........................................................... 2394
6.4.1.20.11.139  Compiler error C0221........................................................... 2395
6.4.1.20.11.140  Compiler error C0222........................................................... 2395
6.4.1.20.11.141  Compiler error C0224........................................................... 2395
6.4.1.20.11.142  Compiler Error C0225........................................................... 2396
6.4.1.20.11.143  Compiler error C0227........................................................... 2396
6.4.1.20.11.144  Compiler error C0228........................................................... 2397
6.4.1.20.11.145  Compiler Error C0230........................................................... 2397
6.4.1.20.11.146  Compiler Error C0232........................................................... 2397
6.4.1.20.11.147  Compiler Error C0233........................................................... 2398
6.4.1.20.11.148  Compiler error C0234........................................................... 2398
6.4.1.20.11.149  Compiler error C0235........................................................... 2399
6.4.1.20.11.150  Compiler error C0236........................................................... 2399
6.4.1.20.11.151  Compiler error C0237........................................................... 2399
6.4.1.20.11.152  Compiler error C0238........................................................... 2400
Compiler error C0001

**Message:** Constant '<constant value>' too large for type '<data type>'

**Possible error cause:** A typed constant is too large for the given data type or a constant is too large for each possible data type.

**Error correction:** Use smaller constants or an appropriate data type for a typed constant.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
    test1: INT;
    test2: INT;
    test3: LREAL;
END_VAR

    test1 := 1234567891234556699192393292939911;
    test2 := INT#123456;
    test3 := 10E500;

--> C0001: Constant '1234567891234556699192393292939911' too large for type 'ANY_INT'
--> C0001: Constant 'INT#123456' too large for type 'INT'
--> C0001: Constant '10E500' too large for type 'ANY_REAL'
```
**Possible error cause:** Attempted access to a bit that is outside of the range for a data type.

**Error correction:** Use a bit value for the bit access that is lower than the number of bits in the data type of the variable.

---

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
    test1: WORD;
    test2: BOOL;
END_VAR

    test1 := test2.17;
--> C0003: '17' is not a valid bit number for 'w'
```

---

**Compiler Error C0004**

**Message:** `<variable>` is not a component of `<structure>`

**Possible error cause:** Component access with `.` to a variable that is not a structured value or does not exist as a component of the structure.

**Error correction:** Access a defined component, or change the definition of the component in the data type. The input assistance "List components" provides all valid access to this position.

---

**Example of the error:**

```plaintext
TYPE DUT:
STRUCT
    x, y : INT;
END_STRUCT
END_TYPE

PROGRAM PLC_PRG
VAR
    test1: DUT;
    test2: INT;
END_VAR

    test2 := test1.z;
--> C0032: Type 'Unknown type: 'test1.z'' cannot be converted to type 'INT'
--> C0004: 'z' is to a component of 'DUT'
```

---

**Compiler error C0005**

**Message:** Constant overflow in address `<address>`

**Possible error cause:** At least one component in the address does not fit into a 32-bit integer value.

**Error correction:** Use a valid address expression.

---

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
    X: BYTE;
END_VAR

    X := %QB5555555555;
--> C0005: Constant overflow in address '%??'
```
Compiler error C0006

**Message:** '<operator>' expected instead of '<token>'

**Possible error cause:** Syntax error

**Error correction:** Use the correct syntax.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
    x: INT;
    bTest : BOOL;
END_VAR

IF bTest
    x := 9;
END_IF

--> C0006: 'THEN' expected instead of 'x'
```

Compiler error C0007

**Message:** Expression expected instead of '<token>'

**Possible error cause:** Syntax error

**Error correction:** Use the correct syntax.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
    x: INT;
    bTest : BOOL;
END_VAR

IF THEN
    x := 9;
END_IF

--> C0007: Expression expected instead of 'THEN'
```

Compiler error C0008

**Message:** Unexpected end-of-file found: '<operator 1>', '<operator 2>', or '<operator 3>'

**Possible error cause:** Syntax error

**Error correction:** Use the correct syntax.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
    x: INT;
    bTest : BOOL;
END_VAR

IF bTest THEN
    x := 9;

--> C0008: Unexpected end-of-file found: 'ELSIF', 'ELSE' or 'END_IF' expected
```
Compiler error C0009
  Message: Unexpected token '<token>' found
  Possible error cause: Syntax error
  Error correction: Use the correct syntax.

Example of the error:
PROGRAM PLC_PRG
VAR
END_VAR
END_FOR;

--> C0009: Unexpected token 'END_FOR' found

Compiler error C0010
  Message: Unexpected end-of-file found: '<token>' expected
  Possible error cause: Syntax error
  Error correction: Use the correct syntax.

Example of the error:
PROGRAM PLC_PRG
VAR
  i: INT;
END_VAR
FOR i := 0 TO 2 DO
  END_FOR;

--> C0010: Unexpected end-of-file 'END_FOR' found

Compiler error C0011
  Message: No 'CASE' label found
  Possible error cause: Syntax error in a CASE statement. A statement in a CASE statement is not assigned to a CASE label.
  Error correction: Add a CASE label.

Example of the error:
PROGRAM PLC_PRG
VAR
  i: INT;
  x: INT;
END_VAR
CASE i OF
  x := 9;
END_CASE

--> C0011: No 'CASE' label found

Error correction:
CASE i OF
  0: x := 9;
END_CASE
Compiler error C0013

**Message:** At least one statement is expected.

**Possible error cause:** At least one statement is expected at some positions in the code. For example, in the THEN and ELSE part of an IF statement, or in the body of a FOR loop.

**Error correction:** Add at least one statement at the selected position. It is enough to write a blank statement ";".

**Example of the error:**

```
PROGRAM PLC_PRG
VAR
  bTest: BOOL;
END_VAR

IF bTest THEN
END_IF

--> C0013: At least one statement is expected
```

Compiler error C0016

**Message:** Counter initialization expected

**Possible error cause:** Syntax error in a FOR loop. The counter variable is not initialized correctly.

**Error correction:** Pay attention to the correct syntax of the FOR loop.

```
FOR i := 0 TO 10 DO
  ;
END_FOR
```

**Example of the error:**

```
PROGRAM PLC_PRG
VAR
  i: INT;
END_VAR

FOR i TO 10 DO
  ;
END_FOR

--> C0015: Counter initialization expected
```

Compiler error C0018

**Message:** <expression> is not a valid assignment target

**Possible error cause:** An expression with no write permission is on the left side of an assignment. Example: a constant.

**Error correction:** Assign only to variables that have write access.

**Example of the error:**

```
PROGRAM PLC_PRG
VAR
  i: INT;
END_VAR
VAR CONSTANT
```

Example of the error:

```
PROGRAM PLC_PRG
VAR
  i: INT;
END_VAR
VAR CONSTANT
```
j: INT := 0;
END_VAR
j := i;

--> C0018: 'j' is not a valid assignment target

Compiler error C0020
Message: '<statement>' is no valid statement
Possible error cause: Syntax error (for example, too few or too many characters)
Error correction: Make sure that the syntax is correct.

Example of the error:
PROGRAM PLC_PRG
VAR
  x : INT;
END_VAR
x = 2;

--> C0020: '(x = 2); ' is no valid statement
Error correction: Example:
  x := 2;

Compiler error C0022
Message: '<operator>' needs exactly '<number of operands>' operands
Possible error cause: Too many or too few operands are assigned to an operator.
Error correction: Assign the required number of operands to the operator.

Example of the error:
PROGRAM PLC_PRG
VAR
  i : INT;
  pt: POINTER TO INT;
END_VAR
pt := ADR(i,1);

--> C0022: 'ADR' needs exactly '1' operands
Error correction: Example:
  pt := ADR(i);

Compiler error C0023
Message: '<operator>' needs at least '<number of operands>' operands
Possible error cause: Too few operands are assigned to an operator.
Error correction: Assign the required number of operands to the operator.
Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
    i : INT;
END_VAR

i := MUX(30,40);
```

--> C0023: 'MUX' needs at least '3' operands

Error correction:

```plaintext
Example:
i := MUX(30,40,50);
```

Compiler error C0026

Message: Identifier expected instead of '<invalid identifier>'

Possible error cause: An invalid identifier is passed to a method.

Error correction: Use valid identifiers.

Example of the error:

```plaintext
METHOD 123
VAR_INPUT
END_VAR
```

--> C0243: The name used in the signature is not identical to the object name

--> C0026: Identifier expected instead of '123'

Error correction:

```plaintext
Example:
METHOD METH123
```

Compiler error C0027

Message: size of string expected after '('

Possible error cause: The length of the string is not specified.

Error correction: Specify a string length between the parentheses.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
    str : STRING();
END_VAR
```

--> C0027: size of string expected after '('

--> C0006: ';, :=, REF=, ( or ['] expected instead of ')'

Error correction:

```plaintext
Example:
str : STRING(100);
```

Compiler error C0030

Message: Direct Address expected after 'AT' instead of '<identifier>'

Possible error cause: Either an invalid address or no address is assigned after 'AT'.

Error correction: Specify a valid address.
Example of the error:
PROGRAM PLC_PRG
VAR
    i AT ABC : INT;
END_VAR

--> C0030: Direct Address expected after 'AT' instead of 'ABC'

Error correction:
Example:
    i AT %IW0 : INT;

Compiler error C0031

Message: Type definition expected instead of '<no data type>'
Possible error cause: An invalid type definition is assigned to the identifier.
Error correction: Specify a valid type definition.

Example of the error:
PROGRAM PLC_PRG
VAR
    i : 0;
END_VAR

--> C0031: Type definition expected instead of '0'

Error correction:
Example:
    i : INT;

Compiler error C0032

Message: Type '<type 1>' can not be converted to type '<type 2>'
Possible error cause: A variable is assigned to another variable with an incompatible type.
Error correction: Use a type conversion.

Example of the error:
PROGRAM PLC_PRG
VAR
    test1: INT;
    test2: STRING;
END_VAR

    test1 := test2;

--> C0032: Type 'STRING' cannot be converted to type 'INT'

Error correction:
Example:
    test1 := TO_INT(test2);

Compiler Error C0033

Message: Type '<pointer type>' possibly not convertible to type '<data type>'
Possible error cause: This error occurs only when checking pool objects. An attempt was made to convert a pointer to an integer. Because the size of pointers in a library is unknown, errors may occur when using the library.
Error correction: Use the type __UXINT or __XWORD for platform-independent calculations with pointers.
Example of the error:

```
PROGRAM PLC_PRG
VAR
  ptr : POINTER TO INT;
  dw : DWORD;
END_VAR
  dw := ptr;

--> C0033: Type 'POINTER TO INT' possibly not convertible to type 'DWORD'.
```

Compiler error C0035

**Message:** Program name, function or function block instance expected instead of '<invalid function>'

**Possible error cause:** A function is called that does not exist.

**Error correction:** Make sure that only program names, functions, and function Block Instances that exist are called.

Example of the error:

```
PROGRAM PLC_PRG
VAR
  end_var
  PLC_PRG.METH1();
METHOD METH
VAR_INPUT
END_VAR

--> C0004: 'METH1' is no component of 'PLC_PRG'
--> C0035: Program name, function or function block instance expected instead of 'PLC_PRG.METH1'
```

**Error correction:** Example:

```
PLC_PRG.METH();
```

Compiler Error C0036

**Message:** Cannot call object of type <type>

**Possible error cause:** An attempt has been made to call an object that does not support any calls.

**Error correction:** Only functions, function blocks, programs, methods, and actions can be called.

Example of the error:

```
VAR_GLOBAL GVL
  value : INT;
END_VAR
PRGGRAM PLC_PRG
GVL();

--> C0036: Cannot call object of type 'VAR_GLOBAL'.
```

Compiler error C0037

**Message:** '<invalid input>' is no input of '<function name>'
Possible error cause: A local variable is defined in a function call.

Error correction: Declare the variable as an input parameter.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
  i : INT;
END_VAR
i := TEST(iVar := 1);

FUNCTION TEST : INT
VAR
  iVar : INT;
END_VAR

--> C0037: 'iVar' is no input of 'TEST'
```

Error correction:

```plaintext
Example:
VAR_INPUT
  iVar : INT;
END_VAR
```

Compiler error C0038

Message: '<invalid output>' is no output of '<function name>'

Possible error cause: A local variable is handled as an output in a function call.

Error correction: Declare the variable as an output parameter.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
  i : INT;
  x : INT;
END_VAR
i := TEST(iVar => x);

FUNCTION TEST : INT
VAR
  iVar : INT;
END_VAR

--> C0038: 'iVar' is no output of 'TEST'
```

Error correction:

```plaintext
Example:
VAR_OUTPUT
  iVar : INT;
END_VAR
```

Compiler error C0039

Message: VAR_IN_OUT '<invalid variable>' must be assigned in call of '<function block name>'

Possible error cause: An IN_OUT variable is not passed to a function block that requires an IN_OUT variable.

Error correction: Assign the IN_OUT variable.
Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
  inst : FB;
END_VAR
inst();

FUNCTION_BLOCK FB
VAR_IN_OUT
  inout : INT;
END_VAR

--> C0039: VAR_IN_OUT 'inout' must be assigned in call of 'FB'

Error correction:
Example:
inst(inout := i);
```

Compiler error C0040

- **Message:** Function '<function name>' requires exactly '<number of inputs>' input
- **Possible error cause:** Too many or too few parameters are passed to the called function.
- **Error correction:** Pass exactly as many parameters to the function as are expected.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
  i : INT;
END_VAR
i := TEST(1,2);

FUNCTION TEST : INT
VAR_INPUT
  IN: INT;
END_VAR

--> C0040: Function 'TEST' requires exactly '1' inputs

Error correction:
Example:
i := Test(1);
```

Compiler error C0041

- **Message:** VAR_IN_OUT parameter '<parameter name>' of '<function name>' needs variable with write access as input
- **Possible error cause:** The passed parameter is not a variable with write access (but a constant for example).
- **Error correction:** Pass a VAR_IN_OUT parameter with write access to the function.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
  i : INT;
  x : INT;
END_VAR
i := Test(31415);

FUNCTION TEST : INT
  Example of the error:
  PROGRAM PLC_PRG
  VAR
    i : INT;
    x : INT;
  END_VAR
  i := Test(31415);

  FUNCTION TEST : INT
    Example of the error:
    PROGRAM PLC_PRG
    VAR
      i : INT;
      x : INT;
    END_VAR
    i := Test(31415);

    FUNCTION TEST : INT
```
VAR_IN_OUT
    in_out: INT;
END_VAR

--> C0041: VAR_IN_OUT' parameter 'in_out' of 'TEST' needs variable with write access as input

Error correction: Example:
i := Test(x);

Compiler Error C0042 (Compiler Version <= 3.4.10)

Message: Either all or none formal parameter have to be denoted in function call
Possible error cause: The parameters are explicitly assigned to the function in the wrong order.
Error correction: Use uniform formal parameters or implicit parameters.

Example of the error:
PROGRAM PLC_PRG
VAR
    i : INT;
END_VAR
    i := Test(iPar1:=2, 5);

FUNCTION Test : INT
VAR_INPUT
    iPar1 : INT;
    iPar2 : INT;
END_VAR

--> Either all or none formal parameter have to be denoted in function call

Compiler error C0043

Message: Wrong formal parameter: '<parameter name>' expected in this place
Possible error cause: The parameters are assigned to the function explicitly in the wrong order.
Error correction: Specify the parameters in the correct order.

Example of the error:
PROGRAM PLC_PRG
VAR
    i : INT;
END_VAR
    i := Test(iPar2 := 2, 5);

FUNCTION Test : INT
VAR_INPUT
    iPar1 : INT;
    iPar2 : INT;
END_VAR

--> C0043: Wrong formal parameter: 'iPar1' expected in this place
--> C0412: Multiple input assignments for parameter ''
Error correction:  
Example:  
i := Test(5, iPar2 := 2);

Compiler error C0044  

Message: Assignment to input missing for parameter '<input variable name>' in call of '<function block name>'

Possible error cause: A parameter is passed although an input variable is not declared.

Error correction: Declare an input variable.

Example of the error:  
PROGRAM PLC_PRG  
VAR  
    inst : FB;  
END_VAR  
    inst(1);  

FUNCTION_BLOCK FB  
VAR_INPUT  
END_VAR  

--> C0044: Assignment to input missing for parameter '1' in call of 'FB'

Error correction:  
Example:  
VAR_INPUT  
    in: INT;  
END_VAR

Compiler error C0045  

Message: Use of 'THIS' is not allowed in this context

Possible error cause: In order to be assigned to the current instance, THIS can be used only in a method, action, transition, or in the body of a function block. This error message appears for all other positions.

Error correction: Use THIS in an allowed context only.

Example of the error:  
PROGRAM PLC_PRG  
VAR  
    test1: INT;  
END_VAR  
    THIS^.test1 := 19;  

--> C0018: 'THIS^.test1' is not a valid assignment target  
--> C0062: 'THIS^' is not a structure variable  
--> C0045: Use of 'THIS' is not allowed in this context

Compiler error C0046  

Message: Identifier '<identifier name>' not defined

Possible error cause: An identifier is used that is not declared.
**Error correction:** Declare the variables that you want to use.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
  i := i;
END_VAR

--> C0018: 'i' is no valid assignment target
--> C0046: Identifier 'i' not defined
```

**Error correction:**

```plaintext
Example:
VAR
  i : INT;
END_VAR
```

**Compiler error C0047**

**Message:** Cannot apply indexing with '[]' to an expression of type '<data type>'

**Possible error cause:** A data type that is not an array is indexed with '[]'.

**Error correction:** Index data types with '[]' only if they are declared as arrays.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
  i : INT;
END_VAR
i[1];

--> C0047: Cannot apply indexing with '[]' to an expression of type 'INT'
```

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
  arr1 : ARRAY[1..2,1..3] OF INT;
END_VAR
arr1[1] := 5;
```

**Compiler error C0048**

**Message:** Array requires exactly '<number>' indexes

**Possible error cause:** Too many or too few indexes are specified when using an array.

**Error correction:** Specify as many indexes as there are dimensions assigned to the array.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
  arr1 : ARRAY[1..2,1..3] OF INT;
END_VAR
arr1[1] := 5;
```

**Error correction:**

```plaintext
Example:
arr1[1,2] := 5;
```
Compiler error C0049

Message: The constant index 'index value' is not within the range from 'start index' to 'end index'.

Possible error cause: An index is specified that is outside the size of the array.

Error correction: Use only indexes that are within the size of the array.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
  arr1 : ARRAY[1..2] OF INT;
END_VAR
arr1[3] := 1;
```

--> C0049: The constant index '3' is not within the range from '1' to '2'

Error correction:

Example:

```plaintext
arr1[2] := 1;
```

Compiler error C0050

Message: Bitaccess requires literal or symbolic integer constant

Possible error cause: No literal or an integer constant is specified in a bit access.

Error correction: Use a literal or an integer constant.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
  i : INT;
  x : INT;
END_VAR
i.x := FALSE;
```

--> C0018: 'i.x' is no valid assignment target
--> C0050: Bitaccess requires literal or symbolic integer constant

Error correction:

Example:

```plaintext
i := Test(x);
```

Compiler Error C0051

Message: Single byte string expected for an attribute value instead of '<value>'.

Possible error cause: A character string does not appear at the displayed location as expected.

Error correction: Replace the current value with a string.

Example of the error:

```plaintext
PROGRAM PLC_PRG
{IF hasattribute(pou: MyPOU, MyAttribute)}
{END_IF}
```

--> C0051: Single byte string expected for an attribute value instead of 'MyAttribute'.

Example:

```plaintext
{IF hasattribute(pou: MyPOU, 'MyAttribute')} {END_IF}
```
Error correction:  
PROGRAM PLC_PRG
(IF hasattribute(pou: MyPOU, 'MyAttribute'))
(END_IF)

Compiler Error C0053  
**Message:** Compiler version <version> has been withdrawn. Please use a higher compiler version instead.  
**Possible error cause:** The current compiler version cannot be used.  
**Error correction:** Adapt the current compiler version in the project (Project Environment, Project Settings).

Compiler error C0061  
**Message:** Bitaccess on function call is not allowed  
**Possible error cause:** Bit access is performed on a function.  
**Error correction:** Use bit access only for supported data types.

Example of the error:  
PROGRAM PLC_PRG  
VAR  
END_VAR  
Test().2;  
FUNCTION Test : INT  
VAR_INPUT  
END_VAR  
--> C0061: Bitaccess on function call is not allowed

Compiler error C0062  
**Message:** `<variable name>` is no structured variable  
**Possible error cause:** A variable that is not a structure variable is treated like a structure variable.  
**Error correction:** Make sure that the variable is a structure variable.

Example of the error:  
PROGRAM PLC_PRG  
VAR  
  pt : PUNKT;  
  i : INT;  
END_VAR  
i.x := 1024;  
  TYPE Punkt :  
    STRUCT  
      x : REAL;  
      y : REAL;  
    END_STRUCT
--- C0018: 'i.x' is no valid assignment target
--- C0062: 'Variable' is no structured variable

Example:
pt.x := 1024;

Compiler error C0064
Message: Dereferencing requires a pointer
Possible error cause: A variable that is not a pointer variable is dereferenced.
Error correction: Dereference only variables that are pointer variables.

Example of the error:
PROGRAM PLC_PRG
VAR
  i : INT;
  pi : POINTER TO INT;
END_VAR
i^:=1;

--- C0018: 'i^' not a valid assignment target
--- C0064: Dereferencing requires a pointer

Error correction:
Example:
pi := ADR(i);
pi^ := 1;

Compiler Error C0065
Message: There is no global definition for '<name>'.
Possible error cause: The value searched for is not a global variable, global POU, or other value that can be accessed globally.
Error correction: Declare '<name>' as a global variable.

Example of the error:
PROGRAM PLC_PRG
.someValue := 5;

--- C0065: There is no global definition for 'someValue'

Error correction:
Example:
VAR_GLOBAL
  someValue : INT;
END_VAR

Compiler error C0066
Message: Cannot compare type '<data type>' with type '<data type>'
Possible error cause: Two data types are compared which cannot be compared with each other.
Error correction: Compare only data types that can be compared with each other.
Example of the error:

PROGRAM PLC_PRG
VAR
    i : INT;
    re : REAL;
    str: STRING;
    b : BOOL;
END_VAR

b := i > str;

--> C0066: Cannot compare type 'INT' with type 'STRING'

Error correction:

Example:

b := i > re;

Compiler error C0068

Message: Compare not possible on objects of type '<data type>'
Possible error cause: Objects are being compared in which a comparison is not possible.
Error correction: Compare only data types in which a comparison is possible (INT, REAL, etc.).

Example of the error:

PROGRAM PLC_PRG
VAR
    b : BOOL;
    arr1 : ARRAY [1..2] OF INT;
    arr2 : ARRAY [1..2] OF INT;
END_VAR

b := arr1 > arr2;

--> C0068: Compare not possible on objects of type 'ARRAY [1..2]'

Compiler error C0069

Message: Compare not possible on objects of type '<data type>' or '<data type>'
Possible error cause: Two different objects are being compared in which a comparison is not possible.
Error correction: Compare only data types in which a comparison is possible (INT, REAL, etc.).

Example of the error:

PROGRAM PLC_PRG
VAR
    b : BOOL;
    arr1 : ARRAY [1..2] OF INT;
    arr2 : ARRAY [1..3] OF INT;
END_VAR

b := arr1 > arr2;

--> C0069: Compare not possible on objects of type 'ARRAY [1..2]' or 'ARRAY [1..3]'
Compiler error C0070

**Message:** 'INI' operator needs function block instance or data unit type instance

**Possible error cause:** Neither a function block instance nor a DUT instance is applied to the INI operator.

**Error correction:** Pass only function block instances or DUT instances to the INI operator.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
  b : BOOL;
  inst : FB;
END_VAR

b := INI(b, TRUE);

FUNCTION_BLOCK FB
VAR
END_VAR

--> C0070: 'INI' operator needs function block instance or data unit type instance

Example:
  b := INI(inst, TRUE);
```

Compiler error C0072

**Message:** Operator '<operator name>' is not possible on type '<data type>'

**Possible error cause:** An operator is applied to an incompatible type.

**Error correction:** Apply operators only on compatible types.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
  i : INT;
  str : STRING;
END_VAR

str := ABS(str);

--> C0072: Operator 'Abs' is not possible on type 'STRING'

Example:
  i := ABS(i);
```

Compiler error C0074

**Message:** Unexpected array initialisation

**Possible error cause:** Syntax error in the array initialization

**Error correction:** Correct the syntax
Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
  arr1 : INT := [1,2,3,4,5,6];
END_VAR
```

--> C0074: Unexpected array initialisation
--> C0032: Cannot convert type 'Unknown type: [1,2,3,4,5,6]' to type 'INT'

Error correction:

Example:

```plaintext
arr1 : ARRAY [1..6] OF INT := [1,2,3,4,5,6];
```

Compiler error C0075

Message: Too many initializers for array
Possible error cause: Too many values are specified for the size of the array.
Error correction: The number of assigned values must correspond to the size of the array.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
  arr1 : ARRAY [1..5] OF INT := [1,2,3,4,5,6];
END_VAR
```

--> C0075: Unexpected array initialisation

Error correction:

Example:

```plaintext
arr1 : ARRAY [1..6] OF INT := [1,2,3,4,5,6];
```

Compiler error C0076

Message: Unexpected structure initialisation
Possible error cause: Syntax error in the structure initialization
Error correction: Make sure that the syntax is correct.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
  st1 : INT := (p1 := 1);
END_VAR
```

--> C0076: Unexpected structure initialisation
--> C0032: Cannot convert type 'STRUCT(p1:=1)' to type 'INT'
--> C0046: Identifier 'p1' not defined
--> C0018: 'p1' is no valid assignment target

Error correction:

Example:

```plaintext
st1 : STRUCT1 := (p1:=1,p2:=10);
```

Compiler error C0077

Message: Unknown type: '<data type>'
Possible error cause: Invalid data type in the declaration (maybe a syntax error)
Error correction: Specify valid data types only.
Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
  i : INTEGER;
END_VAR

--> C0077: Unknown type: 'INTEGER'
```

Error correction:

```plaintext
Example:
arr1 : ARRAY[1..2] OF STRUCT1 := (p1:=1,p2:=10);
```

Compiler Error C0078

Message: Unsupported type: '<data type>'

Possible error cause: The used type is not supported by the current device and therefore cannot be used.

Error correction: If possible, use a different type. For example, REAL instead of LREAL.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
  value : LREAL;
END_VAR

--> C0078: Unsupported type: 'LREAL'
```

Error correction:

```plaintext
Example:
PROGRAM PLC_PRG
VAR
  value : REAL;
END_VAR
```

Compiler error C0080

Message: Functionblock '<function block name>' must be instantiated to be accessed

Possible error cause: Missing function Block Instantiation

Error correction: Instantiate the function block.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
END_VAR

FB();

FUNCTION_BLOCK FB
VAR
END_VAR

--> C0080: Functionblock 'FB' must be instantiated to be accessed
```

Error correction:

```plaintext
Example:
VAR
  inst : FB;
END_VAR
inst();
```
Compiler error C0081

Message: Unexpected Pragma: '<pragma name>' found without matching 'if'

Possible error cause: The IF condition is missing when using the pragma.

Error correction: Complete the IF condition of the pragma.

Example of the error:

PROGRAM PLC_PRG
VAR
  i : INT;
END_VAR

i := 5;
{END_IF}

--> C0081: Unexpected Pragma: 'END_IF' found without matching 'if'

Error correction:
Example:
{IF <expression>}
i := 5;
{END_IF}

Compiler error C0082

Message: '<invalid pragma>' is no valid condition for pragma

Possible error cause: When using a pragma, an invalid expression is used in the IF condition.

Error correction: Use valid pragma conditions.

Example of the error:

PROGRAM PLC_PRG
VAR
  i : INT;
END_VAR

{IF abc}
i := 5;
{END_IF}

--> C0082: '!!!ERROR!!!' is no valid condition for pragma

Error correction:
Example:
{IF defined (abc)}

Compiler error C0084

Message: '<pragma operand>' is no valid operand for pragma

Possible error cause: Syntax error

Error correction: Use valid pragma operands.
Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
END_VAR

{IF defined(0)}
{END_IF}

--> C0084: 'defined(null)' is no valid operand for pragma
```

Error correction:

```plaintext
Example:
{IF defined (abc)}
```

Compiler Error C0085

**Message:** Define value expected instead of '<value>'.

**Possible error cause:** A string is expected instead of the current value at the displayed location of the pragma.

**Error correction:** Replace the current value with a string.

Example of the error:

```plaintext
PROGRAM PLC_PRG
{IF hasvalue(define, defineValue)}
{END_IF}

--> C0086: C:0085: Define value expected instead of 'defineValue'
```

Error correction:

```plaintext
Example:
PROGRAM PLC_PRG

{IF hasvalue(define, '120')} {END_IF}
```

Compiler error C0086

**Message:** No definition found for interface '<interface name>'

**Possible error cause:** An undefined interface is used.

**Error correction:** Define the interface.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
  inst : FB;
END_VAR

FUNCTION_BLOCK FB IMPLEMENTS XY
VAR
END_VAR

--> C0086: No definition found for interface 'XY'
```

Error correction:

```plaintext
Example:
INTERFACE XY
```
Compiler error C0087

**Message:** There is no implementation for method '<method name>' defined in interface '<interface name>'.

**Possible error cause:** One of the methods specified by the interface has not be provided by the implemented function block.

**Error correction:** Implement all methods that are specified by the interface.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
  inst : FB;
END_VAR

INTERFACE XY
METHOD METH1
VAR_INPUT
END_VAR

FUNCTION_BLOCK FB IMPLEMENTS XY
VAR
END_VAR
METHOD METH2
VAR_INPUT
END_VAR

--> C0087: There is no implementation for method 'METH1' defined in interface 'XY'
```

Compiler error C0089

**Message:** Interface of overridden method '{0}' of interface '{1}' does not match declaration

**Possible error cause:** The signature of the implemented method does not match the signature of the method in the interface.

**Error correction:** Make sure that the same return types and parameters are declared.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
  inst : FB;
END_VAR

INTERFACE XY
METHOD METH1
VAR_INPUT
  iPar : INT;
END_VAR

FUNCTION_BLOCK FB IMPLEMENTS XY
VAR
END_VAR
METHOD METH1
VAR_INPUT
```
Compiler error C0090

Message: No definition found for base class '<function name>'
Possible error cause: The function block specified as the base does not exist or is not a function block.
Error correction: Use a function block as the base.

Example of the error:

PROGRAM PLC_PRG
VAR
  inst : FB;
END_VAR

FUNCTION_BLOCK FB EXTENDS POU
VAR
END_VAR

FUNCTION POU
VAR
END_VAR

--> C0090: No definition found for base class 'POU'

Compiler error C0091

Message: Recursion in base function block list: <function name>
Possible error cause: A base function block is extended by itself.
Error correction: Recursion in base function block lists is not possible.

Example of the error:

PROGRAM PLC_PRG
VAR
  inst : FB;
END_VAR

FUNCTION_BLOCK FB EXTENDS FB
VAR
END_VAR

--> C0091: Recursion in base function block list: FB -> FB

Compiler error C0094

Message: Interface of overridden method '<method name>' of interface '<function block name>' doesn't match declaration
Possible error cause: The signature of the method of the first interface does not match the signature of the method in the second interface, which is extended by the first.
Error correction: Align the signatures.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
    xyz : XY2;
END_VAR

FUNCTION_BLOCK XY
METHOD METH1
VAR_INPUT
END_VAR

FUNCTION_BLOCK XY2 EXTENDS XY
METHOD METH1
VAR_INPUT
    _iPar : BOOL;
END_VAR

--> C00094: Interface of the overridden method METH1 of interface XY
doesn't match declaration
```

Compiler error C0096

Message: Only one base function block may be defined in EXTENDS-list.
Possible error cause: Two or more base function blocks are defined in the EXTENDS list.
Error correction: Define only one base function block in the EXTENDS list.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
    fb : FB;
END_VAR

FUNCTION_BLOCK FB EXTENDS FB2, FB3
VAR
END_VAR

FUNCTION_BLOCK FB2
VAR
END_VAR

FUNCTION_BLOCK FB3
VAR
END_VAR

--> C00096: Only one base function block may be defined in EXTENDS-list
```

Compiler error C0097

Message: Duplicate definition of variable '<variable name>' in function block '<function block name>' and in base '<base function block name>'
Possible error cause: A variable is declared with the same name in a function block and its base.
Error correction: Use different variable names.
Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
    fb : FB;
END_VAR

FUNCTION_BLOCK FB EXTENDS FB2
VAR
    i : INT;
END_VAR

FUNCTION_BLOCK FB2
VAR
    i : INT;
END_VAR

--> C00097: Duplicate definition of variable 'i' in function block 'FB' and in base 'FB2'
```

Compiler error C0098

**Message:** The keyword "FUNCTIONBLOCK" is no longer supported. Use "FUNCTION_BLOCK" instead.

**Possible cause of error:** Syntax error

**Error correction:** Use the keyword "FUNCTION_BLOCK".

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
    inst : FB;
END_VAR

FUNCTIONBLOCK FB
VAR
END_VAR

--> C00098: The keyword "FUNCTIONBLOCK" is no longer supported. Use "FUNCTION_BLOCK" instead. Use "FUNCTION_BLOCK" instead.
```

Compiler Error C0099 (Compiler Version < 3.5.7.0)

**Message:** Local defined enumeration are no longer supported. Use datatype definition instead.

**Possible error cause:** A local enumeration declaration was used together with a compiler version that does not support this.

**Error correction:** Use a later compiler version, or define the enumeration in a DUT.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
    localEnumVar : (RED, GREEN, BLUE) := RED;
END_VAR

--> C0099: Local defined enumeration are no longer supported. Use datatype definition instead.
```
Compiler error C0101

Message: Data Recursion: '<recursion>'
Possible error cause: Recursive data initialization over two function blocks
Error correction: Avoid recursions for data initialization.

Example of the error:

PROGRAM PLC_PRG
VAR
  inst0 : FB1;
END_VAR

FUNCTION_BLOCK FB1
VAR
  inst1 : FB2;
END_VAR

FUNCTION_BLOCK FB2
VAR
  inst2 : FB1;
END_VAR

--> C0101: Data Recursion: FB1->FB2->FB1

Compiler error C0102

Message: Out of retain memory: Variable '<variable name>', <byte size> bytes.
Possible error cause: More retain memory is used than is available on the PLC. It is also possible that the retain memory is too fragmented due to incremental builds.
Error correction: Use the "Clean" for fragmenting the memory. This will force the reallocation of all data at the next build.

Compiler error C0104

Message: 'Out of global data memory: Variable '<variable name>', <byte size> bytes.
Possible error cause: More memory for data is used than is available on the PLC. It is also possible that the memory is too fragmented due to incremental builds.
Error correction: Use the "Clean" for fragmenting the memory. This will force the reallocation of all data at the next build.

Compiler error C0114

Message: Invalid destination <jump label> for 'JMP'
Possible error cause: Syntax error or typographical error in the JMP destination
Error correction: Correct the typographical or syntax error.

Example of the error:

PROGRAM PLC_PRG
VAR
END_VAR
JMP 0;

--> C0114: Invalid destination 0 for 'JMP'
Compiler Error C0115

**Message:** The second parameter of a conditional call (?? ALWAYS CALC????) has to be a valid call statement.

**Error correction:** Specify the call of a function, method, or function block in the second parameter of the conditional ????CALC??? call.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
  condition : BOOL;
END_VAR
CALC(condition, 1+2);

--> C0115: The second parameter of a conditional call has to be a valid call statement.
```

**Error correction:**

```plaintext
Example:
CALC(condition, MyFunction(1,2))
```

Compiler error C0116

**Message:** The label '<jump label>' is a duplicate

**Possible error cause:** A label is defined multiple times.

**Error correction:** Define each label one time only.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
END_VAR
JMP label;
label:
label:

--> C0116: The label 'LABEL' is a duplicate
```

Compiler error C0117

**Message:** No such label '<jump label>' within the scope of the 'JMP' statement

**Possible error cause:** A jump is made to a label that does not exist.

**Error correction:** Define the label that you specify as the destination.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
END_VAR
JMP A;

--> C0117: No such label 'A' within the scope of the 'JMP' statement
```

Compiler error C0118

**Message:** The label '<jump label>' has not been referenced.
Possible error cause: A jump label is defined that is not referenced.
Error correction: Remove the unused jump labels.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
END_VAR
LABEL:

--> C0118: The label 'LABEL' has not been referenced
```

Compiler error C0119

Message: An 'FB_init'-Method of a functionblock or struct needs two inputs 'bInitRetains' and 'bInCopyCode' of type BOOL

Possible error cause: One or both of the inputs 'bInitRetains' and 'bInCopyCode' of type BOOL is missing.

Error correction: Define the missing inputs.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
    inst : FB;
END_VAR

FUNCTION_BLOCK FB
METHOD FB_init
VAR_INPUT
    END_VAR

--> C0119: An 'FB_init'-Method of a functionblock or struct needs two inputs 'bInitRetains' and 'bInCopyCode' of type BOOL

Error correction:

    METHOD FB_init
    VAR_INPUT
        bInitRetains : BOOL;
        bInCopyCode : BOOL;
    END_VAR
```

Compiler error C0120

Message: An 'FB_Exit'-Method of a functionblock or struct needs an input 'bInCopyCode' of type BOOL.

Possible error cause: The input 'bInCopyCode' of type BOOL is missing.

Error correction: Define the input.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
    inst : FB;
END_VAR

FUNCTION_BLOCK FB
```
METHOD FB_exit
VAR_INPUT
END_VAR

--> C0120: An 'FB_Exit'-Method of a functionblock or struct needs an input 'bInCopyCode' of type BOOL.

Error correction:
Example:
METHOD FB_exit
VAR_INPUT
  bInCopyCode : BOOL;
END_VAR

Compiler error C0122

Message: Expression 'SUPER' is not allowed in this context
Possible error cause: "SUPER^" is used outside of derived function blocks.
Error correction: Use "SUPER^" in function blocks only.

Example of the error:
PROGRAM PLC_PRG
VAR
END_VAR

SUPER^.METH(TRUE, TRUE);

--> C0122: Expression 'SUPER' is not allowed in this context

Compiler error C0124

Message: 'Initialization' is no valid initialization for an enumeration
Possible error cause: A data type that is not ANY_INT is used for the enum initialization.
Error correction: Use only ANY_INT for enum initializations.

Example of the error:
PROGRAM PLC_PRG
VAR
  inst : DUT;
END_VAR

TYPE DUT :
  (enum_member := 1.5)
) DWORD;
END_TYPE

--> C0032: Cannot convert type 'LREAL' to type 'DUT'
--> C0124: 'Initialization' is no valid initialization for an enumeration

Compiler error C0125

Message: The constant <constant value> is assigned to more than one enumeration.
Possible error cause: The same value is assigned to two or more enumerations.
**Error correction:** Assign different values to the enumerations.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
  inst : DUT;
END_VAR

TYPE DUT :
  (  
    enum_member := 0,
    enum_member2 := 0
  );
END_TYPE

--> C0125: The constant 0 is assigned to more than one enumeration
```

**Compiler error C0126**

**Message:** Variable of type `<data type>` requires exactly 1 index

**Possible error cause:** Multiple indexes are assigned to a variable with one index.

**Error correction:** Assign only one index.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
  pi : POINTER TO INT;
END_VAR

pi[0,1] := 0;

--> C0126: Variable of type 'POINTER TO INT' requires exactly 1 Index
```

**Error correction:**

Example:

```plaintext
pi[0] := 0;
```

**Compiler error C0130**

**Message:** `<object> `<object name>` referenced without parentheses `()'`

**Possible error cause:** A method is referenced without parentheses.

**Error correction:** Always reference methods by means of parentheses.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
  inst : FB;
END_VAR

inst.METH1

--> C0130: METHOD 'METH1' referenced without parentheses '()'`

**Error correction:**

Example:

```plaintext
inst.METH1();
```
Compiler error C0131

Message: '<value>' is not allowed as operand for 'ADR'
Possible error cause: A constant is passed as an operand to the operator ADR.
Error correction: Use only valid operands for ADR.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
   i : INT;
   pt : POINTER TO INT;
END_VAR

pt := ADR(1);

---> C0131: '1' is not allowed as operand for 'ADR'
```

Error correction:

```plaintext
Example:
pt := ADR(i);
```

Compiler error C0132

Message: No enclosing loop of which to EXIT
Possible error cause: EXIT is used outside of a loop.
Error correction: Use EXIT inside of a loop only.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
END_VAR

EXIT ;

---> C0132: No enclosing loop of which to EXIT
```

Compiler error C0136

Message: ambiguous use of name '<variable name>'
Possible error cause: A variable is declared in multiple GVLs.
Error correction: Qualify the variable with the desired GVL.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
   j : INT := g_i;
END_VAR

GVL1:
VAR_GLOBAL
   g_i : INT;
END_VAR

GVL2:
```
VAR_GLOBAL
    _g_i : INT;
END_VAR

--> C0136: ambiguous use of name 'g_i'

Example:
    j : INT := GVL1.g_i;

Compiler Error C0138

Message: No matching 'FB_Init' method found for instantiation of POU.
Possible error cause: No FB_Init method exists that accepts the passed parameters.
Error correction: Check which arguments FB_Init has to receive and adjust the passed arguments.

Example of the error:
PROGRAM PLC_PRG
VAR
    myPOU : POU(arg1 := 1, arg2 := 2);
END_VAR

--> C0138: No matching 'FB_Init' method found for instantiation of POU.

Compiler error C0139

Message: The code <code> has no effect. Is this the intent?
Possible error cause: The written code is syntactically correct but does not do anything.
Error correction: Write code that has a purpose.

Example of the error:
PROGRAM PLC_PRG
VAR
    i : INT;
END_VAR
    i;

--> C0139: The code 'i;' has no effect. Is this the intent?

Compiler error C0140

Message: Reference assign is only allowed to variables of Reference type
Possible error cause: An attempt is made to assign a reference value to a variable not defined as a reference type.
Error correction: Define the variable as a reference type.

Example of the error:
PROGRAM PLC_PRG
VAR
    i : INT;
    I_r : INT;
END_VAR
I_r REF= i;

--> C0140: Reference assign is only allowed to variables of Reference type

Example:
I_r : REFERENCE TO INT;

Compiler error C0141

Message: Reference assign needs variable with write access

Possible error cause: A constant is assigned to the reference assignment.

Error correction: Assign a writable variable.

Example of the error:

PROGRAM PLC_PRG
VAR
  i : INT;
  I_r : REFERENCE TO INT;
END_VAR

I_r REF= 314;

--> C0141: Reference assign needs variable with write access

Example correction:
I_r REF= i;

Compiler error C0142

Message: A local variable named '<variable name>' is already defined in '<pou name>'

Possible error cause: The same variable name is used two times.

Error correction: Use different variable names.

Example of the error:

PROGRAM PLC_PRG
VAR
  i : INT;
  i : INT;
END_VAR

--> C0142: A local variable named 'i' is already defined in 'PLC_PRG'

Compiler error C0143

Message: The property '<property name>' cannot be used in this context because it lacks the get accessor

Possible error cause: The property does not have Get access.

Error correction: Make sure that the property has a Get access definition.
Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
  i : INT;
  inst: FB;
END_VAR

i := inst.Prop;

FUNCTION_BLOCK FB
VAR
END_VAR

PROPERTY Prop : INT
Set;

--> C0143: The property 'Prop' cannot be used in this context because it lacks the get accessor
```

Compiler error C0144

**Message:** Inheritance only allowed in Functionblocks, Interfaces and Structures

**Possible error cause:** An attempt is made to use inheritance in an object that does not permit inheritance.

**Error correction:** Use `EXTENDS` in function blocks, interfaces, and structures only.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
  inst : DUT_1;
END_VAR

TYPE DUT:
  enum_member := 0
END_TYPE

TYPE DUT_1 EXTENDS DUT:
  enum_memberX := 0
END_TYPE

--> C0144: Inheritance only allowed in Functionblocks, Interfaces and Structures
```

Compiler error C0145

**Message:** Interfaces can only be implemented by Functionblocks

**Possible error cause:** An attempt is made to implement an interface outside of a function block.

**Error correction:** Implement interfaces only in function blocks.
Example of the error:

```
PROGRAM PLC_PRG
VAR
END_VAR

POU();

FUNCTION POU IMPLEMENTS ITF
VAR
END_VAR

--> C0145: Interfaces can only be implemented by Functionblocks
```

Compiler error C0149

**Message:** Variable declarations are not allowed in interfaces

**Possible error cause:** An attempt is made to define a variable in an interface.

**Error correction:** Do not define variables in interfaces.

Example of the error:

```
PROGRAM PLC_PRG
VAR
  inst : ITF;
END_VAR

INTERFACE ITF
VAR_INPUT
  i : INT;
END_VAR

--> C0149: Variable declarations are not allowed in interfaces
```

Compiler error C0161

**Message:** Border <array bound> of array is no constant value

**Possible error cause:** A variable is specified as an array bound.

**Error correction:** Use constants for the array bounds.

Example of the error:

```
PROGRAM PLC_PRG
VAR
  i : INT := 3;
  arr1 : ARRAY[1..i] OF INT;
END_VAR

--> C0161: Border 'i' of array is no constant value
```

**Error correction:**

Example:

```
arr1 : ARRAY[1..3] OF INT;
```

Compiler error C0162

**Message:** Number <number of array values> of array initialisations is no constant value

**Possible error cause:** The initialization [Wert1, AnzahlWert2(Wert2)] works only with a constant for AnzahlWert2.

**Error correction:** Use constants only.
Example of the error:

PROGRAM PLC_PRG
VAR
  i : INT := 3;
  arr1 : ARRAY[1..4] OF INT := [1,i(7)];
END_VAR

--- C0162: Number 'i' of array initialisations is no constant value

Example:
arr1 : ARRAY[1..4] OF INT := [1,3(7)];

Compiler Error C0164

Message: POU <name> writes to output <name> and is called in several tasks.

Possible error cause: The device setting codegenerator\check-multiple-task-output-write is set and multiple tasks access the same output.

Error correction: Do not call a program that changes outputs in multiple tasks.

Example of the error:

PROGRAM PLC_PRG
VAR
  Output AT %QB7 : BYTE
END_VAR

Output := 0;

--- C0164: POU 'PLC_PRG' writes to output 'QB7' and is called in several tasks

Compiler Error C0165

Message: Variable '<variable name>', which is mapped on address '<address>' is written in different tasks.

Possible error cause: The device setting codegenerator\check-multiple-task-output-write is set and multiple tasks access the same output.

Error correction: Write an output in one fixed task only. If multiple tasks need to calculate data for one output, then you should try to transfer this information by means of global variables to one fixed task, which then writes the data to one output.
Example of the error:

PROGRAM PLC_PRG_1
VAR
  Output AT %QB7 : BYTE;
END_VAR
Output := 0;

PROGRAM PLC_PRG_2
VAR
  Output AT %QB7 : BYTE;
END_VAR
Output := 1;

--> C0165: Variable 'Output', which is mapped on address 'QB7' is written in different tasks.

Compiler error C0168

Message: 'VAR_CONFIG' declaration only allowed in VAR_CONFIG - list
Possible error cause: 'VAR_CONFIG' is used outside of a VAR_CONFIG list.
Error correction: Use 'VAR_CONFIG' only in VAR_CONFIG lists.

Example of the error:

PROGRAM PLC_PRG
VAR_CONFIG
  i : INT;
END_VAR

--> C0168: 'VAR_CONFIG' declaration only allowed in VAR_CONFIG - list

Compiler error C0169

Message: 'VAR_GLOBAL' declaration only allowed in Global variable list
Possible error cause: 'VAR_GLOBAL' is used outside of global variable lists.
Error correction: Use 'VAR_GLOBAL' in global variable lists only.

Example of the error:

PROGRAM PLC_PRG
VAR_GLOBAL
  i : INT;
END_VAR

--> C0169: 'VAR_GLOBAL' declaration only allowed in Global variable list
Compiler Error C0173

**Message:** '<keyword>' not allowed in this place

**Possible error cause:** A declaration keyword (example: VAR_INPUT, VAR_OUTPUT, or VAR) is not allowed at this location.

**Error correction:** Correct the declaration: Inputs and outputs are not useful or necessary in type definitions or global variable lists.

```
TYPE DUT :
  STRUCT
    member : INT;
  END_STRUCT
END_TYPE
```

---

**Example of the error:**

```
TYPE DUT :
  STRUCT
    VAR_INPUT
      member : INT;
    END_VAR
  END_STRUCT
END_TYPE
```

--> C0173: 'VAR_INPUT' not allowed in this place.

**Error correction**

Example:

```
TYPE DUT :
  STRUCT
    member : INT;
  END_STRUCT
END_TYPE
```

---

Compiler error C0174

**Message:** 'VAR_TEMP' declaration not allowed in this place

**Possible error cause:** 'VAR_TEMP' is used outside of a program or function block.

**Error correction:** Use 'VAR_TEMP' inside of programs and function blocks only.

---

**Example of the error:**

```
PROGRAM PLC_PRG
VAR
END_VAR

FUN();

FUNCTION FUN
VAR_TEMP
END_VAR

--> C0174: 'VAR_TEMP' declaration not allowed in this place
```

---

Compiler error C0175

**Message:** 'RETAIN' or 'PERSISTENT' not allowed in this place

**Possible error cause:** 'RETAIN' or 'PERSISTENT' is used in a function.

**Error correction:** Use 'RETAIN' or 'PERSISTENT' at the intended locations.
Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
END_VAR

POU_1();

FUNCTION POU_1
VAR RETAIN
END_VAR

--> C0175: 'RETAIN' or 'PERSISTENT' not allowed in this place

See also
- Chapter 6.4.1.20.2.14 “Retain Variable - RETAIN” on page 2124
- Chapter 6.4.1.20.2.14 “Retain Variable - RETAIN” on page 2124
```

Compiler error C0177

**Message:** ‘<object>’ is of type ‘type’ and cannot be instantiated

**Possible error cause:** An attempt is made to instantiate a function.

**Error correction:** Instantiate only objects that can be instantiated.

```plaintext
Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
  inst : POU;
END_VAR

FUNCTION POU
VAR
END_VAR

--> C0177: 'POU' is of type 'FUNCTION' and cannot be instantiated
```

Compiler error C0178

**Message:** No external access to 'VAR_IN_OUT' parameter '<parameter name>' of '<object name>'

**Possible error cause:** An attempt is made to remotely access a 'VAR_IN_OUT' parameter.

**Error correction:** Do not remotely access 'VAR_IN_OUT' parameters.

```plaintext
Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
  inst : FB;
  i : INT;
END_VAR
  i := inst.in_out;

FUNCTION_BLOCK FB
VAR_IN_OUT
  in_out : INT;
END_VAR

--> C0178: No external access to 'VAR_IN_OUT' parameter 'in_out' of 'FB'
```
Compiler Error C0179

**Message:** '<identifier>' is no output of 'Function block'

**Possible error cause:** The initialization of a function block instance must not contain VAR_IN_OUT variables.

**Error correction:** Use VAR_IN_OUT variables in function block calls only. When initializing a function block instance, only assign the inputs of a function block.

**Example of the error:**

```plaintext
FUNCTION_BLOCK MyFB
  VAR_IN_OUT
    inOut : INT;
  END_VAR

PROGRAM PLC_PRG
  VAR
    iValue : INT;
    fb : MyFB := (inOut := iValue);
  END_VAR

--> C0179: 'inOut' is no output of 'MyFB'
```

Compiler Error C0180

**Message:** Ambiguous namespace '<library 1>' defined by library '<library 2>'

**Possible error cause:** The namespace of the library <library 1> is not unique. It is already used for <library 2>.

**Error correction:** Change the namespace of the library accordingly ("Properties" button in the Library Manager).

**Example of the error:**

```plaintext
--> C0180: Ambiguous namespace 'STANDARD' defined by library 'Standard, 3.5.15.0 (System)'
```

Compiler error C0182

**Message:** Return type is only possible for POUs of Type FUNCTION and METHOD

**Possible error cause:** An attempt is made to define a return value in a program.

**Error correction:** Define a return value only in methods and functions.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG : BOOL
  VAR
  END_VAR

--> C0182: Return type is only possible for POUs of Type FUNCTION and METHOD
```
Compiler Error C0183

**Message:** Global scope operation '.' is not valid on expression '<expression>'

**Possible error cause:** The '.' operator is used to access a global variable. However, at this location it is not followed by a valid IEC identifier, but for example a character such as ';' or a reserved identifier such as FUNCTION, or an operator such as TO_STRING.

**Error correction:** Use a valid IEC identifier for a global variable.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
  iVar := .FUNCTION; // ERROR: C0183 because ; is not a valid identifier
  strVar := .TO_STRING;
  --> C0183: Global scope operation '.' is not valid on expression '<expression>'
```

**Error correction:**

```plaintext
Example: globalValue is declared in a GVL.
PROGRAM PLC_PRG
  iVar := .globalValue;
```

Compiler error C0185

**Message:** It is not possible to perform component access '.', index access '[]' or call '()' on result of function call. Assign result to help variable first.

**Possible error cause:** Component or index access to the result of a function call is performed.

**Error correction:** Assign the result to a variable in order to access.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
  VAR
    it : ITF;
  END_VAR
  POU_1()[0].METH1();
  FUNCTION POU_1 : ARRAY[0..0] OF ITF
  INTERFACE ITF
  METHOD METH1
  --> C0185: It is not possible to perform component access '.', index access '[]' or call '()' on result of function call. Assign result to help variable first.
```

Compiler Error C0186

**Message:** It is not possible to compare interface that is return value of call. Assign to variable first.

**Possible error cause:** A comparison operation is applied to an interface that is returned by a function.

**Error correction:** First assign the result of the function call to a variable and then compare the value of the variable. This will also reduce the number of function calls that are required.
Example of the error:

```plaintext
INTERFACE MyInterface

FUNCTION GetInterface : MyInterface

PROGRAM PLC_PRG
IF GetInterface() <> 0 THEN
   // ...
END_IF

--> C0186: It is not possible to compare interface that is return value of call. Assign to variable first.
```

Error correction:

```plaintext
Example:
PROGRAM PLC_PRG
VAR_TEMP
   tempInterface : MyInterface;
END_VAR
tempInterface := GetInterface();
IF tempInterface <> 0 THEN
   // ...
END_IF
```

Compiler Error C0188

**Message:** Device not installed to the system. No code generation possible.

**Possible error cause:** The desired device is not installed.

**Error correction:** Install the missing device in the device repository, or replace the existing device already inserted in the device tree with another existing device ("Update Device").

Compiler error C0189

**Message:** `;` expected instead of '<token>'

**Possible error cause:** Syntax error

**Error correction:** Make sure that the syntax is correct.
Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
  INT
END_VAR

--> C0009: Unexpected Token '<Token>' found
--> C0189: ';' expected instead of 'INT'
```

Compiler error C0190

**Message:** ';' expected instead of end of POU

**Possible error cause:** Syntax error in the POU

**Error correction:** Make sure that the syntax is correct.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
  i : INT;
END_VAR
  i := 5

--> C0190: ';' expected instead of end of POU
```

Compiler error C0191

**Message:** The operator 'INDEXOF' is no longer supported. Use ADR instead. ADR on a POU-Name returns a Pointer to a Pointer to the function code.

**Possible error cause:** The outdated operator 'INDEXOF' is used.

**Error correction:** Use the operator 'ADR'.

Compiler error C0195

**Message:** Implicit conversion from signed Type '<data type 1>' to unsigned Type '<data type 2>' : possible change of sign

**Possible error cause:** A sign conflict may have been missed in the implicit conversion.

**Error correction:** Convert only data types with the same sign implicitly.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
  i : INT;
  b : UINT;
END_VAR
  b := i;

--> C0195: Implicit conversion from signed Type 'INT' to unsigned Type 'UINT' : possible change of sign
```

Compiler error C0196

**Message:** Implicit conversion from unsigned Type '<data type 1>' to signed type '<data type 2>' : possible change of sign
Possible error cause: A sign conflict may have been missed in the implicit conversion.

Error correction: Use explicit conversions.

Example of the error:

```
PROGRAM PLC_PRG
VAR
  i : INT;
  b : UINT;
END_VAR

i := b;

--> C0196: Implicit conversion from unsigned Type 'UINT' to signed type 'INT' : possible change of sign
```

Compiler error C0197

Message: Implicit conversion from '<data type 1>' to '<data type 2>': possible loss of information

Possible error cause: An attempt is made to convert a variable from data type DINT or LINT to data type REAL.

Error correction: For DINT, use the data type LREAL, and when converting from LINT to LREAL make sure that the value of LINT does not exceed the capacity of LREAL.

Example of the error:

```
PROGRAM PLC_PRG
VAR
  i : DINT;
  b : REAL;
END_VAR

b := i;

--> C0197: Implicit conversion from 'DINT' to 'REAL': possible loss of information
```

Compiler error C0198

Message: String constant '<string value>' too long for destination type '<data type>'

Possible error cause: The string constant has too many characters.

Error correction: Use shorter string constants or declare larger strings.

Example of the error:

```
PROGRAM PLC_PRG
VAR
  str : STRING(4) := '12345';
END_VAR

--> C0198: String constant '12345' too long for destination type 'STRING(4)'
```

Compiler error C0199

Message: Interface '<interface name>' must be instantiated to be accessed

Possible error cause: An attempt is made to access an interface method without the interface being instantiated.
**Error correction:** Instantiate the interface.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
END_VAR

ITF.METH();

INTERFACE ITF

METHOD METH
VAR_INPUT
END_VAR

--> C0199: Interface 'ITF' must be instantiated to be accessed

```

**Error correction:**

Example:

```plaintext
itest: ITF;
```

**Compiler error C0201**

**Message:** Type '<data type 1>' is not equal to type '<data type 2>' of VAR_IN_OUT 'Variable'

**Possible error cause:** The data type that is passed to the function as a VAR_IN_OUT parameter does not match the data type defined in it.

**Error correction:** Pass a variable with the correct data type.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
    Inst: POU;
    b : BOOL;
END_VAR

inst(in_out := b);

FUNCTION_BLOCK POU
VAR_IN_OUT
    in_out : INT;
END_VAR

--> C0201: Type 'BOOL' is not equal to type 'INT' of VAR_IN_OUT 'Variable'
```

**Compiler error C0203**

**Message:** Only Structures and Function Blocks can contain variables of type BIT.

**Possible error cause:** An attempt is made to declare a variable of type BIT outside of structures and function blocks.

**Error correction:** Declare variables of type BIT only in structures and function blocks.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
    b : BIT;
END_VAR

--> C0203: Only Structures and Function Blocks can contain variables of type BIT.
```
Compiler error C0204

**Message**: Variables of type BIT must be declared within a VAR_INPUT-, VAR_OUTPUT or VAR-block

**Possible error cause**: An attempt is made to define a variable of type BIT or as a VAR_IN_OUT parameter.

**Error correction**: Define variables of type BIT only within a VAR_INPUT, VAR_OUTPUT or VAR block.

**Example of the error**:

```plaintext
PROGRAM PLC_PRG
  VAR
    inst : FB;
  END_VAR

  FUNCTION_BLOCK FB
    VAR_IN_OUT
      b : BIT;
    END_VAR
  --> C0204: Variables of type BIT must be declared within a VAR_INPUT-, VAR_OUTPUT or VAR-block
```

Compiler error C0205

**Message**: POINTER TO BIT is not allowed

**Possible error cause**: An attempt is made to declare a POINTER TO BIT.

**Error correction**: Do not declare POINTER TO BIT.

**Example of the error**:

```plaintext
PROGRAM PLC_PRG
  VAR
    pt : POINTER TO BIT;
  END_VAR
  --> C0205: POINTER TO BIT is not allowed
```

Compiler error C0206

**Message**: BIT is not allowed as base type of an array

**Possible error cause**: An attempt is made to declare a BIT array.

**Error correction**: Do not declare BIT arrays.

**Example of the error**:

```plaintext
PROGRAM PLC_PRG
  VAR
    arr : ARRAY[1..2] OF BIT;
  END_VAR
  --> C0206: BIT is not allowed as base type of an array
```

Compiler Error C0207

**Message**: There is no system definition for '<identifier>'
**Possible error cause:** An attempt was made to access a variable in __SYSTEM that does not exist.

**Error correction:** Check and correct the specified identifier of the respective variable.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
  Value : INT;
END_VAR
Value := __SYSTEM.UnknownVariable;

--> C0207: There is no system definition for 'UnknownVariable'
```

**Compiler error C0208**

**Message:** 'MOD' is not defined for 'REAL'

**Possible error cause:** An attempt is made to perform a modulo operation with a variable of type REAL.

**Error correction:** Modulo operations are only possible with variables of type ANY_INT.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
  r1 : REAL;
END_VAR
r1 := r1 MOD 2;

--> C0208: 'MOD' is not defined for 'REAL'
```

**Compiler Error C0209**

**Message:** You have defined '<number>' applications for device '<device name>'. The maximum number is '<number>'. So you will not be able to download all applications.

**Possible error cause:** Some devices only support a specific number of applications (device description). If a project contains more applications, then not all will be downloaded to the device.

**Error correction:** Remove applications from your project or use another device.

**Compiler error C0211**

**Message:** Variable declaration expected instead of <expression>

**Possible error cause:** Syntax error

**Error correction:** Make sure that the syntax is correct.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
  VAR
    END_VAR
END_VAR

--> C0211: Variable declaration expected instead of VAR END_VAR
```
Compiler error C0212

**Message:** VAR, VAR_INPUT, VAR_OUTPUT or VAR_INOUT expected instead of <expression>

**Possible error cause:** Syntax error

**Error correction:** Make sure that the syntax is correct.

**Example of the error:**

```c
PROGRAM PLC_PRG
  i : INT;
  --> C0212: VAR, VAR_INPUT, VAR_OUTPUT or VAR_INOUT expected instead of i : INT;
```

Compiler Error C0215

**Message:** Direct address declaration is not possible in persistent list

**Possible error cause:** Persistent variables are not allowed to have a direct address.

**Error correction:** Remove the direct address assignment in the persistent variable list.

**Example of the error:**

```c
VAR_GLOBAL PERSISTENT RETAIN
directAddressVar AT %QB7 : BYTE;
END_VAR
  --> C0215: Direct address declaration is not possible in persistent list.
```

Compiler error C0216

**Message:** Case label duplicate

**Possible error cause:** A CASE label is used multiple times.

**Error correction:** Use each CASE label only one time.

**Example of the error:**

```c
PROGRAM PLC_PRG
  VAR
  i : INT;
  END_VAR
  CASE i OF
    1: i := i+1;
    1: i := i+2;
    ELSE
    i := i+10;
    END_CASE;
  --> C0216: Case label duplicate
```

Compiler error C0217

**Message:** Case label <case label> also contained in range <case range begin> .. <case range end>

**Possible error cause:** A CASE label is part of the range of another CASE label.

**Error correction:** Make sure that there is no intersecting.
Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
  i : INT;
END_VAR
CASE i OF
  3..5: i := i+2;
  4: i := i+2;
ELSE
  i := i+10;
END_CASE;

--> C0217: Case label 4 also contained in range 3 .. 5
```

Compiler error C0218

**Message:** Case label requires literal or symbolic integer constant

**Possible error cause:** An attempt is made to use a variable as a CASE label.

**Error correction:** Use only literals and symbolic integer constants.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
  i : INT;
  a : INT := 2;
END_VAR
CASE i OF
  1: i := i+1;
  a: i := i+2;
ELSE
  i := i+10;
END_CASE;

--> C0218: Case label requires literal or symbolic integer constant
```

Compiler error C0219

**Message:** Case contains overlapping range <case range 1 begin> .. <case range 1 end> and <case range 2 begin> .. <case range 2 end>

**Possible error cause:** Two branches of CASE markers have the same elements or subsets.

**Error correction:** Make sure that there is no intersecting.

Example of the error:

```plaintext
PROGRAM PLC_PRG
VAR
  i : INT;
END_VAR
CASE i OF
  3..5: i := i+2;
  1..4: i := i+2;
ELSE
  i := i+10;
END_CASE;

--> C0219: Case contains overlapping range 1 .. 4 and 3 .. 5
```
**Compiler error C0221**

**Message:** Direct Address '<address>' malformed

**Possible error cause:** An address is not displayed completely.

**Error correction:** Make sure that the address is displayed correctly.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
  xVar : BOOL;
END_VAR;

xVar := %IX0;

--> C0221: Direct Address '%IX0' malformed
```

**Error correction:**

```plaintext
Example:

xVar := %IX0.2;
```

**Compiler error C0222**

**Message:** Outputs can't be of type 'REFERENCE TO'

**Possible error cause:** An attempt is made to define 'REFERENCE TO' as an output parameter.

**Error correction:** Do not use 'REFERENCE TO' as an output parameter.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
  inst : FB;
END_VAR

FUNCTION_BLOCK FB
VAR_OUTPUT
  re : REFERENCE TO INT;
END_VAR

--> C0222: Outputs can't be of type 'REFERENCE TO'
```

**Compiler error C0224**

**Message:** Call Recursion: <recursion>

**Possible error cause:** A function calls itself.

**Error correction:** Make sure that functions are not recursive.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
END_VAR

POU();

FUNCTION POU
VAR
END_VAR

POU();

--> C0224: Call Recursion: POU -> POU
```
Compiler Error C0225

**Message:** '<name>' is not an instance of '<name>'

**Possible error cause:** A function block in a graphical programming language has been assigned with an explicitly specified type that does not match the declared type.

**Error correction:** Replace the explicit type with the one used in the declaration part, or remove the specification of the explicit type from the POU.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
  fbVar : MyFB;
END_VAR

--> C0225: 'fbVar' is not an instance of 'MyFB2'

Error correction:
```

Compiler error C0227

**Message:** Initialisation of constant variable <constant name> not constant

**Possible error cause:** A constant is initialized with a variable.

**Error correction:** Initialize constants only with constant values.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
  i : INT;
END_VAR
VAR CONSTANT
  k : INT := i;
END_VAR

--> C0227: Initialisation of constant variable 'k' not constant
```
Compiler error C0228

**Message:** No initial value for constant variable '<constant name>''

**Possible error cause:** A constant is not initialized.

**Error correction:** Initialize the constants.

**Example of the error:**

```
PROGRAM PLC_PRG
VAR
END_VAR
VAR CONSTANT
  k : INT;
END_VAR

--> C0228: No initial value for constant variable 'k'
```

**Error correction:**

```
k : INT := 1;
```

Compiler Error C0230

**Message:** Type name '<data type>' not expected in this place

**Possible error cause:** The data type name of an enumeration is used at an invalid position.

**Error correction:** Check whether the data type name is used correctly at this location. Maybe there is a spelling error.

**Example of the error:**

```
TYPE MyEnum :
  (enum_member := 0);
END_TYPE

PROGRAM PLC_PRG
VAR
  value : INT;
END_VAR
value := MyEnum;
MyEnum := value;

--> For PLC_PRG, the error message is issued 2x:
C0230: Type name 'MyEnum' not expected in this place
```

**Error correction:**

```
value := MyEnum.enum_member;
MyEnum.enum_member := value;
```

Compiler Error C0232

**Message:** Array initialisation expected

**Possible error cause:** An array of arrays is initialized, but the initialization values are not nested.

**Error correction:** Use a nested array initialization as shown in the example below.
Example of the error:

PROGRAM PLC_PRG
VAR
  value : ARRAY[0..2] OF ARRAY[0..2] OF INT := [1,2,3];
END_VAR

--> C0232: Array initialisation expected

Error correction:

Example:
value : ARRAY[0..2] OF ARRAY[0..2] OF INT := [ [1,2,3], [4,5,6], [7,8,9] ];

Compiler Error C0233

Message: Initialisation list for {0} <data type> expected
Possible error cause: An array of the type of a structure is initialized with elements that are not structure initializations or variables.
Error correction: As shown in the example below, use structure initializations or existing variables to initialize arrays of structures.

Example of the error:

PROGRAM PLC_PRG
VAR
  values : ARRAY[0..2] OF COLOR := [1,2,3];
END_VAR

--> C0233: Initialisation list for COLOR expected

Error correction:

Example:
PROGRAM PLC_PRG
VAR
  colorVariable : COLOR := (red:=0, green:=0, blue:=255);
  value : ARRAY[0..2] OF COLOR := [ colorVariable,
    (red:=255, green:=0, blue:=0),
    (red:=0, green:=255, blue:=0) ];
END_VAR

Compiler error C0234

Message: First Operand of __QueryInterface must be an interface reference or the instance of a function block
Possible error cause: Incorrect operands are passed to the operator __QueryInterface.
Error correction: Pass an interface reference or the instance of a function block.

Example of the error:

PROGRAM PLC_PRG
VAR
  a : INT;
  ITFRef, ITFRef2 : ITF;
  ITFRef2 : ITF2;
END_VAR

__QueryInterface(a ,ITFRef);
INTERFACE ITF EXTENDS __SYSTEM.IQueryInterface
INTERFACE ITF2 EXTENDS ITF

--> C0234: First Operand of __QueryInterface must be an interface reference or the instance of a function block

Example:
__QueryInterface(ITFref2, ITFref);

Error correction:

Compiler error C0235

Message: Second Operand of __QueryInterface must be an interface reference

Possible error cause: Incorrect operands are passed to the operator __QueryInterface.

Error correction: Pass an interface reference.

Example of the error:
PROGRAM PLC_PRG
VAR
   a : INT;
   ITFref, ITFref2 : ITF;
   ITFref2 : ITF2;
END_VAR
__QueryInterface(ITFref2, a);

INTERFACE ITF EXTENDS __SYSTEM.IQueryInterface
INTERFACE ITF2 EXTENDS ITF

--> C0235: Second Operand of __QueryInterface must be an interface reference

Example:
__QueryInterface(ITFref2, ITFref);

Error correction:

Compiler error C0236

Message: Wrong type definition for VAR_EXTERNAL <variable name>

Possible error cause: The variable is declared in VAR_GLOBAL / VAR_EXTERNAL as different types.

Error correction: Use the same type definition in VAR_GLOBAL and VAR_EXTERNAL.

Example of the error:
PROGRAM PLC_PRG
VAR_EXTERNAL
   _ig : STRING;
END_VAR

VAR_GLOBAL
   _ig : INT;
END_VAR

--> C0236: Wrong type definition for VAR_EXTERNAL ig

Compiler error C0237

Message: No global definition found for VAR_EXTERNAL '<variable name>'
Possible error cause: An attempt is made to declare a variable in VAR_EXTERNAL which does not exist in VAR_GLOBAL.

Error correction: Make sure that the identifiers match.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR_EXTERNAL
  i : INT;
END_VAR

VAR_GLOBAL
  ig : INT;
END_VAR

--> C0237: No global definition found for VAR_EXTERNAL 'i'
```

**Compiler error C0238**

**Message:** No initial value allowed for VAR_EXTERNAL <variable name>

**Possible error cause:** An attempt is made to initialize a variable in VAR_EXTERNAL.

**Error correction:** Do not initialize variables in VAR_EXTERNAL.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR_EXTERNAL
  ig : INT := 2;
END_VAR

VAR_GLOBAL
  ig : INT;
END_VAR

--> C0238: No initial value allowed for VAR_EXTERNAL ig
```

**Compiler error C0239**

**Message:** Interface <interface name 1> does not extend <interface name 2>

**Possible error cause:** The used interface does not extend another interface.

**Error correction:** Extend the interface.

**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
  ITFref : ITF;
  ITFref2 : ITF2;
END_VAR

__QueryInterface(ITFref2, ITFref);

INTERFACE ITF
INTERFACE ITF2 EXTENDS ITF

--> C0239: Interface ITF__Union does not extend __System.IQueryInterface
```

**Error correction:**

```plaintext
Example:
INTERFACE ITF EXTENDS __System.IQueryInterface
```
Compiler error C0240

Message: First Operand of __QueryPointer must be an interface reference or the instance of a function block
Possible error cause: Incorrect operands are passed to the operator __QueryPointer.
Error correction: Pass an interface reference or the instance of a function block.

Example of the error:
PROGRAM PLC_PRG
VAR
  a : INT;
  ITFref : ITF;
  pt : POINTER TO FB;
END_VAR
__QueryPointer(a,pt);

Compiler error C0241

Message: Second Operand of __QueryPointer must be pointer
Possible error cause: Incorrect operands are passed to the operator __QueryPointer.
Error correction: Pass a pointer.

Example of the error:
PROGRAM PLC_PRG
VAR
  b : INT;
  ITFref : ITF;
  pt : POINTER TO FB;
END_VAR
__QueryPointer(ITFref,b);

Compiler error C0242

Message: Operand of __DELETE must be pointer
Possible error cause: An incorrect operand is passed to the operator __DELETE.
Error correction: Pass a pointer.
**Example of the error:**

```plaintext
PROGRAM PLC_PRG
VAR
  a : INT;
  pt : POINTER TO INT;
END_VAR

__DELETE(a);

--> C0242: Operand of __DELETE must be pointer
```

**Error correction:**

```plaintext
__DELETE (pt);
```

---

**Compiler error C0243**

**Message:** The name used in the signature is not identical to the object name

**Possible error cause:** The object name differs from the name used in the code.

**Error correction:** make sure that the names are the same.

---

**Compiler Error C0380**

**Message:** The Operators LOWER_BOUND and UPPER_BOUND are only supported for arrays of variable length.

**Possible error cause:** One of the two operators LOWER_BOUND or UPPER_BOUND is not used for an array of variable length.

**Error correction:** Use the operators LOWER_BOUND and UPPER_BOUND only for an array of variable length.

```
For compiler version 3.5.14.0 and higher, the operators can also be used for static arrays. As a result, the error C0380 occurs only in the case of earlier compiler versions.
```

**Example of the error:**

```plaintext
FUNCTION_BLOCK POU
VAR_IN_OUT
  arrin : ARRAY [*] OF INT;
END_VAR
VAR
  arrtest : ARRAY [0..5] OF INT;
  test1: DINT;
  test2: DINT;
```
END_VAR

test1 := UPPER_BOUND(arrin, 1);
test2 := UPPER_BOUND(arrest, 1);

--> C0380: The operators LOWER_BOUND and UPPER_BOUND are supported only for arrays with variable length.

Compiler error C0509

Message: Multiple assignments for operator '__New' not allowed

Possible error cause: In one line of code, the assignment operator "=" is called a multiple number of times with the __New operator.

Error correction: Program the memory allocation with the __New operator in a separate line of code for each pointer that points to dynamically allocated memory.

Example of the error:

PROGRAM PLC_PRG
VAR
  pbAlpha : POINTER TO BYTE; // Typed pointer to Alpha
  pbBeta: POINTER TO BYTE;    // Typed pointer to Beta
  xInit : BOOL := TRUE;
  xDelete : BOOL;
END_VAR

IF (xInit) THEN
  pbBeta := pbAlpha := __NEW(BYTE); // Incorrect code for memory allocation
END_IF

pbBeta := pbAlpha := 16#01;

IF (xDelete) THEN
  __DELETE(pbAlpha); // Frees memory of pointer
END_IF

--> C0509: Multiple assignments for operator '__New' not allowed

Error correction:

PROGRAM PLC_PRG
VAR
  pbAlpha : POINTER TO BYTE; // Pointer to Alpha
  pbBeta: POINTER TO BYTE;    // Pointer to Beta
  xInit : BOOL := TRUE;
  xDelete : BOOL;
END_VAR

IF (xInit) THEN
  pbAlpha := __NEW(BYTE); // Allocates memory for Alpha
  pbBeta := __NEW(BYTE); // Allocates memory for Beta
END_IF

pbBeta := pbAlpha := 16#01; // Multiple assignment

IF (xDelete) THEN
  __DELETE(pbAlpha); // Frees memory of pointer
END_IF
Compiler error C0511

**Message:** The function block '<function block name>' is ABSTRACT and cannot be used as a target for an assignment.

**Possible error cause:** A value was assigned to an abstract function block. The concrete function blocks may have different types and therefore cannot be copied.

**Error correction:** In order to copy the data of the function block, concrete function blocks have to be used.

**Example of the error:**

```
PROGRAM PLC_PRG
VAR
  refAbstract1 : REFERENCE TO AbstractPOU;
  refAbstract2 : REFERENCE TO AbstractPOU;
END_VAR

refAbstract1 := refAbstract2;
--> C0511: The function block 'refAbstract1' is ABSTRACT and cannot be used as a target for an assignment.

Error correction:
Use the reference assignment REF= to assign the reference refAbstract1 to the same function block as refAbstract2.
```

Compiler Error C0542

**Message:** Inheritance is not intended for the data type "UNION" <data type name>.

**Possible error cause:** A structured data type (DUT) is derived from a UNION by extending with EXTENDS, or a UNION is derived from a DUT. This kind of derivation is not permitted. However, for reasons of compatibility only a warning is issued.

**Example of the error:**

```
TYPE U_StringExt EXTENDS U_StringBase :
  UNION
    str10 : STRING(10);
  END_UNION
END_TYPE TYPE U_StringBase :
  UNION
    str20 : STRING(20);
  END_UNION
END_TYPE

PROGRAM PLC_PRG
VAR
  uStringExt : U_StringExt;
END_VAR

uStringExt.str20 := 'a234567890b234567890'; --> C0542
```
Compiler Error C0543

Message: The name <keyword> is a reserved keyword in the IEC 1131-3 standard. An error will be issued in future versions.

Possible error cause: A reserved keyword was assigned as the name of a variable.

Error correction: Rename the variable.

Example of the error:

```
PROGRAM PLC_PRG
VAR
  char : BYTE;
END_VAR
```

--> C0543: The name 'char' is a reserved keyword in the IEC 1131-3 standard. An error will be issued in future versions.

Note: For violations in compiled libraries, only a text message (information) will be issued instead of a warning.

The following keywords are reserved:

- CHAR
- WCHAR
- ANY DERIVED
- ANY ELEMENTARY
- ANY MAGNITUDE
- ANY SIGNED
- ANY DURATION
- ANY CHAR
- ANY CHAR
- CHAR TO
- TO CHAR
- WCHAR TO
- TO WCHAR
- ATAN2
- USING
- CLASS

See also

- Chapter 6.4.1.20.9 “Keywords” on page 2335

Compiler Error C0549

Message: Initialization of the static variable '<variable name>' is not constant, or replaced constants is disabled.

Possible error cause: VAR_STAT and CONSTANT declarations are used together in a function block declaration. The Replaces constants compile option is disabled.
The Replace constants compile option is disabled.

```plaintext
VAR CONSTANT
  iMaxInst : INT := 2;
END_VAR
VAR_STAT
  iIDs : INT := iMaxInst - 1;
END_VAR
```

Message: C0549: Initialization of the static variable 'iIDs' is not constant, or replaced constants is disabled.

Error correction: In Project → Project Settings, on the “Compile Options” tab, enable the ‘Replace constants’ compile option.

Compiler Error C0550

**Message:** Attribute 'pack_mode' for 'FUNCTION' ( 'METHOD') not allowed

**Possible error cause:** Functions or methods which are attributed with the pragma {attribute 'pack_mode' := ' <pack mode value>'}

**Example**

```plaintext
{attribute 'pack_mode' := '2'}
METHOD METH : INT
  VAR_INPUT
  END_VAR
{attribute 'pack_mode' := '1'}
FUNCTION FunPacked : DINT
  VAR_INPUT
    by1: BYTE;
  END_VAR
  VAR
    by2: BYTE;
  END_VAR
```

**Message:**

C0550: Attribute 'pack_mode' for 'METHOD' not allowed
C0550: Attribute 'pack_mode' for 'FUNCTION' not allowed

Error correction: Delete the attribute pragma.

Compiler Error C0554

**Message:** No explicit calls of '<FB name>' allowed. <value of attribute 'no_explicit_call'>

**Possible error cause:** A function block with the no_explicit_call attribute has been called.
Configuration and programming
Programming with CODESYS > CODESYS Development System

Example
{attribute 'no_explicit_call' := 'Call of this FB is not allowed'}
FUNCTION_BLOCK FB1
VAR_INPUT
END_VAR
VAR_OUTPUT
END_VAR
VAR
END_VAR
PROGRAM PLC_PRG
VAR
myFB: FB1;
END_VAR
myFB();
Message:
C0554: No explicit calls of 'FB1' allowed. Call of this FB is not allowed.
Error correction: Delete the attribute pragma.

Compiler Error C0555
Message: The string literal <literal> contains characters that cannot be displayed. The project
option 'UTF-8 encoding for STRING' could be used.
Possible error cause: Input of unknown characters which cannot be transformed to Latin-1.

Example
PROGRAM PLC_PRG
VAR
str1: STRING(200);
str2: STRING := '1 €';
str3: STRING(200) := ' !$"#$$%&$'()*+,-./0123456789:;<=>?
@ABCDEFGHIJKLMNOPQRSTUVWXYZ[\]^_`abcdefghijklmnopqrstuvwxyz{|}~';
END_VAR
str1 := '你好,世界';
str1 := 'ABC abc 123 äöü ß#~=" §% /(!)[]{}\ ´`^*~°€µ *_-.; 中文字
Ω �';
str1 := '1 £';
str1 := '1 €';
str1 := ' !$"#$$%&$'()*+,-./0123456789:;<=>?
@ABCDEFGHIJKLMNOPQRSTUVWXYZ[\]^_`abcdefghijklmnopqrstuvwxyz{|}~';
Message:
C0555: The string literal '你好,世界' contains characters that cannot be displayed. The project
option 'UTF-8 Encoding for STRING' could be used.
Error correction: Select the option.

2024/01/05

3ADR010583, 1, en_US

2407


6.4.1.21  Reference, User Interface

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.4.1.21.1</td>
<td>Notifications</td>
<td>2408</td>
</tr>
<tr>
<td>6.4.1.21.2</td>
<td>Objects</td>
<td>2409</td>
</tr>
<tr>
<td>6.4.1.21.3</td>
<td>Menu Commands</td>
<td>2551</td>
</tr>
<tr>
<td>6.4.1.21.4</td>
<td>Dialogs</td>
<td>2745</td>
</tr>
</tbody>
</table>

6.4.1.21.1  Notifications

Notifications inform you about important information, such as available updates or security notices.

To open the “Notifications” view, click the icon in the upper right corner of the frame window of CODESYS. All received notifications are displayed in this view. Notifications marked as “read” are deleted from the list the next time CODESYS is started.

The red icon \(^3\) indicates that new notifications are available, as well as how many.
6.4.1.21.2 Objects

General

Objects in CODESYS provide special functionalities to create applications. Examples: Application, program, function, Library Manager, devices, image pool. Objects are managed in tree structures in the views “Devices”, “POUs” and “Modules”.

You can add an object to the belonging "tree" by use of the command “Project ➔ Add Object”. The possible insert positions depends on the position within the tree.

Each object provides properties, which can be viewed and accessed with the command from the context menu of the object.

See also
- Chapter 6.4.1.21.3.4.22 “Command 'Properties'” on page 2597
Object 'Application'

Symbol: 🚀

The object is displayed as a node in the device tree. It comprises the objects which are required for a controller program to run.

You can insert an application object below a “PLC Logic” node (below a programmable device) or as a child application below an existing application (parent application).

Below each application, there has to be a “Task Configuration” where you configure which program of the application will be called by which task and using which settings.

Furthermore, you insert the POU\s of your controller program below an application, for example POU\s, global variables lists, and the Library Manager. These POU\s are available only for this application and its child applications.

In addition, the application can also use instances of project-global POU\s. You manage project-global POU\s in the “POUs” view. The use of these kinds of instances follows the thinking behind object-oriented programming.

Multiple applications can be inserted below a PLC device object. To do this, they have to have unique names.

![Diagram of PLC device object with applications](image)

**NOTICE!**

An online change after a changing the parent application will remove the child application from the PLC.

When multiple applications are directly below a device object, for the I/O handling of the device you have to define the application whose variables CODESYS should use for communication with the target system. The settings are configured on the “PLC Settings” tab of the device editor.

The application that you want to work with in online mode has to be set as the "active application" (see “App2” in the figure above).

You can set special properties for an application on the “Application Build Options” tab of the “Properties” dialog of the application object. Example: Activation of dynamic memory allocation.

When downloading the application to the PLC, you can include information about the application contents. This is also a setting on the “Application Build Options” tab. Then later you can compare the application on the controller with the active application in CODESYS.
If you want to add individual information about the author, version, and an individual short description, you can modify the information in the general "Project Information" on the "Information" tab of the "Properties" dialog.

When you want to log in to the target system (PLC or simulation) with an application, it will first be checked which applications are currently on the PLC and whether or not the application parameters on the controller match those in the project configuration. Corresponding messages will notify you about mismatches and possible options for further action. In this step, you can also delete applications from the PLC.

On the "Application" tab of the device editor, you can see which applications currently exist on the device. There you can also delete applications from the target system. It is possible that you also see additional applications which are not represented by a separate object in the device tree, for example the `<application>_symbols.app`, which contains a symbol list created for the application (see "Symbol Configuration").

See also

- Chapter 6.4.1.21.2.29 “Object 'Task Configuration’” on page 2533
- Chapter 6.4.1.21.4.11.10 “Dialog 'Properties - Application Build Options’” on page 2759
- Chapter 6.4.1.11 “Downloading an Application to the PLC” on page 1965
- Chapter 6.4.1.21.2.8.10 “Tab 'PLC Settings’” on page 2439
- Chapter 6.4.1.10.3 “Symbol Configuration” on page 1941
- Chapter 6.4.1.14.2 “Executing the online change” on page 2025
- Chapter 6.4.1.21.3.5.13 “Command 'Project information’” on page 2604

Object 'POU Locations'

This object is available only for specific controllers. It is displayed automatically in the device tree. The object cannot be added or removed manually. The object can be used for mapping the executable code of an application in different code areas on the controller. Specifically small controllers often have limited internal code areas (flash memory). If one or more additional code areas (for example, external flash memory) are available on the controller, then the location of the code POUs of an application can be changed specifically.

If there are no specific requirements, then the code POUs are stored sequentially in the code areas (“default”). This means that the next code POUs are stored in the next areas only when the first code area is filled. In the "POU Locations" editor, you will see the current location of the POUs in the memory areas and you can change them specifically.

Editor 'POU Locations'

Double-clicking the "POU Locations’" object in the device tree of the controller opens the editor. Then it receives the entry `<application>`. After a code generation, all program blocks of the application are displayed with the respective object type, current location in the memory, and code size.

In the “Configured Location” column, you can set one of the memory areas other than the “Current Location” for each POU or library.

In order to move the POUs to the recently configured memory locations, you first have to “Clean” and then “Generate Code” again.

Make sure to pay attention to the messages in the category “POU Locations”. This also shows when a code POU cannot be moved as expected.
**“Clean”**
Deletion of the compile information for the application. Corresponds to the menu command “Build ➔ Clean”. Requirement for moving the POUs to the configured memory locations.

**“Generate code”**
Starting of the code generation for the application. Corresponds to the menu command “Build ➔ Generate Code”. Requirement for moving the POUs to the configured memory locations.

**“Objects”**
Objects of the application, including the objects from the referenced libraries

**“Type”**
Object type; examples: “Function block”, “Method”, “Library”

**“Current location”**
Current memory location of the POU: area_<n>.

**“Configured location”**
Configured memory location where the POU is moved at the next code generation. Possible values:
- “default”: Automatically assigned area.
- “area_<n>”: Explicitly assigned memory area (n=number)

**“Code size”**
Code size of the POU (in bytes)

- [Chapter 6.4.1.21.3.6.2 “Command ‘Clean’” on page 2618](#)
- [Chapter 6.4.1.21.3.6.1 “Command ‘Generate Code’” on page 2618](#)

---

**Objects for Alarm Management**

The help pages for alarm management are summarized in the help for CODESYS Visualization. So please see there for help on the following objects:

- Object “Alarm Configuration”
- Object “Alarm Class”
- Object “Alarm Group”
- Object “Alarm Storage”
- Object “Remote Alarms”

---

**Object ‘Data Source Manager’**

Symbol: 

The object is used as a node for data sources below it. At least one data source has to exist. An application with the data source manager communicates with remote devices.

See also

- [Chapter 6.4.1.10.6 “Data Link with Data Sources” on page 1947](#)

---

**Command ‘Add Object’ > ‘Data Source’**

**Function:** The command opens the “Add Data Source” dialog.

**Call**
- Menu bar: “Project”
- Context menu in the “Devices” view of the CODESYS perspective
- Context menu in the “Data Sources” view of the “HMI” perspective

**Requirement:** The “Data Source Manager” object is selected that should have an additional data source.
Dialog 'Add Data Source'

<table>
<thead>
<tr>
<th>“Name”</th>
<th>Example: Data_Source_A</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Select data source type”</td>
<td>Data source type that matches the controller configuration in order to establish communication.</td>
</tr>
<tr>
<td>● “CODESYS Symbolic”:</td>
<td>Requirement: The local device is a CODESYS HMI. The data is transmitted by means of symbolic monitoring. This requires that symbols are configured in the symbol configuration of the remote PLC application. Note: As long as the symbol configuration is not impacted by an application change, you have the advantage that the application in the local device does not have to be updated. Hint: Use this communication connection unless there are no resources available in the remote PLC for a symbol configuration.</td>
</tr>
<tr>
<td>● “CODESYS ApplicationV3”:</td>
<td>The data is transmitted via the CODESYS address protocol. This requires that the address information between the remote PLC and the local device match. Otherwise a connection cannot be established. Advantage: A symbol configuration is not required in the remote application. Note: For changes to the remote application, the local application has to be updated (for example, the HMI application). Hint: Use this communication for embedded or mini PLCs when there are no available resources for the symbol configuration.</td>
</tr>
<tr>
<td>● “OPC UA Server”:</td>
<td>Data is transferred from an OPC UA server to the local controller via a TCP connection.</td>
</tr>
<tr>
<td>“Add”</td>
<td>Opens the “Initialize Data Source - Provider settings” dialog. The contents of the dialog depend on the selected data source type.</td>
</tr>
</tbody>
</table>

**NOTICE!**

The remote PLC should be running and the remote PLC application loaded and started.

See also

- ☂ Chapter 6.4.1.21.2.5 “Object 'Data Source Manager’” on page 2412
- ☂ Chapter 6.4.1.21.2.6.2 “Tab 'Variables’” on page 2415

Dialog 'Initialize Data Source Wizard - Provider settings' (for 'CODESYS Symbolic')

The settings of this dialog are described in the following chapter: Object ‘Data Source’ - Tab ‘Communication’.

The dialog is used to configure the connection initially when you have selected “CODESYS Symbolic” as the data source type. The communication is done by means of symbolic monitoring. The configuration can be modified later in the editor of the data source on the “Communication” tab.

See also

- ☂ Chapter 6.4.1.21.2.6.4 “Tab 'Communication' via CODESYS Symbolic” on page 2417
Dialog 'Initialize Data Source Wizard - Provider settings' (for 'CODESYS ApplicationV3')

The settings of this dialog are described in the following chapter: Object 'Data Source' - Tab 'Communication'.

The dialog is used to configure the connection initially when you have selected “CODESYS ApplicationV3” as the data source type. The communication is done by means of address monitoring.

See also

- Chapter 6.4.1.21.2.6.5 “Tab 'Communication' via CODESYS ApplicationV3” on page 2422

Dialog 'Initialize Data Source Wizard - Provider settings' (for 'OPC UA Server')

The settings of this dialog are described in the following chapter: Object 'Data Source' - Tab 'Communication'.

The dialog is used to configure the connection initially when you have selected “OPC UA Server” as the data source type. The communication takes place over a TCP connection.

See also

- Chapter 6.4.1.21.2.6.6 “Tab 'Communication' via OPC UA Server” on page 2424

Dialog 'Initialize Data Source Wizard - Browse data items'

The settings of this dialog are described in the following chapter: Object 'Data Source' - Dialog 'Choose Variables'.

Function: You can select the variables for data transmission from the variables of the remote PLC. By clicking “Finish”, the data source is initialized and the data types and variables (data interface) are declared below the folder “DataSources_Objects”. You can modify the settings in the editor of the data source object.

Call: Automatic

See also

- “Dialog 'Choose Variables” on page 2416

Object 'Data Source'

General

Symbol: 

In the editor (object type “Data Source”), the access to the data of a remote device is managed on the “Variables”, “Type Mappings”, “Communication”, and “General and Diagnosis” tabs.

Status bar

The status bar which is always visible notifies you about the data source type and the most important communication settings. When the communication is established by means of the data source type CODESYS Symbolic, the name of the data source type, the connection type, and the network name of the remote device are displayed. When the communication is established by means of data source type CODESYS ApplicationV3, then the name of the data source type, the location of the remote project, and the instance name of the remote application.

Example:

CODESYS Symbolic (CODESYS V3): PLC_Name
Tab 'Variables'

The variables for the data originating from the remote source are declared in the global variable list <name of data source>. The global variable list acts as a data interface to the remote PLC. The object is located below the application and below the “DataSources_Objects” folder.

|“Update variables”| Establishes a connection to the remote device and opens the “Choose Variables” dialog. |
|“Local variable”| Variable in the local application. Contains the remote data. |
|“Access rights”| Access rights of the variables. The respective remote variable has the same access rights. |
| | ● : Write access. Every time the values changes, the variable is updated on the controller. |
| | ● : Read access. Every time the values changes on the controller, the variable is updated in the application. |
| | ● : Read/Write access |
| | Note: If you change the access rights, then a download is required for the change to go into effect. |
|“Update always”| The controller data is updated automatically (via the data source). A variable is updated automatically if it is used in the visualization, trend, recipe, or as an alarm. |
| | Note: This is the recommended setting type. |
| | : The variable is updated in each cycle. |
| | Note: Select the option only when the variable is used exclusively in IEC code. If a variable is used in the visualization code, then it is updated automatically. |
| | Note: When an instance of a function block or a data type is updated in this way, the instance is always transferred completely. |
|“Create or map”| Mapping type for how the remote variable is mapped to the local variable. |
| | ● : Mapping to a specific created variable with the data type of the remote variable. The control data is mapped 1:1. That is the recommended mapping type. The variable is declared in the GVL <name of data source>. |
| | ● : Mapping to an existing variable. This requires that the existing variable has the same data type. |
| | ● : Mapping to a specific created variable with type-conforming data type to the remote data type: remote and local data types are not the same, but compatible. For example, a type-conforming data type can be available in a library. The variable is declared in the GVL <name of data source>. |
|“Type mapping”| Data type of the remote variable. If the variable is not a scalar type, then the type is listed on the “Type Mappings” tab. |
|“Remote variable”| Variable in the remote PLC |
Dialog 'Choose Variables'

Symbol: 🔄

**Function:** The dialog lists the remote variables that are accessed by means of the configured connection.

**Call:** "Update variables" command on the "Variables" tab.

**Requirement:** The remote PLC is running. The control application is downloaded.

**"Variables"**
The remote variables are listed in the tree view. The top node is identified by the remote application name. Its variables are listed below that. Structured data is listed with all of its subordinate elements.

**Example:** appControl_A

☑️: The variable is selected for transferring to the local device. When the variable is structured, it is applied with all subelements. If the variables themselves are subelements, then only this subelement is applied without accepting the structure completely.

Red font: When a variable is displayed in a red font, the variable is not available (anymore) in the remote PLC.

Note: You can click "Uncheck unavailable variables" to remove the variable from the list.

☐: The variable is not selected for the transfer.

+ The variable has expandable elements. By clicking the symbol, the variable is extended by their elements.

**"Insert the items structured"**

☑️: The selected variables are transferred with this structure if they are structured.

☐: The variable is transferred unstructured with a scalar data type.

**"Uncheck unavailable variables"**

Requirement: The link is visible when previously are no longer available in the variable available on the remote PLC. These variables are marked in red in the window above. The symbol configuration or the application presumably changed in the remote PLC.

By clicking the command, the red variables are removed from the list box.

Tab 'Type Mappings'
The tab lists the non-scalar data types as they are currently available in the "DataSources_Objects" folder. You can edit or delete the data type declaration by selecting a data type and then the declared elements in the lower window. Moreover, you can modify the name, reset access rights, map another type, or select another remote variable.

Tab 'Type Mappings'

<table>
<thead>
<tr>
<th>&quot;Local type&quot;</th>
<th>Data type in the local application</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Create or map&quot;</td>
<td></td>
</tr>
<tr>
<td>☑️: Mapping to a new created data type. Declared in the &quot;DataSources_Objects&quot; folder.</td>
<td></td>
</tr>
<tr>
<td>☐: Mapping to an existing data type</td>
<td></td>
</tr>
<tr>
<td>☀️: Mapping to a type-conforming data type. Declared in the &quot;DataSources_Objects&quot; folder.</td>
<td></td>
</tr>
</tbody>
</table>

| "Mapping name" | Name of the data type |
| "Remote type" | Data type of the remote PLC |
List with the subordinate elements of the selected data type.

<table>
<thead>
<tr>
<th>Element Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Local variable&quot;</td>
<td>Local variable name of the element of the selected data type</td>
</tr>
<tr>
<td>&quot;Access right&quot;</td>
<td>Access rights to the element</td>
</tr>
<tr>
<td>&quot;Type mapping&quot;</td>
<td>Data type of the element</td>
</tr>
<tr>
<td>&quot;Remote variable&quot;</td>
<td>Remote variable name of the element of the selected data type</td>
</tr>
</tbody>
</table>

[Del] Removes the selected element

See also
- Chapter 6.4.1.10.6.3 “Editing data source variables” on page 1954

Tab 'Communication' via CODESYS Symbolic

The tab includes the communication settings via CODESYS Symbolic for the remote data source.

When initially adding a data source, you have selected the “CODESYS Symbolic” data source type, and depending on that the communication settings to the data source were configured. Afterwards, the communication settings are outdated on this tab. You can only initially set the “Data source type” setting.

CODESYS Symbolic means that in the case of an active connection the communication is done via symbolic monitoring. This kind of symbolic access is possibly for CODESYS V2 and CODESYS V3 controller variants. In addition, the runtime system has to support the symbol configuration.

You can develop a local application offline based on the symbol information without a connection to the data source. To do this, you refer to a symbol file in the configuration settings in which all required variable information has been stored. Then no active connection is established.
“Variable information”  
Source of the variable information

- “From connection settings”
  A connection is established actively according to the communication settings specified below (“Connection type” and “Connection Settings”). The variable information is read from the remote controller application.

- “<device name>.<application name>.symbol configuration”
  The variable information is read from the symbol configuration. The symbol configuration is part of the active project and located in the device tree at the object of the remote controller below the application. An active connection is not established to the controller.

- “From symbol file”
  The variable information is read from a symbol configuration file that is stored on the development system. In the “Choose symbol file” field, specify this data. An active connection is not established to the controller.

“Choose symbol file”  
The path of the symbol file for the “Variable information” selection is “From symbol file”.

The symbol file is stored on the development system and contains the required variable information. By default, a symbol file path is created in the project directory in the following structure: <project folder>\<project name>\<device name>\<application name>.xml.

Example:
D:\Projects\Project_A\VisualizeWithHMI.Device.Application.xml

Note: If the “Alarm Table” element or “Trend” element is used in the visualization, then the symbol file required for symbolic access and the respective project must both be saved in the same folder. The project contains the configuration for the alarm table element or the trend recording for the trend element. This is the default case for automatically generated symbol files.

Example: D:\Projects\Project_A\VisualizeWithHMI.project

“Connection type”  
Connection type between the remote PLC and the local device.

Depending on the selected connection type, the following settings below change.

Note: Whenever possible, avoid a direct connection without a gateway.

- “CODESYS V2”
  The devices exist in the same network. The V2 runtime on the remote PLC provides a communication interface.

- “CODESYS V2 (Via gateway)”
  The devices do not exist in the same network. They are connected via a V2 gateway.

- “CODESYS V3”
  The devices exist in the same network. The V3 runtime on the remote PLC provides a communication interface.

- “CODESYS V3 (Via gateway)”
  The devices do not exist in the same network. They are connected via a V3 gateway.
### PLC Settings

#### “PLC”

#### “Driver type”
- “Tcp/Ip (Level 2 Route)”
- “Tcp/Ip (Level 2)”
- “Tcp/Ip”

#### “Address”
Example: localhost (for the currently used system on your computer)

#### “Port”
Example: 1200

#### “Block size”
Example: 128
Requirement: The driver type is “Tcp/Ip (Level 2)”.

#### “Target ID”
Example: 0
Requirement: The driver type is “Tcp/Ip (Level 2 Route)”.

#### “Motorola byte order”
☑: Byte order on the PLC in big endian (Motorola format)
☐: Byte order in little endian (Intel format)

### Connection settings for connection type 'CODESYS V2 (Via gateway)'

#### “Gateway”
The gateway settings are configured in addition to the PLC settings.
Note: For this connection, a “CoDeSys V2.3 Gateway Server” (V2 Gateway) also has to be installed on the development computer where CODESYS V3 is running.

#### “IP address”
Example: localhost

#### “Port”
Example: 1217

### Connection settings for connection type 'CODESYS V3'

#### “PLC”

#### “Name or address of device”
The setting that you make here varies according to the selection in the “Type of name or address” list box. For options that are derived automatically, you do not have to specify the setting here. The setting can remain empty.
Example: Nothing specified for “...(automatically derived)”
Example: PLC_A for “Node name”
Example: [ABCD] for “Node address”
Example: 192.168.1.5:11741 for “IP address”
Example: POU.dssCommVar with data type DatasourceSym.ConnectionSetup for “Dynamic from variable”

Hint: ☑: Opens the input to select the program variables for dynamic configuration. This variable has to be the data type DatasourceSym.ConnectionSetup.
"Type of name or address"

- "Node name (automatically derived)"
- "Node address (automatically derived)"
- "IP address (automatically derived)"
- "Node name"
- "Node address"
- "IP address"
- "Dynamic from variable"

"Dynamic from variable"

The device name or address is configured dynamically at runtime by means of an IEC variable of data type `DatasourceSym.ConnectionSetup`. The data type `DatasourceSym.ConnectionSetup` (STRUCT) is defined in the Datasource Symbolic Access library. For the configuration, the structure member `xDDataValid` first has to be set to `FALSE`. If the address data has been specified, then `xDDataValid` has to be set back to `TRUE`.

Use case: The device name or address is not available when a project is being created.

The dynamic configuration can also be used to change the settings at runtime without restarting the HMI application.

Note: For this connection type, the connection is also not done dynamically via gateway.

---

Connection settings for connection type 'CODESYS V3 (Via gateway)'

| "Gateway" | The gateway settings are configured in addition to the PLC settings. |
| "IP address" | Example: localhost |
| "Port" | Example: 1217 |

Extending the communication settings for the PLCHandler interface

**NOTICE!**

It is not recommended to configure the PLCHandler manually.

The connection to the controller is established via the CODESYS PLCHandler communication interface. In this case, the configuration is performed in the PLCHandler INI format and allows for advanced parameterization.

| "Advanced" |
| "Used as" |
| "Don't use" |
| Recommended setting |
| The "INI content" property as well as any specified configuration settings there are ignored. |
| "Extend the configuration by the following content" |
| As a rule, the configuration settings are used which are specified in the "Connection Settings for CODESYS V3 (Via gateway)" property. Moreover, the configuration settings are used in the "INI content" property. |
| "Configure completely with the following content" |
| The configuration settings of the "Configuration Settings for CODESYS V3 (Via gateway)" property are ignored. Instead, only the configuration settings are used in the "INI content" property. |
**“INI content”**

Requirement: “Used as” is set to “Extend the configuration by the following content”.

Example:

```
loqfilter=16#000000FF
```

Example:

```
parameter0=EncryptCommunication
value0=1
```

Note: If the parameters are generic, then they can be specified as 0-based (parameter0 and value0). When extending, the numbering is automatically adjusted so that the extended parameters connect to the existing ones. The number of parameters (parameters=<n>) is also set to the correct value.

**“INI content”**

Requirement: “Used as” is set to “Configure completely with the following content”.

Example:

```
[PLC:PLC_IdArti]
interfacetype=ARTI
active=1
logevents=1
motorola=0
nologin=0
timeout=10000
precheckidentity=0
tries=3
waittime=12
reconnecttime=10
buffersize=0
device=Tcp/Ip (Level 2 Route)
instance=PLCWinNT_TCP1P_L2Route
parameters=4
parameter0=Address
value0=localhost
parameter1=Port
value1=1200
parameter2=TargetId
value2=0
parameter3=Motorola byteorder
value3=No
```

---

**Communication settings for controllers with visualization user management**

**“Login Configuration”**

If a visualization user management is configured on the remote device, then valid credentials are required at login.

**“Type”**

Defines how the visualization user management gets credentials

- **“Login using the following credentials”**
  The credentials are hard-coded into the “User name” and “Password” settings. They are used each time a connection is attempted.

- **“Login using the credentials determined at runtime”**
  At runtime, a dialog opens and prompts the user to specify a user name and password. Hard-coded credentials, which have nonetheless been specified in “User name” and “Password”, are ignored.
**User name**  
Example: max.smith

**Password**  
Example: ···

See also
- Chapter 6.4.1.10.6.2 “Initially Adding a Data Source” on page 1949
- Chapter 6.4.1.21.2.5 “Object ‘Data Source Manager’” on page 2412

### Tab 'Communication' via CODESYS ApplicationV3

The tab includes the communication settings for a remote data source.

When initially adding a data source, you have selected the CODESYS ApplicationV3 data source type, and depending on that the communication settings to the data source were configured. Afterwards, the communication settings are outdated on this tab. You can only initially set the “Data source type” and “Select the project type” settings.

CODESYS ApplicationV3 means that in the case of an active connection the communication is done via address monitoring. In this case, the remote PLC is configured by directly specifying the device address or automatically via network scan.

### Tab 'Communication' via CODESYS ApplicationV3

<table>
<thead>
<tr>
<th><strong>“Select the project type”</strong></th>
<th>The project type indicates where the controller is configured: in the same project as the HMI application or in a separate project.</th>
</tr>
</thead>
</table>
|                             | - “Current project”  
|                             | The control application is part of the currently open project. The communication settings can be updated automatically or manually. |
|                             | - “Other Project”  
|                             | The control application is part of a separate project whose location is specified in “Choose file”. The communication settings are done manually. |

In the initial setting of the data source object, this option is fixed and influences which settings are available for “Target device”.

| **“Choose file”** | Name and path of the project that contains the control application (source project)  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Example:</strong> D:\PLCs\PLC_A.project</td>
<td>Requirement: The “Select the project type” is “Other Project”.</td>
</tr>
</tbody>
</table>

| Window area for controllers of the project | Controllers and their subordinate applications, read from the selected project  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Example:</strong></td>
<td></td>
</tr>
</tbody>
</table>
**"Target device"**

Note: The following settings are available when “Select the project type” is set to “Current project”.

**"Automatic configuration"**

- The configuration is read automatically from the source project. This is the recommended setting.
  
  Example: “[DEVICE_A]”

  Example: “[undetermined]”: No configuration can be read.

  Note: Make sure that the application is running on the controller and the network path is active. The communication settings of the controller are applied only then. These are the communication settings that were configured in the source project in the device editor on the "Communication Settings" tab.

**"Manual configuration"**

- More configuration settings are displayed.

  See "Manual configuration" below.

---

**Settings for ‘Select the project type’ == ‘Other Project’**

The communication setting is done only manually.

See "Manual configuration" below.

**Manual configuration**

**"Dynamic from variable"**

- The communication parameters are configured at application runtime by means of an IEC variable of data type DatasourceAppV3.ConnectionSetup.

  - Opens the input for selecting the IEC variables for a dynamic configuration.

  The data type DatasourceAppV3.ConnectionSetup (STRUCT) is defined in the Datasource ApplicationV3 Access library. For the configuration, the structure member xDataValid first has to be set to FALSE. If the address data has been specified, then xDataValid has to be set back to TRUE.

  Use case: The communication parameters are not available yet when a project is being created.

**"Use device address"**

- The communication is done via the address specified here.

  Example: 0101

  Hint: Click “From device” for an automatic address setting.

**"From device"**

The data of the currently connected data source device is read automatically and specified in “Use device address”. The address corresponds to the setting of the device in the device editor in “Communication Settings”.

**"Search for the target device using the network scan"**

- The data source manager starts the network scan for devices in the network. The scan is successfully when controllers are found whose communication settings match the selected search criteria. The result is displayed in the input fields.

**"Node name"**

- Search for the specified node name

  Example: WST06

**"Target type"**

- Search for the specified target type

  Example: 4096

**"Target ID"**

- Search for the specified target ID

  Example: 0000 0001

**"Target version"**

- Search for the specified target version

  Example: 1.0.0.0
### Network location
- **Direct child of the data sources PLC**: The scanned remote PLC has an address that is running with the address of the local controller (of the data source manager).
  - Example: Data sources PLC: 0000.0001; remote source PLC: 0000.0001.0001
- **Direct child of node with address**: Specify the address of the parent node
- **Direct child of the data source PLC or of the node with address**: Combination of both options above.

### Search type
- **First found device**: The first controller in the device tree is selected that fulfills the specified criteria.
- **Exactly found device**: The controller is selected that fulfills the specified criteria exactly.

Note: The data source manager waits until the network scan is complete. This usually takes about 10 seconds.

---

### Communication settings for controllers with visualization user management

<table>
<thead>
<tr>
<th><strong>Login Configuration</strong></th>
<th>If a visualization user management is configured on the remote device, then valid credentials are required at login.</th>
</tr>
</thead>
</table>
| **Type**               | Defines how the visualization user management gets credentials | **Login using the following credentials**  
The credentials are hard-coded into the “User name” and “Password” settings. They are used each time a connection is attempted.  
**Login using the credentials determined at runtime**  
At runtime, a dialog opens and prompts the user to specify a user name and password. Hard-coded credentials, which have nonetheless been specified in “User name” and “Password”, are ignored. |
| **User name**          | Example: max.smith |
| **Password**           | Example: ⋯ |

### Specific settings of the communication buffer

<table>
<thead>
<tr>
<th><strong>Advanced</strong></th>
<th>☑: The subsequent settings are changed.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Default communication buffer size</strong></td>
<td>Default setting: 50000</td>
</tr>
</tbody>
</table>

See also
- % Chapter 6.4.1.10.6.2 “Initially Adding a Data Source” on page 1949
- % Chapter 6.4.1.21.2.5 “Object ‘Data Source Manager’” on page 2412

### Tab 'Communication' via OPC UA Server

<table>
<thead>
<tr>
<th><strong>Where to find the server layout</strong></th>
<th>The client connects to the server and detects the existing variables and types.</th>
</tr>
</thead>
</table>
### From Information Model

The client reads the data structure (layout) of the OPC UA Server from the information model set here and as a result receives the information about available variables and types. A connection to the server is not required.

The list box contains the information models installed in the OPC UA Information Model Repository.

[Chapter 6.4.1.21.3.9.12 “Command ‘OPC UA Information Model Repository’” on page 2665](#)

### Read Connection Settings from IEC Variable

 Begins: The connection settings used by the device are not read here from the dialog, but at runtime from the IEC variable specified here.

For this possibility, see: Using a Dynamic Connection to an OPC UA Server

[Chapter 6.4.1.10.6.7 “Data Source OPC UA Client” on page 1960](#)

### Connection Type

**“Server URI”**

URI of the OPC UA Server; editable

**“Show All Endpoints”**

The button opens the “Available Endpoints” dialog with the end points available on the OPC UA Server. An “endpoint” is a combination of security settings.

The lower part of the dialog displays the available user tokens: “PolicyId, TokenId”, and “SecurityPolicy”.

For the selected end point, clicking “Apply” will apply the security settings “SecurityMode” and “SecurityPolicy” on the “Communication” tab in the “Security” section.

### Security

**“Messages Security Mode”**

Type of encryption

- **“None”**: No encryption and no signing
  
  Note: if you select this option, there can be no guarantee who receives the data. Therefore, “None” should be used exclusively in closed networks.

- **“Sign and Encrypt”**: The transferred data will be signed and encrypted.
  
  Signing makes sure that the data is not manipulated and the receiver is correct.

- **“Sign”**: The transferred data will be signed.

  Signing and encryption work only for certificates.

**“Security Policy”**

List box for the encryption method to be used:

- Basic256sha256

Requirement: Either “Sign and Encrypt” or “Sign” was selected for “Messages Security Mode”.

**“Client certificate”**

Here you can specify a certificate for an encrypted signed access to the OPC UA Server for the purpose of browsing.

Note: The access which is safeguarded in this way is ONLY for browsing the server (see above, “Browse Live Server” option). For encrypted data exchange between the server and client in online mode, a separate certificate is required, which can be created in the security screen. For more information see: OPC UA Server, Creating a certificate of the CODESYS OPC UA Server.

In case a certificate is not available for selection, you can click the button to open the “Create Self-Signed Certificate” dialog. Here you define a password for your private key and a file name for the certificate. When you click [OK], the certificate files .cer and .pfx are created in the project directory and the certificate is automatically registered in the certificate manager.
## Authentication

<table>
<thead>
<tr>
<th>Access</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anonymous</td>
<td>Access without authentication. Permission for this can be granted for compatibility reasons in the “Change Communication Policy” dialog on the “Communication Settings” tab of the device editor.</td>
</tr>
<tr>
<td>User name</td>
<td>Access to the OPC UA Server requires the entry of a user name and password. You can programmatically set up how the transfer of this authentication data should be done: To help with the creation of a POU for this purpose in the project, you can click the “Create Authentication Provider” button to create a program template Datasource_OPCUA_Initializer and program it accordingly.</td>
</tr>
</tbody>
</table>

---

### Tab 'General and Diagnosis'

The “General and Diagnosis” tab provides information about the status of the data source communication.

<table>
<thead>
<tr>
<th>Access</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Configuration</td>
<td></td>
</tr>
<tr>
<td>Update rate (ms)</td>
<td>Example: 200</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Access</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Information</td>
<td></td>
</tr>
<tr>
<td>Connection status</td>
<td>Example: online</td>
</tr>
<tr>
<td>Error information</td>
<td>Example: OK</td>
</tr>
</tbody>
</table>

See also:

- Chapter 6.4.1.21.2.5 “Object 'Data Source Manager’” on page 2412

### Object 'DeviceTrace'

Symbol: 📈

A “DeviceTrace” object shows trace data in one or more diagrams, as does a “Trace” object.

The difference is that a “DeviceTrace” directly accesses traces that are running on the controller. The object is inserted below the device in the device tree. Therefore there is no immediate dependency on the applications in the CODESYS project.

- You can use the DeviceTrace for visualizing the processor load of a multicore controller.

For more information about the editor and its operation, refer to the help page for the “Trace” object.

See also:

- Chapter 6.4.1.21.2.31 “Object 'Trace’” on page 2541
- “Runtime system component CmpTraceMgr, “Trace manager”” on page 2008
- Chapter 6.4.1.13.3.5 “Accessing All Traces on the Controller” on page 2014
Object 'Device' and Generic Device Editor

General

Symbol: 

A device object represents a type of hardware: examples: control device, fieldbus node, bus node, drive, I/O module, monitor. The arrangement of the device objects in the device tree, that is the view "Devices" in CODESYS, maps the hardware structure. In the device object configuration editors inter alia you connect the controller I/Os with project variables.

Use command "Add Device" or "Insert Device" to insert a device object in the device tree. Depending on the insert position CODESYS always offers the currently matching devices.

A double-click on a device object in the device tree opens the associated device editor. The editor provides generic and device-specific tabs for the device configuration.

See also

- Chapter 6.4.1.21.2.8.2 "Generic device editor" on page 2427

Generic device editor

The generic device editor contains tabs for the configuration of a PLC device in CODESYS. Additionally there are device-specific tabs, so that the configuration editor consists of many different dialogs, depending on the device.

The editor opens after a double-click the device object in the device tree ("Devices" view).

You can make general settings for a device editor in the CODESYS "Options" in the "Device Editor" category. For example, you can show and hide the tabs of the generic device editor.

A device editor is given the name of the device. The following tabs of the generic device editor can be included:

- "Communication": Configuration of the connection between the development system and a programmable device (PLC). Not available in the case of pure I/O devices.
- "Applications": List of the applications on the controller.
- "<device> Parameters": Display and configuration of device parameters.
- "Files": Configuration of the file transfers between a host file system and the device.
- "Log": Display of the PLC log file.
- "PLC Settings": Configuration of the handling of the I/Os: which application, behavior in the stop state, updating, bus cycle options, etc.
- "PLC Shell": Text-based control monitor for interrogating certain information from the controller.
- "Users and Groups": User management with regard to the device at runtime.
- "Access Rights": Rights for access to objects and files on the device.
- "Symbol Rights": Access rights of individual user groups to symbols (symbol sets) on the device.
- "Task List": Overview of all inputs and outputs, which are assigned to tasks – useful for troubleshooting.
- "Status": Device-specific status and diagnostic messages.
- "Information": General information about the device (name, vendor, version etc.)

See also

- Chapter 6.4.1.8 "Configuring I/O Links" on page 1835

Tab 'Communication Settings'

On this tab of the generic device editor, you define the connection between CODESYS and the device on which your application(s) should run. This includes security settings such as encrypted communication and signing.
If you prefer the classic mode of display for the dialog, then select it in the CODESYS “Options” in the “Device editor” category.

You select a gateway and a target device from the list boxes. The possible selections depend on the entries in the “Manage Gateways” and “Manage Favorite Devices” dialogs (see the “Gateway” menu).

You can also specify the target directly with the IP address (example: “192.168.101.109”), device address (example: “[056D]”), or device name (example: “MyDevice”). After the device is entered, CODESYS searches for the device in the network of the gateway.

The solid circle on the lower right corner of the gateway symbol provides information about the connection status:

- Red: CODESYS cannot establish the connection.
- Green: The connection is established.
- Black: The connection status is unknown.

Some communication protocols allow regular checking of the gateway so that the status cannot be displayed.

Clicking the solid circle of the target device starts a network scan for the device. This works only if the network is not already being scanned.
“Scan Network” This button opens the “Select Device” dialog. It lists all configured gateways with the associated devices. You can select one target device from this list. If the name of the selected device is unique, then the name will be used in the connection settings. Otherwise, the unique device address is applied.

For details about this dialog, see the description of the classic view below.

Option: **Hide non-matching devices, filter by Target ID:**

- : The display is limited on the devices that have the same target ID as the current device configured in the project.
- : All available devices in the network are displayed. Double-clicking the entry of a device, which has a different target system ID than the device configured in the project, opens a dialog box. This dialog box allows you to update the device description of the device in the project to the one matching the selected device.

**Note:** This kind of update is possible only with devices which have different IDs, not for those which only have different versions. The update also requires that the device description is already installed in the repository.

“Gateway” This menu includes the following commands:

- **“Add New Gateway”**: Opens the “Gateway” dialog for defining a new gateway channel.
- **“Manage Gateways”**: Opens the “Manage Gateways” dialog with an overview of all gateways. You can add or delete entries here or change their order.
- **“Configure Local Gateway”**: Opens the “Gateway Configuration” dialog. You can configure the block drivers for the local gateway.

“Device” This menu includes the following commands:

- Options:
  - **“Add Current Device to Favorites”**: Adds the currently set device to the list of favorite devices.
  - **“Manage Favorite Devices”**: Opens the favorites dialog with a list of all preferred devices. In this dialog, you can add or delete entries or change their order. The top device is the default.
  - **“Confirmed Online Mode”**: For security reasons, CODESYS requires you to confirm the following when calling the following online commands: **Force Values**, **Write Values**, **Multiple Loading**, **Release Force List**, **Single Cycle**, **Start**, **Stop**.
  - **“Store Communication Settings in Project”**: CODESYS saves the communication settings in the project for reuse on the same computer.

  **Note:** If you use the project on another computer, then you have to reset the active path.

  CODESYS saves the communication settings in the options of the local installation for reuse on the same computer.

  **Note:** When using CODESYS SVN, the option should be cleared in order to prevent blocking the device object.

- **“Rename Active Device”**: Opens a dialog for changing the device name.
- **“Wink Active Device”**: Devices that support this function react by blinking.
- **“Send Echo Service”**: CODESYS sends five echo services to the controller. These are used to test the network connection, similar to the ping function. The services are sent first without a payload and then with a payload. The scope of the payload depends on the communication buffer of the PLC. A message view opens with information about the average echo service delay and the scope of the sent payload.
- **“Encrypted Communication”**: The communication to this controller is encrypted. A certificate of the controller is required in order to log in to the controller. If the certificate is not available, then an error message opens prompting whether or not the certificate should be displayed and installed.
If the “Enforce encrypted communication” option is selected as “Security level” in the “Security Screen” view, then the “Encrypted Communication” command is disabled here.

- “Change Runtime Security Policy”
  Opens the “Change Runtime Security Policy” dialog for changing the device setting for the encryption of communication.
- “Change Runtime Password Policy”
  Opens the “Change Runtime Password Policy” dialog to change the settings for the password policy and the login lock.
- “Security Settings”: This command is available only if CODESYS Security Agent >= 1.3.0.0 is installed. It opens the “Device Security Settings” dialog. The current security settings on the connected device are displayed. You can change the settings in the “Value” column and click “OK” to write them to the device.
- “Filter Network Scans by Target ID”:
  The display is limited on the devices that have the same target ID as the current device configured in the project.

Table 402: Dialog “Change Runtime Security Policy”

<table>
<thead>
<tr>
<th>“Communication Settings”</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Current policy”</strong></td>
<td>Shows the currently selected policy for the encryption of communication with the device</td>
</tr>
<tr>
<td><strong>“New policy”</strong></td>
<td>List box for the new policy for encryption</td>
</tr>
<tr>
<td>- “No encryption”: The controller does not support encrypted communication.</td>
<td></td>
</tr>
<tr>
<td>- “Optional encryption”: The controller supports encrypted and unencrypted communication.</td>
<td></td>
</tr>
<tr>
<td>- “Enforced encryption”: The controller supports encrypted communication only.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Code Signing”</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Current policy”</strong></td>
<td>Display of the code signing policy which is currently set in the runtime system</td>
</tr>
<tr>
<td><strong>“New policy”</strong></td>
<td></td>
</tr>
<tr>
<td>- “All”: All types of application code are accepted.</td>
<td></td>
</tr>
<tr>
<td>- “Enforced signing”: Only signed application code is accepted (preventing loading an application from untrusted sources).</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Device User Management”</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Current policy”</strong></td>
<td>Shows the currently selected policy for user management</td>
</tr>
<tr>
<td><strong>“New policy”</strong></td>
<td></td>
</tr>
<tr>
<td>- “Optional user management”: It is the responsibility of the user to enable user management on the device or leave the device unprotected.</td>
<td></td>
</tr>
<tr>
<td>- “Enforced user management”: The user management on the device is enabled and cannot be disabled by the user.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Allow anonymous login”</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>✓: Specific registered components (for example, OPC UA) can connect to the controller without the providing any credentials. Even if anonymous access to the OPC UA is permitted, the created device user management for the controller remains active.</td>
<td></td>
</tr>
</tbody>
</table>
Table 403: Dialog “Change Runtime Password Policy”

<table>
<thead>
<tr>
<th>“Password policy is active”</th>
<th></th>
<th>The “Password settings” can be changed and are used when a password for the device user management is created.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>“Password settings”</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● “Minimum length”</td>
<td>Default setting: 8</td>
</tr>
<tr>
<td></td>
<td>● “Number of unique characters”</td>
<td>Default setting: 4</td>
</tr>
<tr>
<td></td>
<td>● “Requires lowercase letter”</td>
<td>Default setting: enabled</td>
</tr>
<tr>
<td></td>
<td>● “Requires uppercase letter”</td>
<td>Default setting: enabled</td>
</tr>
<tr>
<td></td>
<td>● “Requires digit”</td>
<td>Default setting: enabled</td>
</tr>
<tr>
<td></td>
<td>● “Requires special character”</td>
<td>Default setting: enabled</td>
</tr>
<tr>
<td></td>
<td>● “Must not contain username”</td>
<td>Default setting: enabled</td>
</tr>
<tr>
<td></td>
<td>The following rules for the password always apply, even when the rules are partially or completely disabled:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● The password must not be blank.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● The password must not be the same as the user name.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Login lock is active”</th>
<th></th>
<th>The “Login lock settings” are applied at login.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>“Login lock settings”</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● “Scope”</td>
<td></td>
</tr>
<tr>
<td></td>
<td>– “ADMINS”: The settings apply to users who have administrator permissions.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>– “NOADMINS”: The settings apply to all users who do not have administrator permissions.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>– “ALL”: The settings apply to all users.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● “Maximal Retries”: When the number of login attempts specified here is exceeded, the user will be locked out for the amount of time which is specified in the “Lock duration” field. The user cannot log in again until the lock is removed by an administrator or the lockout time has expired.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● “Lock duration [s]”: Lock time (in seconds)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For information about unlocking a locked user, see:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>☞ Chapter 6.4.11.3 “Encrypting Communication, Changing Security Settings” on page 1967</td>
<td></td>
</tr>
</tbody>
</table>

Communication Settings - Classic Mode

In the CODESYS options, you can activate the classic mode of the dialog (”Tools ➔ Options”, “Device Editor” category).

<table>
<thead>
<tr>
<th>“Select the network path to the controller”</th>
<th>Gateway channel for the connection.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Select the channel from the lower part of the view.</td>
</tr>
</tbody>
</table>
Table 404: “View displaying configured gateway channels and network devices”

Left side of view

Tree structure of the configured gateway channels with the connected devices in the local network:

Note: CODESYS saves these entries on the local system, not in the project.

The device entries are preceded by a device symbol ( ). Entries with a target ID that are different from those currently configured in the project are displayed in gray.

Click “Scan Network” to refresh the list.

Note: If you created the first project on the local system, then the local gateway is listed as an entry in the tree by default. CODESYS starts this gateway automatically on system boot.

The solid circle on the lower right corner of the gateway symbol provides information about the connection status:

- Red: CODESYS Development System cannot establish the connection.
- Green: The connection is established.
- Black: The connection status is unknown.

Note: Some communication protocols allow regular checking of the gateway so that the status cannot be displayed.

Each of the device entries in the tree consists of a symbol followed by the “Device name” > “[Device address]”. On the right side of the view, you also see the “Target ID”, “Target Name”, “Target Type, Target Vendor”, and “Target Version”.

Right side of view

Information about the gateway channel of device selected on the left side of the view.

When a gateway channel is selected in the left view, the following information is displayed: “Device name”, “IP address”, “Port”, “Driver”.

When a device is selected in the left view, the following information is displayed (depending on the device): “Device name”, “Device address”, “Number of channels”, “Block driver”, “Serial number”, “Encrypted communication”, “Target vendor”, “Target ID”, “Target name”, “Target type”, “Target version”.

Table 405: “Filter and sorting functions on the right side of the dialog”

<table>
<thead>
<tr>
<th>Filter</th>
<th>You can reduce the displayed list of devices that have the same “Target ID” as the current device configured in the project.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sorting order</td>
<td>You can sort the list by “Name” or “Device Address” in alphabetical or ascending order.</td>
</tr>
</tbody>
</table>

Table 406: Command buttons on the right side of the dialog

<table>
<thead>
<tr>
<th>Command</th>
<th>The command sets the selected communications channel as active. Double-clicking the entry in the channel tree achieves the same result.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Gateway</td>
<td>The command opens the “Gateway” dialog where you can define a gateway that CODESYS should add to the current configuration.</td>
</tr>
<tr>
<td>Add Device</td>
<td>The command opens the “Add Device” dialog. Here you can manually define a device that is to be inserted under the gateway entry currently selected in the tree. Note the functionality of “Scan Network” as well.</td>
</tr>
<tr>
<td>Scan Network</td>
<td>The command starts a search for available devices in the local network. The configuration tree of the gateway is refreshed accordingly.</td>
</tr>
</tbody>
</table>
Table 407: “Commands in the context menu of the gateway tree and device tree in the dialog”

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Scan for Device by Address”</td>
<td>The command searches the network for devices with a unique address as given in the configuration tree. CODESYS displays the detected devices with the given address below the gateway. The search always applies to the devices below the selected gateway or below the selected entry.</td>
</tr>
<tr>
<td>“Scan for Device by Name”</td>
<td>The command searches the network for devices with the same name as given in the configuration tree. Capitalization is ignored. CODESYS displays the detected devices below the gateway with the given name together with its unique device address. The search always applies to the devices below the selected gateway or below the selected entry.</td>
</tr>
<tr>
<td>“Scan for Device by IP Address”</td>
<td>The command searches the network for devices with a unique IP address as given in the configuration tree. CODESYS displays the detected devices with the given address below the gateway together with its name. The search always applies to the devices below the selected gateway or below the selected entry.</td>
</tr>
<tr>
<td>“Send Echo Service”</td>
<td>CODESYS sends five echo services to the controller. These are used to test the network connection, similar to the ping function. The services are sent first without a payload and then with a payload. The scope of the payload depends on the communication buffer of the PLC. A message view opens with information about the average echo service delay and the scope of the sent payload.</td>
</tr>
<tr>
<td>“Delete Selected Device”</td>
<td>The command deletes the selected device from the channel tree.</td>
</tr>
<tr>
<td>“Edit Gateway”</td>
<td>The command opens the “Gateway” dialog for editing the settings for the selected gateway.</td>
</tr>
<tr>
<td>“Configure the Local Gateway”</td>
<td>The command opens a dialog for configuring a local gateway. This provides an alternative to manually editing the Gateway.cfg file.</td>
</tr>
</tbody>
</table>

Table 408: Options in the lower part of the dialog

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| “Don’t store communication settings in project” | - [ ]: CODESYS saves the communication settings in the options of the local installation for reuse on the same computer. Note: When using CODESYS SVN, the option should be selected in order to prevent blocking the device object.  
  - [ ]: CODESYS saves the communication settings in the project for reuse on the same computer. Note: If you use the project on another computer, then you have to reset the active path. |
| “Confirmed Online Mode”             | [ ]: For security reasons, CODESYS requires you to confirm the following when calling the following online commands: “Force Values”, “Write Values”, “Multiple Loading”, “Release Force List”, “Single Cycle”, “Start”, “Stop”. |

Tab ‘Parameters’

This dialog is intended for test purposes. Its values should be changed only by experts.

The device-specific parameters are displayed in a table on this tab of the generic device editor. The device description defines which parameters you can edit in this dialog.

You can sort the entries in alphabetically ascending or descending order or in the default order by clicking the column header.

<table>
<thead>
<tr>
<th>“Parameter”</th>
<th>Parameter name, not editable</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Type”</td>
<td>Data type of the parameter, not editable</td>
</tr>
<tr>
<td><strong>“Value”</strong></td>
<td>Initially displays the default value of the parameter, directly or the corresponding symbol name. Non-editable parameters are displayed in light-gray. If the parameter is editable you can open an input field, a drop-down list or a file selection dialog with a double-click the table field and use it to change the value.</td>
</tr>
<tr>
<td><strong>“Default value”</strong></td>
<td>Default value of the parameter defined by the device description, not editable</td>
</tr>
<tr>
<td><strong>“Unit”</strong></td>
<td>Unit of measure for the value (example: &quot;ms&quot; for milliseconds; not editable)</td>
</tr>
<tr>
<td><strong>“Description”</strong></td>
<td>Short description of the parameter specified by the device description, not editable</td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.1.21.2.8.2 “Generic device editor” on page 2427

### Tab 'Applications'

On this tab of the generic device editor you can see which applications exist on the device. Depending on the system you can delete the applications from the device or retrieve detailed information about the application.

| **“Applications on the PLC”** | List of the applications found via “Refresh list” during the last scan of the control device. |
| **“Delete”** | Deletes the application selected in the list or all listed applications on the controller |
| **“Delete All”** | Note: If a safety controller is inserted below a PLC, then this command can permanently interrupt the communication links of the safety controller to other safety controllers (via safety network variables), to field devices, and to the development system. The safe field devices and the other safety controller can enter the safe state as a reaction. The connection to the development system is affected only in the case of a safety controller that is connected to the main controller via a fieldbus. For more information, refer to the section "Subordinate Safety Controller". |
| **“Details”** | Opens the dialog box “Details”. It displays information defined for the application on the “Information” tab of the dialog box “Properties”. |
| **“Contents”** | Requirement: The “Download the application info” option is activated in the “Properties” of the application object on the “Application generation options” tab. This causes information about the contents of the application to be additionally loaded to the PLC. The “Contents” button opens a dialog box with additional information about the differences between the latest generated code and the application code that exists on the controller. The different modules are displayed in a comparison view. |
| **“Refresh List”** | The controller is scanned for applications and the list is refreshed accordingly |

You can configure the commands “Remove Application from Device” and “Remove Applications from Device” by means of the dialog box form “Tools → Customize”. These commands correspond to the “Delete” and “Delete All” buttons.

See also

- Chapter 6.4.1.21.2.8 “Object ‘Device’ and Generic Device Editor” on page 2427
- Chapter 6.4.1.21.2.2 “Object ‘Application’” on page 2410
- Chapter 6.4.1.21.2.8.2 “Generic device editor” on page 2427
Tab 'Backup and Restore'

In this tabbed page of the generic device editor, you can backup and restore the application-specific file on the PLC by saving and reading a zip archive.

Requirement: The communication settings are correct for connection to the device. The application for backup is available on the PLC.

Table 409: Menu Bar

<table>
<thead>
<tr>
<th>Button</th>
<th>Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup</td>
<td>This button opens a menu with the following commands:</td>
</tr>
<tr>
<td></td>
<td>- &quot;Read Backup Information from Device&quot;: This command searches for</td>
</tr>
<tr>
<td></td>
<td>application-specific files from the $PlcLogic$ directory of the PLC and</td>
</tr>
<tr>
<td></td>
<td>lists them in a table in the lower part of the tabbed page.</td>
</tr>
<tr>
<td></td>
<td>- &quot;Create Backup File and Save to Disk&quot;: Requirement: The &quot;Read Backup</td>
</tr>
<tr>
<td></td>
<td>Information from Device&quot; command was used for determining the backup-</td>
</tr>
<tr>
<td></td>
<td>related files. These files are located in the table in the lower part</td>
</tr>
<tr>
<td></td>
<td>of the tabbed page. This command compresses the files in the table set</td>
</tr>
<tr>
<td></td>
<td>as &quot;Active&quot; and the meta.info information file into a backup zip file.</td>
</tr>
<tr>
<td></td>
<td>The file extension is tbf (&quot;Target Backup File&quot;).</td>
</tr>
<tr>
<td></td>
<td>- &quot;Save Backup File to Device&quot;: Requirement: The backup file has been</td>
</tr>
<tr>
<td></td>
<td>saved to the disk. This command saves the backup file to the TBF directory</td>
</tr>
<tr>
<td></td>
<td>of the PLC.</td>
</tr>
<tr>
<td>Restore</td>
<td>This button opens a menu with the following commands:</td>
</tr>
<tr>
<td></td>
<td>- &quot;Load Backup File from Disk&quot;: This command opens the &quot;Open&quot; dialog</td>
</tr>
<tr>
<td></td>
<td>box for navigating the file system for a saved backup file. The included</td>
</tr>
<tr>
<td></td>
<td>files are listed in a table in the lower part of the tabbed page.</td>
</tr>
<tr>
<td></td>
<td>- &quot;Load Backup File from Device&quot;: This command generates a list of all</td>
</tr>
<tr>
<td></td>
<td>backup files found on the PLC. Select one of these files to view its</td>
</tr>
<tr>
<td></td>
<td>contents in a table on the tabbed page. For the restore operation, you</td>
</tr>
<tr>
<td></td>
<td>can deactivate optional components and edit the comments.</td>
</tr>
<tr>
<td></td>
<td>- &quot;Restore on Device&quot;: This command is available if at least one</td>
</tr>
<tr>
<td></td>
<td>component of the backup file that is currently loaded in the tabbed page</td>
</tr>
<tr>
<td></td>
<td>is set to active. It prompts for restoring the application status on the</td>
</tr>
<tr>
<td></td>
<td>device. The user interface is blocked during restore. You can cancel the</td>
</tr>
<tr>
<td></td>
<td>operation.</td>
</tr>
</tbody>
</table>

Table 410: "Target Information"

<table>
<thead>
<tr>
<th>ID</th>
<th>ID of the PLC (example: 0000 0001)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Device type (example: 4096)</td>
</tr>
<tr>
<td>Version</td>
<td>Device version (example: 3.5.8.0)</td>
</tr>
</tbody>
</table>

Table 411: "Backup Information"

<table>
<thead>
<tr>
<th>File name</th>
<th>Storage path of the backup file. Clicking the symbol (file) opens the</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>file system dialog box. Example: PlcLogic$/Application/Application.crc</td>
</tr>
<tr>
<td>Size of active files</td>
<td>(in kilobytes) Total size of the files set as active in the table (example: 206 KB (210965 bytes)).</td>
</tr>
</tbody>
</table>
“Mode” | Defines the scope of the backup: “Application”. The application-related files are added to the archive.

“Comment” | Optional entry for comments to be saved in the meta.info file of the backup and reading when the files are restored.

Table 412: Table of files for backup

| “Active” | Optional files can be deactivated here for exclusion in the backup file. Required components are shown here with a green check mark (no check box). |
| “Component” | Affected components (example: file system) |
| “File” | Name of the component file to back up (example: $PlcLogic$/Application/Application.app) |
| “Size” | File size in bytes (example: 43280) |
| “Requires STOP” | For components, the application must be stopped before backup and restore. A dialog prompt will open to warn you of any backup or restore conflicts. |

See also
- § Chapter 6.4.1.13.9 “Backup and restore” on page 2024

Tab 'Synchronized Files'

The tab of the generic device editor lists the files that are downloaded to the PLC when the application is downloaded. For example, these are external files that were added to an application.

Implicit files, such as the source code archive file, are displayed here only if their time of download is configured for this and the “Show implicit files for application download on the editor of a PLC” option is activated in the CODESYS options (“Device Editor” category).

| “Refresh” | Refreshes the view |
| “Download 'on-demand' files” | For internal use only. |
| “File Name” | Name of the file below the application, or direct name of the implicitly transferred file (example: archive.prj). Double-click the file name to open the file. |
| “Host Path” | Location or original location of the file (example: D:\Proj1\Files). Double-click the path to open the directory in the file explorer. |
| “Timing” | Time interval of the file update on the PLC (example: “After application download/online change”). |
| “Information” | Object-dependent additional information (example: “Object: External File”). |
| “Provider” | General origin type of the file (example: “External File Objects”, “Source code download provider”). |

See also
- § Chapter 6.4.1.21.4.14.7 “Dialog ‘Options’ - ‘Device Editor’” on page 2786
- § Chapter 6.4.1.21.2.10 “Object ‘External File’” on page 2464
Tab 'Files'

In this tab of the generic device editor, you can transfer files between CODESYS (host) and the PLC. If the communication settings are correct and the PLC is online, then CODESYS establishes the connection automatically to the PLC for the duration of the file transfer.

<table>
<thead>
<tr>
<th>Table 413: “Host” / “Runtime”</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access to the file system of the host with the functionalities of a standard file manager</td>
</tr>
<tr>
<td>“Location”</td>
</tr>
<tr>
<td>File icon</td>
</tr>
<tr>
<td>Remove icon</td>
</tr>
<tr>
<td>Update icon</td>
</tr>
<tr>
<td>Copy icon</td>
</tr>
<tr>
<td>The “Write File to Controller” and “Write File from Controller” commands are not included in any menu. You can add it to a menu by means of the “Tools – Customize” dialog, in the “Online” command category.</td>
</tr>
</tbody>
</table>

See also
- Chapter 6.4.1.21.2.8.2 “Generic device editor” on page 2427
- Chapter 6.4.1.15 “Copying files to/from PLC” on page 2027

Tab 'Log'

You can view the PLC log on this tab of the generic device editor. It lists the events that were recorded on the target system. This concerns the following:
- Events during the startup and shutdown of the system (components loaded, with version)
- Application download and loading of the boot application
- Custom entries
- Log entries from I/O drivers
- Log entries from data sources

The “Log” tab also opens when you click “Open Log Page”. You can configure this as a menu command in the “Customize” dialog.

<table>
<thead>
<tr>
<th>Table 414: Menu bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refreshes the list of log events for all runtime system component</td>
</tr>
</tbody>
</table>
“Components” Filters the display of log events by the runtime system components selected in the list box
Example:
CmpApp displays all events which occur in these components, for example
"Application [ <name> ] loaded via [OnlineChange]."
"<all components>“: Displays the reported events of all components

 Loads the next page with newer log messages
 Loads the previous page with older log messages
 Loads the page with the newest log entries and enables automatic scrolling
 Indicates that there are new log messages which have not been displayed yet.
 Hint: This is also displayed on the status bar as “Auto-Scroll: ON”.
 Loads the page with oldest log messages
 Filters events with the severity “Warning” and notifies about how many
 Blue-outlined button: Warnings are displayed.
 Filters events with the severity “Error” and notifies about how many
 Blue-outlined button: Errors are displayed.
 Filters events with the severity “Exception” and notifies about how many
 Blue-outlined button: Exceptions are displayed.
 Filters events with the severity “Information” and notifies about how many
 Blue-outlined button: Information is displayed.
 Filters events with the severity “Debug” and notifies about how many
 Blue-outlined button: Debug messages are displayed.

Logger Enables a logger for displaying its recorded events
By default, the <default logger> defined by the system is set. For example, that is the logger PlcLog for a CODESYS Control Win V3 runtime system.

“UTC time” Converts the times displayed below “Timestamp” to the local time of the development system. The conversion is based on the time zone of the operating system where the CODESYS is running. (default setting)
 Displays the original time stamp of the runtime system
 If you change the option, then the displayed time stamp is converted automatically.

 Exports the list contents to an xml file. You can select the file name and location.
 Imports an XML file with log messages stored in the file system. A separate window opens to display the log messages.

Table 415: Display window with log file
Tabular display of the log messages
Ten thousand log messages are displayed per page.

“Severity”

<table>
<thead>
<tr>
<th>Severity</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warning</td>
<td>![Warning Icon]</td>
</tr>
<tr>
<td>Error</td>
<td>![Error Icon]</td>
</tr>
<tr>
<td>Exception</td>
<td>![Exception Icon]</td>
</tr>
<tr>
<td>Information</td>
<td>![Information Icon]</td>
</tr>
<tr>
<td>Debug message</td>
<td>![Debug Icon]</td>
</tr>
</tbody>
</table>
Table 416: Status bar

| “Auto-Scroll” | Displays whether auto-scrolling is enabled (“ON”) or disabled (“OFF”).
| | Hint: Click the button to enable “Auto-Scroll”.
| | ● “ON”: The log list is refreshed automatically when changes occur.
| | ● “OFF”: When a new log event occurs, it is displayed next to “Off”. Moreover, the button is decorated on the menu bar.

Note for error checking

For exceptions with the description *SOURCEPOSITION*, the affected function opens in the editor by double-clicking it or by means of the “Display Source Code in Editor” command in the context menu. The cursor jumps to the line that is causing the error. You can also perform this diagnosis when you have the CODESYS project archive, including the download information files and the exported log file. When the affected function is protected, then the following message appears: “The source code is not available for <function name>”.

If a VendorException is reported, then a manufacturer-specific exception error has occurred in the CODESYS runtime. Contact the PLC manufacturer for more information.

See also

- Chapter 6.4.1.21.2.8.2 “Generic device editor” on page 2427
- Chapter 6.4.1.21.2.8 “Object ‘Device’ and Generic Device Editor” on page 2427
- Chapter 6.4.1.13.6 “Reading the PLC log” on page 2021
- Chapter 6.4.1.21.4.15.2 “Dialog ‘Customize’ - ‘Menu’” on page 2801

Tab 'PLC Settings'

On this tab of the generic device editor you make the basic settings for the configuration of the PLC, for example the handling of inputs and outputs and the bus cycle task.

| “Application for I/O handling” | Application that is responsible for the I/O handling.
Table 417: “PLC Settings”

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh I/Os in stop</td>
<td>The values of the input and output channels are also refreshed when the PLC is in STOP mode. If the watchdog detects a malfunction, the outputs are set to the predefined default values.</td>
</tr>
</tbody>
</table>
| Behavior of the outputs at stop | Handling of the output channels when the controller enters the stop state:  
  - “Retain values”: The current values are retained.  
  - “All outputs to default value”: The default values resulting from the I/O mapping are assigned.  
  - “Execute program”: You can control the handling of the output values via a program contained in the project, which CODESYS executes at “STOP”. Enter the name of the program in the field on the right. |
| Always update variables  | Global setting that defines whether or not CODESYS updates the I/O variables in the bus cycle task. This setting is effective for I/O variables of the slaves and modules only if 'deactivated' is defined in their update settings.  
  - Deactivated (update only if used in a task): The I/O variables are updated only if they are used in a task.  
  - “Enabled 1 (use bus cycle task if not used in any task)”: CODESYS updates the I/O variables in the bus cycle task if they are not used in any other task.  
  - “Enabled 2 (always in bus cycle task)”: CODESYS updates all variables in each cycle of the bus cycle task, regardless of whether they are used and whether they are mapped to an input or output channel. |

Table 418: “Bus Cycle Options”

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Bus cycle task           | Task that controls the bus cycle. By default the task defined by the device description is entered.  
  By default the bus cycle setting of the superordinate bus device (use cycle settings of the superordinate bus) applies, i.e. the device tree is scanned upwards for the next valid bus cycle task definition. |

NOTICE!

Before you select the “<unspecified>” setting for the bus cycle task, you should be aware that “<unspecified>” means that the default setting given in the device description goes into effects. You should therefore check this description. Use of the task with the shortest cycle time may be defined as the default there, but use of the task with the longest cycle time could equally well be defined!

NOTICE!

For fieldbuses, a fixed cycle matrix is necessary to assure a determined behavior. Therefore, do not use the type 'freewheeling' for a bus cycle task.
Table 419: "Additional Settings"

```
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Force variables for the I/O mapping&quot;</td>
<td>This setting is available only if it is supported by the device.</td>
</tr>
<tr>
<td></td>
<td>☑: When compiling the application CODESYS creates two global variables for each I/O channel that is mapped to a variable in the dialog &quot;I/O Mapping&quot;. You can use these variables for the forcing of the input or output value on this channel, for example via an HMI visualization.</td>
</tr>
<tr>
<td>&quot;Activate diagnostics for devices&quot;</td>
<td>☑: The CAA Device Diagnosis library is integrated in the project. An implicit function block is generated for each device. If there is already a function block for the device, then either an extended function block is generated (example: EtherCAT) or another function block instance is added. This then contains a general implementation of the device diagnostics. By means of the function block instances you can determine the status of all devices in the application and evaluate errors. In addition, the library contains functions for the programmatic editing of the device tree. Example: Scanning of all children of a bus system, jumping to the parent element.</td>
</tr>
<tr>
<td>&quot;Create additional parameters&quot;</td>
<td>This setting is available only if it is supported by the device.</td>
</tr>
<tr>
<td></td>
<td>Create additional parameters.</td>
</tr>
<tr>
<td>&quot;Display I/O warnings as errors&quot;</td>
<td>Warnings concerning the I/O configuration are displayed as errors.</td>
</tr>
<tr>
<td>&quot;Enable symbolic access for I/Os&quot;</td>
<td>☑: Input and output variables (VAR_INPUT and VAR_OUTPUT) are automatically created for the I/O channels of the device. For this purpose, an extended function block is created for each slave. The basis is the existing function block of the slave. This kind of automatically generated function block can be accessed directly in the application code. This symbolic access works in parallel to the I/O mapping which was set up manually. ☑: Access to I/O channels is not supported. It is necessary to manually set up a mapping and specifically assign new or existing variables per I/O channel.</td>
</tr>
</tbody>
</table>

See also
- ☇ Chapter 6.4.1.21.2.8.2 "Generic device editor" on page 2427
- ☇ Chapter 6.4.1.21.2.8.12 "Tab <device name> I/O Mapping" on page 2444
- ☇ Chapter 6.4.1.21.3.6.4 "Command 'Build'" on page 2619
- PDF document 'CAA Device Diagnosis', which is a component of the library.
```

Tab 'PLC Shell'

This tab of the generic device editor includes a text-based control monitor for querying specific information from the controller. You can specify device-dependent commands for this and receive the response from the controller in a result window.

Table 420: ABB AG standard commands

```
<table>
<thead>
<tr>
<th>Command with Possible Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>?</td>
<td>List of available PLC shell commands with possible parameters and short description</td>
</tr>
<tr>
<td>applist</td>
<td>Provides a list of all loaded applications The order in the list defines the application index beginning with 0.</td>
</tr>
<tr>
<td>batt [INFO, ACK]</td>
<td>Get battery status; batt INFO: displays detailed information; batt ACK: acknowledge fail state</td>
</tr>
<tr>
<td>cdump [exp,sdc,rst]</td>
<td>handle logging data in case of crash or malfunction; cdump ? for help</td>
</tr>
</tbody>
</table>
```
<table>
<thead>
<tr>
<th>Command with Possible Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cert-createcsr [&lt;number for search result by &quot;cert-getapplist&quot;&gt;]</td>
<td>Generates CSR files for all applications</td>
</tr>
<tr>
<td>cert-export &lt;trust level&gt; [&lt;number for search result by &quot;cert-getcertlist&quot;&gt;]</td>
<td>Exports the specified certificate</td>
</tr>
<tr>
<td>cert-genselfsigned [&lt;number for search result by &quot;cert-getapplist&quot;&gt; &lt;expdays&gt;]</td>
<td>Generates self-signed certificates</td>
</tr>
<tr>
<td>cert-getapplist</td>
<td>Provides all registered and used certificates (ID of the component and usage).</td>
</tr>
<tr>
<td>cert-getcertlist [&lt;trust level&gt;]</td>
<td>Lists all certificates of the specified trust level</td>
</tr>
<tr>
<td></td>
<td>If a trust level is not given, then all certificates are listed.</td>
</tr>
<tr>
<td></td>
<td>Possible trust levels</td>
</tr>
<tr>
<td></td>
<td>● untrusted: Untrustworthy certificates</td>
</tr>
<tr>
<td></td>
<td>● trusted: Trustworthy certificates</td>
</tr>
<tr>
<td></td>
<td>● own: Certificate of the controller</td>
</tr>
<tr>
<td></td>
<td>● quarantine: Certificates whose trust level (trusted, untrusted) cannot be determined by validation. Incoming connections were therefore denied.</td>
</tr>
<tr>
<td>cert-import &lt;trust level&gt; &lt;filename.cer&gt;</td>
<td>Imports the specified certificate</td>
</tr>
<tr>
<td>cert-remove &lt;trust level&gt; [&lt;number for search result by &quot;cert-getcertlist&quot; or &quot;all&quot;&gt;]</td>
<td>Removes the specified certificate</td>
</tr>
<tr>
<td>channelinfo</td>
<td>Provides information about the communication channel</td>
</tr>
<tr>
<td>clearsram &lt;segment number retrieved by &quot;getsramlayout&quot; or &quot;all&quot;&gt;</td>
<td>Init and mark SRAM segment or complete SRAM as free</td>
</tr>
<tr>
<td>coupler desc</td>
<td>Get version information of communication modules</td>
</tr>
<tr>
<td>com settings</td>
<td>Get information of serial COM ports</td>
</tr>
<tr>
<td>cpuload</td>
<td>Shows the processor load of the CPU (for multicore, each processor core)</td>
</tr>
<tr>
<td>date [yyyy-mm-dd]</td>
<td>Get/set system date; date: get system date; date yyyy-mm-dd: set system date</td>
</tr>
<tr>
<td>ethernet [netstat,desc]</td>
<td>Will show Ethernet information; ethernet ? for help</td>
</tr>
<tr>
<td>getcmdlist</td>
<td>List of names of available PLC shell commands</td>
</tr>
<tr>
<td>getmulticoreinfo</td>
<td>Shows whether or not multicore is supported and the number of available processor cores</td>
</tr>
<tr>
<td>getprgprop [not implemented, yet]'</td>
<td>-</td>
</tr>
<tr>
<td>getprgstat [&lt;application name&gt;</td>
<td>&lt;application index&gt;]</td>
</tr>
<tr>
<td>getsramlayout</td>
<td>Display layout of complete SRAM</td>
</tr>
<tr>
<td>Command with Possible Parameters</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>gettaskgroups</td>
<td>Provides a list of all task groups, their tasks, and the CPU core binding</td>
</tr>
<tr>
<td>gettaskgroups</td>
<td>Provides a list of defined task groups The assigned tasks are shown for each task group.</td>
</tr>
<tr>
<td>gettasks</td>
<td>Get list of all tasks, its name and the optional bound taskgroup</td>
</tr>
<tr>
<td>heapinfo</td>
<td>Print memory usage and heap statistics</td>
</tr>
<tr>
<td>io-bus [stat,desc]</td>
<td>Will show I/O bus information; io-bus ? for help</td>
</tr>
<tr>
<td>license [export,import,required,available,generate]</td>
<td>License handling commands; license ? for help</td>
</tr>
<tr>
<td>pid [&lt;application name&gt;</td>
<td>&lt;application index&gt;]’</td>
</tr>
<tr>
<td>pinf [&lt;application name&gt;</td>
<td>&lt;application index&gt;]’</td>
</tr>
<tr>
<td>plcload</td>
<td>Shows the processor load of the controller (in percent)</td>
</tr>
<tr>
<td>proddata</td>
<td>Get production data and public keys information of CPU</td>
</tr>
<tr>
<td>reboot</td>
<td>Performs PLC reboot</td>
</tr>
<tr>
<td>reflect</td>
<td>Repeats the given command (for testing the connection)</td>
</tr>
<tr>
<td>reload [&lt;application name&gt;</td>
<td>&lt;application index&gt;]’</td>
</tr>
<tr>
<td>resetprg [&lt;application name&gt;</td>
<td>&lt;application index&gt;]’</td>
</tr>
<tr>
<td>resetprgcold [&lt;application name&gt;</td>
<td>&lt;application index&gt;]’</td>
</tr>
<tr>
<td>restoreretains [&lt;application name&gt;]</td>
<td>Restore retains to files(s). [Optional only from specified application].</td>
</tr>
<tr>
<td>restoresram &lt;filename&gt;</td>
<td>Restore complete SRAM content to file</td>
</tr>
<tr>
<td>rtc-get</td>
<td>Provides the universal time (UTC) via the DateTime string</td>
</tr>
<tr>
<td>rtc-set</td>
<td>Sets the universal time (UTC) via the DateTime string (see ISO 8601), required format: &quot;rtc-set YYYY-MM-DDThh:mm:ss[,sss</td>
</tr>
<tr>
<td>rtsinfo</td>
<td>Provides information about the runtime system, for example the processor and version of the runtime system</td>
</tr>
<tr>
<td>safestopinfo &lt;slot&gt;</td>
<td>Get version errors from DPRAM from communication module &lt;slot&gt;</td>
</tr>
<tr>
<td>saveretains [&lt;application name&gt;]</td>
<td>Save retains to files(s). [Optional only from specified application].</td>
</tr>
<tr>
<td>savesram &lt;filename&gt;</td>
<td>Save complete SRAM content to file</td>
</tr>
<tr>
<td>sdclone &lt;slot&gt;</td>
<td>Clone content of SM560-s at slot &lt;slot&gt;</td>
</tr>
<tr>
<td>sessinfo-getcnt</td>
<td>Provides the number of currently logged in clients/users</td>
</tr>
<tr>
<td>sessinfo-list</td>
<td>Provides a list of all currently logged in clients/users</td>
</tr>
<tr>
<td>showsecuritysettings</td>
<td>Show the list of all security settings and the current configuration</td>
</tr>
<tr>
<td>sram</td>
<td>Export or import data from SRAM</td>
</tr>
<tr>
<td>startprg [&lt;application name&gt;</td>
<td>&lt;application index&gt;]’</td>
</tr>
</tbody>
</table>
### Command with Possible Parameters

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>`stopprg [&lt;application name&gt;</td>
<td>&lt;application index&gt;]`</td>
</tr>
<tr>
<td><code>time [hh:mm:ss]</code></td>
<td>Get/set system time; <code>time</code> to get system time; <code>time hh:mm:ss</code> to set system time</td>
</tr>
<tr>
<td><code>trenddatastore</code></td>
<td>Configure location of the trend DB, reboot of CPU and download is required</td>
</tr>
<tr>
<td><code>versioninfo</code></td>
<td>Get version information on AC500 components</td>
</tr>
</tbody>
</table>

* Application name: Name of the application in the device tree
* Application index: Results from the list of all applications on the controller that you can call with the “applist” command. Index 0 stands for the first application in the list, 1 for the second, and so on.

See also
- Chapter 6.4.1.13.7 “Using PLC shell for requesting information” on page 2022
- Chapter 6.4.1.21.2.8.2 “Generic device editor” on page 2427
- Chapter 6.4.1.21.3.5.13 “Command ‘Project information’” on page 2604

### Tab ‘<device name> I/O Mapping’

#### Devices with I/O channels

This tab is displayed in device editors for devices with I/O channels. It shows the available channels and allows for the mapping of input, output, and memory addresses of the controller to variables or entire function blocks of the application. In this way, you create the ‘I/O Mapping’.

The application that is to take care of the I/O handling is defined on the “PLC Settings” tab.

You can use the "Online Configuration Mode" if the device supports it. In this mode, you can access the I/Os of the hardware without having to download an actual application to the device beforehand.

You can also create the I/O mapping in the “Edit I/O Mapping” dialog. Here you get a mapping list with search and filter functions for an entire device tree.

**NOTICE!**

Mapping 'too large' data types

If a variable of a data type that is larger than a byte is mapped to a byte address, the value of the variable will be truncated to byte size there. For monitoring the variable value in the “I/O Mapping” dialog, this means that, in the root element of the address, the value is displayed which the variable currently has in the project. The current individual bit values of the byte are displayed in succession in the bit elements below that, but this may not be sufficient for the entire variable value.

Example of the “<device name> I/O Mapping” tab for a CAN bus slave:
The tab contains a table for editing the I/O mapping. The information displayed for the inputs and outputs originates from the device description.

| “Find” (1) | Input field for a search string for the mapping table. The search results are marked in yellow. |
| “Filter” (2) | List box with filters for the I/O mappings displayed in the mapping table:  
  ● “Show all”  
  ● “Show only outputs”  
  ● “Show only inputs”  
  ● “Show only unmapped variables”  
  ● “Show only mapped variables”  
  ● “Show only mapping to existing variables”  
  ● “Show only mapping to new variables” |
| “Add FB for IO channel” (11) | Depending on the device, available if the channel entry is selected in the mapping table. Opens the “Select Function Block” dialog for selecting the function block that should be linked directly to the channel. |
| “Go to instance” (12) | Available if the entry is selected in the mapping table. Jumps to the corresponding entry on the “<device name> IEC Objects” tab. |
### “Variable”

Depending on the device, the inputs and outputs of the device are displayed as nodes and below them, indented, the associated channels or, depending on the device, only the implicitly created device instance.

The symbol indicates the type of channel:

- 🕵️: Input
- 🕵️️: Output

Double-click the cell to open an input field.

- Option 1: The variable already exists; specify complete path: `<application name>.<module name>.<variable name>`; example: `app1.plc_prd.ivar`; input assistance via [x].
- Option 2: The variable does not exist yet; enter a simple name; automatically created internally as a global variable.

Depending on the device, inputs or outputs can be linked directly to a function block. In this case, the 🕵️ “Add FB for IO channel” button can be clicked. See above.

### “Mapping” (3)

Type of mapping:

- 🕵️: Existing variable
- 🕵️️: New variable
- 🕵️️️: Mapping to function block instance

### “Channel” (4)

Symbolic name of the channel.

### “Address” (5)

Address of the channel (example: `%IW0`).

Address strikethrough: Indicates that you should not assign any more variables to this address. Reason: Although the variable specified here is managed – as an existing variable – at a different memory location, ambiguity could result when the values are written, particularly with outputs.

- 🕵️: Indicates that this address has been edited and fixed. If the arrangement of the device objects in the device tree changes, then CODESYS does not adapt this address automatically.

### “Type” (6)

Data type of the channel (example: `BOOL`).

Structures or bit fields defined in the device description are displayed only if they are part of the IEC standard and are identified as IEC data types in the device description. Otherwise the table cell remains empty.

When mapping structured variables, the editor prevents you from specifying both the structure variable (example: `%QB0`) and individual structure elements (example: `%QB0.1` and `%QB0.2`). Therefore, if there is a main entry with a subtree of bit channel entries in the mapping table, then the following applies: You can input a variable either into the line of the main entry, or into the lines of the subelements (bit channels), but not into both.

### “Default value”

Default value of the parameter that applies to the channel: Appears only if the option “Set all outputs to default” is selected in the “PLC Settings” for the behavior of the outputs at stop.

Note: For compiler version V3.5 SP11 and higher, the initialization value of the variables is used automatically as the default value when mapping to an existing variable. You can edit the “Default value” field only if you map to a new created variable or if no mapping is specified. In older versions, users had to specify explicitly that the default value and initialization value were identical.

### “Unit” (7)

Unit for the parameter value (example: `ms` for milliseconds).

### “Description” (8)

Short description of the parameter.

### “Current value”

Actual value of the parameter applied to the channel; displayed in online mode only.
The change of the default value by an online change is allowed, however the value is applied only after a "Reset cold" or "Reset warm".

<table>
<thead>
<tr>
<th>“Reset Mapping” (9)</th>
<th>CODESYS resets the mapping settings to the default values as defined in the device description file.</th>
</tr>
</thead>
</table>
| “Always update variables” (10) | Definition for the device object about updating I/O variables. The default value is defined in the device description:  
   - “Use parent device setting”: Update according to the setting of the superordinate device.  
   - “Enabled 1 (use bus cycle task if not used in any task)”: CODESYS updates the I/O variables in the bus cycle task if they are not used in any other task.  
   - “Enabled 2 (always in bus cycle task)”: CODESYS updates all variables in each cycle of the bus cycle task, regardless of whether they are used and whether they are mapped to an input or output channel. |

If a UNION is represented by I/O channels in the mapping dialog, it depends on the device whether mapping to the root element is also possible.

Devices with I/O drivers  
For devices with I/O drivers, you can set the bus cycle task here in the “I/O Mapping” tab if the general settings should not be used (“PLC Settings” tab).

Table 421: Bus Cycle Options

| “Bus Cycle Task” | The list box provides all tasks which are defined in the task configuration of the active application (example: “MainTask”. In case of “Use parent bus cycle setting”, the settings of the parent node will be used. |

General information about the bus cycle task  
Generally, for each IEC task, the used input data is read at the start of each task (1) and the written output data is transferred to the I/O driver at the end of the task (3). The implementation in the I/O driver is decisive for additional transfer of the I/O data. It is responsible for the time frame and time point that the actual transfer to the corresponding bus system occurs.

The bus cycle task of the PLC can be defined globally for all fieldbuses in the PLC settings. For some fieldbuses, however, you can change this independent of the global setting. The task with the shortest cycle time is used as the bus cycle task (setting: “unspecified” in the PLC settings). The messages are normally sent on the bus in this task.

Other tasks copy only the I/O data from an internal buffer that is exchanged only with the physical hardware in the bus cycle task.
Task usage

The “Task Deployment” tab provides an overview of used I/O channels, the set bus cycle task, and the usage of channels.

WARNING!

If an output is written in various tasks, then the status is undefined, as this can be overwritten in each case.

If the same inputs are used in various tasks, then it is possible for the input to change during the processing of a task. This happens when the task is interrupted by a task with a higher priority and causes the process image to be read again. Solution: At the beginning of the IEC task, copy the input variables to variables and then work only with the local variables in the rest of the code.

Conclusion: Using the same inputs and outputs in several tasks does not make any sense and can lead to unexpected reactions in some cases.

See also

- Chapter 6.4.1.8.2 “Configuring Devices and I/O Mapping” on page 1836
- Chapter 6.4.1.21.2.8.2 “Generic device editor” on page 2427
- Chapter 6.4.1.21.3.5.35 “Command ‘Edit I/O Mapping’” on page 2615
- Chapter 6.4.1.21.2.8.13 “Tab <device name> IEC Objects” on page 2449
- Chapter 6.4.1.21.4.4 “Dialog ‘Select Function Block’” on page 2746
- Chapter 6.4.1.21.3.5.39 “Command ‘Online Config Mode’” on page 2616
- Chapter 6.4.1.21.2.8.10 “Tab ‘PLC Settings’” on page 2439
Tab '<device name> IEC Objects'

NOTICE!
Please note that manually creating another instance of the device object can lead to malfunctions.

In this tab of the generic device editor, "objects" are listed that allow for access to the device from the IEC application. In online mode, this is used as the monitoring view.

For devices for which a function block instance is created implicitly, at least this instance is listed as an object here in the table. This instance can be used, for example, in order to restart a bus or to query information from the application. The device type determines whether this kind of device instance is available and which access options it has. Please refer to the help for the special device configuration.

Instances of function blocks that are linked with inputs or outputs of the device are also displayed here. The mapping of a function block to a channel is defined in the "<device name> I/O Mapping" tab. The "Go to Instance" command takes you directly to the affected object from there.

In addition, you can create more objects in the table here that are not yet linked with a device channel.

In online mode, you can use the table of IEC objects as a monitoring view. It also shows the current value, the address, and the comment for the function block variable at the channel. Finally, it provides the capability of writing and forcing values.

<table>
<thead>
<tr>
<th>“Add”</th>
<th>“Edit”</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opens the “Select Function Block” dialog for creating a new instance or for editing the instance selected in the table.</td>
<td></td>
</tr>
</tbody>
</table>

| “Delete” |
| Deletes the selected entry. |

| “Go to Variable” |
| Jumps from the selected entry directly to the corresponding mapping in the "<device name> I/O Mapping" tab. |

| “Variable” |
| The object name comprises the device name and the function block name. Example: EL2004_Relay. Changing the device name has an immediate effect. The part of the name after the device name is editable here. |

| “Mapping” |
| Mapping type, as in the "<device name> I/O Mapping" tab |

| “Type” |
| Data type: Here it is the name of the function block. |

| “Value” |
| "Prepared value” |
| “Address” |
| “Comment” |
| In online mode only: Display of the current value, the address, and the comment for the variable at the channel. Moreover, the option of specifying a value for writing or forcing the variable. |

See also

- Chapter 6.4.1.21.2.8.12 "Tab '<device name> I/O Mapping’" on page 2444
Tab 'Users and Groups'

**NOTICE!**

**Recommendations regarding data security**

In order to minimize the risk of data security violations, we recommend the following organizational and technical actions for the system where your applications are running. Whenever possible, avoid exposing the PLC and control networks to open networks and the Internet. Use additional data link layers for protection, such as a VPN for teleaccess, and install firewall mechanisms. Restrict access to authorized persons only, and change any existing default passwords during the initial commissioning, and change them regularly.

On this tab of the generic device editor, you edit the device user management of the PLC. Depending on how it is supported by the device, you can define user accounts and user groups. In combination with the configuration on the "Access Rights" tab, you thus control access to control objects and files at runtime.

Requirements: The controller has a user management and allows it to be edited. You have login data in order to be able to log in to the controller.

It is possible to apply user account definitions from the project user management into the device user management (see below: “Import” button).
Table 422: Toolbar of the tab

- **Synchronization**: Switches on and off the synchronization between the editor and the user management on the device.
  - If the button is not pressed, then the editor is blank or it contains a configuration that you loaded from the hard disk.
  - When the button is pressed, CODESYS synchronizes the display in the editor continuously with the current user management on the connected device.
  - When you enable the synchronization while the editor contains a user configuration that is not synchronized with the device yet, you are prompted what should happen to the editor contents. Options:
    - **“Upload from the device and overwrite the editor content”**: The configuration on the device is loaded into the editor, overwriting the current contents.
    - **“Download the editor content to the device and overwrite the user management there”**: The configuration in the editor is transferred to the device and applied there.

- **Import from disk**: CAUTION: The import of a device user management by means of a *.dum2 file completely overwrites the existing user management on the device. In order to log in to the device again afterwards, you need authentication data from the new user management. This means that you have to log in as a user from the imported user management after the import.
  - When you click the button on the “Users and Groups” tab to import a “Device user management file *.dum2”, the default dialog for selecting a file opens to select a device user management file from the hard drive. After you select the file, the “Enter Password” dialog opens. You have to specify the password that was assigned when the file was exported. Then the user management is enabled.
  - Note: Before V3.5 SP16, the “Device user management files (*.dum)” file type was used which did not require any encryption.

- **Export to disk**: When you click the button on the “Users and Groups” tab, first the “Enter Password” dialog opens for assigning a password to the device user management file. Note: This password has to be repeated later when this file is imported to enable this user management on the controller.
  - After the password assignment dialog is closed, the default dialog for selecting and importing a user management configuration from the hard drive opens. In this case, the file type is “Device user management files (*.dum)”. Note: Before V3.5 SP16, the “Device user management files (*.dum)” file type was used which did not require any encryption.
  - When you click the button on the “Access Rights” tab, the file type is “Device rights management files (*.drm)”. In this case, a password does not have to be assigned for the file before saving.

Table 423: “User”

- **Add**: Opens the “Add User” dialog for creating a new user account.
- **Import**: Opens the “Import User” dialog. It displays all the user accounts defined in the project user management.
  - Select the desired entries and click “OK” in order to import them into the device user management. CAUTION: The passwords are NOT applied.
<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Edit”</td>
<td>Opens the “Edit User &lt;user name&gt;” dialog. It corresponds to the “Add User” dialog and you can change the settings of the user account.</td>
</tr>
<tr>
<td>“Delete”</td>
<td>Deletes the account of the currently selected user.</td>
</tr>
</tbody>
</table>

Table 424: “Groups”

All currently defined groups, and below them the users assigned to them, are listed in a tree structure.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Add”</td>
<td>Opens the “Add Group” dialog. Define a new group name. From the list of defined users, select those that are to belong to the group. Click “OK” to confirm the selection. The group is displayed in the tree.</td>
</tr>
<tr>
<td>“Import”</td>
<td>Opens the “Import User” dialog. It displays all the user groups defined in the project user management. Select the desired entries and click “OK” in order to import them into the device user management.</td>
</tr>
<tr>
<td>“Edit”</td>
<td>Opens the “Edit Group &lt;group name&gt;” dialog. It corresponds to the “Add Group” dialog where you can change the group definition.</td>
</tr>
<tr>
<td>“Delete”</td>
<td>Deletes the currently selected group.</td>
</tr>
</tbody>
</table>

Table 425: “Add Dialog ’Add User’”

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Name”</td>
<td>Name of the new user</td>
</tr>
<tr>
<td>“Default group”</td>
<td>List box with all configured user groups. Every user has to belong to at least one group. You define this here as a default group.</td>
</tr>
<tr>
<td>“Password”</td>
<td></td>
</tr>
<tr>
<td>“Confirm password”</td>
<td></td>
</tr>
<tr>
<td>“Password strength”</td>
<td>Password security in a range from “Very weak” to “Very good”.</td>
</tr>
<tr>
<td>“Hide password”</td>
<td>☑: The password is shown only with asterisks “*” when it is typed in.</td>
</tr>
<tr>
<td>“Password can be changed by the user”</td>
<td></td>
</tr>
<tr>
<td>“Password must be changed at first login”</td>
<td></td>
</tr>
</tbody>
</table>

See also
- Chapter 6.4.1.21.2.8 “Object ‘Device’ and Generic Device Editor” on page 2427
- Chapter 6.4.1.21.2.8.2 “Generic device editor” on page 2427
- Chapter 6.4.1.11.4 “Handling of Device User Management” on page 1971
- Chapter 6.4.1.21.2.8.15 “Tab ‘Access Rights’” on page 2453
- Chapter 6.4.1.21.3.7.16 “Command ‘Add Device User’” on page 2637
Tab 'Access Rights'

NOTICE!
Recommendations regarding data security
- In order to minimize the risk of data security violations, we recommend the following organizational and technical actions for the system where your applications are running. Whenever possible, avoid exposing the PLC and control networks to open networks and the Internet. Use additional data link layers for protection, such as a VPN for teleaccess, and install firewall mechanisms. Restrict access to authorized persons only, and change any existing default passwords during the initial commissioning, and change them regularly.

NOTICE!
Detailed information on the concept and use of device user management is provided in "Handling of Device User Management". There you will also find the following instructions on how to use the editor:
- First-time login to the controller for editing and viewing its user management
- Setting up a new user in the user management of the controller
- Changing of access rights to controller objects in the user management of the controller
- Loading user management from a *.dum file, modifying it, and downloading it to the controller in offline mode

On this tab of the device editor, you define the device access rights of device users to objects on the controller. As in the project user management, users must be members of at least one user group and only user groups can be granted certain access rights.

Requirements for the “Access Rights” tab to be displayed:
- In the CODESYS options, in the "Device Editor" category, the "Show access rights page" option has to be selected.
  Note that this CODESYS option can be overwritten by the device description.

Requirements for the access rights to be granted to user groups
- A component for the user management has to be available on the controller. That is the primary requirement.
- Users and user groups have to be configured on the "Users and Groups" tab.
### Table 426: Toolbar of the tab

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Synchronization" /></td>
<td>Switches on and off the synchronization between the editor and the user management on the device. If the button is not pressed, then the editor is blank or it contains a configuration that you loaded from the hard disk. When the button is pressed, CODESYS synchronizes the display in the editor continuously with the current user management on the connected device. When you enable the synchronization while the editor contains a user configuration that is not synchronized with the device yet, you are prompted what should happen to the editor contents. Options:</td>
</tr>
<tr>
<td><img src="image" alt="Import from disk" /></td>
<td>CAUTION: The import of a device user management by means of a *.dum2 file completely overwrites the existing user management on the device. In order to log in to the device again afterwards, you need authentication data from the new user management. This means that you have to log in as a user from the imported user management after the import.</td>
</tr>
<tr>
<td><img src="image" alt="Export to disk" /></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Device user" /></td>
<td>User name of the user currently logged in on the device</td>
</tr>
</tbody>
</table>

- **“Upload from the device and overwrite the editor content”**: The configuration on the device is loaded into the editor, overwriting the current contents.
- **“Download the editor content to the device and overwrite the user management there”**: The configuration in the editor is transferred to the device and applied there.

CAUTION: The import of a device user management by means of a *.dum2 file completely overwrites the existing user management on the device. In order to log in to the device again afterwards, you need authentication data from the new user management. This means that you have to log in as a user from the imported user management after the import.

- When you click the button on the “Users and Groups” tab to import a “Device user management file *.dum2”, the default dialog for selecting a file opens to select a device user management file from the hard drive. After you select the file, the “Enter Password” dialog opens. You have to specify the password that was assigned when the file was exported. Then the user management is enabled.
  
  Note: Before V3.5 SP16, the “Device user management files (*.dum)” file type was used which did not require any encryption.

- When you click the button on the “Access Rights” tab to import a “Device rights management file *.drm”, the default dialog for selecting a file opens to select a corresponding file from the hard drive. The existing configuration in the dialog is overwritten by the imported file.

- When you click the button on the “Users and Groups” tab, first the “Enter Password” dialog opens for assigning a password to the device user management file. Note: This password has to be repeated later when this file is imported to enable this user management on the controller. After the password assignment dialog is closed, the default dialog for selecting and importing a user management configuration from the hard disk opens. In this case, the file type is “Device user management files (*.dum2)”. Note: Before V3.5 SP16, the “Device user management files (*.dum)” file type was used which did not require any encryption.

- When you click the button on the “Access Rights” tab, the file type is “Device rights management files (*.drm)”. In this case, a password does not have to be assigned for the file before saving.
Table 427: “Objects”

In the tree structure, the objects are listed to which actions can be executed at runtime. The objects are each assigned by their object source and partially sorted in object groups. In the “Rights” view, you can configure the access options for a user group to a selected object.

<table>
<thead>
<tr>
<th>Object source (root node)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“File system objects → Device”: In these objects, the rights can be granted to folders of the current execution directory of the controller.</td>
<td></td>
</tr>
<tr>
<td>“Runtime objects → /”: In these objects, all objects are managed that have online access in the controller and therefore have to control the access rights.</td>
<td></td>
</tr>
</tbody>
</table>

A description of the objects is located in the table. “Overview of the objects” on page 2457

<table>
<thead>
<tr>
<th>Object groups and objects (indented)</th>
</tr>
</thead>
</table>
In general, the access rights are inherited from the root object (also “Device” or “/”) to the subobjects. This means that if a permission of a user group is denied or explicitly granted to a parent object, then this first affects all child objects.

The table applies for the object that is currently selected in the tree. For every user group, it shows the rights currently configured for the possible actions on this object.

Possible actions on the object:

- “Add/Remove”
- “Modify”
- “View”
- “Execute”

When an object is clicked, a table on the right side shows the access rights of the available user groups for the selected object.

This allows you to quickly see:

- Which access rights are evaluated by an object
- Which user group has which effective rights to which object

Meanings of the symbols

- : Access right granted explicitly
- : Access right denied explicitly
- : Access right granted through inheritance
- : Access right denied through inheritance
- : The access right was not granted or denied explicitly and also not inherited by the parent object. Access is not possible.
- No symbol: Multiple objects are selected that have different access rights.

Change the permission by clicking the symbol.
The "Logger" object on the "Access Rights" tab was created by the "Logger" component and controls its access rights. It is located directly below the "Device" runtime object.

The possible access rights for this object can be granted only for the "View" action.

Initially, each object has a read access. This means that every user can read the "Logger" of a controller. If this access right should be denied for a single user group ("Service" in the example), then the read access to the logger object has to be denied explicitly.

Example

<table>
<thead>
<tr>
<th>&quot;Runtime objects&quot;</th>
<th>&quot;Device&quot;</th>
<th>&quot;Add/Remove&quot;</th>
<th>&quot;Modify&quot;</th>
<th>&quot;View&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Logger&quot;</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;PlcLogic&quot;</td>
<td>All IEC applications are inserted here automatically as child objects during download. When an application is deleted, it is removed automatically. This allows specific control of online access to the application. Access rights can be assigned centrally over all applications in the &quot;PlcLogic.&quot; The &quot;Administrator&quot; and &quot;Developer&quot; user groups have full access to the IEC applications. The &quot;Service&quot; and &quot;Watch&quot; user groups only have read access (for example for read-only monitoring of values).</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The following table shows which action is affected in particular when a specific access right is granted for an IEC application.

<table>
<thead>
<tr>
<th>&quot;Application&quot;</th>
<th>&quot;Operation&quot;</th>
<th>&quot;Add/ Remove&quot;</th>
<th>&quot;Execute&quot;</th>
<th>&quot;Modify&quot;</th>
<th>&quot;View&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login</td>
<td></td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>x</td>
</tr>
<tr>
<td>Create</td>
<td></td>
<td>x</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Create child object</td>
<td></td>
<td>x</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Delete</td>
<td></td>
<td>x</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Download / online change</td>
<td></td>
<td>x</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Create Boot Application</td>
<td></td>
<td>x</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

x : The right has to be set explicitly.

- : The right is not relevant.
<table>
<thead>
<tr>
<th>Operation</th>
<th>Read variable</th>
<th>Write Variable</th>
<th>Force variable</th>
<th>Set and delete breakpoint</th>
<th>Set Next Statement</th>
<th>Read call stack</th>
<th>Single cycle</th>
<th>Switch on flow control</th>
<th>Start / Stop</th>
<th>Reset</th>
<th>Restore retain variables</th>
<th>Save retain variables</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>x</td>
<td>x</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

"PlcShell" Only the “Modify” permission is evaluated at this time. This means that only when the “Modify” permission has been granted to a user group can PLC shell commands also be evaluated.

"RemoteConnections" Additional external connections to the controller can be configured below this node. Currently, access to the CODESYS OPC UA server can be configured here.

"Settings" This is the online access to the configuration settings of a controller. By default, access to “Modify” is granted only to the administrator.

"UserManagement" This is the online access to the user management of a controller. By default, read/write access is granted only to the administrator.

"X509" This controls the online access to the X.509 certificates. Two types of access are distinguished here:
- Read (“View”)
- Write (“Modify”)
Every operation is assigned to one of these two access rights. Each operation is inserted as a child object below X509. Therefore, access per operation can now be fine-tuned even more.

"File system objects ➔ /")
All folders from the execution path of the controller are inserted below the ""/"" file system object. This allows you to grant specific rights to each folder of the file system.

See also
- Chapter 6.4.1.11.4 "Handling of Device User Management" on page 1971
- Chapter 6.4.1.21.2.8.2 "Generic device editor" on page 2427
- Chapter 6.4.1.21.2.8.14 "Tab 'Users and Groups'" on page 2450

Tab 'Symbol Rights'
In this tab of the generic device editor, you define the access rights of different user groups (clients) to the individual symbol sets available on the controller.
Requirement: User management must be set up on the PLC. An application was downloaded to the controller for which symbol sets were defined in the CODESYS project. They have access data for logging in to the controller.

In the “Symbol Sets” view, all symbol sets are listed below the “Application” node whose definition was downloaded with the application to the controller.

In the “Rights” view, the user groups defined in the user management of the controller are listed in a table. When a symbol set is selected, you see the access rights of the corresponding user group to the symbols of this set. Access granted; Access not granted. You can change the access rights by double-clicking the symbol.

Click the button to save the current access configuration to an XML file The file type is “Device symbol management files (*.dsm)”. Click the button to read a file like this from the hard drive.

See also
- “Creating symbol sets with different access rights for different control clients” on page 1943
- Chapter 6.4.1.21.2.8.2 “Generic device editor” on page 2427
- Chapter 6.4.1.21.2.8.15 “Tab 'Access Rights'” on page 2453
- Chapter 6.4.1.21.2.8.14 “Tab 'Users and Groups'” on page 2450

Tab 'Licensed Software Metrics'

The tab of the device editor displays the code sizes of the applications of the open project in a tree structure. The display is refreshed when you click "Build ➔ Generate Code" or "Online ➔ Login" for the active application. When the compile information is deleted, the displayed code size of the corresponding application is reset.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Applications of the open project</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Size”</td>
<td>“Size of User Code”: Sum of the displayed code sizes of the applications listed below</td>
</tr>
<tr>
<td></td>
<td>Code size of the respective application</td>
</tr>
<tr>
<td>“Unit”</td>
<td>Unit in which the “Size” is displayed</td>
</tr>
<tr>
<td>“Max. Allowed”</td>
<td>Not implemented yet</td>
</tr>
</tbody>
</table>

Tab 'Task deployment'

This sub-dialog box of the device editor displays a table of inputs and outputs as well as their assignment to the defined tasks.

The information only becomes visible after code has been generated for the application. It is used for troubleshooting, because it shows where inputs or outputs are used in several tasks with different priorities. Multiple use can lead to undefined values through overwriting.
Table 429: “I/O Deployment for Tasks” (1)

<table>
<thead>
<tr>
<th>I/O Channels” (2)</th>
<th>All inputs and outputs of the linked devices. The display corresponds to that in the dialog box “I/O Mapping” of the device editor. By double-clicking on an input or output you can open the associated I/O mapping editor.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“&lt;task name&gt;” (3)</td>
<td>A column appears for every task defined in the task configuration. The title contains the task name and priority. The priority of the tasks decreases from first to the last column. A red cross appears in the box for inputs and outputs that are written or read by a task: [X]. In addition, the task defined as a “Bus cycle task” in the “PLC Settings” of the device editor is marked at these points with a blue double arrow symbol [ ]. Following a mouse-click on the title cell, only the I/Os assigned to this task are displayed. Following a mouse-click on the “I/O Channels” cell, all channels are shown again.</td>
</tr>
</tbody>
</table>

See also
- Chapter 6.4.1.21.2.8.2 “Generic device editor” on page 2427
- Chapter 6.4.1.21.2.8.12 “Tab <device name> I/O Mapping” on page 2444
- Chapter 6.4.1.21.2.8.10 “Tab ‘PLC Settings’” on page 2439
- Chapter 6.4.1.9.17.2 “Creating a task configuration” on page 1914

Tab 'Status'

This tab of the generic device editor displays status information, for example 'Running' or 'Stopped', and specific diagnostic messages from the respective device, also information about the card used and the internal bus system.

See also
- Chapter 6.4.1.21.2.8.2 “Generic device editor” on page 2427

Tab 'Information'

This tab of the generic device editor displays general information that originates from the device description file: name, vendor, categories, version, order number, description, if necessary an illustration.
Object 'DUT'

Symbol:

- 🎨 for a DUT without text list support
- 📚 for an enumeration data type with text list support

A DUT (Data Unit Type) declares a user-specific data type. You can add this kind of object below the application or in the “POUs” view. When the object is created, the “Add DUT” dialog opens. There you select among the “Structure”, “Enumeration”, “Alias”, or “Union” data types.

Moreover, enumerations can have a text list stored to localize the enumeration values. Then the object also has a localization view.

Syntax

```
TYPE <identifier> : <data type declaration with optional initialization>
END_TYPE
```

How the data type declaration has to be done syntactically depends in detail on the selected data type.
Examples

**Declaration of a structure**

```plaintext
TYPE S_POLYGONLINE :
  STRUCT
    aiStart : ARRAY[1..2] OF INT := [-99, -99];
    aiPoint1 : ARRAY[1..2] OF INT;
    aiPoint2 : ARRAY[1..2] OF INT;
    aiPoint3 : ARRAY[1..2] OF INT;
    aiPoint4 : ARRAY[1..2] OF INT;
    aiEnd : ARRAY[1..2] OF INT := [99, 99];
  END_STRUCT
END_TYPE
```

**Extension of a structure**

```plaintext
TYPE S_PENTAGON EXTENDS S_POLYGONLINE :
  STRUCT
    aiPoint5 : ARRAY[1..2] OF INT;
  END_STRUCT
END_TYPE
```

**Declaration of an enumeration**

```plaintext
{attribute 'qualified_only'}
{attribute 'strict'}
TYPE E_TRAFFICSIGNAL :
{eRed,
  eYellow,
  eGreen := 10
};
END_TYPE
```

**Enumeration with text list support in the localization view**

The "Textual View" and "Localization View" buttons are located on the right edge of the editor. Click the buttons to toggle between the views.

**Declaration of an alias**

```plaintext
TYPE A_MESSAGE : STRING[50];
END_TYPE
```

**Declaration of a union of components with different data types**

```plaintext
TYPE U_DATA :
  UNION
    lrA : LREAL;
    liA : LINT;
    dwA : DWORD;
  END_UNION
END_TYPE
```

**Dialog 'Add DUT' Function:** The dialog is used to configure a new DUT (Data Unit Type).

**Call:** Menu bar: "Project ➔ Add Object ➔ DUT"; context menu of the application object.
| **Name** | Name of the new DUT data type  
**Example**: S_POLYGONLINE |
|---|---|

**Table 430: “Type”**

| **Structure** | Creates an object which declares a structure that combines multiple variables with different data types into a logical unit. The variables declared within the structure are called members.  
**Example**: S_POLYGONLINE |
| **Extends** | ☑: Extends an existing structure by more members. In the input field, specify an existing structure. The members of the existing structure are automatically available in the new structure.  
**Example**: S_PENTAGON |
| **Enumeration** | Creates an object which declares an enumeration that combines multiple integer constants into a logical unit. The constants declared within an enumeration are also called enumeration values.  
**Example**: E_TRAFFICSIGNAL |
| **Add Text List Support** | ☐: Enumeration that does not have any text list support  
☑: Enumeration with additionally stored text list for the enumeration values. The text list allows you to localize the names of the enumeration values.  
**Example**: ETL_TRAFFICSIGNAL |

Note: In the case of an existing enumeration type, text list support can be added or removed at any time. As a result, the “Add Text List Support” and “Remove Text List Support” commands are provided in the context menu of the object.

Hint: The localized texts can be displayed, for example, in a visualization. In this case, the text output of a visualization element displays the symbolic enumeration values in the current language instead of the numeric enumeration values. When an enumeration with text list support is specified in the “Text variable” property of a visualization element, it gets the additional property `<<enumeration name>> >`.  
**Example**: In a visualization, you use the variable PLC_PRG.eTrafficLight of type ETL_TRAFFICSIGNAL. ETL_TRAFFICSIGNAL is an enumeration with text list support. Then the entry in the properties editor of the visualization element looks like this: PLC_PRG.eTrafficLight <ETL_TRAFFICSIGNAL>.  
Hint: When you edit the enumeration type in the application, a prompt opens when you close the application and asks whether the affected visualizations should be updated automatically.  
See also: Help for "Enumerations" with information about the declaration syntax |

| **Alias** | Creates an object which declares an alias with which an alternative name is declared for a base type, data type, or function block |
| **Union** | Creates an object which declares a union that combines multiple members with mostly different data types into a logical unit.  
All members have the same offset so that they are occupy the same memory. The memory requirement of a union is determined by the memory requirement of its “largest” component. |
| **Add** | Closes the dialog and creates the new object  
The object is displayed with the symbol in the device tree or in the “POUs” view. When a text list is also stored for the object, the symbol is displayed. |
Object 'External File'

An “External File” is any file that you add to the project in the “POUs” view or “Devices” view. Click “Project → Add Object” to open the “Add External File” dialog and define how the file belongs to the project.

An external file which was inserted in the “POUs” view is never downloaded to the controller.

An external file which was added in the “Devices” view is always downloaded to the controller when an online change or a download is performed due to an IEC code change.

When an external file is downloaded to the controller, it is not updated in the project.

Dialog 'Add External File'

| “File path” | The button opens a dialog for selecting a file in the local file system. |
| “Name” | Object name for the file in CODESYS. If you do not type anything, the file will have its previous name. |

Table 431: “File Handling”

| “Remember the link” | The file is available in the project only as long as it exists in the defined file path. |
| “Remember the link and embed into project” | CODESYS saves an internal copy of the file in the project, as well as the link to the defined file path. The update option selected below applies as long as the external file exists there. Otherwise CODESYS uses the version saved in the project. |
| “Embed into project” | CODESYS saves only one copy of the file in the project. There is no longer a link to the external file. |

Table 432: “Change Tracking”

| “Reload the file automatically” | If the external file changes, then CODESYS updates the file in the project. |
| “Prompt whether to reload the file” | If the external file changes, then a dialog prompt opens whether CODESYS should also update the file in the project. |
| “Do nothing” | The file remains unchanged in the project, even if the external file changes. |

| “Display File Properties” | Clicking this button opens the default “Properties of <file name>” dialog, which you can also open in the Windows file system by right-clicking the file. |
| “Open” | The file object is inserted into the device tree (“Devices” or “POUs” view) and opened in the editor for the matching file format. |
Object 'GlobalTextList'

Symbol: 

This object is for the management and translation of texts that are written as static text in visualizations in the project. It contains a table with these texts. If you write a text in a visualization in an element under the property "Texts", CODESYS automatically adds a line in the table. You cannot write any new text here, you can only edit an existing text.

In addition CODESYS makes the following commands available, in order to consolidate the "GlobalTextList":

- "Check Visualization Text IDs"
- "Update Visualization Text IDs"
- "Remove Unused Text List Entries"

The object is located in the POUs view and exists once at the most

<table>
<thead>
<tr>
<th>&quot;ID&quot;</th>
<th>Unambiguous identifier of the text</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Default&quot;</td>
<td>Source text as a character string with one formatting specification at the most, for example Information A: %i possibilities. If no translation is written under a language column, CODESYS uses this text. Double-click in the field in order to edit the text.</td>
</tr>
<tr>
<td>&quot;&lt;Language code&gt;&quot;</td>
<td>Name of the language as a language code, for example en-US. This column contains the translation of the text that is written under &quot;Standard&quot;. If the language code is selected as a language in the visualization manager, a visualization displays the translation during operation. A running visualization can switch over during operation to another language at the request of a user. Double-click in the field in order to edit the text.</td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.1.21.3.21.1 “Command ‘Add Language’” on page 2728
- Chapter 6.4.1.21.3.21.2 “Command ‘Create Global Text List’” on page 2728
- Chapter 6.4.1.21.3.21.6 “Command ‘Import/Export Text Lists’” on page 2729
- Chapter 6.4.1.21.3.21.7 “Command ‘Remove Language’” on page 2730
- Chapter 6.4.1.21.3.21.9 “Command ‘Remove Unused Text List Entries’” on page 2731
- Chapter 6.4.1.21.3.21.10 “Command ‘Check Visualization Text IDs’” on page 2731
- Chapter 6.4.1.21.3.21.11 “Command ‘Update Visualization Text IDs’” on page 2731
- Chapter 6.4.1.21.2.28 “Object ‘Text List’” on page 2532
- Chapter 6.4.1.9.10 “Managing text in text lists” on page 1891

Object 'GVL' - Global Variable List

Symbol: 

A global variable list is used for the declaration, editing and display of global variables.

A GVL is added to the application or the project with the command “Project ➔ Add Object ➔ Global Variable List”.

If you insert a GVL under an application in the Device tree, the variables are valid within this application. If you add a GVL in the POU view, the variables are valid for the entire project.

You can apply settings for the editor of the object in the dialog “Tools ➔ Options” in the categories “Declaration Editor” and “Text Editor”.

If the target system supports network functionality, you can convert the variables of a GVL into network variables and thus use them for data exchange with other devices in the network. To do this you must define corresponding properties for the GVL in the “Network Variables” tab of the “Properties” dialog.

See also
- Chapter 6.4.1.9 “Programming of Applications” on page 1844
- Chapter 6.4.1.21.4.11.12 “Dialog ‘Properties’ - ‘Network Variables’” on page 2760
- Chapter 6.4.1.21.4.14 “Dialog ‘Options’” on page 2781

Object ‘GVL’ - Global Variable List (task-local)

Symbol: 📚

A global variable list (task-local) is used for the declaration, editing and display of global variables. For this special global variable list, the declared variables in the list can be written by one task only. All other tasks have only read-only access. This makes sure that the values of these variables are always consistent, even for multicore projects.

The object is available for compiler version 3.5.13.0 with the corresponding device description.

| "Task with write access" | Task that has exclusive write access to the variables. |

See also
- Chapter 6.4.1.9.4.6 “Using Task-Local Variables” on page 1855
- Chapter 6.4.1.9.4.5 “Declaring global variables” on page 1854
- Chapter 6.4.1.21.2.12 “Object ‘GVL’ - Global Variable List” on page 2465
- Chapter 6.4.1.21.2.29.6 “Tab ‘Task Groups’” on page 2537

Object: IEC Symbol Publishing

The “IEC Symbol Publishing” object contains an editor for configuring variables and IEC data types from the project for publishing via an OPC UA Server. A group of symbols can be compiled and configured for each created object.

The editor is a newer alternative to the already known editor for the Symbol Configuration.

Use the Add Object dialog to attach one or more IEC Symbol Publishing objects below an OPC UA Server object below the Communication Manager. You can change the object name, for example to webvisu, if the symbols are to be used for exchange with a web visualization.

Editor: IEC Symbol Publishing

Function: Configuration of a symbol set for exchange via OPC UA

Call: Double click or [Edit Object] command on the desired “<name of IEC symbol publishing>” object in the device tree.

The editor consists of two tabs: On the “IEC Symbol Editor” tab, you configure the symbol set to be published from individual variables from the project. On the “Symbol Type Editor” tab, you work with whole data types, such as GVL and FB.
Note that the editor works with variables and types from the precompile state of the project. If changes are made to variables or types in the project, then it can create inconsistencies with the current configuration in the symbol publishing editor. They are indicated at the relevant places in the editor by icons of the error, warning, or information. A tooltip on the icon provides more information about the inconsistency and a possible fix. The tooltip contains at least the message text, which also appears in the message window in the “IEC Symbol Publishing” category.

| “Refresh” | Refreshes the display in the editor according to the current situation in the project |
| “Use access rights defined in the user management” | ☑ The access rights to the symbol set are taken from the current settings in the user management of the controller. |

On this tab of the editor, you configure individual variables from the application as symbols to be published. You do this by dragging the desired variables from the “Precompile Sets” from the left part of the tab to the right part, where the symbols can then be configured.

| “Precompile Sets” | The tree structure shows all variables which are already available for publication in the project before compilation. To do this, the project scans the following: |
| | ● “<device>.<application>”: Project POUs below the device application |
| | ● “Libraries”: Integrated libraries |
| | ● “Pool”: Project POUs in the “POUs” view |
| | A list of excluded types can be found in the tooltip after the icon. |

| D Sync | This button is operable as long as there are inconsistencies between the current symbol configuration and the project. In this case you will see icons of the type error, warning, or information. After correcting the inconsistencies, synchronize the editor with the project again. |

| | The display of information about the configured symbols can be filtered. In the list after the icon, you select which table columns are to be displayed. When you enter a string in the search field, the search hits are highlighted in yellow in the table. |

| Table of configured symbols | Information about the individual symbols, depending on the set filter: |
| | ● Symbol: Variable name (example: iVar) |
| | ● Path: Variable path (example: PLC_PRG.iVar, PLC_PRG.fb1_inst) |
| | ● IEC type: IEC data type of the variable (example: INT, FB1) |
| | ● Symbol Type (Exported Type Name): Name of the symbol under which it will appear after export. In the case of structured types, the instance can be selected here. |
| | ● Access Rights: Permissions to the symbol. Example: Read/Write |
| | ● Comment: Comment stored in the application code |
On this tab of the editor, you configure entire “symbol types” for publishing. To do this, you drag the desired “IEC Data Types” from the left part of the window to the right side into the configuration table. Then there you can configure for each symbol type in detail which of its components should be exported with which access rights and with which name.

You can also filter the display in this table via ✓ and search for strings.

<table>
<thead>
<tr>
<th>Symbol Type (Exported Type Name)</th>
<th>The name of the symbol type dragged from IEC data types can be edited. It is used after export as defined here.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Members</td>
<td>The [ ] button opens the Data type members of &lt;symbol type&gt; dialog (see above).</td>
</tr>
<tr>
<td>IEC Type</td>
<td>IEC data type as defined in the project (example: Color)</td>
</tr>
</tbody>
</table>

Dialog: Data type members of <symbol type>.

Call: [ ] button on the “IEC Symbol Type Editor” tab in the “Members”

In this dialog, you select which members of the symbol type in question should be exported as symbols. You can define a name for each member under which it will be exported, including the access rights.

<table>
<thead>
<tr>
<th>Export</th>
<th>✓: The member is exported as a symbol.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exported Name</td>
<td>Default: Member name (IEC Name) from the project; can be edited</td>
</tr>
<tr>
<td>IEC Name</td>
<td>Member name from the project</td>
</tr>
<tr>
<td>IEC Type</td>
<td>IEC data type of the member (example: INT)</td>
</tr>
<tr>
<td>Symbol Type (Exported Type Name)</td>
<td>Name of the data type to which the member belongs (example: Color)</td>
</tr>
<tr>
<td>Access Rights</td>
<td>Access right to the symbol (Read, Write, Read/Write)</td>
</tr>
</tbody>
</table>

Above the table, there are filter and search options, just like on the editor tabs described above.

Object 'Image Pool'

The “Image Pool” object contains a table with image ID assignments.

<table>
<thead>
<tr>
<th>“ID”</th>
<th>ID of the image; you reference this ID, for example in the visualization of the image.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“File name”</td>
<td>File path of the image; if you click for more settings ( ), the “Select Image” dialog box opens.</td>
</tr>
<tr>
<td>“Image”</td>
<td>Show a thumbnail of the image.</td>
</tr>
<tr>
<td>“Link type”</td>
<td>Opens the “Select Image” dialog box, where you define the link type.</td>
</tr>
</tbody>
</table>
**Dialog box 'Select Image'**

| “Image file” | Name and directory of the image file (example: "C:\Programme\images\logo.bmp") CODESYS supports the following image formats: BMP, EMF, GIF, ICO, JPG, PNG, SVG, and TIFF. Please note that a controller may not support all formats. Whether or not you can use images formatted as scalable vector graphics (*.svg) depends on the operating system. Any necessary information is located in the device description of the hardware vendor. |

**Table 433: “File Handling”**

| “Remember the link” | CODESYS saves only the link. CODESYS automatically updates any changes to an image file in the image pool. You must ensure that the path of the image file does not change. When saving the project as an archive, CODESYS embeds the image file in the project archive. |
| “Remember the link and embed into project” | CODESYS copies the image to the image pool and the link information is retained. In this way, CODESYS recognizes any changes to the image file and then update the image pool can as needed. This behavior is controlled with the options in the next table. Embedded image files increase the memory requirement of the project. |
| “Embed into project” | CODESYS copies the image to the image pool. If the image file is changed again afterwards, then it is not updated in the project. For libraries, you must embed the image in the project. Embedded image files increase the memory requirement of the project. |

**Table 434: “Change Tracking”**

These options are available only if you have selected the “Remember the link and embed into project” check box as described above.

| “Reload the file automatically” | CODESYS automatically updates the image file in the project without prompting. |
| “Prompt whether to reload the file” | If the image file has changed, you may be prompted whether or not the image file should be updated. |
| “Do nothing” | CODESYS does not update the image file in the image pool. |

See also

- Chapter 6.4.1.9.11 “Using image pools” on page 1899

**Object 'Library Manager'**

Symbol: 📖

The Library Manager lists all libraries that were integrated in the project for creating applications. It provides information about the type of library, its properties, and its contents.

You can expand or collapse the list of integrated libraries, as well as edit library properties for non-dependent libraries.

The Library Manager consists of three views:

- Upper view: List of integrated libraries
- Lower left view: Tree structure with all modules of the library selected in the upper view
- Lower right view: Documentation for the module selected in the tree
List of integrated libraries

<table>
<thead>
<tr>
<th>Displayed in gray fonts</th>
<th>The library was added to the project automatically by means of a plug-in.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displayed in black fonts</td>
<td>The library was added to the project automatically by means of the “Add Library” command.</td>
</tr>
</tbody>
</table>

**“Name”**

Display of the integrated library in the following syntax:

```
<placeholder name> = <library name>, <version> (<company>)
```

- `<placeholder name>`: If it is a placeholder library for a library, then the placeholder name is before a `="`.  
- `<library name>`: Name of the library that is used for management in the library repository.  
- `<version>`: Version that was referenced at the first time it was integrated.  
- `(<company>)`: Vendor (optional)

**“Namespace”**

Namespace for unique access to the contents of the library.  
It is prepended to a module identifier for this purpose:  

```
<namespace>.<library module identifier>
```

The namespace usually coincides with the library name.  

**Note:** If the library has the property `LanguageModelAttribute "qualified-access-only"`, then you **must** access the library module in the application code by means of the namespace. Qualified (unique) access is enforced.  

You can modify the standard namespace for local use (within the project) in the “Properties” dialog.

**“Effective version”**

Version of the library after the resolution. This version is used in the project.  

**Requirement:** The Library Manager exists in the “Devices” view and a placeholder library is selected.  

**Example:** 3.5.10.0  
A placeholder library that is integrated below an application is resolved by assigning a special resolution to the placeholder library in the “Placeholders” dialog. Then the selected library is loaded. Other resolutions are ignored. If no special resolution is given, then a check is performed as to whether or not a resolution is specified in the device description and library profile of the application. The first detected resolution is used.  

If you have assigned a special resolution to the placeholder library in the “Placeholders” dialog, then this will **always be ignored**. The result is shown in the tooltip of the ⚠ symbol.
Library that is signed with a trusted certificate (compatible with CODESYS >= V3 SP15)

Library that is signed with a trusted certificate, but references at least one unsigned library

Library that is signed with a private key and token (compatible with CODESYS < V3 SP15)

Library that is not signed, or signed with an untrusted or expired certificate. In the case of an untrusted certificate, the “Trust Certificate” command is provided in the context menu.

Library that is defined as optional and not currently available

Library whose status is being determined

Licensed library for which no valid license is currently available

Library symbol for a library that cannot be loaded because its signature (encryption) could not be verified

Table 435: Commands in the Library Manager

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Add Library”</td>
<td>Opens the dialog for selecting a library. All libraries installed in the library repository are offered.</td>
</tr>
<tr>
<td>“Delete Library”</td>
<td>Removes the presently selected library from the project</td>
</tr>
<tr>
<td>“Properties”</td>
<td>Opens the dialog for the display and editing of the properties of the presently selected library</td>
</tr>
<tr>
<td>“Details”</td>
<td>Opens a dialog with details for the presently selected library (general information, contents, properties, license information)</td>
</tr>
<tr>
<td>“Try to Reload Library”</td>
<td>If you select a library marked as not found, you can attempt to load it into the project again using this command.</td>
</tr>
<tr>
<td>“Download Missing Libraries”</td>
<td>CODESYS scans for the missing libraries in the download servers specified in the project options. After that you can download and install the library.</td>
</tr>
<tr>
<td>“Placeholders”</td>
<td>The “Placeholders” dialog opens. The current resolution is displayed there and you can edit it.</td>
</tr>
<tr>
<td>“Library Repository”</td>
<td>Opens the “Library Repository” dialog for installing and uninstalling libraries and for defining library locations</td>
</tr>
<tr>
<td>“Icon legend”</td>
<td>Opens the “Information” dialog with a legend of the icons that display the current status of a library in the list of integrated libraries (see above)</td>
</tr>
<tr>
<td>“Summary”</td>
<td>Opens the “Library Summary” dialog. All libraries referenced in the project are displayed in a tree structure in the dialog, and those libraries which reference these libraries.</td>
</tr>
<tr>
<td></td>
<td>• Command “Display all occurrences in library hierarchy and close dialog”: In the editor of the Library Manager, the libraries in the open tree structure are marked which reference or use this library. Requirement: A library is selected. The “Information” dialog is then closed. This command is also executed when you double-click a library.</td>
</tr>
<tr>
<td></td>
<td>Display of the libraries</td>
</tr>
<tr>
<td></td>
<td>• “Managed Library”: Name and version of the library</td>
</tr>
<tr>
<td></td>
<td>• “Number of Occurrences”: Number of locations where this library is referenced by other libraries.</td>
</tr>
<tr>
<td></td>
<td>When you click “*” for a library, the libraries, which reference this library, are displayed in the next level down.</td>
</tr>
</tbody>
</table>
"Trust Certificate" Only in the context menu of a library selected in the Library Manager, in which the library has been signed with an untrusted certificate. The command turns the untrusted certificate into a trusted certificate and the prepended icon changes from 🟢 to 🟢.

"Export Library" Only in the context menu of a library selected in the Library Manager: Opens the default dialog for saving the library file in the file system.

See also
- § Chapter 6.4.1.21.3.15.1 “Command ‘Add Library’” on page 2712
- § Chapter 6.4.1.21.3.15.5 “Command ‘Export Library’” on page 2716
- § Chapter 6.4.1.21.3.15.3 “Command ‘Properties’” on page 2714
- § Chapter 6.4.1.21.3.9.5 “Command ‘Library Repository’” on page 2657
- § Chapter 6.4.1.21.3.15.4 “Command ‘Placeholders’” on page 2716
- § Chapter 6.4.1.21.4.16.14 “Dialog ‘Options’ – ‘Library Download’” on page 2790
- § Chapter 6.4.1.21.2.24 “Object ‘Project Information’” on page 2515

Tree structure of all modules of a selected library
All library modules that were integrated with the library are listed in the tree structure.

Requirement: A library is selected in the upper view.

The usual sorting and search functions are available in the menu bar.

Documentation for the library module selected in the lower left view

<table>
<thead>
<tr>
<th>Tab “Inputs/Outputs”</th>
<th>Interface (inputs/outputs) of the library module</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab “Graphical”</td>
<td>Graphical display of the module</td>
</tr>
<tr>
<td>Tab “Documentation”</td>
<td>Documentation for the library module.</td>
</tr>
<tr>
<td></td>
<td>Note: As a library developer, you have to follow the rules for documentation inclusion in ‘Guidelines for library development’.</td>
</tr>
<tr>
<td>Tab “Parameter List”</td>
<td>Requirement: The library project contains a parameter list. You can change the values of these parameters in the column “Value (editable)”.</td>
</tr>
</tbody>
</table>

See also
- § Chapter 6.4.1.17.3 “Information for Library Developers” on page 2035

Object ‘OPC UA Information Model’

Symbol: ☁️

The “OPC UA Information Model” object is added to the “Communication Manager” in the application. When added, an OPC UA publishing object ☁️ and below that an information model object ☁️ as a child object are also added.

In the “Add OPC UA Information Model” dialog, specify a name for the information model and select the OPC UA information model. The selection includes the OPC UA information models which are installed in the “OPC UA Information Model Repository”.

2472

3ADR010583, 1, en_US

2024/01/05
**OPC UA information model editor**

The editor is used to select the object types and data types of the OPC UA information model which you want to use in the open CODESYS project. The selected OPC UA types are converted to IEC types in the editor.

<table>
<thead>
<tr>
<th>“Browse Information Model”</th>
<th>List box</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The currently used information model and the information models which are referenced by the current model are displayed. The dependencies depend on the respective information model. The OPC UA base model is always displayed.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Generate IEC declarations”</th>
<th>Generates an IEC declaration for all OPC UA types converted into an IEC type. The generated IEC types are saved in a folder (example: “OPC Objects”) in the “Devices” view and can be used in the implementation of the IEC code. When implementing the CODESYS project, you can select them in the “Input Assistant” dialog.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>When the IEC declarations are generated, the appropriate attributes are automatically added to the generated POUs (example: 'opcua.mapping.type','opcua.mapping.member.accesslevel').</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The attributes added by the system should not be changed by the user.</td>
</tr>
<tr>
<td></td>
<td>When the IEC type cannot be created, the entry UNKNOWN_TYPE is displayed in the declaration instead of the data type. The user should delete this variable because in this case it is almost always an OPC UA feature which is not supported yet. OPC UA features which are not supported yet are grayed out in the left area.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Data Model”</th>
<th>Left area: OPC UA data model</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Types”</th>
<th>Display of the OPC UA data types and object types in a tree structure</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>When you drag an OPC UA type to the right area, CODESYS converts the OPC UA type into the corresponding IEC type which can be used in the implementation of the CODESYS project. In this case, only the root node of an OPC UA type can be dragged to the right area.</td>
</tr>
<tr>
<td></td>
<td>For a detailed description of the assignment of individual OPC UA types to the corresponding IEC types in the mapping operation, see the chapters “Mapping of OPC UA Types to IEC Types” and “Mapping of Reference Types”.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Element Type”</th>
<th>OPC UA element type</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Reference Type”</th>
<th>OPC UA reference types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: HasComponent, HasProperty</td>
<td></td>
</tr>
<tr>
<td>For a description of these reference types, see the chapter “Mapping of OPC UA Types to IEC Types”.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Modelling Rule”</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>● “Mandatory”: For the corresponding OPC UA type, the respective members are generated in the project when the “Generate IEC declarations” command is executed. In the right area, the “Generate member” field is activated and cannot be deactivated.</td>
</tr>
<tr>
<td></td>
<td>● “Optional”: Generating an IEC member for this OPC UA type is optional.</td>
</tr>
<tr>
<td></td>
<td>● “Optional placeholder”: in the right, you can drag another IEC type for this placeholder. For an example as a screenshot, see the chapter “Using OPC UA Companion Information Models”.</td>
</tr>
</tbody>
</table>

| Right area: Object types and data types of the OPC UA information model which are mapped to IEC types |
### “Name”
Name of the IEC POU or data type in the project
By default, the name of the type is displayed in the OPC UA information model. OPC UA also supports names which are invalid in IEC. In these cases, CODESYS automatically generates a valid IEC name.
You can change the name.

### “IEC Type”
IEC type to which the OPC UA type was mapped (example: BOOL, “Method”).

### “OPC UA Type”
Corresponds to the “Element Type” displayed in the left area

### “Generate member”
- ✓ When the “Generate IEC declarations” command is executed, a corresponding member or a placeholder is generated in the project. Only the interfaces are automatically generated here. The implementation still has to be manually created later in a POU.
  - When the “Modelling Rule” is “Mandatory” for the OPC UA type in the right area, this option cannot be deactivated.
- □ When the “Generate IEC declarations” command is executed, a corresponding member is not generated in the project. Click this option to activate it.

---

### OPC UA publishing editor
Symbol: ☁
In the editor, the instances (OPC UA objects) of the OPC UA types are configured which should be available to the OPC UA Clients via the controller

### “Search for Mapped Instances”
Searches in GVLs and PRGs below the current application for instances of the mapped OPC UA types which have already been declared. The search result is displayed in the list.
Note: Instances in the “POUs” view and in libraries are not taken into consideration.

### “Create New Instance”
Opens the “Create New Instance” dialog to select the IEC type for which a new instance should be generated.
Instances can be generated for the POUs which have been created in the OPC UA information model editor from OPC UA types. These instances can be used in POUs in the application.
Requirement: In the OPC UA information model editor, the “Generate IEC declarations” command has been executed after mapping the OPC UA types to the IEC types.

### “Root Node”
Selection of directories or the object instance of the server which is displayed on the OPC UA Client for publishing the instances. The list box depends on the applied OPC UA companion specification.

### Tabular list of generated instances:

<table>
<thead>
<tr>
<th>“OPC UA Variable”</th>
<th>Variable which has been generated as an instance of an OPC UA type. This variable can be published in an OPC UA Client. You can edit the displayed name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“OPC UA Type”</td>
<td>OPC UA type of the “OPC UA Variable”</td>
</tr>
</tbody>
</table>
| “Map or Generate”  | - ✓: The “OPC UA Variable” has been mapped to an existing variable.  
- □: The “OPC UA Variable” has been generated as a new instance.                                                                                                                                       |
| “IEC Variable”     | Full variable name                                                                                                                                                                                 |
| “IEC Type”         | IEC type of the IEC variable                                                                                                                                                                        |
“Access Rights” | Note that an OPC UA Client may have read/write access the OPC UA variable. In the function blocks, the access rights to the variables can be changed by attributes which can also be read from the XML file if necessary. Reading and writing

“Maximal” | Maximum possible permissions for the OPC UA variable

See also

- Chapter 6.4.1.21.3.9.12 “Command ‘OPC UA Information Model Repository’” on page 2665

Object ‘Network Variable List (Sender)’

Symbol: 🌐

A network variable list (sender) is used for declaring and listing global variables that should be sent to network variable lists (receiver) of other devices or network projects.

You add the object to the device tree by clicking “Add Object ➔ Network Variable List (Sender)” of an application.

You can configure the protocol and transfer parameters in the “Add Network Variable List (Sender)” dialog box or “Properties” dialog box of the object in the “Network Variables” tab.

**Dialog Box ‘Add Network Variable List (Sender)’**

**Function:** This dialog box defines the network properties for the sender NVL. When you close the dialog box, CODESYS adds the sender NVL of the application to the device tree.

**Call:** Main menu “Project ➔ Add Object ➔ Network Variable List (Sender)” while the application is selected in the device tree.

This dialog box corresponds to the “Network Variables” tab in the “Properties” of the network variable list object.

See also

- Chapter 6.4.1.21.4.11.12 “Dialog ‘Properties’ - ‘Network Variables’” on page 2760
- Chapter 6.4.1.21.2.19 “Object ‘Network Variable List (Receiver)’” on page 2475

Object ‘Network Variable List (Receiver)’

Symbol: 🌐

The object is used for listing the received network variables and displaying the information: network and transmit information and sender.

You add the object to an application by clicking “Add Object ➔ Network Variable List (Receiver)”.

The network variable list (receiver) shows the received network variables, which were declared in network variable list (sender) of another device or project. You cannot change the network variables in the object editor.

The object editor consists of two parts:

- Information about the sender and transfer log of the list
- List of declarations of network variables

**Dialog Box ‘Add Network Variable List (Receiver)’**

**Function:** This dialog box defines the receiver NVL to a sender NVL and adds the receiver NVL to the application object in the device tree.

**Call:** Main menu “Project ➔ Add Object ➔ Network Variable List (Receiver)” (when the application object is selected).
### `Task`

Task of the current application that controls the variables to be received.

### `Sender`

Drop-down list

- Available sender NVLs of another device in the project
- "Import from file": Required if the necessary sender NVL is defined in another project. For this, the necessary sender NVL must have been generated in another project as "GVL export file *.gvl" in the properties dialog of the NVL in the "Link To File" tab.

### `Import from file`

File name in "GVL export file *.gvl" format if you have selected "Import from file" for "Sender".

See also

- Chapter 6.4.1.21.2.18 “Object ‘Network Variable List (Sender)’” on page 2475

### Object ‘Persistent variable list’

**Symbol:** 🏛

The object contains the declaration of global persistent variables in the declaration section `VAR_GLOBAL PERSISTENT RETAIN .. END_VAR`. The variables are stored in special non-volatile memory.

The persistence editor shows the variables as a list in the usual way. The displayed list does not influence the persistence behavior of the variables, but only the list stored internally in the process image. The list there contains all variables ever declared in chronological order. Variables that you have removed are marked with a placeholder and continue to exist as a gap.

The declaration section can also contain instance paths, which refer to locally declared persistent variables and were created with the command "Declarations ➤ Add All Instance Paths".

**NOTICE!**

Before you decide how to set up persistence for an application, it would be helpful for you to be familiar with the use cases described in the "Data Persistence" section. Moreover, it is helpful if you can differentiate between the mechanisms of persistent variables, retain variables, variables of the Persistence Manager, and recipe variables.

### Commands

The following commands are provided in the persistence editor:

- Command "Declarations ➤ Add All Instance Paths"
- Command "Declarations ➤ Reorder List and Clear Gaps"

See also

- TODO
- Chapter 6.4.1.21.3.18.1 “Command ‘Reorder List and Clean Gaps’” on page 2719
- Chapter 6.4.1.9.19.2 “Preserving data with persistent variables” on page 1923
- Chapter 6.4.1.9.19.3 “Preserving data with retain variables” on page 1925
- Chapter 6.4.1.21.3.18.4 “Command ‘Add all instance paths’” on page 2720
Object 'POU'

General

Symbol: 🛠️

An object of the type “POU” is a Program Organization Unit in a CODESYS project. You write source code for your controller program in POUs.

There are the following types of POUs:

- Program
- Function
- Function block

A “POU” object is inserted by using the command “Project ➔ Add Object” in the Device tree or in the “POUs” view. When adding a POU you define the POU type and the implementation language.

You can also add other programming objects (method, action, etc.) to these objects.

Calling POUs

Certain POUs can call other POUs. Recursions are not permitted.

When calling POUs via the namespace, CODESYS browses the project for the POU to be called in accordance with the following order:

1. Current application
2. “Library Manager” of the current application
3. “POUs” view
4. “Library Manager” in the “POUs” view

If you want to call a POU that exists with the same name in a library used in the application and as an object in the “POUs” view, note the following: There is no syntax that allows you to call the POU in the “POUs” view only by its name. In this case you must shift the library from the application's library manager to the project's library manager (in the “POUs” view). After that you can call the POU object in the “POUs” view purely by its name. If you add the namespace to the library, you can call the POU of the library.

The term “POU” is also used in CODESYS for the “POUs” view in which CODESYS manages the global objects in the project.

See also

- § Chapter 6.4.1.21.2.21 “Object ‘POU’” on page 2477
- § Chapter 6.4.1.21.4.11 “Dialog ‘Properties’” on page 2753

Dialog 'Add POU'

**Function:** The dialog is used to configure a new POU according to the IEC 61131-3 standard. This means that a POU can be a program, a function, or a function block.

**Call:** “Project ➔ Add Object” menu; context menu in the “Devices” view when an application is selected; context menu in the “POUs” view

<table>
<thead>
<tr>
<th>“Name”</th>
<th>Name of POU</th>
</tr>
</thead>
</table>

2024/01/05 3ADR010583, 1, en_US 2477
**Table 436: “Type”**

<table>
<thead>
<tr>
<th>“Program”</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>“Function Block”</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>☑ “Extends”: Specification or selection of a base function module in the sense of object-oriented programming. Specified with the EXTENDS keyword in the function block declaration</td>
</tr>
<tr>
<td></td>
<td>☑ “Implements”: Specification or selection of an interface in the sense of object-oriented programming. Specified with the IMPLEMENTS keyword in the function block declaration. When the POU is created, all methods are created which are defined via the interface.</td>
</tr>
<tr>
<td></td>
<td>☑ “Final”: Derived access is not allowed. This means that you cannot extend the function block with another function block. This allows for optimized code generation.</td>
</tr>
<tr>
<td></td>
<td>☑ “Abstract”: Identifies that the function block has a missing or incomplete implementation and cannot be instantiated. Abstract FBs are used exclusively as base function blocks and the implementation typically occurs in a derived FB. If a non-abstract function block is created, which in turn extends an abstract function block, then all abstract methods of the abstract basic function block are added to the new function block as (non-abstract) methods.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>“Access specifier”</td>
</tr>
<tr>
<td></td>
<td>– “PUBLIC”: Corresponds to the specification of no access specifier.</td>
</tr>
<tr>
<td></td>
<td>– “INTERNAL”: Access to the function block is restricted to the namespace (library).</td>
</tr>
<tr>
<td></td>
<td>“Method implementation language”: When you select the “Implements” option, you can select an implementation language here for all method objects that CODESYS generates by means of the implementation of the interface. The “Method implementation language” does not depend on the implementation language of the function block.</td>
</tr>
<tr>
<td><strong>“Function”</strong></td>
<td>Note: Not available when “Sequential Function Chart (SFC)” is selected as the “Implementation language”.</td>
</tr>
<tr>
<td></td>
<td>“Return type”: Data type of the return value</td>
</tr>
<tr>
<td><strong>“Implementation language”</strong></td>
<td>Implementation language of the POU</td>
</tr>
</tbody>
</table>

See also

- ☑ Chapter 6.4.1.21.2.21.3 “Object ‘Function Block’” on page 2479
- ☑ Chapter 6.4.1.21.2.21.2 “Object ‘Program’” on page 2478
- ☑ Chapter 6.4.1.21.2.21.4 “Object ‘Function’” on page 2482
- ☑ Chapter 6.4.1.9.22.2 “Extension of function blocks” on page 1929
- ☑ Chapter 6.4.1.9.22.3 “Implementing interfaces” on page 1931

---

**Object ‘Program’**

A program is a POU that supplies one or more values during execution. After execution of the program, all values are retained until the next execution. The order of calling the programs within an application is defined in task objects.

A program is added to the application or the project using the command “Project ➔ Add Object ➔ POU”. In the Device tree and in the “POUs” view the program POUs have the suffix “(PRG)”.

The editor of a program consists of the declaration part and the implementation part.

The uppermost line of the declaration part contains the following declaration:

```plaintext
PROGRAM <program>
```
Calling a program

Programs and function blocks can call a program. A program call is not permitted in a function. There are no instances of programs.

If a POU calls a program and values of the program change as a result, these changes are retained until the next program call. The values of the program are also retained even if the repeat call takes place by another POU. This differs from the call of a function block. When calling a function block only the values of the respective instance of the function block change. The changes only need to be observed if a POU calls the same instance again.

You can also set the input or output parameters for a program directly when calling.

Syntax: `<program>(<input variable> := <value>, <output value> => <value>):`

If you insert a program call via the input assistant and the “Insert with arguments” option in the input assistant is activated at the same time, CODESYS adds input and/or output parameters to the program call in accordance with the syntax.

Calls:

IL:

```
CAL

PLC_PRG()

in1:= 2

LD

PLC_PRG.out2

ST

erg
```

With assignment of the parameters:

```
CAL

PLC_PRG(

in1:= 2,

out2=> erg)
```

ST:

```
PLC_PRG()

erg := PLC_PRG.out2;
```

With assignment of the parameters:

```
PLC_PRG(in1:=2, out1=>erg);
```

See also

- "Chapter 6.4.1.21.2.21 “Object 'POU’” on page 2477"
- "Chapter 6.4.1.9.17 “Task Configuration” on page 1914"

Object 'Function Block'

A function block is a POU that yields one or more values when executed.

The object is added to the application or the project by clicking “Project ➔ Add Object ➔ POU”. In the device tree or in the “POUs” view, function block POU’s have the “(FB)” suffix.

It always calls a function block by means of an instance that is a copy of the function block.
The editor of a function block consists of the declaration part and the implementation part.
The values of the output variables and the internal variables remain unchanged after execution
until the next execution. This means that the function block does not necessarily return the
same output values for multiple calls with the same input variables.

In addition to the functionality described in IEC 61131-3, you can also use function blocks in
CODESYS for the following functionalities of object-oriented programming:

- Extension of a function block
- Implementation of interfaces
- Methods
- Properties

The top line of the declaration part contains the following declaration:

\[
\text{FUNCTION BLOCK} \ <\text{access specifier}> \ <\text{function block}> \ | \ \text{EXTENDS} \ <\text{function block}> \ | \ \text{IMPLEMENTS} \ <\text{comma-separated list of interfaces}>
\]

Calling a function block

The call is always made by means of an instance of the function block. When a function block is
called, only the values of the respective instance change.

Declaration of the instance:

\[
<\text{instance}> \ : \ <\text{function block}>;
\]

You access a variable of the function block in the implementation part as follows:

\[
<\text{instance}> \ . \ <\text{variable}>
\]

NOTICE!

Note the following:

- You can access only input and output variables of a function block from
  outside the function block instance, not the internal variables.
- Access to a function block instance is restricted to the POU in which the
  instance is declared, unless you have declared the instance globally.
- You can assign the desired values to the function block variables when you
  call the instance.
Access to function block variables:
The function block FB1 has the input variable iVar1 of type INT and the output variable out1. In the following, the variable iVar1 is called from the program Prog.

PROGRAM Prog
VAR
   inst1:FB1;
END_VAR

   inst1.iVar1 := 33; (* FB1 is called and the value 33 is assigned to the variable iVar1 *)
   inst1(); (* FB1 is called, that's necessary for the following access to the output variable *)
   ires := inst1.out1 (* the output variable out1 of the FB1 is read *)

In FBD:

Assigning variable values when calling:
In the textual languages IL and ST, you can assign values directly to input and/or output variables when you call the function block.

A value is assigned to an input variable with := .
A value is assigned to an output variable with => .

Example in IL:
The instance CMD_TMR of the timer function block is called with assignments for the input variables IN and PT. Then the output variable Q of the timer is assigned to the variable A.

PROGRAM PLC_PRG
VAR
   CMD_TMR : TOF;
END_VAR

   CMD_TMR(IN := %IX5.1, PT := T#100MS);
   A := CMD_TMR.Q;

i

  When you insert a function block instance by means of the “Input Assistant” and select the “Insert with arguments” option in the “Input Assistant” dialog, CODESYS inserts the call with all input and output variables. Then you only have to insert the desired value assignment. In the example above, CODESYS inserts the call as follows: CMD_TMR(IN:= ,PT:= , Q=> ).

i

  You can use the attribute 'is_connected' and a local variable to determine at the time of the call in the function block instance whether or not a specific input receives an external assignment.
See also

- Chapter 6.4.1.21.2.21 “Object ‘POU’” on page 2477
- Chapter 6.4.1.9.22.2 “Extension of function blocks” on page 1929
- Chapter 6.4.1.9.22.3 “Implementing interfaces” on page 1931
- Chapter 6.4.1.21.2.21.6 “Object ‘Method’” on page 2485
- Chapter 6.4.1.21.2.21.9 “Object ‘Property’” on page 2493
- Chapter 6.4.1.20.6.3.24 “Attribute ‘is_connected’” on page 2293

**Object ‘Function’**

A function is a POU that supplies precisely one data element when executed and whose call in textual languages can occur as an operator in expressions. The data element can also be an array or a structure.

The object is added to the application or the project by clicking “Project ➔ Add Object ➔ POU”.

In the device tree or in the “POUs” view, function POUs have the “(FUN)” suffix.

**NOTICE!**

Functions have no internal status information, which means that functions do not save the values of their variables until the next call. Calls of a function with the same input variable values always supply the same output value. Therefore, functions must not use global variables and addresses!

The editor of a function consists of the declaration part and the implementation part.

The top line of the declaration part contains the following declaration:

FUNCTION <function> : <data type>

Below that, you declare the input and function variables.

The output variable of a function is the function name.

**NOTICE!**

If you declare a local variable in a function as RETAIN, this has no effect. In this case, CODESYS issues a compiler error.

**NOTICE!**

You cannot mix explicit and implicit parameter assignments in function calls in CODESYS V3. This means that you have to use either only explicit or only implicit parameter assignments in function calls. The order of the parameter assignments when calling a function is arbitrary.

**Calling a function**

In ST, you can use the call of a function as an operand in expressions.

In SFC, you can use a function call only within step actions or transitions.
According to the IEC 61131-3 standard, functions can have additional outputs. You declare the additional outputs in the function between the keywords `VAR_OUTPUT` and `END_VAR`. The function is called according to the following syntax:

```
<function> (<function output variable1> => <output variable 1>,
<function output variable n> => <output variable n>)
```

Example

The `fun` function is defined with two input variables `in1` and `in2`. The output variable of the `fun` function is written to the locally declared output variables `loc1` and `loc2`.

```
fun(in1 := 1, in2 := 2, out1 => loc1, out2 => loc2);
```
Object 'Interface'

Symbol:  

**Keyword:** INTERFACE

An interface is a means of object-oriented programming. The object ITF describes a set of method and property prototypes. In this context, prototype means that the methods and properties contain only declarations and no implementation.

This allows different function blocks having common properties to be used in the same way. An object “ITF” is added to the application or the project with the command “Project ➔ Add Object ➔ Interface”.

Table 437: “Adding an interface”

<table>
<thead>
<tr>
<th>“Inheritance”</th>
<th>Interface name</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Name”</td>
<td>Interface name</td>
</tr>
<tr>
<td>“Extends”</td>
<td>✓: Extends the interface that you enter in the input field or via the input assistant ... This means that all methods of the interface that extend the new interface are also available in the new interface.</td>
</tr>
</tbody>
</table>

You can add the objects “Interface property” and “Interface Method” to the object “ITF”. Interface methods may contain only the declarations of input, output and input/output variables, but no implementation.

So that you can also use an interface in the program, there must be a function block that implements this interface.

This means:

- the function block contains the interface in its IMPLEMENTS list in its declaration part
- the function block contains an implementation for all methods and property prototypes of the interface

A function block can implement one or more interfaces. You can use the same method with identical parameters, but different implementation code in different function blocks.

Please note the following:

- You may not define variables within an interface. An interface has no implementation part and no actions. Only a collection of methods is defined, in which you may define only input, output and input/output variables.
- CODESYS always treats variables declared with the type of an interface as references.
- A function block that implements an interface must contain implementation code for the methods of the interface. You have named the methods exactly as in the interface and the methods contain the same input, output and input/output variables as in the interface.
NOTICE!

Interface references and online change

The following can happen with a compiler version < 3.4.1.0: if a function block changes its data because variables are added or deleted, or because the type of variables changes, then CODESYS copies all instances of the function block to a new memory location. In this case, however, an interface reference refers not to the new memory location, but still to the old one.

In case of compiler versions >= 3.4.1.0, CODESYS automatically re-addresses the interface references so that CODESYS also references the correct interface in case of an online change. CODESYS requires additional code and more time for this, so that jitter problems can occur depending on the number of objects concerned. Therefore, CODESYS displays the number of variables and interface references concerned before the execution of the online change and you can then decide whether the online change should be executed or aborted.

Example

Definition of an interface and its use in a function block

You have inserted the interface “ITF” below the application. The interface contains the methods “Method1” and “Method2”. “ITF”, “Method1” and “Method2” contain no implementation code. You insert the required variable declarations only in the declaration part of the methods.

If you subsequently insert a function block in the device tree that implements the interface “ITF”, CODESYS automatically also inserts the methods “Method1” and “Method2” under the function block. Here you can implement function-block-specific code in the methods.

- Chapter 6.4.1.9.22.3 “Implementing interfaces” on page 1931
- Chapter 6.4.1.9.22.4 “Extending interfaces” on page 1933

Object ‘Method’

Symbol: METHOD

Keyword: METHOD
Methods are an extension of the IEC 61131-3 standard and a tool for object-oriented programming which is used for data encapsulation. A method contains a declaration and an implementation. However, unlike a function, a method is not an independent POU, and it is subordinated to a function block or program. A method can access all valid variables of the superordinate POU. 

You can use interfaces for the organization of methods. 

You can add a method below a program or a function block. Click “Project ➔ Add Object ➔ Method” to open the “Add Method” dialog.

### Declaration
- The variables of a method contain temporary data that are valid only during the execution of the method (stack variables). All variables that are declared and implemented in a method are reinitialized each time the method is called.
- Like functions, methods can have additional outputs. You have to assign these additional outputs in the method call.
- Depending on the declared access specifier, a method can be called only within its own namespace (INTERNAL), only within its own POU and its derivatives (PROTECTED), or only within its own POU (PRIVATE). For PUBLIC, the method can be called from anywhere.

Interface methods can have declared input, output, and VAR_IN_OUT variables, but do not contain an implementation.

See also
- § Chapter 6.4.1.21.2.21.7 “Object 'Interface Method’” on page 2490

### Implementation
- Access to function block instances or program variables is allowed in the implementation of the method.
- The THIS pointer allows for access to its own function block instance. Therefore, the pointer is allowed only in methods that are assigned to a function block.
- A method cannot access VAR_TEMP variables of the function block.
- A method can call itself recursively.

### Calling a method

Syntax for calls:

```
<return value variable> := <POU name> . <method name> ( <method input name> := <variable name> (, <further method input name> := <variable name> )* );
```

For the method call, you assign transfer parameters to the input variables of the method. Respect the declaration when doing this. It is enough to specify the names of the input variables without paying attention to their order in the declaration.
METHOD PUBLIC DoIt : BOOL
VAR_INPUT
   iInput_1 : DWORD;
   iInput_2 : DWORD;
   sInput_3 : STRING(12);
END_VAR

bFinishedMethod := fbInstance.DoIt(sInput_3 := 'Hello World ',
iInput_2 := 16#FFFF, iInput_1 := 16);

When the method is called, the return value of the method is assigned, for example, to variables declared locally. When you omit the names of the input variables, you have to pay attention to the declaration order.

Example

Declaration
METHOD PUBLIC DoIt : BOOL
VAR_INPUT
   iInput_1 : DWORD;
   iInput_2 : DWORD;
   sInput_3 : STRING(12);
END_VAR

Call
bFinishedMethod := fbInstance.DoIt(16, 16#FFFF,'Hello World ');

Recursive method call
Within the implementation, a method can call itself, either directly by means of the THIS pointer, or by means of a local variable for the assigned function block.

● THIS^. <method name> ( <parameter transfer of all input and output variables> )
   Direct call of the relevant function block instance with the THIS pointer

● VAR fb_Temp : <function block name>; END_VAR
   Call by means of a local variable of the method that temporarily instantiates the relevant function block

A compiler warning is issued for a recursive call. If the method is provided with the pragma \{attribute 'estimated-stack-usage' := '<estimated_stack_size_in_bytes>'\}, then the compiler warning is suppressed. For an implementation example, see the "Attribute ‘estimated-stack-usage’" chapter.

To call methods recursively, it is not enough to specify only the method name. If only the method name is specified, then a compiler error is issued: “Program name, function or function block instance expected instead of”

See also
● § Chapter 6.4.1.9.22.5 “Calling methods” on page 1933
● § Chapter 6.4.1.20.6.3.14 “Attribute ‘estimated-stack-usage’” on page 2281
● § Chapter 6.4.1.20.2.16 “THIS” on page 2126

Special methods of a function block
<table>
<thead>
<tr>
<th>Declaration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FB_Init</td>
<td>Declarations automatically implicit, but explicit declaration also possible. Contains initialization code for the function block, as is defined in the declaration part of the function block.</td>
</tr>
<tr>
<td>FB_Reinit</td>
<td>Explicit declaration is necessary. Call after the instance of the function block was copied (as during an online change). It reinitializes the new instance module.</td>
</tr>
<tr>
<td>FB.Exit</td>
<td>Explicit declaration is necessary. Call for each instance of the function block before a new download or a reset or during an online change for all shifted or deleted instances.</td>
</tr>
</tbody>
</table>

**Properties**

- Provides `Set` and/or `Get` accessor methods.

**See also**

- Chapter 6.4.1.20.10 “Methods ‘FB_Init’, ‘FB_Reinit’, and ‘FB_Exit’” on page 2336
- Chapter 6.4.1.21.2.21.9 “Object ‘Property’” on page 2493
- Chapter 6.4.1.21.2.21.8 “Object ‘Interface Property’” on page 2490

**Dialog 'Add Method'**

**Function:** Defines a method below the selected POU when the dialog is closed.

**Call:** Menu bar: “Project ➔ Add Object ➔ Method”; context menu

**Requirement:** A program (PRG) or a function block (FUNCTION_BLOCK) is selected in the “POUs” view or the “Devices” view.

The interface of a method inserted below a basic function block is copied when a method with the same name is inserted below a derived function block.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Name”</td>
<td>Example: <code>meth_DoIt</code>. The standard methods <code>FB_Init</code> and <code>FB.Exit</code> are offered in a list box if they are not already inserted below the POU. If it is a derived function block, then the list box also offers all of the methods of the basic function block.</td>
</tr>
<tr>
<td>“Return type”</td>
<td>Default data type or structured data type of return value. Example: <code>BOOL</code></td>
</tr>
<tr>
<td>“Implementation language”</td>
<td>Example: “Structured Text (ST)”</td>
</tr>
<tr>
<td>“Access specifier”</td>
<td>Controls access to data. Controls access to data.</td>
</tr>
<tr>
<td></td>
<td>- “PUBLIC” or not specified: Access is not restricted.</td>
</tr>
<tr>
<td></td>
<td>- “PRIVATE”: Access is restricted to the program, function block, or GVL.</td>
</tr>
<tr>
<td></td>
<td>The object is marked as (private) in the POU or device view. The declaration contains the keyword <code>PRIVATE</code>.</td>
</tr>
<tr>
<td></td>
<td>- “PROTECTED”: Access is restricted to the program, function block, or GVL</td>
</tr>
<tr>
<td></td>
<td>with its derivations. The declaration contains the keyword <code>PROTECTED</code>.</td>
</tr>
<tr>
<td></td>
<td>The object is marked as (protected) in the POU or device view.</td>
</tr>
<tr>
<td></td>
<td>- “INTERNAL”: Access to the method is restricted to the namespace (library).</td>
</tr>
<tr>
<td></td>
<td>The object is marked as (internal) in the POU or device view. The declaration contains the keyword <code>INTERNAL</code>.</td>
</tr>
<tr>
<td>“Abstract”</td>
<td>☑: Identifies that the method does not have an implementation and the implementation is provided by the derived FB</td>
</tr>
<tr>
<td>“Add”</td>
<td>Adds a new method below the selected object.</td>
</tr>
</tbody>
</table>
When you doing object-oriented programming and using the inheritance (keyword `EXTENDS`) of POUs, you can get support as follows:

When you insert an action, a property, a method, or a transition below a POU derived from a base POU, the “Add ...” dialog opens. Then the input field for the name extends to a list box. The list box contains a valid selection from the actions, properties, methods, or transitions available in the base POU. Now you can, for example, easily accept a method of the base POU and then adapt it to the derived function of the POU.

Methods and properties with the access modifier `PRIVATE` are not listed here because they are also not inherited. Methods and properties with the access modifier `PUBLIC` automatically get a blank access modifier field when accepting into the derived POU, which means the same thing functionally.

Example

See also

- Chapter 6.4.1.9.22 “Object-Oriented Programming” on page 1929
- Chapter 6.4.1.21.2.21.10 “Object ‘Action’” on page 2497
- Chapter 6.4.1.21.2.21.9 “Object ‘Property’” on page 2493
- Chapter 6.4.1.21.2.21.6 “Object ‘Method’” on page 2485
- Chapter 6.4.1.21.2.21.11 “Object ‘Transition’” on page 2499

See also

- Chapter 6.4.1.20.1.4.2 “ST editor in online mode” on page 2050
- Chapter 6.4.1.13.2.3 “Using watch lists” on page 2002
- Chapter 6.4.1.20.2.10 “Instance variables - VAR_INST” on page 2120
Object 'Interface Method''

Symbol: 

This object is used for object-oriented programming.

The object “Interface Method” is added to an interface via the command “Project ➔ Add Object”.

If a method is inserted underneath an interface, you can add and instance only variable declarations (input, output and input/output variables) in this method.

You can only add program code to the method if a function block 'implements' the interface to which the method belongs. CODESYS then inserts the method underneath the function block.

See also
- Chapter 6.4.1.21.2.21.5 “Object 'Interface’” on page 2484
- Chapter 6.4.1.21.2.21.6 “Object 'Method’” on page 2485
- Chapter 6.4.1.9.22.3 “Implementing interfaces” on page 1931

Object 'Interface Property''

Symbol: 

Interface properties are an extension of the IEC 61131-3 standard and a tool for object-oriented programming. An interface property declares the accessor methods Get and Set (no implementation code). Therefore, a function block that implements an interface also inherits their interface properties.

You can add an interface property to the device tree for an interface. Then an interface is extended with the accessor methods Get and Set. The Get accessor is for read access. The Set accessor is for write access. You can delete an unneeded accessor. Click “Project ➔ Add Object ➔ Interface Property” to add an accessor. The “Add Interface Property” dialog opens.

See also
- Chapter 6.4.1.21.2.21.5 “Object 'Interface’” on page 2484
- Chapter 6.4.1.21.2.21.9 “Object 'Property’” on page 2493
This interface \texttt{itf\_A} has the property \texttt{Literal\_A} with the accessor methods \texttt{Get} and \texttt{Set}. The function blocks \texttt{fb\_A1} and \texttt{fb\_A2} implement the interface \texttt{itf\_A} and therefore inherit its interface property. Each FB has its own implementation.

\begin{verbatim}
INTERFACE itf_A
VAR
PROPERTY Literal_A : STRING
END_VAR

FUNCTION_BLOCK fb_A1 IMPLEMENTS itf_A
VAR
    str_1 : STRING;
    str_2 : STRING;
    iCnt : INT;
END_VAR
    iCnt := iCnt + 1;
    str_1 := 'Function block A1';
\end{verbatim}
VAR
END_VAR
Literal_A := CONCAT (str_1,' and property.');

VAR
END_VAR
str_2 := Literal_A;

FUNCTION_BLOCK fb_A2 IMPLEMENTS itf_A
VAR
str_1 : STRING;
str_2 : STRING;
iCnt : INT;
END_VAR

iCnt := iCnt + 1;
str_1 := 'Function block A2';

VAR
END_VAR
str_1 := 'Function block A1';

VAR
END_VAR
str_1 := str_1;

VAR
END_VAR
str_2 := Literal_A;

PROGRAM PLC_PRG
VAR
iCnt : INT;
my_1 : fb_A1;
my_2 : fb_A2;
strName_1 : STRING;
strName_2: STRING;
END_VAR

iCnt := iCnt + 1;
my_1();
my_2();
strName_1:= my_1.Literal_A;
strName_2:= my_2.Literal_A;
my_1.Literal_A := 'Hello 1';
my_2.Literal_A := 'World 2';

This leads to the following monitoring of PLC_PRG when the application is in runtime mode:
Object 'Property'

Symbol: Property

Keyword: PROPERTY

Properties are an extension of the IEC 61131-3 standard and a tool for object-oriented programming.

Properties are used for data encapsulation because they allow for external access to data and act as filters at the same time. For this purpose, a property provides the accessor methods Get and Set which allows for read and write access to the data of the instance below the property.

You can add a property with accessor methods below a program, a function block, or a global variable list. Click “Project ➔ Add Object ➔ Property” to open the “Add Property” dialog.

You can add an interface property below an interface.

When you copy a property that is inserted below a POU and add it below an interface, or if you move the property there, the included implementations are removed automatically.

See also

● Chapter 6.4.1.21.2.21.8 “Object 'Interface Property'” on page 2490

Dialog 'Add Property'

Function: Creates a new property below the selected POU when the dialog is closed.

Call: Menu bar: “Project ➔ Add Object ➔ Property”; context menu

Requirement: A program (PRG), a function block (FUNCTION_BLOCK), or a global variable list (GVL) is selected in the “POUs” view or the “Devices” view.

<table>
<thead>
<tr>
<th>“Name”</th>
<th>Name (identifier) of the property</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: prop_iA</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Return type”</th>
<th>Default type or structured type of return value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: INT</td>
<td></td>
</tr>
</tbody>
</table>

<p>| “Implementation language” | Example: “Structured Text (ST)” |</p>
<table>
<thead>
<tr>
<th>Access specifier</th>
<th>Controls access to data</th>
</tr>
</thead>
<tbody>
<tr>
<td>PUBLIC or unspecified</td>
<td>Access is not restricted.</td>
</tr>
<tr>
<td>PRIVATE</td>
<td>Access is restricted to the program, function block, or GVL. The object is marked as (private) in the POU or device view. The declaration contains the keyword PRIVATE.</td>
</tr>
<tr>
<td>PROTECTED</td>
<td>Access is restricted to the program, function block, or GVL with its derivations. The object is marked as (protected) in the POU or device view. The declaration contains the keyword PROTECTED.</td>
</tr>
<tr>
<td>INTERNAL</td>
<td>Access is restricted to the namespace (library). The object is marked as (internal) in the POU or device view. The declaration contains the keyword INTERNAL.</td>
</tr>
<tr>
<td>Abstract</td>
<td>☑️: Identifies that the property does not have an implementation and the implementation is provided by the derived FB</td>
</tr>
<tr>
<td>Add</td>
<td>Adds a new property below the selected object and below that the accessor methods Get and Set Note: When you select a property, you can also add a previously removed accessor explicitly by clicking “Add Object”.</td>
</tr>
</tbody>
</table>

**Editor 'Property'**

You can program the data access in the editor. The code can contain additional local variables. However, it must not contain any additional input variables or (as opposed to a function or method) output variables.
FUNCTION_BLOCK FB_A
VAR_INPUT
END_VAR
VAR_OUTPUT
END_VAR
VAR
iA : INT;
END_VAR
iA := iA + 1;
PROPERTY PUBLIC prop_iA : INT
prop_iA := iA;
iA := prop_iA;
PROGRAM PLC_PRG
VAR
fbA : FB_A;
iVar: INT;
END_VAR
fbA();
IF fbA.prop_iA > 500 THEN
  fbA.prop_iA := 0;
END_IF
iVar := fbA.prop_iA;

Get and Set accessors

The call of the Set accessor is written to the property. Then it is used in the same way as an input parameter. When the Get accessor is called, the property is read. It is used in the same way as an output parameter. Access is restricted in each case by means of access modifiers (qualifiers). As a result, the objects are identified accordingly.

When a property is accessed as read only or write only, you can delete the unneeded accessors.

You can add accessors explicitly by selecting a property and clicking “Add Object”. A dialog opens, either “Add Get accessor” or “Add Set accessor”. There you can set the implementation language and the access.

Table 438: Dialog “Add Get (Set) Accessor”

<table>
<thead>
<tr>
<th>“Implementation language”</th>
<th>Example: “Structured Text (ST)”</th>
</tr>
</thead>
</table>

Example

Function block

FB_A

FUNCTION_BLOCK FB_A
VAR_INPUT
END_VAR
VAR_OUTPUT
END_VAR
VAR
iA : INT;
END_VAR
iA := iA + 1;
PROPERTY PUBLIC prop_iA : INT
prop_iA := iA;
iA := prop_iA;
PROGRAM PLC_PRG
VAR
fbA : FB_A;
iVar: INT;
END_VAR
fbA();
IF fbA.prop_iA > 500 THEN
  fbA.prop_iA := 0;
END_IF
iVar := fbA.prop_iA;
### Access specifier

<table>
<thead>
<tr>
<th>Access specifier</th>
<th>Qualifier for the declaration part</th>
</tr>
</thead>
<tbody>
<tr>
<td>PUBLIC or unspecified</td>
<td>Access is not restricted.</td>
</tr>
<tr>
<td>PRIVATE</td>
<td>Access is restricted to the program, function block, or GVL. The object is marked as (private) in the POU or device view. The declaration contains the keyword.</td>
</tr>
<tr>
<td>PROTECTED</td>
<td>Access to the property is restricted to the program, function block, or GVL and its derivations. The declaration contains the keyword. The object is marked as (protected) in the POU or device view.</td>
</tr>
<tr>
<td>INTERNAL</td>
<td>Access to the method is restricted to the namespace (the library). The object is marked as (internal) in the POU or device view. The declaration contains the keyword.</td>
</tr>
</tbody>
</table>

### “Add”

Adds the accessor methods `Get` or `Set` below the selected property.

### Monitoring of properties in online mode

The following pragmas are provided for the monitoring of properties in online mode. You insert them at the top position of the property definition:

- `{attribute 'monitoring' := 'variable'}`
  - Each time the property is accessed, CODESYS saves the actual value to a variable and displays the value of this variable. This value can become outdated if no more access to the property takes place in the code.
- `{attribute 'monitoring' := 'call'}`
  - Each time the value is displayed, CODESYS calls the code of the `Get` accessor. If this code contains a side effect, then the monitoring executes the side effect.

You can monitor a property with the help of the following functions:

- Inline monitoring
  - Requirement: The “Enable inline monitoring” option is selected in the “Text Editor” category of the “Options” dialog.
- Watch List

See also

- Chapter 6.4.1.20.6.3.26 “Attribute ‘monitoring’” on page 2295

### Input support when generating inheriting POU

When you doing object-oriented programming and using the inheritance (keyword `EXTENDS`) of POU, you can get support as follows:

When you insert an action, a property, a method, or a transition below a POU derived from a base POU, the “Add …” dialog opens. Then the input field for the name extends to a list box. The list box contains a valid selection from the actions, properties, methods, or transitions available in the base POU. Now you can, for example, easily accept a method of the base POU and then adapt it to the derived function of the POU.

Methods and properties with the access modifier `PRIVATE` are not listed here because they are also not inherited. Methods and properties with the access modifier `PUBLIC` automatically get a blank access modifier field when accepting into the derived POU, which means the same thing functionally.
Object ‘Action’

Symbol: 

Implement more program code in an action. You can implement this program code as the base implementation in another language. The base implementation is a function block or a program where you inserted the action.

An action does not have its own declaration and it works with the data from the base implementation. This means that the action uses the input and output variables and the local variables from its base implementation.

Add an “Action” to a function block or program by clicking “Project ➔ Add Object ➔ Action”.

See also

- % Chapter 6.4.1.9.22 “Object-Oriented Programming” on page 1929
- % Chapter 6.4.1.21.2.21.10 “Object 'Action’” on page 2497
- % Chapter 6.4.1.21.2.21.9 “Object 'Property’” on page 2493
- % Chapter 6.4.1.21.2.21.6 “Object 'Method’” on page 2485
- % Chapter 6.4.1.21.2.21.11 “Object 'Transition’” on page 2499
When you are doing object-oriented programming and using the inheritance (keyword `EXTENDS`) of POUs, you can get support as follows:

When you insert an action, a property, a method, or a transition below a POU derived from a base POU, the "Add …" dialog opens. Then the input field for the name extends to a list box. The list box contains a valid selection from the actions, properties, methods, or transitions available in the base POU. Now you can, for example, easily accept a method of the base POU and then adapt it to the derived function of the POU.

Methods and properties with the access modifier `PRIVATE` are not listed here because they are also not inherited. Methods and properties with the access modifier `PUBLIC` automatically get a blank access modifier field when accepting into the derived POU, which means the same thing functionally.

See also

- Chapter 6.4.1.9.22 “Object-Oriented Programming” on page 1929
- Chapter 6.4.1.21.2.21.10 “Object ‘Action’” on page 2497
- Chapter 6.4.1.21.2.21.9 “Object ‘Property’” on page 2493
- Chapter 6.4.1.21.2.21.6 “Object ‘Method’” on page 2485
- Chapter 6.4.1.21.2.21.11 “Object ‘Transition’” on page 2499
Calling an action

Syntax:

<program>.<action> or <FB instance>.<action>

To call an action from only within the base implementation, you only have to provide the action name.

Examples

Calling a “Reset” action from another POU

The call is not executed from the base implementation.

Declaration:

PROGRAM PLC_PRG
VAR
    Inst : Counter;
END_VAR

Calling a “Reset” action from an IL POU

CAL Inst.Reset(In := FALSE)
LD Inst.Out
ST ERG

Calling a “Reset” action from an ST POU

Inst.Reset(In := FALSE);
Erg := Inst.out;

Calling a “Reset” action from an FBD POU

Examples

Actions are used frequently in the SFC implementation language.

See also

● § Chapter 6.4.1.20.1.5.8.2 “SFC Element 'Action’” on page 2075

Object 'Transition'

Symbol: 

The object can be used as a transition element in a program block implemented in SFC.

See also

● § Chapter 6.4.1.20.1.5.8.1 “SFC elements 'Step' and 'Transition’” on page 2073

Input support when generating inheriting POU

When you doing object-oriented programming and using the inheritance (keyword **EXTENDS**) of POU, you can get support as follows:

When you insert an action, a property, a method, or a transition below a POU derived from a base POU, the “Add …” dialog opens. Then the input field for the name extends to a list box. The list box contains a valid selection from the actions, properties, methods, or transitions available in the base POU. Now you can, for example, easily accept a method of the base POU and then adapt it to the derived function of the POU.
Methods and properties with the access modifier `PRIVATE` are not listed here because they are also not inherited. Methods and properties with the access modifier `PUBLIC` automatically get a blank access modifier field when accepting into the derived POU, which means the same thing functionally.

### Example

![Image showing a PLC block diagram with an FB_B function block extending FB_A and a property named `prop_IA` being added.](image)

See also

- § Chapter 6.4.1.9.22 “Object-Oriented Programming” on page 1929
- § Chapter 6.4.1.21.2.21.10 “Object 'Action'” on page 2497
- § Chapter 6.4.1.21.2.21.9 “Object 'Property'” on page 2493
- § Chapter 6.4.1.21.2.21.6 “Object 'Method'” on page 2485
- § Chapter 6.4.1.21.2.21.11 “Object 'Transition'” on page 2499

### Object 'POUs for Implicit Checks'

#### General

You can add these special POUs to an application to equip them with implicit monitoring functions. At runtime, these functions check the limits of arrays or subrange types, the validity of pointer addresses, and division by zero. Please note: This option can be disabled for devices that are already equipped with these kinds of monitoring blocks by a special implicit library.

The command “Add Object ➔ POU for Implicit Checks” is used for adding to the application. The command opens the “Add POU for Implicit Checks” dialog where you can select a monitoring function type (see table below). Depending on the monitoring function, you have to adapt the implementation code or create it yourself from scratch.
To prevent multiple inclusions, monitoring functions that have already been inserted are disabled in the “Add POU for Implicit Checks” dialog.

**NOTICE!**

To get the feature for monitoring functions, do not edit their declaration part. However, you are permitted to add local variables.

After removing an implicit monitoring function (example: Check Bounds) from the project, only a download is possible, not an online change. A corresponding message is issued.

By default, CODESYS does not run implicit checks for function blocks from libraries used in the application. However, you can extend the check to the libraries by opening the “Properties” dialog of the application and specifying the compiler definition `checks_in_libs` in the “Compiler-Defines” field in the “Build” tab. This definition affects implementation libraries (*.library) only, not protected libraries (*.compiled-library).

You can use the “no_check” attribute to deactivate the check for special POUs in the project.

Table 440: “Available Functions”

<table>
<thead>
<tr>
<th>Monitoring function</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Check Bounds”</td>
<td>“Bound Checks”</td>
</tr>
<tr>
<td></td>
<td>Appropriate handling of bound violations; such handling includes setting flags or changing field indices.</td>
</tr>
<tr>
<td>“CheckDivDInt”</td>
<td>“Division checks”:</td>
</tr>
<tr>
<td>“CheckDivLInt”</td>
<td>Monitors the divisor value to avoid division by zero.</td>
</tr>
<tr>
<td>“CheckDivReal”</td>
<td></td>
</tr>
<tr>
<td>“CheckDivLReal”</td>
<td></td>
</tr>
<tr>
<td>“CheckRangeSigned”</td>
<td>“Range checks”:</td>
</tr>
<tr>
<td>“CheckRangeUnsigned”</td>
<td>Monitors the range limit of a subrange type in runtime mode. Valid for data types DINT/UDINT.</td>
</tr>
<tr>
<td>“CheckLRangeSigned”</td>
<td>“L-range checks”:</td>
</tr>
<tr>
<td>“CheckLRangeUnsigned”</td>
<td>Monitors the range limit of a subrange type in runtime mode. Valid for data types LINT/ULINT.</td>
</tr>
<tr>
<td>“CheckPointer”</td>
<td>“Pointer checks”</td>
</tr>
<tr>
<td></td>
<td>You are responsible for filling in this function completely with implementation code. Refer to the help page for “POU ‘CheckPointer’”. The function should monitor whether the passed pointer reference a valid memory address, and whether the orientation of the referenced memory area matches the variable type to which the pointer refers. If both conditions are fulfilled, then the pointer is returned. If not, then CheckPointer should complete an appropriate error handling. CheckPointer monitors the same way as variables of type REFERENCE TO.</td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.1.9.21 “Using POUs for implicit checks” on page 1928
- Chapter 6.4.1.21.2.22.2 “POU ‘CheckBounds’” on page 2502
- Chapter 6.4.1.21.2.22.3 “POU ‘CheckDivInt’” on page 2505
- Chapter 6.4.1.21.2.22.4 “POU ‘CheckDivLInt’” on page 2505
POU 'CheckBounds'

Functions for Bound Checks: CheckBounds

The task of this monitoring function is to handle bound violations appropriately. Examples of reactions to violations include setting error flags and changing the value of the array index. The check is performed only for one variable array index. An incorrect constant array index causes a compiler error. CODESYS calls the function implicitly when values are assigned to an ARRAY variable.

After inserting the function, you receive automatically generated code in the declaration and implementation parts. See below.

CAUTION!
To obtain the feature for monitoring functions, do not edit the declaration part. However, you are permitted to add local variables.

Declaration part

// Automatically generated code: DO NOT EDIT
FUNCTION CheckBounds : DINT
VAR_INPUT
index, lower, upper: DINT;
END_VAR

Implementation

// This automatically generated code is a suggested implementation.
IF index < lower THEN
  CheckBounds := lower;
ELSIF index > upper THEN
  CheckBounds := upper;
ELSE
  CheckBounds := index;
END_IF

(* It is also possible to set a breakpoint, log messages or e.g. to halt on an exception: Add CmpApp.library, SysExcept.library and SysTypes2_Itf as newest.
Declaration:
VAR
  _pApp : POINTER TO CmpApp.APPLICATION;
  _result   : SysTypes.RTS_IEC_RESULT;
END_VAR

Implementation:
  _pApp := AppGetCurrent(pResult:=_result);
  IF index < lower THEN
    CheckBounds := lower;
    IF _pApp <> 0 THEN
      AppGenerateException(pApp:=_pApp,
        ulException:=RtsExceptions.RTSEXCPT_ARRAYBOUNDS);
    END_IF
  ELSIF index > upper THEN
    CheckBounds := upper;
    IF _pApp <> 0 THEN
      AppGenerateException(pApp:=_pApp,
When the “CheckBounds” function is called, it receives the following input parameters:

- **index**: Index of the array element
- **lower**: Lower limit of the array range
- **upper**: Upper limit of the array range

The return value is the index of the array element, as long as it is within a valid range. If not, then the CODESYS returns either the upper or lower limit, depending on which threshold was violated.

### Example: Correction of the access to an array outside the defined array bounds

In the sample program below, the index falls short of the defined lower limit of the `a` array.

```plaintext
PROGRAM PLC_PRG
VAR
  a: ARRAY[0..7] OF BOOL;
  b: INT:=10;
END_VAR
  a[b]:=TRUE;
```

In this example, the `CheckBounds` function causes `a` to change the upper limit of the array range index to 10. The value `TRUE` is assigned then to the element `a[7]`. In this way, the function corrects array access outside of the valid array range.
Add the following libraries in the library manager of the application:

- CmpApp.library and SysExcept.library as placeholder libraries
- SysTypes2.Itfs.library with “Newest version always”

Add a “CheckBounds” object below the application and modify the specified code as shown below.

**FUNCTION CheckBounds : DINT**
**VAR_INPUT**
  - index, lower, upper: DINT;
**END_VAR**
**VAR**
  - _pApp : POINTER TO CmpApp.APPLICATION;
  - _Result : ISystypes2.RTS_IEC_RESULT;
**END_VAR**

```
// This automatically generated code is a suggested implementation.
_pApp := AppGetCurrent(pResult := _Result);
IF index < lower THEN
  CheckBounds := lower;
IF _pApp <> 0 THEN
  AppGenerateException(pApp := _pApp, ulException := RtsExceptions.RTSEXCPT_ARRAYBOUNDS);
END_IF
ELSIF index > upper THEN
  CheckBounds := upper;
IF _pApp <> 0 THEN
  AppGenerateException(pApp:=_pApp,
                       ulException:=RtsExceptions.RTSEXCPT_ARRAYBOUNDS);
END_IF
ELSE
  CheckBounds := index;
END_IF
```

**Program a “MAIN_PRG” object below the application with the contents shown below.**

**PROGRAM MAIN_PRG**
**VAR**
  - xInit : BOOL;
  - arData : ARRAY[0..7] OF BYTE;
  - i : INT;
  - dwAdr : DWORD;
**END_VAR**

```
IF NOT xInit THEN
  // Required for CheckBounds
  xInit := TRUE;
END_IF

// Set i to a value > 7 or < 0
// Generates an exception in CheckBounds, user-defined
arData[i] := 11;
```

When you load and start this application, an exception will be thrown when array bounds are violated. Processing stops in “CheckBounds” so that the type of error can be detected.

See also:

- § Chapter 6.4.1.9.21 “Using POU for implicit checks” on page 1928
- § Chapter 6.4.1.21.2.8.9 “Tab ‘Log’” on page 2437
POU 'CheckDivInt'

Functions for preventing division by zero: CheckDivInt, CheckDivLint, CheckDivReal, and CheckDivLReal. To prevent division by zero, you can use the functions CheckDivInt, CheckDivLint, CheckDivReal, and CheckDivLReal. If you include these functions in the application, then they are called before each division operation in the code.

CAUTION!
To obtain the feature for monitoring functions, do not edit the declaration section. However, you are permitted to add local variables.

The declaration section:

```c
// This is automatically generated code: DO NOT EDIT
FUNCTION CheckDivReal : REAL
VAR_INPUT
    divisor:REAL;
END_VAR
```

The implementation section:

```c
// This automatically generated code is a suggested implementation.
IF divisor = 0 THEN
    CheckDivReal:=1;
ELSE
    CheckDivReal:=divisor;
END_IF;
```

The DIV operator uses the output of the CheckDivReal function as a divisor. In the sample program below, CheckDivReal prevents division by 0 by changing the implicit value of the divisor d from "0" to 1 before the division operation is executed. Therefore, the division result is 799.

```c
PROGRAM PLC_PRG
VAR
    erg:REAL;
    v1:REAL:=799;
    d:REAL:=0;
END_VAR
erg:= v1 / d;
```

See also
- Chapter 6.4.1.9.21 “Using POU for implicit checks” on page 1928

POU 'CheckDivLInt'

Functions for preventing division by zero: CheckDivInt, CheckDivLint, CheckDivReal, and CheckDivLReal. To prevent division by zero, you can use the functions CheckDivInt, CheckDivLint, CheckDivReal, and CheckDivLReal. If you include these functions in the application, then they are called before each division operation in the code.
CAUTION!
To obtain the feature for monitoring functions, do not edit the declaration section. However, you are permitted to add local variables.

**The default implementation of CheckDivReal:**

Declaration section:

```plaintext
// This is automatically generated code: DO NOT EDIT
FUNCTION CheckDivReal : REAL
VAR_INPUT
    divisor: REAL;
END_VAR
```

Implementation section:

```plaintext
// This automatically generated code is a suggested implementation.
IF divisor = 0 THEN
    CheckDivReal := 1;
ELSE
    CheckDivReal := divisor;
END_IF;
```

The **DIV** operator uses the output of the **CheckDivReal** function as a divisor. In the sample program below, **CheckDivReal** prevents division by 0 by changing the implicit value of the divisor `d` from "0" to 1 before the division operation is executed. Therefore, the division result is 799.

```plaintext
PROGRAM PLC_PRG
VAR
    erg: REAL;
    v1: REAL := 799;
    d: REAL := 0;
END_VAR

erg := v1 / d;
```

See also

- Chapter 6.4.1.9.21 “Using POUs for implicit checks” on page 1928

**POU 'CheckDivReal'**

Functions for preventing division by zero: **CheckDivInt**, **CheckDivLint**, **CheckDivReal**, and **CheckDivLReal**

To prevent division by zero, you can use the functions **CheckDivInt**, **CheckDivLint**, **CheckDivReal**, and **CheckDivLReal**. If you include these functions in the application, then they are called before each division operation in the code.

CAUTION!
To obtain the feature for monitoring functions, do not edit the declaration section. However, you are permitted to add local variables.
The default implementation of CheckDivReal:

```plaintext
// This is automatically generated code: DO NOT EDIT
FUNCTION CheckDivReal : REAL
VAR_INPUT
  divisor:REAL;
END_VAR

Implementation section:

// This automatically generated code is a suggested implementation.
IF divisor = 0 THEN
  CheckDivReal:=1;
ELSE
  CheckDivReal:=divisor;
END_IF;
```

The DIV operator uses the output of the CheckDivReal function as a divisor. In the sample program below, CheckDivReal prevents division by 0 by changing the implicit value of the divisor d from "0" to 1 before the division operation is executed. Therefore, the division result is 799.

```plaintext
PROGRAM PLC_PRG
VAR
  erg:REAL;
  v1:REAL:=799;
  d:REAL:=0;
END_VAR
  erg:= v1 / d;
```

See also

- § Chapter 6.4.1.9.21 “Using POUas for implicit checks” on page 1928

POU 'CheckDivLReal'

Functions for preventing division by zero: CheckDivInt, CheckDivLint, CheckDivReal, and CheckDivLReal

To prevent division by zero, you can use the functions CheckDivInt, CheckDivLint, CheckDivReal, and CheckDivLReal. If you include these functions in the application, then they are called before each division operation in the code.

CAUTION!

To obtain the feature for monitoring functions, do not edit the declaration section. However, you are permitted to add local variables.
**The default implementation of CheckDivReal:**

```plaintext
// This is automatically generated code: DO NOT EDIT
FUNCTION CheckDivReal : REAL
VAR_INPUT
  divisor:REAL;
END_VAR

Implementation section:
// This automatically generated code is a suggested implementation.
IF divisor = 0 THEN
  CheckDivReal:=1;
ELSE
  CheckDivReal:=divisor;
END_IF;
```

The DIV operator uses the output of the CheckDivReal function as a divisor. In the sample program below, CheckDivReal prevents division by 0 by changing the implicit value of the divisor d from "0" to 1 before the division operation is executed. Therefore, the division result is 799.

```plaintext
PROGRAM PLC_PRG
VAR
  erg:REAL;
  v1:REAL:=799;
  d:REAL:=0;
END_VAR
erg:= v1 / d;
```

See also

- § Chapter 6.4.1.9.21 “Using POU for implicit checks” on page 1928

**POU 'CheckRangeSigned'**

Function for monitoring the range limits of a subrange type of type DINT.

This monitoring function is responsible for the appropriate handling violations to range limits. Examples of reactions to violations include setting error flags and changing values. The functions are called implicitly when a value is assigned to a subrange type variable.

**CAUTION!**

To obtain the feature for monitoring functions, do not edit the declaration section. However, you are permitted to add local variables.

When the function is called, it receives the following input parameters:

- **value**: Value that should be assigned to the subrange type variables
- **lower**: Lower range limit
- **upper**: Upper range limit

The return value is the assignment value as long as it is within the valid range. If not, then either the upper or lower limit is returned, depending on which threshold was violated.

For example, the assignment `i := 10*y` is replaced implicitly by `i := CheckRangeSigned(10*y, -4095, 4095);`
If \( y \) is "1000", then "10*1000=10000" is not assigned to \( i \) like in the original code. Instead, the upper range limit of "4095" is assigned.

The same is true for \texttt{CheckRangeUnsigned} function.

\begin{center}

\textbf{NOTICE!}

If functions are not available, then the subrange is not checked for the respective variables at runtime. In this case, you can assign any value between -2147483648 and +2147483648 (or between 0 and 4294967295) to a variable of subrange type \texttt{DINT/UDINT}. You can assign any value between -9223372036854775808 and +9223372036854775807 (or between 0 and 18446744073709551615) to a variable of a subrange type \texttt{LINT/ULINT}.

\end{center}

\begin{center}

\textbf{CAUTION!}

Linking area monitoring functions can lead to endless loops. For example, an endless loop can occur if the counter variable of a FOR loop is a subrange type and the counting range for the loop exits the defined subrange.

\end{center}

\begin{center}

\textbf{Example of an endless loop:}

\texttt{VAR}
\begin{Verbatim}
ui : UINT (0..10000);
...
END_VAR

FOR ui:=0 TO 10000 DO
... END_FOR
\end{Verbatim}

The program never exits the FOR loop because the \texttt{CheckRangeSigned} monitoring function prevents \( ui \) from being set to a value greater than 10000.

\end{center}

\begin{center}

\textbf{Example for \texttt{CheckRangeSigned}}

The assignment of a value to a \texttt{DINT} variable of a signed subrange type is a condition for automatically calling the \texttt{CheckRangeSigned}. This function restricts the assignment value to the subrange as defined in the variables declaration. The default implementation of the function in \texttt{ST} is as follows:

\texttt{Declaration section:}

\begin{Verbatim}
// This is automatically generated code: DO NOT EDIT
FUNCTION CheckRangeSigned : DINT
VAR_INPUT
    value, lower, upper: DINT;
END_VAR

\end{Verbatim}

\texttt{Implementation:}

\begin{Verbatim}
// This automatically generated code is a suggested implementation.
IF (value < lower) THEN
    CheckRangeSigned := lower;
ELSEIF (value > upper) THEN
    CheckRangeSigned := upper;
ELSE
    CheckRangeSigned := value;
END_VAR
\end{Verbatim}

\end{center}
POU 'CheckLRangeSigned'

Function for monitoring the range limits of a subrange type of type LINT.

For an implementation example of range monitoring, refer to the help page for the CheckRangeSigned function.

This monitoring function is responsible for the appropriate handling violations to range limits. Examples of reactions to violations include setting error flags and changing values. The functions are called implicitly when a value is assigned to a subrange type variable.

CAUTION!
To obtain the feature for monitoring functions, do not edit the declaration section. However, you are permitted to add local variables.

When the function is called, it receives the following input parameters:

- **value**: Value that should be assigned to the subrange type variables
- **lower**: Lower range limit
- **upper**: Upper range limit

The return value is the assignment value as long as it is within the valid range. If not, then either the upper or lower limit is returned, depending on which threshold was violated.

For example, the assignment `i := 10*y` is replaced implicitly by `i := CheckRangeSigned(10*y, -4095, 4095);`

If `y` is "1000", then "10*1000=10000" is not assigned to `i` like in the original code. Instead, the upper range limit of "4095" is assigned.

The same is true for CheckRangeUnsigned function.

NOTICE!
If functions are not available, then the subrange is not checked for the respective variables at runtime. In this case, you can assign any value between -2147483648 and +2147483648 (or between 0 and 4294967295) to a variable of subrange type DINT/UDINT. You can assign any value between -9223372036854775808 and +9223372036854775807 (or between 0 and 18446744073709551615) to a variable of a subrange type LINT/ULINT.

CAUTION!
Linking area monitoring functions can lead to endless loops. For example, an endless loop can occur if the counter variable of a FOR loop is a subrange type and the counting range for the loop exits the defined subrange.
Example of an endless loop:

```plaintext
VAR
  ui : UINT (0..10000);
...
END_VAR

FOR ui:=0 TO 10000 DO
  ...
END_FOR
```

The program never exits the FOR loop because the `CheckRangeSigned` monitoring function prevents `ui` from being set to a value greater than 10000.

See also
- `Chapter 6.4.1.9.21 “Using POU's for implicit checks” on page 1928`
- `Chapter 6.4.1.21.2.22.7 “POU 'CheckRangeSigned'” on page 2508`

**POU 'CheckRangeUnsigned'**

Function for monitoring the range limits of a subrange type of type UDINT.

For an implementation example of range monitoring, refer to the help page for the `CheckRangeSigned` function.

This monitoring function is responsible for the appropriate handling violations to range limits. Examples of reactions to violations include setting error flags and changing values. The functions are called implicitly when a value is assigned to a subrange type variable.

**CAUTION!**

To obtain the feature for monitoring functions, do not edit the declaration section. However, you are permitted to add local variables.

When the function is called, it receives the following input parameters:
- `value`: Value that should be assigned to the subrange type variables
- `lower`: Lower range limit
- `upper`: Upper range limit

The return value is the assignment value as long as it is within the valid range. If not, then either the upper or lower limit is returned, depending on which threshold was violated.

For example, the assignment `i := 10*y` is replaced implicitly by `i := CheckRangeSigned(10*y, -4095, 4095);`

If `y` is "1000", then "10*1000=10000" is not assigned to `i` like in the original code. Instead, the upper range limit of "4095" is assigned.

The same is true for `CheckRangeUnsigned` function.

**NOTICE!**

If functions are not available, then the subrange is not checked for the respective variables at runtime. In this case, you can assign any value between -2147483648 and +2147483648 (or between 0 and 4294967295) to a variable of subrange type DINT/UDINT. You can assign any value between -9223372036854775808 and +9223372036854775807 (or between 0 and 18446744073709551615) to a variable of a subrange type LINT/ULINT.
CAUTION!
Linking area monitoring functions can lead to endless loops. For example, an endless loop can occur if the counter variable of a FOR loop is a subrange type and the counting range for the loop exits the defined subrange.

Example of an endless loop:

```plaintext
VAR
  ui : UINT (0..10000);
...
END_VAR

FOR ui:=0 TO 10000 DO
...
END_FOR

The program never exits the FOR loop because the CheckRangeSigned monitoring function prevents ui from being set to a value greater than 10000.
```

See also
- Chapter 6.4.1.9.21 “Using POU for implicit checks” on page 1928
- Chapter 6.4.1.21.22.7 “POU 'CheckRangeSigned’” on page 2508

POU 'CheckLRangeUnsigned'

Function for monitoring the range limits of a subrange type of type ULINT.

For an implementation example of range monitoring, refer to the help page for the CheckRangeSigned function.

This monitoring function is responsible for the appropriate handling violations to range limits. Examples of reactions to violations include setting error flags and changing values. The functions are called implicitly when a value is assigned to a subrange type variable.

CAUTION!
To obtain the feature for monitoring functions, do not edit the declaration section. However, you are permitted to add local variables.

When the function is called, it receives the following input parameters:
- `value`: Value that should be assigned to the subrange type variables
- `lower`: Lower range limit
- `upper`: Upper range limit

The return value is the assignment value as long as it is within the valid range. If not, then either the upper or lower limit is returned, depending on which threshold was violated.

For example, the assignment `i := 10*y` is replaced implicitly by `i := CheckRangeSigned(10*y, -4095, 4095);`

If `y` is "1000", then "10*1000=10000" is not assigned to `i` like in the original code. Instead, the upper range limit of "4095" is assigned.

The same is true for CheckRangeUnsigned function.
NOTICE!
If functions are not available, then the subrange is not checked for the respective variables at runtime. In this case, you can assign any value between -2147483648 and 2147483647 (or between 0 and 4294967295) to a variable of subrange type DINT/UDINT. You can assign any value between -9223372036854775808 and 9223372036854775807 (or between 0 and 18446744073709551615) to a variable of a subrange type LINT/ULINT.

CAUTION!
Linking area monitoring functions can lead to endless loops. For example, an endless loop can occur if the counter variable of a FOR loop is a subrange type and the counting range for the loop exits the defined subrange.

Example of an endless loop:

```
VAR
  ui : UINT (0..10000);
  ...
END_VAR

FOR ui:=0 TO 10000 DO
  ...
END_FOR
```

The program never exits the FOR loop because the CheckRangeSigned monitoring function prevents `ui` from being set to a value greater than 10000.

See also
- § Chapter 6.4.1.9.21 “Using POU for implicit checks” on page 1928
- § Chapter 6.4.1.21.21.22.7 “POU ‘CheckRangeSigned’” on page 2508

POU 'CheckPointer'

Monitoring function for pointers (Checkpointer)

Use this function to monitor the memory access of pointers in runtime mode. As opposed to other monitoring functions, a standard suggestion does not exist for the implementation of CheckPointer. You must define an implementation according to your own requirements.

The CheckPointer function should check whether the returned pointer references a valid memory address; monitors whether the orientation of the referenced memory range matches the variable type that the pointer refers to. If both conditions are fulfilled, then the pointer is returned. If not, then the function should complete an appropriate error handling.

CAUTION!
To obtain the feature for monitoring functions, do not edit the declaration section. However, you are permitted to add local variables.

NOTICE!
An implicit monitoring function call does not occur for THIS pointer and SUPER pointer.
NOTICE!

For compiler version 3.5.7.40 and later, the implicit check function "Checkpointer" also acts on REFERENCE variables in the same way as on pointer variables.

FUNCTION CheckPointer : POINTER TO BYTE
VAR_INPUT
   ptToTest : POINTER TO BYTE;
   iSize : DINT;
   iGran : DINT;
   bWrite: BOOL;
END_VAR

// Not a standard implementation. Please add your own code here.
CheckPointer := ptToTest;

When the function is called, CODESYS provides the following input parameters:

- `ptToTest`: Target address of the pointer
- `iSize`: Size of the referenced variable; the data type of `iSize` must be compatible with INT and cover the dimensional scope of the variables.
- `iGran`: Granularity of the referenced size; this is the largest non-structured data type contained in the referenced variables; the data type of `iGran` must be compatible with INT
- `bWrite`: Access type (TRUE = write access, FALSE = read access); the data type of `bWrite` must be BOOL

When the result of the check is positive, the unchanged pointer is returned (`ptToTest`).

See also
- Chapter 6.4.1.9.21 “Using POU for implicit checks” on page 1928

Object 'Project Settings'

Symbol: 

Function: This object contains the configuration of the project.

Call:
- “Project ➔ Project Settings”
- Double-click on the object in the device tree

CODESYS saves the project settings directly in the project. If, for example, you transfer a project to another system, the "Project Settings" object is also transferred with it without a project archive being required.

The project settings are valid project-wide and offer setting possibilities for various categories such as "AS" or "Users and Groups". The available categories vary, depending on which software packages you have installed via the package manager.

See also
- Chapter 6.4.1.3.4.3 “Making project settings” on page 1814
- Chapter 6.4.1.21.3.9.4 “Command ‘Package Manager’” on page 2655
- Chapter 6.4.1.21.4.12.2 “Dialog ‘Project Settings’ - ‘SFC’” on page 2767
- Chapter 6.4.1.21.4.12.3 “Dialog ‘Project Settings’ - ‘Users and Groups’” on page 2768
- Chapter 6.4.1.21.4.12.4 “Dialog Box ‘Project Settings’ - ‘Compileoptions’” on page 2769
Object 'Project Information'

Symbol: €

Function: The object contains the properties, meta-information, and project information. With this, you can check the authorship and integrity of the project.

Call
- Double-click the object in the device tree
- Menu bar: “Project ➔ Project Information”

Requirement: CODESYS creates the object when you click “Project ➔ Project Information”, and the dialog opens.

CODESYS saves the project information directly in the project. For example, if you transfer a project to another system, then the “Project Information” object is also transferred. You do not need a project archive.

Tab 'File'

The tab displays the properties of the project file and their attributes. You cannot edit these attributes. They correspond to the file properties of Windows Explorer.

Tab 'Summary'

The tab contains general information and meta-information of the project file. CODESYS uses this information to create keys on the “Properties” tab. For example, if the name Company_A is specified in “Company”, then the Company key with the value Company_A is provided on the “Properties” tab.

NOTICE!
If you save your project as a library project, then you should pay attention to the guidelines for library developers (Library Development Summary).

For a library project, a “Company”, a “Title”, and a “Version” must be specified to install the library.

<table>
<thead>
<tr>
<th>“Company”</th>
<th>Name of the company (example: Company_A).</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Title”</td>
<td>Title of the project (example Automation_A).</td>
</tr>
<tr>
<td>“Version”</td>
<td>Version of the project (example: 0.0.0.1).</td>
</tr>
<tr>
<td>“Released”</td>
<td>☑: Activates protection from modification. Result: If you edit the project now, then a dialog prompt opens to confirm whether you really want to change the project. If you reply to this prompt one time by clicking “Yes”, then no additional prompts appear for more editing actions.</td>
</tr>
</tbody>
</table>
Categories of the library project, according to which you can sort in the “Library Repository” dialog. If no category is specified, then the category “Other” is assigned to the library.

The categories originate from one or more external description files in XML format. However, they can also originate from a library project that has already been created.

Requirement: The project is a library project.

The “Library Categories” dialog opens where you can add library categories.

Default namespace
If you do not define a standard namespace here, then the name of the library file is applied automatically as the namespace.

Author
Author of the project (example: Arnold Best).

Description
Example: For internal use only

See also
- § Chapter 6.4.1.21.3.2.7 “Command ’Save Project as Compiled Library’” on page 2556
- § Chapter 6.4.1.17.3 “Information for Library Developers” on page 2035

Table 441: Dialog “Library Categories”

<table>
<thead>
<tr>
<th>List of categories</th>
<th>The list of the categories that are assigned to the library project. They can originate from several sources. After you specify all desired categories, click “OK” to confirm.</th>
</tr>
</thead>
</table>

| Button “Add” | The “From Description File” and “From Other Library” commands appear. |
| Button “Remove” | CODESYS removes the selected category. |
| Command “From Description File” | The “Select Description File” dialog opens for you to select a description file (*.libcat.xml). The file contains command categories. When you click “Open”, CODESYS accepts the categories. |
| Command “From Other Library” | The “Select Library” dialog opens, where you select a library with command categories to be accepted. When you click “Open”, CODESYS accepts the categories. |
| Button “OK” | CODESYS provides the categories as project information and displays it in the “Library Categories” field. |

See also
- § Chapter 6.4.4.2 “Guidelines for creating libraries” on page 2852
- § Chapter 6.4.1.21.3.9.5 “Command ’Library Repository’” on page 2657

Tab ‘Properties’
On this tab, you can define keys that you can control externally from user-specific programs.

NOTICE!
If you have opened a library project, then note the description of the relevant keys in the guidelines for library developers (Library Development Summary).

- If you have opened a symbol library as a project, then the key **VisuSymbolLibrary = TRUE** must be defined. It identifies the library as a symbol library.

| “Key” | Name of the key. Specify any string of text for the new key, or select an existing key from the “Properties” table. |
| “Type” | Data type of the key. Possible types: “Text”, “Date”, “Number”, “Boolean”, “Version”. |
“Value” Value of the key in permitted format
- “Text”: Any character string
- “Date”: Example: Friday, January 1, 2016 00:00:00. Minimum entry for the date: 1.1
- “Number”: Integer in Integer32 format with or without a sign (example: -32500).
- “Boolean”: True or False, capitalization irrelevant.
- “Version”: Examples: 1.1, 1.0.1.0, maximum four figures.

“Add” Adds the new defined key to the “Properties” table.

“Modify” Saves the change made for the key selected in the “Properties” table.

“Remove” Removes the key selected in the “Properties” table.

“Properties” List of the properties that are defined as keys. CODESYS creates keys automatically for the information in the “Summary” tab.

Click a key to edit it in the input fields above the list.

See also
- Chapter 6.4.4.2 “Guidelines for creating libraries” on page 2852
- Using the Symbol Library in the Visualization
- Chapter 6.4.1.21.4.11.18 “Dialog ‘Properties’ - ‘Image Pool’” on page 2764

Tab ‘Statistics’ The dialog provides statistical information about the number of objects of the individual type or use in the project.

Tab ‘Licensing’ The dialog is for the license protection of libraries.

CAUTION!
You can protect only compiled libraries in this way.

Table 442: “Variables”

| “Activate dongle licensing” | ✔: The library requires a dongle with a license to use it. |
| “Firm code” | License information that must be supplied from the dongle for using the library later. |
| “Product code” |
| “Activation URL” |
| “Activation mail” |

See also
- Chapter 6.4.4.2 “Guidelines for creating libraries” on page 2852

Tab ‘Signing’ This tab is displayed only for existing libraries whose signing has been created with this tab. This tab is no longer visible for newly generated libraries.

When a certificate-signed library is created (possible as of CODESYS V3 SP15) and library compatibility with CODESYS < V3 SP15 is not set, the settings on this tab are disabled. In this case, the signing is done by means of a certificate that has to be assigned to the user profile in the security screen.
One method, which is not recommended but may be necessary in some case for compatibility with versions < V3 SP15, is the less secure signing of a library by means of a vendor-specific, one-time key in this dialog. Requirement: This key is available as a private key file (*.libpk) with an associated token. The user of the library also has to obtain this key in order to be able to check whether the last signing was actually performed by the library vendor.

| “Activate signing” | CODESYS signs the library project with a single-use, manufacturer-specific key. |
| “Private key file” | Location of the private key file *.libpk (example: D:\for lib developers only\mycomp_libkey.libpk). |
| “Public key token” | Example: 427A5701DA3CF3CF Requirement: A private key file is specified, and CODESYS has read and entered the token. |
| “Create Private Key File” | CODESYS creates a new private key file. |

See also
● Chapter 6.4.1.21.3.4.18 “Command ‘Security Screen’” on page 2592

Options for creating blocks for accessing project information

| “Automatically generate ‘Project Information’ POU”s” | Note: The functions that are created with this option can be used only if the runtime supports the WSTRING data type. If this is not the case, then you can use the functions that were created automatically for the with the individual items of the project information, at least in the application for accessing properties. These functions are not registered in the runtime. CODESYS creates POU of the FUNCTION type in the “POUs” view, allowing programmatic access to the project properties in the application. The function blocks GetCompany, GetTitle and GetVersion are created for the properties “Company”, “Title” and “Version”.

The following function blocks are available for user-defined properties:
● GetBooleanProperty: BOOL (TRUE/FALSE)
● GetNumberProperty: DINT (numeric value)
● GetTextProperty: WSTRING (character string)
● GetTextProperty2: POINTER TO WSTRING (unlimited length)
● GetVersionProperty: VERSION (version number as character string)

Note: Do not activate this option for standard libraries, because this can cause problems on smaller systems due to the additional memory requirements.

Note: If a library also contains this project information POU, then you should use the operator _POO to make sure that this POU is accessed. |

| “Automatically generate ‘Library Information’ POU”s” | CODESYS creates POU of the FUNCTION type in the “POUs” view, allowing programmatic access to the project properties in the application. For the “Version” and “Released” properties, the following functions are created: GetLibVersion (version number as character string), GetLibVersionNumber (version number as numeric value), and IsLibReleased (TRUE/FALSE). Note: These functions are not registered in the runtime. The option is available as an alternative solution is the runtime does not support the WSTRING data type, therefore not permitting you to use the functions created with the “Automatically generate ‘Project Information’ POU” option. |
Object 'Recipe Manager'

Tab 'Storage'  The recipe manager provides functions for maintaining user-defined variable lists, known as recipe definitions. The recipe definitions can be stored in recipe files on the PLC.

| **“Storage Type”** | “Textual”: CODESYS saves the recipe in a readable Format with the configured columns and delimiters.  
“Binary”: CODESYS saves the recipe in a non-readable binary format. This format requires less storage space.  
Note: You can read binary recipes again only if you have not changed the variable lists. |
|-------------------|--------------------------------------------------------------------------------------------------|
| **“File path”**   | <directory name>\  
Example: AllRecipes\  
Path on the runtime system  
Notes:  
• The path has to end with a backslash ("\").  
• The path is usually a relative path on the target system in the directory of the runtime files (PlcLogic).  
• Access to paths outside of the directory PlcLogic is not permitted on every controller. An absolute path for Windows systems can be selected by pressing the [ ] button.  
Example of the file path in the runtime system: PlcLogic/AllRecipes  
CODESYS saves a file in this directory for each recipe when downloading to the PLC. The requirement is that you select the “Recipe management in the PLC” option.  
The files are loaded to the recipe manager each time the application is restarted. |
| **“File extension”** | File extension for the recipe file in the format .<file extension>  
The resulting default name for recipe files is in the form <recipe>.<recipe definition>.<file extension>. |
| **“Separator”**   | Delimiters between the individual values in the saved file |
| **“Available Columns”** | Defines the information that is saved and in which order in the recipe file |
| **“Selected Columns”** | |
| **“Save as Default”** | CODESYS uses the settings on the tab throughout the entire project for all other recipe managers. |

Tab 'General'

| **“Recipe management in the PLC”** | ☑: Has to be selected for the user program or visualization elements to load recipes at runtime. If you transfer recipes to the PLC exclusively via the CODESYS program interface, then you can clear this option. |
Table 443: “Save Recipe”

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Save recipe changes to recipe files automatically”</td>
<td>When “Recipe management in the PLC” is selected, there is the following option for saving the recipe:</td>
</tr>
<tr>
<td></td>
<td>✔️: We recommend this option because it helps the recipe manager operate “normally”. The recipe files on the PLC are updated automatically at runtime whenever a recipe is changed.</td>
</tr>
</tbody>
</table>

Table 444: “Load Recipe”

When “Recipe management in the PLC” is selected, there are the following two options for downloading from the PLC:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Download only for exact match of the variable list”</td>
<td>✔️: The recipe is only downloaded if the file on the PLC contains all variables from the variable list of the recipe definition of the application and these are sorted in the same order. Additional entries at the end are ignored. If the required match does not exist, then the error status ERR_RECIPE_MISMATCH is set (RecipeManCommands.GetLastError).</td>
</tr>
<tr>
<td>“Download variables with matching names”</td>
<td>✔️: The recipe values are downloaded only for those variables that have the same name in the recipe definition of the application as in the recipe file on the PLC. If the variable lists differ in composition and sorting, then no error status is set. In this way, recipe files can also be downloaded if variables in the file or in the recipe definition have been deleted.</td>
</tr>
<tr>
<td>“Overwrite existing recipes on download”</td>
<td>✔️: If recipe files with the same name exist on the controller, then they are overwritten with the configured values from the project when the application is started. If the values from the existing recipe files should be loaded instead, then this option has to be disabled. Requirement: The “Storage Type” is “Textual” and the “Save recipe changes to recipe files automatically” option is selected.</td>
</tr>
</tbody>
</table>

Table 445: “Write Recipe”

The following options are available for writing recipe values to the variables on the PLC:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Limit the variable to min/max when recipe value is out of the range”</td>
<td>✔️: If the recipe contains a value that is outside of the range of values specified in the definition, then the defined minimum or maximum value is written to the PLC variable instead of this value.</td>
</tr>
<tr>
<td>“Do not write to a variable when the recipe value is out of the min/max range”</td>
<td>✔️: If the recipe contains a value that is outside of the range of values specified in the definition, then no value is written to the PLC variable. It retains its current value.</td>
</tr>
</tbody>
</table>
Table 446: “Read Recipe”

The following option is available for reading recipe values from the PLC into the recipe in the project:

| “Check recipe for changes” | Always use the function block RecipeManCommands from RecipeManagement.library to read recipes. Never call the method cyclically. This is because each call can be written to the file system, which is time-intensive and burdens the controller. For example, a Raspberry protocol interpreter has a limited number of write cycles.

☑️: With each method call, the current PLC variable values are first read into the recipe. Then the system checks whether the values have changed. Only if the values have changed is the recipe saved. This means that the recipe file is overwritten with the current recipes.

☐☐: With each method call, the current PLC variable values are first read into the recipe. Then the recipe is written to the recipe file in the local file system.

The option can be used in order to update the recipe file in the local file system only if recipe values have changed on the PLC. However, it affects performance because it generates additional code for checking.

Note: As the file system is written to each call, the controller can be very burdened.

Table 447: Option “Save recipe changes to recipe files automatically” is selected.

<table>
<thead>
<tr>
<th>Menu commands</th>
<th>Behavior of the recipes defined in the project</th>
<th>Behavior of the defined recipes at runtime</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Online ➔ Reset Warm”</td>
<td>The recipes of all recipe definitions are downloaded with the values from the current projects.</td>
<td>Dynamically generated recipes remain unchanged.</td>
</tr>
<tr>
<td>“Online ➔ Reset Cold”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>“Online ➔ Download”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>“Online ➔ Reset Origin”</td>
<td>The application is removed from the PLC. If a download is done again afterwards, then the recipes are restored as for an online reset warm.</td>
<td></td>
</tr>
<tr>
<td>Shutdown and restart of the PLC</td>
<td>After a restart, the recipes are downloaded again from the automatically created files. This will restore the same state as before shutdown.</td>
<td></td>
</tr>
<tr>
<td>“Online ➔ Online Change”</td>
<td>The recipe values remain unchanged. In runtime mode, a recipe can be changed only via the function block command RecipeManCommands.</td>
<td></td>
</tr>
<tr>
<td>“Debug ➔ Stop”</td>
<td>The recipes remain unchanged when the PLC is stopped or started.</td>
<td></td>
</tr>
<tr>
<td>“Debug ➔ Start”</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 448: Option “Save recipe changes to recipe files automatically” is not selected.

<table>
<thead>
<tr>
<th>Actions</th>
<th>Recipes defined in the project</th>
<th>Recipes defined at runtime</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Online ➔ Reset Warm”</td>
<td>The recipes of all recipe definitions are downloaded with the values from the current projects. However, these are set in the memory only. To save recipes to a file, you have to run the “Save Recipe” command explicitly.</td>
<td>Dynamically generated recipes are lost.</td>
</tr>
<tr>
<td>“Online ➔ Reset Cold”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>“Online ➔ Download”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>“Online ➔ Reset Origin”</td>
<td>The application is removed from the PLC. When a download is performed afterwards, the recipes are restored.</td>
<td>Dynamically generated recipes are lost.</td>
</tr>
</tbody>
</table>
# Actions

<table>
<thead>
<tr>
<th>Actions</th>
<th>Recipes defined in the project</th>
<th>Recipes defined at runtime</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shutdown and restart of the</td>
<td>After the restart, the recipes are downloaded again from the automatically created files. This</td>
<td>This will restore the same state as before shutdown.</td>
</tr>
<tr>
<td>PLC</td>
<td>project</td>
<td></td>
</tr>
<tr>
<td>“Online ➔ Online Change”</td>
<td>The recipe values remain unchanged. In runtime mode, a recipe can be changed only via the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>function block command RecipeManCommands.</td>
<td></td>
</tr>
<tr>
<td>“Debug ➔ Stop”</td>
<td>The recipes remain unchanged when the PLC is stopped or started.</td>
<td></td>
</tr>
<tr>
<td>“Debug ➔ Start”</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.1.13.2.4 “Changing Values with Recipes” on page 2003
- Chapter 6.4.1.21.3.20.9 “Command ’Read and Save Recipe’” on page 2726
- Chapter 6.4.1.21.2.26 “Object ’Recipe Definition’” on page 2522
- Method Calls of the ’Recipe Management’ Library

## Object ’Recipe Definition’

In the recipe definition (1), you define different data sets for the variables, which are termed recipes (2).

You can toggle the display of the recipe definition between the flat list view (3) and the structured view (4). In the structured view, CODESYS groups variables according to structure.

<table>
<thead>
<tr>
<th>“Type”</th>
<th>Entered automatically</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Name”</td>
<td>Optional</td>
</tr>
<tr>
<td>“Minimal Value”</td>
<td>If the variable value is less than the “Minimal Value” or greater than the “Maximal Value”, then</td>
</tr>
<tr>
<td>“Maximal Value”</td>
<td>CODESYS sets the value to the “Minimal Value” or “Maximal Value”.</td>
</tr>
<tr>
<td>“Comment”</td>
<td>Additional information, for example the unit of the value.</td>
</tr>
<tr>
<td>“Current Value”</td>
<td>Current variable value; not shown in online mode</td>
</tr>
</tbody>
</table>

Table 449: “Additional commands in the context menu in the structured view”

| “Add Sibling”               | Adds a sibling variable to the recipe definition. |
| “Add Child”                 | Adds a child variable to the recipe definition. |

See also

- Chapter 6.4.1.13.2.4 “Changing Values with Recipes” on page 2003
Object 'Symbol Configuration'

You can use the symbol configuration for creating symbol descriptions for project variables. Click “Project ➔ Add Object” to add a symbol configuration object to the device tree. Then define specific presets. See dialog below: “Add Symbol Configuration”.

Double-click the “Symbol Configuration” object to open the symbol configuration editor.

Dialog 'Add Symbol Configuration'

Function: This dialog is used to define the defaults for a “Symbol Configuration” object.

Call: “Project ➔ Add Object ➔ Symbol Configuration” menu; context menu of the application object.

<table>
<thead>
<tr>
<th>“Include comments in XML”</th>
<th>Exports the symbol file with the comments assigned to the variables.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Support OPC UA features”</td>
<td>Note: Availability and editability of this option depend on the device.</td>
</tr>
<tr>
<td>[ ]</td>
<td>When downloading the symbol configuration, additional information is also downloaded to the controller. The information below is necessary for operating the OPC UA server.</td>
</tr>
<tr>
<td></td>
<td>● Base types of inherited function blocks</td>
</tr>
<tr>
<td></td>
<td>● Contents of attributes that were assigned via compiler pragmas</td>
</tr>
<tr>
<td></td>
<td>● Scopes (example: VAR_INPUT, VAR_OUTPUT, VAR_IN_OUT)</td>
</tr>
</tbody>
</table>

Table 450: “Client-Side Data Layout”

<table>
<thead>
<tr>
<th>“Compatibility layout”</th>
<th>This setting is used for the compatibility of old projects. The data layout created for the client is matched as much as possible to the layout created internally by the compiler.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Optimized layout”</td>
<td>Recommended for new projects. Calculates the output layout in optimized form detached from the internal compiler layout. Does not generate any gaps for unpublished elements and strictly fulfills the requirements for memory alignment of the data types. Requires compiler version 3.5.7.0 or higher.</td>
</tr>
</tbody>
</table>

Symbol configuration editor

The editor includes a table with selected variables and a menu bar for editing.

Table 451: Menu bar

<table>
<thead>
<tr>
<th>“View”</th>
<th>You can use this button for activating and deactivating the following categories of variables used in the configuration editor:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>● “Unconfigured from Project”: Variables that have not been added to the symbol configuration, but are provided in the project.</td>
</tr>
<tr>
<td></td>
<td>● “Unconfigured from Libraries”: Variables that have not been added to the symbol configuration, but are provided in the project.</td>
</tr>
<tr>
<td></td>
<td>● { Symbols Exported via Attribute}: This filter also lists the variables that have already been marked for export in the symbol file by means of the {attribute 'symbol' := 'read'} pragma. These symbols are displayed in gray. The “Attribute” column shows which access rights are set by the pragma.</td>
</tr>
</tbody>
</table>

| “Build” | Compiles the project. Requirement for current preparation of variables in the configuration editor. |
### “Settings”

- **“Support OPC UA features”:**
  - Note: Availability and editability of this option depend on the device.
  - When downloading the symbol configuration, additional information is also downloaded to the controller. The information below is necessary for operating the OPC UA server. This currently includes the following information:
    - Base types of inherited function blocks
    - Contents of attributes that were assigned via compiler pragmas
    - Scopes (example: VAR_INPUT, VAR_OUTPUT, VAR_IN_OUT)

- **<!> “ Include comments in XML”**
  - Exports the symbol file with the comments assigned to the variables.

- **“Include Node Flags in XML”**
  - The namespace node flags provide additional information about the origin of a node in the namespace. The node flags always in the symbol table when OPC UA is activated. However, its inclusion in the XML file can be deactivated as some defective parsers have problems with it.

- **“Configure Comments and Attributes”**
  - Opens the “Comments and Attributes” dialog. Here you configure the details of what should be included in the symbol configuration and XML file with respect to comments and attributes.

- **“Configure synchronization with IEC tasks”:**
  - Opens the “Properties - <device name>” dialog, “Options” tab.
  - This setting allows for the symbolic clients (e.g. visualizations or database links based on the PLC_HANDLER) to have consistent read/write access synchronized with the IEC tasks. For a detailed description of this setting, see the "Setting: Configure synchronization with IEC tasks" section below.

- **“Use Empty Namespaces by Default (V2 Compatibility)”**
  - Required when using a CODESYS V2-compatible OPC server configuration.

<table>
<thead>
<tr>
<th>Data Layout Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Optimized layout</strong></td>
<td>Recommend for new projects. Calculates the output layout in optimized form detached from the internal compiler layout. Does not generate any gaps for unpublished elements and strictly fulfills the requirements for memory alignment of the data types. Requires compiler version 3.5.7.0 or higher.</td>
</tr>
<tr>
<td><strong>Compatibility layout</strong></td>
<td>This setting is used for the compatibility of old projects. The data layout created for the client is matched as much as possible to the layout created internally by the compiler. Due to the configuration possibilities of the symbol configuration which have grown over time, problematic offsets can still result. Causes of offsets Memory gaps due to internal pointers or references in function blocks and structure components that are not released for symbol configuration. Memory gaps that occur differently in 32-bit and 64-bit systems depending on the data type, such as __XINT / __XWORD. Fields that are at uneven addresses. Some clients are not set up for this. Unintentional memory misalignment, which occurs when using the attributes 'pack_mode' or 'relative_offset'.</td>
</tr>
</tbody>
</table>

- **“Use Empty Namespaces by Default (V2 Compatibility)”**:
  - Required when using a CODESYS V2-compatible OPC server configuration.
  - Behavior same as in CODESYS V2.3.
  - Program variables are exported without an application name
    
  - Global variables are exported additionally without the GVL name
    
  - Behavior same as in CODESYS V2.3.
  - Program variables are exported without an application name
    
  - Global variables are exported additionally without the GVL name
- **“Enable Direct I/O Access”**: This feature is potentially dangerous and **not intended for operation in production**. Activate only for error checking and tests, or when commissioning the machinery (for example, for checking cables connections).
  - ✔️ In the symbol configuration, you can also use access to direct I/O addresses that correspond to IEC syntax (for example, “%IX0.0”). Access to input addresses (I) is read-only*. Access to output addresses (Q) and memory addresses (M) can be read-write.
  - *Information: In simulation mode, write access to symbols is also possible for input addresses.

Because external clients for protocols such as OPC or OPC UA do not always support IEC syntax for direct addresses, access is also provided using an array syntax in the namespace __MIO of the implicit code. For example, you can also access __MIO.MIO_IX[2].x3 instead of %IX2.3.

However, the symbols for array access are hidden in browsers because some clients cannot handle the large number of nodes (several thousand depending on the size of the I/O ranges).

- **“Support Calls of Functions, FBs, Methods, and Programs”**: Note: Availability and editability of this option depend on the device.
  - ✔️ The access rights “execute” can be set in the symbol table for symbols of POUs of type function, function block, method, or program. The “Support OPC UA features” option also has to be selected in the “Settings”.

- **“Include Call information in XML”**: ✔️ The information about called functions, function blocks, methods, or programs is also listed in the XML file of the symbol configuration. The option is enabled only if the “Support calls of functions, FBs, methods, and programs” option is supported by the device.

- **“Enable Symbol Sets”**: ✔️ A toolbar with buttons and a list box is displayed above the symbol table. You can use this to configure symbol sets for client-specific assignment of access rights to the controller. See “Toolbar for symbol set configuration” below.

### “Download”

If you use a device that supports its own application file for the symbol configuration, then this button is also available in the toolbar. If you change the symbol configuration in online mode, then you can load the new `<application name>._symbols` file immediately to the PLC.

### “Tools”

- **“Save XSD Scheme File”**: This command opens the standard dialog for saving a file in the file system. With this command, you can prepare the XSD format of the symbol file, for example for use in external programs.

---

**Table 452: Symbol table**

<table>
<thead>
<tr>
<th>“Access Rights”</th>
<th>You can change the access rights for a symbol by clicking the symbol in the “Access Rights” column.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Icons for access rights (in ascending order)</td>
</tr>
<tr>
<td></td>
<td>✔️ Read only</td>
</tr>
<tr>
<td></td>
<td>✔️ Write only</td>
</tr>
<tr>
<td></td>
<td>✔️ Read and write</td>
</tr>
<tr>
<td></td>
<td>✷: Execute</td>
</tr>
<tr>
<td></td>
<td>This permission allow for execute access to functions, function blocks, methods, and programs.</td>
</tr>
<tr>
<td></td>
<td>Requirements for the assignment: The device provides the “Support calls of functions, FBs, methods, and programs” and “Support OPC UA features” options. Both options are activated in the “Settings”.</td>
</tr>
<tr>
<td></td>
<td>Note: In case the controller has a user management, you can use symbol sets to define client-specific access rights to the same symbols.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Maximal”</th>
<th>Maximum access rights for this symbol</th>
</tr>
</thead>
</table>
“Attribute”  If the access right was assigned by attribute, then a corresponding icon is displayed here.

“Type”  Alias data types are also displayed in CODESYS V3.5 SP6 and higher. Example: MY_INT : INT for a variable declared with the data type MY_INT (type INT).

“Members”  You can add variables of a structured data type also by selecting a check box for symbol configuration in the “Symbols” column. This causes CODESYS to export all member variable symbols. However, in the “Members” column, you can click the ellipsis button (…) to select only specific structural components. Note: This selection applies to all instances of this data type for which symbols are exported. If a member of a structured type cannot be selected, then an asterisk (☆) is displayed in the check boxes of the members to indicate that all exportable members of that type are exported.

Table 453: Toolbar for symbol set configuration

<table>
<thead>
<tr>
<th>“List box”</th>
<th>Already defined symbol sets</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Add New Symbol Set”</td>
<td>Opens the “Add New Symbol Set” dialog for specifying a name for this set</td>
</tr>
<tr>
<td>“Add Duplicate from Selected Symbol Set”</td>
<td>Opens the “Add Duplicate from Selected Symbol Set” dialog. A copy is created for the set selected in the list box. You can change the default name (&lt;group name&gt;_duplicate).</td>
</tr>
<tr>
<td>“Rename Selected Symbol Set”</td>
<td>Opens the “Rename Selected Symbol Set” dialog for specifying another name for the set selected in list box.</td>
</tr>
<tr>
<td>“Delete selected Symbol Set”</td>
<td>Opens a dialog prompting whether or not the symbol set selected in the list box should be deleted.</td>
</tr>
<tr>
<td>“Configure Symbol Rights”</td>
<td>Opens the “Symbol Rights” tab of the device editor. When logged in there, you can assign different access rights for each user group (client) to the symbol set selected in the list box.</td>
</tr>
</tbody>
</table>

See also
- Chapter 6.4.1.21.2.8.16 “Tab ‘Symbol Rights’” on page 2458

Dialog 'Comments and Attributes’

Table 454: “Symbol Table Contents”

| “Enable extended OPC UA information” | Note: Availability and editability of this option depend on the device.  
|-------------------------------------|-------------------------------------------------------------------------|
|                                     | ☑: Additional information that can be evaluated by OPC UA servers is included in the symbol table. This includes inheritance information of user-defined data types and the namespace node flags. Additional information, such as comments and attributes, can also be included if the OPC UA setting is active.  
|                                     | When the OPC UA setting is enabled, attributes are included in the symbol table according to the following rule:  
|                                     | - In compiler versions V3.5.5.0 to V3.5.7.X, all attributes are included according to the “Match simple identifiers” setting.  
|                                     | - In compiler version V3.5.8.X, all attributes are included according to the setting “Include all attributes”.  
|                                     | - In compiler version V3.5.9.0 and higher, you can customize the attributes that are included. |
| “Include comments” | Requirement: “Enable extended OPC UA information” is activated.  
|                      | ☑: Comments and attributes are also saved in the symbol table. |
"Include attributes"

"Also include comments and attributes for type nodes" Requirement: "Include comments" is activated.
- The information for type nodes is also included (user-defined types, such as `STRUCT` and `ENUM` elements).
- Only directly exported variables have comments and attributes.

Table 455: “XML symbol file contents”

| "Include namespace node flags" | The namespace node flags provide additional information about the origin of a node in the namespace. The node flags always in the symbol table when OPC UA is activated. However, its inclusion in the XML file can be deactivated as some defective parsers have problems with it. |
| "Include comments" | Comments can also be saved in the XML file. In compiler versions V3.5.5.x to V3.5.8.0, this includes the setting “Prefer docu-comments”. |
| "Include attributes" | Attributes can also be saved in the symbol file. |
| "Also include comments and attributes for type nodes" | Requirement: "Include comments" is activated. The information for type nodes is also included (user-defined types, such as `STRUCT` and `ENUM` elements). Only directly exported variables have comments and attributes. |

Table 456: “Select Comments”

Requirement: "Include comments" is activated.

| "Include docu comments" "Include normal comments " "Always include both types of comments" "Prefer docu comments, fallback to normal ones" "Prefer normal comments, fallback to docu comments" | The options determines the comments that are saved in the symbol configuration. |

Table 457: “Filter Attributes (Case-Insensitive)”

Requirement: "Include attributes" is activated.

| "Include all attributes" "Include attributes starting with" "Filter attributes with regular expression" | Defines the attributes that are saved in the symbol configuration. |
| "Match simple identifiers" | Exists primarily due to the backward compatibility to older versions in order to emulate the old behavior. |

Setting: Configure synchronization with IEC tasks

For synchronously consistent access, the symbolic client waits in the runtime when processing a read or write request until a time is found when no IEC task is executed. When this gap is detected, restarting the IEC tasks is prevented until all values of the variable list have been copied. Then the IEC tasks are planned again as usual. Synchronized access can cause a delayed starting of IEC tasks, which is shown as increased jitter. As all applications in the runtime are managed by a common scheduler, this potential impairment of the real-time behavior...
affects all applications on the device. All applications of the device are affected, regardless of whether or not they include a symbol configuration or they have been downloaded to the controller from one or more CODESYS projects. Therefore, the runtime permits synchronized consist access only if this it allows all applications that are downloaded to the controller at the time of access.

The setting is located in the editor of the symbol configuration of the “Settings” menu. In addition, the setting is also located in the context menu of the controller when you click the “Properties” command and then select the “Options” tab in the opened dialog.

For applications without symbol configuration, the setting can only be found in the properties dialog.

**NOTICE!**

After changing the setting, all applications downloaded to the device by means of a download or online change have to be reloaded and all boot applications updated.

**In which cases is synchronized consistent access necessary?**

As a rule, there is no need for consistent values for displayed values because it is mostly irrelevant from which IEC task cycle the changed values originate. It is completely irrelevant for seldom changed values. Even when writing there are almost no hard consistency demands because typically the machine must be in a kind of standby mode (for example when writing recipes) in which there is no direct access to the values written as recipes.

In contrast, consistent values are particularly necessary for database links to save production data. For clocked machines, however, these values must be synchronous with the production timing (one value set per produced product) and not consistent with reference to one or more IEC tasks. With reference to the machine clocking, the consistency must be already ensured by the IEC application. For this purpose, the values that arise during a production cycle are typically collected in a global variable list. At the end of the cycle, the symbolic client is notified by means of an additional variable (BOOL or counter) that the machine cycle has ended and the values are valid. Now the client has the chance to archive the values from the production cycle. Depending on necessity, the successful reading can also be displayed in the opposite direction by means of a released variable, so that the production can also be halted in case the production data cannot be archived. Synchronized consistent access is not necessary and helpful for this use case because the synchronization takes place at the application level.

In contrast, synchronized consistent access by symbolic clients is typically applied in the process industry with continuously running systems without production clocking when, for example when process values are written consistently and cyclically in a fixed time frame of 60s. This can take place either by synchronization on the application level similar to clocked machines (see above) or by synchronization of the synchronized consistent symbolic access. The advantage of the latter is that no logic has to be implemented in the IEC program and access is controlled entirely by the client.

**CAUTION!**

Due to the increased jitter, the synchronized consistent monitoring is not suitable for motion or real-time critical applications. For these reasons, synchronized consistent access should be released and used only if it is absolutely necessary.

If a client uses synchronous consistent access released by this setting, then it has and effect on the client. Depending on the scheduler of the runtime, the response time can jitter more here for read/write access because the system might still have to wait for an execution gap of the IEC tasks. Read and/or write access can still fail when IEC tasks run for a long time (in the range of several 100 ms) or the CPU load is close to 100% for an extended period of time with one or more IEC tasks (in the range of several 100 ms). Therefore, the availability of the values also depends on the load of the controller by the IEC application.
Moreover, the client can minimize the effects on itself and on the runtime if it observes the following in the definition of the variable lists to be read or written:

- Synchronized consistent access only to those variables that are absolutely and consistently required.
- Separate variable lists for variables that have to be consistent and for variables that could be inconsistent.
- Divide variable lists with several consistent variables into several smaller lists.
- Select read intervals for cyclic reading of values as large as possible.

Entries marked in red in the symbol table show variables that they are configured for export to the symbol file but are currently invalid in the application. The cause for this can be that the declaration has been removed from the block.

In version 3.5.8.0 and higher, a warning appears in the editor if variables that have configured symbols are not used in the IEC code or are not mapped in the case of I/O variables. In addition, the compiler indicates variables that are referenced from outdated library versions in the symbol configuration.

**NOTICE!**

Object variables that are not used in the program code remain uncompiled by default and are therefore not available in the symbol configuration.

However, CODESYS provides variables from uncompiled objects in the symbol configuration when one of the following conditions is met:

- The “Link always” POU property is selected.
- The `{attribute 'linkalways'}` pragma is used.

See also

- Chapter 6.4.1.10 “Working with Controller Networks” on page 1936
- Chapter 6.4.1.21.4.11.20 “Dialog ‘Properties’ - ‘Options’” on page 2765
- Chapter 6.4.1.21.4.11.15 “Dialog ‘Properties’ - ‘Build’” on page 2755
- Chapter 6.4.1.20.6.3.25 “Attribute ‘linkalways’” on page 2294
- Chapter 6.4.1.20.6.3.46 “Effects of Pragmas on Symbols” on page 2315
The following examples from an IEC application will show how gaps can result in the client-side memory layout caused by unpublished symbols, internal "invisible" pointers, or a "pack mode" definition in the device description. With the "Optimized layout" setting, the gaps are avoided. The symbol file contains different information about the size and offset of memory locations, depending on the selected layout setting.

Example:
Large structure

```plaintext
// Example of a big structure, where not all members get published:
STRUCT
   {attribute 'symbol':='readwrite'}
   PublicNumber : INT;

   {attribute 'symbol':='none'}
   InternalData : ARRAY[0..100] OF BYTE;

   {attribute 'symbol':='readwrite'}
   SecondNumber : INT;

   {attribute 'symbol':='none'}
   MoreData : ARRAY[0..100] OF BYTE;
END_STRUCT
END_TYPE
```

Resulting entries in the symbol file; pay attention to "size" and "byteoffset":

- Symbol file, large structure, compatibility layout option
  ```plaintext
  <TypeUserDef name="T_LargeStructure" size="208" nativesize="208" typeclass="Userdef" pouclass="STRUCTURE" iecname="LargeStructure">
    <UserDefElement iecname="PublicNumber" type="T_INT" byteoffset="0" vartype="VAR" />
  </TypeUserDef>
  <TypeUserDef name="T_LargeStructure" size="4" nativesize="208" typeclass="Userdef" pouclass="STRUCTURE" iecname="LargeStructure">
    <UserDefElement iecname="PublicNumber" type="T_INT" byteoffset="2" vartype="VAR" />
  </TypeUserDef>
  ```

- Symbol file, large structure, optimized layout option
  ```plaintext
  <TypeUserDef name="T_LargeStructure" size="4" nativesize="208" typeclass="Userdef" pouclass="STRUCTURE" iecname="LargeStructure">
    <UserDefElement iecname="PublicNumber" type="T_INT" byteoffset="0" vartype="VAR" />
  </TypeUserDef>
  ```

Example:
Structure with uneven addresses

```plaintext
// The following mechanisms can cause memory misalignment:
// - {attribute 'relative_offset':='...'} at a member
// - {attribute 'pack_mode':='...'} at a structure declaration
// - target setting 'memory-layout\pack-mode' in the device description

{attribute 'pack_mode':='1'}
TYPE UnevenAddresses:
STRUCT
   {attribute 'relative_offset':='3'}
   {attribute 'symbol':='readwrite'}
   PublicNumber : INT;
```

Configuration and programming
Programming with CODESYS > CODESYS Development System

2024/01/05
ADR010583, 1, en_US
Resulting entries in the symbol file; pay attention to "size" and "byteoffset":

```
<TypeUserDef name="T_UnevenAddresses" size="13" nativesize="13"
typeclass="Userdef" pouclass="STRUCTURE" iecname="UnevenAddresses">
  <UserDefElement iecname="PublicNumber" type="T_INT" byteoffset="3"
   vartype="VAR" />
  <UserDefElement iecname="PublicValue" type="T_LREAL" byteoffset="5"
   vartype="VAR" />
</TypeUserDef>

<TypeUserDef name="T_UnevenAddresses" size="16" nativesize="13"
typeclass="Userdef" pouclass="STRUCTURE" iecname="UnevenAddresses">
  <UserDefElement iecname="PublicNumber" type="T_INT" byteoffset="0"
   vartype="VAR" />
  <UserDefElement iecname="PublicValue" type="T_LREAL" byteoffset="8"
   vartype="VAR" />
</TypeUserDef>
```

// Each POU contains some implicit variables, which do not get published. Depending on the
data type these might cause memory gaps of different sizes.
FUNCTION_BLOCK POU IMPLEMENTS SomeInterface
VAR_INPUT
  in : INT;
END_VAR
VAR_OUTPUT
  out : INT;
END_VAR

Each POU contains some implicit variables, which do not get published. If it is a data type
such as __XWORD, then different sizes of memory gaps result in the client-side data layout,
depending on whether the system is 64-bit or 32-bit.

Resulting entries in the symbol file for 64-bit and 32-bit; pay attention to "size" and "byteoffset":

```
<TypeUserDef name="T_POU" size="24" nativesize="24"
typeclass="Userdef" pouclass="FUNCTION_BLOCK" iecname="POU">
  <UserDefElement iecname="in" type="T_INT" byteoffset="16"
   vartype="VAR_INPUT" />
  <UserDefElement iecname="out" type="T_INT" byteoffset="18"
   vartype="VAR_OUTPUT" />
</TypeUserDef>

<TypeUserDef name="T_POU" size="4" nativesize="24"
typeclass="Userdef" pouclass="FUNCTION_BLOCK" iecname="POU">
  <UserDefElement iecname="in" type="T_INT" byteoffset="0"
   vartype="VAR_INPUT" />
</TypeUserDef>
```
See also

- Chapter 6.4.1.10.3 “Symbol Configuration” on page 1941

Object 'Text List'

Symbol: 

This object is used to create, manage, and translate texts. It contains a table with texts where you can add new texts. You can select a text which you have composed here can be selected in a visualization in the “Dynamic texts” property of an element. In runtime mode, the visualization displays this text dynamically in the selected language.

When the object is assigned to an alarm group and is located below the “Alarm Configuration” object, CODESYS adds the texts of the alarm group to the table. You can also add texts.

<table>
<thead>
<tr>
<th>&quot;ID&quot;</th>
<th>Unique identifier of the text</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Standard&quot;</td>
<td>Source text as character string (example: Information A: %i options). Use the keyboard shortcut [Ctrl]+[Enter] to add a line break. Double-click in the field to edit the text.</td>
</tr>
<tr>
<td>&quot;&lt;language code&gt;&quot;</td>
<td>Name of the language as a language code. Example: en-US. This column contains the translation of the text which is composed under “Standard”. Under the condition that the language code is selected as the language in the visualization manager, a visualization displays the translated text in runtime mode. If a translation has not been composed, then CODESYS uses the text under “Standard”. A visualization in runtime mode can also change the language if requested by a user.</td>
</tr>
<tr>
<td>Blank line</td>
<td>Edit the line to add your own text.</td>
</tr>
</tbody>
</table>
Object 'Task Configuration'

General

Symbol: 

The object is used to define and display the basic settings for the task configuration. The "Task Configuration" object must be included exactly one time in each application.

"Task Configuration" tabs and functions

- "Properties": Display of the basic settings
- "System Events": Linking of POU calls with system events
- "Monitor": Display of the status and current statistics for the cycles times in online mode
- "Variable Usage": Overview of the tasks that access the variables and how they do it
- "Task Groups": Definitions of the tasks groups and their assignment to CPUs
- "CPU Load": Graphical representation of the CPU load in online mode

See also

- § Chapter 6.4.1.21.2.11 “Object 'GlobalTextList'” on page 2465
- For descriptions about alarm management and alarm visualization, see the help for CODESYS Visualization.

Tab 'Properties'

Object: “Task Configuration”

In this tab, you define the basic settings of the task configuration as predefined by the target system, such as the maximum values for tasks and watchdog parameters.

Tab 'System Events'

Object: “Task Configuration”

On the “System Events” tab, you define which event calls which function and whether or not the configuration is currently activated. You use this tab when a system event (instead of a task) should call a project function.

| "Add Event Handler" | Opens the “Add Event Handler” dialog |
| "Remove Event Handler" | Deletes the selected list assignment |
| "Event Info" | Shows information from the corresponding event library |
**Open Event Function**
Opens the editor of the new function for the selected assignment. You have selected the implementation language of the new function in the “Add Event Handler” dialog.

Assignment of functions to call for events with: "Name", "Description", "Function to call", and "Active" (activate/deactivate configuration).

---

**Table 458: “Add Event Handler”**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Event”</strong></td>
<td>The possible selection depends on the target device. CODESYS marks unavail-</td>
</tr>
<tr>
<td></td>
<td>able events with a red symbol in front of the name. A list of all possible</td>
</tr>
<tr>
<td></td>
<td>system events is located at the end of this section.</td>
</tr>
<tr>
<td><strong>“Function to call”</strong></td>
<td>Function name (&quot;POU&quot;, type &quot;FUNCTION&quot;)</td>
</tr>
<tr>
<td></td>
<td>You have to specify the name of the new function. CODESYS inserts the func-</td>
</tr>
<tr>
<td></td>
<td>tion to the device tree after you confirm the dialog.</td>
</tr>
<tr>
<td><strong>“Scope”</strong></td>
<td>• &quot;Application&quot;: The function is available to the application.</td>
</tr>
<tr>
<td></td>
<td>• &quot;POUs&quot;: The function is available to the entire project.</td>
</tr>
<tr>
<td><strong>“Implementation language”</strong></td>
<td>Implementation language for the new function</td>
</tr>
<tr>
<td><strong>“Description”</strong></td>
<td>Short description of the selected event</td>
</tr>
</tbody>
</table>

**Features in “Online Mode”**
The list of assignments from called functions to events also includes the following information: “Event Status”, “Call Count”, and the “Online Reset” button.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Event Status”</strong></td>
<td>0: No error has occurred.</td>
</tr>
<tr>
<td></td>
<td>Does not equal 0: Error. You need to consult the respective runtime system</td>
</tr>
<tr>
<td></td>
<td>documentation.</td>
</tr>
<tr>
<td><strong>“Call Count”</strong></td>
<td>Displays how often the event has occurred or the associated function has been</td>
</tr>
<tr>
<td></td>
<td>called.</td>
</tr>
<tr>
<td><strong>“Online Reset”</strong></td>
<td>CODESYS reinitializes the event lists and resets the counter for the events/func-</td>
</tr>
<tr>
<td></td>
<td>tion calls. Incorrectly initialized events are displayed with a red status cell.</td>
</tr>
</tbody>
</table>

**Possible system events**

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
<th>Task</th>
<th>Debugging</th>
</tr>
</thead>
<tbody>
<tr>
<td>PrepareStart</td>
<td>Call before starting the application</td>
<td>Communication task</td>
<td>No</td>
</tr>
<tr>
<td>StartDone</td>
<td>Call after starting the application</td>
<td>Communication task</td>
<td>No</td>
</tr>
<tr>
<td>PrepareStop</td>
<td>Call before stopping the application</td>
<td>Communication task</td>
<td>No</td>
</tr>
<tr>
<td>StopDone</td>
<td>Call after stopping the application</td>
<td>Communication task</td>
<td>No</td>
</tr>
<tr>
<td>PrepareReset</td>
<td>Call before resetting the application</td>
<td>Communication task</td>
<td>No</td>
</tr>
<tr>
<td>ResetDone</td>
<td>Call after resetting the application</td>
<td>Communication task</td>
<td>No</td>
</tr>
<tr>
<td>PrepareOnline-Change</td>
<td>Call before online change of the application</td>
<td>Communication task</td>
<td>No</td>
</tr>
<tr>
<td>Event</td>
<td>Description</td>
<td>Task</td>
<td>Debugging</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>OnlineChangeDone</td>
<td>Call after online change of the application</td>
<td>Communication task</td>
<td>No</td>
</tr>
<tr>
<td>PrepareDownload</td>
<td>Call before downloading the application</td>
<td>Communication task</td>
<td>No</td>
</tr>
<tr>
<td>DownloadDone</td>
<td>Call after downloading the application</td>
<td>Communication task</td>
<td>No</td>
</tr>
<tr>
<td>PrepareDelete</td>
<td>Call before deleting the application</td>
<td>Communication task</td>
<td>No</td>
</tr>
<tr>
<td>DeleteDone</td>
<td>Call after deleting the application</td>
<td>Communication task</td>
<td>No</td>
</tr>
<tr>
<td>PrepareExit</td>
<td>Call before exiting the application</td>
<td>Communication task</td>
<td>No</td>
</tr>
<tr>
<td>ExitDone</td>
<td>Call after exiting the application</td>
<td>Communication task</td>
<td>No</td>
</tr>
<tr>
<td>CodeInitDone</td>
<td>Event is sent after Code Init. Called within the task safe section and only for an online change change (for example, the copy code for online change is executed here).</td>
<td>Communication task</td>
<td>No</td>
</tr>
<tr>
<td>Exception</td>
<td>The event is sent if an exception has occurred in the context of an application.</td>
<td>Exception handling task of the runtime, or the task itself if the runtime does not support exception handling</td>
<td>Depends on the task</td>
</tr>
<tr>
<td>Login</td>
<td>Login of a client to this application</td>
<td>Communication task</td>
<td>No</td>
</tr>
<tr>
<td>Logout</td>
<td>Logout of a client from this application</td>
<td>Communication task</td>
<td>No</td>
</tr>
<tr>
<td>BeforeReadingInputs</td>
<td>Call before reading the inputs</td>
<td>IEC task</td>
<td>Yes</td>
</tr>
<tr>
<td>AfterReadingInputs</td>
<td>Call after reading the inputs</td>
<td>IEC task</td>
<td>Yes</td>
</tr>
<tr>
<td>BeforeWritingOutputs</td>
<td>Call before writing the outputs</td>
<td>IEC task</td>
<td>Yes</td>
</tr>
<tr>
<td>AfterWritingOutputs</td>
<td>Call after writing the outputs</td>
<td>IEC task</td>
<td>Yes</td>
</tr>
<tr>
<td>DebugLoop</td>
<td>Event is sent in cycles to the debug loop if the IEC task stops at a breakpoint.</td>
<td>Communication task</td>
<td>No</td>
</tr>
<tr>
<td>PrepareShutdown</td>
<td>Event is sent immediately before the runtime system is downloaded.</td>
<td>Runtime main loop</td>
<td>No</td>
</tr>
</tbody>
</table>
Event Description Task Debugging
---
PrepareExitComm Event is sent during download before exiting the communica-
tion server. Runtime main loop No
PrepareExitTasks Event is sent during download before exiting all tasks. Runtime main loop No

Tab 'Monitor'

Object: “Task Configuration”

In online mode, the tab shows the status of the tasks of the task configuration, as well as some current measurements of the cycles and cycle times. CODESYS updates the values in the same time interval as for the monitoring of values from the PLC.

The displayed values can be reset to 0 by means of the “Reset” context menu command.

<table>
<thead>
<tr>
<th>“Task”</th>
<th>Task name (as defined in the task configuration)</th>
</tr>
</thead>
</table>
| “Status”       | • “Not created”: The task has not been started since the last update (especially for event tasks).  
                  • “Generated”: The task is recognized in the runtime system, but not yet in opera-
                  tion.  
                  • “Valid”: The task is operating normally.  
                  • “Exception”: The task has produced an exception status. |
| “IEC-Cycle Count” | Number of cycles executed since starting the application where the IEC code was executed (0 if the target system does not support the counter function) |
| “Cycle Count”   | Number of executed cycles since logging in to the PLC.  
                  It depends on the target system whether cycles are also counted where the application is not running. In these cases, the “Cycle Count” may be greater than the “IEC-Cycle Count”. |
| “Last Cycle Time (µs)” | Last measured cycle time [µs] |
| “Average Cycle Time (µs)” | Average cycle time over all cycles [µs] |
| “Max. Cycle Time (µs)” | Maximum measured cycle time over all cycles [µs] |
| “Min. Cycle Time (µs)” | Minimum measured cycle time over all cycles [µs] |
| “Jitter (µs)”    | Current value of the periodic jitter [µs]  
                  Note: From CODESYS 3.5 SP11 to SP15, the peak-peak value of the periodic jitter is displayed. In earlier versions and in SP16 and later, the current value of the periodic jitter is displayed. |
| “Min. Jitter (µs)” | Minimum measured periodic jitter [µs] |
| “Max. Jitter (µs)” | Maximum measured periodic jitter [µs] |
| “Core”          | Number of the processor core where the task is currently running  
                  Example: 2  
                  Requirement: The controller is equipped with a multicore processor.  
                  If the CPU is not a multicore CPU, then the value –1 is displayed here. |

See also

- § Chapter 6.4.1.9.17.3 “Definitions of Jitter and Latency” on page 1915
- § Chapter 6.4.1.9.17 “Task Configuration” on page 1914
Tab 'Variable Usage'

Object: “Task Configuration”

The “Variable Usage” tab provides an overview of all variables and their usage. There you can see the tasks where variables are accessed.

When using multicore, write access (w) to a variable should take place only in a task because otherwise it can cause inconsistencies.

In the context menu, you can hide individual tasks and show the cross-reference list to variables.

<table>
<thead>
<tr>
<th>“Variables”</th>
<th>Name of the variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Type”</td>
<td>Data type</td>
</tr>
<tr>
<td>“Number”</td>
<td>Number of tasks that access these variables.</td>
</tr>
<tr>
<td>“&lt;task name&gt;”</td>
<td>Access to the variable (r: read, w: write, rw: read/write)</td>
</tr>
</tbody>
</table>

See also
- Chapter 6.4.1.9.17 “Task Configuration” on page 1914

Tab 'Task Groups'

Object: “Task Configuration”

You define task groups on the “Task Groups” tab. Task groups can be distributed over the individual processor cores in multicore systems. The tasks of a task group are bound to the processor cores according to the strategy defined in the “Core” field.

<table>
<thead>
<tr>
<th>“Add Group”</th>
<th>The button adds a new task group named NewGroup_&lt;no&gt;.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Remove Group”</td>
<td>Deletes the selected task group.</td>
</tr>
<tr>
<td>“Group Name”</td>
<td>The name can be changed by double-clicking in the field.</td>
</tr>
<tr>
<td>“Core”</td>
<td>Determines the processor core for process the tasks of this group.</td>
</tr>
<tr>
<td></td>
<td>- “Free floating”: All tasks are bound dynamically to different processor cores. The user does not have any influence over this. The operating system is responsible for the distribution.</td>
</tr>
<tr>
<td></td>
<td>- “Sequentially pinned”: All tasks are bound and fixed to different processor cores. The user does not have any influence over this.</td>
</tr>
<tr>
<td></td>
<td>- “Fixed pinned”: All tasks are bound to one processor core. By default, the runtime system determines the processor core.</td>
</tr>
<tr>
<td></td>
<td>- “&lt;core number&gt;”: Fixed defined processor core. If the processor core is not available, then an error message is issued.</td>
</tr>
</tbody>
</table>

Tab 'CPU Load'

Object: “Task Configuration”

The “CPU Load” tab is available in online mode for multicore devices only. The load of the individual CPUs is presented in the trace editor.

You open the trace configuration by double-clicking the legend in the window on the right side. Adding more variables is not possible here.
Mapping of Task Priorities on a Linux System

Dependencies between IEC task priorities and Linux priorities

When the target system is running in Linux, specific priorities of the IEC tasks are mapped to specific priorities and scheduling policies. Depending on the priority, the scheduling policy SCHED_FIFO or SCHED_OTHER is displayed as in the table.

<table>
<thead>
<tr>
<th>IEC Task Priority</th>
<th>Linux Priority Linux (Default)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (highest real-time priority)</td>
<td>56 (SCHED_FIFO)</td>
</tr>
<tr>
<td>15 (lowest real-time priority)</td>
<td>41 (SCHED_OTHER)</td>
</tr>
<tr>
<td>16 (no real-time priority)</td>
<td>0 (SCHED_OTHER)</td>
</tr>
<tr>
<td>31 (no real-time priority)</td>
<td>0 (SCHED_OTHER)</td>
</tr>
</tbody>
</table>

Object 'Task'

General

Symbol: 🙋

In this object, you define the conditions for starting and calling the task.

You insert the object below “Task Configuration” in the device tree.

Tab 'Configuration'

Object: “Task”

<table>
<thead>
<tr>
<th>“Priority”</th>
<th>Possible values: 0..31, where 0 is the highest priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Task group”</td>
<td>Assigned task groups which can be assigned to specific processor cores in multicore</td>
</tr>
</tbody>
</table>

Example:

IEC Tasks Note: The task group is shown in brackets after the task in the device tree.

When using a runtime system in Linux, there exist fixed dependencies between task groups and priorities. For more information, see: ☞ Chapter 6.4.1.21.2.29.8 “Mapping of Task Priorities on a Linux System” on page 2538
### Table 459: “Type”

<table>
<thead>
<tr>
<th>Type</th>
<th>Processing of the task is done cyclically.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Input field “Interval”</strong></td>
<td>Required&lt;br&gt;Time span after which the task is restarted (task cycle time)&lt;br&gt;● As a time definition in the format TIME&lt;br&gt;   Example: #200ms&lt;br&gt;● As a number&lt;br&gt;   Example: 200 Hint: the number is displayed automatically in the format TIME when the input field is in focus again.&lt;br&gt;Note: Deviations of the task from this desired task cycle time are displayed at runtime as periodic jitter on the Watchdog tab.</td>
</tr>
<tr>
<td><strong>Time unit of the interval</strong></td>
<td>If only a number and not a time definition is specified in the Interval input field, then the unit selected here determines the time dimensions.&lt;br&gt;Example: ms&lt;br&gt;Note: A task cycle time in µs is always displayed as a number.</td>
</tr>
<tr>
<td><strong>Type “Event”</strong></td>
<td>Processing of the task starts event-controlled on the rising edge of the event variable.</td>
</tr>
<tr>
<td><strong>Input field “Event”</strong></td>
<td>Global variable (Boolean type)&lt;br&gt;The task starts as soon as the variable value switches from 0 to 1.</td>
</tr>
<tr>
<td><strong>Type “External”</strong></td>
<td>Processing of the task starts event-controlled on the rising edge of the event variable.</td>
</tr>
<tr>
<td><strong>List box “Event”</strong></td>
<td>List with target system-dependent events (Boolean type)&lt;br&gt;Note: The target system determines which events are supported and offered in the list box.&lt;br&gt;Hint: Not to be confused with system events</td>
</tr>
<tr>
<td><strong>“Interval”</strong></td>
<td>Time definition in TIME format or as a number with a time unit Note: Only available when the event requires a time definition</td>
</tr>
<tr>
<td><strong>“Freewheeling”</strong></td>
<td>Processing of the task starts automatically in a continuous loop at program start and at the end of a complete pass&lt;br&gt;Note: A cycle time is not defined.</td>
</tr>
<tr>
<td><strong>“Status”</strong></td>
<td>Processing of the task starts state-triggered by the event variables</td>
</tr>
<tr>
<td><strong>Input field “Event”</strong></td>
<td>Global variable (Boolean type) When the variable has the state TRUE hat, the task starts.</td>
</tr>
</tbody>
</table>

---

**NOTICE!**

For fieldbuses, a fixed cycle matrix is necessary to assure a determined behavior. Therefore, you should not use TypeFreewheeling for a bus cycle task.

---

**NOTICE!**

Note the following difference between the processing types Status and Event. If the given event yields TRUE, then the start condition of a task of type Status is fulfilled. In contrast, the start of a task of type Event requires a switch of the event from FALSE to TRUE. If the sampling rate of the task scheduler is too low, then the rising edge of the event can remain unnoticed.
NOTICE!
When setting the task cycle time, you have to identify which bus system is currently being used. For example, the task cycle time in a CAN bus system must match the currently set baud rate and the number of frames used in the bus. In addition, the times set for heartbeat, node guarding, and sync should always be a multiple of the task cycle time. If not, then CAN frames can be lost.

Table 460: “Watchdog”

Defines the time monitoring for a task. If the target system supports an advanced watchdog configuration, then the following settings may be predefined in the device description.

- Upper and lower limit
- Default watchdog time
- Time specified as percentage

The default watchdog settings depend on the device.

<table>
<thead>
<tr>
<th>“Enable”</th>
<th>The watchdog is active.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If the task exceeds the currently set “Time” of the watchdog, then the task is halted with an error status (exception). The application in whose task the error occurred and its child applications are also halted. In this way, all tasks of the affected applications are also halted. Then the currently defined “Sensitivity” is also taken into account. If you activate the option “Update I/Os” in the “PLC Settings” of the PLC, then CODESYS resets the outputs to the defined default values. Possible cases:</td>
</tr>
<tr>
<td></td>
<td>● Multiple consecutive timeouts:</td>
</tr>
<tr>
<td></td>
<td>Sensitivity: 0, 1 - exception in cycle 1</td>
</tr>
<tr>
<td></td>
<td>Sensitivity: 2 - exception in cycle 2</td>
</tr>
<tr>
<td></td>
<td>Sensitivity: n - exception in cycle n</td>
</tr>
<tr>
<td></td>
<td>● Single timeout: Exception if the cycle time of the current cycle is longer than (time * sensitivity). Example: Time=t#10ms, Sensitivity=5 (i.e., exception as soon as the one-time task runs longer than 50 ms)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Time (e.g. t#200ms)”</th>
<th>Watchdog time</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Defines (together with “Sensitivity”) the watchdog for a task; description as for “Enable”. Depending on the target system, the monitoring time span is given as a percentage of the task interval if possible. In this case, the list box for the unit is disabled and displays “%”.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Sensitivity”</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Defines (together with the watchdog) the watchdog for a task; description as for “Enable”.</td>
</tr>
</tbody>
</table>

Using the functions from the library CmpIecTask.library, you can deactivate a watchdog for specific PLC cycles. This is useful for cycles that demand more time due to initialization.
Deactivating/reactivating the watchdog:

```c
hIecTask := RTS_IEC_HANDLE //Declaration of the variable hIecTask
hIecTask := IecTaskGetCurrent(0);
IecTaskDisableWatchdog(hIecTask); // Watchdog disabled
...
IecTaskEnableWatchdog(hIecTask); Watchdog enabled
```

List of “POU”s that the task calls

The calling order corresponds to the POU order in the list (from top to bottom).

| “Add Call” | Defines a new program call |
| “Open POU” | Opens the selected POU |
| “Move Up” | Changes the calling order |
| “Move Down” | |

The normal watchdog of an IEC task is triggered when the execution time of the IEC task exceeds the watchdog time. The “Omitted Cycle” watchdog is triggered when the task does not start at all. This is the case when the task does not execute any cycle at all within the maximum of \(<\text{Time} \times \text{Sensitivity}\rangle\) or \(<2 \times \text{Interval}\rangle\). The cause could be crowding by other tasks or a failure in the scheduler; which no longer enables the task.

See also
- Chapter 6.4.1.21.2.29 “Object 'Task Configuration'” on page 2533
- Chapter 6.4.1.21.2.29.4 “Tab 'Monitor'” on page 2536
- Chapter 6.4.1.21.2.29.6 “Tab 'Task Groups'” on page 2537

Object ‘Trace’

Symbol: ☑

An object of type “Trace” is used for configuring and displaying application-specific trace data in one or more charts. At application runtime, value curves of trace variables, which you can monitor in the trace editor in CODESYS, are recorded on the controller. Requirements are that a trace configuration has been configured transferred to the controller, and the trace recording has been started. The recorded data is transferred to the development system and displayed in diagrams according to the configuration. You can navigate through the data when tracing.

If the controller supports a Trace Manager, then you can use the 'DeviceTrace' object type in the Trace Manager to access all traces that are running on the controller.

Double clicking the trace object opens the trace editor. The corresponding toolbar contains the most important trace commands. The trace variable list shows the variable whose value curve is recorded.
At application runtime, the runtime system buffer of the trace component is filled with the recorded samples. The data is transferred to the development system and stored in its trace editor buffer. The trace editor accesses this data and displays it in diagrams as a graph over time. When you close the trace editor, the trace editor buffer will be freed.

Use menu commands for controlling the trace. In addition, you can use menu commands, keyboard shortcuts, and mouse input for navigating through the data.

See also
- Chapter 6.4.1.13.3.4 “Operating the data recording” on page 2014
- Chapter 6.4.1.13.3.6 “Navigating into trace data” on page 2015
Trace variable list

The trace variable list provides an overview of the current trace configuration. In the list, all charts with the respective trace variables are displayed in a table. When you double-click a trace variable, the “Trace Configuration” dialog also opens with the variable settings.

<table>
<thead>
<tr>
<th>“Hide Instance Paths”</th>
<th>Display of the variable name in the list</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>•  Example: PLC_PRG.iCounter</td>
</tr>
</tbody>
</table>

Table 461: Charts

<table>
<thead>
<tr>
<th>“Name”</th>
<th>Tabular display of the charts:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>List of charts with the respective variables</td>
</tr>
<tr>
<td></td>
<td>• “Chart &lt;n&gt;” The chart is displayed.</td>
</tr>
<tr>
<td></td>
<td>The chart name can be changed by clicking the selected name.</td>
</tr>
<tr>
<td></td>
<td>• “&lt;variable&gt;” The variable is displayed.</td>
</tr>
<tr>
<td></td>
<td>The variable name can be changed by clicking the selected name in the line editor.</td>
</tr>
<tr>
<td></td>
<td>When you select a “Chart &lt;n&gt;” in the table, the corresponding chart is also selected in the editor. This also works the other way around.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Cursor &lt;n&gt;”</th>
<th>Y-value at the cursor position</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Delta”</td>
<td>Delta of the Y-value from “Cursor 2” to “Cursor 1”</td>
</tr>
</tbody>
</table>

Multiselection

With multiselection, you can use the numpad keys * and / to expand and collapse selected charts.

You can drag the charts and variables to sort them or move them to other diagrams. When the [Ctrl] key is pressed, the variable is copied. This is also possible in online mode.

Table 462: Context menu in the trace variable list

| “Add Variable” | Adds a new trace variable and opens the “Trace Configuration” dialog with its variable settings. Select a variable in the input field of the “Variable” setting to trace its value curve. |
| “Visible”      | Toggles the visibility of the graph (value curve or trace variable) in the corresponding diagrams: |
|                | • Visible. |
|                | • Invisible. |
|                | When multiple charts or variables are selected in the trace variable list by multiselection, the visibility can be toggled for these graphs. |
| “Display Mode” | Opens the “Trace Configuration” dialog. Select a configuration item in the “Trace Record” tree view or “Presentation (Diagrams)”. |
| “Configuration”| Opens the “Trace Configuration” dialog. The “Variable Settings” are displayed on the right. |

See also

• Chapter 6.4.1.21.4.16.2 “Dialog ‘Trace Configuration’” on page 2804
Navigating in the diagram

**Table 463: With mouse input**

<table>
<thead>
<tr>
<th>User input with the mouse</th>
<th>Mouse cursor symbol during user input</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drag the graph along the X-axis.</td>
<td>![Cursor symbol]</td>
<td>Scrolls trace graphs of all diagrams at the same time along the time axis (X-axis).</td>
</tr>
<tr>
<td>Hold down the [Ctrl] key and drag the graphs along the Y-axis.</td>
<td>![Cursor symbol]</td>
<td>Scrolls the trace graphs of the selected diagrams along the Y-axis.</td>
</tr>
<tr>
<td>Roll the mouse wheel backwards.</td>
<td>![Cursor symbol]</td>
<td>Compressed time axis (like the ( \frac{\text{m}}{\text{s}} ) symbol).</td>
</tr>
<tr>
<td>Roll the mouse wheel forwards.</td>
<td>![Cursor symbol]</td>
<td>Stretches time axis (like the ( \frac{\text{m}}{\text{s}} ) symbol).</td>
</tr>
<tr>
<td>Press and hold down the [Ctrl] key and roll the mouse wheel backwards.</td>
<td>![Cursor symbol]</td>
<td>Compresses the Y-axis.</td>
</tr>
<tr>
<td>Press and hold down the [Ctrl] key and roll the mouse wheel forwards.</td>
<td>![Cursor symbol]</td>
<td>Stretches the Y-axis.</td>
</tr>
<tr>
<td>Requirement: One or two trace cursors are activated. Drag the triangle of a trace cursor to another position along the time axis.</td>
<td>![Cursor symbol]</td>
<td>Refreshes the Y-values in the trace variable list at the same time</td>
</tr>
<tr>
<td>Requirement: “Mouse zooming” is activated (( \text{+} )). Stretch a rectangle.</td>
<td>![Cursor symbol]</td>
<td>Zooms the trace graphs of all diagrams to the rectangle.</td>
</tr>
</tbody>
</table>

**Table 464: With keyboard shortcuts**

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requirement: No trace cursor is activated. [Arrow Left] [Arrow Right]</td>
<td>Scrolls trace graphs of all diagrams at the same time along the time axis.</td>
</tr>
<tr>
<td>[Arrow Up] [Arrow Down]</td>
<td>Scrolls the trace graphs of the selected diagrams along the Y-axis.</td>
</tr>
<tr>
<td>Requirement: One or two trace cursors are activated. [Alt]+[Arrow Left] [Alt]+[Arrow Right]</td>
<td>Scrolls trace graphs of all diagrams at the same time along the time axis.</td>
</tr>
<tr>
<td>[-]</td>
<td>Compressed time axis (like the ( \frac{\text{m}}{\text{s}} ) symbol).</td>
</tr>
<tr>
<td>[+]</td>
<td>Stretches the X-axis (like the ( \frac{\text{m}}{\text{s}} ) symbol).</td>
</tr>
<tr>
<td>[Ctrl]+[-]</td>
<td>Compresses the Y-axis of the selected diagram.</td>
</tr>
<tr>
<td>[Ctrl]+[+]</td>
<td>Stretches the Y-axis of the selected diagram.</td>
</tr>
<tr>
<td>[Tab]</td>
<td>Selects the next lower diagram.</td>
</tr>
</tbody>
</table>
Shortcut

| Requirement: One or two trace cursors are activated.  
| [Arrow Left]  
| [Arrow Right] |
| Effect |
| Moves the black trace cursor. |

| Requirement: Two trace cursors are activated.  
| [Shift]+[Arrow Left]  
| [Shift]+[Arrow Right] |
| Effect |
| Moves the gray trace cursor. |

See also
- Chapter 6.4.1.21.3.22.5 “Command ‘Cursor’” on page 2733
- Chapter 6.4.1.21.3.22.9 “Command ‘Mouse Zooming’” on page 2737
- Chapter 6.4.1.13 “Application at Runtime” on page 1995

Object ‘Trend Recording Manager’

Symbol

A “Trend Recording Manager” object makes it possible to save data at runtime in a database for a long period of time. This data is recorded with the “CmpTraceMgr” runtime system component. In the device tree, this object is used as a node for trend recordings that are created below an application. It is available below an application only one time.

See also
- Chapter 6.4.1.13.4 “Data Recording with Trend” on page 2016
- Chapter 6.4.1.21.3.5.1 “Command ‘Add Object’” on page 2598
- Chapter 6.4.1.21.2.33 “Object ‘Trend Recording’” on page 2545

Object ‘Trend Recording’

Symbol

A “Trend Recording” object is always located below a “Trend Recording Manager” and enables editing of the trace configuration. At runtime, CODESYS transfers the configuration that is available to the runtime system component CmpTraceMgr. You can configure an application with any number of trend recordings.

NOTICE!

Timeout for trend recording

During a trend recording, it can happen that the application task triggers a timeout that is caught with an exception when transitioning from “Running” to “Stop”. Causes can be that file operations with the SQLite database are taking too long or that too many variables are being recorded. This usually happens on a target device with weak performance.

You can avoid the occurrence of an exception:
- Configure the trend recording with less memory demand so that the amount of data that is stored is adapted to the target system.
- Reduce the number of variables.

The editor includes the configuration for trend recording. The tree view shows the trend configuration and enables navigation there.
The top entry contains the trend name. When this entry is selected, the “Record Settings” are displayed next to it. An entry is located here for each variable whose data was recorded continuously. When a variable is selected, the “Variable Settings” are displayed next to it.

<table>
<thead>
<tr>
<th>“Add Variable”</th>
<th>When you click the link, a new entry is displayed in the trend configuration with its blank configuration below the “Variable Settings” group.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Delete Variable”</td>
<td>The selected variable is removed. Requirement: A variable is selected.</td>
</tr>
</tbody>
</table>

See also

- Command 'Edit Trend Recording'

'Recording Settings'
The data is recorded in the runtime system component by means of the functionality which is also used for the trace. The settings that appear here are the same. The options that are not required here are deactivated.

| “Task” | Task where data was recorded. Click to open a list box with all tasks available in the project. In general, the trend recording runs in the same task as the main program. For example: MainTask |
| “Recording condition” | Condition under which the application records data: |
| | - IEC variable of type INT. The condition is fulfilled for TRUE. |
| | - Bit access to an integer variable. The condition is fulfilled for 1. As read access to a property. |
| | The contents of a pointer are not permitted. |
| | Note: If no condition is defined, then the recording starts automatically. |
| “Comment” | Comment (example: Data recording of sensor A) |
| “Resolution” | Resolution that the application saves the time stamp |
| | Note: If the task where the trend object is executed has a cycle time of 1 ms or less, then you should set the resolution of the time stamp to “1 µs”. |
| “Trend Storage” | The “Trend Storage” dialog opens. |
| “Advanced” | The “Advanced Trend Settings” dialog opens. |

See also

- Chapter 6.4.1.21.4.17 “Dialog Box ‘Trend storage’” on page 2809
- Chapter 6.4.1.21.4.18 “Dialog Box ‘Advanced Trend Settings’” on page 2810
### Variable Settings

| **“Variable”** | Variable for recorded value. |
|               | - IEC variable with valid data type |
|               | - Property |
|               | - Reference |
|               | - Contents of the pointer |
|               | - Array element of a valid data type |
|               | - Enumeration of a valid data type |
|               | Valid data types are all standard types, except STRING, WSTRING, and ARRAY. |

| **“Parameter”** | Parameter for the recorded value |
|                | The “Input Assistant” dialog lists all valid system parameters in the “Parameters” category of the “Categories” tab. |

| **“Recording condition”** | Condition under which the application records the data of these “Variables”: |
|                         | - IEC variable of type INT. The condition is fulfilled for TRUE. |
|                         | - Bit access to an integer variable. The condition is fulfilled for 1. |
|                         | As read access to a property |
|                         | The contents of a pointer are not permitted. |
|                         | Note: If no condition is defined, then the recording starts automatically. |

| **“Attached y axis”** | Y-axis of the trend diagram that displays the “Variable”. The list box provides the standard Y-axis and the configured Y-axes. |
|                      | Requirement: This option is visible only when the “Trend” visualization element has configured additional Y-axes in the “Edit Display Settings” dialog. |

| **“Display variable name”** | : The visualization shows the name of the IEC variable in the trend diagram at runtime. Either alone or in parentheses after the “Description” |
|                           | : The name of the IEC variable is shown and does not appear in parentheses after the “Description”. |
|                           | Requirement: If any text is typed in “Description”, then you can disable the option. |

| **“Description”** | Text for the tooltip (example: Sensor A): When a visualization user focuses on the variable in the trend diagram, the visualization shows the text as a tooltip. The text is typed into the “GlobalTextList” object and can be localized there. |
|                  | When the “Display Variable Name” property is activated, then the text is supplemented with the variable name in parentheses. Example: Sensor A (PLC_PRG.iSensor_A) |
|                  | If “Description” does not contain any text, then “Display Variable Name” is enabled. The name is then alone without parentheses (for example, PLC_PRG.iSensor_A). |
|                  | If a legend is assigned to the trend, then the trend variable is labeled in the legend and shown like the trend is configured here. |

| **“Curve type”** | |
|                 | - “Line” |
|                 | - “Area”: |

| **“Graph color”** | Color of the curve in the trend diagram |

| **“Line type”** | |
|                | - “Line”: Values are linked to form a line. |
|                | - “Step”: Values are linked in the form of steps. |
|                | - “None”: Values are not linked. |
|                | Requirement: The “Curve type” is “Line”. |
**Filling type**
- "No filling"
- "Plain color"
- "Gradient"

Requirement: The “Curve type” is “Area”.

**Filling color**
- [ ] The area is filled with the selected color.

Requirement: The “Curve type” is “Area”.

**Transparency**
Value (0 to 255) for defining the transparency of the selected color

Example 255: The color is opaque. 0: The color is completely transparent

Requirement: The “Curve type” is “Area”.

**Line width**
Value (in pixels)

Example: 1

**Line style**
The display of the line is solid, dash, dot, dash-dot, or dash-dot-dot.

**Point type**
Display as scatter chart
- "Dot": Value as a dot.
- "Cross": Value as a cross.
- "None": No dot display

Hint: Select “None” for larger size data.

**Activate minimum warning**
- [ ] Warning when below the lower limit.

**Critical lower limit**
If the variable value is below the limit, then the variables are displayed with the alert color in the trend diagram.

**Color**
Warning color on falling below the limit

**Activate maximum warning**
- [ ] A warning is issued if the upper limit is exceeded.

**Critical upper limit**
If the variable value exceeds the limit, then the variables are displayed with the alert color in the trend diagram.

**Color**
Warning color on exceeding the limit

See also
- % Chapter 6.4.1.21.4.16.2 "Dialog 'Trace Configuration'" on page 2804
- Dialog 'Display Settings'
- Visualization Element 'Legend'

See also
- % Chapter 6.1.21.3.5.1 "Command 'Add Object'" on page 2598
- % Chapter 6.4.1.13.4 "Data Recording with Trend" on page 2016
- Visualization Element 'Trend'

### Object 'Trend Recording Task'

**Symbol** 🔄

If you design a visualization with a “Trend” element, then CODESYS automatically extends the “Task Configuration” with a “Trend Recording Task”. The task is below an application one time at most and calls the VisuTrendStorageAccess.GlobalInstances.g_TrendRecordingManager.CyclicCall program to run the trend recording manager.

See also
- % Chapter 6.1.21.3.5.1 "Command 'Add Object'" on page 2598
- % Chapter 6.4.1.13.4 "Data Recording with Trend" on page 2016
Object 'Unit Conversion'

Symbol 🡣

A "Unit Conversion" object is used to define a conversion rule. The following table lists all defined conversion rules. You can edit a conversion rule in the input fields listed below the table.

Table of conversion rules

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>Name</code></td>
<td><code>&lt;name&gt;</code> : <code>&lt;name&gt;_Impl</code> is the name of the conversion rule. CODESYS automatically implements the entry as a function block <code>&lt;name&gt;_Impl</code> and instances it as <code>&lt;name&gt;</code>.</td>
</tr>
<tr>
<td><code>Type</code></td>
<td>Type of conversion rule</td>
</tr>
<tr>
<td>------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><code>Single scaling (offset)</code></td>
<td>Adds an offset to the input variable. Result := Input + Offset.</td>
</tr>
<tr>
<td><code>Single scaling (factor)</code></td>
<td>Multiplies the input variable by a factor. Result := Input * Factor.</td>
</tr>
<tr>
<td><code>Linear scaling 1 (factor and offset)</code></td>
<td>Converts the input variable with a factor and offset. Result := Input * Factor + Offset.</td>
</tr>
<tr>
<td><code>Linear scaling 2 (Base and target range)</code></td>
<td>Converts the input variable for the output value to be within a target range. CODESYS calculates the functional linear equation internally.</td>
</tr>
<tr>
<td><code>User defined conversion</code></td>
<td>Configures a user-defined conversion rule with IEC operators. The input variable is <code>rValue</code>.</td>
</tr>
<tr>
<td><code>Switchable conversion</code></td>
<td>Defines a conversion rule that CODESYS executes independent of any specified language or variable.</td>
</tr>
<tr>
<td><code>Setting</code></td>
<td>Displays the configured conversion rule.</td>
</tr>
<tr>
<td><code>Condition</code></td>
<td>True: CODESYS always executes the conversion. Language: If the language in the visualization is the language defined here, then CODESYS executes the conversion. The current visualization language is located in the <code>VisuElems.CurrentLanguage</code> variable. Variable: If the comparison is TRUE, then CODESYS executes the conversion rule. CODESYS can pass the comparison for a constant, variable, or IEC expression.</td>
</tr>
<tr>
<td><code>Condition Setting</code></td>
<td>If you select &quot;TRUE&quot; as the &quot;Condition&quot;, then the field is hidden. If you configure &quot;Language&quot; as the &quot;Condition&quot;, then the field shows the current configuration, for example en, de. If you select &quot;Variable&quot; as the &quot;Condition&quot;, then the field shows the current configuration, for example <code>PLC_PRG.bActual=PLC_PRG.bSet</code>. You can edit the current condition setting below the table in the &quot;Condition Setting&quot;.</td>
</tr>
</tbody>
</table>

Input field 'Single scaling (offset)'

The input variable is added with an offset.

<table>
<thead>
<tr>
<th>Offset</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>● as a number, including REAL</td>
</tr>
<tr>
<td></td>
<td>● as an IEC variable</td>
</tr>
</tbody>
</table>

Input field 'Single scaling (factor)'

The input variable is multiplied by the factor.
Input field 'Linear scaling 1 (factor and offset)'

The input variable is converted with the linear equation defined below.

| "Factor" | ● as a number, including REAL  
|          | ● as an IEC variable |
| "Offset" | ● as a number, including REAL  
|          | ● as an IEC variable |

Input field 'Linear scaling 2 (Base and target range)'

The input variable is converted to be within a target range. CODESYS internally creates a linear equation from the following input values.

| "Base start value" | Lowest possible value for the input variable.  
|                    | ● as a number, including REAL  
|                    | ● as an IEC variable |
| "Base end value"   | Highest possible value for the input variable.  
|                    | ● as a number, including REAL  
|                    | ● as an IEC variable |
| "Target start value" | Lowest possible value for the output variable.  
|                    | ● as a number, including REAL  
|                    | ● as an IEC variable |
| "Target end value" | Highest possible value for the output variable.  
|                    | ● as a number, including REAL  
|                    | ● as an IEC variable |

Example

Conversion of electric current from a 10-bit input signal to an amperage range of 4-20 mA

| "Base start value" | 0 |
| "Base end value"   | 1024 |
| "Target start value" | 4.0 |
| "Target end value" | 20.0 |

Input field 'User defined conversion'

| "Convert :=" | Conversion rule as mathematical function of rValue The input variable is rValue. |
| "Reverse :=" | Reverse function of the function defined in "Convert" |
**Input field**

Use this conversion rule when you want to apply a conversion that is language-specific or variable-dependent.

<table>
<thead>
<tr>
<th>“Switchable conversion name”</th>
<th>Selected from a list of predefined conversion rules. Double-click directly into the field for editing.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Condition setting”</td>
<td>Configured condition. Click into the input fields in “Condition setting” to edit the condition.</td>
</tr>
</tbody>
</table>

**Example**

The `Conv_A_LanguageDependent` conversion rule that defines which conversion rule is executed for the English or German language.

<table>
<thead>
<tr>
<th>“Name”</th>
<th>“Type”</th>
<th>“Setting”</th>
<th>“Condition”</th>
<th>“Condition setting”</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>Conv_A_LanguageDependent</code></td>
<td>“Switchable conversion”</td>
<td><code>Conv_AInInch</code>, <code>Conv_AInMM</code></td>
<td>“Language”</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Switchable conversion name”</th>
<th>“Condition setting”</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>Conv_AInInch</code></td>
<td>en</td>
</tr>
<tr>
<td><code>Conv_AInMM</code></td>
<td>de</td>
</tr>
</tbody>
</table>

See also

●

### 6.4.1.21.3 Menu Commands

**General**

By default the most important commands are already provided in the CODESYS user interface. If you want to customize the menu configuration individually, choose command “Tools ➔ Customize ➔ Menu”.

When you have installed any packages or add-ons, additional menus and commands might be available.
Menu 'File'

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.4.1.21.3.2.1</td>
<td>Command 'New Project'</td>
</tr>
<tr>
<td>6.4.1.21.3.2.2</td>
<td>Command 'Open Project'</td>
</tr>
<tr>
<td>6.4.1.21.3.2.3</td>
<td>Command 'Close Project'</td>
</tr>
<tr>
<td>6.4.1.21.3.2.4</td>
<td>Command 'Save project'</td>
</tr>
<tr>
<td>6.4.1.21.3.2.5</td>
<td>Command 'Save Project as'</td>
</tr>
<tr>
<td>6.4.1.21.3.2.6</td>
<td>Command 'Save Project and Install into Library Repository'</td>
</tr>
<tr>
<td>6.4.1.21.3.2.7</td>
<td>Command 'Save Project as Compiled Library'</td>
</tr>
<tr>
<td>6.4.1.21.3.2.8</td>
<td>Command 'Save/Send Archive'</td>
</tr>
<tr>
<td>6.4.1.21.3.2.9</td>
<td>Command 'Save Project and Install into Library Repository'</td>
</tr>
<tr>
<td>6.4.1.21.3.2.10</td>
<td>Command 'Source Upload'</td>
</tr>
<tr>
<td>6.4.1.21.3.2.11</td>
<td>Command 'Source Download'</td>
</tr>
<tr>
<td>6.4.1.21.3.2.12</td>
<td>Command 'Print'</td>
</tr>
<tr>
<td>6.4.1.21.3.2.13</td>
<td>Command 'Print Preview'</td>
</tr>
<tr>
<td>6.4.1.21.3.2.14</td>
<td>Command 'Page Setup'</td>
</tr>
<tr>
<td>6.4.1.21.3.2.15</td>
<td>Command 'Recent Projects'</td>
</tr>
<tr>
<td>6.4.1.21.3.2.16</td>
<td>Command 'Exit'</td>
</tr>
</tbody>
</table>

Command ‘New Project’

Symbol: ☑, Shortcut: [Ctrl] + [N]

Function: This command opens the “New Project” dialog box for the creation of a new project file.

Call: “File” menu

'New Project' dialog box

Function: Selection of a project category and a project template.

Call: “File ➔ New Project”

Depending on the template, you obtain a project that is automatically equipped with a certain range of objects.

Table 465: “Categories”

<table>
<thead>
<tr>
<th>Libraries</th>
<th>Projects</th>
</tr>
</thead>
</table>

Table 466: “Templates”

<table>
<thead>
<tr>
<th>Projects” category:</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Empty project”</td>
<td>Contains only the “Project Settings” object</td>
</tr>
<tr>
<td>“Standard project”</td>
<td>Contains a basic range of objects and libraries. A wizard assists with the creation – see below.</td>
</tr>
<tr>
<td>“Standard project with Application Composer”</td>
<td>Contains a basic range of objects and libraries for working with the Application Composer. A wizard assists with the creation.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Libraries” category:</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“CODESYS container library”</td>
<td>Library that contains only further libraries, but no function blocks of its own.</td>
</tr>
<tr>
<td>“CODESYS interface library”</td>
<td>Library only for the definition of the interface of a software component. Thus contains only objects that do not generate any code (constants, structures, interfaces, etc.).</td>
</tr>
<tr>
<td>“Empty library”</td>
<td>Contains only the “Project Settings” object</td>
</tr>
</tbody>
</table>
**“External CODESYS library”**
Target-system-specific library which is implemented as part of the runtime system (in ANSI C or C++).

**“Name”**
Name of the project to be created. Depending on the template, a standard name appears. The numerical suffix ensures the uniqueness of the name in the file system.
You can change the file name, taking into consideration the file path conventions of the operating system. Periods are not permitted in names.
CODESYS automatically adds the appropriate file extension to the selected template.

**“Location”**
Location for the new project file.
[...]
opens a dialog box for browsing the file system.

displays the history of previously entered paths

**“OK”**
CODESYS opens a new project. An error symbol next to the input field draws attention to missing specifications. If you place the mouse pointer on it, a tooltip appears, informing you what to do.

---

**“Standard Project” dialog box**

**Function:** Wizard for the creation of a standard project.

**Call:** Command “File → New Project”; in the “New Project” dialog box, select the “Projects” category and the “Standard project” template and click on “OK”.

---

**“Device”**
Selection list with PLC devices. The selected device is inserted as an object in the Devices view below the root node

**“PLC_PRG in”**
Selection list with the programming languages. The automatically inserted program PLC_PRG is created in the selected language.

---

**Command ‘Open Project’**

Symbol: 🖼; shortcut: [Ctrl]+[O]

**Function:** The command opens the default dialog for loading a project. You can search for a CODESYS project in the file system and open it in the development system.

**Call:** Menu bar: “File”

---

**Dialog ‘Open Project’**

**“File type”**
Type of the CODESYS project to be loaded to the development system

**“All supported files”**
Filters by all projects which CODESYS can load

Hint: For example, you can select PRO projects which have been created with CoDeSys V2.3. These kinds of projects are also converted.

**File extension**

**project**
Filters by projects which have been created with CODESYS V3

**projectarchive**
Filters by project archives which have been created with CODESYS V3
<table>
<thead>
<tr>
<th>File extension library</th>
<th>Filters by library projects which have been created with CODESYS V3</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Open”</td>
<td>Loads the project you selected to CODESYS</td>
</tr>
<tr>
<td></td>
<td>Note: Depending on the state of your CODESYS installation, it may be necessary to update or supplement the installation. If this is the case, then first open another “Open Project” dialog with options for installation management.</td>
</tr>
</tbody>
</table>

See also

- § Chapter 6.4.1.3.2 “Opening a V3 Project” on page 1808
- § Chapter 6.4.1.3.3 “Opening a V2.3 project” on page 1809

Command ‘Close Project’

Function: This command closes the currently opened project. CODESYS remains opened.

Call: “File” menu. In addition implicitly when opening a new/other project, while another project is still open.

If the project contains unsaved changes, a query appears, asking whether the project should be saved.

If you have not yet explicitly saved the project, a query appears asking whether you wish to delete the project files.

Command 'Save project'

Symbol: ⽔, shortcut [Ctrl] + [S]

Function: this command saves the project file.

Call: “File” menu

This command saves the project file with the current project name, which appears in the title bar of the main window. If the project has been changed since it was last saved, the project name is given an asterisk.

The command is not available if the project is read-only.

Write protection exists if

- the project is identified in the project information (summary) as 'Released'
- the option “Open read-only” was selected in the dialog box “Open Project” when opening the project

Write protection is indicated by a line in the top right corner of the main window. A mouse-click on this line brings up a menu with commands for the possible actions:

- “Save project under a different file name on the disk”: a mouse-click on this option leads to 'Save file as…'
- “Exit read-only mode”: appears only if the option “Open read-only” was selected when opening the project.
- “Remove read-only attribute from the project on the disk”: appears only if the project file had been provided with the property 'Read-only' on the disk at the time of opening.
- “Remove identification 'Released in the project information'”: appears only if this attribute is currently set.

Backup copy

Optionally a backup copy of the project file can be created. If the option “Create backup copy” is activated in the option dialog box 'Load and Save', the project is additionally copied to a file <projectname.backup> each time the project is saved.
See also

- Chapter 6.4.1.21.3.2.5 “Command ‘Save Project as’” on page 2555
- Chapter 6.4.1.6.9 “Saving the Project” on page 1831
- Chapter 6.4.1.21.4.14.17 “Dialog ‘Options’ – ‘Load and Save’” on page 2791

Command ‘Save Project as’

This command opens the standard Windows dialog box for saving a file. The project can be stored with the desired location and file type.

---

**“File type”**

For both normal projects and library projects, this drop-down list contains the respective versions of the development system for which the project can be saved. If the current project contains add-ons that are not available in the selected memory format (profile), then the “Extend Profile” dialog box opens.

- **“Project files (CODESYS v<version>) (*.project)”**: The project is saved as a CODESYS project file “<project name>.project” for the currently used or selected version of the development system.
- **“Library files (CODESYS v<version>) (*.library)”**: The project is saved as a CODESYS library file “<project name>.library” for the currently used or selected version of the development system.

If the project should be opened later in an older version, then it makes sense to save for precisely this version, as you will then be informed immediately about possible data loss.

---

**Before saving a project as a library:**

- Make sure that the rules for creating libraries have been followed.
- If it is to be possible to configure global constants provided by the library at a later time in an application, then you must define them in a parameter list. A parameter list is a special type of global variable list.
- When saving the project, no automatic check for errors is performed.
- Unlike CoDeSys V2.3, there is no distinction between 'external' and 'internal' libraries. Now you can define in the properties of each individual project object whether or not it should be treated as 'external'.
- Consider whether the library created is to be installed in the system library repository immediately. If so, then use the command ‘Save project and install in the library repository’.
- If you want to protect the library project from later changes, then set the “Released” attribute in the “Project Information” dialog box. At the next attempt to save the project, a corresponding message will be displayed and the user must respond to the write protection with deliberate actions.
- If you save the project as a version of the development system other than the one currently in use, then you will be informed first about possible data loss.

---

**Dialog box ‘Extend Profile’**

In this dialog box, the selected profile (memory format) can be extended by the add-ons that are contained in the current project. The profile is saved temporarily and then deleted after being saved or exported.

---

**“Add to profile”**

- The current profile is extended by the add-on so that the add-on data of the current project is also saved.

**“Add-on”**

- The add-on of the current project that is not contained in the selected memory format.

**“Version”**

- Version of the “Add-on” included in the current profile.
  - If several versions are installed, then the version can be selected.
“Save profile” Opens the “Enter Profile Name” dialog box. In this dialog box, specify the name for the new profile. The new profile is saved permanently at $ProgramData$/PRODUCT$/CustomInformationalProfiles.

“Use saved profile” The profile which was permanently saved in “Save profile” is used for saving or exporting the current project.

See also
- Chapter 6.4.1.21.3.2.4 “Command ‘Save project’” on page 2554
- Chapter 6.4.1.6.9 “Saving the Project” on page 1831
- Chapter 6.4.1.21.4.14.17 “Dialog ‘Options’ – ‘Load and Save’” on page 2791
- Chapter 6.4.1.17.3 “Information for Library Developers” on page 2035
- Chapter 6.4.1.21.3.2.6 “Command ‘Save Project and Install into Library Repository’” on page 2556

Command ‘Save Project and Install into Library Repository’

Function: this command saves the project as a library in the 'system' library repository.

Call: Main menu “File”.

With this command CODESYS saves the project as a library in the 'system' library repository. This is an extension to the saving of a project as a library file using the “Save Project as” command. The library is installed on the local system and is immediately available for insertion into a project.

See also
- Chapter 6.4.1.21.3.2.5 “Command ‘Save Project as’” on page 2555

Command ‘Save Project as Compiled Library’

Function: The command saves a library project in encrypted form.

Call: Menu bar: “File”

The command opens the default dialog for saving a file in the file system. The “Compiled CODESYS Libraries” file type is already preset. The file extension is .compiled-library-v3 or .compiled-library (CODESYS < SP15). In this format, then source code of the library POU is not visible when the library is used in a project.

If the “Enforce signing of compiled libraries” option is selected in the “Security Screen” view on the “User” tab, then a library project has to be provided with a digital certificate-based signature when being saved. When a suitable certificate is available, it is provided in the “Security Screen” on the “User” tab in the “Digital Signature” section. In the “Project Information”, on the “Summary” tab, a “Library compatibility” with a CODESYS version >= V3 SP15 is set by default. In this case, the project file is stored with the file extension .compiled-library-v3 when being saved as a compiled and signed library. If you still have not specified a suitable valid certificate for your user profile in the “Security Screen”, then a dialog prompt opens next for you to do this. Afterwards, you can execute the save command again.

In all other respects, compiled library files behave just like *.library files, and therefore they can be installed and referenced with the same steps.

We recommend the use of compiled libraries signed with certificates. Besides the protection of the source code and the unauthorized use of a library, less memory is also used which therefore results in shorter loading times.
If you have the corresponding help files with translations, then as of CODESYS V3 SP15 you can extend the library documentation with the translation into other languages. This is done as follows:

Place the files created for the new languages \_lmd\_<language>.aux in a directory <library name>\_lmd parallel to the library project <library name>\_compiled-library-v3. If the files are correct, then they are included in the compiled library file when saving the library project by means of the “Save Project as Compiled Library” command.

Example: The directory standard.lmd is exists parallel to the library file standard\_compiled-library-v3 and contains the file \_lmd\_fr.aux with the French translation of the library documentation. After the compiled library is saved, the French version of the documentation is also available in the Library Manager.

See also
- “Tab ‘Summary’” on page 2515
- Chapter 6.4.1.21.3.4.18 “Command ‘Security Screen’” on page 2592
- Chapter 6.4.1.17.3 “Information for Library Developers” on page 2035
- Chapter 6.4.1.21.3.2.6 “Command ‘Save Project and Install into Library Repository’” on page 2556

Command ‘Save/Send Archive’

Function: This command opens the dialog “Project Archive” for the configuration of project archives.

Call: Menu bar: “File ➔ Project Archive”

An archive file (*.projectarchive) contains all files contained and referenced in the currently opened project. It can either be saved or dispatched as an e-mail attachment. The dispatch by email is very helpful for providing an employee with all project-relevant files. The file can be simply unpacked again with the command “Extract Archive”.

Notice!
The archiving function is not intended for the storage of a project, but rather for the simple summarizing of all project-relevant files.

See also
- Chapter 6.4.1.6.10 “Saving/Sending the project archive” on page 1832
- Chapter 6.4.1.21.3.2.9 “Command ‘Extract Archive’” on page 2558

Dialog ‘Project Archive’
The dialog displays all the categories that can be added to the project archive. In this dialog, complete categories or individual objects from the categories can be added to the project archive by setting a check mark (✓).

Entries that are displayed as red in the list require your attention. Move the mouse pointer over this library for more information.
**“Additional Files”**
Opens the dialog “Additional Files”. Here, further files can be added to the archive with the “Add” button.

**“Comment”**
Opens the “Comment” dialog. Here, comments can be added to the archive.

**“Save”**
Creates the archive file and saves it. The storage location and the archive name are specified in the subsequent dialog.

**“Send”**
Creates a temporary archive file that is attached to an empty e-mail. A correct installation of the MAPI (Messaging Application Programming Interface) is required for the successful execution of this operation. Failure is documented by the display of a corresponding error message. The temporary archive is automatically deleted after sending the e-mail.

### Command 'Extract Archive'

**Function:** The command extracts a project archive, that was created with the command “Save/Send Archive”. You have to configure which objects of the archive CODESYS shall extract and in which directory of the file system they will be copied.

**Call:** Main menu “File ➔ Project Archive”

The file extension of an archive is `.projectarchive`.

After the archive is selected, the dialog “Extract Project Archive” opens to configure the extract parameters.

#### Dialog Box 'Extract Project Archive'

This dialog box shows the contents of the project archive. You can exclude complete categories or single objects from categories by clearing the check boxes (☑) from the extraction.

<table>
<thead>
<tr>
<th>Table 467: “Locations”</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Extract into the same folder where the archive is located”</td>
</tr>
<tr>
<td>“Extract into the following folder”</td>
</tr>
<tr>
<td>“Advanced”</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 468: “Contents”</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Items”</td>
</tr>
<tr>
<td>☑:</td>
</tr>
<tr>
<td>☐:</td>
</tr>
<tr>
<td>“Comment”</td>
</tr>
</tbody>
</table>

| “Extract” | If an extracted file has the same name as an existing file in the target directory, then a dialog box opens, prompting whether the local file should be replaced. The decision can be applied automatically to any additional conflicting names. In this case, you have to select the ☑ “Apply to all objects and files” check box. |

Dialog 'Advanced'
Table 469: “Repositories”

<table>
<thead>
<tr>
<th>Install devices into</th>
<th>Drop-down list with currently available repositories. Select the repositories, in which CODESYS shall install the devices and the libraries of the archive.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install libraries into</td>
<td></td>
</tr>
</tbody>
</table>

Table 470: “Additional Files”

By default the "additional files" are set to "Do not extract". Select the entries in the table and chose one of the following options:

<table>
<thead>
<tr>
<th>Extract into project folder</th>
<th>Folder of the project file</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extract into folder</td>
<td>User defined folder</td>
</tr>
<tr>
<td>Do not extract</td>
<td>Default</td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.1.21.3.2.8 “Command 'Save/Send Archive'” on page 2557

Command 'Source Upload'

**Function:** This command loads the project source code (as project archive) from the controller.

**Call:** Main menu “File”.

**Requirement:** The network path for the controller must be configured.

After you execute the command, an overview opens with all devices in the network. Select a controller from this overview. The dialog box “Extract Project Archive” then opens with export settings.

See also

- Chapter 6.4.1.21.3.2.11 “Command 'Source Download'” on page 2560

Dialog Box 'Extract Project Archive'

This dialog box shows the contents of the project archive. You can exclude complete categories or single objects from categories by clearing the check boxes (x) from the extraction.

Table 471: “Locations”

<table>
<thead>
<tr>
<th>Extract into the same folder where the archive is located</th>
<th>The archive is extracted to the same directory.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extract into the following folder</td>
<td>The contents of the archive are extracted to the given path.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Opens the “Advanced” dialog box for you to define where special and additional files from the archive are extracted.</td>
</tr>
</tbody>
</table>

Table 472: “Contents”

<table>
<thead>
<tr>
<th>Items</th>
<th>Shows the contents of the archive structured in object categories.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>☑️: The object is extracted.</td>
</tr>
<tr>
<td></td>
<td>☐️: The object is not extracted.</td>
</tr>
<tr>
<td>Comment</td>
<td>Comment that was entered when creating the project archive</td>
</tr>
</tbody>
</table>
**Command 'Source Download'**

**Function:** This command loads the project source code (as project archive) to the controller.

**Call:** Main menu “File”.

**Requirement:** The network path for the controller must be configured.

After you execute the command, an overview opens with all devices in the network. Select a controller from this overview. Then the Archiv.prj project archive is downloaded to this controller. You can click “Source Upload” to upload the complete source code to the CODESYS development system at a later time.

If you are already connected to a controller (in online mode), then the “Source Download to Connected Device” command is also available for this process.

See also

- Chapter 6.4.1.21.3.2.10 “Command ‘Source Upload’” on page 2559
- Chapter 6.4.1.21.3.7.7 “Command ‘Source Download to Connected Device’” on page 2631

**Command 'Print'**

**Symbol:** ☑

**Function:** This command opens the default Windows dialog box for printing documents.

**Call:** Main menu “File”

See also

- Chapter 6.4.1.21.4.12.7 “Dialog ‘Project Settings’ - ‘Page Setup’” on page 2772

**Command 'Print Preview'**

**Function:** This command opens a print preview for the currently open element.

**Call:** Main menu “File”

**Requirement:** An object is open in the editor.

See also

- Chapter 6.4.1.21.4.12.7 “Dialog ‘Project Settings’ - ‘Page Setup’” on page 2772
- Chapter 6.4.1.21.3.2.12 “Command ‘Print’” on page 2560

**Command 'Page Setup'**

**Symbol:** ☑

**Function:** This command opens the “Page Setup” dialog box for configuring the layout of the printed version of the project contents.

**Call:** Main menu “File ➔ Page Setup”
See also
- % Chapter 6.4.1.21.4.12.7 “Dialog ‘Project Settings’ - ‘Page Setup’” on page 2772
- % Chapter 6.4.1.21.3.2.12 “Command ‘Print’” on page 2560

Command ‘Recent Projects’

**Function:** Opens the list of the projects used recently, from which you can select a project to open.

**Call:** “File” menu

Command ‘Exit’

**Shortcut:** [Alt]+[F4]

**Function:** this command exits from the programming system. If a project is currently opened that has been changed since it was last saved, a dialog box opens asking whether the project should be saved.

**Call:** “File” menu
### Menu 'Edit'

<table>
<thead>
<tr>
<th>Command Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Commands</td>
<td>2562</td>
</tr>
<tr>
<td>'Find', 'Find in Project'</td>
<td>2563</td>
</tr>
<tr>
<td>'Replace', 'Replace in Project'</td>
<td>2564</td>
</tr>
<tr>
<td>'Find Next'</td>
<td>2565</td>
</tr>
<tr>
<td>'Find Next (Selection)'</td>
<td>2565</td>
</tr>
<tr>
<td>'Find Previous'</td>
<td>2565</td>
</tr>
<tr>
<td>'Find Previous (Selection)'</td>
<td>2566</td>
</tr>
<tr>
<td>'Insert File as Text'</td>
<td>2566</td>
</tr>
<tr>
<td>'Overwrite Mode'</td>
<td>2566</td>
</tr>
<tr>
<td>'View Whitespace'</td>
<td>2566</td>
</tr>
<tr>
<td>'View Indentation Guides'</td>
<td>2567</td>
</tr>
<tr>
<td>'Go to Line'</td>
<td>2567</td>
</tr>
<tr>
<td>'Make Uppercase'</td>
<td>2567</td>
</tr>
<tr>
<td>'Make Lowercase'</td>
<td>2567</td>
</tr>
<tr>
<td>'Go to Matching Bracket'</td>
<td>2568</td>
</tr>
<tr>
<td>'Select to Matching Bracket'</td>
<td>2568</td>
</tr>
<tr>
<td>'Expand All Folds'</td>
<td>2568</td>
</tr>
<tr>
<td>'Collapse All Folds'</td>
<td>2568</td>
</tr>
<tr>
<td>'Comment Out Selected Lines'</td>
<td>2569</td>
</tr>
<tr>
<td>'Uncomment Selected Lines'</td>
<td>2569</td>
</tr>
<tr>
<td>'Enable Inline Monitoring'</td>
<td>2569</td>
</tr>
<tr>
<td>'Toggle Bookmark'</td>
<td>2569</td>
</tr>
<tr>
<td>'Next Bookmark (Active Editor)'</td>
<td>2570</td>
</tr>
<tr>
<td>'Next Bookmark'</td>
<td>2570</td>
</tr>
<tr>
<td>'Previous Bookmark (Active Editor)'</td>
<td>2570</td>
</tr>
<tr>
<td>'Previous Bookmark'</td>
<td>2570</td>
</tr>
<tr>
<td>'Clear All Bookmarks (Active Editor)'</td>
<td>2571</td>
</tr>
<tr>
<td>'Clear All Bookmarks'</td>
<td>2571</td>
</tr>
<tr>
<td>'Browse Cross References'</td>
<td>2571</td>
</tr>
<tr>
<td>'Browse Global Cross References'</td>
<td>2571</td>
</tr>
<tr>
<td>'Browse Call Tree'</td>
<td>2572</td>
</tr>
<tr>
<td>'Auto Declare'</td>
<td>2572</td>
</tr>
<tr>
<td>'Input Assistant'</td>
<td>2574</td>
</tr>
<tr>
<td>'Go to Source Position'</td>
<td>2575</td>
</tr>
<tr>
<td>'Next Message'</td>
<td>2576</td>
</tr>
<tr>
<td>'Previous Message'</td>
<td>2576</td>
</tr>
<tr>
<td>'Go to Definition'</td>
<td>2576</td>
</tr>
<tr>
<td>'Go To Reference'</td>
<td>2576</td>
</tr>
<tr>
<td>'Go to Instance'</td>
<td>2577</td>
</tr>
<tr>
<td>'Refactoring' - 'Rename &lt;...&gt;'</td>
<td>2577</td>
</tr>
<tr>
<td>'Refactoring' - 'Update Referenced Pins'</td>
<td>2578</td>
</tr>
<tr>
<td>'Refactoring' - 'Add Variable'</td>
<td>2578</td>
</tr>
<tr>
<td>'Refactoring' - 'Remove &lt;variable&gt;'</td>
<td>2580</td>
</tr>
<tr>
<td>'Reorder Variables'</td>
<td>2581</td>
</tr>
<tr>
<td>'Advanced' - 'Format Document'</td>
<td>2581</td>
</tr>
</tbody>
</table>

### Standard Commands

CODESYS provides the following standard commands:
Command 'Find', 'Find in Project'

Symbol ⇤: keyboard shortcut: [Ctrl]+[F]
Symbol ⇧: keyboard shortcut [Ctrl]+[Shift]+[F]

Function: These commands scan the project or parts of it for a specified character string.

Call: Menu bar: “Edit ➔ Find Replace”

This command opens the “Find” dialog where the searched character string is specified and the search options are defined.

Dialog 'Find'

| “Search for” | Character string to be searched. |
| “Match case”: | ✓: The search considers uppercase and lowercase. |
| “Match whole word”: | ✓: Only character strings are found that exact matches. |
| “Search up”: | ✓: The specified search range runs upwards. |
| “Use regular expressions”: | Use the button to receive support when specifying regular expressions. |
| “Search in” | ✓: Drop-down list with the areas of the project to be searched: |
| | ● “Active editor” |
| | ● “All open editors” |
| | ● “Selected objects & Subobjects” |
| | ● “Entire project” |
| | ● “Entire project & Uncompiled libraries” |
| | ● “Selection only” |
| | Opens a dialog where you set the areas of the project to be searched (see below) |
| “Find next” | Start the search |
| “Find all” | All search results are listed in the message view with their object path, project name, object name, and object position. Possible additional information for position: “(Decl)” = Declaration part of the object; “(Impl)” = Implementation part of the object |
| | Double-clicking the entry in the list opens the match position in the respective object editor. |
| “Replace” | Switches to the “Replace” dialog |
The color of the search result markings can be customized in the options of the text editor. This is done by means of the parameter “Selection color” - “Inactive” in the “Text Area” tab.

See also
- Tab 'Text Area’ on page 2799

### Dialog for setting the objects to be searched

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Entire project”</td>
<td>All editable positions in all objects of the project are searched.</td>
</tr>
<tr>
<td>“Entire project and all uncompiled libraries”</td>
<td>All editable positions in all objects of the project, including integrated uncompiled libraries, are searched.</td>
</tr>
<tr>
<td>“Within the following objects”</td>
<td>Only the editable positions within the objects defined here are searched:</td>
</tr>
<tr>
<td></td>
<td>- “Scheme”: The “Save” command saves the current search configuration by the specified name. All saved schemes are available in the drop-down list.</td>
</tr>
<tr>
<td></td>
<td>- “Object types”: The object is searched.</td>
</tr>
<tr>
<td></td>
<td>- “Name filter”: Name filter for the searched objects. The placeholder “*” can be used. Example: Filter “<em>CAN</em>”: All objects are searched that have “CAN” in the name.</td>
</tr>
<tr>
<td>“All open editors”</td>
<td>All editors are searched that are currently open in a window.</td>
</tr>
<tr>
<td>“Active editor”</td>
<td>Only the editor is searched where the cursor currently is.</td>
</tr>
<tr>
<td>“Selection only”</td>
<td>Only the text is searched that is currently selected in an object.</td>
</tr>
</tbody>
</table>

See also
- Chapter 6.4.1.21.3.3.3 “Command ‘Replace’, ‘Replace in Project’” on page 2564
- Chapter 6.4.1.9.15 “Searching and replacing in the entire project” on page 1910

### Command ‘Replace’, ‘Replace in Project’

Symbol ⋆; keyboard shortcut: [Ctrl]+[H]
Symbol ⋆, keyboard shortcut [Ctrl]+[Shift]+[H]

**Function:** These commands scan the project or parts of it for a specified character string and replaces it.

**Call:** Menu bar: “Edit ➤ Find Replace”

**Requirement:** The application is in online mode.

This command opens the “Replace” dialog where the search and replace character strings are specified and the search options are defined.

### Table 473: In addition to the options of the “Search” dialog, the following settings are still possible:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Replace with”</td>
<td>Input field for the new character string.</td>
</tr>
<tr>
<td>“Replace”</td>
<td>Each next found string is highlighted in the editor and replaced (step-by-step replace).</td>
</tr>
</tbody>
</table>
**Replace all**

All found strings are replaced at one time without them being displayed in the editors.

**“Leave changed objects open after "Replace all"”**

The editors of the found objects remain open.

---

Replacement in referenced libraries is not possible.

See also

- Chapter 6.4.1.21.3.3.2 “Command ‘Find’, ‘Find in Project’” on page 2563
- Chapter 6.4.1.9.15 “Searching and replacing in the entire project” on page 1910

---

**Command ‘Find Next’**

Symbol , keyboard shortcut [F3]

**Function:** During the search for a certain string within the project, this command selects the next match at its position in the respective editor.

**Call:** Menu “Edit ➤ Search Replace”

**Requirement:** You have already started searching the project for a certain string by using the commands “Find” or “Replace”.

See also

- Chapter 6.4.1.21.3.3.2 “Command ‘Find’, ‘Find in Project’” on page 2563
- Chapter 6.4.1.21.3.3.3 “Command ‘Replace’, ‘Replace in Project’” on page 2564
- Chapter 6.4.1.9.15 “Searching and replacing in the entire project” on page 1910

---

**Command ‘Find Next (Selection)’**

Keyboard shortcut [Ctrl] + [F3]

**Function:** The command searches the project for the next string matching the string which is currently selected or in which you have currently placed the cursor.

**Call:** Menu “Edit ➤ Find Replace”

**Requirement:** You have the cursor placed in an editable string in your project, or you have selected an editable string.

See also

- Chapter 6.4.1.21.3.3.2 “Command ‘Find’, ‘Find in Project’” on page 2563
- Chapter 6.4.1.21.3.3.3 “Command ‘Replace’, ‘Replace in Project’” on page 2564
- Chapter 6.4.1.9.15 “Searching and replacing in the entire project” on page 1910

---

**Command ‘Find Previous’**

Symbol , keyboard shortcut [Shift] + [F3]

**Function:** During the search for a certain string within the project, this command selects the next match at its position in the respective editor.

**Call:** Menu “Edit ➤ Search Replace”

**Requirement:** You have already started searching the project for a certain string by using the commands “Find” or “Replace”.

---

Configuration and programming

Programming with CODESYS > CODESYS Development System

2024/01/05 3ADR010583, 1, en_US 2565
See also
- Chapter 6.4.1.21.3.3.2 “Command 'Find', 'Find in Project’” on page 2563
- Chapter 6.4.1.21.3.3.3 “Command 'Replace', 'Replace in Project’” on page 2564
- Chapter 6.4.1.9.15 “Searching and replacing in the entire project” on page 1910

Command 'Find Previous (Selection)'

Keyboard shortcut [Ctrl] + [Shift] + [F3]

**Function:** The command searches the project for the previous string matching the string which is currently selected or in which you have currently placed the cursor.

**Call:** Menu “Edit ➤ Find Replace”

**Requirement:** You have the cursor placed in an editable string in your project, or you have selected an editable string.

See also
- Chapter 6.4.1.21.3.3.2 “Command 'Find', 'Find in Project’” on page 2563
- Chapter 6.4.1.21.3.3.3 “Command 'Replace', 'Replace in Project’” on page 2564
- Chapter 6.4.1.9.15 “Searching and replacing in the entire project” on page 1910

Command 'Insert File as Text'

**Function:** This command copies the contents of a text file to the active editor as the current cursor position.

**Call:** The command is not in any menu by default. You can add it to a menu by using the dialog box from “Tools ➤ Customize” (command category “Text Editor”).

**Requirement:** The file must have the extension .txt. The command is available in a text editor only.

Many development environments and text processing applications provide the option of exporting code and text as a plain text file. This command can copy the contents of this file to the editor.

See also
- Chapter 6.4.1.21.4.14.26 “Dialog 'Options' - 'Text Editor’” on page 2798

Command 'Overwrite Mode'

**Shortcut:** [Insert]

**Function:** This command activates the overwrite mode.

**Call:** Menu “Edit ➤ Advanced”

**Requirement:** A text editor is opened.

If the overwrite mode is activated, characters in front of the cursor are overwritten when entering new characters. If the overwrite mode is deactivated, characters are inserted and existing characters in front of the cursor are retained.

See also
- Chapter 6.4.1.21.4.14.26 “Dialog 'Options' - 'Text Editor’” on page 2798

Command 'View Whitespace'

**Symbol:**  

2566
**Function:** This command causes control characters for spaces and tabs to be shown.

**Call:** Menu “Edit ➔ Advanced”

**Requirement:** A text editor is opened.

CODESYS visualizes spaces by a period and tabs by an arrow.

See also
- Chapter 6.4.1.21.4.14.26 “Dialog ‘Options’ - ‘Text Editor’” on page 2798

---

Command **'View Indentation Guides'**

**Function:** This command activates the indentation help lines.

**Call:** Menu “Edit ➔ Extended”

**Requirement:** A text editor is opened.

If the indentation help lines are activated, a broken line is inserted for each manual indentation in the code. This facilitates the overview of the different levels in the code. You can insert manual indentations with the [Tab] key.

See also
- Chapter 6.4.1.21.4.14.26 “Dialog ‘Options’ - ‘Text Editor’” on page 2798

---

Command **'Go to Line'**

**Function:** With this command the cursor jumps to a defined line in the code.

**Call:** Menu “Edit ➔ Extended”

**Requirement:** A text editor is opened.

This command opens a dialog box with an input field “Line number”.

See also
- Chapter 6.4.1.21.4.14.26 “Dialog ‘Options’ - ‘Text Editor’” on page 2798

---

Command **'Make Uppercase'**

**Shortcut:** [Ctrl]+[Shift]+[U]

**Function:** This command converts all lowercase letters in the selected code into uppercase letters.

**Call:** Menu “Edit ➔ Advanced”

**Requirement:** A text editor is opened and code is selected, or the declaration editor is opened and variable declarations are selected.

See also
- Chapter 6.4.1.21.4.14.26 “Dialog ‘Options’ - ‘Text Editor’” on page 2798

---

Command **'Make Lowercase'**

**Shortcut:** [Ctrl]+[U]

**Function:** This command converts all uppercase letters in the selected code into lowercase letters.

**Call:** Menu “Edit ➔ Advanced”
**Requirement:** a text editor is opened and code is selected, or the declaration editor is opened and variable declarations are selected.

See also

- Chapter 6.4.1.21.4.14.26 “Dialog ‘Options’ - ‘Text Editor” on page 2798

**Command ‘Go to Matching Bracket’**

**Function:** This command makes the cursor jump to the other part of the selected code parenthesis.

**Call:** Menu “Edit ➔ Advanced”

**Requirement:** A text editor is opened and the cursor is positioned at an opening or closing code parenthesis. If you position the cursor at a code parenthesis, CODESYS displays the corresponding parenthesis in color, provided you have activated the option “Associated parentheses” in the CODESYS options in the “Text Editor” category, “Text Area” tab.

See also

- “Tab ‘Text Area” on page 2799

**Command ‘Select to Matching Bracket’**

**Function:** This command selects the entire code section within the currently selected code parentheses.

**Call:** Menu “Edit ➔ Extended”

**Requirement:** A text editor is opened and the cursor is positioned at an opening or closing code parenthesis. If you position the cursor at a code parenthesis, CODESYS displays the corresponding parenthesis in color, provided you have activated the option “Associated parentheses” in the project options in the “Text Editor” category, “Text Area” tab.

See also

- Chapter 6.4.1.21.4.14.26 “Dialog ‘Options’ - ‘Text Editor” on page 2798

**Command ‘Expand All Folds’**

**Function:** This command expands all collapsed code segments in the textual editor or result locations in the cross-reference list so that the code and all search locations are displayed in full again.

**Requirement:** A textual editor is active and indentation is activated in the “Options” (“Text Editor” category); or the cross-reference list is active.

**Call:** Textual editors: main menu “Edit ➔ Advanced”, or right-click. In the cross-reference list: right-click.

See also

- Chapter 6.4.1.21.4.14.26 “Dialog ‘Options’ - ‘Text Editor” on page 2798
- Chapter 6.4.1.21.3.3.18 “Command ‘Collapse All Folds’” on page 2568
- “Right-click commands in the cross-reference list” on page 2589

**Command ‘Collapse All Folds’**

**Function:** This command collapses all expanded code segments in the textual editor or result locations in the cross-reference list. In this way, only the uppermost level of code and only the root node of the result locations displayed.
**Requirement:** A textual editor is active and indentation is activated in the “Options” (“Text Editor” category); or the cross-reference list is active.

**Call:** In textual editors: main menu “Edit ➔ Advanced”, or right-click. In the cross-reference list: right-click.

See also

- % Chapter 6.4.1.21.4.14.26 “Dialog ‘Options’ - ‘Text Editor’” on page 2798
- % Chapter 6.4.1.21.3.3.17 “Command ‘Expand All Folds’” on page 2568
- % “Right-click commands in the cross-reference list” on page 2589

Command 'Comment Out Selected Lines'

Symbol //; keyboard shortcut: [Ctrl]+[O]

**Function:** The command inserts comment marks ('//') at the beginning of the selected lines.

**Call:** Menu bar: “Edit ➔ Advanced”; context menu

**Requirement:** In the ST editor, either the cursor is located in a line of the implementation or multiple lines are selected.

See also

- % Chapter 6.4.1.21.3.3.20 “Command ‘Uncomment Selected Lines’” on page 2569

Command 'Uncomment Selected Lines'

Symbol ///; keyboard shortcut: [Ctrl]+[I]

**Function:** The command removes any comment marks ('//') at the beginning of the selected lines.

**Call:** Menu bar: “Edit ➔ Advanced”; context menu

**Requirement:** In the ST editor, either the cursor is located in a line of the implementation or multiple lines are selected.

See also

- % Chapter 6.4.1.21.3.3.19 “Command ‘Comment Out Selected Lines’” on page 2569

Command 'Enable Inline Monitoring'

**Function:** This command enables or disables the inline monitoring function. This works the same way as the check box with the same name in the CODESYS options (“Text Editor” category).

**Requirement:** A text editor is active.

**Call:** Context menu of the text editor in the “Advanced” submenu.

See also

- % “Tab ‘Monitoring’” on page 2800
- % Chapter 6.4.1.13.2 “Monitoring of Values” on page 1995

Command 'Toggle Bookmark'

Symbol [], keyboard shortcut [Ctrl]+[F12]

**Function:** The command sets or removes a bookmark at the current position.

**Call:** Menu bar: “Edit ➔ Bookmarks”
Requirement: A POU is open in the editor and the cursor is at a program line.
See also
- Chapter 6.4.1.9.14.3 “Setting and using bookmarks” on page 1908

Command 'Next Bookmark (Active Editor)'
Symbol: ; keyboard shortcut: [F12]
Function: The command jumps to the next bookmark in the active editor.
Call: Menu bar: “Edit ➞ Bookmarks”
Requirement: A POU is open in the editor and the cursor is positioned in the POU.
See also
- Chapter 6.4.1.21.3.3.24 “Command ‘Next Bookmark’” on page 2570
- Chapter 6.4.1.9.14.3 “Setting and using bookmarks” on page 1908

Command 'Next Bookmark'
Symbol: 
Function: The command jumps to the next bookmark in the “Bookmarks” view and in the project, and opens the respective POU. The order of jumping to bookmarks corresponds to the order of bookmarks in the table of the “Bookmarks” view.
Call:
- “Next Bookmark” button in the “Bookmarks” view
- The command is not in any menu by default. You can add it to a menu by using the dialog from “Tools ➞ Customize” (command category “Bookmarks”).
Requirement:
- A project is open.
- The “Bookmarks” view is open.
See also
- Chapter 6.4.1.21.3.3.23 “Command ‘Next Bookmark (Active Editor)’” on page 2570

Command 'Previous Bookmark (Active Editor)'
Symbol: ; keyboard shortcut: [Shift]+[F12]
Function: The command jumps to the previous bookmark in the active editor.
Call: Menu bar: “Edit ➞ Bookmarks”
A POU is open in the editor and the cursor is positioned in the POU.
See also
- Chapter 6.4.1.21.3.3.26 “Command ‘Previous Bookmark’” on page 2570
- Chapter 6.4.1.9.14.3 “Setting and using bookmarks” on page 1908

Command 'Previous Bookmark'
Symbol: 
Function: The command jumps to the previous bookmark in the “Bookmarks” view and in the project, and opens the respective POU. The order of jumping to bookmarks corresponds to the order of bookmarks in the table of the “Bookmarks” view.
Call:

- "Next Bookmark" button in the "Bookmarks" view
- The command is not in any menu by default. You can add it to a menu by using the dialog from "Tools ➔ Customize" (command category "Bookmarks").

Requirement:

- A project is open.
- The "Bookmarks" view is open.

See also

- ☞ Chapter 6.4.1.21.3.3.25 “Command 'Previous Bookmark (Active Editor)’” on page 2570
- ☞ Chapter 6.4.1.9.14.3 “Setting and using bookmarks” on page 1908

Command 'Clear All Bookmarks (Active Editor)'

Symbol: 📌

Function: The command deletes all bookmarks in the active editor.

Call: Menu bar: "Bookmarks"

Requirement: A POU is open in the editor and the cursor is positioned in the POU.

See also

- ☞ Chapter 6.4.1.21.3.3.28 “Command 'Clear All Bookmarks'” on page 2571
- ☞ Chapter 6.4.1.9.14.3 “Setting and using bookmarks” on page 1908

Command 'Clear All Bookmarks'

Symbol: 📌

Function: The command deletes all bookmarks in the open project.

Call: The command is not in any menu by default. You can add it to a menu by using the dialog from "Tools ➔ Customize" (command category "Bookmarks").

Requirement: A POU is open in the editor and the cursor is positioned in the POU.

See also

- ☞ Chapter 6.4.1.21.3.3.27 “Command 'Clear All Bookmarks (Active Editor)’” on page 2571
- ☞ Chapter 6.4.1.9.14.3 “Setting and using bookmarks” on page 1908

Command 'Browse Cross References'

Symbol: 📊

Function: The command shows all occurrences of a variable in the "Cross Reference List" view.

Call: Menu bar: "Edit ➔ Browse”; cross reference view: toolbar

Requirement: A POU is open in the editor and the cursor is set at a variable. Or the "Cross Reference List" view is open and a variable is specified in the "Name" field.

See also

- ☞ Chapter 6.4.1.21.3.3.30 “Command 'Browse Global Cross References’” on page 2571

Command 'Browse Global Cross References'

Symbol: 📊
**Function:** The command shows all occurrences of all variables with the same name in the “Cross Reference List” view. In contrast to the “Browse Cross References” command, these can be different variables.

**Call:** Menu bar: “Edit ➤ Browse”; cross reference view: toolbar

**Requirement:** A POU is open in the editor and the cursor is set at a variable. Or the “Cross Reference List” view is open and a variable is specified in the “Name” field.

See also
- § Chapter 6.4.1.9.14.1 “Using the cross-reference list to find occurrences” on page 1906
- § Chapter 6.4.1.21.3.3.29 “Command ‘Browse Cross References’” on page 2571

---

**Command 'Browse Call Tree’**

Symbol:  

**Function:** The command opens the view “Call Tree”, which displays the calls of a module and also its callers.

**Call:**
- Menu “Edit ➤ Browse”
- Context menu, see below: Requirement

**Requirement:** A module is opened in the editor and the cursor is placed in a variable, or a module is selected in the “Devices” view or in the “POUs” view.

See also
- § Chapter 6.4.1.21.3.4.16 “Command ‘Call tree’” on page 2590

---

**Command 'Auto Declare'**

Keyboard shortcut: [Shift]+[F2]

**Function:** The command opens the “Auto Declare” dialog, which supports the declaration of a variable.

**Call:** Menu bar: “Edit”

**Requirement:** An object or a device of the project is opened in the editor.

With the auto-declaration function, the “Auto Declare” dialog also appears when the cursor is located in the implementation part of a POU in a line containing the name of an undeclared variable. The requirement for this is that you must have clicked “Tools ➤ Options” and enabled the “Declare unknown variables automatically (AutoDeclare)” option in the “SmartCoding” category.

With the smart tag function, the “Auto Declare” command also appears when you place the cursor over an undeclared variable in the implementation part of the ST editor and then click ![tag].

---

**Dialog 'Auto Declare’**

<table>
<thead>
<tr>
<th>“Scope”</th>
<th>Scope of the variable that is not declared yet.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: VAR (default setting for local variables)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Name”</th>
<th>Variable name not declared yet</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: bIsValid</td>
</tr>
</tbody>
</table>

---

2572 3ADR010583, 1, en_US 2024/01/05
| **“Type”** | Example: BOOL  
- glVertex: Lists the standard data types.  
- &lt; Input Assistant &gt;: Opens the “Input Assistant” dialog  
- &lt; Array Assistant &gt;: Opens the “Array” dialog |
| **“Object”** | Object where the new variable is declared. By default, the object that you are editing now.  
Example: fbA  
- &: Lists that objects where the variable can be declared.  
If no objects are available for the selected “Scope”, the entry “<create object>” appears. When you select the “<create object>” entry, the “Add Object” dialog opens for generating a suitable object. |
| **“Initialization”** | Example: FALSE  
If you do not specify an initialization value, then the variable is initialized automatically.  
- &gt;: Opens the “Initialization Value” dialog. This procedure is helpful for the initialization of structured variables. |
| **“Address”** | Memory address of the application for the variable that is not declared yet.  
Example: %IX1.0  
Note:  
Possible only for the following scopes:  
- Local variable (VAR)  
- Global variable (VAR_GLOBAL)  
- Or for a persistent variable (PERSISTENT). |
| **“Flags”** | Attribute keywords  
- CONSTANT: Keyword for a constant.  
- RETAIN: Keyword for a remanent variable.  
- PERSISTENT: Keyword for a persistent variable (stricter than RETAIN).  
The selected attribute keyword is added to the variable declaration. |
| **“Comment”** | Example: New input In1  
In the tabular declaration editor, the comment entered is displayed in the “Comment” column, while in the textual declaration editor it is displayed above the variable declaration. |
| **“Apply changes using refactoring”** | &gt;: When you exit the dialog, the variable is not declared yet, but then it opens the “Refactoring” dialog. You can continue editing your changes here.  
The option appears for the following scopes:  
- Input variable (VAR_INPUT)  
- Output variable (VAR_OUTPUT)  
- VAR_IN_OUT variables (input variable and output variable) |
| **“OK”** | The variable is declared and appears in the declaration.  
Example:  
```
VAR RETAIN  
// New input In1  
xIn1 AT %IX1.0: BOOL := FALSE;  
END_VAR
``` |
Dialog 'Array'

| "Ranks and base type specification" | Definition of the field sizes ("Dimension") by entering the lower and upper limits and the "Base type" of the array. You can enter the basic type directly or with the help of the "Input Assistant" or "Array" dialogs when you click the button. |
| "Result" | Display of the defined array |

NOTICE!
CODESYS reinitializes variables only if you have modified the initialization values of the variables.

Dialog 'Initialization Value'

| List of the variables with name ("Expression"), "Initialization Value" and "Data Type". Modified initialization values are displayed in bold fonts. |
| Input field below the list | Input of an initialization value for the selected variable(s) |
| "Apply value to selected lines" | Change of the initialization value of the selected line(s) according to the value of the input field |
| "Reset selected lines to default values" | Resets the default initialization values |
| "OK" | CODESYS applies the initialization values in the "Auto Declare" dialog. |

In the case that the variable to be initialized by means of this dialog is a function block instance with an extended FB_Init method, an additional table is displayed above the "Initialization Value" table. The additional FB_Init parameters are listed in this table. The meaning and operation essentially correspond to the lower table with the following differences:

- All variables have to be assigned with initialization values. Otherwise "OK" remains disabled.
- For complex data types (structures, arrays), no components contained within are displayed (type cannot be expanded). In this case, the complex type has to be initialized with a corresponding variable.

For FB_Init parameters configure this way, a corresponding symbol is displayed after the initialization value in the "Auto Declare" dialog.

See also

- Chapter 6.4.1.20.10 “Methods 'FB_Init', 'FB_Reinit', and 'FB_Exit’” on page 2336
- “Dialog box 'Refactoring’” on page 2578
- Chapter 6.4.1.20.4.12 “Addresses” on page 2231
- Chapter 6.4.1.21.4.14.22 “Dialog 'Options' - 'Refactoring’” on page 2794
- Chapter 6.4.1.20.1.4.1 “ST Editor” on page 2049

Command 'Input Assistant'

Symbol:  
keyboard shortcut: [F2]

Function: This command opens the “Input Assistant” dialog which helps you to select one of the possible programming elements at the current cursor position.

Call: Menu bar: "Edit", context menu.

Requirement: A POU is open in the editor and the cursor is at a program line.
The input assistant provides all program elements that you can insert at the current cursor position in the editor.

The elements are sorted by “Categories”. In the category “Variables”, you can also set a “Filter” for the scope, for example “Local variables”, “Global variables”, or “Constants”.

"Structured view"  
☑️: The elements are displayed in a structure tree. You can show/hide the columns “Type”, “Address”, and “Origin” by right-clicking the column title and selecting/clearing the column name in the dropdown list.  
☐: The elements are displayed in a flat structure.

"Show documentation"  
☑️: The dialog is extended with the “Documentation” field.

"Insert with arguments"  
☑️: Elements that include arguments (for example, functions) also insert with these arguments at the cursor position.  
Example: If you insert the function block fb1, which contains an input variable fb1_in and an output variable fb1_out, “with arguments”, then this appears in the editor as follows: fb1(fb1_in:= , fb1_out=> ).

"Insert with namespace prefix"  
☑️: Inserts the selected element with the appended namespace. In the case of library modules, the check box remains disabled if the requirement for a namespace has been defined in the library properties.

If you create objects with the same name in the same category, whether globally (“POUs” view) or assigned to an application (“Devices” view), then only one entry appears in the input assistant. The usage conforms to the usual call priority (application assigned before global).

This tab allows you to search for specific objects. When you begin typing a search string into the search field, the names of all objects are listed whose names include the search string. Double-click an object to insert it at the current cursor position in the editor.

"Filters"  
Limits the search to a specific variable category

See also  
● ☺ Chapter 6.4.1.9.7 “Using input assistance” on page 1885  
● ☺ "Dialog 'Properties'" on page 2714  
● ☺ Chapter 6.4.1.21.3.3.33 “Command 'Input Assistant'” on page 2574

Command 'Go to Source Position'  

Function: The command sets the cursor to the position in the source code that causes the message.  

Call: Main menu “Edit”, context menu of the message in the message view.  

Requirements: A message is selected in the message view.  

Use the command “Next Message" or “Previous Message" to display the source code position of the next or previous message.  

See also  
● ☺ Chapter 6.4.1.21.3.3.35 “Command 'Next Message'” on page 2576  
● ☺ Chapter 6.4.1.21.3.3.36 “Command 'Previous Message'” on page 2576  
● ☺ Chapter 6.4.1.21.3.4.5 “Command 'Messages'” on page 2583
Command 'Next Message'  
Keyboard shortcut: [F4]  
**Function:** This command selects the next message in the messages view.  
**Call:** Main menu “Edit”.  
If the last message in the list has been reached, then the marking jumps to the beginning.  
See also  
●  Chapter 6.4.1.21.3.3.36 “Command 'Previous Message’” on page 2576  

Command 'Previous Message'  
Keyboard shortcut: [Shift]+[F4]  
**Function:** This command selects the previous message in the messages view.  
**Call:** Main menu “Edit”  
If the first message in the list has been reached, then the marking jumps to the end.  
See also  
●  Chapter 6.4.1.21.3.3.35 “Command 'Next Message’” on page 2576  

Command 'Go to Definition'  
**Symbol:**  
**Function:** This command shows the definition locations of a variable or function.  
**Call:** Main menu “Edit ➔ Browse”  
**Requirement:** A POU is open in the editor and the cursor is at a variable or function.  
See also  
●  Chapter 6.4.1.9.14.2 “Finding declarations” on page 1908  

Command 'Go To Reference'  
**Symbol:**  
**Function:** The command opens the declaration location of the variable that is referenced by the pointer currently in focus in online mode.  
**Call:**  
●  Context menu in the declaration part or implementation code  
●  Menu bar: “Edit ➔ Browse”  
**Requirement:** Online mode. A POU is open in the editor and the cursor is at a pointer. The referenced variable is stored in static memory.  

If the pointer does not point exactly to the beginning of the variable, then a corresponding message is displayed when you switch to the variable declaration.  

See also  
●  Chapter 6.4.1.20.5.13 “Pointers” on page 2243
Command 'Go to Instance'

Symbol: *\rightarrow*

**Function:** This command opens the instance of a function block in a new window.

**Call:** Menu bar: “Edit \rightarrow Browse for Symbol”

**Requirement:** The application is in online mode. A POU is open in the editor and the cursor is at an instance of a function block.

The command is not available for temporary instances or instances from compiled libraries.

See also
- ☞ Chapter 6.4.1.9.14.2 “Finding declarations” on page 1908

Command 'Refactoring' - 'Rename <...>''

**Function:** This command opens a dialog box for renaming an object or variable across the project.

**Call:** Main menu “Edit \rightarrow Refactoring” or right-click.

**Requirement:** An object is selected in the device tree or in the “POUs” view, or the cursor is placed before or on a variable identifier in the declaration section of a programming object.

You can rename the following:
- Variables
- POU
- GVLs
- Methods
- Properties
- Devices
- Variables and unit conversions in the unit conversion edit

Dialog box 'Rename'

<table>
<thead>
<tr>
<th>“Current name”</th>
<th>Name of the object or variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>“New name”</td>
<td>Input field for a new name.</td>
</tr>
<tr>
<td></td>
<td>If the name already exists, then CODESYS reports this directly below this input field.</td>
</tr>
<tr>
<td>“OK”</td>
<td>Can be activated if you have typed a valid name in “New name”.</td>
</tr>
<tr>
<td></td>
<td>Opens the “Refactoring” dialog box.</td>
</tr>
<tr>
<td></td>
<td>The affected objects and occurrences are highlighted in both views.</td>
</tr>
<tr>
<td></td>
<td>You can determine how to handle the occurrences in each view by right-clicking the occurrences and clicking the available commands.</td>
</tr>
</tbody>
</table>

Dialog box 'Refactoring'

This dialog box displays all occurrences in the project.

The affected objects and occurrences are highlighted in both views.

| Right view | Displays the occurrence within an object where “Current name” occurs. |
| Left view  | Device tree of the project with the object. |
You can determine how to handle the occurrences in each view by right-clicking the occurrences and clicking the available commands.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Reject this change&quot;</td>
<td>Reject the single change in view on the right.</td>
</tr>
<tr>
<td>&quot;Accept this object&quot;</td>
<td>Accept all changes in the affected object.</td>
</tr>
<tr>
<td>&quot;Reject this object&quot;</td>
<td>Reject all changes in the affected object.</td>
</tr>
<tr>
<td>&quot;Accept whole project&quot;</td>
<td>Accept all changes in the project.</td>
</tr>
<tr>
<td>&quot;Reject whole project&quot;</td>
<td>Reject all changes in the project.</td>
</tr>
</tbody>
</table>

CODESYS highlights the accepted changes in yellow and the rejected changes in gray.

See also

- Chapter 6.4.1.9.16 “Refactoring” on page 1910

**Command 'Refactoring' - 'Update Referenced Pins'**

**NOTICE!**
Currently, this command applies only to the CFC, FBD, LD, and IL editors. It is a combination of the “Reset Pins” and “Update Parameters” commands.

**Function:** This command modifies the pins according to the latest block declaration in all affected occurrences of the block.

**Call:** Main menu “Edit ➔ Refactoring” or right-click.

**Requirement:** The cursor is placed in the name of the block in the first line of the block declaration or in the device tree.

See also

- Chapter 6.4.1.9.16 “Refactoring” on page 1910
- Chapter 6.4.1.21.3.13.24 “Command 'Reset Pins’” on page 2694
- Chapter 6.4.1.21.3.14.38 “Command 'Update Parameters’” on page 2710

**Command 'Refactoring' - 'Add Variable’**

**Symbol:** ![add-variable]

**Function:** This command enables the declaration of variables in a POU, as well as the automatic update to the occurrence of the POU.

**Call:** Main menu “Edit ➔ Refactoring”, or right-click.

**Requirements:** The declaration part is in focus.

The command opens the default dialog box for declaring variables.

See also

- “Dialog 'Auto Declare’” on page 2572

**Dialog box 'Re-factorizing'**

After clicking “OK” to close the declaration dialog, the “Refactoring” dialog box opens with two frames.
## Refactoring

**Right dialog frame**  Declaration part and implementation of the POU where the variable is added. Colored highlighting of changed locations: New added declarations have a blue font and are highlighted in yellow (1).

**Left dialog frame**  Device tree or POUs tree of the project. Colored highlighting of blocks where the POU is used: red font and yellow highlight (2). After you double-click the POU object, the detail view opens.

Before you decide which changes to accept at which locations, select the required option from the drop-down list (3) at the upper right part of the window:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Add inputs with placeholder text</strong></td>
<td>Default placeholder text: <code>_REFACTOR_</code>; editable</td>
</tr>
<tr>
<td></td>
<td>The placeholder text defined here is used at the occurrence locations of the new added variables in the implementation code. This is used for searching for the affected locations.</td>
</tr>
<tr>
<td><strong>Add inputs with the following value</strong></td>
<td>Initialization value for the new variable.</td>
</tr>
</tbody>
</table>

You can accept or reject changes by right-clicking the changed locations or by executing commands in the left or right area of the dialog box. Refer to the description of the “Refactoring ➔ Rename” command.
1. By refactoring, the `fun` block receives a new input variable `input3` with the initialization value 1. The change has the following effect:

Before:
```plaintext```
fun(a + b, 3, TRUE);
fun(input1 := a + b , input2 := 3 , inputx := TRUE);
```plaintext```

After:
```plaintext```
fun(a + b, 3, 1, TRUE);
fun(input1 := a + b , input2 := 3 , _REFACTOR_, inputx := TRUE);
```plaintext```

2. By refactoring, the "fun" block receives a new input variable `input3` with the placeholder text "_REFACTOR_":

Before:
```plaintext```
inst(input1 := a + b, input2 := 3, inputx := TRUE);
fun(a + b, 3, TRUE);
```plaintext```

After:
```plaintext```
inst(input1 := a + b, input2 := 3, input3 := _REFACTOR_, inputx := TRUE);
fun(a + b, 3, _REFACTOR_, TRUE);
```plaintext```

---

**Examples**

See also

- § Chapter 6.4.1.9.16 “Refactoring” on page 1910
- § Chapter 6.4.1.21.3.3.40 “Command 'Refactoring' - 'Rename <...>’” on page 2577

---

**Command 'Refactoring' - 'Remove <variable>’**

**Symbol:**

**Function:** This command removes an input or output variable from the POU and all occurrences of the POU.

**Call:** Main menu “Edit ➔ Refactoring”, or right-click.

**Requirements:** In the declaration part of the POU, the cursor is located in the identifier of the variable to be removed.

Then, the command opens a dialog box with information about the removal. After you confirm this, the “Refactoring” dialog box opens. For a description of the “Refactoring” dialog box, refer to the “Edit ➔ Refactoring ➔ Rename” help page.

When you accept the changes in the “Refactoring” dialog box, the respective input and output parameters are deleted at the occurrence locations of the affected POU.

**In CFC, only the connection is removed between the removed input or output to the block. The input or output itself remains in the chart.**

---

**Example in ST**

In a POU, refactoring removes the `input4` input variable. The occurrences are updated automatically:

Before removal:
```plaintext```
inst(input1 := a + b, input2 := 3, input4 := 1, input5 := TRUE);
fun(a + b, 3, 1, TRUE);
```plaintext```

After removal:
```plaintext```
inst(input1 := a + b, input2 := 3, input5 := TRUE);
fun(a + b, 3, TRUE);
```plaintext```
Command 'Refactoring' - 'Reorder Variables'

Symbol: \[\text{\textbullet}\]

Function: This command allows changing the order of variables in the declaration editor for the selected scope: VAR_INPUT, VAR_OUTPUT, or VAR_IN_OUT.

Call: “Edit \rightarrow Refactoring”; context menu of the focused scope in the declaration editor.

Requirement: One of the above scopes is selected in the declaration, and more than one variable is declared in it.

The command opens the “Reorder” dialog box with a list of all declarations of the selected scope. You can drag a selected declaration up or down to another position.

See also
- Chapter 6.4.1.9.16 “Refactoring” on page 1910

Command 'Advanced' - 'Format Document'

Symbol: \[\text{\textbullet}\]

Function: The command starts an automatic formatting of the code in the open ST editor.

Call: Menu bar: “Edit \rightarrow Advanced”; context menu of the window in focus in the ST editor

Requirement: The focus is in the ST editor. The syntax of the ST code does not contain any errors.

The following formatting is performed automatically:
- Keywords are converted to uppercase letters.
- Spacing is standardized.
- Indentations are changed according to syntax.
- Long lines are wrapped in sensible places.

See also
- Chapter 6.4.1.20.1.4.1 “ST Editor” on page 2049
Menu 'View'

6.4.1.21.3.4.1 Standard Menu in View 'Devices', 'POUs', 'Modules'.............. 2582
6.4.1.21.3.4.2 Command 'Devices'................................................................. 2582
6.4.1.21.3.4.3 Command 'POUs'.................................................................... 2583
6.4.1.21.3.4.4 Command 'Modules'................................................................ 2583
6.4.1.21.3.4.5 Command 'Messages'............................................................. 2583
6.4.1.21.3.4.6 Command 'Element properties'............................................... 2584
6.4.1.21.3.4.7 Command 'ToolBox'................................................................. 2584
6.4.1.21.3.4.8 Command 'Watch' - 'Watch <n>'.............................................. 2584
6.4.1.21.3.4.9 Command 'Watch' - 'Watch All Forces'.................................... 2584
6.4.1.21.3.4.10 Command 'Add All Forces to Watchlist'................................. 2585
6.4.1.21.3.4.11 Command 'Bookmarks'.......................................................... 2585
6.4.1.21.3.4.12 Command 'Breakpoints'......................................................... 2586
6.4.1.21.3.4.13 Command 'Cross Reference List'........................................... 2587
6.4.1.21.3.4.14 Command 'Browse Cross References in Classic View'............ 2589
6.4.1.21.3.4.15 Command 'Call Stack'.............................................................. 2590
6.4.1.21.3.4.16 Command 'Call tree'............................................................... 2590
6.4.1.21.3.4.17 Command 'Memory'............................................................... 2592
6.4.1.21.3.4.18 Command 'Security Screen'................................................... 2592
6.4.1.21.3.4.19 Command 'Settings of Memory Reserve for Online Change' ......................... 2595
6.4.1.21.3.4.20 Command 'Start Page'............................................................ 2596
6.4.1.21.3.4.21 Command 'Full Screen'.......................................................... 2597
6.4.1.21.3.4.22 Command 'Properties'............................................................ 2597

Standard Menu in View 'Devices', 'POUs', 'Modules'

The views “Devices”, “POUs” and “Modules” provide the button ☐ in the top right corner to open a menu with the following commands:

- “Open in editor”: Opens the selected object in the corresponding editor.
- “Find object”: Opens the dialog “Find Object” for the object tree. Starting to enter a search string all matching objects will be displayed with their path. Use the button “Open” to open the selected search result in the editor.
- “Sort by type”: Sorts the objects in the view alphabetic by type.
- “Sort by name”: Sorts the objects in the view alphabetic by name.
- “Sort ascending”: Displays the chosen sorting in ascending order.
- “Sort descending”: Displays the chosen sorting in descending order.
- “Track active editor”: CODESYS selects the object, that is opened in the active editor, in the device tree of the view.

See also

- ☞ Chapter 6.4.1.21.3.4.2 “Command 'Devices'” on page 2582
- ☞ Chapter 6.4.1.21.3.4.3 “Command 'POUs'” on page 2583
- ☞ Chapter 6.4.1.21.3.4.4 “Command 'Modules'” on page 2583

Command 'Devices'

Symbol: ☐ view: [Alt] + [0]

Function: The command opens the view “Devices” in the CODESYS main window. The view contains the project's "device tree", where you configure your applications

Button ☐ opens the standard menu for navigating in the tree view.

Call: Menu “View”
Command ‘POUs’

Symbol: [POU]. Shortcut: [Alt] + [1]

Function: This command opens the “POUs” view in the CODESYS main window. POUs located here are available in the entire project.

Call: Menu “View”

See also
● Chapter 6.4.1.21.3.4.1 “Standard Menu in View ‘Devices’, ‘POUs’, ‘Modules’” on page 2582

Command ‘Modules’

Symbol: [Module]

Function: This command opens the “Modules” view and shows the modules of the application composer in a tree structure.

Call: Main menu “View”

See also
● Chapter 6.4.1.21.3.4.1 “Standard Menu in View ‘Devices’, ‘POUs’, ‘Modules’” on page 2582

Command ‘Messages’

Symbol: [Message]

Function: This command opens the “Messages” view.

Call: Menu bar: “View”.

View ‘Messages’

<table>
<thead>
<tr>
<th>Message category</th>
<th>The messages are categorized by component or functionality for selection from a drop-down list. Filter the message display by selecting a category.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message type</td>
<td>Click the symbol of the message type to show or hide messages. CODESYS displays the number of messages next to each symbol.</td>
</tr>
<tr>
<td></td>
<td>● [Error]</td>
</tr>
<tr>
<td></td>
<td>● [Warning]</td>
</tr>
<tr>
<td></td>
<td>● [Message]</td>
</tr>
<tr>
<td>Deletes all messages in the selected message category.</td>
<td></td>
</tr>
<tr>
<td>Deletes all messages in all message categories.</td>
<td></td>
</tr>
<tr>
<td>“Description”</td>
<td>Message text with the reported object and the location in the object.</td>
</tr>
<tr>
<td>“Project”</td>
<td>Double-click a message in the table to jump to the source text location.</td>
</tr>
</tbody>
</table>
Table 474: “Commands in the context menu”

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Next Message”</td>
<td>The source text position of the next message is displayed.</td>
</tr>
<tr>
<td>“Previous Message”</td>
<td>The source text position of the previous message is displayed.</td>
</tr>
<tr>
<td>“Go to Source Position”</td>
<td>The source position of the selected message is displayed.</td>
</tr>
</tbody>
</table>

Command 'Element properties'

Symbol: 

**Function:** This command opens the “Element Properties” view.

**Call:** Main menu “View”

This command opens the properties view for the open object. This view is available only for a few objects, for example visualization and POU (SFC).

The properties are displayed in a structured table. You change the property values by clicking into the value fields. You can filter or sort the properties view.

Command 'ToolBox'

Symbol: 

**Function:** This command opens the “ToolBox” view.

**Call:** Main menu “View”

This command opens the toolbox view for the open object. By default, this view is available for graphical editors and visualizations. It includes the graphical programming elements that you can drag into the editor.

Command 'Watch' - 'Watch <n>,'

Symbol: 

**Function:** This command opens the "Watch <n>" view. You can populate a watchlist with variables from your project in order to monitor, force, or write these variable values in an individual view in online mode. The value "n" can be 1, 2, 3, or 4 for a total of up to four watchlists.

**Call:** Main menu “View”

See also

●  Chapter 6.4.1.13.2.3 “Using watch lists” on page 2002

Command 'Watch' - 'Watch All Forces'

Symbol: 

**Function:** The command opens the “Watch All Forces” view, which is a special kind of watch list.

**Call:** Menu bar: “View ➔ Watch ➔ Watch All Forces”

**Requirement:** A project is in offline mode or online mode.

The view contains all variables currently prepared for forcing, and all forced variables of the application in one list. Actions are possible in the list which are also possible in other watch lists. Moreover, the following commands are available in the “Unforce” list box of the view:
Table 475: “Watch All Forces”

<table>
<thead>
<tr>
<th>“Expression”</th>
<th>Variable name</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Data Type”</td>
<td>Data type of the variable</td>
</tr>
<tr>
<td>“Value”</td>
<td>Currently forced value of the variable</td>
</tr>
<tr>
<td>“Prepared Value”</td>
<td>Value prepared for forcing</td>
</tr>
<tr>
<td>“Overwritten value at start of cycle”</td>
<td>For inputs, the actual value is already overwritten by the force value before the application code is executed. As a result, this is the forced value. For outputs, this is the forced value.</td>
</tr>
<tr>
<td>“Overwritten value at end of cycle”</td>
<td>For outputs, this is the value which is calculated in the cycle. However, this value is overwritten by the force value at the end of the cycle. For inputs, this is the forced value.</td>
</tr>
</tbody>
</table>

- “Unforce and Keep All Selected Values”: For all selected entries in the list, the variables will be set to the forced value and the forcing will be lifted
- “Unforce and Restore All Selected Values”: For all selected entries in the list, the variables will be reset to the values they had before they were forced, and the forcing will be lifted.

See also
- Chapter 6.4.1.12.5 “Forcing and Writing of Variables” on page 1987
- Chapter 6.4.1.13.2.3 “Using watch lists” on page 2002

Command 'Add All Forces to Watchlist'

**Function:** The command adds all variables of the active application, which are currently prepared for forcing, or which are already forced, to the watchlist. Please regard, that this works only for docked watch list views.

**Call:** Context menu of view “Watch”

**Requirement:** Online mode, a watch list view is active.

There is a special watch list: “Watch All Forces”. This view shows automatically all variables currently prepared for forcing or already being forced. It provides additional commands for releasing any forces.

See also
- Chapter 6.4.1.13.2.3 “Using watch lists” on page 2002
- Chapter 6.4.1.21.3.4.8 “Command 'Watch' - 'Watch <n>’” on page 2584
- Chapter 6.4.1.21.3.4.9 “Command 'Watch' - 'Watch All Forces’” on page 2584
- Chapter 6.4.1.12.5 “Forcing and Writing of Variables” on page 1987

Command 'Bookmarks'

**Symbol:** 📌

**Function:** This command opens the “Bookmarks” view.

**Call:** Menu bar: “View”.
“Previous Bookmark” Jumps to the bookmark that above the selected bookmark in the table and opens the respective POU in the editor.

“Next Bookmark” Jumps to the bookmark that below the selected bookmark in the table and opens the respective POU in the editor.

Deletes the selected bookmark from the table and in the respective POU.

List of bookmarks in the project with the following information: “Bookmark”, “Object”, and “Position”.

You can edit the bookmark order per drag&drop.

When you double-click a row, CODESYS opens the respective “Object” in the editor and jumps to this bookmark.

“Bookmark” Name of the bookmark as assigned by CODESYS in ascending numerical order: “Bookmark_0”, “Bookmark_2” etc.

If the bookmark is selected and you click in the field, then it is editable and you can modify the bookmark name.

“Object” Name and project path of the POU where the bookmark is set

Example: POU_Add [PLC_1: SPS-Logic: Application]

“Position” Position of the bookmark in the POU

Example: Row 3, Column 1 (Impl)

(Impl): in the implementation part of the POU

(Decl): in the declaration part of the POU

See also

- Chapter 6.4.1.9.14.3 “Setting and using bookmarks” on page 1908
- Chapter 6.4.1.21.3.3.24 “Command 'Next Bookmark’” on page 2570
- Chapter 6.4.1.21.3.3.26 “Command 'Previous Bookmark’” on page 2570

Command 'Breakpoints'

Symbol: 

Function: This command opens the “Breakpoints” view.

Call: Menu bar: “View”.

This view shows an overview of all defined breakpoints for an application. You have access to all breakpoint commands within this view.

Table 476: Table of current breakpoints

| “Application” | Select the required application from the list. |
| “POU” | Name of the function block that will receive the breakpoint |
| “Location” | Location of the breakpoint in the POU |
| “Instance Path” | Complete object path of the breakpoint location. |
| “Tasks” | Names of tasks that will be effective when the breakpoint is executed. If there are no restrictions, then "(all)" is displayed here. |
“Condition”
- “Break always”: No additional enable condition defined; the breakpoint is always enabled.
- Boolean expression. The expression must yield TRUE for the breakpoint to be enabled.

“Hit Count Condition”
When the breakpoint should be in effect (depending on the hit count)

“Current Hit Count”
How often the breakpoint has already been reached up to now during the execution

Table 477: Toolbar

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;New Breakpoint&quot;</td>
<td>This command opens the “Breakpoint Properties” dialog.</td>
</tr>
<tr>
<td>&quot;New Data Breakpoint&quot;</td>
<td>This command opens the “New Breakpoint” dialog.</td>
</tr>
<tr>
<td>“Clear Breakpoint”</td>
<td>Removes the breakpoint (not the same as disable)</td>
</tr>
<tr>
<td>“Enable/Disable Breakpoint”</td>
<td>Toggles the status of the breakpoint or execution point between “enabled” and “disabled”</td>
</tr>
<tr>
<td></td>
<td>- Breakpoint enabled</td>
</tr>
<tr>
<td></td>
<td>- Breakpoint disabled</td>
</tr>
<tr>
<td></td>
<td>- Execution point enabled</td>
</tr>
<tr>
<td></td>
<td>- Execution point disabled</td>
</tr>
<tr>
<td></td>
<td>- Data breakpoint enabled</td>
</tr>
<tr>
<td></td>
<td>- Data breakpoint disabled</td>
</tr>
<tr>
<td></td>
<td>- Data execution point enabled</td>
</tr>
<tr>
<td></td>
<td>- Data execution point disabled</td>
</tr>
<tr>
<td></td>
<td>As opposed to &quot;Clear breakpoint&quot;, a disabled breakpoint remains in the list and can be enabled again.</td>
</tr>
<tr>
<td>“Properties”</td>
<td>The “Breakpoint Properties” dialog opens for editing the breakpoint parameters. This dialog is the same as “New Breakpoint”. In online mode, you can change the breakpoint into an execution point.</td>
</tr>
<tr>
<td>“Go to Source Position”</td>
<td>Opens the online view of the affected block. The cursor is set at the breakpoint location.</td>
</tr>
<tr>
<td>“Clear All Breakpoints”</td>
<td>Deletes all breakpoints and execution points in the application. The list is cleared. Not to be confused with &quot;deactivate&quot;.</td>
</tr>
<tr>
<td>“Enable All Breakpoints”</td>
<td>Enables all currently disabled breakpoints and execution points.</td>
</tr>
<tr>
<td>“Disable All Breakpoints”</td>
<td>Disables all currently enabled breakpoints and execution points. The points remain in the list and can be enabled again.</td>
</tr>
</tbody>
</table>

See also
- Chapter 6.4.1.21.4.6 “Dialog ‘Breakpoint Properties’” on page 2747
- Chapter 6.4.1.21.3.8.4 “Command 'New Breakpoint’” on page 2645
- Chapter 6.4.1.21.3.8.5 “Command 'New Data Breakpoint’” on page 2645
- Chapter 6.4.1.21.3.8.7 “Command 'Enable Breakpoint’” on page 2646
- Chapter 6.4.1.21.3.8.8 “Command 'Disable Breakpoint’” on page 2646
- Chapter 6.4.1.21.3.8.9 “Command 'Toggle Breakpoint’” on page 2646

Command 'Cross Reference List'

Symbol: ☰

Function: This command opens the “Cross Reference List” view.
Call: Menu bar: “View”, or “Edit  Browse  Browse Cross References”.

This view shows a list of cross-references for a symbol in the project. The symbol can be a variable, a POU (program, function block, function), or a user-specific data type (DUT). The cross-reference list offer two basic types of searches:

- Text search: By specifying a symbol name, the cross-references of all symbols in the project are displayed with their names. If multiple symbols with the same are found, then the display can be limited to individual declarations by means of the context menu.
- Declaration search: The symbol can be selected by means of the input assistant or by specifying a qualified path (for example, Device.Application.PLCPRG.i or __POOL.POU.a). Then only the occurrence locations of this symbol are displayed, even if there exist other symbols with the same name.

<table>
<thead>
<tr>
<th>Input field</th>
<th>Symbol name (variable name, POU name, DUT name). Input options:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>● Selection of a declared symbol by means of the input assistant (button).</td>
</tr>
<tr>
<td></td>
<td>● Manual input of the symbol name. Triggering of the search by pressing the button or the [Enter] key.</td>
</tr>
<tr>
<td></td>
<td>For the text search, you can use the placeholders &quot;*&quot; (any number of characters) or ”?” (exactly any one character) in combination with a partial string of a variable identifier.</td>
</tr>
<tr>
<td></td>
<td>Use the percent sign &quot;%&quot; to search for IEC addresses. Examples: &quot;%MW8&quot;, &quot;%M&quot;.</td>
</tr>
</tbody>
</table>

More options outside of cross-reference list view:

- Use the command “Browse for Symbol  Browse Cross References” if the name of a declared symbol is selected in an editor, or if the cursor is in the name field. A search is also possible if the object is selected in the device tree or POU pool.
- Automatic if the name of a declared symbol is selected in an editor, or if the cursor is in the name field. A automatic search is also possible if the object is selected in the device tree or POU pool.

Requirement: CODESYS option “Automatically list selection in cross reference view” is activated (category “SmartCoding”).

The following input is valid:

- Variable name, simple or qualified. Examples: "iVar", "PLC_PRC.iVar".
- POU name: Examples: "PLC_PRC", "myFB".
- DUT name: Example: "mySTRUCT".
- Strings combined with placeholders: asterisk (*) for any character or question mark (?) for exactly one characters).
  Example: "iVar*" applies to iVar1, iVar_glob2, iVar45, etc.
  "iVar?" refers to iVar1, iVar2, iVarX, and so on, but not iVar_glob2, iVar45 and so on...
- "<IEC address>": CODESYS searches for variables that are assigned to this address and direct memory access. Example: "%QB0", %Q0 := 2.

Open input assistant for selecting a symbol
Perform a search
Define columns to search for the string.

Input field String that is searched for in the selected columns. The result locations are marked in yellow. Cross references without this string are hidden.

Show source position of previous cross-reference, [Shift]+[F4]
Show source position of next cross-reference, [F4]
Limit results to current declaration: Available if multiple declarations are found for a symbol. Limits the display to the declaration that you have selected in the list.
Show source position of selected cross-reference: The focus jumps to the occurrence location of the symbol.

Print cross-reference list: The default dialog opens for setting up a print job.

The cross references are displayed with the following information:

<table>
<thead>
<tr>
<th>“Symbol”</th>
<th>The result locations for the symbols (variables, POU’s, or DUTs) are grouped by declaration. The declaration occurrence comprises the root node and the occurrence locations in the project are indented below. The precise expression is displayed that has the symbol at the occurrence location. Example: If there is a global variable i in the project and a local declared variable i in a POU, then two root node entries will be listed after a text search for cross-references with the occurrences of the variable i below each.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“POU”</td>
<td>Block name; also a task name if a block call in the task configuration.</td>
</tr>
<tr>
<td>“Variable”</td>
<td>Only the variable name (for example, iVar)</td>
</tr>
<tr>
<td>“Access”</td>
<td>Type of access to the variable at the occurrence location: “Declaration” / “Read” / “Write” / “Call”. Special case for pointers: An assignment type p := ADR(var1) is displayed as write</td>
</tr>
<tr>
<td>“Type”</td>
<td>Data type of the variable</td>
</tr>
<tr>
<td>“Address”</td>
<td>IEC address if variables are assigned Example: &quot;AT %QB0&quot;.</td>
</tr>
<tr>
<td>“Position”</td>
<td>Location of the occurrence in the POU editor, for example line number, network number, declaration part, or implementation part. Example: “line 1, column 1 (Impl)”.</td>
</tr>
<tr>
<td>“Object”</td>
<td>POU name plus complete path of the occurrence location in brackets (if this is found in the “Devices” view). Example: &quot;PLC_PRG [Device:Plc Logic:Application]&quot;</td>
</tr>
<tr>
<td>“Comment”</td>
<td>Comments if available in the declaration of the variable</td>
</tr>
</tbody>
</table>

The search yields all result locations in the project and in included, uncompiled libraries.

Right-click commands in the cross-reference list

“Show source position”: Opens the respective POU and marks the occurrence: for root entries, the declaration, and for subordinate entries, the respective occurrence location. As an alternative, you can double-click a line.

“Limit Results to Selected Declaration”: Limits the display of results to the selected symbol declaration if multiple declarations are found.

“Expand All”: In the list, every single result location is shown.

“Collapse All”: In the list, only the root nodes of the result locations are shown.

See also

- § Chapter 6.4.1.21.3.29 “Command ‘Browse Cross References’” on page 2571
- § Chapter 6.4.1.9.14.1 “Using the cross-reference list to find occurrences” on page 1906
- § Chapter 6.4.1.21.3.23.3 “Command ‘Limit Results to Current Declaration’” on page 2744
- § Chapter 6.4.1.21.3.18 “Command ‘Collapse All Folds’” on page 2568
- § Chapter 6.4.1.21.3.17 “Command ‘Expand All Folds’” on page 2568

Command 'Browse Cross References in Classic View'

Symbol 🗿
Function: This command opens the “Classic Cross Reference List” view.

Call: The command is not in any menu by default. You can add it to a menu by using the dialog box from “Tools → Customize” (command category “Browse Project”).

The view corresponds to the “Cross Reference List” view before CODESYS V3.5 SP6.

Command 'Call Stack'

Symbol: 

Function: This command opens the “Call Stack” view.

Call: Main menu “Debug”.

This view is very useful when you want to step into programs. It shows the current location with the complete call path.

| “Application” | Name of the active application that controls the current POU |
| “Task” | Name of the task that controls the current POU |
| “POU” | Name of the POU where program execution has halted |
| “Location” | Position within the POU where program execution has halted |
| ● Line and column numbers for textual editors |
| ● Network or element numbers for graphical editors |
| “Instance path” | Instance where program execution has halted |

The call stack is also available in offline mode and normal online mode when you are not currently using any debugging functions. In this case, it receives the last displayed location during a stepped execution, but it is displayed in gray.

The “Call Tree” view, in contrast to the “Call Stack”, at any time provides information on the calls of a POU.

See also

● Chapter 6.4.1.12.3 “Using Breakpoints” on page 1981
● Chapter 6.4.1.21.3.4.16 “Command ‘Call tree’” on page 2590

Command 'Call tree'

Symbol: 

Function: This command opens the “Call Tree” view.

Call:

● “View” menu
● Context menu of a callable block in the “Devices” or “POUs” view.
The call tree is available at all times, even before compiling the application. It is a static representation of the caller and the calls of the block that you specify explicitly. Therefore, the tree always contains two root nodes above the respective call order is displayed as successive indented entries. Recursive calls are detected quickly in this tree representation.

Example of a call tree (1) for the (2) PLC_PRG block:

- (3) Node “<block name> is called by:”
- (4) Node “<block name> calls:”

<table>
<thead>
<tr>
<th>“Block name”</th>
<th>Name of the program block; specified manually, by dragging from another view, or by means of the button. The drop-down list includes the last specified block names.</th>
</tr>
</thead>
</table>

**Toolbar and keyboard usage**

- **Find block** CODESYS searches for the block specified in “Block name” and displays its caller and calls.
- **Use block from the input assistant** The “Input Assistant” dialog box opens for selecting a block call or instance call. The call tree is refreshed automatically after the selection.
- **Show source code position of the selected block** CODESYS jumps to the occurrence location of the block in the source code of the program.
- **[F4]: Show source code position of the next block** The selection in the call tree jumps to the next or previous block in the call structure. At the same time, the associated source code position is opened in the respective editor.
  - Note: Double-clicking an entry in the call tree also opens the associated source code position.
- **[Shift]+[F4]: Show source code position of the previous block**

**Display of the call tree:**

- **“Symbol”** “<block name> is called by”: The call order is displayed for below this node. The bottom entry in this tree structure shows the start of the calls.
  - “<block name> calls”: The calls from this block are displayed below this node. The bottom entry in this tree structure shows the end of the call chain.
- **“Position”** For the root node in the call tree: Line numbers of the declaration (“Decl”) of the block.
  - For the caller or calls below the root node: Line number, column number, and network number of the position, depending on the implementation language.

**Context menu for the entry selected in the tree:**

- **“Collapse All”** The expanded entries in the call tree are collapsed, except for the two root nodes.
“Show Source Position”  CODESYS jumps to the occurrence location of the block in the source code of the program.

“Set as New Root Node”  The entry selected in the call tree is displayed in “Block name”. The tree is refreshed automatically for the new root nodes.

The “Call list” view is provided for immediate information when stepping through a program, as opposed to the static call tree that provides call information about a block. The call list always shows the full call path of the current position that is reached.

See also
- Chapter 6.4.1.12.4 “Stepping Through a Program” on page 1985
- Chapter 6.4.1.21.3.4.15 “Command ‘Call Stack’” on page 2590
- Chapter 6.4.1.21.3.3.31 “Command ‘Browse Call Tree’” on page 2572

Command 'Memory'
Symbol: 📚

Function:  In CODESYS V3.5 version earlier than SP11, the command opens the “Memory” view.

Call:  Menu bar: “View ➤ Memory”.

As of SP11, the command provides the notice that you must install the CODESYS Memory Tools package (available in the CODESYS Store) in order to use the memory view. After installation, you can open the “Memory” view by clicking “View ➤ Show Memory View”.

Command 'Security Screen'
Symbol: 🛡️

Function:  The command opens the “Security Screen” view.

Call:
- “View” menu
- 🛡️ icon or 🗝️ in the status bar
  The icon is displayed in blue when a valid certificate is specified for the digital signature. When only one client certificate is specified for the encrypted communication, the icon remains gray, resulting in the client certificate providing no increased security for the user.

The following security features of CODESYS are configured and displayed in the view:
- Personal user certificate
- Encrypted communication
- Encryption and signatures of IEC projects
- Encryption and signature of download, online change, and boot application
- Security level

NOTICE!
When the “Security Screen” is opened and closed, the current settings are applied in the user options, even when no active changes have been made.
If the CODESYS Security Agent add-on product is installed, then the “Security Screen” view provides an additional “Devices” tab. This allows for the configuration of certificates for the encrypted communication with controllers.

**Tab 'User'**

On this tab, certificates are configured that are required for the encrypted communication and the digital signature of the user. Only certificates with private keys can be specified here. The user profile is saved as an XML file in the user options.

| **“User Profile and Certificate Selection”** | By default, the login name for Windows is specified as the user profile. |
| List box with existing user profiles | ![Opens the “User Profiles” dialog. Here you specify the name for a new user profile.](image) | ![Deletes the selected user profile. This user profile is no longer displayed in the list box.](image) |

| **“Digital Signature”** | ![Opens the “Certificate Selection” dialog for selecting the certificate for the digital signature.](image) | One certificate can be selected. The certificate has to have a private key. |
| ![Deletes the displayed certificate.](image) | One certificate can be selected. The certificate has to have a private key. |

| **“Project File Decryption”** | ![Opens the “Certificate Selection” dialog for selecting the certificate for decrypting project files.](image) | One certificate can be selected. The certificate has to have a private key. |
| ![Deletes the displayed certificate.](image) |

See also

- Chapter 6.4.1.21.4.19 “Dialog ‘Certificate Selection’” on page 2811

**Table 478: “Security Level”**

| **“Activate the Use of Certificates for Enhanced Security”** | |
| **“Enforce encrypted communication”** | ![When the user communicates with the controller, the server certificate of the controller is used for establishing an encrypted connection. Then the entire communication is encrypted.](image) |

| **“Enforce encryption of project files”** | ![All project files of the user are encrypted with a certificate. When the project is saved, it is encrypted with the certificate specified in the project settings (“Project Settings ➔ Security” dialog). The selected certificate is displayed on the “Project” tab in the “Project file encryption” group. To open this project, the certificate to be encrypted has to be specified in “Project file decryption” with a private key.](image) |

| **“Enforce signing of project files”** | ![All project files of the user are signed with a certificate. In “Digital Signature”, a certificate has to be specified with a private key. When a project is saved, a signature file <project name>.project.p7s is generated in the project directory containing the signature.](image) |
"Enforce encryption of downloads, online changes and boot applications"
- The data that is downloaded to the controller has to be encrypted with a controller certificate.
  This certificate is defined directly either in the properties dialog of the application on the "Encryption" tab, or in the security screen, on the "Project" tab, in the "Encryption of Boot Application, Download and Online Change" group.
  Controller certificates are located in the local Windows Certificate Store in the "PLC Certificates" directory. If the certificates of your controller are not available in the directory, then they first have to be loaded from the controller and installed to the directory. For instructions, see the "Controller Certificates" chapter.

"Enforce signing of downloads, online changes and boot applications"
- The online code (downloads, online changes, and boot applications) have to be signed with a certificate with a personal key. The certificate is selected from the "Digital Signature" area.
  Requirement: The "Encryption of boot application, download and online change" option is selected.

"Enforce signing of compiled libraries"
- The "File ➔ Save Project as Compiled Library" command generates a signed library <library name>.compiled-library-v3.
  Requirements
  ● A certificate with a private key that supports code signing is available.
  ● A library compatibility >= CODESYS V3 SP15 is set in the project information.
  "Enforce timestamping of signed compiled libraries": The URL of the time stamp server which created the time stamp has to be entered in the "Timestamping server" field. Example: timestamp.comodoca.com/rfc3161.

See also
- § Chapter 6.4.1.16 “Using the Command-Line Interface” on page 2028
- § Chapter 6.4.1.21.3.2.7 “Command "Save Project as Compiled Library”” on page 2556
- § Chapter 6.4.1.17.3 “Information for Library Developers” on page 2035

Tab 'Project'
All project-specific settings are configured on this tab. These elements are active only when a primary project is loaded.

"Project file encryption"

"Technology"
- Opens the “Project Settings ➔ Security” dialog
  When you select the "Encryption" project setting and then "Certificates" in the dialog, you can choose a corresponding certificate by clicking . For more information, see the description of the "Project Settings: Security" dialog.

"Certificates of Users Sharing this Project"
Area for listing the certificates that encrypt the project file.
"Encryption of Boot Application, Download and Online Change"

| List of the applications of the controller | Double-clicking an application in the list opens the “Properties ➔ Encryption” dialog. Depending on the settings of the “Security Level” on the “User” tab of the “Security Screen”, the following fields are available in the open properties dialog:
  ● “Encryption” tab with active “Certificates” area
  ● “Encryption” tab with “Encryption Technology” list box.
  In the “Properties ➔ Encryption” dialog, click the button to select the controller certificate for “Encryption of Boot Application, Download and Online Change”. For more information, see the description of the “Properties: Encryption” dialog.
  Controller certificates are located in the local Windows Certificate Store in the “PLC Certificates” directory. If the certificates of your controller are not available in the directory, then they first have to be loaded from the controller and installed to the directory. For instructions, see the "Protecting and Saving a Project" - "Encryption with Certificates" chapter.

See also
- Chapter 6.4.1.21.4.12.8 “Dialog ‘Project Settings’ - ‘Security’” on page 2772
- Chapter 6.4.1.21.4.11.4 “Dialog: Properties: Security” on page 2754
- Chapter 6.4.1.6.8 “Encrypting Projects with Certificates” on page 1829

Tab 'Devices'

This tab is available only after you have installed the CODESYS Security Agent add-on. For a description of this tab, see the help for the CODESYS Security Agent.

Command 'Settings of Memory Reserve for Online Change'

Function: This command opens the “Online Change Memory Reserve” view.
Call: Menu bar: “View”.
In the view, memory reserves are configured for the function blocks during the online change.

"Scan Application"
- Searches the selected application for function blocks and displays them in the “Function blocks” area
- Updates the “Function blocks” area after the application is built again.
- Updates the “Function blocks” area after an online change.

Drop-down list with the applications of the open project
Selection of the application whose function blocks should be displayed and/or edited in this view.

<table>
<thead>
<tr>
<th>Table 479: “Function Blocks”</th>
</tr>
</thead>
<tbody>
<tr>
<td>“All”</td>
</tr>
<tr>
<td>“Pool”</td>
</tr>
<tr>
<td>“No memory-reserve”</td>
</tr>
<tr>
<td>“&lt;memory reserve&gt; bytes”</td>
</tr>
</tbody>
</table>

Information about the function blocks
Multiple selection is also possible when selecting a POU for the configuration of the memory reserve.
<table>
<thead>
<tr>
<th>“Function block”</th>
<th>Name of the function block</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Size”</td>
<td>Size of the function block</td>
</tr>
<tr>
<td></td>
<td>Size of an instance of a function block</td>
</tr>
<tr>
<td></td>
<td>Specified in bytes</td>
</tr>
<tr>
<td>“Number of instances”</td>
<td>Number of instances of a function block in the project</td>
</tr>
<tr>
<td>“Memory reserve”</td>
<td>Display of the memory reserve for each instance of the function block</td>
</tr>
<tr>
<td>“Additional memory for all instances”</td>
<td>Product of “Number of instances” and “Memory reserve”</td>
</tr>
<tr>
<td>“Remaining memory reserve”</td>
<td>Number of bytes that are available as reserve.</td>
</tr>
</tbody>
</table>

Table 480: “Settings”

<table>
<thead>
<tr>
<th>“Memory reserve (in bytes)”</th>
<th>Input field for the memory reserve for the selected function block. Specified in bytes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Requirement: the application is not located on the controller yet or you have allowed the memory reserve to be changed by clicking the “Edit” button in the “Allow editing” area.</td>
</tr>
</tbody>
</table>

| “Apply for Selection” | The “Memory reserve (in bytes)” is assigned to the function block and the table column “Memory Reserve” is updated. In multiple selection, the specified value is assigned to each function block. In order to update the columns “Size”, “Number of Instances”, “Additional Memory for All Instances”, and “Remaining Size of the Memory Reserve”, click “Build ➔ Build”, and then click the “Scan Application” button. |

Table 481: “Enable Editing”

| “Enable” | The input field “Memory reserve (in bytes)” is editable. This button is modified in “Editable”. |

Table 482: “Information”

<table>
<thead>
<tr>
<th>“Number of FBs”</th>
<th>Total number of function blocks in the application</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Additional memory for all instances”</td>
<td>Sum of the memory reserves of all function block instances of the application. Specified in bytes</td>
</tr>
</tbody>
</table>

See also
- Chapter 6.4.1.21.3.7.6 “Command ‘Online Change’” on page 2629

Command 'Start Page'

Symbol: 🕵

**Function:** This command opens the “Start Page” view.

**Call:** Main menu “View”

The view includes some basic commands and a list of recently opened projects. In addition, the CODESYS homepage is displayed.
If you access the Internet through a proxy, then you can save the authentication data in the project options ("Proxy Settings") so you do not have to provide this data every time you use this command.

By moving the mouse pointer over the list of recently opened projects, you can remove or pin individual projects in the list. Pinned projects remain in this list until you remove the pin.

In the project options ("Load and Save"), you can configure whether this start page should open automatically when you start CODESYS.

See also

- § Chapter 6.4.1.21.4.14.21 “Dialog ‘Options’ - ‘Proxy Settings’” on page 2793

**Command 'Full Screen'**

Symbol: ![Full Screen Symbol]

**Function:** This command switches the CODESYS display to full screen mode.

**Call:** Main menu “View”

Choosing this command displays the main window of the CODESYS user interface in full-screen mode. You can return to the previous setting by choosing the command again or with the keyboard shortcut [Ctrl]+[Shift]+[F12].

**Command 'Properties'**

Symbol: ![Properties Symbol]

**Function:** This command opens the properties of the currently selected object in the POU tree or device tree.

**Call:** Main menu “View”
Menu 'Project'

6.4.1.21.3.5.1  Command 'Add Object'........................................................... 2598
6.4.1.21.3.5.2  Command 'Add Folder'............................................................ 2599
6.4.1.21.3.5.3  Command 'Insert Device'......................................................... 2600
6.4.1.21.3.5.4  Command 'Plug Device'.......................................................... 2600
6.4.1.21.3.5.5  Command 'Scan for Devices'.................................................. 2600
6.4.1.21.3.5.6  Command 'Update Device'...................................................... 2602
6.4.1.21.3.5.7  Command 'Acknowledge Diagnosis', 'Acknowledge Diagnosis for Subtree'.............................................................................. 2602
6.4.1.21.3.5.8  Command 'Edit Object'............................................................ 2603
6.4.1.21.3.5.9  Command 'Edit Object with'..................................................... 2603
6.4.1.21.3.5.10 Command 'Check integrity'.................................................... 2603
6.4.1.21.3.5.11 Command 'Edit Object (Offline)'............................................ 2603
6.4.1.21.3.5.12 Command 'Set Active Application'........................................ 2603
6.4.1.21.3.5.13 Command 'Project information'................................................ 2604
6.4.1.21.3.5.14 Command 'Project Settings'................................................... 2604
6.4.1.21.3.5.15 Command 'Project Environment'............................................. 2604
6.4.1.21.3.5.16 Command 'Project Localization' - 'Create Localization Template'...................................................................................... 2604
6.4.1.21.3.5.17 Command 'Project Localization' - 'Manage Localizations'..... 2605
6.4.1.21.3.5.18 Command 'Project Localization' - 'Toggle Localization'........ 2606
6.4.1.21.3.5.19 Command 'Document' ........................................................... 2606
6.4.1.21.3.5.20 Command 'Compare objects'.................................................. 2607
6.4.1.21.3.5.21 Command 'Compare'............................................................. 2607
6.4.1.21.3.5.22 Command 'Commit Accepted Changes'.................................. 2611
6.4.1.21.3.5.23 Command 'Map pool devices'................................................ 2611
6.4.1.21.3.5.24 Command 'Export'................................................................... 2611
6.4.1.21.3.5.25 Command 'Import'................................................................. 2612
6.4.1.21.3.5.26 Command 'Export PLCopenXML'............................................. 2612
6.4.1.21.3.5.27 Command 'Import PLCopenXML'............................................. 2612
6.4.1.21.3.5.28 Command 'User management' – 'Log in User'......................... 2613
6.4.1.21.3.5.29 Command 'User management' – 'Log out User'....................... 2613
6.4.1.21.3.5.30 Command 'User management' – 'Rights...'.................................. 2613
6.4.1.21.3.5.31 Command 'Insert Device'....................................................... 2614
6.4.1.21.3.5.32 Command 'Generate EtherCAT XML'........................................ 2614
6.4.1.21.3.5.33 Command 'Generate Sercos SCI XML'.................................... 2614
6.4.1.21.3.5.34 Command 'Disable Device' – 'Enable Device'.......................... 2614
6.4.1.21.3.5.35 Command 'Edit I/O Mapping'.................................................. 2615
6.4.1.21.3.5.36 Command 'Import Mappings from CSV'................................... 2615
6.4.1.21.3.5.37 Command 'Export Mappings to CSV'...................................... 2616
6.4.1.21.3.5.38 Command 'Read PLC Parameter File to Configuration'........... 2616
6.4.1.21.3.5.39 Command 'Online Config Mode'............................................. 2616
6.4.1.21.3.5.40 Command 'Runtime licensing'................................................ 2617

Command ‘Add Object’

Symbol: 

Function: This command opens a submenu with objects that contain all objects that can be inserted, depending on the current position in the "Devices" or "POUs" view.

Call: "Project" menu, context menu in the "Devices" or "POUs" view.
**Requirement:** If CODESYS is to insert the object in the device tree, select an already existing object under which the new one is can be inserted indented. If CODESYS is to insert the object in the POUs tree, set the focus in any free place in the CODESYS window.

**Command ‘Add Folder’**

Symbol: 🗂️

**Function:** This command opens a dialog box for defining a new folder in the Devices or POUs view.

**Call:** “Project” menu, context menu in the Devices or POUs view

You cannot structure the arrangement of device nodes and device objects through folders that you have created yourself.

This command inserts the folder below the object that has just been selected in the tree. If no object is selected, CODESYS inserts the folder right at the top in the tree directly under the root node.

**Command 'Insert Device'**

**Function:** this command opens the dialog box “Add Device” for the selection of a device object that is to be inserted in the device tree below the currently selected object.

**Call:** Context menu of a device object in the device tree.

**Requirement:** An object is selected in the device tree below which a device object can be inserted.

See also

- ☢ Chapter 6.4.1.8 “Configuring I/O Links” on page 1835

**Dialog box 'Add device'**

**Function:** Depending on the currently selected position in the device tree, the dialog box offers a selection of the devices that can be inserted at this point. In addition, it contains the commands also available in the context menu: “Insert Device”, “Add Device”, “Plug Device”, “Update Device”.

**Requirement:** The devices are installed in the device repository on the local system.

If you have opened the dialog box, it always displays the selection to suit the object currently selected in the device tree until you click “Close”.

<table>
<thead>
<tr>
<th>“Name”</th>
<th>Name with which the device is to appear in the device tree. Must be a valid IEC identifier.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Add device”</th>
<th>CODESYS inserts the selected device indented below the selected object in the device tree.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Insert device”</th>
<th>CODESYS inserts the selected device at the same level as the selected object below it in the device tree.</th>
</tr>
</thead>
</table>
"Plug device"  
CODESYS inserts the selected device in the selected slot. If the slot is already occupied, the existing module is replaced by the new one.

"Update device"  
CODESYS replaces the device selected in the device tree by the one selected. Please note: Depending on the device, this may cause the configuration already done in the device editor to be overwritten with the default values!

"String for the full text search"  
This field is editable after clicking in it. For any character string entered, only those devices that include the character string are displayed in the lower view. The matched string is highlighted in yellow for these devices.

"Vendor:"  
Drop-down list with manufacturers whose available devices are displayed.

"Group by category"  
☑: The available devices (newest version) are sorted by category. The category is defined in the device description file.  
☐: The available devices appear flat and alphabetically sorted.

"Display all versions (for experts only)"  
☑: In addition, all other available versions of the devices can also be selected.  
☐: Only the newest version of each device is available for selection

"Display outdated versions"  
☑: In addition, outdated versions of the devices can also be selected. Outdated versions result, for example, from the update of plug-ins.  
☐: Outdated device versions are not displayed.

The information provided by the device description file is displayed:  
device name, vendor, categories, version, order number and a short description, device-specific bitmap.

See also
- ☰ Chapter 6.4.1.21.3.5.31 “Command 'Insert Device’” on page 2614
- ☰ Chapter 6.4.1.21.3.5.4 “Command 'Plug Device’” on page 2600
- ☰ Chapter 6.4.1.21.3.5.6 “Command 'Update Device’” on page 2602

Command 'Plug Device'  

Function: Like the command “Add Device”, this command opens the dialog box “Add Device” for the selection of a device object that is to be inserted in the device tree in the currently selected slot.

Call: Context menu of the slot of a device object in the device tree.

Requirement: The slot of a device object is selected in the device tree.

An empty slot is identified by the symbol • and the entry "<empty> (<empty>)". An occupied slot is given the symbol ✪ and the name of the device.

In the case of an occupied slot, this command replaces the existing module with the new one.

See also
- ☰ Chapter 6.4.1.21.3.5.3 “Command 'Insert Device’” on page 2599
- ☰ Chapter 6.4.1.8 “Configuring I/O Links” on page 1835

Command 'Scan for Devices'  

Function: The command establishes a brief connection to the hardware and determines the devices in the network. Then you can apply the devices found into the device tree of your project.

Call: Menu bar: “Project”; context menu of a device object in the device tree
Requirement: The communication settings to the controller are correct. The gateway and the PLC are started. The device supports the scan function.

The following devices provide the scan function: EtherCAT master, EtherNet/IP Scanner (IEC), Sercos master, CANopen Manager, CANopen Manager SIL2, PROFINET controller and PROFIBUS DP master.

You can perform the device scan immediately if the scan function is permanently implemented in the PLC. When scan function is implemented in a library, you have to log in only one time to download the library to the controller.

The command refers to the master controller selected in the device tree. For example, an already inserted PROFINET IO controller can be selected and the command used to determine the I/O devices and I/O modules assigned to it.

After performing the scan operation, the “Scan Devices” dialog opens and displays the found devices.

**Dialog 'Scan Devices'*

<table>
<thead>
<tr>
<th>Table 484: “Scanned Devices”</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Device name, Device type, Address, Station name, etc.”</strong></td>
</tr>
<tr>
<td><strong>“Show differences to project”</strong></td>
</tr>
<tr>
<td><strong>“Scan for Devices”</strong></td>
</tr>
<tr>
<td><strong>“Copy All Devices to Project”</strong></td>
</tr>
</tbody>
</table>

**NOTICE!**

If you insert devices, which are available in the device tree, to the device tree with “Copy All Devices to Project”, then the following should be noted. The data of the “Process Data” and “<...> I/O Mapping” tabs of the existing devices can be overwritten with the data of the recently inserted devices.
Table 485: “Configured Devices”

This part of the dialog is visible only when you select the “Show differences to project” option.

Differences between the scanned and configured devices are color-coded. Devices displayed in green are identical on both sides. Devices displayed in red are available only in the view of the scanned or configured devices.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Up Arrow]</td>
<td>If you have selected a device in both views, then the scanned devices are inserted above the selected configured device.</td>
</tr>
<tr>
<td>![Down Arrow]</td>
<td>If you have selected a device in both views, then the scanned devices are inserted below the selected configured device.</td>
</tr>
<tr>
<td>![Reload]</td>
<td>If you have selected a device in both views, then the configured devices are replaced by the selected scanned device.</td>
</tr>
<tr>
<td>![Copy]</td>
<td>All scanned devices are copied to the project.</td>
</tr>
<tr>
<td>![Delete]</td>
<td>Deletes the selected configured device.</td>
</tr>
</tbody>
</table>

The dialogs for the scan differ depending on the type of device. See the help pages for the respective device editor.

Command 'Update Device'

**Function:** Like the command “Add Device”, this command opens the dialog box “Add Device” for the selection of a device object. This object is inserted in the device tree in place of the currently selected object.

**Call:** Context menu of a device object in the device tree.

**Requirement:** An object is selected in the device tree below which a device object can be inserted.

With this command you can insert either a different version of a device or a different type of device in place of the previous one.

The symbolic device name used in the device tree is retained, but the device type specified in parentheses behind it changes if a different type has been selected. Thus if only the device version is changed, the object entry appears unchanged.

If the device type does not change, the configuration tree indented below the device entry concerned is retained. In this case the configuration settings also remain the same. Inconsistencies in the configuration resulting from the device update are reported by CODESYS at the next compilation of the application. This also concerns implicitly inserted libraries, which CODESYS does not remove accordingly during a device update.

See also
- Chapter 6.4.1.8 “Configuring I/O Links” on page 1835
- Chapter 6.4.1.21.3.5.3 “Command 'Insert Device’” on page 2599

Command 'Acknowledge Diagnosis', 'Acknowledge Diagnosis for Subtree'

**Function:** The command acknowledges a diagnosis message.

**Call:** Context menu of a device object in the device tree

**Requirement:** The project is in online mode.
The “Acknowledge diagnosis” command acknowledges the diagnosis messages of an individual device. The “Acknowledge Diagnosis for Subtree” command also acknowledges the diagnosis messages of all subordinate devices. The diagnosis message of a pending malfunction is indicated by a red exclamation mark at the device object. The diagnosis message of a corrected malfunction is indicated by a gray exclamation mark.

Command 'Edit Object'

**Function:** This command opens the object in its editor.

**Call:** Main menu “Project”, context menu.

**Requirement:** An object is selected in the device tree or in the “POUs” view.

Command 'Edit Object with'

**Function:** When multiple objects are available for an object, this command opens a dialog box for selecting an editor. If only one editor is available for an object, then this command opens the object in that editor.

**Call:** Main menu “Project” or shortcut menu (right-click)

**Requirement:** An object is selected in the device tree or in the “POUs” view.

In the standard installation of CODESYS, there is no object that has multiple available editors.

Command 'Check integrity'

**Function:** Automation Builder checks the project integrity for the complete project ("Project integrity" checks if all devices in the device tree are installed in the device repository).

**Call:** Main menu “Project”, Context menu.

**Requirement:** A project is open.

Command 'Edit Object (Offline)'

**Function:** The command opens the object offline in the editor.

**Call:** Main menu “Project”, Context menu

**Requirement:** The application is in online mode. An object is selected in the device tree or in the “POUs” view.

The command allows you to edit objects in online mode. After editing you transfer the changes to the controller by use of the command “Online ➔ Online Change” or “Online ➔ Load”.

See also

- Chapter 6.4.1.21.3.7.6 “Command ‘Online Change’” on page 2629
- Chapter 6.4.1.21.3.7.5 “Command ‘Load’” on page 2628

Command 'Set Active Application'

**Function:** This command sets the selected application as the active application.

**Call:** Main menu “Project”, or right-click the “Application” object.

**Requirement:** The project has at least two applications. The selected application is not active.

Online actions apply only to the active application. The name of an active application is displayed in bold typeface in the device tree.
Command 'Project information'

Symbol: 

**Function:** This command opens the dialog box “Project Information”.

**Call:** Main menu “Project”

When you execute the command in the project for the first time, CODESYS creates the “Project Information” object.

See also

- Chapter 6.4.1.3.4.2 “Retrieving and Editing Project Information” on page 1813
- Chapter 6.4.1.3.4.3 “Making project settings” on page 1814
- Chapter 6.4.1.21.2.24 “Object ‘Project Information’” on page 2515

Command 'Project Settings'

Symbol: 

**Function:** This command opens the “Project Settings” dialog box.

**Call:** “Project” menu or double-click on the object “Project Settings” in the “POUs” view

**Requirement:** A project is open.

See also

- Chapter 6.4.1.3.4.3 “Making project settings” on page 1814
- Chapter 6.4.1.21.4.12 “Dialog ‘Project Settings’” on page 2766
- Chapter 6.4.1.21.2.23 “Object ‘Project Settings’” on page 2514

Command 'Project Environment'

**Function:** This command opens the “Project Environment” dialog box.

**Call:** “Project” menu

**Requirement:** A project is open.

this command is for checking the currentness of software and files integrated in the project and enables them to be updated.

See also

- Chapter 6.4.1.21.4.13.2 “Dialog ‘Project Environment’ – ‘Library Versions’” on page 2778
- Chapter 6.4.1.21.4.13.3 “Dialog ‘Project Environment’ - 'Compiler Version’” on page 2778
- Chapter 6.4.1.21.4.13.4 “Dialog ‘Project Environment’ - 'Device Versions’” on page 2779
- Chapter 6.4.1.21.4.13.5 “Dialog ‘Project Environment’ – ‘Visualization Profile’” on page 2779
- Chapter 6.4.1.21.4.13.6 “Dialog ‘Project Environment’ – ‘Visualization Styles’” on page 2780
- Chapter 6.4.1.21.4.13.7 “Dialog ‘Project Environment’ – ‘Visualization Symbols’” on page 2780

Command 'Project Localization' - 'Create Localization Template'

**Function:** This command opens the “Create Localization Template” dialog. Define here which information should be exported from the project to a translation template (*.pot file).

**Call:** Menu bar: “Project ➤ Project Localization”.

**Requirement:** A project is open.
Dialog 'Create Localization Template'

This dialog is used for selecting the textual information that should be used in the localization template.

Table 486: "Include the Following Information"

| "Names" | Texts, such as dialog captions and object names in the device tree |
| "Identifier" | Variable identifier (example: Counter) |
| "Strings" | Example: 'count' in the following declaration: strVar: STRING := 'count'; |
| "Comments" | Comment texts in the POUs |
| "Position information" | Selection of which positions of the selected text categories in the project should be included in the translation file. The position information is located in the first line(s) of a segment for a translation. Example: #: D:\Proj1.project\Project_Settings:1 msgid "Project settings" msgstr "" |
| “All”: All detected positions of the text are listed. |
| “First appearance”: In the translation file, the position is included in the project where the text to be translated appears for the first time. |
| "None" |
| "Generate" | This button opens the dialog for saving a file. The translation template is created in a text file of type *.pot (portable object template). Each further generation creates a completely new template file. |

See also

- Help about CODESYS Visualization: Multi-language capability

Command 'Project Localization' - 'Manage Localizations'

Function: This command opens the “Manage localizations” dialog. Select the desired localization language in the dialog or the original version of the project. You can still accept the localization files *.<language>.po into the project or remove them.

Call: Menu bar: “Project → Project localization”.

Requirement: A project is open.

Dialog 'Manage localizations'

| “Available Localizations” | List of the localization files available in the project. Example: proj1-de.po proj1-en.po <original version> |
| “Add” | This button opens the dialog for selecting an additional po file from the file system. |
| “Remove” | This button removes the po file, which is selected on the left side, from the project. |
| “Default localization” | ☑: The selected localization is for the default localization. The entry is displayed in bold. |
Switch Localization

Use this button to switch to the selected localization.

OK

The project is displayed in the language that is provided by the file selected below the files. If you select "<original version>", then the project appears in the editable non-localized version.

See also

● Chapter 6.4.5.8 “Setting Up Multiple Languages” on page 2906

Command 'Project Localization' - 'Toggle Localization'

Symbol: 🔄

Function: This command switches between the currently set project localization and the <original version>.

Call: Menu bar: "Project © Project Localization"; button in the "Manage Localizations" dialog; 🔄 button on the toolbar.

Requirement: A project is open. A default localization for the project is defined in the "Manage Localizations" dialog.

See also

● Help about CODESYS Visualization: Multi-language capability

Command 'Document'

Symbol: 📄

Function: This command opens the "Document Project" dialog box, where you can define the project documentation. This includes the selection of objects in the open project that you want to print.

Call: Main menu "Project"

Table 487: “Document Project” dialog box

<table>
<thead>
<tr>
<th>&quot;Please select the objects which are to be printed&quot;</th>
<th>Project tree view</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>In this view, you can select or clear objects for printing.</td>
</tr>
<tr>
<td></td>
<td>All objects are selected by default.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Title page&quot;</th>
<th>CODESYS creates a title page named &quot;Project Documentation&quot; with the following information:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>● File: project file name</td>
</tr>
<tr>
<td></td>
<td>● Date: Creation date of the project documentation</td>
</tr>
<tr>
<td></td>
<td>● Profile: CODESYS profile of the project</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Table of contents&quot;</th>
<th>CODESYS creates a table of contents for the project documentation.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>&quot;Preview&quot;</th>
<th>CODESYS creates and opens a print preview of the project documentation.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>&quot;Select&quot;</th>
<th>CODESYS opens a drop-down list of all or single object types for the project documentation.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>&quot;Deselect&quot;</th>
<th>CODESYS opens a drop-down list of all or single object types that should be excluded from the project documentation.</th>
</tr>
</thead>
</table>

| "OK" | The “Print” dialog box opens. |
Command 'Compare objects'

**Function:** To compare similar objects within a project.

**Call:** Main menu ‘Project’, Context menu.

**Requirement:** Both projects have to be open.

See also:
- Chapter 6.4.1.5 “Comparing projects” on page 1817
- Chapter 6.4.1.21.3.5.22 “Command ‘Commit Accepted Changes’” on page 2611

Command 'Compare'

**Symbol:** ⌜

**Function:** This command opens the “Project Comparison” dialog. In this dialog, you define the reference project to compare with the current project. You configure the comparison process by means of options. When the dialog is exited, the comparison starts and the result is shown in the view “Project Compare - Differences”.

**Call:** Menu bar: “Project ➤ Compare”.

**Requirement:** A project is open.

See also:
- Chapter 6.4.1.21.3.2.12 “Command ‘Print’” on page 2560
- Chapter 6.4.1.21.4.12.7 “Dialog ‘Project Settings’ - ‘Page Setup’” on page 2772

**Table 488:** “Compare the currently open project with:”

<table>
<thead>
<tr>
<th>“Project on disk”</th>
<th>Path of the reference project on the file system.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Project in a source control database”</td>
<td>“Host”: Name of the host where the source code management is located. “Port”: Number of the port for connecting to the source code management. “Location”: Path of the reference project.</td>
</tr>
</tbody>
</table>

**Requirement:** The project is linked to source code management.

**Table 489:** “Compare Options”

<table>
<thead>
<tr>
<th>“Ignore whitespace”</th>
<th>☑: Whitespace differences between the current project and the reference project are ignored.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Ignore comments”</td>
<td>☑: Comments in the programming code are excluded from the comparison.</td>
</tr>
<tr>
<td>“Ignore properties”</td>
<td>☑: Object properties are excluded from the comparison.</td>
</tr>
</tbody>
</table>

| “OK” | Starts the project compare and displays the result in the view “Project compare - Differences”. |

**View ‘Project Comparison’ - ‘Differences’**

The project compare view opens when you click “OK” to close the “Project Compare” dialog.
(1) Object tree of the current project
(2) Object tree of the reference project
(3) Command 'Accept Block', command 'Accept Single'
(4) Compare options, configured in 'Project Compare' dialog

Compare statistics: added, deleted, and changed objects

Table 490: Toolbar

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Switches to the detailed compare view" /></td>
<td>Switches to the detailed compare view “Project Comparison’ - ‘&lt;object name&gt; Differences” for the object selected in the tree. Alternative: Double-click the object.</td>
</tr>
<tr>
<td><img src="image" alt="Selects the next bottom object" /></td>
<td>Selects the next bottom object in the device tree where differences were detected.</td>
</tr>
<tr>
<td><img src="image" alt="Selects the next top object" /></td>
<td>Selects the next top object in the device tree where differences were detected.</td>
</tr>
<tr>
<td><img src="image" alt="“Accept Block”" /></td>
<td>The block (selected object with all subordinate objects and units) is selected for acceptance from the reference block to the current block. Repeated clicking of “Accept Block” undoes the effects of its last change.</td>
</tr>
<tr>
<td><img src="image" alt="“Accept Single”" /></td>
<td>The object is selected in the current object for acceptance from the reference line.</td>
</tr>
<tr>
<td><img src="image" alt="Requirement" /></td>
<td>Requirement: The properties, access rights, or contents of the objects selected in the object tree are different. Opens the “Accept” dialog.</td>
</tr>
</tbody>
</table>
Table 491: Display of differences with colors, and symbols

<table>
<thead>
<tr>
<th>Color and Font Combination</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black font</td>
<td>Objects are identical.</td>
</tr>
<tr>
<td>Object name with</td>
<td>Child objects of the object are different</td>
</tr>
<tr>
<td>Gray highlight</td>
<td>Objects are different.</td>
</tr>
<tr>
<td>Gray highlight + bold blue font</td>
<td>Object is only in the reference project.</td>
</tr>
<tr>
<td>Gray highlight + bold green font</td>
<td>Object is only in the open project (not in reference project).</td>
</tr>
<tr>
<td>Gray highlight + red font +</td>
<td>Object has different properties.</td>
</tr>
<tr>
<td>Gray highlight + red font +</td>
<td>Access rights of object and reference object are different.</td>
</tr>
<tr>
<td>Gray highlight + bold red font +</td>
<td>Implementation of objects is different.</td>
</tr>
<tr>
<td>Yellow highlight</td>
<td>Object is activated for acceptance.</td>
</tr>
<tr>
<td>Yellow highlight + +</td>
<td>Adding the reference object to the open project is activated.</td>
</tr>
<tr>
<td>Yellow highlight + -</td>
<td>Deleting the object (in the open project) is activated.</td>
</tr>
<tr>
<td>Yellow highlight + +</td>
<td>Acceptance of the properties of the reference project is activated.</td>
</tr>
<tr>
<td>Yellow highlight + red font +</td>
<td>Acceptance of the access rights of the reference project is activated.</td>
</tr>
<tr>
<td>Gray highlight + red font +</td>
<td>Acceptance of the implementation of the reference project is activated.</td>
</tr>
</tbody>
</table>

“Compare options” | Defined comparison options in the “Project Comparison” dialog. |
“Compare statistics” | Number of additions, deletions, and changes in the current project, as compared to the reference project. “Change” means differences of an object available in both projects. |

× The dialog prompt opens: “Do you want to commit the changes which you made in the diff view?” “Yes”: The contents, properties, or access rights of the objects highlighted in yellow are modified in the project. Now they correspond to the reference project. Then the project compare view is closed completely.

View ‘Project Comparison’ - ‘<object name> Differences’ | Function: Detail compare view |
Call in the project compare view: |
● Select an object that is identified as having different contents which you need to view in detail. Click . |
● Double-click the object.

Table 492: Toolbar

Switch back to the project compare view. |
Selects the next line below in the code where differences were detected.
Selects the line above in the code where differences were detected.

“Accept Block”

The block (with all subordinate lines) is selected for acceptance of the reference blocks into the current project.

A block in the detailed compare view consists of the unit where the cursor is located and all corresponding units that have the same difference markers. A unit is a line, network, or element. Subsequent lines of a line are examples of corresponding units.

Repeated clicking of “Accept Block” undoes the effects of its last change.

“Accept Single”

The line is selected in the current object for acceptance of the reference line.

Switches between the default display where different units (lines, networks, elements) are displayed in red and another display: The units are displayed as recently added in the open project. In the reference project, they are displayed as deleted.

Available within the detailed compare view only.

Note: Depending on the display, detected differences in the statistics are counted as changed, inserted, or deleted.

<table>
<thead>
<tr>
<th>Table 493: Display of differences with colors, and symbols</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black font</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Gray highlight + bold blue font</th>
<th>Code is only in the reference project.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gray highlight + bold green font</td>
<td>Code is only in the current project (not in reference project).</td>
</tr>
</tbody>
</table>

| Yellow highlight | The object is activated for acceptance. |

| × | The dialog prompt opens: “Do you want to commit the changes which you made in the diff view?” |

| “Yes” | The code highlighted in yellow is accepted into the project. The code corresponds to the reference project. Then the detailed view is closed and the project view is displayed. You can continue working with project compare. |

Dialog 'Accept'

Table 494: “Which meta data should be accepted?”

| “Access rights” | ☑: Access rights that are selected for acceptance. |

| “Accepted groups” | Grouping with access rights accepted by the reference project. A group is accepted if it is present in both projects with different access rights. |
| Example: Group_A |

| “Unaccepted groups (missing in a project)” | The group is not accepted if it is not present in one of the two projects. |

| “Properties” | ☑: Properties activated for accept |
| Requirement: The properties of the reference object and object are different. |
Command 'Commit Accepted Changes'

Symbole: 

**Function:** This command commits the accepted differences from the project comparison to the current project.

**Call:** “Project ➔ Commit Accepted Changes”.

**Requirement:** Changes from the project comparison have been accepted.

![Information icon]

The changes are only copied to the project. This command does not save them to the hard disk.

See also
- 📚 Chapter 6.4.1.5.3 “Opening the detailed compare view” on page 1818

Command 'Map pool devices'

Symbole: 

**Function:** Maps imported devices from the device pool to already configured devices below a PLC.

**Call:** Main menu “Project”, Context menu.

**Requirement:** A project is open.

📚 Chapter 6.6.1.1.8 “Arrange or map devices imported to the device pool” on page 4194

Command 'Export'

**Function:** This command opens a dialog box for exporting objects from a project to an XML file.

**Call:** Menu bar: “Project”.

**Dialog 'Export'**

This dialog box lists all objects from the device tree, POU tree, and module tree that CODESYS can export.

<table>
<thead>
<tr>
<th>One file per subtree</th>
<th>CODESYS generates a separate export file for each subtree that is located directly under the root node and includes selected files.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CODESYS generates one export file for all selected objects.</td>
</tr>
</tbody>
</table>

**“Saved version”**

This version should correspond to the target version where the export file will later be imported.

If the current project contains plug-ins or add-ons that are not available in the selected memory format (profile), then the “Extend Profile” dialog box opens. In this dialog box, the selected profile can be extended with the add-ons.

See also
- 📚 Chapter 6.4.1.21.3.2.5 “Command 'Save Project as’” on page 2555
- 📚 Chapter 6.4.1.21.3.5.25 “Command 'Import’” on page 2612
- 📚 Chapter 6.4.1.4.2 “Exporting and importing projects” on page 1815
Command 'Import'

**Function:** This command opens a dialog box for importing objects from an XML file.

**Call:** Menu “Project”

**Requirement:** A project is open.

**Dialog box 'Import'**

The dialog box lists all objects from the export file that CODESYS can import at this point.

<table>
<thead>
<tr>
<th>“Currently selected target objects”</th>
<th>Object that is selected in the Device tree</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Insertable items”</td>
<td>Displays all objects of the export file that CODESYS can insert below the selected object.</td>
</tr>
<tr>
<td>“Show contents”</td>
<td>Displays the contents of the export file in a tree structure</td>
</tr>
</tbody>
</table>

Command 'Export PLCopenXML'

**Function:** This command opens a dialog box for exporting objects from a project into an XML file in the PLCopen format.

**Call:** Menu “Project”

**Dialog box 'Export PLCopenXML'**

The dialog box lists all objects from the Device tree that CODESYS can export into an XML file in accordance with the PLCopen format.

The PLCopenXML scheme does not permit VAR_GLOBAL and VAR_GLOBAL CONSTANT POU's to be in the same variable list. Therefore, if you wish to export both, you must first divide the variables into two separate variable lists.

See also

- ☀ Chapter 6.4.1.21.3.5.27 “Command ‘Import PLCopenXML’” on page 2612

Command 'Import PLCopenXML'

**Function:** This command opens a dialog box for importing objects from an XML file in PLCopen format.

**Call:** Menu “Project”

**Requirement:** A project is open.

**Dialog box 'Import PLCopenXML'**

The dialog box lists all objects from the PLCopen export file that CODESYS can import at this point.

<table>
<thead>
<tr>
<th>“Currently selected target object”</th>
<th>Object that is selected in the Device tree</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Insertable items”</td>
<td>Displays all objects of the export file that CODESYS can insert below the selected object.</td>
</tr>
</tbody>
</table>
The PLCopenXML scheme does not permit VAR_GLOBAL and VAR_GLOBAL CONSTANT POUs to be in the same variable list. Therefore, if you wish to export both, the variables must first be divided into two separate variable lists.

Command 'User management' – 'Log in User'

Symbol: 🪣

This command opens the dialog box “Login”. Here you specify the project that you wish to edit and enter the login data for a user account with the corresponding rights. In addition, you can open the password manager from this dialog box.

The command is available in the menu “Project ➔ User Management”.

See also
● § Chapter 6.4.1.6.7 “Logging in via User Account and Password Manager” on page 1827

Command 'User management' – 'Log out User'

Symbol: ❌

The user currently logged in to the project is logged out again with this command. This takes place without a dialog box or message, unless no user is currently logged in.

The command is available in the menu “Project ➔ User Management”.

If the user is currently logged in to several projects or to libraries integrated in them (it does not have to be the same user account), then the dialog box “Logout” opens, in which the specific project or library project can be selected from which the current user is to be logged out.

The status bar always displays the user who is currently logged into the project.

A double-click on the field “Current user” in the status bar enables quick access to the “Login” or “Logout” dialog box.

See also
● § Chapter 6.4.1.6.7 “Logging in via User Account and Password Manager” on page 1827
● § Chapter 6.4.1.21.3.5.28 “Command 'User management' – 'Log in User'” on page 2613

Command 'User management' – 'Rights…'

This command opens the dialog box “Rights”, in which you define the actions that may be carried out, the user groups that may carry them out and the project objects on which they may be carried out.

The command is available in the menu “Project ➔ User Management”.

See also
● § Chapter 6.4.1.6.6 “Protecting Objects in the Project by Access Rights” on page 1826
Command 'Insert Device'

Function: Like the command “Add Device”, this command opens a dialog box “Insert Device” for the selection of a device object. This object is inserted in the device tree at the same level as the currently selected object.

Call: Context menu of a device object in the device tree.

Requirement: An object is selected in the device tree below which a device object can be inserted at the same level.

See also
- § Chapter 6.4.1.8 “Configuring I/O Links” on page 1835
- § Chapter 6.4.1.21.3.5.3 “Command 'Insert Device'” on page 2599

Command 'Generate EtherCAT XML'

The command is not integrated in the standard main menu. You can add it via the dialog box “Tools ⇒ Customize” from the category “Devices”.

Function: This command opens the standard dialog box for saving a file in the local file system. You can define a name and a storage location for an xml file, in which CODESYS is to store the EtherCAT configuration of the EtherCAT master currently selected in the device tree. This may be necessary in order to operate an external EtherCAT stack.

Call: Context menu of an EtherCAT master device object in the device tree.

See also
- § Chapter 6.4.1.8 “Configuring I/O Links” on page 1835

Command 'Generate Sercos SCI XML'

The command is not integrated in the standard menu. You can add it via the dialog box “Tools ⇒ Customize” from the category “Devices”.

Function: This command opens the standard dialog box for saving a file in the local file system. You can define a name and a location for an xml file in which CODESYS then stores the configuration data of the sercos master currently selected in the device tree. This may be necessary in order to operate an external sercos stack.

Call: Context menu of a sercos master device object in the device tree.

See also
- § Chapter 6.4.1.8 “Configuring I/O Links” on page 1835
- § Chapter 6.4.1.2.2.2 “Customizing menus” on page 1802

Command 'Disable Device’ – ‘Enable Device'

Function: This command switches back and forth between the enabled (activated) and disabled (deactivated) states of a device in the bus system.

Call: Context menu of a device object in the device tree.

Requirement: The project is in offline mode. The bus driver must support the function.
A disabled device is not taken into account and is not addressed. Note that with some bus systems the deactivation of a node can lead to the master stopping.

The entry of a disabled device in the tree appears in light-gray lettering.

See also

- Chapter 6.4.1.8 “Configuring I/O Links” on page 1835

Command 'Edit I/O Mapping'

**Function:** This command opens the “Edit I/O Mapping” dialog box. This displays all I/O mappings of the currently selected device object, including I/O mappings of all additional device objects that are inserted in the device tree below this object.

**Call:** Context menu of a device object in the device tree.

**Dialog box 'Edit I/O mapping'**

You can edit the I/O mapping in this dialog box in exactly the same way as in the dialog box “I/O mapping” of the individual device editors. The respective other dialog boxes are directly updated accordingly.

| “Search” | Input field for a search string for the mapping table. The search results are marked in yellow. |
| “Filter” | Drop-down list for filtering I/O assignments displayed listed in the mapping table: |
| | ● “Show all” |
| | ● “Show outputs only” |
| | ● “Show inputs only” |
| | ● “Show unmapped variables only” |
| | ● “Show mapped variables only” |
| | ● “Show mappings to existing variables only” |
| | ● “Show mappings to new variables only” |

In the context menu you will find among other things the following commands:

- **“Export Mappings to CSV”**: Stores the mappings of a device and its sub-devices in an external file. To do this you select the device in the device tree or in the mapping list.

- **“Import Mappings from CSV”**: Inserts mappings from a file created beforehand by export.

See also

- Chapter 6.4.1.8 “Configuring I/O Links” on page 1835
- Chapter 6.4.1.21.3.5.35 “Command ‘Edit I/O Mapping’” on page 2615
- Chapter 6.4.1.21.3.5.37 “Command ‘Export Mappings to CSV’” on page 2616
- Chapter 6.4.1.21.3.5.36 “Command ‘Import Mappings from CSV’” on page 2615

Command 'Import Mappings from CSV'

**Function:** The command opens the default dialog for opening a file in the local file system. The filter is set to the file format CSV in order to import the I/O mapping configuration of a device from the file which was exported previously by means of the “Export Mappings to CSV” command. CODESYS writes the configuration to the selected device.

**Call:** Context menu of a device object in the “Devices” view.

**Requirement:** A project is open with a device and an I/O mapping configuration. The device matches the exported CSV file.
NOTICE!
I/O mapping configurations are stored in CSV files with the semicolon separator. These files can be edited manually. If the files are edited manually, then it is imperative that this format is retained in order to import successfully. Note: The entries of the file to the I/O mapping of the device are assigned by the device name and the parameter name. Parameter names that are not unique are numbered sequentially in this file (@<n>). Fields without contents in the CSV file are ignored at import. To remove an existing entry in the I/O mapping by importing, you have to add a space in the respective field in the CSV file.

See also
- Chapter 6.4.1.21.3.5.37 “Command 'Export Mappings to CSV'” on page 2616
- Chapter 6.4.1.8.2 “Configuring Devices and I/O Mapping” on page 1836

Command 'Export Mappings to CSV'

Function: The command opens the default dialog for saving a file to the local file system. The filter is set to file format CSV. After specifying a name and a location, CODESYS stores the I/O mapping configuration in a CSV file with the semicolon separator.

Call: Context menu of a device object in the “Devices” view.

Requirement: A device object with an I/O mapping configuration is selected in the device tree.

Parameter names that are not unique are numbered sequentially in this file (@<n>).

See also
- Chapter 6.4.1.21.3.5.36 “Command 'Import Mappings from CSV'” on page 2615
- Chapter 6.4.1.8.2 “Configuring Devices and I/O Mapping” on page 1836

Command 'Read PLC Parameter File to Configuration'

Function: This command reads the configuration file IoConfig.par of the PLC and stores the values in the project. Such a file is created if the parameters of the PLC have been changed by another device, for example via a visualization. Then these parameters are changed only in the memory of the PLC, but not in the configuration of the project.

Call: Context menu of the PLC device object

Requirement: You have made the command available using the dialog in “Tools ➔ Customize”.

Command 'Online Config Mode'

Function: This command is for switching the online configuration mode on and off. At switch-on it establishes a connection to the PLC and loads an implicitly created application “HiddenOnlineConfigModeApp” to the PLC. Depending on the device, CODESYS goes into simple online configuration mode or a dialog box appears for selecting between simple and advanced online configuration mode.

Call: Context menu of the PLC object in the device tree

Requirement: The communication settings for the PLC device are correctly set.
Simple online configuration mode:

This command creates the implicit application HiddenOnlineConfigModeApp and loads it to the controller. The application automatically initializes all inputs and outputs of the controller once. After that you can access the I/Os as follows:

- Read I/Os
- Write outputs
- Diagnosis (in the device tree and on the “Status” tab of the device editor)
- Scan (of the current hardware)
- Interactive online functions, if supported (for example, writing asynchronous messages)

Advanced online configuration mode (parameter mode):

If there are already applications on the PLC and the controller supports it, the command first opens the dialog box “Devices”, which displays the applications existing on the controller. From this dialog you can connect via the button “Parameter mode” to the PLC and then access the values of the device parameters without having to log in with a real application.

**Writing and forcing in the I/O mapping**

In online configuration mode the writing and forcing of values on the “I/O Mapping” tab works differently to the way it works in real online mode. The outputs are written immediately after insertion into the table. There is no “Prepared Value” column; instead, the initial values can be changed directly after a double-click on the column “Current Value”.

---

**Dialog box 'Config application mode'**

This dialog box appears after the command “Online Config Mode” if the device supports the advanced online configuration mode and there are already real applications on the controller.

| Parameter mode | The controller configuration in the project is compared with that on the device. If they correspond, CODESYS establishes a connection to the PLC. Unlike the simple online configuration mode it permits the reading and – if supported by the driver – the writing of parameters in the generic device editor. The applications already loaded to the device remain unchanged in this case! |
| Config application mode | CODESYS switches to the 'simple online configuration mode'. |

**Command 'Runtime licensing'**

**Symbol:** 🧑

**Function:** Management of runtime licenses on the PLC. The use of some libraries and devices require the PLC to have a runtime license.

**Call:** Main menu “Project”, Context menu. Displayed only offline.

**Requirement:** A project is open. Log-in required for managing runtime licenses without need for memory card.

The license status of a PLC can be displayed at any time ➤ Chapter 6.3.2.2.6 “View license information” on page 1453.
Menu 'Build'

6.4.1.21.3.6.1  Command 'Generate Code'.............................................................. 2618
6.4.1.21.3.6.2  Command 'Clean'............................................................................. 2618
6.4.1.21.3.6.3  Command 'Clean All'....................................................................... 2618
6.4.1.21.3.6.4  Command 'Build'............................................................................ 2619
6.4.1.21.3.6.5  Command 'Rebuild'........................................................................... 2619
6.4.1.21.3.6.6  Command 'Generate Runtime System Files'....................................... 2619
6.4.1.21.3.6.7  Command 'Check all Pool Objects'..................................................... 2621
6.4.1.21.3.6.8  Command 'Generate Code for Active Application'................................ 2621
6.4.1.21.3.6.9  Command 'Check All Application Objects'........................................ 2621
6.4.1.21.3.6.10 Command 'Check Library Compatibility'........................................... 2622
6.4.1.21.3.6.11 Command 'Generate Disassembly File'............................................... 2622

Command 'Generate Code'

Symbol 📄; shortcut: [F11]

**Function:** The command starts the code generation for the active application.

**Call:** Menu bar: "Build"

When generating code with this command, code is generated as when downloading the application to the PLC, but the code is not transferred to the PLC. At this time, other source code tests are performed. As a result, you can check the code for bugs that were not detected by the compiler and for fixing any bugs before the code is used in online mode.

See also

- Chapter 6.4.1.11.5 “Generating Application Code” on page 1976

Command 'Clean'

**Function:** This command deletes the build information for the active application.

**Call:** Main menu “Build”.

During the last download, the build information was created and saved to a file (*.compileinfo). After a cleaning process, an online change is no longer possible for the affected application. The application must be fully downloaded to the controller again.

See also

- Chapter 6.4.1.21.3.6.3 “Command 'Clean All'” on page 2618

Command 'Clean All'

**Function:** This command deletes the build information for all applications in the project.

**Call:** Main menu “Build”.

During the last download, the build information was created in the local file system and saved to a file (*.compileinfo).

This command requires a download before another login. An online change is no longer possible. As compared to the “Clean” command (only the active application), CODESYS regenerates the language model for all objects, which is very time-consuming.
NOTICE!
Reconsider carefully whether or not executing this command is really necessary. If you only want to rebuild and download the active application, then execute the “Clean” command.

See also
- § Chapter 6.4.1.21.3.6.2 “Command ‘Clean’” on page 2618

Command ’Build’

Function: The command starts the build operation for the active application.

Call: The command is not in any menu by default. You can add it to a menu by using the dialog from “Tools ➤ Customize” (command category “Build”).

During the build operation, CODESYS performs a syntactic validation of all objects in the application. However, code is not generated like at log in to the target system or download of the application. The build operation is always performed automatically when you log in with a changed program.

When the check is complete, CODESYS displays any error messages or warnings in the message view (‘Build’ category).

If the program has not been changed since it was compiled without errors the last time, then it is not recompiled. The message “The application is current” appears. If the syntactic validation is repeated, then you must execute the “Rebuild” command.

See also
- § Chapter 6.4.1.21.3.6.5 “Command ‘Rebuild’” on page 2619

Command ’Rebuild’

Function: The command starts the build operation for the active application, even if the last build contained errors.

Call: The command is not in any menu by default. You can add it to a menu by using the dialog from “Tools ➤ Customize” (command category “Build”).

See also
- § Chapter 6.4.1.21.3.6.4 “Command ‘Build’” on page 2619

Command ’Generate Runtime System Files’

Function: The command generates a C stub file and an M4 interface file from the current library project. These files are used as the basis for creating an external library file.

Call: Menu bar: “Build”

Requirement: A library project is open.

The command opens the “Generate Files for Runtime System” dialog.

<table>
<thead>
<tr>
<th>“Output directory”</th>
<th>Directory where CODESYS creates the runtime system files. Click the [...] button to open the default dialog for browsing the file system.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Component names”</td>
<td>Name of the library project</td>
</tr>
<tr>
<td>“Which files do you want to create?”</td>
<td></td>
</tr>
</tbody>
</table>
"M4 interface file"

Interface file <project name>Itf.m4 with definitions. Example of m4 file:

```
#include "SysFile"  // Interface file <project name>Itf.m4 with definitions.

/*
   * <project name>Itf.m4
   */

SET_INTERFACE_NAME( "SysFile" )

/*
   * EXTERN LIB SECTION BEGIN */

/*
   * ifndef __cplusplus
   */

extern "C" {

/*
   * ifndef __cplusplus
   */

/*
   * ifndef __cplusplus
   */

typedef enum {
    FS_OK = 0,
    FS_NO_FILE = 1,
    FS_ILLEGAL_POS = 2,
    FS_FULL = 3,
    FS_EMPTY = 4,
    FS_BUFFER_FULL = 5
} filestatus;

/*
   * ifndef __cplusplus
   */

/*
   * ifndef __cplusplus
   */

/*
   * ifndef __cplusplus
   */

typedef enum {
    AM_READ = 0,
    AM_WRITE = 1,
    AM_APPEND = 2
} fileaccess;
```

"C stub file"

Stub file for reprogramming the library in C. Example of stub file:

```
#include "CmpStd.h"
#include "CmpErrors.h"
#include "CmpItf.h"
#include "SysFileDep.h"

void cdecl cdecl_ext sysfilegetpath(sysfilegetpath_struct *p) {
}

void cdecl cdecl_ext sysfilerename(sysfilerename_struct *p) {
}

void cdecl cdecl_ext sysfilewriter(sysfilewriter_struct *p) {
```

"Options"

"Export referenced types included in libraries"

The referenced types are included in the export.

"Use original type names"

The type names of the library project are used.
Command 'Check all Pool Objects'

Symbol 🌱; shortcut: [F11]

Function: The command starts a build operation (a syntax check) for all pool objects that are managed in the POU view and as a result are available throughout the project. First and foremost, this is useful when creating libraries.

Call: Menu bar: "Build"

Requirement: A library project is open.

NOTICE!

The command does not result in code generation. In addition, no file is created in the project directory with information about the build operation.

See also
- ☩ Chapter 6.4.1.21.4.15.2 “Dialog 'Customize’ - 'Menu’” on page 2801
- ☩ Chapter 6.4.1.17.3 “Information for Library Developers” on page 2035

Command 'Generate Code for Active Application'

Function: The command generates the code for the application of a library project.

Call: Menu bar: "Build"

Requirement: The project contains an application.
- A library project is open.
- The library project contains an application.

When generating code with this command, code is generated as when downloading the application to the PLC, but the code is not transferred to the PLC. At this time, other source code tests are performed as a result, you can check the code for bugs that were not detected by the compiler and for fixing any bugs before the code is used in online mode.

See also
- ☩ Chapter 6.4.1.21.3.6.6 “Command ‘Generate Runtime System Files’” on page 2619

Command 'Check All Application Objects'

Function: This command starts a build operation for all objects of the active application, even for the POU that are not used by the application. After the build operation, the errors that were found in the unused objects are also displayed in the message window.

Call: The command is not in any menu by default. You can add it to a menu by using the dialog from “Tools ➤ Customize” (command category “Build”).

Requirement: An application of the open project is active.

NOTICE!

The command does not result in code generation. In addition, no file is created in the project directory with information about the build operation.

See also
- ☩ Chapter 6.4.1.21.4.15.2 “Dialog 'Customize’ - 'Menu’” on page 2801
Command 'Check Library Compatibility'

Function: The command triggers a check whether the currently opened library project is compatible with the last installed version of this library (next lower version number).

Call: By default the command is not available in any menu. You can add it to a menu by using the "Tools ➔ Customize" dialog, command category "Build".

Requirement: A library project is opened.

The check regards differences in the implemented interfaces of a method. So, after the check you will get displayed error messages in the messages window in the following cases:

- Adding or removing inputs or outputs of function blocks, functions or methods
- Changing the data type of inputs or outputs
- Modifying the implemented interfaces of a method

See also

- § Chapter 6.4.1.21.4.15.2 “Dialog 'Customize' - 'Menu’” on page 2801
- § Chapter 6.4.1.17.3 “Information for Library Developers” on page 2035

Command 'Generate Disassembly File'

Function: This command generates a disassembly file <project name>.asm from the current project and saves it in the file directory in the project folder.

Call: The command is not in any menu by default. You can add it to a menu by using the dialog box from "Tools ➔ Customize" (command category "Build").

See also

- § Chapter 6.4.1.21.4.15.2 “Dialog 'Customize' - 'Menu’” on page 2801
Command 'Choose Active Application'

Symbol: [App (Device PLC Logic)]

The command is implemented as a list box from which you can set an application active. By default, the list box is located on the toolbar.

Function: The list box displays the currently active application with its device path.

Call: The list box contains all applications that are organized in the "Devices" view. By clicking an entry in the list box, you activate the selected application.

Requirement: The project has multiple applications.
When you call commands in the “Build” oder “Online” menus, these commands are applied to the active application. This is displayed in the list box, and also displayed in bold in the device tree. In particular, this applies to the “Build ➔ Build” and “Online ➔ Login” commands.

You can also access these commands using the command icons on the toolbar where the list box is located. When the command icons are called, they are also applied to the active application.

However, if you call a command from the context menu of a device object in the device tree, then the command is applied to the corresponding object. For example, by calling ☑, you can establish a connection to an application on the device which is not active.

See also
- Chapter 6.4.1.21.3.5.12 “Command ‘Set Active Application’” on page 2603
- Chapter 6.4.1.21.3.6.4 “Command ‘Build’” on page 2619
- Chapter 6.4.1.21.3.7.2 “Command ‘Login’” on page 2624

Command ‘Login’

Symbol: ☑; shortcut: [Alt]+[F8].

Function: The command connects the application to the target system (PLC to simulated device) and starts the online mode.
Call: Menu bar: “Online”; context menu of an “Application” object

Requirement: The application contains no errors and the communication settings are configured.

A dialog prompt opens if the communication settings are incorrect. You can then switch directly to the “Communication Settings” of the PLC.

If you click “Login” from the online menu, then the currently active application is connected to the target system. If you choose this command from the context menu (right-click) while an application is selected in the device tree, then that application is logged in, even if it is not set as the active application.

If an online user management is configured on the target device, then you are prompted for user data when you log in. The “Device User Login” dialog opens for this.

CAUTION!
Check controller accessibility

For security reasons, controllers should not be accessible from the Internet or untrusted Networks under any circumstances! In particular, the TCP/IP programming ports (usually UDP-Ports 1740..1743 and TCP-Ports 1217 + 11740 or the controller specific ports) should not be accessible from the internet without protection. In case Internet access to the controller is needed, using a safe mechanism is absolutely mandatory, such as VPN and password protection of the controller.

© Chapter 6.4.1.11.4 “Handling of Device User Management” on page 1971

NOTICE!

If a safety controller is inserted below a controller, then this command can interrupt the communication connections temporarily.

Connections of the safety controller to other safety controllers (via safety network variables), to field devices, and to the development system are affected.

The safe field devices or other safety controller can enter the safe state as a reaction. The connection to the development system is affected only when a safety controller that is connected to the main controller via a fieldbus.

For more information, see the “Subordinate Safety Controllers” chapter.

Possible situations when logging in:

- A later version of the device description (than in the project) is on the PLC. A warning prompt is displayed with the option to cancel the process.
- The application does not exist on the PLC: You are prompted to confirm the download.
- The application is already on the PLC and has not been changed since the last download. The login continues without any more prompts.
- The application exists on the PLC, but it has been changed since the last download. You are prompted to select one of the following options:
  - Login with online change (Note the information about online changes in the help page “Command ‘Online Change’ ”.)
  - Login with download
  - Login without any change

The position also provides the option of updating the boot application on the PLC.
- An unknown version of the application exists on the PLC. CODESYS prompts you to replace it.
- A version of the application exists on the PLC and is running. CODESYS prompts you to log in anyway and overwrite the currently running application.
- The application on the PLC is currently halted at a breakpoint. You are logged out and the program has been changed: CODESYS prompts you with a warning that the PLC will be stopped completely if an online change or download occurs. This happens also if several tasks exist and the breakpoint affects only one of them.
Click “Details” in the dialogs above to open the “Application Information” dialog.

In CODESYS V3.5 SP17 and higher, only exactly one CODESYS instance can ever be logged in to an application of a controller. If a second CODESYS instance wants to log in to the same application of the same controller, then an error message is displayed.

See also
- ☰ Chapter 6.4.1.21.3.7.6 “Command ‘Online Change’” on page 2629
- ☰ Chapter 6.4.1.10.7 “Subordinate safety controller” on page 1964

Dialog 'Application Information' (Details)
The dialog provides two tabs with comparative information about the application changed in the development system and its previous version currently located on the PLC. There are two tabs:

- “Application information”: The application properties of the “Application in the IDE” (Integrated Development Environment) are compared with those of the “Application in the PLC”. Project name, Last modification, IDE version, Author, Description. In addition, CODESYS shows the objects that have changed since the last download.
- “Application contents”: When the “Download application info” is selected, the contents of the applications on both the (1) development system and (2) PLC can be compared. The “Download application info” option is located on the “Application Build Options” tab of the application properties.

If the code in the development system is not current, then (3) “Application not up to date. Generate code now?” appears at the bottom left of the dialog. Execute this command to update the application source code.

This detailed information can help you to better assess the effects of login in the current situation and to make a decision about downloading the new application.

See also
- ☰ Chapter 6.4.1.21.2.8.5 “Tab ‘Applications’” on page 2434
- ☰ Chapter 6.4.1.5 “Comparing projects” on page 1817
Unknown applications on the PLC

If one or more applications are already on the PLC, but are not in the project, then CODESYS opens a dialog with a list of these applications. You can then define whether an application should be deleted before loading the current application from the PLC. This also applies to child applications that are on the PLC, but have been deleted from the project in the meantime.

Compiling the project before login

If an application program has not been compiled since the last change, then CODESYS compiles the project before login. This operation is the same as the “Generate Code” command when logged out.

If compile errors occur, then a dialog prompt opens. The errors are displayed in the message view in the “Build” category. You can then decide whether or not you log in without downloading the program to the PLC.

See also

- Chapter 6.4.1.21.3.6.4 “Command ‘Build’” on page 2619

Error at login

If an error occurs when logging in to the PLC, then CODESYS cancels the loading operation with an error message. The error dialog gives you the options of showing the error details. If an exception was thrown and the text “SOURCEPOSITION” is included in the log, then you can display the affected function in the editor by clicking “Show in Editor”. The cursor jumps to the line containing the error.

Messages during the download operation

If CODESYS downloads the project to the PLC at login, then the following information is printed to the message view:

- Generated code size
- Size of the global data
- Resulting memory requirement on the PLC
- List of the affected blocks (for online change)

In online mode, you cannot change the settings of the devices or modules. You have to logout of the application for changing device parameters. Depending on the bus system, there may be some special parameters that you can also change in online mode.

CODESYS saves the view configuration separately in online and offline mode. In addition, views are closed that cannot be used in any operating mode. For this reason, the view can change automatically at login.

Command ‘Logout’

Symbol: 📋, keyboard shortcut: [Ctrl]+[F8].

Function: This command disconnects the application from the target system (controller or simulated device) and returns to offline mode.

Call: Main menu “Online”, or context menu of the “Application” object.

Command ‘Create Boot Application’

Function: This command generates a boot application.

Call: Main menu “Online”.
A boot application is the application that is started automatically when the controller is switched on or started.

In offline mode, you can save the boot application in any directory. In online mode, CODESYS save the boot application to the target device. The file name is `<application name>.app`.

See also

- Chapter 6.4.1.11.7 “Generating boot applications” on page 1978
- Chapter 6.4.1.21.2.2 “Object ‘Application’” on page 2410

**Command 'Load'**

**Function:** This command causes a compilation of the active application with subsequent download to the controller.

**Call:** Menu bar: “Online”.

**Requirement:** The application is in online mode.

When you execute this command, CODESYS performs a syntax check and generates the application code. This code is downloaded to the PLC. Furthermore, CODESYS generates the build log `<project name>.<device name>.<application ID>.compile info` in the project directory.

**NOTICE!**

During loading all variables are re-initialized with the exception of persistent variables.

**NOTICE!**

If a safety controller is inserted below a controller, then this command can interrupt the communication connections temporarily.

Connections of the safety controller to other safety controllers (via safety network variables), to field devices, and to the development system are affected. The safe field devices or other safety controller can enter the safe state as a reaction. The connection to the development system is affected only when a safety controller that is connected to the main controller via a fieldbus.

For more information, see the "Subordinate Safety Controllers" chapter.

The description of the “Login” command describes the possible situations when logging in and loading.

If you attempt to download an application when the same version of the application is already on the PLC, then you get the message: "Program is unchanged. Application was not downloaded". CODESYS downloads the application to the PLC.

During loading a record of the actions being executed (generation of code, execution of initialization, etc.) appears in the Message window in the message category “Compile”. Furthermore, information is displayed regarding the memory ranges, the size of the code, the global data and the allocated memory. For the purpose of clarity, as opposed to the online change, the modified function blocks are no longer listed.

See also

- Chapter 6.4.1.21.3.7.2 “Command 'Login’” on page 2624
- Chapter 6.4.1.10.7 “Subordinate safety controller” on page 1964
Command 'Online Change'

**Function:** The command is used for initiating an online change on the current application. When this is done, CODESYS re-downloads only the changed parts of an application that is already running on the PLC.

**Call:** Menu bar: “Online”; context menu of an “Application” object

**Requirement:** The application is in online mode.

The command is available in the context menu if an application is selected in the device tree. In this way, you can perform an online change just for one application, even if that application is not currently active.

---

**CAUTION!**

An online change modifies the running application program and does not cause a restart.

- Make sure that the new application code still has the required effect on the controlled system.
- Depending on the controlled plant, the plant and workpieces may be damaged or the health and life of persons could be endangered.

**NOTICE!**

1. When an online change is performed, the application-specific initializations (example: homing) are not executed because the machine retains its status. For this reason, the new program code may not have the intended effect.

2. Pointer variables retain their value from the last cycle. When a pointer refers to a variable whose value was changed in an online change, the variable no longer yields the correct value. Make sure that the pointers are re-assigned in each cycle.

3. After the parent application has been changed, a child application is removed from the controller when an online change is performed.

---

**NOTICE!**

For compiler version >= 3.5.0.0, a fast online change is performed for minor changes. In this case, only the modified blocks are compiled and downloaded. In particular, no initialization code is generated. This means that also no code is generated when variables with the `init_on_onlchange` attribute are initialized. As a rule, this has no effect because the attribute is used primarily for initializing variables with addresses. However, it cannot happen that a variable changes its address during an online change.

To secure the effect of the `init_on_onlchange` attribute in the entire application code, you must deactivate the fast online change in general for the application by using the compiler definition `no_fast_online_change`. To do this, insert the definition in the application “Properties” ("Build" tab).

---

At the time of download, CODESYS also lists the changed interfaces, affected variables, and all blocks with new generated code in the “Build” category of the message view. If memory locations change, a dialog will inform you of possible problems in conjunction with pointers.

---

*In the “Online Change Memory Reserve” view, memory reserves can be configured for the online change so that instance variables do not have to be moved in the memory when changing a function block in an online change.*
What prevents an online change?

There are actions in CODESYS after which an online change on a controller is no longer possible. Afterwards, the application always has to be completely recompiled. A typical case is the “Clean All” action which deletes the compile information stored at the last download. However, these kind of actions typically generate a warning which you have to acknowledge.

But there are also "normal" editing actions that result in an online change not being possible at the next login. Therefore, pay attention to the following symbol in the status bar when editing in the program POUs: . When this symbol turns red in color, only a full download to the controller can be performed. Double-clicking the symbol opens the “Application Information” dialog with a list of differences to the last download. In the dialog, you also find information about which of the changes prevent an online change.

Actions and changes in different areas of an application that prevent an online change:

<table>
<thead>
<tr>
<th>Area</th>
<th>Prevents online change</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check functions</td>
<td>Activation/removal</td>
</tr>
<tr>
<td></td>
<td>of a check function</td>
</tr>
<tr>
<td></td>
<td>(CheckBounds, CheckRange, CheckDiv, etc.)</td>
</tr>
<tr>
<td></td>
<td>Change in an interface of a check function (also the insertion and deletion of local variables)</td>
</tr>
<tr>
<td>Task configuration</td>
<td>Change in the</td>
</tr>
<tr>
<td></td>
<td>configuration settings</td>
</tr>
<tr>
<td>Project settings</td>
<td>Change of the “Compile Options” in the “Settings” section (Unicode, replace constants, logging in, breakpoints)</td>
</tr>
<tr>
<td></td>
<td>Change in the “Compiler defines”</td>
</tr>
<tr>
<td>Application properties</td>
<td>Change of the “Target system memory settings” (“Build” tab)</td>
</tr>
<tr>
<td>POU properties</td>
<td>Change of the “External implementation” option (“Build” tab)</td>
</tr>
<tr>
<td>Task-local</td>
<td>All changes</td>
</tr>
<tr>
<td>global variable list</td>
<td></td>
</tr>
<tr>
<td>Function block</td>
<td>Change of the base POU of a function block (EXTENDS FBbase), also the insertion or deletion of such a base POU</td>
</tr>
<tr>
<td></td>
<td>Change in the interface list (IMPLEMENTS ITF). Exception: Adding a new interface at the end of a list</td>
</tr>
<tr>
<td>Data type</td>
<td>Change of the data type of a variable from a user-defined data type to another user-defined data type (for example, from TON to TOF)</td>
</tr>
<tr>
<td></td>
<td>Change of the data type from a user-defined data type to a base type (for example, from TON to TIME)</td>
</tr>
<tr>
<td></td>
<td>Note: As a workaround, you should always change the name of the variable together with the data type. Then the variable is initialized as a new variable and the old one is removed. Then an online change is possible.</td>
</tr>
<tr>
<td>Alarm configuration</td>
<td>Change in the alarm database configuration</td>
</tr>
<tr>
<td></td>
<td>Change of the number of latch variables (also has an effect on the memory format in the database)</td>
</tr>
<tr>
<td></td>
<td>Change to the configuration of the distributed alarms</td>
</tr>
<tr>
<td>Data source</td>
<td>All changes in the configuration</td>
</tr>
<tr>
<td>Device configuration</td>
<td>Change in the device tree (also by the “Update Device” command)</td>
</tr>
<tr>
<td></td>
<td>Change in a device configuration: By default, changes to device parameters are not capable of online change. However, exceptions can be configured in the device description.</td>
</tr>
<tr>
<td></td>
<td>Note: I/O mapping to variables is possible by online change.</td>
</tr>
<tr>
<td>Visualization</td>
<td>Toggling of the overlay function</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>Before V3.5 SP6:</td>
<td>Change in the configuration of the trace element</td>
</tr>
<tr>
<td>Note: In V3.5 SP6 and higher, the following applies:</td>
<td>For online changes that affect visualizations or affect the data of the application (for example, a new variable is inserted), the visualization is completely reinitialized. For TargetVisu, for example, this means that the visualization closes and reopens with the start page. For WebVisu, the visualization also restarts with the start visualization after a short waiting period.</td>
</tr>
</tbody>
</table>

| Unit conversion | Insertion or removal of objects for unit conversion |
| Trend | Change of the number of variables or maximum number of variables. Change of the number of variables with a description or special line settings |

See also
- Chapter 6.4.1.21.3.6.3 "Command 'Clean All" on page 2618
- Chapter 6.4.1.11.5 “Generating Application Code” on page 1976
- Chapter 6.4.1.14.2 “Executing the online change” on page 2025
- “Dialog 'Application Information' (Details)” on page 2626
- Chapter 6.4.1.20.6.3.21 “Attribute 'init_on_onlchange'” on page 2291
- Chapter 6.4.1.21.2.30.2 “Tab 'Configuration'” on page 2538
- Chapter 6.4.1.21.4.12.4 "Dialog Box 'Project Settings' - 'Compileoptions'" on page 2769
- Chapter 6.4.1.21.4.11.5 “Dialog 'Properties' - 'Build'” on page 2755

Command 'Source Download to Connected Device'

**Function:** This command loads the project source code (as project archive) to the controller currently connected.

**Call:** Main menu “Online”.

**Requirement:** The application is in online mode.

See also
- Chapter 6.4.1.21.3.2.10 “Command ‘Source Upload’” on page 2559
- Chapter 6.4.1.21.3.2.11 “Command ‘Source Download’” on page 2560

Command 'Download Manager'

**Symbol:** 🛠

**Function:** Download or create a boot project from the project devices or update the firmware oft he device.

**Call:** Main menu “Online”, Context menu.

**Requirement:** A project is open.

Command 'Multiple Download'

**Function:** The command causes the code generation of the applications contained in the project as well as the loading of the applications to the corresponding controllers.

**Call:** Menu bar: “Online”
The command opens a dialog with a list of the applications. In this dialog, select the applications that are to be loaded. Then, CODESYS performs the syntax check of these applications and generates the respective code. The code is then downloaded to the respective PLC. For each selected application, CODESYS generates a build log with the name `<project name>.<device name>.<application ID>.compileinfo` in the project directory.

**NOTICE!**
If a safety controller is inserted below a controller, then this command can interrupt the communication connections temporarily.

Connections of the safety controller to other safety controllers (via safety network variables), to field devices, and to the development system are affected. The safe field devices or other safety controller can enter the safe state as a reaction. The connection to the development system is affected only when a safety controller that is connected to the main controller via a fieldbus.

For more information, see the "Subordinate Safety Controllers" chapter.

---

**Dialog 'Multiple Download'**

<table>
<thead>
<tr>
<th><strong>Please select the items to be downloaded</strong></th>
<th>Selection of the applications. The applications are thereby also loaded to different controllers.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Move Up</strong>, <strong>Move Down</strong></td>
<td>Change of the order of download of the applications. The applications are downloaded to the PLCs in the order of this list. By default, this list is alphabetically sorted. Parent-child relationships of applications are thereby taken into account.</td>
</tr>
<tr>
<td><strong>OK</strong></td>
<td>Checks the syntax of all selected applications. Afterwards, the communication with the associated controller is verified for each application before the download takes place.</td>
</tr>
</tbody>
</table>

**Table 495: “Online Change Options”**

If an earlier version already exists on the PLC and is different from the current version, then the following options are provided:

<table>
<thead>
<tr>
<th><strong>“Try to perform an online change. If this is not possible, perform a full download.”</strong></th>
<th>Activated by default. If an online change cannot be executed for one of the applications, then a download is performed.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Force an online change. If this is not possible, cancel the operation.”</strong></td>
<td>If an online change cannot be performed for (at least) one of the applications, then no download is performed and the online change is terminated (for example, if you have executed the command “Clean All” beforehand).</td>
</tr>
<tr>
<td><strong>“Always perform a full download.”</strong></td>
<td>Downloads all parts of the applications to the PLC, regardless of any existing versions.</td>
</tr>
</tbody>
</table>

For selected applications that do not exist on the PLC yet, CODESYS performs a download automatically to the PLC.
Table 496: “Other Options”

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Delete all applications on the PLC which are not part of the project.”</td>
<td>☑️ Corresponding applications are deleted</td>
</tr>
<tr>
<td>“Start all applications after download or online change”</td>
<td>☑️ The applications are started after the download or online change.</td>
</tr>
<tr>
<td>“Do not release forced variables”</td>
<td>☑️ If an application with forced variables exists on the controller, and if the implementation of this application has been changed, then no download is performed for this application. The message “Error: Skipped because one or more variables have been forced” appears for this application in the window “Multiple Download - Result”.</td>
</tr>
</tbody>
</table>

Note that variables with the key attribute `PERSISTENT RETAIN` are not generally initialized. If you change the data layout, however, the persistent variables are automatically re-initialized.

After completion of the download a listing of all selected applications appears in the download order that you configured. In addition, you are shown information on the success of the download for each application in the “Multiple Download - Result” dialog:

- “Created”: A new application has been created and downloaded to the controller.
- “Not changed”: The application which exists on the controller has not been changed.
- “Online changed”: The application which exists on the controller has been modified by an online change.
- “Downloaded”: The application which exists on the controller has been replaced by a new created application.
- “Skipped due to impossible online change”: An online change could not be performed for the application. The application was not changed.
- “Error”: An error has occurred for this application during download. More details may be displayed.
- “Cancelled by user”: The operation has been aborted by the user.

See also
- ☥ Chapter 6.4.1.10.7 “Subordinate safety controller” on page 1964
- ☥ Chapter 6.4.1.9.19 “Data Persistence” on page 1920
- ☥ Chapter 6.4.1.11.5 “Generating Application Code” on page 1976
- ☥ Chapter 6.4.1.9.19 “Data Persistence” on page 1920
- ☥ Chapter 6.4.1.21.3.7.5 “Command ‘Load’” on page 2628

Command 'Reset Cold'

**Function:** The command results in a cold start of the active application on the controller.

**Call:** Menu bar: “Online”

**Requirement:** The application is in online mode.
NOTICE!

If a safety controller is inserted below a controller, then this command can interrupt the communication connections temporarily.

Connections of the safety controller to other safety controllers (via safety network variables), to field devices, and to the development system are affected. The safe field devices or other safety controller can enter the safe state as a reaction. The connection to the development system is affected only when a safety controller that is connected to the main controller via a fieldbus.

For more information, see the "Subordinate Safety Controllers" chapter.

After restarting with "Reset Cold", the following happens:

- Application code is retained on the controller.
- Variables are initialized (with the initialization value or the default initialization value 0), and the previous values are lost.
- Retain variables are initialized, and the previous values are lost.
- Persistent variables are retained with values.
- Breakpoints that were set in the code are retained with their status (for example, activated or deactivated).
- The application goes into the “STOP” state.

You can also select the command while debugging the application when it halts at a breakpoint in the “HALT ON BP” state. Then either the warm start is executed immediately, or the remaining statements of the current cycle are processed. Therefore, a message window opens for you to select the next action. However, the message window opens only if the runtime system is capable of restarting the cycle without terminating it first.

After the reset, you can run the application as usual and, for example, start the execution by clicking “Debug ➔ Start”.

See also:

- Chapter 6.4.1.12.6 “Resetting applications” on page 1990
- Chapter 6.4.1.9.19.2 “Preserving data with persistent variables” on page 1923
- Chapter 6.4.1.12.3 “Using Breakpoints” on page 1981
- Chapter 6.4.1.20.2.13 “Persistent Variable - PERSISTENT” on page 2122
- Chapter 6.4.1.10.7 “Subordinate safety controller” on page 1964
- Chapter 6.4.1.21.3.7.11 “Command 'Reset Warm'” on page 2634
- Chapter 6.4.1.21.3.7.12 “Command 'Reset Origin'” on page 2635

**Command 'Reset Warm'**

**Function:** The command results in a warm start of the active application on the controller.

**Call:** Menu bar: “Online”

**Requirement:** The application is in online mode.
NOTICE!
If a safety controller is inserted below a controller, then this command can interrupt the communication connections temporarily.
Connections of the safety controller to other safety controllers (via safety network variables), to field devices, and to the development system are affected. The safe field devices or other safety controller can enter the safe state as a reaction. The connection to the development system is affected only when a safety controller that is connected to the main controller via a fieldbus.
For more information, see the "Subordinate Safety Controllers" chapter.

After restarting with "Reset Warm", the following happens:
- Application code remains loaded on the controller.
- Variables are initialized (with the initialization value or the default initialization value 0).
- Retain variables are retained with values.
- Persistent variables are retained with values.
- Breakpoints that were set in the code are retained with their status (for example, activated or deactivated).
- The application goes into the “STOP” state.
You can also select the command while debugging the application when it halts at a breakpoint in the “HALT ON BP” state. Then either the warm start is executed immediately, or the remaining statements of the current cycle are processed. Therefore, a message window opens for you to select the next action. However, the message window opens only if the runtime system is capable of restarting the cycle without terminating it first.
After the reset, you can run the application as usual and, for example, start the execution by clicking “Debug ➔ Start”.

See also
- Chapter 6.4.1.12.6 “Resetting applications” on page 1990
- Chapter 6.4.1.9.19.2 “Preserving data with persistent variables” on page 1923
- Chapter 6.4.1.12.3 “Using Breakpoints” on page 1981
- Chapter 6.4.1.20.2.13 “Persistent Variable - PERSISTENT” on page 2122
- Chapter 6.4.1.10.7 “Subordinate safety controller” on page 1964
- Chapter 6.4.1.21.3.7.10 “Command ‘Reset Cold’” on page 2633
- Chapter 6.4.1.21.3.7.12 “Command ‘Reset Origin’” on page 2635

Command 'Reset Origin'

Function: The command results in a reset origin of the active application on the controller.
Call: Menu bar: “Online”
Requirement: The application is in online mode.
NOTICE!
If a safety controller is inserted below a controller, then this command can interrupt the communication connections permanently.

Connections of the safety controller to other safety controllers (via safety network variables), to field devices, and to the development system are affected. The safe field devices or other safety controller can enter the safe state as a reaction. The connection to the development system is affected only when a safety controller that is connected to the main controller via a fieldbus.

For more information, see the "Subordinate Safety Controllers" chapter.

After restarting with “Reset Origin”, the following happens:

- The application code is deleted, and as a result the application has no state.
- Variables are deleted, and the values are lost.
- Retain variables are deleted, and the values are lost.
- Persistent variables are deleted, and the values are lost.
- Breakpoints that were set in the code are lost.

See also:

- Chapter 6.4.1.12.6 “Resetting applications” on page 1990
- Chapter 6.4.1.9.19.2 “Preserving data with persistent variables” on page 1923
- Chapter 6.4.1.12.3 “Using Breakpoints” on page 1981
- Chapter 6.4.1.20.2.13 “Persistent Variable - PERSISTENT” on page 2122
- Chapter 6.4.1.10.7 “Subordinate safety controller” on page 1964
- Chapter 6.4.1.21.3.7.11 “Command 'Reset Warm'” on page 2634
- Chapter 6.4.1.21.3.7.10 “Command 'Reset Cold'” on page 2633

Command 'Reset Origin Device'

**Function:** The command opens a dialog to reset the device to its factory settings. All applications, boot applications, and remanent variables will be deleted from the device. Depending on the version of the device, a selection of the elements to be deleted can be made in this dialog. When these elements are unselected in the dialog, they are not deleted during the reset and remain on the controller. By default, all elements are selected and everything is deleted. Elements that are not available for selection are generally also deleted.

**Call:** Right-click a programmable device in the device tree.

After restarting with “Reset Origin Device”, the following happens:

- All applications are reset as with the “Reset Origin” command.
- All files, which are not deleted by the “Reset Origin” command, are deleted (for example, files from visualization, alarms, and recipes).
- The user management is deleted.
- All certificates which are currently managed by the runtime system are deleted.

<table>
<thead>
<tr>
<th>“Delete”</th>
<th>The object is deleted when the “Reset Origin Device” command is executed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Object”</td>
<td>Objects that can be excluded from “Delete”. The listed objects depend on the version of the controller. In version 3.5.16.20 and higher, the following objects can be excluded from the delete operation.</td>
</tr>
</tbody>
</table>

- “User Management”
- “PLC Logic”
- “Certificates”

**Note:** When resetting the device, the objects selected in this dialog are also deleted. If not all displayed objects are selected in this dialog, then possibly other objects can no longer be used or they are also deleted.

**Command 'Logoff Current Device User'**

**Symbol:** 🏀

**Function:** This command logs out the user currently logged in to the controller (device). If CODESYS still has a connection to the controller, then it will be disconnected.

**Call:** Main menu “Online”.

**Requirement:** The application is in online mode.

You can manage the device user management in the “Users and Groups” tab and “Access control” of the device editor. The commands in the “Online ➔ Security” menu provide another simple option for protecting access to the target device.

**See also**

- Chapter 6.4.1.21.3.7.12 “Command 'Reset Origin’” on page 2635
- Chapter 6.4.1.21.3.7.11 “Command 'Reset Warm’” on page 2634
- Chapter 6.4.1.21.3.7.10 “Command 'Reset Cold’” on page 2633
- Chapter 6.4.1.10.7 “Subordinate safety controller” on page 1964

**Command 'Download’**

**Function:** This command loads the compiled project in the PLC.

**Call:** Main menu “Online”, Context menu.

**Requirement:** A project is open. Log-in required for download.

**Command 'Add Device User’**

**Symbol:** 🤝

**Function:** This command configures a new device user and adds this user to the administrator group.
Call: Menu bar: “Online ➔ Security”

Requirement: The device supports a device user management. You are logged in to the device as a user.

You can manage the device user management in the “Users and Groups” tab and “Access control” of the device editor. The commands in the “Online ➔ Security” menu provide another simple option for protecting access to the target device.

See also

- Chapter 6.4.1.21.2.8.14 “Tab ‘Users and Groups’” on page 2450
- Chapter 6.4.1.11.4 “Handling of Device User Management” on page 1971

This command opens the “Add Device User” dialog. Here you define the access data of the new user.

The dialog corresponds to the dialog in the “Users and Groups” tab of the device editor for adding a new user.

Please use a strong password as follows:

- Password length >= 8 characters (best >= 12)
- Use uppercase and lowercase
- Include numbers
- Use special characters
- Do not use existing names or sequence of characters that are easy to guess (for example, “123”, “abc”, “qwerty”)

CAUTION!

After performing this action, you can no longer use a blank username and password to log in. You must remember your password.

See also

- Chapter 6.4.1.21.3.7.17 “Command ‘Remove Device User’” on page 2638
- Chapter 6.4.1.21.3.7.18 “Command ‘Change Password Device User’” on page 2639

Command ‘Remove Device User’

Symbol: 🗑️

Function: This command removes a user from the user management on the target system (device).

Call: Menu bar: “Online ➔ Security”

Requirement: You are logged in to the device as a user.

You can manage the device user management in the “Users and Groups” tab and “Access control” of the device editor. The commands in the “Online ➔ Security” menu provide another simple option for protecting access to the target device.
This command opens the "Remove Device User" dialog. Specify the user name and password of the user to be removed and click "OK" to confirm.

CAUTION!
After performing this action, you can no longer use this removed user account to log in. If this user is the only one on the target system, then a dialog prompt notifies you that this user cannot be removed.

Command 'Change Password Device User'
Symbol: ✷
Function: The command changes the password for the user who is currently logged on the PLC.
Call: “Online ➔ Security” menu
Requirement: You are logged in as a user.
The command opens the “Change Password for Device User” dialog for defining a new password. You have to specify the old password again.

NOTICE!
After performing this action, you can no longer use the previous password to log in.

Make sure that you use a strong password. Note the following:
- Password length >= 8 characters (best >= 12)
- Use uppercase and lowercase
- Include numbers
- Use special characters
- Do not use existing names or sequence of characters that are easy to guess (for example, "123", "abc", "qwer")

See also
- Chapter 6.4.1.21.3.7.16 “Command ‘Add Device User’” on page 2637
- Chapter 6.4.1.21.3.7.18 “Command ‘Change Password Device User’” on page 2639

Command 'Stop Execution on Handled Exceptions'
Function: This command halts the application where the error is located despite a programmed exception handling.
Call: This command is not available by default, but it can be configured from the “Tools ➔ Customize”, “Add Command” dialog box (“Online” category).
**Requirement:** The application is in online mode and contains a programmed exception handling with the `__TRY` and `__CATCH` operators.

If you have configured this command from the “Online” menu and you call it from there, then the currently active application is affected. Furthermore, this command can help you to detect errors.

See also
- % Chapter 6.4.1.20.3.62 “Operators ‘__TRY’, ‘__CATCH’, ‘__FINALLY’, ‘__ENDTRY’” on page 2206
- % “Adding commands” on page 1803
- % Chapter 6.4.1.21.3.9.16 “Command ‘Customize’” on page 2667

**Command 'Connect to Device'**

**Function:** The command establishes a connection to the device currently selected in the device tree.

**Call:** Context menu of the device.

**Requirements:** A device is selected in the device tree. The communication settings are configured correctly.

See also
- % Chapter 6.4.1.21.3.7.21 “Command ‘Disconnect from Device’” on page 2640

**Command 'Disconnect from Device'**

**Function:** The command disconnects the connection from a device.

**Call:** Context menu of the device.

**Requirements:** A device is selected in the device tree.

See also
- % Chapter 6.4.1.21.3.7.20 “Command ‘Connect to Device’” on page 2640

**Command 'Wink’**

**Symbol:** 🌟

**Function:** The command causes an LED of a connected controller to blink. As a result, the hardware can be identified clearly.

**Call:** The command is not in any menu by default. You can add it to a menu by means of the “Tools ➤ Customize” dialog, in the “Online” command category.

**Requirement:** The controller supports this function and the connection parameters are configured correctly.

**Command 'Simulation’**

**Function:** The command switches the development system to simulation mode.

**Call:** Menu bar: “Online”
In simulation mode, you can start and debug the active application on a simulated target device. A physical target device is not necessary for testing the online behavior of an application. When logging in for the first time, you are prompted whether the application should be created or loaded. For a simulated device, you do not have to configure the communication settings. In CODESYS simulation mode, the entry of the controller in the device tree is displayed in italics.

**NOTICE!**

**No C code for simulation mode**

In simulation mode, C code is not generated and loaded to the runtime system. To simulate the code contained in the C modules anyway, you can implement it for this purpose in the respective IEC objects of the C code module.

After successful login, the red triangle symbol (△) in the device tree indicates simulation mode. You can use the corresponding online commands for testing the application.

To switch off simulation mode, log out of the controller and execute the “Simulation” command again.

The command affects the active application only.

---

### Differences between simulation mode and operation with a physical controller

<table>
<thead>
<tr>
<th></th>
<th>Simulation</th>
<th>Physical Controller</th>
</tr>
</thead>
</table>
| **Real-time behavior / multicore** | - Runs in the CODESYS process with normal priority  
- Single-core  
-- Worse real-time behavior | - Real-time operating system  
- Single-core or multicore |
| **Architecture scope** | - Simulation 64-bit (depends on the CODESYS installation): -->
Possible compile error in the IEC application if the application has been previously run only as 32-bit (for example, use of DWORD as POINTER) | - Controller 32-bit |
| **FPU (rounding error)** | - Uses FPU of the PC  
- Different configuration of the FPU exceptions | - Uses FPU of the controller or FPU emulation  
- Different configuration of the FPU exceptions |
| **Handling of exceptions** | - Exception handling of the Windows Runtime System | - Exception handling of the controller |
Simulation | Physical Controller
---|---
External libraries (Cmp/Sys/CAA/OEM/…) | ● Only a few external Cmp/SysLibs are physically available. As compared to embedded, more SysLibs could also be available.  
● Other implementation/behavior of the SysLibs (Windows in contrast to the OS of the controller)  
● "Unresolved Reference error" on download is ignored. The application can still be downloaded to the controller and started. If the missing functions are actually called, they return nonsense values. Therefore, an IEC implementation can also be specified for external POUs. This substitute IEC code is then executed in the simulation.  
| ● "Unresolved Reference error" on download when external libraries do not exist in the controller

I/O drivers | ● I/O configuration is generated but not evaluated.  
● Fieldbus stacks are not evaluated.  
● I/O channels are not updated and no bus telegrams are sent.  
| ● Mostly no restriction, but depends on the capabilities of the controller

SoftMotion drivers | ● All SoftMotion axes are set to virtual and therefore simulated.  
| ● Mostly no restriction, but depends on the capabilities of the controller

See also
● “Chapter 6.4.1.12.2 “Testing in simulation mode” on page 1980"

Command 'Operating Mode'

**Function:** The commands set the controller to a state which prevents accidental change to the project.

**Call:** Menu bar: “Online ➔ Operating Mode”

You can use these commands, for example, to lock the state of a controller in order to prevent the controller from switching to another state while you program another controller.

When programming is complete, the controller should then be switched to a defined and externally visible state that is set exactly the same way after restarting.

The , , and symbols in the status bar indicate the current operating mode. Double-clicking one of these symbols opens a help window.
If it supports the controller, then you can switch the controller to the following operating modes:

- **“Debug”:** No restrictions
- **“Locked”:** The current state of debugging is locked on the application. No additional breakpoints can be set and no additional variables can be forced. Writing variables is still possible and breakpoints which are already set remain active. Only the "RUN" state of an application is preserved in “Locked” operating mode even if the controller is restarted.
  
  With this operating mode, a developer can prevent himself or another developer from changing the application on the controller, for example by setting or deleting a breakpoint, by forcing, or by making changes to the file system. This operating mode is helpful to prevent a download to an incorrect controller when, for example, multiple controllers of a plant are programmed.

- **“Operational”:**
  
  This operating mode makes sure that the controller reloads the same applications after a restart and that no debug features are active anymore. The operating mode is set when a controller is completely programmed and should be accepted or already is.

  Conditions for activating the “Operational” mode
  - A boot application for each application has to exist on the controller.
  - There must not be any active breakpoints set.
  - All applications have to be running.
  - There must not exist any forced values.
  - Furthermore, the device can define more of its own restrictions.

  The “Locked” and “Operational” operating modes are different in the use cases and in the requirements for activating the operating mode. However, for both operating modes the runtime system prevents the following actions:

  - Regarding the application
    - Download of an application
    - Online change
    - Force variables
    - Set breakpoints
    - Stop application
    - Reset application
    - Start application
    - Delete application

  - Regarding the file transfer of the controller
    - Download of a file to the controller
    - Delete a file on the controller
    - Rename a file on the controller
    - Create a directory on the controller
    - Delete a directory on the controller
    - Rename a directory on the controller

You cannot switch the operating mode between “Locked” and “Operational”.

**Command 'Virtual mode'**

**Function:** “Virtual Mode” option enables virtual mode for Automation Builder.

**Call:** Main menu “Online”, Context menu

**Requirement:** A project is open. Command is only available, if a license for advanced simulation support is activated.
Command 'Virtual system testing'

**Function:** The "Virtual system testing" editor contains settings for the virtual devices and the simulation set-up and control.

**Call:** Main menu "Online", Context menu

**Requirement:** A project is open. Command is only available, if a license for advanced simulation support is activated.

Menu 'Debug'

- **6.4.1.21.3.8.1** Command 'Start'................................................................. 2644
- **6.4.1.21.3.8.2** Command 'Stop'................................................................. 2645
- **6.4.1.21.3.8.3** Command 'Single Cycle'......................................................... 2645
- **6.4.1.21.3.8.4** Command 'New Breakpoint'.................................................... 2645
- **6.4.1.21.3.8.5** Command 'New Data Breakpoint'........................................... 2645
- **6.4.1.21.3.8.6** Command 'Edit Breakpoint'.................................................. 2645
- **6.4.1.21.3.8.7** Command 'Enable Breakpoint'............................................... 2646
- **6.4.1.21.3.8.8** Command 'Disable Breakpoint'............................................... 2646
- **6.4.1.21.3.8.9** Command 'Toggle Breakpoint'............................................... 2646
- **6.4.1.21.3.8.10** Command 'Step Over'........................................................... 2646
- **6.4.1.21.3.8.11** Command 'Step Into'............................................................. 2647
- **6.4.1.21.3.8.12** Command 'Step Out'............................................................. 2647
- **6.4.1.21.3.8.13** Command 'Run to Cursor'...................................................... 2648
- **6.4.1.21.3.8.14** Command 'Set Next Statement'............................................... 2648
- **6.4.1.21.3.8.15** Command 'Show Next Statement'........................................... 2648
- **6.4.1.21.3.8.16** Command 'Force Values'....................................................... 2649
- **6.4.1.21.3.8.17** Command 'Write Values'........................................................ 2649
- **6.4.1.21.3.8.18** Command 'Unforce Values'................................................... 2650
- **6.4.1.21.3.8.19** Command 'Force All Values from <Device.Application>''...... 2650
- **6.4.1.21.3.8.20** Command 'Write All Values from <Device.Application>''...... 2651
- **6.4.1.21.3.8.21** Command 'Unforce All Values from <Device.Application>''.... 2652
- **6.4.1.21.3.8.22** Command 'Flow Control'...................................................... 2652
- **6.4.1.21.3.8.23** Menu 'Core Dump'................................................................... 2653
- **6.4.1.21.3.8.24** Command 'Display Mode' - 'Binary', 'Decimal', 'Hexadecimal'..................................................................................... 2654

Command 'Start'

**Symbol:** ⌘; keyboard shortcut: [F5]

**Function:** This command starts the application (status: "RUN").

**Call:** Menu bar: "Debug"; context menu of object: "Application"

**Requirement:** The application is in online mode and its status is "STOP".

Executing this command from the "Debug" menu will affect the application that is currently in focus.

See also

- Chapter 6.4.1.11.6 "Downloading the application code, logging in, and starting the PLC" on page 1977
Command 'Stop'
Symbol: ■; keyboard shortcut: [Shift]+[F8]
**Function:** This command stops the application (status: “STOP”).
**Call:** Menu bar: “Debug”; context menu of object: “Application”
**Requirement:** The application is in offline mode and its status is “RUN”.
Executing this command from the “Debug” menu will affect the application that is currently in focus.

Command 'Single Cycle'
Keyboard shortcut [Ctrl]+[F5]
**Function:** This command executes the active application for one cycle.
**Call:** Main menu “Debug”.
**Requirement:** The application is in online mode and the program is halted at a program step.

Command 'New Breakpoint'
Symbol: ▼, keyboard shortcut [Alt]+[F7].
**Function:** This command opens the “Breakpoint Properties” dialog box.
**Call:** Main menu “Debug”.
**Requirement:** The application must be in online mode.

With the “Toggle Breakpoint” command, you can set a new breakpoint directly at the current cursor position in online mode.

See also
● ☞ Chapter 6.4.1.12.3 “Using Breakpoints” on page 1981

Command 'New Data Breakpoint'
Symbol: ✉
**Function:** The command opens the “New breakpoint” dialog.
**Call:** Menu bar: “Debug”
**Requirement:**
- The application is in online mode.
- The device description file of the target device contains the entries for the "data breakpoints" functionality. Currently, data breakpoints are possible only with the CODESYS Control Win V3.
See also
● ☞ Chapter 6.4.1.21.4.9 “Dialog ‘New Breakpoint’” on page 2750
● ☞ Chapter 6.4.1.12.3 “Using Breakpoints” on page 1981

Command 'Edit Breakpoint'
Symbol: ☑
**Function:** This command opens the “Breakpoint Properties” dialog box.
**Call:** Main menu “Debug”.
**Requirement:** The application is in online mode and the cursor is halted at a breakpoint.
See also
- Chapter 6.4.1.12.3 “Using Breakpoints” on page 1981

---

**Command 'Enable Breakpoint'**

**Function:** This command enables a disabled breakpoint.
**Call:** Main menu “Debug”.
**Requirement:** The application is in online mode and the cursor is halted at a disabled breakpoint.
See also
- Chapter 6.4.1.12.3 “Using Breakpoints” on page 1981

---

**Command 'Disable Breakpoint'**

**Function:** This command disables an enabled breakpoint.
**Call:** Main menu “Debug”.
**Requirement:** The application is in online mode and the cursor is halted at an enabled breakpoint.
See also
- Chapter 6.4.1.12.3 “Using Breakpoints” on page 1981

---

**Command 'Toggle Breakpoint'**

Keyboard shortcut [F9]
**Function:** This command sets a breakpoint or clears an existing breakpoint.
**Call:** Main menu “Debug”.
**Requirement:** The application is in online mode. The cursor is positioned at a breakpoint.
See also
- Chapter 6.4.1.12.3 “Using Breakpoints” on page 1981

---

**Command 'Step Over’**

Symbol [F10]
**Function:** The command executes the statement where the program is currently located and halts before the next statement in the POU.
**Call:** Menu bar: “Debug”
**Requirement:** The application is in online mode and the program is halted at the current break position (debug mode).

If the executed statement contains a call (from a program, function block instance, function, method, or action), then the subordinate POU is processed completely in one step and returned to the call. Then it halts before the next statement (in the next line of code).
**Command 'Step Into'

Symbol ✨, shortcut [F11]

**Function:** The command executes the statement where the program is currently located and halts before the next statement.

**Call:** Menu bar: “Debug”

**Requirement:** The application is in online mode and the program is halted at the current break position (debug mode).

If the executed statement contains a call (from a program, function block instance, function, method, or action), then the program execution jumps to this subordinate POU. Its code opens in a separate editor. The first statement there is executed and the program execution halts before the next statement. The new current breakpoint position is then in the called POU.

**Command 'Step Over'

Symbol ✨, shortcut [Ctrl]+[F11]

**Function:** The command executes the program until the next return and halts afterwards.

**Call:** Menu bar: “Debug”

**Requirement:** The application is in online mode and the program is halted at the current break position (debug mode).

If the current breakpoint position is in a subordinate POU, then this is run through to the end. Then the program execution jumps back to the calling point in the calling POU and halts there (in the line with the call).

If the current breakpoint position is in the main program, then the POU is run through to the end. Then the program execution jumps back to the beginning (to the program start at the first line of code in the POU) and halts there.

**See also**

- Chapter 6.4.1.12.4 “Stepping Through a Program” on page 1985
- Chapter 6.4.1.21.3.8.10 “Command ‘Step Over’” on page 2646
Command 'Run to Cursor'

Symbol: 

**Function:** The command executes a program until a specified position as marked by the cursor.

**Call:** Menu bar: “Debug”

**Requirement:** The application is in online mode and the program is halted at the current break position (debug mode). Moreover, you have marked any line of code in any POU with the cursor.

The statements between the current breakpoint position and the cursor position are executed in one step. Then the execution halts at the cursor position, which then becomes the next breakpoint position. Remember that the line of code where you placed the cursor is reached but not executed.

See also
- Chapter 6.4.1.12.4 “Stepping Through a Program” on page 1985

Command 'Set Next Statement'

Symbol: ☰

**Function:** The command determines which statement is executed next.

**Call:** Menu bar: “Debug”

**Requirement:** The application is in online mode and the program is halted at the current break position (debug mode). Moreover, you have marked any line of code in any POU with the cursor.

The line of code marked with the cursor becomes the current breakpoint position without executing the statements in between or the statement that jumped to it.

See also
- Chapter 6.4.1.12.4 “Stepping Through a Program” on page 1985

Command 'Show Next Statement'

Symbol: 

**Function:** The command displays the program statement that is processed in the next step.

**Call:** Menu bar: “Debug”

**Requirement:** The application is in online mode and the program is halted at the current break position (debug mode). The break position is in a line of code that you cannot see.

The command makes the window with the current breakpoint position active (in the code highlighted in yellow and marked with the symbol) and makes the breakpoint position to become visible. This is useful if you have multiple editors open and the breakpoint position is hidden in an inactive editor.

See also
- Chapter 6.4.1.12.4 “Stepping Through a Program” on page 1985
Command 'Force Values'

Keyboard shortcut: [F7]

**Function:** The command sets a permanent predefined value to a variable on the controller.

**Call:** Menu bar: "Debug"

**Requirement:** The application is in online mode.

---

**CAUTION!**
Unusual changes to variable values in an application currently running on the controller can lead to undesired behavior of the controlled machinery. Evaluate possible dangers before forcing variable values. Take the respective safety precautions. Depending on the controlled machinery, the result may lead to damage to machinery and equipment or injury to health and life of personnel.

With this command, CODESYS permanently sets one or more variables of the active application to defined values on the PLC.

A forced value is marked with the forced symbol (\(\mathbf{F}\)).

For more information about the functionality of forcing and the p of values, see the "Forcing and Writing of Variables" help page.

By default, the “Force Values [All Applications]” command, which applies to all application in the project, and is not included in a menu.

---

See also

- § Chapter 6.4.1.12.5 “Forcing and Writing of Variables” on page 1987
- § Chapter 6.4.1.21.4.8 "Dialog Box 'Prepare Value'" on page 2749
- § Chapter 6.4.1.21.3.8.18 “Command ‘Unforce Values’” on page 2650

Command 'Write Values'

Keyboard shortcut [Ctrl]-[F7]

**Function:** This command sets a predefined value to a variable on the controller one time.

**Call:** Main menu "Debug".

**Requirement:** The application is in online mode.

---

**CAUTION!**
Unusual changes to variable values in an application currently running on the controller can lead to undesired behavior of the controlled machinery. Evaluate possible dangers before forcing variable values. Take the respective safety precautions. Depending on the controlled machinery, the result may lead to damage to machinery and equipment or injury to health and life of personnel.

With this command, one or more variables of the active application are set to defined values on the controller one time. Writing is done one time at the beginning of the next cycle.

Values are prepared by

- Clicking in the field “Prepared value” in the declaration section
- Clicking in the inline monitoring field in the implementation section
- Clicking in the field “Prepared value” in the watch window
The command “Write Values [All Applications]” affects all application in the project and is not included in a menu by default.

See also

- Chapter 6.4.1.21.3.8.16 “Command ‘Force Values’” on page 2649
- Chapter 6.4.1.12.5 “Forcing and Writing of Variables” on page 1987

Command 'Unforce Values'

Keyboard shortcut [Alt]+[F7]

Function: This command resets the forcing of all variables. The variables receive their current values from the PLC.

Call: “Debug”.

Requirement: The application is in online mode.

The “Remove Force List” command has the same functionality as this command with one difference. If the “Remove Force List” command cannot be executed for all forced values, then no message is displayed.

CAUTION!
Unusual changes to variable values in an application currently running on the PLC can lead to undesired behavior of the controlled machinery.

Evaluate possible dangers before forcing variable values. Take the respective safety precautions. Depending on the controlled system, the result may lead to damage to machinery and equipment or injury to health and life of personnel.

The command “Force Values [All Applications]” affects all application in the project and is not included in a menu by default.

See also

- Chapter 6.4.1.21.3.8.16 “Command ‘Force Values’” on page 2649
- Chapter 6.4.1.12.5 “Forcing and Writing of Variables” on page 1987

Command 'Force All Values from <Device.Application>’

Function: This command resets all values of variables from the selection <Device.Application> to predefined values permanently.

Call:
- Context menu of the application in the device tree
- Context menu in the editor of a POU from the selected application

Requirement: The application is in online mode.
With this command, CODESYS permanently sets one or more variables of the active application to defined values on the PLC. This is done at the beginning and end of a processing cycle. Order of processing: 1) read inputs, 2) force values, 3) process code, 4) force values, 5) write outputs.

You can prepare values as follows:
- Click in the "Prepared value" field in the declaration part and type in the value. For Boolean variables, you change the value by clicking the field.
- Click in the inline monitoring field in the implementation part of the FBD/LD/IL editor
- Click in the "Prepared value" field in the monitoring view and type in the value.

A forced value is marked with the forced symbol (ër).

CODESYS forces the value until you explicitly lift it by
- Clicking "Unforce Values"
- Clicking "Unforce All Values from <Device.Application>"
- Lifting the force in the "Prepare Value" dialog
- Logging out of the application

The command "Force Values [All Applications]" affects all application in the project and is not included in a menu by default.

See also
- § Chapter 6.4.1.21.4.8 “Dialog Box ‘Prepare Value’” on page 2749
- § Chapter 6.4.1.21.3.8.18 “Command ‘Unforce Values’” on page 2650
- § Chapter 6.4.1.12.5 “Forcing and Writing of Variables” on page 1987
- § Chapter 6.4.1.21.3.8.21 “Command ‘Unforce All Values from <Device.Application>’” on page 2652

Command 'Write All Values from <Device.Application>'

Function: This command resets all values of variables from the selection <Device.Application> to predefined values one time.

Call:
- Context menu of the application in the device tree
- Context menu in the editor of a POU from the selected application

Requirement: The application is in online mode.

CAUTION!
Unusual changes to variable values in an application currently running on the controller can lead to undesired behavior of the controlled machinery. Evaluate possible dangers before forcing variable values. Take the respective safety precautions. Depending on the controlled machinery, the result may lead to damage to machinery and equipment or injury to health and life of personnel.
With this command, one or more variables of the selected <Device.Application> are set to defined values on the PLC one time. Writing is done one time at the beginning of the next cycle.

You can prepare values as follows:

- Click in the "Prepared value" field in the declaration part and type in the value. For Boolean variables, you change the value by clicking the field.
- Click in the inline monitoring field in the implementation part of the FBD/LD/IL editor
- Click in the "Prepared value" field in the monitoring view and type in the value.

See also

- § Chapter 6.4.1.21.3.8.17 “Command 'Write Values'” on page 2649
- § Chapter 6.4.1.21.3.8.18 “Command 'Force All Values from <Device.Application>’” on page 2650
- § Chapter 6.4.1.12.5 “Forcing and Writing of Variables” on page 1987

Command 'Unforce All Values from <Device.Application>’

**Function:** This command resets the forcing of all values of the variables from the selected <Device.Application>. The variables receive their current values from the PLC.

**Call:**

- Context menu of the application in the device tree
- Context menu in the editor of a POU from the selected application

**Requirement:** The application is in online mode.

**CAUTION!**
Unusual changes to variable values in an application currently running on the controller can lead to undesired behavior of the controlled machinery.
Evaluate possible dangers before forcing variable values. Take the respective safety precautions. Depending on the controlled machinery, the result may lead to damage to machinery and equipment or injury to health and life of personnel.

See also

- § Chapter 6.4.1.21.3.8.19 “Command 'Force All Values from <Device.Application>’” on page 2650
- § Chapter 6.4.1.21.3.8.18 “Command 'Unforce Values’” on page 2650

Command 'Flow Control'

**Function:** This command activates and deactivates the flow control.

**Call:** Menu "Debug"

**Requirement:** The application is in online mode.

**NOTICE!**
An active flow control extends application runtime.
When "Confirmed Online Mode" is activated in the communication settings, a dialog prompt appears when switching on the flow control to cancel the process.
When flow control is activated, it is not possible to use breakpoints or step through the program.

See also

- § Chapter 6.4.1.12.7 “Flow Control” on page 1992
Menu 'Core Dump'

6.4.1.21.3.8.23.1  Command 'Load Core Dump'............................................. 2653
6.4.1.21.3.8.23.2  Command 'Create Core Dump'.......................................... 2653
6.4.1.21.3.8.23.3  Command 'Close Core Dump'............................................ 2654
6.4.1.21.3.8.23.4  Command 'Load Device Log from Core Dump'.................. 2654

Command 'Load Core Dump'

**Function:** CODESYS scans the project directory for core dump files. When a new core dump is forced with the "Create Core Dump" command, the dump file is automatically loaded from the controller to the project directory. If multiple core dump files are available, then CODESYS prompts you to choose whether the latest file should be opened in the project. You can also select one of the other files.

When a file is loaded into the project, an online view of the application appears with state of the application at the time when the core dump was generated. You can then view the variable values afterwards. Finally, the call tree is also available.

**Call:** Main menu “Debug ➔ Core Dump”.

**Requirement:** The application is in offline mode.

**NOTICE!**

You can close the core dump view only by clicking “Close Core Dump”. The “Logout” command has no effect in this view.

See also

- § Chapter 6.4.1.21.3.8.23.2 “Command ‘Create Core Dump’” on page 2653
- § Chapter 6.4.1.21.3.8.23.3 “Command ‘Close Core Dump’” on page 2654

Command 'Create Core Dump'

**Function:** This command causes CODESYS to check whether a core dump file is already available on the controller.

If a core dump file is available, then CODESYS prompts you to load this file to the project directory.

With the following requirements, CODESYS generates a new dump file with the current application data:

- A core dump file is still not available or CODESYS has rejected a core dump file from being loaded.
- The application is currently stopped at breakpoint or an exception has occurred.

The generated core dump file is saved directly to the project directory: <project name>.<device name>.<application name>.<application Guid>.core. You can cancel the file generation by clicking the button in the status bar.

The amount of detail in the dump depends on the support from the runtime system. Runtime systems that are appropriate for this purpose generate just one dump in the case of an exception error. The core dump output from clicking “Load Core Dump” can therefore be used for error analysis.

**Call:** Main menu “Debug ➔ Core Dump”.

**Requirement:** The application is in online mode.

See also

- § Chapter 6.4.1.21.3.8.23.1 “Command ‘Load Core Dump’” on page 2653
Command 'Close Core Dump'

**Function:** This command closes the core dump view of the application that is open in the project.

**Call:** Main menu “Debug ➔ Core Dump”.

**Requirement:** The application is in offline mode and you have loaded a core dump file to the project from the controller.

Command 'Load Device Log from Core Dump'

**Function:** This command imports the controller log list that was saved with the last generated core dump. The log list is displayed in the same view as in online mode in the “Log” tab of the device editor.

**Call:** Main menu “Debug ➔ Core Dump”.

**Requirement:** The application is in offline mode and a core dump is open in the project.

See also
- Chapter 6.4.1.21.2.8.9 “Tab ’Log’” on page 2437

Command 'Display Mode' - 'Binary', 'Decimal', 'Hexadecimal'

**Function:** These commands in the “Display Mode” submenu are used for setting the format of values in the display mode when monitoring in online mode.

**Call:** Main menu “Debug”.

**Requirement:** The project is in either online or offline mode.

![Info](The "Binary" and "Hexadecimal" display modes are unsigned, and "Decimal" is signed.)

See also
- Chapter 6.4.1.13.2.2 “Calling of monitoring in programming objects” on page 1996
Menu 'Tools'

6.4.1.21.3.9.1  Command 'IP-Configuration' .................................................... 2655
6.4.1.21.3.9.2  Command 'Install additional licence' ........................................ 2655
6.4.1.21.3.9.3  Command 'Migrate third party devices' ................................... 2655
6.4.1.21.3.9.4  Command 'Package Manager' ................................................ 2655
6.4.1.21.3.9.5  Command 'Library Repository' ................................................ 2657
6.4.1.21.3.9.6  Command 'License Manager' .................................................. 2659
6.4.1.21.3.9.7  Command 'License Repository' ............................................... 2662
6.4.1.21.3.9.8  Command 'Device Repository' ................................................ 2663
6.4.1.21.3.9.9  Command 'Create Device list CSV' ......................................... 2665
6.4.1.21.3.9.10 Command 'Multi Online Change' ........................................... 2665
6.4.1.21.3.9.11 Command 'Device ECAD data' .............................................. 2665
6.4.1.21.3.9.12 Command 'OPC UA Information Model Repository' ..................... 2665
6.4.1.21.3.9.13 Command 'Scripting' - 'Execute Script File' ............................. 2666
6.4.1.21.3.9.14 Command 'Scripting' - 'Enable Script Tracing' .......................... 2667
6.4.1.21.3.9.15 Command 'Scripting' - 'Scripts' ............................................. 2667
6.4.1.21.3.9.16 Command 'Customize' ........................................................... 2667
6.4.1.21.3.9.17 Command 'Options' ............................................................... 2667
6.4.1.21.3.9.18 Command 'Import and Export Options' .................................. 2668
6.4.1.21.3.9.19 Command 'Device Reader' .................................................... 2668

Command 'IP-Configuration'

Function: Scan the project for IP address, device ID and other informations.

Call: Main menu “Tools”, Context menu

Requirement: -

☞ Chapter 6.3.2.9.2 “Configuration of the IP settings with the IP configuration tool” on page 1506

Command 'Install additional licence'

Function: Installs additional engineering license.

Call: Main menu “Tools”, Context menu

Requirement: -

Command 'Migrate third party devices'

Function: After a selection of a previous version profile, all the third party devices which have been installed inside this version profile are listed and can be migrated.

Call: Main menu “Tools”, Context menu

Requirement: -

☞ Chapter 6.3.1.5 “Migration of third party devices” on page 1439

Command 'Package Manager'

Symbol: 🗂

Function: The command opens the “Package Manager” dialog where you install, uninstall, and manage packages.
You can also call the Package Manager as a standalone application from the command line.

Table 497: “Currently Installed Packages”

<table>
<thead>
<tr>
<th>“Refresh”</th>
<th>Refreshes the list</th>
</tr>
</thead>
</table>
| “Install”       | Opens the standard dialog for finding a file in the file system. By default, the file type is *.package. You can also install two versions of a package. After you select the package, the “Check package signatures” dialog opens.  
  ● In the dialog, the package is displayed with the information about signing. Detailed information about signing is displayed in the tooltip and also in a dialog which opens when you double-click a package.  
  ● “Allow unsigned and self-signed packages”: The package should be installed although it is unsigned or self-signed. After the package is selected, the installation wizard opens with the dialogs:  
    ● “Installation - License Agreement”: In this dialog, CODESYS also displays the “Checksum” of the package. Displayed only when the package has a license agreement.  
    ● “Choose Setup Type”  
      The options are package-dependent.  
      – “Complete setup”: CODESYS installs all components  
      – “Typical setup”: CODESYS installs a standard set of components as defined in the package  
      – “Custom setup”: CODESYS installs those components which are selected in a dialog  
    ● “Installation - Target Versions”: You select which of the existing target versions should be updated by the package installation. You have to select at least one version profile. When this dialog is successfully completed, the selected package is ready for installation. You have to close all CODESYS instances in order for the package installation to be automatically started and run. |
| “Uninstall”   | Uninstalls the selected package  
  ● When the “Display versions” option is not selected, CODESYS uninstalls all versions of the selected package.  
  ● When the “Display versions” option is selected and you have selected a package node on the top level, CODESYS uninstalls all versions of the selected package.  
  ● When the “Display versions” option is selected and you have selected an individual package version, CODESYS uninstalls exactly this version. When this dialog is closed, all CODESYS instances have to be closed in order for the package uninstallation to start. |
**“Details”**

Opens the “Details” dialog for the selected package with the following tabs:
- **“Package Details”**
  - **“Name”**: Package name
  - **“Version”**
  - **“Checksum”**: SHA-1 checksum of the package
  - **“Vendor”**
  - **“Copyright”**
  - **“Description”**
  - **“Installation date”**
- **“License Agreement”**
- **“Installations Log”**

**“Search updates in background”**

☑: CODESYS automatically searches for updates every time the programming system is started and then one time every hour.

**“Display versions”**

☑: Displays all versions of the installed package.

---

You can compare the “Checksum” with the package checksum from the package vendor. CODESYS displays this checksum in the “Details” dialog and in the “Installation - License Agreement” dialog of the installation wizard. You do this to make sure that you have installed an original package.

---

If you have installed a newer version of the programming system in the same installation directory as the previous version, the license information about the previously installed package remains unchanged and CODESYS displays the information in the “Package Manager” dialog.

---

### Table 498: “Updates”

<table>
<thead>
<tr>
<th>“Search Updates”</th>
<th>Searches for the selected package on your system and in the CODESYS Store Updates. CODESYS displays the found updates in the “Update Info” column of the package list.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Download”</td>
<td>Installs the update package from the “Download Package” dialog. In the “Download Package” dialog, click the “Download and Installation” button for this.</td>
</tr>
</tbody>
</table>

### Table 499: “CODESYS Store”

<table>
<thead>
<tr>
<th>“Rating”</th>
<th>Give an rating of the package</th>
</tr>
</thead>
<tbody>
<tr>
<td>“CODESYS Store”</td>
<td>Link to the homepage of the Store</td>
</tr>
</tbody>
</table>

---

**Command 'Library Repository'**

**Symbol:** 📖

**Function:** The command opens the “Library Repository” dialog. In this dialog you define which libraries are installed on the local system and are thus available for your application.

**Call:** Menu bar: “Tools”
Table 500: “Location”
Display of the directory on the local system in which the library files are located. The libraries in this “Location” are listed in the “Installed libraries” area.

<table>
<thead>
<tr>
<th>“Edit Locations”</th>
<th>Opens the “Edit Repository Locations” dialog.</th>
</tr>
</thead>
</table>

- You can only use empty directories for new repositories.
- You can also use existing repositories as locations.
- The “System” repository is not editable; CODESYS indicates this by the italic lettering of the entry.

Table 501: Dialog “Edit Repository Locations”
List of the repositories with “Location” and “Name”

<table>
<thead>
<tr>
<th>“Add”</th>
<th>Creates a new repository. Opens the “Repository Location” dialog. The selected directory (“Location” input field) has to be either empty or an existing valid repository. “Name” is the input field for a symbolic repository name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Edit”</td>
<td>Opens the “Repository Location” dialog (see “Add”)</td>
</tr>
<tr>
<td>“Remove”</td>
<td>A dialog box open, asking whether only the entry should be removed from the list of repositories, or whether the directory with the library files should be deleted from the file system. If you want to delete the directory, you have to confirm this.</td>
</tr>
</tbody>
</table>

Table 502: “Installed libraries”
List of the libraries in a tree structure. Display of each library with category, name, company and version. The icon to the left of the name indicates whether the library is digitally signed or unsigned.

<table>
<thead>
<tr>
<th>“Company”</th>
<th>List box for filtering the displayed libraries.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Install”</td>
<td>Opens the “Select Library” dialog. Possible filters:</td>
</tr>
<tr>
<td></td>
<td>“Compiled CODESYS library files (*.compiled-library)”.</td>
</tr>
<tr>
<td></td>
<td>“Compiled CODESYS library files (*.compiled-library-v3)” ab V3 SP15</td>
</tr>
<tr>
<td></td>
<td>“Library files (*.library)” for still uncompiled library projects</td>
</tr>
<tr>
<td></td>
<td>“All files (<em>.</em>)”</td>
</tr>
<tr>
<td>“Uninstall”</td>
<td>Uninstalls the selected library.</td>
</tr>
<tr>
<td>“Export”</td>
<td>Opens the default dialog for saving the library project to the local file system. The file type is Library files (<em>.library), Compiled library files (</em>.compiled-library), or Compiled library files (*.compiled-library-v3).</td>
</tr>
<tr>
<td>“Find”</td>
<td>Searches for libraries and function blocks. Opens the “Find Library” dialog. When you enter a string in the input field, CODESYS displays the libraries that it finds with a corresponding string.</td>
</tr>
<tr>
<td>“Details”</td>
<td>Opens the “Details” dialog with details from the project information of the library for the selected version of a library. You find the following information by clicking “More” in the “Details” dialog:</td>
</tr>
<tr>
<td></td>
<td>“Size”: Specified in bytes</td>
</tr>
<tr>
<td></td>
<td>“Created”: Creation date</td>
</tr>
<tr>
<td></td>
<td>“Changed”: Date of the last change</td>
</tr>
<tr>
<td></td>
<td>“Last access”: Date</td>
</tr>
<tr>
<td></td>
<td>“Attributes”</td>
</tr>
<tr>
<td></td>
<td>“Properties”</td>
</tr>
</tbody>
</table>
“Dependencies”  
For the selected library, the “Dependencies” dialog opens, showing the dependencies on other libraries. “Title”, “Version” and “Company” are shown for each library reference. References that function via placeholders are displayed according to the syntax: #<placeholder name>.

“Group by category”  
- ✔ Grouping by library category
- □ Alphabetical sorting

The categories are defined by external description files *.libcat.xml*.

Table 503: “Library Profiles”  
A library profile defines the library version with which CODESYS resolves a library placeholder if a certain compiler version is set in the project.

“Import”  
Imports a *.libraryprofile file.

If the import already contains existing placeholder entries, a query appears asking whether CODESYS should overwrite it.

“Export”  
Exports an xml file with the extension *.libraryprofile with the assignments of the selected placeholder entries; you can only select a single entry of a “Compiler version”.

Placeholder resolutions can also be defined in the target device currently in use and even by a specific local specification in the Placeholders dialog in the Library Manager.

See also
- ☀ Chapter 6.4.1.17.3 “Information for Library Developers” on page 2035
- ☀ Chapter 6.4.1.21.2.24 “Object ‘Project Information’” on page 2515
- ☀ Chapter 6.4.1.21.2.16 “Object ‘Library Manager’” on page 2469
- ☀ Chapter 6.4.1.21.4.3 “Dialog ‘Library Reference Conversion’” on page 2746
- ☀ Chapter 6.4.1.17.6 “Exporting library files” on page 2037

Command ‘License Manager’

Symbol: ✚

Function: This command opens the wizard for configuring licenses for CODESYS add-on products. The wizard starts with the “License Manager - Select target” dialog.

Call: Menu bar: “Tools”.

The License Manager can handle licenses for CODESYS add-on products on the local computer, as well as licenses for RTS add-on products on devices. It supports both the installation in a soft container and on a dongle.

Dialog ‘License Manager - Select Target’

This is the start dialog of the License Manager wizard. Here you decide where the license will be installed.

“Workstation”  
Local computer

“Device”  
Controller. The connection to this device must be configured correctly in order to license (“Communication Settings” tab of the device editor).

After clicking “Next”, you decide the container where you want to manage the licenses.
**Dialog 'License Manager - Select container'**

<table>
<thead>
<tr>
<th>“Dongle”</th>
<th>A corresponding dongle must be connected to the computer or device. Not all devices support dongles.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Soft container”</td>
<td>CODESYS Security Key. A corresponding soft container must be registered in the CodeMeter Control Center. The CODESYS installation provides an existing soft container.</td>
</tr>
</tbody>
</table>

If you are installing a product on your local computer ("Workstation"), then the “License Manager” opens immediately for the specific selection of the dongle or soft container, and the next actions. This happens after you choose the container type and click “Next >”.

If you are licensing the add-on product for a controller, then first the dialog opens for selecting the device in the network after you click “Next >”. This dialog corresponds to the classic view of the “Communication Settings” tab of the device editor.

**Dialog 'License Manager'**

<table>
<thead>
<tr>
<th>“Container”</th>
<th>Depending on whether “Dongle” or “Soft container” was selected: Drop-down list of all CODESYS dongles or soft containers that were found on the computer or device.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Products”</td>
<td>List of all installed products that are subject to licensing. A prepended symbol indicates the existence and validity of the license. On the right side of the window, the following information is displayed for the selected product and corresponding licenses: “Name”, “Company”, “Unit counter”, “License quantity”, “Usage period”, “Feature map”, “Activation time”, “Expiration time”, “Firm code”, “Product code”, “Description”</td>
</tr>
</tbody>
</table>

**“Install Licenses”** Opens the dialog “Install licenses on <computer> - Select Operation”:
- “Activate license”: Opens the dialog “Install licenses on <computer> - Activate License” (see more below)
- “Request license”: Opens the dialog “Install licenses on <computer> - Request License” (see more below)
- “Install license”: Opens the dialog “Install licenses on <computer> - Install License” (see more below)

**“Additional Functions”** Opens the menu with the following actions:
- “Return license”: Opens the “Return Licenses” (see more below)
- “Restore license”: This function is available in the case of device licensing only. Opens the “Restore Licenses” dialog (see more below)
Table 504: “Install Licenses on <computer> - Activate License”

This is the recommended way to activate a license available via the License Server when you have an Internet connection. Requirement: The computer has an Internet connection.

| “Ticket ID” | Input field for the ticket ID that you received from the software vendor. The ticket ID consists of five sets of five alphanumerical characters (for example: LYSQ3-ZU93K-24LWC-XGWJ8-5AY7H). |
| “License server” | Drop-down list of the license server that provides the license for activating the product. You receive the server URL from the software vendor. |
| “Select Ticket from Repository” | Opens the “License Repository” dialog. |
| “Next” | CODESYS connects to the license server. ● If the specified ticket contains only one license, then a dialog opens to confirm the successful activation after completion of the server action. ● If the specified ticket contains multiple licenses, then the dialog “Install licenses - Select Licenses” opens with a list of these licenses (see description below). |

Table 505: “Install Licenses - Select Licenses”

Selection of the licenses to be activated for the ticket which you specified in the dialog “Install Licenses - Activate License”.

| “Name” | Product name |
| “Available” | Number of available licenses |
| “Used” | Number of used licenses |
| Total | Sum of all used and available licenses |

Next

CODESYS connects to the license server. After successful completion of the server action, a dialog opens with the confirmation of the activation.

Table 506: “Install Licenses on <computer> - Request License”

If the computer does not have an Internet connection, then you can generate a context file from this dialog. The file “WibuCmRaC” is then transmitted to the license server via an Internet-enabled computer. When activation is complete, a license update file “WibuCmRaU” is provided for download.

| “Software vendor” | Input field for firm codes from the software vendor that provided the license for activating the product. As an alternative, you can select the software vendor from the drop-down list. |
| “Context file” | Location and name |

Table 507: “Install Licenses on <computer> - Install License”

If you downloaded a license update file from the Internet during software activation, then you can use this dialog to install the license on your dongle. To do this, specify the path of the license update file in the input field.

Table 508: “Return License”

If the license permits, you can return it in order to reactivate it later on another computer.

| “Ticket ID” | Field for specifying the ticket ID that was used for licensing. |
| “License server” | Drop-down list for selecting the license server that provides the license for activating the product. You receive the server URL from the software vendor. |
| “Load License(s)” | Button for showing all current licenses installed for the given ticket ID on the server in the “Licenses” window. |
“Licenses” | List of licenses available on the server for the given ticket ID. The following information for the selected license is displayed next to the window on the right:
- “Name”
- “Number of activations”
- “Return allowed”
- “Activation type”
- “Activation date”
- “Firm code”
- “Comment”

“Return License(s)” | Button for returning the selected license(s). These can be reactivated later on another system.

<table>
<thead>
<tr>
<th>Table 509: “Install Licenses - Restore Licenses”</th>
</tr>
</thead>
<tbody>
<tr>
<td>When activated, device licenses are saved to a file (*.WibuCmRau) on the local computer and in the &quot;CODESYS Central License Server&quot;. If lost, they can be restored from this file to the identical device.</td>
</tr>
<tr>
<td>“Ticket ID”</td>
</tr>
<tr>
<td>“Restore”</td>
</tr>
</tbody>
</table>

See also
- ☞ Chapter 6.4.1.21.2.8.3 “Tab ‘Communication Settings’” on page 2427
- ☞ Chapter 6.4.1.21.3.9.7 “Command ‘License Repository’” on page 2662

**Command ‘License Repository’**

Symbol: ☞

**Function:** This command opens the dialog box “License Repository” for viewing information about the individual licenses.

**Call:** Main menu “Tools”

**Requirements:** CODESYS is in offline or online mode.

In the license repository, after entering the ticket number, you can obtain information about the licenses concerned from the central license server.

To do this you can paste the ticket number(s) from the clipboard or import it/them from a text file.
Table 510: “Tickets”

<table>
<thead>
<tr>
<th>“Licenses”</th>
<th>If you select an entry in the list of tickets, the name and the status of the licensed component are displayed here.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>☑: License available and valid</td>
</tr>
<tr>
<td></td>
<td>☰: License found, but invalid</td>
</tr>
<tr>
<td></td>
<td>☢: License not found</td>
</tr>
<tr>
<td></td>
<td>In the right-hand part of the dialog box you will then receive then the following information about this license:</td>
</tr>
</tbody>
</table>

| “Name”: name of the product to be licensed      |                                                                                                             |
| “Item number”: item number in the license server. |                                                                                                             |
| “Return allowed”: It is possible to have this license deactivated so that it can be re-activated on another system. |                                                                                                             |
| “Can be activated”: you can have the license activated via the license manager. |                                                                                                             |
| “Activation quantity”: number of activations that have taken place so far. |                                                                                                             |
| “Activation date”: date of the current activation |                                                                                                             |
| “Container serial ” |                                                                                                             |
| “Firm codes” |                                                                                                             |
| “Comment” |                                                                                                             |

| “Import Tickets” | The standard dialog box for browsing the local file system appears. If you open a text file containing one or more “tickets”, i.e. license numbers, these are imported into the repository. Alternatively you can also insert the numbers from the clipboard into the list. |

Command ‘Device Repository’

Symbol: ❰

Function: This command opens the “Device Repository” dialog. This dialog is used for managing the devices that are installed on the local system and can be integrated into CODESYS projects.

Call: Menu bar: “Tools”.

Dialog ‘Device Repository’

CAUTION!

Do not change the internal device repository manually. Do not copy any files to or from the repository. Always use the device repository dialog to install or uninstall devices.
### Table 511

<table>
<thead>
<tr>
<th>“Location”</th>
<th>Shows the device repository directory on the local system. The list box shows the currently set save locations. By default, CODESYS creates the system repository during installation. The devices of the selected location are listed in the “Installed device descriptions” field.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Edit Locations”</td>
<td>Opens the “Edit Repository Locations” dialog.</td>
</tr>
</tbody>
</table>

### Table 512: Dialog ‘Edit Repository Locations’

| “Add” | Creates a new repository. Opens the “Repository Location” dialog. The selected directory (“Location” input field) must be empty or it must be a valid repository. |
| “Edit” | Opens the “Repository Location” dialog (see “Add”). |
| “Remove” | A dialog prompt opens for you to decide whether the respective directory should also be deleted from the hard disk. |

### Table 513: “Installed Device Descriptions”

| “String for full-text search in all devices” | This field is editable after clicking in it. For any character string entered, only those devices that include the character string are displayed in the lower view. The matched string is highlighted in yellow for these devices. |
| “Vendor” | Drop-down list with manufacturers whose available devices are displayed. |
| “Install” | Opens the “Install Device Description” dialog. For the default devices with file type "*.devdesc.xml". You can also select manufacturer-specific description files, such as "*.gsd" files for PROFIBUS DP modules, "*.eds" and "*.dcf" files for CAN devices. When you click “OK” to confirm the selection, CODESYS inserts the new device into the device repository. If an error occurs during installation (for example, missing files that are referenced by the device description), then CODESYS reports the error to the lower part of the device repository dialog. |
| “Uninstall” | Removes the selected device. If you delete the device from the device repository, then it is no longer available for use in the programming system. |
| “Renew Device Repository” | Updates all devices in the device repository. When new versions of import plug-ins are available, some device descriptions may be outdated. The affected devices are marked with a warning symbol (⚠️). This command opens a dialog to confirm the update. |
| “Download Missing Device Descriptions” | Opens when you use devices in your project that are not available in the device repository. When you execute this command, a list of missing devices is displayed. There you can select the corresponding devices for download. |
| “Details” | Opens the “Details” dialog for the selected device description. This dialog provides additional information from the device description file. |
NOTICE!
During installation, CODESYS copies the device description files and all additional reference files to an internal location. Therefore, any changes to the original files no longer influence the installed devices. You must reinstall the devices to make any changes effective. We recommended that you change the internal version number of a device description after a modification.

See also
- Chapter 6.4.1.18.2 “Installing devices” on page 2038
- Chapter 6.4.1.21.4.14.6 “Dialog ‘Options’ – ‘Device Description Download’” on page 2785

Command 'Create Device list CSV'
Symbol:
Function: MS Excel template of device list for device import is opened.
Call: Main menu “Tools”, Context menu
Requirement: -
See Chapter 6.6.1.3.3 “Creating CSV device list” on page 4198

Command 'Multi Online Change'
Function: The MultiOnlineChange tool/plug-in for Automation Builder enables firmware update, download and online change of the same project to several AC500 V2 PLCs.
Call: Main menu “Tools”, Context menu
Requirement: -

Command 'Device ECAD data'
Function: Automation Builder provides an ECAD interface for exchanging the PLC configuration data with EPLAN Electric P8 and Zuken E3. This feature removes double data entry between electrical engineering in the ECAD tool and the control logic programming in Automation Builder by synchronizing the PLC hardware including topology and I/O signals between these tools.
Call: Main menu “Tools”, Context menu
Requirement: A project is open.
See Chapter 6.6.1.1 “Exporting and importing ECAD data (PBF)” on page 4191

Command 'OPC UA Information Model Repository'
Function: The command opens the “OPC UA Information Model” dialog. The OPC UA information models, which are installed on the local system and can be integrated in CODESYS projects, are managed in the dialog.
Call: Menu bar: “Tools”
| “Location” | Displays the OPC UA information model directories on the local system. The list box shows the currently set locations. By default, CODESYS creates the system repository during installation. The information models of the selected location are listed in the “Installed OPC UA information models” area. |
| “Edit Locations” | Opens the “Edit Repository Locations” dialog. |
| “Installed OPC UA information models” | List of installed information models. Double-click to open installed information model documentation. Note: The information models of this repository can also be added to project archives. |
| “Install” | Opens the “Select Installed OPC UA Information Model(s)” dialog. |
| ● File type: OPC UA Information Models *NodeSet2.xml (example: “Informationmodel.NodeSet2.xml”. When you click “Open”, the selected information model is inserted in the repository. |
| ● File type: All files *.*: You can select an OPC UA documentation, for example, in PDF or Word format. When you click “Open”, the “Assign Documentation OPC UA Information Models” opens. For a description of the dialog, see below. |
| “Uninstall” | Uninstalls the selected OPC UA information model. When you delete the information model from the repository, it is no longer available in the development system for use in the CODESYS Development System. |
| “Details” | Opens the “Details” dialog for the selected information model. The dialog includes additional information about the information model. In “Alias”, you can specify an alias name for the URI. Moreover, information is displayed as to whether or not a documentation for the information model is available. |
| ● “Model URI” |
| ● “Publication date” |
| ● “Publisher” |
| ● “Repository” |
| ● “Alias” |
| ● “Documentation available”: |
| – “Yes”: The “Uninstall documentation” button is available. |
| – “No”: The “Install documentation” button is available. |
| ● “Install documentation”: Opens the “Select OPC UA Information Model Documentation” dialog. The data type OPC UA Information Model Documentation (*.pdf) is set as default in the dialog. |
| “Documentation” | Opens the installed documentation for the selected information model. If no documentation is installed for the selected information model, then the command is disabled. |
| “Display all versions” | All installed versions of the information model are displayed in a tree structure. |

See also

- Chapter 6.4.1.21.2.17 “Object ‘OPC UA Information Model’” on page 2472

Command 'Scripting' - 'Execute Script File'

Symbol: ☑

Function: This command opens a dialog for selecting and then executing the script file (*.py).

Call: Menu bar: “Tools ➔ Scripting”.

2666
Command 'Scripting' - 'Enable Script Tracing'

Symbol: 📚

**Function**: This command makes CODESYS print all commands from the script file to the message view. Use this command for monitoring and debugging scripts. A blue frame around the symbol indicates that the option is active.

**Call**: Main menu “Tools ➔ Scripting”.

Command 'Scripting' - 'Scripts'

**Function**: This command executes a script that is stored in the ScriptDir folder.

**Call**: Menu bar: “Tools ➔ Scripting ➔ Scripts”.

**Requirement**: The ScriptDir folder exists in the CODESYS installation directory. Python scripts are stored in this folder with the file extension .py.

All scripts that are contained in the ScriptDir folder are executable as menu commands and are sorted alphabetically by file name.

Command 'Customize'

**Function**: This command opens the “Customize” dialog box, where you can customize the menus, toolbars, and keyboard shortcuts according to your individual requirements.

**Call**: Main menu “Tools”

Command 'Options'

**Function**: The command opens the dialog box “Options” for the configuration of the CODESYS options. These options define the behavior and appearance of the CODESYS user interface. CODESYS saves the settings in your current user profile on your local system. The current profile specifies the standard settings.

**Call**: “Tools” menu

See also

- Chapter 6.4.1.21.4.23 “Dialog ‘Options’ - ‘SFC Editor’” on page 2795
- Chapter 6.4.1.21.4.14.4 “Dialog ‘Options’ - ‘CFC Editor’” on page 2784
- Chapter 6.4.1.21.4.14.5 “Dialog ‘Options’ – ‘Declaration Editor’” on page 2785
- Chapter 6.4.1.21.4.14.7 “Dialog ‘Options’ - ‘Device Editor’” on page 2786
- Chapter 6.4.1.21.4.14.6 “Dialog ‘Options’ – ‘Device Description Download’” on page 2785
- Chapter 6.4.1.21.4.14.10 “Dialog ‘Options’ - ‘FBD, LD, and IL’” on page 2787
- Chapter 6.4.1.21.4.14.20 “Dialog ‘Options’ - ‘PLCopenXML’” on page 2793
- Chapter 6.4.1.21.4.14.21 “Dialog ‘Options’ - ‘Proxy Settings’” on page 2793
- Chapter 6.4.1.21.4.14.22 “Dialog ‘Options’ - ‘Refactoring’” on page 2794
- Chapter 6.4.1.21.4.14.24 “Dialog ‘Options’ - ‘SmartCoding’” on page 2796
- Chapter 6.4.1.21.4.14.26 “Dialog ‘Options’ - ‘Text Editor’” on page 2798
Command 'Import and Export Options'

**Function:** This command opens the "Import and Export Options" dialog. Here you can configure the export and import of selected settings of the CODESYS options. The settings are saved to an XML file with the default extension (options.xml).

**Call:** Menu bar: “Tools”.

**Dialog 'Import and Export Options'**

| "Export selected options" | "Select options": In the table, you can select the categories of options, either user-specific or machine-specific (computer), whose current settings are to be exported to the XML file.  
"File": Path of the export file in the local file system. Example: D:\system1.options.xml.  
Button [ ]: Opens the default dialog to search for an existing file in the local file system, or to create one. The "File type" option export (*.options.xml) is preset. |
| "Import selected options" | "File": Path of the options export file whose contents are to be imported.  
Button [ ]: Opens the default dialog to search for an existing file of type option export (*.options.xml) in the local file system.  
After you click “OK” to close the dialog, the settings described in the file are applied to the project. |

See also

- Chapter 6.4.1.2.1.1 “Setting CODESYS options” on page 1802

Command 'Device Reader'

**Function:** The command opens the standard “Select Device” dialog and reads the license and product information of the selected controller. This license and product information is displayed in the “Device Reader” dialog.

**Call:** Menu bar: “Tools”

**Requirement:** No applications exist on the controller.

> If the command is selected although an application exists on the controller, then a dialog prompts the user whether or not all applications should be removed from the controller. When the user click “No” to this dialog, the “Device Reader” command is aborted.

**Table 515: Dialog “Device Reader”**

| "Status of Available Device Features" | "Product" |
| "Feature" |
| "License Active/Count" |

| "Product" | CODESYS product (example: SoftMotion) |
| "Feature" | Feature of “Product”  
Example: CNC is a “Feature” of SoftMotion. |
| "License Active/Count" | Yes: A license exists for the feature.  
No: A license does not exist for the feature.  
"Count": Number of licenses |
Menu 'Window'  

6.4.1.21.3.10.1 Command 'Next Editor' .......................................................... 2669
6.4.1.21.3.10.2 Command 'Previous Editor' ................................................... 2669
6.4.1.21.3.10.3 Command 'Close All Editors'............................................... 2669
6.4.1.21.3.10.4 Command 'Close All Editors of Inactive Applications'............. 2670
6.4.1.21.3.10.5 Command 'Reset Window Layout'.......................................... 2670
6.4.1.21.3.10.6 Command 'New Horizontal Tab Group'.................................... 2670
6.4.1.21.3.10.7 Command 'New Vertical Tab Group'....................................... 2670
6.4.1.21.3.10.8 Command 'Float' .................................................................. 2671
6.4.1.21.3.10.9 Command 'Dock' .................................................................. 2671
6.4.1.21.3.10.10 Command 'Auto Hide'.......................................................... 2671
6.4.1.21.3.10.11 Command 'Next Pane'.......................................................... 2671
6.4.1.21.3.10.12 Command 'Previous Pane'................................................... 2671
6.4.1.21.3.10.13 Command 'Toggle First Pane'............................................... 2672
6.4.1.21.3.10.14 Command 'Toggle Second Pane'............................................ 2672
6.4.1.21.3.10.15 Command 'Windows'............................................................. 2672
6.4.1.21.3.10.16 Command 'Close All Editors But This'.................................... 2673
6.4.1.21.3.10.17 Command 'Select Object in Navigator'.................................... 2673
6.4.1.21.3.10.18 Command 'Select Parent Object in Navigator'....................... 2673
6.4.1.21.3.10.19 Commands of the Submenu 'Window' ...................................... 2673

Command 'Next Editor'

Keyboard shortcut: [Ctrl]+[F6]

Function: This command switches focus from the currently active view to the next view. The next view is identified by the tab to the right of the currently active tab.

Call: Main menu “Window”

Requirement: At least one object is open.

See also
• ¤ Chapter 6.4.1.21.3.10.2 “Command 'Previous Editor'” on page 2669

Command 'Previous Editor'

Keyboard shortcut: [Shift]+[Ctrl]+[F6]

Function: This command switches focus from the currently active view to the previous view. The previous view is identified by the tab to the left of the currently active tab.

Call: Main menu “Window”

Requirement: At least one object is open.

See also
• ¤ Chapter 6.4.1.21.3.10.1 “Command 'Next Editor'” on page 2669

Command 'Close All Editors'

Symbol: 🟦

Function: This command closes all currently open editor views.

Call: Main menu “Window”

Requirement: At least one editor is open.
Command 'Close All Editors of Inactive Applications'

**Function:** This command closes all editor views for objects that are located directly below a currently inactive application. Object editors in the POU view remain open.

**Call:** Main menu “Window”

**Requirement:** At least one object of an inactive application is open.

See also
- Chapter 6.4.1.21.3.10.3 “Command ‘Close All Editors’” on page 2669
- Chapter 6.4.1.21.3.10.16 “Command ‘Close All Editors But This’” on page 2673

Command 'Reset Window Layout'

**Function:** This command resets all currently open windows and views to their default positions. You are prompted for a confirmation before the command is executed.

**Call:** Main menu “Tools”

Command 'New Horizontal Tab Group'

**Symbol:** 📖

**Function:** This command moves the currently active view to a new, separate tab group below the existing one.

**Call:** Main menu “Window” or context menu of the tab

**Requirement:** Several editor views are open as tabs next to each other.

If you open another object in the editor, then this is automatically included in the tab group that is currently in focus.

See also
- Chapter 6.4.1.21.3.10.7 “Command ‘New Vertical Tab Group’” on page 2670

Command 'New Vertical Tab Group'

**Symbol:** ✉️

**Function:** This command moves the currently active view to a new, separate tab group to the right of the existing one.

**Call:** Main menu “Window” or context menu of the tab

**Requirement:** Several editor views are open as tabs next to each other.

If you open another object in the editor, then this is automatically included in the tab group that is currently in focus.

See also
- Chapter 6.4.1.21.3.10.6 “Command ‘New Horizontal Tab Group’” on page 2670
Command 'Float'

**Function:** This command releases a docked view from its frame in the user interface and repositions it on the screen as a floating window.

**Call:** Main menu “Window”

**Requirement:** The application is in online mode.

This window can then be positioned outside of the user interface. Use the “Dock” command to return a floating window to the frame of the user interface.

See also
- “Chapter 6.4.1.21.3.10.9 “Command 'Dock'” on page 2671

Command 'Dock'

**Function:** This command returns a floating window, which was released by the “Float” command, to the frame of the user interface.

**Call:** Main menu “Window”

See also
- “Chapter 6.4.1.21.3.10.8 “Command 'Float'” on page 2671

Command 'Auto Hide'

Keyboard shortcut: [F7]

**Function:** This command shows or hides a view.

**Call:** Main menu “Window”

Hide simply means that CODESYS minimizes the view to a tab at the bottom of the user interface which is visible only when you move the mouse over the tab. The command functions like a check box. When a window is hidden, the check box is selected in the menu. When you click the command again, the checkbox is cleared and the window is shown.

Command 'Next Pane'

Keyboard shortcut: [F6]

**Function:** This command sets the focus on the next pane.

**Call:** Main menu “Window”

**Requirement:** An object is open that contains two or more panes.

Example: If an object is open in the ST editor and the cursor is currently in the declaration section, then command sets the focus to implementation section.

See also
- “Chapter 6.4.1.21.3.10.12 “Command 'Previous Pane'” on page 2671

Command 'Previous Pane'

Keyboard shortcut: [Shift]+[F6]

**Function:** This command sets the focus on the previous pane.

**Call:** Main menu “Window”

**Requirement:** An object is open that contains two or more panes.
Example: If an object is open in the ST editor and the cursor is currently in the declaration section, then command sets the focus to implementation section.

See also
- § Chapter 6.4.1.21.3.10.11 “Command 'Next Pane'” on page 2671

**Command 'Toggle First Pane'**

Keyboard shortcut [Alt]+[F6]

**Function:** This command shows and hides the declaration view.

**Call:** “Window”.

**Requirement:** The cursor is positioned in the editor of one of the following objects:
- POU
- Transition
- Method
- Get accessor method of a property
- Set accessor method of a property
- Visualization

You can also toggle the subviews by means of the buttons.

See also
- § Chapter 6.4.1.21.3.10.14 “Command 'Toggle Second Pane'” on page 2672

**Command 'Toggle Second Pane'**

**Function:** This command shows and hides the implementation view.

**Call:** “Window”.

**Requirement:** The cursor is positioned in the editor of one of the following objects:
- POU
- Transition
- Method
- Get accessor method of a property
- Set accessor method of a property
- visualization

You can also toggle the subviews by means of the buttons.

See also
- § Chapter 6.4.1.21.3.10.13 “Command 'Toggle First Pane'” on page 2672

**Command 'Windows'**

**Function:** This command opens the “Windows” dialog box, which lists all open objects. You can then activate or close any of the listed views.
Call: Main menu “Window”

Command 'Close All Editors But This'
Function: This command closes all editor views except the currently open one.
Call: Right-click the tab
Requirement: At least two objects are open.
See also
- Chapter 6.4.1.21.3.10.3 “Command 'Close All Editors’” on page 2669
- Chapter 6.4.1.21.3.10.4 “Command 'Close All Editors of Inactive Applications’” on page 2670

Command 'Select Object in Navigator'
Function: This command selects the object of the active editor in the device tree.
Call: Right-click the tab
Requirement: At least one object is open.
This command is executed automatically when you select the “Track active editor” option for the device tree.
See also
- Chapter 6.4.1.21.3.10.18 “Command 'Select Parent Object in Navigator’” on page 2673

Command 'Select Parent Object in Navigator'
Function: This command selects the parent object in the device tree.
Call: Right-click the tab
Requirement: At least one object is open.
See also
- Chapter 6.4.1.21.3.10.17 “Command 'Select Object in Navigator’” on page 2673

Commands of the Submenu 'Window'
Function: The command activates the selected window.
Call: Main menu “Window”
For each opened editor window the menu “Window” contains a command “<n><object name>”. Choosing this command activates the corresponding window. In offline mode CODESYS adds the extension “(Offline)”. To differentiate between the implementation or the instances of a function block the extension “(Impl)” or “<instance path>” is added.
Menu 'Help'

6.4.1.21.3.11.1 Command 'Contents'............................................................. 2674
6.4.1.21.3.11.2 Command 'Index'................................................................... 2674
6.4.1.21.3.11.3 Command 'Find'..................................................................... 2674
6.4.1.21.3.11.4 Command 'About'.................................................................. 2675

Command 'Contents'

Symbol: ¯; keyboard shortcut: [Ctrl]+[Shift]+[F1]

Function: This command opens the CODESYS help.

Call: Menu bar: “Help”.

Command 'Index'

Symbol: ®; keyboard shortcut: [Ctrl]+[Shift]+[F2]

Function: This command opens the CODESYS help.

Call: Menu bar: “Help”.

An index search is not possible in the online help. The “Index” tab opens in the offline help. All index entries of the help are listed alphabetically in the index view.

<table>
<thead>
<tr>
<th>“Look for”</th>
<th>As you type letters into the input field, CODESYS searches automatically for matches in the index list.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Display”</td>
<td>Opens the help page for the highlighted index entry in the list and displays the title of the help page and location of the help file (*.chm) in the “Index results for &lt;index entry&gt;” view. When several pages are found and then displayed in this view, then you view a specific help page by clicking its entry in the list. Clicking an entry in the index list achieves the same result.</td>
</tr>
</tbody>
</table>

Command 'Find'

Symbol: 📚

Function: This command opens the CODESYS help.

Call: Menu bar: “Help”.

In the online help, you can run a full-text search from the input field on the top right of the help page. The “Find” tab opens in the offline help.

Table 516: Tab ‘Search’

<table>
<thead>
<tr>
<th>“Search for”</th>
<th>Combo box for defining the search term or for selecting the 25 most recent search terms.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Search in titles only”</td>
<td>The search is performed only in the titles of the help pages.</td>
</tr>
<tr>
<td>“Display partial matches”</td>
<td>Displays terms also as search results that include the search term.</td>
</tr>
<tr>
<td>“Limit to .... matches ”</td>
<td>Limits the number of search results. Maximum value: 1000</td>
</tr>
<tr>
<td>“Find”</td>
<td>Starts the full-text search.</td>
</tr>
</tbody>
</table>
Command 'About'

**Function:** This command opens a splash screen with information about the CODESYS version and copyright. In addition, buttons are available for detailed information about the version, license, and acknowledgments.

**Call:** Main menu “Help”.

<table>
<thead>
<tr>
<th>“Version Info”</th>
<th>Opens the “Detailed Version Information” dialog box with a list of CODESYS components and information about the operating system.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Export”</td>
<td>Exports the detailed version information as a *.txt file or in any other format.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“License Info”</th>
<th>Opens the “License Information” dialog box.</th>
</tr>
</thead>
<tbody>
<tr>
<td>● “Plug-in”:</td>
<td>Drop-down list for the plug-in to display the license information</td>
</tr>
<tr>
<td>● “Software License”: License information about selected “Plug-in”</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Acknowledgments”</th>
<th></th>
</tr>
</thead>
</table>

**Menu 'SFC'**

6.4.1.21.3.12.1 Command 'Init Step'.............................................................. 2675
6.4.1.21.3.12.2 Command 'Insert Step'.......................................................... 2676
6.4.1.21.3.12.3 Command 'Insert Step After'.................................................. 2676
6.4.1.21.3.12.4 Command 'Insert Transition After'......................................... 2676
6.4.1.21.3.12.5 Command 'Insert Transition'.................................................. 2677
6.4.1.21.3.12.6 Command 'Insert Step-Transition'......................................... 2677
6.4.1.21.3.12.7 Command 'Insert Step-Transition After'................................. 2677
6.4.1.21.3.12.8 Command 'Add Entry Action'................................................... 2678
6.4.1.21.3.12.9 Command 'Add Exit Action'.................................................... 2678
6.4.1.21.3.12.10 Command 'Parallel'..................................................................... 2678
6.4.1.21.3.12.11 Command 'Alternative'.................................................................. 2679
6.4.1.21.3.12.12 Command 'Insert Branch'.......................................................... 2679
6.4.1.21.3.12.13 Command 'Insert Branch Right'............................................... 2679
6.4.1.21.3.12.14 Command 'Insert Action Association'....................................... 2680
6.4.1.21.3.12.15 Command 'Insert Action Association After'.............................. 2681
6.4.1.21.3.12.16 Command 'Insert Jump'................................................................ 2681
6.4.1.21.3.12.17 Command 'Insert Jump After'.................................................. 2681
6.4.1.21.3.12.18 Command 'Insert Macro'............................................................ 2682
6.4.1.21.3.12.19 Command 'Insert Macro After'................................................ 2682
6.4.1.21.3.12.20 Command 'Zoom Into Macro'................................................... 2682
6.4.1.21.3.12.21 Command 'Zoom Out of Macro'................................................ 2682
6.4.1.21.3.12.22 Command 'Paste After'................................................................ 2683
6.4.1.21.3.12.23 Command 'Change Duplication' - 'Set'...................................... 2683
6.4.1.21.3.12.24 Command 'Change Duplication' - 'Remove'.................................. 2683
6.4.1.21.3.12.25 Command 'Do Not Display Embedded Objects'.......................... 2684

**Command 'Init Step'**

**Symbol:** 🕵️‍♂️

**Function:** This command converts the selected step into an initial step.

**Call:** Main menu “SFC”
After you choose this command, the borders of the step element change to a double line. The previous initial step is automatically displayed as a normal step with a single-line border.

You can also activate and deactivate the property “Init step” in the properties dialog of a step. However, CODESYS does not automatically adjust the settings of other steps.

This command is useful if you want to convert a diagram. When you create a new SFC object, it automatically includes an initial step followed by a transition (TRUE) and a jump back to the initial step.

Please note: In online mode, it is possible to reset the diagram to the initial step using the $SFCInit and $SFCReset flags.

See also
- Chapter 6.4.1.20.1.5.6 “SFC Flags” on page 2067
- Chapter 6.4.1.20.1.5.8.6 “SFC element properties” on page 2080

Command 'Insert Step'
Symbol: ✍

Function: This command inserts a step before the selected point.
Call: Menu bar “SFC”; context menu in SFC editor
The new step is named $Step<n> by default, where $n is an incremental number starting at 0 for the first step that is inserted in addition to the initial step. The name can be edited by clicking on it.

See also
- Chapter 6.4.1.21.3.12.7 “Command 'Insert Step-Transition After’” on page 2677
- Chapter 6.4.1.21.3.12.1 “Command ‘Init Step’” on page 2675
- Chapter 6.4.1.20.1.5.8.1 “SFC elements ‘Step’ and ‘Transition’” on page 2073

Command 'Insert Step After'
Symbol: ✍

Function: This command inserts a step after the selected point.
Call: Menu bar “SFC”; context menu in SFC editor
The new step is named $Step<n> by default, where $n is an incremental number starting at 0 for the first step that is inserted in addition to the initial step. The name can be edited by clicking on it.

See also
- Chapter 6.4.1.21.3.12.7 “Command 'Insert Step-Transition After’” on page 2677
- Chapter 6.4.1.21.3.12.1 “Command ‘Init Step’” on page 2675
- Chapter 6.4.1.20.1.5.8.1 “SFC elements ‘Step’ and ‘Transition’” on page 2073

Command 'Insert Transition After'
Symbol: ✍

Function: This command inserts a transition after the selected point.
Call: Menu bar “SFC”; context menu in SFC editor
The new transition is named $\text{Trans}<n>$ by default, where $n$ is an incremental number beginning at 0 for the first transition. The name can be edited by clicking on it.

See also
- Chapter 6.4.1.21.3.12.7 “Command ‘Insert Step-Transition After’” on page 2677
- Chapter 6.4.1.20.1.5.8.1 “SFC elements ‘Step’ and ‘Transition’” on page 2073

Command ‘Insert Transition’

Symbol: $\uparrow$

**Function:** This command inserts a transition before the selected point.

**Call:** Menu bar “SFC”; context menu in SFC editor

The new transition is named $\text{Trans}<n>$ by default, where $n$ is an incremental number beginning at 0 for the first transition. The name can be edited by clicking on it.

See also
- Chapter 6.4.1.21.3.12.7 “Command ‘Insert Step-Transition After’” on page 2677
- Chapter 6.4.1.20.1.5.8.1 “SFC elements ‘Step’ and ‘Transition’” on page 2073

Command ‘Insert Step-Transition’

Symbol: $\uparrow$

**Function:** This command inserts a step and a transition before the selected point.

**Call:** Main menu “SFC”

If you have selected a step, then CODESYS inserts a new step-transition combination. If you have selected a transition, then a new transition-step combination is inserted.

The new step is named $\text{Step}<n>$ by default, where $n$ is an incremental number beginning at 0 for the first step that was inserted in addition to the initial step. The new transition is named $\text{Trans}<n>$ by default. You can edit the default names directly by clicking the names.

See also
- Chapter 6.4.1.21.3.12.7 “Command ‘Insert Step-Transition After’” on page 2677
- Chapter 6.4.1.21.3.12.1 “Command ‘Init Step’” on page 2675
- Chapter 6.4.1.20.1.5.8.1 “SFC elements ‘Step’ and ‘Transition’” on page 2073

Command ‘Insert Step-Transition After’

Symbol: $\downarrow$

**Function:** This command inserts a step and a transition after the selected point.

**Call:** Main menu “SFC”

If you have selected a step, then CODESYS inserts a new transition-step combination. If you have selected a transition, then a new step-transition combination is inserted.

The new step is named $\text{Step}<n>$ by default, where $n$ is an incremental number beginning at 0 for the first step that was inserted in addition to the initial step. The new transition is named $\text{Trans}<n>$ by default. You can edit the default names directly by clicking the names.

See also
- Chapter 6.4.1.21.3.12.6 “Command ‘Insert Step-Transition’” on page 2677
Command 'Add Entry Action'

Symbol: 

Function: This command opens the “Add Entry Action” dialog box where you define a new entry action. Depending on the SFC options, a dialog prompt may open for selecting the duplication mode for the new step action.

Call: Menu bar: “SFC”; context menu of the selected step element.

Requirement: A step element in SFC is selected.

The entry action is opened automatically in the ST editor. The step element contains an \( \varepsilon \) in the lower left corner.

Options:
- “Copy reference: A new step will call the same actions”: If the step is copied in SFC, the link to the step action(s) is also copied. The steps copied by each other will therefore call the same actions.
- “Copy implementation: New action objects are created for a new step.”: This means that the step actions for a copied step are embedded. By default, the generated action objects appear below an SFC box in the device tree or “POUs” view. These objects contains a copy of the original implementation code of the respective action. The display of the embedded objects can be activated and deactivated in the tree by means of the “Show Embedded Objects” and “Hide Embedded Objects” commands in the context menu of an SFC object.

See also
- Chapter 6.4.1.21.4.14.23 “Dialog ‘Options’ - ‘SFC Editor’” on page 2795
- Chapter 6.4.1.9.5.5.2 “Programming in SFC” on page 1880
- Chapter 6.4.1.20.1.5.8.2 “SFC Element ‘Action’” on page 2075
- Chapter 6.4.1.21.3.12.25 “Command ‘Do Not Display Embedded Objects’” on page 2684

Command 'Add Exit Action'

Symbol: 

Function: This command opens the “Add Exit Action” dialog box where you define a new exit action. Depending on the SFC options, a dialog prompt may open for selecting the duplication mode for the new step action. For more information, refer to the help page for the “Add Exit Action” command.

Call: Menu bar: “SFC”; context menu of the selected step element.

Requirement: A step element in SFC is selected.

See also
- Chapter 6.4.1.21.3.12.8 “Command ‘Add Entry Action’” on page 2678
- Chapter 6.4.1.21.4.14.23 “Dialog ‘Options’ - ‘SFC Editor’” on page 2795
- Chapter 6.4.1.9.5.5.2 “Programming in SFC” on page 1880
- Chapter 6.4.1.20.1.5.8.2 “SFC Element ‘Action’” on page 2075
- Chapter 6.4.1.21.3.12.25 “Command ‘Do Not Display Embedded Objects’” on page 2684

Command 'Parallel'

Symbol: 

Function: This command converts the selected alternative branch into a parallel branch.

Call: Main menu “SFC”

Requirement: The horizontal connecting line of a branch is selected.
Please note that after you convert a branch, you must check and modify the layout of the steps and transitions before and after the branch.

See also

- Chapter 6.4.1.21.3.12.11 “Command ‘Alternative’” on page 2679

**Command ‘Alternative’**

Symbol: 🟢

**Function:** This command converts the selected parallel branch into an alternative branch.

**Call:** Main menu “SFC”

**Requirement:** The horizontal connecting line of a branch is selected.

Please note that after you convert a branch, you must check and modify the layout of the steps and transitions before and after the branch.

See also

- Chapter 6.4.1.21.3.12.10 “Command ‘Parallel’” on page 2678
- Chapter 6.4.1.21.3.12.13 “Command ‘Insert Branch Right’” on page 2679

**Command ‘Insert Branch’**

Symbol: 🟢

**Function:** This command inserts a branch to the left of the selected point.

**Call:** Main menu “SFC”

This command functions similar to the “Insert Branch Right” command.

See also

- Chapter 6.4.1.20.1.5.8.3 “SFC element ‘Branch’” on page 2078
- Chapter 6.4.1.21.3.12.13 “Command ‘Insert Branch Right’” on page 2679

**Command ‘Insert Branch Right’**

Symbol: 🟢

**Function:** This command inserts a branch to the right of the selected point.

**Call:** Main menu “SFC”

The type of inserted branch depends on the selected element.

- If the uppermost element of the selected elements is a transition or an alternative branch, then CODESYS inserts an alternative branch.
- If the uppermost element of the selected elements is a step, a macro, a jump, or a parallel branch, then CODESYS inserts a parallel branch with the Branch<\text{\textless}x\text{\textrangle}> jump marker, where \text{\textless}x\text{\textrangle} is an incremental number. You can edit the default name of the jump marker or define the jump marker as a jump destination.
- If a common element of an existing branch (horizontal line) is selected, then CODESYS inserts the new branch line as a branch line on the far right. If an entire branch line of an existing branch is selected, then CODESYS inserts the new branch line directly to the right as a new branch line.

Please note: You can convert a branch into another type with the “Alternative” and “Parallel” commands.
Example of parallel branch

The following image shows a new inserted parallel branch generated by the “Insert Branch Right” command while the Step11 step was selected. CODESYS automatically inserts a step (Step2 in the example).

Processing in online mode: If $t_2$ yields TRUE, then CODESYS executes Step2 immediately after Step11 and before $t_3$ is passed.

Thus, CODESYS processes both branch lines as opposed to alternative branches.

Example of alternative branch

The following image shows a new inserted alternative branch generated by the “Insert Branch Right” command while the $t_4$ transition was selected. CODESYS automatically inserts a step (Step32 in the example), a preceding transition, and a subsequent transition ($t_41$, $t_42$).

Processing in online mode: If Step3 is active, then CODESYS passes the subsequent transitions ($t_4$, $t_41$) from left to right. The first branch line of the main branch with the first transition yielding TRUE is passed. Therefore, only one branch line is processed as opposed to with a parallel branch.

See also

- Chapter 6.4.1.20.1.5.8.3 “SFC element 'Branch'” on page 2078
- Chapter 6.4.1.21.3.12.12 “Command 'Insert Branch'” on page 2679
- Chapter 6.4.1.21.3.12.10 “Command 'Parallel'” on page 2678
- Chapter 6.4.1.21.3.12.11 “Command 'Alternative'” on page 2679

Command 'Insert Action Association'

Symbol: $\text{Insert Action Association}$

**Function:** This command assigns an IEC action to a step.

**Call:** Main menu “SFC”
**Requirement:** A step is selected.

CODESYS inserts the action element to the right of the selected step element.

If you have already assigned one or more actions to the step, they are displayed in an action list. The new action is then inserted as follows:

- If you selected the step element, the action is inserted as the first action of the step at first position of the action list.
- If you selected one of the available actions in the action list, then the action is inserted directly above the selected action.

The left section of the action element includes the qualifier (N by default). You enter the action name in the right section. To set this value, click in the box to obtain an editing frame. You must have already created this action as a POU in the project.

You can also edit the qualifier. Valid qualifiers are described in the chapter “Qualifiers for Actions in SFC”.

See also:
- Chapter 6.4.1.21.3.12.15 “Command 'Insert Action Association After’” on page 2681
- Chapter 6.4.1.20.1.5.4 “Qualifiers for Actions in SFC” on page 2065

**Command 'Insert Action Association After’**

**Symbol:** \( \text{ä} \)

**Function:** This command assigns an IEC action to a step.

**Call:** Main menu “SFC”

**Requirement:** A step is selected.

This command functions similar to the “Insert Action Association” command. The difference between the two commands is that CODESYS inserts the new action in the last position of the action list, not the first position. If you select an action in the action list, then CODESYS inserts the new action at the bottom of the list, not at the top.

See also:
- Chapter 6.4.1.21.3.12.14 “Command 'Insert Action Association’” on page 2680
- Chapter 6.4.1.20.1.5.4 “Qualifiers for Actions in SFC” on page 2065

**Command 'Insert Jump’**

**Symbol:** \( \text{i} \)

**Function:** This command inserts a jump element before the selected element.

**Call:** Main menu “SFC”

**Requirement:** A step is selected.

CODESYS automatically inserts the jump with the Step destination. Then, you still have to replace this jump destination with an actual destination by using the input assistant.

See also:
- Chapter 6.4.1.20.1.5.8.4 “SFC element 'Jump’” on page 2079
- Chapter 6.4.1.21.3.12.17 “Command 'Insert Jump After’” on page 2681

**Command 'Insert Jump After’**

**Symbol:** \( \text{i} \)

**Function:** This command inserts a jump element after the selected element.
Call: Main menu “SFC”
CODESYS automatically inserts the jump with the step destination. Then, you still have to replace this jump destination with an actual destination by using the input assistant.

See also
- § Chapter 6.4.1.20.1.5.8.4 “SFC element ‘Jump’” on page 2079
- § Chapter 6.4.1.21.3.12.16 “Command ‘Insert Jump’” on page 2681

Command 'Insert Macro'
Symbol: 图

Function: This command inserts a macro element before the selected element.

Call: Main menu “SFC”
The new macro is named Macro<x> by default, where x is an incremental number beginning at 0 for the first macro. You can edit the default name directly by clicking the name.

To edit the macro, click “Zoom Into Macro” in the macro editor.

See also
- § Chapter 6.4.1.21.3.12.20 “Command ‘Zoom Into Macro’” on page 2682
- § Chapter 6.4.1.21.3.12.19 “Command ‘Insert Macro After’” on page 2682

Command 'Insert Macro After'
Symbol: 图↓

Function: This command inserts a macro element after the selected element.

Call: Main menu “SFC”
This command functions similar to the “Insert Macro” command.

See also
- § Chapter 6.4.1.21.3.12.20 “Command ‘Zoom Into Macro’” on page 2682
- § Chapter 6.4.1.21.3.12.18 “Command ‘Insert Macro’” on page 2682

Command ‘Zoom Into Macro’
Symbol: 图

Function: This command opens a macro for editing in the macro editor.

Call: Main menu “SFC”
Requirement: A macro is selected.

By choosing this command, CODESYS closes the main view of the SFC editor and opens the macro editor. This is also an SFC editor for editing the section of the SFC diagram that is displayed as a macro box in the main view.

Click “Zoom Out of Macro” to return to the main view.

See also
- § Chapter 6.4.1.21.3.12.21 “Command ‘Zoom Out of Macro’” on page 2682

Command 'Zoom Out of Macro'
Symbol: 图↓
Function: This command closes the macro editor and returns to the main view of the SFC editor.

Call: Main menu “SFC”

Requirement: A macro is open in the macro editor.

See also
● § Chapter 6.4.1.21.3.12.20 “Command ‘Zoom Into Macro’” on page 2682

Command 'Paste After'

Symbol: 

Function: This command pastes the elements from the clipboard after the selected position.

Call: Main menu “SFC”.

Command 'Change Duplication' - 'Set'

Function: This command embeds every step action or transition, which is called by a step or transition in the SFC box, with the caller. In this way, the action or transition object can be called only from exactly this caller (pseudo-embedding). The result is that copying step and transition elements that call actions or transitions automatically creates new action or transition objects. The implementation code is also copied.

Call: Menu bar: “SFC”.

For more details about duplication mode, refer to the help page for the SFC element properties and the instructions for adding step actions.

Pseudo-embedded objects can be hidden in the “Devices” or “POUs” view by means of a command.

See also
● § Chapter 6.4.1.20.1.5.8.6 “SFC element properties” on page 2080
● § Chapter 6.4.1.9.5.5.2 “Programming in SFC” on page 1880

Command 'Change Duplication' - 'Remove'

Function: This command removes the embedding of action, transition, and property objects by a step or transition that calls it for the entire SFC box. In this way, the pseudo-embedding of the action, transition, or property objects is removed. If step or transition elements are copied, which call actions, transitions, or properties, then the copying calls the same actions and transitions as the source.

Call: Menu bar: “SFC”.

For more details about duplication mode, refer to the help page for the SFC element properties and the instructions for adding step actions.

Pseudo-embedded objects can be hidden in the “Devices” or “POUs” view by means of a command.
Command 'Do Not Display Embedded Objects'

**Function:** This command causes action and transition objects, which are embedded in an SFC box by a step or transition, do not appear in the tree.

**Call:** Context menu of an SFC box in the “Devices” or “POUs” view.

See also

- Chapter 6.4.1.20.1.5.8.6 “SFC element properties” on page 2080
- Chapter 6.4.1.21.3.12.25 “Command 'Do Not Display Embedded Objects’” on page 2684

- Chapter 6.4.1.9.5.5.2 “Programming in SFC” on page 1880
### Menu 'CFC'

<table>
<thead>
<tr>
<th>Command ID</th>
<th>Command Name</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.4.1.21.3.13.1</td>
<td>Command 'Edit Worksheet'</td>
<td>2685</td>
</tr>
<tr>
<td>6.4.1.21.3.13.2</td>
<td>Command 'Edit Page Size'</td>
<td>2686</td>
</tr>
<tr>
<td>6.4.1.21.3.13.3</td>
<td>Command 'Negate'</td>
<td>2686</td>
</tr>
<tr>
<td>6.4.1.21.3.13.4</td>
<td>Command 'EN/ENO'</td>
<td>2686</td>
</tr>
<tr>
<td>6.4.1.21.3.13.5</td>
<td>Command 'None'</td>
<td>2687</td>
</tr>
<tr>
<td>6.4.1.21.3.13.6</td>
<td>Command 'R (Reset)'</td>
<td>2687</td>
</tr>
<tr>
<td>6.4.1.21.3.13.7</td>
<td>Command 'S (Set)'</td>
<td>2687</td>
</tr>
<tr>
<td>6.4.1.21.3.13.8</td>
<td>Command 'REF= (Reference Assignment)'</td>
<td>2687</td>
</tr>
<tr>
<td>6.4.1.21.3.13.9</td>
<td>Command 'Display Execution Order'</td>
<td>2688</td>
</tr>
<tr>
<td>6.4.1.21.3.13.10</td>
<td>Command 'Set Start of Feedback'</td>
<td>2688</td>
</tr>
<tr>
<td>6.4.1.21.3.13.11</td>
<td>Command 'Send to Front'</td>
<td>2688</td>
</tr>
<tr>
<td>6.4.1.21.3.13.12</td>
<td>Command 'Send to Back'</td>
<td>2689</td>
</tr>
<tr>
<td>6.4.1.21.3.13.13</td>
<td>Command 'Move Up'</td>
<td>2689</td>
</tr>
<tr>
<td>6.4.1.21.3.13.14</td>
<td>Command 'Move Down'</td>
<td>2690</td>
</tr>
<tr>
<td>6.4.1.21.3.13.15</td>
<td>Command 'Set Execution Order'</td>
<td>2690</td>
</tr>
<tr>
<td>6.4.1.21.3.13.16</td>
<td>Command 'Order by Data Flow'</td>
<td>2691</td>
</tr>
<tr>
<td>6.4.1.21.3.13.17</td>
<td>Command 'Order by Topology'</td>
<td>2691</td>
</tr>
<tr>
<td>6.4.1.21.3.13.18</td>
<td>Command 'Edit Parameters'</td>
<td>2692</td>
</tr>
<tr>
<td>6.4.1.21.3.13.19</td>
<td>Command 'Save Prepared Parameters to Project'</td>
<td>2693</td>
</tr>
<tr>
<td>6.4.1.21.3.13.20</td>
<td>Command 'Connect Selected Pins'</td>
<td>2693</td>
</tr>
<tr>
<td>6.4.1.21.3.13.21</td>
<td>Command 'Unlock Connection'</td>
<td>2693</td>
</tr>
<tr>
<td>6.4.1.21.3.13.22</td>
<td>Command 'Show Next Collision'</td>
<td>2694</td>
</tr>
<tr>
<td>6.4.1.21.3.13.23</td>
<td>Command 'Select Connected Pins'</td>
<td>2694</td>
</tr>
<tr>
<td>6.4.1.21.3.13.24</td>
<td>Command 'Reset Pins'</td>
<td>2694</td>
</tr>
<tr>
<td>6.4.1.21.3.13.25</td>
<td>Command 'Remove Unused Pins'</td>
<td>2694</td>
</tr>
<tr>
<td>6.4.1.21.3.13.26</td>
<td>Command 'Add Input Pin'</td>
<td>2695</td>
</tr>
<tr>
<td>6.4.1.21.3.13.27</td>
<td>Command 'Add Output Pin'</td>
<td>2695</td>
</tr>
<tr>
<td>6.4.1.21.3.13.28</td>
<td>Command 'Route All Connections'</td>
<td>2695</td>
</tr>
<tr>
<td>6.4.1.21.3.13.29</td>
<td>Command 'Remove Control Point'</td>
<td>2695</td>
</tr>
<tr>
<td>6.4.1.21.3.13.30</td>
<td>Command 'Create Control Point'</td>
<td>2696</td>
</tr>
<tr>
<td>6.4.1.21.3.13.31</td>
<td>Command 'Connection Mark'</td>
<td>2696</td>
</tr>
<tr>
<td>6.4.1.21.3.13.32</td>
<td>Command 'Create group'</td>
<td>2696</td>
</tr>
<tr>
<td>6.4.1.21.3.13.33</td>
<td>Command 'Ungroup'</td>
<td>2697</td>
</tr>
<tr>
<td>6.4.1.21.3.13.34</td>
<td>Command 'Prepare Box for Forcing'</td>
<td>2697</td>
</tr>
<tr>
<td>6.4.1.21.3.13.35</td>
<td>Command 'Force Function Block Input'</td>
<td>2697</td>
</tr>
<tr>
<td>6.4.1.21.3.13.36</td>
<td>Command 'Use Attributed Member as Input'</td>
<td>2698</td>
</tr>
</tbody>
</table>

**Command 'Edit Worksheet'**

**Function:** This command opens the “Edit Worksheet” dialog box in which you set the size of the worksheet.

**Call:** Main menu “CFC”

**Requirements:** A CFC editor is active.

**Dialog box 'Edit worksheet'**
“Use following dimensions” | Here is where you set the size of the worksheet. Your change is only accepted if the size is sufficient for the existing program.

“Adapt the dimensions automatically” | Automatically adapts the size of the worksheet to the size of your program.

“Move the working sheet origin relatively” | Shifts the worksheet along the x or y axis. The input of negative numbers is permitted.

Command 'Edit Page Size'

**Function**: This command opens the “Edit Page Size” dialog box, in which you change the size of the page-oriented CFC editor.

**Call**: Main menu “CFC”

**Requirements**: A page-oriented CFC editor is active.

Dialog box ‘Edit page size’

| “Width” | Width of the page (minimum 24, maximum 1024). Elements outside of the working area are marked red. |
| “Height” | Height of the page (minimum 24, maximum 1024). Elements outside of the working area are marked red. |
| “Margin width” | Width of the margin (minimum 6, maximum 25% or page width). |
| “Set as standard for new CFC objects” | ✓: The current settings are selected as standard for new CFC objects. |

See also

- Chapter 6.4.1.20.1.7.6.1 “CFC element 'Page’” on page 2109

Command 'Negate'

**Symbol**: -\( \circ \)

**Function**: This command negates the selected function block input or function block output.

**Call**: Main menu “CFC”, context menu

**Requirements**: A CFC editor is active. A function block input or function block output is selected.

Command 'EN/ENO'

**Symbol**: \[\text{EN}\]

**Function**: This command adds a boolean input “EN” (Enable) and a boolean output “ENO” (Enable Out) to the selected function block.

**Call**: Main menu “CFC”, context menu

**Requirements**: A CFC editor is active. A function block is selected.

The added input “EN” activates the function block. The function block is executed only if the input is TRUE. The value of this signal is output at the “ENO” output.
Command 'None'
Symbol: -
keyboard shortcut: [Ctrl]+[M] (to toggle between “S”, “R”, “REF”, and None)

Function: The command removes a Reset (R), Set (S), or REF from the input of the “Output” element.

Call: Menu bar: “CFC ➔ Set/Reset”; context menu: “Set/Reset”

Requirement: A CFC editor is active. The input of an “Output” element is selected.

Command 'R (Reset)'
Symbol: -
keyboard shortcut: [Ctrl]+[M] (to toggle between “S”, “R”, “REF”, and None)

Function: The command adds a Reset to the input of a Boolean “Output” element.

Call: Menu bar: “CFC ➔ Set/Reset”; context menu: “Set/Reset”

Requirement: A CFC editor is active. The input of an “Output” element is selected.

If an “Output” element has a Reset input, then the Boolean output value is set to “FALSE” as soon as the value of the input is “TRUE”. The “FALSE” value at the output is retained, even if the input value changes.

See also
● § Chapter 6.4.1.21.3.13.7 “Command ‘S (Set)’” on page 2687

Command 'S (Set)'
Symbol: -
keyboard shortcut: [Ctrl]+[M] (to toggle between “S”, “R”, “REF”, and None)

Function: The command adds a Set (S) to the input of a Boolean “Output” element.

Call: Menu bar: “CFC ➔ Set/Reset”; context menu: “Set/Reset”

Requirement: A CFC editor is active. The input of an “Output” element is selected.

If an “Output” element has a Set input, then the Boolean output value is set to “TRUE” as soon as the value of the input is “TRUE”. The “TRUE” value at the output is retained, even if the input value changes.

See also
● § Chapter 6.4.1.21.3.13.6 “Command ‘R (Reset)’” on page 2687

Command 'REF= (Reference Assignment)'
Symbol: -
keyboard shortcut: [Ctrl]+[M] (to toggle between “S”, “R”, “REF”, and None)

Function: The command assigns a reference to an “Output” element.

Call: Menu bar: “CFC ➔ Set/Reset”; context menu: “Set/Reset”

Requirements: A CFC editor is active. The input of an “Output” element is selected.

Example:
Declaration:
```
ref_int : REFERENCE TO INT;
a : INT;
```

CFC:
![Diagram of CFC editor with REF and ref_int]

This corresponds to the ST code: `ref_int REF= a;`
Command 'Display Execution Order'

**Function:** The command temporarily shows a numbered tag for all CFC elements of the programming object.

**Call**
- Menu bar: “CFC ➔ Execution Order”
- Context menu in the CFC editor

**Requirement:** A CFC editor is active and the “Auto Data Flow Mode” property is selected.

The numbers represent the automatically determined execution order. The execution order is determined by data flow. In the case of multiple networks, it is determined by their topological position in the editor.

The tags are hidden as soon as you click in the CFC editor.

See also
- Chapter 6.4.1.9.5.3.2 “Automatic Execution Order by Data Flow” on page 1867
- Chapter 6.4.1.21.3.13.9 “Command ‘Display Execution Order’” on page 2688
- Chapter 6.4.1.21.4.11.14 “Dialog ‘Properties’ - ‘CFC Execution Order’” on page 2761

Command 'Set Start of Feedback'

**Symbol:** ➔

**Function:** The command defines the selected element as the starting point within a feedback.

**Call:**
- Menu bar: “CFC ➔ Execution Order”
- Context menu: “Execution Order”

**Requirement:** A CFC editor is active and the “Auto Data Flow Mode” property is selected. Moreover, a network of the CFC POU contains a feedback, and an element within the feedback is selected.

In the CFC editor, the starting point within the feedbacks is decorated with the ➔ symbol. Then the element has the lowest number in the execution order within the feedbacks. At runtime, the processing of the feedback begins with this element.

See also
- Chapter 6.4.1.9.5.3.2 “Automatic Execution Order by Data Flow” on page 1867
- Chapter 6.4.1.21.3.13.9 “Command ‘Display Execution Order’” on page 2688
- Chapter 6.4.1.21.4.11.14 “Dialog ‘Properties’ - ‘CFC Execution Order’” on page 2761

Command 'Send to Front'

**Symbol:** ➔

For more information, see the description for the data type REFERENCE TO.

See also
- Chapter 6.4.1.9.5.3.3 “Programming in the CFC editor” on page 1871
- Chapter 6.4.1.20.5.14 “Reference” on page 2245
**Function:** The command numbers the elements so that the selected elements are located at the front of the execution order.

**Call:** Menu bar: “CFC ➔ Execution Order”; context menu: “Execution Order”

**Requirements:** A CFC editor is active and the “Explicit Execution Order Mode” property is selected. At least one element is selected.

The selected elements get the lowest numbers beginning at 0 while keeping the previous order. The remaining elements are numbered so that their execution order remains the same. The topological positions of the elements are retained anyway.

See also

- Chapter 6.4.1.9.5.3.2 “Automatic Execution Order by Data Flow” on page 1867
- Chapter 6.4.1.21.4.11.14 “Dialog ‘Properties’ - ‘CFC Execution Order’” on page 2761
- Chapter 6.4.1.21.3.13.12 “Command ‘Send to Back’” on page 2689
- Chapter 6.4.1.21.3.13.13 “Command ‘Move Up’” on page 2689
- Chapter 6.4.1.21.3.13.14 “Command ‘Move Down’” on page 2690
- Chapter 6.4.1.21.3.13.16 “Command ‘Order by Data Flow’” on page 2691
- Chapter 6.4.1.21.3.13.17 “Command ‘Order by Topology’” on page 2691

**Command 'Send to Back’**

**Symbol:** 🔄

**Function:** The command numbers the elements so that the selected elements are located at the end of the execution order.

**Call:** Menu bar: “CFC ➔ Execution Order”; context menu: “Execution Order”

**Requirements:** A CFC editor is active and the “Explicit Execution Order Mode” property is selected. At least one element is selected.

The selected elements get the highest numbers while keeping the previous order. The remaining elements are numbered so that their execution order remains the same. The topological positions of the elements are retained anyway.

See also

- Chapter 6.4.1.9.5.3.2 “Automatic Execution Order by Data Flow” on page 1867
- Chapter 6.4.1.21.4.11.14 “Dialog ‘Properties’ - ‘CFC Execution Order’” on page 2761
- Chapter 6.4.1.21.3.13.11 “Command ‘Send to Front’” on page 2688
- Chapter 6.4.1.21.3.13.13 “Command ‘Move Up’” on page 2689
- Chapter 6.4.1.21.3.13.14 “Command ‘Move Down’” on page 2690
- Chapter 6.4.1.21.3.13.16 “Command ‘Order by Data Flow’” on page 2691
- Chapter 6.4.1.21.3.13.17 “Command ‘Order by Topology’” on page 2691

**Command 'Move Up’**

**Symbol:** ⬆️

**Function:** The command numbers the elements so that the selected elements are located one position forward.

**Call:** Menu bar: “CFC ➔ Execution Order”; context menu: “Execution Order”

**Requirements:** A CFC editor is active and at least one element is selected. The “Explicit Execution Order Mode” property is selected.
The selected elements get a numbering decreased by one while keeping the previous order. The selected elements are processed one position earlier. The remaining elements are numbered so that their execution order remains the same. The topological positions of the elements are retained anyway.

See also
- Chapter 6.4.1.9.5.3.2 “Automatic Execution Order by Data Flow” on page 1867
- Chapter 6.4.1.21.4.11.14 “Dialog 'Properties' - ‘CFC Execution Order’” on page 2761
- Chapter 6.4.1.21.3.13.11 “Command ‘Send to Front’” on page 2688
- Chapter 6.4.1.21.3.13.12 “Command ‘Send to Back’” on page 2689
- Chapter 6.4.1.21.3.13.14 “Command ‘Move Down’” on page 2690
- Chapter 6.4.1.21.3.13.16 “Command ‘Order by Data Flow’” on page 2691
- Chapter 6.4.1.21.3.13.17 “Command ‘Order by Topology’” on page 2691

Command 'Move Down'

Symbol: 📡

**Function:** The command numbers the elements so that the selected elements are located one position backward.

**Call:** Menu bar: “CFC ➔ Execution Order”; context menu: “Execution Order”

**Requirements:** A CFC editor is active and at least one element is selected. The “Explicit Execution Order Mode” property is selected.

The selected elements get a numbering increased by one while keeping the previous order. The elements are processed one position later. The remaining elements are numbered so that their execution order remains the same. The topological positions of the elements are retained anyway.

See also
- Chapter 6.4.1.9.5.3.2 “Automatic Execution Order by Data Flow” on page 1867
- Chapter 6.4.1.21.4.11.14 “Dialog 'Properties' - ‘CFC Execution Order’” on page 2761
- Chapter 6.4.1.21.3.13.11 “Command ‘Send to Front’” on page 2688
- Chapter 6.4.1.21.3.13.12 “Command ‘Send to Back’” on page 2689
- Chapter 6.4.1.21.3.13.13 “Command ‘Move Up’” on page 2689
- Chapter 6.4.1.21.3.13.16 “Command ‘Order by Data Flow’” on page 2691
- Chapter 6.4.1.21.3.13.17 “Command ‘Order by Topology’” on page 2691

Command 'Set Execution Order'

**Function:** The command opens a dialog for setting the number of the selected element to any value.

**Call:** Menu bar: “CFC ➔ Execution Order”; context menu: “Execution Order”

**Requirements:** A CFC editor is active and the “Explicit Execution Order Mode” property is selected. Exactly one element is selected.

The selected element gets the number specified in the dialog. The remaining elements are numbered so that their execution order remains the same. The topological positions of the elements are retained anyway.
Command 'Order by Data Flow'

**Function:** The command numbers the elements in the program by data flow, or in the case of multiple networks by their topological position in the editor.

**Call:** Menu bar: “CFC ➔ Execution Order”; context menu: “Execution Order”

**Requirements:** A CFC editor is active and the “Explicit Execution Order Mode” property is selected.

The command is also available when no element is selected.

The execution order is determined by data flow. In the case of multiple networks, it is determined by their topological position of the networks. All numbered elements of the POU are set accordingly. Afterwards, the execution order is identical to that in auto data flow mode. The topological positions of the elements are retained anyway.

See also

- Chapter 6.4.1.9.5.3.2 “Automatic Execution Order by Data Flow” on page 1867
- Chapter 6.4.1.21.4.11.14 “Dialog ‘Properties’ - ‘CFC Execution Order’” on page 2761
- Chapter 6.4.1.21.3.13.11 “Command ‘Send to Front’” on page 2688
- Chapter 6.4.1.21.3.13.12 “Command ‘Send to Back’” on page 2689
- Chapter 6.4.1.21.3.13.13 “Command ‘Move Up’” on page 2689
- Chapter 6.4.1.21.3.13.14 “Command ‘Move Down’” on page 2690
- Chapter 6.4.1.21.3.13.16 “Command ‘Order by Data Flow’” on page 2691
- Chapter 6.4.1.21.3.13.17 “Command ‘Order by Topology’” on page 2691

Command 'Order by Topology'

**Function:** The command orders the execution order of the elements by their topological position from right to left and from top to bottom.

**Call:** Menu bar: “CFC ➔ Execution Order”; context menu: “Execution Order”

**Requirements:** A CFC editor is active and the “Explicit Execution Order Mode” property is selected. At least one element is selected.

The command applies to all elements in the program, even if not all elements are selected when the command is executed. The topological positions of the elements are retained anyway.

See also

- Chapter 6.4.1.9.5.3.2 “Automatic Execution Order by Data Flow” on page 1867
- Chapter 6.4.1.21.4.11.14 “Dialog ‘Properties’ - ‘CFC Execution Order’” on page 2761
- Chapter 6.4.1.21.3.13.11 “Command ‘Send to Front’” on page 2688
- Chapter 6.4.1.21.3.13.12 “Command ‘Send to Back’” on page 2689
Command 'Edit Parameters'

Function: This command opens the “Edit Parameters” dialog box, where you change the constant input parameters of a function block.

Call: Main menu “CFC ➔ Edit Parameters”, or “Right-Click ➔ Edit Parameters”, click the “Parameter” function block.

Requirements: A CFC editor is active. An instantiated function block has VAR_INPUT CONSTANT variables in its declaration.

This functionality applies only to blocks that are inserted in a CFC with CODESYS >= V3.5 SP4.

CODESYS displays blocks with VAR_INPUT CONSTANT variables by the word “Parameter” in the lower left corner of the block.

### Dialog Box 'Edit Parameters'

<table>
<thead>
<tr>
<th>“Parameters”</th>
<th>Name of the variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Type”</td>
<td>Data type of the variables</td>
</tr>
<tr>
<td>“Value”</td>
<td>Click into the field to type a value.</td>
</tr>
<tr>
<td>“Initial Value”</td>
<td>Initialization Value</td>
</tr>
<tr>
<td>“Category”</td>
<td>Additional information about the parameters; these values are defined by attributes and cannot be changed in this dialog box.</td>
</tr>
<tr>
<td>“Unit”</td>
<td>parameterCategory</td>
</tr>
<tr>
<td></td>
<td>parameterMinValue</td>
</tr>
<tr>
<td>“Max”</td>
<td>parameterMaxValue</td>
</tr>
</tbody>
</table>

“Delete Prepared Parameters” This command is active when you write a prepared value (“Debug ➔ Write Value”).

When you exit the field and the dialog box by clicking “OK”, the value changes are applied to the project.

**Example of a block with constant inputs**

```plaintext
FUNCTION_BLOCK FB1
VAR_INPUT CONSTANT
{attribute 'parameterCategory':='General'}
{attribute 'parameterUnit':='m/s'}
{attribute 'parameterMinValue':='0'}
{attribute 'parameterMaxValue':='100'}
{attribute 'parameterMinValue':='100'}

fbin1:INT;
fbin2:DWORD:=24354333;
fbin3:STRING:='abc';
END_VAR
```
This functionality and the declaration of variables with keyword VAR_INPUT CONSTANT applies only to the CFC editor. In the FBD editor, CODESYS always shows all input parameters on the block, regardless of whether or not they are declared as VAR_INPUT or VAR_INPUT CONSTANT. CODESYS also does not make a distinction about this in text editors.

See also

- § Chapter 6.4.1.20.1.7.5 “CFC Editor in Online Mode” on page 2103
- § Chapter 6.4.1.21.3.13.19 “Command 'Save Prepared Parameters to Project’” on page 2693

Command 'Save Prepared Parameters to Project’

Function: This command saves the prepared parameter values to the project.

Call: Main menu “CFC”.

Requirements: A CFC editor is active. Parameter values of function block instances are changed in online mode. You are in offline mode.

If the values of constants on the controller are different from the values in the application, then this is indicated by a red asterisk next to the parameter field. Clicking “Incur Prepared Parameters” saves the controller values to the application.

See also

- § “Changing of constant input parameters of function block instances” on page 2105
- § Chapter 6.4.1.21.3.13.18 “Command 'Edit Parameters’” on page 2692

Command 'Connect Selected Pins’

Symbol: 📛

Function: The command establishes a connection between the selected pins.

Call: Main menu “CFC”, context menu

Requirements: A CFC editor is active. Precisely one output and several inputs are selected.

In order to select the pins you must keep the [CTRL] key pressed while clicking on the pins. Then you execute the command.

See also

- § Chapter 6.4.1.21.3.13.23 “Command 'Select Connected Pins’” on page 2694

Command 'Unlock Connection'

Symbol: 🔐

Function: This command unlocks a disabled connection.

Call: Main menu “CFC ➔ Routing”, context menu “Routing”

Requirements: A CFC editor is active. A connection or a connection mark is selected.

You obtain a disabled connection if you change the connections of the automatic routing. If you wish to carry out automatic routing again, you must first unlock a disabled connection.
With a mouse-click on the icon of a disabled connection you can similarly unlock this connection.

See also

- § Chapter 6.4.1.9.5.3.3 “Programming in the CFC editor” on page 1871
- § Chapter 6.4.1.20.1.7.6.12 “CFC element ‘Connection Mark - Source/Sink’” on page 2112

Command 'Show Next Collision'

**Function:** This command displays the next collision in the editor and marks the place concerned.

**Call:** Menu menu “CFC ➔ Routing”, context menu “Routing”

**Requirements:** A CFC editor is active and at least one connection with a collision is present.

This function is very useful if you operate with large networks and see only one sub-area. A collision is additionally indicated to you by the red bordered symbol in the top right corner of the editor.

Command 'Select Connected Pins'

**Symbol:** ; shortcut: [Ctrl]+[Left Arrow], or [Ctrl]+[Right Arrow]

**Function:** The command selects all pins that are connected to the currently selected line, or connected to the currently selected connection mark in page-oriented CFC.

**Call:** “CFC” menu; context menu

**Requirements:** A CFC editor or a page-oriented CFC editor is active. One line and therefore exactly one connection or exactly one connection mark is selected.

See also

- § Chapter 6.4.1.20.1.7.2 “CFC Editor” on page 2098
- § Chapter 6.4.1.20.1.7.3 “CFC editor, page-oriented” on page 2101
- § Chapter 6.4.1.20.1.7.6.12 “CFC element ‘Connection Mark - Source/Sink’” on page 2112

Command 'Reset Pins'

**Symbol:** , [Ctrl]+[U]

**Function:** The command restores the deleted pins of a box.

**Call:** “CFC ➔ Pins” menu; “Pins” in the context menu

**Requirements:** A CFC editor is active and a box is selected.

The command restores all inputs and outputs of the box as they are defined in their implementation.

See also

- § Chapter 6.4.1.21.3.13.25 “Command 'Remove Unused Pins’” on page 2694

Command 'Remove Unused Pins'

**Symbol:** ☑
**Command 'Add Input Pin'**

Symbol: ![Symbol]

**Function:** The command adds a further input to the selected function block.

**Call:** Main menu “CFC ➔ Pins”, context menu “Pins”

**Requirements:** A CFC editor is active. A function block is selected.

See also

- ° Chapter 6.4.1.21.3.13.27 “Command 'Add Output Pin’” on page 2695

**Command 'Add Output Pin'**

Symbol: ![Symbol]

**Function:** The command adds a further output to the selected function block.

**Call:** Main menu “CFC ➔ Pins”, context menu “Pins”

**Requirements:** A CFC editor is active. A suitable function block is selected.

See also

- ° Chapter 6.4.1.21.3.13.26 “Command 'Add Input Pin’” on page 2695

**Command 'Route All Connections'**

Symbol: ![Symbol]

**Function:** This command cancels all manual changes to the connections in the program and re-establishes the original state.

**Call:** Main menu “CFC ➔ Routing”, context menu “Routing”

**Requirements:** A CFC editor is active.

CODESYS cannot automatically route connections that are fixed by control points. You must remove the control points before executing the command. Use the “Remove Control Point” command to do this. Furthermore you must disconnect connections that have been changed manually and are marked by the ![Icon] icon. Use the “Disconnect Connection” command to do this.

See also

- ° Chapter 6.4.1.21.3.13.29 “Command 'Remove Control Point’” on page 2695
- ° Chapter 6.4.1.21.3.13.21 “Command 'Unlock Connection’” on page 2693

**Command 'Remove Control Point'**

**Function:** This command removes a control point.

**Call:** Context menu “Routing”

**Requirements:** A CFC editor is active. You have selected a connecting line.
If you move the mouse pointer over a selected connecting line, the existing control points are displayed with yellow circle symbols. Set the cursor on the control point to be deleted and execute the command from the context menu.

See also
- Chapter 6.4.1.20.1.7.6.2 “CFC element ’Control Point’” on page 2109
- Chapter 6.4.1.21.3.13.30 “Command ’Create Control Point’” on page 2696

Command ’Create Control Point’

Symbol: ▲

Function: The command creates a control point on a connecting line.

Call: Context menu “Routing”

Requirements: A CFC editor is active. The cursor is over a connection.

The control point is created in the position on the connection at which the cursor is located when calling the command. The command corresponds to the “Control Point” element in the “Tools” window.

See also
- Chapter 6.4.1.20.1.7.6.2 “CFC element ’Control Point’” on page 2109
- Chapter 6.4.1.21.3.13.29 “Command ’Remove Control Point’” on page 2695

Command ’Connection Mark’

Symbol: ☀

Function: This command switches the display of the connection between two elements back and forth between a connecting line and the use of connection marks.

Call: Main menu “CFC”, context menu

Requirements: A CFC editor is active. A connection or a connection mark is selected.

If you have selected a connecting line, the command removes this line and adds a “Connection Mark - Source” at the output of one element and a “Connection Mark - Sink” at the input of the other. Both are given the same name by default, “C-<n>”, where n is a sequential number.

If you select a pair of connection marks, the command converts these marks into a connecting line.

See also
- Chapter 6.4.1.20.1.7.6.12 “CFC element ’Connection Mark - Source/Sink’” on page 2112

Command ’Create group’

Symbol: ☀

Function: This command groups the selected elements.

Call: Main menu “CFC ➔ Group”, context menu “Group”

Requirements: A CFC editor is active. Several elements are selected.

Grouped elements can only be moved together. The position of the elements is not affected by the grouping.

See also
- Chapter 6.4.1.21.3.13.33 “Command ’Ungroup’” on page 2697
Command 'Ungroup'

Symbol: 

**Function:** The command undoes a previous grouping.

**Call:** Main menu “CFC ➔ Group”, context menu “Group”

**Requirements:** A CFC editor is active. A grouping is selected.

See also

- % Chapter 6.4.1.21.3.13.32 “Command 'Create group’” on page 2696

Command 'Prepare Box for Forcing'

This command is required when using compiler versions 3.5.11.x and 3.5.12.x. The command is no longer required for compiler versions >= 3.5.13.0.

**Function:** The command activates and deactivates the forceability of the inputs for a function block element.

**Call:**
- CFC
- Context menu

**Requirements:** The CFC editor is in offline mode and a function block element is selected.

After executing the command, the “Force Function Block Input” command is available in online mode to open a dialog for forcing the box input values.

See also

- % Chapter 6.4.1.21.3.13.35 “Command ‘Force Function Block Input’” on page 2697
- % Chapter 6.4.1.20.1.7.2 “CFC Editor” on page 2098
- % Chapter 6.4.1.12.5 “Forcing and Writing of Variables” on page 1987

Command 'Force Function Block Input'

**NOTICE!**

This kind of forcing uses a data breakpoint internally and is therefore different from forcing with the “Force Values” command or [F7].

Values that were forced by the command “Force FB Input” do not respond to the commands “Show All Forces” or “Unforce Values”.

**Function:** The command opens the “Force Value” dialog to force the selected input of a function block. Forcing can be canceled with the same command and dialog.

**Call:**
- CFC
- Context menu

**Requirements:**

- The CFC editor is in online mode and the input of the function block is selected.
- For compiler versions 3.5.11.x and 3.5.12.x, the “forceability” of the function block is enabled by the “Prepare Box for Forcing” command.

In the “Force Value” dialog, you can either specify a value that the input of the function block should be forced, or remove the currently forced value.
After forcing, the input is highlighted in green again. Boolean inputs get a small monitoring view with the forced value. The forced value is displayed in the “Value” column of monitoring views (in the declaration part of the POU or in a watch list).

**Dialog 'Force Value'**

<table>
<thead>
<tr>
<th>“Expression”</th>
<th>Name of the function block input. Example: TON_1.IN.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Type”</td>
<td>Data type of the input</td>
</tr>
</tbody>
</table>

**Table 517: “What do you want to do?”**

| “Set a new value to force” | ☑: You can specify a new value in the input field. The format has to correspond to the data type. |
| “Remove value”             | ☑: Forcing at the input is canceled.                  |

See also

- ☑ Chapter 6.4.1.20.1.7.2 “CFC Editor” on page 2098
- ☑ Chapter 6.4.1.12.5 “Forcing and Writing of Variables” on page 1987
- ☑ Chapter 6.4.1.21.3.13.34 “Command 'Prepare Box for Forcing’” on page 2697

**Command 'Use Attributed Member as Input’**

Symbol: →[1]

**Function:** This command allows for connecting a structure member to a scalar type input.

**Call:** Menu bar: “CFC ➔ Pins”; context menu: “Pins”

**Requirements:** A CFC editor is active and a function block input is selected.

The member of the structure that is connected to the input of the subsequent function block must be provided with the pragma `{attribute 'ProcessValue'}. The data type of the structure member has to be compatible with the data type of the subsequent input. Inputs connected in this way are flagged with the "V" symbol.
Example

TYPE QINT :
STRUCT
   Status : STRING;
   {attribute 'ProcessValue'}
   Value1 : INT;
   Value2 : INT;
END_STRUCT
END_TYPE

PROGRAM PLC_PRG
VAR
   input1: QINT;
   output1: QINT;
   intValue: INT;
END_VAR

If you do not execute the command “Use attributed member as input” for this link, then a compiler error is issued.

See also
- "Chapter 6.4.1.20.6.3.39 "Attribute ‘ProcessValue” on page 2312"
Menu 'FBD/LD/IL'

Command 'Insert Network'.................................................... 2700
Command 'Insert Network (Below)'....................................... 2701
Command 'Toggle Network Comment State'................................. 2701
Command 'Insert Assignment'............................................... 2701
Command 'Insert Box'........................................................... 2701
Command 'Insert Box with EN/ENO'..................................... 2702
Command 'Insert Empty Box'................................................ 2702
Command 'Insert Empty Box with EN/ENO'.............................. 2702
Command 'Insert Box Parallel (Below)'................................ 2702
Command 'Insert Jump'....................................................... 2703
Command 'Insert Label'....................................................... 2703
Command 'Insert Return'..................................................... 2703
Command 'Insert Input'........................................................ 2703
Command 'Insert Coil'........................................................ 2704
Command 'Insert Set Coil'.................................................. 2704
Command 'Insert Reset Coil'................................................. 2704
Command 'Insert Contact'................................................... 2704
Command 'Insert Contact (Right)'.................................... 2705
Command 'Insert Contact in Parallel (Below)'........................ 2705
Command 'Insert Contact in Parallel (Above)'.......................... 2706
Command 'Toggle Parallel Mode'.......................................... 2706
Command 'Insert Negated Contact'...................................... 2706
Command 'Insert Negated Contact Parallel (Below)'............... 2706
Command 'Paste Contacts: Paste Below'................................ 2706
Command 'Paste Contacts: Paste Above'................................ 2706
Command 'Paste Contacts: Paste Right (After)'........................ 2707
Command 'Insert IL Line Below'.......................................... 2707
Command 'Delete IL Line'................................................... 2707
Command 'Negation'......................................................... 2708
Command 'Edge Detection'.................................................. 2708
Command 'Set/Reset'.......................................................... 2708
Command 'Set Output Connection'....................................... 2708
Command 'Insert Branch'.................................................... 2709
Command 'Insert Branch Above'.......................................... 2709
Command 'Insert Branch Below'.......................................... 2709
Command 'Set Branch Start Point'..................................... 2709
Command 'Set Branch End Point'......................................... 2710
Command 'Update Parameters'............................................. 2710
Command 'Remove Unused FB Call Parameters'.......................... 2710
Command 'Repair POU'....................................................... 2710
Command 'View as Function Block Diagram'............................ 2711
Command 'View as Ladder Logic'......................................... 2711
Command 'View as Instruction List'..................................... 2711
Command 'Go to'................................................................. 2712

Command 'Insert Network'
Symbol: [\[I], shortcut: [Ctrl] + [I]
Function: This command inserts a further network in the FBD/LD/IL editor.
Call: Main menu "FBD, LD, IL", context menu
Requirements: The FBD, LD or IL editor is active. No box is selected.

See also
- Chapter 6.4.1.20.1.6.4.1 “FBD/LD/IL element 'Network’” on page 2091
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082
- Chapter 6.4.1.21.3.14.2 “Command ‘Insert Network (Below)’” on page 2701

Command 'Insert Network (Below)'
Symbol: [F], shortcut: [Ctrl]+[T]
Function: This command inserts a further network in the FBD/LD/IL editor below the selected network.
Call: Main menu “FBD, LD, IL”, context menu
Requirements: The FBD, LD or IL editor is active. No box is selected.
See also
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082

Command 'Toggle Network Comment State'
Symbol: [Ctrl]+[O]
Function: The command comments the selected network in or out.
Call: Main menu “FBD, LD, IL”, context menu
Requirements: The FBD, LD or IL editor is active. A network is selected, but no box is selected.
See also
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082

Command 'Insert Assignment'
Symbol: [Ctrl]+[A]
Function: This command inserts an assignment in the FBD or LD editor.
Call: Main menu “FBD/LD/IL”, context menu
Requirements: The FBD, LD or IL editor is active. A network is selected, but no box is selected.

In IL an assignment is programmed via the operators LD and ST.

See also
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082

Command 'Insert Box'
Symbol: [Ctrl]+[B]
Function: This command inserts a box that is available in the project at the end of the selected network.
Call: Main menu “FBD, LD, IL”, context menu
Requirements: The FBD, LD or IL editor is active. A network is selected, but no box is selected. If you select this command the input assistant opens, where you can select the desired box.

See also
- Chapter 6.4.1.20.1.6.4.2 “FBD/LD/IL element 'Box'” on page 2092
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082
- Chapter 6.4.1.9.7 “Using input assistance” on page 1885

Command 'Insert Box with EN/ENO'
Symbol: [ reopened ], shortcut: [Ctrl] + [Shift] + [E]
Function: This command inserts a box with a boolean input “Enable” and a boolean output “Enable Out” at the end of the selected network.
Call: Main menu “FBD, LD, IL”, context menu
Requirements: the FBD, LD or IL editor is active. A network is selected, but no box is selected.
See also
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082
- Chapter 6.4.1.9.7 “Using input assistance” on page 1885

Command 'Insert Empty Box'
Symbol: opened , shortcut: [Ctrl] + [Shift] + [B]
Function: This command inserts an empty function block at the end of the currently selected network.
Call: Main menu “FBD/LD/IL”, context menu
Requirements: The FBD, LD or IL editor is active. A network is selected, but no box is selected.
See also
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082

Command 'Insert Empty Box with EN/ENO'
Symbol: reopened
Function: The command inserts an empty box with a Boolean input “Enable” and a Boolean output “Enable Out” at the end of the selected network.
Call: Main menu “FBD/LD/IL”, context menu
Requirements: The FBD editor, the IL editor or the LD editor is active. A network must be selected. No other box may be selected.
If “Enable” has the value FALSE at the time of the function block call, then the operations defined in the FB are not executed. Otherwise, if “Enable” has the value TRUE, these operations are executed. The ENO output acts as a repeater of the EN input.
See also
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082

Command 'Insert Box Parallel (Below)'
Function: This command inserts an empty box parallel below the selected function block.
Call: Menu bar: “FBD/LD/IL”; context menu.
**Requirements**: A box is selected in the LD editor.

See also

- [Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082](#)

**Command 'Insert Jump’**

Symbol ➔, shortcut: [Ctrl]+[L]

**Function**: This command inserts a jump element before the selected element.

**Call**: Main menu “FBD/LD/IL”, context menu

**Requirements**: The FBD, LD or IL editor is active. A connecting line is selected.

See also

- [Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082](#)
- [Chapter 6.4.1.20.1.6.4.7 “FBD/LD/IL element ‘Jump’” on page 2093](#)

**Command 'Insert Label’**

Symbol: 

**Function**: This command inserts a jump label into the currently selected network.

**Call**: Main menu “FBD, LD, IL”, context menu

**Requirements**: The FBD, LD or IL editor is active. A network is selected. No jump label is selected.

See also

- [Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082](#)
- [Chapter 6.4.1.20.1.6.4.6 “FBD/LD/IL element 'Label’” on page 2093](#)

**Command 'Insert Return’**

Symbol: 

**Function**: This command inserts an element “Return” in the selected place.

**Call**: Main menu “FBD/LD/IL”, context menu

**Requirements**: The FBD, LD or IL editor is active. A box output is selected.

If a box is selected, the command “Append Input” is available in the context menu. The input is inserted at the lower end of the box.

See also

- [Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082](#)
- [Chapter 6.4.1.20.1.6.4.8 “FBD/LD/IL element 'Return’” on page 2093](#)

**Command 'Insert Input’**

Symbol: 

**Function**: This command adds a further input to an extendable box (ADD, OR, ADD, MUL, SEL) above the selected input.

**Call**: “FBD/LD/IL” menu

**Requirements**: The FBD or LD editor is active. An input of a box is selected.
Command 'Insert Coil'
Symbol: W, shortcut: [Ctrl] + [A]

Function: This command inserts a coil into the network.
Call: Main menu “FBD, LD, IL”, context menu
Requirements: The LD editor is active. A network, a coil or a connecting line is selected, but no box is selected.
See also
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082
- Chapter 6.4.1.20.1.6.4.12 “LD element ‘Coil’” on page 2095

Command 'Insert Set Coil'
Symbol: ↔
Function: This command inserts a set coil into the network.
Call: Main menu “FBD, LD, IL”, context menu
Requirements: The LD editor is active. A network, a coil or a line is selected, but no box is selected.
See also
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082

Command 'Insert Reset Coil'
Symbol: ↔
Function: This command inserts a reset coil into the network.
Call: Main menu “FBD, LD, IL”, context menu
Requirements: The LD editor is active. A network, a coil or a line is selected, but no box is selected.
See also
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082
- Chapter 6.4.1.20.1.6.4.12 “LD element ‘Coil’” on page 2095
- “Ladder diagram (LD)” on page 1860

Command 'Insert Contact'
Symbol: ⬤, shortcut: [Ctrl] + [K]
Function: This command inserts a contact to the left of the selected element.
Call: Main menu “FBD/LD/IL”, context menu
Requirements: The LD editor is active. A line or a contact is selected.
See also
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082
- Chapter 6.4.1.20.1.6.4.11 “LD element ‘Contact’” on page 2094
Command 'Insert Contact (Right)'

Symbol: ☑️, shortcut: [Ctrl] + [D]

Function: This command inserts a contact to the right of the selected element.

Call: Main menu “FBD/LD/IL”, context menu

Requirements: The LD editor is active. A line, a contact or a box is selected.

See also
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082
- Chapter 6.4.1.20.1.6.4.11 “LD element 'Contact'” on page 2094

Command 'Insert Contact in Parallel (Below)'

Symbol: ☑️; keyboard shortcut: [Ctrl]+[R]

Function: This command inserts a contact with lines in parallel with and below the selected element.

Call: Menu bar: “FBD/LD/IL”; context menu.

Requirements: The LD editor is active. A line or a contact or a box is selected.

You can program closed parallel branches in a LD network as short circuit evaluation (SCE) or OR constructs. SCE branches are displayed with double vertical lines, and OR branches with single lines. Refer to the help page for “Closed branches”.

See also
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082
- Chapter 6.4.1.21.3.14.20 “Command 'Insert Contact in Parallel (Above)’” on page 2705
- Chapter 6.4.1.20.1.6.4.14 “Closed branch” on page 2096

Command 'Insert Contact in Parallel (Above)'

Symbol: ☑️; keyboard shortcut: [Ctrl]+[P]

Function: This command inserts a contact with lines in parallel with and above the selected element.

Call: Menu bar: “FBD/LD/IL”; context menu.

Requirements: The LD editor is active. A line, a contact or a box is selected.

You can program closed parallel branches in a LD network as short circuit evaluation (SCE) or OR constructs. SCE branches are displayed with double vertical lines, and OR branches with single lines. Refer to the help page for “Closed branches”.
Command 'Toggle Parallel Mode'

**Function:** This command toggles a parallel branch between an OR construct and the Short Circuit Evaluation (SCE).

**Call:** Menu bar: “FBD/LD/IL”; context menu.

**Requirements:** The LD editor is active. A vertical line of a parallel branch is selected.

---

You can program closed parallel branches in a LD network as short circuit evaluation (SCE) or OR constructs. SCE branches are displayed with double vertical lines, and OR branches with single lines. Refer to the help page for “Closed branches”.

---

Command 'Insert Negated Contact'

**Symbol:** ☞, shortcut: [Ctrl] + [K]

**Function:** This command inserts a negated contact to the left of the selected element.

**Call:** Main menu “FBD/LD/IL”, context menu

**Requirements:** The LD editor is active. A line or a contact is selected.

See also

- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082
- Chapter 6.4.1.20.1.6.4.11 “LD element ‘Contact’” on page 2094

Command 'Insert Negated Contact Parallel (Below)'

**Symbol:** ☞

**Function:** The command inserts a negated contact with lines in parallel with and below the selected element.

**Call:** Main menu “FBD/LD/IL”, context menu

**Requirements:** The LD editor is active. A line, a contact or a box is selected.

See also

- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082
- Chapter 6.4.1.9.5.2.3 “Programming ladder diagrams (LD)” on page 1864
Command 'Paste Contacts: Paste Below'

Shortcut: [Ctrl] + [F]

Function: This command inserts a previously copied contact with lines below the selected element.

Call: Main menu “FBD/LD/IL ➔ Paste”, context menu

Requirements: the LD editor is active.

See also
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082
- Chapter 6.4.1.20.1.6.4.11 “LD element ‘Contact’” on page 2094

Command 'Paste Contacts: Paste Above'

Shortcut: [Ctrl] + [F]

Function: This command inserts a previously copied contact with lines above the selected element.

Call: Main menu “FBD/LD/IL ➔ Paste Contacts”, context menu

Requirements: the LD editor is active. A line or a contact is selected.

See also
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082
- Chapter 6.4.1.20.1.6.4.11 “LD element ‘Contact’” on page 2094

Command 'Paste Contacts: Paste Right (After)'

Shortcut: [Ctrl] + [G]

Function: this command inserts a previously copied contact to the right of the selected element.

Call: Main menu “FBD/LD/IL ➔ Paste Contacts”, context menu

Requirements: The LD editor is active. A line or a contact is selected.

See also
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082
- Chapter 6.4.1.20.1.6.4.11 “LD element ‘Contact’” on page 2094

Command 'Insert IL Line Below'

Symbol: 

Function: The command inserts an instruction line below the selected line.

Call: Main menu “FBD/LD/IL”, context menu

Requirements: The IL editor is active. A line is selected.

See also
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082

Command 'Delete IL Line'

Symbol: , shortcut: [Ctrl]+[Del]

Function: This command deletes the selected instruction line.
Command 'Negation'

Symbol: 
, shortcut: [Ctrl] + [N]

Function: This command negates the following elements:

- Input/output of a box
- Jump
- Return
- Coil

Call: Main menu “FBD/LD/IL”, context menu

Requirements: The IL editor is active. A line is selected.

See also

- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082

Command 'Edge Detection'

Symbol FBD: 
, symbol LD: 
, shortcut: [Ctrl] + [N]

Function: This command inserts an edge detector before the selected box input or box output.

Call: Main menu “FBD/LD/IL”, context menu

Requirements: The FBD or LD editor is active. A box input or box output is selected.

See also

- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082

Command 'Set/Reset'

Symbol: 
, shortcut [Ctrl] + [M]

Function: In the case of an element with a boolean output, this command switches between reset, set and no mark.

Call: Main menu “FBD/LD/IL”, context menu

Requirements: The FBD or LD editor is active. An element with a boolean output is selected.

See also

- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082

Command 'Set Output Connection'

Symbol: 
, shortcut [Ctrl] + [W]

Function: This command turns the selected box output into the forwarding box output.

Call: Main menu “FBD/LD/IL”, context menu

Requirements: The FBD or LD editor is active. One of several box outputs is selected.
Command 'Insert Branch'

Symbol: ➔, shortcut [Ctrl] + [Shift] + [V]

Function: This command creates an open line branch on the selected line.

Call: Main menu “FBD/LD/IL”, context menu

Requirements: The FBD or LD editor is active. An input or an output of a box is selected.

See also
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082

Command 'Insert Branch Above'

Symbol:

Function: This command inserts a line branch above the selected open line branch.

Call: Main menu “FBD/LD/IL”, context menu

Requirements: The FBD or LD editor is active. An open line branch is selected.

See also
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082
- Chapter 6.4.1.20.1.6.4.9 “FBD/LD/IL element 'Branch'” on page 2093

Command 'Insert Branch Below'

Symbol:

Function: This command inserts a line branch below the selected open line branch.

Call: Main menu “FBD/LD/IL”, context menu

Requirements: The FBD or LD editor is active. An open line branch is selected.

See also
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082
- Chapter 6.4.1.20.1.6.4.9 “FBD/LD/IL element 'Branch'” on page 2093

Command 'Set Branch Start Point'

Symbol: 

Function: This command sets the starting point of a line branch on the selected line.

Call: Main menu “FBD/LD/IL”, context menu

Requirements: The LD editor is active. A line is selected.

See also
- Chapter 6.4.1.20.1.6.4.14 “Closed branch” on page 2096
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082
Command 'Set Branch End Point'

Symbol: §

Function: This command sets the end point of a line branch on the selected line.

Call: Main menu “FBD/LD/IL”, context menu

Requirements: The LD editor is active. A line is selected. A starting point of the line branch has been set.

See also
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082
- Chapter 6.4.1.20.1.6.4.14 “Closed branch” on page 2096

Command 'Update Parameters'

Function: This command enters changes to the declaration of the selected element in the diagram.

Call: Main menu “FBD/LD/IL”, context menu

Requirements: The FBD, LD or CFC editor is active. A box is selected. An extending change has been made to the declaration.

The command checks whether a box and its declaration in the declaration editor correspond. The change is accepted for the box only if the declaration was extended. Deletions and overwrites are not updated.

See also
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082

Command 'Remove Unused FB Call Parameters'

Symbol: 🌊

Function: This command deletes inputs and outputs of the selected box to which no variable and no value were assigned. However, the default inputs and outputs are always retained.

Call: Main menu “FBD/LD/IL”, context menu

Requirements: The FBD or LD editor is active. A box is selected. The box has interfaces to which no value is assigned.

See also
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082

Command 'Repair POU'

Symbol: 🧤

Function: This command repairs internal inconsistencies in the selected box.

Call: Main menu “FBD/LD/IL”, context menu

Requirements: The FBD or LD editor is active. The defective box is selected. The editor has found internal inconsistencies in the programming module that can possibly be resolved automatically. CODESYS reports the inconsistencies in the Message window.

This situation is conceivable when editing a project that was created with an older programming system version that did not yet handle the inconsistency concerned as an error.

See also
- Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082
Command 'View as Function Block Diagram'

**CAUTION!**

**Loss of data!** An error-free conversion requires syntactically correct code. Otherwise parts of the implementation can be lost.

Shortcut: [Ctrl] + [1]

**Function:** This command converts the active instruction list or the active ladder diagram into the function block diagram.

**Call:** Menu “FBD/LD/IL ➔ View”

**Requirements:** The LD or IL editor is active.

See also

- Chapter 6.4.1.20.1.6.1 "FBD/LD/IL Editor" on page 2082

Command 'View as Ladder Logic'

**CAUTION!**

**Loss of data!** An error-free conversion requires syntactically correct code. Otherwise parts of the implementation can be lost.

Shortcut: [Ctrl] + [2]

**Function:** This command converts the current function block code or the active instruction list into a ladder diagram.

**Call:** Menu “FBD/LD/IL ➔ View”

**Requirements:** The FBD or IL editor is active.

See also

- Chapter 6.4.1.20.1.6.1 "FBD/LD/IL Editor" on page 2082

Command 'View as Instruction List'

If necessary, IL can be activated in the CODESYS options.

**CAUTION!**

**Loss of data!** An error-free conversion requires syntactically correct code. Otherwise parts of the implementation can be lost.

Shortcut: [Ctrl] + [3]

**Function:** This command converts the active function block code or the active ladder diagram into an instruction list.

**Call:** Menu “FBD/LD/IL ➔ View”

**Requirements:** The LD or FBD editor is active.
See also
- ☀ Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082

Command 'Go to'

Symbol:

Function: This command allows you to jump to any network.

Call: Main menu “FBD/LD/IL”

Requirements: The LD, FBD or IL editor is active. A network is selected.

This command opens a dialog box with an input field. Enter the number of the desired network in the input field.

See also
- ☀ Chapter 6.4.1.20.1.6.1 “FBD/LD/IL Editor” on page 2082

Menu 'Library'

<table>
<thead>
<tr>
<th>Section</th>
<th>Function</th>
<th>Call</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.4.1.21.3.15.1</td>
<td>Command 'Add Library'</td>
<td>Main menu “Libraries”</td>
<td>The Library Manager is open in the editor.</td>
</tr>
<tr>
<td>6.4.1.21.3.15.2</td>
<td>Command 'Try to Reload Library'</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6.4.1.21.3.15.3</td>
<td>Command 'Properties'</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6.4.1.21.3.15.4</td>
<td>Command 'Placeholders'</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6.4.1.21.3.15.5</td>
<td>Command 'Export Library'</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Command 'Add Library'

Function: The command opens the “Add Library” dialog. In this dialog, you can add libraries to the Library Manager and then integrate them in your application.

Call: Menu bar: “Libraries”

Requirement: The Library Manager is open in the editor.

Dialog 'Add Library'

In the line above the library list, you can search for library names or library modules by typing an appropriate string.

<table>
<thead>
<tr>
<th>“Library”</th>
<th>Suitable libraries that are installed in the library repository. For example, the selection of libraries is defined in the device description or by the system integrator. By default, the displayed libraries are grouped into categories.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Company”</td>
<td>Vendor of the library</td>
</tr>
<tr>
<td>“Advanced”</td>
<td>Opens the advanced “Add Library” dialog</td>
</tr>
<tr>
<td></td>
<td>The displayed libraries are grouped into categories.</td>
</tr>
<tr>
<td></td>
<td>The displayed libraries are listed in alphabetical order.</td>
</tr>
<tr>
<td></td>
<td>All available libraries are displayed.</td>
</tr>
</tbody>
</table>

Specific libraries can be blacklisted in a device description. These libraries cannot be added below this device in the Library Manager.
You should use this dialog only if you have expert knowledge of library referencing. Using this dialog, you can link special versions or change placeholder definitions.

We recommend seriously that you follow the guidelines for the creation of libraries when developing and referencing libraries.

Table 518: Tab 'Library'

<table>
<thead>
<tr>
<th>“Company”</th>
<th>Filtering the list according to vendor</th>
</tr>
</thead>
</table>
| “Group by category” | ✅: Display of the libraries in a tree structure grouped in categories.  
                  | ❌: Display of the libraries in alphabetical order in a flat structure. |
| “Display all versions” | ✅: Display of all versions of the libraries. Version specification ‘*’ means the latest version available in the repository.  
                  | ❌: Display of the latest versions of the libraries only. A multiple selection of libraries is possible in this display. To do this, hold down the [Shift] key and select the entries. |
| “Details” | Opens a detailed view with the library modules. |
| “Library Repository” | Opens the “Library Repository” dialog. There you can install more libraries to your local system. |

Table 519: Tab ‘Placeholder’

| “Placeholder name” | The input field provides a combo box for entering the valid placeholder names that are read from the currently accessible device descriptions. You can also enter a new placeholder name in order to define a free placeholder, which is not resolved by the device or by the library profile. |
| “Default library” | CODESYS uses this library when for any reason no device is available that the resolution defines. In this way it is possible to compile the current project without errors. |

Note about placeholder resolution

For compiler version V3.5.8.0 and later, the following statement applies in the case of library placeholders with a resolution in the device description that are located in the Library Manager of the POU pool. This placeholder is always resolved automatically according to the description of the device that compiles the application.

See also

- § Chapter 6.4.1.21.3.5 “Command ‘Library Repository’” on page 2657
- § Chapter 6.4.1.17.3 “Information for Library Developers” on page 2035
- § Chapter 6.4.1.21.3.15.4 “Command ‘Placeholders’” on page 2716

Command ‘Try to Reload Library’

**Function:** This command tries to reload the selected library.

**Call:** Main menu “Library”.

**Requirement:** A library is selected that failed to load.
If for any reason a library is not available in the defined repository location when a project is opened, CODESYS displays a corresponding error message. Once you have rectified the error, i.e. when the library is properly available again, you can reload the library with this command without having to leave the project.

See also

- Chapter 6.4.1.21.3.9.5 “Command 'Library Repository’” on page 2657

Command 'Properties'

**Function:** The command opens the “Properties” dialog for the library selected in the Library Manager.

**Call**

- Menu bar: “Library”
- Context menu of the selected library
- Symbol in the toolbar of the Library Manager

**Requirement:** A library is selected.

**NOTICE!**

This dialog is intended for library developers. Use this only if you have profound knowledge of library referencing. In addition, follow the guidelines for library developers.

See also

- Chapter 6.4.1.17.3 “Information for Library Developers” on page 2035

**Dialog 'Properties’**

**Table 520: “General”**

<table>
<thead>
<tr>
<th>“Namespace”</th>
<th>Namespace of the selected library. By default, this is identical to the library name, unless it was defined explicitly in the project information when the library was created. You can change the namespace for the open project. Example: LA</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Default”:</th>
<th>Library that triggers the placeholder when no other trigger is defined or is possible. Requirement: The selected library is a library placeholder, and therefore the setting is available. Note: For compiler version 3.5.8.0 and higher, the following statement applies in the case of library placeholders with a resolution in the device description that are located in the Library Manager of the “POUs” view. This placeholder is always resolved automatically according to the description of the device that compiles the application.</th>
</tr>
</thead>
</table>

**If the selected library is developed in compliance with the “Guidelines for Developing Libraries”, then we do not recommend that you change the following settings.**
Table 521: “Version”

<table>
<thead>
<tr>
<th>Selection of version constraint</th>
<th>Requirement: The settings are available only if the selected library is <strong>not</strong> a library placeholder.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> Container and interface libraries are created automatically with library references with version constraint. As far as possible, do not create libraries that include library references with version constraint. Otherwise, you reference the libraries by placeholders. Edit a placeholder resolution in the “Placeholders” dialog.</td>
<td></td>
</tr>
</tbody>
</table>

| “Exact version” | ☑: (selected from list box) Version is integrated into the project. Note: This option is strongly recommended for container libraries, and it is usually preset for this library type. |
| “Always newest version” | ☑: The library repository is scanned and the latest detected version is integrated. Note: If a newer library version is available, then the library POUs that are actually used can change. This option is strongly recommended for interface libraries, and it is usually preset for this library type. |

Table 522: “Visibility”

| “Allow only qualified access to all identifiers” | ☑: Library POUs (and variables) are called in the project only with prepended namespace paths. |
| “When the current project is referenced as a library in another project” | Note: Changing the following settings makes sense only if you created a library with your project and therefore opened a library project. In this way, the selected library is referenced in the new library. |
| “Make visible all IEC symbols in the project if this reference were directly integrated here.” | ☑: As a container library, the selected library makes the contents of the referenced library visible at the top level (later in a project). Requirement: A container project is created with a library project. A container library does not implement its own POUs, but references other libraries exclusively. It bundles libraries. A container library can be employed sensibly to bundle multiple libraries (in a reference) in a project. This option **must** be activated for each library reference. Symbolic access to library POUs: `<namespace of container library>.<POU name>` |
| | ☐: The contents of the referenced library is accessed uniquely by means of the namespace. The path name consists of the library name and the unique name (library reference), and it is prepended to the POU name. Requirement: **No** container project is created with a library project. |
| “Do not show this reference in the dependency tree.” | ☑: The selected library is not displayed in the Library Manager as a library reference (later in a project). The library is a hidden reference. Warning: If there are compile errors resulting from hidden library errors, then detecting the errors may be difficult. ☐: The selected library is displayed as a library reference (later in a project). |
| “Optional (if the library is missing, no error will be reported).” | ☑: The selected library is treated as optional. When downloading the project that references the library, no error is reported, even if the library is **not** available in the library repository. |

See also
- ☆ Chapter 6.4.1.21.3.15.4 “Command ‘Placeholders’” on page 2716
Command 'Placeholders'

**Function:** This command opens the “Placeholders” dialog box. The dialog shows information on the currently selected placeholder library and allows to assign a project-specific resolution.

**Call:**
- Menu “Libraries”
- Symbol in the symbol bar in the upper part of the Library Manager window.

**Requirement:** A placeholder library is selected in the Library Manager.

A placeholder library, which is included in the “Devices” view, will be resolved as follows:
- If you have assigned a specific resolution to the placeholder library via the dialog “Placeholder”, this will be applied.
- If no specific resolution is defined, it will be checked, whether there is one specified in the device description of the application.
- Afterwards the library profile will be checked for a resolution definition.
- The result is displayed in the Library Manager below the “Effective Version”.

A placeholder library, which is included in the “POUs” view, gets resolved as follows:
- A specific resolution defined in the dialog “Placeholder” will be ignored.
- For the application it will be checked whether there is a resolution defined in the device description.
- Afterwards the library profile will be checked.
- The result is displayed in the tooltip of the symbol.

See also
- Chapter 6.4.1.17 “Using Libraries” on page 2034
- Chapter 6.4.1.21.2.16 “Object ‘Library Manager’” on page 2469
- Chapter 6.4.1.17.3 “Information for Library Developers” on page 2035

**Dialog box 'Placeholders’**

<table>
<thead>
<tr>
<th>“Name”</th>
<th>Name of the placeholder.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Library”</td>
<td>Current resolution, valid for the project Double-click on the entry in order to edit the placeholder resolution. A selection list with the available library versions appears. Additionally the command “Other Library” is available.</td>
</tr>
</tbody>
</table>

**Command “Other Library”**

The command opens the dialog box “Bibliothek durchsuchen” for searching and installing libraries. Choose this command, if you do not want to redirect to another version, but on a specific library.

**“Info”**

Type of placeholder resolution:
- Resolved by device description
- Resolved by library profile
- Resolved by <specific library>

Command 'Export Library'

**Function:** This command is used for saving the library file to the hard disk.

**Call:** Context menu of the Library Manager

**Requirement:** A library is selected in the Library Manager.

The command opens the standard dialog for saving a file in the local file system. The library file can have the file type Library files (*.library), Compiled library files (*.compiled-library), or Compiled library files (*.compiled-library-v3).
Menu 'Image Pool'

6.4.1.21.3.16.1  Command 'Insert Image'........................................................ 2717

Command 'Insert Image'

Symbol: 

Function: This command inserts a new line into an image pool.

Call: Main menu “Imagepool”, or right-click.

Requirements: An image pool is active and a line is selected in the image pool.

See also

●  Chapter 6.4.1.21.2.15 “Object 'Image Pool’” on page 2468

Menu 'Declarations'

6.4.1.21.3.17.1  Command 'Insert'............................................................... 2717
6.4.1.21.3.17.2  Command 'Edit Declaration Header'...................................... 2717
6.4.1.21.3.17.3  Command 'Move Down'...................................................... 2718
6.4.1.21.3.17.4  Command 'Move Up'.......................................................... 2718

Command 'Insert'

Symbol: 

Function: This command inserts a new line for a variable declaration in the declaration editor and the input field for the variable name opens.

Call: Context menu in the tabular declaration editor; button in the declaration heading.

To edit the other fields of the declaration lines, double-click the fields and select the data from the drop-down lists or by means of the respective dialogs.

See also

●  Chapter 6.4.1.9.4.2 “Using the declaration editor” on page 1851

Command 'Edit Declaration Header'

Function: The command opens the dialog “Edit Declaration Header”, which serves in the declaration editor for the configuration of a POU header.

Call: Context menu of the tabular declaration editor

Requirements: The tabular declaration editor is the active editor.

See also

●  “Declaring in the tabular declaration editor” on page 1852

Dialog 'Edit Declaration Header'

Function: The dialog is for configuring the declaration part of a POU.

Call: Click on the header bar of the tabular declaration editor, or context menu in the tabular declaration editor.
### “Declaration” Selection list for changing the POU type

- “PROGRAM”
- “FUNCTION_BLOCK”
  - “EXTENDS”: Input field for a basic function block
  - “IMPLEMENTS”: Input field for an interface
- “FUNCTION”
  - “Return type”

Input field with current POU name: you can change the name of the POU

<table>
<thead>
<tr>
<th>“Automatically adapt all references on rename”</th>
<th>☑: Dialog box “Refactoring” opens.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>□: Renaming is only effective in the declaration header of the POU.</td>
</tr>
</tbody>
</table>

- “Attributes”
  The dialog box “Attribute ” opens for the input of attributes and pragmas.

See also

- Chapter 6.4.1.9.4.2 “Using the declaration editor” on page 1851
- Chapter 6.4.1.20.6 “Pragmas” on page 2269
- Chapter 6.4.1.9.16 “Refactoring” on page 1910

---

**Command 'Move Down’**

Symbol: 📈

**Function:** This command shifts a variable declaration downwards by one row.

**Call:** Context menu

**Requirement:** A row with a variable declaration is selected in the tabular declaration editor.

See also

- Chapter 6.4.1.9.4.2 “Using the declaration editor” on page 1851

**Command 'Move Up’**

Symbol: 🔻

**Function:** This command shifts a variable declaration upwards by one row.

**Call:** Context menu

**Requirement:** A row with a variable declaration is selected in the tabular declaration editor.

See also

- Chapter 6.4.1.9.4.2 “Using the declaration editor” on page 1851

---

**Menu 'Declarations' (Persistence)**

<table>
<thead>
<tr>
<th></th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.4.1.21.3.18.1</td>
<td>'Reorder List and Clean Gaps'</td>
</tr>
<tr>
<td>6.4.1.21.3.18.2</td>
<td>'Save Current Values to Recipe'</td>
</tr>
<tr>
<td>6.4.1.21.3.18.3</td>
<td>'Restore Values from Recipe'</td>
</tr>
<tr>
<td>6.4.1.21.3.18.4</td>
<td>'Add all instance paths'</td>
</tr>
</tbody>
</table>
Command 'Reorder List and Clean Gaps'

**Function:** This command cleans the gaps that can result when you make changes to the declaration of persistent variables. The memory requirement is reduced by this cleaning. When the command is executed, CODESYS displays a warning informing the user about the possible loss of data.

**Call:** Main menu “Declarations”, context menu

**Requirement:** The persistence editor (persistent variable list) is active.

Before cleaning you should consider saving the current values of the persistent variables to a recipe (command “Save Current Values to Recipe”). Then you can load the values to the controller again after the next download.

See also
- Chapter 6.4.1.9.19 “Data Persistence” on page 1920
- Chapter 6.4.1.21.3.18.3 “Command ‘Restore Values from Recipe’” on page 2719
- Chapter 6.4.1.21.3.18.2 “Command ‘Save Current Values to Recipe’” on page 2719

Command 'Save Current Values to Recipe'

**Function:** This command creates a new recipe definition in the recipe manager and stores the current values of the persistent variables in it. You should execute this command before the command “Reorder List and Clear Gaps” in order to avoid a possible loss of data. You can subsequently restore the data with the command “Restore Values from Recipe”.

**Call:** Main menu “Deklarationen”

**Requirement:** The application is in online mode and the persistence editor (persistent variable list) is active.

If a list already exists in the recipe manager with the corresponding names when saving a persistent variable list, then the current persistent variables are sorted into the list:

- New persistent variables are added to the list
- Variables, that are not in the list, will be deleted

Therefore, it is possible to add more recipes to the list in the recipe manager and these will be retained. However, if new variables are added to the list, then these are deleted the next time the command “Save Current Values to Recipe” is executed.

See also
- Chapter 6.4.1.9.19 “Data Persistence” on page 1920
- Chapter 6.4.1.21.3.18.1 “Command ‘Reorder List and Clean Gaps’” on page 2719
- Chapter 6.4.1.21.3.18.3 “Command ‘Restore Values from Recipe’” on page 2719
- Chapter 6.4.1.21.2.20 “Object ‘Persistent variable list’” on page 2476

Command 'Restore Values from Recipe'

**Function:** This command restores the values of the persistent variables that you have stored in a recipe using the command “Save Current Values to Recipe”. You would normally select this command after executing the command “Reorder List and Clear Gaps”.

**Call:** Main menu “Declarations”

**Requirement:** The persistence editor (persistent variable list) is active, the application is in online mode
Command 'Add all instance paths'

Function:
- When you execute the command in the persistence editor, the application is searched for declarations of persistent variables with the PERSISTENT keyword which are outside of the persistence editor. For each declaration found, an instance path of this variable is added in the persistence editor.
- When you execute the command in a variable configuration, an instance path is added for each variable with an incomplete address. All function blocks of the application are considered in this case.


Requirement
- the persistence editor (global persistent variable list) is active or a variable configuration (global variable list with VAR_CONFIG declarations) is opened.
- The application was compiled successfully.

See also
- Chapter 6.4.1.20.2.13 “Persistent Variable - PERSISTENT” on page 2122
- Chapter 6.4.1.20.2.14 “Retain Variable - RETAIN” on page 2124

Menu 'Device Communication', Gateway

6.4.1.21.3.19.1 Command 'Add New Gateway' ................................................... 2720
6.4.1.21.3.19.2 Command 'Configure the Local Gateway' ................................... 2721

Command 'Add New Gateway'

Function: This command opens the “Gateway” dialog where you can define a gateway channel and add it to the current device configuration.

Call: Menu bar: “Gateway” in the “Communication Settings” dialog of the device editor.

Dialog 'Gateway'

<table>
<thead>
<tr>
<th>“Name”</th>
<th>Name of the gateway.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Driver”</td>
<td>Driver type from a drop-down list.</td>
</tr>
</tbody>
</table>

Driver-specific settings, for example:
- IP address, port: Editable after double-clicking the predefined value. A short description for each parameter is displayed in the lower part of the dialog.
- Note: You can also specify the address of a DNS domain. This has to begin with dns: (example: dns:MyDynDNSAdress).

The dialog is also used for later editing of the gateway entries of your project.

See also
- Chapter 6.4.1.21.2.8.3 “Tab ‘Communication Settings’” on page 2427
Command 'Configure the Local Gateway'

**Function:** The command opens the “Gateway Configuration” dialog where you can configure the block drivers for the local gateway. This is an alternative to manually editing the configuration file `Gateway.cfg`.

**Call:** Context menu when a gateway entry is selected in the device editor in the “Communication Settings” dialog.

---

**NOTICE!**
A correct configuration of the gateway requires detailed knowledge. In case you have any doubts, do not change the default configuration settings.

---

**Dialog 'Gateway Configuration'**
The configuration tree displayed in the dialog corresponds to the description currently valid configuration file `gateway.cfg`. It displays the parameters with the current settings for the interfaces involved. Changes to the configuration in the dialog, confirmed by clicking “OK”, result in the direct update of the configuration file.

**i**
After the gateway configuration file `gateway.cfg` has been changed, the gateway has to be restarted in order for the changes to be applied.

---

<table>
<thead>
<tr>
<th>“Add”</th>
<th>Menu with commands for adding interfaces and settings. The commands are also available in the context menu of the dialog. The selection depends on which entry is selected and which settings have already been added:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>“Add Interface”: Select an interface for communication via the gateway. It is inserted at the top level of the tree. See the table below for the possible block driver interfaces.</td>
</tr>
<tr>
<td></td>
<td>“Add Configuration Setting”: Select a setting for the selected interface. It is inserted below the interface in the tree. To edit the value of the setting, double-click in the “Setting” column to open an editing field. See the table below for the possible settings per block driver interface.</td>
</tr>
</tbody>
</table>

| “Delete” | Deletes the selected configuration setting |

<p>| “Up”, “Down” | Moves the selected configuration entry one position up or down. |</p>
<table>
<thead>
<tr>
<th>Interface</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;COM Port&quot;</td>
<td>Serial port on the device, for example for data exchange according to the RS-232 standard on a COM port intended for this purpose.</td>
</tr>
<tr>
<td></td>
<td>Possible configuration settings:</td>
</tr>
<tr>
<td></td>
<td>&quot;Name&quot;: Symbolic only</td>
</tr>
<tr>
<td></td>
<td>&quot;Port&quot;: Physical serial port which is used for this interface, for example COM 5 on a Windows computer</td>
</tr>
<tr>
<td></td>
<td>&quot;Baudrate&quot;: 2400, 4800, 9600, 19200, 38400, 57600, 115200</td>
</tr>
<tr>
<td></td>
<td>&quot;Activate auto addressing&quot;: The setting Local address is evaluated. Both devices, which communicate via the serial port, will negotiate their addresses independently before they begin exchanging messages. If the addresses of both devices are the same, then they are negotiated again. This setting is useful when the local addresses cannot be set explicitly, for example for physically separated devices.</td>
</tr>
<tr>
<td></td>
<td>&quot;Local address&quot;: Evaluated only when &quot;Enable auto addressing&quot; is activated. Default = actual value for port</td>
</tr>
<tr>
<td>&quot;Shared Memory&quot;</td>
<td>Shared memory driver</td>
</tr>
<tr>
<td></td>
<td>Possible settings:</td>
</tr>
<tr>
<td></td>
<td>&quot;Name&quot;: Symbolic only</td>
</tr>
<tr>
<td></td>
<td>&quot;Forced address&quot;: Default = -1 (= no forced address); example: 42 means that the driver has to use the fixed address defined here and that addresses are assigned freely in the range 0-255. This setting can be useful when more than one shared memory driver is activated in the configuration.</td>
</tr>
<tr>
<td>&quot;Ethernet UDP/IP&quot;</td>
<td>Ethernet interface for data exchange according to the &quot;user datagram protocol&quot;.</td>
</tr>
<tr>
<td></td>
<td>Possible settings:</td>
</tr>
<tr>
<td></td>
<td>&quot;Name&quot;: Symbolic only</td>
</tr>
<tr>
<td></td>
<td>&quot;Port index&quot;: Port number for the communication. Port indices are in the range 0–3. They are mapped to the following Ethernet port: 1740 to 1743.</td>
</tr>
<tr>
<td></td>
<td>&quot;IP address&quot;: Default = 127.0.0.1. This setting can be useful to explicitly set an interface when the device has several network interfaces. Example: 127.0.0.1 stands for some local network interface, also known as localhost. Every other address (example: 10.27.7.72) represents a real IP address which has to be available on the device.</td>
</tr>
<tr>
<td></td>
<td>&quot;Network mask&quot;: Default = 255.255.255.0; example: 255.255.252.0. This setting can be useful to explicitly set an interface when there are multiple network interfaces on the device.</td>
</tr>
<tr>
<td></td>
<td>&quot;PPP remote address&quot;: Default = 127.0.0.1; example: 10.13.42.240; establishes a logical point-to-point connection between the UDP interface and the node named with the address specified here; has the effect that the UDP interface communicates exclusively with this node and that no broadcasts are sent in the network</td>
</tr>
<tr>
<td>&quot;Ethernet TCP/IP&quot;</td>
<td>Ethernet interface for data exchange according to the &quot;Transmission Control Protocol&quot;.</td>
</tr>
</tbody>
</table>
Possible settings:

"Name", "Port", "IP address": See Ethernet UDP/IP above.

"Inactivity timeout": Default = 0. This setting defines the time span (in seconds) after which the TCP connections are closed when data is no longer exchanged.

<table>
<thead>
<tr>
<th>“CAN Client”</th>
<th>“Name&quot;: Symbolic only</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A description for the other settings can be found directly in the dialog.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“USB Port”</th>
<th>“Name&quot;: Symbolic only</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A description for the other settings can be found directly in the dialog.</td>
</tr>
</tbody>
</table>

See also:

- § Chapter 6.4.1.21.2.8.3 “Tab 'Communication Settings'” on page 2427

Menu 'Recipes'

6.4.1.21.3.20.1 Command 'Insert Variable'................................................................. 2723
6.4.1.21.3.20.2 Command 'Add a New Recipe'................................................................. 2723
6.4.1.21.3.20.3 Command 'Remove Recipe'................................................................. 2724
6.4.1.21.3.20.4 Command 'Load Recipe'................................................................. 2724
6.4.1.21.3.20.5 Command 'Save Recipe'................................................................. 2724
6.4.1.21.3.20.6 Command 'Read Recipe'................................................................. 2725
6.4.1.21.3.20.7 Command 'Write Recipe'................................................................. 2725
6.4.1.21.3.20.8 Command 'Load and Write Recipe'......................................................... 2725
6.4.1.21.3.20.9 Command 'Read and Save Recipe'......................................................... 2726
6.4.1.21.3.20.10 Command 'Remove Variables'............................................................... 2726
6.4.1.21.3.20.11 Command 'Load Recipes from Device'.................................................. 2727
6.4.1.21.3.20.12 Command 'Update Structured Variables'................................................ 2727

Command 'Insert Variable'

Symbol: [view]

Function: This command inserts a variable into the currently opened recipe definition before the selected position.

Call: Main menu “Recipes”.

Requirement: You have opened a recipe definition in the editor and selected the normal view.

CODESYS inserts the default text "NewVariable" in the column “Variable”. You must replace this name with the respective variable name. To do this, open the input assistant by clicking or enter the variable name directly into the table element.

See also

- § Chapter 6.4.1.13.2.4 “Changing Values with Recipes” on page 2003
- § Chapter 6.4.1.21.3.20 “Menu 'Recipes'” on page 2723

Command 'Add a New Recipe'

Symbol: [add]

Function: This command opens a dialog box for adding a new recipe (new column) to the recipe definition.
Call: Main menu “Recipes”.

Requirement: You have opened a recipe definition in the editor.

After choosing the command, a dialog box opens for you to define the name of the new recipe. The dialog box also provides the capability of copying existing recipes into the new recipe.

See also
- Chapter 6.4.1.13.2.4 “Changing Values with Recipes” on page 2003
- Chapter 6.4.1.21.3.20 “Menu ‘Recipes’” on page 2723

Command ‘Remove Recipe’

Symbol: 🗑

Function: This command removes a recipe from the currently opened recipe definition.

Call: Main menu “Recipes”.

Requirement: You have selected a field in the recipe column of a recipe definition.

See also
- Chapter 6.4.1.13.2.4 “Changing Values with Recipes” on page 2003
- Chapter 6.4.1.21.3.20 “Menu ‘Recipes’” on page 2723

Command ‘Load Recipe’

Symbol: ✉

Function: The command loads a recipe from a file.

Call: Menu bar: “Recipes”.

Requirement: You have selected a field in the recipe column of a recipe definition.

This command overwrites the values of the selected recipe of the recipe definition.

If you have selected the option “Recipe Management in the PLC”, please note the following:

If you change recipes in the project by choosing the command “Load Recipe” or “Read Recipe”, then an online change is required when logging in again.

If you want to overwrite only individual recipe variables with new values, then remove the values for the other variables before loading to the recipe file. Entries without value definitions are not read, and therefore updating leaves these variables unchanged on the PLC and in the project.

For values of the data type REAL/LREAL, the hexadecimal value is also written to the recipe file in some cases. This is necessary so that the exact identical value is restored when converting back. In this case, change the decimal value and delete the hexadecimal value.

See also
- Chapter 6.4.1.13.2.4 “Changing Values with Recipes” on page 2003
- Chapter 6.4.1.21.3.20 “Menu ‘Recipes’” on page 2723

Command ‘Save Recipe’

Symbol: ✉
Function: This command saves the variable values of a recipe to a file.

Call: Main menu “Recipes”.

Requirement: You have selected the value of a recipe in the recipe definition.

When you choose this command, CODESYS saves the values of the selected recipe to a file. You can define the format in the settings for the recipe manager in the tab “Storage”.

See also
- § Chapter 6.4.1.13.2.4 “Changing Values with Recipes” on page 2003
- § Chapter 6.4.1.21.3.20 “Menu ‘Recipes’” on page 2723

Command 'Read Recipe'

Symbol: *<p>

Function: This command reads the variable values of a recipe from the controller.

Call: Main menu “Recipes”.

Requirement: The application is in online mode and you have selected the value of a recipe in the recipe definition.

When you choose this command, CODESYS overwrites the values of the selected recipe with the read values from the controller.

If you have selected the option “Recipe Management in the PLC”, please note the following.

If you change recipes in the project by choosing the command “Load Recipe” or “Read Recipe”, then an online change is required when logging in again.

See also
- § Chapter 6.4.1.13.2.4 “Changing Values with Recipes” on page 2003
- § Chapter 6.4.1.21.3 “Menu Commands” on page 2551

Command 'Write Recipe'

Symbol: *

Function: This command writes the values of a recipe to the variables in the controller.

Call: Main menu “Recipes”.

Requirement: The application is in online mode and you have selected the value of a recipe in the recipe definition.

When you choose this command, CODESYS overwrites the values in the controller with the values of the selected recipe.

See also
- § Chapter 6.4.1.13.2.4 “Changing Values with Recipes” on page 2003
- § Chapter 6.4.1.21.3.20 “Menu ‘Recipes’” on page 2723

Command 'Load and Write Recipe'

Symbol: 📊

Function: This command loads a recipe from a file and writes the values to the variables in the PLC.

Call: Menu bar: “Recipes”.
Requirement: The application is in online mode. You have selected the value of a recipe in the recipe definition.

After choosing the command, you are prompted either to write the variable values also to the recipe in the project or only to write them to the PLC. Updating the values in the recipe could require an online change when logging in again.

When you choose this command, CODESYS overwrites the values of the selected recipe of the recipe definition. In addition, these recipe values overwrite the variable values in the PLC.

If you want to overwrite only individual recipe variables with new values, then remove the values for the other variables before loading to the recipe file. Entries without value definitions are not read, and therefore updating leaves these variables unchanged on the PLC and in the project.

For values of the data type REAL/LREAL, the hexadecimal value is also written to the recipe file in some cases. This is necessary so that the exact identical value is restored when converting back. In this case, change the decimal value and delete the hexadecimal value.

See also
- “Chapter 6.4.1.13.2.4 “Changing Values with Recipes” on page 2003
- “Chapter 6.4.1.21.3.20 “Menu ‘Recipes’” on page 2723

Command 'Read and Save Recipe'

Symbol: 📑

Function: This command reads the variable values of a recipe from the controller and saves them to a file.

Call: Main menu “Recipes”.

Requirement: The application is in online mode and you have selected the value of a recipe in the recipe definition.

After choosing the command, you are prompted either to read the variable values to the recipe or only to save them. Updating the values in the recipe could require an online change when logging in again.

The values are saved with the default name for recipe files according to the settings for the recipe manager (tab “Storage”).

See also
- “Chapter 6.4.1.13.2.4 “Changing Values with Recipes” on page 2003
- “Chapter 6.4.1.21.3.20 “Menu ‘Recipes’” on page 2723

Command 'Remove Variables'

Symbol: 🗑️

Function: This command removes the selected variables from a “Recipe Definition”.

Call: The command is not in any menu by default. You can add it to a menu by using the dialog box from “Tools ➔ Customize” (command category “Recipe”).

See also
- “Chapter 6.4.1.13.2.4 “Changing Values with Recipes” on page 2003
- “Chapter 6.4.1.21.3.20 “Menu ‘Recipes’” on page 2723
Command 'Load Recipes from Device'

Symbol: 📋

**Function:** This command initiates the synchronization of the recipes from the open recipe definition in the project and the recipes located on the device in the form of recipe files.

**Call:** Menu bar: “Recipes”.

**Requirement:** The application is in online mode and a recipe definition is open in the editor.

In detail, the synchronization is described as follows:

- The current values for the recipe variables located in the project are overwritten by the values from the recipes on the controller. As a result, there is likely an online change at the next login.
- If recipe variables are defined in the recipe files on the controller, and the recipe variables are missing in the recipe definition of the project, then these variables are ignored when at the time of download. Before that, a message appears for each recipe file regarding the variables in question.
- If recipe variables are missing in the recipe files on the controller, and these recipe variables are included in the recipe definition of the project, then a message appears for each recipe file with the variables in question.
- If more recipes for these variables have been created on the controller, then they are added to the recipe definition in the project.

Command 'Update Structured Variables'

Symbol: ¬

**Function:** This command opens the “Update Structured Variables” dialog box.

**Call:** Main menu “Recipes”.

In this dialog box, you can update recipe definitions if the declaration of a structured variable or a block has changed. For example, if the dimension of an array is changed, then you can automatically add or remove the entries in the recipe definition.

<table>
<thead>
<tr>
<th>Table 524: Dialog Box 'Update Structured Variables'</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Remove not existing variables”</td>
</tr>
<tr>
<td>“Update instances of structures and function blocks”</td>
</tr>
<tr>
<td>“Update array dimensions of array instances”</td>
</tr>
<tr>
<td>“Update contained global variable lists”</td>
</tr>
<tr>
<td>“Update contained programs”</td>
</tr>
</tbody>
</table>

See also

- ☑ Chapter 6.4.1.13.2.4 “Changing Values with Recipes” on page 2003
- ☑ Chapter 6.4.1.21.3.20 “Menu ‘Recipes’” on page 2723
Menu 'Text List'

6.4.1.21.3.21.1 Command 'Add Language'.......................................................... 2728
6.4.1.21.3.21.2 Command 'Create Global Text List'.............................................. 2728
6.4.1.21.3.21.3 Command 'Export Everything as Text'......................................... 2728
6.4.1.21.3.21.4 Command 'Export All Unicode .txt Text List Files'.................... 2729
6.4.1.21.3.21.5 Command 'Insert Text'.............................................................. 2729
6.4.1.21.3.21.6 Command 'Import/Export Text Lists'.......................................... 2729
6.4.1.21.3.21.7 Command 'Remove Language'.................................................. 2730
6.4.1.21.3.21.8 Command 'Rename Language'................................................... 2730
6.4.1.21.3.21.9 Command 'Remove Unused Text List Entries'............................. 2731
6.4.1.21.3.21.10 Command 'Check Visualization Text IDs'................................ 2731
6.4.1.21.3.21.11 Command 'Update Visualization Text IDs'................................ 2731
6.4.1.21.3.21.12 Command 'Add Text List Support'........................................... 2732
6.4.1.21.3.21.13 Command 'Remove Text List Support'..................................... 2732

Command 'Add Language'

Symbol: 

Function: This command adds a further language column to the text list.

Call: Main menu “Textlist”, context menu

Requirement: A text list or a global text list is open and active.

In the dialog box “Enter Language”, enter a code for the new language, for example “en-US”. CODESYS inserts the code as column header.

Command 'Create Global Text List'

Symbol: 

Function: This command creates the global text list in the “POUs” view.

Call: “Visualization”, context menu.

Requirements: A visualization is open.

See also
- © Chapter 6.4.1.21.2.11 “Object ‘GlobalTextList’” on page 2465
- © Chapter 6.4.1.9.10.7 “Managing static text in global text lists” on page 1894

Command 'Export Everything as Text'

Symbol: 

Function: This command exports all the text lists of the project.

Call: Main menu “Textlist”, context menu

Requirement
- A text list or a global text list is open and active.
- The visualization does not code the characters of the texts in Unicode.

CODESYS creates a file as plain text in the format .txt for each text list. The name of the text list becomes the name of the file. The directory into which the files are exported is set in “Project ➔ Project Settings ➔ Visualization”, category “General” in “Text list files”.

A controller can read and use this format. For example, you can copy the file to a controller and, by means of a configuration in the visualization manager, prevent the text lists from being transmitted again when loading the application.
Command 'Export All Unicode .txt Text List Files' 

Function: This command exports all the text lists of the project.

Call: Main menu “Textlist”, context menu

Requirement

- A text list or a global text list is open and active.
- The visualization codes the characters of the texts in Unicode.
  - The option “Use Unicode strings” in the visualization manager is activated.
  - The compiler instruction VISU_USEWSTRING in the application is set. Check this by selecting the command “Properties” in the context menu of the application. Then select the “Compile” tab. VISU_USEWSTRING must be entered in the input field for “Compiler defines”.

CODESYS creates a file as plain text in the format .txt for each text list. The name of the text list becomes the name of the file. The directory into which the files are exported is set in “Project ➔ Project Settings ➔ Visualization”, category “General” in “Text list files”.

A controller can read and use this format. For example, you can copy the file to a controller and, by means of a configuration in the visualization manager, prevent the text lists from being transmitted again when loading the application.

See also

- Chapter 6.4.1.9.10 “Managing text in text lists” on page 1891

Command 'Insert Text'

Function: This command inserts a new line into the text list above the selected line. An input field under “Standard” opens, in which you input the source text.

Call: Main menu “Textlist ➔ Insert Text”, context menu

Requirement: A text list, not a “GlobalTextList”, is open and active. A field in the table is selected.

See also

- Chapter 6.4.1.9.10 “Managing text in text lists” on page 1891

Command 'Import/Export Text Lists'

Function: This command exports an active text list, imports a file, or matches a text list with a file. The file has the CSV format. The “Import/Export” dialog provides options for this.

Call: Menu bar: “Text List ➔ Import/Export Text Lists”; context menu

Requirement: A text list or global text list is active.

Dialog 'Import/Export'

| “Select File for Import” | File that CODESYS reads. |
| “Select export file” | File that CODESYS writes to. |
Table 525: “Import/Export Type”

| “Import” | Requirement: A file is selected in “Select file for compare or import”. The file can contain text list entries for both the global text list and text lists.  
|          | Global text list  
|          | - CODESYS reads the file, compares the text list entries for the same source text, and accepts differences in the translations. CODESYS overwrites any translations in the project.  
|          | Text lists  
|          | - CODESYS reads the file, compares the text list entries for the same ID, and accepts differences in the source text and translations into the project. CODESYS overwrites any text list entries in the project.  
|          | - If the file contains a new ID, then the text list entry is imported into the text list of the project and the text list is added.  

| “Import replacement file” | Requirement: A replacement file is selected in “Select file for compare or import”. The replacement file contains replacements for the global text list. CODESYS processes the replacement file row by row and performs the specified replacements in the global text list. The structure of the replacement file is described in the section “Managing static text in a global text list”.  

| “Export” | Requirement: The file that CODESYS writes to is selected in “Select export file”. CODESYS exports all texts from all text lists of the current project. All languages available in the project are inserted as columns in the export file. The file can be used for the external translation of the language-dependent texts.  

| “Export text differences only” | Requirement: An import file is selected for the comparison in “Select file for compare or export”, and an export file that CODESYS writes to is selected in “Select export file”. CODESYS reads the import file and then uses that information to compare the rows of the active text list. CODESYS ignores the rows that match. If rows differ, then CODESYS writes the row to the export file and, if necessary, copies translations from the text list. CODESYS accepts the translations from the import file and overwrites them if necessary.  

See also  
- § Chapter 6.4.1.9.10 “Managing text in text lists” on page 1891  
- § “Updating the global text list with a replacement file” on page 1895

Command ‘Remove Language’

Symbol: ![Symbol](image_url)  
Function: Removes the selected language column from the text list.  
Call: Main menu “Textlist”, context menu  
Requirement: A text list or a global text list is open and active. A field is selected in the column of the language that you wish to remove.  
See also  
- § Chapter 6.4.1.9.10 “Managing text in text lists” on page 1891

Command ‘Rename Language’

Symbol: ![Symbol](image_url)
Function: Opens a dialog for specifying a new name for a language that is displayed in the text list as a column heading.

Call: Menu bar: “Text List”, context menu.

Requirement: A text list or global text list is active. A field in the language column to be renamed is selected.

See also
- Chapter 6.4.1.9.10 “Managing text in text lists” on page 1891

Command 'Remove Unused Text List Entries'

Symbol: ✗

Function: This command checks whether a text list entry in the project is used as static text. If not, CODESYS removes it from the text list.

Call: Main menu “Textlist”, context menu

Requirement: The “GlobalTextList” is open and active. A field in the table is selected.

See also
- Chapter 6.4.1.9.10 “Managing text in text lists” on page 1891

Command 'Check Visualization Text IDs'

Symbol: ✗

Function: This command checks whether the ID of a text list entry in the project is correct and reports the result.

Call: Main menu “Textlist”, context menu

Requirement: The “GlobalTextList” is open and active. A field in the table is selected.

If CODESYS finds during checking that the global text list and the static texts of the visualizations do not correspond, this could be because the global text list is or was write protected. The requirement for this is that you have set up a user management system in the project.

See also
- Chapter 6.4.1.9.10 “Managing text in text lists” on page 1891

Command 'Update Visualization Text IDs'

Symbol: ✗

Function: This command updates all inconsistent IDs in a static text list.

Call: Main menu “Textlist ➔ Paste Text”, context menu

Requirement: The “GlobalTextList” is open and active. A field in the table is selected. The object is write protected.

If CODESYS finds during checking that the global text list and the static texts of the visualizations do not correspond, this could be because the global text list is or was write protected. The requirement for this is that you have set up a user management system in the project.

See also
- Chapter 6.4.1.9.10 “Managing text in text lists” on page 1891
- Chapter 6.4.1.6.6 “Protecting Objects in the Project by Access Rights” on page 1826
Command 'Add Text List Support'

Symbol: 📚

**Function:** This command adds text list support to the selected DUT object (type: enumeration).

**Call:** Context menu of a standard DUT object (type: enumeration 📚).

Text list support allows the localization of the enumeration component identifier and the display of the symbolic component value in a text output of a visualization.

See also
- ☀ Chapter 6.4.1.21.2.9 “Object 'DUT'” on page 2461
- ☀ Chapter 6.4.1.21.3.21.13 “Command 'Remove Text List Support'” on page 2732

Command 'Remove Text List Support'

Symbol: 📚

**Function:** This command removes text list support from the selected enumeration object.

**Call:** Context menu of an object of an enumeration with text list support (📚).

Text list support allows the localization of the enumeration component identifier and the display of the symbolic component value in a text output of a visualization.

47293

See also
- ☀ Chapter 6.4.1.21.2.9 “Object 'DUT'” on page 2461
- ☀ Chapter 6.4.1.21.3.21.12 “Command 'Add Text List Support'” on page 2732

Menu 'Trace'

6.4.1.21.3.22.1  Command 'Add Variable'............................................................... 2732
6.4.1.21.3.22.2  Command 'AutoFit'................................................................ 2733
6.4.1.21.3.22.3  Command 'Compress'................................................................ 2733
6.4.1.21.3.22.4  Command 'Configuration'......................................................... 2733
6.4.1.21.3.22.5  Command 'Cursor'.................................................................... 2733
6.4.1.21.3.22.6  Command 'Download Trace'.................................................... 2734
6.4.1.21.3.22.7  Command 'Export Symbolic Trace Config'............................. 2735
6.4.1.21.3.22.8  Command 'Load Trace'............................................................. 2737
6.4.1.21.3.22.9  Command 'Mouse Zooming'..................................................... 2737
6.4.1.21.3.22.10 Command 'Convert to Multi-Channel'......................................... 2737
6.4.1.21.3.22.11 Command 'Convert to Single-Channel'..................................... 2738
6.4.1.21.3.22.12 Command 'Online List'............................................................. 2739
6.4.1.21.3.22.13 Command 'Reset Trigger'......................................................... 2740
6.4.1.21.3.22.14 Command 'Reset View'............................................................. 2740
6.4.1.21.3.22.15 Command 'Save Trace'............................................................. 2741
6.4.1.21.3.22.16 Command 'Start Trace'............................................................. 2741
6.4.1.21.3.22.17 Command 'Stop Trace'............................................................... 2741
6.4.1.21.3.22.18 Command 'Stretch'................................................................. 2742
6.4.1.21.3.22.19 Command 'Upload Trace'........................................................ 2742
6.4.1.21.3.22.20 Command 'Statistics'............................................................... 2742

Command 'Add Variable'

**Function:** This command adds a trace variable to the configuration.
Call: Main menu “Trace”.

A new variable is displayed in the tree view of the trace configuration. The associated variables configuration appears to the right in “Variable Settings”.

See also
- % Chapter 6.4.1.21.4.16.2 “Dialog ‘Trace Configuration’” on page 2804
- % Chapter 6.4.1.13.3.3 “Creating trace configuration” on page 2010

Command ‘AutoFit’

Symbol: 🔬

Function: This command scales the y-axis of the trace diagram for optimum display of all graphs, making sure that the y-values fit in the visible region of the diagrams. The command works with both single-channel and multi-channel displays.

Call: Menu bar: “Trace”; context menu.

Trace in a single-channel display

When all trace variables are displayed in one diagram, the trace is in single-channel display.

Trace in a multi-channel display

When the trace variables are displayed in multiple diagrams, the trace is in multi-channel display.

See also
- % Chapter 6.4.1.21.4.16.2 “Dialog ‘Trace Configuration’” on page 2804
- % Chapter 6.4.1.13.3.6 “Navigating into trace data” on page 2015

Command ‘Compress’

Symbol: 📡

Function: This command compresses the trace graph by zooming into the displayed time range by a fixed percentage.

Call: Main menu “Trace”, or context menu.

See also
- % Chapter 6.4.1.21.4.16.2 “Dialog ‘Trace Configuration’” on page 2804
- % Chapter 6.4.1.13.3.6 “Navigating into trace data” on page 2015

Command ‘Configuration’

Function: This command opens the “Trace Configuration” dialog box for enabling the configuration of the data recording.

Call: Main menu “Trace”, or context menu.

See also
- % Chapter 6.4.1.21.4.16.2 “Dialog ‘Trace Configuration’” on page 2804
- % “Subdialog ‘Variable Settings’” on page 2807

Command ‘Cursor’

Symbol: 📋
**Function:** This function
- inserts a trace cursor into the trace diagram when **no** trace cursor is available
- inserts a second trace cursor into the trace diagram when **1** trace cursor is available
- removes the trace cursors when **2** trace cursors are available

**Call:** Menu bar: “Trace”; context menu.

A trace cursor is a small black triangle with a vertical black line running parallel to the y-axis.

**Trace diagram without trace cursors**
In this mode, you can process the trace diagram with the mouse pointer. The x-value that focuses on with the cursor is displayed in the status bar with normal style. Example: “**Time:** 1m23s456ms; **Value:** 1”

**Trace diagram with one trace cursor**
In the status bar and y-value, CODESYS prints the time that was marked by the trace cursor. Example: “**Time:** 1m23s456ms”

**Trace diagram with two trace cursors**
In the status bar, CODESYS prints the two times and the time interval that are marked by the two trace cursors. Example: “**Time:** 1m23s456ms - **Time:** 1m24s456ms (∆ 1s)”.

**User input in the trace diagram**
If one or two trace cursors are available, then you can move them along the x-axis.

<table>
<thead>
<tr>
<th>Mouse Input</th>
<th>Symbol</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drag the triangle of a trace cursor to another position.</td>
<td><img src="image" alt="Mouse Input Symbol" /></td>
<td>While the mouse button is pressed, the cursor can be moved without restriction. The current y-value is always displayed in the status bar. When the mouse button is released, the cursor jumps to the nearest measuring point</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Keyboard Shortcuts</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Left arrow]</td>
<td>CODESYS moves the black trace cursor to the next measuring point.</td>
</tr>
<tr>
<td>[Right arrow]</td>
<td></td>
</tr>
<tr>
<td>[Shift]+[Left Arrow]</td>
<td>CODESYS moves the gray trace cursor to the next measuring point.</td>
</tr>
<tr>
<td>[Shift]+[Right Arrow]</td>
<td></td>
</tr>
</tbody>
</table>

See also
- Chapter 6.4.1.13.3.6 “Navigating into trace data” on page 2015

**Command 'Download Trace'**

**Symbol:** [PDF]

**Function:** This command transfers the trace configuration on the controller to the associated application, and starts the data recording. The recorded data is transferred back to the development system. The trace diagram shows the current samples and continues.

**Call:** Menu bar: “Trace”; context menu.

**Requirement:** The command is available when the assigned application is in online mode.

See also
- Chapter 6.4.1.13.3.4 “Operating the data recording” on page 2014
Command 'Export Symbolic Trace Config'

**Function:** This command exports a trace configuration to a `traceconfig` file.

**Call:** Main menu “Trace”, or context menu.

**Requirement:** The origin application includes a symbol configuration that defines the configured trace variables as symbols. Access to the IEC variables where data was recorded is therefore symbolic. Then you can use the trace configuration for various similar applications.

**Using the configuration file**

You can transfer this file to any runtime system. At runtime, its `CmpTraceMgr` runtime system component can access and perform data recording. The configuration file also includes information about the application context in addition to the configuration data.

The configuration file defines the following context:

- Application name
- Trace name
- Task name

The application that is executed at runtime must fulfill the following conditions:

- The application has the same name as the origin application.
- The trace that is configured in the application has the same as the trace that is configured in the origin application.
- The task that is running in the data recording has the same name as the task that is configured in the origin application.

**NOTICE!**

The configuration is not loaded automatically. You must execute the command explicitly.

You can proceed as follows:

- Access the trace manager programmatically via IEC code by using library interfaces.
- Register the configuration file with the trace manager. Then the trace manager loads the configuration file when the application is started.

**For more information about the functionality of the trace manager, refer to “Trace Manager Runtime System Component Description”**.
Sample configuration file

Configuration file
Trace_Trigger.traceconfig

[key]: [value]
Version; 0x03050000
Name; Application.Trace_Trigger
ApplicationName; Application
ApplicationDataGuid; 00000000-0000-0000-0000-000000000000
IecTaskName; MainTask
Comment;
Trigger.Flags; 5
Trigger.Edge; 2
Trigger.Position; 0
Trigger.UpdatesAfterTrigger; 50
Trigger.Variable.Name; PLC_PRG.B.OUT
Trigger.Variable.AddrFlags; 0x00000101
Trigger.Variable.Class; 0
Trigger.Variable.Size; 1
Trigger.Level;
Condition.Name;
Condition.AddrFlags; 0x00000000
Condition.Class; 0
Condition.Size; 0
EveryNCycles; 1
BufferEntries; 100
Flags; 16
0.Variable; PLC_PRG.S5.OUT
0.Address.AddrFlags; 0x00000101
0.Class; 7
0.Size; 2
0.GraphColor; 4278190335
0.GraphType; 3
0.MinWarningColor; 4278190080
0.MaxWarningColor; 4294901760
0.CriticalLowerLimit; 0
0.CriticalUpperLimit; 0
0.ActivateMinWarning; 0
0.ActivateMaxWarning; 0
0.YAxis; 0
0.Data;
1.Variable; PLC_PRG.B.OUT
1.Address.AddrFlags; 0x00000101
1.Class; 0
1.Size; 1
1.GraphColor; 4278222848
1.GraphType; 1
1.MinWarningColor; 4278190080
1.MaxWarningColor; 4294901760
1.CriticalLowerLimit; 0
1.CriticalUpperLimit; 0
1.ActivateMinWarning; 0
1.ActivateMaxWarning; 0
1.YAxis; 0
1.Data;
Command 'Load Trace'

**Function:** This command makes it possible to load a file, which contains the configuration and data, and was saved to the file system of the development system. The "Load Trace" dialog box opens.

**Call:** Main menu “Trace”, or context menu.

### Dialog box “Load Trace”

<table>
<thead>
<tr>
<th>“File name”</th>
<th>Name of the file that is loaded</th>
</tr>
</thead>
<tbody>
<tr>
<td>“File type”</td>
<td>File format</td>
</tr>
<tr>
<td></td>
<td>● *.trace: “Trace file” that includes the trace configuration</td>
</tr>
<tr>
<td></td>
<td>● *.csv: Text file in CSV format that includes a trace configuration</td>
</tr>
</tbody>
</table>

See also

- § Chapter 6.4.1.13.3.7 “Managing trace” on page 2016

Command 'Mouse Zooming'

**Symbol:** (command disabled), (command enabled)

**Function:** This command enables and disables mouse zooming in the trace diagram.

**Call:** Menu bar: “Trace”; context menu.

**User input in the trace diagram** If the command is enabled, then you can stretch a box with the mouse. When you release the mouse button, the display zooms in on the box and the data is enlarged.

See also

- § Chapter 6.4.1.13.3.6 “Navigating into trace data” on page 2015

Command 'Convert to Multi-Channel'

**Function:** This command switches the display in the trace editor from single-channel to multi-channel.

**Call:** Menu bar: “Trace”; context menu.

**Multi-channel display** Multi-channel display means that the trace variables are displayed in multiple diagrams.
Command 'Convert to Single-Channel'

**Function:** This command switches the display in the trace editor from multi-channel to single-channel.

**Call:** Menu bar: “Trace”; context menu.

**Single-channel display**

If a trace is displayed as single-channel, then all trace variables are included in one diagram.
Command 'Online List'

**Function:** This command opens the “Online List” dialog. If the trace editor of a DeviceTrace object is active, then all traces that are running on the controller are displayed in a tree view. If the trace editor of an application-specific trace object is active, then only this trace is displayed if it is running on the controller.

**Call:** Menu bar: “Trace”; context menu of the trace editor.

**Requirement:** The runtime system uses the CmpTraceMgr components. An application belonging to the device is in online mode.
NOTICE!
Closing the DeviceTrace editor terminates the connection to the controller.
Please note that the connections to the controller is also terminated when the last open "DeviceTrace" editor is closed. In order for device traces to be displayed again in the project, you have to reload them into the "DeviceTrace" objects.
At this time, closing the editor is also the recommended procedure for deliberately terminating the connection to the controller. Logging out is not enough for this.

**Dialog 'Online List'**

<table>
<thead>
<tr>
<th>&quot;Delete from runtime&quot;</th>
<th>Stops and removes the selected trace from the running application.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Upload&quot;</td>
<td>This command is visible when a DeviceTrace is loaded in the trace editor. A DeviceTrace is a trace that runs on the controller: In the device tree, it can be represented with a DeviceTrace object directly below a device. When you execute this command, the trace that is selected in the tree view is loaded from the runtime system into the trace editor. Any existing configuration in the project is overwritten. For example, the device can provide traces for data of the processor load (cpuload, plcload), which then you can track in the trace editor in CODESYS. An individual &quot;DeviceTrace&quot; object is necessary in the device tree for each trace of the device that should be displayed in the project.</td>
</tr>
</tbody>
</table>

See also
- ☞ Chapter 6.4.1.13.3.5 “Accessing All Traces on the Controller” on page 2014
- ☞ Chapter 6.4.1.21.2.7 “Object ‘DeviceTrace’” on page 2426
- ☞ Chapter 6.4.1.21.2.31 “Object ‘Trace’” on page 2541
- ☞ Chapter 6.4.1.21.3.22.19 “Command ‘Upload Trace’” on page 2742

**Command 'Reset Trigger'**

Symbol: [ ]

**Function:** This command resets the trace configuration after a triggered data recording. Then the application can record new data and react to a trigger again.

**Call:** Main menu “Trace”, or context menu.

**Requirement:** After triggering, the complete data is in the buffer of the development system.

See also
- ☞ Chapter 6.4.1.13.3.4 “Operating the data recording” on page 2014

**Command 'Reset View'**

Symbol: [ ]

**Function:** This command resets the trace diagram to the default view.

**Call:** Main menu “Trace”, or context menu.
**Requirement:** The display in the trace diagram has been changed by zooming, scrolling, or “AutoFit”.

See also
-  % Chapter 6.4.1.21.3.22.2 “Command ‘AutoFit’” on page 2733
-  % Chapter 6.4.1.13.3.6 “Navigating into trace data” on page 2015

**Command ‘Save Trace’**

**Function:** This command saves the data to a file on the development system. Depending on the file format, the configuration may also be saved. The “Save Trace” dialog box opens.

**Call:** Main menu “Trace”, or right-click.

**Dialog Box ‘Save Trace’**

<table>
<thead>
<tr>
<th>“File name”</th>
<th>Name and location of the trace file</th>
</tr>
</thead>
<tbody>
<tr>
<td>“File type”</td>
<td>File format</td>
</tr>
<tr>
<td></td>
<td>• *.trace:</td>
</tr>
<tr>
<td></td>
<td>“Trace file” contains the data and configuration. You can run the “Load Trace” command to load the file to the trace editor when offline.</td>
</tr>
<tr>
<td></td>
<td>• *.txt:</td>
</tr>
<tr>
<td></td>
<td>“Text file” contains the recorded data. You can load this file type and edit it with tools that support CSV format. It cannot be loaded to the trace editor when offline because the trace editor cannot read this format.</td>
</tr>
<tr>
<td></td>
<td>• *.trace.csv</td>
</tr>
<tr>
<td></td>
<td>“Trace CSV file (data only)” contains the recorded data. Address information is provided for each trace variable. The created file can be read in the runtime system. The data is imported but the trace cannot be started because the variable addresses are not saved.</td>
</tr>
</tbody>
</table>

See also
-  % Chapter 6.4.1.21.3.22.8 “Command ‘Load Trace’” on page 2737
-  % Chapter 6.4.1.13.3.7 “Managing trace” on page 2016

**Command ‘Start Trace’**

**Symbol:** ➤

**Function:** This command starts the data recording on the controller when it is stopped.

**Call:** Main menu “Trace”, or context menu.

**Requirement:** The assigned application on the runtime system is running and a trace configuration is loaded.

See also
-  % Chapter 6.4.1.13.3.4 “Operating the data recording” on page 2014

**Command ‘Stop Trace’**

**Symbol:** ☹️
**Function:** This command stops the data recording of a trace.

**Call:** Main menu “Trace”, or context menu.

**Requirement:** The assigned application on the runtime system is running and executes a trace.

See also
- Chapter 6.4.1.13.3.4 “Operating the data recording” on page 2014

---

**Command 'Stretch’**

Symbol: 📣

**Function:** This command stretches the trace graph by zooming out of the displayed time range by a fixed percentage.

**Call:** Main menu “Trace”, or context menu.

See also
- Chapter 6.4.1.21.3.22.3 “Command 'Compress’” on page 2733
- Chapter 6.4.1.13.3.6 “Navigating into trace data” on page 2015

---

**Command 'Upload Trace'**

**Function:** This command establishes the connection to the PLC device, if not already connected. Then it opens the “Online List” dialog listing the traces running on the controller. Then the selected trace is loaded to the trace editor by means of the “Upload” command in the dialog.

**Call:** Menu bar: “Trace”; context menu of the trace editor.

**Requirement:** The editor of a “DeviceTrace” object is open. The runtime system uses the CmpTraceMgr components (trace manager). At least one application in the runtime system is running. The communication settings for the PLC are configured correctly in the CODESYS project.

---

**NOTICE!**
Closing the DeviceTrace editor terminates the connection to the controller.

Please note that the connections to the controller is also terminated when the last open “DeviceTrace” editor is closed. In order for device traces to be displayed again in the project, you have to reload them into the “DeviceTrace” objects.

At this time, closing the editor is also the recommended procedure for deliberately terminating the connection to the controller. Logging out is not enough for this.

See also
- “Dialog ‘Online List’” on page 2740
- Chapter 6.4.1.21.2.7 “Object ‘DeviceTrace’” on page 2426
- Chapter 6.4.1.13.3.5 “Accessing All Traces on the Controller” on page 2014

---

**Command 'Statistics’**

**Function:** This command opens the “Trace Statistics” dialog box, which shows statistics about each trace variable.

**Call:** Main menu “Trace”, or right-click.

**Requirement:** The trace editor contains samples.
The analyzed time range and duration are shown in the caption.

The table contains one line per signal.

<table>
<thead>
<tr>
<th>“Signal”</th>
<th>Name of the trace variable (for example, PLC_PRG.S1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Index”</td>
<td>0-based index of the signal order</td>
</tr>
<tr>
<td>“N”</td>
<td>Number of measurements for the calculations</td>
</tr>
<tr>
<td>“Min”</td>
<td>Smallest value</td>
</tr>
<tr>
<td>“Avg”</td>
<td>Average</td>
</tr>
<tr>
<td>“Median”</td>
<td>Middle value when the values are ordered by size</td>
</tr>
<tr>
<td>“RMS”</td>
<td>Root mean square</td>
</tr>
<tr>
<td>“StdDev”</td>
<td>Standard deviation</td>
</tr>
<tr>
<td>“Max”</td>
<td>Largest value</td>
</tr>
<tr>
<td>“Integral”</td>
<td>Integral</td>
</tr>
<tr>
<td>“Min Δt [s]”</td>
<td>Smallest change of time intervals for successive values</td>
</tr>
<tr>
<td>“Avg Δt [s]”</td>
<td>Average change of time intervals for successive values</td>
</tr>
<tr>
<td>“Median Δt [s]”</td>
<td>Median change of time intervals for successive values</td>
</tr>
<tr>
<td>“StdDev Δt [s]”</td>
<td>Standard deviation of change of time intervals for successive values</td>
</tr>
<tr>
<td>“Max Δt [s]”</td>
<td>Largest change of time intervals for successive values</td>
</tr>
</tbody>
</table>

Click a column head in the table. CODESYS sorts the table by that column, changing the order from ascending to descending and back.

Default: The table is sorted ascending by the “Index” column. The signals are then sorted in the same order as in the signal tree.

Click in the line. The line is selected. You can select or clear other lines by pressing [Shift]+[arrow] up or down.

[Ctrl]+[C] CODESYS copies the selected lines as text to the clipboard. The values of the individual columns are tab-separated, and the lines are delimited with the control character [CR] or [LF].

Requirement: At least one line is selected.

See also
- § Chapter 6.4.1.13.3 “Data Recording with Trace” on page 2007

Other

6.4.1.21.3.23.1 Command ‘Add Watch’ .......................................................... 2743
6.4.1.21.3.23.2 Command ‘Implement Interfaces’ ........................................... 2744
6.4.1.21.3.23.3 Command ‘Limit Results to Current Declaration’ .................... 2744

Command ‘Add Watch’

Symbol: ⚜

Function: This command adds the variable of the current location of the cursor to a watchlist for the purpose of online monitoring.
Call: Right-click a variable in an editor when the application is in online mode.

This command adds the variable to the currently opened watchlist. If a watchlist is not open, then the variable is added to the “Watch 1” list and that view opens.

See also
- % Chapter 6.4.1.13.2.3 “Using watch lists” on page 2002
- % Chapter 6.4.1.13.2 “Monitoring of Values” on page 1995

Command 'Implement Interfaces'

Function: This command updates the implemented interfaces for a function block.

Call: Context menu of the selected function block (FB) in the device tree.

Requirement: The function block implements an interface that you have modified. For example, an additional method was added to the interface.

In object-oriented programming, if you derive a function block (FB) from a base function block, which implements one or more interfaces, for the purpose of inheritance, then the following applies:

When you execute the “Implement Interfaces” command for the derived FB, all interface methods and interface attributes of the base FB are accepted into the derived FB in the form of stubs (without implementation). Then you are responsible for making sure that an "empty" method/attribute in the derived FB does not conflict with an implemented one in the base FB. The following actions are taken to support you in this case: If there is a base implementation for a method/attribute, then CODESYS adds a pragma attribute {error..} in the first line of the affected derived interface method or interface attribute that will generate the error message. If there is no base implementation for the method/attribute, then there is a pragma attribute entry for a warning. After editing the block, you must remove the error pragma attribute entry explicitly.

See also
- % Chapter 6.4.1.21.2.21.5 “Object 'Interface”’ on page 2484
- % Chapter 6.4.1.9.22.3 “Implementing interfaces” on page 1931

Command 'Limit Results to Current Declaration'

Function: When multiple declarations have been found, this command collapses the display in the cross-reference list. It shows only the results for the declaration that you selected explicitly in the list.

Call: Right-click.

Requirement: The cross-reference list is active. Multiple declarations for the searched symbol are listed as cross-references.

See also
- % Chapter 6.4.1.9.14.1 “Using the cross-reference list to find occurrences” on page 1906
6.4.1.21.4 Dialogs

6.4.1.21.4.1 General

6.4.1.21.4.2 Dialog 'Import Assistant'

6.4.1.21.4.3 Dialog 'Library Reference Conversion'

6.4.1.21.4.4 Dialog 'Select Function Block'

6.4.1.21.4.5 Dialog 'Device Conversion'

6.4.1.21.4.6 Dialog 'Breakpoint Properties'

6.4.1.21.4.7 Dialog 'Permissions'

6.4.1.21.4.8 Dialog Box 'Prepare Value'

6.4.1.21.4.9 Dialog 'New Breakpoint'

6.4.1.21.4.10 Dialog 'Monitoring Range'

6.4.1.21.4.11 Dialog 'Properties'

6.4.1.21.4.12 Dialog 'Project Settings'

6.4.1.21.4.13 Dialog 'Project Environment'

6.4.1.21.4.14 Dialog 'Options'

6.4.1.21.4.15 Dialog 'Customize'

6.4.1.21.4.16 Dialog 'Trace Configuration'

6.4.1.21.4.17 Dialog Box 'Trend storage'

6.4.1.21.4.18 Dialog Box 'Advanced Trend Settings'

6.4.1.21.4.19 Dialog 'Certificate Selection'

General

The dialogs of the CODESYS user interface basically are described on the help pages for
the CODESYS menu commands or CODESYS objects. The help book "Dialogs" contains only
descriptions of dialogs, which

- appear only after multi-step calls after a certain menu command call or within an object
editor,
- or which are not placed on a help page for a command or for an object because of their
complexity (multiple subdialogs).

Dialog 'Import Assistant'

Function: The dialog allows for the transfer of CODESYS options and package installations
from an older CODESYS installation that was found in the local computer.

Call: The dialog opens when a recently installed CODESYS version is started for the first time
and an older version is installed on the computer.

| "Program settings" | ☑: The user-specific CODESYS options are transferred from the older installa-
|                     | tion to the new installation. |
| "Packages"          | ☑: The packages installed with the older CODESYS version are transferred to
|                     | the Package Manager of the new version. See the list of discovered package
|                     | installations with the "Name", "Version", and "Installation date". |
| "Import"            | The program settings and/or options are transferred to the current CODESYS
|                     | version. |
| "Skip"              | The program settings and/or options are not transferred to the current
|                     | CODESYS version. |

See also

- ☰ Chapter 6.4.1.2.1.1 “Setting CODESYS options” on page 1802
Dialog 'Library Reference Conversion'  

**Function:** The dialog defines how references to libraries that are no longer available are to be handled. Note: The undefined library references can be found in the Global Library Manager located in the "POUs" view.

**Call:** When opening a CoDeSys V2.3 project in V3, the dialog opens when the converter detects a library which cannot be used anymore in the current CODESYS version.

---

A CoDeSys V2.3 project can be converted into a CODESYS V3 project only if the CODESYS V2.3 Converter package is installed in CODESYS V3. The package is available in the CODESYS Store.

---

**Table 526: “What do you want to do?”**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Convert and install the library as well.&quot;</td>
<td>The converter also converts the library file into the new format. It remains referenced in the project. It is installed automatically in the library repository in the &quot;Other&quot; category. If the library does not provide the necessary project information for an installation, then the “Enter Project Information” dialog opens for the information to be added.</td>
</tr>
<tr>
<td>&quot;Use the following library that has already been installed&quot;</td>
<td>The previously used library is replaced by another library. The “Browse” button opens a dialog for selecting from the local library repository.</td>
</tr>
<tr>
<td>&quot;Ignore the library. The reference will not appear in the converted project&quot;</td>
<td>The library reference is removed from the project.</td>
</tr>
</tbody>
</table>

**"Remember this mapping for all future occurrences of that library reference"** 

The settings made here in the dialog are also used for future project conversions.

See also

- ☞ Chapter 6.4.1.3.3 “Opening a V2.3 project” on page 1809
- ☞ Chapter 6.4.1.21.3.9.5 “Command 'Library Repository’” on page 2657

Dialog 'Select Function Block'  

**Function:** The dialog is used for selecting a function block for I/O mapping. The function block should be mapped to the I/O channel selected in the "<device name> I/O Mapping" tab or to the object selected in the "<device name> IEC Objects" tab.

**Call:**

- Tab "<device name> I/O Mapping", command button "Add FB for I/O channel"
- Tab "<device name> IEC Objects", command button "Add"

The dialog provides all function blocks from the active application and the libraries included in the project which fulfill the following:

- The function block has the {attribute 'io_function_block'} attribute.
- The function block contains input or output parameters that match the channel type (input, output, data type) and has the {attribute 'io_function_block_mapping'} attribute.

When a function block is selected that provides multiple matching parameters, only the first one is mapped automatically to the channel. The others can only be assigned manually in the "<device name> I/O Mapping" tab.

After the function block is assigned, the parameter of the function block instance is entered in the “Variable” column of the mapping table. Then the path is composed as follows:
<application name>._<device channel name>_<FB name>._<continuous FB instance number>.<FB parameter name>

**Example:** App1.Out_4_Int_myScale_Output_Int_1.iOutput for the parameter iOutput of the first inserted instance of the function block myScale_Output.

<table>
<thead>
<tr>
<th>“Find”</th>
<th>Input field for searching for function block names</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Type”</td>
<td>Function blocks in the tree structure that match the channel type. Nodes: application, library name(s)</td>
</tr>
<tr>
<td>“Documentation”</td>
<td>Shows the available documentation for the library selected in the tree or the library block.</td>
</tr>
</tbody>
</table>

**See also**
- % Chapter 6.4.1.21.2.8.12 “Tab ‘<device name> I/O Mapping’” on page 2444
- % Chapter 6.4.1.20.6.3.23 “Attribute ‘io_function_block’, ‘io_function_block_mapping’” on page 2293

**Dialog ‘Device Conversion’**

**Function:** The dialog defines how references to devices that are no longer available are to be handled.

**Call:** When opening a CoDeSys V2.3 project in V3, the dialog opens when the converter detects a device reference which cannot be used anymore.

- A CoDeSys V2.3 project can be converted into a CODESYS V3 project only if the CODESYS V2.3 Converter package is installed in CODESYS V3. The package is available in the CODESYS Store.

**Table 527: “What do you want to do?”**

<table>
<thead>
<tr>
<th>Use the following device that has already been installed</th>
<th>CODESYS replaces the previously used device in the device tree with another device. The “Browse” button opens a dialog for selecting from the local device repository.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ignore the device. All device specific objects will not be available in the new project</td>
<td>The device entry with all objects inserted below it is removed from the device tree.</td>
</tr>
</tbody>
</table>

| Remember this mapping for all future occurrences of that device | The settings made here in the dialog are saved in the CODESYS Options, in the “CODESYS V2.3 Converter” category. As a result, they are also valid for future project conversions. |

**See also**
- % Chapter 6.4.1.3.3 “Opening a V2.3 project” on page 1809
- % Chapter 6.4.1.21.3.9.8 “Command ’Device Repository’” on page 2663

**Dialog ‘Breakpoint Properties’**

**Function:** The dialog is used to display or change the properties of the selected breakpoint in the “Breakpoints” view.

**Call:**
● “Breakpoints” view, “Properties” button
● “Breakpoints” view, “New” button, “New Breakpoint” command or “New Data Breakpoint” command

**Requirement:** An entry is selected in the list of breakpoints.

The dialog is identical to the “New Breakpoint” dialog which is opened in the “Debug” menu by means of the respective commands. Therefore, see the description in the help for the “New Breakpoint” dialog.

See also
● ☞ Chapter 6.4.1.21.4.9 “Dialog ‘New Breakpoint’” on page 2750

**Dialog 'Permissions'**

**Function:** The permissions of user groups are defined here with which they can execute specific actions on specific objects in the project.

**Call:** Menu bar: “Project ➔ User Management”.

Every change made in the dialog is applied immediately.

**Actions**

All possible actions on objects of the projects are listed in “Actions”. The actions are divided into four categories and assignments to all current objects of the project are listed below each action. For each “action->object” assignment, you can define the permission for each existing user group.

**Action categories:**

<table>
<thead>
<tr>
<th>“Commands”</th>
<th>Actions regarding the execution of commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Users, groups and permissions”</td>
<td>Actions regarding the configuration of user accounts, user groups, and their permissions</td>
</tr>
<tr>
<td>“Object types”</td>
<td>Actions regarding the creation of object types</td>
</tr>
<tr>
<td>“Project objects”</td>
<td>Actions regarding the viewing, modification, removal, and child-object handling of objects of the project</td>
</tr>
</tbody>
</table>

**Actions in detail:**

| “Execute” | Execute a menu command |
| “Create”  | Create a new object in the project |
| “Add or remove children” | Add or remove a child object below an existing object |
| “Modify”  | Modify an object in the editor or modification of user, group, and permission settings in the corresponding editor/dialog |
| “Remove”  | Delete or remove an object |
| “View”    | Open the view of an object in the editor |

Possible target of an action. This can be specific objects of the project, or the user, group, and permission configuration.

**Permissions**

All defined user groups (except the “Owner” group) are listed in “Permissions” with a toolbar for configuring the permissions of a group.
| **Granted** | The action, which is selected in the actions view, on the selected target(s) is **granted** for the selected group. |
| **Denied** | The action, which is selected in the “Actions” view, on the selected target(s) is **denied** for the selected group. |
| **+** | The permission that executes the actions, which are selected in the “Actions” view, on the selected targets has not been defined explicitly. However, the actions are **granted by default**; for example, because the corresponding permissions have been granted to the parent object. Example: The group has the permission for the object "myplc". As a result, it also has the permission by default for the object "myplc.pb_1". |
| **-** | The action, which is expanded in the actions view, on the selected targets has not been denied explicitly. However, it is denied by default; for example, because it has been denied to the parent object. |
| **No symbol** | There are currently multiple actions selected in the Actions view for which the group does not have the same permission. |

**Toolbar:**

| **“Grant”** | The selected action on the selected target object is granted explicitly for the selected group. |
| **“Deny”** | The selected action on the selected target object is denied explicitly for the selected group. |
| **“Clear”** | The permission for the selected action on the selected target object is reset to the default value for the selected group. |

**“Export/Import”**

- **“Export all permissions”**
  - Opens a menu with the commands
  - **“Export all permissions”**
  - **“Export selected permissions”**
  - **“Import permissions”**

  **“Export all permissions”**
  - Exports all actions and their configured access permissions of the current project to a user-specific file of data type *.perms.
  - To do this, the “Export Permissions” dialog opens for you to specify a file name and to select a location in the file directory. The default file type is Permissions (*.perms).

  **“Export selected permissions”**
  - Exports all selected actions and their configured access permissions of the current project to a user-specific file of data type *.perms.
  - To do this, the “Export Permissions” dialog opens for you to specify a file name and to select a location in the file directory. The default file type is Permissions (*.perms).

  **“Import permissions”**
  - The contents of a *.perms file is merged with the actions and permissions of the current project. Groups that are part of the file but not part of the project are ignored. The actions and permissions are aligned by name.
  - To do this, the “Import Permissions” opens for you to select the *.perms file from the file system.

See also

- % Chapter 6.4.1.6.6 “Protecting Objects in the Project by Access Rights” on page 1826

**Dialog Box 'Prepare Value’**

**Function:** This dialog box is used for preparing a value for a forced variable. CODESYS executes the prepared action with the next forcing.
CODESYS opens the dialog box in the following situations:

- When clicking in the field “Prepared value” of a forced variable in the declaration section
- When clicking in the inline monitoring field of a forced variable
- When clicking in the field “Prepared value” of a forced variable in the monitoring window

| “Prepare a new value for the next write or force operation” | Value that CODESYS writes to the variable with the next force operation |
| “Remove a preparation with a value” | CODESYS deletes the prepared value. |
| “Release the force, without modifying the value” | CODESYS retains the forced value and ends forcing. CODESYS marks the variable <Unforce>. |
| “Release the force and restore the variable to the value it had before forcing it” | CODESYS resets the forced value and ends forcing. The variable is marked with <Unforce and restore>. |

See also

- Chapter 6.4.1.21.3.8.16 “Command ‘Force Values’” on page 2649

**Dialog 'New Breakpoint’**

**Function:** In the dialog, you define the settings for a new breakpoint or data breakpoint. It is identical to the “Breakpoint Properties” dialog which is used in the “Breakpoints” view.

**Call:**

- “Debug ➔ New Breakpoint”
- “Debug ➔ New Data Breakpoint”

**Requirement:** The application is in online mode.

**Tab 'Condition’**

The dialog defines the requirements for which program processing should halt at a breakpoint.

---

**NOTICE!**

Using conditional breakpoints slows down code execution, even when the condition does not yield TRUE.

Conditional breakpoints required a CODESYS runtime >= V3.5.4.0.

---

**Table 528: “Tasks”**

| “Break only when the breakpoint is hit in one of the following tasks” | CODESYS evaluates the breakpoint only if it is reached by specific tasks. The required tasks must be activated. For example, you can define a single debug task and also prevent other tasks that use the same block from being affected when debugging. |
Table 529: “Hit Count”

| “Hit Count”          | “Break always”: The program always halts at this breakpoint. Alternative: The program halts at the breakpoint when the breakpoint has been hit as often as defined in the following (type in the required hit count or select it from the number list): ● “Break when the hit count is equal to” ● “Break when the hit count is a multiple of ” ● “Break when the hit count is greater than or equal to” |

Table 530: “Condition”

| “Break, when true”                      | CODESYS evaluates the specified condition and halts the program at the breakpoint only when the result yields TRUE. You can define a condition as a valid Boolean expression. Examples: $x>100$, $x[y]=z$, $a \text{ AND } b$, boolVar. |

Tab 'Data'

Requirement: This is used for the properties of a data breakpoint.

The function of data breakpoints depends on the target system. Currently, data breakpoints are possible only with the CODESYS Control Win V3.

On the tab, the variable or memory address is specified for which the data breakpoint is set or will be set.

| “Break execution when the value of the variable or address changes” | ● Input of a qualified variable name ● Selection of a variable in the “Input Assistant” dialog, in the “Watch Variables” category Examples: variable: PLC_PRG.fb_DoSth.dwVariable; address: 16#12A, 0x12A, 129 |

| “Size” | Number of bytes of the specified variable or memory address above which should be monitored for changes. When a new variable or memory address is specified, a value that matches the data type or memory is set automatically at first. Note: The “Size” and quantity depend on the target system. For the CODESYS Control Win V3, a maximum of four data breakpoints with a maximum size of 8 bytes can be defined. Example: 2 for data type DWORD Example: 4 for data type DWORD: Only the two first bytes of the variable are monitored. |

Tab 'Execution Point Settings'

Here, an existing breakpoint or data breakpoint can be converted into an execution point.
**Execution point (execution does not stop at breakpoint)**
- The breakpoint becomes an execution point. Processing does not halt at this point and the given code is executed.
  - Execution point of a breakpoint: activated: ✔; deactivated: ✗
  - Execution point of a data breakpoint: activated: ✔; deactivated: ✗

**Execute the following code**
- Code that is executed when the execution point is reached.
- Looped structures (For, While) and IF or CASE expressions are not possible.

**Print a message in the device log**
- This option is available only when you select the “Enable logging in breakpoints” option in “Project Settings ➔ Compile Options”.
- CODESYS can print variables with the placeholder {variable name} in the message text.

---

**Tab 'Location'**
Requirement: The command “New breakpoint” was selected.

<table>
<thead>
<tr>
<th><strong>POU</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>POU of the active application where the breakpoint is placed.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Position</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Position of the breakpoint in the POU. Entry as row and column numbers (text editor) or as network or element numbers.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Instances</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>In the case of function blocks, you have to define whether the breakpoint should be set in the implementation or in an instance.</td>
</tr>
</tbody>
</table>

**Enable breakpoint immediately**
- The breakpoint is activated.
- The breakpoint is not activated. To activate later, click the button in the “Breakpoints” view.

---

**Dialog 'Monitoring Range'**

**Function:** This dialog restricts the range of array elements whose values are displayed during monitoring.

**Call:** Click in the column field “Data Type” that belongs to the array variable.

**Requirement:** A POU is in online mode and is being monitored. In addition, a variable of the POU has the data type “ARRAY”.

<table>
<thead>
<tr>
<th><strong>Valid range</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>The validity range of the array elements that are monitored.</td>
</tr>
<tr>
<td>Example of a three-dimensional array: [1..10][-3..3][-10..10]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Maximum number of array elements</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of elements of the array variables</td>
</tr>
<tr>
<td>Example: 1470</td>
</tr>
</tbody>
</table>

When you edit one of the settings “Start”, “End”, or “Scroll range of 1000 elements”, both of the other settings are adapted automatically.
See also

- Chapter 6.4.1.13.2.2 "Calling of monitoring in programming objects " on page 1996

Dialog 'Properties'

6.4.1.21.4.11.1 General................................................................................................. 2753
6.4.1.21.4.11.2 Dialog Box 'Properties' - 'Common'.................................................. 2753
6.4.1.21.4.11.3 Dialog 'Properties' - 'Boot Application'............................................. 2754
6.4.1.21.4.11.4 Dialog: Properties: Security.............................................................. 2754
6.4.1.21.4.11.5 Dialog 'Properties' - 'Build'.............................................................. 2755
6.4.1.21.4.11.6 Dialog 'Properties' – 'Build' (C-integration).................................. 2756
6.4.1.21.4.11.7 Dialog 'Properties' - 'Access Control'................................................. 2757
6.4.1.21.4.11.8 Dialog 'Properties' - 'External file'.................................................... 2757
6.4.1.21.4.11.9 Dialog Box 'Properties' - 'Bitmap'.................................................... 2758
6.4.1.21.4.11.10 Dialog 'Properties - Application Build Options'.......................... 2759
6.4.1.21.4.11.11 Dialog 'Properties' - 'Target memory settings'............................. 2759
6.4.1.21.4.11.12 Dialog 'Properties' - 'Network Variables'....................................... 2760
6.4.1.21.4.11.13 Dialog 'Properties' - 'Network Settings'........................................ 2761
6.4.1.21.4.11.14 Dialog 'Properties' - 'CFC Execution Order'............................... 2761
6.4.1.21.4.11.15 Dialog 'Properties' - 'SFC Settings'............................................... 2762
6.4.1.21.4.11.16 Dialog 'Properties' – 'Link to File'.................................................. 2763
6.4.1.21.4.11.17 Dialog 'Properties' - 'Cam'............................................................. 2763
6.4.1.21.4.11.18 Dialog 'Properties' - 'Image Pool'.................................................. 2764
6.4.1.21.4.11.19 Dialog 'Properties' - 'TextList'....................................................... 2765
6.4.1.21.4.11.20 Dialog 'Properties' - 'Options'....................................................... 2765
6.4.1.21.4.11.21 Dialog 'Properties' - 'Monitoring'.................................................. 2766

General

This dialog box is for the configuration of the properties of an object in CODESYS. In addition, depending on the object, it contains different tabs that each handle a category of properties.

Call: Menu “View”, context menu of the object in the “Devices”, “POUs” or “Modules” view.

Dialog Box 'Properties' - 'Common'

Function: This dialog box shows common information about the selected object.

Call: Main menu “View ➔ Properties”, or context menu of the object (“Common”).

Requirement: An object is selected in the device tree or POUs view.
Table 531

<table>
<thead>
<tr>
<th>“Name”</th>
<th>Object name as shown in the device tree or POUs view</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Object type”</td>
<td>Type of object (for example, POU, application, or interface)</td>
</tr>
<tr>
<td>“Open with”</td>
<td>Type of editor to display or edit the object</td>
</tr>
</tbody>
</table>

**Dialog 'Properties' - 'Boot Application'**

**Function:** The settings on this tab define when and how a boot application is created from the application.

**Requirement:** The device supports the settings.

**Call:** Select the application object; context menu: “Properties”; menu bar: “View ➔ Properties”, “Boot Application” category

| “Create implicit boot application on download” | A boot application is created automatically when downloading the application. |
| “Create implicit boot application on Online Change” | A boot application is created automatically when for an online change. |
| “Remind boot application on project close” | Before closing the project, CODESYS prompts to create the boot application. |
| “Verify boot application after creation” | After the boot application is created, an independent service checks whether or not the boot application has been created correctly. |

Regardless of the presets defined here, you are always able to create a boot application explicitly when you login.

See also
- ¶ Chapter 6.4.1.11.7 “Generating boot applications” on page 1978
- ¶ Chapter 6.4.1.21.3.7.6 “Command ‘Online Change’” on page 2629

**Dialog: Properties: Security**

**Function:** The dialog contains the properties of the application for encryption. If the CODESYS Security Agent is installed, then you can start a wizard for the encryption of downloads, online changes, and boot applications.

**Call:**
- Menu bar: “View ➔ Properties”
- Context menu of an application object

Table 532: “Encryption Technology”

If the “Enforce encryption of downloads, online changes and boot applications” option is selected in the “Security Screen” view in the “Security level” group, then the encryption technology is set to “Encryption with certificates” and cannot be changed in this dialog.

“No Encryption”
### “Simple Encryption”
You can download the boot application to the controller only when the defined dongle (license key) is connected to the computer. The dongle is provided by ABB AG or by the respective hardware manufacturer. The firmcode is displayed. Type in the delivered product code.

### “Encryption with license management”
You can download the boot application to the controller only after you have specified the product code and firmcode, and the respective dongle is connected to both the development computer and the controller. You receive the codes from the vendor that manages the licenses.

### “Encryption with certificates”
You can download the boot application to the controller only when a valid certificate exists for it. The “Certificates” group is enabled. See the description below. The option is already selected if the “Enforce encryption of downloads, online changes and boot applications” option is selected on the “User” tab of the “Security Screen” view.

You can also select the “Digitally sign application code” option.

<table>
<thead>
<tr>
<th>Table 533: “Certificates”</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note: If the “Enforce encryption of downloads, online changes and boot applications” option is selected in the “Security Screen” view in the “Security Level” group, then the encryption technology is set to “Encryption with certificates” and cannot be changed in the “Properties” dialog.</td>
</tr>
<tr>
<td>The “Certificate Selection” dialog opens. Here you can select previously installed certificates of devices for which the encryption of download, online change, and boot application is enabled. The list can contain several entries if several devices are authorized to run this application.</td>
</tr>
<tr>
<td>“Digitally sign application code” The application is signed with a digital signature. The certificate for the digital signature is specified in the “Security Screen” view on the “User” tab.</td>
</tr>
</tbody>
</table>

### Information per certificate:
- “Issued for”
- “Issued by”
- “Valid from”
- “Valid until”
- “Thumbprint”

### “Encryption Wizard”
This button is available only if the CODESYS Security Agent is installed. It starts the wizard with the same name. See the help for CODESYS Security Agent in this case.

See also
- Chapter 6.4.1.9.18 “Protecting an application” on page 1915
- Chapter 6.4.1.21.3.4.18 “Command ‘Security Screen’” on page 2592
- Help about CODESYS Security Agent

### Dialog 'Properties' - 'Build'

**Symbol:** 📋

**Function:** The dialog contains options for building (build operation) the object.

**Call:** Menu bar: “View ➔ Properties”; context menu of the object in the device tree
**Name** | **Description**
--- | ---
"Exclude from build" | ☑: This object and recursively its child objects are not considered for the next compile process. The object entry is displayed in green fonts in the “Devices” or “POUs” view.

"External implementation" "(Late link in the runtime system) " | ☑: CODESYS does not generate any code for this object when compiling the project. The object is linked as soon as the project is running on the target system, provided it is available there (for example, in a library). The object name is postfixed with (EXT) in “Devices” or “POUs” view.

"Enable system call" | ☑: A system call (runtime system) for functions is possible. Background: As opposed to CoDeSys V2.3, the ADR operator in V3 can be used with function names, program names, function block names, and method names. It replaces the INSTANCE_OF operator. BUT: It is not possible to call function pointers from within CODESYS.

"Link always" | ☑: The object is marked by the compiler and therefore always included in the compile information. This means that it is always compiled and downloaded to the PLC. Note: The pragma `{attribute 'linkalways'}` can also be used to instruct the compiler to always include an object.

"Compiler defines" | Here you can specify defines or conditions for compiling the object (conditional compile). You can also type in the expression `expr`, which is used in these kinds of pragmas. Multiple entries are possible as a comma-separated list (see `{define} statements`).
Example: `hello, test:= '1'`

"Additional compiler definitions from the device description" |

"Defined in device" | List of compiler definitions that originate from the device description. These compiler definitions are used in the build if they are not listed in the “Ignored definitions” field.

"Ignored definitions" | List of compiler definitions from the device description that are not used in the build.

Copies the selected compiler definition from the “Defined in device” field to the “Ignored definitions” field.

Moves the selected compiler definition from the “Ignored definitions” field to the “Defined in device” field. The compiler definition is used in the build.

See also
- § Chapter 6.4.1.20.6.4 “Conditional Pragmas” on page 2318
- § Chapter 6.4.1.20.6.3.25 “Attribute ‘linkalways’” on page 2294

**Dialog 'Properties' – 'Build' (C-integration)**

**Function:** In this dialog, you configure the build environment and the necessary data for the integration of the C development environment.

**Call:** Main menu “View”, context menu of the object “C Code Module”

**Requirement:** The object “C Code Module” is selected in the device tree.
NOTICE!
The dialog in this form is valid only for CODESYS Control Win V3 and Visual Studio. For other environments, the dialog can look different or may not even be available at all.

| “Visual Studio location” | Installation path of Visual Studio on the hard disk
You can also select the path with the input assistant or search for it with the magnifying glass. |
|--------------------------|--------------------------------------------------------------------------------------------------|
| “Windows SDK location”   | Installation path of Windows SDK on the hard disk
You can also select the path with the input assistant or search for it with the magnifying glass. |
| “Temporary build folder Location” | Path on the hard disk for the temporary build files |

See also

Dialog 'Properties' - ‘Access Control’

Function: The dialog defines the access rights of user groups for objects.

Call: Main menu “View ➔ Properties”, context menu of an object in the view “Device” or “POUs”.

Requirement: An object is selected in the view “Device” or in the view “POUs”.

| “Groups, actions and permissions” | A table which displays the following user groups access rights on objects:
- “View”
- “Modify”
- “Remove”
- “Add/remove children”
Perform a double click on the access right symbol to open the drop down list with the available rights. |

See also

- Chapter 6.4.1.6.6 “Protecting Objects in the Project by Access Rights” on page 1826
- Chapter 6.4.1.21.4.7 “Dialog ‘Permissions’” on page 2748

Dialog 'Properties' - ‘External file’

Function: The dialog is used to view and edit the properties of the external file. The properties were defined when the object was created. Changed properties are saved by pressing the “OK” button.

Call: Menu bar: “View ➔ Properties”; context menu of the object

Requirement: The object of the external file is selected in the “Devices” view or the “POUs” view.
Table 534

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Remember the link”</td>
<td>The file is available in the project only as long as it exists in the defined file path.</td>
</tr>
<tr>
<td>“Remember the link and embed into project”</td>
<td>CODESYS saves an internal copy of the file in the project, as well as the link to the defined file path. The update option selected below applies as long as the external file exists there. Otherwise CODESYS uses the version saved in the project.</td>
</tr>
<tr>
<td>“Embed into project”</td>
<td>CODESYS saves only one copy of the file in the project. There is no longer a link to the external file.</td>
</tr>
</tbody>
</table>

Table 535: “When the external file changes, then”

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Reload the file automatically”</td>
<td>If the external file changes, then CODESYS updates the file in the project.</td>
</tr>
<tr>
<td>“Prompt whether to reload the file”</td>
<td>If the external file changes, then a dialog prompt opens whether CODESYS should also update the file in the project.</td>
</tr>
<tr>
<td>“Do nothing”</td>
<td>The file remains unchanged in the project, even if the external file changes.</td>
</tr>
</tbody>
</table>

Table 536: “Linked File”

Requirement: Either the “Remember the link” option or the “Remember the link and embed into project” option is selected.

The following information about the linked file is displayed: “Name”, “Location”, “Size”, “Changed”.

“Display File Properties” Clicking this button opens the default “Properties of <file name>” dialog, which you can also open in the Windows file system by right-clicking the file.

Table 537: “Embedded file”

Requirement: Either the “Remember the link and embed into project” option or the “Embed into project” option is selected.

Display of the following information about the embedded file: “Size” and “Changed”.

“Update the embedded file” If the external file that was added to the project is changed in the specified file path, then CODESYS updates the embedded file in the project.

See also
- Chapter 6.4.1.21.2.10 “Object ‘External File’” on page 2464

Dialog Box ‘Properties’ - ‘Bitmap’

**Function:** The dialog is for assigning a bitmap file to the object. The image will be used in the graphic view of the Library Manager and in the Toolbox view of the FBD/LD/IL editor.

**Call:** Main menu “View ➔ Properties”, context menu of the object

**Requirement:** The object is selected in the view “Devices” or in the view “POUs”

“Render pixels of this color transparently:” The selected color will be displayed transparently.
Dialog 'Properties - Application Build Options'

**Function:** The dialog includes settings that CODESYS uses for creating a boot application for the controller.

**Call:** Menu bar: “View ➤ Properties”; context menu of an application object

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Download application info** | This feature requires compiler version >=3.5.0.0, runtime version >= 3.5.0.0.  
The information about the application contents is also downloaded to the PLC. We recommend that you keep this option enabled because it allows for a difference check between the current application and the application on the PLC. This compares the number of blocks, data, and memory locations.  
To get the information about the differences, click “Details” in the “Applications” tab of the device editor. This is also in the message view that opens when you are downloading an application to the PLC when it is different from the one already on the PLC. |
| **Stop parent application in case of exception** | Available for applications with a parent application. |
| **Dynamic memory settings** | Memory is allocated dynamically for the application, for example when using the operator __NEW. In this case, define the “Maximum size of memory (bytes)”.  
Caution: The entire memory is not available for creating objects dynamically. Instead, the system always uses part of it for management information. |

See also
- % Chapter 6.4.1.11.5 “Generating Application Code” on page 1976
- % Chapter 6.4.1.11.7 “Generating boot applications” on page 1978
- % Chapter 6.4.1.21.2.2 “Object ‘Application’” on page 2410

Dialog 'Properties' - 'Target memory settings'

**Function:** The dialog allows for changing the memory settings of the target device.

**Call:** Menu bar: “View ➤ Properties”; context menu of the application

**Requirement:** The application is selected in the “Devices” view.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Override target memory settings** | ✓: The memory settings stored in the device description are overridden by the values specified in “Input size”, “Output size”, and “Memory size”.  
Note: If the memory settings of the target device are changed, then it is no longer possible to log in to an existing application on the target device, nor is it possible to perform an online change. |
| **Input size** | Input fields for the memory sizes used to override the values "memory-layout\input-size", "memory-layout\output-size", and "memory-layout\memory-size" stored in the device description.  
Requirement: The “Override target memory settings” option is selected. |
| **Output size** |
| **Memory size** |

See also
- % Chapter 6.4.1.21.2.2 “Object ‘Application’” on page 2410
Dialog 'Properties' - 'Network Variables'

Symbol: ⌒

**Function:** In this dialog, you define network properties for the variable list that is selected in the device tree. Furthermore, any variables in it that are declared as network variables are also available.

**Call:** “Context menu of variable list in device tree → Properties”, “Network Variables” tab

<table>
<thead>
<tr>
<th><strong>“Network type”</strong></th>
<th>UDP</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Task”</strong></td>
<td>Task of the current application that controls the variables to be sent. CODESYS always sends the variables at the end of a task cycle.</td>
</tr>
<tr>
<td><strong>“List identifier”</strong></td>
<td>Used to identify the network variable list. Must be unique</td>
</tr>
<tr>
<td><strong>“Pack variables”</strong></td>
<td>The size of the packages (telegrams) that are transmitted depends on the network type. In the case of “UDP”, a package is 256 bytes. ✓ CODESYS bundles the variables for sending in packages in order to reduce as much as possible the number of packages to send. In the case of variables of type array or structured data types, this can lead to the splitting of the variables into multiple telegrams. As a result, data inconsistencies are possible within these variables, even if the variable size is smaller than the package size.</td>
</tr>
<tr>
<td><strong>“Transmit checksum”</strong></td>
<td>✓ A checksum is provided for each variable package. The receiver checks the checksum to make sure that the variable definitions match from the sender and receiver. A package with non-matching checksums is not accepted.</td>
</tr>
<tr>
<td><strong>“Acknowledgement”</strong></td>
<td>✓ CODESYS sends an acknowledgement message for each received data package. If the sender does not receive a confirmation before it sends again, then an error is written to the diagnostic structure. Note: For the NetVarUdp library version 3.5.7.0 and later, a receiver channel is no longer assigned when confirmed transfer is not selected. In this way, network variable exchange is also possible between two controllers on one hardware device.</td>
</tr>
<tr>
<td><strong>“Cyclic transmission”, “Interval”</strong></td>
<td>CODESYS sends the variables within the defined interval. Example for time definition: “T#70ms”.</td>
</tr>
<tr>
<td><strong>“Transmit on change”, “Minimum gap”</strong></td>
<td>✓ CODESYS sends the variables only if their values have changed. You can use “minimum gap” to define the least amount of time between two transmissions.</td>
</tr>
</tbody>
</table>
**“Transmit on event”, “Variable”**

- **CODESYS** sends the variables as soon as the defined variable yields **TRUE**.

**“Settings”**

- Protocol-specific settings; possible entries depend on the network library.
- **“Port”**: Number of the port that CODESYS uses for data exchange with other network units. The “Default value” is “1202”. You can change the current value in the “Value” field at any time. Select the field, press the [Space Bar], and type the value.
- **Caution**: The other nodes in the network must define the same port. If more than one UDP connection is defined in the project, then the port numbers in all configurations are adapted to this value.
- **“Broadcast Adr.”**: The “Default value” is 255.255.255.255, which means that data exchange will take place with all network units. You can change the current value in the “Value” field, press the [space bar], and type the address or address range of a subnetwork (for example, 197.200.100.255 when communication should be with all nodes that have an IP address in the range 197.200.100.x).

See also

- ☼ Chapter 6.4.1.10.5 “Network Variables” on page 1946
- ☼ Chapter 6.4.1.21.2.19 “Object 'Network Variable List (Receiver)’” on page 2475
- ☼ Chapter 6.4.1.21.2.18 “Object 'Network Variable List (Sender)’” on page 2475

**Dialog 'Properties' - 'Network Settings’**

If the device supports the network functionality, then the current network settings for a GNVL (global network variable list) can be displayed and changed in the “Properties” dialog of the object. These are the settings that were used when adding the GNVL in the “Add Network Variable List (Receiver)” dialog.

See also

- ☼ “Dialog Box 'Add Network Variable List (Receiver)’” on page 2475

**Dialog 'Properties' - 'CFC Execution Order’**

**Function**: The tab switches the mode of the execution order for CFC objects.

**Call**: Context menu: “Properties” of a CFC object in the “Devices” view or “POUs” view

**Tab 'CFC Execution Order’**
"Execution order" | In the CFC editor, you position the elements and therefore also the networks freely. Two modes are available to prevent the execution order in the CFC POU from being undefined.

"Auto Data Flow Mode" | In this mode, the execution order is determined automatically by data flow, or in case of ambiguity, by network topology. The POUs and the outputs are numbered internally. The networks are executed from top to bottom and left to right.

Advantage: The automatically defined execution order is optimized by time and by cycle. You do not need any information about the internally managed execution order during the development process.

The following commands are provided afterwards in the “CFC ➔ Execution Order” menu:
- “Display Execution Order”
- “Set Start of Feedback”

The elements in the CFC editor are displayed without markers and without numbering. It is not possible to change the execution order manually. For networks with feedback, you can also set a starting point.

"Explicit Execution Order Mode" | In this mode, you can define the execution order explicitly. To do this, the elements are displayed in the CFC editor with markers and numbering, and menu commands are provided for defining the order.

The following commands are provided in the “CFC ➔ Execution Order” menu:
- “Send to Front”
- “Send to Back”
- “Move Up”
- “Move Down”
- “Set Execution Order”
- “Order by Data Flow”
- “Order by Topology”

Note: Up to CODESYS V3.5 SP1, this was the usual behavior of CFC POUs. Pay attention that it is your responsibility to adapt the execution order and assess the consequences and impacts. This is another reason why the execution order is always displayed.

"Apply to All CFCs" | Changes the mode for all other CFC objects in the project to the mode selected in the list.

See also
- Chapter 6.4.1.9.5.3.2 “Automatic Execution Order by Data Flow” on page 1867
- Chapter 6.4.1.21.3.13.10 “Command ‘Set Start of Feedback’” on page 2688
- Chapter 6.4.1.21.3.13.11 “Command ‘Send to Front’” on page 2688
- Chapter 6.4.1.21.3.13.12 “Command ‘Send to Back’” on page 2689
- Chapter 6.4.1.21.3.13.13 “Command ‘Move Up’” on page 2689
- Chapter 6.4.1.21.3.13.14 “Command ‘Move Down’” on page 2690
- Chapter 6.4.1.21.3.13.16 “Command ‘Order by Data Flow’” on page 2691
- Chapter 6.4.1.21.3.13.17 “Command ‘Order by Topology’” on page 2691

Dialog 'Properties' - 'SFC Settings'

Function: The dialog defines the default settings for all POUs used in the project, which are programmed in SFC.

Call: Main menu “View ➔ Properties”, context menu of a SFC POU in the view “Device” or “POUs”.

Configuration and programming
Programming with CODESYS > CODESYS Development System

2762 3ADR010583, 1, en_US 2024/01/05
Flag

<table>
<thead>
<tr>
<th>List of all possible SFC flags</th>
<th>“Use” [✓]: The SFC flag is activated and will be considered in the program execution.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>“Declare” [✓]: The SFC flag is declared automatically.</td>
</tr>
<tr>
<td></td>
<td>If “Declare” is activated, but “Use” is not activated, the variable will be declared but the flag has no effect in the program execution.</td>
</tr>
<tr>
<td></td>
<td>Hint: If you have manually declared a SFC variable you have to disable the declaration of this flag in the “SFC Settings”. Otherwise the automatically generated flag will overwrite the manually declared flag.</td>
</tr>
<tr>
<td></td>
<td>Hint: A automatically declared flag variable is only visible in the online mode in the declaration part of the SFC editor.</td>
</tr>
</tbody>
</table>

“Use defaults” [✓]: The settings of this dialog overwrites the “SFC settings” of the single POUs.

See also
- Chapter 6.4.1.20.1.5.6 “SFC Flags” on page 2067

Build

Table 538: “Code generation”

| “Calculate active transitions only” | [✓]: CODESYS generates code for the currently active transition only. |

Dialog 'Properties' – 'Link to File'

**Function:** The dialog defines the link of an external file with the contents of the global variable list (GVL). You can either export the GVL to an external file or import it from an external file.

**Call:** Menu bar: “View ➔ Properties”; context menu of an object of type “Global Variable List”

<table>
<thead>
<tr>
<th>“File name”</th>
<th>Input field of the file path</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Export before compile”</td>
<td>[✓]: Before each compile of the project (for example with [F11]), CODESYS saves a file with the extension gvl in the path, which is specified in the “File name” field.</td>
</tr>
<tr>
<td>“Import before compile”</td>
<td>[✓]: The export file which is specified in the “File name” field is read automatically before each project compile. Therefore you can import a GVL which was exported from another project, for example to set up a communication by means of network variables.</td>
</tr>
</tbody>
</table>

See also
- Chapter 6.4.1.21.2.12 “Object ‘GVL’ - Global Variable List” on page 2465
- linetarget [_cds_configuring_network_variables_exchange] doesn't exist but @y.link.required='true'

Dialog 'Properties' - 'Cam'

**Function:** Use this dialog to define the global variables of the cam.
Table 539: “Dimensions”

| Master start/end position | The start and end positions of the master define the range of the master values and therefore the scale of the horizontal axis of the cam. The default settings are given in angular degrees with 0 and 360 as limiting values. |
| Slave start/end position | The associated slave positions are determined by the graph type that is defined for the cam. However, the segment depicted by the curves (this is also the scale of the vertical axis) can be defined by the slave start and end positions given here. |

Table 540: “Period”

These settings affect the work in the cam editor and cam table. Depending on these parameters, the slave start point is adjusted automatically when the end point is changed, as well as the other way around. This adjustment optimizes the period transition to be as smooth and jerk-free as possible.

| Smooth transition | The values for position, velocity, and acceleration are adjusted automatically. |
| Slave period | Indicates when the slave period is repeated mechanically. The slave position at the start and end of the master period may then be in an interval of a whole number multiple of this value. This value is effective only if the “Smooth transition” check box is selected. |

Table 541: “Continuity Requirements”

Activation of these options for the continuity of the curve does not have any effect when editing the cam. It does, however, prompt a continuity check, which reports any violations to the message view (CAM). It is not possible to edit jumps in the position curve. The default setting also requires the continuity of velocity and acceleration. You can clear these options, for example in the special case of a curve that consists of only linear segments. However, this will lead to kinks in the position curve. By default, the jerk (3rd derivative) is not tested for jumps.

| Position | ✔: The entire curve is tested for jumps. |
| Velocity | ✔: The entire curve is tested for jumps. |
| Acceleration | ✔: The entire curve is tested for jumps. |
| Jerk | ✔: The entire curve is tested for jumps. |

Table 542: “Compile Format”

When compiling, _MC_CAM_REF_ structure variables are generated. A cam is described according to the following options:

| Polynomial (XYVA) | Polynomial description of the individual points consisting of the master position, slave position, slave velocity, and slave acceleration. |

Dialog 'Properties' - 'Image Pool'

**Function:** The dialog allows for setting the basic properties of the selected image pool.

**Call:** “View ➔ Properties” of an “Image Pool” object type; context menu of an “Image Pool” object type.

| Download only used images | ✔: Instead of loading all images from the image pool, CODESYS loads only the images that are actually used in the application on the PLC. |
| Download by visualization | ✔: The image pool is downloaded with the visualization to the controller. |
| Internal | ✔: CODESYS does not provide the image pool in the “ToolBox” view. You cannot drag these images to the visualization. |
Table 543: “Symbol library settings”

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Mark library as symbol library”</td>
<td>Marks the image pool as a symbol library for use in a visualization. The symbol library receives the key <code>VisuSymbolLibrary = TRUE</code> as file property in the project information. The <code>VisuElements</code> library is inserted automatically as a placeholder library in the “POUs” pool of the Library Manager. Requirement: A library project is open. CODESYS displays symbol libraries that are installed in the repository in the “Project Settings” (“Visualization” category, “Symbol Libraries” tab).</td>
</tr>
<tr>
<td>“Textlist for symbol translation”</td>
<td>Select the text list from the drop-down list that contains the translated texts for the image pool.</td>
</tr>
</tbody>
</table>

See also
- § Chapter 6.4.1.21.2.15 “Object ‘Image Pool’” on page 2468
- § Chapter 6.4.1.9.11 “Using image pools” on page 1899
- § Chapter 6.4.1.21.4.12.10 “Dialog ‘Project Settings’ - ‘Visualization’” on page 2776

Dialog ‘Properties’ - ‘TextList’

**Function:** The dialog allows for setting the basic properties of the selected text list.

**Call:** “View ➔ Properties” of an “Text List” object type; context menu of an “Image List” object type.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Download by visualization”</td>
<td>☑: The text list is downloaded with the visualization to the controller.</td>
</tr>
<tr>
<td>“Internal”</td>
<td>☑: The text list can be used only in a library. It is not available in an ordinary CODESYS project.</td>
</tr>
</tbody>
</table>

See also
- § Chapter 6.4.1.21.2.28 “Object ‘Text List’” on page 2532

Dialog ‘Properties’ - ‘Options’

**Options (Controller)**

**Function:** This dialog provides the settings for monitoring an login for objects of type device. The availability of the options depends on the device description.

**Call:** Context menu of the device, or main menu “View ➔ Properties”, if the device is selected.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Monitoring interval (ms)”</td>
<td>Interval of the monitoring (10 ms - 1000 ms)</td>
</tr>
</tbody>
</table>

Table 544: “Interactive Login Mode”

This mode is used to prevent an accidentally login to a different controller.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“None”</td>
<td>No interaction with the user during login. Corresponds to the behavior of previous versions.</td>
</tr>
<tr>
<td>“Enter ID”</td>
<td>During login CODESYS asks to enter an ID. The ID is stored in the controller. Without a valid ID no login is possible. When login a second time, CODESYS does not ask again for the ID if the computer name, the user name, the device name and the device address have not changed. The information is saved in the project options.</td>
</tr>
</tbody>
</table>
**“Press key”**
During login a dialog prompts and requests the user to press a key on the controller. The timeout for this action is saved in the device description.

**“Wink (= blink an LED)”**
During login a led blinks on the connected controller.

### Table 545: “Symbol Configuration”

| **Access variables in sync with IEC tasks** | ☐ | Default setting, consistent access is not permitted |
| ☑ | Consistent access is permitted |
| The setting only will take effect when all applications and boot applications are re-downloaded to the controller. |
| Note: If the option is activated, then the jitter for all IEC applications may increase on this device! The consistent access can disturb the real-time capability. |

Siehe auch
- ☼ Chapter 6.4.1.21.2.8 “Object ‘Device’ and Generic Device Editor” on page 2427
- ☼ Chapter 6.4.1.21.2.27 “Object ‘Symbol Configuration’” on page 2523

### Dialog 'Properties' - 'Monitoring'

**Function:** The tab contains options for the monitoring of transitions in SFC.

**Call:** Select transition object, click “Properties”; menu bar: “View ➔ Properties”.

| **Enable monitoring** | ☑ | An implicit variable is created for the transition, which is then always given the current property value when the application calls the Transition method. The value stored last in this variable is displayed in the monitoring. |
| **Monitoring using call** | ☑ | The transition to be monitored is read by directly calling the transition. Note: When you activate this option, you have to consider possible side effects. These kinds of side effects can occur if additional operations are implemented in the transition. |

See also
- ☼ Chapter 6.4.1.21.2.21.11 “Object ‘Transition’” on page 2499
- ☼ Chapter 6.4.1.20.6.3.26 “Attribute ‘monitoring’” on page 2295

### Dialog 'Project Settings'

| 6.4.1.21.4.12.1 General................................................................. | 2767 |
| 6.4.1.21.4.12.2 Dialog 'Project Settings' - 'SFC'.............................. | 2767 |
| 6.4.1.21.4.12.3 Dialog 'Project Settings' - 'Users and Groups'........... | 2768 |
| 6.4.1.21.4.12.4 Dialog Box 'Project Settings' - 'Compileoptions'.......... | 2769 |
| 6.4.1.21.4.12.5 Dialog Box 'Project Settings' - 'Compiler Warnings'....... | 2770 |
| 6.4.1.21.4.12.6 Dialog 'Project Settings' – 'Source Download'........... | 2770 |
| 6.4.1.21.4.12.7 Dialog 'Project Settings' - 'Page Setup'................... | 2772 |
| 6.4.1.21.4.12.8 Dialog 'Project Settings' - 'Security'....................... | 2772 |
| 6.4.1.21.4.12.9 Dialog 'Project Settings' - 'Static Analysis Light'....... | 2773 |
| 6.4.1.21.4.12.10 Dialog 'Project Settings' - 'Visualization'.............. | 2776 |
| 6.4.1.21.4.12.11 Dialog 'Project Settings' - 'Visualization Profile'....... | 2777 |
General

Symbol: 

**Function:** The object contains the basic configuration of the project. In the “Project Settings” dialogs the configuration can be adjusted.

**Call:** Double click on the “Project Settings” object in the device tree, or main menu “Project ➔ Project Settings”.

CODESYS saves the project settings directly in the project. If a project is transferred to another system for example the “Project Settings” object is transferred as well without the need of a project archive.

The project settings are valid project wide. Dependent on the installed packages the dialogs provide settings for several categories, as for example “SFC” or “User and Groups”.

See also

- [Chapter 6.4.1.21.3.9.4 “Command ‘Package Manager’”](#) on page 2655

Dialog 'Project Settings' - 'SFC'

Symbol: 

**Function:** This dialog is used for configuring the settings of SFC objects. The properties of each new SFC object automatically have the configured settings.

**Call:** Menu bar: “Project ➔ Project Settings” (“SFC”).

**Requirement:** A project is open.

**Tab 'Flags'**

Implicitly generated variables for checking and monitoring the processing in an SFC diagram

| “Active” | ✅: The corresponding variable is used. |
| “Declare” | ✅: The corresponding variable is created automatically. Otherwise, you have to declare the variable explicitly if you intend to use it (“Use” is selected). |

| “Apply to all” | In this dialog, CODESYS applies changes to existing SFC objects. CODESYS selects the “Use defaults” check box in the properties of the SFC POUs. |

**NOTICE!**

Automatically declared variables are visible in the declaration part of the SFC editor only in online mode.

**Tab 'Build'**

Table 546: “Code Generation”

| “Calculate active transitions only” | ✅: CODESYS generates code only for currently active transitions. |
This part of the dialog is available only for compiler versions < 3.4.1.0.

| “Company” | Defines the SFC library that CODESYS uses by default. |
| “Title”   | Enables unique references to libraries. Required when various versions of the library are available on the system. Please make sure that there are no discrepancies between the namespace defined in the library manager and the namespace defined for the individual object. The SfcIec.library data is used for the default settings that CODESYS provides with the default profile. |
| “Version” | |

Each SFC block stores the information via the library version that applied when you added the block. This can cause you to use multiple library versions within the same project. In order to prevent this, you are prevented from defining specific versions of IecSfc.library (as of compiler version 3.4.1.0). The library version, which you use for all SFC blocks in the project, is defined with a placeholder. CODESYS resolves the placeholder depending on the compiler version in use. The allocation of the library version to the compiler version is defined in the library profile.

See also
- § Chapter 6.4.1.20.1.5.6 “SFC Flags” on page 2067
- § Chapter 6.4.1.17.3 “Information for Library Developers” on page 2035

Dialog 'Project Settings' - 'Users and Groups'

Symbol: 🌐

Function: This dialog is for the configuration of the user management for the current project.

Call: Menu “Project ➔ Project Settings”, category “Users and Groups”

Tab 'User'

Displays the users and their memberships in groups

| “Add”       | Opens the “Add User” dialog. |
| “Edit”      | Opens the “Edit User” dialog. |
| “Delete”    | An error message appears if you attempt to delete the last user of a group, since a group must have at least one member. |

Table 548: “Add User / Edit User”

Input fields for setting up a new user account or changing an existing one

| “Active” | ☑: You may use the user account, default
|          | ☐: The user cannot log in. If he attempts to login again with incorrect login data, this can result in automatic deactivation of the account; see below: Settings. |
| “Memberships” | List of all user groups that you have defined in addition to the group “Everyone” (to which each new user automatically belongs).
|           | ☑<group name>: the new user belongs to the group. |
Table 549: “Export/Import”

<table>
<thead>
<tr>
<th>“Export Users and Groups”</th>
<th>The command opens the standard dialog for saving a file in the local file system. You can store the users and groups definitions of the project in a file *.users in xml format.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Import Users and Groups”</td>
<td>Export users and groups opens the standard dialog for browsing the local file system for a file. Search for a file with extension *.users in order to import the users and groups definitions, stored in this file, into the project.</td>
</tr>
</tbody>
</table>

Tab 'Groups'

Display of the groups and their members. A group can also be a member of a group.

<table>
<thead>
<tr>
<th>“Add”</th>
<th>Opens the “Add Group” dialog.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Edit”</td>
<td>Opens the “Edit Group” dialog.</td>
</tr>
<tr>
<td>“Delete”</td>
<td>If you delete a group, the user accounts of the members remain unchanged. You cannot delete the groups “Everyone” and “Owner”.</td>
</tr>
</tbody>
</table>

On button “Export/Import” please see above the “User” paragraph.

Tab 'Settings'

Display of the groups and their members in a tree structure. A group can also be a member of a group.

<table>
<thead>
<tr>
<th>“Maximum number of authentication trials”</th>
<th>(standard) : If the user has attempted to login with an incorrect password the number of times specified here, the user account is deactivated.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Automatic logoff after time of inactivity”</td>
<td>: The number of the unsuccessful attempts is unlimited</td>
</tr>
</tbody>
</table>

| “Automatic logoff after time of inactivity” | : The user is automatically logged out if CODESYS does not register any user actions by mouse or keyboard during the time period (minutes) specified here. |

See also

- Chapter 6.4.1.6 “Protecting and Saving Projects” on page 1819
- Chapter 6.4.1.21.3.5.28 “Command ‘User management’ – ‘Log in User’” on page 2613

Dialog Box 'Project Settings' - ‘Compileoptions’

Symbol: ✅

Function: This dialog box is for configuring the compiler options.

Call: Main menu “Project ➔ Project Settings” (“Compileoptions” category).

Requirement: A project is open.

Table 550: “Compilerversion”

<table>
<thead>
<tr>
<th>“Fix Version”</th>
<th>Defines the compiler version that CODESYS uses when compiling and downloading for compile (for example, “3.5.6.0” for version 3.5 SP6).</th>
</tr>
</thead>
</table>

2024/01/05 3ADR010583, 1, en_US 2769
### Table 551: “Settings”

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Allow unicode characters for identifiers”</td>
<td>Cleared by default because using Unicode characters in identifier names is not permitted in the IEC standard. May be required for some foreign languages (for example, Asian languages).</td>
</tr>
<tr>
<td>“Replace constants”</td>
<td>[default]: CODESYS loads the value directly for every scalar constant (not for strings, arrays, and structures). In online mode, CODESYS marks the constants with a symbol that is prepended to the value in the declaration editor or monitoring view. In this case, access is not possible, for example by means of an <code>ADR</code> operator, forcing, and writing.</td>
</tr>
<tr>
<td>“Enable logging in breakpoints”</td>
<td>For breakpoints that are defined as execution points, you can create a message text in the “Execution point settings” dialog box. CODESYS prints this text to the device log when the application halts at the execution point.</td>
</tr>
</tbody>
</table>

### Table 552: “Compiler Warnings”

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Maximum number of warnings”</td>
<td>Refers to the warnings that CODESYS prints to the messages view. You define the selection of displayed compiler warnings in the “Project Settings” dialog box in the “Compiler Warnings” category.</td>
</tr>
</tbody>
</table>

See also
- § Chapter 6.4.1.21.4.12.4 “Dialog Box ‘Project Settings’ - ‘Compileoptions’” on page 2769
- § Chapter 6.4.1.21.2.8.9 “Tab 'Log’ on page 2437

### Dialog Box ‘Project Settings’ - ‘Compiler Warnings’

**Symbol:** 🔍

**Function:** This dialog box is used for selecting the compiler warnings that CODESYS displays in the messages view during a compile process.

**Call:** Call: Main menu “Project ➔ Project Settings” (“Compiler Warnings” category).

**Requirement:** A project is open.

You define the maximum number of listed warnings in the “Compileoptions” dialog box.

See also
- § Chapter 6.4.1.21.4.12.4 “Dialog Box ‘Project Settings’ - ‘Compileoptions’” on page 2769
- § Chapter 6.4.1.21.3.6.4 “Command ‘Build’” on page 2619

### Dialog ‘Project Settings’ – ‘Source Download’

**Symbol:** 📂

**Function:** This dialog defines the compilation and the storage of the source code as a source-code download archive on one or more controllers.

**Call:** “Project ➔ Project settings” menu, “Download source code” category

A source-code download archive is a project archive with the name `Archiv.prj`. 
The settings affect the command “Online ➔ Load source code to connected controller”. These settings do not affect the command “File ➔ Load source code to controller”.

**Table 553: “Destination device”**

<table>
<thead>
<tr>
<th>Definition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;name of controller&gt;</code></td>
<td>Selected controller. CODESYS loads the project archive to this controller. Requirement: the project contains several controllers.</td>
</tr>
<tr>
<td><code>&lt;all devices in project&gt;</code></td>
<td>CODESYS loads the project archive to all controllers in the project.</td>
</tr>
</tbody>
</table>

**Table 554: “Content”**

<table>
<thead>
<tr>
<th>Definition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Use compact download”</td>
<td>[☑]: The project archive contains only that device in the project that contains the active application.</td>
</tr>
<tr>
<td></td>
<td>[☐]: The project archive contains all the devices in the project</td>
</tr>
<tr>
<td>“Additional Files”</td>
<td>Opens the “Additional files” dialog where you can select additional files for downloading.</td>
</tr>
<tr>
<td></td>
<td>Not all types of additional files are available for each project.</td>
</tr>
<tr>
<td></td>
<td>“Download information files” - Project information files</td>
</tr>
<tr>
<td></td>
<td>“Library profile” - Includes the applied profile</td>
</tr>
<tr>
<td></td>
<td>“Project information” - Includes the project information</td>
</tr>
<tr>
<td></td>
<td>“Referenced devices” - Includes all device descriptions of third party devices into the archive</td>
</tr>
<tr>
<td></td>
<td>“Referenced libraries” - Includes all referenced libraries into the archive</td>
</tr>
<tr>
<td></td>
<td>“Referenced visualisation styles” - Includes the used styles</td>
</tr>
<tr>
<td></td>
<td>“Visualisation profile” - Includes the used profile</td>
</tr>
<tr>
<td></td>
<td>The most important types “Referenced devices” and “Referenced libraries” should always be included, if the archive shall be usable by Automation Builder installations without availability of the required devices or libraries.</td>
</tr>
</tbody>
</table>

**Table 555: “Timing”**

<table>
<thead>
<tr>
<th>Definition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Implicitly at program download and online change”</td>
<td>Each time an application is loaded or an online change is made, CODESYS additionally loads the project archive to the target device(s) with no further prompt.</td>
</tr>
<tr>
<td>“Implicitly at creating boot project”</td>
<td>Each time a boot application is created, CODESYS additionally loads the project archive to the target device(s) with no further prompt.</td>
</tr>
<tr>
<td>“Implicitly at creating boot project, download and online change”</td>
<td>Each time a boot application is created, an application is loaded or an online change is made, CODESYS additionally loads the project archive to the target device(s) with no further prompt.</td>
</tr>
<tr>
<td>“Prompt at program download and online change”</td>
<td>Each time an application is loaded or an online change is made, CODESYS opens a prompt, where you can select whether CODESYS should load the project archive to the controller.</td>
</tr>
<tr>
<td>“Only on demand”</td>
<td>A prompt opens only if the command “Online ➔ Load source code to connected controller” is called. There you can select whether CODESYS should load the project archive to the controller.</td>
</tr>
</tbody>
</table>
Dialog 'Project Settings' - 'Page Setup'

Symbol:  

**Function:** This dialog defines the layout for the print version of the project contents. This layout is used for the printout of the project information by clicking “File ➤ Print” and the printout of the project documentation by clicking “Project ➤ Document”.

**Call:** Main menu “Project ➤ Project Settings” (“Page Setup”)

You can change settings the following:

- “Paper”
- “Margins”
- “Header and Footer”
- “Document”
- “Title Page”

**Table 556: “Edit Header, Edit Footer”**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Row spanning”</strong></td>
<td>Number of rows that CODESYS should merge into a single column.</td>
</tr>
<tr>
<td><strong>“Column spanning”</strong></td>
<td>Number of columns that CODESYS should merge into a single row.</td>
</tr>
<tr>
<td></td>
<td>Opens the list of available placeholders for the “Text” field.</td>
</tr>
</tbody>
</table>

When printing the page, CODESYS provides the placeholders with the current values.

See also

- % Chapter 6.4.1.21.3.2.14 “Command 'Page Setup’” on page 2560
- % Chapter 6.4.1.21.3.5.19 “Command 'Document’” on page 2606
- % Chapter 6.4.1.21.3.2.12 “Command ’Print’” on page 2560

Dialog 'Project Settings' - 'Security'

Symbol:  

**Function:** this dialog is for the configuration of the project protection by a password, a dongle, or a certificate.

**Call:** Menu bar: “Project ➤ Project Settings” (category “Security”).

**NOTICE!**

If the encryption password is lost you can no longer open the project. You can also no longer restore it.
### No protection

- The project file is not protected from unauthorized access and data manipulation.

Note: We strongly recommend that you use security functionality.

- The "Password", "Dongle", and "Certificates" options cannot be selected.

### Integrity check

When you create a new project, this option is enabled by default.

- The project file is stored in a proprietary format and its integrity is checked each time the project is loaded. The file may be incompatible with older versions of the development system.

Please note that the project file is not encrypted. To better protect your data, activate one of the encryption functions.

### Encryption

- The "Password", "Dongle", and "Certificates" encryption functions can be selected.

### Password

Entering, changing and confirming the encryption password.

If you save the project with these settings you must enter the password later in order to open the project again, even if it is to be loaded as a library reference.

### Dongle

Requirement: you have connected the CODESYS security key (dongle) to the computer.

- "Add": The dialog "Add Registered Dongle" opens.

### Registered dongles

Drop-down list of the registered dongles.

### Certificates

Certificates are used for the encryption of contents of the open project file.

Requirement: The certificates for all users who share the project must be installed in the local memory.

- The "Certificate selection" dialog opens.

---

**Table 557: Adding a registered dongle**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Dongle&quot;</td>
<td>Drop-down list of all connected dongles.</td>
</tr>
<tr>
<td>&quot;Update&quot;</td>
<td>CODESYS refreshes the drop-down list.</td>
</tr>
<tr>
<td>&quot;Flash&quot;</td>
<td>The LEDs of the currently selected dongle flash for two seconds (if it supports this function).</td>
</tr>
</tbody>
</table>

The dongle must be connected to the computer when CODESYS loads the project, even if it is loaded as a library reference.

See also

- Chapter 6.4.1.6 "Protecting and Saving Projects" on page 1819
- Chapter 6.4.1.6.3 "Assigning Passwords" on page 1824
- Chapter 6.4.1.6.4 "Protecting Projects Using a Dongle" on page 1825
- Chapter 6.4.1.6.8 "Encrypting Projects with Certificates" on page 1829
- Chapter 6.4.1.21.4.19 "Dialog 'Certificate Selection'" on page 2811

---

**Dialog 'Project Settings' - 'Static Analysis Light'**

**Symbol:** §

**Function:** This dialog activates the tests that the light version of CODESYS Static Analysis performs each time code is generated.

**Call:** Menu bar: “Project ➔ Project Settings” (“Static Analysis Light” category).
You can exclude lines of code from the static code analysis by marking
the code with the pragma `{analysis ...}` or the pragma `{attribute
'analysis' := '...'}`.

### Additional compile tests

<table>
<thead>
<tr>
<th>Rule ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SA0033: Unused variables</strong></td>
<td>Finds variables that are declared, but not used within the compiled program code. For GVL variables: If there are multiple applications in one project, then only the objects under the currently active application are affected. If there is only one application, then the objects in the POU's view are also affected.</td>
</tr>
</tbody>
</table>
| **SA0028: Overlapping memory areas** | Detects the locations where two or more variables reserve the same storage space. For example, this occurs for the following declarations:
```
var1 AT %QB21: INT
and
var2 AT %QD5: DWORD.
```
In this case, both variables use byte 21, which means that the memory range of the variables overlap. |
| **SA0006: Write access from multiple tasks** | Detects variables that are written by more than one task. |
| **SA0004 “Multiple write access on output”** | Detects outputs that are written to more than one location. Note: No error is reported when an output variable (VAR_IN_OUT) is written in different branches of IF and CASE statements. Note: A pragma cannot deactivate this rule. |
| **SA0027: Multiple use of identifiers** | Detects multiple uses of a name/identifier for a variable or an object (POU) within the scope of a project. The following cases are detected:
- The name of an enumeration constant is the same as in another enumeration in the application or used in an included library.
- The name of a variable is the same as an object in the application or an included library.
- The name of a variable is the same as for an enumeration constant in an enumeration in the application or an included library.
- The name of an object is the same as another object in the application.
- The name of a variable is the same as the name of a method.
- The name of an object is the same as the name of a superordinate object ("parent object"). |
| **SA0167: Temporary function block instances** | The test detects function block instances that are declared as temporary variables. This concerns instances that are declared in a method or in a function or as VAR_TEMP, and therefore are reinitialized in each processing cycle and for each POU call. |
Examples

SA0003: Empty statements

; (* Comment *); iVar;

SA0006: Concurrent access

FUNCTION_BLOCK ADD_FB
  g_iTemp1 := g_iTemp1 + INT#1;
PROGRAM PLC_PRG //controlled by MainTask
  g_iTemp1 := g_iTemp1 + INT#2;
  g_xTemp2 := g_iTemp1 > INT#10;
PROGRAM PLC_PRG_1 //controlled by SubTask
  g_iTemp1 := g_iTemp1 - INT#3;
  g_xTemp2 := g_iTemp1 < INT#-10;

SA0004 Multiple write access on output

VAR_GLOBAL
  g_xVar AT %QX0.0 : BOOL ;
  g_iTest AT %QW0 : INT ;
END_VAR

PROGRAM PLC_PRG
IF iCondition < INT#0 THEN
  g_xVar := TRUE;
  g_iTest := INT#12;
END_IF
CASE iCondition OF
  INT#1:
    g_xVar := FALSE;
  INT#2:
    g_iTest := INT#11;
ELSE
    g_xVar := TRUE;
    g_iTest := INT#9;
END_CASE

SA0006: Write access from multiple tasks

FUNCTION_BLOCK ADD_FB
  g_iTemp1 := g_iTemp1 + INT#1;
PROGRAM PLC_PRG // Controlled by MainTask
  g_iTemp1 := g_iTemp1 + INT#2;
  g_xTemp2 := g_iTemp1 > INT#10;
PROGRAM PLC_PRG_1 //Controlled by SubTask
  g_iTemp1 := g_iTemp1 - INT#3;
  g_xTemp2 := g_iTemp1 < INT#-10;

SA0027: Multiple use of name

PROGRAM PLC_PRG
VAR
  ton : INT;     // error SA0027
END_VAR

SA0029: Different notation in implementation and declaration

The PLC_PRG POU and a fnc function POU are in the device tree.
PROGRAM PLC_PRG
VAR
  iVar: INT;
  _123test_var_: INT;
END_VAR
ivar := iVar + 1; // notation different to that in the declaration part -> SA0029
_123TEST_var_ := _123test_var_INT; // notation different to that in the declaration part -> SA0029
Fnc(); // notation different to that in the devices tree -> SA0029
END_VAR

SA0167: Temporary function block instances
PROGRAM PLC_PRG
VAR
END_VAR
VAR_TEMP
  yafb: AFB;
END_VAR
FUNCTION Fun : INT
VAR_INPUT
END_VAR
VAR
  funafb: AFB;
END_VAR
METHOD METH: INT
VAR_INPUT
END_VAR
VAR
  methafb: AFB;
END_VAR

See also
● § Chapter 6.4.1.9.13.3 “Analyzing code statically” on page 1904

Dialog 'Project Settings' - 'Visualization'

Symbol: 🎨

Function: The dialog is used to configure the project-wide settings for objects of type “Visualization”.

Call: Menu bar: “Project ➔ Project Settings”, “Visualization” category

Requirement: A project is open.
Tab 'General'

Table 558: “Visualization Directories”

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Text list files”</td>
<td>Directory which contains text lists that are available in the project to configure texts for different languages. CODESYS uses the directory, for example to import or export text lists. After clicking , the “Select Directory” dialog opens which allows for the selection of a directory in the file system.</td>
</tr>
<tr>
<td>“Image files”</td>
<td>Directory which contains image files that are available in the project. Multiple folders are separated with a semicolon. CODESYS uses the directory, for example to import or export image files. After clicking , the “Select Directory” dialog opens which allows for the selection of a directory in the file system.</td>
</tr>
</tbody>
</table>

Table 559: “Advanced”

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
</table>
| “Activate property handling in all element properties” | You can also configure a visualization element with a property in those of its properties in which you select an IEC variable. Then CODESYS creates additional code for the property handling when a visualization is compiled. Requirement: Its IEC code contains at least an object of type “Interface property” (a property).
|                                      | Requirement: “Visible” is selected.                                                                                                         |
| “Enable implicit checks for visualization POUs” | The implicit check is also performed for visualization POUs. As a result, additional code is generated, which increases memory usage. When memory is limited, this option should be disabled. |

See also
- Object 'Property'

Tab 'Symbol Libraries'

Table 560: “Visualization Symbol Libraries”

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Symbol libraries”</td>
<td>List of all installed symbol libraries (example: VisuSymbols)</td>
</tr>
<tr>
<td>“Assigned”</td>
<td>Symbol library is selected in the project and CODESYS makes it available in the “Visualization ToolBox” view of a visualization. Symbol library is installed in the library repository, but CODESYS does not make it available in the “Visualization ToolBox” view of a visualization.</td>
</tr>
</tbody>
</table>

See also
- CODESYS Visualization
- Dialog 'Add Visualization'

Dialog 'Project Settings' - 'Visualization Profile'

Symbol: 

Function: The dialog enables the setting of the visualization profile.
**Call:** Menu “Project ➔ Project Settings”, category “Visualization Profile”

**Requirement:** A project is open.

---

**Table 561: “Visualization Profile”**

<table>
<thead>
<tr>
<th>“Certain profile”</th>
<th>Profile that CODESYS uses in the project and that determines the visualization elements that are available in the project. The selection list contains all the profiles installed so far.</th>
</tr>
</thead>
</table>

---

**Dialog 'Project Environment’**

| 6.4.1.21.4.13.1 | General......................................................................................................................... 2778 |
| 6.4.1.21.4.13.2 | Dialog ‘Project Environment’ – ‘Library Versions’.......................... 2778 |
| 6.4.1.21.4.13.3 | Dialog ‘Project Environment’ - ‘Compiler Version’......................... 2778 |
| 6.4.1.21.4.13.4 | Dialog 'Project Environment' - 'Device Versions'................................. 2779 |
| 6.4.1.21.4.13.5 | Dialog 'Project Environment' – ‘Visualization Profile’.................... 2779 |
| 6.4.1.21.4.13.6 | Dialog ‘Project Environment’ – ‘Visualization Styles’............. 2780 |
| 6.4.1.21.4.13.7 | Dialog ‘Project Environment’ – ‘Visualization Symbols’........ 2780 |

**General**

**Function:** You use this dialog for checking the actuality of the software and of the files, which are included in the project. CODESYS checks for example the selected compiler and finds out if there is a newer version. In such a case you can update the affected components.

**Call:** Main menu “Project”

**Dialog 'Project Environment’ – ‘Library Versions’**

**Function:** This dialog displays the libraries of the opened project for which newer versions are available.

**Call:** Main menu “Project ➔ Project Environment”, tab “Library Version ”

This dialog opens automatically when you open a project containing outdated libraries.

**Table 562**

<table>
<thead>
<tr>
<th>“Action”</th>
<th>Double-click inside the field to select the desired actions.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Check for updates when loading this project”</td>
<td>✔: Checking takes place each time the project is opened. ☐: Checking takes place once only.</td>
</tr>
<tr>
<td>“Set all to newest”</td>
<td>CODESYS uses the newest available version of the library.</td>
</tr>
<tr>
<td>“OK”</td>
<td>CODESYS performs the selected action(s).</td>
</tr>
</tbody>
</table>

**Dialog 'Project Environment' - ‘Compiler Version’**

**Function:** This dialog shows the current compiler version of the project and provides the capability of updating.

**Call:** Main menu “Project ➔ Project Environment” (“Compiler Version” tab).
Table 563

<table>
<thead>
<tr>
<th>“Current compiler version in project”</th>
<th>Shows the set compiler version for the open project.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Recommended, newest version”</td>
<td>Shows the latest version.</td>
</tr>
</tbody>
</table>
| “Action”                            | ● “Do not update”: The compiler version of the project remains the same.  
                                       | ● “Update to x.x.x.x”: The selected compiler version is set for the project. |
| “Check for updates when loading this project” | ☑: CODESYS checks for new versions each time the project is opened. If there is a new version, then the respective update dialog opens automatically.  
                                           | ☐: The compiler version is not checked. The update dialogs do not open automatically. |
| “Set all to newest”                 | The compiler version is set to the latest version. |

Dialog 'Project Environment' - 'Device Versions'

Function: This dialog shows the devices of the open project in which there are new versions available.

Call: Main menu “Project ➔ Project Environment” (“Device Versions” tab)

This dialog opens automatically when you open a project that contains an outdated device.

Table 564

<table>
<thead>
<tr>
<th>“Action”</th>
<th>Double-click in the field to select the required actions.</th>
</tr>
</thead>
</table>
| “Check for updates when loading this project” | ☑: The check is performed when the project is opened.  
                                           | ☐: The check is performed one time only. |
| “Set all to newest” | CODESYS uses the latest library version. |
| “OK” | CODESYS executes the selected actions. |

Dialog 'Project Environment' – 'Visualization Profile'

Function: This dialog shows the current visualization profile of the project. The profile can be updated here.

Call: Menu bar: “Project ➔ Project Environment” (“Visualization Profile” tab).

<table>
<thead>
<tr>
<th>“Current visualization profile in the project”</th>
<th>The set visualization profile of the open project.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Recommended, newest profile”</td>
<td>The newest version.</td>
</tr>
</tbody>
</table>
| “Action”                                      | ● “Do not update”: The visualization profile of the project remains unchanged.  
                                           | ● “Update to x.x.x.x”: CODESYS updates the project to the selected visualization profile. |
| “Check for updates when loading this project” | ☑: CODESYS checks for new profiles each time the project is opened. If there is a new version, then the respective update dialog opens automatically.  
                                           | ☐: Not test of the profile when opening the project. The update dialogs do not open automatically. |
| “Set all to newest”                           | CODESYS updates the . |
See also
- Help about visualization

Dialog 'Project Environment' – 'Visualization Styles'

**Function:** This dialog shows the current visualization style of the project and provides the capability of updating it.

**Call:** Menu bar: “Project ➔ Project Environment” (“Visualization Styles” tab).

**Table 565:** “Newer versions are available for the following visualization styles currently in use”

<table>
<thead>
<tr>
<th>“Visualization style”</th>
<th>Version of the set visualization style in the open project</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Current”</td>
<td>Current version of the visualization style (example: 3.5.6.0)</td>
</tr>
<tr>
<td>“Recommended”</td>
<td>Recommended version of the visualization style (example: 3.5.7.0)</td>
</tr>
</tbody>
</table>
| “Action”              | ● “Do not update”: The visualization style of the project remains unchanged.  
                         | ● “Update to x.x.x.x”: CODESYS updates the project to the version of the selected visualization style. |
| “Check for updates when loading this project” | ☑: CODESYS checks for new versions each time the project is opened. If there is a new version, then the respective update dialog opens automatically.  
                         | ☐: The version is not checked. The update dialogs do not open automatically. |
| “Set all to newest”   | CODESYS updates the version. |

See also
- Help for visualization, section "Visualization style"

Dialog 'Project Environment' – 'Visualization Symbols'

**Function:** The dialog lists installed symbol libraries and allows for you to assign symbol libraries to a project.

**Call:** Menu bar: “Project ➔ Project Environment”, “Visualization Symbols” tab

**Requirement:** The open project contains a visualization and has been saved with a compiler version < 3.5.7.0. CODESYS recognizes symbol libraries in compiler version 3.5.7.0 and higher.

<table>
<thead>
<tr>
<th>“Symbol library”</th>
<th>List of all installed symbol libraries</th>
</tr>
</thead>
</table>
| “Active”         | ☑: Symbol library is selected for the project. CODESYS provides its symbols in the “Visualization Toolbox” view.  
                         | ☐: Symbol library has been previously installed only in the library repository. |

See also
- Help for visualization, "Using the symbol library in the visualization" chapter
Dialog 'Options'

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.4.1.21.4.14.1 General</td>
<td>General...</td>
<td>2781</td>
</tr>
<tr>
<td>6.4.1.21.4.14.2 Dialog 'Options' - 'Automation Builder'</td>
<td>This dialog is for the configuration of the settings for the Automation Builder.</td>
<td>2781</td>
</tr>
<tr>
<td>6.4.1.21.4.14.3 Dialog 'Options' - 'C Compiler'</td>
<td></td>
<td>2782</td>
</tr>
<tr>
<td>6.4.1.21.4.14.4 Dialog 'Options' - 'CFC Editor'</td>
<td></td>
<td>2784</td>
</tr>
<tr>
<td>6.4.1.21.4.14.5 Dialog 'Options' – 'Declaration Editor'</td>
<td></td>
<td>2785</td>
</tr>
<tr>
<td>6.4.1.21.4.14.6 Dialog 'Options' – 'Device Description Download'</td>
<td></td>
<td>2785</td>
</tr>
<tr>
<td>6.4.1.21.4.14.7 Dialog 'Options' - 'Device Editor'</td>
<td></td>
<td>2786</td>
</tr>
<tr>
<td>6.4.1.21.4.14.8 Dialog 'Options' - 'Diagnosis'</td>
<td></td>
<td>2786</td>
</tr>
<tr>
<td>6.4.1.21.4.14.9 Dialog 'Options' – 'External tools'</td>
<td></td>
<td>2786</td>
</tr>
<tr>
<td>6.4.1.21.4.14.10 Dialog 'Options' - 'FBD, LD, and IL'</td>
<td></td>
<td>2787</td>
</tr>
<tr>
<td>6.4.1.21.4.14.11 Dialog 'Options' - 'Help'</td>
<td></td>
<td>2789</td>
</tr>
<tr>
<td>6.4.1.21.4.14.12 Dialog 'Options' - 'IEC 60870-5-104'</td>
<td></td>
<td>2789</td>
</tr>
<tr>
<td>6.4.1.21.4.14.13 Dialog 'Options' – 'International Settings'</td>
<td></td>
<td>2790</td>
</tr>
<tr>
<td>6.4.1.21.4.14.15 Dialog 'Options' – 'Libraries'</td>
<td></td>
<td>2790</td>
</tr>
<tr>
<td>6.4.1.21.4.14.16 Dialog 'Options' – 'Library Download'</td>
<td></td>
<td>2790</td>
</tr>
<tr>
<td>6.4.1.21.4.14.17 Dialog 'Options' – 'Load and Save'</td>
<td></td>
<td>2791</td>
</tr>
<tr>
<td>6.4.1.21.4.14.18 Dialog 'Options' – 'Message View'</td>
<td></td>
<td>2792</td>
</tr>
<tr>
<td>6.4.1.21.4.14.19 Dialog 'Options' – 'Monitoring'</td>
<td></td>
<td>2792</td>
</tr>
<tr>
<td>6.4.1.21.4.14.20 Dialog 'Options' – 'PLCopenXML'</td>
<td></td>
<td>2793</td>
</tr>
<tr>
<td>6.4.1.21.4.14.21 Dialog 'Options' – 'Proxy Settings'</td>
<td></td>
<td>2793</td>
</tr>
<tr>
<td>6.4.1.21.4.14.22 Dialog 'Options' – 'Refactoring'</td>
<td></td>
<td>2794</td>
</tr>
<tr>
<td>6.4.1.21.4.14.23 Dialog 'Options' – 'SFC Editor'</td>
<td></td>
<td>2795</td>
</tr>
<tr>
<td>6.4.1.21.4.14.24 Dialog 'Options' – 'SmartCoding'</td>
<td></td>
<td>2796</td>
</tr>
<tr>
<td>6.4.1.21.4.14.25 Dialog 'Options' – 'Startup settings'</td>
<td></td>
<td>2797</td>
</tr>
<tr>
<td>6.4.1.21.4.14.26 Dialog 'Options' – 'Text Editor'</td>
<td></td>
<td>2798</td>
</tr>
</tbody>
</table>

**General**

**Function:** You use the dialog box for selecting the CODESYS options. With these options you configure the appearance and the behavior of the user interface. CODESYS saves the current configuration as standard settings in the local system.

**Call:** Main menu “Tools ➔ Options”

**Dialog 'Options' - ‘Automation Builder’**

**Symbol:** 🗨️

**Function:** This dialog is for the configuration of the settings for the Automation Builder.

**Call:** menu “Tools ➔ Options”, category “Automation Builder”

**Tab 'DeviceTree'**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Show warning message on delete objects”</td>
<td>☑: A warning appears whether the selected object should really be deleted from the project.</td>
</tr>
<tr>
<td>“Show device type”</td>
<td>☑: In the project tree the device type is displayed in brackets</td>
</tr>
<tr>
<td>“Show device tag”</td>
<td>☑: Show device tag</td>
</tr>
</tbody>
</table>
### Tab 'Project'

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close Add / Update object dialog after single transaction</td>
<td>The &quot;Add/Update Object&quot; dialog is closed after a single transaction.</td>
</tr>
<tr>
<td>Display all versions</td>
<td>Some devices are present in several versions. If the check mark is set, then all devices in all versions are displayed. If the checkbox is not set (default), then only the latest version is displayed.</td>
</tr>
</tbody>
</table>

### Tab 'Editors'

Max parallel opened editors allowed 25 (max. 99).

#### I/O-mapping

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use tree based I/O mapping dialog</td>
<td>The view of the I/O mapping dialog is defined, here use tree based I/O mapping dialog.</td>
</tr>
<tr>
<td>Use list based I/O mapping dialog</td>
<td>The view of the I/O mapping dialog is defined, here use list based I/O mapping dialog.</td>
</tr>
<tr>
<td>Use both I/O mapping dialog</td>
<td>The view of the I/O mapping dialog is defined, here use both based I/O mapping dialog.</td>
</tr>
</tbody>
</table>

#### Tab 'General'

- Participate in ABB usability improvement program (Function not yet active.)

### Dialog 'Options' - 'C Compiler'

Symbol: í

**Function:** This dialog is for the configuration of the settings for the “C Compiler”.

**Call:** menu “Tools ➔ Options”, category “C Compiler”

### Tab 'GCC 4.7.3'

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path to Compiler executable</td>
<td>Path to the file location.</td>
</tr>
<tr>
<td>&quot;...&quot;: Open the file manager to search for the file location.</td>
<td></td>
</tr>
<tr>
<td>&quot;Reset&quot;: Resets the input.</td>
<td></td>
</tr>
<tr>
<td>Environment Variables</td>
<td></td>
</tr>
<tr>
<td>&quot;New...&quot;: A new input window opens.</td>
<td></td>
</tr>
<tr>
<td>&quot;Variable name:&quot; Enter new variables.</td>
<td></td>
</tr>
<tr>
<td>&quot;Variable value:&quot; Enter new variables.</td>
<td></td>
</tr>
<tr>
<td>&quot;Edit...&quot;: A new input window opens.</td>
<td></td>
</tr>
<tr>
<td>&quot;Variable name:&quot; Edit new variables.</td>
<td></td>
</tr>
<tr>
<td>&quot;Variable value:&quot; Edit new variables.</td>
<td></td>
</tr>
<tr>
<td>&quot;Delete&quot;: Deletes the entries.</td>
<td></td>
</tr>
<tr>
<td>&quot;Reset&quot;: Deletes the entries.</td>
<td></td>
</tr>
<tr>
<td><strong>Include path</strong></td>
<td>&quot;New..:&quot; A new input window opens.</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>&quot;Edit...:&quot; A new input window opens.</td>
<td>&quot;Path:&quot; Edit include path.</td>
</tr>
<tr>
<td><strong>C:\Program Files (x86)\ABB\AutomationBuilder\CCodeToolchain\FWAPI\2.11</strong></td>
<td>&quot;Delete&quot;: Deletes the entries.</td>
</tr>
<tr>
<td>**Reset&quot;: Deletes the entries.</td>
<td></td>
</tr>
</tbody>
</table>

**Tab 'GCC 4.7.3 PM595-4ETH'**

<table>
<thead>
<tr>
<th><strong>Path to Compiler executable</strong></th>
<th>Path to the file location.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;...:&quot; Opens the file manager to search for the file location.</td>
<td></td>
</tr>
<tr>
<td>&quot;Reset&quot;: Resets the input.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Environment Variables</strong></th>
<th>&quot;New..:&quot; A new input window opens.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Variable name:&quot; Enter new variables.</td>
<td></td>
</tr>
<tr>
<td>&quot;Variable value:&quot; Enter new variables.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Edit...:&quot; A new input window opens.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Variable name:&quot; Edit new variables.</td>
</tr>
<tr>
<td>&quot;Variable value:&quot; Edit new variables.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Delete&quot;: Deletes the entries.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Reset&quot;: Deletes the entries.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Include path</strong></th>
<th>&quot;New..:&quot; A new input window opens.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Path:&quot; Enter a new path.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Edit...:&quot; A new input window opens.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Path:&quot; Edit include path.</td>
</tr>
<tr>
<td><strong>C:\Program Files (x86)\ABB\AutomationBuilder\CCodeToolchain\FWAPI\2.11</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Delete&quot;: Deletes the entries.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Reset&quot;: Deletes the entries.</td>
</tr>
</tbody>
</table>

**Tab 'GCC ++ 4.7.3 PM595-4ETH'**

<table>
<thead>
<tr>
<th><strong>Path to Compiler executable</strong></th>
<th>Path to the file location.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;...:&quot; Opens the file manager to search for the file location.</td>
<td></td>
</tr>
<tr>
<td>&quot;Reset&quot;: Resets the input.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Environment Variables</strong></th>
<th>&quot;New..:&quot; A new input window opens.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Variable name:&quot; Enter new variables.</td>
<td></td>
</tr>
<tr>
<td>&quot;Variable value:&quot; Enter new variables.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Edit...:&quot; A new input window opens.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Variable name:&quot; Edit new variables.</td>
</tr>
<tr>
<td>&quot;Variable value:&quot; Edit new variables.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Delete&quot;: Deletes the entries.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Reset&quot;: Deletes the entries.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Include path</strong></th>
<th>&quot;New..:&quot; A new input window opens.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Path:&quot; Enter a new path.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Edit...:&quot; A new input window opens.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Path:&quot; Edit include path.</td>
</tr>
<tr>
<td><strong>C:\Program Files (x86)\ABB\AutomationBuilder\CCodeToolchain\FWAPI\2.11</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Delete&quot;: Deletes the entries.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Reset&quot;: Deletes the entries.</td>
</tr>
</tbody>
</table>
"Delete": Deletes the entries.

"Reset": Deletes the entries.

Tab 'External diff tool'

| “Path to external diff tool” | “…”: Opens the file manager to search for the file location. |

Dialog 'Options' - 'CFC Editor'

Symbol: [image]

Function: This dialog is for the configuration of the settings for editing and printing in the CFC editor.

Call: menu “Tools ➔ Options”, category “CFC Editor”

Tab 'General'

| “Enable AutoConnect” | ☑: If you drag a CFC element onto the work area of the editor and insert it, CODESYS automatically connects together unconnected pins that 'touch' one another. Make sure that you do not create unwanted connections when shifting elements! |

| “Prepare values in implementation part” | ☑: In online mode you can also prepare variable values for writing and forcing in the implementation part of the CFC module. In addition, CODESYS displays the values you have just prepared in the inline monitoring box of the variable in angle brackets. |

Tab 'View'

| “Display grid points” | ☑: Grid points at which you can position the elements are visible in the editor. |

| “Show box icon” | ☑: Existing function blocks that are linked with a bitmap are displayed by CODESYS in the CFC editor as symbols. Requirement: You have either created the link for a function block or a function in the object properties or loaded it via a library. |

| “Edit Line Colors” | Opens the “Edit Line Colors” dialog for the definition of the colors of the connecting lines, depending on the data type applied. The lines appear in offline and online mode in these colors, unless CODESYS paints over them with the thick black and blue lines used to display the boolean data flow.

- “Add Type”: Adds a data type to the list.
- “Delete Type” |

| “Font” | Display of the font and button for changing the font. |

See also

- Chapter 6.4.1.21.4.11.9 “Dialog Box ‘Properties’ - ‘Bitmap’” on page 2758

Tab 'Print'

| Setting the “Layout Options” | |

| “Fit method” | “Page” or “Poster” |

| “Scale” | Possible values: 20 % - 200 % |
See also

- Chapter 6.4.1.9.5.3.3 “Programming in the CFC editor” on page 1871
- Chapter 6.4.1.20.1 “Programming Languages and Editors” on page 2047

Dialog ‘Options’ – 'Declaration Editor'

Symbol: 

Function: This dialog is for the configuration of the display settings for the declaration editor.

Call: Main menu “Tools ➔ Options”, category “Declaration Editor”

<table>
<thead>
<tr>
<th>“Textual only”</th>
<th>Textual view of the declaration editor</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Tabular only”</td>
<td>Tabular view of the declaration editor</td>
</tr>
<tr>
<td>“Switchable between textual and tabular”</td>
<td>The declaration editor offers two buttons for switching between the textual and tabular views:</td>
</tr>
<tr>
<td>: textual view</td>
<td>: tabular view</td>
</tr>
<tr>
<td>The following option defines the view that appears by default when opening a programming object:</td>
<td></td>
</tr>
<tr>
<td>● “Always textual”</td>
<td>● “Always tabular”</td>
</tr>
<tr>
<td>● “Remember recent setting (per object)”</td>
<td>● “Remember recent setting (global)”</td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.1.9.4.2 “Using the declaration editor” on page 1851

Dialog ‘Options’ – 'Device Description Download'

Symbol: 

Function: This dialog is for the configuration of addresses of download servers for device descriptions.

Call: Menu “Tools ➔ Options”, category “Download the Device Descriptions”.

See also

- Chapter 6.4.1.18 “Managing devices” on page 2038

Table 566: “Download server”

| List of download servers containing device descriptions. By default 'https://store.codesys.com/CODESYSDevs' is entered as the download server. |
| If you select the button “Download Missing Device Descriptions” in the “Device Repository” dialog, CODESYS uses the servers entered here and uses the set login data for the proxy server. |
| Double-click on “(Enter new download server here...)” | An input field opens in which you can enter the URL address of a server. |
| [Del] | Deletes the selected download server. |

See also

- Chapter 6.4.1.21.3.9.8 “Command ‘Device Repository’” on page 2663
- Chapter 6.4.1.21.4.14.21 “Dialog ‘Options’ - ‘Proxy Settings’” on page 2793
**Dialog 'Options' - 'Device Editor'**

Symbol: 

**Function:** This dialog includes settings for displaying the device editor.

**Call:** Menu bar: “Tools ➤ Options”; category: “Device Editor”.

**Tab 'View'**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Show generic device configuration views&quot;</td>
<td>This tab with the list of device parameters is available in the device editors of parameterizable devices.</td>
</tr>
<tr>
<td>&quot;Create cross references for IEC addresses (clean necessary)&quot;</td>
<td>CODESYS creates the cross-references for unmapped I/Os.</td>
</tr>
</tbody>
</table>
| "Communication page"                                                   | - "Classic mode": The “Communication” tab of the device editors appears as a split window with the left side showing the current configured gateway channels in a tree structure and the right side showing the associated data and information.
  - "Simple mode": The “Communication” tab appears as described in the corresponding section in the help. Additional modes may also be available from customer-specific extensions. |
| "Show implicit files for application download on the editor of a PLC"   | The tab for synchronized files is available in the device editors. Synchronized files are downloaded to the PLC at the time of application download. These can be external files that were added to the application, or implicit files such as a source code archive. |
| "Show access rights page"                                              | The “Access Rights” tab is available in the device editors. Note: Depending on the device, the device description may overwrite this setting.                                                                     |

See also

- % Chapter 6.4.1.21.2.8.3 “Tab 'Communication Settings'” on page 2427
- % Chapter 6.4.1.21.2.8.7 “Tab 'Synchronized Files'” on page 2436

**Dialog 'Options' - 'Diagnosis'**

Symbol: 

**Function:** This dialog is for the “Diagnosis” setting and views.

**Call:** menu “Tools ➤ Options”, category “Diagnosis”

**Table 567: ‘Diagnosis view’**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Enable subtree diagnosis&quot;</td>
<td>The subtree diagnosis is switched on.</td>
</tr>
<tr>
<td>&quot;Enable debug columns&quot;</td>
<td>Debug columns are enabled.</td>
</tr>
</tbody>
</table>

**Dialog 'Options' - 'External tools'**

Symbol: 

**Function:** This dialog is for setting of “External tools”.

**Call:** menu “Tools ➤ Options”, category “External tools”
### Tool Version

<table>
<thead>
<tr>
<th>Tool</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Panel builder&quot;</td>
<td>&quot;Default&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Custom&quot;: Opens the file manager to search for the file location. Sometimes it is required to use dedicated versions of these tools (qualified versions, versions supporting more legacy types, …)</td>
</tr>
<tr>
<td>&quot;Drive composer pro&quot;</td>
<td>&quot;Default&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Custom&quot;: Opens the file manager to search for the file location. Sometimes it is required to use dedicated versions of these tools (qualified versions, versions supporting more legacy types, …)</td>
</tr>
</tbody>
</table>

| "Restore defaults"    | Resets the custom settings to default. |

*The modified settings will be valid after restart of Automation Builder.*

### Dialog 'Options' - 'FBD, LD, and IL'

**Symbol:** 🏒

**Function:** This dialog is used for configuring the display options for the FBD/LD/IL editor.

**Call:** "Tools ➔ Options" (category “FBD, LD, and IL”).

### Tab 'General'

#### Table 568: “View”

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Show network title&quot;</td>
<td>The network title is displayed in the upper left corner of the network.</td>
</tr>
<tr>
<td>&quot;Show network comment&quot;</td>
<td>The network comment is displayed in the upper left corner of the network. When the network title is also shown in CODESYS, the comment is shown in the line below.</td>
</tr>
<tr>
<td>&quot;Show box icon&quot;</td>
<td>The block symbol is displayed in the block element in the FBD and LD editor. The standard operators also have symbols.</td>
</tr>
<tr>
<td>&quot;Show operand comment&quot;</td>
<td>CODESYS shows the comment that you indicated for a variable in the implement-</td>
</tr>
<tr>
<td></td>
<td>ation part. The operand comment refers to the local occurrence of the variable only, as opposed to the symbol comment.</td>
</tr>
<tr>
<td></td>
<td>This comment is truncated automatically depending on available space.</td>
</tr>
<tr>
<td></td>
<td>You can limit the comment to a defined width by activating the option “Fixed size for operand fields”.</td>
</tr>
<tr>
<td>&quot;Show symbol comment&quot;</td>
<td>The comment that you indicated for a variable or symbol in the declaration is displayed in CODESYS above the variable name. You can also assign a local operand comment in addition to or instead of the symbol comment.</td>
</tr>
<tr>
<td>&quot;Show symbol address&quot;</td>
<td>If an address is assigned to a symbol (variable), then this address is displayed above the variable name.</td>
</tr>
<tr>
<td>&quot;Show network separators&quot;</td>
<td>A separator is displayed between the individual networks.</td>
</tr>
</tbody>
</table>
Table 569: “Behavior”

| Placeholder for new operands | The operand field of pins for the new function block is left blank (instead of "???"). |
| Empty operands for function block pins | Adds blank operands instead of ???.

Table 570: “Font”

Click the input field to open the “Font” dialog.

| Fixed size for operand fields | ☑: “Edit operand sizes” can be enabled. |
| Edit operand sizes | The “Operand Sizes” dialog opens for setting the number of characters and lines.

Table 571: “View”

| Networks with line breaks | ☑: Display of the network with line breaks so that CODESYS can show as many blocks as possible in the current width of the window. |
| Connect boxes with straight line | ☑: The length of the lines between the elements are fixed and short. |

Table 572: “Behavior”

| Default network content | Drop-down list: Contents of a new network |
| After insertion select | Drop-down list: Element that CODESYS selects after inserting a new network |

Table 573: “View”

| Networks with line breaks | ☑: Display of the network with line breaks so that CODESYS can show as many blocks as possible in the current width of the window. |

Table 574: “Behavior”

| Default network content | Drop-down list: Contents of a new network |
| After insertion select | Drop-down list: Element that CODESYS selects after inserting a new network |

Table 575: “View”

| Enable IL | The IL implementation language is available in the development system. |

Table 576: “Behavior”

| Default network content | Drop-down list: Contents of a new network |
| After insertion select | Drop-down list: Element that CODESYS selects after inserting a new network |

Tab 'Print'
Table 577: “Layout Options”

<table>
<thead>
<tr>
<th>“Fit method”</th>
<th>Drop-down list for resizing.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Avoid cutting of elements”</td>
<td>Elements that do not fit on the page are printed on the next page.</td>
</tr>
<tr>
<td>“Mark connections on adjacent pages”</td>
<td>Enabled for selection when “Avoid cutting of elements” is selected.</td>
</tr>
</tbody>
</table>

See also
- Chapter 6.4.1.20.1 “Programming Languages and Editors” on page 2047

Dialog 'Options' - 'Help'

Symbol: 📚

Function: This dialog defines whether CODESYS Online Help or CODESYS Offline Help opens when help is called.

Call: Menu bar: “Tools ➔ Options”; category: “Help”.

- CODESYS Online Help opens when CODESYS Help is called. This is the default setting.
- CODESYS Offline Help opens when CODESYS Help is called.

Dialog 'Options' - 'IEC 60870-5-104'

Symbol: 🌐

Function: In this dialog you can set this notation of the “Address format”.

Call: menu “Tools ➔ Options”, category “IEC 60870-5-104”

Tab 'Address format'

- 1.2.3 (separated by dots)
- 1-2-3 (separated by hyphens)
- 66051 (decimal number, big endian --> 0x10203)
- 197121 (decimal number, little endian --> 0x30201)
Dialog 'Options' – 'International Settings'

Symbol: 🌐

Function: This dialog is for the setting of the language in the user interface and in the help.

Call: Menu bar: “Tools ➤ Options”, category “International Settings”.

Dialog 'Options' – 'Libraries'

Symbol: 📚

Function: This dialog helps you to manage the mappings of library references that CODESYS uses during the conversion of an old project. If you have not yet stored any mapping for a certain library, you must redefine the mapping each time when opening an old project in which this library is integrated.


A mapping defines what a library reference looks like following the conversion of the project to the current format. There are three possibilities:

- You retain the reference. This means that CODESYS similarly converts the library into the current format (*.library) and installs it in the local library repository.
- You replace a reference with another reference. This means that one of the installed libraries replaces the library that was integrated until now.
- You delete the reference. This means that the converted project no longer integrates the library.

CODESYS applies all the listed mappings to the library references of an old project the next time it is converted. Hence, you must repeat the mapping definition if the same library is integrated again in a project that is to be converted. You can enter a new mapping in the last line.

<table>
<thead>
<tr>
<th>“Source Library”</th>
<th>Path of the library that is integrated in the project before the conversion. A double-click an entry makes the field editable and the button for the input assistance appears.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Target Library”</td>
<td>Name and location of the library that is to be integrated in the project after the conversion. A double-click an entry opens the dialog “Set target system library”.</td>
</tr>
</tbody>
</table>

Table 578: “Set target system library”

<table>
<thead>
<tr>
<th>“Scan”</th>
<th>The “Select Library” dialog opens. You can select a library from the library repository here. The dialog corresponds to the dialog in the library repository.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Ignore”</td>
<td>When CODESYS converts the project, CODESYS always removes the existing source library from the project.</td>
</tr>
</tbody>
</table>

Dialog 'Options' – 'Library Download'

Symbol 🌐

Function: This dialog is for the setting of download servers.

Call: menu “Tools ➤ Options”, “Library Download” category
If you click on the button “Download Missing Libraries” in the library manager, CODESYS browses these download servers for libraries marked as missing in the library manager and uses the set login details for the proxy server.

<table>
<thead>
<tr>
<th>“Download servers”</th>
<th>URL of a server containing library files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Double-click on “(Enter new download server here)”</td>
<td>An input field opens in which you can enter the URL address of a server.</td>
</tr>
</tbody>
</table>

See also
- Chapter 6.4.1.21.2.16 “Object 'Library Manager’” on page 2469
- Chapter 6.4.1.21.4.14.21 “Dialog ‘Options’ - ‘Proxy Settings’” on page 2793

**Dialog ‘Options’ – ‘Load and Save’**

**Symbol:** 🚀

**Function:** The dialog contains settings for the behavior of CODESYS when loading and saving a project.

**Call:** Menu bar: “Tools ➔ Options”, “Load and Save” category

<table>
<thead>
<tr>
<th>“Create backup files”</th>
<th>✓ Each time the project is saved, CODESYS also saves the project as the file <code>&lt;project name&gt;.project</code> in addition to the file <code>&lt;project name&gt;.backup</code>. You can rename the backup file and open it in the programming system.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Automatically save every … minutes”</td>
<td>✓ CODESYS automatically saves the project at the specified time intervals in a file <code>&lt;project name&gt;.autosave</code>, which you can reload following non-regular closing of the programming system. CODESYS deletes the <code>.autosave</code> file whenever the project is closed or saved regularly. CODESYS retains the <code>.autosave</code> file in the case of an irregular termination. When you open a project for which there is an associated autosave file, the “Auto Save Backup” dialog opens. In this dialog you select whether the <code>.autosave</code> file or the version of the project last saved by the user should be opened.</td>
</tr>
<tr>
<td>“Save before build”</td>
<td>CODESYS saves the project automatically before each build operation.</td>
</tr>
<tr>
<td>“Create project recovery information”</td>
<td>Requirement: The “No protection” option is selected in the project settings in the “Security” category. This means that the project is not protected against unauthorized access and data manipulation, and there is no integrity check when the project is loaded. ✓ If a project crashes during editing, then the next time the project is opened, a prompt is displayed asking whether or not you want to restore the unsaved data and create a new project file. If you click “Yes”, then another dialog opens. In this dialog, you can select whether you want to open the restored project or open the project comparison. This project comparison displays the differences between the last saved project and the restored project. Note: The project restore records every change on the hard disk when the change is made. If a power failure or hard disk error occurs on the hard disk during this operation, then the last change may be lost.</td>
</tr>
<tr>
<td>“Advanced Settings”</td>
<td>The “Advanced Settings” dialog opens.</td>
</tr>
</tbody>
</table>
“At startup”

List box for the startup screen of CODESYS:

- “Show start page”: The start page of CODESYS is shown.
- “Load last loaded project”
- “Show "Open Project" dialog”
- “Show "New Project" dialog”
- “Show empty environment”

“News page”

URL that is opened by means of the command “Help ➔ CODESYS CODESYS Homepage”.
By default, this page is http://www.codesys.com/startpage.

Table 579: Dialog “Advanced Settings”

<table>
<thead>
<tr>
<th>“Project compression”</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Level”</strong></td>
</tr>
<tr>
<td>Requirement: The “No protection” option is selected in the project settings in the “Security” category. This means that the project is not protected against unauthorized access and data manipulation, and there is no integrity check when the project is loaded.</td>
</tr>
<tr>
<td>List box for the compression level that is used when saving the project.</td>
</tr>
<tr>
<td>- “Least compression - best speed (recommended)”</td>
</tr>
<tr>
<td>- “Medium compression - medium speed”</td>
</tr>
<tr>
<td>- “Most compression - worst speed”</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Load Behavior”</th>
</tr>
</thead>
<tbody>
<tr>
<td>Libraries and compilation information are loaded in the background while you edit the project.</td>
</tr>
</tbody>
</table>

See also
- Chapter 6.4.1.6 “Protecting and Saving Projects” on page 1819

Dialog ‘Options’ - ‘Message View’

Symbol: 📡

Function: In this dialog the number of messages can be determined.
Call: menu “Tools ➔ Options”, category “Message View”

<table>
<thead>
<tr>
<th>“Maximum numer of messages” xxx</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default, 500, max. 9999, min. 20</td>
</tr>
</tbody>
</table>

Dialog ‘Options’ - ‘Monitoring’

Symbol: 🌐

Function: This dialog includes settings for displaying the variable values in monitoring.
Call: Menu bar: “Tools ➔ Options”; category: “Monitoring”
Table 580: “Display Mode for Integer Variables”

- **“Binary”**: The value of the variable is displayed in the corresponding format in online mode.
- **“Decimal”**: This option corresponds to the setting of the command “Debug
  ➔ Display Mode”.
- **“Hexadecimal”**

Table 581: “Floating Point Variables”

- **“Number of displayed digits”**: Decimal places that are represented in online mode when REAL values are displayed.
  
  Note: The settings apply to the watch list, the monitoring of the declaration editor and the trace editor. The configuration for inline monitoring of the editor is set in the text editor options.

See also
- ¶ “Tab ‘Monitoring’” on page 2800

Dialog 'Options' - 'PLCopenXML'

Symbol: 📜

**Function**: This dialog contains settings for the behavior of CODESYS when exporting or importing PLCopenXML.

**Call**: Main menu “Tools ➔ Options”, category “PLCopenXML”

Table 582: “PLCopenXML Export Settings”

- **“Additionally export declarations as plain text”**: By default, CODESYS splits the declaration parts in accordance with the PLCopenXML scheme into individual variables and thus loses the formatting and some comment information.
  
  ☑: Formatting and comments are retained. CODESYS additionally writes the plain text of the exported declaration part into the PLCopenXML file and thus extends the PLCopenXML scheme.

- **“Export Folder Structure”**: CODESYS also exports the folders if they contain one of the selected objects. That is a CODESYS-specific extension to the PLCopenXML scheme.

Table 583: “PLCopenXML Import Settings”

- **“Import folder structure”**: If the import file contains information about the folder structure of the objects, CODESYS also imports this structure.
  
  ☐: CODESYS imports objects without structure.

See also
- ¶ Chapter 6.4.1.4.2 “Exporting and importing projects” on page 1815
- ¶ Chapter 6.4.1.21.3.5.26 “Command ‘Export PLCopenXML’” on page 2612
- ¶ Chapter 6.4.1.21.3.5.27 “Command ‘Import PLCopenXML’” on page 2612

Dialog 'Options' - 'Proxy Settings'

Symbol: 🌐

**Function**: You use this dialog for storing the authentication data for the proxy server which is currently used for accessing the internet from CODESYS.

**Call**: Main menu “Tools ➔ Options”, category “Proxy Settings”
**Requirement:** Internet access of the network via proxy server

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A double click opens the input request for the user name and the password for the proxy server.</td>
<td>CODESYS uses the access data for the establishment of the connection to the download server for libraries and the device description, for the establishment of the connection to the CODESYS Store and for the command “View ➔ Start Page”. Requirement: If the internet access of your computer or of the network takes place via a proxy server, then the button is available.</td>
</tr>
</tbody>
</table>

- § Chapter 6.4.1.21.16 “Object 'Library Manager’” on page 2469
- § Chapter 6.4.1.21.3.4.20 “Command ‘Start Page’” on page 2596

**Dialog 'Options' - 'Refactoring'**

**Symbol:** 🎖

**Function:** The dialog is used for defining the operations in the project for which the automatic refactoring is suggested. The refactoring functionality helps you in your improvement endeavors.

**Call:** Menu bar: “Tools ➔ Options”, “Refactoring” category

**'Suggest Refactoring for the Following Operations’**

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>When you change the name of a variable in a declaration by calling AutoDeclare ([Shift]+[F2]), the activated option “Apply changes by means of refactoring” appears. Then the “Refactoring” dialog opens and you can change the variable throughout the project.</td>
<td>When you change the name of a conversion in the unit conversion editor, you are prompted whether CODESYS should perform &quot;Automatic Refactoring&quot; when renaming.</td>
</tr>
<tr>
<td>- “On adding or removing variables, or on changing the scope”</td>
<td></td>
</tr>
<tr>
<td>✓ You delete the names in the “Declare Variable” dialog and click “OK” to close the dialog. Then the “Refactoring” dialog opens for removing the variable throughout the project.</td>
<td>✓ When you change the name of a conversion in the unit conversion editor, you are prompted whether CODESYS should perform &quot;Automatic Refactoring&quot; when renaming.</td>
</tr>
<tr>
<td>- “On renaming variables”</td>
<td></td>
</tr>
<tr>
<td>✓ You specify the names in the “Declare Variable” dialog and click “OK” to close the dialog. Then the “Refactoring” dialog opens for renaming the variable throughout the project.</td>
<td></td>
</tr>
</tbody>
</table>

See the chapter: "Refactoring", "Changing a variable declaration and applying refactoring automatically".

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>‘Auto-declare’</td>
<td>On renaming of unit conversions”</td>
</tr>
<tr>
<td>“Unit conversion editor”</td>
<td>“On renaming variables”</td>
</tr>
<tr>
<td>✓ When you change the name of a conversion in the unit conversion editor, you are prompted whether CODESYS should perform &quot;Automatic Refactoring&quot; when renaming.</td>
<td>✓ When you change a variable name in the device editor (‘I/O Mapping” tab), you are prompted whether CODESYS should perform &quot;Automatic Refactoring&quot; when renaming.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Mapping editor”</td>
<td>“On renaming variables”</td>
</tr>
<tr>
<td>✓ When you change a variable name in the device editor (‘I/O Mapping” tab), you are prompted whether CODESYS should perform &quot;Automatic Refactoring&quot; when renaming.</td>
<td></td>
</tr>
</tbody>
</table>
“Navigator”  “On renaming objects”  
- When you change the name of an object in the device tree or in the POUs view, you are prompted whether CODESYS should perform “Automatic Refactoring” when renaming.

“Tabular declaration editor”  “On renaming variables”  
- When you change the name of a variable in the tabular declaration editor, you are prompted whether CODESYS should perform “Automatic Refactoring” when renaming.

See also
- Chapter 6.4.1.9.16 “Refactoring” on page 1910
- Chapter 6.4.1.9 “Programming of Applications” on page 1844
- Chapter 6.4.1.21.3.3.40 “Command 'Refactoring' - 'Rename <...>’” on page 2577
- Chapter 6.4.1.21.3.3.32 “Command 'Auto Declare’” on page 2572
- Chapter 6.4.1.21.2.35 “Object 'Unit Conversion’” on page 2549

Dialog 'Options' - 'SFC Editor'
Symbol: 

Function: This dialog is used for configuring the settings for the SFC editor.

Call: Menu bar: “Tools ➔ Options” (“SFC Editor” category).

See also
- Chapter 6.4.1.9.5.5.2 “Programming in SFC” on page 1880
- Chapter 6.4.1.21.3.12 “Menu ‘SFC’” on page 2675
- Chapter 6.4.1.20.1.5.1 “SFC editor” on page 2062

Tab 'Layout'

Table 584: “Elements”
This defines the dimensions of the SFC elements: step, action, qualifier, property. The values are given in matrix units, where one matrix unit equals the font size that you set in the text editor options (text area / font). The settings are always active immediately in all open SFC editor views.

<table>
<thead>
<tr>
<th>Element</th>
<th>Possible values</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Step height”</td>
<td>1-100</td>
</tr>
<tr>
<td>“Step width”</td>
<td>2-100</td>
</tr>
<tr>
<td>“Action width”</td>
<td>2-100</td>
</tr>
<tr>
<td>“Qualifier width”</td>
<td>2-100</td>
</tr>
<tr>
<td>“Property width”</td>
<td>2-100</td>
</tr>
</tbody>
</table>

Table 585: “Font”
The example text shows the current font. Click it to change the font.
### Table 586: “Step Actions”

| “Default insertion method” | “Copy reference”: The reference to the action objects that call the step are also copied when the step is copied. The copied step and new step call the same action.  
| | “Duplicate implementation”: The reference to the action objects that call the step are linked to this step. When copying the step element, new action objects are created for the new step, and the implementation is duplicated.  
| | “Always ask”: When inserting a step action, you are always prompted whether the actions of a step element should be duplicated when it is copied, or whether the reference to the existing action should be applied.  
| Note: If a step already contains an embedded action, then new inserted actions of this step are also embedded. Likewise, new inserted actions are not embedded when the step already contains a non-embedded action. In these cases, you are no longer prompted for a duplication mode. |

### Table 587: “Embedded Objects”

| “Show action and transition objects in the navigator” | ✓: Action and transition objects that are embedded in the SFC box by a step are displayed in the “Devices” or “POUs” tree view. |

### Table 588: “Property Visibility”

| “Property” | Defines the element properties displayed next to the element in the SFC diagram.  
| “Value” | ✓: Display of the property value.  
| “With Name” | ✓: Display of the property value including name. |

### Table 589: “Online”

| “Show step time” | ✓: In online mode, CODESYS displays the step time to the right of the steps. |

### Dialog 'Options' - ‘SmartCoding’

**Symbol:** ☰

**Function:** This dialog is for configuring the settings for easier coding.

**Call:** Menu bar: “Tools ➔ Options”, “SmartCoding” category

| “Declare unknown variables automatically (AutoDeclare)” | ✓: The “Declare Variable” dialog opens when you type an undeclared identifier into an implementation language editor and then click away from the input line.  
| In order for the AutoDeclare function to be available in the ST editor as well, the “Enable for ST editor” option also has to be selected. |

| “Enable for ST editor” | Requirement: The “Declare unknown variables automatically (AutoDeclare)” option is selected.  
| ✓: The AutoDeclare function is also available in the ST editor.  
| ☐: The AutoDeclare function is not available in the ST editor. |
"Show all instance variables in Input Assistant"  
- The "List components" function also lets you select the local variables of a function block instance.  
- The "List components" function lets select only the input variables and output variables of a function block instance.

"Show symbols from system libraries in Input Assistant"  
- System libraries are inserted in the library manager automatically and displayed in light gray.  
- Symbols, such as global variables, data types, and function blocks, are offered in the Input Assistant.  
- The symbols of the system libraries are not available in the Input Assistant.

"List components after typing a dot (.)"  
- Activates the "List components" function. When you type a dot (.) at a location where CODESYS expects an identifier, a list box appears with possible code.

"List components immediately when typing"  
- Requirement: The "List components after typing a dot (.)" check box is selected.  
- While you type code, a list box appears with possible identifiers and operators.

"Insert with namespace"  
- CODESYS adds the namespace before the identifier.

"Convert keywords to uppercase automatically (AutoFormat)"  
- CODESYS displays all keywords in uppercase.

"Automatically list selection in cross-reference view"  
- The cross-reference list automatically shows the references of variables, POU's, and DUT's that are currently selected or where the cursor is waiting.

"Underline errors in the editor"  
- Incorrect or unknown program code is underlined.

"Highlight symbols"  
- All occurrences of a symbol where the cursor is positioned are highlighted in color within the editor. In this way, cross-references within the editor are quickly detected.

"Max. degree of parallelism"  
- List box for the number of parallel threads that can be used for the precompile processing. CODESYS detects the displayed number of threads from the number of CPU cores. This default number should be changed only in exceptional cases.

See also
- § Chapter 6.4.1.20.1 “Programming Languages and Editors” on page 2047
- § “Smart tag functions” on page 1888
- § Chapter 6.4.1.9.14.1 “Using the cross-reference list to find occurrences” on page 1906
- § Chapter 6.4.1.20.1.4.1 “ST Editor” on page 2049

Dialog 'Options' - 'Startup settings'

Symbol: "*"  

Function: In this dialog the “Version profile” and the “License” are set.  

Call: menu “Tools ➔ Options”, category “Startup settings”

<table>
<thead>
<tr>
<th>&quot;Version profil:&quot;</th>
<th>Automation Builder 2.5</th>
</tr>
</thead>
<tbody>
<tr>
<td>§ &quot;Display selected dialog at each start&quot;: Refers to the version of the AB to be displayed&quot;</td>
<td></td>
</tr>
</tbody>
</table>
Dialog 'Options' - 'Text Editor'

Symbol: 🏷️

Function: The dialog contains settings for displaying and working in a text editor.

Call: Menu bar: “Tools ➔ Options”, “Text Editor” category

Tab 'Theme'

On this tab, you set the desired theme in the interface design of the ST editor.

<table>
<thead>
<tr>
<th>“Theme”</th>
<th>Color theme for the text editor. The selected theme is shown in the “Preview” window. The available color schemes are stored in the installation directory in the Themes folder.</th>
</tr>
</thead>
</table>
Tab 'Editing'

<table>
<thead>
<tr>
<th>“Number of undos”</th>
<th>Maximum number of editing steps that you can apply the “Edit ➔ Undo” command to.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Folding”</td>
<td>Defines the structuring of the code by indentation. When you select an indentation, you can expand or collapse the indentation section by means of a plus and minus sign in front of the first line of each section.</td>
</tr>
<tr>
<td></td>
<td>● “Indent”: CODESYS combines all lines that are indented in relation to the preceding line into one indentation unit.</td>
</tr>
<tr>
<td></td>
<td>● “Explicit”: You mark the code segment explicitly with comments that should be combined in one indentation unit: a comment with three opening braces “{“ has to be before the segment, and a comment with three closing braces ”}” has to be after the segment. The comments can contain additional text. Example:</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Example Code" /></td>
</tr>
<tr>
<td>“Word wrap”</td>
<td>● “Soft”: The line break occurs at the edge of the editor window when 0 is specified for “Wrap margin”.</td>
</tr>
<tr>
<td></td>
<td>● “Hard”: The line break occurs after the number of characters specified for “Wrap margin”.</td>
</tr>
<tr>
<td>“Tab width”</td>
<td>Number of characters</td>
</tr>
<tr>
<td>“Keep tabs”</td>
<td>CODESYS does not break up the space you have inserted with the [Tab] key into individual spaces afterwards.</td>
</tr>
<tr>
<td>“Indent width”</td>
<td>If you have selected “Smart” or “Smart with code completion” for the “AutoIndent” option, then CODESYS inserts the number of spaces at the beginning of the line.</td>
</tr>
<tr>
<td>“AutoIndent”</td>
<td>● “None”</td>
</tr>
<tr>
<td></td>
<td>● “Block”: A new line automatically applies the indentation of the previous line.</td>
</tr>
<tr>
<td></td>
<td>● “Smart”: Lines that follow a line which contains a keyword (for example, VAR) indent automatically by the specified Indent width.</td>
</tr>
<tr>
<td></td>
<td>● “Smart with code completion”: Indentation as in the case of the “Intelligent ” option, but CODESYS also inserts the closing keyword (for example, END_VAR).</td>
</tr>
</tbody>
</table>

Tab 'Text Area'

| “Highlight current line” | ☑: The line where the cursor is located is highlighted. |
| “Matching brackets”      | ☑: When the cursor is positioned before or after a bracket within a line of code, the corresponding closing or opening bracket is marked by a frame. |
**“End of line markers”**  
☑️: The end of each editor line is marked by a small dash after the last character (including spaces) of the line.

**“Wrap guide”**  
☑️: When a soft or hard line break is activated, the defined line break position is displayed with a vertical line.

**“Font”**  
Clicking the field opens the default dialog for configuring the font.

### Tab 'Margin'
Settings for the left margin of the text editor window, which is separated from the input area by a vertical line:

**“Line numbering”**  
☑️: The declaration and implementation parts of the editor are numbered on the left, each beginning with 1.

**“Highlight current line”**  
☑️: The line number of the line where the cursor is located is highlighted.

**“Show bracket scope”**  
☑️: Brackets include the lines between the keywords that open and close a construct (for example, `IF` and `END_IF`). When the option is enabled and the cursor is positioned before, after, or in one of the keywords of a construct, the bracket area is displayed with a square bracket in the margin.

**“Mouse Actions”**  
You can assign one of the following actions to each of the specified mouse actions or mouse-keyboard combinations. CODESYS performs the selected action when you move the mouse to the plus or minus sign in front of the header of a bracketed area:
- **“None”**: The mouse action does not trigger an action.
- **“Select fold”**: CODESYS selects all lines of the bracketed area.
- **“Toggle fold”**: CODESYS opens or closes the bracketed area, or if there are nested brackets, the first level of the bracketed area.
- **“Toggle fold fully”**: CODESYS opens or closes all levels of a nested bracketed area.

### Tab 'Monitoring'
Settings for displaying the monitoring fields

**“Enable inline monitoring”**  
☑️: Display of the monitoring fields behind the variables in online mode

**“Number of displayed digits”**  
Number of comma places in the monitoring field

**“String length”**  
Maximum length of string variable values in the monitoring field

See also
- ☇ Chapter 6.4.1.9.5.4.2 “Programming structured text (ST)” on page 1879

### Dialog 'Customize'

<table>
<thead>
<tr>
<th>Section</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>6.4.121.4.15.1</td>
</tr>
<tr>
<td></td>
<td>6.4.121.4.15.2</td>
</tr>
<tr>
<td></td>
<td>6.4.121.4.15.3</td>
</tr>
<tr>
<td></td>
<td>6.4.121.4.15.4</td>
</tr>
<tr>
<td></td>
<td>6.4.121.4.15.5</td>
</tr>
</tbody>
</table>

### General
The dialog contains the tabs to configure the user interface.

You can reset the CODESYS settings to default by use of the “Reset” button.
Dialog 'Customize' - 'Menu'

**Function:** With this dialog, you define the structure and contents of the user interface.

**Call:** Main menu “Tools ➔ Customize” (“Menu”).

When you click “OK” to close the dialog, the changes are visible in the menu bar of the CODESYS user interface.

<table>
<thead>
<tr>
<th>Table 590: “Menu”</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display of currently defined menus, submenus, and included commands. In CODESYS, a menu or submenu caption is identified by the caption symbol ( ). The layout from top to bottom corresponds to the layout displayed later in the CODESYS menu.</td>
</tr>
</tbody>
</table>

| “Add Command” | Enabled when a command is selected. Adds a command above the selected command. Opens the “Add Command” dialog. Use the “Add Command” dialog for selecting one or more commands. Left part: List of categories. Right part: List of commands in the selected category. |
| “Add Separator” | Adds a separator above the selected command. |
| “Add Popup Menu” | Adds a popup menu above the selected menu, submenu, or command. Opens the “Add Popup Menu” dialog. |
| “Edit Popup Menu” | Opens the “Edit Popup Menu” dialog. |
| “Reset” | Resets the default settings of the entire menu. |
| “Load” | Loads the settings from a stored file (<file name>.opt.menu). |

<table>
<thead>
<tr>
<th>Table 591: “Add Popup Menu”</th>
</tr>
</thead>
<tbody>
<tr>
<td>In CODESYS, a new menu is shown in the menu bar only when the menu contains at least one command.</td>
</tr>
</tbody>
</table>

| “Default text” | Select this check box when localization is available. |
| “Localized Texts” | List: Languages and localized texts. |
| “Add Language” | Opens a drop-down list of available languages. In CODESYS, the selected language is displayed in the area “Localized Texts”. Use the “Text” column for typing the localized texts. |

See also
- % Chapter 6.4.1.2.2.2 “Customizing menus” on page 1802
- % Chapter 6.4.1.21.4.15.4 “Dialog ‘Customize’ - ‘Toolbars’” on page 2802

Dialog 'Customize' - 'Command Icons'

**Function:** This dialog defines the icons of the menu commands.

**Call:** Menu bar: “Tools ➔ Customize” (“Command Icons”).

<table>
<thead>
<tr>
<th>Table 592: “Command icon”</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Assign”</td>
</tr>
<tr>
<td>“Remove”</td>
</tr>
<tr>
<td>“Reset”</td>
</tr>
<tr>
<td>“Load”</td>
</tr>
<tr>
<td>“Save”</td>
</tr>
</tbody>
</table>
Dialog 'Customize' - 'Toolbars'

**Function:** Use this dialog for generating new toolbars or customizing existing toolbars.

**Call:** Main menu “Tools ➔ Customize” (“Toolbars”).

When you click “OK” to close the dialog, the changes are visible in the menu bar of the CODESYS user interface.

<table>
<thead>
<tr>
<th>Table 593: “Toolbars”</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display of currently defined toolbars. In CODESYS, the associated commands are listed below each toolbar in the order they will appear in the toolbar.</td>
</tr>
<tr>
<td>Double-clicking a toolbar in the list switches to editing mode.</td>
</tr>
</tbody>
</table>

| “Add Toolbar” | Enabled when a toolbar is selected. |
|---------------------------------------------------------------|
| In CODESYS, this adds a toolbar above the selected toolbar and places the cursor in the name field of the new toolbar. |

| “Add Command” | Enabled when you select a command or blank command entry below a toolbar. |
|---------------------------------------------------------------|
| Adds a command above the selected command. Opens the “Add Command” dialog. |
| Use the “Add Command” dialog to select one or more commands. Left part: List of categories. Right part: List of commands in the selected category. |

| “Add Separator” | Adds a separator above the selected command. |
|---------------------------------------------------------------|
| “Hide” | Hide the selected toolbar from the user interface. |
| “Show” | Shows the selected hidden toolbar in the CODESYS user interface. |
| “Reset” | Resets the default settings of the toolbars. |
| “Load” | Loads the settings from a stored file (<file name>.opt.tbar). |

See also

- ¶ Chapter 6.4.1.2.4 “Customize command icon” on page 1805

Dialog Box 'Customize' - 'Keyboard'

**Function:** This dialog box is used for defining keyboard shortcuts (quick access keys or keyboard combinations) for commands.

**Call:** Main menu “Tools ➔ Customize” (“Keyboard”).

<table>
<thead>
<tr>
<th>Table 594: “Keyboard”</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Shortcuts for selected command”</td>
</tr>
<tr>
<td>“Press shortcut keys”</td>
</tr>
<tr>
<td>“Shortcut keys currently used by”</td>
</tr>
</tbody>
</table>
### Dialog 'Trace Configuration'

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.4.1.21.4.16.1</td>
<td>Dialog 'Advanced Trace Settings'................................. 2803</td>
</tr>
<tr>
<td>6.4.1.21.4.16.2</td>
<td>Dialog 'Trace Configuration'.......................................... 2804</td>
</tr>
</tbody>
</table>

### Dialog 'Advanced Trace Settings'

**Function:** This dialog provides extended settings for recording data.

**Call:** “Advanced” button in “Trace Configuration” dialog, "Record Settings" subdialog

**Requirement:** The trace editor is open and active. The dialog “Trace configuration” is open and the top node of the trace record tree is selected so that the subdialog “Record settings” is available.

---

The buffer size is defined as "number of samples". CODESYS calculates the time intervals that corresponds to this number and displays the result in normal fonts on the right outside the table (for example, “1h1m1s1ms”). The calculation is possible only with the help of the task configuration settings and when the task cycle time is known.

<table>
<thead>
<tr>
<th>&quot;Measurement in every n-th cycle&quot;</th>
<th>Data sampling in every n task cycle</th>
<th>Sampling interval which is automatically calculated from the value specified in the Measurement in every n-th cycle option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default: 1; then the application performs the data sampling in each task cycle.</td>
<td></td>
<td>Example: 100ms</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Recommended runtime buffer size (samples)&quot;</th>
<th>Calculated automatically and therefore recommended number of samples which the application can store per trace variable at runtime</th>
<th>Maximum length of the time interval during which the application samples data on the runtime system</th>
</tr>
</thead>
<tbody>
<tr>
<td>This value determines the maximum ring buffer size in the runtime system. This buffer size is automatically calculated from the task cycle time and the value in the “Measure in every n-th cycle” option, and the displayed.</td>
<td>Example: 2s</td>
<td>Note: The calculation is possible only when the settings of the trace configuration are set in the “Trace Configuration” dialog and therefore the task cycle time is known.</td>
</tr>
<tr>
<td>This buffer size is used when the “Override runtime buffer size” option is disabled.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**“Override runtime buffer size”**

- Enables the input field for you to specify your own defined buffer size. At runtime, the value which you have specified here is used, not the value displayed in the Recommended runtime buffer size (samples) option.
- Example: 100
- At least 10
- The application uses this value, not the value calculated by CODESYS from the Recommended runtime buffer size (samples) option.
- Example: 6s

**“Trace editor buffer size per variable (samples)”**

- Number of values that can be stored per variable in the trace editor.
- Example: 10000

Maximum length of the time interval during which the application samples data on the runtime system without overwriting it.

- Example: 6s

The maximum time period for the display in the trace editor results from the maximum number and the sampling interval of the data sampling. You can scroll back a maximum of this time in the trace editor.

**Example**

Column (1) notifies you about the number of samples.

Column (2) next to it displays the calculated time intervals which result.

- The information displayed in the example means that one sample is taken per task cycle in the runtime system and continuously cached in a ring buffer, which can hold a maximum of 201 samples. The enabled “Override runtime buffer size” option has the effect that, due to the ring buffer, the first cached values are first overwritten after 100 samples. During this time, 10000 samples are continuously displayed in the trace editor so that a value curve can be displayed over an interval of 1 minute and almost 40 seconds.

See also

- Chapter 6.4.1.21.2.31 “Object ‘Trace’” on page 2541
- Chapter 6.4.1.13.3.3 “Creating trace configuration” on page 2010

**Dialog ‘Trace Configuration’**

- Symbol: 📊
- **Function:** The dialog includes the trace configuration for the data recording.

**Call**

- “Trace ➔ Configuration”; context menu
- Link “Configuration” in the trace editor
- Link “Add Variable” in the trace editor

**Requirement:** The editor of a trace object is open and active.

See also

- Chapter 6.4.1.13.3.3 “Creating trace configuration” on page 2010
- Chapter 6.4.1.13.3 “Data Recording with Trace” on page 2007
- Chapter 6.4.1.20.6.3.26 “Attribute ‘monitoring’” on page 2295

**Tree view ‘Trace Record’**

The tree view lists the variables that are traced and allows for access to the variable settings.
Selected trace name  The “Record Settings” subdialog is displayed on the right.
Selected trace variable  The “Variable Settings” subdialog is displayed on the right.

Table 595: Context menu commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+ “Add Variable”</td>
<td>Adds a new trace variable. The “Variable Settings” subdialog opens on the right and is partially configured. Select a variable in the input field of the “Variable” setting to trace its value curve.</td>
</tr>
<tr>
<td>“Assign to Diagram”</td>
<td>Lists the diagrams (in the submenu on the right) where the selected variable is not currently displayed. Select a diagram to display the variable there. The command is available when a variable is selected in the tree view. Hint: When the command is deactivated, the variable is already displayed in all diagrams.</td>
</tr>
<tr>
<td>“Enabled”</td>
<td>Selected by default Disabled variables are displayed as disabled. They are neither displayed nor recorded.</td>
</tr>
</tbody>
</table>

Tree view ‘Presentation (Diagrams)’  The tree view lists the diagrams that are displayed in the trace editor and allows for access to their display mode.

<table>
<thead>
<tr>
<th>Selected node “Time axis”</th>
<th>The “Display Mode” subdialog for the time axis is displayed on the right. You can specify the time axis display. See below.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected diagram name</td>
<td>The settings for the coordinate system of the diagram and a preview are displayed on the right. See below.</td>
</tr>
<tr>
<td>Selected node “Y-axis”</td>
<td>The “Display Mode” subdialog is displayed on the right. You can specify the axis display. See below.</td>
</tr>
<tr>
<td>“Show variables”</td>
<td></td>
</tr>
<tr>
<td>Selected trace variable</td>
<td>The “Variable Settings” subdialog is displayed on the right. You can configure the trace variable. See below. Note: These are the same settings that can be accessed in the “Trace Record” tree view.</td>
</tr>
</tbody>
</table>

Table 596: Context menu commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+ “Add Diagram”</td>
<td>Adds a new diagram below and displays it in the tree view “Presentation (Diagrams)”.</td>
</tr>
<tr>
<td>+ “Add New Variable”</td>
<td>Adds a new trace variable. The “Variable Settings” subdialog opens on the right and it is partially configured. Select a variable in the input field of the “Variable” setting to trace its value curve. Specify its display. In addition, the variable is assigned to the selected diagram.</td>
</tr>
<tr>
<td>“Add Existing Variable”</td>
<td>Lists all trace variables (in the submenu on the right) where the selected diagram is not currently displayed. Select a variable in order to display it in the selected diagram. Hint: When the command is deactivated, all trace variables are already displayed in the selected diagram.</td>
</tr>
</tbody>
</table>

Subdialog ‘Record Settings’  Requirement: The top node is selected in the “Trace Record” tree view.
**“Enable trigger”**

☑️: Triggering is enabled. The trace data is buffered at runtime only when a trigger signal has been sent. You determine how the trigger signal is sent in the “Trigger variable”, “Trigger parameter”, “Trigger edge”, “Post-trigger (Samples)”, and “Trigger level” settings.

☐: Continuous display of current records

**“Trigger variable”**

Signal that is used as a trigger. A complete instance path is required.

A valid trigger signal is an IEC variable, a property, a reference, a pointer, an array element of the application, or an expression. Allowed types are all IEC-based types except STRING, WSTRING, and ARRAY. Enumerations are allowed when the base type is not STRING, WSTRING, or ARRAY. The contents of a pointer are not a valid signal.

When the runtime system uses the CmpTraceMgr component, a property that is linked to the 'monitoring' attribute can then be recorded as a variable.

**“Trigger parameter”**

System parameter that is used as a trigger

The “Input Assistant” dialog lists all valid system parameters in the “Parameters” category of the “Categories” tab.

Allows the selection of “Trigger variable” or “Trigger parameter”

**“Trigger edge”**

Defined the edge detection for triggering:

- **positive**
  - For Boolean trigger variables, triggering occurs when the values change from FALSE to TRUE.
  - For analog trigger variables, triggering occurs when the value as defined in “Trigger level” is reached from below.
- **negative**
  - For Boolean trigger variables, triggering occurs when the values change from TRUE to FALSE.
  - For analog trigger variables, triggering occurs when the value as defined in “Trigger level” is reached from above.
- **both**
  - For Boolean trigger variables, triggering occurs when the values change.
  - For analog trigger variables, triggering occurs when the value as defined in “Trigger level” is reached.

**“Post trigger (samples)”**

Number of records per trace variable that are buffered after triggering. Default: 50; value range: 0 to \(2^{32}-1\)

**“Trigger level”**

Value that is reached to start the triggering

**“Task”**

Task in which the data is recorded.

**“Recording condition”**

At runtime, the application checks the recording condition. If it is fulfilled, then the trace data is buffered.

Record condition for data recording with CmpTraceMgr runtime system component:

- As an expression that includes only permitted operators and operands.
  - Allowed operators that can also be nested: (logical) AND, NOT, OR, comparison operators <, <=, >, >=, =, <>
  - Allowed operands: Variables that are valid for trace.
- As a variable.
  - Allowed type: BOOL, bit access, property. The condition is fulfilled for TRUE or 1. The contents of a pointer are not permitted.

Recording condition for a data recording with IEC code:

- As an expression that returns a Boolean value.

**“Comment”**

Comment (for example, from the recording condition)
"Resolution"  Unit of measure for the time stamp that is recorded per data set

- "ms": Time stamp (in milliseconds).
- "µs": Time stamp (in microseconds) for a task cycle time of 1 ms or less

"Automatic restart"  Persistently saves the trace configuration and the last contents of the RTS buffer to the target device. After the device has been restarted, the trace is started automatically if the trigger has not occurred yet.

"Advanced"  Opens the "Advanced Trace Settings" dialog.

See also
- Chapter 6.4.1.21.4.16.1 “Dialog ‘Advanced Trace Settings’” on page 2803

Subdialog 'Variable Settings'

Requirement: A trace variable is selected in the "Trace Record" or "Display (Diagrams)" tree view.

<table>
<thead>
<tr>
<th>&quot;Variable&quot;</th>
<th>Valid variable Variable; value recorded with full instance path. Valid:</th>
</tr>
</thead>
<tbody>
<tr>
<td>IEC variable</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td></td>
</tr>
<tr>
<td>Reference</td>
<td></td>
</tr>
<tr>
<td>Contents of the pointer</td>
<td></td>
</tr>
<tr>
<td>Array element</td>
<td></td>
</tr>
<tr>
<td>Allowed data type</td>
<td></td>
</tr>
<tr>
<td>IEC-based type except STRING, WSTRING, or ARRAY</td>
<td></td>
</tr>
<tr>
<td>Enumeration when the base type is not STRING, WSTRING, or ARRAY</td>
<td></td>
</tr>
<tr>
<td>When the runtime system uses the CmpTraceMgr component, a property that is linked to the 'monitoring' attribute can then be recorded as a variable.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Parameter&quot;</th>
<th>Parameter whose data is recorded. Requirement: Runtime system with CmpTraceMgr component</th>
</tr>
</thead>
<tbody>
<tr>
<td>The “Input Assistant” dialog lists all valid system parameters in the “Parameters” category of the “Categories” tab.</td>
<td></td>
</tr>
</tbody>
</table>

| "Color" | Color of the variable in the trace diagram |

<table>
<thead>
<tr>
<th>&quot;Line type&quot;</th>
<th>Display as line chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Line&quot;: Values are linked to form a line.</td>
<td></td>
</tr>
<tr>
<td>&quot;Step&quot;: Values are linked in the form of steps</td>
<td></td>
</tr>
<tr>
<td>&quot;None&quot;: Values are not linked</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Point type&quot;</th>
<th>Display as scatter chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Dot&quot;: Value is displayed as a dot</td>
<td></td>
</tr>
<tr>
<td>&quot;Cross&quot;: Value is displayed as a cross.</td>
<td></td>
</tr>
<tr>
<td>&quot;None&quot;: value is not displayed</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Activate minimum warning&quot;</th>
<th>Warning when less than the lower limit</th>
</tr>
</thead>
</table>

| "Critical lower limit" | If the value of the trace variable falls below the limit, the variable is displayed in the warning color. |

| "Color" | Warning color on falling below the limit |

| "Activate maximum warning" | Warning when exceeding the upper limit |

### Notes
- A trace variable is selected in the "Trace Record" or "Display (Diagrams)" tree view.
- The "Input Assistant" dialog lists all valid system parameters in the “Parameters” category of the “Categories” tab.
- The runtime system with CmpTraceMgr component enables recording variables linked to the 'monitoring' attribute.
- Parameters are displayed as line or scatter charts, with options for line types "Line", "Step", or "None" and point types "Dot", "Cross", or "None".
- Minimum and maximum warnings are configurable.

---

2024/01/05  3ADR010583, 1, en_US  2807
**Subdialog 'Display Mode'**

**Table 597: “Tick marks”**

<table>
<thead>
<tr>
<th>“Fixed spacing”</th>
<th>☑: Display of tick marks with “Distance” and “Subdivisions”.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Distance”</td>
<td>Distance between tick marks</td>
</tr>
<tr>
<td>“Subdivisions”</td>
<td>Number of subdivisions between two tick marks</td>
</tr>
</tbody>
</table>

**Link “Preview”** Displays the preview of the diagram.
**Dialog Box 'Trend storage'**

**Function:** This dialog box includes the configuration for buffering the trend data of a trend recording.

**Call:** “Trend Storage” button in the editor of a trend recording.
### Maximum number of variables

Maximum number of trend variables that can be managed in the database. If you increase this value afterwards, then will CODESYS perform a download and reconfigure the database.

### Store every N milliseconds

Time interval (in ms) when the CmpTraceMgr runtime system component buffers the recorded data before storing it persistently in the database. The application calculates internally the number of task cycles from the time interval. The duration of a task cycle is defined in the task configuration.

A high value results in better runtime performance. The disadvantage is the increased risk of losing data if the controller crashes or shuts down. A low value reduces this risk. The disadvantage is the slower control over a trend visualization with large amounts of data.

### Limit

- **Limit:** Limit the recording
  - **No Limit**: Unlimited number of data records (not recommended)
  - **Maximum number of records**: Maximum number of data records that are stored in the database. A data record consists of time stamp and the values of the trend variables at this time.
  - **Maximum storage size**: Maximum size of the trend storage. The application calculates internally the number of data records.

Clicking the "down" symbol (▼) of the drop-down list will set the units to kilobytes (KB), megabytes (MB), or gigabytes (GB).

### Additional Runtime Buffer for

Length of the time interval when the runtime system can record more data (for example, 1000 ms).

If a delay occurs when writing data in the runtime system component, then there is a risk of data loss due to overwriting. In this case, the runtime system uses the addition buffer.

### Dialog Box 'Advanced Trend Settings'

**Function:** This dialog box provides more settings for configuring trend recording.

**Call:** Click “Advanced” in the editor of a “TrendRecording” object.

**See also**

- Chapter 6.4.1.13.4.2 “Getting started with trend recording” on page 2017
- Chapter 6.4.1.13.4.3 “Configuring trend recording” on page 2018
Dialog 'Certificate Selection'

**Symbol:**

**Function:** This dialog is used for selecting the certificates for encryption, decryption, and digital signatures.

**Call:**
- "Security Screen" view, "User" tab
- Main menu: "View ➔ Properties", "Security" tab when the "Application" is selected in the device tree.
- Main menu: "Project ➔ Project Settings", category "Security"

Dialog 'Certificate selection'

The purpose of the certificate that is selected in the dialog depends on the call location:

- Call location: "Security screen" view, "User" tab
  - Certificate for digital signatures
  - Certificate for the decryption of project files
  - Certificate for encrypted communication
- Call: "View ➔ Properties" of the application
  - "Certificates of devices that share the encrypted download and the boot application"
- Call location: "Project ➔ Project settings", category "Security"
  - "Certificate for project encryption"

<table>
<thead>
<tr>
<th>Listing of the selected certificates in a table</th>
<th>The following properties are displayed for each selected X.509 certificate:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>● “Issued for”</td>
</tr>
<tr>
<td></td>
<td>● “Issued by ”</td>
</tr>
<tr>
<td></td>
<td>● “Valid from”</td>
</tr>
<tr>
<td></td>
<td>● “Valid until”</td>
</tr>
<tr>
<td></td>
<td>● “Thumbprint”: SHA1 fingerprint</td>
</tr>
<tr>
<td></td>
<td>Double-clicking an entry opens the “Certificate” dialog with the “General” tab, “Details” tab, and “Certification Path” tab. In that tab, you will find a reference to Windows help with more information about the dialog.</td>
</tr>
</tbody>
</table>

**Add**

Adds the selected available certificate to the list of selected certificates.

**Remove**

Deletes the certificate selected in the list.

"Available certificates in the local Windows Certificate Store"

Double-clicking an entry opens the “Certificate” dialog with the “General” tab, “Details” tab, and “Certification Path” tab. In that tab, you will find a reference to Windows help with more information about the dialog.

| Certificate icons | 
|--------------------|--------------------------------------------------------------------------|
|                   | ● ![Certificate icon] Certificate with a private key                      |
|                   | ● ![Certificate icon] Untrusted certificate                              |

See also
- ☞ Chapter 6.4.1.21.3.4.18 “Command ‘Security Screen’” on page 2592
6.4.2 Fieldbus Support

6.4.2.1 Device Diagnosis

CODESYS provides general and fieldbus-specific function blocks for performing a diagnosis on the connected devices.

General diagnosis

You can perform a diagnosis on devices regardless of the fieldbus. The function blocks from the CAA Device Diagnosis library are provided for this purpose.

Before you can work with these function blocks, you have to select the “Enable diagnosis for devices” option in the PLC settings. This causes CODESYS to create instances of the diagnosis functions blocks automatically. These function blocks can be used for your diagnosis.

Work exclusively with the automatically generated instances of the diagnosis function blocks. Do not create your own instances.

See also

● § Chapter 6.4.1.21.2.8.10 “Tab ‘PLC Settings’” on page 2439
● Library CAA DeviceDiagnosis

Bus-specific diagnosis

For bus-specific diagnosis options, see the diagnosis chapters of the individual fieldbuses.

6.4.2.2 Fieldbus Devices and I/O Drivers

The technical basis for each fieldbus device, which is configured in the device tree, is the CODESYS I/O driver.

The I/O driver is the link between the fieldbus stack, the IEC application, and the CODESYS IDE. The driver configures the fieldbus stack from the data of the device configuration. It shows the diagnosis, provides an API for the IEC application, and is responsible for the I/O mapping (see chapter "I/O Mapping").

This chapter provides a brief overview of the basic functionality of CODESYS I/O driver devices, without discussing the details of specific bus systems. In addition, some recommendations for the configuration are provided.

Bus cycle task

The bus cycle task is the IEC task in whose context the I/O driver is executed. Some I/O drivers use multiple tasks: usually one real-time critical task (with high priority), which is used for the transfer of I/O data, and another task with low priority for tasks such as evaluating diagnostics and executing acyclic services of the bus system.

With real-time critical bus systems, it has to be ensured that no operations are executed in the context of this bus task that would interrupt the bus clock due to the execution time.

The bus task can be configured in the I/O mapping dialog of the I/O driver device. Note that the settings of the parent device are inherited by default. If this device is the PLC, then its PLC setting applies in the bus cycle task.
NOTICE!
If this above setting is not set, then the task with the shortest cycle time is used. In this way, a non-real-time I/O driver can be executed unintentionally in the task context of a real-time critical driver, thus interrupting its communication. To diagnose these communication problems, it is recommended to check the task monitoring.

See also
● § Table 418 “Bus Cycle Options” on page 2440

I/O mapping
An essential function of an CODESYS I/O driver is to update the I/O mapping. This means the mapping of the I/O data of the bus system to variables of the IEC application (and vice versa).

The input/output data is mapped cyclically by copy and conversion operations in both directions from the internal memory image of the bus system to IEC variables assigned to %I and %Q addresses.

For the I/O driver, there is no internal difference whether symbolic names or "direct" access to the %I and %Q addresses are used for this I/O mapping. For the maintainability of the application, it is recommended to always use descriptive variable names (example: variable "TemperatureReactor" instead of "%IW117" access).

The updating of the I/O mapping can be set with “Always update variables” (globally in the “PLC Settings” or individually for each device in the I/O mapping dialog):

● Disabled:
  Only I/O data used in the application is mapped.
  This may improve performance by avoiding the copy operations, but may cause confusion if the I/O data in the I/O mapping dialog is not updated (the values are then grayed out). This setting is recommended for an application whose development has been completed.

● Enabled 1:
  All data is updated.

● Enabled 2:
  Caution: For productive use in special cases only.
  As a result, inconsistent I/O data may occur, because the bus cycle task reads/writes this data while the application code uses it in other tasks.
  See „Consistency of I/O data“.

See also
● § Chapter 6.4.1.21.2.8.12 “Tab '<device name> I/O Mapping’” on page 2444

Consistency of I/O data
The CODESYS programming system allows the IEC application to use multiple tasks executed in parallel (for visualization, field buses, or other POU's). The application code can access I/O data from the context of these tasks via the mapped IEC variables. By accessing the same data from different tasks, inconsistent or corrupt data could occur (for example, due to interrupted write access).

The I/O driver ensures data consistency by providing each task executing a task cycle with a consistent mapping – a snapshot, so to speak – of all I/O data used.

So a code like in the following example cannot cause problems: (Note "DIV by ZERO")

```plaintext
IF(inputData <> 0) THEN
  x := y / inputData;  // inputData is mapped to %I
END_IF
```

```
DIV_BY_ZERO Exception
```

```
// inputData is not updated by bus cycle during execution of POU
```
NOTICE!
With the "Always update variables" option set to "Enabled 2 – always in bus cycle task", this mechanism is overridden. Accordingly, the application code has to take this into account.

Services
In addition to the basic functionality, some I/O drivers provide services that can be called from the CODESYS IDE, such as the device scan function or the setting of device addresses.

General recommendations
Settings:
- "PLC Settings": [ ] I/O updates in stop:
  The bus cycle continues even when the application is stopped, for example when the application is on a debug breakpoint. In this way, communication with the field devices is maintained and can be continued immediately without interruption.
- "PLC Settings": "Always update variables" is set to "Enabled 1 – use bus cycle task if not used in any task":
  During the development of the application, it is useful to see the values of all I/O data.

Task configuration:
- Especially for real-time critical fieldbus systems such as Profinet, EtherCAT, or CAN, which depend on maintaining an exact send/receive clock, it is recommended to use a separate bus cycle task with high priority. For less real-time-critical tasks (for example, visualization) a significantly lower priority should be selected than for the bus cycle task.
- In order to achieve maximum I/O throughput with as little offset as possible, separate POU's can be executed in the bus task of the fieldbus system. However, these then have to meet the real-time requirements: for example, no file access or blocking socket functions may be executed, but for example only the calculation of the output data.

Multiple I/O drivers and tasks (troubleshooting)
If consistent access to I/O data from multiple tasks and possibly across multiple I/O driver instances has to be synchronized, then undesired reciprocal interference between the bus and application task may occur under certain circumstances.

This is the case, for example, when the general system load is high or when the I/O data of the real-time critical fieldbus system is used together with I/O data of a slow and blocking local bus system in the same task.

In case of unexpected interference of the communication, with the particularly real-time-critical fieldbuses (EtherCAT, Profinet, CAN), the task monitoring should therefore first be examined for very large jitter or outliers in the cycle time (maximum value compared to average value). The task list provides detailed information about the use of I/O data in different tasks.

It may be possible to avoid using I/O data from different bus systems in one and the same task or to reduce the number of I/O tasks.

See also
- Chapter 6.4.1.21.2.8.18 “Tab ‘Task deployment’” on page 2459

6.4.2.3 Bus Cycle Task
Generally, for each IEC task, the used input data is read at the start of each task (1) and the written output data is transferred to the I/O driver at the end of the task (3). The implementation in the I/O driver is decisive for additional transfer of the I/O data. It is responsible for the time frame and time point that the actual transfer to the corresponding bus system occurs.

The bus cycle task of the PLC can be defined globally for all fieldbuses in the PLC settings. For some fieldbuses, however, you can change this independent of the global setting. The task with the shortest cycle time is used as the bus cycle task (setting: "unspecified" in the PLC settings). The messages are normally sent on the bus in this task.
Other tasks copy only the I/O data from an internal buffer that is exchanged only with the physical hardware in the bus cycle task.

(1) Read inputs from input buffer          (2) IEC task
(3) Write outputs to output buffer       (4) Bus cycle
(5) Input buffer                                    (6) Output buffer
(7) Copy data to/from bus
(9) Bus cycle task, priority 1, 1 ms
(10) Bus cycle task, priority 5
(11) Bus cycle task, priority 10, interrupted by task 5

**Task usage**

The "Task Deployment" tab provides an overview of used I/O channels, the set bus cycle task, and the usage of channels.

**WARNING!**

If an output is written in various tasks, then the status is undefined, as this can be overwritten in each case.

If the same inputs are used in various tasks, then it is possible for the input to change during the processing of a task. This happens when the task is interrupted by a task with a higher priority and causes the process image to be read again. Solution: At the beginning of the IEC task, copy the input variables to variables and then work only with the local variables in the rest of the code.

Conclusion: Using the same inputs and outputs in several tasks does not make any sense and can lead to unexpected reactions in some cases.

### 6.4.2.4 Symbolic Access to I/O Channels

#### 6.4.2.4.1 General

You get direct access to the I/O channels of your device by means of specially generated function blocks, without having to actively set up a mapping manually for each device and for each channel.

**Automated generation**

- The inputs and outputs are combined into a function block under the name of the I/O channel. If possible, the basic block defined in the device description is extended.
- The channel name corresponds to the name as specified in the device editor on the I/O Mapping tab in the "Channel" column.
- The input and output variables created in this way are also displayed in the Input Assistant.
If the I/O channels are structured or enumerations, then their function blocks are also structured accordingly. As such, the generated function blocks contain structured inputs and outputs or enumerations.

- For channels with identical names, the suffix \_<X> is appended to the input or output of the function block.
- If a device does not have its own I/O channels (example: EK1100 Slave), then no function block is created.

### 6.4.2.4 Enable automatic mapping

1. In the **Devices** view, open the top device. In the device editor, select the **PLC Settings** tab.
   
   Under **Additional Settings**, there is the **Enable symbolic access for I/Os** option.

2. **Select the check box**.
   
   The generated function block instance is displayed on the **IEC Objects** tab of the device.
   
   For each I/O channel, a (usually extended) function block is now automatically created and instantiated. This provides you with direct access immediately. You can access the I/O channel by means of the variables of the function block.

**Example:** EtherCAT Slave

The new function block extends the existing function block. The EL1008 function block instance is listed in the device editor below the **EtherCAT IEC Objects** tab.

Function block: EL1008\_FB

The DrvEthercatLib.ETCSlave_Diag function block is extended to EL1008\_FB and gets the output variables Input\_<n>.

**Example:** CANopen

If no function block is defined in the device description which can be extended, then a new function block is generated. For example, the Generic\_XN1AI function block instance is listed in the device editor below the **IEC Objects** tab.

**Example:** CANopen

The BK5120\_FB function block, which extends the existing _3SCOS.CANRemoteDevice function block according to the device description, is generated. The BK5120 function block instance is listed in the device editor on the **CANopen IEC Objects** tab.

### 6.4.2.3 Online Mode

In online mode, the data is updated by means of the existing functions. However, only those of the generated variables which are actually used are updated. Or if the **Always update variables** option is enabled.

If a channel is simultaneously accessed symbolically and via I/O mapping, then compiler warnings are issued.

### 6.4.2.5 EtherNet/IP

#### 6.4.2.5.1 Introduction

EtherNet/IP is used to connect any number of different terminals in a network, using a scanner-adapter relationship. The scanner can be thought of as a teacher and the adapter as a student. The scanner gives commands to the adapter in the form of input data and the adapter responds to the request with output data. For example, a PLC might send input to a motor to determine the speed of the machine. The motor, acting as an adapter, would respond with an output containing the speed of the machine.
The difference of EtherNet/IP from other protocols, is that the adapters can accept connections from more than one scanner. With other protocols, such as Modbus RTU, slave devices can only connect to a master device. A scanner can connect to any number of adapters and access their data. However, only one scanner can control the outputs of an adapter. Other scanners can monitor the output of an adapter.

Chapter 6.8.2.6.1.2 "Ethernet protocols and ports for AC500 V3 products" on page 4480

“Pin assignment” on page 381

6.4.2.5.2 Configuration EtherNet/IP adapter

Setting up the communication gateway

To set up the communication between the PC and the PLC, e.g., for downloading the compiled program, you have to set up the communication parameters.

The IP address of your PC must be in the same class as the IP address of the CPU.

The factory setting of the IP address of the CPU is 192.168.0.10.

The IP address of your PC should be 192.168.0.X. Avoid X = 10 in order to prevent an IP conflict with the CPU.

Subnet mask should be 255.255.255.0.

Changing of the IP address

1. Open Windows control panel. Click “Network and Internet > Network and Sharing Center”.
2. Click “Change adapter settings”.

   If using existing network with several devices, please pay attention on given network rules or contact your system administrator.

3. Right-click “Local Area Connection (Ethernet)” and select [Properties].
5. Enter your desired IP address and subnet mask.
Setting up the communication gateway

- CPU and PC are connected with an Ethernet cable.

1. In the Automation Builder device tree right-click “PLC_AC500_V3”.
2. Select “Communication Settings”.

---

Configuration and programming
Programming with CODESYS > Fieldbus Support

ADR010583, 1, en_US

2820

3ADR010583, 1, en_US
2024/01/05
3. Keep the default value in the IP address of the CPU or type in the current IP address, if differs.

   The standard (default) IP address of the port ETH1 is: 192.168.0.10

4. Select [OK] to implement the IP address.

**Network scan**  
If you need to scan the network for the CPU or if you have multiple CPUs on the same network.
1. Right-click “PLC_AC500_V3” in the device tree.
2. Select “Communication Settings”.

![Communication Settings for PLC_AC500_V3](image)
3. Select “…”

⇒ “Pick IP Address for PLC_AC500_V3” opens.

The automatic scan runs.
The results will appear in this field.

4. Select the CPU in the field and select [OK] to implement the needed communications gateway.

**Checking the communication settings**

If you need to check the communications settings or if you want to see more information about the current selected CPU.

1. Double-click “PLC_AC500_V3” in the device tree.
2. Select “Communication Settings”.
   ⇒ The selected IP address is shown.

3. If the IP address is not visible, enter the IP address manually.

4. To test the connection and/or to see the CPU information press [Enter] or click on the black dot next to the PLC figure.

### 6.4.2.5.3 EtherNet/IP - Bus Cycle Task

**General information**

The term "bus" includes all fieldbuses as well as the ☰ I/O bus. Consider that there is no bus cycle task for Modbus as Modbus does not provide I/O mapping and is controlled by POUs.

It's recommended to define a dedicated bus cycle task for each fieldbus configured in the project. It's strongly recommended not to use "unspecified" in the "PLC Settings" to avoid unexpected behavior. The task defined in "PLC Settings" determines the bus cycle task of I/O bus and, depending on the configuration, of the additional fieldbuses (the setting is by default inherited).

Especially in case of EtherCAT, a dedicated bus cycle task should be used which is not shared with other fieldbuses. If [unspecified] is set in the "PLC Settings", the EtherCAT task might be automatically used by other fieldbuses, potentially causing the EtherCAT task processing to fail. This should be avoided by specifying a task different to the EtherCAT task in the "PLC Settings".

As a rule, for each IEC task the used input data is read at the start of each task and the written output data is transferred to the I/O driver at the end of the task. The implementation in the I/O driver is decisive for further transfer of the I/O data. The implementation is therefore responsible for the timeframe and the specific time when the actual transmission occurs on the respective bus system.

Other tasks copy only the I/O data from an internal buffer that is exchanged only with the physical hardware in the bus cycle task.

<table>
<thead>
<tr>
<th>(1) Read inputs from input buffer</th>
<th>(2) IEC task</th>
</tr>
</thead>
<tbody>
<tr>
<td>(3) Write outputs to output buffer</td>
<td>(4) Bus cycle</td>
</tr>
<tr>
<td>(5) Input buffer</td>
<td>(6) Output buffer</td>
</tr>
<tr>
<td>(7) Copy data to/from bus</td>
<td></td>
</tr>
<tr>
<td>(9) Bus cycle task, priority 1, 1 ms</td>
<td>(10) Bus cycle task, priority 5</td>
</tr>
<tr>
<td>(11) Bus cycle task, priority 10, interrupted by task 5</td>
<td></td>
</tr>
</tbody>
</table>

**Using tasks**

The "Task Deployment" provides an overview of used I/O channels, the set bus cycle task, and the usage of channels.
6.4.2.5.4 Tabs EtherNet/IP Scanner

Tab EtherNet/IP Scanner - “General”

This tab in the configurator of the EtherNet/IP scanner includes the basic settings. The network interface used by the scanner is configured in the settings of the Ethernet adapter.

Table 598: Options

| Auto-reestablish of connections | ☑: The scanner always attempts to automatically reestablish an interrupted connection. 
For example, if a timeout is detected for UDP I/O messages or the TCP connection to the adapter is interrupted. If the option is activated, then the scanner reconnects to the adapters with the lost connection. |

Tab “NetX Configuration”

This tab is only displayed if Ethernet communication modules (e.g. CI50x-PNIO) based on the highly integrated netX100 microcontroller is used.

As an alternative to the general EtherNet/IP node in case of a NetX field bus the EtherNet/IP node (NetX) can be added to the device tree. This node provides the additional NetX configuration dialog to select the NetX chip (slot for the card) and the communication channel of this chip. The name of the setting used in the dialog and the possible settings provided by the selection lists are defined by the device description.

Table 599: NetX settings

| Slot | Slot to be used. In case of PCI cards with NetX chip, the slot numbers usually correspond to the PCI card numbers. |
| NetX Com channel | Channel on the card to be used for the communication. A NetX board may have up to four communication channels for different fieldbuses. |
| Auto-initialize bus | ☑ The user is asked to determine if the bus should be reinitialized when downloading or when resetting the application. A new initialization will interrupt the bus and may lead to unwanted behavior of the machine. |
Tab EtherNet/IP Scanner NetX - “General”

This tab in the configurator of the EtherNet/IP scanner contains the basic settings for communication in the network.

Table 600: Address Settings

<table>
<thead>
<tr>
<th>Use static IP address</th>
<th>These entries each occupy four bytes and serve to identify the scanner within the network environment</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP address</td>
<td></td>
</tr>
<tr>
<td>Subnet mask</td>
<td></td>
</tr>
<tr>
<td>Gateway address</td>
<td></td>
</tr>
<tr>
<td>Optain IP address automatically</td>
<td>This option is available only for the NetX scanner</td>
</tr>
<tr>
<td>BOOTP</td>
<td>Assignment of the IP address by a server by means of Bootstrap Protocol (BOOTP)</td>
</tr>
<tr>
<td>DHCP</td>
<td>Automatic configuration of the network settings by the host by means of Dynamic Host Configuration Protocol (DHCP)</td>
</tr>
</tbody>
</table>

Table 601: Ethernet Settings

| Speed and duplex: Bit rate of the transmission. In case of “Auto-negotiation”, the highest of the available bit rates is selected automatically. |

Table 602: Options

<table>
<thead>
<tr>
<th>Auto-reestablish connections</th>
<th>☑: The scanner always attempts to automatically reestablish an interrupted connection.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>For example, if a timeout is detected for UDP I/O messages or the TCP connection to the adapter is interrupted. If the option is activated, then the scanner reconnects to the adapters with the lost connection.</td>
</tr>
</tbody>
</table>

6.4.2.5.5 Tabs EtherNet/IP Adapter

Tab EtherNet/IP Adapter - “General”

The device editor tab shows general information from the device description file. You can modify these values.

Table 603: EDS File

<table>
<thead>
<tr>
<th>Vendor name</th>
<th>Provided by the ODVA (Open DeviceNet Vendors Association)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor ID</td>
<td></td>
</tr>
<tr>
<td>Product name</td>
<td>Values from the EDS file</td>
</tr>
<tr>
<td>Product code</td>
<td></td>
</tr>
<tr>
<td>Major revision</td>
<td></td>
</tr>
<tr>
<td>Minor revision</td>
<td></td>
</tr>
</tbody>
</table>
Enable ACD  ☑ Enables the ACD functionality (Address Conflict Detection) for the EtherNet/IP adapter.

Note: The ACD functionality is normally applied by the operating system. Therefore, the user should only use this function very conscientiously. By enabling ACD, complications can result between the controller and the operating system. ACD is a mechanism that EtherNet/IP devices can use to detect and respond to IPv4 address conflicts. The ACD mechanism used in EtherNet/IP complies with the IETF RFC 5227 standard.

Install to Device Repository  If a device with the same device identification has already been installed, then you are asked whether the device should be overwritten. If the device is inserted as a remote adapter below an EtherNet/IP scanner, then you will be asked to automatically update the device.

Export EDS File  The EDS file is created and stored on the local computer. In this way, the EDS file can be used in an external configuration file.

Tab EtherNet/IP Adapter - “Connections”

The upper part of this tab displays a list of all configured connections. When there is an “Exclusive owner” connection in the EDS file, it is inserted automatically when adding the adapter. The configuration data for these connections can be changed in the lower part of the dialog.

The configuration data is defined in the EDS file. The data is transmitted when the connection to the adapter is established.

<table>
<thead>
<tr>
<th>RPI (ms)</th>
<th>Requested Packet Interval: Exchange interval of the input/output data</th>
</tr>
</thead>
<tbody>
<tr>
<td>O --&gt; T Size (Bytes)</td>
<td>Size of the producer data from the scanner to the adapter (Originator --&gt; Target)</td>
</tr>
<tr>
<td>T --&gt; O Size (Bytes)</td>
<td>Size of the consumer data from the adapter to the scanner (T --&gt; O)</td>
</tr>
<tr>
<td>Proxy Config Size (Bytes)</td>
<td>Size of proxy configuration data</td>
</tr>
<tr>
<td>Target Config Size (Bytes)</td>
<td>Size of adapter configuration data</td>
</tr>
<tr>
<td>Connection Path</td>
<td>Address of the - configuration objects - input objects - output objects</td>
</tr>
<tr>
<td>Add Connection</td>
<td>Opens the “New Connection” dialog. The parameters for the new connection are determined here.</td>
</tr>
<tr>
<td>Delete Connection</td>
<td>Deletes the selected connection from the list</td>
</tr>
<tr>
<td>Edit Connection</td>
<td>Opens the “Edit Connection” dialog. The parameters for the existing connection are modified here.</td>
</tr>
</tbody>
</table>

Table 604: “Configuration Data”

The table shows the connections with the configuration parameters from the EDS file. The connections are divided into configuration groups.

<table>
<thead>
<tr>
<th>Raw data values</th>
<th>If the scaling parameters are defined in the EDS file for the data, then you can show the values as raw data or converted data.</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑</td>
<td>The data is displayed without conversion. In the case of enum data types, the index of the enumeration value is shown.</td>
</tr>
<tr>
<td>☐</td>
<td>The data is displayed with conversion. In the case of enum data types, the enumeration value is shown.</td>
</tr>
<tr>
<td>Show parameter groups</td>
<td>☑ If groups are defined in the EDS file, then the parameters that are defined in these groups are displayed in a sorted list.</td>
</tr>
</tbody>
</table>
Defaults | Resets to the default values
--- | ---
Value | Double-click to change the value. Depending of the data type, you can specify the value directly in the input field or select from a list box.

In the case of bit field data types and deactivated raw data values, a dialog opens for you to choose the individual bits. Only those can be selected which fall within defined minimum and maximum values. If bit field data types contain enumerations in the associated EDS file, then only these enumerations are shown with the associated bit positions.

If a connection contains a parameterizable connection path in the EDS file, then here you can modify the different parameters of the respective connection.

### Dialog “New Connection”

**Generic connection (freely configurable)**

The dialog contains the parameters for the new connection.

**Table 605: Connection Path Settings**

<table>
<thead>
<tr>
<th>Automatically generated path</th>
<th>The “Connection Path” is generated automatically from the values for “Configuration assembly”, “Consuming assembly”, and “Producing assembly”.</th>
</tr>
</thead>
<tbody>
<tr>
<td>User-defined path</td>
<td>The “Connection Path” is specified manually in the corresponding input field.</td>
</tr>
<tr>
<td>Path defined by symbolic name</td>
<td>The path is specified by a symbolic name. Requirement: The device must support symbolic connection paths.</td>
</tr>
</tbody>
</table>

**Table 606: General Parameters**

<table>
<thead>
<tr>
<th>Connection Path</th>
<th>The connection path is used to address one or more objects in the adapter that provide the input data and receive the output and configuration data. Requirement: The connection path is set to “User-defined path”.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symbolic name</td>
<td>An ANSI string is used instead of the normal connection path. See the manual of the respective EtherNet/IP adapter for permitted ANSI strings. Requirement: The connection path is set to “Path defined by symbolic name”.</td>
</tr>
<tr>
<td>Trigger type</td>
<td>● “Cyclic”: Data exchange takes place cyclically at intervals set by the RPI. ● “Change of State”: Data is exchanged automatically after a change to the scanner outputs or adapter inputs. ● “Application”: Not implemented</td>
</tr>
<tr>
<td>Transport type</td>
<td>Details for this can be taken from the specifications CIP Volume 1 and Volume 2.</td>
</tr>
<tr>
<td>RPI (ms)</td>
<td>(Requested Packet Interval) Length of the time interval (in milliseconds) in which the transmitting application requests the transmission of data to the target application. This value must be a multiple of the bus cycle task.</td>
</tr>
<tr>
<td>Timeout multiplier</td>
<td>In case of device failure, there is a time delay (RPI * Timeout multiplier) before the device state switches to “Error”.</td>
</tr>
</tbody>
</table>

**Predefined connection (EDS file)**

Use this option to employ existing connections from an EDS file. The data that can be changed are defined in the EDS file.
Table 607: Scanner to Target (Output)

<table>
<thead>
<tr>
<th>O--&gt;T size (bytes)</th>
<th>Amount of data from scanner to adapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proxy config size (bytes)</td>
<td>Size of proxy configuration data</td>
</tr>
<tr>
<td>Target config size (bytes)</td>
<td>Size of adapter configuration data</td>
</tr>
</tbody>
</table>

Connection type
- **“Multicast”**: A network connection is established. The connection data can be received by multiple consumers.
- **“Point to Point”**: A network connection is established. The connection data can be received by exactly one consumer.
- **“Null”**: A network connection is not established.

Connection Priority
Two scanners using different priorities to one adapter can cause conflicts. Adapting the connection priority solves this problem.

Fixed/Variable
See the specifications CIP volume 1 and volume 2 for details of the parameters.

Transfer format

Inhibit time (ms)

Heartbeat multiplier
Requirement: The “Transfer format” is “Heartbeat”.
Extends the interval at which the scanner sends heartbeat messages to the adapter. This value is multiplied by the “RPI” value.
Example: “RPI” = 10ms and “Heartbeat multiplier” = 10 causes a message to be sent every 100ms.

Table 608: Target to Scanner (Input)

<table>
<thead>
<tr>
<th>T--&gt;O size (bytes)</th>
<th>See description for “Scanner to Target”</th>
</tr>
</thead>
</table>

Connection type

Connection Priority

Fixed/Variable

Transfer format

Inhibit time (ms)

Tab EtherNet/IP Adapter - “Assemblies”
The upper part of this tab displays a list of all configured connections. When a connection is selected, the associated assemblies in the lower area of the tab are displayed.

Table 609: Connections
A description of the columns is found on the “Connections” tab.

Table 610: Consuming Assembly O-->T, Producing Assembly T-->O

<table>
<thead>
<tr>
<th>Add</th>
<th>Opens the “Select Parameters” dialog.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Deletes all selected parameters.</td>
</tr>
<tr>
<td>Move Up</td>
<td>Moves the selected parameter within the list. The order in the list determines the order in the I/O mapping.</td>
</tr>
<tr>
<td>Move Down</td>
<td></td>
</tr>
</tbody>
</table>
You can double-click in the text field to edit the values.

- **Show filling bytes of assemblies**: The filling bytes of the assemblies are shown in the I/O mapping. This can be helpful in case the parameter layout of the assemblies is not mapped correctly in the EDS file.

### Dialog Select Parameters

- **Display parameter groups**: The dialog displays all parameters from the EDS file by group.
  - The dialog displays all parameters from the EDS file in a flat structure.
  
  Individual parameters from this list can be selected and added to the list of assemblies by clicking “OK”.

- **Generic parameters**: You can add generic parameters. Individual values of the parameter can be edited.

### Tab EtherNet/IP Adapter - “User-Defined Parameters”

The tab displays all additional parameters that are transmitted once only into the bus system during the phase of the starting procedure allotted to this.

**NOTICE!**

The user parameters are also transmitted again when a connection is reestablished, for example after the failure of a remote adapter.

- **New**: Opens the “Select Parameters” dialog for adding a new parameter. The new parameter is inserted before the selected line.
- **Edit**: Opens the “Select Parameters” dialog for changing an existing parameter.
- **Delete**: Delete the marked lines.
- **Move Up, Move Down**: Changes the order of the user parameters. The order of the parameters in the list corresponds to the order at the initialization.

<table>
<thead>
<tr>
<th>Line</th>
<th>Number of the line</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the parameter</td>
</tr>
<tr>
<td>Value</td>
<td>The value of the respective parameter can be changed directly by double-clicking the value. If applicable, a list box opens containing possible values.</td>
</tr>
<tr>
<td>Unit</td>
<td>Unit</td>
</tr>
<tr>
<td>Bit Length</td>
<td>Length of the bit</td>
</tr>
</tbody>
</table>

**Abort on Error**: In case of error, the entire transmission of the parameters is aborted.

**Jump to Line on Error**: In case of error, the program resumes with the line specified in the “Next Line” column. In this way, an entire block can be skipped during the initialization, or a return can be defined.

**Note**: A return can lead to an infinite loop if it is never possible to write a certain parameter.
Dialog “Select Parameters”

The dialog contains a list of the parameters that are defined in the EDS file. You can define your own generic parameters in addition to the specified parameters.

The values of the selected parameter are displayed in the lower section of the dialog. They can be changed there.

<table>
<thead>
<tr>
<th>Show parameter groups</th>
<th>☑: Display of the parameters sorted by parameter groups</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generic parameter</td>
<td>☑: Enables the creation of generic parameters</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the generic parameter</td>
</tr>
<tr>
<td>Class</td>
<td>Each object class that can be addressed by the network is identified by an integer value.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Object class #5" /></td>
</tr>
<tr>
<td>Instance</td>
<td>Integer value for the unique identification of an object instance within a class. Example of an object instance:</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Object class #5, Instance #2" /></td>
</tr>
<tr>
<td></td>
<td>If the value 0 is assigned to the instance, then the class itself is referenced by this special instance. Example – object instance 0:</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Object class #5, Instance #0" /></td>
</tr>
</tbody>
</table>
Attribute: Integer value that can belong to a certain class or instance.
Example attribute:

Object class #5, Instance #2, Attribute #

Data type: Different data types (e.g. BOOL, UDINT, WORD, DWORD...)
Bit length: 8, 16, 32
Value: Input of different values in different output formats.

---

The values for “Class”, “Instance”, and “Attribute” are defined in the “CIP Networks Library” (Vol. 1 and 2) or in the manual of the device manufacturer.

---

CAUTION!
When individual values are entered, a plausibility check is not performed. Any errors are identified only when the bus is started and they are reported with a message in the log file.

---

Tab EtherNet/IP Adapter - “General”, local
The tab in the device editor of the EtherNet/IP adapter contains the basic settings for network communication.

**Table 611: Address Settings**

<table>
<thead>
<tr>
<th>IP address</th>
<th>Address for the identification of the EtherNet/IP adapter device.</th>
</tr>
</thead>
</table>

**Table 612: BOOTP**
Bootstrap Protocol
This option is available only for adapters under the NetX scanner.

<table>
<thead>
<tr>
<th>MAC address</th>
<th>Device-specific MAC address of the slave.</th>
</tr>
</thead>
</table>

| Save IP address | : The address of the slave is saved. The requirement, however, is that the slave supports this function. This option is only available for the CIFX scanner. |
Table 613: Electronic Keying

<table>
<thead>
<tr>
<th>Compatibility check</th>
<th>Compatibility check</th>
<th>Compatibility check</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>The adapter uses its own keying values to perform a compatibility check of the keying values from the EDS file. All keying values are sent to the device. Then the device decides whether it is compatible with the received values.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>□</td>
<td>□</td>
<td>□</td>
</tr>
<tr>
<td>The adapter uses its own keying values to perform an exact check of the keying values from the EDS file. The user decides which keying information should be checked.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>● Vendor ID</td>
<td>● Device type</td>
<td>● Product code</td>
</tr>
<tr>
<td>● Major revision</td>
<td>● Minor revision</td>
<td></td>
</tr>
</tbody>
</table>

If the check fails, then an I/O connection is not established to the device and an error message is issued to the status page.

Restore Default Values For generic devices only.

6.4.2.5.6 Application notes

Application example

How to set up an EtherNet/IP connection and use a PLC as a scanner and set it up with another PLC as adapter is described in detail in the application example. AC500 V3 EtherNet/IP - AC500 as scanner connected to another AC500 as adapter.

Application example

How to set up an EtherNet/IP connection and use a PLC as a scanner and set it up with a drive is described in detail in the application example. AC500 V3 EtherNet/IP - AC500 as scanner connected to a drive.

6.4.2.5.7 Command EtherNet/IP - “Scan for Devices”

Function: The command establishes a brief connection to the hardware and determines the devices in the network. Then you can apply the devices found into the device tree of your project.

Call: Menu bar: “Project”; context menu of a device object in the device tree

Requirement: The communication settings to the controller are correct. The gateway and the PLC are started. The device supports the scan function.

The following devices provide the scan function: EtherCAT master, EtherNet/IP Scanner (IEC), Sercos master, CANopen Manager, CANopen Manager SIL2, PROFINET controller and PROFIBUS DP master.

You can perform the device scan immediately if the scan function is permanently implemented in the PLC. When scan function is implemented in a library, you have to log in only one time to download the library to the controller.

The command refers to the master controller selected in the device tree. For example, an already inserted PROFINET IO controller can be selected and the command used to determine the I/O devices and I/O modules assigned to it.

After performing the scan operation, the “Scan Devices” dialog opens and displays the found devices.
Table 614: “Scanned Devices”

| “Device name, Device type, Address, Station name, etc.” | Data about the scanned device depending on network type. When you change a value in the list of scanned devices, the value is shown in italics. This indicates that the new value has been changed in the editor in CODESYS, but not in the device. When you download the value to the device, it is shown normally. Value that indicate differences between the project and the scanned device are shown in orange. If multiple device descriptions are available for the scanned device, then the name is displayed in bold. The selection of the matching device description is resolved differently for different fieldbuses. For more detailed information, see the corresponding fieldbus chapters. If a device description cannot be found, then the following message is shown: "Attention! The device was not found in the repository." Depending on the bus system, additional information is displayed, such as manufacturer number and product number. The device cannot be inserted into the project without the installed device description. |
|——|——|
| “Show differences to project” | ☑: The table in the dialog also shows additional configured devices (in the device tree of the project). ☐: The table shows all scanned devices. The configured devices are not shown. |
| “Scan for Devices” | Starts a new search. |
| “Copy All Devices to Project” | The device that is selected in the table is inserted into the device tree in the project. If nothing is selected, then all scanned devices are shown. |

**NOTICE!**
If you insert devices, which are available in the device tree, to the device tree with “Copy All Devices to Project”, then the following should be noted. The data of the “Process Data” and “<...> I/O Mapping” tabs of the existing devices can be overwritten with the data of the recently inserted devices.

Table 615: “Configured Devices”

This part of the dialog is visible only when you select the “Show differences to project” option.

Differences between the scanned and configured devices are color-coded. Devices displayed in green are identical on both sides. Devices displayed in red are available only in the view of the scanned or configured devices.

| | If you have selected a device in both views, then the scanned devices are inserted above the selected configured device. |
| | If you have selected a device in both views, then the scanned devices are inserted below the selected configured device. |
| | If you have selected a device in both views, then the configured devices are replaced by the selected scanned device. |
| | All scanned devices are copied to the project. |
| | Deletes the selected configured device. |
Scanning an adapter can fail if the PLC is in RUN mode and a connection already exists from the scanning controller to the adapter. Then the scanning causes another connection to be established to the adapter, which interrupts the existing connection in some adapters. Then the scanner restarts the connection to the adapter, which causes the adapter to interrupt the connection to the scanning controller.

For this reason, it makes sense to perform a network scan in STOP mode after a "Reset". If RUN mode cannot be interrupted, then scanning is possible without an projected remote adapter (EtherNet/IP scanners in the device tree only).

For experts

When accepting the remote adapter by means of the “Copy to Project” command, the I/O dimensions with which the adapter responded are set for the first "exclusive owner" connection. In order to log all of the detected assembly instances after scanning, the definition IODRVETHERNETIP_PRINT_SCAN_RESULT must be set. By default, it is scanned by the instance ID 100–199. This can be adapted by means of the library parameters ParamScanStartOfInstanceAssem and ParamScanLastOfInstanceAssem from the library IoDrvEtherNetIP Library. This might be necessary, for example to scan in another manufacturer-specific range (assembly instance ID ranges).

6.4.3 Runtime systems, OPC UA server

6.4.3.1 OPC UA server for AC500 V3 products

6.4.3.1.1 General

OPC UA server can be added as an object below the Ethernet interfaces ETH1 or ETH2. The user can access the variable interface of the PLC via a client. At the same time, communication can be protected by means of encryption.

The CODESYS OPC UA server supports the following features:

- Browsing of data types and variables
- Standard read/write services
- Notification for value changes: subscription and monitored item services
- Encrypted communication according to "OPC UA standard (profile: Basic256SHA256)"
- Imaging of the IEC application according to "OPC UA Information Model for IEC 61131-3"
- Supported profile: Micro Embedded Device server Profile
- By default, there is no restriction in the number of sessions, monitored items, and subscriptions. The number depends on the performance of the respective platform.
- Sending of events according to the OPC UA standard.

Application note

How to install and configure an OPC V2 or OPC V3 server and how to use it for AC500 PLCs is described in the application note How to use OPC server.

Application example

The application example How to use OPC server V3 - for DA and UA is available to gain a deeper understanding of the OPC protocol and to configure AC500 V3 accordingly.

6.4.3.1.2 Creating a project for OPC UA access

1. Click “File ➔ New Project ➔ AC500 project” in Automation Builder 2.1 or newer.
2. Choose a PLC - AC500 V3 and click [Add object].
3. Right-click on node ETH1 or ETH2 and “Add object”.
4. Choose OPC UA Server in the dialog and click [Add object].
5. Declare some variables of different types in the program.

6. Right-click “Application ➔ Add object”. Choose “Symbol configuration” and click [Add object].

7. Enable checkbox “Support OPC UA Features” in the dialog “Add symbol configuration”.

8. Double-click “Symbol configuration” in the Devices tree to open the editor “Symbol configuration”.

9. Click [Build].

   ⇒ The variables are displayed in a tree structure.

10. Activate the variables that you want to publish to an OPC UA client. Specify the access rights.

11. Download the project to the PLC.

### 6.4.3.1.3 Use node name

1. Double-click node “OPC_UA_Server”.

2. Set parameter “Use node name” to TRUE.

3. Double-click node “PLC_AC500_V3 <...>”.

4. Click “Device” and “Rename active device...”

5. Enter new device name in the following dialog and click [OK].

### 6.4.3.1.4 Use UaExpert client

The OPC UA client UaExpert is available for download from the Unified Automation website and can be used free of charge (freeware license).

Using this client, you can connect to the AC500 OPC UA server.

The following description refers to this program. Other OPC UA clients work in a similar way.
1. Start the *UaExpert* program.

2. Click on the “blue cross symbol”.


4. Enter URL and click [OK].
   - The URL appears in the “Add Server” dialog.

5. Select “Advanced” tab and click [OK].

6. Click [Connect].
7. Expand the project tree in the "Address Space" window.

8. Drag and drop the needed symbols to "Data Access View".

### 6.4.3.1.5 Working with encryption

#### Creating a certificate for the OPC UA server

- Prerequisite: A battery is inserted and the clock is set to actual time.

2. Select the "Devices" tab.
   - The certificate information opens.
3. Select the PLC in the left "Information" view.
   - All services of the PLC that require a certificate are displayed in the right Information view.
4. Select the service "OPC UA Server".
5. Click the icon to create a new certificate for the device.
   - "Certificate Settings" dialog appears.
6. Define the certificate parameters according to the figure above and click [OK].
   \[\Rightarrow\] The certificate is created on the PLC.

7. Upload the certificate to your PC.
8. Restart the runtime system.

For further information see Chapter 6.3.4.7.3.4 “OPC UA secure” on page 1728.

Encrypted connection with UaExpert client

1. Start the UaExpert program.

2. Click on the “blue cross symbol”.


4. Enter URL and click [OK].
   \[\Rightarrow\] The URL appears in the “Add Server” dialog.
5. Select “Advanced” tab.

6. Choose option “Basic256Sha256” of drop-down list “Security Policy” and “Sign & Encrypt” of drop-down list “Message Security Mode” and click [OK].
7. Click menu “Settings” and “Manage Certificates”

8. Click [Create new Application Certificate...].
   Dialog “New Application Instance Certificate” opens.
9. Enter the required informations and click [OK].
   ⇒ Dialog “Manage Certificates” opens

10. Click [Copy Application Certificate To...] your PC.

11. Download the certificate to AC500 via the “Security Screen” view.

Dialog “Certificate Validation” opens.

Working with a trusted certificate will avoid this error message.

14. Enable checkbox Accept the server certificate temporarily for this session and click [Continue].

Dialog “Connect Error” opens
15. Click [Ignore]

16. Check settings in dialog “Manage Certificates”.

6.4.3.1.6 Changing variables via UaExpert client

1. Expand in view “Address Space“ “Objects ➔ DeviceSet ➔ PM5670 ➔ Resources ➔ Application ➔ PLC_PRG”.

   ▶ The variables of the global variable list are visible.
2. Drag and drop the variables to the Data Access View.
3. Change values in the column Value.

6.4.3.1.7 Configuring OPC UA client

Operating modes

Polling
- Objects will be continuously updated in a defined interval
- Create higher load than Subscription
- Is recommended only for a few Symbols

Pub/Sub
Not yet supported

Subscription (recommended mode)
- Updated objects depending on the publishing interval and filters
- Method to reduce load
- Different intervals
- Filter possible (coming in AC500)

<table>
<thead>
<tr>
<th>Client defines a group of symbols with</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publishing interval</td>
<td>Interval, in which server publish data to client</td>
</tr>
<tr>
<td>Sampling interval</td>
<td>Interval for sampling and storing data at server and send in each publishing interval</td>
</tr>
<tr>
<td>Queue size</td>
<td>Array of data to save data if sampling Interval is faster than publishing Interval (At AC500 in the moment only 1)</td>
</tr>
</tbody>
</table>
| Data change filter                   | Can be used to reduce traffic from server to client. Criteria:  
  - Change of data,  
  - Change of status  
  - Change of time stamp  
  AC500 is fix configured for change of data and change of status. |

![Diagram of OPC UA client configuration](image)
Using OPC UA with subscription mode

**Recommendations:**

- Define only variables you need as symbols
- Do not configure publishing intervals to short (increase load)
- Use different subscriptions with different publishing intervals in order to decrease load
- Do not use sampling intervals faster than publishing intervals as long as AC500 OPC UA server don’t support Queue Size different from 1
- Be careful: Setting “0” at sampling Interval at client will be interpreted in server as „as fast as possible”, which is 100ms at AC500 and create a high load.

Publishing and sampling intervals in UaExpert
1. Right-Click on an Item in “Data Access View” and click “Subscription Settings”.

2. Set the recommended values.
   
   **Life Time Count**: Number of publishing intervals in which client has to send publish requests to the server. After this period without request from client, subscription in server will be deleted.
   
   **Max Keep Alive Count**: If there are no new data to send, server can skip a publishing interval. After the alive count, server has to send, even if there are no new data.
   
   Click [OK].

3. Right-Click on an Item in “Data Access View” and click “Monitored Item Settings”.

4. Set the recommended values.

6.4.3.2 Using OPC UA Information Models

The OPC UA information models provide plant information according to the OPC UA standard. This plant data contains both data and metadata, such as data origin, data quality, and data cross-connections. OPC UA-based plants can therefore be connected and analyzed faster.

In plant and mechanical construction, there are several sector-specific OPC UA information models. For example, the Companion Specification EUROMAP77 is an information model for plastics and rubber machinery.

An information model consists of different objects that contain meta-information, runtime information, and user data, such as process variables.
Requirements:
- A CODESYS project is open.
- A controller with integrated OPC UA server functionality has been added to the project.

1. Click “Tools ➔ OPC UA Information Model Repository”.
   - The “OPC UA Information Model” dialog opens.

2. To install the OPC UA information model that you need in your project, select it and click “Install”.

3. In the “Select OPC UA Information Model” dialog, select the information model file *NodeSet2.xml* from the file directory and click “Open”.
   - Now the selected OPC UA information model is displayed in the “OPC UA Information Model Repository”.

4. Add a “Communication Manager” object to the application of your CODESYS project.

5. Add an “OPC UA Information Model” object to the “Communication Manager”.

6. In the “Add OPC UA Information Model” dialog, specify a name for the information model according to IEC 61131-3 and select the desired information model in the “Information Model URI” list box. The list box shows all OPC UA information models from the OPC UA information model repository. Then click “Add”.
   - The publishing object for which you specified a name in the last step is inserted in the “Devices” view with the selected “Information Model” inserted below it.

7. In the next steps, select those objects and data types from the OPC UA information model which you want to use in your CODESYS application. To do this, first open the “Information Model” in the editor.
   - The type declarations of the OPC UA information model are displayed on the left side.

8. Add the OPC UA type declarations desired for your CODESYS application by dragging them from the left area to the right area. For all types with the “Modelling Rule” as “Mandatory”, a corresponding IEC member is generated for the application later when the IEC declarations are generated. For the “Modelling Rule” as “Optional”, in the right area you can activate an IEC member to be generated for this type as well.

9. For OPC UA types with the modelling rule as “Optional Placeholder”, in the right area you can drag and drop another corresponding IEC type to insert it.
   - Example:
6.4.3.3 Mapping of OPC UA Types to IEC Types

<table>
<thead>
<tr>
<th>OPC UA</th>
<th>IEC</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic types</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Boolean</td>
<td>BOOL</td>
<td></td>
</tr>
<tr>
<td>Byte</td>
<td>BYTE</td>
<td></td>
</tr>
<tr>
<td>SByte</td>
<td>SINT</td>
<td></td>
</tr>
<tr>
<td>Int16</td>
<td>INT</td>
<td></td>
</tr>
<tr>
<td>UInt16</td>
<td>UINT</td>
<td></td>
</tr>
<tr>
<td>INT32</td>
<td>DINT</td>
<td></td>
</tr>
<tr>
<td>UInt32</td>
<td>UDINT</td>
<td></td>
</tr>
<tr>
<td>Int64</td>
<td>LINT</td>
<td></td>
</tr>
<tr>
<td>OPC UA</td>
<td>IEC</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>UInt64</td>
<td>ULINT</td>
<td>Simple strings are converted to IEC strings. The length of the IEC string can be changed afterwards and can be chosen without restriction.</td>
</tr>
<tr>
<td>FLOAT</td>
<td>REAL</td>
<td></td>
</tr>
<tr>
<td>Double</td>
<td>LREAL</td>
<td></td>
</tr>
<tr>
<td>Duration</td>
<td>LREAL</td>
<td></td>
</tr>
<tr>
<td>DateTime</td>
<td>LDATEANDTIME</td>
<td></td>
</tr>
<tr>
<td>UtcTime</td>
<td>LTIME</td>
<td></td>
</tr>
<tr>
<td>String</td>
<td>STRING</td>
<td></td>
</tr>
</tbody>
</table>

| Special types (examples: NodeId, Bytestring) | Not currently supported | The special data types are ignored when generating the IEC mappings. Members are not generated. |

| Inheritance | Inheritance is allowed for all OPC UA types. For example, new types can also be derived from String and Int32. |

### Table 617: Object types

<table>
<thead>
<tr>
<th>OPC UA</th>
<th>IEC</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPC UA object types</td>
<td>Function blocks</td>
<td></td>
</tr>
<tr>
<td>Interfaces and add-ins</td>
<td>Function block. The members of the interface are members of the function block. Example:</td>
<td></td>
</tr>
</tbody>
</table>

**Mapping of object types**

All declarations are declared altogether as local variables between VAR and END_VAR. The user can change the declarations as needed in VAR_INPUT and VAR_OUTPUT.
**OPC UA** | **IEC** | **Description**
--- | --- | ---
Inheritance | Instead of generating multiple function blocks with "Extends", a flat hierarchy is generated. Example: ![OPC UA Typespace](image)

| **Folder** | A separate type for each instance of a folder in an OPC UA object type. The user may add the instances on his own by editing the declaration of the IEC POUs. However, function blocks have to be used which originate from an OPC UA companion. All instances of function blocks below the folder are exported. Semantic checks based on NodeSet2.xml are not possible. | Initially, a folder is set as an object type in OPC UA. However, it is not enough to generate a folder type. The user is responsible for adding appropriate elements to the folder. ![Folder Typespace](image)

---

**Table 618: Structured data types**

<table>
<thead>
<tr>
<th>OPC UA</th>
<th>IEC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Structure</td>
<td>DUT</td>
</tr>
<tr>
<td>Union</td>
<td>Not currently supported</td>
</tr>
<tr>
<td>Optional member</td>
<td>Not currently supported</td>
</tr>
<tr>
<td>Inheritance</td>
<td>Implementation as for the object types</td>
</tr>
</tbody>
</table>

**Mapping of structured data types**

**Table 619: OPC UA reference types**

<table>
<thead>
<tr>
<th>OPC UA</th>
<th>Meaning in OPC UA</th>
<th>Mapping in IEC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organizes</td>
<td></td>
<td>Normally only the derivations of this type are relevant. The exception is when folders are mapped directly to IEC. See Chapter 6.4.3.3 “Mapping of OPC UA Types to IEC Types” on page 2848</td>
</tr>
<tr>
<td>HasSubtype</td>
<td></td>
<td>See Chapter 6.4.3.3 “Mapping of OPC UA Types to IEC Types” on page 2848</td>
</tr>
<tr>
<td>OPC UA</td>
<td>Meaning in OPC UA</td>
<td>Mapping in IEC</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>HasTypeDefinition</td>
<td>• Used to collect all elements of a type when the UA types are compiled according to IEC.</td>
<td>• Declarations of instances in IEC are then referenced again by the OPC UA Server with this reference to the type in the information model.</td>
</tr>
<tr>
<td></td>
<td>• Declarations of instances in IEC are then referenced again by the OPC UA Server with this reference to the type in the information model.</td>
<td>• HasTypeDefinition for OPC UA variables is currently supported only for the special case when the variable type has the same members as the data type. Then the single access to the individual variables of the DUT instance is allowed in IEC.</td>
</tr>
<tr>
<td>HasComponent</td>
<td>Variables and objects are mapped in IEC as variables. Therefore, each HasComponent reference becomes an variable declaration in IEC. Methods also become methods of the function block in IEC. The user has to apply the modelling rules in the information model editor before the IEC POUs are generated. Optional members can be selected or deselected and concrete members can be generated for placeholders.</td>
<td></td>
</tr>
<tr>
<td>HasProperty</td>
<td>In OPC UA, properties have the character of additional meta-information for process data. They can be of static nature, for example engineering units. But they can also change when the server is running.</td>
<td>In IEC, this reference is handled exactly like HasComponent. As a result, variables are also created for this at the function block. An unresolved issue is the handling of properties at variables in UA (by means of the detour of HasTypeDefinition and VariableType). In IEC, the variable of type INT would have to be structured once again and have children. Currently, properties at variables in OPC UA are ignored and cannot be reached from IEC.</td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.3.2 “Using OPC UA Information Models” on page 2846
- Chapter 6.4.1.21.2.17 “Object 'OPC UA Information Model'” on page 2472
6.4.4 Libraries

6.4.4.1 General

Libraries are used for preparing POU's and functions for use in CODESYS applications. In addition to the descriptions presented here in the help, always see the documentation included in the library as well.

For using libraries in your CODESYS project, see the "Managing Libraries" chapter.

To create your own CODESYS libraries, follow the guidelines for library developers.

☞ Chapter 6.4.1.17 “Using Libraries” on page 2034

6.4.4.2 Guidelines for creating libraries

Libraries must be created according to specific rules to avoid compatibility issues.

The main items include the following:

- Select a meaningful library name (required)
- Use templates to ensure consistency (optional)
- Use a familiar and uniform project structure, when possible (optional)
- Register a unique library namespace (required)
- Enter all project information (required)
- Apply the correct method for referencing other libraries correctly (required)
- Design smart external and internal interfaces (required)
- Implement a user-friendly error handling (required)
- Apply the correct method (protection) for deployment (required)
- Apply a consistent naming convention to get clean code (optional)
- When revising an existing library, consider the interface compatibility with previous versions.

Please follow these guidelines when developing libraries in CODESYS: "Library Development Summary". You will find this document as a CHM file (LibDevSummary.chm) in the installation directory of CODESYS, or in the online help.

See also

☞ Chapter 6.4.1.17 “Using Libraries” on page 2034

6.4.5 CODESYS Visualization

6.4.5.1 Introduction

Everything in one project

In the same CODESYS project, you use CODESYS Visualization to create the suitable user interface for your application. You link the visualization to the application variables and in this way they can animate and display data. When creating a visualization and an application, you use common functions, for example, as library and source code management or find/replace throughout the project.

Overview of functionality

- Display variant depending on the target platform
  You can execute the same visualization on various target platforms. Possible display variants are CODESYS WebVisu, CODESYS TargetVisu. In addition, there is a display integrated in the development system.

- Visualization editor
  In the graphic editor you design the desired user interface from visualization elements. The visualization elements are provided via libraries in a "ToolBox". You drag them into the editor area and adapt them with the help of a property configurator.
- **Referenceable visualizations**
  A visualization can be referenced in other visualizations. This enables the creation of user interfaces with a complex structure. For this purpose CODESYS Visualization also provides predefined visualizations, e.g. for dialogs.

- **Simple design change**
  The simple change of the look & feel of a visualization is possible in one place by creating a different visualization style.

- **Multilingualism**
  You can conveniently prepare visualization texts in several languages with the help of text lists. You can configure a user input element for switching to a different language in online mode.

- **User management**
  You can set up the visualization's own user management for access control up to individual element level.

- **Other useful features**
  Function block instances of visualizations, array accesses to the visualization, real-time data logging, extendability of the pool of visualization elements, provision of graphic objects via symbol libraries, calls of PLC functions from the visualization, reusability of visualizations by depositing them in libraries.

---

**Table 620: Overview of the objects, editors, repositories, etc. relevant for the visualization in the CODESYS Development System**

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visualization</td>
<td>Object below an application in the device tree or in the POUs pool that contains a visualization image. A visualization can reference other visualizations.</td>
</tr>
<tr>
<td>Visualization editor and addi-</td>
<td>In this IEC 61131-3-compliant editor you can create the desired graphical user interfaces, panels, dialogs, etc. from visualization elements. The editor is made up of the following components:</td>
</tr>
</tbody>
</table>
|    tional views              |   - Graphic editor area for arranging the elements  
|                              |     - "Interface Editor": for the parameterization of the visualization  
|                              |     - "Hotkey Configuration": editor for defining keys for online operation  
|                              |     - "Elementlist": overview of all visualization elements used, editor for the position of the elements on the z-axis  
|                              | The following views are also available:  
|                              |     - "ToolBox": view for the provision of visualization elements  
|                              |     - "Properties": view with editor for the configuration of the element that currently has the focus in the graphic editor  
| Visualization element        | Ready-to-use elements from the visualization libraries are available in the Tools view of the visualization editor for insertion.                   |
| Visualization profile        | The profile defines which visualization elements are available. Each project that contains a visualization is based on such a profile (project settings). |
| Visualization Styles         | The selected style determines the "look & feel" of the elements. It is set application-wide in the visualization manager. Ready-to-use styles are provided and you can also create your own. |
Visualization Manager

Each application has a visualization manager of its own for its visualizations with various settings such as user management, style, language, input type, etc. The “Visualization Manager” object is suspended in the device tree below the application.

Display variant

A visualization can be displayed in online mode in the following variants, which are created as objects under the visualization manager:
- CODESYS TargetVisu (target visualization and remote target visualization on PLC devices)
- CODESYS WebVisu (web visualization via a web browser)
- Visualization integrated in the development system

Visualization library

Collection of visualization elements that are provided in the toolbox.

Symbol library

Collection of images and graphics that you can use in visualizations. When inserting a visualization object you can choose whether the installed system libraries should be available in the project.

Visualization Element Repository

Repository for the management of the visualization profiles and the visualization element libraries.

Visualization Styles Repository

Repository for the management of visualization styles.

VISU_TASK

This task is automatically present as an object in the task configuration of an application as long as an object for a display variant of the type WebVisu or TargetVisu is also inserted under the Visualization Manager.

The user interfaces created in CODESYS can be used in different display variants, depending on which ones the controller employed supports.

The display variants

- **Visualization (“diagnostic visualization”) integrated in the CODESYS Development System:**
  The integrated visualization in the development system is ideal for application tests, service or diagnostic purposes and for the commissioning of a system. As soon as a connection to the controller has been established, the visualization editor switches over and animates the elements displayed. This variant is part of the free CODESYS Development System and can always be used, irrespective of the controller employed.

- **CODESYS WebVisu:**
  This variant means web-based display of the user interface in a standard browser (PCs, tablets, smartphones), enabling remote access, remote monitoring and service and diagnosis of a system via the Internet. A standard web browser communicates by JavaScript (optionally with SSL encryption) with the web server in the controller and displays the visualization by means of HTML5. This technology is supported by virtually all browsers and is thus also available on terminal devices with iOS or Android.

- **CODESYS TargetVisu:**
  This variant runs independent of the platform on control systems with an integrated display. Logic application and user interface run on the same device; the user interface is displayed directly on the controller. This variant is suitable for the operation and monitoring of machines and plants. An optional extension of the runtime system is required for the use of CODESYS TargetVisu.
6.4.5.2 Tutorial

6.4.5.2.1 CODESYS visualization - Getting started

If you are not yet familiar with CODESYS visualization, we recommend you to start with the application example First steps with CODESYS visualization. The example demonstrates the main features of visualization and provides insights into possible use cases.

To use the Edge browser for CODESYS visualization of AC500 PLCs, follow the steps described in the application note Usage in the Edge browser.

Visualization basics

More examples and step by step instructions are available in the Automation Builder.

- Chapter 3.4.10 “Setting up a visualization” on page 53
- Chapter 3.4.11 “Creation of a visualization” on page 57
- Chapter 3.4.12 “Enabling a web visualization” on page 65

6.4.5.2.2 Show instance names

For complex visualizations, it can be helpful if the instance names are displayed within the visualization. How to show instance names is described in the application example Visualization - Instance names.

6.4.5.2.3 Visualizing a Refrigerator Controller

This tutorial demonstrates how to add visualizations to the project and link the elements of the visualization to the variables of the control program.

Preparation

This tutorial is based on the sample program RefrigeratorControl, which was created in the "Your First Program in CODESYS" chapter. The finished program can also be found in the installation directory of CODESYS, in the "Projects" subfolder.

See also
- Your First CODESYS Program

Creating the visualizations

The visualization consists of the following three visualization screens:

- **Visualization**: Control elements and display of the refrigerator
- **Diagnosis**: History of the set and actual temperature, parameter settings
- **Live Visu**: Animation with refrigerator

1. Select the “Application” object in the device tree.
2. Click “Project ➔ Add Object ➔ Visualization”.
3. Specify Live_Visu as the name.
4. Create two more visualizations with the names Diagnosis and Visualization.

Structure of the visualization

This screen consists of control and display elements that control the refrigerator.
1. Open the visualization `Visualization` in the editor.
2. Drag a “Rectangle” visualization element to the editor. Change the following properties:
   - “Texts” ➔ Text: Actual temperature: %2.1f °C
   - “Text variables” ➔ Text variable: `Glob_Var.rTempActual`
3. Drag a “Meter 180°” visualization element to the editor. Change the following properties:
   - “Value”: `Glob_Var.rTempActual`
   - “Scale ➔ Scale end”: 20
   - “Scale ➔ Main scale”: 5
   - “Scale ➔ Subscale”: 1
4. Drag a “Rectangle” visualization element to the editor. Change the following properties:
   - “Texts” ➔ Text: Temperature presetting: %.1f °C
   - “Text variables” ➔ Text variable: `Glob_Var.rTempSet`
5. Drag a “Potentiometer” visualization element to the editor.
   Change the following properties
   - “Variable”: Glob_Var.rTempSet
   - “Background ➔ Background color”: “yellow”
   - “Pointer ➔ Color”: “red”
   - “Scale ➔ Subscale position”: “Outward”
   - “Scale ➔ Scale start”: 3
   - “Scale ➔ Scale end”: 13
   - “Scale ➔ Subscale”: 1
   - “Scale ➔ Main scale”: 1
   - “Label ➔ Unit”: “°C”
   - “Label ➔ Scale format (C syntax)”: %.0f
   - “Label ➔ Max. text width of labels”: 21
   - “Label ➔ Height of labels”: 15

6. Drag a “Label” visualization element to the editor.
   Change the following properties
   - “Texts ➔ Text”: Cooling compressor

7. Drag a “Lamp” visualization element to the editor. Position it behind the text Cooling compressor.
   Change the following properties
   - “Variable”: Glob_Var.bCompressor

8. Drag a “Label” visualization element to the editor.
   Change the following properties
   - “Texts ➔ Text”: Signal (beep)

9. Drag a “Lamp” visualization element to the editor. Position it behind the text “Signal (beep)”.
   Change the following properties
   - “Variable”: Glob_Var.bSignal
   - “Background ➔ Image”: Red

10. Drag a “Rectangle” visualization element to the editor.
    Change the following properties
    - “Texts ➔ Text”: Door open

11. Drag a “Rocker Switch” visualization element to the editor.
    Change the following properties
    - “Variable”: Glob_Var.rDoorOpen

Structure of the visualization
Diagnosis

In this screen, you can monitor the temperature curve and optimize the parameters.
1. Open the visualization Diagnosis in the editor.
2. Drag a “Label” visualization element to the editor.
   Change the following properties
   - “Text” : Refrigerator Diagnosis & Service Menu
   - “Text properties” : Arial, Standard, 18
3. Drag a “Trace” visualization element to the editor.
4. Click the Diagnosis_Trace1 value of the “Trace” property.
   The “Trace Configuration” dialog opens.
5. Select the “MainTask” in “Task”.
6. Click the “Add Variable” link.
   A variable is added to the trace. The variable settings are displayed in the dialog.
7. Select Glob_Var.bCompressor for the variable.
8. Add the Glob_Var.rTempSet and Glob_Var.rTempActual variables to the trace. For the other settings, you can use the default values.
9. Click “OK” to exit the dialog.
10. Drag a “Rectangle” visualization element to the editor. Position it on the right next to the trace element.
    Change the following properties
    - “Text” : %s
    - “Text variables” : PLC_PRG.rHysteresis
11. Configure the “OnMouseDown” input configuration of the element. Click “Input configuration ➔ OnMouseDown ➔ Configure”.
    The “Input Configuration” dialog opens.
12. Assign the “Write Variable” command to the action. Accept the default values and click “OK”.
13. Drag a “Label” visualization element to the editor. Position it over the first rectangle.
    Change the following properties
    - “Text” : Hysteresis Regulator
14. Adjust the size and position of both elements.
15. Select both of the “Rectangle” and “Label” elements and duplicate them by means of copy and paste.
16. Adjust the labels and variables of the copied elements.
   - “Text”: Compressor Efficiency, “Text variable”: Simulation.P_Cooling
   - “Text”: Time until Beep for DoorOpen, “Text variable”: Glob_Var.timDoorOpenThreshold
   - “Text”: Time until Beep for Compressor On, “Text variable”: Glob_Var.timAlarmThreshold

See also
- Chapter 6.4.5.21.3.6 “Dialog ‘Input Configuration’” on page 3370

Structure of the visualization ‘Live Visu’

This screen includes the representation of a refrigerator. The refrigerator consists of several polygon type visualization elements. The doors of the refrigerator are drawn in both the closed and open states. Both doors consist of a group of single elements.

1. Open the Live_Visu visualization in the editor.
2. Select the “Polygon” visualization element in the “Visualization Toolbox” view.
3. Click several times in the editor to create a surface. Right-click to stop adding corner marks.

4. Move the corner marks to the required position so that the element (1) is formed.

5. Select the element.

   Change the following properties:
   - “Colors ➔ Use gradient color”:
   - “Appearance ➔ Line style”. “Invisible”

6. Click the “Colors ➔ Use gradient color” property.

7. Select the color “Gray” for “Color 1” in the “Gradient Editor” dialog.

8. Create all other elements with the “Polygon” visualization element.

9. Group the elements of the closed doors (2+3+4) and the open doors (5+6+7+8). To do this, press the [Shift] key and click “Visualization ➔ Group” to select the elements.

10. Move the elements together so that the completed refrigerator is formed. Position the open doors precisely on the closed doors.

11. Select the “Open doors” group.

12. In the properties, double-click the input field “State variable ➔ Invisible”.


14. Select the rDoorOpen variable in the “Variables” category (below “Application ➔ Glob_Var”).

15. Negate the variable with NOT (→ NOT Glob_Var.rDoorOpen).

   ➔ If the rDoorOpen variable is FALSE (door is closed), then the element is invisible. Then the underlying doors are visible.

16. Copy the following elements from the Visualization screen:
   - Potentiometer for setting the temperature
   - Rectangle for displaying the set temperature
   - Door open switch
   - Cooling compressor lamp
   - Signal (beep) lamp

17. Insert the elements from the clipboard to the Live_Visu visualization screen.
18. Reduce the elements and position them on the refrigerator.

**Visualization in online mode (simulation)**

When the visualization is complete, test it in simulation mode.

1. Click “Online ➔ Simulation”.
2. Click “Online ➔ Login”.
   - A dialog opens and prompts you to create and download the application.
3. Click “Yes” to confirm the dialog.
4. Click “Debug ➔ Start”.
5. Open the visualization Live_Visu in the editor.
   - The refrigerator is in online mode.
6. Open the doors with the switch and monitor the temperature and the alarms. Change the parameters in the screen Diagnosis and watch the reaction in the temperature curve.
6.4.5.2.4 Displaying Array Data in a Histogram

Setting element properties for the histogram

Requirements

- A project contains a visualization object and a program.
- A one-dimensional array is declared in the program (example: `histogram : ARRAY[1..10] OF INT;`).
- In the program, `histogram` data is assigned to the array (example: within the range from 0 to 50).

1. Double-click the “Visualization” object in the device tree.
2. In the “Visualization Toolbox” view, click “Measurement Controls” and drag the “Histogram” element to the visualization editor.
3. In the visualization editor, click the inserted “Histogram”. The “Properties” view opens.
4. In the “Properties” view, double-click the “Value” input field in the “Data array” element property. Then click.
5. In the “Input Assistant” dialog in the “Variables” category of the “PLC (PRG)” program, select the array (example here: `histogram : ARRAY[1..10] OF INT;`) and click “OK”.
6. To display only part of the array as a histogram, activate the “Use subrange” option and specify the index values of the array in “Start index” and “End index” to define the subrange.
7. Select the “Display type” (example: “Bar”).
8. Specify a value between 1 and 100 (example: 30) for the “Relative bar width”.
9. Click the histogram in the visualization editor and change the size and position as desired. The “Position” property changes its values accordingly.
10. Specify the values for the “Scale” element property. Select the values for “Scale start” and “Scale end” so that the array is displayed completely. For the example: “Scale start” 0, “Scale end” 50.
    For the distance between values on the main scale, specify the value 10, for example, in “Main scale”.
11. In the “Label” element property, specify the “Unit” for the display values.
12. Click “Build ➔ Generate Code”.

Configuration and programming
Programming with CODESYS > CODESYS Visualization

2024/01/05  ADR010583, 1, en_US
13. If the project has been compiled without errors, then click “Online ➔ Login” and click “Debug ➔ Start” to start the application.

- The histogram is displayed in the visualization as follows:

```
<table>
<thead>
<tr>
<th>Value</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>5</td>
</tr>
<tr>
<td>10</td>
<td>4</td>
</tr>
<tr>
<td>20</td>
<td>3</td>
</tr>
<tr>
<td>30</td>
<td>2</td>
</tr>
<tr>
<td>40</td>
<td>1</td>
</tr>
</tbody>
</table>
```

Defining alarm colors for the histogram

- The visualization displays a histogram with bars all the same color (example: green). Now you want the bars with values less than 30, for example, to be displayed in another color (example: red).

1. Click the element property “Colors ➔ Alarm color”.
2. Specify the limiting value in “Alarm value” above or below which the bars should be displayed in another color.
3. Select “More” from the list box in “Alarm condition” if all values greater than the “Alarm value” should be displayed in another color. Otherwise, select “Less”.
4. Select an “Alarm color” (example: “Red”).
5. Click “Build ➔ Generate Code”.

Defining alarm colors for the histogram
6. If the project has been compiled without errors, then click “Online ➔ Login” and click “Debug ➔ Start” to start the application.

In the example histogram, all bars with values greater than 30 are displayed in red.

See also

- Chapter 6.4.5.20.1.29 “Visualization Element 'Histogram’” on page 3216

### 6.4.5.2.5 Displaying Array Variables in Tables

A frequently required function of a user interface is the display of data arrays. CODESYS Visualization provides the element “Table” for this.

In the configuration of the element “Table”, enter an array variable in the property “Data array”. The array components are displayed in the rows and columns of the table.

Subsequent instructions describe an example of how an array of a structure is displayed in a table. As a preparation, create the MYSTRUCT DUT and the declarations in the PLC_PRG program.

```plaintext
TYPE MYSTRUCT :
  STRUCT
    iNo : INT;
    bOnStock : BOOL;
    strPartNumber : STRING;
  END_STRUCT
END_TYPE

PROGRAM PLC_PRG
VAR
  arrStruct : ARRAY[0..6] OF MYSTRUCT;
  iSelectedColumn : INT;
END_VAR
```
1. Drag the “Table” visualization element to the visualization editor.

2. Assign the array variable `arrStruct` to the “Data array” property.
   ⇨ The structure members are displayed as column headings and the array index as row headings.

3. Change the “Columns ➔ Column ➔ [0] ➔ Column header” property to an informative heading (example: Number).


5. Assign a color to the “Selection ➔ Selection color” property.

6. Define the “Selection ➔ Selection type” property as Row selection.

7. In the “Selection ➔ Variable for selected row” property, define the `PLC_PRG.iSelectedColumn` variable.
   ⇨ The following display results in online mode:

<table>
<thead>
<tr>
<th>Number</th>
<th>in Stock</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>FALSE</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>FALSE</td>
</tr>
<tr>
<td>2</td>
<td>0</td>
<td>FALSE</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>FALSE</td>
</tr>
</tbody>
</table>

See also
- ☑ Chapter 6.4.5.20.1.13 “Visualization Element ‘Table’” on page 3106

### 6.4.5.2.6 Displaying Web Contents

Displaying websites in a visualization

☑️ Requirement: A visualization open in a CODESYS project. The “Visualization Toolbox” and “Properties” views of the visualization are also open.

1. Drag the “Web Browser” element from “Special Controls” to the visualization editor.

2. Select the element in the editor.
   ⇨ In the “Properties” view, the element properties are listed for the “Web Browser” element.

3. In the “Position” property, specify the size (in pixels) for the “Width” and the “Height” (example: 600).

4. In “Control variables ➔ URL”, specify the URL for the website (example: 'http://de.wikipedia.org'). You can also specify a variable here (STRING or WSTRING) where the URL is assigned in the project.

5. In “Control variables ➔ Display”, specify a Boolean variable (example: `bSetURL`).
   ⇨ If the variable `bSetURL` has the value TRUE, then the website 'http://en.wikipedia.org' is displayed at runtime.
Configuring the buttons for forward and back navigation of the website

☑ Requirement: The “Web Browser” element of your visualization is configured as described above.

1. In a POU, declare both Boolean variables bGoBack and bGoForward.
2. In the visualization editor, click the “Web browser”.
3. For the property “Control variables ➤ Back”, select the variable bGoBack from the Input Assistant. For the property “Control variables ➤ Forward”, select the variable bGoForward.
4. In “General Controls”, add the “Button” element to your visualization two times.
5. Click a “Button” in the visualization editor and drag the “Button” to the required position (for example above the “Web Browser” element).
6. In the property “Texts ➤ Text”, specify the character >. In “Text properties ➤ Font”, select a font from the Input Assistant (example: Arial, Bold, 14).
7. Configure the property “Input configuration ➤ OnMouseClick” so that the variable bGoForward switches.
8. Configure the second button for back navigation in the same way as described in Steps 5 to 7.

⇒ If the variable bSetURL has the value TRUE, then the website 'http://de.wikipedia.org' is displayed with the forward and back buttons. When you click the buttons, navigation to the previous and next websites is successful.

Chapter 6.4.5.20.1.38 “Visualization Element ‘Web Browser’” on page 3262
⇒ “Input action ‘Toggle Variable’” on page 3379

6.4.5.2.7 Using Client Animation

The example shows a visualization with 3 screens. A menu controls the navigation of the screens. The menu is hidden until it moves into view by means of a hamburger button. During the movement, the transparency of the menu is changed. After the screen is selected, the menu moves back out of view. The animation is computed entirely on the target system. The CODESYS visualization only defines the target values (positions, transparency).

1. Preparation

1. Create a new standard project with the CODESYS Control Win V3 controller.
2. Add a “Visualization” object below the “Application”. Choose the name Visu_Main.
3. Open the Visualization Manager in the editor and select the “Support client animations and overlay of native elements” option.

2. Creating the PLC_PRG program

The program checks whether the menu button has been pressed. If the menu bar is not visible (position –300), then the position is moved to the visible area (0). If the menu bar is already visible (position 0), then the position is moved to the hidden area.
1. Open the “PLC_PRG” program in the editor.
2. Input the following code into the declaration editor:

```plaintext
PROGRAM PLC_PRG
VAR
  iSelection : INT;                  // to switch the
  xVisible: BOOL;                    // auxiliary variable to
toggle the menu bar
  iMenuPos : INT := -300;            // position of the menu bar
  xToggle: BOOL;                     // button variable to
toggle the menu bar
END_VAR

3. Input the following code into the implementation:

```plaintext
IF xToggle THEN
  xToggle := FALSE;
IF xVisible THEN
  xVisible := FALSE;
  iMenuPos := -300;
ELSE
  xVisible := TRUE;
  iMenuPos := 0;
END_IF
```

3. Creating the menu bar

The menu bar has 3 menu items. A visualization screen is displayed by clicking the corresponding menu item.

1. Insert a “Visu_Menu” visualization below the application.
2. Open the object properties. In the “Visualization” tab, set the “Visualization size” to a “Width” of 300 and a “Height” of 180.
3. Open the visualization in the editor.
4. Select the “Advanced” option in the “Properties” view.
5. In the upper left corner, add a button with a “Width” of 300 and a “Height” of 60.
6. Label the button as “Visu 1”. Set the font size to 24.
7. Open the “Input configuration ➔ OnMouseClick” property.
8. Select the “Execute ST code” action.
9. Input the following ST code:

```plaintext
PLC_PRG.iSelection := 0;
PLC_PRG.xToggle := TRUE;
```
10. Set the “Button state variable ➔ Digital variable” property to PLC_PRG.iSelection=0
11. Add two more buttons named “Visu 2” and “Visu 3”.
12. Edit the button properties of "Visu2" (PLC_PRG.iSelection = 1) and "Visu3" (PLC_PRG.iSelection = 2).

Result:

4. Creating more visualization screens

1. Insert the "Visu1" visualization below the application.
2. Open the object properties. In the "Visualization" tab, set the "Visualization size" to a "Width" of 800 and a "Height" of 600.
3. Change the background color of the screen (for example, light gray).
4. Insert a "Label" object into the visualization screen and name the element (example: "Visu 1").
5. Insert two more visualizations "Visu2" and "Visu3" below the application. Edit the properties in the same way as for "Visu1".

5. Creating the main visualization screen

On this screen, you can see the menu bar and a button to show or hide the menu bar. The different visualization screens are navigated in a "Frame" visualization element.

1. Open the properties of the "Visu_Main" visualization. In the "Visualization" tab, set the "Visualization size" to a "Width" of 800 and a "Height" of 600.
2. Open the visualization in the editor.
3. Insert a "Frame" element into the visualization.
   ⇒ The "Frame Configuration" dialog opens.
4. Add the "Visu1" (Index 0), "Visu2" (Index 1), and "Visu3" (Index 2) visualizations.
5. Set the property values of "Position" as follows: "X" = 0, "Y" = 0, "Width" = 800, and "Height" = 600.
6. Set the property value of "Switch frame variable ⇒ Variable" to PLC_PRG.iSelection.
7. Insert a "Button" element into the visualization.
8. Set the property values of "Position" as follows: "X" = 0, "Y" = 0, "Width" = 800, and "Height" = 600.
9. Set the property value of "Texts ⇒ Text" to =.
10. Set the property value of "Text properties ⇒ Font" to Arial; 36.
11. Open the "Input configuration ⇒ OnMouseClick" property.
12. Select the “Execute ST code” action.
13. Input the following ST code:
   ```
   PLC_PRG.xToggle := TRUE;
   ```
14. Set the property value of “Button state variable ➔ Digital variable” to PLC_PRG.xVisible.
15. Insert the “Visu_Menu” visualization element from the “Current Project” category into the visualization.
16. Set the property values of “Position” as follows: “X” = 0, “Y” = 0, “Width” = 300, and “Height” = 180.
17. Set the property value “Absolute movement ➔ Movement ➔ X” to PLC_PRG.iMenuPos.
18. Set the property value of “State variables ➔ Invisible” to not(PLC_PRG.xVisible).
19. Set the property value of “Animation duration” to 2000.

⇒ Result:

![Visualization screenshot]

See also

- Chapter 6.4.5.20.1.6 “Visualization Element ‘Frame’” on page 3053

### 6. Downloading the project to the controller and starting the WebVisu

1. Build the project and download it to the PLC.
2. Start the project.
3. In the browser, connect to the visualization (http://localhost:8080).
   ⇒ The WebVisu connects to the controller and the visualization opens.
4. In the visualization, click the menu button.
   ⇒ The menu moves into view.
5. Select a menu item.
   ⇒ The visualization screen is selected and the menu moves back out of view.

### 6.4.5.3 Preparing CODESYS and projects

The following provides details of the presets that exist for visualizations and the steps that are necessary for creating a visualization in a project.

#### Presets

When you create a visualization in a project, you should know that the following presets apply:

<table>
<thead>
<tr>
<th>Scope</th>
<th>Location</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Throughout CODESYS</td>
<td>“Tools → Options” Categories “Visualization” and “Visualization styles”</td>
<td>● Visualization editor: display, handlingternal text and image files</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Paths of the basic text and image files</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Visualization styles</td>
</tr>
<tr>
<td>Throughout the project</td>
<td>“Project → Project settings” Categories “Visualization” and “Visualization profiles”</td>
<td>● “Properties handling” for the visualization elements</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Paths of the basic text and image files</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Symbol libraries with ready content</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Visualization profile</td>
</tr>
<tr>
<td>Throughout the application</td>
<td>“Visualization Manager”:</td>
<td>● Unicode, CurrentVisu variable, multitouch, semi-transparency, memory size, data transmission, number of clients</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Visualization styles</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Language setting, language-specific font</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Default keyboard configuration</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Visualizations and visualization references</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Font for each language</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● User management</td>
</tr>
<tr>
<td>Single visualization</td>
<td>“Properties” of the visualization object Category “Visualization”</td>
<td>● Purpose and scope of use</td>
</tr>
<tr>
<td>Display variant of a single visualization</td>
<td>Editor of the WebVisu or TargetVisu object</td>
<td>● Size definition</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Start visualization, refresh rate, buffer size, html file name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Scaling options</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Display options</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Default text input</td>
</tr>
</tbody>
</table>

Project-specific updates of the visualization profile, the visualization styles, and the visualization symbol libraries are possible in “Project → Project environment” of the respective tabs.

Customization of the visualization menu is performed in “Tools → Customize”.

See also
- © Chapter 6.4.5.21.3.9 “Dialog Box ‘Options’ - ‘Visualization’” on page 3384
- © Chapter 6.4.5.21.3.7 “Dialog ‘Options’ - ‘Visualization Styles’” on page 3382
- © Chapter 6.4.5.21.3.13 “Dialog ‘Project Settings’ - ‘Visualization’” on page 3387
- © Chapter 6.4.5.21.3.14 “Dialog ‘Project Settings’ - ‘Visualization Profile’” on page 3388
- © Chapter 6.4.5.21.3.10 “Dialog ‘Project Environment’ - ‘Visualization Profile’” on page 3385
- © Chapter 6.4.5.21.3.11 “Dialog ‘Project Environment’ - ‘Visualization Styles’” on page 3386
For each visualization, you insert a "Visualization" object into your project like any other object. This also applies to visualizations that should be used later only within other visualizations. You can insert the new visualization object directly below an application, or below the root node of the "Devices" view (for availability throughout the entire project).

The required base libraries and other objects, such as the Visualization Manager, are inserted automatically. When you insert the visualization object below an application, the subordinate objects for the display variants supported by the device are also displayed.

Every visualization object can be edited separately in the visualization editor.

The following steps describe a simply example for creating an object for an application-specific visualization.

Requirement: A project is open. An application is created in the device tree.

1. Select the application in the device tree. Click "Add object ➔ Visualization" in the context menu.
   - The "Add visualization" dialog box opens. In the "Symbol libraries" table, there is at least the standard entry "VisuSymbols Vx.x.x. (System)", and possibly other installed symbol libraries.

2. Accept the default name Visualization. Activate the "VisuSymbols" option. Then the visualization symbols (graphical objects) are contained in the library in the visualization project. Click "Add" to close the dialog box.
   - In the device tree, the "Visualization manager" and "Visualization" objects are inserted below the application. Depending on the device in use, the "TargetVisu" and/or "WebVisu" objects are also created below the visualization manager.
     
If a "TargetVisu" object or "WebVisu" object is created, then a "VISU_TASK" object is also created below the task configuration with an implicit program call.

The required visualization libraries are added automatically in the "Library Manager" of the application.

The visualization editor opens with the "Visualization" editor window and the "ToolBox" and "Properties" views.

   - In the "ToolBox" view, there is a "Symbols" button for viewing the symbols from the library VisuSymbols.library.

3. Now you can create the required visualization in the visualization editor.

4. Note: You can create structured visualizations by using a frame element to reference one visualization in another visualization. Dialog visualizations are a special option for this. In this case, the input configuration of a visualization element is used for referencing.

For creating an application-dependent visualization, insert the visualization object directly below the root node of the device tree. This corresponds to insertion in the "POUs" view. In this case, the visualization manager is not created with objects for the display variants.

- Chapter 6.4.5.21.3.7 “Dialog ‘Options’ - ‘Visualization Styles’” on page 3382
- Chapter 6.4.5.21.3.13 “Dialog ‘Project Settings’ - ‘Visualization’” on page 3387
- Chapter 6.4.5.21.3.15 “Dialog ‘Properties’ of Visualization Objects” on page 3388
6.4.5.4 Limitation of the number of usable web pages on AC500 V3 PLCs

Automation Builder will get all the available visualizations in the project and count those reachable from the visualization client objects (WebVisu and RemoteTargetVisualization).

In case the predefined number of visualizations is exceeded an error is shown in the message window, preventing the user from compiling the project.

The error will be shown under “Build” category when the user executes the build command. The PLC program won’t download to the PLC until this error is solved (like with any other build errors). In the image below, there are 5 visualizations being used (3 of them added directly into the Automation Builder project and the other 2 referenced from a library that was added to the project).

The error will look like this when build command is executed:

If the visualizations are in the project but not being referenced (e.g. not reachable from the “Start Visualization” in the WebVisu) they are not taken into account for this limitation. If the error condition is solved, the error will disappear when the user executes the build command again.

6.4.5.5 Designing a visualization with elements

6.4.5.5.1 General

The visualization editor provides the visualization elements for designing a user interface in the “Visualization Toolbox” view.
Drag the desired element into the editor view and adapt it in the “Properties” view: purely visual design, labeling, display of data, reaction to user inputs, possibility to input values, etc.

Static or dynamic configuration of the properties is possible. This means the assignment of fixed values or the assignment of application variables. A dynamic configuration allows for an animation which is executed at runtime.

See also
- Chapter 6.4.5.21.1.1 “Visualization Editor” on page 3393
- Chapter 6.4.5.10 “Animating visualization elements” on page 2912

6.4.5.5.2 Select Element

The “Visualization Toolbox” view provides the following elements for selection:
- All visualization elements which the set visualization profile defines.
- Image elements for all images of the project from the integrated libraries or symbol libraries.
- Frame elements for all visualizations of the project or from the libraries.

See the “Project Settings” for the currently set visualization profile and the currently used symbol libraries.

The elements are combined into specific categories, each of which has its own button in the “Visualization Toolbox” view. You can create new categories and assign its elements.

The elements of the categories are displayed in the “Visualization Toolbox” view as preview images. It is also possible to search for an element name.

Simply drag the preview image of the element to the desired position in the editor window. Then the configurable properties of the element are displayed automatically in the “Properties” view of the visualization editor.

- Chapter 6.4.5.21.1.1 “Visualization Editor” on page 3393
- Chapter 6.4.5.21.1.2 “View ’Visualization Toolbox‘” on page 3394
- Chapter 6.4.5.20.1.5 “Visualization Element ’Image‘” on page 3038
- Chapter 6.4.5.20.1.6 “Visualization Element ’Frame‘” on page 3053

Create or remove new element category

Requirement: The visualization editor is open.

1. In the “Visualization Toolbox” view, click the button.
   - the “Configure Categories and Items” dialog opens.
2. In the dialog, click the + symbol to open the “Add Category” dialog. Note: Click the - symbol or press the [Del] key to delete the definition of a category.
3. In the “Name” field, specify a name (example: tagA) and click “OK” to close the dialog.
   - In the “Configure Categories and Items” dialog, the new custom category tagA is inserted below in the tree view. It is provided with the symbol.
4. Click the “Enable” option for the new category, and click “OK” to close the dialog.
   - CODESYS adds a “tagA” button in the “Visualization Toolbox” view. When you click the button, all elements that are assigned to this category are displayed.

- Chapter 6.4.5.21.3.4 “Dialog ’Configure Categories and Items‘” on page 3368
Assigning a visualization element of an element category

Requirement: The visualization editor is open. You have already created a custom category `tagA`. A button labeled `tagA` is visible in the "Visualization Toolbox" view.

1. In the "Visualization Toolbox" view, right-click an element to open its context menu.
   - A context menu opens. It contains the “Add Item to Category 'tagA'” and “Add to Categories” commands.
2. Click “Add to Category 'tagA'” and click "OK" to close the dialog.
3. Click the “tagA” button.
   - All elements are displayed which are assigned to this category, below it also the currently assigned element.

Chapter 6.4.5.21.4.1.2 “View 'Visualization Toolbox'” on page 3394

6.4.5.3 Positioning the Element, Adapting Size and Layer

A visualization is a raster image in pixels. The pixel position is specified in X/Y-coordinates. The origin (0,0) is located at the upper left corner of the window. The positive X-values run to the right, and the positive Y-values run downwards. The position of an element on the Z-axis of the visualization is controlled by the position in the element list (see below).

Configuring the size and position in the editor

The size and position of an element are specified as pixel coordinates in the "Properties" view. These settings are displayed graphically in the editor view at the same time.

When you drag a visualization element from the "Visualization Toolbox" view to the editor view, it is shown as selected, as in the following example of a rectangle element:

The possible positions depend on the set grid. You can change its settings CODESYS options. Commands in the context menu are available for alignment and grouping.

Now you can move or resize the element directly in the editor. As an alternative, you configure the “Position” property in the properties editor, which opens automatically for the selected element. See the description for this, for example in the help page for the “Button” element. The changes are also updated in the other editor.

Changing the element size and position in the editor

1. Focus the element so that the shape of the mouse pointer indicates movement (example: 

2. Drag the element to any position.
   - The position of the element is also updated in the properties “Position ➔ X” and “Position ➔ Y”.
3. Focus on a blue box.
   - The shape of the mouse pointer is a double arrow that indicates the direction you can drag the box in order to resize the box: 🔄.
4. Drag the blue box to resize the element.
   - The position of the element is also updated in the properties “Position ➔ X” and “Position ➔ Y”.

Moreover, you can rotate the “Rectangle”, “Line”, “Polygon”, and “Pie” elements.
1. Select the element for static rotation. Example: Rectangle
   - The rectangle is displayed with a handle next to the movable position boxes.

   (1) Handle

2. Drag the mouse pointer over the handle.
   - The cursor is displayed as a rotating arrow.

3. Rotate the element to any position.
   - In the property “Position → Angle”, the set angle is displayed in degrees.

ₐ Chapter 6.4.5.10.2 “Configuring rotations and offsets” on page 2912

Moving the visualization element forward and back

Each visualization element is in its own layer of the visualization (Z-axis). It can be hidden by other elements in the foreground and hide other elements in the background. The order of layers is visible on the “Element List” tab above the editor view. The order of elements from front to back specifies the order of visualization layers from back to front.

Use the commands from the “Order” context menu to move a selected element.

Example of an element list (1):
You configure the color of a visualization element either statically by means of the “Color” property, or dynamically by assigning an application variable by means of the “Color variables” property. Depending on the element, color assignments are also available in other properties. For example, for the font color, this is provided in the “Text” property of a labeled element.

For the static assignment of a color value, you can always use the color dialog in the properties editor, which provides color palettes to choose from.

You can specify the color as a style color. Style colors are color names for color definitions from the actively applied style. When configuring an corresponding property, you are provided with a list of available style colors. **We recommend that you use style colors** because then you can change colors centrally by means of a style selection or a style customization. You can also open the “Color” dialog to select a value from color palettes.

In addition, you can define the fill color of an element as a “Gradient”. Then the color changes linearly, radially, or axially from the initial color to the final color. You configure the “Gradient setting” in the “Gradient Editor” dialog.
Designing a visualization element with a style color or a fixed color value

**NOTICE!**
A color assignment with style color allows for easy global color changes.

1. **Requirement:** The visualization editor is open.
2. **Insert some** Rectangle elements.
3. **Select an element.**
   - The “Properties” view is active.
4. **Click in the** “Colors ➔ Normal state ➔ Fill color” property.
   - A list box and the button appear.
5. **Assign a style color** to the rectangle. For example, select “Elementfillcolor” from the list box.
6. **Define the degree of transparency** in the “Colors ➔ Normal state ➔ Fill color ➔ Transparency” property. Use the slider to select the value “136”.
7. **Select another rectangle.** Click in the “Colors ➔ Normal state ➔ Fill color” property.
   - A list box and the button appear.
8. **Assign a fixed color value** to the rectangle. Click to do this.
   - The “Color” dialog opens.
9. **Select a standard color or “Define Custom Colors”** to fine-tune your selection. Then click “OK”.
   - The color is set as a fixed value. The color is displayed as a small rectangle. The RGB values are also indicated next to it.
10. **Click in the** “Colors ➔ Normal state ➔ Fill color ➔ Transparency” property.
11. **Use the slider to select the value “136”.**
   - The color is semitransparent.

Designing a visualization element with a color gradient

1. **Requirement:** The visualization editor is open.
2. **Drag a** Rectangle element to the visualization.
3. **Select the** “Colors ➔ Use gradient color” property.
4. **Click in the** “Colors ➔ Gradient setting” property.
   - The “Gradient Editor” dialog opens.
4. Define the color gradient for the element:
   - “Gradient type”: “Radial”
   - “Standard radial”: “Center”
   - The fill color of the element changes radially from white to black.

   ![Color Gradient](image.png)

   Chapter 6.4.5.21.3.5 “Dialog ‘Gradient Editor’” on page 3369

Configuring a visualization element for color animation

The “Color variables” property, which certain elements may have, is used for the color animation of the element. If you assign a variable there, then you can program color changes in the application code or configure a user input that results in a color change.

You can see an example in the "Animating Visualization Elements" chapter.

   Chapter 6.4.5.10 “Animating visualization elements” on page 2912
   Chapter 6.4.5.21.4.2 “Object ‘Visualization manager’” on page 3398
   Chapter 6.4.5.19 “Applying Visualization Styles” on page 2979
   Chapter 6.4.5.10.4 “Animating a color display” on page 2914

6.4.5.5 Using texts

You can get displayed text in an element by assigning a string in the element property “Texts ➔ Text”. For example all base elements have this property. Also, you can get displayed a text as a tooltip (element property “Texts ➔ Tooltip”). Texts assigned in this way are static. They are managed in the object “GlobalTextList” in view “POUs” and they cannot be modified during runtime, neither programmatically nor via an user input.

However, you can extend a static text by (exactly) 1 placeholder containing a formatting specification, in order to output the content of a variable at this place. At runtime the current value of the variable, which you have assigned to the element via property “Textvariable”, will be output.

On the possible formatting specifications please see: Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329

By dynamic configuration you can animate the optical representation of the text.

You can localize the static texts, if you have set up multilingualism in your project.

See some examples for the text configuration of visualization elements in the following chapters.

   Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329
   Chapter 6.4.5.8 “Setting Up Multiple Languages” on page 2906

Labeling an image element with a static text

- Precondition: A project containing a visualization is opened. You have an image file representing a stop symbol.
  1. Below the Application object insert an object “Image Pool” named ImagePool_A.
  2. In the image pool ImagePool_A add your stop symbol image file with ID Stop.

   ![Image Pool](image.png)
   ![Stop Symbol](image.png)
3. Open the visualization and from the ToolBox draw an element “Image” into the editor.
   ⇒ The input assistant opens. In tab Category you see the image pool ImagePool_A.
4. Select the image Stop and close the dialog with “OK”.
5. Configure the property “Text” of the image: ImagePool_A, Stop
6. Configure the property “Text properties ➔ Horizontal alignment”: Left.
7. Configure the property “Text properties ➔ Vertical alignment”: Bottom.

Precondition: A project containing a visualization is opened.
1. Open the visualization and insert a “Button” element.
   ⇒ The “Properties” view opens for the new element.
2. Configure property “Text”: Number of clicks: %I
   ⇒ The string contains the placeholder %I.
3. In POU PLC_PRG of the application declare a type-conform variable: iClicks : INT;
4. Configure the property “Text variable” of the button element with PLC_PRG.iClicks.
   ⇒ At runtime the variable value will be output instead of the placeholder.
5. Below property “Inputconfiguration”, in the cell containing the input event OnMouseClick, click on “Configure”.
6. From the list of possible actions choose Execute ST-Code.
7. Enter the code for the action in the editor “Execute ST-Code”:
   PLC_PRG.iClicks := PLC_PRG.iClicks + 1;
8. Close the dialog with “OK”.
   ⇒ The user input is configured.
9. Build, download and start the application.
   ⇒ The application is running. The visualization opens. The element is labeled and the number of clicks will be output. If you as user click on the button, the number will be increased.
Using the “Text field” element you can produce a dynamic text output. The text output can be effected via an user input or via the application program.

1. Open the visualization and insert a “Text field” element. The “Properties” view shows the configuration of the element.
2. Below the application add a Text List with the following entries: Textlist_A.

3. In POU PLC_PRG of the application declare the text variable: strTextID : STRING := '0';
4. Also declare the variable strTooltipID : STRING := '0';
5. Also declare the variable iText : INT;
6. Configure the property “Dynamic texts ➞ Text List” with 'Textlist_A'.
7. Configure the property “Dynamic texts ➞ Text index” with PLC_PRG.strTextID.
8. Configure the property “Dynamic texts ➞ Tooltip index” with PLC_PRG.strTooltipID.
9. In POU PLC_PRG implement the CASE instruction as shown below.
   v The variables in property “Dynamic Texts” are programmed.
10. Configure the property “Inputconfiguration ➞ OnMouseclick” for Execute ST-Code with PLC_PRG.iText := (PLC_PRG.iText + 1) MOD 4;
   v For element “Text field” an user input is configured.
11. Build, download and start the application.
   v The application is running. The visualization opens. In the text field the text None is output. When you as user click on the element, the text changes to Dynamic File_A. And the matching tooltip is available: Information A. With each click the text changes according to the CASE instruction.
CASE instruction

```c
CASE iText OF
  0:    strTextID := '0';
        strToolTipID := '0';
  1:    strTextID := '1';
        strToolTipID := '4';
  2:    strTextID := '2';
        strToolTipID := '5';
  3:    strTextID := '3';
        strToolTipID := '6';
ELSE
  END_CASE;
```

Text output: Configuring a static + dynamic text output
In property “Texts ➔ Text” you can define a text in order to get a static text output. A text in “Texts ➔ Tooltip” will be displayed as tooltip. You can configure the text in a way, that the content of a variable is additionally output.

You can extend a static text by (exactly) 1 placeholder including a formatting definition, in order to output the content of a variable at this place at runtime. The variable must be assigned in property “Text variable”. When the variable value changes in the application code, then at the same time the output in the visualization changes.

- Precondition: A project containing a visualization is opened.
1. Open the visualization and insert an element “Text field”.
   ⇒ The “Properties” view shows the element configuration.
2. Configure the property “Text ➔ Text”: File name: %s
   ⇒ The text contains the placeholder %s.
3. In POU PLC_PRG of the application declare a type-conform variable strFileName : STRING := 'File_A';
4. Configure the property “Text variable” of the text field with PLC_PRG.strFileName.
   ⇒ At runtime the variable value will be output instead of the placeholder.
5. Build, download and start the application.
   ⇒ The application is running. The visualization opens. The text field element displays the text: File name: File_A

▷ Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329

Configuring text input in a text field
You can use the “Text field” element in order to output the text given by a variable, or to provide a place, where the user can give input on the variable.

Additionally you can configure a text input. In this case on an user input an input field in the element “Text field” will appear. As a precondition you must have configured an user input action in the property “Inputconfiguration”.

▷ Chapter 6.4.5.8 “Setting Up Multiple Languages” on page 2906
Showing text as a tooltip

- Precondition: A project containing a visualization is opened.
  1. Open the visualization and insert an element “Text field”.
     - The “Properties” view shows the element configuration.
  2. Configure the property “Texts ➔ Text”: File name: %s
     - The text contains the placeholder %s
  3. Configure the property “Texts ➔ Tooltip”: Storage location: %s
  4. In POU PLC_PRG of the application declare a type-conform variable strFileName : STRING := 'File_A';
  5. In POU PLC_PRG of the application declare also the variable strFileDir : STRING := 'D:/Data';
  6. Configure the property “Text variable” of the text field with PLC_PRG.strFileName.
    - At runtime the variable value will be output instead of the placeholder.
  7. Configure the property “Tooltip” of the text field with PLC_PRG.strFileDir.
  8. Build, download and start the application.
    - The application is running. The visualization opens. The text field element shows the text File name: File_A. When the mouse cursor is moved above the text field, the tooltip will be displayed: Storage location : D/Data.

.chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329

Configuring element “Text field” for text input

- Precondition: A project containing a visualization is opened.
  1. In POU PLC_PRG of the application declare a string variable: strInput : STRING;
  2. Open the visualization and insert an element “Text field”.
    - The “Properties” view shows the configuration of the element.
  3. In property “Texts ➔ Text” enter Input: %s.
  4. In property “Inputconfiguration” for mouse action “OnMouseClick” click on “Configure” to open the “Input Configuration” dialog box. There choose action “Write a Variable” and activate option “Use text output variable”. Close with “OK”.
  5. In the element property “Text variables ➔ Text variable” assign the text output variable PLC_PRG.strInput.
6. Build, download and start the application.

The application is running. The visualization opens. The element outputs the text:

```
Input: Click in the element to open an input field, where you can enter a string.
After having terminated the input by [Enter], the text will be adopted.
```

### Animating the text display

Configure the property “Font variables” in order to animate the display of a text. All base elements have this property, additionally the table, scrollbar and text field element.

* Chapter 6.4.5.10.3 “Animating a text display” on page 2914

### Configuring the ‘Label’ element

- Precondition: A project containing a visualization is opened.
- 1. Open a visualization and insert an element “Label”.
  - The “Properties” view with the pre-set property configuration opens.
- 2. Configure the property “Texts ➔ Text” Visualization A.

### Making an element invisible

You can configure the property “State variables ➔ Invisible” in order to hide an element in the visualization.

- Precondition: In the visualization you have configured a text field, which gets visible only, if a certain application variable gets TRUE. For example in order to show certain instructions or descriptions only in a certain state of the machine.
- 1. For the text field element configure the property “Texts ➔ Text” with Error detected: Do the following...
  - Configure the property “Text properties ➔ Font color” with “dark red”.
- 2. In PLC_PRG declare the variable bIsInvisible : BOOL : TRUE; (this is the initialization for the current example; normally the variable should be set to TRUE by the application program under certain conditions.
- 3. Configure the property “State variables ➔ Invisible” with PLC_PRG.bIsInvisible.
- 4. Build, download and start the application.
  - The application is running. The visualization opens and the text field is not visible. When you set bIsInvisible to TRUE, the textfield will be displayed.

#### 6.4.5.5.6 How to display variable values in the visualization

There are simple to very specialized visualization elements for displaying data from a running application.

Examples:

- Simple output of variable values: For example, you can configure a purely formatting specification for a “Rectangle” element in the “Text” property and the variable whose value is to be displayed in the element in the “Text variable” property.
- Display of structured variable values (structure, array, function block): You use the “Table” element and specify an array variable in its configuration in the “Data array” property whose values are to be displayed in the table. One-dimensional arrays can also be displayed in a “Histogram”.
● Display of values by image switching. Example: A specific screen is displayed depending on the error message that occurs. You do this by configuring an “Image” element with a variable for the “Bitmap ID variable” property.
● Display a variable value as a bar or with a pointer on a scale: You specify a variable in the “Value” property of the “Bar Display” element or “Meter” element to display its value as a bar on a horizontal or circular scale.
● Display of alarms: The alarms configured in the alarm management of the application can be made visible by means of the “Alarm Table” and “Alarm Banner” elements in the user interface.
● “Trace” and “Trend”: For graphical recording of variable values over a period of time.
For details, see the descriptions of the element properties.
See also
● Chapter 6.4.5.20.1 “Visualization Elements” on page 2987
● Chapter 6.4.5.5.5 “Using texts” on page 2878
● Chapter 6.4.5.2.4 “Displaying Array Data in a Histogram” on page 2862

6.4.5.5.7 How to Change Variable Values via the Visualization
In addition to displaying values from the controller, a user interface is also used to enter and change values.
In general, you can configure user input for each element in its “Input configuration” properties. Moreover, elements have been developed especially for specific input.
Examples:
● A “Button” element (or “Rectangle” element, and so on) that is clicked to open a predefined dialog visualization for easily specifying a value.
● A “Slider” element for changing the value of a variable by moving visual element parts, for example with the mouse. In the case of the slider: The element adjusts the value of a variable, depending on the position of the slider within the slider. You define the value range of the slider bar by means of the scale start and scale end.
● A switch element (example; “Power Switch”) for setting a Boolean value.
● A “Spin Box” element for incrementing or decrementing the value of a variable in defined intervals.
● A “Button” element for writing a recipe, executing a specific ST code, writing a specific variable, and so on (definition in the input configuration).
See also
● Chapter 6.4.5.21.5 “Visualization Elements” on page 3412
● Chapter 6.4.5.6 “Configuring user inputs” on page 2885

6.4.5.5.8 Designing a background
You can design the background of your visualization in color or with an image. To do this, use the command “Visualization ➔ Background”.
See also
● Chapter 6.4.5.21.2.10 “Command ‘Background’” on page 3349
● Chapter 6.4.5.21.3.15 “Dialog ‘Properties’ of Visualization Objects” on page 3388

Configuring an image as a background
In addition, you can use the property “Integrate background” in the dialog “Properties” of a visualization object to specify whether the background image should always be displayed in its entirety or whether it should be truncated.
Requirement: A project with a visualization is open.
1. Open the visualization and select the command “Visualization ➔ Background”.
2. Activate the option “Image” and open the input assistant.
3. Select an image in the dialog “Input Assistant”.
   ⇒ The image serves as a background image.

See also
● Chapter 6.4.5.21.3.15 “Dialog 'Properties' of Visualization Objects” on page 3388

### Configuring a colored background

Requirement: A project with a visualization is open.
1. Open the visualization and select the command “Visualization ➔ Background”.
2. Activate the option “Color”.
3. Select a style color such as “Element background color” from the selection list.
   ⇒ The background of the visualization is colored.

### 6.4.5.6 Configuring user inputs

#### 6.4.5.6.1 General

User inputs for a visualization are configured in order to operate the visualization. For this purpose, you configure input events on visualization elements where follow-up actions are triggered. The combination of user inputs and follow-up actions are defined in the “Input configuration” of an element. For example, you can select a mouse click on an element as the input event and opening a dialog box as the input action.

Keyboard events can also be configured that trigger actions in a specific visualization window when the events occur. You program this kind of input configuration for a visualization in its “Keyboard configuration” editor.

In addition, keyboard events can be configured that occur in all visualizations programmed in the application. You configure this kind of input configuration per application below the visualization manager in the “Standard keyboard shortcuts” tab.

Input is usually performed with the mouse and keyboard as controlling device. You can also configure a user operation by means of gestures.

If a visualization device is not equipped with a mouse, then you can activate default keyboard usage. Then a user can operate the visualization with the keyboard only by navigating with the arrow keys and triggering events by pressing the [Enter] key.

If a visualization device is not equipped with a keyboard, then you can call a virtual keyboard or a virtual numeric keypad.

**NOTICE!**

Configure keyboard events only for keys that the visualization device supports.

● Chapter 6.4.5.21.2.2 “Command 'Keyboard Configuration’” on page 3341
● Chapter 6.4.5.21.3.6 “Dialog 'Input Configuration’” on page 3370
● Chapter 6.4.5.21.4.3 “Tab 'Visualization Manager’ - 'Default Hotkeys’” on page 3402
1. Event handler of the application. Requirement: The event handler is activated.
2. Events of the default keyboard usage
3. Events of the keyboard usage are configured in the tab “Visualization manager” - “Default hotkeys”.
4. Events of keyboard usage are configured in the tab “Keyboard configuration” for the currently visible visualization.

- Chapter 6.4.5.6.6 “Capturing user input events” on page 2895
- Chapter 6.4.5.21.1 “Keyboard Shortcuts for Default Keyboard Action” on page 3338
- “Tab ‘Keyboard configuration’” on page 3341
- Chapter 6.4.5.21.2.2 “Command ‘Keyboard Configuration’” on page 3341
- Chapter 6.4.5.21.4.3 “Tab ‘Visualization Manager’ - ‘Default Hotkeys’” on page 3402
- Chapter 6.4.5.21.4.3 “Tab ‘Visualization Manager’ - ‘Default Hotkeys’” on page 3402

### 6.4.5.6.2 Configuring user inputs for visualization elements

All base elements and some common control elements have the “Input configuration” property. This is where you can configure a user input for an element. For this purpose, you select an input event and an input action.

#### Configuring user inputs

- Requirement: A project is open with a visualization.
- Open the visualization and added a “Button” element.
  - The “Properties” view opens for the new button.
- Configure the property “Text” with Number of clicks: %i.
- Declare a variable iClicks : INT; in the application in the PLC_PRG POU.
- Configure the “Text variable” property of the button as PLC_PRG.iClicks.
  - At runtime, its variable value will replace the placeholder in the “Text” property.
- In the “Input configuration” property, click the “Configure” button in the OnMouseClick line.
- Select the Execute ST code action from the list of possible actions and click the symbol.
  - The action appears in the list of actions to be executed. The blank implementation of the action appears in the window area to the right of the list.
7. Program the action in the editor at “Execute ST code”:

```plaintext
PLC_PRG.iClicks := PLC_PRG.iClicks + 1;
```

8. Click “OK” to close the dialog box.
   ⇒ The user input is configured.

9. Compile, download, and start the application.
   ⇒ The application runs. The visualization opens. If the user clicks the button, then the
action is executed, the variable `PLC_PRG.iClicks` is incremented, and the number
of clicks is printed.

---

Chapter 6.4.5.21.3.6 “Dialog ’Input Configuration’” on page 3370

6.4.5.6.3 Configuring gesture recognition

You can execute a visualization on a device that is operated by means of gestures. The visualization retains its user input configuration for mouse and keyboard operation and also recognizes gestures and multi-touch events. Gesture events are recognized and interpreted as mouse events.

For this purpose, activate the “Activate multi-touch” setting in the visualization manager.

Elements of the type “Frame” or “Tab control element” display contents that a user should be able to move. Therefore, configure their “Scaling type” property with “Fixed and scrollable”.

Gesture recognition for:

- Tapping
  A quick tap on the element is interpreted as a mouse click.

- Panning
  Pressing, moving, and releasing with one finger in a frame or with a tab control element (in the window area of the element) will move the contents.

- Multi-finger touch detection
  Touching several elements at the same time will input for all elements. These touch events are interpreted as the respective mouse events.

Example:
Two-hand operation in order to trigger an action with two simultaneous inputs on two different elements.
Virtual mixing console where multiple sliders can be operated at the same time.

In addition, the `IGestureEventHandler` interface is available in the `VisuElems.VisuElemBase` library. You can use this to implement application code that recognizes gestures and executes follow-up actions.

The following display variants can execute a visualization on a multi-touch device

- CODESYS WebVisu

“Implementing event handling with multi-touch” on page 2888
Using gestures to control visualizations

☐ Requirement: A project is open with a visualization and a user input configuration. It contains one button. The visualization device is a display with multi-touch support.

1. Double-click the “Visualization manager” object.
   ⇒ The editor opens.
2. Click the “Settings” tab.
3. In the “Additional settings” group, activate the “Activate multi-touch” option.
4. Compile, download, and start the application.
   ⇒ The application runs. The visualization opens. When a user touches the display of the visualization device, the visualization responds. Elements that respond to mouse events also respond to touch events. Several buttons can be pressed at the same time. Scrollable frames or tab control elements are displayed without scrollbars and can be moved by panning.
   Note: The “Scaling type” property of elements type “Frame” or “Tab control element” must be set to “Fixed and scrollable”.

Chapter 6.4.5.20.1.6 “Visualization Element ‘Frame’” on page 3053
Chapter 6.4.5.20.1.10 “Visualization Element ‘Tabs’” on page 3084

Implementing event handling with multi-touch

☐ Requirement: The device is multi-touch capable

1. Implement and register a function block that receives the gesture events.
   ⇒ FUNCTION_BLOCK GesturesHandler IMPLEMENTS VisuElems.VisuElemBase.IGestureEventHandler2
   VisuElems.g_VisuEventManager.SetGestureEventHandler(THIS^);
2. Implement and register a function block that sets the touch areas.
   ⇒ FUNCTION_BLOCK RectProvider IMPLEMENTS VisuElems.VisuElemBase.IApplicationRectangleProvider
   VisuElems.g_VisuRectangleProvider := THIS^;
3. Implement actions as application code that are executed when a gesture event occurs

6.4.5.6 Configuring text input with the virtual keyboard

A visualization is usually configured so that it calls a virtual keyboard for a text input event when an input device is not available. For this purpose, the follow-up action “Write variable” is preset accordingly in the user input: The value “Standard” is selected for the “Input type” setting.

However, you can also configure especially how text is input. For this purpose, more input types are available in the user input, such as Text input or the listed visualizations. These visualizations have the visualization type “Numpad/Keypad” and display virtual keyboards or numeric keypads.

In the “Settings for default text input” setting of the visualization manager, you can preset a keyboard visualization that is called from all visualizations in the application when required. This is possible without having to customize the user inputs of the visualizations.

Chapter 6.4.5.21.3.6 “Dialog ‘Input Configuration’” on page 3370
Configuring text input especially for virtual keyboards

☐ Requirement: A project is open with a visualization.

1. Declare an input variable in the PLC_PRG program.
   `VAR_INPUT stInput : STRING; VAR_END`

2. Add a button to the visualization and select the element.

3. Configure the property “Texts ➔ Text” with Text input: %s.

4. Configure the property “Text variables ➔ Text variable” with PLC_PRG.stInput.

5. Click auf “Configure” in the property “Input configuration ➔ OnMouseClick”.
   ➔ The “Input Configuration” dialog box opens. The selected input event is printed below the caption.

6. Select the “Write variable” action.

7. Select the visualization Visudialogs.Keypad in “Input type” of the implementation of the action.
   ➔ The virtual keyboard Visudialogs.Keypad is selected as the input device.

8. Compile, download, and start the application.
   ➔ The visualization opens.

9. Click the button as a visualization user.
   ➔ The virtual keyboard appears and allows text input by means of the mouse.
Configuration and programming
Programming with CODESYS > CODESYS Visualization

Configuring numeric input especially for virtual numeric keypads

☑ Requirement: A project is open with a visualization.
1. Declare an input variable in the PLC_PRG program.
   ➔ VAR_INPUT iInput : INT; VAR_END
2. Open the visualization and added a “Rectangle” element.
3. Select the element in the editor.
   ➔ The properties are visible in the “Properties” view.
4. Configure the property “Texts ➔ Text” with Number input: %i.
5. Configure the property “Text variables ➔ Text variable” with PLC_PRG.iInput.
6. In the “Input configuration” property, click the “Configure” button in the OnMouseClick line.
   ➔ The “Input Configuration” dialog box opens. The selected input event is printed below the caption.
7. Select the Write variable action from the list of possible actions and click the symbol.
   ➔ The action appears in the list of actions to be executed. The blank implementation of the action appears in the window area to the right of the list.
8. Select the following settings:
   “Input type” set to VisuDialogs.Numpad.
   “Choose variable to edit” set to “Use text output variable”.
   “Dialog title” set to 'My virtual numpad'.
9. Click “OK” to close the dialog box.
   ➔ The user input is configured.
10. Compile, download, and start the application.

⇒ The application runs. The visualization opens. When a user clicks the rectangle, the numeric keypad opens.

![Image of numeric keypad]

**Defining standard text input**

☑ Requirement: A project is open with a visualization and a user input configuration. For all “Write variable” follow-up actions, the value “Default” is selected for the “Input type” setting.

1. Double-click the visualization manager.

2. Click in the default text input in the “Settings” tab (“Default text input” group) and assign visualizations.

⇒ These visualizations are defined as default text input. If a display variant does not have a keyboard, then these visualizations are called without you having to adapt the user input.
6.4.5.6.5 Configuring Keyboard Shortcuts

You can define keyboard shortcuts and assign specific actions to them. At runtime, a visualization detects the keyboard input event and executes the action.

There are different locations where you can configure a keyboard input event.

The options include the following:

- Configure keyboard input for a specific element.
- Configure keyboard input for a specific visualization.
- Configure keyboard input that is valid for all visualizations.
- Select the default hotkeys.

If the visualization integrated in CODESYS is executed, then you can deactivate the keyboard input of the visualization in order to use the keyboard shortcut from CODESYS in this state.

You can define a keyboard shortcut that triggers an action for an element. The element has to be visible and operable. For this purpose, the property “Input configuration ➔ Keyboard shortcuts” is available in the “Properties” view of the visualization editor.

Configuration and programming

Requirement: A CODESYS project is open with the existing visualizations visEllipse and visRectangle.

1. Select the application in the device tree and add a visualization named visMain.
   ➔ The visualization editor opens.
2. In the “Visualization Toolbox” view, select and drag the “Frame” element to the editor.
   ➔ The “Configuration of Frame Visualizations” dialog opens.
3. Double-click in succession the visEllipse and visRectangle visualizations in “Available Visualizations”.
   ➔ The visualizations appear in “Selected Visualizations”.
4. Click “OK” to exit the dialog.
   ➔ The visualization contains a new element type “Frame”. The 2 selected visualizations appear under its property “References”.
   In the editor, the frame shows the visualization with the index 0.
5. Add a button and configure its properties:
Select Rectangle in the property “Texts ➔ Text”.
In the “Input configuration ➔ OnMouseDown” property, select “Toggle frame visualization” for the visualization visRectangle.
Specify the value R in the property “Input configuration ➔ Keyboard shortcuts ➔ Key”.
➔ The button has a user input and a keyboard shortcut.
6. Add a button and configure its properties:
Select Ellipse in the property “Texts ➔ Text”.
In the “Input configuration ➔ OnMouseDown” property, select “Toggle frame visualization” for the visualization visEllipse.
Specify the value E in the property “Input configuration ➔ Keyboard shortcuts ➔ Key”.
➔ The button has a user input and a keyboard shortcut.
7. Click “Online ➔ Login” for the device and start the application.

   ➔ The visualization starts. It has a frame where one of the referenced visualizations runs. Focus on the visEllipse visualization and press [E]. The visualization switches the contents in the frame to the visEllipse visualization. When you press [R], the visualization switches the contents in the frame to the visRectangle visualization.

---

### Configuring keyboard shortcuts for a specific visualization

You can define keyboard shortcuts that trigger an input action on a specific visualization. The “Keyboard Configuration” tab in the editor of the visualization is used for this purpose.

- **Requirement:** A CODESYS project is open with the visualizations visEllipse and visRectangle.

1. Open the CODESYS TargetVisu object and select visEllipse as the start visualization.
2. Open the visEllipse visualization and click the “Keyboard Configuration” tab.
3. Click “Visualizations ➔ Keyboard Configuration”.
   ➔ The “Keyboard Configuration” tab opens.
4. Select the value C in the “Key” column.
5. Activate the “Press key” option.
6. Select the “Change shown visualization” value in the “Action Type” column.
7. Select visRectangle in the “Action” column.
   ➔ The user input is configured for [C].
8. Open the visRectangle visualization and click the “Keyboard Configuration” tab.
9. Select the value C in the “Key” column.
10. Activate the “Press key” option.
11. Select the “Change shown visualization” value in the “Action Type” column.
12. Select visEllipse in the “Action” column.
   ➔ The user input for [C] is also configured for this visualization.
13. Build the application.
14. Click “Online ➔ Login” for the device and start the application.

⇒ The visualization starts and displays an ellipse. Focus on the visEllipse visualization and press [C]. The visRectangle visualization is displayed. Focus on the visualization and press [C] again. Now the visualization is switched again to visRectangle.

⇒ “Tab ‘Keyboard configuration’” on page 3341
⇒ “Input action ‘Change Shown Visualization’” on page 3373

**Configuring keyboard shortcuts for all visualizations in the application**

You can define keyboard shortcuts that trigger the same input action for all visualizations of the application. The “Default Hotkeys” tab in the Visualization Manager is available for this purpose.

☐ Requirement: A project is open with a visualization.

1. Open the visualization.
2. Add a rectangle.
3. Configure the property “Texts ➔ Text” with Keyboard shortcut.
4. Double-click the “GlobalTextList” object.
5. Click in the table, “Add Language”, and then specify de.

⇒ The language de is configured.
6. Click in the table, “Add Language”, and then specify en.

⇒ The language en is configured.
7. Configure translations for de and en for the text Keyboard shortcut.

⇒ Hotkey Keyboard Shortcut Hotkey
8. Open the Visualization Manager and select the “Default Hotkeys” tab.
9. Specify D in the “Key” column.
10. Activate the “Press key” option.
11. Select the “Change language” value in the “Action Type” column.
12. Select the language de in the “Action” column.

⇒ The keyboard event for [D] is configured.
13. Specify D in the “Key” column.
15. Select the “Alt” option.
16. Select the “Change language” value in the “Action Type” column.
17. Select the language en in the “Action” column.

⇒ The keyboard event for [Alt]+[D] is configured.
18. Compile, download, and start the application.
   ➔ The visualization opens.

19. As the visualization user, press [D].
   ➔ The text is displayed in the language de.

- Chapter 6.4.5.21.4.3 “Tab ‘Visualization Manager’ - ‘Default Hotkeys’” on page 3402
- “Input action ‘Change Language’” on page 3372

### Activating standard keyboard handling

When you activate the universal keyboard shortcuts for standard keyboard handling, the user can operate the visualization without a mouse. Elements that respond to user input can process a keyboard event instead of a mouse event without adapting its input configuration.

- Requirement: A project with a visualization is open.
- 1. Click the “Visualization Manager” object.
- 2. Activate the “Activate standard keyboard handling” option.
   ➔ The universal keyboard shortcuts are activated.
- 3. Download the application to a device and start the application.
   ➔ The visualization starts. Now operation can proceed without the mouse. You can navigate in the window by means of the [Arrow] and [Tab] keys and press [Enter] instead of the mouse button.

- Chapter 6.4.5.21.1 “Keyboard Shortcuts for Default Keyboard Action” on page 3338

### Activating and deactivating keyboard shortcuts for integrated visualizations

If you execute the visualization as an integrated visualization, then the “Visualization ➔ Activate Keyboard Usage” command is available in order to deactivate the capturing of keyboard events. It is actually possible for the same keyboard shortcuts to be defined in the visualization and in CODESYS.

When you activate the command, the visualization executes the configured keyboard events.

When you deactivate the command, CODESYS executes the keyboard events. Capturing keyboard events is then deactivated for the visualization.

- Chapter 6.4.5.21.2.4 “Command ‘Activate Keyboard Usage’” on page 3343

### 6.4.5.6.6 Capturing user input events

You can capture user input events in the application. For this purpose, you can implement a function block that is executed when user events occur.

### Capturing the writing of variables

When the user completes the input of a value (in an input field), an edit control event is closed. You can capture this event in the application as follows.

- 1. Create a function block that implements the VisuElems.IEditBoxInputHandler interface from the VisuElemBase library.
- 2. Pass the instance to the global event manager VisuElems.Visu_Globalis.g_VisuEventManager by calling the SetEditBoxEventHandler method.
A visualization has two input fields for `iInput_A` and `rInput_B` and one text output element. The input fields are rectangles that the user is prompted to click in order to input text.

The text output element is a rectangle where the contents of the text variable `PLC_PRG.stInfo` are printed. The text variable contains the last input by a user in one of the input fields and the additional information that was added.

```
PROGRAM PLC_PRG
VAR_INPUT
  iInput_A:INT; (* Used in the visualization as user input variable*)
  rInput_B:REAL; (* Used in the visualization as user input variable*)
  stInfo : STRING; (* Informs about the user input via the edit *n)
```
control field;
    String gets composed by method 'VariableWritten;
    Result is displayed in the lower rectangle of the
visualization *)
END_VAR
VAR
  inst : POU;
  bFirst : BOOL := TRUE;
END_VAR

IF bFirst THEN
  bFirst := FALSE;
  VisuElems.Visu_Globals.g_VisuEventManager.SetEditBoxEventHandler(inst);
  (* Call of method VariableWritten *)
END_IF

FUNCTION_BLOCK POU IMPLEMENTS VisuElems.IEditBoxInputHandler
(* no further declarations, no implementation code *)
METHOD VariableWritten : BOOL
(* provides some information always when an edit control field is
closed in the visualization, that is a variable gets written by
user input in one of the upper rectangles *)
VAR_INPUT
  pVar : POINTER TO BYTE;
  varType : VisuElems.Visu_Types;
  iMaxSize : INT;
  pClient : POINTER TO VisuElems.VisuStructClientData;
END_VAR

  // String stInfo, which will be displayed in the lower rectangle,
  // is composed here
  PLC_PRG.stInfo := 'Variable written; type: ';
  PLC_PRG.stInfo := CONCAT(PLC_PRG.stInfo, INT_TO_STRING(varType));
  PLC_PRG.stInfo := CONCAT(PLC_PRG.stInfo, ', adr: ');
  PLC_PRG.stInfo := CONCAT(PLC_PRG.stInfo, DWORD_TO_STRING(pVar));
  PLC_PRG.stInfo := CONCAT(PLC_PRG.stInfo, ', by: ');
  PLC_PRG.stInfo := CONCAT(PLC_PRG.stInfo,
    SELECT(pClient^.globaldata.clienttype =
    VisuElems.Visu_ClientType.TargetVisualization,'other visu','
    targetvisu'));

Capturing keyboard events

When the user presses and releases the key, a keyboard event is triggered in the visualization. You can capture this event in the application as follows.

1. Create a function block that implements VisuElems.IVisuUserEventManager from the VisuElemBase library.

2. Pass the instance to the global event manager VisuElems.Visu_Globals.g_VisuEventManager by calling the SetKeyEventHandler method.
A visualization has one text output element. The text output element is a rectangle where the contents of the text variable PLC_PRG.stInfo are printed. The text variable contains information about the last key pressed by the user.

Properties of the rectangle for the text output

<table>
<thead>
<tr>
<th>Texts ➔ Text</th>
<th>%s</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Text variables ➔ Text variable&quot;</td>
<td>PLC_PRG.stInfo</td>
</tr>
</tbody>
</table>

**Implementation of the PLC_PRG program**

```plaintext
PROGRAM PLC_PRG
VAR_INPUT
  stInfo : STRING;
END_VAR
VAR
  inst : POU;
  bFirst : BOOL := TRUE;
END_VAR

IF bFirst THEN
  bFirst := FALSE;
  VisuElems.Visu_Globals.g_VisuEventManager.SetKeyEventHandler(inst);
END_IF
```

**Implementation of the POU function block**

```plaintext
FUNCTION_BLOCK POU IMPLEMENTS VisuElems.IKeyEventHandler
(* no further declarations, no implementation code *)

/// This method will be called after a key event is released.
/// RETURN:
/// TRUE - When the handler has handled this event and it should not be handled by someone else
/// FALSE - When the event is not handled by this handler
METHOD HandleKeyEvent : BOOL
VAR_INPUT
  /// Event type. The value is true if a key-up event was released.
  bKeyUpEvent : BOOL;
  /// Key code
  dwKey : DWORD;
  /// Modifier. Possible values:
  /// VISU_KEYMOD_SHIFT : DWORD := 1;
  /// VISU_KEYMOD_ALT : DWORD := 2;
  /// VISU_KEYMOD_CTRL : DWORD := 4;
  dwModifiers : DWORD;
  /// Pointer to the client structure were the event was released
  pClient : POINTER TO VisuStructClientData;
END_VAR
VAR
END_VAR

PLC_PRG.stInfo := 'KeyEvent up: ';
PLC_PRG.stInfo := CONCAT(PLC_PRG.stInfo, BOOL_TO_STRING(bKeyUpEvent));
PLC_PRG.stInfo := CONCAT(PLC_PRG.stInfo, ', key: ');
PLC_PRG.stInfo := CONCAT(PLC_PRG.stInfo, DWORD_TO_STRING(dwKey));
PLC_PRG.stInfo := CONCAT(PLC_PRG.stInfo, ', modifier: ');
PLC_PRG.stInfo := CONCAT(PLC_PRG.stInfo, DWORD_TO_STRING(dwModifiers));
PLC_PRG.stInfo := CONCAT(PLC_PRG.stInfo, ', by: ');
PLC_PRG.stInfo := CONCAT(PLC_PRG.stInfo, ', by: ');
```

**Example Implementation of the PLC_PRG program**

```plaintext
PROGRAM PLC_PRG
VAR_INPUT
  stInfo : STRING;
END_VAR
VAR
  inst : POU;
  bFirst : BOOL := TRUE;
END_VAR

IF bFirst THEN
  bFirst := FALSE;
  VisuElems.Visu_Globals.g_VisuEventManager.SetKeyEventHandler(inst);
END_IF
```

**Implementation of the POU function block**

```plaintext
METHOD HandleKeyEvent : BOOL
```

**Implementation of the VariableWriter method of the POU function block**

```plaintext
/// Event type. The value is true if a key-up event was released.
/// RETURN:
/// TRUE - When the handler has handled this event and it should not be handled by someone else
/// FALSE - When the event is not handled by this handler
```
SEL(pClient^.globaldata.clienttype = 
VisuElems.Visu_ClientType.Targetvisualization,
'other visu',
'targetvisu'));

1. Implement a function block (example: POU) that implements the IValueChangedListener interface.

   FUNCTION_BLOCK POU IMPLEMENTS VisuElems.IValueChangedListener
   
   In the device tree, the “ValueChanged” method is inserted below the function block.

2. In a program (example: “PLC_PRG”), implement the IEC code that registers the interface.

   VisuElems.g_itfValueChangedListenerManager.AddValueChangedListener(itfValueChangedListener)

   “PLC_PRG” receives all value changes by means of the “ValueChanged” method.

   Now you can record and process the value changes.

### 6.4.5.7 Setting Up User Management

| 6.4.5.7.1 | General................................................................................................. | 2899 |
| 6.4.5.7.2 | Creating runtime-based user management initially............................ | 2900 |
| 6.4.5.7.3 | Switch to legacy user management.................................................. | 2902 |
| 6.4.5.7.4 | Creating a group with administrator rights for visualizations............. | 2902 |
| 6.4.5.7.5 | Setting up access control and login operation.................................. | 2903 |
| 6.4.5.7.6 | Group-dependent restriction of functionality.................................... | 2905 |

### 6.4.5.7.1 General

If you want to deploy a web visualization and securely protect it from third-party access, it is advantageous to set up runtime-based user management for it.

Runtime-based user management makes sure that users will log in securely with current technology. The credentials are managed using standard web technologies. In addition, user accounts can be created at runtime via secure channels, user credentials can be managed, and user permissions can be restricted according to the role of the user.

For this, it is necessary that the visualization user management is coupled with the device user management. You need to map the groups with their rights in the visualization to the groups in the device. You configure the user accounts centrally on the “Users and Groups” tab of the device editor.

If you do not want this because you value independent user management for your visualization and accept the outdated technology for this, then you can alternatively switch to legacy user management. This is not recommended if your controller supports runtime-based user management.

◇ Chapter 6.4.11.4 “Handling of Device User Management” on page 1971
◇ Chapter 6.4.1.6.5 “Setting up a user management” on page 1825
User management linked to device user management for higher security.

Whenever possible, always use runtime-based user management.

If you want to convert to your existing user management, then open the “User Management -> Groups” tab in the “Visualization Manager” and click the “Convert to Runtime-Based” button. At this time, the user groups are taken over. The credentials of the users will be lost because these then have to be set up in the controller.

The users are configured in the device user management on the “Users and Groups” tab of the device editor. If you want a user to have access only to a visualization but not to any device, then assign them a group membership and restrict the group permissions so that they are only allowed access to a visualization but not to any other device functionality.

Chapter 6.4.5.7.2 “Creating runtime-based user management initially” on page 2900

Legacy User Management

Deprecated but still available user management.

Legacy user management runs independently of device user management.

In the deprecated visualization user management, you define user groups and visualization users in the “Visualization Manager”. In the user management dialogs, which request the credentials at runtime, authorized users log in to their visualization with their group permissions. In the visualization, elements can have group-dependent permissions and therefore be visible only to the group, for example.

In a project with several applications, you can configure user management for each application.

NOTICE!

When a visualization user management exists, an unregistered user automatically receives the access rights from the None group.

“Tab ‘Groups’” on page 3404

Login operation on the display variants

The login operation is always the same for all display variants. This means it is independent of which user management is set up.

Login operation on the display variants:

- The integrated display ignores the user management functionality and starts with the user who logged in to the controller using CODESYS.
- When a TargetVisu is started, no user is initially logged in and the operator then has to log in if this is required by the designed visualization.
- When starting a remote TargetVisu, the user from the communication settings of the remote TargetVisu itself is initially logged in. This can be changed via a new login within the visualization.
- Web visualizations start with the secure login operation of runtime-based user management.

6.4.5.7.2 Creating runtime-based user management initially

Whenever possible, use a runtime version >= 3.5 SP18 Patch 1 and CODESYS Visualization version >= 4.2.0.0 for a new project with a visualization.
**With standard groups**

The default groups are “Administrator”, “Service”, and “Operator”.

Requirement: You have inserted a “WebVisu” below the “Visualization Manager”. You want to create a runtime-based user management with standard groups.

**With standard groups**

1. Double-click the “Visualization Manager” object in the device tree.
2. Select the “User Management” tab.
3. Click the [Create Runtime Based User Management with Default Groups] button.
   - The “Groups” and “Settings” tabs are displayed on the “User Management” tab.
   - The “Administrator”, “Service”, and “Operator” groups are configured on the “Groups” tab.
4. If necessary, to create new user groups, click in the empty field in the “Group Name” column and specify the name of the new group.
5. Connect the application to the controller and click the [Upload device groups names] button.
   - The user groups of the device user management are uploaded and are now selectable in the “Mapping in Runtime Group” column.
6. For the user groups of the visualization of the “Group Name” column, select a group of the device user management from the list box in the “Mapping in Runtime Group” column to which the user group of the visualization should be assigned.
   - By assigning the visualization user groups to the device user groups, the visualization groups get the same permissions on the controller as the respective groups of the device user management.

The visualization user management is now coupled with the device user management. The visualization user groups are now mapped to the device user management groups and get their group rights.

To configure the login operation, see: ☞ Chapter 6.4.5.7.5 “Setting up access control and login operation” on page 2903

**Empty with None group**

First create an empty user management if you want new created groups with self-determined permissions.

Requirement: You have inserted a WebVisu below the Visualization Manager.

1. Double-click the “Visualization Manager” object in the device tree.
2. Select the “User Management” tab.
3. Click the [Create Runtime Based Empty User Management] button.
   - The “Groups” and “Settings” tabs are displayed.
   - The “Group” tab is open.
4. To create new user groups, click in the empty field in the “Group Name” column and specify the name of the new group.
5. Connect the application to the controller and click the [Upload device groups names] button.
   - The user groups of the device user management are uploaded and are now selectable in the “Mapping in Runtime Group” column.
6. On the “User Management” tab: For the user groups of the visualization of the “Group Name” column, select a group of the device user management from the list box in the “Mapping in Runtime Group” column to which the user group of the visualization should be assigned.

By assigning the visualization user groups to the device user groups, the visualization groups get the same permissions on the controller as the respective groups of the device user management.

The newly created user management groups are now coupled with the device user management and are mapped to the device user management groups. You get their group permissions.

To configure the login operation, see: Chapter 6.4.5.7.5 “Setting up access control and login operation” on page 2903

6.4.5.7.3 Switch to legacy user management

Whenever possible, use a runtime version >= 3.5 SP18 Patch 1 and CODESYS Visualization version >= 4.2.0.0 for a new project with a visualization.

You have initially created a runtime-based user management. Now you want to decouple this from the device user management and have a separate management only for the visualization users.

1. In the Visualization Manager, open the “User Management” tab and click the “Groups” tab.
2. Click the [Convert to Legacy] button.

User management is decoupled from device user management and converted to legacy. The “Users” tab opens.

6.4.5.7.4 Creating a group with administrator rights for visualizations

Only with runtime-based user management.

Configuration of user groups with restricted administrator permissions for the visualization.

Typically, operators of the visualization are a separate user group from application developers. Therefore, the following steps can also be used to configure an administrator for the visualization, who has access only to the groups of the visualization.

This configuration is possible with runtime version 3.5.18.10 and higher.

For detailed information about CODESYS device user management and its operation, see: Handling of Device User Management.

Chapter 6.4.1.11.4 “Handling of Device User Management” on page 1971

Requirement: A visualization group (example: VISU_ADMIN) has been assigned to a runtime group (example: RTS_GRP_RESTR) in the Visualization Manager on the User Management tab. In the device user management, the User_Restr user has been assigned to the RTS_GRP_RESTR group. The RTS_GRP_RESTR group has full View permissions for the controller.
1. In the device user management, on the “Access Rights” tab, grant the “View” permission for the “UserManagement” object to the “RTS_GRP_RESTR” group. To do this, select the “UserManagement” object, and in the “Rights” area on the right side, double-click the “View” field of the “RTS_GRP_RESTR” group. This opens a dialog prompting whether or not the changed permissions should also be changed for all child objects. Click [No] to refuse this action. Double-click the field again and click [No] again in the next dialog.

   ➔ The symbol is displayed for the View permission. For all other groups (except Administrator), the permission should have the symbol.

2. To the “RTS_GRP_RESTR” group, grant the “View” and “Modify” permissions for the “UserManagement → Users” object.

   ➔ The symbol is displayed for both permissions.

3. To the “RTS_GRP_RESTR” group, grant the “View” and “Modify” permissions for those objects of the “UserManagement → Groups” object which are relevant for the visualization.

   ➔ Access to the groups which are relevant for the visualization is granted to the RTS_GRP_RESTR group. For the respective objects, the symbol is displayed for both permissions.

4. For the “RTS_GRP_RESTR” group, deny the “View” permission to the “Administrator” group. As a result, users of the “RTS_GRP_RESTR” group cannot extend their permissions.

   Moreover, select the “UserManagement → Groups → Administrator” object and deny the “View” permission to the “RTS_GRP_RESTR” group.

   ➔ The symbol is displayed.

   ➔ Now when you are logged in as a user with restricted administrator permissions on the application, you can create new users or modify existing users for the visualization, but not for groups with additional permissions on the controller.

### 6.4.5.7.5 Setting up access control and login operation

In the user management dialogs, you define the login, logout, changing of the user password, and editing of the user management in the visualization at runtime.

#### Editing and Selecting User Management Dialogs

**NOTICE!**

If you create your own dialog as a user management dialog, then you should use the visualizations from the included library project `VisuUserMgmtDialogs` as the basis, because it uses the required interfaces. Your own user management dialog is listed then in “Visualization Manager → Settings”, “Settings for User Management Dialogs”.

*For information about the login visualization in runtime-based user management, see: “Creating runtime-based user management initially”.*

[Chapter 6.4.5.7.2 “Creating runtime-based user management initially” on page 2900](#)

### Creating Login Pages

1. If you do not want to configure your own login page, then a preconfigured login page from a library is automatically used when logging in to the visualization. This visualization is automatically entered in the editor of the “WebVisu” as the “Login visualization” when the user administration is created, but it can be changed if necessary.

2. If you want to create your own login page, then follow the steps below:
3. Add a "Visualization" object (for example, named "Login_Visu") to the application.
4. In the context menu of this object, click "Properties". In the properties dialog, open the "Visualization" tab.
5. In the context menu of this object, click "Properties". In the properties dialog, open the "Visualization" tab.
6. Open the "Login_Visu" visualization and design your login page with the input fields for user name, password, and buttons for logging in and canceling the dialog.
7. To do this, only certain visualization elements are available to you. In these visualization elements, you can use placeholders to configure the input fields for the user name and password, as well as the buttons for logging in and canceling the dialog.
8. Compile the application and perform a download to the controller. When you open the web visualization, the login page which you created for the visualization opens. Type in your user name and the password for the controller which you have stored in the device user management and click the [LOGIN] button.

**Editing user management dialogs**

Requirement: The library project `VisuUserMgmtDialogs.library` exists in the installation directory.

1. Click "File → Open Project".
2. Select the project `VisuUserMgmtDialogs.library` from the Projects folder of the installation directory.
3. Click "View → POU"s.
   - In the "POU" view, the project is displayed with the visualizations "UserMgmtChangePassword", "UserMgmtConfig", and `UserMgmtChangePassword`.
4. Double-click a visualization (example: "UserMgmtLogin").
5. Change the visualization as you like and save the project.
6. Then, reinstall the library and add it to the "Library Manager" of your application.

**Selecting user management dialogs**

A user management already exists in your application in the "Visualization Manager" object on the "User Management" tab.

The "VisuUserManagement" library is in the "Library Manager".

1. In the device tree, click the "Visualization Manager" object.
2. Select the "Dialog Settings" tab.
3. In "Settings for User Management Dialogs", select the dialogs for "Login dialog", "Change password dialog", and "Change configuration dialog".

If no entries can be seen in "Settings for User Management Dialogs" in the dialog lists, then close the "Visualization Manager" and reopen it.

**Customizing the dialogs of the user management**

You configure the visualization buttons for the login, logout, change password, and user management dialogs as follows:

Requirement: A visualization is open.

1. Drag a "Button" element from the "Visualization Toolbox" view ("Common Controls" category) to the visualization.
2. In the "Properties" view, click the "Input configuration" node.
3. In the “Input Configuration ➔ OnMouseClick” property, click “Configure”.

4. In the “Input Configuration” dialog, click “User management” and  
   ➤ The following “Dialogs and actions” are listed on the right: “Login, Logout, Change User Password”, and “Open User Configuration”.

5. Elect the dialog or action to assign to the button and click [OK].
   ➤ When the button is clicked at runtime, the selected dialog opens or the selected action is executed.

| If you want to open and edit the user management in the visualization at runtime, you have to be a member of a group that has permission to Change User Data. |

6.4.5.7.6 Group-dependent restriction of functionality

Configuring permissions for an element of the visualization

Permissions for visualization-elements are not granted to individual users, but to groups with assigned users.

Requirement: A “Visualization” object is open with at least one inserted visualization element.

1. Click a visualization element in the editor.
2. Click the “Value” field of the “Permissions” element property in the “Properties” view.
   ➤ The “Permissions” dialog opens.
3. Select the permissions that the respective user group should have for the visualization element.

| If the option “Group hierarchy is used” is activated, the groups lower in the hierarchy cannot be granted more permissions than groups higher in the hierarchy. |

In the “Visualization Element List” of a visualization, the “Permissions” column shows the element permissions granted to groups.

➤ Chapter 6.4.5.21.2.3 “Command ‘Visualization Element List’” on page 3342

Updating groups and group permissions

In the project below the application, a visualization is stored which has at least one element with restricted permissions.

1. Open the Visualization Manager and click the “User Management” tab.
2. Click the “List Usage of Groups” button.
   ➤ In “Messages”, all elements with restricted permissions are listed which exist in the visualizations that are used across the application. This will give you an overview of functional limitations.
3. Click the [Update Visualizations/Hotkeys] button.

 The “Update Visualizations and Hotkeys” dialog opens. Here you can centrally rename groups, delete groups, or change group permissions. The affected visualization elements are updated. This means that the “Access Rights” property is updated for each of the affected elements: There, the group names are removed or renamed or the permissions are reset.

6.4.5.8 Setting Up Multiple Languages

Texts and tooltip texts for visualizations are managed in text lists and can be displayed in different languages. To switch a visualization between the available languages, configure a visualization element with the corresponding input configuration for changing the language.

There are static texts that are managed in “GlobalTextList” (generated automatically) and dynamic texts from created text lists. A dynamic text can be changed at runtime with a variable that defines the index of the text list entry. Static texts are fixed labels within a visualization; dynamic texts are often used for displaying variable values or error messages.

For creating and using text lists, see: Chapter 6.4.1.9.10 “Managing text in text lists” on page 1891.

You can modify the appearance and formatting of texts and tooltips with the element properties “Text properties” and “Font variables”.

See also
- Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329
- Chapter 6.4.5.21.3.6 “Dialog ‘Input Configuration’” on page 3370

Configuration language switching for texts from text lists

Requirement: An empty visualization object is inserted into the project and it is open for editing in the visualization editor. There is also a “Visualization Manager” object. User management is not created for the visualization.

The following instructions provide a simplified example:

- By means of two buttons, the user should be able to toggle the visualization texts between English and German.
- Static texts in the visualization include the labels “State, Machine 01”, “State, Machine 02”, “English”, and “German”. These texts are located in the “GlobalTextList” in English and German.
- Dynamic texts will describe the state of both machines. The texts are provided in the text list “Status_Texts” in English (en) and German (de).

1. Drag a “Text Field” from the “Visualization Toolbox” view (“Common Controls” category) to the editor view. Specify the value State, Machine M01 in the properties editor for the element property “Texts ➔ Text”.
2. Copy the element and change the copy label to State, Machine M02.
3. See also the figure in step 14 for the following steps.

Insert two elements of type “Button” from the “Visualization Toolbox” view (“Common Controls” category) in the visualization editor. With these elements, the user should be able to toggle the language of the visualization. Specify the text German or English in the properties editor for element property “Texts ➔ Text” (4).

4. Double-click and open “GlobalTextList” in the “POUs” view.

 The texts are entered in the “Standard” (1) column, and the “ID”s 0 and 1 are assigned automatically as additional information.
5. Add the languages “de” and “en” with the texts shown in the following figure.

![GlobalTextList](image)

6. Close the “GlobalTextList”.

7. Add two elements of type “Rectangle” from the “Visualization Toolbox” view (“Basic” category) in the visualization editor. The current state of each machine should be displayed.

8. For managing the texts for describing the states, add an object of type “Text List” below the application. Name the list Status_Texts.

9. Specify the texts shown in the figure for the standard language (1) and the target languages “en” and “de” in the editor of “Status_Texts”.

![Status_Texts](image)

10. Close the text list “Status_Texts”.

11. Select the rectangle element for displaying the state of machine M01. Select the text list Status_Texts from the combo box in the properties editor (2) for the “Dynamic texts” element property (5). Specify an application variable for “Text index” that shows the appropriate text index for the state of the machine at runtime. Example: PLC_PRG.ivar_status_m01.

12. Now configure the user input for both buttons for toggling the language in the visualization. Select the “German” button. Double-click “Configure” of the property “Input configuration” (6), “OnMouseClick”.

   The “Input configuration / OnMouseClick” dialog opens.

13. Select “Change the language” on the left. Click the arrows to accept the setting to the right. Select “de” in “Language” to the right of the dialog in the input assistance. Click “OK” to confirm.
14. In the same way, configure the entry for the second button: English: "Text list": Status_Texts, "Text index": 3, "Change the language": English).

⇒ The following figure shows the performed properties configurations for the four visualization elements.

15. When the application is compiled without errors, you can test the visualization in simulation mode. Activate the option "Online ➔ Simulation". Click "Online ➔ Login".

⇒ The visualization appears in the visualization editor view in online mode:

16. Click the “German” button.

⇒ The language changes to German:

⇒ “Input action ‘Change Language’“ on page 3372
Setting up fonts for a language

The font for a visualization element is defined in the properties editor. If a language switch is provided, you can overwrite this basic font with another font for each language in the visualization manager.

Requirement: A visualization is set up with at least one language in addition to the default language.

Example

1. Double-click and open the “Visualization Manager” object and select the “Font” tab.
2. Double-click the field in the “Font” line for a particular language. Select a font from the combo box.
3. In the “Font size” line, replace the value 1 with a value greater than 1 (example: 2) in order to increase the size of the font as defined by the visualization style; or replace it with a value less than 1 in order to decrease it (example: 0.5).
   ⇒ In online mode, the font changes depending on the set language.

6.4.5.9 Visualizing alarm management

In CODESYS, the alarm management is a powerful object for creating and managing alarms. You can group alarms and set the acknowledgement behavior individually. The alarm display in the visualization can also be customized.

The “Alarm Table” and “Alarm Banner” visualization elements are available for displaying and processing alarms. The alarm table lists the alarm texts. The alarm banner is a simplified version of the alarm table. It visualizes a single alarm only. However, by adding scroll elements you can allow for switching the display from one active alarm to another active alarm.

Creating an alarm table

Requirement: In your project, alarms are defined in alarm groups and they are assigned to an alarm class. The following instructions are based on the example that is described in the “Configuring alarm management” chapter.

1. Open the visualization editor.
2. Drag the “Alarm Table” element from the “Alarm Manager” group to the visualization editor.
   ⇒ The “Alarm Table” visualization element is visible in the editor.
3. In the “Alarm configuration” / “Alarm groups” property, define the alarm groups that you want to visualize. Click into the value field.
   ⇒ The “Select Alarm Group” dialog opens.
4. Clear the “All” check box and select the “PartsDeficit” alarm group. Add the group to the selected alarm groups by clicking the button.
5. In the “Alarm configuration” / “Alarm classes” property, define the alarm classes that you want to visualize. Click into the value field.
   ⇒ The “Select Alarm Class” dialog opens.
6. Clear the “All” check box and select the “PartsDeficit” alarm class. Add the alarm class to the selected alarm classes by clicking the button.
7. Add an additional column. Click the “Columns” / “Create New” button.
   ⇒ CODESYS adds the column “[2]” to the properties. The “Symbol” column is added to the table.
8. Select data type “State” for column [2].
   ⇓ The default column heading “State” is shown in the table.

9. Name the “Column heading” column “Status”.

10. Specify the appearance of the selected table cell. Set the “Selection” / “Selection color” to “Green”.

11. In the “Control variables” / “Confirm selection” property, specify the variable bQuitAlarm for confirming messages.

12. Adjust the other properties to your requirements. See the “Alarm table” visualization element for a complete description of the properties.

   Chapter 6.4.5.20.1.22 “Visualization Element ‘Alarm Table’” on page 3166

Inserting elements for acknowledging alarms

In CODESYS, predefined buttons are available for controlling the alarms in an alarm table.

Requirement: An “Alarm table” element exists in the visualization.

1. Select the visualization element in the editor.

2. Click “Visualization è Insert elements for acknowledging alarms”.
   ⇓ The “Alarm Table Wizard” dialog opens.

3. Click “OK” to accept all settings.
   ⇓ Four buttons are added for controlling the alarm table.

Creating an alarm banner

Requirement: In your project, alarms are defined in alarm groups and they are assigned to an alarm class. The following statement is based on the example that is described in the “Configuring alarm management” chapter.

The alarm banner displays an active alarm in online mode. If there are multiple active alarms, filtering takes place by means of the filter criteria set in the alarm banner (newest for filter criterion "Priority" and most important for filter criterion "Newest"). See the instructions below for adding scroll elements in order to switch the display between multiple alarms.

1. Open the visualization editor.

2. Drag the “Alarm banner” element from the “Alarm manager” group to the visualization editor.
   ⇓ The “Alarm banner” visualization element is visible in the editor.

3. In the “Alarm configuration” / “Alarm groups” property, define the alarm groups that you want to visualize. Click into the value field.
   ⇓ The “Select Alarm Group” dialog opens.

   Chapter 6.4.5.20.1.22 “Visualization Element ‘Alarm Table’” on page 3166
4. Clear the “All” check box and select the “PartsDeficit” alarm group. Add the group to the selected alarm groups by clicking the button.

5. In the “Alarm configuration” / “Alarm classes” property, define the alarm classes that you want to visualize. Click into the value field.
   ⇨ The “Select Alarm Class” dialog opens.

6. Clear the “All” check box and select the “PartsDeficit” alarm class. Add the alarm class to the selected alarm classes by clicking the button.

7. Set the “Alarm configuration” / “Filter criterion” property to “Newest”.
   ⇨ In online mode, the newest alarm message is always shown.

8. Add an additional column. Click the “Columns” / “Create new” button.
   ⇨ CODESYS adds the column “[2]” to the properties. The “Symbol” column is added to the table.

9. Select data type “State” for column [2].
   ⇨ The default column heading “State” is shown in the table.

10. In the “Confirmation variable” property, specify the variable bQuitAlarm for confirming messages.

Chapter 6.4.5.20.1.23 “Visualization Element ‘Alarm Banner’” on page 3175

Adding elements for scrolling the active alarms

Elements can be added to an alarm banner for switching the display between the individual active alarms. You can control the scrolling with visu-local variables or application variables.

1. Select the added “Alarm banner” visualization element. Click “Insert Elements for Scrolling Alarms” in the context menu.
   ⇨ The “Alarm Banner Wizard” opens.

2. Select the element type for the scroll elements: “Button” or “Rectangle”.

3. Activate the action(s) for which a control should be inserted: “Scroll to next alarm”, “Scroll to previous alarm”.

4. Specify a Boolean variable that gets the value TRUE when multiple active alarms are present. If you have already configured a project variable in the element properties, then it is also specified here in the wizard. Otherwise CODESYS automatically creates the visu-local variable “xMultipleAlarmsActive”.

5. In the next step, check the configuration of the element properties of the extended alarm banner.

6. Select the alarm banner element and look at the section “Handling of multiple active alarms” in the “Properties” view. You have two options:

7. Option 1: The display should switch automatically. Activate the “Switch automatically” property.
   ⇨ Now, in “Every N seconds” you define the time interval after which the display in the alarm banner in online mode should switch to the next alarm.

8. Option 2: The display should be controlled by means of the application. Deactivate the “Switch automatically” property.
   ⇨ Switching between the active alarms can be controlled by two variables. By default, xNext and xPrev are created for scrolling to the next or previous alarm. You can replace these variables with custom your own defined application variables.

2024/01/05 3ADR010583, 1, en_US 2911
Filtering by the contents of a latch variable can be useful when there are a lot of alarm events displayed. If the latch variable assigned to an alarm in the alarm group definition contains, for example, the error number or the name of a device instance, then you can filter the alarms in the visualization by it.

For this purpose, you configure an input option in the alarm visualization for the contents of the latch variable to be filtered by. For example, insert an input field which writes to the variable that is specified in the “Alarm configuration” - “Filter by latch 1” - “Filter variable” property of the configuration of the “Alarm table” element or “Alarm banner” element.

In addition, you configure an input option for the type of filtering. The type determines whether a numeric value (typed literal, LINT literal) or the string value of the latch variable is used for filtering. Filtering can also be switched off by means of type setting 0. For example, in the visualization, insert another input field which writes to the variable that is specified in the “Filter type” property of the configuration of the alarm table or alarm banner.

For more information, see the "Alarm Filter Latch Example" sample project in the CODESYS Store.

### 6.4.5.10 Animating visualization elements

<table>
<thead>
<tr>
<th>Subsection</th>
<th>Title</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.4.5.10.1</td>
<td>General</td>
<td>2912</td>
</tr>
<tr>
<td>6.4.5.10.2</td>
<td>Configuring rotations and offsets</td>
<td>2912</td>
</tr>
<tr>
<td>6.4.5.10.3</td>
<td>Animating a text display</td>
<td>2914</td>
</tr>
<tr>
<td>6.4.5.10.4</td>
<td>Animating a color display</td>
<td>2914</td>
</tr>
</tbody>
</table>

#### 6.4.5.10.1 General

The animation of a visualization element at runtime can serve to visualize value curves in addition to serving purely visual purposes. Animation is possible through a dynamic configuration of certain element properties, i.e. by controlling these properties with a variable. See the following examples of possible animations.

#### 6.4.5.10.2 Configuring rotations and offsets

You can animate a visualization element and have it shifted or rotated at runtime. To do this you assign variables in its property “Absolute movement” and then program the animation in the application code.

**Configuring an offset**

You can configure an offset of the element by programming the variables in “Absolute movement ➔ Movement”.

- Requirement: A project with a visualization is open.
- 1. Open the visualization and add an element “Rectangle”.
  - The view “Properties” displays the configuration of the element.
- 2. In the application in the POU PLC_PRG, declare type-compliant variables: diOffsetX : DINT; and diOffsetY : DINT;
- 3. Configure the property “Absolute movement ➔ Movement ➔ X” with PLC_PRG.diOffsetX and “Y” with PLC_PRG.diOffsetY.
- 4. Implement a shift of the element, for example by means of a modulo division of the value: 
  
  diOffsetX := diOffsetX MOD 100;
  
  diOffsetY := diOffsetY MOD 100;
- 5. Compile, load and start the application.
  - The application runs. The visualization opens. The rectangle moves.

---

Configuration and programming
Programming with CODESYS > CODESYS Visualization
When an element rotates, then the center point of the element rotates precisely around its center. The center is defined in the property “Center”. The center point of an element is calculated internally. If the center point and center coincide, then there is no rotation.

You can configure a clockwise rotation of the element by increasing the value of the variable “Absolute movement → Rotation”.

☐ Requirement: A project with a visualization is open.
1. Open the visualization and add an element “Rectangle”.
   ⇒ The view “Properties” displays the configuration of the element.
2. In the application in the POU PLC_PRG, declare a type-compliant variable:

   rValue : REAL;

3. Configure the property “Absolute movement → Rotation” with PLC_PRG.rValue.
4. Implement the clockwise rotation of the element by increasing the value of the variable:

   rValue := rValue + 0.1;
5. Compile, load and start the application.
   ⇒ The application runs. The visualization opens. The rectangle rotates about the center. The alignment of the element with respect to the coordinate system is fixed.

When an element performs an inner rotation and rotates, then the center point of the element rotates precisely around its center. This is the point defined in the property “Center”. The alignment of the element also rotates relative to the coordinate system. If the center point of the element and the center coincide, this produces a rotation on the spot.

You can configure a clockwise rotation of the element by increasing the value of the variable “Absolute movement → Inner rotation”.

If the visualization is in runtime, you can see that the element rotates (also relative to the coordinate system of the visualization).

☐ Requirement: A project with a visualization is open.
1. Open the visualization and add an element “Polygon”, which you form into a pointer.
   ⇒ The view “Properties” displays the configuration of the element.
2. Drag the center point of the element to the base of the pointer.
3. In the application in the POU PLC_PRG, declare a type-compliant variable:

   rValue : REAL;

4. Configure the property “Absolute movement → Inner rotation” with PLC_PRG.rValue.
5. Implement the clockwise rotation of the element by increasing the value of the variable:

   rValue := rValue + 0.1;
6. Compile, load and start the application.

⇒ The application runs. The visualization opens. The pointer rotates about its base.

See also
- Chapter 6.4.5.20.1.1 “Visualization Element 'Rectangle', 'Rounded Rectangle', 'Ellipse'” on page 2988

### 6.4.5.10.3 Animating a text display

An animation of the text display can be configured in the property “Font variables”. All basic elements have this property as well as tables, scrollbars and text fields.

- Requirement: A project with a visualization is open.
- 1. Open the visualization and add an element “Rectangle”.

⇒ The view “Properties” displays the configuration of the element.
- 2. Configure the property “Texts ⇒ Text” with Important:
- 3. In the application in the POU PLC_PRG, declare a type-compliant variable:

⇒ iFontHeight : INT;
- 4. Configure the property “Font variables ⇒ Size” with PLC_PRG.iFontHeight.
- 5. Implement a change of the font size.

⇒ iFontHeight := iFontHeight + 1) MOD 20;
- 6. Compile, load and start the application.

⇒ The application runs. The visualization opens. The rectangle is labelled with Important. The font size grows from 1 to 20.

See also
- Chapter 6.4.5.20.1.1 “Visualization Element 'Rectangle', 'Rounded Rectangle', 'Ellipse'” on page 2988

### 6.4.5.10.4 Animating a color display

The colors of an element are specified in the “Colors” properties of the element properties. There you can select either a predefined style color from the selection list or a color in the color dialog.

The “Color variables” element property is used for the color animation of the element. If you pass variables to the properties, then you can program color changes in the application code or configure a user input that results in a color change. A color constant or color variable in the code has the data type DWORD and is encoded according to the RGB color space or RGBA extension.
NOTICE!
The "Activate semi-transparent drawing" option is provided in the Visualization Manager. This option is enabled by default so that the "Transparency" property is available for all color definitions. With programmatic color definition, the leading byte is interpreted as an alpha channel and therefore used as the transparency value of the color. When the option is cleared, the "Transparency" property is not available and the leading byte is ignored in color literals.

Color information in the code is specified as DWORD literals. The value is in the RGBA color space and is usually shown as a hexadecimal number. The value is coded with additive portions of red, green, and blue. It is appended with the alpha channel which determines the transparency of the color.

\[\text{16#<TT><RR><GG><BB>}\]

\(<\text{TT}>\) : 00 - FF     // Transparency in 256 levels  
\(<\text{RR}>\) : 00 - FF     // Red in 256 levels  
\(<\text{GG}>\) : 00 - FF     // Green in 256 levels  
\(<\text{BB}>\) : 00 - FF     // Blue in 256 levels

The graduation value for transparency is \text{16#FF} for opaque and \text{16#00} for transparent. For each color portion, one byte is reserved for 256 color graduations \text{16#FF} to \text{16#00}. \text{16#FF} means 100% color portion and \text{16#00} means 0% color portion.

<table>
<thead>
<tr>
<th>Byte order of a color literal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(&lt;\text{TT}&gt;)</td>
<td>Byte for the transparent graduation of 00-FF</td>
</tr>
<tr>
<td>(&lt;\text{RR}&gt;)</td>
<td>Byte for the red portion of 00-FF</td>
</tr>
<tr>
<td>(&lt;\text{GG}&gt;)</td>
<td>Byte for the green portion of 00-FF</td>
</tr>
<tr>
<td>(&lt;\text{BB}&gt;)</td>
<td>Byte for the blue portion of 00-FF</td>
</tr>
</tbody>
</table>

Table 621: Color literal

<table>
<thead>
<tr>
<th>Color Literal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\text{16#FF0000FF}</td>
<td>Blue, opaque</td>
</tr>
<tr>
<td>\text{16#FF00FF00}</td>
<td>Green, opaque</td>
</tr>
<tr>
<td>\text{16#FFFF00FF}</td>
<td>Yellow, opaque</td>
</tr>
<tr>
<td>\text{16#88888888}</td>
<td>Gray, semitransparent</td>
</tr>
<tr>
<td>\text{16#88000000}</td>
<td>Black, semitransparent</td>
</tr>
<tr>
<td>\text{16#FFFF0000}</td>
<td>Red, opaque</td>
</tr>
</tbody>
</table>

Example

Global declaration of color constants

\[\begin{align*}
\text{VAR\_GLOBAL\_CONSTANT} \\
\quad \text{c\_dwBLUE} & : \text{DWORD} := \text{16#FF0000FF}; \quad \text{// Highly opaque} \\
\quad \text{c\_dwGREEN} & : \text{DWORD} := \text{16#FF00FF00}; \quad \text{// Highly opaque} \\
\quad \text{c\_dwYELLOW} & : \text{DWORD} := \text{16#FFFF00FF}; \quad \text{// Highly opaque} \\
\quad \text{c\_dwGREY} & : \text{DWORD} := \text{16#88888888}; \quad \text{// Semitransparent} \\
\quad \text{c\_dwBLACK} & : \text{DWORD} := \text{16#88000000}; \quad \text{// Semitransparent} \\
\quad \text{c\_dwRED} & : \text{DWORD} := \text{16#FFFF0000}; \quad \text{// Highly opaque} \\
\end{align*}\]
Animating a visualization element in color

1. Create a standard project in CODESYS.
2. Declare global color constants in the POU tree.
   
   ```plaintext
   {attribute 'qualified_only'}
   VAR_GLOBAL CONSTANT
   gc_dwRed : DWORD := 16#FFFF0000;
   gc_dwGreen: DWORD := 16#FF00FF00;
   gc_dwYellow: DWORD := 16#FFFFFF00;
   gc_dwBlue: DWORD := 16#FF0000FF; // Highly opaque
   gc_dwBlack : DWORD := 16#88000000; // Semitransparent
   END_VAR
   
   3. In the device tree, declare local color variables in PLC_PRG.
      
      ```plaintext
      VAR
dwFillColor: DWORD := GVL.gc_dwGreen;
dwFrameColor : DWORD := GVL.gc_dwBlack;
dwAlarmColor : DWORD := GVL.gc_dwRed;
END_VAR
   
   4. Declare a control variable.
      
      ```plaintext
      bChangeColor : BOOL;
   
   5. Declare an input variable in PLC_PRG.
      
      ```plaintext
      bInput : BOOL;
   
   6. Enable the visualization editor.
   
7. Drag a “Rectangle” element to the visualization editor.
   
   ```plaintext
   The “Properties” view of the element opens.
   
   8. Configure the properties of the rectangle as follows:
   
   ● Property “Color variables”, “Normal state”, “Filling color”: PLC_PRG.dwFillColor
   ● Property “Color variables”, “Normal state”, “Frame color”: PLC_PRG.dwFrameColor
   ● Property “Color variables”, “Alarm state”, “Filling color”: PLC_PRG.dwAlarmColor
   ● Property “Color variables”, “Toggle color”: <toggle/tap variable>
   ● Property “Input configuration”, “Toggle”, “Variable”: PLC_PRG.bInput
9. Program the variables as follows:

PROGRAM PLC_PRG
VAR
  dwFillColor: DWORD := GVL.gc_dwGreen;
  dwFrameColor : DWORD := GVL.gc_dwBlack;
  dwAlarmColor : DWORD := GVL.gc_dwRed;
  bChangeColor : BOOL;
  bInput : BOOL;
END_VAR

IF bChangeColor = TRUE THEN
  dwFillColor := GVL.gc_dwYellow;
  dwFrameColor := GVL.gc_dwBlue;
ELSE
  dwFillColor:= GVL.gc_dwGreen;
  dwFrameColor := GVL.gc_dwBlack;
END_IF

The colors are initialized at runtime. If the variable bChangeColor is then forced to TRUE, the color display of the rectangle changes. When the rectangle is clicked in the visualization, the rectangle is displayed in alarm colors.

See also
• § Chapter 6.4.5.10 “Animating visualization elements” on page 2912
• § Chapter 6.4.5.21.4.2 “Object ‘Visualization manager’” on page 3398
• § Chapter 6.4.5.19 “Applying Visualization Styles” on page 2979
• § Chapter 6.4.5.10.3 “Animating a text display” on page 2914

6.4.5.11 Displaying data arrays in tables

6.4.5.11.1 General
A frequently required function of a user interface is the display of data arrays. CODESYS Visualization provides the element “Table” for this.
In the configuration of the element “Table”, enter an array variable in the property “Data array”. The array components are displayed in the rows and columns of the table.
A table for displaying data arrays can also be created in the following way. You duplicate a single element having at least one property that is described by a structured variable. The single element is configured as a “template” for this and duplicated with a command.

6.4.5.11.2 Displaying Array Variables in Tables
A frequently required function of a user interface is the display of data arrays. CODESYS Visualization provides the element “Table” for this.
In the configuration of the element “Table”, enter an array variable in the property “Data array”. The array components are displayed in the rows and columns of the table.
Subsequent instructions describe an example of how an array of a structure is displayed in a table. As a preparation, create the MYSTRUCT DUT and the declarations in the PLC_PRG program.

```plaintext
TYPE MYSTRUCT :
  STRUCT
    iNo : INT;
    bOnStock : BOOL;
    strPartNumber : STRING;
  END_STRUCT
END_TYPE

PROGRAM PLC_PRG
VAR
  arrStruct : ARRAY[0..6] OF MYSTRUCT;
  iSelectedColumn : INT;
END_VAR

1. Drag the “Table” visualization element to the visualization editor.
2. Assign the array variable arrStruct to the “Data array” property.
   ⇒ The structure members are displayed as column headings and the array index as row headings.
3. Change the “Columns ➔ Column ➔ [0] ➔ Column header” property to an informative heading (example: Number).
5. Assign a color to the “Selection ➔ Selection color” property.
6. Define the “Selection ➔ Selection type” property as Row selection.
7. In the “Selection ➔ Variable for selected row” property, define the PLC_PRG.iSelectedColumn variable.
   ⇒ The following display results in online mode:

<table>
<thead>
<tr>
<th>Number</th>
<th>in Stock</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>FALSE</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>FALSE</td>
</tr>
<tr>
<td>2</td>
<td>0</td>
<td>FALSE</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>FALSE</td>
</tr>
</tbody>
</table>

See also
● Chapter 6.4.5.20.1.13 “Visualization Element ‘Table’” on page 3106

6.4.5.11.3 Configuring and Multiplying Visualization Elements as Templates

A table can also be created to display data arrays in the following way. You multiply a single element that has at least one property which is described by a structured variable. To do this, the single element is configured as a "template" and multiplied by means of a command.
You can use the “Visualization ➔ Multiply Visu Element” command to display array data in a visualization. The command multiplies a template element to create an element of the same type for each array component. The layout of the new elements in the visualization is one-dimensional as a row or column, or two-dimensional as a table.

To do this, drag an applicable element into the visualization editor. Then configure the properties of the element with array variables and specify the index access placeholder \$FIRSTDIM\$ as component access. If you have declared a multidimensional array, then you can use the second index access placeholder \$SECONDDIM\$ for the additional dimension. Configure the remaining properties as usual with the typical values. The purpose is to create a valid template element. Then execute the “Multiply Visu Element” command on the template element. Now the dialog with the same name opens. There you define in detail how many elements should be created and where they should be located.

After multiplying, the visualization contains as many of the same elements as are indexed using placeholders. In doing so, the settings in the “Multiply Visu Element” dialog are taken into consideration. All new elements in the properties that were preset with placeholders have these replaced with precise indexes. The remaining properties have been applied and copied without changes.

For example, you can have a layout of nine buttons as 3x3 tables, which are all the same size or the same color, but vary in the labeling. The labels are declared as a string array (nine components) and are passed as a value to the “Texts” ➔ “Text” property.

Valid template element:

- Declaration of array variables
  Example: asText: ARRAY[1..3, 1..3] OF STRING;
- Element with applicable element type
- Configuration of at least one property of the applicable element with array variables with index access placeholders
  Example: Property “Texts”, “Text” = PLC_PRG.asText\[$FIRSTDIM\$, \$SECONDDIM\$]
  This is possible for all properties that permit a variable as a value (for example, also properties from the “Animation” or “Input” categories. To configure multiple properties for an element with arrays and index access placeholders, all arrays must have the same structure with the same dimension. The declarations have to be compatible.
- Configuration of properties that do not vary (and are therefore the same for all generated elements) with the usual values without index access placeholders
  Example:
  sButtonTip : STRING := 'This element is created by multiplication'
  Property “Texts”, “Tooltip” = \%
  Property “Text variables”, “Tooltip variable” = sButtonTip

You can still use the placeholder \% as usual for the text display of variable values in the properties in “Texts”.

Applicable visualization elements

Visualization elements that can be multiplied:

- “Rectangle”
- “Rounded Rectangle”
- “Ellipse”
- “Line”
- “Polygon”
- “Polyline”
- “Bézier Curve”
- “Image”
- “Frame”
- “Button”
- “Pie”
1. Create a new standard project.
   ➔ A CODESYS Control Win V3 is configured as the device. The **MainTask** calls **PLC_PRG**. The implementation language is ST.

2. In **PLC_PRG** in the program code, declare array variables with basic data type **STRING**.
   ➔
   ```
   PROGRAM PLC_PRG
   VAR
       axLampIsOn: ARRAY[1..2,1..3] OF BOOL;  // For lamp, property 'variable' and button, user input
       asButtonText: ARRAY[1..2,1..3] OF STRING := // Output text
       for button, property 'text variables''text variable'
       [  '1A Lamp', '2A Lamp',
         '1B Lamp', '2B Lamp',
         '1C Lamp', '2C Lamp'
       ];
   END_VAR
   ```

3. Select the application in the device tree and click “Add Object ➔ Visualization”.

4. In the “Add Visualization” dialog, specify the name **VisuMain** and click “Add” to close the dialog.

5. Drag a “Lamp” element from the “Visualization Toolbox” view to the visualization.
6. Configure the fixed property values.

7. Double-click the value field of the “Variable” property.
   ⇒ The line editor opens.

8. Click \[\text{...}\].
   ⇒ The Input Assistant opens.

9. Select the array variable PLC_PRG.axLampIsOn from the variable tree.

10. Extend the string at the end, for example with ",s".
    ⇒ If you have activated SmartCoding (“Options” dialog, “SmartCoding” category, “List components immediately when typing” option), then the current variable list appears with the placeholders:

    ![Variable List](image)

11. Select the placeholder $\$FIRSTDIM$\$ for the first dimension and confirm the selection.

12. Extend the string at the end, for example with ",s".
    ⇒ The variable list appears again.

13. Select the placeholder $\$SECONDDIM$\$ for the second dimension and confirm the selection.

14. Complete the string with a closing bracket.
    ⇒ PLC_PRG.axLampIsOn[$\$FIRSTDIM$, $\$SECONDDIM$]

    The lamp is configured as a template.
15. Click “Visualization ➔ Multiply Visu Element”.
   ➞ The “Multiply Visu Element” dialog opens. The default values are derived from the array declarations.
   
   “Total number of elements”, “Horizontal” = 2
   “Total number of elements”, “Vertical” = 3

16. Declare the distance between the new elements.
   ➞ “Offset between elements”, “Horizontal” = 3
   “Offset between elements”, “Vertical” = 3

17. Check the advanced settings.

18. Click “OK” to confirm the selection.
   ➞ The new elements appear in the visualization editor. All properties are configured with a precise index and the array variables are indexed.

19. In the “Visualization Toolbox”, in the “Common Controls” category, drag the “Button” element to the visualization editor.
   ➞ The “Properties” view of the element opens.

20. Configure the fixed property values.
   ➤ PLC_PRG.asButtonText[\$FIRSTDIM\$, \$SECONDDIM\$]

   ➤ PLC_PRG.axLampIsOn[\$FIRSTDIM\$, \$SECONDDIM\$]

   The button is configured as a template.

23. Click “Visualization ➔ Multiply Visu Element”.
   ➤ The “Multiply Visu Element” dialog opens. The default values are derived from the array declarations.
   “Total number of elements”, “Horizontal” = 2
   “Total number of elements”, “Vertical” = 3

24. Declare the distance between the new elements.
   ➤ “Offset between elements”, “Horizontal” = 3
    “Offset between elements”, “Vertical” = 3

25. Check the advanced settings.

26. Click “OK” to confirm the selection.
   ➤ The new elements appear in the visualization editor. All properties are configured with a precise index and the array variables are indexed.
27. Build, start, and download the application.

 designate Visualization at runtime:

You can also configure the template element with array variables that have more than two dimensions, but you can only assign placeholders to a maximum of two of the dimensions. In the additional dimensions, the indexes are fixed.

**Declaration**

```
PROGRAM PLC_PRG
VAR
  asText: ARRAY[1..2, 1..3, 1..6, 1..2] OF STRING;
END_VAR
```

**Example**

```
Configure the “Text variables”, “Tooltip variable” property for the template element:
PLC_PRG.asText[2, $FIRSTDIM$, $SECONDDIM$, 2]
```
You can configure the template element with a one-dimensional array by means of the index access placeholder $FIRSTDIM$. If the number of new elements to be created is greater than five, then a tabular layout is preset in the "Multiply Visu Element" dialog. The layout of the new elements is as quadratic as possible.

**Example**

```plaintext
PROGRAM PLC_PRG
VAR
  asText: ARRAY[1..100] OF STRING;
END_VAR
```

The default setting in the "Multiply Visu Element" dialog allows for a layout of 100 new elements in a 10x10 field.

See also
- § Chapter 6.4.5.21.2.11 “Command 'Multiply Visu Element'” on page 3350
- § Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329
- Options for SmartCoding

### 6.4.5.12 Displaying data curve with trace
#### 6.4.5.12.1 General

With this element, you can integrate a trace graph in the visualization that monitors and displays variable values permanently. You configure the displayed trace graph in the element properties. In addition, you can add control elements that control the trace functionality. This is done manually or by using the “Insert Elements for Controlling Trace” command.

*Configurations for the 'Trace' visualization element can be taken from the 'Trace' object.*
See also

- Chapter 6.4.5.12.2 “Getting started with trace” on page 2926
- Chapter 6.4.5.21.2.15 “Command 'Insert Elements for Controlling Trace’” on page 3358
- Chapter 6.4.1.13.3 “Data Recording with Trace” on page 2007

### 6.4.5.12.2 Getting started with trace

Create a project with the following program PLC_PRG:

```plaintext
PROGRAM PLC_PRG
VAR
    iVar : INT;
    rSin : REAL;
    rVar : REAL;
END_VAR

iVar := iVar + 1;
iVar := iVar MOD 33;

rVar := rVar + 0.1;
rSin := 30 * SIN(rVar);
```

1. In the device tree, select the application and add a new visualization by clicking “Project ➔ Add Object ➔ Visualization”.
   ➔ The respective visualization editor opens.

2. Add the “Visualization” object to the device tree below “Application”.
   ➔ An empty visualization appears.

3. Open “Toolbox ➔ Special Controls”.

4. Drag the “Trace” element to the visualization editor.
   ➔ The element properties are displayed on the right side.
5. Click the symbol in the “Trace” property.  
   ⇒ The “Trace Configuration” dialog opens.

6. Click “Add Variable” to add an entry to the tree view of the trace configuration and select a project variable (for example, PLC_PRG.rSin).

7. Click the top node of the trace configuration.  
   ⇒ The group “Record Settings” is shown on the right.

8. Select the MainTask option for the “Task” setting.  
   Tip: The trace recording and the corresponding program should be executed in the same task.

9. Click “OK”.  
   ⇒ The task configuration is applied.

10. Select the trace element and click “Visualization ⇒ Add Elements for Trace Control”  
   ⇒ The “Trace Wizard” dialog opens. By default, all control elements are activated there.

11. Click “OK” to close the dialog.  
   ⇒ The control elements are added to the visualization and the control variables are declared. Then the control elements and the trace element are configured with the control variables.

12. Download the application to the controller and start it.

Example

The PLC_PRG program is running on the PLC. When you follow the "Getting Started" instructions, the following interface is displayed:

You can control the trace recording by clicking the buttons.
6.4.5.13 Displaying data curve with trend

6.4.5.13.1 General

A trend visualizes data that is used in the database of a trend recording. In contrast to the trace element, the trend element is particularly appropriate for long-term data recording.

The visualization of a trend encompasses the Trend element and the control elements. The three possible control elements can be seen in the illustration.

- Legend ①: Outputs the trend variables with values.
- Time range picker ②: Provides buttons for selecting predefined time ranges.
- Date range picker ③: encompasses control elements for navigation and zooming in the historical and current data on basis of the set date range.

A cursor is optionally available that enables the reading of a value at a certain time.

You can execute a trend visualization in the following clients:

- Target visualization
- Integrated visualization

See also

- Chapter 6.4.5.21.2.13 “Command 'Configure Trace'” on page 3355
- Chapter 6.4.5.21.3.19 “Dialog 'Display Settings'” on page 3391
- Chapter 6.4.5.20.1.34 “Visualization Element 'Trace'” on page 3240

6.4.5.13.2 Getting Started with Trend Visualization

When you execute a Trend, it is best to proceed with user guidance and the help of the trend wizard.
Development of a visualization with trend

1. Create an empty standard project and program at least one variable into PLC_PRG.
   - PLC_PRG is declared and implemented

2. Add the "Visualization" object to the device tree below "Application".
   - An empty visualization appears.

3. Open "Toolbox ➔ Special Control".

4. Drag the "Trend" element to the visualization
   - The "Trend Recording" dialog opens with the "Recording Settings".

5. Select the task in which the trend recording will be executed.
   - In general the trend recording runs in the same task as the main program, i.e. PLC_PRG.
   - Therefore, select MainTask.

6. Add a trend variable with "Add Variable" and assign an IEC variable from PLC_PRG to the trend variable.

7. Click "OK" to close "Trend Configuration".
   - There is a newly created object of the type Trend recording under "Trend Recording Manager". The active visualization contains a "Trend" element that is selected.

8. Click "Visualization ➔ Insert Elements for Controlling Trend Elements".
   - The "Trend Wizard" dialog box opens.

9. By default, all three control elements are activated in the dialog. Click "OK" to close the dialog box.
   - The active visualization contains a "Trend" with control elements.

10. Set the application containing the trend objects to active.

11. Compile the application with [F11].

12. Click "Online ➔ Login".

13. Start the application with [F5].
   - The target visualization appears. The visualization contains the trend diagram with the value curve of the variable. The control elements enable user inputs.

Example: Visualization of the sinusoidal trend of an IEC variable.

The following objects are implemented in the project:
- PLC_PRG
- Visualization_Trend1
- VisuWithTrend

Chapter 6.4.5.13.3 "Programming a Trend Visualization" on page 2931
Chapter 6.4.5.21.2.18 "Command 'Insert Elements for Controlling the Trend'" on page 3360
PLC_PRG runs as part of the application on the controller.

```plaintext
PROGRAM PLC_PRG
VAR
  iVar : INT;
  rSin : REAL;
  rVar : REAL;
END_VAR

iVar := iVar + 1;
iVar := iVar MOD 33;

rVar := rVar + 0.1;
rSin := 30 * SIN(rVar);
```

Visualization_Trend1 is the object that contains the configuration of the trend recording.
**VisuWithTrend** is the object that visualizes the trend.

The visualization contains four elements: one “Trend” and three control elements. The properties of the trend are defined as follows.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Trend recording”</td>
<td>Visualization_Trend1</td>
</tr>
<tr>
<td>“Display cursor”</td>
<td>![Checkmark]</td>
</tr>
<tr>
<td>“Display tool tip”</td>
<td>![Checkmark]</td>
</tr>
<tr>
<td>“Show frame”</td>
<td>![Checkmark]</td>
</tr>
<tr>
<td>“Date Range Picker”</td>
<td>Trend1DateRangeSelector</td>
</tr>
<tr>
<td>“Time Picker”</td>
<td>Trend1TimeSelector</td>
</tr>
<tr>
<td>“Legend”</td>
<td>Trend1Legend</td>
</tr>
</tbody>
</table>

**VisuWithTrend at runtime**

![Trend Visualization Image]

---

**6.4.5.13.3 Programming a Trend Visualization**

To display a trend recording in the visualization, you define which application provides which trend recording. You define the display by means of the “Properties” of the trend element and the controls used.
Defining the application and data source

The visualization task and the trend recording task generally run under the same application. If this is not the case, then the application containing the visualization task requires a data source manager.

1. Select a trend element in the active visualization editor.
   ⇒ The properties of the trend element are displayed on the right side.
2. Double-click the value field “Properties ➔ Application”.
3. Use the Input Assistant (assistant) to select the application. You can also specify the name of the application directly.

See also

● Trend Recording
● Data Source Manager

Adding a control

1. Select a trend element in the active visualization editor.
2. Click “Visualization ➔ Insert Elements for Trend Controlling”.
   ⇒ The “Trend Wizard” dialog opens.
   ⇒ The selected controls are inserted for the trend element. You can move them to any position you like. In the “Properties” of the trend element, the controls are shown below “Assigned controls”.

See also

● Chapter 6.4.5.21.2.18 “Command ‘Insert Elements for Controlling the Trend’” on page 3360

Defining the trend recording to visualize

1. Select a trend element in the active visualization editor.
   ⇒ The properties of the trend element are displayed on the right side.
2. Click the value field of “Properties ➔ Trend recording”
   ⇒ “Select trend recording” is displayed. The trend recordings available application-wide are listed under “Available trend recordings”.
3. Select a trend record below “Available trend recordings”.
4. Click .
   ⇒ The trend recording is located under “Selected trend recording”.
5. Click “OK” to confirm the entry.
   ⇒ The selected trend recording is listed in “Values” in “Properties ➔ Trend recording”.

See also

● Trend Recording
Removing a control

A control that was added with the help of the “Trend Wizard” cannot be deleted via the Trend wizard dialog.

1. Select a control of a trend in the active visualization editor.
2. Press [Del] or “Delete” to delete the element.
3. Select the trend in the active visualization editor.
4. Delete the assigned value in “Properties ➔ Assigned controls ➔ <control>”.

**NOTICE!**
It is absolutely necessary to delete this reference manually. The property is not deleted automatically by deleting the control.

Configuring the coordinate system of the trend diagram

1. Select a trend in the active visualization editor.
2. Use the “Visualization ➔ Configure Trend Display Settings” command.
   ⇒ The “Display Settings” dialog opens.
3. Adapt the settings as needed.

See also
- Chapter 6.4.5.21.2.18 “Command 'Insert Elements for Controlling the Trend’” on page 3360

Reading a trend value at runtime

1. Open “View ➔ Element Properties”.
2. Select a trend element in your visualization.
   ⇒ The properties of the trend element are displayed on the right side.
3. Select the “Properties ➔ Show cursor” option and “Show tooltip”.
   ⇒ A cursor is drawn in the coordinate system.
4. Select the “Properties ➔ Show tooltip” option.
5. Download the application to the controller and start the application.
6. If the diagram "runs", then the date range has been placed in such a way that its end time is the current time.

Select the date range so that the diagram does not run. If necessary, drag the scroll bar to an earlier date range.
⇒ A cursor is available. The tooltip of the cursor informs you of the trend values. For each trend variable, the legend displays the value at the point in time at which the cursor is positioned.
Deleting the trend recording history

You can insert an input element in the visualization which the operator can use to delete the previous value recording in the trend visualization at runtime. The curve displayed until then is removed and the display starts over.

1. In the application (example: in the program PLC_PRG), implement the following code:

   ```
   itfTrendRecording : ITrendRecording;
   itfTrendStorageWriter : ITrendStorageWriter;
   itfTrendStorageWriter3 : ITrendStorageWriter3;
   sTrendRecordingName : STRING := 'TrendRecording';
   itfTrendRecording :=
   GlobalInstances.g_TrendRecordingManager.FindTrendRecording(ADR(sTrendRecordingName));
   xClearHistoryTrend: BOOL;

   IF xClearHistoryTrend THEN
     itfTrendRecording :=
     GlobalInstances.g_TrendRecordingManager.FindTrendRecording(ADR(sTrendRecordingName));
     IF itfTrendRecording <> 0 THEN
       itfTrendStorageWriter :=
       itfTrendRecording.GetTrendStorageWriter();
       IF __QUERYINTERFACE(itfTrendStorageWriter, itfTrendStorageWriter3) THEN
         itfTrendStorageWriter3.ClearHistory();
         END_IF
     END_IF
   END_IF
   ```

2. In the visualization of the trend recording, add a button for deleting the previous curve. Configure its "Toggle" property with the variable PLC_PRG.xClearHistoryTrend.

   ➔ When xClearHistoryTrend is set to TRUE, the previously recorded curve is deleted. The recording immediately starts again.

6.4.5.14 Displaying and Editing Text Files

6.4.5.14.1 General.......................................................................................... 2934
6.4.5.14.2 Configuring the Display of a Text File............................................ 2934
6.4.5.14.3 Configuring the Editing of a Text File............................................. 2937

6.4.5.14.1 General

With the help of the element “Text Editor” you can display a text file in the user interface and optionally also enable the user to edit the file.

6.4.5.14.2 Configuring the Display of a Text File

In order to display a text file that is located on the controller, you need not only the element “Text Editor”, but also control elements for selecting, opening and closing the file. Optionally a text search function can be set up in the file with further control elements.

Example:
1. Drag an element “Text Editor” into the visualization editor.
2. Declare the control variables for the element, for example as global variables in the GVL object.
   ⇒ Refer to the declaration of the control variables for this.
3. For the “Text Editor”, configure the property “Editing mode” with “Read only”.
4. Also configure the property “Control variables”.
   Assign the following variables there:
   - “Control variables ➔ File ➔ Variable” with g_sFileName
   - “Control variables ➔ File ➔ Open” with g_bFileOpen
   - “Control variables ➔ File ➔ Close” with g_bFileClose
   - “Control variables ➔ File ➔ New ➔ Variable” with g_bFileNew
   - “Control variables ➔ File ➔ Save ➔ Variable” with g_bFileSave
   - “Control variables ➔ Edit ➔ Variable” with g_sEditSearchFor
   - “Control variables ➔ Edit ➔ Find” with g_bEditFind
   - “Control variables ➔ Edit ➔ Find next occurrence” with g_bEditFindNext
VAR_GLOBAL

VAR_GLOBAL

g_sFileName: STRING := 'Readme.txt';
g_bFileOpen : BOOL;
g_bFileClose: BOOL;
g_bFileNew: BOOL;
g_bFileSave: BOOL;
g_sEditSearchFor : STRING;
g_bEditFind : BOOL;
g_bEditFindNext : BOOL;

END_VAR

Configuring control elements for the file selection

1. Add an element “Label”.
2. Configure the property “Texts ➔ Text” with File:
3. Add an element “Rectangle” next to it, in which the user can then enter the file name:
4. Configure the property “Texts ➔ Text” with %s:
5. Configure the property “Texts ➔ Text variable” with g_sFileName.
6. Configure the property “Input configuration ➔ OnMouseclick” with “Write a variable”. In the dialog “Input Configuration”, select “Text input” as the “Input type”. Activate the option “Use text output variable”.
   ⇒ The rectangle for the input of the file name is configured.
7. Add an element “Button” for opening the file.
8. Configure the property “Texts ➔ Text” with Open:
9. Configure the property “Input configuration ➔ OnMouseclick” with “Toggle a variable”.
   Assign g_bFileOpen as a variable.
   ⇒ The button Open is configured.
10. Add a further element “Button” for closing the file.
11. Configure the property “Texts ➔ Text” with Close:
12. Configure the property “Input configuration ➔ OnMouseclick” with “Toggle a variable”.
   Assign g_bEditFile as a variable.
   ⇒ The button Close is configured.

Control elements for searching for a text.

1. Add an element “Label”.
2. Configure the property “Texts ➔ Text” with Text:
3. Alongside it, add an element “Rectangle” for the input of the text to be found.
4. Configure the property “Texts ➔ Text” with %s:
5. Configure the property “Texts ➔ Text variable” with g_sEditSearchFor.
6. Configure the property “Input configuration ➔ OnMouseclick” with “Write a variable”. In the dialog “Input Configuration”, select “Text input” as the “Input type”. Activate the option “Use text output variable”.
   ⇒ The rectangle is configured.
7. Add an element “Button” for starting the search.
8. Configure its property “Texts ➔ Text” with Find.
9. Configure the property “Input configuration ➔ OnMouseclick” with “Toggle a variable”.
Assign g_bEditFind as a variable.

10. Also add the action “Execute ST-Code”.
Program the action with: g_bEditFind := FALSE;
⇒ The button is configured.

11. Add a further element “Button”.

12. Configure the property “Texts ➔ Text” with “Find next”.

13. Configure the property “Input Configuration ➔ OnMouseclick” with “Toggle a variable”.
Assign g_bEditFind as a variable.

14. Also add the action “Execute ST code”.
Program: g_bEditFindNext := TRUE;
⇒ The button is configured.

See also
- Chapter 6.4.5.20.1.41 “Visualization Element 'Text Editor’” on page 3274

6.4.5.14.3 Configuring the Editing of a Text File

In order to be able to create a new text file or edit an existing one on the controller with the “Text Editor” in the user interface, you need not only the element “Text Editor”, but also control elements for selecting, opening, closing, saving and creating a file.

Example:

1. Drag an element “Text Editor” into the visualization editor.
2. Declare the control variables for the element, for example as global variables in the GVL object.
⇒ Refer below to the declaration of the control variables for this.
3. For the “Text Editor”, configure the property “Editing mode” with “Read/Write”.
4. Also configure the property “Control variables”.
Assign the following variables there:
- “Control variables ➔ File ➔ Variable” with g_sFileName
- “Control variables ➔ File ➔ Open” with g_bFileOpen
- “Control variables ➔ File ➔ Close” with g_bFileClose
- “Control variables ➔ File ➔ Save” with g_bFileSave
- “Control variables ➔ File ➔ New” with g_FileNew

VAR_GLOBAL

<table>
<thead>
<tr>
<th>Variable</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>g_sFileName: STRING := 'Readme.txt';</td>
<td>STRING</td>
</tr>
<tr>
<td>g_bFileOpen : BOOL;</td>
<td>BOOL</td>
</tr>
<tr>
<td>g_bFileClose: BOOL;</td>
<td>BOOL</td>
</tr>
<tr>
<td>g_bFileSave: BOOL;</td>
<td>BOOL</td>
</tr>
<tr>
<td>g_FileNew: BOOL;</td>
<td>BOOL</td>
</tr>
<tr>
<td>g_usiErrorHandlingVarForErrorCode: USINT;</td>
<td>USINT</td>
</tr>
<tr>
<td>g_bVarForContentChanged : BOOL;</td>
<td>BOOL</td>
</tr>
<tr>
<td>g_bVarForReadWriteMode: BOOL;</td>
<td>BOOL</td>
</tr>
<tr>
<td>END_VAR</td>
<td></td>
</tr>
</tbody>
</table>

Configuring control elements for file selection

1. Add an element “Label”.
2. Configure it in the property “Texts ➔ Text” with File:
3. Add an element “Rectangle” next to it.
4. Configure its property “Texts ➔ Text” with %s.
5. Configure its property “Texts ➔ Text variable” with g_sFileName.
6. Configure the property “Input configuration ➔ OnMouseclick” with “Write a variable”.
   In the dialog “Input Configuration”, select “Text input” as the “Input type”.
   Activate the option “Use text output variable”.
   ➔ The rectangle for the input of the file name is configured.
7. Add an element “Button”.
9. Configure the property “Input configuration ➔ OnMouseclick” with “Toggle a variable”.
    Assign g_bFileNew as a variable.
   ➔ The button New is configured.
10. Add a further element “Button”.
11. Configure the property “Texts ➔ Text” with Open:
12. Configure the property “Input configuration ➔ OnMouseclick” with “Toggle a variable”.
    Assign g_bFileOpen as a variable.
   ➔ The button Open is configured.
13. Add a further element “Button”.
15. Configure the property “Input configuration ➔ OnMouseclick” with “Toggle a variable”.
    Assign g_bFileSave as a variable.
   ➔ The button Save is configured.
16. Add a further element “Button”.
17. Configure its property “Texts ➔ Text” with Close.
18. Configure the property “Input configuration ➔ OnMouseclick” with “Toggle a variable”.
   Assign g_bEditFile as a variable.
   ⇒ The button Close is configured.

See also
- Chapter 6.4.5.20.1.41 “Visualization Element ‘Text Editor’” on page 3274

6.4.5.15 Configuring a variable assignment with unit conversion

A variable that was assigned in a visualization can be linked with a unit conversion. This causes the variable value to be converted according to a predefined rule and the result is edited in the visualization.

You have already configured the conversion rules in the editor of an object of the type “Unit Conversion”.

See also

- Requirement: A project with a visualization is open. In addition, the application contains the object UnitConversion with the rule convert_A.

1. Select an element.
   ⇒ The view “Properties” opens.

2. When assigning a variable, link the variable iVar_A with a rule of the unit conversion:
   convert_A.convert(iVar_A)

3. Compile, load and start the application.
   ⇒ The application runs. The visualization opens. The unit conversion is applied.

6.4.5.16 Using recipes in visualization elements

You can manage and use the recipes created in CODESYS by means of a visualization. For this purpose, the input configuration of a visualization element provides the following commands:

- “Read Recipe”
- “Write Recipe”
- “Load Recipe from File”
- “Save Recipe to File”
- “Create Recipe”
- “Delete Recipe”

See also

- Chapter 6.4.1.13.2.4 “Changing Values with Recipes” on page 2003
- Chapter 6.4.5.21.3.6 “Dialog ‘Input Configuration’” on page 3370
Example: Loading recipes by means of visualization elements

Requirement: The “Visualization” object is added to the project.

1. Create a recipe according to the instructions in the section "Changing Values with Recipes - Creating Recipes".
   Assign the following names:
   - Recipe definition: "Recipes"
   - Recipes: "Recipe1" and "Recipe2"
   - Variables: iValue1 and iValue2
   Type in different variable values of both recipes.

2. Open the “Visualization” object in the editor.

3. Drag a “Button” element to the visualization. Label it "Load Recipe 1". You can specify the text by double-clicking the element or in the “Texts ➔ Text” property.

4. Click the value field of the “Input configuration”: “OnMouseDown” property.
   ➔ The “Input Configuration” dialog box opens.

5. Select “Execute command” in the left of the left side and click the button ➔ The configuration of the “Internal command” opens on the right side of the dialog.

6. Select the “Write Recipe” command from the drop-down list.

7. Click the button.
   ➔ The “WriteRecipe” command is added to the list.

8. Specify the first parameter as Recipes and the second parameter as Recipe1.

9. Click “OK” to close the dialog box.

10. Drag a second button to the visualization, name it "Load Recipe 2", and repeat steps 4 to 8. For step 7, specify Recipe2 as the second parameter.

11. Load the program to the controller and start it Click the “Load Recipe 1” and “Load Recipe 2”, and monitor the variables iValue1 and iValue2.

   The other recipe commands are assigned to visualization elements as described in this example. Refer to the help page of the input configuration for a description of the internal commands.

6.4.5.17 Creating a structured user interface

6.4.5.17.1 General

You can reference visualizations that are available or exist in the project in another visualization and thus reuse them. You obtain a structured user interface that consists of several visualizations. In principle you have the following possibilities to reference visualizations.

On the one hand you can display visualizations within a main visualization and toggle between them. The element “Frame” or “Tabs” serves here as a window area element that defines the display area for the referenced visualizations.

On the other hand you can configure a user input for a visualization that causes another visualization to open as a dialog. The requirements for this is that it has the visualization type “Dialog”. A dialog is used to collect inputs from the user.

In addition, you can declare an interface for a visualization that is to be referenced in order to vary the display of the visualization at runtime. A visualization is thereby instanced with different data and executed.
6.4.5.17.2 Displaying Multiple Visualizations in One Visualization

You can reference other visualizations within a main visualization either in a “Frame” or a “Tabs” element, and then display them in the window pane of the element.

In the case of the “Frame” element, you can freely program which of the visualizations is displayed at which time. One option is to use the switch frame variable of the “Frame” element, which automatically triggers a switch according to its value. You can also program additional controls which, after user input, trigger input actions that result in switching a visualization.

NOTICE!

Visualizations can be nested at any depth by means of “Frame” elements. In order to use the “Switch to any visualization” frame selection type without any problems, a “Frame” must not contain more than 21 referenced visualizations.

For more information, see also the description for the “Input configuration” of an element: Action “Switch frame visualization”.

Moreover, you can use the “Tabs” to reference visualizations. It is easy and advantageous that the “Tabs” element provides preconfigured control of the visualization switch.

In CODESYS Forge, you will find the sample project "Visualization Switching". There you will see a visualization that displays other visualizations in a frame area one after another at runtime. The visualization switch is controlled either by the user, programmatically, or via the FrameManager.

See also

- Sample project in CODESYS Forge

Switching frame visualizations by means of a variable

<table>
<thead>
<tr>
<th>Connecting frame visualizations with a radio buttons element</th>
<th>In the main visualization, the “Frame” element displays one of the referenced frame visualizations at runtime. The user can select the “Radio Buttons” element which is displayed in the frame.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Create a new standard project in CODESYS.</td>
<td>1. Create a new standard project in CODESYS.</td>
</tr>
<tr>
<td>2. Select the application in the device tree and click “Add Object ➔ Visualization”.</td>
<td>2. Select the application in the device tree and click “Add Object ➔ Visualization”.</td>
</tr>
<tr>
<td>3. In the “Add Visualization” dialog, specify the name VisuMain and click “Add” to close the dialog.</td>
<td>3. In the “Add Visualization” dialog, specify the name VisuMain and click “Add” to close the dialog.</td>
</tr>
<tr>
<td>4. Select the application in the device tree and click “Add Object ➔ Visualization”.</td>
<td>4. Select the application in the device tree and click “Add Object ➔ Visualization”.</td>
</tr>
<tr>
<td>5. In the “Add Visualization” dialog, specify the name Visu1 and click “Add” to close the dialog.</td>
<td>5. In the “Add Visualization” dialog, specify the name Visu1 and click “Add” to close the dialog.</td>
</tr>
<tr>
<td>6. Select the application in the device tree and click “Add Object ➔ Visualization”.</td>
<td>6. Select the application in the device tree and click “Add Object ➔ Visualization”.</td>
</tr>
<tr>
<td>7. In the “Add Visualization” dialog, specify the name Visu2 and click “Add” to close the dialog.</td>
<td>7. In the “Add Visualization” dialog, specify the name Visu2 and click “Add” to close the dialog.</td>
</tr>
<tr>
<td>8. Select the application in the device tree and click “Add Object ➔ Visualization”.</td>
<td>8. Select the application in the device tree and click “Add Object ➔ Visualization”.</td>
</tr>
<tr>
<td>9. In the “Add Visualization” dialog, specify the name Visu3 and click “Add” to close the dialog.</td>
<td>9. In the “Add Visualization” dialog, specify the name Visu3 and click “Add” to close the dialog.</td>
</tr>
<tr>
<td>⇒ In addition to the main visualization, there are three more visualization objects.</td>
<td>In addition to the main visualization, there are three more visualization objects.</td>
</tr>
<tr>
<td>10. Open the Visu1 object.</td>
<td>10. Open the Visu1 object.</td>
</tr>
</tbody>
</table>
11. In the “Visualization Toolbox”, in the “Basic” category, select and drag the “Radio Buttons” element to the visualization editor.
   ⇒ The “Properties” view of the element opens.

12. Configure the properties of the rectangle as follows:
   - Property “Texts”, “Text” = Visu1
   - Property “Text properties”, “Font” = “Title”
   - Property “Colors”, “Normal state”, “Fill color” = “Light gray”

13. Program the object Visu2 accordingly.
   Properties of the rectangle:
   - Property “Texts”, “Text” = Visu2
   - Property “Text properties”, “Font” = “Title”
   - Property “Colors”, “Normal state”, “Fill color” = “Gray”

14. Program the object Visu3 accordingly.
   Properties of the rectangle:
   - Property “Texts”, “Text” = Visu3
   - Property “Text properties”, “Font” = “Title”
   - Property “Colors”, “Normal state”, “Fill color” = “Dark gray”

15. Open the VisuMain object.

16. In the “Visualization Toolbox”, in the “Basic” category, select and drag the “Frame” element to the visualization editor.
   ⇒ The “Frame Configuration” dialog opens.

17. In the “Available Visualizations” window area, on the “By Visualization Name” tab, select the object Visu1. In “Selected Visualizations”, click “Add”.

18. Then select the object Visu2 and click “Add” in “Selected Visualizations”.

19. Then select the object Visu3 and click “Add” in “Selected Visualizations”.
20. Click “OK” to exit the dialog.

Now the “Frame” element references the three selected visualizations. The references (1) are listed in the “References” property in the element properties of the “Frame” element. In addition to the visualization name, the corresponding index value (2) is also displayed.

Note: You can open the dialog when you click the “Configure” button in the value field of the “References” property. See (3). You can influence the index by means of the visualization order in the “Selected Visualizations” list.

21. In the “Visualization Toolbox”, in the “Common Controls” category, drag the “Radio Buttons” element to the visualization editor.

The “Properties” view of the element opens.

22. In the “Radio button settings”, “Radio button”, click the “Create new” button.

This element has three switches to select from.
23. Configure the properties of the radio button as follows:
   - Property “Radio button settings”, “Areas”, “[0]”, “Text” = Visu1
   - Property “Radio button settings”, “Areas”, “[1]”, “Text” = Visu2
   - Property “Radio button settings”, “Areas”, “[2]”, “Text” = Visu3

24. In the PLC_PRG program, declare a local variable for the number of the visualization that is active.

   ```
   VAR
       iActiveVisu : INT; // Index of visu activated by the user
   END_VAR
   ```

25. Select the “Radio Buttons” element. In the value field of the “Variable” property, click [ ].

26. In the “Input Assistant” dialog, select the recently declared variable. Then exit the dialog.

   - Property of the “Radio Buttons” element:
     - Property “Variable” = PLC_PRG.iActiveVisu

27. Select the “Frame” element. Click in the value field of the “Switch frame variable”, “Variable” property. Specify the recently declared variable here as well.

   - Property of the “Frame” element:
     - Property “Switch frame variable”, “Variable” = PLC_PRG.iActiveVisu

   The control variable of the “Radio Buttons” element is also the switch frame variable of the “Frame” element. User input for the “Radio Buttons” element switches the frame visualization.

28. Click “Build ➔ Generate Code”.
29. Click “Online ➔ Login” and start the application.

- The visualization starts. One of the referenced visualizations is running in the frame. When you click an unselected option of the “Radio Buttons” element, the visualization switches the contents in the frame to the desired visualization.

In the example, the switch frame variable is connected to an input variable. Instead, you can also set the switch frame variable programmatically in the IEC code.

### Switching frame visualizations by means of a follow-up action

- In the main visualization, the “Frame” element displays one of the frame visualizations at runtime. The user can use buttons to control the display in the frame. The user input triggers the “Switch frame visualization” input action.

### Programming a visualization

1. Create a new standard project in CODESYS.
2. Select the application in the device tree and click “Add Object ➔ Visualization”.
3. In the “Add Visualization” dialog, specify the name VisuMain and click “Add” to close the dialog.
4. Select the application in the device tree and click “Add Object ➔ Visualization”.
5. In the “Add Visualization” dialog, specify the name Visu1 and click “Add” to close the dialog.
6. Select the application in the device tree and click “Add Object ➔ Visualization”.

---
7. In the “Add Visualization” dialog, specify the name Visu2 and click “Add” to close the dialog.

8. Select the application in the device tree and click “Add Object ➔ Visualization”.

9. In the “Add Visualization” dialog, specify the name Visu3 and click “Add” to close the dialog.
   ⇒ In addition to the main visualization, there are three more visualization objects.

10. Open the Visu1 object.

11. In the “Visualization Toolbox”, in the “Basic” category, select and drag the “Rectangle” element to the visualization editor.
   ⇒ The “Properties” view of the element opens.

12. Configure the properties of the rectangle as follows:
   ● Property “Texts”, “Text” = Visu1
   ● Property “Text properties”, “Font” = “Title”
   ● Property “Colors”, “Normal state”, “Fill color” = “Light gray”

13. Program the object Visu2 accordingly.
   ⇒ Properties of the rectangle:
   ● Property “Texts”, “Text” = Visu2
   ● Property “Text properties”, “Font” = “Title”
   ● Property “Colors”, “Normal state”, “Fill color” = “Gray”

14. Program the object Visu3 accordingly.
   ⇒ Properties of the rectangle:
   ● Property “Texts”, “Text” = Visu3
   ● Property “Text properties”, “Font” = “Title”
   ● Property “Colors”, “Normal state”, “Fill color” = “Dark gray”

15. Open the VisuMain object.

16. In the “Visualization Toolbox”, in the “Basic” category, select and drag the “Frame” element to the visualization editor.
   ⇒ The “Frame Configuration” dialog opens.

17. In the “Available Visualizations” window area, on the “By Visualization Name” tab, select the object Visu1. In “Selected Visualizations”, click “Add”.

18. Then select the object Visu2 and click “Add” in “Selected Visualizations”.

19. Then select the object Visu3 and click “Add” in “Selected Visualizations”.

Configuration and programming
Programming with CODESYS ➔ CODESYS Visualization
20. Click “OK” to exit the dialog.

⇒ Now the “Frame” element references the three selected visualizations. The references (1) are listed in the “References” property in the element properties of the “Frame” element. In addition to the visualization name, the corresponding index value (2) is also displayed.

![Frame element references three visualizations](image)

Note: You can open the dialog independently when you click the “Configure” button in the value field of the “References” property. See (3). You can influence the index by means of the visualization order in the “Selected Visualizations” list.

21. In the “Visualization Toolbox”, in the “Common Controls” category, drag the “Button” element to the visualization editor.

⇒ The element is selected and its properties are visible in the “Properties” view.


23. In the “Input configuration” “OnMouseDown” property, click “Configure”.

⇒ The “Input Configuration” dialog opens.

24. Select the “Switch frame visualization” action and click .

⇒ The action is displayed in the window on the right.

25. Configure the action:

- Select the “Switch local visualization” option.
- Set the “Visualization selection” to Visu1.
- Click “OK” to exit the dialog.

⇒ The follow-up action is configured in the “Input configuration” property.

Property “Input configuration”, “OnMouseDown”, “Switch frame visualization” = 0
26. Drag another “Button” element to the visualization editor. Configure the button accordingly.
   ➔ Properties of the button:
   ● Property “Texts”, “Text” = Visu2
   ● Property “Input configuration”, “OnMouseDown”, “Switch frame visualization” = 1

27. Drag another “Button” element to the visualization editor. Configure the button accordingly.
   ➔ Properties of the button:
   ● Property “Texts”, “Text” = Visu3
   ● Property “Input configuration”, “OnMouseDown”, “Switch frame visualization” = 2

28. Click “Build ➔ Generate Code”.

29. Click “Online ➔ Login” for the device and start the application.
   ➔ The visualization starts. One of the referenced visualizations is running in the frame. When you click one of the buttons, the visualization switches the contents in the frame to the respective visualization.

For the “Tabs”, the navigation of the referenced visualizations is provided automatically. The first of the referenced visualizations is in the foreground, while the others are hidden behind it. The user can navigate between them by means of the tabs which are provided automatically.

1. Create a new standard project in CODESYS.
2. Select the application in the device tree and click “Add Object ➔ Visualization”.

Displaying visualizations on a tabs element
Configuring a tabs element
3. In the “Add Visualization” dialog, specify the name VisuMain and click “Add” to close the dialog.
4. Select the application in the device tree and click “Add Object ➔ Visualization”.
5. In the “Add Visualization” dialog, specify the name Visu1 and click “Add” to close the dialog.
6. Select the application in the device tree and click “Add Object ➔ Visualization”.
7. In the “Add Visualization” dialog, specify the name Visu2 and click “Add” to close the dialog.
8. Select the application in the device tree and click “Add Object ➔ Visualization”.
9. In the “Add Visualization” dialog, specify the name Visu3 and click “Add” to close the dialog.

In addition to the main visualization, there are three more visualization objects.

10. Open the Visu1 object.
11. Drag a “Rectangle” element to the visualization editor.

The “Properties” view of the element opens.

12. Configure the properties of the rectangle as follows:
   - Property “Texts”, “Text” = Visu1
   - Property “Text properties”, “Font” = “Title”
   - Property “Colors”, “Normal state”, “Fill color” = “Light gray”

13. Program the object Visu2 accordingly.

   Properties of the rectangle:
   - Property “Texts”, “Text” = Visu2
   - Property “Text properties”, “Font” = “Title”
   - Property “Colors”, “Normal state”, “Fill color” = “Gray”

14. Program the object Visu3 accordingly.

   Properties of the rectangle:
   - Property “Texts”, “Text” = Visu3
   - Property “Text properties”, “Font” = “Title”
   - Property “Colors”, “Normal state”, “Fill color” = “Dark gray”

15. Open the VisuMain object.
16. In the “Visualization Toolbox”, in the “Basic” category, select and drag the “Frame” element to the visualization editor.

   The “Frame Configuration” dialog opens.
17. In the “Available Visualizations” window area, on the “By Visualization Name” tab, select the object Visu1. In “Selected Visualizations”, click “Add”.

18. Then select the object Visu2 and click “Add” in “Selected Visualizations”.

19. Then select the object Visu3 and click “Add” in “Selected Visualizations”.

20. Click “OK” to exit the dialog.

Now the “Tabs” element references the three selected visualizations. The references (1) are listed in the “References” property in the element properties of the “Frame” element. In addition to the visualization name, the corresponding index value (2) is also displayed.

Note: You can open the dialog “Frame Configuration” dialog independently when you click the “Configure” button in the value field of the “References” property. See (3). You can influence the index by means of the visualization order in the “Selected Visualizations” list.

21. In the “Visualization Toolbox”, in the “Common Controls” category, drag the “Tabs” element to the visualization editor.

The “Properties” view of the element opens.
22. Configure the properties of the tab as follows:

- Property “Tab width”: 40
- Property “References”, Visu1, “Header” = Visu1
- Property “References”, Visu2, “Header” = Visu2
- Property “References”, Visu3, “Header” = Visu3

23. Click “Build ➔ Generate Code”.

24. Click “Online ➔ Login” for the device and start the application.

→ The visualization starts. One of the referenced visualizations is running in the “Tabs” element. Click the tab to switch to the respective visualization.

---

See also

- “Dialog ‘Frame Configuration’” on page 3348
- Chapter 6.4.5.20.1.6 “Visualization Element ‘Frame’” on page 3053
- Chapter 6.4.5.20.1.10 “Visualization Element ‘Tabs’” on page 3084

---

6.4.5.17.3 Calling a Visualization with an Interface

You can declare an interface for parameters for a visualization that is to be referenced. The actual parameters are passed to the interface (similar as in the case of a function block) when the visualization is called at runtime.
First of all, declare the interface variables in the visualization interface editor. Then configure the parameters that are transferred to the interface by assigning a data-type-compliant application variable to each interface variable. The assignment is configured in the “References” property in the case of a “Frame” or a “Tabs”.

Depending on the display variant, the parameter transfer of local variables (with the VAR scope) is limited. If you execute the visualization as an integrated visualization, you can only transfer local variables having a basic data type as parameters. If the visualization is called as CODESYS TargetVisu or CODESYS WebVisu, then you can also transfer parameters with a user-defined data type.

### User-controlled update of the transfer parameters

If you have configured visualization references and then save a change to the variable declaration for one of these visualizations in an interface editor, then the “Updating the Frame Parameters” dialog appears automatically. The dialog prompts you to edit the references. A list of all the visualizations affected is displayed there, so that the parameter transfers can be reassigned at the changed interface.

When the dialog is closed, the changes are accepted and the elements affected are displayed in the “References” property.

### Calling visualization with interface (VAR_IN_OUT)

- Requirement: The project contains a visualization and a main visualization. The main visualization contains an element that the visualization references.

1. Open the visualization.
2. Click “Visualization ➔ Interface Editor”.
3. Declare a variable in the interface editor.
   - The visualization has an interface and the “Updating the Frame Parameters” dialog appears.
4. Assign a type-compliant transfer parameter to the interface variables in all calls by entering an application variable in “Value”. Close the dialog.
   - A transfer parameter is assigned at the points where the visualization is to be referenced. These now appear in the main visualization in the “References” property.
The `visPie` visualization contains an animated, colored pie. The `visMain` main visualization calls the `visPie` visualization multiple times in a “Tabs” control. Color information, angle information, and label are transferred via the `pieToDisplay` interface variable. The pies vary at runtime.

Visualization `visPie`:

```
Table 622: Properties of the “Pie” element:

| “Variable for begin”      | pieToDisplay.iStart          |
| “Variable for end”        | pieToDisplay.iEnd            |
| “Texts ➔ Text”            | %s                           |
| “Text variables ➔ Text variable” | pieToDisplay.sLabel      |
| “Color variable ➔ Normal state” | pieToDisplay.dwColor |

VAR_IN_OUT
pieToDisplay : DATAPIE;
END_VAR
```

Main visualization `visMain`:

```
Table 623: Properties of the “Tabs” element:

<table>
<thead>
<tr>
<th>“References”</th>
<th>“visPie”</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Heading”</td>
<td>A</td>
</tr>
<tr>
<td>pieToDisplay</td>
<td>PLC_PRG.pieA</td>
</tr>
<tr>
<td>“visPie”</td>
<td>B</td>
</tr>
<tr>
<td>“Heading”</td>
<td>B</td>
</tr>
<tr>
<td>pieToDisplay</td>
<td>PLC_PRG.pieB</td>
</tr>
<tr>
<td>“visPie”</td>
<td>C</td>
</tr>
<tr>
<td>“Heading”</td>
<td>C</td>
</tr>
<tr>
<td>pieToDisplay</td>
<td>PLC_PRG.pieC</td>
</tr>
</tbody>
</table>
```

Example
DATAPIE (STRUCT) TYPE DATAPIE : // Parameter type used in visPie
  STRUCT
    dwColor : DWORD; // Color data
    iStart : INT; // Angle data
    iEnd : INT;
    sLabel : STRING;
  END_STRUCT
END_TYPE

GVL {attribute 'qualified_only'}
VAR_GLOBAL CONSTANT
  c_dwBLUE : DWORD := 16#FF0000FF; // Highly opaque
  c_dwGREEN : DWORD := 16#FF00FF00; // Highly opaque
  c_dwYELLOW : DWORD := 16#FFFF0000; // Highly opaque
  c_dwGREY : DWORD := 16#88888888; // Semitransparent
  c_dwBLACK : DWORD := 16#00000000; // Highly opaque
  c_dwRED : DWORD := 16#FFFF0000; // Highly opaque
END_VAR

PLC_PRG PROGRAM PLC_PRG
VAR
  iInit: BOOL := TRUE;
  pieA : DATAPIE; // Used as argument when visPie is called
  pieB : DATAPIE;
  pieC : DATAPIE;
  iDegree : INT; // Variable center angle for the pie element
  used for animation
END_VAR

IF iInit = TRUE THEN
  pieA.dwColor := GVL.c_dwBLUE;
  pieA.iStart := 0;
  pieA.sLabel := 'Blue';
  pieB.dwColor := GVL.c_dwGREEN;
  pieB.iStart := 22;
  pieB.sLabel := 'Green';
  pieC.dwColor := GVL.c_dwYELLOW;
  pieC.iStart := 45;
  pieC.sLabel := 'Yellow';
  iInit := FALSE;
END_IF

iDegree := (iDegree + 1) MOD 360;

pieA.iEnd := iDegree;
pieB.iEnd := iDegree;
pieC.iEnd := iDegree;

Main visualization visMain at runtime:
Printing the instance name of a transfer parameter

In order to obtain and output the instance name of a transfer parameter, you can implement an interface variable (data type STRING) with the pragma {attribute 'parameterstringof'} in the VAR_INPUT scope.

The project contains a visualization and a main visualization. The main visualization contains elements that the visualization references.

1. Open the visualization.
2. Click “Visualization ➔ Interface Editor”.
3. Declare an interface variable (VAR_IN_OUT).
   pieToDisplay : DATAPIE;
4. In the interface editor, declare a variable (VAR_INPUT) with attribute {attribute 'parameterstringof'}.
   {attribute 'parameterstringof' := 'pieToDisplay'}
   sNameToDisplay : STRING;
5. Save the changes.
   The “Updating the Frame Parameters” dialog does not open.
6. Insert a “Text Field” element.
7. In the “Texts”, “Text” property, assign an output text to the text field.
   Visualization of %s
8. In the “Text variables” “Text variable” property, assign the interface variable to the text field.
   sNameToDisplay
   visPie has a heading.
The **visPie** visualization consists of one pie until now. The **visMain** main visualization calls **visPie** in a “Tabs” control three times with different transfer parameters.

The **visPie** is extended with a text field that outputs the name of the parameters actually passed to the visualization. For this, the interface of **visPie** is extended with a string variable that contains the instance name of the specified transfer parameter. At runtime, each pie is overwritten.

**Table 624: Properties of the “Text field” element:**

<table>
<thead>
<tr>
<th>“Texts”, “Text”</th>
<th>Visualization of %s</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Text variables”, “Text variable”</td>
<td>sNameToDisplay</td>
</tr>
</tbody>
</table>

**Interface of the ‘visPie’ visualization:**

```plaintext
VAR_INPUT
  {attribute 'parameterstringof' := 'pieToDisplay'}
  sNameToDisplay : STRING;
END_VAR
VAR_IN_OUT
  pieToDisplay : DATAPIE;
END_VAR
```

**Main visualization **visMain** at runtime:**

![Visualization of PLC_PRG.pieA, Visualization of PLC_PRG.pieB, Visualization of PLC_PRG.pieC]
6.4.5.17.4 Calling a dialog in a visualization

You can configure a user input for a visualization that causes a referenced visualization to open as a dialog. For example, a user clicks on a button, whereupon a dialog opens requesting the input of values. A dialog is used to collect user inputs and, if it is modal, it can lead to inputs outside the dialog being blocked.

Only visualizations with the visualization type “Dialog” can be opened as dialog. The visualization type is configured in the dialog “Properties” of a visualization object.

**Basic procedure:**

- **Requirement:** The project contains a main visualization and a dialog.

- **1.** Configure a user input for the main visualization with the action “OpenDialog” for the dialog.
  - The opening of the dialog is configured.

- **2.** Configure a user input for an element of the dialog with the action “CloseDialog”.
  - Hint: in the case of non-modal dialogs you can also configure the user input for closing outside the dialog.
  - The closing of the dialog is configured.

You can also use dialogs from the library instead of self-made dialogs. For example, if the library VisuDialogs is integrated in the project, you can use the dialogs VisuDialogs.Login or VisuDialogs.FileOpenSave contained in it.

See also

- Chapter 6.4.5.6 “Configuring user inputs” on page 2885
- Chapter 6.4.5.21.3.6 “Dialog ‘Input Configuration’” on page 3370
- Chapter 6.4.5.21.3.15 “Dialog ‘Properties’ of Visualization Objects” on page 3388

### Configuring a visualization object as a dialog

1. Select the object in the view “Devices”, open the context menu and select the command “Properties”.
2. Select the tab “Visualization”.
3. Activate the option “Dialog” and close the dialog with “OK”.
   - The visualization has the visualization type “Dialog” and can be called as such.

### Configuring a dialog call

When calling a dialog, a user normally clicks on a button, whereupon a dialog opens requesting an input.

In the following example, a dialog representing a calendar enables a date to be entered.
Requirement: The project contains the visualizations visMain and dlgCalender.

1. Set the visualization type of dlgCalender to Dialog.
2. Drag a rectangle into the visualization visMain.
3. Configure the property “Texts ➔ Text” with the text due Date: %t[yyyy-MM-dd].
   Configure the property “Text variables ➔ Text variable” with PLC_PRG.dateDue.
4. Drag a button into the visualization.
5. Configure the property “Texts ➔ Text” with the text Open dialog.
   Configure the property “Input configuration ➔ OnMouseClick” for the action “Open Dialog” with dlgCalender.
   ➤ The user input for the opening of the dialog is configured.
6. Double-click on the dialog dlgCalender.
7. Drag the element “Date picker” into the visualization editor.
8. Configure the property “Texts ➔ Text” with Due Date: %t[yyyy-MM-dd].
   Configure the property “Variable” with PLC_PRG.dateCalender.
   ➤ The element is configured.
9. Drag a button into the visualization editor.
10. Configure the property “Texts ➔ Text” with OK.
11. Configure the property “Input configuration ➔ OnMouseClick” for the action “Close Dialog” with dlgCalender, Result: OK.
12. Configure a further property “Input configuration ➔ OnMouseClick” for the action “Execute ST-Code” with PLC_PRG.dateDue := PLC_PRG.dateCalendar;
   ➤ The user input for the closing of the dialog is configured.
13. Drag a further button into the visualization editor.
14. Configure the property “Texts ➔ Text” with Cancel.
15. Configure the property “Input configuration ➔ OnMouseClick” for the action “Close Dialog” with dlgCalender, Result: Cancel.
   ➤ The user input for the cancellation of the dialog is configured.
17. Compile, load and start the application.

Variable declaration:

```
PROGRAM PLC_PRG
VAR
  dateDue : DATE := DATE#2000-01-01;
  dateCalendar : DATE;
END_VAR
```

Opening a dialog globally

Normally a dialog appears only on the display variant on which the user has executed the triggering event. However, you can configure the opening of the dialog in such a way that the dialog appears simultaneously on all active display variants configured under the visualization manager. This way, for example, an input request can appear simultaneously on all display variants although a user only entered something on the CODESYS TargetVisu.

If a user closes the dialog on a CODESYS TargetVisu display variant, it will be closed on all display variants.
You can open and close a global dialog with the functions `OpenDialog3` and `CloseDialog2` from the library `VisuElems`.

In the application code you can implement the access to a dialog that is managed in the dialog manager. The dialog manager automatically instances and manages all visualizations of the type "Dialog". The access takes place via the internal visualization manager.

First of all, implement the access to the dialog manager by calling the `GetDialogManager()` method of the internal visualization manager. You can then use the methods of the dialog manager to program the program sequence of a dialog.

In the following example a button is configured so that it opens the preconfigured dialog `Login` when clicked. The user can enter a name and a password in the dialog. The dialog `Login` is contained in the library `VisuDialogs`. You can also call a self-made dialog in the same way.

- **Requirement:** The library `VisuDialogs` is integrated in the project.

1. Insert a new visualization `visMain` under the application.
   - The visualization editor opens.
2. Drag a button into the visualization editor.
3. Enter in its property "Text" `Login`.
   - The button is labelled.
4. Click on "Configure" in the property "Input configuration => OnMouseDown".
5. Select the input action "Execute ST-Code" and click on ☑.
6. Enter the following function call in the ST editor: `OpenLoginDialog(pClientData);`
   - The main visualization contains a button. If a user clicks on the button, the dialog `Login` opens and the function `OpenLoginDialog()` is called.
7. Click on "Configure" in the property "Input configuration => OnDialogClosed".
8. Select the input action "Execute ST-Code" and click on ☑.
9. Enter the following function call in the ST editor: `OnLoginDialogClosed(pClientData);`
   - If a user closes the dialog, the function `OnLoginDialogClosed()` is called.

```st
FUNCTION OpenLoginDialog : BOOL
VAR_INPUT
  pClientData : POINTER TO VisuStructClientData;
END_VAR

VAR
  dialogMan : IDialogManager;
```
LoginDialog : IVisualisationDialog;
pLoginInfo : POINTER TO Login_VISU_STRUCT; // Login_VISU_STRUCT contains the parameters defined in the interface of visualization "Login".
result : Visu_DialogResult;
stTitle : STRING := 'Login ...';
stPasswordLabelText : STRING;
stUserLabelText : STRING;
stUsername : STRING;
END_VAR

dialogMan := g_VisuManager.GetDialogManager(); // The DialogManager is provided via the implicitly available VisuManager
IF dialogMan <> 0 AND pClientData <> 0 THEN
  loginDialog :=
  dialogMan.GetDialog('VisuDialogs.Login'); // Dialog to be opened is specified
  IF loginDialog <> 0 THEN
    pLoginInfo :=
    dialogMan.GetClientInterface(loginDialog, pClientData);
    IF pLoginInfo <> 0 THEN
      // In the following the parameters of the login dialog in the Login_VISU_STRUCT will be read
      pLoginInfo^.stTitle := stTitle;
      pLoginInfo^.stPasswordLabelTxt := stPasswordLabelText;
      pLoginInfo^.stUserLabelText := stUserLabelText;
      dialogMan.OpenDialog(loginDialog, pClientData, TRUE, 0);
    END_IF
  END_IF
END_IF

OnLoginDialogClosed() defines the reaction to the closing of a dialog.

FUNCTION OnLoginDialogClosed : BOOL
  VAR_INPUT
    pClientData : POINTER TO VisuStructClientData;
  END_VAR

  VAR
    dialogMan : IDialogManager;
    loginDialog : IVisualisationDialog;
    pLoginInfo : POINTER TO Login_VISU_STRUCT;
    result : Visu_DialogResult;
    stPassword : STRING;
    stUsername : STRING;
  END_VAR

  dialogMan := g_VisuManager.GetDialogManager(); // The DialogManager is provided via the implicitly available VisuManager
  IF dialogMan <> 0 AND pVisuClient <> 0 THEN
    loginDialog :=
    dialogMan.GetDialog('VisuDialogs/Login'); // Gets the login dialog
    IF loginDialog <> 0 THEN
      result := loginDialog.GetResult(); // Gets the result (OK, Cancel) of the dialog
      IF result = Visu_DialogResult.OK THEN
        loginDialog.SetResult(Visu_DialogResult.None); // Reset to default (none)
        pLoginInfo :=
        dialogMan.GetClientInterface(loginDialog, pVisuClient); // Structure Login_VISU_STRUCT gets read;
        // In the following the structure parameters can be set
        IF pLoginInfo <> 0 THEN
          stPassword :=
LoginInfo^.stPassword := ''; // Reset the password
    stUsername := pLoginInfo^.stUsername;
    END_IF
ELSIF result = Visu_DialogResult.Cancel THEN
    loginDialog.SetResult(Visu_DialogResult.None); // React on 'Cancel'
    ELSE
        // nothing to do
    END_IF
    END_IF
    END_IF

See also
●  "Chapter 6.4.5.20.3 “Methods of the Dialog Manager” on page 3335"

6.4.5.17.5 Calling a Dialog with an Interface
You can define an interface for a visualization that is called as a dialog.
Create a visualization for this with visualization type “Dialog” and declare an interface for the dialog. The reference the visualization in a primary visualization by means of a user input and transfer the parameters to the interface.
If you call the visualization as an integrated visualization, then the parameter that are transferred must be variables of a basic data type. If the visualization is called as CODESYS TargetVisu or CODESYS WebVisu, then the parameters can have user-defined data types as well.
See also
●  "Scopes” on page 3340
●  "Chapter 6.4.5.21.3.15 “Dialog ’Properties’ of Visualization Objects” on page 3388

Main procedure
1. Set the visualization types of the visualization to dialog.
2. Declare variables in the interface editor of the dialog.
   ➞ The dialog has an interface. You can transfer parameters when calling the dialog.
3. Configure the elements of the dialog and use the interface variables.
4. Select an element in another visualization (usually the main visualization) for configuring how the dialog opens.
5. Click “Configure” in the property “Input configuration ➞ OnMouseDown”.
   ➞ The “Input Configuration” dialog box opens.
6. Select “Open dialog” in the list of selected input actions.
7. Select one from the “Dialog” drop-down list.
   ➞ If the selected dialog has an interface, then the interface variables are listed below.
8. Assign a transfer parameter to the interface variables in the “Value” column.
9. Select the result for which the parameters were updated in the list “Update” ➞ “and” ➞ “Parameter in case of results”.
10. Activate the option “Open dialog modal”. Click “OK” to close the dialog box.
   ➞ The dialog opening is configured.
Executing a dialog several times at the same time requires multiple instances of the dialog. These must have already been downloaded to the visualization device when downloading the application. For this purpose, set the number of instances to download in the visualization manager (“Visualizations” tab).

See also
- § Chapter 6.4.5.21.3.15 “Dialog ‘Properties’ of Visualization Objects” on page 3388
- § Chapter 6.4.5.21.3.6 “Dialog ‘Input Configuration’” on page 3370
- § Chapter 6.4.5.17.5 “Calling a Dialog with an Interface” on page 2962

Example

the following application calls the “Change User Level” dialog and prompts the user to select a level and specify a password. If the password agrees, then the “OK” button is enabled. Then the user can close the dialog. The input of the level is also applied.
Dialog visChangeUserLevel:

Table 625: Element list of the visChangeUserLevel dialog box:

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Element properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#0</td>
<td>Image</td>
<td>&quot;Static ID&quot;: VisuDialogs.ImagePoolDialogs.Login</td>
<td>The property assigns the image of a blank dialog with a gray background and a blank blue caption bar to the element. The image is included in the “VisuDialogs” library.</td>
</tr>
<tr>
<td>#1</td>
<td>Box</td>
<td>&quot;Texts ➔ Text&quot;: %s</td>
<td>Output with placeholder for text variable</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;Text variables ➔ Text variable&quot;: sItfTitle</td>
<td>Assignment of interface variable sItfTitle for which a parameter is transferred at call time.</td>
</tr>
<tr>
<td>#2</td>
<td>Radio Buttons</td>
<td>&quot;Variable&quot;: iItfLevel</td>
<td>Assignment of interface variable iItfLevel for which a parameter is transferred at call time. Includes the user input at runtime.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;Number of columns&quot;: 4</td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>Name</td>
<td>Element properties</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>------------------</td>
<td>-------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>“Radio button order”: “Left to right”</td>
<td>Display</td>
</tr>
<tr>
<td></td>
<td></td>
<td>“Radio button settings”</td>
<td>Label of eight radio buttons with numbers from 0 to 7</td>
</tr>
<tr>
<td></td>
<td></td>
<td>“Areas”: [0] bis [7]”</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>“Text”: &lt;n&gt;</td>
<td></td>
</tr>
<tr>
<td>#3</td>
<td>Text Field</td>
<td>Input password</td>
<td>Output with placeholder for text variable</td>
</tr>
<tr>
<td></td>
<td></td>
<td>“Texts → Text”: %s</td>
<td>Assignment of interface variable sItfPwd for which a parameter is transferred at call time. Includes the user input at runtime.</td>
</tr>
<tr>
<td>#4</td>
<td>Text Field</td>
<td>Label for level</td>
<td>In the “Input configuration” dialog, “Text input” is selected for the “Input type” drop-down list and the option “Use text output variable” is activated.</td>
</tr>
<tr>
<td>#5</td>
<td>Text Field</td>
<td>Label for password</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>“Texts → Text”: Password</td>
<td></td>
</tr>
<tr>
<td>#6</td>
<td>Button</td>
<td>OK</td>
<td>Configuration of the display in state-dependent colors. You can switch between colors.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>“Colors → Color”: Element base color</td>
<td>If the password and the user input do not agree, then the expression is TRUE. Then the button is displayed in the alarm color.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>“Colors → Alarm color”: Alarm fill color</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>“Color variables → Toggle color”:</td>
<td>If the password and the user input do not agree, then the expression is TRUE. The button is deactivated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sItfPwd &lt;&gt; MUX(iItfLevel, sItfLevel0,</td>
<td>If the password agrees, then the button is enabled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sItfLevel1, sItfLevel2, sItfLevel3,</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>sItfLevel4, sItfLevel5, sItfLevel6,</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>sItfLevel7);</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>“State variables → Deactivate inputs”:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>sItfPwd &lt;&gt; MUX(iItfLevel, sItfLevel0,</td>
<td>If the password and the user input do not agree, then the expression is TRUE. The button is deactivated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sItfLevel1, sItfLevel2, sItfLevel3,</td>
<td>If the password agrees, then the button is enabled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sItfLevel4, sItfLevel5, sItfLevel6,</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>sItfLevel7);</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>“Input configuration → OnMouseDown → Close dialog”:</td>
<td>if a user clicks the “OK” button, then the visChangeUserLevel dialog is closed and the parameters are updated.</td>
</tr>
<tr>
<td>#7</td>
<td>Button</td>
<td>Cancel</td>
<td>Label</td>
</tr>
<tr>
<td></td>
<td></td>
<td>“Texts → Text”: Cancel</td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>Name</td>
<td>Element properties</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>------</td>
<td>--------------------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;Colors ➔ Color&quot;: Element base color</td>
<td>Display</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;Input configuration ➔ OnMouseDown ➔ Close dialog&quot;: Close Dialog: visChangeUserLevel, Result : Cancel</td>
<td>If a user clicks the &quot;Cancel&quot; button, then the visChangeUserLevel dialog is closed.</td>
</tr>
</tbody>
</table>
Main visualization visMain:

Table 626: Element list of the visMain visualization:

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Element properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#5 Text Field</td>
<td>Button for change user level</td>
<td>&quot;Texts ➔ Text&quot;: %s</td>
<td>Output with placeholder</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;Text variables ➔ Text variable&quot;: PLC_PRG.iLevel</td>
<td>Assignment of the PLC_PRG.iLevel variables to the placeholder. Includes the level number.</td>
</tr>
<tr>
<td>#6 Button</td>
<td>Title</td>
<td>&quot;Texts ➔ Text&quot;: Change user level</td>
<td>If a user clicks the Change user level button, then the visChangeUserLevel dialog opens with the parameter list stored here. Tip: Click &quot;Configure&quot; to view the stored configuration in the &quot;Input Configuration&quot; dialog (input action &quot;Open dialog&quot;).</td>
</tr>
</tbody>
</table>

Table 627: Configuration of the call of dialog visChangeUserLevel:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sItfTitle</td>
<td>STRING</td>
<td>'ChangeUse user level'</td>
<td>Transfer of a string for the title.</td>
</tr>
<tr>
<td>sItfLevel0</td>
<td>STRING</td>
<td>'pwd0'</td>
<td>Transfer of a string as password for Level0.</td>
</tr>
<tr>
<td>sItfLevel1</td>
<td>STRING</td>
<td>'pwd1'</td>
<td>Transfer of a string as password for Level1.</td>
</tr>
<tr>
<td>sItfLevel2</td>
<td>STRING</td>
<td>'pwd2'</td>
<td>Transfer of a string as password for Level2.</td>
</tr>
</tbody>
</table>
### Table 628: List “Update” and “Parameter in case of result”

<table>
<thead>
<tr>
<th>“Value”</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“OK”</td>
<td>activated</td>
</tr>
</tbody>
</table>

“Open in dialog mode” activated input outside of the dialog is not possible.

**Application code PLC_PRG:**

```plaintext
PROGRAM PLC_PRG
VAR
  iLevel: INT;
  sPwd: STRING;
END_VAR
```
After clicking the button, the dialog opens and permits input. If the specified text agrees with the stored text, then “OK” is enabled:

After clicking “OK”, the selection is applied.

The example shows the procedure for multiple return values. However, the password can be returned more easily with a local variable in the dialog.
Accessing parameters programmatically

The variables declared in the interface of a visualization are available automatically as structure variables. They are identified by `<Name of visualization>_VISU_STRUCT`. Therefore, you can access the interface variables of visualizations that appear as a dialog. Normally you use the structure in the application code of a function that is called by a user input.

Passing pointers as parameters

To pass a complex data structure, you can flag an interface variable of type VAR_IN_OUT with the pragma attribute VAR_IN_OUT_AS_POINTER and pass a pointer or reference to it as a parameter.

Procedure for using references

1. Declare the user data object (DUT).
2. In the interface editor of a dialog, declare an interface variable (VAR_IN_OUT) as a reference to the data object by assigning the attribute 'VAR_IN_OUT_AS_POINTER' to the variable.
3. Program the user interface: use the dialog in a visualization or assign the dialog in the input configuration of a visualization element. Then access to the referenced data is possible.
Example:
Using an interface with the pragma "VAR_IN_OUT_AS_POINTER"

```plaintext
FUNCTION_BLOCK ControlFB
  VAR
    bOk : BOOL := TRUE;
    nCounter : INT;
    nValue : INT;
  END_VAR
  nCounter := nCounter + 1;
END_FUNCTION_BLOCK
```

Declaration of an interface variable with VAR_IN_OUT_AS_POINTER
User interface: dialog opens:

```plaintext
VAR_INPUT
    nValueIn: INT;
END_VAR
VAR_IN_OUT
    {attribute 'VAR_IN_OUT_AS_POINTER'}
    controller: ControlFB;
END_VAR
VAR_OUTPUT
    nValueOut: INT;
END_VAR

%s
Controller Counter: %s
Controller Value: %s
```
Configuring and executing display variants

6.4.5.18 General

You can select from different variants for displaying your visualization created in CODESYS. An advantage is that you can have not only one, but multiple display variants running at the same time. During this time, the contents of the visualization are the same for all variants. This also applies to the integrated visualization: when the visualization editor is open in CODESYS, the visualization is also displayed there with the same active contents.

The following object types are available:

- **“TargetVisu”**
  The display as a variant of CODESYS TargetVisu is possible one time. You can insert an object of this type below the Visualization Manager.

- **“WebVisu”**
  The display as a variant of CODESYS WebVisu is possible any number of times. You can insert any number of objects.

- **“Remote TargetVisu”**
  The display as a variant of CODESYS TargetVisu is possible any number of times. You can insert any number of objects.

When you insert a variant below the Visualization Manager, the task configuration is extended by the visualization task `VISU_TASK` (the flow unit of the visualizations). The task is automatically deleted when no more objects exist below the Visualization Manager or the objects below are excluded from compiling. You can set this in the “Properties” dialog of an object, on the “Compile” tab.
Exception handling at runtime

If an error or an exception occurs in a visualization at runtime, the execution of the visualization is stopped without stopping the execution of the application. An error screen appears informing you of this. In addition, the error screen (usually) enables you to restart the visualization. This exception handling takes place from visualization profile CODESYS V3.5 SP7, compiler version 3.5.7.0 and a runtime system from version 3.5.7.0.

Select the command “Stop Execution at Handled Exceptions” in order to investigate the cause of the occurrence of exceptions and the error position.

See also
- Chapter 6.4.1.21.3.7.19 “Command ‘Stop Execution on Handled Exceptions’” on page 2639

Identifying display variants

In order to programmatically identify a display variant, the VisuFbClientTagDataHelper library module from the VisuElemBase library is available to you. The library itself is referenced in VisuElems. The library module is typically called with VisuElems.VisuFbClientTagDataHelper.

Further information on this library module can be found in its documentation in the library manager.

See also
- Chapter 6.4.1.9.9 “Using Library POUs” on page 1890

6.4.5.18.2 Executing as CODESYS WebVisu

NOTICE!

Recommendations for data security

In order to minimize the risk of breaches of data security, we recommend the following organizational and technical measures for the system on which your applications run:

As far as possible, avoid exposing the PLC and control networks to open networks and the Internet. For protection, use additional data-link layers such as a VPN for remote access and install firewall mechanisms. Limit access to authorized persons, change any existing standard passwords during the initial commissioning and continue to change them regularly.

If you nevertheless wish to publish your web visualization, it is urgently recommended that you provide it at least with simple password protection in order to prevent anyone accessing your control functionality over the Internet. (See an example in the project SimpleWebvisuLogin.project, which is provided with the standard installation of the development system).

Use the latest versions of the gateway server and the web server.

You can execute a visualization as CODESYS WebVisu.
The requirement for this is that the runtime system contains a web server with WebVisu support. This enables communication between target system and web browser. The web server on the target system is started as soon as an application with WebVisu configuration is started and runs until all applications with WebVisu are ended. The device can then display visualizations in connected HTML5-capable web browsers.

The web-based display variant of the CODESYS Visualization enables remote access to a plant as well as its remote monitoring, service and diagnosis over the Internet. A web browser communicates by Java Script (optionally with SSL encryption) with the web server in the controller and displays the visualization by means of HTML5. This technology is supported by virtually all browsers and is thus also available on terminal devices with iOS or Android.

### Configuring and starting display variants

- An executable visualization `visMain` exists in the project.
- Select the object “Visualization manager” and select the command “Add object”.
- Select the object “WebVisu” and enter the name `WebVisu_A`.
  - There is a new object in the device tree underneath the object “Visualization Manager”. The associated editor opens.
  - The visualization task `VISU_TASK` is automatically added under the task configuration.
- Select the visualization `visMain` in the “Start Visualization”.
- In “Name of .htm file”, enter the name `webvisuA`.
- Click on “Show used visualizations” and check whether the selected visualization is activated for a download to the associated device.
  - The visualization is configured. The settings under “Scaling options” determine the window size and the scaling.
- Start a suitable runtime system with web server and WebVisu support.
  - The runtime system runs.
- Compile, load and start the application.
  - The application and the web server run.
- Start a web browser with the following address: `http://localhost:8080/webvisuA.htm`
  - The page is displayed and you can see the data of the application and operate the application.

See also

- Chapter 6.4.5.21.4.7 “Object ‘TargetVisu’” on page 3408
Calling a page in the web server

☐ Requirement: A visualization with WebVisu is started.
1. Start a current browser with JavaScript and support of HTML5-Canvas, e.g. Firefox, Chrome, IE>=9.
2. Enter the following address in the web browser:
   http://localhost:8080/webvisu.htm
   Formal: http://<IP address of webserver>:<port of webserver>/<name of HTM-file>
   <name of HTM-file> is the HTML start page of the visualization defined in the object “WebVisu”.
   ⇨ The page is displayed and you can see the data of the application and operate the application.

Identifying WebVisu

In order to be able to identify a WebVisu with the help of the library block VisuFbClientTagDataHelper, the WebVisu needs a name. In order to be able to specifically address it in the application, expand the URL call by the parameter ClientName=<Name>.


See also
● § Chapter 6.4.5.21.4.8 “Object 'WebVisu'” on page 3409

6.4.5.18.3 Executing as an Integrated Visualization

You can execute the visualization as an integrated visualization. In this case a display variant of the visualization runs on the development system without the visualization code being loaded to the controller.

Use the integrated visualization for the testing and diagnosis of your application, or for the service and commissioning of a plant.

The requirement for this is that there are no objects under the visualization manager. Alternatively, any objects located there can be excluded from compilation. You can configure an individual object accordingly in its dialog “Properties” on the tab “Compile”.

See also
● § Chapter 6.4.5.21.3.15 “Dialog 'Properties' of Visualization Objects” on page 3388

Configuring and starting display variants

☐ A visualization project is open.
1. Remove all objects from underneath the visualization manager or exclude the objects from compilation.
   ⇨ The VISU_TASK has been removed from under the task configuration.
2. Load the application to the controller.
   ⇨ Now no visualization code will be transferred on loading the application.
3. Start the application.
   ⇒ The visualization in the visualization editor is being executed. You can operate your
   application.

Use the command “Activate keyboard usage” in order to toggle between the keyboard usage of the integrated visualization and the keyboard usage of CODESYS.

See also
- Chapter 6.4.5.21.2.4 “Command 'Activate Keyboard Usage’” on page 3343
- Chapter 6.4.5.21.1 “Keyboard Shortcuts for Default Keyboard Action” on page 3338

Restrictions in the variable output

Numerical variable values, which are output within a text in an integrated visualization, are displayed according to the current display format. You can select the display format with the command “Debug ➔ Display”.

See also
- Chapter 6.4.1.21.3.8.24 “Command 'Display Mode’ - 'Binary’, 'Decimal’, 'Hexadecimal’” on page 2654

Data server restrictions

A variable value that is transferred via the data server is not output. The integrated visualization only outputs the initialization or the last transferred value.

The integrated visualization thus only enables a passive observation of the application.

Restrictions in variable types

VAR_INPUT variables behave like integrated visualizations such as VAR_IN_OUT variables during execution.

Restrictions in expressions and monitoring

Only the following expressions, which are also used in the monitoring mechanism of the development system, are supported in an integrated visualization.

Variable access:
- Example: PLC_PRG.myPou.nCounter

Array access:
- Access to an array of scalar data types, where a variable is used as an index
  Example: a[i]
- Access to an array of complex data types (structure, function block, array), where a variable is used as an index
  Example: a[i].x
- Access to a multidimensional array of all kinds of data types with one or more variable indices
  Example: a[i, 1, j].x
- Access to an array with constant index
  Example: a[3]
- Accesses like those described above in which simple operators are used for the calculations inside the index brackets.
  Example: a[i+3]
- Nested combinations of the complex expressions listed above
  Example: a[i + 4 * j].aInner[j * 3].x

Operators in index calculations:
- +, −, *, /, MOD
Pointer monitoring:

- Example: p^.x

Methods and function calls are not supported with the exception of the following:

- Standard string functions
- Type conversion functions
  
  Example: INT_TO_DWORD
- Operators such as SEL, MIN, etc.

Restrictions in the input action “Execute ST-Code”

When the input action “Execute ST-Code” is called, only a list of assignments is supported. If a list of assignments is used, the value of the left-hand side is not assigned until the next cycle. Processing in the next row immediately afterwards is not possible.

Example

```plaintext
PLC_PRG.n := 20 * PLC_PRG.m; // Don't use this!
IF PLC_PRG.n < MAX_COUNT THEN
  PLC_PRG.n := PLC_PRG.n + 1;
END_IF
// Use the following!
PLC_PRG.n := MIN(MAX_COUNT, PLC_PRG.n + 1);
```

Restrictions in the interface of a visualization

No interface (INTERFACE) may be declared in the interface editor of a visualization.

6.4.5.18.4 Configure File Transfer Mode

When downloading, usually files required by the visualization for displaying, are transmitted to the respective display unit. These are especially image files or text list files.

Alternatively, you can configure, that the visualization accesses local files. So no files are transferred with a download.

The following configuration is required to allow the visualization access to local files:

- The file paths for image files or text files lists are relative.
- The link type for image files is “Link to file”.

Using local visualization files

☐ Requirement: You have opened a visualization project with an image pool.
1. Open the image pool.
2. Select for each image under “Link Type” the setting “Link to file”.
   ⇒ The image is linked.
3. Select the command “Project ➔ Project Setting” and select the category “Visualization”.
4. Insert in tab “General” in “Image files” the local paths of the image files with relative path names.
   ⇒ Example: \.;\.;\.;\images\ 
   
   Note: When no path is specified, the setting in dialog box “Options”, category “Visualization”, tab “File Options” setting “Image files” is used.
5. Open the visualization manager.
6. Activate under “Extended settings” the option “Visible”.
7. Activate under “File Transfer Mode” the option “Use local visualization files”.
   ⇒ When downloading, no files are transferred. When displaying the visualization, the
local files are used.

See also
- Chapter 6.4.5.21.4.2 “Object ’Visualization manager’” on page 3398
- Chapter 6.4.1.21.2.15 “Object ’Image Pool’” on page 2468
- Chapter 6.4.5.21.3.13 “Dialog ’Project Settings’ - ’Visualization’” on page 3387
- Chapter 6.4.5.21.3.9 “Dialog Box ’Options’ - ’Visualization’” on page 3384

6.4.19 Applying Visualization Styles

6.4.19.1 General

A visualization style is a collection of colors, fonts, images, and any values that are defined as
style properties. When designing a visualization element, you can use these style properties
only. The you have a uniform, style-dependent appearance.

An element that applies style colors and style fonts behaves according to the selected style
design in each selected style. In this way, a style property, such as Element basic color,
can be blue in one style and gray in another style. In contrast, if the color of an element has a
fixed value, this color is fixed even when the style is switched.

All applicable styles are consistent because they define a fixed set of style properties. There-
fore, you can switch smoothly between styles in order to customize your visualization. You can
preview a style to get an impression of how it behaves.

CODESYS provides different styles, for example the styles Flat style and White Style.

These provided styles are installed in the visualization style repository.

The selected style that applies to all visualizations in the application is set in the “Visualization
Manager” object (“Settings” tab, “Style Settings” group, “Selected style”). In addition, the
“Properties” view provides its style properties when designing an element. For each element,
you can assign these styles instead of fixed values.

The style is applied to all visualizations that are below an application. The settings of the
“Options - Visualization Styles” dialog are also considered for a library visualization or a visuali-
zation in the POUs view.

See also
- Chapter 6.4.5.21.3.11 “Dialog ’Project Environment’ - ’Visualization Styles’”
on page 3386
- Chapter 6.4.5.21.3.7 “Dialog ’Options’ - ’Visualization Styles’” on page 3382
- Chapter 6.4.5.21.4.2 “Object ’Visualization manager’” on page 3398

Designing visualization elements with style properties

The set style includes style properties. These are provided in the “Properties” view of an
element in the drop-down list of the “Value” column. It is checked which style properties are
appropriate for which property. For example, only style properties with color definitions are
available for a color assignment.

A style can have directly defined visualization element properties. If this style is
used in the project, then these properties are not configurable anymore.

☑ Requirement: A project is open with a visualization.
1. Double-click the visualization.
2. Select an element.
3. Choose “View ➔ Element Properties”.
4. Click in the input field of a color in the window “Properties” (category “Colors”).
   ➔ The list box opens with style properties. The style colors are based on the currently selected style.
5. Select a style property.
   ➔ The visualization shows the element according to the style.

**Example**

A visualization uses the style CompanyStyle8, which defines the colors CompanyRed, CompanyBlue, and CompanyGreen. An element is selected in the visualization. By clicking into the value field of the “Color” property, you receive a drop-down list with the entries CompanyRed, CompanyBlue, and CompanyGreen.

**Switching visualization styles**

When setting a style in the visualization manager, all complete styles in the repository are available for selection. It does not matter and it is not evident if a style have been derived from another style.

You can preview a style to get an impression of how it behaves.

How a visualization implements a style at runtime also depends on the display variant. For example, if a font that is defined in the style is not available, the display variant shows the visualization with a preset font.

☐ Requirement: A project is open with a visualization.
1. Double-click the “Visualization Manager” object in the device tree.
   ➔ The editor opens.
2. Click in the input field of “Selected style” (“Settings” tab, “Style Settings” group).
   ➔ All styles that are installed in the repository are listed.
3. Mouse over a style.
   ➔ A preview of how the style is displayed appears in a new window.
4. Select a style.
   ➔ The style is applied. The preview in “Style Settings” shows the new setting.
5. Double-click a visualization.
   ➔ The visualization appears in the new style.

**Updating versions**

☐ Requirement: A project is open with a visualization.
1. Click “Project ➔ Project Environment”, “Visualization Styles” tab.
   ➔ CODESYS lists all new versions of the currently used styles.
2. Click “Set All to Newest”.
   ➔ The style is updated. Visualizations and their elements apply the new style.

**6.4.5.19.2 Editing visualization styles in the visualization style editor**

A style is an XML file with the file extension *.visustyle.xml. It contains a specific set of style properties. CODESYS checks the style properties in the consistency check.
You can create a new style or customize an existing style. The visualization style editor is available for this.

If you customize a style, then a new style is created as a hierarchy of styles. A hierarchy consists of at least two styles based on each other. The nesting depth is unrestricted. A hierarchy is identified simply with its top derived style. You can derive multiple different styles from one base style by extending the styles by differing style properties. This save memory and therefore should be your preferred method.

A base style does not have to be consistent for itself. Instead, you must identify it as an incomplete style. Only the top derived style must be consistent.
In a partial style, you can combine any style properties to form efficient hierarchies without having to worry about consistency. For example, you can collect all image references into one partial style. Then you derive the style and define more style properties for colors. This style is also incomplete. You derive the style again and define more style properties for its fonts. The top style is now completely.

Style Petrostyle

(1): `CompanyImg` is a partial style defining image references.
(2): `CompanyColor` is a partial, derived style based on `CompanyImg` and also defines colors.
(3): `PetrolStyle` is a complete, derived style based on `CompanyColor` and also defines a special color.
(4): The hierarchy of styles comprises `PetrolStyle, CompanyColor, and CompanyImg`.

Example of a style hierarchy

Configuration and programming
Programming with CODESYS > CODESYS Visualization
In the visualization style editor, you can open a style, define its style properties, and localize its name. If the style is consistent, then you can install it in the visualization style repository. The editor is not integrated in CODESYS. However, you can start the editor in CODESYS.

Names for style properties

A style property is an entry for a specific color, a specific font, or a specific image reference. If this name contains a dash, then the Visualization Style Editor can sort the style properties by the prefixed terms before the dash and display them in a hierarchy. Otherwise the names can be sorted in alphabetical order or sequential order or in sequential order (as saved in the XML file). CODESYS displays the style properties in the order of names actually saved in the XML file for the style.

Example: Element-Alarm-Fill-Color

See also

● Chapter 6.4.5.22.3 “Editor 'Visualization Style Editor'” on page 3750

Starting the editor in CODESYS

1. Double-click the “Visualization Manager” object. ⇒ The editor opens.
2. Click the symbol ("Settings" tab, "Style Settings" group).
3. Click “Open Style Editor” from the drop-down list. ⇒ The “Visualization Style Editor” opens.

Starting the editor independent of CODESYS

Choose “Visualization Styles Editor” from the CODESYS install folder in the Start menu. If you have a standard installation, then this link is located in CODESYS (the program folder for CODESYS). ⇒ The visualization style editor opens.

Deriving visualization styles

This is the recommended way to create a style that combines existing style properties with new ones.

Starting the editor in CODESYS and deriving styles

Requirement: CODESYS is open with a project containing a visualization.
1. Double-click the “Visualization Manager” object in the device tree. ⇒ The editor opens.
2. Click the symbol ("Settings" tab, "Style Settings" group). ⇒ A list of commands opens.
3. Choose “Create and Edit Derived Style”. ⇒ The visualization style editor starts and the “Create a New Visualization Style” dialog box opens.
4. Type a name.
5. Select a directory.
6. Select a base style. The default style is set in CODESYS. You can also select a style from the repository.
   ⇒ The new style appears in the visualization style editor. The style properties from the base style are displayed yellow.
7. Add a new style property or modify an existing value.
8. Provide a version for the style and click “File ➔ Save and Install”.
   ⇒ The style is installed in the repository. The memory requirement is low because only the style property added in step 7 is saved.

Copying visualization styles

- Requirement: CODESYS is open with a project containing a visualization.
  1. Double-click the “Visualization Manager” object in the device tree.
     ⇒ The editor opens.
  2. Click the symbol (”Settings” tab, “Style Settings” group).
     ⇒ A list of commands opens.
  3. Choose “Copy and Edit Style”.
     ⇒ The visualization style editor starts and the “Open Existing Style as a Copy” dialog box opens.
  4. Select which style should be copied (“Style”).
  5. Type a directory in “Destination” and click “OK”.
     ⇒ The new style appears in the visualization style editor. All style properties are identical to those in the copied style.
  6. Type a name.
  7. Add a new style property or modify the value of an existing style property.
  8. Provide a version for the style and click “File ➔ Save and Install”.
     ⇒ The style is installed in the repository and the style properties are identical to the added style property, except for the style property added in step 8. The memory requirement is high because the common style properties are defined in both styles.

Creating new visualization styles

- Requirement: CODESYS is open with a project containing a visualization.
  1. Double-click the “Visualization Manager” object in the device tree.
     ⇒ The editor opens.
  2. Click the symbol (”Settings” tab, “Style Settings” group).
     ⇒ A list of commands opens.
  3. Click “Open Style Editor”.
     ⇒ The visualization style editor opens.
  4. Click “File ➔ New Style”.
     ⇒ The “Create a New Visualization Style” dialog box opens.
  5. Type a name. Specify a base style.
6. Specify a directory and click “OK” to close the dialog box. 
   ⇒ The new style appears in the visualization style editor.
7. Add a new style property.
8. Provide a version for the style and click “File ➔ Save and Install”.
   ⇒ The style is installed in the Visualization Styles Repository with the version number.

**Adding a style property**

Using the visualization style editor, you can edit a style to save and install as a new version.

☑ Requirement: The visualization style editor is open with a style.
1. Select a style property and click “Styles ➔ New Style (Afterwards)” in the “Style Properties” tab.
   ⇒ A new style property is added.
2. In the “General” tab, type a new version number in the “Version” setting.
3. Choose “File ➔ Save and Install”.
   ⇒ The changes are saved and the style is installed in the repository as the new version.

**Localizing style properties**

You can assign a language-dependent name to a style property. CODESYS displays a style property by its localized name, depending on the language settings in category “International Settings” (menu “Tools ➔ Options”).

☑ Requirement: The visualization style editor is open with a style.
1. Translate the name of the style property into the localized language in the “Localization” tab.
2. Provide a version for the file in the “General” tab.
3. Choose “Save and Install”.
   ⇒ The edited style is installed in the repository currently selected in CODESYS.
4. Update the style.
5. Set the language settings in CODESYS to the localized language.
6. Open a visualization and select an element. The style settings in its properties are displayed in the localized language.

**6.4.5.19.3 Managing visualization styles in repositories**

The styles that are listed in CODESYS in the drop-down lists of different dialogs and editors are all checked for consistency and installed in the visualization style repository. For derived styles, the hierarchy is checked completely and all styles of the hierarchy are installed. The repository is a version control system within the development system.

You can open a style as write-protected from the visualization style repository in the visualization style editor. The “Save” and “Save and Install” commands are not available there for read-only files. However, you can derive it as the basis for a new style or as a copy.

See also

- ☺ Chapter 6.4.5.21.2.20 “Command ‘Visualization Style Repository’” on page 3363
- ☺ Chapter 6.4.5.22.3 “Editor ‘Visualization Style Editor’” on page 3750
Installing styles to repositories

1. Click “Tools ➔ Visualization Style Repository”.
   ➔ The “Visualization Styles” dialog box opens.
2. Select the “System” repository in the drop-down list of “Storage location”.
   ➔ All versions of the installed styles are listed in “Installed Visualization Styles”.
3. Click on the “Install” button.
   ➔ The “Select Visualization style(s)” dialog box opens.
4. Select a style file and click “Open” to close the dialog box.
   ➔ The style is installed in the “System” repository. It appears now in the tree view below “Installed Visualization Styles”.

Uninstalling styles

1. Click “Tools ➔ Visualization Style Repository”.
   ➔ The “Visualization Styles” dialog box opens.
2. Select a repository in the drop-down list of “Storage location”.
   ➔ All versions of the installed styles are listed in “Installed Visualization Styles”.
3. Select a style there.
4. Click the “Uninstall” button.
   ➔ The “Select Visualization Style(s)” dialog box opens.

Managing repositories

1. Click “Tools ➔ Visualization Style Repository”.
   ➔ The “Visualization Styles” dialog box opens.
2. Click on the “Edit Locations” button.
   ➔ The dialog makes it possible to manage other repositories.

6.4.5.20 Reference, Programming

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.4.5.20.1</td>
<td>Visualization Elements</td>
<td>2987</td>
</tr>
<tr>
<td>6.4.5.20.2</td>
<td>Placeholders with Format Definition in the Output Text</td>
<td>3329</td>
</tr>
<tr>
<td>6.4.5.20.3</td>
<td>Methods of the Dialog Manager</td>
<td>3335</td>
</tr>
<tr>
<td>6.4.5.20.4</td>
<td>Attribute ‘VAR_IN_OUT_AS_POINTER’</td>
<td>3337</td>
</tr>
<tr>
<td>6.4.5.20.5</td>
<td>Attribute ‘parameterstringof’</td>
<td>3338</td>
</tr>
</tbody>
</table>
6.4.5.20.1 Visualization Elements

6.4.5.20.1.1 Visualization Element 'Rectangle', 'Rounded Rectangle', 'Ellipse' ......................................................... 2988
6.4.5.20.1.2 Visualization Element 'Line' .................................................................................................................. 3000
6.4.5.20.1.3 Visualization Element 'Polygon', 'Polyline', 'Bézier Curve' ................................................................. 3012
6.4.5.20.1.4 Visualization Element 'Pie' .................................................................................................................... 3025
6.4.5.20.1.5 Visualization Element 'Image' .................................................................................................................. 3038
6.4.5.20.1.6 Visualization Element 'Frame' .................................................................................................................. 3053
6.4.5.20.1.7 Visualization Element 'Label' .................................................................................................................. 3068
6.4.5.20.1.8 Visualization Element 'Combo Box, Integer' ............................................................................................ 3072
6.4.5.20.1.9 Visualization Element 'Combo Box, Array' ............................................................................................... 3079
6.4.5.20.1.10 Visualization Element 'Tabs' .................................................................................................................. 3084
6.4.5.20.1.11 Visualization Element 'Button' ............................................................................................................... 3089
6.4.5.20.1.12 Visualization Element 'Group Box' ........................................................................................................ 3101
6.4.5.20.1.13 Visualization Element 'Table' ................................................................................................................ 3106
6.4.5.20.1.14 Visualization Element 'Text Field' ........................................................................................................... 3113
6.4.5.20.1.15 Visualization Element 'Scroll Bar' ........................................................................................................... 3125
6.4.5.20.1.16 Visualization Element 'Slider' .................................................................................................................. 3134
6.4.5.20.1.17 Visualization Element 'Spin Box' ............................................................................................................. 3140
6.4.5.20.1.18 Visualization Element 'Invisible Input' .................................................................................................... 3147
6.4.5.20.1.19 Visualization Element 'Progress Bar' ...................................................................................................... 3152
6.4.5.20.1.20 Visualization Element 'Check Box' ......................................................................................................... 3156
6.4.5.20.1.21 Visualization Element 'Radio Buttons' ................................................................................................. 3161
6.4.5.20.1.22 Visualization Element 'Alarm Table' ....................................................................................................... 3166
6.4.5.20.1.23 Visualization Element 'Alarm Banner' ................................................................................................... 3175
6.4.5.20.1.24 Visualization Element 'Bar Display' ....................................................................................................... 3181
6.4.5.20.1.25 Visualization Element 'Meter 90°' ............................................................................................................. 3187
6.4.5.20.1.26 Visualization Element 'Meter 180°' ............................................................................................................ 3194
6.4.5.20.1.27 Visualization Element 'Meter' ................................................................................................................ 3201
6.4.5.20.1.28 Visualization Element 'Potentiometer' .................................................................................................... 3208
6.4.5.20.1.29 Visualization Element 'Histogram' ......................................................................................................... 3216
6.4.5.20.1.30 Visualization Element 'Image Switcher' ................................................................................................. 3221
6.4.5.20.1.31 Visualization Element 'Lamp' ................................................................................................................ 3226
6.4.5.20.1.32 Visualization Element 'Dip Switch', 'Power Switch', 'Push Switch', 'Push Switch LED', 'Rocker Switch' .......................................................................................................................... 3231
6.4.5.20.1.33 Visualization Element 'Rotary Switch' ..................................................................................................... 3235
6.4.5.20.1.34 Visualization Element 'Trace' .................................................................................................................. 3240
6.4.5.20.1.35 Visualization Element 'Trend' .................................................................................................................. 3246
6.4.5.20.1.36 Visualization Element 'Legend' ............................................................................................................... 3254
6.4.5.20.1.37 Visualization Element 'ActiveX' .............................................................................................................. 3258
6.4.5.20.1.38 Visualization Element 'Web Browser' .................................................................................................... 3262
6.4.5.20.1.39 Visualization Element 'Busy Symbol, Cube' ........................................................................................... 3266
6.4.5.20.1.40 Visualization Element 'Busy Symbol, Flower' ......................................................................................... 3270
6.4.5.20.1.41 Visualization Element 'Text Editor' ......................................................................................................... 3274
6.4.5.20.1.42 Visualization Element 'Path3D' ................................................................................................................ 3279
6.4.5.20.1.43 Visualization Element 'Control Panel' ................................................................................................. 3282
6.4.5.20.1.44 Visualization Element 'Cartesian XY Chart' ........................................................................................... 3296
6.4.5.20.1.45 Visualization Element 'Date Range Picker' ........................................................................................... 3301
6.4.5.20.1.46 Visualization Element 'Time Range Picker' ........................................................................................... 3306
6.4.5.20.1.47 Visualization Element 'Date Picker' ....................................................................................................... 3311
6.4.5.20.1.48 Visualization Element 'Analog Clock' .................................................................................................... 3317
Visualization Element 'Rectangle', 'Rounded Rectangle', 'Ellipse'

Symbol:

Category: “Basic”

The “Rectangle”, “Rounded Rectangle”, and “Ellipse” are the same type of element. They can be converted into another element type by changing the “Element type” property.

**Element properties**

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: Werkstueck_3</td>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
</tr>
</tbody>
</table>

| “Type of element”    | “Rectangle”, “Rounded Rectangle”, “Ellipse” |

**Element property 'Position'**

The position defines the location and size of the element in the visualization window. This is based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>The x-coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in pixels</td>
<td>Example: 10</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>The y-coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in pixels</td>
<td>Example: 10</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Width”</th>
<th>Specified in pixels</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 150</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Height”</th>
<th>Specified in pixels</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 30</td>
<td></td>
</tr>
</tbody>
</table>

Tip: You can change the values in “X”, “Y”, “Width”, and “Height” by dragging the corresponding symbols to another position in the editor.
**“Angle”**

Static angle of rotation (in degrees)

Example: 35

The element is displayed rotated in the editor. The point of rotation is the center of the element. A positive value rotates clockwise.

Tip: You can change the value in the editor by focusing the element to the handle. When the cursor is displayed as a rotating arrow, you can rotate the element about its center as a handle.

(1): Handle

Note: If a dynamic angle of rotation is also configured in the property “Absolute movement → Internal rotation”, then the static and dynamic angles of rotation are added in runtime mode. The static angle of rotation acts as an offset.

See also

- ☞ Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

**Radius setting**

Visible only when “Rounded Rectangle” is selected in the “Type of element” property.

<table>
<thead>
<tr>
<th>“Radius”</th>
<th>Rounding of the corners.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“From style”</td>
<td></td>
</tr>
<tr>
<td>“Relative to the element size”</td>
<td></td>
</tr>
<tr>
<td>“Explicit”: Allows for specifying a custom value in the “Value” setting.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Value”</th>
<th>Radius of the rounded corners (in pixels)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 5</td>
<td></td>
</tr>
<tr>
<td>Requirement: “Explicit” is selected in the “Radius” setting.</td>
<td></td>
</tr>
</tbody>
</table>

**Element property ‘Center’**

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols ( Audience ) to other positions in the editor.

**Element property ‘Colors’**
### Normal state
The normal state is in effect if the variable in “Color variables ➤ Toggle color” is not defined or it has the value FALSE.

### Frame color
Frame and fill color for the corresponding state of the variable.

### Fill color

### Transparency
Transparency value (0 to 255) for defining the transparency of the selected color.
Example: 255: The color is opaque. 0: The color is completely transparent.

### Alarm state
The alarm state is in effect if the variable in “Color variables ➤ Toggle color” has the value TRUE.

### Use gradient color
☑: The element is displayed with a gradient of two colors.

### Gradient setting
The “Gradient editor” dialog box opens.

### Element property 'Appearance'
The properties contain fixed values for setting the look of the element.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Line width</strong></td>
<td>Value in pixels</td>
</tr>
<tr>
<td></td>
<td>Example: 2</td>
</tr>
<tr>
<td></td>
<td>Note: The values 0 and 1 both result in a line weight of 1 pixel. If no line should be displayed, then the “Line style” property must be set to the option “Invisible”.</td>
</tr>
<tr>
<td><strong>Fill attributes</strong></td>
<td>The way in which the element is filled.</td>
</tr>
<tr>
<td></td>
<td>● “Filled”: The element is filled with the color from property “Colors ➤ Fill color”.</td>
</tr>
<tr>
<td></td>
<td>● “Invisible”: The fill color is invisible.</td>
</tr>
<tr>
<td><strong>Line style</strong></td>
<td>Type of line representation</td>
</tr>
<tr>
<td></td>
<td>● “Solid”</td>
</tr>
<tr>
<td></td>
<td>● “Dashes”</td>
</tr>
<tr>
<td></td>
<td>● “Dots”</td>
</tr>
<tr>
<td></td>
<td>● “Dash Dot”</td>
</tr>
<tr>
<td></td>
<td>● “Dash Dot Dot”</td>
</tr>
<tr>
<td></td>
<td>● “not visible”</td>
</tr>
</tbody>
</table>

You can assign variables in the “Appearance variables” property for controlling the appearance dynamically. The fixed values here are overwritten.

See also
- § Chapter 6.4.5.21.3.5 “Dialog ‘Gradient Editor” on page 3369

### Element property 'Texts'
The properties contains character strings for labeling the element. The character string can also contain a placeholder with a format definition. In runtime mode, the placeholder is replaced by the current value in the specified format.
CODESYS accepts the specified texts automatically into the “GlobalTextList” text list. Therefore, these texts can be localized.

See also
- § “Element property 'Appearance variables” on page 3051
### Text

Character string (without single straight quotation marks) for the labeling the element. Add a line break by pressing the keyboard shortcut [Ctrl] + [Enter].

**Example:** Accesses: %i

The variable that contains the current value for the placeholder is specified in the property “Text variable ➤ Text”.

### Tooltip

Character string (without single straight quotation marks) that is displayed as the tooltip of an element.

**Example:** Number of valid accesses.

The variable that contains the current value for the placeholder is specified in the property “Text variable ➤ Tooltip”.

See also

- ☑ “Element property ‘Text variables’” on page 2993
- ☑ Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
- ☑ Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329

### Element property ‘Text properties’

The properties contain fixed values for the text properties.

<table>
<thead>
<tr>
<th>“Horizontal alignment”</th>
<th>Horizontal alignment of the text within the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Vertical alignment”</td>
<td>Vertical alignment of the text within the element.</td>
</tr>
<tr>
<td>“Text format”</td>
<td>Definition for displaying texts that are too long</td>
</tr>
<tr>
<td></td>
<td>● “Default”: The long text is truncated.</td>
</tr>
<tr>
<td></td>
<td>● “Line break”: The text is split into parts.</td>
</tr>
<tr>
<td></td>
<td>● “Ellipsis”: The visible text ends with “...” indicating that it is not complete.</td>
</tr>
</tbody>
</table>

| “Font”                 | Example: “Default”                                   |
|                       | ☑: The “Font” dialog box opens.                      |
|                       | ☑: Drop-down list with style fonts.                  |

| “Font color”           | Example: “Black”                                     |
|                       | ☑: The “Color” dialog box opens.                     |
|                       | ☑: Drop-down list with style colors.                 |

| “Transparency”         | Whole number (value range from 0 to 255). This determines the transparency of the respective color. |
|                       | Example: 255: The color is opaque.                   |
|                       | 0: The color is completely transparent.              |

Please note: If the color is a style color and already has a transparency value, then this property is write-protected.

### Element property ‘Absolute movement’

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>“Movement”</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iPos_X.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
</tbody>
</table>
| **“Y”** | Variable (numeric data type). Defines the Y position (in pixels).  
Example: PLC_PRG.iPos_Y.  
Increasing this value in runtime mode moves the element downwards. |
| **“Rotation”** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
Example: PLC_PRG.iAngle1.  
The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.  
In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right. |
| **“Scaling”** | Variable (integer data type). Causes centric stretching.  
Example: PLC_PRG.iScaling.  
The reference point is the “Center” property.  
The value 1 shrinks the element by a factor of 0.001. The value 1000 returns the element to its original size. |
| **“Interior rotation”** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
Example: PLC_PRG.iAngle2.  
In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.  
The rotation point is shown as the symbol.  
Note: If a static angle of rotation is specified in the property “Position ➔ Angle”, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed. |
| **“Use REAL values”** | Note: Only available if the device supports the use of REAL coordinates.  
☑️ The properties of the absolute movement are interpreted as REAL values. The values are not rounded.  
The option allows for the individual fine-tuning of drawing the element, for example for the visualization of a smoother rotation.  
Hint: If a horizontal or vertical line is drawn blurry on a specific visualization platform, then this can be corrected by an offset of 0.5px in the direction of the line thickness. |

You can link the variables to a unit conversion.
The properties “X”, “Y”, “Rotation”, and “Interior rotation” are supported by the “Client Animation” functionality.

See also

- “Element property ‘Absolute movement’” on page 2991

**Element property ‘Relative movement’**

The properties contain variables for moving the element. The reference point is the position of the element (“Position” property). The shape of the element can change.

<table>
<thead>
<tr>
<th>“Movement top-left”</th>
<th>Variable (integer data type). It contains the number (in pixels) that the left edge is moved horizontally. Incrementing the value moves the element to the right. Example: PLC_PRG.iDeltaX</th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
<td>Variable (integer data type). It contains the number (in pixels) that the top edge is moved vertically. Incrementing the value moves the element to the down. Example: PLC_PRG.iDeltaY</td>
</tr>
<tr>
<td>“Y”</td>
<td>Variable (integer data type). It contains the number (in pixels) that the right edge is moved horizontally. Incrementing the value moves the element to the right. Example: PLC_PRG.iDeltaWidth</td>
</tr>
<tr>
<td>“Movement bottom-right”</td>
<td>Variable (integer data type). It contains the number (in pixels) that the bottom edge is moved vertically. Incrementing the value moves the element to the down. Example: PLC_PRG.iDeltaHeight</td>
</tr>
</tbody>
</table>

See also

- “Element property ‘Absolute movement’” on page 2991

**Element property ‘Text variables’**

These properties are variables with contents that replace a format definition.

<table>
<thead>
<tr>
<th>“Text variable”</th>
<th>Variable (data type compliant with the format definition). It contains what is printed instead of the format definition. Example: PLC_PRG.iAccesses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note: The format definition is part of the text in the property “Texts ➔ Text”. Note: If you specify a variable of type enumeration with text list support, then the name of the enumeration data type is added automatically in angle brackets after the variable name. Example: PLC_PRG.enVar &lt;enumeration name&gt;. Then the symbolic value of the enumeration component is printed instead of the numeric value when text is printed. Refer to the help page for the enumerations.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Tooltip variable”</th>
<th>Variable (data type compliant with the format definition). It contains what is printed instead of the format definition. Example: PLC_PRG.iAccessesInTooltip</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note: The format definition is part of the text in the property “Texts ➔ Tooltip”.</td>
<td></td>
</tr>
</tbody>
</table>
Dynamic texts are variably indexed texts of a text list. At runtime, the text is displayed that is currently indexed in the variable.

<table>
<thead>
<tr>
<th><strong>Text list</strong></th>
<th>Variable (string) or name of the text list as a fixed string in single straight quotation marks.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example</td>
<td>'Errorlist'</td>
</tr>
<tr>
<td></td>
<td>▼: Drop-down list with the dialogs available in the text lists.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Text index</strong></th>
<th>Text list ID. This refers to the desired output text.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example</td>
<td>'1'</td>
</tr>
<tr>
<td></td>
<td>As a variable (STRING) for dynamically controlling the text output.</td>
</tr>
<tr>
<td>Sample assignment</td>
<td>PLC_PRG.strTextID := '1';</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Tooltip index</strong></th>
<th>Text list ID. This refers to the desired output text.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example</td>
<td>'2'</td>
</tr>
<tr>
<td></td>
<td>As a variable (STRING) for dynamically controlling the text output.</td>
</tr>
<tr>
<td>Sample assignment</td>
<td>PLC_PRG.strToolTipID := '2';</td>
</tr>
</tbody>
</table>

See also
- % Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329
- % “Element property ‘Texts’” on page 2990
- % Chapter 6.4.1.20.5.18 “Enumerations” on page 2263

The variables allow for dynamic control of the text display.

Element property 'Font variables'
### “Font name”
Variable (STRING). Includes the font of the text.
Example: PLC_PRG.stFontVar := 'Arial';
The selection of fonts corresponds to the default “Font” dialog.

### “Size”
Variable (numeric data type). Contains the font size (in pixels or points). The applied unit is specified in brackets after the variable name.
- **<pt>**: Points (default)
  Example: PLC_PRG.iFontHeight <pt>
  Code: iFontHeight : INT := 12;
- **<px>**: Pixels
  Example: PLC_PRG.iFontHeight <px>
  Code: iFontHeight : INT := 19;

If you click in the value field, a drop-down list opens on the right for setting the unit.
Hint: The font size is specified in points (example: Arial 12). Use points when the variable font size should match a font, for example if a font is set in the property “Text property → Font”.

### “Flags”
Variable (DWORD). Contains the flags for displaying fonts.
Flags:
- **1**: Italics
- **2**: Bold
- **4**: Underline
- **8**: Strikethrough
Note: You can combine the font displays by adding the coding of the flags. For example, a bold and underlined text: PLC_PRG.dwFontType := 6;

### “Character set”
Variable (DWORD). Contains a character set number for the font.
The selection of character set numbers corresponds to the “Script” setting of the standard “Font” dialog.

### “Color”
Variable (DWORD). Includes the color of the text.
Example: PLC_PRG.dwColorFont := 16#FF000000;

### “Flags for text alignment”
Variable (integer data type). Contains the coding for text alignment.
Example: PLC_PRG.dwTextAlignment.
Coding:
- **0**: Top left
- **1**: Horizontal center
- **2**: Right
- **4**: Vertical center
- **8**: Bottom
Note: You can combine the text alignments by adding the coding of the flags. For example, a vertical and horizontal centered text: PLC_PRG.dwFontType := 5;
## Element property 'Color variables'

The Element property is used as an interface for project variables to dynamically control colors at runtime.

### “Toggle color”

The property controls the toggled color at runtime.

**Value assignment:**
- **FALSE:** The element is displayed with the color specified in the “Color” property.
- **TRUE:** The element is displayed with the color specified in the “Alarm color” property.

**Assignment options:**
- Placeholder for the user input variable
  - `<toggle/tap variable>`
  - `<NOT toggle/tap variable>`

  The color change is not controlled by its own variable, but by a user input variable.

  **Note:** Specify a variable for the mouse events “Tap” or “Toggle” in the input configuration of the element. Only then is the placeholder set. If you configure a variable in both “Toggle” and “Tap”, then the variable specified in “Tap” is used.

  **Hint:** Click the symbol to insert the placeholder `<toggle/tap variable>` . When you activate the “Inputconfiguration”, “Tap FALSE” property, then the “<NOT toggle/tap variable>” placeholder is displayed.

- Instance path of a project variable (BOOL)
  
  **Example:** PLC_PRG.xColorIsToggeled

  **Note:** In the code, declare and implement the variable specified here. Its value assignment determines when the color changes.

### “Normal state”

### “Alarm state”

The properties listed below control the color depending on the state. The normal state is in effect if the variable in “Color variables”, “Toggle color” is not defined or it has the value FALSE. The alarm state is in effect if the variable in “Color variables”, “Toggle color” has the value TRUE.

### “Frame color”

**Assignment options:**
- Variable (DWORD) for the frame color
  
  **Example:** PLC_PRG.dwBorderColor

- Color literal
  
  **Example of green and opaque:** 16#FF00FF00

### “Filling color”

**Assignment options:**
- Variable (DWORD) for the fill color
  
  **Example:** PLC_PRG.dwFillColor

- Color literal
  
  **Example of gray and opaque:** 16#FF888888
The transparency part of the color value is evaluated only if the "Activate semi-transparent drawing" option of the visualization manager is selected.

Select the "Advanced" option in the toolbar of the properties view. Then all element properties are visible.

See also
- Chapter 6.4.5.10.4 “Animating a color display” on page 2914

The properties contain IEC variables for controlling the appearance of the element dynamically.

### Element property 'Appearance variables'

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Line width&quot;</td>
<td>Variable (integer data type). Contains the line weight (in pixels).</td>
</tr>
<tr>
<td>&quot;Fill attributes&quot;</td>
<td>Variable (DWORD). Controls whether the fill color of the element is visible.</td>
</tr>
<tr>
<td></td>
<td>- Variable value = 0: Filled</td>
</tr>
<tr>
<td></td>
<td>- Variable value &gt; 0: Invisible; no fill color</td>
</tr>
<tr>
<td>&quot;Line style&quot;</td>
<td>Variable (DWORD). Controls the line style.</td>
</tr>
<tr>
<td></td>
<td>Coding:</td>
</tr>
<tr>
<td></td>
<td>- 0: Solid line</td>
</tr>
<tr>
<td></td>
<td>- 1: Dashed line</td>
</tr>
<tr>
<td></td>
<td>- 2: Dotted line</td>
</tr>
<tr>
<td></td>
<td>- 3: Line type &quot;Dash Dot&quot;</td>
</tr>
<tr>
<td></td>
<td>- 3: Line type &quot;Dash Dot Dot&quot;</td>
</tr>
<tr>
<td></td>
<td>- 8: Invisible; no line</td>
</tr>
</tbody>
</table>

Fixed values can be set in the "Appearance" property. These values can be overwritten by dynamic variables at runtime.

See also
- “Element property ‘Appearance’” on page 3002

### Element property 'State variables'

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Invisible&quot;</td>
<td>Variable (BOOL). Toggles the visibility of the element.</td>
</tr>
<tr>
<td></td>
<td>TRUE: The element is not visible at runtime.</td>
</tr>
<tr>
<td></td>
<td>Example: bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR</td>
</tr>
<tr>
<td>&quot;Deactivate inputs&quot;</td>
<td>Variable (BOOL). Toggles the operability of the element.</td>
</tr>
<tr>
<td></td>
<td>TRUE: User inputs do not have any effect in runtime more. The element is</td>
</tr>
<tr>
<td></td>
<td>shown as deactivated.</td>
</tr>
</tbody>
</table>
The “Invisible” property is supported by the “Client Animation” functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

<table>
<thead>
<tr>
<th>“Animation duration”</th>
<th>Defines the duration (in milliseconds) in which the element runs an animation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Variable (integer value)</td>
</tr>
<tr>
<td></td>
<td>Example: Menu.tContent with VAR tContent : INT := 500; END_VAR</td>
</tr>
<tr>
<td></td>
<td>• Integer literal</td>
</tr>
<tr>
<td></td>
<td>Example: 500</td>
</tr>
</tbody>
</table>

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

<table>
<thead>
<tr>
<th>“Move to foreground”</th>
<th>Moves the visualization element to the foreground</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Variable (BOOL)</td>
</tr>
<tr>
<td></td>
<td>Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR</td>
</tr>
<tr>
<td>TRUE: At runtime, the visualization element is displayed in the foreground.</td>
<td></td>
</tr>
<tr>
<td>FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.</td>
<td></td>
</tr>
</tbody>
</table>

## Element property 'Input configuration'

The properties contain the configurations for the user input when using the mouse or keyboard. A user input defines an event and one or more actions that are executed when an event occurs.

The “Configure” button opens the “Input Configuration” dialog. There you can create or edit user inputs. Configured user inputs are listed below the events. They each include the action that is triggered and the setting in short form.

**Example:** "Execute ST Code": PLC_PRG.i_x := 0;

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;OnDialogClosed&quot;</td>
<td>Input event: The user closes the dialog.</td>
</tr>
<tr>
<td>&quot;OnMouseClick&quot;</td>
<td>Input event: The user clicks the mouse button completely in the element area. The mouse button is clicked and released.</td>
</tr>
<tr>
<td>&quot;OnMouseDown&quot;</td>
<td>Input event: The user clicks down on the mouse button.</td>
</tr>
<tr>
<td>&quot;OnMouseEnter&quot;</td>
<td>Input event: The user drags the mouse pointer to the element.</td>
</tr>
<tr>
<td>&quot;OnMouseLeave&quot;</td>
<td>Input event: The user drags the mouse pointer away from the element.</td>
</tr>
</tbody>
</table>
### “OnMouseMove”
Input event: The user moves the mouse pointer over the element area.

### “OnMouseUp”
Input events:
- The user releases the mouse button within the element area. It is irrelevant whether the user has previously pressed the mouse button inside or outside the element area.
- The user presses the mouse button within the element area, leaves the element area, and then releases the mouse button.

Note: This CODESYS-specific triggering behavior guarantees that actions for key elements are completed. A key element starts an action for “OnMouseDown” and ends the action for “OnMouseUp”.

Example: A visualization user presses the mouse button within the element area of the key element and then moves the cursor position so that it lies outside the element area. The action is ended anyway because “OnMouseUp” is triggered.

### “Tap”
When a mouse click event occurs, the variable defined in “Variable” is described in the application. The coding depends on the “Tap FALSE” and “Tap on enter if captured” options.

### “Variable”
Variable (BOOL) that is set on mouse click event.

**Example:** FLC_PRG.bIsTapped

- **TRUE:** A mouse click event exists. It lasts as long as the user presses the mouse button over the element. It ends when the button is released.
- **FALSE:** A mouse click event does not exist.

**Requirement:** The “Tap FALSE” option is not activated.

### “Tap FALSE”
- **☑:** The mouse click event leads to a complementary value in “Variable”.
- **TRUE:** A mouse click event does not exist.
- **FALSE:** While the mouse click event exists.

### “Tap on enter if captured”
- **☑:** During user input, it is also taken into consideration whether the mouse pointer is dragged within the element area or not while the mouse button is pressed.
- **TRUE:** While the mouse click event exists and the mouse pointer is moved over the element area.
- **FALSE:** A mouse click event does not exist. Or the user moves the mouse pointer outside of the element area while the mouse button is pressed.

The value is **TRUE** again as soon as the user moves the pointer back to the element area. The mouse is then captured.

### “Toggle”
With the onset of a mouse click event, the variable is set; when the mouse click event is completed, the variable is reset.

### “Variable”
Variable (BOOL). Its value toggled when the mouse click event is ended. This is when the user releases the mouse button while the mouse pointer is over the element area.

If the user releases the mouse button while the mouse pointer is outside of the element area, then the mouse click event is not ended and the value is not toggled.

**Hint:** The user can cancel a started toggle input by dragging the mouse pointer out of the element area.

### “Toggle on up if captured”
- **☑:** The value toggles regardless of where the mouse pointer is when the mouse button is released. The mouse is then captured.
### Hotkey

Keyboard shortcut on the element for triggering specific input actions. When the keyboard shortcut event occurs, the input actions in the “Events” property are triggered. In this way, it is not the input action itself that leads to this input action, but the mouse input action.

### Key

Key pressed for input action.

Example: \[T\]

Note: The following properties appear when a key is selected.

### Events

- “None”
- “Mouse down”: Pressing the key triggers the input actions that are configured in the “OnMouseDown” property.
- “Mouse up”: Releasing the key triggers the input actions that are configured in the “OnMouseUp” property.
- “Mouse down/up”: Pressing and releasing the key triggers the input actions that are configured in the “OnMouseDown” property and the “OnMouseUp” property.

### Shift

✓: Combination with the Shift key

Example: [Shift]+[T].

### Control

✓: Combination with the Ctrl key

Example: [Ctrl]+[T].

### Alt

✓: Combination with the Alt key

Example: [Alt]+[T].

---

All keyboard shortcuts and their actions that are configured in the visualization are listed on the “Keyboard Configuration” tab.

---

See also

- § Chapter 6.4.5.21.2.2 “Command ‘Keyboard Configuration’” on page 3341
- § Chapter 6.4.5.21.3.6 “Dialog ‘Input Configuration’” on page 3370

---

**Element property ‘Access rights’**

Requirement: User management is set up for the visualization.

### Access rights

Opens the “Access rights” dialog. There you can edit the access privileges for the element.

Status messages:

- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

---

See also

- § Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

---

See also

- § Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

---

**Visualization Element ‘Line’**

Symbol:
Category: “Basic”
The element draws a simple line.

**Element properties**

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Optional.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: Separator_Header</td>
<td></td>
</tr>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
</tbody>
</table>

| “Type of element” | “Line” |

**Element property ‘Position’**  
The following properties define the position and length of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

- **“Dots”**
  - “[0]”: Coordinates of the starting point
  - “[1]”: Coordinate of the end point
  
You can also change the values by dragging the box symbols (→) to other positions in the editor.

- **“Angle”**
  
Static angle of rotation (in degrees).

Example: 35

The element is displayed rotated in the editor. The point of rotation is the center of the element. A positive value rotates clockwise.

Tip: You can change the value in the editor by focusing the element to the handle. When the cursor is displayed as a rotating arrow (⟳), you can rotate the element about its center as a handle.

Example:

![Element rotated in editor](image)

(1): Handle

Note: If a dynamic angle of rotation is also configured in the property “Absolute movement ➔ Internal rotation”, then the static and dynamic angles of rotation are added in runtime mode. The static angle of rotation acts as an offset.

See also

- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

**Element property ‘Center’**
The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the ⚫ symbol. The point is used as the center for rotating and scaling.
<table>
<thead>
<tr>
<th><strong>X</strong></th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Y</strong></td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (ϕ) to other positions in the editor.

### Element property 'Colors'

The properties contain fixed values for setting colors.

<table>
<thead>
<tr>
<th><strong>Color</strong></th>
<th>Color of the line in normal state.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Please note that the normal state is in effect if the expression in the “Color variables ➔ Toggle color” property is not defined or it has the value FALSE.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Alarm color</strong></th>
<th>Color of the line in alarm state.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Please note that the alarm state is in effect if the expression in the “Color variables ➔ Toggle color” property has the value TRUE.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Transparency</strong></th>
<th>Value (0 to 255) for defining the transparency of the selected color.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example 255: The color is opaque. 0: The color is completely transparent.</td>
</tr>
</tbody>
</table>

See also
- ☞ Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

### Element property 'Appearance'

The properties contain fixed values for setting the look of the element.

<table>
<thead>
<tr>
<th><strong>Line width</strong></th>
<th>Value in pixels</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 2</td>
</tr>
</tbody>
</table>

Note: The values 0 and 1 both result in a line weight of one pixel. If no line should be displayed, then the “Line style” property must be set to the option “Invisible”.

<table>
<thead>
<tr>
<th><strong>Line style</strong></th>
<th>Type of line representation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>“Solid”</td>
</tr>
<tr>
<td></td>
<td>“Dashes”</td>
</tr>
<tr>
<td></td>
<td>“Dots”</td>
</tr>
<tr>
<td></td>
<td>“Dash Dot”</td>
</tr>
<tr>
<td></td>
<td>“Dash Dot Dot”</td>
</tr>
<tr>
<td></td>
<td>“not visible”</td>
</tr>
</tbody>
</table>

You can assign variables in the “Appearance variables” property for controlling the appearance dynamically. The fixed values are defined here.

See also
- ☞ “Element property 'Appearance variables” on page 3051
The properties contain character strings for labeling the element. The character string can also contain a placeholder with a format definition. In runtime mode, the placeholder is replaced by the current value in the specified format.

CODESYS accepts the specified texts automatically into the “GlobalTextList” text list. Therefore, these texts can be localized.

### Element property 'Texts'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Text&quot;</td>
<td>Character string (without single straight quotation marks) for labeling the element. Add a line break by pressing the keyboard shortcut [Ctrl] + [Enter]. Example: Accesses: %i. The variable that contains the current value for the placeholder is specified in the property “Text variable” ➔ Text.</td>
</tr>
<tr>
<td>&quot;Tooltip&quot;</td>
<td>Character string (without single straight quotation marks) that is displayed as the tooltip of an element. Example: Number of valid accesses. The variable that contains the current value for the placeholder is specified in the property “Text variable” ➔ Tooltip.</td>
</tr>
</tbody>
</table>

See also
- “Element property 'Text variables’” on page 3005
- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
- Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329

### Element property 'Text properties'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Horizontal alignment&quot;</td>
<td>Horizontal alignment of the text within the element.</td>
</tr>
<tr>
<td>&quot;Vertical alignment&quot;</td>
<td>Vertical alignment of the text within the element.</td>
</tr>
<tr>
<td>&quot;Text format&quot;</td>
<td>Definition for displaying texts that are too long</td>
</tr>
<tr>
<td></td>
<td>- “Default”: The long text is truncated.</td>
</tr>
<tr>
<td></td>
<td>- “Line break”: The text is split into parts.</td>
</tr>
<tr>
<td></td>
<td>- “Ellipsis”: The visible text ends with &quot;...&quot; indicating that it is not complete.</td>
</tr>
<tr>
<td>&quot;Font&quot;</td>
<td>Example: “Default”</td>
</tr>
<tr>
<td></td>
<td>➔ The “Font” dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>➔: Drop-down list with style fonts.</td>
</tr>
<tr>
<td>&quot;Font color&quot;</td>
<td>Example: “Black”</td>
</tr>
<tr>
<td></td>
<td>➔ The “Color” dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>➔: Drop-down list with style colors.</td>
</tr>
<tr>
<td>&quot;Transparency&quot;</td>
<td>Whole number (value range from 0 to 255). This determines the transparency of the respective color. Example: 255: The color is opaque. 0: The color is completely transparent. Please note: If the color is a style color and already has a transparency value, then this property is write-protected.</td>
</tr>
</tbody>
</table>

### Element property 'Absolute movement'

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.
### Movement

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Example</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>X</strong></td>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
<td>PLC_PRG.iPos_X</td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td><strong>Y</strong></td>
<td>Variable (numeric data type). Defines the Y position (in pixels).</td>
<td>PLC_PRG.iPos_Y</td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
</tr>
</tbody>
</table>

### Rotation

- Variable (numeric data type). Defines the angle of rotation (in degrees).
- Example: PLC_PRG.iAngle1.
- The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.
- In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

### Scaling

- Variable (integer data type). Causes centric stretching.
- Example: PLC_PRG.iScaling.
- The reference point is the “Center” property.
- The value 1 shrinks the element by a factor of 0.001. The value 1000 returns the element to its original size.

### Interior rotation

- Variable (numeric data type). Defines the angle of rotation (in degrees).
- Example: PLC_PRG.iAngle2.
- In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.
- The rotation point is shown as the symbol.
- Note: If a static angle of rotation is specified in the property “Position ➔ Angle”, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

### Use REAL values

- Note: Only available if the device supports the use of REAL coordinates.
- The properties of the absolute movement are interpreted as REAL values. The values are not rounded.
- The option allows for the individual fine-tuning of drawing the element, for example for the visualization of a smoother rotation.
- Hint: If a horizontal or vertical line is drawn blurry on a specific visualization platform, then this can be corrected by an offset of 0.5px in the direction of the line thickness.
You can link the variables to a unit conversion.

The properties “X”, “Y”, “Rotation”, and “Interior rotation” are supported by the “Client Animation” functionality.

See also

Element property ‘Relative movement’

The properties contains variables for moving the element. The reference point is the position of the element (“Position” property). The shape of the element can change.

<table>
<thead>
<tr>
<th>Movement point[0]</th>
<th>Variable (numeric data type). It contains the number (in pixels) that the starting point of the line is moved.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Incrementing the X value moves the element to the right.</td>
</tr>
<tr>
<td></td>
<td>Incrementing the Y value moves the element to the down.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Movement point[1]</th>
<th>Variable (numeric data type). It contains the number (in pixels) that the end point of the line is moved.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Incrementing the X value moves the element to the right.</td>
</tr>
<tr>
<td></td>
<td>Incrementing the Y value moves the element to the down.</td>
</tr>
</tbody>
</table>

See also

- "Element property ‘Absolute movement’" on page 3003

Element property ‘Text variables’

These properties are variables with contents that replace a format definition.

<table>
<thead>
<tr>
<th>Text variable</th>
<th>Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: PLC_PRG.iAccesses</td>
</tr>
<tr>
<td></td>
<td>Note: The format definition is part of the text in the property “Texts ➔ Text”.</td>
</tr>
<tr>
<td></td>
<td>Note: If you specify a variable of type enumeration with text list support, then the name of the enumeration data type is added automatically in angle brackets after the variable name. Example: PLC_PRG.enVar &lt;enumeration name&gt;. Then the symbolic value of the enumeration component is printed instead of the numeric value when text is printed. Refer to the help page for the enumerations.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tooltip variable</th>
<th>Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: PLC_PRG.iAccessesInTooltip</td>
</tr>
<tr>
<td></td>
<td>Note: The format definition is part of the text in the property “Texts ➔ Tooltip”.</td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329
- “Element property ‘Texts’” on page 3003
- Chapter 6.4.1.20.5.18 “Enumerations” on page 2263
Dynamic texts are variably indexed texts of a text list. At runtime, the text is displayed that is currently indexed in the variable.

| Element property 'Dynamic texts' | Variable (string) or name of the text list as a fixed string in single straight quotation marks.
Example: 'Errorlist'
▼: Drop-down list with the dialogs available in the text lists. |
| "Text list" | Text list ID. This refers to the desired output text.
● As fixed string with the ID in single straight quotation marks.
Example: '1'
● As a variable (STRING) for dynamically controlling the text output.
Example: strTextID
Sample assignment: PLC_PRG.strTextID := '1'; |
| "Text index" | Text list ID. This refers to the desired output text.
● As fixed string with the ID in single straight quotation marks.
Example: '2'
● As a variable (STRING) for dynamically controlling the text output.
Example: strToolTipID
Sample assignment: PLC_PRG.strToolTipID := '2'; |
| "Tooltip index" | The variables allow for dynamic control of the text display. |
| "Font name" | Variable (STRING). Includes the font of the text.
Example: PLC_PRG.stFontVar := 'Arial';
The selection of fonts corresponds to the default "Font" dialog. |
| "Size" | Variable (numeric data type). Contains the font size (in pixels or points). The applied unit is specified in brackets after the variable name.
● <pt>: Points (default)
Example: PLC_PRG.iFontHeight <pt>
Code: iFontHeight : INT := 12;
● <px>: Pixels
Example: PLC_PRG.iFontHeight <px>
Code: iFontHeight : INT := 19;
If you click in the value field, a drop-down list opens on the right for setting the unit.
Hint: The font size is specified in points (example: Arial 12). Use points when the variable font size should match a font, for example if a font is set in the property "Text property ➔ Font". |
### “Flags”

Variable (DWORD). Contains the flags for displaying fonts.

Flags:
- 1: Italics
- 2: Bold
- 4: Underline
- 8: Strikethrough

Note: You can combine the font displays by adding the coding of the flags. For example, a bold and underlined text: `PLC_PRG.dwFontType := 6;`

### “Character set”

Variable (DWORD). Contains a character set number for the font.

The selection of character set numbers corresponds to the “Script” setting of the standard “Font” dialog.

### “Color”

Variable (DWORD). Includes the color of the text.

Example: `PLC_PRG.dwColorFont := 16#FF000000;`

### “Flags for text alignment”

Variable (integer data type). Contains the coding for text alignment.

Example: `PLC_PRG.dwTextAlignment.`

Coding:
- 0: Top left
- 1: Horizontal center
- 2: Right
- 4: Vertical center
- 8: Bottom

Note: You can combine the text alignments by adding the coding of the flags. For example, a vertical and horizontal centered text: `PLC_PRG.dwFontType := 5;`

---

**Fixed values for displaying texts are set in "Text properties".**

See also
- "Element property 'Text properties'" on page 3003

Element property 'Color variables'

The Element property is used as an interface for project variables to dynamically control colors at runtime.
<table>
<thead>
<tr>
<th><strong>&quot;Toggle color&quot;</strong></th>
<th>The property controls the toggled color at runtime.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Value assignment:</strong></td>
<td></td>
</tr>
<tr>
<td>● <strong>FALSE:</strong> The element is displayed with the color specified in the “Color” property.</td>
<td></td>
</tr>
<tr>
<td>● <strong>TRUE:</strong> The element is displayed with the color specified in the “Alarm color” property.</td>
<td></td>
</tr>
<tr>
<td><strong>Assigning the property:</strong></td>
<td></td>
</tr>
<tr>
<td>● Placeholder for the user input variable</td>
<td></td>
</tr>
<tr>
<td>– “&lt;toggle/tap variable&gt;”</td>
<td></td>
</tr>
<tr>
<td>– “&lt;NOT toggle/tap variable&gt;”</td>
<td></td>
</tr>
<tr>
<td>The color change is not controlled by its own variable, but by a user input variable.</td>
<td></td>
</tr>
<tr>
<td>Note: Specify a variable for the mouse events “Tap” or “Toggle” in the input configuration of the element. Only then is the placeholder set. If you configure a variable in both “Toggle” and “Tap”, then the variable specified in “Tap” is used.</td>
<td></td>
</tr>
<tr>
<td>Hint: Click the symbol to insert the placeholder “&lt;toggle/tap variable&gt;”. When you activate the “Inputconfiguration”, “Tap FALSE” property, then the “&lt;NOT toggle/tap variable&gt;” placeholder is displayed.</td>
<td></td>
</tr>
<tr>
<td>● Instance path of a project variable (BOOL)</td>
<td></td>
</tr>
<tr>
<td>Example: PLC_PRG.xColorIsToggeled</td>
<td></td>
</tr>
<tr>
<td>Note: In the code, declare and implement the variable specified here. Its value assignment determines when the color changes.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>&quot;Color&quot;</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Variable (DWORD) for the color</strong></td>
<td></td>
</tr>
<tr>
<td>Example: PLC_PRG.dwColor</td>
<td></td>
</tr>
<tr>
<td><strong>Color literal</strong></td>
<td></td>
</tr>
<tr>
<td>Example of gray and opaque: 16#FF888888</td>
<td></td>
</tr>
<tr>
<td>Please note that the normal state is in effect if the expression in the “Colorvariables ➔ Toggle color” property is not defined or it has the value FALSE.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>&quot;Alarm color&quot;</strong></th>
<th>Color variable in the alarm state</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Variable (DWORD) for the alarm color</strong></td>
<td></td>
</tr>
<tr>
<td>Example: PLC_PRG.dwAlarmColor</td>
<td></td>
</tr>
<tr>
<td><strong>Color literal</strong></td>
<td></td>
</tr>
<tr>
<td>Example of red and opaque: 16#FFFF0000</td>
<td></td>
</tr>
<tr>
<td>Please note that the alarm state is in effect if the expression in the “Colorvariables ➔ Toggle color” property has the value TRUE.</td>
<td></td>
</tr>
</tbody>
</table>

- The transparency part of the color value is evaluated only if the “Activate semi-transparent drawing” option of the visualization manager is selected.

- Select the “Advanced” option in the toolbar of the properties view. Then all element properties are visible.

See also
- § Chapter 6.4.5.10.4 “Animating a color display” on page 2914
- § Chapter 6.4.5.21.4.2 “Object 'Visualization manager’” on page 3398
**Element property 'State variables'**

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
</table>
| **"Invisible"** | Variable (BOOL). Toggles the visibility of the element.  
  TRUE: The element is not visible at runtime.  
  Example: `bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR` |
| **"Deactivate inputs"** | Variable (BOOL). Toggles the operability of the element.  
  TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated. |

The "Invisible" property is supported by the "Client Animation" functionality.

**Element property 'Line width variable'**

Dynamic definition of the weight of a line element using a variable.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
</table>
| **"Integer value "** | Variable (integer data type). Defines the line weight of the element (in pixels).  
  This overwrites the fixed value that is defined in "Appearance ➤ Line weight".  
  Note: The value 0 codes the same as 1 and sets the line weight to one pixel. |

**Element property 'Line style variable'**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
</table>
| **"Integer value "** | Variable (integer data type). Defines the appearance of the line at runtime.  
  - 1: Solid  
  - 2: Dashes  
  - 3: Dots  
  - 4: Dash Dot  
  - 5: Dash Dot Dot  
  - 6: Invisible: The line is not drawn. |

These properties are available only when you have selected the "Support client animations and overlay of native elements" option in the Visualization Manager.
“Animation duration”

Defines the duration (in milliseconds) in which the element runs an animation

- **Variable (integer value)**
  
  Example: Menu.tContent with VAR tContent : INT := 500; END_VAR

- **Integer literal**
  
  Example: 500

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

“Move to foreground”

Moves the visualization element to the foreground

**Variable (BOOL)**

Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR

TRUE: At runtime, the visualization element is displayed in the foreground.
FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

**Element property 'Input configuration'**

The properties contain the configurations for the user input when using the mouse or keyboard. A user input defines an event and one or more actions that are executed when an event occurs.

The “Configure” button opens the “Input Configuration” dialog. There you can create or edit user inputs.

Configured user inputs are listed below the events. They each include the action that is triggered and the setting in short form.

**Example: “Execute ST Code”:**

PLC_PRG.i_x := 0;

- **“OnDialogClosed”** Input event: The user closes the dialog.
- **“OnMouseClicked”** Input event: The user clicks the mouse button completely in the element area. The mouse button is clicked and released.
- **“OnMouseDown”** Input event: The user clicks down on the mouse button.
- **“OnMouseEnter”** Input event: The user drags the mouse pointer to the element.
- **“OnMouseLeave”** Input event: The user drags the mouse pointer away from the element.
<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“OnMouseMove”</strong></td>
<td>Input event: The user moves the mouse pointer over the element area.</td>
</tr>
<tr>
<td><strong>“OnMouseUp”</strong></td>
<td>Input events:</td>
</tr>
<tr>
<td></td>
<td>● The user releases the mouse button within the element area. It is irrelevant whether the user has previously pressed the mouse button inside or outside the element area.</td>
</tr>
<tr>
<td></td>
<td>● The user presses the mouse button within the element area, leaves the element area, and then releases the mouse button.</td>
</tr>
<tr>
<td></td>
<td>Note: This CODESYS-specific triggering behavior guarantees that actions for key elements are completed. A key element starts an action for “OnMouseDown” and ends the action for “OnMouseUp”.</td>
</tr>
<tr>
<td></td>
<td>Example: A visualization user presses the mouse button within the element area of the key element and then moves the cursor position so that it lies outside the element area. The action is ended anyway because “OnMouseUp” is triggered.</td>
</tr>
<tr>
<td><strong>“Tap”</strong></td>
<td>When a mouse click event occurs, the variable defined in “Variable” is described in the application. The coding depends on the “Tap FALSE” and “Tap on enter if captured” options.</td>
</tr>
<tr>
<td><strong>“Variable”</strong></td>
<td>Variable (BOOL) that is set on mouse click event.</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.bIsTapped</td>
</tr>
<tr>
<td></td>
<td>TRUE: A mouse click event exists. It lasts as long as the user presses the mouse button over the element. It ends when the button is released.</td>
</tr>
<tr>
<td></td>
<td>FALSE: A mouse click event does not exist.</td>
</tr>
<tr>
<td></td>
<td>Requirement: The “Tap FALSE” option is not activated.</td>
</tr>
<tr>
<td><strong>“Tap FALSE”</strong></td>
<td>If: The mouse click event leads to a complementary value in “Variable”.</td>
</tr>
<tr>
<td></td>
<td>TRUE: A mouse click event does not exist.</td>
</tr>
<tr>
<td></td>
<td>FALSE: While the mouse click event exists.</td>
</tr>
<tr>
<td><strong>“Tap on enter if captured”</strong></td>
<td>During user input, it is also taken into consideration whether the mouse pointer is dragged within the element area or not while the mouse button is pressed.</td>
</tr>
<tr>
<td></td>
<td>TRUE: While the mouse click event exists and the mouse pointer is moved over the element area.</td>
</tr>
<tr>
<td></td>
<td>FALSE: A mouse click event does not exist. Or the user moves the mouse pointer outside of the element area while the mouse button is pressed.</td>
</tr>
<tr>
<td></td>
<td>The value is TRUE again as soon as the user moves the pointer back to the element area. The mouse is then captured.</td>
</tr>
<tr>
<td><strong>“Toggle”</strong></td>
<td>With the onset of a mouse click event, the variable is set; when the mouse click event is completed, the variable is reset.</td>
</tr>
<tr>
<td><strong>“Variable”</strong></td>
<td>Variable (BOOL). Its value toggled when the mouse click event is ended. This is when the user releases the mouse button while the mouse pointer is over the element area.</td>
</tr>
<tr>
<td></td>
<td>If the user releases the mouse button while the mouse pointer is outside of the element area, then the mouse click event is not ended and the value is not toggled.</td>
</tr>
<tr>
<td></td>
<td>Hint: The user can cancel a started toggle input by dragging the mouse pointer out of the element area.</td>
</tr>
<tr>
<td><strong>“Toggle on up if captured”</strong></td>
<td>The value toggles regardless of where the mouse pointer is when the mouse button is released. The mouse is then captured.</td>
</tr>
</tbody>
</table>
**“Hotkey”**  
Keyboard shortcut on the element for triggering specific input actions.  
When the keyboard shortcut event occurs, the input actions in the “Events” property are triggered. In this way, it is not the input action itself that leads to this input action, but the mouse input action.

**“Key”**  
Key pressed for input action.  
Example: [T]  
Note: The following properties appear when a key is selected.

**“Events”**  
- “None”  
- “Mouse down”: Pressing the key triggers the input actions that are configured in the “OnMouseDown” property.  
- “Mouse up”: Releasing the key triggers the input actions that are configured in the “OnMouseUp” property.  
- “Mouse down/up”: Pressing and releasing the key triggers the input actions that are configured in the “OnMouseDown” property and the “OnMouseUp” property.

**“Shift”**  
☑: Combination with the Shift key  
Example: [Shift]+[T].

**“Control”**  
☑: Combination with the Ctrl key  
Example: [Ctrl]+[T].

**“Alt”**  
☑: Combination with the Alt key  
Example: [Alt]+[T].

All keyboard shortcuts and their actions that are configured in the visualization are listed on the “Keyboard Configuration” tab.

See also  
- § Chapter 6.4.5.21.2.2 “Command 'Keyboard Configuration’” on page 3341  
- § Chapter 6.4.5.21.3.6 “Dialog 'Input Configuration’” on page 3370

**Element property 'Access rights'**  
Requirement: User management is set up for the visualization.

**“Access rights”**  
Opens the “Access rights” dialog. There you can edit the access privileges for the element.  
Status messages:  
- “Not set. Full rights.”: Access rights for all user groups : “operable”  
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also  
- § Chapter 6.4.5.21.3.1 “Dialog 'Access Rights’” on page 3366

See also  
- § Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

**Visualization Element 'Polygon', 'Polyline', 'Bézier Curve'**  
Symbol:
Category: “Basic”

The “Polygon”, “Polyline”, and “Bézier Curve” are the same element type. They can be converted into another type by changing the “Element type” property.

Elements can be dragged to the editor. The element is then drawn with five points: [0] to [4].

Other positions are added as follows: Move the mouse pointer over a corner point; the mouse pointer changes shape. Now if you press and hold [Ctrl] and click the left mouse button, another point is created. You can delete a point by pressing and holding [Shift]+[Ctrl] and click the selected point.

As an alternative, you can select the element in the toolbox area and in the editor click multiple times. At the same time, a connecting line is drawn from one point to the other. End by double-clicking the element or right-clicking it one time.

**Element properties**

| “Element name” | Optional.  
|----------------|---------------------------------------------------|
| Hint: Assign individual names for elements so that they are found faster in the element list.  
| Example: Werkstueck_1 |
| “Type of element” |  
| ● “Polygon”  
| ● “Polyline”  
| ● “Bézier Curve” |

**Element property ‘Position’**

The following properties define the position of the corner points in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.
### “Dots”

[0..n]: Coordinates of the corner points

Specified in pixels

You can also change the values by dragging the box symbols (✓) to other positions in the editor.

### “Angle”

Static angle of rotation (in degrees).

**Example:** 35

The element is displayed rotated in the editor. The point of rotation is the center of the element. A positive value rotates clockwise.

**Tip:** You can change the value in the editor by focusing the element to the handle. When the cursor is displayed as a rotating arrow (✓), you can rotate the element about its center as a handle.

(1): Handle

Note: If a dynamic angle of rotation is also configured in the property “Absolute movement → Internal rotation”, then the static and dynamic angles of rotation are added in runtime mode. The static angle of rotation acts as an offset.

See also

- ☰ Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

---

### Element property ‘Center’

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the ✗ symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (✓) to other positions in the editor.

---

### Element property ‘Colors’

| “Normal state” | The normal state is in effect if the variable in “Color variables → Toggle color” is not defined or it has the value FALSE. |
| “Frame color”  | Frame and fill color for the corresponding state of the variable. |
| “Fill color”   | |
| “Transparency” | Transparency value (0 to 255) for defining the transparency of the selected color. Example: 255: The color is opaque. 0: The color is completely transparent. |
| “Alarm state”  | The alarm state is in effect if the variable in “Color variables → Toggle color” has the value TRUE. |
“Use gradient color”  The element is displayed with a gradient of two colors.

“Gradient setting”  The “Gradient editor” dialog box opens.

| Element property 'Appearance'
<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“Line width”</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>“Fill attributes”</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

“Line style”  Type of line representation  
- “Solid”  
- “Dashes”  
- “Dots”  
- “Dash Dot”  
- “Dash Dot Dot”  
- “not visible”  

You can assign variables in the “Appearance variables” property for controlling the appearance dynamically. The fixed values here are overwritten.

See also  
- § Chapter 6.4.5.21.3.5 “Dialog ‘Gradient Editor’” on page 3369

| Element property 'Texts'
<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“Text”</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>“Tooltip”</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>
The properties contain fixed values for the text properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Horizontal alignment&quot;</td>
<td>Horizontal alignment of the text within the element.</td>
</tr>
<tr>
<td>&quot;Vertical alignment&quot;</td>
<td>Vertical alignment of the text within the element.</td>
</tr>
<tr>
<td>&quot;Text format&quot;</td>
<td>Definition for displaying texts that are too long</td>
</tr>
<tr>
<td></td>
<td>- &quot;Default&quot;: The long text is truncated.</td>
</tr>
<tr>
<td></td>
<td>- &quot;Line break&quot;: The text is split into parts.</td>
</tr>
<tr>
<td></td>
<td>- &quot;Ellipsis&quot;: The visible text ends with &quot;...&quot; indicating that it is not complete.</td>
</tr>
<tr>
<td>&quot;Font&quot;</td>
<td>Example: “Default”</td>
</tr>
<tr>
<td></td>
<td>- The “Font” dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>- ▼: Drop-down list with style fonts.</td>
</tr>
<tr>
<td>&quot;Font color&quot;</td>
<td>Example: “Black”</td>
</tr>
<tr>
<td></td>
<td>- The “Color” dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>- ▼: Drop-down list with style colors.</td>
</tr>
<tr>
<td>&quot;Transparency&quot;</td>
<td>Whole number (value range from 0 to 255). This determines the transparency of the respective color.</td>
</tr>
<tr>
<td></td>
<td>Example: 255: The color is opaque.</td>
</tr>
<tr>
<td></td>
<td>0: The color is completely transparent.</td>
</tr>
<tr>
<td></td>
<td>Please note: If the color is a style color and already has a transparency value, then this property is write-protected.</td>
</tr>
</tbody>
</table>

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Movement&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;X&quot;</td>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
</tr>
<tr>
<td>Example: PLC_PRG.iPos_X.</td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td>&quot;Y&quot;</td>
<td>Variable (numeric data type). Defines the Y position (in pixels).</td>
</tr>
<tr>
<td>Example: PLC_PRG.iPos_Y.</td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
</tr>
</tbody>
</table>
| **“Rotation”** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
  **Example:** PLC_PRG.iAngle1.  
  The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.  
  In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right. |
| **“Scaling”** | Variable (integer data type). Causes centric stretching.  
  **Example:** PLC_PRG.iScaling.  
  The reference point is the “Center” property.  
  The value 1 shrinks the element by a factor of 0.001. The value 1000 returns the element to its original size. |
| **“Interior rotation”** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
  **Example:** PLC_PRG.iAngle2.  
  In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.  
  The rotation point is shown as the symbol.  
  Note: If a static angle of rotation is specified in the property “Position – Angle”, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed. |
| **“Use REAL values”** | Note: Only available if the device supports the use of REAL coordinates.  
  - The properties of the absolute movement are interpreted as REAL values. The values are not rounded.  
  - The option allows for the individual fine-tuning of drawing the element, for example for the visualization of a smoother rotation.  
  - Hint: If a horizontal or vertical line is drawn blurry on a specific visualization platform, then this can be corrected by an offset of 0.5px in the direction of the line thickness. |

You can link the variables to a unit conversion.
The properties “X”, “Y”, “Rotation”, and “Interior rotation” are supported by the “Client Animation” functionality.

See also

- Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329
- “Element property ‘Texts’” on page 3015
- Chapter 6.4.1.20.5.18 “Enumerations” on page 2263

## Element property ‘Dynamic points’

### “Array of points”

Variable (POINTER TO). Points to an array of the structure VisuElems.VisuStructPoint. The elements iX and iY of VisuStructPoint contain the xy-coordinates of a point. The current number of array elements implicitly contains the variable in the property “Number of points”.

The variable that is assigned to the property “Number of points” contains the number of array elements and therefore the number of corner points.

**Example:**

```pPoints : POINTER TO ARRAY[0..100] OF VisuElems.VisuStructPoint;
```

### “Number of points”

Variable (integer data type): Contains the number of array elements and therefore the number of corner points for displaying the element.

**Example:**

```PLC_PRG.iNumberOfPoints := 24;
```

In the example, the element has 24 points. This definition is necessary because the individual points are defined by a pointer and this does not allow control over the number of points.

Note: In this way, it is possible to adapt the display of the element dynamically by updating the number of corner points.

## Element property ‘Text variables’

These properties are variables with contents that replace a format definition.

### “Text variable”

Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.

**Example:**

```PLC_PRG.iAccesses
```

Note: The format definition is part of the text in the property “Texts ➔ Text”.

Note: If you specify a variable of type enumeration with text list support, then the name of the enumeration data type is added automatically in angle brackets after the variable name. Example: `PLC_PRG.enVar <enumeration name>`. Then the symbolic value of the enumeration component is printed instead of the numeric value when text is printed. Refer to the help page for the enumerations.

### “Tooltip variable”

Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.

**Example:**

```PLC_PRG.iAccessesInTooltip
```

Note: The format definition is part of the text in the property “Texts ➔ Tooltip”.

See also

- “Element property ‘Texts’” on page 3015
- Chapter 6.4.1.20.5.18 “Enumerations” on page 2263
**Element property 'Dynamic texts'**

Dynamic texts are variably indexed texts of a text list. At runtime, the text is displayed that is currently indexed in the variable.

| **“Text list”** | Variable (string) or name of the text list as a fixed string in single straight quotation marks.  
Example: 'Errorlist'  
▼: Drop-down list with the dialogs available in the text lists. |
|-----------------|-------------------------------------------------------------------------------------------------------------|

| **“Text index”** | Text list ID. This refers to the desired output text.  
● As fixed string with the ID in single straight quotation marks.  
Example: '1'  
● As a variable (STRING) for dynamically controlling the text output.  
Example: strTextID  
Sample assignment: PLC_PRG.strTextID := '1'; |
|-----------------|-------------------------------------------------------------------------------------------------------------|

| **“Tooltip index”** | Text list ID. This refers to the desired output text.  
● As fixed string with the ID in single straight quotation marks.  
Example: '2'  
● As a variable (STRING) for dynamically controlling the text output.  
Example: strToolTipID  
Sample assignment: PLC_PRG.strToolTipID := '2'; |
|-----------------|-------------------------------------------------------------------------------------------------------------|

**See also**

- § Chapter 6.4.1.21.2.28 “Object 'Text List’” on page 2532

**Element property 'Font variables’**

The variables allow for dynamic control of the text display.

| **“Font name”** | Variable (STRING). Includes the font of the text.  
Example: PLC_PRG.stFontVar := 'Arial';  
The selection of fonts corresponds to the default “Font” dialog. |
|-----------------|-------------------------------------------------------------------------------------------------------------|

| **“Size”** | Variable (numeric data type). Contains the font size (in pixels or points). The applied unit is specified in brackets after the variable name.  
● <pt>: Points (default)  
Example: PLC_PRG.iFontHeight <pt>  
Code: iFontHeight : INT := 12;  
● <px>: Pixels  
Example: PLC_PRG.iFontHeight <px>  
Code: iFontHeight : INT := 19; |
|-----------------|-------------------------------------------------------------------------------------------------------------|

If you click in the value field, a drop-down list opens on the right for setting the unit.

Hint: The font size is specified in points (example: Arial 12). Use points when the variable font size should match a font, for example if a font is set in the property “Text property ➔ Font”.

---

2024/01/05 3ADR010583, 1, en_US 3019
**“Flags”**

Variable (DWORD). Contains the flags for displaying fonts.

Flags:
- 1: Italics
- 2: Bold
- 4: Underline
- 8: Strikethrough

Note: You can combine the font displays by adding the coding of the flags. For example, a bold and underlined text: `PLC_PRG.dwFontType := 6;`

**“Character set”**

Variable (DWORD). Contains a character set number for the font.

The selection of character set numbers corresponds to the “Script” setting of the standard “Font” dialog.

**“Color”**

Variable (DWORD). Includes the color of the text.

Example: `PLC_PRG.dwColorFont := 16#FF000000;`

**“Flags for text alignment”**

Variable (integer data type). Contains the coding for text alignment.

Example: `PLC_PRG.dwTextAlignment`

Coding:
- 0: Top left
- 1: Horizontal center
- 2: Right
- 4: Vertical center
- 8: Bottom

Note: You can combine the text alignments by adding the coding of the flags. For example, a vertical and horizontal centered text: `PLC_PRG.dwFontType := 5;`

---

Fixed values for displaying texts are set in “Text properties”.

See also

- § “Element property ‘Text properties’” on page 3016

Element property ‘Color variables’

The Element property is used as an interface for project variables to dynamically control colors at runtime.
The property controls the toggled color at runtime.

**Value assignment:**
- **FALSE:** The element is displayed with the color specified in the “Color” property.
- **TRUE:** The element is displayed with the color specified in the “Alarm color” property.

**Assignment options:**
- Placeholder for the user input variable
  - “<toggle/tap variable>”
  - “<NOT toggle/tap variable>”
  
  The color change is not controlled by its own variable, but by a user input variable.

  Note: Specify a variable for the mouse events “Tap” or “Toggle” in the input configuration of the element. Only then is the placeholder set. If you configure a variable in both “Toggle” and “Tap”, then the variable specified in “Tap” is used.

  Hint: Click the symbol < to insert the placeholder “<toggle/tap variable>”. When you activate the “Input configuration”, “Tap FALSE” property, then the “<NOT toggle/tap variable>” placeholder is displayed.

- Instance path of a project variable (BOOL)
  
  Example: PLC_PRG.xColorIsToggled

  Note: In the code, declare and implement the variable specified here. Its value assignment determines when the color changes.

---

**“Normal state”**

**“Alarm state”**

The properties listed below control the color depending on the state. The normal state is in effect if the variable in “Color variables”, “Toggle color” is not defined or it has the value **FALSE**. The alarm state is in effect if the variable in “Color variables”, “Toggle color” has the value **TRUE**.

**“Frame color”**

**Assignment options:**
- Variable (DWORD) for the frame color
  
  Example: PLC_PRG.dwBorderColor

- Color literal
  
  Example of green and opaque: 16#FF00FF00

**“Filling color”**

**Assignment options:**
- Variable (DWORD) for the fill color
  
  Example: PLC_PRG.dwFillColor

- Color literal
  
  Example of gray and opaque: 16#FF888888

---

The transparency part of the color value is evaluated only if the “Activate semi-transparent drawing” option of the visualization manager is selected.

Select the “Advanced” option in the toolbar of the properties view. Then all element properties are visible.

See also
- Chapter 6.4.5.10.4 “Animating a color display” on page 2914
The properties contain IEC variables for controlling the appearance of the element dynamically.

<table>
<thead>
<tr>
<th><strong>Element property 'Appearance variables'</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>&quot;Line width&quot;</strong></td>
<td>Variable (integer data type). Contains the line weight (in pixels).</td>
</tr>
</tbody>
</table>
| **"Fill attributes"** | Variable (DWORD). Controls whether the fill color of the element is visible.  
  - Variable value = 0: Filled  
  - Variable value > 0: Invisible; no fill color |
| **"Line style"** | Variable (DWORD). Controls the line style.  
  - Coding:  
    - 0: Solid line  
    - 1: Dashed line  
    - 2: Dotted line  
    - 3: Line type "Dash Dot"  
    - 3: Line type "Dash Dot Dot"  
    - 8: Invisible; no line |

Fixed values can be set in the "Appearance" property. These values can be overwritten by dynamic variables at runtime.

See also
- § “Element property ‘Appearance’” on page 3043

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th><strong>Element property 'State variables'</strong></th>
<th></th>
</tr>
</thead>
</table>
| **"Invisible"** | Variable (BOOL). Toggles the visibility of the element.  
  TRUE: The element is not visible at runtime.  
  Example: bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR |
| **"Deactivate inputs"** | Variable (BOOL). Toggles the operability of the element.  
  TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated. |

The "Invisible" property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
**“Animation duration”**

Defines the duration (in milliseconds) in which the element runs an animation

- **Variable (integer value)**
  
  **Example:**
  ```
  Menu.tContent with VAR tContent : INT := 500;
  END_VAR
  ```

- **Integer literal**
  
  **Example:** 500

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**“Move to foreground”**

Moves the visualization element to the foreground

**Variable (BOOL)**

**Example:**
```
VAR bIsInForeground : BOOL := FALSE;
END_VAR
```

**TRUE:** At runtime, the visualization element is displayed in the foreground.

**FALSE:** At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

---

**Element property 'Input configuration'**

The properties contain the configurations for the user input when using the mouse or keyboard. A user input defines an event and one or more actions that are executed when an event occurs.

The “Configure” button opens the “Input Configuration” dialog. There you can create or edit user inputs.

Configured user inputs are listed below the events. They each include the action that is triggered and the setting in short form.

**Example:** “Execute ST Code”:
```
PLC_PRG.i_x := 0;
```

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“OnDialogClosed”</strong></td>
<td>Input event: The user closes the dialog.</td>
</tr>
<tr>
<td><strong>“OnMouseClick”</strong></td>
<td>Input event: The user clicks the mouse button completely in the element area.</td>
</tr>
<tr>
<td></td>
<td>The mouse button is clicked and released.</td>
</tr>
<tr>
<td><strong>“OnMouseDown”</strong></td>
<td>Input event: The user clicks down on the mouse button.</td>
</tr>
<tr>
<td><strong>“OnMouseEnter”</strong></td>
<td>Input event: The user drags the mouse pointer to the element.</td>
</tr>
<tr>
<td><strong>“OnMouseLeave”</strong></td>
<td>Input event: The user drags the mouse pointer away from the element.</td>
</tr>
</tbody>
</table>
### “OnMouseMove”
Input event: The user moves the mouse pointer over the element area.

### “OnMouseUp”
Input events:
- The user releases the mouse button within the element area. It is irrelevant whether the user has previously pressed the mouse button inside or outside the element area.
- The user presses the mouse button within the element area, leaves the element area, and then releases the mouse button.

Note: This CODESYS-specific triggering behavior guarantees that actions for key elements are completed. A key element starts an action for “OnMouseDown” and ends the action for “OnMouseUp”.

Example: A visualization user presses the mouse button within the element area of the key element and then moves the cursor position so that it lies outside the element area. The action is ended anyway because “OnMouseUp” is triggered.

### “Tap”
When a mouse click event occurs, the variable defined in “Variable” is described in the application. The coding depends on the “Tap FALSE” and “Tap on enter if captured” options.

### “Variable”
Variable (BOOL) that is set on mouse click event.

Example: PLC PRG.bIsTapped

- TRUE: A mouse click event exists. It lasts as long as the user presses the mouse button over the element. It ends when the button is released.
- FALSE: A mouse click event does not exist.

Requirement: The “Tap FALSE” option is not activated.

### “Tap FALSE”
- ✔: The mouse click event leads to a complementary value in “Variable”.
- TRUE: A mouse click event does not exist.
- FALSE: While the mouse click event exists.

### “Tap on enter if captured”
- ✔: During user input, it is also taken into consideration whether the mouse pointer is dragged within the element area or not while the mouse button is pressed.
- TRUE: While the mouse click event exists and the mouse pointer is moved over the element area.
- FALSE: A mouse click event does not exist. Or the user moves the mouse pointer outside of the element area while the mouse button is pressed.

The value is TRUE again as soon as the user moves the pointer back to the element area. The mouse is then captured.

### “Toggle”
With the onset of a mouse click event, the variable is set; when the mouse click event is completed, the variable is reset.

### “Variable”
Variable (BOOL). Its value toggled when the mouse click event is ended. This is when the user releases the mouse button while the mouse pointer is over the element area.

If the user releases the mouse button while the mouse pointer is outside of the element area, then the mouse click event is not ended and the value is not toggled.

Hint: The user can cancel a started toggle input by dragging the mouse pointer out of the element area.

### “Toggle on up if captured”
- ✔: The value toggles regardless of where the mouse pointer is when the mouse button is released. The mouse is then captured.
“Hotkey”  
Keyboard shortcut on the element for triggering specific input actions.  
When the keyboard shortcut event occurs, the input actions in the “Events” property are triggered. In this way, it is not the input action itself that leads to this input action, but the mouse input action.

“Key”  
Key pressed for input action.  
Example: [T]  
Note: The following properties appear when a key is selected.

“Events”  
- “None”  
- “Mouse down”: Pressing the key triggers the input actions that are configured in the “OnMouseDown” property.  
- “Mouse up”: Releasing the key triggers the input actions that are configured in the “OnMouseUp” property.  
- “Mouse down/up”: Pressing and releasing the key triggers the input actions that are configured in the “OnMouseDown” property and the “OnMouseUp” property.

“Shift”  
☑: Combination with the Shift key  
Example: [Shift]+[T].

“Control”  
☑: Combination with the Ctrl key  
Example: [Ctrl]+[T].

“Alt”  
☑: Combination with the Alt key  
Example: [Alt]+[T].

All keyboard shortcuts and their actions that are configured in the visualization are listed on the “Keyboard Configuration” tab.

See also
- Chapter 6.4.5.21.2.2 “Command ‘Keyboard Configuration’” on page 3341
- Chapter 6.4.5.21.3.6 “Dialog ‘Input Configuration’” on page 3370

Element property ‘Access rights’  
Requirement: User management is set up for the visualization.

“Access rights”  
Opens the “Access rights” dialog. There you can edit the access privileges for the element.  
Status messages:  
- “Not set. Full rights.”: Access rights for all user groups: “operable”  
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also
- Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

See also
- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

Visualization Element ‘Pie’  
Symbol:
Category: “Basic”
The element draws a pie of any angle.

**Element properties**

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: Error_rate_part_1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
</tbody>
</table>

| “Type of element” | “Pie” |

**Element property 'Position'**
The position defines the location and size of the element in the visualization window. This is based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>The x-coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels</td>
</tr>
<tr>
<td></td>
<td>Example: 10</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>The y-coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels</td>
</tr>
<tr>
<td></td>
<td>Example: 10</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Width”</th>
<th>Specified in pixels</th>
<th>Example: 150</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Height”</th>
<th>Specified in pixels</th>
<th>Example: 30</th>
</tr>
</thead>
</table>

Tip: You can change the values in “X”, “Y”, “Width”, and “Height” by dragging the corresponding symbols to another position in the editor.
**“Angle”**

Static angle of rotation (in degrees).

Example: 35

The element is displayed rotated in the editor. The point of rotation is the center of the element. A positive value rotates clockwise.

Tip: You can change the value in the editor by focusing the element to the handle. When the cursor is displayed as a rotating arrow, you can rotate the element about its center as a handle.

(1): Handle

Note: If a dynamic angle of rotation is also configured in the property “Absolute movement → Internal rotation”, then the static and dynamic angles of rotation are added in runtime mode. The static angle of rotation acts as an offset.

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

---

**“Begin”**

Start angle of the pie. If you also define a variable for the start, then the start angle is calculated from the sum of the values for “Begin” and “Variable for begin”.

Example:

- “Begin”: 330
- “End”: 90

---

**“End”**

End angle of the pie. If you also define a variable for the end, then the end angle is calculated from the sum of the values for “End” and “Variable for end”.

The pie is drawn clockwise from the start angle to the end angle.

---

**“Variable for begin”**

The start of the sector is defined dynamically by a variable.

**“Variable for end”**

The end of the sector is defined dynamically by a variable.

**“Only show circle line”**

✓ The pie is drawn without the radius line or filling color.

---

Element property ‘Center’
Display of the center coordinates. You cannot modify these values here in the properties.

If the Pie is selected in the editor, then the center of the Pie (as well as the center of the enveloping box) is visualized with the symbol ✶. Moreover, the element is decorated with a position, begin, and end boxes that you can move.

The center coordinates change when you move the center symbol ✶ in the editor. This also changes the size of the Pie so that the position box ✕ retains its position and the center remains in the middle of the element.

**Element property 'Colors'**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Normal state”</td>
<td>The normal state is in effect if the variable in “Color variables ➔ Toggle color” is not defined or it has the value FALSE.</td>
</tr>
<tr>
<td>“Frame color”</td>
<td>Frame and fill color for the corresponding state of the variable.</td>
</tr>
<tr>
<td>“Fill color”</td>
<td></td>
</tr>
<tr>
<td>“Transparency”</td>
<td>Transparency value (0 to 255) for defining the transparency of the selected color. Example: 255: The color is opaque. 0: The color is completely transparent.</td>
</tr>
<tr>
<td>“Alarm state”</td>
<td>The alarm state is in effect if the variable in “Color variables ➔ Toggle color” has the value TRUE.</td>
</tr>
<tr>
<td>“Use gradient color”</td>
<td>✔: The element is displayed with a gradient of two colors.</td>
</tr>
<tr>
<td>“Gradient setting”</td>
<td>The “Gradient editor” dialog box opens.</td>
</tr>
</tbody>
</table>

See also
- ☑ Chapter 6.4.5.21.3.5 “Dialog ‘Gradient Editor’” on page 3369

**Element property 'Appearance'**

The properties contain fixed values for setting the look of the element.
"Line width"  Value in pixels  
Example: 2  

Note: The values 0 and 1 both result in a line weight of 1 pixel. If no line should be displayed, then the “Line style” property must be set to the option “Invisible”.

"Fill attributes"  The way in which the element is filled.  
- "Filled": The element is filled with the color from property “Colors ➔ Fill color”.  
- "Invisible": The fill color is invisible.

"Line style"  Type of line representation  
- “Solid”  
- “Dashes”  
- “Dots”  
- “Dash Dot”  
- “Dash Dot Dot”  
- “not visible”

You can assign variables in the “Appearance variables” property for controlling the appearance dynamically. The fixed values here are overwritten.

See also  
- § “Element property ‘Appearance variables’” on page 3051

Element property ‘Texts’  The properties contain character strings for labeling the element. The character string can also contain a placeholder with a format definition. In runtime mode, the placeholder is replaced by the current value in the specified format.  
CODESYS accepts the specified texts automatically into the “GlobalTextList” text list. Therefore, these texts can be localized.

"Text"  Character string (without single straight quotation marks) for the labeling the element. Add a line break by pressing the keyboard shortcut [Ctrl] + [Enter].  
Example: Accesess: %i  
The variable that contains the current value for the placeholder is specified in the property “Text variable ➔ Text”.

"Tooltip"  Character string (without single straight quotation marks) that is displayed as the tooltip of an element.  
Example: Number of valid accesses.  
The variable that contains the current value for the placeholder is specified in the property “Text variable ➔ Tooltip”.

See also  
- § “Element property ‘Text variables’” on page 3031  
- § Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872  
- § Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329

Element property ‘Text properties’  The properties contain fixed values for the text properties.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Horizontal alignment</strong></td>
<td>Horizontal alignment of the text within the element.</td>
</tr>
<tr>
<td><strong>Vertical alignment</strong></td>
<td>Vertical alignment of the text within the element.</td>
</tr>
<tr>
<td><strong>Text format</strong></td>
<td>Definition for displaying texts that are too long</td>
</tr>
<tr>
<td></td>
<td>- &quot;Default&quot;: The long text is truncated.</td>
</tr>
<tr>
<td></td>
<td>- &quot;Line break&quot;: The text is split into parts.</td>
</tr>
<tr>
<td></td>
<td>- &quot;Ellipsis&quot;: The visible text ends with &quot;...&quot; indicating that it is not complete.</td>
</tr>
<tr>
<td><strong>Font</strong></td>
<td>Example: &quot;Default&quot;</td>
</tr>
<tr>
<td></td>
<td>- The “Font” dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>- ▼: Drop-down list with style fonts.</td>
</tr>
<tr>
<td><strong>Font color</strong></td>
<td>Example: &quot;Black&quot;</td>
</tr>
<tr>
<td></td>
<td>- The “Color” dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>- ▼: Drop-down list with style colors.</td>
</tr>
<tr>
<td><strong>Transparency</strong></td>
<td>Whole number (value range from 0 to 255). This determines the transparency of the respective color.</td>
</tr>
<tr>
<td></td>
<td>Example: 255: The color is opaque.</td>
</tr>
<tr>
<td></td>
<td>0: The color is completely transparent.</td>
</tr>
<tr>
<td></td>
<td>Please note: If the color is a style color and already has a transparency value, then this property is write-protected.</td>
</tr>
</tbody>
</table>

**Element property 'Absolute movement'**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Movement</strong></td>
<td></td>
</tr>
<tr>
<td><strong>X</strong></td>
<td>Variable (integer data type). Defines the X position (in pixels).</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iPos_X.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td><strong>Y</strong></td>
<td>Variable (integer data type). Defines the Y position (in pixels).</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iPos_Y.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
</tr>
<tr>
<td><strong>Scaling</strong></td>
<td>Variable (integer data type). Causes centric stretching.</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iScaling.</td>
</tr>
<tr>
<td></td>
<td>The reference point is the “Center” property.</td>
</tr>
<tr>
<td></td>
<td>The value 1 shrinks the element by a factor of 0.001. The value 1000 returns the element to its original size.</td>
</tr>
</tbody>
</table>
"Interior rotation" variable (integer data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the \( \oplus \) symbol.

If a static angle of rotation is specified in “Position \( \Rightarrow \) Angle”, then the static angle of rotation and the angle of rotation are added.

You can link the variables to a unit conversion.

The “X”, “Y”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329
- “Element property ‘Texts’” on page 3029
- Chapter 6.4.1.20.5.18 “Enumerations” on page 2263

Element property ‘Text variables’

These properties are variables with contents that replace a format definition.

“Text variable” variable (data type compliant with the format definition). It contains what is printed instead of the format definition.

Example: PLC_PRG.iAccesses

Note: The format definition is part of the text in the property “Texts \( \Rightarrow \) Text”.

Note: If you specify a variable of type enumeration with text list support, then the name of the enumeration data type is added automatically in angle brackets after the variable name. Example: PLC_PRG.enVar <enumeration name>.

Then the symbolic value of the enumeration component is printed instead of the numeric value when text is printed. Refer to the help page for the enumerations.

“Tooltip variable” variable (data type compliant with the format definition). It contains what is printed instead of the format definition.

Example: PLC_PRG.iAccessesInTooltip

Note: The format definition is part of the text in the property “Texts \( \Rightarrow \) Tooltip”.

See also

- Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329
- “Element property ‘Texts’” on page 3029
- Chapter 6.4.1.20.5.18 “Enumerations” on page 2263
**Element property 'Dynamic texts'**

Dynamic texts are variably indexed texts of a text list. At runtime, the text is displayed that is currently indexed in the variable.

<table>
<thead>
<tr>
<th><strong>&quot;Text list&quot;</strong></th>
<th>Variable (string) or name of the text list as a fixed string in single straight quotation marks.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Example:</strong></td>
<td>'Errorlist'</td>
</tr>
<tr>
<td><strong>▼:</strong></td>
<td>Drop-down list with the dialogs available in the text lists.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>&quot;Text index&quot;</strong></th>
<th>Text list ID. This refers to the desired output text.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>● As fixed string with the ID in single straight quotation marks.</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td>'1'</td>
</tr>
<tr>
<td><strong>● As a variable (STRING) for dynamically controlling the text output.</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td>strTextID</td>
</tr>
<tr>
<td><strong>Sample assignment:</strong></td>
<td>PLC_PRG.strTextID := '1';</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>&quot;Tooltip index&quot;</strong></th>
<th>Text list ID. This refers to the desired output text.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>● As fixed string with the ID in single straight quotation marks.</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td>'2'</td>
</tr>
<tr>
<td><strong>● As a variable (STRING) for dynamically controlling the text output.</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td>strToolTipID</td>
</tr>
<tr>
<td><strong>Sample assignment:</strong></td>
<td>PLC_PRG.strToolTipID := '2';</td>
</tr>
</tbody>
</table>

See also

- % Chapter 6.4.1.21.2.28 “Object 'Text List'” on page 2532

**Element property 'Font variables'**

The variables allow for dynamic control of the text display.

<table>
<thead>
<tr>
<th><strong>&quot;Font name&quot;</strong></th>
<th>Variable (STRING). Includes the font of the text.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Example:</strong></td>
<td>PLC_PRG.stFontVar := 'Arial';</td>
</tr>
<tr>
<td><strong>The selection of fonts corresponds to the default “Font” dialog.</strong></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>&quot;Size&quot;</strong></th>
<th>Variable (numeric data type). Contains the font size (in pixels or points). The applied unit is specified in brackets after the variable name.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>● &lt;pt&gt;: Points (default)</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td>PLC_PRG.iFontHeight &lt;pt&gt;</td>
</tr>
<tr>
<td><strong>Code:</strong></td>
<td>iFontHeight := INT := 12;</td>
</tr>
<tr>
<td><strong>● &lt;px&gt;: Pixels</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td>PLC_PRG.iFontHeight &lt;px&gt;</td>
</tr>
<tr>
<td><strong>Code:</strong></td>
<td>iFontHeight := INT := 19;</td>
</tr>
</tbody>
</table>

If you click in the value field, a drop-down list opens on the right for setting the unit.

**Hint:** The font size is specified in points (example: Arial 12). Use points when the variable font size should match a font, for example if a font is set in the property "Text property ➤ Font".
**“Flags”**

Variable (DWORD). Contains the flags for displaying fonts.

Flags:
- 1: Italics
- 2: Bold
- 4: Underline
- 8: Strikethrough

Note: You can combine the font displays by adding the coding of the flags. For example, a bold and underlined text:

```plaintext
PLC_PRG.dwFontType := 6;
```

---

**“Character set”**

Variable (DWORD). Contains a character set number for the font.

The selection of character set numbers corresponds to the “Script” setting of the standard “Font” dialog.

---

**“Color”**

Variable (DWORD). Includes the color of the text.

Example:

```plaintext
PLC_PRG.dwColorFont := 16#FF000000;
```

---

**“Flags for text alignment”**

Variable (integer data type). Contains the coding for text alignment.

Example:

```plaintext
PLC_PRG.dwTextAlignment := 5;
```

Coding:
- 0: Top left
- 1: Horizontal center
- 2: Right
- 4: Vertical center
- 8: Bottom

Note: You can combine the text alignments by adding the coding of the flags. For example, a vertical and horizontal centered text:

```plaintext
PLC_PRG.dwFontType := 5;
```

---

Fixed values for displaying texts are set in “Text properties”.

See also

- \$ “Element property ‘Text properties’” on page 3029

---

**Element property ‘Color variables’**

The Element property is used as an interface for project variables to dynamically control colors at runtime.
### "Toggle color"

The property controls the toggled color at runtime.

**Value assignment:**

- **FALSE:** The element is displayed with the color specified in the “Color” property.
- **TRUE:** The element is displayed with the color specified in the “Alarm color” property.

**Assignment options:**

- Placeholder for the user input variable
  - "<toggle/tap variable>"
  - "<NOT toggle/tap variable>"

The color change is not controlled by its own variable, but by a user input variable.

- Note: Specify a variable for the mouse events “Tap” or “Toggle” in the input configuration of the element. Only then is the placeholder set. If you configure a variable in both “Toggle” and “Tap”, then the variable specified in “Tap” is used.

  - Hint: Click the symbol to insert the placeholder "<toggle/tap variable>". When you activate the “Input configuration”, “Tap FALSE” property, then the “<NOT toggle/tap variable>” placeholder is displayed.

- Instance path of a project variable (BOOL)
  - Example: PLC_PRG.xColorIsToggled

  - Note: In the code, declare and implement the variable specified here. Its value assignment determines when the color changes.

### "Normal state"

### "Alarm state"

The properties listed below control the color depending on the state. The normal state is in effect if the variable in “Color variables”, “Toggle color” is not defined or it has the value FALSE. The alarm state is in effect if the variable in “Color variables”, “Toggle color” has the value TRUE.

### "Frame color"

**Assignment options:**

- Variable (DWORD) for the frame color
  - Example: PLC_PRG.dwBorderColor
- Color literal
  - Example of green and opaque: 16#FF00FF00

### "Filling color"

**Assignment options:**

- Variable (DWORD) for the fill color
  - Example: PLC_PRG.dwFillColor
- Color literal
  - Example of gray and opaque: 16#FF888888

---

The transparency part of the color value is evaluated only if the “Activate semi-transparent drawing” option of the visualization manager is selected.

Select the “Advanced” option in the toolbar of the properties view. Then all element properties are visible.

---

See also

- Chapter 6.4.5.10.4 “Animating a color display” on page 2914
The properties contain IEC variables for controlling the appearance of the element dynamically.

### “Line width”
Variable (integer data type). Contains the line weight (in pixels).

### “Fill attributes”
Variable (DWORD). Controls whether the fill color of the element is visible.
- Variable value = 0: Filled
- Variable value > 0: Invisible; no fill color

### “Line style”
Variable (DWORD). Controls the line style.

<table>
<thead>
<tr>
<th>Coding</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Solid line</td>
</tr>
<tr>
<td>1</td>
<td>Dashed line</td>
</tr>
<tr>
<td>2</td>
<td>Dotted line</td>
</tr>
<tr>
<td>3</td>
<td>Line type &quot;Dash Dot&quot;</td>
</tr>
<tr>
<td>3</td>
<td>Line type &quot;Dash Dot Dot&quot;</td>
</tr>
<tr>
<td>8</td>
<td>Invisible; no line</td>
</tr>
</tbody>
</table>

Fixed values can be set in the “Appearance” property. These values can be overwritten by dynamic variables at runtime.

See also
-  "Element property 'Appearance'" on page 3043

The variables control the element behavior dynamically.

### “Invisible”
Variable (BOOL). Toggles the visibility of the element.

```plaintext
Example: bIsVisible with VAR bIsVisible : BOOL := FALSE;
        END_VAR
```

### “Deactivate inputs”
Variable (BOOL). Toggles the operability of the element.

```plaintext
Example: bIsDeactivated with VAR bIsDeactivated : BOOL := FALSE;
         END_VAR
```

The “Invisible” property is supported by the “Client Animation” functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
“Animation duration”

Defines the duration (in milliseconds) in which the element runs an animation

- **Variable (integer value)**
  
  **Example:** `Menu.tContent with VAR tContent : INT := 500; END_VAR`

- **Integer literal**
  
  **Example:** `500`

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

“Move to foreground”

Moves the visualization element to the foreground

**Variable (BOOL)**

**Example:** `bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR`

**TRUE:** At runtime, the visualization element is displayed in the foreground.

**FALSE:** At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

Element property 'Input configuration'

The properties contain the configurations for the user input when using the mouse or keyboard. A user input defines an event and one or more actions that are executed when an event occurs.

The “Configure” button opens the “Input Configuration” dialog. There you can create or edit user inputs. Configured user inputs are listed below the events. They each include the action that is triggered and the setting in short form.

**Example:** “Execute ST Code”: `PLC_PRG.i_x := 0;`

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“OnDialogClosed”</td>
<td>Input event: The user closes the dialog.</td>
</tr>
<tr>
<td>“OnMouseClick”</td>
<td>Input event: The user clicks the mouse button completely in the element area. The mouse button is clicked and released.</td>
</tr>
<tr>
<td>“OnMouseDown”</td>
<td>Input event: The user clicks down on the mouse button.</td>
</tr>
<tr>
<td>“OnMouseEnter”</td>
<td>Input event: The user drags the mouse pointer to the element.</td>
</tr>
<tr>
<td>“OnMouseLeave”</td>
<td>Input event: The user drags the mouse pointer away from the element.</td>
</tr>
</tbody>
</table>
### “OnMouseMove”
Input event: The user moves the mouse pointer over the element area.

### “OnMouseUp”
Input events:
- The user releases the mouse button within the element area. It is irrelevant whether the user has previously pressed the mouse button inside or outside the element area.
- The user presses the mouse button within the element area, leaves the element area, and then releases the mouse button.

Note: This CODESYS-specific triggering behavior guarantees that actions for key elements are completed. A key element starts an action for “OnMouseDown” and ends the action for “OnMouseUp”.

Example: A visualization user presses the mouse button within the element area of the key element and then moves the cursor position so that it lies outside the element area. The action is ended anyway because “OnMouseUp” is triggered.

### “Tap”
When a mouse click event occurs, the variable defined in “Variable” is described in the application. The coding depends on the “Tap FALSE” and “Tap on enter if captured” options.

### “Variable”
Variable (BOOL) that is set on mouse click event.

Example: PLC_PRG.bIsTapped
- TRUE: A mouse click event exists. It lasts as long as the user presses the mouse button over the element. It ends when the button is released.
- FALSE: A mouse click event does not exist.

Requirement: The “Tap FALSE” option is not activated.

### “Tap FALSE”
- TRUE: The mouse click event leads to a complementary value in “Variable”.
- TRUE: A mouse click event does not exist.
- FALSE: While the mouse click event exists.

### “Tap on enter if captured”
- TRUE: During user input, it is also taken into consideration whether the mouse pointer is dragged within the element area or not while the mouse button is pressed.
- TRUE: While the mouse click event exists and the mouse pointer is moved over the element area.
- FALSE: A mouse click event does not exist. Or the user moves the mouse pointer outside of the element area while the mouse button is pressed.

The value is TRUE again as soon as the user moves the pointer back to the element area. The mouse is then captured.

### “Toggle”
With the onset of a mouse click event, the variable is set; when the mouse click event is completed, the variable is reset.

### “Variable”
Variable (BOOL). Its value toggled when the mouse click event is ended. This is when the user releases the mouse button while the mouse pointer is over the element area.

If the user releases the mouse button while the mouse pointer is outside of the element area, then the mouse click event is not ended and the value is not toggled.

Hint: The user can cancel a started toggle input by dragging the mouse pointer out of the element area.

### “Toggle on up if captured”
- TRUE: The value toggles regardless of where the mouse pointer is when the mouse button is released. The mouse is then captured.
“Hotkey”
Keyboard shortcut on the element for triggering specific input actions. When the keyboard shortcut event occurs, the input actions in the “Events” property are triggered. In this way, it is not the input action itself that leads to this input action, but the mouse input action.

“Key”
Key pressed for input action.
Example: [T]
Note: The following properties appear when a key is selected.

“Events”
- “None”
- “Mouse down”: Pressing the key triggers the input actions that are configured in the “OnMouseDown” property.
- “Mouse up”: Releasing the key triggers the input actions that are configured in the “OnMouseUp” property.
- “Mouse down/up”: Pressing and releasing the key triggers the input actions that are configured in the “OnMouseDown” property and the “OnMouseUp” property.

“Shift”
☑: Combination with the Shift key
Example: [Shift]+[T].

“Control”
☑: Combination with the Ctrl key
Example: [Ctrl]+[T].

“Alt”
☑: Combination with the Alt key
Example: [Alt]+[T].

All keyboard shortcuts and their actions that are configured in the visualization are listed on the “Keyboard Configuration” tab.

See also
- % Chapter 6.4.5.21.2.2 “Command ‘Keyboard Configuration’” on page 3341
- % Chapter 6.4.5.21.3.6 “Dialog ‘Input Configuration’” on page 3370

Requirement: User management is set up for the visualization.

Element property ‘Access rights’
Opens the “Access rights” dialog. There you can edit the access privileges for the element.

Status messages:
- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also
- % Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

Visualization Element ‘Image’
Symbol:

Category: “Basic”
The element adds an image to the visualization. The displayed image is managed in the image pool and referenced in the visualization element by means of a static ID. You can also change the displayed image dynamically by using a variable instead of the static ID.

With the “Background” command, you can define a background for the entire visualization.

Directories that contain the images for use in visualizations can be defined in the project settings (category “Visualization”).

**Element properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Element name”</td>
<td>Status bar</td>
<td>Optional. Hint: Assign individual names for elements so that they are found faster in the element list.</td>
</tr>
<tr>
<td>“Type of element”</td>
<td>“Image”</td>
<td></td>
</tr>
<tr>
<td>“Static ID”</td>
<td>Identifier of the image file for a static assignment</td>
<td>ID of the image file on, as it is defined in the corresponding image pool. If the image is not included in the global image pool in the POU view, then the instance path must be specified. Then the name of the image pool is preceded to make the entry unique. Example: imagepool2.button_image. When a new ID is specified, a file selection dialog opens. The selected file is saved to the “GlobalImagePool”. See also: Help for the “Image Pool” object.</td>
</tr>
<tr>
<td>“Show frame”</td>
<td>☑️: The image file is displayed with a frame.</td>
<td></td>
</tr>
<tr>
<td>“Clipping”</td>
<td>☑️: Only part of the visualization is displayed that fits in the element frame.</td>
<td>Requirement: The “Scaling type” property is “Fixed”.</td>
</tr>
<tr>
<td>“Transparent”</td>
<td>☑️: The image pixels that have the “Transparent color” are displayed as transparent.</td>
<td></td>
</tr>
<tr>
<td>“Transparent color”</td>
<td>Effective only if the “Transparent” option is activated.</td>
<td>The button opens the color selection dialog. This is where you select the transparent color.</td>
</tr>
</tbody>
</table>
### Scaling type
Definition of how an image fits in the element frame.
- **Isotropic**: The entire image is displayed in the element frame, either larger or smaller. As a result, the proportion of height and width are retained.
  
If the alignment of the elements to each other should also be retained within a scaled frame element, then note the following. Unwanted horizontal or vertical offsets can be prevented by setting the properties “Horizontal alignment” and “Vertical alignment” to “Centered”. The alignment of the elements is retained and there are no resulting horizontal or vertical offsets.
  
Example: A lamp is centered above a switch. The lamp should remain in the horizontally centered position, even if the frame is resized.
- **Anisotropic**: The image resizes automatically to the dimensions of the element frame, filling the entire element frame. As a result, the proportions are not retained.
- **Fixed**: The image retains its original size, even if the element frame is resized. Note also that the “Clipping” option is selected.
  
For each reassignment of an image ID, the element size is adapted automatically to the image size.

### Horizontal alignment
Horizontal alignment of the element within the element frame:
- “Left”
- “Centered”
- “Right”

Requirement: The scaling type of the image is “Isotropic” or “Fixed”.

Note: If the visualization is referenced, then the horizontal alignment takes effect within the frame position.

> The “Variable” property is shown below this.

### Variable
Enumeration variable (ENUM VisuElemBase.VisuEnumHorizontalAlignment). Contains the horizontal alignment.

Example: PLC_PRG.eHorizontalAlignment

### Vertical alignment
Vertical alignment of the element within the element frame:
- “Top”
- “Centered”
- “Bottom”

Requirement: The scaling type of the image is “Isotropic” or “Fixed”.

Note: If the visualization is referenced, then the horizontal alignment takes effect within the frame position.

> The “Variable” property is shown below this.

### Variable
Enumeration variable (ENUM VisuElemBase.VisuEnumVerticalAlignment). Contains the vertical alignment.

Example: PLC_PRG.eVerticalAlignment
A valid declaration is required for the variables used as an example in the table above.

### Enumeration

```plaintext
TYPE VisuElemBase.VisuEnumHorizontalAlignment
  LEFT
  HCENTER
  RIGHT
END_TYPE

TYPE VisuElemBase.VisuEnumVerticalAlignment
  DOWN
  VCENTER
  BOTTOM
END_TYPE
```

### Declaration

```plaintext
PROGRAM PLC_PRG
VAR
  eHorizontalAlignment : VisuElemBase.VisuEnumHorizontalAlignment := VisuElemBase.VisuEnumHorizontalAlignment.HCENTER;
END_VAR
```

See also

- **Object 'Image Pool'**

### Element property 'Position'

The position defines the location and size of the element in the visualization window. This is based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“X”</strong></td>
<td>The x-coordinate of the upper left corner of the element&lt;br&gt;Specified in pixels&lt;br&gt;Example: 10</td>
</tr>
<tr>
<td><strong>“Y”</strong></td>
<td>The y-coordinate of the upper left corner of the element&lt;br&gt;Specified in pixels&lt;br&gt;Example: 10</td>
</tr>
<tr>
<td><strong>“Width”</strong></td>
<td>Specified in pixels&lt;br&gt;Example: 150</td>
</tr>
<tr>
<td><strong>“Height”</strong></td>
<td>Specified in pixels&lt;br&gt;Example: 30</td>
</tr>
</tbody>
</table>

Tip: You can change the values in “X”, “Y”, “Width”, and “Height” by dragging the corresponding symbols to another position in the editor.
"Angle"  
Static angle of rotation (in degrees).  
Example: 35  
The element is displayed rotated in the editor. The point of rotation is the center of the element. A positive value rotates clockwise.  
Tip: You can change the value in the editor by focusing the element to the handle. When the cursor is displayed as a rotating arrow, you can rotate the element about its center as a handle.

(1): Handle  
Note: If a dynamic angle of rotation is also configured in the property "Absolute movement ➔ Internal rotation", then the static and dynamic angles of rotation are added in runtime mode. The static angle of rotation acts as an offset.

See also  
- ☞ Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

Element property 'Center'  
The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
<td>X-coordinate of the point of rotation</td>
</tr>
<tr>
<td>“Y”</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (1) to other positions in the editor.

Element property 'Colors'  
The properties contain fixed values for setting colors.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| “Color”     | Color for the frame  
Requirement: “Show frame” property is activated.  
Please note that the normal state is in effect if the expression in the “Color variables ➔ Toggle color” property is not defined or it has the value FALSE. |
| “Alarm color” | Color for the frame in alarm state  
Requirement: “Show frame” property is activated.  
Please note that the alarm state is in effect if the expression in the “Color variables ➔ Toggle color” property has the value TRUE. |
| “Transparency” | Value (0 to 255) for defining the transparency of the selected color.  
Example 255: The color is opaque. 0: The color is completely transparent. |
### Element property 'Appearance'

The properties contain fixed values for setting the look of the element.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Line width&quot;</td>
<td>Value in pixels</td>
</tr>
<tr>
<td></td>
<td>Example: 2</td>
</tr>
<tr>
<td></td>
<td>Note: The values 0 and 1 both result in a line weight of one pixel. If no line should be displayed, then the &quot;Line style&quot; property must be set to the option &quot;Invisible&quot;.</td>
</tr>
<tr>
<td>&quot;Line style&quot;</td>
<td>Type of line representation</td>
</tr>
<tr>
<td></td>
<td>● &quot;Solid&quot;</td>
</tr>
<tr>
<td></td>
<td>● &quot;Dashes&quot;</td>
</tr>
<tr>
<td></td>
<td>● &quot;Dots&quot;</td>
</tr>
<tr>
<td></td>
<td>● &quot;Dash Dot&quot;</td>
</tr>
<tr>
<td></td>
<td>● &quot;Dash Dot Dot&quot;</td>
</tr>
<tr>
<td></td>
<td>● &quot;not visible&quot;</td>
</tr>
</tbody>
</table>

You can assign variables in the "Appearance variables" property for controlling the appearance dynamically. The fixed values are defined here.

### Element property 'Texts'

The properties contain character strings for labeling the element. The character string can also contain a placeholder with a format definition. In runtime mode, the placeholder is replaced by the current value in the specified format.

CODESYS accepts the specified texts automatically into the "GlobalTextList" text list. Therefore, these texts can be localized.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Text&quot;</td>
<td>Character string (without single straight quotation marks) for the labeling the element. Add a line break by pressing the keyboard shortcut [Ctrl] + [Enter].</td>
</tr>
<tr>
<td></td>
<td>Example: Accesses: %i</td>
</tr>
<tr>
<td></td>
<td>The variable that contains the current value for the placeholder is specified in the property &quot;Text variable ➔ Text&quot;.</td>
</tr>
<tr>
<td>&quot;Tooltip&quot;</td>
<td>Character string (without single straight quotation marks) that is displayed as the tooltip of an element.</td>
</tr>
<tr>
<td></td>
<td>Example: Number of valid accesses.</td>
</tr>
<tr>
<td></td>
<td>The variable that contains the current value for the placeholder is specified in the property &quot;Text variable ➔ Tooltip&quot;.</td>
</tr>
</tbody>
</table>

See also

- "Element property 'Appearance variables'" on page 3051
- "Element property 'Text variables'" on page 3046
- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
- Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329
### Element property 'Text properties'

The properties contain fixed values for the text properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Horizontal alignment&quot;</td>
<td>Horizontal alignment of the text within the element.</td>
</tr>
<tr>
<td>&quot;Vertical alignment&quot;</td>
<td>Vertical alignment of the text within the element.</td>
</tr>
<tr>
<td>&quot;Text format&quot;</td>
<td>Definition for displaying texts that are too long</td>
</tr>
<tr>
<td></td>
<td>● &quot;Default&quot;: The long text is truncated.</td>
</tr>
<tr>
<td></td>
<td>● &quot;Line break&quot;: The text is split into parts.</td>
</tr>
<tr>
<td></td>
<td>● &quot;Ellipsis&quot;: The visible text ends with &quot;...&quot; indicating that it is not complete.</td>
</tr>
<tr>
<td>&quot;Font&quot;</td>
<td>Example: &quot;Default&quot;</td>
</tr>
<tr>
<td></td>
<td>▲: The &quot;Font&quot; dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>▼: Drop-down list with style fonts.</td>
</tr>
<tr>
<td>&quot;Font color&quot;</td>
<td>Example: &quot;Black&quot;</td>
</tr>
<tr>
<td></td>
<td>▲: The &quot;Color&quot; dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>▼: Drop-down list with style colors.</td>
</tr>
<tr>
<td>&quot;Transparency&quot;</td>
<td>Whole number (value range from 0 to 255). This determines the transparency of the respective color.</td>
</tr>
<tr>
<td></td>
<td>Example: 255: The color is opaque.</td>
</tr>
<tr>
<td></td>
<td>0: The color is completely transparent.</td>
</tr>
<tr>
<td></td>
<td>Please note: If the color is a style color and already has a transparency value, then this property is write-protected.</td>
</tr>
</tbody>
</table>

### Element property 'Image ID variable'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Image ID&quot;</td>
<td>Variable (STRING). Contains the image ID. The contents of the string corresponds to the description of the &quot;Static ID&quot; property.</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.stImageID := 'ImagePool_A.Image3';</td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.5.21.5.5 "Visualization Element 'Image'" on page 3463
- Chapter 6.4.1.21.2.15 "Object 'Image Pool'" on page 2468

### Element property 'Dynamic image'

You can use this element property for animating a series of image files.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Bitmap version&quot;</td>
<td>Variable (integer data type). Contains the version of the image.</td>
</tr>
<tr>
<td></td>
<td>If the variable changes, then the visualization re-reads the image referenced in the &quot;Image ID&quot; property and displays it.</td>
</tr>
<tr>
<td></td>
<td>The visualization displays animations when the image file on the controller is updated continuously, thus incrementing the version variable. The application must be programmed for this.</td>
</tr>
<tr>
<td></td>
<td>Possible applications</td>
</tr>
<tr>
<td></td>
<td>● Displaying graphics that are generated by the application</td>
</tr>
<tr>
<td></td>
<td>● Displaying images that are refreshed by a camera</td>
</tr>
</tbody>
</table>
**Element property 'Absolute movement'**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>“Movement”</th>
<th></th>
</tr>
</thead>
</table>
| **“X”** | Variable (numeric data type). Defines the X position (in pixels).  
*Example*: PLC_PRG.iPos_X.  
Increasing this value in runtime mode moves the element to the right. |
| **“Y”** | Variable (numeric data type). Defines the Y position (in pixels).  
*Example*: PLC_PRG.iPos_Y.  
Increasing this value in runtime mode moves the element downwards. |

<table>
<thead>
<tr>
<th><strong>“Rotation”</strong></th>
<th></th>
</tr>
</thead>
</table>
| Variable (numeric data type). Defines the angle of rotation (in degrees).  
*Example*: PLC_PRG.iAngle1.  
The midpoint of the element rotates at the “Center” point. This rotation point is shown as the + symbol.  
In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right. |

<table>
<thead>
<tr>
<th><strong>“Scaling”</strong></th>
<th></th>
</tr>
</thead>
</table>
| Variable (integer data type). Causes centric stretching.  
*Example*: PLC_PRG.iScaling.  
The reference point is the “Center” property.  
The value 1 shrinks the element by a factor of 0.001. The value 1000 returns the element to its original size. |

<table>
<thead>
<tr>
<th><strong>“Interior rotation”</strong></th>
<th></th>
</tr>
</thead>
</table>
| Variable (numeric data type). Defines the angle of rotation (in degrees).  
*Example*: PLC_PRG.iAngle2.  
In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.  
The rotation point is shown as the + symbol.  
Note: If a static angle of rotation is specified in the property “Position ➔ Angle”, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed. |

You can link the variables to a unit conversion.
The properties “X”, “Y”, “Rotation”, and “Interior rotation” are supported by the "Client Animation" functionality.

See also

- Element property 'Relative movement'

The properties contains variables for moving the element. The reference point is the position of the element (“Position” property). The shape of the element can change.

<table>
<thead>
<tr>
<th>&quot;Movement top-left&quot;</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
<td>Variable (integer data type). It contains the number (in pixels) that the left edge is moved horizontally. Incrementing the value moves the element to the right. Example: PLC_PRG.iDeltaX</td>
</tr>
<tr>
<td>“Y”</td>
<td>Variable (integer data type). It contains the number (in pixels) that the top edge is moved vertically. Incrementing the value moves the element to the down. Example: PLC_PRG.iDeltaY</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Movement bottom-right&quot;</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
<td>Variable (integer data type). It contains the number (in pixels) that the right edge is moved horizontally. Incrementing the value moves the element to the right. Example: PLC_PRG.iDeltaWidth</td>
</tr>
<tr>
<td>“Y”</td>
<td>Variable (integer data type). It contains the number (in pixels) that the bottom edge is moved vertically. Incrementing the value moves the element to the down. Example: PLC_PRG.iDeltaHeight</td>
</tr>
</tbody>
</table>

See also

- “Element property 'Absolute movement'” on page 3016

Element property 'Text variables'

These properties are variables with contents that replace a format definition.

<table>
<thead>
<tr>
<th>&quot;Text variable&quot;</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable (data type compliant with the format definition). It contains what is printed instead of the format definition. Example: PLC_PRG.iAccesses</td>
<td></td>
</tr>
</tbody>
</table>

Note: The format definition is part of the text in the property “Texts ➔ Text”.

Note: If you specify a variable of type enumeration with text list support, then the name of the enumeration data type is added automatically in angle brackets after the variable name. Example: PLC_PRG.enVar <enumeration name>. Then the symbolic value of the enumeration component is printed instead of the numeric value when text is printed. Refer to the help page for the enumerations.

<table>
<thead>
<tr>
<th>&quot;Tooltip variable&quot;</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable (data type compliant with the format definition). It contains what is printed instead of the format definition. Example: PLC_PRG.iAccessesInTooltip</td>
<td></td>
</tr>
</tbody>
</table>

Note: The format definition is part of the text in the property “Texts ➔ Tooltip”.

See also

- Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329
- “Element property 'Texts’” on page 3043
- Chapter 6.4.1.20.5.18 “Enumerations” on page 2263

Element property 'Dynamic texts’

Dynamic texts are variably indexed texts of a text list. At runtime, the text is displayed that is currently indexed in the variable.

<table>
<thead>
<tr>
<th>“Text list”</th>
<th>Variable (string) or name of the text list as a fixed string in single straight quotation marks.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 'Errorlist' \n\nDROP: Drop-down list with the dialogs available in the text lists.</td>
</tr>
<tr>
<td>“Text index”</td>
<td>Text list ID. This refers to the desired output text. \n\n• As fixed string with the ID in single straight quotation marks. \n  Example: '1' \n\n• As a variable (STRING) for dynamically controlling the text output. \n  Example: strTextID \n  Sample assignment: PLC_PRG.strTextID := '1';</td>
</tr>
<tr>
<td>“Tooltip index”</td>
<td>Text list ID. This refers to the desired output text. \n\n• As fixed string with the ID in single straight quotation marks. \n  Example: '2' \n\n• As a variable (STRING) for dynamically controlling the text output. \n  Example: strToolTipID \n  Sample assignment: PLC_PRG.strToolTipID := '2';</td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.1.21.2.28 “Object 'Text List’” on page 2532

Element property 'Font variables’

The variables allow for dynamic control of the text display.
### Font name

Variable (STRING). Includes the font of the text.

Example: `PLC_PRG.stFontVar := 'Arial';`

The selection of fonts corresponds to the default “Font” dialog.

### Size

Variable (numeric data type). Contains the font size (in pixels or points). The applied unit is specified in brackets after the variable name.

- `<pt>`: Points (default)
  
  Example: `PLC_PRG.iFontHeight <pt>`

  Code: `iFontHeight : INT := 12;`

- `<px>`: Pixels
  
  Example: `PLC_PRG.iFontHeight <px>`

  Code: `iFontHeight : INT := 19;`

If you click in the value field, a drop-down list opens on the right for setting the unit.

Hint: The font size is specified in points (example: Arial 12). Use points when the variable font size should match a font, for example if a font is set in the property “Text property ➤ Font”.

### Flags

Variable (DWORD). Contains the flags for displaying fonts.

Flags:

- 1: Italic
- 2: Bold
- 4: Underline
- 8: Strikethrough

Note: You can combine the font displays by adding the coding of the flags. For example, a bold and underlined text: `PLC_PRG.dwFontType := 6;`

### Character set

Variable (DWORD). Contains a character set number for the font.

The selection of character set numbers corresponds to the “Script” setting of the standard “Font” dialog.

### Color

Variable (DWORD). Includes the color of the text.

Example: `PLC_PRG.dwColorFont := 16#FF000000;`

### Flags for text alignment

Variable (integer data type). Contains the coding for text alignment.

Example: `PLC_PRG.dwTextAlignment`.

Coding:

- 0: Top left
- 1: Horizontal center
- 2: Right
- 4: Vertical center
- 8: Bottom

Note: You can combine the text alignments by adding the coding of the flags. For example, a vertical and horizontal centered text: `PLC_PRG.dwFontType := 5;`
Fixed values for displaying texts are set in “Text properties”.

See also

- "Element property 'Text properties'" on page 3044

**Element property 'Color variables'**

The Element property is used as an interface for project variables to dynamically control colors at runtime.
### “Toggle color”

The property controls the toggled color at runtime.

**Value assignment:**
- **FALSE:** The element is displayed with the color specified in the “Color” property.
- **TRUE:** The element is displayed with the color specified in the “Alarm color” property.

**Assigning the property:**
- Placeholder for the user input variable
  - “<toggle/tap variable>”
  - “<NOT toggle/tap variable>”

The color change is not controlled by its own variable, but by a user input variable.

- Instance path of a project variable (BOOL)
  - Example: PLC_PRG.xColorIsToggled

Note: Specify a variable for the mouse events “Tap” or “Toggle” in the input configuration of the element. Only then is the placeholder set. If you configure a variable in both “Toggle” and “Tap”, then the variable specified in “Tap” is used.

**Hint:** Click the symbol to insert the placeholder “<toggle/tap variable>”. When you activate the “Inputconfiguration”, “Tap FALSE” property, then the “<NOT toggle/tap variable>” placeholder is displayed.

**Instance path of a project variable (BOOL)**
  - Example: PLC_PRG.xColorIsToggled

Note: In the code, declare and implement the variable specified here. Its value assignment determines when the color changes.

### “Color”

Color variable for the frame

- Variable (DWORD) for the color
  - Example: PLC_PRG.dwColor

- Color literal
  - Example of gray and opaque: 16#FF888888

**Requirement:** “Show frame” property is activated.

Please note that the normal state is in effect if the expression in the “Colorvariables ➔ Toggle color” property is not defined or it has the value FALSE.

### “Alarm color”

Color variable for the frame in alarm state

- Variable (DWORD) for the alarm color
  - Example: PLC_PRG.dwAlarmColor

- Color literal
  - Example of red and opaque: 16#FFFF0000

Please note that the alarm state is in effect if the expression in the “Colorvariables ➔ Toggle color” property has the value TRUE.

---

**The transparency part of the color value is evaluated only if the “Activate semi-transparent drawing” option of the visualization manager is selected.**

**Select the “Advanced” option in the toolbar of the properties view. Then all element properties are visible.**
The properties contain variables for controlling the appearance of the element dynamically.

**Element property 'Appearance variables'**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>&quot;Line width&quot;</strong></td>
<td>Variable (integer data type). Contains the line weight (in pixels). Note: The values 0 and 1 both result in a line weight of one pixel. If no line should be displayed, then the &quot;Line style&quot; property must be set to the option &quot;Invisible&quot;.</td>
</tr>
</tbody>
</table>
| **"Line style"** | Variable (DWORD). Controls the line style. Coding:  
- 0: Solid line  
- 1: Dashed line  
- 2: Dotted line  
- 3: Line type "Dash Dot"  
- 3: Line type "Dash Dot Dot"  
- 8: Invisible: The line is not drawn. |

*Fixed values can be set in the "Appearance" property. These values can be overwritten by dynamic variables at runtime.*

See also
- § "Element property 'Appearance'" on page 3043

**Element property 'State variables'**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
</table>
| **"Invisible"** | Variable (BOOL). Toggles the visibility of the element. 
**TRUE**: The element is not visible at runtime. 
**Example**: bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR |
| **"Deactivate inputs"** | Variable (BOOL). Toggles the operability of the element. 
**TRUE**: User inputs do not have any effect in runtime more. The element is shown as deactivated. |

*The "Invisible" property is supported by the "Client Animation" functionality.*

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
**Animation duration**

Defines the duration (in milliseconds) in which the element runs an animation

- Variable (integer value)
  
  **Example:**
  ```
  Menu.tContent with VAR tContent : INT := 500;
  END_VAR
  ```

- Integer literal
  
  **Example:** 500

**Animatable properties**

- "Absolute movement", "Movement", "X", "Y"
- "Absolute movement", "Rotation"
- "Absolute movement", "Interior rotation"
- "Absolute movement", "Exterior rotation"

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**Move to foreground**

Moves the visualization element to the foreground

Variable (BOOL)

**Example:**
```
bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR
```  

**TRUE:** At runtime, the visualization element is displayed in the foreground.

**FALSE:** At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

---

**Element property 'Input configuration'**

The properties contain the configurations for the user input when using the mouse or keyboard.

User input is a user event from the perspective of the element.

The "Configure" button opens the "Input configuration" dialog box for creating or modifying a user input configuration.

A configuration contains one or more input actions for the respective input event. Existing input actions are displayed below it.

**Example:** "Execute ST code": #PLC_PRG.i_x := 0;

- **OnDialogClosed** Input event: The user closes the dialog box.
- **OnMouseClick** Input event: A user clicks the element completely. The mouse button is clicked and released.
- **OnMouseDown** Input event: A user clicks down on the element only.
- **OnMouseEnter** Input event: A user drags the mouse pointer to the element.
- **OnMouseMove** Input event: A user moves the mouse pointer over the element area.
- **OnMouseUp** Input event: The user releases the mouse button over the element area.

See also

- § Chapter 6.4.5.21.3.6 “Dialog 'Input Configuration'” on page 3370
<table>
<thead>
<tr>
<th><strong>Hotkeys</strong></th>
<th>Keyboard shortcut on the element for triggering specific input actions. When the keyboard shortcut event occurs, the input actions in the “Event(s)” property are triggered.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Key</strong></td>
<td>Key pressed for input action. Example: [T]</td>
</tr>
<tr>
<td><strong>Event(s)</strong></td>
<td></td>
</tr>
</tbody>
</table>
- “None”
- “Mouse down”: Pressing the key triggers the input actions that are configured in the “OnMouseDown” property.
- “Mouse up”: Releasing the key triggers the input actions that are configured in the “OnMouseUp” property.
- “Mouse down/up”: Pressing and releasing the key triggers the input actions that are configured in the “OnMouseDown” property and the “OnMouseUp” property. |
| **Shift** | ☑: Combination with the Shift key Example: [Shift]+[T]. |
| **Control** | ☑: Combination with the Ctrl key Example: [Ctrl]+[T]. |
| **Alt** | ☑: Combination with the Alt key Example: [Alt]+[T]. |

All keyboard shortcuts and their actions that are configured in the visualization are listed in the “Keyboard configuration” tab.

See also
- Chapter 6.4.5.21.2.2 “Command ‘Keyboard Configuration’” on page 3341

**Element property 'Access rights’**

Requirement: User management is set up for the visualization.

| **Access rights** | Opens the “Access rights” dialog. There you can edit the access privileges for the element. Status messages:
- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group. |

See also
- Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

See also
- Project Settings - Visualization
- Chapter 6.4.5.21.2.10 “Command ‘Background’” on page 3349
- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

**Visualization Element 'Frame’**

Symbol:
Category: “Basic”

The element serves as a frame in which to display one or more already existing visualizations. You get a structured user interface. The size of the frame can be fixed or scaled. The display area of the referenced visualization then adapts itself to the frame size.

Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: refVisUserInfo</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Type of element”</td>
<td>“Frame”</td>
</tr>
<tr>
<td>“Clipping”</td>
<td>Fixed size. Only that part of the referenced visualization that fits inside the frame is displayed. Requirement: The “Scaling type” property is “Fixed”.</td>
</tr>
<tr>
<td>“Show frame”</td>
<td>Displays the frame</td>
</tr>
<tr>
<td></td>
<td>● “No frame”: The displayed area of the frame does not have borders.</td>
</tr>
<tr>
<td></td>
<td>● “Frame”: The displayed area of the frame has borders.</td>
</tr>
<tr>
<td></td>
<td>● “No frame with offset”: The displayed area of the frame does not have a border and the displayed area of the referenced visualization is reduced inwards by one pixel as compared to the frame area. The gap prevents the referenced visualization from touching any adjacent elements.</td>
</tr>
<tr>
<td>“Scaling type”</td>
<td>The method with which the height and width of the referenced visualization are scaled.</td>
</tr>
<tr>
<td></td>
<td>● “Isotropic”: The visualization is scaled to the size of the element. The visualization retains its proportions with a fixed height/width ratio.</td>
</tr>
<tr>
<td></td>
<td>● “Anisotropic”: The visualization is scaled to the size of the element. The height and width are adapted to the element independently of each other.</td>
</tr>
<tr>
<td></td>
<td>● “Fixed”: the visualization is displayed in its original size without taking into account the size of the element.</td>
</tr>
<tr>
<td></td>
<td>● “Fixed and scrollable”: The visualization is displayed fixed in the element. If it is larger than the element, the element will be provided with scrollbars. Please note: assign variables to the properties “Scroll position variable horizontal” or “Scroll position variable vertical”. You can then edit the data of the scrollbar position in the application.</td>
</tr>
</tbody>
</table>

Element properties 'Scrollbar settings'

The properties contain variables for the position of the scrollboxes in the scrollbars. You can then edit the data of the scrollbox position in the application.
### Requirement
The property “Scaling type” is “fixed and scrollable”.

**“Scroll position variable horizontal”**
Variable (integer data type, also as array). Contains the position of the horizontal or vertical scrollbar. The array contains the position for every display variant. If the visualization runs on several display variants, then the position changes are decoupled from each other.

Example:
```
PLC_PRG.iScrollHor[CURRENTCLIENTID]
PLC_PRG.iScrollVer[CURRENTCLIENTID]
```

The variable is declared as an array in the example.

```
iScrollHor: ARRAY[0..20] OF INT;
iScrollVer: ARRAY[0..20] OF INT;
CURRENTCLIENTID indexes the current display variant.
```

You can combine the variables with a unit conversion.

See also
- [Unit conversion](#)

**“Scroll position variable vertical”**

You can combine the variables with a unit conversion.

See also
- [Unit conversion](#)

**“Deactivation of the background character”**

- The background is drawn. The non-animated element of the referenced visualization is drawn as a background bitmap in order to optimize the performance of the visualization.
- Consequence: Elements can be displayed in an unexpected order at runtime. For example, an animated element can push itself behind the Frame at runtime.

- Background character is deactivated in order to avoid the behavior described above.

**Element property 'References’**

Contains the currently configured visualization references as a subnode

**“References”**
Clicking “Configure” opens the “Frame Configuration” dialog. This is used to manage the referenced visualizations.

Caution: Visualizations can be nested at any depth by means of Frame elements. In order to use the “Switch to any visualization” Frame selection type without any problems, a Frame must not contain more than 21 referenced visualizations. For more information, see also the description for the “Input configuration” of an element: Action “Switch Frame visualization”.

List of the currently referenced visualizations
Visualizations that have a button also have this displayed as a subnode. Each interface variable is listed with the currently assigned transfer parameters.

Example:
```
vis_FormA
- iDataToDisplay_1: PLC_PRG.iVar1
- iDataToDisplay_2: PLC_PRG.iVar2
```

Hint: You can change the assignment of the variables to an interface variable here and edit the value field. Or click the “Configure” button instead.
See also
- § Chapter 6.4.5.21.2.1 “Command 'Interface Editor’” on page 3340
- § Chapter 6.4.5.17 “Creating a structured user interface” on page 2940
- § “Input action 'Switch Frame Visualization” on page 3377

**Element property 'Position'**

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| “X”      | X coordinate of the upper left corner of the element  
Specified in pixels.  
Example: 10. |
| “Y”      | Y coordinate of the upper left corner of the element  
Specified in pixels.  
Example: 10. |
| “Width”  | Specified in pixels.  
Example: 150 |
| “Height” | Specified in pixels.  
Example: 30 |

You can also change the values by dragging the box symbols ( marginBottom) to other positions in the editor.

See also
- § Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

**Element property 'Center'**

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
<td>X-coordinate of the point of rotation</td>
</tr>
<tr>
<td>“Y”</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (margin) to other positions in the editor.

**Element property 'Colors'**

The properties contain fixed values for the colors.
### "Color"

Color of the frame

- Selection list with style colors appears
- Standard dialog "Color" opens for selecting a color.

Please note: the normal state is when the boolean variable in the property "Color variables ➔ Toggle color" is not defined or its value is **FALSE**.

### "Alarm color"

Color with which the element is filled during the alarm state.

Please note: Alarm state is when the value of the boolean variable in the property "Color variables ➔ Toggle color" is **FALSE**.

### "Transparency"

Integer number (value range from 255 to 0). Specifies the transparency of the associated color.

- 255: The color is opaque.
- 0: The color is fully transparent.

Please note: If the color is a style color and already contains a transparency value, then this property is write-protected.

See also
- ☰ Chapter 6.4.5.5.4 “Assigning a color” on page 2876

### Element property 'Appearance'

The properties contain fixed values for setting the look of the element.

<table>
<thead>
<tr>
<th>&quot;Line width&quot;</th>
<th>Value in pixels</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 2</td>
<td></td>
</tr>
</tbody>
</table>

Note: The values 0 and 1 both result in a line weight of one pixel. If no line should be displayed, then the "Line style" property must be set to the option "Invisible".

<table>
<thead>
<tr>
<th>&quot;Line style&quot;</th>
<th>Type of line representation</th>
</tr>
</thead>
<tbody>
<tr>
<td>● “Solid”</td>
<td></td>
</tr>
<tr>
<td>● “Dashes”</td>
<td></td>
</tr>
<tr>
<td>● “Dots”</td>
<td></td>
</tr>
<tr>
<td>● “Dash Dot”</td>
<td></td>
</tr>
<tr>
<td>● “Dash Dot Dot”</td>
<td></td>
</tr>
<tr>
<td>● “not visible”</td>
<td></td>
</tr>
</tbody>
</table>

You can assign variables in the “Appearance variables” property for controlling the appearance dynamically. The fixed values are defined here.

See also
- ☰ “Element property 'Appearance variables’” on page 3064

### Element property 'Texts'

The properties contains character strings for labeling the element. The character string can also contain a placeholder with a format definition. In runtime mode, the placeholder is replaced by the current value in the specified format.

CODESYS accepts the specified texts automatically into the “GlobalTextList” text list. Therefore, these texts can be localized.
### “Text”
Character string (without single straight quotation marks) for the labeling the element. Add a line break by pressing the keyboard shortcut [Ctrl] + [Enter].

**Example:** `Accesses: %i`

The variable that contains the current value for the placeholder is specified in the property “Text variable ➔ Text”.

### “Tooltip”
Character string (without single straight quotation marks) that is displayed as the tooltip of an element.

**Example:** `Number of valid accesses`.

The variable that contains the current value for the placeholder is specified in the property “Text variable ➔ Tooltip”.

---

### Element property 'Text properties'
The properties contain fixed values for the text properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Horizontal alignment”</td>
<td>Horizontal alignment of the text within the element.</td>
</tr>
<tr>
<td>“Vertical alignment”</td>
<td>Vertical alignment of the text within the element.</td>
</tr>
<tr>
<td>“Text format”</td>
<td>Definition for displaying texts that are too long</td>
</tr>
<tr>
<td></td>
<td>- <strong>“Default”</strong>: The long text is truncated.</td>
</tr>
<tr>
<td></td>
<td>- <strong>“Line break”</strong>: The text is split into parts.</td>
</tr>
<tr>
<td></td>
<td>- <strong>“Ellipsis”</strong>: The visible text ends with &quot;...&quot; indicating that it is not complete.</td>
</tr>
<tr>
<td>“Font”</td>
<td><strong>Example:</strong> “Default”</td>
</tr>
<tr>
<td></td>
<td>- The “Font” dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>- ▼: Drop-down list with style fonts.</td>
</tr>
<tr>
<td>“Font color”</td>
<td><strong>Example:</strong> “Black”</td>
</tr>
<tr>
<td></td>
<td>- The “Color” dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>- ▼: Drop-down list with style colors.</td>
</tr>
<tr>
<td>“Transparency”</td>
<td>Whole number (value range from 0 to 255). This determines the transparency of the respective color.</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong> 255: The color is opaque.</td>
</tr>
<tr>
<td></td>
<td>0: The color is completely transparent.</td>
</tr>
<tr>
<td></td>
<td>Please note: If the color is a style color and already has a transparency value, then this property is write-protected.</td>
</tr>
</tbody>
</table>

---

### Element property 'Absolute movement'
The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Movement”</td>
<td></td>
</tr>
<tr>
<td>“X”</td>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong> PLC_PRG.iPos_X.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
</tbody>
</table>
“Y” Variable (numeric data type). Defines the Y position (in pixels).
Example: PLC_PRG.iPos_Y.
Increasing this value in runtime mode moves the element downwards.

“Rotation” Variable (numeric data type). Defines the angle of rotation (in degrees).
Example: PLC_PRG.iAngle1.
The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.
In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

“Scaling” Variable (integer data type). Causes centric stretching.
Example: PLC_PRG.iScaling.
The reference point is the “Center” property.
The value 1 shrinks the element by a factor of 0.001. The value 1000 returns the element to its original size.

You can link the variables to a unit conversion.

The properties “X”, “Y”, “Rotation”, and “Interior rotation” are supported by the “Client Animation” functionality.

Element property 'Relative movement' The properties contain variables for moving the element. The reference point is the position of the element ("Position" property). The shape of the element can change.

“Movement top-left”

“X” Variable (integer data type). It contains the number (in pixels) that the left edge is moved horizontally. Incrementing the value moves the element to the right.
Example: PLC_PRG.iDeltaX

“Y” Variable (integer data type). It contains the number (in pixels) that the top edge is moved vertically. Incrementing the value moves the element to the down.
Example: PLC_PRG.iDeltaY

“Movement bottom-right”
| **“X”** | Variable (integer data type). It contains the number (in pixels) that the **right** edge is moved horizontally. Incrementing the value moves the element to the right.  
*Example:* PLC_PRG.iDeltaWidth |
| **“Y”** | Variable (integer data type). It contains the number (in pixels) that the **bottom** edge is moved vertically. Incrementing the value moves the element to the down.  
*Example:* PLC_PRG.iDeltaHeight |

**Element property ‘Text variables’**  
These properties are variables with contents that replace a format definition.

| **“Text variable”** | Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.  
*Example:* PLC_PRG.iAccesses  
*Note:* The format definition is part of the text in the property “Texts ➔ Text”.  
*Note:* If you specify a variable of type enumeration with text list support, then the name of the enumeration data type is added automatically in angle brackets after the variable name. Example: PLC_PRG.enVar <enumeration name>. Then the symbolic value of the enumeration component is printed instead of the numeric value when text is printed. Refer to the help page for the enumerations. |
| **“Tooltip variable”** | Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.  
*Example:* PLC_PRG.iAccessesInTooltip  
*Note:* The format definition is part of the text in the property “Texts ➔ Tooltip”. |

**Element property ‘Dynamic texts’**  
Dynamic texts are variably indexed texts of a text list. At runtime, the text is displayed that is currently indexed in the variable.
"Text list"  
Variable (string) or name of the text list as a fixed string in single straight quotation marks.  
Example: 'Errorlist'  
▼: Drop-down list with the dialogs available in the text lists.

"Text index"  
Text list ID. This refers to the desired output text.  
- As fixed string with the ID in single straight quotation marks.  
  Example: '1'  
- As a variable (STRING) for dynamically controlling the text output.  
  Example: strTextID  
  Sample assignment: PLC_PRG.strTextID := '1';

"Tooltip index"  
Text list ID. This refers to the desired output text.  
- As fixed string with the ID in single straight quotation marks.  
  Example: '2'  
- As a variable (STRING) for dynamically controlling the text output.  
  Example: strToolTipID  
  Sample assignment: PLC_PRG.strToolTipID := '2';

See also  
- \( \approx \) Chapter 6.4.1.21.2.28 “Object 'Text List'” on page 2532

Element property 'Font variables'  
The variables allow for dynamic control of the text display.

"Font name"  
Variable (STRING). Includes the font of the text.  
Example: PLC_PRG.stFontVar := 'Arial';  
The selection of fonts corresponds to the default “Font” dialog.

"Size"  
Variable (numeric data type). Contains the font size (in pixels or points). The applied unit is specified in brackets after the variable name.  
- \(<\text{pt}\rangle\): Points (default)  
  Example: PLC_PRG.iFontHeight <pt>  
  Code: iFontHeight : INT := 12;  
- \(<\text{px}\rangle\): Pixels  
  Example: PLC_PRG.iFontHeight <px>  
  Code: iFontHeight : INT := 19;

If you click in the value field, a drop-down list opens on the right for setting the unit.  

Hint: The font size is specified in points (example: Arial 12). Use points when the variable font size should match a font, for example if a font is set in the property “Text property \( \rightarrow \) Font”.
### Flags

Variable (DWORD). Contains the flags for displaying fonts.

Flags:
- 1: Italics
- 2: Bold
- 4: Underline
- 8: Strikethrough

Note: You can combine the font displays by adding the coding of the flags. For example, a bold and underlined text: PLC_PRG.dwFontType := 6;

### Character set

Variable (DWORD). Contains a character set number for the font.

The selection of character set numbers corresponds to the "Script" setting of the standard "Font" dialog.

### Color

Variable (DWORD). Includes the color of the text.

Example: PLC_PRG.dwColorFont := 16#FF000000;

### Flags for text alignment

Variable (integer data type). Contains the coding for text alignment.

Example: PLC_PRG.dwTextAlignment.

Coding:
- 0: Top left
- 1: Horizontal center
- 2: Right
- 4: Vertical center
- 8: Bottom

Note: You can combine the text alignments by adding the coding of the flags. For example, a vertical and horizontal centered text: PLC_PRG.dwFontType := 5;

---

**Fixed values for displaying texts are set in "Text properties".**

See also

- ¶ "Element property 'Text properties'" on page 3058

**Element property 'Color variables'**

The Element property is used as an interface for project variables to dynamically control colors at runtime.
**“Toggle color”**
The property controls the toggled color at runtime.

**Value assignment:**
- **FALSE**: The element is displayed with the color specified in the “Color” property.
- **TRUE**: The element is displayed with the color specified in the “Alarm color” property.

**Assigning the property:**
- Placeholder for the user input variable
  - “<toggle/tap variable>”
  - “<NOT toggle/tap variable>”

  The color change is not controlled by its own variable, but by a user input variable.

  **Note:** Specify a variable for the mouse events “Tap” or “Toggle” in the input configuration of the element. Only then is the placeholder set. If you configure a variable in both “Toggle” and “Tap”, then the variable specified in “Tap” is used.

  **Hint:** Click the symbol to insert the placeholder “<toggle/tap variable>”. When you activate the “Input configuration”, “Tap FALSE” property, then the “<NOT toggle/tap variable>” placeholder is displayed.

- Instance path of a project variable (BOOL)
  Example: PLC_PRG.xColorIsToggled

  **Note:** In the code, declare and implement the variable specified here. Its value assignment determines when the color changes.

---

**“Color”**
Color variable for the Frame

- **Variable (DWORD) for the color**
  Example: PLC_PRG.dwColor

- **Color literal**
  Example of gray and opaque: 16#FF888888

  **Requirement:** “Show Frame” property is activated.

  Please note that the normal state is in effect if the expression in the “Colorvariables ➔ Toggle color” property is not defined or it has the value FALSE.

---

**“Alarm color”**
Color variable for the Frame in alarm state

- **Variable (DWORD) for the alarm color**
  Example: PLC_PRG.dwAlarmColor

- **Color literal**
  Example of red and opaque: 16#FFFF0000

  Please note that the alarm state is in effect if the expression in the “Colorvariables ➔ Toggle color” property has the value TRUE.

---

The transparency part of the color value is evaluated only if the “Activate semi-transparent drawing” option of the visualization manager is selected.

---

Select the “Advanced” option in the toolbar of the properties view. Then all element properties are visible.
The properties contain variables for controlling the appearance of the element dynamically.

### Element property 'Appearance variables'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Line width”</strong></td>
<td>Variable (integer data type). Contains the line weight (in pixels). Note: The values 0 and 1 both result in a line weight of one pixel. If no line should be displayed, then the “Line style” property must be set to the option “Invisible”.</td>
</tr>
<tr>
<td><strong>“Line style”</strong></td>
<td>Variable (DWORD). Controls the line style. Coding:</td>
</tr>
<tr>
<td></td>
<td>● 0: Solid line</td>
</tr>
<tr>
<td></td>
<td>● 1: Dashed line</td>
</tr>
<tr>
<td></td>
<td>● 2: Dotted line</td>
</tr>
<tr>
<td></td>
<td>● 3: Line type &quot;Dash Dot&quot;</td>
</tr>
<tr>
<td></td>
<td>● 3: Line type &quot;Dash Dot Dot&quot;</td>
</tr>
<tr>
<td></td>
<td>● 8: Invisible: The line is not drawn.</td>
</tr>
</tbody>
</table>

*Fixed values can be set in the “Appearance” property. These values can be overwritten by dynamic variables at runtime.*

### Element property 'Switch frame variable'

The variable controls the switching of the referenced visualizations. This variable indexes one of the referenced frame visualizations and this is displayed in the frame. When the value of the variable changes, it switches to the recently indexed visualization.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Variable”</strong></td>
<td>Variable (integer data type) that contains the index of the active visualization Example: PLC_PRG.uiIndexVisu</td>
</tr>
<tr>
<td></td>
<td>Hint: The “Frame Configuration” dialog includes a list of referenced visualizations. The visualizations are automatically numerically indexed via the order in the list. Note: This variant of switching usually affects all connected display variants.</td>
</tr>
<tr>
<td></td>
<td>Array element (integer data type) for index access via CURRENTCLIENTID Example: PLC_PRG.aIndexVisu[CURRENTCLIENTID]</td>
</tr>
<tr>
<td></td>
<td>Note: This variant of switching applies to the current client only, and therefore only on one display variant. That is the display variant where the value change was triggered (for example, by means of user input).</td>
</tr>
</tbody>
</table>

### Element property 'State variables'

The variables control the element behavior dynamically.
**“Invisible”**

Variable (BOOL). Toggles the visibility of the element.

**TRUE**: The element is not visible at runtime.

**Example**:
```
bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR
```

**“Deactivate inputs”**

Variable (BOOL). Toggles the operability of the element.

**TRUE**: User inputs do not have any effect in runtime more. The element is shown as deactivated.

> The “Invisible” property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

**“Animation duration”**

Defines the duration (in milliseconds) in which the element runs an animation

- **Variable (integer value)**
  ```
  Menu.tContent with VAR tContent : INT := 500; END_VAR
  ```

- **Integer literal**
  ```
  Example: 500
  ```

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**“Move to foreground”**

Moves the visualization element to the foreground

**Variable (BOOL)**

**Example**:
```
bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR
```

**TRUE**: At runtime, the visualization element is displayed in the foreground.

**FALSE**: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

**Element property 'Input configuration'**

The properties contain the configurations for the user input when using the mouse or keyboard. A user input defines an event and one or more actions that are executed when an event occurs.
The “Configure” button opens the “Input Configuration” dialog. There you can create or edit user inputs. Configured user inputs are listed below the events. They each include the action that is triggered and the setting in short form.

Example: “Execute ST Code”:

```
PLC_PRG.i_x := 0;
```

“OnDialogClosed” Input event: The user closes the dialog.

“OnMouseClick” Input event: The user clicks the mouse button completely in the element area. The mouse button is clicked and released.

“OnMouseDown” Input event: The user clicks down on the mouse button.

“OnMouseEnter” Input event: The user drags the mouse pointer to the element.

“OnMouseLeave” Input event: The user drags the mouse pointer away from the element.

“OnMouseMove” Input event: The user moves the mouse pointer over the element area.

“OnMouseUp” Input events:

- The user releases the mouse button within the element area. It is irrelevant whether the user has previously pressed the mouse button inside or outside the element area.
- The user presses the mouse button within the element area, leaves the element area, and then releases the mouse button.

Note: This CODESYS-specific triggering behavior guarantees that actions for key elements are completed. A key element starts an action for “OnMouseDown” and ends the action for “OnMouseUp”.

Example: A visualization user presses the mouse button within the element area of the key element and then moves the cursor position so that it lies outside the element area. The action is ended anyway because “OnMouseUp” is triggered.

“Tap” When a mouse click event occurs, the variable defined in “Variable” is described in the application. The coding depends on the “Tap FALSE” and “Tap on enter if captured” options.

“Variable” Variable (BOOL) that is set on mouse click event.

Example: PLC_PRG.bIsTapped

TRUE: A mouse click event exists. It lasts as long as the user presses the mouse button over the element. It ends when the button is released.

FALSE: A mouse click event does not exist.

Requirement: The “Tap FALSE” option is not activated.

“Tap FALSE” [✓]: The mouse click event leads to a complementary value in “Variable”.

TRUE: A mouse click event does not exist.

FALSE: While the mouse click event exists.

“Tap on enter if captured” [✓]: During user input, it is also taken into consideration whether the mouse pointer is dragged within the element area or not while the mouse button is pressed.

TRUE: While the mouse click event exists and the mouse pointer is moved over the element area.

FALSE: A mouse click event does not exist. Or the user moves the mouse pointer outside of the element area while the mouse button is pressed.

The value is TRUE again as soon as the user moves the pointer back to the element area. The mouse is then captured.
“Toggle” | With the onset of a mouse click event, the variable is set; when the mouse click event is completed, the variable is reset.

“Variable” | Variable (BOOL). Its value toggled when the mouse click event is ended. This is when the user releases the mouse button while the mouse pointer is over the element area. If the user releases the mouse button while the mouse pointer is outside of the element area, then the mouse click event is not ended and the value is not toggled. Hint: The user can cancel a started toggle input by dragging the mouse pointer out of the element area.

“Toggle on up if captured” | ☑: The value toggles regardless of where the mouse pointer is when the mouse button is released. The mouse is then captured.

“Hotkey” | Keyboard shortcut on the element for triggering specific input actions. When the keyboard shortcut event occurs, the input actions in the “Events” property are triggered. In this way, it is not the input action itself that leads to this input action, but the mouse input action.

“Key” | Key pressed for input action. Example: [T]

“Events” | ● “None”
● “Mouse down”: Pressing the key triggers the input actions that are configured in the “OnMouseDown” property.
● “Mouse up”: Releasing the key triggers the input actions that are configured in the “OnMouseUp” property.
● “Mouse down/up”: Pressing and releasing the key triggers the input actions that are configured in the “OnMouseDown” property and the “OnMouseUp” property.

“Shift” | ☑: Combination with the Shift key Example: [Shift]+[T].

“Control” | ☑: Combination with the Ctrl key Example: [Ctrl]+[T].

“Alt” | ☑: Combination with the Alt key Example: [Alt]+[T].

All keyboard shortcuts and their actions that are configured in the visualization are listed on the “Keyboard Configuration” tab.

See also
● § Chapter 6.4.5.21.2.2 “Command ‘Keyboard Configuration’” on page 3341
● § Chapter 6.4.5.21.3.6 “Dialog ‘Input Configuration’” on page 3370

Element property 'Access rights' | Requirement: User management is set up for the visualization.
“Access rights”
Opens the “Access rights” dialog. There you can edit the access privileges for the element.

Status messages:
- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also
- § Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

Visualization Element ‘Label’
Symbol:

Category: “Common Controls”
The element is used to label visualizations.

Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
<tr>
<td>Example: Header_Parameter</td>
<td></td>
</tr>
</tbody>
</table>

| “Type of element” | “Label” |

Element property ‘Texts’
The property requires a character string.
This text is entered automatically into the GlobalTextList text list and can be localized there.

<table>
<thead>
<tr>
<th>“Text”</th>
<th>Character string (without single straight quotation marks)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: Main page</td>
<td></td>
</tr>
</tbody>
</table>

See also
- § Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
- § Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329

Element property ‘Position’
The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.
### "X"
- X coordinate of the upper left corner of the element
- Specified in pixels.
- Example: 10.

### "Y"
- Y coordinate of the upper left corner of the element
- Specified in pixels.
- Example: 10.

### "Width"
- Specified in pixels.
- Example: 150

### "Height"
- Specified in pixels.
- Example: 30

You can also change the values by dragging the box symbols (_draging_image_ ) to other positions in the editor.

See also
- Chapter 6.4.5.3 "Positioning the Element, Adapting Size and Layer" on page 2874

#### Element property 'Center'

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the _rotation_symbol_ symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>&quot;X&quot;</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Y&quot;</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (_rotation_symbol_ ) to other positions in the editor.

#### Element property 'Text properties'

The properties contain fixed values for the text properties.

<table>
<thead>
<tr>
<th>&quot;Horizontal alignment&quot;</th>
<th>Horizontal alignment of the text within the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Vertical alignment&quot;</td>
<td>Vertical alignment of the text within the element.</td>
</tr>
<tr>
<td>&quot;Text format&quot;</td>
<td>Definition for displaying texts that are too long</td>
</tr>
<tr>
<td></td>
<td>• &quot;Default&quot;: The long text is truncated.</td>
</tr>
<tr>
<td></td>
<td>• &quot;Line break&quot;: The text is split into parts.</td>
</tr>
<tr>
<td></td>
<td>• &quot;Ellipsis&quot;: The visible text ends with &quot;...&quot; indicating that it is not complete.</td>
</tr>
<tr>
<td>&quot;Font&quot;</td>
<td>Example: &quot;Default&quot;</td>
</tr>
<tr>
<td></td>
<td>✉: The &quot;Font&quot; dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>▼: Drop-down list with style fonts.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Font color</strong></td>
<td>Example: “Black”&lt;br&gt;Ʉ: The “Color” dialog box opens.&lt;br&gt;▼: Drop-down list with style colors.</td>
</tr>
<tr>
<td><strong>Transparency</strong></td>
<td>Whole number (value range from 0 to 255). This determines the transparency of the respective color.&lt;br&gt;Example: 255: The color is opaque.&lt;br&gt;0: The color is completely transparent.&lt;br&gt;Please note: If the color is a style color and already has a transparency value, then this property is write-protected.</td>
</tr>
</tbody>
</table>

**Element property ‘Absolute movement’**<br>The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th><strong>Movement</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>X</strong></td>
<td>Variable (numeric data type). Defines the X position (in pixels).&lt;br&gt;Example: PLC_PRG.iPos_X.&lt;br&gt;Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td><strong>Y</strong></td>
<td>Variable (numeric data type). Defines the Y position (in pixels).&lt;br&gt;Example: PLC_PRG.iPos_Y.&lt;br&gt;Increasing this value in runtime mode moves the element downwards.</td>
</tr>
<tr>
<td><strong>Rotation</strong></td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).&lt;br&gt;Example: PLC_PRG.iAngle1.&lt;br&gt;The midpoint of the element rotates at the “Center” point. This rotation point is shown as the ⚫ symbol.&lt;br&gt;In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
</tr>
<tr>
<td><strong>Interior rotation</strong></td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).&lt;br&gt;Example: PLC_PRG.iAngle2.&lt;br&gt;In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.&lt;br&gt;The rotation point is shown as the ⚫ symbol.&lt;br&gt;Note: If a static angle of rotation is specified in the “Position Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.</td>
</tr>
</tbody>
</table>
You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- Element property 'State variables'

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>“Invisible”</th>
<th>Variable (BOOL). Toggles the visibility of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRUE:</td>
<td>The element is not visible at runtime.</td>
</tr>
</tbody>
</table>

The “Invisible” property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
**Animation duration**
Defines the duration (in milliseconds) in which the element runs an animation

- Variable (integer value)
  Example: `Menu.tContent with VAR tContent : INT := 500; END_VAR`
- Integer literal
  Example: `500`

**Animatable properties**
- "Absolute movement", "Movement", "X", "Y"
- "Absolute movement", "Rotation"
- "Absolute movement", "Interior rotation"
- "Absolute movement", "Exterior rotation"

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**Move to foreground**
Moves the visualization element to the foreground

Variable (BOOL)

Example: `bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR`

**TRUE**: At runtime, the visualization element is displayed in the foreground.

**FALSE**: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

**Element property 'Access rights'**
Requirement: User management is set up for the visualization.

**Access rights**
Opens the "Access rights" dialog. There you can edit the access privileges for the element.

Status messages:
- "Not set. Full rights.": Access rights for all user groups: "operable"
- "Rights are set: Limited rights": Access is restricted for at least one group.

See also
- ☞ Chapter 6.4.5.21.3.1 "Dialog 'Access Rights'" on page 3366

See also
- ☞ Chapter 6.4.5.5 "Designing a visualization with elements" on page 2872

**Visualization Element 'Combo Box, Integer'**

Symbol:

**Category: “Common Controls”**
The element shows values as a list box. When the user clicks an entry, the ID of the entry is written to an integer variable. The entries in the list box can be from a list and contain images from an image pool.
### Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: List of product numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Type of element”</th>
<th>“Combo Box, Integer”</th>
</tr>
</thead>
</table>

### Element property 'Position'

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Width”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 150</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Height”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols ( sprawl) to other positions in the editor.

See also

- Chapter 6.4.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

### Element property 'Center'

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols ( sprawl) to other positions in the editor.
**“Variable”**

At runtime, the text list ID of the list entry that the user clicks is saved at runtime. If only one image pool is displayed, then the image ID is saved.

Property value

- Variable (integer data type)
  - Example: PLC_PRG.iIDComboboxEntry
- Enumeration variable with text list support
  - Example: PLC_PRG.eMyCombobox<COMBO>

**“Text List”**

Displayed as a combo box. Every text list entry becomes a combo box entry.

Note: A maximum of 32766 entries can be displayed.

Transfer value

- Text list identifier as string
  - Example: 'TextList_A'
  - Note: The IDs of the text list have to be within the range of values of DWORD or DINT.
- Blank
  - When an enumeration variable with text list support is specified in the “Variable” property
  - When only one image pool is displayed

**“Image Pool”**

Displayed as a combo box. Every image in the image pool becomes a combo box entry.

Example: 'ImagePool_A'

See also

- Enumerations
- § Chapter 6.4.5.8 “Setting Up Multiple Languages” on page 2906

**Element property 'Settings of the list'**

Displayed list that expands when a visualization user clicks into the element.

| **“Number of rows setting”** | **“From style”:**
| --- | ---
| “Explicit”: Then the “Number of visible rows” property appears below it. |

| **“Number of visible rows”** | Number of visible lines of the combo box drop-down list defined here
| --- | ---
| Integer literal
  - Example: 5 |
| Variable (integer data type)
  - Example: PLC_PRG.iNumberOfVisibleRows |
| Note: The property is available when the “Number of rows setting” property is set to “Explicit”. |

| **“Row height”** | **“From style”:**
| --- | ---
| Literal
  - Example: 20 |

| **“Height of image”** | Image height (in pixels) of the image displayed in the drop-down list entry
| --- | ---
| **“From style”:**
| Integer literal
  - Example: 30 |
<p>| Note: Images are displayed only when a value is specified in the “Image pool” property. |</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Width of image”</td>
<td>Image width (in pixels) of the image displayed in the drop-down list entry</td>
</tr>
<tr>
<td>• “From style”:</td>
<td>• Literal</td>
</tr>
<tr>
<td></td>
<td>Example: 30</td>
</tr>
<tr>
<td>Note:</td>
<td>Images are displayed only when a value is specified in the “Image pool”</td>
</tr>
<tr>
<td>“Offset of image”</td>
<td>Makes the images in the selection list appear offset (in pixels) from the left margin. An offset of 0 means that the images are displayed directly on the margin.</td>
</tr>
<tr>
<td>• “From style”:</td>
<td>• Literal</td>
</tr>
<tr>
<td></td>
<td>Example: 4</td>
</tr>
<tr>
<td>Note:</td>
<td>Images are displayed only when a value is specified in the “Image pool”</td>
</tr>
<tr>
<td>“Scrollbar size”</td>
<td>Size of the scrollbar (in pixels). The scrollbar is displayed when more entries are specified in the drop-down list than in “Number of visible rows”.</td>
</tr>
<tr>
<td></td>
<td>Default: 20</td>
</tr>
</tbody>
</table>

Element property "Texts"

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Tooltip”</td>
<td>Character string (without single straight quotation marks) that is displayed as the tooltip of an element in runtime mode</td>
</tr>
<tr>
<td></td>
<td>Example: Products of customer A</td>
</tr>
<tr>
<td>Hint:</td>
<td>The text is accepted automatically into the “GlobalTextList” text list and can be localized there.</td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

Element property 'Value range'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Limit valuerange”</td>
<td>Limits the text list to one subrange. This subrange is displayed by the combo box.</td>
</tr>
<tr>
<td>Requirement:</td>
<td>A value is specified in the “Text list” property.</td>
</tr>
<tr>
<td>✓: Only the subrange that is defined by the “Minimum value” “Maximum value” properties is displayed as a drop-down list.</td>
<td></td>
</tr>
<tr>
<td>“Minimum value”</td>
<td>ID of the text list entry from which a combo box entry is displayed</td>
</tr>
<tr>
<td>• Literal (ANY_NUM)</td>
<td>Example: 5</td>
</tr>
<tr>
<td>• Variable (integer data type)</td>
<td>Example: PLC_PRG.iFirstEntry</td>
</tr>
</tbody>
</table>
### Maximum value

ID of the text list entry up to which combo box entries are displayed

- **Literal** *(ANY_NUM)*
  
  - **Example:** 10

- **Variable** (integer data type)
  
  - **Example:** PLC_PRG.iLastEntry

### Filter missing textentries

☑️ Text list is refreshed and any unused texts (IDs) are removed.

**Requirement:** A value is specified in the “Text list” property.

### Element property 'Text properties'

The properties contain fixed values for the text properties.

| “Usage of” | • “Default style values”: The values of the visualization style are used.  
  | • “Individual settings”: The ”Individual text properties” property group is shown  
  | The values can be customized here. |

| “Individual text properties” | Requirement: The “Individual settings” text property is defined. |

| “Horizontal alignment” | Horizontal alignment of the text within the element. |

| “Vertical alignment” | Vertical alignment of the text within the element. |

| “Font” | Example: “Default”  
  | ✓: The “Font” dialog box opens.  
  | ✴: Drop-down list with style fonts. |

| “Font color” | Example: “Black”  
  | ✓: The “Color” dialog box opens.  
  | ✴: Drop-down list with style colors. |

| “Transparency” | Whole number (value range from 0 to 255). This determines the transparency of the respective color.  
  | Example: 255: The color is opaque.  
  | 0: The color is completely transparent.  
  | Please note: If the color is a style color and already has a transparency value, then this property is write-protected. |

### Element property 'Absolute movement'

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

| “Movement” | |

| “X” | Variable (numeric data type). Defines the X position (in pixels).  
  | **Example:** PLC_PRG.iPos_X.  
  | Increasing this value in runtime mode moves the element to the right. |

| “Y” | Variable (numeric data type). Defines the Y position (in pixels).  
  | **Example:** PLC_PRG.iPos_Y.  
  | Increasing this value in runtime mode moves the element downwards. |
### "Rotation"

Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** PLC_PRG.iAngle1.

The midpoint of the element rotates at the "Center" point. This rotation point is shown as the symbol.

In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

### "Interior rotation"

Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in "Center" according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the "Position Angle" property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

---

You can link the variables to a unit conversion.

The "X", "Y", "Rotation", and "Interior rotation" properties are supported by the "Client Animation" functionality.

See also

- Element property 'State variables'

The variables control the element behavior dynamically.

### "Invisible"

Variable (BOOL). Toggles the visibility of the element.

**TRUE:** The element is not visible at runtime.

**Example:** bIsVisible with VAR bIsVisible : BOOL := FALSE;

### "Deactivate inputs"

Variable (BOOL). Toggles the operability of the element.

**TRUE:** User inputs do not have any effect in runtime more. The element is shown as deactivated.
The “Invisible” property is supported by the “Client Animation” functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

<table>
<thead>
<tr>
<th>“Animation duration”</th>
<th>Defines the duration (in milliseconds) in which the element runs an animation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Variable (integer value)</td>
</tr>
<tr>
<td></td>
<td>Example: Menu.tContent with VAR tContent : INT := 500; END_VAR</td>
</tr>
<tr>
<td></td>
<td>• Integer literal</td>
</tr>
<tr>
<td></td>
<td>Example: 500</td>
</tr>
</tbody>
</table>

Animatable properties

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

<table>
<thead>
<tr>
<th>“Move to foreground”</th>
<th>Moves the visualization element to the foreground</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Variable (BOOL)</td>
</tr>
<tr>
<td></td>
<td>Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR</td>
</tr>
<tr>
<td></td>
<td>TRUE: At runtime, the visualization element is displayed in the foreground.</td>
</tr>
<tr>
<td></td>
<td>FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.</td>
</tr>
</tbody>
</table>

**Element property 'Access rights'**

Requirement: User management is set up for the visualization.

<table>
<thead>
<tr>
<th>“Access rights”</th>
<th>Opens the “Access rights” dialog. There you can edit the access privileges for the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Status messages:</td>
</tr>
<tr>
<td></td>
<td>• “Not set. Full rights.”: Access rights for all user groups: “operable”</td>
</tr>
<tr>
<td></td>
<td>• “Rights are set: Limited rights”: Access is restricted for at least one group.</td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

See also

- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
Visualization Element ‘Combo Box, Array’

Symbol:

Category: “Common Controls”
The element shows values of an array as a list box. When the visualization user clicks an entry, the array index of the entry is written to an integer variable.

Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
</tr>
<tr>
<td></td>
<td>Example: List_Product_Number</td>
</tr>
</tbody>
</table>

| “Type of element”    | “Combo Box, Array” |

Element property 'Position'
The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Width”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 150</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Height”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (®) to other positions in the editor.

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

Element property 'Center'
The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the 🈞️ symbol. The point is used as the center for rotating and scaling.
| "X" | X-coordinate of the point of rotation |
| "Y" | Y-coordinate of the point of rotation |

You can also change the values by dragging the symbols (บางคน) to other positions in the editor.

<table>
<thead>
<tr>
<th>&quot;Variable&quot;</th>
<th>The array index of the list entry that the user clicks is saved at runtime.</th>
</tr>
</thead>
</table>

- **Property value**
  - Variable (integer data type)
    
    Example: PLC_PRG.iIndexComboboxEntry
  - Enumeration variable with text list support
    
    Example: PLC_PRG.eMyCombobox<COMBO>
    
    Note: Value range of the enumeration value that lies within the DWORD or DINT value range

<table>
<thead>
<tr>
<th>&quot;Data array&quot;</th>
<th>Displayed as a combo box. Every array component becomes a combo box entry.</th>
</tr>
</thead>
</table>

- **Property value**
  - Array variable (ARRAY[... OF])
    
    Example: PLC_PRG.astrCombobox
    

See also
- **Enumerations**
- © Chapter 6.4.5.8 “Setting Up Multiple Languages” on page 2906

**Element property 'Columns'**

The "Combo box – Array" element visualizes an array variable or structure variable in a tabular view. The index of array elements or structure members is shown in a column or row. Two-dimensional arrays or structure arrays are shown in several columns. You specify the visualized variable in the "Data array" property. If a variable is assigned there, then you can specify the display of the table columns where the array elements are shown. You can customize each column that is assigned to an index [<n>].

<table>
<thead>
<tr>
<th>&quot;Columns&quot;</th>
<th>Due to the structure of the variable that is defined in &quot;Data array&quot;, CODESYS determines the number of columns and defines them with the index &lt;n&gt;.</th>
</tr>
</thead>
</table>

- **[<n>]**
  
  Example: StringTable : ARRAY [0..2, 0..4] OF STRING := ['BMW','Audi','Mercedes','VW','Fiat', '150','150','150','150','100','blue','gray','silver','blue', 'red'];: three columns are formed [0], [1] and [2].

| "Max. array index" | Optional. Variable (integer data type) or value. Defines up to which array index the data is displayed. |
| "Row height" | Height of the rows (in pixels). |
| "Number visible rows" | Optional. If the array is larger than the number of visible rows, then a scrollbar is included. |
| "Scrollbar size" | Width of the vertical scrollbar (in pixels). |
### Table 629: “Element property ‘Columns: Column [<n>]’”

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Width”</td>
<td>Column width (in pixels).</td>
</tr>
<tr>
<td>“Image column”</td>
<td>Images can be displayed in the column. Images are used from the global image pool or user-defined image pools. The image IDs are shown in the cells of the table as defined in the image pool.</td>
</tr>
<tr>
<td>“Image configuration”</td>
<td></td>
</tr>
<tr>
<td>“Fill mode”</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● “Fill cell” The image resizes to the dimensions of the cell without fixing the height/width ratio.</td>
</tr>
<tr>
<td></td>
<td>● “Centered” The image is centered in the cell and retains its proportions (height-width ratio).</td>
</tr>
<tr>
<td>“Transparency”</td>
<td>The color that is specified in “Transparent color” is displayed as transparent.</td>
</tr>
<tr>
<td>“Transparent color”</td>
<td>When the “Transparent” property is enabled, the color specified here is not displayed. Pixels with this color are transparent.</td>
</tr>
<tr>
<td>“Text alignment in column”</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● “Left”</td>
</tr>
<tr>
<td></td>
<td>● “Centered”</td>
</tr>
<tr>
<td></td>
<td>● “Right”</td>
</tr>
</tbody>
</table>

### Element property 'Texts'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Tooltip”</td>
<td>Character string (without single straight quotation marks) that is displayed as the tooltip of an element in runtime mode</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong> Products of customer A</td>
</tr>
<tr>
<td></td>
<td>Hint: The text is accepted automatically into the “GlobalTextList” text list and can be localized there.</td>
</tr>
</tbody>
</table>

See also

- § Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

### Element property 'Text properties'

The properties contain fixed values for the text properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Usage of”</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● “Default style values”: The values of the visualization style are used.</td>
</tr>
<tr>
<td></td>
<td>● “Individual settings”: The &quot;Individual text properties&quot; property group is shown The values can be customized here.</td>
</tr>
<tr>
<td>“Individual text properties”</td>
<td>Requirement: The “Individual settings” text property is defined.</td>
</tr>
<tr>
<td>“Font”</td>
<td>Example: “Default”</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="The “Font” dialog opens." /></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="List box with style fonts" /></td>
</tr>
</tbody>
</table>
**“Font color”**

Example: “Black”
- The “Color” dialog opens.
- ▼: List box with style colors

**“Transparency”**

Integer (value range from 0 to 255). This determines the transparency of the respective color.
- 255: The color is opaque.
- 0: The color is completely transparent.

Note: If the color is a style color and already has a transparency value, then this property is write-protected.

---

**Element property 'Absolute movement’**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

---

**“Movement”**

<table>
<thead>
<tr>
<th>“X”</th>
<th>Variable (numeric data type). Defines the X position (in pixels).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: PLC_PRG.iPos_X.</td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Variable (numeric data type). Defines the Y position (in pixels).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: PLC_PRG.iPos_Y.</td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Rotation”</th>
<th>Variable (numeric data type). Defines the angle of rotation (in degrees).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: PLC_PRG.iAngle1.</td>
<td>The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.</td>
</tr>
<tr>
<td></td>
<td>In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Interior rotation”</th>
<th>Variable (numeric data type). Defines the angle of rotation (in degrees).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: PLC_PRG.iAngle2.</td>
<td>In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.</td>
</tr>
<tr>
<td></td>
<td>The rotation point is shown as the symbol.</td>
</tr>
<tr>
<td>Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.</td>
<td></td>
</tr>
</tbody>
</table>
You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Invisible”</td>
<td>Variable (BOOL). Toggles the visibility of the element. TRUE: The element is not visible at runtime. Example: <code>bIsVisible := FALSE;</code></td>
</tr>
<tr>
<td>“Deactivate inputs”</td>
<td>Variable (BOOL). Toggles the operability of the element. TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.</td>
</tr>
</tbody>
</table>

The “Invisible” property is supported by the “Client Animation” functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
### “Animation duration”

Defines the duration (in milliseconds) in which the element runs an animation

- **Variable (integer value)**
  
  **Example:**
  ```plaintext
  Menu.tContent with VAR tContent : INT := 500;
  END_VAR
  ```

- **Integer literal**
  
  **Example:**
  500

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

### “Move to foreground”

Moves the visualization element to the foreground

**Variable (BOOL)**

**Example:**
```plaintext
bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR
```

**TRUE:** At runtime, the visualization element is displayed in the foreground.

**FALSE:** At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

### See also
- ☞ Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

---

**Visualization Element ‘Tabs’**

**Symbol:**

![Tabs symbol]

**Category:** “Common Controls”

The element displays selected visualizations in tabs. The tabs can be used by means of the tab header without having to configure an input configuration. A visualization user switches between visualizations by clicking the tab header.

**Element properties**

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: Assembly A</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Type of element”</th>
<th>“Tabs”</th>
</tr>
</thead>
</table>
"Tab width" Width of the tab (in pixels). If there is not space for all tab headers, then a scroll bar is added.
Example: 30

"Tab height" Height of the tab (in pixels)
- Integer literal
  Example: 15
- "From style"

"Scaling type" The method with which the height and width of the referenced visualization are scaled.
- "Isotropic": The visualization is scaled to the size of the element. The visualization retains its proportions with a fixed height/width ratio.
- "Anisotropic": The visualization is scaled to the size of the element. The height and width are adapted to the element independently of each other.
- "Fixed": The visualization is displayed in its original size without taking into account the size of the element.
- "Fixed and scrollable": The visualization is displayed fixed in the element. If it is larger than the element, the element will be provided with scrollbars.

Please note: assign variables to the properties "Scroll position variable horizontal" or "Scroll position variable vertical". You can then edit the data of the scrollbar position in the application.

"Deactivate background drawing" ☐: The non-animated elements of the referenced visualization are displayed as background images in order to optimize the performance of the visualization.
Result: At runtime, the elements can be displayed in any order, for example when an element moves behind the frame at runtime.
☑: Deactivates the background display in order to prevent the behavior described above

The property is not available for the following settings:
- The "Scaling type" property is set to "Fixed and scrollable"
- The client animation functionality is enabled.

Element property 'Scroll bar settings' The properties include variables for the position of the scroll boxes in the scroll bars. You can process the data for the scroll box position in the application.

Requirement: The "Scaling type" property is "Fixed and scrollable".

"Scroll position variable horizontal" Variable (integer data type, also array). Includes the position of the horizontal or vertical scroll box. The array contains the position for each display variant. If the visualization is running on multiple display variants, then the position changes are disconnected from each other.
Example:
PLC_PRG.iScrollHor[CURRENTCLIENTID]
PLC_PRG.iScrollVer[CURRENTCLIENTID]

In this example, the variable is declared as an array:
iScrollHor: ARRAY[0..20] OF INT;
iScrollVer: ARRAY[0..20] OF INT;
CURRENTCLIENTID indicates the current display variant.
Element property 'References'

<table>
<thead>
<tr>
<th>References</th>
<th>Clicking &quot;Configure&quot; opens the &quot;Frame Configuration&quot; dialog. You can select an existing visualization there. Selected visualization references are shown in the properties. Selected visualization references are listed here as subordinate properties.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of the visualization reference (example: PLC_PRG.S1)</td>
<td></td>
</tr>
<tr>
<td>&quot;Heading&quot;</td>
<td>Tab caption (example: Panel)</td>
</tr>
<tr>
<td>&quot;Image ID&quot;</td>
<td>Image ID in the theme &lt;image pool name&gt;.&lt;ID&gt; Example: Imagepool_A.1 for the image with ID 1 in Imagepool_A</td>
</tr>
</tbody>
</table>

Interface parameter of the visualization reference

| Example: ix | If the visualization has an interface, then their parameters are displayed here as subordinate properties. Variable (data type conforms to data type of the interface parameter). Includes the initialization value for the instantiation of the visualization. |

See also

- ☞ Chapter 6.4.5.17 “Creating a structured user interface” on page 2940
- ☞ Chapter 6.4.5.21.2.1 “Command 'Interface Editor'” on page 3340
- ☞ Chapter 6.4.5.21.2.9 “Command 'Frame Selection'” on page 3348

Element property 'Position'

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

| "X" | X coordinate of the upper left corner of the element Specified in pixels. Example: 10. |
| "Y" | Y coordinate of the upper left corner of the element Specified in pixels. Example: 10. |
| "Width" | Specified in pixels. Example: 150 |
| "Height" | Specified in pixels. Example: 30 |

You can also change the values by dragging the box symbols (_drag-) to other positions in the editor.
See also

- Chapter 6.4.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

**Element property ‘Center’**

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols to other positions in the editor.

**Element property ‘Switch frame variable’**

| “Variable” | Variable (integer data type). Specifies the index of the active visualization. Example: PLC_PRG.uiActiveVisuID. Tip: The “Frame Configuration” dialog box includes a list of selected visualizations. The visualizations are ordered automatically in numeric order in the list. |

See also

- Chapter 6.4.5.21.2.9 “Command ‘Frame Selection’” on page 3348

**Element property ‘Absolute movement’**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>“Movement”</th>
<th>Variable (numeric data type). Defines the X position (in pixels). Example: PLC_PRG.iPos_X. Increasing this value in runtime mode moves the element to the right.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
<td>Variable (numeric data type). Defines the Y position (in pixels). Example: PLC_PRG.iPos_Y. Increasing this value in runtime mode moves the element downwards.</td>
</tr>
</tbody>
</table>
### "Rotation"

Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** PLC_PRG.iAngle1.

The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.

In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

### "Interior rotation"

Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

---

You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- The variables control the element behavior dynamically.

### "Invisible"

Variable (BOOL). Toggles the visibility of the element.

**Example:**

```plaintext
VAR bIsVisible : BOOL := FALSE;
END_VAR
```

TRUE: The element is not visible at runtime.

### "Deactivate inputs"

Variable (BOOL). Toggles the operability of the element.

TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.
The "Invisible" property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

<table>
<thead>
<tr>
<th>&quot;Animation duration&quot;</th>
<th>Defines the duration (in milliseconds) in which the element runs an animation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>● Variable (integer value)</td>
</tr>
<tr>
<td></td>
<td>Example: Menu.tContent with VAR tContent : INT := 500; END_VAR</td>
</tr>
<tr>
<td></td>
<td>● Integer literal</td>
</tr>
<tr>
<td></td>
<td>Example: 500</td>
</tr>
</tbody>
</table>

Animatable properties

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

<table>
<thead>
<tr>
<th>&quot;Move to foreground&quot;</th>
<th>Moves the visualization element to the foreground</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Variable (BOOL)</td>
</tr>
<tr>
<td></td>
<td>Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR</td>
</tr>
<tr>
<td>TRUE:</td>
<td>At runtime, the visualization element is displayed in the foreground.</td>
</tr>
<tr>
<td>FALSE:</td>
<td>At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.</td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

**Visualization Element 'Button'**

Symbol:

Category: “Common Controls”

The element triggers an action, such as setting a variable.
**Element property 'Position'**

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>X</strong></td>
<td>X coordinate of the upper left corner of the element</td>
</tr>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
<tr>
<td><strong>Y</strong></td>
<td>Y coordinate of the upper left corner of the element</td>
</tr>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
<tr>
<td><strong>Width</strong></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 150</td>
</tr>
<tr>
<td><strong>Height</strong></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (_drag_box_) to other positions in the editor.

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

**Element property 'Center'**

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>X</strong></td>
<td>X-coordinate of the point of rotation</td>
</tr>
<tr>
<td><strong>Y</strong></td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (_rotation_symbol_) to other positions in the editor.

**Element property 'Colors'**

The properties contain fixed values for setting colors.
### “Color”
Color for the element in its normal state. Please note that the normal state is in effect if the expression in the “Color variables ➔ Toggle color” property is not defined or it has the value `FALSE`.

### “Alarm color”
Color for the element in alarm state. Please note that the alarm state is in effect if the expression in the “Color variables ➔ Toggle color” property has the value `TRUE`.

### “Transparency”
Value (0 to 255) for defining the transparency of the selected color. Example 255: The color is opaque. 0: The color is completely transparent.

### “Use gradient color”
[ ]: The element is displayed with a color gradient.

### “Gradient setting”
The “Color gradient editor” dialog box opens.

---

#### See also
- § Chapter 6.4.5.21.3.5 “Dialog ‘Gradient Editor’” on page 3369
- § Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

---

### Element property ‘Image’

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Static ID”</td>
<td>Reference to an image in an image pool of the format <code>&lt;name of image pool&gt;_&lt;image ID&gt;</code> (example: <code>image_pool.GreenButton</code>). If the image is from the “GlobalImagePool”, then you can omit the name of the image pool because CODESYS always searches this pool first. The “Input Assistant” dialog box opens and lists all available image pools and images in the entire project.</td>
</tr>
<tr>
<td>“Scale type”</td>
<td>Behavior of the image when resizing the button.</td>
</tr>
<tr>
<td></td>
<td>● “Isotropic”: The image retains its proportions. The ratio of height to width is retained, even if you change the height or width of the button separately.</td>
</tr>
<tr>
<td></td>
<td>● “Anisotropic”: The image resizes to the dimensions of the button.</td>
</tr>
<tr>
<td></td>
<td>● “Fixed”: The image retains its original size, even if you change the size of the button.</td>
</tr>
<tr>
<td>“Transparency”</td>
<td>The visualization displays the image with the transparency color that is selected in “Transparency color”.</td>
</tr>
<tr>
<td>“Transparency color”</td>
<td>Color that is transparent in the image (example: “White”). If the image background that is reference by “Static ID” is white, then this background is displayed transparent. Clicking opens a color selection dialog. Requirement: The “Transparency” option is activated.</td>
</tr>
<tr>
<td>“Horizontal alignment”</td>
<td>Horizontal alignment of the image</td>
</tr>
<tr>
<td></td>
<td>● “Left”</td>
</tr>
<tr>
<td></td>
<td>● “Centered”</td>
</tr>
<tr>
<td></td>
<td>● “Right”</td>
</tr>
<tr>
<td>“Vertical alignment”</td>
<td>Vertical alignment of the image</td>
</tr>
<tr>
<td></td>
<td>● “Top”</td>
</tr>
<tr>
<td></td>
<td>● “Centered”</td>
</tr>
<tr>
<td></td>
<td>● “Bottom”</td>
</tr>
</tbody>
</table>

---

### Element property ‘Texts’
The properties contains character strings for labeling the element. The character string can also contain a placeholder with a format definition. In runtime mode, the placeholder is replaced by the current value in the specified format.
CODESYS accepts the specified texts automatically into the “GlobalTextList” text list. Therefore, these texts can be localized.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Text”</td>
<td>Character string (without single straight quotation marks) for the labeling the element. Add a line break by pressing the keyboard shortcut [Ctrl] + [Enter]. Example: Accesses: %i. The variable that contains the current value for the placeholder is specified in the property “Text variable ➤ Text”.</td>
</tr>
<tr>
<td>“Tooltip”</td>
<td>Character string (without single straight quotation marks) that is displayed as the tooltip of an element. Example: Number of valid accesses. The variable that contains the current value for the placeholder is specified in the property “Text variable ➤ Tooltip”.</td>
</tr>
</tbody>
</table>

See also
- “Element property ‘Text variables’” on page 3094
- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
- Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329

**Element property ‘Text properties’**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Horizontal alignment”</td>
<td>Horizontal alignment of the text within the element.</td>
</tr>
<tr>
<td>“Vertical alignment”</td>
<td>Vertical alignment of the text within the element.</td>
</tr>
</tbody>
</table>
| “Text format” | Definition for displaying texts that are too long  
  - “Default”: The long text is truncated.  
  - “Line break”: The text is split into parts.  
  - “Ellipsis”: The visible text ends with “...” indicating that it is not complete. |
| “Font” | Example: “Default”  
  - The “Font” dialog box opens.  
  - ▼: Drop-down list with style fonts. |
| “Font color” | Example: “Black”  
  - The “Color” dialog box opens.  
  - ▼: Drop-down list with style colors. |
| “Transparency” | Whole number (value range from 0 to 255). This determines the transparency of the respective color.  
  Example: 255: The color is opaque.  
  0: The color is completely transparent.  
  Please note: If the color is a style color and already has a transparency value, then this property is write-protected. |

**Element property ‘Absolute movement’**

The properties contain fixed values for the text properties.
### "Movement"

| **“X”** | Variable (numeric data type). Defines the X position (in pixels).  
Example: PLC_PRG.iPos_X.  
Increasing this value in runtime mode moves the element to the right. |
|---|---|
| **“Y”** | Variable (numeric data type). Defines the Y position (in pixels).  
Example: PLC_PRG.iPos_Y.  
Increasing this value in runtime mode moves the element downwards. |
| **“Rotation”** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
Example: PLC_PRG.iAngle1.  
The midpoint of the element rotates at the “Center” point. This rotation point is shown as the \( + \) symbol.  
In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right. |
| **“Scaling”** | Variable (integer data type). Causes centric stretching.  
Example: PLC_PRG.iScaling.  
The reference point is the “Center” property.  
The value 1 shrinks the element by a factor of 0.001. The value 1000 returns the element to its original size. |

You can link the variables to a unit conversion.

The properties “X”, “Y”, “Rotation”, and “Interior rotation” are supported by the "Client Animation" functionality.

See also

- 

**Element property 'Relative movement'**

The properties contain variables for moving the element. The reference point is the position of the element ("Position" property). The shape of the element can change.

### "Movement top-left"

| **“X”** | Variable (integer data type). It contains the number (in pixels) that the left edge is moved horizontally. Incrementing the value moves the element to the right.  
Example: PLC_PRG.iDeltaX |
|---|---|
**“Y”**  
Variable (integer data type). It contains the number (in pixels) that the top edge is moved vertically. Incrementing the value moves the element to the down.  
Example: PLC_PRG.iDeltaY

**“Movement bottom-right”**

**“X”**  
Variable (integer data type). It contains the number (in pixels) that the right edge is moved horizontally. Incrementing the value moves the element to the right.  
Example: PLC_PRG.iDeltaWidth

**“Y”**  
Variable (integer data type). It contains the number (in pixels) that the bottom edge is moved vertically. Incrementing the value moves the element to the down.  
Example: PLC_PRG.iDeltaHeight

See also  
- “Element property ‘Absolute movement’” on page 3016

**Element property ’Text variables’**  
These properties are variables with contents that replace a format definition.

**“Text variable”**  
Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.  
Example: PLC_PRG.iAccesses  
Note: The format definition is part of the text in the property “Texts ➔ Text”.  
Note: If you specify a variable of type enumeration with text list support, then the name of the enumeration data type is added automatically in angle brackets after the variable name. Example: PLC_PRG.enVar <enumeration name>. Then the symbolic value of the enumeration component is printed instead of the numeric value when text is printed. Refer to the help page for the enumerations.

**“Tooltip variable”**  
Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.  
Example: PLC_PRG.iAccessesInTooltip  
Note: The format definition is part of the text in the property “Texts ➔ Tooltip”.

See also  
- Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329  
- “Element property ‘Texts’” on page 3091  
- Chapter 6.4.1.20.5.18 “Enumerations” on page 2263

**Element property ’Dynamic texts’**  
Dynamic texts are variably indexed texts of a text list. At runtime, the text is displayed that is currently indexed in the variable.
**“Text list”**

<table>
<thead>
<tr>
<th>Variable (string) or name of the text list as a fixed string in single straight quotation marks.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: ‘Errorlist’</td>
</tr>
<tr>
<td>▼: Drop-down list with the dialogs available in the text lists.</td>
</tr>
</tbody>
</table>

**“Text index”**

<table>
<thead>
<tr>
<th>Text list ID. This refers to the desired output text.</th>
</tr>
</thead>
<tbody>
<tr>
<td>● As fixed string with the ID in single straight quotation marks.</td>
</tr>
<tr>
<td>Example: ‘1’</td>
</tr>
<tr>
<td>● As a variable (STRING) for dynamically controlling the text output.</td>
</tr>
<tr>
<td>Example: strTextID</td>
</tr>
<tr>
<td>Sample assignment: PLC_PRG.strTextID := '1';</td>
</tr>
</tbody>
</table>

**“Tooltip index”**

<table>
<thead>
<tr>
<th>Text list ID. This refers to the desired output text.</th>
</tr>
</thead>
<tbody>
<tr>
<td>● As fixed string with the ID in single straight quotation marks.</td>
</tr>
<tr>
<td>Example: ‘2’</td>
</tr>
<tr>
<td>● As a variable (STRING) for dynamically controlling the text output.</td>
</tr>
<tr>
<td>Example: strToolTipID</td>
</tr>
<tr>
<td>Sample assignment: PLC_PRG.strToolTipID := '2';</td>
</tr>
</tbody>
</table>

See also
- % Chapter 6.4.1.21.2.28 “Object 'Text List’” on page 2532

**Element property 'Font variables’**

<table>
<thead>
<tr>
<th>Variable (STRING). Includes the font of the text.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: PLC_PRG.stFontVar := 'Arial';</td>
</tr>
<tr>
<td>The selection of fonts corresponds to the default “Font” dialog.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Variable (numeric data type). Contains the font size (in pixels or points). The applied unit is specified in brackets after the variable name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>● &lt;pt&gt;: Points (default)</td>
</tr>
<tr>
<td>Example: PLC_PRG.iFontHeight &lt;pt&gt; Code: iFontHeight : INT := 12;</td>
</tr>
<tr>
<td>● &lt;px&gt;: Pixels</td>
</tr>
<tr>
<td>Example: PLC_PRG.iFontHeight &lt;px&gt; Code: iFontHeight : INT := 19;</td>
</tr>
</tbody>
</table>

If you click in the value field, a drop-down list opens on the right for setting the unit.

Hint: The font size is specified in points (example: Arial 12). Use points when the variable font size should match a font, for example if a font is set in the property “Text property ➔ Font”. 
### Flags
Variable (DWORD). Contains the flags for displaying fonts.

- 1: Italics
- 2: Bold
- 4: Underline
- 8: Strikethrough

Note: You can combine the font displays by adding the coding of the flags. For example, a bold and underlined text: `PLC_PRG.dwFontType := 6;`

### Character set
Variable (DWORD). Contains a character set number for the font.

The selection of character set numbers corresponds to the “Script” setting of the standard “Font” dialog.

### Color
Variable (DWORD). Includes the color of the text.

Example: `PLC_PRG.dwColorFont := 16#FF000000;`

### Flags for text alignment
Variable (integer data type). Contains the coding for text alignment.

- 0: Top left
- 1: Horizontal center
- 2: Right
- 4: Vertical center
- 8: Bottom

Note: You can combine the text alignments by adding the coding of the flags. For example, a vertical and horizontal centered text: `PLC_PRG.dwFontType := 5;`

---

Fixed values for displaying texts are set in "Text properties".

See also

- § “Element property 'Text properties'” on page 3092

Element property 'Color variables'

The Element property is used as an interface for project variables to dynamically control colors at runtime.
### "Toggle color"

The property controls the toggled color at runtime.

**Value assignment:**
- **FALSE**: The element is displayed with the color specified in the "Color" property.
- **TRUE**: The element is displayed with the color specified in the "Alarm color" property.

**Assigning the property:**
- Placeholder for the user input variable
  - "<toggle/tap variable>"
  - "<NOT toggle/tap variable>"

The color change is not controlled by its own variable, but by a user input variable.

**Note:** Specify a variable for the mouse events "Tap" or "Toggle" in the input configuration of the element. Only then is the placeholder set. If you configure a variable in both "Toggle" and "Tap", then the variable specified in "Tap" is used.

**Hint:** Click the symbol to insert the placeholder "<toggle/tap variable>". When you activate the "Input configuration", "Tap FALSE" property, then the "<NOT toggle/tap variable>" placeholder is displayed.

**Instance path of a project variable (BOOL)**

Example: PLC_PRG.xColorIsToggeled

**Note:** In the code, declare and implement the variable specified here. Its value assignment determines when the color changes.

### "Color"

Color variable for the Frame

- **Variable (DWORD) for the color**
  - Example: PLC_PRG.dwColor
- **Color literal**
  - Example of gray and opaque: 16#FF888888

**Requirement:** "Show Frame" property is activated.

Please note that the normal state is in effect if the expression in the "Colorvariables → Toggle color" property is not defined or it has the value FALSE.

### "Alarm color"

Color variable for the Frame in alarm state

- **Variable (DWORD) for the alarm color**
  - Example: PLC_PRG.dwAlarmColor
- **Color literal**
  - Example of red and opaque: 16#FFFF0000

Please note that the alarm state is in effect if the expression in the "Colorvariables → Toggle color" property has the value TRUE.

---

**The transparency part of the color value is evaluated only if the "Activate semi-transparent drawing" option of the visualization manager is selected.**

**Select the “Advanced” option in the toolbar of the properties view. Then all element properties are visible.**
The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Invisible&quot;</td>
<td>Variable (BOOL). Toggles the visibility of the element.</td>
</tr>
<tr>
<td></td>
<td>TRUE: The element is not visible at runtime.</td>
</tr>
<tr>
<td>Example: bIsVisible with var bIsVisible : BOOL := FALSE; end_var</td>
<td></td>
</tr>
<tr>
<td>&quot;Deactivate inputs&quot;</td>
<td>Variable (BOOL). Toggles the operability of the element.</td>
</tr>
<tr>
<td></td>
<td>TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.</td>
</tr>
</tbody>
</table>

The "Invisible" property is supported by the "Client Animation" functionality.

**Element property 'State variables'**

- **"Digital variable"**
  - At runtime, the property controls whether the Button is displayed as pressed or not.
  - Values:
    - FALSE: The Button is displayed as not pressed.
    - TRUE: The Button is displayed as pressed.
  - Argument passed to the property:
    - Placeholder for the user input variable to couple the representation of the Button with the input variable.
      - "<toggle/tap variable>"
      - "<NOT toggle/tap variable>"
    - Note: Specify a variable for the mouse events "Tap" or "Toggle" in the input configuration of the Button. Only then is the placeholder set. If you configure a variable in both "Toggle" and "Tap", then the variable specified in "Tap" is used.
    - Hint: Click the symbol to insert the placeholder "<toggle/tap variable>". When you activate the "Inputconfiguration", "Tap FALSE" property, then the "<NOT toggle/tap variable>" placeholder is displayed.
    - Instance path of a project variable (BOOL)
      - Example: prgA.xButtonState
      - Note: Implement a value assignment in the code for the variable specified here.

**Element property 'Image ID variable'**
"Image ID"  
Variable (STRING). Contains the image ID. The contents of the string corresponds to the description of the "Static ID" property.
Example: PLC_PRG.stImageID := 'ImagePool_A.Image3';

See also
- Chapter 6.4.5.20.1.5 “Visualization Element 'Image’” on page 3038
- Chapter 6.4.1.21.2.15 “Object 'Image Pool’” on page 2468

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

"Animation duration"  
Defines the duration (in milliseconds) in which the element runs an animation
- Variable (integer value)
  Example: Menu.tContent with VAR tContent : INT := 500; END_VAR
- Integer literal
  Example: 500

Animatable properties
- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”
The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

"Move to foreground"  
Moves the visualization element to the foreground
Variable (BOOL)
Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR
TRUE: At runtime, the visualization element is displayed in the foreground.
FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

Element property 'Input configuration'
The properties contain the configurations for the user input when using the mouse or keyboard. A user input defines an event and one or more actions that are executed when an event occurs.
The “Configure” button opens the “Input Configuration” dialog. There you can create or edit user inputs. Configured user inputs are listed below the events. They each include the action that is triggered and the setting in short form.
Example: “Execute ST Code”: PLC_PRG.i_x := 0;

"OnDialogClosed"  
Input event: The user closes the dialog.

"OnMouseClicked"  
Input event: The user clicks the mouse button completely in the element area. The mouse button is clicked and released.

"OnMouseDown"  
Input event: The user clicks down on the mouse button.

"OnMouseEnter"  
Input event: The user drags the mouse pointer to the element.

"OnMouseLeave"  
Input event: The user drags the mouse pointer away from the element.
<table>
<thead>
<tr>
<th>“OnMouseMove”</th>
<th>Input event: The user moves the mouse pointer over the element area.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“OnMouseUp”</td>
<td>Input events:</td>
</tr>
<tr>
<td></td>
<td>● The user releases the mouse button within the element area. It is irrelevant whether the user has previously pressed the mouse button inside or outside the element area.</td>
</tr>
<tr>
<td></td>
<td>● The user presses the mouse button within the element area, leaves the element area, and then releases the mouse button.</td>
</tr>
<tr>
<td></td>
<td>Note: This CODESYS-specific triggering behavior guarantees that actions for key elements are completed. A key element starts an action for “OnMouseDown” and ends the action for “OnMouseUp”.</td>
</tr>
<tr>
<td></td>
<td>Example: A visualization user presses the mouse button within the element area of the key element and then moves the cursor position so that it lies outside the element area. The action is ended anyway because “OnMouseUp” is triggered.</td>
</tr>
</tbody>
</table>

| “Tap” | When a mouse click event occurs, the variable defined in “Variable” is described in the application. The coding depends on the “Tap FALSE” and “Tap on enter if captured” options. |
| “Variable” | Variable (BOOL) that is set on mouse click event. |
| Example: FLC_PRG.bIsTapped | TRUE: A mouse click event exists. It lasts as long as the user presses the mouse button over the element. It ends when the button is released. |
| | FALSE: A mouse click event does not exist. |
| Requirement: The “Tap FALSE” option is not activated. |

| “Tap FALSE” | ☑: The mouse click event leads to a complementary value in “Variable”. |
| | TRUE: A mouse click event does not exist. |
| | FALSE: While the mouse click event exists. |

| “Tap on enter if captured” | ☑: During user input, it is also taken into consideration whether the mouse pointer is dragged within the element area or not while the mouse button is pressed. |
| | TRUE: While the mouse click event exists and the mouse pointer is moved over the element area. |
| | FALSE: A mouse click event does not exist. Or the user moves the mouse pointer outside of the element area while the mouse button is pressed. |
| | The value is TRUE again as soon as the user moves the pointer back to the element area. The mouse is then captured. |

| “Toggle” | With the onset of a mouse click event, the variable is set; when the mouse click event is completed, the variable is reset. |
| “Variable” | Variable (BOOL). Its value toggled when the mouse click event is ended. This is when the user releases the mouse button while the mouse pointer is over the element area. |
| If the user releases the mouse button while the mouse pointer is outside of the element area, then the mouse click event is not ended and the value is not toggled. |
| Hint: The user can cancel a started toggle input by dragging the mouse pointer out of the element area. |

| “Toggle on up if captured” | ☑: The value toggles regardless of where the mouse pointer is when the mouse button is released. The mouse is then captured. |
**“Hotkey”**
Keyboard shortcut on the element for triggering specific input actions.
When the keyboard shortcut event occurs, the input actions in the “Events” property are triggered. In this way, it is not the input action itself that leads to this input action, but the mouse input action.

**“Key”**
Key pressed for input action.
Example: [T]
Note: The following properties appear when a key is selected.

**“Events”**
- “None”
- “Mouse down”: Pressing the key triggers the input actions that are configured in the “OnMouseDown” property.
- “Mouse up”: Releasing the key triggers the input actions that are configured in the “OnMouseUp” property.
- “Mouse down/up”: Pressing and releasing the key triggers the input actions that are configured in the “OnMouseDown” property and the “OnMouseUp” property.

**“Shift”**
☑: Combination with the Shift key
Example: [Shift]+[T].

**“Control”**
☑: Combination with the Ctrl key
Example: [Ctrl]+[T].

**“Alt”**
☑: Combination with the Alt key
Example: [Alt]+[T].

All keyboard shortcuts and their actions that are configured in the visualization are listed on the “Keyboard Configuration” tab.

See also
- ☼ Chapter 6.4.5.21.2.2 “Command ‘Keyboard Configuration’” on page 3341
- ☼ Chapter 6.4.5.21.3.6 “Dialog ‘Input Configuration’” on page 3370

**Element property ‘Access rights’**
Requirement: User management is set up for the visualization.

**“Access rights”**
Opens the “Access rights” dialog. There you can edit the access privileges for the element.
Status messages:
- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also
- ☼ Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

**Visualization Element ‘Group Box’**
Symbol:
Category: “Common Controls”

The element provides a visual grouping of visualization elements. The group box can have multiple levels of nesting.

You can also use drag&drop to add elements to a “Group Box”. To do this, drag the element to the window area of the “Group Box”. The appearance of the cursor changes (a small plus sign is displayed). When you click the [Shift] key at the same time, the element is not added.

You can remove elements from the “Group Box” by dragging them out of the window area.

Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: Parameter axis 1</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Optional</td>
</tr>
<tr>
<td></td>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Type of element”</th>
<th>“Group Box”</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Clipping”</td>
<td>[ ]: Elements that protrude beyond the size of the group box are clipped.</td>
</tr>
</tbody>
</table>

Element property 'Position'

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

| “X”                     | X coordinate of the upper left corner of the element |
|                        | Specified in pixels.  |
|                        | Example: 10.          |

| “Y”                     | Y coordinate of the upper left corner of the element |
|                        | Specified in pixels.  |
|                        | Example: 10.          |

| “Width”                 | Specified in pixels.  |
|                        | Example: 150          |

| “Height”                | Specified in pixels.  |
|                        | Example: 30           |

You can also change the values by dragging the box symbols (mouseover) to other positions in the editor.

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

Element property 'Center'

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.
The properties contain character strings for labeling the element.

CODESYS accepts the specified texts automatically into the “GlobalTextList” text list. Therefore, these texts can be localized.

**Element property 'Texts'**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Text”</td>
<td>Character string (without single straight quotation marks) for labeling the element. Example: Axis 1.</td>
</tr>
<tr>
<td>“Tooltip”</td>
<td>Character string (without single straight quotation marks) that is displayed as the tooltip of an element. Example: Parameters of Axis 1.</td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

The properties contain fixed values for the text properties.

**Element property 'Text properties'**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| “Font”    | Example: “Default”

- The “Font” dialog box opens.
- ▼: Drop-down list with style fonts.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| “Font color” | Example: “Black”

- The “Color” dialog box opens.
- ▼: Drop-down list with style colors.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| “Transparency” | Whole number (value range from 0 to 255). This determines the transparency of the respective color.

- Example: 255: The color is opaque.
- 0: The color is completely transparent.

Please note: If the color is a style color and already has a transparency value, then this property is write-protected.

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.
"Movement"

- **X** variable (numeric data type). Defines the X position (in pixels).

  Example: PLC_PRG.iPos_X.

  Increasing this value in runtime mode moves the element to the right.

- **Y** variable (numeric data type). Defines the Y position (in pixels).

  Example: PLC_PRG.iPos_Y.

  Increasing this value in runtime mode moves the element downwards.

- **Rotation** variable (numeric data type). Defines the angle of rotation (in degrees).

  Example: PLC_PRG.iAngle1.

  The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.

  In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

- **Scaling** variable (integer data type). Causes centric stretching.

  Example: PLC_PRG.iScaling.

  The reference point is the “Center” property.

  The value 1 shrinks the element by a factor of 0.001. The value 1000 returns the element to its original size.

- **Interior rotation** variable (numeric data type). Defines the angle of rotation (in degrees).

  Example: PLC_PRG.iAngle2.

  In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

  The rotation point is shown as the symbol.

  Note: If a static angle of rotation is specified in the property “Position Angle”, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

You can link the variables to a unit conversion.

The properties “X”, “Y”, “Rotation”, and “Interior rotation” are supported by the "Client Animation" functionality.
### Element property 'State variables'

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
</table>
| **"Invisible"** | Variable (BOOL). Toggles the visibility of the element.  
**Example:** bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR  
**TRUE:** The element is not visible at runtime.  
**Example:** TRUE  
**FALSE:** The element is visible at runtime. |
| **"Deactivate inputs"** | Variable (BOOL). Toggles the operability of the element.  
**Example:** FALSE  
**TRUE:** User inputs do not have any effect in runtime more. The element is shown as deactivated. |

The ‘Invisible’ property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| **"Animation duration"** | Defines the duration (in milliseconds) in which the element runs an animation  
**Variable (integer value)**  
**Example:** Menu.tContent with VAR tContent : INT := 500; END_VAR  
**Integer literal**  
**Example:** 500  
Animatable properties  
• “Absolute movement”, “Movement”, “X”, “Y”  
• “Absolute movement”, “Rotation”  
• “Absolute movement”, “Interior rotation”  
• “Absolute movement”, “Exterior rotation”  
The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth. |
| **"Move to foreground"** | Moves the visualization element to the foreground  
**Variable (BOOL)**  
**Example:** bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR  
**TRUE:** At runtime, the visualization element is displayed in the foreground.  
**FALSE:** At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor. |

See also

- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
**Visualization Element 'Table'**

Symbol: ![Table symbol]

Category: “Common Controls”

The element displays data that can be represented as an array in a table. Therefore, the data type of the visualizing variable can be 1) a one-dimensional array, 2) a maximum two-dimensional array, 3) an array of an array, 4) an array of structures, or 5) an array of a function block.

### Element properties

<table>
<thead>
<tr>
<th><strong>“Element name”</strong></th>
<th>Example: Data set component 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Type of element”</strong></th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Array whose data is visualized as a table</td>
</tr>
</tbody>
</table>

**“Data array”**

Variable (ARRAY) whose data type determines the number of columns and rows in the table

**Array types**

- One-dimensional array: The table has one column.
- Two-dimensional array: The second dimension determines the number of columns.
- Array of an array: The number of array elements of the back array determines the number of columns.
- Array of a structure: The number of structure members determines the number of columns.
- Array of a function block: The number of local variables determines the number of columns.

**Example:**

```plaintext
PLC_PRG.aiTable

Declaration: aiTable : ARRAY[0..3, 0..4] OF INT := [4(1, 2, 3, 4, 5)];
```

**Hint:** If the declaration of the array changes, then the table can be refreshed by placing the cursor in the data array value field and pressing the [Enter] key.

<table>
<thead>
<tr>
<th><strong>“Max. array index”</strong></th>
<th>Top index limit for the displayed table. Limits the number of displayed rows. The index begins at 0.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Variable (integer data type)</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iUpperIndexBoundToDisplay</td>
</tr>
<tr>
<td></td>
<td>Integer literal</td>
</tr>
<tr>
<td></td>
<td>Example: 4 is displayed as 5 in the row of the table.</td>
</tr>
</tbody>
</table>

See also

- **Data Type ‘ARRAY’**
The "Table" element shows the values of a variable in a tabular view. The array elements of structure members are shown in a column or in a row. Two-dimensional arrays or arrays of a structure are shown in multiple columns. The visualized variable is defined in the "Data array" property. When a variable is assigned there, you can specify the display of the Table columns where the array elements are shown. An individual configuration is possible for each column that is assigned to an index [<n>].

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Show row header&quot;</td>
<td>The row header is visible. Example: For an array, the index of the array element is displayed in the header.</td>
</tr>
<tr>
<td>&quot;Show column header&quot;</td>
<td>The column label is visible.</td>
</tr>
<tr>
<td>&quot;Row height&quot;</td>
<td>Height of the rows (in pixels)</td>
</tr>
<tr>
<td>&quot;Row header width&quot;</td>
<td>Width of the row label</td>
</tr>
<tr>
<td>&quot;Scroll bar size&quot;</td>
<td>Size of the scroll bar (in pixels)</td>
</tr>
</tbody>
</table>

Table 630: "Element property 'Columns: Column [<n>]'

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Column header&quot;</td>
<td>By default, the name of the array or structure is applied as the heading with the index or structure member for the column. If an array of a function block has been selected for &quot;Data array&quot;, then the name of the array is applied to the column header with the local variables of the function block that belong to the column. The column label can be changed here by specifying a new title.</td>
</tr>
<tr>
<td>&quot;Width&quot;</td>
<td>Column width (in pixels)</td>
</tr>
<tr>
<td>&quot;Image column&quot;</td>
<td>Images can be displayed in the column. Images are used from the global image pool or custom image pools. The image IDs are shown in the cells of the Table as they are defined in the image pool.</td>
</tr>
<tr>
<td>&quot;Image configuration&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Fill mode&quot;</td>
<td>● Fill cell: The image resizes to the dimensions of the cell without fixing the height/width ratio. ● Centered: The image is centered in the cell and retains its proportions (height/width ratio).</td>
</tr>
<tr>
<td>&quot;Transparency&quot;</td>
<td>The color which is specified in &quot;Transparent color&quot; is displayed as transparent.</td>
</tr>
<tr>
<td>&quot;Transparent color&quot;</td>
<td>This color is displayed as transparent. Requirement: The &quot;Transparency&quot; property is activated.</td>
</tr>
<tr>
<td>&quot;Text alignment of header&quot;</td>
<td>Alignment of the column header: ● Left ● Centered ● Right</td>
</tr>
<tr>
<td>&quot;Use template&quot;</td>
<td>Another visualization element (type &quot;Rectangle&quot;, &quot;Rounded Rectangle&quot;, or &quot;Ellipse&quot;) is inserted into each line of this Table column. The properties list is extended automatically with the properties of this element in &quot;Template&quot;.</td>
</tr>
<tr>
<td>&quot;Text alignment of the headline from the template&quot;</td>
<td>Requirement: The &quot;Use template&quot; property is activated.</td>
</tr>
</tbody>
</table>
| "Template" | Requirement: The "Use template" property is activated. The properties of all elements assigned to the column are listed in "Template". They can be modified there as described in "Rectangle", "Rounded Rectangle", and "Ellipse"."
The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

**Element property 'Position'**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>X coordinate of the upper left corner of the element</td>
<td>10</td>
</tr>
<tr>
<td>Y</td>
<td>Y coordinate of the upper left corner of the element</td>
<td>10</td>
</tr>
<tr>
<td>Width</td>
<td>Specified in pixels.</td>
<td>150</td>
</tr>
<tr>
<td>Height</td>
<td>Specified in pixels.</td>
<td>30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols ([]) to other positions in the editor.

**Element property 'Center'**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>X-coordinate of the point of rotation</td>
</tr>
<tr>
<td>Y</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (ø) to other positions in the editor.

**Element property 'Text properties'**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Horizontal alignment</td>
<td>Horizontal alignment of the text within the element.</td>
</tr>
<tr>
<td>Vertical alignment</td>
<td>Vertical alignment of the text within the element.</td>
</tr>
</tbody>
</table>
### “Font”

<table>
<thead>
<tr>
<th>Example: “Default”</th>
</tr>
</thead>
<tbody>
<tr>
<td>The “Font” dialog box opens.</td>
</tr>
<tr>
<td>▼: Drop-down list with style fonts.</td>
</tr>
</tbody>
</table>

### “Font color”

<table>
<thead>
<tr>
<th>Example: “Black”</th>
</tr>
</thead>
<tbody>
<tr>
<td>The “Color” dialog box opens.</td>
</tr>
<tr>
<td>▼: Drop-down list with style colors.</td>
</tr>
</tbody>
</table>

### “Transparency”

Whole number (value range from 0 to 255). This determines the transparency of the respective color.

| Example: 255: The color is opaque. |
| 0: The color is completely transparent. |

Please note: If the color is a style color and already has a transparency value, then this property is write-protected.

#### Element property 'Dynamic texts'

Dynamic texts are variably indexed texts of a text list. At runtime, the text is displayed that is currently indexed in the variable.

### “Text list”

| Variable (string) or name of the text list as a fixed string in single straight quotation marks. |
| Example: 'Errorlist' |
| ▼: Drop-down list with the dialogs available in the text lists. |

### “Text index”

Text list ID. This refers to the desired output text.

- As fixed string with the ID in single straight quotation marks.
  - Example: '1' |
- As a variable (STRING) for dynamically controlling the text output.
  - Example: strTextID |
  - Sample assignment: PLC_PRG.strTextID := '1'; |

### “Tooltip index”

Text list ID. This refers to the desired output text.

- As fixed string with the ID in single straight quotation marks.
  - Example: '2' |
- As a variable (STRING) for dynamically controlling the text output.
  - Example: strToolTipID |
  - Sample assignment: PLC_PRG.strToolTipID := '2'; |

### Element property 'Font variables'

The variables enable dynamic control of the text display.

### “Font name”

| Variable (STRING). Includes the font of the text. |
| Example: PLC_PRG.stFontVar := 'Arial'; |

The selection of fonts corresponds to the default “Font” dialog box.

### “Size”

| Variable (integer data type). Contains the font size (in pixels). |
| Example: PLC_PRG.iFontHeight := 16; |

The selection of font sizes corresponds to the default “Font” dialog box.
### “Flags”

Variable (DWORD). Contains the flags for displaying fonts.

**Flags:**
- 1: Italics
- 2: Bold
- 4: Underline
- 8: Strikethrough

Note: You can combine the font displays by adding the coding of the flags. For example, a bold and underlined text: `PLC_PRG.dwFontType := 6;`

### “Charset”

Variable (DWORD). Contains a character set number for the font.

The selection of character set numbers corresponds to the “Script” setting of the standard “Font” dialog box.

### “Color”

Variable (DWORD). Includes the color of the text.

Example: `PLC_PRG.dwColorFont := 16#FF000000;`

### “Flags for text alignment”

Variable (integer data type). Contains the coding for text alignment.

Example: `PLC_PRG.dwTextAlignment.

Coded:
- 0: Top left
- 1: Horizontal center
- 2: Right
- 4: Vertical center
- 8: Bottom

Note: You can combine the text alignments by adding the coding of the flags. For example, a vertical and horizontal centered text: `PLC_PRG.dwFontType := 5;`

---

**Fixed values for displaying texts are set in “Text properties”.

See also
- "Element property ‘Text properties’” on page 3116

**Element property ‘Absolute movement’**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

### “Movement”

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>Variable (numeric data type). Defines the X position (in pixels). Example: <code>PLC_PRG.iPos_X</code>. Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td>Y</td>
<td>Variable (numeric data type). Defines the Y position (in pixels). Example: <code>PLC_PRG.iPos_Y</code>. Increasing this value in runtime mode moves the element downwards.</td>
</tr>
</tbody>
</table>
| **“Rotation”** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
**Example:** `PLC_PRG.iAngle1`.  
The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.  
In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right. |
| --- | --- |

| **“Interior rotation”** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
**Example:** `PLC_PRG.iAngle2`.  
In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.  
The rotation point is shown as the symbol.  
**Note:** If a static angle of rotation is specified in the “Position Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed. |
| --- | --- |

You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

-  

Element property 'State variables'

| **“Invisible”** | Variable (BOOL). Toggles the visibility of the element.  
**TRUE:** The element is not visible at runtime.  
**Example:**  
`bIsVisible with VAR bIsVisible : BOOL := FALSE;`  
`END_VAR` |
| --- | --- |

| **“Deactivate inputs”** | Variable (BOOL). Toggles the operability of the element.  
**TRUE:** User inputs do not have any effect in runtime more. The element is shown as deactivated. |
Element property ‘Selection’

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Background color on selection”</td>
<td>Fill color of the selected row.</td>
</tr>
<tr>
<td>“Selection font color”</td>
<td>Font color of the selected row.</td>
</tr>
<tr>
<td>“Selection type”</td>
<td>Selection when clicking the table row.</td>
</tr>
<tr>
<td></td>
<td>- No selection: <strong>No selection</strong></td>
</tr>
<tr>
<td></td>
<td>- Cell selection: <strong>The clicked cell only</strong></td>
</tr>
<tr>
<td></td>
<td>- Row selection: <strong>Row of the clicked cell</strong></td>
</tr>
<tr>
<td></td>
<td>- Column selection: <strong>Column of the clicked cell</strong></td>
</tr>
<tr>
<td></td>
<td>- Row and column selection: <strong>Row and column of the clicked cell</strong></td>
</tr>
<tr>
<td>“Frame around selected cells”</td>
<td>☑: A frame is drawn around the selected cells.</td>
</tr>
<tr>
<td>“Variable for selected column”</td>
<td>Variable (INT). Contains the array index of the “Column” of the selected cell. If the data array points to a structure, then the structure components are indexed, starting at 0. Warning: This index represents the correct position in the array only if no columns have been removed from the table in the display.</td>
</tr>
<tr>
<td>“Variable for selected row”</td>
<td>Variable (INT). Contains the array index of the “Row” of the selected cell.</td>
</tr>
<tr>
<td>“Variable for valid column selection”</td>
<td>Variable (BOOL). TRUE: The “Variable for selected column” variable contains a valid value.</td>
</tr>
</tbody>
</table>

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
### “Animation duration”
Defines the duration (in milliseconds) in which the element runs an animation

- **Variable (integer value)**
  - **Example:** Menu.tContent with
    ```
    VAR tContent : INT := 500;
    END_VAR
    ```
- **Integer literal**
  - **Example:** 500

#### Animatable properties
- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

### “Move to foreground”
Moves the visualization element to the foreground

**Variable (BOOL)**

**Example:** bIsInForeground with
```
VAR bIsInForeground : BOOL := FALSE; END_VAR
```

- **TRUE:** At runtime, the visualization element is displayed in the foreground.
- **FALSE:** At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

#### Element property 'Access rights'

**Requirement:** User management is set up for the visualization.

### “Access rights”
Opens the “Access rights” dialog. There you can edit the access privileges for the element.

**Status messages:**
- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also
- % Chapter 6.4.5.21.3.1 “Dialog 'Access Rights’” on page 3366

See also
- % Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
- % Chapter 6.4.5.11.2 “Displaying Array Variables in Tables” on page 2917
- Data Type 'ARRAY'

#### Visualization Element 'Text Field'

**Symbol:**

**Category:** “Common Controls”
The element is used for the following purposes:

- Static output of text. The contents of a variable can be part of the text.
- Showing a tooltip. The text is managed as static text and can also be defined so that the contents of a variable are also displayed.
- Dynamic output of text. Texts of a text list are displayed dynamically.
- Input of text. For example, a user can input a number or a text literal.

See also
- ☞ Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

**Element properties**

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: FileName_A</td>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Type of element”</th>
<th>“Text Field”</th>
</tr>
</thead>
</table>

**Element property 'Position'**

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td>Example: 10</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td>Example: 10</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Width”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 150</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Height”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (_drag_2) to other positions in the editor.

See also
- ☞ Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

**Element property 'Colors'**

<table>
<thead>
<tr>
<th>“Normal state”</th>
<th>The normal state is in effect if the variable in “Color variables ➔ Toggle color” is not defined or it has the value FALSE.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Frame color”</th>
<th>Frame and fill color for the corresponding state of the variable.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>“Fill color”</td>
<td>Transparency value (0 to 255) for defining the transparency of the selected color. Example: 255: The color is opaque. 0: The color is completely transparent.</td>
</tr>
<tr>
<td>“Transparency”</td>
<td>Transparency value (0 to 255) for defining the transparency of the selected color. Example: 255: The color is opaque. 0: The color is completely transparent.</td>
</tr>
<tr>
<td>“Alarm state”</td>
<td>The alarm state is in effect if the variable in “Color variables” has the value TRUE.</td>
</tr>
</tbody>
</table>

See also
- [Chapter 6.4.5.21.3.5 “Dialog ‘Gradient Editor’” on page 3369](#)

### Element property 'Appearance'

The properties contain fixed values for setting the look of the element.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| “Line width”      | Value in pixels  
Example: 2  
Note: The values 0 and 1 both result in a line weight of 1 pixel. If no line should be displayed, then the “Line style” property must be set to the option “Invisible”. |
| “Fill attributes” | The way in which the element is filled.  
- “Filled”: The element is filled with the color from property “Colors”  
- “Invisible”: The fill color is invisible. |
| “Line style”      | Type of line representation  
- “Solid”  
- “Dashes”  
- “Dots”  
- “Dash Dot”  
- “Dash Dot Dot”  
- “not visible” |

You can assign variables in the “Appearance variables” property for controlling the appearance dynamically. The fixed values here are overwritten.

See also
- [“Element property 'Appearance variables’” on page 3064](#)

### Element property 'Texts'

The properties contain character strings for labeling the element. The character string can also contain a placeholder with a format definition. In runtime mode, the placeholder is replaced by the current value in the specified format.

CODESYS accepts the specified texts automatically into the “GlobalTextList” text list. Therefore, these texts can be localized.
### Element property 'Text variable'

- **Text**
  - Character string (without single straight quotation marks) for the labeling the element. Add a line break by pressing the keyboard shortcut [Ctrl] + [Enter].
  - **Example:** `Accesses: %i`

- **Tooltip**
  - Character string (without single straight quotation marks) that is displayed as the tooltip of an element.
  - **Example:** `Number of valid accesses`

See also
- [“Element property 'Text variables’” on page 3116](#)
- [Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872](#)
- [Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329](#)

### Element property 'Text properties'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Horizontal alignment</strong></td>
<td>Horizontal alignment of the text within the element.</td>
</tr>
<tr>
<td><strong>Vertical alignment</strong></td>
<td>Vertical alignment of the text within the element.</td>
</tr>
<tr>
<td><strong>Text format</strong></td>
<td>Definition for displaying texts that are too long</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default</strong>: The long text is truncated.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Line break</strong>: The text is split into parts.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Ellipsis</strong>: The visible text ends with &quot;...&quot; indicating that it is not complete.</td>
</tr>
<tr>
<td><strong>Font</strong></td>
<td>Example: “Default”</td>
</tr>
<tr>
<td></td>
<td><img src="#" alt="Font" /> The “Font” dialog box opens.</td>
</tr>
<tr>
<td></td>
<td><img src="#" alt="Font" /> Drop-down list with style fonts.</td>
</tr>
<tr>
<td><strong>Font color</strong></td>
<td>Example: “Black”</td>
</tr>
<tr>
<td></td>
<td><img src="#" alt="Font" /> The “Color” dialog box opens.</td>
</tr>
<tr>
<td></td>
<td><img src="#" alt="Font" /> Drop-down list with style colors.</td>
</tr>
<tr>
<td><strong>Transparency</strong></td>
<td>Whole number (value range from 0 to 255). This determines the transparency of the respective color.</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong> 255: The color is opaque.</td>
</tr>
<tr>
<td></td>
<td>0: The color is completely transparent.</td>
</tr>
<tr>
<td></td>
<td>Please note: If the color is a style color and already has a transparency value, then this property is write-protected.</td>
</tr>
</tbody>
</table>

### Element property 'Text variables'

These properties are variables with contents that replace a format definition.
"Text variable" | Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.  
| Example: PLC_PRG.iAccesses  
| Note: The format definition is part of the text in the property “Texts ➔ Text”.  
| Note: If you specify a variable of type enumeration with text list support, then the name of the enumeration data type is added automatically in angle brackets after the variable name. Example: PLC_PRG.enVar <enumeration name>. Then the symbolic value of the enumeration component is printed instead of the numeric value when text is printed. Refer to the help page for the enumerations.  

"Tooltip variable" | Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.  
| Example: PLC_PRG.iAccessesInTooltip  
| Note: The format definition is part of the text in the property “Texts ➔ Tooltip”.  

**See also**  
- `% Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329`  
- `% “Element property ‘Texts’” on page 3115`  
- `% Chapter 6.4.1.20.5.18 “Enumerations” on page 2263`  

**Element property ‘Dynamic texts’**  
Dynamic texts are variably indexed texts of a text list. At runtime, the text is displayed that is currently indexed in the variable.  

| "Text list" | Variable (string) or name of the text list as a fixed string in single straight quotation marks.  
| Example: 'Errorlist'  
| ▼: Drop-down list with the dialogs available in the text lists.  

| "Text index" | Text list ID. This refers to the desired output text.  
| As fixed string with the ID in single straight quotation marks.  
| Example: '1'  
| As a variable (STRING) for dynamically controlling the text output.  
| Example: strTextID  
| Sample assignment: PLC_PRG.strTextID := '1';  

| "Tooltip index" | Text list ID. This refers to the desired output text.  
| As fixed string with the ID in single straight quotation marks.  
| Example: '2'  
| As a variable (STRING) for dynamically controlling the text output.  
| Example: strToolTipID  
| Sample assignment: PLC_PRG.strToolTipID := '2';  

**See also**  
- `% Chapter 6.4.1.21.2.28 “Object ‘Text List’” on page 2532`  

**Element property ‘Font variables’**  
The variables allow for dynamic control of the text display.
### Font Name

Variable (STRING). Includes the font of the text.

Example: `PLC_PRG.stFontVar := 'Arial';`

The selection of fonts corresponds to the default "Font" dialog.

### Size

Variable (numeric data type). Contains the font size (in pixels or points). The applied unit is specified in brackets after the variable name.

- `<pt>`: Points (default)
  
  Example: `PLC_PRG.iFontHeight <pt>
  
  Code: `iFontHeight : INT := 12;`

- `<px>`: Pixels
  
  Example: `PLC_PRG.iFontHeight <px>
  
  Code: `iFontHeight : INT := 19;`

If you click in the value field, a drop-down list opens on the right for setting the unit.

Hint: The font size is specified in points (example: Arial 12). Use points when the variable font size should match a font, for example if a font is set in the property "Text property ➔ Font".

### Flags

Variable (DWORD). Contains the flags for displaying fonts.

Flags:

- 1: Italics
- 2: Bold
- 4: Underline
- 8: Strikethrough

Note: You can combine the font displays by adding the coding of the flags. For example, a bold and underlined text: `PLC_PRG.dwFontType := 6;`

### Character set

Variable (DWORD). Contains a character set number for the font.

The selection of character set numbers corresponds to the "Script" setting of the standard "Font" dialog.

### Color

Variable (DWORD). Includes the color of the text.

Example: `PLC_PRG.dwColorFont := 16#FF000000;`

### Flags for text alignment

Variable (integer data type). Contains the coding for text alignment.

Example: `PLC_PRG.dwTextAlignment`

Coding:

- 0: Top left
- 1: Horizontal center
- 2: Right
- 4: Vertical center
- 8: Bottom

Note: You can combine the text alignments by adding the coding of the flags. For example, a vertical and horizontal centered text: `PLC_PRG.dwFontType := 5;`
**Fixed values for displaying texts are set in “Text properties”**.

See also

- “Element property 'Text properties’” on page 3116

**Element property 'Color variables’**

The Element property is used as an interface for project variables to dynamically control colors at runtime.

<table>
<thead>
<tr>
<th><strong>“Toggle color”</strong></th>
<th>The property controls the toggled color at runtime.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Value assignment:</strong></td>
<td><strong>FALSE</strong>: The element is displayed with the color specified in the “Color” property.</td>
</tr>
<tr>
<td></td>
<td><strong>TRUE</strong>: The element is displayed with the color specified in the “Alarm color” property.</td>
</tr>
<tr>
<td><strong>Assignment options:</strong></td>
<td><strong>Placeholder for the user input variable</strong></td>
</tr>
<tr>
<td></td>
<td>- “&lt;toggle/tap variable&gt;”</td>
</tr>
<tr>
<td></td>
<td>- “&lt;NOT toggle/tap variable&gt;”</td>
</tr>
<tr>
<td></td>
<td>The color change is not controlled by its own variable, but by a user input variable.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Specify a variable for the mouse events “Tap” or “Toggle” in the input configuration of the element. Only then is the placeholder set. If you configure a variable in both “Toggle” and “Tap”, then the variable specified in “Tap” is used.</td>
</tr>
<tr>
<td></td>
<td><strong>Hint:</strong> Click the symbol to insert the placeholder “&lt;toggle/tap variable&gt;”. When you activate the “Inputconfiguration”, “Tap FALSE” property, then the “&lt;NOT toggle/tap variable&gt;” placeholder is displayed.</td>
</tr>
<tr>
<td></td>
<td><strong>Instance path of a project variable (BOOL)</strong></td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.xColorIsToggeled</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> In the code, declare and implement the variable specified here. Its value assignment determines when the color changes.</td>
</tr>
</tbody>
</table>

| **“Normal state”**                  | The properties listed below control the color depending on the state. The normal state is in effect if the variable in “Color variables”, “Toggle color” is not defined or it has the value FALSE. |
| **“Alarm state”**                   | The alarm state is in effect if the variable in “Color variables”, “Toggle color” has the value TRUE.                                                                   |

| **“Frame color”**                   | Assignment options:                                                                                                                                                        |
|                                     | **Variable (DWORD) for the frame color**                                                                                                                                     |
|                                     | Example: PLC_PRG.dwBorderColor                                                                                                                                              |
|                                     | **Color literal**                                                                                                                                                           |
|                                     | Example of green and opaque: 16#FF00FF00                                                                                                                                       |

| **“Filling color”**                 | Assignment options:                                                                                                                                                         |
|                                     | **Variable (DWORD) for the fill color**                                                                                                                                      |
|                                     | Example: PLC_PRG.dwFillColor                                                                                                                                                |
|                                     | **Color literal**                                                                                                                                                           |
|                                     | Example of gray and opaque: 16#FF888888                                                                                                                                      |
The transparency part of the color value is evaluated only if the “Activate semi-transparent drawing” option of the visualization manager is selected.

Select the “Advanced” option in the toolbar of the properties view. Then all element properties are visible.

See also
●  Chapter 6.4.5.10.4 “Animating a color display” on page 2914

Element property 'Absolute movement'
The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>“Movement”</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
</tr>
<tr>
<td>Example: PLC_PRG.iPos_X.</td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td>“Y”</td>
<td>Variable (numeric data type). Defines the Y position (in pixels).</td>
</tr>
<tr>
<td>Example: PLC_PRG.iPos_Y.</td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
</tr>
<tr>
<td>“Rotation”</td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
</tr>
<tr>
<td>Example: PLC_PRG.iAngle1.</td>
<td>The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.</td>
</tr>
<tr>
<td></td>
<td>In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
</tr>
</tbody>
</table>
"Interior rotation" Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in "Center" according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.  

Note: If a static angle of rotation is specified in the "Position ➔ Angle" property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

---

You can link the variables to a unit conversion.

---

The "X", "Y", "Rotation", and "Interior rotation" properties are supported by the "Client Animation" functionality.

---

See also

- 

**Element property ‘State variables’**

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Invisible&quot;</td>
<td>Variable (BOOL). Toggles the visibility of the element. True: The element is not visible at runtime. <strong>Example:</strong> bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR</td>
</tr>
<tr>
<td>&quot;Deactivate inputs&quot;</td>
<td>Variable (BOOL). Toggles the operability of the element. True: User inputs do not have any effect in runtime more. The element is shown as deactivated.</td>
</tr>
</tbody>
</table>

---

The "Invisible" property is supported by the "Client Animation" functionality.

---

**Element property ‘Selection and caret configuration’**

The variables allow for controlling the caret position and the selection of the text.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Caret position”</td>
<td>Variable (integer data type). Contains the position of the cursor.</td>
</tr>
<tr>
<td>“Selection start”</td>
<td>Variable (integer data type). Contains the position of the first selected character. Example: PLC_PRG.iSelStart</td>
</tr>
<tr>
<td>“Selection end”</td>
<td>Variable (integer data type). Contains the position of the last selected character. Example: PLC_PRG.iSelEnd</td>
</tr>
<tr>
<td>“All selected”</td>
<td>Variable (BOOL). Toggles the selection of the entered text. TRUE: The text in the text field is selected. FALSE: The selection starts with the value in “Selection start” and ends with “Selection end”</td>
</tr>
</tbody>
</table>

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Animation duration”</td>
<td>Defines the duration (in milliseconds) in which the element runs an animation&lt;br&gt; • Variable (integer value)&lt;br&gt; Example: Menu.tContent with VAR tContent : INT := 500; END_VAR&lt;br&gt; • Integer literal&lt;br&gt; Example: 500&lt;br&gt; Animatable properties&lt;br&gt; • “Absolute movement”, “Movement”, “X”, “Y”&lt;br&gt; • “Absolute movement”, “Rotation”&lt;br&gt; • “Absolute movement”, “Interior rotation”&lt;br&gt; • “Absolute movement”, “Exterior rotation”&lt;br&gt; The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.</td>
</tr>
<tr>
<td>“Move to foreground”</td>
<td>Moves the visualization element to the foreground&lt;br&gt; Variable (BOOL)&lt;br&gt; Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR&lt;br&gt; TRUE: At runtime, the visualization element is displayed in the foreground.&lt;br&gt; FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.</td>
</tr>
</tbody>
</table>

**Element property 'Input configuration'**

The properties contain the configurations for the user input when using the mouse or keyboard. A user input defines an event and one or more actions that are executed when an event occurs.

The “Configure” button opens the “Input Configuration” dialog. There you can create or edit user inputs.

Configured user inputs are listed below the events. They each include the action that is triggered and the setting in short form.

Example: “Execute ST Code”: fPLC_PRG.i_x := 0;

“OnDialogClosed” Input event: The user closes the dialog.
### OnMouseClick
Input event: The user clicks the mouse button completely in the element area. The mouse button is clicked and released.

### OnMouseDown
Input event: The user clicks down on the mouse button.

### OnMouseEnter
Input event: The user drags the mouse pointer to the element.

### OnMouseLeave
Input event: The user drags the mouse pointer away from the element.

### OnMouseMove
Input event: The user moves the mouse pointer over the element area.

### OnMouseUp
Input events:
- The user releases the mouse button within the element area. It is irrelevant whether the user has previously pressed the mouse button inside or outside the element area.
- The user presses the mouse button within the element area, leaves the element area, and then releases the mouse button.

Note: This CODESYS-specific triggering behavior guarantees that actions for key elements are completed. A key element starts an action for “OnMouseDown” and ends the action for “OnMouseUp”.

Example: A visualization user presses the mouse button within the element area of the key element and then moves the cursor position so that it lies outside the element area. The action is ended anyway because “OnMouseUp” is triggered.

### Tap
When a mouse click event occurs, the variable defined in “Variable” is described in the application. The coding depends on the “Tap FALSE” and “Tap on enter if captured” options.

### Variable
Variable (BOOL) that is set on mouse click event.

Example: PLC_PRG.bIsTapped

TRUE: A mouse click event exists. It lasts as long as the user presses the mouse button over the element. It ends when the button is released.

FALSE: A mouse click event does not exist.

Requirement: The “Tap FALSE” option is not activated.

### Tap FALSE
☑: The mouse click event leads to a complementary value in “Variable”.

TRUE: A mouse click event does not exist.

FALSE: While the mouse click event exists.

### Tap on enter if captured
☑: During user input, it is also taken into consideration whether the mouse pointer is dragged within the element area or not while the mouse button is pressed.

TRUE: While the mouse click event exists and the mouse pointer is moved over the element area.

FALSE: A mouse click event does not exist. Or the user moves the mouse pointer outside of the element area while the mouse button is pressed.

The value is TRUE again as soon as the user moves the pointer back to the element area. The mouse is then captured.
<table>
<thead>
<tr>
<th><strong>Toggle</strong></th>
<th>With the onset of a mouse click event, the variable is set; when the mouse click event is completed, the variable is reset.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Variable</strong></td>
<td>Variable (BOOL). Its value toggled when the mouse click event is ended. This is when the user releases the mouse button while the mouse pointer is over the element area. If the user releases the mouse button while the mouse pointer is outside of the element area, then the mouse click event is not ended and the value is not toggled. Hint: The user can cancel a started toggle input by dragging the mouse pointer out of the element area.</td>
</tr>
<tr>
<td><strong>Toggle on up if captured</strong></td>
<td>☑️: The value toggles regardless of where the mouse pointer is when the mouse button is released. The mouse is then captured.</td>
</tr>
</tbody>
</table>

| **Hotkey** | Keyboard shortcut on the element for triggering specific input actions. When the keyboard shortcut event occurs, the input actions in the “Events” property are triggered. In this way, it is not the input action itself that leads to this input action, but the mouse input action. |
| **Key** | Key pressed for input action. Example: [T] Note: The following properties appear when a key is selected. |
| **Events** | ● “None” ● “Mouse down”: Pressing the key triggers the input actions that are configured in the “OnMouseDown” property. ● “Mouse up”: Releasing the key triggers the input actions that are configured in the “OnMouseUp” property. ● “Mouse down/up”: Pressing and releasing the key triggers the input actions that are configured in the “OnMouseDown” property and the “OnMouseUp” property. |
| **Shift** | ☑️: Combination with the Shift key Example: [Shift]+[T]. |
| **Control** | ☑️: Combination with the Ctrl key Example: [Ctrl]+[T]. |
| **Alt** | ☑️: Combination with the Alt key Example: [Alt]+[T]. |

All keyboard shortcuts and their actions that are configured in the visualization are listed on the “Keyboard Configuration” tab.

See also
- ☮ Chapter 6.4.5.21.2.2 “Command ‘Keyboard Configuration’” on page 3341
- ☮ Chapter 6.4.5.21.3.6 “Dialog ‘Input Configuration’” on page 3370

Element property 'Access rights'

Requirement: User management is set up for the visualization.
“Access rights” dialog. There you can edit the access privileges for the element.

Status messages:
- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also
- ⚫ Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

Visualization Element ‘Scroll Bar’

Symbol:

Category: “Common Controls”

The element sets the value of a variable, depending on the position of the scroll bar.

Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: Speed Conveyor Belt 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Type of element”</th>
<th>“Scroll Bar”</th>
</tr>
</thead>
</table>

Element property ‘Center’

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (noinspection) to other positions in the editor.

<table>
<thead>
<tr>
<th>“Value”</th>
<th>Variable as type integer that includes the position of the scroll bar.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Minimum value”</td>
<td>Smallest value of the scroll bar (fixed value or variable).</td>
</tr>
<tr>
<td>“Maximum value”</td>
<td>Largest value of the scroll bar (fixed value or variable).</td>
</tr>
</tbody>
</table>
"Page size"

<table>
<thead>
<tr>
<th>Page size</th>
</tr>
</thead>
<tbody>
<tr>
<td>● As a fixed value, for example 10</td>
</tr>
<tr>
<td>● As a variable of data type integer</td>
</tr>
</tbody>
</table>

Requirement: Visible when the "Move to click" property is **not** selected.

"Move to click"

<table>
<thead>
<tr>
<th>Behavior of the scroll bar at visualization runtime when it is clicked:</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔: The scrollbar moves to the clicked position.</td>
</tr>
<tr>
<td>☐: The scrollbar moves to one “Page size” in the direction of the click.</td>
</tr>
</tbody>
</table>

**Element property 'Position'**

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>&quot;X&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>X coordinate of the upper left corner of the element</td>
</tr>
<tr>
<td>Specified in pixels.</td>
</tr>
<tr>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Y&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y coordinate of the upper left corner of the element</td>
</tr>
<tr>
<td>Specified in pixels.</td>
</tr>
<tr>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Width&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in pixels.</td>
</tr>
<tr>
<td>Example: 150</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Height&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in pixels.</td>
</tr>
<tr>
<td>Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (⿱) to other positions in the editor.

See also

- Chapter 6.4.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

**Element property 'Bar'**

The property defines the representation of scaling and direction of travel.
### “Orientation”
Alignment of the slider; defined by the ratio of width to height.
- “Horizontal”
- “Vertical”

You can modify the alignment in the visualization editor by using the pointing device to adjust the width and height of the Scroll Bar.

### “Running direction”
The drop-down list varies depending on the alignment of the slider.

**Horizontal**
- “Left to right”: Scale starts at the left.
- “Right to left”: Scale starts at the right.

**Vertical**
- “Bottom to top”: Scale starts at the bottom.
- “Top to bottom”: Scale starts at the top.

---

#### Element property ‘Colors’
The properties contain fixed values for setting colors.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Color”</td>
<td>Color for the element in its normal state.</td>
</tr>
<tr>
<td></td>
<td>Please note that the normal state is in effect if the expression in the</td>
</tr>
<tr>
<td></td>
<td>“Color variables ➔ Toggle color” property is not defined or it has the value</td>
</tr>
<tr>
<td></td>
<td>FALSE.</td>
</tr>
<tr>
<td>“Alarm color”</td>
<td>Color for the element in alarm state.</td>
</tr>
<tr>
<td></td>
<td>Please note that the alarm state is in effect if the expression in the</td>
</tr>
<tr>
<td></td>
<td>“Color variables ➔ Toggle color” property has the value TRUE.</td>
</tr>
<tr>
<td>“Transparency”</td>
<td>Value (0 to 255) for defining the transparency of the selected color.</td>
</tr>
<tr>
<td></td>
<td>Example 255: The color is opaque. 0: The color is completely transparent.</td>
</tr>
</tbody>
</table>

See also
- § Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

#### Element property ‘Texts’
The properties contains character strings for labeling the element. The character string can also contain a placeholder with a format definition. In runtime mode, the placeholder is replaced by the current value in the specified format.

CODESYS accepts the specified texts automatically into the “GlobalTextList” text list. Therefore, these texts can be localized.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Text”</td>
<td>Character string (without single straight quotation marks) for the labeling</td>
</tr>
<tr>
<td></td>
<td>the element. Add a line break by pressing the keyboard shortcut [Ctrl] + [Enter].</td>
</tr>
<tr>
<td></td>
<td>Example: Accesses: %i</td>
</tr>
<tr>
<td></td>
<td>The variable that contains the current value for the placeholder is specified in the property “Text variable ➔ Text”.</td>
</tr>
<tr>
<td>“Tooltip”</td>
<td>Character string (without single straight quotation marks) that is displayed as the tooltip of an element.</td>
</tr>
<tr>
<td></td>
<td>Example: Number of valid accesses.</td>
</tr>
<tr>
<td></td>
<td>The variable that contains the current value for the placeholder is specified in the property “Text variable ➔ Tooltip”.</td>
</tr>
</tbody>
</table>
See also

- “Element property 'Text variables’” on page 3128
- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
- Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329

Element property 'Text properties’

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Horizontal alignment”</td>
<td>Horizontal alignment of the text within the element.</td>
</tr>
<tr>
<td>“Vertical alignment”</td>
<td>Vertical alignment of the text within the element.</td>
</tr>
<tr>
<td>“Font”</td>
<td>Example: “Default”&lt;br&gt;<img src="image" alt="The “Font” dialog box opens." /> ◀: Drop-down list with style fonts.</td>
</tr>
<tr>
<td>“Font color”</td>
<td>Example: “Black”&lt;br&gt;<img src="image" alt="The “Color” dialog box opens." /> ◀: Drop-down list with style colors.</td>
</tr>
<tr>
<td>“Transparency”</td>
<td>Whole number (value range from 0 to 255). This determines the transparency of the respective color. &lt;br&gt;Example: 255: The color is opaque. &lt;br&gt;0: The color is completely transparent. &lt;br&gt;Please note: If the color is a style color and already has a transparency value, then this property is write-protected.</td>
</tr>
</tbody>
</table>

Element property 'Text variables’

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Text variable”</td>
<td>Variable (data type compliant with the format definition). It contains what is printed instead of the format definition. &lt;br&gt;Example: PLC_PRG.iAccesses &lt;br&gt;Note: The format definition is part of the text in the property “Texts ➔ Text”. &lt;br&gt;Note: If you specify a variable of type enumeration with text list support, then the name of the enumeration data type is added automatically in angle brackets after the variable name. Example: PLC_PRG.enVar &lt;enumeration name&gt;. Then the symbolic value of the enumeration component is printed instead of the numeric value when text is printed. Refer to the help page for the enumerations.</td>
</tr>
<tr>
<td>“Tooltip variable”</td>
<td>Variable (data type compliant with the format definition). It contains what is printed instead of the format definition. &lt;br&gt;Example: PLC_PRG.iAccessesInTooltip &lt;br&gt;Note: The format definition is part of the text in the property “Texts ➔ Tooltip”.</td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329
- “Element property ‘Texts’” on page 3127
- Chapter 6.4.1.20.5.18 “Enumerations” on page 2263
Dynamic texts are variably indexed texts of a text list. At runtime, the text is displayed that is currently indexed in the variable.

<table>
<thead>
<tr>
<th>&quot;Text list&quot;</th>
<th>Variable (string) or name of the text list as a fixed string in single straight quotation marks.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 'Errorlist' ▼: Drop-down list with the dialogs available in the text lists.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Text index&quot;</th>
<th>Text list ID. This refers to the desired output text.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>● As fixed string with the ID in single straight quotation marks.</td>
</tr>
<tr>
<td></td>
<td>Example: '1'</td>
</tr>
<tr>
<td></td>
<td>● As a variable (STRING) for dynamically controlling the text output.</td>
</tr>
<tr>
<td></td>
<td>Example: strTextID</td>
</tr>
<tr>
<td></td>
<td>Sample assignment: PLC_PRG.strTextID := '1';</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Tooltip index&quot;</th>
<th>Text list ID. This refers to the desired output text.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>● As fixed string with the ID in single straight quotation marks.</td>
</tr>
<tr>
<td></td>
<td>Example: '2'</td>
</tr>
<tr>
<td></td>
<td>● As a variable (STRING) for dynamically controlling the text output.</td>
</tr>
<tr>
<td></td>
<td>Example: strToolTipID</td>
</tr>
<tr>
<td></td>
<td>Sample assignment: PLC_PRG.strToolTipID := '2';</td>
</tr>
</tbody>
</table>

See also

- ☰ Chapter 6.4.1.21.2.28 “Object ‘Text List’” on page 2532

The variables allow for dynamic control of the text display.

<table>
<thead>
<tr>
<th>&quot;Font name&quot;</th>
<th>Variable (STRING). Includes the font of the text.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: PLC_PRG.stFontVar := 'Arial';</td>
</tr>
<tr>
<td></td>
<td>The selection of fonts corresponds to the default “Font” dialog.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Size&quot;</th>
<th>Variable (numeric data type). Contains the font size (in pixels or points). The applied unit is specified in brackets after the variable name.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>● &lt;pt&gt;: Points (default)</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iFontHeight &lt;pt&gt;</td>
</tr>
<tr>
<td></td>
<td>Code: iFontHeight := INT := 12;</td>
</tr>
<tr>
<td></td>
<td>● &lt;px&gt;: Pixels</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iFontHeight &lt;px&gt;</td>
</tr>
<tr>
<td></td>
<td>Code: iFontHeight := INT := 19;</td>
</tr>
</tbody>
</table>

If you click in the value field, a drop-down list opens on the right for setting the unit.

Hint: The font size is specified in points (example: Arial 12). Use points when the variable font size should match a font, for example if a font is set in the property “Text property ➔ Font”.
### Flags
Variable (DWORD). Contains the flags for displaying fonts.

Flags:
- 1: Italics
- 2: Bold
- 4: Underline
- 8: Strikethrough

Note: You can combine the font displays by adding the coding of the flags. For example, a bold and underlined text: `PLC_PRG.dwFontType := 6;`

### Character set
Variable (DWORD). Contains a character set number for the font.

The selection of character set numbers corresponds to the “Script” setting of the standard “Font” dialog.

### Color
Variable (DWORD). Includes the color of the text.

Example: `PLC_PRG.dwColorFont := 16#FF000000;`

### Flags for text alignment
Variable (integer data type). Contains the coding for text alignment.

Example: `PLC_PRG.dwTextAlignment`.

Coding:
- 0: Top left
- 1: Horizontal center
- 2: Right
- 4: Vertical center
- 8: Bottom

Note: You can combine the text alignments by adding the coding of the flags. For example, a vertical and horizontal centered text: `PLC_PRG.dwFontType := 5;`

---

---

Fixed values for displaying texts are set in “Text properties”.

See also
- “Element property ‘Text properties’” on page 3116

Element property 'Color variables'

The Element property is used as an interface for project variables to dynamically control colors at runtime.
<table>
<thead>
<tr>
<th>&quot;Toggle color&quot;</th>
<th>The property controls the toggled color at runtime.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value assignment:</td>
<td></td>
</tr>
<tr>
<td>● FALSE: The element is displayed with the color specified in the &quot;Color&quot; property.</td>
<td></td>
</tr>
<tr>
<td>● TRUE: The element is displayed with the color specified in the &quot;Alarm color&quot; property.</td>
<td></td>
</tr>
<tr>
<td>Assignment options:</td>
<td></td>
</tr>
<tr>
<td>● Placeholder for the user input variable</td>
<td></td>
</tr>
<tr>
<td>– &quot;&lt;toggle/tap variable&gt;&quot;</td>
<td></td>
</tr>
<tr>
<td>– &quot;&lt;NOT toggle/tap variable&gt;&quot;</td>
<td></td>
</tr>
<tr>
<td>The color change is not controlled by its own variable, but by a user input variable.</td>
<td></td>
</tr>
<tr>
<td>Note: Specify a variable for the mouse events &quot;Tap&quot; or &quot;Toggle&quot; in the input configuration of the element. Only then is the placeholder set. If you configure a variable in both &quot;Toggle&quot; and &quot;Tap&quot;, then the variable specified in &quot;Tap&quot; is used.</td>
<td></td>
</tr>
<tr>
<td>Hint: Click the symbol □ to insert the placeholder &quot;&lt;toggle/tap variable&gt;&quot;. When you activate the &quot;Inputconfiguration&quot; &quot;Tap FALSE&quot; property, then the &quot;&lt;NOT toggle/tap variable&gt;&quot; placeholder is displayed.</td>
<td></td>
</tr>
<tr>
<td>● Instance path of a project variable (BOOL)</td>
<td></td>
</tr>
<tr>
<td>Example: PLC_PRG.xColorIsToggeled</td>
<td></td>
</tr>
<tr>
<td>Note: In the code, declare and implement the variable specified here. Its value assignment determines when the color changes.</td>
<td></td>
</tr>
</tbody>
</table>

| "Normal state" | The properties listed below control the color depending on the state. The normal state is in effect if the variable in "Color variables", "Toggle color" is not defined or it has the value FALSE. |
| "Alarm state" | The alarm state is in effect if the variable in "Colorvariables", "Toggle color" has the value TRUE. |

<table>
<thead>
<tr>
<th>&quot;Frame color&quot;</th>
<th>Assignment options:</th>
</tr>
</thead>
<tbody>
<tr>
<td>● Variable (DWORD) for the frame color</td>
<td></td>
</tr>
<tr>
<td>Example: PLC_PRG.dwBorderColor</td>
<td></td>
</tr>
<tr>
<td>● Color literal</td>
<td></td>
</tr>
<tr>
<td>Example of green and opaque: 16#FF00FF00</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Filling color&quot;</th>
<th>Assignment options:</th>
</tr>
</thead>
<tbody>
<tr>
<td>● Variable (DWORD) for the fill color</td>
<td></td>
</tr>
<tr>
<td>Example: PLC_PRG.dwFillColor</td>
<td></td>
</tr>
<tr>
<td>● Color literal</td>
<td></td>
</tr>
<tr>
<td>Example of gray and opaque: 16#FF888888</td>
<td></td>
</tr>
</tbody>
</table>

The transparency part of the color value is evaluated only if the "Activate semi-transparent drawing" option of the visualization manager is selected.

Select the "Advanced" option in the toolbar of the properties view. Then all element properties are visible.

See also

● Chapter 6.4.5.10.4 “Animating a color display” on page 2914
The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

**"Movement"**

**"X"**
Variable (numeric data type). Defines the X position (in pixels).
Example: PLC_PRG.iPos_X.
Increasing this value in runtime mode moves the element to the right.

**"Y"**
Variable (numeric data type). Defines the Y position (in pixels).
Example: PLC_PRG.iPos_Y.
Increasing this value in runtime mode moves the element downwards.

**"Rotation"**
Variable (numeric data type). Defines the angle of rotation (in degrees).
Example: PLC_PRG.iAngle1.
The midpoint of the element rotates at the "Center" point. This rotation point is shown as the symbol.
In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

**"Interior rotation"**
Variable (numeric data type). Defines the angle of rotation (in degrees).
Example: PLC_PRG.iAngle2.
In runtime mode, the element rotates about the point of rotation specified in "Center" according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.
The rotation point is shown as the symbol.
Note: If a static angle of rotation is specified in the "Position ➔ Angle" property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

You can link the variables to a unit conversion.

The "X", "Y", "Rotation", and "Interior rotation" properties are supported by the "Client Animation" functionality.

See also

•
The variables control the element behavior dynamically.

**“Invisible”**  
Variable (BOOL). Toggles the visibility of the element.  
TRUE: The element is not visible at runtime.  
Example: `bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR`

**“Deactivate inputs”**  
Variable (BOOL). Toggles the operability of the element.  
TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.

The “Invisible” property is supported by the “Client Animation” functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

**“Animation duration”**  
Defines the duration (in milliseconds) in which the element runs an animation  
- Variable (integer value)  
  Example: `Menu.tContent with VAR tContent : INT := 500; END_VAR`  
- Integer literal  
  Example: 500  

Animatable properties  
- “Absolute movement”, “Movement”, “X”, “Y”  
- “Absolute movement”, “Rotation”  
- “Absolute movement”, “Interior rotation”  
- “Absolute movement”, “Exterior rotation”  
The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**“Move to foreground”**  
Moves the visualization element to the foreground  
Variable (BOOL)  
Example: `bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR`  
TRUE: At runtime, the visualization element is displayed in the foreground.  
FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

Requirement: User management is set up for the visualization.
“Access rights”

Opens the “Access rights” dialog. There you can edit the access privileges for the element.

Status messages:
- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also
- Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

See also
- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

Visualization Element ‘Slider’

Symbol:

Category: “Common Controls”

The element changes the value of a variable, depending on the position of the slider within the slider bar. You define the value range of the slider bar by means of the scale start and scale end.

Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: Speed controller conveyor belt 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
</tbody>
</table>

| “Type of element” | “Slider” |

Element property ‘Position’

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element Specified in pixels. Example: 10.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Y coordinate of the upper left corner of the element Specified in pixels. Example: 10.</td>
</tr>
<tr>
<td>“Width”</td>
<td>Specified in pixels. Example: 150</td>
</tr>
<tr>
<td>“Height”</td>
<td>Specified in pixels. Example: 30</td>
</tr>
</tbody>
</table>
You can also change the values by dragging the box symbols ( draggable) to other positions in the editor.

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

**Element property ‘Center’**

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
<td>X-coordinate of the point of rotation</td>
</tr>
<tr>
<td>“Y”</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols ( draggable) to other positions in the editor.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Variable”</td>
<td>Variable (numeric data type)</td>
</tr>
</tbody>
</table>

Example: PLC_PRG.rSlider

When executed, the variable assigns a value that corresponds to the position of the slider in the bar.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Page size”</td>
<td>Page size</td>
</tr>
</tbody>
</table>

- As a fixed value, for example 10
- As an IEC variable of data type integer

Requirement: The “Move to click” element property is not selected.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Move to click”</td>
<td>Behavior of the slider at visualization runtime when it is clicked:</td>
</tr>
<tr>
<td></td>
<td>✓: The slider moves to the clicked position.</td>
</tr>
<tr>
<td></td>
<td>□: The slider moves to the value (defined in the “Page size” element property) in the direction of the click.</td>
</tr>
</tbody>
</table>

**Element property ‘Scale’**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Show scale”</td>
<td>✓: The element has a visible scale.</td>
</tr>
</tbody>
</table>

Note: This option is available for the “Slider” only.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Scale start”</td>
<td>Least value of the scale and the lower limit of the value range for the element.</td>
</tr>
</tbody>
</table>

Example: 0

✧: The property “Variable” is shown below.
<table>
<thead>
<tr>
<th><strong>“Variable”</strong></th>
<th><strong>“Variable”</strong></th>
<th><strong>Variable</strong> (integer data type). Contains the scale start.</th>
<th><strong>Example</strong>: PLC_PRG.iScaleStart</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Declaration</strong>:</td>
<td><strong>Declaration</strong>:</td>
<td>PROGRAM PLC_PRG VAR iScaleStart : INT := 0;</td>
<td>PROGRAM PLC_PRG VAR iScaleEnd : INT := 120;</td>
</tr>
<tr>
<td><strong>“Scale end”</strong></td>
<td><strong>“Variable”</strong></td>
<td>Greatest value of the scale and the upper limit of the value range for the element.</td>
<td><strong>Example</strong>: 100</td>
</tr>
<tr>
<td><strong>“Main scale”</strong></td>
<td><strong>“Variable”</strong></td>
<td>Distance between two tick marks on the rough scale.</td>
<td><strong>Example</strong>: 10</td>
</tr>
<tr>
<td><strong>“Subscale”</strong></td>
<td><strong>“Variable”</strong></td>
<td>Distance between two dashes on the fine scale. You can hide the fine scale by setting the value to 0.</td>
<td><strong>Example</strong>: 2</td>
</tr>
<tr>
<td><strong>“Scale format (C Syntax)”</strong></td>
<td><strong>“Variable”</strong></td>
<td>Formatting of the scale label (example: %d %s)</td>
<td><strong>Example</strong>: PLC_PRG.iSubScale</td>
</tr>
<tr>
<td><strong>“Scale proportion”</strong></td>
<td><strong>“Variable”</strong></td>
<td>Size of the scale (in %) of the total size</td>
<td>PROGRAM PLC_PRG VAR iMainScale : INT := 20;</td>
</tr>
<tr>
<td><strong>Note</strong>: This property is available for the Slider only.</td>
<td>PROGRAM PLC_PRG VAR iMainScale : INT := 20;</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Note</strong>: This property is available for the Slider only.</td>
<td>PROGRAM PLC_PRG VAR iMainScale : INT := 20;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Element property 'Bar'

The property defines the representation of scaling and direction of travel.

<table>
<thead>
<tr>
<th><strong>Diagram type</strong></th>
<th>The drop-down list varies depending on the alignment of the diagram.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Horizontal</td>
</tr>
<tr>
<td></td>
<td>- &quot;Top&quot;: Scale is above the slider.</td>
</tr>
<tr>
<td></td>
<td>- &quot;Bottom&quot;: Scale is below the slider.</td>
</tr>
<tr>
<td></td>
<td>- &quot;Top and bottom&quot;: Two scales frame the slider above and below.</td>
</tr>
<tr>
<td></td>
<td>Vertical</td>
</tr>
<tr>
<td></td>
<td>- Left: Scale is left of the slider.</td>
</tr>
<tr>
<td></td>
<td>- Right: Scale is right of the slider.</td>
</tr>
<tr>
<td></td>
<td>- Left and right: Two scales frame the slider on the left and the right.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Orientation</strong></th>
<th>Alignment of the slider; defined by the ratio of width to height.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- &quot;Horizontal&quot;</td>
</tr>
<tr>
<td></td>
<td>- &quot;Vertical&quot;</td>
</tr>
</tbody>
</table>

You can modify the alignment in the visualization editor by using the pointing device to adjust the width and height of the scrollbar.

<table>
<thead>
<tr>
<th><strong>Running direction</strong></th>
<th>The drop-down list varies depending on the alignment of the slider.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Horizontal</td>
</tr>
<tr>
<td></td>
<td>- &quot;Left to right&quot;: Scale starts at the left.</td>
</tr>
<tr>
<td></td>
<td>- &quot;Right to left&quot;: Scale starts at the right.</td>
</tr>
<tr>
<td></td>
<td>Vertical</td>
</tr>
<tr>
<td></td>
<td>- &quot;Bottom to top&quot;: Scale starts at the bottom.</td>
</tr>
<tr>
<td></td>
<td>- &quot;Top to bottom&quot;: Scale starts at the top.</td>
</tr>
</tbody>
</table>

### Element property 'Absolute movement'

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th><strong>Movement</strong></th>
<th>Variable (numeric data type). Defines the X position (in pixels).</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;X&quot;</td>
<td>Example: PLC_PRG.iPos_X.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Y&quot;</th>
<th>Variable (numeric data type). Defines the Y position (in pixels).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: PLC_PRG.iPos_Y.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
</tr>
</tbody>
</table>
“Rotation” | Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle1.

The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.

In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

“Interior rotation” | Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the “Position Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

Element property ‘State variables’

The variables control the element behavior dynamically.

“Invisible” | Variable (BOOL). Toggles the visibility of the element.

TRUE: The element is not visible at runtime.

Example: bIsVisible with VAR bIsVisible : BOOL := FALSE;
END_VAR

“Deactivate inputs” | Variable (BOOL). Toggles the operability of the element.

TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.
The "Invisible" property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

<table>
<thead>
<tr>
<th>“Animation duration”</th>
<th>Defines the duration (in milliseconds) in which the element runs an animation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable (integer value)</td>
<td>Example: Menu.tContent with VAR tContent : INT := 500; END_VAR</td>
</tr>
<tr>
<td>Integer literal</td>
<td>Example: 500</td>
</tr>
</tbody>
</table>

Animatable properties
- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

<table>
<thead>
<tr>
<th>“Move to foreground”</th>
<th>Moves the visualization element to the foreground</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable (BOOL)</td>
<td>Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR</td>
</tr>
<tr>
<td>TRUE: At runtime, the visualization element is displayed in the foreground.</td>
<td></td>
</tr>
<tr>
<td>FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.</td>
<td></td>
</tr>
</tbody>
</table>

Element property ‘Access rights’

Requirement: User management is set up for the visualization.

<table>
<thead>
<tr>
<th>“Access rights”</th>
<th>Opens the “Access rights” dialog. There you can edit the access privileges for the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status messages:</td>
<td>• “Not set. Full rights.”: Access rights for all user groups : “operable”</td>
</tr>
<tr>
<td></td>
<td>• “Rights are set: Limited rights”: Access is restricted for at least one group.</td>
</tr>
</tbody>
</table>

See also
- § Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

See also
- § Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
## Visualization Element ‘Spin Box’

**Symbol:**

**Category:** “Common Controls”
The element increments or decrements the value of a variable in defined intervals.

### Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: Speed controller conveyor belt</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Type of element”</th>
<th>“Spin Box”</th>
</tr>
</thead>
</table>

### Element property 'Position'

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in pixels.</td>
<td></td>
</tr>
<tr>
<td>Example: 10.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in pixels.</td>
<td></td>
</tr>
<tr>
<td>Example: 10.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Width”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 150</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Height”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 30</td>
<td></td>
</tr>
</tbody>
</table>

*You can also change the values by dragging the box symbols (▼) to other positions in the editor.*

### Element property 'Center'

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

See also

- [Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874](#)
You can also change the values by dragging the symbols ( Griffel ) to other positions in the editor.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Variable”</td>
<td>Variable (numeric data type)</td>
</tr>
<tr>
<td>Example: PLC_PRG.iTemp</td>
<td></td>
</tr>
<tr>
<td>“Number format”</td>
<td>Format of the value in printf syntax</td>
</tr>
<tr>
<td>Example: %d, %5.2f</td>
<td></td>
</tr>
<tr>
<td>“Interval”</td>
<td>Interval used for modification of the value</td>
</tr>
</tbody>
</table>

**Element property 'Value range'**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Minimum value”</td>
<td>Lower limit of the output value</td>
</tr>
<tr>
<td>• fixed value</td>
<td></td>
</tr>
<tr>
<td>• Variable (INT)</td>
<td></td>
</tr>
<tr>
<td>“Maximum value”</td>
<td>Upper limit of the output value</td>
</tr>
<tr>
<td>• fixed value</td>
<td></td>
</tr>
<tr>
<td>• Variable (INT)</td>
<td></td>
</tr>
</tbody>
</table>

**Element property 'Text properties'**

The properties contain fixed values for the text properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Usage of”</td>
<td>• “Default style values”: The values of the visualization style are used.</td>
</tr>
<tr>
<td>• “Individual settings”: The &quot;Individual text properties&quot; property group is shown.</td>
<td></td>
</tr>
<tr>
<td>The values can be customized here.</td>
<td></td>
</tr>
<tr>
<td>“Individual text properties”</td>
<td>Requirement: The “Individual settings” text property is defined.</td>
</tr>
<tr>
<td>“Horizontal alignment”</td>
<td>Horizontal alignment of the text within the element.</td>
</tr>
<tr>
<td>“Vertical alignment”</td>
<td>Vertical alignment of the text within the element.</td>
</tr>
<tr>
<td>“Font”</td>
<td>Example: “Default”</td>
</tr>
<tr>
<td></td>
<td>• The “Font” dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>• Drop-down list with style fonts.</td>
</tr>
<tr>
<td>“Font color”</td>
<td>Example: “Black”</td>
</tr>
<tr>
<td></td>
<td>• The “Color” dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>• Drop-down list with style colors.</td>
</tr>
<tr>
<td>“Transparency”</td>
<td>Whole number (value range from 0 to 255). This determines the transparency of the respective color.</td>
</tr>
<tr>
<td></td>
<td>Example: 255: The color is opaque.</td>
</tr>
<tr>
<td></td>
<td>0: The color is completely transparent.</td>
</tr>
<tr>
<td></td>
<td>Please note: If the color is a style color and already has a transparency value, then this property is write-protected.</td>
</tr>
</tbody>
</table>
The Element property is used as an interface for project variables to dynamically control colors at runtime.

**“Toggle color”**

The property controls the toggled color at runtime. 

Value assignment:

- **FALSE**: The element is displayed with the color specified in the “Color” property.
- **TRUE**: The element is displayed with the color specified in the “Alarm color” property.

Assigning the property:

- Placeholder for the user input variable
  - "<toggle/tap variable>"
  - "<NOT toggle/tap variable>"

The color change is not controlled by its own variable, but by a user input variable.

Note: Specify a variable for the mouse events “Tap” or “Toggle” in the input configuration of the element. Only then is the placeholder set. If you configure a variable in both “Toggle” and “Tap”, then the variable specified in “Tap” is used.

Hint: Click the symbol ≦ to insert the placeholder “<toggle/tap variable>". When you activate the “Inputconfiguration”, “Tap FALSE” property, then the “<NOT toggle/tap variable>” placeholder is displayed.

- Instance path of a project variable (BOOL)
  
  Example: PLC_PRG.xColorIsToggled

Note: In the code, declare and implement the variable specified here. Its value assignment determines when the color changes.

---

The transparency part of the color value is evaluated only if the “Activate semi-transparent drawing” option of the visualization manager is selected.

Select the “Advanced” option in the toolbar of the properties view. Then all element properties are visible.

See also

- Chapter 6.4.5.10.4 “Animating a color display” on page 2914

---

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

**“Movement”**

**“X”**

Variable (numeric data type). Defines the X position (in pixels).

Example: PLC_PRG.iPos_X.

Increasing this value in runtime mode moves the element to the right.
<table>
<thead>
<tr>
<th>“Y”</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable (numeric data type). Defines the Y position (in pixels).</td>
</tr>
<tr>
<td>Example: PLC_PRG.iPos_Y.</td>
</tr>
<tr>
<td>Increasing this value in runtime mode moves the element downwards.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Rotation”</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
</tr>
<tr>
<td>Example: PLC_PRG.iAngle1.</td>
</tr>
<tr>
<td>The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.</td>
</tr>
<tr>
<td>In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Interior rotation”</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
</tr>
<tr>
<td>Example: PLC_PRG.iAngle2.</td>
</tr>
<tr>
<td>In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.</td>
</tr>
<tr>
<td>The rotation point is shown as the symbol.</td>
</tr>
<tr>
<td>Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.</td>
</tr>
</tbody>
</table>

You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- Element property 'State variables'

The variables control the element behavior dynamically.
### "Invisible"
| Variable (BOOL). Toggles the visibility of the element. |
| TRUE: The element is not visible at runtime. |
| **Example:** `bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR` |

### "Deactivate inputs"
| Variable (BOOL). Toggles the operability of the element. |
| TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated. |

---

The "Invisible" property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

---

### "Animation duration"
| Defines the duration (in milliseconds) in which the element runs an animation |
| - Variable (integer value) |
|  **Example:** `Menu.tContent with VAR tContent : INT := 500; END_VAR` |
| - Integer literal |
|  **Example:** 500 |

- Animatable properties
  - “Absolute movement”, “Movement”, “X”, “Y”
  - “Absolute movement”, “Rotation”
  - “Absolute movement”, “Interior rotation”
  - “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

---

### "Move to foreground"
| Moves the visualization element to the foreground |
| Variable (BOOL) |
| **Example:** `bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR` |
| TRUE: At runtime, the visualization element is displayed in the foreground. |
| FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor. |

---

Element property 'Input configuration'  The properties contain the configurations for the user input when using the mouse or keyboard. User input is a user event from the perspective of the element.

- The input configuration refers to the text area of the element only, not the two buttons.
The “Configure” button opens the “Input configuration” dialog box for creating or modifying a user input configuration.

A configuration contains one or more input actions for the respective input event. Existing input actions are displayed below it.

Example: “Execute ST code”: 

```plaintext
PLC_PRG.i_x := 0;
```

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“OnDialogClosed”</td>
<td>Input event: The user closes the dialog box.</td>
</tr>
<tr>
<td>“On_MouseClick”</td>
<td>Input event: The user clicks the element completely. The mouse button is clicked and released.</td>
</tr>
<tr>
<td>“OnMouseDown”</td>
<td>Input event: The user clicks down on the element only.</td>
</tr>
<tr>
<td>“OnMouseEnter”</td>
<td>Input event: The user drags the mouse pointer to the element.</td>
</tr>
<tr>
<td>“OnMouseLeave”</td>
<td>Input event: The user drags the mouse pointer away from the element.</td>
</tr>
<tr>
<td>“OnMouseMove”</td>
<td>Input event: The user moves the mouse pointer over the element area.</td>
</tr>
<tr>
<td>“OnMouseUp”</td>
<td>Input event: The user releases the mouse button over the element area.</td>
</tr>
</tbody>
</table>

See also

- § Chapter 6.4.5.21.3.6 “Dialog ‘Input Configuration’” on page 3370

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Tap”</td>
<td>When a mouse click event occurs, the variable defined in “Variable” is described in the application. The coding depends on the options “Tap FALSE” and “Tap on enter if captured”.</td>
</tr>
<tr>
<td>“Variable”</td>
<td>Variable (BOOL). Contains the information whether a mouse click event exists.</td>
</tr>
<tr>
<td>Example: PLC_PRG.bIsTapped</td>
<td></td>
</tr>
<tr>
<td>TRUE:</td>
<td>A mouse click event exists. It lasts while the user presses the mouse button over the element. It ends when the button is released.</td>
</tr>
<tr>
<td>FALSE:</td>
<td>A mouse click event does not exist.</td>
</tr>
<tr>
<td>Requirement:</td>
<td>The “Tap FALSE” option is not activated.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Tap FALSE”</td>
<td>☑: The mouse click event leads to a complementary value in “Variable”.</td>
</tr>
<tr>
<td>TRUE:</td>
<td>A mouse click event does not exist.</td>
</tr>
<tr>
<td>FALSE:</td>
<td>While the mouse click event exists.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Tap on enter if captured”</td>
<td>☑: During user input, it is also taken into consideration whether the mouse pointer is dragged within the element area or not while the mouse button is pressed.</td>
</tr>
<tr>
<td>TRUE:</td>
<td>While the mouse click event exists and the mouse pointer is moved over the element area.</td>
</tr>
<tr>
<td>FALSE:</td>
<td>A mouse click event does not exist. Or the user moves the mouse pointer outside of the element area while the mouse button is pressed. The value is TRUE again as soon as the user moves the pointer back to the element area. The mouse is then captured.</td>
</tr>
</tbody>
</table>
**“Shift”**  
When a mouse click event occurs, the variable here is described in the application. When the mouse click event ends, its value is toggled with the “Toggle on up if captured” option.

**“Variable”**  
Variable (BOOL). Its value toggled when the mouse click event is ended. This is when the user releases the mouse button while the mouse pointer is over the element area.  
If the user releases the mouse button while the mouse pointer is outside of the element area, then the mouse click event is not ended and the value is not toggled.  
Tip: The user can cancel a started toggle input by dragging the mouse pointer out of the element area.

**“Toggle on up if captured”**  
☑️: The value toggles regardless of where the mouse pointer is when the mouse button is released. The mouse is then captured.

**“Hotkeys”**  
Keyboard shortcut on the element for triggering specific input actions.  
When the keyboard shortcut event occurs, the input actions in the “Event(s)” property are triggered. In this way, it is not the input action itself that leads to this input action, but the mouse input action.

**“Key”**  
Key pressed for input action.  
Example: [T]  
Note: The following properties appear when a key is selected.

**“Event(s)”**  
- “None”  
- “Mouse down”: Pressing the key triggers the input actions that are configured in the “OnMouseDown” property.  
- “Mouse up”: Releasing the key triggers the input actions that are configured in the “OnMouseUp” property.  
- “Mouse down/up”: Pressing and releasing the key triggers the input actions that are configured in the “OnMouseDown” property and the “OnMouseUp” property.

**“Shift”**  
☑️: Combination with the Shift key  
Example: [Shift]+[T].

**“Control”**  
☑️: Combination with the Ctrl key  
Example: [Ctrl]+[T].

**“Alt”**  
☑️: Combination with the Alt key  
Example: [Alt]+[T].

All keyboard shortcuts and their actions that are configured in the visualization are listed in the “Keyboard configuration” tab.

See also  
- ☰️ Chapter 6.4.5.21.2.2 “Command ‘Keyboard Configuration’” on page 3341  
- ☰️ Chapter 6.4.5.21.3.6 “Dialog ‘Input Configuration’” on page 3370

**Element property 'Access rights'**  
Requirement: User management is set up for the visualization.
“Access rights”

Opens the “Access rights” dialog. There you can edit the access privileges for the element.

Status messages:
- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also

- ° Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

Visualization Element 'Invisible Input'

Symbol:

Category: “Common Controls”

This element is displayed in the editor with a dashed line which is not visible in online mode.

You define the behavior of the el in the input configuration.

Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
<tr>
<td>Example: Unsichtbare_Eingabe_1</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Type of element”</th>
<th>“Invisible Input”</th>
</tr>
</thead>
</table>

Element property 'Position'

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in pixels.</td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in pixels.</td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Width”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 150</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Height”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 30</td>
<td></td>
</tr>
</tbody>
</table>
You can also change the values by dragging the box symbols ( kvinnor) to other positions in the editor.

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

**Element property ‘Center’**

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
<td>X-coordinate of the point of rotation</td>
</tr>
<tr>
<td>“Y”</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols ( kvinnor) to other positions in the editor.

**Element property ‘Absolute movement’**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“Movement”</td>
<td></td>
</tr>
<tr>
<td>“X”</td>
<td>Variable (numeric data type). Defines the X position (in pixels). Example: PLC_PRG.iPos_X. Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td>“Y”</td>
<td>Variable (numeric data type). Defines the Y position (in pixels). Example: PLC_PRG.iPos_Y. Increasing this value in runtime mode moves the element downwards.</td>
</tr>
<tr>
<td>“Rotation”</td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees). Example: PLC_PRG.iAngle1. The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol. In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
</tr>
</tbody>
</table>
“Interior rotation”
Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the 👀 symbol.

Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

Element property ‘State variables’

“Deactivate inputs”
Variable (BOOL). Toggles the operability of the element.

TRUE: User inputs do not have any effect in runtime mode. The element is shown as deactivated.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
“Animation duration”

Defines the duration (in milliseconds) in which the element runs an animation

- **Variable (integer value)**
  
  **Example:**
  ```
  Menu.tContent with VAR tContent : INT := 500;
  END_VAR
  ```

- **Integer literal**
  
  **Example:** 500

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

“Move to foreground”

Moves the visualization element to the foreground

**Variable (BOOL)**

**Example:**
```
VAR bIsInForeground : BOOL := FALSE;
END_VAR
```

**Example:**
```
TRUE: At runtime, the visualization element is displayed in the foreground.
```
```
FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.
```

**Element property 'Input configuration'**

The properties contain the configurations for the user input when using the mouse or keyboard. A user input defines an event and one or more actions that are executed when an event occurs.

The “Configure” button opens the “Input Configuration” dialog. There you can create or edit user inputs. Configured user inputs are listed below the events. They each include the action that is triggered and the setting in short form.

**Example:**
```
“Execute ST Code”:
```
```
PLC_PRG.i_x := 0;
```

```
“OnDialogClosed”
```

Input event: The user closes the dialog.

```
“OnMouseClick”
```

Input event: The user clicks the mouse button completely in the element area. The mouse button is clicked and released.

```
“OnMouseDown”
```

Input event: The user clicks down on the mouse button.

```
“OnMouseEnter”
```

Input event: The user drags the mouse pointer to the element.

```
“OnMouseLeave”
```

Input event: The user drags the mouse pointer away from the element.
<table>
<thead>
<tr>
<th><strong>“OnMouseMove”</strong></th>
<th>Input event: The user moves the mouse pointer over the element area.</th>
</tr>
</thead>
</table>
| **“OnMouseUp”** | Input events:  
  - The user releases the mouse button within the element area. It is irrelevant whether the user has previously pressed the mouse button inside or outside the element area.  
  - The user presses the mouse button within the element area, leaves the element area, and then releases the mouse button.  
  
  Note: This CODESYS-specific triggering behavior guarantees that actions for key elements are completed. A key element starts an action for “OnMouseDown” and ends the action for “OnMouseUp”.  
  
  Example: A visualization user presses the mouse button within the element area of the key element and then moves the cursor position so that it lies outside the element area. The action is ended anyway because “OnMouseUp” is triggered. |
| **“Tap”** | When a mouse click event occurs, the variable defined in “Variable” is described in the application. The coding depends on the “Tap FALSE” and “Tap on enter if captured” options. |
| **“Variable”** | Variable (BOOL) that is set on mouse click event.  
  **Example:** FLC_PRG.bIsTapped  
  **TRUE:** A mouse click event exists. It lasts as long as the user presses the mouse button over the element. It ends when the button is released.  
  **FALSE:** A mouse click event does not exist.  
  **Requirement:** The “Tap FALSE” option is not activated. |
| **“Tap FALSE”** |  
  - **☑:** The mouse click event leads to a complementary value in “Variable”.  
    **TRUE:** A mouse click event does not exist.  
    **FALSE:** While the mouse click event exists. |
| **“Tap on enter if captured”** |  
  - **☑:** During user input, it is also taken into consideration whether the mouse pointer is dragged within the element area or not while the mouse button is pressed.  
    **TRUE:** While the mouse click event exists and the mouse pointer is moved over the element area.  
    **FALSE:** A mouse click event does not exist. Or the user moves the mouse pointer outside of the element area while the mouse button is pressed.  
    The value is **TRUE** again as soon as the user moves the pointer back to the element area. The mouse is then captured. |
| **“Toggle”** | With the onset of a mouse click event, the variable is set; when the mouse click event is completed, the variable is reset. |
| **“Variable”** | Variable (BOOL). Its value toggled when the mouse click event is ended. This is when the user releases the mouse button while the mouse pointer is over the element area.  
  If the user releases the mouse button while the mouse pointer is outside of the element area, then the mouse click event is not ended and the value is not toggled.  
  **Hint:** The user can cancel a started toggle input by dragging the mouse pointer out of the element area. |
| **“Toggle on up if captured”** |  
  - **☑:** The value toggles regardless of where the mouse pointer is when the mouse button is released. The mouse is then captured. |
| **Hotkey** | Keyboard shortcut on the element for triggering specific input actions. When the keyboard shortcut event occurs, the input actions in the “Events” property are triggered. In this way, it is not the input action itself that leads to this input action, but the mouse input action. |
| **Key** | Key pressed for input action. Example: [T] Note: The following properties appear when a key is selected. |
| **Events** | ● “None” ● “Mouse down”: Pressing the key triggers the input actions that are configured in the “OnMouseDown” property. ● “Mouse up”: Releasing the key triggers the input actions that are configured in the “OnMouseUp” property. ● “Mouse down/up”: Pressing and releasing the key triggers the input actions that are configured in the “OnMouseDown” property and the “OnMouseUp” property. |
| **Shift** | : Combination with the Shift key Example: [Shift]+[T]. |
| **Control** | : Combination with the Ctrl key Example: [Ctrl]+[T]. |
| **Alt** | : Combination with the Alt key Example: [Alt]+[T]. |

All keyboard shortcuts and their actions that are configured in the visualization are listed on the “Keyboard Configuration” tab.

See also
- Chapter 6.4.5.21.2.2 “Command ‘Keyboard Configuration’” on page 3341
- Chapter 6.4.5.21.3.6 “Dialog ‘Input Configuration’” on page 3370

**Element property ‘Access rights’**

Requirement: User management is set up for the visualization.

| **Access rights** | Opens the “Access rights” dialog. There you can edit the access privileges for the element. Status messages: ● “Not set. Full rights.”: Access rights for all user groups: “operable” ● “Rights are set: Limited rights”: Access is restricted for at least one group. |

See also
- Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

See also
- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

**Visualization Element ‘Progress Bar’**

Symbol:
Category: “Common Controls”

The element displays the value of a variable as a progress bar.

**Element properties**

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
<tr>
<td>Example: Progress_Data_Transfer</td>
<td></td>
</tr>
</tbody>
</table>

| “Type of element” | “Progress Bar” |

| “Text ID” | ID of the global text list |
| Requirement: Text is configured in the property “Texts → Text”. |

| “Variable” | Variable (numeric data type). Represents the length of the progress bar. |

| “Minimum value” | Value range of the variable |

| “Maximum value” | |

| “Style” | ● “Blocks” |
| ● “Bar” |

**Element property 'Position'**

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

| “X” | X coordinate of the upper left corner of the element |
| Specified in pixels. |
| Example: 10. |

| “Y” | Y coordinate of the upper left corner of the element |
| Specified in pixels. |
| Example: 10. |

| “Width” | Specified in pixels. |
| Example: 150 |

| “Height” | Specified in pixels. |
| Example: 30 |

You can also change the values by dragging the box symbols (Moving Box) to other positions in the editor.

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874
**Element property 'Center'**

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;X&quot;</td>
<td>X-coordinate of the point of rotation</td>
</tr>
<tr>
<td>&quot;Y&quot;</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols to other positions in the editor.

**Element property 'Texts'**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Text&quot;</td>
<td>String label for the element. Example: Zoom</td>
</tr>
</tbody>
</table>

**Element property 'Absolute movement'**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Movement&quot;</td>
<td>Variable (numeric data type). Defines the X position (in pixels). Example: PLC_PRG.iPos_X. Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td>&quot;Y&quot;</td>
<td>Variable (numeric data type). Defines the Y position (in pixels). Example: PLC_PRG.iPos_Y. Increasing this value in runtime mode moves the element downwards.</td>
</tr>
<tr>
<td>&quot;Rotation&quot;</td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees). Example: PLC_PRG.iAngle1. The midpoint of the element rotates at the &quot;Center&quot; point. This rotation point is shown as the symbol. In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
</tr>
</tbody>
</table>
**“Interior rotation”**

Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

---

You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- 

**Element property ‘State variables’**

The variables control the element behavior dynamically.

**“Invisible”**

Variable (BOOL). Toggles the visibility of the element.

TRUE: The element is not visible at runtime.

The “Invisible” property is supported by the “Client Animation” functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
**Animation duration**

Defines the duration (in milliseconds) in which the element runs an animation

- **Variable (integer value)**
  
  Example: `Menu.tContent with VAR tContent : INT := 500; END_VAR`

- **Integer literal**
  
  Example: `500`

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**Move to foreground**

Moves the visualization element to the foreground

Variable (BOOL)

Example: `bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR`

**TRUE:** At runtime, the visualization element is displayed in the foreground.

**FALSE:** At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

**Element property 'Access rights'**

Requirement: User management is set up for the visualization.

**Access rights**

Opens the “Access rights” dialog. There you can edit the access privileges for the element.

Status messages:

- **“Not set. Full rights.”:** Access rights for all user groups: “operable”
- **“Rights are set: Limited rights.”:** Access is restricted for at least one group.

See also

- § Chapter 6.4.5.21.3.1 “Dialog 'Access Rights'” on page 3366

See also

- § Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

**Visualization Element 'Check Box'**

Symbol:

Category: “Common Controls”

The element is used for setting and resetting a Boolean variable. The set state is identified by a check mark.
Element properties

<table>
<thead>
<tr>
<th>&quot;Element name&quot;</th>
<th>Example: signal_tone_for_parts_deficit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Type of element&quot;</th>
<th>&quot;Check Box&quot;</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>&quot;Text ID&quot;</th>
<th>ID for the text in the &quot;GlobalTextList&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 22</td>
<td>The text ID cannot be changed. As soon as you specify and save a text in &quot;Texts&quot; - &quot;Text&quot;, CODESYS automatically creates an entry in the &quot;GlobalTextList&quot; and displays the ID here.</td>
</tr>
</tbody>
</table>

Element property 'Position'

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>&quot;X&quot;</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Y&quot;</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Width&quot;</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 150</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Height&quot;</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 30</td>
<td></td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols to other positions in the editor.

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

Element property 'Center'

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>&quot;X&quot;</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Y&quot;</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>
You can also change the values by dragging the symbols (กาลเวลา) to other positions in the editor.

<table>
<thead>
<tr>
<th>“Variable”</th>
<th>Variable of type BOOL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: “PLC_PRG.xIsTrue”</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Frame size”</th>
<th>Distance of the element to the edge</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: “From style”</td>
<td></td>
</tr>
</tbody>
</table>

**Element property ’Texts’** The properties contains character strings for labeling the element. CODESYS accepts the specified texts automatically into the “GlobalTextList” text list. Therefore, these texts can be localized.

<table>
<thead>
<tr>
<th>“Text”</th>
<th>Character string (without single straight quotation marks) for the labeling the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: Axis 1.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Tooltip”</th>
<th>Character string (without single straight quotation marks) that is displayed as the tooltip of an element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: Parameters of Axis 1.</td>
<td></td>
</tr>
</tbody>
</table>

See also
- ☮ Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

**Element property ’Text properties’** The properties contain fixed values for the text properties.

| “Usage of” | 
|------------|------------------|
| ● “Default style values”: The values of the visualization style are used. |
| ● “Individual settings”: The ”Individual text properties” property group is shown |
| The values can be customized here. |

<table>
<thead>
<tr>
<th>“Individual text properties”</th>
<th>Requirement: The “Individual settings” text property is defined.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Horizontal alignment”</th>
<th>Horizontal alignment of the text within the element.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Vertical alignment”</th>
<th>Vertical alignment of the text within the element.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Text format”</th>
<th>Definition for displaying texts that are too long</th>
</tr>
</thead>
<tbody>
<tr>
<td>● “Default”: The long text is truncated.</td>
<td></td>
</tr>
<tr>
<td>● “Line break”: The text is split into parts.</td>
<td></td>
</tr>
<tr>
<td>● “Ellipsis”: The visible text ends with “…” indicating that it is not complete.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Font”</th>
<th>Example: “Default”</th>
</tr>
</thead>
<tbody>
<tr>
<td>☰: The “Font” dialog box opens.</td>
<td></td>
</tr>
<tr>
<td>📌: Drop-down list with style fonts.</td>
<td></td>
</tr>
</tbody>
</table>
### "Font color"

<table>
<thead>
<tr>
<th>Example: “Black”</th>
</tr>
</thead>
<tbody>
<tr>
<td>▶: The “Color” dialog box opens.</td>
</tr>
<tr>
<td>▼: Drop-down list with style colors.</td>
</tr>
</tbody>
</table>

### "Transparency"

Whole number (value range from 0 to 255). This determines the transparency of the respective color.

| Example: 255: The color is opaque. |
| 0: The color is completely transparent. |

Please note: If the color is a style color and already has a transparency value, then this property is write-protected.

---

**Element property 'Absolute movement'**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>&quot;Movement&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>&quot;X&quot;</strong> Variable (numeric data type). Defines the X position (in pixels).</td>
</tr>
<tr>
<td>Example: PLC_PRG.iPos_X.</td>
</tr>
<tr>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td><strong>&quot;Y&quot;</strong> Variable (numeric data type). Defines the Y position (in pixels).</td>
</tr>
<tr>
<td>Example: PLC_PRG.iPos_Y.</td>
</tr>
<tr>
<td>Increasing this value in runtime mode moves the element downwards.</td>
</tr>
<tr>
<td><strong>&quot;Rotation&quot;</strong> Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
</tr>
<tr>
<td>Example: PLC_PRG.iAngle1.</td>
</tr>
<tr>
<td>The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.</td>
</tr>
<tr>
<td>In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
</tr>
<tr>
<td><strong>&quot;Interior rotation&quot;</strong> Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
</tr>
<tr>
<td>Example: PLC_PRG.iAngle2.</td>
</tr>
<tr>
<td>In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.</td>
</tr>
<tr>
<td>The rotation point is shown as the symbol.</td>
</tr>
<tr>
<td>Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.</td>
</tr>
</tbody>
</table>
You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>Property</th>
<th>Variable (BOOL). Toggles the visibility of the element.</th>
<th>TRUE: The element is not visible at runtime.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Invisible”</td>
<td>Example: bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR</td>
<td></td>
</tr>
<tr>
<td>“Deactivate inputs”</td>
<td>Variable (BOOL). Toggles the operability of the element.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.</td>
<td></td>
</tr>
</tbody>
</table>

The “Invisible” property is supported by the “Client Animation” functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
<table>
<thead>
<tr>
<th>&quot;Animation duration&quot;</th>
<th>Defines the duration (in milliseconds) in which the element runs an animation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- Variable (integer value)</td>
</tr>
<tr>
<td></td>
<td>Example: <code>Menu.tContent with VAR tContent : INT := 500; END_VAR</code></td>
</tr>
<tr>
<td></td>
<td>- Integer literal</td>
</tr>
<tr>
<td></td>
<td>Example: 500</td>
</tr>
<tr>
<td>Animatable properties</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- &quot;Absolute movement&quot;, &quot;Movement&quot;, &quot;X&quot;, &quot;Y&quot;</td>
</tr>
<tr>
<td></td>
<td>- &quot;Absolute movement&quot;, &quot;Rotation&quot;</td>
</tr>
<tr>
<td></td>
<td>- &quot;Absolute movement&quot;, &quot;Interior rotation&quot;</td>
</tr>
<tr>
<td></td>
<td>- &quot;Absolute movement&quot;, &quot;Exterior rotation&quot;</td>
</tr>
<tr>
<td>The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Move to foreground&quot;</th>
<th>Moves the visualization element to the foreground</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Variable (BOOL)</td>
</tr>
<tr>
<td></td>
<td>Example: <code>bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR</code></td>
</tr>
<tr>
<td></td>
<td>TRUE: At runtime, the visualization element is displayed in the foreground.</td>
</tr>
<tr>
<td></td>
<td>FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.</td>
</tr>
</tbody>
</table>

**Element property 'Access rights'**

**Requirement:** User management is set up for the visualization.

<table>
<thead>
<tr>
<th>&quot;Access rights&quot;</th>
<th>Opens the &quot;Access rights&quot; dialog. There you can edit the access privileges for the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Status messages:</strong></td>
</tr>
<tr>
<td></td>
<td>- &quot;Not set. Full rights.&quot;: Access rights for all user groups : &quot;operable&quot;</td>
</tr>
<tr>
<td></td>
<td>- &quot;Rights are set: Limited rights&quot;: Access is restricted for at least one group.</td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.5.21.3.1 "Dialog 'Access Rights'" on page 3366

See also

- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

**Visualization Element 'Radio Buttons'**

**Symbol:**

Category: “Common Controls”

The element provides a series of radios buttons with an unlimited number of options.
### Element properties

<table>
<thead>
<tr>
<th>&quot;Element name&quot;</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
<tr>
<td>Example: Morning Shift</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Type of element&quot;</th>
<th>&quot;Radio Buttons&quot;</th>
</tr>
</thead>
</table>

### Element property 'Position'

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>&quot;X&quot;</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td>Example:</td>
<td>10</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Y&quot;</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td>Example:</td>
<td>10</td>
</tr>
</tbody>
</table>

| "Width"             | Specified in pixels.                                |
|                     | Example: 150                                        |

| "Height"            | Specified in pixels.                                |
|                     | Example: 30                                         |

You can also change the values by dragging the box symbols (_drag_) to other positions in the editor.

See also

- § Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

<table>
<thead>
<tr>
<th>&quot;Variable&quot;</th>
<th>Variable (integer data type) that gives the index of the radio button that the visualization user has activated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example:</td>
<td>PLC_PRG.iNrOfActivatedRadioButton</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Number of columns&quot;</th>
<th>Definition of the number of list boxes displayed in a row</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example:</td>
<td>2</td>
</tr>
</tbody>
</table>

| "Radio button order"| "Left to right": The radio buttons are aligned by rows until the number of columns is reached. |
|                     | "Top to bottom": The radio buttons are aligned row by columns until the number of columns is reached. |

<table>
<thead>
<tr>
<th>&quot;Frame size&quot;</th>
<th>Defines the distance from the list boxes to the edge (in pixels).</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>&quot;Row height&quot;</th>
<th>Height of the row (in pixels) Modifying the height of the row also changes the size of the list box.</th>
</tr>
</thead>
</table>
The properties contain fixed values for the text properties.

<table>
<thead>
<tr>
<th>&quot;Usage of&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>● &quot;Default style values&quot;: The values of the visualization style are used.</td>
</tr>
<tr>
<td>● &quot;Individual settings&quot;: The &quot;Individual text properties&quot; property group is shown</td>
</tr>
</tbody>
</table>

The values can be customized here.

<table>
<thead>
<tr>
<th>&quot;Individual text properties&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requirement: The &quot;Individual settings&quot; text property is defined.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Horizontal alignment&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Horizontal alignment of the text within the element.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Vertical alignment&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical alignment of the text within the element.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Text format&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Definition for displaying texts that are too long</td>
</tr>
<tr>
<td>● &quot;Default&quot;: The long text is truncated.</td>
</tr>
<tr>
<td>● &quot;Line break&quot;: The text is split into parts.</td>
</tr>
<tr>
<td>● &quot;Ellipsis&quot;: The visible text ends with &quot;...&quot; indicating that it is not complete.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Font&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: &quot;Default&quot;</td>
</tr>
<tr>
<td>➔ The &quot;Font&quot; dialog box opens.</td>
</tr>
<tr>
<td>➔ Drop-down list with style fonts.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Font color&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: &quot;Black&quot;</td>
</tr>
<tr>
<td>➔ The &quot;Color&quot; dialog box opens.</td>
</tr>
<tr>
<td>➔ Drop-down list with style colors.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Transparency&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Whole number (value range from 0 to 255). This determines the transparency of the respective color.</td>
</tr>
<tr>
<td>Example: 255: The color is opaque.</td>
</tr>
<tr>
<td>0: The color is completely transparent.</td>
</tr>
</tbody>
</table>

Please note: If the color is a style color and already has a transparency value, then this property is write-protected.

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>&quot;Movement&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
</tr>
<tr>
<td>Example: PLC_PRG.iPos_X.</td>
</tr>
<tr>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
</tbody>
</table>

| "Y" |
| Variable (numeric data type). Defines the Y position (in pixels). |
| Example: PLC_PRG.iPos_Y. |
| Increasing this value in runtime mode moves the element downwards. |
### “Rotation”

Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** PLC_PRG.iAngle1.

The midpoint of the element rotates at the “Center” point. This rotation point is shown as the + symbol.

In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

### “Interior rotation”

Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the + symbol.

Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

---

You can link the variables to a unit conversion.

---

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

---

See also

- 

### Element property 'State variables'

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>Variable (BOOL)</th>
<th>Toggles the visibility of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Invisible”</strong></td>
<td>TRUE: The element is not visible at runtime.</td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td>VAR bIsVisible : BOOL := FALSE;</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Variable (BOOL)</th>
<th>Toggles the operability of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Deactivate inputs”</strong></td>
<td>TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.</td>
</tr>
</tbody>
</table>
The “Invisible” property is supported by the “Client Animation” functionality.

<table>
<thead>
<tr>
<th>Element property 'Radio button settings'</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“Radio button”</td>
<td>“Create new”: Clicking this button creates a new selection button in the editor and lists an additional area in the properties editor. For each radio button, an area is visible that records the settings.</td>
</tr>
</tbody>
</table>
| • “Areas”                                 | • [<n>]: This number indicates the area. Clicking “Delete” will delete the associated radio button with its settings “Text”, “Tooltip”, and “Line spacing (in pixels)”.
|   – “[<n>]”                               | |
| Areas: [<n>]                              | |
| “Text”                                   | The button name is specified here. Default value: “Radio_button” |
| “Tooltip”                                 | Text is specified here that is displayed in a tooltip. |
| “Line spacing (in pixels)”               | The distance (in pixels) to the upper button can be specified here. |

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

<table>
<thead>
<tr>
<th>“Animation duration”</th>
<th>Defines the duration (in milliseconds) in which the element runs an animation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Variable (integer value)</td>
</tr>
<tr>
<td></td>
<td>Example: Menu.tContent with VAR tContent : INT := 500; END_VAR</td>
</tr>
<tr>
<td></td>
<td>• Integer literal</td>
</tr>
<tr>
<td></td>
<td>Example: 500</td>
</tr>
<tr>
<td>Animatable properties</td>
<td>• “Absolute movement”, “Movement”, “X”, “Y”</td>
</tr>
<tr>
<td></td>
<td>• “Absolute movement”, “Rotation”</td>
</tr>
<tr>
<td></td>
<td>• “Absolute movement”, “Interior rotation”</td>
</tr>
<tr>
<td></td>
<td>• “Absolute movement”, “Exterior rotation”</td>
</tr>
<tr>
<td></td>
<td>The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Move to foreground”</th>
<th>Moves the visualization element to the foreground</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable (BOOL)</td>
<td></td>
</tr>
<tr>
<td>Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR</td>
<td></td>
</tr>
<tr>
<td>TRUE: At runtime, the visualization element is displayed in the foreground.</td>
<td></td>
</tr>
<tr>
<td>FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.</td>
<td></td>
</tr>
</tbody>
</table>

Element property 'Access rights' Requirement: User management is set up for the visualization.
“Access rights”
Opens the “Access rights” dialog. There you can edit the access privileges for the element.

Status messages:
- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also
- Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

See also
- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

Visualization Element 'Alarm Table'
Symbol:

Category: “Alarm Manager”
The element displays alarms in a list. In the element properties, you specify which information is shown. You define the appearance of the element and the variables that control the element behavior.

In online mode, you can sort an alarm table by a specific column – even in the classic view. Click into the column header. A small triangle indicates the current sort order (ascending, descending). Clicking the symbol reverses the order.

Sorting inside the column depends on the type of the contained information. The "Priority" column is sorted numerically, and the "Message" and "Class" columns alphabetically. The "Value" and "Latch" columns may contain different value types. In this case, sorting is first by type (blank, Boolean, numeric value, character string) and then either numerically or alphabetically depending on the type.

If an alarm history has been created, then you can programmatically delete it at runtime. The recording starts again from the time of deletion. See the help page for “Visualizing Alarm Management”.

Element properties
<table>
<thead>
<tr>
<th><strong>Element name</strong></th>
<th>Example: GenElemInst_1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type of element</strong></td>
<td>“Alarm Table”</td>
</tr>
</tbody>
</table>
| **Data source** | Selection of the device and the application where the data to be visualized and the alarms are generated  
- Remote data source which accesses a remote device, accesses a remote application, and then transfers the data to the alarm configuration  
Example: ![DataSource_A](image)
  
Below the (now visible) “Application” property, the remote application is displayed as configured in the data source.  
Example: ![App_A](image)
  
Note: If the data source is accessed symbolically by means of a symbol file (CODESYS symbolic), then the required symbol file and the corresponding project have to be saved in the same folder.  
- Local application below which the alarm configuration is located  
Example: ![<local application>](image) |

See also
- **Object 'Data Source'**

**Element property 'Alarm configuration'**

<table>
<thead>
<tr>
<th><strong>Alarm groups</strong></th>
<th>Opens the “Select Alarm Group” dialog where you define the alarm groups that you want to display.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Priority from</strong></td>
<td>Least priority for alarm display. (0 to 255).</td>
</tr>
<tr>
<td><strong>Priority to</strong></td>
<td>Greatest priority for alarm display. (0 to 255).</td>
</tr>
<tr>
<td><strong>Alarm classes</strong></td>
<td>Opens the “Select Class Group” dialog where you define the alarm classes that you want to display.</td>
</tr>
</tbody>
</table>
| **Filter criterion** | For the “Alarm Banner” element only  
- “Most important”: The alarm with the highest priority (lowest value) is displayed.  
- “Newest”: The most recent alarm is displayed. |
**Filter by latch 1**

The generated alarms (previous and current) can be filtered by the contents of "Latch variable 1", which is specified in the configuration of the alarm group. In "Filter type", you define whether or not the filtering is performed by a string value or a numerical value.

- **Filter variable**: Indicates what the alarms are filtered by. Possible entries: Application variable of data type STRING or WSTRING, or a literal value directly. Examples: PLC_PRG.strFilterVariable, 'STRING'.
- **Filter type**: Integer value that determines by which criteria the latch variable value is used for filtering. Possible entries: Numerical variable from the application (example: PLC_PRG.diFilterType, or a value directly (example: 2).

Possible values:
- 0: No filtering
- 1: Filter by alarms whose latch variable 1 contains the string specified in "Filter variable". Example: The filter variable contains 'Error 1' which is the latch variable 1 of different alarms of type STRING and has the value 'Error 1' ->. Only these alarms are displayed.
- 2: Filter by alarms whose latch variable 1 contains the typed literal specified in "Filter variable" according to IEC 61131-3. Examples: T#1h2s, DINT#15, REAL#1.5, FALSE
- 3: Filter by alarms whose latch variable 1 contains the LINT literal value specified in "Filter variable". Therefore, the value of the latch variables has to be in the range of 9,223,372,036,854,775,808 to 9,223,372,036,854,775,807.
- All other values: The behavior is not defined and can change in the future.

**Filter by time range**

The generated alarms (remote, historical, local) can be displayed for a specified time range. You use the "Filter type" to define whether filtering by time range is enabled or disabled.

- **Filter variable, from**: Variable of data type DT or DATE_AND_TIME (example: PLC_PRG.filterTimeFrom) for the start time that the alarms are displayed.
- **Filter variable, to**: Variable of data type DT or DATE_AND_TIME (example: PLC_PRG.filterTimeTo) for the end time that the alarms are displayed.
- **Filter type**: Variable of integer data type that determines whether "Filter by time range" is enabled or disabled.

Possible values:
- 1: Filtering is enabled
- 0: Filtering is disabled

See also
- % Chapter 6.4.5.21.3.17 “Dialog ‘Selected Alarm Group’” on page 3390
- % Chapter 6.4.5.21.3.16 “Dialog ‘Selected Alarm Class’” on page 3389

**Element property 'General table configuration'**

- **Show row header**: Display of the row number at the beginning of the row.
- **Show column header**: Display of the column heading as defined in “Column heading”.
- **Row height**: Height of the table rows (in pixels).
- **Row header width**: Width of the line header (in pixels).
### "Scrollbar size"

Width of the scrollbar when it runs vertically. Width of the scrollbar when it runs horizontally. Specified in pixels.

### "Automatic line break for alarm message"

- ✓: The message text is truncated at the end of the line.
- ☐: The message text is truncated at the end of the column, if the text is too long.

---

**Element property 'Columns: Column [<>]':**

By default, columns [0] and [1] are configured: “Time stamp” and “Message text”. You can create more columns by clicking the “Create new”, and remove columns by clicking “Delete”. Animations (dynamic text, font variables), text, and tooltip are not supported.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Column header&quot;</td>
<td>The standard header is set and changed here by specifying a new text.</td>
</tr>
</tbody>
</table>
| "Use text alignment in title" | ✓: The text in the column header is aligned according to the current definition in "Text alignment".  
  ☐: The text in the column header is centered.                               |
| "Width"             | Width of the column (in pixels).                                            |
| "Data type"         | Notice about time stamps: For use in a TargetVisu or WebVisu, you can control the date and time format with the help of the global string variables from the library Alarmmanager.library: AlarmGlobals.g_sDateFormat (example: AlarmGlobals.g_sDateFormat := 'MM.yyyy') and AlarmGlobals.g_sTimeFormat (example: AlarmGlobals.g_sTimeFormat := 'HH:mm'). Define the information to be displayed in the column. |
| - "Symbol"          | Date and time of the last status change of the alarm.                      |
| - "Time stamp"      | Date and time of the last activation of the alarm.                         |
| - "Time stamp active"| Date and time of the last deactivation of the alarm.                       |
| - "Time stamp inactive" | Date and time of the last deactivation of the alarm.                      |
| - "Time stamp acknowledge" | Date and time of the last acknowledgment.                                |
| - "Value"           | Current value of the printout                                             |
| - "Message text"    | Output of the message text                                                |
| - "Priority"        | Alarm priority                                                             |
| - "Class"           | Alarm class                                                                |
| - "State"           | Alarm state                                                                |
| - "Latch Variable <n>" | Value of the selected latch variables                                     |
| "Text alignment"    | Alignment of the text in this column                                       |
| - "Left"            |                                                                             |
| - "Centered"        |                                                                             |
| - "Right"           |                                                                             |
| "Color settings"    |                                                                             |
| - "Activate color settings": Boolean variable for activating and deactivating the color settings defined here. Example: PLC_PRG.bColorSettings  |
| - "Cell fill color": Variable for the cell fill color, example: dwCellColor (hexadecimal color definition: 16#TTRRGGBB) |
| - "Use color also for column header": ✓: The color defined via "Color variable" is used in the column header as well. |
| - "Text color":     |                                                                             |
| - "Color variable": Variable for the definition of the text color in the column, example: dwTextColor (hexadecimal color definition: 16#TTRRGGBB) |
| - "Use color also for column header": ☐: The color defined via "Color variable" is used in the column header as well. |

---

See also

- ☰ Chapter 6.4.5.10.4 “Animating a color display” on page 2914
Element property 'Position' The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>X coordinate of the upper left corner of the element Specified in pixels. Example: 10.</td>
</tr>
<tr>
<td>Y</td>
<td>Y coordinate of the upper left corner of the element Specified in pixels. Example: 10.</td>
</tr>
<tr>
<td>Width</td>
<td>Specified in pixels. Example: 150</td>
</tr>
<tr>
<td>Height</td>
<td>Specified in pixels. Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (/*) to other positions in the editor.

See also
- Chapter 6.4.5.3 "Positioning the Element, Adapting Size and Layer" on page 2874

Element property 'Center' The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>X-coordinate of the point of rotation</td>
</tr>
<tr>
<td>Y</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (/*) to other positions in the editor.

Element property 'Text properties' The properties contain fixed values for the text properties.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Font”</strong></td>
<td>Example: “Default”</td>
</tr>
<tr>
<td></td>
<td>The “Font” dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>▼: Drop-down list with style fonts.</td>
</tr>
<tr>
<td><strong>“Font color”</strong></td>
<td>Example: “Black”</td>
</tr>
<tr>
<td></td>
<td>The “Color” dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>▼: Drop-down list with style colors.</td>
</tr>
<tr>
<td><strong>“Transparency”</strong></td>
<td>Whole number (value range from 0 to 255). This determines the transparency of the respective color.</td>
</tr>
<tr>
<td></td>
<td>Example: 255: The color is opaque.</td>
</tr>
<tr>
<td></td>
<td>0: The color is completely transparent.</td>
</tr>
<tr>
<td></td>
<td>Please note: If the color is a style color and already has a transparency value, then this property is write-protected.</td>
</tr>
</tbody>
</table>

**Element property 'Selection'**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Selection color”</strong></td>
<td>Fill color of the selected row</td>
</tr>
<tr>
<td><strong>“Selection font color”</strong></td>
<td>Font color of the selected row</td>
</tr>
<tr>
<td><strong>“Frame around selected cells”</strong></td>
<td>☑: A frame is drawn around the selected cells at runtime.</td>
</tr>
<tr>
<td><strong>“Variable for selected alarm group”</strong></td>
<td>Name of the affected alarm group; type: STRING, WSTRING</td>
</tr>
<tr>
<td><strong>“Variable for selected alarm ID”</strong></td>
<td>Alarm ID of the affected alarm group; type: STRING, WSTRING</td>
</tr>
<tr>
<td><strong>“Variable for selected line”</strong></td>
<td>Index of the selected alarm line (0-based). The index can be read and written; integer data type</td>
</tr>
<tr>
<td><strong>“Variable for valid selection”</strong></td>
<td>TRUE: An alarm line is selected.</td>
</tr>
<tr>
<td></td>
<td>FALSE: The selection is invalid. For example, for an empty alarm table or when an alarm is not selected yet.</td>
</tr>
<tr>
<td><strong>“Variable for selected alarm information”</strong></td>
<td>Information about the selected alarm. Type AlarmSelectionInfo</td>
</tr>
<tr>
<td></td>
<td>For easy usage, the function block AlarmSelectionInfoDefault is provided. This FB fills the structure with the memory for 10 messages and 10 latch variables.</td>
</tr>
<tr>
<td></td>
<td>Example: myAlarmSelectionInfoDefault.AlarmSelectionInfo</td>
</tr>
<tr>
<td></td>
<td>The following information is available:</td>
</tr>
<tr>
<td></td>
<td>• sAlarmgroup</td>
</tr>
<tr>
<td></td>
<td>• uialarmID</td>
</tr>
<tr>
<td></td>
<td>• timeStampActive</td>
</tr>
<tr>
<td></td>
<td>• timeStampInactive</td>
</tr>
<tr>
<td></td>
<td>• timeStampAcknowledge</td>
</tr>
<tr>
<td></td>
<td>• timeStampLast</td>
</tr>
<tr>
<td></td>
<td>• paLatchVariables</td>
</tr>
<tr>
<td></td>
<td>• iLatchVariablesCount</td>
</tr>
<tr>
<td></td>
<td>• papwsAlarmMessages</td>
</tr>
<tr>
<td></td>
<td>• dwAlarmMessageTextBufferSize</td>
</tr>
<tr>
<td></td>
<td>• iAlarmMessagesCount</td>
</tr>
<tr>
<td></td>
<td>• iSelectionChangedCounter</td>
</tr>
</tbody>
</table>
### Element property 'Control variables'

Boolean variables are defined here for executing specific actions in the table can be executed at runtime.

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Data Type</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Acknowledge selected”</td>
<td>BOOL</td>
<td>PLC_PRG.bAckSelectedAlarms</td>
<td>If the assigned variable is TRUE, then the selected alarm is acknowledged.</td>
</tr>
<tr>
<td>“Acknowledge all visible”</td>
<td>BOOL</td>
<td>PLC_PRG.bAckVisibleAlarms</td>
<td>If the assigned variable is TRUE, then all alarms are acknowledged that are visible in the alarm table.</td>
</tr>
<tr>
<td>“History”</td>
<td>BOOL</td>
<td>PLC_PRG.bShowHistory</td>
<td>If the assigned variable is TRUE, then the history alarms are displayed in addition to the active alarms. In the classic view, the same sort options apply as in normal mode. Note: Acknowledgment is not possible in this view.</td>
</tr>
<tr>
<td>“Freeze scroll position”</td>
<td>BOOL</td>
<td>PLC_PRG.bFreezeScrollPosition</td>
<td>If the assigned variable is TRUE, then the scroll position set in the “History” view is retained, even if a new alarm is active. If not, then the scroll position jumps to the first table row (the newest alarm).</td>
</tr>
<tr>
<td>“Count alarms”</td>
<td>integer</td>
<td>PLC_PRG.iNumberOfAlarms</td>
<td>Number of alarms that are currently displayed in the alarm table. Defined by the alarm table.</td>
</tr>
<tr>
<td>“Count visible rows”</td>
<td>integer</td>
<td>PLC_PRG.iNumberVisibleLines</td>
<td>Number of alarms that can be displayed on one page of the alarm table. Defined by the alarm table.</td>
</tr>
<tr>
<td>“Current scroll index”</td>
<td>integer</td>
<td>PLC_PRG.iScrollIndex</td>
<td>The index of the first visible row if the alarm table (0-based). The variable can be read and written.</td>
</tr>
<tr>
<td>“Current column sorting”</td>
<td>integer</td>
<td>PLC_PRG.iColSort</td>
<td>The variable contains a value of the enumeration &quot;VisuElemsAlarm.VisuEnumAlarmDataType&quot;. This value determines the column that sorts the alarm table.</td>
</tr>
<tr>
<td>“Variable for sorting direction”</td>
<td>BOOL</td>
<td>PLC_PRG.xSortAscending</td>
<td>The variable determines the sort order for the entries in the alarm table (TRUE: ascending; FALSE: descending).</td>
</tr>
</tbody>
</table>

You can also use the “Insert Elements for Acknowledging Alarms” command to define buttons with predefined control variables.
The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

## "Movement"

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>X position (in pixels)</td>
<td>PLC_PRG.iPos_X. Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td>Y</td>
<td>Y position (in pixels)</td>
<td>PLC_PRG.iPos_Y. Increasing this value in runtime mode moves the element downwards.</td>
</tr>
</tbody>
</table>

## "Rotation"

Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle1.

The midpoint of the element rotates at the “Center” point. In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

## "Interior rotation"

Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in "Center" according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise. The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the "Position ➔ Angle" property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

You can link the variables to a unit conversion.
The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- Element property ‘State variables’

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>“Invisible”</th>
<th>Variable (BOOL). Toggles the visibility of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>TRUE: The element is not visible at runtime.</td>
</tr>
</tbody>
</table>

The “Invisible” property is supported by the “Client Animation” functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

<table>
<thead>
<tr>
<th>“Animation duration”</th>
<th>Defines the duration (in milliseconds) in which the element runs an animation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- Variable (integer value)</td>
</tr>
<tr>
<td></td>
<td>Example: Menu.tContent with VAR tContent : INT := 500; END_VAR</td>
</tr>
<tr>
<td></td>
<td>- Integer literal</td>
</tr>
<tr>
<td></td>
<td>Example: 500</td>
</tr>
</tbody>
</table>

- Animatable properties

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

<table>
<thead>
<tr>
<th>“Move to foreground”</th>
<th>Moves the visualization element to the foreground</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Variable (BOOL)</td>
</tr>
<tr>
<td></td>
<td>Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR</td>
</tr>
<tr>
<td></td>
<td>TRUE: At runtime, the visualization element is displayed in the foreground.</td>
</tr>
<tr>
<td></td>
<td>FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.</td>
</tr>
</tbody>
</table>

Element property ‘Access rights’

Requirement: User management is set up for the visualization.
**“Access rights”**

Opens the “Access rights” dialog. There you can edit the access privileges for the element.

Status messages:
- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also
- ∙ Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

**Visualization Element ‘Alarm Banner’**

Symbol:

Category: “Alarm Manager”

The element is a simplified version of the alarm table. It visualizes a single alarm only. In the element properties, you specify which information is shown. You define the appearance of the element and the variables that control the element behavior.

> The alarm banner displays active alarms only. If the alarm is acknowledged, then it disappears from the alarm banner.

**Element properties**

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: GenElemInst_1</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Type of element”</td>
<td>“Alarm Banner”</td>
</tr>
<tr>
<td>“Data source”</td>
<td>If you intend to use a remote alarm configuration, then you have to specify the name of the remote application here. If you do not specify anything, the alarm configuration will be located locally.</td>
</tr>
</tbody>
</table>

**Element property 'Alarm configuration'**

| “Alarm groups” | Opens the “Select Alarm Group” dialog where you define the alarm groups that you want to display. |
| “Priority from” | Least priority for alarm display. (0 to 255). |
| “Priority to” | Greatest priority for alarm display. (0 to 255). |
| “Alarm classes” | Opens the “Select Class Group” dialog where you define the alarm classes that you want to display. |
| “Filter criterion” | For the “Alarm Banner” element only |
| | ● “Most important”: The alarm with the highest priority (lowest value) is displayed. |
| | ● “Newest”: The most recent alarm is displayed. |
### "Filter by latch 1"

The generated alarms (previous and current) can be filtered by the contents of "Latch variable 1", which is specified in the configuration of the alarm group. In "Filter type", you define whether or not the filtering is performed by a string value or a numerical value.

- **"Filter variable"**: Indicates what the alarms are filtered by. Possible entries:
  - Application variable of data type STRING or WSTRING, or a literal value directly. Examples: PLC_PRG.strFilterVariable, 'STRING'.
  - Integer value that determines by which criteria the latch variable value is used for filtering. Possible entries: Numerical variable from the application (example: PLC_PRG.diFilterType), or a value directly (example: 2).

  Possible values:
  - 0: No filtering
  - 1: Filter by alarms whose latch variable 1 contains the string specified in "Filter variable". Example: The filter variable contains 'Error 1' which is the latch variable 1 of different alarms of type STRING and has the value 'Error 1' ->. Only these alarms are displayed.
  - 2: Filter by alarms whose latch variable 1 contains the typed literal specified in "Filter variable" according to IEC 61131-3. Examples: T#1h2s, DINT#15, REAL#1.5, FALSE
  - 3: Filter by alarms whose latch variable 1 contains the LINT literal value specified in "Filter variable". Therefore, the value of the latch variables has to be in the range of 9,223,372,036,854,775,808 to 9,223,372,036,854,775,807.
  - All other values: The behavior is not defined and can change in the future.

### "Filter by time range"

The generated alarms (remote, historical, local) can be displayed for a specified time range. You use the "Filter type" to define whether filtering by time range is enabled or disabled.

- **"Filter variable, from"**: Variable of data type DT or DATE_AND_TIME (example: PLC_PRG.filterTimeFrom) for the start time that the alarms are displayed.
- **"Filter variable, to"**: Variable of data type DT or DATE_AND_TIME (example: PLC_PRG.filterTimeTo) for the end time that the alarms are displayed.
- **"Filter type"**: Variable of integer data type that determines whether "Filter by time range" is enabled or disabled.

Possible values:
- 1: Filtering is enabled
- 0: Filtering is disabled

See also
- § Chapter 6.4.5.21.3.17 "Dialog 'Selected Alarm Group'" on page 3390
- § Chapter 6.4.5.21.3.16 "Dialog 'Selected Alarm Class'" on page 3389

### Element property 'Columns: Column [<n>]'

By default, columns [0] and [1] are preconfigured: "Time stamp" and "Message text". You create more columns by clicking "Create new". You remove columns by clicking "Delete".

Animations (dynamic text, font variables), texts, and tooltips are not supported.
**“Width”** | Width of the column (in pixels)  
---|---  
**“Type of data”** | About time stamps: When used in a TargetVisu or WebVisu, you can control the date and time format by means of the global string variables from the library `Alarmmanager.library`: `AlarmGlobals.g_sDateFormat := 'MM.yyyy')` and `AlarmGlobals.g_sTimeFormat` (example: `AlarmGlobals.g_sTimeFormat := 'HH:mm'`).  
Here you define the information to be displayed in the column.  
- “Bitmap”  
- “Time stamp”: Date and time of the last status change of the alarm  
- “Time stamp active”: Date and time of the last activation of the alarm  
- “Time stamp inactive”: Date and time of the last deactivation of the alarm  
- “Time stamp acknowledge”: Date and time of the last acknowledgement  
- “Value”: Actual value of the expression  
- “Message”: Output of the message text  
- “Priority”: Alarm priority  
- “Class”: Alarm class  
- “State”: Alarm state  
- “Latch Variable <n>”: Value of the selected latch variables  

**“Text alignment”** | Alignment of the contents in the column  
---|---  
- “Left”  
- “Centered”  
- “Right”  

**Element property 'Position’**  
The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

| “X” | X coordinate of the upper left corner of the element  
|---|---  
| Specified in pixels.  
| Example: 10.  
| “Y” | Y coordinate of the upper left corner of the element  
|---|---  
| Specified in pixels.  
| Example: 10.  
| “Width” | Specified in pixels.  
|---|---  
| Example: 150  
| “Height” | Specified in pixels.  
|---|---  
| Example: 30

You can also change the values by dragging the box symbols (🖼) to other positions in the editor.

See also  
- § Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874
The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols to other positions in the editor.

The properties contain fixed values for the text properties.

<table>
<thead>
<tr>
<th>“Font”</th>
<th>Example: “Default”</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The “Font” dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>: Drop-down list with style fonts.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Font color”</th>
<th>Example: “Black”</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The “Color” dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>: Drop-down list with style colors.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Transparency”</th>
<th>Whole number (value range from 0 to 255). This determines the transparency of the respective color.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 255: The color is opaque.</td>
</tr>
<tr>
<td></td>
<td>0: The color is completely transparent.</td>
</tr>
<tr>
<td></td>
<td>Please note: If the color is a style color and already has a transparency value, then this property is write-protected.</td>
</tr>
</tbody>
</table>

A rising edge of this variable acknowledges the alarm.

<table>
<thead>
<tr>
<th>“Automatic switch”</th>
<th>The display in the alarm banner is switched automatically according to the time to the next alarm as configured in “Every N second”.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>: The “Automatic switch” is selected.</td>
</tr>
<tr>
<td>“Every N second”</td>
<td>Time period until the next switching. Available only if “Automatic switch” is selected.</td>
</tr>
<tr>
<td>“Next alarm”</td>
<td>Variable for switching to the next alarm. Available only if “Automatic switch” is not selected.</td>
</tr>
<tr>
<td>“Previous alarm”</td>
<td>Variable for switching to the previous alarm. Available only if “Automatic switch” is not selected.</td>
</tr>
<tr>
<td>“Multiple alarms active”</td>
<td>Variable that has the value true if multiple alarms are active.</td>
</tr>
</tbody>
</table>

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.
### "Movement"

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>X</strong></td>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
<td>PLC_PRG.iPos_X.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
<td></td>
</tr>
<tr>
<td><strong>Y</strong></td>
<td>Variable (numeric data type). Defines the Y position (in pixels).</td>
<td>PLC_PRG.iPos_Y.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
<td></td>
</tr>
<tr>
<td><strong>Rotation</strong></td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
<td>PLC_PRG.iAngle1.</td>
</tr>
<tr>
<td></td>
<td>The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.</td>
<td><img src="image" alt="Image of rotation point" /></td>
</tr>
<tr>
<td></td>
<td>In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
<td></td>
</tr>
<tr>
<td><strong>Interior rotation</strong></td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
<td>PLC_PRG.iAngle2.</td>
</tr>
<tr>
<td></td>
<td>In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.</td>
<td><img src="image" alt="Image of interior rotation" /></td>
</tr>
<tr>
<td></td>
<td>The rotation point is shown as the symbol.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.</td>
<td></td>
</tr>
</tbody>
</table>

You can link the variables to a unit conversion.

The "X", "Y", "Rotation", and "Interior rotation" properties are supported by the "Client Animation" functionality.

See also

- The variables control the element behavior dynamically.
**“Invisible”**

Variable (BOOL). Toggles the visibility of the element.

**TRUE:** The element is not visible at runtime.

The “Invisible” property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

---

**“Animation duration”**

Defines the duration (in milliseconds) in which the element runs an animation

- **Variable (integer value)**
  
  Example: Menu.tContent with VAR tContent : INT := 500; END_VAR

- **Integer literal**
  
  Example: 500

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**“Move to foreground”**

Moves the visualization element to the foreground

**Variable (BOOL)**

Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR

**TRUE:** At runtime, the visualization element is displayed in the foreground.

**FALSE:** At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

---

**Element property ‘Access rights’**

Requirement: User management is set up for the visualization.

**“Access rights”**

Opens the “Access rights” dialog. There you can edit the access privileges for the element.

Status messages:

- “Not set. Full rights.”: Access rights for all user groups : “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also

- ☞ Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366
Visualization Element ‘Bar Display’

Symbol:

Category: “Measurement Controls”
The element displays the value of a variable.

See also

● Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: GenElemInst_2</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Type of element”</td>
<td>“Bar Display”</td>
</tr>
<tr>
<td>“Value”</td>
<td>Variable (numeric data type)</td>
</tr>
<tr>
<td></td>
<td>The value of the variable is displayed as a bar length.</td>
</tr>
</tbody>
</table>

Element property ‘Center’

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

| “X” | X-coordinate of the point of rotation |
| “Y” | Y-coordinate of the point of rotation |

You can also change the values by dragging the symbols (_symbol) to other positions in the editor.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
**“Animation duration”**

Defines the duration (in milliseconds) in which the element runs an animation

- **Variable (integer value)**
  
  **Example:**
  ```
  Menu.tContent with VAR tContent : INT := 500; END_VAR
  ```

- **Integer literal**
  
  **Example:** 500

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**“Move to foreground”**

Moves the visualization element to the foreground

Variable (BOOL)

**Example:**
```
VAR bIsInForeground : BOOL := FALSE; END_VAR
```

**TRUE:** At runtime, the visualization element is displayed in the foreground.

**FALSE:** At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

**Element property ‘Position’**

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>X</strong></td>
<td>X coordinate of the upper left corner of the element. Specified in pixels. <strong>Example:</strong> 10.</td>
</tr>
<tr>
<td><strong>Y</strong></td>
<td>Y coordinate of the upper left corner of the element. Specified in pixels. <strong>Example:</strong> 10.</td>
</tr>
<tr>
<td><strong>Width</strong></td>
<td>Specified in pixels. <strong>Example:</strong> 150</td>
</tr>
<tr>
<td><strong>Height</strong></td>
<td>Specified in pixels. <strong>Example:</strong> 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols ((locations) to other positions in the editor.

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874
Element property 'Background'

“Background color” Drop-down list with background colors
Note: This property depends on the style. For example, there are no heterochromatic background images for “FlatStyle” and “WhiteStyle”.

“Own image”
- “image”: Image ID of the background image. You select the background image from an image pool by clicking the symbol.
  Info: If you specify the “<default>” value or select the image from the “Default” category in the input assistant, then the original element background image is used.
- “Transparent color”: Color of pixels that are displayed as transparent.
  Selection from drop-down list or input assistant.

“Optimized drawing”
- The background image is drawn one time. If there is a change in the foreground, then only the affected part of the image is redrawn.
- The background image is redrawn in cycles.
  Note: Deactivating this option is sensible only in certain exceptional cases.

Element property 'Bar'

“Diagram type” Position of the scale
- “Scale besides bar”
- “Scale in bar”
- “Bar in scale”
- “No scale”

“Orientation” Orientation depending on the ratio of width to height of the Bar Display:
- “Horizontal”
- “Vertical”

“Running direction” Direction the values are increased.
Drop-down list for “Orientation Horizontal”:
- “Left to right”
- “Right to left”
Drop-down list for “Orientation Vertical”:
- “Bottom to top”
- “Top to bottom”

“Optimum size for bar” The bar width requires the majority of the element surface.
Note: This property depends on the style. It is not provided for “FlatStyle” or “WhiteStyle”.

Element property 'Scale'
| **Scale start** | Least value of the scale and the lower limit of the value range for the element.  
Example: 0  
📍: The property “Variable” is shown below. |
| **Variable** | Variable (integer data type). Contains the scale start.  
Example: PLC_PRG.iScaleStart  
Declaration: |
| **Scale end** | Greatest value of the scale and the upper limit of the value range for the element.  
Example: 100  
📍: The property “Variable” is shown below. |
| **Variable** | Variable (integer data type). Contains the scale end.  
Example: PLC_PRG.iScaleEnd  
Declaration: |
| **Main scale** | Distance between 2 values on the rough scale.  
Example: 10  
📍: The property “Variable” is shown below. |
| **Variable** | Variable (integer data type). Contains the distance.  
Example: PLC_PRG.iMainScale  
Declaration: |
| **Subscale** | Distance between 2 values on the fine scale.  
You can hide the fine scale by setting the value to 0.  
Example: 2  
📍: The property “Variable” is shown below. |
| **Variable** | Variable (integer data type). Contains the spacing.  
Example: PLC_PRG.iSubScale  
Declaration: |
“Scale line width” Specified in pixels.
Example: 3

“Scale color” Color of scale lines
- ▼: The “Color” dialog box opens.
- ▼: A drop-down list with color names opens.

“Scale in 3D” ✔: Tick marks are displayed with slight 3D shadowing.
Note: This property depends on the style. Not available for “FlatStyle”.

“Element frame” ✔: A frame is drawn around the element.

Element property 'Label'

“Unit” Text that is displayed in the element.
Example: Units displayed in m/s.

“Font” Font for labels (example: scale numbering).
Selection from the drop-down list or by clicking the ▼ button.

“Scale format (C Syntax)” Values scaled in "printf" syntax
Examples: %d, %.2f

“Max. text width of labels” (optional) Value that redefines the maximum width of the scale label. The correct value is normally set automatically.
Note: Change this value only if the automatic adjustment does not yield the expected result.

“Text height of labels” (optional) Value that redefines the maximum height of the scale label. The correct value is normally set automatically.
Note: Change this value only if the automatic adjustment does not yield the expected result.

“Font color” Selection from the drop-down list or by clicking the ▼ button.

Element property 'Positioning'

“Horizontal offset” Distance from the scale (bar) to the horizontal element frame
Specified in pixels.
Used for achieving the exact position relative to the background image.

“Vertical offset” Distance from the scale (bar) to the vertical element frame
Specified in pixels.
Used for achieving the exact position relative to the background image.

“Horizontal scaling” Horizontal division of the scale
Specified in pixels.
Used for achieving the exact positioning relative to the background image.

“Vertical scaling” Vertical division of the scale
Specified in pixels.
Used for achieving the exact positioning relative to the background image.
Element property 'Colors'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Graph color&quot;</td>
<td>Color of the bar</td>
</tr>
<tr>
<td>&quot;Bar background&quot;</td>
<td>☑: The background of the bar is black. ☐: The background of the bar is white.</td>
</tr>
<tr>
<td>&quot;Frame color&quot;</td>
<td>Color that the frames are drawn.</td>
</tr>
<tr>
<td>&quot;Switch whole color&quot;</td>
<td>☑: The total color of the bar is switched to the color of the color area of the current value.</td>
</tr>
<tr>
<td>&quot;Use gradient color for bar&quot;</td>
<td>☑: Bar is displayed with a gradient.</td>
</tr>
<tr>
<td>&quot;Color range markers&quot;</td>
<td>The color areas can be separated from each other inside the bar with a vertical mark.</td>
</tr>
<tr>
<td>● &quot;No markers&quot;: No display.</td>
<td>● &quot;Marker forwards&quot;: The color of the vertical mark corresponds to the color of the previous color area.</td>
</tr>
<tr>
<td>● &quot;Marker backwards&quot;: The color of the vertical mark corresponds to the color of the next color area.</td>
<td></td>
</tr>
<tr>
<td>&quot;Color areas&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Create new&quot;</td>
<td>A new color area is added.</td>
</tr>
<tr>
<td>&quot;Delete&quot;</td>
<td>The color area is removed from the list.</td>
</tr>
<tr>
<td>&quot;Begin of area&quot;</td>
<td>Start value of the color area</td>
</tr>
<tr>
<td>&quot;End of area&quot;</td>
<td>End value of the color area</td>
</tr>
<tr>
<td>&quot;Color&quot;</td>
<td>Color that is used for displaying the area.</td>
</tr>
</tbody>
</table>

Element property 'Absolute movement'

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

"Movement"

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;X&quot;</td>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iPos_X.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td>&quot;Y&quot;</td>
<td>Variable (numeric data type). Defines the Y position (in pixels).</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iPos_Y.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
</tr>
<tr>
<td>&quot;Rotation&quot;</td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iAngle1.</td>
</tr>
<tr>
<td></td>
<td>The midpoint of the element rotates at the &quot;Center&quot; point. This rotation point is shown as the symbol.</td>
</tr>
<tr>
<td></td>
<td>In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
</tr>
</tbody>
</table>
"Interior rotation" Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in "Center" according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the "Position & Angle" property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

You can link the variables to a unit conversion.

The "X", "Y", "Rotation", and "Interior rotation" properties are supported by the "Client Animation" functionality.

See also

Element property 'State variables'

"Deactivate inputs" Variable (BOOL). Toggles the operability of the element.

TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.

Requirement: User management is set up for the visualization.

Element property 'Access rights'

"Access rights" Opens the "Access rights" dialog. There you can edit the access privileges for the element.

Status messages:
- "Not set. Full rights.": Access rights for all user groups: "operable"
- "Rights are set: Limited rights": Access is restricted for at least one group.

See also

- Chapter 6.4.5.21.3.1 "Dialog 'Access Rights'" on page 3366

Visualization Element 'Meter 90°'

Symbol:
**Category:** “Measurement Controls”

The element displays the value of a variable. The needle is positioned according to the value of the assigned variable. A meter is used to represent a tachometer, for example.

### Element properties

<table>
<thead>
<tr>
<th><strong>“Element name”</strong></th>
<th>Example: GenElemInst_1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Type of element”</strong></td>
<td>“Meter 90°”</td>
</tr>
<tr>
<td><strong>“Value”</strong></td>
<td>Variable (numeric data type)</td>
</tr>
</tbody>
</table>

The variable value determines the pointer direction of the element.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

<table>
<thead>
<tr>
<th><strong>“Animation duration”</strong></th>
<th>Defines the duration (in milliseconds) in which the element runs an animation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Variable (integer value)</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong> Menu.tContent with VAR tContent : INT := 500; END_VAR</td>
</tr>
<tr>
<td></td>
<td>• Integer literal</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong> 500</td>
</tr>
</tbody>
</table>

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

<table>
<thead>
<tr>
<th><strong>“Move to foreground”</strong></th>
<th>Moves the visualization element to the foreground</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Variable (BOOL)</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong> bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR</td>
</tr>
<tr>
<td></td>
<td><strong>TRUE:</strong> At runtime, the visualization element is displayed in the foreground.</td>
</tr>
<tr>
<td></td>
<td><strong>FALSE:</strong> At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.</td>
</tr>
</tbody>
</table>

### Element property 'Position'

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.
### Element property 'Background'

<table>
<thead>
<tr>
<th><strong>“Image color”</strong></th>
<th>List box containing background colors</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Own image”</strong></td>
<td></td>
</tr>
<tr>
<td>- “Image”: ID of the background image. You select the background image from an image pool by clicking <img src="image" alt="image pool" />. Info: If you specify the value &quot;&lt;default&gt;&quot; or select the image from the “Default” category in the Input Assistant, then the original element background image is used.</td>
<td></td>
</tr>
<tr>
<td>- “Transparency color”: Selection from list box or Input Assistant.</td>
<td></td>
</tr>
</tbody>
</table>

### Element property 'Arrow'

<table>
<thead>
<tr>
<th><strong>“Hand style”</strong></th>
<th>Drop-down list with different arrow types</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Color”</strong></td>
<td><img src="color" alt="color" /> The “Color” dialog box opens.</td>
</tr>
<tr>
<td>![drop-down list](drop-down list) Drop-down list with color names</td>
<td></td>
</tr>
<tr>
<td><strong>“Angle range”</strong></td>
<td>Drop-down list for the alignment of the element</td>
</tr>
<tr>
<td><strong>“Additional arrow”</strong></td>
<td><img src="on" alt="on" /> An additional arrow is shown inside the scale.</td>
</tr>
</tbody>
</table>

---

You can also change the values by dragging the box symbols (👉) to other positions in the editor.

See also

- ☐ Chapter 6.4.5.3.3 “Positioning the Element, Adapting Size and Layer” on page 2874
### “Sub scale position”
- **“Outside”**: The subscale is displayed on the outer scale ring. ("Frame outside")
- **“Inside”**: The subscale is displayed on the inner scale ring. ("Frame inside")

### “Scale type”
Type of scale
- **“Lines”**
- **“Dots”**
- **“Squares”**

### “Scale start”
Least value of the scale and the lower limit of the value range for the element
Example: 0
*: The “Variable” property is displayed in the line below this.

### “Variable”
Variable (integer data type). Contains the scale start
Example: PLC_PRG.iScaleStart
Declarations:

```plaintext
PROGRAM PLC_PRG
VAR
  iScaleStart : INT := 0;
END_VAR
```

### “Scale end”
Greatest value of the scale and the upper limit of the value range for the element
Example: 100
*: The “Variable” property is shown below this.

### “Variable”
Variable (integer data type). Contains the scale end
Example: PLC_PRG.iScaleEnd
Declarations:

```plaintext
PROGRAM PLC_PRG
VAR
  iScaleEnd : INT := 120;
END_VAR
```

### “Main scale”
Distance between two values on the main scale
Example: 10
*: The “Variable” property is shown below.

### “Variable”
Variable (integer data type) Contains the distance between two values on the main scale
Example: PLC_PRG.iMainScale
Declarations:

```plaintext
PROGRAM PLC_PRG
VAR
  iMainScale : INT := 20;
END_VAR
```

### “Sub scale”
Distance between two values on the fine scale
You can hide the fine scale by setting the value to 0.
Example: 2
*: The “Variable” property is shown below this.
"Variable"

Variable (integer data type) Contains the distance between two values on the fine scale

Example: PLC_PRG.iSubScale

Declaration:

```plaintext
PROGRAM PLC_PRG
VAR
  iSubScale : INT := 5;
END_VAR
```

"Scale line width"

Specified in pixels

Example: 3

"Scale color"

Color of scale lines

- [ ]: The “Color” dialog opens.
- [ ]: A list box with style colors opens.

"Scale in 3D"

[ ]: Scale lines are displayed with soft 3D shadowing.

Note: This property is not displayed in “FlatStyle”.

"Show scale"

[ ]: The scale is displayed.

"Frame inside"

[ ]: A frame is drawn at the inner end of the scale.

"Frame outside"

[ ]: A frame is drawn at the outer end of the scale.

**Element property 'Label'**

"Label"

Selection list

- "Outside": Scale values are placed outside of the scale.
- "Inside": Scale values are placed inside of the scale.

"Unit"

Text that is displayed in the element.

Example: Units displayed in m/s.

"Font"

Font for labels (example: scale numbering).

Selection from the drop-down list or by clicking the ![image](button.png) button.

"Scale format (C Syntax)"

Values scaled in "printf" syntax

Examples: %d, %5.2f

"Max. text width of labels"

(optional) Value that redefines the maximum width of the scale label. The correct value is normally set automatically.

Note: Change this value only if the automatic adjustment does not yield the expected result.

"Text height of labels"

(optional) Value that redefines the maximum height of the scale label. The correct value is normally set automatically.

Note: Change this value only if the automatic adjustment does not yield the expected result.

"Font color"

Selection from the drop-down list or by clicking the ![image](button.png) button.
### “Usage of”
- **“Preset style values”**: Values from the current style
- **“User-defined settings”**: The subnode “Positioning” appears.

### “Positioning”
Requirement: “User-defined settings” is selected as “Usage of”.
The displayed positioning settings depend on the type of needle instrument and Potentiometer, and partially on whether a custom background image is selected. The following settings are used for achieving the exact position relative to the background image.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Needle movement”</strong></td>
<td>Length of the needle (in pixels)</td>
</tr>
<tr>
<td><strong>“Scale movement”</strong></td>
<td>Distance from the tick marks to the center (in pixels)</td>
</tr>
<tr>
<td></td>
<td>Requirement: A customer image is selected as “Background”</td>
</tr>
<tr>
<td><strong>“Scale length”</strong></td>
<td>Length of the tick marks (in pixels)</td>
</tr>
<tr>
<td></td>
<td>Requirement: A customer image is selected as “Background”</td>
</tr>
<tr>
<td><strong>“Label offset”</strong></td>
<td>Distance from the labels to the tick marks (in pixels)</td>
</tr>
<tr>
<td><strong>“Unit offset”</strong></td>
<td>Distance of the unit text “Label ➔ Unit” from the upper scale edge (in pixels)</td>
</tr>
<tr>
<td><strong>“Origin offset”</strong></td>
<td>Offset of the element (in pixels)</td>
</tr>
<tr>
<td></td>
<td>Requirement: For the elements “Meter 180°” and “Meter 90°”, this property is displayed only if a custom image is selected as “Background”</td>
</tr>
</tbody>
</table>

### Element property ‘Colors’

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Color areas”</strong></td>
<td></td>
</tr>
<tr>
<td><strong>“Durable color areas”</strong></td>
<td>![checkbox] All color areas are visible, regardless of the current value.</td>
</tr>
<tr>
<td></td>
<td>![checkbox] Only the color area is visible that includes the current value.</td>
</tr>
<tr>
<td><strong>“Use colors for scale”</strong></td>
<td>![checkbox] Colors in the color area are used only for the scale and frame.</td>
</tr>
<tr>
<td><strong>“Color areas”</strong></td>
<td></td>
</tr>
<tr>
<td><strong>“Create new”</strong></td>
<td>A new color area is added to the “Elements” view.</td>
</tr>
<tr>
<td><strong>“Delete”</strong></td>
<td>The color area is removed from the list and the list is refreshed.</td>
</tr>
<tr>
<td><strong>“Begin of area”</strong></td>
<td>Start value of the color area</td>
</tr>
<tr>
<td></td>
<td>Example: 20</td>
</tr>
<tr>
<td></td>
<td>![checkbox] The property “Variable” is shown below.</td>
</tr>
<tr>
<td><strong>“Variable”</strong></td>
<td>Variable (integer data type). Contains the start value.</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iColorAreaStart0</td>
</tr>
<tr>
<td></td>
<td>Declaration:</td>
</tr>
<tr>
<td></td>
<td>PROGRAM PLC_PRG</td>
</tr>
<tr>
<td></td>
<td>VAR</td>
</tr>
<tr>
<td></td>
<td>iColorAreaStart0 : INT := 80;</td>
</tr>
<tr>
<td></td>
<td>END_VAR</td>
</tr>
<tr>
<td><strong>“End of area”</strong></td>
<td>End value of the color area</td>
</tr>
<tr>
<td></td>
<td>Example: 120</td>
</tr>
<tr>
<td></td>
<td>![checkbox] The property “Variable” is shown below.</td>
</tr>
</tbody>
</table>
### Variable

Variable (integer data type). Contains the end value.

**Example:** iColorAreaEnd0

**Declaration:**

```plaintext
PROGRAM PLC_PRG
VAR
    iColorAreaEnd0 : INT := 100;
END_VAR
```

### Color

Color that is used for displaying the area.

### Element property 'Absolute movement'

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

### Movement

#### X

Variable (numeric data type). Defines the X position (in pixels).

**Example:** PLC_PRG.iPos_X.

Increasing this value in runtime mode moves the element to the right.

#### Y

Variable (numeric data type). Defines the Y position (in pixels).

**Example:** PLC_PRG.iPos_Y.

Increasing this value in runtime mode moves the element downwards.

#### Rotation

Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** PLC_PRG.iAngle1.

The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.

In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

#### Interior rotation

Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.
You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

Element property 'Access rights'

Requirement: User management is set up for the visualization.

| “Access rights” | Opens the “Access rights” dialog. There you can edit the access privileges for the element.
| Status messages: | - “Not set. Full rights.”: Access rights for all user groups: “operable”
| | - “Rights are set: Limited rights”: Access is restricted for at least one group.

See also

- Page 3366

Visualization Element 'Meter 180°'

Symbol:

Category: “Measurement Controls”

The element displays the value of a variable. The needle is positioned according to the value of the assigned variable on a scale. A meter is used to represent a tachometer, for example.

Element properties

| “Element name” | Example: GenElemInst_1 |
| “Type of element” | “Meter 180°” |
| “Value” | Variable (numeric data type) |

The variable value determines the pointer direction of the element.

Element property 'Center'

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.
<table>
<thead>
<tr>
<th>“X”</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (usahaan) to other positions in the editor.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

**“Animation duration”**

Defines the duration (in milliseconds) in which the element runs an animation

- **Variable (integer value)**
  - Example: `Menu.tContent` with `VAR tContent : INT := 500; END_VAR`
- **Integer literal**
  - Example: 500

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**“Move to foreground”**

Moves the visualization element to the foreground

**Variable (BOOL)**

- Example: `bIsInForeground` with `VAR bIsInForeground : BOOL := FALSE; END_VAR`
- **TRUE**: At runtime, the visualization element is displayed in the foreground.
- **FALSE**: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

**Element property ‘Position’**

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>
“Width”
Specified in pixels.
Example: 150

“Height”
Specified in pixels.
Example: 30

You can also change the values by dragging the box symbols (_drag_box) to other positions in the editor.

See also
● % Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

Element property 'Background'

“Image color”
List box containing background colors

“Own image”
● “Image”: ID of the background image.
You select the background image from an image pool by clicking [image].
Info: If you specify the value "<default>" or select the image from the “Default” category in the Input Assistant, then the original element background image is used.
● “Transparency color”: Selection from list box or Input Assistant.

Element property 'Arrow'

“Hand style”
Drop-down list with different arrow types

“Color”
● [color]: The “Color” dialog box opens.
● ▼: Drop-down list with color names

“Angle range”
Drop-down list for the alignment of the element

“Additional arrow”
☑: An additional arrow is shown inside the scale.

Element property 'Scale'

“Sub scale position”
● “Outside”: The subscale is displayed on the outer scale ring. (“Frame outside”)
● “Inside”: The subscale is displayed on the inner scale ring. (“Frame inside”)

“Scale type”
Type of scale
● “Lines”
● “Dots”
● “Squares”

“Scale start”
Least value of the scale and the lower limit of the value range for the element
Example: 0
☑: The “Variable” property is displayed in the line below this.
| **“Variable”** | Variable (integer data type). Contains the scale start  
Example: PLC_PRG.iScaleStart |
|----------------|---------------------------------------------------------------------|
| **Declaration** | PROGRAM PLC_PRG  
VAR  
  iScaleStart : INT := 0;  
END_VAR |

| **“Scale end”** | Greatest value of the scale and the upper limit of the value range for the element  
Example: 100 |
| **Description** | The “**Variable**” property is shown below this. |

| **“Variable”** | Variable (integer data type). Contains the scale end  
Example: PLC_PRG.iScaleEnd |
|----------------|---------------------------------------------------------------------|
| **Declaration** | PROGRAM PLC_PRG  
VAR  
  iScaleEnd : INT := 120;  
END_VAR |

| **“Main scale”** | Distance between two values on the main scale  
Example: 10 |
| **Description** | The “**Variable**” property is shown below. |

| **“Variable”** | Variable (integer data type) Contains the distance between two values on the main scale  
Example: PLC_PRG.iMainScale |
|----------------|---------------------------------------------------------------------|
| **Declaration** | PROGRAM PLC_PRG  
VAR  
  iMainScale : INT := 20;  
END_VAR |

| **“Sub scale”** | Distance between two values on the fine scale  
You can hide the fine scale by setting the value to 0.  
Example: 2 |
| **Description** | The “**Variable**” property is shown below this. |

| **“Variable”** | Variable (integer data type) Contains the distance between two values on the fine scale  
Example: PLC_PRG.iSubScale |
|----------------|---------------------------------------------------------------------|
| **Declaration** | PROGRAM PLC_PRG  
VAR  
  iSubScale : INT := 5;  
END_VAR |

| **“Scale line width”** | Specified in pixels  
Example: 3 |
## Scale color

Color of scale lines
- [ ] The “Color” dialog opens.
- ▼: A list box with style colors opens.

## Scale in 3D

☑️: Scale lines are displayed with soft 3D shadowing.
Note: This property is not displayed in “FlatStyle”.

## Show scale

☑️: The scale is displayed.

## Frame inside

☑️: A frame is drawn at the inner end of the scale.

## Frame outside

☑️: A frame is drawn at the outer end of the scale.

### Element property 'Label'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Label”</strong></td>
<td>Selection list</td>
</tr>
<tr>
<td></td>
<td>• “Outside”: Scale values are placed outside of the scale.</td>
</tr>
<tr>
<td></td>
<td>• “Inside”: Scale values are placed inside of the scale.</td>
</tr>
<tr>
<td><strong>“Unit”</strong></td>
<td>Text that is displayed in the element. Units displayed in m/s.</td>
</tr>
<tr>
<td><strong>“Font”</strong></td>
<td>Font for labels (example: scale numbering).</td>
</tr>
<tr>
<td></td>
<td>Selection from the drop-down list or by clicking the “” button.</td>
</tr>
<tr>
<td><strong>Scale format (C Syntax)”</strong></td>
<td>Values scaled in &quot;printf&quot; syntax</td>
</tr>
<tr>
<td></td>
<td>Examples: %d, %5.2f</td>
</tr>
<tr>
<td><strong>Max. text width of labels</strong></td>
<td>(optional) Value that redefines the maximum width of the scale label.</td>
</tr>
<tr>
<td></td>
<td>The correct value is normally set automatically.</td>
</tr>
<tr>
<td></td>
<td>Note: Change this value only if the automatic adjustment does not yield the expected result.</td>
</tr>
<tr>
<td><strong>Text height of labels</strong></td>
<td>(optional) Value that redefines the maximum height of the scale label.</td>
</tr>
<tr>
<td></td>
<td>The correct value is normally set automatically.</td>
</tr>
<tr>
<td></td>
<td>Note: Change this value only if the automatic adjustment does not yield the expected result.</td>
</tr>
<tr>
<td><strong>Font color”</strong></td>
<td>Selection from the drop-down list or by clicking the “” button.</td>
</tr>
</tbody>
</table>

### Element property 'Positioning'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Usage of”</strong></td>
<td>• “Preset style values”: Values from the current style</td>
</tr>
<tr>
<td></td>
<td>• “User-defined settings”: The subnode “Positioning” appears.</td>
</tr>
<tr>
<td><strong>Positioning</strong></td>
<td>Requirement: “User-defined settings” is selected as “Usage of”.</td>
</tr>
<tr>
<td></td>
<td>The displayed positioning settings depend on the type of needle instrument and Potentiometer, and partially on whether a custom background image is selected. The following settings are used for achieving the exact position relative to the background image.</td>
</tr>
<tr>
<td><strong>Needle movement”</strong></td>
<td>Length of the needle (in pixels)</td>
</tr>
<tr>
<td><strong>Scale movement”</strong></td>
<td>Distance from the tick marks to the center (in pixels)</td>
</tr>
<tr>
<td></td>
<td>Requirement: A customer image is selected as “Background”.</td>
</tr>
<tr>
<td><strong>“Scale length”</strong></td>
<td>Length of the tick marks (in pixels)</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td><strong>Requirement:</strong></td>
<td>A customer image is selected as “Background”.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Label offset”</strong></th>
<th>Distance from the labels to the tick marks (in pixels)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>“Unit offset”</strong></th>
<th>Distance of the unit text “Label ➔ Unit” from the upper scale edge (in pixels)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>“Origin offset”</strong></th>
<th>Offset of the element (in pixels)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Requirement:</strong></td>
<td>For the elements “Meter 180°” and “Meter 90°”, this property is displayed only if a custom image is selected as “Background”.</td>
</tr>
</tbody>
</table>

**Element property ‘Colors’**

<table>
<thead>
<tr>
<th><strong>“Color areas”</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Durable color areas”</strong></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Use colors for scale”</strong></th>
<th>Colors in the color area are used only for the scale and frame.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>“Create new”</strong></th>
<th>A new color area is added to the “Elements” view.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>“Delete”</strong></th>
<th>The color area is removed from the list and the list is refreshed.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>“Begin of area”</strong></th>
<th>Start value of the color area</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 20</td>
<td>✴: The property “Variable” is shown below.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Variable”</strong></th>
<th>Variable (integer data type). Contains the start value.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: PLC_PRG.iColorAreaStart0</td>
<td>Declaration:</td>
</tr>
<tr>
<td>PROGRAM PLC_PRG</td>
<td>VAR</td>
</tr>
<tr>
<td>iColorAreaStart0 : INT := 80;</td>
<td></td>
</tr>
<tr>
<td>END_VAR</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“End of area”</strong></th>
<th>End value of the color area</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 120</td>
<td>✴: The property “Variable” is shown below.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Variable”</strong></th>
<th>Variable (integer data type). Contains the end value.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: iColorAreaEnd0</td>
<td>Declaration:</td>
</tr>
<tr>
<td>PROGRAM PLC_PRG</td>
<td>VAR</td>
</tr>
<tr>
<td>iColorAreaEnd0 : INT := 100;</td>
<td></td>
</tr>
<tr>
<td>END_VAR</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Color”</strong></th>
<th>Color that is used for displaying the area.</th>
</tr>
</thead>
</table>

**Element property ‘Absolute movement’**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.
### Movement

<table>
<thead>
<tr>
<th><strong>“X”</strong></th>
<th>Variable (numeric data type). Defines the X position (in pixels).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: PLC_PRG.iPos_X.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Y”</strong></th>
<th>Variable (numeric data type). Defines the Y position (in pixels).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: PLC_PRG.iPos_Y.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Rotation”</strong></th>
<th>Variable (numeric data type). Defines the angle of rotation (in degrees).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: PLC_PRG.iAngle1.</td>
</tr>
<tr>
<td></td>
<td>The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.</td>
</tr>
<tr>
<td></td>
<td>In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Interior rotation”</strong></th>
<th>Variable (numeric data type). Defines the angle of rotation (in degrees).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: PLC_PRG.iAngle2.</td>
</tr>
<tr>
<td></td>
<td>In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.</td>
</tr>
<tr>
<td></td>
<td>The rotation point is shown as the symbol.</td>
</tr>
<tr>
<td></td>
<td>Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.</td>
</tr>
</tbody>
</table>

You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- The variables control the element behavior dynamically.
**“Invisible”**
Variable (BOOL). Toggles the visibility of the element. 
**TRUE:** The element is not visible at runtime.

The “Invisible” property is supported by the "Client Animation" functionality.

**Element property ‘Access rights’**
Requirement: User management is set up for the visualization.

**“Access rights”**
Opens the “Access rights” dialog. There you can edit the access privileges for the element.
Status messages:
- **“Not set. Full rights.”**: Access rights for all user groups: “operable”
- **“Rights are set: Limited rights”**: Access is restricted for at least one group.

See also
- ☞ Chapter 6.4.5.21.3.1 "Dialog 'Access Rights” on page 3366

See also
- ☞ Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

**Visualization Element ‘Meter’**
Symbol:

Category: “Measurement Controls”
The element displays the value of a variable. The needle is positioned according to the value of the assigned variable. A meter is used to represent a tachometer, for example.

**Element properties**

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: GenElemInst_1</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Type of element”</td>
<td>“Meter”</td>
</tr>
</tbody>
</table>
| “Value”              | Variable (numeric data type). 
The variable value determines the pointer direction of the element. |

**Element property ‘Center’**
The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>
You can also change the values by dragging the symbols ( draggable) to other positions in the editor.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

<table>
<thead>
<tr>
<th>“Animation duration”</th>
<th>Defines the duration (in milliseconds) in which the element runs an animation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Variable (integer value)</td>
</tr>
<tr>
<td></td>
<td>Example: Menu.tContent with VAR tContent : INT := 500; END_VAR</td>
</tr>
<tr>
<td></td>
<td>• Integer literal</td>
</tr>
<tr>
<td></td>
<td>Example: 500</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Animatable properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Absolute movement”, “Movement”, “X”, “Y”</td>
</tr>
<tr>
<td>“Absolute movement”, “Rotation”</td>
</tr>
<tr>
<td>“Absolute movement”, “Interior rotation”</td>
</tr>
<tr>
<td>“Absolute movement”, “Exterior rotation”</td>
</tr>
</tbody>
</table>

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

<table>
<thead>
<tr>
<th>“Move to foreground”</th>
<th>Moves the visualization element to the foreground</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable (BOOL)</td>
<td></td>
</tr>
<tr>
<td>Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR</td>
<td></td>
</tr>
<tr>
<td>TRUE: At runtime, the visualization element is displayed in the foreground.</td>
<td></td>
</tr>
<tr>
<td>FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Element property 'Position'</th>
<th>The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
<td>X coordinate of the upper left corner of the element Specified in pixels. Example: 10.</td>
</tr>
<tr>
<td>“Y”</td>
<td>Y coordinate of the upper left corner of the element Specified in pixels. Example: 10.</td>
</tr>
</tbody>
</table>
**Element property 'Background'**

<table>
<thead>
<tr>
<th>“Image color”</th>
<th>List box containing background colors</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Own image”</td>
<td><img src="imagePool.png" alt="Image" /> You select the background image from an image pool by clicking <img src="imagePool.png" alt="Image" />. Info: If you specify the value “&lt;default&gt;” or select the image from the “Default” category in the Input Assistant, then the original element background image is used.</td>
</tr>
</tbody>
</table>

**Element property 'Arrow'**

| “Hand style” | Drop-down list with different arrow types |
| “Color” | ![Color](colorOptions.png) The “Color” dialog box opens. ![Color](colorOptions.png) Drop-down list with color names |
| “Arrow start” | Angle (in degrees) between the scale start and the horizontal axis |
| “Arrow end” | Angle (in degrees) between the right edge of the pointer instrument and the horizontal axis |
| “Additional arrow” | ![Additional Arrow](additionalArrow.png) An additional arrow is shown inside the scale. |

**Element property 'Scale'**

<p>| “Sub scale position” | <img src="outsideFrame.png" alt="Outside" /> The subscale is displayed on the outer scale ring. (&quot;Frame outside&quot;) <img src="insideFrame.png" alt="Inside" /> The subscale is displayed on the inner scale ring. (&quot;Frame inside&quot;) |
| “Scale type” | Type of scale |
| “Scale start” | Least value of the scale and the lower limit of the value range for the element Example: 0 |</p>
<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable (integer data type). Contains the scale start</td>
<td>PLC_PRG.iScaleStart</td>
<td></td>
</tr>
<tr>
<td>Declaration:</td>
<td>PROGRAM PLC_PRG</td>
<td>VAR iScaleStart : INT := 0;</td>
</tr>
<tr>
<td>Scale end</td>
<td>Greatest value of the scale and the upper limit of the value range for the element</td>
<td>100</td>
</tr>
<tr>
<td>Variable (integer data type). Contains the scale end</td>
<td>PLC_PRG.iScaleEnd</td>
<td></td>
</tr>
<tr>
<td>Declaration:</td>
<td>PROGRAM PLC_PRG</td>
<td>VAR iScaleEnd : INT := 120;</td>
</tr>
<tr>
<td>Main scale</td>
<td>Distance between two values on the main scale</td>
<td>10</td>
</tr>
<tr>
<td>Variable (integer data type) Contains the distance between two values on the main scale</td>
<td>PLC_PRG.iMainScale</td>
<td></td>
</tr>
<tr>
<td>Declaration:</td>
<td>PROGRAM PLC_PRG</td>
<td>VAR iMainScale : INT := 20;</td>
</tr>
<tr>
<td>Sub scale</td>
<td>Distance between two values on the fine scale</td>
<td>2</td>
</tr>
<tr>
<td>You can hide the fine scale by setting the value to 0.</td>
<td>PLC_PRG.iSubScale</td>
<td></td>
</tr>
<tr>
<td>Variable (integer data type) Contains the distance between two values on the fine scale</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Declaration:</td>
<td>PROGRAM PLC_PRG</td>
<td>VAR iSubScale : INT := 5;</td>
</tr>
<tr>
<td>Scale line width</td>
<td>Specified in pixels</td>
<td>3</td>
</tr>
<tr>
<td>Example: 3</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Configuration and programming
Programming with CODESYS > CODESYS Visualization
**“Scale color”**

Color of scale lines
- [ ] The “Color” dialog opens.
- [ ] A list box with style colors opens.

**“Scale in 3D”**

[ ] Scale lines are displayed with soft 3D shadowing.

Note: This property is not displayed in “FlatStyle”.

**“Show scale”**

[ ] The scale is displayed.

**“Frame inside”**

[ ] A frame is drawn at the inner end of the scale.

**“Frame outside”**

[ ] A frame is drawn at the outer end of the scale.

---

**Element property 'Label'**

<table>
<thead>
<tr>
<th><strong>“Label”</strong></th>
<th>Selection list</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>“Outside”: Scale values are placed outside of the scale.</td>
</tr>
<tr>
<td></td>
<td>“Inside”: Scale values are placed inside of the scale.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Unit”</strong></th>
<th>Text that is displayed in the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: Units displayed in m/s.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Font”</strong></th>
<th>Font for labels (example: scale numbering).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Selection from the drop-down list or by clicking the “button.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Scale format (C Syntax)”</strong></th>
<th>Values scaled in “printf” syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Examples: %d, %5.2f</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Max. text width of labels”</strong></th>
<th>(optional) Value that redefines the maximum width of the scale label. The correct value is normally set automatically.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Note: Change this value only if the automatic adjustment does not yield the expected result.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Text height of labels”</strong></th>
<th>(optional) Value that redefines the maximum height of the scale label. The correct value is normally set automatically.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Note: Change this value only if the automatic adjustment does not yield the expected result.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Font color”</strong></th>
<th>Selection from the drop-down list or by clicking the “button.</th>
</tr>
</thead>
</table>

---

**Element property 'Positioning'**

<table>
<thead>
<tr>
<th><strong>“Usage of”</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>“Preset style values”: Values from the current style</td>
</tr>
<tr>
<td></td>
<td>“User-defined settings”: The subnode “Positioning” appears.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Positioning”</strong></th>
<th>Requirement: “User-defined settings” is selected as “Usage of”.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The displayed positioning settings depend on the type of needle instrument and Potentiometer, and partially on whether a custom background image is selected. The following settings are used for achieving the exact position relative to the background image.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Needle movement”</strong></th>
<th>Length of the needle (in pixels)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>“Scale movement”</strong></th>
<th>Distance from the tick marks to the center (in pixels)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requirement: A customer image is selected as “Background”.</td>
<td></td>
</tr>
</tbody>
</table>
**Element property 'Colors'**

**Color areas**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Durable color areas</td>
<td>□: All color areas are visible, regardless of the current value.</td>
</tr>
<tr>
<td></td>
<td>✔: Only the color area is visible that includes the current value.</td>
</tr>
<tr>
<td>Use colors for scale</td>
<td>✔: Colors in the color area are used only for the scale and frame.</td>
</tr>
</tbody>
</table>

**Create new**

A new color area is added to the “Elements” view.

**Delete**

The color area is removed from the list and the list is refreshed.

**Begin of area**

Start value of the color area

Example: 20

◆: The property “Variable” is shown below.

**Variable**

Variable (integer data type). Contains the start value.

Example: PLC_PRG.iColorAreaStart0

Declaration:

```plaintext
PROGRAM PLC_PRG
VAR
  iColorAreaStart0 : INT := 80;
END_VAR
```

**End of area**

End value of the color area

Example: 120

◆: The property “Variable” is shown below.

**Variable**

Variable (integer data type). Contains the end value.

Example: iColorAreaEnd0

Declaration:

```plaintext
PROGRAM PLC_PRG
VAR
  iColorAreaEnd0 : INT := 100;
END_VAR
```

**Color**

Color that is used for displaying the area.

---

**Element property 'Absolute movement'**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.
### Movement

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Example</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>X</strong></td>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
<td><code>PLC_PRG.iPos_X</code></td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td><strong>Y</strong></td>
<td>Variable (numeric data type). Defines the Y position (in pixels).</td>
<td><code>PLC_PRG.iPos_Y</code></td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
</tr>
<tr>
<td><strong>Rotation</strong></td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
<td><code>PLC_PRG.iAngle1</code></td>
<td>The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol. In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
</tr>
<tr>
<td><strong>Interior rotation</strong></td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
<td><code>PLC_PRG.iAngle2</code></td>
<td>In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise. The rotation point is shown as the symbol. Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.</td>
</tr>
</tbody>
</table>

You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the "Client Animation" functionality.

See also

- Element property 'State variables'

The variables control the element behavior dynamically.
### "Invisible"

<table>
<thead>
<tr>
<th>Variable (BOOL)</th>
<th>Toggles the visibility of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>TRUE</strong>: The element is not visible at runtime.</td>
<td></td>
</tr>
</tbody>
</table>

The "Invisible" property is supported by the "Client Animation" functionality.

---

#### Element property 'Access rights'

**Requirement**: User management is set up for the visualization.

<table>
<thead>
<tr>
<th>&quot;Access rights&quot;</th>
<th>Opens the &quot;Access rights&quot; dialog. There you can edit the access privileges for the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status messages:</td>
<td>&quot;Not set. Full rights.&quot;: Access rights for all user groups: &quot;operable&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Rights are set: Limited rights&quot;: Access is restricted for at least one group.</td>
</tr>
</tbody>
</table>

See also
- % Chapter 6.4.5.21.3.1 "Dialog 'Access Rights'" on page 3366

See also
- % Chapter 6.4.5.5 "Designing a visualization with elements" on page 2872

---

#### Visualization Element 'Potentiometer'

**Symbol:**

Category: "Measurement Controls"

The element displays the value of a variable as a setting on the potentiometer. A visualization user can modify the value by dragging the pointer to another position.

See also
- % Chapter 6.4.5.5 "Designing a visualization with elements" on page 2872

---

#### Element properties

<table>
<thead>
<tr>
<th>&quot;Element name&quot;</th>
<th>Example: GenElemInst_1</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Type of element&quot;</td>
<td>&quot;Potentiometer&quot;</td>
</tr>
<tr>
<td>&quot;Variable&quot;</td>
<td>Variable (numeric data type). Contains the position of the pointer for the potentiometer.</td>
</tr>
<tr>
<td></td>
<td>A visualization user can modify the value by dragging the pointer to another position.</td>
</tr>
</tbody>
</table>
The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>X-coordinate of the point of rotation</td>
</tr>
<tr>
<td>Y</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols to other positions in the editor.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

**Animation duration**

Defines the duration (in milliseconds) in which the element runs an animation.

- **Variable (integer value)**
  
  Example: `Menu.tContent with VAR tContent : INT := 500; END_VAR`

- **Integer literal**
  
  Example: 500

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**Move to foreground**

Moves the visualization element to the foreground.

Variable (BOOL)

Example: `bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR`

- TRUE: At runtime, the visualization element is displayed in the foreground.
- FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.
<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;X&quot;</td>
<td>X coordinate of the upper left corner of the element. Specified in pixels. Example: 10.</td>
</tr>
<tr>
<td>&quot;Y&quot;</td>
<td>Y coordinate of the upper left corner of the element. Specified in pixels. Example: 10.</td>
</tr>
<tr>
<td>&quot;Width&quot;</td>
<td>Specified in pixels. Example: 150</td>
</tr>
<tr>
<td>&quot;Height&quot;</td>
<td>Specified in pixels. Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (⌘) to other positions in the editor.

See also
- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

### Element property ‘Background’

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Image color&quot;</td>
<td>List box containing background colors</td>
</tr>
<tr>
<td>&quot;Own image&quot;</td>
<td>- &quot;Image&quot;: ID of the background image. You select the background image from an image pool by clicking 📛. Info: If you specify the value &quot;&lt;default&gt;&quot; or select the image from the &quot;Default&quot; category in the Input Assistant, then the original element background image is used. - &quot;Transparency color&quot;: Selection from list box or Input Assistant.</td>
</tr>
</tbody>
</table>

### Element property ‘Arrow’

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Hand style&quot;</td>
<td>Drop-down list with different arrow types</td>
</tr>
<tr>
<td>&quot;Color&quot;</td>
<td>- 🎨: The “Color” dialog box opens. - ▼: Drop-down list with color names</td>
</tr>
<tr>
<td>&quot;Arrow start&quot;</td>
<td>Angle (in degrees) between the left edge of the element and the horizontal axis</td>
</tr>
<tr>
<td>&quot;Arrow end&quot;</td>
<td>Angle (in degrees) between the right edge of the element and the horizontal axis</td>
</tr>
</tbody>
</table>
### Sub scale position
- **Outside**: The subscale is displayed on the outer scale ring. ("Frame outside")
- **Inside**: The subscale is displayed on the inner scale ring. ("Frame inside")

### Scale type
Type of scale
- **Lines**
- **Dots**
- **Squares**

### Scale start
Least value of the scale and the lower limit of the value range for the element
Example: 0
❖: The "Variable" property is displayed in the line below this.

### Variable
Variable (integer data type). Contains the scale start
Example: PLC_PRG.iScaleStart
Declaration:
```plaintext
PROGRAM PLC_PRG
VAR
  iScaleStart : INT := 0;
END_VAR
```

### Scale end
Greatest value of the scale and the upper limit of the value range for the element
Example: 100
❖: The "Variable" property is shown below this.

### Variable
Variable (integer data type). Contains the scale end
Example: PLC_PRG.iScaleEnd
Declaration:
```plaintext
PROGRAM PLC_PRG
VAR
  iScaleEnd : INT := 120;
END_VAR
```

### Main scale
Distance between two values on the main scale
Example: 10
❖: The "Variable" property is shown below.

### Variable
Variable (integer data type) Contains the distance between two values on the main scale
Example: PLC_PRG.iMainScale
Declaration:
```plaintext
PROGRAM PLC_PRG
VAR
  iMainScale : INT := 20;
END_VAR
```

### Sub scale
Distance between two values on the fine scale
You can hide the fine scale by setting the value to 0.
Example: 2
❖: The "Variable" property is shown below this.
## Variable

Variable (integer data type) Contains the distance between two values on the fine scale

**Example:** PLC_PRG.iSubScale  

**Declaration:**

```plaintext
PROGRAM PLC_PRG  
VAR  
iSubScale : INT := 5;  
END_VAR
```

## Scale line width

Specified in pixels  
**Example:** 3

## Scale color

Color of scale lines  
- ![icon] The “Color” dialog opens.  
- ![icon] A list box with style colors opens.

## Scale in 3D

- [ ] Scale lines are displayed with soft 3D shadowing.  
**Note:** This property is not displayed in “FlatStyle”.

## Show scale

- [ ] The scale is displayed.

## Frame inside

- [ ] A frame is drawn at the inner end of the scale.

## Frame outside

- [ ] A frame is drawn at the outer end of the scale.

---

### Element property 'Label'

#### “Label”

Selection list  
- “Outside”: Scale values are placed outside of the scale.  
- “Inside”: Scale values are placed inside of the scale.

#### “Unit”

Text that is displayed in the element.  
**Example:** Units displayed in m/s.

#### “Font”

Font for labels (example: scale numbering).  
Selection from the drop-down list or by clicking the ![icon] button.

#### “Scale format (C Syntax)”

Values scaled in “printf” syntax  
**Examples:** %d, %.2f

#### “Max. text width of labels”

(optional) Value that redefines the maximum width of the scale label. The correct value is normally set automatically.  
**Note:** Change this value only if the automatic adjustment does not yield the expected result.

#### “Text height of labels”

(optional) Value that redefines the maximum height of the scale label. The correct value is normally set automatically.  
**Note:** Change this value only if the automatic adjustment does not yield the expected result.

#### “Font color”

Selection from the drop-down list or by clicking the ![icon] button.
**“Usage of”**
- “Preset style values”: Values from the current style
- “User-defined settings”: The subnode “Positioning” appears.

**“Positioning”**
Requirement: “User-defined settings” is selected as “Usage of”.
The displayed positioning settings depend on the type of needle instrument and Potentiometer, and partially on whether a custom background image is selected. The following settings are used for achieving the exact position relative to the background image.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Needle movement”</strong></td>
<td>Length of the needle (in pixels)</td>
</tr>
<tr>
<td><strong>“Scale movement”</strong></td>
<td>Distance from the tick marks to the center (in pixels)</td>
</tr>
<tr>
<td>Requirement:</td>
<td>A customer image is selected as “Background”.</td>
</tr>
<tr>
<td><strong>“Scale length”</strong></td>
<td>Length of the tick marks (in pixels)</td>
</tr>
<tr>
<td>Requirement:</td>
<td>A customer image is selected as “Background”.</td>
</tr>
<tr>
<td><strong>“Label offset”</strong>:</td>
<td>Distance from the labels to the tick marks (in pixels)</td>
</tr>
<tr>
<td><strong>“Unit offset”</strong>:</td>
<td>Distance of the unit text “Label ➔ Unit” from the upper scale edge (in pixels)</td>
</tr>
<tr>
<td><strong>“Origin offset”</strong></td>
<td>Offset of the element (in pixels)</td>
</tr>
<tr>
<td>Requirement:</td>
<td>For the elements “Meter 180°” and “Meter 90°”, this property is displayed only if a custom image is selected as “Background”.</td>
</tr>
</tbody>
</table>

**Element property ‘Colors’**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Color areas”</strong></td>
<td></td>
</tr>
<tr>
<td><strong>“Durable color areas”</strong></td>
<td>□: All color areas are visible, regardless of the current value.</td>
</tr>
<tr>
<td></td>
<td>✓: Only the color area is visible that includes the current value.</td>
</tr>
<tr>
<td><strong>“Use colors for scale”</strong></td>
<td>✓: Colors in the color area are used only for the scale and frame.</td>
</tr>
<tr>
<td><strong>“Color areas”</strong></td>
<td></td>
</tr>
<tr>
<td><strong>“Create new”</strong></td>
<td>A new color area is added to the “Elements” view.</td>
</tr>
<tr>
<td><strong>“Delete”</strong></td>
<td>The color area is removed from the list and the list is refreshed.</td>
</tr>
<tr>
<td><strong>“Begin of area”</strong></td>
<td>Start value of the color area</td>
</tr>
<tr>
<td>Example:</td>
<td>20</td>
</tr>
<tr>
<td>♦: The property “Variable” is shown below.</td>
<td></td>
</tr>
<tr>
<td><strong>“Variable”</strong></td>
<td>Variable (integer data type). Contains the start value.</td>
</tr>
<tr>
<td>Example:</td>
<td>PLC_PRG.iColorAreaStart0</td>
</tr>
<tr>
<td>Declaration:</td>
<td></td>
</tr>
<tr>
<td>PROGRAM PLC_PRG</td>
<td></td>
</tr>
<tr>
<td>VAR</td>
<td></td>
</tr>
<tr>
<td>iColorAreaStart0 : INT := 80;</td>
<td></td>
</tr>
<tr>
<td>END_VAR</td>
<td></td>
</tr>
<tr>
<td><strong>“End of area”</strong></td>
<td>End value of the color area</td>
</tr>
<tr>
<td>Example:</td>
<td>120</td>
</tr>
<tr>
<td>♦: The property “Variable” is shown below.</td>
<td></td>
</tr>
</tbody>
</table>
**Variable**

Variable (integer data type). Contains the end value.

Example: `iColorAreaEnd0`

Declaration:

```plaintext
PROGRAM PLC_PRG
VAR
  iColorAreaEnd0 : INT := 100;
END_VAR
```

**Color**

Color that is used for displaying the area.

**Element property 'State variables'**

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>“Invisible”</th>
<th>Variable (BOOL). Toggles the visibility of the element. TRUE: The element is not visible at runtime. Example: <code>bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR</code></th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Deactivate inputs”</th>
<th>Variable (BOOL). Toggles the operability of the element. TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.</th>
</tr>
</thead>
</table>

The “Invisible” property is supported by the “Client Animation” functionality.

**Element property 'Absolute movement'**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>“Movement”</th>
<th>Variable (numeric data type). Defines the X position (in pixels). Example: <code>PLC_PRG.iPos_X</code>. Increasing this value in runtime mode moves the element to the right.</th>
</tr>
</thead>
</table>

| “Y”                 | Variable (numeric data type). Defines the Y position (in pixels). Example: `PLC_PRG.iPos_Y`. Increasing this value in runtime mode moves the element downwards. |
**“Rotation”**  
Variable (numeric data type). Defines the angle of rotation (in degrees).  
**Example:** PLC_PRG.iAngle1.  
The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.  
In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

**“Interior rotation”**  
Variable (numeric data type). Defines the angle of rotation (in degrees).  
**Example:** PLC_PRG.iAngle2.  
In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.  
The rotation point is shown as the symbol.  
Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

-  

Element property ‘Access rights’  
Requirement: User management is set up for the visualization.

**“Access rights”**  
Opens the “Access rights” dialog. There you can edit the access privileges for the element.  
Status messages:  
- “Not set. Full rights.”: Access rights for all user groups: “operable”  
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also

- ☞ Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366
Visualization Element 'Histogram'

Symbol:

Category: “Measurement Controls”
The element displays the data of a one-dimensional array as a histogram. You can define specific colors for certain value ranges.

See also
● Chapter 6.4.5.2.4 “Displaying Array Data in a Histogram” on page 2862

Element properties

<table>
<thead>
<tr>
<th>&quot;Element name&quot;</th>
<th>Example: GenElemInst_35</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Type of element&quot;</td>
<td>&quot;Histogram&quot;</td>
</tr>
<tr>
<td>&quot;Data array&quot;</td>
<td>One-dimensional array with data displayed in this histogram. Example: PLC_PRG.arr1</td>
</tr>
</tbody>
</table>

Element property 'Subrange of array'

| "Use subrange" | ☑: Only part of the array is displayed in the histogram. |
| "Start index"  | First array index with a displayed value. Requirement: "Use subrange" is activated. |
| "End index"    | Last array index with a displayed value. Requirement: "Use subrange" is activated. |

| "Display type" | ● "Bars": Data is displayed as bars. ● "Lines": Data is displayed as lines. ● "Curve": Interpolation of data into a curve. |
| "Line width"   | Specified in pixels Requirement: "Curve" is selected as the "Display type". |
| "Show horizontal lines" | ☑: Horizontal lines are drawn on the main scale. Note: Not all visualization styles have this property. This element property is not available for visualization styles that have striped backgrounds (example: “Flat style”). |
| "Relative bar width" | Integer value between 1 and 100 ● 1: The bars are drawn as lines. ● 100: The entire width of the histogram is filled with the bars. |

Element property 'Position'
The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>X</code></td>
<td>X coordinate of the upper left corner of the element. Specified in pixels. Example: 10.</td>
</tr>
<tr>
<td><code>Y</code></td>
<td>Y coordinate of the upper left corner of the element. Specified in pixels. Example: 10.</td>
</tr>
<tr>
<td><code>Width</code></td>
<td>Specified in pixels. Example: 150</td>
</tr>
<tr>
<td><code>Height</code></td>
<td>Specified in pixels. Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (_epi) to other positions in the editor.

See also

- Chapter 6.4.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

**Element property 'Center'**

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the  symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>X</code></td>
<td>X-coordinate of the point of rotation</td>
</tr>
<tr>
<td><code>Y</code></td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (_epi) to other positions in the editor.

**Element property 'Scale'**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>Scale start</code></td>
<td>Least value of the scale and the lower limit of the value range for the element. Example: 0</td>
</tr>
<tr>
<td><code>Variable</code></td>
<td>Variable (integer data type). Contains the scale start. Example: PLC_PRG.iScaleStart</td>
</tr>
<tr>
<td><code>Scale end</code></td>
<td>Greatest value of the scale and the upper limit of the value range for the element. Example: 100</td>
</tr>
<tr>
<td><code>Variable</code></td>
<td>Variable (integer data type). Contains the scale end. Example: PLC_PRG.iScaleEnd</td>
</tr>
</tbody>
</table>
| **Main scale** | Distance between 2 values on the rough scale.  
Example: 10  
 ADVISED: The property “Variable” is shown below. |
| **Variable** | Variable (integer data type). Contains the distance.  
Example: PLC_PRG.iMainScale |
| **Subscale** | Distance between 2 values on the fine scale.  
You can hide the fine scale by setting the value to 0.  
Example: 2  
 ADVISED: The property “Variable” is shown below. |
| **Variable** | Variable (integer data type). Contains the spacing.  
Example: PLC_PRG.iSubScale |
| **Scale color** | Color of scale lines  
- ☑️: The “Color” dialog box opens.  
- ➡️: A drop-down list with color names opens. |
| **Base line** | Value of the main scale where the horizontal base line of the Histogram is located.  
The drawing of the bar starts at the base line. |

**Example**
A valid declaration is required for the variables used as an example in the table above.

```plaintext
PROGRAM PLC_PRG
VAR
  iScaleStart : INT := 0;
  iScaleEnd : INT := 120;
  iMainScale : INT := 20;
  iSubScale : INT := 5;
END_VAR
```

**Element property ‘Label’**

| **“Unit”** | Text that is displayed in the element.  
Example: Units displayed in m/s. |
| **“Font”** | Font for labels (example: scale numbering).  
Selection from the drop-down list or by clicking the “…” button. |
| **Scale format (C Syntax)”** | Values scaled in “printf” syntax  
Examples: %d, %5.2f |
| **Max. text width of labels”** | Optional value that defines the maximum width of the scale label.  
Note: Change this value only if the automatic adjustment does not yield the expected result. |
| **Text height of labels”** | Optional value that defines the maximum height of the scale label.  
Note: Change this value only if the automatic adjustment does not yield the expected result. |
| **“Font color”** | Selection from the drop-down list or by clicking the “…” button. |
**Element property 'Colors'**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>&quot;Graph color&quot;</strong></td>
<td>Color of the bar in normal state.</td>
</tr>
<tr>
<td></td>
<td>Note: The normal state is in effect when the current value of the array compo-</td>
</tr>
<tr>
<td></td>
<td>nent does not fulfill the alarm condition.</td>
</tr>
<tr>
<td><strong>&quot;Alarm value&quot;</strong></td>
<td>Threshold for the alarm.</td>
</tr>
<tr>
<td><strong>&quot;Alarm condition&quot;</strong></td>
<td>If the current value of the array component fulfills the alarm condition, then the alarm condition is set.</td>
</tr>
<tr>
<td></td>
<td>● &quot;Less&quot;: The current value is less than the &quot;Alarm value&quot;</td>
</tr>
<tr>
<td></td>
<td>● &quot;More&quot;: The current value is greater than the &quot;Alarm value&quot;</td>
</tr>
<tr>
<td><strong>&quot;Alarm color&quot;</strong></td>
<td>Color of the bar in alarm state.</td>
</tr>
<tr>
<td><strong>&quot;Use color areas&quot;</strong></td>
<td>☑: The color areas defined in this element are used.</td>
</tr>
<tr>
<td><strong>&quot;Color areas&quot;</strong></td>
<td></td>
</tr>
<tr>
<td><strong>&quot;Create new&quot;</strong></td>
<td>A new color area is added.</td>
</tr>
<tr>
<td><strong>&quot;Delete&quot;</strong></td>
<td>The color area is removed from the list.</td>
</tr>
<tr>
<td><strong>&quot;Begin of area&quot;</strong></td>
<td>The start value on the &quot;Scale&quot; of the Histogram where the color area begins.</td>
</tr>
<tr>
<td><strong>&quot;End of area&quot;</strong></td>
<td>The end value on the &quot;Scale&quot; of the Histogram where the color area ends.</td>
</tr>
<tr>
<td><strong>&quot;Color&quot;</strong></td>
<td>Color that is used for displaying the area.</td>
</tr>
</tbody>
</table>

**Element property 'Absolute movement'**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>&quot;Movement&quot;</strong></td>
<td></td>
</tr>
<tr>
<td><strong>&quot;X&quot;</strong></td>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iPos_X.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td><strong>&quot;Y&quot;</strong></td>
<td>Variable (numeric data type). Defines the Y position (in pixels).</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iPos_Y.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
</tr>
<tr>
<td><strong>&quot;Rotation&quot;</strong></td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iAngle1.</td>
</tr>
<tr>
<td></td>
<td>The midpoint of the element rotates at the &quot;Center&quot; point. This rotation point is shown as the symbol.</td>
</tr>
<tr>
<td></td>
<td>In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
</tr>
</tbody>
</table>
**“Interior rotation”**

Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

---

You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- 

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
"Animation duration" defines the duration (in milliseconds) in which the element runs an animation.

- Variable (integer value)
  Example: Menu.tContent with VAR tContent : INT := 500; END_VAR
- Integer literal
  Example: 500

Animatable properties:
- "Absolute movement", "Movement", "X", "Y"
- "Absolute movement", "Rotation"
- "Absolute movement", "Interior rotation"
- "Absolute movement", "Exterior rotation"

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

"Move to foreground" moves the visualization element to the foreground.

- Variable (BOOL)
  Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR
  TRUE: At runtime, the visualization element is displayed in the foreground.
  FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

Element property 'Access rights'

Requirement: User management is set up for the visualization.

"Access rights" opens the "Access rights" dialog. There you can edit the access privileges for the element.

Status messages:
- "Not set. Full rights.": Access rights for all user groups: "operable"
- "Rights are set: Limited rights": Access is restricted for at least one group.

See also:
- § Chapter 6.4.5.21.3.1 "Dialog 'Access Rights'" on page 3366

Visualization Element 'Image Switcher'

Symbol:

Category: "Lamps/Switches/Bitmaps"

The element displays one of three referenced images. Mouse actions change the displayed image. The images are defined in the "Image settings" element properties. The effects of mouse clicks are defined in the "Element behavior" property.
**Element name**
Optional

Hint: Assign individual names for elements so that they are found faster in the element list.

Example: ImageSwitcher_1

**Type of element**
"Image Switcher"

---

**Element property 'Position'**
The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th><strong>“X”</strong></th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Y”</strong></th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Width”</strong></th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 150</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Height”</strong></th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (throat) to other positions in the editor.

See also
- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

<table>
<thead>
<tr>
<th><strong>“Variable”</strong></th>
<th>Variable (BOOL).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The value of the variable changes according to user input and it is independent of the “Element behavior” element property.</td>
</tr>
</tbody>
</table>

---

**Image settings**

<table>
<thead>
<tr>
<th><strong>“Image &quot;on&quot;”</strong></th>
<th>Image ID from an image pool. The image can be selected using the input assistant.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The image is used if the variable of the “Variable” property has the value TRUE.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Image &quot;off&quot;”</strong></th>
<th>Image ID from an image pool. The image can be selected using the input assistant.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The image is used if the variable of the “Variable” property has the value FALSE.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Image &quot;clicked&quot;”</strong></th>
<th>Image ID from an image pool. The image is selected using the input assistant.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>In runtime mode, the visualization displays the referenced image when the element is clicked (and the mouse button is held down).</td>
</tr>
<tr>
<td></td>
<td>Requirement: The “Element behavior” is “Image toggler”.</td>
</tr>
</tbody>
</table>
**"Transparency"**<br>[☑]: The "Transparent color" is selected.

**"Transparent color"**<br>The image pixels that have the transparent color are displayed as transparent.

Requirement: "Transparency" is activated.
- [☑]: The "Color" dialog box opens.
- [çiler]: A drop-down list with color names opens.

**"Scaling type"**<br>Defines how an image fits in the element frame.
- "Fixed": The original size of the image is retained, regardless of the dimensions of the element.
- "Isotropic": The entire image is shown in the element frame, either larger or smaller. As a result, the proportion of height and width are retained.
- "Anisotropic": The image resizes automatically to the dimensions of the element frame, filling the entire element frame. As a result, the proportions are not retained.

**"Horizontal alignment"**<br>Horizontal alignment of the image within the element frame or element
- Left
- Centered
- Right

Requirement: "Scaling type" is "Isotropic".

**"Vertical alignment"**<br>Vertical alignment of the image within the element frame or element
- Top
- Centered
- Bottom

Requirement: "Scaling type" is "Isotropic".

**"Element behavior"**
- "Image toggler": Every mouse click switches the image.
- "Image tapper": While a visualization user holds down the mouse button, the image of the "Image on" property is displayed. At the same time, the value TRUE is assigned to the "Variable" property.

**"Tap FALSE"**<br>[☑]: While the mouse button is pressed, the image of the "Image" property is displayed and the "Variable" property gets the value FALSE instead of the value TRUE, and back.

Requirement: "Image tapper" is selected in the "Element behavior" property.

**Element property 'Center'**<br>The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the ⬤ symbol. The point is used as the center for rotating and scaling.

| “X” | X-coordinate of the point of rotation |
| “Y” | Y-coordinate of the point of rotation |

You can also change the values by dragging the symbols (⬤) to other positions in the editor.

**Element property 'Texts'**
**“Tooltip”**

String display as tooltip for the element

*Example:* Valid access.

---

**Element property 'Absolute movement'*
The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

---

<table>
<thead>
<tr>
<th><strong>“Movement”</strong></th>
<th></th>
</tr>
</thead>
</table>
| **“X”** | Variable (numeric data type). Defines the X position (in pixels).  
*Example:* PLC_PRG.iPos_X.  
Increasing this value in runtime mode moves the element to the right. |
| **“Y”** | Variable (numeric data type). Defines the Y position (in pixels).  
*Example:* PLC_PRG.iPos_Y.  
Increasing this value in runtime mode moves the element downwards. |

---

<table>
<thead>
<tr>
<th><strong>“Rotation”</strong></th>
<th></th>
</tr>
</thead>
</table>
| **“Rotation”** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
*Example:* PLC_PRG.iAngle1.  
The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.  
In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right. |

---

<table>
<thead>
<tr>
<th><strong>“Interior rotation”</strong></th>
<th></th>
</tr>
</thead>
</table>
| **“Interior rotation”** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
*Example:* PLC_PRG.iAngle2.  
In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.  
The rotation point is shown as the symbol.  
Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed. |

---

You can link the variables to a unit conversion.
The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- 

**Element property 'State variables'**

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>Property</th>
<th>Variable (BOOL). Toggles the visibility of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Invisible”</td>
<td>TRUE: The element is not visible at runtime.</td>
</tr>
<tr>
<td></td>
<td>Example: bIsVisible with VAR bIsVisible : BOOL := FALSE;</td>
</tr>
<tr>
<td></td>
<td>END_VAR</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Property</th>
<th>Variable (BOOL). Toggles the operability of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Deactivate inputs”</td>
<td>TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.</td>
</tr>
</tbody>
</table>

The “Invisible” property is supported by the “Client Animation” functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
**“Animation duration”**

Defines the duration (in milliseconds) in which the element runs an animation.

- **Variable (integer value)**
  
  **Example:**
  ```
  Menu.tContent with VAR tContent : INT := 500;
  END_VAR
  ```

- **Integer literal**
  
  **Example:** 500

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**“Move to foreground”**

Moves the visualization element to the foreground.

**Variable (BOOL)**

**Example:**
```
VAR bIsInForeground : BOOL := FALSE; END_VAR
```

**TRUE:** At runtime, the visualization element is displayed in the foreground.

**FALSE:** At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

**Element property ‘Access rights’**

Requirement: User management is set up for the visualization.

**“Access rights”**

Opens the “Access rights” dialog. There you can edit the access privileges for the element.

**Status messages:**

- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also

- ⏩ Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

See also

- ⏩ Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

**Visualization Element ‘Lamp’**

**Symbol:**

![Symbol](image)

**Category: “Lamps/Switches/Bitmaps”**

The element shows the value of a variable, and the element is displayed as illuminated or not.
Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
<tr>
<td>Example: Lamp_green</td>
<td></td>
</tr>
</tbody>
</table>

| “Type of element” | “Lamp” |

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Width”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 150</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Height”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (мышь) to other positions in the editor.

See also
- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

<table>
<thead>
<tr>
<th>“Variable”</th>
<th>Variable (BOOL).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The variable value is displayed as a lamp that goes on (TRUE) or off (FALSE).</td>
</tr>
</tbody>
</table>

Image settings

<table>
<thead>
<tr>
<th>“Transparency”</th>
<th>The “Transparent color” property is selected.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Transparent color”</th>
<th>Pixels in this color are displayed as transparent.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Requirement: “Transparency” is activated.</td>
</tr>
<tr>
<td></td>
<td>• The “Color” dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>• A drop-down list with style colors opens.</td>
</tr>
</tbody>
</table>
### “Scaling type”

<table>
<thead>
<tr>
<th>Reaction of the element when the dimension of the “Frame” element is changed:</th>
</tr>
</thead>
<tbody>
<tr>
<td>● “Isotropic”: The height and width of the image are resized proportionally to the “Frame”.</td>
</tr>
<tr>
<td>Please note: To retain the alignment of elements also within a scaled “Frame” element, define the “Horizontal alignment” or “Vertical alignment” explicitly with “Centered”.</td>
</tr>
<tr>
<td>● “Anisotropic”: The image fills the entire “Frame” regardless of its proportions.</td>
</tr>
</tbody>
</table>

### “Horizontal alignment”

<table>
<thead>
<tr>
<th>Horizontal alignment of the image within the element frame or element</th>
</tr>
</thead>
<tbody>
<tr>
<td>● Left</td>
</tr>
<tr>
<td>● Centered</td>
</tr>
<tr>
<td>● Right</td>
</tr>
</tbody>
</table>

Requirement: “Scaling type” is “Isotropic”.

### “Vertical alignment”

<table>
<thead>
<tr>
<th>Vertical alignment of the image within the element frame or element</th>
</tr>
</thead>
<tbody>
<tr>
<td>● Top</td>
</tr>
<tr>
<td>● Centered</td>
</tr>
<tr>
<td>● Bottom</td>
</tr>
</tbody>
</table>

Requirement: “Scaling type” is “Isotropic”.

### Element property ‘Center’

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
<td>X-coordinate of the point of rotation</td>
</tr>
<tr>
<td>“Y”</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (white arrow) to other positions in the editor.

### Element property ‘Texts’

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Tooltip”</td>
<td>String display as tooltip for the element</td>
</tr>
<tr>
<td>Example: Valid access.</td>
<td></td>
</tr>
</tbody>
</table>

### Element property 'Absolute movement'

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Movement”</td>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
</tr>
<tr>
<td>Example: PLC_PRG.iPos_X.</td>
<td></td>
</tr>
<tr>
<td>Increasing this value in runtime mode moves the element to the right.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Variable (numeric data type). Defines the Y position (in pixels).</td>
</tr>
<tr>
<td>Example: PLC_PRG.iPos_Y.</td>
<td></td>
</tr>
<tr>
<td>Increasing this value in runtime mode moves the element downwards.</td>
<td></td>
</tr>
</tbody>
</table>
"Rotation" Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle1.

The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.

In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

"Interior rotation" Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the “Position Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the "Client Animation" functionality.

See also

The variables control the element behavior dynamically.

"Invisible" Variable (BOOL). Toggles the visibility of the element.

TRUE: The element is not visible at runtime.

The “Invisible” property is supported by the "Client Animation" functionality.
These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Animation duration&quot;</td>
<td>Defines the duration (in milliseconds) in which the element runs an animation</td>
</tr>
<tr>
<td></td>
<td>● Variable (integer value)</td>
</tr>
<tr>
<td></td>
<td>Example: Menu.tContent with VAR tContent : INT := 500; END_VAR</td>
</tr>
<tr>
<td></td>
<td>● Integer literal</td>
</tr>
<tr>
<td></td>
<td>Example: 500</td>
</tr>
<tr>
<td></td>
<td>Animatable properties</td>
</tr>
<tr>
<td></td>
<td>● “Absolute movement”, “Movement”, “X”, “Y”</td>
</tr>
<tr>
<td></td>
<td>● “Absolute movement”, “Rotation”</td>
</tr>
<tr>
<td></td>
<td>● “Absolute movement”, “Interior rotation”</td>
</tr>
<tr>
<td></td>
<td>● “Absolute movement”, “Exterior rotation”</td>
</tr>
<tr>
<td></td>
<td>The animated movement is executed when at least one value of an animatable</td>
</tr>
<tr>
<td></td>
<td>property has changed. The movement then executed is not jerky, but is</td>
</tr>
<tr>
<td></td>
<td>smooth within the specified animation duration. The visualization element</td>
</tr>
<tr>
<td></td>
<td>travels to the specified position while rotating dynamically. The</td>
</tr>
<tr>
<td></td>
<td>transitions are smooth.</td>
</tr>
</tbody>
</table>

| "Move to foreground"      | Moves the visualization element to the foreground                         |
|                           | Variable (BOOL)                                                          |
|                           | Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR|
|                           | TRUE: At runtime, the visualization element is displayed in the foreground.|
|                           | FALSE: At runtime, the visualization element is displayed in the layer    |
|                           |   where it was inserted in the visualization editor.                      |

Element property 'Background'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Image&quot;</td>
<td>Drop-down list with background colors</td>
</tr>
<tr>
<td></td>
<td>Depends on the visualization style</td>
</tr>
</tbody>
</table>

Element property 'Access rights'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Access rights&quot;</td>
<td>Opens the “Access rights” dialog. There you can edit the access privileges for the element.</td>
</tr>
<tr>
<td></td>
<td>Status messages:</td>
</tr>
<tr>
<td></td>
<td>● “Not set. Full rights.”: Access rights for all user groups : “operable”</td>
</tr>
<tr>
<td></td>
<td>● “Rights are set: Limited rights”: Access is restricted for at least one group.</td>
</tr>
</tbody>
</table>

See also
- Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

See also
- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
Visualization Element 'Dip Switch', 'Power Switch', 'Push Switch', 'Push Switch LED', 'Rocker Switch'

Symbols:

Category: “Lamps/Switches/Bitmaps”

The element assigns a value to a Boolean variable. The switch position "on" the value TRUE to the variable, and the switch position "off" assigns the value FALSE. Use the mouse to change the switch position.

**Element properties**

<table>
<thead>
<tr>
<th>&quot;Element name&quot;</th>
<th>Example: Operating_Switch</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
</tbody>
</table>

| "Type of element" | Depending on the element: “Dip Switch”, “Power Switch”, “Push Switch”, “Push Switch LED”, or “Rocker Switch” |

**Element property 'Position'**

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>&quot;X&quot;</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in pixels.</td>
<td></td>
</tr>
<tr>
<td>Example: 10.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Y&quot;</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in pixels.</td>
<td></td>
</tr>
<tr>
<td>Example: 10.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Width&quot;</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 150</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Height&quot;</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 30</td>
<td></td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (貘) to other positions in the editor.

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

<table>
<thead>
<tr>
<th>&quot;Variable&quot;</th>
<th>Variable (BOOL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The value of the variables TRUE and FALSE indicates the switch position on/off.</td>
<td></td>
</tr>
</tbody>
</table>
Image settings

"Transparency"  [✔]: The “Transparent color” property is selected.

"Transparent color"  Pixels in this color are displayed as transparent.
Requirement: “Transparency” is activated.
  ●  The “Color” dialog box opens.
  ●  ▼: A drop-down list with style colors opens.

"Scaling type"  Reaction of the element when the dimension of the “Frame” element is changed:
  ●  “Isotropic”: The height and width of the image are resized proportionally to the “Frame”.
    Please note: To retain the alignment of elements also within a scaled “Frame” element, define the “Horizontal alignment” or “Vertical alignment” explicitly with “Centered”.
  ●  “Anisotropic”: The image fills the entire “Frame” regardless of its proportions.

"Horizontal alignment"  Horizontal alignment of the image within the element frame or element
  ●  Left
  ●  Centered
  ●  Right
Requirement: “Scaling type” is “Isotropic”.

"Vertical alignment"  Vertical alignment of the image within the element frame or element
  ●  Top
  ●  Centered
  ●  Bottom
Requirement: “Scaling type” is “Isotropic”.

"Element behavior"
  ●  “Image toggler”: Every mouse click changes the switch and the “Variable” value.
  ●  “Image tapper”: The switch is "on" and the “Variable” value is TRUE while the mouse button is pressed.

"Tap FALSE"  [✔]: The value TRUE is assigned to the “Variable” property instead of the value FALSE, and back.
Requirement: “Image tapper” is selected in the “Element behavior” property.

Element property 'Center'  The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols to other positions in the editor.

Element property 'Texts'
**Element property 'Absolute movement'**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th><strong>Property</strong></th>
<th>Description</th>
<th>Example</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tooltip</strong></td>
<td>String display as tooltip for the element</td>
<td>Example: Valid access.</td>
<td></td>
</tr>
<tr>
<td><strong>Movement</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>X</strong></td>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
<td>PLC_PRG.iPos_X.</td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td><strong>Y</strong></td>
<td>Variable (numeric data type). Defines the Y position (in pixels).</td>
<td>PLC_PRG.iPos_Y.</td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
</tr>
<tr>
<td><strong>Rotation</strong></td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
<td>PLC_PRG.iAngle1.</td>
<td>The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol. In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
</tr>
<tr>
<td><strong>Interior rotation</strong></td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
<td>PLC_PRG.iAngle2.</td>
<td>In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise. The rotation point is shown as the symbol. Note: If a static angle of rotation is specified in the &quot;Position ➔ Angle&quot; property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.</td>
</tr>
</tbody>
</table>

You can link the variables to a unit conversion.
The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- 

**Element property 'State variables'**

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Deactivate inputs”</td>
<td>Variable (BOOL). Toggles the operability of the element. True: User inputs do not have any effect in runtime more. The element is shown as deactivated.</td>
</tr>
</tbody>
</table>

The “Invisible” property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
**“Animation duration”**
Defines the duration (in milliseconds) in which the element runs an animation

- **Variable (integer value)**
  
  *Example:* `Menu.tContent with VAR tContent : INT := 500; END_VAR`

- **Integer literal**
  *Example:* `500`

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**“Move to foreground”**
Moves the visualization element to the foreground

**Variable (BOOLEAN)**

*Example:* `bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR`

TRUE: At runtime, the visualization element is displayed in the foreground.
FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

**Element property 'Background'**

**“Image”**
Drop-down list with background colors

Depends on the visualization style

**Element property 'Access rights'**

Requirement: User management is set up for the visualization.

**“Access rights”**
Opens the “Access rights” dialog. There you can edit the access privileges for the element.

Status messages:

- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also

- § Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

See also

- § Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

**Visualization Element 'Rotary Switch'**

Symbol:
Category: “Lamps/Switches/Bitmaps”

The element assigns a value to a Boolean variable. The switch position "on" the value TRUE to the variable, and the switch position "off" assigns the value FALSE. Use the mouse to change the switch position.

Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: Operating_Switch</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Type of element”</th>
<th>“Rotary Switch”</th>
</tr>
</thead>
</table>

Element property 'Position'

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Width”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 150</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Height”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (◮) to other positions in the editor.

See also

- Chapter 6.4.5.3.3 “Positioning the Element, Adapting Size and Layer” on page 2874

<table>
<thead>
<tr>
<th>“Variable”</th>
<th>Variable (BOOL).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The value of the variables TRUE and FALSE indicates the switch position on/off.</td>
</tr>
</tbody>
</table>

Image settings
"Transparency"  ☑: The "Transparent color" property is selected.

"Transparent color"  
Pixels in this color are displayed as transparent.
Requirement: "Transparency" is activated.
- ☑: The "Color" dialog box opens.
- ▼: A drop-down list with style colors opens.

"Scaling type"  
Reaction of the element when the dimension of the "Frame" element is changed:
- "Isotropic": The height and width of the image are resized proportionally to the "Frame".
  Please note: To retain the alignment of elements also within a scaled "Frame" element, define the "Horizontal alignment" or "Vertical alignment" explicitly with "Centered".
- "Anisotropic": The image fills the entire "Frame" regardless of its proportions.

"Horizontal alignment"  
Horizontal alignment of the image within the element frame or element
- Left
- Centered
- Right
Requirement: "Scaling type" is "Isotropic".

"Vertical alignment"  
Vertical alignment of the image within the element frame or element
- Top
- Centered
- Bottom
Requirement: "Scaling type" is "Isotropic".

"Element behavior"  
- "Image toggler": Every mouse click changes the switch and the "Variable" value.
- "Image tapper": The switch is "on" and the "Variable" value is TRUE while the mouse button is pressed.

"Orientation"  
- "At top": The rotary switch turns from the top right to the top left.
- "At side": The rotary switch turns from the top right to the bottom right.

"Color change"  ☑: The element changes in color when "Variable" is TRUE.

**Element property ‘Center’**  
The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>&quot;X&quot;</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Y&quot;</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols to other positions in the editor.

**Element property ‘Texts’**
**Tooltip**

String display as tooltip for the element

**Example:** Valid access.

---

**Element property 'Absolute movement'**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

---

**“Movement”**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“X”</strong></td>
<td>Variable (numeric data type). Defines the X position (in pixels). Increasing this value in runtime mode moves the element to the right.</td>
<td>PLC_PRG.iPos_X.</td>
</tr>
<tr>
<td><strong>“Y”</strong></td>
<td>Variable (numeric data type). Defines the Y position (in pixels). Increasing this value in runtime mode moves the element downwards.</td>
<td>PLC_PRG.iPos_Y.</td>
</tr>
</tbody>
</table>

---

**“Rotation”**

Variable (numeric data type). Defines the angle of rotation (in degrees). The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.

In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

**“Interior rotation”**

Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

---

You can link the variables to a unit conversion.
The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- 

**Element property 'State variables'**

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>Variable (BOOL)</th>
<th>Toggles the visibility of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRUE: The element is not visible at runtime.</td>
<td></td>
</tr>
<tr>
<td>Example: bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Variable (BOOL)</th>
<th>Toggles the operability of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.</td>
<td></td>
</tr>
</tbody>
</table>

The “Invisible” property is supported by the “Client Animation” functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
“Animation duration”

Defines the duration (in milliseconds) in which the element runs an animation

- Variable (integer value)
  Example: Menu.tContent with
  ```
  VAR tContent : INT := 500;
  END_VAR
  ```

- Integer literal
  Example: 500

Animatable properties

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

“Move to foreground”

Moves the visualization element to the foreground

Variable (BOOL)

Example: bIsInForeground with
```
VAR bIsInForeground : BOOL := FALSE; END_VAR
```

TRUE: At runtime, the visualization element is displayed in the foreground.
FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

Element property 'Background'

“Image”

Drop-down list with background colors

Depends on the visualization style

Element property 'Access rights'

Requirement: User management is set up for the visualization.

“Access rights”

Opens the “Access rights” dialog. There you can edit the access privileges for the element.

Status messages:

- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also

- ¶ Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

See also

- ¶ Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

Visualization Element 'Trace'

Symbol:
Category: “Special Controls”

The element displays the graphical curve of variable values. In addition, variables can be configured to control the view.

See also
- § Chapter 6.4.5.12 “Displaying data curve with trace” on page 2925
- § “Dialog box 'Trace Configuration’” on page 3355

### Element properties

<table>
<thead>
<tr>
<th><strong>“Element name”</strong></th>
<th><strong>Example:</strong> Velocity</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Data Source”</strong></td>
<td>Location where the trace data is buffered.</td>
</tr>
<tr>
<td></td>
<td>- “&lt;local application&gt;”*: The trace record is listed below the local application. The visualization that contains the trace is located below this application. When the application is downloaded, the trace configuration is downloaded to the local device. During execution, the data is stored locally in the trace buffer.</td>
</tr>
<tr>
<td></td>
<td>- “&lt;data source name&gt;”*: Data source that identifies the remote device where the trace record is created. When the local application is downloaded with the visualization, the trace configuration is downloaded to the remote device. During execution, the trace buffer is filled, and the trace data is transferred and then displayed in the local visualization as HMI. Example: DataSoure_PLC_A Note: The trace buffer is filled only if the remote application is being executed. The data recording is started when the local visualization is started.</td>
</tr>
</tbody>
</table>

| **“Application”** | Application where data was recorded. |
|                  | - : Lists all applications that are present below the data source. |
|                  | Requirement: A remote data source (not “<local application>”) is referenced in the “Data source” property. |
| **“Type of element”** | “Trace” |
| **“Trace”** | “<name of trace configuration>”\*: Opens the “Trace Configuration” dialog where you can modify the trace configuration. |

See also
- § “Dialog box ‘Trace Configuration’” on page 3355
- **Data Source Manager**

### Element property ‘Position’

The position defines the location and size of the element in the visualization window. This is based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.
### Properties of the Element

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>X</strong></td>
<td>The x-coordinate of the upper left corner of the element. Specified in pixels. Example: 10</td>
</tr>
<tr>
<td><strong>Y</strong></td>
<td>The y-coordinate of the upper left corner of the element. Specified in pixels. Example: 10</td>
</tr>
<tr>
<td><strong>Width</strong></td>
<td>Specified in pixels. Example: 150</td>
</tr>
<tr>
<td><strong>Height</strong></td>
<td>Specified in pixels. Example: 30</td>
</tr>
<tr>
<td><strong>Angle</strong></td>
<td>Static angle of rotation (in degrees). Example: 35</td>
</tr>
</tbody>
</table>

**Tip:** You can change the values in “X”, “Y”, “Width”, and “Height” by dragging the corresponding symbols to another position in the editor.

**Angle**

The element is displayed rotated in the editor. The point of rotation is the center of the element. A positive value rotates clockwise.

**Tip:** You can change the value in the editor by focusing the element to the handle. When the cursor is displayed as a rotating arrow, you can rotate the element about its center as a handle.

![Diagram of handle](image)

(1): Handle

Note: If a dynamic angle of rotation is also configured in the property “Absolute movement → Internal rotation”, then the static and dynamic angles of rotation are added in runtime mode. The static angle of rotation acts as an offset.

---

### Additional Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show cursor</strong></td>
<td>A cursor (vertical line) is displayed at the mouse position.</td>
</tr>
<tr>
<td><strong>Overwrite existing trace on PLC</strong></td>
<td>If a trace with the same name is on the PLC, then it is overwritten at download with the configuration that is defined here.</td>
</tr>
<tr>
<td><strong>Number format</strong></td>
<td>Number format of values in the tooltip in printf syntax (example: %d, %.2f).</td>
</tr>
</tbody>
</table>

---

**Element property 'Control variables'**

The control variables are assigned automatically when you click “Insert elements for controlling Trace”.

---

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874
"Reset Trigger" Variable (BOOL).
Standard control variable: bResetTrigger
TRUE: Resets the triggering. After the action is executed, the variable is set automatically to FALSE.

"Start Trace" Variable (BOOL).
Standard control variable: bStart
TRUE: Starts the Trace. After the action is executed, the variable is set automatically to FALSE.

"Stop Trace" Variable (BOOL).
Standard control variable: bStop
TRUE: Stops the Trace. After the action is executed, the variable is set automatically to FALSE.

"Save Trace to a file"

"Save Trace" Variable (BOOL).
Standard control variable: bStore
TRUE: Saves the current trace configuration and the data that is stored in the development system to a file. When the action is ended, the variable is set automatically to FALSE.

"File name" Variable (STRING) that contains the file name of the file to be saved.
Standard control variable: sStoreFilename

"Load trace from file"

"Load Trace" Variable (BOOL).
Standard control variable: bRestore
TRUE: Reads the file specified below and loads its contents into the trace editor. The file contains a trace configuration and possibly also trace data. To do this, the stored trace configuration must match the application where the trace configuration is located. When the action is ended, the variable is set automatically to FALSE.

Note: A trace configuration can be loaded from a file only under special circumstances. The file must have been created with exactly the same (running) application with which it will then be loaded. The consequence of changing the running application (for example by downloading again) is that a file which was previously created from the application cannot no longer be read into the application. Even external manual changes to the file can cause this. You should edit only those configuration settings that have an effect on displaying the variables. If you change variable definitions directly in the file (for example by replacing variable x with v y), then the file cannot be loaded.

"File name" Variable (STRING) that contains the file name of the file to be read.
Standard variable: sRestoreFilename

See also

- § Chapter 6.4.5.21.2.15 “Command 'Insert Elements for Controlling Trace'” on page 3358

Element property 'Center' The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.
**Element property 'Absolute movement'**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“X”</strong></td>
<td>X-coordinate of the point of rotation</td>
</tr>
<tr>
<td><strong>“Y”</strong></td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (⊕) to other positions in the editor.

---

**“Movement”**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| **“X”** | Variable (numeric data type). Defines the X position (in pixels).  
**Example:** PLC_PRG.iPos_X.  
Increasing this value in runtime mode moves the element to the right. |
| **“Y”** | Variable (numeric data type). Defines the Y position (in pixels).  
**Example:** PLC_PRG.iPos_Y.  
Increasing this value in runtime mode moves the element downwards. |

**“Rotation”**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| **“X”** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
**Example:** PLC_PRG.iAngle1.  
The midpoint of the element rotates at the “Center” point. This rotation point is shown as the ⊕ symbol.  
In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right. |

**“Interior rotation”**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| **“X”** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
**Example:** PLC_PRG.iAngle2.  
In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.  
The rotation point is shown as the ⊕ symbol.  
Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed. |
You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- The variables control the element behavior dynamically.

**Element property 'State variables'**

<table>
<thead>
<tr>
<th>Variable (BOOL)</th>
<th>Toggles the visibility of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Invisible&quot;</td>
<td>TRUE: The element is not visible at runtime.</td>
</tr>
</tbody>
</table>

The “Invisible” property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
“Animation duration”
Defines the duration (in milliseconds) in which the element runs an animation

- Variable (integer value)
  Example: Menu.tContent with VAR tContent : INT := 500; END_VAR
- Integer literal
  Example: 500

Animatable properties
- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

“Move to foreground”
Moves the visualization element to the foreground

Variable (BOOL)
Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR
TRUE: At runtime, the visualization element is displayed in the foreground.
FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

Element property 'Access rights'
Requirement: User management is set up for the visualization.

“Access rights”
Opens the “Access rights” dialog. There you can edit the access privileges for the element.

Status messages:
- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also
- Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

Visualization Element ‘Trend’

Symbol:

Category: “Special Controls”
The element displays the curve of variable values as a trend diagram. The trend diagram is suitable for representing a long-term data curve because the data is read from a trend recording and hence from a database. Moreover, you can run the “Trend” element together with the “Date Range Picker”, “Legend”, and “Time Range Picker” operating elements so that the user can navigate conveniently in the diagram.
You can programmatically delete the recorded trend curve at runtime. The recording starts again from the time of deletion. See the help page for "Programming a Trend Visualization".

**Element properties**

<table>
<thead>
<tr>
<th>&quot;Element name&quot;</th>
<th>Example: Velocity</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Data source&quot;</td>
<td>Data source for the connection via the device and the application to the &quot;Trend Recording&quot; object where the trend data that you want to show was saved.</td>
</tr>
<tr>
<td></td>
<td>If the &quot;Trend Recording&quot; object is on the local device, then it is sufficient when you specify the respective application. If the trend recording is on a remote device, then you need to specify the data source connection to this device.</td>
</tr>
<tr>
<td></td>
<td>● “&lt;local application&gt;” The &quot;Trend Recording&quot; object is located on the local device in the local application.</td>
</tr>
<tr>
<td></td>
<td>● &lt;device name&gt; . &lt;application name&gt; Example: Device_A.App_A The &quot;Trend Recording&quot; object is located on the local device Device_A below the application App_A.</td>
</tr>
<tr>
<td></td>
<td>● &lt;data source name&gt; Example: DataSource_B The &quot;Trend Recording&quot; object is located on a remote device that is connected via the data source DataSource_B. Below the (now visible) &quot;Application&quot; property, the remote application is displayed as configured in the data source. Example: App_B Note: If the data source is accessed symbolically by means of a symbol file (CODESYS symbolic), then the required symbol file and the corresponding project have to be saved in the same folder.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Type of element&quot;</th>
<th>&quot;Trend&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Trend recording&quot;</td>
<td>📊: Trend recording whose data is displayed as a diagram</td>
</tr>
<tr>
<td></td>
<td>The trend recording is located on the device specified in the &quot;Data source&quot; property.</td>
</tr>
</tbody>
</table>

| "Display Mode" | 📊: Opens the "Display Settings" dialog. |

See also

- Chapter 6.4.5.13 “Displaying data curve with trend” on page 2928
- Chapter 6.4.5.21.2.12 “Command ‘Configure Display Settings of Trend’” on page 3353
- Object ‘Data Source’

**Element property ‘Position’**

The position defines the location and size of the element in the visualization window. This is based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.
| **“X”** | The x-coordinate of the upper left corner of the element  
Specified in pixels  
Example: 10 |
| **“Y”** | The y-coordinate of the upper left corner of the element  
Specified in pixels  
Example: 10 |
| **“Width”** | Specified in pixels  
Example: 150 |
| **“Height”** | Specified in pixels  
Example: 30 |
| **“Angle”** | Static angle of rotation (in degrees)  
Example: 35  
The element is displayed rotated in the editor. The point of rotation is the center of the element. A positive value rotates clockwise.  
Tip: You can change the value in the editor by focusing the element to the handle. When the cursor is displayed as a rotating arrow, you can rotate the element about its center as a handle. |

(1): Handle  
Note: If a dynamic angle of rotation is also configured in the property “Absolute movement ➔ Internal rotation”, then the static and dynamic angles of rotation are added in runtime mode. The static angle of rotation acts as an offset.

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874
### “Show cursor”
A cursor (black triangle with vertical line) is shown in the trend diagram.

**Behavior at runtime:** As soon as the graph is drawn, the user can move the cursor along the time axis in order to mark a specific time. Then the variable value belonging to the cursor position is displayed in the legend above the graph.

![Trend diagram with cursor](image)

### “Show tooltip”
Requirement: “Show cursor” is activated.

- A tooltip opens at the cursor.

**Behavior at runtime:** The variable value belonging to the cursor position is displayed as a tooltip.

### “Show frame”
- The trend diagram is drawn with a frame.

### “Number format”
- Format specification in printf syntax, which determines how the values are displayed in the tooltip and in the legend

Example: `%d` (integer variable) or `%5.2f` (floating-point number)

---

**Element property 'Tick mark labels'**

The time stored in the trend recording are in the UTC time zone. If the time is displayed in the trend of the visualization element, then the time stamps are converted to the local time zone of the operating system of the PLC.

Change the time zone in the operating system if the times in the trend diagram are not in the zone that you need.
### “Time stamps”

<table>
<thead>
<tr>
<th>X-value of the trend diagram</th>
<th>“Absolute time stamps”</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The absolute time with date and time is displayed at each tick mark on the time axis.</td>
</tr>
<tr>
<td>Example:</td>
<td>03/18/2016 12h30m50s</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Relative time stamps”</th>
</tr>
</thead>
<tbody>
<tr>
<td>The time period from the start of the recording (=0) is displayed at each tick mark.</td>
</tr>
<tr>
<td>Example:</td>
</tr>
</tbody>
</table>

### “Draw labels on two lines”

| ☑: The time stamps are displayed on two lines (for example, the date is displayed on the first line and the time on the second line). |
| ☐: The time stamp is displayed on one line. Example: 2019-11-01-12:30:50. |

### “Omit irrelevant information in timestamps”

| ☑: The time stamps are displayed in a truncated form (without insignificant information). For example, the date is displayed at the first tick mark, and only the time is displayed at the following tick marks. The “Internationalization (format strings)” property is not visible and is ignored. |
| ☐: The time stamps are displayed with all information. This takes into consideration the “Internationalization (format strings)” property which contains the format specification for the date and time display. |

### “Internationalization (format strings)”

Format specification for the date and time display of the time stamp (when it is displayed in full)

Note: The property is visible only if the “Omit irrelevant information in timestamps” option is **not** selected.
### "Date"

Format string that returns the date display according to the defined format. The operating system locale is used as the default setting.

Defined format strings for the date:
- **Year**: yyyy, yy, y
- **Month**: MM, M
- **Day**: dd, d
- **Recommended separator**: - . /

Example:
- yyyy-MM-d displays 2019-10-25
- yyyy-MM-dd displays 2019-10-25
- dd.MM.yyyy displays 25.10.2019
- dd/MM/yyyy displays 25/10/2019

### "Time"

Format string that returns the time (or time of day) display according to the defined format. The operating system locale is used as the default setting.

Defined format strings for the time:
- **24-hour time definition**: HH, H
- **12-hour time definition**: hh, h
- **AM/PM for 12-hour time definition**: tt
- **Minutes**: mm, m
- **Seconds**: ss, s
- **Milliseconds**: ms
- **Microseconds**: us
- **Recommended separator**: : or space character

Example:
- HH:mm:ss:ms displays 15:30:59:123
- h:mm:ss tt displays 3:30:59 PM

See also
- Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329

### Element property 'Assigned control elements'

These elements are created automatically when the control elements are added with the command “Insert elements for controlling Trend”.

<table>
<thead>
<tr>
<th>&quot;Date Range Picker&quot;</th>
<th>Control element for changing the date and time of the displayed data sets. With [xxx], all elements are provided that have implemented the interface IDateRangeSelector. By default, instances of the &quot;Date Range Picker&quot; visualization element are available.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Time Range Picker&quot;</td>
<td>Control element for changing the time of the displayed data sets. With [xxx], all elements are provided that have implemented the interface ITimeSelector. By default, instances of the &quot;Time Range Picker&quot; visualization element are available.</td>
</tr>
<tr>
<td>&quot;Legend&quot;</td>
<td>Control element for displaying a legend for the graphs. With [xxx], all elements are provided that have implemented the interface ILegendDisplayer.</td>
</tr>
</tbody>
</table>

See also
- Chapter 6.4.5.21.2.18 “Command 'Insert Elements for Controlling the Trend’” on page 3360
Element property 'Center'  
The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>X-coordinate of the point of rotation</td>
</tr>
<tr>
<td>Y</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (symbol) to other positions in the editor.

Element property 'Absolute movement'  
The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

**“Movement”**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| X        | Variable (numeric data type). Defines the X position (in pixels).  
Example: PLC_PRG.iPos_X.  
Increasing this value in runtime mode moves the element to the right. |
| Y        | Variable (numeric data type). Defines the Y position (in pixels).  
Example: PLC_PRG.iPos_Y.  
Increasing this value in runtime mode moves the element downwards. |

**“Rotation”**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| X        | Variable (numeric data type). Defines the angle of rotation (in degrees).  
Example: PLC_PRG.iAngle1.  
The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.  
In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right. |

**“Interior rotation”**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| X        | Variable (numeric data type). Defines the angle of rotation (in degrees).  
Example: PLC_PRG.iAngle2.  
In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.  
The rotation point is shown as the symbol.  
Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed. |
You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- The variables control the element behavior dynamically.

**Element property ‘State variables’**

<table>
<thead>
<tr>
<th>“Invisible”</th>
<th>Variable (BOOL). Toggles the visibility of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>TRUE</strong>: The element is not visible at runtime.</td>
</tr>
</tbody>
</table>

The “Invisible” property is supported by the “Client Animation” functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
**“Animation duration”**

Defines the duration (in milliseconds) in which the element runs an animation

- **Variable (integer value)**
  
  **Example:**
  ```
  Menu.tContent with VAR tContent : INT := 500;
  END_VAR
  ```

- **Integer literal**
  
  **Example:** 500

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**“Move to foreground”**

Moves the visualization element to the foreground

**Variable (BOOL)**

**Example:**

```
VAR bIsInForeground : BOOL := FALSE; END_VAR
```

**TRUE:** At runtime, the visualization element is displayed in the foreground.

**FALSE:** At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

---

**Element property ‘Access rights’**

Requirement: User management is set up for the visualization.

**“Access rights”**

Opens the “Access rights” dialog. There you can edit the access privileges for the element.

**Status messages:**

- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also

- § Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

See also

- § Chapter 6.4.5.13 “Displaying data curve with trend” on page 2928
- § Chapter 6.4.5.13.2 “Getting Started with Trend Visualization” on page 2928
- § Chapter 6.4.5.13.3 “Programming a Trend Visualization” on page 2931
- **Object ‘Trend Recording’**

---

**Visualization Element ‘Legend’**

**Symbol:**

![Symbol](image)

**Category:** “Special Controls”
The element is used as a legend for another element (for example, a trend). The legend is assigned in the properties of the other element.

See also
- Chapter 6.4.5.13 “Displaying data curve with trend” on page 2928

### Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: LegendOfTrendA</th>
</tr>
</thead>
</table>

**Optional**

Hint: Assign individual names for elements so that they are found faster in the element list.

<table>
<thead>
<tr>
<th>“Type of element”</th>
<th>“Legend”</th>
</tr>
</thead>
</table>

### Element property 'Position'

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

| “X” | X coordinate of the upper left corner of the element  
Specified in pixels.  
Example: 10. |
|------|--------------------------------------------------|

| “Y” | Y coordinate of the upper left corner of the element  
Specified in pixels.  
Example: 10. |
|------|--------------------------------------------------|

| “Width” | Specified in pixels.  
Example: 150 |
|---------|--------------------------------------------------|

| “Height” | Specified in pixels.  
Example: 30 |
|----------|--------------------------------------------------|

You can also change the values by dragging the box symbols (🧱) to other positions in the editor.

See also
- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

### Element property 'Center'

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the ⌀ symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y-coordinate of the point of rotation</th>
</tr>
</thead>
</table>
You can also change the values by dragging the symbols (¶) to other positions in the editor.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Orientation”</td>
<td>Orientation of the element. The value is configured in the assigned element.</td>
</tr>
<tr>
<td></td>
<td>- “Horizontal”</td>
</tr>
<tr>
<td></td>
<td>- “Vertical”</td>
</tr>
<tr>
<td>“Attached element instance”</td>
<td>Example: Element_A</td>
</tr>
<tr>
<td>“Show frame”</td>
<td>☑: The element is displayed with frames.</td>
</tr>
<tr>
<td>“Number format”</td>
<td>The format of the value in printf syntax (example: %d, %5.2f)</td>
</tr>
</tbody>
</table>

### Element Property 'Layout'

Defines how many variables can be displayed at a maximum and is calculated from the row and column number.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Max. number of rows”</td>
<td>Example: 3</td>
</tr>
<tr>
<td>“Max. number of columns”</td>
<td>Example: 2</td>
</tr>
</tbody>
</table>

### Element Property 'Text properties'

The property affects the text configured in the associated element.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Text format”</td>
<td>“Default”: The text will be cut and displayed in only the part that fits into the visualization element.</td>
</tr>
<tr>
<td></td>
<td>“Linebreak”: The text will be wrapped in rows.</td>
</tr>
<tr>
<td></td>
<td>“Ellipsis”: The text is cut and ellipsis ... are added to indicate that something is missing.</td>
</tr>
<tr>
<td>“Font”</td>
<td>Font of the text. The entries of the selection list are defined in the visualization style.</td>
</tr>
<tr>
<td>“Font color”</td>
<td>Text color, for example Grey. The entries of the selection list are defined in the visualization style.</td>
</tr>
<tr>
<td>“Transparency”</td>
<td>Transparency value (255 to 0), which defines the transparency of the corresponding color. Example: 255: The color is opaque. 0: The color is fully transparent.</td>
</tr>
</tbody>
</table>

### Element property 'Absolute movement'

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Movement”</td>
<td></td>
</tr>
<tr>
<td>“X”</td>
<td>Variable (numeric data type). Defines the X position (in pixels). Example: PLC_PRG.iPos_X.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
</tbody>
</table>
### “Y”
Variable (numeric data type). Defines the Y position (in pixels).

**Example:** PLC_PRG.iPos_Y.

Increasing this value in runtime mode moves the element downwards.

### “Rotation”
Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** PLC_PRG.iAngle1.

The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.

In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

### “Interior rotation”
Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

---

You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- 

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
<table>
<thead>
<tr>
<th><strong>“Animation duration”</strong></th>
<th>Defines the duration (in milliseconds) in which the element runs an animation</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Variable (integer value)</td>
<td>Example: <code>Menu.tContent with VAR tContent : INT := 500; END_VAR</code></td>
</tr>
<tr>
<td>• Integer literal</td>
<td>Example: 500</td>
</tr>
</tbody>
</table>

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

<table>
<thead>
<tr>
<th><strong>“Move to foreground”</strong></th>
<th>Moves the visualization element to the foreground</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable (BOOL)</td>
<td>Example: <code>bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR</code></td>
</tr>
<tr>
<td>TRUE: At runtime, the visualization element is displayed in the foreground.</td>
<td></td>
</tr>
<tr>
<td>FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.</td>
<td></td>
</tr>
</tbody>
</table>

**Element property 'Access rights'**

Requirement: User management is set up for the visualization.

<table>
<thead>
<tr>
<th><strong>“Access rights”</strong></th>
<th>Opens the “Access rights” dialog. There you can edit the access privileges for the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status messages:</td>
<td><strong>“Not set. Full rights.”</strong>: Access rights for all user groups: “operable”</td>
</tr>
<tr>
<td></td>
<td><strong>“Rights are set: Limited rights”</strong>: Access is restricted for at least one group.</td>
</tr>
</tbody>
</table>

See also

- ☘️ Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

**Visualization Element 'ActiveX’**

Symbol:

![ActiveX Symbol]

Category: “Special Controls”

The element is used to link an existing ActiveX control in the visualization. You can configure the method calls and their parameters in the element properties of the “ActiveX” element.

**Element properties**
<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: GenElemInst_1</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Type of element”</td>
<td>“ActiveX”</td>
</tr>
<tr>
<td>“Element”</td>
<td>Installed ActiveX component that is linked to the visualization. Hint: To avoid typing errors, select the required ActiveX component by means of the Input Assistant.</td>
</tr>
</tbody>
</table>

**Element property 'Position'**

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element Specified in pixels. Example: 10.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Y coordinate of the upper left corner of the element Specified in pixels. Example: 10.</td>
</tr>
<tr>
<td>“Width”</td>
<td>Specified in pixels. Example: 150</td>
</tr>
<tr>
<td>“Height”</td>
<td>Specified in pixels. Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (🧩) to other positions in the editor.

See also

- ☝️ Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

**Element property 'Center'**

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the ⚪ symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (🧩) to other positions in the editor.

**Element property 'Absolute movement'**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

2024/01/05 3ADR010583, 1, en_US 3259
### Movement

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>Defines the X position (in pixels).</td>
<td>PLC_PRG.iPos_X. Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td>Y</td>
<td>Defines the Y position (in pixels).</td>
<td>PLC_PRG.iPos_Y. Increasing this value in runtime mode moves the element downwards.</td>
</tr>
</tbody>
</table>

#### Rotation

Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle1.

The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.

In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

#### Scaling

Variable (integer data type). Causes centric stretching.

Example: PLC_PRG.iScaling.

The reference point is the “Center” property.

The value 1 shrinks the element by a factor of 0.001. The value 1000 returns the element to its original size.

#### Interior rotation

Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the property “Position → Angle”, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

---

You can link the variables to a unit conversion.

The properties “X”, “Y”, “Rotation”, and “Interior rotation” are supported by the “Client Animation” functionality.
The variables control the element behavior dynamically.

**State variables**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Invisible&quot;</td>
<td>Variable (BOOL). Toggles the visibility of the element. TRUE: The element is not visible at runtime.</td>
</tr>
</tbody>
</table>

The "Invisible" property is supported by the "Client Animation" functionality.

**Initial calls**

These method calls are executed during initialization. They are executed in the first cycle only.

| Method calls | "Create new" | Creates a subnode below "Methods" with parameters for the method call. |
| "Methods" | [<number>] | |
| | "Method": Name of the method |
| | "Parameter": Parameter passed at the method call |
| | "Result parameter": Optional variable for the return value of the method |

**Cyclic calls**

These method calls are executed in every cycle. They are executed in the refresh rate of the visualization.

| Method calls | "Create new" | Creates a subnode below "Methods" for a method call and its parameters. |
| "Methods" | [<number>] | |
| | "Method": Name of the method |
| | "Parameter": Parameter passed at the method call |
| | "Result parameter": Optional variable for the return value of the method |

**Conditional calls**

These method calls are executed in the refresh rate of the visualization. You define the call condition in the property "Methods ➔ [<number>] ➔ Call condition".

| Method calls | "Create new" | Creates a subnode below "Methods" with a call condition and parameters for the method call. |
| "Methods" | [<number>] | |
| | "Method": Name of the method |
| | "Call condition": Variable (BOOL). A rising edge of this variable triggers the call of this method. |
| | "Parameter": Parameter passed at the method call |
| | "Result parameter": Optional variable for the return value of the method |
These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

| “Animation duration” | Defines the duration (in milliseconds) in which the element runs an animation
|----------------------|--------------------------------------------------------------------------------
|                      | • Variable (integer value)
|                      |   Example: Menu.tContent with VAR tContent : INT := 500;
|                      |     END_VAR
|                      | • Integer literal
|                      |   Example: 500

Animatable properties

• “Absolute movement”, “Movement”, “X”, “Y”
• “Absolute movement”, “Rotation”
• “Absolute movement”, “Interior rotation”
• “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

| “Move to foreground” | Moves the visualization element to the foreground
|----------------------|--------------------------------------------------------------------------------
|                      | Variable (BOOL)
|                      | Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR
|                      | TRUE: At runtime, the visualization element is displayed in the foreground.
|                      | FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

Element property 'Access rights'

Requirement: User management is set up for the visualization.

| “Access rights” | Opens the “Access rights” dialog. There you can edit the access privileges for the element.
|-----------------|--------------------------------------------------------------------------------
|                 | Status messages:
|                 | • “Not set. Full rights.”: Access rights for all user groups: “operable”
|                 | • “Rights are set: Limited rights”: Access is restricted for at least one group.

See also

• Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

Visualization Element 'Web Browser’

Symbol:

Category: “Special Controls”

The element shows a website, PDF file, or video that has a URL.
NOTICE!
The display options of the "Web Browser" element depend on the operating system and the display variant of the visualization.

Requirement: The software components of the web browser are available in the runtime and configured accordingly (example: videos to be shown on Linux).

See also
- Chapter 6.4.5.2.6 “Displaying Web Contents” on page 2865

<table>
<thead>
<tr>
<th>Element properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Element name”</td>
</tr>
<tr>
<td>“Type of element”</td>
</tr>
</tbody>
</table>

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td>Example: 10.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td>Example: 10.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Width”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 150</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Height”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 30</td>
<td></td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (¶) to other positions in the editor.

See also
- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the ⚪ symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y-coordinate of the point of rotation</th>
</tr>
</thead>
</table>
The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

### Movement

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>X</strong></td>
<td>Variable (numeric data type). Defines the X position (in pixels). Increasing this value in runtime mode moves the element to the right.</td>
<td>PLC_PRG.iPos_X</td>
</tr>
<tr>
<td><strong>Y</strong></td>
<td>Variable (numeric data type). Defines the Y position (in pixels). Increasing this value in runtime mode moves the element downwards.</td>
<td>PLC_PRG.iPos_Y</td>
</tr>
</tbody>
</table>

### Rotation

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rotation</strong></td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees). The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol. In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
<td>PLC_PRG.iAngle1</td>
</tr>
</tbody>
</table>

### Scaling

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scaling</strong></td>
<td>Variable (integer data type). Causes centric stretching. The reference point is the “Center” property. The value 1 shrinks the element by a factor of 0.001. The value 1000 returns the element to its original size.</td>
<td>PLC_PRG.iScaling</td>
</tr>
</tbody>
</table>

### Interior rotation

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Interior rotation</strong></td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees). In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise. The rotation point is shown as the symbol. Note: If a static angle of rotation is specified in the property “Position ➔ Angle”, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.</td>
<td>PLC_PRG.iAngle2</td>
</tr>
</tbody>
</table>
You can link the variables to a unit conversion.

The properties “X”, “Y”, “Rotation”, and “Interior rotation” are supported by the “Client Animation” functionality.

See also

Element property ‘State variables’

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Invisible”</td>
<td>Variable (BOOL). Toggles the visibility of the element. TRUE: The element is not visible at runtime.</td>
</tr>
</tbody>
</table>

The “Invisible” property is supported by the “Client Animation” functionality.

Element property ‘Control variables’

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“URL”</td>
<td>URL of the web page that is displayed in the visualization.</td>
</tr>
<tr>
<td>Variable (STRING or WSTRING)</td>
<td>Example: PLC_PRG.stURL</td>
</tr>
<tr>
<td>Literal in single straight quotation marks</td>
<td>Example: '<a href="http://de.wikipedia.org">http://de.wikipedia.org</a>'</td>
</tr>
<tr>
<td>“Show”</td>
<td>Variable (BOOL). Example: PLC_PRG.bSetURL</td>
</tr>
<tr>
<td>Controls the display of the “Web browser” element. If the variable contains a rising edge, then the visualization calls the web page given in “URL” and displays its contents in the ‘Web browser’ visualization element.</td>
<td></td>
</tr>
<tr>
<td>“Back”</td>
<td>Variable (BOOL). Example: PLC_PRG.bGoBack</td>
</tr>
<tr>
<td>Controls the back navigation in the “Web browser”. If the variable has a rising edge, then the visualization displays the contents of the previously displayed page.</td>
<td></td>
</tr>
<tr>
<td>“Forward”</td>
<td>Variable (BOOL). Example: PLC_PRG.bGoForward</td>
</tr>
<tr>
<td>Controls the forward navigation in the “Web browser”. If the variable has a rising edge, then the visualization displays the contents of the previously displayed page.</td>
<td></td>
</tr>
</tbody>
</table>
These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

### “Animation duration”
Defines the duration (in milliseconds) in which the element runs an animation

- **Variable** (integer value)
  
  **Example:**
  ```
  Menu.tContent with
  VAR tContent : INT := 500;
  END_VAR
  ```

- **Integer literal**
  
  **Example:**
  500

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

### “Move to foreground”
Moves the visualization element to the foreground

**Variable** (**BOOL**)

**Example:**
```
VAR bIsInForeground : BOOL := FALSE; END_VAR
```

**TRUE:** At runtime, the visualization element is displayed in the foreground.

**FALSE:** At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

---

**Element property 'Access rights'**

**Requirement:** User management is set up for the visualization.

### “Access rights”
Opens the “Access rights” dialog. There you can edit the access privileges for the element.

**Status messages:**

- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also

- § Chapter 6.4.5.21.3.1 “Dialog 'Access Rights'” on page 3366

**Visualization Element 'Busy Symbol, Cube'**

**Symbol:**

- **Category:** “Special Controls”

At runtime, this element indicates automatically that the runtime is busy or waiting for data.
Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: Data_Transfer</th>
</tr>
</thead>
</table>

Optional

Hint: Assign individual names for elements so that they are found faster in the element list.

| “Type of element” | “Busy Symbol, Cube” |

Element property ‘Position’

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels. Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels. Example: 10.</td>
</tr>
</tbody>
</table>

| “Width” | Specified in pixels. Example: 150 |
| “Height” | Specified in pixels. Example: 30 |

You can also change the values by dragging the box symbols (■) to other positions in the editor.

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

Element property ‘Center’

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (φ) to other positions in the editor.

Element property 'Absolute movement'

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.
### "Movement"

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>X</strong></td>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
<td>PLC_PRG.iPos_X.</td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td><strong>Y</strong></td>
<td>Variable (numeric data type). Defines the Y position (in pixels).</td>
<td>PLC_PRG.iPos_Y.</td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
</tr>
<tr>
<td><strong>Rotation</strong></td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
<td>PLC_PRG.iAngle1.</td>
<td>The midpoint of the element rotates at the &quot;Center&quot; point. This rotation point is shown as the symbol. In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
</tr>
<tr>
<td><strong>Interior rotation</strong></td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
<td>PLC_PRG.iAngle2.</td>
<td>In runtime mode, the element rotates about the point of rotation specified in &quot;Center&quot; according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise. The rotation point is shown as the symbol. Note: If a static angle of rotation is specified in the &quot;Position ➔ Angle&quot; property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.</td>
</tr>
</tbody>
</table>

You can link the variables to a unit conversion.

The "X", "Y", "Rotation", and "Interior rotation" properties are supported by the "Client Animation" functionality.

See also

- **Element property 'State variables'**
  The variables control the element behavior dynamically.
"Invisible" Variable (BOOL). Toggles the visibility of the element.
TRUE: The element is not visible at runtime.

The "Invisible" property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

"Animation duration" Defines the duration (in milliseconds) in which the element runs an animation
- Variable (integer value)
  Example: Menu.tContent with VAR tContent : INT := 500; END_VAR
- Integer literal
  Example: 500

Animatable properties
- "Absolute movement", "Movement", “X”, “Y"
- "Absolute movement", "Rotation"
- "Absolute movement", "Interior rotation"
- "Absolute movement", "Exterior rotation"

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

"Move to foreground" Moves the visualization element to the foreground
Variable (BOOL)
Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR
TRUE: At runtime, the visualization element is displayed in the foreground.
FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

Element property 'Access rights'

Requirement: User management is set up for the visualization.

"Access rights" Opens the “Access rights” dialog. There you can edit the access privileges for the element.
Status messages:
- "Not set. Full rights.
- "Rights are set: Limited rights": Access is restricted for at least one group.

See also
- $Chapter 6.4.5.21.3.1 "Dialog 'Access Rights'" on page 3366
Visualization Element 'Busy Symbol, Flower'

Symbol:

Category: “Special Controls”
The element indicates that the system is busy or waiting for data.

<table>
<thead>
<tr>
<th>Element properties</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Element name&quot;</td>
<td>Data_Transfer</td>
</tr>
<tr>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>Hint:</td>
<td></td>
</tr>
<tr>
<td>&quot;Type of element&quot;</td>
<td>&quot;Busy Symbol, Flower&quot;</td>
</tr>
</tbody>
</table>

Element property 'Position'
The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

You can also change the values by dragging the box symbols (_drag) to other positions in the editor.

See also
• Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

See also
• Chapter 6.4.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874
Element property 'Center'
The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the \( \phi \) symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (\( \phi \)) to other positions in the editor.

Element property 'Colors'
The properties contain fixed values for setting colors.

<table>
<thead>
<tr>
<th>“Frame color”</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“Fill color”</td>
<td></td>
</tr>
<tr>
<td>“Transparency”</td>
<td>Value (0 to 255) for defining the transparency of the selected color. Example 255: The color is opaque. 0: The color is completely transparent.</td>
</tr>
</tbody>
</table>

See also
- \( \$ \) Chapter 6.4.5.21.3.5 “Dialog ‘Gradient Editor’” on page 3369
- \( \$ \) Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

Element property 'Appearance'
The properties contain fixed values for setting the look of the element.

| “Line width” | Value in pixels
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 2</td>
<td></td>
</tr>
</tbody>
</table>

Note: The values 0 and 1 both result in a line weight of 1 pixel. If no line should be displayed, then the “Line style” property must be set to the option “Invisible”.

<table>
<thead>
<tr>
<th>“Fill attributes”</th>
<th>The way in which the element is filled.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Filled”</td>
<td>The element is filled with the color from property “Colors ➔ Fill color”.</td>
</tr>
<tr>
<td>“Invisible”</td>
<td>The fill color is invisible.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Line style”</th>
<th>Type of line representation</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Solid”</td>
<td></td>
</tr>
<tr>
<td>“Dashes”</td>
<td></td>
</tr>
<tr>
<td>“Dots”</td>
<td></td>
</tr>
<tr>
<td>“Dash Dot”</td>
<td></td>
</tr>
<tr>
<td>“Dash Dot Dot”</td>
<td></td>
</tr>
<tr>
<td>“not visible”</td>
<td></td>
</tr>
</tbody>
</table>

You can assign variables in the “Appearance variables” property for controlling the appearance dynamically. The fixed values here are overwritten.

See also
- \( \$ \) “Element property 'Appearance variables’” on page 3292
<table>
<thead>
<tr>
<th><strong>Symbol color</strong></th>
<th>Selection of a color for the flower symbol.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Line</strong></td>
<td>Stroke width of the lines (in pixels).</td>
</tr>
</tbody>
</table>

**Element property 'Absolute movement'**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

### Movement

| **X** | Variable (numeric data type). Defines the X position (in pixels).  
Example: PLC_PRG.iPos_X.  
Increasing this value in runtime mode moves the element to the right. |
|-------|---------------------------------------------------------------------|
| **Y** | Variable (numeric data type). Defines the Y position (in pixels).  
Example: PLC_PRG.iPos_Y.  
Increasing this value in runtime mode moves the element downwards. |

**Rotation**

Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle1.

The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.

In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

| **Interior rotation** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
Example: PLC_PRG.iAngle2.  
In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.  
The rotation point is shown as the symbol.  
Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed. |

You can link the variables to a unit conversion.
The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>“Invisible”</th>
<th>Variable (BOOL). Toggles the visibility of the element. TRUE: The element is not visible at runtime.</th>
</tr>
</thead>
</table>

The “Invisible” property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

<table>
<thead>
<tr>
<th>“Animation duration”</th>
<th>Defines the duration (in milliseconds) in which the element runs an animation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>● Variable (integer value)</td>
</tr>
<tr>
<td></td>
<td>Example: Menu.tContent with VAR tContent : INT := 500; END_VAR</td>
</tr>
<tr>
<td></td>
<td>● Integer literal</td>
</tr>
<tr>
<td></td>
<td>Example: 500</td>
</tr>
</tbody>
</table>

Animatable properties

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

<table>
<thead>
<tr>
<th>“Move to foreground”</th>
<th>Moves the visualization element to the foreground</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Variable (BOOL)</td>
</tr>
<tr>
<td></td>
<td>Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR</td>
</tr>
<tr>
<td></td>
<td>TRUE: At runtime, the visualization element is displayed in the foreground.</td>
</tr>
<tr>
<td></td>
<td>FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.</td>
</tr>
</tbody>
</table>

Element property 'Access rights'

Requirement: User management is set up for the visualization.
“Access rights” Opens the “Access rights” dialog. There you can edit the access privileges for the element. Status messages:
- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also
- Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

See also
- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

Visualization Element ‘Text Editor’

Symbol:

Category: “Special Controls”
The element shows the contents of text files that are saved on the controller. Files can be encoded in ASCII or Unicode formats.
A visualization user can also edit the text.

Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: GenElemInst_1</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Type of element”</td>
<td>“Text Editor”</td>
</tr>
</tbody>
</table>

Element property ‘Position’ The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

| “X” | X coordinate of the upper left corner of the element Specified in pixels. Example: 10. |
| “Y” | Y coordinate of the upper left corner of the element Specified in pixels. Example: 10. |
| “Width” | Specified in pixels. Example: 150 |
| “Height” | Specified in pixels. Example: 30 |
You can also change the values by dragging the box symbols (_drag-دة) to other positions in the editor.

See also

- Chapter 6.4.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

**Element property ‘Font’**

<table>
<thead>
<tr>
<th>“Font name”</th>
<th>Non-proportional font used by the visualization to display the contents of the file. Example: “Courier New”</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Size”</td>
<td>Font size</td>
</tr>
<tr>
<td></td>
<td>Example: 12</td>
</tr>
</tbody>
</table>

**Element property ‘Control variables’**

**Table 631: Element property “Control variables --> File”**

<table>
<thead>
<tr>
<th>“Variable”</th>
<th>Variable (STRING). Contains the file names and optionally the location of the file. It is located in the file system of the controller. Example: PLC_PRG.strFile: STRING := '/Documentation/Info.txt';</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Open”</td>
<td>Variable (BOOL). Controls opening the file which is defined in the “Variable” property. Example: bOpen: BOOL; TRUE: The file is opened.</td>
</tr>
<tr>
<td>“Close”</td>
<td>Variable (BOOL). Controls closing the file which is defined in the “Variable” property. Example: bClose: BOOL; TRUE: The file is closed.</td>
</tr>
<tr>
<td>“Save”</td>
<td>Variable (BOOL). Controls saving the file which is defined in the “Variable” property. Example: bStore: BOOL; TRUE: The file is saved.</td>
</tr>
<tr>
<td>“New”</td>
<td>Variable (BOOL). Controls creating a new file. The name is defined in the “Variable” property. Example: bCreate: BOOL; TRUE: A file is created and opened.</td>
</tr>
</tbody>
</table>
### Table 632: Element property “Control variables --> Edit”

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Variable”</td>
<td>Variable (STRING). Contains the string to search for in the file</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Example: <code>strFind: STRING := 'abc';</code></td>
<td></td>
</tr>
<tr>
<td>“Find”</td>
<td>Variable (BOOL). Controls executing the search for the string in the “Variable” property</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Example: <code>bFind: BOOL;</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td>TRUE: The search is performed. The variable is automatically reset to FALSE.</td>
<td></td>
</tr>
<tr>
<td>“Find next”</td>
<td>Variable (BOOL). Controls the location to begin the search in the file</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Example: <code>bFindNext: BOOL;</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td>TRUE: The search begins at the last search result location.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>FALSE: The search begins at the beginning of the file.</td>
<td></td>
</tr>
</tbody>
</table>

### Table 633: Element property “Control variables --> Cursor position”

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Line”</td>
<td>Variable (integer data type). Contains the line of the cursor</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Example: <code>iRowCursor: INT;</code></td>
<td></td>
</tr>
<tr>
<td>“Column”</td>
<td>Variable (integer data type). Contains the column of the cursor</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Example: <code>iColumnCursor: INT;</code></td>
<td></td>
</tr>
<tr>
<td>“Position”</td>
<td>Output variable (integer data type). Shows the absolute cursor position in the text.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Example: <code>iPosCursor: INT;</code></td>
<td></td>
</tr>
<tr>
<td>“Set cursor”</td>
<td>Variable (BOOL). Controls the setting of the cursor at a specific location</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Example: <code>iSetCursor: INT;</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td>TRUE: The cursor is moved. The new position is defined in the “Line” and “Column” properties.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>FALSE: The “Line”, “Column”, and “Position” properties contain the actual values.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Note: The variable is used as the control variable for an input event triggered by a visualization user.</td>
<td></td>
</tr>
</tbody>
</table>

### Table 634: Element property “Control variables --> Selection”

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Start position”</td>
<td>Output variable (integer data type). Shows the absolute position for starting the text selection</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Example: <code>iPosSelection: INT;</code></td>
<td></td>
</tr>
<tr>
<td>“End position”</td>
<td>Output variable (integer data type). Shows the absolute position for ending the text selection</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Example: <code>iPosEndSelection: INT;</code></td>
<td></td>
</tr>
<tr>
<td>“Start line number”</td>
<td>Output variable (integer data type). Shows the line where the text selection begins</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Example: <code>iRowSelection: INT;</code></td>
<td></td>
</tr>
<tr>
<td>“Start column index”</td>
<td>Output variable (integer data type). Shows the column where the text selection begins</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Example: <code>iColumnSelection: INT;</code></td>
<td></td>
</tr>
<tr>
<td>“End line number”</td>
<td>Output variable (integer data type). Shows the line where the text selection ends</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Example: <code>iRowEndSelection: INT;</code></td>
<td></td>
</tr>
<tr>
<td><strong>“End column index”</strong></td>
<td>Output variable (integer data type). Shows the column where the text selection ends.</td>
<td><strong>Example:</strong> <code>iColumnEndSelection: INT;</code></td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td><strong>“Line to select”</strong></td>
<td>Variable (integer data type). Contains the line number that is selected. Note: The selection is controlled by the variables in the “Trigger selection” property.</td>
<td></td>
</tr>
<tr>
<td><strong>“Set selection”</strong></td>
<td>Variable (BOOL). Controls the selection of a line. Example: <code>bSetSelection: BOOL;</code> TRUE: The line from the “Line to select” property is selected and highlighted in the Text Editor. if the line is not in the current text segment of the Text Editor, then the text segment is moved to this line. Note: The variable is used as the control variable for an input event triggered by a visualization user. The control variable is not reset automatically. You are responsible for this to occur in the visualization.</td>
<td></td>
</tr>
</tbody>
</table>

Table 635: Element property “Control variables --> Error handling”

| **“Variable for error code”** | Variable (integer data type). Contains the error code when an error occurs. Example: `iError: INT;` The error codes are declared in `GVL_ErrorCodes` in the `VisuElemTextEditor` library. To display the error text, the `VisuFctTextEditorGetErrorText()` function of the library must be called. |
|-----------------------------|---------------------------------------------------------------------------------|---------------------------------|
| **“Variable for content changed”** | Variable (BOOL). Shows whether the contents have changed. Example: `bIsContentEdited: BOOL;` TRUE: The contents of the Text Editor have changed. |
| **“Variable for access mode”** | Variable (BOOL). Controls the access privileges to the file. Example: `bIsReadOnly: BOOL;` TRUE: A visualization user has read-only permission. At runtime, the file contents are highlighted in gray in the Text Editor. FALSE: A visualization user has read/write permission. Note: The variable overwrites the setting in the “Editor mode” property. |

<table>
<thead>
<tr>
<th><strong>“Maximum line length”</strong></th>
<th>Maximum number of characters per line</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Editor mode”</strong></td>
<td>•  “Read-only”: A visualization user has read-only permissions to the file. At runtime, the file contents are highlighted in gray in the text editor.  •  “Read/write”: A visualization user has read-write permissions.</td>
</tr>
</tbody>
</table>

Element property 'New files'
**“Encoding”**

Character encoding of the new file:
- “ASCII”
- “Unicode (Little endian)”
- “Unicode (Big endian)”

**“New line character sequence”**

End of line character of the new file:
- “CR/LF”: Normal for Windows systems
- “LF”: Normal for UNIX systems

Please note: When a visualization user opens an existing file, the end-of-line character of the file is detected and used automatically.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

**“Animation duration”**

Defines the duration (in milliseconds) in which the element runs an animation
- Variable (integer value)
  - Example: Menu.tContent with VAR tContent : INT := 500; END_VAR
- Integer literal
  - Example: 500

Animatable properties
- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**“Move to foreground”**

Moves the visualization element to the foreground
- Variable (BOOL)
- Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR
  - TRUE: At runtime, the visualization element is displayed in the foreground.
  - FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

**Element property ‘Access rights’**

Requirement: User management is set up for the visualization.

**“Access rights”**

Opens the “Access rights” dialog. There you can edit the access privileges for the element.

Status messages:
- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also
- “Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366”
Visualization Element 'Path3D'

Symbol:

Category: “Special Controls”

The "Path3D" visualization element graphically displays the curves of two independent records as a 3D path. It is specially designed for use with Motion Solution CNC in order to display the trajectory of a machine tool or a robot. The programmed path (path) and the path actually traveled (track) is displayed.

Although the visualization element is designed for use with Motion Solution CNC, it can also be used to display any other record. In this case the application has to provide the path data. The sample application 3D Path Generator, which is available in CODESYS Forge, shows how these data can be generated.

If the element is used together with SoftMotion CNC, then function blocks from the library SM3_CNC_Visu help to generate the data from the path and track. These function blocks are used by the sample project CNC_File_3DPath, which is stored in the installation directory of CODESYS.

- SMC_PathCopier
- SMC_PathCopierCompleteQueue
- SMC_PathCopierFile
- SMC_PositionTracker

A description of the function blocks can be found in the Library Manager in the library SM3_CNC_Visu.

The element does not work with the CODESYS HMI display variant.

See also

- CNC Example 6: Using Path3D with SoftMotion CNC
- Sample project in CODESYS Forge

**Element properties**

<table>
<thead>
<tr>
<th>&quot;Element name&quot;</th>
<th>Example: GenElemInst_1</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Type of element&quot;</td>
<td>&quot;Path3D&quot;</td>
</tr>
</tbody>
</table>

**Element property 'Position'**

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.
| **“X”** | X coordinate of the upper left corner of the element  
Specified in pixels.  
Example: 10. |
| --- | --- |
| **“Y”** | Y coordinate of the upper left corner of the element  
Specified in pixels.  
Example: 10. |
| **“Width”** | Specified in pixels.  
Example: 150 |
| **“Height”** | Specified in pixels.  
Example: 30 |

You can also change the values by dragging the box symbols (揹) to other positions in the editor.

See also
- ![Page link](#) Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

### Path description

**“Path data (VisuStruct3DTrack)”**

Variable of the type VisuStruct3DTrack, which is declared in the IEC code.  
Example: PLC_PRG.pc.vs3dt. A description of the structure can be found in the library manager in the library VisuElem3DPath.library.  

The data structure describes a path or track through a certain number of points. The points are determined and buffered by the application. The track typically displays the last n positions, so that only a certain part of them is ever displayed at any one time. VisuStruct3DTrack.pProjection is a variable that is set by the visualization element and contains information about the path/track projection. It can be read (only) by the application. In addition, the methods Projection.Apply or ApplyV can be used in order to see whether the transformed position lies inside or outside the visualization display area, which is defined by Projection.ElementRect.

**“Path color”**  
Color of the path drawn

**“Path line width”**  
Path line width in pixels, e.g.: "2"

**“Style of boundary points”**  
Display of the points between two successive objects in the path
- End points are not displayed
- End points are marked with a circle
- End points are marked with a cross
- End points are marked with a plus

### Track description

The track data are structured in exactly the same way as the path data: VisuStruct3DTrack

**“Track data (VisuStruct3DTrack)”**

Variable of the type VisuStruct3DTrack, which is declared in the IEC code.  
Example: PLC_PRG.pc.vs3dt. A description of the structure can be found in the library manager in the library VisuElem3DPath.library.

**“Track color”**  
Color of the track drawn

**“Track line width”**  
Track line width in pixels, e.g.: "2"
Camera control  
The camera position for the 3D mode is controlled with a reference to the external data structure. This structure allows the following operations:

- Shifting to the left/to the right/upwards/downwards
- Rotation around the X/Y/Z axis
- Resetting of the view at X/Y, Y/Z or Z/X level, so that the path and the track are completely visible.

<table>
<thead>
<tr>
<th>“Control data (VisuStruct3DControl)”</th>
<th>Variable of the type VisuStruct3DControl, which is declared in the IEC code. Example: PLC_PRG.pc.vs3dc.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A description of the structure can be found in the library manager in the library VisuElem3DPath.</td>
</tr>
<tr>
<td></td>
<td>The values can be set via the application itself or via the visualization element “ControlPanel”. The library VisuElem3DPath contains ready-to-use visualization frames that provide a possible user interface for these data.</td>
</tr>
</tbody>
</table>

Additional aspects

| “Coordinate system” | [✓]: The coordinate system is displayed |
| “Grid”              | [✓]: Grid lines are displayed |
| “Grid color”        | Color of the grid lines |

Highlighting  
Individual parts of the path can be visually highlighted. This is typically used to mark the already processed part of a track with a different color. Each point in the path is given a unique ID, which in the case of a CNC editor is linked with the object ID on which the point lies. This ID ("highlight ID") can be specified via the application so that dynamic elements/parts of the track can be highlighted.

<table>
<thead>
<tr>
<th>Highlight mode</th>
<th>Select one of the following highlight modes:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>● Only the element whose ID corresponds to the value of the variable is highlighted.</td>
</tr>
<tr>
<td></td>
<td>● All elements whose ID (linked with the object ID in the case of a CNC editor) is smaller than or equal to the value in Variable are highlighted.</td>
</tr>
</tbody>
</table>

| Variable       | Project variable that specifies the ID of an element. Example: PLC_PRG.iVarElementID. This "highlight ID" is taken into account for the setting of the highlight mode. The variable must be set in the IEC application. |

| Highlight color | |

Element look

| “Frame line width” | Width of the frame around the element, in pixels, for example: "1" |
| “Frame line style” | Select one of these style types for the frame line: |
|                   | ● Solid |
|                   | ● Dashes |
|                   | ● Dots |
|                   | ● Dash Dot |
|                   | ● Dash Dot Dot |
|                   | ● Hollow |
| **"Transparent background"** | - The background of the element is displayed transparently.  
- The background of the element is displayed in the defined background color. |

| **"Background color"** |

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

| **"Animation duration"** | Defines the duration (in milliseconds) in which the element runs an animation  
- Variable (integer value)  
  Example: Menu.tContent with VAR tContent : INT := 500; END_VAR  
- Integer literal  
  Example: 500  

**Animatable properties**  
- “Absolute movement”, “Movement”, “X”, “Y”  
- “Absolute movement”, “Rotation”  
- “Absolute movement”, “Interior rotation”  
- “Absolute movement”, “Exterior rotation”  

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

| **"Move to foreground"** | Moves the visualization element to the foreground  
Variable (BOOL)  
Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR  
TRUE: At runtime, the visualization element is displayed in the foreground.  
FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor. |

**Element property 'Access rights'**  
**Requirement:** User management is set up for the visualization.

| **"Access rights"** | Opens the “Access rights” dialog. There you can edit the access privileges for the element.  
**Status messages:**  
- “Not set. Full rights.”: Access rights for all user groups: “operable”  
- "Rights are set: Limited rights": Access is restricted for at least one group. |

See also  
- § Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

**Visualization Element 'Control Panel'**  
Symbol:
Category: “Special Controls”

This visualization element is used in connection with the “Path3D” visualization element. It is used for changing the position and orientation to the CNC path shown with “Path3D”.

See also

- Chapter 6.4.5.20.1.42 “Visualization Element ‘Path3D’” on page 3279

Element properties

| “Element name” | Optional.  
|---------------|-------------
| Hint: Assign individual names for elements so that they are found faster in the element list.  
| Example: Camera_Path_1 |

| “Type of element” | “Frame” |

| “Clipping” | ☑: If you have set the “Scaling type” to “Fixed”, then only that part of the visualization is displayed that fits in the frame. |

| “Show frame” | Displays the frame  
|---------------|-------------
| • “No frame”: The displayed area of the frame does not have borders.  
| • “Frame”: The displayed area of the frame has borders.  
| • “No frame with offset”: The displayed area of the frame does not have a border and the displayed area of the referenced visualization is reduced inwards by one pixel as compared to the frame area.  
| The resulting gap prevents the referenced visualization from touching any adjacent elements. |

| “Scaling type” | Describes how the frame reacts when the visualization is resized:  
|---------------|-------------
| • “Isotropic”: The frame retains its proportions. This allows the ratio of height to width to be preserved, even if the height and width of the visualization have been changed separately.  
| • “Anisotropic”: The frame depends on the size of the visualization, so that height and width of the referenced visualization can be changed separately.  
| • “Fixed”: The original size of the frame is retained, regardless of the visualization size. If you have also selected the “Clipping” option, then only the fitting part is displayed.  
| • “Fixed and scrollable”: The referenced visualization is displayed without scaling. If the value is greater than the window area of the frame, then scrollbars are added to the frame. To set the position of the scroll bar with a variable, use the “Scroll position variable horizontal” or “Scroll position variable vertical” property. |

| “Deactivation of the background drawing” | ☐: To optimize the performance of the visualization, the non-animated elements of the frame element are drawn as a background bitmap. This could result in the elements not being displayed in the expected order.  
| ☑: Deactivation of the background drawing. This can prevent the behavior described above. |

Element property ‘References’  
Contains the currently configured visualization references as a subnode.
Clicking "Configure" opens the "Frame Configuration" dialog. This is used to manage the referenced visualizations.

Caution: Visualizations can be nested at any depth by means of Frame elements. In order to use the "Switch to any visualization" Frame selection type without any problems, a Frame must not contain more than 21 referenced visualizations. For more information, see also the description for the "Input configuration" of an element: Action "Switch Frame visualization".

<table>
<thead>
<tr>
<th>List of the currently referenced visualizations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visualizations that have a button also have this displayed as a subnode. Each interface variable is listed with the currently assigned transfer parameters.</td>
</tr>
<tr>
<td>Example:</td>
</tr>
<tr>
<td>vis_FormA</td>
</tr>
<tr>
<td>• iDataToDisplay_1: PLC_PRG.iVar1</td>
</tr>
<tr>
<td>• iDataToDisplay_2: PLC_PRG.iVar2</td>
</tr>
</tbody>
</table>

Hint: You can change the assignment of the variables to an interface variable here and edit the value field. Or click the "Configure" button instead.

See also
- § Chapter 6.4.5.21.2.1 “Command 'Interface Editor'” on page 3340
- § Chapter 6.4.5.17 “Creating a structured user interface” on page 2940
- § “Input action ‘Switch Frame Visualization’” on page 3377

### Element property 'Position'

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
</tr>
</thead>
<tbody>
<tr>
<td>X coordinate of the upper left corner of the element</td>
</tr>
<tr>
<td>Specified in pixels.</td>
</tr>
<tr>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y coordinate of the upper left corner of the element</td>
</tr>
<tr>
<td>Specified in pixels.</td>
</tr>
<tr>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Width”</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in pixels.</td>
</tr>
<tr>
<td>Example: 150</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Height”</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in pixels.</td>
</tr>
<tr>
<td>Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols ( draggable ) to other positions in the editor.

See also
- § Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

### Element property ‘Center’

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
<td>X-coordinate of the point of rotation</td>
</tr>
<tr>
<td>“Y”</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols ( Biol) to other positions in the editor.

**Element property 'Colors'**

The properties contain fixed values for setting colors.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Color”</td>
<td>Color for the element in its normal state. Please note that the normal state is in effect if the expression in the “Color variables ➔ Toggle color” property is not defined or it has the value FALSE.</td>
</tr>
<tr>
<td>“Alarm color”</td>
<td>Color for the element in alarm state. Please note that the alarm state is in effect if the expression in the “Color variables ➔ Toggle color” property has the value TRUE.</td>
</tr>
<tr>
<td>“Transparency”</td>
<td>Value (0 to 255) for defining the transparency of the selected color. Example 255: The color is opaque. 0: The color is completely transparent.</td>
</tr>
<tr>
<td>“Use gradient color”</td>
<td>☑: The element is displayed with a color gradient.</td>
</tr>
<tr>
<td>“Gradient setting”</td>
<td>The “Color gradient editor” dialog box opens.</td>
</tr>
<tr>
<td>“Frame color”</td>
<td>Example: “Black”</td>
</tr>
<tr>
<td>“Fill color”</td>
<td>Example: “Light gray”</td>
</tr>
</tbody>
</table>

See also
- ☰ Chapter 6.4.5.21.3.5 “Dialog ‘Gradient Editor’” on page 3369
- ●

**Element property 'Appearance'**

The properties contain fixed values for setting the look of the element.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Line width”</td>
<td>Value in pixels Example: 2 Note: The values 0 and 1 both result in a line weight of one pixel. If no line should be displayed, then the “Line style” property must be set to the option “Invisible”.</td>
</tr>
</tbody>
</table>
| “Line style”  | Type of line representation  
  - “Solid”  
  - “Dashes”  
  - “Dots”  
  - “Dash Dot”  
  - “Dash Dot Dot”  
  - “not visible” |
You can assign variables in the “Appearance variables” property for controlling the appearance dynamically. The fixed values are defined here.

See also
- “Element property ‘Appearance variables’” on page 3292

Element property ‘Texts’
The properties contain character strings for labeling the element. The character string can also contain a placeholder with a format definition. In runtime mode, the placeholder is replaced by the current value in the specified format.

CODESYS accepts the specified texts automatically into the “GlobalTextList” text list. Therefore, these texts can be localized.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Text”</td>
<td>Character string (without single straight quotation marks) for the labeling the element. Add a line break by pressing the keyboard shortcut [Ctrl] + [Enter].</td>
</tr>
<tr>
<td></td>
<td>Example: Accesses: %i</td>
</tr>
<tr>
<td></td>
<td>The variable that contains the current value for the placeholder is specified in the property “Text variable ➔ Text”.</td>
</tr>
<tr>
<td>“Tooltip”</td>
<td>Character string (without single straight quotation marks) that is displayed as the tooltip of an element.</td>
</tr>
<tr>
<td></td>
<td>Example: Number of valid accesses.</td>
</tr>
<tr>
<td></td>
<td>The variable that contains the current value for the placeholder is specified in the property “Text variable ➔ Tooltip”.</td>
</tr>
</tbody>
</table>

See also
- “Element property ‘Text variables’” on page 3289
- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
- Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329

Element property ‘Text properties’
The properties contain fixed values for the text properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Horizontal alignment”</td>
<td>Horizontal alignment of the text within the element.</td>
</tr>
<tr>
<td>“Vertical alignment”</td>
<td>Vertical alignment of the text within the element.</td>
</tr>
<tr>
<td>“Text format”</td>
<td>Definition for displaying texts that are too long</td>
</tr>
<tr>
<td></td>
<td>- “Default”: The long text is truncated.</td>
</tr>
<tr>
<td></td>
<td>- “Line break”: The text is split into parts.</td>
</tr>
<tr>
<td></td>
<td>- “Ellipsis”: The visible text ends with “...” indicating that it is not complete.</td>
</tr>
<tr>
<td>“Font”</td>
<td>Example: “Default”</td>
</tr>
<tr>
<td></td>
<td>- The “Font” dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>- Drop-down list with style fonts.</td>
</tr>
</tbody>
</table>
### "Font color"

<table>
<thead>
<tr>
<th>Example: “Black”</th>
</tr>
</thead>
<tbody>
<tr>
<td>: The “Color” dialog box opens.</td>
</tr>
<tr>
<td>▼: Drop-down list with style colors.</td>
</tr>
</tbody>
</table>

### "Transparency"

| Whole number (value range from 0 to 255). This determines the transparency of the respective color. |
| Example: 255: The color is opaque. |
| 0: The color is completely transparent. |

Please note: If the color is a style color and already has a transparency value, then this property is write-protected.

### Element property 'Absolute movement'

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>&quot;Movement&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>X</strong></td>
</tr>
<tr>
<td>Example: PLC_PRG.iPos_X.</td>
</tr>
<tr>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
</tbody>
</table>

| **Y** | Variable (numeric data type). Defines the Y position (in pixels). |
| Example: PLC_PRG.iPos_Y. |
| Increasing this value in runtime mode moves the element downwards. |

| **Rotation** | Variable (numeric data type). Defines the angle of rotation (in degrees). |
| Example: PLC_PRG.iAngle1. |
| The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol. |
| In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right. |

| **Scaling** | Variable (integer data type). Causes centric stretching. |
| Example: PLC_PRG.iScaling. |
| The reference point is the “Center” property. |
| The value 1 shrinks the element by a factor of 0.001. The value 1000 returns the element to its original size. |
**“Interior rotation”**

Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the property “Position ➔ Angle”, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

---

You can link the variables to a unit conversion.

---

The properties “X”, “Y”, “Rotation”, and “Interior rotation” are supported by the "Client Animation" functionality.

---

**Element property 'Relative movement'**

The properties contains variables for moving the element. The reference point is the position of the element (“Position” property). The shape of the element can change.

<table>
<thead>
<tr>
<th>“Movement top-left”</th>
<th>Variable (integer data type). It contains the number (in pixels) that the left edge is moved horizontally. Incrementing the value moves the element to the right. <strong>Example:</strong> PLC_PRG.iDeltaX</th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
<td></td>
</tr>
<tr>
<td>“Y”</td>
<td>Variable (integer data type). It contains the number (in pixels) that the top edge is moved vertically. Incrementing the value moves the element to the down. <strong>Example:</strong> PLC_PRG.iDeltaY</td>
</tr>
<tr>
<td>“Movement bottom-right”</td>
<td>Variable (integer data type). It contains the number (in pixels) that the right edge is moved horizontally. Incrementing the value moves the element to the right. <strong>Example:</strong> PLC_PRG.iDeltaWidth</td>
</tr>
<tr>
<td>“X”</td>
<td></td>
</tr>
<tr>
<td>“Y”</td>
<td>Variable (integer data type). It contains the number (in pixels) that the bottom edge is moved vertically. Incrementing the value moves the element to the down. <strong>Example:</strong> PLC_PRG.iDeltaHeight</td>
</tr>
</tbody>
</table>

---

See also

- “Element property ‘Absolute movement’” on page 3319
**Element property 'Text variables'**

These properties are variables with contents that replace a format definition.

<table>
<thead>
<tr>
<th>“Text variable”</th>
<th>Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example:</td>
<td>PLC_PRG.iAccesses</td>
</tr>
<tr>
<td>Note:</td>
<td>The format definition is part of the text in the property “Texts ➔ Text”.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you specify a variable of type enumeration with text list support, then the name of the enumeration data type is added automatically in angle brackets after the variable name. Example: PLC_PRG.enVar &lt;enumeration name&gt;. Then the symbolic value of the enumeration component is printed instead of the numeric value when text is printed. Refer to the help page for the enumerations.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Tooltip variable”</th>
<th>Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example:</td>
<td>PLC_PRG.iAccessesInTooltip</td>
</tr>
<tr>
<td>Note:</td>
<td>The format definition is part of the text in the property “Texts ➔ Tooltip”.</td>
</tr>
</tbody>
</table>

See also

- ☰ Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329
- ☰ “Element property 'Texts’” on page 3286
- ☰ Chapter 6.4.1.20.5.18 “Enumerations” on page 2263

**Element property 'Dynamic texts'**

Dynamic texts are variably indexed texts of a text list. At runtime, the text is displayed that is currently indexed in the variable.

<table>
<thead>
<tr>
<th>“Text list”</th>
<th>Variable (string) or name of the text list as a fixed string in single straight quotation marks.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example:</td>
<td>'Errorlist'</td>
</tr>
<tr>
<td></td>
<td>➔: Drop-down list with the dialogs available in the text lists.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Text index”</th>
<th>Text list ID. This refers to the desired output text.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• As fixed string with the ID in single straight quotation marks.</td>
</tr>
<tr>
<td></td>
<td>Example: '1'</td>
</tr>
<tr>
<td></td>
<td>• As a variable (STRING) for dynamically controlling the text output.</td>
</tr>
<tr>
<td></td>
<td>Example: strTextID</td>
</tr>
<tr>
<td></td>
<td>Sample assignment: PLC_PRG.strTextID := '1';</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Tooltip index”</th>
<th>Text list ID. This refers to the desired output text.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• As fixed string with the ID in single straight quotation marks.</td>
</tr>
<tr>
<td></td>
<td>Example: '2'</td>
</tr>
<tr>
<td></td>
<td>• As a variable (STRING) for dynamically controlling the text output.</td>
</tr>
<tr>
<td></td>
<td>Example: strToolTipID</td>
</tr>
<tr>
<td></td>
<td>Sample assignment: PLC_PRG.strToolTipID := '2';</td>
</tr>
</tbody>
</table>

See also

- ☰ Chapter 6.4.1.21.2.28 “Object 'Text List’” on page 2532

**Element property 'Font variables'**

The variables allow for dynamic control of the text display.
### Font name

Variable (STRING). Includes the font of the text.  
Example: `PLC_PRG.stFontVar := 'Arial';`

The selection of fonts corresponds to the default “Font” dialog.

### Size

Variable (numeric data type). Contains the font size (in pixels or points). The applied unit is specified in brackets after the variable name.  
- `<pt>`: Points (default)  
  Example: `PLC_PRG.iFontHeight <pt>`  
  Code: `iFontHeight : INT := 12;`
- `<px>`: Pixels  
  Example: `PLC_PRG.iFontHeight <px>`  
  Code: `iFontHeight : INT := 19;`

If you click in the value field, a drop-down list opens on the right for setting the unit.  
Hint: The font size is specified in points (example: Arial 12). Use points when the variable font size should match a font, for example if a font is set in the property “Text property → Font”.

### Flags

Variable (DWORD). Contains the flags for displaying fonts.  
Flags:  
- 1: Italics  
- 2: Bold  
- 4: Underline  
- 8: Strikethrough  

Note: You can combine the font displays by adding the coding of the flags. For example, a bold and underlined text: `PLC_PRG.dwFontType := 6;`

### Character set

Variable (DWORD). Contains a character set number for the font.  
The selection of character set numbers corresponds to the “Script” setting of the standard “Font” dialog.

### Color

Variable (DWORD). Includes the color of the text.  
Example: `PLC_PRG.dwColorFont:= 16#FF000000;`

### Flags for text alignment

Variable (integer data type). Contains the coding for text alignment.  
Example: `PLC_PRG.dwTextAlignment.`  
Coding:  
- 0: Top left  
- 1: Horizontal center  
- 2: Right  
- 4: Vertical center  
- 8: Bottom  

Note: You can combine the text alignments by adding the coding of the flags. For example, a vertical and horizontal centered text: `PLC_PRG.dwFontType := 5;`
Fixed values for displaying texts are set in “Text properties”.

See also
● “Element property ‘Text properties’” on page 3286

The Element property is used as an interface for project variables to dynamically control colors at runtime.

<table>
<thead>
<tr>
<th>“Toggle color”</th>
<th>The property controls the toggled color at runtime.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value assignment:</td>
<td></td>
</tr>
<tr>
<td>● FALSE: The element is displayed with the color specified in the “Color” property.</td>
<td></td>
</tr>
<tr>
<td>● TRUE: The element is displayed with the color specified in the “Alarm color” property.</td>
<td></td>
</tr>
<tr>
<td>Assignment options:</td>
<td></td>
</tr>
<tr>
<td>● Placeholder for the user input variable</td>
<td></td>
</tr>
<tr>
<td>– “&lt;toggle/tap variable&gt;”</td>
<td></td>
</tr>
<tr>
<td>– “&lt;NOT toggle/tap variable&gt;”</td>
<td></td>
</tr>
<tr>
<td>The color change is not controlled by its own variable, but by a user input variable.</td>
<td></td>
</tr>
<tr>
<td>Note: Specify a variable for the mouse events “Tap” or “Toggle” in the input configuration of the element. Only then is the placeholder set. If you configure a variable in both “Toggle” and “Tap”, then the variable specified in “Tap” is used.</td>
<td></td>
</tr>
<tr>
<td>Hint: Click the symbol to insert the placeholder “&lt;toggle/tap variable&gt;”. When you activate the “Inputconfiguration”, “Tap FALSE” property, then the “&lt;NOT toggle/tap variable&gt;” placeholder is displayed.</td>
<td></td>
</tr>
<tr>
<td>● Instance path of a project variable (BOOL)</td>
<td></td>
</tr>
<tr>
<td>Example: PLC_PRG.xColorIsToggled</td>
<td></td>
</tr>
<tr>
<td>Note: In the code, declare and implement the variable specified here. Its value assignment determines when the color changes.</td>
<td></td>
</tr>
</tbody>
</table>

| “Normal state” | The properties listed below control the color depending on the state. The normal state is in effect if the variable in “Color variables”, “Toggle color” is not defined or it has the value FALSE. The alarm state is in effect if the variable in “Colorvariables”, “Toggle color” has the value TRUE. |
| “Alarm state” | |

<table>
<thead>
<tr>
<th>“Frame color”</th>
<th>Assignment options:</th>
</tr>
</thead>
<tbody>
<tr>
<td>● Variable (DWORD) for the frame color</td>
<td></td>
</tr>
<tr>
<td>Example: PLC_PRG.dwBorderColor</td>
<td></td>
</tr>
<tr>
<td>● Color literal</td>
<td></td>
</tr>
<tr>
<td>Example of green and opaque: (16\text{#FF00FF00})</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Filling color”</th>
<th>Assignment options:</th>
</tr>
</thead>
<tbody>
<tr>
<td>● Variable (DWORD) for the fill color</td>
<td></td>
</tr>
<tr>
<td>Example: PLC_PRG.dwFillColor</td>
<td></td>
</tr>
<tr>
<td>● Color literal</td>
<td></td>
</tr>
<tr>
<td>Example of gray and opaque: (16\text{#FF888888})</td>
<td></td>
</tr>
</tbody>
</table>
The transparency part of the color value is evaluated only if the "Activate semi-transparent drawing" option of the visualization manager is selected.

Select the "Advanced" option in the toolbar of the properties view. Then all element properties are visible.

See also
- Chapter 6.4.5.10.4 "Animating a color display" on page 2914

**Element property 'Appearance variables'**

The properties contain variables for controlling the appearance of the element dynamically.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Line width&quot;</td>
<td>Variable (integer data type). Contains the line weight (in pixels). Note: The values 0 and 1 both result in a line weight of one pixel. If no line should be displayed, then the &quot;Line style&quot; property must be set to the option &quot;Invisible&quot;.</td>
</tr>
</tbody>
</table>
| "Line style" | Variable (DWORD). Controls the line style. Coding:  
  - 0: Solid line  
  - 1: Dashed line  
  - 2: Dotted line  
  - 3: Line type "Dash Dot"  
  - 3: Line type "Dash Dot Dot"  
  - 8: Invisible: The line is not drawn. |

Fixed values can be set in the "Appearance" property. These values can be overwritten by dynamic variables at runtime.

See also
- "Element property 'Appearance'" on page 3285

**Element property 'Switch frame variable'**

The variable controls the switching of the referenced visualizations. This variable indexes one of the referenced frame visualizations and this is displayed in the frame. When the value of the variable changes, it switches to the recently indexed visualization.
**“Variable”**

- Variable (integer data type) that contains the index of the active visualization
  
  **Example:** PLC_PRG.uiIndexVisu

  **Hint:** The “Frame Configuration” dialog includes a list of referenced visualizations. The visualizations are automatically numerically indexed via the order in the list.

  **Note:** This variant of switching usually affects all connected display variants.

- Array element (integer data type) for index access via CURRENTCLIENTID
  
  **Example:** PLC_PRG.aIndexVisu[CURRENTCLIENTID]

  **Note:** This variant of switching applies to the current client only, and therefore only on one display variant. That is the display variant where the value change was triggered (for example, by means of user input).

---

**See also**

- § Chapter 6.4.5.21.2.9 “Command ‘Frame Selection’” on page 3348

---

**Element property ‘State variables’**

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>“Invisible”</th>
<th>Variable (BOOL). Toggles the visibility of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>TRUE: The element is not visible at runtime.</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong> bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Deactivate inputs”</th>
<th>Variable (BOOL). Toggles the operability of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.</td>
</tr>
</tbody>
</table>

---

The “Invisible” property is supported by the "Client Animation" functionality.

---

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
“Animation duration” Defines the duration (in milliseconds) in which the element runs an animation
- Variable (integer value)
  Example: Menu.tContent with VAR tContent : INT := 500; END_VAR
- Integer literal
  Example: 500

Animatable properties
- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

“Move to foreground” Moves the visualization element to the foreground
Variable (BOOL)
Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR
TRUE: At runtime, the visualization element is displayed in the foreground.
FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

Element property 'Input configuration' The properties contain the configurations for the user input when using the mouse or keyboard. A user input defines an event and one or more actions that are executed when an event occurs.

The “Configure” button opens the “Input Configuration” dialog. There you can create or edit user inputs. Configured user inputs are listed below the events. They each include the action that is triggered and the setting in short form.

Example: “Execute ST Code”: PLC_PRG.i_x := 0;

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“OnDialogClosed”</td>
<td>Input event: The user closes the dialog.</td>
</tr>
<tr>
<td>“OnMouseClick”</td>
<td>Input event: The user clicks the mouse button completely in the element area. The mouse button is clicked and released.</td>
</tr>
<tr>
<td>“OnMouseDown”</td>
<td>Input event: The user clicks down on the mouse button.</td>
</tr>
<tr>
<td>“OnMouseEnter”</td>
<td>Input event: The user drags the mouse pointer to the element.</td>
</tr>
<tr>
<td>“OnMouseLeave”</td>
<td>Input event: The user drags the mouse pointer away from the element.</td>
</tr>
<tr>
<td><strong>OnMouseMove</strong></td>
<td>Input event: The user moves the mouse pointer over the element area.</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **OnMouseUp**  | Input events:  
|                | - The user releases the mouse button within the element area. It is irrelevant whether the user has previously pressed the mouse button inside or outside the element area.  
|                | - The user presses the mouse button within the element area, leaves the element area, and then releases the mouse button.  
|                | Note: This CODESYS-specific triggering behavior guarantees that actions for key elements are completed. A key element starts an action for “OnMouseDown” and ends the action for “OnMouseUp”.  
|                | Example: A visualization user presses the mouse button within the element area of the key element and then moves the cursor position so that it lies outside the element area. The action is ended anyway because “OnMouseUp” is triggered. |

<table>
<thead>
<tr>
<th><strong>Tap</strong></th>
<th>When a mouse click event occurs, the variable defined in “Variable” is described in the application. The coding depends on the “Tap FALSE” and “Tap on enter if captured” options.</th>
</tr>
</thead>
</table>
| **Variable**   | Variable (BOOL) that is set on mouse click event.  
|                | Example: PLC_PRG.bIsTapped  
|                | TRUE: A mouse click event exists. It lasts as long as the user presses the mouse button over the element. It ends when the button is released.  
|                | FALSE: A mouse click event does not exist.  
|                | Requirement: The “Tap FALSE” option is not activated. |
| **Tap FALSE**  | ☑: The mouse click event leads to a complementary value in “Variable”.  
|                | TRUE: A mouse click event does not exist.  
|                | FALSE: While the mouse click event exists. |
| **Tap on enter if captured** | ☑: During user input, it is also taken into consideration whether the mouse pointer is dragged within the element area or not while the mouse button is pressed.  
|                | TRUE: While the mouse click event exists and the mouse pointer is moved over the element area.  
|                | FALSE: A mouse click event does not exist. Or the user moves the mouse pointer outside of the element area while the mouse button is pressed.  
|                | The value is TRUE again as soon as the user moves the pointer back to the element area. The mouse is then captured. |

<table>
<thead>
<tr>
<th><strong>Toggle</strong></th>
<th>With the onset of a mouse click event, the variable is set; when the mouse click event is completed, the variable is reset.</th>
</tr>
</thead>
</table>
| **Variable**   | Variable (BOOL). Its value toggled when the mouse click event is ended. This is when the user releases the mouse button while the mouse pointer is over the element area.  
|                | If the user releases the mouse button while the mouse pointer outside of the element area, then the mouse click event is not ended and the value is not toggled.  
|                | Hint: The user can cancel a started toggle input by dragging the mouse pointer out of the element area.  
| **Toggle on up if captured** | ☑: The value toggles regardless of where the mouse pointer is when the mouse button is released. The mouse is then captured. |
## Hotkey

Keyboard shortcut on the element for triggering specific input actions. When the keyboard shortcut event occurs, the input actions in the “Events” property are triggered. In this way, it is not the input action itself that leads to this input action, but the mouse input action.

### Key

Key pressed for input action.

Example: `[T]`

Note: The following properties appear when a key is selected.

## Events

- **“None”**
- **“Mouse down”:** Pressing the key triggers the input actions that are configured in the “OnMouseDown” property.
- **“Mouse up”:** Releasing the key triggers the input actions that are configured in the “OnMouseUp” property.
- **“Mouse down/up”:** Pressing and releasing the key triggers the input actions that are configured in the “OnMouseDown” property and the “OnMouseUp” property.

## Shift

☑️ Combination with the Shift key

Example: `[Shift]+[T]`.

## Control

☑️ Combination with the Ctrl key

Example: `[Ctrl]+[T]`.

## Alt

☑️ Combination with the Alt key

Example: `[Alt]+[T]`.

---

All keyboard shortcuts and their actions that are configured in the visualization are listed on the “Keyboard Configuration” tab.

---

See also

- § Chapter 6.4.5.21.2.2 “Command 'Keyboard Configuration’” on page 3341
- § Chapter 6.4.5.21.3.6 “Dialog 'Input Configuration’” on page 3370

---

See also

- § Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

---

**Visualization Element 'Cartesian XY Chart'**

Symbol:

![Cartesian XY Chart](image)

Category: “Special Controls”

The element displays the curve of array values graphically as a line or bar chart in the Cartesian coordinate system. The chart can display multiple curves at one time.
NOTICE!

Constraint
The element can be used with controller with V3.5 SP11 and higher.

in CODESYS Forge, you will find a sample project for using “Cartesian XY Chart” elements in visualizations.

See also
- Sample project in CODESYS Forge

Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: Velocity chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Type of element”</td>
<td>“Cartesian XY Chart”</td>
</tr>
<tr>
<td>“Cartesian XY Chart”</td>
<td>XYChart: Opens the “XY Chart Configuration” dialog. This is where the chart is configured.</td>
</tr>
</tbody>
</table>

Element property 'Position'

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td>Example: 10.</td>
<td></td>
</tr>
<tr>
<td>“Y”</td>
<td>Y coordinate of the upper left corner of the element</td>
</tr>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td>Example: 10.</td>
<td></td>
</tr>
<tr>
<td>“Width”</td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td>Example: 150</td>
<td></td>
</tr>
<tr>
<td>“Height”</td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td>Example: 30</td>
<td></td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (drag) to other positions in the editor.

See also
- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

Element property 'Element look'

The properties contain fixed values for defining the look of the element.
“Border line width”  Value (in pixels)
Example: 2
Note: The values 0 and 1 both result in a line weight of one pixel. If no line should be displayed, then the “Border line style” property must be set to the option “Invisible”.

“Border line style”
- “Solid”
- “Dash”
- “Dots”
- “Dash Dot”
- “Dash Dot Dot”
- “Invisible”

“Frame line color”
- Style color from the list box. Example: Black
- Fixed value that is selected in the color dialog. Example: 0; 0; 0

Element property ‘Axis font’

“Font”
Example: “Default”
- [ ] Opens the “Font” dialog.
- [ ] List box with style fonts

Element property ‘Control variables’

Table 636: “Zoom”

Zooming the displayed curve is done by means of the mouse, or the pinch gesture on a multitouch device. It also applies to all axes.

At runtime when “Enable” is TRUE, you can draw a box with the mouse by holding down the left mouse button. When you release the mouse button, the display zooms in on the box and the curve is magnified. To zoom in and out on a multitouch device, move two fingers together or away from each other, respectively.

Zooming and panning can work together.

“Enable”
Variable (BOOL) that enables or disables zooming.
- TRUE: Enables zooming
Example: PLC_PRG.xZoomEnable

“Home”
Variable (BOOL)
Rising edge: Reset the displayed curve to the initial state after the display has changed due to zooming.
Example: PLC_PRG.xZoomHome
**“Undo”**

Variable (BOOL)

Rising edge: Reset the displayed curve to the previous position after the display has changed due to zooming.

Example: PLC_PRG.xZoomUndo

**“Is zoomed”**

Variable (BOOL) that indicates whether or not the displayed curve was modified due to zooming.

TRUE: Curve setting was zoomed.

Example: PLC_PRG.xIsZoomed

**Table 637: “Pan”**

Panning the displayed curve is done by means of the mouse or the pinch gesture on a multitouch device. It also applies to all axes.

At runtime if “Enable” is TRUE, then you can drag the displayed curve to another position by holding down the left mouse button. To pan the displayed curve on a multitouch device, drag it with one finger to another position.

**“Enable”**

Variable (BOOL) to enable or disable panning.

TRUE: Enables panning

Example: PLC_PRG.xPanEnable

**“Home”**

Variable (BOOL)

Rising edge: Reset the displayed curve to the initial position after the display has changed due to panning.

Example: PLC_PRG.xPanHome

**“Is panned”**

Variable (BOOL) whose state indicates whether or not the displayed curve was modified due to zooming.

TRUE: Curve setting was panned.

Example: PLC_PRG.xIsPanned

**Element property ‘Absolute movement’**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

**“Movement”**

**“X”**

Variable (numeric data type). Defines the X position (in pixels).

Example: PLC_PRG.iPos_X.

Increasing this value in runtime mode moves the element to the right.

**“Y”**

Variable (numeric data type). Defines the Y position (in pixels).

Example: PLC_PRG.iPos_Y.

Increasing this value in runtime mode moves the element downwards.
“Rotation” Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle1.

The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.

In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

“Interior rotation” Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the “Position Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- The variables control the element behavior dynamically.

Element prop-
erty 'State vari-
ables'

“Invisible” Variable (BOOL). Toggles the visibility of the element.

TRUE: The element is not visible at runtime.

Example: bIsVisible with VAR bIsVisible : BOOL := FALSE;

“Deactivate inputs” Variable (BOOL). Toggles the operability of the element.

TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.
The “Invisible” property is supported by the “Client Animation” functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Animation duration&quot;</td>
<td>Defines the duration (in milliseconds) in which the element runs an animation</td>
</tr>
<tr>
<td></td>
<td>- Variable (integer value)</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong> Menu.tContent with VAR tContent : INT := 500; END_VAR</td>
</tr>
<tr>
<td></td>
<td>- Integer literal</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong> 500</td>
</tr>
<tr>
<td>Animatable properties</td>
<td></td>
</tr>
<tr>
<td>&quot;Absolute movement&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Movement&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;X&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Y&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Absolute movement&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Rotation&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Absolute movement&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Interior rotation&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Absolute movement&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Exterior rotation&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The animated movement is executed when at least one value of an animatable</td>
</tr>
<tr>
<td></td>
<td>property has changed. The movement then executed is not jerky, but is</td>
</tr>
<tr>
<td></td>
<td>smooth within the specified animation duration. The visualization element</td>
</tr>
<tr>
<td></td>
<td>travels to the specified position while rotating dynamically. The</td>
</tr>
<tr>
<td></td>
<td>transitions are smooth.</td>
</tr>
<tr>
<td>&quot;Move to foreground&quot;</td>
<td>Moves the visualization element to the foreground</td>
</tr>
<tr>
<td>Variable (BOOL)</td>
<td></td>
</tr>
<tr>
<td><strong>Example:</strong> bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR</td>
<td></td>
</tr>
<tr>
<td>TRUE: At runtime, the visualization element is displayed in the foreground.</td>
<td></td>
</tr>
<tr>
<td>FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.</td>
<td></td>
</tr>
</tbody>
</table>

Element property 'Access rights'

Requirement: User management is set up for the visualization.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Access rights&quot;</td>
<td>Opens the “Access rights” dialog. There you can edit the access privileges for the element.</td>
</tr>
<tr>
<td></td>
<td>Status messages:</td>
</tr>
<tr>
<td></td>
<td>- “Not set. Full rights.”: Access rights for all user groups : “operable”</td>
</tr>
<tr>
<td></td>
<td>- “Rights are set: Limited rights”: Access is restricted for at least one group.</td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

Visualization Element 'Date Range Picker'

Symbol:
Category: “Date/Time Controls”

The element provides the capability of selecting the date and time range of a saved data set. The element is used with the “Trend” visualization element.

### Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: DateTrend1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
</tr>
</tbody>
</table>

| “Type of element” | “Date Range Picker” |

#### Element property 'Position'

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

| “X”      | X coordinate of the upper left corner of the element Specified in pixels. Example: 10. |
| “Y”      | Y coordinate of the upper left corner of the element Specified in pixels. Example: 10. |
| “Width”  | Specified in pixels. Example: 150 |
| “Height” | Specified in pixels. Example: 30 |

You can also change the values by dragging the box symbols (□) to other positions in the editor.

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

#### Element property 'Center'

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

| “X” | X-coordinate of the point of rotation |
| “Y” | Y-coordinate of the point of rotation |
You can also change the values by dragging the symbols (_bold) to other positions in the editor.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Show frame”</strong></td>
<td>□: The visualization element is drawn with a frame.</td>
</tr>
<tr>
<td><strong>“Resolution”</strong></td>
<td>Resolution saved for the time stamp: “Millisecond” or “Microsecond”</td>
</tr>
<tr>
<td><strong>“Attached element instance”</strong></td>
<td>The element can be assigned to a “Trend” visualization element. As a result, the time range of the trend element can be changed. The available visual elements are selected with the help of the Input Assistant ( azt).</td>
</tr>
</tbody>
</table>

**Element property 'Tick mark labels'**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Two-line labelling”</strong></td>
<td>□: The time stamps are displayed in two lines. The date is displayed in the first line and the time is displayed in the second line. □: Time stamp is displayed in one line. The date and time can also be displayed in one line depending on the formatting.</td>
</tr>
<tr>
<td><strong>“Omit irrelevant information in time stamp”</strong></td>
<td>□: The time stamp has a shorter form. For example, the date is displayed only for the first tick mark, and only the time for the following tick marks. The settings in “Internationalization (format strings)” are ignored for this setting. □: All information is displayed for all time stamps.</td>
</tr>
<tr>
<td><strong>“Internationalization (format strings)”</strong></td>
<td>Only active when the parameter “Omit irrelevant information in timestamps” is deactivated.</td>
</tr>
<tr>
<td><strong>“Date”</strong></td>
<td>Definition of the date format. The default setting is taken from the Windows control panel.</td>
</tr>
<tr>
<td><strong>“Time”</strong></td>
<td>Definition of the time format. The default setting is taken from the Windows control panel.</td>
</tr>
</tbody>
</table>

**Element property 'Text properties'**

The properties contain fixed values for the text properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Horizontal alignment”</strong></td>
<td>Horizontal alignment of the text within the element.</td>
</tr>
<tr>
<td><strong>“Vertical alignment”</strong></td>
<td>Vertical alignment of the text within the element.</td>
</tr>
<tr>
<td><strong>“Font color”</strong></td>
<td>Example: “Black” □: The “Color” dialog box opens. ▼: Drop-down list with style colors.</td>
</tr>
<tr>
<td><strong>“Transparency”</strong></td>
<td>Whole number (value range from 0 to 255). This determines the transparency of the respective color. Example: 255: The color is opaque. 0: The color is completely transparent. Please note: If the color is a style color and already has a transparency value, then this property is write-protected.</td>
</tr>
</tbody>
</table>
Element property 'Additional buttons'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Jump to the largest possible time stamp&quot;</td>
<td>An additional button (X) is displayed for jumping to the last time stamp.</td>
</tr>
<tr>
<td>&quot;Jump to the smallest possible time stamp&quot;</td>
<td>An additional button (x) is displayed for jumping to the first time stamp.</td>
</tr>
<tr>
<td>&quot;Zoom out&quot;</td>
<td>An additional button (X) is displayed for setting the current min./max. range to the maximum range. The selected range is left.</td>
</tr>
</tbody>
</table>

Element property 'Absolute movement'

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

"Movement"

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>Variable (numeric data type). Defines the X position (in pixels). Example: PLC_PRG.iPos_X. Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td>Y</td>
<td>Variable (numeric data type). Defines the Y position (in pixels). Example: PLC_PRG.iPos_Y. Increasing this value in runtime mode moves the element downwards.</td>
</tr>
</tbody>
</table>

"Rotation"


- The midpoint of the element rotates at the "Center" point. This rotation point is shown as the + symbol.
- In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

"Interior rotation"


- In runtime mode, the element rotates about the point of rotation specified in "Center" according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.
- The rotation point is shown as the + symbol.
- Note: If a static angle of rotation is specified in the "Position ➔ Angle" property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.
You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the "Client Animation" functionality.

See also

Element property 'State variables'

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>&quot;Invisible&quot;</th>
<th>Variable (BOOL). Toggles the visibility of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRUE: The element is not visible at runtime.</td>
<td></td>
</tr>
</tbody>
</table>

The “Invisible” property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
<table>
<thead>
<tr>
<th><strong>“Animation duration”</strong></th>
<th>Defines the duration (in milliseconds) in which the element runs an animation</th>
</tr>
</thead>
<tbody>
<tr>
<td>● Variable (integer value)</td>
<td>Example: <code>Menu.tContent</code> with <code>VAR tContent : INT := 500; END_VAR</code></td>
</tr>
<tr>
<td>● Integer literal</td>
<td>Example: 500</td>
</tr>
<tr>
<td><strong>Animatable properties</strong></td>
<td></td>
</tr>
<tr>
<td>● “Absolute movement”, “Movement”, “X”, “Y”</td>
<td></td>
</tr>
<tr>
<td>● “Absolute movement”, “Rotation”</td>
<td></td>
</tr>
<tr>
<td>● “Absolute movement”, “Interior rotation”</td>
<td></td>
</tr>
<tr>
<td>● “Absolute movement”, “Exterior rotation”</td>
<td></td>
</tr>
<tr>
<td>The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Move to foreground”</strong></th>
<th>Moves the visualization element to the foreground</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable (BOOL)</td>
<td></td>
</tr>
<tr>
<td>Example: <code>bIsInForeground</code> with <code>VAR bIsInForeground : BOOL := FALSE; END_VAR</code></td>
<td></td>
</tr>
<tr>
<td>TRUE: At runtime, the visualization element is displayed in the foreground.</td>
<td></td>
</tr>
<tr>
<td>FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.</td>
<td></td>
</tr>
</tbody>
</table>

**Element property 'Access rights'**

Requirement: User management is set up for the visualization.

<table>
<thead>
<tr>
<th><strong>“Access rights”</strong></th>
<th>Opens the “Access rights” dialog. There you can edit the access privileges for the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status messages:</td>
<td></td>
</tr>
<tr>
<td>● “Not set. Full rights.”: Access rights for all user groups: “operable”</td>
<td></td>
</tr>
<tr>
<td>● “Rights are set: Limited rights”: Access is restricted for at least one group.</td>
<td></td>
</tr>
</tbody>
</table>

See also

● § Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

**Visualization Element ‘Time Range Picker’**

Symbol:

Category: “Date/Time Controls”

The element provides configurable buttons for setting the time range of a trend display to a defined time. In the process the end time of the previous display is left unchanged and the start time is adapted.
<table>
<thead>
<tr>
<th><strong>“Element name”</strong></th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
<tr>
<td>Example: <em>TimeRangeTemperature</em></td>
<td></td>
</tr>
</tbody>
</table>

| **“Type of element”** | “Time range picker” |

**Element property 'Position'**

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th><strong>“X”</strong></th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in pixels.</td>
<td></td>
</tr>
<tr>
<td>Example: 10</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Y”</strong></th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in pixels.</td>
<td></td>
</tr>
<tr>
<td>Example: 10</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Width”</strong></th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 150</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Height”</strong></th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 30</td>
<td></td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (_drag_symbol_) to other positions in the editor.

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

<table>
<thead>
<tr>
<th><strong>“Orientation”</strong></th>
<th>Specifies whether the time picker element is aligned horizontally or vertically in the editor.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint: Change the width to height ratio of the element in the editor.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Show frame”</strong></th>
<th>: The visualization element is drawn with a frame.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>“Resolution”</strong></th>
<th>Resolution saved for the time stamp: “Millisecond” or “Microsecond”</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>“Attached element instance”</strong></th>
<th>Assignment to the element that processes the time picker</th>
</tr>
</thead>
<tbody>
<tr>
<td>The element can be assigned for example to a “Trend” visualization element. Then the time range of the trend element can be changed. The available visual elements are selected with the help of the input assistance (input_assistance).</td>
<td></td>
</tr>
<tr>
<td>Example: <em>GenElemInst_1</em></td>
<td></td>
</tr>
</tbody>
</table>

**Element property 'Texts'**

<table>
<thead>
<tr>
<th><strong>“Text”</strong></th>
<th>String label for the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: <em>Zoom</em></td>
<td></td>
</tr>
</tbody>
</table>
Element property 'Text properties'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Font&quot;</td>
<td>Example: &quot;Default&quot;&lt;br&gt;Font dialog box opens. Drop-down list with style fonts.</td>
</tr>
<tr>
<td>&quot;Font color&quot;</td>
<td>Example: &quot;Black&quot;&lt;br&gt;Color dialog box opens. Drop-down list with style colors.</td>
</tr>
<tr>
<td>&quot;Transparency&quot;</td>
<td>Whole number (value range from 0 to 255). Determines transparency of color.</td>
</tr>
<tr>
<td></td>
<td>Example: 255: Color is opaque.&lt;br&gt;0: Color is completely transparent.</td>
</tr>
<tr>
<td></td>
<td>Please note: If color is a style color already has a transparency value,</td>
</tr>
<tr>
<td></td>
<td>then this property is write-protected.</td>
</tr>
</tbody>
</table>

Property 'Times'

In "Times", the buttons that the element provides at runtime are defined and configured in an array.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Provide &quot;All&quot; selection&quot;</td>
<td>Time Range Picker bar extended by &quot;All&quot; button. The diagram represents a time interval that covers all time stamps.</td>
</tr>
<tr>
<td>&quot;Times&quot;</td>
<td>Adds another button to the Time Range Picker bar and increases the array by one entry. An additional index is present in the property &quot;Times -&gt; Times &lt;[&lt;new&gt;]&quot;. &quot;Time&quot; is located under this index. The configuration of the button is to be entered there.</td>
</tr>
<tr>
<td>&quot;Times&quot;</td>
<td>Array of all buttons in the time selection bar. Index corresponds to the number of buttons. The associated button is removed from the Time Range Picker bar. The configuration entry is deleted from the &quot;Times&quot; property list.</td>
</tr>
<tr>
<td>&quot;Time&quot;</td>
<td>Time interval in standardized notation. Example: 3M for 3 months; 30m for 30 minutes. If a time interval is indicated in the field, then the button is labelled with it. If a user clicks on the button at runtime, the command is executed to switch the diagram to this time interval. The default is empty.</td>
</tr>
</tbody>
</table>

Element property 'Control variables'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Time&quot;</td>
<td>Displays which time is currently selected.</td>
</tr>
<tr>
<td>Variable (STRING)</td>
<td>Example: PLC_PRG.strSelcetedTime</td>
</tr>
<tr>
<td>&quot;All&quot; selected</td>
<td>Displays the state of the &quot;All&quot; button</td>
</tr>
<tr>
<td>Variable (BOOL)</td>
<td>Example: PLC_PRG.AllTimesAreSelected</td>
</tr>
</tbody>
</table>
The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

### "Movement"

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;X&quot;</td>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
<td>PLC_PRG.iPos_X</td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td>&quot;Y&quot;</td>
<td>Variable (numeric data type). Defines the Y position (in pixels).</td>
<td>PLC_PRG.iPos_Y</td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
</tr>
<tr>
<td>&quot;Rotation&quot;</td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
<td>PLC_PRG.iAngle1</td>
<td>The midpoint of the element rotates at the &quot;Center&quot; point. This rotation point is shown as the ◆ symbol. In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
</tr>
<tr>
<td>&quot;Interior rotation&quot;</td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
<td>PLC_PRG.iAngle2</td>
<td>In runtime mode, the element rotates about the point of rotation specified in &quot;Center&quot; according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise. The rotation point is shown as the ◆ symbol. Note: If a static angle of rotation is specified in the &quot;Position ➔ Angle&quot; property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.</td>
</tr>
</tbody>
</table>

You can link the variables to a unit conversion.

The "X", "Y", "Rotation", and "Interior rotation" properties are supported by the "Client Animation" functionality.

See also

-
The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Invisible”</td>
<td>Variable (BOOL). Toggles the visibility of the element. TRUE: The element is not visible at runtime.</td>
</tr>
</tbody>
</table>

The “Invisible” property is supported by the “Client Animation” functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| “Animation duration” | Defines the duration (in milliseconds) in which the element runs an animation.  
- Variable (integer value)  
  Example: Menu.tContent with VAR tContent : INT := 500; END_VAR  
- Integer literal  
  Example: 500  
  Animatable properties  
  - “Absolute movement”, “Movement”, “X”, “Y”  
  - “Absolute movement”, “Rotation”  
  - “Absolute movement”, “Interior rotation”  
  - “Absolute movement”, “Exterior rotation”  
  The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth. |
| “Move to foreground” | Moves the visualization element to the foreground.  
Variable (BOOL)  
Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR  
TRUE: At runtime, the visualization element is displayed in the foreground.  
FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor. |

Element property 'State variables'

Element property 'Access rights'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| “Access rights” | Opens the “Access rights” dialog. There you can edit the access privileges for the element.  
Status messages:  
- “Not set. Full rights.”: Access rights for all user groups: “operable”  
- “Rights are set: Limited rights”: Access is restricted for at least one group. |

See also

- Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366
Visualization Element 'Date Picker'

Symbol:

Category: “Date/Time Controls”

The element is a calendar that displays the current date. A user can click a day to select a date, which is saved to a variable. In addition, it can customize the time interval that the calendar displays. Clicking the calendar header changes the year. Clicking the arrows in the calendar header changes the month.

Language-dependent texts of the element

The element contains language-dependent texts that are managed in the System text list. This deals with the names of the month and the days of the week written out completely or abbreviated. When the date picker is added to a visualization, CODESYS generates the text list automatically below the POU view. The IDs correspond to the standard text and therefore English terms. The text list makes it possible to translate these texts.

<table>
<thead>
<tr>
<th>ID</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apr</td>
<td>Apr</td>
</tr>
<tr>
<td>April</td>
<td>April</td>
</tr>
</tbody>
</table>

See also
- Chapter 6.4.5.8 “Setting Up Multiple Languages” on page 2906

Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: DueDateCalendar</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Type of element”</td>
<td>“Date Picker”</td>
</tr>
</tbody>
</table>

Element property 'Position'  The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in pixels.</td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in pixels.</td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>
“Width”  Specified in pixels.  
Example: 150

“Height”  Specified in pixels.  
Example: 30

You can also change the values by dragging the box symbols (🪐) to other positions in the editor.

See also
● § Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

Element property ‘Center’  The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the 🎭 symbol. The point is used as the center for rotating and scaling.

“X”  X-coordinate of the point of rotation

“Y”  Y-coordinate of the point of rotation

You can also change the values by dragging the symbols (🪐) to other positions in the editor.

“Variable”  Input variable (DATE). Contains the date that a user selects in the calendar.  
Example: PLC_PRG.dtDueDate

“Design”  ● “From style”: All settings are preconfigured according to the style.  
● “Explicit”: The “Design settings” property is available. You can customize the calendar here.

Design settings  Requirement: This property is visible only if the “Design” property is set to “Explicit”.  
The values of the property can be predefined in the style. Then they are available in the drop-down list.

Table 638: “Header of Date Picker”

<table>
<thead>
<tr>
<th>Design of the header</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Font”</td>
</tr>
<tr>
<td>“Font color”</td>
</tr>
<tr>
<td>“Arrows”</td>
</tr>
<tr>
<td>“Arrow color”</td>
</tr>
<tr>
<td>“Color of printed arrow”</td>
</tr>
<tr>
<td>“Background”</td>
</tr>
</tbody>
</table>
**Draw background**

*From style*: The style defines whether and how a background is drawn.
*Yes*: The background is filled with the color in the **Background color** property.
*No*: The background is not filled with a color.

**Fill color**

Style color or user-defined color

---

**Table 639: Design of the main display area**

<table>
<thead>
<tr>
<th>Design of the main display area</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Today”</strong></td>
<td>Design of today</td>
</tr>
<tr>
<td><strong>“Font”</strong></td>
<td>Style font or user-defined font</td>
</tr>
<tr>
<td><strong>“Font color”</strong></td>
<td>Style color or user-defined color</td>
</tr>
</tbody>
</table>
| **“Draw background”** | *From style*: The style defines whether and which background is drawn.
*Yes*: The background is filled with the color in the **Background color** property.
*No*: The background is not filled with a color. |
| **“Background color”** | Style color or user-defined color. Used if “Yes” is selected in “Draw background”. |
| **“Show frame”** | *From style*: The style defines whether and how a frame is drawn.
*Yes*: The frame is displayed with the following properties.
*No*: A frame is not displayed. |
| **“Frame color”** | Used if “Yes” is selected in “Show frame”. |
| **“Rectangle type”** |  |
| **“Line width”** |  |

---

<table>
<thead>
<tr>
<th>Design of the selected day</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Font”</strong></td>
<td>Style font or user-defined font</td>
</tr>
<tr>
<td><strong>“Font color”</strong></td>
<td>Style color or user-defined color</td>
</tr>
</tbody>
</table>
| **“Draw background”** | *From style*: The style defines whether and how a background is drawn.
*Yes*: The background is filled with the color in the **Background color** property.
*No*: The background is not filled with a color. |
| **“Background color”** | Style color or user-defined color |
| **“Show frame”** | *From style*: The style defines whether and how a background is drawn.
*Yes*: The background is filled with the color in the **Background color** property.
*No*: The background is not filled with a color. |
| **“Frame color”** | Used if “Yes” is selected in “Show frame”. |
| **“Rectangle type”** |  |
| **“Line width”** |  |

---

<table>
<thead>
<tr>
<th>Design of the current month</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Font”</strong></td>
<td>Style font or user-defined font</td>
</tr>
<tr>
<td><strong>“Font color”</strong></td>
<td>Style color or user-defined color</td>
</tr>
</tbody>
</table>
### "Draw background"
- **"From style":** The style defines whether and how a background is drawn.
  - **"Yes":** The background is filled with the color in the "Background color" property.
  - **"No":** The background is not filled with a color.

### "Background color"

### "Show frame"
- **"From style":** The style defines whether and how a frame is drawn.
  - **"Yes":** The frame is displayed with the following properties.
  - **"No":** A frame is not displayed.

### "Frame color"
- Used if "Yes" is selected in "Show frame".

### "Rectangle type"

### "Line width"

### "Other months"
- Design of the previous and subsequent months

### "Font"
- Style font or user-defined font

### "Font color"
- Style color or user-defined color

### "Display other month"
- Design of the previous and subsequent months

### "Draw background"
- **"From style":** The style defines whether and how a background is drawn.
  - **"Yes":** The background is filled with the color in the "Background color" property.
  - **"No":** The background is not filled with a color.

### "Background color"

### "Show frame"
- **"From style":** The style defines whether and how a frame is drawn.
  - **"Yes":** The frame is displayed with the following properties.
  - **"No":** A frame is not displayed.

### "Frame color"
- Used if "Yes" is selected in "Show frame".

### "Rectangle type"

### "Line width"

### "Day of week heading"
- Design of the heading with the days of the week

### "Font"
- Style font or user-defined font

### "Font color"
- Style color or user-defined color

### "Draw background"
- **"From style":** The background is filled with the style color "From style". The style defines whether and how a background is drawn.
  - **"Yes":** The background is filled with the color in the "Background color" property.
  - **"No":** The background is not filled with a color.

### "Background color"

### "Show frame"
- **"From style":** The style defines whether and how a frame is drawn.
  - **"Yes":** The frame is displayed with the following properties.
  - **"No":** A frame is not displayed.

### "Frame color"
- Used if "Yes" is selected in "Show frame".

### "Rectangle type"

### "Line width"
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display separator line</td>
<td>&quot;From style&quot;: The style defines whether and how a separator line is drawn.</td>
</tr>
<tr>
<td>&quot;Yes&quot;: Display with the following properties.</td>
<td></td>
</tr>
<tr>
<td>&quot;No&quot;: A separator line is not displayed.</td>
<td></td>
</tr>
<tr>
<td>Color of the separator line</td>
<td>Used if &quot;Yes&quot; is selected in &quot;Display separator line&quot;.</td>
</tr>
<tr>
<td>Width of separator line</td>
<td></td>
</tr>
<tr>
<td>Background</td>
<td>Design of the calendar days</td>
</tr>
<tr>
<td>Draw background</td>
<td>&quot;From style&quot;: The style defines whether and how a background is drawn.</td>
</tr>
<tr>
<td>&quot;Yes&quot;: The background is filled with the color in the &quot;Fill color&quot; property and framed in the &quot;Frame color&quot;.</td>
<td></td>
</tr>
<tr>
<td>&quot;No&quot;: The background is not filled with a color.</td>
<td></td>
</tr>
<tr>
<td>Fill color</td>
<td>Style color or user-defined color</td>
</tr>
<tr>
<td>Frame color</td>
<td></td>
</tr>
</tbody>
</table>

**Element property 'Display type'**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rows</td>
<td>Number of month calendars per row (preset: 1)</td>
</tr>
<tr>
<td>Columns</td>
<td>Number of month calendars per column (preset: 1)</td>
</tr>
</tbody>
</table>

**Element property 'Absolute movement'**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
</tr>
<tr>
<td>Example</td>
<td>PLC_PRG.iPos_X.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td>Y</td>
<td>Variable (numeric data type). Defines the Y position (in pixels).</td>
</tr>
<tr>
<td>Example</td>
<td>PLC_PRG.iPos_Y.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
</tr>
<tr>
<td>Rotation</td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
</tr>
<tr>
<td>Example</td>
<td>PLC_PRG.iAngle1.</td>
</tr>
<tr>
<td></td>
<td>The midpoint of the element rotates at the &quot;Center&quot; point. This rotation point is shown as the symbol.</td>
</tr>
<tr>
<td></td>
<td>In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
</tr>
</tbody>
</table>
### “Interior rotation”

Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

---

You can link the variables to a unit conversion.

---

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

---

See also

---

**Element property 'State variables’**

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Invisible”</strong></td>
<td>Variable (BOOL). Toggles the visibility of the element.</td>
<td><code>bIsVisible</code> with <code>VAR bIsVisible : BOOL := FALSE; END_VAR</code></td>
</tr>
<tr>
<td><strong>“Deactivate inputs”</strong></td>
<td>Variable (BOOL). Toggles the operability of the element.</td>
<td>TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.</td>
</tr>
</tbody>
</table>

---

The “Invisible” property is supported by the “Client Animation” functionality.

---

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
"Animation duration" | Defines the duration (in milliseconds) in which the element runs an animation  
---|---  
- **Variable (integer value)**  
  **Example:** Menu.tContent with \[ \text{VAR} \ tContent \ : \ \text{INT} := 500; \ \text{END_VAR} \]  
- **Integer literal**  
  **Example:** 500  

Animatable properties  
- "Absolute movement", "Movement", "X", "Y"  
- "Absolute movement", "Rotation"  
- "Absolute movement", "Interior rotation"  
- "Absolute movement", "Exterior rotation"  

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

"Move to foreground" | Moves the visualization element to the foreground  
---|---  
**Variable** (BOOL)  
**Example:** bIsInForeground with \[ \text{VAR} \ bIsInForeground \ : \ \text{BOOL} := \text{FALSE}; \ \text{END_VAR} \]  
**TRUE:** At runtime, the visualization element is displayed in the foreground.  
**FALSE:** At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

**Element property 'Access rights'**  
Requirement: User management is set up for the visualization.

"Access rights" | Opens the "Access rights" dialog. There you can edit the access privileges for the element.  
---|---  
**Status messages:**  
- "Not set. Full rights.": Access rights for all user groups: "operable"  
- "Rights are set: Limited rights": Access is restricted for at least one group.

See also  
- "Chapter 6.4.5.21.3.1 "Dialog 'Access Rights” on page 3366"

See also  
- "Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872"

**Visualization Element 'Analog Clock'**  
**Symbol:**  

Category: "Date/Time Controls"  
The element is a clock that displays the current time of day. The clock can also display a random time.
Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: GenElemInst_1</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Type of element”</td>
<td>“Analog Clock”</td>
</tr>
</tbody>
</table>

Element property 'Position'

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

| “X” | X coordinate of the upper left corner of the element  
Specified in pixels.  
Example: 10. |
| “Y” | Y coordinate of the upper left corner of the element  
Specified in pixels.  
Example: 10. |
| “Width” | Specified in pixels.  
Example: 150 |
| “Height” | Specified in pixels.  
Example: 30 |

You can also change the values by dragging the box symbols (▲) to other positions in the editor.

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

Element property 'Center'

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the ● symbol. The point is used as the center for rotating and scaling.

| “X” | X-coordinate of the point of rotation |
| “Y” | Y-coordinate of the point of rotation |

You can also change the values by dragging the symbols (●) to other positions in the editor.

Element property 'Time Display'
### “Use system time”

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“Use system time”</td>
<td>☑</td>
</tr>
</tbody>
</table>

### “Variable”

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“Variable”</td>
<td>Variable (time data type TOD, TIME_OF_DAY). This receives the time of day that is not the system time.</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.todTimeTokio</td>
</tr>
<tr>
<td></td>
<td>Requirement: The “Use system time” property is not activated.</td>
</tr>
</tbody>
</table>

See also

- ☭ Chapter 6.4.1.20.5.6 “Data Type ‘TIME’” on page 2237

### “Design”

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“Design”</td>
<td>• “From style”: All settings are preconfigured according to the style.</td>
</tr>
<tr>
<td></td>
<td>• “Explicit”: The “Settings” property is available. Here you can customize the analog clock.</td>
</tr>
</tbody>
</table>

### Element property 'Absolute movement'

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

### “Movement”

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iPos_X.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td>“Y”</td>
<td>Variable (numeric data type). Defines the Y position (in pixels).</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iPos_Y.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
</tr>
</tbody>
</table>

### “Rotation”

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“Rotation”</td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iAngle1.</td>
</tr>
<tr>
<td></td>
<td>The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.</td>
</tr>
<tr>
<td></td>
<td>In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
</tr>
</tbody>
</table>

### “Scaling”

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“Scaling”</td>
<td>Variable (integer data type). Causes centric stretching.</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iScaling.</td>
</tr>
<tr>
<td></td>
<td>The reference point is the “Center” property.</td>
</tr>
<tr>
<td></td>
<td>The value 1 shrinks the element by a factor of 0.001. The value 1000 returns the element to its original size.</td>
</tr>
</tbody>
</table>
### “Interior rotation”

Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the 🔄 symbol.

Note: If a static angle of rotation is specified in the property “Position ➔ Angle”, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

### “Use REAL values”

Note: Only available if the device supports the use of REAL coordinates.

- The properties of the absolute movement are interpreted as REAL values. The values are not rounded.

The option allows for the individual fine-tuning of drawing the element, for example for the visualization of a smoother rotation.

Hint: If a horizontal or vertical line is drawn blurry on a specific visualization platform, then this can be corrected by an offset of 0.5px in the direction of the line thickness.

---

You can link the variables to a unit conversion.

The properties “X”, “Y”, “Rotation”, and “Interior rotation” are supported by the “Client Animation” functionality.

See also

- 

---

**Element property 'Settings'**

Requirement: The “Property” is “Explicit”. Only then is the “Clock Settings” category visible.

### Table 640: “Background”

<table>
<thead>
<tr>
<th><strong>“Background color”</strong></th>
<th>Color variants of the default background image</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>“Yellow”</td>
</tr>
<tr>
<td></td>
<td>“Red”</td>
</tr>
<tr>
<td></td>
<td>“Blue”</td>
</tr>
<tr>
<td></td>
<td>“Green”</td>
</tr>
<tr>
<td></td>
<td>“Black”</td>
</tr>
</tbody>
</table>

<p>| <strong>“Own background”</strong> | Background display with the specific “Image”. Replaces the default background image. |</p>
<table>
<thead>
<tr>
<th>“Image”</th>
<th>Image from an image pool or library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: myImagepool.myImage</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Transparency color”</th>
<th>The transparent color in the image representation.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: “White”</td>
<td>The white parts of the image are transparent.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Use background color”</th>
<th>The image background is displayed using the color defined in the “Background color” property.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requirement: No image reference is given in the “Image” property.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Background color”</th>
<th>Style color or color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requirement: “Use background color” is activated.</td>
<td></td>
</tr>
</tbody>
</table>

**Table 641: “Hands”**

<table>
<thead>
<tr>
<th>“Hand style”</th>
<th>Example: “Thin arrow”</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Color hour hand”</td>
<td>Style color or color for the hands</td>
</tr>
<tr>
<td>“Color minute hand”</td>
<td></td>
</tr>
<tr>
<td>“Color second hand”</td>
<td></td>
</tr>
</tbody>
</table>

**Table 642: “Lines”**

<table>
<thead>
<tr>
<th>“Lines style”</th>
<th>Clock face graduation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: “None”</td>
<td>“Line”: Graduation lines by hour</td>
</tr>
<tr>
<td>“Hours and minutes”</td>
<td>“Dots”: Graduation dots by hour</td>
</tr>
<tr>
<td>“Color”</td>
<td>Color of the clock face graduation</td>
</tr>
<tr>
<td>“Line width”</td>
<td>Line weight of the clock face graduation</td>
</tr>
<tr>
<td>“Scale in 3D”</td>
<td>![ ] Representation of the clock face with 3D effect</td>
</tr>
</tbody>
</table>

**Table 643: “Numerics”**

<table>
<thead>
<tr>
<th>“Style of numerics”</th>
<th>Digits on the clock face</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: “None”</td>
<td>“Quarter”</td>
</tr>
<tr>
<td>“All”</td>
<td></td>
</tr>
<tr>
<td>“Font”</td>
<td>Font for displaying the digits</td>
</tr>
<tr>
<td>“Font color”</td>
<td>Font for displaying the digits</td>
</tr>
</tbody>
</table>

**Table 644: “Center point”**

| “Color”                          | Color of the center of the clock                   |

**Table 645: “Positioning”**

<table>
<thead>
<tr>
<th>“Usage of”</th>
<th>“Default style values”: Presetting of the style values</th>
</tr>
</thead>
</table>
| “Positioning”                    | Requirement: Visible when the “Usage or” property is set to “Individual settings”.

2024/01/05
**“Numerics movement”**
Value (in pixels) for shifting the digits.
Example: 80

**“Line movement”**
Value (in pixels) for shifting the hour lines.
Example: 100

**“Hands scaling”**
Factor for scaling the length of the hour hand. You can customize the exact position of the hour hand relative to the background image.
Example: 100

**“Scaling type”**
Defines the scaling of the height and width of the element.
- “Anisotropic”: The background image is scaled to the size of the element. The height and width are scaled independently of each other.
- “Isotropic”: The background image is scaled to the size of the element, retaining its proportion. The proportion of height and width is fixed.

**“Optimized drawing”**
[☑]: The background image is drawn one time. When the hour hand moves, only the affected part of the image is redrawn.
[☐]: The background image is redrawn in cycles.
Hint: Disable this option only for extreme exceptions.

---

**Element property 'Absolute movement'**
The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

**“Movement”**

**“X”**
Variable (numeric data type). Defines the X position (in pixels).
Example: PLC_PRG.iPos_X.
Increasing this value in runtime mode moves the element to the right.

**“Y”**
Variable (numeric data type). Defines the Y position (in pixels).
Example: PLC_PRG.iPos_Y.
Increasing this value in runtime mode moves the element downwards.

**“Rotation”**
Variable (numeric data type). Defines the angle of rotation (in degrees).
Example: PLC_PRG.iAngle1.
The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.
In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.
"Interior rotation" Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in "Center" according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the "Position ➔ Angle" property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the "Client Animation" functionality.

See also

- The variables control the element behavior dynamically.

Element property 'State variables'

"Invisible" Variable (BOOL). Toggles the visibility of the element.

TRUE: The element is not visible at runtime.

The “Invisible” property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
**“Animation duration”**

Defines the duration (in milliseconds) in which the element runs an animation

- **Variable (integer value)**
  
  **Example:** Menu.tContent

  ```
  VAR tContent : INT := 500;
  END_VAR
  ```

- **Integer literal**
  
  **Example:** 500

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**“Move to foreground”**

Moves the visualization element to the foreground

**Variable (BOOL)**

**Example:** bIsInForeground

```
VAR bIsInForeground : BOOL := FALSE;
END_VAR
```

**TRUE:** At runtime, the visualization element is displayed in the foreground.

**FALSE:** At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

---

See also

- ¶ Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

---

**Visualization Element ‘Date/Time Picker’**

**Symbol:**

![Date/Time Picker Symbol](image)

**Category:** “Date/Time Controls”

The element provides the capability of selecting the date and time. The value can be changed by means of the arrow keys on the keyboard. The date can be selected from a calendar.

**Element properties**

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
<tr>
<td><strong>Example:</strong> StartDateAndTime</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Type of element”</th>
<th>“Date/Time Picker”</th>
</tr>
</thead>
</table>
The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

**Element property 'Position'**

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;X&quot;</td>
<td>X coordinate of the upper left corner of the element. Specified in pixels. Example: 10.</td>
</tr>
<tr>
<td>&quot;Y&quot;</td>
<td>Y coordinate of the upper left corner of the element. Specified in pixels. Example: 10.</td>
</tr>
<tr>
<td>&quot;Width&quot;</td>
<td>Specified in pixels. Example: 150</td>
</tr>
<tr>
<td>&quot;Height&quot;</td>
<td>Specified in pixels. Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (_drag_ ) to other positions in the editor.

See also

- Chapter 6.4.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

**Element property 'Center'**

You can also change the values by dragging the symbols (_drag_ ) to other positions in the editor.
<table>
<thead>
<tr>
<th><strong>Variable</strong></th>
<th>Variable (DATE, DT, TIME, LTIME, TOD)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The value of the value of the variable is displayed and modified by means of the element.</td>
</tr>
<tr>
<td></td>
<td>The data type automatically determines the displayed value units:</td>
</tr>
<tr>
<td></td>
<td>● TIME: Day, hour, minute, and second (by default, milliseconds are not displayed)</td>
</tr>
<tr>
<td></td>
<td>● DATE: Year, month, and day</td>
</tr>
<tr>
<td></td>
<td>● DT: Year, month, day, hour, minute, and second</td>
</tr>
<tr>
<td></td>
<td>● TOD: Hour, minute, and second (by default, milliseconds are not displayed)</td>
</tr>
<tr>
<td></td>
<td>● LTIME: Day, hour, minute, and second (by default, milliseconds, microseconds, and nanoseconds are not displayed)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Format string</strong></th>
<th>The format can restrict the output to individual values.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example for DATE: Format: yyyy/MM/dd --&gt; displayed: 2015/12/17</td>
</tr>
<tr>
<td></td>
<td>Basically, all usual formats available for %t are also supported.</td>
</tr>
</tbody>
</table>

| **Design date time picker** | ● “From style”: All settings are preconfigured according to the style. |
|                            | ● “Explicit”: The “Design settings” property is available. You can customize the calendar here. |

| **Design date picker** | ● “From style”: All settings are preconfigured according to the style. |
|                        | ● “Explicit”: The “Design settings” property is available. You can customize the calendar here. |

| **Positioning date picker** | ● “Dynamic”: The calendar is adapted and positioned automatically. |
|                            | ● “Manual”: The “Position settings” property is available. You can customize the calendar here. |

See also
- Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329

**Element property 'Absolute movement'**
The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th><strong>Movement</strong></th>
<th>Variable (numeric data type). Defines the X position (in pixels).</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>X</strong></td>
<td>Example: PLC_PRG.iPos_X.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td><strong>Y</strong></td>
<td>Variable (numeric data type). Defines the Y position (in pixels).</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iPos_Y.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
</tr>
</tbody>
</table>
| **“Rotation”** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
**Example:** PLC_PRG.iAngle1.  
The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.  
In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right. |
| **“Scaling”** | Variable (integer data type). Causes centric stretching.  
**Example:** PLC_PRG.iScaling.  
The reference point is the “Center” property.  
The value 1 shrinks the element by a factor of 0.001. The value 1000 returns the element to its original size. |
| **“Interior rotation”** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
**Example:** PLC_PRG.iAngle2.  
In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.  
The rotation point is shown as the symbol.  
Note: If a static angle of rotation is specified in the property “Position ➔ Angle”, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed. |

---

You can link the variables to a unit conversion.

The properties “X”, “Y”, “Rotation”, and “Interior rotation” are supported by the “Client Animation” functionality.

See also

- Element property ‘State variables’

The variables control the element behavior dynamically.
“Invisible” Variable (BOOL). Toggles the visibility of the element.

TRUE: The element is not visible at runtime.

Example:
```plaintext
bIsVisible with VAR bIsVisible : BOOL := FALSE;
END_VAR
```

“Deactivate inputs” Variable (BOOL). Toggles the operability of the element.

TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.

The “Invisible” property is supported by the "Client Animation“ functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

“Animation duration” Defines the duration (in milliseconds) in which the element runs an animation

- Variable (integer value)
  Example:
  ```plaintext
  Menu.tContent with VAR tContent : INT := 500;
  END_VAR
  ```
- Integer literal
  Example: 500

Animatable properties

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

“Move to foreground” Moves the visualization element to the foreground

Variable (BOOL)

Example:
```plaintext
bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR
```

TRUE: At runtime, the visualization element is displayed in the foreground.

FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

Element property 'Access rights'

Requirement: User management is set up for the visualization.

“Access rights” Opens the “Access rights” dialog. There you can edit the access privileges for the element.

Status messages:

- “Not set. Full rights.”: Access rights for all user groups : “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.
6.4.5.20.2 Placeholders with Format Definition in the Output Text

A character string which is output in the visualization can include the placeholder % for a variable. At runtime, the placeholder is replaced by the actual value of the variable in the defined format. The data type in the format definition and of the variable have to be identical. A character string can contain a maximum of one placeholder.

Character strings for output are listed in the “Text” property. The assigned variable is listed in the “Text variable” property.

See also
- Integer Data Types
- REAL/LREAL Data Type
- Time Data Types

<table>
<thead>
<tr>
<th>Placeholder</th>
<th>Description</th>
<th>Code:</th>
<th>Property “Text”</th>
<th>Property “Text variable”</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>%d</td>
<td>Output of variable (integer data type) as decimal number</td>
<td>iCounter : INT := 12;</td>
<td>Value: %i</td>
<td>PLC_PRG.iCounter</td>
<td>Value: 12</td>
</tr>
<tr>
<td>%i</td>
<td>Output of variable (integer data type) as binary number</td>
<td>byCode : BYTE := 255;</td>
<td>Coding: %b</td>
<td>PLC_PRG.byCode</td>
<td>Coding: 11111111</td>
</tr>
<tr>
<td>%b</td>
<td>Output of variable (integer data type) as unsigned octal number without a preceding zero</td>
<td>byCode : BYTE := 8#377;</td>
<td>Coding: %o</td>
<td>PLC_PRG.byCode</td>
<td>Coding: 377</td>
</tr>
<tr>
<td>%o</td>
<td>Output of variable (integer data type with max. 32 bits) as unsigned hexadecimal number without a preceding &quot;0x&quot;</td>
<td>dwCode : INT := 16#FFFFFFFF;</td>
<td>Coding: %x</td>
<td>PLC_PRG.dwCode</td>
<td>Coding: ffffffff</td>
</tr>
<tr>
<td>%x</td>
<td>Output of 64-bit variable (LWORD, LINT, ULINT) as hexadecimal number. Note: llx means &quot;long long hexadecimal&quot;</td>
<td>lwCode : LWORD := 16#4FFF_3FFF_2FFF_1FFF;</td>
<td>Coding: %llX</td>
<td>PLC_PRG.lwCode</td>
<td>Coding: 4fffffff2ff1fff</td>
</tr>
<tr>
<td>%u</td>
<td>Output of variable (integer data type) as unsigned decimal number</td>
<td>uiNumber : UINT := 1234;</td>
<td>Number: %u</td>
<td>PLC_PRG.uiNumber</td>
<td>Number: 1234</td>
</tr>
</tbody>
</table>
Floating-point numbers have the data type **REAL** or **LREAL**.

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
<th>Code</th>
<th>Property “Text”</th>
<th>Property “Text variable”</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>%f</td>
<td>In decimal form with decimal point in format 1.6</td>
<td><code>rWeight : REAL := 1.123456789;</code></td>
<td>Weight: %f</td>
<td>PLC_PRG.rWeight</td>
<td>Weight: 1.123456</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Property “Text”</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>“Text variable”</td>
<td>PLC_PRG.rWeight</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Output:</td>
<td>Weight: 1.123456</td>
<td></td>
</tr>
<tr>
<td>%&lt;alignment&gt;&lt;minimum width&gt;.&lt;accuracy&gt;f</td>
<td>As decimal number in user-defined format</td>
<td><code>rWeight : REAL := 12.1</code></td>
<td>Weight: %2.3f</td>
<td>PLC_PRG.rWeight</td>
<td>Weight: 12.100</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Property “Text”</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>“Text variable”</td>
<td>PLC_PRG.rWeight</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Output:</td>
<td>Weight: 12.100</td>
<td></td>
</tr>
<tr>
<td>%e</td>
<td>Output of floating-point number (REAL or LREAL) in exponential notation of base 10</td>
<td><code>rValue : REAL := 1.234567%e-003;</code></td>
<td>Value: %E</td>
<td>PLC_PRG.rValue</td>
<td>Value: 1.23E-6</td>
</tr>
<tr>
<td>%E</td>
<td>Output of floating-point number (REAL or LREAL) in exponential notation of base 10</td>
<td><code>rValue : REAL := 1.234567%e-003;</code></td>
<td>Value: %e</td>
<td>PLC_PRG.rValue</td>
<td>Value: 1.23e-6</td>
</tr>
<tr>
<td>%c</td>
<td>Output of single character in ASCII character set</td>
<td><code>bChar := 16#41;</code></td>
<td>Key: %c</td>
<td>PLC_PRG.bChar</td>
<td>Key: A</td>
</tr>
<tr>
<td>%s</td>
<td>Output of character string</td>
<td><code>strName := 'Paul Smith';</code></td>
<td>Name: %s</td>
<td>PLC_PRG.strName</td>
<td>Name: Paul Smith</td>
</tr>
</tbody>
</table>
For the output of the percent sign

<table>
<thead>
<tr>
<th>Output of percent sign in character string</th>
<th>Property “Text”: Valid until 90%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code: iPercentage : INT := 80;</td>
<td>Property “Text”: Valid until %d%</td>
</tr>
<tr>
<td>Property “Text variable”:</td>
<td>PLC_PRG.iPercentage := 80;</td>
</tr>
<tr>
<td>Output: Valid until 80%</td>
<td></td>
</tr>
</tbody>
</table>

For the output of the date and time

If the output text in the element “Text” property contains the placeholder “%t”, then a date and/or time is output. If a variable is not specified in the “Text variable” property, then the system time is output; otherwise it is the value of the variable.

By default, the names of the days and months are displayed in English. If localized texts are used, then the text list System has to be supplemented. This text list is created automatically in the “POUs” view when the placeholder %t is used. The English terms have to be used as the ID here. The localization can be done for both the abbreviated names and full names.

Time data types include LTIME, TIME, TIME_OF_DAY, TOD, DATE, DATE_AND_TIME, and DT.

Compatibility Notice

In order to get the usual display, in V3.5 SP17 and higher, as a rule three digits are used for the output of fractions of a second (ms/µs/ns). Example: In %t[dd-HH:mm:ss:ms], ms is specified with three digits for the milliseconds. For this purpose, the two-digit ms number is prepended with a zero. If a two-digit output is desired (like before V3.5 SP17), then a special compiler define has to be set in the compiler properties of the application: VISU_MILLISEC_NOLEADING_ZERO.

Date and time formats

<table>
<thead>
<tr>
<th>%t[yyyy] Year with century</th>
<th>Code: dateBy : DATE := DATE#2020-1-1;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Property “Text”: By the year %t[yyyy]</td>
<td>Property “Text variable”: PLC_PRG.dateBy</td>
</tr>
<tr>
<td>Output: By the year 2020</td>
<td></td>
</tr>
<tr>
<td>%t[yy] Year without century (00–99)</td>
<td>Code: dateSince : DATE := DATE#2000-1-1;</td>
</tr>
<tr>
<td>Property “Text”: Since: %t[yy]</td>
<td>Property “Text variable”: PLC_PRG.dateSince</td>
</tr>
<tr>
<td>Output: Since: 0</td>
<td></td>
</tr>
<tr>
<td>%t[y] Year without century (0–99)</td>
<td>Code: dateSince : DATE := DATE#2000-1-1;</td>
</tr>
<tr>
<td>Property “Text”: Since: %t[y]</td>
<td>Property “Text variable”: PLC_PRG.dateSince</td>
</tr>
<tr>
<td>Output: Since: 0</td>
<td></td>
</tr>
</tbody>
</table>
| %t[MMMM] | Month as full name | Code: dateMonth : DATE := DATE#2016-1-1;  
Property “Text”: Month: %t[MMMM]  
Property “Text variable”: PLC_PRG.dateMonth  
Output: Month: January |
| %t[MMM] | Month as abbreviated name | Code: dateMonth : DATE := DATE#2016-1-1;  
Property “Text”: Month: %t[MMM]  
Property “Text variable”: PLC_PRG.dateMonth  
Output: Month: Jan |
| %t[MM] | Month as number (01–12) | Code: dateMonth : DATE := DATE#2016-1-1;  
Property “Text”: Month: %t[MM]  
Property “Text variable”: PLC_PRG.dateMonth  
Output: Month: 01 |
| %t[M] | Month as number (1–12) | Code: dateMonth : DATE := DATE#2016-1-1;  
Property “Text”: Month: %t[M]  
Property “Text variable”: PLC_PRG.dateMonth  
Output: Month: 1 |
| %t[dddd] | Day of week as number (1=Monday – 7=Sunday) | Code: iDay : INT := 7;  
Property “Text”: Day: %t[dddd]  
Property “Text variable”: PLC_PRG.iDay  
Output: Day: 7 |
| %t[ddd] | Day of week as full name | Code: iDay : INT := 7;  
Property “Text”: Day: %t[ddd]  
Property “Text variable”: PLC_PRG.iDay  
Output: Day: Sunday |
| %t[ddd] | Day of week as abbreviated name | Code: iDay : INT := 7;  
Property “Text”: Day: %t[ddd]  
Property “Text variable”: PLC_PRG.iDay  
Output: Day: Sun |
| %t[dd] | Day of month as number (01–31) | Code: iDay : INT := 1;  
Property “Text”: Day: %t[dd]  
Property “Text variable”: PLC_PRG.iDay  
Output: Day: 01 |
<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Code</th>
<th>Property “Text”</th>
<th>Property “Text variable”</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>%t[jjj]</td>
<td>Day of year as number (001–366)</td>
<td>Code: dateOfNoReturn : DATE := DATE#2016-09-01;</td>
<td>Property “Text”: Day of no return: %t[jjj]</td>
<td>Property “Text variable”: PLC_PRG.dateOfNoReturn</td>
<td>Output: Day of no return: 245</td>
</tr>
<tr>
<td>%t[HH]</td>
<td>Hour in 24-hour format (00–23)</td>
<td>Code: todEnd : TOD := TIME_OF_DAY#17:0:0;</td>
<td>Property “Text”: Ends at: %t[HH]:00</td>
<td>Property “Text variable”: PLC_PRG.todEnd</td>
<td>Output: Ends at 17:00</td>
</tr>
<tr>
<td>%t.hh</td>
<td>Hour in 12-hour format (01–12)</td>
<td>Code: todEnd : TOD := TIME_OF_DAY#17:0:0;</td>
<td>Property “Text”: Ends at: %t[hh] o'clock</td>
<td>Property “Text variable”: PLC_PRG.todEnd</td>
<td>Output: Ends at: 05 o'clock</td>
</tr>
<tr>
<td>%t[mm]</td>
<td>Minutes with leading zero (00–59)</td>
<td>Code: tPeriod : TIME := T#5M;</td>
<td>Property “Text”: Period: %t[mm]m</td>
<td>Property “Text variable”: PLC_PRG.tPeriod</td>
<td>Output: Period: 05m</td>
</tr>
<tr>
<td>%t[m]</td>
<td>Minutes without leading zero (0–59)</td>
<td>Code: tPeriod : TIME := T#5m;</td>
<td>Property “Text”: Period: %t[m]'m'</td>
<td>Property “Text variable”: PLC_PRG.tPeriod</td>
<td>Output: Period: 5 m</td>
</tr>
<tr>
<td>%t[ss]</td>
<td>Seconds with leading zero (00–59)</td>
<td>Code: tPeriod : TIME := T#5m3s;</td>
<td>Property “Text”: Period: %t[mm]'m:ss's'</td>
<td>Property “Text variable”: PLC_PRG.tPeriod</td>
<td>Output: Period: 05m03s</td>
</tr>
<tr>
<td>%t[s]</td>
<td>Seconds without leading zero (0–59)</td>
<td>Code: tPeriod : TIME := T#5m3s;</td>
<td>Property “Text”: Period: %t[m]'m s's'</td>
<td>Property “Text variable”: PLC_PRG.tPeriod</td>
<td>Output: Period: 5m 3s</td>
</tr>
<tr>
<td>Code:</td>
<td>Description</td>
<td>Property “Text”</td>
<td>Property “Text variable”</td>
<td>Output:</td>
<td></td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
<td>----------------------------------</td>
<td>-----------------</td>
<td></td>
</tr>
<tr>
<td><code>tPeriod : TIME := T#500ms;</code></td>
<td></td>
<td><code>%t[ms] Milliseconds without leading zero (0–999)</code></td>
<td><code>%t[ms] 'ms'</code></td>
<td><code>%tPeriod : PLC_PRG.tPeriod</code></td>
<td>Period: 500 ms</td>
</tr>
<tr>
<td><code>ltPeriod : LTIME := LTIME#1000D23H44M12S34MS2US44NS;</code></td>
<td>Only for LTIME variables: microsecond definition (0–999)</td>
<td><code>%t[dd.HH.m.s.ms.us.ns] Period:</code></td>
<td><code>%t[dd.HH.m.s.ms.us.ns]</code></td>
<td><code>%tPeriod : PLC_PRG.ltPeriod</code></td>
<td>Period: 1000.23.44.12.34.2.44</td>
</tr>
<tr>
<td><code>%t[ns]</code> Only for LTIME variables: nanosecond definition (0–999)</td>
<td><code>%t[ns] 'ns'</code></td>
<td><code>%tPeriod : PLC_PRG.tPeriod</code></td>
<td>Period: 500 ms</td>
<td>Hint: Overflow is permitted in the greatest time unit of a definition.</td>
<td></td>
</tr>
<tr>
<td><code>tClosed : TOD := TOD#17:17:17.17;</code></td>
<td>If the value is a time &lt; 12h, then A is output; otherwise P is output.</td>
<td><code>Closed at %t[hh:mm t]</code></td>
<td><code>%tClosed : PLC_PRG.tClosed</code></td>
<td>Closed at 05:17 P</td>
<td></td>
</tr>
<tr>
<td><code>tClosed : TOD := TOD#17:17:17.17;</code></td>
<td>If the value is a time &lt; 12h, then AM is output; otherwise PM is output.</td>
<td><code>Closed at %t[hh:mm tt]</code></td>
<td><code>%tClosed : PLC_PRG.tClosed</code></td>
<td>Closed at 05:17 PM</td>
<td></td>
</tr>
<tr>
<td><code>%t[&quot;']</code></td>
<td>If character strings should be output which correspond to a format definition, then these have to be represented in single straight quotation marks.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
%t[<f><n>] A number (<n>) which defines the number of decimal places of the time value follows the letters which define the time unit (<f>).

As a result, the hours, minutes, and seconds (for TIME values) and also the microseconds and nanoseconds (for LTIME values) can be specified or displayed as values with decimal places.

Note: Even if a decimal number is not desired for the input or display, at least the number "0" has to be specified to allow for fractional input.

Examples of the formatting
%t[hh4] or %t[HH4]: The time can be specified/displayed with a hour definition of four decimal places.
%t[mm2] or %t[m2]: The time can be specified/displayed with a minute definition of four decimal places. Then for a value of t#1h20m15s, this leads to the following output: 80.25.
%t[ss0]: The time can be specified/displayed with a second definition without decimal places.

The format definitions can be represented in a series.

%t[HH:mm:ss:ms] Output of the time

Code: dwTime : DWORD := 4294967295;
Property "Text": Time: %t[HH:mm:ss:ms]
Property "Text variable": PLC_PRG.dwTime

%t[yyyy-MM-dd dddd] Output of the date and day of the week

Code: dateSet : DATE := DATE#2016-02-12;
Property "Text": Date: %t[yyyy-MM-dd dddd]
Property "Text variable": PLC_PRG.dateSet
Output: Date: 2016-02-12 Friday

See also
● Time Data Types

### 6.4.5.20.3 Methods of the Dialog Manager

Visualizations that are a “Dialog” visualization type and are used to prompt an input are instantiated automatically and managed by the internal dialog manager.

In the application, the dialog manager can be accessed via the also internal Visualization Manager by calling the method GetDialogManager.

The dialog manager is provided with the following methods for handling a dialog.

**NOTICE!**

You can program the method calls in function blocks or functions which are themselves called from the visualization by the action Execute ST Code.

Moreover, you can program the method calls in the application code. Make sure that the call runs in VISU_TASK. If this is not the case, then the behavior is undefined.
Method 'GetDialog'  Returns the instance (IVisualisationDialog) of the dialog whose name is passed.

Table 646: Inputs (VAR_INPUT)

<table>
<thead>
<tr>
<th>Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>stName</td>
<td>STRING</td>
<td>Name of the dialog</td>
</tr>
</tbody>
</table>

Table 647: Outputs (VAR_OUTPUT)

<table>
<thead>
<tr>
<th>Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GetDialog</td>
<td>VisuElems.IVisualisationDialog</td>
<td>Instance (IVisualisationDialog) of the dialog</td>
</tr>
</tbody>
</table>

Method 'GetClientInterface'  Returns a pointer to the dialog structure.

Respective dialog data held for each display variant.

Table 648: Inputs (VAR_INPUT)

<table>
<thead>
<tr>
<th>Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dialog</td>
<td>VisuElems.IVisualisationDialog</td>
<td>Name of the visualization</td>
</tr>
<tr>
<td>pClient</td>
<td>POINTER TO VisuElems.IVisualisationDialogVisuStructClientData</td>
<td>Pointer to the display variant</td>
</tr>
</tbody>
</table>

Table 649: Outputs (VAR_OUTPUT)

<table>
<thead>
<tr>
<th>Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GetClientInterface</td>
<td>Example: POINTER TO Login_VISU_STRUCT</td>
<td>Pointer to the dialog structure</td>
</tr>
</tbody>
</table>

Method 'OpenDialog'  Opens the dialog of the client.

Next to it, there is the extended method 'OpenDialog(number)'.

Table 650: Inputs (VAR_INPUT)

<table>
<thead>
<tr>
<th>Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dialog</td>
<td>VisuElems.IVisualisationDialog</td>
<td>Name of the visualization</td>
</tr>
<tr>
<td>pClient</td>
<td>POINTER TO VisuElems.VisuStructClientData</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Data Type</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>bModal</td>
<td>BOOL</td>
<td></td>
</tr>
<tr>
<td>pRect</td>
<td>POINTER TO</td>
<td></td>
</tr>
</tbody>
</table>

Table 651: Outputs (VAR_OUTPUT)

<table>
<thead>
<tr>
<th>Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OpenDialog</td>
<td></td>
<td>Closes the dialog of the client.</td>
</tr>
</tbody>
</table>

Method 'CloseDialog'

Table 652: Inputs (VAR_INPUT)

<table>
<thead>
<tr>
<th>Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dialog</td>
<td>VisuElems.IVisualisationDialog</td>
<td>Dialog object as received by GetDialog</td>
</tr>
<tr>
<td>pClient</td>
<td>POINTER TO VisuElems.VisuStructClientData</td>
<td></td>
</tr>
</tbody>
</table>

Table 653: Outputs (VAR_OUTPUT)

<table>
<thead>
<tr>
<th>Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CloseDialog</td>
<td></td>
<td>Closes the dialog of the client. Extension of the method CloseDialog.</td>
</tr>
</tbody>
</table>

Method 'CloseDialog2'

Table 654: Inputs (VAR_INPUT)

<table>
<thead>
<tr>
<th>Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dialog</td>
<td>VisuElems.IVisualisationDialog</td>
<td>Dialog object as received by GetDialog</td>
</tr>
<tr>
<td>pClient</td>
<td>POINTER TO VisuElems.VisuStructClientData</td>
<td></td>
</tr>
<tr>
<td>DialogFlags</td>
<td>DWORD</td>
<td>Specification of possible options for closing the dialogs. Only the values 0 (behavior as for CloseDialog) and 16#40 are relevant in the case that a dialog should be closed on all connected clients.</td>
</tr>
</tbody>
</table>

Table 655: Outputs (VAR_OUTPUT)

<table>
<thead>
<tr>
<th>Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CloseDialog2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

6.4.5.20.4 Attribute 'VAR_IN_OUT_AS_POINTER'

Function: The pragma `{attribute 'VAR_IN_OUT_AS_POINTER'}` allows for the passing of a reference to a data object to the interface variable of a visualization.
Requirement: The referenced visualization must be used as a dialog.

Syntax:

```
{attribute 'VAR_IN_OUT AS_POINTER'}
```

**NOTICE!**
Uppercase and lowercase characters must be maintained.

---

### Example: Declaration of an interface

**VAR_IN_OUT**

```
{attribute 'VAR_IN_OUT AS_POINTER'}
  itfController := ControlFB;
END_VAR
```

See also
- § Chapter 6.4.5.17.5 “Calling a Dialog with an Interface” on page 2962
- § Chapter 6.4.5.21.2.1 “Command 'Interface Editor” on page 3340

---

### 6.4.5.20.5 Attribute 'parameterstringof'

The pragma `{attribute 'parameterstringof'}` allows that the instance name of the specified parameter is made accessible for the referenced visualization. An interface variable (STRING) will contain the instance name of the specified parameter. The interface variable is visible within the referenced visualization and can for example be used in a text output.

Syntax:

```
{attribute 'parameterstringof' := '<variable>'}
```

**Example: declaration of an interface**

```
VAR_INPUT
{attribute 'parameterstringof' := 'iftDut_A'}
  sItfNameDut_A: STRING;
END_VAR
```

**See also**
- § Chapter 6.4.5.17.3 “Calling a Visualization with an Interface” on page 2951
- § Chapter 6.4.5.21.2.1 “Command 'Interface Editor” on page 3340

---

### 6.4.5.21 Reference, user interface

6.4.5.21.1 Keyboard Shortcuts for Default Keyboard Action........................... 3338
6.4.5.21.2 Commands.................................................................................... 3339
6.4.5.21.3 Dialog Boxes.................................................................................. 3366
6.4.5.21.4 Objects.......................................................................................... 3393
6.4.5.21.5 Visualization Elements................................................................. 3412

### 6.4.5.21.1 Keyboard Shortcuts for Default Keyboard Action

Requirement: The “Activate default keyboard handling” option is activated in the “Visualization Manager” object.
The keyboard shortcuts for default keyboard action make it possible for users to operate the visualization with the keyboard only. Elements that respond to user input can process a keyboard event instead of a mouse event. You do not have to change their input configuration for this purpose. The universal keyboard shortcuts are supported by all devices and are available on all display variants when needed.

### Keyboard shortcuts

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Tab]</td>
<td>Focus jumps to the next element.</td>
</tr>
<tr>
<td></td>
<td>The next element that responds to a configured or preconfigured user input</td>
</tr>
<tr>
<td></td>
<td>receives the focus. The order of elements corresponds to the order that</td>
</tr>
<tr>
<td></td>
<td>the elements were added to the editor.</td>
</tr>
<tr>
<td></td>
<td>If the focused element is a table, then the upper left cell in the table is</td>
</tr>
<tr>
<td></td>
<td>the next focus. After that, each next cell until all cells have been</td>
</tr>
<tr>
<td></td>
<td>focused. It also applies here that only cells that require input are</td>
</tr>
<tr>
<td></td>
<td>focused.</td>
</tr>
<tr>
<td>[Shift]+[Tab]</td>
<td>Focus jumps to the previous element.</td>
</tr>
<tr>
<td></td>
<td>The element is focused that is before the currently focused element in the</td>
</tr>
<tr>
<td></td>
<td>added order. Therefore, the order is the opposite as for “Tab”.</td>
</tr>
<tr>
<td>[Arrow]</td>
<td>The focus jumps to the element that is in the direction as indicated by the</td>
</tr>
<tr>
<td>[Input]</td>
<td>The visualization detects the input at the focused element and triggers the</td>
</tr>
</tbody>
</table>

### 6.4.5.21.2 Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.4.5.21.2.1 Command 'Interface Editor'</td>
<td>3340</td>
</tr>
<tr>
<td>6.4.5.21.2.2 Command 'Keyboard Configuration'</td>
<td>3341</td>
</tr>
<tr>
<td>6.4.5.21.2.3 Command 'Visualization Element List'</td>
<td>3342</td>
</tr>
<tr>
<td>6.4.5.21.2.4 Command 'Activate Keyboard Usage'</td>
<td>3343</td>
</tr>
<tr>
<td>6.4.5.21.2.5 Command 'Order'</td>
<td>3344</td>
</tr>
<tr>
<td>6.4.5.21.2.6 Command 'Alignment'</td>
<td>3344</td>
</tr>
<tr>
<td>6.4.5.21.2.7 Command 'Group'</td>
<td>3347</td>
</tr>
<tr>
<td>6.4.5.21.2.8 Command 'Ungroup'</td>
<td>3348</td>
</tr>
<tr>
<td>6.4.5.21.2.9 Command 'Frame Selection'</td>
<td>3348</td>
</tr>
<tr>
<td>6.4.5.21.2.10 Command 'Background'</td>
<td>3349</td>
</tr>
<tr>
<td>6.4.5.21.2.11 Command 'Multiply Visu Element'</td>
<td>3350</td>
</tr>
<tr>
<td>6.4.5.21.2.12 Command 'Configure Display Settings of Trend'</td>
<td>3353</td>
</tr>
<tr>
<td>6.4.5.21.2.13 Command 'Configure Trace'</td>
<td>3355</td>
</tr>
<tr>
<td>6.4.5.21.2.14 Command 'Export Trace Configuration'</td>
<td>3357</td>
</tr>
<tr>
<td>6.4.5.21.2.15 Command 'Insert Elements for Controlling Trace'</td>
<td>3358</td>
</tr>
<tr>
<td>6.4.5.21.2.16 Command 'Configure Display Settings of Trend'</td>
<td>3359</td>
</tr>
<tr>
<td>6.4.5.21.2.17 Command 'Edit Trend Recording'</td>
<td>3360</td>
</tr>
<tr>
<td>6.4.5.21.2.18 Command 'Insert Elements for Controlling the Trend'</td>
<td>3360</td>
</tr>
<tr>
<td>6.4.5.21.2.19 Command 'Visualization Element Repository'</td>
<td>3361</td>
</tr>
<tr>
<td>6.4.5.21.2.20 Command 'Visualization Style Repository'</td>
<td>3363</td>
</tr>
<tr>
<td>6.4.5.21.2.21 Command 'Add Visual Element'</td>
<td>3364</td>
</tr>
<tr>
<td>6.4.5.21.2.22 Command 'Select None'</td>
<td>3365</td>
</tr>
<tr>
<td>6.4.5.21.2.23 Command 'Add Elements for Alarm Acknowledgement'</td>
<td>3365</td>
</tr>
</tbody>
</table>
**Command 'Interface Editor'**

Symbol: ; keyboard shortcut: [Alt]+[F6].

**Function:** The command opens and closes the “Interface Editor” tab above the visualization editor.

**Call:** Menu bar: “Visualization ➔ Interface Editor” Also by clicking on the small down arrow at the top of the visualization editor

---

**Tab 'Interface Editor'**

Symbol: 

The tab contains an editor for the declaration of interface variables. The editor behaves in a similar way to the declaration editor of a function block, however interface variables are not initialized.

**Syntax**

```
<scope>
    {attribute '<attribute name>' ( := '<expression>' )? }?
    <identifier> : <data type>;
END_VAR

<scope> : VAR_INPUT | VAR_OUTPUT | VAR_IN_OUT
// (...)? : Optional
```

**Example**

**Declaration in the interface editor**

```
VAR_INPUT
    {attribute 'parameterstringof'}
    sIdentifier : STRING; // String for instance name
    iCounter : INT;
END_VAR

VAR_IN_OUT
    {attribute 'VAR_IN_OUT_AS_POINTER'}
    fbController: FB_Controller;
END_VAR
```

**Scopes**

Possible scopes for interfaces of visualizations or dialogs

<table>
<thead>
<tr>
<th>Scope</th>
<th>Details</th>
</tr>
</thead>
</table>
| **VAR_IN_OUT** | ● When transferring a structure  
When the visualization is instanced, it gets a reference to the current application data.  
● When transferring a control variable, if the variable is written to when a user input is made. Only then can the visualization write to it.  
Note: In the case of dialogs, the data is written back only when the dialog is closed.  
Hint: We strongly recommend that you use this scope so that the return of values is possible. Moreover, no data needs to be copied. |
| **VAR_IN_OUT** | Pragma {attribute 'VAR_IN_OUT_AS_POINTER'}  
When transferring a pointer to a data object  
In contrast to the VAR_IN_OUT scope (without an attribute), the variable changes are effective immediately and not just when the dialog is closed.  
Note: Use this scope only if the visualization implements a Dialog. |
<table>
<thead>
<tr>
<th>VAR_INPUT</th>
<th>When transferring data that will only be read</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note:</td>
<td>- If the visualization is executed as an integrated visualization, then only input variables of a basic data type (scalar type) are permitted to be transferred.</td>
</tr>
<tr>
<td></td>
<td>- If the visualization is executed as a CODESYS TargetVisu or a CODESYS WebVisu, then input variables of any data type (including POU s) can also be transferred.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>VAR_INPUT</th>
<th>When transferring a variable (data type STRING) for the instance name of the transfer parameter specified in the attribute</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pragma</td>
<td>{attribute 'parameterstringof'}</td>
</tr>
</tbody>
</table>

See also
- § Chapter 6.4.1.9.4 “Declaration of Variables” on page 1847
- § Chapter 6.4.1.20.1.2 “Declaration Editor” on page 2047
- § Chapter 6.4.5.17.3 “Calling a Visualization with an Interface” on page 2951
- § Chapter 6.4.5.17.5 “Calling a Dialog with an Interface” on page 2962
- § Chapter 6.4.5.20.5 “Attribute ‘parameterstringof’” on page 3338
- § Chapter 6.4.5.20.4 “Attribute ‘VAR_IN_OUT_AS_POINTER’” on page 3337

### Command 'Keyboard Configuration'

Symbol: 📚 keyboard shortcut: [Alt]+[F6].

**Function:** This command opens and closes the “Keyboard Configuration” tab above the visualization editor.

**Call:** Menu bar: “Visualization”.

**Requirement:** A visualization is open and active in the visualization editor.

See also
- § Chapter 6.4.5.21.4.2 “Object ‘Visualization manager’” on page 3398

### Tab ‘Keyboard configuration’

Symbol: ⎢

This tab contains a list of keyboard shortcuts with an editing option.

A keyboard shortcut can refer specifically to an element. Then the configuration appears here and in the “Input configuration” property of the associated element.

A keyboard shortcut can also have several configurations. If a keyboard shortcut has multiple keyboard configurations, then its input actions are executed in the order listed here.

Keyboard shortcuts of the default keyboard action are not listed here.

<table>
<thead>
<tr>
<th>“Key”</th>
<th>Key that a keyboard configuration is defined. Example: [M]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note</td>
<td>You can combine the key with [Ctrl], [Alt], and/or [Shift].</td>
</tr>
</tbody>
</table>

| “Key down” | | |
|------------|------------------------|
|            | [ ]: The input action is executed when the user presses the key. |
|            | [ ]: The input action is executed when the user releases the key. |
|            | Double-click: Drop-down list of all keys. |
| Note      | If the input action should be executed for both pressing the key (KeyDown) and releasing the key (KeyUp), then you must define a keyboard configuration for both input actions. |

| “Shift” | [ ]: The input event is triggered for [Shift]+[key]. |
**“Ctrl”**  
☑️ The input event is triggered for `[Ctrl]+[key].

**“Alt”**  
☑️ The input event is triggered for `[Alt]+[key].

<table>
<thead>
<tr>
<th><strong>“Action type”</strong></th>
<th>input action</th>
</tr>
</thead>
</table>
| Double-click: Drop-down list of input actions.  
Tip: For a description of input actions, refer to the “Input configuration” dialog box. | |

| **“Action”** | Configuration of the input action that was selected next.  
Double-click: A dialog box opens that varies according to the input action. It allows the user-prompted customization of the settings.  
Tip: For a description of dialog boxes, refer to the “Input configuration” dialog box. The input action is configured in the same way here. | |

| **“Element ID”** | ID of the visualization element where the user can execute the key event. The ID is relevant only if the event is also assigned to an element.  
Tip: The assignment of ID to element name is listed in the “Element list”. | |

| **“Access rights”** | Access privileges of the action per user group  
Requirement: The visualization has a user management. | |

| ✷ | Clicking the symbol on the right of the list moves the selected row one line down. |
| ✦ | Clicking the symbol on the right of the list moves the selected row one line up. |

Blank line Allows adding a new keyboard configuration.

See also

- ☑️ Chapter 6.4.5.21.2.3 “Command ‘Visualization Element List’” on page 3342
- ☑️ Chapter 6.4.5.21.3.6 “Dialog ‘Input Configuration’” on page 3370

---

**Command ‘Visualization Element List’**

Symbol: 📚

**Function:** The command opens the “Visualization Element List” tab for the current visualization. It is displayed in the upper part of the visualization editor.

**Call:** Menu bar: “Visualization”

**Requirement:** A visualization is open in the editor.

---

**Tab ‘Visualization Element List’**

This view contains a list of the visualization elements in the open visualization. Grouped elements are displayed in a tree structure and have their own order within the group (other hierarchy level).

The current selection in the list is always synchronized with the selection in the main window of the editor.

The order in the element list from top to bottom describes the order of the elements on the display layers of the visualization from back to front. When you insert elements consecutively, they are arranged starting from the back (position 0) on one layer forward. When you use the commands in the menu “Visualization ➔ Order” to move an element from front to back in the editor window, the element list refreshes accordingly.
| **“Type”** | Element type and symbol, as used in the “Visualization Toolbox” view, as well as the element number that specifies the display layer. #0 = layer furthest back. |
| **“X”** | Position of the upper left corner of the element (0,0 = upper left corner of the visualization area). |
| **“Y”** | |
| **“Width”** | Dimensions of the element (in pixels). |
| **“Height”** | |
| **“ID”** | Internally assigned element identifier |
| **“Name”** | Element name as defined in “Properties ➔ Element name”. |
| **“Access Rights”** | The lock symbol ✜ indicates the restricted behavior of an element for some user groups. |
| **“Tab Order”** | Position within the order in which you can jump from element to element in the editor by means of the tab key when the default keyboard usage is activated. The activation is done in the visualization manager, on the settings tab. Note that elements within a group or group box have their own order (different hierarchy level). The tab order initially corresponds to the order in which the elements are arranged on the layers from back to front (“Type” above). To change the position in the order for an element, you can specify a different number directly in the table field. You can also use the “Move to Position” context menu command to open a dialog for specifying a new position. Bold fonts indicate changed position specifications. By removing the displayed value, you exclude the element from the selection using tab or arrow keys. You can use the “Reset to Default” context menu command to reset a changed position to the original position. This can be done simultaneously for a multiselection of elements when they do not belong to different hierarchy levels (groupings). |

See also
- ☞ Chapter 6.4.5.21.4.1.1 “Visualization Editor” on page 3393
- ☞ Chapter 6.4.5.21.2.5 “Command ‘Order’” on page 3344
- ☞ “Moving the visualization element forward and back” on page 2875

**Command ’Activate Keyboard Usage’**

**Symbol:** ☑

**Function:** This command activates and deactivates the keyboard usage when a visualization is executed in online mode (integrated in CODESYS).

**Call:** Menu bar: “Visualization”; context menu.

**Requirement:** A visualization is open.

When this command is active, the visualization executes the keyboard events that you specified as a visualization user.

When the command is inactive, CODESYS executes the keyboard events that you specify.

See also
- ☞ Chapter 6.4.5.6.5 “Configuring Keyboard Shortcuts” on page 2892
Command 'Order'

**Function:** The command makes further commands available. They are for specifying the order of the elements in levels, since elements in the rear levels are concealed by those in the front levels.

**Call:** Menu “Visualization”, context menu

Requirements: The visualization elements are positioned behind one another.

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

Command 'Bring to Front'

Symbol: 

**Function:** The command positions the selected visualization element in the front level. The element becomes completely visible.

**Call:** Menu “Visualization ➔ Order”, context menu

Command 'Bring One to Front'

Symbol: 

**Function:** The command positions the selected visualization element one level further forwards.

**Call:** Menu “Visualization ➔ Order”, context menu

Command 'Send to Back'

Symbol: 

**Function:** The command positions the selected visualization element in the back level.

**Call:** Menu “Visualization ➔ Order”, context menu

Command 'Send One to Back'

Symbol: 

**Function:** The command positions the selected visualization element one level further backwards.

**Call:** Menu “Visualization ➔ Order”, context menu

Command 'Alignment'

**Function:** The command makes further commands available. It is used for the alignment of visualization elements in the window area of the visualization.

**Call:** Menu “Visualization”, context menu

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

Command 'Align Left'

Symbol: 

**Function:** The command aligns the selected visualization elements along a line through the left-hand edge of the element that is positioned furthest left.

**Call:** Menu “Visualization ➔ Alignment”, context menu

Requirements: Several elements are selected.

Command 'Align Top'

Symbol: 

**Function:** The command aligns the selected visualization elements along a line through the upper edge of the element that is positioned highest.
Call: Menu “Visualization ➔ Alignment”, context menu
Requirement: Several elements are selected.

Command 'Align Right'
Symbol: ⚠️
Function: The command aligns the selected visualization elements along a line through the right-hand edge of the element that is positioned furthest right.
Call: Menu “Visualization ➔ Alignment”, context menu
Requirement: Several elements are selected.

Command 'Align Bottom'
Symbol: ⬇️
Function: The command aligns the selected visualization elements along a line through the lower edge of the element that is positioned lowest.
Call: Menu “Visualization ➔ Alignment”, context menu
Requirement: Several elements are selected.

Command 'Align Vertical Center'
Symbol: ✿
Function: The command aligns the selected visualization elements to their common vertical center.
Call: Menu “Visualization ➔ Alignment”, context menu
Requirement: Several elements are selected.

Command 'Align Horizontal Center'
Symbol: ⬊
Function: The command aligns the selected visualization elements to their common horizontal center.
Call: Menu “Visualization ➔ Alignment”, context menu
Requirement: Several elements are selected.

Command 'Make Horizontal Spacing Equal'
Symbol: ⬊
Function: The command aligns the selected visualization elements so that the elements positioned furthest left and furthest right retain their position and the elements between them are positioned with the same horizontal spacing.
Call: Menu “Visualization ➔ Alignment”, context menu
Requirement: 3 or more elements are selected. The first element is blue, while the other elements are displayed in grey.

Command 'Increase Horizontal Spacing'
Symbol: ⬊
Function: The command aligns the selected visualization elements so that the blue element retains its position and the other elements are positioned with a larger horizontal spacing. The spacing increases by 1 pixel each time.
Call: Menu “Visualization ➔ Alignment”, context menu
Requirement: Several elements are selected.

Command 'Decrease Horizontal Spacing'
Symbol: ⬊
**Function:** The command aligns the selected visualization elements so that the blue element retains its position and the other elements are positioned with a smaller horizontal spacing. The spacing decreases by 1 pixel each time.

**Call:** Menu “Visualization → Alignment”, context menu

**Requirement:** Several elements are selected.

**Command 'Remove Horizontal Spacing'**

Symbol: 

**Function:** The command aligns the selected visualization elements so that the blue element retains its position and the other elements are positioned with no horizontal spacing between them.

**Call:** Menu “Visualization → Alignment”, context menu

**Requirement:** Several elements are selected.

**Command 'Make Vertical Spacing Equal'**

Symbol: 

**Function:** The command aligns the selected visualization elements so that the uppermost and lowermost elements retain their position and the elements between them are positioned with the same vertical spacing.

**Call:** Menu “Visualization”, context menu

**Requirement:** 3 or more elements are selected. The first element is blue, while the other elements are displayed in grey.

**Command 'Increase Vertical Spacing'**

Symbol: 

**Function:** The command aligns the selected visualization elements so that the blue element retains its position and the other elements are positioned with a larger vertical spacing. The spacing increases by 1 pixel each time.

**Call:** Menu “Visualization → Alignment”, context menu

**Requirement:** Several elements are selected.

**Command 'Decrease Vertical Spacing'**

Symbol: 

**Function:** The command aligns the selected visualization elements so that the blue element retains its position and the other elements are positioned with a smaller vertical spacing. The spacing decreases by 1 pixel each time.

**Call:** Menu “Visualization → Alignment”, context menu

**Requirement:** Several elements are selected.

**Command 'Remove Vertical Spacing'**

Symbol: 

**Function:** The command aligns the selected visualization elements so that the blue element retains its position and the other elements are positioned with no horizontal spacing between them.

**Call:** Menu “Visualization → Alignment”, context menu

**Requirement:** Several elements are selected.

**Command 'Make Same Width'**

Symbol: 

**Function:** The command makes the width of the selected visualization elements the same as the width of the blue selected element.

**Call:** Menu “Visualization → Alignment”, context menu
**Requirement:** Several elements are selected. The first element is blue, while the other elements are displayed in grey.

*The command does not work with lines or polygons.*

---

**Command 'Make Same Height'**

**Symbol:** 📊

**Function:** The command makes the height of the selected visualization elements the same as the height of the blue selected element.

**Call:** Menu “Visualization ➔ Alignment”, context menu

**Requirement:** Several elements are selected. The first element is blue, while the other elements are displayed in grey.

*The command does not work with lines or polygons.*

---

**Command 'Make Same Size'**

**Symbol:** 📄

**Function:** The command makes the size of the selected visualization elements the same as the size of the blue selected element.

**Call:** Menu “Visualization ➔ Alignment”, context menu

**Requirement:** Several elements are selected. The first element is blue, while the other elements are displayed in grey.

*The command does not work with lines or polygons.*

---

**Command 'Size to Grid'**

**Symbol:** 📆

**Function:** The command aligns the size and position of the selected visualization elements to the grid.

**Call:** Menu “Visualization ➔ Alignment”, context menu

**Requirement:** Several elements are selected.

*The command does not work with lines or polygons.*

---

**Command 'Group'**

**Symbol:** 🎉

**Function:** The command groups the selected visualization elements and displays them as one.

**Call:** Menu “Visualization”, context menu
**Requirement:** At least 2 elements are selected.

To select more elements you can drag a window around the desired elements with the mouse. Alternatively you can click on the desired elements while keeping the [Shift] key pressed.

To select all elements you can open the context menu of the visualization editor and choose the “Select All” command.

You can also drag and drop elements to a group. For that, press the [Shift] key while dragging the element to the group. Meanwhile the cursor changes its appearance (display a small plus sign).

See also
- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874
- Chapter 6.4.5.21.2.8 “Command ‘Ungroup’” on page 3348
- Chapter 6.4.5.21.2.22 “Command ‘Select None’” on page 3365

**Command ‘Ungroup’**

Symbol: 🌞

**Function:** The command ungroups elements again.

**Call:** Menu “Visualization”, context menu

**Requirement:** A grouping is selected.

See also
- Chapter 6.4.5.21.2.7 “Command ‘Group’” on page 3347

**Command ‘Frame Selection’**

**Function:** The command opens the “Frame Configuration” dialog.

**Call:**
- Menu bar: “Visualization”
- Click the “Configure” button in the “References” property.

**Requirement:** A “Frame” element or “Tabs” element is selected in the editor. The “Element Properties” view is open.

**Dialog ‘Frame Configuration’**

The dialog allows you to select one or more of all available visualizations. The selected visualizations are displayed at runtime in the window area of the “Frame” element or “Tabs” element.

**NOTICE!**

Visualizations can be nested at any depth by means of “Frame” elements. In order to use the “Switch to any visualization” frame selection type without any problems, a “Frame” must not contain more than 21 referenced visualizations.

For more information, see also the description for the “Input configuration” of an element: Action “Switch frame visualization”.

---

3348

3ADR010583, 1, en_US

2024/01/05
Table 656: “Available Visualizations”

| “By Visualization Name” | The list of available visualizations of the project and libraries is sorted alphabetically. |
| “By Type or Instance” | The list of available visualizations of the project and libraries is sorted by type or instance. |
| Input field for a filter | If a filter text is specified, then only those visualizations whose names contain the filter text are listed. |
| { } | Library with project visualizations below it |

Table 657: “Selected Visualizations”

| “Add” | Click the symbol to add a visualization to the list of selected visualizations. |
| | Requirement: This is selected in “Available Visualizations”. |
| | Hint: To add a visualization, double-click a visualization in “Available Visualizations”. |
| “Delete” | Click the symbol to delete a visualization from the list. |
| | Requirement: This is selected in “Selected Visualizations”. |

The visualizations are automatically numerically indexed via the order in the list. The top visualization has the index 0. The next visualization has the index 1 and so on.

Note: A “Frame” and a “Tabs” element use the variables specified in the index of the “Switch frame variable” property.

| “Move Up” | Click the symbol to move a visualization up in the list. |
| | Requirement: This is selected in “Selected Visualizations”. |
| “Move Down” | Click the symbol to move a visualization down in the list. |
| | Requirement: This is selected in “Selected Visualizations”. |

See also

- Chapter 6.4.5.21.5.6 “Visualization Element ‘Frame’” on page 3478
- Chapter 6.4.5.21.5.10 “Visualization Element ‘Tabs’” on page 3509
- “Element property ‘Switch frame variable’” on page 3292

Command 'Background'

Symbol: 🎨

Function: The dialog “Background” opens. You can define here whether the background of the visualization is colored or displayed with an image.

Call: Menu “Visualization”, context menu

See also

- Chapter 6.4.5.5.8 “Designing a background” on page 2884

Dialog 'Background'

Table 658: “Color Settings”

| “Use Color” | : Background in color |
| | Color defined as a style color or as a fixed value. |
Table 659: “Image Setting”

<table>
<thead>
<tr>
<th>“Use Image”</th>
<th>☑: Display of a background image</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Reference to an image from an image pool in the project, formally specified as an instance path: <code>&lt;Name of the image pool&gt;.&lt;ID&gt;</code></td>
</tr>
<tr>
<td></td>
<td>Example:</td>
</tr>
<tr>
<td></td>
<td>• ImagePool_A.Factory</td>
</tr>
<tr>
<td></td>
<td>• ImagePool_B.ID_B</td>
</tr>
</tbody>
</table>

Command 'Multiply Visu Element'

Symbol: 🖼

Function: The command opens the “Multiply Visu Element” dialog, which contains a configuration derived from the template element and the array declaration. You can rearrange the elements here, as well as their quantity and the index access to the array data. When you exit the dialog, a field of similar elements is created from the template element. In the properties of the new elements, array variables are now configured with precise array indexes. These new elements are those in which you have configured an array variable with index access placeholders in the template.

Call: Menu bar: “Visualization”; context menu

Requirement: The visualization is active and a configured template element is selected.

Dialog 'Multiply Visu Element'

Table 660: Tab “Basic Settings”

| “Total number of elements” | The total number is determined by the index range of the placeholders, including the setting on the “Advanced Settings” tab. The layout of the elements can be one-dimensional (as a column or row) or two-dimensional (as a table field). |
| “Horizontal” | Number of elements per row |
| Default: Number of array components (index range) of the placeholder $FIRSTDIMS$ |
| Example for array: axLampIsOn: ARRAY[0..4] OF BOOL; = 5 |
| “Vertical” | Number of rows required for the layout of all elements |
| Default |
| • When using index access placeholder $FIRSTDIMS$: |
| If the index range of the placeholder is less than five, then the layout of elements is horizontal. If the index range is greater than five, then the layout of the elements is quadratic whenever possible. |
| • When using index access placeholders $FIRSTDIMS$ and $SECONDDIMS$: |
| The number of horizontal elements is equal to the number of index ranges specified by the placeholder $FIRSTDIMS$. The number of vertical elements is equal to the number of index ranges specified by the placeholder $SECONDDIMS$. |
| “Offset between elements” | Distance between the new elements; affects the positions of the new elements |
| • “0”: The frames of the elements overlap by one pixel. |
| • “1”: The elements touch. |
| • “<n>”: A distance of n-1 pixel is visible between the elements. |
| “Horizontal” | Distance between the elements within a row (in pixels) |
| Example: 2 for a distance of one pixel |
### “Vertical”
Distance between the elements within the columns (in pixels)
Example for a distance of three pixels: 4

### “Arrangement of elements”
Origin from which the new elements are positioned and arranged
- If “Vertical” or “Horizontal” <> 1
  - “From top left”
  - “From top right”
  - “From bottom left”
  - “From bottom right”
- If “Horizontal” or “Vertical” = 1
  - “From top”
  - “From bottom”

### “Orientation”
Determines the layout of the elements in the field (row by row, or column by column)
- “Line by line”
- “Column by column”

### “Preview”
Displays the set layout and orientation of the elements as an arrow

---

**Table 661: Tab “Advanced Settings”**

**“Array access”**
Based on the template element, the precise index for accessing the array variable is calculated for each new element. The calculation is based on the array index limits as specified in the array declaration. The settings are also taken into account here.

**“1st dimension”**
Calculation guideline for the index of the first dimension that replaces $FIRSTDIM$
- The first new element gets the value specified below in “Start index” in the first dimension. The other elements each get an index incremented by “Increment” until an index is calculated for all elements.
- Example
  - “Start index”: 1
  - “Increment”: 1

**“2nd dimension”**
Calculation guideline for the index of the second dimension that replaces $SECONDDIM$
- The first new element gets the value specified below in “Start index” in the second dimension. The other elements each get an index incremented by “Increment”.
- Example
  - “Start index”: 1
  - “Increment”: 1

**“OK”**
First, it is validated whether the calculated indices are in the index range of the array variable. If so, then the elements that match the template element are created and arranged as a field (row, column, or table). The placeholder indexes are replaced by the calculated indexes.
Example

Declaration of array variables

```pascal
VAR
  asTexts_Example: ARRAY[1..2,1..2] OF STRING :=
  [
    '1A Text', '2A Text',
    '1B Text', '2B Text'
  ];
  asToolTips_Example: ARRAY[1..2,1..2] OF STRING :=
  [
    '1A Tooltip', '2A Tooltip',
    '1B Tooltip', '2B Tooltip'
  ];

  axUserInput_Example: ARRAY[1..2,1..2] OF BOOL;
END_VAR
```

Visualization with template element and its property configuration

Table 662: Dialog 'Multiply Visu Element'

<table>
<thead>
<tr>
<th>Tab “Basic Settings”</th>
<th>“Total number of elements”</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Horizontal”</td>
<td>2</td>
</tr>
<tr>
<td>“Vertical”</td>
<td>2</td>
</tr>
<tr>
<td>“Offset between elements”</td>
<td></td>
</tr>
<tr>
<td>---------------------------</td>
<td>--</td>
</tr>
<tr>
<td>“Horizontal”</td>
<td>2</td>
</tr>
<tr>
<td>“Vertical”</td>
<td>2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Arrangement of elements”</th>
<th>“From top left”</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Orientation”</td>
<td>“Line by line”</td>
</tr>
</tbody>
</table>

**Tab “Advanced Settings”**

<table>
<thead>
<tr>
<th>“Array access”</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“1st dimension”</td>
<td></td>
</tr>
</tbody>
</table>

| “Start index” | 1 |
| “Increment” | 1 |

<table>
<thead>
<tr>
<th>“2nd dimension”</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“Start index”</td>
<td>1</td>
</tr>
<tr>
<td>“Increment”</td>
<td>1</td>
</tr>
</tbody>
</table>

**Visualization at runtime:**

![Visualization Image]

**See also**

- Chapter 6.4.5.11.3 “Configuring and Multiplying Visualization Elements as Templates” on page 2918

**Command 'Configure Display Settings of Trend'**

**Symbol:** 🎨

**Function:** When you execute this command in “Visualization” or in the context menu, the “Edit Display Settings” dialog opens.
Call:
- Menu bar: “Visualization”
- Context menu of a “Trend” element in the visualization editor
- Property “Diagram”

**Requirement:** A trend is selected in the active visualization editor.

### Tab “X Axis”

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Grid”</td>
<td>Trend diagram with grid lines in the X-direction in the selected color</td>
</tr>
<tr>
<td>“Font”</td>
<td>Font for the axis label</td>
</tr>
</tbody>
</table>

### Tab “Y axis”

#### Table 663: “Display mode”

<table>
<thead>
<tr>
<th>Display Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Auto”</td>
<td>The visualization scales automatically.</td>
</tr>
<tr>
<td>“Fixed”</td>
<td>Fixed range from “Minimum” to “Maximum”</td>
</tr>
</tbody>
</table>

#### “Minimum”

<table>
<thead>
<tr>
<th>Minimum</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Literal, variable (integer data type), or constant variable (integer data type). It contains the initial value of the segment. Requirement: The “Display Mode” is “Fixed”.</td>
<td></td>
</tr>
</tbody>
</table>

**Examples:** 20, PLC_PRG.iLimit_Min, GVL.c_iLimit_Min

**Note:** The variable has to have an initial value. This is important for the offline display and the scaling subdivision. Example: iLimit_Min : INT := 20

#### “Maximum”

<table>
<thead>
<tr>
<th>Maximum</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Literal, variable (integer data type), or constant variable (integer data type). It contains the end value of the segment. Requirement: The “Display Mode” is “Fixed”.</td>
<td></td>
</tr>
</tbody>
</table>

**Examples:** 80, PLC_PRG.iLimit_Max, GVL.c_iLimit_Max

**Note:** The variable has to have an initial value. This is important for the offline display and the scaling subdivision. Example: iLimit_Max : INT := 80

#### “Grid”

- Trend diagram with grid lines in the Y-direction in the selected color

#### “Description”

- Text for labeling the Y-axis (for example, DC/mA)

#### Table 664: “Tick marks”

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Fixed spacing”</td>
<td>Axis scale with tick marks for “Distance” and “Subdivisions”</td>
</tr>
<tr>
<td>“Distance”</td>
<td>Distance between the tick marks (example: 2)</td>
</tr>
<tr>
<td>“Subdivisions”</td>
<td>Number of subdivisions between tick marks (example: 4)</td>
</tr>
</tbody>
</table>

#### “Font”

- Font for the axis label

#### Table 665: “Background”

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“From visualization style”</td>
<td>Background color as defined in the visualization style</td>
</tr>
<tr>
<td>“Draw background”</td>
<td>Background color which is selected in the lower input field</td>
</tr>
<tr>
<td>“No background”</td>
<td>Trend diagram with transparent background</td>
</tr>
</tbody>
</table>

**Background color of the trend diagram**

**Requirement:** “Draw background” is activated.
| **“Reset”** | Resets the settings to the default settings |
| **“Use as default”** | Saves the settings as default |

| **“Add Y-axis”** | Extends the trend diagram by one Y-axis |
| **Result:** | The “Trend Recording” editor contains an extended selection of Y-axes in the “Additional axes” option of the “Variable Settings”. |

| **“Delete Y-axis”** | Deletes the Y-axis of the visible tab. |

See also
- Chapter 6.4.5.21.2.16 “Command ‘Configure Display Settings of Trend’” on page 3359
- Editor ‘Trend Recording’

**Command ‘Configure Trace’**

Symbol: 📊

**Function:** This command opens the “Trace Configuration” dialog box.

**Call:** Context menu of the visualization element; “Trace” property of the visualization element.

**Requirement:** An element of type “Trace” is open in the editor.

**Dialog box ‘Trace Configuration’**

The tree view shows the trace configuration and allows navigation.

The top entry contains the trace name. When this entry is selected, the “Record Settings” group appears in the adjacent view.

An entry is located here for each variable that data was recorded continuously. When a variable is selected, the “Variable Settings” group appears in the adjacent view.

| **“Add variable”** | Adds a new entry to the trace configuration. |
| **Result:** | A blank configuration appears next to the new variable under “Variable Settings”. You configure the variable there. |

| **“Delete variable”** | Removes the selected variable. |

**‘Recording Settings’**

A trigger can be configured in the trace only.

| **“Task”** | Task where data was recorded. |
| **“Record condition”** | Recording condition for which the application records data in runtime mode: |
| | Variable (BOOL) |
| **“Comment”** | Example: Acquiring data only when all conditions are true. |
| **“Resolution”** | Measure for the time stamp that is recorded per data set. |
| | “ms”: Time stamp (in milliseconds). |
| | “µs”: Time stamp (in microseconds) for a task cycle time of 1 ms or less |
| **“Automatic restart”** | ✔: Recording starts automatically as soon as the trace has been started one time and then the controller was restarted. The trace configuration and the contents of the trace buffer are saved persistently to a file on the target system. |
| | Format: .trace.csv |
| **“Display”** | The “Edit Appearance” dialog box opens. |
The "Advanced Trace Settings" dialog box opens.

The "Copy Settings from Trace Instance" dialog box opens. If you have already created an existing trace configuration from a trace object, then you can copy the configuration data to the visualization element. To do this, select the respective object.

See also
- Chapter 6.4.5.21.3.19 “Dialog ‘Display Settings’” on page 3391
- Chapter 6.4.5.21.3.18 “Dialog ‘Advanced Trace Settings’” on page 3391
- Chapter 6.4.5.20.1.34 “Visualization Element ‘Trace’” on page 3240

'Variable Settings'

<table>
<thead>
<tr>
<th>&quot;Variable&quot;</th>
<th>Variable for recorded value.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Variable (valid data type)</td>
<td></td>
</tr>
<tr>
<td>• property</td>
<td></td>
</tr>
<tr>
<td>• Reference</td>
<td></td>
</tr>
<tr>
<td>• Contents of the pointer</td>
<td></td>
</tr>
<tr>
<td>• Array element (base type with valid data type)</td>
<td></td>
</tr>
<tr>
<td>• Enumeration (base type with valid data type)</td>
<td></td>
</tr>
</tbody>
</table>

Valid data types are all standard types, except STRING, WSTRING, and ARRAY.

<table>
<thead>
<tr>
<th>&quot;Parameters&quot;</th>
<th>Parameter whose value is acquired.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Enables toggling between &quot;Variable&quot; and &quot;Parameter&quot;</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Attached axis&quot;</th>
<th>Y-axis of the trace diagram for the &quot;Variable&quot;.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Enables toggling between standard y-axis and additional configured y-axes</td>
</tr>
</tbody>
</table>

Note: The additional configured y-axes are configured in the "Edit Display Settings" dialog box.

<table>
<thead>
<tr>
<th>&quot;Display variable name&quot;</th>
<th>The trace graphs are displayed in tooltip with their variable names.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If a text is also specified in &quot;Description&quot;, then the text is displayed first with the variable names in parentheses. Example: Sensor A (PLC_PRG.iSensor_A)</td>
</tr>
<tr>
<td></td>
<td>If &quot;Description&quot; does not contain any text, then the &quot;Display Variable Name&quot; property is activated automatically. Then only the name is displayed (example: PLC_PRG.iSensor_A).</td>
</tr>
<tr>
<td></td>
<td>The trace graphs are displayed in tooltip without their variable names. Only the text in &quot;Description&quot; is displayed.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Description&quot;</th>
<th>Text for the tooltip. It is displayed when a visualization user moves the cursor in the trace diagram.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: Sensor A</td>
</tr>
<tr>
<td></td>
<td>The text is also entered into the &quot;GlobalTextList&quot; object and can be translated there.</td>
</tr>
</tbody>
</table>

| "Color" | Color of the graph in the diagram. |

<table>
<thead>
<tr>
<th>&quot;Line type&quot;</th>
<th>Representation of the graph as a line chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Line&quot;: Values are linked to form a line.</td>
<td></td>
</tr>
<tr>
<td>&quot;Step&quot;: Values are linked in the form of steps.</td>
<td></td>
</tr>
<tr>
<td>&quot;None&quot;: Values are not linked.</td>
<td></td>
</tr>
</tbody>
</table>
| **“Line width”** | In pixels  
Example: 1 |
| **“Line style”** | The display of the line is solid, dash, dot, dash-dot, or dash-dot-dot. |
| **“Dot type”** | Representation of the graph as a scatter chart. This configuration entry with the “Line type” determines the appearance of the graph.  
• “Dot”: Each value as a dot.  
• “Cross”: Each value as a cross.  
• “None”  
Note: For “Dot” or “Cross”, a paint buffer overflow can result from many recorded variables. |
| **“Warning at minimum”** | ![Checkmark]: When below the lower limit, the visualization shows the trace graphs in the alert color. |
| **“Critical lower limit”** | Minimum Value  
Example: 10. |
| **“Color”** | Warning color on falling below the limit |
| **“Warning at maximum”** | ![Checkmark]: When above the upper limit, the visualization shows the trace graphs in the alert color. |
| **“Critical upper limit”** | Maximum value  
Example: 90 |
| **“Color”** | Warning color on exceeding the limit |
| **“Dynamic appearance options”** | |
| **“Variable for visibility”** | Variable (BOOL) or as bit access. This controls the visibility of the variables in the trace diagram.  
• TRUE: Visible  
• FALSE: Invisible |

See also
- Chapter 6.4.5.21.2.13 “Command ‘Configure Trace’” on page 3355

**Command ‘Export Trace Configuration’**

**Function:** This command opens the “Export Trace Configuration” dialog box.  
**Call:** context menu (right-click) the upper node in the tree view of the trace configuration.  
**Requirement:** The dialog box “Trace Configuration” is active and the name of the trace configuration is selected in the tree view (example: Visu_Trace1).

**Dialog box ‘Export Trace Configuration’**

This dialog is used for saving the trace configuration to a text file that can be read by the runtime system.

| **“File name”** | Name of text file to be created. |
| **“File type”** | “Trace file (*.trace)”: Format that the runtime system component CmpTraceMgr expects for reading. |
Command 'Insert Elements for Controlling Trace'

Symbol: 

**Function:** The command opens the “Trace Wizard” dialog. In this dialog, you select predefined visualization elements for controlling the trace recording. These elements are then inserted as configured into the visualization editor.

**Call:** Menu bar: “Visualization”; context menu of the trace element.

**Requirement:** The view is active and a trace element is selected.

### Dialog 'Trace wizard'

<table>
<thead>
<tr>
<th>“Control variable”</th>
<th>Corresponds to the “Control variables” property that is available in the element properties of the trace element.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>: The control element for this trace control variable is created in the visualization editor.</td>
</tr>
<tr>
<td>“Variable”</td>
<td>Project variables that are assigned to the control element below the “Input configuration” property. In addition, the project variables are declared as local variables in the visualization when needed (in the interface editor).</td>
</tr>
<tr>
<td></td>
<td>: This list corresponds to the assignments that are defined in the element properties of the trace element. If nothing is configured in the properties of the trace element (no project variables assigned as control variables), then a pre-allocation is offered with default variable names.</td>
</tr>
<tr>
<td>“Type of element to insert”</td>
<td>For a Boolean variable, this element can be inserted as a button or rectangle. For a string variable, a rectangle or a text field is provided.</td>
</tr>
<tr>
<td>“OK”</td>
<td>At the closing of the dialog, the selected control elements are inserted into the visualization editor and (when needed) its control variables are created as local variables of the visualization. They are declared in the interface editor and they are used by the control element (property “Input configuration” ➔ Toggle ➔ Variable”) and by the trace element (“Control variables” property). The control element writes to the variable and the trace element reads the variable.</td>
</tr>
</tbody>
</table>

**Example**

**Standard control variables:**

```plaintext
VAR
  bResetTrigger : BOOL;
  bStart : BOOL;
  bStop : BOOL;
  bStore : BOOL;
  sStoreFilename : STRING;
  bRestore : BOOL;
  sRestoreFilename : STRING;
END_VAR
```

See also

-  Chapter 6.4.5.21.13 “Command 'Configure Trace’” on page 3355

See also

-  Chapter 6.4.5.12.2 “Getting started with trace” on page 2926
**Command 'Configure Display Settings of Trend'**

**Symbol:** 🛠️

**Function:** When you execute this command in “Visualization” or in the context menu, the “Edit Display Settings” dialog opens.

**Call:**
- Menu bar: “Visualization”
- Context menu of a “Trend” element in the visualization editor
- Property “Diagram”

**Requirement:** A trend is selected in the active visualization editor.

**Tab “X Axis”**

| “Grid” | : Trend diagram with grid lines in the X-direction in the selected color |
| “Font” | Font for the axis label |

**Tab “Y axis”**

**Table 666: “Display mode”**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Auto”</strong></td>
<td>: The visualization scales automatically.</td>
</tr>
<tr>
<td><strong>“Fixed”</strong></td>
<td>: Fixed range from “Minimum” to “Maximum”</td>
</tr>
</tbody>
</table>
| **“Minimum”** | Literal, variable (integer data type), or constant variable (integer data type). It contains the initial value of the segment. Requirement: The “Display Mode” is “Fixed”.
Examples: 20, PLC_PRG.iLimit_Min, GVL.c_iLimit_Min
Note: The variable has to have an initial value. This is important for the offline display and the scaling subdivision. Example: iLimit_Min : INT := 20 |
| **“Maximum”** | Literal, variable (integer data type), or constant variable (integer data type). It contains the end value of the segment. Requirement: The “Display Mode” is “Fixed”.
Examples: 80, PLC_PRG.iLimit_Max, GVL.c_iLimit_Max
Note: The variable has to have an initial value. This is important for the offline display and the scaling subdivision. Example: iLimit_Max : INT := 80 |
| **“Grid”** | : Trend diagram with grid lines in the Y-direction in the selected color |
| **“Description”** | : Text for labeling the Y-axis (for example, DC/mA) |

**Table 667: “Tick marks”**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Fixed spacing”</strong></td>
<td>: Axis scale with tick marks for “Distance” and “Subdivisions”</td>
</tr>
<tr>
<td><strong>“Distance”</strong></td>
<td>Distance between the tick marks (example: 2)</td>
</tr>
<tr>
<td><strong>“Subdivisions”</strong></td>
<td>Number of subdivisions between tick marks (example: 4)</td>
</tr>
</tbody>
</table>

| “Font” | Font for the axis label |

**Table 668: “Background”**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“From visualization style”</strong></td>
<td>Background color as defined in the visualization style</td>
</tr>
<tr>
<td><strong>“Draw background”</strong></td>
<td>Background color which is selected in the lower input field</td>
</tr>
<tr>
<td><strong>“No background”</strong></td>
<td>Trend diagram with transparent background</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>Background color of the trend diagram</td>
<td>Requirement: “Draw background” is activated.</td>
</tr>
</tbody>
</table>

| **“Reset”** | Resets the settings to the default settings |
| **“Use as default”** | Saves the settings as default |

<table>
<thead>
<tr>
<th><strong>“Add Y-axis”</strong></th>
<th>Extends the trend diagram by one Y-axis</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Result: The “Trend Recording” editor contains an extended selection of Y-axes in the “Additional axes” option of the “Variable Settings”.</td>
</tr>
</tbody>
</table>

| **“Delete Y-axis”** | Deletes the Y-axis of the visible tab. |

See also

- Chapter 6.4.5.21.2.12 “Command ‘Configure Display Settings of Trend’” on page 3353
- Editor ‘Trend Recording’

Command 'Edit Trend Recording'

Symbol: 📊

**Function:** This command opens the “Trend Recording” object.

**Call:**
- Menu bar: “Visualization”
- Context menu of a “Trend” element in the visualization editor
- Property “Trend recording”

**Requirement:** An element of type “Trend recording” is selected in the visualization editor.

See also

- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
- Chapter 6.4.1.21.2.33 “Object ‘Trend Recording’” on page 2545

Command 'Insert Elements for Controlling the Trend'

Symbol: 🔍

**Function:** When you execute this command in “Visualization”, the “Trend Wizard” dialog box opens.

**Call:** Menu bar: “Visualization”; context menu of a “Trend” element in the visualization editor.

**Requirement:** A trend is selected in the active visualization editor.

**Dialog ‘Trend wizard’**

Each row of the table contains a control element that can assigned to the trend. The elements are placed in the visualization next to the trend. The control elements are saved in the “Assigned control elements” property and can be modified there.
"Attached control element" The associated element is available in the visualization and connected with the trend via the property "Assigned Visu element". The element is inserted into the visualization.

Deactivating the option does not cause the element to be deleted from the visualization.

"Position" Position of the control element in relation to the trend.

"Type of element to insert" Drop-down list with the installed types of the control element

"Instance name" Instance name of the control element

See also

● Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

Command 'Visualization Element Repository'

Symbol: 📜

Function: This command opens the "Visualization Element Repository" dialog box opens for editing the storage location and visualization profile.

Call: Menu bar: “Tools”.

Requirement: No project is open.

The visualization element repository is used for creating a visualization profile or visualization extension. This is necessary when developing your own visualization elements with the CODESYS VisuElement Toolkit. The CODESYS VisuElement Toolkit is required for this with a valid license. Users who do not wish to create their own visualization elements can use this dialog to find out which elements are included in which visualization profile. A reconfiguration of the storage location for a repository is also important only for element developers.

NOTICE!

1. Only an empty directory can be selected as a new storage location for a repository.

2. The "System" repository cannot be modified. This is indicated by the entry in italics in the repository list.

Currently only a single version of an element can be installed.

Dialog box 'Visualization Element Repository'

Table 669: Editing the repository

<table>
<thead>
<tr>
<th>&quot;Location&quot;</th>
<th>Storage location for the repository in the file system. The drop-down list contains the configured repositories for visualization elements.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Edit locations&quot;</td>
<td>Opens the &quot;Edit Repositories&quot; dialog box for modifying the repository currently selected in &quot;Location&quot; or for creating a new repository.</td>
</tr>
</tbody>
</table>
Table 670: “Profile or extension selection”

A profile is a collection of visualization elements in a specific version. These elements originate from one or more libraries. They are available in the toolbox of the visualization editor when the profile is used in the project. You can use an extension to add a specific selection of elements to an existing profile.

Creating and editing a profile is possible only if the CODESYS VisuElement Toolkit is installed. In this case, the buttons on the right side of the dialog box can be used.

**“Create or update profile”**

You can configure a new profile in the dialog or modify an existing one. Then, the “New”, “Copy”, and “Delete” buttons are operable, as well as the “Installed Elements” and “Available Elements” views.

**“Create or update extension”**

In the dialog, you can configure an extension for the selected profile. Another drop-down list “Extension” appears with all currently available extensions.

To configure a new extension, use the “New” or “Copy” buttons (see below).

In both cases, the “Specify Visualization Extension” dialog box opens for you to define a new extension. In this dialog box, the “Name”, “Company”, and “Version” of the extension are displayed. Version syntax: Sequence of numbers and points with a number at the end.

**“Profile”**

Currently selected profile. The drop-down list provides all profiles available in the repository set above.

**“Extension”**

The extension that is currently selected for the specified profile. The drop-down list provides all extensions available for the profile.

**“New”**

Pressing the button opens the “Specify Name of Visualization Profile” dialog or the “Specify Visualization Extension” dialog. Specify a unique name for the new profile, or for an extension also the company name and the version. CODESYS automatically enters the previously used name, appended with “_0”.

The “Installed elements” list is empty.

**“Copy”**

Pressing the button opens the “Specify Name of Visualization Profile” dialog or the “Specify Visualization Extension” dialog (see above: “New”).

The elements of the selected profile are accepted and they appear in the “Installed elements” view.

**“Delete”**

The currently set profile or the extension is deleted, and then the drop-down list is removed.

Table 671: “Installed Elements”

<table>
<thead>
<tr>
<th>Name, Vendor, Library</th>
<th>Elements that are assigned to the selected profile.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Uninstall”</strong></td>
<td>All elements currently selected in the list are uninstalled and removed from the “Available Elements” list.</td>
</tr>
<tr>
<td><strong>“Update code”</strong></td>
<td>The list is refreshed with any changes in the implementation code of the library POU.</td>
</tr>
<tr>
<td><strong>“Update all”</strong></td>
<td>The list is refreshed with any changes in the implementation code and in the interfaces (declaration part) of the library POU.</td>
</tr>
</tbody>
</table>
Elements that are available in the system and can be installed into the current profile or extension. The selection depends on the installed element libraries and element packages. The tree structure displays the libraries with the contained elements below them. Elements display in green are already installed for the specified profile or extension. “Profiles” shows the elements installed for the profiles.

The elements selected in the list are added to the “Installed Elements” view. Existing elements are overwritten.

The “Library Repository” dialog box opens where another library can be installed in order to accept its elements in the “Available Elements” view.

When refreshing the list, only the most current version of the library is searched, not all libraries.

For actions that change the profile, the usual prompt does not appear for confirming the change.

For managing the visualization elements, one or more repositories can be used. All currently defined storage locations are listed here with file path and name. The order from top to bottom is also the search order for the visualization elements.

File path and name of the storage location selected previously in the “Repository for Visualization Elements” dialog.

Note: A storage location "System" is always defined automatically, which cannot be modified or deleted.

Opens the “Storage Location for Repository” dialog for creating a new storage location or for editing the current storage location.

Specify: “Storage location” (file path of an empty directory) and “Name”. The name is symbolic (example: "Elements category 1").

Deletes the repository currently selected in the repository list.

Moves the entries within the list. Note: The repositories are searched from top to bottom.

This command opens the “Visualization Styles” dialog box. It makes it possible to edit visualization style repositories.

Call: Menu bar: “Tools”.

See also

- Chapter 6.4.5.19.3 “Managing visualization styles in repositories” on page 2985
Dialog Box 'Visualization Styles' 

<table>
<thead>
<tr>
<th>“Storage location”</th>
<th>Name of the currently selected repository Preset: “System”</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>▼: Lists the repositories installed in the development system.</td>
</tr>
<tr>
<td>“(...)”</td>
<td>Storage location of the repository Example: (C:\ProgramData\CODESYS\Visualization Styles)</td>
</tr>
<tr>
<td>“Edit locations”</td>
<td>The “Edit Repository Locations” dialog box opens.</td>
</tr>
</tbody>
</table>

Table 673: “Installed Visualization Styles”

<table>
<thead>
<tr>
<th>“Company”</th>
<th>When a company name is specified here, the tree view is filtered and only the styles of the selected company are listed. Preset: “(All companies)” It is not filtered. ▼: Lists all companies that are specified in the styles.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows with styles</td>
<td>Tree view of all versions of the installed visualization styles in the selected repository</td>
</tr>
<tr>
<td>“Display localized names”</td>
<td>[✓]: The style name is localized and displayed in the language that is set in CODESYS. [☐]: The style is display as the source name.</td>
</tr>
<tr>
<td>“Install”</td>
<td>The “Select Visualization Style(s)” dialog box opens.</td>
</tr>
<tr>
<td>“Uninstall”</td>
<td>The selected style version is removed from the repository.</td>
</tr>
<tr>
<td>“Preview”</td>
<td>The windows closes. A preview is displayed of the selected style in the selected version. Specific elements are displayed in the style.</td>
</tr>
</tbody>
</table>

Dialog box 'Edit Repository Locations'

Table 674: “Repositories (elements are searched in that order)”

<table>
<thead>
<tr>
<th>“Location”</th>
<th>Storage location of the configured repository on the development system Example: C:\ProgramData\CODESYS\Visualization Styles</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Name”</td>
<td>Preset: System</td>
</tr>
<tr>
<td>“Add”</td>
<td>The “Repository Locations” dialog box opens. It makes it possible to manage other repositories.</td>
</tr>
<tr>
<td>“Edit”</td>
<td></td>
</tr>
<tr>
<td>“Remove”</td>
<td></td>
</tr>
<tr>
<td>“Move Up”</td>
<td>The order in the list of repositories is adapted. It defines the processing order when searching for elements.</td>
</tr>
<tr>
<td>“Move Down”</td>
<td></td>
</tr>
</tbody>
</table>

Command 'Add Visual Element’

Function: The command opens a menu containing all available visualization elements as menu items.

Requirement: You have configured the command in the dialog box “Customize” in a way that you have a call in a (any) menu.
When you select an element in the menu, the element is added in the visualization editor in the upper left corner.

See also

- Chapter 6.4.5.5.2 “Select Element” on page 2873
- Chapter 6.4.1.21.3.9.16 “Command ‘Customize’” on page 2667

Command 'Select None'

**Function:** The command cancels at once any selection in the current visualization editor.

**Requirement:** You have configured the command in the dialog box “Customize” in a way that you have a call in a (any) menu.

See also

- Chapter 6.4.5.5.2 “Select Element” on page 2873
- Chapter 6.4.5.21.2.7 “Command ‘Group’” on page 3347
- Chapter 6.4.1.21.3.9.16 “Command ‘Customize’” on page 2667

Command 'Add Elements for Alarm Acknowledgement'

**Symbol:** 🕵️‍♂️

**Function:** This command adds buttons automatically to the visualization for acknowledging alarms. It opens an assistant for inserting controls below the table.

**Call:** Menu bar: “Visualization”; context menu of visualization element "Alarm table"

**Requirement:** An "Alarm table" visualization element is selected.

<table>
<thead>
<tr>
<th>Type of element(s) to insert</th>
<th>Button</th>
<th>Rectangle</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Action</strong></td>
<td>☑️: A button or a rectangle with the selected function is added to the visualization.</td>
<td></td>
</tr>
<tr>
<td><strong>Variable</strong></td>
<td>If you have already specified a variable for an action, then this is displayed here in the “Variable” column. If you have not defined a variable yet, then a local visualization variable is created automatically.</td>
<td></td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.5.21.5.22 “Visualization Element 'Alarm Table’” on page 3591
Dialog 'Access Rights'

**Function:** This dialog defines the permissions of user groups for a visualization element.

**Call:** Click in the “Value” field of the “Access Rights” element property of a visualization element.

**Requirement:** A visualization element is selected in a visualization element and the “Properties” is open.

<table>
<thead>
<tr>
<th>“User Groups”</th>
<th>Groups that were configured in the “Visualization Manager” (tab “User Management” ➔ Groups”).</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Operable”</td>
<td>☑: The visualization element is available with full functionality.</td>
</tr>
<tr>
<td>“Only Visible”</td>
<td>☑: The visualization element is visible only and does not provide any functionality.</td>
</tr>
<tr>
<td>“Invisible”</td>
<td>☑: The visualization element is not displayed.</td>
</tr>
<tr>
<td>“Group hierarchy is used”</td>
<td>Display whether the option “Use group hierarchy” is activated in the “Visualization Manager” (tab “User Management” ➔ Settings”).</td>
</tr>
</tbody>
</table>

A group of a higher hierarchy cannot have fewer permissions for an element than an element of a lower hierarchy.

If no user is logged in, then the permissions apply for the visualization elements that are configured for the user group “None”. If the permissions for a visualization element is restricted, then the group “None” should be granted the lowest permissions.

See also

- ☰ Chapter 6.4.5.21.4.5 “Tab ‘Visualization manager’ - ‘User management’” on page 3403
Dialog 'Add Visualization'

**Function:** The dialog is used to create a new object of type “Visualization”.

**Call:** Menu bar: “Project ➔ Add Object ➔ Visualization”; context menu of an application

**Requirement:** An application is selected in the device tree.

| “Name” | Name of the visualization  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: Visu_A</td>
</tr>
</tbody>
</table>

The following settings are displayed only when you add a “Visualization” object to the project for the first time.

<table>
<thead>
<tr>
<th>“Symbol library”</th>
<th>List of all installed symbol libraries</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Assigned”</td>
<td>☑: Symbol library is selected</td>
</tr>
<tr>
<td></td>
<td>Hint: CODESYS manages this setting in the project settings.</td>
</tr>
</tbody>
</table>

| “Add” | CODESYS creates a new visualization, assigns the selected symbol libraries to the project, and lists them in the “Visualization Toolbox” view. |

See also

- ☺ Chapter 6.4.5.5.2 “Select Element” on page 2873
- Dialog 'Project Settings' - 'Visualization'
- Command 'Add Object'

Dialog 'Update Frame Parameters'

**Function:** The dialog requests you, after changing an interface in the visualization references concerned, to re-assign the variables for the parameter transfer.

**Call:** The dialog appears automatically.

**Requirement:** You have changed the interface of a visualization, for example by adding an additional variable. After that, you have clicked either “File ➔ Save Project” or “Build ➔ Generate Code”, or opened a visualization.

<table>
<thead>
<tr>
<th>“Parameter”</th>
<th>Hierarchical structure of the interface parameters as a tree view</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Top node of the visualization hierarchy with the name of the visualization. This contains an element of type “Frame” or “Tabs”.</td>
</tr>
<tr>
<td></td>
<td>Name of the element (&quot;Frame&quot; or &quot;Tabs&quot; type)</td>
</tr>
<tr>
<td></td>
<td>Name of the referenced visualization</td>
</tr>
<tr>
<td>“(Recent)”</td>
<td>Interface of the referenced visualization with the new parameters</td>
</tr>
<tr>
<td></td>
<td>You can edit the parameter transfer here.</td>
</tr>
<tr>
<td>“(Previous)”</td>
<td>Interface of the referenced visualization with the previously valid parameters</td>
</tr>
<tr>
<td></td>
<td>You cannot edit the parameter transfer, but you can use it as a template.</td>
</tr>
<tr>
<td>&lt;name&gt;</td>
<td>Variable for the parameter transfer (VAR_INPUT scope)</td>
</tr>
<tr>
<td>&lt;name&gt;</td>
<td>Variable for the parameter transfer (VAR_IN_OUT scope)</td>
</tr>
</tbody>
</table>
### Table: Parameter Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>Data type of the variable&lt;br&gt;Example: INT</td>
</tr>
<tr>
<td><strong>Value</strong></td>
<td>Variable that is transferred as a parameter and with whose value the visualization is initialized during instantiation.&lt;br&gt;Example: PLC_PRG.iVisNr&lt;br&gt;If the variable lies under the current interface, which is marked in the tree view with &quot;(Current)&quot;, then you can edit the parameter transfer.&lt;br&gt;● Click in the field to open the input field.&lt;br&gt;● Double-click in the field to open the Input Assistant.&lt;br&gt;● Accept the settings by copying assignments in the “Value” column and pasting them into another cell. Use the “Copy” and “Paste” links to do this.</td>
</tr>
<tr>
<td><strong>Copy</strong></td>
<td>Link for copying an assignment from the “Value” column.&lt;br&gt;Requirement: An assignment is selected.</td>
</tr>
<tr>
<td><strong>Paste</strong></td>
<td>Link for inserting an assignment&lt;br&gt;Requirement: You have copied an assignment.</td>
</tr>
<tr>
<td><strong>OK</strong></td>
<td>Click the button to close the dialog and confirm the changes made under &quot;(Recent)&quot;.&lt;br&gt;Result: The assignment is entered in the “References” property and on the &quot;Interface Editor&quot; tab.</td>
</tr>
</tbody>
</table>

See also
- Chapter 6.4.5.21.5.6 “Visualization Element 'Frame’” on page 3478
- Chapter 6.4.5.21.2.1 “Command 'Interface Editor’” on page 3340

### Dialog 'Configure Categories and Items'

**Function:** The dialog is used to manage the categories in a tree view. The assigned elements are listed below a category. You can create custom categories and edit the assignment to the visualization elements. The name of the category is displayed in the “Visualization Toolbox” view as a label of the button to open the element selection.

**Call:** Click the  symbol in the “Visualization Toolbox” view.

See also
- Chapter 6.4.5.5.2 “Select Element” on page 2873
- Chapter 6.4.5.21.4.1.2 “View 'Visualization Toolbox’” on page 3394

### Tree view
"Category" Tree view
- "<name>": Default category
- "<name>": Custom category
Example: "Favorite"

[+] Lists the assigned visualization elements. To remove a selected visualization element, click the [Del] key.
Hint: The assignment is created in the "Visualization Toolbox" view with the help of the context menu of a selected element.

"Active" [✓]: A button for the category is visible in the "Visualization Toolbox" view.

**Toolbar**

[+] The “Add Category” dialog opens.

− or [Del] The category selected in the tree view is removed. After you click “OK” to close the dialog, the button is also removed from the “Visualization Toolbox” view.

**Dialog 'Add Category'**

- **Call**: Click the + symbol in the “Configure Categories and Items” dialog.

```
<table>
<thead>
<tr>
<th>“Name”</th>
<th>Name of the category</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: tagA</td>
<td></td>
</tr>
</tbody>
</table>
```

```
| “Description” | Example: Tagged with A |
```

**Dialog 'Gradient Editor'**

**Function**: The dialog is for setting the color gradient of visualization elements. If you define two colors, the color graduates between them. If you only select 1 color, the color graduates within this color through its brightness. The detailed settings are for a special specification of the initial position and the angle of the color gradient.

**Call**: Click in the value field of the property “Gradient settings”

**Requirement**: You have selected a visualization element in the editor that has the property “Gradient settings”.

```
<table>
<thead>
<tr>
<th>“Gradient type”</th>
<th>“Linear”</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Radial&quot;</td>
<td>“Axial”: The color gradient runs along an axis, with the colors extending perpendicular to the axis on both sides.</td>
</tr>
</tbody>
</table>
```

```
<table>
<thead>
<tr>
<th>“Color 1”</th>
<th>First color of the gradient.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Color 2”</td>
<td>Second color of the gradient.</td>
</tr>
</tbody>
</table>
```

```
<table>
<thead>
<tr>
<th>“Transparency”</th>
<th>Transparency of the associated color. Permissible values: Integers in the range of values from 255 to 0. 255: The color is opaque. 0: The color is fully transparent.</th>
</tr>
</thead>
</table>
```

Direction of the color gradient

"Angle (degrees)" Requirement: "Linear" or "Axial" color gradient.

"Center X (%):" Requirement: "Radial" color gradient.
X-position of the center point (0 – 100%)

"Center Y (%):" Requirement: "Radial" color gradient.
Y-position of the center point (0 – 100%)

"Use one color" Color gradient between "Color 1" and the same color with a different brightness.

"Brightness" Requirement: The option "Use one color" is selected.
Setting from 0 (black) to 100 (white)

"Use two colors" Color gradient between the two selected colors "Color 1" and "Color 2".

See also

● Chapter 6.4.5.5.4 “Assigning a color” on page 2876
● Chapter 6.4.5.10.4 “Animating a color display” on page 2914

Dialog 'Input Configuration'

Symbol:  

Function: The dialog is used to assign input actions to specific input events. It also includes specific settings for the selected input action.

Call: In the “Input configuration” property, click “Configure”.

Requirement: An element is selected in the editor.

Input action 'User Management'

"Dialogs and actions" Configures which one of the possible user management dialogs or which action follows the input event

Note: The dialog used at runtime is configured in the "Dialog Settings" tab of the Visualization Manager.

See also

● “Login dialog”
● “Change password dialog”
● “Change configuration dialog”

Default: Dialogs from the VisuUserManagement library

"Login" The login prompt opens.
Default: VisuUserManagement.VUM_Login in "Login dialog"

"Logout" The current user is logged out.

"Change User Password" The dialog for changing the password opens.
Default: VisuUserManagement.VUM_ChangePassword in “Change password dialog”

"Open User Configuration" The dialog opens for changing the configuration.
Default: VisuUserManagement.VUM_UserManagement in “Change configuration dialog”
See also
- Chapter 6.4.5.7 “Setting Up User Management” on page 2899
- “Tab ‘Visualization manager’ – ‘Settings’” on page 3398

## Input action 'Close Dialog'

<table>
<thead>
<tr>
<th>“Dialog”</th>
<th>The visualization of type “Dialog” that will be closed.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>List box with all “Dialog” type visualizations available in the project.</td>
</tr>
<tr>
<td>Example:</td>
<td>Default dialogs of the VisuDialogs library, which is usually integrated in the project.</td>
</tr>
<tr>
<td></td>
<td>• FileOpenSave</td>
</tr>
<tr>
<td></td>
<td>• Keypad</td>
</tr>
<tr>
<td></td>
<td>• Login</td>
</tr>
<tr>
<td></td>
<td>• Numpad</td>
</tr>
<tr>
<td></td>
<td>• NumpadExtended</td>
</tr>
<tr>
<td></td>
<td>• TextinputWithLimits</td>
</tr>
<tr>
<td>Note:</td>
<td>The setting in the object property (”Visualization” tab) of a visualization determines whether or not a visualization can be used as a dialog.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Result”</th>
<th>Return value for closing the dialog.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“None”</td>
<td>No return value</td>
</tr>
<tr>
<td>“OK”</td>
<td>The set return value is returned. The return value refers to the button in the dialog. The value OK is returned for the OK button. The value Cancel is returned for the cancel button.</td>
</tr>
<tr>
<td>“Cancel”</td>
<td></td>
</tr>
<tr>
<td>“Abort”</td>
<td></td>
</tr>
<tr>
<td>“Retry”</td>
<td></td>
</tr>
<tr>
<td>“Ignore”</td>
<td></td>
</tr>
<tr>
<td>“Yes”</td>
<td></td>
</tr>
<tr>
<td>“No”</td>
<td></td>
</tr>
</tbody>
</table>

See also
- Chapter 6.4.5.21.3.15 “Dialog ‘Properties’ of Visualization Objects” on page 3388

## Input action 'Open Dialog'

<table>
<thead>
<tr>
<th>“Dialog”</th>
<th>Visualization (type “Dialog”). The dialog opens.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>List box with all dialogs available in the project.</td>
</tr>
<tr>
<td>Note:</td>
<td>The “VisuDialogs” library provides visualizations (type “Dialog”).</td>
</tr>
<tr>
<td></td>
<td>• VisuDialogs.FileOpenSave</td>
</tr>
<tr>
<td></td>
<td>• VisuDialogs.Login</td>
</tr>
</tbody>
</table>

2024/01/05 3ADR010583, 1, en_US 3371
Transfer parameters of the dialog

<table>
<thead>
<tr>
<th>“Parameter”</th>
<th>Interface parameter as declared in the interface editor of the visualization. Example: filelistProvider</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Type”</td>
<td>Data type of the parameter as declared in the interface editor of the visualization. Example: VISU_FBFILELISTPROVIDER</td>
</tr>
<tr>
<td>“Value”</td>
<td>Variable (data type corresponds to the data type of the parameter). The value of the variable is read when the dialog opens and passed to the parameter. Example: PLC_PRG.fileListProvider // Instance of function block VisuDialogs.Visu_FbFileListProvider</td>
</tr>
</tbody>
</table>

Example:

1. The input assistance offers all variables available in the entire project.

Here the return value of the dialog is activated for which the Var_OUTPUT variable and VAR_IN_OUT variable are written. The dialog closes afterwards.

<table>
<thead>
<tr>
<th>“Update” and “parameter in case of result”</th>
<th>Note: The parameters are updated before the dialog is closed. Until then, the values are stored temporarily. They are stored as a copy, not as a reference.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“None”</td>
<td>No return value</td>
</tr>
<tr>
<td>“OK”</td>
<td>Defines the return value for which the transfer parameter is written</td>
</tr>
<tr>
<td>“Cancel”</td>
<td></td>
</tr>
<tr>
<td>“Abort”</td>
<td></td>
</tr>
<tr>
<td>“Retry”</td>
<td></td>
</tr>
<tr>
<td>“Ignore”</td>
<td></td>
</tr>
<tr>
<td>“Yes”</td>
<td></td>
</tr>
<tr>
<td>“No”</td>
<td></td>
</tr>
</tbody>
</table>

| “Open dialog modal” | Only the dialog processes user inputs. The remaining visualizations are blocked to user input. |

<table>
<thead>
<tr>
<th>“Position to open”</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“Centered”</td>
<td>The dialog opens in the center of the visualization.</td>
</tr>
<tr>
<td>“Position”</td>
<td>The dialog opens at the position defined by “X” and “Y”.</td>
</tr>
<tr>
<td>“X”</td>
<td>Position (in pixels) or variable (integer data type)</td>
</tr>
<tr>
<td>“Y”</td>
<td>Position (in pixels) or variable (integer data type)</td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.5.17.4 “Calling a dialog in a visualization” on page 2957

Input action 'Change Language'

<table>
<thead>
<tr>
<th>“Language”</th>
<th>Language to be switched Example: en</th>
</tr>
</thead>
</table>

The input assistance offers all languages available in the project.
Table 675: “Zoom to visualization”

<table>
<thead>
<tr>
<th>Input action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Change Shown Visualization'</td>
<td>Commands are listed here with transfer parameters that the visualization processes when an input event occurs.</td>
</tr>
</tbody>
</table>

### Visualization that is shown at the user input

- **“Assign”**
  - Visualization that is selected from all available visualizations in the project or libraries.
  - Example: visMain

- **“Assign expression”**
  - Variable (STRING) that contains the name of the visualization
  - Example: PLC_PRG.strVisu for the following application code: strVisu: STRING := 'visMain';

The order in which visualizations are displayed by user inputs is saved internally. The following options use this information.

- **“Previous shown visualization”**
  - Visualization that has already been shown before the current one
  - Requirement: A visualization switch has already occurred.

- **“Next shown visualization”**
  - Visualization that is next in the call order after the current one.
  - Requirement: A visualization switch has already occurred which was called by “Previous shown visualization”.

### Commands are listed here with transfer parameters that the visualization processes when an input event occurs.

- **“Configure commands”**
  - “Execute program on the plc”
  - “Execute program on client”
  - “Print”
  - “Navigate to URL (WebVisu)”
  - “Create Recipe”
  - “Read Recipe”
  - “Write Recipe”
  - “Write Recipe in File”
  - “Load Recipe from File”
  - “Delete Recipe”

Click ▲ to add the selected command to the lower command list.

The order in which visualizations are displayed by user inputs is saved internally.
### Table 676: Command “Execute program on the plc”

<table>
<thead>
<tr>
<th>“Command”</th>
<th>“1st parameter”</th>
<th>“2nd parameter”</th>
</tr>
</thead>
<tbody>
<tr>
<td>ExecutePlcProgram</td>
<td>'C:\programs\notepad.exe'</td>
<td>'Notes_A.txt'</td>
</tr>
</tbody>
</table>

EXE file that is executed on the controller
The program is executed on the PLC and therefore it must not be interactive or have any user interfaces.
It is possible, for example, for a program to copy a file.

Program name with directory as STRING in single straight quotation marks
Arguments of the program as STRING in single straight quotation marks
Example: Name of the file that the program opens

### Table 677: Command “Execute program on client”

<table>
<thead>
<tr>
<th>“Command”</th>
<th>“1st parameter”</th>
<th>“2nd parameter”</th>
</tr>
</thead>
<tbody>
<tr>
<td>ExecuteClientProgram</td>
<td>'C:\programs\notepad.exe'</td>
<td>'Notes_A.txt'</td>
</tr>
</tbody>
</table>

EXE file that is executed on the display variant. Exception: WebVisu.
The program is executed within the context of the display variant. After this, the program may be interactive and have a user interface.

Program name with directory as STRING in single straight quotation marks
Arguments of the program as STRING in single straight quotation marks
Example: Name of the file that the program opens

### NOTICE!
If the visualization is displayed as a CODESYS WebVisu, then no program (EXE file) can be started.

### Table 678: Command “Navigate to URL (WebVisu)”

<table>
<thead>
<tr>
<th>“Command”</th>
<th>“1st parameter”</th>
<th>“2nd parameter”</th>
</tr>
</thead>
<tbody>
<tr>
<td>NavigateURL</td>
<td>'<a href="http://en.wikipedia.org">http://en.wikipedia.org</a>'</td>
<td>'replace'</td>
</tr>
</tbody>
</table>

The visualization navigates to the web page of the URL.
Requirement: The visualization is executed as a CODESYS WebVisu.

URL
- As a literal in single straight quotation marks
- As a variable (STRING)

If a parameter is not specified, then the web page is displayed in a new window or a new tab.
If 'replace' is specified, then the CODESYS WebVisu is replaced by the web page.

### Table 679: Command “Read Recipe”

<table>
<thead>
<tr>
<th>“Command”</th>
<th>“1st parameter”</th>
<th>“2nd parameter”</th>
</tr>
</thead>
<tbody>
<tr>
<td>ReadRecipe</td>
<td>'RecipeDefinitionForModule'</td>
<td>'RecipeModuleA'</td>
</tr>
</tbody>
</table>
At visualization runtime, the controller reads the actual values from the variables of the recipe definition and writes them to the specified recipe. The values are saved implicitly (to a file on the controller) and shown in the recipe definition in the Recipe Manager of CODESYS. In other words, the recipe that is managed in CODESYS is updated with values from the controller.

**Table 680: Command “Write Recipe”**

<table>
<thead>
<tr>
<th>“Command”</th>
<th>“1st parameter”</th>
<th>“2nd parameter”</th>
</tr>
</thead>
<tbody>
<tr>
<td>WriteRecipe</td>
<td>PLC_PRG.stRecipeDef</td>
<td>PLC_PRG.stRecipe</td>
</tr>
</tbody>
</table>

Name of the affected recipe definition
- As a literal
- As a variable (STRING)

Name of the recipe (from the recipe definition)
- As a literal
- As a variable (STRING)

At visualization runtime, the values of the recipe are written to the variables on the controller as they are in the Recipe Manager.

**Table 681: Command “Save Recipe in File”**

<table>
<thead>
<tr>
<th>“Command”</th>
<th>“1st parameter”</th>
<th>“2nd parameter”</th>
</tr>
</thead>
<tbody>
<tr>
<td>SaveRecipeAs</td>
<td>PLC_PRG.stRecipeDef</td>
<td>PLC_PRG.stRecipe</td>
</tr>
</tbody>
</table>

Name of the affected recipe definition
- As a literal
- As a variable (STRING)

Optional parameter: If you do not specify a transfer parameter here, then the values from the recipe variables are saved only the file that is specified later. The implicit recipe files are not updated.

At visualization runtime, the “Save Recipe as” dialog opens and prompts the user for a file name and a storage location on the controller. The file name must not be `<recipe>.<recipe definition>`. The file extension is `.txtrecipe`.

The user can then save the file that includes the actual values from the recipe variables. If a transfer parameter is not specified in the 2nd parameter, then the file is saved without changing an implicit recipe file. If a transfer parameter is given in the 2nd parameter, then the implicit recipe file is also updated.

Note: If the “Save recipe changes to recipe files automatically” option is selected in the “Recipe Manager - General” tab, then the recipe definition in CODESYS and the implicit recipe files are kept the same automatically.

Note: Implicit (automatically generated) recipe files exist on the controller with names in the following syntax: `<recipe>.<recipe definition>.txtrecipe`. These are typically used in the application as a buffer when reading and writing recipe variables.
### Table 682: Command “Load Recipe from File”

<table>
<thead>
<tr>
<th>“Command”</th>
<th>“1st parameter”</th>
<th>“2nd parameter”</th>
</tr>
</thead>
<tbody>
<tr>
<td>LoadRecipeFrom</td>
<td>PLC_PRG.stRecipeDef</td>
<td>PLC_PRG.stRecipe</td>
</tr>
<tr>
<td></td>
<td>Name of the affected recipe definition</td>
<td>Name of the affected recipe definition</td>
</tr>
<tr>
<td></td>
<td>● As a literal</td>
<td>● As a literal</td>
</tr>
<tr>
<td></td>
<td>● As a variable (STRING)</td>
<td>● As a variable (STRING)</td>
</tr>
</tbody>
</table>

At visualization runtime, the “Load Recipe” dialog opens. It provides the visualization user with a file list that is located in the file system of the controller and filters by the extension txtrecipe. The selected file is downloaded. Then the recipes from the file are written to the implicit files and read to the given recipe in the recipe definition of the Recipe Manager.

Requirement: The file was created with the `SaveRecipeAs` command.

### Table 683: Command “Create Recipe”

<table>
<thead>
<tr>
<th>“Command”</th>
<th>“1st parameter”</th>
<th>“2nd parameter”</th>
</tr>
</thead>
<tbody>
<tr>
<td>CreateRecipe</td>
<td>PLC_PRG.stRecipeDef</td>
<td>PLC_PRG.stRecipe_New</td>
</tr>
<tr>
<td></td>
<td>Name of the affected recipe definition</td>
<td>Name of the new recipe definition</td>
</tr>
<tr>
<td></td>
<td>● As a literal</td>
<td>● As a literal</td>
</tr>
<tr>
<td></td>
<td>● As a variable (STRING)</td>
<td>● As a variable (STRING)</td>
</tr>
</tbody>
</table>

At visualization runtime, a new recipe is created in the given recipe definition.

### Table 684: Command “Delete Recipe”

<table>
<thead>
<tr>
<th>“Command”</th>
<th>“1st parameter”</th>
<th>“2nd parameter”</th>
</tr>
</thead>
<tbody>
<tr>
<td>DeleteRecipe</td>
<td>PLC_PRG.stRecipeDef</td>
<td>PLC_PRG.stRecipe</td>
</tr>
<tr>
<td></td>
<td>Name of the affected recipe definition</td>
<td>Name of the recipe definition</td>
</tr>
<tr>
<td></td>
<td>● As a literal</td>
<td>● As a literal</td>
</tr>
<tr>
<td></td>
<td>● As a variable (STRING)</td>
<td>● As a variable (STRING)</td>
</tr>
</tbody>
</table>

At visualization runtime, the specified recipe is deleted from the recipe definition.

### Table 685: Command “Print”

<table>
<thead>
<tr>
<th>“Command”</th>
<th>“1st parameter”</th>
<th>“2nd parameter”</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print</td>
<td>Optional: File name for the visualization screen to be printed (example: ‘Start screen’)</td>
<td>A second parameter cannot be specified for the Print command</td>
</tr>
</tbody>
</table>

The default “Printer” dialog opens while the visualization is running. In the dialog, you select a printer and configure additional print settings. When you confirm the dialog, the currently displayed visualization screen is printed.

Note: The command can be executed in the TargetVisu only.

See also
- Changing Values with Recipes
- Object ‘Recipe Definition’
When the input event occurs, the display switches to another visualization within one frame.

**Input action**  
'Switch Frame Visualization'

<table>
<thead>
<tr>
<th>“Frame selection type”</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“Switch local visualization”</td>
<td>The “Frame Selection” group is visible.</td>
</tr>
<tr>
<td>“Switch to any visualization”</td>
<td>The “Frame and visualization selection” group is visible.</td>
</tr>
</tbody>
</table>

| Requirement: “Switch local visualization” is selected. |
|--------------------------|---|
| “Frame selection” | List of all frames that contain the active visualization. The referenced visualizations are listed below each frame, as determined in the “References” property of the respective frame.  
Example: |
| “Assign selection” | The selection in the “Frame selection” input field is accepted. Then it appears in the “Selected frame” and “Selected visualization” settings.  
Requirement: A visualization is selected in the “Frame selection” input field. |
| “Selected Frame” | Name of the frame to be switched to  
Example: `MainArea`  
Hint: Use the “Assign selection” command for changing the setting here. |
| “Selected Visu” | Name of the switched visualization.  
Example: `visMainArea`  
Hint: Use the “Assign selection” command for changing the setting here. |

| Requirement: The “Switch to any visualization” option is selected. |
|--------------------------|---|
| “Frame and visualization selection” | Contains the frame to be switched to |
| “Assign” | Frame to be switched to (with complete path). The index determines the visualization.  
Example: `visMain.frameA.visB.frameB`  
The path is specified in the following syntax: `<visualization name>..<frame name> { <visualization name>..<frame name> }`  
Caution: Visualizations can be nested at any depth by means of frame elements. In order to use the “Switch to any visualization” frame selection type without any problems, a frame must not contain more than 21 referenced visualizations. |
"Assign expression" Variable (STRING). Contains the path of the frame to be switched to
Example: strFrame: STRING := 'visMain.frameA.visB.frameB';

"Index to select" Index that determines which of the referenced visualizations is displayed
- As an integer
- As a variable (integer data type)
Example: PLC_PRG.iIndex
Note: The referenced visualizations of a frame are indexed automatically according to their order.

Requirement: The project contains visualizations that form a structure.
See also
- "Dialog ‘Frame Configuration’" on page 3348

Input action 'Write Variable' The configuration of the input action defines how a visualization user specifies a value and to which variable the value is written.

Check all inputs for there validity. Be sure that only values within the range can be added to a numeric field. Depending on the datatype of the input value, the limitations can be different.

"Input type" How the input is prompted.

"Default": An input field also opens, or if necessary a virtual keyboard (when the display variant does not have a physical keyboard).
Note: The default option for text input at runtime is set in the Visualization Manager: “Dialog Settings” tab, “Settings for Default Text Input”.

"Text input" An input field appears. You use the keyboard to specify a number or a text.
Requirement: The display variant has a keyboard as input device.

"Text input with limits" An input field appears. You use the keyboard to specify a number or a text. The field also shows the range of values for the input. When a limit is passed, the input value is displayed in red.
Requirement: The display variant has a keyboard as input device.

"VisuDialogs.Keypad" A virtual keyboard opens. You use it to specify a number or a text.
"VisuDialogs.Numpad" A virtual keyboard opens. You use it to specify a number.
"VisuDialogs.NumpadExtended" A virtual keyboard opens. You use it to specify a number. Hexadecimal and exponential notation are also permitted here.

"Choose variable to edit"

"Use text output variable" The input value is written to the text output variable of the element. This is the variable that is assigned in the “Text variable” property.

"Use another variable" Variable where the input value is written.
Example: PLC_PRG.iVariable

"Initial display format" Placeholder with format definition. It defines the output format for the variable value and the input limits.
Example: %2.3f for displaying the value as a decimal fraction.
**“Min”**
Minimum value of the input limit. If a user specifies a lesser value, then it is not accepted.
- As a fixed value
- As a variable (data type corresponds to selected variable)

**“Max”**
Maximum value of the input limit. If a user specifies a greater value, then it is not accepted.
- As a fixed value
- As a variable (data type corresponds to selected variable)

**“Dialog title”**
Text displayed in the title bar of the dialog. Optional.
- As a fixed string
  Example: Insert value
- As a variable (STRING)
  Example: PLC_PRG.stTitle : STRING := 'Insert value';

**“Password field”**
Unseen text input. *** is shown instead of the input text.

---

**Table 686: “Position to open input dialog”**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Use global setting (from the Visualization Manager)”</strong></td>
<td>♻: This option is applies only for use in a TargetVisu or WebVisu. The settings are used which are available in the “Dialog Settings” tab of the Visualization Manager.</td>
</tr>
<tr>
<td><strong>“Centered”</strong></td>
<td>♻: The dialog opens in the center of the visualization window.</td>
</tr>
<tr>
<td><strong>“Position”</strong></td>
<td>♻: The dialog opens in the visualization at the position defined here. “X”, “Y”: Variable or explicit number (in pixels) for the definition of the upper left corner of the dialog in the coordinate system of the visualization window. You can use the placeholders ElementRectangle.ptTopLeft.iX and .iY ElementRectangle.ptBottomRight.iY. It is replaced at runtime by the coordinates of the calling element.</td>
</tr>
</tbody>
</table>

See also
- § Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329
- § Chapter 6.4.5.21.3.15 “Dialog ‘Properties’ of Visualization Objects” on page 3388
- § Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329
- § “Tab ‘Visualization manager’ – ‘Settings’” on page 3398

**Input action ‘Execute ST Code’**

<table>
<thead>
<tr>
<th>Input field</th>
<th>Editor for code as Structured Text</th>
</tr>
</thead>
</table>

**Input action ‘Toggle Variable’**

<table>
<thead>
<tr>
<th><strong>“Variable”</strong></th>
<th>Variable (BOOL). It toggles between TRUE and FALSE for an input event. Example: PLC_PRG.bSwitch</th>
</tr>
</thead>
</table>

**Input action ‘File Transfer’**
With the “File Transfer” input action, a file can be transferred from an operating variant (target or web visualization) to the PLC as well as to and from the PLC. This works either by means of a file transfer (“Type”: “File”) or streaming (“Type”: “Streaming”).

---

2024/01/05 3ADR010583, 1, en_US 3379
The action has the effect that a file selection dialog is displayed in the visualization at runtime. There the visualization user can select a file which will be transferred either to or from the PLC:

For a transfer from a PLC to the visualization, the “Save File” dialog opens. For the transfer from the visualization to the PLC, the “Open File” dialog opens.

### “Transfer”

<table>
<thead>
<tr>
<th>“Direction”</th>
<th>Direction of file transfer</th>
</tr>
</thead>
<tbody>
<tr>
<td>“From PLC to Visualization”</td>
<td>The object specified in “File name” or “Streaming instance name” is transferred from the PLC to the visualization.</td>
</tr>
<tr>
<td></td>
<td>The “Save File” file selection dialog is displayed in the visualization at runtime.</td>
</tr>
<tr>
<td>“From Visualization to PLC”</td>
<td>The file specified by the visualization user is transferred to the PLC and saved in the file path specified in “File name” or “Streaming instance name”.</td>
</tr>
<tr>
<td></td>
<td>The “Open File” file selection dialog is displayed in the visualization at runtime.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Type”</th>
<th>Determines how the file is transferred</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>● Transfer type “File”: By file transfer</td>
</tr>
<tr>
<td></td>
<td>● Transfer type “Streaming”: By streaming</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Type”</th>
<th>“File”</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The data transfer is done by file transfer.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“File name”</th>
<th>File path (type STRING) which describes the file in the file system</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>● Variable</td>
</tr>
<tr>
<td></td>
<td>Example: strTransferFile: STRING;</td>
</tr>
<tr>
<td></td>
<td>● Literal with relative path</td>
</tr>
<tr>
<td></td>
<td>Example: '/Recipes/Recipe_1.txt' saves the file in the directory Recipes.</td>
</tr>
</tbody>
</table>
|             | ● Literal with placeholder $PLCLOGIC$
|             |   PlcLogic is the default resolution for the directory placeholder $PLCLOGIC$.
|             |   Example: '$$PLCLOGIC$$/test.txt' saves the file in the directory PlcLogic.
|             |   Example: '$$PLCLOGIC$$/MyData/test.txt' saves the file in the directory PlcLogic/MyData. |
|             | ● Literal with placeholder $VISU$
|             |   visu is the default resolution for the placeholder $VISU$.
|             |   Example: '$$VISU$$/test.txt' save the file in the subdirectory PlcLogic/visu. Alternatively, 'visu/test.txt' can also be specified. |
|             | ● Literal with absolute path |
|             |   Example: 'E:\temp\test.txt' |
|             |   Note: These kinds of file paths are not always supported. |

Note: If a user specifies the file path in the visualization by means of a “Text Field” element, the masking character $ must not be included: $VISU$/dummy.txt

Note: In the case that the file path is specified by the user, it should be checked by the application in order to prevent files from being read or overwritten accidentally.
**“Type”**

The data transfer is done by streaming.

---

**“Streaming instance name”**

Instance path (type IVisuStreamWriter or IVisuStreamReader) which describes the object in the file system of the controller.

Type IVisuStreamReader for transfer direction “From PLC to Visualization”
Type IVisuStreamWriter for transfer direction “From Visualization to PLC”

---

**“Control flags”**

Note: The variable is evaluated only for transfer direction “From Visualization to PLC”.

Variable (type DWORD)

Determines how the object (file or instance object) is handled on the file system of the PLC. Two flags are provided for this with which the variable can be set.

- **Flag 1:** VisuElems.VisuEnumFileTransferControlFlags.UseOriginalFileName
- **Flag 2:** VisuElems.VisuEnumFileTransferControlFlags.ConfirmFileOverwriteInPlc

Options

- **No flag set:** The user selects a file which is saved in the path specified in “File name” or “Streaming instance name”.
- **Flag 1 is set:** The path, which is specified by the user at visualization runtime, is applied and used as the path in the PLC file system.
- **Both flags are set:** The path is also checked. If an object already exists in the path specified on the client side, then a message prompt is displayed in the visualization. There the visualization user can confirm that the file will be overwritten.

**Example:**

The transfer direction is “From Visualization to PLC” (write).

Example: A new recipe file Recipes/Recipe_2021.txt has been created in the visualization device. The visualization user selects this file and wants to save the file on the PLC under the same name. Because the control flags are set accordingly, a message window opens and the visualization user can confirm that the file will be overwritten.

```plaintext
PROGRAM PLC_PRG
VAR
    xVisuToggle : BOOL;
    strFileName: STRING := '/Recipes/Recipe_new.txt';
END_VAR
```
Table 687: "Status Variables"

<table>
<thead>
<tr>
<th>Status Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Transfer active&quot;</td>
<td>Boolean variable (optional)</td>
</tr>
<tr>
<td></td>
<td>TRUE: The transfer is in progress.</td>
</tr>
<tr>
<td>&quot;Transfer successful&quot;</td>
<td>Boolean variable (optional)</td>
</tr>
<tr>
<td></td>
<td>TRUE: The transfer has completed successfully</td>
</tr>
<tr>
<td>&quot;Error code&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0: No errors</td>
</tr>
<tr>
<td></td>
<td>1: Unspecified error</td>
</tr>
<tr>
<td></td>
<td>2: Cancellation of file dialog</td>
</tr>
<tr>
<td></td>
<td>3: Other file transfer in progress</td>
</tr>
<tr>
<td></td>
<td>4: Error during file transfer</td>
</tr>
<tr>
<td></td>
<td>5: Cancellation by timeout</td>
</tr>
<tr>
<td></td>
<td>6: File read error – The file is not available or cannot be read.</td>
</tr>
<tr>
<td></td>
<td>7: No device support for file transfer</td>
</tr>
<tr>
<td>Possible causes:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>– CODESYS WebVisu: File transfer is not possible by default.</td>
</tr>
<tr>
<td></td>
<td>– Communication with a controller of a version &lt; 3.5.11: Functionality not</td>
</tr>
<tr>
<td></td>
<td>implemented.</td>
</tr>
<tr>
<td></td>
<td>– Communication with a controller of a version &gt;= 3.5.11: File transfer not</td>
</tr>
<tr>
<td></td>
<td>activated (device description).</td>
</tr>
<tr>
<td>Note: In this case, contact the</td>
<td></td>
</tr>
<tr>
<td>CODESYS support team.</td>
<td></td>
</tr>
</tbody>
</table>

Dialog 'Options' - 'Visualization Styles'

Symbol: 📄

**Function:** This dialog is used for configuring the display of library visualizations and visualizations in the POUs view in the visualization editor. In addition, it is used for configuring the tab "Visualization Manager" - "Settings" (group "Style Settings").

**Call:** Menu bar: “Tools ➔ Options” ("Visualization Styles" category).

These settings are not applied at visualization runtime. In runtime mode, only the settings of the visualization manager are available in the “Settings” tab.

See also

- ☰ Chapter 6.4.5.19 “Applying Visualization Styles” on page 2979

'Style Configuration for Libraries and Global Visualizations'

These settings are applied for library visualizations and for visualizations in the POUs view.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Use no visualization style&quot;</td>
<td>✕: Display without using style properties. Elements are displayed as defined by presets.</td>
</tr>
<tr>
<td>&quot;Use the following visualization style&quot;</td>
<td>✕: Style with style properties used for displaying visualizations.</td>
</tr>
</tbody>
</table>
"Derive visualization style automatically" | Display with the style that was selected in the application in the visualization manager (when possible). Therefore, the display is derived from this style. It is actually possible for this to cause an incorrect display. Then the fallback solution is used.

"Fallback if no visualization style could be derived" | Another style that is applied after the selected style. Then a style property is assigned from the style specified here. This is done for element properties that could not be assigned style properties. Requirement: The selected style causes a device-specific, deficient display on the display variant.

### 'Style Selection'

The drop-down list of "Selected style" can be configured in the visualization manager ("Settings" tab, "Style settings" group).

"Display all versions" | All other styles of the repository, including the selected style, are listed for selection, but only in the latest version. If newer versions are installed for the selected style, then these are also listed. All installed styles in all installed versions are available for selection.

### 'Style for New Visualization Managers'

"Last used: <style, version, vendor>" | Style that is selected automatically when you add a new visualization application. Note: It is actually possible that a display variant is displayed another way depending on the device despite this setting.

"Preset: <style, version, vendor>" | You can edit the list. The list is created in the "Visualization manager" ("User management → Groups") by clicking "Export groups for global visualizations".

### Dialog 'Options' - 'Visualization User Management'

Symbol: 🌟 Symbol: 🌟

**Function:** The options define the use of visualization user management for global visualizations in the "POUs" view and for visualizations that are linked from libraries.

**Call:** Menu bar: "Tools".

**Requirement:** A visualization user management exists.

### Table 688: "User Management Configuration for Libraries and Global Visualizations"

| "Do not use visualization user management" | The affected visualizations behave as when no user management is configured. |
| "Use the following visualization user group list" | You can edit the list. The list is created in the "Visualization manager" ("User management → Groups") by clicking "Export groups for global visualizations". |
| "Derive visualization user management automatically" | The affected visualizations use the user management configuration of the visualization manager selected here. The drop-down list shows all visualization managers of the project. If this is not possible, then the user groups are used from the option "Use the following user group list for the visualization". |
The user management for a visualization in the "Devices" view is configured in the “Visualization Manager” (tab "User Management”).

See also

- Chapter 6.4.5.21.4.5 “Tab 'Visualization manager' - 'User management'” on page 3403

Dialog Box 'Options' - 'Visualization'

Symbol: ✉

**Function:** The dialog serves for the configuration of the visualization editor and during runtime it serves the configuration of the Integrated Visualization.

**Call:** Main menu “Tools ➔ Options”, category “Visualization”

Tab 'General'

These settings will **not** be applied for the following visualization clients:
CODESYS TargetVisu, CODESYS WebVisu.

<table>
<thead>
<tr>
<th>Table 689: “Presentation options (visualization editor in the programming system)”</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Fixed”</strong></td>
</tr>
<tr>
<td><strong>“Isotropic”</strong></td>
</tr>
<tr>
<td><strong>“Anisotropic”</strong></td>
</tr>
<tr>
<td><strong>“Antialiased Drawing”</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 690: “Editing options”</th>
</tr>
</thead>
</table>
| **“Link to toggle/tap variable when appropriate”** | The placeholder “<toggle/tap variable>” in the visualization element properties is enabled. Effect: If you drag an element having the property “Color variable ➔ Toggle color” in the visualization editor, this property will be configured with the placeholder “<toggle/tap variable>”.

See also

- Chapter 6.4.5.21.5.11 “Visualization Element ‘Button’” on page 3514
- Chapter 6.4.5.21.5.6 “Visualization Element ‘Frame’” on page 3478
- Chapter 6.4.5.21.5.5 “Visualization Element ‘Image’” on page 3463
- Chapter 6.4.5.21.5.2 “Visualization Element ‘Line’” on page 3425
- Chapter 6.4.5.21.5.4 “Visualization Element ‘Pie’” on page 3450
- Chapter 6.4.5.21.5.3 “Visualization Element ‘Polygon’, ‘Polylines’, ‘Bézier Curve’” on page 3437
- Chapter 6.4.5.21.5.14 “Visualization Element ‘Text Field’” on page 3538
- Chapter 6.4.5.21.5.15 “Visualization Element ‘Scroll Bar’” on page 3550
Tab 'Grid'

- "Visible": The visualization editor contains a grid. The spacing of the grid lines is defined by "Size".
- "Active": The visualization elements get aligned to the grid, defined by "Size", even if the grid lines are not visible. When you insert or move an element, its center will be positioned on the grid. When you modify the size of an element, you can move the position markers onto grid lines only. Elements already available in a visualization, will not be aligned automatically, until you change their position.
- "Size": Spacing of the grid lines in pixel.

Tab 'File options'

- "Text list files for textual "IntelliSense": File name and path of a file of type .csv. The file contains texts in the format of a text list. The file entries will be available when using the function "List Components" as input assistance. Note: You can create this file as an export file of the global text list. For this purpose use the command "Import/Export Text Lists".
- "Visualization Directories":
  - "Text list files": Storage path for text lists. Note: This setting will be used in CODESYS only if no storage path for "Text list files" is defined in the "Project Settings", category "Visualization".
  - "Image files": Storage path for image files. Multiple paths get separated by semicolons. CODESYS uses this path for example when exporting or importing image files. Note: This setting will be used in CODESYS only if no storage path for "Image files" is defined in the "Project Settings", category "Visualization".

See also
- Chapter 6.4.1.9.10 "Managing text in text lists" on page 1891
- Chapter 6.4.1.21.3.21.6 "Command 'Import/Export Text Lists'" on page 2729

See also
- Chapter 6.4.5.21.3.13 "Dialog 'Project Settings' - 'Visualization'" on page 3387
- Chapter 6.4.5.21.4.7 "Object 'TargetVisu'" on page 3408

Dialog 'Project Environment' - 'Visualization Profile'

**Function:** The dialog displays the current visualization profile of the project. The profile can be updated here.

**Call:** Main menu "Project ➔ Project Environment", Tab "Visualization Profile".

- "Current visualization profile in project": The currently set visualization profile of the opened project.
- "Recommended, newest profile": The newest profile
- "Action":
  - "Do not update": The visualization profile of the project remains unchanged.
**Dialog 'Project Environment' - 'Visualization Styles'**

**Function:** The dialog displays the currently used visualization style of the project. The visualization style can be updated here.

**Call:** Main menu “Project ➔ Project Environment”, tab “Visualization Styles”

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“For the following visualization styles currently in use, newer versions are available:”</td>
<td></td>
</tr>
<tr>
<td>“Visualization Styles”</td>
<td>Version of the currently set visualization style of the opened project.</td>
</tr>
<tr>
<td>“Current”</td>
<td>Current version of the visualization style, for example 3.5.6.0</td>
</tr>
<tr>
<td>“Recommended”</td>
<td>Recommenden version of the visualization style, for example 3.5.7.0</td>
</tr>
<tr>
<td>“Action”</td>
<td></td>
</tr>
<tr>
<td>“Do not update”</td>
<td>The visualization style of the project remains unchanged.</td>
</tr>
<tr>
<td>“Update to x.x.x.x”</td>
<td>CODESYS updates the project to the version of the chosen visualization style.</td>
</tr>
<tr>
<td>“Check for updates when loading the project”</td>
<td>CODESYS checks for new versions when the project is opened. If there are updates available an update dialog opens automatically.</td>
</tr>
<tr>
<td>“Set All to Newest”</td>
<td>CODESYS updates the version.</td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.5.19 “Applying Visualization Styles” on page 2979

**Dialog 'Project Environment' – 'Visualization Symbols'**

**Function:** The dialog lists installed symbol libraries and allows for you to assign symbol libraries to a project.

**Call:** Menu bar: “Project ➔ Project Environment”, “Visualization Symbols” tab

**Requirement:** The open project contains a visualization and has been saved with a compiler version < 3.5.7.0. CODESYS recognizes symbol libraries in compiler version 3.5.7.0 and higher.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Symbol library”</td>
<td>List of all installed symbol libraries</td>
</tr>
<tr>
<td>“Active”</td>
<td>Symbol library is selected for the project. CODESYS provides its symbols in the “Visualization Toolbox” view.</td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.5.5.2 “Select Element” on page 2873
Dialog 'Project Settings' - 'Visualization'

**Symbol:** 📝

**Function:** The dialog is used to configure the project-wide settings for objects of type "Visualization".

**Call:** Menu bar: “Project ➡ Project Settings”, “Visualization” category

**Requirement:** A project is open.

Tab 'General'

**Table 691: “Visualization Directories”**

<table>
<thead>
<tr>
<th>Directory Type</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Text list files”</td>
<td>Directory which contains text lists that are available in the project to configure texts for different languages. CODESYS uses the directory, for example to import or export text lists. After clicking 📦, the “Select Directory” dialog opens which allows for the selection of a directory in the file system.</td>
<td>📦</td>
</tr>
<tr>
<td>“Image files”</td>
<td>Directory which contains image files that are available in the project. Multiple folders are separated with a semicolon. CODESYS uses the directory, for example to import or export image files. After clicking 📦, the “Select Directory” dialog opens which allows for the selection of a directory in the file system.</td>
<td>📦</td>
</tr>
</tbody>
</table>

**Table 692: “Advanced”**

<table>
<thead>
<tr>
<th>Property Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Activate property handling in all element properties”</td>
<td>You can also configure a visualization element with a property 📝 in those of its properties in which you select an IEC variable. Then CODESYS creates additional code for the property handling when a visualization is compiled. Requirement: Its IEC code contains at least an object of type “Interface property” (a property 📝).</td>
</tr>
</tbody>
</table>

Requirement: “Visible” is selected.

See also
- 📝 Object 'Property'

Tab 'Symbol Libraries'

**Table 693: “Visualization Symbol Libraries”**

<table>
<thead>
<tr>
<th>Library Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Symbol libraries”</td>
<td>List of all installed symbol libraries</td>
</tr>
<tr>
<td><strong>Example:</strong> VisuSymbols</td>
<td></td>
</tr>
<tr>
<td>“Assigned”</td>
<td>Symbol library is selected in the project and CODESYS makes it available in the “Visualization ToolBox” view of a visualization. Symbol library is installed in the library repository, but CODESYS does <strong>not</strong> make it available in the “Visualization ToolBox” view of a visualization.</td>
</tr>
</tbody>
</table>

See also
- 📖 Chapter 6.4.5.21.3.2 “Dialog 'Add Visualization’” on page 3367
Dialog ‘Project Settings’ - ‘Visualization Profile’

Symbol: 📝

**Function:** The dialog box enables the setting of the visualization profile.

**Call:** Menu “Project ➔ Project Settings”, category “Visualization Profile”

**Requirement:** A project is open.

| “Specific profile” | Profile that CODESYS uses in the project and that determines the visualization elements that are available in the project.
|                    | The selection list contains all the profiles installed so far.

**Table 694: “Visualization Profile”**

Dialog 'Properties' of Visualization Objects

**Function:** This dialog is used for configuring object-dependent properties.

**Call:** Menu bar: “View”; context menu of the visualization object in the “Devices” view or “POUs” view.

**Tab 'General'**

| “Name” | Example: visMain |
| “Object type” | visualization |
| “Open with” | visualization |

See also

- Chapter 6.4.1.21.4.11.2 “Dialog Box ‘Properties’ - ‘Common’” on page 2753

**Tab 'Access Control’**

This tab is used for defining which user group can execute which actions on the object.

See also

- Chapter 6.4.1.21.4.11.7 “Dialog ‘Properties’ - ‘Access Control’” on page 2757

**Tab 'Visualization’**

This tab assigns a visualization type to a visualization.

In addition, it includes settings for window size that are used at runtime.
Table 695: “Use visualization as”

<table>
<thead>
<tr>
<th>“Visualization”</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Dialog”</strong></td>
<td>Visualization type for a visualization that opens as a dialog in its own window for an input event. The input action for this is “Open dialog”. The “Close dialog” input action closes the window. Tip: A dialog usually includes an “OK” button or “Cancel” button at the bottom edge for confirming or rejecting user input, and for closing the dialog. A simple dialog or a dialog prompt includes only a question or information and buttons for closing the dialog with either “Yes” or “No”. A dialog is part of a user interface. While a dialog is open, the rest of the user interface is usually disabled.</td>
</tr>
<tr>
<td><strong>“Numpad / keypad / dialog for input configuration”</strong></td>
<td>Visualization type for a visualization that displays a virtual numeric keypad or a virtual keyboard. It appears when the user is prompted to specify text. The input action for this is “Write variable”. Note: The interface of this visualization must also conform with the interfaces for the standard visualizations for the numeric keypad or that keyboard that provides the VisuDialogs library: Numpad, Keypad, NumpadExtended, or TextinputwithLimits. Tip: The VisuDialogs library contains templates for virtual keyboards or numeric keypads.</td>
</tr>
<tr>
<td><strong>“Dialog is opaque”</strong></td>
<td>☑: The screen area that is covered by the dialog is not refreshed. This has a positive effect on the character and input performance. Use this option when your drawn dialog is rectangular and opaque, containing no transparent parts.</td>
</tr>
<tr>
<td><strong>“Use automatic detected visualization size”</strong></td>
<td>☐: The size is determined so that all visualization elements are enclosed.</td>
</tr>
<tr>
<td><strong>“Include background image”</strong></td>
<td>☑: All elements and the background image are completely visible. ☐: All elements are visible, but a larger background image is truncated.</td>
</tr>
<tr>
<td><strong>“Use specified visualization size”</strong></td>
<td>☑: The values “Height” and “Width” define the window size of the visualization (in pixels).</td>
</tr>
<tr>
<td><strong>“Internal”</strong></td>
<td>☑: The visualization is internal. It is used exclusively as an internal module of a complete visualization in a library. When editing as a library project while the project is open in CODESYS, an internal visualization is handled like all visualizations. The internal visualization appears in drop-down lists. Or in the visualization manager (&quot;Visualizations&quot; tab). The internal visualizations that include a linked library are not visible to you.</td>
</tr>
</tbody>
</table>

See also
- ☑ “Dialog ‘Frame Configuration’” on page 3348

Tab ‘Build’
This tab includes options for compiling the object.
See also
- ☑ Chapter 6.4.1.21.4.11.5 “Dialog ‘Properties’ - ‘Build’” on page 2755

Dialog ‘Selected Alarm Class’
**Function:** In this dialog box, you define the alarm classes that are considered for the alarm table or alarm banner.
**Call:** Property “Alarm configuration” / “Alarm classes” of the alarm table or alarm banner visualization element.

**Requirement:** An alarm table visualization element or alarm banner visualization element is added to the visualization.

<table>
<thead>
<tr>
<th>“Available Alarm Classes”</th>
<th>Shows all alarm classes created in the project.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Selected Alarm Classes”</td>
<td>The alarm classes in this column are displayed in the alarm table.</td>
</tr>
<tr>
<td>“All”</td>
<td>![Check box] All alarm classes are listed in an alarm table.</td>
</tr>
<tr>
<td></td>
<td>![Arrow] Moves all available alarm classes to the “Selected Alarm Classes” column.</td>
</tr>
<tr>
<td></td>
<td>![Arrow] Moves the selected alarm classes to the “Selected Alarm Classes” column.</td>
</tr>
<tr>
<td></td>
<td>![Backward Arrow] Removes the selected alarm classes from the “Selected Alarm Classes” column.</td>
</tr>
<tr>
<td></td>
<td>![Backward Double Arrow] Removes all selected alarm classes from the “Selected Alarm Classes” column.</td>
</tr>
</tbody>
</table>

See also
- ![Chapter 6.4.5.21.5.22 “Visualization Element 'Alarm Table’” on page 3591](#)
- ![Chapter 6.4.5.21.5.22 “Visualization Element 'Alarm Table’” on page 3591](#)
- ![Chapter 6.4.5.9 “Visualizing alarm management” on page 2909](#)

**Dialog ‘Selected Alarm Group’**

**Function:** In this dialog box, you define the alarm groups that are considered for the alarm table or alarm banner.

**Call:** Property “Alarm configuration” / “Alarm groups” of the alarm table or alarm banner visualization element.

**Requirement:** An alarm table visualization element or alarm banner visualization element is added to the visualization.

<table>
<thead>
<tr>
<th>“Available Alarm Groups”</th>
<th>Shows all alarm groups created in the project.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Selected Alarm Groups”</td>
<td>The alarm groups in this column are displayed in the alarm table.</td>
</tr>
<tr>
<td>“All”</td>
<td>![Check box] All alarm groups are listed in an alarm table.</td>
</tr>
<tr>
<td></td>
<td>![Arrow] Moves all available alarm groups to the “Selected Alarm Groups” column.</td>
</tr>
<tr>
<td></td>
<td>![Arrow] Moves the selected alarm groups to the “Selected Alarm Groups” column.</td>
</tr>
<tr>
<td></td>
<td>![Backward Arrow] Removes the selected alarm groups from the “Selected Alarm Groups” column.</td>
</tr>
<tr>
<td></td>
<td>![Backward Double Arrow] Removes all alarm groups from the “Selected Alarm Groups” column.</td>
</tr>
</tbody>
</table>

See also
- ![Chapter 6.4.5.21.5.22 “Visualization Element 'Alarm Table’” on page 3591](#)
- ![Chapter 6.4.5.21.5.22 “Visualization Element 'Alarm Table’” on page 3591](#)
- ![Chapter 6.4.5.9 “Visualizing alarm management” on page 2909](#)
Dialog 'Advanced Trace Settings'

**Function:** The recording rate of the “Trace” visualization element is configured in this dialog box.

**Call**
- Properties: “Trace”, “Advanced”
- Context menu: “Configure trace”, “Advanced”

**Requirement:** A trace is selected in the active visualization editor.

### Table 696

<table>
<thead>
<tr>
<th>“Measurement in every nth cycle”</th>
<th>The task where the trace is running is the basis for the measurement. The measurement interval is a multiple of the trace task according to the selected value. The measurement interval is displayed on the right side.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Buffer size (samples)”</td>
<td>The number of measurements is calculated according to the time range of the x-axis.</td>
</tr>
</tbody>
</table>

See also
- Chapter 6.4.5.21.2.13 “Command 'Configure Trace’” on page 3355

Dialog 'Display Settings'

**Function:** The dialog includes the configuration for the display settings of the trace diagram (for both the X-axis and Y-axis) and provides a preview in the trace diagram.

**Call:** “Display” button in “Trace Configuration” dialog.

**Add Y-Axis**
- Extends the trace diagram by one Y-axis.

**Delete Y-axis**
- Deletes the Y-axis with the visible tab.

Tab 'X-axis'

**Display Mode**
- Scaling
  - “Auto”**: CODESYS Scales automatically.
  - “Fixed length”**: CODESYS displays a segment of constant “Length”.
  - “Fixed”**: CODESYS displays a segment from “Minimum” to “Maximum”.

**Minimum**
- Initial value of the segment. Requirement: The “Display Mode” is “Fixed”.

**Maximum**
- End value of the segment. Requirement: The “Display Mode” is “Fixed”.

**Length**
- Constant length of the segment.

**Grid**
- Diagram with vertical grid lines. Select the line color from the list box of colors.

### Table 697: “Tick marks”

<table>
<thead>
<tr>
<th>“Fixed spacing”</th>
<th>CODESYS draws tick marks with “Distance” and “Subdivisions”.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Distance”</td>
<td>Distance between tick marks</td>
</tr>
<tr>
<td>“Subdivisions”</td>
<td>Number of subdivisions between two tick marks</td>
</tr>
</tbody>
</table>
“Font”  Font for the X-axis

Tab 'Y-Axis'

“Display Mode”  Scaling
- “Auto” ✓: CODESYS Scales automatically.
- “Fixed” ✓: CODESYS displays a segment from “Minimum” to “Maximum”.

“Minimum”  Literal, variable (integer data type), or constant variable (integer data type). It contains the initial value of the segment. Requirement: The “Display Mode” is “Fixed”.
Examples: 20, PLC_PRG.iLimit_Min, GVL.c_iLimit_Min
Note: The variable has to have an initial value. This is important for the offline display and the scaling subdivision.
Example: iLimit_MIN : INT := 20

“Maximum”  Literal, variable (integer data type), or constant variable (integer data type). It contains the end value of the segment. Requirement: The “Display Mode” is “Fixed”.
Examples: 80, PLC_PRG.iLimit_Max, GVL.c_iLimit_Max
Note: The variable has to have an initial value. This is important for the offline display and the scaling subdivision.
Example: iLimit_MAX : INT := 80

“Grid”  ✓: Diagram with a grid line. Select the line color from the list box of colors.

“Label”  ✓: The description is displayed on the axis.

Table 698: “Tick marks”

“Fixed spacing” ✓: CODESYS draws tick marks with “Distance” and “Subdivisions”.

“Distance”  Distance between tick marks

“Subdivisions”  Number of subdivisions between two tick marks

“Font”  Font for the Y-axis

Preview of the trace diagram
| "Background color" | ● "No background": Transparent display without background color.  
|                    | ● "Draw background": Background color according to selection below.  
|                    | ● "From visualization style": Background color as defined in the visualization style. |

| "Reset" | CODESYS resets all settings to the defaults.  
| "Use as default" | CODESYS saves the settings as default  

### 6.4.5.21.4 Objects

#### Object 'Visualization' and visualization editor

The object represents a single visualization. You can insert a visualization under an application or, so that it is available project-wide, under the root node of the view "Devices" or directly in the view "POUs". You can open the visualization editor for editing by double-clicking on the object entry in the device tree or in the view POUs.

See also

- % Chapter 6.4.5.21.3.15 “Dialog ‘Properties’ of Visualization Objects” on page 3388
- % Chapter 6.4.5.21.4.1.1 “Visualization Editor” on page 3393

#### Visualization Editor

The visualization editor opens when you double-click a visualization object.
● (1) Graphical editor: Here you create the visualization from the visualization elements which are provided in the visualization toolbox view.

● (2) View "Visualization Toolbox": available visualization elements

● (3) View "Properties": Configuration editor for the visualization element currently selected in the editor area

● (4) Menu “Visualization”: Commands for working in the visualization editor

The “Visualization” menu contains, for example, commands for opening additional editors.

● (5) "Interface Editor": Declaration of variables which can be used to parameterize references of the visualization.

● (6) "Hotkeys Configuration": Definition of keyboard shortcuts for inputs on the visualization in online mode.

● (7) “Element List”: List of all elements used in the visualization; possibility to change their position on the Z-axis.

See also

● Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

● Chapter 6.4.5.6.5 “Configuring Keyboard Shortcuts” on page 2892

● Chapter 6.4.5.17.3 “Calling a Visualization with an Interface” on page 2951

● Chapter 6.4.5.21.4.1.2 “View 'Visualization Toolbox'” on page 3394

● Chapter 6.4.5.21.4.1.3 “View 'Properties' of a visualization element” on page 3396

● Chapter 6.4.5.21.2 “Commands” on page 3339

● Chapter 6.4.5.21.2.1 "Command 'Interface Editor'” on page 3340

● Chapter 6.4.5.21.2.2 "Command 'Keyboard Configuration'” on page 3341

● Chapter 6.4.5.21.2.3 "Command 'Visualization Element List'” on page 3342

View 'Visualization Toolbox'

Symbol: 🎨

Function: The view provides the elements that can be used in the editor. The individual elements are assigned with specific categories. There is a button for each category. The elements of selected categories are displayed with thumbnails which can be dragged into the editor. In addition to the standard categories, you can also define your own categories. You can resize the thumbnails with the slider or perform a full-text search of element names.
**Call:** Menu bar: “View ➜ ”

**Requirement:** A visualization is active.

- (1) “Visualization Toolbox” view
- (2) Toolbar with commands
- (3): Buttons for selecting element categories
- (4) Selection of individual visualization elements
- (5) Controls

See also

- *Command 'Toolbox'*
Toolbar with commands

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Symbol](85x732 to 95x742)</td>
<td>Only one button can be selected.</td>
</tr>
<tr>
<td>![Symbol](85x714 to 95x724)</td>
<td>Multiple buttons can be selected.</td>
</tr>
<tr>
<td>![Symbol](270x334 to 282x344)</td>
<td>The &quot;Configure Categories and Items&quot; dialog opens.</td>
</tr>
</tbody>
</table>

See also

- % Chapter 6.4.5.21.3.4 “Dialog ‘Configure Categories and Items’” on page 3368

Buttons for selecting element categories

A button is displayed for each defined element category. A selected button is displayed in green.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Shift] + click a button</td>
<td>Changes the selection of the category and the selection type (single or multiple selection possible)</td>
</tr>
<tr>
<td>Right-click a button</td>
<td>The context menu opens.</td>
</tr>
</tbody>
</table>

Table 699: Context menu of a button

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Hide Category”</td>
<td>Removes the button. Then the category is removed from view.</td>
</tr>
<tr>
<td>“Enable Category”</td>
<td>The button turns green and the category is enabled, irrespective of the selection type.</td>
</tr>
<tr>
<td>“Disable Category”</td>
<td>The button turns gray and the category is disabled, irrespective of the selection type.</td>
</tr>
</tbody>
</table>

See also

- % Chapter 6.4.5.5.2 “Select Element” on page 2873
- % Chapter 6.4.5.21.3.4 “Dialog ‘Configure Categories and Items’” on page 3368
- Command ‘Toolbox’

Selection of visualization elements

The visualization elements are displayed as thumbnails and labeled with names. The selection depends on the search query in or on the chosen buttons.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slider</td>
<td>To resize of the thumbnails.</td>
</tr>
<tr>
<td>![Search](46x261 to 150x289) with input field</td>
<td>For a full-text search by element name of all available elements</td>
</tr>
<tr>
<td>“&lt;number&gt; items”</td>
<td>Number of visualization element items that are currently displayed as a result of the selected buttons and the search query in.</td>
</tr>
</tbody>
</table>

View 'Properties' of a visualization element

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Symbol](166x146 to 176x156)</td>
<td>This view is used for configuring the element properties of the selected visualization element.</td>
</tr>
</tbody>
</table>

**Function:** This view is used for configuring the element properties of the selected visualization element.

**Call:** Menu bar: “View ➔ Element Properties”

See also

- % Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
Menu bar

Table 700: “Filters”

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“All categories”</td>
<td>List of all element properties</td>
</tr>
<tr>
<td>“Default”</td>
<td>List of the most frequently used element properties</td>
</tr>
<tr>
<td>“Simple”</td>
<td>List of certain basic element properties, such as “Texts”, “Colors”, and “Input configuration”</td>
</tr>
<tr>
<td>“Animation”</td>
<td>List of element properties for animation with variables</td>
</tr>
<tr>
<td>“Colors”</td>
<td>List of element properties for designing with color</td>
</tr>
<tr>
<td>“Texts”</td>
<td>List of element properties for designing with text</td>
</tr>
<tr>
<td>“Input”</td>
<td>List of element properties for configuring user input</td>
</tr>
</tbody>
</table>

Table 701: “Sort”

<table>
<thead>
<tr>
<th>Sort Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Sort by type”</td>
<td>Element properties are sorted by the original order of categories.</td>
</tr>
<tr>
<td>“Sort by name”</td>
<td>Element properties are sorted in alphabetical order.</td>
</tr>
</tbody>
</table>

Table 702: “Order”

<table>
<thead>
<tr>
<th>Order Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Sort ascending”</td>
<td>The properties are sorted from A to Z.</td>
</tr>
<tr>
<td>“Sort descending”</td>
<td>The properties are sorted from Z to A.</td>
</tr>
</tbody>
</table>

“Expert”

- The table includes all properties. The menu command “Filter ➔ Show all categories” is enabled at the same time.

Element properties display in a table

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Property”</td>
<td>Element properties of the selected element</td>
</tr>
<tr>
<td>“Value”</td>
<td>The assigned value is applied in the editor view.</td>
</tr>
</tbody>
</table>

Double-click in the “Value” column

- A line editor, drop-down list, or dialog opens for editing the value.

Single-click for a selected field [Blank] for a selected field

- opens the “Input Assistant” dialog for help, for example when assigning variables or image references.

- A style selected in the visualization manager can include single, predefined element properties. As a result, these do not appear in this view because a fixed value is already assigned to them. They do not have to be configured anymore.

- Visualizations can be configured with device-specific restrictions that block the availability of element properties.
Device-specific restrictions:
- Elements with restricted availability
- Fonts with restricted availability
- Colors with restricted display
- Image formats with restricted display
- Maximum number of visualization elements
- Maximum number of visualizations below the device

Object 'Visualization manager'

Symbol: 🖼

The visualization manager manages the configuration settings for all display variants of the visualizations of the current application.

The object is automatically inserted when a visualization object is inserted below the application. On a double-click the configuration dialog opens with several tabs.

If the device employed supports display variants of the visualization, the visualization manager automatically brings along the corresponding objects (CODESYS WebVisu, CODESYS TargetVisu).

If the device employed supports CODESYS TargetVisu, the visualization manager automatically brings along the corresponding object CODESYS TargetVisu.

See also
- Chapter 6.4.5.18 “Configuring and executing display variants” on page 2973
- Chapter 6.4.5.21.4.7 “Object 'TargetVisu’” on page 3408
- Chapter 6.4.5.21.4.8 “Object 'WebVisu’” on page 3409

Tab 'Visualization manager' – 'Settings'

Symbol: 🖼

Function: the tab contains settings for all visualizations that are available application-wide.

'General settings’

| “Use unicode strings” | ☑: The visualization codes character strings as Unicode. |
| “Use CurrentVisu variable” | ☑: the application knows and uses the global variable VisuElems.CurrentVisu of the type STRING. It contains the name of the currently active visualization at the runtime of the application. The application can read from the variable in order to obtain the name of the currently active visualization. The application can cause a visualization change by a write access. Requirement: the application contains a visualization that calls further visualizations. Example |
| Variable assignment: VisuElems.CurrentVisu:=strVisuName; |
| Visualization name assignment: VisuElems.CurrentVisu:='visu1'; |
The “Visualization Style Editor” enables new styles to be generated, checked and installed in the visualization styles repository.

**“Selected style”**
- Style from the visualization styles repository that every visualization in the application uses, for example “Flat Style”.
- “<None>”: The visualization displays its elements without style or according to the internal default. A standard dialog appears instead of a selection list for selection in the element properties “Color” and “Font”.

**Display all versions (for experts only)**
- The selection list contains only the latest version of each selected style and all other styles. If a newer version of the selected style is installed it is also displayed.
- The selection list contains all versions of all installed styles.

**Button 🔌**
- Opens a selection list with commands for the use of the “Visualization Styles Editor”.

**“Open Style Editor”**
- The “Visualization Styles Editor” opens.

**“Create and edit derived style”**
- The “Visualization Styles Editor” opens with the dialog “Create a new visualization style”. The dialog contains the settings for the first configuration step.
  - Requirement: a style is selected in “Selected style”.

**“Copy and edit the selected style”**
- The “Visualization Style Editor” opens with the dialog “Open existing style as a copy”. The dialog contains the settings for the first configuration step.
  - Requirement: a style is selected in “Selected style”.

**“Preview”**
- The elements displayed represent the style specified in “Selected style”.

See also:
- ☀ Chapter 6.4.5.19 “Applying Visualization Styles” on page 2979
- ☀ Chapter 6.4.5.19.3 “Managing visualization styles in repositories” on page 2985
- ☀ Chapter 6.4.5.22.1 “Dialog ‘Create a New Visualization Style’” on page 3749
- ☀ Chapter 6.4.5.22.2 “Dialog ‘Open Existing Style as a Copy’” on page 3749
- ☀ Chapter 6.4.5.21.3.7 “Dialog ‘Options’ - ‘Visualization Styles’” on page 3382

**‘Language settings’**

**“Selected language”**
- Language used by the display variants at the start of a visualization.

**‘Settings for default text input’**
- For an element with standard text input, a dialog that supports the input appears at runtime. You can specify which dialog appears.
“Numpad” Dialog that calls the visualization if a user activates the input field for a number at runtime. The dialog represents a numeric keypad. Default: “VisuDialogs.Numpad”

“Keypad” Dialog that calls the visualization if a user activates the input field for a text at runtime. The dialog represents a keyboard. Preset: “VisuDialogs.Keypad”

“Use text input with limits” Requirement: CODESYS TargetVisu or CODESYS WebVisu are configured as display variants and the “standard text input” is “keyboard”. The visualization then supports input via keyboard at runtime. The input thus generally takes place via an input field.

☑️ Instead of the input field you can call a dialog that displays the value range for inputs with a limited value range.

Default: “VisuDialogs.TextinputWithLimits”. This dialog displays the value range and doesn't accept any value outside these limits.

See also
- § Chapter 6.4.5.21.4.7 “Object ‘TargetVisu’” on page 3408
- § Chapter 6.4.5.21.4.8 “Object ‘WebVisu’” on page 3409

'Settings for user management dialogs'

You can configure your visualization with a user management. To do this, configure an input to an element that causes a user management dialog to appear. The VisuUserManagement library contains ready-to-use dialog visualizations for this purpose. The library is located in the installation directory, for example in C:\Program Files (x86)\3S CODESYS\CODESYS\Projects\Visu\Dialogs\VisuUserMgmtDialogs.library.

You can also use other visualizations as user management dialogs. To do that you have to change the defaults here.

“Login dialog” User management dialog that enables logging in; typically a request to enter a username and a password. It appears upon an input event on an element that executes as a consequential action “User management”, action “Login”.

Preset: VisuUserManagement.VUM_Login

“Change password dialog” User management dialog that enables a password to be changed; typically a request to enter the current password and a new one. It appears upon an input event on an element that executes as a consequential action “User management”, action “Change user password”.

Preset: VisuUserManagement.ChangePassword

“Change configuration dialog” User management dialog that enables a configuration change of the user management, i.e. typically a display of the current user configuration and a possibility to change it. It appears upon an input event on an element that executes as a consequential action “User management”, action “Open user configuration”.

Preset: VisuUserManagement.VUM_UserManagement

See also
- § Chapter 6.4.5.7 “Setting Up User Management” on page 2899
- § Chapter 6.4.5.21.3.6 “Dialog ‘Input Configuration’” on page 3370
'Additional settings'

"Activate multitouch handling" ☑: At runtime the visualization expects user inputs via gestures and touch events.

Elements concerned
- Elements with input configuration
- Element of the type “Frame”
- Component of the type “Tab control”

"Activate semi-transparent drawing" ☑: The visualization draws the elements in a semi-transparent color.

To do this you can additionally specify a graduation value for the transparency when defining a color. The transparency is defined in the “Transparency” property.

The leading byte is evaluated in color variables.

Preset: Activated. Requirement: you create a new visualization and the display variants can paint semi-transparently.

"Activate standard keyboard handling" ☑
- [Tab]
- [Shift] + [Tab]
- [Input]
- [Up arrow]
- [Down arrow]
- [Right arrow]
- [Left arrow]

See also
- % Chapter 6.4.5.5.4 “Assigning a color” on page 2876
- % Chapter 6.4.5.21.1 “Keyboard Shortcuts for Default Keyboard Action” on page 3338

'Extended settings'

Table 703: “Memory settings”

<table>
<thead>
<tr>
<th>“Size of memory for visualization”</th>
<th>Memory size in bytes allocated by the visualization at runtime. Preset: “400000”</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Size of the paintbuffer (per client)”</td>
<td>Memory size in bytes allocated by the visualization per display variant and used for painting actions. Preset: “50000”</td>
</tr>
</tbody>
</table>

Table 704: “File transfer mode”

"Transfer visualization files to the PLC” ☑: When downloading the application from the visualization directories to the controller, CODESYS copies image files and text list files that the visualization references. A CODESYS TargetVisu needs the files on the PLC and similarly the dialogs that support a numerical input or a keyboard input.

Use local visualization files ☑: The visualization uses image files and text list files from local directories

Note: In order to achieve that the visualization can access the files stored locally, it is necessary that the file paths are relative. The paths are given in dialog box “Project ➔ Project settings” in tab “Visualization”.

Note: It is also necessary that the link type of a image is “Link to file”. The link type is specified in the image pool.

See also
- % Chapter 6.4.5.18.4 “Configure File Transfer Mode” on page 2978
- % Chapter 6.4.5.21.3.13 “Dialog ‘Project Settings’ - ‘Visualization’” on page 3387
Display variant denotes the type of visualization, for example WebVisu, TargetVisu. A visualization client is a currently connected display medium. Thus, several browsers (clients) can be connected in parallel for the display variant WebVisu.

Table 705: “Client settings”

| “Maximum number of visualization clients” | Limits the number of visualization clients that are executed at the same time. If you configure the elements so that they vary depending on the display variant, then you have to limit the number of display variants. A visualization is given an ID at runtime that identifies the display variant and then processes data accordingly. CODESYS can query the ID using the system variable CURRENTCLIENTID and thus obtains the information as to which of the running variants is concerned. Example: arr[CURRENTCLIENTID].dwColor  
Requirement: VisuGlobalClientManager library is integrated in the project.  
Tip: You can find in the CODESYS store. example "Global Client Manager"
|

| “Transfer both svg images and converted images” | This option is visible only if both a WebVisu and a TargetVisu exist. It concerns images in svg format only. The option is available if the device description for the controller of the TargetVisu does not support the svg (full) format.  
☑: The images are transmitted in the png or bmp formats (for TargetVisu) and additionally in svg format (for WebVisu).  
Not all settings are available with an integrated CODESYS visualization. |

Tab ‘Visualization Manager’ - ‘Default Hotkeys’

Symbol: ☐

The tab includes a list of configured keyboard shortcuts that are valid for all visualizations available throughout the application. Therefore, the tab is the central location for defining keyboard shortcuts for all visualizations that are below an application. Keyboard shortcuts of the default keyboard action are not listed here. The tab is similar to the “Keyboard Configuration” tab and provides the same editing options. See also  
● “Tab ‘Keyboard configuration’” on page 3341

Tab ‘Visualization manager’ – ‘Visualizations’

Symbol: ☐
**Function:** The tab lists all visualizations that are available project-wide and enables an assignment of the visualizations for the loading behaviour, depending on the display variants.

**Tab 'Visualization manager'**

**Symbol:** 🧑‍💻

The “User management” tab is used for creating and configuring the user management for visualizations and their users and groups.

If a user management has not been configured yet, then the following buttons are available:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Create empty user management”</td>
<td>The user management opens. The “None” group is created.</td>
</tr>
<tr>
<td>“Create user management with default groups and users”</td>
<td>The user management opens. The following groups and users are created:</td>
</tr>
<tr>
<td></td>
<td>● “Admin” group with “Admin” user</td>
</tr>
<tr>
<td></td>
<td>● “Service” group with “Service” user</td>
</tr>
<tr>
<td></td>
<td>● “Operator” group “Operator” user</td>
</tr>
<tr>
<td></td>
<td>● “None” group</td>
</tr>
</tbody>
</table>

**Project with multiple visualization user managements**

**Table 706: “Choose between local and remote user management”**

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use local user management</strong></td>
<td>The user management of this visualization manager is used for the visualization.</td>
</tr>
<tr>
<td><strong>Use remote user management</strong></td>
<td>Drop-down list with all devices of the project that have their own visualization user management.</td>
</tr>
</tbody>
</table>
Visualization user management on the controller for a visualization without a display variant

Even if there are no display variants of the visualization in the application, it may be required that the visualization user management is located on the controller. This is the case, for example, when HMIs connect to the controller.

Requirement: The visualization does not have any display variants. This means that the objects "Web visualization", "Target visualization", or "Remote target visualization" are inserted below the visualization manager.

Tab 'Groups'

<table>
<thead>
<tr>
<th>“Group name”</th>
<th>When you click the node, all users are listed that belong to the group.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Automatic logout&quot;</td>
<td>✅: The &quot;Logout time&quot; input field is active and editable.</td>
</tr>
<tr>
<td>&quot;Logout time&quot;</td>
<td>Input field for integer value</td>
</tr>
<tr>
<td></td>
<td>Drop-down list for time unit &quot;Min&quot;, &quot;Sec&quot;, or &quot;Hr&quot;</td>
</tr>
<tr>
<td>&quot;Permission to change user data&quot;</td>
<td>✅: The group is granted permission to edit user data when the visualization is in online mode.</td>
</tr>
<tr>
<td>&quot;Description&quot;</td>
<td>The text is visible in the development system only. It is not downloaded to the controller.</td>
</tr>
<tr>
<td>&quot;ID&quot;</td>
<td>Unique ID for each group. Assigned automatically by the system.</td>
</tr>
</tbody>
</table>

Add a new group
In the last row of the table, click in the “Group name” field and specify the name for the new group.

Delete a group
Select a group and press [Del]. The “None” group cannot be deleted.

Table 707: Buttons

<table>
<thead>
<tr>
<th>“Update visualizations / hotkeys”</th>
<th>Opens the “Update visualizations and hotkeys” dialog box. Update, if groups were changed at a time when visualizations or keyboard shortcuts already had restricted permissions.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“List usage of groups”</td>
<td>List of visualizations and keyboard shortcuts with restricted permissions. The list is displayed in the “Messages” view.</td>
</tr>
<tr>
<td>“Export groups for global visualizations”</td>
<td>The defined group names are transmitted to “Tools ➔ Options ➔ Visualization user management”. They are then listed in “Use the following user group list for the visualization”. The list can be changed there as well.</td>
</tr>
<tr>
<td>“Delete complete user management”</td>
<td>The user management is deleted and the start view is shown with the following buttons:</td>
</tr>
<tr>
<td></td>
<td>“Create empty user management” and “Create user management with default groups and users”.</td>
</tr>
<tr>
<td>“Export user management”</td>
<td>The drop-down list opens.</td>
</tr>
<tr>
<td></td>
<td>● “Before V3.5 SP6”</td>
</tr>
<tr>
<td></td>
<td>● “V3.5 SP6 and later”</td>
</tr>
<tr>
<td></td>
<td>A standard dialog opens for saving the user management as a CSV file with any name in any directory.</td>
</tr>
</tbody>
</table>
**Import user management**
A standard dialog opens for importing a user management. The user management must be a CSV file.

↑, ↓
Moves the selected group one line up/down, thus changing the hierarchy of the group.
A group of a higher hierarchy cannot have fewer permissions for an element than a group of a lower hierarchy.

---

Table 708: Dialog box “Update visualizations and hotkeys”
This dialog updates only visualization elements and keyboard shortcuts with configured permissions.

<table>
<thead>
<tr>
<th>“Add new group”</th>
<th>Drop-down list with all new created groups of this user management. Requirement: A new user group was created.</th>
</tr>
</thead>
</table>
| “Setting for new group” | • “new group in visualization / hotkey will get the right like group”: Drop-down list with all existing groups of this user management
• “new group should get the following right”
  – “for visualization elements”: Drop-down list with the permissions: “Operable”, “Only visible”, and “Invisible”.
  – “for hotkeys”: Drop-down list with the permissions: “Operable”, “Not operable”. |
| “Delete not existing groups” | If no affected visualization elements or keyboard shortcuts are found for updating, then this is displayed as a message in the “Messages” view (“Visualization” category). |
| “Rename groups” | Updates the permissions of the affected visualization elements and keyboard shortcuts |
| “Update” | Updates the permissions of the affected visualization elements and keyboard shortcuts |

---

**Tab 'User’**

| “Login name” | Name for the user to log in to the visualization at runtime. This name is unique. |
| “Full name” | This name may exist more than one time in the user management. |
| “Password” | Encrypted by CODESYS. By default, the “Login name” is displayed here. If you click the “Password” field of a selected line, then the “Change password” dialog box opens. |
| “User group” | Group(s) that the user belongs to. Clicking the “User group” field of a selected user opens the dialog box “User groups the user belongs to”.
  • “Groups”
  • “Assigned” [✓]: The user is assigned to this group. |
| “Deactivate” | [✓]: The user is deactivated. |
| “Description” | Descriptive text is available in the development system only and is not downloaded to the controller. |

---

Table 709: Buttons

| “Upload user from device” | The data of the user management is uploaded from the controller. If user data is already configured then it is overwritten. |
| “Download user to device” | The data of the user management is downloaded to the controller. The existing user management on the controller is overwritten. |
### Tab 'Settings'

#### “Settings for download of user data”

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Download user data on every login</strong></td>
<td>The data of the user management is downloaded to the controller at login. Existing data is overwritten.</td>
</tr>
<tr>
<td><strong>Never download user data on login</strong></td>
<td>The data of the user management is never downloaded to the controller, even if it changes.</td>
</tr>
<tr>
<td><strong>Allow decision on every download</strong></td>
<td>A “Warning” dialog box opens for you to accept or refuse the download.</td>
</tr>
</tbody>
</table>

#### “Access rights for elements”

- **Use group hierarchy**: The permissions can be granted to the group hierarchy of the “Groups” tab only. The group in the first line of the “Group” list is the highest in the hierarchy. A group of a higher hierarchy cannot have fewer permissions for an element than a group of a lower hierarchy.

#### “Logout behavior”

- **Change to start visualization at logout**: Switches at logout to the visualization that is configured as the “Start visualization” in the respective display variant.

---

### CSV file with the data for user management

The data for user management is saved to a CSV file in the following format:

- **User groups**: ID;group name; automatic logoff TRUE/FALSE; logoff time; unit logoff time; permission to change user data TRUE/FALSE
- **Users**: login name; full name; password encrypt TRUE/FALSE; password; group ID; user deactivated TRUE/FALSE

Use this format when you want to edit data for user management by means of any tool. If you set `password encrypt` to `FALSE`, then an unencrypted password can be used. In the example, the unencrypted password `Yellow` was specified for the user `Hugo`. If you import the CSV file with the command “Import user management”, then the password is encrypted automatically.
**Example**

```
V1.0.0.1
Usergroups:
1;Admin;TRUE;1;Minute;TRUE
3;Operator;FALSE;1;Minute;FALSE
7;Service;FALSE;1;Minute;FALSE
0;None;FALSE;1;Minute;FALSE
4;Early and late shift;FALSE;1;Minute;FALSE
2;Early shift;TRUE;1;Minute;FALSE
6;Late shift;FALSE;1;Minute;FALSE
User:
Service;Service;TRUE;C08298D42A35732CFFB7DF43771B7607;2;FALSE
Operator;Operator;TRUE;3D94AB9540B025B07773DE7037F19837;3;FALSE
John;Blue;TRUE;62ED5DE29E5DD4164A01F3AF1B081EFA0;4;FALSE
Paul;White;TRUE;01E2CBD4AE5442D9EACE33669549A3CC;2;FALSE
Hugo;Green;FALSE;Yellow;6;FALSE
```

**Tab 'Visualization Manager' - 'Font'**

**Symbol:** 📦

**Function:** This tab provides settings for adapting the font and font size in the visualization according to the language. The settings apply to all visualizations of the application, including the visualization manager.

**Table 710: “Language Specific Font Settings”**

<table>
<thead>
<tr>
<th>“Language”</th>
<th>Language used in the project. A column is created for each language. All text lists, including those from integrated libraries, are scanned for this.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Font”</td>
<td>Font used by the visualization depending on the language.</td>
</tr>
</tbody>
</table>
| “Size factor” | The factor affects the type size of all texts in the visualization.  
|             | Preset: 1  
|             | If the factor is smaller than 1, this leads to a reduction of the type size. If the factor is 1, all texts are displayed unchanged as defined in “Properties”. |
| Red highlighting of a cell | The highlighted language is no longer present in the text lists of the project or the libraries.  
|             | This highlighting is not available in runtime mode. |

**Context menu of a selected table row**

| “Delete Language” | The associated column is removed. This is advisable above all if settings in the column are highlighted in red. |
| “Copy Language Settings” | All settings in the column are copied to the clipboard. |
| “Paste Language Settings” | All settings in the column are overwritten with the values from the clipboard. |

**Table 711: “General Font Settings”**

| “Automatic decrease of font size” | ✅: If the text to be displayed does not fit in the text field in the set format, then the font size is decreased automatically until the text fits completely in the text field.  
| | Tip: This prevents a text from being truncated when changing to a language that needs more space. The requirement is that a font is available which has a sufficiently small font. |
See also
● % Chapter 6.4.5.8 “Setting Up Multiple Languages” on page 2906

Object 'TargetVisu'

Symbol: 

Function: The object is used for configuring CODESYS TargetVisu in order to display the visualization directly on the controller of an integrated or connected panel.

Requirement: The CODESYS control runtime environment is equipped with the CODESYS TargetVisu component. The object itself is inserted below the visualization manager.

CODESYS TargetVisu can be executed on different platforms, from embedded controllers to powerful PC-based systems on different operating systems. Therefore, it can be run on Windows, Windows Embedded CE, Linux, QNX, or VxWorks. A ready-made adaptation to the graphics interface of the systems is available on these operating systems. An adaptation is required for embedded controllers or other operating systems. In addition, there are device manufacturers that integrate visualizations into external applications by means of ActiveX controls.

<table>
<thead>
<tr>
<th>“Start Visualization”</th>
<th>Name of the visualization where the start is displayed as CODESYS TargetVisu. Hint: Use input assistance for selecting another visualization.</th>
</tr>
</thead>
</table>
| “Update rate (ms)”    | Refresh rate (in milliseconds) in the visualization  
Example: 200 |
| “Show used visualizations” | The link opens the “Visualizations” tab in the “Visualization manager” editor. The tab provides information of the visualizations loaded on the display variants. |

See also
● % Chapter 6.4.5.21.4.4 “Tab ‘Visualization manager’ – ‘Visualizations’” on page 3402

Table 712: “Scaling Options”

<table>
<thead>
<tr>
<th>“Fixed”</th>
<th>∅: Fixed size of the visualization (original size).</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Isotropic”</td>
<td>∅: The size of the visualization is adapted to the dimensions of the display device, retaining the proportions of the visualization.</td>
</tr>
<tr>
<td>“Anisotropic”</td>
<td>∅: The size of the visualization is adjusted to the size of the display device, for example a screen.</td>
</tr>
<tr>
<td>“Use scaling options for dialogs”</td>
<td>☑: The dialogs, also for keypad and numpad, are scaled like the visualization (drawn with the same scaling factor). This is an advantage when a dialog was created to match the visualization because then they are scaled together.</td>
</tr>
<tr>
<td>“Use automatically detected client size”</td>
<td>☑: The visualization fills the screen of the display device completely.</td>
</tr>
<tr>
<td>“Use specified client size”</td>
<td>☑: The values in “Client height” and “Client width” are used for the size of the visualization. The visualization fills this screen area only.</td>
</tr>
<tr>
<td>“Client height”</td>
<td>Height of the visualization (in pixels).</td>
</tr>
<tr>
<td>“Client width”</td>
<td>Width of the visualization (in pixels).</td>
</tr>
</tbody>
</table>
Table 713: “Presentation Options”

<table>
<thead>
<tr>
<th>“Antialiased drawing”</th>
</tr>
</thead>
<tbody>
<tr>
<td>Antialiasing is used in the visualization editor for drawing a visualization as a TargetVisu and a TargetVisu variant.</td>
</tr>
<tr>
<td>Hint: If a horizontal or vertical line is drawn blurry on a specific visualization platform, then this can be corrected by an offset of 0.5px in the direction of the line thickness (see element property “Absolute movement”, option “Use REAL values”). Requirement: The platform in use supports using REAL coordinates.</td>
</tr>
</tbody>
</table>

Table 714: “Default Text Input”

<table>
<thead>
<tr>
<th>“Input with”</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Touchscreen”</td>
</tr>
<tr>
<td>Text input on the display variant with touchscreen. The keypad or numpad dialog opens.</td>
</tr>
<tr>
<td>“Keyboard”</td>
</tr>
<tr>
<td>Text input on the display variant with an ordinary keyboard or a virtual keyboard (on Linux for example)</td>
</tr>
</tbody>
</table>

Effect: When you configure a user input for default text input, select an input configuration for input action “Write variable”, and configure the “Input type” as “Default”, then the settings are used here.

See also
- ☞ Chapter 6.4.5.6 “Configuring user inputs” on page 2885
- ☞ “Input action ‘Write Variable’” on page 3378

Object ‘WebVisu’

Symbol: 🌐

**Function:** The object is used to configure the web-based display variant for remote display of the visualization of the controller in a web browser. This allows for remote access, remote monitoring, as well as service and diagnostics of an application over the Internet.

**Requirement:** The object is inserted below the Visualization Manager, and the target system has a web server with CODESYS WebVisu support. The web server allows for the communication between the target system and the web browser.

See also
- ☞ Chapter 6.4.5.18.2 “Executing as CODESYS WebVisu” on page 2974

<table>
<thead>
<tr>
<th>“Start Visualization”</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of the visualization where the start is displayed as CODESYS WebVisu.</td>
</tr>
<tr>
<td>Hint: Use the Input Assistant to select another visualization.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Name of the .htm file”</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base URL of the web page. The URL is also specified as the address in the web browser.</td>
</tr>
<tr>
<td><strong>Example:</strong> <a href="http://localhost:8080/webvisu.htm">http://localhost:8080/webvisu.htm</a></td>
</tr>
<tr>
<td><strong>Note:</strong> If you use a BeagleBone Black as a visualization device, then you have to note that a BeagleBone Black uses port 9090 for its web server. A valid IP address is as follows: <a href="http://192.168.7.2:9090/webvisu.htm">http://192.168.7.2:9090/webvisu.htm</a></td>
</tr>
</tbody>
</table>
**“Use as default page”**

☑️: The page specified in “Name of .htm file” is preset as the default page. Now this page will always open when a user specified in the web browser the IP address and port of the web server that is running on the controller: http://<IP address web server>:<port web server>.

Example: http://localhost:8080

Notice: Even if you have created multiple web visualizations, you can activate this option for exactly one web page only and therefore preset only one page as the default page.

**“Update rate (ms)”**

Refresh rate (in milliseconds) in the web browser

**“Default communication buffer size”**

Default size for communication buffer (in bytes). Defines the maximum available memory for data transfer between the web client and the web server.

Example: 50000

**“Show Used Visualizations”**

The link opens the “Visualizations” tab in the “Visualization Manager” editor.

The tab provides information about the visualizations downloaded to the display variants.

See also

- 🆕️ Chapter 6.4.5.21.4.4 “Tab ‘Visualization manager’ – ‘Visualizations’” on page 3402
- 🆕️ Chapter 6.4.5.18.2 “Executing as CODESYS WebVisu” on page 2974

<table>
<thead>
<tr>
<th>Table 715: “Scaling Options”</th>
</tr>
</thead>
</table>
| **“Fixed”** | ☑️: Fixed size of the visualization. The values used are “Client height” and “Client width”.

| **“Isotropic”** | ☑️: The size of the visualization is adapted to the dimensions of the web browser, retaining the proportions of the visualization.

| **“Anisotropic”** | ☑️: The size of the visualization is adapted to the web browser.

| **“Use scaling options for dialogs”** | ☑️ The dialogs (also for keypad and numpad) are scaled as the visualization (drawn with the same scaling factor). This is an advantage when a dialog was created to match the visualization because then they are scaled together.

| **“Client height”** | Height of the visualization (in pixels).

| **“Client width”** | Width of the visualization (in pixels).

<table>
<thead>
<tr>
<th>Table 716: “Presentation Options”</th>
</tr>
</thead>
</table>
| **“Antialiased drawing”** | ☑️: Antialiasing is used when drawing the visualization in the web browser.

<table>
<thead>
<tr>
<th>Table 717: “Input handing options”</th>
</tr>
</thead>
</table>
| **“Standard text input with”** | ☑️ “Touchscreen”: Text input on the WebVisu with touchscreen. The keypad or numpad dialog opens.

| **“Keyboard”**: Text input on the WebVisu with an ordinary keyboard or a virtual keyboard (on Android OS for example)

Effect:

When you configure a user input for default text input, select an input configuration for input action “Write Variable”, and configure the “Input type” as “Default”, then the settings are used here.

| **“Treat touch as mouse actions”** | ☑️: On devices with a touchscreen, gestures are treated as mouse actions. This option is required, for example, to operate a slider or scrollbar on a touch device.
See also

- © Chapter 6.4.5.6 “Configuring user inputs” on page 2885
- © “Input action ‘Write Variable’” on page 3378
### Visualization Elements

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.4.5.21.5.1</td>
<td>Visualization Element 'Rectangle', 'Rounded Rectangle', 'Ellipse'</td>
</tr>
<tr>
<td>6.4.5.21.5.2</td>
<td>Visualization Element 'Line'</td>
</tr>
<tr>
<td>6.4.5.21.5.3</td>
<td>Visualization Element 'Polygon', 'Polyline', 'Bézier Curve'</td>
</tr>
<tr>
<td>6.4.5.21.5.4</td>
<td>Visualization Element 'Pie'</td>
</tr>
<tr>
<td>6.4.5.21.5.5</td>
<td>Visualization Element 'Image'</td>
</tr>
<tr>
<td>6.4.5.21.5.6</td>
<td>Visualization Element 'Frame'</td>
</tr>
<tr>
<td>6.4.5.21.5.7</td>
<td>Visualization Element 'Label'</td>
</tr>
<tr>
<td>6.4.5.21.5.8</td>
<td>Visualization Element 'Combo Box, Array'</td>
</tr>
<tr>
<td>6.4.5.21.5.9</td>
<td>Visualization Element 'Combo Box, Integer'</td>
</tr>
<tr>
<td>6.4.5.21.5.10</td>
<td>Visualization Element 'Tabs'</td>
</tr>
<tr>
<td>6.4.5.21.5.11</td>
<td>Visualization Element 'Button'</td>
</tr>
<tr>
<td>6.4.5.21.5.12</td>
<td>Visualization Element 'Group Box'</td>
</tr>
<tr>
<td>6.4.5.21.5.13</td>
<td>Visualization Element 'Table'</td>
</tr>
<tr>
<td>6.4.5.21.5.14</td>
<td>Visualization Element 'Text Field'</td>
</tr>
<tr>
<td>6.4.5.21.5.15</td>
<td>Visualization Element 'Scroll Bar'</td>
</tr>
<tr>
<td>6.4.5.21.5.16</td>
<td>Visualization Element 'Slider'</td>
</tr>
<tr>
<td>6.4.5.21.5.17</td>
<td>Visualization Element 'Spin Box'</td>
</tr>
<tr>
<td>6.4.5.21.5.18</td>
<td>Visualization Element 'Invisible Input'</td>
</tr>
<tr>
<td>6.4.5.21.5.19</td>
<td>Visualization Element 'Check Box'</td>
</tr>
<tr>
<td>6.4.5.21.5.20</td>
<td>Visualization Element 'Progress Bar'</td>
</tr>
<tr>
<td>6.4.5.21.5.21</td>
<td>Visualization Element 'Radio Buttons'</td>
</tr>
<tr>
<td>6.4.5.21.5.22</td>
<td>Visualization Element 'Alarm Table'</td>
</tr>
<tr>
<td>6.4.5.21.5.23</td>
<td>Visualization Element 'Alarm Banner'</td>
</tr>
<tr>
<td>6.4.5.21.5.24</td>
<td>Visualization Element 'Bar Display'</td>
</tr>
<tr>
<td>6.4.5.21.5.25</td>
<td>Visualization Element 'Meter 90°'</td>
</tr>
<tr>
<td>6.4.5.21.5.26</td>
<td>Visualization Element 'Meter 180°'</td>
</tr>
<tr>
<td>6.4.5.21.5.27</td>
<td>Visualization Element 'Meter'</td>
</tr>
<tr>
<td>6.4.5.21.5.28</td>
<td>Visualization Element 'Potentiometer'</td>
</tr>
<tr>
<td>6.4.5.21.5.29</td>
<td>Visualization Element 'Histogram'</td>
</tr>
<tr>
<td>6.4.5.21.5.30</td>
<td>Visualization Element 'Image Switcher'</td>
</tr>
<tr>
<td>6.4.5.21.5.31</td>
<td>Visualization Element 'Lamp'</td>
</tr>
<tr>
<td>6.4.5.21.5.32</td>
<td>Visualization Element 'Dip Switch', 'Power Switch', 'Push Switch', 'Push Switch LED', 'Rocker Switch'</td>
</tr>
<tr>
<td>6.4.5.21.5.33</td>
<td>Visualization Element 'Rotary Switch'</td>
</tr>
<tr>
<td>6.4.5.21.5.34</td>
<td>Visualization Element 'Trace'</td>
</tr>
<tr>
<td>6.4.5.21.5.35</td>
<td>Visualization Element 'Trend'</td>
</tr>
<tr>
<td>6.4.5.21.5.36</td>
<td>Visualization Element 'Legend'</td>
</tr>
<tr>
<td>6.4.5.21.5.37</td>
<td>Visualization Element 'ActiveX'</td>
</tr>
<tr>
<td>6.4.5.21.5.38</td>
<td>Visualization Element 'Web Browser'</td>
</tr>
<tr>
<td>6.4.5.21.5.39</td>
<td>Visualization Element 'Busy Symbol, Cube'</td>
</tr>
<tr>
<td>6.4.5.21.5.40</td>
<td>Visualization Element 'Busy Symbol, Flower'</td>
</tr>
<tr>
<td>6.4.5.21.5.41</td>
<td>Visualization Element 'Text Editor'</td>
</tr>
<tr>
<td>6.4.5.21.5.42</td>
<td>Visualization Element 'Path3D'</td>
</tr>
<tr>
<td>6.4.5.21.5.43</td>
<td>Visualization Element 'Control Panel'</td>
</tr>
<tr>
<td>6.4.5.21.5.44</td>
<td>Visualization Element 'Date Range Picker'</td>
</tr>
<tr>
<td>6.4.5.21.5.45</td>
<td>Visualization Element 'Time Range Picker'</td>
</tr>
<tr>
<td>6.4.5.21.5.46</td>
<td>Visualization Element 'Date Picker'</td>
</tr>
<tr>
<td>6.4.5.21.5.47</td>
<td>Visualization Element 'Analog Clock'</td>
</tr>
</tbody>
</table>
Visualization Element ‘Rectangle’, ‘Rounded Rectangle’, ‘Ellipse’

Symbol:

Category: “Basic”

The “Rectangle”, “Rounded Rectangle”, and “Ellipse” are the same type of element. They can be converted into another element type by changing the “Element type” property.

**Element properties**

| “Element name” | Optional
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: Werkstück_3</td>
<td></td>
</tr>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
</tbody>
</table>

| “Type of element” | “Rectangle”, “Rounded Rectangle”, “Ellipse” |

**Element property ‘Position’**

The position defines the location and size of the element in the visualization window. This is based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

| “X” | The x-coordinate of the upper left corner of the element
| Specified in pixels |
| Example: 10 |

| “Y” | The y-coordinate of the upper left corner of the element
| Specified in pixels |
| Example: 10 |

| “Width” | Specified in pixels |
| Example: 150 |

| “Height” | Specified in pixels |
| Example: 30 |

Tip: You can change the values in “X”, “Y”, “Width”, and “Height” by dragging the corresponding symbols to another position in the editor.
**“Angle”**

Static angle of rotation (in degrees)

Example: 35

The element is displayed rotated in the editor. The point of rotation is the center of the element. A positive value rotates clockwise.

Tip: You can change the value in the editor by focusing the element to the handle. When the cursor is displayed as a rotating arrow, you can rotate the element about its center as a handle.

\[\text{(1): Handle}\]

Note: If a dynamic angle of rotation is also configured in the property “Absolute movement ➔ Internal rotation”, then the static and dynamic angles of rotation are added in runtime mode. The static angle of rotation acts as an offset.

See also

- § Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

---

**Radius setting**

Visible only when “Rounded Rectangle” is selected in the “Type of element” property.

<table>
<thead>
<tr>
<th>“Radius”</th>
<th>Rounding of the corners.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“From style”</td>
<td></td>
</tr>
<tr>
<td>“Relative to the element size”</td>
<td></td>
</tr>
<tr>
<td>“Explicit”: Allows for specifying a custom value in the “Value” setting.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Value”</th>
<th>Radius of the rounded corners (in pixels)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 5</td>
<td></td>
</tr>
<tr>
<td>Requirement: “Explicit” is selected in the “Radius” setting.</td>
<td></td>
</tr>
</tbody>
</table>

**Element property ‘Center’**

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the θ symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (θ) to other positions in the editor.

---

**Element property ‘Colors’**
The properties contain fixed values for setting the look of the element.

**Line width**
- Value in pixels
- Example: 2
- Note: The values 0 and 1 both result in a line weight of 1 pixel. If no line should be displayed, then the “Line style” property must be set to the option “Invisible”.

**Fill attributes**
- The way in which the element is filled.
  - “Filled”: The element is filled with the color from property “Colors ➔ Fill color”.
  - “Invisible”: The fill color is invisible.

**Line style**
- Type of line representation
  - “Solid”
  - “Dashes”
  - “Dots”
  - “Dash Dot”
  - “Dash Dot Dot”
  - “not visible”

You can assign variables in the “Appearance variables” property for controlling the appearance dynamically. The fixed values here are overwritten.

See also
- “Element property ‘Appearance variables’” on page 3476

The properties contain character strings for labeling the element. The character string can also contain a placeholder with a format definition. In runtime mode, the placeholder is replaced by the current value in the specified format.

CODESYS accepts the specified texts automatically into the “GlobalTextList” text list. Therefore, these texts can be localized.
**“Text”**  
Character string (without single straight quotation marks) for the labeling the element. Add a line break by pressing the keyboard shortcut [Ctrl] + [Enter].  
**Example:** Accesses: %i  
The variable that contains the current value for the placeholder is specified in the property “Text variable ➔ Text”.

**“Tooltip”**  
Character string (without single straight quotation marks) that is displayed as the tooltip of an element.  
**Example:** Number of valid accesses.  
The variable that contains the current value for the placeholder is specified in the property “Text variable ➔ Tooltip”.

See also  
- ☼ “Element property ‘Text variables’” on page 3418  
- ☼ Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872  
- ☼ Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329

### Element property ‘Text properties’

The properties contain fixed values for the text properties.

<table>
<thead>
<tr>
<th>“Horizontal alignment”</th>
<th>Horizontal alignment of the text within the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Vertical alignment”</td>
<td>Vertical alignment of the text within the element.</td>
</tr>
</tbody>
</table>

**“Text format”**  
Definition for displaying texts that are too long  
- “Default”: The long text is truncated.  
- “Line break”: The text is split into parts.  
- “Ellipsis”: The visible text ends with “…” indicating that it is not complete.

**“Font”**  
**Example:** “Default”  
△: The “Font” dialog box opens.  
▼: Drop-down list with style fonts.

**“Font color”**  
**Example:** “Black”  
△: The “Color” dialog box opens.  
▼: Drop-down list with style colors.

**“Transparency”**  
Whole number (value range from 0 to 255). This determines the transparency of the respective color.  
**Example:** 255: The color is opaque.  
0: The color is completely transparent.  
Please note: If the color is a style color and already has a transparency value, then this property is write-protected.

### Element property ‘Absolute movement’

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

**“Movement”**

| “X” | Variable (numeric data type). Defines the X position (in pixels).  
**Example:** PLC_PRG.iPos_X.  
Increasing this value in runtime mode moves the element to the right. |
<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Y”</strong></td>
<td>Variable (numeric data type). Defines the Y position (in pixels). Increasing this value in runtime mode moves the element downwards.</td>
<td>PLC_PRG.iPos_Y</td>
</tr>
<tr>
<td><strong>“Rotation”</strong></td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees). Increasing the value in runtime mode rotates the element to the right.</td>
<td>PLC_PRG.iAngle1</td>
</tr>
<tr>
<td><strong>“Scaling”</strong></td>
<td>Variable (integer data type). Causes centric stretching. Increasing the value 1 shrinks the element by a factor of 0.001. The value 1000 returns the element to its original size.</td>
<td>PLC_PRG.iScaling</td>
</tr>
<tr>
<td><strong>“Interior rotation”</strong></td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees). In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. Increasing the value in the code rotates clockwise.</td>
<td>PLC_PRG.iAngle2</td>
</tr>
<tr>
<td><strong>“Use REAL values”</strong></td>
<td>Note: Only available if the device supports the use of REAL coordinates. The properties of the absolute movement are interpreted as REAL values. The values are not rounded. The option allows for the individual fine-tuning of drawing the element, for example for the visualization of a smoother rotation.</td>
<td></td>
</tr>
</tbody>
</table>

---

You can link the variables to a unit conversion.
The properties “X”, “Y”, “Rotation”, and “Interior rotation” are supported by the “Client Animation” functionality.

See also

- Element property 'Relative movement'

The properties contains variables for moving the element. The reference point is the position of the element (‘Position’ property). The shape of the element can change.

<table>
<thead>
<tr>
<th>“Movement top-left”</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
<td>Variable (integer data type). It contains the number (in pixels) that the left edge is moved horizontally. Incrementing the value moves the element to the right. Example: PLC_PRG.iDeltaX</td>
</tr>
<tr>
<td>“Y”</td>
<td>Variable (integer data type). It contains the number (in pixels) that the top edge is moved vertically. Incrementing the value moves the element to the down. Example: PLC_PRG.iDeltaY</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Movement bottom-right”</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
<td>Variable (integer data type). It contains the number (in pixels) that the right edge is moved horizontally. Incrementing the value moves the element to the right. Example: PLC_PRG.iDeltaWidth</td>
</tr>
<tr>
<td>“Y”</td>
<td>Variable (integer data type). It contains the number (in pixels) that the bottom edge is moved vertically. Incrementing the value moves the element to the down. Example: PLC_PRG.iDeltaHeight</td>
</tr>
</tbody>
</table>

See also

- “Element property ‘Absolute movement’” on page 3416

Element property 'Text variables'

These properties are variables with contents that replace a format definition.

<table>
<thead>
<tr>
<th>“Text variable”</th>
<th>Variable (data type compliant with the format definition). It contains what is printed instead of the format definition. Example: PLC_PRG.iAccesses</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Note: The format definition is part of the text in the property “Texts ➔ Text”. Note: If you specify a variable of type enumeration with text list support, then the name of the enumeration data type is added automatically in angle brackets after the variable name. Example: PLC_PRG.enVar &lt;enumeration name&gt;. Then the symbolic value of the enumeration component is printed instead of the numeric value when text is printed. Refer to the help page for the enumerations.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Tooltip variable”</th>
<th>Variable (data type compliant with the format definition). It contains what is printed instead of the format definition. Example: PLC_PRG.iAccessesInTooltip</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Note: The format definition is part of the text in the property “Texts ➔ Tooltip”.</td>
</tr>
</tbody>
</table>
Dynamic texts are variably indexed texts of a text list. At runtime, the text is displayed that is currently indexed in the variable.

| "Text list" | Variable (string) or name of the text list as a fixed string in single straight quotation marks.  
| Example: 'Errorlist' |
| "Text index" | Text list ID. This refers to the desired output text.  
| As fixed string with the ID in single straight quotation marks.  
| Example: '1' |
| As a variable (STRING) for dynamically controlling the text output.  
| Example: strTextID  
| Sample assignment: PLC_PRG.strTextID := '1'; |
| "Tooltip index" | Text list ID. This refers to the desired output text.  
| As fixed string with the ID in single straight quotation marks.  
| Example: '2' |
| As a variable (STRING) for dynamically controlling the text output.  
| Example: strToolTipID  
| Sample assignment: PLC_PRG.strToolTipID := '2'; |

The variables allow for dynamic control of the text display.

See also
- `Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329`
- `“Element property ‘Texts’” on page 3415`
- `Chapter 6.4.1.20.5.18 “Enumerations” on page 2263`
### “Font name”
Variable (STRING). Includes the font of the text.
Example: PLC_PRG.stFontVar := 'Arial';
The selection of fonts corresponds to the default “Font” dialog.

### “Size”
Variable (numeric data type). Contains the font size (in pixels or points). The applied unit is specified in brackets after the variable name.
- \(<pt>\): Points (default)
  Example: PLC_PRG.iFontHeight <pt>
  Code: iFontHeight : INT := 12;
- \(<px>\): Pixels
  Example: PLC_PRG.iFontHeight <px>
  Code: iFontHeight : INT := 19;

If you click in the value field, a drop-down list opens on the right for setting the unit.
Hint: The font size is specified in points (example: Arial 12). Use points when the variable font size should match a font, for example if a font is set in the property “Text property ➔ Font”.

### “Flags”
Variable (DWORD). Contains the flags for displaying fonts.
Flags:
- 1: Italics
- 2: Bold
- 4: Underline
- 8: Strikethrough
Note: You can combine the font displays by adding the coding of the flags. For example, a bold and underlined text: PLC_PRG.dwFontType := 6;

### “Character set”
Variable (DWORD). Contains a character set number for the font.
The selection of character set numbers corresponds to the “Script” setting of the standard “Font” dialog.

### “Color”
Variable (DWORD). Includes the color of the text.
Example: PLC_PRG.dwColorFont := 16#FF000000;

### “Flags for text alignment”
Variable (integer data type). Contains the coding for text alignment.
Example: PLC_PRG.dwTextAlignment.
Coding:
- 0: Top left
- 1: Horizontal center
- 2: Right
- 4: Vertical center
- 8: Bottom
Note: You can combine the text alignments by adding the coding of the flags. For example, a vertical and horizontal centered text: PLC_PRG.dwFontType := 5;
Fixed values for displaying texts are set in “Text properties”.

See also
- “Element property ‘Text properties’” on page 3416

The Element property is used as an interface for project variables to dynamically control colors at runtime.

<table>
<thead>
<tr>
<th>“Toggle color”</th>
<th>The property controls the toggled color at runtime. Value assignment:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• FALSE: The element is displayed with the color specified in the “Color” property.</td>
</tr>
<tr>
<td></td>
<td>• TRUE: The element is displayed with the color specified in the “Alarm color” property.</td>
</tr>
<tr>
<td>Assignment options:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Placeholder for the user input variable</td>
</tr>
<tr>
<td></td>
<td>- “&lt;toggle/tap variable&gt;”</td>
</tr>
<tr>
<td></td>
<td>- “&lt;NOT toggle/tap variable&gt;”</td>
</tr>
<tr>
<td>The color change is not controlled by its own variable, but by a user input variable.</td>
<td></td>
</tr>
<tr>
<td>Note: Specify a variable for the mouse events “Tap” or “Toggle” in the input configuration of the element. Only then is the placeholder set. If you configure a variable in both “Toggle” and “Tap”, then the variable specified in “Tap” is used.</td>
<td></td>
</tr>
<tr>
<td>Hint: Click the symbol to insert the placeholder “&lt;toggle/tap variable&gt;”. When you activate the “Inputconfiguration”, “Tap FALSE” property, then the “&lt;NOT toggle/tap variable&gt;” placeholder is displayed.</td>
<td></td>
</tr>
<tr>
<td>• Instance path of a project variable (BOOL)</td>
<td></td>
</tr>
<tr>
<td>Example: PLC_PRG.xColorIsToggeled</td>
<td></td>
</tr>
<tr>
<td>Note: In the code, declare and implement the variable specified here. Its value assignment determines when the color changes.</td>
<td></td>
</tr>
</tbody>
</table>

| “Normal state” | The properties listed below control the color depending on the state. The normal state is in effect if the variable in “Color variables”, “Toggle color” is not defined or it has the value FALSE. The alarm state is in effect if the variable in “Color variables”, “Toggle color” has the value TRUE. |
| “Alarm state” | |

<table>
<thead>
<tr>
<th>“Frame color”</th>
<th>Assignment options:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Variable (DWORD) for the frame color</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.dwBorderColor</td>
</tr>
<tr>
<td></td>
<td>• Color literal</td>
</tr>
<tr>
<td></td>
<td>Example of green and opaque: 16#FF00FF00</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Filling color”</th>
<th>Assignment options:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Variable (DWORD) for the fill color</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.dwFillColor</td>
</tr>
<tr>
<td></td>
<td>• Color literal</td>
</tr>
<tr>
<td></td>
<td>Example of gray and opaque: 16#FF888888</td>
</tr>
</tbody>
</table>
The transparency part of the color value is evaluated only if the “Activate semi-transparent drawing” option of the visualization manager is selected.

Select the “Advanced” option in the toolbar of the properties view. Then all element properties are visible.

See also
- Chapter 6.4.5.10.4 “Animating a color display” on page 2914

**Element property 'Appearance variables'**

The properties contain IEC variables for controlling the appearance of the element dynamically.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Line width&quot;</td>
<td>Variable (integer data type). Contains the line weight (in pixels).</td>
</tr>
</tbody>
</table>
| "Fill attributes" | Variable (DWORD). Controls whether the fill color of the element is visible.  
  - Variable value = 0: Filled  
  - Variable value > 0: Invisible; no fill color |
| "Line style" | Variable (DWORD). Controls the line style.  
  Coding:  
  - 0: Solid line  
  - 1: Dashed line  
  - 2: Dotted line  
  - 3: Line type "Dash Dot"  
  - 4: Line type "Dash Dot Dot"  
  - 8: Invisible; no line |

Fixed values can be set in the “Appearance” property. These values can be overwritten by dynamic variables at runtime.

See also
- "Element property 'Appearance’” on page 3427

**Element property 'State variables'**

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
</table>
| "Invisible" | Variable (BOOL). Toggles the visibility of the element.  
  TRUE: The element is not visible at runtime.  
  Example:  
  ```cpp
  bIsVisible with VAR bIsVisible : BOOL := FALSE;  
  END_VAR
  ``` |
| "Deactivate inputs" | Variable (BOOL). Toggles the operability of the element.  
  TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated. |
The “Invisible” property is supported by the “Client Animation” functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

**“Animation duration”**

Defines the duration (in milliseconds) in which the element runs an animation

- **Variable (integer value)**
  
  Example: `Menu.tContent with VAR tContent : INT := 500; END_VAR`

- **Integer literal**
  
  Example: 500

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**“Move to foreground”**

Moves the visualization element to the foreground

Variable (BOOL)

Example: `bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR`

- TRUE: At runtime, the visualization element is displayed in the foreground.
- FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

**Element property ‘Input configuration’**

The properties contain the configurations for the user input when using the mouse or keyboard. A user input defines an event and one or more actions that are executed when an event occurs.

The “Configure” button opens the “Input Configuration” dialog. There you can create or edit user inputs. Configured user inputs are listed below the events. They each include the action that is triggered and the setting in short form.

Example: “Execute ST Code”: `PLC_PRG.i_x := 0;`

**“OnDialogClosed”**

Input event: The user closes the dialog.

**“OnMouseClick”**

Input event: The user clicks the mouse button completely in the element area. The mouse button is clicked and released.

**“OnMouseDown”**

Input event: The user clicks down on the mouse button.

**“OnMouseEnter”**

Input event: The user drags the mouse pointer to the element.

**“OnMouseLeave”**

Input event: The user drags the mouse pointer away from the element.
<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>&quot;OnMouseMove&quot;</strong></td>
<td>Input event: The user moves the mouse pointer over the element area.</td>
</tr>
</tbody>
</table>
| **"OnMouseUp"** | Input events:  
- The user releases the mouse button within the element area. It is irrelevant whether the user has previously pressed the mouse button inside or outside the element area.  
- The user presses the mouse button within the element area, leaves the element area, and then releases the mouse button.  

Note: This CODESYS-specific triggering behavior guarantees that actions for key elements are completed. A key element starts an action for "OnMouseDown" and ends the action for "OnMouseUp".  
Example: A visualization user presses the mouse button within the element area of the key element and then moves the cursor position so that it lies outside the element area. The action is ended anyway because "OnMouseUp" is triggered. |
| **"Tap"** | When a mouse click event occurs, the variable defined in "Variable" is described in the application. The coding depends on the "Tap FALSE" and "Tap on enter if captured" options. |
| **"Variable"** | Variable (BOOL) that is set on mouse click event.  
**Example:** FLC_PRG.bIsTapped  
TRUE: A mouse click event exists. It lasts as long as the user presses the mouse button over the element. It ends when the button is released.  
FALSE: A mouse click event does not exist.  
Requirement: The "Tap FALSE" option is not activated. |
| **"Tap FALSE"** | ☑️: The mouse click event leads to a complementary value in "Variable".  
TRUE: A mouse click event does not exist.  
FALSE: While the mouse click event exists. |
| **"Tap on enter if captured"** | ☑️: During user input, it is also taken into consideration whether the mouse pointer is dragged within the element area or not while the mouse button is pressed.  
TRUE: While the mouse click event exists and the mouse pointer is moved over the element area.  
FALSE: A mouse click event does not exist. Or the user moves the mouse pointer outside of the element area while the mouse button is pressed.  
The value is TRUE again as soon as the user moves the pointer back to the element area. The mouse is then captured. |
| **"Toggle"** | With the onset of a mouse click event, the variable is set; when the mouse click event is completed, the variable is reset. |
| **"Variable"** | Variable (BOOL). Its value toggled when the mouse click event is ended. This is when the user releases the mouse button while the mouse pointer is over the element area.  
If the user releases the mouse button while the mouse pointer is outside of the element area, then the mouse click event is not ended and the value is not toggled.  
Hint: The user can cancel a started toggle input by dragging the mouse pointer out of the element area. |
| **"Toggle on up if captured"** | ☑️: The value toggles regardless of where the mouse pointer is when the mouse button is released. The mouse is then captured. |
### “Hotkey”

Keyboard shortcut on the element for triggering specific input actions.

When the keyboard shortcut event occurs, the input actions in the “Events” property are triggered. In this way, it is not the input action itself that leads to this input action, but the mouse input action.

### “Key”

Key pressed for input action.

Example: `[T]`

Note: The following properties appear when a key is selected.

### “Events”

- “None”
- “Mouse down”: Pressing the key triggers the input actions that are configured in the “OnMouseDown” property.
- “Mouse up”: Releasing the key triggers the input actions that are configured in the “OnMouseUp” property.
- “Mouse down/up”: Pressing and releasing the key triggers the input actions that are configured in the “OnMouseDown” property and the “OnMouseUp” property.

### “Shift”

☑: Combination with the Shift key

Example: `[Shift]+[T]`.

### “Control”

☑: Combination with the Ctrl key

Example: `[Ctrl]+[T]`.

### “Alt”

☑: Combination with the Alt key

Example: `[Alt]+[T]`.

---

All keyboard shortcuts and their actions that are configured in the visualization are listed on the “Keyboard Configuration” tab.

See also

- Chapter 6.4.5.21.2.2 “Command ‘Keyboard Configuration’” on page 3341
- Chapter 6.4.5.21.3.6 “Dialog ‘Input Configuration’” on page 3370

### Element property ‘Access rights’

Requirement: User management is set up for the visualization.

### “Access rights”

Opens the “Access rights” dialog. There you can edit the access privileges for the element.

Status messages:

- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also

- Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

See also

- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

### Visualization Element ‘Line’

Symbol:
Category: “Basic”
The element draws a simple line.

**Element properties**

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Optional.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: Separator_Header</td>
<td></td>
</tr>
</tbody>
</table>

| “Type of element” | “Line” |

**Element property 'Position'**
The following properties define the position and length of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

| “Dots” | “[0]”: Coordinates of the starting point  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>“[1]”: Coordinate of the end point</td>
</tr>
<tr>
<td></td>
<td>You can also change the values by dragging the box symbols (🪐) to other positions in the editor.</td>
</tr>
</tbody>
</table>

| “Angle” | Static angle of rotation (in degrees).  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 35</td>
<td></td>
</tr>
<tr>
<td>The element is displayed rotated in the editor. The point of rotation is the center of the element. A positive value rotates clockwise.</td>
<td></td>
</tr>
<tr>
<td>Tip: You can change the value in the editor by focusing the element to the handle. When the cursor is displayed as a rotating arrow (🔗), you can rotate the element about its center as a handle.</td>
<td></td>
</tr>
<tr>
<td>Example:</td>
<td></td>
</tr>
</tbody>
</table>

(1): Handle

Note: If a dynamic angle of rotation is also configured in the property “Absolute movement ➔ Internal rotation”, then the static and dynamic angles of rotation are added in runtime mode. The static angle of rotation acts as an offset.

See also
- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

**Element property 'Center'**
The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the 📍 symbol. The point is used as the center for rotating and scaling.
<table>
<thead>
<tr>
<th><strong>X</strong></th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Y</strong></td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (Φ) to other positions in the editor.

### Element property 'Colors'

The properties contain fixed values for setting colors.

<table>
<thead>
<tr>
<th><strong>“Color”</strong></th>
<th>Color of the line in normal state.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Please note that the normal state is in effect if the expression in the “Color variables ⇒ Toggle color” property is not defined or it has the value FALSE.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Alarm color”</strong></th>
<th>Color of the line in alarm state.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Please note that the alarm state is in effect if the expression in the “Color variables ⇒ Toggle color” property has the value TRUE.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Transparency”</strong></th>
<th>Value (0 to 255) for defining the transparency of the selected color.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example 255: The color is opaque. 0: The color is completely transparent.</td>
</tr>
</tbody>
</table>

See also

- ☀ Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

### Element property 'Appearance'

The properties contain fixed values for setting the look of the element.

<table>
<thead>
<tr>
<th><strong>“Line width”</strong></th>
<th>Value in pixels</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 2</td>
</tr>
<tr>
<td></td>
<td>Note: The values 0 and 1 both result in a line weight of one pixel. If no line should be displayed, then the “Line style” property must be set to the option “Invisible”.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Line style”</strong></th>
<th>Type of line representation</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Solid”</td>
<td></td>
</tr>
<tr>
<td>“Dashes”</td>
<td></td>
</tr>
<tr>
<td>“Dots”</td>
<td></td>
</tr>
<tr>
<td>“Dash Dot”</td>
<td></td>
</tr>
<tr>
<td>“Dash Dot Dot”</td>
<td></td>
</tr>
<tr>
<td>“not visible”</td>
<td></td>
</tr>
</tbody>
</table>

You can assign variables in the “Appearance variables” property for controlling the appearance dynamically. The fixed values are defined here.

See also

- ☀ “Element property ‘Appearance variables’” on page 3476
The properties contain character strings for labeling the element. The character string can also contain a placeholder with a format definition. In runtime mode, the placeholder is replaced by the current value in the specified format. CODESYS accepts the specified texts automatically into the “GlobalTextList” text list. Therefore, these texts can be localized.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Text”</td>
<td>Character string (without single straight quotation marks) for the labeling the element. Add a line break by pressing the keyboard shortcut [Ctrl] + [Enter]. Example: Accesses: %i The variable that contains the current value for the placeholder is specified in the property “Text variable” ➔ &quot;Text&quot;.</td>
</tr>
<tr>
<td>“Tooltip”</td>
<td>Character string (without single straight quotation marks) that is displayed as the tooltip of an element. Example: Number of valid accesses. The variable that contains the current value for the placeholder is specified in the property “Text variable” ➔ &quot;Tooltip&quot;.</td>
</tr>
</tbody>
</table>

See also
- “Element property ‘Text variables’” on page 3430
- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
- Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329

The properties contain fixed values for the text properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Horizontal alignment”</td>
<td>Horizontal alignment of the text within the element.</td>
</tr>
<tr>
<td>“Vertical alignment”</td>
<td>Vertical alignment of the text within the element.</td>
</tr>
</tbody>
</table>
| “Text format” | Definition for displaying texts that are too long
- “Default”: The long text is truncated.
- “Line break”: The text is split into parts.
- “Ellipsis”: The visible text ends with "..." indicating that it is not complete. |
| “Font” | Example: “Default”
![Font dialog box](image)
The “Font” dialog box opens.
▼: Drop-down list with style fonts. |
| “Font color” | Example: “Black”
![Font color dialog box](image)
The “Color” dialog box opens.
▼: Drop-down list with style colors. |
| “Transparency” | Whole number (value range from 0 to 255). This determines the transparency of the respective color. Example: 255: The color is opaque. 0: The color is completely transparent. Please note: If the color is a style color and already has a transparency value, then this property is write-protected. |

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.
<table>
<thead>
<tr>
<th><strong>“Movement”</strong></th>
<th></th>
</tr>
</thead>
</table>
| “X” | Variable (numeric data type). Defines the X position (in pixels).  
Example: PLC_PRG.iPos_X.  
Increasing this value in runtime mode moves the element to the right. |
| “Y” | Variable (numeric data type). Defines the Y position (in pixels).  
Example: PLC_PRG.iPos_Y.  
Increasing this value in runtime mode moves the element downwards. |
| “Rotation” | Variable (numeric data type). Defines the angle of rotation (in degrees).  
Example: PLC_PRG.iAngle1.  
The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.  
In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right. |
| “Scaling” | Variable (integer data type). Causes centric stretching.  
Example: PLC_PRG.iScaling.  
The reference point is the “Center” property.  
The value 1 shrinks the element by a factor of 0.001. The value 1000 returns the element to its original size. |
| “Interior rotation” | Variable (numeric data type). Defines the angle of rotation (in degrees).  
Example: PLC_PRG.iAngle2.  
In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.  
The rotation point is shown as the symbol.  
Note: If a static angle of rotation is specified in the property “Position ➔ Angle”, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed. |
| “Use REAL values” | Note: Only available if the device supports the use of REAL coordinates.  
- The properties of the absolute movement are interpreted as REAL values. The values are not rounded.  
The option allows for the individual fine-tuning of drawing the element, for example for the visualization of a smoother rotation.  
Hint: If a horizontal or vertical line is drawn blurry on a specific visualization platform, then this can be corrected by an offset of 0.5px in the direction of the line thickness. |
You can link the variables to a unit conversion.

The properties “X”, “Y”, “Rotation”, and “Interior rotation” are supported by the “Client Animation” functionality.

See also

Element property 'Relative movement'
The properties contain variables for moving the element. The reference point is the position of the element (“Position” property). The shape of the element can change.

```
<table>
<thead>
<tr>
<th>Movement point[0]</th>
<th>Variable (numeric data type). It contains the number (in pixels) that the starting point of the line is moved.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
<td>Incrementing the X value moves the element to the right.</td>
</tr>
<tr>
<td>“Y”</td>
<td>Incrementing the Y value moves the element to the down.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Movement point[1]</th>
<th>Variable (numeric data type). It contains the number (in pixels) that the end point of the line is moved.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
<td>Incrementing the X value moves the element to the right.</td>
</tr>
<tr>
<td>“Y”</td>
<td>Incrementing the Y value moves the element to the down.</td>
</tr>
</tbody>
</table>
```

See also

- “Element property ‘Absolute movement’” on page 3428

Element property 'Text variables'
These properties are variables with contents that replace a format definition.

```
<table>
<thead>
<tr>
<th>Text variable</th>
<th>Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: PLC_PRG.iAccesses</td>
<td></td>
</tr>
<tr>
<td>Note: The format definition is part of the text in the property “Texts ➔ Text”.</td>
<td></td>
</tr>
<tr>
<td>Note: If you specify a variable of type enumeration with text list support, then the name of the enumeration data type is added automatically in angle brackets after the variable name. Example: PLC_PRG.enVar &lt;enumeration name&gt;. Then the symbolic value of the enumeration component is printed instead of the numeric value when text is printed. Refer to the help page for the enumerations.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tooltip variable</th>
<th>Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: PLC_PRG.iAccessesInTooltip</td>
<td></td>
</tr>
<tr>
<td>Note: The format definition is part of the text in the property “Texts ➔ Tooltip”.</td>
<td></td>
</tr>
</tbody>
</table>
```

See also

- Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329
- “Element property ‘Texts’” on page 3428
- Chapter 6.4.1.20.5.18 “Enumerations” on page 2263
Dynamic texts are variably indexed texts of a text list. At runtime, the text is displayed that is currently indexed in the variable.

<table>
<thead>
<tr>
<th>Element property 'Dynamic texts'</th>
<th>Dynamic texts are variably indexed texts of a text list. At runtime, the text is displayed that is currently indexed in the variable.</th>
</tr>
</thead>
</table>
| "Text list" | Variable (string) or name of the text list as a fixed string in single straight quotation marks. Example: 'Errorlist'
  ‣: Drop-down list with the dialogs available in the text lists. |
| "Text index" | Text list ID. This refers to the desired output text.  
  ● As fixed string with the ID in single straight quotation marks. Example: '1'
  ● As a variable (STRING) for dynamically controlling the text output. Example: strTextID
  Sample assignment: PLC_PRG.strTextID := '1'; |
| "Tooltip index" | Text list ID. This refers to the desired output text.  
  ● As fixed string with the ID in single straight quotation marks. Example: '2'
  ● As a variable (STRING) for dynamically controlling the text output. Example: strToolTipID
  Sample assignment: PLC_PRG.strToolTipID := '2'; |

See also
- § Chapter 6.4.1.21.2.28 “Object 'Text List'” on page 2532

The variables allow for dynamic control of the text display.

<table>
<thead>
<tr>
<th>Element property 'Font variables'</th>
<th>The variables allow for dynamic control of the text display.</th>
</tr>
</thead>
</table>
| "Font name" | Variable (STRING). Includes the font of the text. Example: PLC_PRG.stFontVar := 'Arial'; 
The selection of fonts corresponds to the default "Font" dialog. |
| "Size" | Variable (numeric data type). Contains the font size (in pixels or points). The applied unit is specified in brackets after the variable name.  
  ● <pt>: Points (default) Example: PLC_PRG.iFontHeight <pt>  
  Code: iFontHeight : INT := 12;  
  ● <px>: Pixels Example: PLC_PRG.iFontHeight <px>  
  Code: iFontHeight : INT := 19; |

If you click in the value field, a drop-down list opens on the right for setting the unit.

Hint: The font size is specified in points (example: Arial 12). Use points when the variable font size should match a font, for example if a font is set in the property "Text property ➤ Font".
### “Flags”

Variable (DWORD). Contains the flags for displaying fonts.

**Flags:**
- 1: Italics
- 2: Bold
- 4: Underline
- 8: Strikethrough

Note: You can combine the font displays by adding the coding of the flags. For example, a bold and underlined text: PLC_PRG.dwFontType := 6;

### “Character set”

Variable (DWORD). Contains a character set number for the font.

The selection of character set numbers corresponds to the “Script” setting of the standard “Font” dialog.

### “Color”

Variable (DWORD). Includes the color of the text.

Example: PLC_PRG.dwColorFont:= 16#FF000000;

### “Flags for text alignment”

Variable (integer data type). Contains the coding for text alignment.

Example: PLC_PRG.dwTextAlignment.

**Coding:**
- 0: Top left
- 1: Horizontal center
- 2: Right
- 4: Vertical center
- 8: Bottom

Note: You can combine the text alignments by adding the coding of the flags. For example, a vertical and horizontal centered text: PLC_PRG.dwFontType := 5;

---

**Fixed values for displaying texts are set in “Text properties”.

See also
- § “Element property ‘Text properties’” on page 3428

**Element property ‘Color variables’**

The Element property is used as an interface for project variables to dynamically control colors at runtime.
**“Toggle color”**

The property controls the toggled color at runtime.

**Value assignment:**

- **FALSE**: The element is displayed with the color specified in the “Color” property.
- **TRUE**: The element is displayed with the color specified in the “Alarm color” property.

**Assigning the property:**

- Placeholder for the user input variable
  - `<toggle/tap variable>`
  - `<NOT toggle/tap variable>`

  The color change is not controlled by its own variable, but by a user input variable.

  Note: Specify a variable for the mouse events “Tap” or “Toggle” in the input configuration of the element. Only then is the placeholder set. If you configure a variable in both “Toggle” and “Tap”, then the variable specified in “Tap” is used.

  Hint: Click the symbol 💡 to insert the placeholder “<toggle/tap variable>”. When you activate the “Inputconfiguration”, “Tap FALSE” property, then the “<NOT toggle/tap variable>” placeholder is displayed.

- Instance path of a project variable (BOOL)
  Example: PLC_PRG.xColorIsToggeled

  Note: In the code, declare and implement the variable specified here. Its value assignment determines when the color changes.

**“Color”**

- Variable (DWORD) for the color
  Example: PLC_PRG.dwColor

- Color literal
  Example of gray and opaque: 16#FF888888

  Please note that the normal state is in effect if the expression in the “Colorvariables ➔ Toggle color” property is not defined or it has the value FALSE.

**“Alarm color”**

Color variable in the alarm state

- Variable (DWORD) for the alarm color
  Example: PLC_PRG.dwAlarmColor

- Color literal
  Example of red and opaque: 16#FFFF0000

  Please note that the alarm state is in effect if the expression in the “Colorvariables ➔ Toggle color” property has the value TRUE.

---

**The transparency part of the color value is evaluated only if the “Activate semi-transparent drawing” option of the visualization manager is selected.**

**Select the “Advanced” option in the toolbar of the properties view. Then all element properties are visible.**

---

See also

- % Chapter 6.4.5.10.4 “Animating a color display” on page 2914
- % Chapter 6.4.5.21.4.2 “Object ‘Visualization manager’” on page 3398
Element property 'State variables'

The variables control the element behavior dynamically.

|“Invisible”| Variable (BOOL). Toggles the visibility of the element.
| TRUE: The element is not visible at runtime.
| Example: bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR |

|“Deactivate inputs”| Variable (BOOL). Toggles the operability of the element.
| TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated. |

The “Invisible” property is supported by the "Client Animation" functionality.

Element property 'Line width variable'

Dynamic definition of the weight of a line element using a variable.

|“Integer value”| Variable (integer data type). Defines the line weight of the element (in pixels).
| This overwrites the fixed value that is defined in “Appearance ➔ Line weight”.
| Note: The value 0 codes the same as 1 and sets the line weight to one pixel. |

Element property 'Line style variable'

|“Integer value”| Variable (integer data type). Defines the appearance of the line at runtime.
| ● 1: Solid
| ● 2: Dashes
| ● 3: Dots
| ● 4: Dash Dot
| ● 5: Dash Dot Dot
| ● 6: Invisible: The line is not drawn. |

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
**“Animation duration”**

Defines the duration (in milliseconds) in which the element runs an animation

- **Variable (integer value)**
  
  Example: `Menu.tContent with VAR tContent : INT := 500; END_VAR`

- **Integer literal**
  
  Example: `500`

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**“Move to foreground”**

Moves the visualization element to the foreground

Variable (`BOOL`)

Example: `bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR`

**TRUE:** At runtime, the visualization element is displayed in the foreground.

**FALSE:** At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

<table>
<thead>
<tr>
<th>Element property 'Input configuration'</th>
<th>The properties contain the configurations for the user input when using the mouse or keyboard. A user input defines an event and one or more actions that are executed when an event occurs.</th>
</tr>
</thead>
<tbody>
<tr>
<td>The “Configure” button opens the “Input Configuration” dialog. There you can create or edit user inputs. Configured user inputs are listed below the events. They each include the action that is triggered and the setting in short form.</td>
<td>Example: “Execute ST Code”: $PLC_PRG.i_x := 0;”</td>
</tr>
<tr>
<td>“OnDialogClosed” Input event: The user closes the dialog.</td>
<td></td>
</tr>
<tr>
<td>“OnMouseClick” Input event: The user clicks the mouse button completely in the element area. The mouse button is clicked and released.</td>
<td></td>
</tr>
<tr>
<td>“OnMouseDown” Input event: The user clicks down on the mouse button.</td>
<td></td>
</tr>
<tr>
<td>“OnMouseEnter” Input event: The user drags the mouse pointer to the element.</td>
<td></td>
</tr>
<tr>
<td>“OnMouseLeave” Input event: The user drags the mouse pointer away from the element.</td>
<td></td>
</tr>
<tr>
<td>Event</td>
<td>Input event</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>OnMouseMove</strong></td>
<td>The user moves the mouse pointer over the element area.</td>
</tr>
</tbody>
</table>
**“Hotkey”**
Keyboard shortcut on the element for triggering specific input actions.
When the keyboard shortcut event occurs, the input actions in the “Events” property are triggered. In this way, it is not the input action itself that leads to this input action, but the mouse input action.

**“Key”**
Key pressed for input action.
Example: [T]
Note: The following properties appear when a key is selected.

**“Events”**
- “None”
- “Mouse down”: Pressing the key triggers the input actions that are configured in the “OnMouseDown” property.
- “Mouse up”: Releasing the key triggers the input actions that are configured in the “OnMouseUp” property.
- “Mouse down/up”: Pressing and releasing the key triggers the input actions that are configured in the “OnMouseDown” property and the “OnMouseUp” property.

**“Shift”**
☑: Combination with the Shift key
Example: [Shift]+[T].

**“Control”**
☑: Combination with the Ctrl key
Example: [Ctrl]+[T].

**“Alt”**
☑: Combination with the Alt key
Example: [Alt]+[T].

![Accessibility note]
All keyboard shortcuts and their actions that are configured in the visualization are listed on the “Keyboard Configuration” tab.

See also
- § Chapter 6.4.5.21.2.2 “Command ‘Keyboard Configuration’” on page 3341
- § Chapter 6.4.5.21.3.6 “Dialog ‘Input Configuration’” on page 3370

**Element property ‘Access rights’**
Requirement: User management is set up for the visualization.

**“Access rights”**
Opens the “Access rights” dialog. There you can edit the access privileges for the element.
Status messages:
- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also
- § Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

See also
- § Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

**Visualization Element 'Polygon', 'Polyline', 'Bézier Curve'**
Symbol:
Category: “Basic”

The “Polygon”, “Polyline”, and “Bézier Curve” are the same element type. They can be converted into another type by changing the “Element type” property.

Elements can be dragged to the editor. The element is then drawn with five points: [0] to [4].

Other positions are added as follows: Move the mouse pointer over a corner point; the mouse pointer changes shape. Now if you press and hold [Ctrl] and click the left mouse button, another point is created. You can delete a point by pressing and holding [Shift]+[Ctrl] and click the selected point.

As an alternative, you can select the element in the toolbox area and in the editor click multiple times. At the same time, a connecting line is drawn from one point to the other. End by double-clicking the element or right-clicking it one time.

**Element properties**

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Optional.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
<tr>
<td>Example: Werkstück_1</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Type of element”</th>
<th>● “Polygon”</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>● “Polyline”</td>
</tr>
<tr>
<td></td>
<td>● “Bézier Curve”</td>
</tr>
</tbody>
</table>

**Element property 'Position'**
The following properties define the position of the corner points in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.
"Dots" [0..[n]: Coordinates of the corner points
Specified in pixels
You can also change the values by dragging the box symbols (מהלך) to other positions in the editor.

"Angle" Static angle of rotation (in degrees).
Example: 35
The element is displayed rotated in the editor. The point of rotation is the center of the element. A positive value rotates clockwise.
Tip: You can change the value in the editor by focusing the element to the handle. When the cursor is displayed as a rotating arrow (ניירון), you can rotate the element about its center as a handle.

(1): Handle
Note: If a dynamic angle of rotation is also configured in the property "Absolute movement ➔ Internal rotation", then the static and dynamic angles of rotation are added in runtime mode. The static angle of rotation acts as an offset.

See also
• ° Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

Element property 'Center'
The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the ◇ symbol. The point is used as the center for rotating and scaling.

"X" X-coordinate of the point of rotation
"Y" Y-coordinate of the point of rotation
You can also change the values by dragging the symbols (מהלך) to other positions in the editor.

Element property 'Colors'

"Normal state" The normal state is in effect if the variable in "Color variables ➔ Toggle color" is not defined or it has the value FALSE.

"Frame color" Frame and fill color for the corresponding state of the variable.

"Fill color"

"Transparency" Transparency value (0 to 255) for defining the transparency of the selected color.
Example: 255: The color is opaque. 0: The color is completely transparent.

"Alarm state" The alarm state is in effect if the variable in "Color variables ➔ Toggle color" has the value TRUE.
"Use gradient color" The element is displayed with a gradient of two colors.

"Gradient setting" The "Gradient editor" dialog box opens.

See also
- Chapter 6.4.5.21.3.5 “Dialog ‘Gradient Editor’” on page 3369

Element property 'Appearance'
The properties contain fixed values for setting the look of the element.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Line width&quot;</td>
<td>Value in pixels&lt;br&gt;Example: 2&lt;br&gt;Note: The values 0 and 1 both result in a line weight of 1 pixel. If no line should be displayed, then the &quot;Line style&quot; property must be set to the option &quot;Invisible&quot;.</td>
</tr>
<tr>
<td>&quot;Fill attributes&quot;</td>
<td>The way in which the element is filled.&lt;br&gt;• &quot;Filled&quot;: The element is filled with the color from property &quot;Colors ➔ Fill color&quot;.&lt;br&gt;• &quot;Invisible&quot;: The fill color is invisible.</td>
</tr>
<tr>
<td>&quot;Line style&quot;</td>
<td>Type of line representation&lt;br&gt;• &quot;Solid&quot;&lt;br&gt;• &quot;Dashes&quot;&lt;br&gt;• &quot;Dots&quot;&lt;br&gt;• &quot;Dash Dot&quot;&lt;br&gt;• &quot;Dash Dot Dot&quot;&lt;br&gt;• &quot;not visible&quot;</td>
</tr>
</tbody>
</table>

You can assign variables in the "Appearance variables" property for controlling the appearance dynamically. The fixed values here are overwritten.

See also
- "Element property 'Appearance variables'” on page 3476

Element property 'Texts'
The properties contain character strings for labeling the element. The character string can also contain a placeholder with a format definition. In runtime mode, the placeholder is replaced by the current value in the specified format.
CODESYS accepts the specified texts automatically into the "GlobalTextList" text list. Therefore, these texts can be localized.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Text&quot;</td>
<td>Character string (without single straight quotation marks) for the labeling the element. Add a line break by pressing the keyboard shortcut [Ctrl] + [Enter].&lt;br&gt;Example: Accesses: %i&lt;br&gt;The variable that contains the current value for the placeholder is specified in the property “Text variable ➔ Text&quot;.</td>
</tr>
</tbody>
</table>
| "Tooltip"  | Character string (without single straight quotation marks) that is displayed as the tooltip of an element.<br>Example: Number of valid accesses.<br>The variable that contains the current value for the placeholder is specified in the property “Text variable ➔ Tooltip".
The properties contain fixed values for the text properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Horizontal alignment”</strong></td>
<td>Horizontal alignment of the text within the element.</td>
</tr>
<tr>
<td><strong>“Vertical alignment”</strong></td>
<td>Vertical alignment of the text within the element.</td>
</tr>
<tr>
<td><strong>“Text format”</strong></td>
<td>Definition for displaying texts that are too long</td>
</tr>
<tr>
<td></td>
<td>- “Default”: The long text is truncated.</td>
</tr>
<tr>
<td></td>
<td>- “Line break”: The text is split into parts.</td>
</tr>
<tr>
<td></td>
<td>- “Ellipsis”: The visible text ends with &quot;...&quot; indicating that it is not complete.</td>
</tr>
<tr>
<td><strong>“Font”</strong></td>
<td>Example: “Default”</td>
</tr>
<tr>
<td></td>
<td>- The “Font” dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>- ▼: Drop-down list with style fonts.</td>
</tr>
<tr>
<td><strong>“Font color”</strong></td>
<td>Example: “Black”</td>
</tr>
<tr>
<td></td>
<td>- The “Color” dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>- ▼: Drop-down list with style colors.</td>
</tr>
<tr>
<td><strong>“Transparency”</strong></td>
<td>Whole number (value range from 0 to 255). This determines the transparency of the respective color.</td>
</tr>
<tr>
<td></td>
<td>Example: 255: The color is opaque.</td>
</tr>
<tr>
<td></td>
<td>0: The color is completely transparent.</td>
</tr>
<tr>
<td></td>
<td>Please note: If the color is a style color and already has a transparency value, then this property is write-protected.</td>
</tr>
</tbody>
</table>

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Movement”</strong></td>
<td></td>
</tr>
<tr>
<td><strong>“X”</strong></td>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iPos_X.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td><strong>“Y”</strong></td>
<td>Variable (numeric data type). Defines the Y position (in pixels).</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iPos_Y.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
</tr>
</tbody>
</table>
### “Rotation”

Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** PLC_PRG.iAngle1.

The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.

In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

### “Scaling”

Variable (integer data type). Causes centric stretching.

**Example:** PLC_PRG.iScaling.

The reference point is the “Center” property.

The value 1 shrinks the element by a factor of 0.001. The value 1000 returns the element to its original size.

### “Interior rotation”

Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the property “Position ➔ Angle”, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

### “Use REAL values”

Note: Only available if the device supports the use of REAL coordinates.

- The properties of the absolute movement are interpreted as REAL values. The values are not rounded.

The option allows for the individual fine-tuning of drawing the element, for example for the visualization of a smoother rotation.

Hint: If a horizontal or vertical line is drawn blurry on a specific visualization platform, then this can be corrected by an offset of 0.5px in the direction of the line thickness.

---

You can link the variables to a unit conversion.
The properties “X”, “Y”, “Rotation”, and “Interior rotation” are supported by the “Client Animation” functionality.

See also

Element property 'Dynamic points'

| “Array of points” | Variable (POINTER TO). Points to an array of the structure VisuElems.VisuStructPoint. The elements iX and iY of VisuStructPoint contain the xy-coordinates of a point. The current number of array elements implicitly contains the variable in the property “Number of points”. The variable that is assigned to the property “Number of points” contains the number of array elements and therefore the number of corner points.
Example: pPoints : POINTER TO ARRAY[0..100] OF VisuElems.VisuStructPoint; |

| “Number of points” | Variable (integer data type): Contains the number of array elements and therefore the number of corner points for displaying the element. Example: PLC_PRG.iNumberOfPoints := 24;
In the example, the element has 24 points. This definition is necessary because the individual points are defined by a pointer and this does not allow control over the number of points.
Note: In this way, it is possible to adapt the display of the element dynamically by updating the number of corner points. |

Element property 'Text variables'

| “Text variable” | Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.
Example: PLC_PRG.iAccesses
Note: The format definition is part of the text in the property “Texts ➔ Text”.
Note: If you specify a variable of type enumeration with text list support, then the name of the enumeration data type is added automatically in angle brackets after the variable name. Example: PLC_PRG.enVar <enumeration name>. Then the symbolic value of the enumeration component is printed instead of the numeric value when text is printed. Refer to the help page for the enumerations. |

| “Tooltip variable” | Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.
Example: PLC_PRG.iAccessesInTooltip
Note: The format definition is part of the text in the property “Texts ➔ Tooltip”. |

See also

- Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329
- “Element property ‘Texts’” on page 3440
- Chapter 6.4.1.20.5.18 “Enumerations” on page 2263
Element property 'Dynamic texts'

Dynamic texts are variably indexed texts of a text list. At runtime, the text is displayed that is currently indexed in the variable.

<table>
<thead>
<tr>
<th>Text list</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable (string) or name of the text list as a fixed string in single straight quotation marks.</td>
</tr>
<tr>
<td>Drop-down list with the dialogs available in the text lists.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Text index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text list ID. This refers to the desired output text.</td>
</tr>
<tr>
<td>As fixed string with the ID in single straight quotation marks.</td>
</tr>
<tr>
<td>As a variable (STRING) for dynamically controlling the text output.</td>
</tr>
<tr>
<td>Sample assignment: PLC_PRG.strTextID := '1';</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tooltip index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text list ID. This refers to the desired output text.</td>
</tr>
<tr>
<td>As fixed string with the ID in single straight quotation marks.</td>
</tr>
<tr>
<td>As a variable (STRING) for dynamically controlling the text output.</td>
</tr>
<tr>
<td>Sample assignment: PLC_PRG.strToolTipID := '2';</td>
</tr>
</tbody>
</table>

See also

- § Chapter 6.4.1.21.2.28 “Object 'Text List'” on page 2532

Element property 'Font variables'

The variables allow for dynamic control of the text display.

<table>
<thead>
<tr>
<th>Font name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable (STRING). Includes the font of the text.</td>
</tr>
<tr>
<td>Example: PLC_PRG.stFontVar := 'Arial';</td>
</tr>
<tr>
<td>The selection of fonts corresponds to the default “Font” dialog.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable (numeric data type). Contains the font size (in pixels or points). The applied unit is specified in brackets after the variable name.</td>
</tr>
<tr>
<td>&lt;pt&gt;: Points (default)</td>
</tr>
<tr>
<td>Example: PLC_PRG.iFontHeight &lt;pt&gt;</td>
</tr>
<tr>
<td>Code: iFontHeight : INT := 12;</td>
</tr>
<tr>
<td>&lt;px&gt;: Pixels</td>
</tr>
<tr>
<td>Example: PLC_PRG.iFontHeight &lt;px&gt;</td>
</tr>
<tr>
<td>Code: iFontHeight : INT := 19;</td>
</tr>
</tbody>
</table>

If you click in the value field, a drop-down list opens on the right for setting the unit.

Hint: The font size is specified in points (example: Arial 12). Use points when the variable font size should match a font, for example if a font is set in the property “Text property ➔ Font”.
"Flags" Variable (DWORD). Contains the flags for displaying fonts.

Flags:
- 1: Italics
- 2: Bold
- 4: Underline
- 8: Strikethrough

Note: You can combine the font displays by adding the coding of the flags. For example, a bold and underlined text: PLC_PRG.dwFontType := 6;

"Character set" Variable (DWORD). Contains a character set number for the font.

The selection of character set numbers corresponds to the “Script” setting of the standard “Font” dialog.

"Color" Variable (DWORD). Includes the color of the text.

Example: PLC_PRG.dwColorFont := 16#FF000000;

"Flags for text alignment" Variable (integer data type). Contains the coding for text alignment.

Coding:
- 0: Top left
- 1: Horizontal center
- 2: Right
- 4: Vertical center
- 8: Bottom

Note: You can combine the text alignments by adding the coding of the flags. For example, a vertical and horizontal centered text: PLC_PRG.dwFontType := 5;

Fixed values for displaying texts are set in "Text properties".

See also
- § “Element property 'Text properties'” on page 3441

Element property 'Color variables'

The Element property is used as an interface for project variables to dynamically control colors at runtime.
"Toggle color"  
The property controls the toggled color at runtime.
Value assignment:
- **FALSE**: The element is displayed with the color specified in the "Color" property.
- **TRUE**: The element is displayed with the color specified in the "Alarm color" property.
Assignment options:
- Placeholder for the user input variable
  - "<toggle/tap variable>"
  - "<NOT toggle/tap variable>"
  The color change is not controlled by its own variable, but by a user input variable.
  Note: Specify a variable for the mouse events "Tap" or "Toggle" in the input configuration of the element. Only then is the placeholder set. If you configure a variable in both "Toggle" and "Tap", then the variable specified in "Tap" is used.
  Hint: Click the symbol to insert the placeholder "<toggle/tap variable>". When you activate the "Inputconfiguration", "Tap FALSE" property, then the "<NOT toggle/tap variable>" placeholder is displayed.
- Instance path of a project variable (BOOL)
  Example: PLC_PRG.xColorIsToggeled
  Note: In the code, declare and implement the variable specified here. Its value assignment determines when the color changes.

"Normal state"  "Alarm state"
The properties listed below control the color depending on the state. The normal state is in effect if the variable in "Color variables", "Toggle color" is not defined or it has the value FALSE. The alarm state is in effect if the variable in "Colorvariables", "Toggle color" has the value TRUE.

"Frame color"  Assignment options:
- Variable (DWORD) for the frame color
  Example: PLC_PRG.dwBorderColor
- Color literal
  Example of green and opaque: 16#FF00FF00

"Filling color"  Assignment options:
- Variable (DWORD) for the fill color
  Example: PLC_PRG.dwFillColor
- Color literal
  Example of gray and opaque: 16#FF888888

The transparency part of the color value is evaluated only if the "Activate semi-transparent drawing" option of the visualization manager is selected.

Select the "Advanced" option in the toolbar of the properties view. Then all element properties are visible.

See also
- Chapter 6.4.5.10.4 “Animating a color display” on page 2914
The properties contain IEC variables for controlling the appearance of the element dynamically.

<table>
<thead>
<tr>
<th><strong>Line width</strong></th>
<th>Variable (integer data type). Contains the line weight (in pixels).</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fill attributes</strong></td>
<td>Variable (DWORD). Controls whether the fill color of the element is visible.</td>
</tr>
<tr>
<td>● Variable value = 0: Filled</td>
<td></td>
</tr>
<tr>
<td>● Variable value &gt; 0: Invisible; no fill color</td>
<td></td>
</tr>
<tr>
<td><strong>Line style</strong></td>
<td>Variable (DWORD). Controls the line style.</td>
</tr>
<tr>
<td>Coding:</td>
<td></td>
</tr>
<tr>
<td>● 0: Solid line</td>
<td></td>
</tr>
<tr>
<td>● 1: Dashed line</td>
<td></td>
</tr>
<tr>
<td>● 2: Dotted line</td>
<td></td>
</tr>
<tr>
<td>● 3: Line type &quot;Dash Dot&quot;</td>
<td></td>
</tr>
<tr>
<td>● 3: Line type &quot;Dash Dot Dot&quot;</td>
<td></td>
</tr>
<tr>
<td>● 8: Invisible; no line</td>
<td></td>
</tr>
</tbody>
</table>

Fixed values can be set in the "Appearance" property. These values can be overwritten by dynamic variables at runtime.

See also
● "Element property 'Appearance'" on page 3468

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th><strong>Invisible</strong></th>
<th>Variable (BOOL). Toggles the visibility of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRUE: The element is not visible at runtime.</td>
<td></td>
</tr>
<tr>
<td>Example: bIsVisible with VAR bIsVisible := BOOL := FALSE; END_VAR</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Deactivate inputs</strong></th>
<th>Variable (BOOL). Toggles the operability of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.</td>
<td></td>
</tr>
</tbody>
</table>

The "Invisible" property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the "Support client animations and overlay of native elements" option in the Visualization Manager.
"Animation duration" | Defines the duration (in milliseconds) in which the element runs an animation
| - Variable (integer value)
|   Example: Menu.tContent with VAR tContent : INT := 500; END_VAR
| - Integer literal
|   Example: 500

Animatable properties
- "Absolute movement", "Movement", "X", "Y"
- "Absolute movement", "Rotation"
- "Absolute movement", "Interior rotation"
- "Absolute movement", "Exterior rotation"

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

"Move to foreground" | Moves the visualization element to the foreground
| Variable (BOOL)
| Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR

TRUE: At runtime, the visualization element is displayed in the foreground.
FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

Element property 'Input configuration' | The properties contain the configurations for the user input when using the mouse or keyboard. A user input defines an event and one or more actions that are executed when an event occurs.

The "Configure" button opens the "Input Configuration" dialog. There you can create or edit user inputs. Configured user inputs are listed below the events. They each include the action that is triggered and the setting in short form.

Example: "Execute ST Code":

```plaintext
PLC_PRG.i_x := 0;
```

"OnDialogClosed" | Input event: The user closes the dialog.

"OnMouseClicked" | Input event: The user clicks the mouse button completely in the element area. The mouse button is clicked and released.

"OnMouseDown" | Input event: The user clicks down on the mouse button.

"OnMouseEnter" | Input event: The user drags the mouse pointer to the element.

"OnMouseLeave" | Input event: The user drags the mouse pointer away from the element.
<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“OnMouseMove”</strong></td>
<td>Input event: The user moves the mouse pointer over the element area.</td>
</tr>
</tbody>
</table>
| **“OnMouseUp”**  | Input events:  
  - The user releases the mouse button within the element area. It is irrelevant whether the user has previously pressed the mouse button inside or outside the element area.  
  - The user presses the mouse button within the element area, leaves the element area, and then releases the mouse button.  
Note: This CODESYS-specific triggering behavior guarantees that actions for key elements are completed. A key element starts an action for “OnMouseDown” and ends the action for “OnMouseUp”.  
Example: A visualization user presses the mouse button within the element area of the key element and then moves the cursor position so that it lies outside the element area. The action is ended anyway because “OnMouseUp” is triggered. |

| **“Tap”** | When a mouse click event occurs, the variable defined in “Variable” is described in the application. The coding depends on the “Tap FALSE” and “Tap on enter if captured” options. |
| **Variable** | Variable (BOOL) that is set on mouse click event.  
Example: FLC_PRG.bIsTapped  
TRUE: A mouse click event exists. It lasts as long as the user presses the mouse button over the element. It ends when the button is released.  
FALSE: A mouse click event does not exist.  
Requirement: The “Tap FALSE” option is not activated. |

| **“Tap FALSE”** | ❑: The mouse click event leads to a complementary value in “Variable”.  
TRUE: A mouse click event does not exist.  
FALSE: While the mouse click event exists. |

| **“Tap on enter if captured”** | ❑: During user input, it is also taken into consideration whether the mouse pointer is dragged within the element area or not while the mouse button is pressed.  
TRUE: While the mouse click event exists and the mouse pointer is moved over the element area.  
FALSE: A mouse click event does not exist. Or the user moves the mouse pointer outside of the element area while the mouse button is pressed.  
The value is TRUE again as soon as the user moves the pointer back to the element area. The mouse is then captured. |

| **“Toggle”** | With the onset of a mouse click event, the variable is set; when the mouse click event is completed, the variable is reset. |
| **Variable** | Variable (BOOL). Its value toggled when the mouse click event is ended. This is when the user releases the mouse button while the mouse pointer is over the element area.  
If the user releases the mouse button while the mouse pointer is outside of the element area, then the mouse click event is not ended and the value is not toggled.  
Hint: The user can cancel a started toggle input by dragging the mouse pointer out of the element area. |

| **“Toggle on up if captured”** | ❑: The value toggles regardless of where the mouse pointer is when the mouse button is released. The mouse is then captured. |
**“Hotkey”**
Keyboard shortcut on the element for triggering specific input actions. When the keyboard shortcut event occurs, the input actions in the “Events” property are triggered. In this way, it is not the input action itself that leads to this input action, but the mouse input action.

**“Key”**
Key pressed for input action.
Example: [T]
Note: The following properties appear when a key is selected.

**“Events”**
- “None”
- “Mouse down”: Pressing the key triggers the input actions that are configured in the “OnMouseDown” property.
- “Mouse up”: Releasing the key triggers the input actions that are configured in the “OnMouseUp” property.
- “Mouse down/up”: Pressing and releasing the key triggers the input actions that are configured in the “OnMouseDown” property and the “OnMouseUp” property.

**“Shift”**
☑: Combination with the Shift key
Example: [Shift]+[T].

**“Control”**
☑: Combination with the Ctrl key
Example: [Ctrl]+[T].

**“Alt”**
☑: Combination with the Alt key
Example: [Alt]+[T].

All keyboard shortcuts and their actions that are configured in the visualization are listed on the “Keyboard Configuration” tab.

See also
- § Chapter 6.4.5.21.2.2 “Command ‘Keyboard Configuration’” on page 3341
- § Chapter 6.4.5.21.3.6 “Dialog ‘Input Configuration’” on page 3370

**Element property ‘Access rights’**
Requirement: User management is set up for the visualization.

**“Access rights”**
Opens the “Access rights” dialog. There you can edit the access privileges for the element.
Status messages:
- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also
- § Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

See also
- § Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

**Visualization Element ‘Pie’**
Symbol:
Category: “Basic”
The element draws a pie of any angle.

**Element properties**

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: Error_rate_part_1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Type of element”</th>
<th>“Pie”</th>
</tr>
</thead>
</table>

**Element property ‘Position’**
The position defines the location and size of the element in the visualization window. This is based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

| “X” | The x-coordinate of the upper left corner of the element  
|  | Specified in pixels  
|  | Example: 10 |

| “Y” | The y-coordinate of the upper left corner of the element  
|  | Specified in pixels  
|  | Example: 10 |

| “Width” | Specified in pixels  
|  | Example: 150 |

| “Height” | Specified in pixels  
|  | Example: 30 |

Tip: You can change the values in “X”, “Y”, “Width”, and “Height” by dragging the corresponding symbols to another position in the editor.
**“Angle”**

Static angle of rotation (in degrees).

**Example:** 35

The element is displayed rotated in the editor. The point of rotation is the center of the element. A positive value rotates clockwise.

Tip: You can change the value in the editor by focusing the element to the handle. When the cursor is displayed as a rotating arrow ((rotation icon), you can rotate the element about its center as a handle.

(1): Handle

Note: If a dynamic angle of rotation is also configured in the property "Absolute movement ➔ Internal rotation", then the static and dynamic angles of rotation are added in runtime mode. The static angle of rotation acts as an offset.

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

**“Begin”**

Start angle of the pie. If you also define a variable for the start, then the start angle is calculated from the sum of the values for “Begin” and “Variable for begin”.

**Example:**

- “Begin”: 330
- “End”: 90

**“End”**

End angle of the pie. If you also define a variable for the end, then the end angle is calculated from the sum of the values for “End” and “Variable for end”.

The pie is drawn clockwise from the start angle to the end angle.

**“Variable for begin”**

The start of the sector is defined dynamically by a variable.

**“Variable for end”**

The end of the sector is defined dynamically by a variable.

**“Only show circle line”**

☑: The pie is drawn without the radius line or filling color.

---

**Element property ‘Center’**
"X" Display of the center coordinates. You cannot modify these values here in the properties.

"Y" If the Pie is selected in the editor, then the center of the Pie (as well as the center of the enveloping box) is visualized with the symbol . Moreover, the element is decorated with a position, begin, and end boxes that you can move.

The center coordinates change when you move the center symbol in the editor. This also changes the size of the Pie so that the position box retains its position and the center remains in the middle of the element.

Element property 'Colors'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Normal state&quot;</td>
<td>The normal state is in effect if the variable in &quot;Color variables \rightarrow Toggle color&quot; is not defined or it has the value FALSE.</td>
</tr>
<tr>
<td>&quot;Frame color&quot;</td>
<td>Frame and fill color for the corresponding state of the variable.</td>
</tr>
<tr>
<td>&quot;Fill color&quot;</td>
<td>Transparency value (0 to 255) for defining the transparency of the selected color. Example: 255: The color is opaque. 0: The color is completely transparent.</td>
</tr>
<tr>
<td>&quot;Alarm state&quot;</td>
<td>The alarm state is in effect if the variable in &quot;Color variables \rightarrow Toggle color&quot; has the value TRUE.</td>
</tr>
<tr>
<td>&quot;Use gradient color&quot;</td>
<td>☑: The element is displayed with a gradient of two colors.</td>
</tr>
<tr>
<td>&quot;Gradient setting&quot;</td>
<td>The &quot;Gradient editor&quot; dialog box opens.</td>
</tr>
</tbody>
</table>

See also
- Chapter 6.4.5.21.3.5 "Dialog 'Gradient Editor'" on page 3369

Element property 'Appearance' The properties contain fixed values for setting the look of the element.
"Line width" Value in pixels
Example: 2
Note: The values 0 and 1 both result in a line weight of 1 pixel. If no line should
be displayed, then the “Line style” property must be set to the option “Invisible”.

"Fill attributes" The way in which the element is filled.
● “Filled”: The element is filled with the color from property “Colors ➔ Fill color”.
● “Invisible”: The fill color is invisible.

"Line style" Type of line representation
● “Solid”
● “Dashes”
● “Dots”
● “Dash Dot”
● “Dash Dot Dot”
● “not visible”

You can assign variables in the “Appearance variables” property for controlling
the appearance dynamically. The fixed values here are overwritten.

See also
● § “Element property ‘Appearance variables’” on page 3476

Element property 'Texts'
The properties contains character strings for labeling the element. The character string can also
contain a placeholder with a format definition. In runtime mode, the placeholder is replaced by
the current value in the specified format.

CODESYS accepts the specified texts automatically into the “GlobalTextList” text list. Therefore,
these texts can be localized.

"Text" Character string (without single straight quotation marks) for the labeling the
element. Add a line break by pressing the keyboard shortcut [Ctrl] + [Enter].
Example: Accesses: %i
The variable that contains the current value for the placeholder is specified in the
property “Text variable ➔ Text”.

"Tooltip" Character string (without single straight quotation marks) that is displayed as the
tooltip of an element.
Example: Number of valid accesses.
The variable that contains the current value for the placeholder is specified in the
property “Text variable ➔ Tooltip”.

See also
● § “Element property ‘Text variables’” on page 3456
● § Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
● § Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329

Element property 'Text properties'
The properties contain fixed values for the text properties.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Horizontal alignment</td>
<td>Horizontal alignment of the text within the element.</td>
</tr>
<tr>
<td>Vertical alignment</td>
<td>Vertical alignment of the text within the element.</td>
</tr>
</tbody>
</table>
| Text format         | Definition for displaying texts that are too long  
|                     |   • "Default": The long text is truncated.  
|                     |   • "Line break": The text is split into parts.  
|                     |   • "Ellipsis": The visible text ends with "..." indicating that it is not complete. |
| Font                | Example: “Default”  
|                     |   The “Font” dialog box opens.  
|                     |   ▼: Drop-down list with style fonts. |
| Font color          | Example: “Black”  
|                     |   The “Color” dialog box opens.  
|                     |   ▼: Drop-down list with style colors. |
| Transparency        | Whole number (value range from 0 to 255). This determines the transparency of the respective color.  
|                     | Example: 255: The color is opaque.  
|                     | 0: The color is completely transparent.  
|                     | Please note: If the color is a style color and already has a transparency value, then this property is write-protected. |

**Element property 'Absolute movement'**  
The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Movement</td>
<td></td>
</tr>
</tbody>
</table>
| X              | Variable (integer data type). Defines the X position (in pixels).  
|                |   Example: PLC_PRG.iPos_X.  
|                |   Increasing this value in runtime mode moves the element to the right. |
| Y              | Variable (integer data type). Defines the Y position (in pixels).  
|                |   Example: PLC_PRG.iPos_Y.  
|                |   Increasing this value in runtime mode moves the element downwards. |
| Scaling        | Variable (integer data type). Causes centric stretching.  
|                |   Example: PLC_PRG.iScaling.  
|                |   The reference point is the “Center” property.  
|                |   The value 1 shrinks the element by a factor of 0.001. The value 1000 returns the element to its original size. |
“Interior rotation”

Variable (integer data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

If a static angle of rotation is specified in “Position ➔ Angle”, then the static angle of rotation and the angle of rotation are added.

You can link the variables to a unit conversion.

The “X”, “Y”, and “Interior rotation” properties are supported by the "Client Animation" functionality.

See also

- Ä Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329
- Ä “Element property 'Texts'” on page 3454
- Ä Chapter 6.4.1.20.5.18 “Enumerations” on page 2263
**Element property 'Dynamic texts'**

Dynamic texts are variably indexed texts of a text list. At runtime, the text is displayed that is currently indexed in the variable.

| **"Text list"** | Variable (string) or name of the text list as a fixed string in single straight quotation marks.  
Example: 'Errorlist'  
▼: Drop-down list with the dialogs available in the text lists. |
| **"Text index"** | Text list ID. This refers to the desired output text.  
• As fixed string with the ID in single straight quotation marks.  
  Example: '1'  
• As a variable (STRING) for dynamically controlling the text output.  
  Example: strTextID  
  Sample assignment: PLC_PRG.strTextID := '1'; |
| **"Tooltip index"** | Text list ID. This refers to the desired output text.  
• As fixed string with the ID in single straight quotation marks.  
  Example: '2'  
• As a variable (STRING) for dynamically controlling the text output.  
  Example: strToolTipID  
  Sample assignment: PLC_PRG.strToolTipID := '2'; |

See also

- § Chapter 6.4.1.21.2.28 “Object 'Text List'” on page 2532

**Element property 'Font variables'**

The variables allow for dynamic control of the text display.

| **"Font name"** | Variable (STRING). Includes the font of the text.  
Example: PLC_PRG.stFontVar := 'Arial';  
The selection of fonts corresponds to the default "Font" dialog. |
| **"Size"** | Variable (numeric data type). Contains the font size (in pixels or points). The applied unit is specified in brackets after the variable name.  
• <pt>: Points (default)  
  Example: PLC_PRG.iFontHeight <pt>  
  Code: iFontHeight : INT := 12;  
• <px>: Pixels  
  Example: PLC_PRG.iFontHeight <px>  
  Code: iFontHeight : INT := 19;  

If you click in the value field, a drop-down list opens on the right for setting the unit.

Hint: The font size is specified in points (example: Arial 12). Use points when the variable font size should match a font, for example if a font is set in the property "Text property ➤ Font".
### Flags

Variable (DWORD). Contains the flags for displaying fonts.

**Flags:**
- 1: Italics
- 2: Bold
- 4: Underline
- 8: Strikethrough

Note: You can combine the font displays by adding the coding of the flags. For example, a bold and underlined text: `PLC_PRG.dwFontType := 6;`

### Character set

Variable (DWORD). Contains a character set number for the font.

The selection of character set numbers corresponds to the “Script” setting of the standard “Font” dialog.

### Color

Variable (DWORD). Includes the color of the text.

Example: `PLC_PRG.dwColorFont := 16#FF000000;`

### Flags for text alignment

Variable (integer data type). Contains the coding for text alignment.

**Example:** `PLC_PRG.dwTextAlignment.`

**Coding:**
- 0: Top left
- 1: Horizontal center
- 2: Right
- 4: Vertical center
- 8: Bottom

Note: You can combine the text alignments by adding the coding of the flags. For example, a vertical and horizontal centered text: `PLC_PRG.dwFontType := 5;`
### Toggle color

The property controls the toggled color at runtime.

**Value assignment:**
- **FALSE**: The element is displayed with the color specified in the “Color” property.
- **TRUE**: The element is displayed with the color specified in the “Alarm color” property.

**Assignment options:**
- Placeholder for the user input variable
  - `<toggle/tap variable>`
  - `<NOT toggle/tap variable>`

  The color change is not controlled by its own variable, but by a user input variable.

  **Note:** Specify a variable for the mouse events “Tap” or “Toggle” in the input configuration of the element. Only then is the placeholder set. If you configure a variable in both “Toggle” and “Tap”, then the variable specified in “Tap” is used.

  **Hint:** Click the symbol 🚧 to insert the placeholder `<toggle/tap variable>“`. When you activate the “Input configuration” “Tap FALSE” property, then the `<NOT toggle/tap variable>“` placeholder is displayed.

  - Instance path of a project variable (BOOL)
    
    **Example:** PLC_PRG.xColorIsToggled

    **Note:** In the code, declare and implement the variable specified here. Its value assignment determines when the color changes.

### Normal state

### Alarm state

The properties listed below control the color depending on the state. The normal state is in effect if the variable in “Color variables”, “Toggle color” is not defined or it has the value FALSE. The alarm state is in effect if the variable in “Colorvariables”, “Toggle color” has the value TRUE.

### Frame color

**Assignment options:**
- Variable (DWORD) for the frame color
  
  **Example:** PLC_PRG.dwBorderColor

- Color literal
  
  **Example of green and opaque:** 16#FF00FF00

### Filling color

**Assignment options:**
- Variable (DWORD) for the fill color
  
  **Example:** PLC_PRG.dwFillColor

- Color literal
  
  **Example of gray and opaque:** 16#FF888888

---

The transparency part of the color value is evaluated only if the “Activate semi-transparent drawing” option of the visualization manager is selected.

Select the “Advanced” option in the toolbar of the properties view. Then all element properties are visible.

See also
- Chapter 6.4.5.10.4 “Animating a color display” on page 2914
The properties contain IEC variables for controlling the appearance of the element dynamically.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Line width”</strong></td>
<td>Variable (integer data type). Contains the line weight (in pixels).</td>
</tr>
<tr>
<td><strong>“Fill attributes”</strong></td>
<td>Variable (DWORD). Controls whether the fill color of the element is visible.</td>
</tr>
<tr>
<td></td>
<td>- Variable value = 0: Filled</td>
</tr>
<tr>
<td></td>
<td>- Variable value &gt; 0: Invisible; no fill color</td>
</tr>
<tr>
<td><strong>“Line style”</strong></td>
<td>Variable (DWORD). Controls the line style.</td>
</tr>
<tr>
<td></td>
<td>Coding:</td>
</tr>
<tr>
<td></td>
<td>- 0: Solid line</td>
</tr>
<tr>
<td></td>
<td>- 1: Dashed line</td>
</tr>
<tr>
<td></td>
<td>- 2: Dotted line</td>
</tr>
<tr>
<td></td>
<td>- 3: Line type &quot;Dash Dot&quot;</td>
</tr>
<tr>
<td></td>
<td>- 3: Line type &quot;Dash Dot Dot&quot;</td>
</tr>
<tr>
<td></td>
<td>- 8: Invisible; no line</td>
</tr>
</tbody>
</table>

Fixed values can be set in the “Appearance” property. These values can be overwritten by dynamic variables at runtime.

See also
- “Element property ‘Appearance’” on page 3468

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Invisible”</strong></td>
<td>Variable (BOOL). Toggles the visibility of the element.</td>
</tr>
<tr>
<td></td>
<td>TRUE: The element is not visible at runtime.</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong> bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR</td>
</tr>
<tr>
<td><strong>“Deactivate inputs”</strong></td>
<td>Variable (BOOL). Toggles the operability of the element.</td>
</tr>
<tr>
<td></td>
<td>TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.</td>
</tr>
</tbody>
</table>

The “Invisible” property is supported by the “Client Animation” functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
### "Animation duration"

Defines the duration (in milliseconds) in which the element runs an animation.

- **Variable (integer value)**
  - Example: `Menu.tContent with VAR tContent : INT := 500; END_VAR`
- **Integer literal**
  - Example: `500`

#### Animatable properties

- "Absolute movement", "Movement", "X", "Y"
- "Absolute movement", "Rotation"
- "Absolute movement", "Interior rotation"
- "Absolute movement", "Exterior rotation"

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

### "Move to foreground"

Moves the visualization element to the foreground.

- **Variable (BOOL)**
  - Example: `bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR`

  - **TRUE**: At runtime, the visualization element is displayed in the foreground.
  - **FALSE**: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

---

**Element property 'Input configuration'**

The properties contain the configurations for the user input when using the mouse or keyboard. A user input defines an event and one or more actions that are executed when an event occurs.

- **Configure button**
  - Opens the "Input Configuration" dialog. There you can create or edit user inputs.
  - Configured user inputs are listed below the events. They each include the action that is triggered and the setting in short form.

**Example:** "Execute ST Code":

```
PLC_PRG.i_x := 0;
```

- **OnDialogClosed**
  - Input event: The user closes the dialog.

- **OnMouseClick**
  - Input event: The user clicks the mouse button completely in the element area. The mouse button is clicked and released.

- **OnMouseDown**
  - Input event: The user clicks down on the mouse button.

- **OnMouseEnter**
  - Input event: The user drags the mouse pointer to the element.

- **OnMouseLeave**
  - Input event: The user drags the mouse pointer away from the element.
"OnMouseMove" | Input event: The user moves the mouse pointer over the element area.

"OnMouseUp" | Input events:
- The user releases the mouse button within the element area. It is irrelevant whether the user has previously pressed the mouse button inside or outside the element area.
- The user presses the mouse button within the element area, leaves the element area, and then releases the mouse button.

Note: This CODESYS-specific triggering behavior guarantees that actions for key elements are completed. A key element starts an action for "OnMouseDown" and ends the action for "OnMouseUp".

Example: A visualization user presses the mouse button within the element area of the key element and then moves the cursor position so that it lies outside the element area. The action is ended anyway because "OnMouseUp" is triggered.

"Tap" | When a mouse click event occurs, the variable defined in "Variable" is described in the application. The coding depends on the "Tap FALSE" and "Tap on enter if captured" options.

"Variable" | Variable (BOOL) that is set on mouse click event.
Example: PLC_PRG.bIsTapped
- TRUE: A mouse click event exists. It lasts as long as the user presses the mouse button over the element. It ends when the button is released.
- FALSE: A mouse click event does not exist.

Requirement: The "Tap FALSE" option is not activated.

"Tap FALSE" | ☑️: The mouse click event leads to a complementary value in "Variable".
- TRUE: A mouse click event does not exist.
- FALSE: While the mouse click event exists.

"Tap on enter if captured" | ☑️: During user input, it is also taken into consideration whether the mouse pointer is dragged within the element area or not while the mouse button is pressed.
- TRUE: While the mouse click event exists and the mouse pointer is moved over the element area.
- FALSE: A mouse click event does not exist. Or the user moves the mouse pointer outside of the element area while the mouse button is pressed.

The value is TRUE again as soon as the user moves the pointer back to the element area. The mouse is then captured.

"Toggle" | With the onset of a mouse click event, the variable is set; when the mouse click event is completed, the variable is reset.

"Variable" | Variable (BOOL). Its value toggled when the mouse click event is ended. This is when the user releases the mouse button while the mouse pointer is over the element area.

If the user releases the mouse button while the mouse pointer is outside of the element area, then the mouse click event is not ended and the value is not toggled.

Hint: The user can cancel a started toggle input by dragging the mouse pointer out of the element area.

"Toggle on up if captured" | ☑️: The value toggles regardless of where the mouse pointer is when the mouse button is released. The mouse is then captured.
<table>
<thead>
<tr>
<th><strong>“Hotkey”</strong></th>
<th>Keyboard shortcut on the element for triggering specific input actions. When the keyboard shortcut event occurs, the input actions in the “Events” property are triggered. In this way, it is not the input action itself that leads to this input action, but the mouse input action.</th>
</tr>
</thead>
</table>
| **“Key”**  | Key pressed for input action.  
Example: [T]  
Note: The following properties appear when a key is selected. |
| **“Events”**  |  
- “None”  
- “Mouse down”: Pressing the key triggers the input actions that are configured in the “OnMouseDown” property.  
- “Mouse up”: Releasing the key triggers the input actions that are configured in the “OnMouseUp” property.  
- “Mouse down/up”: Pressing and releasing the key triggers the input actions that are configured in the “OnMouseDown” property and the “OnMouseUp” property. |
| **“Shift”**  | ☑: Combination with the Shift key  
Example: [Shift]+[T]. |
| **“Control”**  | ☑: Combination with the Ctrl key  
Example: [Ctrl]+[T]. |
| **“Alt”**  | ☑: Combination with the Alt key  
Example: [Alt]+[T]. |

All keyboard shortcuts and their actions that are configured in the visualization are listed on the “Keyboard Configuration” tab.

See also
- ☮ Chapter 6.4.5.21.2.2 “Command 'Keyboard Configuration’” on page 3341
- ☮ Chapter 6.4.5.21.3.6 “Dialog 'Input Configuration’” on page 3370

**Element property 'Access rights’**

Requirement: User management is set up for the visualization.

| **“Access rights”**  | Opens the “Access rights” dialog. There you can edit the access privileges for the element.  
Status messages:  
- “Not set. Full rights.”: Access rights for all user groups: “operable”  
- “Rights are set: Limited rights”: Access is restricted for at least one group. |
|---|---|

See also
- ☮ Chapter 6.4.5.21.3.1 “Dialog 'Access Rights’” on page 3366

**Visualization Element 'Image’**

Symbol: 📸

Category: “Basic”
The element adds an image to the visualization. The displayed image is managed in the image pool and referenced in the visualization element by means of a static ID. You can also change the displayed image dynamically by using a variable instead of the static ID.

**With the “Background” command, you can define a background for the entire visualization.**

**Directories that contain the images for use in visualizations can be defined in the project settings (category “Visualization”).**

### Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: Status bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Type of element”</th>
<th>“Image”</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Static ID”</th>
<th>Identifier of the image file for a static assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID of the image file on, as it is defined in the corresponding image pool. If the image is not included in the global image pool in the POU view, then the instance path must be specified. Then the name of the image pool is preceded to make the entry unique. Example: imagepool2.button_image.</td>
<td></td>
</tr>
<tr>
<td>When a new ID is specified, a file selection dialog opens. The selected file is saved to the “GlobalImagePool”. See also: Help for the “Image Pool” object.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Show frame”</th>
<th>[✓]: The image file is displayed with a frame.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Clipping”</th>
<th>Requirement: The “Scaling type” property is “Fixed”.</th>
</tr>
</thead>
<tbody>
<tr>
<td>[✓]: Only part of the visualization is displayed that fits in the element frame.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Transparent”</th>
<th>[✓]: The image pixels that have the “Transparent color” are displayed as transparent.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Transparent color”</th>
<th>Effective only if the “Transparent” option is activated.</th>
</tr>
</thead>
<tbody>
<tr>
<td>The … button opens the color selection dialog. This is where you select the transparent color.</td>
<td></td>
</tr>
</tbody>
</table>
### Scaling type

Definition of how an image fits in the element frame.

- **Isotropic**: The entire image is displayed in the element frame, either larger or smaller. As a result, the proportion of height and width are retained.
  
  If the alignment of the elements to each other should also be retained within a scaled frame element, then note the following. Unwanted horizontal or vertical offsets can be prevented by setting the properties “Horizontal alignment” and “Vertical alignment” to “Centered”. The alignment of the elements is retained and there are no resulting horizontal or vertical offsets.
  
  Example: A lamp is centered above a switch. The lamp should remain in the horizontally centered position, even if the frame is resized.

- **Anisotropic**: The image resizes automatically to the dimensions of the element frame, filling the entire element frame. As a result, the proportions are not retained.

- **Fixed**: The image retains its original size, even if the element frame is resized. Note also that the “Clipping” option is selected.

  For each reassignment of an image ID, the element size is adapted automatically to the image size.

### Horizontal alignment

Horizontal alignment of the element within the element frame:

- “Left”
- “Centered”
- “Right”

Requirement: The scaling type of the image is “Isotropic” or “Fixed”.

Note: If the visualization is referenced, then the horizontal alignment takes effect within the frame position.

*: The “Variable” property is shown below this.

### Variable

Enumeration variable (ENUM VisuElemBase.VisuEnumHorizontalAlignment). Contains the horizontal alignment.

Example: PLC_PRG.eHorizontalAlignment

### Vertical alignment

Vertical alignment of the element within the element frame:

- “Top”
- “Centered”
- “Bottom”

Requirement: The scaling type of the image is “Isotropic” or “Fixed”.

Note: If the visualization is referenced, then the horizontal alignment takes effect within the frame position.

*: The “Variable” property is shown below this.

### Variable

Enumeration variable (ENUM VisuElemBase.VisuEnumVerticalAlignment). Contains the vertical alignment.

Example: PLC_PRG.eVerticalAlignment
A valid declaration is required for the variables used as an example in the table above.

**Enumeration**

```plaintext
TYPE VisuElemBase.VisuEnumHorizontalAlignment
  LEFT
  HCENTER
  RIGHT
END_TYPE

TYPE VisuElemBase.VisuEnumVerticalAlignment
  DOWN
  VCENTER
  BOTTOM
END_TYPE
```

**Declaration**

```plaintext
PROGRAM PLC_PRG
VAR
  eHorizontalAlignment : VisuElemBase.VisuEnumHorizontalAlignment :=
    VisuElemBase.VisuEnumHorizontalAlignment.HCENTER;
  eVerticalAlignment : VisuElemBase.VisuEnumVerticalAlignment :=
    VisuElemBase.VisuEnumVerticalAlignment.VCENTER;
END_VAR
```

See also
- *Object 'Image Pool'*

**Element property 'Position'**
The position defines the location and size of the element in the visualization window. This is based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“X”</strong></td>
<td>The x-coordinate of the upper left corner of the element</td>
</tr>
<tr>
<td></td>
<td>Specified in pixels</td>
</tr>
<tr>
<td></td>
<td>Example: 10</td>
</tr>
<tr>
<td><strong>“Y”</strong></td>
<td>The y-coordinate of the upper left corner of the element</td>
</tr>
<tr>
<td></td>
<td>Specified in pixels</td>
</tr>
<tr>
<td></td>
<td>Example: 10</td>
</tr>
<tr>
<td><strong>“Width”</strong></td>
<td>Specified in pixels</td>
</tr>
<tr>
<td></td>
<td>Example: 150</td>
</tr>
<tr>
<td><strong>“Height”</strong></td>
<td>Specified in pixels</td>
</tr>
<tr>
<td></td>
<td>Example: 30</td>
</tr>
</tbody>
</table>

Tip: You can change the values in “X”, “Y”, “Width”, and “Height” by dragging the corresponding symbols to another position in the editor.
### “Angle”

Static angle of rotation (in degrees).

**Example:** 35

The element is displayed rotated in the editor. The point of rotation is the center of the element. A positive value rotates clockwise.

Tip: You can change the value in the editor by focusing the element to the handle. When the cursor is displayed as a rotating arrow, you can rotate the element about its center as a handle.

(1): Handle

Note: If a dynamic angle of rotation is also configured in the property “Absolute movement Internal rotation”, then the static and dynamic angles of rotation are added in runtime mode. The static angle of rotation acts as an offset.

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

### Element property ‘Center’

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

| “X” | X-coordinate of the point of rotation |
| “Y” | Y-coordinate of the point of rotation |

You can also change the values by dragging the symbols to other positions in the editor.

### Element property ‘Colors’

The properties contain fixed values for setting colors.

| “Color” | Color for the frame |
| “Alarm color” | Color for the frame in alarm state |
| “Transparency” | Value (0 to 255) for defining the transparency of the selected color. |

- Requirement: “Show frame” property is activated.
- Please note that the normal state is in effect if the expression in the “Color variables Toggle color” property is not defined or it has the value `FALSE`.
- Please note that the alarm state is in effect if the expression in the “Color variables Toggle color” property has the value `TRUE`.

Example 255: The color is opaque. 0: The color is completely transparent.
Element property 'Appearance'  
The properties contain fixed values for setting the look of the element.

<table>
<thead>
<tr>
<th>“Line width”</th>
<th>Value in pixels</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 2</td>
<td></td>
</tr>
<tr>
<td>Note: The values 0 and 1 both result in a line weight of one pixel. If no line should be displayed, then the “Line style” property must be set to the option “Invisible”.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Line style”</th>
<th>Type of line representation</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Solid”</td>
<td></td>
</tr>
<tr>
<td>“Dashes”</td>
<td></td>
</tr>
<tr>
<td>“Dots”</td>
<td></td>
</tr>
<tr>
<td>“Dash Dot”</td>
<td></td>
</tr>
<tr>
<td>“Dash Dot Dot”</td>
<td></td>
</tr>
<tr>
<td>“Dash Dot Dot Dot”</td>
<td></td>
</tr>
<tr>
<td>“not visible”</td>
<td></td>
</tr>
</tbody>
</table>

You can assign variables in the “Appearance variables” property for controlling the appearance dynamically. The fixed values are defined here.

See also
- §§ Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

Element property 'Texts'

The properties contains character strings for labeling the element. The character string can also contain a placeholder with a format definition. In runtime mode, the placeholder is replaced by the current value in the specified format.

CODESYS accepts the specified texts automatically into the “GlobalTextList” text list. Therefore, these texts can be localized.

<table>
<thead>
<tr>
<th>“Text”</th>
<th>Character string (without single straight quotation marks) for the labeling the element. Add a line break by pressing the keyboard shortcut [Ctrl] + [Enter].</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: Accesses: %i</td>
</tr>
<tr>
<td></td>
<td>The variable that contains the current value for the placeholder is specified in the property “Text variable” ➜ Text.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Tooltip”</th>
<th>Character string (without single straight quotation marks) that is displayed as the tooltip of an element.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: Number of valid accesses.</td>
</tr>
<tr>
<td></td>
<td>The variable that contains the current value for the placeholder is specified in the property “Text variable” ➜ Tooltip.</td>
</tr>
</tbody>
</table>

See also
- §§ “Element property ‘Text variables’” on page 3471
- §§ Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
- §§ Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329
**Element property 'Text properties'**
The properties contain fixed values for the text properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Horizontal alignment&quot;</td>
<td>Horizontal alignment of the text within the element.</td>
</tr>
<tr>
<td>&quot;Vertical alignment&quot;</td>
<td>Vertical alignment of the text within the element.</td>
</tr>
<tr>
<td>&quot;Text format&quot;</td>
<td>Definition for displaying texts that are too long</td>
</tr>
<tr>
<td></td>
<td>● &quot;Default&quot;: The long text is truncated.</td>
</tr>
<tr>
<td></td>
<td>● &quot;Line break&quot;: The text is split into parts.</td>
</tr>
<tr>
<td></td>
<td>● &quot;Ellipsis&quot;: The visible text ends with &quot;...&quot; indicating that it is not complete.</td>
</tr>
<tr>
<td>&quot;Font&quot;</td>
<td>Example: &quot;Default&quot;</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="The &quot;Font&quot; dialog box opens." /></td>
</tr>
<tr>
<td></td>
<td>•: Drop-down list with style fonts.</td>
</tr>
<tr>
<td>&quot;Font color&quot;</td>
<td>Example: &quot;Black&quot;</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="The &quot;Color&quot; dialog box opens." /></td>
</tr>
<tr>
<td></td>
<td>•: Drop-down list with style colors.</td>
</tr>
<tr>
<td>&quot;Transparency&quot;</td>
<td>Whole number (value range from 0 to 255). This determines the transparency of the respective color.</td>
</tr>
<tr>
<td></td>
<td>Example: 255: The color is opaque.</td>
</tr>
<tr>
<td></td>
<td>0: The color is completely transparent.</td>
</tr>
<tr>
<td></td>
<td>Please note: If the color is a style color and already has a transparency value, then this property is write-protected.</td>
</tr>
</tbody>
</table>

**Element property 'Image ID variable'**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Image ID&quot;</td>
<td>Variable (STRING). Contains the image ID. The contents of the string correspond to the description of the &quot;Static ID&quot; property.</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.stImageID := 'ImagePool_A.Image3';</td>
</tr>
</tbody>
</table>

See also
- Chapter 6.4.5.20.1.5 "Visualization Element 'Image'" on page 3038
- Chapter 6.4.1.21.2.15 "Object 'Image Pool'" on page 2468

**Element property 'Dynamic image'**
You can use this element property for animating a series of image files.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Bitmap version&quot;</td>
<td>Variable (integer data type). Contains the version of the image. If the variable changes, then the visualization re-reads the image referenced in the &quot;Image ID&quot; property and displays it.</td>
</tr>
<tr>
<td></td>
<td>The visualization displays animations when the image file on the controller is updated continuously, thus incrementing the version variable. The application must be programmed for this.</td>
</tr>
<tr>
<td></td>
<td>Possible applications</td>
</tr>
<tr>
<td></td>
<td>● Displaying graphics that are generated by the application</td>
</tr>
<tr>
<td></td>
<td>● Displaying images that are refreshed by a camera</td>
</tr>
</tbody>
</table>
**Element property 'Absolute movement'**
The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>&quot;Movement&quot;</th>
<th>Variable (numeric data type). Defines the X position (in pixels).</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>&quot;X&quot;</strong></td>
<td>Example: PLC_PRG.iPos_X.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td><strong>&quot;Y&quot;</strong></td>
<td>Variable (numeric data type). Defines the Y position (in pixels).</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iPos_Y.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Rotation&quot;</th>
<th>Variable (numeric data type). Defines the angle of rotation (in degrees).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: PLC_PRG.iAngle1.</td>
</tr>
<tr>
<td></td>
<td>The midpoint of the element rotates at the &quot;Center&quot; point. This rotation point is shown as the symbol.</td>
</tr>
<tr>
<td></td>
<td>In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Scaling&quot;</th>
<th>Variable (integer data type). Causes centric stretching.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: PLC_PRG.iScaling.</td>
</tr>
<tr>
<td></td>
<td>The reference point is the &quot;Center&quot; property.</td>
</tr>
<tr>
<td></td>
<td>The value 1 shrinks the element by a factor of 0.001. The value 1000 returns the element to its original size.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Interior rotation&quot;</th>
<th>Variable (numeric data type). Defines the angle of rotation (in degrees).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: PLC_PRG.iAngle2.</td>
</tr>
<tr>
<td></td>
<td>In runtime mode, the element rotates about the point of rotation specified in &quot;Center&quot; according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.</td>
</tr>
<tr>
<td></td>
<td>The rotation point is shown as the symbol.</td>
</tr>
<tr>
<td></td>
<td>Note: If a static angle of rotation is specified in the property &quot;Position ➔ Angle&quot;, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.</td>
</tr>
</tbody>
</table>

---

You can link the variables to a unit conversion.
The properties “X”, “Y”, “Rotation”, and “Interior rotation” are supported by the “Client Animation” functionality.

See also

- “Element property ‘Absolute movement’” on page 3441

### Element property 'Relative movement'

The properties contains variables for moving the element. The reference point is the position of the element (“Position” property). The shape of the element can change.

<table>
<thead>
<tr>
<th>“Movement top-left”</th>
<th>Variable (integer data type). It contains the number (in pixels) that the left edge is moved horizontally. Incrementing the value moves the element to the right.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
<td>Example: PLC_PRG.iDeltaX</td>
</tr>
<tr>
<td>“Y”</td>
<td>Variable (integer data type). It contains the number (in pixels) that the top edge is moved vertically. Incrementing the value moves the element to the down.</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iDeltaY</td>
</tr>
</tbody>
</table>

### “Movement bottom-right”

<table>
<thead>
<tr>
<th>“X”</th>
<th>Variable (integer data type). It contains the number (in pixels) that the right edge is moved horizontally. Incrementing the value moves the element to the right.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Variable (integer data type). It contains the number (in pixels) that the bottom edge is moved vertically. Incrementing the value moves the element to the down.</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iDeltaHeight</td>
</tr>
</tbody>
</table>

See also

- “Element property ‘Absolute movement’” on page 3441

### Element property 'Text variables'

These properties are variables with contents that replace a format definition.

<table>
<thead>
<tr>
<th>“Text variable”</th>
<th>Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: PLC_PRG.iAccesses</td>
</tr>
<tr>
<td></td>
<td>Note: The format definition is part of the text in the property “Texts ➔ Text”.</td>
</tr>
<tr>
<td></td>
<td>Note: If you specify a variable of type enumeration with text list support, then the name of the enumeration data type is added automatically in angle brackets after the variable name. Example: PLC_PRG.enVar &lt;enumeration name&gt;. Then the symbolic value of the enumeration component is printed instead of the numeric value when text is printed. Refer to the help page for the enumerations.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Tooltip variable”</th>
<th>Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: PLC_PRG.iAccessesInTooltip</td>
</tr>
<tr>
<td></td>
<td>Note: The format definition is part of the text in the property “Texts ➔ Tooltip”.</td>
</tr>
</tbody>
</table>
Dynamic texts are variably indexed texts of a text list. At runtime, the text is displayed that is currently indexed in the variable.

| "Text list" | Variable (string) or name of the text list as a fixed string in single straight quotation marks. Example: 'Errorlist' |
| "Text index" | Text list ID. This refers to the desired output text.  
- As fixed string with the ID in single straight quotation marks. Example: '1'  
- As a variable (STRING) for dynamically controlling the text output. Example: strTextID  
  Sample assignment: PLC_PRG.strTextID := '1'; |
| "Tooltip index" | Text list ID. This refers to the desired output text.  
- As fixed string with the ID in single straight quotation marks. Example: '2'  
- As a variable (STRING) for dynamically controlling the text output. Example: strToolTipID  
  Sample assignment: PLC_PRG.strToolTipID := '2'; |

See also
- § Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329
- § “Element property ‘Texts’” on page 3468
- § Chapter 6.4.1.20.5.18 “Enumerations” on page 2263

The variables allow for dynamic control of the text display.
### “Font name”
Variable (STRING). Includes the font of the text.
Example: PLC_PRG.stFontVar := 'Arial';
The selection of fonts corresponds to the default “Font” dialog.

### “Size”
Variable (numeric data type). Contains the font size (in pixels or points). The applied unit is specified in brackets after the variable name.
- **<pt>:** Points (default)
  Example: PLC_PRG.iFontHeight <pt>
  Code: iFontHeight : INT := 12;
- **<px>:** Pixels
  Example: PLC_PRG.iFontHeight <px>
  Code: iFontHeight : INT := 19;

If you click in the value field, a drop-down list opens on the right for setting the unit.
Hint: The font size is specified in points (example: Arial 12). Use points when the variable font size should match a font, for example if a font is set in the property “Text property ➔ Font”.

### “Flags”
Variable (DWORD). Contains the flags for displaying fonts.
Flags:
- 1: Italics
- 2: Bold
- 4: Underline
- 8: Strikethrough
Note: You can combine the font displays by adding the coding of the flags. For example, a bold and underlined text: PLC_PRG.dwFontType := 6;

### “Character set”
Variable (DWORD). Contains a character set number for the font.
The selection of character set numbers corresponds to the “Script” setting of the standard “Font” dialog.

### “Color”
Variable (DWORD). Includes the color of the text.
Example: PLC_PRG.dwColorFont := 16#FF000000;

### “Flags for text alignment”
Variable (integer data type). Contains the coding for text alignment.
Example: PLC_PRG.dwTextAlignment.
Coding:
- 0: Top left
- 1: Horizontal center
- 2: Right
- 4: Vertical center
- 8: Bottom
Note: You can combine the text alignments by adding the coding of the flags. For example, a vertical and horizontal centered text: PLC_PRG.dwFontType := 5;
Fixed values for displaying texts are set in “Text properties”.

See also

- "Element property 'Text properties'” on page 3469

The Element property is used as an interface for project variables to dynamically control colors at runtime.
| "Toggle color" | The property controls the toggled color at runtime.  
Value assignment:  
- **FALSE**: The element is displayed with the color specified in the "Color" property.  
- **TRUE**: The element is displayed with the color specified in the "Alarm color" property.  
Assigning the property:  
- Placeholder for the user input variable  
  - "<toggle/tap variable>"  
  - "<NOT toggle/tap variable>"  
  The color change is not controlled by its own variable, but by a user input variable.  
  Note: Specify a variable for the mouse events "Tap" or "Toggle" in the input configuration of the element. Only then is the placeholder set. If you configure a variable in both "Toggle" and "Tap", then the variable specified in "Tap" is used.  
  Hint: Click the symbol to insert the placeholder "<toggle/tap variable>". When you activate the "Inputconfiguration", "Tap FALSE" property, then the "<NOT toggle/tap variable>" placeholder is displayed.  
- Instance path of a project variable (BOOL)  
  Example: PLC_PRG.xColorIsToggeled  
  Note: In the code, declare and implement the variable specified here. Its value assignment determines when the color changes. |
| "Color" | Color variable for the frame  
- Variable (**DWORD**) for the color  
  Example: PLC_PRG.dwColor  
- Color literal  
  Example of gray and opaque: 16#FF888888  
  Requirement: "Show frame" property is activated.  
  Please note that the normal state is in effect if the expression in the "Colorvariables ➔ Toggle color" property is not defined or it has the value **FALSE**. |
| "Alarm color" | Color variable for the frame in alarm state  
- Variable (**DWORD**) for the alarm color  
  Example: PLC_PRG.dwAlarmColor  
- Color literal  
  Example of red and opaque: 16#FFFF0000  
  Please note that the alarm state is in effect if the expression in the "Colorvariables ➔ Toggle color" property has the value **TRUE**. |

---

**The transparency part of the color value is evaluated only if the “Activate semi-transparent drawing” option of the visualization manager is selected.**

---

**Select the “Advanced” option in the toolbar of the properties view. Then all element properties are visible.**
The properties contain variables for controlling the appearance of the element dynamically.

### Element property 'Appearance variables'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Line width”</strong></td>
<td>Variable (integer data type). Contains the line weight (in pixels). Note: The values 0 and 1 both result in a line weight of one pixel. If no line should be displayed, then the “Line style” property must be set to the option “Invisible”.</td>
</tr>
</tbody>
</table>

*Fixed values can be set in the “Appearance” property. These values can be overwritten by dynamic variables at runtime.*

See also
- Chapter 6.4.5.4.10 “Animating a color display” on page 2914
- Chapter 6.4.5.21.4.2 “Object ‘Visualization manager’” on page 3398

### Element property 'State variables'

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Invisible”</strong></td>
<td>Variable (BOOL). Toggles the visibility of the element. TRUE: The element is not visible at runtime. Example: bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR</td>
</tr>
<tr>
<td><strong>“Deactivate inputs”</strong></td>
<td>Variable (BOOL). Toggles the operability of the element. TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.</td>
</tr>
</tbody>
</table>

*The “Invisible” property is supported by the "Client Animation" functionality.*

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
**Animation duration**

Defines the duration (in milliseconds) in which the element runs an animation

- **Variable (integer value)**
  
  **Example:**
  ```
  Menu.tContent with
  VAR tContent : INT := 500;
  END_VAR
  ```

- **Integer literal**
  
  **Example:**
  ```
  500
  ```

**Animatable properties**

- **“Absolute movement”, “Movement”, “X”, “Y”**
- **“Absolute movement”, “Rotation”**
- **“Absolute movement”, “Interior rotation”**
- **“Absolute movement”, “Exterior rotation”**

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

---

**Move to foreground**

Moves the visualization element to the foreground

**Variable (BOOL)**

**Example:**
```
VAR bIsInForeground : BOOL := FALSE;
END_VAR
```

**TRUE:** At runtime, the visualization element is displayed in the foreground.

**FALSE:** At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

---

### Element property 'Input configuration'

The properties contain the configurations for the user input when using the mouse or keyboard. User input is a user event from the perspective of the element.

The “Configure” button opens the “Input configuration” dialog box for creating or modifying a user input configuration.

A configuration contains one or more input actions for the respective input event. Existing input actions are displayed below it.

**Example:**
```
“Execute ST code”: # PLC_PRG.i_x := 0;
```

<table>
<thead>
<tr>
<th>Input event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>OnDialogClosed</strong></td>
<td>Input event: The user closes the dialog box.</td>
</tr>
<tr>
<td><strong>OnMouseClick</strong></td>
<td>Input event: A user clicks the element completely. The mouse button is clicked and released.</td>
</tr>
<tr>
<td><strong>OnMouseDown</strong></td>
<td>Input event: A user clicks down on the element only.</td>
</tr>
<tr>
<td><strong>OnMouseEnter</strong></td>
<td>Input event: A user drags the mouse pointer to the element.</td>
</tr>
<tr>
<td><strong>OnMouseLeave</strong></td>
<td>Input event: A user drags the mouse pointer away from the element.</td>
</tr>
<tr>
<td><strong>OnMouseMove</strong></td>
<td>Input event: A user moves the mouse pointer over the element area.</td>
</tr>
<tr>
<td><strong>OnMouseUp</strong></td>
<td>Input event: The user releases the mouse button over the element area.</td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.5.21.3.6 "Dialog 'Input Configuration" on page 3370
### Hotkeys

Keyboard shortcut on the element for triggering specific input actions. When the keyboard shortcut event occurs, the input actions in the **Event(s)** property are triggered.

### Key

Key pressed for input action.

Example: `[T]`

### Event(s)

- **None**
- **Mouse down**: Pressing the key triggers the input actions that are configured in the **OnMouseDown** property.
- **Mouse up**: Releasing the key triggers the input actions that are configured in the **OnMouseUp** property.
- **Mouse down/up**: Pressing and releasing the key triggers the input actions that are configured in the **OnMouseDown** property and the **OnMouseUp** property.

### Shift

☑ Combination with the Shift key

Example: `[Shift]+[T]`.

### Control

☑ Combination with the Ctrl key

Example: `[Ctrl]+[T]`.

### Alt

☑ Combination with the Alt key

Example: `[Alt]+[T]`.

All keyboard shortcuts and their actions that are configured in the visualization are listed in the “Keyboard configuration” tab.

See also

- ✎ Chapter 6.4.5.21.2.2 “Command ‘Keyboard Configuration’” on page 3341

### Element property 'Access rights'

Requirement: User management is set up for the visualization.

### Access rights

Opens the “Access rights” dialog. There you can edit the access privileges for the element.

Status messages:

- **Not set. Full rights.**: Access rights for all user groups: “operable”
- **Rights are set: Limited rights**: Access is restricted for at least one group.

See also

- ✎ Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

See also

- **Project Settings - Visualization**
- ✎ Chapter 6.4.5.21.2.10 "Command 'Background'” on page 3349
- ✎ Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

### Visualization Element 'Frame'

Symbol:
Category: “Basic”

The element serves as a frame in which to display one or more already existing visualizations. You get a structured user interface. The size of the frame can be fixed or scaled. The display area of the referenced visualization then adapts itself to the frame size.

**Element properties**

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: refVisUserInfo</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Type of element”</td>
<td>“Frame”</td>
</tr>
<tr>
<td>“Clipping”</td>
<td>Fixed size. Only that part of the referenced visualization that fits inside the frame is displayed. Requirement: The “Scaling type” property is “Fixed”.</td>
</tr>
<tr>
<td>“Show frame”</td>
<td>Displays the frame</td>
</tr>
<tr>
<td></td>
<td>• “No frame”: The displayed area of the frame does not have borders.</td>
</tr>
<tr>
<td></td>
<td>• “Frame”: The displayed area of the frame has borders.</td>
</tr>
<tr>
<td></td>
<td>• “No frame with offset”: The displayed area of the frame does not have a border and the displayed area of the referenced visualization is reduced inwards by one pixel as compared to the frame area. The gap prevents the referenced visualization from touching any adjacent elements.</td>
</tr>
<tr>
<td>“Scaling type”</td>
<td>The method with which the height and width of the referenced visualization are scaled.</td>
</tr>
<tr>
<td></td>
<td>• “Isotropic”: The visualization is scaled to the size of the element. The visualization retains its proportions with a fixed height/width ratio.</td>
</tr>
<tr>
<td></td>
<td>• “Anisotropic”: The visualization is scaled to the size of the element. The height and width are adapted to the element independently of each other.</td>
</tr>
<tr>
<td></td>
<td>• “Fixed”: The visualization is displayed in its original size without taking into account the size of the element.</td>
</tr>
<tr>
<td></td>
<td>• “Fixed and scrollable”: The visualization is displayed fixed in the element. If it is larger than the element, the element will be provided with scrollbars. Please note: assign variables to the properties “Scroll position variable horizontal” or “Scroll position variable vertical”. You can then edit the data of the scrollbar position in the application.</td>
</tr>
</tbody>
</table>

**Element properties ‘Scrollbar settings’**

The properties contain variables for the position of the scrollboxes in the scrollbars. You can then edit the data of the scrollbox position in the application.
Requirement: the property “Scaling type” is “fixed and scrollable”.

| “Scroll position variable horizontal” | Variable (integer data type, also as array). Contains the position of the horizontal or vertical scrollbar. The array contains the position for every display variant. If the visualization runs on several display variants, then the position changes are decoupled from each other. Example: 

```
PLC_PRG.iScrollHor[CURRENTCLIENTID]
PLC_PRG.iScrollVer[CURRENTCLIENTID]
```

The variable is declared as an array in the example.

```
iScrollHor: ARRAY[0..20] OF INT;
iScrollVer: ARRAY[0..20] OF INT;
```

CURRENTCLIENTID indexes the current display variant. |

| “Scroll position variable vertical” | You can combine the variables with a unit conversion. |

See also

- Unit conversion

| “Deactivation of the background character” | The background is drawn. The non-animated element of the referenced visualization is drawn as a background bitmap in order to optimize the performance of the visualization. Consequence: Elements can be displayed in an unexpected order at runtime. For example, an animated element can push itself behind the Frame at runtime. |

☑: Background character is deactivated in order to avoid the behavior described above.

Element property ‘References’

Contains the currently configured visualization references as a subnode

| “References” | Clicking “Configure” opens the “Frame Configuration” dialog. This is used to manage the referenced visualizations. Caution: Visualizations can be nested at any depth by means of Frame elements. In order to use the “Switch to any visualization” Frame selection type without any problems, a Frame must not contain more than 21 referenced visualizations. For more information, see also the description for the “Input configuration” of an element: Action “Switch Frame visualization”. |

List of the currently referenced visualizations

Visualizations that have a button also have this displayed as a subnode. Each interface variable is listed with the currently assigned transfer parameters. Example:

```
vis_FormA
  • iDataToDisplay_1: PLC_PRG.iVar1
  • iDataToDisplay_2: PLC_PRG.iVar2
```

Hint: You can change the assignment of the variables to an interface variable here and edit the value field. Or click the “Configure” button instead.
See also

- % Chapter 6.4.5.21.2.1 “Command 'Interface Editor'” on page 3340
- % Chapter 6.4.5.17 “Creating a structured user interface” on page 2940
- % “Input action 'Switch Frame Visualization’” on page 3377

Element property 'Position'
The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element Specified in pixels. Example: 10.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Y coordinate of the upper left corner of the element Specified in pixels. Example: 10.</td>
</tr>
<tr>
<td>“Width”</td>
<td>Specified in pixels. Example: 150</td>
</tr>
<tr>
<td>“Height”</td>
<td>Specified in pixels. Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (■) to other positions in the editor.

See also

- % Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

Element property 'Center'
The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the  symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (■) to other positions in the editor.

Element property 'Colors'
The properties contain fixed values for the colors.
### “Color”

**Color of the frame**
- Λ: Selection list with style colors appears
- 📜: Standard dialog “Color” opens for selecting a color.

Please note: the normal state is when the boolean variable in the property “Color variables ➔ Toggle color” is not defined or its value is **FALSE**.

### “Alarm color”

**Color with which the element is filled during the alarm state.**

Please note: Alarm state is when the value of the boolean variable in the property “Color variables ➔ Toggle color” is **FALSE**.

### “Transparency”

Integer number (value range from **255** to **0**). Specifies the transparency of the associated color.

- **255**: The color is opaque.
- **0**: The color is fully transparent.

Please note: If the color is a style color and already contains a transparency value, then this property is write-protected.

### Element property ‘Appearance’

The properties contain fixed values for setting the look of the element.

<table>
<thead>
<tr>
<th>“Line width”</th>
<th>Value in pixels</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 2</td>
<td></td>
</tr>
</tbody>
</table>

Note: The values **0** and **1** both result in a line weight of one pixel. If no line should be displayed, then the “Line style” property must be set to the option “Invisible”.

<table>
<thead>
<tr>
<th>“Line style”</th>
<th>Type of line representation</th>
</tr>
</thead>
<tbody>
<tr>
<td>✅ “Solid”</td>
<td></td>
</tr>
<tr>
<td>✅ “Dashes”</td>
<td></td>
</tr>
<tr>
<td>✅ “Dots”</td>
<td></td>
</tr>
<tr>
<td>✅ “Dash Dot”</td>
<td></td>
</tr>
<tr>
<td>✅ “Dash Dot Dot”</td>
<td></td>
</tr>
<tr>
<td>✅ “not visible”</td>
<td></td>
</tr>
</tbody>
</table>

You can assign variables in the “Appearance variables” property for controlling the appearance dynamically. The fixed values are defined here.

### Element property ‘Texts’

The properties contain character strings for labeling the element. The character string can also contain a placeholder with a format definition. In runtime mode, the placeholder is replaced by the current value in the specified format.

CODESYS accepts the specified texts automatically into the “GlobalTextList” text list. Therefore, these texts can be localized.

---

See also
- ✅ Chapter 6.4.5.5.4 “Assigning a color” on page 2876
- ✅ “Element property ‘Appearance variables’” on page 3489
**“Text”**

Character string (without single straight quotation marks) for the labeling the element. Add a line break by pressing the keyboard shortcut [Ctrl] + [Enter].

Example: Accesses: %i

The variable that contains the current value for the placeholder is specified in the property “Text variable ⇒ Text”.

---

**“Tooltip”**

Character string (without single straight quotation marks) that is displayed as the tooltip of an element.

Example: Number of valid accesses.

The variable that contains the current value for the placeholder is specified in the property “Text variable ⇒ Tooltip”.

---

**See also**

- ☄ “Element property ‘Text variables’” on page 3485
- ☄ Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
- ☄ Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329

---

**Element property ‘Text properties’**

The properties contain fixed values for the text properties.

<table>
<thead>
<tr>
<th>“Horizontal alignment”</th>
<th>Horizontal alignment of the text within the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Vertical alignment”</td>
<td>Vertical alignment of the text within the element.</td>
</tr>
</tbody>
</table>

**“Text format”**

Definition for displaying texts that are too long

- “Default”: The long text is truncated.
- “Line break”: The text is split into parts.
- “Ellipsis”: The visible text ends with “...” indicating that it is not complete.

---

**“Font”**

Example: “Default”

![Font]: The “Font” dialog box opens.

- Drop-down list with style fonts.

---

**“Font color”**

Example: “Black”

![Color]: The “Color” dialog box opens.

- Drop-down list with style colors.

---

**“Transparency”**

Whole number (value range from 0 to 255). This determines the transparency of the respective color.

Example: 255: The color is opaque.

0: The color is completely transparent.

Please note: If the color is a style color and already has a transparency value, then this property is write-protected.

---

**Element property ‘Absolute movement’**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>“Movement”</th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
</tr>
</tbody>
</table>

Variable (numeric data type). Defines the X position (in pixels).

Example: PLC_PRG.iPos_X.

Increasing this value in runtime mode moves the element to the right.
### “Y”
Variable (numeric data type). Defines the Y position (in pixels).

Example: PLC_PRG.iPos_Y.

Increasing this value in runtime mode moves the element downwards.

### “Rotation”
Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle1.

The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.

In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

### “Scaling”
Variable (integer data type). Causes centric stretching.

Example: PLC_PRG.iScaling.

The reference point is the “Center” property.

The value 1 shrinks the element by a factor of 0.001. The value 1000 returns the element to its original size.

---

You can link the variables to a unit conversion.

The properties “X”, “Y”, “Rotation”, and “Interior rotation” are supported by the “Client Animation” functionality.

See also

- [The properties contains variables for moving the element. The reference point is the position of the element (“Position” property). The shape of the element can change.](#)

#### “Movement top-left”
Variable (integer data type). It contains the number (in pixels) that the left edge is moved horizontally. Incrementing the value moves the element to the right.

Example: PLC_PRG.iDeltaX

#### “Movement bottom-right”
Variable (integer data type). It contains the number (in pixels) that the top edge is moved vertically. Incrementing the value moves the element to the down.

Example: PLC_PRG.iDeltaY
| "X" | Variable (integer data type). It contains the number (in pixels) that the **right** edge is moved horizontally. Incrementing the value moves the element to the right.  
Example: PLC_PRG.iDeltaWidth |
| "Y" | Variable (integer data type). It contains the number (in pixels) that the **bottom** edge is moved vertically. Incrementing the value moves the element to the down.  
Example: PLC_PRG.iDeltaHeight |

**See also**
- “Element property ‘Absolute movement’” on page 3441

**Element property ‘Text variables’**

These properties are variables with contents that replace a format definition.

| "Text variable" | Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.  
Example: PLC_PRG.iAccesses |
| "Tooltip variable" | Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.  
Example: PLC_PRG.iAccessesInTooltip |

**See also**
- Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329
- “Element property ‘Texts’” on page 3482
- Chapter 6.4.1.20.5.18 “Enumerations” on page 2263

**Element property ‘Dynamic texts’**

Dynamic texts are variably indexed texts of a text list. At runtime, the text is displayed that is currently indexed in the variable.
### “Text list”

Variable (string) or name of the text list as a fixed string in single straight quotation marks.

Example: 'Errorlist'

- Drop-down list with the dialogs available in the text lists.

### “Text index”

Text list ID. This refers to the desired output text.

- As fixed string with the ID in single straight quotation marks.
  
  Example: '1'

- As a variable (STRING) for dynamically controlling the text output.
  
  Example: strTextID
  
  Sample assignment: PLC_PRG.strTextID := '1';

### “Tooltip index”

Text list ID. This refers to the desired output text.

- As fixed string with the ID in single straight quotation marks.
  
  Example: '2'

- As a variable (STRING) for dynamically controlling the text output.
  
  Example: strToolTipID
  
  Sample assignment: PLC_PRG.strToolTipID := '2';

See also

- § Chapter 6.4.1.21.2.28 “Object 'Text List’” on page 2532

---

**Element property 'Font variables’**

The variables allow for dynamic control of the text display.

### “Font name”

Variable (STRING). Includes the font of the text.

Example: PLC_PRG.stFontVar := 'Arial';

The selection of fonts corresponds to the default “Font” dialog.

### “Size”

Variable (numeric data type). Contains the font size (in pixels or points). The applied unit is specified in brackets after the variable name.

- <pt>: Points (default)
  
  Example: PLC_PRG.iFontHeight <pt>
  
  Code: iFontHeight : INT := 12;

- <px>: Pixels
  
  Example: PLC_PRG.iFontHeight <px>
  
  Code: iFontHeight : INT := 19;

If you click in the value field, a drop-down list opens on the right for setting the unit.

Hint: The font size is specified in points (example: Arial 12). Use points when the variable font size should match a font, for example if a font is set in the property “Text property ➤ Font”.
<table>
<thead>
<tr>
<th><strong>Flags</strong></th>
<th>Variable (DWORD). Contains the flags for displaying fonts.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flags:</td>
<td></td>
</tr>
<tr>
<td>● 1: Italics</td>
<td></td>
</tr>
<tr>
<td>● 2: Bold</td>
<td></td>
</tr>
<tr>
<td>● 4: Underline</td>
<td></td>
</tr>
<tr>
<td>● 8: Strikethrough</td>
<td></td>
</tr>
<tr>
<td>Note: You can combine the font displays by adding the coding of the flags. For example, a bold and underlined text: PLC_PRG.dwFontType := 6;</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Character set</strong></th>
<th>Variable (DWORD). Contains a character set number for the font.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The selection of character set numbers corresponds to the “Script” setting of the standard “Font” dialog.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Color</strong></th>
<th>Variable (DWORD). Includes the color of the text.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example:</td>
<td>PLC_PRG.dwColorFont:= 16#FF000000;</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Flags for text alignment</strong></th>
<th>Variable (integer data type). Contains the coding for text alignment.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example:</td>
<td>PLC_PRG.dwTextAlignment.</td>
</tr>
<tr>
<td>Coding:</td>
<td></td>
</tr>
<tr>
<td>● 0: Top left</td>
<td></td>
</tr>
<tr>
<td>● 1: Horizontal center</td>
<td></td>
</tr>
<tr>
<td>● 2: Right</td>
<td></td>
</tr>
<tr>
<td>● 4: Vertical center</td>
<td></td>
</tr>
<tr>
<td>● 8: Bottom</td>
<td></td>
</tr>
<tr>
<td>Note: You can combine the text alignments by adding the coding of the flags. For example, a vertical and horizontal centered text: PLC_PRG.dwFontType := 5;</td>
<td></td>
</tr>
</tbody>
</table>

Fixed values for displaying texts are set in “Text properties”.

See also
- “Element property ‘Text properties’” on page 3483

Element property ’Color variables’

The Element property is used as an interface for project variables to dynamically control colors at runtime.
### “Toggle color”

The property controls the toggled color at runtime.

**Value assignment:**
- **FALSE:** The element is displayed with the color specified in the “Color” property.
- **TRUE:** The element is displayed with the color specified in the “Alarm color” property.

**Assigning the property:**
- Placeholder for the user input variable
  - `<toggle/tap variable>`
  - `<NOT toggle/tap variable>`

The color change is not controlled by its own variable, but by a user input variable.

Note: Specify a variable for the mouse events “Tap” or “Toggle” in the input configuration of the element. Only then is the placeholder set. If you configure a variable in both “Toggle” and “Tap”, then the variable specified in “Tap” is used.

Hint: Click the symbol `>` to insert the placeholder “<toggle/tap variable>”. When you activate the “Input configuration”, “Tap FALSE” property, then the “<NOT toggle/tap variable>” placeholder is displayed.

- **Instance path of a project variable (BOOL)**
  
  Example: PLC_PRG.xColorIsToggiled

  Note: In the code, declare and implement the variable specified here. Its value assignment determines when the color changes.

### “Color”

Color variable for the Frame

- **Variable (DWORD) for the color**
  
  Example: PLC_PRG.dwColor

- **Color literal**
  
  Example of gray and opaque: `16#FF888888`

Requirement: “Show Frame” property is activated.

Please note that the normal state is in effect if the expression in the “Colorvariables ➔ Toggle color” property is not defined or it has the value FALSE.

### “Alarm color”

Color variable for the Frame in alarm state

- **Variable (DWORD) for the alarm color**
  
  Example: PLC_PRG.dwAlarmColor

- **Color literal**
  
  Example of red and opaque: `16#FFFF0000`

Please note that the alarm state is in effect if the expression in the “Colorvariables ➔ Toggle color” property has the value TRUE.

---

**The transparency part of the color value is evaluated only if the “Activate semi-transparent drawing” option of the visualization manager is selected.**

**Select the “Advanced” option in the toolbar of the properties view. Then all element properties are visible.**
The properties contain variables for controlling the appearance of the element dynamically.

| “Line width”     | Variable (integer data type). Contains the line weight (in pixels). Note: The values 0 and 1 both result in a line weight of one pixel. If no line should be displayed, then the “Line style” property must be set to the option “Invisible”. |
|“Line style”      | Variable (DWORD). Controls the line style. Coding:  
  ● 0: Solid line  
  ● 1: Dashed line  
  ● 2: Dotted line  
  ● 3: Line type “Dash Dot”  
  ● 3: Line type “Dash Dot Dot”  
  ● 8: Invisible: The line is not drawn. |

**Fixed values can be set in the “Appearance” property. These values can be overwritten by dynamic variables at runtime.**

The variable controls the switching of the referenced visualizations. This variable indexes one of the referenced frame visualizations and this is displayed in the frame. When the value of the variable changes, it switches to the recently indexed visualization.

| “Variable”       | Variable (integer data type) that contains the index of the active visualization  
Example: PLC_PRG.uiIndexVisu  
Hint: The “Frame Configuration” dialog includes a list of referenced visualizations. The visualizations are automatically numerically indexed via the order in the list.  
Note: This variant of switching usually affects all connected display variants.  
● Array element (integer data type) for index access via CURRENTCLIENTID  
Example: PLC_PRG.aIndexVisu[CURRENTCLIENTID]  
Note: This variant of switching applies to the current client only, and therefore only on one display variant. That is the display variant where the value change was triggered (for example, by means of user input). |

The variables control the element behavior dynamically.

See also
- Chapter 6.4.5.10.4 “Animating a color display” on page 2914
- Chapter 6.4.5.21.4.2 “Object ‘Visualization manager’” on page 3398

See also
- “Element property ‘Appearance’” on page 3482

See also
- Chapter 6.4.5.21.2.9 “Command ‘Frame Selection’” on page 3348

Element property 'State variables'
### “Invisible”

Variable (BOOL). Toggles the visibility of the element.

- **TRUE**: The element is not visible at runtime.

**Example:**
```plaintext
VAR bIsVisible : BOOL := FALSE; END_VAR
```

### “Deactivate inputs”

Variable (BOOL). Toggles the operability of the element.

- **TRUE**: User inputs do not have any effect in runtime more. The element is shown as deactivated.

**Example:**
```plaintext
VAR VAR bIsVisible : BOOL := FALSE; END_VAR
```

The “Invisible” property is supported by the "Client Animation“ functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

### “Animation duration”

Defines the duration (in milliseconds) in which the element runs an animation

- **Variable (integer value)**
  ```plaintext
  Example: Menu.tContent with VAR tContent : INT := 500; END_VAR
  ```
- **Integer literal**
  ```plaintext
  Example: 500
  ```

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

### “Move to foreground”

Moves the visualization element to the foreground

**Variable (BOOL)**

**Example:**
```plaintext
VAR bIsInForeground : BOOL := FALSE; END_VAR
```

- **TRUE**: At runtime, the visualization element is displayed in the foreground.
- **FALSE**: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

**Element property 'Input configuration'**

The properties contain the configurations for the user input when using the mouse or keyboard.

A user input defines an event and one or more actions that are executed when an event occurs.
The “Configure” button opens the “Input Configuration” dialog. There you can create or edit user inputs. Configured user inputs are listed below the events. They each include the action that is triggered and the setting in short form.

Example: “Execute ST Code”: `PLC_PRG.i_x := 0;`

**“OnDialogClosed”**
Input event: The user closes the dialog.

**“OnMouseMove”**
Input event: The user moves the mouse pointer over the element area.

**“OnMouseDown”**
Input event: The user clicks down on the mouse button.

**“OnMouseEnter”**
Input event: The user drags the mouse pointer to the element.

**“OnMouseLeave”**
Input event: The user drags the mouse pointer away from the element.

**“OnMouseClick”**
Input event: The user clicks the mouse button completely in the element area. The mouse button is clicked and released.

**“OnMouseUp”**
Input events:
- The user releases the mouse button within the element area. It is irrelevant whether the user has previously pressed the mouse button inside or outside the element area.
- The user presses the mouse button within the element area, leaves the element area, and then releases the mouse button.

Note: This CODESYS-specific triggering behavior guarantees that actions for key elements are completed. A key element starts an action for “OnMouseDown” and ends the action for “OnMouseUp”.

Example: A visualization user presses the mouse button within the element area of the key element and then moves the cursor position so that it lies outside the element area. The action is ended anyway because “OnMouseUp” is triggered.

**“Tap”**
When a mouse click event occurs, the variable defined in “Variable” is described in the application. The coding depends on the “Tap FALSE” and “Tap on enter if captured” options.

**“Variable”**
Variable (BOOL) that is set on mouse click event.

Example: `PLC_PRG.bIsTapped`

TRUE: A mouse click event exists. It lasts as long as the user presses the mouse button over the element. It ends when the button is released.

FALSE: A mouse click event does not exist.

Requirement: The “Tap FALSE” option is not activated.

**“Tap FALSE”**
☑️: The mouse click event leads to a complementary value in “Variable”.

TRUE: A mouse click event does not exist.

FALSE: While the mouse click event exists.

**“Tap on enter if captured”**
☑️: During user input, it is also taken into consideration whether the mouse pointer is dragged within the element area or not while the mouse button is pressed.

TRUE: While the mouse click event exists and the mouse pointer is moved over the element area.

FALSE: A mouse click event does not exist. Or the user moves the mouse pointer outside of the element area while the mouse button is pressed.

The value is TRUE again as soon as the user moves the pointer back to the element area. The mouse is then captured.
**“Toggle”**

With the onset of a mouse click event, the variable is set; when the mouse click event is completed, the variable is reset.

**“Variable”**

Variable (BOOL). Its value toggled when the mouse click event is ended. This is when the user releases the mouse button while the mouse pointer is over the element area.

If the user releases the mouse button while the mouse pointer is outside of the element area, then the mouse click event is not ended and the value is not toggled.

Hint: The user can cancel a started toggle input by dragging the mouse pointer out of the element area.

**“Toggle on up if captured”**

☑: The value toggles regardless of where the mouse pointer is when the mouse button is released. The mouse is then captured.

**“Hotkey”**

Keyboard shortcut on the element for triggering specific input actions.

When the keyboard shortcut event occurs, the input actions in the “Events” property are triggered. In this way, it is not the input action itself that leads to this input action, but the mouse input action.

**“Key”**

Key pressed for input action.

Example: [T]

Note: The following properties appear when a key is selected.

**“Events”**

- “None”
- “Mouse down”: Pressing the key triggers the input actions that are configured in the “OnMouseDown” property.
- “Mouse up”: Releasing the key triggers the input actions that are configured in the “OnMouseUp” property.
- “Mouse down/up”: Pressing and releasing the key triggers the input actions that are configured in the “OnMouseDown” property and the “OnMouseUp” property.

**“Shift”**

☑: Combination with the Shift key

Example: [Shift]+[T].

**“Control”**

☑: Combination with the Ctrl key

Example: [Ctrl]+[T].

**“Alt”**

☑: Combination with the Alt key

Example: [Alt]+[T].

---

*All keyboard shortcuts and their actions that are configured in the visualization are listed on the “Keyboard Configuration” tab.*

---

**See also**

- ☝️ Chapter 6.4.5.21.2.2 “Command ‘Keyboard Configuration’” on page 3341
- ☝️ Chapter 6.4.5.21.3.6 “Dialog ‘Input Configuration’” on page 3370

---

**Element property 'Access rights'**

Requirement: User management is set up for the visualization.
## “Access rights”

Opens the “Access rights” dialog. There you can edit the access privileges for the element.

**Status messages:**
- **“Not set. Full rights.”**: Access rights for all user groups: “operable”
- **“Rights are set: Limited rights”**: Access is restricted for at least one group.

See also
- "Chapter 6.4.5.3.1 “Dialog ‘Access Rights’” on page 3366"

See also
- "Chapter 6.4.5.17 “Creating a structured user interface” on page 2940"
- "Chapter 6.4.5.21.3.6 “Dialog ‘Input Configuration’” on page 3370"

## Visualization Element ‘Label’

**Symbol:**

Category: “Common Controls”

The element is used to label visualizations.

### Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
<tr>
<td>Example: Header_Parameter</td>
<td></td>
</tr>
</tbody>
</table>

| “Type of element” | “Label” |

**Element property ‘Texts’**

The property requires a character string.

This text is entered automatically into the **GlobalTextList** text list and can be localized there.

<table>
<thead>
<tr>
<th>“Text”</th>
<th>Character string (without single straight quotation marks)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: Main page</td>
<td></td>
</tr>
</tbody>
</table>

See also
- "Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872"
- "Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329"

**Element property ‘Position’**

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.
X: X coordinate of the upper left corner of the element
   Specified in pixels.
   Example: 10.

Y: Y coordinate of the upper left corner of the element
   Specified in pixels.
   Example: 10.

Width: Specified in pixels.
   Example: 150

Height: Specified in pixels.
   Example: 30

You can also change the values by dragging the box symbols to other
positions in the editor.

See also
- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

Element property ‘Center’

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

X: X-coordinate of the point of rotation

Y: Y-coordinate of the point of rotation

You can also change the values by dragging the symbols to other
positions in the editor.

Element property ‘Text properties’

The properties contain fixed values for the text properties.

Horizontal alignment: Horizontal alignment of the text within the element.

Vertical alignment: Vertical alignment of the text within the element.

Text format: Definition for displaying texts that are too long
   - “Default”: The long text is truncated.
   - “Line break”: The text is split into parts.
   - “Ellipsis”: The visible text ends with “...” indicating that it is not complete.

Font: Example: “Default”

The “Font” dialog box opens.

: Drop-down list with style fonts.
<table>
<thead>
<tr>
<th><strong>Font color</strong></th>
<th>Example: “Black”</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The “Color” dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>▼: Drop-down list with style colors.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Transparency</strong></th>
<th>Whole number (value range from 0 to 255). This determines the transparency of the respective color.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 255: The color is opaque.</td>
<td></td>
</tr>
<tr>
<td>0: The color is completely transparent.</td>
<td></td>
</tr>
<tr>
<td>Please note: If the color is a style color and already has a transparency value, then this property is write-protected.</td>
<td></td>
</tr>
</tbody>
</table>

**Element property ‘Absolute movement’**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th><strong>Movement</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>X</strong></td>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
</tr>
<tr>
<td>Example: PLC_PRG.iPos_X.</td>
<td></td>
</tr>
<tr>
<td>Increasing this value in runtime mode moves the element to the right.</td>
<td></td>
</tr>
<tr>
<td><strong>Y</strong></td>
<td>Variable (numeric data type). Defines the Y position (in pixels).</td>
</tr>
<tr>
<td>Example: PLC_PRG.iPos_Y.</td>
<td></td>
</tr>
<tr>
<td>Increasing this value in runtime mode moves the element downwards.</td>
<td></td>
</tr>
<tr>
<td><strong>Rotation</strong></td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
</tr>
<tr>
<td>Example: PLC_PRG.iAngle1.</td>
<td></td>
</tr>
<tr>
<td>The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.</td>
<td></td>
</tr>
<tr>
<td>In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
<td></td>
</tr>
<tr>
<td><strong>Interior rotation</strong></td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
</tr>
<tr>
<td>Example: PLC_PRG.iAngle2.</td>
<td></td>
</tr>
<tr>
<td>In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.</td>
<td></td>
</tr>
<tr>
<td>The rotation point is shown as the symbol.</td>
<td></td>
</tr>
<tr>
<td>Note: If a static angle of rotation is specified in the “Position Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.</td>
<td></td>
</tr>
</tbody>
</table>
You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the "Client Animation" functionality.

See also

- The variables control the element behavior dynamically.

**Element property ‘State variables’**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invisible</td>
<td>Variable (BOOL). Toggles the visibility of the element. TRUE: The element is not visible at runtime.</td>
</tr>
</tbody>
</table>

The “Invisible” property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
### Animation duration

Defines the duration (in milliseconds) in which the element runs an animation.

- **Variable (integer value)**
  - **Example:**
    ```
    Menu.tContent with VAR tContent : INT := 500;
    END_VAR
    ```

- **Integer literal**
  - **Example:** 500

**Animatable properties**

- "Absolute movement", "Movement", "X", "Y"
- "Absolute movement", "Rotation"
- "Absolute movement", "Interior rotation"
- "Absolute movement", "Exterior rotation"

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

### Move to foreground

Moves the visualization element to the foreground.

- **Variable (BOOL)**
  - **Example:**
    ```
    bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR
    ```

- **TRUE:** At runtime, the visualization element is displayed in the foreground.
- **FALSE:** At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

**Requirement:** User management is set up for the visualization.

### Access rights

Opens the "Access rights" dialog. There you can edit the access privileges for the element.

**Status messages:**

- "Not set. Full rights.": Access rights for all user groups: "operable"
- "Rights are set: Limited rights": Access is restricted for at least one group.

**See also**

- "Chapter 6.4.5.21.3.1 "Dialog 'Access Rights" on page 3366"

**See also**

- "Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872"

### Visualization Element 'Combo Box, Array'

**Symbol:**

Category: "Common Controls"

The element shows values of an array as a list box. When the visualization user clicks an entry, the array index of the entry is written to an integer variable.
Element properties

<table>
<thead>
<tr>
<th>Element name</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
<tr>
<td>Example: List_Product_Number</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Type of element</th>
<th>“Combo Box, Array”</th>
</tr>
</thead>
</table>

Element property 'Position'

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>X coordinate of the upper left corner of the element Specified in pixels. Example: 10.</td>
</tr>
<tr>
<td>Y</td>
<td>Y coordinate of the upper left corner of the element Specified in pixels. Example: 10.</td>
</tr>
<tr>
<td>Width</td>
<td>Specified in pixels. Example: 150</td>
</tr>
<tr>
<td>Height</td>
<td>Specified in pixels. Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (+len) to other positions in the editor.

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

Element property 'Center'

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>X-coordinate of the point of rotation</td>
</tr>
<tr>
<td>Y</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (+) to other positions in the editor.
### “Variable”

The array index of the list entry that the user clicks is saved at runtime.

**Property value**
- Variable (integer data type)
  - Example: `PLC_PRG.iIndexComboboxEntry`
- Enumeration variable with text list support
  - Example: `PLC_PRG.eMyCombobox<COMBO>`
  - Note: Value range of the enumeration value that lies within the DWORD or DINT value range

### “Data array”

Displayed as a combo box. Every array component becomes a combo box entry.

**Property value**
- Array variable (ARRAY[...] OF)
  - Example: `PLC_PRG.astrCombobox`

**See also**
- Enumerations
- § Chapter 6.4.5.8 “Setting Up Multiple Languages” on page 2906

#### “Columns”

The “Combo box – Array” element visualizes an array variable or structure variable in a tabular view. The index of array elements or structure members is shown in a column or row. Two-dimensional arrays or structure arrays are shown in several columns. You specify the visualized variable in the “Data array” property. If a variable is assigned there, then you can specify the display of the table columns where the array elements are shown. You can customize each column that is assigned to an index [<n>].

<table>
<thead>
<tr>
<th>“Columns”</th>
<th>Due to the structure of the variable that is defined in “Data array”, CODESYS determines the number of columns and defines them with the index &lt;n&gt;.</th>
</tr>
</thead>
<tbody>
<tr>
<td>[&lt;n&gt;]</td>
<td>Example: <code>StringTable : ARRAY [0..2, 0..4] OF STRING := ['BMW','Audi','Mercedes','VW','Fiat', '150','150','150','150','100','blue','gray','silver','blue' ,'red'];: three columns are formed [0], [1] and [2].</code></td>
</tr>
</tbody>
</table>

| “Max. array index” | Optional. Variable (integer data type) or value. Defines up to which array index the data is displayed. |

| “Row height” | Height of the rows (in pixels). |

| “Number visible rows” | Optional. If the array is larger than the number of visible rows, then a scrollbar is included. |

| “Scrollbar size” | Width of the vertical scrollbar (in pixels). |

**Table 718: “Element property ‘Columns: Column [<n>]’”**

| “Width” | Column width (in pixels). |

| “Image column” | Images can be displayed in the column. Images are used from the global image pool or user-defined image pools. The image IDs are shown in the cells of the table as defined in the image pool. |

| “Image configuration” | |
“Fill mode”
- “Fill cell”
  The image resizes to the dimensions of the cell without fixing the height/width ratio.
- “Centered”
  The image is centered in the cell and retains its proportions (height-width ratio).

“Transparency”
- When enabled, the color specified here is displayed as transparent.

“Transparent color”
- When the “Transparent” property is enabled, the color specified here is not displayed. Pixels with this color are transparent.

“Text alignment in column”
- “Left”
- “Centered”
- “Right”

Element property 'Texts'

“Tooltip”
- Character string (without single straight quotation marks) that is displayed as the tooltip of an element in runtime mode
- Example: Products of customer A
- Hint: The text is accepted automatically into the “GlobalTextList” text list and can be localized there.

See also
- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

Element property 'Text properties'

“Usage of”
- “Default style values”: The values of the visualization style are used.
- “Individual settings”: The "Individual text properties" property group is shown. The values can be customized here.

“Individual text properties”
Requirement: The “Individual settings” text property is defined.

“Font”
- Example: “Default”
  - The “Font” dialog opens.
  - List box with style fonts

“Font color”
- Example: “Black”
  - The “Color” dialog opens.
  - List box with style colors

“Transparency”
- Integer (value range from 0 to 255). This determines the transparency of the respective color.
  - 255: The color is opaque.
  - 0: The color is completely transparent.
- Note: If the color is a style color and already has a transparency value, then this property is write-protected.
The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

### “Movement”

| “X” | Variable (numeric data type). Defines the X position (in pixels).<br>Example: PLC_PRG.iPos_X.<br>Increasing this value in runtime mode moves the element to the right. |
| “Y” | Variable (numeric data type). Defines the Y position (in pixels).<br>Example: PLC_PRG.iPos_Y.<br>Increasing this value in runtime mode moves the element downwards. |

### “Rotation”

| “Rotation” | Variable (numeric data type). Defines the angle of rotation (in degrees).<br>Example: PLC_PRG.iAngle1.<br>The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.<br>In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right. |

### “Interior rotation”

| “Interior rotation” | Variable (numeric data type). Defines the angle of rotation (in degrees).<br>Example: PLC_PRG.iAngle2.<br>In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.<br>The rotation point is shown as the symbol.<br>Note: If a static angle of rotation is specified in the “Position Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed. |

You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

-
The variables control the element behavior dynamically.

**“Invisible” Variable (BOOL).** Toggles the visibility of the element.

- **TRUE:** The element is not visible at runtime.

  **Example:**
  ```
  bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR
  ```

**“Deactivate inputs” Variable (BOOL).** Toggles the operability of the element.

- **TRUE:** User inputs do not have any effect in runtime more. The element is shown as deactivated.

  The “Invisible” property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

**“Animation duration”** Defines the duration (in milliseconds) in which the element runs an animation

1. **Variable (integer value)**
   **Example:**
   ```
   Menu.tContent with VAR tContent : INT := 500; END_VAR
   ```

2. **Integer literal**
   **Example:**
   ```
   500
   ```

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**“Move to foreground”** Moves the visualization element to the foreground

**Variable (BOOL)**

**Example:**
```
Menu.bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR
```

- **TRUE:** At runtime, the visualization element is displayed in the foreground.
- **FALSE:** At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

See also

- § Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
Visualization Element 'Combo Box, Integer'

Symbol:

Category: “Common Controls”

The element shows values as a list box. When the user clicks an entry, the ID of the entry is written to an integer variable. The entries in the list box can be from a list and contain images from an image pool.

Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: List of product numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Optional</td>
</tr>
<tr>
<td></td>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
</tr>
</tbody>
</table>

| “Type of element” | “Combo Box, Integer” |

Element property 'Position'

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels. Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels. Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Width”</th>
<th>Specified in pixels. Example: 150</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Height”</th>
<th>Specified in pixels. Example: 30</th>
</tr>
</thead>
</table>

You can also change the values by dragging the box symbols (智库) to other positions in the editor.

See also
- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

Element property 'Center'

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.
<table>
<thead>
<tr>
<th>“X”</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (.defineProperty) to other positions in the editor.

<table>
<thead>
<tr>
<th>“Variable”</th>
<th>At runtime, the text list ID of the list entry that the user clicks is saved at runtime. If only one image pool is displayed, then the image ID is saved.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Property</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Variable (integer data type)</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iIDComboboxEntry</td>
</tr>
<tr>
<td></td>
<td>• Enumeration variable with text list support</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.eMyCombobox&lt;COMBO&gt;</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Text List”</th>
<th>Displayed as a combo box. Every text list entry becomes a combo box entry. Note: A maximum of 32766 entries can be displayed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transfer value</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Text list identifier as string</td>
</tr>
<tr>
<td></td>
<td>Example: ’TextList_A’</td>
</tr>
<tr>
<td></td>
<td>Note: The IDs of the text list have to be within the range of values of DWORD or DINT.</td>
</tr>
<tr>
<td></td>
<td>• Blank</td>
</tr>
<tr>
<td></td>
<td>– When an enumeration variable with text list support is specified in the “Variable” property</td>
</tr>
<tr>
<td></td>
<td>– When only one image pool is displayed</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Image Pool”</th>
<th>Displayed as a combo box. Every image in the image pool becomes a combo box entry.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example:</td>
<td>’ImagePool_A’</td>
</tr>
</tbody>
</table>

See also

- Enumerations
- Chapter 6.4.5.8 “Setting Up Multiple Languages” on page 2906

Element property ‘Settings of the list’

<table>
<thead>
<tr>
<th>“Number of rows setting”</th>
<th>“From style”</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>“Explicit”: Then the “Number of visible rows” property appears below it.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Number of visible rows”</th>
<th>Number of visible lines of the combo box drop-down list defined here</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Integer literal</td>
</tr>
<tr>
<td></td>
<td>Example: 5</td>
</tr>
<tr>
<td></td>
<td>• Variable (integer data type)</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.1NumberOfVisibleRows</td>
</tr>
</tbody>
</table>

Note: The property is available when the “Number of rows setting” property is set to “Explicit”.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>From style</th>
<th>Example</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>&quot;Row height&quot;</strong></td>
<td>Row height (in pixels) of the image displayed in the drop-down list entry</td>
<td>Literal</td>
<td>20</td>
<td>Images are displayed only when a value is specified in the “Image pool” property.</td>
</tr>
<tr>
<td><strong>&quot;Height of image&quot;</strong></td>
<td>Image height (in pixels) of the image displayed in the drop-down list entry</td>
<td>Integer</td>
<td>30</td>
<td>Images are displayed only when a value is specified in the “Image pool” property.</td>
</tr>
<tr>
<td><strong>&quot;Width of image&quot;</strong></td>
<td>Image width (in pixels) of the image displayed in the drop-down list entry</td>
<td>Literal</td>
<td>30</td>
<td>Images are displayed only when a value is specified in the “Image pool” property.</td>
</tr>
<tr>
<td><strong>&quot;Offset of image&quot;</strong></td>
<td>Makes the images in the selection list appear offset (in pixels) from the left margin. An offset of 0 means that the images are displayed directly on the margin.</td>
<td>Literal</td>
<td>4</td>
<td>Images are displayed only when a value is specified in the “Image pool” property.</td>
</tr>
<tr>
<td><strong>&quot;Scrollbar size&quot;</strong></td>
<td>Size of the scrollbar (in pixels). The scrollbar is displayed when more entries are specified in the drop-down list than in “Number of visible rows”.</td>
<td></td>
<td>20</td>
<td></td>
</tr>
</tbody>
</table>

**Element property ‘Texts’**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>&quot;Tooltip&quot;</strong></td>
<td>Character string (without single straight quotation marks) that is displayed as the tooltip of an element in runtime mode</td>
<td>Products of customer A</td>
<td>The text is accepted automatically into the “GlobalTextList” text list and can be localized there.</td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
### Limit valuerange
Limits the text list to one subrange. This subrange is displayed by the combo box.

**Requirement:** A value is specified in the “Text list” property.

- Only the subrange that is defined by the “Minimum value” “Maximum value” properties is displayed as a drop-down list.

### Minimum value
ID of the text list entry from which a combo box entry is displayed

- **Literal (ANY_NUM)**
  - Example: 5
- **Variable (integer data type)**
  - Example: PLC_PRG.iFirstEntry

### Maximum value
ID of the text list entry up to which combo box entries are displayed

- **Literal (ANY_NUM)**
  - Example: 10
- **Variable (integer data type)**
  - Example: PLC_PRG.iLastEntry

### Filter missing textentries
- Text list is refreshed and any unused texts (IDs) are removed.

**Requirement:** A value is specified in the “Text list” property.

### Element property 'Text properties'
The properties contain fixed values for the text properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Usage of</td>
<td>- <strong>Default style values</strong>: The values of the visualization style are used.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Individual settings</strong>: The “Individual text properties” property group is shown</td>
</tr>
<tr>
<td></td>
<td>The values can be customized here.</td>
</tr>
<tr>
<td>Individual text properties</td>
<td><strong>Requirement:</strong> The “Individual settings” text property is defined.</td>
</tr>
<tr>
<td>Horizontal alignment</td>
<td>Horizontal alignment of the text within the element.</td>
</tr>
<tr>
<td>Vertical alignment</td>
<td>Vertical alignment of the text within the element.</td>
</tr>
<tr>
<td>Font</td>
<td>Example: “Default”</td>
</tr>
<tr>
<td></td>
<td>• The “Font” dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>• Drop-down list with style fonts.</td>
</tr>
<tr>
<td>Font color</td>
<td>Example: “Black”</td>
</tr>
<tr>
<td></td>
<td>• The “Color” dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>• Drop-down list with style colors.</td>
</tr>
<tr>
<td>Transparency</td>
<td>Whole number (value range from 0 to 255). This determines the transparency of the respective color.</td>
</tr>
<tr>
<td></td>
<td>Example: 255: The color is opaque.</td>
</tr>
<tr>
<td></td>
<td>0: The color is completely transparent.</td>
</tr>
<tr>
<td></td>
<td>Please note: If the color is a style color and already has a transparency value, then this property is write-protected.</td>
</tr>
</tbody>
</table>

### Element property 'Absolute movement'
The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.
“Movement”

“X” Variable (numeric data type). Defines the X position (in pixels).

Example: PLC_PRG.iPos_X.

Increasing this value in runtime mode moves the element to the right.

“Y” Variable (numeric data type). Defines the Y position (in pixels).

Example: PLC_PRG.iPos_Y.

Increasing this value in runtime mode moves the element downwards.

“Rotation” Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle1.

The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.

In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

“Interior rotation” Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- Element property 'State variables'

The variables control the element behavior dynamically.
"Invisible"  
Variable (BOOL). Toggles the visibility of the element.  
TRUE: The element is not visible at runtime.  
Example: bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR

"Deactivate inputs"  
Variable (BOOL). Toggles the operability of the element.  
TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.

The "Invisible" property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

"Animation duration"  
Defines the duration (in milliseconds) in which the element runs an animation  
- Variable (integer value)  
  Example: Menu.tContent with VAR tContent : INT := 500; END_VAR  
- Integer literal  
  Example: 500

Animatable properties  
- “Absolute movement”, “Movement”, “X”, “Y”  
- “Absolute movement”, “Rotation”  
- “Absolute movement”, “Interior rotation”  
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

"Move to foreground"  
Moves the visualization element to the foreground  
Variable (BOOL)  
Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR  
TRUE: At runtime, the visualization element is displayed in the foreground.  
FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

Element property 'Access rights'  
Requirement: User management is set up for the visualization.

"Access rights"  
Opens the “Access rights” dialog. There you can edit the access privileges for the element.  
Status messages:  
- “Not set. Full rights.”: Access rights for all user groups : “operable”  
- “Rights are set: Limited rights”: Access is restricted for at least one group.
Visualization Element 'Tabs'

Symbol:

Category: “Common Controls”

The element displays selected visualizations in tabs. The tabs can be used by means of the tab header without having to configure an input configuration. A visualization user switches between visualizations by clicking the tab header.

**Element properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Element name&quot;</td>
<td>Assembly A</td>
</tr>
<tr>
<td></td>
<td>Optional</td>
</tr>
<tr>
<td></td>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
</tr>
<tr>
<td>&quot;Type of element&quot;</td>
<td>&quot;Tabs&quot;</td>
</tr>
<tr>
<td>&quot;Tab width&quot;</td>
<td>Width of the tab (in pixels). If there is not space for all tab headers, then a scrollbar is added.</td>
</tr>
<tr>
<td></td>
<td>Example: 30</td>
</tr>
<tr>
<td>&quot;Tab height&quot;</td>
<td>Height of the tab (in pixels)</td>
</tr>
<tr>
<td></td>
<td>- Integer literal</td>
</tr>
<tr>
<td></td>
<td>- Example: 15</td>
</tr>
<tr>
<td></td>
<td>- &quot;From style&quot;</td>
</tr>
</tbody>
</table>

| "Scaling type"    | The method with which the height and width of the referenced visualization are scaled. |
|                   | - "Isotropic": The visualization is scaled to the size of the element. The visualization retains its proportions with a fixed height/width ratio. |
|                   | - "Anisotropic": The visualization is scaled to the size of the element. The height and width are adapted to the element independently of each other. |
|                   | - "Fixed": the visualization is displayed in its original size without taking into account the size of the element. |
|                   | - "Fixed and scrollable": The visualization is displayed fixed in the element. If it is larger than the element, the element will be provided with scrollbars. Please note: assign variables to the properties “Scroll position variable horizontal” or “Scroll position variable vertical”. You can then edit the data of the scrollbar position in the application. |
"Deactivate background drawing" The non-animated elements of the referenced visualization are displayed as background images in order to optimize the performance of the visualization.

Result: At runtime, the elements can be displayed in any order, for example when an element moves behind the frame at runtime.

☑️ Deactivates the background display in order to prevent the behavior described above

The property is not available for the following settings:
- The "Scaling type" property is set to "Fixed and scrollable"
- The client animation functionality is enabled.

**Element property 'Scroll bar settings'**

The properties include variables for the position of the scroll boxes in the scroll bars. You can process the data for the scroll box position in the application.

<table>
<thead>
<tr>
<th>Requirement: The &quot;Scaling type&quot; property is &quot;Fixed and scrollable&quot;.</th>
</tr>
</thead>
</table>

| “Scroll position variable horizontal” | Variable (integer data type, also array). Includes the position of the horizontal or vertical scroll box. The array contains the position for each display variant. If the visualization is running on multiple display variants, then the position changes are disconnected from each other.

Example:
- PLC_PRG.iScrollHor[CURRENTCLIENTID]
- PLC_PRG.iScrollVer[CURRENTCLIENTID]

In this example, the variable is declared as an array:
- iScrollHor: ARRAY[0..20] OF INT;
- iScrollVer: ARRAY[0..20] OF INT;
- CURRENTCLIENTID indicates the current display variant. |

See also
- Unit conversion

**Element property 'References'**

| “References” | Clicking “Configure” opens the “Frame Configuration” dialog. You can select an existing visualization there.

Selected visualization references are shown in the properties.

Selected visualization references are listed here as subordinate properties. |
|---------------------------------------------------------------|

<table>
<thead>
<tr>
<th>Name pf the visualization reference (example: PLC_PRG.S1)</th>
</tr>
</thead>
</table>

| “Heading” | Tab caption (example: Panel) |
|---------------------------------------------------------------|

| “Image ID” | Image ID in the theme <image pool name>.<ID>

Example: Imagepool_A.1 for the image with ID 1 in Imagepool_A |

| Interface parameter of the visualization reference
Example: iX | If the visualization has an interface, then their parameters are displayed here as subordinate properties.

Variable (data type conforms to data type of the interface parameter). Includes the initialization value for the instantiation of the visualization. |
The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

### Element property 'Position'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(X)</td>
<td>X coordinate of the upper left corner of the element</td>
</tr>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
<tr>
<td>(Y)</td>
<td>Y coordinate of the upper left corner of the element</td>
</tr>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
<tr>
<td>(Width)</td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 150</td>
</tr>
<tr>
<td>(Height)</td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (_drag_ ) to other positions in the editor.

### Element property 'Center'

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(X)</td>
<td>X-coordinate of the point of rotation</td>
</tr>
<tr>
<td>(Y)</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (_drag_ ) to other positions in the editor.

### Element property 'Switch frame variable'

See also

- Chapter 6.4.5.17 “Creating a structured user interface” on page 2940
- Chapter 6.4.5.21.2.1 “Command 'Interface Editor’” on page 3340
- Chapter 6.4.5.21.2.9 “Command 'Frame Selection’” on page 3348
<table>
<thead>
<tr>
<th>Variable</th>
<th>Variable (integer data type). Specifies the index of the active visualization. Example: PLC_PRG.uiActiveVisuID. Tip: The “Frame Configuration” dialog box includes a list of selected visualizations. The visualizations are ordered automatically in numeric order in the list.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Movement”</td>
<td>The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.</td>
</tr>
<tr>
<td>“X”</td>
<td>Variable (numeric data type). Defines the X position (in pixels). Example: PLC_PRG.iPos_X. Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td>“Y”</td>
<td>Variable (numeric data type). Defines the Y position (in pixels). Example: PLC_PRG.iPos_Y. Increasing this value in runtime mode moves the element downwards.</td>
</tr>
<tr>
<td>“Rotation”</td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees). Example: PLC_PRG.iAngle1. The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol. In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
</tr>
<tr>
<td>“Interior rotation”</td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees). Example: PLC_PRG.iAngle2. In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise. The rotation point is shown as the symbol. Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.</td>
</tr>
</tbody>
</table>
You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

Element property 'State variables'
The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>Property</th>
<th>Variable (BOOL). Toggles the visibility of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Invisible”</td>
<td>TRUE: The element is not visible at runtime.</td>
</tr>
<tr>
<td></td>
<td>Example: <code>bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR</code></td>
</tr>
<tr>
<td>“Deactivate inputs”</td>
<td>TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.</td>
</tr>
</tbody>
</table>

The “Invisible” property is supported by the “Client Animation” functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
**“Animation duration”**

Defines the duration (in milliseconds) in which the element runs an animation.

- **Variable (integer value)**
  
  **Example:** Menu.tContent with
  ```plaintext
  VAR tContent : INT := 500;
  END_VAR
  ```

- **Integer literal**
  
  **Example:** 500

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**“Move to foreground”**

Moves the visualization element to the foreground.

**Variable (BOOL)**

**Example:** bIsInForeground with
  ```plaintext
  VAR bIsInForeground : BOOL := FALSE;
  END_VAR
  ```

TRUE: At runtime, the visualization element is displayed in the foreground.

FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

See also

- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

**Visualization Element ‘Button’**

- **Symbol:**
  ![Button Symbol](image)

- **Category:** “Common Controls”

The element triggers an action, such as setting a variable.

**Element properties**

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong> Voltage_on</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Type of element”</th>
<th>“Button”</th>
</tr>
</thead>
</table>

**Element property ‘Position’**

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.
**“X”**
X coordinate of the upper left corner of the element
Specified in pixels.
Example: 10.

**“Y”**
Y coordinate of the upper left corner of the element
Specified in pixels.
Example: 10.

**“Width”**
Specified in pixels.
Example: 150

**“Height”**
Specified in pixels.
Example: 30

You can also change the values by dragging the box symbols (±) to other positions in the editor.

See also
- ☛ Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

**Element property ‘Center’**
The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the 🌌 symbol. The point is used as the center for rotating and scaling.

**“X”**
X-coordinate of the point of rotation

**“Y”**
Y-coordinate of the point of rotation

You can also change the values by dragging the symbols (四十) to other positions in the editor.

**Element property ‘Colors’**
The properties contain fixed values for setting colors.

**“Color”**
Color for the element in its normal state.
Please note that the normal state is in effect if the expression in the “Color variables ➔ Toggle color” property is not defined or it has the value FALSE.

**“Alarm color”**
Color for the element in alarm state.
Please note that the alarm state is in effect if the expression in the “Color variables ➔ Toggle color” property has the value TRUE.

**“Transparency”**
Value (0 to 255) for defining the transparency of the selected color.
Example 255: The color is opaque. 0: The color is completely transparent.

**“Use gradient color”**
✔: The element is displayed with a color gradient.

**“Gradient setting”**
The “Color gradient editor” dialog box opens.
See also

- Chapter 6.4.5.21.3.5 “Dialog ‘Gradient Editor’” on page 3369
- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

Element property 'Image'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| “Static ID”        | Reference to an image in an image pool of the format <name of image pool>.<image ID> (example: image_pool.GreenButton). If the image is from the “GlobalImagePool”, then you can omit the name of the image pool because CODESYS always searches this pool first. 
|                    | ![...](...): The “Input Assistant” dialog box opens and lists all available image pools and images in the entire project. |
| “Scale type”       | Behavior of the image when resizing the button.                              |
|                    | - “Isotropic”: The image retains its proportions. The ratio of height to width is retained, even if you change the height or width of the button separately. |
|                    | - “Anisotropic”: The image resizes to the dimensions of the button.         |
|                    | - “Fixed”: The image retains its original size, even if you change the size of the button. |
| “Transparency”     | The visualization displays the image with the transparency color that is selected in “Transparency color”. |
| “Transparency color” | Color that is transparent in the image (example: “White”). If the image background that is reference by “Static ID” is white, then this background is displayed transparent. Clicking ![...](...) opens a color selection dialog. |
| “Horizontal alignment” | Horizontal alignment of the image                                             |
|                    | - “Left”                                                                    |
|                    | - “Centered”                                                                |
|                    | - “Right”                                                                   |
| “Vertical alignment” | Vertical alignment of the image                                              |
|                    | - “Top”                                                                     |
|                    | - “Centered”                                                                |
|                    | - “Bottom”                                                                  |

Element property 'Texts'

The properties contains character strings for labeling the element. The character string can also contain a placeholder with a format definition. In runtime mode, the placeholder is replaced by the current value in the specified format. 

CODESYS accepts the specified texts automatically into the “GlobalTextList” text list. Therefore, these texts can be localized.
**"Text"**

Character string (without single straight quotation marks) for the labeling the element. Add a line break by pressing the keyboard shortcut [Ctrl] + [Enter].

Example: Accesses: %i

The variable that contains the current value for the placeholder is specified in the property “Text variable ➔ Text”.

**"Tooltip"**

Character string (without single straight quotation marks) that is displayed as the tooltip of an element.

Example: Number of valid accesses.

The variable that contains the current value for the placeholder is specified in the property “Text variable ➔ Tooltip”.

See also
- “Element property ‘Text variables’” on page 3519
- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
- Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329

### Element property ‘Text properties’

The properties contain fixed values for the text properties.

<table>
<thead>
<tr>
<th>“Horizontal alignment”</th>
<th>Horizontal alignment of the text within the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Vertical alignment”</td>
<td>Vertical alignment of the text within the element.</td>
</tr>
</tbody>
</table>

**“Text format”**

Definition for displaying texts that are too long
- “Default”: The long text is truncated.
- “Line break”: The text is split into parts.
- “Ellipsis”: The visible text ends with “...” indicating that it is not complete.

**“Font”**

Example: “Default”

- The “Font” dialog box opens.
- ▼: Drop-down list with style fonts.

**“Font color”**

Example: “Black”

- The “Color” dialog box opens.
- ▼: Drop-down list with style colors.

**“Transparency”**

Whole number (value range from 0 to 255). This determines the transparency of the respective color.

Example: 255: The color is opaque.

0: The color is completely transparent.

Please note: If the color is a style color and already has a transparency value, then this property is write-protected.

### Element property ‘Absolute movement’

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

**“Movement”**

<table>
<thead>
<tr>
<th>“X”</th>
<th>Variable (numeric data type). Defines the X position (in pixels).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: PLC_PRG.iPos_X.</td>
</tr>
</tbody>
</table>

Increasing this value in runtime mode moves the element to the right.
### “Y”
Variable (numeric data type). Defines the Y position (in pixels).

**Example:** PLC_PRG.iPos_Y.

Increasing this value in runtime mode moves the element downwards.

### “Rotation”
Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** PLC_PRG.iAngle1.

The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.

In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

### “Scaling”
Variable (integer data type). Causes centric stretching.

**Example:** PLC_PRG.iScaling.

The reference point is the “Center” property.

The value 1 shrinks the element by a factor of 0.001. The value 1000 returns the element to its original size.

---

You can link the variables to a unit conversion.

The properties “X”, “Y”, “Rotation”, and “Interior rotation” are supported by the “Client Animation” functionality.

---

**Element property ‘Relative movement’**

The properties contain variables for moving the element. The reference point is the position of the element (“Position” property). The shape of the element can change.

<table>
<thead>
<tr>
<th>“Movement top-left”</th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
</tr>
</tbody>
</table>
| Variable (integer data type). It contains the number (in pixels) that the left edge is moved horizontally. Incrementing the value moves the element to the right.**Example:** PLC_PRG.iDeltaX

| “Y”                 |
| Variable (integer data type). It contains the number (in pixels) that the top edge is moved vertically. Incrementing the value moves the element to the down.**Example:** PLC_PRG.iDeltaY

| “Movement bottom-right” |
**“X”** Variable (integer data type). It contains the number (in pixels) that the right edge is moved horizontally. Incrementing the value moves the element to the right.  
Example: PLC_PRG.iDeltaWidth

**“Y”** Variable (integer data type). It contains the number (in pixels) that the bottom edge is moved vertically. Incrementing the value moves the element to the down.  
Example: PLC_PRG.iDeltaHeight

See also
- “Element property ‘Absolute movement’” on page 3441

**Element property 'Text variables'** These properties are variables with contents that replace a format definition.

| **“Text variable”** | Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.  
Example: PLC_PRG.iAccesses  
Note: The format definition is part of the text in the property “Texts ➔ Text”.  
Note: If you specify a variable of type enumeration with text list support, then the name of the enumeration data type is added automatically in angle brackets after the variable name. Example: PLC_PRG.enVar <enumeration name>. Then the symbolic value of the enumeration component is printed instead of the numeric value when text is printed. Refer to the help page for the enumerations. |
| --- | --- |

| **“Tooltip variable”** | Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.  
Example: PLC_PRG.iAccessesInTooltip  
Note: The format definition is part of the text in the property “Texts ➔ Tooltip”. |
| --- | --- |

See also
- Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329
- “Element property ‘Texts’” on page 3516
- Chapter 6.4.1.20.5.18 “Enumerations” on page 2263

**Element property 'Dynamic texts'** Dynamic texts are variably indexed texts of a text list. At runtime, the text is displayed that is currently indexed in the variable.
### Text list

Variable (string) or name of the text list as a fixed string in single straight quotation marks.

- Example: 'Errorlist'
- ▼: Drop-down list with the dialogs available in the text lists.

### Text index

Text list ID. This refers to the desired output text.

- As fixed string with the ID in single straight quotation marks.
  - Example: '1'
- As a variable (STRING) for dynamically controlling the text output.
  - Example: `strTextID`
  - Sample assignment: `PLC_PRG.strTextID := '1';`

### Tooltip index

Text list ID. This refers to the desired output text.

- As fixed string with the ID in single straight quotation marks.
  - Example: '2'
- As a variable (STRING) for dynamically controlling the text output.
  - Example: `strToolTipID`
  - Sample assignment: `PLC_PRG.strToolTipID := '2';`

See also
- § Chapter 6.4.1.21.2.28 “Object ‘Text List’” on page 2532

### Element property ‘Font variables’

The variables allow for dynamic control of the text display.

| **Font name** | Variable (STRING). Includes the font of the text.
|---------------|-------------------------------------------------
| Example: `PLC_PRG.stFontVar := 'Arial';` |
| The selection of fonts corresponds to the default “Font” dialog. |

| **Size** | Variable (numeric data type). Contains the font size (in pixels or points). The applied unit is specified in brackets after the variable name.
|-----------|--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------|
| ▼: Points (default)
  - Example: `PLC_PRG.iFontHeight <pt>`
  - Code: `iFontHeight : INT := 12;`
| ▼: Pixels
  - Example: `PLC_PRG.iFontHeight <px>`
  - Code: `iFontHeight : INT := 19;`

If you click in the value field, a drop-down list opens on the right for setting the unit.

Hint: The font size is specified in points (example: Arial 12). Use points when the variable font size should match a font, for example if a font is set in the property “Text property ➔ Font”.

### Flags

Variable (DWORD). Contains the flags for displaying fonts.

**Flags:**
- 1: Italics
- 2: Bold
- 4: Underline
- 8: Strikethrough

Note: You can combine the font displays by adding the coding of the flags. For example, a bold and underlined text: `PLC_PRG.dwFontType := 6;`

### Character set

Variable (DWORD). Contains a character set number for the font.

The selection of character set numbers corresponds to the “Script” setting of the standard “Font” dialog.

### Color

Variable (DWORD). Includes the color of the text.

Example: `PLC_PRG.dwColorFont := 16#FF000000;`

### Flags for text alignment

Variable (integer data type). Contains the coding for text alignment.

Example: `PLC_PRG.dwTextAlignment = 5;`

**Coding:**
- 0: Top left
- 1: Horizontal center
- 2: Right
- 4: Vertical center
- 8: Bottom

Note: You can combine the text alignments by adding the coding of the flags. For example, a vertical and horizontal centered text: `PLC_PRG.dwFontType := 5;`
The property controls the toggled color at runtime.

**Value assignment:**
- **FALSE:** The element is displayed with the color specified in the "Color" property.
- **TRUE:** The element is displayed with the color specified in the "Alarm color" property.

**Assigning the property:**
- Placeholder for the user input variable
  - "<toggle/tap variable>"
  - "<NOT toggle/tap variable>"

The color change is not controlled by its own variable, but by a user input variable.

Note: Specify a variable for the mouse events "Tap" or "Toggle" in the input configuration of the element. Only then is the placeholder set. If you configure a variable in both "Toggle" and "Tap", then the variable specified in "Tap" is used.

Hint: Click the symbol to insert the placeholder "<toggle/tap variable>". When you activate the "Input configuration", "Tap FALSE" property, then the "<NOT toggle/tap variable>" placeholder is displayed.

- Instance path of a project variable (BOOL)
  Example: PLC_PRG.xColorIsToggeled

Note: In the code, declare and implement the variable specified here. Its value assignment determines when the color changes.

---

**Color**

Color variable for the Frame
- Variable (DWORD) for the color
  Example: PLC_PRG.dwColor
- Color literal
  Example of gray and opaque: `16#FF888888`

**Requirement:** "Show Frame" property is activated.

Please note that the normal state is in effect if the expression in the "Colorvariables ➔ Toggle color" property is not defined or it has the value FALSE.

---

**Alarm color**

Color variable for the Frame in alarm state
- Variable (DWORD) for the alarm color
  Example: PLC_PRG.dwAlarmColor
- Color literal
  Example of red and opaque: `16#FFFF0000`

Please note that the alarm state is in effect if the expression in the "Colorvariables ➔ Toggle color" property has the value TRUE.

---

The transparency part of the color value is evaluated only if the “Activate semi-transparent drawing” option of the visualization manager is selected.

Select the “Advanced” option in the toolbar of the properties view. Then all element properties are visible.
The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>Property</th>
<th>Variable (BOOL). Toggles the visibility of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Invisible”</strong></td>
<td>TRUE: The element is not visible at runtime.</td>
</tr>
<tr>
<td></td>
<td>Example: bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Property</th>
<th>Variable (BOOL). Toggles the operability of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Deactivate inputs”</strong></td>
<td>TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.</td>
</tr>
</tbody>
</table>

The “Invisible” property is supported by the “Client Animation” functionality.

---

### Element property 'Button state variable'

**“Digital variable”**

At runtime, the property controls whether the Button is displayed as pressed or not.  
Values:  
- FALSE: The Button is displayed as not pressed.  
- TRUE: The Button is displayed as pressed.

Argument passed to the property:  
- Placeholder for the user input variable to couple the representation of the Button with the input variable.  
  - “<toggle/tap variable>”  
  - “<NOT toggle/tap variable>”  

Note: Specify a variable for the mouse events “Tap” or “Toggle” in the input configuration of the Button. Only then is the placeholder set. If you configure a variable in both “Toggle” and “Tap”, then the variable specified in “Tap” is used.

Hint: Click the symbol to insert the placeholder “<toggle/tap variable>”.  
When you activate the “Inputconfiguration”, “Tap FALSE” property, then the “<NOT toggle/tap variable>” placeholder is displayed.

- Instance path of a project variable (BOOL)  
  Example: prgA.xButtonState

Note: Implement a value assignment in the code for the variable specified here.

---

### Element property 'Image ID variable'
"Image ID"  
Variable (STRING). Contains the image ID. The contents of the string corresponds to the description of the "Static ID" property.

Example: PLC_PRG.stImageID := 'ImagePool_A.Image3';

See also
● § Chapter 6.4.5.21.5.5 “Visualization Element 'Image'” on page 3463
● § Chapter 6.4.1.21.2.15 “Object 'Image Pool’” on page 2468

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

"Animation duration"  
Defines the duration (in milliseconds) in which the element runs an animation

- Variable (integer value)

  Example: Menu.tContent with VAR tContent : INT := 500; END_VAR
- Integer literal

  Example: 500

Animatable properties

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

"Move to foreground"  
Moves the visualization element to the foreground

Variable (BOOL)

Example: bIsInForeground with VAR bIsInForeground : BOOL := TRUE; END_VAR

TRUE: At runtime, the visualization element is displayed in the foreground.
FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

Element property 'Input configuration'

The properties contain the configurations for the user input when using the mouse or keyboard. A user input defines an event and one or more actions that are executed when an event occurs.

The "Configure" button opens the "Input Configuration" dialog. There you can create or edit user inputs.

Configured user inputs are listed below the events. They each include the action that is triggered and the setting in short form.

Example: “Execute ST Code”: PLC_PRG.i_x := 0;

"OnDialogClosed"  
Input event: The user closes the dialog.

"OnMouseClick"  
Input event: The user clicks the mouse button completely in the element area. The mouse button is clicked and released.

"OnMouseDown"  
Input event: The user clicks down on the mouse button.

"OnMouseEnter"  
Input event: The user drags the mouse pointer to the element.

"OnMouseLeave"  
Input event: The user drags the mouse pointer away from the element.
**“OnMouseMove”**

Input event: The user moves the mouse pointer over the element area.

---

**“OnMouseUp”**

Input events:
- The user releases the mouse button within the element area. It is irrelevant whether the user has previously pressed the mouse button inside or outside the element area.
- The user presses the mouse button within the element area, leaves the element area, and then releases the mouse button.

Note: This CODESYS-specific triggering behavior guarantees that actions for key elements are completed. A key element starts an action for “OnMouseDown” and ends the action for “OnMouseUp”.

Example: A visualization user presses the mouse button within the element area of the key element and then moves the cursor position so that it lies outside the element area. The action is ended anyway because “OnMouseUp” is triggered.

---

**“Tap”**

When a mouse click event occurs, the variable defined in “Variable” is described in the application. The coding depends on the “Tap FALSE” and “Tap on enter if captured” options.

**“Variable”**

Variable (BOOL) that is set on mouse click event.

Example: PLC_PRG.bIsTapped

- **TRUE**: A mouse click event exists. It lasts as long as the user presses the mouse button over the element. It ends when the button is released.
- **FALSE**: A mouse click event does not exist.

Requirement: The “Tap FALSE” option is not activated.

**“Toggle”**

With the onset of a mouse click event, the variable is set; when the mouse click event is completed, the variable is reset.

**“Variable”**

Variable (BOOL). Its value toggled when the mouse click event is ended. This is when the user releases the mouse button while the mouse pointer is over the element area.

If the user releases the mouse button while the mouse pointer is outside of the element area, then the mouse click event is not ended and the value is not toggled.

Hint: The user can cancel a started toggle input by dragging the mouse pointer out of the element area.

**“Toggle on up if captured”**

- **TRUE**: The value toggles regardless of where the mouse pointer is when the mouse button is released. The mouse is then captured.
**Hotkey**
Keyboard shortcut on the element for triggering specific input actions. When the keyboard shortcut event occurs, the input actions in the “Events” property are triggered. In this way, it is not the input action itself that leads to this input action, but the mouse input action.

**Key**
Key pressed for input action.
Example: [T]
Note: The following properties appear when a key is selected.

**Events**
- “None”
- “Mouse down”: Pressing the key triggers the input actions that are configured in the “OnMouseDown” property.
- “Mouse up”: Releasing the key triggers the input actions that are configured in the “OnMouseUp” property.
- “Mouse down/up”: Pressing and releasing the key triggers the input actions that are configured in the “OnMouseDown” property and the “OnMouseUp” property.

**Shift**
☑: Combination with the Shift key
Example: [Shift]+[T].

**Control**
☑: Combination with the Ctrl key
Example: [Ctrl]+[T].

**Alt**
☑: Combination with the Alt key
Example: [Alt]+[T].

All keyboard shortcuts and their actions that are configured in the visualization are listed on the “Keyboard Configuration” tab.

See also
- ☀ Chapter 6.4.5.21.2.2 “Command ‘Keyboard Configuration’” on page 3341
- ☀ Chapter 6.4.5.21.3.6 “Dialog ‘Input Configuration’” on page 3370

**Element property ’Access rights’**
Requirement: User management is set up for the visualization.

**Access rights**
Opens the “Access rights” dialog. There you can edit the access privileges for the element.
Status messages:
- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also
- ☀ Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

**Visualization Element ‘Group Box’**
Symbol:
Category: “Common Controls”

The element provides a visual grouping of visualization elements. The group box can have multiple levels of nesting.

You can also use drag&drop to add elements to a “Group Box”. To do this, drag the element to the window area of the “Group Box”. The appearance of the cursor changes (a small plus sign is displayed). When you click the [Shift] key at the same time, the element is not added.

You can remove elements from the “Group Box” by dragging them out of the window area.

Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: Parameter axis 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Type of element”</th>
<th>“Group Box”</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Clipping”</td>
<td>Elements that protrude beyond the size of the group box are clipped.</td>
</tr>
</tbody>
</table>

Element property 'Position'

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels. Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels. Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Width”</th>
<th>Specified in pixels. Example: 150</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Height”</th>
<th>Specified in pixels. Example: 30</th>
</tr>
</thead>
</table>

You can also change the values by dragging the box symbols (✔️) to other positions in the editor.

See also

* Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

Element property 'Center'

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the 🔘 symbol. The point is used as the center for rotating and scaling.
“X”  
X-coordinate of the point of rotation

“Y”  
Y-coordinate of the point of rotation

You can also change the values by dragging the symbols (掴) to other positions in the editor.

Element property 'Texts'  
The properties contain character strings for labeling the element.
CODESYS accepts the specified texts automatically into the “GlobalTextList” text list. Therefore, these texts can be localized.

<table>
<thead>
<tr>
<th>“Text”</th>
<th>Character string (without single straight quotation marks) for the labeling the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example:</td>
<td>Axis 1.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Tooltip”</th>
<th>Character string (without single straight quotation marks) that is displayed as the tooltip of an element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example:</td>
<td>Parameters of Axis 1.</td>
</tr>
</tbody>
</table>

See also
● Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

Element property 'Text properties'  
The properties contain fixed values for the text properties.

| “Font”    | Example: “Default”  
|           | 🕒: The “Font” dialog box opens.  
|           | ▼: Drop-down list with style fonts. |

| “Font color” | Example: “Black”  
|             | 🕒: The “Color” dialog box opens.  
|             | ▼: Drop-down list with style colors. |

| “Transparency” | Whole number (value range from 0 to 255). This determines the transparency of the respective color.  
|                | Example: 255: The color is opaque.  
|                | 0: The color is completely transparent.  
|                | Please note: If the color is a style color and already has a transparency value, then this property is write-protected. |

Element property 'Absolute movement'  
The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.
## "Movement"

| **X** | Variable (numeric data type). Defines the X position (in pixels).  
Example: PLC_PRG.iPos_X.  
Increasing this value in runtime mode moves the element to the right. |
|-------|-------------------------------------------------------------------|
| **Y** | Variable (numeric data type). Defines the Y position (in pixels).  
Example: PLC_PRG.iPos_Y.  
Increasing this value in runtime mode moves the element downwards. |
| **Rotation** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
Example: PLC_PRG.iAngle1.  
The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.  
In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right. |
| **Scaling** | Variable (integer data type). Causes centric stretching.  
Example: PLC_PRG.iScaling.  
The reference point is the “Center” property.  
The value 1 shrinks the element by a factor of 0.001. The value 1000 returns the element to its original size. |
| **Interior rotation** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
Example: PLC_PRG.iAngle2.  
In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.  
The rotation point is shown as the symbol.  
Note: If a static angle of rotation is specified in the property “Position Angle”, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed. |

---

You can link the variables to a unit conversion.

The properties “X”, “Y”, “Rotation”, and “Interior rotation” are supported by the "Client Animation" functionality.
Element property "State variables"  The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Invisible&quot;</td>
<td>Variable (BOOL). Toggles the visibility of the element. TRUE: The element is not visible at runtime. Example: <code>bIsVisible</code> with <code>VAR bIsVisible : BOOL := FALSE; END_VAR</code></td>
</tr>
<tr>
<td>&quot;Deactivate inputs&quot;</td>
<td>Variable (BOOL). Toggles the operability of the element. TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.</td>
</tr>
</tbody>
</table>

The "Invisible" property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the "Support client animations and overlay of native elements" option in the Visualization Manager.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Animation duration&quot;</td>
<td>Defines the duration (in milliseconds) in which the element runs an animation variable (integer value) Example: <code>Menu.tContent</code> with <code>VAR tContent : INT := 500; END_VAR</code></td>
</tr>
<tr>
<td></td>
<td>Animatable properties</td>
</tr>
<tr>
<td></td>
<td>• &quot;Absolute movement&quot;, &quot;Movement&quot;, &quot;X&quot;, &quot;Y&quot;</td>
</tr>
<tr>
<td></td>
<td>• &quot;Absolute movement&quot;, &quot;Rotation&quot;</td>
</tr>
<tr>
<td></td>
<td>• &quot;Absolute movement&quot;, &quot;Interior rotation&quot;</td>
</tr>
<tr>
<td></td>
<td>• &quot;Absolute movement&quot;, &quot;Exterior rotation&quot;</td>
</tr>
<tr>
<td></td>
<td>The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.</td>
</tr>
<tr>
<td>&quot;Move to foreground&quot;</td>
<td>Moves the visualization element to the foreground variable (BOOL) Example: <code>bIsInForeground</code> with <code>VAR bIsInForeground : BOOL := FALSE; END_VAR</code></td>
</tr>
<tr>
<td></td>
<td>TRUE: At runtime, the visualization element is displayed in the foreground. FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.</td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
Visualization Element 'Table'

Symbol:

Category: “Common Controls”

The element displays data that can be represented as an array in a table. Therefore, the data type of the visualizing variable can be 1) a one-dimensional array, 2) a maximum two-dimensional array, 3) an array of an array, 4) an array of structures, or 5) an array of a function block.

**Element properties**

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: Data set component 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Type of element”</th>
<th>Table</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Data array”</th>
<th>Array whose data is visualized as a table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable (ARRAY) whose data type determines the number of columns and rows in the table</td>
<td></td>
</tr>
</tbody>
</table>

Array types

- One-dimensional array: The table has one column.
- Two-dimensional array: The second dimension determines the number of columns.
- Array of an array: The number of array elements of the back array determines the number of columns.
- Array of a structure: The number of structure members determines the number of columns.
- Array of a function block: The number of local variables determines the number of columns.

Example: PLC_PRG.aiTable

Declaration: aiTable : ARRAY[0..3, 0..4] OF INT := [4(1, 2, 3, 4, 5)];

Hint: If the declaration of the array changes, then the table can be refreshed by placing the cursor in the data array value field and pressing the [Enter] key.

<table>
<thead>
<tr>
<th>“Max. array index”</th>
<th>Top index limit for the displayed table. Limits the number of displayed rows. The index begins at 0.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable (integer data type)</td>
<td></td>
</tr>
</tbody>
</table>

Example: PLC_PRG.iUpperIndexBoundToDisplay |

- Integer literal

Example: 4 is displayed as 5 in the row of the table.

See also

- *Data Type 'ARRAY'*
**Element property 'Columns'**

The "Table" element shows the values of a variable in a tabular view. The array elements of structure members are shown in a column or in a row. Two-dimensional arrays or arrays of a structure are shown in multiple columns. The visualized variable is defined in the "Data array" property. When a variable is assigned there, you can specify the display of the Table columns where the array elements are shown. An individual configuration is possible for each column that is assigned to an index [<n>].

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Show row header&quot;</td>
<td>✓: The row header is visible. Example: For an array, the index of the array element is displayed in the header.</td>
</tr>
<tr>
<td>&quot;Show column header&quot;</td>
<td>✓: The column label is visible.</td>
</tr>
<tr>
<td>&quot;Row height&quot;</td>
<td>Height of the rows (in pixels)</td>
</tr>
<tr>
<td>&quot;Row header width&quot;</td>
<td>Width of the row label</td>
</tr>
<tr>
<td>&quot;Scroll bar size &quot;</td>
<td>Size of the scroll bar (in pixels)</td>
</tr>
</tbody>
</table>

**Table 719: "Element property 'Columns: Column [<n>]'"**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Column header&quot;</td>
<td>By default, the name of the array or structure is applied as the heading with the index or structure member for the column. If an array of a function block has been selected for &quot;Data array&quot;, then the name of the array is applied to the column header with the local variables of the function block that belong to the column. The column label can be changed here by specifying a new title.</td>
</tr>
<tr>
<td>&quot;Width&quot;</td>
<td>Column width (in pixels)</td>
</tr>
<tr>
<td>&quot;Image column&quot;</td>
<td>✓: Images can be displayed in the column. Images are used from the global image pool or custom image pools. The image IDs are shown in the cells of the Table as they are defined in the image pool.</td>
</tr>
<tr>
<td>&quot;Image configuration&quot;</td>
<td></td>
</tr>
</tbody>
</table>
| "Fill mode"          | • Fill cell: The image resizes to the dimensions of the cell without fixing the height/width ratio.  
                       | • Centered: The image is centered in the cell and retains its proportions (height/width ratio). |
| "Transparency"       | ✓: The color which is specified in "Transparent color" is displayed as transparent. |
| "Transparent color"  | This color is displayed as transparent.                                     
                       | Requirement: The "Transparency" property is activated.                     |
| "Text alignment of header" | Alignment of the column header:  
                                 | • Left  
                                 | • Centered  
                                 | • Right |
| "Use template"       | ✓: Another visualization element (type "Rectangle", "Rounded Rectangle", or "Ellipse") is inserted into each line of this Table column. The properties list is extended automatically with the properties of this element in "Template". |
| "Text alignment of the headline from the template" | Requirement: The "Use template" property is activated.  
                                                            | ✓: When activated, the settings for font (size) and alignment in the inserted template are also applied to the column header. |
| "Template"           | Requirement: The "Use template" property is activated.                     
                       | The properties of all elements assigned to the column are listed in "Template". They can be modified there as described in "Rectangle", "Rounded Rectangle", and "Ellipse". |
The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>X coordinate of the upper left corner of the element</td>
</tr>
<tr>
<td>Y</td>
<td>Y coordinate of the upper left corner of the element</td>
</tr>
<tr>
<td>Width</td>
<td>Specified in pixels</td>
</tr>
<tr>
<td>Height</td>
<td>Specified in pixels</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols ( ) to other positions in the editor.

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>X-coordinate of the point of rotation</td>
</tr>
<tr>
<td>Y</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols ( ) to other positions in the editor.

The properties contain fixed values for the text properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Horizontal alignment</td>
<td>Horizontal alignment of the text within the element.</td>
</tr>
<tr>
<td>Vertical alignment</td>
<td>Vertical alignment of the text within the element.</td>
</tr>
</tbody>
</table>
### Element property 'Dynamic texts'

Dynamic texts are variably indexed texts of a text list. At runtime, the text is displayed that is currently indexed in the variable.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Font</strong></td>
<td>Example: “Default”</td>
</tr>
<tr>
<td></td>
<td>- The “Font” dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>- Drop-down list with style fonts.</td>
</tr>
<tr>
<td><strong>Font color</strong></td>
<td>Example: “Black”</td>
</tr>
<tr>
<td></td>
<td>- The “Color” dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>- Drop-down list with style colors.</td>
</tr>
<tr>
<td><strong>Transparency</strong></td>
<td>Whole number (value range from 0 to 255). This determines the transparency of the respective color.</td>
</tr>
<tr>
<td></td>
<td>Example: 255: The color is opaque.</td>
</tr>
<tr>
<td></td>
<td>0: The color is completely transparent.</td>
</tr>
<tr>
<td></td>
<td>Please note: If the color is a style color and already has a transparency value, then this property is write-protected.</td>
</tr>
</tbody>
</table>

### Element property 'Text list'

Variable (string) or name of the text list as a fixed string in single straight quotation marks.

Example: 'Errorlist'

Drop-down list with the dialogs available in the text lists.

### Element property 'Text index'

Text list ID. This refers to the desired output text.

- As fixed string with the ID in single straight quotation marks.
  
  Example: '1'

- As a variable (STRING) for dynamically controlling the text output.
  
  Example: strTextID
  
  Sample assignment: PLC_PRG.strTextID := '1';

### Element property 'Tooltip index'

Text list ID. This refers to the desired output text.

- As fixed string with the ID in single straight quotation marks.
  
  Example: '2'

- As a variable (STRING) for dynamically controlling the text output.
  
  Example: strToolTipID
  
  Sample assignment: PLC_PRG.strToolTipID := '2';

See also

- ¶ Chapter 6.4.1.21.2.28 “Object 'Text List'” on page 2532

### Element property 'Font variables'

The variables enable dynamic control of the text display.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Font name</strong></td>
<td>Variable (STRING). Includes the font of the text.</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.stFontVar := 'Arial';</td>
</tr>
<tr>
<td></td>
<td>The selection of fonts corresponds to the default “Font” dialog box.</td>
</tr>
<tr>
<td><strong>Size</strong></td>
<td>Variable (integer data type). Contains the font size (in pixels).</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iFontHeight := 16;</td>
</tr>
<tr>
<td></td>
<td>The selection of font sizes corresponds to the default “Font” dialog box.</td>
</tr>
</tbody>
</table>
### “Flags”

Variable (DWORD). Contains the flags for displaying fonts.

**Flags:**
- 1: Italics
- 2: Bold
- 4: Underline
- 8: Strikethrough

Note: You can combine the font displays by adding the coding of the flags. For example, a bold and underlined text: `PLC_PRG.dwFontType := 6;`

### “Charset”

Variable (DWORD). Contains a character set number for the font.

The selection of character set numbers corresponds to the “Script” setting of the standard “Font” dialog box.

### “Color”

Variable (DWORD). Includes the color of the text.

Example: `PLC_PRG.dwColorFont := 16#FF000000;`

### “Flags for text alignment”

Variable (integer data type). Contains the coding for text alignment.

Example: `PLC_PRG.dwTextAlignment`.

**Coding:**
- 0: Top left
- 1: Horizontal center
- 2: Right
- 4: Vertical center
- 8: Bottom

Note: You can combine the text alignments by adding the coding of the flags. For example, a vertical and horizontal centered text: `PLC_PRG.dwFontType := 5;`

---

**Fixed values for displaying texts are set in “Text properties”.

See also
- § “Element property ‘Text properties’” on page 3541**

---

**Element property ‘Absolute movement’**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

### “Movement”

<table>
<thead>
<tr>
<th><strong>“X”</strong></th>
<th>Variable (numeric data type). Defines the X position (in pixels).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: <code>PLC_PRG.iPos_X.</code></td>
<td></td>
</tr>
<tr>
<td>Increasing this value in runtime mode moves the element to the right.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Y”</strong></th>
<th>Variable (numeric data type). Defines the Y position (in pixels).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: <code>PLC_PRG.iPos_Y.</code></td>
<td></td>
</tr>
<tr>
<td>Increasing this value in runtime mode moves the element downwards.</td>
<td></td>
</tr>
</tbody>
</table>
"Rotation" Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle1.

The midpoint of the element rotates at the "Center" point. This rotation point is shown as the ✱ symbol.

In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

"Interior rotation" Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in "Center" according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the ✱ symbol.

Note: If a static angle of rotation is specified in the "Position ➔ Angle" property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

You can link the variables to a unit conversion.

The "X", "Y", "Rotation", and "Interior rotation" properties are supported by the "Client Animation" functionality.

See also

- Element property 'State variables'

The variables control the element behavior dynamically.

"Invisible" Variable (BOOL). Toggles the visibility of the element.

TRUE: The element is not visible at runtime.

Example: bIsVisible with VAR bIsVisible : BOOL := FALSE;

END_VAR

"Deactivate inputs" Variable (BOOL). Toggles the operability of the element.

TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.
The “Invisible” property is supported by the “Client Animation” functionality.

### Element property ‘Selection’

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Background color on selection”</td>
<td>Fill color of the selected row.</td>
</tr>
<tr>
<td>“Selection font color”</td>
<td>Font color of the selected row.</td>
</tr>
<tr>
<td>“Selection type”</td>
<td>Selection when clicking the table row.</td>
</tr>
<tr>
<td></td>
<td>- No selection: No selection</td>
</tr>
<tr>
<td></td>
<td>- Cell selection: The clicked cell only.</td>
</tr>
<tr>
<td></td>
<td>- Row selection: Row of the clicked cell.</td>
</tr>
<tr>
<td></td>
<td>- Column selection: Column of the clicked cell.</td>
</tr>
<tr>
<td></td>
<td>- Row and column selection: Row and column of the clicked cell.</td>
</tr>
<tr>
<td>“Frame around selected cells”</td>
<td>☑: A frame is drawn around the selected cells.</td>
</tr>
<tr>
<td>“Variable for selected column”</td>
<td>Variable (INT). Contains the array index of the “Column” of the selected cell.</td>
</tr>
<tr>
<td></td>
<td>Warning: This index represents the correct position in the array only if no columns have been removed from the table in the display.</td>
</tr>
<tr>
<td>“Variable for selected row”</td>
<td>Variable (INT). Contains the array index of the “Row” of the selected cell.</td>
</tr>
<tr>
<td>“Variable for valid column selection”</td>
<td>Variable (BOOL). TRUE: The “Variable for selected column” variable contains a valid value.</td>
</tr>
</tbody>
</table>

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
**Animation duration**

Defines the duration (in milliseconds) in which the element runs an animation.

- Variable (integer value)
  
  *Example:* Menu.tContent with
  
  ```
  VAR tContent : INT := 500;
  END_VAR
  ```

- Integer literal
  
  *Example:* 500

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**Move to foreground**

Moves the visualization element to the foreground.

Variable (BOOL)

*Example:* bIsInForeground with

```
VAR bIsInForeground : BOOL := FALSE; END_VAR
```

**TRUE:** At runtime, the visualization element is displayed in the foreground.

**FALSE:** At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

**Requirement:** User management is set up for the visualization.

**Access rights**

Opens the “Access rights” dialog. There you can edit the access privileges for the element.

**Status messages:**

- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

**See also**

- § Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

**See also**

- § Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
- § Chapter 6.4.5.11.2 “Displaying Array Variables in Tables” on page 2917
- Data Type ‘ARRAY’

**Visualization Element ‘Text Field’**

**Symbol:**

<table>
<thead>
<tr>
<th>![Text Field Symbol]</th>
</tr>
</thead>
</table>

**Category:** “Common Controls”
The element is used for the following purposes:

- Static output of text. The contents of a variable can be part of the text.
- Showing a tooltip. The text is managed as static text and can also be defined so that the contents of a variable are also displayed.
- Dynamic output of text. Texts of a text list are displayed dynamically.
- Input of text. For example, a user can input a number or a text literal.

See also

- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

**Element properties**

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: FileName_A</td>
<td></td>
</tr>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
</tbody>
</table>

| “Type of element”      | “Text Field” |

**Element property ‘Position’**

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td>Example: 10</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td>Example: 10</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Width”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 150</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Height”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 30</td>
<td></td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (🚀) to other positions in the editor.

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

**Element property ‘Colors’**

<table>
<thead>
<tr>
<th>“Normal state”</th>
<th>The normal state is in effect if the variable in “Color variables ➔ Toggle color” is not defined or it has the value FALSE.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Frame color”</td>
<td>Frame and fill color for the corresponding state of the variable.</td>
</tr>
</tbody>
</table>
**“Fill color”**

Transparency value (0 to 255) for defining the transparency of the selected color. Example: 255: The color is opaque. 0: The color is completely transparent.

**“Transparency”**

Transparency value (0 to 255) for defining the transparency of the selected color. Example: 255: The color is opaque. 0: The color is completely transparent.

**“Alarm state”**

The alarm state is in effect if the variable in “Color variables ➔ Toggle color” has the value TRUE.

---

### Element property 'Appearance'

The properties contain fixed values for setting the look of the element.

<table>
<thead>
<tr>
<th>“Line width”</th>
<th>Value in pixels</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 2</td>
<td></td>
</tr>
</tbody>
</table>

Note: The values 0 and 1 both result in a line weight of 1 pixel. If no line should be displayed, then the “Line style” property must be set to the option “Invisible”.

<table>
<thead>
<tr>
<th>“Fill attributes”</th>
<th>The way in which the element is filled.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Filled”</td>
<td>The element is filled with the color from property “Colors ➔ Fill color”.</td>
</tr>
<tr>
<td>“Invisible”</td>
<td>The fill color is invisible.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Line style”</th>
<th>Type of line representation</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Solid”</td>
<td></td>
</tr>
<tr>
<td>“Dashes”</td>
<td></td>
</tr>
<tr>
<td>“Dots”</td>
<td></td>
</tr>
<tr>
<td>“Dash Dot”</td>
<td></td>
</tr>
<tr>
<td>“Dash Dot Dot”</td>
<td></td>
</tr>
<tr>
<td>“not visible”</td>
<td></td>
</tr>
</tbody>
</table>

You can assign variables in the “Appearance variables” property for controlling the appearance dynamically. The fixed values here are overwritten.

See also
- § Chapter 6.4.5.21.3.5 “Dialog ‘Gradient Editor’” on page 3369

---

### Element property 'Texts'

The properties contain character strings for labeling the element. The character string can also contain a placeholder with a format definition. In runtime mode, the placeholder is replaced by the current value in the specified format.

CODESYS accepts the specified texts automatically into the “GlobalTextList” text list. Therefore, these texts can be localized.

---

See also
- § “Element property 'Appearance variables’” on page 3489
| **“Text”** | Character string (without single straight quotation marks) for the labeling the element. Add a line break by pressing the keyboard shortcut [Ctrl] + [Enter].  
**Example:** Accesses: %i  
The variable that contains the current value for the placeholder is specified in the property “Text variable ⇒ Text”. |
| **“Tooltip”** | Character string (without single straight quotation marks) that is displayed as the tooltip of an element.  
**Example:** Number of valid accesses.  
The variable that contains the current value for the placeholder is specified in the property “Text variable ⇒ Tooltip”. |

**See also**
- “Element property ‘Text variables’” on page 3541
- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
- Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329

### Element property ‘Text properties’
The properties contain fixed values for the text properties.

| **“Horizontal alignment”** | Horizontal alignment of the text within the element. |
| **“Vertical alignment”** | Vertical alignment of the text within the element. |
| **“Text format”** | Definition for displaying texts that are too long  
- “Default”: The long text is truncated.  
- “Line break”: The text is split into parts.  
- “Ellipsis”: The visible text ends with “…” indicating that it is not complete. |
| **“Font”** | Example: “Default”  
[▶]: The “Font” dialog box opens.  
[▼]: Drop-down list with style fonts. |
| **“Font color”** | Example: “Black”  
[▶]: The “Color” dialog box opens.  
[▼]: Drop-down list with style colors. |
| **“Transparency”** | Whole number (value range from 0 to 255). This determines the transparency of the respective color.  
**Example:** 255: The color is opaque.  
0: The color is completely transparent.  
Please note: If the color is a style color and already has a transparency value, then this property is write-protected. |

**Element property ‘Text variables’**
These properties are variables with contents that replace a format definition.

---

2024/01/05 3ADR010583, 1, en_US 3541
"Text variable"

Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.

Example: PLC_PRG.iAccesses

Note: The format definition is part of the text in the property “Texts ➔ Text”.

Note: If you specify a variable of type enumeration with text list support, then the name of the enumeration data type is added automatically in angle brackets after the variable name. Example: PLC_PRG.enVar <enumeration name>. Then the symbolic value of the enumeration component is printed instead of the numeric value when text is printed. Refer to the help page for the enumerations.

"Tooltip variable"

Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.

Example: PLC_PRG.iAccessesInTooltip

Note: The format definition is part of the text in the property “Texts ➔ Tooltip”.

See also

- Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329
- “Element property ‘Texts’” on page 3540
- Chapter 6.4.1.20.5.18 “Enumerations” on page 2263

Element property 'Dynamic texts'

Dynamic texts are variably indexed texts of a text list. At runtime, the text is displayed that is currently indexed in the variable.

"Text list"

Variable (string) or name of the text list as a fixed string in single straight quotation marks.

Example: 'Errorlist'

♥: Drop-down list with the dialogs available in the text lists.

"Text index"

Text list ID. This refers to the desired output text.

- As fixed string with the ID in single straight quotation marks.
  Example: '1'
- As a variable (STRING) for dynamically controlling the text output.
  Example: strTextID
  Sample assignment: PLC_PRG.strTextID := '1';

"Tooltip index"

Text list ID. This refers to the desired output text.

- As fixed string with the ID in single straight quotation marks.
  Example: '2'
- As a variable (STRING) for dynamically controlling the text output.
  Example: strToolTipID
  Sample assignment: PLC_PRG.strToolTipID := '2';

See also

- Chapter 6.4.1.21.2.28 “Object ‘Text List’” on page 2532

Element property 'Font variables'

The variables allow for dynamic control of the text display.
| **“Font name”** | Variable (STRING). Includes the font of the text.  
Example: PLC_PRG.stFontVar := 'Arial';  
The selection of fonts corresponds to the default “Font” dialog. |
| **“Size”** | Variable (numeric data type). Contains the font size (in pixels or points). The applied unit is specified in brackets after the variable name.  
- `<pt>`: Points (default)  
  Example: PLC_PRG.iFontHeight <pt>  
  Code: iFontHeight : INT := 12;  
- `<px>`: Pixels  
  Example: PLC_PRG.iFontHeight <px>  
  Code: iFontHeight : INT := 19;  
If you click in the value field, a drop-down list opens on the right for setting the unit.  
Hint: The font size is specified in points (example: Arial 12). Use points when the variable font size should match a font, for example if a font is set in the property “Text property ➔ Font”. |
| **“Flags”** | Variable (DWORD). Contains the flags for displaying fonts.  
Flags:  
- 1: Italics  
- 2: Bold  
- 4: Underline  
- 8: Strikethrough  
Note: You can combine the font displays by adding the coding of the flags. For example, a bold and underlined text: PLC_PRG.dwFontType := 6; |
| **“Character set”** | Variable (DWORD). Contains a character set number for the font.  
The selection of character set numbers corresponds to the “Script” setting of the standard “Font” dialog. |
| **“Color”** | Variable (DWORD). Includes the color of the text.  
Example: PLC_PRG.dwColorFont := 16#FF000000; |
| **“Flags for text alignment”** | Variable (integer data type). Contains the coding for text alignment.  
Example: PLC_PRG.dwTextAlignment.  
Coding:  
- 0: Top left  
- 1: Horizontal center  
- 2: Right  
- 4: Vertical center  
- 8: Bottom  
Note: You can combine the text alignments by adding the coding of the flags. For example, a vertical and horizontal centered text: PLC_PRG.dwFontType := 5; |
Fixed values for displaying texts are set in “Text properties”.

See also

- “Element property ‘Text properties’” on page 3541

**Element property ‘Color variables’**

The Element property is used as an interface for project variables to dynamically control colors at runtime.

### “Toggle color”

The property controls the toggled color at runtime.

**Value assignment:**

- **FALSE**: The element is displayed with the color specified in the “Color” property.
- **TRUE**: The element is displayed with the color specified in the “Alarm color” property.

**Assignment options:**

- Placeholder for the user input variable
  - "<toggle/tap variable>"
  - "<NOT toggle/tap variable>"

  The color change is not controlled by its own variable, but by a user input variable.

  **Note:** Specify a variable for the mouse events “Tap” or “Toggle” in the input configuration of the element. Only then is the placeholder set. If you configure a variable in both “Toggle” and “Tap”, then the variable specified in “Tap” is used.

  **Hint:** Click the symbol to insert the placeholder "<toggle/tap variable>". When you activate the “Inputconfiguration”, “Tap FALSE” property, then the “<NOT toggle/tap variable>” placeholder is displayed.

- Instance path of a project variable (BOOL)
  - Example: PLC_PRG.xColorIsToggled

  **Note:** In the code, declare and implement the variable specified here. Its value assignment determines when the color changes.

### “Normal state”

**“Alarm state”**

The properties listed below control the color depending on the state. The normal state is in effect if the variable in “Color variables”, “Toggle color” is not defined or it has the value FALSE. The alarm state is in effect if the variable in “Colorvariables”, “Toggle color” has the value TRUE.

### “Frame color”

**Assignment options:**

- Variable (DWORD) for the frame color
  - Example: PLC_PRG.dwBorderColor
- Color literal
  - Example of green and opaque: 16#FF00FF00

### “Filling color”

**Assignment options:**

- Variable (DWORD) for the fill color
  - Example: PLC_PRG.dwFillColor
- Color literal
  - Example of gray and opaque: 16#FF888888
The transparency part of the color value is evaluated only if the "Activate semi-transparent drawing" option of the visualization manager is selected.

Select the "Advanced" option in the toolbar of the properties view. Then all element properties are visible.

See also
- Chapter 6.4.5.10.4 "Animating a color display" on page 2914

**Element property 'Absolute movement'**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>“Movement”</th>
<th>Variable (numeric data type). Defines the X position (in pixels).</th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
<td>Example: PLC_PRG.iPos_X. Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td>“Y”</td>
<td>Variable (numeric data type). Defines the Y position (in pixels).</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iPos_Y. Increasing this value in runtime mode moves the element downwards.</td>
</tr>
<tr>
<td>“Rotation”</td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iAngle1. The midpoint of the element rotates at the “Center” point. This rotation point is shown as the ⚫ symbol.</td>
</tr>
<tr>
<td></td>
<td>In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
</tr>
</tbody>
</table>
**“Interior rotation”**  
Variable (numeric data type). Defines the angle of rotation (in degrees).  
**Example:** PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

---

You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- Element property ‘State variables’
  
The variables control the element behavior dynamically.

**“Invisible”**  
Variable (BOOL). Toggles the visibility of the element.

**Example:**

```plaintext
bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR
```

**“Deactivate inputs”**  
Variable (BOOL). Toggles the operability of the element.

**Example:**

```plaintext
bIsDeactivate with VAR bIsDeactivate : BOOL := FALSE; END_VAR
```

The “Invisible” property is supported by the “Client Animation” functionality.

---

Element property ‘Selection and caret configuration’

The variables allow for controlling the caret position and the selection of the text.
### “Caret position”
Variable (integer data type). Contains the position of the cursor.

### “Selection start”
Variable (integer data type). Contains the position of the first selected character.
Example: PLC_PRG.iSelStart

### “Selection end”
Variable (integer data type). Contains the position of the last selected character.
Example: PLC_PRG.iSelEnd

### “All selected”
Variable (BOOL). Toggles the selection of the entered text.
- TRUE: The text in the text field is selected.
- FALSE: The selection starts with the value in “Selection start” and ends with “Selection end”.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

### “Animation duration”
Defines the duration (in milliseconds) in which the element runs an animation
- Variable (integer value)
  Example: Menu.tContent with VAR tContent : INT := 500; END_VAR
- Integer literal
  Example: 500

Animatable properties
- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”
The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

### “Move to foreground”
Moves the visualization element to the foreground
Variable (BOOL)
Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR
- TRUE: At runtime, the visualization element is displayed in the foreground.
- FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

### Element property ‘Input configuration’
The properties contain the configurations for the user input when using the mouse or keyboard.
A user input defines an event and one or more actions that are executed when an event occurs.

The “Configure” button opens the “Input Configuration” dialog. There you can create or edit user inputs.
Configured user inputs are listed below the events. They each include the action that is triggered and the setting in short form.
Example: “Execute ST Code”: PLC_PRG.i_x := 0;

### “OnDialogClosed”
Input event: The user closes the dialog.
### “OnMouseClick”
Input event: The user clicks the mouse button completely in the element area. The mouse button is clicked and released.

### “OnMouseDown”
Input event: The user clicks down on the mouse button.

### “OnMouseEnter”
Input event: The user drags the mouse pointer to the element.

### “OnMouseLeave”
Input event: The user drags the mouse pointer away from the element.

### “OnMouseMove”
Input event: The user moves the mouse pointer over the element area.

### “OnMouseUp”
Input events:
- The user releases the mouse button within the element area. It is irrelevant whether the user has previously pressed the mouse button inside or outside the element area.
- The user presses the mouse button within the element area, leaves the element area, and then releases the mouse button.

Note: This CODESYS-specific triggering behavior guarantees that actions for key elements are completed. A key element starts an action for “OnMouseDown” and ends the action for “OnMouseUp”.

Example: A visualization user presses the mouse button within the element area of the key element and then moves the cursor position so that it lies outside the element area. The action is ended anyway because “OnMouseUp” is triggered.

### “Tap”
When a mouse click event occurs, the variable defined in “Variable” is described in the application. The coding depends on the “Tap FALSE” and “Tap on enter if captured” options.

### “Variable”
Variable (BOOL) that is set on mouse click event.

**Example**: FLC_PRG.bIsTapped

**TRUE**: A mouse click event exists. It lasts as long as the user presses the mouse button over the element. It ends when the button is released.

**FALSE**: A mouse click event does not exist.

**Requirement**: The “Tap FALSE” option is not activated.

### “Tap FALSE”
☑: The mouse click event leads to a complementary value in “Variable”.

**TRUE**: A mouse click event does not exist.

**FALSE**: While the mouse click event exists.

### “Tap on enter if captured”
☑: During user input, it is also taken into consideration whether the mouse pointer is dragged within the element area or not while the mouse button is pressed.

**TRUE**: While the mouse click event exists and the mouse pointer is moved over the element area.

**FALSE**: A mouse click event does not exist. Or the user moves the mouse pointer outside of the element area while the mouse button is pressed.

The value is TRUE again as soon as the user moves the pointer back to the element area. The mouse is then captured.
| **"Toggle"** | With the onset of a mouse click event, the variable is set; when the mouse click event is completed, the variable is reset. |
| **"Variable"** | Variable (BOOL). Its value toggled when the mouse click event is ended. This is when the user releases the mouse button while the mouse pointer is over the element area. If the user releases the mouse button while the mouse pointer is outside of the element area, then the mouse click event is not ended and the value is not toggled. Hint: The user can cancel a started toggle input by dragging the mouse pointer out of the element area. |
| **"Toggle on up if captured"** | ☑: The value toggles regardless of where the mouse pointer is when the mouse button is released. The mouse is then captured. |

| **"Hotkey"** | Keyboard shortcut on the element for triggering specific input actions. When the keyboard shortcut event occurs, the input actions in the "Events" property are triggered. In this way, it is not the input action itself that leads to this input action, but the mouse input action. |

| **"Key"** | Key pressed for input action. Example: [T] Note: The following properties appear when a key is selected. |

| **"Events"** | ● "None" ● "Mouse down": Pressing the key triggers the input actions that are configured in the "OnMouseDown" property. ● "Mouse up": Releasing the key triggers the input actions that are configured in the "OnMouseUp" property. ● "Mouse down/up": Pressing and releasing the key triggers the input actions that are configured in the "OnMouseDown" property and the "OnMouseUp" property. |

| **"Shift"** | ☑: Combination with the Shift key Example: [Shift]+[T]. |
| **"Control"** | ☑: Combination with the Ctrl key Example: [Ctrl]+[T]. |
| **"Alt"** | ☑: Combination with the Alt key Example: [Alt]+[T]. |

All keyboard shortcuts and their actions that are configured in the visualization are listed on the "Keyboard Configuration" tab.

See also
- ☓ Chapter 6.4.5.21.2.2 “Command ‘Keyboard Configuration’” on page 3341
- ☓ Chapter 6.4.5.21.3.6 “Dialog ‘Input Configuration’” on page 3370

Requirement: User management is set up for the visualization.
“Access rights” opens the “Access rights” dialog. There you can edit the access privileges for the element.

Status messages:
- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also
- “Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

Visualization Element ‘Scroll Bar’

Symbol:

Category: “Common Controls”

The element sets the value of a variable, depending on the position of the scroll bar.

Element properties

- **“Element name”**
  - Example: Speed Conveyor Belt 1
  - Optional
  - Hint: Assign individual names for elements so that they are found faster in the element list.

- **“Type of element”**
  - “Scroll Bar”

Element property ‘Center’

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

- **“X”**
  - X-coordinate of the point of rotation

- **“Y”**
  - Y-coordinate of the point of rotation

You can also change the values by dragging the symbols ( Española ) to other positions in the editor.

- **“Value”**
  - Variable as type integer that includes the position of the scroll bar.

- **“Minimum value”**
  - Smallest value of the scroll bar (fixed value or variable).

- **“Maximum value”**
  - Largest value of the scroll bar (fixed value or variable).
**“Page size”**

<table>
<thead>
<tr>
<th>Page size</th>
</tr>
</thead>
<tbody>
<tr>
<td>- As a fixed value, for example 10</td>
</tr>
<tr>
<td>- As a variable of data type integer</td>
</tr>
</tbody>
</table>

Requirement: Visible when the “Move to click” property is **not** selected.

**“Move to click”**

<table>
<thead>
<tr>
<th>Behavior of the scroll bar at visualization runtime when it is clicked:</th>
</tr>
</thead>
<tbody>
<tr>
<td>✅: The scrollbar moves to the clicked position.</td>
</tr>
<tr>
<td>☐: The scrollbar moves to one “Page size” in the direction of the click.</td>
</tr>
</tbody>
</table>

**Element property ‘Position’**

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

**“X”**

<table>
<thead>
<tr>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in pixels.</td>
</tr>
<tr>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

**“Y”**

<table>
<thead>
<tr>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in pixels.</td>
</tr>
<tr>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

**“Width”**

<table>
<thead>
<tr>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 150</td>
</tr>
</tbody>
</table>

**“Height”**

<table>
<thead>
<tr>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (_drag-) to other positions in the editor.

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

**Element property ‘Bar’**

The property defines the representation of scaling and direction of travel.
### Element property 'Colors'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Color</strong></td>
<td>Color for the element in its normal state.</td>
</tr>
<tr>
<td></td>
<td>Please note that the normal state is in effect if the expression in the</td>
</tr>
<tr>
<td></td>
<td>“Color variables ➔ Toggle color” property is not defined or it has the value</td>
</tr>
<tr>
<td></td>
<td>FALSE.</td>
</tr>
<tr>
<td><strong>Alarm color</strong></td>
<td>Color for the element in alarm state.</td>
</tr>
<tr>
<td></td>
<td>Please note that the alarm state is in effect if the expression in the</td>
</tr>
<tr>
<td></td>
<td>“Color variables ➔ Toggle color” property has the value TRUE.</td>
</tr>
<tr>
<td><strong>Transparency</strong></td>
<td>Value (0 to 255) for defining the transparency of the selected color.</td>
</tr>
<tr>
<td></td>
<td>Example 255: The color is opaque. 0: The color is completely transparent.</td>
</tr>
</tbody>
</table>

See also

- § Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

### Element property 'Texts'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Text</strong></td>
<td>Character string (without single straight quotation marks) for the labeling</td>
</tr>
<tr>
<td></td>
<td>the element. Add a line break by pressing the keyboard shortcut [Ctrl] + [Enter].</td>
</tr>
<tr>
<td></td>
<td>Example: Accesses: %i</td>
</tr>
<tr>
<td></td>
<td>The variable that contains the current value for the placeholder is specified in the property “Text variable ➔ Text”.</td>
</tr>
<tr>
<td><strong>Tooltip</strong></td>
<td>Character string (without single straight quotation marks) that is displayed as the tooltip of an element.</td>
</tr>
<tr>
<td></td>
<td>Example: Number of valid accesses.</td>
</tr>
<tr>
<td></td>
<td>The variable that contains the current value for the placeholder is specified in the property “Text variable ➔ Tooltip”.</td>
</tr>
</tbody>
</table>
Element property 'Text properties'

The properties contain fixed values for the text properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Horizontal alignment&quot;</td>
<td>Horizontal alignment of the text within the element.</td>
</tr>
<tr>
<td>&quot;Vertical alignment&quot;</td>
<td>Vertical alignment of the text within the element.</td>
</tr>
<tr>
<td>&quot;Font&quot;</td>
<td>Example: “Default”&lt;br&gt;The “Font” dialog box opens.&lt;br&gt;▼: Drop-down list with style fonts.</td>
</tr>
<tr>
<td>&quot;Font color&quot;</td>
<td>Example: “Black”&lt;br&gt;The “Color” dialog box opens.&lt;br&gt;▼: Drop-down list with style colors.</td>
</tr>
<tr>
<td>&quot;Transparency&quot;</td>
<td>Whole number (value range from 0 to 255). This determines the transparency of the respective color.&lt;br&gt;Example: 255: The color is opaque.&lt;br&gt;0: The color is completely transparent.&lt;br&gt;Please note: If the color is a style color and already has a transparency value, then this property is write-protected.</td>
</tr>
</tbody>
</table>

Element property 'Text variables'

These properties are variables with contents that replace a format definition.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Text variable&quot;</td>
<td>Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.&lt;br&gt;Example: PLC_PRG.iAccesses&lt;br&gt;Note: The format definition is part of the text in the property “Texts ➔ Text”.&lt;br&gt;Note: If you specify a variable of type enumeration with text list support, then the name of the enumeration data type is added automatically in angle brackets after the variable name. Example: PLC_PRG.enVar &lt;enumeration name&gt;. Then the symbolic value of the enumeration component is printed instead of the numeric value when text is printed. Refer to the help page for the enumerations.</td>
</tr>
<tr>
<td>&quot;Tooltip variable&quot;</td>
<td>Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.&lt;br&gt;Example: PLC_PRG.iAccessesInTooltip&lt;br&gt;Note: The format definition is part of the text in the property “Texts ➔ Tooltip”.</td>
</tr>
</tbody>
</table>

See also

- "Element property 'Text variables’” on page 3553
- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
- Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329
- Chapter 6.4.1.20.5.18 “Enumerations” on page 2263
### Element property 'Dynamic texts'

Dynamic texts are variably indexed texts of a text list. At runtime, the text is displayed that is currently indexed in the variable.

| **“Text list”** | Variable (string) or name of the text list as a fixed string in single straight quotation marks.  
Example: 'Errorlist'  
▼: Drop-down list with the dialogs available in the text lists. |
|-----------------|---------------------------------------------------------------------------------------------------------------|
| **“Text index”** | Text list ID. This refers to the desired output text.  
● As fixed string with the ID in single straight quotation marks.  
Example: '1'  
● As a variable (STRING) for dynamically controlling the text output.  
Example: strTextID  
Sample assignment: PLC_PRG.strTextID := '1'; |
| **“Tooltip index”** | Text list ID. This refers to the desired output text.  
● As fixed string with the ID in single straight quotation marks.  
Example: '2'  
● As a variable (STRING) for dynamically controlling the text output.  
Example: strToolTipID  
Sample assignment: PLC_PRG.strToolTipID := '2'; |

See also
- § Chapter 6.4.1.21.2.28 “Object 'Text List'” on page 2532

### Element property 'Font variables'

The variables allow for dynamic control of the text display.

| **“Font name”** | Variable (STRING). Includes the font of the text.  
Example: PLC_PRG.stFontVar := 'Arial';  
The selection of fonts corresponds to the default “Font” dialog. |
|-----------------|---------------------------------------------------------------------------------------------------------------|
| **“Size”**      | Variable (numeric data type). Contains the font size (in pixels or points). The applied unit is specified in brackets after the variable name.  
● <pt>: Points (default)  
Example: PLC_PRG.iFontHeight <pt>  
Code: iFontHeight : INT := 12;  
● <px>: Pixels  
Example: PLC_PRG.iFontHeight <px>  
Code: iFontHeight : INT := 19; |

If you click in the value field, a drop-down list opens on the right for setting the unit.

Hint: The font size is specified in points (example: Arial 12). Use points when the variable font size should match a font, for example if a font is set in the property “Text property ➔ Font”.

---

Configuration and programming  
Programming with CODESYS > CODESYS Visualization  
2024/01/05  
3ADR010583, 1, en_US  
3554
### Flags

Variable (DWORD). Contains the flags for displaying fonts.

**Flags:**
- 1: Italics
- 2: Bold
- 4: Underline
- 8: Strikethrough

*Note:* You can combine the font displays by adding the coding of the flags. For example, a bold and underlined text: `PLC_PRG.dwFontType := 6;`

### Character set

Variable (DWORD). Contains a character set number for the font.

The selection of character set numbers corresponds to the “Script” setting of the standard “Font” dialog.

### Color

Variable (DWORD). Includes the color of the text.

*Example:* `PLC_PRG.dwColorFont := 16#FF000000;`

### Flags for text alignment

Variable (integer data type). Contains the coding for text alignment.

*Example:* `PLC_PRG.dwTextAlignment.`

**Coding:**
- 0: Top left
- 1: Horizontal center
- 2: Right
- 4: Vertical center
- 8: Bottom

*Note:* You can combine the text alignments by adding the coding of the flags. For example, a vertical and horizontal centered text: `PLC_PRG.dwFontType := 5;`

---

**Fixed values for displaying texts are set in "Text properties".**

See also
- "$Element property 'Text properties'" on page 3541

---

**Element property 'Color variables'**

The Element property is used as an interface for project variables to dynamically control colors at runtime.
### “Toggle color”

The property controls the toggled color at runtime.

**Value assignment:**

- **FALSE:** The element is displayed with the color specified in the “Color” property.
- **TRUE:** The element is displayed with the color specified in the “Alarm color” property.

**Assignment options:**

- Placeholder for the user input variable
  - “<toggle/tap variable>”
  - “<NOT toggle/tap variable>”

  The color change is not controlled by its own variable, but by a user input variable.

  Note: Specify a variable for the mouse events “Tap” or “Toggle” in the input configuration of the element. Only then is the placeholder set. If you configure a variable in both “Toggle” and “Tap”, then the variable specified in “Tap” is used.

  Hint: Click the symbol to insert the placeholder “<toggle/tap variable>”. When you activate the “Input configuration”, “Tap FALSE” property, then the “<NOT toggle/tap variable>” placeholder is displayed.

- Instance path of a project variable (BOOL)
  Example: PLC_PRG.xColorIsToggeled

  Note: In the code, declare and implement the variable specified here. Its value assignment determines when the color changes.

### “Normal state”

**Alarm state**

The properties listed below control the color depending on the state. The normal state is in effect if the variable in “Color variables”, “Toggle color” is not defined or it has the value FALSE. The alarm state is in effect if the variable in “Color variables”, “Toggle color” has the value TRUE.

### “Frame color”

**Assignment options:**

- Variable (DWORD) for the frame color
  Example: PLC_PRG.dwBorderColor

- Color literal
  Example of green and opaque: 16#FF00FF00

### “Filling color”

**Assignment options:**

- Variable (DWORD) for the fill color
  Example: PLC_PRG.dwFillColor

- Color literal
  Example of gray and opaque: 16#FF888888

---

The transparency part of the color value is evaluated only if the “Activate semi-transparent drawing” option of the visualization manager is selected.

Select the “Advanced” option in the toolbar of the properties view. Then all element properties are visible.

---

See also

- Chapter 6.4.5.10.4 “Animating a color display” on page 2914
The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

### “Movement”

#### “X”
Variable (numeric data type). Defines the X position (in pixels).

**Example:** PLC_PRG.iPos_X.

Increasing this value in runtime mode moves the element to the right.

#### “Y”
Variable (numeric data type). Defines the Y position (in pixels).

**Example:** PLC_PRG.iPos_Y.

Increasing this value in runtime mode moves the element downwards.

### “Rotation”
Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** PLC_PRG.iAngle1.

The midpoint of the element rotates at the “Center” point. This rotation point is shown as the ➕ symbol.

In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

### “Interior rotation”
Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the ➕ symbol.

Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

---

You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also
The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Invisible&quot;</td>
<td>Variable (BOOL). Toggles the visibility of the element. TRUE: The element is not visible at runtime. Example: <code>bIsVisible := FALSE;</code> END_VAR</td>
</tr>
<tr>
<td>&quot;Deactivate inputs&quot;</td>
<td>Variable (BOOL). Toggles the operability of the element. TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.</td>
</tr>
</tbody>
</table>

The "Invisible" property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the "Support client animations and overlay of native elements" option in the Visualization Manager.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Animation duration&quot;</td>
<td>Defines the duration (in milliseconds) in which the element runs an animation</td>
</tr>
<tr>
<td></td>
<td>- Variable (integer value)</td>
</tr>
<tr>
<td></td>
<td>Example: <code>Menu.tContent := 500;</code> END_VAR</td>
</tr>
<tr>
<td></td>
<td>- Integer literal</td>
</tr>
<tr>
<td></td>
<td>Example: 500</td>
</tr>
<tr>
<td>Animatable properties</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- &quot;Absolute movement&quot;, &quot;Movement&quot;, &quot;X&quot;, &quot;Y&quot;</td>
</tr>
<tr>
<td></td>
<td>- &quot;Absolute movement&quot;, &quot;Rotation&quot;</td>
</tr>
<tr>
<td></td>
<td>- &quot;Absolute movement&quot;, &quot;Interior rotation&quot;</td>
</tr>
<tr>
<td></td>
<td>- &quot;Absolute movement&quot;, &quot;Exterior rotation&quot;</td>
</tr>
</tbody>
</table>

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Move to foreground&quot;</td>
<td>Moves the visualization element to the foreground</td>
</tr>
<tr>
<td></td>
<td>Variable (BOOL)</td>
</tr>
<tr>
<td></td>
<td>Example: <code>bIsInForeground := FALSE;</code> END_VAR</td>
</tr>
<tr>
<td></td>
<td>TRUE: At runtime, the visualization element is displayed in the foreground.</td>
</tr>
<tr>
<td></td>
<td>FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.</td>
</tr>
</tbody>
</table>

Element property 'Access rights'

Requirement: User management is set up for the visualization.
“Access rights” dialog. There you can edit the access privileges for the element.

Status messages:
● **“Not set. Full rights.”**: Access rights for all user groups: “operable”
● **“Rights are set: Limited rights.”**: Access is restricted for at least one group.

See also
● § Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

See also
● § Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

Visualization Element 'Slider'

Symbol:

Category: “Common Controls”
The element changes the value of a variable, depending on the position of the slider within the slider bar. You define the value range of the slider bar by means of the scale start and scale end.

Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: Speed controller conveyor belt 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
</tbody>
</table>

| “Type of element”    | “Slider”                                  |

Element property 'Position'
The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in pixels.</td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in pixels.</td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Width”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 150</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Height”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 30</td>
<td></td>
</tr>
</tbody>
</table>
You can also change the values by dragging the box symbols ( شيئ) to other positions in the editor.

See also
- Chapter 6.4.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

**Element property ‘Center’**

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the (��) symbol. The point is used as the center for rotating and scaling.

| “X” | X-coordinate of the point of rotation |
| “Y” | Y-coordinate of the point of rotation |

You can also change the values by dragging the symbols (��) to other positions in the editor.

| “Variable” | Variable (numeric data type) |
| Example: PLC_PRG.rSlider |
| When executed, the variable assigns a value that corresponds to the position of the slider in the bar. |

| “Page size” | Page size |
| As a fixed value, for example 10 |
| As an IEC variable of data type integer |
| Requirement: The “Move to click” element property is not selected. |

| “Move to click” | Behavior of the slider at visualization runtime when it is clicked: |
| ✅: The slider moves to the clicked position. |
| ❌: The slider moves to the value (defined in the “Page size” element property) in the direction of the click. |

**Element property ‘Scale’**

| “Show scale” | ✅: The element has a visible scale. |
| Note: This option is available for the “Slider” only. |

<p>| “Scale start” | Least value of the scale and the lower limit of the value range for the element. |
| Example: 0 |
| ✉: The property “Variable” is shown below. |</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example</th>
<th>Declaration</th>
</tr>
</thead>
</table>
| Variable           | Variable (integer data type). Contains the scale start.                     | PLC_PRG.iScaleStart                                                      | ```
PROGRAM PLC_PRG
VAR
  iScaleStart : INT := 0;
END_VAR``` |
| Scale end          | Greatest value of the scale and the upper limit of the value range for the element. | 100                                                                      | ```
PROGRAM PLC_PRG
VAR
  iScaleEnd : INT := 120;
END_VAR``` |
| Main scale         | Distance between two tick marks on the rough scale.                         | 10                                                                      | ```
PROGRAM PLC_PRG
VAR
  iMainScale : INT := 20;
END_VAR``` |
| Subscale           | Distance between two dashes on the fine scale. You can hide the fine scale by setting the value to 0. | 2                                                                        | ```
PROGRAM PLC_PRG
VAR
  iMainScale : INT := 5;
END_VAR``` |
| Scale format (C Syntax) | Formatting of the scale label (example: %d %s)                                      |                                                                           |                                                                           |
| Scale proportion   | Size of the scale (in %) of the total size                                     |                                                                           |                                                                           |
Element property 'Bar'

The property defines the representation of scaling and direction of travel.

"Diagram type"  The drop-down list varies depending on the alignment of the diagram.

Horizontal
  ● "Top": Scale is above the slider.
  ● "Bottom": Scale is below the slider.
  ● "Top and bottom": Two scales frame the slider above and below.

Vertical
  ● Left: Scale is left of the slider.
  ● Right: Scale is right of the slider.
  ● Left and right: Two scales frame the slider on the left and the right.

"Orientation"  Alignment of the slider; defined by the ratio of width to height.

  ● "Horizontal"
  ● "Vertical"

You can modify the alignment in the visualization editor by using the pointing device to adjust the width and height of the scrollbar.

"Running direction"  The drop-down list varies depending on the alignment of the slider.

Horizontal
  ● "Left to right": Scale starts at the left.
  ● "Right to left": Scale starts at the right.

Vertical
  ● "Bottom to top": Scale starts at the bottom.
  ● "Top to bottom": Scale starts at the top.

Element property 'Absolute movement'

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

"Movement"

"X"  Variable (numeric data type). Defines the X position (in pixels).

Example: PLC_PRG.iPos_X.
Increasing this value in runtime mode moves the element to the right.

"Y"  Variable (numeric data type). Defines the Y position (in pixels).

Example: PLC_PRG.iPos_Y.
Increasing this value in runtime mode moves the element downwards.
“Rotation” Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle1.

The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.

In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

“Interior rotation” Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

“Invisible” Variable (BOOL). Toggles the visibility of the element.

TRUE: The element is not visible at runtime.

Example: bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR

“Deactivate inputs” Variable (BOOL). Toggles the operability of the element.

TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.
The “Invisible” property is supported by the “Client Animation” functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

**“Animation duration”**

Defines the duration (in milliseconds) in which the element runs an animation

- Variable (integer value)
  - **Example:** `Menu.tContent with VAR tContent : INT := 500; END_VAR`
- Integer literal
  - **Example:** `500`

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**“Move to foreground”**

Moves the visualization element to the foreground

- Variable (BOOL)
  - **Example:**  
  ```plaintext
  bIsInForeground with  
  VAR bIsInForeground : BOOL := FALSE; END_VAR
  
  TRUE: At runtime, the visualization element is displayed in the foreground.
  
  FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.
  ```

**Element property ‘Access rights’**

Requirement: User management is set up for the visualization.

**“Access rights”**

Opens the “Access rights” dialog. There you can edit the access privileges for the element.

- **Status messages:**
  - “Not set. Full rights.”: Access rights for all user groups: “operable”
  - “Rights are set: Limited rights”: Access is restricted for at least one group.

See also

- ☞ Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

See also

- ☞ Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
Visualization Element ‘Spin Box’

Symbol: 📈

Category: “Common Controls”
The element increments or decrements the value of a variable in defined intervals.

Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: Speed controller conveyor belt</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Type of element”</th>
<th>“Spin Box”</th>
</tr>
</thead>
</table>

Element property ‘Position’
The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Width”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 150</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Height”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (_drag_box_ to other positions in the editor.

See also
- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

Element property ‘Center’
The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the 🎉 symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y-coordinate of the point of rotation</th>
</tr>
</thead>
</table>
You can also change the values by dragging the symbols (跑了) to other positions in the editor.

<table>
<thead>
<tr>
<th>&quot;Variable&quot;</th>
<th>Variable (numeric data type)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: PLC_PRG.iTemp</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Number format&quot;</th>
<th>Format of the value in printf syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: %d, %5.2f</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Interval&quot;</th>
<th>Interval used for modification of the value</th>
</tr>
</thead>
</table>

### Element property 'Value range'

<table>
<thead>
<tr>
<th>&quot;Minimum value&quot;</th>
<th>Lower limit of the output value</th>
</tr>
</thead>
<tbody>
<tr>
<td>• fixed value</td>
<td></td>
</tr>
<tr>
<td>• Variable (INT)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Maximum value&quot;</th>
<th>Upper limit of the output value</th>
</tr>
</thead>
<tbody>
<tr>
<td>• fixed value</td>
<td></td>
</tr>
<tr>
<td>• Variable (INT)</td>
<td></td>
</tr>
</tbody>
</table>

### Element property 'Text properties'

The properties contain fixed values for the text properties.

<table>
<thead>
<tr>
<th>&quot;Usage of&quot;</th>
<th>&quot;Default style values&quot;: The values of the visualization style are used.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• &quot;Individual settings&quot;: The &quot;Individual text properties&quot; property group is shown</td>
<td></td>
</tr>
<tr>
<td>The values can be customized here.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Individual text properties&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requirement: The &quot;Individual settings&quot; text property is defined.</td>
</tr>
</tbody>
</table>

| "Horizontal alignment" | Horizontal alignment of the text within the element. |
| "Vertical alignment" | Vertical alignment of the text within the element. |

<table>
<thead>
<tr>
<th>&quot;Font&quot;</th>
<th>Example: &quot;Default&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>▼: The &quot;Font&quot; dialog box opens.</td>
<td></td>
</tr>
<tr>
<td>▼: Drop-down list with style fonts.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Font color&quot;</th>
<th>Example: &quot;Black&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>▼: The &quot;Color&quot; dialog box opens.</td>
<td></td>
</tr>
<tr>
<td>▼: Drop-down list with style colors.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Transparency&quot;</th>
<th>Whole number (value range from 0 to 255). This determines the transparency of the respective color.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 255: The color is opaque.</td>
<td></td>
</tr>
<tr>
<td>0: The color is completely transparent.</td>
<td></td>
</tr>
<tr>
<td>Please note: If the color is a style color and already has a transparency value, then this property is write-protected.</td>
<td></td>
</tr>
</tbody>
</table>
The Element property is used as an interface for project variables to dynamically control colors at runtime.

### "Toggle color"

The property controls the toggled color at runtime.

**Value assignment:**
- **FALSE:** The element is displayed with the color specified in the "Color" property.
- **TRUE:** The element is displayed with the color specified in the "Alarm color" property.

**Assigning the property:**
- Placeholder for the user input variable
  - "<toggle/tap variable>"
  - "<NOT toggle/tap variable>"

  The color change is not controlled by its own variable, but by a user input variable.

  **Note:** Specify a variable for the mouse events "Tap" or "Toggle" in the input configuration of the element. Only then is the placeholder set. If you configure a variable in both "Toggle" and "Tap", then the variable specified in "Tap" is used.

  **Hint:** Click the symbol to insert the placeholder "<toggle/tap variable>". When you activate the "Inputconfiguration", "Tap FALSE" property, then the "<NOT toggle/tap variable>" placeholder is displayed.

- **Instance path of a project variable (BOOL)**
  
  **Example:** PLC_PRG.xColorIsToggeled

  **Note:** In the code, declare and implement the variable specified here. Its value assignment determines when the color changes.

---

The transparency part of the color value is evaluated only if the “Activate semi-transparent drawing” option of the visualization manager is selected.

Select the “Advanced” option in the toolbar of the properties view. Then all element properties are visible.

See also
- % Chapter 6.4.5.10.4 “Animating a color display” on page 2914

---

### Element property 'Absolute movement'

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>&quot;Movement&quot;</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>&quot;X&quot;</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
</tr>
</tbody>
</table>
**Example:** PLC_PRG.iPos_X. 

Increasing this value in runtime mode moves the element to the right.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Variable (numeric data type). Defines the Y position (in pixels).</td>
<td>PLC_PRG.iPos_Y</td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
</tr>
<tr>
<td>“Rotation”</td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
<td>PLC_PRG.iAngle1</td>
<td>The midpoint of the element rotates at the “Center” point. The rotation point is shown</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>as the symbol.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>In runtime mode, the alignment of the element remains the same with respect to the</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>coordinate system of the visualization. Increasing the value rotates the element to the</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>right.</td>
</tr>
<tr>
<td>“Interior rotation”</td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
<td>PLC_PRG.iAngle2</td>
<td>In runtime mode, the element rotates about the point of rotation specified in “Center”</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>according to the value of the variable. In addition, the alignment of the element rotates</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>according to the coordinate system of the visualization. Increasing the value in the</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>code rotates clockwise.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The rotation point is shown as the symbol.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Note: If a static angle of rotation is specified in the “Position ➔ Angle” property,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>then the static angle of rotation is added to the variable angle of rotation (offset)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>when the visualization is executed.</td>
</tr>
</tbody>
</table>

You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- Element property 'State variables'

The variables control the element behavior dynamically.
"Invisible" Variable (BOOL). Toggles the visibility of the element.
TRUE: The element is not visible at runtime.
Example:

```
bIsVisible := FALSE;
```

"Deactivate inputs" Variable (BOOL). Toggles the operability of the element.
TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.

The "Invisible" property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

"Animation duration" Defines the duration (in milliseconds) in which the element runs an animation
- Variable (integer value)
  Example:
  ```
  Menu.tContent := 500;
  ```
- Integer literal
  Example: 500

Animatable properties
- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

"Move to foreground" Moves the visualization element to the foreground
Variable (BOOL)
Example:

```
bIsInForeground := FALSE;
```

TRUE: At runtime, the visualization element is displayed in the foreground.
FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

The properties contain the configurations for the user input when using the mouse or keyboard. User input is a user event from the perspective of the element.

The input configuration refers to the text area of the element only, not the two buttons.
The “Configure” button opens the “Input configuration” dialog box for creating or modifying a user input configuration.

A configuration contains one or more input actions for the respective input event. Existing input actions are displayed below it.

Example: “Execute ST code”: $PLC_PRG.i_x := 0;

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“OnDialogClosed”</td>
<td>Input event: The user closes the dialog box.</td>
</tr>
<tr>
<td>“OnMouseClick”</td>
<td>Input event: The user clicks the element completely. The mouse button is clicked and released.</td>
</tr>
<tr>
<td>“OnMouseDown”</td>
<td>Input event: The user clicks down on the element only.</td>
</tr>
<tr>
<td>“OnMouseEnter”</td>
<td>Input event: The user drags the mouse pointer to the element.</td>
</tr>
<tr>
<td>“OnMouseLeave”</td>
<td>Input event: The user drags the mouse pointer away from the element.</td>
</tr>
<tr>
<td>“OnMouseMove”</td>
<td>Input event: The user moves the mouse pointer over the element area.</td>
</tr>
<tr>
<td>“OnMouseUp”</td>
<td>Input event: The user releases the mouse button over the element area.</td>
</tr>
</tbody>
</table>

See also
- § Chapter 6.4.5.21.3.6 “Dialog ‘Input Configuration’” on page 3370

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Tap”</td>
<td>When a mouse click event occurs, the variable defined in “Variable” is described in the application. The coding depends on the options “Tap FALSE” and “Tap on enter if captured”.</td>
</tr>
<tr>
<td>“Variable”</td>
<td>Variable ( BOOL). Contains the information whether a mouse click event exists. Example: PLC_PRG.bIsTapped</td>
</tr>
<tr>
<td>TRUE:</td>
<td>A mouse click event exists. It lasts while the user presses the mouse button over the element. It ends when the button is released.</td>
</tr>
<tr>
<td>FALSE:</td>
<td>A mouse click event does not exist.</td>
</tr>
<tr>
<td>Requirement:</td>
<td>The “Tap FALSE” option is not activated.</td>
</tr>
<tr>
<td>“Tap FALSE”</td>
<td>☑: The mouse click event leads to a complementary value in “Variable”.</td>
</tr>
<tr>
<td>TRUE:</td>
<td>A mouse click event does not exist.</td>
</tr>
<tr>
<td>FALSE:</td>
<td>While the mouse click event exists.</td>
</tr>
<tr>
<td>“Tap on enter if captured”</td>
<td>☑: During user input, it is also taken into consideration whether the mouse pointer is dragged within the element area or not while the mouse button is pressed.</td>
</tr>
<tr>
<td>TRUE:</td>
<td>While the mouse click event exists and the mouse pointer is moved over the element area.</td>
</tr>
<tr>
<td>FALSE:</td>
<td>A mouse click event does not exist. Or the user moves the mouse pointer outside of the element area while the mouse button is pressed. The value is TRUE again as soon as the user moves the pointer back to the element area. The mouse is then captured.</td>
</tr>
</tbody>
</table>
"Shift" When a mouse click event occurs, the variable here is described in the application. When the mouse click event ends, its value is toggled with the "Toggle on up if captured" option.

"Variable" Variable (BOOL). Its value toggled when the mouse click event is ended. This is when the user releases the mouse button while the mouse pointer is over the element area.

If the user releases the mouse button while the mouse pointer is outside of the element area, then the mouse click event is not ended and the value is not toggled.

Tip: The user can cancel a started toggle input by dragging the mouse pointer out of the element area.

"Toggle on up if captured" The value toggles regardless of where the mouse pointer is when the mouse button is released. The mouse is then captured.

"Hotkeys" Keyboard shortcut on the element for triggering specific input actions. When the keyboard shortcut event occurs, the input actions in the "Event(s)" property are triggered. In this way, it is not the input action itself that leads to this input action, but the mouse input action.

"Key" Key pressed for input action.

Example: [T]

Note: The following properties appear when a key is selected.

"Event(s)"

- "None"
- "Mouse down": Pressing the key triggers the input actions that are configured in the "OnMouseDown" property.
- "Mouse up": Releasing the key triggers the input actions that are configured in the "OnMouseUp" property.
- "Mouse down/up": Pressing and releasing the key triggers the input actions that are configured in the "OnMouseDown" property and the "OnMouseUp" property.

"Shift" Combination with the Shift key

Example: [Shift]+[T].

"Control" Combination with the Ctrl key

Example: [Ctrl]+[T].

"Alt" Combination with the Alt key

Example: [Alt]+[T].

All keyboard shortcuts and their actions that are configured in the visualization are listed in the "Keyboard configuration" tab.

See also

- Chapter 6.4.5.21.2.2 “Command ‘Keyboard Configuration’” on page 3341
- Chapter 6.4.5.21.3.6 “Dialog ‘Input Configuration’” on page 3370

Requirement: User management is set up for the visualization.
“Access rights”

Opens the “Access rights” dialog. There you can edit the access privileges for the element.

Status messages:
- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also
- Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

Visualization Element ’Invisible Input’

Symbol:

Category: “Common Controls”

This element is displayed in the editor with a dashed line which is not visible in online mode. You define the behavior of the el in the input configuration.

Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
<tr>
<td>Example: Unsichtbare_Eingabe_1</td>
<td></td>
</tr>
</tbody>
</table>

| “Type of element” | “Invisible Input” |

Element property ’Position’

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in pixels.</td>
<td></td>
</tr>
<tr>
<td>Example: 10</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in pixels.</td>
<td></td>
</tr>
<tr>
<td>Example: 10</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Width”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 150</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Height”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 30</td>
<td></td>
</tr>
</tbody>
</table>
You can also change the values by dragging the box symbols (◮) to other positions in the editor.

See also
- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

**Element property ‘Center’**

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the ◆ symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (◮) to other positions in the editor.

**Element property ‘Absolute movement’**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>“Movement”</th>
<th>Variable (numeric data type). Defines the X position (in pixels).</th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
<td>Example: PLC_PRG.iPos_X. Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td>“Y”</td>
<td>Example: PLC_PRG.iPos_Y. Increasing this value in runtime mode moves the element downwards.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Rotation”</th>
<th>Variable (numeric data type). Defines the angle of rotation (in degrees).</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Rotation”</td>
<td>Example: PLC_PRG.iAngle1. The midpoint of the element rotates at the “Center” point. This rotation point is shown as the ◆ symbol.</td>
</tr>
<tr>
<td></td>
<td>In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
</tr>
</tbody>
</table>
**“Interior rotation”**

Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** `PLC_PRG.iAngle2`.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- 

**Element property 'State variables'**

The variables control the element behavior dynamically.

**“Deactivate inputs”**

Variable (`BOOL`). Toggles the operability of the element.

**TRUE:** User inputs do not have any effect in runtime more. The element is shown as deactivated.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
**Animation duration**

Defines the duration (in milliseconds) in which the element runs an animation

- **Variable (integer value)**
  
  **Example:**
  ```
  Menu.tContent with VAR tContent : INT := 500;
  END_VAR
  ```

- **Integer literal**
  
  **Example:** 500

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**Move to foreground**

Moves the visualization element to the foreground

- **Variable (BOOL)**
  
  **Example:**
  ```
  bIsInForeground with VAR bIsInForeground : BOOL := FALSE;
  END_VAR
  ```

  **TRUE:** At runtime, the visualization element is displayed in the foreground.
  **FALSE:** At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

**Element property 'Input configuration'**

The properties contain the configurations for the user input when using the mouse or keyboard. A user input defines an event and one or more actions that are executed when an event occurs.

The “Configure” button opens the “Input Configuration” dialog. There you can create or edit user inputs.

Configured user inputs are listed below the events. They each include the action that is triggered and the setting in short form.

**Example:**

**“Execute ST Code”:**

```
PLC_PRG.i_x := 0;
```
### `OnMouseMove`
Input event: The user moves the mouse pointer over the element area.

### `OnMouseUp`
Input events:
- The user releases the mouse button within the element area. It is irrelevant whether the user has previously pressed the mouse button inside or outside the element area.
- The user presses the mouse button within the element area, leaves the element area, and then releases the mouse button.

Note: This CODESYS-specific triggering behavior guarantees that actions for key elements are completed. A key element starts an action for "OnMouseDown" and ends the action for "OnMouseUp".

Example: A visualization user presses the mouse button within the element area of the key element and then moves the cursor position so that it lies outside the element area. The action is ended anyway because "OnMouseUp" is triggered.

### `Tap`
When a mouse click event occurs, the variable defined in "Variable" is described in the application. The coding depends on the "Tap FALSE" and "Tap on enter if captured" options.

### `Variable`
Variable (BOOL) that is set on mouse click event.

Example: FLC_PRG.bIsTapped

- **TRUE**: A mouse click event exists. It lasts as long as the user presses the mouse button over the element. It ends when the button is released.
- **FALSE**: A mouse click event does not exist.

Requirement: The "Tap FALSE" option is not activated.

### `Tap FALSE`
- **☑**: The mouse click event leads to a complementary value in "Variable".
- **TRUE**: A mouse click event does not exist.
- **FALSE**: While the mouse click event exists.

### `Tap on enter if captured`
- **☑**: During user input, it is also taken into consideration whether the mouse pointer is dragged within the element area or not while the mouse button is pressed.
- **TRUE**: While the mouse click event exists and the mouse pointer is moved over the element area.
- **FALSE**: A mouse click event does not exist. Or the user moves the mouse pointer outside of the element area while the mouse button is pressed.

The value is **TRUE** again as soon as the user moves the pointer back to the element area. The mouse is then captured.

### `Toggle`
With the onset of a mouse click event, the variable is set; when the mouse click event is completed, the variable is reset.

### `Variable`
Variable (BOOL). Its value toggled when the mouse click event is ended. This is when the user releases the mouse button while the mouse pointer is over the element area.

If the user releases the mouse button while the mouse pointer is outside of the element area, then the mouse click event is not ended and the value is not toggled.

Hint: The user can cancel a started toggle input by dragging the mouse pointer out of the element area.

### `Toggle on up if captured`
- **☑**: The value toggles regardless of where the mouse pointer is when the mouse button is released. The mouse is then captured.
**Hotkey**
Keyboard shortcut on the element for triggering specific input actions. When the keyboard shortcut event occurs, the input actions in the “Events” property are triggered. In this way, it is not the input action itself that leads to this input action, but the mouse input action.

**Key**
Key pressed for input action.
Example: [T]
Note: The following properties appear when a key is selected.

**Events**
- “None”
- “Mouse down”: Pressing the key triggers the input actions that are configured in the “OnMouseDown” property.
- “Mouse up”: Releasing the key triggers the input actions that are configured in the “OnMouseUp” property.
- “Mouse down/up”: Pressing and releasing the key triggers the input actions that are configured in the “OnMouseDown” property and the “OnMouseUp” property.

**Shift**
☑: Combination with the Shift key
Example: [Shift]+[T].

**Control**
☑: Combination with the Ctrl key
Example: [Ctrl]+[T].

**Alt**
☑: Combination with the Alt key
Example: [Alt]+[T].

![i]

All keyboard shortcuts and their actions that are configured in the visualization are listed on the “Keyboard Configuration” tab.

See also
- Chapter 6.4.5.21.2.2 “Command 'Keyboard Configuration’” on page 3341
- Chapter 6.4.5.21.3.6 “Dialog 'Input Configuration’” on page 3370

**Access rights**
Opens the “Access rights” dialog. There you can edit the access privileges for the element.

Status messages:
- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also
- Chapter 6.4.5.21.3.1 “Dialog 'Access Rights’” on page 3366

See also
- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

**Visualization Element 'Check Box’**
Symbol:
Category: “Common Controls”

The element is used for setting and resetting a Boolean variable. The set state is identified by a check mark.

**Element properties**

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: signal_tone_for_parts_deficit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Type of element”</th>
<th>“Check Box”</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Text ID”</td>
<td>ID for the text in the “GlobalTextList”</td>
</tr>
<tr>
<td>Example: 22</td>
<td></td>
</tr>
<tr>
<td>The text ID cannot be changed. As soon as you specify and save a text in “Texts” - “Text”, CODESYS automatically creates an entry in the “GlobalTextList” and displays the ID here.</td>
<td></td>
</tr>
</tbody>
</table>

**Element property ‘Position’**

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element Specified in pixels. Example: 10.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Y coordinate of the upper left corner of the element Specified in pixels. Example: 10.</td>
</tr>
<tr>
<td>“Width”</td>
<td>Specified in pixels. Example: 150</td>
</tr>
<tr>
<td>“Height”</td>
<td>Specified in pixels. Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (겠다) to other positions in the editor.

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

**Element property ‘Center’**

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;X&quot;</td>
<td>X-coordinate of the point of rotation</td>
</tr>
<tr>
<td>&quot;Y&quot;</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols to other positions in the editor.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Variable&quot;</td>
<td>Variable of type BOOL. Example: &quot;PLC_PRG.xIsTrue&quot;</td>
</tr>
<tr>
<td>&quot;Frame size&quot;</td>
<td>Distance of the element to the edge. Example: &quot;From style&quot;</td>
</tr>
</tbody>
</table>

**Element property 'Texts'**

The properties contain character strings for labeling the element.

CODESYS accepts the specified texts automatically into the "GlobalTextList" text list. Therefore, these texts can be localized.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Text&quot;</td>
<td>Character string (without single straight quotation marks) for the labeling the element. Example: &quot;Axis 1&quot;</td>
</tr>
<tr>
<td>&quot;Tooltip&quot;</td>
<td>Character string (without single straight quotation marks) that is displayed as the tooltip of an element. Example: &quot;Parameters of Axis 1&quot;</td>
</tr>
</tbody>
</table>

**Element property 'Text properties'**

The properties contain fixed values for the text properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Usage of&quot;</td>
<td>- &quot;Default style values&quot;: The values of the visualization style are used.</td>
</tr>
<tr>
<td></td>
<td>- &quot;Individual settings&quot;: The &quot;Individual text properties&quot; property group is shown. The values can be customized here.</td>
</tr>
<tr>
<td>&quot;Individual text properties&quot;</td>
<td>Requirement: The &quot;Individual settings&quot; text property is defined.</td>
</tr>
<tr>
<td>&quot;Horizontal alignment&quot;</td>
<td>Horizontal alignment of the text within the element.</td>
</tr>
<tr>
<td>&quot;Vertical alignment&quot;</td>
<td>Vertical alignment of the text within the element.</td>
</tr>
<tr>
<td>&quot;Text format&quot;</td>
<td>Definition for displaying texts that are too long</td>
</tr>
<tr>
<td></td>
<td>- &quot;Default&quot;: The long text is truncated.</td>
</tr>
<tr>
<td></td>
<td>- &quot;Line break&quot;: The text is split into parts.</td>
</tr>
<tr>
<td></td>
<td>- &quot;Ellipsis&quot;: The visible text ends with &quot;...&quot; indicating that it is not complete.</td>
</tr>
<tr>
<td>&quot;Font&quot;</td>
<td>Example: &quot;Default&quot;</td>
</tr>
<tr>
<td></td>
<td>☀: The &quot;Font&quot; dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>☐: Drop-down list with style fonts.</td>
</tr>
</tbody>
</table>
| **“Font color”** | Example: “Black”  
| | The “Color” dialog box opens.  
| | Drop-down list with style colors. |
| **“Transparency”** | Whole number (value range from 0 to 255). This determines the transparency of the respective color.  
| | Example: 255: The color is opaque.  
| | 0: The color is completely transparent.  
| | Please note: If the color is a style color and already has a transparency value, then this property is write-protected. |

### Element property ‘Absolute movement’
The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

| **“Movement”** |  |
| **“X”** | Variable (numeric data type). Defines the X position (in pixels).  
| | Example: PLC_PRG.iPos_X.  
| | Increasing this value in runtime mode moves the element to the right. |
| **“Y”** | Variable (numeric data type). Defines the Y position (in pixels).  
| | Example: PLC_PRG.iPos_Y.  
| | Increasing this value in runtime mode moves the element downwards. |
| **“Rotation”** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
| | Example: PLC_PRG.iAngle1.  
| | The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.  
| | In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right. |
| **“Interior rotation”** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
| | Example: PLC_PRG.iAngle2.  
| | In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.  
| | The rotation point is shown as the symbol.  
| | Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed. |
You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- Element properties ‘State variables’
  The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>“Invisible”</th>
<th>Variable (BOOL). Toggles the visibility of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRUE: <strong>The element is not visible at runtime.</strong></td>
<td></td>
</tr>
<tr>
<td>Example: <code>bIsVisible := bIsVisible := FALSE;</code></td>
<td></td>
</tr>
<tr>
<td>END_VAR</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Deactivate inputs”</th>
<th>Variable (BOOL). Toggles the operability of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRUE: <strong>User inputs do not have any effect in runtime more. The element is shown as deactivated.</strong></td>
<td></td>
</tr>
</tbody>
</table>

The “Invisible” property is supported by the “Client Animation” functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
<table>
<thead>
<tr>
<th><strong>“Animation duration”</strong></th>
<th>Defines the duration (in milliseconds) in which the element runs an animation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>● Variable (integer value)</td>
</tr>
<tr>
<td></td>
<td>Example: Menu.tContent with VAR tContent : INT := 500; END_VAR</td>
</tr>
<tr>
<td></td>
<td>● Integer literal</td>
</tr>
<tr>
<td></td>
<td>Example: 500</td>
</tr>
</tbody>
</table>

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

<table>
<thead>
<tr>
<th><strong>“Move to foreground”</strong></th>
<th>Moves the visualization element to the foreground</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Variable (BOOL)</td>
</tr>
<tr>
<td></td>
<td>Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR</td>
</tr>
<tr>
<td></td>
<td>TRUE: At runtime, the visualization element is displayed in the foreground.</td>
</tr>
<tr>
<td></td>
<td>FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.</td>
</tr>
</tbody>
</table>

**Element property 'Access rights'**

Requirement: User management is set up for the visualization.

<table>
<thead>
<tr>
<th><strong>“Access rights”</strong></th>
<th>Opens the “Access rights” dialog. There you can edit the access privileges for the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Status messages:</td>
</tr>
<tr>
<td></td>
<td>● “Not set. Full rights.”: Access rights for all user groups: “operable”</td>
</tr>
<tr>
<td></td>
<td>● “Rights are set: Limited rights”: Access is restricted for at least one group.</td>
</tr>
</tbody>
</table>

See also

- ☞ Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

See also

- ☞ Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

**Visualization Element 'Progress Bar’**

Symbol:

![Progress Bar Symbol](image)

Category: “Common Controls”

The element displays the value of a variable as a progress bar.
## Element properties

| “Element name” | Optional  
|----------------|----------|
| Hint: Assign individual names for elements so that they are found faster in the element list.  
| Example: Progress_Data_Transfer |

<table>
<thead>
<tr>
<th>“Type of element”</th>
<th>“Progress Bar”</th>
</tr>
</thead>
</table>

| “Text ID” | ID of the global text list  
| Requirement: Text is configured in the property “Texts ➔ Text” |

| “Variable” | Variable (numeric data type). Represents the length of the progress bar. |

<table>
<thead>
<tr>
<th>“Minimum value”</th>
<th>Value range of the variable</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Maximum value”</th>
<th></th>
</tr>
</thead>
</table>

| “Style” |  
| “Blocks” |
| “Bar” |

## Element property 'Position'

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

| “X” | X coordinate of the upper left corner of the element  
| Specified in pixels.  
| Example: 10. |

| “Y” | Y coordinate of the upper left corner of the element  
| Specified in pixels.  
| Example: 10. |

| “Width” | Specified in pixels.  
| Example: 150 |

| “Height” | Specified in pixels.  
| Example: 30 |

You can also change the values by dragging the box symbols (_draged_ ) to other positions in the editor.

See also  
• Chapter 6.4.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

## Element property 'Center'

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y-coordinate of the point of rotation</th>
</tr>
</thead>
</table>
You can also change the values by dragging the symbols (DlgItemDragIcon) to other positions in the editor.

### Element property 'Texts'

| “Text”                  | String label for the element.  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: <strong>Zoom</strong></td>
<td></td>
</tr>
</tbody>
</table>

### Element property 'Absolute movement'

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

| “Movement”               | Variable (numeric data type). Defines the X position (in pixels).  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
<td>Example: PLC_PRG.iPos_X.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td>“Y”</td>
<td>Example: PLC_PRG.iPos_Y.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
</tr>
</tbody>
</table>

| “Rotation”               | Variable (numeric data type). Defines the angle of rotation (in degrees).  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“Rotation”</td>
<td>Example: PLC_PRG.iAngle1.</td>
</tr>
<tr>
<td></td>
<td>The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.</td>
</tr>
<tr>
<td></td>
<td>In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
</tr>
</tbody>
</table>

| “Interior rotation”      | Variable (numeric data type). Defines the angle of rotation (in degrees).  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“Interior rotation”</td>
<td>Example: PLC_PRG.iAngle2.</td>
</tr>
<tr>
<td></td>
<td>In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.</td>
</tr>
<tr>
<td></td>
<td>The rotation point is shown as the symbol.</td>
</tr>
<tr>
<td></td>
<td>Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.</td>
</tr>
</tbody>
</table>
You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

Element property 'State variables'

| "Invisible" | Variable (BOOL). Toggles the visibility of the element. TRUE: The element is not visible at runtime. |

The “Invisible” property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
### “Animation duration”
Defines the duration (in milliseconds) in which the element runs an animation.

- **Variable (integer value)**
  - **Example:**
    ```
    Menu.tContent with VAR tContent : INT := 500;
    END_VAR
    ```

- **Integer literal**
  - **Example:** 500

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

### “Move to foreground”
Moves the visualization element to the foreground.

**Variable (BOOL)**

- **Example:**
  ```
  bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR
  ```

- **TRUE:** At runtime, the visualization element is displayed in the foreground.
- **FALSE:** At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

### Element property ‘Access rights’
Requirement: User management is set up for the visualization.

### “Access rights”
Opens the “Access rights” dialog. There you can edit the access privileges for the element.

**Status messages:**

- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also

- % Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

See also

- % Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

### Visualization Element ‘Radio Buttons’

**Symbol:**

Category: “Common Controls”

The element provides a series of radios buttons with an unlimited number of options.
### Element properties

| **“Element name”** | Optional  
|-------------------|-----------  
| **Hint:** Assign individual names for elements so that they are found faster in the element list.  
| **Example:** Morning Shift |

| **“Type of element”** | “Radio Buttons” |

#### Element property 'Position'

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

| **“X”** | X coordinate of the upper left corner of the element  
|---------|------------------------------------------  
|         | Specified in pixels.  
|         | **Example:** 10. |

| **“Y”** | Y coordinate of the upper left corner of the element  
|---------|------------------------------------------  
|         | Specified in pixels.  
|         | **Example:** 10. |

| **“Width”** | Specified in pixels.  
|-------------|----------------  
|             | **Example:** 150 |

| **“Height”** | Specified in pixels.  
|--------------|----------------  
|              | **Example:** 30 |

You can also change the values by dragging the box symbols (埂) to other positions in the editor.

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

| **“Variable”** | Variable (integer data type) that gives the index of the radio button that the visualization user has activated  
|----------------|----------------------------------------------------------  
|                | **Example:** PLC_PRG.iNrOfActivatedRadioButton |

| **“Number of columns”** | Definition of the number of list boxes displayed in a row  
|-------------------------|----------------------------------------------------------  
|                         | **Example:** 2 |

| **“Radio button order”** | “Left to right”: The radio buttons are aligned by rows until the number of columns is reached.  
|--------------------------|----------------------------------------------------------  
|                         | “Top to bottom”: The radio buttons are aligned row by columns until the number of columns is reached. |

<table>
<thead>
<tr>
<th><strong>“Frame size”</strong></th>
<th>Defines the distance from the list boxes to the edge (in pixels).</th>
</tr>
</thead>
</table>

| **“Row height”** | Height of the row (in pixels) Modifying the height of the row also changes the size of the list box. |
Element property 'Text properties'

The properties contain fixed values for the text properties.

<table>
<thead>
<tr>
<th>Usage of</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>● &quot;Default style values&quot;: The values of the visualization style are used.</td>
<td></td>
</tr>
<tr>
<td>● &quot;Individual settings&quot;: The &quot;Individual text properties&quot; property group is shown The values can be customized here.</td>
<td></td>
</tr>
</tbody>
</table>

**"Individual text properties"**

Requirement: The "Individual settings" text property is defined.

<table>
<thead>
<tr>
<th>Horizontal alignment</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Horizontal alignment of the text within the element.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Vertical alignment</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical alignment of the text within the element.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Text format</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Definition for displaying texts that are too long</td>
<td></td>
</tr>
<tr>
<td>● &quot;Default&quot;: The long text is truncated.</td>
<td></td>
</tr>
<tr>
<td>● &quot;Line break&quot;: The text is split into parts.</td>
<td></td>
</tr>
<tr>
<td>● &quot;Ellipsis&quot;: The visible text ends with &quot;...&quot; indicating that it is not complete.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Font</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: &quot;Default&quot;</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="The “Font” dialog box opens." /></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Drop-down list with style fonts." /></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Font color</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: &quot;Black&quot;</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="The “Color” dialog box opens." /></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Drop-down list with style colors." /></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Transparency</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Whole number (value range from 0 to 255). This determines the transparency of the respective color.</td>
<td></td>
</tr>
<tr>
<td>Example: 255: The color is opaque.</td>
<td></td>
</tr>
<tr>
<td>0: The color is completely transparent.</td>
<td></td>
</tr>
<tr>
<td>Please note: If the color is a style color and already has a transparency value, then this property is write-protected.</td>
<td></td>
</tr>
</tbody>
</table>

Element property 'Absolute movement'

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>Movement</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
<td></td>
</tr>
<tr>
<td>Example: PLC_PRG.iPos_X.</td>
<td></td>
</tr>
<tr>
<td>Increasing this value in runtime mode moves the element to the right.</td>
<td></td>
</tr>
</tbody>
</table>

| Y        |       |
| Variable (numeric data type). Defines the Y position (in pixels). |
| Example: PLC_PRG.iPos_Y. |
| Increasing this value in runtime mode moves the element downwards. |
"Rotation" Variable (numeric data type). Defines the angle of rotation (in degrees).
Example: PLC_PRG.iAngle1.
The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.
In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

"Interior rotation" Variable (numeric data type). Defines the angle of rotation (in degrees).
Example: PLC_PRG.iAngle2.
In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.
The rotation point is shown as the symbol.
Note: If a static angle of rotation is specified in the “Position è Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the "Client Animation" functionality.

See also

Element property 'State variables' The variables control the element behavior dynamically.

"Invisible" Variable (BOOL). Toggles the visibility of the element.
TRUE: The element is not visible at runtime.
Example: bIsVisible with VAR bIsVisible : BOOL := FALSE;
END_VAR

"Deactivate inputs" Variable (BOOL). Toggles the operability of the element.
TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.
The "Invisible" property is supported by the "Client Animation" functionality.

### Element property 'Radio button settings'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| "Radio button"          | "Areas"  
  - "[<n>]"  
  - "[<n>]": This number indicates the area. Clicking "Delete" will delete the associated radio button with its settings "Text", "Tooltip", and "Line spacing (in pixels)". |
| "Create new"            | Clicking this button creates a new selection button in the editor and lists an additional area in the properties editor. For each radio button, an area is visible that records the settings. |
| **Areas: [<n>]**        |                                                                                                                                           |
| "Text"                  | The button name is specified here. Default value: "Radio_button"                                                                          |
| "Tooltip"               | Text is specified here that is displayed in a tooltip.                                                                                     |
| "Line spacing (in pixels)" | The distance (in pixels) to the upper button can be specified here.                                                               |

These properties are available only when you have selected the "Support client animations and overlay of native elements" option in the Visualization Manager.

### Element property 'Animation duration'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| "Animation duration"    | Defines the duration (in milliseconds) in which the element runs an animation  
  - **Variable (integer value)**  
    Example: Menu.tContent with VAR tContent : INT := 500; END_VAR  
  - **Integer literal**  
    Example: 500  
  Animatable properties  
  - "Absolute movement", "Movement", "X", "Y"  
  - "Absolute movement", "Rotation"  
  - "Absolute movement", "Interior rotation"  
  - "Absolute movement", "Exterior rotation"  
  The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth. |

### Element property 'Move to foreground'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| "Move to foreground"    | Moves the visualization element to the foreground  
  Variable (BOOL)  
  Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR  
  TRUE: At runtime, the visualization element is displayed in the foreground.  
  FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor. |

### Requirement: User management is set up for the visualization.
“Access rights”

Opens the “Access rights” dialog. There you can edit the access privileges for the element.

Status messages:
- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also
- Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

See also
- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

Visualization Element ‘Alarm Table’

Symbol:

Category: “Alarm Manager”

The element displays alarms in a list. In the element properties, you specify which information is shown. You define the appearance of the element and the variables that control the element behavior.

In online mode, you can sort an alarm table by a specific column – even in the classic view. Click into the column header. A small triangle indicates the current sort order (ascending, descending). Clicking the symbol reverses the order.

Sorting inside the column depends on the type of the contained information. The "Priority" column is sorted numerically, and the "Message" and "Class" columns alphabetically. The "Value" and "Latch" columns may contain different value types. In this case, sorting is first by type (blank, Boolean, numeric value, character string) and then either numerically or alphabetically depending on the type.

If an alarm history has been created, then you can programmatically delete it at runtime. The recording starts again from the time of deletion. See the help page for “Visualizing Alarm Management”.

Element properties
| "Element name" | Example: GenElemInst_1 |
| "Type of element" | "Alarm Table" |
| "Data source" | Selection of the device and the application where the data to be visualized and the alarms are generated  
- Remote data source which accesses a remote device, accesses a remote application, and then transfers the data to the alarm configuration  
  Example: ![DataSource_A]  
  Below the (now visible) "Application" property, the remote application is displayed as configured in the data source.  
  Example: ![App_A]  
  Note: If the data source is accessed symbolically by means of a symbol file (CODESYS symbolic), then the required symbol file and the corresponding project have to be saved in the same folder.  
- Local application below which the alarm configuration is located  
  Example: !["<local application>"] |

See also  
- *Object 'Data Source'*

**Element property 'Alarm configuration'**

| "Alarm groups" | Opens the "Select Alarm Group" dialog where you define the alarm groups that you want to display. |
| "Priority from" | Least priority for alarm display. (0 to 255). |
| "Priority to" | Greatest priority for alarm display. (0 to 255). |
| "Alarm classes" | Opens the "Select Class Group" dialog where you define the alarm classes that you want to display. |
| "Filter criterion" | For the "Alarm Banner" element only  
  - "Most important": The alarm with the highest priority (lowest value) is displayed.  
  - "Newest": The most recent alarm is displayed. |
### “Filter by latch 1”

The generated alarms (previous and current) can be filtered by the contents of "Latch variable 1", which is specified in the configuration of the alarm group. In “Filter type”, you define whether or not the filtering is performed by a string value or a numerical value.

- **“Filter variable”**: Indicates what the alarms are filtered by. Possible entries: Application variable of data type STRING or WSTRING, or a literal value directly. Examples: PLC_PRG.strFilterVariable, 'STRING'.
- **“Filter type”**: Integer value that determines by which criteria the latch variable value is used for filtering. Possible entries: Numerical variable from the application (example: PLC_PRG.diFilterType, or a value directly (example: 2).

Possible values:
- 0: No filtering
- 1: Filter by alarms whose latch variable 1 contains the string specified in “Filter variable”. Example: The filter variable contains 'Error 1' which is the latch variable 1 of different alarms of type STRING and has the value 'Error 1' ->. Only these alarms are displayed.
- 2: Filter by alarms whose latch variable 1 contains the typed literal specified in "Filter variable" according to IEC 61131-3. Examples: T#1h2s, DINT#15, REAL#1.5, FALSE
- 3: Filter by alarms whose latch variable 1 contains the LINT literal value specified in “Filter variable”. Therefore, the value of the latch variables has to be in the range of 9,223,372,036,854,775,808 to 9,223,372,036,854,775,807.
- All other values: The behavior is not defined and can change in the future.

### “Filter by time range”

The generated alarms (remote, historical, local) can be displayed for a specified time range. You use the “Filter type” to define whether filtering by time range is enabled or disabled.

- **“Filter variable, from”**: Variable of data type DT or DATE_AND_TIME (example: PLC_PRG.filterTimeFrom) for the start time that the alarms are displayed.
- **“Filter variable, to”**: Variable of data type DT or DATE_AND_TIME (example: PLC_PRG.filterTimeTo) for the end time that the alarms are displayed.
- **“Filter type”**: Variable of integer data type that determines whether “Filter by time range” is enabled or disabled.

Possible values:
- 1: Filtering is enabled
- 0: Filtering is disabled

See also
- Chapter 6.4.5.21.3.17 “Dialog ‘Selected Alarm Group’” on page 3390
- Chapter 6.4.5.21.3.16 “Dialog ‘Selected Alarm Class’” on page 3389

### Element property 'General table configuration'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Show row header”</td>
<td>☑: Display of the row number at the beginning of the row.</td>
</tr>
<tr>
<td>“Show column header”</td>
<td>☑: Display of the column heading as defined in “Column heading”.</td>
</tr>
<tr>
<td>“Row height”</td>
<td>Height of the table rows (in pixels).</td>
</tr>
<tr>
<td>“Row header width”</td>
<td>Width of the line header (in pixels).</td>
</tr>
</tbody>
</table>
### Scrollbar size
Width of the scrollbar when it runs vertically. Width of the scrollbar when it runs horizontally. Specified in pixels.

### Automatic line break for alarm message
- ✔: The message text is truncated at the end of the line.
- ☐: The message text is truncated at the end of the column, if the text is too long.

---

**Element property 'Columns: Column [<n>]':**

By default, columns [0] and [1] are configured: “Time stamp” and “Message text”. You can create more columns by clicking the “Create new”, and remove columns by clicking “Delete”. Animations (dynamic text, font variables), text, and tooltip are not supported.

---

**“Column header”**
The standard header is set and changed here by specifying a new text.

**“Use text alignment in title”**
- ✔: The text in the column header is aligned according to the current definition in “Text alignment”.
- ☐: The text in the column header is centered.

**“Width”**
Width of the column (in pixels).

**“Data type”**
Notice about time stamps: For use in a TargetVisu or WebVisu, you can control the date and time format with the help of the global string variables from the library `Alarmmanager.library.AlarmGlobals.g_sDateFormat` (example: `AlarmGlobals.g_sDateFormat := 'MM.yyyy'`) and `AlarmGlobals.g_sTimeFormat` (example: `AlarmGlobals.g_sTimeFormat := 'HH:mm'`).

Define the information to be displayed in the column.
- “Symbol”
- “Time stamp”: Date and time of the last status change of the alarm.
- “Time stamp active”: Date and time of the last activation of the alarm.
- “Time stamp inactive”: Date and time of the last deactivation of the alarm.
- “Time stamp acknowledge”: Date and time of the last acknowledgment.
- “Value”: Current value of the printout
- “Message text”: Output of the message text
- “Priority”: Alarm priority
- “Class”: Alarm class
- “State”: Alarm state
- “Latch Variable <n>”: Value of the selected latch variables

**“Text alignment”**
Alignment of the text in this column
- “Left”
- “Centered”
- “Right”

**“Color settings”**
- “Activate color settings”: Boolean variable for activating and deactivating the color settings defined here. Example: `PLC_PRG.bColorSettings`
- “Cell fill color”:
  - “Color variable”: Variable for the cell fill color, example: `dwCellColor` (hexadecimal color definition: 16#TTRRGGBB)
  - “Use color also for column header”: ✔: The color defined via “Color variable” is used in the column header as well.
- “Text color”:
  - “Color variable”: Variable for the definition of the text color in the column, example: `dwTextColor` (hexadecimal color definition: 16#TTRRGGBB)
  - “Use color also for column header”: ☐: The color defined via “Color variable” is used in the column header as well.

---

See also
- Chapter 6.4.5.10.4 “Animating a color display” on page 2914
Element property 'Position'
The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>X coordinate of the upper left corner of the element Specified in pixels. Example: 10.</td>
</tr>
<tr>
<td>Y</td>
<td>Y coordinate of the upper left corner of the element Specified in pixels. Example: 10.</td>
</tr>
<tr>
<td>Width</td>
<td>Specified in pixels. Example: 150</td>
</tr>
<tr>
<td>Height</td>
<td>Specified in pixels. Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols ((GUI) to other positions in the editor.

See also
- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

Element property 'Center'
The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>X-coordinate of the point of rotation</td>
</tr>
<tr>
<td>Y</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (GUI) to other positions in the editor.

Element property 'Text properties'
The properties contain fixed values for the text properties.
### "Font"
Example: "Default"
- The "Font" dialog box opens.
- Drop-down list with style fonts.

### "Font color"
Example: "Black"
- The "Color" dialog box opens.
- Drop-down list with style colors.

### "Transparency"
Whole number (value range from 0 to 255). This determines the transparency of the respective color.
- Example: 255: The color is opaque.
- 0: The color is completely transparent.

Please note: If the color is a style color and already has a transparency value, then this property is write-protected.

---

**Element property 'Selection'**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Selection color&quot;</td>
<td>Fill color of the selected row</td>
</tr>
<tr>
<td>&quot;Selection font color&quot;</td>
<td>Font color of the selected row</td>
</tr>
<tr>
<td>&quot;Frame around selected cells&quot;</td>
<td>☑: A frame is drawn around the selected cells at runtime.</td>
</tr>
<tr>
<td>&quot;Variable for selected alarm group&quot;</td>
<td>Name of the affected alarm group; type: STRING, WSTRING</td>
</tr>
<tr>
<td>&quot;Variable for selected alarm ID&quot;</td>
<td>Alarm ID of the affected alarm group; type: STRING, WSTRING</td>
</tr>
<tr>
<td>&quot;Variable for selected line&quot;</td>
<td>Index of the selected alarm line (0-based). The index can be read and written; integer data type</td>
</tr>
<tr>
<td>&quot;Variable for valid selection&quot;</td>
<td>TRUE: An alarm line is selected. FALSE: The selection is invalid. For example, for an empty alarm table or when an alarm is not selected yet.</td>
</tr>
<tr>
<td>&quot;Variable for selected alarm information&quot;</td>
<td>Information about the selected alarm. Type: AlarmSelectionInfo. For easy usage, the function block AlarmSelectionInfoDefault is provided. This FB fills the structure with the memory for 10 messages and 10 latch variables. Example: myAlarmSelectionInfoDefault.AlarmSelectionInfo</td>
</tr>
</tbody>
</table>

The following information is available:
- sAlarmgroup
- uialarmID
- timeStampActive
- timeStampInactive
- timeStampAcknowledge
- timeStampLast
- paLatchVariables
- iLatchVariablesCount
- papwsAlarmMessages
- dwAlarmMessageTextBufferSize
- iAlarmMessagesCount
- iSelectionChangedCounter
Element property 'Control variables'  |  Boolean variables are defined here for executing specific actions in the table can be executed at runtime.

| **“Acknowledge selected”** | Variable (BOOL)  
Example: PLC_PRG.bAckSelectedAlarms  
If the assigned variable is TRUE, then the selected alarm is acknowledged. |
| **“Acknowledge all visible”** | Variable (BOOL)  
Example: PLC_PRG.bAckVisibleAlarms  
If the assigned variable is TRUE, then all alarms are acknowledged that are visible in the alarm table. |
| **“History”** | Variable (BOOL)  
Example: PLC_PRG.bShowHistory  
If the assigned variable is TRUE, then the history alarms are displayed in addition to the active alarms. In the classic view, the same sort options apply as in normal mode.  
Note: Acknowledgment is not possible in this view. |
| **“Freeze scroll position”** | Variable (BOOL)  
Example: PLC_PRG.bFreezeScrollPosition  
If the assigned variable is TRUE, then the scroll position set in the “History” view is retained, even if a new alarm is active. If not, then the scroll position jumps to the first table row (the newest alarm). |
| **“Count alarms”** | Variable (integer data type)  
Example: PLC_PRG.iNumberOfAlarms  
Number of alarms that are currently displayed in the alarm table. Defined by the alarm table. |
| **“Count visible rows”** | Variable (integer data type)  
Example: PLC_PRG.iNumberOfVisibleLines  
Number of alarms that can be displayed on one page of the alarm table. Defined by the alarm table. |
| **“Current scroll index”** | Variable (integer data type)  
Example: PLC_PRG.iScrollIndex  
The index of the first visible row if the alarm table (0-based). The variable can be read and written. |
| **“Current column sorting”** | Variable (integer data type)  
Example: PLC_PRG.iColSort  
The variable contains a value of the enumeration "VisuElemsAlarm.VisuEnumAlarmDataType". This value determines the column that sorts the alarm table. |
| **“Variable for sorting direction”** | Variable (BOOL)  
Example: PLC_PRG.xSortAscending  
The variable determines the sort order for the entries in the alarm table (TRUE: ascending; FALSE: descending). |

You can also use the “Insert Elements for Acknowledging Alarms” command to define buttons with predefined control variables.
See also

- Chapter 6.4.5.21.2.23 “Command 'Add Elements for Alarm Acknowledgement'” on page 3365

**Element property 'Absolute movement'**
The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

### "Movement"

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Example</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;X&quot;</td>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
<td>PLC_PRG.iPos_X</td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td>&quot;Y&quot;</td>
<td>Variable (numeric data type). Defines the Y position (in pixels).</td>
<td>PLC_PRG.iPos_Y</td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
</tr>
</tbody>
</table>

### "Rotation"

Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle1.

The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.

In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

### "Interior rotation"

Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the "Position ➔ Angle" property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

- You can link the variables to a unit conversion.
The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the "Client Animation" functionality.

See also

The variables control the element behavior dynamically.

| "Invisible" | Variable (BOOL). Toggles the visibility of the element. | TRUE: The element is not visible at runtime. |
| "Animation duration" | Defines the duration (in milliseconds) in which the element runs an animation | Variable (integer value)
  Example: Menu.tContent with VAR tContent : INT := 500; END_VAR
  Integer literal
  Example: 500 |
| "Move to foreground" | Moves the visualization element to the foreground Variable (BOOL) | Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR
  TRUE: At runtime, the visualization element is displayed in the foreground.
  FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor. |

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

The “Invisible” property is supported by the "Client Animation" functionality.

Element property 'State variables'

Element property 'Access rights'

Requirement: User management is set up for the visualization.
“Access rights” Opens the “Access rights” dialog. There you can edit the access privileges for the element. Status messages:

- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also

- “Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

Visualization Element ‘Alarm Banner’

Symbol:

Category: “Alarm Manager”

The element is a simplified version of the alarm table. It visualizes a single alarm only. In the element properties, you specify which information is shown. You define the appearance of the element and the variables that control the element behavior.

The alarm banner displays active alarms only. If the alarm is acknowledged, then it disappears from the alarm banner.

Element properties

<table>
<thead>
<tr>
<th>Element name</th>
<th>Example: GenElemInst_1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of element</td>
<td>“Alarm Banner”</td>
</tr>
<tr>
<td>Data source</td>
<td>If you intend to use a remote alarm configuration, then you have to specify the name of the remote application here. If you do not specify anything, the alarm configuration will be located locally.</td>
</tr>
</tbody>
</table>

Element property 'Alarm configuration'

| Alarm groups | Opens the “Select Alarm Group” dialog where you define the alarm groups that you want to display. |
| Priority from | Least priority for alarm display. (0 to 255). |
| Priority to | Greatest priority for alarm display. (0 to 255). |
| Alarm classes | Opens the “Select Class Group” dialog where you define the alarm classes that you want to display. |
| Filter criterion | For the “Alarm Banner” element only
  - “Most important”: The alarm with the highest priority (lowest value) is displayed.
  - “Newest”: The most recent alarm is displayed. |
### “Filter by latch 1”

The generated alarms (previous and current) can be filtered by the contents of “Latch variable 1”, which is specified in the configuration of the alarm group. In “Filter type”, you define whether or not the filtering is performed by a string value or a numerical value.

- **“Filter variable”**: Indicates what the alarms are filtered by. Possible entries: Application variable of data type STRING or WSTRING, or a literal value directly. Examples: PLC_PRG.strFilterVariable, 'STRING'.
- **“Filter type”**: Integer value that determines by which criteria the latch variable value is used for filtering. Possible entries: Numerical variable from the application (example: PLC_PRG.diFilterType, or a value directly (example: 2). Possible values:
  - 0: No filtering
  - 1: Filter by alarms whose latch variable 1 contains the string specified in “Filter variable”. Example: The filter variable contains 'Error 1' which is the latch variable 1 of different alarms of type STRING and has the value 'Error 1' ->. Only these alarms are displayed.
  - 2: Filter by alarms whose latch variable 1 contains the typed literal specified in “Filter variable” according to IEC 61131-3. Examples: T#1h2s, DINT#15, REAL#1.5, FALSE
  - 3: Filter by alarms whose latch variable 1 contains the LINT literal value specified in “Filter variable”. Therefore, the value of the latch variables has to be in the range of 9,223,372,036,854,775,808 to 9,223,372,036,854,775,807.
  - All other values: The behavior is not defined and can change in the future.

### “Filter by time range”

The generated alarms (remote, historical, local) can be displayed for a specified time range. You use the “Filter type” to define whether filtering by time range is enabled or disabled.

- **“Filter variable, from”**: Variable of data type DT or DATE_AND_TIME (example: PLC_PRG.filterTimeFrom) for the start time that the alarms are displayed.
- **“Filter variable, to”**: Variable of data type DT or DATE_AND_TIME (example: PLC_PRG.filterTimeTo) for the end time that the alarms are displayed.
- **“Filter type”**: Variable of integer data type that determines whether “Filter by time range” is enabled or disabled.
  Possible values:
  - 1: Filtering is enabled
  - 0: Filtering is disabled

### See also

- Chapter 6.4.5.21.3.17 “Dialog 'Selected Alarm Group’” on page 3390
- Chapter 6.4.5.21.3.16 “Dialog 'Selected Alarm Class’” on page 3389

### Element property 'Columns: Column [<n>]' by default, columns [0] and [1] are preconfigured: “Time stamp” and “Message text”. You create more columns by clicking “Create new”. You remove columns by clicking “Delete”.

Animations (dynamic text, font variables), texts, and tooltips are not supported.
<table>
<thead>
<tr>
<th><strong>“Width”</strong></th>
<th>Width of the column (in pixels)</th>
</tr>
</thead>
</table>
| **“Type of data”** | About time stamps: When used in a TargetVisu or WebVisu, you can control the date and time format by means of the global string variables from the library `Alarmmanager.library`:

- `AlarmGlobals.g_sDateFormat` (example: `AlarmGlobals.g_sDateFormat := 'MM.yyyy'`)
- `AlarmGlobals.g_sTimeFormat` (example: `AlarmGlobals.g_sTimeFormat := 'HH:mm'`).

Here you define the information to be displayed in the column.

- “Bitmap”
- “Time stamp”: Date and time of the last status change of the alarm
- “Time stamp active”: Date and time of the last activation of the alarm
- “Time stamp inactive”: Date and time of the last deactivation of the alarm
- “Time stamp acknowledge”: Date and time of the last acknowledgement
- “Value”: Actual value of the expression
- “Message”: Output of the message text
- “Priority”: Alarm priority
- “Class”: Alarm class
- “State”: Alarm state
- “Latch Variable <n>”: Value of the selected latch variables |
<table>
<thead>
<tr>
<th><strong>“Text alignment”</strong></th>
<th>Alignment of the contents in the column</th>
</tr>
</thead>
<tbody>
<tr>
<td>● “Left”</td>
<td>● “Centered”</td>
</tr>
<tr>
<td>● “Right”</td>
<td></td>
</tr>
</tbody>
</table>

### Element property 'Position'

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th><strong>“X”</strong></th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in pixels. Example: 10.</td>
<td></td>
</tr>
<tr>
<td><strong>“Y”</strong></td>
<td>Y coordinate of the upper left corner of the element</td>
</tr>
<tr>
<td>Specified in pixels. Example: 10.</td>
<td></td>
</tr>
<tr>
<td><strong>“Width”</strong></td>
<td>Specified in pixels. Example: 150</td>
</tr>
<tr>
<td><strong>“Height”</strong></td>
<td>Specified in pixels. Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (_drag_ ) to other positions in the editor.

See also

- % Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874
Element property 'Center'
The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the 🌐 symbol. The point is used as the center for rotating and scaling.

| "X" | X-coordinate of the point of rotation |
| "Y" | Y-coordinate of the point of rotation |

You can also change the values by dragging the symbols (🌐) to other positions in the editor.

Element property 'Text properties'
The properties contain fixed values for the text properties.

| "Font" | Example: "Default"
|        | 📷: The "Font" dialog box opens.
|        | ✅: Drop-down list with style fonts. |
| "Font color" | Example: "Black"
|        | 📷: The "Color" dialog box opens.
|        | ✅: Drop-down list with style colors. |
| "Transparency" | Whole number (value range from 0 to 255). This determines the transparency of the respective color.
|        | Example: 255: The color is opaque.
|        | 0: The color is completely transparent.
|        | Please note: If the color is a style color and already has a transparency value, then this property is write-protected. |

| "Acknowledge variable" | A rising edge of this variable acknowledges the alarm. |

Handling of multiple active alarms

| "Automatic switch" | ✅: The display in the alarm banner is switched automatically according to the time to the next alarm as configured in "Every N second". |
| "Every N second" | Time period until the next switching. Available only if "Automatic switch" is selected. |
| "Next alarm" | Variable for switching to the next alarm. Available only if "Automatic switch" is not selected. |
| "Previous alarm" | Variable for switching to the previous alarm. Available only if "Automatic switch" is not selected. |
| "Multiple alarms active" | Variable that has the value TRUE if multiple alarms are active. |

Element property 'Absolute movement'
The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.
**Movement**

| **“X”** | Variable (numeric data type). Defines the X position (in pixels).  
Example: PLC_PRG.iPos_X.  
Increasing this value in runtime mode moves the element to the right. |
| --- | --- |

| **“Y”** | Variable (numeric data type). Defines the Y position (in pixels).  
Example: PLC_PRG.iPos_Y.  
Increasing this value in runtime mode moves the element downwards. |
| --- | --- |

| **“Rotation”** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
Example: PLC_PRG.iAngle1.  
The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.  
In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right. |
| --- | --- |

| **“Interior rotation”** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
Example: PLC_PRG.iAngle2.  
In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.  
The rotation point is shown as the symbol.  
Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed. |
| --- | --- |

You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- Element property 'State variables'  
The variables control the element behavior dynamically.
**“Invisible”**  
Variable (BOOL). Toggles the visibility of the element.  
TRUE: The element is not visible at runtime.

The “Invisible” property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

**“Animation duration”**  
Defines the duration (in milliseconds) in which the element runs an animation  
- Variable (integer value)  
  Example: Menu.tContent with VAR tContent : INT := 500; END_VAR  
- Integer literal  
  Example: 500  

Animatable properties  
- “Absolute movement”, “Movement”, “X”, “Y”  
- “Absolute movement”, “Rotation”  
- “Absolute movement”, “Interior rotation”  
- “Absolute movement”, “Exterior rotation”  
The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**“Move to foreground”**  
Moves the visualization element to the foreground  
Variable (BOOL)  
Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR  
TRUE: At runtime, the visualization element is displayed in the foreground.  
FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

**Element property ‘Access rights’**  
Requirement: User management is set up for the visualization.

**“Access rights”**  
Opens the “Access rights” dialog. There you can edit the access privileges for the element.  
Status messages:  
- “Not set. Full rights.”: Access rights for all user groups : “operable”  
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also  
- Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366
Visualization Element ‘Bar Display’

Symbol:  

Category: “Measurement Controls”
The element displays the value of a variable.

See also
● Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: GenElemInst_2</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Type of element”</td>
<td>“Bar Display”</td>
</tr>
<tr>
<td>“Value”</td>
<td>Variable (numeric data type)</td>
</tr>
<tr>
<td></td>
<td>The value of the variable is displayed as a bar length.</td>
</tr>
</tbody>
</table>

Element property ‘Center’
The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the 🌭 symbol. The point is used as the center for rotating and scaling.

| “X” | X-coordinate of the point of rotation |
| “Y” | Y-coordinate of the point of rotation |

You can also change the values by dragging the symbols 🌭 to other positions in the editor.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
**“Animation duration”**
Defines the duration (in milliseconds) in which the element runs an animation

- **Variable** (integer value)
  Example: Menu.tContent with VAR tContent : INT := 500; END_VAR
- **Integer literal**
  Example: 500

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**“Move to foreground”**
Moves the visualization element to the foreground

Variable (BOOL)
Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR
  TRUE: At runtime, the visualization element is displayed in the foreground.
  FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

**Element property ‘Position’**
The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

| **“X”** | X coordinate of the upper left corner of the element | Specified in pixels. | Example: 10. |
| **“Y”** | Y coordinate of the upper left corner of the element | Specified in pixels. | Example: 10. |
| **“Width”** | Specified in pixels. | Example: 150 |
| **“Height”** | Specified in pixels. | Example: 30 |

You can also change the values by dragging the box symbols (_drag_ ) to other positions in the editor.

See also

- % Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874
Element property 'Background'

<table>
<thead>
<tr>
<th>&quot;Background color&quot;</th>
<th>Drop-down list with background colors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note: This property depends on the style. For example, there are no heterochromatic background images for &quot;FlatStyle&quot; and &quot;WhiteStyle&quot;.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Own image&quot;</th>
<th>● &quot;image&quot;: Image ID of the background image. You select the background image from an image pool by clicking the symbol.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Info: If you specify the &quot;&lt;default&gt;&quot; value or select the image from the &quot;Default&quot; category in the input assistant, then the original element background image is used.</td>
<td></td>
</tr>
<tr>
<td>● &quot;Transparent color&quot;: Color of pixels that are displayed as transparent. Selection from drop-down list or input assistant.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Optimized drawing&quot;</th>
<th>☑: The background image is drawn one time. If there is a change in the foreground, then only the affected part of the image is redrawn.</th>
</tr>
</thead>
<tbody>
<tr>
<td>□: The background image is redrawn in cycles.</td>
<td></td>
</tr>
<tr>
<td>Note: Deactivating this option is sensible only in certain exceptional cases.</td>
<td></td>
</tr>
</tbody>
</table>

Element property 'Bar'

<table>
<thead>
<tr>
<th>&quot;Diagram type&quot;</th>
<th>Position of the scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>● &quot;Scale besides bar&quot;</td>
<td></td>
</tr>
<tr>
<td>● &quot;Scale in bar&quot;</td>
<td></td>
</tr>
<tr>
<td>● &quot;Bar in scale&quot;</td>
<td></td>
</tr>
<tr>
<td>● &quot;No scale&quot;</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Orientation&quot;</th>
<th>Orientation depending on the ratio of width to height of the Bar Display:</th>
</tr>
</thead>
<tbody>
<tr>
<td>● &quot;Horizontal&quot;</td>
<td></td>
</tr>
<tr>
<td>● &quot;Vertical&quot;</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Running direction&quot;</th>
<th>Direction the values are increased.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drop-down list for &quot;Orientation Horizontal&quot;:</td>
<td></td>
</tr>
<tr>
<td>● &quot;Left to right&quot;</td>
<td></td>
</tr>
<tr>
<td>● &quot;Right to left&quot;</td>
<td></td>
</tr>
<tr>
<td>Drop-down list for &quot;Orientation Vertical&quot;:</td>
<td></td>
</tr>
<tr>
<td>● &quot;Bottom to top&quot;</td>
<td></td>
</tr>
<tr>
<td>● &quot;Top to bottom&quot;</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Optimum size for bar&quot;</th>
<th>☑: The bar width requires the majority of the element surface.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note: This property depends on the style. It is not provided for &quot;FlatStyle&quot; or &quot;WhiteStyle&quot;.</td>
<td></td>
</tr>
</tbody>
</table>

Element property 'Scale'
| **“Scale start”** | Least value of the scale and the lower limit of the value range for the element.  
Example: 0  
шей: The property “Variable” is shown below. |
| **“Variable”** | Variable (integer data type). Contains the scale start.  
Example: PLC_PRG.iScaleStart  
Declaration: |
| **“Scale end”** | Greatest value of the scale and the upper limit of the value range for the element.  
Example: 100  
шей: The property “Variable” is shown below. |
| **“Variable”** | Variable (integer data type). Contains the scale end.  
Example: PLC_PRG.iScaleEnd  
Declaration: |
| **“Main scale”** | Distance between 2 values on the rough scale.  
Example: 10  
шей: The property “Variable” is shown below. |
| **“Variable”** | Variable (integer data type). Contains the distance.  
Example: PLC_PRG.iMainScale  
Declaration: |
| **“Subscale”** | Distance between 2 values on the fine scale.  
You can hide the fine scale by setting the value to 0.  
Example: 2  
шей: The property “Variable” is shown below. |
| **“Variable”** | Variable (integer data type). Contains the spacing.  
Example: PLC_PRG.iSubScale  
Declaration: |
### Scale line width
Specified in pixels.
Example: 3

### Scale color
Color of scale lines
- ![Color](image)
The “Color” dialog box opens.
- ![Drop-down list](image): A drop-down list with color names opens.

### Scale in 3D
- ![Tick marks](image): Tick marks are displayed with slight 3D shadowing.
Note: This property depends on the style. Not available for “FlatStyle”.

### Element frame
- ![Frame](image): A frame is drawn around the element.

#### Element property 'Label'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Unit</strong></td>
<td>Text that is displayed in the element.</td>
</tr>
<tr>
<td>Example: Units displayed in m/s.</td>
<td></td>
</tr>
<tr>
<td><strong>Font</strong></td>
<td>Font for labels (example: scale numbering).</td>
</tr>
<tr>
<td>Selection from the drop-down list or by clicking the “&quot; button.</td>
<td></td>
</tr>
<tr>
<td><strong>Scale format (C Syntax)</strong></td>
<td>Values scaled in &quot;printf&quot; syntax</td>
</tr>
<tr>
<td>Examples: %d, %5.2f</td>
<td></td>
</tr>
<tr>
<td><strong>Max. text width of labels</strong></td>
<td>(optional) Value that redefines the maximum width of the scale label. The correct value is normally set automatically.</td>
</tr>
<tr>
<td>Note: Change this value only if the automatic adjustment does not yield the expected result.</td>
<td></td>
</tr>
<tr>
<td><strong>Text height of labels</strong></td>
<td>(optional) Value that redefines the maximum height of the scale label. The correct value is normally set automatically.</td>
</tr>
<tr>
<td>Note: Change this value only if the automatic adjustment does not yield the expected result.</td>
<td></td>
</tr>
<tr>
<td><strong>Font color</strong></td>
<td>Selection from the drop-down list or by clicking the “&quot; button.</td>
</tr>
</tbody>
</table>

#### Element property 'Positioning'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Horizontal offset</strong></td>
<td>Distance from the scale (bar) to the horizontal element frame</td>
</tr>
<tr>
<td>Specified in pixels.</td>
<td></td>
</tr>
<tr>
<td>Used for achieving the exact position relative to the background image.</td>
<td></td>
</tr>
<tr>
<td><strong>Vertical offset</strong></td>
<td>Distance from the scale (bar) to the vertical element frame</td>
</tr>
<tr>
<td>Specified in pixels.</td>
<td></td>
</tr>
<tr>
<td>Used for achieving the exact position relative to the background image.</td>
<td></td>
</tr>
<tr>
<td><strong>Horizontal scaling</strong></td>
<td>Horizontal division of the scale</td>
</tr>
<tr>
<td>Specified in pixels.</td>
<td></td>
</tr>
<tr>
<td>Used for achieving the exact positioning relative to the background image.</td>
<td></td>
</tr>
<tr>
<td><strong>Vertical scaling</strong></td>
<td>Vertical division of the scale</td>
</tr>
<tr>
<td>Specified in pixels.</td>
<td></td>
</tr>
<tr>
<td>Used for achieving the exact positioning relative to the background image.</td>
<td></td>
</tr>
</tbody>
</table>
Element property 'Colors'

<table>
<thead>
<tr>
<th>“Graph color”</th>
<th>Color of the bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Bar background”</td>
<td>✓: The background of the bar is black.</td>
</tr>
<tr>
<td></td>
<td>□: The background of the bar is white.</td>
</tr>
<tr>
<td>“Frame color”</td>
<td>Color that the frames are drawn.</td>
</tr>
<tr>
<td>“Switch whole color”</td>
<td>✓: The total color of the bar is switched to the color of the color area of the current value.</td>
</tr>
<tr>
<td>“Use gradient color for bar”</td>
<td>✓: Bar is displayed with a gradient.</td>
</tr>
<tr>
<td>“Color range markers”</td>
<td>The color areas can be separated from each other inside the bar with a vertical mark.</td>
</tr>
<tr>
<td></td>
<td>● “No markers”: No display.</td>
</tr>
<tr>
<td></td>
<td>● “Marker forwards”: The color of the vertical mark corresponds to the color of the previous color area.</td>
</tr>
<tr>
<td></td>
<td>● “Marker backwards”: The color of the vertical mark corresponds to the color of the next color area.</td>
</tr>
</tbody>
</table>

“Color areas”

| “Create new”       | A new color area is added. |
| “Delete”           | The color area is removed from the list. |
| “Begin of area”    | Start value of the color area |
| “End of area”      | End value of the color area |
| “Color”            | Color that is used for displaying the area. |

Element property 'Absolute movement'

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

“Movement”

| “X” | Variable (numeric data type). Defines the X position (in pixels). |
|     | Example: PLC_PRG.iPos_X. |
|     | Increasing this value in runtime mode moves the element to the right. |

| “Y” | Variable (numeric data type). Defines the Y position (in pixels). |
|     | Example: PLC_PRG.iPos_Y. |
|     | Increasing this value in runtime mode moves the element downwards. |

| “Rotation” | Variable (numeric data type). Defines the angle of rotation (in degrees). |
|            | Example: PLC_PRG.iAngle1. |
|            | The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol. |
|            | In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right. |
"Interior rotation" Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in "Center" according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the "Position ➔ Angle" property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

You can link the variables to a unit conversion.

The "X", "Y", "Rotation", and "Interior rotation" properties are supported by the "Client Animation" functionality.

See also

Element property 'State variables'

The variables control the element behavior dynamically.

"Deactivate inputs" Variable (BOOL). Toggles the operability of the element.

TRUE: User inputs do not have any effect in runtime mode. The element is shown as deactivated.

Element property 'Access rights'

Requirement: User management is set up for the visualization.

"Access rights" Opens the "Access rights" dialog. There you can edit the access privileges for the element.

Status messages:

- "Not set. Full rights.": Access rights for all user groups: "operable"
- "Rights are set: Limited rights": Access is restricted for at least one group.

See also

- § Chapter 6.4.5.21.3.1 "Dialog 'Access Rights’" on page 3366

Visualization Element 'Meter 90°'

Symbol:
Category: “Measurement Controls”
The element displays the value of a variable. The needle is positioned according to the value of the assigned variable. A meter is used to represent a tachometer, for example.

Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: GenElemInst_1</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Type of element”</td>
<td>“Meter 90°”</td>
</tr>
<tr>
<td>“Value”</td>
<td>Variable (numeric data type)</td>
</tr>
</tbody>
</table>

The variable value determines the pointer direction of the element.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

<table>
<thead>
<tr>
<th>“Animation duration”</th>
<th>Defines the duration (in milliseconds) in which the element runs an animation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>● Variable (integer value)</td>
</tr>
<tr>
<td></td>
<td>Example: Menu.tContent with VAR tContent : INT := 500;</td>
</tr>
<tr>
<td></td>
<td>END_VAR</td>
</tr>
<tr>
<td></td>
<td>● Integer literal</td>
</tr>
<tr>
<td></td>
<td>Example: 500</td>
</tr>
</tbody>
</table>

Animatable properties

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

<table>
<thead>
<tr>
<th>“Move to foreground”</th>
<th>Moves the visualization element to the foreground</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Variable (BOOL)</td>
</tr>
<tr>
<td></td>
<td>Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR</td>
</tr>
<tr>
<td></td>
<td>TRUE: At runtime, the visualization element is displayed in the foreground.</td>
</tr>
<tr>
<td></td>
<td>FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.</td>
</tr>
</tbody>
</table>

Element property 'Position'
The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.
**Element property 'Background'**

<table>
<thead>
<tr>
<th>&quot;Image color&quot;</th>
<th>List box containing background colors</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Own image&quot;</td>
<td></td>
</tr>
<tr>
<td>- &quot;Image&quot;: ID of the background image.</td>
<td></td>
</tr>
<tr>
<td>- You select the background image from an image pool by clicking <img src="https://example.com" alt="Image Pool" />.</td>
<td></td>
</tr>
<tr>
<td>- Info: If you specify the value &quot;&lt;default&gt;&quot; or select the image from the &quot;Default&quot; category in the Input Assistant, then the original element background image is used.</td>
<td></td>
</tr>
<tr>
<td>- &quot;Transparency color&quot;: Selection from list box or Input Assistant.</td>
<td></td>
</tr>
</tbody>
</table>

**Element property 'Arrow'**

<table>
<thead>
<tr>
<th>&quot;Hand style&quot;</th>
<th>Drop-down list with different arrow types</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Color&quot;</td>
<td></td>
</tr>
<tr>
<td>- <img src="https://example.com" alt="Color" />: The “Color” dialog box opens.</td>
<td></td>
</tr>
<tr>
<td>- <img src="https://example.com" alt="Color" />: Drop-down list with color names</td>
<td></td>
</tr>
<tr>
<td>&quot;Angle range&quot;</td>
<td>Drop-down list for the alignment of the element</td>
</tr>
<tr>
<td>&quot;Additional arrow&quot;</td>
<td><img src="https://example.com" alt="Additional Arrow" />: An additional arrow is shown inside the scale.</td>
</tr>
</tbody>
</table>

**Element property 'Scale'**
**Sub scale position**

- **Outside**: The subscale is displayed on the outer scale ring. ("Frame outside")
- **Inside**: The subscale is displayed on the inner scale ring. ("Frame inside")

**Scale type**

Type of scale

- **Lines**
- **Dots**
- **Squares**

**Scale start**

Least value of the scale and the lower limit of the value range for the element

Example: 0

- The "Variable" property is displayed in the line below this.

**Variable**

Variable (integer data type). Contains the scale start

Example: PLC_PRG.iScaleStart

Declaration:

```plaintext
PROGRAM PLC_PRG
VAR
  iScaleStart : INT := 0;
END_VAR
```

**Scale end**

Greatest value of the scale and the upper limit of the value range for the element

Example: 100

- The "Variable" property is shown below this.

**Variable**

Variable (integer data type). Contains the scale end

Example: PLC_PRG.iScaleEnd

Declaration:

```plaintext
PROGRAM PLC_PRG
VAR
  iScaleEnd : INT := 120;
END_VAR
```

**Main scale**

Distance between two values on the main scale

Example: 10

- The "Variable" property is shown below.

**Variable**

Variable (integer data type) Contains the distance between two values on the main scale

Example: PLC_PRG.iMainScale

Declaration:

```plaintext
PROGRAM PLC_PRG
VAR
  iMainScale : INT := 20;
END_VAR
```

**Sub scale**

Distance between two values on the fine scale

You can hide the fine scale by setting the value to 0.

Example: 2

- The "Variable" property is shown below this.
### Variable

Variable (integer data type) Contains the distance between two values on the fine scale  
**Example:** PLC_PRG.iSubScale  
**Declaration:**

```plaintext
PROGRAM PLC_PRG
VAR
    iSubScale : INT := 5;
END_VAR
```

### Scale line width

Specified in pixels  
**Example:** 3

### Scale color

Color of scale lines  
- [ ]: The "Color" dialog opens.  
- [ ]: A list box with style colors opens.

### Scale in 3D

[ ]: Scale lines are displayed with soft 3D shadowing.  
**Note:** This property is not displayed in "FlatStyle".

### Show scale

[ ]: The scale is displayed.

### Frame inside

[ ]: A frame is drawn at the inner end of the scale.

### Frame outside

[ ]: A frame is drawn at the outer end of the scale.

---

**Element property 'Label'**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| "Label"                       | Selection list  
  - "Outside": Scale values are placed outside of the scale.  
  - "Inside": Scale values are placed inside of the scale. |
| "Unit"                        | Text that is displayed in the element.  
  **Example:** Units displayed in m/s. |
| "Font"                        | Font for labels (example: scale numbering).  
  Selection from the drop-down list or by clicking the "" button. |
| "Scale format (C Syntax)"     | Values scaled in "printf" syntax  
  **Examples:** %d, %5.2f |
| "Max. text width of labels"   | (optional) Value that redefines the maximum width of the scale label. The correct value is normally set automatically.  
  **Note:** Change this value only if the automatic adjustment does not yield the expected result. |
| "Text height of labels"       | (optional) Value that redefines the maximum height of the scale label. The correct value is normally set automatically.  
  **Note:** Change this value only if the automatic adjustment does not yield the expected result. |
| "Font color"                  | Selection from the drop-down list or by clicking the "" button. |
### Usage of
- "Preset style values": Values from the current style
- "User-defined settings": The subnode "Positioning" appears.

### Positioning

**Requirement:** "User-defined settings" is selected as "Usage of".

The displayed positioning settings depend on the type of needle instrument and Potentiometer, and partially on whether a custom background image is selected. The following settings are used for achieving the exact position relative to the background image.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Needle movement&quot;</td>
<td>Length of the needle (in pixels)</td>
</tr>
<tr>
<td>&quot;Scale movement&quot;</td>
<td>Distance from the tick marks to the center (in pixels)</td>
</tr>
<tr>
<td></td>
<td>Requirement: A customer image is selected as &quot;Background&quot;.</td>
</tr>
<tr>
<td>&quot;Scale length&quot;</td>
<td>Length of the tick marks (in pixels)</td>
</tr>
<tr>
<td></td>
<td>Requirement: A customer image is selected as &quot;Background&quot;.</td>
</tr>
<tr>
<td>&quot;Label offset&quot;</td>
<td>Distance from the labels to the tick marks (in pixels)</td>
</tr>
<tr>
<td>&quot;Unit offset&quot;</td>
<td>Distance of the unit text &quot;Label ➔ Unit&quot; from the upper scale edge (in pixels)</td>
</tr>
<tr>
<td>&quot;Origin offset&quot;</td>
<td>Offset of the element (in pixels)</td>
</tr>
</tbody>
</table>

**Requirement:** A customer image is selected as "Background".

### Scale length

Length of the tick marks (in pixels)

**Requirement:** A customer image is selected as "Background".

### Label offset

Distance from the labels to the tick marks (in pixels)

### Unit offset

Distance of the unit text "Label ➔ Unit" from the upper scale edge (in pixels)

### Origin offset

Offset of the element (in pixels)

**Requirement:** For the elements "Meter 180°" and "Meter 90°", this property is displayed only if a custom image is selected as "Background".

---

### Element property 'Colors'

#### Color areas

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Durable color areas&quot;</td>
<td>□: All color areas are visible, regardless of the current value.</td>
</tr>
<tr>
<td></td>
<td>□: Only the color area is visible that includes the current value.</td>
</tr>
<tr>
<td>&quot;Use colors for scale&quot;</td>
<td>□: Colors in the color area are used only for the scale and frame.</td>
</tr>
<tr>
<td>&quot;Color areas&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Create new&quot;</td>
<td>A new color area is added to the &quot;Elements&quot; view.</td>
</tr>
<tr>
<td>&quot;Delete&quot;</td>
<td>The color area is removed from the list and the list is refreshed.</td>
</tr>
<tr>
<td>&quot;Begin of area&quot;</td>
<td>Start value of the color area</td>
</tr>
<tr>
<td></td>
<td>Example: 20</td>
</tr>
<tr>
<td></td>
<td>➔: The property &quot;Variable&quot; is shown below.</td>
</tr>
<tr>
<td>&quot;Variable&quot;</td>
<td>Variable (integer data type). Contains the start value.</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iColorAreaStart0</td>
</tr>
<tr>
<td></td>
<td>Declaration:</td>
</tr>
<tr>
<td>PROGRAM PLC_PRG</td>
<td></td>
</tr>
<tr>
<td>VAR</td>
<td></td>
</tr>
<tr>
<td>iColorAreaStart0</td>
<td>: INT := 80;</td>
</tr>
<tr>
<td>END_VAR</td>
<td></td>
</tr>
<tr>
<td>&quot;End of area&quot;</td>
<td>End value of the color area</td>
</tr>
<tr>
<td></td>
<td>Example: 120</td>
</tr>
<tr>
<td></td>
<td>➔: The property &quot;Variable&quot; is shown below.</td>
</tr>
</tbody>
</table>
“Variable” Variable (integer data type). Contains the end value.  
Example: ColorAreaEnd0  
Declaration:  

PROGRAM PLC_PRG  
VAR  
  iColorAreaEnd0 : INT := 100;  
END_VAR

“Color” Color that is used for displaying the area.

Element property ‘Absolute movement’ The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

“Movement”

| “X” | Variable (numeric data type). Defines the X position (in pixels).  
     | Example: PLC_PRG.iPos_X.  
     | Increasing this value in runtime mode moves the element to the right. |

| “Y” | Variable (numeric data type). Defines the Y position (in pixels).  
     | Example: PLC_PRG.iPos_Y.  
     | Increasing this value in runtime mode moves the element downwards. |

“Rotation” Variable (numeric data type). Defines the angle of rotation (in degrees).  
Example: PLC_PRG.iAngle1.  
The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.  
In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

“Interior rotation” Variable (numeric data type). Defines the angle of rotation (in degrees).  
Example: PLC_PRG.iAngle2.  
In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.  
The rotation point is shown as the symbol.  
Note: If a static angle of rotation is specified in the “Position Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.
You can link the variables to a unit conversion.

The "X", "Y", "Rotation", and "Interior rotation" properties are supported by the "Client Animation" functionality.

See also

Requirement: User management is set up for the visualization.

**Element property 'Access rights'**

| "Access rights" | Open the "Access rights" dialog. There you can edit the access privileges for the element. Status messages:  
|                 | ● “Not set. Full rights.”: Access rights for all user groups: "operable"  
|                 | ● “Rights are set: Limited rights”: Access is restricted for at least one group. |

See also

● % Chapter 6.4.5.21.3.1 “Dialog 'Access Rights'” on page 3366

See also

● % Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

**Visualization Element 'Meter 180°'**

Symbol:

Category: "Measurement Controls"

The element displays the value of a variable. The needle is positioned according to the value of the assigned variable on a scale. A meter is used to represent a tachometer, for example.

**Element properties**

<table>
<thead>
<tr>
<th>&quot;Element name&quot;</th>
<th>Example: GenElemInst_1</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Type of element&quot;</td>
<td>&quot;Meter 180°&quot;</td>
</tr>
</tbody>
</table>
| "Value" | Variable (numeric data type)  
The variable value determines the pointer direction of the element. |

**Element property 'Center'**

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.
You can also change the values by dragging the symbols (↻) to other positions in the editor.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

<table>
<thead>
<tr>
<th>“Animation duration”</th>
<th>Defines the duration (in milliseconds) in which the element runs an animation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>● Variable (integer value)</td>
</tr>
<tr>
<td></td>
<td>Example: Menu.tContent with VAR tContent : INT := 500; END_VAR</td>
</tr>
<tr>
<td></td>
<td>● Integer literal</td>
</tr>
<tr>
<td></td>
<td>Example: 500</td>
</tr>
</tbody>
</table>

Animatable properties

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

<table>
<thead>
<tr>
<th>“Move to foreground”</th>
<th>Moves the visualization element to the foreground</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Variable (BOOL)</td>
</tr>
<tr>
<td></td>
<td>Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR</td>
</tr>
<tr>
<td></td>
<td>TRUE: At runtime, the visualization element is displayed in the foreground.</td>
</tr>
<tr>
<td></td>
<td>FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.</td>
</tr>
</tbody>
</table>

**Element property ‘Position’**

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>
“Width” Specified in pixels. Example: 150

“Height” Specified in pixels. Example: 30

You can also change the values by dragging the box symbols (¶) to other positions in the editor.

See also
- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

Element property ‘Background’

“Image color” List box containing background colors

“Own image”
- “Image”: ID of the background image.
  You select the background image from an image pool by clicking .
  Info: If you specify the value “<default>” or select the image from the “Default” category in the Input Assistant, then the original element background image is used.
- “Transparency color”: Selection from list box or Input Assistant.

Element property ‘Arrow’

“Hand style” Drop-down list with different arrow types

“Color”
- The “Color” dialog box opens.
- ▼: Drop-down list with color names

“Angle range” Drop-down list for the alignment of the element

“Additional arrow” ✓: An additional arrow is shown inside the scale.

Element property ‘Scale’

“Sub scale position”
- “Outside”: The subscale is displayed on the outer scale ring. (“Frame outside”)
- “Inside”: The subscale is displayed on the inner scale ring. (“Frame inside”)

“Scale type” Type of scale
- “Lines”
- “Dots”
- “Squares”

“Scale start” Least value of the scale and the lower limit of the value range for the element
Example: 0
◆: The “Variable” property is displayed in the line below this.
| **Variable** | Variable (integer data type). Contains the scale start  
Example: PLC_PRG.iScaleStart  
Declaration: |
| --- | --- |
| | PROGRAM PLC_PRG  
VAR  
iScaleStart : INT := 0;  
END_VAR |

| **Scale end** | Greatest value of the scale and the upper limit of the value range for the element  
Example: 100  
✨: The **Variable** property is shown below this. |
| --- | --- |

| **Variable** | Variable (integer data type). Contains the scale end  
Example: PLC_PRG.iScaleEnd  
Declaration: |
| --- | --- |
| | PROGRAM PLC_PRG  
VAR  
iScaleEnd : INT := 120;  
END_VAR |

| **Main scale** | Distance between two values on the main scale  
Example: 10  
✨: The **Variable** property is shown below. |
| --- | --- |

| **Variable** | Variable (integer data type) Contains the distance between two values on the main scale  
Example: PLC_PRG.iMainScale  
Declaration: |
| --- | --- |
| | PROGRAM PLC_PRG  
VAR  
iMainScale : INT := 20;  
END_VAR |

| **Sub scale** | Distance between two values on the fine scale  
You can hide the fine scale by setting the value to 0.  
Example: 2  
✨: The **Variable** property is shown below this. |
| --- | --- |

| **Variable** | Variable (integer data type) Contains the distance between two values on the fine scale  
Example: PLC_PRG.iSubScale  
Declaration: |
| --- | --- |
| | PROGRAM PLC_PRG  
VAR  
iSubScale : INT := 5;  
END_VAR |

| **Scale line width** | Specified in pixels  
Example: 3 |
### Element property 'Label'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Label”</td>
<td>Selection list</td>
</tr>
<tr>
<td></td>
<td>○ “Outside”: Scale values are placed outside of the scale.</td>
</tr>
<tr>
<td></td>
<td>○ “Inside”: Scale values are placed inside of the scale.</td>
</tr>
<tr>
<td>“Unit”</td>
<td>Text that is displayed in the element.</td>
</tr>
<tr>
<td></td>
<td>Example: Units displayed in m/s.</td>
</tr>
<tr>
<td>“Font”</td>
<td>Font for labels (example: scale numbering).</td>
</tr>
<tr>
<td></td>
<td>Selection from the drop-down list or by clicking the “?” button.</td>
</tr>
<tr>
<td>“Scale format (C Syntax)”</td>
<td>Values scaled in “printf” syntax.</td>
</tr>
<tr>
<td></td>
<td>Examples: %d, %5.2f</td>
</tr>
<tr>
<td>“Max. text width of labels”</td>
<td>(optional) Value that redefines the maximum width of the scale label.</td>
</tr>
<tr>
<td></td>
<td>The correct value is normally set automatically.</td>
</tr>
<tr>
<td></td>
<td>Note: Change this value only if the automatic adjustment does not yield the expected result.</td>
</tr>
<tr>
<td>“Text height of labels”</td>
<td>(optional) Value that redefines the maximum height of the scale label.</td>
</tr>
<tr>
<td></td>
<td>The correct value is normally set automatically.</td>
</tr>
<tr>
<td></td>
<td>Note: Change this value only if the automatic adjustment does not yield the expected result.</td>
</tr>
<tr>
<td>“Font color”</td>
<td>Selection from the drop-down list or by clicking the “?” button.</td>
</tr>
</tbody>
</table>

### Element property 'Positioning'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Usage of”</td>
<td>○ “Preset style values”: Values from the current style</td>
</tr>
<tr>
<td></td>
<td>○ “User-defined settings”: The subnode “Positioning” appears.</td>
</tr>
<tr>
<td>“Positioning”</td>
<td>Requirement: “User-defined settings” is selected as “Usage of”.</td>
</tr>
<tr>
<td></td>
<td>The displayed positioning settings depend on the type of needle instrument and Potentiometer, and partially on whether a custom background image is selected. The following settings are used for achieving the exact position relative to the background image.</td>
</tr>
<tr>
<td>“Needle movement”</td>
<td>Length of the needle (in pixels)</td>
</tr>
<tr>
<td>“Scale movement”</td>
<td>Distance from the tick marks to the center (in pixels)</td>
</tr>
<tr>
<td></td>
<td>Requirement: A customer image is selected as “Background”.</td>
</tr>
</tbody>
</table>
“Scale length”
Length of the tick marks (in pixels)
Requirement: A customer image is selected as “Background”.

“Label offset”:
Distance from the labels to the tick marks (in pixels)

“Unit offset”:
Distance of the unit text “Label ➔ Unit” from the upper scale edge (in pixels)

“Origin offset”
Offset of the element (in pixels)
Requirement: For the elements “Meter 180°” and “Meter 90°”, this property is displayed only if a custom image is selected as “Background”.

Element property ‘Colors’

“Color areas”

“Durable color areas”
☐: All color areas are visible, regardless of the current value.
☑: Only the color area is visible that includes the current value.

“Use colors for scale”
☑: Colors in the color area are used only for the scale and frame.

“Color areas”

“Create new”
A new color area is added to the “Elements” view.

“Delete”
The color area is removed from the list and the list is refreshed.

“Begin of area”
Start value of the color area
Example: 20

!: The property “Variable” is shown below.

“Variable”
Variable (integer data type). Contains the start value.
Example: PLC_PRG.iColorAreaStart0
Declaration:

PROGRAM PLC_PRG
VAR
  iColorAreaStart0 : INT := 80;
END_VAR

“End of area”
End value of the color area
Example: 120

!: The property “Variable” is shown below.

“Variable”
Variable (integer data type). Contains the end value.
Example: iColorAreaEnd0
Declaration:

PROGRAM PLC_PRG
VAR
  iColorAreaEnd0 : INT := 100;
END_VAR

“Color”
Color that is used for displaying the area.

Element property ‘Absolute movement’
The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.
### Movement

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Example</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
<td>PLC_PRG.iPos_X.</td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td>Y</td>
<td>Variable (numeric data type). Defines the Y position (in pixels).</td>
<td>PLC_PRG.iPos_Y.</td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
</tr>
<tr>
<td>Rotation</td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
<td>PLC_PRG.iAngle1.</td>
<td>The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol. In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
</tr>
<tr>
<td>Interior</td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
<td>PLC_PRG.iAngle2.</td>
<td>In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise. The rotation point is shown as the symbol. Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.</td>
</tr>
</tbody>
</table>

You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- The variables control the element behavior dynamically.
**“Invisible”**

Variable (BOOL). Toggles the visibility of the element.

**TRUE**: The element is not visible at runtime.

---

The “Invisible” property is supported by the "Client Animation" functionality.

---

**Element property ‘Access rights’**

Requirement: User management is set up for the visualization.

**“Access rights”**

Opens the “Access rights” dialog. There you can edit the access privileges for the element.

Status messages:

- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also

- Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’" on page 3366

See also

- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

---

**Visualization Element ‘Meter’**

**Symbol:**

**Category:** “Measurement Controls”

The element displays the value of a variable. The needle is positioned according to the value of the assigned variable. A meter is used to represent a tachometer, for example.

---

**Element properties**

- **“Element name”**
  - **Example:** GenElemInst_1
- **“Type of element”**
  - **“Meter”**
- **“Value”**
  - Variable (numeric data type).
  - The variable value determines the pointer direction of the element.

**Element property ‘Center’**

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the ⦼ symbol. The point is used as the center for rotating and scaling.

- **“X”**
  - X-coordinate of the point of rotation
- **“Y”**
  - Y-coordinate of the point of rotation
You can also change the values by dragging the symbols ( resizable symbols ) to other positions in the editor.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

<table>
<thead>
<tr>
<th>“Animation duration”</th>
<th>Defines the duration (in milliseconds) in which the element runs an animation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>● Variable (integer value)</td>
</tr>
<tr>
<td></td>
<td>Example: Menu.tContent with VAR tContent : INT := 500; END_VAR</td>
</tr>
<tr>
<td></td>
<td>● Integer literal</td>
</tr>
<tr>
<td></td>
<td>Example: 500</td>
</tr>
</tbody>
</table>

Animatable properties

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

<table>
<thead>
<tr>
<th>“Move to foreground”</th>
<th>Moves the visualization element to the foreground</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Variable (BOOL)</td>
</tr>
<tr>
<td></td>
<td>Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR</td>
</tr>
<tr>
<td>TRUE</td>
<td>At runtime, the visualization element is displayed in the foreground.</td>
</tr>
<tr>
<td>FALSE</td>
<td>At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.</td>
</tr>
</tbody>
</table>

Element property 'Position'

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element</th>
<th>Specified in pixels.</th>
<th>Example: 10.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Y coordinate of the upper left corner of the element</td>
<td>Specified in pixels.</td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>
“Width” Specified in pixels.
Example: 150

“Height” Specified in pixels.
Example: 30

You can also change the values by dragging the box symbols (_drag-) to other positions in the editor.

See also
● Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

Element property 'Background'

“Image color” List box containing background colors

“Own image”
● “Image”: ID of the background image.

You select the background image from an image pool by clicking [...] Info: If you specify the value “<default>” or select the image from the “Default” category in the Input Assistant, then the original element background image is used.
● “Transparency color”: Selection from list box or Input Assistant.

Element property 'Arrow'

“Hand style” Drop-down list with different arrow types

“Color”
● ▼: The “Color” dialog box opens.
● ▲: Drop-down list with color names

“Arrow start” Angle (in degrees) between the scale start and the horizontal axis

“Arrow end” Angle (in degrees) between the right edge of the pointer instrument and the horizontal axis

“Additional arrow” Check: An additional arrow is shown inside the scale.

Element property 'Scale'

“Sub scale position”
● “Outside”: The subscale is displayed on the outer scale ring. (“Frame outside”)
● “Inside”: The subscale is displayed on the inner scale ring. (“Frame inside”)

“Scale type” Type of scale
● “Lines”
● “Dots”
● “Squares”

“Scale start” Least value of the scale and the lower limit of the value range for the element
Example: 0
●: The “Variable” property is displayed in the line below this.
| **“Variable”** | Variable (integer data type). Contains the scale start  
**Example:** PLC_PRG.iScaleStart  
**Declaration:** |
|---|---|
| | PROGRAM PLC_PRG  
VAR  
iScaleStart : INT := 0;  
END_VAR |

| **“Scale end”** | Greatest value of the scale and the upper limit of the value range for the element  
**Example:** 100  
👉 The “**Variable**” property is shown below this. |
|---|---|
| | PROGRAM PLC_PRG  
VAR  
iScaleEnd : INT := 120;  
END_VAR |

| **“Main scale”** | Distance between two values on the main scale  
**Example:** 10  
👉 The “**Variable**” property is shown below. |
|---|---|
| | PROGRAM PLC_PRG  
VAR  
iMainScale : INT := 20;  
END_VAR |

| **“Sub scale”** | Distance between two values on the fine scale  
You can hide the fine scale by setting the value to 0.  
**Example:** 2  
👉 The “**Variable**” property is shown below this. |
|---|---|
| | PROGRAM PLC_PRG  
VAR  
iSubScale : INT := 5;  
END_VAR |

| **“Scale line width”** | Specified in pixels  
**Example:** 3 |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Scale color&quot;</td>
<td>Color of scale lines</td>
</tr>
<tr>
<td></td>
<td>• ▶️: The “Color” dialog opens.</td>
</tr>
<tr>
<td></td>
<td>• ▼: A list box with style colors opens.</td>
</tr>
<tr>
<td>&quot;Scale in 3D&quot;</td>
<td>☑️: Scale lines are displayed with soft 3D shadowing.</td>
</tr>
<tr>
<td></td>
<td>Note: This property is not displayed in “FlatStyle”.</td>
</tr>
<tr>
<td>&quot;Show scale&quot;</td>
<td>☑️: The scale is displayed.</td>
</tr>
<tr>
<td>&quot;Frame inside&quot;</td>
<td>☑️: A frame is drawn at the inner end of the scale.</td>
</tr>
<tr>
<td>&quot;Frame outside&quot;</td>
<td>☑️: A frame is drawn at the outer end of the scale.</td>
</tr>
</tbody>
</table>

**Element property 'Label'**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Label&quot;</td>
<td>Selection list</td>
</tr>
<tr>
<td></td>
<td>• &quot;Outside&quot;: Scale values are placed outside of the scale.</td>
</tr>
<tr>
<td></td>
<td>• &quot;Inside&quot;: Scale values are placed inside of the scale.</td>
</tr>
<tr>
<td>&quot;Unit&quot;</td>
<td>Text that is displayed in the element.</td>
</tr>
<tr>
<td></td>
<td>Example: Units displayed in m/s.</td>
</tr>
<tr>
<td>&quot;Font&quot;</td>
<td>Font for labels (example: scale numbering).</td>
</tr>
<tr>
<td></td>
<td>Selection from the drop-down list or by clicking the &quot;&quot; button.</td>
</tr>
<tr>
<td>&quot;Scale format (C Syntax)&quot;</td>
<td>Values scaled in &quot;printf&quot; syntax</td>
</tr>
<tr>
<td></td>
<td>Examples: %d, %5.2f</td>
</tr>
<tr>
<td>&quot;Max. text width of labels&quot;</td>
<td>(optional) Value that redefines the maximum width of the scale label. The correct value is normally set automatically.</td>
</tr>
<tr>
<td></td>
<td>Note: Change this value only if the automatic adjustment does not yield the expected result.</td>
</tr>
<tr>
<td>&quot;Text height of labels&quot;</td>
<td>(optional) Value that redefines the maximum height of the scale label. The correct value is normally set automatically.</td>
</tr>
<tr>
<td></td>
<td>Note: Change this value only if the automatic adjustment does not yield the expected result.</td>
</tr>
<tr>
<td>&quot;Font color&quot;</td>
<td>Selection from the drop-down list or by clicking the &quot;&quot; button.</td>
</tr>
</tbody>
</table>

**Element property 'Positioning'**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Usage of&quot;</td>
<td>• &quot;Preset style values&quot;: Values from the current style</td>
</tr>
<tr>
<td></td>
<td>• &quot;User-defined settings&quot;: The subnode “Positioning” appears.</td>
</tr>
<tr>
<td>&quot;Positioning&quot;</td>
<td>Requirement: “User-defined settings” is selected as “Usage of”.</td>
</tr>
<tr>
<td></td>
<td>The displayed positioning settings depend on the type of needle instrument and Potentiometer, and partially on whether a custom background image is selected. The following settings are used for achieving the exact position relative to the background image.</td>
</tr>
<tr>
<td>&quot;Needle movement&quot;</td>
<td>Length of the needle (in pixels)</td>
</tr>
<tr>
<td>&quot;Scale movement&quot;</td>
<td>Distance from the tick marks to the center (in pixels)</td>
</tr>
<tr>
<td></td>
<td>Requirement: A customer image is selected as “Background”.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>&quot;Scale length&quot;</td>
<td>Length of the tick marks (in pixels)</td>
</tr>
<tr>
<td></td>
<td>Requirement: A customer image is selected as &quot;Background&quot;.</td>
</tr>
<tr>
<td>&quot;Label offset&quot;</td>
<td>Distance from the labels to the tick marks (in pixels)</td>
</tr>
<tr>
<td>&quot;Unit offset&quot;</td>
<td>Distance of the unit text &quot;Label ➔ Unit&quot; from the upper scale edge (in pixels)</td>
</tr>
<tr>
<td>&quot;Origin offset&quot;</td>
<td>Offset of the element (in pixels)</td>
</tr>
<tr>
<td></td>
<td>Requirement: For the elements &quot;Meter 180°&quot; and &quot;Meter 90°&quot;, this property is displayed only if a custom image is selected as &quot;Background&quot;.</td>
</tr>
</tbody>
</table>

**Element property 'Colors'**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Durable color areas&quot;</td>
<td>☐: All color areas are visible, regardless of the current value.</td>
</tr>
<tr>
<td></td>
<td>☑: Only the color area is visible that includes the current value.</td>
</tr>
<tr>
<td>&quot;Use colors for scale&quot;</td>
<td>☑: Colors in the color area are used only for the scale and frame.</td>
</tr>
<tr>
<td>&quot;Color areas&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Create new&quot;</td>
<td>A new color area is added to the &quot;Elements&quot; view.</td>
</tr>
<tr>
<td>&quot;Delete&quot;</td>
<td>The color area is removed from the list and the list is refreshed.</td>
</tr>
<tr>
<td>&quot;Begin of area&quot;</td>
<td>Start value of the color area</td>
</tr>
<tr>
<td></td>
<td>Example: 20</td>
</tr>
<tr>
<td></td>
<td>☑: The property “Variable” is shown below.</td>
</tr>
<tr>
<td>&quot;Variable&quot;</td>
<td>Variable (integer data type). Contains the start value.</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iColorAreaStart0</td>
</tr>
<tr>
<td></td>
<td>Declaration:</td>
</tr>
<tr>
<td></td>
<td>PROGRAM PLC_PRG</td>
</tr>
<tr>
<td></td>
<td>VAR</td>
</tr>
<tr>
<td></td>
<td>iColorAreaStart0 : INT := 80;</td>
</tr>
<tr>
<td></td>
<td>END_VAR</td>
</tr>
<tr>
<td>&quot;End of area&quot;</td>
<td>End value of the color area</td>
</tr>
<tr>
<td></td>
<td>Example: 120</td>
</tr>
<tr>
<td></td>
<td>☑: The property “Variable” is shown below.</td>
</tr>
<tr>
<td>&quot;Variable&quot;</td>
<td>Variable (integer data type). Contains the end value.</td>
</tr>
<tr>
<td></td>
<td>Example: iColorAreaEnd0</td>
</tr>
<tr>
<td></td>
<td>Declaration:</td>
</tr>
<tr>
<td></td>
<td>PROGRAM PLC_PRG</td>
</tr>
<tr>
<td></td>
<td>VAR</td>
</tr>
<tr>
<td></td>
<td>iColorAreaEnd0 : INT := 100;</td>
</tr>
<tr>
<td></td>
<td>END_VAR</td>
</tr>
<tr>
<td>&quot;Color&quot;</td>
<td>Color that is used for displaying the area.</td>
</tr>
</tbody>
</table>

**Element property 'Absolute movement'**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.
### Movement

| **“X”** | Variable (numeric data type). Defines the X position (in pixels).  
**Example:** PLC_PRG.iPos_X.  
Increasing this value in runtime mode moves the element to the right. |
|---|---|

| **“Y”** | Variable (numeric data type). Defines the Y position (in pixels).  
**Example:** PLC_PRG.iPos_Y.  
Increasing this value in runtime mode moves the element downwards. |
|---|---|

| **“Rotation”** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
**Example:** PLC_PRG.iAngle1.  
The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.  
In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right. |

| **“Interior rotation”** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
**Example:** PLC_PRG.iAngle2.  
In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.  
The rotation point is shown as the symbol.  
Note: If a static angle of rotation is specified in the ”Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed. |

---

**You can link the variables to a unit conversion.**

---

**The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the "Client Animation" functionality.**

---

**Element property 'State variables'**

The variables control the element behavior dynamically.
"Invisible" Variable (BOOL). Toggles the visibility of the element. TRUE: The element is not visible at runtime.

The “Invisible” property is supported by the "Client Animation" functionality.

Element property 'Access rights'

Requirement: User management is set up for the visualization.

"Access rights" Opens the "Access rights" dialog. There you can edit the access privileges for the element. Status messages:

- "Not set. Full rights.": Access rights for all user groups: "operable"
- "Rights are set: Limited rights". Access is restricted for at least one group.

See also

- Chapter 6.4.5.21.3.1 "Dialog 'Access Rights'" on page 3366

See also

- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

Visualization Element 'Potentiometer'

Symbol:

Category: “Measurement Controls”

The element displays the value of a variable as a setting on the potentiometer. A visualization user can modify the value by dragging the pointer to another position.

See also

- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

Element properties

<table>
<thead>
<tr>
<th>&quot;Element name&quot;</th>
<th>Example: GenElemInst_1</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Type of element&quot;</td>
<td>&quot;Potentiometer&quot;</td>
</tr>
<tr>
<td>&quot;Variable&quot;</td>
<td>Variable (numeric data type). Contains the position of the pointer for the potentiometer. A visualization user can modify the value by dragging the pointer to another position.</td>
</tr>
</tbody>
</table>
Element property 'Center'  The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
<td>X-coordinate of the point of rotation</td>
</tr>
<tr>
<td>“Y”</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (ϕ) to other positions in the editor.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

“Animation duration” Defines the duration (in milliseconds) in which the element runs an animation

- Variable (integer value)
  Example: Menu.tContent with VAR tContent : INT := 500; END_VAR
- Integer literal
  Example: 500

Animatable properties

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

“Move to foreground” Moves the visualization element to the foreground

Variable (BOOL)

Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR

TRUE: At runtime, the visualization element is displayed in the foreground.
FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

Element property 'Position' The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.
**X**
X coordinate of the upper left corner of the element
Specified in pixels.
Example: 10.

**Y**
Y coordinate of the upper left corner of the element
Specified in pixels.
Example: 10.

**Width**
Specified in pixels.
Example: 150

**Height**
Specified in pixels.
Example: 30

You can also change the values by dragging the box symbols to other positions in the editor.

See also
- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

**Element property 'Background'**

| “Image color” | List box containing background colors |
| “Own image” | ・“Image”: ID of the background image. You select the background image from an image pool by clicking ![image pool](image.png).
Info: If you specify the value “<default>” or select the image from the “Default” category in the Input Assistant, then the original element background image is used.
・“Transparency color”: Selection from list box or Input Assistant. |

**Element property ‘Arrow’**

| “Hand style” | Drop-down list with different arrow types |
| “Color” | ・[open]: The “Color” dialog box opens.
・[drop-down]: Drop-down list with color names |
| “Arrow start” | Angle (in degrees) between the left edge of the element and the horizontal axis |
| “Arrow end” | Angle (in degrees) between the right edge of the element and the horizontal axis |

**Element property ‘Scale’**
<table>
<thead>
<tr>
<th><strong>“Sub scale position”</strong></th>
<th>Type of scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ “Outside”: The subscale is displayed on the outer scale ring. (“Frame outside”)</td>
<td>✓ “Lines”</td>
</tr>
<tr>
<td>✓ “Inside”: The subscale is displayed on the inner scale ring. (“Frame inside”)</td>
<td>✓ “Dots”</td>
</tr>
<tr>
<td>✓ “Squares”</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Scale type”</strong></th>
<th>Least value of the scale and the lower limit of the value range for the element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 0</td>
<td>Example: PLC_PRG.iScaleStart</td>
</tr>
<tr>
<td>◆: The “Variable” property is displayed in the line below this.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Variable”</strong></th>
<th>Greatest value of the scale and the upper limit of the value range for the element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 100</td>
<td>Example: PLC_PRG.iScaleEnd</td>
</tr>
<tr>
<td>◆: The “Variable” property is shown below this.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Main scale”</strong></th>
<th>Distance between two values on the main scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 10</td>
<td>Example: PLC_PRG.iMainScale</td>
</tr>
<tr>
<td>◆: The “Variable” property is shown below.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Sub scale”</strong></th>
<th>Distance between two values on the fine scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 2</td>
<td>Example: PLC_PRG.iMainScale</td>
</tr>
<tr>
<td>You can hide the fine scale by setting the value to 0.</td>
<td></td>
</tr>
<tr>
<td>◆: The “Variable” property is shown below this.</td>
<td></td>
</tr>
</tbody>
</table>
### “Variable”

Variable (integer data type) Contains the distance between two values on the fine scale  

**Example:** PLC_PRG.iSubScale  

**Declaration:**

```plaintext
PROGRAM PLC_PRG
VAR
  iSubScale : INT := 5;
END_VAR
```

### “Scale line width”

Specified in pixels  

**Example:** 3

### “Scale color”

Color of scale lines  

- 💡: The “Color” dialog opens.  
- 🔢: A list box with style colors opens.

### “Scale in 3D”

✔️: Scale lines are displayed with soft 3D shadowing.  

Note: This property is not displayed in “FlatStyle”.

### “Show scale”

✔️: The scale is displayed.

### “Frame inside”

✔️: A frame is drawn at the inner end of the scale.

### “Frame outside”

✔️: A frame is drawn at the outer end of the scale.

---

#### Element property 'Label'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| “Label”                      | Selection list  
  - “Outside”: Scale values are placed outside of the scale.  
  - “Inside”: Scale values are placed inside of the scale. |
| “Unit”                       | Text that is displayed in the element.  
  Example: Units displayed in m/s. |
| “Font”                       | Font for labels (example: scale numbering).  
  Selection from the drop-down list or by clicking the "" button. |
| “Scale format (C Syntax)”    | Values scaled in “printf” syntax  
  Examples: %d, %5.2f |
| “Max. text width of labels”  | (optional) Value that redefines the maximum width of the scale label. The correct value is normally set automatically  
  Note: Change this value only if the automatic adjustment does not yield the expected result. |
| “Text height of labels”      | (optional) Value that redefines the maximum height of the scale label. The correct value is normally set automatically  
  Note: Change this value only if the automatic adjustment does not yield the expected result. |
| “Font color”                 | Selection from the drop-down list or by clicking the "" button. |
### Usage of
- **“Preset style values”**: Values from the current style
- **“User-defined settings”**: The subnode “Positioning” appears.

### Positioning

**Requirement**: “User-defined settings” is selected as “Usage of”.

The displayed positioning settings depend on the type of needle instrument and Potentiometer, and partially on whether a custom background image is selected. The following settings are used for achieving the exact position relative to the background image.

<table>
<thead>
<tr>
<th>“Needle movement”</th>
<th>Length of the needle (in pixels)</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Scale movement”</td>
<td>Distance from the tick marks to the center (in pixels)</td>
</tr>
</tbody>
</table>
|                   | Requirement: A customer image is selected as “Background”.
| “Scale length”    | Length of the tick marks (in pixels)  |
|                   | Requirement: A customer image is selected as “Background”.
| “Label offset”    | Distance from the labels to the tick marks (in pixels)  |
| “Unit offset”     | Distance of the unit text “Label ➔ Unit” from the upper scale edge (in pixels)  |
| “Origin offset”   | Offset of the element (in pixels)  |
|                   | Requirement: For the elements “Meter 180°” and “Meter 90°”, this property is displayed only if a custom image is selected as “Background”.

### Element property ‘Colors’

<table>
<thead>
<tr>
<th>“Color areas”</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Durable color areas”</td>
</tr>
<tr>
<td>- [ ] All color areas are visible, regardless of the current value.</td>
</tr>
<tr>
<td>- [ ] Only the color area is visible that includes the current value.</td>
</tr>
<tr>
<td>“Use colors for scale”</td>
</tr>
<tr>
<td>- [ ] Colors in the color area are used only for the scale and frame.</td>
</tr>
<tr>
<td>“Color areas”</td>
</tr>
<tr>
<td>“Create new”</td>
</tr>
<tr>
<td>A new color area is added to the “Elements” view.</td>
</tr>
<tr>
<td>“Delete”</td>
</tr>
<tr>
<td>The color area is removed from the list and the list is refreshed.</td>
</tr>
<tr>
<td>“Begin of area”</td>
</tr>
<tr>
<td>Start value of the color area</td>
</tr>
<tr>
<td>Example: 20</td>
</tr>
<tr>
<td>✤ The property “Variable” is shown below.</td>
</tr>
<tr>
<td>“Variable”</td>
</tr>
<tr>
<td>Variable (integer data type). Contains the start value.</td>
</tr>
<tr>
<td>Example: PLC_PRG.iColorAreaStart0</td>
</tr>
<tr>
<td>Declaration:</td>
</tr>
<tr>
<td>PROGRAM PLC_PRG</td>
</tr>
<tr>
<td>VAR</td>
</tr>
<tr>
<td>iColorAreaStart0 : INT := 80;</td>
</tr>
<tr>
<td>END_VAR</td>
</tr>
<tr>
<td>“End of area”</td>
</tr>
<tr>
<td>End value of the color area</td>
</tr>
<tr>
<td>Example: 120</td>
</tr>
<tr>
<td>✤ The property “Variable” is shown below.</td>
</tr>
</tbody>
</table>
### “Variable”
Variable (integer data type). Contains the end value.

**Example:** iColorAreaEnd0

**Declaration:**
```
PROGRAM PLC_PRG
VAR
  iColorAreaEnd0 : INT := 100;
END_VAR
```

### “Color”
Color that is used for displaying the area.

---

### Element property ‘State variables’

#### “Invisible”
Variable (BOOL). Toggles the visibility of the element.

**Example:** bIsVisible

```
VAR
  bIsVisible : BOOL := FALSE;
END_VAR
```

** TRUE:** The element is not visible at runtime.

#### “Deactivate inputs”
Variable (BOOL). Toggles the operability of the element.

** TRUE:** User inputs do not have any effect in runtime more. The element is shown as deactivated.

*The “Invisible” property is supported by the “Client Animation” functionality.*

---

### Element property ‘Absolute movement’
The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

#### “Movement”

<table>
<thead>
<tr>
<th><strong>X</strong></th>
<th>Variable (numeric data type). Defines the X position (in pixels).</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Example:</strong> PLC_PRG.iPos_X.</td>
<td></td>
</tr>
<tr>
<td>Increasing this value in runtime mode moves the element to the right.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Y</strong></th>
<th>Variable (numeric data type). Defines the Y position (in pixels).</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Example:</strong> PLC_PRG.iPos_Y.</td>
<td></td>
</tr>
<tr>
<td>Increasing this value in runtime mode moves the element downwards.</td>
<td></td>
</tr>
</tbody>
</table>
### "Rotation"

Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** PLC_PRG.iAngle1.

The midpoint of the element rotates at the "Center" point. This rotation point is shown as the symbol.

In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

### "Interior rotation"

Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in "Center" according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the "Position Angle" property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

---

You can link the variables to a unit conversion.

---

The "X", "Y", "Rotation", and "Interior rotation" properties are supported by the "Client Animation" functionality.

---

**Element property 'Access rights'**

Requirement: User management is set up for the visualization.

**"Access rights"**

Opens the "Access rights" dialog. There you can edit the access privileges for the element.

Status messages:

- "Not set. Full rights.": Access rights for all user groups: "operable"
- "Rights are set: Limited rights": Access is restricted for at least one group.

See also

- ☰ Chapter 6.4.5.21.3.1 "Dialog 'Access Rights'" on page 3366
Visualization Element 'Histogram'

Symbol:

Category: “Measurement Controls”

The element displays the data of a one-dimensional array as a histogram. You can define specific colors for certain value ranges.

See also

● Chapter 6.4.5.2.4 “Displaying Array Data in a Histogram” on page 2862

Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: GenElemInst_35</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Type of element”</td>
<td>“Histogram”</td>
</tr>
<tr>
<td>“Data array”</td>
<td>One-dimensional array with data displayed in this histogram. Example: PLC_PRG.arr1</td>
</tr>
</tbody>
</table>

Element property 'Subrange of array'

| “Use subrange”       | ☑: Only part of the array is displayed in the histogram. |
| “Start index”        | First array index with a displayed value. Requirement: “Use subrange” is activated. |
| “End index”          | Last array index with a displayed value. Requirement: “Use subrange” is activated. |

| “Display type”        | ● “Bars”: Data is displayed as bars. ● “Lines”: Data is displayed as lines. ● “Curve”: Interpolation of data into a curve. |
| “Line width”          | Specified in pixels Requirement: “Curve” is selected as the “Display type”. |
| “Show horizontal lines” | ☑: Horizontal lines are drawn on the main scale. Note: Not all visualization styles have this property. This element property is not available for visualization styles that have striped backgrounds (example: “Flat style”). |
| “Relative bar width”  | Integer value between 1 and 100
  ● 1: The bars are drawn as lines.
  ● 100: The entire width of the histogram is filled with the bars. |

Element property 'Position'

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;X&quot;</td>
<td>X coordinate of the upper left corner of the element</td>
</tr>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
<tr>
<td>&quot;Y&quot;</td>
<td>Y coordinate of the upper left corner of the element</td>
</tr>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
<tr>
<td>&quot;Width&quot;</td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 150</td>
</tr>
<tr>
<td>&quot;Height&quot;</td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (_drag_+) to other positions in the editor.

See also
- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

### Element property ‘Center’

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the ◾ symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;X&quot;</td>
<td>X-coordinate of the point of rotation</td>
</tr>
<tr>
<td>&quot;Y&quot;</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (_drag_) to other positions in the editor.

### Element property ‘Scale’

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Scale start&quot;</td>
<td>Least value of the scale and the lower limit of the value range for the element.</td>
</tr>
<tr>
<td></td>
<td>Example: 0</td>
</tr>
<tr>
<td></td>
<td>◾: The property “Variable” is shown below.</td>
</tr>
<tr>
<td>&quot;Variable&quot;</td>
<td>Variable (integer data type). Contains the scale start.</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iScaleStart</td>
</tr>
<tr>
<td>&quot;Scale end&quot;</td>
<td>Greatest value of the scale and the upper limit of the value range for the element.</td>
</tr>
<tr>
<td></td>
<td>Example: 100</td>
</tr>
<tr>
<td></td>
<td>◾: The property “Variable” is shown below.</td>
</tr>
<tr>
<td>&quot;Variable&quot;</td>
<td>Variable (integer data type). Contains the scale end.</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.iScaleEnd</td>
</tr>
</tbody>
</table>
### Main scale
Distance between 2 values on the rough scale.
Example: 10

- The property “Variable” is shown below.

### Variable
Variable (integer data type). Contains the distance.
Example: PLC_PRG.iMainScale

### Subscale
Distance between 2 values on the fine scale.
You can hide the fine scale by setting the value to 0.
Example: 2

- The property “Variable” is shown below.

### Variable
Variable (integer data type). Contains the spacing.
Example: PLC_PRG.iSubScale

### Scale color
Color of scale lines
- The “Color” dialog box opens.
- A drop-down list with color names opens.

### Base line
Value of the main scale where the horizontal base line of the Histogram is located.
The drawing of the bar starts at the base line.

---

#### Example
A valid declaration is required for the variables used as an example in the table above.

```plaintext
PROGRAM PLC_PRG
VAR
    iScaleStart : INT := 0;
    iScaleEnd : INT := 120;
    iMainScale : INT := 20;
    iSubScale : INT := 5;
END_VAR
```

---

#### Element property 'Label'

- **Unit**
  - Text that is displayed in the element.
  - Example: Units displayed in m/s.

- **Font**
  - Font for labels (example: scale numbering).
  - Selection from the drop-down list or by clicking the “” button.

- **Scale format (C Syntax)**
  - Values scaled in "printf" syntax
  - Examples: %d, %5.2f

- **Max. text width of labels**
  - Optional value that defines the maximum width of the scale label.
  - Note: Change this value only if the automatic adjustment does not yield the expected result.

- **Text height of labels**
  - Optional value that defines the maximum height of the scale label.
  - Note: Change this value only if the automatic adjustment does not yield the expected result.

- **Font color**
  - Selection from the drop-down list or by clicking the “” button.
### Element property 'Colors'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Graph color</strong></td>
<td>Color of the bar in normal state.</td>
</tr>
<tr>
<td><strong>Alarm value</strong></td>
<td>Threshold for the alarm</td>
</tr>
<tr>
<td><strong>Alarm condition</strong></td>
<td>If the current value of the array component fulfills the alarm condition, then the alarm condition is set.</td>
</tr>
<tr>
<td></td>
<td>● “Less”: The current value is less than the “Alarm value”</td>
</tr>
<tr>
<td></td>
<td>● “More”: The current value is greater than the “Alarm value”</td>
</tr>
<tr>
<td><strong>Alarm color</strong></td>
<td>Color of the bar in alarm state.</td>
</tr>
<tr>
<td><strong>Use color areas</strong></td>
<td>☑: The color areas defined in this element are used.</td>
</tr>
<tr>
<td><strong>Create new</strong></td>
<td>A new color area is added.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>The color area is removed from the list.</td>
</tr>
<tr>
<td><strong>Begin of area</strong></td>
<td>The start value on the “Scale” of the Histogram where the color area begins.</td>
</tr>
<tr>
<td><strong>End of area</strong></td>
<td>The end value on the “Scale” of the Histogram where the color area ends.</td>
</tr>
<tr>
<td><strong>Color</strong></td>
<td>Color that is used for displaying the area.</td>
</tr>
</tbody>
</table>

### Element property 'Absolute movement'

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Movement</strong></td>
<td></td>
</tr>
<tr>
<td><strong>X</strong></td>
<td>Variable (numeric data type). Defines the X position (in pixels). Example: PLC_PRG.iPos_X. Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td><strong>Y</strong></td>
<td>Variable (numeric data type). Defines the Y position (in pixels). Example: PLC_PRG.iPos_Y. Increasing this value in runtime mode moves the element downwards.</td>
</tr>
<tr>
<td><strong>Rotation</strong></td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees). Example: PLC_PRG.iAngle1. The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol. In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
</tr>
</tbody>
</table>
| "Interior rotation" | Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in "Center" according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the "Position ➔ Angle" property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

---

You can link the variables to a unit conversion.

---

The "X", "Y", "Rotation", and "Interior rotation" properties are supported by the "Client Animation" functionality.

See also

- 

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
“Animation duration” Defines the duration (in milliseconds) in which the element runs an animation

- Variable (integer value)
  Example: Menu.tContent with VAR tContent : INT := 500; END_VAR
- Integer literal
  Example: 500

Animatable properties

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

“Move to foreground” Moves the visualization element to the foreground

Variable (BOOL)

Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR

TRUE: At runtime, the visualization element is displayed in the foreground.
FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

Element property 'Access rights'

Requirement: User management is set up for the visualization.

“Access rights” Opens the “Access rights” dialog. There you can edit the access privileges for the element.

Status messages:

- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also

- § Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

Visualization Element ‘Image Switcher’

Symbol:

Category: “Lamps/Switches/Bitmaps”

The element displays one of three referenced images. Mouse actions change the displayed image. The images are defined in the “Image settings” element properties. The effects of mouse clicks are defined in the “Element behavior” property.

Element properties
**“Element name”**
Optional
Hint: Assign individual names for elements so that they are found faster in the element list.
Example: `ImageSwitcher_1`

**“Type of element”**
“Image Switcher”

---

**Element property 'Position'**
The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“X”</strong></td>
<td>X coordinate of the upper left corner of the element Specified in pixels. Example: 10.</td>
</tr>
<tr>
<td><strong>“Y”</strong></td>
<td>Y coordinate of the upper left corner of the element Specified in pixels. Example: 10.</td>
</tr>
<tr>
<td><strong>“Width”</strong></td>
<td>Specified in pixels. Example: 150</td>
</tr>
<tr>
<td><strong>“Height”</strong></td>
<td>Specified in pixels. Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (щен) to other positions in the editor.

See also
- § Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

**“Variable”**
Variable (`BOOL`).
The value of the variable changes according to user input and it is independent of the “Element behavior” element property.

---

**Image settings**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Image “on””</strong></td>
<td>Image ID from an image pool. The image can be selected using the input assistant. The image is used if the variable of the “Variable” property has the value <code>TRUE</code>.</td>
</tr>
<tr>
<td><strong>“Image “off””</strong></td>
<td>Image ID from an image pool. The image can be selected using the input assistant. The image is used if the variable of the “Variable” property has the value <code>FALSE</code>.</td>
</tr>
<tr>
<td><strong>“Image “clicked””</strong></td>
<td>Image ID from an image pool. The image is selected using the input assistant. In runtime mode, the visualization displays the referenced image when the element is clicked (and the mouse button is held down). Requirement: The “Element behavior” is “Image toggler”.</td>
</tr>
</tbody>
</table>
“Transparency”  [✓]: The “Transparent color” is selected.

“Transparent color” The image pixels that have the transparent color are displayed as transparent. Requirement: “Transparency” is activated.
- [✓]: The “Color” dialog box opens.
- [✓]: A drop-down list with color names opens.

“Scaling type” Defines how an image fits in the element frame.
- “Fixed”: The original size of the image is retained, regardless of the dimensions of the element.
- “Isotropic”: The entire image is shown in the element frame, either larger or smaller. As a result, the proportion of height and width are retained.
- “Anisotropic”: The image resizes automatically to the dimensions of the element frame, filling the entire element frame. As a result, the proportions are not retained.

“Horizontal alignment” Horizontal alignment of the image within the element frame or element
- Left
- Centered
- Right
Requirement: “Scaling type” is “Isotropic”.

“Vertical alignment” Vertical alignment of the image within the element frame or element
- Top
- Centered
- Bottom
Requirement: “Scaling type” is “Isotropic”.

“Element behavior”
- “Image toggler”: Every mouse click switches the image.
- “Image tapper”: While a visualization user holds down the mouse button, the image of the “Image on” property is displayed. At the same time, the value TRUE is assigned to the “Variable” property.

“Tap FALSE” [✓]: While the mouse button is pressed, the image of the “Image” property is displayed and the “Variable” property gets the value FALSE instead of the value TRUE, and back.
Requirement: “Image tapper” is selected in the “Element behavior” property.

Element property 'Center' The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the  symbol. The point is used as the center for rotating and scaling.

“X” X-coordinate of the point of rotation
“Y” Y-coordinate of the point of rotation

You can also change the values by dragging the symbols ( ) to other positions in the editor.

Element property 'Texts'
### "Tooltip"

String display as tooltip for the element

**Example:** Valid access.

---

**Element property 'Absolute movement'**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

---

#### "Movement"

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>X</strong></td>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
<td>PLC_PRG.iPos_X.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
<td></td>
</tr>
<tr>
<td><strong>Y</strong></td>
<td>Variable (numeric data type). Defines the Y position (in pixels).</td>
<td>PLC_PRG.iPos_Y.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
<td></td>
</tr>
</tbody>
</table>

---

#### "Rotation"

- **Variable (numeric data type). Defines the angle of rotation (in degrees).**

**Example:** PLC_PRG.iAngle1.

The midpoint of the element rotates at the "Center" point. This rotation point is shown as the symbol.

In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

---

#### "Interior rotation"

- **Variable (numeric data type). Defines the angle of rotation (in degrees).**

**Example:** PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in "Center" according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

**Note:** If a static angle of rotation is specified in the "Position ➔ Angle" property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

---

You can link the variables to a unit conversion.
The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Invisible”</td>
<td>Variable (BOOL). Toggles the visibility of the element. TRUE: The element is not visible at runtime. Example: <code>bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR</code></td>
</tr>
<tr>
<td>“Deactivate inputs”</td>
<td>Variable (BOOL). Toggles the operability of the element. TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.</td>
</tr>
</tbody>
</table>

The “Invisible” property is supported by the “Client Animation” functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
"Animation duration"  Defines the duration (in milliseconds) in which the element runs an animation

- Variable (integer value)
  Example: Menu.tContent with VAR tContent : INT := 500;
  END_VAR
- Integer literal
  Example: 500

Animatable properties

- "Absolute movement", "Movement", "X", "Y"
- "Absolute movement", "Rotation"
- "Absolute movement", "Interior rotation"
- "Absolute movement", "Exterior rotation"

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

"Move to foreground"  Moves the visualization element to the foreground

Variable (BOOL)

Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR

TRUE: At runtime, the visualization element is displayed in the foreground.
FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

Element property 'Access rights'

Requirement: User management is set up for the visualization.

"Access rights"  Opens the "Access rights" dialog. There you can edit the access privileges for the element.

Status messages:

- "Not set. Full rights.": Access rights for all user groups: "operable"
- "Rights are set: Limited rights": Access is restricted for at least one group.

See also

- § Chapter 6.4.5.21.3.1 “Dialog 'Access Rights'” on page 3366

See also

- § Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

Visualization Element 'Lamp'

Symbol:

Category: “Lamps/Switches/Bitmaps”

The element shows the value of a variable, and the element is displayed as illuminated or not.
Element properties

"Element name" Optional
Hint: Assign individual names for elements so that they are found faster in the element list.
Example: Lamp_green

"Type of element" “Lamp”

Element property 'Position'
The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>&quot;X&quot;</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td>Example:</td>
<td>10</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Y&quot;</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td>Example:</td>
<td>10</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Width&quot;</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example:</td>
<td>150</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Height&quot;</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example:</td>
<td>30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (_drag] to other positions in the editor.

See also
- § Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

<table>
<thead>
<tr>
<th>&quot;Variable&quot;</th>
<th>Variable (BOOL).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The variable value is displayed as a lamp that goes on (TRUE) or off (FALSE).</td>
</tr>
</tbody>
</table>

Image settings

| "Transparency" | [✓]: The “Transparent color” property is selected. |

| "Transparent color" | Pixels in this color are displayed as transparent. |
|                     | Requirement: “Transparency” is activated. |
|                     | ● [ ] The “Color” dialog box opens. |
|                     | ● [▼]: A drop-down list with style colors opens. |
“Scaling type” | Reaction of the element when the dimension of the “Frame” element is changed:
---|---
- **“Isotropic”**: The height and width of the image are resized proportionally to the “Frame”.
  Please note: To retain the alignment of elements also within a scaled “Frame” element, define the “Horizontal alignment” or “Vertical alignment” explicitly with “Centered”.
- **“Anisotropic”**: The image fills the entire “Frame” regardless of its proportions.

“Horizontal alignment” | Horizontal alignment of the image within the element frame or element
---|---
- Left
- Centered
- Right
Requirement: “Scaling type” is “Isotropic”.

“Vertical alignment” | Vertical alignment of the image within the element frame or element
---|---
- Top
- Centered
- Bottom
Requirement: “Scaling type” is “Isotropic”.

**Element property 'Center'** | The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.
---|---
**“X”** | X-coordinate of the point of rotation
**“Y”** | Y-coordinate of the point of rotation

You can also change the values by dragging the symbols to other positions in the editor.

**Element property 'Texts'** | String display as tooltip for the element
---|---
**“Tooltip”** | Example: Valid access.

**Element property 'Absolute movement'** | The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.
---|---
**“Movement”** | Variable (numeric data type). Defines the X position (in pixels).
---|---
**“X”** | Example: PLC_PRG.iPos_X.
Increasing this value in runtime mode moves the element to the right.
**“Y”** | Example: PLC_PRG.iPos_Y.
Increasing this value in runtime mode moves the element downwards.
"Rotation" Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle1.

The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.

In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

"Interior rotation" Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the "Client Animation" functionality.

See also

Element property 'State variables'

The variables control the element behavior dynamically.

"Invisible" Variable (BOOL). Toggles the visibility of the element.

TRUE: The element is not visible at runtime.

The “Invisible” property is supported by the "Client Animation" functionality.
These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

| “Animation duration” | Defines the duration (in milliseconds) in which the element runs an animation
| --- | ---
| • Variable (integer value)  
  **Example:** Menu.tContent with VAR tContent : INT := 500; END_VAR  
| • Integer literal  
  **Example:** 500  

Animatable properties:
- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

| “Move to foreground” | Moves the visualization element to the foreground  
| --- | ---
| Variable (BOOL)  
  **Example:** bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR  
| TRUE: At runtime, the visualization element is displayed in the foreground.  
| FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.  

Element property 'Background'

| “Image” | Drop-down list with background colors  
| --- | ---
| Depends on the visualization style  

Element property 'Access rights'

| “Access rights” | Opens the “Access rights” dialog. There you can edit the access privileges for the element.  
| --- | ---
| Status messages:  
  • “Not set. Full rights.”: Access rights for all user groups: “operable”  
  • “Rights are set: Limited rights”: Access is restricted for at least one group.  

See also
- § Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366  

See also
- § Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
Visualization Element 'Dip Switch', 'Power Switch', 'Push Switch', 'Push Switch LED', 'Rocker Switch'

Symbols:

Category: “Lamps/Switches/Bitmaps”

The element assigns a value to a Boolean variable. The switch position "on" the value TRUE to
the variable, and the switch position "off" assigns the value FALSE. Use the mouse to change
the switch position.

Element proper-
ties

<table>
<thead>
<tr>
<th>&quot;Element name&quot;</th>
<th>Example: Operating_Switch</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Type of element&quot;</th>
<th>Depending on the element: &quot;Dip Switch&quot;, “Power Switch”, “Push Switch”, “Push Switch LED”, or “Rocker Switch”</th>
</tr>
</thead>
</table>

Element proper-
ty 'Position'

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in pixels.</td>
<td></td>
</tr>
<tr>
<td>Example: 10.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in pixels.</td>
<td></td>
</tr>
<tr>
<td>Example: 10.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Width”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 150</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Height”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 30</td>
<td></td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (🗂) to other positions in the editor.

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

<table>
<thead>
<tr>
<th>&quot;Variable&quot;</th>
<th>Variable (BOOL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The value of the variables TRUE and FALSE indicates the switch position on/off.</td>
<td></td>
</tr>
</tbody>
</table>
Image settings

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Transparency”</td>
<td>√: The “Transparent color” property is selected. Pixels in this color are displayed as transparent. Requirement: “Transparency” is activated.</td>
</tr>
<tr>
<td>“Transparent color”</td>
<td>Pixels in this color are displayed as transparent. Requirement: “Transparency” is activated. ● The “Color” dialog box opens. ● A drop-down list with style colors opens.</td>
</tr>
<tr>
<td>“Scaling type”</td>
<td>Reaction of the element when the dimension of the “Frame” element is changed: ● “Isotropic”: The height and width of the image are resized proportionally to the “Frame”. Please note: To retain the alignment of elements also within a scaled “Frame” element, define the “Horizontal alignment” or “Vertical alignment” explicitly with “Centered”. ● “Anisotropic”: The image fills the entire “Frame” regardless of its proportions.</td>
</tr>
<tr>
<td>“Horizontal alignment”</td>
<td>Horizontal alignment of the image within the element frame or element ● Left ● Centered ● Right Requirement: “Scaling type” is “Isotropic”.</td>
</tr>
<tr>
<td>“Vertical alignment”</td>
<td>Vertical alignment of the image within the element frame or element ● Top ● Centered ● Bottom Requirement: “Scaling type” is “Isotropic”.</td>
</tr>
<tr>
<td>“Element behavior”</td>
<td>● “Image toggler”: Every mouse click changes the switch and the “Variable” value. ● “Image tapper”: The switch is “on” and the “Variable” value is TRUE while the mouse button is pressed.</td>
</tr>
<tr>
<td>“Tap FALSE”</td>
<td>√: The value TRUE is assigned to the “Variable” property instead of the value FALSE, and back. Requirement: “Image tapper” is selected in the “Element behavior” property.</td>
</tr>
</tbody>
</table>

Element property 'Center' The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
<td>X-coordinate of the point of rotation</td>
</tr>
<tr>
<td>“Y”</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (_PERSON) to other positions in the editor.

Element property 'Texts'
**Tooltip**

String display as tooltip for the element

**Example:** Valid access.

**Element property 'Absolute movement'**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th><strong>Movement</strong></th>
<th></th>
</tr>
</thead>
</table>
| **X**        | Variable (numeric data type). Defines the X position (in pixels).  
**Example:** PLC_PRG.iPos_X. 
Increasing this value in runtime mode moves the element to the right. |
| **Y**        | Variable (numeric data type). Defines the Y position (in pixels).  
**Example:** PLC_PRG.iPos_Y. 
Increasing this value in runtime mode moves the element downwards. |
| **Rotation** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
**Example:** PLC_PRG.iAngle1. 
The midpoint of the element rotates at the "Center" point. This rotation point is shown as the symbol. 
In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right. |
| **Interior rotation** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
**Example:** PLC_PRG.iAngle2. 
In runtime mode, the element rotates about the point of rotation specified in "Center" according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise. 
The rotation point is shown as the symbol. 
Note: If a static angle of rotation is specified in the "Position ➔ Angle" property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed. |

You can link the variables to a unit conversion.
The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

Element property ‘State variables’

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>“Invisible”</th>
<th>Variable (BOOL). Toggles the visibility of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRUE: The element is not visible at runtime.</td>
<td>Example: <code>bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR</code></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Deactivate inputs”</th>
<th>Variable (BOOL). Toggles the operability of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.</td>
<td></td>
</tr>
</tbody>
</table>

The “Invisible” property is supported by the “Client Animation” functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
"Animation duration" defines the duration (in milliseconds) in which the element runs an animation.

- **Variable (integer value)**
  - Example: `Menu.tContent with VAR tContent : INT := 500; END_VAR`
- **Integer literal**
  - Example: `500`

**Animatable properties**

- "Absolute movement", "Movement", "X", "Y"
- "Absolute movement", "Rotation"
- "Absolute movement", "Interior rotation"
- "Absolute movement", "Exterior rotation"

The animated movement is executed when at least one value of an animatable property has changed. The movement is then executed in a smooth and not jerky manner within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

"Move to foreground" moves the visualization element to the foreground.

- **Variable (BOOL)**
  - Example: `bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR`

- **TRUE**: At runtime, the visualization element is displayed in the foreground.
- **FALSE**: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

**Element property 'Background'**

- "Image" is a drop-down list with background colors.
- It depends on the visualization style.

**Element property 'Access rights'**

- Requirement: User management is set up for the visualization.

- "Access rights" opens the "Access rights" dialog. Here you can edit the access privileges for the element.

  - **Status messages:**
    - "Not set. Full rights.
    - "Rights are set: Limited rights": Access is restricted for at least one group.

  - See also
    - §Chapter 6.4.5.21.3.1 "Dialog 'Access Rights'" on page 3366

  - See also
    - §Chapter 6.4.5.5 "Designing a visualization with elements" on page 2872

**Visualization Element 'Rotary Switch'**

Symbol:
Category: “Lamps/Switches/Bitmaps”

The element assigns a value to a Boolean variable. The switch position "on" the value TRUE to the variable, and the switch position "off" assigns the value FALSE. Use the mouse to change the switch position.

**Element properties**

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: Operating_Switch</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
</tr>
<tr>
<td>“Type of element”</td>
<td>“Rotary Switch”</td>
</tr>
</tbody>
</table>

**Element property 'Position'**

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Width”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 150</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Height”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols ((JFrame) to other positions in the editor.

See also

- § Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

<table>
<thead>
<tr>
<th>“Variable”</th>
<th>Variable (BOOL).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The value of the variables TRUE and FALSE indicates the switch position on/off.</td>
</tr>
</tbody>
</table>

**Image settings**
**“Transparency”**  
☑️: The “Transparent color” property is selected.

**“Transparent color”**  
Pixels in this color are displayed as transparent.  
Requirement: “Transparency” is activated.  
- ☐: The “Color” dialog box opens.  
- ▼: A drop-down list with style colors opens.

**“Scaling type”**  
Reaction of the element when the dimension of the “Frame” element is changed:  
- “Isotropic”: The height and width of the image are resized proportionally to the “Frame”.  
  Please note: To retain the alignment of elements also within a scaled “Frame” element, define the “Horizontal alignment” or “Vertical alignment” explicitly with “Centered”.  
- “Anisotropic”: The image fills the entire “Frame” regardless of its proportions.

**“Horizontal alignment”**  
Horizontal alignment of the image within the element frame or element  
- Left  
- Centered  
- Right  
Requirement: “Scaling type” is “Isotropic”.

**“Vertical alignment”**  
Vertical alignment of the image within the element frame or element  
- Top  
- Centered  
- Bottom  
Requirement: “Scaling type” is “Isotropic”.

**“Element behavior”**  
- “Image toggler”: Every mouse click changes the switch and the “Variable” value.  
- “Image tapper”: The switch is "on" and the “Variable” value is TRUE while the mouse button is pressed.

**“Orientation”**  
- “At top”: The rotary switch turns from the top right to the top left.  
- “At side”: The rotary switch turns from the top right to the bottom right.

**“Color change”**  
☑️: The element changes in color when “Variable” is TRUE.

---

**Element property ‘Center’**  
The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the ☐ symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>Element property ‘Center’</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“X”</strong></td>
<td>X-coordinate of the point of rotation</td>
</tr>
<tr>
<td><strong>“Y”</strong></td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (☐) to other positions in the editor.

---

**Element property ‘Texts’**
### Element property 'Absolute movement'

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>“Movement”</th>
<th></th>
</tr>
</thead>
</table>
| **“X”** | Variable (numeric data type). Defines the X position (in pixels).  
Example: PLC_PRG.iPos_X.  
Increasing this value in runtime mode moves the element to the right. |
| **“Y”** | Variable (numeric data type). Defines the Y position (in pixels).  
Example: PLC_PRG.iPos_Y.  
Increasing this value in runtime mode moves the element downwards. |
| **“Rotation”** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
Example: PLC_PRG.iAngle1.  
The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.  
In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right. |
| **“Interior rotation”** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
Example: PLC_PRG.iAngle2.  
In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.  
The rotation point is shown as the symbol.  
Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed. |

You can link the variables to a unit conversion.
The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the "Client Animation" functionality.

See also

Element property 'State variables'

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Invisible&quot;</td>
<td>Variable (BOOL). Toggles the visibility of the element. TRUE: The element is not visible at runtime. Example: bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR</td>
<td></td>
</tr>
<tr>
<td>&quot;Deactivate inputs&quot;</td>
<td>Variable (BOOL). Toggles the operability of the element. TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.</td>
<td></td>
</tr>
</tbody>
</table>

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
**“Animation duration”**

Defines the duration (in milliseconds) in which the element runs an animation

- **Variable (integer value)**
  
  *Example:* Menu.tContent with
  ```
  VAR tContent : INT := 500;
  END_VAR
  ```

- **Integer literal**
  
  *Example:* 500

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**“Move to foreground”**

Moves the visualization element to the foreground

Variable (BOOL)

*Example:* bIsInForeground with
```
VAR bIsInForeground : BOOL := FALSE; END_VAR
```

TRUE: At runtime, the visualization element is displayed in the foreground.
FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

**Element property 'Background'**

**“Image”**

Drop-down list with background colors

Depends on the visualization style

**Element property 'Access rights'**

Requirement: User management is set up for the visualization.

**“Access rights”**

Opens the “Access rights” dialog. There you can edit the access privileges for the element.

Status messages:

- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also

- § Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

See also

- § Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

**Visualization Element 'Trace'**

Symbol:
Category: “Special Controls”

The element displays the graphical curve of variable values. In addition, variables can be configured to control the view.

See also

- Chapter 6.4.5.12 “Displaying data curve with trace” on page 2925
- “Dialog box 'Trace Configuration’” on page 3355

**Element properties**

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: Velocity</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Data Source”</td>
<td>Location where the trace data is buffered.</td>
</tr>
<tr>
<td></td>
<td>- “&lt;local application&gt;”: The trace record is listed below the local application. The visualization that contains the trace is located below this application. When the application is downloaded, the trace configuration is downloaded to the local device. During execution, the data is stored locally in the trace buffer.</td>
</tr>
<tr>
<td></td>
<td>- “&lt;data source name&gt;”: Data source that identifies the remote device where the trace record is created. When the local application is downloaded with the visualization, the trace configuration is downloaded to the remote device. During execution, the trace buffer is filled, and the trace data is transferred and then displayed in the local visualization as HMI. Example: DataSoure_PLC_A</td>
</tr>
<tr>
<td></td>
<td>Note: The trace buffer is filled only if the remote application is being executed. The data recording is started when the local visualization is started.</td>
</tr>
<tr>
<td>“Application”</td>
<td>Application where data was recorded.</td>
</tr>
<tr>
<td></td>
<td>- : Lists all applications that are present below the data source.</td>
</tr>
<tr>
<td></td>
<td>Requirement: A remote data source (not “&lt;local application&gt;”) is referenced in the “Data source” property.</td>
</tr>
<tr>
<td>“Type of element”</td>
<td>“Trace”</td>
</tr>
<tr>
<td>“Trace”</td>
<td>“&lt;name of trace configuration&gt;”: Opens the “Trace Configuration” dialog where you can modify the trace configuration.</td>
</tr>
</tbody>
</table>

See also

- “Dialog box 'Trace Configuration’” on page 3355
- Data Source Manager

**Element property 'Position’**

The position defines the location and size of the element in the visualization window. This is based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.
| **X**      | The x-coordinate of the upper left corner of the element  |
|           | Specified in pixels                                      |
|           | Example: 10                                             |
| **Y**     | The y-coordinate of the upper left corner of the element  |
|           | Specified in pixels                                      |
|           | Example: 10                                             |
| **Width** | Specified in pixels                                      |
|           | Example: 150                                            |
| **Height**| Specified in pixels                                     |
|           | Example: 30                                             |

Tip: You can change the values in “X”, “Y”, “Width”, and “Height” by dragging the corresponding symbols to another position in the editor.

| **Angle** | Static angle of rotation (in degrees)  |
|           | Example: 35                              |
|           | The element is displayed rotated in the editor. The point of rotation is the center of the element. A positive value rotates clockwise.  |
|           | Tip: You can change the value in the editor by focusing the element to the handle. When the cursor is displayed as a rotating arrow, you can rotate the element about its center as a handle. |
|           | ![Diagram](image.png)                      |
|           | (1): Handle                                  |

Note: If a dynamic angle of rotation is also configured in the property “Absolute movement → Internal rotation”, then the static and dynamic angles of rotation are added in runtime mode. The static angle of rotation acts as an offset.

See also
- § Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

| **Show cursor** | A cursor (vertical line) is displayed at the mouse position. The trigger and variable values where the cursor points are displayed as a tooltip. |
| **Overwrite existing trace on PLC** | If a trace with the same name is on the PLC, then it is overwritten at download with the configuration that is defined here. |
| **Number format** | Number format of values in the tooltip in printf syntax (example: %d, %5.2f). |

Element property 'Control variables'  The control variables are assigned automatically when you click "Insert elements for controlling Trace".
**“Reset Trigger”**
Variable (BOOL).
Standard control variable: bResetTrigger
TRUE: Resets the triggering. After the action is executed, the variable is set automatically to FALSE.

**“Start Trace”**
Variable (BOOL).
Standard control variable: bStart
TRUE: Starts the Trace. After the action is executed, the variable is set automatically to FALSE.

**“Stop Trace”**
Variable (BOOL).
Standard control variable: bStop
TRUE: Stops the Trace. After the action is executed, the variable is set automatically to FALSE.

**“Save Trace to a file”**

**“Save Trace”**
Variable (BOOL).
Standard control variable: bStore
TRUE: Saves the current trace configuration and the data that is stored in the development system to a file. When the action is ended, the variable is set automatically to FALSE.

**“File name”**
Variable (STRING) that contains the file name of the file to be saved.
Standard control variable: sStoreFilename

**“Load trace from file”**

**“Load Trace”**
Variable (BOOL).
Standard control variable: bRestore
TRUE: Reads the file specified below and loads its contents into the trace editor. The file contains a trace configuration and possibly also trace data. To do this, the stored trace configuration must match the application where the trace configuration is located. When the action is ended, the variable is set automatically to FALSE.

Note: A trace configuration can be loaded from a file only under special circumstances. The file must have been created with exactly the same (running) application with which it will then be loaded. The consequence of changing the running application (for example by downloading again) is that a file which was previously created from the application cannot no longer be read into the application. Even external manual changes to the file can cause this. You should edit only those configuration settings that have an effect on displaying the variables. If you change variable definitions directly in the file (for example by replacing variable x with v y), then the file cannot be loaded.

**“File name”**
Variable (STRING) that contains the file name of the file to be read.
Standard control variable: sRestoreFilename

See also
● Chapter 6.4.5.21.2.15 “Command ’Insert Elements for Controlling Trace’” on page 3358

Element property 'Center'
The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the ⚫ symbol. The point is used as the center for rotating and scaling.
<table>
<thead>
<tr>
<th>“X”</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (⊕) to other positions in the editor.

**Element property 'Absolute movement'**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

**“Movement”**

| “X” | Variable (numeric data type). Defines the X position (in pixels).  
Example: PLC_PRG.iPos_X.  
Increasing this value in runtime mode moves the element to the right. |
|------|------------------------------------------------------------------|
| “Y” | Variable (numeric data type). Defines the Y position (in pixels).  
Example: PLC_PRG.iPos_Y.  
Increasing this value in runtime mode moves the element downwards. |

**“Rotation”**

| “Rotation” | Variable (numeric data type). Defines the angle of rotation (in degrees).  
Example: PLC_PRG.iAngle1.  
The midpoint of the element rotates at the “Center” point. This rotation point is shown as the ⊕ symbol.  
In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right. |

**“Interior rotation”**

| “Interior rotation” | Variable (numeric data type). Defines the angle of rotation (in degrees).  
Example: PLC_PRG.iAngle2.  
In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.  
The rotation point is shown as the ⊕ symbol.  
Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed. |
You can link the variables to a unit conversion.

The "X", "Y", "Rotation", and "Interior rotation" properties are supported by the "Client Animation" functionality.

See also

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>&quot;Invisible&quot;</th>
<th>Variable (BOOL). Toggles the visibility of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRUE</td>
<td>The element is not visible at runtime.</td>
</tr>
</tbody>
</table>

The "Invisible" property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
"Animation duration" | Defines the duration (in milliseconds) in which the element runs an animation
| **Variable (integer value)**
| Example: Menu.tContent with VAR tContent : INT := 500; END_VAR
| **Integer literal**
| Example: 500

Animatable properties

- "Absolute movement", "Movement", "X", "Y"
- "Absolute movement", "Rotation"
- "Absolute movement", "Interior rotation"
- "Absolute movement", "Exterior rotation"

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

"Move to foreground" | Moves the visualization element to the foreground
Variable (BOOL)
Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR
TRUE: At runtime, the visualization element is displayed in the foreground.
FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

Element property 'Access rights' | Requirement: User management is set up for the visualization.

"Access rights" | Opens the "Access rights" dialog. There you can edit the access privileges for the element.
Status messages:
- "Not set. Full rights.": Access rights for all user groups: "operable"
- "Rights are set: Limited rights": Access is restricted for at least one group.

See also
- % Chapter 6.4.5.21.3.1 "Dialog 'Access Rights'" on page 3366

Visualization Element 'Trend'
Symbol:

Category: "Special Controls"

The element displays the curve of variable values as a trend diagram. The trend diagram is suitable for representing a long-term data curve because the data is read from a trend recording and hence from a database. Moreover, you can run the "Trend" element together with the "Date Range Picker", "Legend", and "Time Range Picker" operating elements so that the user can navigate conveniently in the diagram.
You can programmatically delete the recorded trend curve at runtime. The recording starts again from the time of deletion. See the help page for "Programming a Trend Visualization".

**Element properties**

<table>
<thead>
<tr>
<th>&quot;Element name&quot;</th>
<th>Example: Velocity</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Data source&quot;</td>
<td>Data source for the connection via the device and the application to the “Trend Recording” object where the trend data that you want to show was saved. If the “Trend Recording” object is on the local device, then it is sufficient when you specify the respective application. If the trend recording is on a remote device, then you need to specify the data source connection to this device.</td>
</tr>
</tbody>
</table>
|                | *° <local application>“*  
|                | The “Trend Recording” object is located on the local device in the local application. |
|                | *<device name> . <application name>*  
|                | Example: Device_A.App_A  
|                | The “Trend Recording” object is located on the local device Device_A below the application App_A. |
|                | *■<data source name>*  
|                | Example: DataSource_B  
|                | The “Trend Recording” object is located on a remote device that is connected via the data source DataSource_B. Below the (now visible) “Application” property, the remote application is displayed as configured in the data source. |
|                | Example: App_B  
|                | Note: If the data source is accessed symbolically by means of a symbol file (CODESYS symbolic), then the required symbol file and the corresponding project have to be saved in the same folder. |

<table>
<thead>
<tr>
<th>&quot;Type of element&quot;</th>
<th>&quot;Trend&quot;</th>
</tr>
</thead>
</table>
| "Trend recording" | ◊: Trend recording whose data is displayed as a diagram  
|                   | The trend recording is located on the device specified in the “Data source” property. |

| "Display Mode" | ◊: Opens the “Display Settings” dialog. |

See also

- Chapter 6.4.5.13 “Displaying data curve with trend” on page 2928
- Chapter 6.4.5.21.2.16 “Command ‘Configure Display Settings of Trend’” on page 3359
- Object ‘Data Source’

**Element property 'Position'**

The position defines the location and size of the element in the visualization window. This is based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.
| **X** | The x-coordinate of the upper left corner of the element  
Specified in pixels  
Example: 10 |
|---|---|
| **Y** | The y-coordinate of the upper left corner of the element  
Specified in pixels  
Example: 10 |
| **Width** | Specified in pixels  
Example: 150 |
| **Height** | Specified in pixels  
Example: 30 |
| Tip: You can change the values in “X”, “Y”, “Width”, and “Height” by dragging the corresponding symbols to another position in the editor. |
| **Angle** | Static angle of rotation (in degrees)  
Example: 35  
The element is displayed rotated in the editor. The point of rotation is the center of the element. A positive value rotates clockwise.  
Tip: You can change the value in the editor by focusing the element to the handle. When the cursor is displayed as a rotating arrow, you can rotate the element about its center as a handle. |
| (1): Handle |
| Note: If a dynamic angle of rotation is also configured in the property “Absolute movement ➔ Internal rotation”, then the static and dynamic angles of rotation are added in runtime mode. The static angle of rotation acts as an offset. |

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874
**“Show cursor”**

- A cursor (black triangle with vertical line) is shown in the trend diagram.

  Behavior at runtime: As soon as the graph is drawn, the user can move the cursor along the time axis in order to mark a specific time. Then the variable value belonging to the cursor position is displayed in the legend above the graph.

**“Show tooltip”**

- Requirement: “Show cursor” is activated.

- A tooltip opens at the cursor.

  Behavior at runtime: The variable value belonging to the cursor position is displayed as a tooltip.

**“Show frame”**

- The trend diagram is drawn with a frame.

**“Number format”**

- Format specification in printf syntax, which determines how the values are displayed in the tooltip and in the legend

  Example: `%d` (integer variable) or `%5.2f` (floating-point number)

---

**Element property 'Tick mark labels'**

- The time stored in the trend recording are in the UTC time zone. If the time is displayed in the trend of the visualization element, then the time stamps are converted to the local time zone of the operating system of the PLC.

- Change the time zone in the operating system if the times in the trend diagram are not in the zone that you need.
<table>
<thead>
<tr>
<th><strong>“Time stamps”</strong></th>
<th>X-value of the trend diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>● “<strong>Absolute time stamps</strong>”</td>
</tr>
<tr>
<td></td>
<td>The absolute time with date and time is displayed at each tick mark on the time axis.</td>
</tr>
<tr>
<td></td>
<td>Example: 03/18/2016 12h30m50s</td>
</tr>
<tr>
<td></td>
<td>● “<strong>Relative time stamps</strong>”</td>
</tr>
<tr>
<td></td>
<td>The time period from the start of the recording (=0) is displayed at each tick mark.</td>
</tr>
<tr>
<td></td>
<td>Example: 5m30s</td>
</tr>
</tbody>
</table>

| “Draw labels on two lines” | ✔: The time stamps are displayed on two lines (for example, the date is displayed on the first line and the time on the second line). |
|                          | ☐: The time stamp is displayed on one line. Example: 2019-11-01-12:30:50. |

| “Omit irrelevant information in timestamps” | ✔: The time stamps are displayed in a truncated form (without insignificant information). For example, the date is displayed at the first tick mark, and only the time is displayed at the following tick marks. The “**Internationalization (format strings)**” property is not visible and is ignored. |
|                                             | ☐: The time stamps are displayed with all information. This takes into consideration the “**Internationalization (format strings)**” property which contains the format specification for the date and time display. |

| “Internationalization (format strings)” | Format specification for the date and time display of the time stamp (when it is displayed in full) |
|                                         | Note: The property is visible only if the “Omit irrelevant information in timestamps” option is **not** selected. |
**Date**

Format string that returns the date display according to the defined format. The operating system locale is used as the default setting.

Defined format strings for the date:

- **Year:** yyyy, yy, y
- **Month:** MM, M
- **Day:** dd, d
- **Recommended separator:** - /

Example:

- `yyyy-MM-d` displays `2019-10-25`
- `yyyy-MM-dd` displays `2019-10-25`
- `dd.MM.yyyy` displays `25.10.2019`
- `dd/MM/yyyy` displays `25/10/2019`

**Time**

Format string that returns the time (or time of day) display according to the defined format. The operating system locale is used as the default setting.

Defined format strings for the time:

- **24-hour time definition:** HH, H
- **12-hour time definition:** hh, h
- **AM/PM for 12-hour time definition:** tt
- **Minutes:** mm, m
- **Seconds:** ss, s
- **Milliseconds:** ms
- **Microseconds:** us
- **Recommended separator:** : or space character

Example:

- `HH:mm:ss:ms` displays `15:30:59:123`
- `h:mm:ss tt` displays `3:30:59 PM`

See also

- § Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329

**Element property 'Assigned control elements'**

These elements are created automatically when the control elements are added with the command “Insert elements for controlling Trend”.

---

**Date Range Picker**

Control element for changing the date and time of the displayed data sets. With all elements are provided that have implemented the interface IDateRangeSelector. By default, instances of the “Date Range Picker” visualization element are available.

**Time Range Picker**

Control element for changing the time of the displayed data sets. With all elements are provided that have implemented the interface ITimeSelector. By default, instances of the “Time Range Picker” visualization element are available.

**Legend**

Control element for displaying a legend for the graphs. With all elements are provided that have implemented the interface ILegendDisplayer.

See also

- § Chapter 6.4.5.21.2.18 “Command 'Insert Elements for Controlling the Trend'” on page 3360
Element property 'Center'  

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

| "X"       | X-coordinate of the point of rotation |
| "Y"       | Y-coordinate of the point of rotation |

You can also change the values by dragging the symbols (⊕) to other positions in the editor.

Element property 'Absolute movement'  

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

| "Movement" | 
| "X" Variable (numeric data type). Defines the X position (in pixels).  Example: PLC_PRG.iPos_X.  Increasing this value in runtime mode moves the element to the right. |
| "Y" Variable (numeric data type). Defines the Y position (in pixels).  Example: PLC_PRG.iPos_Y.  Increasing this value in runtime mode moves the element downwards. |

| "Rotation" | Variable (numeric data type). Defines the angle of rotation (in degrees).  Example: PLC_PRG.iAngle1.  The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.  In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right. |

| "Interior rotation" | Variable (numeric data type). Defines the angle of rotation (in degrees).  Example: PLC_PRG.iAngle2.  In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.  The rotation point is shown as the symbol.  Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed. |
You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- The variables control the element behavior dynamically.

**Element property ‘State variables’**

<table>
<thead>
<tr>
<th>“Invisible”</th>
<th>Variable (BOOL). Toggles the visibility of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>TRUE: The element is not visible at runtime.</td>
</tr>
</tbody>
</table>

The “Invisible” property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
Animation duration

Defines the duration (in milliseconds) in which the element runs an animation

- Variable (integer value)
  Example: Menu.tContent with VAR tContent : INT := 500; END_VAR
- Integer literal
  Example: 500

Animatable properties

- "Absolute movement", "Movement", "X", "Y"
- "Absolute movement", "Rotation"
- "Absolute movement", "Interior rotation"
- "Absolute movement", "Exterior rotation"

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

Move to foreground

Moves the visualization element to the foreground

Variable (BOOL)

Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR

TRUE: At runtime, the visualization element is displayed in the foreground.
FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

Element property 'Access rights'

Requirement: User management is set up for the visualization.

Access rights

Opens the "Access rights" dialog. There you can edit the access privileges for the element.

Status messages:

- "Not set. Full rights": Access rights for all user groups: "operable"
- "Rights are set: Limited rights": Access is restricted for at least one group.

See also

- Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

See also

- Chapter 6.4.5.13 “Displaying data curve with trend” on page 2928
- Chapter 6.4.5.13.2 “Getting Started with Trend Visualization” on page 2928
- Chapter 6.4.5.13.3 “Programming a Trend Visualization” on page 2931
- Object 'Trend Recording'

Visualization Element 'Legend'

Symbol:

Category: “Special Controls”
The element is used as a legend for another element (for example, a trend). The legend is assigned in the properties of the other element.

See also

- Chapter 6.4.5.13 “Displaying data curve with trend” on page 2928

### Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: LegendOfTrendA</th>
</tr>
</thead>
</table>

Optional

*Hint: Assign individual names for elements so that they are found faster in the element list.*

<table>
<thead>
<tr>
<th>“Type of element”</th>
<th>“Legend”</th>
</tr>
</thead>
</table>

### Element property 'Position'

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Width”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 150</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Height”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 30</td>
</tr>
</tbody>
</table>

*You can also change the values by dragging the box symbols (.rectangle) to other positions in the editor.*

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

### Element property 'Center'

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the  icon. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y-coordinate of the point of rotation</th>
</tr>
</thead>
</table>
You can also change the values by dragging the symbols ( resizable) to other positions in the editor.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Orientation&quot;</td>
<td>Orientation of the element. The value is configured in the assigned element.</td>
</tr>
<tr>
<td></td>
<td>- &quot;Horizontal&quot;</td>
</tr>
<tr>
<td></td>
<td>- &quot;Vertical&quot;</td>
</tr>
<tr>
<td>&quot;Attached element instance&quot;</td>
<td>Example: Element_A</td>
</tr>
<tr>
<td>&quot;Show frame&quot;</td>
<td>[ ]: The element is displayed with frames.</td>
</tr>
<tr>
<td>&quot;Number format&quot;</td>
<td>The format of the value in printf syntax (example: %d, %5.2f)</td>
</tr>
</tbody>
</table>

**Element Property 'Layout'**

Defines how many variables can be displayed at a maximum and is calculated from the row and column number.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Max. number of rows&quot;</td>
<td>Example: 3</td>
</tr>
<tr>
<td>&quot;Max. number of columns&quot;</td>
<td>Example: 2</td>
</tr>
</tbody>
</table>

**Element Property 'Text properties'**

The property affects the text configured in the associated element.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Text format&quot;</td>
<td>&quot;Default&quot;: The text will be cut and displayed in only the part that fits into the visualization element.</td>
</tr>
<tr>
<td></td>
<td>&quot;Linebreak&quot;: The text will be wrapped in rows.</td>
</tr>
<tr>
<td></td>
<td>&quot;Ellipsis&quot;: The text is cut and ellipsis . . . are added to indicate that something is missing.</td>
</tr>
<tr>
<td>&quot;Font&quot;</td>
<td>Font of the text. The entries of the selection list are defined in the visualization style.</td>
</tr>
<tr>
<td>&quot;Font color&quot;</td>
<td>Text color, for example Grey. The entries of the selection list are defined in the visualization style.</td>
</tr>
<tr>
<td>&quot;Transparency&quot;</td>
<td>Transparency value (255 to 0), which defines the transparency of the corresponding color. Example: 255: The color is opaque. 0: The color is fully transparent.</td>
</tr>
</tbody>
</table>

**Element property 'Absolute movement'**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Movement&quot;</td>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
</tr>
<tr>
<td>&quot;X&quot;</td>
<td>Example: PLC_PRG.iPos_X.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td>Property</td>
<td>Variable (numeric data type). Defines the Y position (in pixels).</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------</td>
</tr>
<tr>
<td>“Y”</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Property</th>
<th>Variable (numeric data type). Defines the angle of rotation (in degrees).</th>
<th>Example: PLC_PRG.iAngle1.</th>
<th>The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Rotation”</td>
<td></td>
<td></td>
<td>In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
</tr>
<tr>
<td>“Interior rotation”</td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
<td>Example: PLC_PRG.iAngle2.</td>
<td>In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise. The rotation point is shown as the symbol.</td>
</tr>
</tbody>
</table>

Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
**“Animation duration”**

Defines the duration (in milliseconds) in which the element runs an animation

- **Variable (integer value)**
  
  Example: `Menu.tContent with VAR tContent : INT := 500; END_VAR`

- **Integer literal**
  
  Example: `500`

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**“Move to foreground”**

Moves the visualization element to the foreground

Variable (BOOL)

Example: `bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR`

TRUE: At runtime, the visualization element is displayed in the foreground.

FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

---

**Element property 'Access rights'**

Requirement: User management is set up for the visualization.

**“Access rights”**

Opens the “Access rights” dialog. There you can edit the access privileges for the element.

Status messages:

- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also

- § Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

---

**Visualization Element ‘ActiveX’**

**Symbol:**

Category: “Special Controls”

The element is used to link an existing ActiveX control in the visualization. You can configure the method calls and their parameters in the element properties of the “ActiveX” element.

---

**Element properties**
### Element property ‘Position’

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th><strong>“X”</strong></th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels. [\text{Example: 10.}]</td>
</tr>
<tr>
<td><strong>“Y”</strong></td>
<td>Y coordinate of the upper left corner of the element</td>
</tr>
<tr>
<td></td>
<td>Specified in pixels. [\text{Example: 10.}]</td>
</tr>
<tr>
<td><strong>“Width”</strong></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>[\text{Example: 150}]</td>
</tr>
<tr>
<td><strong>“Height”</strong></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>[\text{Example: 30}]</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (¶) to other positions in the editor.

See also

- § Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

### Element property ‘Center’

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th><strong>“X”</strong></th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Y”</strong></td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (¶) to other positions in the editor.

### Element property ‘Absolute movement’

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.
**“Movement”**

| **“X”** | Variable (numeric data type). Defines the X position (in pixels).  
| Example: PLC_PRG.iPos_X.  
| Increasing this value in runtime mode moves the element to the right. |
| **“Y”** | Variable (numeric data type). Defines the Y position (in pixels).  
| Example: PLC_PRG.iPos_Y.  
| Increasing this value in runtime mode moves the element downwards. |
| **“Rotation”** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
| Example: PLC_PRG.iAngle1.  
| The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.  
| In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right. |
| **“Scaling”** | Variable (integer data type). Causes centric stretching.  
| Example: PLC_PRG.iScaling.  
| The reference point is the “Center” property.  
| The value 1 shrinks the element by a factor of 0.001. The value 1000 returns the element to its original size. |
| **“Interior rotation”** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
| Example: PLC_PRG.iAngle2.  
| In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.  
| The rotation point is shown as the symbol.  
| Note: If a static angle of rotation is specified in the property “Position ➔ Angle”, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed. |

---

You can link the variables to a unit conversion.

The properties “X”, “Y”, “Rotation”, and “Interior rotation” are supported by the “Client Animation” functionality.
See also

- The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Invisible”</strong></td>
<td>Variable (BOOL). Toggles the visibility of the element. TRUE: The element is not visible at runtime.</td>
</tr>
</tbody>
</table>

> The “Invisible” property is supported by the "Client Animation" functionality.

**Element property 'State variables'**

- These method calls are executed during initialization. They are executed in the first cycle only.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Method calls”</strong></td>
<td>Button &quot;Create new&quot; Creates a subnode below “Methods” with parameters for the method call.</td>
</tr>
<tr>
<td><strong>“Methods”</strong></td>
<td>![call condition variable (BOOL)] “Method”: Name of the method “Parameter”: Parameter passed at the method call “Result parameter”: Optional variable for the return value of the method</td>
</tr>
</tbody>
</table>

**Element property 'Initial calls'**

- These method calls are executed in every cycle. They are executed in the refresh rate of the visualization.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Method calls”</strong></td>
<td>Button &quot;Create new&quot; Creates a subnode below “Methods” for a method call and its parameters.</td>
</tr>
<tr>
<td><strong>“Methods”</strong></td>
<td>![call condition variable (BOOL)] “Method”: Name of the method “Parameter”: Parameter passed at the method call “Result parameter”: Optional variable for the return value of the method</td>
</tr>
</tbody>
</table>

**Element property 'Cyclic calls'**

- These method calls are executed in the refresh rate of the visualization. You define the call condition in the property “Methods → ![call condition variable (BOOL)] → Call condition”.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Method calls”</strong></td>
<td>Button &quot;Create new&quot; Creates a subnode below “Methods” with a call condition and parameters for the method call.</td>
</tr>
<tr>
<td><strong>“Methods”</strong></td>
<td>![call condition variable (BOOL)] “Method”: Name of the method “Call condition”: Variable (BOOL). A rising edge of this variable triggers the call of this method. “Parameter”: Parameter passed at the method call “Result parameter”: Optional variable for the return value of the method</td>
</tr>
</tbody>
</table>
These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

<table>
<thead>
<tr>
<th><strong>Animation duration</strong></th>
<th>Defines the duration (in milliseconds) in which the element runs an animation</th>
</tr>
</thead>
<tbody>
<tr>
<td>– Variable (integer value)</td>
<td></td>
</tr>
<tr>
<td>Example: Menu.tContent with VAR tContent : INT := 500; END_VAR</td>
<td></td>
</tr>
<tr>
<td>– Integer literal</td>
<td></td>
</tr>
<tr>
<td>Example: 500</td>
<td></td>
</tr>
</tbody>
</table>

Animatable properties

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

<table>
<thead>
<tr>
<th><strong>Move to foreground</strong></th>
<th>Moves the visualization element to the foreground</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable (BOOL)</td>
<td></td>
</tr>
<tr>
<td>Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR</td>
<td></td>
</tr>
<tr>
<td>TRUE: At runtime, the visualization element is displayed in the foreground.</td>
<td></td>
</tr>
<tr>
<td>FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.</td>
<td></td>
</tr>
</tbody>
</table>

Element property 'Access rights' Requirement: User management is set up for the visualization.

<table>
<thead>
<tr>
<th><strong>Access rights</strong></th>
<th>Opens the “Access rights” dialog. There you can edit the access privileges for the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status messages:</td>
<td>- “Not set. Full rights.”: Access rights for all user groups: “operable”</td>
</tr>
<tr>
<td></td>
<td>- “Rights are set: Limited rights”: Access is restricted for at least one group.</td>
</tr>
</tbody>
</table>

See also

- § Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

Visualization Element 'Web Browser'

Symbol:

Category: “Special Controls”

The element shows a website, PDF file, or video that has a URL.
NOTICE!
The display options of the “Web Browser” element depend on the operating system and the display variant of the visualization.

Requirement: The software components of the web browser are available in the runtime and configured accordingly (example: videos to be shown on Linux).

See also

- § Chapter 6.4.5.2.6 “Displaying Web Contents” on page 2865

**Element properties**

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: GenElemInst_59</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Type of element”</td>
<td>“Web Browser”</td>
</tr>
</tbody>
</table>

**Element property 'Position'**
The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

| “X” | X coordinate of the upper left corner of the element  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

| “Y” | Y coordinate of the upper left corner of the element  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

| “Width” | Specified in pixels.  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 150</td>
</tr>
</tbody>
</table>

| “Height” | Specified in pixels.  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (_drag_ to other positions in the editor.

See also

- § Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

**Element property 'Center'**
The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the _rotation_ symbol. The point is used as the center for rotating and scaling.

| “X” | X-coordinate of the point of rotation  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| “Y” | Y-coordinate of the point of rotation  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
You can also change the values by dragging the symbols (قبول) to other positions in the editor.

**Element property 'Absolute movement'**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

### "Movement"

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>X</strong></td>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
<td>PLC_PRG.iPos_X.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
<td></td>
</tr>
<tr>
<td><strong>Y</strong></td>
<td>Variable (numeric data type). Defines the Y position (in pixels).</td>
<td>PLC_PRG.iPos_Y.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
<td></td>
</tr>
</tbody>
</table>

### "Rotation"

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rotation</strong></td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
<td>PLC_PRG.iAngle1.</td>
</tr>
<tr>
<td></td>
<td>The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
<td></td>
</tr>
</tbody>
</table>

### "Scaling"

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scaling</strong></td>
<td>Variable (integer data type). Causes centric stretching.</td>
<td>PLC_PRG.iScaling.</td>
</tr>
<tr>
<td></td>
<td>The reference point is the “Center” property.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The value 1 shrinks the element by a factor of 0.001. The value 1000 returns the element to its original size.</td>
<td></td>
</tr>
</tbody>
</table>

### "Interior rotation"

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Interior rotation</strong></td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
<td>PLC_PRG.iAngle2.</td>
</tr>
<tr>
<td></td>
<td>In runtime mode, the element rotates about the point of rotation specified in &quot;Center&quot; according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The rotation point is shown as the symbol.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Note: If a static angle of rotation is specified in the property &quot;Position ➔ Angle&quot;, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.</td>
<td></td>
</tr>
</tbody>
</table>
You can link the variables to a unit conversion.

The properties “X”, “Y”, “Rotation”, and “Interior rotation” are supported by the “Client Animation” functionality.

See also

Element property ‘State variables’

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>“Invisible”</th>
<th>Variable (BOOL). Toggles the visibility of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>TRUE: The element is not visible at runtime.</td>
</tr>
</tbody>
</table>

The “Invisible” property is supported by the "Client Animation" functionality.

Element property ‘Control variables’

<table>
<thead>
<tr>
<th>“URL”</th>
<th>URL of the web page that is displayed in the visualization.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Variable (STRING or WSTRING)</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.stURL</td>
</tr>
<tr>
<td></td>
<td>• Literal in single straight quotation marks</td>
</tr>
<tr>
<td></td>
<td>Example: '<a href="http://de.wikipedia.org">http://de.wikipedia.org</a>'</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Show”</th>
<th>Variable (BOOL).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: PLC_PRG.bSetURL</td>
</tr>
<tr>
<td></td>
<td>Controls the display of the “Web browser” element.</td>
</tr>
<tr>
<td></td>
<td>If the variable contains a rising edge, then the visualization calls the web page given in “URL” and displays its contents in the ‘Web browser’ visualization element.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Back”</th>
<th>Variable (BOOL).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: PLC_PRG.bGoBack</td>
</tr>
<tr>
<td></td>
<td>Controls the back navigation in the “Web browser”. If the variable has a rising edge, then the visualization displays the contents of the previously displayed page.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Forward”</th>
<th>Variable (BOOL).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: PLC_PRG.bGoForward</td>
</tr>
<tr>
<td></td>
<td>Controls the forward navigation in the “Web browser”. If the variable has a rising edge, then the visualization displays the contents of the previously displayed page.</td>
</tr>
</tbody>
</table>
These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

| “Animation duration” | Defines the duration (in milliseconds) in which the element runs an animation  
|-----------------------|----------------------------------------------------------------------------------|
| ● Variable (integer value)  
  Example: Menu.tContent with VAR tContent : INT := 500; END_VAR  
| ● Integer literal  
  Example: 500  
| Animatable properties  
  ● “Absolute movement”, “Movement”, “X”, “Y”  
  ● “Absolute movement”, “Rotation”  
  ● “Absolute movement”, “Interior rotation”  
  ● “Absolute movement”, “Exterior rotation”  
| The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth. |

| “Move to foreground” | Moves the visualization element to the foreground  
|----------------------|----------------------------------------------------------------------------------|
| Variable (BOOL)  
  Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR  
| TRUE: At runtime, the visualization element is displayed in the foreground.  
| FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor. |

Element property 'Access rights'

Requirement: User management is set up for the visualization.

| “Access rights” | Opens the “Access rights” dialog. There you can edit the access privileges for the element.  
|-----------------|----------------------------------------------------------------------------------|
| Status messages:  
  ● “Not set. Full rights.”: Access rights for all user groups: “operable”  
  ● “Rights are set: Limited rights”: Access is restricted for at least one group. |

See also

- % Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

Visualization Element ‘Busy Symbol, Cube’

Symbol:

Category: “Special Controls”

At runtime, this element indicates automatically that the runtime is busy or waiting for data.
Element properties

<table>
<thead>
<tr>
<th>Element name</th>
<th>Example: Data_Transfer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
</tbody>
</table>

| Type of element   | "Busy Symbol, Cube" |

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>X</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels. Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Y</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels. Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Width</th>
<th>Specified in pixels. Example: 150</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Height</th>
<th>Specified in pixels. Example: 30</th>
</tr>
</thead>
</table>

You can also change the values by dragging the box symbols (⬛) to other positions in the editor.

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

Element property 'Center'

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the 🦜 symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>X</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Y</th>
<th>Y-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols ( vinden) to other positions in the editor.

Element property 'Absolute movement'

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.
### Movement

<table>
<thead>
<tr>
<th><strong>X</strong></th>
<th>Variable (numeric data type). Defines the X position (in pixels).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example</td>
<td>PLC_PRG.iPos_X.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Y</strong></th>
<th>Variable (numeric data type). Defines the Y position (in pixels).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example</td>
<td>PLC_PRG.iPos_Y.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Rotation</strong></th>
<th>Variable (numeric data type). Defines the angle of rotation (in degrees).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example</td>
<td>PLC_PRG.iAngle1.</td>
</tr>
<tr>
<td></td>
<td>The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.</td>
</tr>
<tr>
<td></td>
<td>In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Interior rotation</strong></th>
<th>Variable (numeric data type). Defines the angle of rotation (in degrees).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example</td>
<td>PLC_PRG.iAngle2.</td>
</tr>
<tr>
<td></td>
<td>In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.</td>
</tr>
<tr>
<td></td>
<td>The rotation point is shown as the symbol.</td>
</tr>
<tr>
<td></td>
<td>Note: If a static angle of rotation is specified in the “Position Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.</td>
</tr>
</tbody>
</table>

- You can link the variables to a unit conversion.

- The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- Element property ‘State variables’

The variables control the element behavior dynamically.
"Invisible" variable (BOOL). Toggles the visibility of the element.

**FALSE**: The element is not visible at runtime.

---

The "Invisible" property is supported by the "Client Animation" functionality.

---

These properties are available only when you have selected the "Support client animations and overlay of native elements" option in the Visualization Manager.

---

"Animation duration" defines the duration (in milliseconds) in which the element runs an animation.

- **Variable (integer value)**
  - Example: Menu.tContent with VAR tContent : INT := 500;
    END_VAR
- **Integer literal**
  - Example: 500

**Animatable properties**

- "Absolute movement", "Movement", "X", "Y"
- "Absolute movement", "Rotation"
- "Absolute movement", "Interior rotation"
- "Absolute movement", "Exterior rotation"

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

---

"Move to foreground" moves the visualization element to the foreground.

**Variable (BOOL)**

- Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR

**TRUE**: At runtime, the visualization element is displayed in the foreground.
**FALSE**: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

---

Element property 'Access rights'

Requirement: User management is set up for the visualization.

"Access rights" opens the "Access rights" dialog. There you can edit the access privileges for the element.

**Status messages:**

- "Not set. Full rights.": Access rights for all user groups : "operable"
- "Rights are set: Limited rights": Access is restricted for at least one group.

---

See also

- "Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366"
Visualization Element 'Busy Symbol, Flower'

Symbol:

Category: “Special Controls”
The element indicates that the system is busy or waiting for data.

Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: Data_Transfer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
</tbody>
</table>

| “Type of element”  | “Busy Symbol, Flower” |

Element property 'Position'
The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element Specified in pixels. Example: 10.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Y coordinate of the upper left corner of the element Specified in pixels. Example: 10.</td>
</tr>
<tr>
<td>“Width”</td>
<td>Specified in pixels. Example: 150</td>
</tr>
<tr>
<td>“Height”</td>
<td>Specified in pixels. Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols ( ) to other positions in the editor.

See also

- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874
The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols to other positions in the editor.

The properties contain fixed values for setting colors.

| “Frame color” |  |
| “Fill color”  |  |
| “Transparency” | Value (0 to 255) for defining the transparency of the selected color. Example 255: The color is opaque. 0: The color is completely transparent. |

The properties contain fixed values for setting the look of the element.

| “Line width” | Value in pixels |
| “Fill attributes” | The way in which the element is filled. |
| “Line style” | Type of line representation |

You can assign variables in the “Appearance variables” property for controlling the appearance dynamically. The fixed values here are overwritten.

See also
- § Chapter 6.4.5.21.3.5 “Dialog ‘Gradient Editor’” on page 3369
- § Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
**Symbol color** Selection of a color for the flower symbol.

**Line** Stroke width of the lines (in pixels).

**Element property 'Absolute movement'** The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th><strong>Movement</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>X</strong></td>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
</tr>
<tr>
<td>Example: PLC_PRG.iPos_X.</td>
<td></td>
</tr>
<tr>
<td>Increasing this value in runtime mode moves the element to the right.</td>
<td></td>
</tr>
<tr>
<td><strong>Y</strong></td>
<td>Variable (numeric data type). Defines the Y position (in pixels).</td>
</tr>
<tr>
<td>Example: PLC_PRG.iPos_Y.</td>
<td></td>
</tr>
<tr>
<td>Increasing this value in runtime mode moves the element downwards.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Rotation</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
<td></td>
</tr>
<tr>
<td>Example: PLC_PRG.iAngle1.</td>
<td></td>
</tr>
<tr>
<td>The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.</td>
<td></td>
</tr>
<tr>
<td>In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Interior rotation</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
<td></td>
</tr>
<tr>
<td>Example: PLC_PRG.iAngle2.</td>
<td></td>
</tr>
<tr>
<td>In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.</td>
<td></td>
</tr>
<tr>
<td>The rotation point is shown as the symbol.</td>
<td></td>
</tr>
<tr>
<td>Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.</td>
<td></td>
</tr>
</tbody>
</table>

You can link the variables to a unit conversion.
The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

Element property 'State variables'

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>&quot;Invisible&quot;</th>
<th>Variable (BOOL). Toggles the visibility of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRUE</td>
<td>The element is not visible at runtime.</td>
</tr>
</tbody>
</table>

The “Invisible” property is supported by the "Client Animation” functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

<table>
<thead>
<tr>
<th>&quot;Animation duration&quot;</th>
<th>Defines the duration (in milliseconds) in which the element runs an animation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Variable (integer value)</td>
</tr>
<tr>
<td></td>
<td>Example: Menu.tContent with VAR tContent : INT := 500; END_VAR</td>
</tr>
<tr>
<td></td>
<td>Integer literal</td>
</tr>
<tr>
<td></td>
<td>Example: 500</td>
</tr>
</tbody>
</table>

Animatable properties

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

<table>
<thead>
<tr>
<th>&quot;Move to foreground&quot;</th>
<th>Moves the visualization element to the foreground</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable (BOOL)</td>
<td>Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR</td>
</tr>
<tr>
<td>TRUE</td>
<td>At runtime, the visualization element is displayed in the foreground.</td>
</tr>
<tr>
<td>FALSE</td>
<td>At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.</td>
</tr>
</tbody>
</table>

Element property 'Access rights'

Requirement: User management is set up for the visualization.
“Access rights” dialog. There you can edit the access privileges for the element.

Status messages:
- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also
- Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

See also
- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

Visualization Element 'Text Editor'

Symbol:

Category: “Special Controls”

The element shows the contents of text files that are saved on the controller. Files can be encoded in ASCII or Unicode formats.

A visualization user can also edit the text.

**Element properties**

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: GenElemInst_1</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Type of element”</td>
<td>“Text Editor”</td>
</tr>
</tbody>
</table>

**Element property 'Position'*

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element</th>
<th>Specified in pixels.</th>
<th>Example: 10.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Y coordinate of the upper left corner of the element</td>
<td>Specified in pixels.</td>
<td>Example: 10.</td>
</tr>
<tr>
<td>“Width”</td>
<td>Specified in pixels.</td>
<td>Example: 150</td>
<td></td>
</tr>
<tr>
<td>“Height”</td>
<td>Specified in pixels.</td>
<td>Example: 30</td>
<td></td>
</tr>
</tbody>
</table>
You can also change the values by dragging the box symbols (şık) to other positions in the editor.

See also
- § Chapter 6.4.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

### Element property ‘Font’

<table>
<thead>
<tr>
<th><strong>“Font name”</strong></th>
<th>Non-proportional font used by the visualization to display the contents of the file. Example: “Courier New”</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Size”</strong></td>
<td>Font size</td>
</tr>
<tr>
<td></td>
<td>Example: 12</td>
</tr>
</tbody>
</table>

### Element property ‘Control variables’

**Table 720: Element property “Control variables --> File”**

<table>
<thead>
<tr>
<th><strong>“Variable”</strong></th>
<th>Variable (STRING). Contains the file names and optionally the location of the file. It is located in the file system of the controller. Example: <code>PLC_PRG.strFile: STRING := '/Documentation/Info.txt';</code></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Open”</strong></td>
<td>Variable (BOOL). Controls opening the file which is defined in the “Variable” property. Example: <code>bOpen: BOOL;</code> TRUE: The file is opened.</td>
</tr>
<tr>
<td><strong>“Close”</strong></td>
<td>Variable (BOOL). Controls closing the file which is defined in the “Variable” property. Example: <code>bClose: BOOL;</code> TRUE: The file is closed.</td>
</tr>
<tr>
<td><strong>“Save”</strong></td>
<td>Variable (BOOL). Controls saving the file which is defined in the “Variable” property. Example: <code>bStore: BOOL;</code> TRUE: The file is saved.</td>
</tr>
<tr>
<td><strong>“New”</strong></td>
<td>Variable (BOOL). Controls creating a new file. The name is defined in the “Variable” property. Example: <code>bCreate: BOOL;</code> TRUE: A file is created and opened.</td>
</tr>
</tbody>
</table>
Table 721: Element property "Control variables --> Edit"

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Variable&quot;</td>
<td>Variable (STRING). Contains the string to search for in the file</td>
</tr>
<tr>
<td>Example:</td>
<td>strFind: STRING := 'abc';</td>
</tr>
<tr>
<td>&quot;Find&quot;</td>
<td>Variable (BOOL). Controls executing the search for the string in the &quot;Variable&quot; property</td>
</tr>
<tr>
<td>Example:</td>
<td>bFind: BOOL;</td>
</tr>
<tr>
<td></td>
<td>TRUE: The search is performed. The variable is automatically reset to FALSE.</td>
</tr>
<tr>
<td>&quot;Find next&quot;</td>
<td>Variable (BOOL). Controls the location to begin the search in the file</td>
</tr>
<tr>
<td>Example:</td>
<td>bFindNext: BOOL;</td>
</tr>
<tr>
<td></td>
<td>TRUE: The search begins at the last search result location.</td>
</tr>
<tr>
<td></td>
<td>FALSE: The search begins at the beginning of the file.</td>
</tr>
</tbody>
</table>

Table 722: Element property "Control variables --> Cursor position"

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Line&quot;</td>
<td>Variable (integer data type). Contains the line of the cursor</td>
</tr>
<tr>
<td>Example:</td>
<td>iRowCursor: INT;</td>
</tr>
<tr>
<td>&quot;Column&quot;</td>
<td>Variable (integer data type). Contains the column of the cursor</td>
</tr>
<tr>
<td>Example:</td>
<td>iColumnCursor: INT;</td>
</tr>
<tr>
<td>&quot;Position&quot;</td>
<td>Output variable (integer data type). Shows the absolute cursor position in the text.</td>
</tr>
<tr>
<td>Example:</td>
<td>iPosCursor: INT;</td>
</tr>
<tr>
<td>&quot;Set cursor&quot;</td>
<td>Variable (BOOL). Controls the setting of the cursor at a specific location</td>
</tr>
<tr>
<td>Example:</td>
<td>iSetCursor: INT;</td>
</tr>
<tr>
<td></td>
<td>TRUE: The cursor is moved. The new position is defined in the &quot;Line&quot; and &quot;Column&quot; properties.</td>
</tr>
<tr>
<td></td>
<td>FALSE: The &quot;Line&quot;, &quot;Column&quot;, and &quot;Position&quot; properties contain the actual values.</td>
</tr>
<tr>
<td></td>
<td>Note: The variable is used as the control variable for an input event triggered by a visualization user.</td>
</tr>
</tbody>
</table>

Table 723: Element property "Control variables --> Selection"

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Start position&quot;</td>
<td>Output variable (integer data type). Shows the absolute position for starting the text selection</td>
</tr>
<tr>
<td>Example:</td>
<td>iPosSelection: INT;</td>
</tr>
<tr>
<td>&quot;End position&quot;</td>
<td>Output variable (integer data type). Shows the absolute position for ending the text selection.</td>
</tr>
<tr>
<td>Example:</td>
<td>iPosEndSelection: INT;</td>
</tr>
<tr>
<td>&quot;Start line number&quot;</td>
<td>Output variable (integer data type). Shows the line where the text selection begins</td>
</tr>
<tr>
<td>Example:</td>
<td>iRowSelection: INT;</td>
</tr>
<tr>
<td>&quot;Start column index&quot;</td>
<td>Output variable (integer data type). Shows the column where the text selection begins</td>
</tr>
<tr>
<td>Example:</td>
<td>iColumnSelection: INT;</td>
</tr>
<tr>
<td>&quot;End line number&quot;</td>
<td>Output variable (integer data type). Shows the line where the text selection ends</td>
</tr>
<tr>
<td>Example:</td>
<td>iRowEndSelection: INT;</td>
</tr>
</tbody>
</table>
“End column index” | Output variable (integer data type). Shows the column where the text selection ends.  
Example: iColumnEndSelection: INT;

“Line to select” | Variable (integer data type). Contains the line number that is selected.  
Note: The selection is controlled by the variables in the “Trigger selection” property.

“Set selection” | Variable (BOOL). Controls the selection of a line.  
Example: bSetSelection: BOOL;  
TRUE: The line from the “Line to select” property is selected and highlighted in the Text Editor.  
if the line is not in the current text segment of the Text Editor, then the text segment is moved to this line.  
Note: The variable is used as the control variable for an input event triggered by a visualization user. The control variable is not reset automatically. You are responsible for this to occur in the visualization.

| Table 724: Element property “Control variables --> Error handling” |
| “Variable for error code” | Variable (integer data type). Contains the error code when an error occurs.  
Example: iError: INT;  
The error codes are declared in GVL_ErrorCodes in the VisuElemTextEditor library. To display the error text, the VisuFctTextEditorGetErrorText() function of the library must be called.

| “Variable for content changed” | Variable (BOOL). Shows whether the contents have changed.  
Example: bIsContentEdited: BOOL;  
TRUE: The contents of the Text Editor have changed.

| “Variable for access mode” | Variable (BOOL). Controls the access privileges to the file.  
Example: bIsReadOnly: BOOL;  
TRUE: A visualization user has read-only permission. At runtime, the file contents are highlighted in gray in the Text Editor.  
FALSE: A visualization user has read/write permission.  
Note: The variable overwrites the setting in the “Editor mode” property.

| “Maximum line length” | Maximum number of characters per line.

| “Editor mode” |  
- “Read-only”: A visualization user has read-only permissions to the file. At runtime, the file contents are highlighted in gray in the text editor.  
- “Read/write”: A visualization user has read-write permissions.

Element property 'New files'
**Encoding**

Character encoding of the new file:

- “ASCII”
- “Unicode (Little endian)”
- “Unicode (Big endian)”

**New line character sequence**

End of line character of the new file:

- “CR/LF”: Normal for Windows systems
- “LF”: Normal for UNIX systems

Please note: When a visualization user opens an existing file, the end-of-line character of the file is detected and used automatically.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

**Animation duration**

Defines the duration (in milliseconds) in which the element runs an animation

- Variable (integer value)
  Example: Menu.tContent with VAR tContent : INT := 500; END_VAR
- Integer literal
  Example: 500

Animatable properties

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**Move to foreground**

Moves the visualization element to the foreground

Variable (BOOL)

Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR

TRUE: At runtime, the visualization element is displayed in the foreground.
FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

**Element property 'Access rights'**

Requirement: User management is set up for the visualization.

**Access rights**

Opens the “Access rights” dialog. There you can edit the access privileges for the element.

Status messages:

- “Not set. Full rights.”: Access rights for all user groups: “operable”
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also

- § Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366
Visualization Element 'Path3D'

Symbol:

Category: “Special Controls”

The "Path3D" visualization element graphically displays the curves of two independent records as a 3D path. It is specially designed for use with Motion Solution CNC in order to display the trajectory of a machine tool or a robot. The programmed path (path) and the path actually traveled (track) is displayed.

Although the visualization element is designed for use with Motion Solution CNC, it can also be used to display any other record. In this case the application has to provide the path data. The sample application 3D Path Generator, which is available in CODESYS Forge, shows how these data can be generated.

If the element is used together with SoftMotion CNC, then function blocks from the library SM3_CNC_Visu help to generate the data from the path and track. These function blocks are used by the sample project CNC_File_3DPath, which is stored in the installation directory of CODESYS.

- SMC_PathCopier
- SMC_PathCopierCompleteQueue
- SMC_PathCopierFile
- SMC_PositionTracker

A description of the function blocks can be found in the Library Manager in the library SM3_CNC_Visu.

The element does not work with the CODESYS HMI display variant.

See also

- CNC Example 6: Using Path3D with SoftMotion CNC
- Sample project in CODESYS Forge

Element properties

<table>
<thead>
<tr>
<th>&quot;Element name&quot;</th>
<th>Example: GenElemInst_1</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Type of element&quot;</td>
<td>&quot;Path3D&quot;</td>
</tr>
</tbody>
</table>

Element property 'Position'

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.
<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“X”</td>
<td>X coordinate of the upper left corner of the element</td>
</tr>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
<tr>
<td>“Y”</td>
<td>Y coordinate of the upper left corner of the element</td>
</tr>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
<tr>
<td>“Width”</td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 150</td>
</tr>
<tr>
<td>“Height”</td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols to other positions in the editor.

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

Path description

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Path data (VisuStruct3DTrack)”</td>
<td>Variable of the type VisuStruct3DTrack, which is declared in the IEC code.</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.pc.vs3dt. A description of the structure can be found in the library manager in the library VisuElem3DPath.library.</td>
</tr>
<tr>
<td></td>
<td>The data structure describes a path or track through a certain number of points. The points are determined and buffered by the application. The track typically displays the last n positions, so that only a certain part of them is ever displayed at any one time. VisuStruct3DTrack.pProjection is a variable that is set by the visualization element and contains information about the path/track projection. It can be read (only) by the application. In addition, the methods Projection.Apply or .ApplyV can be used in order to see whether the transformed position lies inside or outside the visualization display area, which is defined by Projection.ElementRect.</td>
</tr>
<tr>
<td>“Path color”</td>
<td>Color of the path drawn</td>
</tr>
<tr>
<td>“Path line width”</td>
<td>Path line width in pixels, e.g.: “2”</td>
</tr>
<tr>
<td>“Style of boundary points”</td>
<td>Display of the points between two successive objects in the path</td>
</tr>
<tr>
<td></td>
<td>- End points are not displayed</td>
</tr>
<tr>
<td></td>
<td>- End points are marked with a circle</td>
</tr>
<tr>
<td></td>
<td>- End points are marked with a cross</td>
</tr>
<tr>
<td></td>
<td>- End points are marked with a plus</td>
</tr>
</tbody>
</table>

Track description

The track data are structured in exactly the same way as the path data: VisuStruct3DTrack

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Track data (VisuStruct3DTrack)”</td>
<td>Variable of the type VisuStruct3DTrack, which is declared in the IEC code.</td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.pc.vs3dt. A description of the structure can be found in the library manager in the library VisuElem3DPath.library.</td>
</tr>
<tr>
<td>“Track color”</td>
<td>Color of the track drawn</td>
</tr>
<tr>
<td>“Track line width”</td>
<td>Track line width in pixels, e.g.: “2”</td>
</tr>
</tbody>
</table>
**Camera control**  
The camera position for the 3D mode is controlled with a reference to the external data structure. This structure allows the following operations:
- Shifting to the left/to the right/upwards/downwards
- Rotation around the X/Y/Z axis
- Resetting of the view at X/Y, Y/Z or Z/X level, so that the path and the track are completely visible.

<table>
<thead>
<tr>
<th>“Control data (VisuStruct3DControl)”</th>
<th>Variable of the type VisuStruct3DControl, which is declared in the IEC code. Example: PLC_PRG.pc.vs3dc.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A description of the structure can be found in the library manager in the library VisuElem3DPath.</td>
</tr>
<tr>
<td></td>
<td>The values can be set via the application itself or via the visualization element “ControlPanel”. The library VisuElem3DPath contains ready-to-use visualization frames that provide a possible user interface for these data.</td>
</tr>
</tbody>
</table>

**Additional aspects**

<table>
<thead>
<tr>
<th>“Coordinate system”</th>
<th>☑: The coordinate system is displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Grid”</td>
<td>☑: Grid lines are displayed</td>
</tr>
<tr>
<td>“Grid color”</td>
<td>Color of the grid lines</td>
</tr>
</tbody>
</table>

**Highlighting**  
Individual parts of the path can be visually highlighted. This is typically used to mark the already processed part of a track with a different color. Each point in the path is given a unique ID, which in the case of a CNC editor is linked with the object ID on which the point lies. This ID ("highlight ID") can be specified via the application so that dynamic elements/parts of the track can be highlighted.

<table>
<thead>
<tr>
<th>Highlight mode</th>
<th>Select one of the following highlight modes:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>● Only the element whose ID corresponds to the value of the variable is highlighted.</td>
</tr>
<tr>
<td></td>
<td>● All elements whose ID (linked with the object ID in the case of a CNC editor) is smaller than or equal to the value in Variable are highlighted.</td>
</tr>
</tbody>
</table>

| Variable | Project variable that specifies the ID of an element. Example: PLC_PRG.iVarElementID. This "highlight ID" is taken into account for the setting of the highlight mode. The variable must be set in the IEC application. |

| Highlight color | |

**Element look**

<table>
<thead>
<tr>
<th>“Frame line width”</th>
<th>Width of the frame around the element, in pixels, for example: &quot;1&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Frame line style”</td>
<td>Select one of these style types for the frame line:</td>
</tr>
<tr>
<td></td>
<td>● Solid</td>
</tr>
<tr>
<td></td>
<td>● Dashes</td>
</tr>
<tr>
<td></td>
<td>● Dots</td>
</tr>
<tr>
<td></td>
<td>● Dash Dot</td>
</tr>
<tr>
<td></td>
<td>● Dash Dot Dot</td>
</tr>
<tr>
<td></td>
<td>● Hollow</td>
</tr>
</tbody>
</table>
"Transparent background"  
- The background of the element is displayed transparently.  
- The background of the element is displayed in the defined background color.

"Background color"

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

"Animation duration"  
Defines the duration (in milliseconds) in which the element runs an animation  
- Variable (integer value)  
  Example: Menu.tContent with VAR tContent : INT := 500; END_VAR  
- Integer literal  
  Example: 500

Animatable properties  
- “Absolute movement”, “Movement”, “X”, “Y”  
- “Absolute movement”, “Rotation”  
- “Absolute movement”, “Interior rotation”  
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

"Move to foreground"  
Moves the visualization element to the foreground  
Variable (BOOL)  
Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR  
TRUE: At runtime, the visualization element is displayed in the foreground.  
FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

**Element property 'Access rights'**

Requirement: User management is set up for the visualization.

"Access rights"  
Opens the “Access rights” dialog. There you can edit the access privileges for the element.  
Status messages:  
- “Not set. Full rights.”: Access rights for all user groups: “operable”  
- “Rights are set: Limited rights”: Access is restricted for at least one group.

See also  
- % Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

**Visualization Element 'Control Panel'**

Symbol:
Category: “Special Controls”

This visualization element is used in connection with the “Path3D” visualization element. It is used for changing the position and orientation to the CNC path shown with “Path3D”.

See also
- § Chapter 6.4.5.21.5.42 “Visualization Element 'Path3D'” on page 3704

### Element properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Element name”</strong></td>
<td>Optional. Hint: Assign individual names for elements so that they are found faster in the element list. Example: Camera_Path_1</td>
</tr>
<tr>
<td><strong>“Type of element”</strong></td>
<td>“Frame”</td>
</tr>
<tr>
<td><strong>“Clipping”</strong></td>
<td>If you have set the “Scaling type” to “Fixed”, then only that part of the visualization is displayed that fits in the frame.</td>
</tr>
<tr>
<td><strong>“Show frame”</strong></td>
<td>Displays the frame</td>
</tr>
<tr>
<td>- “No frame”: The displayed area of the frame does not have borders.</td>
<td></td>
</tr>
<tr>
<td>- “Frame”: The displayed area of the frame has borders.</td>
<td></td>
</tr>
<tr>
<td>- “No frame with offset”: The displayed area of the frame does not have a border and the displayed area of the referenced visualization is reduced inwards by one pixel as compared to the frame area. The resulting gap prevents the referenced visualization from touching any adjacent elements.</td>
<td></td>
</tr>
<tr>
<td><strong>“Scaling type”</strong></td>
<td>Describes how the frame reacts when the visualization is resized:</td>
</tr>
<tr>
<td>- “Isotropic”: The frame retains its proportions. This allows the ratio of height to width to be preserved, even if the height and width of the visualization have been changed separately.</td>
<td></td>
</tr>
<tr>
<td>- “Anisotropic”: The frame depends on the size of the visualization, so that height and width of the referenced visualization can be changed separately.</td>
<td></td>
</tr>
<tr>
<td>- “Fixed”: The original size of the frame is retained, regardless of the visualization size. If you have also selected the “Clipping” option, then only the fitting part is displayed.</td>
<td></td>
</tr>
<tr>
<td>- “Fixed and scrollable”: The referenced visualization is displayed without scaling. If the value is greater than the window area of the frame, then scrollbars are added to the frame. To set the position of the scroll bar with a variable, use the “Scroll position variable horizontal” or “Scroll position variable vertical” property.</td>
<td></td>
</tr>
<tr>
<td><strong>“Deactivation of the background drawing”</strong></td>
<td>To optimize the performance of the visualization, the non-animated elements of the frame element are drawn as a background bitmap. This could result in the elements not being displayed in the expected order.</td>
</tr>
<tr>
<td>-</td>
<td>Deactivation of the background drawing. This can prevent the behavior described above.</td>
</tr>
</tbody>
</table>

### Element property ‘References’

Contains the currently configured visualization references as a subnode
Clicking "Configure" opens the "Frame Configuration" dialog. This is used to manage the referenced visualizations.

Caution: Visualizations can be nested at any depth by means of Frame elements. In order to use the "Switch to any visualization" Frame selection type without any problems, a Frame must not contain more than 21 referenced visualizations. For more information, see also the description for the "Input configuration" of an element: Action "Switch Frame visualization".

Visualizations that have a button also have this displayed as a subnode. Each interface variable is listed with the currently assigned transfer parameters.

Example:

```
vis_FormA
  ● iDataToDisplay_1:PLC_PRG.iVar1
  ● iDataToDisplay_2:PLC_PRG.iVar2
```

Hint: You can change the assignment of the variables to an interface variable here and edit the value field. Or click the "Configure" button instead.

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

```
"X"
X coordinate of the upper left corner of the element
Specified in pixels.
Example: 10.
```

```
"Y"
Y coordinate of the upper left corner of the element
Specified in pixels.
Example: 10.
```

```
"Width"
Specified in pixels.
Example: 150
```

```
"Height"
Specified in pixels.
Example: 30
```

You can also change the values by dragging the box symbols ( располагаемый элемент ) to other positions in the editor.

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

See also

- Chapter 6.4.5.21.2.1 “Command 'Interface Editor’” on page 3340
- Chapter 6.4.5.17 “Creating a structured user interface” on page 2940
- “Input action ‘Switch Frame Visualization’” on page 3377

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874
<table>
<thead>
<tr>
<th>“X”</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (♀) to other positions in the editor.

**Element property 'Colors'**

The properties contain fixed values for setting colors.

<table>
<thead>
<tr>
<th>“Color”</th>
<th>Color for the element in its normal state.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Please note that the normal state is in effect if the expression in the “Color variables ⇒ Toggle color” property is not defined or it has the value FALSE.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Alarm color”</th>
<th>Color for the element in alarm state.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Please note that the alarm state is in effect if the expression in the “Color variables ⇒ Toggle color” property has the value TRUE.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Transparency”</th>
<th>Value (0 to 255) for defining the transparency of the selected color. Example 255: The color is opaque. 0: The color is completely transparent.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Use gradient color”</th>
<th>☑: The element is displayed with a color gradient.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Gradient setting”</td>
<td>The “Color gradient editor” dialog box opens.</td>
</tr>
<tr>
<td>“Frame color”</td>
<td>Example: “Black”</td>
</tr>
<tr>
<td>“Fill color”</td>
<td>Example: “Light gray”</td>
</tr>
</tbody>
</table>

See also

- ☻ Chapter 6.4.5.21.3.5 “Dialog ‘Gradient Editor’” on page 3369
- ☻

**Element property 'Appearance'**

The properties contain fixed values for setting the look of the element.

<table>
<thead>
<tr>
<th>“Line width”</th>
<th>Value in pixels</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 2</td>
</tr>
</tbody>
</table>

Note: The values 0 and 1 both result in a line weight of one pixel. If no line should be displayed, then the “Line style” property must be set to the option “Invisible”.

<table>
<thead>
<tr>
<th>“Line style”</th>
<th>Type of line representation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>“Solid”</td>
</tr>
<tr>
<td></td>
<td>“Dashes”</td>
</tr>
<tr>
<td></td>
<td>“Dots”</td>
</tr>
<tr>
<td></td>
<td>“Dash Dot”</td>
</tr>
<tr>
<td></td>
<td>“Dash Dot Dot”</td>
</tr>
<tr>
<td></td>
<td>“not visible”</td>
</tr>
</tbody>
</table>
You can assign variables in the “Appearance variables” property for controlling the appearance dynamically. The fixed values are defined here.

See also

- “Element property ‘Appearance variables’” on page 3717

**Element property ‘Texts’**

The properties contain character strings for labeling the element. The character string can also contain a placeholder with a format definition. In runtime mode, the placeholder is replaced by the current value in the specified format.

CODESYS accepts the specified texts automatically into the “GlobalTextList” text list. Therefore, these texts can be localized.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Text”</td>
<td>Character string (without single straight quotation marks) for the labeling the element. Add a line break by pressing the keyboard shortcut [Ctrl] + [Enter]. Example: Accesses: %i. The variable that contains the current value for the placeholder is specified in the property “Text variable ➔ Text”.</td>
</tr>
<tr>
<td>“Tooltip”</td>
<td>Character string (without single straight quotation marks) that is displayed as the tooltip of an element. Example: Number of valid accesses. The variable that contains the current value for the placeholder is specified in the property “Text variable ➔ Tooltip”.</td>
</tr>
</tbody>
</table>

See also

- “Element property ‘Text variables’” on page 3714
- Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872
- Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329

**Element property ‘Text properties’**

The properties contain fixed values for the text properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Horizontal alignment”</td>
<td>Horizontal alignment of the text within the element.</td>
</tr>
<tr>
<td>“Vertical alignment”</td>
<td>Vertical alignment of the text within the element.</td>
</tr>
</tbody>
</table>
| “Text format” | Definition for displaying texts that are too long
- “Default”: The long text is truncated.
- “Line break”: The text is split into parts.
- “Ellipsis”: The visible text ends with “…” indicating that it is not complete. |
| “Font” | Example: “Default”
- The “Font” dialog box opens.
- ➔: Drop-down list with style fonts. |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Font color** | Example: “Black”  
- The “Color” dialog box opens.  
- ▼: Drop-down list with style colors. |
| **Transparency** | Whole number (value range from 0 to 255). This determines the transparency of the respective color.  
Example: 255: The color is opaque.  
0: The color is completely transparent.  
Please note: If the color is a style color and already has a transparency value, then this property is write-protected. |
| **Element property 'Absolute movement'** | The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved. |
| **Movement** | |
| **X** | Variable (numeric data type). Defines the X position (in pixels).  
Example: PLC_PRG.iPos_X.  
Increasing this value in runtime mode moves the element to the right. |
| **Y** | Variable (numeric data type). Defines the Y position (in pixels).  
Example: PLC_PRG.iPos_Y.  
Increasing this value in runtime mode moves the element downwards. |
| **Rotation** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
Example: PLC_PRG.iAngle1.  
The midpoint of the element rotates at the “Center” point. This rotation point is shown as the ◇ symbol.  
In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right. |
| **Scaling** | Variable (integer data type). Causes centric stretching.  
Example: PLC_PRG.iScaling.  
The reference point is the “Center” property.  
The value 1 shrinks the element by a factor of 0.001. The value 1000 returns the element to its original size. |
"Interior rotation"  Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the property “Position → Angle”, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

You can link the variables to a unit conversion.

The properties “X”, “Y”, “Rotation”, and “Interior rotation” are supported by the “Client Animation” functionality.

See also

Element property 'Relative movement'

The properties contains variables for moving the element. The reference point is the position of the element ("Position" property). The shape of the element can change.

"Movement top-left"

<table>
<thead>
<tr>
<th>Variable (integer data type). It contains the number (in pixels) that the left edge is moved horizontally. Incrementing the value moves the element to the right. Example: PLC_PRG.iDeltaX</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;X&quot;</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Variable (integer data type). It contains the number (in pixels) that the top edge is moved vertically. Incrementing the value moves the element to the down. Example: PLC_PRG.iDeltaY</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Y&quot;</td>
</tr>
</tbody>
</table>

"Movement bottom-right"

<table>
<thead>
<tr>
<th>Variable (integer data type). It contains the number (in pixels) that the right edge is moved horizontally. Incrementing the value moves the element to the right. Example: PLC_PRG.iDeltaWidth</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;X&quot;</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Variable (integer data type). It contains the number (in pixels) that the bottom edge is moved vertically. Incrementing the value moves the element to the down. Example: PLC_PRG.iDeltaHeight</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Y&quot;</td>
</tr>
</tbody>
</table>

See also

- “Element property ‘Absolute movement’” on page 3739
### Element property 'Text variables'

These properties are variables with contents that replace a format definition.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Example</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Text variable&quot;</td>
<td>Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.</td>
<td><code>PLC_PRG.iAccesses</code></td>
<td>Note: The format definition is part of the text in the property “Texts ➔ Text”. Note: If you specify a variable of type enumeration with text list support, then the name of the enumeration data type is added automatically in angle brackets after the variable name. Example: <code>PLC_PRG.enVar &lt;enumeration name&gt;</code>. Then the symbolic value of the enumeration component is printed instead of the numeric value when text is printed. Refer to the help page for the enumerations.</td>
</tr>
<tr>
<td>&quot;Tooltip variable&quot;</td>
<td>Variable (data type compliant with the format definition). It contains what is printed instead of the format definition.</td>
<td><code>PLC_PRG.iAccessesInTooltip</code></td>
<td>Note: The format definition is part of the text in the property “Texts ➔ Tooltip”.</td>
</tr>
</tbody>
</table>

### Element property 'Dynamic texts'

Dynamic texts are variably indexed texts of a text list. At runtime, the text is displayed that is currently indexed in the variable.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Example</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Text list&quot;</td>
<td>Variable (string) or name of the text list as a fixed string in single straight quotation marks.</td>
<td>'Errorlist'</td>
<td>• Drop-down list with the dialogs available in the text lists.</td>
</tr>
<tr>
<td>&quot;Text index&quot;</td>
<td>Text list ID. This refers to the desired output text.</td>
<td></td>
<td>• As fixed string with the ID in single straight quotation marks. Example: '1'</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• As a variable (STRING) for dynamically controlling the text output. Example: <code>strTextID</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Sample assignment: <code>PLC_PRG.strTextID := '1';</code></td>
</tr>
<tr>
<td>&quot;Tooltip index&quot;</td>
<td>Text list ID. This refers to the desired output text.</td>
<td></td>
<td>• As fixed string with the ID in single straight quotation marks. Example: '2'</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• As a variable (STRING) for dynamically controlling the text output. Example: <code>strToolTipID</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Sample assignment: <code>PLC_PRG.strToolTipID := '2';</code></td>
</tr>
</tbody>
</table>

### Element property 'Font variables'

The variables allow for dynamic control of the text display.

See also
- ¤ Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329
- ¤ “Element property 'Texts’” on page 3711
- ¤ Chapter 6.4.1.20.5.18 “Enumerations” on page 2263
- ¤ Chapter 6.4.1.21.2.28 “Object 'Text List’” on page 2532
**“Font name”** Variable (STRING). Includes the font of the text.
Example: PLC_PRG.stFontVar := 'Arial';
The selection of fonts corresponds to the default “Font” dialog.

**“Size”** Variable (numeric data type). Contains the font size (in pixels or points). The applied unit is specified in brackets after the variable name.
- <pt>: Points (default)
  Example: PLC_PRG.iFontHeight <pt>
  Code: iFontHeight : INT := 12;
- <px>: Pixels
  Example: PLC_PRG.iFontHeight <px>
  Code: iFontHeight : INT := 19;

If you click in the value field, a drop-down list opens on the right for setting the unit.

Hint: The font size is specified in points (example: Arial 12). Use points when the variable font size should match a font, for example if a font is set in the property “Text property → Font”.

**“Flags”** Variable (DWORD). Contains the flags for displaying fonts.
Flags:
- 1: Italics
- 2: Bold
- 4: Underline
- 8: Strikethrough

Note: You can combine the font displays by adding the coding of the flags. For example, a bold and underlined text: PLC_PRG.dwFontType := 6;

**“Character set”** Variable (DWORD). Contains a character set number for the font.
The selection of character set numbers corresponds to the “Script” setting of the standard “Font” dialog.

**“Color”** Variable (DWORD). Includes the color of the text.
Example: PLC_PRG.dwColorFont := 16#FF000000;

**“Flags for text alignment”** Variable (integer data type). Contains the coding for text alignment.
Example: PLC_PRG.dwTextAlignment.
Coding:
- 0: Top left
- 1: Horizontal center
- 2: Right
- 4: Vertical center
- 8: Bottom

Note: You can combine the text alignments by adding the coding of the flags. For example, a vertical and horizontal centered text: PLC_PRG.dwFontType := 5;
Fixed values for displaying texts are set in “Text properties”.

See also
- ‘Element property ‘Text properties’” on page 3711

**Element property 'Color variables'**

The Element property is used as an interface for project variables to dynamically control colors at runtime.

<table>
<thead>
<tr>
<th><strong>“Toggle color”</strong></th>
<th>The property controls the toggled color at runtime.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value assignment:</td>
<td><strong>FALSE:</strong> The element is displayed with the color specified in the “Color” property.</td>
</tr>
<tr>
<td></td>
<td><strong>TRUE:</strong> The element is displayed with the color specified in the “Alarm color” property.</td>
</tr>
<tr>
<td>Assignment options:</td>
<td><strong>Placeholder for the user input variable</strong></td>
</tr>
<tr>
<td></td>
<td>– “&lt;toggle/tap variable&gt;”</td>
</tr>
<tr>
<td></td>
<td>– “&lt;NOT toggle/tap variable&gt;”</td>
</tr>
<tr>
<td></td>
<td>The color change is not controlled by its own variable, but by a user input variable.</td>
</tr>
<tr>
<td></td>
<td>Note: Specify a variable for the mouse events “Tap” or “Toggle” in the input configuration of the element. Only then is the placeholder set. If you configure a variable in both “Toggle” and “Tap”, then the variable specified in “Tap” is used.</td>
</tr>
<tr>
<td></td>
<td>Hint: Click the symbol 💯 to insert the placeholder “&lt;toggle/tap variable&gt;”. When you activate the “Inputconfiguration”, “Tap FALSE” property, then the “&lt;NOT toggle/tap variable&gt;” placeholder is displayed.</td>
</tr>
<tr>
<td></td>
<td><strong>Instance path of a project variable (BOOL)</strong></td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.xColorIsToggled</td>
</tr>
<tr>
<td></td>
<td>Note: In the code, declare and implement the variable specified here. Its value assignment determines when the color changes.</td>
</tr>
</tbody>
</table>

| **“Normal state”** | The properties listed below control the color depending on the state. The normal state is in effect if the variable in “Color variables”, “Toggle color” is not defined or it has the value FALSE. |
| **Alarm state”**   | The alarm state is in effect if the variable in “Color variables”, “Toggle color” has the value TRUE. |

<table>
<thead>
<tr>
<th><strong>“Frame color”</strong></th>
<th>Assignment options:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Variable (DWORD) for the frame color</strong></td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.dwBorderColor</td>
</tr>
<tr>
<td></td>
<td><strong>Color literal</strong></td>
</tr>
<tr>
<td></td>
<td>Example of green and opaque: 16#FF00FF00</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Filling color”</strong></th>
<th>Assignment options:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Variable (DWORD) for the fill color</strong></td>
</tr>
<tr>
<td></td>
<td>Example: PLC_PRG.dwFillColor</td>
</tr>
<tr>
<td></td>
<td><strong>Color literal</strong></td>
</tr>
<tr>
<td></td>
<td>Example of gray and opaque: 16#FF888888</td>
</tr>
</tbody>
</table>
The transparency part of the color value is evaluated only if the “Activate semi-transparent drawing” option of the visualization manager is selected.

Select the “Advanced” option in the toolbar of the properties view. Then all element properties are visible.

See also

- Chapter 6.4.5.10.4 “Animating a color display” on page 2914

The properties contain variables for controlling the appearance of the element dynamically.

**Element property 'Appearance variables'*

<table>
<thead>
<tr>
<th><strong>Variable</strong></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Line width”</td>
<td>Variable (integer data type). Contains the line weight (in pixels). Note: The values 0 and 1 both result in a line weight of one pixel. If no line should be displayed, then the “Line style” property must be set to the option “Invisible”.</td>
</tr>
</tbody>
</table>
| “Line style”       | Variable (DWORD). Controls the line style. Coding:  
  - 0: Solid line  
  - 1: Dashed line  
  - 2: Dotted line  
  - 3: Line type "Dash Dot"  
  - 3: Line type "Dash Dot Dot"  
  - 8: Invisible: The line is not drawn. |

Fixed values can be set in the “Appearance“ property. These values can be overwritten by dynamic variables at runtime.

See also

- “Element property 'Appearance“ on page 3710

The variable controls the switching of the referenced visualizations. This variable indexes one of the referenced frame visualizations and this is displayed in the frame. When the value of the variable changes, it switches to the recently indexed visualization.
"Variable"

- Variable (integer data type) that contains the index of the active visualization
  
  **Example:** PLC_PRG.uiIndexVisu

  **Hint:** The "Frame Configuration" dialog includes a list of referenced visualizations. The visualizations are automatically numerically indexed via the order in the list.

  **Note:** This variant of switching usually affects all connected display variants.

- Array element (integer data type) for index access via CURRENTCLIENTID
  
  **Example:** PLC_PRG.aIndexVisu[CURRENTCLIENTID]

  **Note:** This variant of switching applies to the current client only, and therefore only on one display variant. That is the display variant where the value change was triggered (for example, by means of user input).

See also

- ☞ Chapter 6.4.5.21.2.9 “Command ‘Frame Selection’” on page 3348

**Element property ‘State variables’**

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>&quot;Invisible&quot;</th>
<th>Variable (BOOL). Toggles the visibility of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>TRUE: The element is not visible at runtime.</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong> bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Deactivate inputs&quot;</th>
<th>Variable (BOOL). Toggles the operability of the element.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.</td>
</tr>
</tbody>
</table>

**The “Invisible” property is supported by the "Client Animation" functionality.**

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
### “Animation duration”
Defines the duration (in milliseconds) in which the element runs an animation
- **Variable (integer value)**
  - **Example:**
    ```
    Menu.tContent with VAR tContent : INT := 500;
    END_VAR
    ```
- **Integer literal**
  - **Example:** 500

#### Animatable properties
- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

### “Move to foreground”
Moves the visualization element to the foreground
- **Variable (BOOL)**
  - **Example:**
    ```
    bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR
    ```

**TRUE:** At runtime, the visualization element is displayed in the foreground.
**FALSE:** At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

### Element property ‘Input configuration’
The properties contain the configurations for the user input when using the mouse or keyboard.
A user input defines an event and one or more actions that are executed when an event occurs.

The “Configure” button opens the “Input Configuration” dialog. There you can create or edit user inputs.
Confugured user inputs are listed below the events. They each include the action that is triggered and the setting in short form.

**Example:** “Execute ST Code”: 
```
PLC_PRG.i_x := 0;
```

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“OnDialogClosed”</strong></td>
<td>Input event: The user closes the dialog.</td>
</tr>
<tr>
<td><strong>“OnMouseClick”</strong></td>
<td>Input event: The user clicks the mouse button completely in the element area. The mouse button is clicked and released.</td>
</tr>
<tr>
<td><strong>“OnMouseDown”</strong></td>
<td>Input event: The user clicks down on the mouse button.</td>
</tr>
<tr>
<td><strong>“OnMouseEnter”</strong></td>
<td>Input event: The user drags the mouse pointer to the element.</td>
</tr>
<tr>
<td><strong>“OnMouseLeave”</strong></td>
<td>Input event: The user drags the mouse pointer away from the element.</td>
</tr>
<tr>
<td>&quot;OnMouseMove&quot;</td>
<td>Input event: The user moves the mouse pointer over the element area.</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------</td>
</tr>
<tr>
<td>&quot;OnMouseUp&quot;</td>
<td>Input events:</td>
</tr>
<tr>
<td></td>
<td>● The user releases the mouse button within the element area. It is irrelevant whether the user has previously pressed the mouse button inside or outside the element area.</td>
</tr>
<tr>
<td></td>
<td>● The user presses the mouse button within the element area, leaves the element area, and then releases the mouse button.</td>
</tr>
<tr>
<td>Note: This CODESYS-specific triggering behavior guarantees that actions for key elements are completed. A key element starts an action for &quot;OnMouseDown&quot; and ends the action for &quot;OnMouseUp&quot;.</td>
<td></td>
</tr>
<tr>
<td>Example: A visualization user presses the mouse button within the element area of the key element and then moves the cursor position so that it lies outside the element area. The action is ended anyway because &quot;OnMouseUp&quot; is triggered.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Tap&quot;</th>
<th>When a mouse click event occurs, the variable defined in &quot;Variable&quot; is described in the application. The coding depends on the &quot;Tap FALSE&quot; and &quot;Tap on enter if captured&quot; options.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Variable&quot;</td>
<td>Variable (BOOL) that is set on mouse click event.</td>
</tr>
<tr>
<td>Example: FLC_PRG.bIsTapped</td>
<td></td>
</tr>
<tr>
<td>TRUE: A mouse click event exists. It lasts as long as the user presses the mouse button over the element. It ends when the button is released.</td>
<td></td>
</tr>
<tr>
<td>FALSE: A mouse click event does not exist.</td>
<td></td>
</tr>
<tr>
<td>Requirement: The &quot;Tap FALSE&quot; option is not activated.</td>
<td></td>
</tr>
</tbody>
</table>

| "Tap FALSE"        | ☑: The mouse click event leads to a complementary value in "Variable".                                                                                                                          |
|                    | TRUE: A mouse click event does not exist.                                                                                                                                                    |
|                    | FALSE: While the mouse click event exists.                                                                                                                                                   |

| "Tap on enter if captured" | ☑: During user input, it is also taken into consideration whether the mouse pointer is dragged within the element area or not while the mouse button is pressed. |
|                           | TRUE: While the mouse click event exists and the mouse pointer is moved over the element area.                                                                                         |
|                           | FALSE: A mouse click event does not exist. Or the user moves the mouse pointer outside of the element area while the mouse button is pressed.                  |
|                           | The value is TRUE again as soon as the user moves the pointer back to the element area. The mouse is then captured.                                                                 |

| "Toggle"              | With the onset of a mouse click event, the variable is set; when the mouse click event is completed, the variable is reset.                                                                      |
| "Variable"           | Variable (BOOL). Its value toggled when the mouse click event is ended. This is when the user releases the mouse button while the mouse pointer is over the element area. |
|                     | If the user releases the mouse button while the mouse pointer is outside of the element area, then the mouse click event is not ended and the value is not toggled. |
|                     | Hint: The user can cancel a started toggle input by dragging the mouse pointer out of the element area.                                                                                       |
| "Toggle on up if captured" | ☑: The value toggles regardless of where the mouse pointer is when the mouse button is released. The mouse is then captured.                                                                 |
"Hotkey" | Keyboard shortcut on the element for triggering specific input actions. When the keyboard shortcut event occurs, the input actions in the “Events” property are triggered. In this way, it is not the input action itself that leads to this input action, but the mouse input action.

"Key" | Key pressed for input action. Example: [T]
Note: The following properties appear when a key is selected.

"Events" |
- “None”
- “Mouse down”: Pressing the key triggers the input actions that are configured in the “OnMouseDown” property.
- “Mouse up”: Releasing the key triggers the input actions that are configured in the “OnMouseUp” property.
- “Mouse down/up”: Pressing and releasing the key triggers the input actions that are configured in the “OnMouseDown” property and the “OnMouseUp” property.

"Shift" | ✔: Combination with the Shift key Example: [Shift]+[T].

"Control" | ✔: Combination with the Ctrl key Example: [Ctrl]+[T].

"Alt" | ✔: Combination with the Alt key Example: [Alt]+[T].

All keyboard shortcuts and their actions that are configured in the visualization are listed on the “Keyboard Configuration” tab.

See also
- § Chapter 6.4.5.21.2.2 “Command ‘Keyboard Configuration’” on page 3341
- § Chapter 6.4.5.21.3.6 “Dialog ‘Input Configuration’” on page 3370

See also
- § Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

Visualization Element ‘Date Range Picker’

Symbol:

Category: “Date/Time Controls”
The element provides the capability of selecting the date and time range of a saved data set. The element is used with the “Trend” visualization element.

Element properties
Element property 'Position'

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specified in pixels.</td>
</tr>
<tr>
<td></td>
<td>Example: 10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Width”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 150</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Height”</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: 30</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the box symbols (_drag) to other positions in the editor.

See also

- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

Element property 'Center'

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Y”</th>
<th>Y-coordinate of the point of rotation</th>
</tr>
</thead>
</table>

You can also change the values by dragging the symbols (_drag) to other positions in the editor.


<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Show frame&quot;</td>
<td>The visualization element is drawn with a frame.</td>
</tr>
<tr>
<td>&quot;Resolution&quot;</td>
<td>Resolution saved for the time stamp: &quot;Millisecond&quot; or &quot;Microsecond&quot;</td>
</tr>
<tr>
<td>&quot;Attached element instance&quot;</td>
<td>The element can be assigned to a &quot;Trend&quot; visualization element. As a result, the time range of the trend element can be changed. The available visual elements are selected with the help of the Input Assistant.</td>
</tr>
</tbody>
</table>

**Element property 'Tick mark labels'**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Two-line labelling&quot;</td>
<td>The time stamps are displayed in two lines. The date is displayed in the first line and the time is displayed in the second line.</td>
</tr>
<tr>
<td>&quot;Omit irrelevant information in time stamp&quot;</td>
<td>The time stamp has a shorter form. For example, the date is displayed only for the first tick mark, and only the time for the following tick marks. The settings in “Internationalization (format strings)” are ignored for this setting.</td>
</tr>
<tr>
<td>&quot;Internationalization (format strings)&quot;</td>
<td>Only active when the parameter “Omit irrelevant information in timestamps” is deactivated.</td>
</tr>
<tr>
<td>&quot;Date&quot;</td>
<td>Definition of the date format. The default setting is taken from the Windows control panel.</td>
</tr>
<tr>
<td>&quot;Time&quot;</td>
<td>Definition of the time format. The default setting is taken from the Windows control panel.</td>
</tr>
</tbody>
</table>

**Element property 'Text properties'**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Horizontal alignment&quot;</td>
<td>Horizontal alignment of the text within the element.</td>
</tr>
<tr>
<td>&quot;Vertical alignment&quot;</td>
<td>Vertical alignment of the text within the element.</td>
</tr>
<tr>
<td>&quot;Font&quot;</td>
<td>Example: &quot;Default&quot;</td>
</tr>
<tr>
<td></td>
<td>☐: The &quot;Font&quot; dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>▼: Drop-down list with style fonts.</td>
</tr>
<tr>
<td>&quot;Font color&quot;</td>
<td>Example: &quot;Black&quot;</td>
</tr>
<tr>
<td></td>
<td>☐: The &quot;Color&quot; dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>▼: Drop-down list with style colors.</td>
</tr>
<tr>
<td>&quot;Transparency&quot;</td>
<td>Whole number (value range from 0 to 255). This determines the transparency of the respective color. Example: 255: The color is opaque. 0: The color is completely transparent. Please note: If the color is a style color and already has a transparency value, then this property is write-protected.</td>
</tr>
</tbody>
</table>

**Element property 'Additional buttons'**
**“Jump to the largest possible time stamp”**

☑️ An additional button (●) is displayed for jumping to the last time stamp.

**“Jump to the smallest possible time stamp”**

☑️ An additional button (●) is displayed for jumping to the first time stamp.

**“Zoom out”**

☑️ An additional button (●) is displayed for setting the current min./max. range to the maximum range. The selected range is left.

---

**Element property 'Absolute movement'**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

**“Movement”**

**“X”**

Variable (numeric data type). Defines the X position (in pixels).

Example: PLC_PRG.iPos_X.

Increasing this value in runtime mode moves the element to the right.

**“Y”**

Variable (numeric data type). Defines the Y position (in pixels).

Example: PLC_PRG.iPos_Y.

Increasing this value in runtime mode moves the element downwards.

**“Rotation”**

Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle1.

The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.

In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

**“Interior rotation”**

Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

---

You can link the variables to a unit conversion.
The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

**Element property 'State variables'**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Invisible”</td>
<td>Variable (BOOL). Toggles the visibility of the element. TRUE: The element is not visible at runtime.</td>
</tr>
</tbody>
</table>

The “Invisible” property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Animation duration”</td>
<td>Defines the duration (in milliseconds) in which the element runs an animation</td>
</tr>
<tr>
<td></td>
<td>- Variable (integer value)</td>
</tr>
<tr>
<td></td>
<td>Example: Menu.tContent with VAR tContent : INT := 500; END_VAR</td>
</tr>
<tr>
<td></td>
<td>- Integer literal</td>
</tr>
<tr>
<td></td>
<td>Example: 500</td>
</tr>
<tr>
<td></td>
<td>• “Absolute movement”, “Movement”, “X”, “Y”</td>
</tr>
<tr>
<td></td>
<td>• “Absolute movement”, “Rotation”</td>
</tr>
<tr>
<td></td>
<td>• “Absolute movement”, “Interior rotation”</td>
</tr>
<tr>
<td></td>
<td>• “Absolute movement”, “Exterior rotation”</td>
</tr>
</tbody>
</table>

Animatable properties

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Move to foreground”</td>
<td>Moves the visualization element to the foreground</td>
</tr>
<tr>
<td></td>
<td>Variable (BOOL)</td>
</tr>
<tr>
<td></td>
<td>Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR</td>
</tr>
<tr>
<td></td>
<td>TRUE: At runtime, the visualization element is displayed in the foreground.</td>
</tr>
<tr>
<td></td>
<td>FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.</td>
</tr>
</tbody>
</table>

**Element property 'Access rights'**

Requirement: User management is set up for the visualization.
"Access rights" opens the "Access rights" dialog. There you can edit the access privileges for the element.

Status messages:
- "Not set. Full rights." - Access rights for all user groups: "operable"
- "Rights are set: Limited rights" - Access is restricted for at least one group.

See also
- Chapter 6.4.5.21.3.1 "Dialog 'Access Rights'" on page 3366

Visualization Element ‘Time Range Picker’

Symbol:

Category: "Date/Time Controls"

The element provides configurable buttons for setting the time range of a trend display to a defined time. In the process the end time of the previous display is left unchanged and the start time is adapted.

Element properties

<table>
<thead>
<tr>
<th>&quot;Element name&quot;</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
<tr>
<td>Example: TimeRangeTemperature</td>
<td></td>
</tr>
</tbody>
</table>

| "Type of element" | “Time range picker” |

Element property 'Position'

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

<table>
<thead>
<tr>
<th>&quot;X&quot;</th>
<th>X coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in pixels.</td>
<td></td>
</tr>
<tr>
<td>Example: 10.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Y&quot;</th>
<th>Y coordinate of the upper left corner of the element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in pixels.</td>
<td></td>
</tr>
<tr>
<td>Example: 10.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Width&quot;</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 150</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Height&quot;</th>
<th>Specified in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: 30</td>
<td></td>
</tr>
</tbody>
</table>
You can also change the values by dragging the box symbols (_drag_→) to other positions in the editor.

See also

- \( \text{Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874} \)

| “Orientation” | Specifies whether the time picker element is aligned horizontally or vertically in the editor.
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Hint: Change the width to height ratio of the element in the editor.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Show frame”</th>
<th>☑: The visualization element is drawn with a frame.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Resolution”</th>
<th>Resolution saved for the time stamp: “Millisecond” or “Microsecond”</th>
</tr>
</thead>
</table>

| “Attached element instance” | Assignment to the element that processes the time picker
|-----------------------------|------------------------------------------------------------------------------------------------------------------|
|                             | The element can be assigned for example to a “Trend” visualization element. Then the time range of the trend element can be changed. The available visual elements are selected with the help of the input assistance (\[\text{ele}\]). Example: GenElemInst_1

**Element property 'Texts'**

<table>
<thead>
<tr>
<th>“Text”</th>
<th>String label for the element. Example: Zoom</th>
</tr>
</thead>
</table>

**Element property 'Text properties’**

The properties contain fixed values for the text properties.

<table>
<thead>
<tr>
<th>“Font”</th>
<th>Example: “Default”[\text{ele}]: The “Font” dialog box opens. [\text{ele}]: Drop-down list with style fonts.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Font color”</th>
<th>Example: “Black”[\text{ele}]: The “Color” dialog box opens. [\text{ele}]: Drop-down list with style colors.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Transparency”</th>
<th>Whole number (value range from 0 to 255). This determines the transparency of the respective color. Example: 255: The color is opaque. 0: The color is completely transparent. Please note: If the color is a style color and already has a transparency value, then this property is write-protected.</th>
</tr>
</thead>
</table>

**Property 'Times’** In “Times”, the buttons that the element provides at runtime are defined and configured in an array.
### Provide "All" selection

- **Time Range Picker bar extended by "All" button.** The diagram represents a time interval that covers all time stamps.

### Times

- **Note:** Adds another button to the Time Range Picker bar and increases the array by one entry. An additional index is present in the property "Times ➔ Times ➔ [<new>]". "Time" is located under this index. The configuration of the button is to be entered there.

### Times

- **‘[Index]’**
  - with index ∈ {0, 1, 2,...}
  - **Array of all buttons in the time selection bar.** Index corresponds to the number of buttons.
  - **X:** The associated button is removed from the Time Range Picker bar. The configuration entry is deleted from the “Times” property list.

### ‘[Index]’

- **‘Time’**
  - **Time interval in standardized notation.** Example: 3M for 3 months; 30m for 30 minutes. If a time interval is indicated in the field, then the button is labelled with it. If a user clicks on the button at runtime, the command is executed to switch the diagram to this time interval. The default is empty.

#### Element property 'Control variables'

<table>
<thead>
<tr>
<th><strong>“Time”</strong></th>
<th>Displays which time is currently selected.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable (STRING)</td>
<td>Example: PLC_PRG.strSelcetedTime</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>&quot;All&quot; selected</strong></th>
<th>Displays the state of the &quot;All&quot; button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable (BOOL)</td>
<td>Example: PLC_PRG.AllTimesAreSelected</td>
</tr>
</tbody>
</table>

#### Element property 'Absolute movement'

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th><strong>“Movement”</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“X”</strong></td>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
</tr>
<tr>
<td>Example: PLC_PRG.iPos_X.</td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
</tbody>
</table>

| **“Y”** | Variable (numeric data type). Defines the Y position (in pixels). |
| Example: PLC_PRG.iPos_Y. | Increasing this value in runtime mode moves the element downwards. |
| **“Rotation”** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
**Example:** PLC_PRG.iAngle1.  
The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.  
In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right. |
| **“Interior rotation”** | Variable (numeric data type). Defines the angle of rotation (in degrees).  
**Example:** PLC_PRG.iAngle2.  
In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.  
The rotation point is shown as the symbol.  
Note: If a static angle of rotation is specified in the “Position è Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed. |

---

You can link the variables to a unit conversion.

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- The variables control the element behavior dynamically.

The “Invisible” property is supported by the “Client Animation” functionality.
These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Animation duration”</strong></td>
<td>Defines the duration (in milliseconds) in which the element runs an animation</td>
</tr>
<tr>
<td>- Variable (integer value)</td>
<td>Example: Menu.tContent with VAR tContent : INT := 500; END_VAR</td>
</tr>
<tr>
<td>- Integer literal</td>
<td>Example: 500</td>
</tr>
<tr>
<td>Animatable properties</td>
<td></td>
</tr>
<tr>
<td>- “Absolute movement”, “Movement”, “X”, “Y”</td>
<td></td>
</tr>
<tr>
<td>- “Absolute movement”, “Rotation”</td>
<td></td>
</tr>
<tr>
<td>- “Absolute movement”, “Interior rotation”</td>
<td></td>
</tr>
<tr>
<td>- “Absolute movement”, “Exterior rotation”</td>
<td>The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.</td>
</tr>
<tr>
<td><strong>“Move to foreground”</strong></td>
<td>Moves the visualization element to the foreground</td>
</tr>
<tr>
<td>Variable (BOOL)</td>
<td>Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR</td>
</tr>
<tr>
<td>TRUE: At runtime, the visualization element is displayed in the foreground.</td>
<td></td>
</tr>
<tr>
<td>FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.</td>
<td></td>
</tr>
</tbody>
</table>

**Element property 'Access rights'**

Requirement: User management is set up for the visualization.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Access rights”</strong></td>
<td>Opens the “Access rights” dialog. There you can edit the access privileges for the element.</td>
</tr>
<tr>
<td>Status messages:</td>
<td></td>
</tr>
<tr>
<td>- “Not set. Full rights.”: Access rights for all user groups: “operable”</td>
<td></td>
</tr>
<tr>
<td>- “Rights are set: Limited rights”: Access is restricted for at least one group.</td>
<td></td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.5.21.3.1 “Dialog ‘Access Rights’” on page 3366

**Visualization Element ‘Date Picker’**

Symbol: ![Symbol](image)

**Category: “Date/Time Controls”**

The element is a calendar that displays the current date. A user can click a day to select a date, which is saved to a variable. In addition, it can customize the time interval that the calendar displays. Clicking the calendar header changes the year. Clicking the arrows in the calendar header changes the month.
The element contains language-dependent texts that are managed in the System text list. This deals with the names of the month and the days of the week written out completely or abbreviated. When the date picker is added to a visualization, CODESYS generates the text list automatically below the POU view. The IDs correspond to the standard text and therefore English terms. The text list makes it possible to translate these texts.

### Example

**System text list**

<table>
<thead>
<tr>
<th>ID</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apr</td>
<td>Apr</td>
</tr>
<tr>
<td>April</td>
<td>April</td>
</tr>
</tbody>
</table>

See also
-  
  "Chapter 6.4.5.8 “Setting Up Multiple Languages” on page 2906"

### Element properties

| "Element name" | Example: DueDateCalendar |
| "Type of element" | “Date Picker” |

### Element property ‘Position’

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

| "X" | X coordinate of the upper left corner of the element  
Specified in pixels.  
Example: 10. |
| "Y" | Y coordinate of the upper left corner of the element  
Specified in pixels.  
Example: 10. |
| "Width" | Specified in pixels.  
Example: 150 |
| "Height" | Specified in pixels.  
Example: 30 |

You can also change the values by dragging the box symbols to other positions in the editor.

See also
-  
  "Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874"

### Element property ‘Center’

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.
**“X”**
X-coordinate of the point of rotation

**“Y”**
Y-coordinate of the point of rotation

---

You can also change the values by dragging the symbols (🔗) to other positions in the editor.

---

**“Variable”**
Input variable (DATE). Contains the date that a user selects in the calendar.
Example: FLC_PRG.dtDueDate

**“Design”**
- **“From style”**: All settings are preconfigured according to the style.
- **“Explicit”**: The “Design settings” property is available. You can customize the calendar here.

---

**Design settings**
Requirement: This property is visible only if the “Design” property is set to “Explicit”.
The values of the property can be predefined in the style. Then they are available in the drop-down list.

---

**Table 725: “Header of Date Picker”**

<table>
<thead>
<tr>
<th>Design of the header</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Font”</strong></td>
<td>Style font or user-defined font</td>
</tr>
<tr>
<td><strong>“Font color”</strong></td>
<td>Style color or user-defined color</td>
</tr>
<tr>
<td><strong>“Arrows”</strong></td>
<td></td>
</tr>
<tr>
<td><strong>“Arrow color”</strong></td>
<td>Style color or user-defined color</td>
</tr>
<tr>
<td><strong>“Color of printed arrow”</strong></td>
<td></td>
</tr>
<tr>
<td><strong>“Background”</strong></td>
<td></td>
</tr>
<tr>
<td><strong>“Draw background”</strong></td>
<td>“From style”: The style defines whether and how a background is drawn. “Yes”: The background is filled with the color in the “Background color” property. “No”: The background is not filled with a color.</td>
</tr>
<tr>
<td><strong>“Fill color”</strong></td>
<td>Style color or user-defined color</td>
</tr>
</tbody>
</table>

---

**Table 726: Design of the main display area**

<table>
<thead>
<tr>
<th>Design of the main display area</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Today”</strong></td>
<td>Design of today</td>
</tr>
<tr>
<td><strong>“Font”</strong></td>
<td>Style font or user-defined font</td>
</tr>
<tr>
<td><strong>“Font color”</strong></td>
<td>Style color or user-defined color</td>
</tr>
<tr>
<td><strong>“Draw background”</strong></td>
<td>“From style”: The style defines whether and which background is drawn. “Yes”: The background is filled with the color in the “Background color” property. “No”: The background is not filled with a color.</td>
</tr>
<tr>
<td><strong>“Background color”</strong></td>
<td>Style color or user-defined color. Used if “Yes” is selected in “Draw background”.</td>
</tr>
<tr>
<td><strong>Show frame</strong></td>
<td>&quot;From style&quot;: The style defines whether and how a frame is drawn.</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>&quot;Yes&quot;: The frame is displayed with the following properties.</td>
<td><em>&quot;No&quot;: A frame is not displayed.</em></td>
</tr>
<tr>
<td>&quot;Frame color&quot;</td>
<td>Used if &quot;Yes&quot; is selected in &quot;Show frame&quot;.</td>
</tr>
<tr>
<td>&quot;Rectangle type&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Line width&quot;</td>
<td></td>
</tr>
</tbody>
</table>

| **Selected day** | Design of the selected day |
| "Font" | Style font or user-defined font |
| "Font color" | Style color or user-defined color |
| "Draw background" | "From style": The style defines whether and how a background is drawn. |
| "Yes": The background is filled with the color in the "Background color" property. | *"No": The background is not filled with a color.* |
| "Background color" | Style color or user-defined color |
| "Show frame" | "From style": The style defines whether and how a background is drawn. |
| "Yes": The frame is displayed with the following properties. | *"No": A frame is not displayed.* |
| "Frame color" | Used if "Yes" is selected in "Show frame". |
| "Rectangle type" | |
| "Line width" | |

| **Current month** | Design of the current month |
| "Font" | Style font or user-defined font |
| "Font color" | Style color or user-defined color |
| "Draw background" | "From style": The style defines whether and how a background is drawn. |
| "Yes": The background is filled with the color in the "Background color" property. | *"No": The background is not filled with a color.* |
| "Background color" | |
| "Show frame" | "From style": The style defines whether and how a background is drawn. |
| "Yes": The frame is displayed with the following properties. | *"No": A frame is not displayed.* |
| "Frame color" | Used if "Yes" is selected in "Show frame". |
| "Rectangle type" | |
| "Line width" | |

| **Other months** | Design of the previous and subsequent months |
| "Font" | Style font or user-defined font |
| "Font color" | Style color or user-defined color |
| "Display other month" | Design of the previous and subsequent months |
### Draw background

*From style*: The style defines whether and how a background is drawn.

*Yes*: The background is filled with the color in the “Background color” property.

*No*: The background is not filled with a color.

### Background color

*Show frame*

*From style*: The style defines whether and how a frame is drawn.

*Yes*: The frame is displayed with the following properties.

*No*: A frame is not displayed.

### Frame color

Used if “Yes” is selected in “Show frame”.

### Rectangle type

### Line width

### Day of week heading

Design of the heading with the days of the week

### Font

Style font or user-defined font

### Font color

Style color or user-defined color

### Draw background

*From style*: The background is filled with the style color “From style”. The style defines whether and how a background is drawn.

*Yes*: The background is filled with the color in the “Background color” property.

*No*: The background is not filled with a color.

### Background color

### Show frame

*From style*: The style defines whether and how a frame is drawn.

*Yes*: The frame is displayed with the following properties.

*No*: A frame is not displayed.

### Frame color

Used if “Yes” is selected in “Show frame”.

### Rectangle type

### Line width

### Display separator line

*From style*: The style defines whether and how a separator line is drawn.

*Yes*: Display with the following properties.

*No*: A separator line is not displayed.

### Color of the separator line

Used if “Yes” is selected in “Display separator line”.

### Width of separator line

### Background

Design of the calendar days

### Draw background

*From style*: The style defines whether and how a background is drawn.

*Yes*: The background is filled with the color in the “Fill color” property and framed in the “Frame color”.

*No*: The background is not filled with a color.

### Fill color

*Frame color*

Style color or user-defined color

### Element property ‘Display type’
**Element property 'Absolute movement'**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

### Movement

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Example</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>X</strong></td>
<td>Defines the X position (in pixels).</td>
<td>PLC_PRG.iPos_X</td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td><strong>Y</strong></td>
<td>Defines the Y position (in pixels).</td>
<td>PLC_PRG.iPos_Y</td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
</tr>
</tbody>
</table>

### Rotation

Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle1.

The midpoint of the element rotates at the "Center" point. This rotation point is shown as the symbol.

In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

### Interior rotation

Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in "Center" according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the "Position Angle" property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

---

You can link the variables to a unit conversion.
The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the "Client Animation" functionality.

See also

- 

**Element property 'State variables'**

The variables control the element behavior dynamically.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Invisible&quot;</td>
<td>Variable (BOOL). Toggles the visibility of the element. TRUE: The element is not visible at runtime. Example: bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR</td>
</tr>
<tr>
<td>&quot;Deactivate inputs&quot;</td>
<td>Variable (BOOL). Toggles the operability of the element. TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.</td>
</tr>
</tbody>
</table>

The “Invisible” property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
**"Animation duration"**

Defines the duration (in milliseconds) in which the element runs an animation

- **Variable (integer value)**
  
  Example: Menu.tContent with VAR tContent : INT := 500; END_VAR

- **Integer literal**
  
  Example: 500

**Animatable properties**

- "Absolute movement", "Movement", "X", "Y"
- "Absolute movement", "Rotation"
- "Absolute movement", "Interior rotation"
- "Absolute movement", "Exterior rotation"

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

**"Move to foreground"**

Moves the visualization element to the foreground

Variable (BOOL)

Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR

TRUE: At runtime, the visualization element is displayed in the foreground.

FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

**Element property 'Access rights'**

Requirement: User management is set up for the visualization.

**"Access rights"**

Opens the "Access rights" dialog. There you can edit the access privileges for the element.

Status messages:

- "Not set. Full rights.": Access rights for all user groups: "operable"
- "Rights are set: Limited rights": Access is restricted for at least one group.

See also

- § Chapter 6.4.5.21.3.1 "Dialog 'Access Rights’" on page 3366

See also

- § Chapter 6.4.5.5 "Designing a visualization with elements" on page 2872

**Visualization Element 'Analog Clock'**

Symbol:

![Analog Clock Symbol](image)

Category: "Date/Time Controls"

The element is a clock that displays the current time of day. The clock can also display a random time.
Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Example: GenElemInst_1</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Type of element”</td>
<td>“Analog Clock”</td>
</tr>
</tbody>
</table>

Element property 'Position' The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

| “X” | X coordinate of the upper left corner of the element  
Specified in pixels.  
Example: 10. |
|------|------------------------------------------------------|
| “Y” | Y coordinate of the upper left corner of the element  
Specified in pixels.  
Example: 10. |
| “Width” | Specified in pixels.  
Example: 150 |
| “Height” | Specified in pixels.  
Example: 30 |

You can also change the values by dragging the box symbols (▼) to other positions in the editor.

See also
- Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

Element property 'Center' The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the symbol. The point is used as the center for rotating and scaling.

<table>
<thead>
<tr>
<th>“X”</th>
<th>X-coordinate of the point of rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Y”</td>
<td>Y-coordinate of the point of rotation</td>
</tr>
</tbody>
</table>

You can also change the values by dragging the symbols (▼) to other positions in the editor.

Element property 'Time Display'
### “Use system time”

- The system time of the PLC is displayed.

### “Variable”

- Variable (time data type `TOD`, `TIME_OF_DAY`). This receives the time of day that is not the system time.
- **Example:** `PLC_PRG.todTimeTokio`
- **Requirement:** The “Use system time” property is not activated.

See also

- [Chapter 6.4.1.20.5.6 “Data Type ’TIME’” on page 2237](#)

### “Design”

- “From style”: All settings are preconfigured according to the style.
- “Explicit”: The “Settings” property is available. Here you can customize the analog clock.

### Element property 'Absolute movement'

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>“Movement”</th>
<th></th>
</tr>
</thead>
</table>
| “X” | Variable (numeric data type). Defines the X position (in pixels).
- **Example:** `PLC_PRG.iPos_X`.
- Increasing this value in runtime mode moves the element to the right. |
| “Y” | Variable (numeric data type). Defines the Y position (in pixels).
- **Example:** `PLC_PRG.iPos_Y`.
- Increasing this value in runtime mode moves the element downwards. |
| “Rotation” | Variable (numeric data type). Defines the angle of rotation (in degrees).
- **Example:** `PLC_PRG.iAngle1`.
- The midpoint of the element rotates at the “Center” point. This rotation point is shown as the symbol.
- In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right. |
| “Scaling” | Variable (integer data type). Causes centric stretching.
- **Example:** `PLC_PRG.iScaling`.
- The reference point is the “Center” property.
- The value 1 shrinks the element by a factor of 0.001. The value 1000 returns the element to its original size. |
"Interior rotation" Variable (numeric data type). Defines the angle of rotation (in degrees).

Example: PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in "Center" according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the \( \odot \) symbol.

Note: If a static angle of rotation is specified in the property "Position \( \Rightarrow \) Angle", then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

"Use REAL values" Note: Only available if the device supports the use of REAL coordinates.

- The properties of the absolute movement are interpreted as REAL values. The values are not rounded.
- The rotation point is shown as the \( \odot \) symbol.

Hint: If a horizontal or vertical line is drawn blurry on a specific visualization platform, then this can be corrected by an offset of 0.5px in the direction of the line thickness.

You can link the variables to a unit conversion.

The properties "X", "Y", "Rotation", and "Interior rotation" are supported by the "Client Animation" functionality.

See also

- 

**Element property 'Settings'**

Requirement: The "Property" is "Explicit". Only then is the "Clock Settings" category visible.

**Table 727: "Background"

<table>
<thead>
<tr>
<th>&quot;Background color&quot;</th>
<th>Color variants of the default background image</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>&quot;Yellow&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Red&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Blue&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Green&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Black&quot;</td>
</tr>
</tbody>
</table>

<p>| &quot;Own background&quot; | Background display with the specific &quot;Image&quot;. Replaces the default background image. |</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Image”</td>
<td>Image from an image pool or library</td>
</tr>
<tr>
<td>Example: myImagepool.myImage</td>
<td></td>
</tr>
<tr>
<td>“Transparency color”</td>
<td>The transparent color in the image representation.</td>
</tr>
<tr>
<td>Example: “White”</td>
<td>The white parts of the image are transparent.</td>
</tr>
<tr>
<td>“Use background color”</td>
<td>The image background is displayed using the color defined in the “Background color” property.</td>
</tr>
<tr>
<td>Requirement: No image reference is given in the “Image” property.</td>
<td></td>
</tr>
<tr>
<td>“Background color”</td>
<td>Style color or color</td>
</tr>
<tr>
<td>Requirement: “Use background color” is activated.</td>
<td></td>
</tr>
</tbody>
</table>

Table 728: “Hands”

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Hand style”</td>
<td>Example: “Thin arrow”</td>
</tr>
<tr>
<td>“Color hour hand”</td>
<td>Style color or color for the hands</td>
</tr>
<tr>
<td>“Color minute hand”</td>
<td></td>
</tr>
<tr>
<td>“Color second hand”</td>
<td></td>
</tr>
</tbody>
</table>

Table 729: “Lines”

| “Lines style”                  | Clock face graduation                                                                                                                        |
| “None”                         |                                                                                                                                             |
| “Line”: Graduation lines by hour|                                                                                                                                             |
| “Hours and minutes”: Graduation lines by hours and minutes |                                                                                                                                             |
| “Dots”: Graduation dots by hour |                                                                                                                                             |
| “Color”                        | Color of the clock face graduation                                                                                                          |
| “Line width”                   | Line weight of the clock face graduation                                                                                                    |
| “Scale in 3D”                  | ☑: Representation of the clock face with 3D effect                                                                                           |

Table 730: “Numerics”

| “Style of numerics”            | Digits on the clock face                                                                                                                      |
| “None”                         |                                                                                                                                             |
| “Quarter”                      |                                                                                                                                             |
| “All”                          |                                                                                                                                             |
| “Font”                         | Font for displaying the digits                                                                                                                |
| “Font color”                   | Font for displaying the digits                                                                                                               |

Table 731: “Center point”

| “Color”                        | Color of the center of the clock                                                                                                             |

Table 732: “Positioning”

<p>| “Usage of”                     | • “Default style values”: Presetting of the style values                                                                                     |
|                                | • “Individual settings”: User-defined settings in the subordinate “Positioning” property.                                                   |
| “Positioning”                  | Requirement: Visible when the “Usage or” property is set to “Individual settings”.                                                          |</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Numerics movement”</td>
<td>Value (in pixels) for shifting the digits.</td>
<td>80</td>
</tr>
<tr>
<td>“Line movement”</td>
<td>Value (in pixels) for shifting the hour lines.</td>
<td>100</td>
</tr>
<tr>
<td>“Hands scaling”</td>
<td>Factor for scaling the length of the hour hand. You can customize the exact position of the hour hand relative to the background image.</td>
<td>100</td>
</tr>
<tr>
<td>“Scaling type”</td>
<td>Defines the scaling of the height and width of the element.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>“Anisotropic”: The background image is scaled to the size of the element The height and width are scaled independently of each other.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>“Isotropic”: The background image is scaled to the size of the element, retaining its proportion. The proportion of height and width is fixed.</td>
<td></td>
</tr>
<tr>
<td>“Optimized drawing”</td>
<td>☑: The background image is drawn one time. When the hour hand moves, only the affected part of the image is redrawn.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>☐: The background image is redrawn in cycles.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hint: Disable this option only for extreme exceptions.</td>
<td></td>
</tr>
</tbody>
</table>

**Element property 'Absolute movement'**

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Movement”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>“X”</td>
<td>Variable (numeric data type). Defines the X position (in pixels).</td>
<td>PLC_PRG.iPos_X.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element to the right.</td>
<td></td>
</tr>
<tr>
<td>“Y”</td>
<td>Variable (numeric data type). Defines the Y position (in pixels).</td>
<td>PLC_PRG.iPos_Y.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value in runtime mode moves the element downwards.</td>
<td></td>
</tr>
<tr>
<td>“Rotation”</td>
<td>Variable (numeric data type). Defines the angle of rotation (in degrees).</td>
<td>PLC_PRG.iAngle1.</td>
</tr>
<tr>
<td></td>
<td>The midpoint of the element rotates at the “Center” point. This rotation point is shown as the + symbol.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.</td>
<td></td>
</tr>
</tbody>
</table>
**“Interior rotation”**

Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in “Center” according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the symbol.

Note: If a static angle of rotation is specified in the “Position ➔ Angle” property, then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

---

You can link the variables to a unit conversion.

---

The “X”, “Y”, “Rotation”, and “Interior rotation” properties are supported by the “Client Animation” functionality.

See also

- "State variables"

The variables control the element behavior dynamically.

**“Invisible”**

Variable (BOOL). Toggles the visibility of the element.

**TRUE:** The element is not visible at runtime.

---

The “Invisible” property is supported by the “Client Animation” functionality.

---

These properties are available only when you have selected the “Support client animations and overlay of native elements” option in the Visualization Manager.
“Animation duration”

Defines the duration (in milliseconds) in which the element runs an animation

- **Variable (integer value)**
  
  Example: Menu.tContent with VAR tContent : INT := 500;
  END_VAR

- **Integer literal**
  
  Example: 500

**Animatable properties**

- “Absolute movement”, “Movement”, “X”, “Y”
- “Absolute movement”, “Rotation”
- “Absolute movement”, “Interior rotation”
- “Absolute movement”, “Exterior rotation”

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

“Move to foreground”

Moves the visualization element to the foreground

Variable (BOOL)

Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR

TRUE: At runtime, the visualization element is displayed in the foreground.
FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

See also

- § Chapter 6.4.5.5 “Designing a visualization with elements” on page 2872

Visualization Element ‘Date/Time Picker’

Symbol:

Category: “Date/Time Controls”

The element provides the capability of selecting the date and time. The value can be changed by means of the arrow keys on the keyboard. The date can be selected from a calendar.

Element properties

<table>
<thead>
<tr>
<th>“Element name”</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint: Assign individual names for elements so that they are found faster in the element list.</td>
<td></td>
</tr>
<tr>
<td>Example: StartDateAndTime</td>
<td></td>
</tr>
</tbody>
</table>

| “Type of element” | “Date/Time Picker” |
**Element property 'Position'**

The position defines the location and size of the element in the visualization window. These are based on the Cartesian coordinate system. The origin is located at the upper left corner of the window. The positive horizontal x-axis runs to the right. The positive vertical y-axis runs downwards.

| "X" | X coordinate of the upper left corner of the element  
|-----|------------------------------------------------------  
|     | Specified in pixels.  
|     | Example: 10.  
| "Y" | Y coordinate of the upper left corner of the element  
|-----|------------------------------------------------------  
|     | Specified in pixels.  
|     | Example: 10.  
| "Width" | Specified in pixels.  
|------|------------------------------------------------------  
|      | Example: 150  
| "Height" | Specified in pixels.  
|-------|------------------------------------------------------  
|       | Example: 30

You can also change the values by dragging the box symbols (♀) to other positions in the editor.

See also

- § Chapter 6.4.5.5.3 “Positioning the Element, Adapting Size and Layer” on page 2874

**Element property 'Center'**

The properties contain fixed values for the coordinates of the point of rotation. This point of rotation is shown as the ⦿ symbol. The point is used as the center for rotating and scaling.

| "X" | X-coordinate of the point of rotation  
|-----|--------------------------------------  
| "Y" | Y-coordinate of the point of rotation  

You can also change the values by dragging the symbols (⦿) to other positions in the editor.
**“Variable”**

Variable (DATE, DT, TIME, LTIME, TOD)

The value of the value of the variable is displayed and modified by means of the element.

The data type automatically determines the displayed value units:

- **TIME**: Day, hour, minute, and second (by default, milliseconds are not displayed)
- **DATE**: Year, month, and day
- **DT**: Year, month, day, hour, minute, and second
- **TOD**: Hour, minute, and second (by default, milliseconds are not displayed)
- **LTIME**: Day, hour, minute, and second (by default, milliseconds, microseconds, and nanoseconds are not displayed)

**“Format string”**

The format can restrict the output to individual values.

Example for **LTIME**: Format: HH:mm:ss.ms.ns \(\rightarrow\) displayed: 08:15:12.780.150.360

LTIME restricted: format: HH:mm \(\rightarrow\) displayed: 08:15

Example for **DATE**: Format: yyyy/MM/dd \(\rightarrow\) displayed: 2015/12/17

Basically, all usual formats available for %t are also supported.

**“Design date time picker”**

- **“From style”**: All settings are preconfigured according to the style.
- **“Explicit”**: The “Design settings” property is available. You can customize the calendar here.

**“Design date picker”**

- **“From style”**: All settings are preconfigured according to the style.
- **“Explicit”**: The “Design settings” property is available. You can customize the calendar here.

**“Positioning date picker”**

- **“Dynamic”**: The calendar is adapted and positioned automatically.
- **“Manual”**: The “Position settings” property is available. You can customize the calendar here.

See also

- ☞ Chapter 6.4.5.20.2 “Placeholders with Format Definition in the Output Text” on page 3329

Element property ‘Absolute movement’

The properties contain IEC variables for controlling the position of the element dynamically. The reference point is the upper left corner of the element. In runtime mode, the entire element is moved.

**“Movement”**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>Variable (numeric data type). Defines the X position (in pixels). Example: PLC_PRG.iPos_X. Increasing this value in runtime mode moves the element to the right.</td>
</tr>
<tr>
<td>Y</td>
<td>Variable (numeric data type). Defines the Y position (in pixels). Example: PLC_PRG.iPos_Y. Increasing this value in runtime mode moves the element downwards.</td>
</tr>
</tbody>
</table>
### "Rotation"
Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** PLC_PRG.iAngle1.

The midpoint of the element rotates at the "Center" point. This rotation point is shown as the \( \theta \) symbol.

In runtime mode, the alignment of the element remains the same with respect to the coordinate system of the visualization. Increasing the value rotates the element to the right.

### "Scaling"
Variable (integer data type). Causes centric stretching.

**Example:** PLC_PRG.iScaling.

The reference point is the "Center" property.

The value 1 shrinks the element by a factor of 0.001. The value 1000 returns the element to its original size.

### "Interior rotation"
Variable (numeric data type). Defines the angle of rotation (in degrees).

**Example:** PLC_PRG.iAngle2.

In runtime mode, the element rotates about the point of rotation specified in "Center" according to the value of the variable. In addition, the alignment of the element rotates according to the coordinate system of the visualization. Increasing the value in the code rotates clockwise.

The rotation point is shown as the \( \theta \) symbol.

Note: If a static angle of rotation is specified in the property "Position \( \rightarrow \) Angle", then the static angle of rotation is added to the variable angle of rotation (offset) when the visualization is executed.

---

**You can link the variables to a unit conversion.**

**The properties "X", "Y", "Rotation", and "Interior rotation" are supported by the "Client Animation" functionality.**

See also

- Element property ‘State variables’

The variables control the element behavior dynamically.
"Invisible" Variable (BOOL). Toggles the visibility of the element.

TRUE: The element is not visible at runtime.

Example: bIsVisible with VAR bIsVisible : BOOL := FALSE; END_VAR

"Deactivate inputs" Variable (BOOL). Toggles the operability of the element.

TRUE: User inputs do not have any effect in runtime more. The element is shown as deactivated.

The "Invisible" property is supported by the "Client Animation" functionality.

These properties are available only when you have selected the "Support client animations and overlay of native elements" option in the Visualization Manager.

"Animation duration" Defines the duration (in milliseconds) in which the element runs an animation

- Variable (integer value)
  Example: Menu.tContent with VAR tContent : INT := 500; END_VAR
- Integer literal
  Example: 500

Animatable properties

- "Absolute movement", "Movement", "X", "Y"
- "Absolute movement", "Rotation"
- "Absolute movement", "Interior rotation"
- "Absolute movement", "Exterior rotation"

The animated movement is executed when at least one value of an animatable property has changed. The movement then executed is not jerky, but is smooth within the specified animation duration. The visualization element travels to the specified position while rotating dynamically. The transitions are smooth.

"Move to foreground" Moves the visualization element to the foreground

Variable (BOOL)

Example: bIsInForeground with VAR bIsInForeground : BOOL := FALSE; END_VAR

TRUE: At runtime, the visualization element is displayed in the foreground.
FALSE: At runtime, the visualization element is displayed in the layer where it was inserted in the visualization editor.

Element property 'Access rights'

Requirement: User management is set up for the visualization.

"Access rights" Opens the "Access rights" dialog. There you can edit the access privileges for the element.

Status messages:

- "Not set. Full rights.": Access rights for all user groups: "operable"
- "Rights are set: Limited rights": Access is restricted for at least one group.
6.4.5.22 Reference, visualization style editor

6.4.5.22.1 Dialog 'Create a New Visualization Style'

Symbol: 🕵

Function: The dialog prompts you to specify data for a new created style file.

Call:
- In CODESYS:
  In the “Visualization Manager” object (tab “Settings”, group “Style Settings”):
  - Clicking ‌‌ opens a drop-down list. Click “Create and Edit Derived Style”.
- In the visualization style editor:
  - Menu bar: “File ➔ New Style”

| “Name” | Name of the new style. |
| “Storage location” | Working directory for style editing |
| “Base style” | Style to base the new style on. The drop-down list includes all styles that are installed in the repository. |
| “<none>” | The new style does not derive itself from an existing style. |
| “Visualization profile” | The profile is intended for informational purposes. For example, you find elements that are not preconfigured with special style entries, and information from the profile. In addition, CODESYS checks in the profile whether a required style is missing. |

Example: Style_CI

Click “OK” The new style is created and opened for editing in the visualization style editor. It already includes all required style entries and the localization in German (language column de).

See also
- ° Chapter 6.4.5.21.4.2 “Object ‘Visualization manager’” on page 3398
- ° Chapter 6.4.5.19 “Applying Visualization Styles” on page 2979

6.4.5.22.2 Dialog 'Open Existing Style as a Copy'

Function: This dialog prompts you to specify data for copying a style file.

Call:
- In CODESYS:
  - In the editor of the “Visualization Manager” object (tab “Settings”, group “Style Settings”, click ‌‌ for a drop-down list). Click “Copy and Edit Style”.
- In the visualization style editor:
  - Menu bar: “File ➔ Open as Copy”
### Style

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Style”</strong></td>
<td>Style to be copied.</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong> Basic Style, 3.5.9.0</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can also select a style from the repository.</td>
</tr>
</tbody>
</table>

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Destination”</strong></td>
<td>Working directory for style editing</td>
</tr>
<tr>
<td><strong>“OK”</strong></td>
<td>A copy of the style is created and opened for editing in the visualization style editor.</td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.5.19 “Applying Visualization Styles” on page 2979
- Chapter 6.4.5.22.3 “Editor ‘Visualization Style Editor’” on page 3750
- Chapter 6.4.5.21.4.2 “Object ‘Visualization manager’” on page 3398

### 6.4.5.22.3 Editor ‘Visualization Style Editor’

**Symbol:** 🎨

**Function:** The editor is used for creating, deriving, editing, and localizing visualization styles. In addition, it makes it possible to check and install a style or a hierarchy of styles.

**Call:**

- In CODESYS:
  - In the “Visualization Manager” object (tab “Settings”, group “Style Settings”, click 🎨 for a drop-down list). Click “Open Style Editor”.
- Start menu > CODESYS installation folder > 'CODESYS' > 'Visualization Style Editor'

#### Menu 'File'

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“New style”</td>
<td>The “Create a New Visualization Style” dialog box opens.</td>
</tr>
<tr>
<td>“Open”</td>
<td>The “Open Dialog” dialog box opens. This dialog prompts you to select a style file (format .visustyle.xml) to be opened and edited.</td>
</tr>
<tr>
<td>“Open as copy”</td>
<td>The “Open Existing Style as Dialog” dialog box opens. This dialog prompts you to select a style that is copied, saved to the target location, and opened for editing.</td>
</tr>
<tr>
<td>“Close”</td>
<td>Closes the style open in the editor.</td>
</tr>
<tr>
<td>“Save”</td>
<td>Saves the changes of the open style.</td>
</tr>
<tr>
<td>“Save As”</td>
<td>The “Select Visualization Style(s)” dialog box opens. This dialog prompts you to select a file to save the current settings.</td>
</tr>
<tr>
<td>“Save and Install”</td>
<td>Saves the open visualization style and installs it to the visualization style repository.</td>
</tr>
<tr>
<td>“Recently opened files”</td>
<td>Lists the files for selection that were last opened.</td>
</tr>
<tr>
<td>“Abort”</td>
<td>Closes the visualization style editor.</td>
</tr>
</tbody>
</table>

See also

- Chapter 6.4.5.22.1 “Dialog ‘Create a New Visualization Style’” on page 3749

#### Menu 'Styles’

The commands affect the contents of the “Style Properties” tab.
<table>
<thead>
<tr>
<th><strong>New Entry (as Child)</strong></th>
<th>Creates another style entry as a child of the selected style property.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New Entry (Afterwards)</strong></td>
<td>Creates a new style entry in the list after the selected style property.</td>
</tr>
<tr>
<td><strong>Move Down</strong></td>
<td>Moves the selected style entry down. Requirement: Sort order is flat.</td>
</tr>
<tr>
<td><strong>Move Up</strong></td>
<td>Moves the selected style entry up. Requirement: Sort order is flat.</td>
</tr>
<tr>
<td><strong>Sort Order</strong></td>
<td>Toggles between three sort orders:</td>
</tr>
<tr>
<td></td>
<td>● Flat structure and alphabetical order</td>
</tr>
<tr>
<td></td>
<td>● Flat structure and order according to the position of the entry in the XML style file</td>
</tr>
<tr>
<td></td>
<td>This position also determines the position of the property in CODESYS. The property appears, for example, in the “Properties” view below the “Values” column in the drop-down list for style properties.</td>
</tr>
<tr>
<td></td>
<td>● Hierarchical structure of entries</td>
</tr>
<tr>
<td></td>
<td>Requirement: The names of the style properties contain at least one dash.</td>
</tr>
<tr>
<td><strong>Check</strong></td>
<td>The settings of the style properties are checked for consistency errors. This check is also performed when saving the style.</td>
</tr>
</tbody>
</table>

**Menu 'Localization'**

The commands affect the contents of the “Localization” tab.

<table>
<thead>
<tr>
<th><strong>Add Language</strong></th>
<th>The dialog box “Add New Language” opens. The dialog prompts you to specify data for creating a new language column.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Remove Selected Language</strong></td>
<td>Removes the columns of the selected cell.</td>
</tr>
<tr>
<td><strong>Rename Selected Language</strong></td>
<td>The “Rename Language” dialog box opens. The dialog is used for renaming the column that defines the selected cell and removes all previous translations.</td>
</tr>
</tbody>
</table>

**Table 733: Dialog box “Add New Language”**

<table>
<thead>
<tr>
<th><strong>Name</strong></th>
<th>Name of the new language as a language code according to ISO 639-1.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Examples: de, en, es, it, fr, ja</td>
<td></td>
</tr>
<tr>
<td><strong>Copy from existing</strong></td>
<td>All existing language columns are available for selection. The selected language is copied with all entered translations.</td>
</tr>
<tr>
<td>“&lt;do not copy text&gt;”: The new language receives a blank translation column.</td>
<td></td>
</tr>
</tbody>
</table>

**Tab 'General'**

This tab contains the general metadata of the open style file and allows it to be edited.

**Table 734: “Identification”**

<table>
<thead>
<tr>
<th><strong>Company</strong></th>
<th>Example: Xy-z GmbH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tip: In the installed styles, CODESYS can filter by the company names specified here.</td>
<td></td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Example: Style_A</td>
</tr>
<tr>
<td><strong>Version</strong></td>
<td>User-defined version number</td>
</tr>
<tr>
<td>Example: 1.1.1.1</td>
<td></td>
</tr>
</tbody>
</table>
### Table 735: “General Settings”

<table>
<thead>
<tr>
<th><strong>“Base style”</strong></th>
<th>Name and version of the style that the open style is based on. Tip: The derived style properties from the base style are highlighted in yellow in the “Style Properties” tab.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Partial style (usable only as base for other visualization styles)”</strong></td>
<td>☑: The style is identified as incomplete. Therefore, it can be used for other styles as a base style only. Example: Style only with color definitions that derive this to many other styles. Note: CODESYS does not check for consistency errors of an incomplete style for itself. ☐: The style is identified as complete.</td>
</tr>
<tr>
<td><strong>“From”</strong></td>
<td>The “Select Base Style” dialog box opens. This dialog prompts you to select a style file that is saved to the file system (and not does not have to be installed). The file is used as a base style.</td>
</tr>
</tbody>
</table>

### Table 736: “Informational”

| **“Visualization profile”** | The profile is intended for informational purposes. For example, you find elements that are not preconfigured with special style entries, and information from the profile. In addition, CODESYS checks in the profile whether a required style is missing. |

**Tab 'Style Properties'**

This tab lists the names of the style properties with the associated values and makes it possible to edit it, even by means of the commands in the “Styles” menu. The style properties can be defined for colors, fonts, images, and any values. The style properties defined in a base style are derived and highlighted in yellow.

| **“Name”** | Name of the style property. If the name contains a dash, then the Visualization Style Editor can sort the style properties by the prefixed terms before the dash and display them in a hierarchy. A name can contain more than one dash. |
| **“Value”** | Value that is assigned to the style property. |
| **“Type”** | Data type of the style property; selected from a drop-down list. Note: This is possible and necessary only for specific style properties with a data type that is not implicitly defined. |
| **“Attribute”** | “hide”: The associated style property is not listed in the drop-down lists in CODESYS. |
| **“Used by”** | Visualization element that can be configured with this style property. Can be edited. |
| **Comment** | Example: Special setting for Bar Display. Optional. |
| **Double-click a cell.** | An input field opens for editing. |
| **[Del]** | Removes the selected row. |

**Tab 'Localization'**

This tab makes it possible to translate the names of the style properties into other languages.
6.4.6 CODESYS Visualization Support

With CODESYS Visualization Support, you get the functionality to collect and manage images in image pools and texts in text lists. For image pools, the focus is on the most optimal storage of image files. For text lists, the focus is on the localization of the texts.

6.4.6.1 Using an Image Pool

An image pool is a table of image files where an entry for each image is listed with the image ID, file name, thumbnail, and link type. At this central location, you add an image to your project or application and can further edit the image entry. At the location in the code where an image is accessed, the image ID can then be briefly specified instead of the file name of the image. The centrally stored images are accessed primarily in visualizations.

We recommend that you reduce the size of image files as much as possible before integrating them. This will optimize the loading time of the visualization in every visualization type: TargetVisu, WebVisu, and development system.

You can create any number of image pools in the project in order to sort and categorize the images thematically.

You can create image pools in the POU pool so that they are available globally in all applications. If necessary, it is located there next to the GlobalImagePool image pool, which is created automatically.

In a library project, you can use the object properties of an image pool to convert it into a symbol library for the visualization.

6.4.6.1.1 Creating an image pool

1. In the device tree, select the “Application” object.
   Click “Project → Add Object → Image Pool”.
   ➞ The “Add Image Pool” dialog opens.
2. Type a name for the image pool (for example, "Images1") and click “Add”.
   ➞ The image pools are added to the device tree.
3. Select the “ImagePool” object and click “Project → Edit Object” to open it.
4. Double-click the field in the “ID” column and assign an appropriate ID (for example, "Icon1").
   Alternatively, you could also click Add Image File to add new images to the list.
5. Double-click the field in the “File Name” column. Click the button.
   ➞ The “Select Image” dialog opens.
6. Click the button and then select the image file.
   ➞ A thumbnail of the image file is displayed in the field of the column “Image”. The name of the file is displayed in the “File name” field.
The image file can be references only by the name Images1.Icon1.

6.4.6.1.2 Implementing access to an image

At locations in the application where an image should to be accessed, the image ID can be briefly specified. This is especially the case with visualizations. There you can configure elements which can display images with the image ID (qualified with `<name of image pool>.<image ID>`).

Elements with static image display:

- `$ Image$ visualization element: “Static ID” property
- `$ Button$ visualization element: “Static ID” property
- `$ Chapter 6.4.5.21.5.30 “Visualization Element 'Image Switcher'” on page 3646$ visualization element: “Image on”, “Image off”, and “Image clicked” properties
- $ Cartesian XY Chart visualization element: Configuration of the background in the Dialog: XY Chart Configuration dialog$

If an element should dynamically display multiple images one after the other, then a string variable is specified for it, not the image ID itself. The variable is set programmatically (in IEC code) to change the image IDs. In this way, a dynamic image display in the visualization element is achieved.

Elements with dynamic image display:

- `$ Image$ visualization element: “Image ID variable” property
- `$ Button$ visualization element: “Image ID variable” property

6.4.6.1.3 Tab: Build

The tab contains options for compiling the object.

6.4.6.1.4 Running the HMI application

1. Click the $\mathbb{1}$ symbol.
   - The application is compiled.
2. Click the $\mathbb{2}$ symbol.
   - The application is downloaded to HMI device.
3. Click the start $\mathbb{3}$ symbol.
   - The HMI application is executed. The visualization starts. The actual value from the controller is output.

You can operate the visualization using the keyboard, mouse, or gestures.

Output: -24714
6.4.6.1.5 For experts

When accepting the remote adapter by means of the "Copy to Project" command, the I/O dimensions with which the adapter responded are set for the first "exclusive owner" connection. In order to log all of the detected assembly instances after scanning, the definition IODRVETHERNETIP_PRINT_SCAN_RESULT must be set. By default, it is scanned by the instance ID 100–199. This can be adapted by means of the library parameters ParamScanStartOfInstanceAssem and ParamScanLastOfInstanceAssem from the library IoDrvEtherNetIP Library. This might be necessary, for example to scan in another manufacturer-specific range (assembly instance ID ranges).

6.4.6.1.6 Configuring a visualization background with an image

You can set an image in the background definition of a visualization. You can define the image by the name of the image pool plus the file name, as described above for a visualization element.

For more information, see: Command: Background

6.4.6.1.7 Labeling an Image Element with Static Text

☐ Requirement: A project with a visualization is open. You have an image file for a stop symbol.

1. Below the application, insert an "ImagePool" object named ImagePool_A.
2. Add an image with the Stop ID to ImagePool_A.

3. Open the visualization and drag an "Image" element to the editor.
   - The Input Assistant opens. ImagePool_A is listed on the Category tab.
4. Select the Stop image and click "OK" to close the dialog.
5. Configure its "Text" property: ImagePool_A, Stop
6. Configure the "Text properties ➔ Horizontal alignment" property: Links.
7. Configure the "Text properties ➔ Vertical alignment" property: Bottom.

6.4.6.2 Using a Text List

A text list is a table of text entries which lists an entry with a text ID, the default text, and its translations into other languages for each text used in the project. At this central location, you can add a new text or further edit an existing text entry.

The centrally stored texts are accessed primarily by visualizations. The text list is the basis for localization, selecting a language, and changes languages in visualizations.
You can specify the texts in Unicode format so that all languages and characters are possible. You can translate the default texts and add more languages when needed. Moreover, you can export text lists and then translate the texts outside of the current project. For more information, see:

- Exporting a text list
- Importing files with text list entries

### 6.4.6.2.1 Output of dynamic text by a variable

Besides the automatically created global text list, there are also custom text lists.

If an element should dynamically display multiple texts one after the other, then a string variable is specified for it, not the text ID itself. The variable is then set programmatically (in IEC code) to change the text IDs. In this way, a dynamic text display in the visualization element is achieved.

In custom text lists, you can translate the default texts and add more languages when needed. If language switching is implemented for visualizations, then the translation is displayed at runtime for the configured text.

Elements which can dynamically display the text referenced under the "Dynamic texts" property:

- Image visualization element
- Frame visualization element
- Pie visualization element
- Polygon, Polyline, and Bézier Curve visualization elements
- Rectangle visualization element
- Button visualization element
- Scroll Bar visualization element
- Table visualization element
- Text Field visualization element

#### Example

1. All texts about a topic (such as error handling) are listed in a text list.

2. The "Text Field" visualization element is configured for dynamic display:
3. A case distinction is implemented in the application code where the text for error handling is displayed depending on the error.

   ⇒ For this purpose, a text ID from the `ErrorHandling` text list is assigned to the `strHandlingID` variable depending on the `iError` error.

   ```
   // Text list name
   strErrorHandling := 'ErrorHandling';
   // Assigning text ID
   CASE iError OF
     2: strHandlingID := 'ID_2';
     3: strHandlingID := 'ID_3';
     4: strHandlingID := 'ID_3';
     ELSE    strHandlingID := 'ID_1';
     END_CASE;
   ```

6.4.6.2.2 Managing Languages and Translations

Adding a language and translating text

Requirement: A project is open with a text list or global text.

1. In the device tree or POU view, double-click an object of type “TextList” or “GlobalTextList”.
   ⇒ The “Text List” menu is shown in the menu bar and the text list opens in the editor.

2. Click “Text List ➔ Add Language”.

3. Specify a name for the language (example: en-US). Click “OK” to exit the dialog.
   ⇒ A column is displayed with the heading en-US.

4. Type in the translation of the source text into the column.

You can use the “Rename Language” command in the context menu of the text list to correct the name of a language in the table.

Exporting a text list

═ Requirement: A project is open with a text list or global text.

1. Double-click the “GlobalTextList” object or a “TextList” object type.
   ⇒ The object opens.

2. Click “Text List ➔ Import/Export Text Lists”.
   ⇒ The “Import/Export” dialog opens.

3. At “Choose export file”, click ![folder_icon] and select the directory and file name.
   Example: Text_lists_exported

4. Select the “Export” option.

5. Click “OK” to close the “Import/Export” dialog.
   ⇒ CODESYS exports to a file the text list entries of all text lists of the project. The table contains a column with the text list names.
### Example: Contents of the Text_lists_exported file

<table>
<thead>
<tr>
<th>TextList</th>
<th>Id</th>
<th>Default</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Text_list_A</td>
<td>A</td>
<td>Information A</td>
<td>Infrrmaiton A_en</td>
<td></td>
</tr>
<tr>
<td>Text_list_A</td>
<td>B</td>
<td>Information B: OK</td>
<td>Information B_en: OK</td>
<td></td>
</tr>
<tr>
<td>Text_list_A</td>
<td>C</td>
<td>Information C</td>
<td>Information C_en</td>
<td></td>
</tr>
<tr>
<td>Text_list_A</td>
<td>D</td>
<td>Information D</td>
<td>Information D_en</td>
<td></td>
</tr>
<tr>
<td>Text_list_A</td>
<td>E</td>
<td>Information E</td>
<td>Information E_en</td>
<td></td>
</tr>
<tr>
<td>Text_list_A</td>
<td>F</td>
<td>Information F</td>
<td>Information F_en</td>
<td></td>
</tr>
<tr>
<td>AlarmGroup</td>
<td>2</td>
<td>Warnung 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AlarmGroup</td>
<td>1</td>
<td>Warnung 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GlobalTextList</td>
<td></td>
<td>Information B</td>
<td>Information B_en</td>
<td></td>
</tr>
<tr>
<td>GlobalTextList</td>
<td></td>
<td>Information A</td>
<td>Information A_en</td>
<td></td>
</tr>
<tr>
<td>GlobalTextList</td>
<td></td>
<td>Umschalten</td>
<td>Switch</td>
<td></td>
</tr>
<tr>
<td>GlobalTextList</td>
<td></td>
<td>Zähler: %i</td>
<td>Counter : %i</td>
<td></td>
</tr>
</tbody>
</table>

### Preparing the Exported File for the Input Assistant

- **Requirement:** A file is created (example: `Text_lists_exported`) by means of the "Import/Export Text Lists" command. It contains the texts of the text lists of the project.

1. Click "Tools ➔ Options", "Visualization" category, "File Options" tab.
2. In "Text file for textual "List components"", click ![Select file icon](select_file_icon.png) and select a file (example: `Text_lists_exported`). Click "OK" to exit the dialog.

   ![Text file selection dialog](selection_dialog.png)

   - When you specify a static text in the "Texts" property for an element in a visualization, CODESYS offers the source text of the file as input assistance when typing in the first letter.

### Importing files with text list entries

A file to be imported has the .csv format. The first line is a header (example: `TextList Id Default en_US`). The other lines contain text list entries. You get this kind of file by exporting the text lists of the project to a file. There you can edit the text list entries and then import the file outside of CODESYS. When importing, CODESYS handles the text list entries differently for the `GlobalTextList` and for dynamic text lists.

- **GlobalTextList**
  - CODESYS does not create new text list entries for an unknown ID.
  - CODESYS ignores changes that affect the ID or the source text.
  - CODESYS accepts changes in the translations.

- **Text List**
  - For a new ID, CODESYS supplements the corresponding text list with a text list entry.
  - For an existing ID which does not match in the source text, the source text of the text list is overwritten with the source text of the file.
  - CODESYS accepts changes in the translations.
Importing a file

Requirement: A project is open with a text list or global text.
1. Double-click the “GlobalTextList” object or a “TextList” object type.
   ⇒ The object opens.
2. Click “Text List ➔ Import/Export Text Lists”.
   ⇒ The “Import/Export” dialog opens.
3. In the “Choose file to compare or to import” input field, click ... and select the directory and file.
   Example: Text_lists_corrected.csv
4. Select the “Import” option.
5. Click “OK” to exit the dialog.
   ⇒ CODESYS imports the text list entries of the file into the respective text lists.

Example

Contents of the file Text_lists_corrected.csv

<table>
<thead>
<tr>
<th>TextList</th>
<th>Id</th>
<th>Default</th>
<th>en_US</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text_list_A</td>
<td>A</td>
<td>Information A</td>
<td>Information A2 en</td>
</tr>
<tr>
<td>Text_list_A</td>
<td>B</td>
<td>Information B: OK</td>
<td>Information B_en: OK</td>
</tr>
<tr>
<td>Text_list_A</td>
<td>C</td>
<td>Information C</td>
<td>Information C_en</td>
</tr>
<tr>
<td>Text_list_A</td>
<td>D</td>
<td>Information D</td>
<td>Information D_en</td>
</tr>
<tr>
<td>Text_list_A</td>
<td>E</td>
<td>Information E</td>
<td>Information E_en</td>
</tr>
<tr>
<td>Text_list_A</td>
<td>F</td>
<td>Information F</td>
<td>Information F_en</td>
</tr>
<tr>
<td>Text_list_A</td>
<td>G</td>
<td>Information G</td>
<td>Information G_en</td>
</tr>
<tr>
<td>AlarmGroup</td>
<td>2</td>
<td>Warnung 2</td>
<td></td>
</tr>
<tr>
<td>AlarmGroup</td>
<td>1</td>
<td>Warnung 1</td>
<td></td>
</tr>
<tr>
<td>GlobalTextList</td>
<td></td>
<td>Information B</td>
<td>Information B_en</td>
</tr>
<tr>
<td>GlobalTextList</td>
<td></td>
<td>Information A</td>
<td>Information A_en</td>
</tr>
<tr>
<td>GlobalTextList</td>
<td></td>
<td>Umschalten</td>
<td>Switch</td>
</tr>
<tr>
<td>GlobalTextList</td>
<td></td>
<td>Zähler: %i</td>
<td>Counter : %i</td>
</tr>
</tbody>
</table>

These contents are applied to the text lists with the same name in the project.

For more information, see: Import/Export Text Lists

Comparing text lists with a file and exporting differences

Requirement: A project is open with a text list or global text.
1. Double-click the “GlobalTextList” object or a “TextList” object type.
   ⇒ The object opens.
2. In the context menu, click “Text List ➔ Import/Export Text Lists”.
   ⇒ The “Import/Export” dialog opens.
3. In the “Choose file to compare or to import” input field, click ... and select the directory and file name of the comparison file (example: Text_lists_corrected.csv).
4. For “Choose export file”, click ... and select the directory and file which contains the comparison result.
5. Select the “Export only text differences” option.
6. Click “OK” to exit the dialog.
   ⇒ CODESYS reads the import file and compares the text list entries that have the same ID. If they do not match, then CODESYS writes the text list entries of the text list to the export file.
   For the global text list, CODESYS compares the translations of the same source texts. If they do not match, then CODESYS writes the text list entries to the export file.
6.4.6.2.3 Using static text in GlobalTextList

The global text list is the central location for texts that are displayed in the visualization. When you configure a text for the first time in visualization element, CODESYS creates the global text list. CODESYS fills in the table as you create more texts. Therefore, the table includes all texts automatically that you create in the project visualizations. CODESYS assigns incremental IDs as integers, beginning at 0.

You can check, update, and align the global text list with the static texts of the visualization. You cannot edit the source text or the ID directly in the table. However, you can replace a source text with another source text by creating and importing a replacement file. Menu commands are provided for this purpose.

Configuring visualization elements with static text

A text in a "GlobalTextList" can contain a format definition.

- Requirement: A project with a visualization is open. The "GlobalTextList" object contains the texts that are defined in the project visualizations.

1. Double-click the visualization.
   - The editor opens.
2. Select an element with the "Text" property (example: "Text Field").
3. Type in some text in the "Text" property (example: Static Information A).

   CODESYS adds the text to the global text list in the POU view.

Checking GlobalTextList

- Requirement: A project with a visualization is open. The "GlobalTextList" object contains the texts that are defined in the project visualizations.

1. Double-click the "GlobalTextList" object in the POUs tree.
   - The table opens with the static texts.
2. Click "Text List ➔ Visualization Text IDs".

   CODESYS reports when a source text of the text list does not match the static text that is identified by the ID. The source text in the global text list and the text in the visualization with the same ID do not match.

Updating IDs in GlobalTextList

- Requirement: A project with a visualization is open. The "GlobalTextList" object contains the texts that are defined in the project visualizations.

1. In the POU tree, double-click the "GlobalTextList" object.
   - The list opens with the text list entries.
2. Click "Text List ➔ Update Visualization Text IDs".

   CODESYS adds text to the global text list when a text in the "Static Text" property does not match the source text in the project visualizations.
Removing GlobalTextList and creating current IDs again

☐ Requirement: A project with a visualization is open. The “GlobalTextList” object contains the texts that are defined in the project visualizations.

1. Right-click the “GlobalTextList” object in the POUs tree and select the “Delete” command.
   ⇒ The object is removed.
2. Open a visualization.
3. Click “Visualization ➔ Create Global Text List”.
   ⇒ In the POU view, a new “GlobalTextList” object is created. The global text list contains the static text from the existing project visualizations.

Removing IDs from GlobalTextList

☐ Requirement: A project with a visualization is open. The “GlobalTextList” object contains the texts that were defined in the project visualizations.

1. Double-click the “GlobalTextList” object in the POUs tree.
   ⇒ The table opens with the texts.
2. Click “Text List ➔ Remove Unused Text List Entries”.
   ⇒ CODESYS removes the text list entries with IDs not referenced in the project visualizations.

Editing GlobalTextList with a replacement file

A replacement file has the CSV format. The first row is a header: defaultold defaultnew REPLACE. The following rows contain the old source texts, the new source texts, and then the REPLACE command. Tabs, commas, and semicolons are permitted separators. A combination of separator characters in a file is not permitted.

Example (tab as separator character)

<table>
<thead>
<tr>
<th>defaultold</th>
<th>defaultnew</th>
<th>REPLACE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information A</td>
<td>Information A1</td>
<td>REPLACE</td>
</tr>
</tbody>
</table>

When you import a replacement file, CODESYS processes the replacement file row by row and performs the specified replacements in the “GlobalTextList”. In addition, CODESYS replaces the previous text with the replacement text in the visualizations. If the replacement text already exists as static text, then CODESYS recognizes this and harmonizes the static text and leaves only one text list entry.

☐ Requirement: A project is open with a text list or global text.

1. Double-click the “GlobalTextList” object.
   ⇒ The object opens.
2. Click “Text List ➔ Import/Export Text Lists”.
   ⇒ The “Import/Export” dialog opens.
3. At the “Choose file to compare or to import” input field, click and select the directory and file (example: ReplaceGlobalTextList.csv).
4. Select the “Import replacement file” option.
5. Click “OK” to exit the dialog.
   ⇒ The texts in the text lists and the visualizations are replaced.
Example

The global text list contains the following source texts:

- GlobalTextList
- Counter: %i
- Zähler: %i
- Information A
- Information a
- Information Aa
- Umschalten

The replacement file contains the following replacements:

- defaultalt
- defaultneu
- Counter: %i
- Counter2: %i
- Zähler: %i
- Counter2: %i
- Information A
- Information A
- Information A
- Information A
- Information A
- Information A
- Umschalten
- Switch2

CODESYS detects duplicate text list entries and removes them. Afterwards, the global text list contains the following source texts:

The texts in the visualization have been replaced.

6.4.6.2.4 Creating Text in Text Lists and Displaying Dynamically

You can create and translate texts in a text list for dynamic texts in order to display them dynamically in a visualization or in the alarm management. The object of type "Text list" can be located globally in the POU view or below an application in the device tree. It contains a table with text list entries that you can edit and extend. A text list entry consists of an ID for identification, the output text, and its translation. You can add new text list entries to a text list. Menu commands are provided for this purpose.

Creating text lists for dynamic text display

Requirement: A project with a visualization is open.

1. Select an application in the POU view or device tree and click “Project ➔ Add Object”.
2. Select “Text List”.

...
3. Type a name (example: Text_List_A). Click “Add” to exit the dialog.
   ⇒ A Text List type object is created.

4. Click below the “Default” column and open the input field. Type a text (example: Information).
   ⇒ The source text is created. It is used as a key in the table and as a source text for translations.

5. Type any string in the “ID” column (example: A).
   ⇒ A text list entry is defined with source text and ID. When you configure the “Dynamic texts” property of an element in a visualization, you can select the text list Text_List_A and assign the ID A.

6. Double-click in the blank line at the end of the table below “Default” and type in more text list entries.
   ⇒

Dynamically Displaying a Text

In a visualization, you can configure the dynamic output of texts which were created in a text list by configuring the “Dynamic texts” property of an element. You can directly assign a text list and an ID, as well as IEC variables, where you set the values programmatically.

- Requirement: A project with visualization is open and a text list is in the device tree.
- 1. Open the text list (example: Text_List_A).
- 2. Double-click the visualization.
   ⇒ The editor opens.
- 3. Drag an element (example: “Rectangle”) to the visualization.
- 4. Configure its “Dynamic texts” property by selecting one in the “Text list” property (example: 'Text_List_A') and add an ID from the text list into the “Text index” (example: 'A').

Pay attention to the single straight quotation marks. You can also assign an IEC variable of type STRING for the text list name and ID.

- ⇒ The IEC variables allow for programmatic access to the texts of the text lists.
- 5. Build the application, download it to the controller, and start it.
   ⇒ The visualization shows the text from the text list in the text field: Information A.

6.4.6.2.5 Displaying a text dynamically

You can define a text in “Texts ➔ Text” in order to display it statically. A text in “Texts ➔ Tooltip” is shown as a tooltip. You can configure the text in such a way that the contents of a variable are displayed with it.
You can expand a static text by exactly one placeholder with a formatting specification in order to display the contents of a variable at this location at runtime. The variable which you have assigned in the “Text variable” property is displayed. When the variable changes in the application code, its display in the visualization changes at the same time.

☐ Requirement: A project with a visualization is open.

1. Open the visualization and add a “Text Field” element.
   - The “Properties” view shows the configuration of the element.

2. Configure the “Texts → Text” property with File name: %s.
   - The text contains the %s placeholder.

3. In the application in the PLC_PRG POU, declare a type-compliant variable
   strFileName : STRING := 'File_A';

4. Configure the “Text variable” property of the button with PLC_PRG.strFileName.
   - The contents of the variable will be displayed instead of the placeholder at runtime.

5. Compile, download, and start the application.
   - The application runs. The visualization opens. The element displays the text: File name: File_A

A text entered in the “Texts → Text” or “Texts → Tooltip” visualization property is automatically entered in GlobalTextList under POU’s. There you can translate the text into other languages.

For more information see: ☑ Using static text in GlobalTextList

6.4.6.3 Reference
6.4.6.3.1 Objects
Object: ImagePool

The “ImagePool” object contains a table with image ID assignments.

For more information, see: ☑ Using an Image Pool

<table>
<thead>
<tr>
<th>“ID”</th>
<th>ID of the image</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>You reference this ID, for example in the visualization of the image.</td>
</tr>
<tr>
<td>“File name”</td>
<td>File path of the image file</td>
</tr>
<tr>
<td></td>
<td>When you click the button for more settings, the “Select Image” dialog opens.</td>
</tr>
<tr>
<td>“Image”</td>
<td>Show a thumbnail of the image</td>
</tr>
<tr>
<td>“Link Type”</td>
<td>Opens the “Select Image” dialog</td>
</tr>
<tr>
<td></td>
<td>In the dialog, you define the type of link.</td>
</tr>
</tbody>
</table>
Dialog: Select Image

<table>
<thead>
<tr>
<th>Image file</th>
<th>Name and directory of the image file (example: &quot;C:\Program Files\images\logo.bmp&quot;)</th>
</tr>
</thead>
</table>

In CODESYS, the following image formats are supported: BMP, EMF, GIF, ICO, JPG, PNG, SVG, and TIFF. Note that a controller might not support all formats.

Whether or not you can use images formatted as scalable vector graphics (*.svg) depends on the operating system. Any necessary information is located in the device description of the hardware vendor.

Hint: It is recommended to use only images in SVG format where the aspect ratio of width to height corresponds to the aspect ratio of the view box value. Otherwise an unexpected display might result.

Table 737: File Handling

<table>
<thead>
<tr>
<th>Remember the link</th>
<th>Only the link is saved. This automatically updates a change to the image file in the image pool. You need to make sure that the path of the image file does not change. When saving the project as a project archive, the image file is embedded into the project archive.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Remember the link and embed into project</th>
<th>The image in the image pool is copied, but the link information is retained. This makes it possible to detect changes to the image file so that, if necessary, an update of the image can be made in the image pool. The behavior is controlled with the options in the next table. Note: Embedded image files increase the memory requirement of the project.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Embed into project</th>
<th>The image is added to the image pool. If the image file is changed again afterwards, then it is not updated in the project. For libraries, you need to embed the image into the project. Note: Embedded image files increase the memory requirement of the project.</th>
</tr>
</thead>
</table>

Table 738: Change Tracking

These options are available only if you have selected the “Remember the link and embed into project” option as described above.

<table>
<thead>
<tr>
<th>Reload the file automatically</th>
<th>The image file is automatically updated in the project without any prompts.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Prompt whether to reload the file</th>
<th>If the image file has changed, then you may be prompted whether or not the image file should be updated.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Do nothing</th>
<th>The image file in the image pool is not updated.</th>
</tr>
</thead>
</table>

Object: GlobalTextList

Symbol: 📝

The object is used to manage and translate texts which are composed as static text in visualizations in the project. The object contains a table with these texts. When you compose a text in a visualization in an element in the “Texts” property, CODESYS automatically adds a line in the table. You can only edit existing text here, not compose any new text.

For more information, see: Using a Text List, Text List
Moreover, CODESYS provides the following commands in order to consolidate the “GlobalTextList”:

- “Check Visualization Text IDs”
- “Update Visualization Text IDs”
- “Remove Unused Text List Entries”

The object is located in the POU view and exists at most one time.

<table>
<thead>
<tr>
<th>“ID”</th>
<th>Unique identifier of the text</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Default”</td>
<td>Source text as string with one formatting specification at the most (example: Information A: %i options) If a translation is not provided below a language column, then the default text is used. Double-click in the field to edit the text.</td>
</tr>
</tbody>
</table>

You can add as many language columns to the table as you want. A language column is named with a language code which you already specified when creating the column with the “Insert Language” command.

| “<language code>” | Name of the language as a language code (example: en-US) This column contains the translation of the text that is made in “Default”. When the language code is selected as a language in the Visualization Manager, a visualization displays the translation when it is run. A running visualization can toggle between languages at the request of a user. Double-click in the field to edit the text. |

Object: Text List
Symbol: 📖

The object is used to create, manage, and translate texts. It contains a table with texts where you can add new texts. You can select a text which you have composed here can be selected in a visualization in the “Dynamic texts” property of an element. In runtime mode, the visualization displays this text dynamically in the selected language.

For more information, see: ✍ Using a Text List

When the object is assigned to an alarm group and is located below the “Alarm Configuration” object, CODESYS adds the texts of the alarm group to the table. You can also add texts.

<table>
<thead>
<tr>
<th>“ID”</th>
<th>Unique identifier of the text</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Default”</td>
<td>Source text as string (example: Information A: %i options). Use the [Ctrl] + [Enter] shortcut to add a line break. Double-click in the field to edit the text.</td>
</tr>
</tbody>
</table>
You can add as many language columns to the table as you want. A language column is named with a language code which you already specified when creating the column with the "Insert Language" command.

<table>
<thead>
<tr>
<th><code>&lt;language code&gt;</code></th>
<th>Name of the language as a language code. Example: en-US. This column contains the translation of the text which is composed in &quot;Default&quot;. Under the condition that the language code is selected as the language in the Visualization Manager, a visualization displays the translated text in runtime mode. If a translation has not been composed, then CODESYS uses the text in &quot;Default&quot;. A visualization in runtime mode can also change the language if requested by a user.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blank line</td>
<td>Edit the line to add your own text.</td>
</tr>
</tbody>
</table>

### 6.4.6.3.2 Menu Commands

**Image Pool**

**Command: Insert Image**

Symbol: ![Image Pool](image)

**Function:** The command inserts a new line into an image pool.

**Call:** "Image Pool" menu; context menu

**Requirements:** An image pool is active and a line is selected in the image pool.

For more information, see: Using an Image Pool

**Text List**

**Command: Add Language**

Symbol: ![Language Addition](language)

**Function:** Another language column is added to the text list.

**Call:** "Text List" menu; context menu

**Requirement:** A text list or global text list is open and active.

In the "Choose Language" dialog, specify a language abbreviation for the new language (example: "en-US"). This language code is then inserted as a column heading.

**Command: Create Global Text List**

Symbol: ![Global Text List](global)

**Function:** The GlobalTextList global text list is created in the "POUs" view.

**Call:** "Visualization" menu; context menu

**Requirement:** A visualization is open.

For more information, see: GlobalTextList
Command: Export All Unicode .txt Text List Files

Symbol: 📁

Function: All text lists of the project are exported.

Call: “Text List” menu; context menu

Requirements:
- A text list or global text list is open and active.
- The visualization encodes the characters of the texts into Unicode.
  - The “Use unicode strings” option is selected in the Visualization Manager.
  - The VISU_USEWSTRING compiler statement of the application is set. To check this, select the “Properties” command in the context menu. Then click the “Build” tab. VISU_USEWSTRING is specified in the input field for “Compiler definitions”.

At this time, a simple text file (.txt format) is created for each text list. The name of the text list is used as the file name. The directory where the files are exported is defined in “Project ➔ Project Settings ➔ Visualization”, on the “General” tab, in “Text list files”.

A controller can read and use this format. You can copy the file to a controller, for example, and configure a setting in the Visualization Manager so that the text lists are not transferred again when the application is downloaded.

For more information, see: % Using a Text List

Command: Insert Text

Symbol: 📄

Function: A new line is inserted above the selected line in the text list. Below “Default”, an input field opens where you specify the output text.

Call: “Text List” menu; context menu

Requirement: A text list (not a “GlobalTextList”) is open and active. A field is selected in the table.

Command: Import/Export Text Lists

Symbol: 📁

Function: The command exports an active text list, imports a file, or aligns a text list with a file. The file is in CSV format. The “Import/Export” dialog provides options for this.

Call: “Text List” menu; context menu

Requirement: A text list or global text list is open and active.

Dialog: Import/Export

<table>
<thead>
<tr>
<th>“Choose file to compare or to import”</th>
<th>File which is read</th>
</tr>
</thead>
<tbody>
<tr>
<td>[⋯⋯] Opens the “Choose Text List File” dialog for you to select a file</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Choose export file”</th>
<th>File to which is written</th>
</tr>
</thead>
<tbody>
<tr>
<td>[⋯⋯] Opens the “Choose Text List File” dialog where you can select a file and directory</td>
<td></td>
</tr>
</tbody>
</table>
## Import/Export Type

| **Import** | Requirement: A file is selected in “Choose file to compare or to import”. The file can contain text list entries for both the global text list and text lists. 

Global text list  
- The file is read. Then the text list entries are compared for the same source text and the differences in the translations are accepted. If necessary, the translations are overwritten in the project. 

Text lists  
- The file is read. Then the text list entries are compared for the same IDs and the differences in the source text and translations are accepted into the project. If necessary, the text list entries in the project are overwritten.  
- If the file contains a new ID, then the text list entry is imported into the text list of the project and the text list is added. |
| **Import replacement file** | Requirement: A replacement file is selected in “Choose file to compare or to import”. The replacement file contains replacements for the global text list. The replacement file is processed row by row and the specified replacements are performed in the global text list. The structure of the replacement file is described in the "Using static text in GlobalText-List" chapter. |
| **Export** | Requirement: The file which will be written to is selected in “Select export file”. All texts from all text lists of the current project are exported. All languages available in the project are inserted as columns in the export file. The file can be used for the external translation of the language-dependent texts. |
| **Export only text differences** | Requirement: An import file is selected for the comparison in “Choose file to compare or to import”, and an export file to be written to is selected in “Select export file”. The import file is read and the lines of the active text list are compared with it. When lines match, they are ignored. When lines differ, the line is written to the export file. Translations from the text list are accepted if necessary. The translations from the import file are accepted and overwritten if necessary. |
| **Use qualified path** | Text lists are exported and imported with full and qualified path name. Example: Device.Application.TextList 
As a result, text lists are found uniquely, even if they occur multiple times in the project with the same name. |

For more information, see: "Using a Text List"

---

**Command: Remove Language**

**Symbol:** 💥

**Function:** The selected language column is removed from the text list.

**Call:** “Text List” menu; context menu

**Requirement:** A text list or global text list is open and active. A field is selected in the language column which you want to remove.

For more information, see: "Using a Text List"
**Command: Rename Language**

Symbol: 🔄

**Function:** A dialog opens for specifying a new name for a language which is displayed in the text list as a column heading.

**Call:** “Text List” menu; context menu

**Requirement:** A text list or global text list is open and active. A field is selected in the language column which you want to rename.

For more information, see: Using a Text List

**Command: Remove Unused Text List Entries**

Symbol: 🗑

**Function:** The command checks whether or not a text list entry in the project is used as a static text. If this is the case, then the text list entry is removed from the text list.

**Call:** “Text List” menu; context menu

**Requirement:** The “GlobalTextList” is open and active. A field is selected in the table.

For more information, see: Using a Text List

**Command: Check Visualization Text IDs**

Symbol: 🔍

**Function:** The command checks whether or not the ID of a text list entry in the project is correct and reports the result.

**Call:** “Text List” menu; context menu

**Requirement:** The “GlobalTextList” is open and active. A field is selected in the table.

If the check determines that the global text list and the static texts of the visualizations do not match, then the reason for this may be that the global text list is or was write-protected. The requirement for this is that you have configured a user management in the project.

For more information, see: Using a Text List

**Command: Update Visualization Text IDs**

Symbol: ✅

**Function:** The command updates all inconsistent IDs in a static text list.

**Call:** “Text List” menu; context menu

**Requirement:** The “GlobalTextList” is open and active. A field is selected in the table. The object is write-protected.

If the check determines that the global text list and the static texts of the visualizations do not match, then the reason for this may be that the global text list is or was write-protected. The requirement for this is that you have configured a user management in the project.

For more information, see: Using a Text List

**Command: Remove text list support**

Symbol: ✖

**Function:** The text list support from the selected enumeration object is removed.
**Call:** Context menu of an object of an enumeration with text list support

Text list support allows for the localization of the enumeration component identifier and the display of the symbolic component value in a text display of a visualization.

**Command: Add text list support**

Symbol: 

**Function:** A text list support is added to the selected DUT object of type `Enumeration`.

**Call:** Context menu of a standard DUT object of type `Enumeration`

Text list support allows for the localization of the enumeration component identifier and the display of the symbolic component value in a text display of a visualization.

### 6.4.6.3.3 Dialogs

#### Dialog: Properties – Image Pool

**Function:** The basic properties of the selected image pool are set here.

**Call:** “View ➔ Properties” command of an “ImagePool” object; context menu of an “ImagePool” object

<table>
<thead>
<tr>
<th>“Download only used images”</th>
<th>✅: Instead of loading all images from the image pool, only the images which are actually used in the application are downloaded to the controller.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Download by visualization”</td>
<td>✅: The image pool is downloaded with the visualization to the controller.</td>
</tr>
<tr>
<td>“Internal”</td>
<td>✅: The image pool is not provided in the “ToolBox” view. You cannot drag these images to the visualization.</td>
</tr>
</tbody>
</table>

**Table 740: “Symbol Library Settings”**

<table>
<thead>
<tr>
<th>“Mark library as symbol library”</th>
<th>Identifies the image pool as a symbol library for use in a visualization</th>
</tr>
</thead>
<tbody>
<tr>
<td>The symbol library gets the <code>VisuSymbolLibrary = TRUE</code> key as a file property in the project information. The <code>VisuElements</code> library is automatically inserted as a placeholder library in the “POUs” pool of the Library Manager.</td>
<td></td>
</tr>
<tr>
<td>Requirement: A library project is open.</td>
<td></td>
</tr>
<tr>
<td>The symbol libraries installed in the repository under “Project Settings”, “Visualization” category, “Symbol Libraries” tab are displayed.</td>
<td></td>
</tr>
</tbody>
</table>

| “Text list for symbol translation” | Select the text list from the list box which contains the translated texts for the image pool. |

For more information, see: Using an Image Pool and Using a Text List

#### Dialog: Properties – Text List

**Function:** The basic properties of the selected text list are set here.

**Call:** “View ➔ Properties” command of a “Text List” object; context menu of a “Text List” object
<table>
<thead>
<tr>
<th>&quot;Download by visualization&quot;</th>
<th>The text list is downloaded with the visualization to the controller.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Internal&quot;</td>
<td>The text list can be used only in a library. It is not available in an ordinary CODESYS project.</td>
</tr>
</tbody>
</table>

For more information, see: "Using a Text List"
6.5 Libraries and solutions

6.5.1 Information on libraries

AC500 V3 library handling with CODESYS V3 is different from the library handling with CODESYS V2. In AC500 V3 a coexistence of library versions in the library manager is possible and users can change a version within the project. How to install a new library and how to choose a library version in the project is described in the application note Add New Library Version To an AC500 V3 Project.

System libraries

When upgrading Automation Builder or an existing project, new AC500 V2 system libraries are installed automatically. Older library versions will be removed as coexistence of a new library version and an older library version is not possible. Check the available library version in the Library Manager.

```
Usually, when upgrading Automation Builder or an existing project, new AC500 V2 system libraries are installed automatically and older library versions are removed.

As an exception, for the CANopen device CM598-CN both library versions are available in the Library Manager due to compatibility reasons. However, coexistence of a new library version and an older library version is not possible. In order to avoid compile errors remove the older library version.

Chapter 6.3.7 “Converting an AC500 V2 project to an AC500 V3 project” on page 1799
```

Part of the system libraries are the group of CMP libraries, i.e. the App library, IEC task library and the log library. How to use CMP libraries is described in an application example.

Customer libraries

Target change from AC500 V2 to AC500 V3

After a target change from AC500 V2 to AC500 V3 the customer libraries have to be converted manually using the Library Converter Chapter 6.3.1.3 “Later change-over of a target system” on page 1414.

Some Standard CODESYS libraries are automatically converted during the target change.

Documentation for libraries

- Description for the use of and information about selected libraries.
- Reference for function blocks, functions, structures etc.

Chapter 6.5.14 “Reference, function blocks” on page 4086

6.5.2 Reference to CODESYS (V3)

Note that CODESYS V3 libraries are used.

Chapter 6.4.1.17.3 “Information for Library Developers” on page 2035

6.5.3 Library Manager functionality

6.5.3.1 General

The Library Manager contains descriptions of libraries and function blocks.

In the Automation Builder the Library Manager is located under the node “Application”.
The Library Manager offers a wide array of functionality for the user.

**Use cases and how to handle the function blocks of a certain library is described in sample projects. After the respective library has been installed the corresponding sample projects are available in the default path AutomationBuilder Examples. If the default path is inaccessible, click “Help ➔ Project examples” in the Automation Builder menu.**

### StringUtils library

With the help of the StringUtils library, strings in the AC500 PLC application can be handled and modified. How to use the available functions is demonstrated in the application example **StringUtils library**.

#### 6.5.3.2 Search for libraries and add libraries

In the Library Manager the search function allows you to quickly find any library, user defined library or function.
1. Select “Add Library”.

   ![Add Library Window](image)

   The Add Library Window opens and a list of all available libraries is displayed.

   Libraries in folder “ABB - AC500” are created by ABB and tested in combination with Automation Builder.

   We recommend to use libraries of subfolder “Use Cases” for your project.

   Libraries in subfolder “Intern” are necessary for internal procedures.

   All 3S libraries distributed with Automation Builder are required by ABB libraries and have been tested in combination with AC500 and Automation Builder. Additional 3S libraries that are not distributed with Automation Builder can easily be added. There are no known major issues with using them, however, be aware that they are not tested by ABB.

2. Enter the name of the library or function you are searching for.

3. Choose the library you want to add.

### 6.5.3.3 View embedded documentation of all libraries

In the Library Manager you can view embedded documentation of any ABB and 3S libraries.

Precondition: Library must be available in Library Manager.

☞ Chapter 6.5.3.2 “Search for libraries and add libraries” on page 3774
1. Select a library.
   - The contents of the library are shown.

2. From the contents select an object.
   - The corresponding documentation is opened.

6.5.3.4 **Access version history**

The Library Manager allows you to access the version history of ABB libraries.

The version history is not available for non ABB libraries.
1. Select a library.
   - The contents of the library are shown.

2. Select “history”.
   - The version history is shown.

### 6.5.3.5 Download missing libraries

The Library Manager allows you to automatically download missing 3S libraries from the project that are not available from the library repository.

1. Select “Download missing libraries”.
   - The 'Download missing libraries' window is opened.
2. Select which libraries you want to download.
6.5.4 ACS/DCS drives libraries

6.5.4.1 Introduction

6.5.4.1.1 Scope of the document

The purpose of system technology document is to give an overview and explain the overall concepts of the Drives library in V3. The library contains function blocks to establish communication, to control the ABB ACS / DCS drives from AC500 V3 PLCs.

6.5.4.1.2 Safety instructions and preconditions to use drives library

The user has to read the following instructions and documents before using the libraries:

- All pertinent state, regional, and local safety regulations must be observed when installing and using this product. When functions or devices are used for applications with technical safety requirements, the relevant instructions must be followed.
- Read the complete safety instructions of the user’s manuals for the devices you are using, before installation and commissioning.
- Read all safety instructions of the AC500 PLC. See System description AC500 in the online help in Automation Builder.
- Read the user information of the devices and functions you are using, see online help in Automation Builder.
- Installation and commissioning of the drive(s) is not part of this document nor the online help of Automation Builder. Installation and commissioning of the drive(s) must be done according to the related drives manuals and safety instructions.

The library package has been released for the software and firmware versions listed in the readme file of the package only.

In no event will ABB or its representatives be liable for loss of data, profits, revenue or consequential, incidental or other damage that may result from the use of other versions of product, software or firmware versions. The error-free operation of the Drives V3 Library with other devices, software or firmware versions should be possible but cannot be guaranteed and may need adaptations e.g. of example programs.

The user must follow all applicable safety instructions and the guidelines mentioned in the user documents of the ABB products.

Read the complete safety instructions for the AC500 before installation and commissioning.

CAUTION!

Generally, the user in all applications is fully and alone responsible for checking all functions carefully, especially for safe and reliable operation.

The function blocks contained in the library can only be executed in RUN mode of the PLC, but not in simulation mode.

6.5.4.1.3 Comparison of V2 and V3 drives library

The below table compares the FBs in the V2 library package and corresponding adapted FBs in the V3 library package.

The V2 package (PS553-Drives) has different library files for each protocol and the same is replaced with a single library in V3 (ABB_Drives_AC500).
<table>
<thead>
<tr>
<th>Library Name</th>
<th>Function Block</th>
<th>Library</th>
<th>Function Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACSDrives-Base_AC500_V2</td>
<td>ACS3XX_DRIVES_CTRL_BASIC</td>
<td>Not supported – use DrvControlModbusACS</td>
<td>ACS3XX_COM_MOD_RTU</td>
</tr>
<tr>
<td></td>
<td>ACS_DRIVES_CTRL_EN G</td>
<td>ABB_Drives_AC500</td>
<td>ABB_Drives_AC500</td>
</tr>
<tr>
<td></td>
<td>ACS_DRIVES_CTRL_STA NDARD</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ACS_DRIVES_CTRL_STA NDARD_GEN</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ACS_MOD_READ_N_PR M</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ACS_MOD_WRITE_N_PR M</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ACS_REF_SCALING</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ACSDrivesCom-ModRTU_AC500_V20</td>
<td>ACS3XX_COM_MOD_RTU</td>
<td>Not supported</td>
<td>ACS_COM_MOD_RTU</td>
</tr>
<tr>
<td></td>
<td>ACS_COM_MOD_RTU_E NHANCED</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ACS_COM_MOD_RTU_G EN</td>
<td>ABB_ModbusRtu_AC500</td>
<td>ABB_ModbusRtu_AC500</td>
</tr>
<tr>
<td></td>
<td>ACS_COM_MOD_RTU_G EN_READ_N_PRM</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ACS_COM_MOD_RTU_G EN_WRITE_N_PRM</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ACS_PN_WRITE_N_PRM _DPV1</td>
<td>ABB_Drives_AC500</td>
<td>ABB_Drives_AC500</td>
</tr>
<tr>
<td></td>
<td>ACS_PN_READ_N_PRM _DPV1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ACS_PB_READ_N_PRM _DPV1</td>
<td>Will be supported in next Release</td>
<td>ACS_PB_READ_N_PRM _DPV1</td>
</tr>
<tr>
<td></td>
<td>ACS_PB_WRITE_N_PRM _DPV1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ACS_COM_PB</td>
<td>Not supported</td>
<td>ACS_COM_PB</td>
</tr>
<tr>
<td></td>
<td>ACS_COM_PB_PZD</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ACS_PB_READ_PRM_DP V0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
6.5.4.1.4 PLCs and drives: communication and control

General

This document will briefly explain about communication settings between PLCs with drives, how to control the drives from PLC using the control function blocks.

Each input and output of the function blocks are explained in the integrated documentation in the library.

This library is released for the following products:
- AC500 V3 CPU
- ABB Drives:
  - ACS380, ACS480, ACS580, ACH580, ACQ580, AC5M1, ACS880, DCS550, DCS800, DCS880. Other drives may still work, but are not tested.
  - To use the control blocks the Communication Profile must be “ABB Drives Profile” or “ABB Drives Profile enhanced”
- Fieldbus Adapters: FENA-01, FENA-11, FENA-21, FSCA-01, FCAN-01, FECA-01, RETA-01, RETA-02, RCAN-01, FPNO-21, FMBT-21. Fieldbus adapter support is dependent on the drive and for more details refer the corresponding drive manual.

Drives Library in V3 will support following protocols for the communication:
- Modbus TCP (onboard ETH1 and ETH2 ports)
- Modbus RTU (onboard COM1 port)
- PROFINET (using communication module CM579-PNIO)
- EtherCAT (using communication module CM579-ETHCAT)
- CANopen (onboard CAN port)

Modbus TCP

Preconditions

The following hardware components must be available:
- AC500 V3 PLC with ETH option. Configure onboard ETH1 or ETH2 for Modbus TCP.
- Drive with fieldbus adapter module
  - ACS Drives and DCS880: FENA-01 or FENA-11 or FENA-21 or FMBT-21
  - DCS550 and DCS800: RETA-01
- RJ45 Ethernet cable
ACS drives

Fig. 274: FB - Overview of Modbus TCP connection with ACS drives

To exchange only status word, actual speed, control word and speed reference:
- Communication profile in drive parameters: ABB Drives classic
- Communication function block in AC500 program:
  - Use function block ‘DrvModbusTcp’. ղ Chapter 6.5.4.4.1.8 “DrvModbusTcp” on page 3805
- DrvModbusTcp
- Control function block in AC500 program:
  - Use function block ‘DrvControlModbusACS’. ղ Chapter 6.5.4.4.1.4 “DrvControlModbusACS” on page 3801
- Scaling of the speed or torque (optional):
  - Use function block ‘DrvScaling’. ղ Chapter 6.5.4.4.1.1 “DrvScaling” on page 3796

To exchange status word, actual value1 (speed), actual value2 (torque), control word, reference1 (speed), reference value2 (torque) and up to 12 more values read from drive and up to 12 more values write to the drive:
- Communication profile in drive parameters: ABB Drives enhanced
- Communication function block in AC500 program:
  - Use the function block ‘DrvModbusTcp’ with input EnhancedProfile = TRUE. ղ Chapter 6.5.4.4.1.8 “DrvModbusTcp” on page 3805
- DrvModbusTcp
- Control function block in AC500 program:
  - Use function block ‘DrvControlModbusACS’. ղ Chapter 6.5.4.4.1.4 “DrvControlModbusACS” on page 3801
- Scaling of the speed or torque (optional): Use function block ‘DrvScaling’. ղ Chapter 6.5.4.4.1.1 “DrvScaling” on page 3796
To exchange more than above mentioned values use additionally the following blocks:

- **Read the values:**
  Use the function block ‘DrvModbusRead’. \(\text{\textcopyright}\) Chapter 6.5.4.4.1.6 “DrvModbusRead” on page 3804

- **Write the values:**
  Use the function block ‘DrvModbusWrite’. \(\text{\textcopyright}\) Chapter 6.5.4.4.1.7 “DrvModbusWrite” on page 3805

- **Read Write the values:**
  Use the function block ‘DrvModbusReadWrite23’. \(\text{\textcopyright}\) Chapter 6.5.4.4.1.11 “DrvModbusRead-Write23” on page 3825

### DCS drives

![DCS drives diagram](image)

*Fig. 275: FB - Overview of Modbus TCP connection with DCS drives*

### DCS550 and DCS800 drives

To exchange only status word, actual speed, control word and speed reference:

- **Communication function block in AC500 program:**
  Use function block “DrvModbusTcp”. \(\text{\textcopyright}\) Chapter 6.5.4.4.1.8 “DrvModbusTcp” on page 3805

- **“DrvModbusTcp”**

- **Control function block in AC500 program:**
  Use function block “DrvControlModbusDCS”. \(\text{\textcopyright}\) Chapter 6.5.4.4.1.5 “DrvControlModbusDCS” on page 3803

- **Scaling of the speed or torque (optional):**
  Use function block “DrvScaling”. \(\text{\textcopyright}\) Chapter 6.5.4.4.1.1 “DrvScaling” on page 3796
To exchange more than above mentioned values use additionally the following blocks:

- **Read the values:**
  Use the function block “DrvModbusRead”. ☞ *Chapter 6.5.4.4.1.6 “DrvModbusRead” on page 3804*

- **Write the values:**
  Use the function block “DrvModbusWrite”. ☞ *Chapter 6.5.4.4.1.7 “DrvModbusWrite” on page 3805*

- **Read write the values:**
  Use the function block “DrvModbusReadWrite23”. ☞ *Chapter 6.5.4.4.1.11 “DrvModbusReadWrite23” on page 3825*

**DCS880 drives**

To exchange only status word, actual speed, control word and speed reference:

- Communication profile in drive parameters: ABB Drives classic
- Communication function block in AC500 program:
  Use function block “DrvModbusTcp”. ☞ *Chapter 6.5.4.4.1.8 “DrvModbusTcp” on page 3805*
- “DrvModbusTcp”
- Control function block in AC500 program:
  Use function block “DrvControlModbusDCS”. ☞ *Chapter 6.5.4.4.1.5 “DrvControlModbusDCS” on page 3803*
- Scaling of the speed or torque (optional):
  Use function block “DrvScaling”. ☞ *Chapter 6.5.4.4.1.1 “DrvScaling” on page 3796*

To exchange status word, actual value1 (speed), actual value2 (torque), control word, reference1 (speed), reference value2 (torque) and up to 12 more values read from drive and up to 12 more values write to the drive:

- Communication profile in drive parameters: ABB drives enhanced
- Communication function block in AC500 program:
  Use the function block “DrvModbusTcp” with input EnhancedProfile = TRUE. ☞ *Chapter 6.5.4.4.1.8 “DrvModbusTcp” on page 3805*
- “DrvModbusTcp”
- Control function block in AC500 program:
  Use function block “DrvControlModbusDCS”. ☞ *Chapter 6.5.4.4.1.5 “DrvControlModbusDCS” on page 3803*
- Scaling of the speed or torque (optional): Use function block “DrvScaling”. ☞ *Chapter 6.5.4.4.1.1 “DrvScaling” on page 3796*

To exchange more than above mentioned values use additionally the following blocks:

- **Read the values:**
  Use the function block “DrvModbusRead”. ☞ *Chapter 6.5.4.4.1.6 “DrvModbusRead” on page 3804*

- **Write the values:**
  Use the function block “DrvModbusWrite”. ☞ *Chapter 6.5.4.4.1.7 “DrvModbusWrite” on page 3805*

- **Read Write the values:**
  Use the function block “DrvModbusReadWrite23”. ☞ *Chapter 6.5.4.4.1.11 “DrvModbusReadWrite23” on page 3825*
Modbus RTU

Preconditions

The following hardware components must be available:

- AC500 V3 PLC. Configure onboard COM1 for the Modbus RTU communication.
- Drive with
  - ACS Drives and DCS880: Embedded fieldbus or FSCA-01
  - DCS550 and DCS800: Embedded fieldbus or RMBA-01
  - Twisted pair serial cable

ACS drives

To exchange only status word, actual speed, control word and speed reference:

- Communication profile in drive parameters: ABB Drives classic
- Communication function block in AC500 program:
  Use function block “DrvModbusRtu”. \(\text{\$ Chapter 6.5.4.4.1.9 "DrvModbusRtu" on page 3812}\)
- DrvModbusRtu
- Control function block in AC500 program:
  Use function block “DrvControlModbusACS”. \(\text{\$ Chapter 6.5.4.4.1.4 “DrvControlModbusACS” on page 3801}\)
- Scaling of the speed or torque (optional):
  Use function block “DrvScaling”. \(\text{\$ Chapter 6.5.4.4.1.1 “DrvScaling” on page 3796}\)
To exchange status word, actual value1 (speed), actual value2 (torque), control word, reference1 (speed), reference value2 (torque) and up to 12 more values read from drive and up to 12 more values write to the drive:

- Communication profile in drive parameters: ABB Drives enhanced
- Communication function block in AC500 program:
  Use the function block “DrvModbusRtu”. Chapter 6.5.4.4.1.9 “DrvModbusRtu” on page 3812
- “DrvModbusRtu”
- Control function block in AC500 program:
  Use function block “DrvControlModbusACS”. Chapter 6.5.4.4.1.4 “DrvControlModbusACS” on page 3801
- Scaling of the speed or torque (optional): Use function block “DrvScaling”. Chapter 6.5.4.4.1.1 “DrvScaling” on page 3796

To exchange more than above mentioned values use additionally the following blocks:

- Read the values:
  Use the function block “DrvModbusRead”. Chapter 6.5.4.4.1.6 “DrvModbusRead” on page 3804
- Write the values:
  Use the function block “DrvModbusWrite”. Chapter 6.5.4.4.1.7 “DrvModbusWrite” on page 3805
- Read Write the values:
  Use the function block “DrvModbusReadWrite23”. Chapter 6.5.4.4.1.11 “DrvModbusReadWrite23” on page 3825

**DCS drives**

![Fig. 277: FB - Overview of Modbus RTU connection with DCS drives](image-url)
To exchange only status word, actual speed, control word and speed reference:

- Communication function block in AC500 program:
  Use function block “DrvModbusRtu”. See Chapter 6.5.4.4.1.9 “DrvModbusRtu” on page 3812
- “DrvModbusRtu”
- Control function block in AC500 program:
  Use function block “DrvControlModbusDCS”. See Chapter 6.5.4.4.1.5 “DrvControlModbusDCS” on page 3803
- Scaling of the speed or torque (optional):
  Use function block “DrvScaling”. See Chapter 6.5.4.4.1.1 “DrvScaling” on page 3796

To exchange more than above mentioned values use additionally the following blocks:

- Read the values:
  Use the function block “DrvModbusRead”. See Chapter 6.5.4.4.1.6 “DrvModbusRead” on page 3804
- Write the values:
  Use the function block “DrvModbusWrite”. See Chapter 6.5.4.4.1.7 “DrvModbusWrite” on page 3805
- Read Write the values:
  Use the function block “DrvModbusReadWrite23”. See Chapter 6.5.4.4.1.11 “DrvModbusReadWrite23” on page 3825

**DCS550 and DCS800 drives**

To exchange only status word, actual speed, control word and speed reference:

- Communication profile in drive parameters: ABB Drives classic
- Communication function block in AC500 program:
  Use function block “DrvModbusRtu”. See Chapter 6.5.4.4.1.9 “DrvModbusRtu” on page 3812
- “DrvModbusRtu”
- Control function block in AC500 program:
  Use function block “DrvControlModbusDCS”. See Chapter 6.5.4.4.1.5 “DrvControlModbusDCS” on page 3803
- Scaling of the speed or torque (optional):
  Use function block “DrvScaling”. See Chapter 6.5.4.4.1.1 “DrvScaling” on page 3796

**DCS880 drives**

To exchange only status word, actual speed, control word and speed reference:

- Communication profile in drive parameters: ABB Drives classic
- Communication function block in AC500 program:
  Use function block “DrvModbusRtu”. See Chapter 6.5.4.4.1.9 “DrvModbusRtu” on page 3812
- “DrvModbusRtu”
- Control function block in AC500 program:
  Use function block “DrvControlModbusDCS”. See Chapter 6.5.4.4.1.5 “DrvControlModbusDCS” on page 3803
- Scaling of the speed or torque (optional):
  Use function block “DrvScaling”. See Chapter 6.5.4.4.1.1 “DrvScaling” on page 3796

To exchange status word, actual value1 (speed), actual value2 (torque), control word, reference1 (speed), reference value2 (torque) and up to 12 more values read from drive and up to 12 more values write to the drive:

- Communication profile in drive parameters: ABB Drives enhanced
- Communication function block in AC500 program:
  Use the function block “DrvModbusRtu”. See Chapter 6.5.4.4.1.9 “DrvModbusRtu” on page 3812
- “DrvModbusRtu”
- Control function block in AC500 program:
  Use function block “DrvControlModbusDCS”. See Chapter 6.5.4.4.1.5 “DrvControlModbusDCS” on page 3803
- Scaling of the speed or torque (optional): Use function block “DrvScaling”. See Chapter 6.5.4.4.1.1 “DrvScaling” on page 3796
To exchange more than above mentioned values use additionally the following blocks:

- **Read the values:**
  Use the function block “DrvModbusRead”. "Chapter 6.5.4.4.1.6 “DrvModbusRead” on page 3804"

- **Write the values:**
  Use the function block “DrvModbusWrite”. "Chapter 6.5.4.4.1.7 “DrvModbusWrite” on page 3805"

- **Read Write the values:**
  Use the function block “DrvModbusReadWrite23”. "Chapter 6.5.4.4.1.11 “DrvModbusReadWrite23” on page 3825"

---

**PROFINET**

**Preconditions**

The following hardware components must be available:

- AC500 V3 PLC with CM579-PNIO (PROFINET Master communication module)
- Drive with fieldbus adapter module
  - ACS Drives and DCS880: FENA-01 or FENA-11 or FENA-21
  - DCS550 and DCS800: RETA-02
- RJ45 Ethernet cable

The following values should be mapped in the fieldbus configuration of the drive and the configuration of AC500. These settings must be done in the Automation Builder hardware configuration.

- Drive → AC500: Status word and actual value 1 (speed) and optional actual value 2 (torque).
- AC500 → Drive: Control word and reference value 1 (speed) and optional reference value 2 (torque).

The following function blocks can be configured in the AC500 program.

- **Communication profile:** ABB Drives Profile
- **Control block:**
  - ACS Drives: Use function block ‘DrvControlACS’. "Chapter 6.5.4.4.1.2 “DrvControlACS” on page 3797."
  - DCS Drives: Use function block ‘DrvControlDCS’. "Chapter 6.5.4.4.1.3 “DrvControlDCS” on page 3799."
- **Scaling of the speed or torque (optional):** Use function block ‘DrvScaling’. "Chapter 6.5.4.4.1.1 “DrvScaling” on page 3796."
- **PROFINET read function block.** "Chapter 6.5.4.4.1.14 “DrvPNRead” on page 3829"
- **PROFINET write function block.** "Chapter 6.5.4.4.1.15 “DrvPnWrite” on page 3830"
ACS drives

Fig. 278: FB - Overview of PROFINET connection with ACS drives

DCS drives

Fig. 279: FB - Overview of PROFINET connection with DCS drives
EtherCAT
Preconditions

The following hardware components must be available:

- AC500 V3 PLC with CM579-ETHCAT (EtherCAT Master communication module)
- Drive with fieldbus adapter module
  - ACS Drives and DCS880: FECA-01
  - DCS550 and DCS800: RECA-01
- RJ45 Ethernet cable

The following values should be mapped in the fieldbus configuration of the drive and the configuration of AC500. These settings must be done in the Automation Builder hardware configuration.

- Drive → AC500: Status word and actual value 1 (speed) and optional actual value 2 (torque).
- AC500 → Drive: Control word and reference value 1 (speed) and optional reference value 2 (torque).

A direct Ethernet cable from CM579-ETHCAT to FECA-01 module is recommended, connection through switch is not recommended since it will slow down the connectivity. Also, the drives need to be connected in the same sequence as they are added in the Automation Builder when multiple drives are connected.

The following function blocks can be configured in the AC500 program.

- Communication profile: ABB Drives Profile
- Control block:
  - ACS Drives: Use function block "DrvControlACS".  
    Chapter 6.5.4.4.1.2 "DrvControlACS" on page 3797
  - DCS Drives: Use function block "DrvControlDCS".  
    Chapter 6.5.4.4.1.3 "DrvControlDCS" on page 3799
- Scaling of the speed or torque (optional): Use function block "DrvScaling".  
  Chapter 6.5.4.4.1.1 "DrvScaling" on page 3796
ACS drives

**Fig. 280: FB - Overview of EtherCAT connection with ACS drives**

DCS drives

**Fig. 281: FB - Overview of EtherCAT connection with DCS drives**

CANopen

**Preconditions**

The following hardware components must be available:

- AC500 V3 PLC. Configure onboard CAN port for CANopen communication.
- Drive with fieldbus adapter module
  - ACS Drives and DCS880: FCAN-01
  - DCS550 and DCS800: RCAN-01
- CANopen communication cable with 120 Ω resistor.
The following values should be mapped in the fieldbus configuration of the drive and the configuration of AC500. These settings must be done in the Automation Builder hardware configuration.

- Drive → AC500: Status word and actual value 1 (speed) and optional actual value 2 (torque).
- AC500 → Drive: Control word and reference value 1 (speed) and optional reference value 2 (torque).

The following function blocks can be configured in the AC500 program.

- Communication profile: ABB Drives Profile
- Control block:
  - ACS Drives: Use function block “DrvControlACS”. See Chapter 6.5.4.4.1.2 “DrvControlACS” on page 3797
  - DCS Drives: Use function block “DrvControlDCS”. See Chapter 6.5.4.4.1.3 “DrvControlDCS” on page 3799
- Scaling of the speed or torque (optional): Use function block “DrvScaling”. See Chapter 6.5.4.4.1.1 “DrvScaling” on page 3796

ACS drives

Fig. 282: FB - Overview of CANopen connection with ACS drives
DCS drives

Fig. 283: FB - Overview of CANopen connection with DCS drives

**CANopen with CAN CiA402 Profile for generic Drives**

**Preconditions**

The following hardware components must be available:

- AC500 V3 PLC. Configure onboard CAN port for CANopen communication.
- Any drive with CAN fieldbus adapter module and CAN CiA402 profile.
- CANopen communication cable with 120Ω resistor.

The following values should be mapped in the fieldbus configuration of the drive and the configuration of AC500. These settings must be done in the Automation Builder hardware configuration.

- Drive → AC500: Status word and actual speed.
- AC500 → Drive: Control word and reference speed.

The following function blocks can be configured in the AC500 program.

- Communication profile: CANopen device profile CiA402
- Control block: Use function block “DrvControlCANCiA402”.  
  Chapter 6.5.4.4.1.13 “DrvControlCANCiA402” on page 3828
General drives with CAN CiA402 interface

![Diagram showing AC500 program, Control Block, Communication, and Drive with CANopen CiA402 interface]

Fig. 284: FB - Overview of CANopen CiA402 with any drives
6.5.4.1.5 Compatibility

To check the compatibility of the drives and their communication modules please refer to the following table, it shows the tested combinations.

<table>
<thead>
<tr>
<th>Communication</th>
<th>PLC communication modules</th>
<th>Drive fieldbus adapter module</th>
<th>Drive</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PLC communication module</td>
<td>Firmware version</td>
<td>FBA</td>
</tr>
<tr>
<td>Modbus RTU - Classic</td>
<td>Onboard</td>
<td>FSCA-01</td>
<td>1.63</td>
</tr>
<tr>
<td></td>
<td>Embedded</td>
<td>ACS380</td>
<td>2.04.0.3</td>
</tr>
<tr>
<td>Modbus RTU – Enhanced</td>
<td>Onboard</td>
<td>FSCA-01</td>
<td>1.63</td>
</tr>
<tr>
<td>Modbus TCP</td>
<td>Onboard ETH1 / ETH2</td>
<td>RETA-01</td>
<td>1.30</td>
</tr>
<tr>
<td>Modbus TCP - Enhanced</td>
<td>Onboard ETH1 / ETH2</td>
<td>FENA-21</td>
<td>3.20</td>
</tr>
<tr>
<td>PROFINE T</td>
<td>CM579-PNIO</td>
<td>FENA-21</td>
<td>2.8.6.21</td>
</tr>
<tr>
<td></td>
<td>FENA-21</td>
<td>3.20</td>
<td>ACSM1</td>
</tr>
<tr>
<td>EtherCAT</td>
<td>CM579-ETHCAT</td>
<td>FECA-01</td>
<td>4.4.3.21</td>
</tr>
<tr>
<td>CANopen (ABB Profile)</td>
<td>Onboard</td>
<td>FCAN-01</td>
<td>1.16</td>
</tr>
<tr>
<td>CANopen (CiA402)</td>
<td>Onboard</td>
<td>FCAN-01</td>
<td>1.16</td>
</tr>
</tbody>
</table>

6.5.4.2 Installation

The library is part of the Automation Builder 2.2. or higher. Use the Library manager to add the library into project.

For more details on the package, refer to the release notes of the latest Automation Builder.
### 6.5.4.3 Hardware and software requirement

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC500 V3 PLCs: PM5630-2ETH, PM5650-2ETH, PM5670-2ETH and PM5675-2ETH</td>
<td>Automation Builder 2.2. or higher</td>
</tr>
<tr>
<td>AC500 V3 eCO: PM5012-x-ETH PM5032-x-ETH PM5052-x-ETH and PM5072-T-2ETH PM5082-T-2ETH</td>
<td></td>
</tr>
<tr>
<td>ABB drive: ACS380, ACS480, ACS580, ACH580, ACQ580, ACS880, ACM1, DCS550, DCS800, DCS880. (Other drives may work, but are not tested.)</td>
<td>Drive Composer Pro, Drive Studio, Drive Window or Drive Window Light</td>
</tr>
<tr>
<td>Fieldbus adapter module: FSCA-01, RMBA-01 FENA-01 / FENA-11 / FENA-21, RETA-01, FPNO-21, FMBT-21 FECA-01, RETA-02 FCAN-01, RCAN-01 (Other fieldbus adapter modules may work, but are not tested.)</td>
<td></td>
</tr>
</tbody>
</table>

Remarks: `:`: from ≥ AB 2.6.1 and CPU FW ≥ 3.6.2

---

Before adding a drive to the device tree, the correct device description file has to be installed into Automation Builder's device repository. For ABB drives the corresponding device descriptions are available for download from our website. For ABB drives connected via CANopen or EtherCAT there is also the option to generate the device descriptions via Drive Composer Pro ("Tools ➔ EDS Export").

Drive configuration tool and fieldbus adapter module support is dependent on the drive used, for the compatible tool details refer to the drive manual.
6.5.4.4 Description of the library

6.5.4.4.1 Function blocks

DrvScaling

DrvScaling function block is used to scale the speed or torque reference to the drive based on the maximum values defined.

Function block “DrvScaling” can be used to scale the variables from fieldbus equivalent values to values used in the program. Fieldbus variables are given in fieldbus equivalent values as INT values. With the scaling a conversion from INT (fieldbus) to REAL (program) and vice versa is performed. Reference1 and Actual Value1 (speed) are mostly given in the range of -20000 ... +20000. Reference2 and Actual Value2 (torque) are mostly given in the range of 0 ... +10000.
This function block can be used to control ACS drives with ABB drives profile using direct input of status word (SW) from drive via any supported fieldbus communication like PROFINET, EtherCAT, CANopen.

Control word (CW) will be built by the function block according to the ABB drives profile state machine. Output CW has to be send to the drive via any fieldbus communication supported. Function block provides standard start/stop signals to control the drive and standard diagnosis signals are read from the drive.
## Drive Parameter

<table>
<thead>
<tr>
<th>Drive Parameter</th>
<th>ACS380/ ACS480/ ACS580/ ACH580/ ACQ580/ ACS880</th>
<th>ACSM1</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXT1 COMMANDS</td>
<td>20.01 = Fieldbus A</td>
<td>10.01 = FBA</td>
<td>Fieldbus interface as source for start and stop</td>
</tr>
<tr>
<td>EXT1 / EXT2 SEL</td>
<td>19.11 = MCW Bit11 (06.01)</td>
<td>34.01 = P02.12 bit 15</td>
<td>Fieldbus interface as source to switch to EXT2 control place</td>
</tr>
<tr>
<td>REF1 SELECT</td>
<td>22.11 = FBA ref1</td>
<td>24.01 = FBA ref1</td>
<td>Fieldbus interface as source to speed reference</td>
</tr>
<tr>
<td>FAULT RESET SELECT</td>
<td>31.11 = P06.01 bit 7</td>
<td>10.08 = P02.12 bit 8</td>
<td>Fieldbus interface as source for fault reset</td>
</tr>
<tr>
<td>PROFILE</td>
<td>51.02 = Drives Classic / Enhanced</td>
<td>51.02 = Drives Classic / Enhanced</td>
<td>Control profile to ABB Drives profile classic or enhanced</td>
</tr>
</tbody>
</table>
This function block can be used to control DCS drives with ABB drives profile using direct input of status word (SW) from drive via any supported fieldbus communication like PROFINET, EtherCAT, CANopen.

Control word (CW) will be built by the function block according to the ABB drives profile state machine. Output CW must be sent to the drive via any fieldbus communication supported. Function block provides standard start/stop signals to control the drive and standard diagnosis signals are read from the drive.
<table>
<thead>
<tr>
<th>Drive Parameter</th>
<th>DCS550</th>
<th>DCS800</th>
<th>DCS880</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXT1 COMMANDS</td>
<td>10.01 = Main Ctrl Word</td>
<td>10.01 = Main Ctrl Word</td>
<td>20.01 = Main Ctrl Word</td>
<td>Fieldbus interface as source for start and stop</td>
</tr>
<tr>
<td>EXT1 / EXT2 SEL</td>
<td>10.07 (HandAuto) MCW: Bit11</td>
<td>10.07 (HandAuto) MCW: Bit11</td>
<td>19.11 = MCW Bit11 (06.01)</td>
<td>Fieldbus interface as source to switch to EXT2 control place</td>
</tr>
<tr>
<td></td>
<td>11.02 (Ref1Mux) MCW: Bit11</td>
<td>11.02 (Ref1Mux) MCW: Bit11</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>11.12 (Ref2Mux) Invert 11.02</td>
<td>11.12 (Ref2Mux) Invert 11.02</td>
<td></td>
<td></td>
</tr>
<tr>
<td>REF1 SELECT</td>
<td>11.03 = SpeedRef2301</td>
<td>11.03 = SpeedRef2301</td>
<td>22.11 = FBA ref1</td>
<td>Fieldbus interface as source to speed reference</td>
</tr>
<tr>
<td>FAULT RESET SELECT</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>Fieldbus interface as source for fault reset</td>
</tr>
<tr>
<td>PROFILE</td>
<td>NA</td>
<td>NA</td>
<td>51.02 = Drives Classic / Enhanced</td>
<td>Control profile to ABB Drives profile classic or enhanced</td>
</tr>
</tbody>
</table>
This function block can be used to control ACS drives with ABB Drives profile or ABB Drives enhanced profile using Modbus communication block like DrvModbusTcp or DrvModbusRtu.

Status Word (SW) is read from drive through Modbus communication block using “DriveData” interface. Chapter 6.5.4.4.3 “Structure: DrvDataType” on page 3831
Control Word (CW) will be built by the function block according to the ABB drives profile state machine. CW will be sent via DriveData and the used communication block to the drive. Function block provides standard start/stop signals to control the drive and standard diagnosis signals are read from the drive.

The function block should be used for ACS drives using ABB drive (Classic/Enhanced) profile for Modbus protocol only. The data transfer to the ACS drive is realized via the “IN_OUT” variable DriveData, which must be connected to “DrvModbusTcp” or “DrvModbusRtu” function block.
This function block can be used to control DCS drives with ABB Drives profile using Modbus communication block like "DrvModbusTcp" or "DrvModbusRtu".

Status Word (SW) is read from drive through Modbus communication block using DriveData interface. Chapter 6.5.4.4.3 “Structure: DrvDataType” on page 3831

Control Word (CW) will be built by the function block according to the ABB drives profile state machine. CW will be sent via DriveData and the used communication block to the drive. Function block provides standard start/stop signals to control the drive and standard diagnosis signals are read from the drive.
The function block should be used for DCS drives using ABB drive profile for Modbus protocol only. The data transfer to the DCS drive is realized via the “IN_OUT” variable DriveData, which must be connected to “DrvModbusTcp” or “DrvModbusRtu” function block.

**DrvModbusRead**

The function block 'DrvModbusRead' reads one or more parameters / values of the drive. The number of data to be read is specified at the input 'Nvar'. The first parameter number is specified at the input 'PrmNum'. All parameters must be accessible from consecutive Modbus registers in the drive. The values of the parameters are stored in the PLC memory area, defined at the input 'Data'.

The values in the PLC memory area are updated when the read job was performed without error. This is indicated by JobDone = TRUE and ModMastErrorAct = FALSE.

If the Modbus job was finished with an error, the output ModMastErrorAct is set for one cycle. The Error ID returned by the Modbus job is shown at the output ModMastErrorIDLast. The output ModMastErrorIDLast will show that last Error ID until the input Enable is set from TRUE to FALSE.

As long as the Enable = TRUE a new read job is requested automatically one cycle after the further read job was terminated. The Modbus job is started from the Communication Block which is connected to the same 'DriveData' variable. It uses the Modbus function code 03 (read n words). The drive (Modbus device) from which the parameter is read is specified at this Communication Block. The Communication Blocks are available from the library e.g. DrvModbusTcp or DrvModbusRtu.

The function block is activated (Enable = TRUE) or deactivated (Enable = FALSE) via input Enable. If the block is active, the current values are available at the outputs. To start a new read job the input Enable must be set to TRUE. If the input values are valid, a request to perform a Modbus job is send to the Communication Block via the 'DriveData' variable. If at least 1 input is invalid, no job is generated, and the error is displayed at the outputs Error and ErrorID instead.
**DrvModbusWrite**

Function block 'DrvModbusWrite' writes 'n' parameters to the drive. The number of parameters to be written must be available in the PLC memory area, defined at the input Data. The write job has been performed without error if JobDone = TRUE and ModMastErrorAct = FALSE.

If the Modbus job was finished with an error, the output ModMastErrorAct is set for one cycle. The Error ID returned by the Modbus job is shown at the output ModMastErrorIDLast. The output ModMastErrorIDLast will show that last Error ID until the input Execute is set from TRUE to FALSE.

To start a new write job the input Execute must be set from FALSE to TRUE (edge sensitive). The Modbus job is started from the Communication Block which is connected to the same DriveData variable. It uses the Modbus function code 16 (write n words). The drive (Modbus device) to which the parameter is written is specified at the Communication Block.

*Drive parameters are only saved temporarily, if changed via fieldbus. To make these changes permanent in the drive the special parameter "PARAMETER SAVE" must be set.*

*Please see drive manuals for the parameter details.*

---

**DrvModbusTcp**

**Introduction**

Function block DrvModbusTcp controls the Modbus TCP communication to ACS/DCS drives and provides the basic values (CW, Ref1, Ref2, SW, Act1, Act2) which are used for the basic control of drives with ABB Drives Profile or ABB Drives Enhanced Profile.
ABB drives classic profile

With input parameter EnhancedProfile = FALSE, the function block works for ABB Drives Classic Profile.

Reading status information from drives

The function block continuously reads data from the drive starting at Modbus register 400004. So at least the Status Word (SW), Actual Value 1 (Speed Reference), Actual Value 2 (Actual Value 2) are continuously read from the drive and written to the DriveData variable.

These values are stored in DriveData.StatusWord, DriveData.ActValue1 and DriveData.ActValue2.

The following table shows the performed Modbus read job and the needed mapping in the drive as well as the area where the data is stored in the AC500.

<table>
<thead>
<tr>
<th>Modbus register address in drive</th>
<th>Mapping configuration in drive</th>
<th>Written in AC500</th>
<th>Condition at function block</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACS380, ACS480, ACS580, ACH580, ACQ580, ACS880, ACSM1</td>
<td>DCS550, DCS800</td>
<td>DCS880</td>
<td></td>
</tr>
<tr>
<td>Communication module FENA-01/11/21</td>
<td>RETA-01 FENA-01/11/21</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Status Word (SW) 400004</td>
<td>Status Word (SW)</td>
<td>Status Word (SW)</td>
<td>DriveData.wStatusWord</td>
</tr>
<tr>
<td>Actual Value 1 400005</td>
<td>Actual Value 1</td>
<td>Actual Value 1</td>
<td>DriveData.iActValue1</td>
</tr>
<tr>
<td>Actual Value 2 400006</td>
<td>Actual Value 2</td>
<td>Actual Value 2</td>
<td>DriveData.iActValue2</td>
</tr>
</tbody>
</table>

Writing control word and reference value to drives

To write the Control Word (CW), Reference Value 1 (Speed Reference) or Reference Value 2 (Reference Value 2) from the DriveData variable (DriveData.ControlWord, DriveData.Reference1, DriveData.Reference2) to the drive, the input EnableWrite has to be TRUE (default).

If the input SteadyWrite = TRUE (default = FALSE) these values are written steadily.

If the input SteadyWrite = FALSE (default) these values are only written if there was a change on any of those values.

These 3 values are written to the ACS drive starting at Modbus register 400001.

The function block checks if there are changes of the Control Word (wControlWord), Reference Value 1 (iRefValue1) or Reference Value 2 (iRefValue2) on the DriveData variable. If there is a change a write job is requested to send these 3 values to the ACS/DCS drive starting at Modbus register 400001.

The following table shows the performed Modbus write job and the needed mapping in the drive as well as the area where the data is stored in the AC500.
# ABB drives enhanced profile

With input parameter `EnhancedProfile = TRUE`, the function block works for ABB Drives Enhanced Profile.

## Reading status information from drives

The function block continuously reads data from the drive starting at Modbus register 400051. So at least the Status Word (SW), Actual Value 1 (Speed Reference), Actual Value 2 (Actual Value 2) are continuously read from the drive and written to the DriveData variable.

These values are stored in `DriveData.StatusWord`, `DriveData.ActValue1` and `DriveData.ActValue2`.

Apart from these three parameters there is also an option to read 12 additional drive parameters.

Using the input `NvarRead` the function block can be configured to read between 0 and 12 parameters from the drive. All read data is then written to the array at the `ReadValue` output array. Configuration in ACS drive is depending on configured parameters in group FBA DATA IN.
### Modbus register address in drive

<table>
<thead>
<tr>
<th>Modbus register address in drive</th>
<th>Mapping configuration in drive</th>
<th>Written in AC500</th>
<th>Condition at function block</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACS380, ACS480, ACS580, ACH580, ACH580, ACQ580, ACS880, ACSM1</td>
<td>DCS550, DCS800</td>
<td>DCS880</td>
<td></td>
</tr>
<tr>
<td>Communication module</td>
<td>FENA-01/ 11/21 RETA-01</td>
<td>FENA-01/11/21 FMBT-21</td>
<td></td>
</tr>
<tr>
<td>400051</td>
<td>Status Word (SW)</td>
<td>Status Word (SW)</td>
<td>Status Word (SW)</td>
</tr>
<tr>
<td>400052</td>
<td>Actual Value 1</td>
<td>Actual Value 1</td>
<td>Actual Value 1</td>
</tr>
<tr>
<td>400053</td>
<td>Actual Value 2</td>
<td>Actual Value 2</td>
<td>Actual Value 2</td>
</tr>
<tr>
<td>400054</td>
<td>FBA Data IN 1</td>
<td>FBA Data IN 1</td>
<td>FBA Data IN 1</td>
</tr>
<tr>
<td>400055</td>
<td>FBA Data IN 2</td>
<td>FBA Data IN 2</td>
<td>FBA Data IN 2</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>400064</td>
<td>FBA Data IN 11</td>
<td>FBA Data IN 11</td>
<td>FBA Data IN 11</td>
</tr>
<tr>
<td>400065</td>
<td>FBA Data IN 12</td>
<td>FBA Data IN 12</td>
<td>FBA Data IN 12</td>
</tr>
</tbody>
</table>

---

**If 32-bit parameters are mapped to DATA IN,**

- The following field in DATA IN must be left open (= 0)
- The word order of the High-Word (HW) and Low-Word (LW) can be configured in the drive.
  (using FENA-X1: Par. 51.22)
- To retrieve the original 32-bit value from the drive in AC500 the HW and LW from ReadValues fields must be recombined in the program.

---

Function block DATA IN has to be configured in drive in the following groups see also FENA-x1 manual.

<table>
<thead>
<tr>
<th>Drive</th>
<th>Parameter Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACS355</td>
<td>54.01 ... 54.10</td>
</tr>
<tr>
<td>ACS380, ACS480, ACS580, ACH580, ACQ580, ACS880, ACM1</td>
<td>52.01 ... 52.12 52.01 ... 52.12 if installed as adapter A</td>
</tr>
</tbody>
</table>
To write the Control Word (CW), Reference Value 1 (Speed Reference) or Reference Value 2 (Reference Value 2) from the DriveData variable (DriveData.ControlWord, DriveData.Reference1, DriveData.Reference2) to the drive, the input EnableWrite has to be TRUE (default).

If the input SteadyWrite = TRUE (default = FALSE) these values are written steadily.

If the input SteadyWrite = FALSE (default) these values are only written if there was a change on any of those values.

These 3 values are written to the ACS drive starting at Modbus register 400001.

Apart from these three there parameters there is also an option to write 12 additional drive parameters.

Using the input NvarWrite the function block can be configured to write between 0 and 12 parameters to the drive. The necessary values must be present in the array connected to WriteValues input. Configuration in ACS drive is depending on configured parameters in group FBA DATA OUT.

<table>
<thead>
<tr>
<th>Modbus register address in drive</th>
<th>Mapping configuration in drive</th>
<th>Written from AC500</th>
<th>Condition at function block</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACS380, ACS480, ACS580, ACH580, ACQ580, ACS880, ACSM1</td>
<td>DCS550, DCS800</td>
<td>DCS880</td>
<td></td>
</tr>
<tr>
<td>Communication module</td>
<td>FENA-01/11/21 FMBT-21</td>
<td>RETA-01</td>
<td>FENA-01/11/21 FMBT-21</td>
</tr>
<tr>
<td>400001</td>
<td>Control Word (CW)</td>
<td>Control Word (CW)</td>
<td>DriveData.wControlWord</td>
</tr>
<tr>
<td>400002</td>
<td>Reference Value 1</td>
<td>Reference Value 1</td>
<td>DriveData.iReference1</td>
</tr>
<tr>
<td>400003</td>
<td>Reference Value 2</td>
<td>Reference Value 2</td>
<td>DriveData.iReference2</td>
</tr>
<tr>
<td>400004</td>
<td>FBA Data OUT 1</td>
<td>FBA Data OUT 1</td>
<td>WriteValues[1]</td>
</tr>
<tr>
<td>400005</td>
<td>FBA Data OUT 2</td>
<td>FBA Data OUT 2</td>
<td>WriteValues[2]</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>400015</td>
<td>FBA Data OUT 12</td>
<td>FBA Data OUT 12</td>
<td>WriteValues[12]</td>
</tr>
</tbody>
</table>

If a Modbus TCP job tries to access a register in the drive which has no valid mapping information then job is aborted with an error.

Therefore, the drive parameters in FBA DATA IN group and FBA DATA OUT must be configured according to the used ‘NvarRead’ and ‘NvarWrite’ input number respectively.
If 32-bit parameters are mapped to DATA OUT,

- The next/following field in DATA OUT must be left open (= 0)
- The word order of the High-Word (HW) and Low-Word (LW) can be configured in the drive.
  (using FENA-X1: Par. 51.22)
- To retrieve the original 32-bit value from the drive in AC500 the HW and LW from WriteValues fields must be recombined in the program.

ACS drive parameters are only saved temporarily, if changed via fieldbus. To make these changes permanent in the drive the special parameter "PARAMETER SAVE" must be set.

Please see also drive manuals which parameter must be set.

For ACS380, ACS480, ACS580, ACH580, ACQ580, ACS880 and DCS880 – Par 96.07 = 1
For ACSM1, DCS800 and DCS550 – Par 16.06 = 1

Diagnosis

If a Modbus TCP job tries to access a register in the drive which has no valid mapping information the job is aborted with an error.

The output ModMastErrorAct reflects that an actual error occurred. This output is only TRUE for one cycle. At that cycle the output ModMastErrorIDLast reflects the actual ErrorID from the ModTcpMast job. The ModMastErrorIDLast will keep this Error ID until a new rising edge of the Enable is given.

However, there are internal diagnosis variables available, which are not shown at any output, but can be accessed from the function block instance.

These additional diagnosis variables can be accessed by opening the function block instance or through the block visualization "VisuDrvModbusTcp".

- iWriteErrCnt: number of errors in write jobs since Enable = TRUE.
- wLastWriteErno: holds the error number of the last executed write job.
- iReadErrCnt: number of errors in read jobs since Enable = TRUE.
- wLastReadErno: holds the error number of the last executed read job.
- iReadWriteErrCnt: number of errors in read write jobs since Enable = TRUE.
- wLastReadWriteErno: holds the error number of the last executed read write job.

If the user changes drive profile while drive is online with PLC, function block outputs may give wrong indication.
## Drive parameter settings

<table>
<thead>
<tr>
<th>Settings in the drive according to AC500 configuration</th>
<th>ACS380, ACS480, ACS580, ACH580, ACQ580, ACS880, ACSM1</th>
<th>DCS550, DCS800</th>
<th>DCS880</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication module</td>
<td>FENA-01 /11/21</td>
<td>RETA-01</td>
<td>FENA-01/11/21</td>
</tr>
<tr>
<td></td>
<td>FMBT-21</td>
<td></td>
<td>FMBT-21</td>
</tr>
<tr>
<td>Fieldbus activation = EXT FBA / ENABLE</td>
<td>50.01</td>
<td>98.02</td>
<td>50.01</td>
</tr>
<tr>
<td></td>
<td>30.35</td>
<td></td>
<td>50.02</td>
</tr>
<tr>
<td>FBA A Comm loss func</td>
<td>50.02</td>
<td>50.02</td>
<td>50.02</td>
</tr>
<tr>
<td>Comm Rate = Auto (0)</td>
<td>51.03</td>
<td>51.02</td>
<td>51.03</td>
</tr>
<tr>
<td>IP configuration = Static IP</td>
<td>51.04</td>
<td>51.02</td>
<td>51.04</td>
</tr>
<tr>
<td></td>
<td>51.05 … 51.08</td>
<td>51.04 … 51.07</td>
<td>51.05 … 51.08</td>
</tr>
<tr>
<td></td>
<td>51.09</td>
<td>51.08 … 51.11</td>
<td>51.09</td>
</tr>
<tr>
<td>Subnet CIDR = 24 (eg: 255.255.255.0)</td>
<td>51.10 … 51.13</td>
<td>51.12 … 51.15</td>
<td>51.10 … 51.13</td>
</tr>
<tr>
<td>Gateway Address (normally = 0.0.0.0)</td>
<td>51.02</td>
<td>51.16</td>
<td>51.02</td>
</tr>
<tr>
<td>Protocol / Profile = MB/TCP ABB E or MB/TCP ABB C</td>
<td>51.22</td>
<td>No 32-bit access</td>
<td>51.22</td>
</tr>
<tr>
<td></td>
<td>51.20</td>
<td>51.17</td>
<td>51.20</td>
</tr>
<tr>
<td>Modbus timeout. Depending on timeout mode. Value in 100 ms</td>
<td>51.21</td>
<td></td>
<td>51.21</td>
</tr>
<tr>
<td>Modbus timeout mode:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>If input “SteadyWrite” is false set to “Any message”</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>If input “SteadyWrite” is true can also be set to</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>“Control RW”</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Refresh settings in drive</td>
<td>51.27</td>
<td>51.27</td>
<td>51.27</td>
</tr>
</tbody>
</table>

- Please refer the respective drive / fieldbus module manual for the parameter settings if the drive setting is not mentioned in above table.
- For RETA-01/-02 IP address could also be set via hardware Dip-Switches. If any switch is set (192.168.0.xxx) with xxx = Dip-Switches setting.
- ACS drive parameters are only saved temporarily, if changed via fieldbus. To make these changes permanent in the drive the special parameter "PARAMETER SAVE" must be set.
- Please see also drive manuals which parameter must be set.
- For ACS380, ACS480, ACS580, ACH580, ACQ580, ACS880 and DCS880 – Par 96.07 = 1
- For ACSM1, DCS800 and DCS550 – Par 16.06 = 1
DrvModbusRtu

Introduction

Function block DrvModbusRtu controls the Modbus RTU communication to ACS/DCS drives and is used for the basic control of drives with ABB Drives Profile or ABB Drives Enhanced Profile.

ABB drives classic profile

With input parameter EnhancedProfile = FALSE, the function block works for ABB Drives Classic Profile.

Reading status information from drives

The function block continuously reads data from the drive starting at Modbus register 400004. So at least the Status Word (wStatusWord), Actual Value 1 (iActValue1), Actual Value 2 (iActValue2) are continuously read from the drive and written to the DriveData variable.

These values are stored in DriveData.wStatusWord, DriveData.iActValue1 and DriveData.iActValue2.

With input NvarRead the function block can be configured to read in the same job between 0 ... 24 data more from the drive. These additional data are written to the array at the ‘ReadValues’ output. These data must be configured in the drive and are only accessible if the embedded Modbus is used.

The following table shows the performed Modbus read job and the needed mapping in the drive as well as the area where the data is stored in the AC500.
<table>
<thead>
<tr>
<th>Modbus register address in drive</th>
<th>Mapping configuration in drive</th>
<th>Written in AC500</th>
<th>Condition at function block</th>
</tr>
</thead>
</table>

Communication module  
FSCA-01, RMBA-01  
Embedded fieldbus

<table>
<thead>
<tr>
<th>400004</th>
<th>Status Word (SW)</th>
<th>Status Word (SW)</th>
<th>Status Word (SW)</th>
<th>DriveData.wStatusWord</th>
<th>Enable = TRUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>400005</td>
<td>Actual Value 1</td>
<td>Actual Value 1</td>
<td>Actual Value 1</td>
<td>DriveData.iActValue1</td>
<td>Enable = TRUE</td>
</tr>
<tr>
<td>400006</td>
<td>Actual Value 2</td>
<td>Actual Value 2</td>
<td>Actual Value 2</td>
<td>DriveData.iActValue2</td>
<td>Enable = TRUE</td>
</tr>
<tr>
<td>400007</td>
<td>-</td>
<td>-</td>
<td>58.107 DATA I/O 7</td>
<td>ReadValues[1]</td>
<td>Enable = TRUE</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>400014</td>
<td>-</td>
<td>-</td>
<td>58.114 DATA I/O 14</td>
<td>ReadValues[8]</td>
<td>Enable = TRUE</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>400024</td>
<td>-</td>
<td>-</td>
<td>58.124 DATA I/O 24</td>
<td>ReadValues[18]</td>
<td>Enable = TRUE</td>
</tr>
</tbody>
</table>

More details on the limits for the data read and write is explained in Chapter 6.5.4.5 “Limits for the data read and write between AC500 and drives” on page 3832. The value is dependent on the Drive used.

Writing control word and reference value to drives  
The function block checks if there are changes of the Control Word (wControlWord), Reference Value 1 (iRefValue1) or Reference Value 2 (iRefValue2) on the DriveData variable. If there is a change a write job is requested to send these 3 values to the ACS/DCS drive starting at Modbus register 400001.

The following table shows the performed Modbus write job and the needed mapping in the drive as well as the area where the data is stored in the AC500.
<table>
<thead>
<tr>
<th>Modbus register address in drive</th>
<th>Mapping configuration in drive</th>
<th>Written from AC500</th>
<th>Condition at function block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication module</td>
<td>FSCA-01</td>
<td>RMBA-01</td>
<td>Embedded fieldbus</td>
</tr>
<tr>
<td>400004</td>
<td>Control Word (CW)</td>
<td>Control Word (CW)</td>
<td>Control Word (CW)</td>
</tr>
<tr>
<td>400005</td>
<td>Reference Value 1</td>
<td>Reference Value 1</td>
<td>Reference Value 1</td>
</tr>
<tr>
<td>400006</td>
<td>Reference Value 2</td>
<td>Reference Value 2</td>
<td>Reference Value 2</td>
</tr>
</tbody>
</table>

More details on the limits for the data read and write is explained in Chapter 6.5.4.5 “Limits for the data read and write between AC500 and drives” on page 3832. The value is dependent on the Drive used.

**ABB drives enhanced profile**

With input parameter EnhancedProfile = TRUE, the function block works for ABB Drives Enhanced Profile.

The ABB Drives Profile Enhanced communication profile provides register mapped access to the Control, Status, Reference and Actual Values of the ABB Drives Profile Enhanced. The mapping of the registers has been enhanced to allow additional writing of up to 12 control and reading of up to 12 additional status parameters in a single Modbus job.

**Reading status information from drives**

The function block continuously reads data from the drive starting at Modbus register 400051. So at least the Status Word (wStatusWord), Actual Value 1 (iActValue1), Actual Value 2 (iActValue2) are continuously read from the drive and written to the DriveData variable.

These values are stored in DriveData.wStatusWord, DriveData.iActValue1 and DriveData.iActValue2.

Apart from these three parameters there is also an option to read 12 additional drive parameters in the same job.

Using the input NvarRead the function block can be configured to read between 1 and 12 more parameters from the drive. All read data is then written to the array at the ReadValues output. Configuration in ACS drive is depending on configured parameters in group FBA DATA IN.

The following table shows the performed Modbus read job and the needed mapping in the drive as well as the area where the data is stored in the AC500.
The function block checks if there are changes in any of the following values since last write job:

- Control Word (wControlWord),
- Reference Value 1 (iRefValue1),
- Reference Value 2 (iRefValue2) on the DriveData variable,
- values in the input array WriteValues – WriteValues[1..NvarWrite].

If there is a change a write job is requested to send the 3 control values and the values in WriteValues array (WriteValues[1..NvarWrite]) to the ACS/DCS drive starting at Modbus register 400001. Configuration in ACS drive is depending on configured parameters in group FBA DATA OUT.

The following table shows the performed Modbus write job and the needed mapping in the drive as well as the area where the data is stored in the AC500.
<table>
<thead>
<tr>
<th>Modbus register address in drive</th>
<th>Mapping configuration in drive</th>
<th>Written from AC500</th>
<th>Condition at function block</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACS380, ACS480, ACS580, ACH580, ACQ580, ACS880, ACSM1, DCS880</td>
<td>DCS550, DCS800</td>
<td>DCS880</td>
<td></td>
</tr>
<tr>
<td>Communication module</td>
<td>FSCA-01</td>
<td>RMBA-01</td>
<td>FSCA-01</td>
</tr>
<tr>
<td>400001</td>
<td>Control Word (CW)</td>
<td>Control Word (CW)</td>
<td>Control Word (CW)</td>
</tr>
<tr>
<td>400002</td>
<td>Reference Value 1</td>
<td>Reference Value 1</td>
<td>Reference Value 1</td>
</tr>
<tr>
<td>400003</td>
<td>Reference Value 2</td>
<td>Reference Value 2</td>
<td>Reference Value 2</td>
</tr>
<tr>
<td>400004</td>
<td>FBA Data OUT 1</td>
<td>FBA Data OUT 1</td>
<td>FBA Data OUT 1</td>
</tr>
<tr>
<td>400005</td>
<td>FBA Data OUT 2</td>
<td>FBA Data OUT 2</td>
<td>FBA Data OUT 2</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>400015</td>
<td>FBA Data OUT 12</td>
<td>FBA Data OUT 12</td>
<td>FBA Data OUT 12</td>
</tr>
</tbody>
</table>

**Reconnection pause**

When one or more drives in the Modbus RTU lines are offline, all the other drives have to wait for the TimeOut to elapse until a line token is assigned to next drive. Reconnection pause input helps in skipping the drives which are offline from the next Modbus job and execute Modbus job operations only for the drives which are online.

"ReconnectPause" is time in seconds before next retry to connect after a timeout was detected. Timeout is detected with ModMastErrorIDLast = 16#120 (ERR_TIMEOUT).

This feature can be used with the DrvModbusRtu function block in both ABB Drives Profile and ABB Drives Enhanced Profile. User must configure the reconnect pause input value using the input variable "ReconnectPause".

For the generic RTU block ModRtuToken (part of AC500_ModbusRtu library), also the value for the reconnect pause must be configured at input variable "ReconnectPause".

**Diagnosis**

The output ErrorID which reflects an actual error number is only valid for one cycle if output Error is set to TRUE. To capture this error number an external function must be programmed.

The output ModMastErrorAct reflects that an actual error occurred. This output is only TRUE for one cycle. At that cycle the output ModMastErrorIDLast reflects the actual ErrorID from the ModRtuMast job. The ModMastErrorIDLast will keep this error ID until a new rising edge of the Enable input is given.
However, there are internal diagnosis variables available, which are not shown at any output, but can be accessed from the function block instance.

These additional diagnosis variables can be accessed by opening the function block instance or through the block visualization “VisuDrvModbusRTU”.

- **iWriteErrCnt**: number of errors in write jobs since Enable = TRUE.
- **wLastWriteErrno**: holds the error number of the last executed write job.
- **iReadErrCnt**: number of errors in read jobs since Enable = TRUE.
- **wLastReadErrno**: holds the error number of the last executed read job.
- **iReadWriteErrCnt**: number of errors in read write jobs since Enable = TRUE.
- **wLastReadWriteErrno**: holds the error number of the last executed read write job.

---

**If several drives are used, for each drive a communication function block such as DrvModbusRtu must be programmed. Also, every other generic Modbus server device on the same Modbus RTU line must be programmed with its own ModRtuToken function block. All those communication function blocks of one Modbus RTU line must be linked together via one variable of type ModRtuTokenType, connected to the InOut LineToken. Via this variable the Modbus token is passed to the next drive/device, so only one drive/device at a time is communicating with the PLC.**

ModRtuToken function block and ModRtuTokenType structure are part of AC500_ModbusRtu library. Kindly refer the same.

---

**If the user changes drive profile while drive is online with PLC, function block outputs may give wrong indication.**

---

**If a Modbus RTU job tries to access a register in the drive which has no valid mapping information then the job is aborted with an error.**

Therefore, the drive parameters in FBA DATA IN group and FBA DATA OUT must be configured according to the used ‘NvarRead’ and ‘NvarWrite’ input number respectively.

**Modbus RTU using Embedded Fieldbus:**

When embedded fieldbus is used for the Modbus RTU communication, user can read maximum of 24 parameters (based on the limitation in drive) from the DATA I/O parameters in the embedded fieldbus parameter group. These parameters can only be used for reading operation and cannot be configured to write data.
### Drive parameter settings

<table>
<thead>
<tr>
<th>Settings in the drive according to AC500 configuration</th>
<th>ACS380, ACS480, ACS580, ACH580, ACQ580, ACS880, ACSM1, DCS880</th>
<th>DCS550, DCS800</th>
<th>ACS380, ACS480, ACS580, ACH580, ACQ580, ACS880, DCS880</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication module</td>
<td>FSCA-01</td>
<td>RMB-01</td>
<td>Embedded fieldbus</td>
</tr>
<tr>
<td>Fieldbus activation = EXT FBA / ENABLE</td>
<td>50.01</td>
<td>98.02</td>
<td>58.01</td>
</tr>
<tr>
<td>FBA A Comm loss func</td>
<td>50.02</td>
<td>30.35</td>
<td>50.02</td>
</tr>
<tr>
<td>Slave number</td>
<td>51.03</td>
<td>51.02</td>
<td>58.03</td>
</tr>
<tr>
<td>Transmission rate</td>
<td>51.04</td>
<td>51.03</td>
<td>58.04</td>
</tr>
<tr>
<td>Parity</td>
<td>51.05</td>
<td>51.05</td>
<td>58.05</td>
</tr>
<tr>
<td>Protocol / Profile = ABB Classic/ABB Enhanced</td>
<td>51.02</td>
<td>51.16</td>
<td>51.02</td>
</tr>
<tr>
<td>Word order for 32-bit parameter</td>
<td>51.22</td>
<td>No 32-bit access</td>
<td>51.22</td>
</tr>
<tr>
<td>Mapping of control word, Mod-bus reg 400001</td>
<td>Fix</td>
<td>Fix</td>
<td>58.101</td>
</tr>
<tr>
<td>Mapping of reference value 1, Modbus reg 400002</td>
<td>Fix</td>
<td>Fix</td>
<td>58.102</td>
</tr>
<tr>
<td>Mapping of reference value 2, Modbus reg 400003</td>
<td>Fix</td>
<td>Fix</td>
<td>58.103</td>
</tr>
<tr>
<td>Mapping of status word, Modbus reg 400004</td>
<td>Fix</td>
<td>Fix</td>
<td>58.104</td>
</tr>
<tr>
<td>Mapping of actual value 1, Modbus reg 400005</td>
<td>Fix</td>
<td>Fix</td>
<td>58.105</td>
</tr>
<tr>
<td>Mapping of actual value 2, Modbus reg 400006</td>
<td>Fix</td>
<td>Fix</td>
<td>58.106</td>
</tr>
<tr>
<td>Timeout mode = None (0) or Any Message (1), but not Ctrl write (2) as these values are only written after changes</td>
<td>51.07</td>
<td></td>
<td>58.15</td>
</tr>
<tr>
<td>Modbus timeout. Depending on timeout mode. Value in 100 ms</td>
<td></td>
<td>58.17</td>
<td>58.16</td>
</tr>
<tr>
<td>Refresh settings in drive</td>
<td>51.27</td>
<td>51.27</td>
<td>58.06</td>
</tr>
</tbody>
</table>
- Please refer the respective drive / fieldbus module manual for the parameter settings if the drive setting is not mentioned in above table.
- ACS drive parameters are only saved temporarily, if changed via fieldbus. To make these changes permanent in the drive the special parameter “PARAMETER SAVE” must be set. Please see also drive manuals which parameter must be set.
  For ACS380, ACS480, ACS580, ACH580, ACQ580, ACS880 and DCS880 – Par 96.07 = 1
  For ACSM1, DCS800 and DCS550 – Par 16.06 = 1
**DrvModbusRtuBroadcast**

**Introduction**

Function block DrvModbusRtuBroadcast is a communication block which sends the broadcast messages via the Modbus RTU communication to all ACS/DCS drives and other Modbus devices connected to the same Modbus RTU line (physical line). The function block can be used with all drives with either ABB Drives Profile or ABB Drives Enhanced Profile but not a mix of both profiles.

As the broadcast job will be received by all devices on the same physical Modbus line it’s highly recommended to use this block only in case there are no other Modbus devices connected to this line and all drives use the same profile.

This function block does not perform any Modbus read operation, hence it does not read any values such as status word, actual value 1 and actual value 2 etc., from any of the drive.

This function block should not be used along with 'DrvModbusRead' and 'DrvModbusRead-Write23' function blocks. They will be ignored showing an error. This function block should be only used independently or in combination with 'DrvModbusWrite' function block for broadcasting write operation.

A successful broadcast message for writing control word, reference values and additional mapped parameters (only in case of Enhanced Profile) is indicated by JobDone = TRUE and ModMastErrorAct = FALSE. A next broadcast job for writing these values can once again started with a fresh rising edge at ‘SendCtrlValues’ input.

Apart from sending control values and up to 12 additional values from WriteValues array (only in case of ABB Drives Enhanced Profile) a normal Modbus write function block “DrvModbusWrite” can be used to send broadcast write messages to specific address on all drives connected to the Modbus RTU line. The requests to process broadcast write Modbus jobs is transferred via the DriveData structure at the InOut variable DriveData which can be connected to multiple instances of write function block 'DrvModbusWrite'.

After each successful broadcast write job a fixed pause of 250 ms is implemented before any other Modbus job within the same line will be started.

**ABB drives classic profile**

With input parameter EnhancedProfile = FALSE, the function block works for ABB Drives Classic Profile.

**Writing control word and reference value to drives**

A rising edge from FALSE to TRUE at input ‘SendCtrlValues’ starts sending broadcast message with Control Word and Reference Values to all the drives starting at Modbus register 400001.

Following control values: Control Word (wControlWord), Reference Value 1 (iRefValue1) or Reference Value 2 (iRefValue2) are taken from DriveData variable for sending broadcast message.

The following table shows the performed Modbus write job and the needed mapping in the drive as well as the area where the data is stored in the AC500.
<table>
<thead>
<tr>
<th>Modbus register address in drive</th>
<th>Mapping configuration in drive</th>
<th>Written from AC500</th>
<th>Condition at function block and input SendCtrlvalues</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACS380, ACS480, ACS580, ACH580, ACQ580, ACS880, ACSM1DCS880 DCS800</td>
<td>DCS50, DCS800</td>
<td>ACS380, ACS480, ACS580, ACH580, ACQ580, ACS880DCS880 DCS880</td>
<td>Enable = TRUE and Rising Edge at SendCtrlvalues</td>
</tr>
</tbody>
</table>

Communication module

<table>
<thead>
<tr>
<th>Communication module</th>
<th>FSCA-01</th>
<th>RMBA-01</th>
</tr>
</thead>
<tbody>
<tr>
<td>400001</td>
<td>Control Word (CW)</td>
<td>Control Word (CW)</td>
</tr>
<tr>
<td>400002</td>
<td>Reference Value 1</td>
<td>Reference Value 1</td>
</tr>
<tr>
<td>400003</td>
<td>Reference Value 2</td>
<td>Reference Value 2</td>
</tr>
</tbody>
</table>

ABB drives enhanced profile

With input parameter EnhancedProfile = TRUE, the function block works for ABB Drives Enhanced Profile.

With the ABB Drives Profile Enhanced profile, along with 3 control values Control Word, Reference Value 1, Reference Value 2, up to 12 additional values can be sent as broadcast message in a single Modbus job.

Writing control word and reference values to drives

A rising edge from FALSE to TRUE at input 'SendCtrlValues' starts sending broadcast message with Control Word and reference values to all the drives starting at Modbus register 400001.

Following control values: Control Word (wControlWord), Reference Value 1 (iRefValue1) or Reference Value 2 (iRefValue2) from DriveData along with values in the input array WriteValues – WriteValues[1..NvarWrite] are taken for sending broadcast message.

For the additional 12 values the configuration in ACS drive is depending on configured parameters in group FBA DATA OUT.

The following table shows the performed Modbus broadcast write job and the needed mapping in the drive as well as the area where the data is taken from the AC500.
<table>
<thead>
<tr>
<th>Modbus register address in drive</th>
<th>Mapping configuration in drive</th>
<th>Written from AC500</th>
<th>Condition at function block</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACS380, ACS480, ACS580, ACH580, ACQ580, ACS880, ACSM1, DC880</td>
<td>DCS550, DCS800</td>
<td>DCS880</td>
<td></td>
</tr>
<tr>
<td>Communication module</td>
<td>FSCA-01</td>
<td>RMBA-01</td>
<td>FSCA-01</td>
</tr>
<tr>
<td>400001</td>
<td>Control Word (CW)</td>
<td>Control Word (CW)</td>
<td>Control Word (CW)</td>
</tr>
<tr>
<td>400002</td>
<td>Reference Value 1</td>
<td>Reference Value 1</td>
<td>Reference Value 1</td>
</tr>
<tr>
<td>400003</td>
<td>Reference Value 2</td>
<td>Reference Value 2</td>
<td>Reference Value 2</td>
</tr>
<tr>
<td>400004</td>
<td>FBA Data OUT 1</td>
<td>FBA Data OUT 1</td>
<td>FBA Data OUT 1</td>
</tr>
<tr>
<td>400005</td>
<td>FBA Data OUT 2</td>
<td>FBA Data OUT 2</td>
<td>FBA Data OUT 2</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>400015</td>
<td>FBA Data OUT 12</td>
<td>FBA Data OUT 12</td>
<td>FBA Data OUT 12</td>
</tr>
</tbody>
</table>

**Diagnosis**

The output ErrorID which reflects an actual error number is only valid for one cycle if output Error is set to TRUE. To capture this error number an external function must be programmed.

The output ModMastErrorAct reflects an actual error occurred in Modbus job. This output is only TRUE for one cycle. At that cycle the output ModMastErrorIDLast reflects the actual ErrorID from the ModRtuMast job. The ModMastErrorIDLast will keep this error ID until a new rising edge of the Enable input is given.

However, there are internal diagnosis variables available, which are not shown at any output, but can be accessed from the function block instance.

These additional diagnosis variables can be accessed by opening the function block instance or through the block visualization “VisuDrvModbusRTUBroadcast”.

- iWriteErrCnt: number of errors in write jobs since Enable = TRUE.
- wLastWriteErno: holds the error number of the last executed write job.

---

For all drives, which are connected to same Modbus RTU line, one instance of broadcast block DrvModbusRtuBroadcast is enough and it must be connected to same LineToken ofDrvModbusRtu function blocks which are used for communication between PLC and each drive on Modbus RTU line. All those communication function blocks of one Modbus RTU line must be linked together via one variable of type ModRtuTokenType, connected to the InOut LineToken. Via this variable the Modbus token is passed to the next drive / device, so only one drive / device at a time is communicating with the PLC.
All the drives should be configured either in Classic Profile or Enhanced Profile and accordingly the function block DrvModbusRtuBroadcast should be parameterized. Mix of profile with few drives in Classic and few drives in Enhanced should not be used when using DrvModbusRtuBroadcast block, if using such configuration along with DrvModbusRtuBroadcast may lead to incorrect operation.

If the user changes drive profile while drive is online with PLC, function block outputs may give wrong indication.

The Modbus RTU broadcast job is sent to all devices on the same physical Modbus RTU line.

Therefore, if other Modbus devices than ACS / DCS drives are connected to the same line using the ModRtuToken communication block it’s highly recommended not to use the DrvModbusRtuBroadcast function block.

This might only be used, if the user is aware about the behavior of the connected devices if they receive the Modbus broadcast job.

If a Modbus RTU broadcast job is sent to access a register in the drive which has no valid mapping information then Modbus broadcast job is not aborted but will just send out the broadcast message without any error in the function block. This broadcast message is ignored by drives which have no valid mapping information.

Therefore, the drive parameters in FBA DATA OUT have to be configured according to the used 'NvarWrite' input number respectively.
## Drive parameter settings

<table>
<thead>
<tr>
<th>Settings in the drive according to AC500 configuration</th>
<th>ACS380, ACS480, ACS580, ACH580, ACQ580, ACS880, ACSM1, DCS880</th>
<th>DCS550, DCS800</th>
<th>ACS380, ACS480, ACS580, ACH580, ACQ580, ACS880, DCS880</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication module</td>
<td>FSCA-01</td>
<td>RMB-01</td>
<td>Embedded fieldbus</td>
</tr>
<tr>
<td>Fieldbus activation = Modbus / RS-485 comm</td>
<td>50.01</td>
<td>98.02</td>
<td>58.01</td>
</tr>
<tr>
<td>FBA A Comm loss func</td>
<td>50.02</td>
<td>30.35</td>
<td>50.02</td>
</tr>
<tr>
<td>Slave number</td>
<td>51.03</td>
<td>51.02</td>
<td>58.03</td>
</tr>
<tr>
<td>Transmission rate</td>
<td>51.04</td>
<td>51.03</td>
<td>58.04</td>
</tr>
<tr>
<td>Parity</td>
<td>51.05</td>
<td>51.05</td>
<td>58.05</td>
</tr>
<tr>
<td>Protocol / Profile = ABB Classic / ABB Enhanced</td>
<td>51.02</td>
<td>51.16</td>
<td></td>
</tr>
<tr>
<td>Mapping of control word, Modbus reg 400001</td>
<td>Fix</td>
<td>Fix</td>
<td>58.101</td>
</tr>
<tr>
<td>Mapping of reference value 1, Modbus reg 400002</td>
<td>Fix</td>
<td>Fix</td>
<td>58.102</td>
</tr>
<tr>
<td>Mapping of reference value 2, Modbus reg 400003</td>
<td>Fix</td>
<td>Fix</td>
<td>58.103</td>
</tr>
<tr>
<td>Mapping of status word, Modbus reg 400004</td>
<td>Fix</td>
<td>Fix</td>
<td>58.104</td>
</tr>
<tr>
<td>Mapping of actual value 1, Modbus reg 400005</td>
<td>Fix</td>
<td>Fix</td>
<td>58.105</td>
</tr>
<tr>
<td>Mapping of actual value 2, Modbus reg 400006</td>
<td>Fix</td>
<td>Fix</td>
<td>58.106</td>
</tr>
<tr>
<td>Timeout mode = None (0) or Any Message (1), but not Ctrl write (2) as these values are only written after changes</td>
<td>51.07</td>
<td></td>
<td>58.15</td>
</tr>
<tr>
<td>Modbus timeout. Depending on timeout mode. Value in 100 ms</td>
<td>58.17</td>
<td></td>
<td>58.16</td>
</tr>
<tr>
<td>Refresh settings in drive</td>
<td>51.27</td>
<td>51.27</td>
<td>58.06</td>
</tr>
</tbody>
</table>

---

- Please refer the respective drive/fieldbus module manual for the parameter settings if the drive setting is not mentioned in above table.
- ACS drive parameters are only saved temporarily, if changed via fieldbus. To make these changes permanent in the drive the special parameter "PARAMETER SAVE" must be set.

  Please see also drive manuals which parameter must be set.

  For ACS380, ACS480, ACS580, ACH580, ACQ580, ACS880 and DCS880 – Par 96.07 = 1
  For ACSM1, DCS800 and DCS550 – Par 16.06 = 1
The function block 'DrvModbusReadWrite23' reads and writes one or more parameters of the drive via DriveData connected to Modbus TCP / Modbus RTU communication blocks with Modbus function code FCT = 23. This function block internally calls DrvModbusWrite to execute ReadWrite job with FCT = 23, used along with the internal structure for Fct23, DrvModFct23Type.

The number of parameters to be read is specified at the input 'NvarRead'. The first address for read operation is specified at the input 'PrmNumRead'. The values of the data are stored in the PLC memory area, defined at the input 'DataRead'.

The number of parameters to be written is specified at the input 'NvarWrite'. The first address for write operation is specified at the input 'PrmNumWrite'. The values of the data that should be written must be stored in the PLC memory area, defined at the input 'DataWrite'.

To start a new ReadWrite job the input Execute must be set from FALSE to TRUE (edge sensitive). The Modbus job is started from the communication block DrvModbusTcp or DrvModbusRtu which is connected to the same DriveData variable. It uses the Modbus function code 23 (Read and write n words). The drive (Modbus device) to which the parameter is written is specified at the Communication Block.

The values in the PLC memory area are updated when the ReadWrite job was performed without error. The ReadWrite job has been performed without error if JobDone = TRUE and ModMastErrorAct = FALSE.

If the Modbus job was finished with an error, the output ModMastErrorAct is set for one cycle. The Error ID returned by the Modbus job is shown at the output ModMastErrorIDLast. The output ModMastErrorIDLast will show that last Error ID until the input Execute is set from TRUE to FALSE.

After termination of this job, even if it was not successful, a next ReadWrite job can once again only be started with a rising edge at 'Execute' input.

Drive parameters are only saved temporarily, if changed via fieldbus. To make these changes permanent in the drive the special parameter "PARAMETER SAVE" must be set.

Please see drive manuals for the parameter details.

For ACS380, ACS480, ACS580, ACH580, ACQ580, ACS880 and DCS880 – Par 96.07 = 1

For ACSM1, DCS800 and DCS550 – Par 16.06 = 1
The function block “DrvControlModbusEng” is designed for user specific control of the drive by setting the control word (CW) by the user itself in the program. Therefore, the user should have a detailed knowledge of the ABB drives profile handling.

The reference and actual values must be given in fieldbus equivalent, e.g. range -20000 ... +20000.

Inputs “RefValue1”, “RefValue2” and the generated control word are written to the “DriveData” variable which transfers these values to a communication function block, e.g. “DrvModbusRtu”, “DrvModbusTcp” or “DrvModbusRtuBroadcast” communication function block writes to the drive. In the same way “ActValue1”, “ActValue2” and the status word are transferred from the communication function block to the “DrvControlModbusEng” block, where they are written to the outputs.

The control word can be generated in 2 ways.

First way is to set the single bits of the control word separately at the inputs “Off1”, “Off2”… “ControlWordB15” while the input “UseControlWord” = FALSE.

Second way is to set the input “UseControlWord” = TRUE and write the control word as a whole word directly to the input control word. The generated control word is written to the “DriveData” variable and for diagnosis purpose also available at output “UsedControlWord”.

The input and output names of the bits in control word and status word reflect the functions used with ABB Drive Profile. So the block should be used with ABB Drives Profil setting in the drive.

The function block does not execute any functionality except data transfer to and from the “DriveData” variable. There is no special drive parameter setting necessary to use this block.

The programmer using this block should have a detailed understanding of how to set the control word according to the status word and the description of the used drive.

For standard speed and torque control application it is recommended to use the “DrvControlModbusACS” instead.
The function block “DrvControlCiA402” is used for the control of ABB ACS Drive or non-ABB drives from AC500 using CANCiA402 Profile. The CANopen CiA402 function block and visualization from the library can also be used for the 3rd party drives which comply to the CANopen CiA402 Profile.
**DrvPNRead**

Function block “DrvPNRead” reads maximum 37 parameters from the drive in a single DPV1 query. The number of parameters to be read is specified at the input Nvar.

Parameters to read from the drive are specified at the Data input. “DrvPbPnPrmDpv1DataType” structure must be declared to a variable and connected to Data input using ADR. This structure contains the group, index, which must be given to the variable. Read parameter type and values are stored in the same variable.

“DrvPdPrmDpv1DataType” structure has the following array elements:

- **abyPrmGroup**: Array of 37 WORD for specifying parameter group.
- **abyPrmIndex**: Array of 37 WORD for specifying parameter index.
- **abyPrmType**: Array of 37 DRV_PDRIVE_PRM_TYPE. READ parameter data type will be available here. For details refer to DRV_PDRIVE_PRM_TYPE. If a type is set here at the start, it can be compared with the type read from the drive if the compare input is TRUE.
- **adwPrmValue**: Array of 37 DWORD. Read parameter value will be available here. If a value is set at the start, it can be compared with the value read from the drive if the compare input is TRUE.

**Read errors:**

If the drive rejects to read a specific parameter, it returns the error code DRV_ERROR_PRM (16#44) in the corresponding abyPrmType element and a more specific error value in the corresponding adwPrmValue element.

The number of elements with errors from the drive are given at the output “NumPrmErrors”. The output “PrmErrCmpValues” gives an array, which contains the more specific error values in the elements (index). This can be used to quickly identify the erroneous elements.

**Compare input:**

As the “DrvPnWrite” function block does not return an error in case a parameter in the drive could not be written correctly it is recommended to verify the writing.

This can be done with the call of this function block “DrvPNRead” if the same parameters, types and values are connected to the DATA input (use the same struct as for the writing), and the input “Compare” is set to TRUE.

Then the types and values of the connected struct are copied at the rising edge of execute inputs and compared with the returned types and values from the drive.

In case of a difference this is set into the corresponding element of the output array “PrmErrCmpValues” with the possible three error codes DRV_CMP_DIFF_TYPE, DRV_CMP_DIFF_VALUE or DRV_CMP_DIFF_TYPE_AND_VALUE.

**Mode input:**

- **Mode = 16#00 =>** Read direct variables and parameters via an Fxxx module, e.g. FENA-21 or FPNO-21. Group and Index have to be used as in the “Data.awPrmGroup” and “Data.awPrmIndex” array. (Number of Elements in the PN Data block is set to 16#01)
- **Mode = 16#01 =>** Read direct variables and parameters via an Rxxx module, e.g. RETA-21 for ACS800 or DCS500. Group and Index have to be used as in the “Data.awPrmGroup” and “Data.awPrmIndex” array. (Number of Elements in the PN Data block is set to 16#01)
- **Mode = 16#1x =>** to be used to access “PROFIDrive” parameters with Attribute = 16#10 (Value) and Number of Elements = x.
● Mode = 16#2x => to be used to access “PROFIDrive” parameters with Attribute = 16#20 (Description) and Number of Elements = x. (Not supported with Fxxx or Rxxx modules)
● Mode = 16#3x => to be used to access PROFIDrive parameters with Attribute = 16#30 (Text) and Number of Elements = x. (Not supported with Fxxx or Rxxx modules)

For “PROFIDrive” parameters using Mode = 16#1x, 16#2x or 16#3x the Number of Elements = x is used for all the parameters in the Data array.

**DrvPnWrite**

Function block “DrvPnRead” reads maximum 37 parameters from the drive in a single DPV1 query. The number of parameters to be written is specified at the input Nvar.

Another limit while using the “DrvPnWrite” function block is, it can process only up to 240-byte data in one request or 37 drive parameters whichever is lower. If the write data length is more than 240 bytes, the function block generates an error code WRITE_PACKAGE_SIZE_TOO_LONG 16#0004. At the output “PackageSize” the precalculated size of the request is shown.

Parameters to write to the drive are specified at the data input. “DrvPdPrmDpv1DataType” structure must be declared to a variable and connected to data input using ADR.

“DrvPdPrmDpv1DataType” structure has the following array elements:

- “abyPrmGroup”: Array of 37 WORD for specifying parameter group.
- “abyPrmIndex”: Array of 37 WORD for specifying parameter index.
- “abyPrmType”: Array of 37 DRV_PDRIVE_PRM_TYPE for specifying parameter type, refer the respective drives manual for parameter data type and enter the respective enumeration. For details about enumeration refer DRV_PDRIVE_PRM_TYPE in the library.
- “adwPrmValue”: Array of 37 DWORD for specifying parameter value that should be written.

The values in the structure area are updated when the write job was performed without error. This is indicated by Done=TRUE.

**Mode input:**

- Mode = 16#00 => Write direct variables and parameters via an Fxxx module, e.g. FENA-21 or FPNO-21. Group and Index have to be used as in the “Data.awPrmGroup” and “Data.awPrmIndex” array. (Number of Elements in the PN Data block is set to 16#01)
- Mode = 16#01 => Write direct variables and parameters via an Rxxx module, e.g. RETA-21 for ACS800 or DCS500. Group and Index have to be used as in the “Data.awPrmGroup” and “Data.awPrmIndex” array. (Number of Elements in the PN Data block is set to 16#01)
- Mode = 16#1x => to be used to access “PROFIDrive” parameters with Attribute = 16#10 (Value) and Number of Elements = x.
- Mode = 16#2x => to be used to access “PROFIDrive” parameters with Attribute = 16#20 (Description) and Number of Elements = x. (Not supported with Fxxx or Rxxx modules)
- Mode = 16#3x => to be used to access PROFIDrive parameters with Attribute = 16#30 (Text) and Number of Elements = x. (Not supported with Fxxx or Rxxx modules)

For “PROFIDrive” parameters using Mode = 16#1x, 16#2x or 16#3x the Number of Elements = x is used for ALL the parameters in the Data array.
6.5.4.4.2 **Function: DrvModPara32Bit**

Creates the Modbus address for 32-bit parameters of the ACSxxx drives.

To access 32-bit parameters in ACSxxx drives using Modbus a special address calculation must be performed.

This block calculates the 6-digit address out of the 5-digit address used for 16-bit parameters.

Input is the 5-digit address: GGii, where GG = parameter group and ii = the index.

E.g. Par 12.02 ➨ address = 1202.

Output is the calculated address for 32-bit parameters according to the following rule:

\[ \text{DrvModPara32Bit} = 20000 + (200 \times GG) + (2 \times ii) \]

E.g. Par. 14.54 ➨ output = 22908

This output can be connected directly to the input "PrmNum" of one of the blocks DrvModbusRead or DrvModbusWrite or inputs “PrmNumRead” and “PrmNumWrite” of the block DrvModbusReadWrite23.

6.5.4.4.3 **Structure: DrvDataType**

Structure DrvDataType is used for the DriveData variable to exchange the data for one drive.

Structure DrvDataType is used for the DriveData variable which must be connected to all function blocks related to the same drive.

Besides the element "sName" all variables should not be written by the user directly. They are read and written within the function blocks. The DrvDataType contains some more internal, invisible variables which are used for internal functionality and not meant for user access.

The following table shows the visible variables of DrvDataType.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Data Type</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>wStatusWord</td>
<td>WORD</td>
<td>0</td>
<td>Actual status word from drive</td>
</tr>
<tr>
<td>iActValue1</td>
<td>INT</td>
<td>0</td>
<td>Actual value1 from drive – mostly equal speed</td>
</tr>
<tr>
<td>iActValue2</td>
<td>INT</td>
<td>0</td>
<td>Actual value2 from drive – mapping is made in drive configuration</td>
</tr>
<tr>
<td>wControlWord</td>
<td>WORD</td>
<td>0</td>
<td>Control word to drive</td>
</tr>
<tr>
<td>iRefValue1</td>
<td>INT</td>
<td>0</td>
<td>Reference value1 to drive – mostly speed reference</td>
</tr>
<tr>
<td>iRefValue2</td>
<td>INT</td>
<td>0</td>
<td>Reference value2 to drive – mapping is made in drive configuration</td>
</tr>
<tr>
<td>xOnline</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Connection established – set in Modbus communication function block after successful reading and writing one Modbus job</td>
</tr>
<tr>
<td>xCtrlBlockUsedf</td>
<td>BOOL</td>
<td>FALSE</td>
<td>A control block is used to generate the control word, ref1 and ref2 values</td>
</tr>
<tr>
<td>sName</td>
<td>STRING</td>
<td>‘Default Drive Name’</td>
<td>Name for drive, which can be set by user directly to DriveData variable</td>
</tr>
</tbody>
</table>
6.5.4.4 Structure: DrvPdPrmDpv1DataType

Structure “DrvPdPrmDpv1DataType” is required to exchange the data between AC500 and drives using the PROFINET communication. “DrvPdPrmDpv1DataType” structure must be declared to a variable and connected to data input using ADR in the “DrvPnRead” or “DrvPnWrite” function blocks.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Data Type</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>awPmGroup</td>
<td>ARRAY [1..37] OF WORD</td>
<td>[37(0)]</td>
<td>ABB drive Group number from where the parameter to read or write - Profidrive Parameter Index.</td>
</tr>
<tr>
<td>awPmIndex</td>
<td>ARRAY [1..37] OF WORD</td>
<td>[37(0)]</td>
<td>ABB drive index number from where the parameter to read or write - Profidrive Parameter Subindex.</td>
</tr>
<tr>
<td>abyPmType</td>
<td>ARRAY [1..37] OF DRV_PDRI VE_PRM_TYP</td>
<td>[37(DRV_EMP TY_PRM)]</td>
<td>Parameter Type in array. While using read block it will act as an output (and input at start of block with Compare=TRUE). While using write block it will act as an input.</td>
</tr>
<tr>
<td>adwPmValue</td>
<td>ARRAY [1..37] OF DWORD</td>
<td>[37(0)]</td>
<td>Parameter Value in array. While using read block it will act as an output (and input at start of block with Compare=TRUE). While using write block it will act as an input.</td>
</tr>
</tbody>
</table>

6.5.4.5 Limits for the data read and write between AC500 and drives

The below table defines the limits for the reading of data from the drive and limits for writing data to drives from AC500 with cyclic data exchange.

If fieldbus adapter Plug (FBA) is used, then parameter group FBA DATA IN (e.g. 52) and group FBA DATA OUT (e.g. 53) is accessed in the drive. For the embedded fieldbus (EFB) parameters are used in EFB group (e.g. 58).

According to the table below, limits are defined for the variables ‘NVarRead’, ‘NVarWrite’ in DrvModbusRtu and DrvModbusTcp blocks.

<table>
<thead>
<tr>
<th>Drive</th>
<th>Fieldbus Adapter (FBA)</th>
<th>Embedded Fieldbus (EFB)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Data In (Group 52)</td>
<td>Data Out (Group 53)</td>
</tr>
<tr>
<td>ACS380</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>ACS480</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>ACS580</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>ACQ580</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>ACH580</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>ACS880</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>ACSM1</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>DCS550</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DCS800</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DCS880</td>
<td>12</td>
<td>12</td>
</tr>
</tbody>
</table>
6.5.5 Application libraries

Application libraries can be used in AC500 V3 PLCs. The requirements for the use of the function blocks of the application libraries and information and prerequisites for the general handling of application libraries are described in the application examples:

HTTP library

In order to be able to use the PLC as a client for web services, the HTTP function block library can be used. Setup and use of the HTTP library are described in the application example AC500 Webservices - HTTP Function Block Library.

MySQL library

With the help of the MySQL function block library, MySQL databases can be used to store and access AC500 V3 data. Setup and use are described in an application example.

MSSQL library

With the help of the MSSQL function block library, MSSQL databases can be used to store and access AC500 V3 data. Setup and use are described in an application example.

6.5.6 BACnet-BC

6.5.6.1 Introduction to BACnet

BACnet is a standardized data communication protocol for Building Automation and Control networks as defined in the ANSI/ASHRAE standard 135 and ISO 16484-5.

The advantage is interoperability between devices of different vendors.

The BACnet protocol defines services to allow communication between devices. Examples include 'Who is', 'I am', 'Who has' and 'I have' for device and object search and identification, "Read Property" and "Write Property" for the exchange of data, up to more complex services for alarm and event management, scheduling and trending.

The BACnet protocol defines a number of object types on which the services operate. Each object is characterized by its properties.

The BACnet objects are combined in a BACnet device. A BACnet device represents the functionality of a physical device.

More background information and introduction can be found here:

http://www.bacnet.org
http://www.bacnet.org/Bibliography

6.5.6.2 AC500 and BACnet

A BACnet device can be described by its “BACnet Interoperability Building Blocks” (BIBB)s, which are needed to establish services. They are grouped in different areas:

- "Data Sharing" (DS)
- "Alarm and Event Management" (AE)
- "Scheduling" (SCHED)
- "Trending" (T)
- "Device and Network Management" (DM)

"Data Sharing" for example contains two BIBBs which are needed for the “Service Read Property”:

- Client side: DS-RP-A (Data Sharing - Read Property - A)
- Server side: DS-RP-B (Data Sharing - Read Property - B)

The BACnet standard defines profiles by the minimum required BIBBs, see table below.

"BACnet Simple Sensor" (B-SS) is the simplest one, only containing one BIBB. More complex devices contain more BIBBs (from right to left).
The AC500 V2 supports BIBBs qualifying it as "BACnet Application Specific Controller" (B-ASC), by installing the BACnet B-ASC library.

AC500 V3 supports many more BIBBs qualifying it as "BACnet Building Controller" (B-BC), which contains a server (all BIBBs ending with -B) and a client (all BIBBs ending with -A). In fact, the AC500 contains some more BIBBs. All BIBBs under B-BC in the table above, plus:

- DS-COV-A, -B (Change of Value-A, -B)
- DS-COVP-A, -B (Change of Value of Properties-A, -B)
- AE-N-E-B (Alarm and Event-Notification External-B)
- AE-ASUM-B (Alarm and Event-Alarm Summary-B)
- SCHED-I-B (Scheduling-Internal-B)
- T-VMTE-B (Viewing and Modifying Trends External-B)
- DM-TS-B (Time Synchronization-B)
- DM-UTC-B (UTC Time Synchronization-B)
- DM-MTS-A (Manual Time Synchronization-A)
- DM-LM-B (List Manipulation-B)
- DM-OCD-B (Object Creation and Deletion-B)
- NM-BBMDC-B (BBMD Configuration-B)

A list with all details can be found in the Automation Builder pdf document ABB-B-BC-PICS-AC500_V3.pdf. Direction: Help/Project examples/Examples.

The figure below shows a typical application for an AC500 V3, acting as B-BC.
A drive with several actuators and sensors is acting as B-ASC, for example providing a temperature value as "Analog Input" (AI) object on the MS/TP network.

AC500 B-BC as client can read this temperature value, perform some processing (scaling, limit check) and on the server side provide the processed value as "Analog Value" (AV) object and as "Trend" object on the IP network. Higher level clients like BACnet Operator Workstation (B-OWS) can access the processed objects "Analog Value" and "Trend" for supervision.

The following chapters describe the possible applications and how to configure an AC500 V3 as B-BC.

6.5.6.3 AC500 V3 as BACnet Building Controller (B-BC)

6.5.6.3.1 General

The BACnet integration into CODESYS implements the ANSI/ASHRAE standard 135-2012 (ISO 16484-5) protocol revision 14 and is based on the AMEV AS-A and AS-B standards. Integration allows access to the properties of BACnet objects and the configuration parameters of a BACnet device by means of an IEC application. You can program a dynamic BACnet configuration and have access to the BACnet functions in the BACnet network by reading and writing BACnet object properties.

6.5.6.3.2 Supported BACnet networks

BACnet can run on different local area network types. The AC500 B-BC supports the following ones:

- MS/TP (Master Slave / Token Passing), based on serial RS-485
- BACnet IP, based on Ethernet / UDP / IP
Different networks can be combined to one common “BACnet internetwork”. The figure above shows an example of some BACnet devices in one “BACnet internetwork”. Each device has a device ID (10 to 15) which must be unique on application level. Services on application level (e.g. read or write request) are working with these device IDs and need no addressing information of the lower levels.

The example “BACnet internetwork” consists of different BACnet networks:
- BACnet MS/TP network connecting device 10, 11 and 12
- BACnet IP network (UDP port 47808), consisting of one IP subnets with IP range 192.168.0.x, connecting device 12, 13 and 14
- BACnet IP network (UDP port 47809), consisting of one IP subnet with IP range 192.168.2.x, connecting device 14 and 15

Addressing in a BACnet network is done through datalinks which must have a unique BACnet MAC address (which is different to an Ethernet MAC address).
- In a MS/TP network the BACnet MAC address is just one octet (1, 2, 3 in the example).
- In an IP network the BACnet MAC address is the combination of the IP address and the UDP port number (for example 192.168.0.130.47808 for device 13). The following 16 UDP ports are reserved for BACnet: BAC0 (=47808 decimal) to BACF.

To form a common “BACnet internetwork” the single BACnet networks must be combined by BACnet routers. AC500 can act as a BACnet router between BACnet MS/TP and IP networks (device 12 in the figure above) or between two different BACnet IP networks (device 14).

Two IP subnets using the same UDP ports can be combined to one BACnet IP network with an internet router.

The problem is that internet routers block local broadcast messages, which are required for BACnet communication. This can be solved by “Broadcast Management Devices” (BBDM). AC500 V3 can be configured as BBDM. In the figure above the devices 12 and 14 should be configured as BBDM in order to enable the BACnet communication across the internet router.

An alternative is to configure AC500 V3 as foreign BACnet device if an IP subnet contains no BBDM device to pass broadcast messages over internet routers.

Configuring the AC500 as BBDM or foreign device is described in § Chapter 6.5.6.3.5.5 “Configuration of datalinks ” on page 3844.
### 6.5.6.3.3 Supported objects and properties

Communication with BACnet is done through objects and properties. The AC500 B-BC server of the figure below is represented as a BACnet device object with “ID 12”. The device contains more objects like the Analog Input object, representing the input of a temperature measurement device. An object contains several properties, like “ID, Description, Present Value, Unit” etc.

Further possible objects of an AC500 B-BC are:
- “Binary Input” for example from connected to a switch
- “Analog / Binary Output” for actuators
- “Analog / Binary Values” for local variables
- “Calender”
- “Schedule”
- “Trend Log”
- ...

A list with all details can be found in the Automation Builder pdf document ABB-B-BC-PICS-AC500_V3.pdf. Help/Project examples/.

![Fig. 286: BACnet objects, properties, services and BIBBs](image)

### 6.5.6.3.4 Supported BIBBs and services

While objects and properties describe which data are communicated, the communication itself is done with services between clients and servers. A certain service can only be executed if client and server have the related BIBBs. The Fig. 286 BACnet objects, properties, services and BIBBs shows a simple “Service Read Property” which is possible because the client on the right supports DS-RP-A and the server on the left supports DS-RP-B. The service is executed in two steps:

1. The client initiates a confirmed request “Read Property”, asking for the present value of the “Analog Input” of object with “ID 1010”.
2. The server answers with an acknowledge, sending the present value which is 21,89°C in the example.

A list of all supported BIBBs and services of AC500 V3 is given in the Automation Builder pdf document ABB-B-BC-PICS-AC500_V3.pdf. Help/Project examples/Examples.
6.5.6.3.5 BACnet configuration in Automation Builder

General

To act as a BACnet server or client, the AC500 must be configured accordingly. The figure below shows the basic configuration of a BACnet server (left) and a BACnet server with client functionality (right). It is also possible to have server and client functionality in parallel.

Following objects need to be created:

1. “BACnet Server” root object. This is the root object for the server functionality, as well as for the client functionality. It is mandatory, even if only client functionality is required.  
   “Chapter 6.5.6.3.5.2 “Configuration of BACnet server root object” on page 3838

2. BACnet server objects, for example “BACnet Analog Input” Temperature. The properties of the objects must be controlled (written or read) by the PLC logic.  
   “Chapter 6.5.6.3.5.3 “Adding BACnet server objects” on page 3840

3. BACnet client objects, represented by a different symbol. For example, “BACnet Client Read Property”. The functionality of the client objects must be programmed in the PLC logic. Inserting the client objects below the server is optional. It is also possible to instantiate the objects only in a PLC logic.  
   “Chapter 6.5.6.3.5.4 “Adding BACnet client functionality” on page 3841

4. Datalink for the physical layer. This object links the physical interface (Ethernet IP or serial MS/TP) to the “BACnet Server” object. In the example above the IP address of ETH1 is automatically retrieved by inserting the “BACnet IP datalink” below the ETH1 port.  
   “Configuration of an IP datalink” on page 3845. For MS/TP refer to  “Configuration of an MS/TP datalink” on page 3844.

Configuration of BACnet server root object

1. Create an empty project with an AC500 V3 CPU type and call it for example “Device_12”.

2. Insert a “BACnet Server” object below the interfaces object in the device tree.
3. Set the device `InstanceNumber` in the “BACnet Parameters” of the “BACnet Server”, e.g. to 12 and the `InstanceName` to `Device_12` (according to Fig. 286 BACnet objects, properties, services and BIBBs).

4. Add a datalink, IP or MS/TP. In the example an IP datalink is inserted below `ETH1`. Default parameters are sufficient if only one datalink is used.  
   “Configuration of an IP datalink” on page 3845

5. Build the project, download to the PLC and set it to [RUN]. The status of the “BACnet Server” should be green (running). If not, please ensure that you have installed the runtime license BACnet Protocol B-BC Runtime, verifiable by right-click on the PLC node and select [Show license information] from the runtime licensing menu. The project is scanned for required licenses. If you are logged in to a PLC, then the licenses available on the PLC are displayed. A missing required license is highlighted.
   “Chapter 6.3.2.2.2 “PLC runtime licensing” on page 1446"
6. Start any BACnet client to find the server, for example Inneasoft BACnet Explorer.

Adding BACnet server objects

Goal is to publish an analog value as BACnet server object. This example is according to Fig. 286 BACnet objects, properties, services and BIBBs, left part containing a temperature value.

1. Configure a “BACnet Server” root object according to Chapter 6.5.6.3.5.2 “Configuration of BACnet server root object” on page 3838.

2. Add a “BACnet Analog Input” object below the “BACnet Server”.

3. Rename it to Temperature, adjust the parameters: InstanceNumber: 1010, Description: Temperature, Units: UNIT DEGREES C.
4. The present value of the objects Temperature needs to be fed with the value from the real temperature device. Alternatively, a simple PLC program can simulate this value.

5. Download the program and observe the temperature value in the BACnet client.

Adding BACnet client functionality

Goal is to configure a second AC500 controller as BACnet client which reads an analog value from a server. This example is according to Fig. 286 BACnet objects, properties, services and BIBBs, right part.

1. Add a new controller and configure a “BACnet Server” root object according to Chapter 6.5.6.3.5.2 “Configuration of BACnet server root object ” on page 3838.

2. Set InstanceNumber to 14 and InstanceName to Device 14.
3. In addition to BACnet objects, BACnet clients can also be inserted as devices under a “BACnet Server”. Add a “BACnet Client Read Property” below the “BACnet Server” node.

4. The created object “BACnet Client Read Property” generates a function block instance which can be used to program the client read functionality. The figure below shows a simple example.

In line 1-5 of the code part the function block is called with the following parameter:

- Device ID of the server to read from (12)  
- Object ID of the object to read from (1010 for the “Analog Input”)
- Object type (“Analog Input”)
- Property to read (“present value”)
- triggerRead to start the read operation

When the user (or another program part) sets the variable triggerRead from FALSE to TRUE the edge triggered function block BACnet_Client_Read_Property starts operation and sends the read request to the server device. After receiving the reply from the Server, the output .xDone gets TRUE (line 8) and the temperature value can be read from the output .result (line 14).
5. Download this program to another AC500 V3 controller, which is in the same IP network as the server. Set it to run and read the temperature value by setting `triggerRead` to `TRUE`. In online mode the read temperature value can be observed in line 14.

### Alternative configuration

Unlike BACnet objects, a BACnet client does not require a complex (static) configuration, thus a client function block can be used without creating a BACnet client as device.

There is no `BACnet_Client_Read_Property` object created below the “BACnet Server”. Instead a function block `BACnet_Client_Read_Property` must be declared in the PRG (line 6 in the declaration) and initially "connected" to its “BACnet Server” in IEC-code via `RegisterToServer()`, and thus get activated (line 2 in the code) § Chapter 6.5.14 “Reference, function blocks” on page 4086.
Configuration of datalinks

For communication with other BACnet devices AC500 provides two different possibilities: MS/TP and IP.

Chapter 6.5.6.3.2 “Supported BACnet networks” on page 3835

For a non-routing device one MS/TP or IP datalink must be configured.

If more than one datalink is configured, routing between the datalinks is automatically enabled.

Configuration of an MS/TP datalink

- Add the “BACnet MS/TP COM” object below the COM port.

In fact the empty COM port is replaced by the “BACnet MS/TP COM”. By that the COM port is configured as RS-485 with fixed settings for MS/TP: No parity, 8 data bits, 1 stop bits.

- Below the “BACnet MS/TP COM” port object an “BACnet MS/TP datalink” is inserted automatically which can be configured according to the requirements.
● NetworkNumber: Use the default value 1 if no routing is required. For routing, use a unique network number in one controller.

● ConnectionType: Use the default value Master if no routing is required. For routing, use “Master – answering always postponed”.

● Baudrate can be set according to requirements in the range of from 9600 to 38400 bits/s, higher values (57600 and 115200 bits/s) are not recommended.

● DatalayerAddress: This is the MAC address as described in § Chapter 6.5.6.3.2 “Supported BACnet networks ” on page 3835. The MAC address must be unique in the MS/TP network.

● For all other parameters the default values are recommended for typical applications.

Configuration of an IP datalink

- Add a “BACnet_IP_datalink” object below the Ethernet port ETH1 or ETH2.

- NetworkNumber: Use the default value if no routing is required. For routing, use a unique network number in one controller.

- UDPport: Use the default value (47808 decimal) in the normal case. Range is possible from BAC0 (= 47808 decimal) to BACF. UDPport + IP address form the MAC address of the IP datalink as described in § Chapter 6.5.6.3.2 “Supported BACnet networks ” on page 3835. The IP address cannot be specified here. It is automatically taken from the parent Ethernet node (ETH1 or ETH2); its IP address is set in the communication settings of the CPU node, “Device_14” in the example.

- ForeignDevice and BBMD: Special configuration is only needed if an internet router is located between two BACnet devices. § Chapter 6.5.6.3.2 “Supported BACnet networks ” on page 3835

AC500 can be configured as ForeignDevice or BBMD, but not the combination of both. An example for BBDM can be found in the example folder.

Configuration of Routing

Routing enables the combination of different BACnet networks to one common “BACnet internetwork”.

§ Chapter 6.5.6.3.2 “Supported BACnet networks ” on page 3835

BACnet devices from different BACnet networks can communicate with each other.

If more than one datalink is configured in one CPU, routing between the different networks is automatically enabled. It must only be ensured that the network number is unique in one controller.

§ Chapter 6.5.6.3.2 “Supported BACnet networks ” on page 3835

For MS/TP the ConnectionType must be set to “Master – answering always postponed”. An example for routing can be found in the example folder.

Time synchronisation

The BACnet clients expect to receive the local time. Currently the AC500 V3 does not distinguish between UTC time and local time and its time zone is set to 0. This will be improved in the near future. In the meantime, it is recommended to store the local time (green color in the following figure) in the AC500 as a workaround.
Using this workaround, the following time sync mechanisms can be used:

- Set local time from Automation Builder Tab "PLC Shell":
  Set the time by the command "time hh:mm:ss"

- Read the local time from the Automation Builder Tab "Statistics":
  "Current PLC Date and time" shows the PLC time as local time without conversion, if the tab "Show PLC time in UTC" is enabled.

For storing the local time in AC500, do not use the button [Set PLC to PC Time] (Tab "Statistics"), since this is always converting from local time to UTC time.
6.5.6.3.6 Package content

General

The BACnet package PS5607-BACnet-BC can be installed with the Installation Manager and contains the following components:

- BACnet runtime component, part of AC500 firmware.
- Automation Builder package: CODESYS BACnet
  - BACnet plug-in component
  - Device descriptions for "BACnet Server", BACnet objects, BACnet client and datalinks

Example folder

- Example folder
  - Examples and example documentation
  - Datasheet and FAQ
    BACnet Protocol Implementation Conformance Statement (PICS), acting as a datasheet, describing all BACnet objects, services and communication capabilities.
    BACnet Conformance Certificate
    FAQ – Frequently Asked Questions, including AC500 specific information, performance and limit

BACnet libraries

The IEC library CmpBACnet represents the integration of the BACnet stack into a CODESYS IEC environment and provides the BACnet data types as well as the BACStack methods. The sole use of the IEC library CmpBACnet (without the BACnet and BACnetDefaultImpl libraries) would result in complex and lengthy IEC application code.

The BACnet library simplifies BACnet application development considerably as compared to the sole use of CmpBACnet, especially in the following areas:

- Starting and stopping the BACnet stack
- Using BACnet server objects and their properties
- Triggering asynchronous requests (mainly client service requests) and processing the request transaction
- Processing of callbacks from the BACnet stack (see IBACnetEventConsumer) and distributing the callbacks to multiple receivers in the application

Furthermore, the BACnet library provides a plug-in mechanism (BACnetServerPlugin) for extending certain aspects of the BACnet library. BACnetServerPlugin is the basis for the BACnetDefaultImpl library.

The BACnetDefaultImpl library is used for the additional simplification of BACnet application development. The BACnet standard ASHRAE 135 leaves some aspects of the practical use of BACnet open. The most notable examples include the following:

- Persistence of server objects
- Storage and persistence of Trend Log, Trend Log Multiple, and Event Log entries
- Update of the date/time information of the device object
The IEC library BACnet is intended as a layer over the IEC library CmpBACnet. However, the layer does not hide the library because this would require the BACnet library to have "facade" functions for CmpBACnet functions. These facade functions would result in larger application code and increased runtime requirements. This is difficult for the PLC to accept. For this reason, it is necessary to know when elements from the BACnet library or CmpBACnet library are to be used.

General rules:

- Starting and stopping the BACnet stack
  
  Always use BACnetServer.StartBACnetStack and BACnetServer.StopBACnetStack or AutoStart. Never directly use the corresponding functions of the CmpBACnet library, such as CmpBACnet.BACnetServerInit.

- Using BACnet server objects and their properties
  
  Always use the specified function blocks in IEC-lib-BACnet, such as BACnetAnalogValue. Never directly use the corresponding functions of the BACnet library, such as CmpBACnet.BACnetStorePropertyInstance.

- Triggering of asynchronous requests
  
  Always use the specified client function blocks of the BACnet library, such as BACnetClientReadProperty. Never directly use the corresponding functions of the CmpBACnet library, such as CmpBACnet.BACnetReadProperty. All functions of the CmpBACnet library that require a BACnetAsyncTransactionToken belong to this category and should never be used directly.

- Processing of callbacks from the BACnet stack and distributing the callbacks to multiple receivers in the application
  
  Always use IBACnetEventConsumer and BACnetServer.RegisterHook/UnregisterHook/RegisterCallback/UnregisterCallback. Never directly use the corresponding functions of the CmpBACnet library, such as CmpBACnet.BACnetSetHook or CmpBACnet.BACnetSetCallback.

When is it appropriate and safe to directly call the functions of the CmpBACnet library?

Basically, it is only necessary to call functions of CmpBACnet directly when a corresponding functionality is not provided in the BACnet library. Check the BACnet library first before trying to use CmpBACnet directly. It is possible to use blocking functions in CmpBACnet, such as BACnet*CbCompletion, BACnetIam(Ex), or BACnetIHAVE(Ex), BACnetUnconf*.

Most often, you will use BACnet*CbCompletion to implement your specific IBACnetEventConsumer.BACnetEventCallback. But first check whether or not the BACnetDefaultImpl library already contains an appropriate standard implementation.

Application examples

- AC500_V3_BACnet_B-BC_Example_ABxxx.project including simple read and write operations between client and server.
  
  Use case 1: AC500 as BACnet client, read and write (with priority)
  Use case 2: AC500 as "BACnet Server", publish the analog value

- AC500_V3_BACnet_B-BC_Example_Routing_ABxxx.project

- Examples from 3S, including

  - Read and write operations with more options, notification class, calendar, scheduler, etc.
  - Device discovery
  - BBMD
  - Persistence
  - Logging
  - Routing
6.5.7 CAA library guidelines

With the help of the CAA library, different use cases for dealing with AC500 PLCs can be programmed. Function block descriptions for the CAA library can be found in the Library Manager. The guidelines for the CAA libraries correspond to the general guidelines for library development. For a detailed description see help chapter Guidelines for Library Development.

By using the CSV read function, information from CSV or other formatted DAT files can be read into Structured Text. This use case is described in an application example.

Procedures how to handle files with the CAA library in order to write, read and append files are given in an application example.

6.5.8 Data Logger Library

6.5.8.1 Overview

The AC500 “Data Logger Library” package (PS5609-Log) contains the:

- “DataLogger” and “DataLoggerEco” library (licensed)
- “Multilogger” library (technology preview, documentation in the examples folder)

The data logging function block library (“DataLogger” and “DataLoggerEco”) contains 5 function blocks for the purpose of advanced time-stamped data logging for different use cases.

In the most challenging use case, it also can be called buffering:

The AC500 application program generates or receives data which are normally transmitted to a telecontrol system for storage (historian databases) and further processing or displaying to the end user (SCADA, reporting). Typically, these may be remote applications like water- or oil-pumping or electrification stations or solar power plants. The connection between these remote stations with an AC500 and a central SCADA/telecontrol station is not always stable (mobile or wired internet) or only sporadically connected. Sporadically connected can be by intention, e.g. to save communication costs or open ports/connections to be used with a control station only in a limited way. Still owners or even authorities often require gapless data for compliance/prove of correct operation, billing or other purposes.

- Then the data logging function blocks buffer or store data in case of a broken or intentionally interrupted connection between AC500 and the telecontrol system and automatically retrieves and resends the data once online again and/or requested, while already newer data has to be buffered in parallel.

![Diagram](image_url)

Fig. 287: Overview

1 AC500 application (remote substation)
2 Telecontrol (control station)
● The "Data Logger Library" can be also used as an event recorder. In this special mode data is continuously recorded in a ring buffer which can be read out after a certain event x (e.g. outage) in order to analyze the values especially before but also after the event x.

OR

● Data can be logged only (and on command transferred to the FTP area to be analyzed offline or taken out via the memory card).

The following figure gives an overview of the described interaction of the data logging function blocks. There is always an input function block ("Logxx_Input") needed which transfers the input data into data sets with timestamp for use by the data logger ("LogHandling"). An output function block (Logxx_Output) receives the current or retrieved data from the data logger in case of communication or further processing. The input function blocks "Logxx_Input", the function block "LogHandling" and the output function blocks "Logxx_Output" communicate via SRAM FIFOin and FIFOout areas in the memory. The SRAM FIFOin is power-fail-safe intermediate buffer and help in decoupling time wise and speeding up the necessary write/read operations on the logging file structures significantly. These read/write operations on the files are done in blocks of data sets, enabling a comparably fast interaction with the otherwise slow file system.

Fig. 288: Overview function blocks

Each data logger application requires the main function block "LogHandling", one of the input function blocks to provide data to be logged and one output function block to retrieve the data and send the data to telecontrol (SCADA).

As input and output function blocks 2 different types exist:

● For data logging of an interrupted IEC 60870 communication, the function blocks "LogIec60870_Input" and "LogIec60870_Output" are provided. The IEC 60870 data logging function blocks support the IEC data types and work internally with the standard AC500 IEC 60870 library. The IEC data logging output function block does not need special handling or control/inputs.

● For other types of general data "LogGeneric_Input" and "LogGeneric_Output" are provided. The generic data logging function blocks support an even larger variety of data types. The generic output function block needs to be handshake with for each data set, in order to retrieve the data from the data logging files. Therefore the generic function blocks can also be used to integrate the data logging into any other protocol, e.g. Modbus.

The function block "LogHandling" ensures that also several consecutive and fast interruptions can be handled without losing data. While the log file is replayed, arriving new data is stored in the SRAM FIFOin and added to the data logging files in parallel (File FIFO) if the SRAM FIFOin becomes full (during that short time the log file replay is paused). Nevertheless any data sent to a control station via a communication is always with the oldest data first (FIFO = "First In First Out").
As for normal Ethernet default setting it takes up to 30 seconds before a communication break is detected (e.g. with TCP/IP protocols the following has to be done):

- The data rate at which data might have to be buffered in case of a communication break has to be estimated and possibly minimized, especially the threshold option has to be checked carefully if used. A worst case test is advised with the application if in doubt.
- Ping mechanism should be used in the substation. This is done in the example program for the IEC logger. With this ping the interruption is detected much faster e.g. here after 1-2 seconds (can be configured in the example program - the configurable “SecureReadTime” must be considered in this context. This ensures that the time delay - before a loss of connection is detected and is compensated).

As the SRAM FIFO has to store data during this time its size limits the data rate. The SRAM FIFO size is 160 data sets (or 60 data sets on AC500-eCo). If data rate is too high, FIFO will overflow. The maximum data rate is depending on the CPU type, storage media (memory card/flash disk) and cycle time configured, and must be determined by trial and error if high.

The data rates for storing only without this detection can be much higher and depends on the CPU and memory type chosen. The data is always logged in directly readable csv format.

Chapter 6.5.8.6 “CSV file formats” on page 3856

Depending on the input function block and data type, the log file contains only one or up to 32 data variables per timestamped data set. The data logging files can be configured (up to 65k data sets per file, up to 999 consecutive log files, file name extension).

### 6.5.8.2 Operating modes

This chapter describes the different operating modes of the data logging and their behavior.

- Mode 0/1: Buffer and disposal in chronologic order.
  - Mode 0: Limited storage (keeps oldest, but stops if full).
  - Mode 1: Endless (ring buffer) operation modes (deletes oldest).
- Mode 2: Buffer and disposal via FTP, Log file(s) copied to FTP server area for further use.
- Mode 3: Events recorder, logs data before and after an event.

![Mode 0/1: Buffer and disposal in chronologic order](image)

Fig. 289: Overview Mode 0/1

Mode 0/1 is for buffering the values from the AC500 application in case of a broken or intentionally interrupted connection between AC500 and telecontrol. In the normal state 1 the values are directly sent from the FIFOin (input values from application) to FIFOout (telecontrol connection). As soon as the connection is interrupted, the data logging changes to working state 2. The values are sent to the file FIFO instead. When the file FIFO is full, the data logging is stopped (Mode 0) or the oldest data will be overwritten (Mode 1 = ringbuffer). When the connection is established again and the “ReleaseHistory” pin is triggered, the data logging changes to working state 3. It cares for disposal of the values in chronological order. The buffered values...
are written to FIFOout (working state 3a). This may take some time during which new values are coming from the application and stored into FIFOin. Before the FIFOin overflows the data logging switches to working state 3b and buffers the new values. After that it can continue with working state 3a. Only if the File FIFO is empty (all files deleted) the data logging changes back to normal state 1.

The advantage of Mode 0/1 is that all values (directly and buffered) are sent to telecontrol in strictly chronological order which is expected by most control stations (SCADA systems/historians).

If a historical value is sent to the SCADA after a current value has already been sent, the historical value is normally rejected by the SCADA.

As it takes up to 30 seconds before a communication break is detected (e.g. with TCP/IP protocols by the AC500 hardware/firmware), the data rate at which data should be logged in case of a communication break has to be calculated and limited. It therefore makes sense to use PING to detect a possible interruption in the connection. This enables an earlier detection of the connectionless state.

Mode 2: Buffer and disposal via FTP

![Mode 2 Diagram](image)

---

**Fig. 290: Overview Mode 2**

Mode 2 is also used for buffering the values from AC500 application in case of a broken connection between AC500 and telecontrol. State 1 and state 2 are similar to Mode 0/1. The difference is the disposal. When the connection is established again the data logging changes directly back to state 1 and the input values in FIFOin are directly sent to FIFOout (telecontrol connection). The buffered values in File FIFO are internally moved from disk 1 to disk 2 which can then be accessed or used by FTP (client or server). This move action can also be triggered by the command "MoveFile", or when file 1 is full. The advantage of Mode 2 is the immediate availability of the latest and all current values after an outage.

---

**Use data logging for permanent logging**

To use data logging for normal, permanent logging, set Mode = 2 and make input “BreakConnect” = “TRUE” or “Connected” = “FALSE”.

---
Mode 3: Events recorder

Fig. 291: Overview Mode 3

Mode 3 is used to record data values around an event, before and after the event X, e.g. outage of a part of the plant. The values are continuously recorded into the File FIFO file system independent of the connection status to telecontrol. If the File FIFO is full the oldest values are overwritten (ring buffer). Thus the file FIFO always contains the values from the past period n, which is depending on the number of values per second and on the size of the File FIFO. When a certain event x occurs, the command “MoveFile” can be given directly or after the period m. With the command “MoveFile” the values in File FIFO are internally moved from disk1 to disk 2 and can be read out by an FTP action (client or server) when required.

Fig. 292: The buffered values represent the time before the event \( (n-m) \) and after the event \( (m) \).

The advantage of Mode 3 is that the values from the time period before the event \( (n-m) \) and after the event \( (m) \) are recorded and can help to reconstruct the cause and effect of the event.

### 6.5.8.3 Technical details

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>IEC 60870-5-104 protocol integrated in data logging, IEC data types</td>
<td>SinglePoint SP1/16, DoublePoint DP, IntegratedTotal IT1/16, MeasurementValue ME1/16</td>
</tr>
<tr>
<td>Generic logging to file(s); AC500 data types</td>
<td>BIN, BYTE, INT, UINT, DINT, UDINT, REAL</td>
</tr>
<tr>
<td>Trigger</td>
<td>Cyclic, event, tolerance</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>File format</td>
<td>CSV, including local timestamp. Generic logging with separate ID (max. 8 characters), IEC logging with IEC addresses.</td>
</tr>
<tr>
<td></td>
<td>Timestamped data sets contain 1-16 values (IEC) depending on type logged. Generic contain different number of values, depending on type logged.</td>
</tr>
<tr>
<td></td>
<td>BINAR;Y: max. 58</td>
</tr>
<tr>
<td></td>
<td>BYTE: max. 88</td>
</tr>
<tr>
<td></td>
<td>INT: max. 50</td>
</tr>
<tr>
<td></td>
<td>UIUNIT: max. 58</td>
</tr>
<tr>
<td></td>
<td>DINT: max. 29</td>
</tr>
<tr>
<td></td>
<td>UDINT: max. 31</td>
</tr>
<tr>
<td></td>
<td>REAL: max. 27</td>
</tr>
<tr>
<td>Data logging target</td>
<td>Flash disk, userdisk or memory card, power fail input for memory card (from UPS)</td>
</tr>
<tr>
<td>Data logging file sizes and storage depth</td>
<td>FIFO storage in file system, data logging depth only limited by memory size</td>
</tr>
<tr>
<td>Configurable file FIFO</td>
<td>Number of files (max. 999); number of data sets per file (max. 65535)</td>
</tr>
<tr>
<td>Internal SRAM FIFO size</td>
<td>160 data sets (Standard AC500 PLC)</td>
</tr>
<tr>
<td></td>
<td>Maximum 60 data sets (AC500-eCo PLC)</td>
</tr>
<tr>
<td>Block write mode into files</td>
<td>Up to 50 data sets/second per max. 88 values</td>
</tr>
<tr>
<td>Operation modes</td>
<td>Mode 0: Buffer and disposal in chronologic order limited storage (keeps oldest, but stops if full)</td>
</tr>
<tr>
<td></td>
<td>Mode 1: Buffer and disposal in chronologic order endless (ring buffer) operation modes (deletes oldest)</td>
</tr>
<tr>
<td></td>
<td>Mode 2: Buffer and disposal via FTP, log file(s) copied to FTP server area for further use</td>
</tr>
<tr>
<td></td>
<td>Mode 3: Events recorder, logs data before and after an event.</td>
</tr>
<tr>
<td>Supported software/firmware</td>
<td>V3.4 or higher</td>
</tr>
<tr>
<td>Current restrictions</td>
<td>One data logger per PLC</td>
</tr>
<tr>
<td></td>
<td>One IEC 60870 connection only: While log file is replayed, no other current information via IEC available</td>
</tr>
<tr>
<td></td>
<td>Usable solutions:</td>
</tr>
<tr>
<td></td>
<td>● Delay replay of log file after connection returned to allow a “general inquiry”</td>
</tr>
<tr>
<td></td>
<td>● Use of Mode 2</td>
</tr>
</tbody>
</table>

Logging capacity:

- Data set: One data set always has 400 bytes.
- FIFOIn: Has a maximum capacity of 161 data sets (a 400 bytes = 64400 bytes).
- FIFOOut: Has a maximum capacity of 161 data sets (a 400 bytes = 64400 bytes).
- File: One file store up to 65535 data records, which are copied block by block from the FIFOIn in case of a communication lost.
- A maximum of 999 files can be saved.

In purely mathematical terms, that would be 999 files * 65535 data sets * 400 bytes/data set = 26,187,786,000 bytes = 26 GB.
Since neither the flash disk nor the usable memory card have such a capacity, the user has to find a sensible compromise. The flash disk as a storage medium is fail-safe, i.e. in the event of a sudden power failure, data in the possibly currently open file is reconstructed when the power is restored. This is not the case with a memory card. There the file is destroyed. It is therefore advantageous if such a variant is operated with a power supply that keeps the PLC alive for at least a few seconds after the supply voltage failure (“Input ExternalPower” on the “LogHandling” function block).

**Time synchronization:**

Currently the AC500 V3 does not distinguish between UTC time and local time and its time zone is set to 0. This will be improved in near future. In the meantime, it is recommended to store the local time in the AC500 as a workaround.

*Chapter 6.5.6.3.5.6 “Time synchronization” on page 3845*

### 6.5.8.4 File names

File names are renamed according to storing time with an accuracy of 100 ms. The files are renamed from “filename.csv” to a file name with timestamp and with or without file extension, according to input “Disk2Extension” is applicable only in Mode 2.

<table>
<thead>
<tr>
<th>File name with timestamp</th>
<th>02281448.593 = February 28th, 2:48pm (14:48), 59s, 300ms</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>File name with timestamp and file extension</th>
<th>02281448.csv = February 28th, 2:48pm (14:48)</th>
</tr>
</thead>
</table>

### 6.5.8.5 Preconditions

**CAUTION!**

To avoid failure in processing of the function blocks.

- The function blocks LOGxxxxx_Input, LogHandling and LOGxxxxx_Output must be executed in the same task.

*CAUTION!*

*The “Data Logger Library” is supported in standard AC500 V3 PLCs, use the library “ABB_Datalogger_AC500”.*

*The “Data Logger Library” can be used with AC500-eCo V3 – PM50x2-T-2ETH using the library “ABB_DataloggerEco_AC500”.*

- CPU firmware must be V 3.4.0 or higher.
- Use memory card from ABB with sufficient free space, at least 1.5 x file size as configured (file size is depending on input “MaxNumDatasetFile” from “LogHandling” function block).
- Maximum number of files (input of “LogHandling”) is limited to 999. ABB memory card is formatted with FAT by default.

*Chapter 5.2.9 “Storage devices” on page 1332*
Runtime License:

- To use the "Data Logger Library", runtime license must be activated in the PLC. Runtime license is separate for standard AC500 and AC500-eCo V3 PLC.
- If using the:
  - "ABB_Datalogger_AC500" library with standard PLC, use the PS5609-Log runtime license.
  - "ABB_DataloggerEco_AC500" library with AC500-eCo V3 (PM50x2-T-2ETH), use the PS5609-Log-e runtime license (AC500-eCo library will not run on AC500 Standard), but PS5609-log license can also be used on AC500-eCo library).

6.5.8.6 CSV file formats

Generic data logging

![Fig. 293: Explanation of the csv file structure](image)

One data set consists of:

ID (8 any char) + TimeStamp + msec + Datatype (num) + Datatype (txt) + Length (following data) + max 32 data

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>ID of LogGeneric_Input (max 8 any characters)</td>
</tr>
<tr>
<td>DataType</td>
<td>DataType of LogGeneric_Input (1…7)</td>
</tr>
<tr>
<td>Length</td>
<td>Length of LogGeneric_Input (max 88)</td>
</tr>
<tr>
<td></td>
<td>BINARY (58); BYTE (88); INT (50); UINT (58); DINT (29); UDINT (31); REAL (27)</td>
</tr>
</tbody>
</table>

Example

![Fig. 294: File opened directly with Excel](image)

IEC 60870 data logging

![Fig. 295: Explanation of the csv file structure](image)
Table 741: One data set consists of the following parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IecType</td>
<td>IecType of Logiec60870_Input (1…7)</td>
</tr>
<tr>
<td>Slot/Con/Idx/NoDP</td>
<td>Pin group of Logiec60870_Input (1…7)</td>
</tr>
<tr>
<td>Quality_Bits(Byte)</td>
<td>IV/NT/BL/CA/CY/QOV (packed in 1 byte) of Logiec60870_Input (1…7)</td>
</tr>
<tr>
<td>Quality (SQ)</td>
<td>SQ of LOG_IEC60870_INPUT (1…7)</td>
</tr>
<tr>
<td>GADU</td>
<td>Calculated internally, from Automation Builder configurator (Gadu1+Gadu2)</td>
</tr>
<tr>
<td>IAD3/2/1(n)</td>
<td>Calculated internally, for every datapoint separately, from Automation Builder configurator (IAD1+IAD2+IAD3)</td>
</tr>
<tr>
<td>n</td>
<td>1 or 16, in case of DP is n=2</td>
</tr>
<tr>
<td>VAR(n)</td>
<td>Variable</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>IEC type</th>
<th>Values</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>SP1</td>
<td>-</td>
<td>SinglePoint 1</td>
</tr>
<tr>
<td>SP16</td>
<td>-</td>
<td>SinglePoint 16</td>
</tr>
<tr>
<td>DP</td>
<td>-</td>
<td>DoublePoint</td>
</tr>
<tr>
<td>IT1</td>
<td>-</td>
<td>IntegratedTotal 1</td>
</tr>
<tr>
<td>IT16</td>
<td>-</td>
<td>IntegratedTotal 16</td>
</tr>
<tr>
<td>ME1</td>
<td>-</td>
<td>MeasurementValue 1</td>
</tr>
<tr>
<td>ME16</td>
<td>-</td>
<td>MeasurementValue 16</td>
</tr>
<tr>
<td>Quality_Bits(Byte):</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quality.0:</td>
<td>= IV;</td>
<td>Quality with quality invalid</td>
</tr>
<tr>
<td>Quality.1:</td>
<td>= NT;</td>
<td>Quality not topical</td>
</tr>
<tr>
<td>Quality.2:</td>
<td>= SB;</td>
<td>Quality substituted</td>
</tr>
<tr>
<td>Quality.3:</td>
<td>= BL;</td>
<td>Quality blocked</td>
</tr>
<tr>
<td>Quality.4:</td>
<td>= CA;</td>
<td>Quality with quality carry</td>
</tr>
<tr>
<td>Quality.5:</td>
<td>= CY;</td>
<td>Quality with quality counter adjusted</td>
</tr>
<tr>
<td>Quality.6:</td>
<td>= QOV;</td>
<td>Quality Overflow Quality</td>
</tr>
<tr>
<td>Quality.7:</td>
<td>= Reserve;</td>
<td>(<em>Reserve - Quality</em>)</td>
</tr>
<tr>
<td>Quality SQ(Byte)</td>
<td>SQ</td>
<td>Quality sequence number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Range: 0 to 31)</td>
</tr>
</tbody>
</table>

Example

Fig. 296: File opened directly with Excel

6.5.8.7 Comparison V2 and V3 Data Logger Library package

List of differences between V2 and V3 “Data Logger Library”.

---

2024/01/05 3ADR010583, 1, en_US 3857
<table>
<thead>
<tr>
<th>Feature</th>
<th>V2 data logger</th>
<th>V3 data logger</th>
</tr>
</thead>
<tbody>
<tr>
<td>Package</td>
<td>Part of PS563-Water</td>
<td>PS5609-Log</td>
</tr>
<tr>
<td>Supported in AC500-eCo PLCs</td>
<td>No</td>
<td>Yes (PM50x2-T-2ETH)</td>
</tr>
<tr>
<td>Buffer size</td>
<td>160 data sets</td>
<td>AC500 – 160 data sets</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AC500-eCo – Maximum 60 data sets (default 50)</td>
</tr>
<tr>
<td>Storage area</td>
<td>Memory card, flash disk</td>
<td>Memory card, flash disk, user-disk</td>
</tr>
</tbody>
</table>

While updating the library from V2 to V3 platform some of the inputs and output names are adapted in the function blocks. List of adapted names as below, not mentioned variables remains unchanged.

<table>
<thead>
<tr>
<th>Function block</th>
<th>Variable type</th>
<th>V2 name</th>
<th>V3 name</th>
</tr>
</thead>
<tbody>
<tr>
<td>LogGeneric_Input</td>
<td>Output</td>
<td>RDY</td>
<td>InExecution</td>
</tr>
<tr>
<td></td>
<td>Output</td>
<td>OV</td>
<td>Overflow</td>
</tr>
<tr>
<td></td>
<td>Output</td>
<td>DONE</td>
<td>Busy</td>
</tr>
<tr>
<td></td>
<td>Output</td>
<td>NUMBER_OV</td>
<td>NumberOverflow</td>
</tr>
<tr>
<td>LogGeneric_Output</td>
<td>Input</td>
<td>SENT</td>
<td>PickedUp</td>
</tr>
<tr>
<td></td>
<td>Output</td>
<td>WORD_ARRAY</td>
<td>UintArray</td>
</tr>
<tr>
<td></td>
<td>Output</td>
<td>DWORD_ARRAY</td>
<td>UdintArray</td>
</tr>
<tr>
<td></td>
<td>Output</td>
<td>ENUM_ERROR</td>
<td>FileError</td>
</tr>
<tr>
<td></td>
<td>Input</td>
<td>MAX_DS_IN_FILE</td>
<td>MaxNumDatasetFile</td>
</tr>
<tr>
<td></td>
<td>Output</td>
<td>DONE</td>
<td>Busy</td>
</tr>
<tr>
<td></td>
<td>Output</td>
<td>RDY</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Output</td>
<td>OV</td>
<td>Overflow</td>
</tr>
<tr>
<td></td>
<td>Output</td>
<td>ENUM_ERROR</td>
<td>FileError</td>
</tr>
<tr>
<td></td>
<td>Output</td>
<td>FILE_NEXTWRITE</td>
<td>FileNextWritePosition</td>
</tr>
<tr>
<td></td>
<td>Output</td>
<td>FILE_NEXTREAD</td>
<td>FileNextReadPosition</td>
</tr>
<tr>
<td></td>
<td>Output</td>
<td>USED_FILES</td>
<td>NumberUsedFiles</td>
</tr>
<tr>
<td></td>
<td>Output</td>
<td>NUMBER_DIRECT_SENDS</td>
<td>NumberDirectSend-Datasets</td>
</tr>
<tr>
<td></td>
<td>Output</td>
<td>WRITE-TIME_DB_IN_FILE</td>
<td>WriteTimeDatablock-slnFile</td>
</tr>
<tr>
<td></td>
<td>Output</td>
<td>READ-TIME_DB_FROM_FILE</td>
<td>ReadTimeDatablocks-FromFile</td>
</tr>
<tr>
<td>Function block</td>
<td>Variable type</td>
<td>V2 name</td>
<td>V3 name</td>
</tr>
<tr>
<td>----------------</td>
<td>---------------</td>
<td>----------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>Output</td>
<td>MAXWRITE-TIME_DB_IN_FILE</td>
<td>MaxWriteTimeData-blocksInFile</td>
<td></td>
</tr>
<tr>
<td>Output</td>
<td>MAXREAD-TIME_DB_FROM_FILE</td>
<td>MaxReadTimeData-blocksFromFile</td>
<td></td>
</tr>
<tr>
<td>Output</td>
<td>POSSIBLE_SECURE-READ_DS</td>
<td>PossibleSecureRead-Datasets</td>
<td></td>
</tr>
<tr>
<td>Loglec60870_Input</td>
<td>Output</td>
<td>RDY</td>
<td>InExecution</td>
</tr>
<tr>
<td>Output</td>
<td>OV</td>
<td>Overflow</td>
<td></td>
</tr>
<tr>
<td>Output</td>
<td>DONE</td>
<td>Busy</td>
<td></td>
</tr>
<tr>
<td>Output</td>
<td>NUMBER_OV</td>
<td>NumberOverflow</td>
<td></td>
</tr>
<tr>
<td>Loglec60870_Output</td>
<td>Input</td>
<td>-</td>
<td>Timeout</td>
</tr>
<tr>
<td>Input</td>
<td></td>
<td>-</td>
<td>Busy</td>
</tr>
<tr>
<td>Input</td>
<td></td>
<td>-</td>
<td>ErrorNumberIEC</td>
</tr>
</tbody>
</table>

In all 5 function blocks, all the “INOUT” variables in V2 are changed as “VAR_INPUT” variable in V3.

6.5.8.8 Examples

Example projects for the libraries can be found in the example folder: “Help ➔ Project examples” in the Automation Builder menu.

Prerequisite: Install the related library package with “Automation Builder ➔ Tools ➔ Installation Manager” - [Modify].

6.5.9 High Availability Modbus TCP

6.5.9.1 HA-Modbus TCP - System technology

6.5.9.1.1 The AC500 High Availability system

The AC500 High Availability system is designed for the demand of automation systems that require a higher availability, which is realized by redundant devices and communications. The redundancy concept reduces the risk of losing production due to failure of parts of the automation system and thereby minimizes scheduled idle times.

For instance, control can be taken over by the secondary station automatically if the primary station fails.

AC500 High Availability system implements redundancy based on standard AC500 PLCs:
- PLC
- Field communication
- SCADA communication

General differences in high availability / redundancy systems are in which way and how fast the switchover between redundancies happens.
Cold standby: A replacement system is there but not up and running - Process has (to allow) to completely stop for switchover – e.g. outputs may go to zero.

Warm standby: Both CPU may be running (= warm) but e.g. communication need to be started/stopped for switch-over - Process needs to tolerate longer freeze times e.g. on outputs - e.g. several seconds.

AC500 High Availability systems are "hot-standby":
- Redundant CPUs and all communications are always up and running (hot)
- Continuous failure detection in both CPU’s and mutual exchange of status
- Continuous synchronization of critical/historical data from primary to secondary
- Automatic switch-over in very short time in case of any failure in primary CPU

---

**Fig. 297: Principle AC500 HA-Modbus TCP architecture example based on Ethernet redundancy**

Details of AC500 HA operation along the figure above:
● PLC redundancy: The two PLCs (A and B) are running in parallel and calculating and reading. One is “primary” (= active), which means also writing data to field devices. The other one is “secondary” (= stand-by), also calculating but only reading data from field and receiving synchronization (or short = sync) data from the primary.

● Synchronisation data are critical internal variables with e.g. historical content, which will be transmitted from primary to secondary CPU over the sync connection, so that secondary always has the latest data and can take over immediately. Automatically synced are the historic data of the special HA library function blocks (like counters, timers, integral controllers, …), additional Data e.g. of events and diagnosis can be synced by the user with sync blocks. The sync connection also transmits a “lifecom1” signal (back and forth) containing diagnosis data of each CPU, so that both CPU know the status of the other CPU. If secondary CPU receives no “lifecom1” anymore it assumes that primary CPU has a failure and takes over primary status. If the sync connection is broken both CPUs would try to adopt primary status, therefore, a parallel separate connection “lifecom2” is used to differential a “sync link” failure from an “other PLC” failure. The “lifecom2” should be routed via a different physical communication path than the data sync/lifecom1, e.g. the Field or SCADA network.

● The field I/O connection is performed via the Ethernet protocol ModbusTCP - connecting the CI52x devices (CI521 or CI522) Chapter 5.2.6.5.1 “CI521-MODTCP” on page 1070 % Chapter 5.2.6.5.2 “CI522-MODTCP” on page 1111.

For high availability/redundancy of the field or SCADA network, proven Ethernet network redundancy mechanisms are used. (In AC500 this is assumed to be realized by at least 2 (to avoid a single point of failure) external, managed switches), which has the advantage to be able to use AC500 HA with any faster redundancy mechanism / protocol.

● For the I/O communication with CI52x modules two variants exist (see online help: PLC Automation with V2 CPUs ➔ PLC integration ➔ Device specifications ➔ Communication interface modules (S500) ➔ Modbus XY)

For smaller systems, the CI52x modules can be directly daisy chained (as in previous figure above) if MRP (Media Redundancy Protocol) or DLR (Device Level Ring) is used. CI52x are not actively participating in ring recovery however, a special FW allows fast ring detection and very short freeze times. Larger systems with e.g. many IO and clusters typically anyway connect to the network via a dedicated managed switch.

● SCADA connection is redundant by nature of the two Ethernet ports and can be extended with further redundancy level as well by managed switches. SCADA itself can also switch the primary PLC to ensure communication to the active PLC in case of a simple connection and a connection failure. If the redundancy mechanism of the OPC DA server is not used, SCADA level itself must be able to handle and differentiate primary and secondary PLC and IP addresses based on the HA-status bits. For CP600 a script exists to do the same for Modbus or AC500 communication protocol.

In most PLC applications the critical components to fail are, beneath PLC, typically the power supply or communication components such as wires or switches. Therefore a SPOF (Single Point Of Failure) has to be avoided by adding redundant devices or redundancy functions wherever a failure likelihood is high and failures are not tolerable.

HA core functionality typically can tolerate only a single failure in the different levels. Then, a repair of the failed part is highly advised to achieve and ensure redundancy again. As shown in the above figure, the I/O-network cabling already provides a second independent redundancy layer e.g. for cable failure by its redundancy mechanism (e.g. ring), which can keep up communication without switching the PLCs: There a second failure in the PLC level could be tolerated as long as both connecting, managed switched still work, but it is highly advised to repair immediately anyway.

The AC500 High Availability system itself only takes care of the first fault. For example, in case of a second fault the primary PLC remains primary PLC until the second fault occurs. This results in no further switchovers (manual switchovers included).

Due to the efficient data sync mechanism, which allows data sync over normal and shared ethernet networks, with a well-planned communication network, the PLCs can operate geographically separated (by many 10th of kilometers). So even in catastrophic events with full mechanical destruction still one PLC will be available to control the process or infrastructure.
The secondary PLC or single CI52x modules can be exchanged in a running system without interruption of the primary PLC or the process. (Check document in “Examples” directory of Automation Builder if HA package was installed.)

**Libraries**

In order to achieve high availability, the CODESYS application must be enhanced with HA function blocks, from the HA-Modbus TCP library and the CI52x library. If the bulk data manager tool (BDM) is used for configuring the System and I/O modules - this is done automatically for the basic initial configuration step by code creation resulting in a prepared user specific “template” application (see below).

- **HA-Modbus TCP library** contains *HA control* and *HA utility* function blocks
  - *HA control* function blocks manage the core HA functionality by collecting diagnosis and switching if necessary.
  - *HA utility* function blocks provide standard functions in the application program with internal sync for integral data e.g. timers, counters, PI control.
- **CI52x library** contains a function block to configure and communicate to the communication interface modules and ensures that only the primary PLC writes to the outputs. The inputs are read by both PLCs.
- For both PLCs the same application must be used/downloaded.

**Bulk data manager tool (BDM)**

For configuration of the CI52x Modbus TCPs, a separate Bulk Data Manager tool (BDM) is provided. Especially in larger systems usage of BDM is recommended to comfortably engineer HA and create CI52x related configuration and variable data in one place:

- Configuration and parameters of the used I/O modules
- Program code creation for variable naming, configuration, communication and all basic HA functionality

The BDM tool can serve SCADA programming and documentation as well in an efficient manner.

### 6.5.9.1.2 Hardware, requirements and options overview

**Introduction**

Two same type AC500 PLCs are required as central hardware components. Each PLC is equipped with at least two Ethernet ports at a processor module or at a communication module. The two PLCs, called PLC A and PLC B, are linked by Ethernet to exchange and synchronize information (Sync). Connections to the AC500 peripheral field devices (I/O) are performed via Ethernet as well.

Further information on which CPU type and library to be used.

The following table gives an overview of the different High Availability variants possible with AC500.

The figures are indicative, depend on chosen architectures, system size, network and CPU/communication modules used.
### Table 742: Overview of AC500 HA systems and options

<table>
<thead>
<tr>
<th>Library version</th>
<th>HA-CS31</th>
<th>HA-Modbus TCP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Library version</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU version</td>
<td>V2 CPUs</td>
<td>V2 CPUs</td>
</tr>
<tr>
<td>CPU version</td>
<td>V2 CPUs</td>
<td>V3 CPUs</td>
</tr>
<tr>
<td>I/O communication</td>
<td>Parallel serial</td>
<td>Ethernet</td>
</tr>
<tr>
<td>I/O communication</td>
<td>Ethernet</td>
<td>Ethernet</td>
</tr>
<tr>
<td>CPUs</td>
<td>PM573 - 593</td>
<td>PM573 - 593</td>
</tr>
<tr>
<td>CPUs</td>
<td>PM571</td>
<td>PM595</td>
</tr>
<tr>
<td>CPUs</td>
<td>PM5630</td>
<td>PM5650</td>
</tr>
<tr>
<td>CPUs</td>
<td>PM5670</td>
<td>PM5670</td>
</tr>
<tr>
<td>Max. system size</td>
<td>CI52x</td>
<td>CI52x</td>
</tr>
<tr>
<td>Max. system size</td>
<td>3 - 50</td>
<td>3</td>
</tr>
<tr>
<td>Max. system size</td>
<td>&lt; 25 / 50</td>
<td>&lt; 60 / 92</td>
</tr>
<tr>
<td>Max. system size</td>
<td>&lt; 30</td>
<td>&lt; 50</td>
</tr>
<tr>
<td>Max. system size</td>
<td>&lt; 120</td>
<td></td>
</tr>
<tr>
<td>I/O modules</td>
<td>CI590: S500</td>
<td>CI52x: S500 and S500-eCo usable</td>
</tr>
<tr>
<td>Switch-over times</td>
<td>CPU</td>
<td>25 - 120 ms</td>
</tr>
<tr>
<td>Switch-over times</td>
<td>Field</td>
<td>15 - 120 ms</td>
</tr>
<tr>
<td>SCADA connectivity</td>
<td>OPC DA, IEC60870, ...</td>
<td>OPC DA, IEC60870, ...</td>
</tr>
<tr>
<td>SCADA connectivity</td>
<td>OPC DA, IEC60870, ...</td>
<td>OPC DA, OPC UA, IEC60870, ...</td>
</tr>
<tr>
<td>Interfaces</td>
<td>Several CS31 and Ethernet</td>
<td>Several ETH ports, via CM597</td>
</tr>
<tr>
<td>Interfaces</td>
<td>Several CS31 and Ethernet</td>
<td>Several ETH ports</td>
</tr>
<tr>
<td>Interfaces</td>
<td>Several CS31 and Ethernet</td>
<td>Several ETH ports</td>
</tr>
<tr>
<td>Interfaces</td>
<td>Several CS31 and Ethernet</td>
<td>Several ETH ports</td>
</tr>
<tr>
<td>Sync</td>
<td>UDP</td>
<td>UDP</td>
</tr>
<tr>
<td>Lifecom1</td>
<td>UDP</td>
<td>UDP</td>
</tr>
<tr>
<td>Lifecom2</td>
<td>Modbus TCP</td>
<td>Modbus TCP / CAN</td>
</tr>
</tbody>
</table>

**Overview of AC500 HA system**

1) Number of CI52x recommendation based on performance or max. number of sockets. For more details of Modbus clients supported in AC500 V3 PLCs refer to "Ethernet protocols and ports for AC500 V3" \* Chapter 6.8.2.6.1.2.4 “Limitation of connections per protocol” on page 4484.

2) Limited by CPU performance, number of CM574 modules number of CS31 clients and process data limits.

3) Depends on system size and CPU type.
4) For details on certain S500-eCo modules not supported, see the Automation Builder release notes, Appendix 1.

5) 2ETH onboard ports - port extensions via CM5640-2ETH: 2 separate ETH ports/communication module for separate networks (no additional sockets or coprocessing, not switched, all ports in different subnets).

6) Based on HA bits switchover, depending on failure case.

7) Field network: If CI52x are used with their 2 ports as part of a ring: In the moment of a network switchover single telegrams may be destroyed: - for V2 ETH onboard: Standard TCP delays repeats by 500 ms - for V3 CPUs onboard/CM5640 or V2 CPU using CM597: A special HA-FW ensures fast repeats of typ. ~50ms (settable).

CPU choice, system size and performance indications

The diagrams below indicate the example choices of AC500 CPU's (horizontal axes) based on the number of communication interface CI-remote I/O clusters (Communication Interface modules; numbers see legend) used in a system and resulting application cycle times (vertical axes).

Further details can be found in 'Task configuration recommendations for HA system' on page 3884. The values in below graphs base on the assumption to use max. 50-60% as CPU loading by the bare fast IO communication and HA functionality. So the application load would come on top and cycle times (especially HA, Modbus) need to be relaxed (made higher) compared to below indication.
Fig. 298: Indication of AC500 CPU's performance (horizontal axes) based on the number of communication interface CI-remote I/O clusters (Communication Interface modules; numbers see legend) used in a system and resulting application cycle times (vertical axes).

Example: If you need a system supporting min. 25 CI at application cycle time around 120 ms, suitable options based on above graph would be V2 PLCs - PM592 or PM595 and V3 PLCs – PM5650 or PM5670. The main parameter in the application cycle determination is the amount of overall Sync data, which is assumed 160 bytes per CI for the smaller systems, up to 250 bytes per CI for the larger ones. Sync data of the project of in total more than ~1200 byte necessitates several HA cycles to transfer within one application cycle.

If CM5640-2ETH port extender is used for the CI network, slightly lower performance/longer cycle time needs has to be expected.

The V2 or V3 PLCs types, also differ in available interfaces, protocols supported and memory size.

CI521-MODTCP or CI522-MODTCP can be used as peripheral devices which communicate via the Modbus TCP protocol with the PLCs. The HA-Modbus TCP library supports currently up to 120 CI52x, depending on the CPU type as listed in table 'Overview of AC500 HA systems and options' Further information on page 3863. Each CI52x supports up to a maximum of 10 S500-I/O modules. Nevertheless the standard Modbus TCP communication of the HA library transfers only 120 words per cycle: Therefore please check if for your module configuration matches: In case of many analog IO modules with high-density - like 16 channel AI523/AO523 or modules with fast counters - this limit might be surpassed by roughly 5-6 such modules (to help calculate exactly, there is an Excel sheet provided in the HA “Examples” subfolder of Automation Builder once installed).

For more details of Modbus clients supported in AC500 V3 PLCs refer to 'Ethernet protocols and ports for AC500 V3' Chapter 6.8.2.6.1.2.4 “Limitation of connections per protocol” on page 4484.
Local I/O on a CPU can only signal/interact for diagnosis or service with/from this CPU. This local I/O is connected only to this CPU - cannot work with other CPU in case of this CPU failure.

Hardware connections

SCADA/Engineering connection is done using ETH ports of both PLCs (or their communication module ETH modules) and one or several managed Ethernet switches depending on the redundancy requirements in the SCADA levels.

- HA communication between PLC A and PLC B must be done via two physical connections between PLC A and PLC B in order to distinguish a “sync link” failure from another PLC failure:
  - Sync (including “lifecom1”) over Ethernet
  - “Lifecom2” over Ethernet (Modbus TCP): Can also be combined with Field or SCADA network over CAN (only possible with AC500 V3 CPU)
    (For V3 CPUs: - “Lifecom2” and sync should be directly on the CPU onboard ports,
    - while for CI and SCADA network the use of CM5640 is possible to be in separate networks).

- Field devices (CI52x modules) will be connected via Ethernet switches, forming a redundant network (if requested) (Chapter 6.5.9.1.5.4 “Field I/O network topologies” on page 3886).
The following table shows possible combinations of connections for different CPU types. There must be at least two physical connections. The availability can be increased with a third physical connection, e.g. CM597 for AC500 V2 CPUs, CAN or CM5640-ETH for AC500 V3 CPUs.

For V3 CPU’s with CM5640-2ETH, following as of Automation Builder 2.6.1 new port options are available for SCADA and field connection.

V3 ETH interface internal numbering for each port of CPU and CM5640-2ETH communication module (ETH1, ETH2).

The dotted box above indicates the example which is used in the next chapters.

---

**Configuration and programming**

**Libraries and solutions > High Availability Modbus TCP**

‘Lifecom2’ connection = “3”: when selected as 3-> means using CAN. It has no relation with communication module 1 ETH1 : 3 port.

At present all the CI modules in the ring must be connected either on onboard ETH or only one port of the CM5640.
The numbers in the figure above define the slot on which the connection is made. Last line # of physical connections define how many physical interfaces are used or connected between the PLCs.

It is also possible to realize an HA system without a communication interface CI module.

Chapter 6.5.9.1.6.1.2 “Configuration without communication interface modules to establish redundancy” on page 3890.

Hardware Example

HA hardware example using CM5640 for field and SCADA connection: Both ports of the CPU available for the two sync connections.

Fig. 300: Physical connection example: 2 ETH CPUs combining sync data / "lifefcom2" with SCADA / Field I/O network

Support of I/O modules (S500/S500-eCo) depends on the version of the library package. See the version details of the library in the Automation Builder release notes.
6.5.9.1.3 Functionality

Failures and use cases

The AC500 High Availability system performs a switch-over whenever the primary PLC is powered off, crashed or stopped or if the primary PLC loses fieldbus communication (cut of ETH or defect MRP switch) while the secondary PLC still has connection.

In the following figure the different use cases and reaction times are outlined.

![Diagram of HA use cases](image)

*Fig. 301: HA use cases – failures, assuming PLC A is primary and “lifecom2” over field network*

The below use case table with reaction and diagnosis messages are based on the setup where Sync is via SCADA network, “lifecom2” over field network and PLC A is primary.

<table>
<thead>
<tr>
<th>Case</th>
<th>Use case</th>
<th>Reaction</th>
<th>Diagnosis message on</th>
<th>diagnosis message on 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Primary PLC is powered off, crashed or stopped.</td>
<td>Switchover to secondary PLC. CI52x outputs are frozen during switchover period.</td>
<td>Secondary</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Secondary PLC is powered off, crashed or stopped.</td>
<td>No switchover, process continues.</td>
<td>Primary</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Primary PLC loses connection to fieldbus CI52x modules while secondary PLC still has a connection.</td>
<td>Switchover to the secondary PLC. CI52x outputs are frozen during switchover period.</td>
<td>Primary</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Secondary PLC loses connection to one or more CI52x modules.</td>
<td>No switchover, process continues.</td>
<td>Secondary</td>
<td></td>
</tr>
</tbody>
</table>
### Use case descriptions

The below cases explain the behavior of the system during different use cases. Basic diagnosis information is provided for each case in Chapter 6.5.9.1.8 “Diagnosis” on page 3895.

**Case 1 a): Primary PLC is powered off or crashes**

<table>
<thead>
<tr>
<th>Case</th>
<th>Use case</th>
<th>Reaction</th>
<th>Diagnosis message on *)</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>CI52x module is stopped/ powered off.</td>
<td>No switchover, process continues.</td>
<td>Primary and secondary</td>
</tr>
<tr>
<td>6</td>
<td>Connection lost in Field Ethernet network.</td>
<td>Depending on Ethernet network structure, and redundancy mechanisms used a reconfiguration time exists.</td>
<td>Lifecom2 lost and CI module lost errors will be generated in primary and secondary.</td>
</tr>
<tr>
<td>7</td>
<td>Sync and/ or “lifecom2” are broken.</td>
<td>No switchover, process continues.</td>
<td>Primary and secondary</td>
</tr>
<tr>
<td>8</td>
<td>Primary PLC loses connection to SCADA.</td>
<td>SCADA is responsible to detect and to switch over.</td>
<td>-</td>
</tr>
<tr>
<td>9</td>
<td>Secondary PLC loses connection to SCADA.</td>
<td>SCADA is responsible to detect and to switch over.</td>
<td>-</td>
</tr>
<tr>
<td>10</td>
<td>SCADA is broken</td>
<td>SCADA is responsible to detect and to switch over.</td>
<td>-</td>
</tr>
<tr>
<td>11</td>
<td>Manual switchover by the user.</td>
<td>Switchover to the secondary PLC. CI52x outputs are frozen during switchover period.</td>
<td>-</td>
</tr>
</tbody>
</table>

*) Diagnosis description, see function block description.
### Reaction
Switchover to secondary PLC. The communication interface modules are updated by the new primary PLC.

### Comment
CI52x outputs are frozen during switchover period.

### Diagnosis message on function block
Primary PLC is powered off. Secondary PLC: control block output Runtime Error = 16#001E and xHaModPrimary = TRUE

---

**Case 1 b): Primary PLC is stopped**

![Diagram of PLC setup with primary PLC stopped]

### Reaction
Switchover to secondary PLC. The communication interface modules are updated by the new primary PLC.

### Comment
CI52x outputs are frozen during switchover period.

### Diagnosis message on function block
Primary PLC is stopped. Secondary PLC: control block output Runtime Error = 16#0016 and xHaModPrimary = TRUE

---

*If “lifecom2” is lost and the PLC is in STOP mode RUNTIME ERROR will not be TRUE. This is because Modbus is still responding even if PLC is in STOP mode.*
Case 2 a): Secondary PLC is powered off or crashes

<table>
<thead>
<tr>
<th>Reaction</th>
<th>No switchover</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment</td>
<td>Process continues</td>
</tr>
<tr>
<td>Diagnosis message on function block</td>
<td>Primary PLC: control block output Runtime Error = 16#001E and xHaModPrimary = TRUE Secondary PLC is stopped.</td>
</tr>
</tbody>
</table>

Case 2 b): Secondary PLC stop
<table>
<thead>
<tr>
<th>Reaction</th>
<th>No switchover</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment</td>
<td>Process continues</td>
</tr>
</tbody>
</table>
| Diagnosis message on function block | Primary PLC: control block output Runtime Error = 16#0016 and xHaModPrimary = TRUE  
Secondary PLC is stopped. |

- If “lifecom2” is lost and the PLC is in STOP mode RUNTIME ERROR will not be TRUE. This is because Modbus is still responding even if PLC is in STOP mode.

### Case 3: Primary PLC loses connection to fieldbus CI52x modules

<table>
<thead>
<tr>
<th>Reaction</th>
<th>Switchover to secondary PLC. The communication interface modules are updated by the new primary.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment</td>
<td>CI52x outputs are frozen during the switchover period.</td>
</tr>
</tbody>
</table>
| Diagnosis message on function block | Primary PLC: control block output Runtime Error = 16#0094 and xHaModPrimary = FALSE  
Secondary PLC: control block output Runtime Error = 16#0015 and xHaModPrimary = TRUE |
Case 4: Secondary PLC loses connection to fieldbus CI52x modules

<table>
<thead>
<tr>
<th>Reaction</th>
<th>No switchover</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment</td>
<td>Process continues</td>
</tr>
<tr>
<td>Diagnosis message on function block</td>
<td>Primary PLC: control block output Runtime Error = 16#0015 and xHaModPrimary = TRUE Secondary PLC: control block output Runtime Error = 16#0094 and xHaModPrimary = FALSE</td>
</tr>
</tbody>
</table>

Case 5: CI52x is powered off or stopped
### Case 7 a): Sync connection is broken between the PLCs

<table>
<thead>
<tr>
<th>Reaction</th>
<th>No switchover</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment</td>
<td>Process continues</td>
</tr>
</tbody>
</table>
| Diagnosis message on function block | Primary PLC: control block output Runtime Error = 16#0081 and xHaModPrimary = TRUE  
Secondary PLC: control block output Runtime Error = 16#0081 and xHaModPrimary = FALSE |

If any CI52x-MODTCP module is powered off and on, there is no need to power restart the complete system. The module will be recognized once the communication is reestablished.
Case 7 b):
Lifecom2 connection is lost between the PLCs

<table>
<thead>
<tr>
<th>Reaction</th>
<th>No switchover</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment</td>
<td>Process continues</td>
</tr>
<tr>
<td>Diagnosis message on function block</td>
<td>Primary PLC: control block output Runtime Error = 16#0008 and xHaModPrimary = TRUE Secondary PLC: control block output Runtime Error = 16#0008 and xHaModPrimary = FALSE</td>
</tr>
</tbody>
</table>

Case 8: Primary PLC loses SCADA connection
### Reaction

<table>
<thead>
<tr>
<th>Comment</th>
<th>No switchover</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process continues, SCADA is responsible to detect and switchover</td>
<td></td>
</tr>
</tbody>
</table>

| Diagnosis message on function block | Primary PLC: control block output Runtime Error = 16#0000 and xHaModPrimary = TRUE  
Secondary PLC: control block output Runtime Error = 16#0000 and xHaModPrimary = FALSE |

### Case 9: Secondary PLC loses SCADA connection

SCADA link may be combined with sync connection or “lifecom2” connection. In that case runtime error and system behavior will be as described in the cases above (Sync connection lost / “lifecom2” connection broken).
Case 11: Manual changeover by user

<table>
<thead>
<tr>
<th>Reaction</th>
<th>Changeover from primary PLC to secondary PLC.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment</td>
<td>Cl52x outputs will be frozen during switchover</td>
</tr>
</tbody>
</table>
| Diagnosis message on function block | Primary PLC: control block output Runtime Error = 16#0000 and xHaModPrimary = FALSE  
Secondary PLC: control block output Runtime Error = 16#0000 and xHaModPrimary = TRUE |

A manual switchover can be triggered from both PLCs. For each trigger a switchover from primary PLC to secondary PLC will take place.

6.5.9.1.4 How to get and install the AC500 High Availability system package

The PS5601- High Availability Modbus library package can be installed from the Automation Builder Installation Manager by selecting the component.
The following components are installed:

- **Libraries**
  - AC500 V2 libraries: C:\Program Files (x86)\Common Files\CAA-Tar-
gets\ABB_AC500\AC500_V12\library\PS5601-HA-MTCP
    - CI52x_AC500_Vxx.lib, HAModbus_AC500_Vxx.lib.
  - AC500 V3 libraries available in library repository:
    - ABB_CI52x_AC500.compiled-library, ABB_HaModbus_AC500.compiled-library
- **Online help:** HA-CS31, HA Modbus V2 function block description
- **Automation Builder Example folder:** %ALLUSERSPROFILE%\Documents\Automation
  Builder Examples\PS5601-HA-MTCP
  - AC500_V2: Examples for AC500 V2 including documentation
  - AC500_V3: Examples for AC500 V3 including documentation
  - BulkDataManager: Bulk Data Manager (BDM) tool which helps efficient engineering
    in larger projects. This requires a separate installation. Further information can be
    found in the document: %ALLUSERSPROFILE%\Documents\Automation Builder Exam-
  ples\PS5601-HA-MTCP\BulkDataManager\Documentation.
  - HA-Modbus TCP System Technology.pdf (this document)

### 6.5.9.1.5 System structure

**Introduction**

This chapter explains the detailed structure of the HA system in CODESYS. A HA-Modbus TCP
system is characterized by two AC500 PLCs with the following features:

- Identical programs (application with additional HA and Modbus function blocks) that are
  loaded to both PLCs.
- Communication interface modules CI52x-MODTCP that are connected via Modbus TCP.
- Synchronization of both PLCs (sync/lifecom1 and lifecom2 logical connections).

**Programming**

Each PLC contains at least three main tasks/ programs:

- HA program
- Application program
- Modbus program
The programs in one PLC communicate via internal structures of the libraries and dedicated internal memory areas for HA-Sync array and the Modbus CI52x memory(ies) CiModDataxx.

**Fig. 303: Principle structure of the HA system and recommended tasks: HA, Modbus, Application**

**Table 743: Image description**

<table>
<thead>
<tr>
<th>Layout element</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dotted outline box</td>
<td>Indicates optional function block or programs.</td>
</tr>
<tr>
<td>Solid outline box</td>
<td>Indicates the mandatory function blocks or programs. All mandatory blocks are called when an export is created from Bulk data manager.</td>
</tr>
<tr>
<td>Italic font</td>
<td>Indicates the program or functions user should call in his project and not created by Bulk data manager.</td>
</tr>
<tr>
<td>Light yellow background block / blue arrow</td>
<td>Indicates the operations which are handled internally in the library.</td>
</tr>
<tr>
<td>Green solid box</td>
<td>Indicates the three different tasks which user has to configure.</td>
</tr>
</tbody>
</table>

**Modbus program**

The function block CIModCI52x (V3) / CI_MOD_CI52x (V2) reads the input values from the CI52x modules and stores them in the structure CiModDataxx. If the CPU is primary it also writes the outputs to the CI52x modules. The Function block also parametrizes the CI Module as configured in e.g. Bulk data manager tool during the first startup or when a CI module is exchanged.
Normally the HA-Modbus TCP library takes care of communication monitoring. Nevertheless if communication is cut completely, the CI52x communication interfaces and its I/O modules have to react on their own to achieve a bumpless or desired behavior: The following parameters for the CI52x communication interfaces and I/O modules need to be considered:

- CI52x: parameter “Timeout” for Bus supervision: 2)
  Allows to detect errors from communication interface side as well and take action to ensure a fail-safe behavior if communication is cut. It can be set in 10 ms steps. If set to 0 no bus supervision is active. Proposed value: 50 = 500 ms = default in Bulk data manager; this value should be increased, e.g. to value 65 if AC500 V2 CPU ports are used for field communication to take care of the larger TCP retransmit time.

- “Behaviour Outputs” at “Timeout for Bus supervision” 1), 2). This fail-safe parameter has to be consciously set: separate settings are possible for each module (and communication interface): “off”, “last” or “substitute”: 5 s, 10 s, ∞ 1).

Remarks:

1) The parameters “Behaviour Outputs at comm. Error” is only analyzed if the Failsafe-mode is [ON].
2) Both are CI52x parameters set e.g. via Bulk data manager tool in the program.

Application program

- At the start of the application task the InputRefresh program has to be called. It copies data from Modbus via the structure CiModDataxx to the user variables, which were defined in BDM as signals. For further information refer to BDM documentation, which is available in the path: %ALLUSERSPROFILE%\Documents\Automation Builder Examples\PS5601-HA-MTCP\BulkDataManager\Documentation.
- Only the main application programs should be in this task and use these variables for the user defined functions. E.g here the user programs and logic should be called and use the HA libraries utility blocks (which sync their historic data automatically) and HA_MOD_DATA_SYNC blocks for further user data which should be synchronized.
- Data of utility blocks and HA_MOD_DATA_SYNC blocks are copied to the HA Sync array of the primary CPU (which is sent to the secondary CPU by the HA program).
- OutputRefresh program is called as a last step. It copies data from the user variables via structure CiModDataxx to Modbus.

Example of a utility function block (with integrated sync data)

Consider the on-delay timer HA_MOD_TON (V2)/ HaModTon (V3).

Fig. 304: HaModTon utility function block with internal synchronization

Both PLCs require the same function block called in the program. Under normal operating conditions the elapsed time ET and output Q of the timer is synchronized internally from primary to the secondary CPU. ET and Q data are available and can be attached to local or global variables in the program as per application requirements. If PLC A shuts down due to a fault, the primary status switches over to PLC B.
In the event of a switchover, the moment PLC B becomes the primary, the timer on this PLC will keep running. Until the time of PLC A failure, the timer on PLC B was synchronized. This is most important in cases when one CPU was not in run or off and needs to “catch up” such integral or historic system values (timers, counters, operator settings, …). The actual process remains then unaffected by the switchover.

**HA program**

HA_MOD_CONTROL has two functions:
- Exchange status data (lifecom1 and lifecom2) and switch from secondary to primary PLC (or vice versa) based on the status according to the use cases described in 'Failures and use cases' Chapter 6.5.9.1.3.1 “Failures and use cases” on page 3869.
- Send sync “HA SYNC” array from primary to secondary PLC to ensure that the secondary PLC is always in hot-stand-by and can take over immediately. UDP protocol is used for data synchronization between the CPUs.

**Data synchronization via UDP**

This chapter explains how the data synchronization happens between primary and secondary PLC via UDP.

All prepared sync data is synchronized with the secondary PLC. Typically only integral values (timers, counters, PID, …) or settings which might have been received have to be synchronized. For example for fast start-up cases when a secondary CPU was restarted, as both PLCs are running and calculating closely in parallel and based on the same input values, synchronization will make the secondary start with current value instead of default value. For details on how to configure or use the data sync function block refer example projects.

Following steps are performed:
- HA SYNC array is transferred via UDP to the secondary CPU. This includes the exchange of lifecom1 status between primary and secondary CPU.
- In the HA program the HA_MOD_CONTROL function block collects all diagnosis, sync and lifecom2 data from the field and/ or the other PLC. Whether a switchover is necessary is decided based on a simple decision matrix.
- Lifecom2 is exchanged between CPUs over Modbus TCP every cycle.
- One task per program, see figure above.
- Status of the inputs connected to CI52x decentralized I/O stations is transferred to both PLCs simultaneously in every PLC cycle. They are received by the CI52x function block.
- At the end of the program, the generated output values are sent, by transferring from the primary PLC respective buffers to the CI52x-MODTCP module(s) via CI52x function block and Modbus TCP. The secondary PLC is prepared to send but stays “silent” (not sending output values).

One ETH frame copies approx. 1412 data bytes. The number of ETH frames needed to synchronize HA Sync Array completely depends on the number of data sync bytes. Global variable iNoOfEthFrames gives the user this information, which should be used to calculate the cycle time for the application task.

Chapter 6.5.9.1.5.3 “Task configuration recommendations for HA system” on page 3884

Up to max. 60 kB of Sync data can be synchronized.

Synchronization between the primary and the secondary PLC happens over a few cycles of HA task time depending on the total sync data bytes configured in the system. Lifecom1 is also exchanged between the primary and the secondary PLC. The primary PLC sends lifecom1 to the secondary PLC along with sync data. Backwards the secondary PLC sends lifecom1 to the primary PLC every cycle.

The following figures shows an example for V2 PLC. When in the project the sync data is equal to 4 iNoOfEthFrames then it takes 4 HA cycles to synchronize the data between the PLCs.
When sync data in the project is equal to 6 \textit{iNoOfEthFrames} then it takes 6 HA cycles to synchronize the data between the PLCs.

Here, it is assumed that 4 HA cycles are needed to transfer sync data from Primary to secondary, meaning global variable \textit{iNoOfEthFrames} = 4. Therefore system need 4 HA cycles, 2 Modbus and 1 Application cycle for one round of sync.
Task configuration recommendations for HA system

For a balanced performance of the HA system consider the following recommendations in your project task configuration:

General

- Use the real time priorities for all HA related tasks. The HA program/ task should be called at highest priority as it is responsible for the core HA functionality and should be the fastest task.
- The Modbus task contains the Modbus communication function blocks at lower priority and (depending on CPU performance) also a faster cycle time to ensure sufficient update rates on Modbus without overloading the CPU with communication.
- The application program parts should be called in the application task with even lower priority and a larger cycle time than above tasks.
- Configuration to improve standard Modbus TCP for a fast switch over between PLCS.
- AC500 V2
  - CM597ETH_SET_TCP_RTO function block from CM597_ETH_AC500_V28.lib needs to be called inside HA task. User needs to call this function block for each CM597 module connected. For recommended values see example description.
- AC500 V3
  - RTO retransmission time function block “EthSetRtoMin” for the ETH port where fieldbus communication is configured. By default, minimum retransmission time configured is 15 ms.
<table>
<thead>
<tr>
<th>Task</th>
<th>Priority</th>
<th>PM57x, PM58x, PM59x</th>
<th>PM595-4ETH V3 PLCs</th>
</tr>
</thead>
<tbody>
<tr>
<td>HA</td>
<td>10 (high)</td>
<td>4 ms or higher</td>
<td>2 ms or higher</td>
</tr>
<tr>
<td>Modbus</td>
<td>11 (medium)</td>
<td>Maximum of (HA cycle time *2), (3 ms + roundup (#CI/2))</td>
<td>Maximum of (HA cycle time *2), (3 ms + roundup (#CI/2))</td>
</tr>
<tr>
<td>Application</td>
<td>12 (low)</td>
<td>Maximum of (Modbus cycle time *2), (iNoOfEthFrames * HA cycle time)</td>
<td>(iNoOfEthFrames * HA cycle time)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>V3 PLCs</th>
<th>Onboard ETH: Max ((HA cycle time *2), (3 + roundup (#CI modules/2)))</th>
</tr>
</thead>
<tbody>
<tr>
<td>CM5640-2ETH</td>
<td>Max ((HA cycle time * 2), (#CI modules))</td>
</tr>
</tbody>
</table>

### Procedure for task configuration

1. Choose suitable CPU type according to chapter CPU choice, system size, performance indications.
2. Configure task priorities according to the table.
3. Set HA task to minimum according to above table.
4. Calculate Modbus cycle time according formulas in the table, based on HA cycle and number of CI modules “#CI”.
5. Calculate Application cycle time according to formulas in the table, based on Modbus cycle time and variable iNoOfEthFrames, which is defined in the global variables of HA-Modbus TCP library.
6. Measure PLC and CPU load during trial operation.

V3: PLC Utilisation § Chapter 6.8.2.1.7 “PLC utilization” on page 4428

If the PLC load is higher than 40 % or CPU load higher than 60 % then increase HA cycle time (e.g. to 8 ms / 12 ms / 24 ms, …) and go to step 4, repeat the steps until loading is within defined range.

---

A new **V3 CPU configuration option** is introduced from Automation Builder 2.4.1 and onwards which allows to change the priority for Ethernet communication in PLCs.

Set this configuration in the device tree of the CPU in Automation Builder double click on PLC “CPU Parameters ➔ Communication Schema ➔ Select “Onboard Ethernet””.

The above parameter should be set to “Onboard” Ethernet for HA systems and it will consequently increase the loading due to the higher priority. PLC Load < 50 % and CPU load < 70 % should be considered as guidelines here instead, while setting the task times while setting the task times.
7. Following timeout values has to be defined in the user project according to the relation defined.

<table>
<thead>
<tr>
<th>Timeout variables (see definitions in box below table)</th>
<th>HA in V2</th>
<th>HA in V3</th>
</tr>
</thead>
<tbody>
<tr>
<td>timCI52xTimeOut</td>
<td>1 * Modbus Task time</td>
<td>50 ms or 2 * Modbus Task time, whichever is higher</td>
</tr>
<tr>
<td>timHaModSyncTimeOut</td>
<td>1 * HA Task time</td>
<td>2 * HA Task time</td>
</tr>
<tr>
<td>timResponseTimeout</td>
<td>Not applicable</td>
<td>50 ms or (3 * &quot;Modbus Task time&quot;), whichever is higher</td>
</tr>
<tr>
<td>timCanTimeOut</td>
<td>Not applicable</td>
<td>100 ms or increase in multiple of 100</td>
</tr>
<tr>
<td>timeLifecom2TimeOut</td>
<td>50 ms</td>
<td>50 ms</td>
</tr>
</tbody>
</table>

8. Add additional applications and SCADA communication: Check PLC and CPU load again vs. your requirements.

In the HA Modbus system different timeouts must be configured for the fine operation of the system as described above in the task configuration for V2 and V3 PLCs. These different timeouts meaning, and relation is explained below:

**timHaModSyncTimeOut:**
Time limit to check if the new sync data is received or not in the secondary PLC. If this timeout is not defined properly, Sync lost error/"lifecom1" lost error will be generated.

**timCanTimeOut:**
Time used for the check whether "lifecom2" is received when configured via CAN. This value is applicable only in AC500 V3. Lifecom2 via CAN won’t be stable between the PLCs and runtime error "lifecom2 lost" will be flickering if not the right value is configured.

**timCI52xTimeOut:**
Time limit to check whether new data is received in the Modbus field modules. It is also used to check whether "lifecom2" is received when configured via Modbus TCP. If "timCI52xTimeOut" is not defined as described, "lifecom2" error / communication interface diagnosis error will not be generated as expected.

**timResponseTimeOut:**
Timeout value to check whether CPU has lost the communication interface modules connected in the network. If this value is not defined as described, communication interface module lost detection will not be indicated properly.

**timeLifecom2TimeOut**
Time limit to check whether "lifecom2" is received when configured via Modbus TCP. Set "timeLifecom2TimeOut" value to default 50 ms, if the value is not defined correctly, runtime error “Lifecom2 lost” diagnosis error will not be generated as expected.

**Field I/O network topologies**

**General**

Modbus TCP communication between PLC and communication interface modules CI521-MODTCP or CI522-MODTCP can be done using different network topologies. In the following subchapters different simple combinations with their pros and cons are explained.
If a CI52x module of a daisy chain is powered off, next following modules will lose connection/data provided there is no redundancy in the Ethernet network (e.g. ring and managed switch).

Simple ring topology (smaller systems)

In a simple configuration, CI52x modules can be part of a ring if MRP (or DLR) protocol is used in the managed switches. Then the CI52x are connected from one to another device (“daisy chained”) through e.g. two network switches. The redundancy protocol detects a closed ring and opens one port of a managed switch to avoid the ring. The user has to configure the necessary ring configurations and enable the ring manager for the used ring ports in one switch.

It is recommended that time interval between ETH cable disconnection and re-connection should be greater than 2-3 seconds.

Standard network topology (large systems)

In the standard redundant network, which is often done by third party dedicated telecommunication companies, managed switches are used for every connection point to this network. It’s the network’s (and operator’s) responsibility to repair any failure fast enough so that no influence on the HA system or its outputs occur.

Fig. 305: Redundant ring topology with 2 MRP switches (avoids a SPOF (Single Point Of Failure))
The network can use other fast redundancy algorithms, also having other than ring structures, if redundancy links are activated fast enough.

**Fig. 306: Redundant ring topology with independent network (using any fast redundancy mechanism internally in a ring or meshed network)**

**Parallel network topology (using PRP)**

Each CI52x module and PLCs as single ended devices are connected by PRP switches to both networks. Here the failure of the switch which connects the primary CPU will also lead to a switchover.
Redundancy switchover timing should match the settings in the program and communication interface modules for time-out and freeze periods. The networks for larger systems are often seen as a separate entity and done by a separate company. Make sure to have the redundancy status information of the network at least in SCADA, to repair in time. If the I/O field network responsibility is with the automation/PLC part, the redundancy status should be also monitored by the PLC. A warning to initiate repair may be created from the managed switches in the I/O field network.

**Examples**

- Alarm output(s) wired (e.g. to a CI52x input and related settings of the switch(es)).
- Settings of the switch(es) to send (e.g. SNMP traps, which can be received in PLC (AC500 SNMP library)).
- Use of "automation switches" which can also communicate their status directly via Modbus.

---

It is also possible to connect switches in ring combination with CI modules connected to them in daisy chain. User needs to do the relevant setting based on type of switch and protocol (Ex: MRP, RSTP).

If RSTP ring configuration is used in the system, ring reconfiguration time is slower than other ring protocols. During this reconfiguration, connection to the CI modules will be lost.

---

HA Modbus system without communication interface modules in the network

It is also possible to have a HA Modbus system without connecting any field devices, CI521-MODTCP / CI522-MODTCP in the network. This system can be used for establishing a redundant PLC system with data synchronization between two AC500 controllers, either without field IO or with user integration of other protocols to field-IO or "intelligent" IO: CPUs as field devices.
Secondary will be on hot standby with primary PLC, during a power off/stop of the primary PLC. Secondary will take over the control and continue the process. Any user integrated field-IO or CPUs can establish communication mapped with the primary bit: parallel reading but prevent parallel writing.

HA without CI modules can be also used during commissioning to check the data sync, OPC and SCADA related communications without any field devices configured. The user has to set the global variable ‘xNoCiBus’ to TRUE defined in the HA_GLOBAL_VARIABLES. This variable has to be set to TRUE in both PLCs. Note: It is not advised to update this variable during run time.

![Diagram](image)

*Fig. 308: Simple SCADA connection*

### 6.5.9.1.6 Getting started

**Quick start list and guidelines**

**Workflow**

![Diagram](image)

*Fig. 309: Engineering workflow using Automation Builder*

Simple steps to engineer the HA Modbus system is explained in the following chapters.

**Configuration without communication interface modules to establish redundancy**

Configuration of the HA system without communication interface modules to establish redundancy is done by the following steps (for details see the example documentations):
1. Install the hardware \(\text{Chapter 6.5.9.1.2} \) “Hardware, requirements and options overview” on page 3862.

2. Select the CPUs based on the requirements \(\text{Chapter 6.5.9.1.2.2} \) “CPU choice, system size and performance indications” on page 3864.

3. Install Automation Builder including the latest libraries \(\text{Chapter 6.5.9.1.4} \) “How to get and install the AC500 High Availability system package” on page 3878.

4. Create a new project in Automation Builder for the chosen CPUs.

5. Configure the required Modbus and UDP configuration in the Automation Builder device tree of the CPU.

6. For UDP in AC500 V2 PLC, configure “UDP_no_AC31_header” and set the port number to value “3000”.

7. Assign the IP addresses in ≥ 2 different Ethernet networks:
   - SCADA network: SCADA, connected PLC A and PLC B
   - Field network: connected CI52x module(s)

8. Configure the mandatory HA_MOD_CONTROL function block for the HA task \(\text{HA program} \) on page 3882.

9. Add Callback stop function HA_MOD_CALLBACK_STOP and call it in the system event “stop”.

10. Add optional HA utility function blocks or function block HA_MOD_DATASYNC.
11. Make the global variable xNoCiBus = TRUE to run the system without communication interface module configured in the system. Chapter 6.5.9.1.5.4.5 “HA Modbus system without communication interface modules in the network” on page 3889.

![Diagrma of HA Modbus system without communication interface modules in the network](image)

12. Add the task configuration. Chapter 6.5.9.1.5.3 “Task configuration recommendations for HA system” on page 3884.

13. Activate the runtime license if it is a V3 PLC to enable HA system. Chapter 6.3.2.2.2 “PLC runtime licensing” on page 1446.

14. Compile and download to both PLCs (simplified in V3 via integrated download manager).

15. Create a boot project, restart the complete system and RUN.

16. Operation: Test use cases (e.g. by putting the primary PLC to STOP mode and observe the switchover). For different use cases and behavior refer to.

17. Runtime error and diagnosis function block can be used to monitor the system. Chapter 6.5.9.1.8 “Diagnosis” on page 3895.

Configuration with communication interface modules and redundancy

For medium or large HA systems the configuration with communication interface modules and redundancy is done by the following steps. For details see the example documentations:

1. Install the hardware. Chapter 6.5.9.1.2 “Hardware, requirements and options overview” on page 3862.

2. Select the CPUs based on the requirements. Chapter 6.5.9.1.2.2 “CPU choice, system size and performance indications” on page 3864.

3. Install Automation Builder including the latest libraries. Chapter 6.5.9.1.2 “Hardware, requirements and options overview” on page 3862.

4. Install the Bulk Data Manager tool (BDM). Chapter 6.5.9.1.4 “How to get and install the AC500 High Availability system package” on page 3878.

5. Create a new project in Automation Builder for the chosen CPUs.
6. Configure the required Modbus and UDP configuration in the Automation Builder device tree of the CPU. UDP settings are only required in AC500 V2 PLCs.

7. For UDP in AC500 V2 PLC, configure "UDP_no_AC31_header" and define the port number as '3000'.

8. In AC500 V2 PLCs for each CM597-ETH communication module added the "Send timeout" value has to be changed to 600 ms for the Modbus TCP server.
9. Assign the IP addresses in ≥ 2 different Ethernet networks:
   - SCADA network: SCADA, connected PLC A and PLC B.
   - Field network: connected CI52x module(s).

10. Configure a network switch in the field network (if managed /redundant) based on network redundancy required § Chapter 6.5.9.1.5.4 “Field I/O network topologies” on page 3886.

11. Run BDM tool to configure CI52x network.

12. Export the files. Refer for details in the document: %ALLUSERSPROFILE%\Documents\Automation Builder Examples\PS5601-HA-MTCP\BulkDataManager\Documentation.

13. Import the Bulk data export files to the Automation Builder project.


15. For the system with V3 PLCs, set the Communication Schema to “Onboard Ethernet” “CPU Parameters“ for better performance.

16. Add Callback stop function HA_MOD_CALLBACK_STOP and call it in the system event “stop”.

17. Add optional HA utility function blocks or function block HA_MOD_DATASYNC.

18. Add the task configuration § Chapter 6.5.9.1.5.3 “Task configuration recommendations for HA system” on page 3884.
19. Activate the runtime license if it is a V3 PLC to enable HA system "PLC runtime licensing" on page 1446.

20. Compile and download to both PLCs (simplified in V3 via integrated download manager).

21. Create a boot project, restart the complete system and RUN.

22. Operation: Test use cases (e.g. by putting the primary PLC to STOP mode and observe the switchover).

23. For different use cases and behavior refer to 'Failures and use cases' "Failures and use cases" on page 3869.

24. Runtime error and diagnosis function block can be used to monitor the system "Diagnosis" on page 3895.

6.5.9.1.7 HA-Modbus TCP Limits

HA-Modbus TCP is supported as of Automation Builder 2.0 or higher and the corresponding AC500 CPUs mentioned previously. AC500 V3 PLC is currently not supporting external ETH communication modules. Therefore, onboard ETH1, ETH2 (and eventually CAN) ports are to be used for communication.

3000 sync instances can be used: Either 3000 HA_MOD_DATA_SYNC function block instances alone or together 3000 instances of HA_MOD_DATA_SYNC including + HA utility function block can be used. If more than 3000 instances are configured user can see the error at xHaModDataErr = True and wHaModDataErNo = 16#2022 in HA_GLOBAL_VARIABLES.

The maximum length of sync data at an instance of HA_MOD_DATA_SYNC function block would be 1412 bytes. The maximum size of sync data which can be synced between PLC A and PLC B in total can be max. 60 000 bytes.

The HA-Modbus TCP system takes care of the first fault only. This fault must be visualized by the programmer and overall system (e.g. HMI, SCADA) to the operator, to plan and repair as soon as possible as redundancy might be lost. If more than one error occurs, system may not react to second or following faults.

SCADA/ HMI has to be configured/programmed to:

- Only read data from the primary PLC.
- Parameters and control data should be always written to both PLCs or has to be synchronized via the function block.

This is given automatically when using OPC DA, where the CODESYS OPC Server does this switching for the connected clients according to the primary status. For CP600 HMI a script is available to switch likewise (connected via the internal AC500 protocol or Modbus). Zenon as a SCADA also uses the AC500 protocol to automatically switchover.

6.5.9.1.8 Diagnosis

General

This chapter explains the diagnosis information available to the user in the HA Modbus library and CI52x library. Diagnosis information is available at the outputs of HA control function block, HA Diagnosis function block and at the CI52x function block.

Depending on the use case different diagnosis information can be accessed.

"Functionality" on page 3869
Primary CPU currently can read-out the diagnosis information (CI52x function block outputs) from communication interface module only once, hence secondary PLC will not be able to read the diagnosis information from the CI52x module.

So if any change happens in CI52x diagnosis it is not reflected in the secondary CPU.

This can lead to different diagnosis information of CI52x module in the primary and the secondary CPU. Hence it is recommended to customers that diagnosis information should be handled in the application (e.g. SCADA).

---

Diagnosis in HA-Modbus TCP library

In the HA Modbus library diagnosis information is available at the control block and diagnosis block.

**Output System Configuration**

This output at the HA control block gives the information of system configuration. Each bit of the word represents a different configuration.

<table>
<thead>
<tr>
<th>Bit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Sync is configured via CAN</td>
</tr>
<tr>
<td>1</td>
<td>Sync is configured via UDP</td>
</tr>
<tr>
<td>2</td>
<td>Lifecom2 is configured via CAN</td>
</tr>
<tr>
<td>3</td>
<td>Lifecom2 is configured via UDP</td>
</tr>
<tr>
<td>4</td>
<td>Lifecom2 is configured via Modbus TCP</td>
</tr>
<tr>
<td>5</td>
<td>Initialization for Ethernet configuration</td>
</tr>
</tbody>
</table>

**Output System Configuration error**

This output at the HA control block gives the details of error in the configuration. Each bit of the word represents different configuration errors. It is valid only when Error = TRUE.

<table>
<thead>
<tr>
<th>Bit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Communication interface module is not configured properly</td>
</tr>
<tr>
<td>1</td>
<td>SyncSlot1: Invalid value at input sync slot</td>
</tr>
<tr>
<td>2</td>
<td>SyncSlot2: Invalid value at input second slot</td>
</tr>
<tr>
<td>3</td>
<td>Value at IpAdrCpuASync is invalid</td>
</tr>
<tr>
<td>4</td>
<td>Value at IpAdrCpuBSync is invalid</td>
</tr>
<tr>
<td>5</td>
<td>Value at IpAdrCpuALifecom2 is invalid</td>
</tr>
<tr>
<td>6</td>
<td>Value at IpAdrCpuBLifecom2 is invalid</td>
</tr>
<tr>
<td>7</td>
<td>IpAdrCpuASync = IpAdrCpuBSync or IpAdrCpuALifecom2 = IpAdrCpuBLifecom2</td>
</tr>
</tbody>
</table>

**Output Runtime error**

This output at the HA control block gives the details of the error during run time of the system. Each bit of the word represents different runtime errors. It will not set Error = FALSE.
### Bit Description

<table>
<thead>
<tr>
<th>Bit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Communication interface modules are lost</td>
</tr>
<tr>
<td>1</td>
<td>Other CPU is not active</td>
</tr>
<tr>
<td>2</td>
<td>Lifecom1 is lost (part of sync)</td>
</tr>
<tr>
<td>3</td>
<td>Lifecom2 is lost. This error will not be TRUE if the PLC is in STOP status. This is because Modbus is still responding even when PLC is in STOP</td>
</tr>
<tr>
<td>4</td>
<td>Synchronization is lost</td>
</tr>
<tr>
<td>5</td>
<td>Error in synchronization</td>
</tr>
<tr>
<td>6</td>
<td>Ethernet status error</td>
</tr>
<tr>
<td>7</td>
<td>Other PLC lost communication to CI52x modules</td>
</tr>
<tr>
<td>8</td>
<td>CAN_HEADER function block has error</td>
</tr>
<tr>
<td>9</td>
<td>CAN_DATA function block has error</td>
</tr>
<tr>
<td>10</td>
<td>fbGetOwnIP function block has error</td>
</tr>
</tbody>
</table>

### Diagnosis function block

Outputs at the HA Diagnosis function block, HaModDiag (V3) / HA_MOD_DIAG (V2) provides the following diagnosis information of the HA system.

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CpuAPrimary / CPUA_PRIMARY</td>
<td>TRUE indicates CPU A is primary</td>
</tr>
<tr>
<td>CpuBPrimary / CPUB_PRIMARY</td>
<td>TRUE indicates CPU B is primary</td>
</tr>
<tr>
<td>CpuARun / CPUA_RUN</td>
<td>TRUE means CPU A is in RUN mode</td>
</tr>
<tr>
<td>CpuBRun / CPUB_RUN</td>
<td>TRUE means CPU B is in RUN mode</td>
</tr>
<tr>
<td>CpuACl52xBusActive / CPUA_CI52x_BUS_ACTIVE</td>
<td>Modbus TCP CI52x bus active on CPU A</td>
</tr>
<tr>
<td>CpuBCl52xBusActive / CPUB_CI52x_BUS_ACTIVE</td>
<td>Modbus TCP CI52x bus active on CPU B</td>
</tr>
<tr>
<td>CpuACl52xCfg / CPUA_CI52x_CFG</td>
<td>Total number of CI52x configured on CPU A</td>
</tr>
<tr>
<td>CpuBCl52xCfg / CPUB_CI52x_CFG</td>
<td>Total number of CI52x configured on CPU B</td>
</tr>
<tr>
<td>CpuACl52xAct / CPUA_CI52x_ACT</td>
<td>Total number of CI52x active on CPU A line</td>
</tr>
<tr>
<td>CpuBCl52xAct / CPUB_CI52x_ACT</td>
<td>Total number of CI52x active on CPU B line</td>
</tr>
<tr>
<td>SyncInstances / SYNC_INSTANCES</td>
<td>Number of data sync and utility blocks initialized in the system</td>
</tr>
<tr>
<td>SyncDataChecksum / SYNC_DATA_SUM</td>
<td>Checksum of all address pointer blocks in bytes, indicates total number of bytes getting synchronized.</td>
</tr>
</tbody>
</table>
StHACpuStatus / stHA_CPU_STATUS

HA own CPU status. It will show the status details of logged in CPU for the following parameters:
- HA1: CPU A is primary
- HA2: CPU B is primary
- bit_CI52x_BUS_active: CI52x bus with one or more communication interface modules active
- bit_CI52x_BUS_err: CI52x bus one or more communication interface modules powered off / connection lost
- RUN: Run status of CI52x
- cnt: Count of data sync communication, indicates data sync between CPUs is okay.

StHAotherCpuStatus / stHA_OTHER_CPU_STATUS

HA other CPU status. It will show the status details of other CPU for the following parameters:
- HA1: CPU A is primary
- HA2: CPU B is primary
- bit_CI52x_BUS_active: CI52x bus with one or more communication interface modules active
- bit_CI52x_BUS_err: CI52x bus one or more communication interface modules powered off / connection lost
- RUN: Run status of CI52x
- byETH_ACT_CI52x_Count: CI52x alive identification count.

Other diagnosis variables

Apart from the errors / diagnosis information available in the control and diagnosis block, few other variables can be monitored too.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>wHA_ER_NO_SYNC_LINK</td>
<td>16#7487</td>
<td>No sync link between the PLCs</td>
</tr>
<tr>
<td>HA_MOD_INVALID_LENGTH</td>
<td>16#2017</td>
<td>Invalid length at the input of the data sync block</td>
</tr>
<tr>
<td>HA_MOD_ERNO_TBL_OVERFLOW</td>
<td>16#2022</td>
<td>HA data reference table is full</td>
</tr>
<tr>
<td>xHaModDataErr</td>
<td>TRUE</td>
<td>IF TRUE – HA data sync is in error state</td>
</tr>
<tr>
<td>wHaModDataErNo</td>
<td></td>
<td>HA data sync error code</td>
</tr>
<tr>
<td>xHaModErr</td>
<td>TRUE</td>
<td>HA system is in error state</td>
</tr>
<tr>
<td>dwHaModServerAlive</td>
<td></td>
<td>Life counter incremented by OPC DA server</td>
</tr>
</tbody>
</table>
Diagnosis in CI52x library

In addition to the diagnosis information in the HA Modbus library, additional diagnosis information for each communication interface module can be obtained from the CI52x library.

System Configuration error

This output at the CI52x function block gives the details of the configuration error in the CI52x module. Each bit of the byte represents different configuration errors:

<table>
<thead>
<tr>
<th>Bit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Reserved</td>
</tr>
<tr>
<td>1</td>
<td>Wrong ETH port is configured at input Config ETH</td>
</tr>
<tr>
<td>2</td>
<td>Wrong IP address is configured for communication interface module</td>
</tr>
</tbody>
</table>

Runtime error

RuntimeError (v3) / RUNTIME_ERROR (v2) of the function block CiModCi52x (v3) / CI_MOD_CI52x (v2). Runtime error is a combination of error bits that are described in the following:

<table>
<thead>
<tr>
<th>Runtime Error</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit 0</td>
<td>Indicates communication error i.e., when CPU is not able to get any response from CI52x module. This error will get reset when communication is reestablished.</td>
</tr>
<tr>
<td>Bit 1</td>
<td>Indicates parameter state is not equal to 2 (PARA_STATE_PARA_DONE). If not true, then system gives I/O bus error. System resets this error when parameter state is equal to 2.</td>
</tr>
<tr>
<td>Bit 2</td>
<td>Indicates the cluster error (^1) in the system, if there is an error in the diagnosis buffer. ACK input is needed to reset this error.</td>
</tr>
<tr>
<td>Bit 3</td>
<td>Indicates the hardware configuration error, mismatch between configuration and actual hardware detected. System automatically resets this error when the hardware matches.</td>
</tr>
<tr>
<td>S-ERR (LED on communication interface module)</td>
<td>Indicates that there is some issue with channel configuration in the cluster (^1). It is not linked with Runtime Error. User can read DiagBuffer (v3) / DIAG_BUFFER (v2) from CiModDiag (v3) / CI_MOD_DIAG (v2) function block to get more information. This error does not get reset using ACK. It will only reset when all channel errors are removed.</td>
</tr>
</tbody>
</table>

\(^1\) "Cluster" means a combination of one communication interface module and several I/O modules attached to it.

Runtime error in different scenarios:
<table>
<thead>
<tr>
<th>Error</th>
<th>Runtime error</th>
<th>PLC A: Primary</th>
<th>PLC B: Secondary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wrong IP address configured</td>
<td>16#1</td>
<td>TRUE</td>
<td>TRUE</td>
</tr>
<tr>
<td>Wrong slot address configured 1)</td>
<td>16#0</td>
<td>FALSE</td>
<td>FALSE</td>
</tr>
<tr>
<td>Communication cable disconnected</td>
<td>16#2</td>
<td>TRUE</td>
<td>TRUE</td>
</tr>
<tr>
<td>Wrong I/O module plugged in the CI module</td>
<td>16#B</td>
<td>BLINK</td>
<td>BLINK</td>
</tr>
<tr>
<td>Wrong hotswap I/O module plugged at the start</td>
<td>16#B</td>
<td>BLINK</td>
<td>BLINK</td>
</tr>
<tr>
<td>Wrong hotswap I/O module swapped online</td>
<td>16#4</td>
<td>FALSE</td>
<td>FALSE</td>
</tr>
<tr>
<td>Configured I/O module not connected at start 2)</td>
<td>16#B</td>
<td>BLINK</td>
<td>BLINK</td>
</tr>
<tr>
<td>Configured hotswap I/O module not connected at start 2)</td>
<td>16#B</td>
<td>BLINK</td>
<td>BLINK</td>
</tr>
<tr>
<td>I/O module powered off in CI module 2)</td>
<td>16#4</td>
<td>FALSE</td>
<td>FALSE</td>
</tr>
<tr>
<td>Hotswap I/O module powered off in CI module 2)</td>
<td>16#4</td>
<td>FALSE</td>
<td>FALSE</td>
</tr>
<tr>
<td>Remove hotswap I/O module when online 2)</td>
<td>16#4</td>
<td>FALSE</td>
<td>FALSE</td>
</tr>
<tr>
<td>Error</td>
<td>Run-time error</td>
<td>PLC A: Primary</td>
<td>PLC B: Secondary</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>----------------</td>
<td>----------------</td>
<td>-------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bit0 - comm error</td>
<td>Bit1 - I/O bus error</td>
</tr>
<tr>
<td>CI module is powered off</td>
<td>16#0</td>
<td>FALSE</td>
<td>FALSE</td>
</tr>
<tr>
<td>Mismatch in Channel configuration and wiring (^3)</td>
<td>16#0</td>
<td>FALSE</td>
<td>FALSE</td>
</tr>
<tr>
<td>Regular I/O module mounted on hotswap terminal unit (^4)</td>
<td>16#0</td>
<td>FALSE</td>
<td>FALSE</td>
</tr>
<tr>
<td>During an error stage if HA system changeover is initiated (^5)</td>
<td>16#0</td>
<td>FALSE</td>
<td>FALSE</td>
</tr>
</tbody>
</table>

1) Slot input in the block can be ignored. Similar to ETH input of the ModMast blocks.
2) Error generated only in the primary PLC, to reset ACK input to be used.
4) No runtime error in function block. Module generates S-Err.
5) Runtimer Error bit2 gets reset when the PLC is switched over and error won’t be available in any of the PLC regardless of its Primary status.
### Table 744: Function block CiModDiag (V3) and CI_MOD_DIAG (V2)

<table>
<thead>
<tr>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DevState / DEV_STATE</td>
<td>CI521 or CI522 device current status is displayed.</td>
</tr>
<tr>
<td></td>
<td>• STATE_PREOP: Device is booting</td>
</tr>
<tr>
<td></td>
<td>• STATE_OPERATION: Device is operational, no bus supervision is active</td>
</tr>
<tr>
<td></td>
<td>• STATE_ERROR: Device detected a bus error, bus supervision is active</td>
</tr>
<tr>
<td></td>
<td>• STATE_IP_ERROR: Device has an IP address error</td>
</tr>
<tr>
<td></td>
<td>• STATE_CYLIC_OPERATION: Device is operational, bus supervision is active</td>
</tr>
<tr>
<td></td>
<td>• STATE_NA: Not available</td>
</tr>
<tr>
<td>ParaState / PARA_STATE</td>
<td>CI521 or CI522 device parameter status.</td>
</tr>
<tr>
<td></td>
<td>• PARA_STATE_NO_PARA: Device has no parameters</td>
</tr>
<tr>
<td></td>
<td>• PARA_STATE_PARA_ACTIVE: Parameterization process is running</td>
</tr>
<tr>
<td></td>
<td>• PARA_STATE_PARA_DONE: Device used valid parameters and parameterization is done</td>
</tr>
<tr>
<td></td>
<td>• PARA_STATE_ERROR: Device has invalid parameters</td>
</tr>
<tr>
<td></td>
<td>• PARA_STATE_NA: Not available</td>
</tr>
<tr>
<td>DeviceInfo / DEVICE_INFO</td>
<td>CI521 or CI522 type and extended module types. This will give the details of the module configured in the communication interface module including the I/O modules.</td>
</tr>
<tr>
<td></td>
<td>If module is with suffix F, then fast counter is enabled for that module.</td>
</tr>
<tr>
<td>DiagBuffer / DIAG_BUFFER</td>
<td>CI521 or CI522 module diagnosis buffer (\xi) Chapter 6.8.4.1.2.3.3 “Diagnosis data” on page 4576.</td>
</tr>
<tr>
<td>ErClass / ERR_CLASS</td>
<td>Communication interface error class (\xi) Chapter 6.9.3 “Diagnosis messages” on page 4655.</td>
</tr>
<tr>
<td>ErNo / ERR_NO</td>
<td>Communication interface error number (\xi) Chapter 6.9.3 “Diagnosis messages” on page 4655.</td>
</tr>
<tr>
<td>ModMastErr / MOD-MAST_ERR</td>
<td>Latest 22 Modbus TCP error message status of the ModMastTcp (V2) / COM_MOD_MAST (V2) function block.</td>
</tr>
<tr>
<td>ModMastErNo / MOD-MAST_ERR_NO</td>
<td>Latest 22 Modbus TCP error numbers. Refer to the error details in Modbus library (\xi) Chapter 6.5.9.1.8.2 “Diagnosis in HA-Modbus TCP library” on page 3896.</td>
</tr>
<tr>
<td></td>
<td>V3: Refer to the ERROR_ID enumeration in the Modbus TCP library (in the Library Manager)</td>
</tr>
</tbody>
</table>

### 6.5.9.1.9 Library overview

**Documentation**

CODESYS V3 libraries are described in the Library Manager as an integrated documentation. Refer to the documentation section within the Library Manager.

The following function blocks are contained in the libraries:
HA-Modbus TCP
Library
6.5.10 Motion Control

6.5.10.1 Motion wizard

This section is an introduction to the key features and tools, which will be used during the motion solution project.

6.5.10.1.1 Introduction to the project

Understanding the “Motion Solution Project”

The project type “Motion Solution Project” is an AC500 project with an inbuilt “Motion Solution Wizard” which helps guide the user intuitively though a step-by-step process to add and configure the motion axis in a few simple steps.

Understanding the “Motion Solution Wizard”

The “Motion Solution Wizard” is a tool which helps the user to efficiently configure the motion axis. The motion wizard helps the user to configure the axis based on PTO or EtherCAT using 2.7.0.

The time saving functions this includes are; code writing, adding hardware and intuitively setting up PDO mapping. Afterwards the user can proceed by adding further PLCopen function blocks based on their application needs.

Understanding the “Motion Specific Device” objects

When using the motion solution to commission the user will come across motion specific objects. These are devices which allow the user to represent:
- Real EtherCAT axes
- Real PTO axes
- Encoders (used for following or closing the position loop)
- Virtual axes (used for following)

Each of these elements contain a motion axis object for configuration.

**Understanding the motion axis objects**

When using the “Motion Solution Project”, motion axis objects are used to configure the axis behavior. These are device tree elements which allow the user to:

- define the motor position system type,
- mechanical units, gearing, and scaling
- control settings (PID)
- PLC Limits (Speed, acceleration etc.)
- PDO mapped data (Only for EtherCAT axis)
- “Drive Control Mode” (Only for EtherCAT axis)

### 6.5.10.1.2 Installing the latest “Motion Control Wizard” and libraries

As described earlier, during the Automation Builder installation process, or later when opening the Installation Manager the “Motion Control (PS5611)” option can be selected and installed. After this step is carried out, the latest version of libraries and motion control tools (such as the “Motion Control Wizard”, Cam editor etc) are available to be used.

### 6.5.10.1.3 Introduction to the PLC capabilities

**Selection of the correct AC500 PLC type**

AC500-eCo CPU (type dependent)

- Supports up to 4 PTO channels – (1ms> Profiling time)
- Support onboard EtherCAT – (1ms> Profiling time)

AC500 CPU (e.g.PM56xx-2ETH)

- Supports only motion via EtherCAT using the CM579-ECAT communication module (0.5ms >)

Each variant has a different limitation which are explained in the following chapters.

**PTO operations**

Due to differences in the performance of CPU types, there are different limits.

**PTO profiling cycle time limits**

On the minimum cycle times configurable in each PLC type. These are detailed below:

<table>
<thead>
<tr>
<th>PLC Type</th>
<th>PM5032</th>
<th>PM5052</th>
<th>PM5072</th>
<th>PM 5082</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min. cycle time</td>
<td>5 ms</td>
<td>2 ms</td>
<td>1 ms</td>
<td>1 ms</td>
</tr>
</tbody>
</table>
PTO hardware limits

Within the AC500-eCo range there are different revisions of hardware available. The revision 0 hardware can only support 2 * 200 kHz or 4 * 100 kHz PTO, where in revision 1 or higher can support 4 * 200 kHz PTO channels. To know if you have a revision 1 AC500-eCo PLC, please refer to the SAP number on the side of the PLC.

- “Revision 1 CPU” has order number 1SAPxxxxxxR017x
- “Revision 0 CPU” has order number 1SAPxxxxxxR007x

Selection of different revision CPU's

Within the wizard page there is a checkbox for selecting of hardware is revision 1 or higher (default) or older revision 0 hardware. The tick box should be made matching your revision.

Revision 1 or higher CPU

Up to 4 * 200 kHz (default) PTO axis

When the axis is configured in revision 1 CPU, output channels 0 to 3 are available for 200 kHz outputs. This means “Output 0” to “Output 3” for direction (PTOx Dir) and “Output 4” to “Output 7” for pulse/step (PTOx HS Pulse) and users need to connect the PTI drive cables accordingly.

Wiring example:

The below table shows the user an overview of the hardware channels configured based on the number of axes configured, this can be used as a reference for the pulse and direction wiring to PTI drive.
<table>
<thead>
<tr>
<th>HW channel selection</th>
<th>DO0</th>
<th>DO1</th>
<th>DO2</th>
<th>DO3</th>
<th>DO4</th>
<th>DO5</th>
<th>DO6</th>
<th>DO7</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Output/PTO0 Dir</td>
<td>Output/PTO0 Dir</td>
<td>Output/PTO0 Dir</td>
<td>Output/PTO0 Dir</td>
<td>Output/PTO0 Dir</td>
<td>Output/PTO0 Dir</td>
<td>Output/PTO0 Dir</td>
<td>Output/PTO0 Dir</td>
</tr>
<tr>
<td>Axis1 200 kHz axis</td>
<td>200</td>
<td>200</td>
<td>200</td>
<td>200</td>
<td>200</td>
<td>200</td>
<td>200</td>
<td>200</td>
</tr>
<tr>
<td>Axis2 200 kHz axis</td>
<td>200</td>
<td>200</td>
<td>200</td>
<td>200</td>
<td>200</td>
<td>200</td>
<td>200</td>
<td>200</td>
</tr>
<tr>
<td>Axis3 200 kHz axis</td>
<td>200</td>
<td>200</td>
<td>200</td>
<td>200</td>
<td>200</td>
<td>200</td>
<td>200</td>
<td>200</td>
</tr>
<tr>
<td>Axis4 200 kHz axis</td>
<td>200</td>
<td>200</td>
<td>200</td>
<td>200</td>
<td>200</td>
<td>200</td>
<td>200</td>
<td>200</td>
</tr>
</tbody>
</table>

Number of PTO axis per PLC (Below are the maximum PTO axes combinations possible based on the PTO frequency configured).

- Max 4 PTO axis - 100 kHz
- Max 3 PTO axis - two 100 kHz and one 200 kHz (200 kHz axis must not be configured between to 100 kHz axis)
- Max 2 PTO axis - 200 kHz
When the axis is configured as 100 kHz, output channel “Output 0” to “Output 3” are configured as direction output (Value = PTOx Dir) and “Output 4” to “Output 7” are configured as pulse (Value = PTOx LS Pulse) and users need to connect the PTI drive cables accordingly.

The below table shows the user an overview of the hardware channels configured based on the number of axes configured, this can be used as a reference for the pulse and direction wiring to PTI drive.

<table>
<thead>
<tr>
<th>HW channel selection</th>
<th>Axis1</th>
<th>Axis2</th>
<th>Axis3</th>
<th>Axis4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axis frequency in kHz</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>DO0</th>
<th>Output/PTO0 Dir</th>
<th>Output/PTO0 Dir</th>
<th>Output/PTO0 Dir</th>
<th>Output/PTO0 Dir</th>
</tr>
</thead>
<tbody>
<tr>
<td>DO1</td>
<td>Output/PTO1 Dir</td>
<td>Output/PTO1 Dir</td>
<td>Output/PTO1 Dir</td>
<td>Output/PTO1 Dir</td>
</tr>
<tr>
<td>DO2</td>
<td>Output/PTO2 Dir</td>
<td>Output/PTO2 Dir</td>
<td>Output/PTO2 Dir</td>
<td>Output/PTO2 Dir</td>
</tr>
<tr>
<td>DO3</td>
<td>Output/PTO3 Dir</td>
<td>Output/PTO3 Dir</td>
<td>Output/PTO3 Dir</td>
<td>Output/PTO3 Dir</td>
</tr>
<tr>
<td>DO4</td>
<td>PWM/PTO0 LS Pulse</td>
<td>PWM/PTO0 LS Pulse</td>
<td>PWM/PTO0 LS Pulse</td>
<td>PWM/PTO0 LS Pulse</td>
</tr>
<tr>
<td>DO5</td>
<td>PWM/PTO1 LS Pulse</td>
<td>PWM/PTO1 LS Pulse</td>
<td>PWM/PTO1 LS Pulse</td>
<td>PWM/PTO1 LS Pulse</td>
</tr>
<tr>
<td>DO6</td>
<td>PWM/PTO2 LS Pulse</td>
<td>PWM/PTO2 LS Pulse</td>
<td>PWM/PTO2 LS Pulse</td>
<td>PWM/PTO2 LS Pulse</td>
</tr>
<tr>
<td>DO7</td>
<td>PWM/PTO3 LS Pulse</td>
<td>PWM/PTO3 LS Pulse</td>
<td>PWM/PTO3 LS Pulse</td>
<td>PWM/PTO3 LS Pulse</td>
</tr>
</tbody>
</table>
When two PTO axes are configured as 100 kHz, the “Motion Solution Wizard” set the onboard output configuration. For the first axis, direction as “Output 0” and pulse as “Output 4” and for the second axis direction as “Output 1” and pulse as “Output 5”.

When the axis is configured as 200 kHz, output channel “Output 4” (Value = PTOx HS Pulse) and “Output 5” (Value = PTOx HS Dir) are configured as pulse and direction output for the first axis and “Output 6” and “Output 7” is configured as pulse and direction output for the second axis.

Below table shows the user an overview of the hardware channels configured based on the number of axes configured, this can be used as a reference for the pulse and direction wiring to PTI drive.

<table>
<thead>
<tr>
<th>HW channel selection</th>
<th>Axis frequency in kHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axis1</td>
<td>200</td>
</tr>
<tr>
<td>Axis2</td>
<td>200</td>
</tr>
<tr>
<td>Axis3</td>
<td></td>
</tr>
<tr>
<td>Axis4</td>
<td></td>
</tr>
<tr>
<td>DO0</td>
<td>Output/PTO0 Dir</td>
</tr>
<tr>
<td>DO1</td>
<td>Output/PTO1 Dir</td>
</tr>
<tr>
<td>DO2</td>
<td>Output/PTO2 Dir</td>
</tr>
<tr>
<td>DO3</td>
<td>Output/PTO3 Dir</td>
</tr>
<tr>
<td>DO4</td>
<td>PWM/PTO0 LS Pulse</td>
</tr>
<tr>
<td></td>
<td>PTO0 HS Pulse/Cw</td>
</tr>
<tr>
<td></td>
<td>PTO0 HS Single O</td>
</tr>
<tr>
<td>DO5</td>
<td>DO6</td>
</tr>
<tr>
<td>-----</td>
<td>-----</td>
</tr>
<tr>
<td>PWM/PTO1 LS Pulse</td>
<td>PWM/PTO2 LS Pulse</td>
</tr>
<tr>
<td>PTO0 HS Dir/Cw</td>
<td>PTO1 HS Pulse/Cw</td>
</tr>
<tr>
<td>PTO0 HS Single 1</td>
<td>PTO0 HS Dir/Cw</td>
</tr>
</tbody>
</table>

When two PTO axes are configured as 200 kHz, the “Motion Solution Wizard” set the onboard output configuration. For the first axis, Pulse as “Output 4” and direction as “Output 5” and for the second axis pulse as “Output 6” and direction as “Output 7”.

When some axes are configured as 100 kHz and some are configured as 200 kHz frequency, user must take care following points:

- Make sure the 200 kHz axis is configured as first or last axis and not in between 100 kHz axis.
- When the first axis is 200 kHz, Automation Builder will configure the “Output 4” and “Output 5” channels and for 100 kHz “Output 6” and “Output 7” is configured as pulse and “Output 2” and “Output 3” are configured as direction.
Below table shows the user an overview of the hardware channels configured based on the number of axes configured.

<table>
<thead>
<tr>
<th>HW channel selection</th>
<th>Axis frequency in kHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axis1</td>
<td>100 200 100 200 100</td>
</tr>
<tr>
<td>Axis2</td>
<td>200 100 100 200</td>
</tr>
<tr>
<td>Axis3</td>
<td>200 100 100</td>
</tr>
<tr>
<td>Axis4</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>DO0</th>
<th>Output/PTO0 Dir</th>
<th>Output/PTO0 Dir</th>
<th>Output/PTO0 Dir</th>
</tr>
</thead>
<tbody>
<tr>
<td>DO1</td>
<td>Output/PTO1 Dir</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DO2</td>
<td>Output/PTO2 Dir</td>
<td>Output/PTO2 Dir</td>
<td>Output/PTO2 Dir</td>
</tr>
<tr>
<td>DO3</td>
<td>Output/PTO3 Dir</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DO4</td>
<td>PWM/PTO0 LS Pulse PT00 HS Pulse/Cw PT00 HS Single 0</td>
<td>PWM/PTO0 LS Pulse PT00 HS Pulse/Cw PT00 HS Single 0</td>
<td>PWM/PTO0 LS Pulse PT00 HS Pulse/Cw PT00 HS Single 0</td>
</tr>
<tr>
<td>DO5</td>
<td>PWM/PTO1 LS Pulse PT01 HS Pulse/Cw PT00 HS Single 1</td>
<td>PT00 HS Pulse/Cw PT00 HS Single 1</td>
<td>PWM/PTO1 LS Pulse PT00 HS Pulse/Cw PT00 HS Single 1</td>
</tr>
<tr>
<td>DO6</td>
<td>PWM/PTO2 LS Pulse PT02 HS Pulse/Cw PT02 HS Single 2</td>
<td>PWM/PTO2 LS Pulse PT02 HS Single 2</td>
<td>PWM/PTO2 LS Pulse PT02 HS Single 2</td>
</tr>
</tbody>
</table>
| DO7 | PWM/PTO3 LS Pulse PT03 HS Pulse/Cw PT00 HS Single 3 | PWM/PTO3 LS Pulse PT00 HS Single 3 | PWM/PTO3 LS Pulse PT00 HS Single 3 | Configuration not allowed. Keep 200 kHz axis as first or last axis.
EtherCAT operation limits

Due to differences in the performance of CPU types, there are different limits for EtherCAT which are detailed below.

Configuration minimum EtherCAT cycle time in each PLC type

<table>
<thead>
<tr>
<th>PLC Type</th>
<th>PM5072</th>
<th>PM5082</th>
<th>PM5630</th>
<th>PM5650</th>
<th>PM5670/PM5675</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min. EtherCAT master cycle time configurable (ms)</td>
<td>2 ms</td>
<td>1 ms</td>
<td>2 ms</td>
<td>1 ms</td>
<td>0.5 ms</td>
</tr>
</tbody>
</table>

There are limits on the minimum cycle time for each PLC type and limit on the number of servo drives can be connected for each PLC type based on the cycle time configured. Refer the help file for more details (“PLC Automation with V3 CPUs ➔ Libraries and solutions ➔ Motion control library ➔ Preconditions for the use of the libraries”) and adapt the cycle time or PLC Type accordingly to avoid error messages during program download.

Maximum number of synchronized axes in each PLC type

<table>
<thead>
<tr>
<th>PLC Type</th>
<th>PM5072</th>
<th>PM5082</th>
<th>PM5630</th>
<th>PM5650</th>
<th>PM5670/PM5675</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of synchr. axis in 1 ms</td>
<td>-</td>
<td>4</td>
<td>-</td>
<td>8</td>
<td>16</td>
</tr>
<tr>
<td>Number of synchr. axis in 2 ms</td>
<td>4</td>
<td>8</td>
<td>4</td>
<td>16</td>
<td>32</td>
</tr>
<tr>
<td>Number of synchr. axis in 4 ms</td>
<td>8</td>
<td>16</td>
<td>8</td>
<td>32</td>
<td>64</td>
</tr>
</tbody>
</table>

These limits are based on the EtherCAT master cycle time configured in the EtherCAT master. The “Number of axes” is counted in Automation Builder are based on the axis configured, therefore PTO axis also counted in case if configured in the AC500-eCo Pro PLC.

Mor axis can be used by:

- Increasing the EtherCAT cycle time to accommodate a higher “Number of axes” in the same PLC type.
- Choosing a higher PLC type.

The “Motion Solution” window can be used to see how many axes are supported and how many are already used for the particular PLC type for the EtherCAT master cycle time configured by checking the slider at the bottom of the “Motion Solution Wizard” overview page:
6.5.10.1.4 Creation a new “Motion Solution Project”

Once the installation process is completed and the elements that will be needed in the configuration are known then the “Motion Solution Project” can be used to allow the user to create a matching configuration.

Creation a “New Project”

1. Start Automation Builder and select “New Project”.
2. Select the “Motion Solution Project” icon.
3. Click the [OK] button and a new project will be created in the specified location with the specified name.
Addition of a PLC

1. Automation Builder will now pop up a “Select PLC” window and from here user can select one of the V3 PLC’s.

   ![Select PLC window](image)

   The PLC type can be changed at any time using the steps outlined earlier.

2. Click the [Add PLC] button to get it added to Automation Builder hardware tree.
3. After selecting the PLC type, “Motion Solution Wizard” will guide the user to the “Motion Solution Wizard” page.
4. After creating the hardware tree, Automation Builder will launch the “Motion Solution Wizard” overview page. From here user can add the axis to the application.

   Depending on the PLC type selected some of the axis types are not possible for the user to add to the project.

Addition of the PTO axes

All AC500-eCo PLC’s are supported with a maximum of 4 PTO axis via onboard I/O channels. After creating the hardware tree, Automation Builder will launch the “Motion Solution Wizard” overview page. From here user can add the PTO axis to the application by clicking on the [Add PTO axis] button from the “Motion Solution Wizard” overview page.
1 objects

Nested underneath the “OnBoard_IO” object is the PTO axis object. From here users can configure each axis they have added separately as per the application requirement by opening the motion axis object which is added under the “OnBoard_IO”.

To do this double click on the object to open “Settings” tab.

Here user can update settings as per the application requirement. Later when downloading the application, the wizard will use these settings to define the operation and scaling of this axis object.
PTO axis settings

All settings related to the application and axis specific will be done here and need to be carefully updated for each axis. Based on the inputs provided here, wizard will compile and generate the code.

“Axis type”

The user can select the type of axis to be configured based on the application requirement.

Below is the list of settings which user can configure from the “Motion Control Wizard” along with their meanings:

<table>
<thead>
<tr>
<th>Axis type</th>
<th>Detail</th>
<th>Max Limit (Counts)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modulo (rotary)</td>
<td>Default setting in the wizard. By selecting the “Modulo” (rotary) your axis will be configured as a roll-over axis and the desired modulo range can be configured later.</td>
<td>16#7FFFFFFF[RB1]</td>
</tr>
<tr>
<td>Finite (rotary)</td>
<td>Your axis will be configured as a roll-over axis where in modulo range is non editable by the user and calculated based on the “Unit” selection, Inc_Per_R, U_Per_Rev_Nominator and U_Per_Rev_Denominator setting.</td>
<td>16#40000000</td>
</tr>
<tr>
<td>Linear (rotary screw)</td>
<td>This needs to be configured when the user having a rotary motor with linear movements (linear axis).</td>
<td>16#7FFFFFFF +/-</td>
</tr>
<tr>
<td>Linear (linear motor)</td>
<td>This needs to be configured when the user axis is a linear motor.</td>
<td>16#7FFFFFFF +/-</td>
</tr>
<tr>
<td>Axis simulation mode</td>
<td>This option is read only from here and needed when the user configured the axis but not have the real hardware yet. This can be selected from the “Motion Solution Wizard” overview page. Virtual axis configuration.</td>
<td>16#7FFFFFFF</td>
</tr>
<tr>
<td></td>
<td>© Chapter 6.5.10.1.4.6 “Addition of a virtual axis” on page 3932</td>
<td></td>
</tr>
</tbody>
</table>

“PTO ” (Hardware settings)

With “Revision 1 CPU” or higher, by default 4 * 200 kHz PTO axis is supported, there is no special settings needed in the axis configuration page.
If a “Revision 0 CPU” is used, user can set the PTO axis frequency to 100 kHz or 200 kHz using the drop down as shown below. Based on the PTO axis frequency selection, the onboard I/O configuration will be updated.

“Closed loop” By default, the PTO axis is open loop and however user can also configure a maximum of two PTO axis as closed loop.

To configure the axis as closed loop, user need to configure an encoder axis -> encoder source -> encoder channel -> encoder purpose as the PTO axis which needs to be a closed loop axis.

“Unit” Based on the application requirement user can select the desired unit in the wizard and the wizard will update the subsequent parameters to the selected user unit.

From the below picture user can find the currently supported unit formats.

As an example, when the user selects the axis type as “Modulo (rotary)” and unit as degree, the wizard will update the subsequent parameters to the selected user unit and fill with default values, ex: modulo range = 360 degree (default). However make sure the user updates the subsequent parameters as per the actual application requirement.

For rotary axis the units mm, µm, nm, and inch might lead to inaccuracy due to rounding errors.

“Pulses per revolution scaling” When the axis is open loop, user can update the “Pulses per revolution scaling” with the steps per revolution.

When the PTO axis is open loop, it is important that the user set the steps per revolution and maximum rpm by keeping the PTO frequency limits into consideration.

For example, for a 100 kHz PTO axis if the steps per revolution is 2000, the maximum rpm the axis can support is 3000 rpm (= 2000 * 3000/60 = 100 kHz)

“Application gearing” Based on the actual application requirement, here user can check/uncheck the “Application has gearing” check box. Here the user can also update the required tool travel distance per motor revolution.

When the user unchecks the “Application has gearing”, user can update the “Tool travel distance per motor revolution” as per the application requirement as shown in the below picture.
When the user checks the “Application has gearing”, user will be prompted to provide the gear box details additionally as shown in the below figure and during the generate application, the wizard will update the same accordingly.

“Modulo range” The user can provide the “Modulo range” here. This is the value at which the axis position will wrap back to zero. This window will be active only when the user selects the axis type as any of the rotary axis.

“Software limits” The user can configure some of the common “Software limits” from the wizard itself. Below is the list of software limits which user can configure from the wizard in the selected application units.

By default, software limits in wizard are not enabled and user need to enable the same by enabling the check box “Enable limits”.

“Direction correction” In some of the application we need to change the relationship between its real direction and that within the PLC program. By default, the check box will be unchecked, and the direction will be normal. By selecting the check box “Invert direction” both actual and reference position will be inverted, and the axis will move in opposite direction.
Here the user can configure the parameters related to position control and supervision. Details of each parameter is explained in our system technology chapter.

- Chapter 6.5.10.3.5.6.3 “Position control loop” on page 4028
- Chapter 6.5.10.3.5.6.2 “Supervision” on page 4027

The user can set the “Maximum application velocity” to a desired value to limit the maximum application speed.

Users can update the maximum limits here. Some parameters depend on the drive settings and needs to be set correctly to get the desired result.

The user can set the “Maximum application velocity” to a desired value to limit the maximum application speed.

Maximum reference value is the maximum frequency of the drive in which it reaches the maximum rpm. In some drives, the calculated maximum reference value may need to be modified, and user can select “Modify” box and change the value. Note, we have the hardware limitation as 100 kHz or 200 kHz based on the configuration and user must make sure this limitation is not crossed.

Maximum speed is recommended to keep the same maximum speed at the drive and at the PLC parameter.

Currently the applications torque limits in the wizard are not valid for PTO axis and this is ignored.

When the PTO axis is open loop, it is important that the user set the steps per revolution and maximum rpm by keeping the PTO frequency limits into consideration.

For example, for a 100 kHz PTO axis if the steps per revolution is 2000, the maximum rpm the axis can support is 3000 rpm ($= 2000 \times 3000/60 = 100$ kHz)

When in closed loop, set the maximum rpm for the axis to reach when the maximum PTO axis frequency is provided.
For example, if the axis is configured as 200 kHz and closed loop, set the maximum rpm for the axis to reach when the 200 kHz frequency is achieved.

“Results (calculated)” Based on the inputs provided, wizard will calculate the results and can be viewed immediately at the end of the configuration page.

<table>
<thead>
<tr>
<th>Results (calculated)</th>
<th>364.0889</th>
<th>pulses/degree</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>36000</td>
<td>degree/sec</td>
</tr>
<tr>
<td></td>
<td>3600</td>
<td>degree</td>
</tr>
</tbody>
</table>

Addition of an EtherCAT axes

From Automation Builder 2.7.0. users will have two options to realize an EtherCAT network:
Using the AC500 and CM579-ETH solution (as we have supported before) and the new option of use AC500-eCo PM5072 and PM5082 PLC’s (EtherCAT master using onboard ETH1 port.)

Differences of the AC500 and AC500-eCo wizard views

After creating the hardware tree the user has selected the CPU. Automation Builder will launch the “Motion Solution Wizard” overview page. As we can see below the user will see a slightly different view based on their selection.

AC500 CPU adding the EtherCAT master via CM579-ETHCAT

To start adding devices click the [Add CM579-ETHCAT axis] button.

AC500-eCo Pro CPU's adding the EtherCAT master onboard ETH1 port for AC500-eCo CPU's

1. To start adding devices click “Add onboard EtherCAT axis”.
2. Adding EtherCAT devices to the master.
Here user find any of EtherCAT drives or devices needed for the application. The user can also add the axis by right clicking on the “EtherCAT_Master” object and select the “Add Object” option or by using the [Add axis] button from “Motion Solution Wizard” overview page.

If user wants to add multiple servo drives, please uncheck the “Close this dialog after each transaction” check box (in left bottom corner) and add multiple drives without closing. In AC500 CPU user can add the EtherCAT motion axis only on the coupler slot 1.

Configuration of the EtherCAT master

As mentioned in the beginning of the chapter, user can now configure EtherCAT master in AC500 CPU via CM579-ETHCAT communication module or in AC500-eCo Pro PLC’s via onboard ETH1 port.

In general, all EtherCAT settings are similar in both solutions but in CM579-ETHCAT user will have more settings tab than onboard EtherCAT. Based on which EtherCAT solution is used, user needs to also use the relevant libraries for diagnosis/SDO handling etc.

For CM579-ETHCAT use the library “AC500_EtherCAT” and for onboard EtherCAT use the library “ETCStack”. Both solutions are not identical, and user need to manually adapt the applications incase if moving from CM579-ETHCAT to onboard EtherCAT or vice versa.

CM579-ETHCAT

These are the settings specific to CM579-ETHCAT master and not valid for onboard EtherCAT. The label will normally CM579_ETHCAT this can be changed by the user but is normally left as default. If so, the name will be CM579_ETHCAT (CM579-ETHCAT).

In most cases these settings can be left at default but occasionally the user might need to change these to fit the application requirements.

- “Run on Config Fault” – As default it is set to “Yes” meaning the CM579-ETHCAT will not go into error and the PLC program will not go into stop if a slave is lost, this is beneficial as the PLC is then still available to handle other follow up actions. This can be changed if the user wants a configuration where a missing slave will prevent the PLC running.
- “Distributed clocks” - As default it is set to “Active” which is a must if you want to use synchronised motion over EtherCAT.
- “Optimize I/O update” - As default it is set to “On” meaning that, consecutive I/O’s are merged in one block to optimize the performance.

ETHCAT_Master

This second part of the EtherCAT master defines the specific settings that define the behavior of the EtherCAT operation and from here settings are similar in both CM579-ETHCAT and in onboard EtherCAT.

Onboard EtherCAT is only possible to configure it on PM5072 and PM5082 ETH1 port. It is recommended not to configure any other protocols on the EtherCAT configured ETH port.
The label will normally be in the format of `[name](ETHCAT-Master)` this can be changed by the user but is normally left as default. If so, the name will be `ETHCAT_Master` (ETHCAT-Master). The most important settings for this are mentioned below:

- **“Auto-config master/slaves”** – As Default this is activated, this means the parameters are set automatically here in accordance with the default settings. This setting is recommended unless the user is very familiar with the setup of EtherCAT networks.
- **“Cycle time”** - The default EtherCAT cycle time is 4000 μs but based on the application requirement, user can adapt the EtherCAT cycle time as shown below.

![EtherCAT Slave Drive Object Settings](image)

*EtherCAT cycle time will directly influence the PLC load. If your PLC load is higher than desired, please increase the cycle time or upgrade the PLC type.*

**Configuration of the EtherCAT slave and axis**

This section explains how to configure the behavior of the Comms slave module. From here we can define how the hardware will behave. It's important to understand the EtherCAT slave axis once added is split into two parts in the project tree. These two parts are described below.

**EtherCAT slave drive object settings**

The label will normally be in the format of `[Drive name](Drive Type)` this can be changed by the user but is normally left as default. If so, the name could be “MicroFlex_e190” (MicroFlex-e190).

In most cases these settings can be left at default but occasionally the user might need to change these to fit the application requirements. Useful settings may be to enable “Expert Settings” to add additional PDO mappings, to check and set mappings or to check the status of the device once online.
PDO mappings

PDO and startup parameters (SDO)

Based on the selection under "Motion axis ➔ Mapping", PDO and startup parameters are generated automatically as shown below.

Based on the control type and PDO mapping selected in the wizard, it will update the “Process Data” tab from the slave axis object and assign the autogenerated name to each object which is added.

Like PDO mapping, SDO startup will be updated based on the control type and the mapping selected in the wizard.

User definition of PDO mappings

If the user wants to add additional PDO mapped objects first enable the “Expert settings”, then the user will get an additional tab called “Expert Process Data” below the general tab and here user can add/edit/delete the mapping.

EtherCAT axis settings

Nested underneath the EtherCAT slave drive object is the axis object, from here users can configure each axis as per the application requirement.
To open this double-click on the object to open the configuration page which then has two separate tabs, one for “Settings” and the other one for “Mapping”.

The user can update both the pages as per the application requirement.

Later during the “Generate application” process, the wizard will use these settings to define the operation and scaling of this axis object.

**EtherCAT axis object settings**

All settings related to the application and axis specific will be done here and need to be carefully updated for each axis. Based on the inputs provided here, wizard will compile and generate the code.

**“Axis type”**

The user can select the type of axis to be configured based on the application requirement.

Below is the list of settings which user can configure from the “Motion Control Wizard” along with their meanings:
### Axis type | Detail | Max Limit (Counts)
---|---|---
Modulo (rotary) | Default setting in the wizard. By selecting the “Modulo” (rotary) your axis will be configured as a roll-over axis and the desired modulo range can be configured later. | 16#7FFFFFFF[RB1]
Finite (rotary) | Your axis will be configured as a roll-over axis where in modulo range is non editable by the user and calculated based on the “Unit” selection, Inc_Per_R, U_Per_Rev_Nominator and U_Per_Rev_Denominator setting. | 16#40000000
Linear (rotary screw) | This needs to be configured when the user having a rotary motor with linear movements (linear axis). | 16#7FFFFFFF+/-
Linear (linear motor) | This needs to be configured when the user axis is a linear motor. | 16#7FFFFFFF+/-
Axis simulation mode | This option is read only from here and needed when the user configured the axis but not have the real hardware yet. This can be selected from the “Motion Solution Wizard” overview page. Virtual axis configuration. | 16#7FFFFFFF

**“Unit”**

Based on the application requirement user can select the desired unit in the wizard and the wizard will update the subsequent parameters to the selected user unit.

From the below picture user can find the currently supported unit formats.

![Unit Formats](image)

As an example, when the user selects the axis type as “Modulo (rotary)” and unit as degree, the wizard will update the subsequent parameters to the selected user unit and fill with default values, ex: modulo range = 360 degree (default). However make sure the user updates the subsequent parameters as per the actual application requirement.

> For rotary axis the units mm, µm, nm, and inch might lead to inaccuracy due to rounding errors.

**“Pulses per revolution scaling”**

User can update the “Pulses per revolution scaling” with the actual encoder increments per motor revolution.
“Application gearing/units per revolution”  Here the user can set the tool travel distance per motor revolution and define the gearing relationship with the mechanical system. As default the “Application has gearing” box is unchecked, this means the application has no gearing and the user can update the “Tool travel distance per motor revolution” as per the application requirement:

If the application has gearing the user can check the “Application has gearing” box and they will be prompted to provide the gearing details. During the generate application, the wizard will update the same accordingly.

“Modulo range”  The user can provide the “Modulo range” here. This is the value at which the axis position will wrap back to zero. This window will be active only when the user selects the axis type as any of the rotary axis.

“Software limits”  The user can configure some of the common “Software limits” from the wizard itself. Below is the list of software limits which user can configure from the wizard in the selected application units.

By default, software limits in wizard are not enabled and user need to enable the same by enabling the check box “Enable limits”.

---

Configuration and programming
Libraries and solutions > Motion Control
“Direction and Homing type”

“**Invert direction**” - This needs to be set for the application which needs to change the axis relationship between its real direction and that within the PLC program. By default, the check box will be unchecked, and the direction will be normal. By selecting the check box “**Invert direction**” both actual and reference position will be inverted, and the axis will move in opposite direction.

“**Homing using DRIVE IO Touch Probe**” - Selecting this will allow the axis to home to a drive based touch probe using EtherCAT.

Selecting this also by default make the PDO mapping preselected for the user, but this can be later changed based on the application need.

“Position control (cyclic sync mode)”

Here the user can configure the parameters related to position control and supervision. Details of each parameter is explained in our system technology chapter.

- Chapter 6.5.10.3.5.6.3 “Position control loop” on page 4028
- Chapter 6.5.10.3.5.6.2 “Supervision” on page 4027

“Dynamic limits”

Users can update the maximum limits here. Some parameters depend on the drive settings and needs to be set correctly to get the desired result.

The user can set the “**Maximum application velocity**” to a desired value to limit the maximum application speed.
Example, if user is using an ABB servo drive with, 131072 encoder increments per revolution and a maximum speed is 6000 rpm.

Maximum application velocity = Max application velocity in RPM * Tool travel distance per revolution / 60 * Gearbox nominator / gearbox denominator = 6000 * 360 / 60 * 1 / 1

= 36000 degree / sec

For easy calculation of parameters user can use the excel “AC500_V3_MotionControl_Startup guide for MC parameterization.xlsx” from example program folder PS5611-Motion.

Use cases and how to handle the function blocks of a certain library is described in sample projects. After the respective library has been installed the corresponding sample projects are available in the default path AutomationBuilder Examples. If the default path is inaccessible, click “Help ➔ Project examples” in the Automation Builder menu.

“Drive based limits”

Here the user can define the limits that will dictate the expected behavior of the drive.

It is recommended to keep the same “Maximum speed” at the drive and at the PLC parameter.

Currently users can define the applications torque limits in the wizard and they will be written to the SDO startup parameter only if the user selects “Torque limits” in the “Mapping” page. These parameters are not used in the program by default.

“Results (calculated)”

Based on the inputs provided, wizard will calculate the results and can be viewed immediately at the end of the configuration page.
Mapping (Axis control type and object mapping)

The “Mapping” and “Control Type” tab can be selected if the user wants to set a “Control type” other than CSP (default) and mappings other than default (Control Word, Set Position, Status Word, Actual Position). It can be found under the axis object here:

By default, wizard is selected for “Cyclic synchronous position mode (CSP)”. User can change the same based on the application requirement. The supported control modes are:

- Cyclic synchronous position mode (CSP).
- Cyclic synchronous velocity mode (CSV).
- Cyclic synchronous velocity mode for load control (CSVL).

CSVL is an ABB specific mode to achieve load control/profiling. By using this mode, the user can use the “Motion Control Load library” which is implemented based on the “PLCopen Motion Part 6 – Fluid Power Extensions”. For more details on load/torque control please refer to the library integrated documentation, system technology in online help file and the example program / description from example program folder.

Control type

By default, wizard is selected for “Cyclic synchronous position mode (CSP)”. User can change the same based on the application requirement. The supported control modes are:

- Cyclic synchronous position mode (CSP).
- Cyclic synchronous velocity mode (CSV).
- Cyclic synchronous velocity mode for load control (CSVL).

Additional PDO mapping

If the application needs “Additional PDO mapping” the wizard helps the user to add most used PDO mapping just by selecting them here.

Based on the control type selected, a few of the mandatory PDO mapping are generated automatically and from additional mapping area in wizard user can find the most common PDO mapping and user can add the same based on the application requirement.

The user can add additional PDO mapping which are not listed here manually by enabling the expert settings from the slave device general configuration page (as described earlier).
SDO start-up parameter mapping

By default, two of the SDO startup parameters are selected and it is recommended not to change these unless the user has expert level knowledge of DS 402 control modes or intends to do non-standard start up coding as it will change the expected operation of the axis at start up.

The user can select the “Torque limits” and the torque values set from the “Settings” page will be written to the respective slave drives startup parameters list.

Once these settings are made and the generated code is executed you can see that these settings have change the drives EtherCAT slave configuration as shown in the picture below:

Addition of an encoder axis

For any application which needs an encoder, an encoder axis can be added and configured. This can be added either by opening the “Motion Solution Wizard” object and clicking on the [Add encoder axis] button on the bottom of the page as shown below or by right clicking on the “Motion Solution Wizard” and selecting “Add object”.

After adding an encoder axis, the user can find it under the “Motion Solution Wizard” in the Automation Builder. Users can double click on the added encoder axis object to get the settings page and configure it as per the requirement. Settings here is like any other motion axis expect here user need to configure encoder source.

When an encoder axis is added, user must configure the encoder source channel and encoder source.
Selection of the encoder source

For a user to use an encoder they must know where the data source that supports it comes from.

Below are the options for the encoder source:

- **“Drive encoder” (EtherCAT)** - When there is an EtherCAT axis, the user will have a chance to use the EtherCAT servo drives, master encoder (16#400C:03) as a source for the encoder axis (which will be scanned at EtherCAT cyclic rate). This can only be used as a ‘master encoder’.

- **PLC encoder (OBIO)** - When an AC500-eCo PLC is used there is an option to use the onboard IO to take in a two channel Automation Builder encoder signal using the 24 V digital inputs. This can be used as a ‘master encoder’ or to close the position loop to a PTO drive in a PTO axis is configured.

- **“Data source”** – here the user can select any data source from which the value of the encoder can be driven. This requires a data area or variable configured within the program.

* This can now be used to latch positions, or as a master for another axis to follow.

Using an EtherCAT drive based encoder source

1. Go to the desired EtherCAT drives axis object.
2. Open the “Mapping” tab.
3. Tick the box for “Master encoder”.

$\Rightarrow$ Now the configured “Master encoder” is ready to be selected. This selection will make the encoder object 16#400C:03 available as a source for the encoder axis (which will be scanned at EtherCAT cyclic rate).

4. Add or select the desired encoder axis.
5. Select “Encoder source channel” as “Drive encoder” and the “Encoder source” via the name of the EtherCAT drive’s name which the encoder will be selected.

![Encoder configuration screen]

Using a PLC (OBIO) based encoder source (AC500-eCo only)

When there is a PTO axis, the user will have an option to use the onboard encoder channels from AC500-eCo PLC as a source for the encoder axis.

User can add or select the desired encoder axis and select “Encoder source channel” as “PLC encoder OBIO” and the “Encoder source” via the channel (0 or 1). In addition, the purpose should be defined, either “Master encoder” (This can now be used to latch positions, or as a master for another axis to follow) or “Close pos loop” to close the position loop for a PTO axis:

![PLC encoder configuration screen]

Filtering is also available should the encoder data require it.

Data source

Here the user can use a “Data source” to define a variable which will then create the variable in the mentioned name as data type “DINT”.

![Data source configuration screen]

Alternatively they can connect to an existing variable from the project to encoder axis. The variable must be of data type “DINT”.

![Connecting to existing variable]

Other encoder axis parameters are same as EtherCAT or PTO axis and for details please refer to the previous chapters.

Addition of a virtual axis

If the applications require a virtual axis (one which has no associated hardware) then the user can add this.

Either by and .
1. Opening the “Motion Solution Wizard” object (by doubling clicking on it).
2. Clicking on the [Add virtual axis] button on the bottom of the page.

3. Open the “Motion Solution Wizard” object by doubling clicking on it.
4. Click on the [Add virtual axis] button on the bottom of the page.

5. Alternatively, right click on the “Motion Solution Wizard” object and by selecting “Add object” option to add the axis.
6. After adding a virtual axis, the user can find it object under the “Motion Solution Wizard”. Users can double click on the added virtual axis object to access the settings page and configure it.

⇒ Settings here are the same as the motion axis and details for how to configure the parameters, refer to the previous chapters.

Important general PLC settings

Compared with a standard AC500 project, when the user is using motion solution wizard, some default settings are changed during code Generation. These settings are always overwritten as long as there is a change in axis configuration or added a new axis. Below are the settings which are updated by the “Motion Solution Wizard”:

[Diagram showing PLC settings interface]
<table>
<thead>
<tr>
<th>Setting</th>
<th>Project type</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting</td>
<td>EtherCAT</td>
<td>PTO Only</td>
</tr>
<tr>
<td>IO bus – Run on config fault</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>PLC &gt; PLC Settings &gt; Always update variables</td>
<td>“Disabled”</td>
<td>“Disabled”</td>
</tr>
<tr>
<td>PLC &gt; PLC Settings &gt; Bus Cycle Options</td>
<td>e.g. “Task”</td>
<td>- any real slow task must be selected and it shouldn’t be set as “unspecified” as this can lead to a negative on cyclic operation.</td>
</tr>
<tr>
<td>CPU-Parameters &gt; Check battery</td>
<td>Off</td>
<td>NA</td>
</tr>
<tr>
<td>CM579-ETHERCAT &gt; Run on config fault</td>
<td>Yes</td>
<td>NA</td>
</tr>
<tr>
<td>CM579-ETHERCAT &gt; Bus Behaviour</td>
<td>Sync Mode 1</td>
<td>NA</td>
</tr>
</tbody>
</table>

It is recommended that user change the above settings manually based on the actual application requirement. To update these setting manually, user need to change the setting after all the axis changes are done and then generate the code.

**Generation the motion configuration**

Once all the configuration is completed, the user can generated the application (like compile) which will then update; its settings, the PDO and SDO mapping, and the motion task configuration automatically based on the settings and parameters provided in the wizard. To do this, go to “Build” menu and click on “Generate Code”

Automation Builder will generate the axis configuration. Once completed successfully, Automation Builder will show the message “Motion Solution Generation successful” in the message window. This can take some time based on the number of axes configured in the project and PDO mapping selection.

**Task configuration**

**Tasks within the Motion Wizard**

The wizard will automatically create a fast task and a slow task to help guide the user to correctly distribute their code. The kernel function block and the transfer of axis IO data with EtherCAT or other hardware should be processed in a faster task. This task should be as short and real time (if EtherCAT) or as fast possible (if PTO) to achieve the best motion control performance.

In case the position reference is transferred to the drive the task of the axis implementation should be synchronized to the fieldbus cycle. The following figures show an example for EtherCAT.

The Cyclic task is show as below:
MotionSolution_Task

The "Motion Solution Wizard" will automatically create a fast task called "MotionSolution_Task". This will call all the axis operation code, and will be configured dependently on the configuration.

MotionSolution_Task in EtherCAT applications

In the case of EtherCAT applications synchronized the setting of "Cycle time" is defined in the EtherCAT master. Once the solution is generated this will then define a task which has a type of external and a cycle time which matches that configured in the EtherCAT master and the Priority is set as "0".

MotionSolution_Task in PTO only applications

In the case of PTO only applications, set the cycle time in the "Motion Solution Wizard". Once the solution is generated this will then define a task which has a "Type" of "Cyclic" and a cycle time which matches that configured in the solution wizard and the priority is set as "10".
Function blocks must be called in the Motion Solution Task

As mentioned previously the “MotionSolution_Task” is the fastest and highest priority task in the CPU and so of course the most draining on resources. It is possible for the user to call parts of the motion application in this “MotionSolution_Task” – however excessive amounts of code or that with a poor structure in this task can lead to overloading of the CPU.

Despite these limitations some function blocks must be called in the same task as the kernel function block (“MotionSolution_Task”).

- MC_CombineAxes
- MCA_MoveByExternalReference
- MCA_MoveByExtRefRelative
- MCA_DigitalCamSwitch
- MCA_GetTappetValue
- ECAT_CiA402 Touchprobe_App
- ECAT_HomingOnTouchprobe
- ECAT_CiA402ParameterHoming

For onboard EtherCAT motion axis projects, it is recommended to call all the EtherCAT function blocks in one task, for coupler EtherCAT this is not relevant.

Cyclic tasks and created task “Task”

As default the wizard will also create a 10 ms cyclic task called “Task” which the user can use for such code calling for noncritical motion function blocks:

Guidance for code distribution within tasks

It is recommended for most non-real time motion PLCopen function blocks in the program to use a different cyclic task with a cycle time at least double of that used in the “MotionSolution_Task” and a lower priority (such as ‘Task’). This will reserve more capacity for better performance on the EtherCAT by the PLC.

To save PLC processing time the most PLCopen function blocks as well as the application logic can also be processed in a task which runs on a lower priority than the real time task with the axis implementation as shown in the figure below.
Motion solution libraries

Based on the control type selected, mandatory libraries are added to the Library Manager. The libraries added depend on the control type selected. See the table below for the libraries added based on the control type selected.

<table>
<thead>
<tr>
<th>Control Type</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC500_Ecat_Cia402</td>
<td>AC500_Motion-Control</td>
</tr>
<tr>
<td>EtherCAT CSP</td>
<td>Added</td>
</tr>
<tr>
<td>EtherCAT CSV</td>
<td>Added</td>
</tr>
<tr>
<td>EtherCAT CSVL</td>
<td>Added</td>
</tr>
<tr>
<td>EtherCAT CST</td>
<td>Added</td>
</tr>
<tr>
<td>PTO</td>
<td>Added</td>
</tr>
</tbody>
</table>

For example, if the user selects control type as CSVL we can see the libraries indicated in the Library Manager.

![Library Manager screenshot]

Additional libraries can always be added later manually.

Axis program generated (Hidden by default)

The code which is generated for each axis is hidden by default (using the tick box in the "Motion Solution Wizard") but users can choose to make it visible if needed.
To view the generated axis program, the user must access the “Motion Solution Wizard” window.

Then navigate to the bottom and uncheck the [Hide generated code] button from the “Motion Solution Wizard” overview page.

Once the user has unchecked [Hide generated code], they can find the folder “MotionSolution_Generated”, which has sub folders for each of the axis configured using the wizard. Each axes subfolder has a GVL and a PRG respectively. Name of the folder GVL/PRG/Function Blocks/variable are generated based on the axis object name.

Below is the example from EtherCAT axis, for other axis it follows the similar structure.

It is not recommended to change the program manually without exert knowledge as any changes which will be made later the axis object will overwrite all the changes done by the user if the “Generate” check box is checked.

Axis parameters generated (GVL)

The GVL generated by the wizard maps the parameters set by the wizard to the library variables in the Axis_Ref structure, and the Axis_IO declaration is initiated here.
It is recommended not to add/edit the program here manually since this will be lost next time when the user click on the [Generate Code].

Generation a program (PRG)

Program which is generated by the wizard initiates the CMC_Axis_Control_Parameter, CMC_Basic_Kernel/CMC_Load_Motion_Kernel and ECAT_CiA402_Control_App function blocks and set the inputs based on the configuration done in the wizard.

For CSP and CSV control type, CMC_Basic_Kernel function block will be called and for CSVL control type CMC_Load_Motion_Kernel function block will be called.

It is recommended not to add/edit the program here manually since this will be lost if there was any modification done on the particular axis reference.

6.5.10.1.5 Wiring application program

It is recommended to the user to write the application by creating new POU’s and adding the POU’s to a new task and setting a cycle time and task priority lower than “MotionSolution_Task”. Dependent on the code writing guidelines mentioned earlier.
An exception to the above general guideline is for the function blocks which needs to be called in the same task where the axis is running and, in such cases, user need to call those function blocks in a separate POU add call the POU in “MotionSolution_Task”. If a function block needs to be called inside the real time task (“MotionSolution_Task”), this is mentioned in the function block help file.

An example of a function blocks which needs to be called in the “MotionSolution_Task” is MCA_MoveByExternalReference. To use this in a program, a new POU with this (and any other real time function blocks) has been created called “MyMotion”.

This POU can then be called from the “MotionSolution_Task” by adding it as shown below.
6.5.10.2 Cams and Tappet tables

6.5.10.2.1 Definition of a “Cam table”

A “Cam table” is an object type containing a tool which allows the user to create and edit Cams and tappets either graphically or by means of tables. After the code is generated for the corresponding application, these elements or tables are transposed into global data structures or “Cam Data” which the IEC program can access.

Definition of a Cam

An electronic Cam describes the functional dependency of the position one axis (slave) to another axis (master). The relationship is described by a continuous function (or curve) that maps a defined range of master actual position values to slave target position values.

A software Cam is created by breaking the motion into several segments. Each segment defines how far the slave axis will travel for a given move distance on the master axis. Once these segments have been defined, a path between them is produced, the interpolation method being set by the user. The user controls the size and accuracy of the segments. Using many small segments will produce smoother motion.

Motion across each segment and across segment boundaries will go through all specified points. The segment information for a Cam profile is defined in an array called a table. A table of positions must be defined together with an optional table of master increments.

Definition of a Tappet

An electronic Tappet describes a function which allows the user to derive a digital state from an axis or cam position which can be used to trigger an event or indicate a state at which an action should occur. You may add tappets (binary switches) to the cam at any position. In this way, you can create cam tables which contain tappets.

6.5.10.2.2 Cam table

Cam table types

With Automation Builder 2.7.0 user has two different Cam objects available in add object option as shown below. From the context menu: “Cam table ABB” and “Cam table ABB basic”.
Differences in the objects

The difference between these objects is the code that is generated by them and the libraries they are compatible with. By hovering over them the user can see the guidance for when to use them:

“Cam table ABB”
- This allows the user to get additional data via Cam structure.
- In the project the user need to use “MCA_CamStructureSelect” (and not “MC_CamTableSelect”).
- Compatible with Automation Builder 2.6.1 or higher.

“Cam table ABB basic”
- This gives the user only basic information from the Cam.
- In the project the user need to use “MC_CamTableSelect” as in the past.
- Compatible with Automation Builder 2.6.0 or lower.

Differences in using the two “Cam tables” types in application code

To use the “Cam table” the user needs to call at least the “MCA_CamStructureSelect” (new) or “MC_CamTableSelect” (old/basic) depending on which version of the “Cam table” objects that are used. Also, in either case you will also need “CamIn” or “CamInDirect” function blocks from the AC500_MotionControl library.
If you use the wrong function block for the wrong type of Cam you can expect your “MC_CamIn/MC_CamInDirect” to never go into ‘InSync’ = TRUE.

6.5.10.2.3 Cam table object structure

The “Cam table” is split into individual editors, which allow the users to edit and add elements to the selected views.

The editor consists of the following tabs:

- [Cam]: Here, you can display and modify the Graphs showing slave position, slave velocity, slave acceleration, and slave jerk. This view can show the user when you program a movement with high acceleration.
- [Cam table]: Here, you can display and modify the slave position, slave velocity, slave acceleration, and slave jerk in a tabular view.
- [Tappets]: Is an editor for programming tappets (switch points) in a diagram. This display provides a very good overview of the sequential order of the tappets.
- [Tappet table]: Is an editor which lists switch points in a table. Here, you can specify the switch points.

6.5.10.2.4 Cam tab

In the Cam graphical editor, the Cam graphs are shown and can be interacted with.

The editor window displays the curves of four graphs:

- Slave position (black)
- Slave velocity (blue)
- Slave acceleration (green)
- Slave jerk (yellow)

The horizontal axis of all four coordinate systems shows the range of the master values ([Minimum - Maximum]). The vertical axis in the position diagram shows the value range that is defined in the Cam properties. The vertical axis of velocity, acceleration, and jerk is scaled automatically.

It is possible to modify all curves, except the jerk curve. As velocity, acceleration, and jerk are derived curves, changes to one graph causes changes to the other graphs.
Switch between the graphical editor and the alternative tabular editor at any time (“Cam table” tab).

### 6.5.10.2.5 Cam table tab

The “Cam table” is an alternative to the graphical editor for defining the Cam graphs (“Cam” tab). The first line of the table always contains the start position of the master (and the related slave values) and the last line is always the end position. The lines in-between alternately define segments and points.

Below is a list of key elements and their descriptions:

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert</td>
<td>Inserts a new line.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected segment</td>
</tr>
<tr>
<td>X</td>
<td>X-position of the slave axis</td>
</tr>
<tr>
<td>Y</td>
<td>Y-position of the slave axis</td>
</tr>
<tr>
<td>V</td>
<td>Velocity of the slave axis</td>
</tr>
<tr>
<td>A</td>
<td>Acceleration of the slave axis</td>
</tr>
<tr>
<td>J</td>
<td>Jerk of the slave axis</td>
</tr>
<tr>
<td>Segment type</td>
<td>Poly5: 5th degree polynomial</td>
</tr>
<tr>
<td></td>
<td>Line</td>
</tr>
</tbody>
</table>

These elements are always shown in every “Cam” configuration:

The following values result from the values of the respective segment. They cannot be modified:

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>min (Position)</td>
<td>Minimum value of the slave position</td>
</tr>
<tr>
<td>max (Position)</td>
<td>Maximum value of the slave position</td>
</tr>
<tr>
<td>max (Velocity)</td>
<td>Maximum value of the velocity of the slave, based on the master axis</td>
</tr>
<tr>
<td>max (Acceleration)</td>
<td>Maximum value of the acceleration of the slave, based on the master axis</td>
</tr>
</tbody>
</table>

**Table 745: View “ToolBox”**

<table>
<thead>
<tr>
<th>Select</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[k]</td>
<td>Select a line in the table by using this tool. Selected points are deleted by pressing the [Del] key.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Add point</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[p]</td>
<td>Add new points with this tool. Click the insertion point in the diagram. The graph is then adapted automatically so that its curve runs through the new inserted point.</td>
</tr>
</tbody>
</table>

Switch between the table editor and the graphical editor at any time (“Cam” tab).

### 6.5.10.2.6 Tappets tab

The tappet behaviors are shown and can be defined in this graphical editor. A tappet path defines one or more tappets depending on the master position. At the upper edge of the editor window, a horizontal axis approaches the range of the master positions. The individual tappet paths are defined below.

You can switch between the graphical editor and the alternative tabular editor at any time (“Tappet table” tab).
Track ID of the tappet path.
All tappets of a tappet path refer to the same tappet switch (a variable of type BOOL).

Table 746: View “ToolBox”

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select</td>
<td>Select the tappets by means of this tool. You can drag the selected tappets to another position. You can modify the switch on/off attribute of a tappet by clicking the relevant end of the crossed line ( ). Delete the selected tappet by pressing the [Del] key.</td>
</tr>
<tr>
<td>Add new tappets with this tool. Click the insertion point in the path.</td>
<td></td>
</tr>
</tbody>
</table>

Table 747: View “Properties”
The tappet is assigned to a result, if it is passed from the position of the master axis in the positive (increasing master values) or negative direction.

<table>
<thead>
<tr>
<th>X</th>
<th>Position of the tappet</th>
</tr>
</thead>
<tbody>
<tr>
<td>Positive pass</td>
<td>Switch on/off attribute</td>
</tr>
<tr>
<td>- No action</td>
<td></td>
</tr>
<tr>
<td>- Switch to ON</td>
<td></td>
</tr>
<tr>
<td>- Switch to OFF</td>
<td></td>
</tr>
<tr>
<td>- Invert</td>
<td></td>
</tr>
<tr>
<td>Negative pass</td>
<td>Switch on/off attribute</td>
</tr>
<tr>
<td>- No action</td>
<td></td>
</tr>
<tr>
<td>- Switch to ON</td>
<td></td>
</tr>
<tr>
<td>- Switch to OFF</td>
<td></td>
</tr>
<tr>
<td>- Invert</td>
<td></td>
</tr>
</tbody>
</table>

Table 748: Table of the possible combinations of tappet attributes

<table>
<thead>
<tr>
<th>Tappet symbol</th>
<th>Positive pass</th>
<th>Negative pass</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>No action</td>
<td>No action</td>
</tr>
<tr>
<td></td>
<td>Switch to ON</td>
<td>No action</td>
</tr>
<tr>
<td></td>
<td>Switch to OFF</td>
<td>No action</td>
</tr>
<tr>
<td></td>
<td>No action</td>
<td>Switch to ON</td>
</tr>
<tr>
<td></td>
<td>No action</td>
<td>Switch to OFF</td>
</tr>
<tr>
<td></td>
<td>Switch to ON</td>
<td>Switch to OFF</td>
</tr>
<tr>
<td></td>
<td>Switch to OFF</td>
<td>Switch to ON</td>
</tr>
<tr>
<td></td>
<td>Switch to OFF</td>
<td>Switch to OFF</td>
</tr>
<tr>
<td></td>
<td>Invert</td>
<td>No action</td>
</tr>
<tr>
<td></td>
<td>No action</td>
<td>Invert</td>
</tr>
<tr>
<td></td>
<td>Invert</td>
<td>Switch to ON</td>
</tr>
<tr>
<td></td>
<td>Invert</td>
<td>Switch to OFF</td>
</tr>
</tbody>
</table>
6.5.10.2.7 Tappet table tab

This tabular editor is an alternative to the graphical editor for configuring the tappet paths ("Tappets” tab). A tappet path defines one or more tappets depending on the master position. In the table, the lines with the definitions of the associated tappets follow below each line that defines a tappet path.

Switch between the graphical editor and the alternative tabular editor at any time ("Tappet table” tab).

<table>
<thead>
<tr>
<th>Tappet symbol</th>
<th>Positive pass</th>
<th>Negative pass</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>Switch to OFF</td>
<td>Invert</td>
</tr>
<tr>
<td>X</td>
<td></td>
<td>Invert</td>
</tr>
</tbody>
</table>

Table 749: View “ToolBox”

| ♻ | Select | Select the tappets by means of this tool. You can drag the selected tappets to another position. |

Table 750: View “Properties”

<table>
<thead>
<tr>
<th>X</th>
<th>Position of the tappet</th>
</tr>
</thead>
</table>

Configuration and programming
Libraries and solutions > Motion Control

2024/01/05
### Positive pass

<table>
<thead>
<tr>
<th>Switch on/off attribute</th>
</tr>
</thead>
<tbody>
<tr>
<td>No action</td>
</tr>
<tr>
<td>Switch to ON</td>
</tr>
<tr>
<td>Switch to OFF</td>
</tr>
<tr>
<td>Invert</td>
</tr>
</tbody>
</table>

### Negative pass

<table>
<thead>
<tr>
<th>Switch on/off attribute</th>
</tr>
</thead>
<tbody>
<tr>
<td>No action</td>
</tr>
<tr>
<td>Switch to ON</td>
</tr>
<tr>
<td>Switch to OFF</td>
</tr>
<tr>
<td>Invert</td>
</tr>
</tbody>
</table>

#### 6.5.10.2.8 Cam additional settings

Once the user has the “Cam” view open (double-click on the “Cam” object in the device tree) the user will have access to several additional “Cam” settings and options:

**Cam ToolBox**

This will allow the user to add and remove elements to the “Cam” and tappet editors. Typical options are:

**Table 751: View “ToolBox”**

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select</strong></td>
<td>Select a line in the table by using this tool. Selected points are deleted by pressing the [Del] key.</td>
</tr>
<tr>
<td><strong>Add point</strong></td>
<td>Add new points with this tool. Click the insertion point in the diagram. The graph is then adapted automatically so that its curve runs through the new inserted point.</td>
</tr>
</tbody>
</table>
Properties

This can be accessed by either “View ➔ Properties” or by right clicking on the “Cam” object and selecting properties. It will allow the user to define the behavior and dimensions of the “Cam”.

Here the user can change:

- **Dimensions**: The master and slave “Cam table” start and end positions.
- **Slave period**: Depending on these parameters, the slave start point is adjusted automatically when the end point is changed, as well as the other way around. This adjustment optimizes the period transition to be as smooth and jerk-free as possible.
- **Continuity requirements**: Activation of these options prompt a continuity check, which reports any violations to the message view (Cam). Clear these options, if the application requires it.
- **Compile format**: In the Automation Builder is only one option: “polynomial (XYVA)” - Polynomial description of the points, for master position, slave position, slave velocity, and slave acceleration.

6.5.10.2.9 Display generated Code

To view the code that is generated by the “Cam” object:

1. Close all Cam views.
2. Open the Cam which’s code needs to be viewed.
3. Go to “Cam” tab from the main Automation Builder tab.
4. Select “the display generated code” option.

The code will be shown where user can find the Cam points that are created in an array. “Cam table” function block from motion library is already initialized with few inputs.
Below is an example of the code generated by the “Cam table ABB” object (Automation Builder 2.6.1 and newer).

Here you can see more in depth information about the Cam is encoded in the structure.

Below is an example of the code generated by the “Cam table ABB basic” object (Automation Builder 2.6.0 and older).

Here you can see only basic Cam data is encoded in the structure.

Currently it can only show the code generated from one Cam which is open.

6.5.10.2.10 Creating Cams

The steps to create a Cam can be explained using an example application. In this application, we can say that there is a rotary table with eight slots ($360° / 8 = 45°$ division). Inside there is a component to be joined by ultrasonic welding. The welding tool is fed by a linear drive after the rotary table has rotated. After welding, the linear axis returns and the rotary table continues to rotate.

Work steps:
- Rotary table turns $45°$ (duration: $400$ ms).
- The welding head is moved down by a vertical axis of $250$ mm (duration: $200$ ms).
- Start welding (duration: $1200$ ms).
- The welding head is moved up by a vertical axis of $250$ mm (duration: $200$ ms).

A cycle time of $2000$ ms results from total times.

The application is implemented by means of a virtual master axis that runs continuously (modulo). The end value of the axis is projected according to the cycle time of $2000$ ms. The rotary table is achieved as a Cam (modulo; end value: $45°$). The vertical axis is also achieved as a Cam (restricted; end value: $300$ mm). The welding process is controlled by a tappet.

6.5.10.2.11 Setting up project

1. Select “Motion Solution” project.
2. Select the required AC500 controller.
3. Add two real drives and configure as below:
   - Name “RotaryAxis”, Type: Modulo, units: Degrees, scale: Gearing 8/1, 1 Tool Rev = 360°, Modulo 0-45°
   - Name “VerticalAxis”, Type: Linear (Rotary Screw), units: mm, scale: 1 Motor Rev = 10mm
4. Add a virtual axis (and don’t rename it)
   - Name “MasterAxis”, Type: Modulo, units: Pulse, Modulo range = 2000

Adding a Cam to the device tree

1. Select the “Application” object in the device tree.
2. Click “Project ➔ Add object ➔ Cam table”.
   - “Cam table ABB” – This allows the user to get additional data via Cam structure and user need to use “MCA_CamStructureSelect” instead to “MC_CamTableSelect”.
   - “Cam table ABB basic” – This allows the user to use the Cam object in the traditional ABB way together with “MC_CamTableSelect”.
3. Specify the name “RotaryAxisCam” for the Cam and click [OK].
   - The object is inserted into the device tree.
4. Insert another Cam.
5. Rename it “VerticalAxisCam”.

Setting the properties of the Cam

1. Select the “Rotary table” Cam in the device tree.
2. Click “Properties” in the “View” menu or in the context menu.
3. Select the “Cam” tab.
4. Specify the following values:
   - Master start position: 0
   - Master end position: 2000
   - Slave start position: 0
   - Slave end position: 45
   - Slave Period: 45 (NA)
   - Smooth transition: (deactivated)
5. Click [OK] to close the dialog. Confirm the dialog for changing the Cam object.
6. Change the values for the “Vertical axis” Cam in the same way:
   - Master start position: 0
   - Master end position: 2000
   - Slave start position: 0
   - Slave end position: 300
   - Slave Period: 300
   - Smooth transition: (activated)
7. Click [OK] to close the dialog. Confirm the dialog for changing the Cam object.

### 6.5.10.2.12 Changing the Cam path

These instructions use the example from the section Chapter 6.5.10.2.10 “Creating Cams” on page 3949 to demonstrate how to change a Cam.

#### Changing the path with the graphical editor
1. Open the “Rotary table” Cam in the editor.
   - The “Cam” tab is visible.
2. Select the point at 120 and 240 and delete them by pressing the key [Del].
3. Select the “Add point” tool from the “ToolBox” view.
   - The mouse pointer turns into crosshairs when you move it into the editor.
4. Click near “Master position” 400 and “Slave position” 45 in the upper graphs (slave position).
   - The curve of the slave position is changed. The curves of velocity, acceleration, and jerk also change.
5. Select the new inserted point by clicking it.
6. Drag the point to another position.
   - The curve of the slave position is adjusted accordingly.
7. Select this point and open the properties view and change the “X” value to 400 and the “Y” value to 45.
8. Using the same method, change the end point to an “X” value of 2000 and “Y” value to 45.
9. Select the “Select” tool from the “ToolBox” view.
10. Select the second curve element (between 400 and 2000).
11. Change the “Segment type” property to “Line”.

12. Check the curve in the graphical editor.

Changing the Cam path with a "Cam table" editor

1. Open the “Vertical axis” Cam in the editor.
   ⇒ The “Cam” tab is visible.
2. Select the “Cam table” tab.
3. Delete the points at 120 and 240 by clicking the symbol.
4. Click the symbol.
   ⇒ A new point and a new segment are inserted at (1000/150).
5. Add two more points.
6. Change the values X/Y of the following points:
   • Point 1: 0 / 0
   • Point 2: 400 / 0
   • Point 3: 600 / 250
   • Point 4: 1800 / 250
   • Point 5: 2000 / 0
   ⇒ The curve of the slave position is changed. The curves of velocity, acceleration, and jerk also change.
7. In the “Cam table”, change the “Segment type” of the first and third segments to “Line”.
8. Check the curve in the graphical editor.

By clicking “Display generated Code,” you can display the automatically created global variables.
Application program using a generated Cam and Tappet table

Once the Cam and Tappet tables are created by the Cam editor, user can use the Cam function blocks to use the same in user application. These instructions use the same example as the previous example (from the section "Chapter 6.5.10.2.10 “Creating Cams” on page 3949) to demonstrate how to define the application program for Cam and tappet points.

Using Cam tables in application code

In the below example we have used an instance of “MC_CamStructureSelect” to connect to the Cam directly (no ADR is needed). Also this function has inputs to allow the user to directly define “Reverse” or “Periodic” settings so the use of “MCA_Cam_Extra” is no longer needed.

Note that in this instance the Cam; “Cam_1” is of the type “ABB Cam Table”.

Using Tappet tables in application code

To use the Cam Tappets the user has two options: “MCA_CamDigitalSwitch” or “MCA_GetTappetValue”.

“MCA_GetTappetValue” uses the output from the “MCA_CamStructureSelect” and will reflect the value based upon the “CAM SLAVE” position and “WILL” take into account offsets or changes to scaling.

In the example, as the second Cam editor object name is “VerticalAxisCam”. If the user has opted to use the new “ABB Cam Table” object and “MCA_CamStructureSelect” then they can use this function to set an output based on the Cam. An excerpt from the generated code can be seen below:

```
VerticalAxisCam_T: ARRAY[0..1] OF MCA_CAMTappet := [

This can be directly passed to input pin name “Tappets” of function block “MCA_DigitalCamSwitch”.
```
Importing a Cam from 3rd party CODESYS controller

Exporting the Cam for the the 3rd party PLC

Using a Cam application that has been previously written using another 3rd party CODESYS based PLC it’s possible to reuse these same data points in your new Automation Builder project to save the user time and effort. The steps to do this are below, in the example application we are using a inovance AM600 PLC program.

1. Open the 3rd party CODESYS environment and the project in question.

   As when using ABB’s solution, the Cam object must be selected from the project tree to allow the user to access the “Cam” item in the system menu at the top of the page which will be needed for some of the steps that follow.

The first thing you should consider is the master and slave settings such as start and end position, and slave period.
2. Check this, with a right click on the Cam object in the hardware tree and select Properties.
   
   From here you will get a pop up where you can double check the settings that will define the Cam operation. Make a note of these.

3. Look at the “Cam table” just to get an idea about the general layout, here we can see this Cam has 6 points (beginning, end and 4 user selected items).

4. Consider the method for getting the Cam data exported from the application.

5. Select the “Cam” object to access the Cam menu.

6. Select the option for “Write Cam Data into ASCII Table”.

7. Export or “Write” the data to an ASCII file.
8. Select somewhere to save it.

Then you will see a pop up which will ask you how many Cam data points you want to export into the file, we can treat this like resolution. In the example below we select 128 data points.

![Number of points dialog box](image)

If we select many of points when the Cam is exported, we can expect the larger number of data points will give the same profile even using the 3rd party Cam builder's interpolation types to ensure the Cam profile is immediately matched perfectly to the previous application.

If we select a lower number of points, one that matches the interpolation points (the smallest number possible) for example then you are relying on Automation builder to plot the interceding Cam points so the interpolation types selected within Automation Builder are more important and must be checked.

Now we are finished with the 3rd party environment.

**Importing the Cam data into Automation Builder**

1. Switch to Automation Builder in which we need to have a project which has a Cam in it ready for us to write the data into.

2. Check the properties of the Cam to check that it has the same maximum and minimum values and other characteristics.

3. Select the Cam object to access the menu in the “Tool bar” from which we can select “Read Cam Data from ASCII table”.

![Automation Builder menu](image)

4. Select the ASCII file we created before.

You will then be asked how many data points you want to import into the project. Typically, this should always match the value that was exported.
In the figure below you can see the result with all 128 data points imported.

Edit the segments (interpolation types) used in each segment in this newly imported Cam via the “Cam table” view.

Once all necessary adjustments have been made, now the Cam is ready to be used in the program.
6.5.10.3 Motion control library

Check the latest version of “Motion Library System Technology” in chapter 10.1 of the “AC500 V3 Motion Control Guide 3ADR 3ADR011239.pdf.

ABB Library

Or via pdf document at: “C:\Users\Public\Documents\Automation Builder 2.x Examples\PS5611-Motion\Documentation

If the default path is inaccessible, click “Help ➔ Project examples” in the Automation Builder menu.

6.5.10.3.1 Safety instructions

- All pertinent state, regional, and local safety regulations must be observed when installing and using this product. When functions or devices are used for applications with technical safety requirements, the relevant instructions must be followed.
- Read the complete safety instructions of the user's manuals for the drives you are using, before installation and commissioning.
- Read all safety instructions and important user information of the AC500 PLC.

% Chapter 1.4 “Regulations” on page 9

6.5.10.3.2 Preconditions for the use of the libraries

The library package has been released for the software and firmware versions listed in the readme file of Automation Builder only (“Help ➔ Automation Builder Release Notes”). In no event will ABB or its representatives be liable for loss of data, profits, revenue or consequential, incidental or other damage that may result from the use of other versions of product, software or firmware versions. The error-free operation of the HA library with other devices, software or firmware versions should be possible but cannot be guaranteed and may need adaptations e. g. of example programs.

The first version of Motion Control Library Package PS5611-Motion has been released with Automation Builder 2.4.0. There after the package is updated with several changes. For details on all changes please refer PS5611-Motion release note area from Automation Builder release notes.

The motion control package contains follows libraries:

<table>
<thead>
<tr>
<th>Library</th>
<th>Automation Builder</th>
<th>PLC firmware</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABB_MotionControl_AC500</td>
<td>AB 2.4.0 or higher</td>
<td>AC500 V3 firmware version 3.3.1 or higher</td>
</tr>
<tr>
<td>ABB_Ecat_CIA402_AC500</td>
<td></td>
<td>AC500-eCo V3 firmware version 3.4.0 or higher</td>
</tr>
<tr>
<td>ABB_MathFunctions_AC500</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ABB_MotionControlEco_AC500 (kernel blocks for eCo V3 PLCs)</td>
<td>AB 2.5.0 or higher</td>
<td>AC500 V3 firmware version 3.5.0 or higher</td>
</tr>
<tr>
<td>ABB_MotionControlLoad_AC500</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The PS5611-Motion libraries have been tested with the following product/firmware/software versions:
- AC500 V3 PLC firmware 3.3.1 or higher
- AC500-eCo V3 (PTO & PWM) firmware 3.4.0 or higher
- CM579-ETHCAT EtherCAT communication module firmware 4.4.3.21 or higher
- ABB e190 Drive
- CD522 module

In no event will ABB or its representatives be liable for loss of data, profits, revenue or consequential, incidental or other damage that may result from the use of other versions of product/software/firmware versions. The error-free operation of the PS5611 - Motion with other devices/software/firmware versions should be possible but can not be guaranteed and may need adaptations e. g. of example programs.

**CAUTION!**
Generally, the user in all applications is fully and alone responsible for checking all functions carefully, especially for safe and reliable operation.

The function blocks contained in the library can only be executed in RUN mode of the PLC, but not in simulation mode.

There are limits on the minimum EtherCAT cycle time, user can configure in each PLC type.

**Table 752: Details on the limits on the minimum EtherCAT cycle time**

<table>
<thead>
<tr>
<th>PLC type</th>
<th>PM5630</th>
<th>PM5650</th>
<th>PM5670</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min. EtherCAT master cycle time</td>
<td>2 ms</td>
<td>1 ms</td>
<td>0,5 ms</td>
</tr>
</tbody>
</table>

Other than the above limits, there is also limits on configuring the number of synchronized axis in each PLC type. This limits is based on the EtherCAT master cycle time configured under EtherCAT master.

**Table 753: Details on the limits for each PLC type**

<table>
<thead>
<tr>
<th>PLC type</th>
<th>PM5630</th>
<th>PM5650</th>
<th>PM5670</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of synchronized axis in 1 ms</td>
<td>-</td>
<td>8</td>
<td>16</td>
</tr>
<tr>
<td>Number of synchronized axis in 2 ms</td>
<td>4</td>
<td>16</td>
<td>32</td>
</tr>
<tr>
<td>Number of synchronized axis in 4 ms</td>
<td>8</td>
<td>32</td>
<td>64</td>
</tr>
</tbody>
</table>

"Number of axis" is counted in Automation Builder is based on the number of Kernel function block instance declared in the IEC application. In this way, it is made sure all real and virtual axis are counted.

**User can increase the EtherCAT cycle time to accommodate more “Number of axis” in the same PLC type.**
User can use the [Statistics] tab from Automation Builder to see how many axis are supported for the particular PLC type and for the EtherCAT master cycle time configured. Once the axis is configured user need to update the [Statistics] tab by “Generate Code” to get the updated information.

Automation Builder allows an additional axis than what is mentioned in the above table to support one virtual axis additionally.

Please remove any Kernel function block instance which is declared but not used in the application to get the correct number of axis calculated by Automation Builder under the [Statistics] tab.

### 6.5.10.3.3 Overview

**Introduction**

The PS5611-Motion is a motion control library for AC500 V3 CPUs, to create motion control applications based on function blocks according to the standard of PLCopen motion control. These function blocks can be used for PLC-based motion control and cover a wide range of possible motion control functionalities. Starting from single axis movements to master-follower axes to perform electronic gearing and CAM functions.

The detailed functionality of each function block is defined in the integrated documentation of the library.

### PLC-based motion control

With PS5611-Motion the application program and the profile generator are realized in the PLC. The implementation of the profile generator is based on a set of function blocks which are named central motion control (CMC).

The profile generator of many possible axes is centrally placed inside the AC500 PLC. Therefore multiaxis motion functionalities become easily available and can be accessed by PLCopen function blocks. As a result, motion control functionalities are almost drive independent.

The detailed functionality of each function block is defined in the integrated documentation of the library.

Available motion control functionalities:

- Simple axis Movements
- Electronic Gearin
- Electronic CAMs
- Position Profiles
- Velocity Profiles
- Acceleration Profiles
- Load control (Torque profiling)

Then the output is a position reference signal which the drive will follow. A new position reference value will be calculated with every cycle of the PLC and has to be transferred to the drive, which demands real time capabilities to the PLC and to the communication channel. A real time fieldbus like EtherCAT is needed. The feedback of the actual position can be used for supervision purposes during operation and is needed to adjust the value of the position reference before the drive will be enabled.
With PLC-based motion control it is also possible to include the position control loop to the AC500 PLC. In this case a speed reference signal will be transferred to the drive, which makes it possible to perform the full range of motion functionalities with standard drives. To close the position control loop, feedback of the actual position is mandatory.

With PLC-based motion control it is also possible to include the load control loop to the AC500 PLC. In this case a speed reference signal will be transferred to the drive, which makes it possible to perform the full range of motion functionalities with standard drives. To close the position control loop, feedback of the actual position is mandatory and to close the load control loop, feedback of the actual load / torque is mandatory.
**Fig. 313:** PLC-based motion control with AC500 PLC and PS5611-Motion, closed load control loop

**Fig. 314:** Central motion control with AC500 PLC and PS5611-Motion, different axis implementations at the same time
Overview of PLCopen function blocks

The following tables give an overview of the defined function blocks, divided into administrative (not driving motion) and motion related sets. They give an overview which function block could be used for the different possible configurations.

These function blocks are part of the ABB_MotionControl_AC500 and ABB_MotionControl-Load_AC500 library.

If there are restrictions concerning a certain drive ("XXX") which lead to a different or limited behavior compared to the standard the respective chapter is supplemented with an additional paragraph "Notes for XXX".

The “KERNEL” function blocks are available in different variants.

The “CMC_Basic_Kernel” and “CMC_Load_Motion_Kernel” function block is designed to be used in standard V3 PLCs, and can either work with drives connected to a fieldbus or IOs.

The “OBIO_PTOMotionKernel” or “OBIO_PWMMotionKernel” function blocks (part of AC500_MotionControlEco) are solely to be used in AC500-eCo V3 CPUs and to make use of the integrated stepper-IO along with PLCopen function blocks. It connects automatically to the internal IOs.

For details of the limitations of PTO and PWM outputs in eCo V3 PLCs, refer to Automation Builder help file.

Table 754: Motion control administrative function blocks

<table>
<thead>
<tr>
<th>Function block</th>
<th>CMC_Basic_Kernel</th>
<th>CMC_Load_Motion_Kernel</th>
<th>OBIO_PTOMotionKernel/ OBIO_PWMMotionKernel</th>
</tr>
</thead>
<tbody>
<tr>
<td>MC_Power</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_ReadStatus</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_ReadAxisError</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_ReadParameter</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_WriteParameter</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_WriteBoolParameter</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_Reset</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_ReadActualPosition</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_ReadActualVelocity</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_SetOverride</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_SetPosition</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_CamTableSelect</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
### Table 755: Motion control single-axis function blocks

<table>
<thead>
<tr>
<th>Function block</th>
<th>PLC-based motion control</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CMC_Basic_Kernel</td>
<td>CMC_Load_Motion_Kernel</td>
<td>OBIO_PTOMotion-Kernel/OBIO_PWMMotionKernel</td>
</tr>
<tr>
<td>MC_MoveAbsolute</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_MoveRelative</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_MoveAdditive</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_MoveSuperimposed</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_HaltSuperimposed</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_MoveVelocity</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_MoveContinuousAbsolute</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_MoveContinuousRelative</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_Stop</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_PositionProfile</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_VelocityProfile</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_AccelerationProfile</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_Halt</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

### Table 756: Motion control multi-axis function blocks

<table>
<thead>
<tr>
<th>Function block</th>
<th>PLC-based motion control</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CMC_Basic_Kernel</td>
<td>CMC_Load_Motion_Kernel</td>
<td>OBIO_PTOMotion-Kernel/OBIO_PWMMotionKernel</td>
</tr>
<tr>
<td>MC_CamIn</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_CamOut</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_GearIn</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_GearInPos</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_GearOut</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_PhasingAbsolute</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_PhasingRelative</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_CombineAxes</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_HaltPhasing</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

### Table 757: Motion control homing function blocks

<table>
<thead>
<tr>
<th>Function block</th>
<th>PLC-based motion control</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CMC_Basic_Kernel</td>
<td>CMC_Load_Motion_Kernel</td>
<td>OBIO_PTOMotion-Kernel/OBIO_PWMMotionKernel</td>
</tr>
<tr>
<td>MC_StepAbsSwitch</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MC_StepLimitSwitch</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
### Table 758: Motion control ABB specific function blocks

<table>
<thead>
<tr>
<th>Function block</th>
<th>PLC-based motion control</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CMC_Basic_Kernel</td>
<td>CMC_Load_Motion_Kernel</td>
</tr>
<tr>
<td>MCA_Cam_Extra</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MCA_Indexing</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MCA_JogAxis</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MCA_MoveByExternalReference</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MCA_MoveVelocityContinuous</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MCA_Parameter</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MCA_ReadParameterList</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MCA_WriteParameterList</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MCA_SetPositionContinuous</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MCA_GearInDirect</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MCA_CamInDirect</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MCA_SetOperatingMode</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MCA_CamInfo</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MCA_DriveBasedHome</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MCA_MoveRelativeOpto</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MCA_PhasingByMaster</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

### Table 759: Motion control fluid power function blocks

<table>
<thead>
<tr>
<th>Function block</th>
<th>PLC-based motion control</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CMC_Basic_Kernel</td>
<td>CMC_Load_Motion_Kernel</td>
</tr>
<tr>
<td>MC_LimitLoad</td>
<td>-</td>
<td>X</td>
</tr>
<tr>
<td>MC_LimitMotion</td>
<td>-</td>
<td>X</td>
</tr>
<tr>
<td>MC_LoadControl</td>
<td>-</td>
<td>X</td>
</tr>
<tr>
<td>MC_LoadProfile</td>
<td>-</td>
<td>X</td>
</tr>
<tr>
<td>MC_LoadSuperimposed</td>
<td>-</td>
<td>X</td>
</tr>
<tr>
<td>MC_TorqueControl</td>
<td>-</td>
<td>X</td>
</tr>
</tbody>
</table>
Overview of libraries

Add the following libraries for the listed applications.

In some cases by adding a library, there will be other libraries added automatically.

<table>
<thead>
<tr>
<th>Application</th>
<th>Library to be added manually</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLC-based motion control</td>
<td>ABB_MotionControl_AC500.-compiled-library</td>
</tr>
<tr>
<td></td>
<td>ABB_MathFunctions_AC500.-compiled-library</td>
</tr>
<tr>
<td>PLC-based motion control, optional for EtherCAT</td>
<td>ABB_Ecat_Cia402_AC500.-library</td>
</tr>
<tr>
<td>Motion control with eCo V3 (OBIO_PTOMotionKernel &amp; OBIO_PWMMotionKernel)</td>
<td>ABB_MotionControlEco_AC500.compiled library</td>
</tr>
<tr>
<td>PLC-based motion control - Fluid Power Extensions</td>
<td>ABB_MotionControlLoad_AC500.compiled library</td>
</tr>
</tbody>
</table>

The features of the function blocks provided with PS5611-Motion can be used from the PLC program according to PLCopen standard. Different drives and different motion control realizations could be used and can be combined with each other as well as different fieldbuses. ABB_Ecat_Cia402_AC500.library is editable and can be adapted based on the drive configuration and drive type.

Overview of data types

The following data types are used for the motion control library. The data types are defined in the library file ABB_MotionControl_AC500 compiled-library. The corresponding elements can be used for the function blocks inputs.

Table 760: Structures

<table>
<thead>
<tr>
<th>Data type</th>
<th>Elements</th>
<th>Element data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMC_AXIS_IO</td>
<td>limitSwitchPos, limitSwitchNeg, absRefSwitch</td>
<td>BOOL</td>
</tr>
<tr>
<td>MC_PPROFILE</td>
<td>master_position, interpolation_point, velocity_ratio, acceleration_ratio</td>
<td>LREAL</td>
</tr>
<tr>
<td>MC_TPROFILE</td>
<td>interpolation_point, first_derivative, second_derivative, delta_time</td>
<td>LREAL, TIME</td>
</tr>
</tbody>
</table>

Table 761: Enum

<table>
<thead>
<tr>
<th>Data type</th>
<th>Possible values</th>
</tr>
</thead>
<tbody>
<tr>
<td>MC_ABB_iTYPES_ENUM</td>
<td>MCA_SPLINE_COMPLETE, MCA_SPLINE_NATURAL, MCA_POLY5</td>
</tr>
<tr>
<td>Data type</td>
<td>Possible values</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>MCA_POLY3</td>
</tr>
<tr>
<td></td>
<td>MCA_LINEAR</td>
</tr>
<tr>
<td>MC_BUFFERMODE</td>
<td>mcABORTING</td>
</tr>
<tr>
<td></td>
<td>mcBUFFERED</td>
</tr>
<tr>
<td></td>
<td>mcBLENDINGlow</td>
</tr>
<tr>
<td></td>
<td>mcBLENDINGprevious</td>
</tr>
<tr>
<td></td>
<td>mcBLENDINGnext</td>
</tr>
<tr>
<td></td>
<td>mcBLENDINGhigh</td>
</tr>
<tr>
<td>MC_DIRECTION</td>
<td>DEFAULT</td>
</tr>
<tr>
<td></td>
<td>POSITIVE</td>
</tr>
<tr>
<td></td>
<td>SHORTEST</td>
</tr>
<tr>
<td></td>
<td>NEGATIVE</td>
</tr>
<tr>
<td></td>
<td>CURRENT</td>
</tr>
<tr>
<td></td>
<td>POSITIVE_STOP</td>
</tr>
<tr>
<td></td>
<td>NEGATIVE_STOP</td>
</tr>
<tr>
<td></td>
<td>CURRENT_STOP</td>
</tr>
<tr>
<td>MC_HOMING_DIRECTION</td>
<td>MC_SwitchNegative</td>
</tr>
<tr>
<td></td>
<td>MC_SwitchPositive</td>
</tr>
<tr>
<td></td>
<td>MC_Positive</td>
</tr>
<tr>
<td></td>
<td>MC_Negative</td>
</tr>
<tr>
<td>MC_HOMING_EDGE</td>
<td>MC_EdgeOn</td>
</tr>
<tr>
<td></td>
<td>MC_EdgeOff</td>
</tr>
<tr>
<td></td>
<td>MC_On</td>
</tr>
<tr>
<td></td>
<td>MC_Off</td>
</tr>
<tr>
<td>MC_HOMING_MODE</td>
<td>MC_REFPULSE</td>
</tr>
<tr>
<td></td>
<td>MC_DIRECT</td>
</tr>
<tr>
<td>MC_SOURCE</td>
<td>mcActualValue</td>
</tr>
<tr>
<td></td>
<td>mcSetValue</td>
</tr>
<tr>
<td>ERROR_ID</td>
<td>MC_OK</td>
</tr>
<tr>
<td></td>
<td>Wrong_State</td>
</tr>
<tr>
<td></td>
<td>Drive_Problem</td>
</tr>
<tr>
<td></td>
<td>Parameter_Exceeds_Limit</td>
</tr>
<tr>
<td></td>
<td>No_Field_Access</td>
</tr>
<tr>
<td></td>
<td>Bus_Problem</td>
</tr>
<tr>
<td></td>
<td>Abs_Switch_Error</td>
</tr>
<tr>
<td></td>
<td>Timeout</td>
</tr>
<tr>
<td></td>
<td>NAK</td>
</tr>
<tr>
<td></td>
<td>MC_TimeLimitExceeded</td>
</tr>
<tr>
<td></td>
<td>MC_DistanceLimitExceeded</td>
</tr>
<tr>
<td></td>
<td>MC_TorqueLimitExceeded</td>
</tr>
</tbody>
</table>
### Naming of function blocks and data structures

**PLCopen**

All function blocks and data types named MC_xxx are implemented according to PLCopen definition and follow the PLCopen documentation. They may have additional inputs but according to PLCopen rules.

All function blocks and data types named MCA_xxx are implemented corresponding to PLCopen rules with adaptations specific to AC500. They are AC500 specific extensions to the PLCopen library.

All function blocks named CMC_xxx belong to the implementation of PLC-based motion control. All data types named CMC_xxx belong to the implementation of PLC-based motion control.

All data types named AXIS_xxx exist according to PLCopen definition. The content is ABB specific and not documented.

All function blocks named zCMC_xxx belong to the implementation of PLC-based motion control. These are not documented and not intended for customer use.

All function blocks and data types named MC_xxx are implemented according to PLCopen definition and follow the PLCopen documentation.

All function blocks and data types named OBIO_xxx in the ABB_MotionControlEco_AC500 library are intended for use with AC500-eCo V3 PLCs only.

All function blocks named xxx_APP are not write protected and may be modified for adaptations. Editable library is available in the example folder.

**PLC-based motion control**

All function blocks and data types named MC_xxx are implemented according to PLCopen definition and follow the PLCopen documentation.

All data types named CMC_xxx belong to the implementation of PLC-based motion control.

All data types named AXIS_xxx exist according to PLCopen definition. The content is ABB specific and not documented.

All function blocks named zCMC_xxx belong to the implementation of PLC-based motion control. These are not documented and not intended for customer use.

All function blocks and data types named MC_xxx are implemented according to PLCopen definition and follow the PLCopen documentation.

All function blocks and data types named OBIO_xxx in the ABB_MotionControlEco_AC500 library are intended for use with AC500-eCo V3 PLCs only.

All function blocks named xxx_APP are not write protected and may be modified for adaptations. Editable library is available in the example folder.

---

<table>
<thead>
<tr>
<th>Data type</th>
<th>Possible values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Implemented</td>
<td></td>
</tr>
<tr>
<td>ErrorID_POSITION_FOLLOW</td>
<td></td>
</tr>
<tr>
<td>ErrorID_POSSW</td>
<td></td>
</tr>
<tr>
<td>ErrorID_NEGSW</td>
<td></td>
</tr>
<tr>
<td>ErrorID_VELOCITY_FAULT</td>
<td></td>
</tr>
<tr>
<td>ErrorID_INTERPOLATION_FAULT</td>
<td></td>
</tr>
<tr>
<td>ErrorID_WARNING_VELOCITYLIMIT</td>
<td></td>
</tr>
<tr>
<td>ErrorID_WARNING_POSITIONLIMITPOS</td>
<td></td>
</tr>
<tr>
<td>ErrorID_WARNING_POSITIONLIMITNEG</td>
<td></td>
</tr>
<tr>
<td>ErrorID_WARNING_POSITIONOVERRUN</td>
<td></td>
</tr>
<tr>
<td>ErrorID_WARNING_ABORT</td>
<td></td>
</tr>
<tr>
<td>ErrorID_WARNING_MOVEMENT_DIRECTION</td>
<td></td>
</tr>
</tbody>
</table>
is reusable across platforms. Effectively, this standardization is done by defining libraries of reusable components. In this way the programming is less hardware dependent, the reusability of the application software increased, the cost involved in training and support reduced, and the application becomes scalable across different control solutions. Due to the data hiding and encapsulation, it is usable on different architectures, for instance ranging from centralized to distributed or integrated to networked control. It is not specifically designed for one application, but will serve as a basic layer for ongoing definitions in different areas. As such it is open to existing and future technologies.

ABB is a member of the PLCopen organization. More Information about PLCopen can be read on the PLCopen website.

Function blocks according to PLCopen are designed for controlling axes via the language elements consistent with those defined in the IEC 61131-3 standard. It was decided by the task force that it would not be practical to encapsulate all the aspects of one axis into only one function block. The retained solution is to provide a set of command-oriented function blocks that have a reference to the axis, e.g. the abstract data type Axis, which offers flexibility, ease of use and reusability.

Implementations based on IEC 61131-3 (for instance via function blocks and SFC) will be focused towards the interface (look-and-feel/proxy) of the function blocks. This specification does not define the internal operation of the function blocks.

PLCopen motion control function blocks can be used in any IEC 61131-3 programming language. The following figure shows an example of a function block used in Function Block Diagram (FBD) language.

Application programs which use the manufacturer independent function blocks according to PLCopen will lead to the following advantages:

● Reusable software structure for different platforms.
● Programming based on function blocks.
● Function blocks can be used in any IEC 61131-3 language.
All function blocks which are defined by PLCopen will have the following qualities independently to the manufacturer of the motion control system:

- Same inputs/outputs
- Same functional behavior
- Same name

The following parts of the PLCopen motion control definition are completely or partly included in this product:

- Part 1: Function blocks for motion control
- Part 2: Extensions
- Part 3: User Guidelines
- Part 4: Homing Procedures
- Part 6: Function blocks for motion control – Fluid Power Extensions

**Programming guidelines**

This chapter explains some rules on the usage of the libraries and the structure Axis_Ref.

- In general, the kernel function block and the transfer of axis IO data should be processed in a cyclic task. This task should be as short and real-time as possible to achieve the best motion control performance. Always make sure Kernel function block is called at the highest priority task and other applications must be at a lower priority task.

- If Axis_Ref is used as input on a user defined function block or program or function, always use it as VAR_IN_OUT and never use it as VAR_INPUT or VAR_OUTPUT. The reason is that this would:
  - Break the consistency and destroy data.
  - Consume a lot of computing power by copying data.

- Any instance of a function block should be called only once per cycle and in only one specific task.

  If the instance is used in several tasks, it has to be checked that it is not called several times. Because this could corrupt the handshake from function block to Axis_Ref to CMC_Basic_Kernel and vice versa.

- Some PLCopen function blocks are only allowed to be called within the same task as the CMC_Basic_Kernel function block. This is mentioned in the function block descriptions.

- If PLCopen function blocks are called from a different task, the cycle time should be at least 2 times the cycle time for CMC_Basic_Kernel function block.

**Axis data type Axis_Ref**

The Axis_Ref is a structure that contains information on the corresponding axis. It is used as a VAR_IN_OUT in all motion control function blocks defined in this document. The content of this structure is implementation dependent and can ultimately be empty. If there are elements in this structure, the supplier shall support the access to them, but this is outside of the scope of this document. The refresh rate of this structure is also implementation dependent. According to IEC 61131-3 it is allowed to switch the Axis_Ref for an active function block, for instance from Axis1 to Axis2. However, the behavior of this can vary across different platforms, and is not encouraged to do.

**Axis_Ref data type declaration:**

```
TYPE Axis_Ref : STRUCT
(Content is implementation dependent)
END_STRUCT
```
Example:

```plaintext
TYPE Axis_Ref : STRUCT
  AxisNo: UINT; AxisName: STRING (255);
  .......... 
END_STRUCT
```

The single axis state diagram

The following diagram normatively defines the behavior of the axis at a high level when multiple motion control function blocks are simultaneously activated. This combination of motion profiles is useful in building a more complicated profile or to handle exceptions within a program. (In real implementations there may be additional states at a lower level defined). The basic rule is that motion commands are always taken sequentially, even if the PLC had the capability of real parallel processing. These commands act on the axis' state diagram.

The axis is always in one of the defined states (see diagram below). Any motion command that causes a transition changes the state of the axis and, as a consequence, modifies the way the current motion is computed. The single axis state diagram is an abstraction layer of what the real state of the axis is, comparable to the image of the I/O points within a cyclic (PLC) program. A change of state is reflected immediately when issuing the corresponding motion command.

The response time of immediately is system dependent, coupled to the state of the axis, or an abstraction layer in the software.

The diagram is focused on a single axis. The multiple axis function blocks, MC_CamIn, MC_GearIn and MC_Phasing, can be looked at, from a single axis state diagram point of view, as multiple single-axes all in specific states. For instance, the CAM-master can be in the state Continuous Motion. The corresponding slave is in the state Synchronized Motion. Connecting a slave axis to a master axis has no influence on the master axis.

The state Disabled describes the initial state of the axis. In this state the movement of the axis is not influenced by the function blocks. The axis feedback is operational. If the MC_Power function block is called with Enable = TRUE while being in state Disabled, this either leads to Standstill if there is no error inside the axis, or to ErrorStop if an error exists.

Calling MC_Power with Enable = FALSE in any state, the axis goes to the state Disabled, either directly or via any other state. If a motion generating function block controls an axis, while the MC_Power function block with Enable = FALSE is called, the motion generating function block is aborted (CommandAborted).

The intention of the state ErrorStop is that the axis goes to a stop, if possible. There are no further inputs from function blocks accepted until a reset has been done from the ErrorStop state.

The transition Error refers to errors from the axis and axis control, and not from the function block instances. These axis errors may also be reflected in the output of the function blocks instances errors.

Issuing MC_Home in any other state than StandStill will go to ErrorStop, even if MC_Home is issued from the state Homing itself.

Function blocks which are not listed in the single axis state diagram do not affect the state of the axis, meaning that whenever they are called the state does not change. They are:

- MC_ReadStatus
- MC_ReadAxisError
- MC_ReadParameter
- MC_ReadBoolParameter
- MC_WriteParameter
- MC_WriteBoolParameter
- MC_ReadActualPosition
- MC_CamTableSelect

Calling the function block MC_Stop in state StandStill changes the state to Stopping and back to Standstill when Execute = FALSE. The state Stopping is kept as long as the input Execute is TRUE. The output Done is set when the stop ramp is finished.
1. In this state ErrorStop or Stopping, all function blocks can be called, although they will not be executed, except MC_Reset and Error – they will generate the transition to StandStill or ErrorStop respectively.

2. Power.Enable = TRUE and there is an error in the Axis.

3. Power.Enable = TRUE and there is no error in the Axis.

Visualizations

For usage with the PLCopen Library, a set of visualization objects is defined. These visualizations use the placeholder concept, which means that they could be used in an actual visualization several times and be instantiated by replacing the “placeholder” with an effective data-structure.

Two types of visualizations exist:

- As placeholder, an instance of Axis_Ref should be used. These are named: MC_VISU_Axis_name. Here the name could be state machine or its actual.
- As placeholder, an instance of the respective PLCopen function block should be used. These visualizations are named MC_VISU_FB_name where "name" could be MoveAbsolute or MoveVelocity, so the complete element is named MC_VISU_FB_MoveAbsolute or MC_VISU_FB_MoveVelocity.

The background colour and the colour for the title of each element could be changed. The colours are defined in some global predefined variables in MC_VISU_COLOR_INFORMATION. By changing these values, different colours will be used.

**MC_VISU_COLOR_INFORMATION (GVL)**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Initial</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>MC_VISU_BACKG</td>
<td>DWORD</td>
<td>16#FF888888</td>
<td>Color combination for the Grey color</td>
</tr>
<tr>
<td>MC_VISU_TITL</td>
<td>DWORD</td>
<td>16#FFFFFF00</td>
<td>Color combination for yellow</td>
</tr>
</tbody>
</table>

Below, some existing visualizations are shown.

**MC_VISU_Axis_StateMachine**

This shows the state machine of the axis according to PLCopen definition. The active state is shown green except the ErrorStop which is shown red. Usually, it starts with Disabled. When no remote connection to the drive is available, it will switch to ErrorStop immediately.

The placeholder of this visualization has to be connected to an instance of the data type Axis_Ref.

**MC_VISU_Axis_actual**

This object shows some actual values.

The Placeholder of this visualization has to be connected to an instance of the data type Axis_Ref.
This object shows the error information connected to the PLCopen function blocks. This is NOT a drive error. If no error occurs in the execution of a function block, just the name is shown. If an error occurred, it shows the name of the function block as well as the error number and a short description. In the example below, the MC_Power function block recognized that no fieldbus connection to the drive was available.

The Placeholder of this visualization has to be connected to an instance of the data type Axis_Ref.

**Error codes**

Besides the diagnosis information of the drive which is described in the respective drive documentation, there are a number of error codes directly related to the function blocks. These error codes are displayed at the output “ErrorID” of the function block.

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Mnemonic</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>MC_Ok</td>
<td>No Error</td>
</tr>
<tr>
<td>1</td>
<td>WRONG_STATE</td>
<td>A function block was activated not according to the state machine, e.g. tried to start a movement while in state Disabled.</td>
</tr>
<tr>
<td>2</td>
<td>DRIVE_PROBLEM</td>
<td>The drive indicates an error, e.g. tripped.</td>
</tr>
<tr>
<td>3</td>
<td>PARAMETER_EXCEEDS_LIMIT</td>
<td>A parameter at the function block is outside the possible range. This does not refer to the parameter range which is allowed for the drive but just to the 32-Bit Integer which is used for internal calculation.</td>
</tr>
<tr>
<td>4</td>
<td>NO_FIELD_ACCESS</td>
<td>No fieldbus connection to the drive.</td>
</tr>
<tr>
<td>5</td>
<td>BUS_PROBLEM</td>
<td>Not used</td>
</tr>
<tr>
<td>6</td>
<td>ABS_SWITCH_ERROR</td>
<td>During Homing, (when done by function blocks) limit switch not according to moving direction e.g. the positive switch occurred when moving in negative direction.</td>
</tr>
<tr>
<td>7</td>
<td>TIMEOUT</td>
<td>Timeout in block execution.</td>
</tr>
<tr>
<td>Error Code</td>
<td>Mnemonic</td>
<td>Explanation</td>
</tr>
<tr>
<td>------------</td>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>8</td>
<td>NAK</td>
<td>Parameter access not applicable</td>
</tr>
<tr>
<td>9</td>
<td>MC_TimeLimitExceeded</td>
<td>Used by function blocks with TimeLimit.</td>
</tr>
<tr>
<td>10</td>
<td>MC_DistanceLimitExceeded</td>
<td>Used by function blocks with DistanceLimit.</td>
</tr>
<tr>
<td>11</td>
<td>MC_TorqueLimitExceeded</td>
<td>Used by function blocks with TorqueLimit.</td>
</tr>
<tr>
<td>12</td>
<td>NOT_IMPLEMENTED</td>
<td>Functionality not implemented for certain axis type.</td>
</tr>
<tr>
<td>101</td>
<td>ErrorID_POSITION_FOLLOW</td>
<td>Following error, caused by &gt; position error =&gt; ERRORSTOP. (parameter POS_LAG_PERCENTAGE)</td>
</tr>
<tr>
<td>102</td>
<td>ErrorID_POSSW</td>
<td>Positive software limit switch =&gt; ERRORSTOP. The actual position did exceed the positive Software limit switch position. This supervision has to be activated with MC_WriteParameter.</td>
</tr>
<tr>
<td>103</td>
<td>ErrorID_NEGSW</td>
<td>Negative software limit switch =&gt; ERRORSTOP. The actual position did exceed the negative Software limit switch position. This supervision has to be activated with MC_WriteParameter.</td>
</tr>
<tr>
<td>104</td>
<td>ErrorID_VELOCITY_FAULT</td>
<td>The measured velocity and commanded velocity are &gt; 50% (related to maximum velocity) apart, for a certain time =&gt;ERRORSTOP (parameter V_CHECKTIME)</td>
</tr>
<tr>
<td>105</td>
<td>ErrorID_INTERPOLATION_FAULT</td>
<td>following error, caused by interpolation problem =&gt;ERRORSTOP. Position following error occurred, but reason most likely a interpolation problem, not drive problem (e.g. CAM Table, position step).</td>
</tr>
<tr>
<td>110</td>
<td>ErrorID_WARNING_VELOCITYLIMIT</td>
<td>Velocity or acceleration/deceleration are in limitation, set by parameter EnableLimitVelocity, MaxVelocityAppl, MaxDecelerationAppl</td>
</tr>
<tr>
<td>111</td>
<td>ErrorID_WARNING_POSITIONLIMITPOS</td>
<td>Position is in limitation towards position limit (SWLimit2DecPos), axis decelerates near positive software limit switch</td>
</tr>
<tr>
<td>112</td>
<td>ErrorID_WARNING_POSITIONLIMITNEG</td>
<td>Position is in limitation towards position limit (SWLimit2DecNeg), axis decelerates near negative software limit switch</td>
</tr>
<tr>
<td>113</td>
<td>ErrorID_WARNING_POSITIONOVERRUN</td>
<td>A linear axis created a 32bit position overrun (&gt; 2147483647 u =&gt;inc) =&gt;configure modulo</td>
</tr>
<tr>
<td>114</td>
<td>ErrorID_WARNING_ABORT</td>
<td>Axis aborted due to too large position gap due to velocity limitation</td>
</tr>
<tr>
<td>115</td>
<td>ErrorID_WARNING_MOTION_DIRECTION</td>
<td>Either positive or negative direction blocked by MC_Power</td>
</tr>
</tbody>
</table>
Error handling

All access to the drive/motion control is via function blocks. Internally these function blocks provide basic error checking on the input data. Exactly, how this is done is implementation dependent. For instance, if MaxVelocity is set to 6000, and the Velocity input to a function block is set to 10,000, a basic error report is generated. In the case where an intelligent drive is coupled via a network to the system, the MaxVelocity parameter is probably stored on the drive. The function block must take care of the errors generated by the drive internally. With another implementation, the MaxVelocity value could be stored locally. In this case the function block will generate the error locally.

Both centralized and decentralized error handling methods are possible when using the motion control function blocks.

Centralized error handling is used to simplify programming of the function block. Error reaction is the same independent of the instance in which the error has occurred.

Decentralized error handling gives the possibility of different reactions depending on the function block in which an error occurred.
Additional parameters are available by ReadParameter and WriteParameter function blocks.

Following function blocks can be used for the read and write operation. Functionality of these blocks and its variables are explained in the integrated documentation:
- MC_ReadParameter
- MC_WriteParameter
- MC_ReadBoolParameter
- MC_WriteBoolParameter
<table>
<thead>
<tr>
<th>Parameter number (PN)</th>
<th>Name</th>
<th>Datatype</th>
<th>Min.</th>
<th>Max.</th>
<th>Default</th>
<th>R/W</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Commanded Position</td>
<td>DINT</td>
<td></td>
<td></td>
<td></td>
<td>R</td>
<td>Commanded position.</td>
</tr>
<tr>
<td>2</td>
<td>SWLimitPos</td>
<td>DINT</td>
<td>-2147483647</td>
<td>2147483647</td>
<td>2147483647</td>
<td>R/W</td>
<td>Positive Software limit switch position.</td>
</tr>
<tr>
<td>3</td>
<td>SWLimitNeg</td>
<td>DINT</td>
<td>-2147483647</td>
<td>2147483647</td>
<td>-2147483647</td>
<td>R/W</td>
<td>Negative Software limit switch position.</td>
</tr>
<tr>
<td>4</td>
<td>EnableLimitPos</td>
<td>BOOL</td>
<td>FALSE</td>
<td>TRUE</td>
<td>FALSE</td>
<td>R/W</td>
<td>Enable positive software limit switch.</td>
</tr>
<tr>
<td>5</td>
<td>EnableLimitNeg</td>
<td>BOOL</td>
<td>FALSE</td>
<td>TRUE</td>
<td>TRUE</td>
<td>R/W</td>
<td>Enable negative software limit switch.</td>
</tr>
<tr>
<td>6</td>
<td>Enable-Pos-LagMonitoring</td>
<td>BOOL</td>
<td>FALSE</td>
<td>TRUE</td>
<td>TRUE</td>
<td>R/W</td>
<td>Enable monitoring of position lag (following error).</td>
</tr>
<tr>
<td>7</td>
<td>Max-PositionLag</td>
<td>DINT</td>
<td>1</td>
<td></td>
<td>2147483647 ***</td>
<td>R</td>
<td>Maximal position lag.</td>
</tr>
<tr>
<td>8</td>
<td>Max-Velocity-System</td>
<td>DINT</td>
<td>0***</td>
<td>32767</td>
<td>32767</td>
<td>R</td>
<td>Maximal allowed velocity of the axis in the motion system.</td>
</tr>
<tr>
<td>9</td>
<td>Max-VelocityApplication</td>
<td>DINT</td>
<td>0***</td>
<td>32767</td>
<td>32767</td>
<td>R/W</td>
<td>Maximal allowed velocity of the axis in the application.</td>
</tr>
<tr>
<td>10</td>
<td>ActualVelocity</td>
<td>DINT</td>
<td>-32767</td>
<td>32767</td>
<td></td>
<td>R</td>
<td>Actual velocity.</td>
</tr>
<tr>
<td>11</td>
<td>CommandedVelocity</td>
<td>DINT</td>
<td>-32767</td>
<td>32767</td>
<td></td>
<td>R</td>
<td>Commanded velocity.</td>
</tr>
<tr>
<td>12</td>
<td>Max-Acceleration-System</td>
<td>DINT</td>
<td></td>
<td>32767</td>
<td></td>
<td>R</td>
<td>Maximal allowed acceleration of the axis in the motion system.</td>
</tr>
<tr>
<td>Parameter number (PN)</td>
<td>Name</td>
<td>Datatype</td>
<td>Min.</td>
<td>Max.</td>
<td>Default</td>
<td>R/W</td>
<td>Comments</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------</td>
<td>----------</td>
<td>------</td>
<td>-------</td>
<td>---------</td>
<td>-----</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>13</td>
<td>Max-Acceleration-Appl</td>
<td>DINT</td>
<td>10</td>
<td>32767</td>
<td>32767</td>
<td>R/W</td>
<td>Maximal allowed acceleration of the axis in the application.</td>
</tr>
<tr>
<td>14</td>
<td>Max-Deceleration-System</td>
<td>DINT</td>
<td></td>
<td>32767</td>
<td></td>
<td>R</td>
<td>Maximal allowed deceleration of the axis.</td>
</tr>
<tr>
<td>15</td>
<td>Max-Deceleration-Appl</td>
<td>DINT</td>
<td>10</td>
<td>32767</td>
<td>32767</td>
<td>R/W</td>
<td>Maximal allowed deceleration of the axis.</td>
</tr>
<tr>
<td>16</td>
<td>Max-Jerk</td>
<td>DINT</td>
<td>0*</td>
<td>2147483647</td>
<td>2147483647</td>
<td>R/W</td>
<td>Maximal allowed jerk of the axis.</td>
</tr>
<tr>
<td>2001</td>
<td>MODULO_NO_MINATOR</td>
<td>DINT</td>
<td>1</td>
<td>2147483647</td>
<td>1</td>
<td>R/W</td>
<td>ABB specific parameter. Used for PLC-based motion control implementation: Gearbox modifier to MODULO_RANGE</td>
</tr>
<tr>
<td>2002</td>
<td>MODULO_DE_NOMINATOR</td>
<td>DINT</td>
<td>1</td>
<td>2147483647</td>
<td>1</td>
<td>R/W</td>
<td>ABB specific parameter. Used for PLC-based motion control implementation: Gearbox modifier to MODULO_RANGE</td>
</tr>
<tr>
<td>2003</td>
<td>Enable-Limit 2Decelerate</td>
<td>BOOL</td>
<td>FALSE</td>
<td>TRUE</td>
<td>FALSE</td>
<td>R/W</td>
<td>Enable software limit switches to decelerate</td>
</tr>
<tr>
<td>Parameter number (PN)</td>
<td>Name</td>
<td>Datatype</td>
<td>Min.</td>
<td>Max.</td>
<td>Default</td>
<td>R/W</td>
<td>Comments</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------</td>
<td>----------</td>
<td>-------</td>
<td>-------</td>
<td>---------</td>
<td>-----</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>2004</td>
<td>EnableLimitAbort</td>
<td>BOOL</td>
<td>FALSE</td>
<td>TRUE</td>
<td>FALSE</td>
<td>R/W</td>
<td>Enable that software limit switches will abort ongoing movement. FALSE = Limits position and velocity, decelerates and shows a warning until the position limit is reached, then ERROR STOP TRUE = Switches off any ongoing motion and decelerates to the position limit, then ERROR STOP</td>
</tr>
<tr>
<td>2005</td>
<td>EnableLimitVelocity</td>
<td>BOOL</td>
<td>FALSE</td>
<td>TRUE</td>
<td>FALSE</td>
<td>R/W</td>
<td>If the velocity is limited the unmoved position will be covered whenever possible</td>
</tr>
<tr>
<td>2006</td>
<td>SWLimit2DecPos</td>
<td>LREAL</td>
<td>-2147483647</td>
<td>2147483647</td>
<td>2147483647</td>
<td>R/W</td>
<td>Used as end position for EnableLimit2Decelerate</td>
</tr>
<tr>
<td>2007</td>
<td>SWLimit2DecNeg</td>
<td>LREAL</td>
<td>-2147483647</td>
<td>2147483647</td>
<td>2147483647</td>
<td>R/W</td>
<td>Used as end position for EnableLimit2Decelerate</td>
</tr>
<tr>
<td>2008</td>
<td>MaxPositionGapL</td>
<td>LREAL</td>
<td>0</td>
<td>2147483647</td>
<td>0</td>
<td>R/W</td>
<td>Used to stop the ongoing movement if position is behind</td>
</tr>
</tbody>
</table>

0* means: no limitation of jerk is performed.

**Axis will stay in stop.

***is modified by CMC_Axis_Control_Parameter, the max. Value is calculated in increments, the value which is delivered by ReadParameter will be given in [u].

In addition to the above parameters certain other operation can be done using the below parameters from the data type "Axis_Parameter"
<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Initial</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>paraFilterVariant</td>
<td>INT</td>
<td></td>
<td>Filter for actual velocity 0 = PT1 1 = LinearRegression</td>
</tr>
<tr>
<td>paraFilterTime</td>
<td>INT</td>
<td>10</td>
<td>Time in PLC cycles, used with paraFilterVariant</td>
</tr>
<tr>
<td>paraFilterForecast</td>
<td>INT</td>
<td>0</td>
<td>Time in PLC cycles, used with paraFilterVariant = 1</td>
</tr>
<tr>
<td>paraReverseDirection</td>
<td>INT</td>
<td>0</td>
<td>Changes the direction for actual and reference positions based on the mode selected. 0 = normal direction 1 = reverse input position 2 = reverse output position and speed reference 3 = reverse both</td>
</tr>
<tr>
<td>paraEarlyClosedLoop</td>
<td>BOOL</td>
<td>FALSE</td>
<td>TRUE: hold the position when Drive_Release is set (not wait for Drive_InOperation = TRUE)</td>
</tr>
<tr>
<td>paraLateOpenLoop</td>
<td>BOOL</td>
<td>FALSE</td>
<td>TRUE: hold the position until Drive_InOperation = FALSE</td>
</tr>
</tbody>
</table>

**Limits**

*Table 762: Limitations for the inputs of PLCopen function blocks when used with CMC_Basic_Kernel*

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Min.</th>
<th>Max.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Velocity</td>
<td>0</td>
<td>x</td>
</tr>
<tr>
<td>Acceleration, Deceleration</td>
<td>0</td>
<td>x</td>
</tr>
<tr>
<td>Position</td>
<td>-2147483647</td>
<td>2147483647</td>
</tr>
</tbody>
</table>
General restrictions

Restrictions for the available function blocks

- As buffered mode, MC_Aborting is realized as a default. This does NOT mean that the axis stops when another movement is started while an ongoing movement is still active. It means instead that the new movement will take control immediately and change the velocity to its own velocity by using its own acceleration or deceleration.
- The buffered mode MC_Buffered could be reached with using the axis state StandStill as enable signal for the Execute of the next block.
- From the Extended Inputs and Outputs at the function blocks, the following are not realized:
  - BufferedMode: The realization just supports the MC_Aborting mode.
  - The following Outputs at ReadStatus are not supported: ConstantVelocity, Accelerating and Decelerating.
  - TorqueLimit for Homing function blocks.
**MC_Aborting Mode**
The diagram shows the behavior with BufferMode MC_Aborting, which is the only available BufferMode. When the second Block is activated, it will take control and will continue on its own velocity. The velocity is changed by using the acceleration value from the second function block. The movement will not be stopped in between. The first function block shows CommandAborted when the second function block is activated.

**MC_Buffered**
A behavior according to BufferMode MC_Buffered could be reached by using the Done output from the first function block to enable the Execute of the second function block.

### Behavior of the function block inputs and outputs

#### General rules

<table>
<thead>
<tr>
<th>Table 763: General rules</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Output exclusivity</strong></td>
</tr>
<tr>
<td>The outputs Busy, Done, Error, and CommandAborted are mutually exclusive: Only one of them can be TRUE on one function block. If Execute is TRUE, one of these outputs has to be TRUE. Only one of the outputs Active, Error, Done and CommandAborted is set at the same time.</td>
</tr>
<tr>
<td><strong>Output status</strong></td>
</tr>
<tr>
<td>The outputs Done, InGear, InSync, InVelocity, Error, ErrorID and CommandAborted are reset with the falling edge of Execute. However, the falling edge of Execute does not stop or even influence the execution of the actual function block. It must be guaranteed that the corresponding outputs are set for at least one cycle if the situation occurs, even if execute was reset before the function block completed. If an instance of a function block receives a new execute before it has finished (as a series of commands on the same instance), the function block will not return any feedback, like Done or CommandAborted, for the previous action.</td>
</tr>
<tr>
<td><strong>Input parameters</strong></td>
</tr>
<tr>
<td>The parameters are used with the rising edge of the execute input. To modify any parameter, it is necessary to change the input parameter(s) and to trigger the motion again.</td>
</tr>
<tr>
<td><strong>Missing input parameters</strong></td>
</tr>
<tr>
<td>According to IEC 61131-3, if any parameter of a function block input is missing (open) then the value from the previous invocation of this instance will be used. In the first invocation the initial value is applied.</td>
</tr>
<tr>
<td><strong>Position versus distance</strong></td>
</tr>
<tr>
<td>Position is a value defined within a coordinate system. Distance is a relative measure related to technical units. Distance is the difference between two positions.</td>
</tr>
<tr>
<td><strong>Sign rules</strong></td>
</tr>
<tr>
<td>Velocity, Acceleration, Deceleration and Jerk are always positive values. Position and Distance can be both positive and negative.</td>
</tr>
<tr>
<td><strong>Error Handling Behavior</strong></td>
</tr>
<tr>
<td>All function blocks have two outputs, which deal with errors that can occur while executing that function block. These outputs are defined as follow:</td>
</tr>
<tr>
<td>Error Rising edge of Error informs that an error occurred during the execution of the function block.</td>
</tr>
<tr>
<td>ErrorID: Error number</td>
</tr>
</tbody>
</table>
The outputs Done, InVelocity, InGear, and InSync mean successful completion so these signals are logically exclusive to Error.

**Types of errors:**
- Function blocks (e.g. parameters out of range, state machine violation attempted),
- Communication,
- Drive Instance errors do not always result in an axis error (bringing the axis to StandStill). The error outputs of the relevant function block are reset with falling edge of Execute.

<table>
<thead>
<tr>
<th>Function block naming</th>
<th>In case of multiple libraries within one system (to support multiple drive/ motion control systems), the function block naming may be changed to MC_FunctionBlockName_SupplierID.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Behavior of Done output</th>
<th>The outputs Done, InGear, InSync... are set when the commanded action has been completed successfully. With multiple function blocks working on the same axis in a sequence, the following applies: When one movement on an axis is interrupted with another movement on the same axis without having reached the final goal, Done of the first function block will not be set.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Behavior of CommandAborted output</th>
<th>CommandAborted is set, when a commanded motion is interrupted by another motion command. The reset-behavior of CommandAborted is like that of Done. When CommandAborted occurs, the other output-signals such as InVelocity are reset.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Inputs exceeding application limits</th>
<th>If a function block is commanded with parameters which result in a violation of application limits, the instance of the function block generates an error. The consequences of this error for the axis are application specific and thus should be handled by the application program.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Behavior of Busy output</th>
<th>Every function block can have an output Busy, reflecting that the function block is not finished. Busy is SET at the rising edge of Execute and RESET when one of the outputs Done, Aborted, or Error is set. It is recommended that this function block should be kept in the active loop of the application program for at least as long as Busy is true, because the outputs may still change. For one axis, several function blocks might be busy, but only one can be active at a time. Exceptions are MC_SuperImposed and MC_Phasing, where more than one function block related to one axis can be active.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Output Active</th>
<th>The output Active is required on buffered function blocks. This output is set at the moment the function block takes control of the motion of the according axis. For un-buffered mode the outputs Active and Busy can have the same value.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Enable and Valid/Status</th>
<th>The input Enable is coupled to output Valid. Enable is level sensitive, and Valid shows that a valid set of outputs is available at the function block. The output Valid is TRUE as long as an output value of Valid is available and the input Enable is TRUE. The relevant output value can be refreshed as long as the input Enable is TRUE. If there is a function block error, the output is not Valid (Valid set to FALSE). When the error condition disappears, the values will reappear and output Valid will be set again.</th>
</tr>
</thead>
</table>
**Why is the command input edge sensitive?**

The input Execute for the different function blocks described in this document always triggers the function with its rising edge. The reason for this is that with edge triggered Execute new input values may be commanded during execution of a previous command. The advantage of this method is a precise management of the instant a motion command is performed. Combining different function blocks is then easier in both centralized and decentralized models of axis management. The output Done can be used to trigger the next part of the movement. The example given below is intended to explain the behavior of the function block execution.

The following figure illustrates the sequence of three function blocks First, Second and Third controlling the same axis. These three function blocks could be for instance various absolute or relative move commands. When First is completed the motion its rising output First.Done triggers Second.Execute. The output Second.Done AND In13 triggers the Third.Execute.

---

**Fig. 320: Behavior of the Execute/Done style function blocks.**
Fig. 321: Function blocks to perform a complex movement

The input ContinuousUpdate

Like described in the previous chapter, the input Execute triggers a new movement. With a rising edge of this input the values of the other function block inputs are defining the movement. Until version 1.1 of PLCopen there was the general rule that a later change in these input parameters does not affect the ongoing motion.

Nevertheless, there are numerous application examples, where a continuous change of the parameters is needed. The user could retrigger the input Execute of the function block, but this complicated the application.

Therefore, the input ContinuousUpdate has been introduced. It is an extended input to all applicable function blocks. If it is TRUE, when the function block is triggered (rising Execute), it will - as long as it stays TRUE – make the function block use the current values of the input variables and apply it to the ongoing movement. This does not influence the general behavior of the function block nor does it impact the single axis state diagram. In other words it only influences the ongoing movement and its impact ends as soon as the function block is no longer Busy or the input ContinuousUpdate is set to FALSE.
It can be that certain inputs like BufferMode are not really intended to change every cycle. However, this has to be dealt with in the application, and is not forbidden in the specification.

If ContinuousUpdate is FALSE with the rising edge of the input Execute, a change in the input parameters is ignored during the whole movement and the original behavior of previous versions is applicable. The ContinuousUpdate is not a retriggering of the input Execute of the function block. A retriggering of a function block which was previously aborted, stopped, or completed, would regain control on the axis and modify its single axis state diagram. Opposite to this, the ContinuousUpdate only effects an ongoing movement. Also, a ContinuousUpdate of relative inputs (e.g. Distance in MC_MoveRelative) always refers to the initial condition (at rising edge of Execute).

**Example**

- MC_MoveContinuousRelative is started at Position 0 with Distance 100, Velocity 10 and ContinuousUpdate set TRUE. Execute is Set and so the movement is started to position 100.
- While the movement is executed (let the drive be at position 50), the input Distance is changed to 130, Velocity 20.
- The axis will accelerate (to the new Velocity 20) and stop at Position 130 and set the output Done and does not accept any new values.

### Unit of length

The only specification for physical quantities is made on the unit of length (noted as [u]) that is to be coherent with its derivatives i.e. (velocity [u/s]; acceleration [u/s²]; jerk [u/s³]). Nevertheless, the unit [u] is not specified (manufacturer dependent). Only its relations with others are specified.

### Aborting versus buffered modes

Some of the function blocks have an input called BufferMode. With this input, the function block can either work in a Non-buffered mode (default behavior) or in a Buffered mode. The difference between those modes is when they should start their action:

- A command in a non-buffered mode acts immediately, even if this interrupts another motion,
- A command in a buffered mode waits till the current function block sets its output Done (or InPosition, InVelocity...).
- The library just supports the mode "aborting" (MCAborting)

The following examples describe the different behavior of these modes:
Example 1:
Standard behavior of two following absolute movements

![Diagram showing two MC_MoveAbsolute on the same axis](image)

Fig. 322: Basic example with two MC_MoveAbsolute on same axis
Fig. 323: Timing diagram for example above without interference between function block 1 and function block 2
Example 2: Aborting motion

```
<table>
<thead>
<tr>
<th>Axis_1</th>
<th>Start_1</th>
<th>MC_MoveAbsolute</th>
<th>Axis</th>
<th>Done_1</th>
<th>Start_2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axis</td>
<td>Execute</td>
<td>Done</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1000</td>
<td>Position</td>
<td>CommandAborted</td>
<td>CA_1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>100</td>
<td>Velocity</td>
<td>Busy</td>
<td>Busy_1</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>100</td>
<td>Acceleration</td>
<td>Active</td>
<td>Active_1</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>100</td>
<td>Deceleration</td>
<td>Error</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Aborting</td>
<td></td>
<td>BufferMode</td>
<td>Aborting</td>
<td>BufferMode</td>
<td></td>
</tr>
</tbody>
</table>
```

```
<table>
<thead>
<tr>
<th>Axis</th>
<th>Execute</th>
<th>Done</th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>2000</td>
<td>Position</td>
<td>CommandAborted</td>
<td>CA_2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td>Velocity</td>
<td>Busy</td>
<td>Busy_2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td>Acceleration</td>
<td>Active</td>
<td>Active_2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td>Deceleration</td>
<td>Error</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>BufferMode</td>
<td>Aborting</td>
<td>BufferMode</td>
<td></td>
</tr>
</tbody>
</table>
```
Fig. 324: Timing diagram for example above with function block 2 interrupting function block 1 (McAborting Mode)
If an on-going motion is aborted by another movement, it can occur that the braking distance is not sufficient due to deceleration limits.

In rotary axis, a modulo can be added. A modulo axis could go to the earliest repetition of the absolute position specified, in cases where the axis should not change direction and reverse to attain the target position.

In linear systems, the resulting overshoot can be resolved by reversing, as each position is unique and therefore there is no need to add a modulo to reach the correct position.
PLCopen examples

Example: A function block instance controls different motions of an axis

The following figure shows an example where the function block (MC_MoveVelocity) is used to control AxisX with three different values of Velocity. In a Sequential Function Chart (SFC) the velocity 10, 20, and 0 is assigned to V. To trigger the input Execute with a rising edge the variable E is stepwise set and reset.

The following timing diagram explains how it works:
The second InVelocity is set for only one cycle because the Execute has gone low before the ActualVelocity equals CommandedVelocity.
Different instances related to the same axis can control the motions on an axis. Each instance will then be responsible for one part of the global profile.

**Example: Different function blocks instances control the motions of an axis**

![Cascaded function blocks](image)

**Fig. 327: Cascaded function blocks**

The timing diagram:
Fig. 328: Cascaded function blocks timing diagram

A corresponding solution written in LD looks like:

Fig. 329: Cascaded function blocks with LD
6.5.10.3.5 PLC-based motion control

PLC-based motion control architecture

With PS561-Motion different motion control system structures are possible. Independent of the system structure a typical motion control application consists of the following system elements:

- An application program which contains PLCopen function blocks that define the general application behavior and logics.
- A profile generator which generates a position profile based on the dynamic specifications of the application program to guide the axis to the desired positions.
- A position control loop which outputs a speed reference signal to minimize the following error.

To achieve the best system structure for an application these components can be separated into different devices. Each type of structure has its own kind of interface and type of signals which need to be transferred between the interacting devices.

All shown motion control system structures (Central motion control with or without position control loop) can be combined together in the same application program for a motion control project.

With the function blocks of motion library a motion control profiler can be used inside the PLC. As shown in the following figure it is needed to provide the actual position of the drive. The output can be either a position or a velocity reference signal. The used output signal will then be used to move the axis in the desired way.

![Diagram](image)

There are 2 possibilities to send a reference value to the drive:

- When the position control loop is closed by the PLC by a CMC_Basic_Kernel function block, the output Speed_Reference should be connected to the drive. The value of Speed_Reference can be scaled with the axis parameters Max_Rpm and Ref_Max.
- When the position control loop is closed by the drive, the output Position_Reference should be connected to the drive. The unit for the output Position_Reference is incremented as well as the input Drive_ActualPosition.
In general the programming of a machine consists of two layers as shown in the figure above.

In the application layer function blocks according to PLCopen motion control are used to program the application sequences with all necessary types of movements and administrative commands. Due to the standard PLCopen motion control this can be reused in any other machine programs that used PLCopen function blocks.

The axis implementation layer is responsible for the execution of the commands from the application layer and can be programmed for each axis in a different way depending on the used hardware components.

**Table 764: Needed function blocks for an application with PLC-based motion control**

<table>
<thead>
<tr>
<th>Library</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABB_MotionControl_AC500.library</td>
<td>Kernel function block, Parameters function block, Axis Simulation function block</td>
</tr>
<tr>
<td></td>
<td>Data types for AC500 motion control</td>
</tr>
<tr>
<td></td>
<td>Motion control function blocks according to PLCopen</td>
</tr>
</tbody>
</table>

For a central motion axis implementation the use of the function blocks CMC_Basic_Kernel and CMC_Axis_Control_Parameter are mandatory.

The library design is independent from any bus architecture or any specific drive features.
### Example for a possible system architecture

<table>
<thead>
<tr>
<th>System</th>
<th>Velocity reference</th>
<th>Position feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>System A</td>
<td>Output via analog output channel as voltage or current</td>
<td>From incremental encoder connected to CD522 I/O module</td>
</tr>
<tr>
<td>System B</td>
<td>Output via EtherCAT network</td>
<td>Input via EtherCAT network</td>
</tr>
<tr>
<td>System C</td>
<td>Output as frequency signal of CD522 I/O module</td>
<td>From incremental encoder connected to CD522 I/O module</td>
</tr>
<tr>
<td>System D</td>
<td>Output via PROFINET IO network</td>
<td>Input via PROFINET IO network</td>
</tr>
<tr>
<td>System E</td>
<td>Output via PTO &amp; PWM channel in eCo V3</td>
<td>Input via either encoder (included in onboard IO), or the PTO or PWM pulse count.</td>
</tr>
</tbody>
</table>

In case the velocity reference value is used from the kernel function block the position control loop is closed inside the drive. In this case, it is necessary to adjust the related parameters from the parameters function block. When the position reference will be used the position control loop is closed inside the drive. In this case, the internal control loop is just used to monitor the position and velocity.

> When the position reference is used for the drive the following aspects have to be taken care of:

- It is necessary to use a real time fieldbus, like EtherCAT.
- The PLC cycle has to be synchronized to the fieldbus cycle.
- The task calculation times may not exceed the used cycle time.

The drive’s status should be managed by a specialized function block that supports the used type of drive as shown in the figure above. The kernel function block is the main function block which is needed to operate an axis with PLC-based motion control. It must be used with the parameter function block which is the interface to input parameters which are used to setup the axis.

The drive has to be accessed outside the CMC_Basic_Kernel function block. Actual values and reference values might be transferred by a synchronized fieldbus or by I/Os. The function block CMC_Basic_Kernel has to be called every cycle and at least once before any function block MC or MCA is activated.

The following figure shows an example with an axis simulation. The main data signals are drawn in bold lines. Here, the drive will receive a speed reference signal which means that the position control loop is closed inside the PLC by the central motion function blocks. The time behavior of the simulated drive can be set by the parameter T1 at the axis simulation function block. If the time constant is too slow and the axis parameter Control_Time is too short the simulation axis will run into instability – like a real drive. Sample values "Chapter 6.5.10.3.5.2.3 “How to use the axis simulation” on page 4005."
A different option to create a virtual or simulated axis is to engage the Enable_Virtual input at CMC_Basic_Kernel. This virtual axis will follow the speed reference without additional delay, whereas the CMC_Axis_Simu creates a first order delay.

The following figure shows an example with a CiA402 drive on an EtherCAT network. The main data signals are drawn in bold lines. Here, the drive will receive a position reference signal which means that the position control loop is closed inside the drive.
In the example the main signals are to be transferred via EtherCAT network. The drive control function block for the Microflex e190 can be found in the ABB_Ecat_CiA402_AC500.library.

If using the eCo V3 PLCs, use the OBIO_PTO MotionKernel function block (separate library ABB_MotionControlEco_AC500.library) instead of CMC_Basic_Kernel for the PTO functionality.

In the eCo V3 PLC, if PWM is used in the configuration, use the OBIO_PWMMotionKernel function block instead of CMC_Basic_Kernel function block.

Basic functionalities

How to connect a drive

The connection to a drive must be done with the inputs and outputs of the function block CMC_Basic_Kernel. All inputs and outputs of the kernel function block with the prefix "Drive_" are intended to be used with a drive, but in some cases not all of them are needed. In all cases the input Drive_ActualPosition has to be connected with the actual position of the axis. This value can be received by an I/O module of the PLC or via a fieldbus.

Depending on which device closes the position control loop either the output Speed_Reference or Position_Reference output has to be used. The value of Speed_Reference can be connected to an analog output module or be transferred via a fieldbus. The value of Position_Reference should be exclusively sent via a real-time fieldbus like EtherCAT.
In the example the position control loop will be closed by the PLC, therefore the input Drive_ActualPosition and the output Speed_Reference are to be used.

In combination with the I/O module CD522 and the corresponding function block CD522Encoder32Bit the position of the encoder can be used. For the effective resolution of the encoder parameter Inc_Per_R of the parameter function block has to be used.

The output Speed_Reference can be written directly to the global variable of an output channel of an analog module but can also be transferred via a fieldbus. The scaling of this output value can be done with the parameters Ref_Max and Max_Rpm of the function block CMC_Axis_Control_Parameter_Real.

The scaling of the Speed_Reference value can be set with the inputs Ref_Max and Max_Rpm of the parameter function block.

In order to finish a homing sequence which is done by the function block MC_StepRefPulse the outputs Drive_Set_Ref and Drive_Set_Position from the kernel function block have to be connected with the inputs EN_RPI and START_VALUE of the CD552 I/O module function block. Also the output RdyRpi of the CD552 I/O module function block has to be connected with Drive_Ref_Ok from the kernel function block.

To enable and disable the drive Drive_Release could be connected to a binary output to activate the drive. Drive_InOperation could be connected to a binary input to get the information that Drive_Release was successful.
In the example the position control loop will be closed by the drive, therefore the input Drive_ActualPosition and the output Position_Reference are to be used. The inputs referring to the position control loop of the parameter function block do not have to be set.

For the effective resolution of the motor’s encoder parameter Inc_Per_R of the parameter function block has to be adjusted.

Example 2:
Servo Drive - Microflex e190 via EtherCAT in continuous positioning mode (csp)

To enable and disable the drive Drive_Release and Drive_Inoperation have to be connected to the control function block ECAT_CiA402_Control_App of the library ABB_Ecat_CiA402_AC500.library, which controls the status and control word of the drive.

All function blocks from this library are not password protected and free to be changed in order to be adapted for different drives. The library and the function blocks are marked with the ending _APP.

How to enable and disable a drive

In order to enable a drive the function block MC_Power has to be used within the applicational layer. The kernel function block will then, if possible, output a rising edge on the output Drive_Release which can be connected to the drive-control function block which performs the needed actions on the drives control word to enable the drive. As soon the drive states enabled, this signal can be connected to the input Drive_In_Operation of the kernel function block. The axis state according to the single axis state diagram of PLCopen will then switch from Disabled to Standstill.

![Graph showing drive enable sequence]

Fig. 331: Enabling sequence of a drive
As long as the drive is in state Disabled or ErrorStop the input Drive_Actual_Position will be copied to the output Position_Reference of the kernel function block. The output Speed_Reference will be zero.

When the axis is in operation, which means it is not in state Disabled or ErrorStop, then the output Position_Reference will be calculated by the kernel function block and the position control loop will be closed, which outputs non zero value for the output Speed_Reference in case of a following error. The input Actual_Position should then follow the position reference. The difference of both values is the following error and will be supervised by the kernel function block.

In case of drive problem, Drive_InOperation should be reset. The function block will open the position control loop and Speed_Reference will be set to zero.

For the most drives the status is control by the drives control word whereas the drives status word represents its actual status. In order to enable the drive it might be necessary to pass through several drives states according a defined scheme which depends on the used drive. Therefore the library ABB_Ecat_Cia402_AC500.library is added to PS5611-Motion package which contains function blocks to operate with different drives on an EtherCAT network. There is also the PS6605-DRIVES library package which can be used to control the state of other ABB drives and other protocols.

How to use the axis simulation

It is possible to use a simulated axis instead of a real drive.

The axis simulation can be used in the following use cases:

● When the real drive is not available the simulation can be used to test all available motion functionalities to verify the application program.

● The simulation can be used to create a virtual master axis and synchronize other axes to it.

The simulation is realized by the function block CMC_Axis_Simu or input Enable_Virtual = TRUE can be used at the KERNEL-block.

Homing will be possible if the limit-switches (data type CMC_Axis_IO) are simulated also. This is not done by CMC_Axis_Simu but could be realized in the PLC program.

Fig. 332: Example for Simulation

The drive velocity is simulated by PT1-Characteristic. The input T1 gives the time constant for this PT1 as multiple of the cycle time. All other properties are simulated according to the CMC_Axis_Control_Parameter.
The value of the time behavior from the axis simulation function block set by the input T1 has to be at least four times smaller than the value of the axis parameter Control_Time from the parameter function block. If Enable_Virtual = TRUE is used, no delay will be applied to the simulated drive speed, and it will not be possible to test the position-control loop, but it will be fine to be used as virtual axis.

How to perform a homing

The homing of an axis is a procedure which consists of up to two phases. For each phase there are different function blocks available. The available function blocks are according to PLCopen and belong to the application layer.

<table>
<thead>
<tr>
<th>Table 765: Overview of the available homing function blocks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phase 1</td>
</tr>
<tr>
<td>MC_StepAbsSwitch</td>
</tr>
<tr>
<td>MC_StepDirect</td>
</tr>
<tr>
<td>MC_StepLimitSwitch</td>
</tr>
<tr>
<td>MC_StepRefPulse</td>
</tr>
</tbody>
</table>

In order to create a complete homing sequence one function block of each phase can be used.

First phase

The used function blocks will change the axis state to Homing and will move the axis to approach installed limit switches or a dedicated absolute switch in the desired directions. No manipulation of a position value will be done in this phase. The use of function blocks of this phase is optional for a homing.

The signals of the installed limit switches have to be written to a variable of the data type CMC_Axis_IO.

Second phase

Function blocks from this phase will also change the axis state to Homing if this has not already happen and will finish the homing. Therefore a new position will be set to the axis. The axis state will then switch back to Standstill.

The use of a function block of the second phase is mandatory for a homing.

In general with AC500 PLC-based motion control there are two position values: One position value will represent the encoder counts of a drive or the CD522 module which is connected to the input Drive_ActualPosition of the kernel function block. The other position is a user defined scaled unit which is used for PLCopen function blocks.

There are different ways to finish the homing by manipulate and adjust a position value. Which value should be manipulated depends on the used drive or module and its capabilities. See the following types A, B and C.

Type A

The user defined position unit will be changed only. The function block MC_StepDirect must be used here. This type of homing is less complex than the other types but also less precise.
The Drive or the CD522 module will change its own position value, the encoder counts.

The process will be started by the execution of the function block MC_StepRefPulse. The axis will start to move.

The output Drive_Set_Ref of the kernel function block will then set the drive to sense for a digital signal. At the same time the kernel function block outputs a preset value which will replace the actual encoder count value at the moment the digital signal occurs.

This signal can be a Z-pulse of an incremental encoder but also any other signal from a sensor. This functionality may require a configuration of the drive or the CD522 module in order to be used.

In the same cycle when the new position value is set there also has to be a boolean signal stating a new position value at the input Drive_Ref_Ok of the kernel function block. The user defined position value will then be shifted accordingly.
The encoder count position value will not be changed but involves registration capabilities of a drive or the CD522 module.

The axis will start to move.

The output Drive_Set_Ref of the kernel function block will then command the drive or the CD522 module to activate the Touch Probe functionality. This will configure the drive to latch a position at the moment a digital signal occurs. The digital signal can be a Z-pulse of an incremental encoder but also any other signal from a sensor. This functionality may require a configuration of the drive or the CD522 module in order to be used.

In combination with the latched position value there is a boolean signal which states that a new latch value has been received. In case of the module CD522 this encoder count position value has to be converted from encoder counts to equivalent user scaled units by the use of the function “CMC_Get_Units_From_Inc” (ABB_MotionControl_AC500.library) before it can be connected to the function block ECAT_HomingOnTouchProbe_APP.

To manage the Touch Probe objects of a drive within the CiA402 profile (e.g. Microflex e190) the function block ECAT_HomingOnTouchProbe_APP (ABB_Ecat_CiA402_AC500.library) can be used. This will also cover the conversion from encoder counts to user scaled units.

At the end of the process the function block ECAT_HomingOnTouchProbe_APP will manipulate the user scaled position value according to the latched position from the drive and the users settings.

For further information see:
AN00220-001 - AC500 and MicroFlex e190 - EtherCAT Homing Methods
How to Use a CAM curve

The CAM functionality is only available in combination with the kernel function block CMC_Basic_Kernel.

From Automation Builder 2.5.0 onwards user can make use of inbuilt Cam Configurator to generate Cam Table. For more details on how to use Cam Configurator please refer Automation Builder Help file.

It is recommended to use the CAM Editor from Automation Builder for those who are new to Cam table or to get the structure of the Cam Table. User can create the complete CAM Table using Cam Editor or can make a copy of CAM Table (IEC Code) and adapt it directly in the IEC code if needed.

Details on the CAM Table structure and different parameters to be considered while creating the CAM is described below.

General usage

The usage of a CAM function is based on the following elements:

- CAM table defined with the data type MC_PProfile.
- An instance of the function block MC_CamTableSelect
- An instance of the function block MCA_Cam_Extra (optional)
- An instance of function block MC_CamIn
- An instance of function block MC_CamOut

The following steps are necessary to use a CAM table

1. Declare a CAM table as an array of the data type “MC_PProfile” in the program.
2. Write data to this array.
3. Use the address of the CAM table at the input “CamTable” of the function block “MC_CamTableSelect”.
4. Execute the function block “MC_CamTableSelect” to process the data of the CAM table with the function block’s input parameters.
5. Additionally you can execute the function block “MCA_Cam_Extra” for optional parameters after the processing of the function block “MC_CamTableSelect”.
6. Execute the function block “MC_CamIn” to start the slave axis movement according to the CAM table data and parameters.
   - The axis will operate in the axis state “Synchronized Motion”.
7. To leave the axis state you can execute the function block “MC_CamOut”.
   - The axis state will switch to state “Continuous Motion” and maintains its last velocity as long as there is no other command.
8. You can also use any other motion command interrupt the “Synchronized Motion”.

Preconditions to use “MC_CamIn” and “MCA_CamInDirect” function blocks
### 1. Use no sync option

<table>
<thead>
<tr>
<th>Behavior</th>
<th>Precondition</th>
<th>Howto</th>
<th>Possible problems</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start directly with cam table positions, previous movement will be aborted if the master is outside the cam table area, the slave position is not changed =&gt;velocity=0.</td>
<td>Move master and slave to matching positions (according to cam table) before MC_CamIn OR start the cam with positions=0 and use relative=TRUE OR compensate the position offset with MasterOffset and Slave-Offset (MC_CamIn).</td>
<td>Use MC_CamIn MasterStartDistance =0</td>
<td>A position jump, if precondition is not met.</td>
</tr>
</tbody>
</table>

### 2. Synchronize to a dedicated position while the master moves from (MasterSyncPosition-MasterStartDistance) to (MasterSyncPosition)

<table>
<thead>
<tr>
<th>Behavior</th>
<th>Precondition</th>
<th>Howto</th>
<th>Possible problems</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sync is started when the master passes (MasterSyncPosition-MasterStartDistance).</td>
<td>Master position &lt; (MasterSyncPosition-MasterStartDistance) (for positive movements), position can be outside the cam table position range. Slave has to be in standstill.</td>
<td>Use MC_CamIn MasterStartDistance&gt;0</td>
<td>Acceleration and velocity during sync process not limited sync has to wait until master passes start condition.</td>
</tr>
</tbody>
</table>

### 3. Synchronize while the master moves a certain distance (MasterStartDistance)

<table>
<thead>
<tr>
<th>Behavior</th>
<th>Precondition</th>
<th>Howto</th>
<th>Possible problems</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sync is started from the actual position and velocity and “inSync” when the master has moved “MasterStartDistance”.</td>
<td>-slave axis in standstill OR -master already moving in the right direction.</td>
<td>Use MC_Cam_ID. ignoreMasterSyncPosition = TRUE (modify data structure, output from MC_CamTableSelect)</td>
<td>Acceleration and velocity during sync process not limited.</td>
</tr>
</tbody>
</table>

### 4. Synchronize as fast as possible, master can move or standstill

<table>
<thead>
<tr>
<th>Behavior</th>
<th>Precondition</th>
<th>Howto</th>
<th>Possible problems</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use a given acceleration and velocity to move the slave to the position which matches the actual master position.</td>
<td>The master position should be within the cam table position range, actual velocity=0 or actual velocity &lt;&gt;0 is possible.</td>
<td>MCA_CamInDirect</td>
<td>The allowed acceleration and velocity must be higher than required by the cam movement, so the slave axis can catch up.</td>
</tr>
</tbody>
</table>

---

**CAM table**

CAM data is done with one table (two dimensional – describing master and slave positions together).

The data of the elements (array of data type MC_PProfile) can either be assigned within the declaration or can be assigned during run time before the execution of the function block MC_CamTableSelect.
It can be filled with data in the following ways:

- To use a predefined variable list.
- To calculate the values within the program (before using the MC_CamTableSelect).
- To send values by any communication access to the PLC.

In order to use the new data it is necessary to execute the function block MC_CamTableSelect again. In case the CAM table is executed the function block MC_CamTableSelect may not be executed.

Elements of the data type MC_PProfile ➔ Chapter 6.5.10.3.3.5 “Overview of data types” on page 3966

The inputs MasterSyncPosition and MasterSyncDistance of the function block MC_CamIn can be used to define a distance to synchronize the slave axis onto the CAM table during the start. In case master axis moves with negative velocity the parameter MasterSyncDistance can be negative. The MasterSyncPosition should always be within the range of the CAM table master position.

MasterSyncDistance = 0 will deactivate the synchronization. In this case the slave axis should be moved on the CAM curve before MC_CamIn is executed, otherwise a following error can occure.

Fig. 336: CAM profile figure

The master position in the CAM table must be strictly monotonic rising.

The length of a CAM table is just restricted by the memory size of the PLC. When long tables are used, it is recommended to call CamTableSelect in a task with lower priority as it will need a considerable computing time.

It is possible to hold several CamTables as a pool and to switch from one to another. This has to be done at matching positions as no means for synchronization are available.

The offset and scaling values (except the time-scale) are transferred continuously. This will allow to follow a "Moving Target" by adjusting these values.

The parameters at MC_CamTableSelect, MC_CamIn and function and MCA_Cam_Extra also modify the behavior:
<table>
<thead>
<tr>
<th>Parameter MC_CamTableSelect</th>
<th>Type</th>
<th>Default value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>MasterAbsolute</td>
<td>BOOL</td>
<td>FALSE</td>
<td>TRUE=Master_position from MC_PPProfile equals the master axis absolute position. FALSE=CAM is executed relative to the master axis actual position at start.</td>
</tr>
<tr>
<td>SlaveAbsolute</td>
<td>BOOL</td>
<td>FALSE</td>
<td>TRUE=interpolation_point from MC_PPProfile equals the slave axis absolute position. FALSE=CAM is started from actual slave position. The values &quot;interpolation_point&quot; are relative to the slave axis position at start.</td>
</tr>
<tr>
<td>iTypes</td>
<td>MC_ABB_iTypesENUM</td>
<td></td>
<td>Interpolationtype.</td>
</tr>
<tr>
<td>Number_of_pairs</td>
<td>INT</td>
<td></td>
<td>Number of points used in TimePosition Array.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter MC_CamIn</th>
<th>Type</th>
<th>Default value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>MasterOffset</td>
<td>LREAL</td>
<td>0</td>
<td>Just used with MasterAbsolute=TRUE, ignored otherwise. Used position for cam-table is: Master axis position-Masteroffset.</td>
</tr>
<tr>
<td>SlaveOffset</td>
<td>LREAL</td>
<td>0</td>
<td>Just used with SlaveAbsolute=TRUE, ignored otherwise. Used position is slave axis position=interpolation_point+Slaveoffset.</td>
</tr>
<tr>
<td>MasterScaling</td>
<td>LREAL</td>
<td>1</td>
<td>The position used for interpolation is multiplied by MasterScaling, e.g MasterScaling=2, the scaled master will pass the position range with double velocity and within the half distance compared to its real velocity and position.</td>
</tr>
<tr>
<td>SlaveScaling</td>
<td>LREAL</td>
<td>1</td>
<td>Interpolation result is multiplied by SlaveScaling, e.g SlaveScaling=2: Slave axis will run twice the distance.</td>
</tr>
<tr>
<td>MasterSyncPosition</td>
<td>LREAL</td>
<td>0</td>
<td>Start synchronization at master axis position=MasterSyncPosition-MasterStartDistance+MasterOffset, meet the CamTable at master axis position=MasterSyncPosition. In case of MasterAbsolute=FALSE: start at &quot;actualPosition+MasterSyncPosition-MasterStartDistance&quot;, meet the CamTable at &quot;actualPosition+MasterSyncPosition&quot;!!! It is just possible to use the &quot;sync&quot; mechanism when the axis is in StandStill on start.</td>
</tr>
<tr>
<td>MasterStartDistance</td>
<td>LREAL</td>
<td>0</td>
<td>A negative value will create a reverse synchronization mode, which means the master should move in negative direction to synchronize. It is independent from the Reverse-Bit which indicates how to end the movement.</td>
</tr>
</tbody>
</table>

These 2 parameters are "extras" to be written with the MCA_Cam_Extra function. When the parameters are used, the MCA_Cam_Extra has to be called after the MC_CamTableSelect.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Default value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Periodic</td>
<td>BOOL</td>
<td>TRUE for master &quot;Modulo&quot;, FALSE for master linear axis</td>
<td>CamTable will not reach &quot;EndOfProfile&quot; but will be repeated periodically. When the master is a linear axis, it has to move forward and backward within the CamTable position range, but even when it leaves this position range, the CamTable will stay active.</td>
</tr>
<tr>
<td>Reverse</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Just necessary when a CamTable is NOT &quot;periodic&quot; and will run in reverse direction (master with negative velocity) Reverse=FALSE, the CamTable is ready when the master leaves the position range in positive direction, e.g. when it moves from 359° to 0° on a rollover axes Reverse=TRUE, the CamTable is ready when the master leaves the position range in negative direction.</td>
</tr>
</tbody>
</table>
In the example, the slave will run from 0 to 2000 while the master runs from 0 to 1000. The slave will start and end with velocity 0, no matter which velocity the master has during start. The slave will reach the maximum velocity when it is at position 1000 and the master is at position 500.
How to use an external axis

To use multiaxis PLCopen function blocks with an externally sensed axis as master axis the following structure can be used for the axis implementation:

Axis Implementation Layer

Encoder Actual Position → Feed Forward Filter Function Block → Drive Actual Position → AXIS_REF

Central Motion Parameters Function Block

Central Motion Kernel Function Block

Fig. 337: Structure synchronization to an external axis

The use of a feed forward filter function block is needed if the slave axis has to follow the position of the external axis. In this case there will be a time delay between sensing the position of the external axis and moving the follower axis along the sensed position. The filter function block will then add a certain distance to the external axis’ position depending of its speed.

The filter function block MATH_LINEAR_REGRESSION from the library ABB_MathFunctions_AC500.library can be used here.
For an axis which is following the external axis, the value “mcActualValue” (from MC_Source enumeration) for the input “MasterValueSource” for multi-axis PLCopen function blocks has to be used.

When the filter function block MATH_LINEAR_REGRESSION is used to process an actual position, 2 different purposes are fulfilled:

- A jitter or noise can be compensated
- It is possible to calculate a forecast-position to compensate for a delay in position measurement

The MATH_LINEAR_REGRESSION function block calculates the progress for a variable which is captured in equidistant periods of time and is assumed to follow a linear curve. It uses the Gauss “least squares” algorithm to do so. The line is calculated in a way that the sum of squares for the distances from the measured points to the assumed straight line is minimized.

A noise or jitter influence of the value is compensated and a predictive value for the variable with an adjustable forecast horizon can be calculated.

Linear equation:

\[
\text{Line}[i] = \text{gradient} \times i + \text{offset}
\]

Sum of squares:

\[
\text{sum} = \sum_{i=1}^{\text{history}} (x[i] - \text{line}[i])^2
\]

The gradient and offset for the line are calculated in a way that “sum” is minimized. Then these 2 values are used to calculate the forecast value:

\[
\text{NEXT_VALUE} = \text{gradient} \times \text{FORECAST} + \text{offset}
\]

FORECAST=0 would mean: value right now, no future or past considered.

When the ACTUAL value is a modulo value, for example a single turn encoder or a rollover axis, this has to be considered in the calculation. The 2 input values POSITIVE_LIMIT and NEGATIVE_LIMIT can be used to configure this. They define the upper and lower limit for ACTUAL. Also, the NEXT_BINARY will as a result be limited to these borders.
How to use an encoder/drive with <> 32-bit position overrun

The incremental position as actual position at the function block CMC_Basic_Kernel is usually assumed as position with a 32-bit position overrun. As well as it is the reference position which is sent to the drive.

Any modulo-axis configuration should be done inside the PLC.

Some drives are requested to correct their positions themselves for a non-linear axis which should constantly run into the same direction.

In this case, the drive has to be configured as a modulo-axis and the function block CMC_Basic_Kernel needs some additional function blocks to create the 32-bit value “Roll-Over axis” on page 4031.

The function block CMC_Modulo2Binary will convert any position with any Modulo_Range to a 32-bit binary position.

The actual_position is assumed to run between 0 to Modulo_Range.

The actual_position should not change > 1/4 Modulo_Range between two scan cycles.

The function block CMC_Modulo2Binary will convert the 32-bit binary position reference from CMC_Basic_Kernel to a position reference which runs from 0 to Modulo_Range.
How to do position correction “on the fly”

Sometimes it is required to have a position correction “on the fly”. For example, it can happen that a position is wrong due to mechanical slip and that a switch which is passed by during the movement is used to capture a position value.

In other cases, it is required to synchronize the position to a print mark, so an actual_position has to be corrected, but not the movement of the printed material.

For both applications, the function block MCA_SetPositionContinuous can be used. It will use ramps and a limited velocity for the correction, so it will be tolerable to execute it during an ongoing movement and while the axis is activated in a multi-axis movement.

![MCA_SetPositionContinuous](image)

**Fig. 341: MCA_Set_PositionContinuous_V3**

The block can be used in any axis state except ERRORSTOP and HOMING.

Two different operation modes are possible:

1. **SuperImp=FALSE**
   - The actual_position will be modified.
   - The block will not cause any movement.
   - If a PLCopen block in DISCRETE_MOTION (positioning) is active during the execution, this block will not reach Done as the actual_position is modified.
   - If a slave axis is coupled to an axis while MCA_SetPositionContinuous is executed (with SuperImp=FALSE) it will follow.
   - This mode is possible while the axis is in state DISABLED.

2. **SuperImp=TRUE**
   - The actual_position will stay constant.
   - A mechanical movement is executed (without changing the axis state machine).
   - A slave axis will not follow.
   - This behavior is similar to a superimposed movement.
   - It is not possible when the axis is in state DISABLED.

The block can just be aborted by another MCA_SetPositionContinuous.

How to limit the movement

It is possible to limit the movement by position (software limit switches) and by velocity. By default, no software limit switches are activated in PS5611-Motion. It is possible to activate them by accessing some PLCopen parameter.

The functionality described below is just available with linear axes.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Data type</th>
<th>Minimum</th>
<th>Maximum</th>
<th>Default</th>
<th>R/W</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 SWLimitPos</td>
<td>DINT</td>
<td>2147483647</td>
<td>2147483647</td>
<td>2147483647</td>
<td>R/W</td>
<td>Positive software limit switch position.</td>
</tr>
<tr>
<td>3 SWLimitNeg</td>
<td>DINT</td>
<td>2147483647</td>
<td>2147483647</td>
<td>2147483647</td>
<td>R/W</td>
<td>Negative software limit switch position.</td>
</tr>
<tr>
<td>4 EnableLimitPos</td>
<td>BOOL</td>
<td>FALSE</td>
<td>TRUE</td>
<td>FALSE</td>
<td>R/W</td>
<td>Enable positive software limit switch.</td>
</tr>
<tr>
<td>5 EnableLimitNeg</td>
<td>BOOL</td>
<td>FALSE</td>
<td>TRUE</td>
<td>FALSE</td>
<td>R/W</td>
<td>Enable negative software limit switch.</td>
</tr>
<tr>
<td>2003 EnableLimit2Decelerate</td>
<td>BOOL</td>
<td>FALSE</td>
<td>TRUE</td>
<td>FALSE</td>
<td>R/W</td>
<td>Enable software limit switches to decelerate</td>
</tr>
<tr>
<td>2004 EnableLimitAbort</td>
<td>BOOL</td>
<td>FALSE</td>
<td>TRUE</td>
<td>FALSE</td>
<td>R/W</td>
<td>Enable that software limit switches will abort ongoing movement</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>FALSE = Limits position and velocity, decelerates and shows a warning until</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>the position limit is reached, then ERROR STOP</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>TRUE = Switches off any ongoing motion and decelerates to the position</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>limit, then ERROR STOP</td>
</tr>
<tr>
<td>2005 EnableLimitVelocity</td>
<td>BOOL</td>
<td>FALSE</td>
<td>TRUE</td>
<td>FALSE</td>
<td>R/W</td>
<td>If the velocity is limited the unmoved position will be covered whenever</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>possible</td>
</tr>
<tr>
<td>2006 SWLimit2DecPos</td>
<td>LREAL</td>
<td>-2147483647</td>
<td>2147483647</td>
<td>2147483647</td>
<td>R/W</td>
<td>Used as end position for EnableLimit2Decelerate</td>
</tr>
<tr>
<td>2007 SWLimit2DecNeg</td>
<td>LREAL</td>
<td>-2147483647</td>
<td>2147483647</td>
<td>2147483647</td>
<td>R/W</td>
<td>Used as end position for EnableLimit2Decelerate</td>
</tr>
<tr>
<td>2008 MaxPositionGap</td>
<td>LREAL</td>
<td>0</td>
<td>214748364700</td>
<td>0</td>
<td>R/W</td>
<td>Used to stop the ongoing movement if position is behind</td>
</tr>
</tbody>
</table>
The following different behavior is possible:

- No limitation at all (default)
- Limit position with ERRORSTOP:
  - Limit position between SWLimitNeg to SWLimitPos, axis to state ERRORSTOP in case the position range is left.
- Limit velocity and acceleration:
  - Limit velocity to paraMaxVelocityAppl and acceleration/deceleration to paraMaxDecelerationAppl, create WARNING_VELOCITY, not state changes for axis, abort movement is optional when MaxPositionGap is reached due to limitation.
- Limit Position with ramp-down:
  - In addition, it is possible to limit the position between SWLimit2DecNeg and SWLimit2DecPos. paraMaxDecelerationAppl is used to ramp down.

When activated with EnableLimitPos or EnableLimitNeg, the reaction will be as follows:

- When the control position reaches the respective limit switch, the axis will go to state ERRORSTOP, and Drive_Release will be switched off. The actual_position might be behind, depending on the following error. It is assumed that a drive or application specific braking is performed. The axis will be stopped behind the limit.
- The axis could be switched on again by MC_Power. A movement in the opposite direction will be possible.
- The functionality of EnableLimitPos and EnableLimitNeg is unchanged.

You can use the limitation of movement to achieve a soft or adjustable braking in advance before reaching the software limit switch. The limitation is activated by three Boolean parameter and will calculate a position distance to the limit switch, which depends on the actual velocity and given deceleration ramp. “paraMaxDecelerationAppl” is used for deceleration. It will decelerate the axis by the given deceleration ramp when the calculated position is reached and stop at the software limit switch. The original behavior is not modified, so if also these software limit-switches are activated, the axis might be set to state ERRORSTOP.

\[ T = \text{velocity/deceleration} \quad \text{(time to stop)} \]

\[ S = \frac{1}{2} \text{velocity}^2 T \quad \text{(distance to stop)} \]
There are 2 different modes:

- **EnableLimitAbort = TRUE**
  - Any ongoing motion will be aborted immediately (when the distance to stop is reached, as shown in the above diagram), a warning is shown.
  - The axis will be decelerated to reach the software limit switch.

- **EnableLimitAbort =FALSE, EnableLimitDecelerate=TRUE**
  - A warning is shown and the velocity is reduced, with respect to the given deceleration and position limit.
  - The ongoing motion is not aborted. If it was just a "tight fit", e.g. in a master slave movement and the direction is turned soon enough, it might be possible to continue the movement.
  - As the ongoing movement is not interrupted, an activated movement might not be completed, for example a MC_MoveAbsolute will never reach its target position. A warning is shown at function block CMC_Basic_Kernel.

When `EnableLimitPos = TRUE` or `EnableLimitNeg = TRUE`, and the values for `SWLimitPos` or `SWLimitNeg` are set, the axis will be set to state ERRORSTOP when these position limits are reached.

In addition, the function block will allow to limit the velocity. With `EnableLimitVelocity = TRUE`, it will monitor the velocity demand from the position reference and limit the position reference, so the given velocity limit will not be exceeded. A warning will be shown. The velocity used for limitation is `MaxVelocityAppl`.

---

**The velocity limitation can be used to prevent short-term velocity peeks. The limited position will be caught up later, whenever possible. This can result in not-expected behavior. The WARNING issued by CMC_Basic_Kernel can be checked and used to stop a movement. The movement will be aborted automatically when the position is by MaxPositionGap behind.**

- For a single axis movement, the commanded velocity is limited at the beginning. No position gap will occur.
- In a multi-axis movement, the slave axis follows a master. This can result in a position gap. A velocity peek from the master axis can be reduced by using the limitation. If the master is too fast because of the value for MaxPositionGap, the movement will be aborted.

---

When `EnableLimit2Decelerate` or `EnableLimitAbort` are used, the velocity is limited to `MaxVelocitySystem` with `EnableLimitVelocity = FALSE`. The function modifies the position reference. This modified position reference is used to control the drive. Whenever the limitation interferes the kernel will show a warning or an error. The warning or error message will disappear when the situation is cleared.

---

<table>
<thead>
<tr>
<th>Parameter Number</th>
<th>Parameter Name</th>
<th>Value</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>EnableLimitPos</td>
<td>TRUE</td>
<td>ERRORSTOP when positions exceed, no previous warning or deceleration.</td>
</tr>
<tr>
<td>5</td>
<td>EnableLimitNeg</td>
<td>TRUE</td>
<td></td>
</tr>
<tr>
<td>2003</td>
<td>EnableLimit2Decelerate</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>2004</td>
<td>EnableLimitAbort</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>2005</td>
<td>EnableLimitVelocity</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>Parameter Number</td>
<td>Parameter Name</td>
<td>Value</td>
<td>Comments</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------</td>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>4</td>
<td>EnableLimitPos</td>
<td>FALSE/TRUE</td>
<td>Reduce the velocity when reaching a position limit within the deceleration distance calculated by using MaxDecelerationAppl. Display a warning at CMC_Basic_Kernel. The underlying movement stays active. With EnableLimitPos = TRUE or EnableLimitNeg = TRUE: When the Position limit is reached, the axis is set to mode ERRORSTOP also if EnableLimitPos or EnableLimitNeg are used. Otherwise, just the movement is limited, without affecting the state machine. An activated positioning movement will not reach its target. Velocity is limited to MaxVelocitySystem.</td>
</tr>
<tr>
<td>5</td>
<td>EnableLimitNeg</td>
<td>FALSE/TRUE</td>
<td></td>
</tr>
<tr>
<td>2003</td>
<td>EnableLimit2Decelerate</td>
<td>TRUE</td>
<td>The active PLCopen function block is aborted as soon as the warning is issued. With EnableLimitPos = TRUE or EnableLimitNeg = TRUE: When the Position limit is reached, the axis is set to mode ERRORSTOP.</td>
</tr>
<tr>
<td>2004</td>
<td>EnableLimitAbort</td>
<td>TRUE</td>
<td></td>
</tr>
<tr>
<td>2005</td>
<td>EnableLimitVelocity</td>
<td>FALSE</td>
<td></td>
</tr>
</tbody>
</table>

The active PLCopen function block is aborted as soon as the warning is issued. With EnableLimitPos = TRUE or EnableLimitNeg = TRUE: When the Position limit is reached, the axis is set to mode ERRORSTOP.
### Programming guidelines

To achieve the best results for motion control the actual position has to be transferred in best possible quality (with minimal jitter) to the PLC. The position feedback is expected to be in increments as the data type is a DINT.

The kernel function block (CMC_Basic_Kernel or OBIO_PTMotionKernel or OBIO_PWMMotionKernel) has to be called every cycle and its task requires a fixed cycle time.

A variable of type Axis_Ref is used to connect to the PLCopen function blocks and their kernel function block.

The function block CMC_Axis_Control_Parameter has to be used for the axis configuration.

The signal of the limits switches and the absolute switch should be connected to the elements of the data type CMC_Axis_IO. The signal of the absolute switch must be TRUE in case the axis hits the sensor. The signal of a corresponding limit switch has to be true when the axis leaves the area surrounded by the limit switches. If needed the signal has to be inverted before it is connected to the elements of the data type.

### Task configuration

The kernel function block and the transfer of axis IO data should be processed in a cyclic task. This task should be as short and real-time as possible to achieve the best motion control performance. Always make sure Kernel function block is called at the highest priority task and other applications must be at a lower priority task.

In order to save PLC processing time the most PLCopen function blocks as well as the application logic can also be processed in a task which runs on a lower priority than the real-time task with the axis implementation as shown in the figure below.

![Task configuration diagram](image)

Optional:

**Unsynchronized Task Execution**

**Synchronized Task Execution**

All PLCopen function blocks which must be called in the same task than the kernel function block:

- MC_CombineAxes
- MCA_MoveByExternalReference

In case the position reference is transferred to the drive the task of the axis implementation should be synchronized to the fieldbus cycle. The following figures show an example for EtherCAT:
The structure of the position control loop is also as visualization element CMC_Visu_FB_Basic_Kernel included in ABB_MotionControl_AC500.library. As placeholder, an instance of CMC_Basic_Kernel has to be used. The visualization shows all numbers as they are really used inside the block, the adjustment for different resolution or cycle times is already included.
Kernel function block

Kernel Arithmetic

The “KERNEL” function blocks are available in two variants.

The OBIO_PTOMotionKernel / OBIO_PWMMotionKernel function blocks are solely to be used in eCo V3 CPUs and to make use of the integrated stepper-IO. It connects automatically to the internal IOs. Use the PTO or PWM specific kernel block based on your configuration Ch. 5.2.1.1.2.1 “Functionality” on page 196.

The CMC_Basic_Kernel block is designed to be used in any V3 PLCs and can either work with drives connected to a fieldbus or IOs.

<table>
<thead>
<tr>
<th>Topic</th>
<th>OBIO_PTOMotion-Kernel/ OBIO_PWMMotion-Kernel</th>
<th>CMC_Basic_Kernel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recommended PLC</td>
<td>eCo V3 PLC</td>
<td>All V3 PLC’s</td>
</tr>
</tbody>
</table>
How does the parameter for jerk influence the axis movements

Fig. 344: Velocity reference with different jerk values

The diagram shows the result with different jerk values and the same velocity and acceleration. The time needed for acceleration with jerk=0 is:

\[ T_{\text{Time1}} = \frac{\text{velocity}}{\text{acceleration}} = \frac{20}{100} \text{s} = 0.2 \text{s} \]

The additional time with jerk=500 will be:

\[ T_{\text{Time2}} = \frac{\text{acceleration}}{\text{jerk}} = \frac{500}{100} \text{s} = 5 \text{s} \]

So the total time is:

\[ T = T_{\text{Time1}} + T_{\text{Time2}} = 0.2 \text{s} + 5 \text{s} = 5.2 \text{s} \]

In the last example with jerk=100, the velocity and acceleration values are not reached.

Axis parameters

General

The parameters for axis configuration and adjustment are set by the function blocks CMC_Axis_Control_Parameter.

Depending on the version of the kernel function block the corresponding version of the parameters function block has to be used. The instance will then be connected to the kernel function block by its instance name.
In the example the control structure is a simple position control loop with just proportional gain. When the application does not require minimized position following error it should be used this way as it is simple to adjust, robust and requires minimal performance. The proportional gain is then adjusted by Control_Time. Just change values at CMC_Axis_Control_Parameter when the position control loop is open (Drive_Release=FALSE, the axis state is Disabled). The values are sending to the control loop with a positive edge at "Enable". The CMC_Basic_Kernel function block needs to be already enabled.

**Supervision**

**Pos_Lag_Percentage**  
This parameter configures the position window for the supervision of the following error. The default value is 150[\%]. A value of 0[\%] will deactivate the supervision function. The size of the position window depends on the setting of the parameters Control_Time and Max_Rpm.  

\[
\text{Position Window [Increments]} = (\text{Inc Per R}) \times \left( \frac{\text{Max Rpm}}{60} \right) \times \left( \frac{\text{Control Time}}{1000} \right)
\]

\[
\text{Position Window [Units]} = \left( \frac{\text{U Per Rev Nominator}}{\text{U Per Rev Denominator}} \right) \times \left( \frac{\text{Max Rpm}}{60} \right) \times \left( \frac{\text{Control Time}}{1000} \right)
\]

**Example**  
Position Window [Increments] = (10000) \times (6000/60) \times (50/1000) = 50000 [Increments]  
Position Window [Units] = (1/1) \times (6000/60) \times (50/1000) = 5 [Units]

A value of 100\% will result in a position window which corresponds to the expected following error with the giving Control_Time at Max_Rpm. Therefore it is recommended to use values higher than 100[\%]. In case the parameter FF_Percentage is used smaller values can be used. If the supervised position window is exceeded the axis state will change to ERRORSTOP.

**V_Check_Time**  
After the configured time the drive’s actual velocity has to be at least 50 \% of the commanded velocity. This function can also be used in case the Position Reference is transferred to the drive.  
A value of 0 will deactivate this supervision function. If the supervised velocity window is exceeded the axis state will change to ERRORSTOP.
Position control loop

Fig. 345: Basic structure of position control loop

Control_Time

The default value is 100 which leads to a proportional gain of 10.

- In case the value of Control Time is too short the position control loop will run into instability.

- In case the position control loop is not used this parameter must not be set to 0.

Fig. 346: Control Time and static following error in case the feed forward of velocity and the integrational part of the position control loop is not used.

The static following error depends on the axis velocity and can be calculated easily: Control Time multiplied by the axis velocity (p_error = v * CT).

In general it should be aimed to reach a high position control loop gain with a short Control Time to achieve a small following error. As the reaction times take account in the possible Control Time of the complete system (parameters of the drive control loop, PLC cycle time as well as the communication fieldbus) should be considered.

As a basic rule the Control Time should be at least four times longer than the reaction time between the output of the Speed Reference and the input of actual position.
When the time \( T_s \) and \( T_t \) is measured, a control_time of \( 4 \times (T_s + T_t) \) will result in an aperiodic damping of the position control loop. It is important to measure the values from inside the PLC (e.g. Trace) to have the complete reaction times included. Practical values for Control_Time might be from 50 - 500ms. The PLC cycle time as well as bus cycle times and mechanical reaction will influence the value.

**FF_Percentage**

The default value is 0.

In case a velocity feedforward has to be configured a value of up to 80 is recommended. For larger values than 80 the parameter Horizon needs to be used as the resulted position will overshoot otherwise.

A value of 100 adds a velocity to the Speed Reference output which corresponds exactly to the ongoing Position Reference value.

**Integral_Part**

The integral part of the position control loop can be used to eliminate a permanent positioning error, e.g. in case of hanging loads.

The time value can be regarded as the time the integrator needs to sum up the input value to reach the same value for its output.

*In case the Integral Part Time is too short the position control loop will run into instability.*

**Horizon**

A communication delay of the Speed Reference value to the drive system can cause an overshoot during positioning caused by the velocity feedforward gain.

This function will compensate this communication delay to prevent an overshoot by time shifting the signals Velocity Feed Forward and Position Reference relatively to each other.

The value of Horizon can be approximately assumed to be the time delay of the communication delay.

The delay time might be caused by the cycle time of the control loop and by any delay in sending the speed reference, delay in the drive to build up the torque and delay to receive the actual position. To overcome this delay, a \( \text{Horizon} > 0 \) might be used. The feed forward reference will be created in advance, while the proportional gain is applied to the original motion profile. The delay is then compensated.

This function should not be used if the feed forward parameter FF_Percentage is 0.

A value of 0 will deactivate this function, which is the default value.

While this function is used, it will increase the needed PLC calculation time for this axis.
PLC cycle time

Cycle

This parameter represents the cycle time in which the kernel function block of the axis is called. If the configured cycle time is not correct the resulting acceleration and speed of an axis will be not correct also.

In case the task execution of the axis is synchronized to a fieldbus (e.g. EtherCAT) the cycle time of the fieldbus has to be used.
Roll-Over axis

If the Position Reference value is used, the drive must be able to perform a position over-run after 32 bit. If the drive’s position over-run is different, it can be adapted with the function blocks CMC_Binary2Modulo and CMC_Modulo2Binary from the library ABB_MotionControl_AC500.library. Incompatibility can cause an axis to trip after hours of operation.

The possible position following error has to be smaller than ½ Modulo_Range. Make sure that the modulo range is large enough.

\[
\text{Position following error} = (100 - \text{FF_Percentage}) \times \text{Max Rpm} \times \text{Inc_Per_R} \times \text{Control_Time} / 6000000.
\]

This is the maximum value at constant velocity.

En_Modulo

With this parameter the axis can be configured as a roll-over axis.

Modulo_Range

The modulo range will be defined in drive position counts (DINT). It will result that the scaled unit position which is used by the PLCopen function blocks will stay within the defined range.

Example

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>En_Modulo</td>
<td>TRUE</td>
</tr>
<tr>
<td>Modulo_Range</td>
<td>20000</td>
</tr>
<tr>
<td>Inc_Per_Rev</td>
<td>10000</td>
</tr>
<tr>
<td>U_Per_Rev_Nominator</td>
<td>360 (e.g. degree)</td>
</tr>
<tr>
<td>U_Per_Rev_Denominator</td>
<td>1</td>
</tr>
</tbody>
</table>

The scaled unit’s position will cover the range from 0 to 720 (degrees).

In some cases it is not suitable to set the modulo range of an application with the DINT value of the parameter Modulo_Range only. In such cases the parameters 2001 Modulo_Nominator and 2002 Modulo_Denominator can be used to scale the parameter Modulo_Range to a more precise value.

Parameter Modulo_Nominator and Modulo_Denominator (supported with CMC_Basic_Kernel)

These parameters can be used to modify the Modulo_Range in a way that fractions of an increment could be used for 1 modulo (=rollover) distance

- Default: Modulo_Nominator=1 and Modulo_Denominator=1: the actual position for an axis is limited between 0 and Modulo_Range increments.
- Limitations: Modulo_Range*Modulo_Nominator < 2147483647. Otherwise: default values will be used.
- When modifying these parameters, the position control loop should be opened.
En_Modulo = TRUE
Modulo_Range = 1024
Modulo_Nominator = 10
Modulo_Denominator = 3
Inc_Per_R = 1024
U_Per_Rev_Nominator = 80*5*3
U_Per_Rev_Denominator = 10

5mm each tooth
80 teeth
Gearbox
Motor / Encoder

3:10 ratio
1024 counts per revolution

Result of parameters Modulo_Range, Modulo_Nominator and Modulo_Denominator: The modulo range will cover one revolution of the toothed-belt wheel.

Result of parameters U_Per_Rev_Nominator and U_Per_Rev_Denominator: One scaled unit corresponds to one mm of the tooth belt.

Example:

<table>
<thead>
<tr>
<th></th>
<th>Option1</th>
<th>Option2</th>
</tr>
</thead>
<tbody>
<tr>
<td>En_Modulo</td>
<td>TRUE</td>
<td>TRUE</td>
</tr>
<tr>
<td>Modulo_Range</td>
<td>10240</td>
<td>10240</td>
</tr>
<tr>
<td>Modulo_Nominator</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Modulo_Denominator</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Inc_Per_R</td>
<td>1024</td>
<td>10240</td>
</tr>
<tr>
<td>U_Per_Rev_Nominator</td>
<td>36</td>
<td>360</td>
</tr>
<tr>
<td>U_Per_Rev_Denominator</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Max_Rpm</td>
<td>3000</td>
<td>300</td>
</tr>
</tbody>
</table>

The two options above describe exactly the same configuration. The Modulo_Range is equivalent to 10 motor revolutions and is 10240 increments. For the position, 1u means 1° and the resolution is 360°/10240inc = 0,035°/Inc = 1°/28,44 Inc.
### Example: Gearbox 10.3

<table>
<thead>
<tr>
<th></th>
<th>Option1</th>
<th>Option2</th>
</tr>
</thead>
<tbody>
<tr>
<td>En_Modulo</td>
<td>TRUE</td>
<td>TRUE</td>
</tr>
<tr>
<td>Modulo_Range</td>
<td>1024</td>
<td>10240</td>
</tr>
<tr>
<td>Modulo_Nominator</td>
<td>10</td>
<td>1</td>
</tr>
<tr>
<td>Modulo_Denominator</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Inc_Per_R</td>
<td>1024</td>
<td>10240</td>
</tr>
<tr>
<td>U_Per_Rev_Nominator</td>
<td>108</td>
<td>1080</td>
</tr>
<tr>
<td>U_Per_Rev_Denominator</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Max_Rpm</td>
<td>3000</td>
<td>300</td>
</tr>
</tbody>
</table>

The two options above describe exactly the same configuration. The gearbox is 10:3, so the Modulo_Range is equivalent to \(1024 \times 10/3 = 3413 + 1/3\) increments. For the first option, the resulting modulo range is calculated \(1024 \times 10/3\), for option2, it is \(10240 \times 1/3\). For the position, 1u means 1° and the resolution is \(108°/1024\text{inc} = 0.105°/\text{inc} = 1°/9.481\text{ inc}\).

### Scaling of the unit of length

**Inc_Per_R**

With this parameter the number of the drive position counts each revolution of the motor (DINT) have to be entered.

**U_Per_Rev_Denominator & U_Per_Rev_Nominator**

With these two parameters the number of units which correspond to one revolution of the motor have to be entered.

The units of length can be scaled to values like: mm, inch, degree, …

All dynamic parameters of the PLCopen function blocks like velocity, acceleration and jerk are based on seconds. Velocity [units/s], acceleration [units/s²], jerk [units/s³]

**Example 1**

\[
\begin{align*}
\text{Inc}_\text{Per}_\text{Rev} &= 10000 \\
\text{U}_\text{Per}_\text{Rev}\text{ Nominator} &= 360 \\
\text{U}_\text{Per}_\text{Rev}\text{ Denominator} &= 1
\end{align*}
\]

This will scale one unit to one degrees of the motor shaft. Correspondingly a velocity [units/s] of 360 will turn the motor shaft one revolution per second.

**Example 2**

In the example one unit will be scaled to one millimeter of the conveyor.

**Fig. 349: Scaling units**

How many units will pass after one revolution of the motor? \((80\times5\text{mm}) / 5 = 80\)

\[
\begin{align*}
\text{Inc}_\text{Per}_\text{Rev} &= 1024 \\
\text{U}_\text{Per}_\text{Rev}\text{ Nominator} &= 80 \\
\text{U}_\text{Per}_\text{Rev}\text{ Denominator} &= 1
\end{align*}
\]
Example 3

In the example one unit will be scaled to one millimeter of the conveyor.

Fig. 350: Scaling units

How many units will pass after one revolution of the motor? $(80 \times 5 \text{mm}) / 32 = 12.5 = 125 / 10$

$$\begin{align*}
\text{Inc}_\text{Per}_\text{Rev} &= 1024 \\
\text{U}_\text{Per}_\text{Rev}\text{ Nominator} &= 125 \\
\text{U}_\text{Per}_\text{Rev}\text{ Denominator} &= 10
\end{align*}$$

Scaling of the speed reference output

These two parameters are used to scale Speed Reference output of the kernel FB in order to reach the intended velocity by the output value and to limit the highest possible output value.

Ref\_Max

Highest possible output value of the Speed Reference output. The Speed Reference value that corresponds to the parameter Max\_Rpm should be used.

Max\_Rpm

Maximum speed of the motor in revolutions per minute.

Example

- Analog Drive: 1000 rpm at 2 Volts, 3200 rpm at 6.4 Volts (max.)
- Analog output module: 10 Volts output at digital value 27648
- Ref\_Max = 17695 (= 27648 / 10 * 6.4)
- Max\_Rpm = 3200

Access and modify parameters

All modifications will be effective immediately. There is no extra plausibility check and values are not checked for limitations.

Use this functionality with care.

Some parameters are collected inside a structure in Axis\_Ref, and can be accessed and modified immediately. They are the same parameters as used with function blocks MC\_WriteParameter and MC\_ReadParameter © Chapter 6.5.10.3.4.8 “PLCopen parameter” on page 3977.

The differences are:

- Only available with CMC\_Basic\_Kernel
- The parameter values are LREAL instead of DINT and can be used with decimals.
- The parameters will be effective immediately.
- There is no check for consistency or limits.
- The parameters for position control can be checked and modified by accessing the structure Axis\_Parameter.CMC\_Pos\_Control in addition.
### Parameter for position control

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>KP</td>
<td>Proportional gain in positive direction. Used directly to multiply the following error and create the Reference_Prop.</td>
</tr>
<tr>
<td>KF</td>
<td>Feed forward in positive direction. Used directly to multiply the speed reference and create the Reference_FF.</td>
</tr>
<tr>
<td>KP_BACK</td>
<td>Proportional gain in negative direction. Used directly to multiply the following error and create the Reference_Prop.</td>
</tr>
<tr>
<td>KF_BACK</td>
<td>Feed forward in negative direction. Used directly to multiply the speed reference and create the Reference_FF.</td>
</tr>
<tr>
<td>TI</td>
<td>Integration time. When parameter is used the position control loop has an additional integral part. In TI cycle, the Reference_ITG will reach the value of Reference_Prop, when KI=100*KP.</td>
</tr>
<tr>
<td>KI</td>
<td>Proportional gain, used for integral part of position control loop.</td>
</tr>
<tr>
<td>KF_100</td>
<td>Value for feed forward gain, if 100% would be used.</td>
</tr>
<tr>
<td>Max_Time</td>
<td>Delay time used for supervision of velocity. With Max_Time=0, no supervision is executed.</td>
</tr>
<tr>
<td>D_XS_Max</td>
<td>Maximum possible velocity in [u/cycle]. The maximum allowed following error is part of the parameter structure, PLCopen parameter paraMaxPositionLag.</td>
</tr>
<tr>
<td>Ref_Max</td>
<td>Limit for Speed_Reference.</td>
</tr>
</tbody>
</table>

#### Element actual of Axis_Ref

The element **actual** represents actual values from inside the position control loop.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>Actual position in [u] to control the axis.</td>
</tr>
<tr>
<td>Control_Position</td>
<td>Reference position in [u] which is actually used for control loop.</td>
</tr>
<tr>
<td>D_XS</td>
<td>Distance in [u] to be moved per cycle.</td>
</tr>
<tr>
<td>D_XSS</td>
<td>Following error in [u].</td>
</tr>
<tr>
<td>Reference_Prop</td>
<td>Proportional part for Speed_Reference.</td>
</tr>
<tr>
<td>Reference_FF</td>
<td>Feed forward part for Speed_Reference.</td>
</tr>
<tr>
<td>Reference_ITG</td>
<td>Integral part for Speed_Reference.</td>
</tr>
</tbody>
</table>

#### Possible to use different gain for forward/ backward movement, possible improvement for hydraulic axis or vertical movement

See parameter KP/KP_BACK and KF/KF_BACK.

#### Limitation for velocity and acceleration and deceleration

From library version 3.1 on, these values are not limited to the 16-bit range of values (32767). The limit for velocity is calculated by the values given at CMC_Axis_Control_Parameter and the acceleration is limited such that this velocity can not be reached faster than 1 cycle.
ABB specific data structures

General

Not all data structures are defined by PLCopen. Some specific structures are described in the following chapter. In addition to the data in these arrays, the movement is modified by offset and scaling values at the respective function block. These offset and scaling values (except the time-scale) are transferred continuously. This will allow to follow a "Moving Target" by adjusting these values.

PositionPositionProfile

The data type MC_PProfile is used for CamTable. An array has to be defined and provided at MC_CamTableSelect. Several CamTables could be defined and the axis could change between them on the fly. There is no routine of smooth movement from one table to the next so the user has to take care just to switch on appropriate positions. Details are described in the documentation included with the library.

Declaration example

CAM_table

ARRAY[1..3] OF MC_PProfile:=
(Master_position:= 0,interpolation_point :=
0 ,Velocity_ratio:= 0 ,Acceleration_ratio:= 0 ),
(Master_position:= 50 ,interpolation_point :=
25 ,Velocity_ratio:= 0 ,Acceleration_ratio:= 0 ),
(Master_position:= 100 ,interpolation_point :=
0 ,Velocity_ratio:= 0 ,Acceleration_ratio:= 0 );

PositionTimeProfile

This structure is used for time based profiles, e.g. MC_PositionProfile:

Interpolation types for profiles

The curves defined by an array of MC_PProfile hold master position points and according slave positions. When the master position is between 2 points, the according position for the slave is interpolated. Different types of interpolation are possible. The type is defined in MC_ABB_iTypes_Enum. The master could be a real axis or some virtual axis which could be created by just writing values for position and velocity to the Axis_Master variable as shown in the example. The same interpolation types could be used on MC_TProfile.
Table 766: Overview of different interpolations

<table>
<thead>
<tr>
<th>Interpolation Types</th>
<th>Results in</th>
<th>Requires</th>
</tr>
</thead>
<tbody>
<tr>
<td>MCA_LINEAR</td>
<td>Linear interpolation with constant velocity between interpolation points.</td>
<td>profile.MC_PProfile_Array[x].master_position, profile.MC_PProfile_Array[x].interpolation_point</td>
</tr>
<tr>
<td>MCA_SPLINE_NATURAL</td>
<td>Cubic spline interpolation without jerk.</td>
<td>profile.MC_PProfile_Array[x].master_position, profile.MC_PProfile_Array[x].interpolation_point</td>
</tr>
<tr>
<td>MCA_SPLINE_COMPLETE</td>
<td>Cubic spline interpolation without jerk, start and end of profile with velocity=0.</td>
<td>profile.MC_PProfile_Array[x].master_position, profile.MC_PProfile_Array[x].interpolation_point</td>
</tr>
<tr>
<td>MCA_POLY3</td>
<td>Polynomial interpolation with linear velocity between interpolation points.</td>
<td>profile.MC_PProfile_Array[x].master_position, profile.MC_PProfile_Array[x].interpolation_point, profile.MC_PProfile_Array[x].velocity_ratio</td>
</tr>
<tr>
<td>MCA_POLY5</td>
<td>Polynomial interpolation with linear acceleration between interpolation points.</td>
<td>profile.MC_PProfile_Array[x].master_position, profile.MC_PProfile_Array[x].interpolation_point, profile.MC_PProfile_Array[x].velocity_ratio, profile.MC_PProfile_Array[x].acceleration_ratio</td>
</tr>
</tbody>
</table>

The interpolations allow to run on smooth curves without the need to define a large number of points. The following chapter shows the results with different interpolation modes for a sinus-curve with 10 interpolation points. The following table gives the mean deviation.

<table>
<thead>
<tr>
<th>Interpolation Type</th>
<th>Mean deviation [ppm]</th>
</tr>
</thead>
<tbody>
<tr>
<td>MCA_LINEAR</td>
<td>19686 =1.9%</td>
</tr>
<tr>
<td>MCA_SPLINE_NATURAL</td>
<td>151=0.0151%</td>
</tr>
<tr>
<td>MCA_SPLINE_COMPLETE</td>
<td>25510=2.5%</td>
</tr>
<tr>
<td>MCA_POLY3</td>
<td>131=0.0131%</td>
</tr>
<tr>
<td>MCA_POLY5</td>
<td>0.37</td>
</tr>
</tbody>
</table>

The original curve is represented by y_sinus for position and v_sinus for velocity. The diagrams show the result which is achieved by different interpolation types.

MCA_LINEAR
**Fig. 351: Results from linear interpolation**

The velocity is constant between the interpolation points.

MCA_POLY3

**Fig. 352: Results from polynomial interpolation**

The result looks almost identical to the original curve. The mean deviation shows that MCA_POLY3, MCA_POLY5 and MCA_SPLINE_NATURAL produce results which follow the original curve really good and are almost identical. The spline interpolation produces a jerk-free curve without the need of providing velocity values and acceleration values in advance.
In the beginning and the end, the curve does not follow the original curve. The reason is that it starts with velocity=0 and produces a jerk free result.

So the favoured result has to be considered in advance to choose the right interpolation method. With these different methods it is not necessary to provide a large number of interpolation points to get good results and smooth acceleration and deceleration ramps.

**PLC-based motion control — Load control / fluid power extensions**

The ABB_MotionControlLoad_AC500 library is an extension to ABB_MotionControl_AC500 library based on PLCopen part 6 called “fluid power” and basically can be used to implement load control as a simple form of torque profiling. It can be used together with all other motion control package libraries. The same structure and general rules are applied and all the above chapters in this document is relevant for ABB_MotionControlLoad_AC500 library as well. It is recommended to read through all the above chapters before start using the function blocks from this library. A difference is that the position control loop has to be closed inside the PLC as it is to be synchronized with the load control loop which is also realized. The implementation of Load function blocks is based on the PLCopen part 6 — Fluid power.

Overview of the defined extended function blocks:

<table>
<thead>
<tr>
<th>Administrative</th>
<th>Motion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single axis</td>
<td>Multiple axis</td>
</tr>
<tr>
<td>MC_LimitLoad</td>
<td>-</td>
</tr>
<tr>
<td>MC_LimitMotion</td>
<td>-</td>
</tr>
<tr>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>-</td>
<td>MC_LoadProfile</td>
</tr>
<tr>
<td>-</td>
<td>MC_LoadSuperImposed</td>
</tr>
<tr>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>-</td>
<td>MC_TorqueControl</td>
</tr>
</tbody>
</table>
As per PLCopen MC_TorqueControl is a part 1 function block, however due to its implementation as a wrapper for the load control and limit load blocks this is added to ABB_MotionControlLoad_AC500 library.

The following state diagram is based on the version as defined in ‘Part 1 – Function Blocks for Motion Control’, Version 2.0.

This specification adds three load function blocks to the state diagram:
- MC_LoadControl
- MC_LoadSuperImposed
- MC_LoadProfile

MC_TorqueControl function block also follows the same state diagram.

Function blocks not listed in the state diagram do not affect the state diagram, meaning that whenever they are called the state does not change.

The state diagram shows synchronized motion because the position-axis follows the load, and the state is related to the position axis.

Note 1: From any state. An error in the axis occurred.
Note 2: From any state. MC_Power.Enable = FALSE and there is no error in the axis
Note 3: MC_Reset and MC_Power.Status = FALSE
Note 5: MC_Power.Enable = TRUE and MC_Power.Status = TRUE
Note 6: MC_Stop.Done = TRUE and MC_Stop.Execute = FALSE

Kernel function block - Fluid power

The basic block is the CMC_Load_Motion_Kernel. It has to be called every cycle and at least once before any MC... block is activated. It is used to combine the position and velocity functionality from CMC_Basic_Kernel with the load control functionality which is utilized by the MC_Load... blocks.
The reference which is used by the CMC_Load_Motion_Kernel is equivalent with the Speed_Reference at CMC_Basic_Kernel, as long as no LOAD-functionality is activated. The documentation from CMC_Basic_Kernel applies to the identical inputs and outputs. Some inputs and outputs are added to serve the load control functionality.

The Load_Ref is used instead of Axis_Ref for the MC_Loadxxx blocks. When the CMC_Load_Motion_Kernel is used, Load_Ref replaces Axis_Ref and user can use all PLCopen-Blocks.

The actuator (drive) has to be accessed outside the CMC_Load_Motion_Kernel block. Actual values and reference values might be transferred by a synchronised bus or by I/Os.

- All inputs and outputs of the function block which are named “DRIVE_xxxxx” should be used to connect to the actuator (drive). It does not matter whether this connection is done by fieldbus or by conventional IOs.
- The Axis-structure is used to connect to the PLCopen blocks
- The Load_Axis structure is used to connect the fluid-power PLCopen blocks.
● The control_parameter-structure is used for configuration of control loop.
● The IO-structure gives a connection to limit- or reference switches.

When the function block will take control (close loop) the output “Drive_Release” is set. The PLC-Program should then start the actuator (actuator (drive)) and set “Drive_InOperation = TRUE” when successful. In case of actuator (actuator (drive)) problem, “Drive_InOperation” should be reset. The function block will then open the position control loop and Speed_Reference will be 0.

The homing is done with PLCopen-blocks. As the interface to the actual position is outside the CompactMotion, the bit “Drive_Set_Ref” is set when the state is reached to evaluate the zero-track. When the zero-track was found, Drive_ActualPosition has to be set to “Drive_Set_Position”, this has to be indicated by “Drive_Ref_Ok”.

The output “Drive Reference” should be send to the actuator (drive). This value is scaled with Max_Rpm and Max_Reference which means: when “Drive_Reference” equals Max_Reference, the motor is expected to run with Max_Rpm.

Load control

The function block holds a position control loop and a load control loop. The load control loop is a PIDT1-Block. Both control loops are alternately activated, depending if a MC_Load..block or a MC_Move... block is active. There is a bumbleless transition realized between the different control loops.

The PIDT1 controller has a proportional, integral and derivative part. The integral and derivative part can be switched of by using a time value = 0.

Transfer function

\[ F(s) = KP \cdot \left(1 + \frac{1}{s \cdot TN} + \frac{s \cdot TV}{1 + (s \cdot T1)} \right) \]

Control algorithm: Simple rectangle rule:

\[
\begin{align*}
Y &= KP \cdot XD + \frac{1}{s \cdot TN} + \frac{s \cdot TV}{1 + (s \cdot T1)} \cdot (VDT(z-1) + Y(z-1) + (XD - XD(z-1))) \\
&+ \frac{1}{s \cdot T1} \cdot TV \cdot (XD(z-1) - XD(z-1))
\end{align*}
\]

Where:

- Y(z-1): The integral portion from the previous program cycle
- XDT(z-1): The differential portion from the previous program cycle
- XD(z-1): Control system difference from the previous program cycle

All 3 parts of the control loop are added up. The integral or derivative part could be disabled by setting the respective time constant to 0, so the following structures are possible:

- P
- PDT1
- PI
- PIDT1

The Load_MaxRef and Load_MinRef values will limit the controllers output Y and also apply to the controller’s internal integral part. I.e the integral part can only hold values between the high and low limits. If the manipulated variable Y reaches one of the two limits, the controller’s integral part is no longer changed. This prevents the integral part from holding meaningless values and, in certain circumstances, not returning to the operating range for a long time. This behavior of a controller is also referred to as a “special anti-reset windup measure”.
Example - Fluid power extensions

**MC LimitLoad**

In the diagram below, an example is explained. SFC is used here to distinguish between a movement where the MC_LimitLoad functionality has become ‘Active’ or not. In Step 2 there is a movement like ‘MoveAbsolute’, which is limited by the MC_LimitLoad functionality. If the absolute position is reached without MC_LimitLoad becoming active, the transition via done to step 3 is applicable. However, if the MC_LimitLoad becomes ‘Active’, the transition to the ‘Halt’ step is applicable, issuing a MC_Halt.

![Fig. 354: MC_LimitLoad used in SFC](image)

**MC_LimitMotion e.g. force fitting**

The function block is intended to be used in conjunction with a MC_LoadControl or MC_TorqueControl having primary control on the axis. The MC_LimitMotion should be enabled by the ‘Active’ output of the MC_LoadControl / MC_TorqueControl. If motion values on the axis exceed the given limit, appropriate measures are taken to keep to these limits, implying that the load/torque will not follow the programmed trajectory but depend on the external load conditions. However, the ‘Active’ output of the MC_LoadControl/MC_TorqueControl will stay TRUE in this case, following the modified PLCopen definition "The ‘Active’ output indicates, that the FB has control on the set-value generation of the axis". This is despite the fact, that physically only the load-conditions or the movement of an axis can be controlled. With actual motion states below programmed limits, the programmed load/torque trajectory will proceed. Enabling the limiter block with activation of the MC_LoadControl/MC_TorqueControl ensures that limits are only supervised when the MC_LoadControl/MC_TorqueControl takes control on the axis for the first time. Disabling the limiter block with de-activation of the MC_LoadControl/MC_TorqueControl ensures that limits are no more supervised when the MC_LoadControl/MC_TorqueControl loses control on the axis by ‘CommandAborted’ or ‘Error’.
**Possible Application:** Actuator: hydraulic cylinder with fluid pressure sensor actuates the press of plastic injection molding machine in a continuous load operation.

**Request:** Prior to MC_LoadSuperImposed call, a MC_LoadControl block is ‘Active’ with a command of 7,500 kPa to press melted plastic into the mold. Once the MC_LoadControl ‘InLoad’ condition is achieved a superimposed pressure of 5,000 kPa is added several times to cause a hammering effect to relieve stresses in the plastic.

**Result:** the MC_LoadControl pressure command of 7,500 kPa is superimposed with a discrete pressure command of 5,000 kPa. Once the ‘LoadSuperImposed’ command is active the system pressure rises to 12,500 kPa.

When the superimposed pressure command has been achieved the MC_LoadSuperImposed block is done and the original command given by the MC_LoadControl resumes the original pressure command. The MC_LoadSuperImposed block is executed several times without affecting the original pressure command given by the MC_LoadControl block.
The example (below) opposite signs for ‘Direction’ & ‘Torque’ are used (e. g. Retention or brake control). (In the function block: +Direction – Torque). It is like an unwinding application with torque on the material, and a break in the material. When the material breaks, as shown in the middle of the figure this causes a drop in the real Torque value (in absolute terms): The velocity will decrease, limited by the fastest “deceleration” limit specified by the ‘Deceleration’ VAR_INPUT down to zero velocity (with no tension there is a risk of having shock breakings, so we have to limit to the fastest). In this case the torque setpoint might not be achieved.

In an unwinding application (derived from this brake control) material tension is the target, not motor torque. The instantaneous diameter of the roll should be taken into account to transform the “User tension setpoint”. Also, additional inertia compensation by modification of the torque setpoint for acceleration / deceleration is common from instantaneous weight data (weight is commonly estimated from diameter). Additionally, in unwinding applications, in the case of loose material (same condition as material break), a negative slow velocity reference is usually applied to “rewind” the loose material. In this case, this must be provided by external programming.

Appendix

List of all PLCopen and ABB specific function blocks in PS552-MC (for V2 PLC) and PS561-Motion (for V3)

<table>
<thead>
<tr>
<th>SNo</th>
<th>Funktions block type</th>
<th>Funktions block name</th>
<th>Motion Library V2 (PS552-MC)</th>
<th>Motion Library V3 (PS561-Motion)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PLCopen</td>
<td>MC_Power</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>2</td>
<td>PLCopen</td>
<td>MC_Home</td>
<td>x</td>
<td>-</td>
</tr>
<tr>
<td>3</td>
<td>PLCopen</td>
<td>MC_Stop</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>4</td>
<td>PLCopen</td>
<td>MC_Halt</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>5</td>
<td>PLCopen</td>
<td>MC_MoveAbsolute</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>6</td>
<td>PLCopen</td>
<td>MC_MoveRelative</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>7</td>
<td>PLCopen</td>
<td>MC_MoveAdditive</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>8</td>
<td>PLCopen</td>
<td>MC_MoveSuperImposed</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>SNo</td>
<td>Funktion block type</td>
<td>Funktion block name</td>
<td>Motion Library V2 (PS552-MC)</td>
<td>Motion Library V3 (PS5611-Motion)</td>
</tr>
<tr>
<td>-----</td>
<td>---------------------</td>
<td>----------------------------------</td>
<td>-----------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>9</td>
<td>PLCopen</td>
<td>MC_HaltSuperImposed</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>10</td>
<td>PLCopen</td>
<td>MC_MoveVelocity</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>11</td>
<td>PLCopen</td>
<td>MC_MoveContinuousAbsolute</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>12</td>
<td>PLCopen</td>
<td>MC_MoveContinuousRelative</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>13</td>
<td>PLCopen</td>
<td>MC_PositionProfile</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>14</td>
<td>PLCopen</td>
<td>MC_VelocityProfile</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>15</td>
<td>PLCopen</td>
<td>MC_AccelerationProfile</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>16</td>
<td>PLCopen</td>
<td>MC_SetPosition</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>17</td>
<td>PLCopen</td>
<td>MC_SetOverride</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>18</td>
<td>PLCopen</td>
<td>MC_ReadParameter</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>19</td>
<td>PLCopen</td>
<td>MC_ReadBoolParameter</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>20</td>
<td>PLCopen</td>
<td>MC_WriteBoolParameter</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>21</td>
<td>PLCopen</td>
<td>MC_WriteParameter</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>22</td>
<td>PLCopen</td>
<td>MC_ReadActualPosition</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>23</td>
<td>PLCopen</td>
<td>MC_ReadActualVelocity</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>24</td>
<td>PLCopen</td>
<td>MC_ReadStatus</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>25</td>
<td>PLCopen</td>
<td>MC_ReadAxisError</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>26</td>
<td>PLCopen</td>
<td>MC_Reset</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>27</td>
<td>PLCopen</td>
<td>MC_CamTableSelect</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>28</td>
<td>PLCopen</td>
<td>MC_CamIn</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>29</td>
<td>PLCopen</td>
<td>MC_CamOut</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>30</td>
<td>PLCopen</td>
<td>MC_GearIn</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>31</td>
<td>PLCopen</td>
<td>MC_GearOut</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>32</td>
<td>PLCopen</td>
<td>MC_GearInPos</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>33</td>
<td>PLCopen</td>
<td>MC_PhasingAbsolute</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>34</td>
<td>PLCopen</td>
<td>MC_PhasingRelative</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>35</td>
<td>PLCopen</td>
<td>MC_HaltPhasing</td>
<td>-</td>
<td>x</td>
</tr>
<tr>
<td>36</td>
<td>PLCopen</td>
<td>MC_LoadControl</td>
<td>-</td>
<td>x</td>
</tr>
<tr>
<td>37</td>
<td>PLCopen</td>
<td>MC_LimitLoad</td>
<td>-</td>
<td>x</td>
</tr>
<tr>
<td>38</td>
<td>PLCopen</td>
<td>MC_LimitMotion</td>
<td>-</td>
<td>x</td>
</tr>
<tr>
<td>39</td>
<td>PLCopen</td>
<td>MC_LoadSuperImposed</td>
<td>-</td>
<td>x</td>
</tr>
<tr>
<td>40</td>
<td>PLCopen</td>
<td>MC_LoadProfile</td>
<td>-</td>
<td>x</td>
</tr>
<tr>
<td>41</td>
<td>PLCopen</td>
<td>MC_TorqueControl</td>
<td>-</td>
<td>x</td>
</tr>
<tr>
<td>42</td>
<td>ABB</td>
<td>MCA_CamInDirect</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>43</td>
<td>ABB</td>
<td>MCA_CamInfo</td>
<td>-</td>
<td>x</td>
</tr>
<tr>
<td>44</td>
<td>ABB</td>
<td>MCA_Cam_EXTRA</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>45</td>
<td>ABB</td>
<td>MCA_DriveBasedHome</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>SNo</td>
<td>Funktion block type</td>
<td>Funktion block name</td>
<td>Motion Library V2 (PS552-MC)</td>
<td>Motion Library V3 (PS5611-Motion)</td>
</tr>
<tr>
<td>-----</td>
<td>---------------------</td>
<td>---------------------</td>
<td>-----------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>46</td>
<td>ABB</td>
<td>MCA_GearInDirect M</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>47</td>
<td>ABB</td>
<td>CA_Indexing</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>48</td>
<td>ABB</td>
<td>MCA_JogAxis</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>49</td>
<td>ABB</td>
<td>MCA_MoveByExternalReference</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>50</td>
<td>ABB</td>
<td>MCA_MoveVelocityContinuous</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>51</td>
<td>ABB</td>
<td>MCA_MoveRelativeOpti</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>52</td>
<td>ABB</td>
<td>MCA_Parameter</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>53</td>
<td>ABB</td>
<td>MCA_PhasingbyMaster</td>
<td>-</td>
<td>x</td>
</tr>
<tr>
<td>54</td>
<td>ABB</td>
<td>MCA_ReadParameterList</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>55</td>
<td>ABB</td>
<td>MCA_SetOperatingMode</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>56</td>
<td>ABB</td>
<td>MCA_SetPositionContinuous</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>57</td>
<td>ABB</td>
<td>MCA_WriteParameterList</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>58</td>
<td>ABB</td>
<td>MCA_CamGetInterpolationPosition</td>
<td>-</td>
<td>x</td>
</tr>
<tr>
<td>59</td>
<td>ABB</td>
<td>MCA_Home</td>
<td>x</td>
<td>-</td>
</tr>
<tr>
<td>60</td>
<td>ABB</td>
<td>MCA_Power</td>
<td>x</td>
<td>-</td>
</tr>
<tr>
<td>61</td>
<td>ABB</td>
<td>ECAT_402Parameter-Homing_APP</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>62</td>
<td>ABB</td>
<td>ECAT_HomingOnTouchProbe_APP</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>63</td>
<td>ABB</td>
<td>ECAT_CiA402_TouchProbe_App</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

PLCopen Part 4 –Coordinated Motion is only available for V2 PLC and not yet available for V3 PLC.

### 6.5.10.3.6 Examples

Prerequisite: Install the related library package with Automation Builder, Installation Manager - "Modify".

Use cases and how to handle the function blocks of a certain library is described in sample projects. After the respective library has been installed the corresponding sample projects are available in the default path AutomationBuilder Examples. If the default path is inaccessible, click "Help ➔ Project examples" in the Automation Builder menu.
### 6.5.11 MQTT client library

#### 6.5.11.1 Structures and enumerations

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MQTT_ERR_NO_ERROR</td>
<td>0</td>
<td>No error.</td>
</tr>
<tr>
<td>MQTT_ERR_CONN_SERVICE_UNAVAIL</td>
<td>16#3001</td>
<td>The Network Connection has been made but the MQTT service is unavailable on the specified port.</td>
</tr>
<tr>
<td>MQTT_ERR_COMMUNICATION_TIMEOUT</td>
<td>16#3013</td>
<td>The timeout value for the communication has been exceeded.</td>
</tr>
<tr>
<td>MQTT_ERR_REC_PACKET_TOO_LONG</td>
<td>16#3017</td>
<td>Received topic is too long.</td>
</tr>
<tr>
<td>MQTT_ERR_PING_NO_ANSWER</td>
<td>16#301A</td>
<td>The MQTT broker did not answer the ping. MQTT client has passed the KeepAlive or MQTT broker is unreachable.</td>
</tr>
<tr>
<td>MQTT_ERR_CONN_CLIENT_ID_NOT_ALLOWED</td>
<td>16#301F</td>
<td>The Client identifier is correct UTF-8 but not allowed by the Server.</td>
</tr>
<tr>
<td>MQTT_ERR_CONN_REFUSED_PROTOCOL</td>
<td>16#3020</td>
<td>The Server does not support the level of the MQTT protocol requested by the Client.</td>
</tr>
<tr>
<td>MQTT_ERR_CONN_REFUSED_CONNECTION</td>
<td>16#3025</td>
<td>Connection refused, maybe the IP address is malformed.</td>
</tr>
<tr>
<td>MQTT_ERR_UNSPECIFIED_ERROR</td>
<td>16#302B</td>
<td>Internal library returned an unspecified error.</td>
</tr>
<tr>
<td>MQTT_ERR_NETWORK_ERROR</td>
<td>16#302D</td>
<td>General network error.</td>
</tr>
<tr>
<td>MQTT_ERR_CONN_AUTH_FAILED</td>
<td>16#3217</td>
<td>Authentication failed: Bad username, password OR client id.</td>
</tr>
<tr>
<td>MQTT_ERR_CONN_TLS_HANDSHAKE_FAILED</td>
<td>16#3230</td>
<td>Error on TLS handshake.</td>
</tr>
<tr>
<td>MQTT_ERR_CONN_SERVER_CERT_NOT_VALID</td>
<td>16#3231</td>
<td>Server certificate not valid. Check if PLC date has been set correctly.</td>
</tr>
<tr>
<td>MQTT_ERR_CONN_SERVER_CERT_NOT_PEM</td>
<td>16#3232</td>
<td>Server certificate format is not formatted as PEM.</td>
</tr>
<tr>
<td>MQTT_ERR_CONN_SERVER_CERT_EXPIRED</td>
<td>16#3233</td>
<td>Server certificate has expired.</td>
</tr>
<tr>
<td>MQTT_ERR_CONN_CLIENT_CERT_NOT_VALID</td>
<td>16#3234</td>
<td>Client certificate not valid. Check if PLC date has been set correctly.</td>
</tr>
<tr>
<td>MQTT_ERR_CONN_CLIENT_CERT_NOT_PEM</td>
<td>16#3235</td>
<td>Client certificate or client key format is not formatted as PEM.</td>
</tr>
<tr>
<td>MQTT_ERR_CONN_CLIENT_CERT_EXPIRED</td>
<td>16#3236</td>
<td>Client certificate has expired.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>MQTT_ERR_INPUT_02_0</td>
<td>16#4020</td>
<td>Function block Input 02 error (error case 0), specific error depends on used function block:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● MqttConnectWithCertBuffer (FB): Parameter Conn of function block was not set.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● MqttConnectWithCertFile (FB): Parameter Conn of function block was not set.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● MqttGetReceivedPacket (FB): Parameter Conn of function block was not set.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● MqttPublish (FB): Parameter Conn of function block was not set.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● MqttSubscribe (FB): Parameter Conn of function block was not set.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● MqttUnsubscribe (FB): Parameter Conn of function block was not set.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● MqttPing (FB): Parameter Conn of function block was not set.</td>
</tr>
<tr>
<td>MQTT_ERR_INPUT_03_0</td>
<td>16#4030</td>
<td>Function block Input 03 error (error case 0), specific error depends on used function block:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● MqttGetReceivedPacket (FB): Pointer payload not initialized.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● MqttPublish (FB): Publish topic name must not contain wildcard characters (+ or #).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● MqttSubscribe (FB): Topic is missing.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● MqttUnsubscribe (FB): Topic is missing.</td>
</tr>
<tr>
<td>MQTT_ERR_INPUT_03_1</td>
<td>16#4031</td>
<td>Function block Input 03 error (error case 1), specific error depends on used function block:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● MqttPublish (FB): Payload is not set in MQTT_MESSAGE.</td>
</tr>
<tr>
<td>MQTT_ERR_INPUT_04_0</td>
<td>16#4040</td>
<td>Function block Input 04 error (error case 0), specific error depends on used function block:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● MqttConnectWithCertBuffer (FB): Check if Port number has been set correctly (0 is not accepted).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● MqttConnectWithCertFile (FB): Check if Port number has been set correctly (0 is not accepted).</td>
</tr>
<tr>
<td>MQTT_ERR_INPUT_06_0</td>
<td>16#4060</td>
<td>Function block Input 06 error (error case 0), specific error depends on used function block:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● MqttConnectWithCertFile (FB): Server certificate file was not found.</td>
</tr>
<tr>
<td>MQTT_ERR_INPUT_07_0</td>
<td>16#4070</td>
<td>Function block Input 07 error (error case 0), specific error depends on used function block:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● MqttConnectWithCertFile (FB): Client certificate file was not found.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>---------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| MQTT_ERR_INPUT_08_0 | 16#4080 | Function block Input 08 error (error case 0), specific error depends on used function block:  
- MqttConnectWithCertFile (FB): Client key file was not found. |
| MQTT_ERR_INPUT_12_0 | 16#4120 | Function block Input 12 error (error case 0), specific error depends on used function block:  
- MqttConnectWithCertFile (FB): Couldn't initialize Last Will message because the topic is not set.  
- MqttConnectWithCertBuffer (FB): Couldn't initialize Last Will message because the payload is not set. |
| MQTT_ERR_INPUT_12_1 | 16#4121 | Function block Input 12 error (error case 1), specific error depends on used function block:  
- MqttConnectWithCertBuffer (FB): Couldn't initialize Last Will message because the topic is not set.  
- MqttConnectWithCertFile (FB): Couldn't initialize Last Will message because the payload is not set. |
| MQTT_ERR_FATAL_ERR | 16#5FFFF | Fatal error state machine. |

### MQTT_QOS (Enum)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>QOS_0</td>
<td>-</td>
<td>Fire and forget (At most once delivered).</td>
</tr>
<tr>
<td>QOS_1</td>
<td>-</td>
<td>Simple acknowledgement (At least once delivered).</td>
</tr>
<tr>
<td>QOS_2</td>
<td>-</td>
<td>Complex acknowledgement (Exactly once delivered).</td>
</tr>
</tbody>
</table>

### MQTT_MESSA\-GE

This structure is used for messages which can be published or used for LastWill on MqttConnect(FB).

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Data type</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sTopic</td>
<td>STRING(MQTT_MAX_TOPIC_LEN)</td>
<td>Empty string</td>
<td>Topic where this message belongs to.</td>
</tr>
<tr>
<td>pbyPayload</td>
<td>POINTER TO BYTE</td>
<td>0</td>
<td>Payload which should be sent.</td>
</tr>
<tr>
<td>dwLen</td>
<td>DWORD</td>
<td>0</td>
<td>Length of the payload.</td>
</tr>
<tr>
<td>eQos</td>
<td>MQTT_QOS</td>
<td>QOS_0</td>
<td>Quality of Service level.</td>
</tr>
<tr>
<td>xRetainFlag</td>
<td>BOOL</td>
<td>FALSE</td>
<td>True = message must be stored by the server, False = server must not store this message.</td>
</tr>
</tbody>
</table>

### MQTT_CON\-NE\-CTION

Internal data required by the library to operate. This structure allocates memory and it is used to identify the MQTT connection you want to work with.
### 6.5.11 Global variables

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Data type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MQTT_MAX_IP_ADDRESS_LEN</td>
<td>Word</td>
<td>15</td>
<td>Maximum length of the IP address.</td>
</tr>
<tr>
<td>MQTT_MAX_PEM_KEY_LEN</td>
<td>Word</td>
<td>2048</td>
<td>Maximum length of the PEM key.</td>
</tr>
<tr>
<td>MQTT_MAX_PEM_CERT_LEN</td>
<td>Word</td>
<td>3072</td>
<td>Maximum length of the PEM certificate.</td>
</tr>
<tr>
<td>MQTT_MAX_FILE_PATH_LEN</td>
<td>Word</td>
<td>255</td>
<td>Maximum length of the file path to the certificate files.</td>
</tr>
<tr>
<td>MQTT_MAX_CLIENT_ID_LEN</td>
<td>Word</td>
<td>250</td>
<td>Maximum length of the client id.</td>
</tr>
<tr>
<td>MQTT_MAX_USERNAME_LEN</td>
<td>Word</td>
<td>250</td>
<td>Maximum length of the username.</td>
</tr>
<tr>
<td>MQTT_MAX_PASSWORD_LEN</td>
<td>Word</td>
<td>250</td>
<td>Maximum length of the password.</td>
</tr>
<tr>
<td>MQTT_MAX_TOPIC_LEN</td>
<td>Word</td>
<td>255</td>
<td>Maximum length of the topic.</td>
</tr>
<tr>
<td>MQTT_CLIENT_STRUCT_SIZE</td>
<td>Word</td>
<td>336</td>
<td>Size of the internal connection structure representing the connection state.</td>
</tr>
<tr>
<td>MQTT_TX_BUF_SIZE</td>
<td>Word</td>
<td>1024</td>
<td>Size of the internally used output buffer.</td>
</tr>
<tr>
<td>MQTT_RX_BUF_SIZE</td>
<td>Word</td>
<td>1024</td>
<td>Size of the internally used input buffer.</td>
</tr>
<tr>
<td>MQTT_MSG_BUF_SIZE</td>
<td>Word</td>
<td>2148</td>
<td>Size of the internally used message buffer.</td>
</tr>
</tbody>
</table>

### 6.5.12 PLCopen libraries

#### 6.5.12.1 Common function block state machine

**General**

Most of the V3 function blocks follow the behavior model and style as recommended by PLC Open.

- Clear separation between *"Edge triggered FBs"* ("Execute") or *"Level triggered FBs"* ("Enable")
- Binary status outputs: *"Done", "Busy", "Error"* (exclusive)
- Standardized state machine
- CamelCase naming for function block and all inputs and outputs
Example: Edge_Triggerd_Function_Block_EthOwnIP according to PLCopen

Currently the following “function block state machines” are used:

- “Edge Triggered” (Input “Execute”), for example EthOwnIP
- “Level Controlled” (Input “Enable”)
- “Level Controlled Continuous” (Input “Enable”, no “Done” output, for example PID)

In contrast to AC500 V2 POUs, either “Done” or “Error” is set, not both outputs at the same time in case of an error.

The state machines are explained in the following chapters.

6.5.12.1.2 Edge triggered (AbbETrig)

After a rising edge at the input “Execute” the state goes from “Dormant” to “Busy”. In the first cycle all inputs are sampled and stored.

When the task is completed successfully the state goes from “Busy” to “Done”.

In case of an error the state goes to “Error”.

The states “Done” or “Error” are stable for minimum one cycle and as long as “Execute” is “TRUE”. With a falling edge of “Execute”, the state goes via Reset to “Dormant”.
Description of standard inputs and outputs:

- **“Execute”**
  A rising edge starts the operation, the output “Busy” goes to “TRUE”. In the first cycle all other inputs are read and stored, afterwards they are ignored.
  A falling edge does not stop the operation.
  After “Done = TRUE” or “Error = TRUE” and “Execute = FALSE” all outputs will be reset.

- **“Busy”**
  Operation is running (while outputs “Done” and “Error” are “FALSE”)

- **“Done”**
  Operation is completed without error (while outputs “Busy” and “Error” are “FALSE”).
  This output is “TRUE” for at least one cycle or until “Execute” is set to “FALSE”

- **“Error”**
  Operation is stopped with error (while outputs “Busy” and “Done” are “FALSE”).
  This output is “TRUE” for at least one cycle or until “Execute” is set to “FALSE”.
  The output “ErrorID” gives more details about the error.

---

### 6.5.12.1.3 Level controlled (AbbLCon)

After a rising edge at the input “Enable” the state goes “Dormant” to “Busy”. All inputs are sampled and considered continuously.

When the task is completed successfully the state goes from “Busy” to “Done”.

In case of an error the state goes to “Error”.

The states “Done” or “Error” are stable for minimum one cycle and as long as “Enable is TRUE”. With a falling edge of “Enable”, the state goes via Reset to “Dormant”.

The Busy state can be aborted from outside by setting the “Enable” input to “FALSE”.

After Aborting is done the state goes back to “Dormant”.

Description of standard inputs and outputs:

- **“Enable”**
  A rising edge (“Enable = TRUE”) starts the operation, the output “Busy” goes to “TRUE”. All other inputs are read and considered continuously. A falling edge (“Enable = FALSE”) aborts the operation.
  During Aborting the Busy is still “TRUE”. Afterward all outputs are reset.

- **“Busy”**
  Operation is running (while outputs “Done” and “Error” are “FALSE”)

---
- “Done”
  Operation is completed without error (while outputs “Busy” and “Error” are “FALSE”).
  This output is “TRUE” for at least one cycle or until “Enable” is set to “FALSE”.
- “Error”
  Operation is stopped with error (while outputs “Busy” and “Done” are “FALSE”).
  This output is “TRUE” for at least one cycle or until “Enable” is set to “FALSE”.
  The output “ErrorID” gives more details about the error.

### 6.5.12.1.4 Level controlled continuous (AbbLConC)

This state machine is a special case of “Level Controlled”. Only difference is that this function block type is never done, for example a PID which never stops.

Therefore these function blocks have no “Done” output.

Description of standard inputs and outputs:
- “Enable”
  A rising edge (“Enable = TRUE”) starts the operation, the output “Busy” goes to “TRUE”. All other inputs are read and considered continuously.
  A falling edge (“Enable = FALSE”) aborts the operation.
  During Aborting the “Busy” is still “TRUE”. Afterward all outputs are reset.
- “Busy”
  Operation is running (while output “Error is FALSE”)
- “Error”
  Operation is stopped with error (while output “Busy is FALSE”).
  This output is “TRUE” for at least one cycle or until “Enable” is set to “FALSE”.
  The output “ErrorID” gives more details about the error.

### 6.5.12.1.5 Error_ID

Each library contains an enumeration “ERROR_ID”, which is valid for this library but not across all libraries.

Only the following errors are unique:
- 16#5FFF FATAL_ERROR from state machine
- 16#4000 errors are used for input errors, same scheme like in V2:
4000hex...4FFFhex - Block Input Error

The error 4xxxhex is used in case of detected Function Block input parameter errors. The error is structured as follows:

<table>
<thead>
<tr>
<th>4</th>
<th>X</th>
<th>X</th>
<th>X</th>
<th>HEX</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0</td>
<td>=</td>
<td>invalid value</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>=</td>
<td>Value too low</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>=</td>
<td>Value too high</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>=</td>
<td>Wrong combination of the parameters</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1...FF</td>
<td>=</td>
<td>Number of the input</td>
<td></td>
</tr>
</tbody>
</table>
6.5.12.6 Compatibility with V2 function blocks

In order to ensure compatibility with V2 applications a lot of ABB function blocks are delivered together with a compatible version in classic style:

Names in CAPITAL letters, input “EN” and outputs “DONE”, “ERR” and “ERNO”:

The classic blocks internally use the PLCopen style function blocks. The inputs and outputs are mapped in the following way:

6.5.13 Pumping library V3

6.5.13.1 Overview of the PS5608 pumping library

The PS5608 – pumping library V3 stands as an upgrade of PS571 – pumping library V2. Specifically designed for pumping stations equipped with up to eight pumps, this library encompasses a comprehensive set of function blocks. This library helps in configuring and monitoring the various pumps in pumping stations.

Depending on the pumping station requirement and objectives, the available process modes typically include pressure control, flow control, and level control.

- Pressure control: This mode focuses on maintaining a specific pressure level within the system. It is ideal for applications where pressure regulation is paramount, such as in water supply systems or hydraulic systems.
- Flow control: Flow control mode is employed to regulate the rate at which the fluid is pumped through the system. It is essential in applications where maintaining a consistent flow rate is critical, such as in chemical manufacturing or irrigation systems.
- Level control: Level control mode is employed to manage the height or volume of liquid in a reservoir or tank. It is commonly used in wastewater treatment plants, industrial storage tanks, and sewage systems.

Depending on the specific operational needs and desired level of control and efficiency for the pumping stations, it offers various operational modes, each tailored to meet different requirements:
- Multimode - all VFD pumps: In this mode, all pumps are equipped with Variable Frequency Drives (VFDs). VFDs allow for precise control of pump speed, making it ideal for applications where fine-tuning flow rates and pressure is essential. This mode provides high efficiency and flexibility.

- Traditional mode - One pump VFD, other DOL pumps: This configuration combines the advantages of a VFD pump with the simplicity of direct-on-line (DOL) pumps. Typically, one pump is equipped with a VFD for precise control, while the others operate using a traditional DOL starter. This mode balances control and cost-effectiveness.

- DOL Mode - All DOL Pumps: In this mode, all pumps operate using direct-on-line (DOL) starters, which provide basic on/off control without speed variation. It's a cost-effective choice for applications where precise control is less critical.

Basic block diagram of a pumping station is as shown below.

The key features supported by the library includes:

- Configuration functions for pump station that permits:
  - Users to customize pump parameters like pump station name, number of pumps, process mode of pumps, pump combination and pump speed.
  - Communication with all pumps in the field that are run by DOL/VFD motors by configuring the pump settings and collecting the pump operation status.

- Pumping functions of the pump that supports:
  - Precise management of emptying and filling operations by comparing actual fluid level with the set fluid level for level control.
  - Uniform fluid level distribution across multiple tanks and reservoirs by providing ON/OFF command to the pumps for level control.
  - Maintenance of flow in the network for flow control.
  - Stabilization of pressure in the network for pressure control.
  - Closed loop control of pressure and flow using PID control.
  - Pump turn off/on sequence generation based on demand.
Auxiliary functions of the pump that include:
– Cleaning up of the pump using anti-jam functionality.
– Capability to calculate and monitor energy consumed and saved.
– Calculation of pump flow rate using pump head flow and pressure flow rate curve characteristics.
– Computation of maintenance schedule for the pump.
– Offering analog and binary protection mechanisms to safeguard pumps against operational risks.
– Conserving energy by enabling pumps to enter sleep mode during periods of low demand.
– Soft fill functionality that ensures gradual pump start up to prevent water hammer and system stress.

Simulation functions of the library that help in system test and validation consists of:
– DOL (Direct-on-line pumps) simulation
– VFD (Variable Frequency Drive) simulation
– Pumptank simulation for tank behavior.

This PLC library for pumping stations is a comprehensive solution that together optimize pump control, energy efficiency, maintenance, protection, and system simulation. It stands as an invaluable tool in the field of industrial automation, ensuring reliability, efficiency, and cost-effectiveness across a wide range of pumping applications.

6.5.13.2 Comparison of V2 and V3 pumping library

The below table compares the function blocks in the V2 library package and corresponding adapted function blocks in the V3 library package.

<table>
<thead>
<tr>
<th>PS571-Pumping library package (V2)</th>
<th>PS5608-Pump library package (V3)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Library name</strong></td>
<td><strong>Library</strong></td>
</tr>
<tr>
<td>PMP_AC500_V25.lib</td>
<td>ABB_Pump_AC500compiled-library</td>
</tr>
<tr>
<td>PMP_CONFIGURATION</td>
<td></td>
</tr>
<tr>
<td>PMP_INTERFACE_DOL</td>
<td>ABB_PumpEco_AC500compiled-library</td>
</tr>
<tr>
<td>PMP_INTERFACE_VFD</td>
<td></td>
</tr>
<tr>
<td>PMP_LEVEL_COMPARATOR</td>
<td></td>
</tr>
<tr>
<td>PMP_LEVEL_DISTRIBUTOR</td>
<td></td>
</tr>
<tr>
<td>PMP_FLOW_DISTRIBUTOR</td>
<td></td>
</tr>
<tr>
<td>PMP_PRESSURE_DISTRIBUTOR</td>
<td></td>
</tr>
<tr>
<td>PMP_PID</td>
<td></td>
</tr>
<tr>
<td>PMP_SEQUENCE_GEN</td>
<td></td>
</tr>
<tr>
<td>PMP_ANTIJAM</td>
<td></td>
</tr>
<tr>
<td>PMP_ENERGY_CALC</td>
<td></td>
</tr>
<tr>
<td>PMP_FLOW_CALC_HQ</td>
<td></td>
</tr>
</tbody>
</table>
### Table 769: Comparison of V3 Pump- and PumpEco libraries

<table>
<thead>
<tr>
<th>Name of the library</th>
<th>ABB_Pump_AC500 library</th>
<th>ABB_PumpEco_AC500 library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Runtime license</td>
<td>Needs pump runtime license</td>
<td>Needs pump eCo runtime license</td>
</tr>
<tr>
<td>PLCs supported</td>
<td>Runs in all PLC’s</td>
<td>Runs only in eCo PLC’s</td>
</tr>
<tr>
<td>Number of pumps supported</td>
<td>8</td>
<td>4</td>
</tr>
</tbody>
</table>

### 6.5.13.3 Contents of the library

#### 6.5.13.3.1 Overview

The library contains function blocks needed for functions of pumping application (pressure control, flow control or level control). It also contains function blocks for some advanced functions needed for different applications.
6.5.13.2 Installation

The library is part of the Automation Builder 2.6.1 or higher. Use the Library Manager to add the library into project.

For more details on the package, refer to the release notes of the latest Automation Builder.

6.5.13.3 Compatibility

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware</td>
<td>AC500 V3 midrange and eCo PLCs</td>
</tr>
<tr>
<td>Software</td>
<td>Automation Builder 2.6.1 or higher</td>
</tr>
<tr>
<td>Library</td>
<td>ABB_Pump_AC500.compiled library</td>
</tr>
<tr>
<td></td>
<td>ABB_PumpEco_AC500.compiled library</td>
</tr>
<tr>
<td>License</td>
<td>Runtime license required</td>
</tr>
</tbody>
</table>
6.5.13.3.4 Required sensors

A minimal sensor equipment is required for the following measurements:

- Actual pressure measurement for pressure control.
- Actual flow measurement for flow control.
- Actual level measurement for level control.

The pressure sensor can be at the input and/or at the output. The flow sensor should be only at the output. Often, at the input a sensor, typically pressure, is placed for advanced protection and diagnosis.
6.5.13.4 Control philosophy of pumping library

The Pumping library is used for controlling the following three water pumping processes:

- Pressure control
- Flow control
- Level control – Emptying or filling

The figure below gives an overview of the pumping library and explains how the library processes the data from the user and then controls the processes.

To run any process, the pumping library follows the four stages described below:

6.5.13.4.1 Stage 1: Comparator

The set process value (e.g., pressure in psi, flow rate in m$^3$/h) is compared with the measured actual value. The distributor uses the output of the comparator to decide the number of pumps and their operating speeds to meet the demand.

- **Pressure control and Flow control:**
  - Pressure control and Flow control: In pressure and flow controls, the function block “$PmpPid acts$” as a comparator which gives the “$PidOut$” in [%] to the function block “$PmpPressureDistributor$” or “$PmpFlowDistributor$”. In the distributor the PID output is then converted as reference speed set point to the pumps.

- **Emptying or Filling mode:**
  - Emptying or Filling mode: In emptying or filling modes, the function block “$PmpLevelComparator$” is used to compare the actual level of the tank with the set levels to start or stop the pumps. This information is sent to the distributor by the output “$NumberOfPumpDemand$”. For example, in filling mode, at lower actual level more pumps are needed to run, to fill the tank.
6.5.13.4.2 Stage 2: Sequence generator

The "PmpSequenceGen" function block is used. The following functions are included:

- Decides which pump is ready to run in the auto mode.
- Decides which pump to start in the sequence, based on the least actual runtime hours.
  Exception – when the pump station is traditional type (with master pump on VFD, rest on DOL), then the pump ID = 1 which is attached to the VFD will always run as master and is first to start and last to stop.
- Decides which pump to stop in the sequence, based on the highest actual runtime hours.
  Exception – when the pump station is traditional type (with master pump on VFD, rest on DOL), then the pump ID = 1 which is attached to the VFD will always run as master and is first to start and last to stop.
- Assigns a master status to the pump in the sequence.
- Indicates how many pumps are ready for automation and how many are running.

The figure below explains a use case where the demand increases and then decreases. The sequence is generated based on these criteria by the function block "PmpSequenceGen".

<table>
<thead>
<tr>
<th>DEMAND</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Next Pump to Start</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>2</td>
<td>Whichever pump has minimum runtime will start next</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Next Pump to Stop</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>1</td>
</tr>
<tr>
<td>Pumps Running</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>5</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>7</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

6.5.13.4.3 Stage 3: Distributor

The distributor function block distributes the start/ stop command and speed reference to all VFD operated pumps.

- Pressure control: For pressure control, the function block "PmpPressureDistributor" is used. The PID output coming from the function block "PmpPid" (comparator) is converted as reference speed setpoint to the master pump. The function block works based on the reference speed of the master pump. If the reference speed is higher, a greater number of pumps are needed to meet the demand. If the reference speed is lower, the already running pumps in the network need to be stopped. The function block:
  - Calculates the speed reference of the master pump and then starts/ stops the follower pumps based on the settings in the inputs "StartSpeedFwr" or "StopSpeedFwr".
  - Distributes the speed references to VFD follower pumps based on the settings in the input "FollowerMode".

- Flow control: For flow control, the function block "PmpFlowDistributor" is used.
  - In the flow distributor the number of pumps to run is decided by the following ratio: "FlowSetpoint'/ (Number of pumps in station * Nominal flow of pump).
  - The function block distributes the speed references to VFD follower pumps based on the settings in the input "FollowerMode".
Emptying/Filling mode: For emptying or filling operation, the function block PmpLevelDistributor is used. The function block starts/ stops the pumps based on the input “NumberOfPumpDemand” (demand) which it receives from function block “PmpLevelComparator”.

- If the actual level is in the normal range, then the speed reference of the pumps are based on the input “NormalSpeed”.
- If for example while filling the actual level reaches below the “LowLevel”, then all pumps run at “HighSpeed”, to quickly fill the pump. Similar analogy is followed when the pump is in emptying mode.

6.5.13.4.4 Stage 4: DRIVE or DOL system

The output of the distributors (“AutoStartCmd” and “AutoSpeedRef”) is connected to function block “PmpInterfaceVFD” and “PmpInterfaceDol”. The function blocks establish the link between library and field devices i.e., pumps.

- For pumps driven by VFD motors, the function block “PmpInterfaceVFD” can be connected with the drives communication function blocks to establish communication and control with the VFD.
- For pumps driven by DOL motor, the function block “PmpInterfaceDol” can be used for start/stop controls.

For more information, see the detailed control philosophy in the following sections.

6.5.13.5 Features in pumping library

Pumping library is mainly designed to use in various application of water industries for example, wastewater treatment, stormwater overflow tank, water association and well stations etc. Maximum 8 pumps can be configured for pressure, flow and level control.

6.5.13.5.1 Types of pumping stations

This section explains the possible combination of library features with different types of pumping stations:

1. “Multi pumping” stations – maximum 8 pumps each fed by variable frequency drive.
2. “Traditional pumping” station – maximum 8 pumps, where one pump (mandatory) fed by variable frequency drive and rest by the direct online motor.
3. “DOL pumping” station – maximum 8 pumps running by direct online motors.

Multi pumping station

This multi pumping station configuration has the best overall and operation economics:

- The library is working in the PLC which controls the operation of the variable frequency drives based on the process requirements.
- All the pumps are connected to the motor which is fed by the VFD. This type of pumping station is most flexible and has optimal process control efficiency performance.
- Based on the load requirements the number of pumps operating can vary and the pumps in operation can be kept as much as possible in their “best efficiency point”.
Traditional pumping station

This pumping station configuration has following features:

- One lead pump is connected to the VFD, and others are connected to the DOL motors.
- The library is working in the PLC which controls the operation of the variable frequency drive of the lead pump. The operation of the DOL motors is based on the process requirements.
- Based on the load requirements the number of pumps operating can vary but the lead pump with the VFD always operates.
Direct-on-line (DOL) pumping station

This pumping station configuration has all the pumps running by the direct-on-line (DOL) motors. This is the most investment cost-effective configuration. It has following features:

- The pump library runs on the AC500 PLC.
- The pump library controls the ON/OFF the pumps based on the process demands.

6.5.13.5.2 Process control vs. pump combinations

The table below explains the applicability of the three process controls and their pump combinations.

<table>
<thead>
<tr>
<th>Process control</th>
<th>Pump combinations</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>DOL</td>
</tr>
<tr>
<td>Flow</td>
<td>✔</td>
</tr>
<tr>
<td>Level</td>
<td>✔</td>
</tr>
<tr>
<td>Pressure</td>
<td>✗</td>
</tr>
</tbody>
</table>

6.5.13.5.3 Process control types

There are three main application and control function blocks:

- Pressure control function blocks
- Flow control function blocks
- Level control function blocks

Pressure control function blocks

Pressure control process flow diagram.
Pressure control is used in applications with individual or multiple water consumers like in water distribution networks. A typical pressure control application diagram is shown below.

1. Suction tank
2. Parallel operating pumps P1 ... P8
3. Pressure setpoint, discharge pressure
4. Consumer
5. Water distribution network
6. Water tower buffer tank
H. Water head between the levels in the suction tank and water tower buffer tank

**Using pressure control**

Pressure control in the pumping library can help in the following operations:

- Water consumption fluctuates always and may be discontinuous over a time period, because of which it is difficult to have a continuous flow rate like in the flow control process.
- The number of pumps and the pump speed is decided by the water consumption in the water distribution system.
- Water is supplied to the pump station through suction pipeline from a suction tank.
- The pumps may be operating in parallel.
- The discharge pressure is measured in the discharge pipeline. The measured discharge pressure is controlled according to the pressure set point.
- Each pump must be started with a minimum speed to build up the pressure which is required to produce a minimum flow.
- The pressure to deliver a minimum flow depends on the water head \((H)\) between the water levels in the suction tank and target tank.
- If there is pump station shutdown due to protection shutdown input, the pumps must be stopped sequentially to prevent water hammering.

Variable speed drives should be stopped through a speed ramp. Otherwise, the water hammering will quickly wear out the pipeline connections and the pump station equipment.
Pressure control mode works for two types of pump combinations: Multi pump and traditional pump.

The combination of function blocks to execute a pressure control is shown in the figures below.

- Multi pump – In this mode all pumps are run using VFDs.
- Traditional pump – In this mode only one pump will run using the VFD and the rest of the pumps will run using the direct-on-line motors. The pump, which is fed by VFD will always be master or lead pump.

Based on the load requirement the number of pumps operating can change but the pump fed by VFD will always be operating.
The pressure control mode cannot be supported by a DOL pump.
The combination with any VFD pump is necessary.

Control philosophy of pressure control mode

The pressure control mode follows this sequence of operation:

1. When the process is started, the first pump runs at “MinimumSpeed” for the time defined in the “TimeToRunMinSpeed” duration. With this process the pipe starts filling gradually and then the normal operation of PID control takes over.
2. The PID compares the required pressured and the actual pressure to generate the output in terms of percentage. This output must be connected to the function block “PmpPressureDistributor”.
3. The function block “PmpPressureDistributor” receives the “PidOut”. The distributor converts the PID output in terms of speed for the master pump.
4. The function block “PmpSequenceGen” has the “MasterPump” information.
5. The “PidOut” is scaled in terms of speed in this method:
   Speed reference of “MasterPump” = (“NominalSpeed” of “MasterPump”) * (“PidOut”/100)
6. As the PID output increases, the speed of the master pump increases. A higher PID output indicates a high demand. In case one pump is not able to cater the requirement, then more pump (followers) are needed to start and supply water to maintain the pressure.
7. If speed reference of the "MasterPump" increases such that it is more than the "StartSpeedFwr[1]", then the first follower in the network will start. The information about which pump to start comes from function block "PmpSequenceGen" at the output "NextPumpToStart".

8. If the speed reference of the "MasterPump" increases further such that it is more than "StartSpeedFwr[2]", then second follower pump starts. This sequence is followed till there is an increase in demand. See the timing diagram below.

![Diagram showing pump startup conditions and timing](image)

- **Start Delay**: Delay time [s] to start the next pump
- **Speed set point of Master Pump**: \( \text{PidOut \%} \times \text{Nominal speed of master pump} \)

Start Delay: Delay time [s] to start the next pump
9. Similar when the demand decreases, the speed reference of master decreases. See
the timing diagram below. As the speed reference of the master pump goes below
“StopSpeedFwr[1]”, the first follower stops. The ID of next pump to stop comes from
“PmpSequenceGen” as “NextPumpToStop”. If the speed reference of the “MasterPump”
decreases further such that it is less than “StopSpeedFwr[2]”, then second follower pump
stops. This sequence is followed till there is a decrease in demand.

The follower pumps in the above figure is considered to be in the
“FollowerMode”= 1, copy master speed. They can also run at their indi-
vidual speed if “FollowerMode”= 2, fixed speed.
6.5.13.5.4 Flow control process flow diagram

Flow control is used in applications where continuous flow distribution to one or more target tanks or reservoirs is needed.

A typical flow control application diagram is shown below.

1 From supply station
2 Suction tank
3 Parallel operating pumps P1 ... P8
4 Flow setpoint, discharge pressure
5 Water distribution network
6 Target tank/Reservoir
7 To next station or distribution network
H Water head between the levels in the suction tank and target tank

6.5.13.5.5 Using flow control

Flow control in the pumping library can help in followings pumping operations:

- Supplying water to the pump station through the suction pipeline from a suction tank.
- Operating pumps in parallel.
- Controlling continuous water flow over a time period.
- Measuring the discharge flow in the discharge pipeline.
- Defining the number of pumps and pump speed based on water flow demand (flow set point).
- Starting each pump with minimum speed to build up the pressure required to produce a minimum flow. The pressure depends on the water head (H) between the water levels in the suction tank and the target tank.
- In case of station shutdown stops the pumps sequentially to prevent water hammering.
- Stops variable speed drives through a speed ramp.
6.5.13.5.6 Pump combinations for flow control

Flow control works for all the three types of pump combinations: Multi pump, traditional pump, and DOL pump.

- Multi pump – In this mode all pumps are run using VFDs. See the example diagram below.
- Traditional pump – In this mode only one pump is run using the VFD and rest are run using the Direct On Line (DOL) motors. See the example diagram below.

- DOL Pump – In this mode all the pumps are operated by DOL motors. The function block PMP_PID is not configured as there is no possibility to change the speed of the pump. See the example diagram below.
6.5.13.5.7 Control philosophy of flow control mode

The above figures show the combination of function blocks to execute the flow control. As it can be seen,

- When the process is started, the first pump runs at the “MinimumSpeed” for the time defined in the “TimeToRunMinSpeed” duration. This is to gradually start filling the pipe. After this the normal operation of PID control takes over.
- The PID acts as a comparator: the PID compares the required flow and the actual flow to generate output in terms of percentage. This needs to be connected to the “PmpFlowDistributor”.
- “PmpFlowDistributor” takes the “PidOut”. Then converts this output in terms of speed for the master pump. The information of master pump comes from the “MasterPump” of the “PmpSequenceGen”. The scaling of the “PidOut” in terms of speed is done in the following ways. Speed reference “MasterPump” = (“NominalSpeed” of “MasterPump”) * (“PidOut”/100)
- This speed reference is given to the master and the follower (if Follower Mode = 1). If Follower Mode = 2, then follower pumps will run at their fixed speed given in the input “FollowerSpeed”[1..8].
- The distributor then decides about the number of pumps to operate based on the following formula, Number of pumps = “FlowSetpoint”/“NominalFlow”, here it is assumed that all pumps are of the same rating.

It is assumed that all the Pumps are of the same capacity.

- As the flow set point increases, the demand of pumps increases.
- Example: if each pump is of capacity = 100 cubic meters per hour and the flow set point is 400 cubic meters per hour, then four pumps will start together. This is unlike the pressure control where the pumps do not start together but based on speed reference of the master pump.
6.5.13.5.8 Flow control with distributor

- Similarly when the demand decreases, the speed reference of the master decreases. As the speed reference of the master pump goes below than “StopSpeedFwr[1]”, the first follower stops. The ID of next pump to stop comes from “PmpSequenceGen” as “NextPumpToStop”.
- If the speed reference of the “MasterPump” decreases further such that it is less than “StopSpeedFwr[2]”, then second follower pump stops. This sequence is follows till there is a decrease in demand.

The follower pumps in the above figures are considered to be in the “FollowerMode” = 1, copy master speed.

They can also run at their individual speed if “FollowerMode” = 2, fixed speed.
6.5.13.5.9 Level control function blocks

Level control process flow diagram

Level control is used in applications where continuous flow distribution into one target tank or reservoir is needed.

A typical flow control application diagram is shown below.

1. From supply station
2. Suction tank
3. Parallel operating pumps P1 ... P8
4. Water distribution network
5. Target tank/Reservoir
6. To next station or distribution network

H Water head between the levels in the suction tank and target tank

Using level control

Level control in the pumping library can help in followings pumping operations:

- Emptying the target tank/reservoir by the next pump station or water distribution network.
- Filling the suction tank from a supply station.
- Defining the number of running pumps based on water level in the water tank.
- Start/stop the pumps with predefined start/stop levels.
- In case of a station shutdown, stop pumps sequentially to prevent water hammering.
Pump combinations for level control

Level control works for all the three types of pump combinations: Multi pump, traditional pump, and DOL pump.

- **Multi pump** – In this mode all pumps are run using VFDs. See the example diagram below.

- **Traditional pump** – In this mode only one pump is run using the VFD and rest using the Direct On Line (DOL) motors. See the example diagram below.

- DOL Pump – In this mode all the pumps are operated by DOL motors. In this case the PMP_PID is not configured as there is no possibility to change the speed of the pump. See the example diagram below.

Control philosophy of level control mode

The level control is based on two modes.
- Emptying mode
- Filling mode

The level control mode follows this sequence of operation:
- The “PmpLevelComparator” compares the actual level (“ActLevel”) with the set start levels (“StartLevel” [1...8]). Based on which the comparator decides the demand - “NoOfPumpDemand”. This demand goes as an input information to the “PmpLevelDistributor”.
- The “PmpLevelDistributor” then starts the required pumps. In case the pumps are driven by VFD, the distributor also gives the speed reference to each pump. The information of which pump to start in the sequence is given to the distributor by “PmpSequenceGen”.
Time diagram:
Emptying mode
6.5.13.6 Auxiliary functions

The various auxiliary functions supported in this library are described in the following chapters.
6.5.13.6.1 Antijam overview

The pump antijam function is used to prevent building up of solids on the pump impellers or piping. The function consists of a programmable sequence of forward and reverse runs of the pump to shake off any residue on the impeller or piping. This function is mostly used with booster and wastewater pumps. See timing diagram below:

![Diagram showing antijam function](image)

The function block PmpAntijam performs the antijam function by running the pump at high speeds without any ramp up/down time.

6.5.13.6.2 Pump energy calculation functionality

The function block “PmpEnergyCalc” calculates the energy consumption of the pumping station run by variable frequency drive and gives the information on cumulative flow in cubic meters. The function includes following calculations:

- Total energy consumed.
- Total energy saved.
- Total cost saved.
- Reduced CO2 emission.

6.5.13.6.3 Pump flow calculation functionality using HQ and PQ curves

The function blocks “PmpFlowCalcHQ” and “PmpFlowCalcPQ” calculates the flow rate of pumps using the pump head flow (HQ) and pump pressure flow rate (PQ) curve characteristics respectively. These functions are applicable only for pumps run by variable frequency drives.

The flow calculation function provides a reasonably accurate calculation of the flow without the installation of a separate flow meter. The flow is calculated based on the pump characteristics. The user can define the PQ (Power vs Flow) or HQ (Head vs Flow) values for the performance curve at the inputs of the function block for the five coordinate points. The values of the PQ and HQ are generally provided by the pump manufacturer and all points defined must be within the operating range of the pump. These points are taken at the maximum operation speed and scaled down by the block according to the actual speed. By this method a good accuracy is achieved with limited parameterization effort.
6.5.13.6.4 Pump maintenance functionality

The function blocks “PmpMaintenance” is used to record the maintenance schedule of the pump. The function block maintains an hourly counter to track the pump maintenance interval and generates timely reminders and alarms.

6.5.13.6.5 Pump protection functionality using analog/binary inputs

The function blocks “PmpProtectionAnalog” and “PmpProtectionBinary” monitors analog inputs and binary inputs respectively and generates signals to shut down or to block the starting of pump or the process.

The function block sends the signals to shut down or to block the starting of pump through inputs “ProtectionShutdown” or “StartBlocker” of these distributor and pump interface function blocks: “PmpLevelDistributor”, “PmpFlowDistributor” “PmpPressureDistributor”, “PmpInterfaceVfd” and “PmpInterfaceDol”.

6.5.13.6.6 Pump sleep functionality

The function block “PmpSleep” stops all pumps in the pressure control process during low demand. The function works only for pressure control (when function block “PmpConfiguration” has the input ProcessMode = 1 (Pressure control) with multi pump station or traditional pump station.

6.5.13.6.7 Pump soft fill functionality

The function block “PmpSoftFilling” enables slow filling operation in pipes in the beginning of the process to avoid damages. If this operation is selected, it is executed before the actual process control takes over.
6.5.13.7 Simulation functions

For the testing of the program in test environment where the real drives or pumps and tanks are missing, these three simulation blocks are provided which can be used.

6.5.13.7.1 Pump DOL simulation block

The function block "PmpDolSimu" is a simple simulation of the direct online pumps. This block can be used to test the behavior of the system when there is start and stop of pumps and external faults are introduced.

6.5.13.7.2 Pump drive simulation block

The function block "PmpDriveSimu" is used to simulate the variable frequency drive (VFD) pumps and for PLC communication. This block can be used to simulate the behavior of the VFDs to check the behavior of system during maximum speed or power, external faults and to check Start and stop sequence of the pumps.

6.5.13.7.3 Pump tank simulation block

The function block "PmpTankSimu" is used to simulate the water tank. This simulation can be used in all the three process control modes:

- Pressure
- Flow
- Level

This block can be used to check the start and stop sequence of the pumps and fault conditions during process control mode when the tank is not available by providing the dimensions of the tank, it can be used in combination with "PmpDolSimu" and "PmpDriveSimu" function blocks to simulate a test environment.
6.5.14 Reference, function blocks

Reference documentation

Chapter 6.5.3.3 “View embedded documentation of all libraries” on page 3775

- BlockGetData
- BlockGetPool
- CloneMessage
- CreateArrayReceiver
- CreateIdAreaReceiver
- CreateMaskReceiver
- CreateMessage
- CreateSingleIdReceiver
- DeleteReceiver
- DisableSyncService
- DriverClose
- DriverGetSize
- DriverOpenH
- DriverOpenP
- EnableSyncService
- FlatCreateH
- FlatCreateP
- FlatDelete
- FlatDisable
- FlatEnable
- FlatGetSize
- FlatRead
- FlatTest
- FlatUpdate
- FreeMessage
- GetBaudrate
- GetBusAlarm
- GetBusload
- GetBusState
- GetCiAState
- GetDiagnosis
- GetLostCounter
- GetMessageDataPointer
- GetMessageId
- GetMessageLength
- GetMsgCount
- GetNetId
- GetReceiveCounter
- GetReceiveErrorCounter
- GetReceivePoolSize
- GetReceiveQueueLength
- GetTimeStamp
- GetTransmitCounter
- GetTransmitErrorCounter
- GetTransmitPoolSize
- GetTransmitQueueLength
- Is29BitIdMessage
- IsRTRMessage
- IsSendingActive
- IsTransmitMessage
- JobAbort
• ASM STATE
• Assert
• AssignerBase
• ASYNC_JOB_ERROR_ID
• AsyncAdd
• AsyncBaseClass
• AsyncGetJobReturnValue
• ASYNCJOB_EVENTPARAM
• ASYNCJOB_HOOKPARAM
• ASYNCJOB_PARAM
• ASYNCJOB_TASKPARAM
• AsyncKill
• AsyncProperty
• AsyncRemove
• AsyncRemoveAll
• atan2_func
• AtomicReadLInt
• AtomicReadLReal
• AtomicReadLTime
• AtomicReadLWord
• AtomicReadULInt
• AtomicWriteLInt
• AtomicWriteLReal
• AtomicWriteLTime
• AtomicWriteLWord
• AtomicWriteULInt
• ATTRIB
• Axis_Parameter
• Axis_Ref
• BACnetAccumulator
• BACnetAcknowledgeAlarm
• BACnetAddListElement
• BACnetAnalogInput
• BACnetAnalogOutput
• BACnetAnalogValue
• BACnetAsyncTransactionToken
• BACnetAveraging
• BACnetBackupBACnetDevice
• BACnetBinaryInput
• BACnetBinaryOutput
• BACnetBinaryValue
• BACnetBitStringGetBit
• BACnetBitStringSetBit
• BACnetCalendar
• BACnetCancelPendingConfirmedRequest
• BACnetClientAcknowledgeAlarm
• BACnetClientAddListElement
• BACnetClientBackupBACnetDevice
• BACnetClientBase
• BACnetClientConfPrivateTransfer
• BACnetClientConfTextMessage
• BACnetClientCreateObject
• BACnetClientDeleteObject
• BACnetClientDeviceCommControl
• BACnetClientGetAlarmSummary
- BCD_TO_BYTE
- BCD_TO(DWORD)
- BCD_TO_INT
- BCD_TO_WORD
- BehaviourModel
- BehaviourModelBase
- BIT AS BYTE
- BIT AS DWORD
- BIT AS WORD
- BitCpy
- BitRelativeAddressInfo
- BLINK
- BlkClass
- BLOB
- BlobAlloc
- BlobCopyToData
- BlobFree
- BlockGetData
- BlockGetPool
- BmpPoolBegin
- BmpPoolEnd
- BmpPoolRegister
- BmpPoolUnRegister
- BOLT
- BoolElement
- BoolElementFactory
- BranchNamedTreeNode
- BranchTreeNode
- BranchTreeNodeOpcUA
- BrowseOperation
- BTagAlignment
- BTagElementType
- BTagReaderCreate
- BTagReaderCreateDynamic
- BTagReaderDestroy
- BTagReaderGetComplexContent
- BTagReaderGetContent
- BTagReaderGetString
- BTagReaderGetTagId
- BTagReaderGetTagLen
- BTagReaderInit
- BTagReaderIsDataTag
- BTagReaderMoveNext
- BTagReaderPeekNext
- BTagReaderSkipContent
- BTagSwapHeader
- BTagWriterAppendBlob
- BTagWriterAppendDummyBytes
- BTagWriterAppendFillBytes
- BTagWriterAppendRaw
- BTagWriterAppendWString
- BTagWriterCreate
- BTagWriterCreateDynamic
- BTagWriterCreateSavePoint
- BTagWriterCreateSavePointDynamic
- BTagWriterDestroy
- BTagWriterDestroySavePoint
- BTagWriterEndTag
- BTagWriterFinish
- BTagWriterInit
- BTagWriterInit2
- BTagWriterRestoreSavePoint
- BTagWriterStartTag
- BTagWriterSwitchBuffer
- Buffer
- BufferPool
- BufferPoolFactoryArgs
- BufferPoolFactoryBase
- BufferToString
- BuildAndEnqueueV3Request
- BUS_INFO
- BUS_STATE
- BUS_TYPE
- BusScanConfHeader
- BUSSTATE
- BYTE_AS_BIT
- BYTE_TO_BCD
- BYTE_TOGRAY
- BYTE_TO_HEXinASCII
- ByteBuffer
- ByteOrder
- C_TS_Type
- CAADiagDeviceDefault
- CAADiagTreeBase
- CAAReconfigureBase
- CalcHesseRepresentation
- CalcRootLin
- CalcRootParable
- CalculatePropertyBufferSize
- CallbackNetVar
- CallbackTaskCodeNC
- CallFunctionByIndex
- CallGlueDeserializeParameters
- CallGlueFunctionParameterSet
- CallGlueSerializeReturnValues
- CamExtended
- CANbus
- CANbus_Diag
- CANDiagnosis
- CANOPEN_KERNEL_ERROR
- CANOPEN_KERNEL_STATE
- CANOpenDiagnosisInfo
- CANopenEvent
- CANopenManager
- CANopenManager_Diag
- CanReconfigure
- CANRemoteDevice
- CANRemoteDevice_Diag
- CANRemoteModule_Diag
- CartesianToPolar
- CIFX_GETSLAVEHANDLE_REQ
- CIFX_HANDSHAKE_CHANNEL_INFO
- CIFX_INDICATION_PARAM
- CIFX_MASTER_DIAG
- CIFX_MAX_PACKET
- CIFX_MEMORY_INFORMATION
- CIFX_PACKET
- CIFX_ResetConfigApplication
- CIFX_SYSTEM_CHANNEL_INFO
- CIFX_SYSTEM_INFO_BLOCK
- CIFX_xChannelBusState
- CIFX_xChannelClose
- CIFX_xChannelCommonStatusBlock
- CIFX_xChannelConfigLock
- CIFX_xChannelControlBlock
- CIFX_xChannelDownload
- CIFX_xChannelExtendedStatusBlock
- CIFX_xChannelFindFirstFile
- CIFX_xChannelFindNextFile
- CIFX_xChannelGetMBXState
- CIFX_xChannelGetPacket
- CIFX_xChannelGetPacketTimeout
- CIFX_xChannelGetSendPacket
- CIFX_xChannelHostState
- CIFX_xChannelInfo
- CIFX_xChannelIOInfo
- CIFX_xChannelIORead
- CIFX_xChannelIOReadSendData
- CIFX_xChannelIOWrite
- CIFX_xChannelOpen
- CIFX_xChannelOpen2
- CIFX_xChannelPLCActivateRead
- CIFX_xChannelPLCActivateWrite
- CIFX_xChannelPLCIsReadReady
- CIFX_xChannelPLCIsWriteReady
- CIFX_xChannelPLCMemoryPtr
- CIFX_xChannelPutPacket
- Cifx_xChannelRegisterRecvCallback
- CIFX_xChannelReset
- CIFX_xChannelSetPacketTimeout
- CIFX_xChannelUpload
- CIFX_xChannelUserBlock
- CIFX_xChannelWatchdog
- CIFX_xDriverClose
- CIFX_xDriverEnumBoards
- CIFX_xDriverEnumChannels
- CIFX_xDriverGetErrorDescription
- CIFX_xDriverGetInformation
- CIFX_xDriverMemoryPointer
- CIFX_xDriverOpen
- CIFX_xMemCpy
- CIFX_xSysdeviceClose
- CIFX_xSysdeviceDownload
- CIFX_xSysdeviceFindFirstFile
- CIFX_xSysdeviceFindNextFile
- CIFX_xSysdeviceGetMBXState
- CIFX_xSysdeviceGetPacket
- CIFX_xSysdeviceInfo
- CIFX_xSysdeviceOpen
- CIFX_xSysdevicePutPacket
- CIFX_xSysdeviceReset
- CIFX_xSysdeviceUpload
- CiModCi52x
- CiModClClusterDiag
- CiModClClusterDiag
- CiModClClusterStatus
- CiModCmdQueue
- CiModCmdQueueInput
- CiModDataAC522
- CiModDataAI523
- CiModDataAI531
- CiModDataAI561
- CiModDataAI562
- CiModDataAI563
- CiModDataAO523
- CiModDataAO561
- CiModDataAX521
- CiModDataAX522
- CiModDataAX561
- CiModDataCD522
- CiModDataCI521
- CiModDataCI522
- CiModDataDA501
- CiModDataDA502
- CiModDataDA561
- CiModDataDC522
- CiModDataDC523
- CiModDataDC532
- CiModDataDC561
- CiModDataDC562
- CiModDataDI524
- CiModDataDI561
- CiModDataDI562
- CiModDataDI571
- CiModDataDI572
- CiModDataDO524
- CiModDataDO526
- CiModDataDO561
- CiModDataDO562
- CiModDataDO571
- CiModDataDO572
- CiModDataDO573
- CiModDataDX522
- CiModDataDX531
- CiModDataDX561
- CiModDataDX571
- CiModDiag
- CiModDiagModInfo
- CiModDiagTableType
- CiModInput
- CiModParaAC522
- CiModParaAI523
- CiModParaAI531
- CiModParaAI561
- CiModParaAI562
- CiModParaAI563
- CiModParaAO523
- CiModParaAO561
- CiModParaAX521
- CiModParaAX522
- CiModParaAX561
- CiModParaCD522
- CiModParaCI521
- CiModParaCI522
- CiModParaDA501
- CiModParaDA502
- CiModParaDC522
- CiModParaDC523
- CiModParaDC532
- CiModParaDC561
- CiModParaDC562
- CiModParaDI524
- CiModParaDI561
- CiModParaDI562
- CiModParaDI571
- CiModParaDI572
- CiModParaDO524
- CiModParaDO526
- CiModParaDO561
- CiModParaDO562
- CiModParaDO571
- CiModParaDO572
- CiModParaDO573
- CiModParaDX522
- CiModParaDX531
- CiModParaDX561
- CiModParaDX571
- CIPClass
- CIPCommonService
- CIPHER_LIST
- CLASS_INFO
- ClassCreate
- ClassDelete
- ClassFree
- CLClient
- CLClientOptions
- CLClientState
- CLIENT_ACCEPT
- CLIENT_REPLY
- CLOCK
- CLOCK_DT
- CloneMessage
- Close
- CLErrorState
- CLServer
- CLServerOptions
- CM5610_2RS
- CM5640_2ETH
- CM579EcatBusDiag
- CM579EcatBusGetDCMaxDeviation
- CM579EcatBussetState
- CM579EcatBusStart
- CM579EcatBusStop
- CM579EcatCoeRead
- CM579EcatCoeWrite
- CM579EcatGetExtSyncInfo
- CM579EcatMasterGetCPULoad
- CM579EcatMasterGetFrameLossCount
- CM579EcatMasterGetMemInfo
- CM579EcatMasterGetThresholdCount
- CM579EcatMasterGetTimingInfo
- CM579EcatRegisterRead
- CM579EcatRegisterWrite
- CM579EcatScanTopology
- CM579EcatScanTopologyStop
- CM579EcatSlvDiag
- CM579EcatSlvGetDCInfo
- CM579EcatSlvGetMDPModules
- CM579EcatSlvGetState
- CM579EcatSlvReadESCVersion
- CM579EcatSlvReadLostLinkCnt
- CM579EcatSlvReadRxErrorCnt
- CM579EcatSlvSetState
- CM579EcatSoeRead
- CM579EcatSoeWrite
- CM579PnioBlockHeader
- CM579PnioCommState
- CM579PnioDeviceState
- CM579PnioDevName
- CM579PnioGetCntrlState
- CM579PnioGetDevState
- CM579PnioIM0Data
- CM579PnioIM0SwRev
- CM579PnioIM0Version
- CM579PnioImplicitRead
- CM579PnioRead
- CM579PnioReadIM0Data
- CM579PnioStartCom
- CM579PnioStopCom
- CM579PnioWrite
- CM582ProfibusDeviceInfoType
- CM592BaseCommonReq
- CM592BaseStatusBlockReq
- CM592CommErrorInfo
- CM592CommStatus
- CM592Control
- CM592DPV1Masc1Read
- CM592DPV1Masc1Write
- CM592ExtDiagData
- CM592ReadInput
- CM592ReadOutput
- CM592SlaveDiagnosis
- CM592SlaveStates
- CM592StateBits
- CM592StationStatus_1
- CM592StationStatus_2
- CM592StationStatus_3
- CM592SystemDiagnosis
- Cm598Base
- Cm598CanInfo
- Cm598CanInfoType
- Cm598CanMessageDataType
- Cm598CanMessageType
- Cm598CanMsgRec
- Cm598CanMsgRecDirect
- Cm598CanMsgRecEvt
- Cm598CanMsgRecMult
- Cm598CanMsgSend
- Cm598CanopenComErrorType
- Cm598CanopenNmt
- Cm598CanopenNodeStates
- Cm598CanopenResetErrors
- Cm598CanopenSdoRead
- Cm598CanopenSdoWrite
- Cm598CanopenSetNodeMode
- Cm598CanopenState
- Cm598CanopenStateBitsType
- Cm598CanopenStateType
- Cm598CanopenSyncState
- Cm598CanopenSysDiag
- Cm598DeviceInfoType
- Cm598NmtCmd
- Cm598NodeModeCmd
- Cm598NodeStateType
- CMAAddComponent
- CMAAddComponent2
- CMC_Axis_Actual
- CMC_Axis_Control_Parameter
- CMC_Axis_InOut
- CMC_Axis_IO
- CMC_Axis_Simu
- CMC_Axis_User
- CMC_Basic_Kernel
- CMC_Basic_Kernel64
- CMC_Binary2Modulo
- CMC_Get_Units_From_Inc
- CMC_Linear_Kernel
- CMC_Load_InOut
- CMC_Load_Motion_Kernel
- CMC_Load_Super
- CMC_Modulo2Binary
- CMC_PidT1
- CMC_Pos_Control
- CMC_SInterPolation
- CMC_SPIPosiLoop
- CMC_XYGroupRef
• CommStatus
• CommunicationSettings
• Compare
• CompareString
• CompareWString
• CompatibilitySafeGetPrepareExitCommProcessingLastCall
• CompatibilitySafeSetPrepareExitCommProcessingFurtherCallNecessary
• ComponentBase
• ComponentPseudo
• ComponentRenamed
• ComponentSimple
• CONCAT
• ConfigError
• ConfigGetConnector
• ConfigGetFirstChild
• ConfigGetFirstConnector
• ConfigGetNextChild
• ConfigGetNextConnector
• ConfigGetParameter
• ConfigGetParameterLength
• ConfigGetParameterValueByte
• ConfigGetParameterValueDword
• ConfigGetParameterValuePointer
• ConfigGetParameterValueWord
• ConnectionSetup
• Connector
• ConnectorFlagController
• ConnectorState
• ContainerSizeProvider
• ContentFeatureFlags
• ControllerConfigUtil
• ControllerState
• ConvertNSecToTick
• ConvertSystimedateToUTC
• ConvertSystimedateUsingLDate
• ConvertSysTimeValueToLWord
• ConvertTickToNSec
• ConvertTickToUSec
• ConvertTimestampToLDateAndTime
• ConvertToIBranchTreeNode
• ConvertToILeafTreeNode
• ConvertToITreeWalker
• ConvertUSecToTick
• ConvertUTF16toUTF8
• ConvertUTF8toUTF16
• Copy
• CopyBufferData
• CopyVUM_User
• CopyVUM_User3
• COUNT
• COUNT_TO_UDINT
• COUNT_TO_UINT
• COUNT_TO_ULINT
• CPU PROD READ_ASYNC
• CpuCoreBindingDesc
- CpuCoreBits
- CRC16_CCITT
- CRC16_generic
- CRC16_Modbus
- CRC16_standard
- CRC16Finish
- CRC16Init
- CRC16Update
- CRC32
- CRC32Finish
- CRC32Init
- CRC32Update
- CRC32Update2
- CREATE_ID
- CreateBuffer
- CreateIdAreaReceiver
- CreateMaskReceiver
- CreateMessage
- CreatePacket
- CreatePacketPool
- CreateSegment
- CreateSegmentPool
- CreateSingleIdReceiver
- CreateTextFromString
- CreateTextFromWString
- CredentialsHandling
- CrossProduct
- CrossProductNormed
- CryptoAsymmetricDecrypt
- CryptoAsymmetricEncrypt
- CryptoDeletePrivateKey
- CryptoDeriveKey
- CryptoExportAsymmetricKey
- CryptoExportRawAsymmetricKey
- CryptoGenerateAsymmetricKeyPair
- CryptoGenerateHash
- CryptoGenerateRandomNumber
- CryptoGetAlgorithmById
- CryptoGetAsymmetricKeyLength
- CryptoGetFirstAlgorithm
- CryptoGetNextAlgorithm
- CryptoHMACSign
- CryptoHMACVerify
- CryptoImportAsymmetricKey
- CryptoImportRawAsymmetricKey
- CryptoKeyAgreement
- CryptoKeyExit
- CryptoKeyInit
- CryptoLoadPrivateKey
- CryptoRtsByteStringExit
- CryptoRtsByteStringInit
- CryptoRtsByteStringInit2
- CryptoSignatureGenerate
- CryptoSignatureVerify
- CryptoStorePrivateKey
- CryptoSymmetricDecrypt
- CryptoSymmetricEncrypt
- CTD
- CtrlFilterContinuous
- CtrlFilterDiscrete
- CtrlIntegrator
- CtrlLag
- CtrlLagDelay
- CtrlLead
- CtrlLeadLag
- CtrlPidParallel
- CtrlPiPulse
- CtrlRampStep
- CTU
- CTUD
- CustomRequestQueue
- CustomRequestResponse
- CWCHAR
- DATA
- DatabaseSizeLimit
- DataCopyToBlob
- DataItem
- DataItemAndPtrVectors
- DataItemBase
- DataItemList
- DataItemListPublic
- DataItemListPublicPersistant
- DataItemLocation
- DataItemPtrVector
- DataItemVector
- DataRepresentation
- DataServer_StructReplacementInfo
- DataServerFlags
- DataServerRequestIdentification
- Datasource
- DataSourceError
- DataSourceMonitoringState
- Datasources
- DatasourcesAction
- DatasourcesActionRecord
- DataSourceShutdownFlags
- DataSourceShutdownInfo
- DatasourcesMgr
- DataSourcesQualityChecker
- DataSourceState
- DataSourceTransactionResult
- DateConcat
- DateSplit
- DateTime
- DateTimeFromWeek
- DateTimeProvider
- DAY
- DayOfWeek
- DAYS
- DCP_DeviceData
- DCP_DeviceRole
- DCP_Error
- DCP_FilterData
- DCP_FilterMode
- DCP_FilterOptions
- DCP_Get
- DCP_GetOptions
- DCP_Identify
- DCP_Reset
- DCP_ResetMode
- DCP_Set
- DCP_SetData
- DCP_SetOptions
- DeallocStackAllocatedContentBuffer
- DebugItfAddrTolItfPtr
- Decode
- DECODE_IOL_STATUS
- DecodeClass
- DecodeEvent
- DefaultAlarmFilterCriteria
- DELETE
- Delete
- DeleteBuffer
- DeleteReceiver
- DERIVATIVE
- Derivative
- DeserializeHexReal
- DetermineVarTypeOfArray
- DetermineVarTypeOfStruct
- DetermineVarTypeOfTypeDesc
- DEVICE
- DEVICE_INFO
- DEVICE_STATE
- DEVICE_TRANSITION_STATE
- DEVICE_TYPE
- DeviceAR
- DeviceAR_State
- DeviceConfigUtil
- DeviceInfo
- DeviceIterator
- DeviceState
- Diag
- DIAG_HISTORY_TXT_TYPE
- DIAG_TXT_TYPE
- DIAG_VAL_TYPE
- DiagHistory
- DiagHistoryValToTxt
- DiagMessageFactory
- DIAGNOSIS_INFO
- DiagnosisDataBuffer
- DiagnosisDataReader
- DiagnosisDirection
- DiagnosisInformationUSI
- DiagnosisRecordIndex
- DiagnosisSeverity
- DiagnosisSource
- DiagnosisSpecifier
- DiagSignalEventIec
- DiagValToTxt
- DiagValTypeGetDeviceType
- DiagValTypeGetTextList
- DiagVerifyTextListCallback
- Dialog_FormatTypes
- DialogCheckInit
- DialogCheckInitForExponential
- DialogCheckInitForExponentialW
- DialogCheckInitW
- DINT_TO_SIGNED
- DintElement
- DintElementFactory
- DintSetBitBased
- DintSetFull
- DintToDintMap
- DintVector
- DirClose
- DirCopy
- DirCreate
- DirectAssigner
- DirectIOBits16
- DirectIOBits8
- DirFileTime
- DirInfo
- DirList
- DirOpen
- DirRemove
- DirRename
- DisableSyncService
- DM1_Read
- DM1_Write
- DM2_Read
- DM2_Write
- DownloadDestination
- DP_ADDR
- DP_AINFO
- DP_DEVICE_ID
- DP_DIAG
- DP_StationStatus1
- DP_StationStatus1_Diag
- DP_StationStatus2
- DP_StationStatus2_Diag
- DP_StationStatus3
- DP_StationStatus3_Diag
- DPSlaveDiag
- DPT10
- DPT10_IEC_to_KNX
- DPT10_KNX_to_IEC
- DPT16_IEC_to_KNX
- DPT16_KNX_to_IEC
- DPT19
- DPT19_IEC_to_KNX
- DPT19 KNX_to_IEC
- Driver
- DriverCfg
- DriverClose
- DriverDiag
- DriverGetSize
- DriverInitInfo
- DriverOpenH
- DriverOpenP
- DRV_PDRIVE_PRM_REQ_ERROR
- DRV_PDRIVE_PRM_TYPE
- DrvControlACS
- DrvControlCANCiA402
- DrvControlDCS
- DrvControlModbusACS
- DrvControlModbusDCS
- DrvControlModbusEng
- DrvDataType
- DrvDataTypeInternal
- DrvModbusRead
- DrvModbusReadWrite23
- DrvModbusRtu
- DrvModbusRtuBroadcast
- DrvModbusTcp
- DrvModbusWrite
- DrvModFct23Type
- DrvModMastType
- DrvModPara32Bit
- DrvPdPmDpv1DataType
- DrvPnRead
- DrvPnWrite
- DrvScaling
- DS_DISK_STATUS
- DS_EOL_INFO
- DS_LIFETIME_USED
- DT_TO_INT64
- DT_TO_ISO8601
- DT_TO_REAL8
- DT_to_Timestamp
- DT_to_Timestamp2
- DTC
- DTCBufferWriter
- DTCLogger
- DTConcat
- DTCPProvider
- DTR_CONTROL
- DTSplit
- DTU_GETDATEANDTIME_PARAMS
- DTU_GETTIMEZONEINFORMATION_PARAMS
- DTU_SETDATEANDTIME_PARAMS
- DTU_SETTIMEZONEINFORMATION_PARAMS
- Dummy
- DummyJob
- DURATION
- DURATION_TO_LTIME
- DURATION_TO_TIME
- DWORD_AS_BIT
- DWORD_TO_BCD
- DWORD_TO_GRAY
- DWORD_TO_HANDLE
- DWORD_TO_IDENT
- DWORD_TO_PVOID
- DwordVector
- DynamicTextChangeLanguage
- DynamicTextGetCurrentLanguage
- DynamicTextGetDefaultText
- DynamicTextGetDefaultTextW
- DynamicTextGetText
- DynamicTextGetTextW
- DynamicTextIterateIndices
- DynamicTextLoadDefaultTexts
- DynamicTextRegisterFile
- DynamicTextRegisterPath
- DynamicTextReloadTexts
- DynamicTextRetrieveIndices
- DynamicTextUnRegisterFile
- DynamicTraceLoader
- DynamicTraceLoaderRemote
- EAlarmStorageReaderErrors
- EAlarmTableParts
- EAlarmType
- ECAT_402ParameterHoming_APP
- ECAT_CiA402_Control_App
- ECAT_CiA402_TouchProbe_App
- ECAT_CiA_Object_App
- ECAT_DecodeCouplerError
- ECAT_HomingOnTouchProbe_APP
- ECAT_Read_Byte_App
- ECAT_Read_Coe_List_App
- ECAT_Read_DInt_App
- ECAT_Read_Int_App
- ECAT_Write_Byte_App
- ECAT_Write_Coe_List_App
- ECAT_Write_DInt_App
- ECAT_Write_Int_App
- EcatBusDiag
- EcatBusGetDCMaxDeviation
- EcatBusSetState
- EcatCoeRead
- EcatCoeWrite
- EcatDeviceIdentification
- EcatDeviceInfoData
- EcatDeviceTypeIdentification
- EcatGetExtSyncInfo
- EcatMasterGetCPULoad
- EcatMasterGetFrameLossCount
- EcatMasterGetMemInfo
- EcatMasterGetThresholdCount
- EcatMasterGetTimingInfo
- EcatRegisterRead
- EcatRegisterWrite
- EcatScanTopology
- EcatScanTopologyStop
- EcatSLvDiag
- EcatSLvGetDCInfo
- EcatSLvGetMDPModules
- EcatSLvGetState
- EcatSLvReadESCVersion
- EcatSLvReadLostLinkCnt
- EcatSLvReadRxErrorCnt
- EcatSLvsetState
- EcatSoeRead
- EcatSoeWrite
- EcatStartCom
- EcatState
- EcatStopCom
- EcatSync
- EcatVendor
- EcatVendorIDList
- EcatVendorName2Device
- ECM_IF_DC_CONTROL_STATUS_E
- ECM_IF_GET_SLAVE_DC_INFO_FLAGS_E
- ECO_DisableMultiPin
- EColorSetting
- ECUSTATE
- EDBActiveIndex
- EDBType
- eDeviceState
- EdgeTriggedBehaviourModelBase
- EdgeTriggedTimingControlledBehaviourModelBase
- EEthernetState
- eFastCounter
- EFillingStyle
- EFFilterCriteriaActivity
- EFFilterLatchContent
- EFFilterTimeRangeType
- EImageStyle
- EIP_CloseClass3Connection
- EIP_OpenClass3Connection
- EIP_SendClass3ConnectedMessage
- EIP_SendUnconnectedMessage
- ElaborateLatchFilterCriteria
- ElaborateTimeRangeFilterCriteria
- Element
- EMCY_DATA
- EMCY_ERROR
- eModulName
- EnableSyncService
- Encode
- EncodeSpec
- ENDIANESS
- EnqueuedRequest
- ENUM61850_BASIC_TYPES
- ENUM61850_CLOCK_SYNC_MODE
- ENUM61850_DataPoint_Type
• ENUM61850 SIM MODE
• EnumAttributes
• EnumValues
• EnXYChartClientActivity
• EnXYChartDataProviderAxisVar
• EnXYChartDataProviderCurveVar
• EnXYChartDataProviderVar
• EnXYChartUpdateType
• EOF
• eParaState
• ERectSetting
• ErrFlexConf
• ERROR
• ERROR_ID
• ERROR_INFO
• ErrorCode
• ErrorCode1_RW
• ErrorCodeOB
• ErrorToString
• EShadowStyle
• ESpecial_FP_Value
• ETC ADS IoLinkRead
• ETC ADS IoLinkWrite
• ETC CO Emergency
• ETC CO_ERROR
• ETC CO_MODE
• ETC CO_SdoInfoGeEntryDescription
• ETC CO_SdoInfoGetObjectDescription
• ETC CO_SdoInfoGetODList
• ETC CO_SdoRead
• ETC CO_SdoRead4
• ETC CO_SdoRead_Access
• ETC CO_SdoRead_Channel
• ETC CO_SdoReadDWord
• ETC CO_SdoWrite
• ETC CO_SdoWrite4
• ETC CO_SdoWrite_Access
• ETC CO_SdoWriteDWord
• ETC_FoE Download
• ETC_FoE Upload
• ETC_LASTERROR
• ETC_MASTER_STATE
• ETC_SDO_INFO_LIST_TYPE
• ETC_SDO_INFO_OBJECT_CODE
• ETC_SLAVE_STATE
• ETC_SoE_Cmd
• ETC_SOE_ERROR
• ETC_SoE_IDNRead
• ETC_SoE_IDNRead4
• ETC_SoE_IDNWrite
• ETC_SoE_IDNWrite4
• ETC_VoE_SendReceive
• ETCDeviceIdentMode
• ETCERRORCODES
• ETCMasterStack
- ETCSlave
- ETCSlave_Diag
- ETCSlaveStack
- ETH_MOD_FCT22_TYPE
- ETH_MOD_FCT23_TYPE
- EthDNSResolve
- EtherCATDevice
- EthercatMaster_GetVersion
- EtherCatReconfigure
- EthernetState
- EthIcmpPing
- EthOwnIP
- EthOwnIPInfo
- EthSetOwnIP
- EthSetRtoMin
- ETHx_ICMP_PING
- ETHx_MOD_CONFIG
- ETHx_MOD_INFO
- ETHx_MOD_MAST
- ETHx_OWN_IP
- ETHx_OWN_IP_INFO
- ETraceAddressFlags
- ETraceGradientType
- ETrendStorageGraphType
- ETrendStoragePenStyle
- ETrendStorageReaderErrors
- ETrendStorageReaderStep
- ETrig
- ETrigA
- ETrigATI
- ETrigATITo
- ETrigATo
- ETrigTIA
- ETrigTITo
- ETrigTo
- ETrigToA
- ETrigToTI
- ETrigToTIA
- EVENT
- EVENT_CLASS
- EVENT_SOURCE
- EventClose2
- EventCreate
- EventCreate2
- EventCreateEventID
- EventDelete2
- EventElementData
- EventGetClass
- EventGetEvent
- EventIdToString
- EventOpen
- EventParam
- EventParam2
- EventPost
- fmod
- FORMAT_MODE
- FormatDateTime
- FormatTimestamp
- FormatTimestamp2
- FormatTypedValue
- FrameManager
- FramePaintState
- FrameRegistrationData
- FreeMessage
- FreeStackAllocatedMemory
- FREQ_MEASURE
- FromBACnetBitString
- FromBACnetBoolean
- FromBACnetDate
- FromBACnetDateRange
- FromBACnetDateTime
- FromBACnetDevObjPropReference
- FromBACnetSetpointReference
- FromBACnetString
- FromBACnetTime
- FromBACnetTimeStamp
- FSLState
- funIEC61850_GetReportHeaderLen
- funIEC61850_MMSTYPE_TO_STRING
- funIEC61850_Subs_Bits_SwapRight
- funIEC61850_Subs_InitDatapoint
- funIEC61850_SubsCheckDataNum
- GEN
- GEN_MODE
- Generic_Service
- Get_Attribute_List
- Get_Attribute_Single
- Get_Attributes_All
- GET_CANOPEN_KERNEL_STATE
- GET_LOCAL_NODE_ID
- GET_STATE
- GetAlarmIDName
- GetAllEtherCATCouplers
- GetAttribute
- GetBACnetDataTypeSize
- GetBACnetPropertyDataType
- GetBaudrate
- GETBIT
- GetBitStringFromContents
- GetBitValue
- GetBooleanProperty
- GetBoolFromContents
- GetBufferSize
- GetBusAlarm
- GetBusError
- GetBusload
- GetBusScan
- GetBusState
- GetCallback
- GetChar
- GetCiAState
- GetClass
- GetClassInfo
- GetCompany
- GetConfigType
- GetControllerNode
- GetDatabaseFileSize
- GetDatabaseFileSize2
- GetDateAndTime
- GetDateFromContents
- GetDateRangeFromContents
- GetDateTime
- GetDateTimeFromContents
- GetDayOfWeek
- GetDeviceError
- GetDeviceNameString
- GetDeviceNameWString
- GetDeviceNode
- GetDevObjPropReferenceFromContents
- GetDiagnosis
- GetElapsedTimeInNSec
- GetElapsedTimeInUSec
- GetHandleOfCallback
- GetID
- GetDeviceInstByIoAddr
- GetInfo
- GETIO_PART
- GetIPAddress
- GetLatchVarColumnID
- GetLibVersion
- GetLibVersionNumber
- GetLINTValue
- GetLINTValue2
- GetLINTValue3
- GetLocalDateTime
- GetLostCounter
- GetLrealFromContents
- GetLRealSpecialVal
- GetMessageDataPointer
- GetMessageId
- GetMessageLength
- GetMsgCount
- GetNetId
- GetNextNode
- GetNodeDepth
- GetNumberActiveCallbacks
- GetNumberProperty
- GetObjectIDFromContents
- GetParent
- GetPos
- GetProperty
- GetRealFromContents
- GetRealSpecialVal
- GetReceiveCounter
- GetReceiveErrorCounter
- GetReceivePoolSize
- GetReceiveQueueLength
- GetRoot
- GetSetpointReferenceFromContents
- GetSignedFromContents
- GetSize
- GetSpecificDeviceError
- GetSubmoduleDiagnosis
- GetSupplierVersion
- GetText
- GetTextListInfo
- GetTextProperty
- GetTextProperty2
- GetTextW
- GetTick
- GetTime
- GetTimeFromContents
- GetTimeStamp
- GetTimeStampsDifference
- GetTimeZoneInformation
- GetTitle
- GetTransmitCounter
- GetTransmitErrorCounter
- GetTransmitPoolSize
- GetTransmitQueueLength
- GetTypeNodeOptions
- GetUnsignedFromContents
- GetVersion
- GetVersionProperty
- GetWStringFromContents
- GlobalImagePool
- GlobalTextList
- GRAY_TO_BYTE
- GRAY_TO_DWORD
- GRAY_TO_WORD
- GUARDING_TYPE
- Guid
- HaModAIQ
- HaModCallbackStop
- HaModControl
- HaModCtd
- HaModCtu
- HaModCtud
- HaModDataSync
- HaModDerivative
- HaModDiag
- HaModDIO
- HaModEthFrame
- HaModEthFrameHeader
- HaModIntegral
- HaModPid
- HaModPidFixCycle
- HaModRampInt
- HaModRampReal
- HaModStatus
- HaModStatusLifeCom2
- HaModStatusPlc
- HaModTof
- HaModTon
- HaModVisuData
- HaModVisuEthInfo
- HANDLE
- HANDLE_TO_DWORD
- HANDLE_TO_LWORD
- HANDLE_TO_WORD
- HandleChannelError
- HandleReply
- HandleStateVariables
- HandleStore
- HasAlarmStorageRecordLimit
- HashCodeFromString
- HashCodeFromWString
- HashTable
- HashTableFactory
- HasNullOrEmptySecurityPolicy
- HEADER_TAG
- HeapInspectionInfo
- HEX_in_ASCII_TO_BYTE
- HexStrToLReal
- HexStrToReal
- HighByte
- HighWord
- HistoricalActiveAlarmRowID
- history
- HOSTNAME
- HOUR
- HvacAirDensity
- HvacAirEnthalpy
- HvacDewConcentration
- HvacDewRelHumidity
- HvacDewTemp
- HvacOnTime
- HvacPumpEnergyCalc
- HvacRuntimeCounter
- HvacVaporSaturationPressure
- HYSTERESIS
- Hysteresis_DINT
- Hysteresis_LREAL
- IAbbAsyncJob
- IAbbETrig2
- IAbbETrig3
- IAbbLCon2
- IAbbLCon3
- IAbbLConC2
- IAbbLConC3
- IAbortable
- IAC500Device
- IAC500DeviceCM5610_2RS
- IAC500DeviceCM5640_2ETH
- IAC500DeviceCM56xCoupler
- IAC500DeviceCoupler
- IAC500DeviceNetxCoupler
- IAC500DeviceOptionBoard
- IAC500DeviceSerialProtocol
- IAC500DeviceTA5130KNXPB
- IAC500DeviceTA5131RTC
- IAC500DeviceTA5141RS232I
- IAC500DeviceTA5142RS485
- IAC500Diag
- IAC500DiagGet
- IAC500NetworkInterface
- IAC500OnboardEtherCATMaster
- IActionController
- IActionController2
- IActionProvider
- IAddressResolver
- IAddrInfoLeafTreeNode
- IAlarm
- IAlarm2
- IAlarm3
- IAlarm4
- IAlarm5
- IAlarmAdditionalLatchVariables
- IAlarmAdditionalLatchVariables2
- IAlarmClass
- IAlarmConfiguration7
- IAlarmConfiguration8
- IAlarmGroup
- IAlarmGroup3
- IAlarmHandler
- IAlarmHandler2
- IAlarmHandler3
- IAlarmHandler4
- IAlarmHandler5
- IAlarmHandlerRemoteMonitor
- IAlarmManagerClient
- IAlarmManagerClient2
- IAlarmDBObjectStub5
- IAlarmNotifiable
- IAlarmRemote
- IAlarmStateChangedEventListener
- IAlarmStateChangedListener
- IAlarmStateChangedListener2
- IAlarmStorageListener
- IAlarmStorageReaderConsumer
- IAlarmStorageReaderConsumer2
- IApplicationRectangleProvider
- IARPACallback
- IARPEthernetClient
- IArrayNotifiable
- IAsyncProperty
- IBACnetClient
- IBACnetEventConsumer
- IBACnetObjectBase
• IBACnetPersistence
• IBACnetPropertyConfiguration
• IBACnetServer
• IBACnetServerPlugin
• IBACnetServerPluginCallback
• IBACnetServerPluginHook
• IBACnetStaticObjectBase
• IBase
• IBaseTreeNode
• iBasicEthercat
• iBasicKernel
• IBehaviourModel
• IBoolElement
• IBranchTreeNode
• IBuffer
• IBuffePool
• IBuffePoolFactoryArgs
• IBus
• ICallback
• ICallOnDialogBlocks
• ICallOnVisuBlocks
• ICANopenEventHandler
• ICANopenStack
• ICascadedDisposalProvider
• ICDSV3Request
• ICDSV3RequestBuilder
• ICDSV3RequestCallback
• ICDSV3RequestHandling
• ICDSV3Response
• ICDSV3ServiceWriter
• ICertificateVerifier
• ICleanupActionProvider
• IClient
• IClientObjectInfo
• IClippingLayer
• ICmpEventCallback
• ICmpIoDrv
• ICmpIoDrvBusControl
• ICmpIoDrvBusControl2
• ICmpIoDrvPbSlaveActivation
• ICmpIoDrvProfibus
• ICmpIoDrvProfibusConfig
• ICollection
• ICompactTextListInfo2
• ICompleteSurroundingRectInfo
• IConfigurationProvider
• IConfigurationProvider2
• IConnection
• IContainerPaintSelf
• IContainsValue
• ICredentials
• ICredentialsProvider
• ICredentialsUserPassword
• ICursor
• ICursor2
- ICursor3
- ICursorAsync
- ICustomAlarmToOpcUaMapping
- ICustomEventHandler
- ICustomRequest
- ICustomRequestCallback
- ICustomRequestHandling
- ICustomResponse
- ICyclicActionProvider
- ID
- ID_TO_ADDR
- IData
- IDataGroup
- IDataItem
- IDataItem2
- IDataItemBase
- IDataItemCompound
- IDataItemInfo
- IDataItemList
- IDataItemListExpanding
- IDataItemListInternal
- IDataItemListPersistant
- IDataItemProvider
- IDataItemProvider2
- IDataItemProviderSupportsPartialLists
- IDataItemValueAssigner
- IDataServer
- IDataServer2
- IDataServer3
- IDataServer4
- IDataServer5
- IDataServer6
- IDataServerActionRecord
- IDataServerFrameManager
- IDatasource
- IDatasource2
- IDatasource3
- IDatasourceDriver
- IDatasourceDriver2
- IDatasourceDriver3
- IDatasourceDriver4
- IDatasourceDriver5
- IDatasourcesActionRecord
- IDatasourcesActionRecordInternal
- IDatasourcesFrameManager
- IDatasourcesMgr
- IDatasourcesMgr2
- IDatasourcesMgr3
- IDatasourcesMgr4
- IDatasourcesResourceEntryAllocator
- IDatasourceTraceAddressInfoProvider
- IDateTimeLanguageTextTarget
- IDateTimeProvider
- IDENT
- IDENT_TO_DWORD
• IDENT_TO_WORD
• IDevice
• IDevice2
• IDeviceCM579EtherCAT
• IDeviceCM579Profinet
• IDeviceCM582Profibus
• IDeviceCM589Profinet
• IDeviceCM592Profibus
• IDeviceCM598Can
• IDeviceSM560
• IDialogCloseListener
• IDialogCloseListenerWithTag
• IDialogManager10
• IDialogManager2
• IDialogManager3
• IDialogManager4
• IDialogManager5
• IDialogManager6
• IDialogManager7
• IDialogManager8
• IDialogManager9
• IDintElement
• IDintSet
• IDirectoryFileElement
• IDisposable
• IDoubleLinkedList
• IDrawingInterface3
• IDrawSequentially
• IDriver
• IDriverCDSV3
• IDriverCredentialsHandling
• IDriverCredentialsHandlingEveryLogin
• IDriverCustomRequest
• IDriverLargeRequest
• IDriverRequest
• IDriverRequestFactory
• IDriverRequestFactoryCustom
• IDriverRequestFactoryLargeRequests
• IDriverRequestFactoryReusable
• IDriverRequestReusable
• IDriverSpecificData
• IDriverSpecifiedSettings
• IDriverStateMachine
• IDriverStateMachine2
• IDriverStateMachineNotifyBeforeShutdown
• IDriverStateMachineShutdownTimeout
• IDriverTraceAddressInfoProvider
• IEC60870_5_104_Connection
• IEC60870_BACKGROUND_SCAN
• IEC60870_DISABLE
• IEC60870_DoubleCommand
• IEC60870_DoublePointInformation
• IEC60870_GET_ADDRESS
• IEC60870_IntegratedTotal
• IEC60870_MeasuredValue
• IEC60870_REC_C_DC
• IEC60870_REC_C_SC
• IEC60870_REC_C_SE
• IEC60870_REC_C_TS_NA_1
• IEC60870_REC_M_DP
• IEC60870_REC_M_IT
• IEC60870_REC_M_ME
• IEC60870_REC_M_ME_1
• IEC60870_REC_M_SP
• IEC60870_REC_P_ME
• IEC60870_SEND_C_CI_NA_1
• IEC60870_SEND_C_CI_NA_1_2
• IEC60870_SEND_C_CS_NA_1
• IEC60870_SEND_C_CS_NA_1_2
• IEC60870_SEND_C_DC
• IEC60870_SEND_C_IC_NA_1
• IEC60870_SEND_C_IC_NA_1_2
• IEC60870_SEND_C_RD_NA_1
• IEC60870_SEND_C_RP_NA_1
• IEC60870_SEND_C_RP_NA_1_2
• IEC60870_SEND_C_SC
• IEC60870_SEND_C_SE
• IEC60870_SEND_C_TS_NA_1_ACT
• IEC60870_SEND_C_TS_NA_1_ACTCON
• IEC60870_SEND_DISABLE
• IEC60870_SEND_M_DP
• IEC60870_SEND_M_DP_ET
• IEC60870_SEND_M_EI_NA_1
• IEC60870_SEND_M_IT
• IEC60870_SEND_M_IT_1
• IEC60870_SEND_M_IT_16
• IEC60870_SEND_M_IT_16_ET
• IEC60870_SEND_M_IT_1_ET
• IEC60870_SEND_M_ME
• IEC60870_SEND_M_ME_1
• IEC60870_SEND_M_ME_16
• IEC60870_SEND_M_ME_16_ET
• IEC60870_SEND_M_ME_1_ET
• IEC60870_SEND_M_SP
• IEC60870_SEND_M_SP_16
• IEC60870_SEND_M_SP_16_ET
• IEC60870_SEND_M_SP_1_ET
• IEC60870_SEND_P_ME
• IEC60870_SetPoint
• IEC60870_SingleCommand
• IEC60870_SinglePointInformation
• IEC60870_STATE
• IEC60870_TIME
• IEC60870Commands
• IEC60870Disable
• IEC60870DisableSend
• IEC60870GetConfigAddress
• IEC60870GetConfigValues
• IEC60870GetConnectionStatistics
• IEC60870GetPinData
- IEC60870GetStatesOfPinParam
- IEC60870GetStatesOfPins
- IEC60870GetTestInformation
- IEC60870SendCommand
- IEC60870SendPinData
- IEC60870SetParameterValues
- IEC60870SetPinData
- IEC60870StartScan
- IEC61850_ArrayBits_SwapLeft
- IEC61850_ASN1_Decoder
- IEC61850_ASN1_DECODING
- IEC61850_ASN1_Decoding_Data
- IEC61850_ASN1_EncodingBlock
- IEC61850_ASN1_EncodingSize
- IEC61850_ASN1_EncodingSpecific
- IEC61850_ASN1_EncodingStruct
- IEC61850_ASN1_GetNextTag
- IEC61850_ASN1_NewDecoder
- IEC61850_ByteBits_SwapLeft
- IEC61850_ByteBits_SwapRight
- IEC61850_CDC_ACD
- IEC61850_CDC_ACT
- IEC61850_CDC_ALM
- IEC61850_CDC_APC
- IEC61850_CDC_ASG
- IEC61850_CDC_ASS
- IEC61850_CDC_BCR
- IEC61850_CDC_BRCB
- IEC61850_CDC_BSC
- IEC61850_CDC_CMD
- IEC61850_CDC_CMV
- IEC61850_CDC_CSD
- IEC61850_CDC_CTE
- IEC61850_CDC_CURVE
- IEC61850_CDC_DEL
- IEC61850_CDC_DPC
- IEC61850_CDC_DPL
- IEC61850_CDC_DPS
- IEC61850_CDC_GoCB
- IEC61850_CDC_HDEL
- IEC61850_CDC_HMV
- IEC61850_CDC_HWYE
- IEC61850_CDC_INC
- IEC61850_CDC_ING
- IEC61850_CDC_INS
- IEC61850_CDC_ISC
- IEC61850_CDC_LPL
- IEC61850_CDC_MV
- IEC61850_CDC_ORG
- IEC61850_CDC_SAV
- IEC61850_CDC_SEQ
- IEC61850_CDC_SPC
- IEC61850_CDC_SPG
- IEC61850_CDC_SPS
- IEC61850 CDC_SPV
- IEC61850 CDC_STV
- IEC61850 CDC_TMS
- IEC61850 CDC_URCB
- IEC61850 CDC_WDPL
- IEC61850 CDC_WYE
- IEC61850 CheckHexString
- IEC61850 CheckBufferIx
- IEC61850 CheckByteOrder
- IEC61850 CheckClients
- IEC61850 CheckDataPoint
- IEC61850 CheckDoubleDP
- IEC61850 CheckEntryID
- IEC61850 CheckEnumRange
- IEC61850 CheckTrgOp
- IEC61850 CLIENT_ACCEPT
- IEC61850 ClientConnectionFB
- IEC61850 CONCAT3
- IEC61850 CONCAT4
- IEC61850 CONCAT5
- IEC61850 CONCAT6
- IEC61850 CpyAndSwap
- IEC61850 CreateBasicNames
- IEC61850 DatasetFB
- IEC61850 DateTime
- IEC61850 DecodeNull
- IEC61850 DeleteDataSet
- IEC61850 DWORD_TO_HEXSTRING
- IEC61850 Encoding Array_Count
- IEC61850 Encoding Array_Struct
- IEC61850 Encoding Component
- IEC61850 Encoding Component_Struct
- IEC61850 Encoding ComponentSingle
- IEC61850 Encoding DirectoryNames
- IEC61850 EncodingListOfData
- IEC61850 EncodingListOfData_Struct
- IEC61850 EncodingListOfVariable
- IEC61850 Encoding Value
- IEC61850 ENUM ASN1_TAGS
- IEC61850 ENUM ATTR NAMES
- IEC61850 ENUM DA_ALM_STATE
- IEC61850 ENUM DA_ANGID
- IEC61850 ENUM DA ANGIDCMV
- IEC61850 ENUM DA ANGLEREFERENCEKIND
- IEC61850 ENUM DA ASS_STVAL
- IEC61850 ENUM DA BEH
- IEC61850 ENUM DA CBOPCAP
- IEC61850 ENUM DA CMDQUAL
- IEC61850 ENUM DA CONTROLOUTPUTKIND
- IEC61850 ENUM DA CTE_HISRS
- IEC61850 ENUM DA CTE_RSPER
- IEC61850 ENUM DA CTLMODELKIND
- IEC61850 ENUM DA CTLMODELS
- IEC61850 ENUM DA CURVECHARKIND
- IEC61850 ENUM DA DAWEEEKDAYKIND
- IEC61850 ENUM DA DBPOS
- IEC61850 ENUM DA DIR
- IEC61850 ENUM DA DIRMOD
- IEC61850 ENUM DA ENUMERATED
- IEC61850 ENUM DA FAILMOD
- IEC61850 ENUM DA FANCTL
- IEC61850 ENUM DA FAULTDIRECTIONKIND
- IEC61850 ENUM DA GNST
- IEC61850 ENUM DA HEALTH
- IEC61850 ENUM DA HVID
- IEC61850 ENUM DA HVREFERENCEKIND
- IEC61850 ENUM DA LEVMOD
- IEC61850 ENUM DA LIVDEAMOD
- IEC61850 ENUM DA MOD
- IEC61850 ENUM DA MONTHKIND
- IEC61850 ENUM DA MULTIPLIER
- IEC61850 ENUM DA MULTIPLIERKIND
- IEC61850 ENUM DA OCCURRENCEKIND
- IEC61850 ENUM DA OPMOD
- IEC61850 ENUM DA ORCAT
- IEC61850 ENUM DA ORIGINATORCATEGORYKIND
- IEC61850 ENUM DA PERIODKIND
- IEC61850 ENUM DA PHASEANGLEREFERENCEKIND
- IEC61850 ENUM DA PHASEFAULTDIRECTIONKIND
- IEC61850 ENUM DA PHASEREFERENCEKIND
- IEC61850 ENUM DA PHSID
- IEC61850 ENUM DA POLQTY
- IEC61850 ENUM DA POWCAP
- IEC61850 ENUM DA RANGE
- IEC61850 ENUM DA RANGEKIND
- IEC61850 ENUM DA RETRMOD
- IEC61850 ENUM DA RSTMOD
- IEC61850 ENUM DA RVAMOD
- IEC61850 ENUM DA SBOCLASSES
- IEC61850 ENUM DA SBOCLASSKIND
- IEC61850 ENUM DA SHTYP
- IEC61850 ENUM DA SEQ
- IEC61850 ENUM DA SEQUENCEKIND
- IEC61850 ENUM DA SETCHARACT
- IEC61850 ENUM DA SEV
- IEC61850 ENUM DA SEVERITYKIND
- IEC61850 ENUM DA SHOPCAP
- IEC61850 ENUM DA SIUNIT
- IEC61850 ENUM DA SIUNITKIND
- IEC61850 ENUM DA SPV CHAPERRS
- IEC61850 ENUM DA SPV SPACCS
- IEC61850 ENUM DA SWOPCAP
- IEC61850 ENUM DA SWTYP
- IEC61850 ENUM DA TCMD
- IEC61850 ENUM DA TMS HISRS
- IEC61850 ENUM DA TMS RSPER
- IEC61850 ENUM DA TRGMOD
- IEC61850 ENUM DA TRMAMOD
- IEC61850 ENUM DA TYPRSCRV
- IEC61850 ENUM DA UNBLKMOD
- IEC61850 Enum DA WEIMOD
- IEC61850 Enum ELEMENTTYP
- IEC61850 Enum FC
- IEC61850 Enum MMS_CONFIRMED_REQ_PDU
- IEC61850 Enum MMS_CONFIRMED_RESP_PDU
- IEC61850 Enum MMS_DataType
- IEC61850 Enum MMS_OBJECTCLASS
- IEC61850 Enum MMS_PDU
- IEC61850 Enum QUALITY
- IEC61850 Enum SERVICES
- IEC61850 Enum TRGOPT
- IEC61850 EthernetAdapter
- IEC61850 GetDatapoint
- IEC61850 GetDataPointLen
- IEC61850 GetDataPointRef
- IEC61850 GetDefinition
- IEC61850 GetDirectory
- IEC61850 GetDirectory_All
- IEC61850 GetFC
- IEC61850 GetReportLen
- IEC61850 GetURCBDataLen
- IEC61850 GetValue
- IEC61850 GetValues_All
- IEC61850 Goose ASN1 Decoder
- IEC61850 GOOSE MReq
- IEC61850 GooseDecodeData
- IEC61850 HEXSTRING_TO_DWORD
- IEC61850 HistDataBuffer_In
- IEC61850 HistDataBufferFB
- IEC61850 Init_BReportBlock
- IEC61850 Init_DataPoints
- IEC61850 Init_GoCB
- IEC61850 Init UBReportBlock
- IEC61850 InitDSLastValPtr
- IEC61850 INT_TO_STRING
- IEC61850 MMS_Data_InterpreterFB
- IEC61850 MMS_ErrorPDU
- IEC61850 MMS_InterpreterFB
- IEC61850 MMSGetBlockLen
- IEC61850 ReadDWord
- IEC61850 ReadISOHeader
- IEC61850 ReadString
- IEC61850 ReadWord
- IEC61850 SetDatasetVal
- IEC61850 SetDSError
- IEC61850 SetISOEntry
- IEC61850 SetISOLen
- IEC61850 SetReportValue
- IEC61850 SetStructIndex
- IEC61850 SetTrgOpt
- IEC61850 SetValue
- IEC61850 SimpleClock
- IEC61850 STR_TO_BYTE
- IEC61850 String_Split
- IEC61850 Swap_2_BYTE
- IEC61850_SWAP_3_BYTE
- IEC61850_SWAP_4_BYTE
- IEC61850_SysMemCpy
- IEC61850_TimeStampR
- IEC61850_Version
- IEC61850_WordBits_SwapLeft
- IEC61850_WordBits_SwapRight
- IEC61850ServerFB
- IEC_BACNET_ERROR_TO_STRING
- IEC_CYCLE_STRUCT
- IEC_STATE
- lecOpcUaMapping
- lecTaskCreate
- lecTaskCreate2
- lecTaskDelete2
- lecTaskDelete3
- lecTaskDisableScheduling
- lecTaskDisableWatchdog
- lecTaskDisableWatchdog2
- lecTaskEnableScheduling
- lecTaskEnableWatchdog
- lecTaskEnableWatchdog2
- lecTaskGetCurrent
- lecTaskGetDesc
- lecTaskGetFirst
- lecTaskGetInfo3
- lecTaskGetNext
- lecTaskGetProfiling
- lecTaskGetWatchdogHitCount
- lecTaskReload
- lecTaskResetStatistics
- lecVarAccBrowseCallback
- lecVarAccBrowseDirection
- lecVarAccBrowseDown2
- lecVarAccBrowseGetNext2
- lecVarAccBrowseRecursive
- lecVarAccBrowseUp2
- lecVarAccess
- lecVarAccessUaInformationModelMetaData
- lecVarAccExitVarInfo
- lecVarAccGetFirstInterface
- lecVarAccGetFirstInterface2
- lecVarAccGetNextInterface
- lecVarAccGetNextInterface2
- lecVarAccGetNode4
- lecVarAccGetNodeFullPath4
- lecVarAccGetNodeName4
- lecVarAccGetSymbolSetMask
- lecVarAccInitVarInfo
- lecVarAccInitVarInfo2
- lecVarAccInvalidVarInfo
- lecVarAccNodeInfoAddBrowseInfo
- lecVarAccNodeInfoAddReference
- lecVarAccNodeInfoGetBrowseInfo
- lecVarAccNodeInfoGetReference
● IecVarAccNodeInfoRemoveBrowseInfo
● IecVarAccNodeInfoRemoveReference
● IecVarAccRegisterInstance
● IecVarAccRegisterInstance2
● IecVarAccRegisterInstance3
● IecVarAccRegisterInstanceBase
● IecVarAccRegisterInstanceBase2
● IecVarAccSetSymbolconfigCrc
● IecVarAccSymbolSetDescription
● IecVarAccUnregisterInstance
● IecVarAccUpdateSymbolSets
● IEdgeTriggered
● IElement
● IEthernet
● IETrig
● IETrigA
● IETrigATl
● IETrigATlTo
● IETrigAto
● IETrigTo
● IETrigTl
● IETrigTlTo
● IETrigTo
● IExitActionProvider
● IExpandSubNodeAdapterSingleRelease
● IExternalUserDatabaseProvider
● IExternalUserDatabaseProvider2
● IFactory
● IFBCommand
● IFDBConfig
● IFileListProvider
● IFrame
● IFrameElement2
● IFrameElement3
● IFrameManager
● IFrameManager2
● IFrameManagerBase
● IGeneralCommand
● IGeneric
● IGestureEventHandler
● IGestureEventHandler2
● IGestureEventHandler3
● IGlobalClientManagerListener
● IGridProvider
● IHasContinuousBehaviour
● iEC61850_LogicalDevice
● IIecVarAccess
● IIecVarAccess10
● IIecVarAccess11
● IIecVarAccess12
● IIecVarAccess13
● IIecVarAccess14
● IIecVarAccess15
● IIecVarAccess2
● IIecVarAccess3
● IIecVarAccess4
- InitializeBACnetDateTime
- InitializeBACnetDateTimeUnspecified
- InitializeBACnetDevObjPropReference
- InitializeBACnetSetpointReference
- InitializeBACnetString
- InitializeBACnetTime
- InitializeBACnetTimeStamp
- InitializeEmptyPropertyInstance
- InitializePropertyInstance
- INode
- INode_TO_IBus
- INode_TO_IDevice
- INode_TO_IDevice2
- INode_TO_IStack
- INodeName
- INotificationClient
- InputDataSave
- INSERT
- Inspect_Heap
- InstanceBase
- InstanceData
- InstancePathBuildingBranchNode
- InstancePathBuildingNode
- InstancePathBuildingNodeType
- InstancePathNodeFinder
- INT64
- INT64_TO_DT
- INT64_TO_ISO8601
- INT64_TO_LOCALTIME
- INT64_TO_LTIME
- INT64_TO_REAL8
- INT64_TO_TIME
- INT64_TO_UTC
- INT_TO_BCD
- INT_TO_SIGNED
- INTEGRAL
- Integral
- IntElement
- IntElementFactory
- InterfaceVersion
- InternalState
- INullElement
- IO_PROD_ENTRY_READ
- IO_SYSTEM_TYPE
- IOBus_Download
- IOBus_GetBusInfo
- IOBus_GetBusStatistics
- IOBus_GetDownloadState
- IOBus_GetHotplugOK
- IOBus_GetODriverVersion
- IOBus_GetModState
- IOBus_GetModuleInfo
- IOBus_GetModuleLinkStatistics
- IOBus_GetModuleStatistics
- IOBus_GetModuleVersion
- IOBus_GetPlugged
- IOBus_GetProductionData
- IOBus_GetRun
- IOBUS_INFO
- IOBUS_LINKSTATISTICS
- IOBUS_MOD_STATE
- IOBUS_MODUL_STATE
- IOBUS_MODULINFO
- IOBUS_PARA_STATE
- IOBUS_PRODDATA
- IOBUS_STATISTICS
- IOBus_SwitchLinkStatistics
- IOBUS_TU_STATE
- IOBUS_VERSIONINFO
- IoCnt
- IoConfigChannelMap
- IoConfigConnector
- IoConfigConnectorMap
- IoConfigParameter
- IoConfigTaskMap
- IoDiag
- IoDriverVersion
- IoDrvAnalogBase
- IoDrvBase
- IoDrvCIFX
- IoDrvCIFXEthernetIP
- IoDrvCIFXEthernetIP_Diag
- IoDrvCIFXProfinetDevice
- IoDrvCIFXProfinetDeviceDiag
- IoDrvCM579EtherCAT
- IoDrvCM579EtherCATDiag
- IoDrvCM579Profinet
- IoDrvCM579ProfinetDiag
- IoDrvCM582Profinet
- IoDrvCM582ProfinetBusDiag
- IoDrvCM589Profinet
- IoDrvCM589ProfinetDiag
- IoDrvCM592Profinet
- IoDrvCM592ProfinetBusDiag
- IoDrvCM598
- IoDrvCM598Diag
- IoDrvCpuModuleDiag
- IoDrvDigitalOptionBoardBase
- IoDrvEtherCAT
- IoDrvEthercat_Diag
- IoDrvEtherCAT
- IoDrvEthernet
- IoDrvEthernetAC500
- IoDrvEthernetAC500Diag
- IoDrvEthernetDiag
- IoDrvEtherNetIP
- IoDrvEtherNetIP_Diag
- IoDrvEtherNetIPAdapter
- IoDrvEtherNetIPAdapter_Diag
- IoDrvInfo
- IoDrvIoBusModuleDiag
Configuration and programming
Libraries and solutions > Reference, function blocks

- IoDrvJ1939Diag
- IoDrvKNX
- IoDrvKNXDiag
- IoDrvOnboardEtherCAT
- IoDrvOnboardEtherCAT_Diag
- IoDrvOnboardIO
- IoDrvOnboardIODiag
- IoDrvS500ModuleDiag
- IoDrvSM560
- IoDrvSM560Diag
- IoDrvTA5101
- IoDrvTA5101Diag
- IoDrvTA5105
- IoDrvTA5105Diag
- IoDrvTA5110
- IoDrvTA5110Diag
- IoDrvTA5120
- IoDrvTA5120Diag
- IoDrvTA5122
- IoDrvTA5122Diag
- IoDrvTA5123
- IoDrvTA5123Diag
- IoDrvTA5126
- IoDrvTA5126Diag
- IoDrvTA5128
- IoDrvTA5128Diag
- IoInformation
- IOL AdditionalCode
- IOL AdjustableSwitchingSensor
- IOL AdSS Function
- IOL AdSS_Status
- IOL AdSS_TeachFunction
- IOL AdSS_TeachMode
- IOL CALL
- IOL DataStorage
- IOL DiagEntry
- IOL Error
- IOL ErrorCode
- IOL Event
- IOL EventCode
- IOL EventCode_Device
- IOL EventCode_Port
- IOL EventQualifier
- IOL EventQualifier_Instance
- IOL EventQualifier_Mode
- IOL EventQualifier_Source
- IOL EventQualifier_Type
- IOL FieldbusStatus
- IOL GetEvent_ChannelDiagnosis
- IOL GetEvent_UDINT
- IOL IdentificationAndDiagnosis
- IOL IdentificationAndDiagnosis_Function
- IOL IdentificationObjects
- IOL Index
- IOL IOLM_Info
- IOL_IOLM_InfoRecord
- IOL_IQ_Behavior
- IOL_MasterIdent
- IOL_MasterIdent_Features_1
- IOL_MasterType
- IOL_MeasurementDataChannel
- IOL_PN_PortControl
- IOL_PortConfigList
- IOL_PortConfiguration
- IOL_PortConfigurationRecord
- IOL_PortError
- IOL_PortMode
- IOL_PortQualityInfo
- IOL_PortStatus
- IOL_PortStatusInfo
- IOL_PortStatusList
- IOL_PortStatusRecord
- IOL_PortType
- IOL_PQI
- IOL_ProfileIdentifier
- IOL_TransmissionRate
- IOL_ValidationBackup
- IoMgrConfigGetConnector
- IoMgrConfigGetConnectorByDriver
- IoMgrConfigGetConnectorList
- IoMgrConfigGetDriver
- IoMgrConfigGetFirstChild
- IoMgrConfigGetFirstConnector
- IoMgrConfigGetFirstParameter
- IoMgrConfigGetNextChild
- IoMgrConfigGetNextConnector
- IoMgrConfigGetNextParameter
- IoMgrConfigGetParameter
- IoMgrConfigGetParameterValueByte
- IoMgrConfigGetParameterValueDword
- IoMgrConfigGetParameterValuePointer
- IoMgrConfigGetParameterValueWord
- IoMgrConfigResetDiagnosis
- IoMgrConfigSetDiagnosis
- IoMgrCopyInputBE
- IoMgrCopyInputLE
- IoMgrCopyOutputBE
- IoMgrCopyOutputLE
- IoMgrGetBusCycleType
- IoMgrGetConfigApplication
- IoMgrGetDriverProperties
- IoMgrGetFirstDriverInstance
- IoMgrGetModuleDiagnosis
- IoMgrGetNextDriverInstance
- IoMgrIdentify
- IoMgrLockEnter
- IoMgrLockLeave
- IoMgrReadInputs
- IoMgrReadParameter
- IoMgrReconfigure
- IPBSlaveDiag
- IPeer
- IPersistentRecipeListSupportsAdd
- IPoolExtender
- IPParameterValue
- IProvidesBitOffset
- IProvidesConcreteType
- IProvidesContainerSize
- IProvidesDifferentRemoteName
- IProvidesRootInfo
- IProvidesTabOrder
- IPseudoNode
- IPSTRING_TO_UDINT
- IPStringAndIntElement
- IPStringElement
- iPTOKernel
- IPv4Address
- IQueryInterfaceElement
- IQueue
- IQueue2
- IRecipeCheckOnStart
- IRecipeDefinition2
- IRecipeDefinition3
- IReconfigureProvider
- IRectangleListManager
- IRectangleListManager2
- IRectangleListManager3
- IRectangleListManager4
- IRectangleProvider
- IRequest
- IRequestResult
- IRequiresInitMeasureString
- IResetActionProvider
- IResolveCallbackHandler
- IRoleEtherCAT
- IRoleEtherCATMaster
- IRootAddressNodeWithDatasourceIndex
- IRow
- IRow2
- IRow3
- IRowAsync
- IRowBase
- IRowIdIterator
- IRowPlanchet
- IRowPlanchetAsync
- IRPCCLClient
- IRPCCLClientCallback
- IRPCProvider
- IRPCProviderCallback
- IRtsServiceHandler
- IRtsServiceHandler2
- Is29BitIdMessage
- IS_MULTICAST_GROUP
- IsAcceptedLeafNode
- ISampleActionProvider
- ISavepoint
- ISavepointAsync
- IsBACnetBACnetDateTimeUnspecified
- IsBACnetDateTimeUnspecified
- IsBACnetObjectAMEVCreatable
- IsBACnetPropertyAMEVASBWritable
- IsBroadcast
- IScrollValueProvider
- ISearchCallbacks
- ISegment
- ISegmentPool
- ISelectableInside
- ISelectionManager
- IServer
- IServiceReader
- IServiceWriter
- IsHandleValid
- ISimpleList
- ISimpleTree
- IsInvalidMemoryAddress
- ISizeProvider
- IsLeapYear
- IsLegalUTF8
- IsLibReleased
- IsLRealNaN
- IsLRealNegInfinity
- IsLRealNumber
- IsLRealPosInfinity
- ISO8073_FB
- ISO8327_FB
- ISO8327_ReadHeader
- ISO8601
- ISO8601_TO_DT
- ISO8601_TO_LTIME
- ISO8601_TO_TIME
- ISO8650_FB
- ISO8823_FB
- ISOLayer_FB
- ISortedList
- ISortedList2
- IsP2P
- ISpecialEventHandler
- IsRealNaN
- IsRealNegInfinity
- IsRealNumber
- IsRealPosInfinity
- IsRTRMessage
- IsSendingActive
- IsSpaceCharacter
- IStack
- IStack2
- IStartActionProvider
- IStorage
- IStorage2
• IStorageAsync
• IsTransmitMessage
• IStream
• IStringElement
• ISupportsRealDrawing
• ISwipeableFrame
• ITable
• ITable2
• ITable3
• ITable4
• ITableAsync
• ITaskFinishedCallback
• ItemAccess
• ItemName
• ItemNameType
• ITempShutdownResult
• ItemQuality
• ITextListInfo
• ITextListWrapper
• ITimeElement
• ITimeLimited
• ITimeOutConstraint
• ITimingControlled
• ITimingController
• ITLSContext
• ITraceAddressInfoWriter
• ITransaction
• ITransactionAsync
• ITransformationImplProvider
• ITree
• ITreeNode
• ITreeWalker
• ITrendRecording2
• ITrendRootPageManager2
• ITrendStorageAccessReadOperator
• ITrendStorageAccessReadOperator2
• ITrendStorageReaderConsumer
• ITrendStorageWriter4
• ITrendStorageWriterListener
• ITSNContext
• ITypedElement
• ITypeDesc
• ITypeDesc2
• ITypeDesc3
• ITypeDesc4
• ITypeDescExecutable
• ITypeDescSubrange
• ITypeDescWithAttributes
• ITypeDescWithBaseType
• ITypeDescWithReferenceType
• ITypedList
• ITypedTree
• IUdintElement
• IUlntElement
• IUlntElement
- IUseDataContextSubNodes
- IUserConfiguration
- IUserMgmtEventHandler
- IValueChangedListener
- IVariableInfoCollectsSpecialAddressInfos
- IVariableInfoCollectsToplevelAddressInfo
- IVariableInformation
- IVariableInformation2
- IVariableInformation3
- IVariableInformation4
- IVariableInformation5
- IVerifyCertCallback
- IVisualElementLayer
- IVisualElementOfflineScaling
- IVisualElementProvidesChildElements
- IVisualElementProvidesSubElements
- IVisualElementWithoutBlobInit
- IVisualisationAccessRights
- IVisualizationClient
- IVisualizationClientFilter
- IVisualizationClientIteration
- IVisualizationClientRaw
- IVisualizationStyle
- IVisualTableColumnSimpleBase
- IVisuGlobalClientManager2
- IVisuGlobalClientManager3
- IVisuManager
- IVisuManager2
- IVisuManager3
- IVisuManagerBase
- IVisuStreamFileNameInfo
- IVisuStreamReader
- IVisuStreamSetFileName
- IVisuStreamWriter
- IVisuUserEventManager
- IVisuUserManagement
- IVisuUserManagement2
- IVisuUserManagement3
- IVisuUserManagement4
- IVisuUserMgmt
- IVisuUserMgmt2
- IVisuUserMgmt3
- IVisuUserMgmt4
- IVisuUserMgmtCyclicCall
- IVisuUserMgmtProvider
- IWORKER
- IWStringElement
- IXYChartAlloc
- IXYChartDataProvider
- IXYChartDataProvider2
- IXYChartDataProvider3
- IXYChartDataProviderAxis
- IXYChartDataProviderCurve
- IXYChartDataProviderCurveChecker
- IXYChartFont
- IXYChartGenericVariable
- IXYChartGenericVariable2
- IXYChartStringApproxMeasurer
- IXYChartVisuStructLevelLine
- J1939ECUBase
- J1939LocalECU
- J1939LocalECUDiag
- J1939RemoteECU
- J1939RemoteECUDiag
- Jitter_Distribution
- JOB_STATE
- JobAbort
- JobClass
- JobClose
- JobExecute
- JobGetId
- JobGetParams
- JobGetState
- JobOpen
- JobOpenEx
- JobReset
- JobSetState
- JoinDateTime
- JSON_ARR_REF
- JSON_OBJ_REF
- JsonAddArray
- JsonAddBool
- JsonAddInt
- JsonAddObject
- JsonAddReal
- JsonAddString
- JsonArrayAddArray
- JsonArrayAddBool
- JsonArrayAddInt
- JsonArrayAddObject
- JsonArrayAddReal
- JsonArrayAddString
- JsonArrayGetArray
- JsonArrayGetBool
- JsonArrayGetInt
- JsonArrayGetObject
- JsonArrayGetReal
- JsonArrayGetString
- JsonArrayRemoveEntry
- JsonCreateArray
- JsonCreateObject
- JsonFreeArray
- JsonFreeObject
- JsonGetArray
- JsonGetBool
- JsonGetInt
- JsonGetObject
- JsonGetReal
- JsonGetString
- JsonParseArrayFromString
- JsonParseObjectFromString
- JsonRemoveEntry
- JsonSerializeArray
- JsonSerializeObject
- KeyValueCollection
- LAMP_FLASH
- LAMP_INFO
- LAMP_STATUS
- LargeReadRequest
- LargeWriteRequest
- LatchValue
- LCon
- LConC
- LConTI
- LConTIC
- LConTTTo
- LConTo
- LCTD
- LCTU
- LCTUD
- LeafTreeNode
- LeafTreeNodeOpcUA
- LeafTreeNodeTypeMember
- LeafTreeNodeTypeMemberOpcUA
- LED_ID
- LEFT
- LegacyRTSVisuStructEvent2
- LEN
- LicenseFunctions
- LIMITALARM
- LimitAlarm_DINT
- LimitAlarm_LREAL
- LIN_TRAFO
- LINE_3D
- LinearTrafo
- LinkedList
- LinkedListElementBase
- LinkedListFactory
- LinkedListIterator
- LinkState_Link
- LINT_TO_SIGNED
- LintElement
- LintElementFactory
- List
- ListBase
- Listener
- ListFactory
- ListIterator
- ListOfDevices
- Load_Ref
- LocalDateTime
- LOG_ENTRY
- LOG_ENUM_STATE
- LogAdd
- LogAdd2
- LogClose
- LogComponent
- LogCreate
- LogDelete
- LogFileDelete
- LogFileReduce
- LogGeneric Input
- LogGeneric Output
- LOGGER_MODE
- LoggingHelper
- LogHandling
- LogIec60870 Input
- LogIec60870 Output
- LogMultifile
- LogOpen
- LogOptions
- LogToDevice
- LostMessages
- LowByte
- LowWord
- LREAL_TO_FLOAT
- LRealToHexStr
- LRealToStr
- LTIME_TO_DURATION
- LTIME_TO_INT64
- LTIME_TO_ISO8601
- LTIME_TO_REAL8
- LTOF
- LTON
- LTP
- LTrig
- LWOR...
- LWORD_TO_HANDLE
- LWORD_TO_PVOID
- MAC_ADDRESS_COMPARE
- MAKE_EVENTID
- MakeNormed3D
- MappingDesc_ArrayArbitrary
- MappingDesc_ArraySubRange
- MATH_FFT
- MATH_INPUT_SHAPER_ZV
- MATH_INPUT_SHAPER_ZVD
- MATH_LINEAR_REGRESSION
- MATH_MOVING_AVG
- MATH_NOTCH_FILTER
- MAUType
- MC_ABB_iTypes_Enum
- MC_AccelerationProfile
- MC_BufferMode
- MC_Cam_Id
- MC_CamIn
- MC_CamOut
- MC_CamTableSelect
- MC_CombineAxes
- MC_Direction
- MC_GearIn
- MC_GearInPos
- MC_GearOut
- MC_Halt
- MC_HaltPhasing
- MC_HaltSuperImposed
- MC_Homing_Direction
- MC_Homing_Edge
- MC_Homing_Mode
- MC_LimitLoad
- MC_LimitMotion
- MC_LoadControl
- MC_LoadProfile
- MC_LoadSuperimposed
- MC_MoveAbsolute
- MC_MoveAdditive
- MC_MoveContinuousAbsolute
- MC_MoveContinuousRelative
- MC_MoveRelative
- MC_MoveSuperImposed
- MC_MoveVelocity
- MC_PhasingAbsolute
- MC_PhasingRelative
- MC_PositionProfile
- MC_Power
- MC_PProfile
- MC_ReadActualPosition
- MC_ReadActualVelocity
- MC_ReadAxisError
- MC_ReadBoolParameter
- MC_ReadParameter
- MC_ReadStatus
- MC_Reset
- MC_SetOverride
- MC_SetPosition
- MC_Source
- MC_StepAbsSwitch
- MC_StepDirect
- MC_StepLimitSwitch
- MC_StepRefPulse
- MC_Stop
- MC_TorqueControl
- MC_TProfile
- MC_VelocityProfile
- MC_WriteBoolParameter
- MC_WriteParameter
- MCA_Cam_EXTRA
- MCA_CamBounds
- MCA_CamEditor
- MCA_CamEditorControlStruct
- MCA_CamEditorFeedbackStruct
- MCA_CamGetInterpolationPosition
- MCA_CamGetInterpolationValues
- MCA_CamInDirect
- MCA_CamInfo
- MCA_CamStructureSelect
- MCA_CAMTappet
- MCA_CamTappet
- MCA_DigitalCamSwitch
- MCA_doWrap
- MCA_DriveBasedHome
- MCA_DriveCheckReadyToEnable
- MCA_DriveEnableImmediateApply
- MCA_DriveParametersSave
- MCA_DriveSetOperatingMode
- MCA_EncoderAxisMotionState
- MCA_GearInDirect
- MCA_GetCamMasterPhase
- MCA_GetE1x0DriveErrorDescription
- MCA_GetTappetValue
- MCA_HomeAbsSwitch
- MCA_HomeLimitSwitch
- MCA_HomeToTorque
- MCA_HomeToTouchProbe
- MCA_Indexing
- MCA_JogAxis
- MCA_LinkOption
- MCA_MoveBuffer
- MCA_MoveByExternalReference
- MCA_MoveByExtRefRelative
- MCA_MoveFeed
- MCA_MoveLink
- MCA_MoveMode
- MCA_MoveRelativeOpti
- MCA_MoveVelocity_PV
- MCA_MoveVelocityContinuous
- MCA_Parameter
- MCA_Parameter_Struct
- MCA_PhasingByMaster
- MCA_Pos_Ref
- MCA_QuickStop
- MCA_ReadCamFile
- MCA_ReadCamTablePoint
- MCA_ReadParameterList
- MCA_ReadTappetTablePoint
- MCA_SetOperatingMode
- MCA_SetPositionContinuous
- MCA_TappetAction
- MCA_TappetType
- MCA_TorqueControl_CSTOL
- MCA_TorqueControl_PT
- MCA_TouchProbeECAT
- MCA_TouchProbeECATFiltering
- MCA_TouchProbeOBIO
- MCA_WriteCamFile
- MCA_WriteCamTablePoint
- MCA_WriteParameterList
- MCA_WriteTappetTablePoint
- MCA_XYGroupCircMode
- MCA_XYGroupEnable
- MCA_XYGroupHome
- MCA_XYGroupHomingSequence
- MCA_XYGroupPause
- MCA_XYGroupReset
- MCA_XYGroupState
- MCA_XYGroupStop
- MCA_XYMoveCircular
- MCA_XYMoveLinear
- MD5
- MD5_FF
- MD5_GG
- MD5_HH
- MD5_I
- MD5_Transform
- MeasureFrequency
- MeasuringPoint
- MemBuffer
- MemCmp
- MemCpy
- MemFill
- MemForceSwap
- MemMove
- MemoryManager
- MemoryToString
- MemSet
- MESSAGE
- MessageBox_Struct
- MessageBoxDialog_Types
- METRICS
- MID
- MILLISECOND
- MinMaxLabels
- MINUTE
- Mod_Client_FCT23
- MODE
- ModRtuGenDevDataType
- ModRtuGenDevDataTypeInternal
- ModRtuMast
- ModRtuMastDev
- ModRtuMastTypeInternal
- ModRtuRead
- ModRtuReadWrite23
- ModRtuToken
- ModRtuTokenDev
- ModRtuTokenType
- ModRtuWrite
- ModTcpConfig
- ModTcpInfo
- ModTcpMast
- ModTcpMast2
- ModTcpServOnOff
- Module
- Module_Diag
- MODULESTATE
- ModuleState
- ModuleStatus
- MonitorDBStatus
- MonitorFilterByDateTime
- MonitorFilterByLatch
- Monitoring2ByteCode
- Monitoring2ByteCodeUnion
- MonitoringService
- MonitoringServiceHelper
- MonitoringState
- MonitorPopulateFilterCriteria
- MonLog_Binary
- MonLog_CurrentTime
- MonLog_DumpDataItem
- MonLog_DumpDataItemBase
- MonLog_DumpDataItemWriting
- MonLog_Error
- MonLog_ErrorAndClose
- MonLog_LogLine
- MonLog_OkAndClose
- MONTH
- MQTT_CONNECTION
- MQTT_MESSAGE
- MQTT_QOS
- MqttConnectWithCertBuffer
- MqttConnectWithCertFile
- MqttConnectWithCertStore
- MqttDisconnect
- MqttGetReceivedPacket
- MqttPing
- MqttPublish
- MqttSubscribe
- MqttUnsubscribe
- MRC_PortState
- MsgAddRef
- MsgClass
- MsgClone
- MsgGetData
- MsgGetRXChg
- MsgReceive
- MsgRelease
- MsgReleaseEx
- MsgSend
- MSK_ECM_IF_EXT_SYNC_INFO_FLAGS
- NamedTreeNode
- NamespaceNodeFlags
- NCAPDUFaultStatus
- NestingPathEntry
- NestingPathInformation
- NET_INFO
- NetClientCloseChannel
- NetClientCloseChannelResult
- NetClientSend
- NetDiagnosis
- NetVarDataItem_Udp
● NetVarManager_Udp_FB
● NetVarOD_Service_Udp
● NetVarPDO_Rx_Udp
● NetVarPDO_Tx_Udp
● NetVarTelegramm_Udp
● NetVarTlgHeader_Udp
● NetVarUDPDiagStruct
● NetVarUDPError
● NetworkScanSettings
● NETX_DEV_DIAG
● NETX_SYSTEM_CHANNEL
● NETX_UDINT_TO_STRINGHEX
● NetxEcallInit
● NetxEcallsCompatible
● NMT
● NMT_ERROR_BEHAVIOUR
● NodeFlags
● NOP
● Norm3D
● NSC_AddrComponent
● NSC_CompleteNodeInfo
● NSC_NodeAddress
● NSC_NodeInfoExt
● NSC_NodeInfoInt
● NSClientClose
● NSClientGeneralResolveCallback
● NSClientOpen
● NSClientResolveAll
● NSClientSearchNodeFlags
● NSClientSysMemAllocator
● NSClientTaskBase
● NSClientTaskResolveAllNodes
● NSClientTaskSearchForSpecificNode
● NSClientUtil_DumpAddress
● NSClientUtil_DumpAddressHelp
● NSClientUtil_DumpCallback
● NSClientUtil_DumpNodeId
● NSClientUtil_DumpStartSearchNodeParams
● NSClientUtil_Log1
● NSClientUtil_Log2
● NSClientUtil_Log3
● NSClientWrapper
● NtpSourceInfoData
● NtpSourceMode
● NtpSourceState
● NullElement
● OBIO_PTO_Motion_Parameter
● OBIO_PTOMotionKernel
● OBIO_PTOSingleLineMotionKernel
● OBIO_PWM_Motion_Parameter
● OBIO_PWMMotionKernel
● OBIOBasicPoint2Point
● OBIOEncoderCounter
● OBIOForwardCounter
● OBIOFreqOut
- `OpcUa_EnumValueType`
- `OpcUa_EUInformation`
- `OpcUa_EventFieldList`
- `OpcUa_EventFilter`
- `OpcUa_EventFilterResult`
- `OpcUa_EventNotificationList`
- `OpcUa_ExpandedNodeId`
- `OpcUa_ExtensionObject`
- `OpcUa_ExtensionObject_Body`
- `OpcUa_ExtensionObjectEncoding`
- `OpcUa_FilterOperator`
- `OpcUa_FindServersOnNetworkRequest`
- `OpcUa_FindServersOnNetworkResponse`
- `OpcUa_FindServersRequest`
- `OpcUa_FindServersResponse`
- `OpcUa_Float`
- `OpcUa_GenericAttributes`
- `OpcUa_GenericAttributeValue`
- `OpcUa_GetEndpointsRequest`
- `OpcUa_GetEndpointsResponse`
- `OpcUa_Guid`
- `OPcUa_Handle`
- `OpcUa_HistoryData`
- `OpcUa_HistoryEvent`
- `OpcUa_HistoryEventFieldList`
- `OpcUa_HistoryModifiedData`
- `OpcUa_HistoryReadRequest`
- `OpcUa_HistoryReadResponse`
- `OpcUa_HistoryReadResult`
- `OpcUa_HistoryReadValueId`
- `OpcUa_HistoryUpdateDetails`
- `OpcUa_HistoryUpdateRequest`
- `OpcUa_HistoryUpdateResponse`
- `OpcUa_HistoryUpdateResult`
- `OpcUa_HistoryUpdateType`
- `OpcUa_IdentifierType`
- `OpcUa_Int`
- `OpcUa_Int16`
- `OpcUa_Int32`
- `OpcUa_Int64`
- `OpcUa_IssuedIdentityToken`
- `OpcUa_LiteralOperand`
- `OpcUa_LocalizedText`
- `OpcUa_MdnsDiscoveryConfiguration`
- `OpcUa_MessageSecurityMode`
- `OpcUa_MethodAttributes`
- `OpcUa_ModelChangeStructureDataType`
- `OpcUa_ModificationInfo`
- `OpcUa_ModifyMonitoredItemsRequest`
- `OpcUa_ModifyMonitoredItemsResponse`
- `OpcUa_ModifySubscriptionRequest`
- `OpcUa_ModifySubscriptionResponse`
- `OpcUa_MonitoredItemCreateRequest`
- `OpcUa_MonitoredItemCreateResult`
- `OpcUa_MonitoredItemModifyRequest`
- OpcUa_RolePermissionType
- OpcUa_SamplingIntervalDiagnosticsDataType
- OpcUa_SByte
- OpcUa_SecurityTokenRequestType
- OpcUa_SemanticChangeStructureDataType
- OpcUa_ServerDiagnosticsSummaryDataType
- OpcUa_ServerOnNetwork
- OpcUa_ServerState
- OpcUa_ServerStatusDataType
- OpcUa_ServiceCounterDataType
- OpcUa_ServiceFault
- OpcUa_SessionDiagnosticsDataType
- OpcUa_SessionlessInvokeRequestType
- OpcUa_SessionlessInvokeResponseType
- OpcUa_SessionSecurityDiagnosticsDataType
- OpcUa_SetMonitoringModeRequest
- OpcUa_SetMonitoringModeResponse
- OpcUa_SetPublishingModeRequest
- OpcUa_SetPublishingModeResponse
- OpcUa_SetTriggeringRequest
- OpcUa_SetTriggeringResponse
- OpcUa_SignatureData
- OpcUa_SignedSoftwareCertificate
- OpcUa_SimpleAttributeOperand
- OpcUa_StatusChangeNotification
- OpcUa_StatusCode
- OpcUa_StatusResult
- OpcUa_String
- OpcUa_StructureDefinition
- OpcUa_StructureField
- OpcUa_StructureType
- OpcUa_SubscriptionAcknowledgement
- OpcUa_SubscriptionDiagnosticsDataType
- OpcUa_TimestampsToReturn
- OpcUa_TimeZoneDataType
- OpcUa_TransferResult
- OpcUa_TransferSubscriptionsRequest
- OpcUa_TransferSubscriptionsResponse
- OpcUa_TranslateBrowsePathsToNodeIdsRequest
- OpcUa_TranslateBrowsePathsToNodeIdsResponse
- OpcUa_UInt
- OpcUa_UInt16
- OpcUa_UInt32
- OpcUa_UInt64
- OpcUa_UnregisterNodesRequest
- OpcUa_UnregisterNodesResponse
- OpcUa_UpdateDataDetails
- OpcUa_UpdateEventDetails
- OpcUa_UpdateStructureDataDetails
- OpcUa_UserIdentityToken
- OpcUa_UserNameIdentityToken
- OpcUa_UserTokenPolicy
- OpcUa_UserTokenType
- OpcUa_VariableAttributes
- OpcUa_VariableTypeAttributes
- `OpcUa_Variant`
- `OpcUa_VariantArrayType`
- `OpcUa_VariantArrayUnion`
- `OpcUa_VariantArrayValue`
- `OpcUa_VariantMatrixValue`
- `OpcUa_VariantUnion`
- `OpcUa_ViewAttributes`
- `OpcUa_ViewDescription`
- `OpcUa_WriteRequest`
- `OpcUa_WriteResponse`
- `OpcUa_WriteValue`
- `OpcUa_X509IdentityToken`
- `OpcUa_XVariant`
- `OpcUa_ApplicationDescriptionClear`
- `OpcUa_ApplicationDescriptionInitialize`
- `OpcUa_BrowsePathClear`
- `OpcUa_BrowsePathInitialize`
- `OpcUa_BrowsePathResultClear`
- `OpcUa_BrowsePathResultInitialize`
- `OpcUa_BrowseResultClear`
- `OpcUa_BrowseResultInitialize`
- `OpcUa_ByteStringClear`
- `OpcUa_ByteStringConcatenate`
- `OpcUa_ByteStringCopyTo`
- `OpcUa_ByteStringInitialize`
- `OPCUA_Client_Browse`
- `OPCUA_Client_BrowseNext`
- `OPCUA_Client_Call`
- `OPCUA_Client_Connect`
- `OPCUA_Client_Create`
- `OPCUA_Client_CreateMonitoredItems`
- `OPCUA_Client_CreateSubscription`
- `OPCUA_Client_Delete`
- `OPCUA_Client_DeleteMonitoredItems`
- `OPCUA_Client_DeleteSubscription`
- `OPCUA_Client_Disconnect`
- `OPCUA_Client_FindServers`
- `OPCUA_Client_GetConfig`
- `OPCUA_Client_GetEndpoints`
- `OPCUA_Client_ModifyMonitoredItems`
- `OPCUA_Client_ModifySubscription`
- `OPCUA_Client_RegisterNodes`
- `OPCUA_Client_SetDataChangeFilterStatic`
- `OPCUA_Client_SetEventFilterStatic`
- `OPCUA_Client_SetMonitoringMode`
- `OPCUA_Client_SetPublishingMode`
- `OPCUA_Client_TranslateBrowsePathsToNodeIds`
- `OPCUA_Client_UnregisterNodes`
- `OPCUA_Client_Write`
- `OPCUA_Client_ConnectionConfiguration`
- `OPCUA_Client_ConnectionState`
- `OPCUA_Client_Credentials`
OPCUA Client Monitored Item Configuration
OPCUA Client Monitored Item State
OPCUA Client Subscription State
OPCUA Client User Token
OpcUa Data Type Description
OpcUa Data Value Clear
OpcUa Data Value Compare
OpcUa Data Value Copy To
OpcUa Data Value Initialize
OpcUa DateTime Utc Now
OpcUa Element Description
OpcUa Endpoint Description Clear
OpcUa Endpoint Description Initialize
OpcUa Event Field List Clear
OpcUa Event Field List Initialize
OpcUa Event Notification List Clear
OpcUa Event Notification List Initialize
OpcUa Expanded Node Id Clear
OpcUa Expanded Node Id Compare
OpcUa Expanded Node Id Copy To
OpcUa Expanded Node Id Initialize
OpcUa Expanded Node Id Is Null
OpcUa Extension Object Clear
OpcUa Extension Object Compare
OpcUa Extension Object Copy To
OpcUa Extension Object Create
OpcUa Extension Object Delete
OpcUa Extension Object Initialize
OpcUa Localized Text Clear
OpcUa Localized Text Compare
OpcUa Localized Text Copy To
OpcUa Localized Text Initialize
OpcUa Meta Data Type
OpcUa Method Description
OpcUa Method Meta Data
OpcUa Node Id Clear
OpcUa Node Id Compare
OpcUa Node Id Copy To
OpcUa Node Id Initialize
OpcUa Node Id Is Null
OpcUa Node Meta Data
OpcUa Object Description
OpcUa Object Type Description
OpcUa Own Data Type Meta Data
OpcUa Qualified Name Clear
OpcUa Qualified Name Compare
OpcUa Qualified Name Copy To
OpcUa Qualified Name Initialize
OpcUa Read Value Id Clear
OpcUa Read Value Id Initialize
OpcUa Reference Description Clear
OpcUa Reference Description Initialize
OpcUa Reference Type Description
OpcUa Server Message Security Mode
OpcUa Server Session Information
- OpcUaServer_SessionEvents
- OpcUaServerGetFirstSession
- OpcUaServerGetNextSession
- OpcUaServerGetSessionInfo
- OpcUaServerNodeDescription
- OpcUaServerOnNetworkClear
- OpcUaServerOnNetworkInitialize
- OpcUaServerReferenceDescription
- OpcUaSimpleAttributeOperandClear
- OpcUaSimpleAttributeOperandInitialize
- OpcUaStackDecodeGetPosition
- OpcUaStackDecodeSetPosition
- OpcUaStackDecodeValue
- OpcUaStackEncodeGetPosition
- OpcUaStackEncodeSetPosition
- OpcUaStackEncodeValue
- OpcUaStackFinishDecode
- OpcUaStackFinishEncode
- OpcUaStackStartDecode
- OpcUaStackStartEncode
- OpcUaStatusChangeNotificationClear
- OpcUaStatusChangeNotificationInitialize
- OpcUaStatusCodeToString
- OpcUaStringAttachCopy
- OpcUaStringAttachReadOnly
- OpcUaStringAttachToString
- OpcUaStringClear
- OpcUaStringGetRawString
- OpcUaStringInitialize
- OpcUaStringIsEmpty
- OpcUaStringIsNull
- OpcUaStringStrLen
- OpcUaStringStrnCat
- OpcUaStringStrnCmp
- OpcUaStringStrnCpy
- OpcUaStringStrSize
- OpcUaTypeMetaData
- OpcUaTypeMetaDataUnion
- OpcUaVariableDescription
- OpcUaVariableTypeDescription
- OpcUaVariantClear
- OpcUaVariantCompare
- OpcUaVariantCopyTo
- OpcUaVariantInitialize
- OpcUaViewDescription
- OpcUaWellKnownDataTypeMetaData
- Open
- OpenChangePasswordDialog
- OpenChangePasswordDialog2
- OpenLoginDialog
- OpenLoginDialog2
- OpenUserManagementDialog
- OpenUserManagementDialog2
- OPERATION
- OPERATION_FWK_ACCESS_ADDRESS
• OPERATION_FWK_ACCESS_CONFIG
• OPERATION_FWK_ACCESS_PARAMETER
• OPERATION_FWK_CALLINFO
• OPERATION_FWK_GET_DEV_STATUS_PARAMETER
• OPERATION_FWK_SEND_COMMAND
• OPERATION_FWK_SEND_PARAMETER
• OPERATION_FWK_SET_PARAMETER
• OPERATION_FWK_START_SCAN
• OPERATION_FWK_STATUS_PARAMETER
• OPERATION_FWK_TEST_ADDRESS
• OPTION
• OS
• OurVarInfo
• PACK
• PackArrayOfBoolToArrayOfByte
• PackBitsToByte
• PackBitsToDword
• PackBitsToWorld
• PackBytesToDword
• PackBytesToWorld
• PacketPool
• PacketQueue
• PacketReader
• PacketWriter
• PackWordsToDword
• Pair_DintDint
• Pair_PStringDint
• Pair_PStringXWORD
• Pair_StringDint
• Pair_StringString
• PARAMETER
• PARAMETERS_INPUT_SHAPING_TYPE
• PARITY
• ParseCANID
• ParsePGN
• PB_SlaveActivation
• PB_SlaveConfigurationData
• PCB
• PD
• PERIOD
• PERIODE
• PERIODE_INFO
• PersistantItemListUsage
• PFSYS_TASK_EXCEPTIONHANDLER
• PFSYS_TASK_FUNCTION
• PG_TYPE
• PID
• PID_FIXCYCLE
• PingRequest
• PINGROUP
• PLANE_H
• plc
• PLC_IDENT
• PlcAbsoluteAddressInfo
• PlcAddressInfo
- PlcAddressInfoType
- PlcAddressInfoUnion
- PlcAppIdentification
- PlcConnectionInitFlags
- PlcCredentialInfo
- PlcCredentials
- PlcCryptType
- PlcDataItemAccess
- PlcDataItemQuality
- PlcDataItemQualityInfo
- PlcDataItemType
- PlcOperationControl
- PlcPropertyByCallAddressInfo
- PM_VERSION
- PmBatt
- PmDiskLifetimeUsed
- PmDiskStatus
- PmDiskWriteProtection
- PmDispSetText
- PmEcoResetFRAM
- PmEnLedSet
- PmGetDeviceState
- PmGetPlcId
- PmLedSet
- PmNtpInfo
- PmpAntiJam
- PmpConfiguration
- PmpDolSimu
- PmpDriveSimu
- PmpEnergyCalc
- PmpFlowCalcHQ
- PmpFlowCalcPQ
- PmpFlowDistributor
- PmpInterfaceDol
- PmpInterfaceVFD
- PmpPlcReboot
- PmpLevelComparator
- PmpLevelDistributor
- PmpMaintenance
- PmpPid
- PmpPressureDistributor
- PmpProtectionAnalog
- PmpProtectionBinary
- PmProdRead
- PmProdReadAsync
- PmpSequenceGen
- PmpSleep
- PmpSoftFilling
- PmpStationType
- PmpTankSimu
- PmpRealtimeClock
- PmpRealtimeClockDT
- PmpSntpInfo
- PmSramCleared
- PmSramExport
- Port
- PostEvent
- Printf
- PrintfW
- private_iomgr_memcpy
- PROC_CMD
- PROC_STATE
- ProfinetByteData
- ProfinetConfigType
- ProfinetController
- ProfinetControllerDiag
- PROJECT_INFO
- ProjectPointOnLine
- ProjectPointOnPlane
- PropertyAddressInfo
- PropertyAddrString
- PropertyAttributeExistenceString
- PropertyAttributePersistentString
- PropertyAttributesString
- PropertyAttributeWritableString
- PropertyIndexAddrString
- PropertyInfo
- PropertyInfoRemote
- PropertyLocation
- PROTOCOL_DATA_UNIT
- ProtocolDataUnit
- ProxyEnumState
- ProxyFbHistActiveAlarmsQueue
- ProxyFbHistAlarmsRowQueue
- ProxyStructError
- ProxyStructMonitor
- ProxyStructMonitorAlarmClassDesc
- ProxyStructMonitorAlarmDesc
- ProxyStructMonitorAlarmGroupDesc
- ProxyStructMonitorRequest
- prvCheckUserMgrIsActive
- prvGetTags
- PRVREC
- PRVREC_MODE
- PStrCat
- PStrCmp
- PStrCmp
- PStrFind
- PStringElement
- PStringElementFactory
- PStringToDintMap
- PStringToXWORDMap
- PStringVector
- PStrLen
- PStrLenUntil
- PStrNIcmp
- PStrToUpper
- PT_SIZE
- PtrToString
- PURPOSE
- PUTBIT
- PVOID
- PVOID TO DWORD
- PVOID TO LWORD
- PVOID TO WORD
- QOS_INFO
- Queue
- QueueFactory
- QuickSortAddrItemHelpers
- R TRIG
- RALARM
- RALARM_MODE
- RAMP_INT
- RAMP_REAL
- RCVREC
- RCVREC_MODE
- RCX_SET_WATCHDOG_TIME_CNF_T
- RCX_SET_WATCHDOG_TIME_REQ_DATA_T
- RCX_SET_WATCHDOG_TIME_REQ_T
- RDIAG
- RDREC
- Read
- ReadArbitraryStringFromBuffer
- ReadEEpromData
- ReadIdentification
- ReadMemory
- ReadNbrSlaves
- ReadRequest
- ReadWriteEEprom
- REAL8
- REAL8_TO_DT
- REAL8_TO_LTIME
- REAL8_TO_TIME
- REAL_TO_FLOAT
- RealToHexStr
- RealToStr
- ReceiveParameterGroup
- ReceiveWatchdog
- Recipe_FileParameters
- RecipeMan_FctTypeClassToDataType
- RecipeManCommands
- Reconfigure
- RECV_EMCY
- RECV_EMCY_DEV
- RedundancyManager
- RedundancyState
- RegContext
- Register
- RegisterCallback
- RegisterIdArea
- RemoteAdapter
- RemoteAdapter_Diag
- RemoteAdapter_diag
- RemotePlcRequestIdentification
- RemoteProcedureCall
- RTCLK_PERIOD_INFO
- RTCLK_SETDATEANDTIME_PARAMS
- RTCLK_SETTIMEZONEINFORMATION_PARAMS
- RTCLK_SYSTEMTIME
- RTCLK_TIME_ZONE_INFO
- RTR.AddrComponent
- RTR.NodeAddress
- RTS_CMBOXENTRY
- RTS_CODEMETER_INFO
- RTS_CONTROL
- RTS_IEC_CWCHAR
- RTS_IEC_HANDLE
- RTS_IEC_RESULT
- RTS_IEC_SIZE
- RTS_SOCKET_SO_VALUE_IP_MREQ
- RTS_SOCKET_SO_VALUE_LINGER
- RTS_SOCKET_SO_VALUE_TCP_KEEPALIVE
- RTS_SYSTIMEDATE
- RtsBrowseInfo
- RtsByteString
- RtsCertEncoding
- RtsCertTrustLevel
- RtsCryptoID
- RtsCryptoKey
- RtsCryptoKeyStorage
- RtsCryptoKeyType
- RtsKdfParameter
- RtsOID
- RtsOIDClear
- RtsOIDCreate
- RtsOIDGetID
- RtsOIDGetName
- RtsOIDStore
- RtsScryptParameter
- RtsServicehandlerBase
- RtsServicehandlerBase2
- RtsX509AltName
- RtsX509AltNameStore
- RtsX509AltNameType
- RtsX509CertCheckFlags
- RtsX509CertFilter
- RtsX509CertFilterContent
- RtsX509CertFilterType
- RtsX509CertInfo
- RtsX509CertName
- RtsX509ExKeyUsage
- RtsX509NameEntry
- RtsX509VerifyFlags
- RXChgGetCurCapacity
- RXChgGetMsgSize
- S_ALLOC
- SAdapterFlags
- SafeStringCopy
- SALARM
- ScalProd3D
- ScalProd3DStand
- ScannerState
- SchedGetCurrentTask
- SchedGetNumOfTasks
- SchedGetProcessorLoad
- SchedGetTaskEventByHandle
- SchedGetTaskHandleByIndex
- SchedGetTaskHandleByName
- SchedGetTaskInterval
- SchedPostExternalEvent
- SchedRegisterExternalEvent
- SchedSetTaskInterval
- Schedule
- SchedUnregisterExternalEvent
- SchedWaitBusy
- SchedWaitSleep
- SDO_ABORT
- SDO_ERROR
- SDO_MODE
- SDO_READ
- SDO_READ4
- SDO_READ_DATA
- SDO_WRITE
- SDO_WRITE4
- SDO_WRITE_DATA
- SdoAbort
- SdoRead
- SdoWrite
- SECOND
- Segment
- SegmentPool
- Select
- SEMA
- SendEvent
- SeparateDateTime
- SerializeHexReal
- ServiceGroup
- SERVICEHANDLER_PARAMETER
- ServiceHeader
- ServiceReader
- ServiceRequest
- ServiceRequestBase
- ServiceRequestRaw
- ServiceResponse
- ServiceWriter
- ServiceWriterSavepoint
- Set_Attribute_List
- Set_Attribute_Single
- Set_Attributes_All
- SETBIT
- SetBitValue
- SetCiAState
- SetCustomMapping
- SetDateAndTime
- SetError
- SETIO_PART
- SetParent
- SetPos
- SetPropertyAgain
- SetResult
- SettgBeginUpdate
- SettgEndUpdate
- SettgGetIntValue
- SettgGetStringValue
- SettgGetWStringValue
- SettgRemoveKey
- SettgSetValue
- SettgSetIntValue
- SettgSetStringValue
- SettgSetWStringValue
- SetTimeZoneInformation
- SettingsHelper
- SettingValue
- SetValueOfTypeDesc
- Severity
- SFCActionControl
- SFCActionType
- SFCStepType
- sgn
- SIGNED
- SIGNED_TO_DINT
- SIGNED_TO_INT
- SIGNED_TO_LINT
- SIZE
- SIZE_TO_UDINT
- SIZE_TO_UINT
- SIZE_TO_ULINT
- SlaveStateBitFieldType
- SLOT_ID
- Sm560Rec
- Sm560Send
- SntpSourceInfoData
- SntpSourceMode
- SntpSourceState
- SOCK_ADAPTER_INFORMATION
- SOCK_ADAPTER_INFORMATION2
- SOCK_ADAPTER_INFORMATION3
- SOCK_HOSTENT
- SOCK_RECVMSG_MSG
- SockAddr
- SOCA ADDRESS
- SOCKET_FD_SET
- SOCKET_TIMEVAL
- SocketType
- SolarBackTracking
- SolarEncoderCD522
- SolarEncoderIO
- SolarEncoderOnboardIO
- SolarEWAxisPrimary
- SolarEWAxisSecondary
- SolarHydraulicControl
- SolarModeCalibration
- SolarModeHoming
- SolarModeManual
- SolarModePosition
- SolarModeTracking
- SolarNoaa
- SolarNormalizeAnalog
- SolarNrel
- SolarNSAxisPrimary
- SolarNSAxisSecondary
- SolarPositionControl
- SortByAddItemHelper
- SortedBranchNamedTreeNode
- SortedDirectoryFileElementFactory
- SortedInstancePathBuildingBranchNode
- SortedList
- SortedListFactory
- SortedPStringVector
- SplitDateTime
- SplitString
- SplitTextListId
- SQLSTATEMENT
- SR
- SR_Mode
- SRAM_CLEARED
- SRAM_EXPORT
- SRAM_IMPORT
- SRAMArea
- SRState
- Stack
- StackFactory
- Start
- StatDynMemory
- STATE
- StateFlags
- StateMachine
- StaticCredentialsProvider
- StaticMemBuffer
- Statistics_DINT
- STATISTICS_INT
- Statistics_LREAL
- Statistics_LTIME
- STATISTICS_REAL
- STK_INFO
- STK_NODES
- STK_SPEC
- STK_STATE
- StkClose
- StkGetInfo
- StkOpen
- StkRegister
- StkUnregister
- STO_BLOB
- STO_METRICS
• STO_TEXT
• Stop
• STOPBIT
• Storage
• StrCaseCmpA
• StrCaseCmpEndA
• StrCaseCmpStartA
• StrCaseCmpW
• StrCaseFindA
• StrCaseFindW
• StrCmpA
• StrCmpEndA
• StrCmpStartA
• StrCmpW
• StrConcatA
• StrConcatW
• StrCpyA
• StrCpyW
• StrCpyWtoA
• StrDeleteA
• StrDeleteW
• Stream
• STREAM_STATE
• StrFindA
• StrFindW
• StringBuilder
• StringBuilderSysMemExtending
• StringElement
• StringElementFactory
• StringToDintMap
• StringToStringMap
• StringVector
• StrIsNullOrEmptyA
• StrIsNullOrEmptyW
• StrLenA
• StrLenW
• StrMidA
• StrMidW
• StrPadLeftA
• StrPadLeftW
• StrPadRightA
• StrPadRightW
• StrReplaceA
• StrReplaceW
• StrToLowerA
• StrToLReal
• StrToReal
• StrToUpperA
• StrTrimA
• StrTrimEndA
• StrTrimEndW
• StrTrimStartA
• StrTrimStartW
• StrTrimW
• StructFilteringName
● StuSprintf
● StuSprintfW
● StyleUtilFct_GetBoolFromStyle
● StyleUtilFct_GetBoolFromStyleEnumOrExplicitValue
● StyleUtilFct_GetSimpleTypeFromStyleEnumOrExplicitValue
● StyleUtilFct_GetUDIntFromStyle
● SubmoduleDiagnosisEntry
● SubmoduleInfo
● SubmoduleIterator
● SubmoduleState_AddInfo
● SubmoduleState_ARInfo
● SubmoduleState_Detail
● SubmoduleState_IdentInfo
● SubmoduleState
● SUBSLOT_ID
● SubVector
● Swap
● SwapByteArrayByWords
● SwapDword
● SwapDwordIf
● SwapLocalToIntel
● SwapLocalToMotorola
● SwapLword
● SwapLwordIf
● SwappedDirectAssigner
● SwappingInfo
● SwapWord
● SwapWordIf
● SWITCHBIT
● Symbol_Translation
● SymbolicInfo
● SymbolicVarNodeAccessor
● SymbolicVarNodeFinder
● SymbolicVarsBaseHandleConverter
● SymbolInfo
● Symbols
● SymbolsBaseNode
● SymbolsBranchNode
● SymVarAccess
● SYNC_INFO
● SYS_FILE_STATUS
● SYS_FILETIME
● SYS_TASK_INFO
● SYS_TASK_PARAM
● SYS_TIME
● SysCpuAtomicAdd
● SysCpuAtomicAdd64
● SysCpuAtomicCompareAndSwap
● SysCpuCallIecFuncWithParams
● SysCpuResetBit
● SysCpuResetBit2
● SysCpuSetBit
● SysCpuSetBit2
● SysCpuTestAndReset
● SysCpuTestAndSet
- SysCpuTestAndSetBit
- SysDirClose
- SysDirCopy
- SysDirCreate
- SysDirCreate2
- SysDirDelete
- SysDirDelete2
- SysDirGetCurrent
- SysDirOpen
- SysDirRead
- SysDirRename
- SysDirSetCurrent
- SysEthernetAdapterClose
- SysEthernetAdapterOpen
- SysEthernetCapabilities
- SysEthernetEthFrameReceive
- SysEthernetEthFrameSend
- SysEthernetFrame
- SysEthernetFrameRelease
- SysEthernetGetCapabilities
- SysEthernetGetInterfaceCounters
- SysEthernetGetMediaCounters
- SysEthernetGetPortConfigAndStatus
- SysEthernetInterfaceCounters
- SysEthernetIpFrameReceive
- SysEthernetIpFrameSend
- SysEthernetMediaCounters
- SysEthernetPortConfigAndStatus
- SysEthernetSetAutoNegAdvertisedCap
- SysEthernetSetAutoNegMode
- SysEthernetSetMauType
- SysEventCreate
- SysEventDelete
- SysEventSet
- SysEventWait
- SysExceptGenerateException
- SysFileClose
- SysFileCopy
- SysFileDelete
- SysFileDeleteByHandle
- SysFileEOF
- SysFileFlush
- SysFileGetName
- SysFileGetName2
- SysFileGetPath
- SysFileGetPos
- SysFileGetSize
- SysFileGetSizeByHandle
- SysFileGetStatus
- SysFileGetStatus2
- SysFileGetTime
- SysFileIoctl
- SysFileOpen
- SysFileRead
- SysFileRename
- SysFileSetPos
- SysFileTruncate
- SysFileWrite
- SysMCBDAloc
- SysMCBDCount
- SysMCBDFree
- SysMCBDGetFirstID
- SysMCBDGetNextID
- SysMCBDIsSet
- SysMCGetLoad
- SysMCGetNumOfCores
- SysMCGetProcessBinding
- SysMCGetTaskBinding
- SysMemAllocData
- SysMemCmp
- SysMemCpy
- SysMemForceSwap
- SysMemFreeData
- SysMemGetCurrentHeapSize
- SysMemIsValidPointer
- SysMemMove
- SysMemReallocData
- SysMemSet
- SysMemSwap
- SysProcessCreate
- SysProcessCreate2
- SysProcessExecuteCommand
- SysProcessExecuteCommand2
- SysProcessFreeHandle
- SysProcessGetCurrentHandle
- SysProcessGetOSId
- SysProcessGetPriority
- SysProcessGetState
- SysProcessResume
- SysProcessSetPriority
- SysProcessTerminate
- SysSemCreate
- SysSemDelete
- SysSemEnter
- SysSemLeave
- SysSemTry
- SysSharedMemoryClose
- SysSharedMemoryCreate
- SysSharedMemoryDelete
- SysSharedMemoryGetPointer
- SysSharedMemoryOpen2
- SysSharedMemoryRead
- SysSharedMemoryReadByte
- SysSharedMemoryWrite
- SysSharedMemoryWriteByte
- SysSock2Accept
- SysSock2Bind
- SysSock2Close
- SysSock2Connect
- SysSock2Create
- SysSock2FdInit
- SysSock2FdIsset
- SysSock2FdZero
- SysSock2GetOption
- SysSock2GetPeerName
- SysSock2GetSockName
- SysSock2Htol!
- SysSock2Htons
- SysSock2InetAddr
- SysSock2InetNtoa
- SysSock2Ioclt!
- SysSock2Listen
- SysSock2Ntohl!
- SysSock2Ntohs
- SysSock2Recv
- SysSock2RecvFrom
- SysSock2RecvMsg
- SysSock2Select
- SysSock2Send
- SysSock2SendTo
- SysSock2SetOption
- SysSock2Shutdown
- SysSockAccept
- SysSockAsyncFB
- SysSockBind
- SysSockClose
- SysSockCloseUdp
- SysSockConnect
- SysSockCreate
- SysSockCreateUdp
- SysSocket2_Parameter
- SysSocket2_SpecificParameter
- SysSocket2_StdSockets
- SysSocket2_TlsSockets
- SysSocket2_Type
- SysSocketPair
- SysSockFdInit
- SysSockFdIsset
- SysSockFdZero
- SysSockGetAdapterInfo
- SysSockGetFirstAdapterInfo
- SysSockGetHostByName
- SysSockGetHostName
- SysSockGetNextAdapterInfo
- SysSockGetOption
- SysSockGetOSHandle
- SysSockGetPeerName
- SysSockGetRecvSizeUdp
- SysSockGetSockName
- SysSockGetSubnetMask
- SysSockHtol!
- SysSockHtons
- SysSockInetAddr
- SysSockInetNtoa
- SysSocklocl!
- SysSockListen
- SysSockNtohl
- SysSockNtohs
- SysSockPing
- SysSockRecv
- SysSockRecvFrom
- SysSockRecvFromUdp
- SysSockRecvFromUdp2
- SysSockRecvMsg
- SysSockSelect
- SysSockSend
- SysSockSendTo
- SysSockSendToUdp
- SysSockSetDefaultGateway
- SysSockSetIPAddress
- SysSockSetIPAddressAndNetMask
- SysSockSetOption
- SysSockSetSubnetMask
- SysSockShutdown
- SysTargetGetDeviceName
- SysTargetGetId
- SysTargetGetNodeName
- SysTargetGetOperatingSystemId
- SysTargetGetProcessorId
- SysTargetGetSerialNumber
- SysTargetGetType
- SysTargetGetVendorName
- SysTargetGetVersion
- SysTargetOperationNumber
- SysTaskAutoReleaseOnExit
- SysTaskCheckStack
- SysTaskCreate
- SysTaskCreate2
- SysTaskDestroy
- SysTaskEnd
- SysTaskEnter
- SysTaskExit
- SysTaskGenerateException
- SysTaskGetContext
- SysTaskGetCurrent
- SysTaskGetCurrentOSHandle
- SysTaskGetInfo
- SysTaskGetInterval
- SysTaskGetName
- SysTaskGetOSHandle
- SysTaskGetOSPriority
- SysTaskGetPriority
- SysTaskJoin
- SysTaskLeave
- SysTaskResume
- SysTaskSetExit
- SysTaskSetInterval
- SysTaskSetPriority
- SysTaskSuspend
- SysTaskWaitInterval
- SysTaskWaitSleep
- SysTaskWaitSleepUs
- SYSTEM MEMORY INFORMATION
- SystemParameter
- SYSTEIME
- SYSTIME
- SYSTIMEDATE
- SysTimeGetMs
- SysTimeGetNs
- SysTimeGetUs
- SysTimeRtcControl
- SysTimeRtcConvertDateToHighRes
- SysTimeRtcConvertDateToUtc
- SysTimeRtcConvertHighResToDate
- SysTimeRtcConvertHighResToLocal
- SysTimeRtcConvertLocalToHighRes
- SysTimeRtcConvertLocalToUtc
- SysTimeRtcConvertUtcToDate
- SysTimeRtcConvertUtcToLocal
- SysTimeRtcGet
- SysTimeRtcGetTimezone
- SysTimeRtcHighResGet
- SysTimeRtcHighResSet
- SysTimeRtcSet
- SysTimeRtcSetTimezone
- SYSTYPE
- TA5130KNXPB
- TA5131RTC
- TA5141RS232I
- TA5142RS485
- TargetVisuCyclic
- TargetVisuFindById
- TargetVisuNotify
- Task_Desc
- Task_Desc2
- TASK_GROUP
- Task_Info2
- TASK_NAME
- Task_WatchdogHitCount
- TaskLock
- TaskUnlock
- tCmpLogAdd
- TCP_Client
- TCP_Connection
- TCP_Processor
- TCP_Read
- TCP_ReadBuffer
- TCP_Reader
- TCP_Server
- TCP_Write
- TCP_WRITE_STATE
- TCP_WriteBuffer
- TCP_Writer
- teClass
- teEcatDcControlState
Configuration and programming
Libraries and solutions > Reference, function blocks

- teEcatDevState
- teEcalSlvDcInfoFlags
- teErrorCodesOB
- teEvent
- teExtSyncInfoFlags
- teHwId
- Test_State
- Testcases
- TEXT
- TextCopyToString
- TextCopyToWString
- TextFree
- TextHelper
- TextListForCombobox_CIPClass
- TICK
- TICK_TO_UDINT
- TICK_TO_UINT
- TICK_TO_ULINT
- TIME_TO_DURATION
- TIME_TO_INT64
- TIME_TO_ISO8601
- TIME_TO_REAL8
- TIME_ZONE_INFO
- TimeElement
- TimeElementFactory
- TimerSwitch
- TIMESTAMP
- Timestamp_to_DT
- TimeZone
- TimezoneInformation
- TimingControlledBehaviourModelBase
- TimingController
- TL_AlarmStatus
- TL_AlarmTableColumnTitles
- TL_DateTime
- TL_ElementProperties
- TL_RecipeManager
- TL_VUM_Errors
- TLR_PACKET_HEADER_T
- TLS_VERSION
- TLSContext
- TO_IDeviceCM579EtherCAT
- TODConcat
- TODSplit
- TOF
- TON
- TP
- TraceAbsoluteAddressInfoWriter
- TraceAbstractAddressInfoWriter
- TraceAddress
- TraceFctGetPropertyValue
- TraceFctGetVariableName
- TraceFctGetVariableNameW
- TraceMgrGetConfigFromFile
- TraceMgrGetConfigFromFileRelease
• TraceMgrPacketCheckTrigger
• TraceMgrPacketClose
• TraceMgrPacketComplete
• TraceMgrPacketCreate
• TraceMgrPacketDelete
• TraceMgrPacketDisable
• TraceMgrPacketDisableTrigger
• TraceMgrPacketEnable
• TraceMgrPacketEnableTrigger
• TraceMgrPacketGetAbsoluteStartTime
• TraceMgrPacketGetChangeTimestamp
• TraceMgrPacketGetConfig
• TraceMgrPacketGetFirst
• TraceMgrPacketGetNext
• TraceMgrPacketGetStartTime
• TraceMgrPacketGetState
• TraceMgrPacketOpen
• TraceMgrPacketReadBegin
• TraceMgrPacketReadEnd
• TraceMgrPacketReadFirst
• TraceMgrPacketReadFirst2
• TraceMgrPacketReadNext
• TraceMgrPacketReadNext2
• TraceMgrPacketResetTrigger
• TraceMgrPacketRestart
• TraceMgrPacketRestore
• TraceMgrPacketStart
• TraceMgrPacketStop
• TraceMgrPacketStore
• TraceMgrRecordAdd
• TraceMgrRecordGetConfig
• TraceMgrRecordGetFirst
• TraceMgrRecordGetNext
• TraceMgrRecordRemove
• TraceMgrRecordUpdate
• TraceMgrRecordUpdate2
• TraceMgrRecordUpdate3
• TraceMgrRecordUpdate4
• TraceMgrRecordUpdate5
• TracePacketConfiguration
• TracePropertyByCallAddressInfoWriter
• TraceRecordConfiguration
• TraceRecordEntry
• TraceState
• TraceTrigger
• TraceVariable
• TraceVariableAddress
• TraceVarInfo
• TRANSITION_STATE
• TRANSMISSION
• TransmissionTrigger
• TransmitParameterGroup
• Tree
• TreeBase
• TreeNode
- TreeNodeFactory
- TreeNodeType
- TrendFbDatabaseAccessErrorHandler
- TrendFbTrendStorageWriterReader
- TrendFctCursorSearchFirstRow
- TrendFctGetDBFileSize
- TrendFctGetDBPercLimit
- TrendFctGetDBReOrderingData
- TrendFctGetDBReOrderingForceFailure
- TrendFctGetRecordSizeFactor
- TrendFctGetTimestamp
- TrendFctResetDBReOrderingData
- TrendFctSetComplexElementCallState
- TrendFctSetDBPercLimit
- TrendFctSetDBReOrderingForceFailure
- TrendFctSetRecordSizeFactor
- TrendFctShowLossOfPrecisionWarning
- TrendFctShowUnsupportedFunctionWarning
- TrendStorageCacheItemData
- TrendStorageConvertFromTimestamp
- TrendStorageConvertToTimestamp
- TrendStorageReader
- TrendStorageReaderValueConverter
- TrendStorageVariableDescription
- TriggerState
- TriggerValue
- Truncate
- TruncateF
- TryAdjustData_Int
- TryAdjustData_Real
- TryAdjustData(UInt
- tsEcmExtSyncInfo
- tsEcmMstrDcInfo
- tsEcmMstrFrameLossCnt
- tsEcmMstrFrameLossCntEntry
- tsEcmMstrInfo
- tsEcmMstrMemInfo
- tsEcmMstrThresholdCnt
- tsEcmMstrThresholdCntEntry
- tsEcmMstrTimingInfo
- tsEcmSlvConnInfo
- tsEcmSlvDcInfo
- tsEcmSlvEmergencies
- tsEcmSlvEmergency
- tsEcmSlvESCVersion
- tsEcmSlvESCVersion_1
- tsEcmSlvInfo
- tsEcmSlvLostLinkCnt
- tsEcmSlvRxErrorCnt
- tsNetxChannel
- tsNetxEcatBusScanDeviceInfo
- tsNetxEcatHandle
- tsParameterStruct
- tSysSockAccept
- tSysSockBind
- tSysSockClose
- tSysSockCloseUdp
- tSysSockConnect
- tSysSockCreate
- tSysSockCreateUdp
- tSysSockGetHostName
- tSysSockGetHostByName
- tSysSockGetOption
- tSysSockGetOsHandle
- tSysSockGetRecvSizeUdp
- tSysSockGetSubnetMask
- tSysSockHtonl
- tSysSockHtons
- tSysSockInetAddr
- tSysSockInetNtoa
- tSysSockioctl
- tSysSockListen
- tSysSockNtohl
- tSysSockNtohs
- tSysSockPing
- tSysSockRecv
- tSysSockRecvFrom
- tSysSockRecvFromUdp
- tSysSockSend
- tSysSockSendTo
- tSysSockSendToUdp
- tSysSockSetIpAddress
- tSysSockSetOption
- tSysSockSetSubnetMask
- tSysSockShutdown

- tyIEC61850_ASN1_Header
- tyIEC61850_AT_AnalogueValue
- tyIEC61850_AT_AnalogueValue_Struct
- tyIEC61850_AT_APC
- tyIEC61850_AT_APC1
- tyIEC61850_AT_APC_Operate
- tyIEC61850_AT_APC_Operate_SP
- tyIEC61850_AT_BOOLEAN
- tyIEC61850_AT_BSC_Operate
- tyIEC61850_AT_Check
- tyIEC61850_AT_CODED_ENUM
- tyIEC61850_AT_DPC_Operate
- tyIEC61850_AT_DstAddress
- tyIEC61850_AT_EntryTime
- tyIEC61850_AT_ENUM_CtlModels
- tyIEC61850_AT_ENUM_MODE
- tyIEC61850_AT_ENUM_SboClass
- tyIEC61850_AT_ENUMERATED
- tyIEC61850_AT_FLOAT32
- tyIEC61850_AT_INC
- tyIEC61850_AT_INC1
- tyIEC61850_AT_INC_Operate
- tyIEC61850_AT_INS
- tyIEC61850_AT_INT128
- tyIEC61850_AT_INT16
- tyIEC61850_AT_INT16U
- tyIEC61850_AT_INT32
- tyIEC61850_AT_INT32U
- tyIEC61850_AT_INT8
- tyIEC61850_AT_INT8U
- tyIEC61850_AT_ISC_Operate
- tyIEC61850_AT_Octet255
- tyIEC61850_AT_Octet64
- tyIEC61850_AT_Oct
- tyIEC61850_AT_POINT
- tyIEC61850_AT_PulseConfig
- tyIEC61850_AT_Quality
- tyIEC61850_AT_RANGECONFIG
- tyIEC61850_AT_ScaledValConfig
- tyIEC61850_AT_SPC
- tyIEC61850_AT_SPC_Operate
- tyIEC61850_AT_StatusValue_Struct
- tyIEC61850_AT_TimeStamp
- tyIEC61850_AT_UCSTRING255
- tyIEC61850_AT_UINT32
- tyIEC61850_AT_UNIT
- tyIEC61850_AT_ValWithTrans
- tyIEC61850_AT_VECTOR
- tyIEC61850_AT_VisSTRING129
- tyIEC61850_AT_VisSTRING255
- tyIEC61850_AT_VisSTRING32
- tyIEC61850_AT_VisSTRING64
- tyIEC61850_AT_VisSTRING65
- tyIEC61850_DataPoint
- tyIEC61850_DataSetRef
- tyIEC61850_GOOSE_Check
- tyIEC61850_GOOSEMsg
- tyIEC61850_MMSDataExchange
- tyIEC61850_MMS_Initiate
- tyIEC61850_SubsDataBlock
- tyIEC61850_SubsDataPoint
- tyISO8073_BlockHeader
- tyISO8073_ClientPara
- tyISO8073_PDU
- tyISO8327_BlockHeader
- tyISO8327_ClientData
- tyISO8327_ConnectAcceptItem
- tyISO8327_ConnectionIdent
- tyISO8650_UserInfoData
- tyISO8823_ContextList
- tyISO8823_ContextName
- tyISO8823_CP_Type
- tyISO8823_DataUser
- tyISO8823_NormalModePara
- tyISO_BlockHeader
- tyISO_SPDU
- TypeClass
- TypeClass3
- TypedElement
- TypeDesc
- TypeDesc_Alias
- TypeDesc_AliasWithAttributes
- TypeDesc_Array
- TypeDesc_Array_ByteAddressed
- TypeDesc_Array_Remote
- TypeDesc_Enum
- TypeDesc_EnumWithAttributes
- TypeDesc_Executable
- TypeDesc_Executable2
- TypeDesc_OpcUaBuiltInType
- TypeDesc_Property
- TypeDesc_Property_Remote
- TypeDesc_Reference
- TypeDesc_Simple
- TypeDesc_Simple_Bit
- TypeDesc_Struct
- TypeDesc_Struct2
- TypeDesc_Struct2_WithBaseType
- TypeDesc_Struct2_WithBaseTypeAndAttributes
- TypeDesc_Struct_Derived_Remote
- TypeDesc_Struct_Remote
- TypeDesc_Subrange
- TypeDesc_UAProperties
- TypeDesc_VarLenArray
- TypeDescArrayAsStruct
- TypeDescAsUnion
- TypeDescSimpleAsStruct
- TypeDescStructAsStruct
- TypeDescUnion
- TypeDescVarArrayAsStruct
- TypedList
- TypedTree
- TypeHasCompleteBlittableLayout
- TypeIds
- TZ_NAME
- UDINT_IN_BYTES
- UDINT_IN_WORDS
- UDINT_TO_COUNT
- UDINT_TO_HEX
- UDINT_TO_IPARRAY
- UDINT_TO_IPSTRING
- UDINT_TO_SIZE
- UDINT_TO_TICK
- UDINT_TO_UNSIGNED
- UdintElement
- UdintElementFactory
- UDP_GetDataSize
- UDP_Peer
- UDP_Processor
- UDP_Receive
- UDP_ReceiveBuffer
- UDP_Receiver
- UDP_REPLY
- UDP_REPLY2
- UDP_Send
- UDP_SendBuffer
- UDP_Sender
- UDPDriver
- UdpGetReceiveDataSize
- UdpOpenReceiveSocket
- UdpOpenSendSocket
- UdpReceiveData
- UdpSendData
- UINT_TO_COUNT
- UINT_TO_HEX
- UINT_TO_SIZE
- UINT_TO_TICK
- UINT_TO_UNSIGNED
- UintElement
- UintElementFactory
- ULINT_TO_COUNT
- ULINT_TO_SIZE
- ULINT_TO_TICK
- ULINT_TO_UNSIGNED
- UlintElement
- UlintElementFactory
- UNPACK
- UnpackArrayOfByte
- UnpackByte
- UnpackDWord
- UnpackWord
- Unregister
- UnregisterCallback
- UnregisterIdArea
- UNSIGNED
- UNSIGNED_TO_UDINT
- UNSIGNED_TO_UINT
- UNSIGNED_TO_ULINT
- UpdateByDefaultInfo
- UpdateByDefaultItem
- UpdateDiagnosis_Status
- UpdateDiagnosisEntry
- UserConfigurationV1
- User_mgrCacheValue
- UserMgrChangeMyPassword
- UserMgrCredentials
- UserMgrCredentials_Password
- UserMgrCredentials_Store
- UserMgrCredentials_Type
- UserMgrGetSessionUser
- UserMgrGetUserAccessRights
- UserMgrGroupAdd
- UserMgrGroupAddUser
- UserMgrGroupGetFirst
- UserMgrGroupGetFirstUser
- UserMgrGroupGetHandle
- UserMgrGroupGetName
- UserMgrGroupGetNext
- UserMgrGroupGetNextUser
- UserMgrGroupRemove
- UserMgrGroupRemoveUser
- UserMgrHasUserAccessRights
- UserMgrIsActive
- UserMgrLogin
- UserMgrLogout
- UserMgrObjectAdd
- UserMgrObjectAddGroup
- UserMgrObjectClearRights
- UserMgrObjectGetFirstChild
- UserMgrObjectGetFirstGroup
- UserMgrObjectGetGroupRights
- UserMgrObjectGetHandle
- UserMgrObjectGetName
- UserMgrObjectGetNextChild
- UserMgrObjectGetNextGroup
- UserMgrObjectRemove
- UserMgrObjectRemoveGroup
- UserMgrObjectSetGroupDeniedRights
- UserMgrObjectSetGroupRights
- UserMgrObjectSetUsedRights
- UserMgrRelogin
- UserMgrTypeClass
- UserMgrUserAdd
- UserMgrUserAddInfoToUser
- UserMgrUserGetFirst
- UserMgrUserGetInfoOfUser
- UserMgrUserGetName
- UserMgrUserGetNext
- UserMgrUserGetProperty
- UserMgrUserRemove
- UserMgrUserRemoveInfoFromAllUsers
- UserMgrUserRemoveInfoFromUser
- UserMgrUserSetCredentials
- UserMgrUserSetProperty
- UserMgrValue
- UtilAddrEqual
- UtilAreGuidsEqual
- UtilBuildItemErrorCode
- UtilBytesFromHexSubString
- UtilByteToHexString
- UtilFillLanguageGroupNames
- UtilFillNodeAddress
- UtilGetHostName
- UtilGetLocalByteorder
- UtilGetLocalByteorderAtRuntime
- UtilGuidToHexString
- UtilIsGeneralErrorReply
- UtilIsGuidEmpty
- UtilIsIntelByteorder
- UtilIsToSwap
- UtilNumericVersionToString
- UtilReadAddressFromRouter
- UtilResolveItemToRemoteAddr
- UtilSizeFromAddrInfo
- Visu_FctRaiseMouseLeave
- Visu_FctReleaseNonIECMemClientResources
- Visu_FctSetDialogClientData
- Visu_FctTransformSelectionIsotropicOverlay
- Visu_HelpDumpLibHierarchy
- Visu_OnlinechangeNotify
- Visu_ScalarTypesUnion
- Visu_ScalarTypesWithPtr
- Visu_SetCodegenFeatureSupport
- Visu_StructCommandData
- Visu_TypeString
- Visu_UserPasswordCredentials
- VisuAlarmScrollValueProvider
- VisuAssignRtsBasedUserMgt
- VisuBenchmarkFBStatistics
- VisuBenchmarkNowInUs
- VisuChangePasswordProvider
- VisuClientAnimationData
- VisuClientObject
- VisuClientObjectClientSpecificData
- VisuClientObjectFlags
- VisuClientObjectFlags_HighWord
- VisuClientObjectIdStack
- VisuClientObjectIdStackOptimized
- VisuClientObjectIdStackWithParentSize
- VisuClientObjectInputRectangleMgr
- VisuClientObjectLayerInitFlags
- VisuClientObjectMgr
- VisuClientObjectReservedIds
- VisuClientObjectStateFlags
- VisuClientTag
- VisuClientType
- VisuCreateUserMgmtObjects
- VisuDateTimeFormatPlaceholders
- VisuDialogOpenFlags
- VisuDlg_CheckedAppend
- VisuDlg_CheckedAppendExp
- VisuDlg_CheckedAppendW
- VisuDlg_CheckedBack
- VisuDlg_CheckedBackW
- VisuDlg_CheckedChangeNumberFormat
- VisuDlg_CheckedChangeSign
- VisuDlg_CheckedChangeSignExtended
- VisuDlg_CheckedClear
- VisuDlg_CheckedExpFloatFormatSwitch
- VisuDlg_GetPasswordString
- VisuDlg_ProcessBack
- VisuDlg_ProcessBack2
- VisuDlg_ProcessBackPrepare
- VisuDlg_ProcessBackW
- VisuDlg_ProcessChangeNumberFormat
- VisuDlg_ProcessChangeSign
- VisuDlg_ProcessChangeSignExtended
- VisuDlg_ProcessChar
- VisuDlg_ProcessCharW
- VisuDlg_ProcessCharW_WithInit
- VisuDlg_ProcessCharWithInit
- VisuDlg_ProcessClear
- VisuDlg_ProcessExp
- VisuDlg_ProcessExpFloatFormatSwitch
- VisuDlg_SetErrorColor
- VisuDlg_Utf8PasswordCaretPosition
- VisuDlg_Utf8RuneLen
- VisuDlgUtil_AdjustCaretAndSelectionAfterNumberFormatChange
- VisuDlgUtil_CloseNumpadExtended
- VisuDlgUtil_CloseNumpadExtended2
- VisuDlgUtil_FormatExpToG
- VisuDlgUtil_FormatValueToDec
- VisuDlgUtil_FormatValueToHex
- VisuDlgUtil_InitValueFromFlags
- VisuDlgUtil_IsDialogOpen
- VisuDlgUtil_SetbInitFormatValue
- VisuDlgUtil_UpdateOutputValue
- VisuElemLayer
- VisuElemLayerAlignmentFlag
- VisuElemLayerClientSpecificData
- VisuElemLayerData
- VisuElemLayerFlag
- VisuElemMgrClientData
- VisuElemMgrClientSpecificData
- VisuElemMgrClientSpecificDataIndices
- VisuElemSelectionLayer
- VisuEnumActionType
- VisuEnumAfterTransformation
- VisuEnumAlarmDataType
- VisuEnumAnalogClockStyle
- VisuEnumAttachedElementLocation
- VisuEnumBackgroundDrawingState
- VisuEnumBrushStyle
- VisuEnumClientTag
- VisuEnumCreateTemporaryRenderLocationFlags
- VisuEnumCurrentCheckboxState
- VisuEnumFileTransferDirection
- VisuEnumFileTransferError
- VisuEnumFileTransferInputEventType
- VisuEnumHorizontalAlignment
- VisuEnumInputOnElementType
- VisuEnumIsotropicType
- VisuEnumLegendDisplayerLineType
- VisuEnumLineCapStyle
- VisuEnumLineJoinStyle
- VisuEnumOrientation
- VisuEnumPenStyle
- VisuEnumPieType
- VisuEnumPolygonType
- VisuEnumPropertyElement
- VisuEnumRectangleFlags
- VisuEnumRedundancyValueChanged
- VisuEnumTableParts
- VisuEnumTextFlag
- VisuEnumVerticalAlignment
- VisuEnumXYChartActivityType
- VisuEnumXYChartAxisPosition
- VisuEnumXYChartAxType
- VisuEnumXYChartBarType
- VisuEnumXYChartBgType
- VisuEnumXYChartCommands
- VisuEnumXYChartCursorActive
- VisuEnumXYChartCursorType
- VisuEnumXYChartCursorVisible
- VisuEnumXYChartCvChartType
- VisuEnumXYChartCvFillType
- VisuEnumXYChartCvHeapCmd
- VisuEnumXYChartCvOverlapType
- VisuEnumXYChartFocusType
- VisuEnumXYChartGradientType
- VisuEnumXYChartGridType
- VisuEnumXYChartLineType
- VisuEnumXYChartLvlLineLbPos
- VisuEnumXYChartPointStyle
- VisuEnumXYChartProgType
- VisuEnumXYChartShadowStyle
- VisuEnumXYChartZeroLineType
- VisuEventOptimization
- VisuEventTarget
- VisuFb3DPathClientData
- VisuFbAlarmBannerDataBlock
- VisuFbAnalyzeDateTimeFormatExtractWithoutWeekdays
- VisuFbAnalyzeDateTimeFormatStringBase
- VisuFbAnalyzeDateTimeFormatStringMinSecOnly
- VisuFbAnalyzeStateVarsTapAware
- VisuFbBaseVector
- VisuFbCapturedTransformationProvider
- VisuFbClientLogger
- VisuFbClientManagerListener
- VisuFbClientStartVisuMgr
- VisuFbClientTagDataHelper
- VisuFbCommandVector
- VisuFbDatasourcesResourceEntries_MBM
- VisuFbDatasourcesResourceEntries_SysMem
- VisuFbDateTimeNamesLocalizer
- VisuFbDialogClientInfo
- VisuFbDialogInfoVector
- VisuFbDialogPos
- VisuFbDialogPosByElementVector
- VisuFbDialogPosVector
- VisuFbDWORDVector
- VisuFbElemTextEditor
- VisuFbExecution
- VisuFbFileTransferManager
- VisuFbFrameRegistrationVector
- VisuFbFrameSwipingHelper
- VisuFbGestureFromEvent
- VisuFbGroupOverlay
- VisuFbInputRectangle
- VisuFbLegacyCapturingTransformationProvider
- VisuFbLibHierarchy
- VisuFbMainClientMgmt
- VisuFbMouseTouchDragUtil
- VisuFbMoveAbsoluteTapAware
- VisuFbMoveAbsoluteTapAwareF
- VisuFbMoveRelativeTapAware
- VisuFbMultiTouchHelper
- VisuFbNamespaceTable
- VisuFbNamespaceTableHelper
- VisuFbNativeControlItemVector
- VisuFbPaintAfterAllDialog
- VisuFbPaintAfterAllElement
- VisuFbPaintRectF
- VisuFbPointF
- VisuFbPrintDateTimeFormatBase
- VisuFbPrintDateTimeFormatCurrentTime
- VisuFbPrintDateTimeFormatVariable
- VisuFbRecordConditionInfo
- VisuFbRecordingRangeRingBuffer
- VisuFbRectangleListManager
- VisuFbRectF
- VisuFbResourcesEntryVector
- VisuFbScalingInfo
- VisuFbSizeF
- VisuFbTabControlOverlayTabs
- VisuFbTableColumnSimpleBase
- VisuFbTemporaryPolygon
- VisuFbTickMarkDrawer2
- VisuFbTransformationCommon
- VisuFbTransformationScrolling
- VisuFbValueChangedListenerForOnValueChanged
- VisuFbVisuVector
- VisuFbWriteDateTimeVariableFormatted
- VisuFbXYChartDataProvider
- VisuFbXYChartDataProviderAxis
- VisuFbXYChartDataProviderCurve
- VisuFbXYChartGenericVariable
- VisuFbXYChartGenericVariableArray
- VisuFct_IsBehindOverlayElement
- VisuFctAddChecksumBool
- VisuFctAddChecksumForConverted
- VisuFctAddClientToEventQueue
- VisuFctAdjustElemRectAndSelectRect
- VisuFctAssignValue
- VisuFctCalculateCompleteSurroundingSimpleRectOfElemArray
- VisuFctCalculateMaxTooltipLength
- VisuFctCalculateSurroundingSimpleRectOfElemArray
- VisuFctCheckClientSupportsFramePreview
- VisuFctCheckClientSupportsTouch
- VisuFctCheckSpecificClientType
- VisuFctClearElementEntries
- VisuFctClearEventIdStack
- VisuFctConfigureTextBufferSize
- VisuFctConvertUtcToSystimedate
- VisuFctCreateEventMapIfNeeded
- VisuFctCreateIdStack
- VisuFctDatasourcesResourceEntryAllocatorGet
- VisuFctDatasourcesResourceEntryAllocatorGet_MBM
- VisuFctDatasourcesResourceEntryAllocatorGet_SysMem
- VisuFctDrawCircle
- VisuFctDrawDot
- VisuFctDrawDot2
- VisuFctDrawImage
- VisuFctDrawIsoBackground
- VisuFctDrawLine
- VisuFctDrawLineEx
- VisuFctDrawLineExUntransformed
- VisuFctDrawLineUntransformed
- VisuFctDrawPolygon
- VisuFctDrawPolyline
- VisuFctDrawPolyline2
- VisuFctDrawText
- VisuFctEvaluatePanGesture
- VisuFctEventIdStackGetValue
- VisuFctEventIdStackGetValuePtr
- VisuFctEventIdStackGetValuePtrFromEvent2
- VisuFctEventIdStackGetValuePtrFromEventLegacy
- VisuFctEventIdStackHas
- VisuFctEventIdStackPopHelp
- VisuFctEventIdStackPopId
- VisuFctEventIdStackPopTarget
- VisuFctEventIdStackPopVisuVersion
- VisuFctEventIdStackPushId
- VisuFctEventIdStackSetValue
- VisuFctExitVisuClientObject
- VisuFctFillPolygon
- VisuFctFillPolygon2
- VisuFctFillPolygon3
- VisuFctFillRectangle
- VisuFctFreeClientTagData
- VisuFctGetAbsolutePosition
- VisuFctGetClientName
- VisuFctGetEffectiveTextProperties
- VisuFctGetElementClientData
- VisuFctGetElementEntry
- VisuFctGetElementState
- VisuFctGetGradient
- VisuFctGetIsNativeElementEventWithResult
- VisuFctGetLineJoinMiterLimit
- VisuFctGetMeasureString2Result
- VisuFctGetMeasureStringApprox
- VisuFctGetMeasureStringResult
- VisuFctGetMultitouchActive
- VisuFctGetMultitouchScrollbarsActive
- VisuFctGetNanosSince1970
- VisuFctGetPaintRectFromSimpleRect
- VisuFctGetRectangleFromPaintRect
- VisuFctGetRectangleFromSimpleRect
- VisuFctGetRectHeight
- VisuFctGetRectWidth
- VisuFctGetShadowColor
- VisuFctGetTargetVisuTouchFlags
- VisuFctGetTextMargins
- VisuFctGetTransparentColor
- VisuFctHandleInputOnElementEvent
- VisuFctHandleInputVisuClientObject
- VisuFctHandleInputWithoutInputHandler
- VisuFctIncreaseCurrentElementIndex
- VisuFctIncreaseSimpleRectIfRotated
- VisuFctInitFlagsVisuClientObject
- VisuFctInitVisuClientObject
- VisuFctIsDegenerateRectangle
- VisuFctIsMultitouchClient
- VisuFctIsRectangleRotated
- VisuFctIsRectRotatedBy0To90Degree
- VisuFctIsRectRotatedBy180Degree
- VisuFctIsRectRotatedBy180To270Degree
- VisuFctIsRectRotatedBy270Degree
- VisuFctIsRectRotatedBy270To360Degree
- VisuFctIsRectRotatedBy90Degree
- VisuFctIsRectRotatedBy90To180Degree
- VisuFctIsToPaintSelection
- VisuFctIsTransparentColor
- VisuFctLimitSimpleRectangleSize
- VisuFctMainClientsCheck
- VisuFctMainClientsCheck3
- VisuFctMainClientsCheckOld
- VisuFctPaintSelection
- VisuFctPaintVisuClientObject
- VisuFctRectSize
- VisuFctRemoveClientFromEventQueue
- VisuFctSearchElementById
- VisuFctSelectElement
- VisuFctSetClientDataVisuClientObject
- VisuFctSetMaxElementCountPaintAfterAll
- VisuFctSetNumericValue
- VisuFctSetRectangleUpdateNecessaryOnAllClients
- VisuFctSetSelectionChanged
- VisuFctSetSimpleRect
- VisuFctSimpleRectangleFToSimpleRectangle
- VisuFctSplitColor
- VisuFctTestLReal
- VisuFctTestReal
- VisuFctTextAddOffset
- VisuFctTextEditorGetErrorText
- VisuFctTryAtomicAssignValueBySize
- VisuFctTryAtomicAssignValueByType
- VisuFctUtf8RuneLen
- VisuFctWriteValueIfValid
- VisuGestureInfo
- VisuInput_CheckUpdateElementStatePossible_DependingOnCurrentInput
- VisuInputType
- VisuValidClientId
VisuLoginProvider
VisuNativeElement
VisuNativeElementMethod
VisuNativeElementMethodParameterList
VisuRegistrationHelpDuringDecl
VisuScrollValueData
VisuScrollValueProvider
VisuSecureTappingKeyEvent
VisuSizeProvider
VisuStruct3DControl
VisuStruct3DPathPoint
VisuStruct3DTrack
VisuStructAllDialogInfo
VisuStructAllModalDialogInfo
VisuStructAllNonModalDialogInfo
VisuStructBackgroundAndStaticElementDrawing
VisuStructButtonClientSpecificData
VisuStructClientSpecificInputRectangles
VisuStructClientTagData
VisuStructColors
VisuStructComboBoxTouchData
VisuStructCompleteSurroundingRectInfo
VisuStructComplexFrameClientSpecificData
VisuStructDialogPosByElement
VisuStructElemBaseClientSpecificData
VisuStructElementClientData
VisuStructElementClientDataExtended
VisuStructElementState
VisuStructFileTransfParams_Union
VisuStructFindElementEvent
VisuStructFlickInfo
VisuStructFont
VisuStructIECTouchInfo
VisuStructInputInfo
VisuStructInputOnElementEvent
VisuStructLegendDisplayerCheckBoxPos
VisuStructLegendDisplayerCheckBoxStatus
VisuStructMethodClientSpecificData
VisuStructNamespace
VisuStructNamespaceProjectIdent
VisuStructNativeElementClientData
VisuStructNativeElementClientSpecificData
VisuStructPAADialogClientSpecificData
VisuStructPanInfo
VisuStructPoint
VisuStructPointD
VisuStructPolygonClientSpecificData
VisuStructRadioButtonClientData
VisuStructRadius
VisuStructRecordingRange
VisuStructRectangularElementUtilBaseClientSpecificData
VisuStructScaleScrollInfo
VisuStructSecureTappingKeyEvent
VisuStructSimpleRectangleD
VisuStructSimpleRectWithBorder
- WorkerRegister
- WorkerUnregister
- WREPLACE
- WRIGHT
- Write
- WriteBootProject
- WriteMemory
- WriteRequest
- WRREC
- WStringElement
- WStringElementFactory
- WStringsEqual
- X509CertCheckHost
- X509CertCheckIP
- X509CertClose
- X509CertCmsDecrypt
- X509CertCmsVerify
- X509CertCreateCSR
- X509CertCreateSelfSigned
- X509CertGetBinary
- X509CertGetContent
- X509CertGetPrivateKey
- X509CertGetPublicKey
- X509CertGetThumbprint
- X509CertHasExtendedKeyUsage
- X509CertHasKeyUsage
- X509CertInfoExit
- X509CertInfoInit
- X509CertIsAuthority
- X509CertIsDateValid
- X509CertIsSelfSigned
- X509CertKeyClose
- X509CertStoreAddCert
- X509CertStoreClose
- X509CertStoreGetFirstCert
- X509CertStoreGetNextCert
- X509CertStoreGetRegisteredCert
- X509CertStoreOpen
- X509CertStoreRegister
- X509CertStoreRemoveCert
- X509CertStoreSearchGetFirst
- X509CertStoreSearchGetNext
- X509CertStoreUnregister
- X509CertVerify
- X509CertVerify2
- X509ParseCertificate
- XChgClass
- XChgCreateH
- XChgCreateP
- XChgDelete
- XChgExtendH
- XChgGetSize
- XChgIsEmpty
- XChgMsgLeft
- XWORD
- XwordVector
- YEAR
- zCMC_ABB_AXIS_TYPES
- zCMC_ABB_ERRORINFO
- zCMC_ADDW
- zCMC_AXIS_INTERNAL
- zCMC_createDecelTable
- zCMC_Cut40Bit
- zCMC_DIFF
- zCMC_DIFF_MODULO32
- zCMC_DIV_LONG_REST
- zCMC_FBPosiReal
- ZCMC_FBPOSIREAL_ZACTION_INIT
- zCMC_FBSpeedReal
- zCMC_INTERPOLATION_BASE
- zCMC_Kernel_Base
- zCMC_POLYNOM_pos
- zCMC_POLYNOM_time
- zCMC_POSITION_IPO
- zCMC_POSITION_IPO_ORIG
- zCMC_PosLoop
- zCMC_PT1_LREAL
- zCMC_SPLINE_pos
- zCMC_STOP_IPO
- zLOG_ENUM_STATE
6.6 Engineering interfaces and tools

6.6.1 Export and import interfaces

6.6.1.1 Exporting and importing ECAD data (PBF)

6.6.1.1.1 Introduction

Automation Builder provides an ECAD interface for exchanging the PLC configuration data with EPLAN Electric P8 and Zuken E3. This feature removes double data entry between electrical engineering in the ECAD tool and the control logic programming in Automation Builder by synchronizing the PLC hardware including topology and I/O signals between these tools.

Automation Builder - ECAD interface supports various flexible workflows:

- Enables PLC hardware planning and configuration in the ECAD tool and allows importing the exported data from the ECAD tool through the PBF file (process integration bus interchange format) into the Automation Builder project with diff and merge functionality, providing full control on selective import/merge.
- Enables PLC hardware configuration in Automation Builder and allows exporting the configuration to the ECAD tool through a PBF file.
- Supports bi-directional roundtrip engineering with loss less data exchange between Automation Builder and the ECAD tool.

Automation Builder uses the rack information to identify the relations between:

- PLC and devices plugged to I/O bus or extension bus.
- Fieldbus slave and attached IO devices.

It is recommended to assign the PLC, IO devices, communication modules and fieldbus slaves properly to the rack in the ECAD project. If the rack information is missing, devices will be imported to the device pool and must be arranged manually in the Automation Builder project or mapped to already existing devices.

6.6.1.2 Requirements on EPLAN electric P8

- EPLAN Electric P8 with PLC and Bus Extension. It is recommended to use version 2.3 or later.
- Use of appropriate part data and macros for ABB devices. This can be achieved by getting the part data and macros from the EPLAN data portal.

6.6.1.3 Importing PLC data from the ECAD tool

You can create a new Automation Builder PLC project from the existing PLC hardware configuration in your ECAD tool, by importing the exported PBF file to Automation Builder.

1. From the main menu, select “Project ➔ Import ➔ ECAD (PBF)”.
2. From the file system, select the PBF file. Automation Builder starts importing the devices and its associated signals from the PBF file. After a successful import, the result is displayed in the Project Compare – Differences view. You can now decide and selectively merge the differences.

   Chapter 6.4.1.21.3.5.21 “Command 'Compare'” on page 2607

3. Select the DevicePool node and click “Accept Block” to accept the complete PLC structure in the ECAD tool.
4. Select the PLC node and click “Accept Block” to accept all child device nodes.

   The DevicePool node holds all devices coming from the ECAD tool without any hierarchy information. The missing hierarchy information can be defined after closing the editor.

5. Close the Project Compare – Differences view to accept the changes.

![Unassigned devices](image1.png) ![Assigned devices](image2.png)

⇒ The I/O signals assigned to I/O devices in the PBF file are imported and allocated to IO devices. IO signals can be viewed in I/O mapping editor of the I/O devices.

### 6.6.1.4 Importing third party devices

Prerequisite: To import third party devices from ECAD to Automation Builder, install third party fieldbus devices (for example, GSD, GSDML and EDS files) using "Tools ➔ Device repository" in Automation Builder.

1. From the main menu, select “Project ➔ Import ➔ ECAD (PBF)”.
2. From the file system, select the ECAD pbf file which consists of third party devices.
   ⇒ When the device identifier of the third party device installed in Automation Builder does not match with the device identifier of the device imported from ECAD, an error window is shown with the devices which are failed to import with error identifier 14.
   To import third party devices, it is required to assign ECAD identifier (PLC type designation/order number) in Automation Builder in “Tools ➔ Device ECAD data”. Click the link in the Import window to see the error messages in a text file.
3. Click “Continue” in the Import window to import valid devices to the project that are imported successfully or click “Cancel” to cancel the import process.
4. In Automation Builder, click “Tools ➔ Device ECAD data”.

Configuration and programming
Engineering interfaces and tools ➔ Export and import interfaces

ADR010583, 1, en_US 2024/01/05
5. In the Device ECAD data editor, add the ECAD identifier for the devices shown in the import errors window with error identifier 14, to enable these devices for export and import.

Also, add the ECAD identifiers for all devices which need to support export/import in ECAD.

6. Reimport the pbf file to import the third party devices.

6.6.1.5 Exporting PLC data to ECAD tool

1. Open the existing PLC project.
2. In the device tree, right-click “PLC ➔ Export ➔ ECAD (PBF)”.
3. Select the desired location in the file system to save the PBF file.

The ECAD user can import the exported PBF file from Automation Builder and can use the imported PLC data for electrical engineering purpose. If the user modifies imported PLC data in the ECAD project, the data can be imported back to the Automation Builder project which supports the round trip engineering efficiently with loss less synchronization of the data.

6.6.1.6 Exporting third party devices

1. Right-click on a PLC device, click “Export” and select “ECAD (PBF)”.
2. Save the file to the desired location in the file system.

If the third party devices does not contain assigned ECAD identifiers, a message is displayed showing which devices cannot be exported.

To add ECAD identifiers to the devices, see Importing third party devices " Chapter 6.6.1.4 "Importing third party devices” on page 4192.

After adding ECAD identifiers to the third party devices, execute “Export” to export the devices including third party devices.
6.6.1.1.7 Importing ECAD PLC data to existing AB project

Automation Builder ECAD interface supports concurrent engineering by importing the ECAD data to the existing Automation Builder PLC project.

1. From the main menu, select “Project ➔ Import ➔ ECAD (PBF)”.
2. Select the PBF file which has been created during the export from the ECAD tool.
3. Select the PLC from the list and click “OK”.
   ⇒ A dialog window is displayed if the Automation Builder project provides PLCs of the identical type as defined in the PBF file.
   By selecting “None” in the dialog window a new PLC is defined in the ECAD tool.
4. In the Project Compare – Differences view, click to merge device signals.
   ⇒ The differences between the current PLC hardware configuration in Automation Builder and the ECAD PLC data are displayed.
5. Select the differences as desired and click “Accept Single” to accept the selected difference block.
6. Close the Project Compare – Differences view to accept the changes.

6.6.1.1.8 Arrange or map devices imported to the device pool

Devices that are imported to the device pool because of missing hierarchy information (mainly rack information) must be arranged manually in the Automation Builder project or mapped to already existing devices.

Arrange devices imported to the device pool

Arrange the unassigned devices in the DevicePool to the PLC hardware structure by drag-and-drop.

Map devices imported to the device pool

If the devices are already added to the Automation Builder project prior to the import, you have to map the instances of the same type manually (one instance in the Automation Builder project tree and one instance in the DevicePool).

After mapping the devices, you can selectively merge the device parameter or signal in the difference view.

To map pool devices, proceed as follows:
1. In the device tree, select the Device Pool node, click “Project” and select “Map pool devices”.

2. Map the device pool instances of identical types in the project from the drop-down list and click “OK”.

   Pool devices which are mapped are removed from the device pool and mapped to the corresponding Automation Builder device. Differences between the signals of the mapped I/O devices are displayed. e.g. AI523_1 device:

   ![Device Tree Diagram](image)

6.6.1.9 Limitations

The following limitations are considered when working with the Automation Builder ECAD interface:

- The scope of a PBF file is limited to one single PLC including all connected devices.
- There is no representation of XC variants of devices in Automation Builder. Therefore, always use the standard variant for export. This might lead to part data mismatch when importing into the ECAD tool.
- In reimport or round trip import cases, if any changes are made in ECAD by adding a new communication module with connecting to one of the PLC slot or replacing existing communication module, then those device changes to the communication modules are not displayed as connected to PLC slots during the import in Automation Builder diff and import, instead those CM modules are added under the device pool. After merging and importing is completed, to work with device pool devices refer to Chapter 6.6.1.8 “Arrange or map devices imported to the device pool” on page 4194.
- IO mapping data cannot be imported for IO devices plugged to an EtherCAT slave when they are imported individually to the device pool because of missing hierarchy information. After arranging the devices properly in the device tree, the import can be done again to import also the IO mapping data.

6.6.1.2 Exporting and importing I/O mapping (CSV)

The I/O module mappings of an Automation Builder project can be exported to CSV for bulk editing in MS Excel or other documentation purposes. I/O mappings can be exported at single I/O module level or at PLC level.
Further, the I/O module mappings can be imported with the option of displaying differences and merging each single changed or import all signals at once by overwriting existing I/O module signals.

### 6.6.1.2.1 Exporting IO mapping data to CSV

To export I/O mappings to a CSV signal list, proceed as follows:

1. In the device tree, right-click “PLC ➔ Export ➔ IO mapping (CSV)”.
2. Save the **IO mappings CSV** to the desired location in the file system.

   If the CSV signal list has been exported successfully, a success message is displayed. The status of the export is shown in the dialog.

3. In the export dialog, click the link to open the exported **IO mapping CSV** file in MS Excel.

   The template can only be opened if MS Excel is installed and configured to open .csv files.

4. In the IO mapping (CSV) file, change **Variable** and **Description** fields to edit I/O mappings.

   Do not modify other field’s data in IO mapping (CSV) file.
6.6.1.2 Importing I/O mapping data from CSV

To import an edited I/O mapping (CSV) file, proceed as follows:

1. From the main menu, select “Project ➔ Import ➔ I/O mapping (CSV) ➔ Open”.
2. A CSV signal list import dialog is displayed.
   - With “YES”, all I/O mappings will be imported without difference view. With “NO”, the difference view is displayed with the I/O mapping differences.
3. In the Project Compare – Differences view, click to merge I/O mappings.
4. Select the signal row for which the difference is to be accepted. Select the Variable field and click “Accept Single” to merge the I/O mappings.
5. Close the Project compare – Differences view to accept the changes and merge the I/O mappings with the Automation Builder project.

6.6.1.3 Exporting and importing device list (CSV)

6.6.1.3.1 General

The Automation Builder project devices can be exported to CSV for bulk device renaming or adding device tag labels to devices in MS Excel or other documentation purposes. A devices export is only possible at PLC level.

Automation Builder provides importing devices in bulk based on device type, instance and hierarchy information provided in the CSV file.

6.6.1.3.2 Exporting device list to CSV

To export a CSV device list, proceed as follows:

1. In the device tree, right-click “PLC ➔ Export ➔ Device list (CSV)”.
2. Select the desired location in the file system to save the Device list (CSV).
   - If the CSV device list is exported successfully, a success message is displayed.
3. In the Export dialog, click the link to open the exported CSV device list. The exported CSV device list consists of all devices connected to the PLC that is exported. Each row represents a device with its device type and hierarchy information.

6.6.1.3.3 Creating CSV device list

To create the devices in CSV, use the device list template provided in Automation Builder.

- In the main menu, click “Tools ➔ Create CSV Device list”.
- The device list template is opened in the MS Excel.

The template can only be opened if MS Excel is installed and configured to open .csv files.

In this file, add each device in a separate row with device information like Device Type (Order Num or Device Type Name) and instance details (name, tag) and hierarchy information (parent Device name, parent Device Tag, position). The mandatory information required to import CSV is only Device Type. All other fields are optional. After editing the device list CSV file, save it in the file system and close.
6.6.1.3.4 Importing a device list from CSV

To import devices from CSV in bulk, proceed as follows:

1. From the main menu, click “Project ➔ Import ➔ Device list (CSV)”.
2. Select the device list CSV file from the file system and click “Open” in the Import dialog.
   All devices that are defined in the CSV are imported. The Project Compare – Differences view displays the current project and the project that has been updated by the import file.
3. Select the desired devices and click “Accept Block” to accept all the devices and its child device nodes or “Accept Single” to accept only a single device.
4. After closing the Project Compare – Differences view, the devices are imported to the Automation Builder project.
   • The devices (except PLC) are placed under the device pool if the valid device hierarchy information is not provided in the CSV device list file. By drag-and-drop devices can be assigned to the desired PLC hardware structure © Chapter 6.6.1.1.8 “Arrange or map devices imported to the device pool” on page 4194.
   If a device tag is provided for a device in CSV, it appears next to each device node in the device tree.

6.6.1.3.5 Renaming devices

To rename the devices, proceed as follows:

1. In the device tree, right-click “PLC ➔ Export ➔ Device list (CSV)”.
2. Select the desired location from the file system to save the CSV device list.
3. Rename the device names in the column **Device Name**:

![Excel sheet](image)

4. Click **Project ➔ Import ➔ Device list (CSV)**.

5. Select the updated CSV file from the file system.

   Open the **Project Compare – Differences** view. If only the device names have been changed in the CSV file, the difference view does not show the changes.

   **Device Name changes are not displayed as changes in the difference view.**

6. Close the **Project Compare – Differences** view. The Renamed Devices dialog is displayed with the current name and the new name provided in the CSV file.

7. In the Rename Devices window, select the desired devices and click “OK”. The device names are updated in the Automation Builder project.
6.6.2 CODESYS Security Agent

6.6.2.1 Integration in CODESYS Development System

At this time, you can configure and create certificates of the controller with the CODESYS Security Agent. You can then configure encrypted communication with the controller, as well as encrypt the boot application, download, and online change.

- § Chapter 6.6.2.2 “Encrypted Communication with Devices via Controller Certificates” on page 4201
- § Chapter 6.6.2.3 “Encryption of the Boot Application, Download, and Online Change” on page 4202

6.6.2.2 Encrypted Communication with Devices via Controller Certificates

An application can be encrypted and signed in order to protect a running application in an AC500 V3 PLC and to protect a configured project. How to set-up the user management, the communication and the boot application in order to prevent unauthorized access is explained in the application note AC500 V3 - Encrypt and sign your application.

Requirement: A digital signature for certificate exchange is configured.

§ Chapter 6.4.1.9.18 “Protecting an application” on page 1915

No certificate use in live system
Self-signed certificates should never be used on production or public websites. The certificates that are created in the following steps are self signed.

We assume that there is still no certificate on the controller that is intended for encrypted communication. In the following steps, you generate this kind of certificate and encrypt communication:

1. Configure the active path to the controller.
2. Open the “Security Screen” view by double-clicking the symbol in the status bar or by clicking “View ➔ Security Screen”. Select the “Devices” tab.
3. Click the button to refresh the list of available devices and their certificate stores.
4. Select the corresponding device on the left side.
   ➔ On the right side, there is still no license listed for the “Encrypted communication” use case.
5. On the right side, select “Encrypted Communication” and click the button to create a new certificate on the device.

Change the default key length to 4096. Otherwise an error occurs that is only visible in the log of the PLC.

➔ The certificate is generated and listed in the table with its properties. The symbol before “Encrypted communication” now appears as such: 📝. The field in the "Valid until" column is highlighted in green because the remaining time is still at least two-thirds of the entire validity period.
6. In this step, you activate encrypted communication with the controller.

Open the “Security Screen” view of CODESYS ("Users" tab). In the “Security Level” group, select the “Enforce encrypted communication” option.

⇒ As of this point, communication with all controllers is possible only as long as the certificate is valid on the controller and you have a key for it.

The connecting line between the development system, the gateway, and the controller is displayed in yellow on the “Communication Settings” tab of the device editor of the controller.

As an alternative to the “Enforce encrypted communication” option that was just described and which applies to all controllers, you can also encrypt communication with a specific controller only. To do this, open the “Communication” tab in the device editor of the controller. Click “Encrypted Communication” in the “Device” list box.

7. Now log back in again to the controller.

⇒ A dialog opens with the notification that the certificate of the controller is not signed by a trusted source. In addition, the dialog displays information about the certificate and prompts for you to install it as a trustworthy certificate in the local store in the “Controller Certificates” folder.

8. Confirm the dialog.

⇒ The certificate is installed in the local store and you are logged in to the controller.

In the future, communication with the controller will be encrypted automatically with this control certificate.

Note: When logging in to the controller, the expiration date of the certificate currently in use is checked. You get a warning if the remaining time is just one-third of the entire time or less. Then you can renew the certificate in time in the security screen.

See also

● § Chapter 6.6.2.4.1 “View ‘Security Screen’ - ‘Devices’” on page 4205
● § Chapter 6.6.2.1 “Integration in CODESYS Development System” on page 4201

6.6.2.3 Encryption of the Boot Application, Download, and Online Change

An application can be encrypted and signed in order to protect a running application in an AC500 V3 PLC and to protect a configured project. How to set-up the user management, the communication and the boot application in order to prevent unauthorized access is explained in the application note AC500 V3 - Encrypt and sign your application.

Aim: You want to encrypt boot applications, downloads, and online changes with a certificate to make sure that the application on the controller cannot be exchanged at will. To do this, you need to download a corresponding certificate of the type “Encrypted Application” from the controller and install it to the “Windows Certificate Store” of your computer. This certificate is required for all development environments that need to make changes to the application on the controller. For example, if this application has to be downloaded from another computer, then the certificate also has to exist on this computer.

See also

● § Chapter 6.6.2.1 “Integration in CODESYS Development System” on page 4201
Encrypting the boot application, download, and online change with the encryption wizard

Requirement: The active path to the controller is configured.

1. Open the “Properties” dialog of the application.
2. Click the “Encryption” tab. Set “Encryption Technology” to “Encryption with certificates”.
   ⇒ The “Encryption Wizard” button is available in the “Certificates” field.
3. Click the “Encryption Wizard” button.
   ⇒ The “Encryption Wizard” dialog opens. The status is Not connected and under “Details” is Ready.
4. Click the “Start” button.
   ⇒ The wizard searches for suitable certificates on the controller. If necessary, the controller creates a new certificate which is registered in the Certificate Store of your computer.
   
   NOTE: A certificate obtained this way is automatically accepted as trusted.
   If a certificate for application encryption already exists on the controller, then it is used.
   If a new certificate has to be created on the controller for your CODESYS, then the “Certificate Settings” dialog opens for configuring the key length for the private key and the validity period.
5. In the “Certificate Settings” dialog, click “OK” to confirm the default or edited values for key length and validity period.
   ⇒ CODESYS saves the values in the CODESYS options as the default for the next certificate configuration of this kind.
   In the “Details” of the wizard, you see a description of the performed actions and the thumbprint of the recently created certificate.
6. When the status reaches “Wizard finished”, close the wizard.
   ⇒ The new certificate is listed in the “Certificates” field of the properties dialog. In the “Certificate Store”, it is listed under “Controller Certificates”. In the “Security Screen” view, on the “Devices” tab, the certificate is displayed in the right window with the “Encrypted Application” information.
7. Confirm the “Properties” dialog of the application.
8. Open the “Security Screen” view.
   ⇒ On the “Project” tab, in the “Encryption of boot application, download and online change” group, the certificate is displayed with the “Encrypted Application” information.
   Boot application, download, and online change are therefore encrypted and only possible as long as the configured certificate and signature are valid.

See also
● Chapter 6.6.2.4.2 “Dialog ‘Encryption Wizard’” on page 4207
● CODESYS Help: Dialog "Properties" "Encryption"
Encrypting the boot application, download, and online change without the encryption wizard

Requirement: The active path to the controller is configured. There is still no certificate on the controller that is suitable and valid for encryption.

1. Open the “Security Screen” view by double-clicking the symbol in the status bar or by clicking “View ➔ Security Screen”. Open the “Devices” tab.
2. Click the “Refresh the list of available devices and their certificate stores” button.
3. Select the device listed on the left side.
4. Select “Encrypted Application” on the right side and click the “Create a new certificate on the device” button.
   - Change the default key length to 4096. Otherwise an error occurs that is only visible in the log of the PLC.
   - The certificate is created and listed in the table with the symbol.
5. Double-click the certificate entry.
   - The Windows “Certificate” default dialog opens.
6. Click the “Install certificate” button on the “General” tab.
   - The “Certificate Import Wizard” opens.
7. In the “Certificate Store” dialog, select the “Place all certificates in the following store” option and select the “Controller Certificates” folder for “Certificate Store”.
   - The controller certificate is imported to the “Controller Certificates” directory and it is immediately available for the encryption of downloads, online changes, and boot applications.
8. Open the “Project” tab and double-click the application entry in the “Encryption of boot application, download and online change” group.
   - The “Properties” dialog of the application opens.
9. Click the “Encryption” tab and set “Encryption Technology” to “Encryption with certificates”. Then click ➔. Note: If the “Enforce encryption of downloads, online changes and boot applications” option is selected in the “Security Screen”, then “Encryption with certificates” is already preset.
10. In the “Certificate Selection” dialog, select the corresponding certificate from the “Controller Certificates” folder and click ➔.
11. Click “OK” to confirm the dialog.
   - The certificate is displayed in the properties dialog.
12. As above when using the wizard, steps 7 and 8.

Enforcing the encryption of boot applications, downloads, and online changes

- Open the “Users” tab in the “Security Screen”. In the “Security level” group, select the “Enforce encryption of downloads, online changes and boot applications” option.
- Only with a valid certificate is it possible to change the application on the controller.
6.6.2.4  Reference, User Interface

6.6.2.4.1  View 'Security Screen' - 'Devices'

Symbol: 🗝

**Function:** The tab allows for the configuration and the transfer of controller certificates for encrypted communication with the controller.

**Call:** Menu bar: “View”

The “Devices” tab shows all PLC devices configured in the project and their certificate store. If the communication path to the controller is configured, then you see the certificates that are stored in memory. Here you can create and configure new certificates on the controller. If a certificate currently in use is about to expire, then you get a warning when you log in to the device. From there you can also switch directly to the “Security Screen” to renew the certificate.

<table>
<thead>
<tr>
<th>Left side: “Information”</th>
<th>Devices and certificate store</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shows the individual devices 🗝 as expandable nodes, each with the controller-specific 🗝 certificate store below it.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Toolbar (left side)</th>
<th>⌚: Refresh the display</th>
</tr>
</thead>
<tbody>
<tr>
<td>📦: Download: Transfer the selected certificate to the PLC</td>
<td></td>
</tr>
</tbody>
</table>
If the active path to the controller is set and a device node is selected, then every use case for controller certificates is displayed on the right side.

- **“OPC UA Server”:** Encrypted communication over an OPC UA server
- **“Encrypted Communication”:** Encrypted communication between the development system and the controller
- **“Encrypted Communication”:** Encryption of the boot application
- **“Web server”:** Encrypted communication with the web server

As long as a certificate is not available for one of these use cases, it is displayed with the "(not available)" symbol.

When a certificate store is selected on the left side, all certificates in it are displayed on the right side with the following information:

- **“Information”:** Use case (currently the controller component in question is displayed: for example, “CmpSecureChannel”)
- **“Created for”:** Name of the computer for which the certificate was created (for example, “MyLocalPC”)
- **“Created by”:** Name of the computer on which the certificate was created (for example, “MyLocalPC”)
- **“Valid as of”:** Date (for example, “07/20/2017 15:09:29”)
- **“Valid until”:** Date (example: “07/20/2022 00:00:00”). Depending on the remaining time of the certificate, the highlight color of the field changes: green -> yellow (two-thirds expired) -> orange (nine-tenths expired) -> red (expired). Note: When logging in to the controller, you get a warning when two-thirds or more of the validity period have expired. Then you can renew the certificate here in the “Security Screen”.
- **“Thumbprint”:** Hash value from specific properties of the certificate for purposes of identification (for example, “279e1a46b86bd636c8e6f19d51c222469ec49a8”)

This thumbprint can be used together with the Mqtt library. Refer to the Mqtt library documentation in the Library Manager.

Double-clicking a certificate entry opens the default Windows “Certificate” dialog. As a result, you can import a controller certificate into the Windows Certificate Store in the “Controller Certificates” folder, so that it is available for the encryption of boot applications, downloads, and online changes.

If multiple certificates are available for one use case, then the system follows the steps below to determine the certificate that is used:

- Certificate that was created directly by the user (currently not supported)
- Filtering of existing certificates by:
  - 1. Subject (user of the certificate)
  - 2. Key usage
  - 3. Extended key usage
  - 4. Valid time stamp
- Dividing of detected, valid certificates as "signed" and "self-signed"
- Filtering of signed certificates, and the self-signed certificates by the following criteria:
  - 1. Longest validity period
  - 2. Strongest key
Drag&Drop: Moving of the certificate to another certificate store of the same device
Double-clicking a certificate entry opens the default Windows dialog for displaying all certificate information.

Toolbar (right side)
- ✖: Creates a new certificate for a specific use case
- The “Certificate Settings” dialog opens for configuring the “Validity period” of the certificate and the “Key length” for the private key. Clicking “OK” saves the specified values in the CODESYS options. The values are reset at the next operation.
- As long as the certificate is being created, “(computing)” is shown after the use case. You cannot cancel the creation operation, but you can close and continue working with the “Security Screen”.
- ✖: Delete the selected certificate.
- ✮: Upload and save the selected certificate to the local file system.
- ✴: Details about the selected certificate: Opens the “Certificate” dialog with the “General” tab, “Details” tab, and “Certification Path” tab.
- ✪: Renew the selected certificate. Opens the “Certificate Settings” dialog to create an additional new certificate for a certificate that will expire soon, with the same purpose and specified key length. The predefined values in the dialog are adapted, if necessary, depending on the selected certificate.

6.6.2.4.2 Dialog 'Encryption Wizard'

Function: The wizard makes sure that a certificate for the encryption of downloads, online changes, and boot applications is downloaded from the controller. If a valid certificate does not exist on the controller for this purpose, then the wizard makes sure that a certificate is created. Changes to the application on the controller (download, online change, boot application) are possible only when this certificate exists.


Requirement: “Encryption Technology” is set to “Encryption with certificates”.
### Status

Statuses while the wizard is in action:

- **“Not connected”**: The connection to the controller has not been established yet or the device cannot be reached.
- **“Error connecting to the device”**: The network path to the controller has not been set correctly.
- **“Connecting...”**: A connection to the controller is being established.
- **“Processing request...”**: The wizard is checking for available certificates and if necessary makes sure that the controller creates a new certificate. The certificate downloaded from the controller is automatically classified as "trusted" and registered in the Certificate Store of the computer.
- **“Wizard finished”**

### Details

Description of the individual actions of the wizard with corresponding notices in the case of failures

### Start

If the connection path to the controller is set correctly in the device editor, then the wizard starts the necessary actions for encrypting downloads, online changes, and boot applications with a certificate.

If an expired certificate exists, then a corresponding warning is displayed with a dialog prompt whether or not a new certificate should be created by the controller. When this is confirmed, the new certificate is created and loaded to the local Certificate Store. In this case, the existing boot application may not start anymore and must be created again with the new certificate.

The “Certificate Settings” dialog opens when a new certificate is to be created on the device. Here you configure the “Key length (bit)” and the “Validity period (days)” for the certificate.

See also

- % Chapter 6.6.2.3 “Encryption of the Boot Application, Download, and Online Change” on page 4202

### 6.6.3 CODESYS Static Analysis

#### 6.6.3.1 Introduction

Already when programming in CODESYS, CODESYS Static Analysis helps to write more readable code and to detect contradictory or unsupported settings. In particular, potential sources of error can be identified, such as test code or pointers that have not been checked for 0 before dereferencing. With specific checks, you can make sure that the code is portable. Example: The analysis should report the use of language resources for object orientation because the code is to run on platforms that do not support object orientation.

The analysis checks the source code of the CODESYS project and reports any deviations from certain coding rules, naming conventions, or permitted keywords and identifiers. CODESYS Static Analysis is based on the rule set defined in the PLCopen Coding Guidelines and extends it with additional test options.

You can display the detected deviations as errors or warnings in the message view before the project is downloaded to the target system. For errors that are reported by Static Analysis based on precompile information, there is support for an immediate error handling ("Quickfix").

You activate Static Analysis either explicitly by clicking “Build ➤ Run Static Analysis”, or you let it execute automatically at each code generation. You activate the automatic execution in the “Static Analysis” dialog of the projects settings. In this dialog, you also configure what is to be checked in detail. You can use pragma statements to exclude individual parts of the code from the check.

To evaluate the code quality, you can also display selected metrics that CODESYS Static Analysis detects in your code in a separate view. An example of this is the McCabe metric, which measures the cyclomatic complexity and indicates the number of execution paths that can be processed during code execution.
NOTICE!
The analysis is performed only for the code of the applications in the current project. Libraries are not taken into consideration.

The CODESYS development system contains a light version of Static Analysis that is extended by CODESYS Static Analysis.

Application example
The Pro Static Analysis tool can be used to check the source code during programming or for debugging purposes in order to identify possible weaknesses of the code. Usage and benefits of the Pro Static Analysis tool are described in the application example Pro Static Analysis tool.

- § Chapter 6.6.3.2.2 “Dialog 'Static Analysis Settings' - 'Settings'” on page 4217
- § Chapter 6.6.3.1 “Commands” on page 4212
- § Chapter 6.6.3.4.1 “Pragmas and Attributes” on page 4228

6.6.3.2 Configuring and Running Static Analysis
Using a basic sample project below, you will find the most important steps and options for configuring and running a static analysis.

Requirements: CODESYS Static Analysis is installed.

Sample project
If you want to reproduce the example project, create a standard project and insert the POU's below the application in the device tree. Then configure the communication settings for the connection to your local CODESYS Control Win V3.

FUNCTION_BLOCK fb1
VAR_INPUT
    iVar_fb1in1 : INT;
    iVar_fb1in2 : INT;
    rVar_fb1in3 : REAL;
END_VAR
VAR_OUTPUT
    iVar_fb1out:INT;
END_VAR
VAR
    P_fSampleProperty : INT;
    rVar : REAL;
    PRO : BOOL;
END_VAR
iVar_fb1out:=iVar_fb1in1 + 1;

FUNCTION_BLOCK fb2
VAR_INPUT
    iVar_fb2in:INT;
END_VAR
VAR_OUTPUT
    iVar_fb2out:INT;
END_VAR
VAR
END_VAR
PROGRAM PLC_PRG
VAR
    fb1_inst: fb1;
    fb2_inst: fb2;
END_VAR
fb1_inst(iVar_fb1in1 := 99);
fb2_inst(iVar_fb2in := 22);
fb2_inst(iVar_fb2in := 1);

Checking for compliance to rules

1. Click “Build ➔ Static Analysis ➔ Settings”. Switch to the “Rules” tab.
   ⇒ A list is displayed containing all possible rule checks. They are organized in a tree
   structure by topical category. The rule number is added in parentheses (for example, “Unused variables (33)” in category “Unused objects”).

2. Click the check box of the first line a few times (“Rules” node).
   ⇒ Clicking toggles the activation status. The check boxes in the entire tree have a red or
   orange check mark, or no check mark at all.

3. In this way, activate all entries with a red check mark. This means that CODESYS Static
   Analysis should report any detected rule violations as errors.

4. Click “Build ➔ Static Analysis ➔ Run Static Analysis”.
   ⇒ Errors are reported in the message view. The message texts are tagged with a § and
   begin with the error number “SA<rule number>”.

5. Double-click the first message SA0033: Unused variables 'iVar_fb2out'.
   ⇒ The focus moves to the declaration part of function block fb2 and the relevant vari-
   able is selected. The variable is declared, but not used. This is checked in Rule 33
   (“Unused variables”). In the code, the relevant locations are underlined with a wavy
   line.

6. To test the automatic execution of the analysis, click “Build ➔ Static Analysis ➔ Settings”. On the “Settings” tab, select the “Perform static analysis automatically” option. Click “OK” to exit the dialog.

7. Click “Online ➔ Login”.
   ⇒ A dialog prompt indicates that compile errors exist. The errors reported by the code
   analysis are displayed again in the message view.

8. Click “Build ➔ Static Analysis ➔ Settings”. Switch to the “Rules” tab. Now clear all of
   the rules in the dialog. In the “Unused Objects” category, explicitly activate Rule SA0035
   (“Unused input variables (35)”) with an orange-colored check mark to report a warning.
   See the tooltip for the rule text: “This rule corresponds to the following PLCopen rules:
   CP24”). Click “OK” to exit the dialog.

   In the project settings, click “OK”.

9. Click “Build ➔ Generate Code”.
   ⇒ The analysis is performed automatically. Two errors are reported in the message view:
   § SA0035: Unused input variable 'iVar_fb1in2 and § SA0035: Unused
   input variable 'iVar_fb1in3.

10. Double-click the message and comment or remove the declaration. Perform the code
    analysis again.
    ⇒ No error messages are displayed.
Checking for compliance to defined naming conventions

1. Click “Build ➔ Static Analysis ➔ Settings”. Click the “Naming Conventions” tab.
   ⇒ You see a table in a tree structure that is divided into expandable categories of variables and program blocks.

2. Expand the “Prefixes for Variables” - “Prefixes for Types” category, and in the “Prefix” column, specify I for “INT (14)”.
   Expand the “Prefixes for POUs” - “Prefixes for POU Type” category: In the “Prefix” column, specify the prog for “PROGRAM (122)” and fb for “FUNCTIONBLOCK (103)”.

3. Select the “First character after prefix should be an uppercase letter” option. Clear all other options.

4. Click “Build ➔ Static Analysis ➔ Run Static Analysis”.
   ⇒ Error messages:
   - NC0102: Invalid name 'PLC_PRG': Expect prefix 'prog' because PLC_PRG does not have the required prefix
   - First character after prefix should be uppercase: 'ivar_fb1in2' because ivar_fb1in2 : INT; in fb1
   - NC0014: Invalid variable name P_fSampleProperty: Expect prefix 'i' because this integer variable does not have the required prefix

See also
- Chapter 6.6.3.3.2.4 “Dialog 'Static Analysis Settings' - 'Naming Conventions'” on page 4219

Checking for forbidden symbols

1. Click “Build ➔ Static Analysis ➔ Settings”. Click the “Forbidden Symbols” tab.
   ⇒ A line editor allows for specifying character strings that should not be used in the code.

2. As an example, double-click the blank line and type in the invalid character string PRO directly. Double-click the next blank line and click ☐ to open the input assistance. From “Standard Types”, select “REAL”. Click “OK” to exit the dialog.

3. Click “Build ➔ Static Analysis ➔ Run Static Analysis”.
   ⇒ The error messages Forbidden symbol 'REAL' and Forbidden symbol 'PRO' are displayed in the message view. Double-click the message text to jump to the relevant line of code.

See also
- Chapter 6.6.3.3.2.6 “Dialog 'Static Analysis Settings' - 'Forbidden Symbols'” on page 4227
Displaying of metrics

CODESYS Static Analysis performs selected tests on the code, and you can display the results in a view.

1. Click “Build ➔ Static Analysis ➔ Settings”. Click the “Metrics” tab.
   - The metrics that CODESYS Static Analysis applies to the code are listed in a table.

2. For this example, activate the “Number of inputs variables” metric and specify the permitted range of values: lower limit 1 and upper limit 2. Activate some more metrics, for example “Code size” and “Number of calls”.

3. Click “Build ➔ Static Analysis ➔ View Standard Metrics”.
   - The view includes a table with a line for each “Program unit” of the sample program. For each activated metric, there is a column showing the measured values. Values that are outside of the range of values defined in the settings are highlighted in red. In the case of this specific example, this is at least the “PLC_PRG/Inputs” field because the number of input variables in this POU is greater than the defined upper limit of 2.

See also

- Chapter 6.6.3.3.2.5 “Dialog ‘Static Analysis Settings’ - ‘Metrics’” on page 4226

See also

- Chapter 6.6.3.3.1 “Commands” on page 4212

6.6.3.3 Reference, User Interface

6.6.3.3.1 Commands

- Command 'Settings'
  Function: The command opens the “Static Analysis Settings” dialog.
  Call: Menu bar: “Build ➔ Static Analysis”
  Requirement:
  - The CODESYS Static Analysis package is installed.
  - A project is open.

See also

- Chapter 6.6.3.3.2.2 “Dialog ‘Static Analysis Settings’ - ‘Settings’” on page 4217

Command 'Run Static Analysis'

Symbol: §

Function: The command starts the static analysis for the active application and displays the results in the message view.
Call: Menu bar: “Build ➔ Static Analysis”

During the code analysis, CODESYS generates code just like the “Build ➔ Generate Code” command. The results of the analysis are displayed as errors and warnings in the message view (“Build” category). The numbers refer to the corresponding rules as they are defined in the project settings. The syntax for the displayed messages is “SA<rule number:<rule text>”.

See also
● § Chapter 6.6.3.4.2 “Rules” on page 4233

Command 'View Standard-Metrics'

Symbol: 

Function: The command starts the static analysis for the active application and displays the metrics for all POUs in a table.

Call: Menu bar: “Build ➔ View Standard Metrics”

The metrics (code numbers) to be displayed are activated in the project settings. You can access the configuration by clicking “Configure” in the context menu of the displayed table. If a value is outside of the configured upper and lower limits, then the field in the table is highlighted in red.

See also
● § Chapter 6.6.3.3.2.5 “Dialog 'Static Analysis Settings' - 'Metrics'” on page 4226

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Code size&quot;</td>
<td>Number of bytes</td>
</tr>
<tr>
<td>&quot;Variable size&quot;</td>
<td>Number of bytes</td>
</tr>
<tr>
<td>&quot;Stack size&quot;</td>
<td>Number of bytes</td>
</tr>
<tr>
<td>&quot;Calls&quot;</td>
<td>Number of calls</td>
</tr>
<tr>
<td>&quot;Tasks&quot;</td>
<td>Number of calls from tasks</td>
</tr>
<tr>
<td>&quot;Global&quot;</td>
<td>Number of different global variables</td>
</tr>
<tr>
<td>&quot;I/Os&quot;</td>
<td>Number of direct object accesses</td>
</tr>
<tr>
<td>&quot;Local&quot;</td>
<td>Number of local variables</td>
</tr>
<tr>
<td>&quot;Inputs&quot;</td>
<td>Number of input variables</td>
</tr>
<tr>
<td>&quot;Outputs&quot;</td>
<td>Number of output variables</td>
</tr>
<tr>
<td>&quot;NOS&quot;</td>
<td>Number of statements</td>
</tr>
<tr>
<td>&quot;Comments&quot;</td>
<td>Percentage of comments</td>
</tr>
<tr>
<td>&quot;McGabe&quot;</td>
<td>McGabe complexity</td>
</tr>
<tr>
<td>&quot;Prather&quot;</td>
<td>Prather complexity of nesting</td>
</tr>
<tr>
<td>&quot;DIT&quot;</td>
<td>Depth of inheritance tree</td>
</tr>
<tr>
<td>&quot;NOC&quot;</td>
<td>Number of children</td>
</tr>
<tr>
<td>&quot;RFC&quot;</td>
<td>Response for class</td>
</tr>
<tr>
<td>&quot;Elshof&quot;</td>
<td>Elshof complexity of reference</td>
</tr>
<tr>
<td>&quot;CBO&quot;</td>
<td>Coupling between objects</td>
</tr>
<tr>
<td>&quot;LCOM&quot;</td>
<td>Lack of cohesion in methods</td>
</tr>
<tr>
<td>&quot;n1 (Halstead)&quot;</td>
<td>Number of different used Halstead (n1) operators</td>
</tr>
<tr>
<td>Metric</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>&quot;N1 (Halstead)&quot;</td>
<td>Number of Halstead (N1) operators</td>
</tr>
<tr>
<td>&quot;n2 (Halstead)&quot;</td>
<td>Number of different used Halstead (n2) operands</td>
</tr>
<tr>
<td>&quot;N2 (Halstead)&quot;</td>
<td>Number of operands (N2)</td>
</tr>
<tr>
<td>&quot;HL (Halstead)&quot;</td>
<td>Halstead length (HL)</td>
</tr>
<tr>
<td>&quot;HV (Halstead)&quot;</td>
<td>Halstead volume (HV)</td>
</tr>
<tr>
<td>&quot;D (Halstead)&quot;</td>
<td>Halstead difficulty (D)</td>
</tr>
<tr>
<td>“ SFC branches”</td>
<td>Number of SFC branches</td>
</tr>
<tr>
<td>“SFC steps”</td>
<td>Number of SFC steps</td>
</tr>
</tbody>
</table>

The following commands are provided in the context menu of the table:

- “Calculate”: The values are refreshed.
- “Copy Table”: The table is copied to the clipboard. The separators are tabs.
- “Print Table”: The default dialog for setting up a print job opens.
- “Export Table”: The table is exported as a CSV file. The separators are semicolons.
- “Kiviat Diagram”: Requirement: At least three metrics have defined upper and lower limits. A radar chart is created for the selected POU. This visualizes the quality of POU code with respect to a given standard. Each metric is depicted as an axis with its origin at the center (value 0) which radiates outward into three concentric ring zones. The inner ring zone represents the range of values below the lower limit defined for the metric. The outer ring represents the range of values above the upper limit. The axes of the metrics are distributed uniformly around the circle. The current values of the individual metrics on the axes are connected by a line. In the ideal case, the complete line is located in the middle zone.
- “Configure”: The table for selecting the desired metrics opens. This corresponds to the table in the project settings.
- “Open POU”: The POU opens in the editor.
The name of the metric is displayed at the end of the respective axis and the name of the POU is displayed in the upper right corner of the diagram.

Example of a Kiviat diagram for five metrics

Command 'Extract function'

**Function:** The command opens the “Extract Function Configuration” dialog. The command extracts selected code from the ST editor and creates a new method or function containing this code. The affected code in the ST editor is replaced by a correct call. When code is extracted from a function block or the child of a function block, a new method is created from the code. When code is extracted from a program or a function, a new function is created from the code.

**Call:** Context menu: “Refactoring”

**Requirements:** When the selected code consists of one or more statements:

- The selected code does not contain any compile errors.
- The selected code is located in the implementation part of an ST POU.
- The selected code does not contain any exiting jumps

Examples of exiting jumps include the following:
- Using **RETURN** to exit the enclosing function
- Using **CONTINUE** or **EXIT** to exit a loop enclosing the code

You can undo the changes that the “Extract function” command made in your project by positioning the cursor in the device tree and clicking “Edit ➤ Undo.”
Table 770: Dialog “Extract Function Configuration”

<table>
<thead>
<tr>
<th>“Name”</th>
<th>Name of the recently created function or method</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The default name can be changed.</td>
</tr>
<tr>
<td>“Return value”</td>
<td>Determines the return value of a function if there are multiple output and/or input/output parameters</td>
</tr>
<tr>
<td>“Parameter”</td>
<td>Display of the available POUs</td>
</tr>
<tr>
<td></td>
<td>Configuration whether the parameters are used as input, output, or input/output variables</td>
</tr>
<tr>
<td></td>
<td>[✓] Input variables</td>
</tr>
<tr>
<td></td>
<td>[✓] Output variables</td>
</tr>
<tr>
<td></td>
<td>[✓] [✓] Input/Output variables</td>
</tr>
<tr>
<td></td>
<td>The changes made for “Name”, “Return value”, or “Parameter” are undone.</td>
</tr>
</tbody>
</table>

Upper code window  Recently created code of the call location
Lower code window  Recently created code of the function or method

“OK”  The displayed code changes are accepted in the ST POUs and the dialog is closed.

“Cancel”  The displayed code changes are rejected and the dialog is closed.

Command ‘Detect clones’

Function: The command scans the program code of the open CODESYS project for copied code, and opens the “Clone detection results” view to display the detected cloned code blocks. In the process, only code blocks larger than a specific size are considered to be clones. Very small chunks of code are not displayed as clones.

Call:
- Menu bar: “Build ➔ Static Analysis”
- Context menu: “Static Analysis”

Requirement: The CODESYS project is open.

Two code positions are considered clones if they have the following properties:
- Same structural composition
- Variables have the same data type.
- Variable names may be different (exception: component access). However, an identifier that is contained multiple times in the code has to be in the same place in both code positions.
- Literals have the same data type.
- Literals may be different. A literal that occurs multiple times in the code has to occur at the same place in both code positions.

Table 771: View “Clone detection results”

<table>
<thead>
<tr>
<th>“Summary”</th>
<th>Tab to display the search results</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>“Number of found cloned code sequences”</td>
</tr>
<tr>
<td></td>
<td>“Number of statements compared”</td>
</tr>
<tr>
<td></td>
<td>“Number of statements in cloned code”</td>
</tr>
<tr>
<td></td>
<td>“Clone ratio”: Specified as a percentage: “Number of statements in cloned code” / “Number of statements compared”</td>
</tr>
</tbody>
</table>
The tab displays the code clones in a tree view and provides commands and filter options. The first occurrence of a duplicate from the set of duplicates is taken as the root node. The background color of the child nodes indicates whether the code is different or completely identical. Same colors mean the "same code". The contents of the tree view are sorted in descending order by the number of statements of the duplicated code.

### Commands and filters on the "Results" tab

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Subnodes/Clone&quot;</td>
<td>Number of subnodes (statements) in the code block</td>
</tr>
<tr>
<td></td>
<td>If the number of subnodes is less than 20, then the code clone is not considered.</td>
</tr>
<tr>
<td>&quot;Filter on Object&quot;</td>
<td>Input field for an &quot;Object&quot;, by which the clone list is filtered</td>
</tr>
<tr>
<td>&quot;Show selected clones&quot;</td>
<td>Requirement: Two child nodes of the same parent node are selected.</td>
</tr>
<tr>
<td></td>
<td>Both programming objects are displayed in the upper part of the view for comparison. In the process, the code duplicates are highlighted and differences (for example, different variable names) are highlighted in a different color.</td>
</tr>
</tbody>
</table>

### List of code clones

<table>
<thead>
<tr>
<th>Columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Description&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Subnodes/Clone&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Object&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Position&quot;</td>
<td></td>
</tr>
</tbody>
</table>

Double-clicking a child node opens the corresponding programming object, and the duplicated code block is selected there.

### Dialogs

6.6.3.3.2.1 General ........................................................................................................ 4217
6.6.3.3.2.2 Dialog 'Static Analysis Settings' - 'Settings' .................................. 4217
6.6.3.3.2.3 Dialog 'Static Analysis Settings' - 'Rules' ...................................... 4218
6.6.3.3.2.4 Dialog 'Static Analysis Settings' - 'Naming Conventions'................... 4219
6.6.3.3.2.5 Dialog 'Static Analysis Settings' - 'Metrics'................................... 4226
6.6.3.3.2.6 Dialog 'Static Analysis Settings' - 'Forbidden Symbols'................... 4227

#### General

For the dialogs for the configuration of static code analysis, click "Build ➔ Static Analysis ➔ Settings". Requirement: A CODESYS project is open.

#### Dialog 'Static Analysis Settings' - 'Settings'

**Function:** In the dialog, you select automatic static analysis, and save or load the project settings for static analysis as a CSA file.

**Call:**
- Menu bar: “Project ➔ Project Settings”, “Static Analysis” category, “Open configuration dialog” link
- Menu bar: “Build ➔ Static analysis ➔ Settings”

**Requirement:**
- The CODESYS Static Analysis package is installed.
- A project is open.
Perform static analysis automatically

☑ CODESYS performs the code check automatically at each code generation (for example, when the "Build ➔ Generate Code" command is executed or before a download.

☐ The code check is not performed automatically, but it can be performed explicitly by means of the "Build ➔ Static Analysis ➔ Run Static Analysis" command.

Load

Opens the “Load Static Analysis Configuration” dialog for selecting the project settings for the static analysis as a CSA file in the file system. When you click the "Open" button, the selected CSA file is loaded.

Save

Opens the “Save Static Analysis Configuration” dialog for saving all project settings in the “Static Analysis” category as a CSA file in the file system.

See also

● Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

Dialog 'Static Analysis Settings' - 'Rules'

Function:

In the dialog, you select the rules that are checked during the static analysis of the source code of a project.

Call:

● Menu bar: “Project ➔ Project Settings”, “Static Analysis” category, “Open configuration dialog” link

● Menu bar: “Build ➔ Static analysis ➔ Settings”

Requirement:

● The CODESYS Static Analysis package is installed.

● A project is open.

This tab shows a tree structure of all rules that can be checked during static analysis. By default, every rule is activated, with the exception of SA0016, SA0024, SA0073, SA0101, SA0105, SA0106, SA0133, SA0134, SA0150, SA0162, and all strict IEC rules.

Each rule has a unique number. When the rule is checked and a violation is detected, the rule number and an error description are shown in the message view in the "Build" category in the following format: \text{SA<rule number>}, where SA stands for "Static Analysis" (example: "SA003" for rule 3).

The list of available rules can be extended by specific plug-ins.

Some rules that are activated in the dialog can be deactivated temporarily in the application by applying a pragma.

When you click the check box, the setting toggles between ☐, ☑, and ☐.

When you activate or deactivate a parent node, all child rules are also activated or deactivated, respectively.

Filter:

● Input field for the strings to be searched for

☑ ☐ Rules are grouped by category.

– “Structured by Importance”: Sorting by “Importance High”, “Importance Medium”, and “Importance Low”

– “Default”: Default structuring of the rules in CODESYS Static Analysis

☐ ☑ Rules are displayed as a flat list. By clicking on the corresponding column header, the list can be sorted by rule number, activation/deactivation, rule-specific configuration, or importance.
<table>
<thead>
<tr>
<th>Columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Rules”</td>
<td>List of rules with rule number</td>
</tr>
</tbody>
</table>
| Rule check | - [ ]: The rule is not checked.  
- [✓]: If the result of the check is positive, then an error (§) for the static analysis is displayed in the message view.  
- [ ]: If the result of the check is positive, then a warning (§) for the static analysis is displayed in the message view. |
| “Precompile” | Rules which can be checked during precompile are identified by a check mark in this column.  
An immediate bugfix (Quickfix) is possible for these rules. You can execute an automatic, immediate error handling directly at the affected code positions. |
| “Rule specific configuration” | For some rules, you can double-click the field to open a rule-specific dialog to configure the rule. |
| “Importance” | Importance of the rule:  
- 3 red stars: High  
- 2 orange stars: Medium  
- 1 gray star: Low |

See also  
- § Chapter 6.6.3.4.2 “Rules” on page 4233  
- § Chapter 6.6.3.4.1 “Pragmas and Attributes” on page 4228  
- § “Checking for compliance to rules” on page 4210

**Dialog 'Static Analysis Settings' - 'Naming Conventions'**

**Function:** In the dialog, you define the prefixes for the data types and scopes of variables, as well as prefixes for POUs and user-defined data types (DUTs). Static analysis checks compliance with the naming conventions. When a convention is not observed, the static analysis reports an error message in the “Messages” view.

**Call:**  
- Menu bar: “Project ➔ Project Settings”, “Static Analysis” category, “Open configuration dialog” link  
- Menu bar: “Build ➔ Static analysis ➔ Settings”

**Requirement:**  
- The CODESYS Static Analysis package is installed.  
- A project is open.

The error messages are displayed in the following format: § NC <prefix convention number> : <message text>. NC stands for “Naming Convention”. For example, the error message “§ NC0102: Invalid name...” means a violation of naming convention 102 for POUs of type PROGRAM.

You can use the pragma ‘naming’ to deactivate naming conventions for individual identifiers. The identifiers can begin with anything, not necessarily with the prefix.

| “Filter” | Input field for strings to be searched for |
### Table with the naming conventions

<table>
<thead>
<tr>
<th>“Names”</th>
<th>Nodes and elements for which a prefix can be defined. The number in parentheses after each element (for example, “PROGRAM (102)”) is the prefix convention number that is reported in the case of noncompliance with a naming convention.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Prefix”</td>
<td>Input field of the prefix</td>
</tr>
<tr>
<td><strong>●</strong> Multiple prefixes can be specified by means of comma separation. Example: “Prefix for POUs”, PROGRAM (102): prog, PRG_ “Prefix for POUs”, FUNCTION (103): fun, FUN_</td>
<td></td>
</tr>
<tr>
<td><strong>●</strong> Regular expressions (RegEx) are also possible for prefixes. To do this, an @ has to be prepended. Example: The name has to begin with x and may contain one character from the scope a-dA-D: @x[a-dA-D].</td>
<td></td>
</tr>
<tr>
<td><strong>●</strong> For variables of type “Alias” and POUs of type “Property”, the prefix can be defined with the placeholder {datatype}.</td>
<td></td>
</tr>
<tr>
<td><strong>“Prefixes for variables”</strong></td>
<td>Organizational node for all variables for which a prefix can be defined dependent on data type or scope.</td>
</tr>
<tr>
<td><strong>“Prefixes for POUs”</strong></td>
<td>Organizational node for all POU types and method scopes for which a prefix can be defined</td>
</tr>
<tr>
<td><strong>“Prefixes for DUTs”</strong></td>
<td>Organizational node for the DUT data types (structure, enumeration, alias, or union) for which a prefix can be defined</td>
</tr>
<tr>
<td><strong>“Prefixes for custom types”</strong></td>
<td>Organizational node for special custom types (particularly those from libraries) You can extend the list with conventions: Click the blank space below it. In the “Input Assistant” dialog, specify the name of a custom type or select a custom type. To delete a convention, select it and press the [Del] key. Note: These conventions have priority over the prefixes which are defined with the attribute {attribute 'nameprefix' := '&lt;prefix&gt;'}.</td>
</tr>
</tbody>
</table>

### Options

| “First character after prefix should be an upper case letter” | ☑: Static analysis reports an error for a variable when the first character of the variable name after the defined prefix is not an uppercase letter. |
**“Combine scope prefix with data type prefix”**

- As its namespace, a variable must have the defined prefix followed by the defined prefix for its data type.

  Example: The following prefixes are defined: \texttt{g\_} for “\texttt{VAR\_GLOBAL}”, and \texttt{r} for the data type “\texttt{REAL}”. The code analysis reports errors for global REAL variables that do not have the prefix \texttt{g\_r}.

- If conventions for the namespace are specified for a variable, then these conventions are taken into account. As a result, any data type conventions are ignored.

  Example: The following prefixes are defined: \texttt{g\_} for “\texttt{VAR\_GLOBAL}”, and \texttt{r} for the data type “\texttt{REAL}”. The code analysis reports exclusively errors for global REAL variables that do not have the prefix \texttt{g\_}.

**“Recursive prefixes for combinable data types”**

- Variables of combined data types have to have compound prefixes that follow the defined naming conventions.

  Example:

  ```plaintext
  ppiVariable : POINTER TO POINTER TO INT;
  ```

  The prefix \texttt{p} was defined for variables of data type \texttt{POINTER}, and the prefix \texttt{I} was defined for the data type \texttt{INT}. Static analysis reports errors for all variables of type \texttt{POINTER TO POINTER TO INT} which do not have the prefix \texttt{ppi}.

  ```plaintext
  refaiVar : REFERENCE TO ARRAY[1..3] OF INT;
  ```

  The prefix \texttt{ref} was defined for the data type \texttt{REFERENCE TO}, the prefix \texttt{a} for an array, and the prefix \texttt{I} for the data type \texttt{INT}. Static analysis reports errors for all variables of type \texttt{REFERENCE TO ARRAY[1..3] OF INT} which do not have the prefix \texttt{refai}. 

The following naming convention corresponds for the most part to the recommendations described in the "Identifiers" chapter.
<table>
<thead>
<tr>
<th>Prefixes for variables</th>
<th>Prefix</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOL (3)</td>
<td>x</td>
</tr>
<tr>
<td>BIT (4)</td>
<td>bit</td>
</tr>
<tr>
<td>BYTE (5)</td>
<td>by</td>
</tr>
<tr>
<td>WORD (6)</td>
<td>w</td>
</tr>
<tr>
<td>DWORD (7)</td>
<td>dw</td>
</tr>
<tr>
<td>LWORD (8)</td>
<td>lw</td>
</tr>
<tr>
<td>SINT (13)</td>
<td>si</td>
</tr>
<tr>
<td>INT (14)</td>
<td>i, n</td>
</tr>
<tr>
<td>DINT (15)</td>
<td>di</td>
</tr>
<tr>
<td>LINT (16)</td>
<td>li</td>
</tr>
<tr>
<td>USINT (9)</td>
<td>usi</td>
</tr>
<tr>
<td>UINT (10)</td>
<td>ui</td>
</tr>
<tr>
<td>UDINT (11)</td>
<td>udi</td>
</tr>
<tr>
<td>ULINT (12)</td>
<td>uli</td>
</tr>
<tr>
<td>REAL (17)</td>
<td>r</td>
</tr>
<tr>
<td>LREAL (18)</td>
<td>lr</td>
</tr>
<tr>
<td>STRING (19)</td>
<td>s</td>
</tr>
<tr>
<td>WSTRING (20)</td>
<td>ws</td>
</tr>
<tr>
<td>TIME (21)</td>
<td>tim</td>
</tr>
<tr>
<td>LTIME (22)</td>
<td>ltim</td>
</tr>
<tr>
<td>DATE (23)</td>
<td>dat</td>
</tr>
<tr>
<td>DATE_AND_TIME (24)</td>
<td>dt</td>
</tr>
<tr>
<td>TIME_OF_DAY (25)</td>
<td>tod</td>
</tr>
<tr>
<td>POINTER (26)</td>
<td>p</td>
</tr>
<tr>
<td>REFERENCE (27)</td>
<td>ref</td>
</tr>
<tr>
<td>SUBRANGE (28)</td>
<td>range</td>
</tr>
<tr>
<td>ARRAY (30)</td>
<td>a</td>
</tr>
<tr>
<td>Function block instance (31)</td>
<td>fb</td>
</tr>
<tr>
<td>Interface (36)</td>
<td>iff</td>
</tr>
<tr>
<td>Structure (32)</td>
<td>struct</td>
</tr>
<tr>
<td>ENUM (29)</td>
<td>e</td>
</tr>
<tr>
<td>Alias (33)</td>
<td>{datatype}</td>
</tr>
<tr>
<td>Variables with data type UNION (34)</td>
<td></td>
</tr>
<tr>
<td>XWORD (35)</td>
<td>xw</td>
</tr>
<tr>
<td>UXINT (37)</td>
<td>xui</td>
</tr>
<tr>
<td>XINT (38)</td>
<td>xi</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Prefixes for scopes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Prefixes for POUs</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Prefixes for DUTs</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>
### Names

<table>
<thead>
<tr>
<th>Prefixes for variables</th>
<th>Prefixes for types</th>
</tr>
</thead>
<tbody>
<tr>
<td>VAR_GLOBAL (51)</td>
<td>VAR_GLOBAL CONSTANT (70)</td>
</tr>
<tr>
<td>VAR_GLOBAL RETAIN (71)</td>
<td>VAR_GLOBAL PERSISTENT (72)</td>
</tr>
<tr>
<td>VAR_GLOBAL RETAIN PERSISTENT (73)</td>
<td></td>
</tr>
<tr>
<td>VAR_INPUT (56)</td>
<td>VAR_OUTPUT (57)</td>
</tr>
<tr>
<td>VAR_IN_OUT (58)</td>
<td>VAR_STAT (59)</td>
</tr>
<tr>
<td>VAR_TEMP (61)</td>
<td>VAR_CONSTANT (62)</td>
</tr>
<tr>
<td>VAR_PERSISTENT (63)</td>
<td>VAR_RETAIN (64)</td>
</tr>
<tr>
<td>IO variables (65)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Prefixes for POUs</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Prefixes for DUTs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prefixes for variables</td>
</tr>
<tr>
<td>------------------------</td>
</tr>
<tr>
<td><strong>Prefixes for POU type</strong></td>
</tr>
<tr>
<td>PROGRAM (102)</td>
</tr>
<tr>
<td>FUNCTIONBLOCK (103)</td>
</tr>
<tr>
<td>FUNCTION (104)</td>
</tr>
<tr>
<td>METHOD (105)</td>
</tr>
<tr>
<td>ACTION (106)</td>
</tr>
<tr>
<td>PROPERTY (107)</td>
</tr>
<tr>
<td>INTERFACE (108)</td>
</tr>
<tr>
<td><strong>Method scope</strong></td>
</tr>
<tr>
<td>PRIVATE (121)</td>
</tr>
<tr>
<td>PROTECTED (122)</td>
</tr>
<tr>
<td>INTERNAL (123)</td>
</tr>
<tr>
<td>PUBLIC (124)</td>
</tr>
<tr>
<td><strong>Prefixes for DUTs</strong></td>
</tr>
<tr>
<td>Structure (151)</td>
</tr>
<tr>
<td>Enumeration (152)</td>
</tr>
<tr>
<td>Variables with data type UNION (153)</td>
</tr>
<tr>
<td>Alias (154)</td>
</tr>
</tbody>
</table>
Example

The naming convention (1) refers to the standard POU **TON**. As a result, declarations of the special library POU are checked for the prefix "ton_". Click the blank space (2) to insert more naming conventions.

See also

- “Checking for compliance to defined naming conventions” on page 4211
- Chapter 6.6.3.4.1.4 “Attribute ‘naming’” on page 4229
- Chapter 6.6.3.4.1.5 “Attribute ‘nameprefix’” on page 4230
- **Identifiers**
- **Data Type Alias**
- **PROPERTY**

Dialog 'Static Analysis Settings' - 'Metrics’

**Function:** In the dialog, you select the metrics to be displayed for each POU in the “Standard Metrics” view by means of the “Build ➔ Static Analysis ➔ View Standard Metrics” command.

**Call:**

- “Open configuration dialog” button in the menu “Project ➔ Project Settings”, “Static Analysis” category
- Menu bar: “Build ➔ Static analysis ➔ Settings”

**Requirement:**

- The CODESYS Static Analysis package is installed.
- A project is open.
The “Code size”, “Variable size”, “Stack size”, and “Calls” metrics are reported only for POUs from libraries which are integrated in the project.

Violations of the upper and lower limits of the activated metrics can be reported as build errors by means of static analysis rule SA0150.

<table>
<thead>
<tr>
<th>“Metrics”</th>
<th>All selectable metrics are displayed in the column.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Active”</td>
<td>: The metric is displayed for each POU in the “Standard Metrics” view following the “Build ➔ Static Analysis ➔ View Standard Metrics” command.</td>
</tr>
<tr>
<td></td>
<td>: The metric is not displayed in the “Standard Metrics” view following the “Build ➔ Static Analysis ➔ View Standard Metrics” command.</td>
</tr>
<tr>
<td>“Lower limit”</td>
<td>Lower value from which the “Metric” is displayed</td>
</tr>
<tr>
<td>“Upper Limit”</td>
<td>Upper value to which the “Metric” is displayed</td>
</tr>
</tbody>
</table>

See also
- “Displaying of metrics” on page 4212
- Chapter 6.6.3.4.2.52 “SA0150: Violations of lower or upper limits or the metrics” on page 4299

Dialog 'Static Analysis Settings' - 'Forbidden Symbols'

**Function:** In the dialog, you define the keywords and symbols that must not be used in the project code.

**Call:**
- “Open configuration dialog” button in the menu “Project ➔ Project Settings”, “Static Analysis” category
- Menu bar: “Build ➔ Static analysis ➔ Settings”

**Requirement:**
- The CODESYS Static Analysis package is installed.
- A project is open.

<table>
<thead>
<tr>
<th>Input line</th>
<th>Double-clicking the line opens the line editor for specifying a keyword or symbol.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>: The Input Assistant opens for selecting the keyword or symbol.</td>
</tr>
</tbody>
</table>

See also
- “Checking for forbidden symbols” on page 4211

6.6.3.4 Reference, Programming

6.6.3.4.1 Pragmas and Attributes................................................................. 4228
6.6.3.4.2 Rules........................................................................................ 4233
6.6.3.4.1 Pragmas and Attributes

General

CODESYS Static Analysis provides pragmas and attributes for activating or deactivating individual rules or naming conventions for static code analysis.

Requirement: The rules or conventions are activated or defined in the project settings.

Attributes are inserted in the declaration part of a POU to deactivate specific rules for an entire programming object.

Pragmas are used in the implementation part of a POU to deactivate specific rules for individual lines of code. One exception is Rule 164, which can also be switched off in the declaration part.

Rules that are deactivated in the project settings cannot be activated by means of pragmas or attributes.

Rule SA0004 cannot be deactivated by means of a pragma or an attribute.

See also

- Chapter 6.6.3.4 “Reference, Programming” on page 4227

Pragma 'analysis'

This pragma is used to deactivate the code rules for individual code lines of a POU. You deactivate code rules by specifying the rule numbers with a prepended minus sign ("-"). A prepended plus sign ("+") activates the rule. You can specify any number of rules in the pragma.

Insert location: Deactivation: In the implementation part, with {analysis - ...} before the first code line where the code analysis is deactivated. Activation: With {analysis + ...} after the last line of the deactivation. For Rule 164, the pragma can also be inserted in the declaration part before a comment.

Syntax:

Deactivation of rules:

{analysis -<rule number> (, -<additional rule number> )* }

* : optional none, one or more additional rule numbers

Activation of rules:

{analysis +<rule number> (, +<additional rule number> )* }

* : none, one or more additional rule numbers

Example

Rule 24 is deactivated for two lines and then reactivated. As a result, rule 24 is not checked in these lines so that nTest:=DINT#99 is allowed for example.

{analysis -24}
nTest := 99;
iVar := INT#2;
{analysis +24}

Deactivating multiple rules:

{analysis -10, -24, -18}

See also

- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209
Attribute 'analysis'

The attribute deactivates specific rules for an entire programming object. You deactivate the code rules by specifying the rule numbers with a prepended minus sign ("-"). You can specify any number of rules in the attribute.

Insert location: In the declaration part of a POU, in the first line.

Syntax:

{attribute 'analysis' := '-<rule number> (, -<additional rule number>)* '}

* : none, one or more additional rule numbers

Example

Rules 33 and 31 are deactivated for the entire structure:

```plaintext
{attribute 'analysis' := '-33, -31'}

TYPE My_Structure :
   STRUCT
      iLocal : INT;
      uiLocal : UINT;
      udiLocal : UDINT;
   END_STRUCT
END_TYPE
```

Rule 100 is deactivated for the array:

```plaintext
{attribute 'analysis' := '-100'}

PROGRAM PLC_PRG
VAR
   aBigData: ARRAY[1..10000] OF DWORD;
   aBigDATA_2: ARRAY[1..10000] OF DWORD;
END_VAR
```

See also

●  Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

Attribute 'naming'

The attribute marks the code lines that are excluded from the analysis of naming convention. An off is assigned to the pragma attribute before the first code line where the code analysis is deactivated. An on is assigned after the last line. When an omit is assigned, only the next code line is ignored.

Insert location: Deactivation: In the declaration part of POUs and DUTs, above the affected lines. Activation: Below the affected lines.

Syntax:

{attribute 'naming' := '<switch state>'}

<switch state> : on | off | omit
on : naming is switched on
off : naming is switched off
omit : only next code line is switched off
Defined naming conventions: 1) INT variable names must be prepended with "int" as the identifier prefix, for example "intValue1". 2) Program names must begin with "prog".

For the code presented below, the static analysis issues messages only for the following variables: cccVar, aVariable, and bVariable.

```plaintext
VAR
{attribute 'naming' := 'off'}
  iVarA : INT;
  iVarB : INT;
{attribute 'naming' := 'on'}
  iVarC : INT;
END_VAR

VAR
...
{attribute 'naming' := 'omit'}
  iVarC : INT;
...
END_VAR

{attribute 'naming' := 'omit'}
PROGRAM PLC_PRG
VAR
...
END_VAR

{attribute 'naming' := 'omit'}
PROGRAM DoSomethingA
VAR
{attribute 'naming' := 'on'}
  iVarA : INT;
  iVarB : INT;
...
VAR_END
```

See also

- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

Attribute 'nameprefix'

The attribute defines a prefix for variables of a structured data type. The prefix must be prepended to the identifier of variables that are declared by this type.

Insert location: In the line before the declaration of a structured data type

Syntax:

```
{attribute 'nameprefix' := '<prefix>'}
```
Example

In the following example, Static Analysis issues a message for pB because the variable name does not begin with "point".

```plaintext
{attribute 'nameprefix' := 'point'}
TYPE DATAPoint :
  STRUCT
    iX: INT;
    iY: INT;
  END_STRUCT
END_TYPE

PROGRAM PLC_PRG
VAR
  pointA : DATAPoint;
  pB : DATAPoint;
END_VAR
pointA.iX := 1;
pointA.iY := 10;
pB.iX := 2;
pB.iY := 20;

Error message after static analysis: "Invalid variable name 'pB'. Expect prefix 'point'"
```

See also

- Chapter 6.6.3.2 "Configuring and Running Static Analysis" on page 4209

Attribute 'analysis:report-multiple-instance-calls'

The attribute marks a function block for checking for rule 105: Only function blocks with this attribute are checked whether the function block instances are called more than one time. If rule 105 is deactivated in the project settings, then the attribute does not have any effect.

Insert location: Top line in the declaration part of a function block.

Syntax:

```plaintext
{attribute 'analysis:report-multiple-instance-calls'}
```
Example

```plaintext
// (attribute 'analysis:report-multiple-instance-calls') Deactivated
FUNCTION_BLOCK FB_DoA
  VAR_INPUT
  END_VAR
  VAR_OUTPUT
  END_VAR
  VAR
    iA : INT;
  END_VAR
  iA := iA + 1;

  (attribute 'analysis:report-multiple-instance-calls')
  FUNCTION_BLOCK FB_DoB
    VAR_INPUT
    END_VAR
    VAR_OUTPUT
    END_VAR
    VAR
      iB : INT;
    END_VAR
    iB := iB +1;

  PROGRAM PLC_PRG
  VAR
    fbA : FB_DoA;
    fbB : FB_DoB;
  ND_VAR

    fbA();
    fbB();  // SA0105
    fbA();
    fbB();  // SA0105

  --> SA0105: Instance 'fbB' called more than once
```

See also
- Chapter 6.6.3.4.2.46 “SA0105: Multiple instance calls” on page 4285
- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209
6.6.3.4.2 Rules

6.6.3.4.2.1 SA0001: Unreachable code.............................................................. 4234
6.6.3.4.2.2 SA0002: Empty objects.................................................................... 4234
6.6.3.4.2.3 SA0003: Empty statements............................................................. 4235
6.6.3.4.2.4 SA0004: Multiple write access on output....................................... 4235
6.6.3.4.2.5 SA0006: Write access from several tasks....................................... 4236
6.6.3.4.2.6 SA0007: Address operator on constants......................................... 4237
6.6.3.4.2.7 SA0008: Check subrange types..................................................... 4237
6.6.3.4.2.8 SA0009: Unused return values....................................................... 4238
6.6.3.4.2.9 SA0010: Arrays with only one component..................................... 4239
6.6.3.4.2.10 SA0011: Useless declarations...................................................... 4239
6.6.3.4.2.11 SA0012: Variable which could be declared as constants............... 4240
6.6.3.4.2.12 SA0013: Declarations with the same variable name....................... 4240
6.6.3.4.2.13 SA0014: Assignment of instances............................................... 4241
6.6.3.4.2.14 SA0015: Access to global data via FB_Init.................................. 4242
6.6.3.4.2.15 SA0016: Gaps in structures......................................................... 4242
6.6.3.4.2.16 SA0017: Non-regular assignments............................................... 4243
6.6.3.4.2.17 SA0018: Unusual bit access....................................................... 4243
6.6.3.4.2.18 SA0020: Possibly assignment of truncated value to REAL variable................................. 4244
6.6.3.4.2.19 SA0021: Transporting the address of a temporary variable............. 4245
6.6.3.4.2.20 SA0022: (Possibly) unassigned return value................................... 4245
6.6.3.4.2.21 SA0023: Complex return values.................................................. 4246
6.6.3.4.2.22 SA0024: Untyped literals / constants.......................................... 4246
6.6.3.4.2.23 SA0025: Unqualified enumeration constants.................................. 4247
6.6.3.4.2.24 SA0026: Possible truncated strings............................................. 4247
6.6.3.4.2.25 SA0027: Multiple uses of identifiers........................................... 4248
6.6.3.4.2.26 SA0028: Overlapping memory areas............................................ 4248
6.6.3.4.2.27 SA0029: Notation in code different to declaration........................ 4249
6.6.3.4.2.28 Unused Objects............................................................................ 4249
6.6.3.4.2.29 SA0034: Enumerations with incorrect assignment.......................... 4252
6.6.3.4.2.30 SA0037: Write access to input variable....................................... 4252
6.6.3.4.2.31 SA0038: Read access to output variable....................................... 4253
6.6.3.4.2.32 SA0040: Possible division by zero................................................. 4254
6.6.3.4.2.33 SA0041: Detect possible loop invariant code.................................. 4255
6.6.3.4.2.34 SA0042: Usage of different access paths..................................... 4256
6.6.3.4.2.35 SA0043: Use of a global variable in only one POU.......................... 4256
6.6.3.4.2.36 SA0044: Declarations with reference to interface............................ 4257
6.6.3.4.2.37 Conversions................................................................................ 4258
6.6.3.4.2.38 Use of Direct Addresses............................................................... 4263
6.6.3.4.2.39 Rules for Operators..................................................................... 4265
6.6.3.4.2.40 Rules for Statements.................................................................... 4275
6.6.3.4.2.41 SA0095: Assignments in conditions.............................................. 4281
6.6.3.4.2.42 SA0100: Variables greater than <n> bytes................................... 4282
6.6.3.4.2.43 SA0101: Names with invalid length............................................ 4283
6.6.3.4.2.44 SA0102: Access to program/fb variables from the outside............. 4283
6.6.3.4.2.45 SA0103: Concurrent access on not atomic data............................ 4284
6.6.3.4.2.46 SA0105: Multiple instance calls................................................... 4285
6.6.3.4.2.47 SA0106: Virtual method calls in FB_INIT..................................... 4286
6.6.3.4.2.48 SA0107: Missing formal parameters............................................. 4287
6.6.3.4.2.49 Checking Strict IEC Rules............................................................. 4288
SA0001: Unreachable code

Dectects lines of code that are not executed, for example due to a RETURN or CONTINUE statement

Justification: Unreachable code should always be avoided. The test often indicates that test code still exists which should be removed.

Importance: High

PLCopen rule: CP2

Example

PROGRAM PLC_PRG
VAR
  xReturn_Before_End: BOOL;
  xContinue_In_Loop_FUN: BOOL;
  iCounter: INT;
END_VAR

xContinue_In_Loop_FUN := FALSE;
FOR iCounter := INT#0 TO INT#5 BY INT#1 DO
  CONTINUE;
  xContinue_In_Loop_FUN := FALSE;
END_FOR

--> SA0001: Unreachable code detected in 'PLC_PRG'

See also

● Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0002: Empty objects

Detects POUs, GVLs, data type declarations, or interfaces that do not contain any code

Justification: Empty objects should be avoided. They are often a sign that an object has not been implemented completely. Exception: In some cases, no code is specified in the body of a function block when it should be used by interfaces only. In other cases, a method is created only because it is required by an interface without a sensible implementation being possible for the method. No matter the case, this kind of situation should be commented.

Importance: Medium

See also

● Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209
SA0003: Empty statements

Detected lines of code that have a semicolon (;) but not a statement

Justification: An empty statement can be a sign for missing code.

Note: There are good reasons for using empty statements. For example, in a CASE statement it can make sense to explicitly program out all cases, even those where there is nothing to do. When this kind of empty CASE statement contains a comment, Static Analysis does not generate an error message.

Importance: Low

Examples

```plaintext
CASE value OF
1:DoSomething();
2;;
3:DoSomethingElse();
END_CASE

--> SA0003: Empty statements

CASE value OF
1:DoSomething();
2::<nothing to do>
3:DoSomethingElse();
END_CASE

--> No SA error
```

See also

- § Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0004: Multiple write access on output

Detected outputs that are written to more than one location

Justification: The maintainability is degraded when an output is written in different locations in the code. Then it is uncertain which write access is the one that actually has an effect in the process. Good practice is to calculate the output variables in auxiliary variables and assign the calculated value at one location at the end of the cycle.

Importance: High

PLCopen rule: CP12

An error is not issued when an output variable (VAR_IN_OUT) is written in different branches of IF and CASE statements.

A pragma cannot deactivate this rule.
Example

```plaintext
VAR_GLOBAL
  g_xVar AT %QX0.0 : BOOL ;
  g_iTest AT %QW0 : INT ;
END_VAR

PROGRAM PLC_PRG
IF g_iCondition < INT#0 THEN
  g_xVar := TRUE;
  g_iTest := INT#12;
END_IF

CASE g_iCondition OF
  INT#1:
    g_xVar := FALSE;
  INT#2:
    g_iTest := INT#11;
ELSE
  g_xVar := TRUE;
  g_iTest := INT#9;
END_CASE

--> SA0004: Multiple write access on output '%QX0.0'
--> SA0004: Multiple write access on output '%QW0'
```

See also
- § Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0006: Write access from several tasks

Detects variables that are written by more than one task

Justification: A variable that is written in multiple tasks may change its value unexpectedly. This can lead to confusing situations. String variables (and on some 32-bit systems also 64-bit integer variables) can even reach an inconsistent state if the variable is written to two tasks simultaneously.

Exception: In specific cases, it may be necessary for several tasks to write a variable. For example, use semaphores to make sure that access does not lead to an inconsistent state.

Importance: High

PLCopen rule: CP10

Example

```plaintext
VAR_GLOBAL
  g_iTemp1: INT;
END_VAR

PROGRAM PLC_PRG    // Controlled by MainTask
  g_iTemp1 := g_iTemp1 + INT#2;
END_PROGRAM

PROGRAM PLC_PRG_1  //Controlled by SubTask
  g_iTemp1 := g_iTemp1 - INT#3;
END_PROGRAM

--> SA0006: Concurrent write access to 'g_iTemp1' in Tasks MainTask, SubTask
```

See also
- § Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209
SA0007: Address operator on constants

Detects lines of code where the operator ADR is applied for a constant

Justification: Using a pointer to a constant variables overrides the CONSTANT property of the variable. The variable can be changed by means of the pointer without any notification from the compiler.

Exception: In rare cases, it might be useful to pass a pointer to a constant to a function. However, you have to make sure that this function does not change the transferred value. Whenever possible, use VAR_IN_OUT CONSTANT.

Importance: High

When the “replace constants” option is selected in the “Compiler options” of the project settings, the address operator is not permitted for scalar constants (integer, BOOL, REAL) and a compile error is issued. (Constant strings, structures, and arrays always have an address.)

Example

PROGRAM PLC_PRG
VAR CONSTANT
  c_iValue : INT := INT#15;
END_VAR
VAR
  poiValue : POINTER TO INT;
END_VAR
  poiValue := ADR(c_iValue); // SA0007
--> SA0007: Address to constant variable 'c_iValue'

See also
● Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0008: Check subrange types

Detects out-of-range violations of subrange types. Assigned literals are already checked by the compiler. When constants are assigned, then the values must be within the defined range. When variables are assigned, then the data types must be identical.

Justification: If subrange types are used, then make sure that this subrange is not exited. The compiler checks for these kinds of subrange violations only for assignments of constants.

Importance: Low

The check is not performed for CFC objects because the code structure does not allow for it.
Example

VAR_GLOBAL
  iVarGlob: INT;
END_VAR

PROGRAM PLC_PRG
VAR
  iSubr1: INT (INT#1..INT#10);
  iSubr2: INT (INT#1..INT#1000);
  iCount: INT;
  by_SubType: BYTE (BYTE#0..BYTE#11);
  iVar: INT (-4095..4095);
END_VAR

iSubr1 := nCount;              // SA0008
iSubr1 := subr2;               // SA0008
iSubr1 := gvl.iVarGlob;        // SA0008

// byBYTE_SubType := BYTE#123;  // already detected by compiler,
// error "Cannot convert type..."

--> SA0008: Subrange variable 'iSubr1' maybe out of allowed range

See also

●  Chapter 6.6.3.2 "Configuring and Running Static Analysis" on page 4209

SA0009: Unused return values

Detects function, method and property calls in which the return value is not used

Justification: When a function or method returns a return value, it should also be evaluated. The return value often indicates whether or not the function was executed successfully. If not, then you will not be able to identify later whether the return value was forgotten or if it is actually not needed.

Exception: If a return value is irrelevant to the call, then you can document this and omit the assignment. Error returns should never be ignored.

Importance: Medium

PLCopen rule: CP7 / CP17

Example

FUNCTION Return_BOOL : BOOL
VAR_INPUT
END_VAR
VAR
  xTest : BOOL;
END_VAR
xTest := FALSE;
Return_BOOL := xTest;

PROGRAM PLC_PRG
Return_BOOL ();  // SA0009

--> SA0009: Ignoring return value of 'Return_Bool'

See also

●  Chapter 6.6.3.2 "Configuring and Running Static Analysis" on page 4209
SA0010: Arrays with only one component

Detects arrays with only one element

Justification: An array with one element can be replaced by a base-type variable. Access to this variable is considerably faster than access by index to the variable.

Exception: The length of an array is often determined by a constant and is a parameter for a program. Then the program can work with arrays of different lengths and does not have to be changed if the length is only 1. This kind of situation should be documented accordingly.

Importance: Low

Example

```
PROGRAM PLC_PRG
VAR
  aoiEmpty : ARRAY [22..22] OF INT;
  aorEmpty : ARRAY [1..1] OF REAL;
END_VAR

aoiEmpty;
aorEmpty;

--> SA0010: Vacuous array element in variable 'aoiEmpty'
--> SA0010: Vacuous array element in variable 'aorEmpty'
```

See also

● § Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0011: Useless declarations

Detects structures or enumerations with only one component

Justification: This kind of declaration can be confusing for the reader. A structure with only one element can be replaced by an alias type. An enumeration with only one element can be replaced by an constant.

PLCopen rule: CP22 / CP24

Importance: Low

Example

```
TYPE SingleStruct :
  STRUCT
    iPart : INT;
  END_STRUCT
END_TYPE

TYPE myUnion :
  UNION
    lrValue : LREAL;
  END_UNION
END_TYPE

TYPE SingleEnum :
  (OnlyOne := 1);
END_TYPE

--> Useless declaration 'SingleStruct'
--> Useless declaration 'myUnion'
--> Useless declaration 'SingleEnum'
```
See also

- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0012: Variable which could be declared as constants

Detects variables that are not accessed with write permission and therefore could be declared as constants.

Justification: If a variable is written only at the declaration point and is otherwise used only for reading, then the static analysis assumes that the variable should also not be changed. Firstly, a declaration as a constant results in checking that the variable is not changed when the program is changed. Secondly, the declaration as a constant may result in faster code.

NOTICE!
If multiple applications exist in one project, then only the objects below the currently active application are affected. If there is only one application, then the objects in the common POU pool are also affected.

Importance: Low

Example

PROGRAM PLC_PRG
VAR
  iVar : INT := INT#17;
  iTest : INT;
END_VAR
iTest := iTest + iVar;   // SA0012: iVar could be declared as constant

--> SA0012: Variable 'iVar' could be declared as constant

See also

- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0013: Declarations with the same variable name

Detects variables with names that are already used by other variables (for example, global and local variables with the same name). Also detects variables with names of functions, actions, methods, or properties which are used in the same access scope. Variables are also detected that are declared in a GVL in the “Devices” view or in the POU pool. For this, however, the GVL of the “POUs” view have to be used in the application program.

Justification: The same names can be confusing when reading the code, and they can cause errors if the wrong object is accessed unintentionally. We recommend that you use naming conventions to avoid these situations.

PLCopen rule: N5 / N9

Importance: Medium
Example

VAR_GLOBAL
  xVar1 : BOOL;
  iVar3 : INT;
END_VAR

PROGRAM PLC_PRG
VAR
  xVar1 : BOOL;  // SA0013
  iVar3 : INT;   // SA0013
END_VAR

xVar1 := NOT GVL.xVar1;
iVar3 := iVar3 + INT#2;
iVar3 := GVL.iVar3;

--> SA0013: Declaration of 'iVar1' hides symbol 'GVL.iVar1'
--> SA0013: Declaration of 'xVar3' hides symbol 'GVL.xVar3'

Example

The function block POU has the action ACT and the method METH.

FUNCTION_BLOCK POU
VAR
  ACT : UINT;  // SA0013
  METH : BYTE; // SA0013
END_VAR

--> SA0013: Declaration of 'ACT' hides symbol 'POT.ACT'
--> SA0013: Declaration of 'METH' hides symbol 'POT.METH'

See also

- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0014: Assignment of instances

Detects assignments to function block instances. In the case of instances with pointer or reference variables, these assignments are potentially risky.

Justification: This is a performance warning. When an instance is assigned to another instance, all elements and subelements are copied from the one instance to the other instance. Pointers to data are also copied, but not their referenced data, so that the target instance and the source instance contain the same data after the assignment. Depending on the size of the instances, this kind of assignment could last a long time. For example, if an instance should be passed to a function for processing, then it is much more efficient to pass a pointer to the instance. If you want to selectively copy values from one instance to another, then a copy method is useful: inst_First.Copy_From(inst_Second).

Importance: Medium
Example

```plaintext
PROGRAM PLC_PRG
VAR
    inst_First : My_FB;
    inst_Second : My_FB;
END_VAR
inst_First();
inst_Second := inst_First;  // SA0014
--> SA0014: Assignment of instances
```

See also

- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0015: Access to global data via FB_Init

Detects the access of a function block to global variables by means of the method `FB_Init`. The value of this variable depends on the order of initializations.

Justification: Depending on the declaration location of the POU instance, an uninitialized variable could be accessed if the rule is violated.

Importance: High

Example

```plaintext
VAR_GLOBAL
    g_xTest1 : BOOL;
    g_iTest3 : INT;
END_VAR

METHOD PUBLIC fb_init : BOOL
VAR_INPUT
    bInitRetains : BOOL; // If TRUE, the retain variables are initialized (warm start / cold start)
    bInCopyCode : BOOL; // If TRUE, the instance afterwards gets moved into the copy code (online change)
END_VAR
g_xTest1 := NOT g_xTest1;       // SA0015
g_iTest3 := g_iTest3 + INT#1;   // SA0015
--> SA0015: FB_Init method of function block 'POU' accesses global data
```

See also

- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0016: Gaps in structures

Detects gaps in structures or function blocks that are caused by the alignment requirements of the currently set target system. If possible, you should remove the gaps by resorting the structure elements or filling them with a dummy element. If this is not possible, then you can deactivate the rule for the affected structures by means of the `analysis` pragma.

Justification: Due to different alignment requirements on different platforms, there may be a different layout in the memory for these kinds of structures. Then the code can perform differently, depending on the platform.

Importance: Low
Example

PROGRAM PLC_PRG
VAR
  myStruct : Unpadded_Structure;
END_VAR
myStruct.iTest := 0;

TYPE Unpadded_Structure :
  STRUCT
    xTest : BOOL;
    iTest : INT;    // SA0016
    byTest : BYTE;
    wTest : WORD;
  END_STRUCT
END_TYPE

--> SA0016: Structure 'Unpadded_Structure' must be padded (pack-mode=8)

See also
● § Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0017: Non-regular assignments

Detects assignments to pointers that are neither addresses (ADR operator, pointer variables) nor constants 0

Justification: If a pointer contains a value that is not a valid address, then an access violation exception occurs when dereferencing the pointer.

Importance: High

Example

PROGRAM PLC_PRG
VAR
  pInt : POINTER TO INT;
  dwAddress : DWORD;
END_VAR

  dwAddress := dwAddress + DWORD#1;
pInt := dwAddress; // SA0017

--> SA0017: Non-regular assignment

See also
● § Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0018: Unusual bit access

Detects bit access to signed variables. However, the IEC 61131-3 standard permits only bit access and bit shift operations on bitfields. See also the strict rules SA0147 and SA0148.

Justification: Signed data types should not be used as bitfields and the other way around. The IEC 61131-3 standard does not provide for this kind of access, and therefore you should comply with this rule when you write portable code.

Importance: Medium
Exception for flag enumerations: When an enumeration is declared as a flag by means of the \{attribute 'flags'\} pragma attribute, the SA0018 error is not issued for bit access with the OR, AND or NOT operators.

Example

PROGRAM PLC_PRG
VAR
  iTemp1 : INT;
  diTemp3 : DINT;
  uliTemp4 : ULINT;
  siTemp5 : SINT;
  usiTemp6 : USINT;
  byTemp2 : BYTE;
END_VAR
iTemp1.3 := TRUE;     // SA0018
diTemp3.4 := TRUE;    // SA0018
uliTemp4.18 := FALSE; // no error because this is an unsigned data type
siTemp5.2 := FALSE;   // SA0018
usiTemp6.3 := TRUE;   // no error because this is an unsigned data type
byTemp2.5 := FALSE;   // no error because the byte is a bitfield
--> SA0018: Unusual bit access

See also

- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209
- Chapter 6.6.3.4.2.49.12 “SA0147: Unusual shift operation - strict” on page 4293
- Chapter 6.6.3.4.2.49.13 “SA0148: Unusual bit access - strict” on page 4294

SA0020: Possibly assignment of truncated value to REAL variable

Detects operations on integer variables for which a truncated value could be assigned to a REAL data type variable

Justification: Static analysis issues an error when the result of an integer calculation is assigned to a REAL or LREAL variable. The programmer should be alerted to a possible incorrect interpretation of this kind of assignment: \texttt{lrealvar := dintvar1 * dintvar2}. Because the range of values of LREAL is greater than that of DINT, one could assume that the result of the calculation could always be represented in LREAL. But that is not the case. The processor calculates the result of the multiplication as an integer and then casts the result to LREAL. An overflow in the integer calculation would be lost. To work around the problem, the calculation has to be done as a REAL operation: \texttt{lreal_var := TO_LREAL(dintvar1) * TO_LREAL(dintvar2)}.

Importance: High

Example

PROGRAM PLC_PRG
VAR
  rx : LREAL;
  di : DINT;
END_VAR
rx := di * di            // SA0020
rx := TO_LREAL(di) * TO_LREAL(di) // No message

--> SA0020: Possibly assignment of truncated value to REAL variable
SA0021: Transporting the address of a temporary variable

Detects address assignments of temporary variables (on the stack) to non-temporary variables

Justification: Local variables of a function or method are created on the stack and they exist only while the function or method is being processed. If a pointer points to this kind of variable after processing the method or function, then you can use this pointer to access undefined memory, or to access an incorrect variable in another function. This situation should be avoided at all costs.

Importance: High

Example

FUNCTION TempVarInFUNC : DWORD
VAR
  uiTemp : UINT;
END_VAR
TempVarInFUNC := ADR(uiTemp); // SA0021

PROGRAM PLC_PRG
VAR
  dwTest : DWORD;
END_VAR
dwTest := TempVarInFUNC();

--> SA0021: Transporting address of temporary variable to outer scope symbol

See also

● Chapter 6.6.3.2 “Configuring and Running Static Analysis" on page 4209

SA0022: (Possibly) unassigned return value

Detects all functions and methods that include an execution thread without an assignment to the return value

Justification: An unassigned return value in a function or method is an indication of missing code. Even if the return value always has a default value, it is always useful to assign it again explicitly to avoid confusion.

Importance: Medium

Example

FUNCTION FUN : DINT
VAR_INPUT
  bTest : BOOL;
END_VAR

IF bTest THEN
  RETURN;
END_IF
FUN := 99;

--> SA0022: (Possibly) unassigned return value

See also

● Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209
SA0023: Complex return values

Determines complex return values that cannot be returned with a simple registry copy of the processor. This includes structures, arrays, and return values of type `STRING` (regardless of the size of the used memory).

Justification: This is a performance warning. If large values are returned as the result of a function, method, or property, then the processor copies them multiple times when executing the code. This can lead to runtime problems and should be avoided whenever possible. Performance can be improved by passing a structured value as `VAR_IN_OUT` to a function or method and filling it in the function or method.

Importance: Medium

Example

```plaintext
TYPE LargeStructure :
    STRUCT
        a : LINT;
        b : BOOL;
    END_STRUCT
END_TYPE

FUNCTION Large_Return_Value_FUNC : LargeStructure   // SA0023
    --> SA0023: Complex return values

    PROGRAM PLC_PRG
    VAR
        iTemp1 : INT = 10;     // SA0024
        diTemp2 : DINT;
        liTemp3 : LINT;
        rTemp4 : REAL;
        lrTemp5 : LREAL;
    END_VAR

    iTemp1 := iTemp1 + INT#34;  // SA0024
    diTemp2 := diTemp2 + 23;   // SA0024
    liTemp3 := liTemp3 + 124;  // SA0024
    rTemp4 := rTemp4 + 1.1;    // SA0024
    lrTemp5 := lrTemp5 + 3.4;  // SA0024

    --> SA0024: Untyped literal found
```

SA0024: Untyped literals / constants

Detects untyped literals and constants

Justification: CODESYS assigns types for literals depending on their use. In some cases, this can cause unexpected problems, which should be resolved better with a typed literal. For example: `dw := ROL(DWORD#1, i)`

Importance: Low

Example

```plaintext
PROGRAM PLC_PRG
VAR
    iTemp1 : INT = 10;     // SA0024
    diTemp2 : DINT;
    liTemp3 : LINT;
    rTemp4 : REAL;
    lrTemp5 : LREAL;
END_VAR

    iTemp1 := iTemp1 + INT#34;  // SA0024
    diTemp2 := diTemp2 + 23;   // SA0024
    liTemp3 := liTemp3 + 124;  // SA0024
    rTemp4 := rTemp4 + 1.1;    // SA0024
    lrTemp5 := lrTemp5 + 3.4;  // SA0024

    --> SA0024: Untyped literal found
```
See also

- § Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

**SA0025: Unqualified enumeration constants**

Detects enumeration constants for which a qualified name does not prepend the enumeration

Justification: Qualified access makes the code more readable and easier to maintain. Without forcing qualified variable names, an additional enumeration could be inserted when the program is extended. This enumeration contains a constant with the same name as an existing enumeration (see the example below: “red”). This would result in ambiguous access to this piece of code. We recommend to always use only enumerations with the {attribute ‘qualified-only’}.

Importance: Medium

### Example

```plaintext
TYPE COLOR
(red, green, blue);
END_TYPE

PROGRAM PLC_PRG
enumVar : COLOR;
enumVar := COLOR.red; // SA0025
enumVar := red; // SA0025

--> SA0025: Enumeration constant 'red' not qualified
```

See also

- § Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

**SA0026: Possible truncated strings**

Detects string assignments and string initializations that do not use sufficient string length

Justification: When strings of different lengths are assigned, a string could be truncated. This can have unexpected results.

Importance: Medium

### Example

```plaintext
PROGRAM PLC_PRG
VAR
  strVar1 : STRING[10];
  strVar2 : STRING[6];
END_VAR

strVar2 := strVar1; // SA0026

--> SA0026: Truncation of string 'abcdefghi'
--> SA0026: Possible truncation of string 'strVar1'
```

See also

- § Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209
SA0027: Multiple uses of identifiers

Detects multiple uses of a name/identifier for a variable or an object (POU) within the scope of a project

Justification: Same names can be confusing when reading the code. They can cause errors if the wrong object is accessed accidentally. Define and follow naming conventions to avoid any situation like this.

The following cases are detected:

- The name of an enumeration is identical to the name of another enumeration in the application or in an integrated library.
- The name of a variable is identical to the name of another object in the application or in an integrated library.
- The name of a variable is identical to the name of an enumeration constant in an enumeration in the application or in an integrated library.
- The name of an object is identical to the name of another object in the application or in an integrated library.

Importance: Medium

Example

The Standard library is integrated in the project and provides the TON function.

PROGRAM PLC_PRG
VAR
ton : INT;
END_VAR

--> Variable name 'ton' in 'PLC_PRG' already used for an object in library 'standard, ...'

See also

- § Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0028: Overlapping memory areas

Detects the lines of code where two or more variables reserve the same memory

Justification: When two variables reserve the same memory, the code may behave with unexpected results. This situation should be avoided at all costs. If you cannot avoid using a value in different interpretations (for example, one time as DINT and another time as REAL), you should define a UNION. You can also use a pointer to access a value with a different type without the value being converted.

Importance: High

Example

PROGRAM PLC_PRG
VAR
iVar1 AT %QB21: INT;
dwVar2 AT %QD5: DWORD;
END_VAR

--> The following variables access the same memory:
--> SA0028: iVar1 AT %QB21
--> SA0028: dwVar2 AT %QD5

See also

- § Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209
SA0029: Notation in code different to declaration

Detects the code locations where the notation of an identifier is different from the notation in its declaration

Justification: The IEC 61131-3 standard defines identifiers as not case-sensitive. This means that a variable declared as "varx" can also be used as "VaRx" in the code. However, this is confusing and misleading and should be avoided.

Importance: Medium

Example

A POU PLC_PRG and a POU fnc (function) exist in the device tree.

PROGRAM PLC_PRG
VAR
  iVar: INT;
_123test_var_: INT;
END_VAR
ivar := iVar + 1;                   // SA0029
_123TEST_var_ := _123test_var_;        // SA0029
Fnc();                              // SA0029

--> SA0029: Notation in code (ivar) must equal declaration (iVar)
--> SA0029: Notation in code (_123TEST_var_) must equal declaration (_123test_var_)
--> SA0029: Notation in code (Fnc) must equal declaration (fnc)

See also

● § Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

Unused Objects

6.6.3.4.2.28.1  SA0031: Unused signatures................................................................. 4249
6.6.3.4.2.28.2  SA0032: Unused enumeration constants........................................ 4250
6.6.3.4.2.28.3  SA0033: Unused variables.............................................................. 4250
6.6.3.4.2.28.4  SA0035: Unused input variables.................................................... 4251
6.6.3.4.2.28.5  SA0036: Unused output variables................................................... 4251

SA0031: Unused signatures

Detects programs, function blocks, functions, data types, interfaces, methods, properties, and actions that are not called within the compiled program code

Justification: Unused objects unnecessarily increase the size of the project and can be confusing when reading the code.

Importance: Low

PLCopen rule: CP2

If multiple applications exist in a project, then only the objects below the currently active applications are affected. If there is only one application, then the objects in the POU pool are also affected.

See also

● § Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209
SA0032: Unused enumeration constants

Detects enumeration constants that are not used in the compiled program code

Justification: Unused enumeration constants unnecessarily increase the size of the enumeration definition and can be confusing when reading the program.

PLCopen rule: CP24

Importance: Low

If multiple applications exist in a project, then only the objects below the currently active applications are affected. If there is only one application, then the objects in the common POU pool are also affected.

Example

```plaintext
TYPE My_Enum :
  (one := 1, two := 2);
END_TYPEE

--> SA0032: Unused enumeration constant 'one'
--> SA0032: Unused enumeration constant 'two'
```

See also

● § Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0033: Unused variables

Detects variables that are declared but not used within the compiled program code

Justification: Unused variables make a program less readable and maintainable. Unused variables unnecessarily fill memory and unnecessarily waste runtime during initialization.

Importance: Medium

PLCopen rule: CP22 / CP24

For GVL variables: If multiple applications exist in a project, then only the objects below the currently active applications are affected. If there is only one application, then the objects in the common POU pool are also affected.

Example

```plaintext
PROGRAM PLC_PRG
VAR
  iCounter1 : INT;
  iCounter2 : INT; // SA0035
END_VAR

iCounter1 := 100;

--> SA0035: Unused Variable 'iCounter2'
```

See also

● § Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209
SA0035: Unused input variables

Detects input variables that are not used by any function block instance

Justification: Unused variables make a program less readable and maintainable. Unused variables unnecessarily fill memory and unnecessarily waste runtime during initialization.

Importance: Medium

PLCopen rule: CP24

Example

```
FUNCTION_BLOCK AFB
VAR_INPUT
  iIn1: INT;
  iIn2: INT;
END_VAR
VAR_OUTPUT
  iOut1: INT;
END_VAR
PROGRAM PLC_PRG
VAR
  Fb1: AFB;
END_VAR
Fb1(iIn1 := 99)
--> SA0035: Unused input 'iIn2'
```

See also
- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0036: Unused output variables

Detects output variables that are not used by any function block instance

Justification: Unused variables make a program less readable and maintainable. Unused variables unnecessarily fill memory and unnecessarily waste runtime during initialization.

Importance: Medium

PLCopen rule: CP24

Example

```
FUNCTION_BLOCK AFB
VAR_INPUT
  iIn1: INT;
  iIn2: INT;
END_VAR
VAR_OUTPUT
  iOut1: INT;
END_VAR
PROGRAM PLC_PRG
VAR
  Fb1: AFB;
END_VAR
Fb1(iIn1 := 99)
--> SA0036: Unused output 'iOut1'
```
SA0034: Enumerations with incorrect assignment

Detects values that are assigned to an enumeration variable. Only defined enumeration constants of an enumeration variable are permitted to be assigned.

Justification: A variable of the enumeration type should have only the intended values, otherwise the code that uses this variable may not work correctly. We recommend to always use enumerations with the \{attribute 'strict'\}. Then the compiler already checks the correct use of the enumeration components.

Importance: High

Example

```plaintext
TYPE COLOR :
  {
    Red := 0,
    Green,
    Yellow
  };
END_TYPE

PROGRAM PLC_PRG
VAR
eColor1: COLOR;
END_VAR

eColor1 := COLOR.Red;
eColor1 := 1;         // SA0034
--> SA0034: Use enumeration value instead of 'INT#1'
```

See also

●  Chapter 6.6.3.2 "Configuring and Running Static Analysis" on page 4209

SA0037: Write access to input variable

Detects input variables (VAR_INPUT) that are accessed with write permission within the POU

Justification: According to the IEC 61131-3 standard, an input variable must not be changed within a POU. This kind of access is also a cause for errors and makes the code poorly maintainable. This is an indication that a variable is used as both an input variable and an auxiliary variable. This kind of dual use should be avoided.

Importance: Medium
Example

VAR_GLOBAL
    g_xGlob AT %QX0.0 : BOOL;
END_VAR

PROGRAM PLC_PRG
VAR_INPUT
    xVarIn1:BOOL;
    xVarIn2:BOOL;
END_VAR
VAR
    iCondition : INT;
END_VAR

iCondition := iCondition + INT#1;
CASE iCondition OF
    INT#1:
        g_xGlob := xVarIn1;
    INT#2:
        g_xGlob := xVarIn2;
    ELSE
        g_xGlob := FALSE;
        xVarIn1 := FALSE; // SA0037
END_CASE

--> SA0037: Write access to input variable 'xVarIn1'

See also

- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0038: Read access to output variable

Detects output variables (VAR_OUTPUT) that are accessed with read permission within the POU.

Justification: According to the IEC 61131-3 standard, it is prohibited to read an output within a POU. This is an indication that the output is not only used as an output but also as a temporary variable for intermediate results. This kind of dual use should be avoided.

Importance: Low
Example

```plaintext
VAR_GLOBAL
  g_xGlob AT %QX0.0 : BOOL ;
  g_iGlob AT %QW1 : INT ;
END_VAR

PROGRAM PLC_PRG
VAR_OUTPUT
  xVarOut1:BOOL;
  xVarOut2:INT;
  xVarOut3:INT;
END_VAR
VAR
  iCondition : INT;
END_VAR

iCondition := iCondition + INT#1;
CASE iCondition OF
  INT#1:
    xVarOut1 := g_xGlob;
    xVarOut2 := g_iGlob;
  INT#2:
    xVarOut3 := xVarOut2;  // SA0038
ELSE
  xVarOut1 := FALSE;
  g_xGlob := xVarOut1;  // SA0038
  xVarOut2 := INT#0;
  xVarOut3 := INT#-1;
END_CASE

--> SA0038: Read access to output variable 'xVarOUT2'
--> SA0038: Read access to output variable 'xVarOUT1'
```

See also

- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

**SA0040: Possible division by zero**

Dectes code locations where there is possible division by zero

Justification: Division by zero should never occur, and a variable denominator should always be checked for 0 first.

Importance: High
Example

```
VAR_GLOBAL
   g_iVar AT %W1 : INT ;
END_VAR

PROGRAM PLC_PRG
VAR
   iCounter : INT;
iSumme:INT;
iMid:INT;
iVal1:INT := INT#2;
iVal2:INT;
iVal3:INT := INT#3;
iVal4:INT := INT#4;
iVal5:INT;
END_VAR
IF iVal2 <> 0 THEN
   iVar1 := iVar1/iVal2; // no error
END_IF;
iMid := iVar1 / iCounter; // SA0040
iVar2 := iVar2 + iVar1;
iSumme := g_iVar + iVar1;
IF iVar2 < INT#100 THEN
   iVar1 := iVar1 / iVar2; // SA0040
END_IF
--> SA0040: Possible division by zero
--> SA0040: Possible division by zero
```

See also

- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0041: Detect possible loop invariant code

Detects assignments in loops that calculate the same value for each loop cycle. These lines of code could possibly be inserted outside of the loop.

Justification: This is a performance warning. Code that is executed in a loop, but does the same thing in each loop cycle, can be executed outside of the loop.

Importance: Medium

Example

```
PROGRAM PLC_PRG
VAR
   iVar1, iVar2: INT;
END_VAR
FOR iCounter := 0 TO 10 DO
   iVar1 := 100;       // SA0041
   iVar2 := iVar2 + iVar1;
END_FOR
--> SAN0041: Possible loop invariant code 'iVar1 := 100'
```

See also

- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209
SA0042: Usage of different access paths

Detects the usage of different access paths for the same variable

Justification: Different access to the same element decreases the readability and maintainability of a program. We recommend the consistent usage of `{attribute 'qualified-only'}` for libraries, global variable lists, and enumerations. This forces a fully qualified access.

Importance: Low

Example

```
VAR_GLOBAL
    iTemp:INT;
    instPOU:POU;
END_VAR

FUNCTION_BLOCK POU
VAR
    a:INT;
END_VAR
    a := INT#1;

PROGRAM SA0042
VAR
    ptiTemp:POINTER TO INT;
    sTemp:STRING;
END_VAR
    ptiTemp := ADR(iTemp);
    ptiTemp^:= INT#1;
    iTemp:= INT#1;  // SA0042 - direct access on variable
    GVL.iTemp := INT#2;  // SA0042 - access on variable via GVL
    sTemp := CONCAT('ab', 'cd');  // SA0042 - direct access on function
    sTemp := Standard.CONCAT('ab', 'cd');  // SA0042 - access on function via Standard
    instPOU();  // SA0042 - direct access on POU instance
    GVL.instPOU();  // SA0042 - access via GVL

--> SA0042: Different access paths for 'CONCAT'
--> SA0042: Different access paths for 'Standard.CONCAT'
--> SA0042: Different access paths for 'instPOU'
--> SA0042: Different access paths for 'GVL.instPOU'
--> SA0042: Different access paths for 'iTemp'
--> SA0042: Different access paths for 'GVL.iTemp'
```

See also

● * Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0043: Use of a global variable in only one POU

Detects the use of a global variable in only a single POU

Justification: A global variable that is used in only one location should also only be declared at this location.

Importance: Medium
Example

```plaintext
VAR_GLOBAL
  g_xVar AT %QX0.0 : BOOL ;
  g_iTest AT %QW1 : INT ;
  g_wTest AT %QW2 : WORD;
END_VAR

PROGRAM prog1
VAR
  iCondition : INT;
  bTemp :BOOL;
END_VAR
iCondition := iCondition + INT#1;
IF iCondition < INT#0 THEN
  bTemp := g_xVar;   // SA0043 - g_xVar only read in this POU
ELSIF iCondition = INT#0 THEN
  bTemp := g_xVar;   // SA0043 - g_xVar only read in this POU
ELSE
  bTemp := g_xVar;   // SA0043 - g_xVar only read in this POU
  g_wTest := WORD#4; // g_wTest used also in prog2 -> OK
END_IF

PROGRAM prog2
VAR
  iCondition : INT;
END_VAR
iCondition := iCondition + INT#1;
CASE iCondition OF
  INT#1:
    g_iTest := WORD_TO_INT(g_wTest); // SA0043 - g_iTest only written in this POU
  INT#2:
    g_iTest := INT#2;   // SA0043 - g_iTest only written in this POU
ELSE
  g_iTest := INT#3;   // SA0043 - g_iTest only written in this POU
END_CASE
--> SA0043: Global variable 'g_xVar' only used in 'prog1'
--> SA0043: Global variable 'g_iTest' only used in 'prog2'
```

See also

- § Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0044: Declarations with reference to interface

Detected declarations with reference to interfaces and declarations of VAR_IN_OUT variables with interfaces (implicitly implemented by means of REFERENCE TO)

Justification: An interface type is always implicitly a reference to an instance of a function block that implements this interface. A reference to an interface is therefore a reference to a reference and can result in unwanted behavior.

Importance: High
Example

ITF is an interface that is defined in the project.

PROGRAM PLC_PRG
VAR
  inst:POU;
  itf_inst1 : ITF;
  itf_ref : REFERENCE TO ITF; // SA0044
END_VAR

FUNCTION_BLOCK POU
VAR_INPUT
  inst_itf2 : ITF;
END_VAR

VAR_OUTPUT
  inst_itf3 : ITF;
END_VAR

VAR_IN_OUT
  inst_itf4 : ITF;           // SA0044
  itf4_ref:
END_VAR

--> SA0044: Reference to interface 'itf_ref'

See also

- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

Conversions

6.6.3.4.2.37.1 SA0019: Implicit pointer conversions........................................ 4258
6.6.3.4.2.37.2 SA0130: Implicit expanding conversions........................................ 4259
6.6.3.4.2.37.3 SA0131: Implicit narrowing conversions........................................ 4260
6.6.3.4.2.37.4 SA0132: Implicit signed/unsigned conversions................................. 4261
6.6.3.4.2.37.5 SA0133: Explicit narrowing conversions........................................ 4261
6.6.3.4.2.37.6 SA0134: Explicit signed/unsigned conversions................................. 4262

SA0019: Implicit pointer conversions

Detects implicitly generated pointer conversions

Justification: In CODESYS, pointers are not strictly typed and they can be assigned to each other in any way. This is often used and therefore not reported by the compiler. However, it can also accidentally cause unexpected access. If you assign a POINTER TO BYTE to a POINTER TO DWORD, then you can unintentionally overwrite memory using the latter pointer. Therefore, always check this rule and block the message for cases in which you intentionally want to access a value with a different type.

Implicit data type conversions are reported with a different message.

Importance: High

PLCopen rule: CP25

Exception: BOOL <-> BIT
Example

PROGRAM PLC_PRG
VAR
  pINT : POINTER TO INT;
  byteVar : BYTE;
END_VAR

pINT := ADR(byteVar);

--> SA0019: Implicit conversion from pointer to 'POINTER TO BYTE'
to pointer to 'POINTER TO INT'

See also
● Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0130: Implicit expanding conversions

Detects implicit conversions from smaller data types to larger data types

Justification: The compiler permits any assignments of different types when the value range of the source type is completely contained within the value range of the target type. However, the compiler will build a conversion into the code as late as possible. For an assignment of type lint := dint * dint, the compiler performs the implicit conversion only after multiplication: lint := TO_LINT(dint * dint). An overflow is therefore truncated. To prevent this, you can already convert the elements: lint := TO_LINT(dint) * TO_LINT(dint). Therefore, it may be useful to report locations where the compiler implements implicit conversions in order to check whether these are exactly what is intended. Furthermore, explicit conversions can be used to improve portability to other systems when those systems have more restrictive type checks.

Importance: Low
Example

PROGRAM PLC_PRG
VAR
  byTemp : BYTE;
  usiTemp : USINT;
    uiTemp : UINT;
    iTemp : INT;
    udiTemp : UDINT;
  diTemp : DINT;
  uliTemp : ULINT;
    liTemp : LINT;
    lwTemp : LWORD;
    lrTemp : LREAL;
END_VAR

liTemp := iTemp;       // SA0130
uliTemp := usiTemp;    // SA0130
lwTemp := udiTemp;     // SA0130
lrTemp := byTemp;      // SA0130
diTemp := uiTemp;      // SA0130
byTemp.5 := FALSE;     // OK (BIT_BOOL conversion)

--> SA0130: Implicit widening conversion from type 'INT' to type 'LINT'
--> SA0130: Implicit widening conversion from type 'USINT' to type 'ULINT'
--> SA0130: Implicit widening conversion from type 'UDINT' to type 'LWORD'
--> SA0130: Implicit widening conversion from type 'BYTE' to type 'LREAL'
--> SA0130: Implicit widening conversion from type 'UINT' to type 'DINT'

See also
  ● Chapter 6.6.3.2 "Configuring and Running Static Analysis" on page 4209

SA0131: Implicit narrowing conversions

Detects implicit conversions from larger data types to smaller data types

Justification: This message is obsolete now because it is already reported as a warning by the compiler.

Importance: Low

Example

PROGRAM PLC_PRG
VAR
  rTemp : REAL;
  lrTemp : LREAL;
END_VAR
rTemp := lrTemp;    // SA0131

--> SA0131: Implicit narrowing conversion from type 'LREAL' to type 'REAL'

See also
  ● Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209
SA0132: Implicit signed/unsigned conversions

Detects implicit conversions from signed data types to unsigned data types or the other way around.

```
This message is obsolete now because it is already reported as a warning by the compiler.
```

Importance: Low

**Example**

```plaintext
PROGRAM PLC_PRG
VAR
  byTest : BYTE;
  udiTest: UDINT;
  ulktest: ULINT;
  wTest : WORD;
  lwTest : LWORD;
  siTest : SINT;
  iTest : INT;
  diTest : DINT;
  liTest : LINT;
END_VAR
liTest := ulktest;    // SA0132
udiTest:= diTest;     // SA0132
siTest := byTest;     // SA0132
wTest := iTest;       // SA0132
lwTest := siTest;     // SA0132
```

```
--> SA0132: Implicit signed/unsigned conversion from type 'ULINT' to type 'LINT'
--> SA0132: Implicit signed/unsigned conversion from type 'DINT' to type 'UDINT'
--> SA0132: Implicit signed/unsigned conversion from type 'BYTE' to type 'SINT'
--> SA0132: Implicit signed/unsigned conversion from type 'INT' to type 'WORD'
--> SA0132: Implicit signed/unsigned conversion from type 'SINT' to type 'LWORD'
```

See also

- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0133: Explicit narrowing conversions

Detects explicit conversions from a larger data type to a smaller data type

Justification: A large number of type conversions may indicate that you have chosen the wrong data types for variables. For this reason, there are programming guidelines that require an explicit justification for data type conversions.

Importance: Low
Example

PROGRAM SA0133
VAR
    siVar:SINT;
    diVar:DINT;
    liVar:LINT;
    byVar:BYTE;
    uiVar:UINT;
    dwVar:DWORD;
    lwVar:LWORD;
    rVar:REAL;
    lrVar:LREAL;
END_VAR

siVar := LINT_TO_SINT(liVar);     // SA0133
byVar := DINT_TO_BYTE(diVar);     // SA0133
siVar := DWORD_TO_SINT(dwVar);    // SA0133
uiVar := LREAL_TO_UINT(lrVar);    // SA0133
rVar := LWORD_TO_REAL(lwVar);     // SA0133

--> SA0133: Explicit narrowing conversion from type 'LINT' to type 'SINT'
--> SA0133: Explicit narrowing conversion from type 'DINT' to type 'BYTE'
--> SA0133: Explicit narrowing conversion from type 'DWORD' to type 'SINT'
--> SA0133: Explicit narrowing conversion from type 'LREAL' to type 'UINT'
--> SA0133: Explicit narrowing conversion from type 'LWORD' to type 'REAL'

See also

● § Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0134: Explicit signed/unsigned conversions

Detects explicit conversions from signed data types to unsigned data types and the other way around

Justification: Excessive use of type conversions may indicate that you have chosen the wrong data types for variables. For this reason, there are programming guidelines that require an explicit justification for data type conversions.

Importance: Low
Example

PROGRAM PLC_PRG
VAR
    byVar : BYTE;
    udiVar : UDINT;
    uliVar : ULLINT;
    lwVar : LWORD;
    wVar : WORD;
    siVar    : SINT;
    iVar    : INT;
    diVar : DINT;
    liVar    : LINT;
END_VAR

liVar := ULINT_TO_LINT(uliVar);
udiVar := DINT_TO_UDINT(diVar);
siVar := BYTE_TO_SINT(byVar);
wVar := INT_TO_WORD(iVar);
lwVar := SINT_TO_LWORD(siVar);

--> SA0134: Explicit signed/unsigned conversion from type 'ULINT' to type 'LINT'
--> SA0134: Explicit signed/unsigned conversion from type 'DINT' to type 'UDINT'
--> SA0134: Explicit signed/unsigned conversion from type 'BYTE' to type 'SINT'
--> SA0134: Explicit signed/unsigned conversion from type 'INT' to type 'WORD'
--> SA0134: Explicit signed/unsigned conversion from type 'SINT' to type 'LWORD'

See also

- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

Use of Direct Addresses

| 6.6.3.4.2.38.1 | SA0005: Invalid addresses and data types........................................ 4263 |
| 6.6.3.4.2.38.2 | SA0047: Accesses to direct address.................................................. 4264 |
| 6.6.3.4.2.38.3 | SA0048: AT-declarations on direct addresses....................................... 4264 |

SA0005: Invalid addresses and data types

Detects invalid addresses and data type specifications. Valid size prefixes in addresses: X for BOOL, B for 1-byte data types, W for 2-byte data types, and D for 4-byte data types.

Justification: Variables located on direct addresses should preferably be associated with an address that corresponds to their data type width. It can be confusing for the reader of the code, for example, if a DWORD is assigned to a BYTE address.

Importance: Low
Example

PROGRAM Check_Address_Type_PRG
VAR
  iVar AT %QB0 : INT ;   // OK e. g.: %QW0
  xTest AT %QW1 : BOOL ; // OK e. g.: %QX1.0
END_VAR

iVar := iVar + INT#1;
xTest := NOT xTest;

--> SA0005: Invalid address for data type 'iVar'

See also
- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0047: Accesses to direct address

Detects direct address access in the implementation code

Justification: Symbolic programming is always preferable. A variable has a name that can also have a meaning. An address cannot indicate what it is used for.

Importance: High
PLCopen rule: N1 / CP1

Example

PROGRAM PLC_PRG
VAR
  xVar : BOOL;
  byVar : BYTE;
END_VAR

xVar := %IX0.0;
%QX0.0 := xVar;
%MX0.1 := xVar;
%MB1 := byVar;

--> Access to direct address '%IX0.0'
--> Access to direct address '%QX0.0'
--> Access to direct address '%MX0.1'
--> Access to direct address '%MB1'

See also
- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0048: AT-declarations on direct addresses

Detects AT declarations on direct addresses

Justification: The use of direct addresses in the code is problematic because the address then appears in multiple locations: first in the controller configuration where the assignment of a physical object to an address is defined, and second in the program where variables are assigned to these addresses. If the addresses are relocated because the configuration is changed, then you have to reassign variables to addresses at a completely different location in the program. This is a cause of error and results in poorer readability and maintainability of the code. Therefore, it is best to perform all assignments in the I/O mapping of the device editor.

Importance: High
PLCopen rule: N1 / CP1

Note: We recommend that you use direct addresses ONLY in the “I/O Mapping” tab of the device editor.

Example

PROGRAM PLC_PRG
VAR
  xVar1    AT    %IX0.0    : BOOL;
  byVar1   AT    %IB1    : BYTE;
  xVar2    AT    %QX0.0    : BOOL;
END_VAR

--> SA0048: Declaration uses direct address '%IX0.0'
--> SA0048: Declaration uses direct address '%IB1'
--> SA0048: Declaration uses direct address '%QX0.0'

See also

- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

Rules for Operators

6.6.3.4.2.39.1 SA0051: Comparison operations on BOOL variables............. 4265
6.6.3.4.2.39.2 SA0052: Unusual shift operation............................................. 4266
6.6.3.4.2.39.3 SA0053: Too big bitwise shift.................................................. 4266
6.6.3.4.2.39.4 SA0054: Comparisons of REAL/LREAL for equality / inequality.................................................. 4267
6.6.3.4.2.39.5 SA0055: Unnecessary comparisons of unsigned operands.... 4268
6.6.3.4.2.39.6 SA0056: Constant out of valid range....................................... 4268
6.6.3.4.2.39.7 SA0057: Possible loss of decimal places............................... 4269
6.6.3.4.2.39.8 SA0058: Operations on enumeration variables....................... 4269
6.6.3.4.2.39.9 SA0059: Comparison operations always returning TRUE or FALSE.................................................. 4271
6.6.3.4.2.39.10 SA0060: Zero used as invalid operand................................. 4271
6.6.3.4.2.39.11 SA0061: Unusual operation on pointer.................................. 4271
6.6.3.4.2.39.12 SA0062: Uses of TRUE or FALSE in expressions.................... 4272
6.6.3.4.2.39.13 SA0063: Possibly not 16-bit-compatible operations.............. 4272
6.6.3.4.2.39.14 SA0064: Addition of pointer................................................... 4273
6.6.3.4.2.39.15 SA0065: Incorrect pointer addition to base size................. 4273
6.6.3.4.2.39.16 SA0066: Uses of temporary results....................................... 4274

SA0051: Comparison operations on BOOL variables

Detects comparison operations on variables of type BOOL

Justification: CODESYS permits these kinds of comparison, but they are very unusual and can be confusing. The IEC 61131-3 standard does not provide for these comparisons. By avoiding them, you increase the portability of the code to other development systems.

Importance: Medium
Example

PROGRAM PLC_PRG
VAR
  xBool1, xBool2 : BOOL;
  xResult : BOOL;
END_VAR

xResult := xBool1 > xBool2;  // SA0051
xBool1 := NOT xBool1;       // OK!
xBool2 := xBool2 XOR xBool1; // OK!

--> SA0051: Comparison operations on BOOL variables

See also
- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0052: Unusual shift operation

Detects shift operations (bit shift) on signed variables. In the case of shift operations on bitfield data types (BYTE, DWORD, LWORD, WORD), an error is not reported.

Justification: CODESYS permits shift operations on signed data types. However, these operations are unusual and can be confusing. The IEC 61131-3 standard does not provide for these kinds of operations. Therefore, they should be avoided in order to increase the portability of the code to other development systems.

Importance: Medium

Example

PROGRAM PLC_PRG
VAR
  iTemp : INT;
  dwTemp1 : DWORD;
  byTemp2 : BYTE;
  diTemp3 : DINT;
  siTemp4 : SINT;
  liTemp5 : LINT;
END_VAR

// the following lines each will cause an SA0052:
intemp := SHL(iTemp, BYTE#2);
diTemp3 := SHR(diTemp3, BYTE#4);
siTemp4 := ROL(siTemp4, BYTE#2);
liTemp5 := ROR(liTemp5, BYTE#2);

// no error SA0052 because DWORD and BYTE are bit field data types:
dwTemp1 := SHL(dwTemp1, BYTE#3);
byTemp2 := SHR(byTemp2, BYTE#1);

--- SA0052: Unusual shift operation

See also
- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0053: Too big bitwise shift

Detects whether or not the data type width of the operand has been exceeded in the case of a bitwise shift (bit shift) of operands
Justification: If a shift operation exceeds the data type width, then a constant 0 is generated. If a rotation shift exceeds the data type width, then it is difficult to read. Therefore, the rotation value should be shortened.

Importance: High

Example

PROGRAM PLC_PRG
VAR
  byTemp1 : BYTE;
  wTemp2 : WORD;
  dwTemp3 : DWORD;
  lwTemp4 : LWORD;
END_VAR
byTemp1 := SHR(byTemp1, BYTE#25);
wTemp2 := SHL(wTemp2, BYTE#45);
dwTemp3 := ROR(dwTemp3, BYTE#78);
lwTemp4 := ROL(lwTemp4, BYTE#111);

--> SA0053: Too big bitwise shift

See also
  ● % Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0054: Comparisons of REAL/LREAL for equality / inequality

Detects whether or not the comparison operators = (equality) and <> (inequality) compare the operands of type REAL or LREAL

Justification: REAL/LREAL values are implemented as floating-point numbers according to the IEEE 754 standard. This standard implies that specific, apparently simple decimal numbers cannot be represented with precision. As a result, there may be different representations as LREAL for the same decimal number.

Consider the following lines of code:

lr11 := 1.1;
lr33 := 3.3;
lrVar1 := lr11 + lr11;
lrVar2 := lr33 - lr11;
botest := lrVar1 = lrVar2;

In this case, botest returns FALSE, even if the variables lrVar1 and lrVar2 both return the monitoring value of 2.2. This is not an error of the compiler, but a property of the floating point units of all conventional processors. You can avoid this by specifying a minimum value by which the values may differ: botest := ABS(lrVar1 - lrVar2) < 0.1;

Exception: A comparison with 0.0 is not reported by this analysis. For the 0, there is an exact representation in the IEEE 754 standard, and therefore the comparison functions normally as expected. Therefore, for better performance, it makes sense to permit a direct comparison here.

Importance: High

PLCopen rule: CP54
Example

```plaintext
PROGRAM PLC_PRG
VAR
    rTest1 : REAL;
    rTest2 : REAL;
    lrTest3 : LREAL;
    lrTest4 : LREAL;
    xResult : BOOL;
END_VAR

//the following lines each will cause an SA0054:
    xResult := rTest1 = rTest1;
    xResult := rTest1 = rTest2;
    xResult := rTest1 <> rTest2;
    xResult := lrTest3 = lrTest3;
    xResult := lrTest3 = lrTest4;
    xResult := lrTest3 <> lrTest4;
//the following lines each will not cause an SA0054:
    xResult := rTest1 > rTest2;
    xResult := lrTest3 < lrTest4;
```

See also

- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0055: Unnecessary comparisons of unsigned operands

Detects unnecessary comparisons with unsigned operands. An unsigned data type is never less than zero. This can be used as a sign check.

Justification: A comparison detected with this check yields a constant result and is an indication of an error in the code.

Importance: High

Example

```plaintext
PROGRAM PLC_PRG
VAR
    byTest: BYTE;
END_VAR

WHILE byTest >= 0 DO
    byTest := byTest - 1;
END WHILE;
```

See also

- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0056: Constant out of valid range

Detects literals (constants) outside of the valid range of the operator.

Justification: The message is issued in cases when a value is compared with a constant that is outside of the range of this value. Then the comparison constantly returns TRUE or FALSE. This is an indication of a programming error.
Example

```plaintext
PROGRAM PLC_PRG
VAR
  byTestVar: BYTE;
END_VAR

WHILE byTestVar >= 260 DO
  byTestVar := byTestVar + 1;
END_WHILE

--> SA0056: Constant out of valid range
```

See also

- § Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0057: Possible loss of decimal places

Detects statements with possible loss of decimal places

Justification: A piece of code of the following type (diTemp2 := 1 rTemp1 := TO_REAL(diTemp2 / DINT#2)) can cause a misinterpretation. The author or reader of this line of code can assume that the division would be performed as a REAL operation, and in this case the result would be REAL#0.5. However, this is not true. It is an integer operation. The result is cast to REAL and rTemp1 gets the value REAL#0. To avoid this, use a cast to make sure that the operation is performed as a REAL operation: rTemp1 := TO_REAL(diTemp2) / REAL#2.

Importance: Medium

Example

```plaintext
PROGRAM PLC_PRG
VAR
  rTemp1: REAL;
  diTemp2: DINT;
  liTemp3: LINT;
END_VAR

diTemp2 := diTemp2 + DINT#11;
  rTemp1 := DINT_TO_REAL(diTemp2 / DINT#3);    // SA0057
rTemp1 := DINT_TO_REAL(diTemp2) / REAL#3.0;
liTemp3 := liTemp3 + LINT#13;
  rTemp1 := LINT_TO_REAL(liTemp3 / LINT#7);    // SA0057
rTemp1 := LINT_TO_REAL(liTemp3) / REAL#7.0;

--> SA0057: Possible loss of decimal places
```

See also

- § Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0058: Operations on enumeration variables

Detects operations on variables of the enumeration data type Assignments are permitted.

Justification: Enumerations should not be used as ordinary integer values. You can also define an alias data type or use a subrange type.
Exception: If an enumeration is tagged with the pragma `{attribute 'strict'}`, then the compiler already reports this kind of operation.

If an enumeration is declared as a flag by the pragma `{attribute 'flags'}`, then an error is not issued for AND, OR, NOT, or XOR operations.

Example

```plaintext
TYPE My_Enum :
  (red := 1, blue := 2, green := 3, black := 4);
END_TYPE

PROGRAM PLC_PRG
VAR
  iTempl : INT;
  abc : My_Enum;
END_VAR

iTempl := iTempl + INT#1;
abc := My_Enum.red;  // OK
iTempl := My_Enum.black / My_Enum.blue; // SA0058
iTempl := My_Enum.green / My_Enum.red;  // SA0058

--> SA0058: Operations on enumeration variables
```

Example with a pragma `{attribute 'flags'}`

```plaintext
{attribute 'flags'}  // declaring the enumeration as a "flag"
TYPE Flags :
  (Unknown := 16#00000001,
   Stopped := 16#00000002,
   Running := 16#00000004
  ) DWORD;
END_TYPE

PROGRAM PLC_PRG
VAR
  iTempl : INT;
  abc : Flags;
  batate : BYTE;
  dwFlags : DWORD;
  dwState : DWORD;
END_VAR

// OK for the following
IF (dwFlags AND Flags.Unknown) <> DWORD#0 THEN
dwState := dwState AND Flags.Unknown;
ELSIF (dwFlags OR Flags.Stopped) <> DWORD#0 THEN
dwState := dwState OR Flags.Running;
END_IF
```

See also

- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209
**SA0059: Comparison operations always returning TRUE or FALSE**

Detects comparisons with literals that always have the result TRUE or FALSE, and can already be processed during the compile.

**Justification:** An operation that consistently yields TRUE or FALSE is an indication of a programming error.

**Importance:** High

**Example**

```plaintext
PROGRAM PLC_PRG
VAR
  byTemp1 : BYTE;
END_VAR

WHILE byTemp1 <= 255 DO
  byTemp1 := byTemp1 + 1;
END_WHILE;

--> SA0059: Relational operator '<=' always evaluates 'TRUE'
```

**See also**

- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

**SA0060: Zero used as invalid operand**

Detects operations where an operand with the value "0" causes an invalid or a nonsense operation

**Justification:** This kind of expression could be an indication of a programming error. In any case, it unnecessarily wastes runtime.

**Importance:** Medium

**Example**

```plaintext
PROGRAM PLC_PRG
VAR
  byTemp1 : BYTE;
  wTemp2 : WORD;
  dwTemp3 : DWORD;
END_VAR

byTemp1 := byTemp1 + 0;
wTemp2 := wTemp2 - WORD#0;
dwTemp3 := dwTemp3 * DWORD#0;

--> SA0060: Zero used as invalid operand
```

**See also**

- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

**SA0061: Unusual operation on pointer**

Detects operations one variables of type POINTER TO which are not = (equality), <> (inequality), + (addition), or ADR.
In CODESYS, pointer arithmetic is generally permitted and can also be used appropriately. Therefore, the addition of a pointer with an integer value is considered a common operation on pointers. This makes it possible to use a pointer to process an array of variable length. All other (unusual) operations with pointers are reported with SA0061.

Importance: High

PLCopen rule: E2 / E3

**Example**

```plaintext
PROGRAM PLC_PRG
VAR
  piTemp : POINTER TO INT;
  iTemp : INT;
END_VAR

iTemp := iTemp + INT#1;
piTemp := ADR(iTemp);
piTemp := piTemp * DWORD#5; // SA0061
piTemp := piTemp / DWORD#2; // SA0061
piTemp := piTemp MOD DWORD#3; // SA0061
piTemp := piTemp + DWORD#1;
piTemp := piTemp - DWORD#1; // SA0061

--> SA0061: Unusual operation on pointer
```

See also

- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

**SA0062: Uses of TRUE or FALSE in expressions**

Detects the use of the literals TRUE or FALSE in expressions

Justification: This kind of expression is obviously unnecessary and may indicate an error. In any case, the expression unnecessarily affects the runtime.

Importance: Medium

**Example**

```plaintext
PROGRAM PLC_PRG
VAR
  xTemp1, xTemp2 : BOOL;
END_VAR
xTemp1 := xTemp1 AND NOT TRUE;
xTemp2 := xTemp1 OR TRUE;
xTemp2 := xTemp1 OR NOT FALSE;
xTemp2 := xTemp1 AND FALSE;

--> Uses of TRUE or FALSE in expressions
```

See also

- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

**SA0063: Possibly not 16-bit-compatible operations**

Detects 16-bit operations with temporary results. Background: On 16-bit systems, 32-bit temporary results can be truncated. Example: (int+10) can exceed 16 bits.

Justification: In the very rare case that you have to write code which should run on a 16-bit processor as well as on a 32-bit processor, this message should help to prevent any problems.
Importance: Low

**Example**

```plaintext
PROGRAM PLC_PRG
VAR
   iVar : INT;
END_VAR
iVar := (iVar + 10) / 2;
--> SA0063: Compatibility for 16 Bit - Possible truncated intermediate result
```

See also

- Chapter 6.6.3.2 "Configuring and Running Static Analysis" on page 4209

**SA0064: Addition of pointer**

Detects the addition of pointers

Justification: In CODESYS, pointer arithmetic is generally permitted and can also be used appropriately. However, it is also a source of errors. Therefore, programming rules exist that generally prohibit pointer arithmetic. This test can check such a requirement.

Importance: Medium

**Example**

```plaintext
PROGRAM PLC_PRG
VAR
   iTest:INT;
   ariTest:ARRAY[0..10] OF INT;
   {attribute 'analysis':='-111'}
   piTest:POINTER TO INT;
   i:INT;
END_VAR

piTest := ADR(ariTest[0]);            // OK
piTest^:= 0;
piTest := ADR(ariTest) + SIZEOF(INT); // SA0064
piTest^:= 1;
piTest := ADR(ariTest) + 6;          // SA0064
piTest^:= 3;
piTest := ADR(ariTest[10]);
FOR i:=0 TO 10 DO
   piTest^ := i;
   piTest := piTest + 2;              // SA0064
END_FOR

--> SA0064: Addition of pointer
```

See also

- Chapter 6.6.3.2 "Configuring and Running Static Analysis" on page 4209

**SA0065: Incorrect pointer addition to base size**

Detects pointer additions for which the value to be added does not match the base size of the pointer. Only literals of the base size can be added. Also multiplication products of the base size cannot be added.
Justification: In CODESYS (in contrast to C and C++), when adding a pointer with an integer value, only this integer value is added as the number of bytes, and not the integer value multiplied by the base size. Example in ST:

```st
pINT := ADR(array_of_int[0])
pINT := pINT + 2 ; // In CODESYS, pINT then points to array_of_int[1]
```

This code would function differently in C:

```c
short* pShort
pShort = &array_of_short[0]
pShort = pShort + 2; // In C, pShort then points to array_of_short[2]
```

Therefore, in CODESYS, you should always add a multiple of the base size of the pointer to a pointer. Otherwise, the pointer may point to non-aligned memory which (depending on the processor) can lead to an alignment exception when accessing it.

Importance: High

### Example

```st
VAR
  pudiTest:POINTER TO UDINT;
  udiTest:UDINT;
  prTest:POINTER TO REAL;
  rTest:REAL;
END_VAR

  pudiTest := ADR(udiTest) + 4;                  // OK
  pudiTest := ADR(udiTest) + ( 2 + 2 );          // OK
  pudiTest := ADR(udiTest) + SIZEOF(UDINT);      // OK
  pudiTest := ADR(udiTest) + 3;                  // SA0065
  pudiTest := ADR(udiTest) + 2*SIZEOF(UDINT);    // SA0065
  pudiTest := ADR(udiTest) + ( 3 + 2 );          // SA0065
  prTest := ADR(rTest);
  prTest := prTest + 4;                          // OK
  prTest := prTest + ( 2 + 2 );                  // OK
  prTest := prTest + SIZEOF(REAL);               // OK
  prTest := prTest + 1;                          // SA0065
  prTest := prTest + 3;                          // SA0065
  prTest := prTest + ( SIZEOF(REAL) - 1 );        // SA0065
  prTest := prTest + ( 1 + 4 );                  // SA0065
```

--> SA0065: Incorrect pointer addition to base size

See also

- Chapter 6.6.3.2 "Configuring and Running Static Analysis" on page 4209

### SA0066: Uses of temporary results

Detects the use of temporary results in statements with a data type that is less than the registry size. The implicit cast in this case may lead to unwanted results.

Justification: For performance reasons, CODESYS performs operations on the register width of the processor. Intermediate results are not truncated. This can lead to misinterpretations as in the following case: `usintTest := 0; xError := usintTest - 1 <> 255;`. In CODESYS, `xError` is TRUE in this case because the operation `usintTest - 1` is typically executed as a 32-bit operation and the result is not cast to the byte size. Then the value `16#fffffff` (not equal to 255) is located in the registry. To avoid this, you have to cast the intermediate result explicitly: `xError := TO_USINT(usintTest - 1) <> 255;`
**NOTICE!**

If this message is activated, then many less problematic locations in the code will be reported. Although a problem can only occur when the operation produces an overflow or underflow in the data type, the static analysis cannot differentiate between the individual locations.

If you include an explicit typecast in all reported locations, then the code will be much slower and less readable.

**Example**

```plaintext
PROGRAM PLC_PRG
VAR
  byTest:BYTE;
  liTest:LINT;
  xError:BOOL;
END_VAR

//type size smaller than register size;
byTest := 0;
IF (byTest - 1) <> 255 THEN //use of temporary result + implicit casting -> SA0066
  xError := TRUE;
ELSE
  xError := FALSE;
END_IF

//type size equal to or bigger than register size;
liTest := 0;
IF (liTest - 1)  <> -1 THEN // use of temporary result and no implicit casting -> OK
  xError := TRUE;
ELSE
  xError := FALSE;
END_IF

--> SA0066: Use of temporary result: (byTest - USINT #1)
```

**See also**

- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

**Rules for Statements**

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.6.3.4.2.40.1</td>
<td>SA0072: Invalid uses of counter variable.................................</td>
<td>4276</td>
</tr>
<tr>
<td>6.6.3.4.2.40.2</td>
<td>SA0073: Uses of inadequate counter variable...............................</td>
<td>4276</td>
</tr>
<tr>
<td>6.6.3.4.2.40.3</td>
<td>SA0080: Loop index variable for array index exeed array range..........................</td>
<td>4276</td>
</tr>
<tr>
<td>6.6.3.4.2.40.4</td>
<td>SA0081: Upper border is not a constant..................................................</td>
<td>4277</td>
</tr>
<tr>
<td>6.6.3.4.2.40.5</td>
<td>SA0075: Missing ELSE.................................................................</td>
<td>4278</td>
</tr>
<tr>
<td>6.6.3.4.2.40.6</td>
<td>SA0076: Missing enumeration constant...............................................</td>
<td>4279</td>
</tr>
<tr>
<td>6.6.3.4.2.40.7</td>
<td>SA0077: Type mismatches with CASE expression..................................</td>
<td>4280</td>
</tr>
<tr>
<td>6.6.3.4.2.40.8</td>
<td>SA0078: Missing CASE branches..........................................................</td>
<td>4280</td>
</tr>
<tr>
<td>6.6.3.4.2.40.9</td>
<td>SA0090: Return statement before end of function............................</td>
<td>4281</td>
</tr>
</tbody>
</table>
SA0072: Invalid uses of counter variable

Detects the use of a counter variable in a FOR loop

Justification: Manipulation of the counter variable in a FOR loop can easily result in an infinite loop. To prevent the execution of the loop for specific values of the counter variable, use CONTINUE or simply an IF.

Importance: High

PLCopen rule: L12

Example

```
PROGRAM PLC_PRG
VAR_TEMP
  iIndex : INT;
END_VAR
FOR iIndex := INT#0 TO INT#20 BY INT#1 DO
  iIndex := iIndex - INT#1;
END_FOR
```

--> SA0072: Invalid use of counter variable 'iIndex'

See also

● % Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0073: Uses of inadequate counter variable

Detects the use of non-temporary variables in FOR loops.

Justification: This is a performance warning. A counter variable is always initialized each time a POU is called. You can create this variable as a temporary variable (VAR_TEMP). Access to it may be faster and the variable does not take up any permanent memory.

Importance: Medium

PLCopen rule: CP21 / L13

Example

```
PROGRAM PLC_PRG
VAR
  nIndex : INT;
  iVar : INT;
END_VAR
FOR nIndex := INT#0 TO INT#20 BY INT#1 DO
  iVar := iVar + nIndex;
END_FOR
```

--> SA0073: Inadequate counter variable

See also

● % Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0080: Loop index variable for array index exceeds array range

Detects the FOR statements where the index variable is used to access an array index and exceeds the range of the array index
Justification: Arrays are typically processed in **FOR** loops. The start and end value of the counter variable should typically match (or at least not exceed) the upper and lower bounds of the array. A typical cause of error is detected here when array bounds are changed and constants are not carefully used; or when a different value is used accidentally in the **FOR** loop than in the array declaration.

Importance: High

### Example

```plaintext
PROGRAM PLC_PRG
VAR
  iIndex1, iIndex2, iIndex3 : INT;
  arWord : ARRAY[1..100] OF WORD;
  arararINT : ARRAY[1..9,1..9,1..9] OF INT;
  arUSINT : ARRAY[0..99] OF USINT;
END_VAR

// 1 violation of the rule (lower range is exceeded): SA0080
FOR iIndex1 := INT#0 TO INT#100 DO
  arWord[iIndex1] := INT_TO_WORD(iIndex1);
END_FOR

// 6 violations (lower and upper range is exceeded for each array dimension): 3SA0080
FOR iIndex2 := INT#0 TO INT#10 DO
  arararINT[iIndex2, iIndex2, iIndex2] := iIndex2;
END_FOR

// 1 violation (upper range is exceeded by the end result of the index), previous expressions on index are not evaluated -> OK
FOR iIndex3 := INT#0 TO INT#50 DO
  arUSINT[iIndex3 * INT#2] := INT_TO_USINT(iIndex3);
END_FOR

--> SA0080: Loop index range of 'Index1' exceeds array range
--> SA0080: Loop index range of 'Index2' exceeds array range
```

**SA0081: Upper border is not a constant**

Detects the **FOR** statements where the upper bound is not defined with a constant value

Justification: If the upper bound of a loop is a variable value, then it is no longer possible to see how often a loop is executed. This can result in serious problems at runtime. The worst case is an infinite loop.

Importance: High
Example

PROGRAM PLC_PRG
VAR
    i:INT;
    iBorder1: INT := 10;
    iBorder2: INT := 10;
    iCounter: INT;
END_VAR
VAR CONSTANT
    ciBorder:INT := 10;
END_VAR
FOR i:=0 TO 10 DO    //OK
    iCounter := i;
END_FOR
FOR i:=0 TO ciBorder DO // OK
    iCounter := i;
END_FOR
FOR i:=0 TO iBorder1 DO    // SA0081
    iCounter := i;
END_FOR
FOR i:=0 TO iBorder2 DO    // SA0081
    iCounter := i;
    IF iCounter = 10 THEN
        iBorder2 := 50;
    END_IF
END_FOR
--> SA0081: Upper border of a for loop must be a constant value

See also
● % Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0075: Missing ELSE

Detects CASE statements without an ELSE branch

Justification: Defensive programming requires the inclusion of an ELSE branch in every CASE statement. If there is nothing to do in the ELSE branch, then include a comment to indicate this. It is then clear to the reader of the code that the case was not simply forgotten.

Importance: Low

PLCopen rule: L17
Example

PROGRAM PLC_PRG
VAR
   iVar : INT;
   xTemp : BOOL;
END_VAR
iVar := iVar + INT#1;
CASE iVar OF
   INT#1:
     xTemp := FALSE;
   INT#2:
     xTemp := TRUE;
END_CASE
--> SA0075: Missing ELSE in CASE statement

See also

● Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0076: Missing enumeration constant

Detects whether or not an enumeration variable is used as a condition and not all enumeration values are treated as CASE branches

Justification: Defensive programming requires the processing of all possible values of an enumeration. If an action is not required for a particular enumeration value, then you should add a comment to indicate this explicitly. It is then clear to the reader of the code that the value was not simply forgotten.

Importance: Low

Example

TYPE My_Enum :
   (red := 1, blue := 2, green := 3, black := 4);
END_TYPE
PROGRAM PLC_PRG
VAR
   iVar : My_Enum;
   xTemp : BOOL;
END_VAR
iVar := My_Enum.black;
CASE iVar OF
   My_Enum.red:
     xTemp := FALSE;
   My_Enum.blue, My_Enum.green:
     xTemp := TRUE;
   ELSE
     xTemp := NOT xTemp;
END_CASE
--> SA0076: Missing enumeration constant 'black' in CASE statement

See also

● Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209
SA0077: Type mismatches with CASE expression

Detects code locations where the data type of a condition does not match that of the CASE branch.

Justification: If the data types between the CASE variable and the CASE itself do not match, then this could indicate an error.

Importance: Low

Example

```plaintext
TYPE My_Enum :
  (  
eins := 1, zwei := 2, drei := 3, vier := 4
);  
END_TYPE

PROGRAM PLC_PRG
VAR
  diVar : DINT;
  xTemp : BOOL;
END_VAR

diVar := diVar + DINT#1;
CASE diVar OF
  DINT#1:
    xTemp := FALSE;
    My_Enum.zwei, DINT#3:  //SA0077
      xTemp := TRUE;
  ELSE
    xTemp := NOT xTemp;
END_CASE

--> SA0077: Type mismatches with CASE expression
```

See also

- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0078: Missing CASE branches

Detects CASE statements without CASE branches and only one ELSE statement.

Justification: A CASE statement without cases wastes execution time and it is difficult to read.

Importance: Medium

Example

```plaintext
PROGRAM PLC_PRG
VAR
  iVar : INT;
  xTemp : BOOL;
END_VAR

iVar := iVar + INT#1;
//in the following the case descriptions are missing:
CASE iVar OF
  ELSE
    xTemp := NOT xTemp;
END_CASE

--> SA0078: CASE-Missing CASE branches
```
See also
-  Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

**SA0090: Return statement before end of function**

Detects whether or not the `RETURN` statement is not the last statement in a function, method, property, or program.

**Justification:** A `RETURN` in the code results in worse maintainability, testability, and readability of the code. A `RETURN` in the code is easily overlooked. Before each `RETURN`, it is often forgotten to insert code that should always be executed when exiting a function.

**Importance:** Medium

**PLCopen rule:** CP14

**Example**

```plaintext
FUNCTION FUN : DINT
VAR_INPUT
  bTest : BOOL;
END_VAR

IF bTest THEN
  RETURN;
END_IF
FUN := 99;

--> SA0090: Return statement before end of function
```

See also
-  Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

**SA0095: Assignments in conditions**

Detects assignments in conditions of IF, CASE, or REPEAT constructs

**Justification:** An assignment (:=) and a comparison (=) can easily be mistaken. As a result, an assignment in a condition can easily be unintentional, and it is therefore reported. This can also confuse the reader of the code.

**Importance:** High
Example

PROGRAM PLC_PRG
VAR
  iCond1:INT := INT#1;
iCond2:INT := INT#2;
xCond:BOOL := FALSE;
iVar : INT;
END_VAR

IF INT_TO_BOOL(iCond1 := iCond2) THEN // SA0095
  iCond1 := INT#1;
iCond2 := INT#2;
ELSIF (iCond1 := 11) = 11 THEN // SA0095
  iCond1 := INT#1;
iCond2 := INT#2;
END_IF

IF xCond := TRUE THEN // SA0095
  xCond := FALSE;
END_IF

IF (xCond := FALSE) OR (iCond1 := iCond2) = 12 THEN // SA0095
  xCond := FALSE;
iCond1 := INT#1;
iCond2 := INT#2;
END_IF

IF (iVar := iVar + 1) = 120 THEN // SA0095 (can be valid, but is not reparable very well
  iVar := 0;
END_IF

WHILE (xCond = TRUE) OR (iCond1 := iCond2) = 12 DO // SA0095
  xCond := FALSE;
END_WHILE

//Error: assignment in repeat loop
REPEAT
  xCond := FALSE;
UNTIL
  (xCond = TRUE) OR (iCond1 := iCond2) = 12 // SA0095
END_REPEAT

--> SA0095: Assignment in condition: '...'

See also

● § Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0100: Variables greater than <n> bytes...

Detects variables that use more than n bytes, where n is defined by the current configuration.
Default value: 1024 bytes. The value can be changed by double-clicking the line.

Justification: Some programming guidelines specify a maximum size for a single variable. This can be checked with this.

Importance: Low
Example

```plaintext
PROGRAM PLC_PRG
VAR
  aobyTest : ARRAY [0..1024] OF BYTE;
END_VAR

aobyTest[INT#0] := aobyTest[INT#0] + BYTE#1;

--> SA0100: Variable 'aobyTest' greater 1024 bytes
```

See also
- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0101: Names with invalid length

Detects names with invalid lengths. In the “Project Settings”, double-click the rule entry to open a dialog where you can define the length of the name and define any exception.

Justification: Some programming guidelines specify a minimum length for variable names. This analysis can be used to check compliance.

Importance: Low

PLCopen rule: N6

Example

```plaintext
PROGRAM PLC1  // SA0101
VAR
  iVar1: INT;  // SA0101
END_VAR

--> SA0101: Incorrect length of name 'PLC1'
```

See also
- Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0102: Access to program/fb variables from the outside

Detects external access to local variables of programs or function blocks

Justification: CODESYS permits external read access to local variables of programs or function blocks. This contradicts the principle of data encapsulation (hiding data) and does not comply with the IEC 61131-3 standard.

Importance: Medium
Example

PROGRAM PLC_PRG
VAR
  iCounter : INT;
  afb_Instance : AFB;
  bfb_Instance : BFB;
END_VAR
iCounter := A_PRG.iLocal;                // SA0102
iCounter := bfb_Instance.iLocal;         // SA0102
A_PRG();

FUNCTION_BLOCK AFB
VAR_INPUT
END_VAR
VAR_OUTPUT
END_VAR
VAR
  iLocal: INT;
END_VAR
METHOD METH : INT
VAR_INPUT
END_VAR
iLocal := iLocal + 1;

FUNCTION_BLOCK BFB EXTENDS AFB
VAR_INPUT
END_VAR
VAR_OUTPUT
END_VAR
VAR
END_VAR
METHOD METH : INT
VAR_INPUT
END_VAR
iLocal := iLocal + 1;

PROGRAM A_PRG
VAR
  iLocal: INT;
END_VAR
iLocal := iLocal + 1;

--> SA0102: Access to program/fb variable 'iLocal' from the outside

See also

● Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209

SA0103: Concurrent access on not atomic data

Detects whether or not non-atomic variables (for example, with data type STRING, WSTRING, ARRAY, STRUCT, FB instances, 64-bit data types) are used in more than one task

Justification: When there is no synchronization during access, inconsistent values can be read when reading in one task and writing in another task at the same time.

Importance: Medium
For some data types, especially 64-bit integers, it depends on the platform whether or not access is atomic. Static analysis reports a problem only when the controller does not support atomic access to 64-bit integer data types.

This rule does not apply in the following cases:

- If the target system has a floating point unit (FPU), then access of multiple tasks to LREAL variables is not detected.
- If the target system is a 64-bit processor or the corresponding target setting is set for the target device, then the rule does not apply to 64-bit data types.

Example

The project contains both programs, PRG1 and PRG2: The program PRG1 is called by the task MainTask_1. The program PRG2 is called by the task MainTask_2.

```plaintext
GVL
VAR GLOBAL
lrTest : LREAL; // Since the target system has an FPU, SA0103 does apply.
lint1 : LINT;
sTest : STRING; // SA0103
wsTest : WSTRING; // SA0103
END_VAR

PROGRAM PRG1
GVL.lrTest := 5.0;
GVL.sTest := 'welt';
GVL.wsTest := "welt";
GVL.lint1 := 99;

PROGRAM PRG2
GVL.lrTest := 5.0;
GVL.sTest := 'hallo';
GVL.wsTest := "hallo";
GVL.lint1 := 88;

--> SA0103: Concurrent access on not atomic data 'sTest'
--> SA0103: Concurrent access on not atomic data 'wsTest'
```

See also

- § Chapter 6.6.3.2 "Configuring and Running Static Analysis" on page 4209

SA0105: Multiple instance calls

Detects the instances of function blocks that are called multiple times. To do this, the function blocks have to be marked with the pragma `attribute 'analysis:report-multiple-instance-calls'`.

Justification: Some function blocks are designed in such a way that they can be called only one time in the cycle. This test checks whether or not a call is made in multiple locations.

Importance: Low

PLCopen rule: CP16 / CP20
Example

// {attribute 'analysis:report-multiple-instance-calls'} Deactivated
FUNCTION_BLOCK FB_DoA
VAR_INPUT
END_VAR
VAR_OUTPUT
END_VAR
VAR
  iA : INT;
END_VAR
iA := iA + 1;

FUNCTION_BLOCK FB_DoB
VAR_INPUT
END_VAR
VAR_OUTPUT
END_VAR
VAR
  iB : INT;
END_VAR
iB := iB + 1;

PROGRAM PLC_PRG
VAR
  fbA : FB_DoA;
  fbB : FB_DoB;
ND_VAR

fbA();
fbB(); // SA0105
fbA();
fbB(); // SA0105

--> SA0105: Instance 'fbB' called more than once

See also

● § Chapter 6.6.3.4.1.6 “Attribute 'analysis:report-multiple-instance-calls'” on page 4231

SA0106: Virtual method calls in FB_INIT

Detects method calls in the FB_Init method of a base function block, which are overwritten by a function block derived from a base function block

Justification: In these cases, it could be that the variables in the overwritten methods are not initialized in the base FB.

Importance: High
The function block FB_A includes the methods FB_Init and Meth_MyInit. FB_Init calls Meth_MyInit for initialization. The function block FB_B is derived from FB_A. PLC_PRG calls FB_B and therefore uses its mbMyDintB variable before it has been initialized. FB_B.Meth_MyInit overwrites FB_A.Meth_MyInit.

FUNCTION_BLOCK FB_A
  VAR
    mbMyDintA : DINT;
  END_VAR
FUNCTION_BLOCK FB_B EXTENDS FB_A
  VAR
    mbMyDintB : DINT;
  END_VAR
METHOD FB_Init : BOOL
  VAR_INPUT
    bInitRetains:BOOL;
    bInCopyCode:BOOL;
  END_VAR
  diDummy:DINT;            // SA0106
  mbMyDintA := 123;
  diDummy := Meth_MyInit();
  mbMyDintB := 123; // access to member of FB_B
PROGRAM PLC_PRG
  VAR
    g_BInst : FB_B;
    xVar : BOOL;
  END_VAR
  xVar := g_BInst.fb_init(TRUE, TRUE);
  //this instruction causes the following order of initializations:
  //FB_A.fb_init
  //FB_B.Meth_MyInit // SA0106
  //FB_B.fb_init
  //FB_B.Meth_MyInit
  --> SA0106: Virtual method call 'Meth_MyInit' in FB_INIT

See also
- Chapter 6.6.3.4.1.6 “Attribute ‘analysis:report-multiple-instance-calls’” on page 4231

SA0107: Missing formal parameters

Detects whether or not formal parameters are missing

Justification: Code becomes more readable when formal parameters are specified in the call.

Importance: Low
Example

FUNCTION FUNA : BOOL
VAR_INPUT
  bDo: BOOL;
  bInit: BOOL;
  bManual : BOOL;
END_VAR
VAR
  iInit: INT;
  iLocal: INT;
  iManual: INT;
END_VAR
IF bInit = TRUE THEN
  iInit := iInit + 1;
END_IF
IF bDo = TRUE THEN
  iLocal := iLocal + 1;
END_IF
IF bManual = TRUE THEN
  iManual:= iManual + 1;
END_IF
FUNA := TRUE;

PROGRAM PLC_PRG
VAR
END_VAR
FUNA(bInit := TRUE, bDo := TRUE, bManual := FALSE);     // OK
FUNA(TRUE, TRUE, bManual:= FALSE);                      // SA0107
--> SA0107: Missing formal parameter for input 'TRUE'

See also
● "Chapter 6.6.3.4.1.6 “Attribute 'analysis:report-multiple-instance-calls’” on page 4231

Checking Strict IEC Rules

<table>
<thead>
<tr>
<th>Rule</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.6.3.4.2.49.1</td>
<td>SA0111: Pointer variables</td>
<td>4289</td>
</tr>
<tr>
<td>6.6.3.4.2.49.2</td>
<td>SA0112: Reference variables</td>
<td>4289</td>
</tr>
<tr>
<td>6.6.3.4.2.49.3</td>
<td>SA0113: Variables with data type WSTRING</td>
<td>4289</td>
</tr>
<tr>
<td>6.6.3.4.2.49.4</td>
<td>SA0114: Variables with data type LTIME</td>
<td>4290</td>
</tr>
<tr>
<td>6.6.3.4.2.49.5</td>
<td>SA0115: Variables with data type UNION</td>
<td>4290</td>
</tr>
<tr>
<td>6.6.3.4.2.49.6</td>
<td>SA0117: Variables with data type BIT</td>
<td>4290</td>
</tr>
<tr>
<td>6.6.3.4.2.49.7</td>
<td>SA0119: Object-oriented features</td>
<td>4291</td>
</tr>
<tr>
<td>6.6.3.4.2.49.8</td>
<td>SA0120: Program calls</td>
<td>4291</td>
</tr>
<tr>
<td>6.6.3.4.2.49.9</td>
<td>SA0121: Missing VAR_EXTERNAL declarations</td>
<td>4292</td>
</tr>
<tr>
<td>6.6.3.4.2.49.10</td>
<td>SA0122: Array index defined as expression</td>
<td>4293</td>
</tr>
<tr>
<td>6.6.3.4.2.49.11</td>
<td>SA0123: Usages of INI, ADR or BITADR</td>
<td>4293</td>
</tr>
<tr>
<td>6.6.3.4.2.49.12</td>
<td>SA0147: Unusual shift operation - strict</td>
<td>4293</td>
</tr>
<tr>
<td>6.6.3.4.2.49.13</td>
<td>SA0148: Unusual bit access - strict</td>
<td>4294</td>
</tr>
<tr>
<td>6.6.3.4.2.49.14</td>
<td>SA0118: Initialisations not using constants</td>
<td>4295</td>
</tr>
<tr>
<td>6.6.3.4.2.49.15</td>
<td>SA0124: Pointer dereferences in declarations</td>
<td>4295</td>
</tr>
<tr>
<td>6.6.3.4.2.49.16</td>
<td>SA0125: References in initializations</td>
<td>4295</td>
</tr>
</tbody>
</table>
**SA0111: Pointer variables**

Detects variables of type `POINTER TO`

Justification: The IEC 61131-3 standard does not permit pointers.

Importance: Low

**Example**

```plaintext
VAR
    piTemp : POINTER TO INT;
    pbyTemp : POINTER TO BYTE;
END_VAR

--> SA0111: Data type POINTER not allowed
```

See also

- `Chapter 6.6.3.4.1.6 “Attribute 'analysis:report-multiple-instance-calls” on page 4231`

**SA0112: Reference variables**

Detects variables of type `REFERENCE TO`

Justification: The IEC 61131-3 standard does not permit references.

Importance: Low

**Example**

```plaintext
VAR
    ref_int : REFERENCE TO INT;
    ref_dw : REFERENCE TO DWORD;
END_VAR

--> Data type REFERENCE not allowed
```

See also

- `Chapter 6.6.3.4.1.6 “Attribute 'analysis:report-multiple-instance-calls” on page 4231`

**SA0113: Variables with data type WSTRING**

Detects variables of type `WSTRING`

Justification: Not all systems support `WSTRING`. The code is more easily portable without `WSTRING`.

**Example**

```plaintext
VAR
    wstrTemp : WSTRING;
END_VAR

--> SA0113: Data type WSTRING not allowed
```

See also

- `Chapter 6.6.3.4.1.6 “Attribute 'analysis:report-multiple-instance-calls” on page 4231`
SA0114: Variables with data type LTIME

Detects variables of type LTIME.

Justification: Not all systems support LTIME. The code is more easily portable without LTIME. Importance: Low

Example

```
VAR
  ltVar : LTIME; // SA0114
END_VAR

--> SA0114: Data type LTIME not allowed
```

See also

● Chapter 6.6.3.4.1.6 “Attribute 'analysis:report-multiple-instance-calls'” on page 4231

SA0115: Variables with data type UNION

Detects declarations of a UNION data type and variable declarations of the UNION type

Justification: The IEC 61131-3 standard does not include unions. The code is more easily portable without unions.

Importance: Low

Example

```
TYPE u1: UNION
  lrTemp : LREAL;
  liTemp : LINT;
END_UNION
END_TYPE

PROGRAM PLC_PRG
VAR
  uVar: u1;
END_VAR

--> SA0115: Unions not allowed
```

See also

● Chapter 6.6.3.4.1.6 “Attribute 'analysis:report-multiple-instance-calls'” on page 4231

SA0117: Variables with data type BIT

Detects variable declarations of data type BIT (possible within structure definitions)

Justification: The IEC 61131-3 standard does not include the data type BIT. The code is more easily portable without BIT.

Importance: Low
Example

```plaintext
TYPE Struct1 :
  STRUCT
    bitVar : BIT;
    iVar : INT;
    bVar : BOOL;
  END_STRUCT
END_TYPE

--> SA0117: Variables with data type BIT
```

See also

- Chapter 6.6.3.4.1.6 “Attribute 'analysis:report-multiple-instance-calls’” on page 4231

**SA0119: Object-oriented features**

Detects the use of object-oriented features, such as function block declarations with `EXTENDS` and `IMPLEMENTS`, or property and interface declarations. This rule is useful when you write code that is intended to be ported to other IEC 61131-3-compliant systems.

Justification: Not all systems support object-oriented programming. The code is more easily portable without object-orientation.

Importance: Low

Example

```plaintext
//Function block extended by another and implementing an interface:
FUNCTION_BLOCK POU EXTENDS CTD IMPLEMENTS ITF     //SA0119
  ...

// Declaration parts of property methods assigned to a function block:
POU.Prop.Get       //SA0119
POU.Prop.Set       //SA0119

--> SA0119: Object-oriented features not allowed
```

See also

- Chapter 6.6.3.4.1.6 “Attribute 'analysis:report-multiple-instance-calls’” on page 4231

**SA0120: Program calls**

Detects program calls

Justification: According to the IEC 61131-3 standard, programs can be called in the task configuration only. The code is more easily portable when you do not call programs from other locations.

Importance: Low
Example

```plaintext
PROGRAM prog_control
VAR
END_VAR

PROGRAM PLC_PRG
VAR
END_VAR

prog_control();
```

--> SA0120: Program call to 'prg_control' not allowed

See also
- Chapter 6.6.3.4.1.6 “Attribute 'analysis:report-multiple-instance-calls'” on page 4231

SA0121: Missing VAR_EXTERNAL declarations

Detects the use of a global variable in function blocks without them being declared there as "VAR_EXTERNAL"

Justification: According to the IEC 61131-3 standard, access to global variables is permitted only by an explicit import by means of a VAR_EXTERNAL declaration.

Importance: Low

PLCopen rule: CP18

Example

```plaintext
VAR_GLOBAL
    iGlob1:INT;
END_VAR

PROGRAM PLC_PRG
VAR
    ivar:INT;
END_VAR

ivar:=iGlob1;   // SA0121
```

--> SA0121: EXTERNAL declaration required for variable ''iGlob1''

Example:
Avoid error

```plaintext
VAR_GLOBAL
    iGlob1:INT;
END_VAR

PROGRAM PLC_PRG
VAR
    ivar:INT;
END_VAR
VAR_EXTERNAL
    iGlob1:INT;
END_VAR

ivar:=iGlob1;   // OK
```
SA0122: Array index defined as expression

Detects the use of expressions in the declaration of array indexes
Justification: Not all systems permit expressions as array limits.
Importance: Low

Example

```plaintext
PROGRAM PLC_PRG
VAR CONSTANT
  c_iValue : INT := INT#15;
END_VAR
VAR
  arr: ARRAY[0..c_iValue + 1] OF INT;
END_VAR
--> SA0122: Only constants allowed for array definition 'arr'
```

See also
● § Chapter 6.6.3.4.1.6 “Attribute 'analysis:report-multiple-instance-calls'” on page 4231

SA0123: Usages of INI, ADR or BITADR

Detects the use of the CODESYS-specific operators INI, ADR, and BITADR
Justification: CODESYS-specific operators prevent the portability of code.
Importance: Low

Example

```plaintext
PROGRAM PLC_PRG
VAR
  uiTemp: UINT;
  TempVarInFUNC: DWORD;
END_VAR
TempVarInFUNC := ADR(uiTemp);        //SA0123
--> SA0123: Operator 'ADR' not allowed
```

See also
● § Chapter 6.6.3.4.1.6 “Attribute 'analysis:report-multiple-instance-calls'” on page 4231

SA0147: Unusual shift operation - strict

Detects bit shift operations that are not made to bitfield data types (BYTE, WORD, DWORD, LWORD)
Justification: The IEC 61131-3 standard permits bit access only to bitfield data types. However, the CODESYS compiler also permits bit shift operations with unsigned data types.
Importance: Low
See also the strict rule SA0018.

Example

PROGRAM PLC_PRG
VAR
  in_byte : BYTE := 16#45; // 2#01000101
  in_word : WORD := 16#0045; // 2#0000000001000101
  in_uint : UINT;
  in_dint : DINT;
  erg_byte : BYTE;
  erg_word : WORD;
  erg_uint : UINT;
  erg_dint : DINT;
  n: BYTE := 2;
END_VAR

  erg_byte := SHL(in_byte,n); // no error because BYTE is a bit field
  erg_word := SHL(in_word,n); // no error because WORD is a bit field
  erg_uint := SHL(in_uint,n); // SA0147
  erg_dint := SHL(in_dint,n); // SA0147

  --> SA0147: Unusual shift operation - strict

See also

- § Chapter 6.6.3.4.1.6 “Attribute ‘analysis:report-multiple-instance-calls’” on page 4231
- § Chapter 6.6.3.4.2.17 “SA0018: Unusual bit access” on page 4243

SA0148: Unusual bit access - strict

Detects bit access that is not made to bitfield data types (BYTE, WORD, DWORD, and LWORD). The IEC 61131-3 standard permits only bit access to bitfield data types. However, the CODESYS compiler also permits bit access to unsigned data types.

Example

PROGRAM PLC_PRG
VAR
  iTemp1 : INT;
  diTemp3 : DINT;
  uliTemp4 : ULINT;
  siTemp5 : SINT;
  usiTemp6 : USINT;
  byTemp2 : BYTE;
END_VAR

  iTemp1.3 := TRUE; // SA0148
  diTemp3.4 := TRUE; // SA0148
  uliTemp4.18 := FALSE; // SA0148
  siTemp5.2 := FALSE; // SA0148
  usiTemp6.3 := TRUE; // SA0148
  byTemp2.5 := FALSE; // no error because BYTE is a bit field

  --> SA0148: Unusual bit access - strict
SA0118: Initialisations not using constants

Detected initializations that do not assign constants

Justification: Initializations should be constant if possible and should not refer to other variables. In particular, you should avoid function calls during initialization because this can allow access to uninitialized data.

Importance: Medium

Example

```plaintext
PROGRAM PLC_PRG
VAR
dwTemp : DWORD := 22;
dwTest : DWORD := dwTemp;   // SA0118
dwVar : DWORD := TempVarInFUNC();  // SA0118
END_VAR

--> SA0118: Initialisations not using constants
```

See also

- Chapter 6.6.3.4.1.6 “Attribute ‘analysis:report-multiple-instance-calls’” on page 4231

SA0124: Pointer dereferences in declarations

Detected pointer dereferences that are used for initialization in the declaration part

Justification: Pointers and references should not be used for initializations because this can lead to access violations if the pointer has not been initialized.

Importance: Medium

Example

```plaintext
FUNCTION_BLOCK FB_Test
VAR_INPUT
   refStruct: REFERENCE TO ST_Test;
END_VAR
VAR
   xPointer : BOOL := refStruct.a;  // SA0124
   iCount : INT;
END_VAR

--> SA0124: Dereference access in initialisation
```

See also

- Chapter 6.6.3.4.1.6 “Attribute ‘analysis:report-multiple-instance-calls’” on page 4231

SA0125: References in initializations

Detected reference variables that are used for initialization in the declaration part

Justification: Pointers and references should not be used for initializations because this can lead to access violations if the pointer has not been initialized.

Importance: Medium
Example

PROGRAM PLC_PRG
VAR
  xRef: REFERENCE TO INT;
  iCount: INT := xRef;
END_VAR

--> SA0125: Reference used in initializations

See also

● § Chapter 6.6.3.4.1.6 “Attribute 'analysis:report-multiple-instance-calls’” on page 4231

SA0140: Statements commented out

Detects commented-out statements

Justification: Code is often commented out for debugging purposes. When this kind of comment is released, it is not always clear at a later time whether the code should be deleted, or whether it has been commented out for debugging purposes and unintentionally not uncommented.

Importance: High

PLCopen rule: C4

Example

PROGRAM PLC_PRG
VAR
  iValue1: INT;
  iValue2: INT;
END_VAR

iValue1 := 100;
iValue2 := 200;
// iValue2 := 300;

--> SA0140: Statement commented out:: iValue2 := 300

See also

● § Chapter 6.6.3.4.1.6 “Attribute 'analysis:report-multiple-instance-calls’” on page 4231

Possible Use of Uninitialized Variables

6.6.3.4.2.51.1  SA0039: Possible null-pointer defences........................................ 4296
6.6.3.4.2.51.2  SA0046: Possible use of not initialised interface............................ 4297
6.6.3.4.2.51.3  SA0145: Possible use of not initialised reference.......................... 4298

SA0039: Possible null-pointer defences

Detects code locations where a null pointer is possibly dereferenced

Justification: A pointer should be checked before each dereferencing to make sure it is not equal to zero. Otherwise an access violation may occur at runtime.

Importance: High
PROGRAM PLC_PRG
VAR
  ptiVar1:POINTER TO INT;
  ptiVar2:POINTER TO INT;
  ptiVar3:POINTER TO INT;
  iVar:INT;
  iCount :INT;
  iCondition: INT;
END_VAR

iCount := iCount + INT#1;
ptiVar1 := ADR(iVar);
ptiVar1^ := iCondition; // OK - valid reference
ptiVar2^ := iCondition; // SA0039 - null pointer dereferenciation
iVar := ptiVar3^;       // SA0039 - null pointer dereferenciation

--> SA0039: Possible null pointer dereference 'ptiVar2^'
--> SA0039: Possible null pointer dereference 'ptiVar3^'

See also
- § Chapter 6.6.3.4.1.6 “Attribute 'analysis:report-multiple-instance-calls'” on page 4231

SA0046: Possible use of not initialised interface

Detects the use of interfaces that were not initialized before being used

Justification: An interface reference should be checked for <> 0 before it is used. Otherwise an access violation may occur during access.

Importance: High
Example

// declaration of INTERFACE ITF and assigned METH2:
METHOD METH2 : BOOL
VAR_INPUT
  iInput2:INT;
END_VAR

// declaration of INTERFACE Master_ITF1 and assigned METH:
METHOD METH : BOOL
VAR_INPUT
  iInput:INT;
END_VAR

PROGRAM PLC_PRG
VAR
  instPOU:POU;
  instITF:ITF;
  instMasterITF1:Master_ITF1;
  instMasterITF2:Master_ITF2;
  iDummy:INT;
 xDummy:BOOL;
  instNoInitITF:ITF;
  instNoInitITF2:ITF;
  instNoInitMasterITF1:Master_ITF1;
  instNoInitMasterITF2:Master_ITF2;
END_VAR

instITF := instPOU;
xDummy := instITF.METH(iInput := iDummy);           // OK
instMasterITF1 := instPOU;
xDummy := instMasterITF1.METH(iInput := iDummy);     // OK

xDummy := instNoInitITF.METH(iInput := INT#1);       // SA0046
xDummy := instNoInitITF.METH2(iInput2 := INT#2);      // SA0046
xDummy := instNoInitMasterITF1.METH(iInput := INT#3); // SA0046
iDummy := instNoInitMasterITF2.Prop;                  // SA0046

IF instNoInitITF <> 0 THEN
  instNoInitITF.Prop;                      // OK, weil das Interface nicht 0 sein kann
END_IF

--> SA0046: Possible use of not initialised interface
  'instNoInitITF'
--> SA0046: Possible use of not initialised interface
  'instNoInitITF'
--> SA0046: Possible use of not initialised interface
  'instNoInitITF'
--> SA0046: Possible use of not initialised interface
  'instNoInitMasterITF1'
--> SA0046: Possible use of not initialised interface
  'instNoInitMasterITF2'

See also

●  % Chapter 6.6.3.4.1.6 “Attribute 'analysis:report-multiple-instance-calls’” on page 4231

SA0145: Possible use of not initialised reference

Detects any reference variables that may not be initialized before use and are not checked by the operator __ISVALIDREF. This rule is applied in the implementation part of POUs. Rule SA0124 applies to the declaration.
Justification: A reference should be checked for its validity before access because an access violation may occur during access.
Importance: High

**Example**

```plaintext
PROGRAM PLC_PRG
VAR_INPUT
    ref_iTest : REFERENCE TO INT;
END_VAR

ref_iTest := 99;           // SA0145
IF __ISVALIDREF(ref_iTest) THEN
    ref_iTest := 88;
END_IF

--> SA0145: Possible use of not initialised reference 'ref_iTest'
```

See also
- § Chapter 6.6.3.4.1.6 “Attribute ‘analysis:report-multiple-instance-calls’” on page 4231
- § Chapter 6.6.3.4.2.49.15 “SA0124: Pointer dereferences in declarations” on page 4295

**SA0150: Violations of lower or upper limits or the metrics**

Detects the POUs that violate the activated metrics at the lower or upper limits
Justification: Code that complies with certain metrics is easier to read, easier to maintain, and easier to test.
Importance: High
PLCopen rule: CP9

**Example**

Initial situation: The “Number of calls” metric is selected in “Project Settings ➔ Static Analysis ➔ Metrics”. Lower limit: 0; upper limit: 3. Prog_1 is called five times.

When running the static analysis, the “SA0150: Metric violation for Prog_1. Report for metric calls (5) > 2” error is issued in the message view, in the “Build” category.

See also
- § Chapter 6.6.3.4.1.6 “Attribute ‘analysis:report-multiple-instance-calls’” on page 4231

**SA0160: Recursive calls**

Detects recursive calls in actions, methods, and properties of function blocks. Also detects possible recursions from virtual function calls and interface calls.
Justification: Recursions lead to non-deterministic behavior and are therefore a source of errors.
Importance: Medium
PLCopen rule: CP13
Example: The following method `Call` is assigned to the function block `FB_Test`:

```plaintext
FUNCTION_BLOCK FB_Test
    VAR
        bParameter: BOOL;
    END_VAR

    METHOD Call : BOOL
        VAR_INPUT
        END_VAR
        Call := THIS^.Call(); //SA0160
    END_VAR

END_FUNCTION_BLOCK
```

The program `PLC_PRG` calls `FB_Test`:

```plaintext
PROGRAM PLC_PRG
    VAR
        fbTest : FB_Test;
        bValue : BOOL;
    END_VAR

    bValue := fbTest.bParameter;
    fbTest.Call();

    --> SA0160: Recursive call detected: 'PLC_PRG -> FB_Test.Call -> FB_Test.Call'
```

See also
- § Chapter 6.6.3.4.1.6 “Attribute 'analysis:report-multiple-instance-calls'” on page 4231

SA0161: Unpacked structure in packed structure

Detects unpacked structures that are used in packed structures.

Justification: The compiler typically sets an unpacked structure to an address that allows aligned access to all elements within the structure. If you create this structure in a packed structure, then aligned access is no longer possible. Furthermore, access to an element in the unpacked structure can lead to a misalignment exception.

Importance: High
The structure \texttt{structSingleDataRecord} is packed, but it contains the unpacked structures \texttt{struct4Byte} and \texttt{struct9Byte}.

\begin{verbatim}
{attribute 'pack_mode' := '1'}
TYPE structSingleDataRecord :
  STRUCT
    str9ByteData: struct9Byte;    (* 9 BYTE *)
    str4ByteData: struct4Byte;    (* 4 BYTE *)
    udi1: UDINT;
    udi2: UDINT;
    udi3: UDINT;
    usi4: USINT;
  END_STRUCT
END_TYPE (* 9 BYTE *)
TYPE struct9Byte :
  STRUCT
    usiRotorSlots: USINT;        (* 1 BYTE *)
    uiMaxCurrent: UINT;            (* 2 BYTE  *)
    us1Velocity: USINT;            (* 1 BYTE  *)
    uiAcceleration: UINT;        (* 2 BYTE  *)
    uiDeceleration: UINT;        (* 2 BYTE *)
    usiDirectionChange: USINT;    (* 1 BYTE *)
  END_STRUCT
END_TYPE TYPE struct4Byte :
  STRUCT
    //udiDummy : UDINT;
    rRealDummy : REAL;
  END_STRUCT
END_TYPE
\end{verbatim}

--> SA0161: Declaration of an unpacked struct 'struct9ByteData' inside a packed struct 'structSingleDataRecord'

--> SA0161: Declaration of an unpacked struct 'struct4ByteData' inside a packed struct 'structSingleDataRecord'

See also

- Chapter 6.6.3.4.1.6 “Attribute ‘analysis:report-multiple-instance-calls’” on page 4231

\begin{description}
\item[SA0162: Missing comments]
Detected uncommented locations in the program

Justification: Complete commenting is required by many programming guidelines, and it increases the readability and maintainability of the code.

Importance: Low

PLCopen rule: C2

Comments are required in the following cases:

- Declaration of variables (Comments are located either above the declaration or to the right of the declaration.)
- Declaration of programs, function blocks, or methods (Comments are located above the declaration in the first line.)
Example

```plaintext
PROGRAM PLC_PRG
VAR
   iMaxValue: INT;
END_VAR

--> SA0162: Missing comment for 'PLC_PRG'
--> SA0162: Missing comment for 'iMaxValue'
```

See also

- Chapter 6.6.3.4.1.6 “Attribute 'analysis:report-multiple-instance-calls’” on page 4231

SA0163: Nested comments

Detects nested comments

Justification: Nested comments should be avoided because they are difficult to read.

Importance: Low

PLCopen rule: C3

Example

```plaintext
{attribute 'do-analysis'}
(* That is
(* nested comment 1 *)
*)
PROGRAM PLC_PRG
VAR
(* That is
// nested comment 2
comment *)
   iVal1: INT;
   iVal2: INT;

(* That is
(* nested comment 3 *) *)
   pVal3: POINTER TO DWORD;
   hugo: INT;
END_VAR

(* That is
// nested comment 4
comment *)
   iVal1 := iVal1 + 1;

(* That is
(* nested comment 5 *)
*)

(* Not that one *)

--> SA0163: Nested comment 'nested comment 1'
--> SA0163: Nested comment 'nested comment 2'
--> SA0163: Nested comment 'nested comment 3'
--> SA0163: Nested comment 'nested comment 4'
--> SA0163: Nested comment 'nested comment 5'
```
SA0164: Multiline comments

Detects multiline comments that are coded as (* comment *). Only single-line comments that are coded as // comment are permitted.

Justification: Some programming guidelines prohibit multiline comments in code because the beginning and end of a comment could get lost and the closing comment bracket could be deleted by accident.

You can deactivate this check by means of the pragma analysis, also for comments in the declaration part.

Importance: Low

PLCopen rule: C5

Example

{attribute 'do-analysis'}
(*
   This is a multi-line comment // SA0164
*)
PROGRAM PLC_PRG
VAR
   // This is a single line comment
   a: DINT;
END_VAR

(* This is not a single line comment *) // SA0164
   a := a + 1;

See also
●  Chapter 6.6.3.4.1.3 “Attribute 'analysis'” on page 4229

SA0165: Tasks calling other POUs than programs

Detects tasks that call function blocks or functions instead of a program

Justification: This rule is part of the PLCopen Coding Guidelines. Therefore, compliance is also checked in CODESYS. We do not see any problems with data consistency in CODESYS if tasks would call POUs other than programs. However, problems can occur if the code is to be ported to other platforms.

Importance: Low

PLCopen rule: CP16

Tasks are inserted below the task configuration. The POUs to be called are configured in the tasks. The POUs must be the “Program” type. The “Function block” and “Function” types are not permitted.
SA0166: Max. number of input/output/in-out variables...

Detects whether or not a defined number of input variables (VAR_INPUT), output variables (VAR_OUTPUT) or VAR_IN_OUT variables is exceeded in a POU. In the “Project Settings”, double-click the rule entry to open a dialog where you define the maximum number.

Justification: This is about checking individual programming guidelines. Many programming guidelines provide for a maximum number of POU parameters. Too many parameters make the code unreadable and the POUs difficult to test.

Importance: Medium

PLCopen rule: CP23

Example

In the project settings, for Rule 166, you have defined a maximum number of 1 for VAR_IN_OUT variables.

FUNCTION_BLOCK FB1
VAR_INPUT
  xIn  : BOOL;
END_VAR
VAR_IN_OUT
  xInOut1 : BOOL;
  xInOut2 : BOOL;
END_VAR

--> SA0166: Too many VAR_IN_OUT variables in POU 'FB1'

See also

● Chapter 6.6.3.4.1.6 “Attribute 'analysis:report-multiple-instance-calls’” on page 4231

SA0167: Temporary function block instances

Detects function block instances that are declared as temporary variables. This affects instances that are declared in a method or function or as VAR_TEMP, and therefore are reinitialized in each processing cycle or for each POU call.

Justification: Function blocks have a state that is usually maintained over multiple PLC cycles. An instance on the stack exists only for the duration of the function call. Therefore, it rarely makes sense to create an instance as a temporary variable. Secondly, function block instances are often large and need a lot of space on the stack (which is usually restricted to controllers). Thirdly, the initialization and often also the scheduling of a function block can take a long time.
Importance: Medium

Examples

```plaintext
PROGRAM PLC_PRG
VAR
END_VAR
VAR_TEMP
_yafb: AFB;
END_VAR

FUNCTION Fun : INT
VAR_INPUT
END_VAR
VAR
_funafb: AFB;
END_VAR

METHOD METH : INT
VAR_INPUT
END_VAR
VAR
_methafb: AFB;        // SA0167
END_VAR

--> SA0167: Temporary function block instance: 'methafb'
```

See also

- § Chapter 6.6.3.4.1.6 “Attribute 'analysis:report-multiple-instance-calls'” on page 4231

SA0168: Unnecessary Assignments

Detects assignments to variables which do not have any effect in the code.

Justification: When values are assigned to a variable multiple times without the variable being evaluated between assignments, the first assignments do not have any effect on the program.

Importance: Low

Example

```plaintext
PROGRAM PLC_PRG
VAR
dwVal1 : DWORD;
dwVal2 : DWORD;
END_VAR

dwVal1 := 1;                // unnecessary assignment
IF  dwVal2 > 100 THEN
    dwVal2 := 0;
dwVal2 := dwVal2 + 1;
END_IF
dwVal1 := 2;

--> SA0168: The variable 'dwVal1' is assigned but its value is never used.
```

See also

- § Chapter 6.6.3.2 “Configuring and Running Static Analysis” on page 4209
SA0169: Ignored outputs

Detects the outputs of methods and functions that are not specified when calling the method or function.

Justification: Ignored outputs can be a notice about an unhandled error or meaningless function calls because results are not used.

Importance: Medium

Example

```plaintext
FUNCTION Fun1
VAR_INPUT
    bIn : BOOL;
VAR_END
VAR_OUTPUT
    bOut : BOOL;
END_VAR
PROGRAM PLC_PRG
VAR
    bValue : BOOL;
END_VAR
Fun1(bIn : TRUE);
--//SA0169: The output 'bOut' is ignored when called.
```

See also

- Chapter 6.6.3.4.2.28.5 “SA0036: Unused output variables” on page 4251

6.6.4 Multi download tool

The multi download tool for AC500 V3 PLCs in Automation Builder enables firmware updates and application downloads of the same project to several PLCs of the same type.

Preconditions

- For application download: An AC500 V3 PLC with the desired target application is available as reference to create an online backup as input for the multi download tool (tbf backup file).
- For firmware download: The desired firmware must be provided as memory card image as input to the multi download tool.

It is recommended to close all Automation Builder instances and projects besides the multi download tool to avoid conflicts and performance reductions.

Create reference data for download

- For application backup: Create an online backup of your desired AC500 V3 PLC target application via PLC device editor’s “Backup and Restore” tab as tbf (target backup file). For further details, please refer to the help section.
  - Chapter 6.4.1.21.2.8.6 “Tab ’Backup and Restore’” on page 2435
- For firmware download: Create a firmware memory card image of your target PLC application via context menu on the application node “Export Firmware (SD-card)...”.

Usage of the multi download tool

The multi download tool can be launched within the Automation Builder via “Tools ➤ Options ➤ Multi download tool”.

See also

- Chapter 6.4.1.21.2.8.6 “Tab ’Backup and Restore’” on page 2435
Selection

The first editor section offers the possibility to select a firmware memory card image and/or an application backup file which shall be downloaded to the PLCs. Depending on the selection a firmware download and/or application download is then executed when executing the [Download] button.

The PLCs to download to can be defined in several ways:

- Execute a scan via [Scan] button and the found connected PLCs will be listed in the table.
- Import a corresponding PLC addresses configuration as csv-file into the table via [Import list] button.
- Enter the IP addresses in the table manually or via copy and paste.

The PLCs to consider for download can be defined via the checkboxes in the first table column. A defined selection can be exported via the [Export list] button as csv-file for later reuse or external modification.

Device name, port, MAC address and serial number are shown as information only. The IP address itself is sufficient to identify the PLC.

Configuration settings

General settings for the multi download tool can be configured by clicking the [Setting] button or via “Tools ➔ Options ➔ Multi download tool”.
● “Network scan timeout”: Maximum time to wait for the network scan results (by default 10 seconds).
● “Blink timeout”: Maximum time to wait for the blink operation to execute (by default 10 seconds).
● “Number of parallel downloads”: How many PLC downloads are executed in parallel (by default 10).
● “Download timeout”: Depending on the network infrastructure the download might run into errors due to timeouts. The user will not be informed about these timeouts directly, but each timeout might result in errors. To avoid these timeouts the corresponding value can be adapted here in minutes (by default 5 minutes).

Specific settings like “Force download even when there are applications running on the PLC” and “Reboot PLC after download operation” can be defined directly in the lower part of the multi download tool editor.

Check

Double-check the selection by executing the [Blink] button which triggers a display blinking of the checked PLCs which are connected to the PC. The connection status itself can be updated via the [Check connection] button indicating it in the “Connected” column.

Download

The download of the defined firmware and/or application backup to the checked PLCs can be executed via the [Download] button.

If downloads to running PLCs shall be executed, the setting “Force download even when there are applications running on the PLC” must be enabled.

The PLC type of the application backup file/firmware memory card image is cross-checked with the PLC types of the checked PLCs before executing a download.

In case a firmware memory card image is selected for download process, first the firmware is download und updated. The status can be seen in the column “Firmware download”. The selected application backup file is downloaded afterwards. The corresponding status is shown in the column “Application download”.
If any error occurs, it is shown in the corresponding status column with additional information in the “Error message” column.

After successful download the PLCs are rebooted if the setting “Reboot PLC after download operation” is enabled.

The status of a download is shown as “Success”, “Failed” or “In progress” for the firmware/application and the PLC state is shown with “Stop” and “Run” modes.

A running download can be cancelled via the [Cancel Download] button which finishes the currently running downloads and stops further executions afterwards.

An overall summary of executed and ongoing downloads can be found in the status line below the table. The results of the download can be documented via “Export Results”.

6.6.5 Tool Calling Interface (TCI) implementation

Automation Builder supports the Tool Calling Interface (TCI) up to conformance class 3 to engineer 3rd party safety devices.

The TCI from PROFINET organization offers a standard interface to call 3rd party configuration tools to e.g., configure iParameters in functional safety applications, calculate \(F_{iPar\_CRC}\) values and write configurations via the PLC to the safety devices.

The corresponding vendor specific configuration tools must be installed manually on the same PC as the Automation Builder. As soon as a 3rd party safety device is added to the Automation Builder project and a matching configuration tool is found to be installed, corresponding context menus are offered on the device to call this tool via TCI (refer to screenshot below).

The offered functionality of those configuration tools strongly varies on the device manufacturer. In the following the functionalities and workflows are exemplarily shown with two tools.

**TR TCI Device Tool**

1. Install the “TR TCI Device Tool” on the same PC as the Automation Builder.
2. Install the required TR GSDML-files in the Automation Builder device repository.
3. Create the desired devices configuration in the Automation Builder device tree.
4. Define the required iParameter of the TR safety device in the Automation Builder.
5. Open the “TR TCI Device Tool” via context menu on the TR safety device.
6. Calculate the \(F_{iPar\_CRC}\) in the “TR TCI Device Tool” and paste the value into the corresponding field in the Automation Builder editor.
In case an online connection is available you can also display the F-Destination-Address which can be set via rotary switches depending on the used hardware device and read/write maintenance data.

To enable an online connection, you must be online in Automation Builder, PLC needs to be in RUN and PROFINET must be running.

1. Install the Siemens S7-Failsafe Configuration Tool on the same PC as the Automation Builder.
2. Install the required Siemens GSDML-files in the Automation Builder device repository.
3. Create the desired devices configuration in the Automation Builder device tree.
4. Change “F_Dest_Add” or “F_Source_Add” on the Siemens safety device in the Automation Builder project.
5. Set “F_Dest_Add” and “F_Source_Add” (if needed in offline mode).
6. Go online, PLC needs to be in RUN and PROFINET must be running.
7. Call the Siemens device tool and choose your preferred way of identification (LED blinking or serial number).

8. Select the check box at the module where the F-destination-address should be set.

9. Press the [Identification] button.

10. Press the [Assign PROFIsafe-address] button after you confirmed that either the correct module is blinking or the displayed serial numbers is matching.

The device tool has a build in timeout with only a view seconds. After that time the device tool cannot communicate with the slave anymore. In this case close the device tool and reopen it again.

6.6.6 Drive composer pro integration

Drive Composer Pro is a start-up and maintenance tool for ABB's common architecture drives. The tool is used to view and set drive parameters, and to monitor and tune process performance.

Drive Composer Pro provides:

- Setting parameters,
- taking local control of the drive from the PC,
- event logger handling
- control diagrams,
- fast monitoring,
- working with multiple drives on the PC tool network,
- macro script editing for parameters and much more.

1. Add “Drive Composer Pro” object into the tree via add object dialog.

2. Open the “Drive Composer Pro” with double-click on the object.

In the following section important functions are described.
1. Import of FSO backup files (*.dcsafety) and Drive Parameters backup files (*.dcparamsbak) into Automation Builder project via the Drive Composer Pro object in the device tree.

2. View of integrated FSO backup files and Drive Parameters backup files in Automation Builder project - refer to figure below.

Drive Composer Pro can't be launched directly with integrated “FSO backup files” but they have to be loaded manually via context menu on the drive in Drive Composer Pro → “Safety Settings”.
1. Select the FSO and Drive Parameters backup files.
2. Export the selected file by clicking [Export].
   - Select the desired storage path.
Remove of backup files
1. Select the FSO and Drive Parameter backup files from Automation Builder project.
2. Remove the selected files by clicking [Remove].
1. Open the “Crane_follower12.dcpamrbak” with double-click.

2. The “Drive Composer Pro” starts automatically.

3. Saved changes in the standard drive parameter backup file are automatically updated in the Automation Builder project.

6.6.7 Professional Version Control

6.6.7.1 SVN integration in CODESYS

Professional Version Control allows for the development of CODESYS projects under version control by Apache™ Subversion®. Professional Version Control provides an SVN client integrated in CODESYS. The objects of your project are versioned in a central SVN repository.

As a rule, the SVN repository should be created in a server configuration and located on a server. For testing purposes, you can create a local SVN repository where you can access via file://.

Professional Version Control requires a valid license and can be installed using the Automation Builder Installer or the Automation Builder Installation Manager.
6.6.7.2 Getting Started

The following steps are required in order to develop your CODESYS project with Professional Version Control with version control by Apache™ Subversion®:

1. Install the Professional Version Control package in CODESYS.
2. Install an SVN server.
3. Create an SVN repository.
4. Open your CODESYS project in CODESYS.
5. Import the CODESYS project into the SVN project archive. ⇒ The CODESYS project is saved in the SVN repository.
6. To edit and further develop the project with SVN version control, the project is edited in CODESYS and then committed to the SVN repository.

As of version 4.4.0.0, in the case of storage profile inconsistencies between the working copy and the project in the SVN repository, corresponding instructions will guide you further. Under certain circumstances, commit actions at the object level are then no longer possible.

See also
- Chapter 6.6.7.4 “Using an SVN Repository” on page 4316
- Chapter 6.6.7.5 “Using Working Copies” on page 4318

6.6.7.3 Version control

What is version control? Apache™ Subversion® (SVN) is a tool for version and revision management of current and previous versions of files, such as source code, websites, and documentation. Apache™ Subversion® is a registered trademark of the Apache Software Foundation.

Revision management (also known as version control, version management, and source code management) is the management of changes to documents, programs, and other information that is stored as computer files. Version control is employed frequently in software development when a team of employees works on the same files.

Tasks
- Tracking of changes in revisions: At any time, you can show who made which changes at which time.
- Restoring of old revisions of individual files: At any time, you can reverse accidental changes to files.
- Archiving of special revisions of a project: At any time, you can revert to older versions.
- Coordination of shared access of developers to data
- Development of a project at the same time in multiple branches

Script Engine
SVN Add-on API

Professional Version Control provides a scripting-interface for SVN.

6.6.7.4 Using an SVN Repository

An SVN repository usually saves information as a file system tree, a hierarchy of files, and directories. Any number of clients connects to the SVN repository and reads or writes changes to the files in revisions.
Creating an SVN repository

NOTICE!
Consult with your IT specialists for more information, for example how to create an SVN repository. For production purposes, we recommend a strictly dedicated administrative SVN server.

We recommend that you create the suggested default directory structure in the SVN repository.

See also

Creating an SVN repository for testing purposes

NOTICE!
Use the file:// access method for testing purposes only.

You can reach SVN repositories that were created in format 1.8 or 1.9 via the file:// protocol.

For testing purposes, you can create a local SVN repository without installing your own server. The SVN repository is accessed via file:// and provides the same functionality as a server.

Requirement: The SVN client TortoiseSVN 1.9 is installed on the development system.

1. Create a new, empty folder on your local file system. The test repository will be created there.
   - Example: D:\SVN repository
2. Click “TortoiseSVN ➔ Create repository here”.
   - The dialog “Create repository” opens.
3. Click “Create directory tree”.
   - The SVN repository is created.

See also
- Documentation TortoiseSVN [Documentation TortoiseSVN](#)

Creating a test repository with TortoiseSVN

Accessing the SVN repository

<table>
<thead>
<tr>
<th>Table 772: SVN repository URLs</th>
</tr>
</thead>
<tbody>
<tr>
<td>file:///</td>
</tr>
<tr>
<td>http://</td>
</tr>
<tr>
<td>https://</td>
</tr>
<tr>
<td>svn://</td>
</tr>
<tr>
<td>svn+ssh://</td>
</tr>
</tbody>
</table>

2024/01/05 3ADR010583, 1, en_US 4317
Import the project into the SVN repository.

1. Open the CODESYS project that you want to save in the SVN repository.
   - Example: A.project is open.
2. Click “Project ➔ SVN ➔ Import project to SVN”.
   - The “Browse SVN repository” dialog opens.
3. Select the directory file:///D:/SVN repository/trunk in the directory tree.
4. Select the command.
   - The “Create remote directory” dialog opens.
5. Specify the URL for the new directory.
   - Note: Because the new directory should contain the CODESYS project, specify the project name with extension here.
   - file:///D:/SVN%20repository/trunk/A.project
6. Click “OK” to close the dialog.
7. Select the new project and click “OK” to exit the “Browse SVN repository” dialog.
   - The “Import Project to SVN” dialog opens. The directory file:///D:/SVN repository/trunk/A.project is specified in “URL of SVN repository”.

See also
- Chapter 6.6.7.6.1 “Overlay Icons” on page 4319

6.6.7.5 Using Working Copies

You can copy CODESYS projects to your development system that are saved in the SVN repository.

1. Open CODESYS.
2. Click “Project ➔ SVN ➔ Checkout”.
   - The “Checkout” dialog opens.
3. Specify the URL of the SVN repository and select a project in the SVN repository tree.
   - A CODESYS project is automatically identified by its file extension (.project, _project, .library or _library) as a “project” or “library project” at checkout.
4. In “Checkout to”, specify the name and location of the working copy on your development system.
5. Click “OK” to close the dialog.
   - The project opens in CODESYS. In the object tree of the project, the SVN link is shown with overlaid icons. Now the project is saved as a working copy on your development system.

See also
- Chapter 6.6.7.6.1 “Overlay Icons” on page 4319
Update the working copy before you start editing, especially if the project is revised by a team. This is how you avoid conflicts.

1. Open the working copy.
2. Click “Project ➔ SVN ➔ Update project” (symbol: 
   ➔ You working copy is current.
3. Revise your project.
4. Click “Project ➔ SVN ➔ Edit SVN working copy”.
   ➔ The dialog opens. There you can browse your changes.
5. Close the dialog.
6. If necessary, you can click “SVN ➔ Revert” in the context menu.
   ➔ The file is reverted back to the base revision and your changes are discarded.
7. If necessary, you can click “Compare” in the context menu of an edited object.
   ➔ The compare dialog opens. You can resolve any conflicts here.
8. Close the compare dialog.
9. Click “Project ➔ SVN ➔ Commit project” (symbol: 
   ➔ The “Commit” dialog opens.
   ➔ Your changes are saved in the SVN repository as a revision with a revision number.

See also
- ☝ Chapter 6.6.7.6.2.2 “Command ‘SVN Repository Browser’” on page 4322

For projects in version Professional Version Control V4.1.0.0 and later, the working directory (working copy) has a new format.

If you open a project that was created with V4.0.4.0 or earlier, then the project is updated automatically to the new format when it is opened.

If you open a project that was created with V4.0.4.0 or earlier and the project is based on an older SVN version of 1.7.x or earlier, then you are prompted whether or not CODESYS should update the format. If you decline the update, then the SVN link of the project is deactivated. You can still load and edit the project.

The update does not have an effect on saving to the SVN server. You can also checkout projects with earlier versions of the client. The new format affects only the local working directory.

See also

6.6.7.6 Reference, User Interface
6.6.7.6.1 Overlay Icons

Every object in CODESYS has a status value in the SVN repository. This status value is displayed in the object tree (in the “POUs”, “Devices”, or “Modules” views) for each object by overlay icons.
### Table 773: Overlay icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Plus Sign]</td>
<td>Object is planned to be added to the SVN repository.</td>
</tr>
<tr>
<td>![Triangle Down]</td>
<td>Object conflicted</td>
</tr>
<tr>
<td>![Cross]</td>
<td>Object deleted</td>
</tr>
<tr>
<td>![Square]</td>
<td>Object modified</td>
</tr>
<tr>
<td>![Square with Exclamation Mark]</td>
<td>Object with modification in the metadata</td>
</tr>
<tr>
<td>![Square with Question Mark]</td>
<td>Object with modifications in the memory format</td>
</tr>
<tr>
<td>![Green Circle]</td>
<td>Object normal</td>
</tr>
<tr>
<td>![Red Exclamation Mark]</td>
<td>Object write-protected (read-only)</td>
</tr>
<tr>
<td>![Red Lock]</td>
<td>Object locked</td>
</tr>
<tr>
<td>![Cross with Exclamation Mark]</td>
<td>Object with deleted subobjects</td>
</tr>
<tr>
<td>![Question Mark]</td>
<td>Object ignored on commit</td>
</tr>
<tr>
<td>![Exclamation Mark]</td>
<td>External object</td>
</tr>
<tr>
<td>![Exclamation Mark with Question Mark]</td>
<td>Ignored object</td>
</tr>
<tr>
<td>![Exclamation Mark with Square]</td>
<td>Unversioned object</td>
</tr>
<tr>
<td>![Square with Plus Sign]</td>
<td>Object with modified subobjects</td>
</tr>
<tr>
<td>![Tall T]</td>
<td>The object is not saved in the SVN repository. It will be created again when loaded from SVN.</td>
</tr>
<tr>
<td>![Exclamation Mark with SVN Version Info]</td>
<td><code>SVN_VERSION_INFO</code> temporarily unavailable, for example as with interface libraries</td>
</tr>
<tr>
<td>![Exclamation Mark with Question Mark]</td>
<td>The status of the object is not updated.</td>
</tr>
<tr>
<td>![Exclamation Mark with U]</td>
<td>The object was modified on the server (Update available).</td>
</tr>
<tr>
<td>![Exclamation Mark with Lock]</td>
<td>The object was locked on the server by another user (or in another working directory).</td>
</tr>
<tr>
<td>![Triangle Arrow]</td>
<td>Tree conflict by changes to the structure of the project</td>
</tr>
</tbody>
</table>

### 6.6.7.6.2 Commands

#### Availability of commands

Not all commands are available in the logged in state because some SVN commands of the project could be changed.
<table>
<thead>
<tr>
<th>Command</th>
<th>Not Logged In</th>
<th>Logged In</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 6.6.7.6.2.2 “Command ‘SVN Repository Browser’” on page 4322</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.3 “Command ‘Edit SVN working copy’” on page 4323</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.4 “Command ‘Import project to SVN’” on page 4326</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.5 “Command ‘Checkout’” on page 4327</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.6 “Command ‘Commit’, Command ‘Commit Project’” on page 4328</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.7 “Command ‘Compare’” on page 4331</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.8 “Command ‘Compare with HEAD revision’” on page 4331</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.9 “Command ‘Compare with revision’” on page 4331</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.10 “Command ‘Compare to remote project...’” on page 4332</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.11 “Command ‘Include externals to project’, Command ‘Include externals’” on page 4333</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.12 “Command ‘Ignore on commit’” on page 4335</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.13 “Command ‘SVN Info’” on page 4335</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.14 “Command ‘Show properties’” on page 4336</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.15 “Command ‘Get lock’” on page 4336</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.16 “Command ‘Steal locks’” on page 4337</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.17 “Command ‘Release lock’” on page 4337</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.18 “Command ‘Release locks recursively’” on page 4337</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.19 “Command ‘Show log’, Command ‘Show project log’” on page 4337</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.20 “Command ‘Revert’, Command ‘Revert project’” on page 4339</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.21 “Command ‘Revert to revision’, Command ‘Revert project to revision’” on page 4340</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.22 “Command ‘Update’, Command ‘Update project’” on page 4340</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.23 “Command ‘Update to revision’” on page 4341</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.24 “Command ‘Update only this’” on page 4342</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>
### Command 'SVN Repository Browser'

**Symbol:** 🛠

**Function:** This command opens the SVN repository browser. The contents of an SVN repository is shown in a tree structure here. You can search through the repository in the browser.

**Call:** Menu bar: “Project ➔ SVN”.

Depending on the selected object, the following commands are available in the context menu:

- “Show log”
- “Checkout”
- “Create folder”
- “Copy to”
- “Rename”
- “Delete”

Double-clicking the object with the right mouse button opens the log dialog.

---

<table>
<thead>
<tr>
<th>Command</th>
<th>Not Logged In</th>
<th>Logged In</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 6.6.7.6.2.25 “Command 'Disconnect project from SVN'” on page 4342</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.26 “Command 'Switch'” on page 4342</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.27 “Command 'Un-Ignore on commit'” on page 4343</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.28 “Command 'SVN Cleanup'” on page 4343</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.29 “Command 'Clear authentication data'” on page 4344</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.30 “Command 'Merge changes'” on page 4344</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.31 “Command 'Connect to existing project'” on page 4345</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.32 “Command 'Resolve conflict'” on page 4346</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.33 “Command 'Work in offline mode'” on page 4346</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.34 “Command 'Copy (Branch/Tag)'” on page 4347</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Chapter 6.6.7.6.2.35 “Command 'Pending Changes'” on page 4348</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>“URL”</td>
<td>URL in SVN repository</td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>-----------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td><a href="https://svnserver/repository/trunk/ControlABC.project">https://svnserver/repository/trunk/ControlABC.project</a></td>
<td></td>
</tr>
<tr>
<td><strong>Tip:</strong></td>
<td>As soon as a valid SVN repository is specified, you can browse and select a specific project by means of the adjacent button.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><img src="select_revision.png" alt="Select revision" /></th>
<th>Opens the dialog “Select revision”.</th>
</tr>
</thead>
<tbody>
<tr>
<td>The button is labeled with the currently selected revision:</td>
<td></td>
</tr>
<tr>
<td>● “HEAD”: Top revision (latest). Preset</td>
<td></td>
</tr>
<tr>
<td>● “3”: Revision number of the selected revision</td>
<td></td>
</tr>
<tr>
<td>● “12/23/2016 11:59:59 (UTC)”: Change date of the selected revision (UTC)</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The dialog provides the same options as the “Revision” group.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><img src="update_browser.png" alt="Update browser" /></th>
<th>Updates the browser view by rescanning the SVN repository.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="navigate_url.png" alt="Navigate URL" /></td>
<td>Navigates the URL address up by one folder.</td>
</tr>
</tbody>
</table>

**Left area**
Directory tree in the SVN repository. Project nodes are shown in bold.

**Right area**
List of objects of the selected directory

<table>
<thead>
<tr>
<th>“Close”</th>
<th>Closes the dialog</th>
</tr>
</thead>
</table>

See also
- *Chapter 6.6.7.6.3.3 “Dialog 'Select revision’” on page 4351*

**Command 'Edit SVN working copy'**

**Symbol:** ![Edit SVN working copy](edit_svn_wc.png)

**Function:** This command opens the dialog “Edit SVN working copy” and displays the working copy in a browser from the SVN view.

**Call:** Menu bar: “Project ➜ SVN”.

The functionality of the browser allows for:
- Access to and actions on objects that are not displayed in the “Devices” view.
- Actions on objects that can lead to exceptions in the “Devices” view.
- Editing of global objects that are modified, in conflict, or blocked.
### Dialog ‘Edit SVN working copy’

**Table 775: “Edit SVN working copy: <project name> - <project URL>”**

<table>
<thead>
<tr>
<th>“Path in the SVN repository”</th>
<th>Display of working copy from SVN view repository. The file and folder structure of the objects in the project are presented in a tree view here. As a result, the recursion depth of an object is visible.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Name of object”</td>
<td>File name of the object</td>
</tr>
<tr>
<td>“Node type”</td>
<td>The top node is the project root directory.</td>
</tr>
<tr>
<td>“Text status”</td>
<td>Object status:</td>
</tr>
<tr>
<td></td>
<td>● “modified”</td>
</tr>
<tr>
<td></td>
<td>● “added”</td>
</tr>
<tr>
<td></td>
<td>● “deleted”</td>
</tr>
<tr>
<td></td>
<td>● “non-versioned”</td>
</tr>
<tr>
<td></td>
<td>● “Conflicted”</td>
</tr>
<tr>
<td>“Property status”</td>
<td>Status in SVN repository:</td>
</tr>
<tr>
<td></td>
<td>● “modified”</td>
</tr>
<tr>
<td></td>
<td>● “added”</td>
</tr>
<tr>
<td></td>
<td>● “deleted”</td>
</tr>
<tr>
<td></td>
<td>● “Conflicted”</td>
</tr>
<tr>
<td></td>
<td>● “normal”</td>
</tr>
<tr>
<td>“Revision”</td>
<td>Revision number</td>
</tr>
<tr>
<td>“Conflict information”</td>
<td>File conflict, property conflict, or tree conflict</td>
</tr>
<tr>
<td>“Lock”</td>
<td>For locked objects, the user who applied the lock is displayed.</td>
</tr>
<tr>
<td>“Lock comment”</td>
<td>Lock message. Implicit, normal, or stolen lock.</td>
</tr>
<tr>
<td>“URL”</td>
<td>URL of the object</td>
</tr>
</tbody>
</table>

| “Select ➔ All”              | Selects all files.                                                                                    |
| “Select ➔ None”             | Deselects all files.                                                                                  |
| “Select ➔ Modified”         | Selects the modified files.                                                                           |
| “Select ➔ Conflicted”       | Selects the conflicted files.                                                                         |
| “Select ➔ Locked”           | Selects the locked files.                                                                             |

| “Update ➔ Project”          | Updates all files of the project.                                                                     |
| “Update ➔ Selected nodes”   | Updates only the selected files.                                                                      |
| “Update ➔ Selected nodes and children” | Updates the selected files and subordinate files.                                                        |

Updates the working copy. Changes made by others are added from the SVN repository to your working copy.
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>“Clear”</strong></td>
<td>Discards your changes to the working copy. Then the object corresponds to the revision in the repository.</td>
</tr>
<tr>
<td><strong>×</strong></td>
<td></td>
</tr>
<tr>
<td>“Delete → Selected nodes”</td>
<td>Deletes the selected objects from the working copy.</td>
</tr>
<tr>
<td><strong>✓</strong></td>
<td></td>
</tr>
<tr>
<td>“Commit”</td>
<td>Commits your changes to the SVN repository. Any locked objects will be unlocked.</td>
</tr>
<tr>
<td>“Commit → Project”</td>
<td>Commits all files in the project.</td>
</tr>
<tr>
<td>“Commit → Selected nodes”</td>
<td>Commits only the selected files.</td>
</tr>
<tr>
<td>“Commit → Selected nodes and children”</td>
<td>Commits the selected files and subordinate files.</td>
</tr>
<tr>
<td>** пара**</td>
<td>Commands for managing locks.</td>
</tr>
<tr>
<td>“Locks → Revalidate all”</td>
<td>Checks the validity of locks in the working copy. Any invalid locks will be unlocked.</td>
</tr>
<tr>
<td>“Locks → Release locks”</td>
<td>Releases the lock.</td>
</tr>
<tr>
<td>“Locks → Acquire locks”</td>
<td>Locks the object from editing by others.</td>
</tr>
<tr>
<td>“Locks → Steal locks”</td>
<td>Locks the file for you and removes the lock of another user. Tip: Avoid stealing a lock because the changes made by another user can be lost.</td>
</tr>
<tr>
<td><strong>▲</strong></td>
<td>Commands to resolve conflicts.</td>
</tr>
<tr>
<td>“Conflicts → Mark as resolved”</td>
<td>Indicates a displayed conflict in the SVN repository as marked and resolved. Note: Select the command if you edited and resolved the displayed conflict. Then you can commit changes again.</td>
</tr>
<tr>
<td>“Conflicts → Resolve using theirs”</td>
<td>Resolves the conflict: In the SVN repository, the changes are accepted that were committed by other users. Your changes are discarded.</td>
</tr>
<tr>
<td>“Conflicts → Resolve using mine”</td>
<td>Resolves the conflict: In the SVN repository, the changes to your working copy are accepted and the changes by other users are discarded.</td>
</tr>
<tr>
<td><strong>Show log</strong></td>
<td>Opens the dialog “Log - Application”. The history of the selected node is shown here. The previous revisions are displayed with the respective actions.</td>
</tr>
<tr>
<td><strong>Change location</strong></td>
<td>Changes the storage location of the selected object within the working copy. Example: You can resolve a tree conflict by saving the local object to another location. Then update the parent object to apply it to the locked children.</td>
</tr>
<tr>
<td><strong>Update</strong></td>
<td>Updates the browser view by rescanning the working copy.</td>
</tr>
<tr>
<td><strong>Cleanup</strong></td>
<td>Executes an SVN cleanup operation on the working copy.</td>
</tr>
</tbody>
</table>

See also:
- Chapter 6.6.7.6.2.22 “Command 'Update', Command 'Update project'” on page 4340
- Chapter 6.6.7.6.2.20 “Command 'Revert', Command 'Revert project’” on page 4339
- Chapter 6.6.7.6.2.6 “Command 'Commit', Command 'Commit Project’” on page 4328
- Chapter 6.6.7.6.2.32 “Command 'Resolve conflict’” on page 4346
- Chapter 6.6.7.6.2.15 “Command 'Get lock’” on page 4336
- Chapter 6.6.7.6.2.17 “Command 'Release lock’” on page 4337
Command 'Import project to SVN'

Symbol: 

Function: This command opens the “Import Project to SVN” dialog for importing a CODESYS project to the SVN repository.

Call: Menu bar: “Project ➔ SVN”.

Requirement

- You have access to an SVN repository and you know its URL.
- You have read access to the entire project.

NOTICE!

Projects are always saved unencrypted on the server. Therefore, take appropriate security measures (for example, respective access rights to the SVN server) for protecting your projects.

See also

- User and access management in Protect and save project

Dialog 'Import Project to SVN'

<table>
<thead>
<tr>
<th>“URL of SVN repository”</th>
<th>URL of the SVN repository with the new project folder where the files are imported</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example</td>
<td><a href="https://svnservserver/repository/trunk/ControlABC.project">https://svnservserver/repository/trunk/ControlABC.project</a></td>
</tr>
<tr>
<td>Hint</td>
<td>When importing libraries, specify the extension .library or _library. For projects, specify the extension .project or _project. Then the project type is recognized automatically at checkout and the options are set accordingly in the “Checkout” dialog.</td>
</tr>
</tbody>
</table>

[button] Opens the “SVN Repository Browser” dialog. The previous project structure is displayed and you can edit them here.

<table>
<thead>
<tr>
<th>“Import message”</th>
<th>Text for use as log message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example</td>
<td>Control project for customer A</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Recent messages”</th>
<th>Opens the “Recent Messages” dialog. There you can reuse the last log messages.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>“Generate SVN_VERSION_INFO”</th>
<th>☐: The object SVN_VERSION_INFO is not created automatically during the import operation. Therefore, the project does not get any global constants or variables for the project metadata.</th>
</tr>
</thead>
</table>

| “OK” | Creates the current project in the SVN repository and imports the project objects. The local project in CODESYS Development System is linked to the SVN repository. Overlay icons show this in the object trees. |

See also

- Chapter 6.6.7.6.2.5 “Command ‘Checkout’” on page 4327
- Chapter 6.6.7.6.2.2 “Command ‘SVN Repository Browser’” on page 4322
- Chapter 6.6.7.6.1 “Overlay Icons” on page 4319
Command 'Checkout'

Symbol: ![Checkout symbol]

**Function:** This command opens the “Checkout” dialog. Here you can checkout a project stored in the SVN repository as a working copy.

**Call:** Menu bar: “Project ➜ SVN”.

Dialog 'Checkout'

**Table 777: “URL of SVN repository”**

<table>
<thead>
<tr>
<th>URL of the project in the SVN repository</th>
<th>Example: <a href="https://svnserver/repository/trunk/ControlABC.project">https://svnserver/repository/trunk/ControlABC.project</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>Tip: As soon as a valid SVN repository is specified, you can click the adjacent button or use the options to browse in “Revision” and select a specific project.</td>
<td></td>
</tr>
</tbody>
</table>

| Opens the dialog “Select revision”. |
| The button is labeled with the currently selected revision: |
| ● “HEAD”: Newest revision (top revision). Default |
| ● “15”: Revision number of the selected revision |
| ● “12/23/2016 11:59:59 (UTC)”: Change date of the selected revision (UTC) |
| Note: The dialog provides the same options as the “Revision” group. |

| Opens the “SVN repository browser” dialog Here you can browse the SVN repository. |

**Table 778: “Checkout to”**

| “Name” | Name of the working copy | Example: ControlABC.project |
| “Location” | Storage location of the working copy | Example: /D:/svn/repository/trunk/ControlABC.project |

**Table 779: “Checkout as”**

| “Project” | The project is saved as a CODESYS project "<project name>.project". |
| “Library” | The project is saved as a CODESYS library file "<project name>.library". |
| “Auto-detect” | CODESYS attempts to recognize the project type by means of the extension. The current implementation checks whether the URL of the project ends with "library" or ".library". In this case, the project is recognized as a library or a project. |

**Table 780: “Checkout options”**

| "Omit externals": | ☑: Externals (external objects) are not copied to the working directory. |

**Table 781: “Revision”**

For a description, refer to the section “Dialog ‘Select revision’”.

Note: The group provides the same options as the “Revision” dialog.
Checks out the project from the SVN repository, saves it locally to the specified location, and opens it in CODESYS as the primary project.

If files were encrypted when imported to the SVN repository, or if they have been committed, then note the following:

When committing to the SVN repository, the information about an encrypted project file is included. However, the type of encryption is not included (password, Wibu security key, X509 certificate). Therefore, it may be necessary to encrypt the working copy again in the project settings. In this case, a dialog opens when exiting the command to notify you of this. Then you are able to switch directly to the project settings.

See also
- Chapter 6.6.7.6.3.3 “Dialog ’Select revision’” on page 4351
- Chapter 6.6.7.6.2.2 “Command ’SVN Repository Browser’” on page 4322
- "Version control with Subversion", Section "Revision identifier"

Command ’Commit’, Command ’Commit Project’

Symbol: ✡

Function: The command commits changes that were made in CODESYS to the SVN repository. The “Commit” dialog opens for this purpose.

Call:
- Context menu: “SVN” to commit exactly this object
- “Project ➔ SVN ➔ Commit Project” to commit all changes in the project at the same time

Requirement: At least one object was modified. An object whose contents have been modified is overlaid in the object tree with the ✡ ✡ or ✡ symbol.

When you execute the command, the lock on the objects to be committed is lifted automatically.

See also
- Chapter 6.6.7.6.1 “Overlay Icons” on page 4319

Dialog ’Commit’

Table 782: “Commit to: <URL project/object>”

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL in SVN repository</td>
<td>Example: file:///D:/SVN repository/trunk/ControlABC.project</td>
</tr>
<tr>
<td>“Log message”</td>
<td>Type in a log message that comments your change. Example: Bug fix error 123</td>
</tr>
<tr>
<td>“Recent Messages”</td>
<td>Opens the “Recent Messages” dialog for displaying the last log messages. You can click a log message to accept it.</td>
</tr>
</tbody>
</table>
Table 783: “Changes made (double-click on object for compare, right-click on object for more operations)”

<table>
<thead>
<tr>
<th>Object</th>
<th>Blue: Modified</th>
<th>Green: Added</th>
<th>Dark red: Deleted</th>
<th>Red: Conflicted</th>
<th>Black: Non-versioned (not in SVN repository)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Note: These objects are displayed when the “Show non-versioned objects” option is selected.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Gray: Excluded from commit Note: This is the case when the “Ignore during commit” option is selected.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The list also contains objects which have not been modified but have a lock. This helps to prevent locking from going unnoticed in the repository.

Double-click an object in order to open the compare dialog. The revision of the working copy is compared with the base revision. The compare dialog also opens when you click “Compare” in the context menu.

Right-click an object in order to open the context menu.

Note: When the “Commit Project” command has been executed, a list of objects is shown here. When the “Commit” command is applied to a specific object, only this object is shown (if modified or locked) and its modified or locked child objects.

“Object”: The object is selected for the commit.
Example: ![Device](Pl Logic/Application) PLC_PRG

“Text status”: Object status in CODESYS
- “Modified”
- “Added”
- “Deleted”
- “Non-versioned”
- “Conflicted”

“Property status”: Status of the metadata of the object
- “Modified”
- “Added”
- “Deleted”
- “Conflicted”
- “Normal”

“Lock”: If the object has a lock, then it is shown here the user who applied the lock.
Example: b.mayer

“Description”: Display of the log message

“Select/Deselect All”: All objects in the list are selected.

“Keep Locks”: Your locked object remains in locked after the commit.

“Keep Change Lists”: The change list also remains after the commit.
- The change list is not deleted after the commit.

“Update After Commit (recommended)”: The object/project is updated after the commit. Select this check box to ensure that the project is up-to-date and to prevent conflicts resulting from mixed revisions of working copies.
Button “Update Project” Updates the project
Hint: Prevent conflicts by committing a previously updated project/object.

“OK” Checks the working copy first. Starts the commit of changes when the working copy is current.
Checks the working copy first. Starts the commit of changes when the working copy is current.
Keyboard shortcut [Ctrl]+[Enter] Opens a dialog when the working copy is outdated. You can then select from the following:

- “Abort the commit, I want to investigate the issue.”
- “Yes, I want to update this project now.”
- “Continue with the commit, I know what I do.”

Note: The history of the commit is displayed in the “Messages” view.
The messages are highlighted in color.
- Blue: Commit a change
- Green: Add an object
- Dark red: Delete/replace an object
- Black: Other messages (summary)

Handling external objects

If the external object is in the same SVN repository, then changes in this external object are listed in the commit dialog and committed together with the internal project. If an external object is in another SVN repository, then you are notified about changes in the external project and you have to commit these separately.

An external object has the “externals” property.

Context menu (right-click on object)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Compare”</td>
<td>Opens the compare dialog to compare the working copy with the top-level revision.</td>
</tr>
<tr>
<td>“Compare with HEAD version”</td>
<td>Opens the compare dialog to compare the working copy with the HEAD revision.</td>
</tr>
<tr>
<td>“Compare with Revision”</td>
<td>The list entries are highlighted in color according to the object status:</td>
</tr>
<tr>
<td></td>
<td>● Blue: Modified</td>
</tr>
<tr>
<td></td>
<td>● Green: Added</td>
</tr>
<tr>
<td></td>
<td>● Dark red: Deleted</td>
</tr>
<tr>
<td></td>
<td>● Red: Conflicted</td>
</tr>
<tr>
<td></td>
<td>● Black: Non-versioned (not in SVN repository)</td>
</tr>
<tr>
<td></td>
<td>Note: These objects are displayed when the “Show non-versioned objects” option is selected.</td>
</tr>
<tr>
<td></td>
<td>● Gray: Excluded from commit</td>
</tr>
<tr>
<td></td>
<td>Note: This is the case when the “Ignore during commit” option is selected for the object.</td>
</tr>
<tr>
<td>“Clear”</td>
<td>Discards your changes to the working copy. Then the object corresponds to the revision in the SVN repository.</td>
</tr>
<tr>
<td>“Show log”</td>
<td>Shows the version history of the selected object.</td>
</tr>
</tbody>
</table>
“Properties” Opens the “SVN Properties” dialog. The properties are displayed there and you can edit them.

Move to change list Note: This command has not been implemented yet.

Command 'Compare'

Symbol: 

**Function:** This command opens a tab that shows the result of the comparison of your working copy and the BASE revision. The base revision is the top-level revision in the SVN repository.

**Call:**
- Menu bar: “Project ➔ SVN”.
- Context menu

**Requirement:** The object is versioned, it was modified locally, and it does not contain any conflicts.

Multiple tabs can be open at the same time with the comparison of different objects.

**Comparison by object type**
The comparison dialog makes use of the functionality of the CODESYS command “Project ➔ Compare”. In this way, objects are compared according to their object type.

See also
- Chapter 6.4.1.5 “Comparing projects” on page 1817

Command 'Compare with HEAD revision'

Symbol: 

**Function:** This command opens a tab that shows the result of the comparison of your working copy and the HEAD revision. The HEAD revision is the top-level revision in the branch. You can revert specific changes that were committed to the HEAD revision.

**Call:** Context menu: “SVN”

**Requirement:** The object is versioned and not conflicted.

Multiple tabs can be open at the same time with the comparison of different objects.

**Comparison by object type**
The comparison dialog makes use of the functionality of the CODESYS command “Project ➔ Compare”. In this way, objects are compared according to their object type.

See also
- Chapter 6.4.1.21.3.5.21 “Command 'Compare'” on page 2607

Command 'Compare with revision'

Symbol: 

See also

2024/01/05 3ADR010583, 1, en_US 4331
Function: This command opens the “Project log” dialog or “Log - <object>” where the version history is displayed from the project or an object of the CODESYS project. Here you can select a revision. A tab opens and shows the result of the comparison of your working copy and the revision.

Call: Context menu: “SVN”

Requirement: The object is versioned and not conflicted.

Multiple tabs can be open at the same time with the comparison of different objects.

**Comparison by object type**
The comparison dialog makes use of the functionality of the CODESYS command “Project ➔ Compare”. In this way, objects are compared according to their object type.

See also
- ¶ “Tab 'Project log', Dialog 'Log - <object>'' on page 4338
- ¶ Chapter 6.4.1.21.3.5.21 “Command 'Compare'” on page 2607

Command 'Compare to remote project...'

Symbol: ☑

Function: This command opens the dialog “Select Remote Project for Comparison”.

Call: Menu bar: “Project ➔ SVN”.

See also
- ¶ Chapter 6.4.1.21.3.5.21 “Command 'Compare'” on page 2607

**Dialog 'Select Remote Project for Comparison'**

**Table 784: “URL of SVN repository”**

<table>
<thead>
<tr>
<th>URL</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="http://userserver/repository/trunk/ControlDEF.project">http://userserver/repository/trunk/ControlDEF.project</a></td>
<td>URL of the project in the SVN repository that is compared.</td>
</tr>
<tr>
<td>file:///D:/SVN repository/trunk/ControlDEF.project</td>
<td>Example: file:///D:/SVN repository/trunk/ControlDEF.project</td>
</tr>
</tbody>
</table>

As soon as a valid SVN repository is specified, you can click the adjacent button or use the options to browse in “Revision” and select a project.

The label on the button corresponds to the selected revision:
- “HEAD”: Newest revision (top revision)
- “15”: Revision number of the selected revision
- “12/23/2016 11:59:59 (UTC)”: Change date of the selected revision (UTC)

After clicking the button, the dialog “Select revision” opens.

Note: The dialog provides the same options as the “Revision” group.

Opens the dialog “Browse SVN repository” to search the SVN repository.

**Table 785: “Checkout options”**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Omit externals”:</td>
<td>☑: External objects are not compared.</td>
</tr>
</tbody>
</table>
Table 786: “Revision”

Options for selecting a specific revision

Note: the current valid selection is also displayed next to the SVN repository URL.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“HEAD”</td>
<td>🌟 The HEAD revision is selected. This is the latest revision (top revision) within a branch.</td>
</tr>
<tr>
<td>“Revision”</td>
<td>🌟 A specific revision is selected by the revision number. Example: 3</td>
</tr>
<tr>
<td>“Date”</td>
<td>🌟 The specific revision is selected by the modification date. Example: 12/23/2016 11:59:59</td>
</tr>
<tr>
<td>“Use UTC Time”</td>
<td>✔️ Modification date in universal time.</td>
</tr>
</tbody>
</table>

Table 787: “compare options”

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Ignore Whitespace”</td>
<td>✔️ No comparison of whitespace characters. Semantically relevant whitespaces, such as in strings, are compared anyway.</td>
</tr>
<tr>
<td>“Ignore Comments”</td>
<td>✔️ No comparison of comments.</td>
</tr>
<tr>
<td>“Ignore Properties”</td>
<td>✔️ No comparison of properties. Folders, the property “Exclude from build”, and POU images are not compared. See: Dialog 'Properties'</td>
</tr>
</tbody>
</table>

“OK” | Compares the SVN project with the working copy. See also

- ☰ Chapter 6.6.7.6.2.2 “Command ‘SVN Repository Browser’” on page 4322
- ☰ Chapter 6.4.1.21.4.11 “Dialog ‘Properties’” on page 2753

Command 'Include externals to project’, Command 'Include externals'

Symbol: ➔

Function: These commands open the dialog “Include externals”.

Call:

- Menu bar: “Project ➔ SVN”.
- Context menu: “SVN”

Requirement: An object is selected in the object tree. The external objects are linked below that. If you have selected nothing or the project root directory, then the command “Include externals to project” is available. If you have selected an object, then the command “Include externals” is available.

The same external objects cannot be linked multiple times at different locations in the same project. This leads to problems in CODESYS because of conflicts with the internal identification of the object.

Dialog 'Include externals'
Table 788: “URL of SVN repository”

<table>
<thead>
<tr>
<th>Table 788: “URL of SVN repository”</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>URL of the external object that is linked.</strong> The object to be linked is versioned and can have sub-objects.</td>
</tr>
<tr>
<td><strong>External objects are located at another location in the SVN repository than the project. It can even be in another SVN repository.</strong></td>
</tr>
<tr>
<td><strong>Example:</strong> file:///D:/SVN repo A/trunk/DSTest.project/GlobalTextList</td>
</tr>
<tr>
<td><strong>Note:</strong> The objects that should be linked below the selected object must have a matching object type. For example, only a task can be linked below the “Task configuration” object.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><img src="image1.jpg" alt="Image" /></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Opens the dialog “Select revision”.</strong> Here you can select a revision.</td>
</tr>
<tr>
<td><strong>The button is labeled with the currently selected revision:</strong></td>
</tr>
<tr>
<td>- “HEAD”: Newest revision (top revision). Default</td>
</tr>
<tr>
<td>- “15”: Revision number of the selected revision</td>
</tr>
<tr>
<td>- “12/23/2016 11:59:59 (UTC)”: Change date of the selected revision (UTC)</td>
</tr>
<tr>
<td><strong>Note:</strong> The dialog provides the same options as the “Revision” group.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><img src="image2.jpg" alt="Image" /></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Opens the “SVN repository browser” dialog.</strong> Here you can browse the SVN repository.</td>
</tr>
</tbody>
</table>

Table 789: “Revision”

<table>
<thead>
<tr>
<th>Table 789: “Revision”</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Options for selecting a revision</strong></td>
</tr>
<tr>
<td><strong>Note:</strong> The current valid selection is also displayed in the buttons next to the SVN repository URL.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“HEAD”</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3.jpg" alt="Image" /></td>
</tr>
<tr>
<td><strong>Latest revision (top revision) selected in a branch.</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Revision”</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image4.jpg" alt="Image" /></td>
</tr>
<tr>
<td><strong>A specific revision by the revision number.</strong></td>
</tr>
<tr>
<td><strong>Example:</strong> 3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Date”</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5.jpg" alt="Image" /></td>
</tr>
<tr>
<td><strong>A specific revision by the modification date.</strong></td>
</tr>
<tr>
<td><strong>Example:</strong> 12/23/2016 11:59:59</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Use UTC Time”</strong>:</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image6.jpg" alt="Image" /></td>
</tr>
<tr>
<td><strong>Modification date in universal time.</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“OK”</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image7.jpg" alt="Image" /></td>
</tr>
<tr>
<td><strong>Adds the external object and its sub-objects with the property svn:externals to your project (below the selected object). The working copy is updated and the external object is overlaid with the symbol.</strong></td>
</tr>
<tr>
<td><strong>Example:</strong> <img src="image8.jpg" alt="Source" /> (external device <strong>Source</strong>)</td>
</tr>
<tr>
<td><strong>Note:</strong> If the linking fails (for example when adding a device below a task configuration), then the complete operation fails and reverts back.</td>
</tr>
<tr>
<td><strong>Note:</strong> Renaming or moving individual external objects is permitted only within an external tree, whereby it is not permitted to move the top object.</td>
</tr>
<tr>
<td><strong>To move a complete tree, you have to remove it and link it to another location.</strong></td>
</tr>
</tbody>
</table>
“... You should seriously consider using explicit revision numbers in all of your externals definitions. Doing so means that you get to decide when to pull down a different snapshot of external information, and exactly which snapshot to pull. Besides avoiding the surprise of getting changes to third-party repositories that you might not have any control over, using explicit revision numbers also means that as you backdate your working copy to a previous revision, your externals definitions will also revert to the way they looked in that previous revision, which in turn means that the external working copies will be updated to match the way they looked back when your repository was at that previous revision. For software projects, this could be the difference between a successful and a failed build of an older snapshot of your complex codebase. ...”

This is cited from:


Command 'Ignore on commit'

Function: This command identifies an object and adds it to the "ignore-on-commit" list. Then it is deactivated in the commit dialog by default.

Call: Menu bar: “SVN”

Requirement: At least one object is available that is not in the change list ignore-on-commit.

Objects of the "ignore-on-commit" list are overlaid with the symbol in the object tree. By default, they are not selected in the commit dialog, unless a dependency of a selected object requires it. These objects can always be selected manually in the dialog.

See also

● § Chapter 6.6.7.6.27 “Command 'Un-Ignore on commit'” on page 4343

Command 'SVN Info'

Function: This command provides information about the selected object in the SVN repository. The "SVN Information" dialog opens for this purpose.

Call: Context menu: “SVN”

Requirement: A versioned object (with SVN link) is selected in the object tree.

Dialog 'SVN Information'

Example

Name: Device_4\Plc Logic\Application\PLC_PRG
URL: file:///D:/SVN repository/trunk/ControlABC.project/Device/Plc Logic/Application/PLC_PRG/svnobj
Repository Root: file:///D:/SVN repository/
Repository UUID: 185325d7-73eb-e54b-ab50-206aa23c8b42
Revision: 29
Node Kind: File
Schedule: Normal
Last Changed Author: a.mayer
Last Changed Rev: 8
Last Changed Date: 17.01.2017 12:33:51
Text Last Updated: 17.01.2017 12:33:51
Checksum: d5fb4d91ebaea06f26bcb15942724d57932b6a3
Command 'Show properties'

Symbol: 

**Function:** This command opens the "SVN Properties" dialog. Here you can edit the properties of the versioned object.

**Call:** Context menu: “SVN”

**Requirement:** A versioned, unlocked object is selected.

**Dialog 'SVN Properties'**

| Table 790: “properties for: <object name>” |
|-----------------|------------------|
| **Name**        | Name of the property |
| Example: myprop:customer-number |
| Note: SVN has some reserved properties. Example: svn:mime-type |
| **Value**       | Example: 1234 |
| Double-click in the field to edit the value. |
| **Add**         | Opens a dialog to define another property with its value. |
| **Remove**      | Deletes the selected property. |
| **Show binary properties** | ☑: The binary properties are also displayed. |
| **Reset**       | Resets the changes displayed in green. |
| **OK**          | Accepts the changes. |

See also

- [http://svnbook.red-bean.com](http://svnbook.red-bean.com)

Command 'Get lock'

Symbol: 

**Function:** This command locks the object explicitly for you. The “Lock Message” dialog opens for this purpose.

**Call:** Context menu: “SVN”

**Requirement:** The versioned object is not locked (not overlaid with the symbol).

**Dialog 'Lock Message'**

<table>
<thead>
<tr>
<th><strong>Enter the reason why you lock the object:</strong></th>
<th>Lock message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: Locked for processing task 123</td>
<td></td>
</tr>
<tr>
<td><strong>Recent Message</strong></td>
<td>Shows message in the dialog that have already been used. There you select one in order to use the lock message.</td>
</tr>
<tr>
<td><strong>Recursive</strong></td>
<td>☑: The object is locked with all subordinate child objects.</td>
</tr>
<tr>
<td><strong>OK</strong></td>
<td>Locks the object</td>
</tr>
<tr>
<td>When the lock is successful, the object (in the object tree) is overlaid with the symbol.</td>
<td></td>
</tr>
</tbody>
</table>
Command 'Steal locks'

Symbol: 

**Function:** This command steal the lock of the object. The “Lock Message” dialog opens for this purpose.

**Call:** Context menu: “SVN”

**Requirement:** The versioned object is locked by someone else (overlaid with the symbol).

---

**Dialog 'Lock Message'**

<table>
<thead>
<tr>
<th>&quot;Enter the reason why you lock the object:&quot;</th>
<th>Lock message</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Example:</strong> a.mayer had to steal the lock because the changes need to be implemented so urgently.</td>
<td></td>
</tr>
</tbody>
</table>

| "Recent Message" | Shows message in the dialog that have already been used. There you select one in order to use the lock message. |

| "Recursive" | Yes: The lock is stolen by the object and all subordinate child objects. |

| "OK" | Steals the lock. When the stolen lock is successful, the object (in the object tree) is overlaid with the symbol. |

---

Command 'Release lock'

Symbol: 

**Function:** This command releases the lock of an object.

**Call:** “Context menu → SVN”

**Requirement:** The object is locked.

---

Command 'Release locks recursively'

Symbol: 

**Function:** This command releases the lock of an object explicitly with all of its subordinate objects.

**Call:** “Context menu → SVN”

**Requirement:** The object is locked.

---

Command 'Show log', Command 'Show project log'

Symbol: 

**Function:** These commands open the tab “Project log” or “Log - <object>”. The version history of the project or an object of the CODESYS project is displayed in the tab.

**Call:**
- Menu bar: “Project → SVN”.
- “Context menu → SVN”

If you select nothing or the base node in the object tree, then the history of the entire project is displayed (“Show project log”). If you select one or more objects, then the history of these elements is displayed (“Show log”).

Multiple tabs can be open at the same time with the version history of different objects.
List of all revisions of the project or the selected objects in the information. The first 100 revisions are displayed by default. The “Next 100” and “All” buttons are provided for displaying more or all revisions.

Several commands are available in the context menu of each revision. These context menu commands are described below.

Display of the “Message” of the revision that is selected in the upper area.

List of actions that were performed on the objects of the project in the selected revision:

- “Hide unrelated changed paths”: All changes of this revision are hidden that do not have any relevance to the object.
- “Stop on copy/rename”: If the object was copied from another location in the SVN repository, then no more log messages are retrieved. This is especially beneficial when branches or tags are monitored and only changes within the branch are relevant.
- “Filter/Range” opens the “Filter” dialog
  - “All” All revisions are listed.
  - “Next 100” The next 100 revisions are listed.

The displayed revisions can be filtered by “Head”, “Revision”, or “Date”.

- The option fields for “Start revision” and “End revision” are editable.
- “Use UTC time”: Date display in universal time.

For more detailed information, refer to the description “Dialog ‘Select revision’”.

Display of revision logs that contain a special text in the “Message”.

Display of revision logs of the specified author.

Display of revision logs of the specified path.

Compares the selected revision of the object with the base working copy (without local changes).

Compares the selected revision of the object with the working copy.

Compares the selected revision of the object with the HEAD revision.

Compares the selected revision of the object with the previous revision.

Updates the object to the selected revision.

Note: Changes of the project by this command cannot be committed.

For VSS users: This is comparable to loading an older version without checkout. To revert a previous commit, the command “Revert to this revision” has to be used.
**Command 'Revert', Command 'Revert project'**

**Symbol:** 

**Function:** This command opens the "Revert" dialog. In the dialog, select the objects whose local changes should be reverted, and those that are reverted to the state of the base revision of the working copy.

**Call:**
- Menu bar: "Project ➔ SVN".
- "Context menu ➔ SVN"

If you select nothing or the main node in the device tree, then all modified objects are listed in this dialog ("Revert project"). If you selected one or more objects, then only the changes to this object are listed and recursively their sub-objects ("Revert").

**Dialog 'Revert'**

- **"Group externals"** [✔]: The external definitions are grouped by their external storage locations.
- **"Keep locks"** [✔]: The lock is retained for all files that are modified by the revert command.
- **"Select/deselect all"**

When external objects are deleted, Professional Version Control cannot restore this data in SVN offline mode. The user is prompted how to proceed:

- Switch back to SVN online mode and call the external objects.
- Connect now to the SVN server one time in order to complete the current operation, but afterwards switch back to SVN offline mode.
- Skip the retrieval of the external objects. They can be fetched later by updating the project.

See also
- Chapter 6.6.7.6.2.7 “Command ‘Compare’” on page 4331
- Chapter 6.6.7.6.2.8 “Command ‘Compare with HEAD revision’” on page 4331
- Chapter 6.6.7.6.2.9 “Command ‘Compare with revision’” on page 4331
- Chapter 6.6.7.6.2.2 “Command ‘SVN Repository Browser’” on page 4322
- Chapter 6.6.7.6.3.3 “Dialog ‘Select revision’” on page 4351
See also

- Chapter 6.6.7.6.2.21 “Command 'Revert to revision', Command 'Revert project to revision'” on page 4340

Command 'Revert to revision', Command 'Revert project to revision'

Symbol: ⚪

Function: This command opens the “Select revision” dialog. In this dialog, you select the revision to which the project or the selected objects revert.

Call:

- “Project ➔ SVN”
- “Context menu ➔ SVN”

If nothing or the base node is marked in the object tree, then the entire project is reverted to a specific revision (“Revert project to revision”). If one or more objects are selected, then these objects and their sub-objects are reverted (“Revert to revision”).

Dialog 'Select revision'

For a description of the dialog, refer to the section "Select revision".

See also

- Chapter 6.6.7.6.3.3 “Dialog 'Select revision'” on page 4351
- Chapter 6.6.7.6.2.20 “Command 'Revert', Command 'Revert project'” on page 4339
- Chapter 6.6.7.6.2.19 “Command 'Show log', Command 'Show project log'” on page 4337

Command 'Update', Command 'Update project'

Symbol: ✗

Function: This command commits changes in the SVN repository to the project. The update is performed with the HEAD revision.

Call:

- Menu bar: “Project ➔ SVN”.
- “Context menu ➔ SVN”

If nothing or the main node is selected, then the entire project is updated (“Update project”). If one or more objects are selected, then these objects and their sub-objects are updated (“Update SVN”).
The following cases are possible:

- **Projects** are added to the project that are present in the SVN repository, but not in the project. In this case, the message "Added <object>\" is issued to the message view.
- **Objects** that no longer exist in the SVN repository, but are present in the project locally (and not marked as "added"), are treated according to the Subversion standard procedure: If local changes are present, then the object remains in the project as unversioned. If there are no local changes, then the object is also deleted locally because the user can retrieve the object from an older version at any time. In this case, "Deleted object" is issued to the message view.
- **Versioned objects** that exist in both the SVN repository and the project are updated if they are different. Three cases to observe:
  - No local changes have been made since the last update: In this case, the local object is overwritten by the contents from the SVN repository. The message "Object updated" is issued to the message view.
  - Local changes have been made since the last update and the corresponding object type can be merged. When versions have been merged successfully, the message "Objects merged" is issued to the message view. If the command is not executed successfully, then the object is marked as "Conflicted object" in the object tree and the message "Conflicted object" is issued.
  - Local changes have been made since the last update and the corresponding object type cannot be merged. In this case, the object is marked as "Conflicted object" in the object tree and the message "Conflicted object" is issued.

If only some of the objects are updated, it may be that objects with the same name already exist. For example, this situation can come from moving objects to a folder.

For this conflict, you can react in the following ways:

- Do nothing and leave the conflict-causing objects as they are.
- Update (and remove) the conflicting objects in order to correct the conflict.
- Update the entire project in order to remove all conflicting objects and correct the conflict.

See also
- Chapter 6.6.7.6.2.23 “Command 'Update to revision'” on page 4341

**Command 'Update to revision'**

**Symbol:** ✗

**SFunction**: This command opens the “Update” dialog. In the dialog, the revision is defined for updating the project.

**Call**:

- "Project ➔ SVN"
- "Context menu ➔ SVN"

If you select nothing or the base node in the object tree, then the entire project is updated to a revision ("Update project to revision"). If you select one or more objects, then these objects are updated and their sub-objects are updated recursively ("Update to revision"). As an option, you can define that the sub-objects are not updated.

The behavior of the updating process (for example merging of conflicts) is similar to the "Update project" and "Update" commands.

**Dialog 'Update'**

<table>
<thead>
<tr>
<th>&quot;HEAD&quot;</th>
<th>✗: This command behaves the same as the &quot;Update&quot; and &quot;Update project&quot; commands.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Revision&quot;</td>
<td>✗: The revision to which was last updated is selected by the revision number.</td>
</tr>
</tbody>
</table>
"Date" | The revision to which was last updated is selected by the modification date.  
| "Use UTC time": The date is displayed in universal time.  
| "Recursive" | Default setting. The selected part is updated recursively. This means that all elements below the selected object are also updated.  
| "Omit externals" | External objects are not updated.  

See also
-  Chapter 6.6.7.6.2.22 ‘Command 'Update', Command 'Update project' “ on page 4340
-  Chapter 6.6.7.6.3.3 “Dialog 'Select revision'” on page 4351

Command 'Update only this'
Symbol: 

**Function:** The command updates the selected objects. In contrast to the “Update” and “Update to Revision” commands, the child objects are not updated.

**Call:** “Context menu ➔ SVN”

See also
-  Chapter 6.6.7.6.2.22 “Command 'Update', Command 'Update project' ” on page 4340
-  Chapter 6.6.7.6.2.23 “Command 'Update to revision'” on page 4341

Command 'Disconnect project from SVN'
Symbol: 

**Function:** This command deletes all connections of the current project to SVN by converting the project into a non-versioned project.

**Call:** Menu bar: “Project ➔ SVN”.

Because this operation cannot be reversed, the operation must be confirmed before the command is executed.

Use the command "Connect to existing project" to connect to the SVN repository again at a later time.

See also
-  Chapter 6.6.7.6.2.31 “Command 'Connect to existing project'” on page 4345

Command 'Switch'
Symbol: 

**Function:** This command opens the “SVN switch” dialog. In this dialog, you specify a URL in the SVN repository to which the current working copy of the project is updated. The command switches a project from a branch or tag to another.

**Call:** Menu bar: “Project ➔ SVN”.

**Requirement:** The project is versioned.
Dialog 'SVN switch'

| “From” | Current SVN URL of the project |
| “To” | Input field for the target URL in SVN |

- “HEAD”: The “Select revision” dialog opens.
- ...: The “SVN Repository Browser” dialog opens. There you select the target URL in the SVN repository.

See also:
- Chapter 6.6.7.6.2.2 “Command ‘SVN Repository Browser’” on page 4322

Command 'Un-Ignore on commit'

Function: This command removes an unversioned object from the ignore list so that the object is checked by default on commit.

Call: Context menu: “SVN”

Requirement: The command “Ignore on commit” was executed for the object. The object is marked with the ☑ symbol.

See also:
- Chapter 6.6.7.6.2.12 “Command 'Ignore on commit’” on page 4335

Command 'SVN Cleanup'

Function: This command opens the “SVN Cleanup” dialog. In the dialog, you define actions that are performed when cleaning up the SVN working copy.

Call: Menu bar: “Project ➔ SVN”.

Dialog 'SVN Cleanup'

Table 793

<table>
<thead>
<tr>
<th>“Internal SVN working copy”</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Update time stamps (speeds up SVN status display)”</td>
</tr>
<tr>
<td>“Vacuum cached pristine copies (may reduce the size of your project file)”</td>
</tr>
<tr>
<td>“Clear work queue and force unlock of SVN internal data structures (emergency only!)”</td>
</tr>
<tr>
<td>“Project contents”</td>
</tr>
<tr>
<td>Command</td>
</tr>
<tr>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>“Revert all local changes (use with care!)”</td>
</tr>
<tr>
<td>“Release all locks”</td>
</tr>
<tr>
<td>“Revalidate all locks against the repository (they could have been stolen)”</td>
</tr>
<tr>
<td>“Status caches”</td>
</tr>
</tbody>
</table>

**Command 'Clear authentication data'**

**Function:** This command opens the “CODESYS” dialog. In this dialog, define the caches that will be deleted.

**Call:** Menu bar: “Project ➔ SVN”.

**Dialog 'CODESYS'**
The authentication memory contains the authentication data of all SVN repositories for which the user has selected for saving the authorization data. This memory is deleted completely by this command.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Clear the shared on-disk cache.”</td>
<td>☑: The data saved on the computer is deleted.</td>
</tr>
<tr>
<td>“Clear the RAM cache of this instance.”</td>
<td>☑: The data saved in the RAM is deleted.</td>
</tr>
</tbody>
</table>

*The authentication data saved on the computer is stored in %APPDATA% \Subversion\auth. This memory path is also used for most other Subversion client applications (for example, TortoiseSVN and AnkhSVN). Therefore, deleting the authentication data affects these applications as well.*

**Command 'Merge changes'**

**Symbol:** 🧵

**Function:** This command opens the “Merge” dialog. In this dialog, you determine the revisions with the changes to be merged with the working copy of the project.

**Call:** Menu bar: “Project ➔ SVN”.

**Requirement:** The project is linked to SVN.

**Dialog 'Merge'***
"Kind of merge"  
- "Sync/Reintegrate/Symmetric merge": All missing changes from the trunk (or a different branch) are synchronized with this branch.  
- "Cherry pick": Integrates specifically selected revisions from one branch to another branch. This is necessary, for example, if any error trapping has to be ported back to an older version.

"Merge source"  
SVN URL of the SVN repository  
- Input field  
- "HEAD": HEAD revision  
- Dialog "SVN Repository Browser" opens for selecting the SVN repository.

"Define start and end revision"  
Select this option to merge a cohesive range of revisions with the working copy.

"Start revision"  
Defines the range of revisions that are merged with the working copy:
- "HEAD": HEAD revision  
- "Revision": Start and end revision of the range  
- "Date": Date of the start and end revisions

"End revision"  
- "HEAD": HEAD revision  
- "Revision": Start and end revision of the range  
- "Date": Date of the start and end revisions

"Define revision range"  
Select this option to merge individual revisions with the working copy. You can also highlight the individual revisions in the "Log" dialog.

Note: When defining ranges, CODESYS SVN behaves like other graphical clients, such as Tortoise SVN), and not like the command-line client. Example: For a range of 4–7, revisions 4, 5, 6, and 7 are merged.

See also: Merging a Range of Revisions

"Dry run (simulation)"  
☑ This command is executed without changing the working copy. Files that are changed during an actual merge are displayed, as well as ranges where conflicts occur.

"Record only"  
☑ The revision is marked as "merged" without actually performing the merge.

"Ignore ancestry "  
☑ SVN uses path-based differences only, not history-based differences.

See also
- ☯ Chapter 6.6.7.6.3.3 “Dialog 'Select revision’” on page 4351
- ☯ Chapter 6.6.7.6.2.2 “Command 'SVN Repository Browser'” on page 4322

Command 'Connect to existing project'

Symbol:

Function: This command opens the “Connect to SVN repository” dialog. In the dialog, you define the URL and the revision of the SVN repository with which the unversioned project is connected.

Call: Menu bar: “Project ➔ SVN”.

Requirement: The project is disconnected from SVN.

NOTICE!

Only users who have read access to the entire project (see the CODESYS user and access management) can import the project into the SVN repository or can link to an existing database project.

NOTICE!

This command functions reliably only when the project has already been imported into SVN and then disconnected with the command “Disconnect project from SVN.”
### Dialog 'Connect to SVN repository'

<table>
<thead>
<tr>
<th>“URL of existing project”</th>
<th>URL of the SVN repository</th>
</tr>
</thead>
<tbody>
<tr>
<td>“HEAD”: Selection of the revision in the “Select revision” dialog</td>
<td>Selection of the SVN repository in the “SVN Repository Browser”</td>
</tr>
<tr>
<td>“Checkout options”</td>
<td>“Omit externals”: External objects are not checked out.</td>
</tr>
<tr>
<td>“Revision”</td>
<td>● “HEAD”: HEAD revision</td>
</tr>
<tr>
<td></td>
<td>● “Revision”: Number of the revision</td>
</tr>
<tr>
<td></td>
<td>● “Date”: Date of the revision</td>
</tr>
<tr>
<td></td>
<td>“Use UTC time”: Date display in universal time.</td>
</tr>
</tbody>
</table>

See also
- § Chapter 6.6.7.6.2.2 “Command ‘SVN Repository Browser’” on page 4322

### Command 'Resolve conflict'

**Symbol:** ☰

**Function:** This command opens the “<object>” dialog. In the dialog, the conflicts are displayed and functions for resolving conflicts are prepared in order to merge changes.

**Call:** Context menu of the object.

**Requirement:** The object has a conflict that has occurred by updating the object with local changes.

### Dialog '<object>'

<table>
<thead>
<tr>
<th>“Compare”</th>
<th>The local objects are displayed on the left side, and the version from the SVN repository is displayed on the right side.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Use mine”</td>
<td>A local change is used.</td>
</tr>
<tr>
<td>“Use yours”</td>
<td>A change of the version from the SVN repository is changed.</td>
</tr>
<tr>
<td>“Apply”</td>
<td>All changes are accepted that you made in this dialog. The status of the object is changed.</td>
</tr>
<tr>
<td>“Cancel”</td>
<td>Cancels all changes that you made in this dialog. But the object keeps the conflicted status.</td>
</tr>
</tbody>
</table>

### Command 'Work in offline mode'

**Function:** This command switches to SVN offline mode. In SVN offline mode, the implicit locking and all commands that access the SVN repository are not possible.

**Call:**
- Menu bar: “Project ➔ SVN”.
- Context menu: “SVN”

**Requirement:** The project is linked to SVN.

When switching back to SVN online mode, all present locks on the working copy are checked against the server. If this locking is invalid, then it is released.
**Uses case**

The user on a machine wants to make changes to the project without disconnecting the connection. At the moment, there is not connection to the server. Despite this, when automatic locking is activated, work is possible because the SVN offline mode deactivates the automatic lock temporarily.

**Command 'Copy (Branch/Tag)'**

*Symbol:*  

*Function:* This command opens the “SVN Copy Branch/Tag” dialog. There you can “Branch” or “Tag” a revision of your project. A specific revision of your project is saved there at this position. A branch is normally used in order to save changes isolated in one version. A tag is used for marking a specific state, for example a shipping version. Internally, it is copied not in the actual sense, but more refers to the revision.

*Call:* Menu bar: “Project ➔ SVN”.

*Requirement:* The project is versioned.

**Dialog 'SVN Copy (Branch/Tag)'**

Table 794: “SVN repository”

<table>
<thead>
<tr>
<th>“From”</th>
<th>SVN path of the current project</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example:</td>
<td><a href="https://svnserver/repository/trunk/ControlABC.project">https://svnserver/repository/trunk/ControlABC.project</a></td>
</tr>
</tbody>
</table>

| “To” | Target path in the SVN repository for the copy operation |
| Example of tag: | https://svnserver/repository/tags/V4.4.4.4/ControlABC.project |

[1]: Dialog “SVN Repository Browser” opens for selecting the target path.

Table 795: “Log message”

<table>
<thead>
<tr>
<th>Input field</th>
<th>Comment the change in a log message.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example:</td>
<td>Tag for version 4.4.4.4 created.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>“Recent Messages”</th>
<th>Opens the dialog “Recent Messages” to display the last log messages. You can click a log message to accept it.</th>
</tr>
</thead>
</table>

Table 796: “Create copy from”

<table>
<thead>
<tr>
<th>“Working copy (including local changes)”</th>
<th>The new branch/tag refers to the working copy including all local changes. The local changes are committed to the SVN repository for this purpose.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Base revision of working copy (&lt;revision number&gt;)”</td>
<td>The new branch/tag refers to the base revision of your working copy whose revision number is displayed in the parentheses. If the working copy already contains local changes, then these are not committed to the SVN repository.</td>
</tr>
<tr>
<td>“HEAD revision of the repository”</td>
<td>The new branch/tag refers to the HEAD revision of your project.</td>
</tr>
<tr>
<td>“Specific revision in SVN repository”</td>
<td>The new branch/tag refers to a revision that is displayed on the adjacent button. Click the button to change the revision. The “dialog opens.”.</td>
</tr>
</tbody>
</table>
After the dialog is confirmed, the working copy switches to the new branch or tag.

The target path is created (as a new tag ../repository/tags/V4.4.4.4 or as a new branch ../repository/branches/new_feature). Then the revision specified in “Create copy from” is copied there.

See also

- § Chapter 6.6.7.6.2.2 “Command ‘SVN Repository Browser’” on page 4322

**Command 'Pending Changes'**

**Symbol:** 🔄

**Function:** The command opens the “Pending Changes” view. All objects are listed there which have changed from the base revision or which are locked.

**Call:** “View ➔ Pending Changes”

**View ‘Pending Changes’**

The modified or locked objects are displayed in the lower half of the view. You can use the “Commit”, “Revert”, and “Update” commands on single or multiple objects. You will find commands for comparing and displaying the version history in the context menu of a selected object.

CODESYS SVN first checks whether or not the storage format of the working copy matches the storage format of the project in the SVN repository. If the storage formats differ, then the revert must not be executed at the object level in order to prevent inconsistencies. In this case, you can delete the entire project (working copy) first with the Save as command as the appropriate storage format, which however can result in smaller data losses. After you select one of the revert options, you will be guided by corresponding dialog prompts.

Double-clicking the object opens the project comparison.

**“Select”**

Selection or clearing of all objects

**“Commit”**

Commits local changes to the SVN repository

**“Revert”**

Reverts the local changes to the state of the base revision of the working copy

**“Update”**

The command commits changes in the SVN repository to the project. The update is performed with the HEAD revision.

**“Keep Locks”**

✓ Lock is not released automatically after commit

**“Storage profile update”**

Note that the storage profile (storage version) of the repository in the working copy differs from the one in the SVN repository. In this case, a commit will change the storage profile in the repository.

For actions which require an exchange between the working copy and repository, you will be guided by corresponding messages to match the storage profile.

**“Recent Messages”**

Shows the last used log messages. You can click a log message to accept it.

**“Messages”**

Type in a log message that comments your change. Example: Bug fix error 123

See also

- § Chapter 6.6.7.6.2.6 “Command ‘Commit’, Command ‘Commit Project’” on page 4328
- § Chapter 6.6.7.6.2.20 “Command ‘Revert’, Command ‘Revert project’” on page 4339
- § Chapter 6.6.7.6.2.22 “Command ‘Update’, Command ‘Update project’ ” on page 4340
6.6.7.3 Dialogs

6.6.7.3.1 Dialog 'Options' - 'SVN Settings' .............................................................. 4349
6.6.7.3.2 Dialog 'Project Settings' - 'SVN Settings' ................................................ 4350
6.6.7.3.3 Dialog 'Select revision' ........................................................................... 4351
6.6.7.3.4 Dialog 'Subversion Authentication' ....................................................... 4352
6.6.7.3.5 Dialog 'Automatic locking failed' ............................................................ 4354

Dialog 'Options' - 'SVN Settings'
Tab 'General'  Symbol: 🗝

Function: This tab includes the basic settings for Professional Version Control.

Call: Menu bar: “Tools ➔ Options”.

Table 797: “Automatic locking and merging”

<table>
<thead>
<tr>
<th>Merge</th>
<th>Behavior for the commands “Update”, “Merge”, or “Switch”, when both sides (working copy and SVN repository) have changed from the base version.</th>
</tr>
</thead>
<tbody>
<tr>
<td>•</td>
<td>“Mark all colliding changes as conflicts”: The objects are not merged automatically. All changes with a conflict are marked as &quot;With conflict&quot;, even if some of them can be merged automatically.</td>
</tr>
<tr>
<td>•</td>
<td>“Merge mergeable changes, mark the others as conflicts”: Changes that can be merged are merged automatically. All others are marked as &quot;With conflict&quot;.</td>
</tr>
<tr>
<td>•</td>
<td>“Merge mergeable changes, ask the user for the others”: Changes that can be merged are merged automatically. The user is prompted for all others.</td>
</tr>
<tr>
<td>•</td>
<td>“Always ask the user, even for mergeable changes”: For all changed objects, the user is prompted, even if some of them can be merged automatically.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Locks</th>
<th>Behavior such as Professional Version Control objects when they are changed locally.</th>
</tr>
</thead>
<tbody>
<tr>
<td>•</td>
<td>“Always try to lock before modification”: All objects are locked before they are changed, even if they can be merged.</td>
</tr>
<tr>
<td>•</td>
<td>“Only lock the objects which don’t support merging”: Only those objects are locked that cannot be merged automatically.</td>
</tr>
<tr>
<td>•</td>
<td>“Never acquire a lock automatically”: No objects are locked, not even if they can be merged automatically.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Marker</th>
<th>“Use conflict markers when merging objects”: If objects with conflicts exist that cannot be merged, then these conflicts are marked in the source code with conflict markers. In addition, the object itself is marked as being merged successfully (no conflict).</th>
</tr>
</thead>
<tbody>
<tr>
<td>•</td>
<td>“Leave non-mergeable objects as conflicted”: No conflict marker is set. Objects that cannot be merged remain in the status “Conflicted”.</td>
</tr>
</tbody>
</table>

| Prompt the user when automatic locking fails. | If it is not possible, to lock the object, then the dialog “Automatic locking failed” opens (see dialog description). |

Example of conflict markers

```c
Foo () ;
>>>>>>>>>>>>>>>>>
1 := 1 + 1 ;
-----------------
1 := 1 + 2 ;
<<<<<<<<<<<
```

2024/01/05  3ADR010583, 1, en_US  4349
### Table 798: “Server check”

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Check server for updates and locks”</td>
<td>Professional Version Control checks in the specified time interval that objects</td>
</tr>
<tr>
<td></td>
<td>have been updated on the server. In addition, it checks whether objects are</td>
</tr>
<tr>
<td></td>
<td>locked or locks have been stolen.</td>
</tr>
<tr>
<td>“Check interval (minutes)”</td>
<td>Example: 10</td>
</tr>
</tbody>
</table>

### Table 799: “Ignore for comparison”

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ignore whitespace</td>
<td>□: Whitespace differences between the current project and the reference project are ignored.</td>
</tr>
<tr>
<td>Ignore comments</td>
<td>□: Comments in the programming code are excluded from the comparison.</td>
</tr>
<tr>
<td>Ignore Properties</td>
<td>□: Object properties are excluded from the comparison.</td>
</tr>
</tbody>
</table>

Some of the SVN options can be overwritten by the project-specific settings.

Project-specific settings are defined in the menu “Project ➔ Project settings”, category “SVN Settings”.

See also
- Chapter 6.6.7.6.3.5 “Dialog 'Automatic locking failed’” on page 4354
- Chapter 6.6.7.6.3.2 “Dialog 'Project Settings’ - ’SVN Settings’” on page 4350

### Tab 'SSH'

**Symbol:** 🆙

**Function:** This tab contains the settings for the SSH protocol.

**Call:** Menu bar: “Tools ➔ Options”.

### Table 800: “SSH client implementation”

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“libssh2 (recommended)”</td>
<td>Professional Version Control uses Libssh2 for establishing a connection via SSH protocol. This is the recommended setting.</td>
</tr>
<tr>
<td>“SharpPlink (backwards compatibility)”</td>
<td>Professional Version Control uses plink.exe for establishing a connection with SSH servers. This option is required only for communication with outdated servers that support the deprecated SSH-1 protocol.</td>
</tr>
</tbody>
</table>

The SSH configuration can be overwritten by means of the environment variable SVN_SSH or server-specific by means of the SVN configuration file.

See also
- **Tunneling via SSH**

### Dialog 'Project Settings' - 'SVN Settings'

**Symbol:** 🆙

**Function:** The behavior of the integrated SVN version control system is configured in this dialog.

**Call:** Menu bar: “Project ➔ Project Settings” (“SVN Settings”).

**Requirement:** A project is open.
Table 801: “Automatic locking and merging”

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Merge”</td>
<td>Behavior for the commands “Update”, “Merge”, or “Switch”, when both sides (working copy and SVN repository) have changed from the base version.</td>
</tr>
<tr>
<td>“Locks”</td>
<td>Behavior such as Professional Version Control objects when they are changed locally.</td>
</tr>
<tr>
<td>“Marker”</td>
<td>Behavior for conflicts</td>
</tr>
</tbody>
</table>

With these settings, you can overwrite the default settings that were made in the dialog "Tools ➔ Options", category “SVN Settings”.

Table 802: “Settings SVN version info”

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| “Create SVN_VERSION_INFO constants for IEC access” | [✔]: The object SVN_VERSION_INFO is created and includes global constants or variables for the project metadata. 
[☒]: The object SVN_VERSION_INFO is not available. 
When you activate the option, the object is created automatically. When you deactivate the option, the object is removed from the project automatically. |

See also
- ✔ Chapter 6.6.7.6.3.1 “Dialog 'Options' - 'SVN Settings'” on page 4349

Dialog 'Select revision'

**Function:** This dialog shows the currently selected revision. You can edit the selection there.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Revision”</td>
<td>[✔]: The latest revision (top revision) within a branch is displayed.</td>
</tr>
</tbody>
</table>
| “HEAD” | A specific revision is displayed by the revision number. 
Example: 3 
Tip: Click to show the revisions. Then the “Log” dialog opens to display the revisions and the associated actions. The revision that you select there is applied. |
| “Revision” | A specific revision is checked out by the modification date. This is the highest revision at the given time (the last revision before that time). 
Example: 12/23/2016 11:59:59 
Tip: See section “Revision identifiers” in "Version control with Subversion" |
| “Date” | [✔]: Modification date in universal time is used. |
| “Use UTC Time” | All objects below the selected object are also reset. 
The action fails if 
- Objects have been moved in or out of the hierarchy below 
- Objects outside of the hierarchy would be changed by implicit dependencies |
| “Reset recursively” | See also
- ✔ Chapter 6.6.7.6.2.19 “Command 'Show log', Command 'Show project log'” on page 4337
- "Version control with Subversion", Section "Revision identifier"
Dialog 'Subversion Authentication'

The dialogs are used for authenticating the server/client connection. A server or client authentication is performed depending on the initial situation and protocol.

Overview of possible protocols and dialogs

- **svn://**: The SVN protocol; either unencrypted or SSL/TLS encrypted
  - Can prompt for user name and password (even for an unencrypted connection)
  - Can prompt for a server certificate from the dialog for authentication in order to confirm the server if a certificate is unknown, defective, or invalid (for TLS/SSL encryption)
  - As an alternative or in addition to the user name and password prompt, the client can also be authenticated with client certificates (for TLS/SSL encryption). The dialogs for authentication open with the client certificate.

- **http://**: SVN via http, unencrypted
  - Can prompt for user name and password

- **https://**: SVN via http, SSL/TLS encrypted.
  - Can prompt for user name and password
  - Can prompt for a server certificate from the dialog for authentication in order to confirm the server if a certificate is unknown, defective, or invalid.
  - As an alternative or in addition to the user name and password, the client can also be authenticated with client certificates. The dialogs for authentication open with the client certificate.

- **svn+ssh://**: The SVN protocol, encrypted through an SSH tunnel. SSH (Secure Shell) is the usual networking tool in Linux/Unix for accessing other computers.
  - Can prompt for user name and password
  - Prompts for server certificate in the dialog for authentication if the server is still unknown in order to be sure that it is the correct server.

Initial situation: CODESYS (as a client) receives an unknown or defective server certificate.

This dialog shows information about the certificate. There you can confirm the identity of the server.

<table>
<thead>
<tr>
<th>“Authentication area”</th>
<th>Connection that is secured</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: <a href="https://svn">https://svn</a> repository:443</td>
<td></td>
</tr>
</tbody>
</table>

Table 803: “Certificate information” (for SSL/TLS connections)

<table>
<thead>
<tr>
<th>“Host name”</th>
<th>Example: svn repository</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Thumbprint”</td>
<td></td>
</tr>
<tr>
<td>“Valid from”</td>
<td></td>
</tr>
<tr>
<td>“Valid to”</td>
<td></td>
</tr>
<tr>
<td>“Issuer”</td>
<td>Example: ABB AG</td>
</tr>
<tr>
<td>“Certificate”</td>
<td></td>
</tr>
</tbody>
</table>

Table 804: “SSH server key information” (for SSH connections)

| “Key type” | |
| “Key size (bits)” | |
| “Key thumbprint” | |
“Save information to RAM” | The certificate is saved to the working memory. Then the client recognizes in the current CODESYS session for future connections. If you restart CODESYS, then you have to accept the certificate again.

“Save to disk” | The certificate is saved on the computer and it is available for future connections. If you restart CODESYS, then the saved certificate is used.

“OK” | Authenticates and established the connection.

*The certificate memory is secured cryptographically and distributed with other SVN clients.*

See also
- *Version Control with Subversion*

**Dialog for authentication with a client certificate**

Initial situation: The SVN server requires a client certificate for authentication. In this dialog, you select the client certificate in order to confirm the identity.

| “Authentication area” | Connection that is secured
| Example: https://svn repository:443 |

**Table 805: “The SSL server requires a client certificate file.”**

| “File” | Client certificate file |

| “Save information to RAM” | The certificate is saved to the working memory. Then the client recognizes in the current CODESYS session for future connections. If you restart CODESYS, then you have to accept the certificate again.

| “Save to disk” | The certificate is saved on the computer and it is available for future connections. If you restart CODESYS, then the saved certificate is used.

| “OK” | Authenticates and established the connection.

**Dialog for authentication with a pass phrase**

Initial situation: The SVN server is configured so that it demands a client certificate for authentication. The applied certificate is protected by a pass phrase.

| “Authentication area” | Connection that is secured
| Example: https://svn repository:443 |
Table 806: “A pass phrase is needed to unlock the certificate.”

<table>
<thead>
<tr>
<th>Pass phrase</th>
<th>Example: ***</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Save information to RAM</th>
<th>The pass phrase is saved to the working memory. Then the client recognizes in the current CODESYS session for future connections. If you restart CODESYS, then you have to accept the certificate again.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save to disk</td>
<td>The pass phrase is saved on the computer and it is available for future connections. If you restart CODESYS, then the saved certificate is used.</td>
</tr>
<tr>
<td>OK</td>
<td>Authenticates with client certificates by means of a pass phrase and establishes the connection.</td>
</tr>
</tbody>
</table>

Dialog for authentication with a user name and password

Initial situation: The SVN server is configured so that it demands a user name and password for authentication.

<table>
<thead>
<tr>
<th>Authentication area</th>
<th>Connection that is secured</th>
</tr>
</thead>
<tbody>
<tr>
<td>User name</td>
<td>Example: a.mayr</td>
</tr>
<tr>
<td>Password</td>
<td>Example: ***</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Save information to RAM</th>
<th>Saved to the working memory. Then the client recognizes in the current CODESYS session for future connections. If you restart CODESYS, then you have to accept the certificate again.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save to disk</td>
<td>Saved on the computer and it is available for future connections. If you restart CODESYS, then the saved certificate is used.</td>
</tr>
<tr>
<td>OK</td>
<td>Establishes the connection and authenticates it.</td>
</tr>
</tbody>
</table>

Dialog 'Automatic locking failed'

The dialog shows a list of all objects for which an automatic locking was not possible. In the options you define how Professional Version Control will resolve the conflict.
Table 807: “Automatic Locking and Merging”

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Try to steal the lock for the affected objects”</td>
<td>These options are displayed if another user has locked the object.</td>
</tr>
<tr>
<td>“Activate the &quot;Offline Mode&quot; to temporarily suppress locking”</td>
<td>These options are displayed if another user has locked the object.</td>
</tr>
<tr>
<td>“Update the affected objects to the newest revision”</td>
<td>These options are displayed if there exists a more current version of the object on the server.</td>
</tr>
<tr>
<td>“Update the whole project to the newest revision”</td>
<td>These options are displayed if there exists a more current version of the object on the server.</td>
</tr>
<tr>
<td>“Activate the &quot;Offline Mode&quot; to temporarily suppress locking”</td>
<td>These options are displayed if no connection can be established to the server.</td>
</tr>
<tr>
<td>“SVN Project Settings”</td>
<td>Opens the SVN project settings dialog (menu “Project ➔ Project Settings”). There you can change the settings for the automatic locking.</td>
</tr>
<tr>
<td>“SVN Settings”</td>
<td>Opens the general SVN project settings dialog (menu “Tools ➔ Options”).</td>
</tr>
</tbody>
</table>

See also
- Chapter 6.6.7.6.3.1 “Dialog 'Options' - 'SVN Settings'” on page 4349
- Chapter 6.6.7.6.3.2 “Dialog 'Project Settings' - 'SVN Settings'” on page 4350

### 6.6.7.6.4 Objects

#### 6.6.7.6.4.1 Object ‘SVN_VERSION_INFO’

Symbol: ![Symbol](image)

The object contains the SVN metadata of the project as global constants or variables in a variable list. It is located in the “POUs” view. You can specifically retrieve the data of the global constants or variables by the application. By calling specific data, you can also reduce the memory usage on the controller.

The SVN metadata is provided for this purpose, subdivided over multiple global variable lists (GVLs):

- “SVN_VERSION_INFO”
- “SVN_Info_Summary”
- “SVN_Info_SummaryW”
- “SVN_Info_URI”
- “SVN_Info_Revisions”
- “SVN_Info_Flags”
- “SVN_info_LastChange”

The SVN_VERSION_INFO object is created automatically when a project is versioned by importing it into a SVN repository. To do this, the “Create SVN_VERSION_INFO” option has to be selected in the “Import project to SVN” dialog.

Furthermore you can create the object or remove it from the project with the option “Generate SVN_VERSION_INFO constants for IEC Access” (Dialog “Project ➔ Project Settings”, category “SVN Settings”).
Table 808: Global Constants

<table>
<thead>
<tr>
<th>Name</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MINREVISION</td>
<td>LINT</td>
<td>Lowest revision number of the working copy</td>
</tr>
<tr>
<td>MAXREVISION</td>
<td>LINT</td>
<td>Highest revision number of the working copy</td>
</tr>
<tr>
<td>PARTIAL</td>
<td>BOOL</td>
<td>TRUE: The working copy is incomplete. Example: Cancellation during the last update due to a network error or a checkout.</td>
</tr>
<tr>
<td>MODIFIED</td>
<td>BOOL</td>
<td>TRUE: Local changes were made.</td>
</tr>
<tr>
<td>SWITCHED</td>
<td>BOOL</td>
<td>TRUE: Parts of the project were branched (with the “Switch” command).</td>
</tr>
<tr>
<td>VERSION</td>
<td>STRING</td>
<td>Version identification, similar to Apache™ Subversion® (subversion.exe)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: 12:34M, means MINREVISION = 12, MAXREVISION = 34, MODIFIED = TRUE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For more information, refer to the documentation for Apache™ Subversion®.</td>
</tr>
<tr>
<td>CLEAN</td>
<td>BOOL</td>
<td>TRUE: The version is clean. This is the case when MINREVISION is equal to MAXREVISION, the working copy is complete, and non-versioned, and is was not switched.</td>
</tr>
<tr>
<td>URL</td>
<td>WSTRING</td>
<td>SVN-URL of the project</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: <a href="https://svnserver/repository/trunk/ControlABC.project">https://svnserver/repository/trunk/ControlABC.project</a></td>
</tr>
</tbody>
</table>

If a controller does not support the data type WSTRING, then a compiler error is issued when accessing the object SVN_VERSION_INFO.

See also
- § 6.6.7.6.3.2 “Dialog ‘Project Settings’ - ‘SVN Settings’” on page 4350
- § 6.6.7.6.2.4 “Command ‘Import project to SVN’” on page 4326

6.6.8 Subversion

6.6.8.1 Project Version Control with Subversion

6.6.8.1.1 Introduction

Automation Builder projects can be stored in Subversion (SVN) repositories by using the Project Version Control. The Project Version Control can be used to track changes on a project and have access to historic versions of the whole project or objects in the project. It is possible to hold different versions of a project in branches and to compare these versions. The Project Version Control enables multiple engineers to work collaboratively on the same project.

6.6.8.1.2 Preconditions

Basic knowledge

Make yourself familiar with the concepts of SVN. This manual about Project Version Control is additionally to the following information and describes mainly the specific behavior of Subversion in Automation Builder.
● Homepage of Subversion: http://subversion.apache.org/
● Online user manual for Subversion: http://svnbook.red-bean.com/
● Documentation on SVN integration in Automation Builder: Refer to subfolder.

Automation Builder
● In Automation Builder, the Project Version Control must be installed.
● A valid license for the Project Version Control must be activated.
● All collaborating users working on the same project need:
  – Automation Builder installed in the same version with the same features.
  – License for same edition.
  – Same set of optional third party device descriptions.
  – Same set of optional customer specific packages.

SVN server
The Project Version Control can be used in combination with an SVN server in version 1.6 or newer, the repository format should be 1.5, 1.6 or 1.7. Newer repository formats are not yet supported.

The usage of local repositories in the local file system or even on a network share is strongly discouraged.

6.6.8.1.3 Working with Project Version Control
● All objects in the device tree or POU tree are represented by an object in the SVN repository, there might be hidden objects that are not visible in the tree but that exist in SVN.
● The smallest unit in the SVN repository is one object including all its data like name, parameters, device identification.
● Objects are identified in the SVN repository by their name. Renaming one object in Automation Builder means to delete it from the SVN repository and add a new one to the SVN repository. Renaming an object causes a break in the history of that object.
● By default objects are locked before they are changed to prevent other users from changing the object. The locking strategy can be changed in the user options.
● Objects can be compared to other versions of the same object, many differences/changes between the current object in the Automation Builder project and the compared object can be merged into the object in the Automation Builder project. Merging changes could be used to resolve conflicts in case concurrent changed can not be avoided.

● To ensure consistency it is required and also enforced that some changes can be committed or reverted only together.
  – All changes to device objects in the hardware tree that are sub-nodes to the same top level device. Note: Objects that are not devices are excluded, e.g. the application node.
  – All changes below the AC500 PLC application node.
● Most SVN operations can not be performed while other external applications like CODESYS or Panel Builder work on files that are embedded in Automation Builder project.
● Some operations like changing the target or updating the project to the latest device (description) versions do a recursive lock of the whole AC500 PLC. If the lock can’t be obtained the operation is aborted.
● Some objects contain internal data that has no meaning to the end user but is also important. Changes on such data are not shown in the compare dialog or are summarized by a placeholder like “There are hidden changes”.
● Including externals is not supported.
6.6.8.1.4 Recommendations on Working with Project Version Control

Be collaborative
- Multiple users that work collaboratively on the same project should agree on their responsibility for certain parts of the project where they do changes to avoid conflicts and tree conflicts.
- Agree on locking strategy used by all users working on the same project.
- Distribute the work between multiple users meaningful.
  - It is suggested to setup the hardware structure at first before other users checkout a project to work on it and limit structure changes in the hardware tree to the minimum.
  - Before adding objects, especially top level objects, users should agree that only one user adds objects at top level or below the same parent, or agree on unique names for the objects to add. The default naming scheme for new objects bears the risk of name conflicts. These conflicts could be resolved only by reverting the changes of the user who later tried to commit the changes.

Be careful
- The SVN integration (and also project compare) gives lot of power to the user, users should be sure to do only things they fully understand. Especially by merging changes incomplete it is possible to create inconsistent data.
- Adding devices, removing devices or even changing parameters can have side effects to other devices, do not change objects/parameters to their original state by merging that were not done explicitly.
- Commit changes frequently to SVN.
  - To release locks that you don’t longer need.
  - To reduce the risk of conflict with co-workers.
  - To keep the sets of changes to commit small.
- Do frequent updates when collaborating in a team.
  - To be up-to-date.
  - To keep the sets of changes to get from SVN small.
  - To reduce the risk of losing work results in case of conflicts.
- To avoid conflicts, it is suggested to stay with the default setting to automatically lock objects before doing changes. Consider explicit recursive locks of sub-trees where you plan bigger changes.
- Prefer a clean checkout over using the switch command to change between different branches.
- Do not use the switch command to change between unrelated projects, this could corrupt the Automation Builder project (local copy, not in SVN) easily.
- Commit local changes to the SVN repository before creating a branch.

Be effective
- Give objects good/correct names after adding them and use renaming of objects already committed to SVN sparingly to maintain a continuous history in the SVN repository.
- The goal to revert only single changes of all changes done that must be committed/reverted together, could be achieved by using project compare or the object compare dialog.
- If changes can’t be committed to the SVN repository because of locks held by other users, it is possible to create a branch, use the switch command to change to this branch and commit the changes there. The branch and base line could be merged together later.

6.6.8.1.5 Known Issues and Troubleshooting

Not all changes are shown for all objects, but hidden changes are also important.

The device pool may be changed as side effect of several operations, including opening the project.

When a project was corrupted (by performing an update that tried to add an AC500 communication module) it is possible to save this project and merge changes to a project that has been cleanly checked out by project compare.
6.6.8.2 SVN Support Examples

6.6.8.2.1 Importing Automation Builder Project to SVN Repository

1. In the Automation Builder main menu, go to “Project ➔ SVN ➔ Import Project to Subversion”.
2. Enter user credentials and click “OK”.
3. Select SVN server repository to import Automation Builder project and click “OK”.
   ➔ The Automation Builder project is imported into the selected repository and connected automatically to the repository. The imported project nodes are identified with green indicators.

6.6.8.2.2 Logging in User2

1. In the Automation Builder main menu, go to “Project ➔ SVN ➔ Checkout”.
2. Enter user credentials and click OK.
3. Select the repository location, project folder and revision if any and click “OK”.
   ➔ The project will checked out of the repository, saved in the selected location and opened as a primary project.

The tables below provide the descriptions of the options available in the check-out dialog.

<table>
<thead>
<tr>
<th>Checkout options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Omit externals</td>
<td>Do not checkout external objects.</td>
</tr>
<tr>
<td>As library project</td>
<td>Saves the project as a CODESYS library file.</td>
</tr>
</tbody>
</table>
Revisions

<table>
<thead>
<tr>
<th>HEAD</th>
<th>Checks out the Head revision.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revision</td>
<td>Allows to select the required revision of the project.</td>
</tr>
<tr>
<td>Date</td>
<td>Allows to select a revision date of the project.</td>
</tr>
</tbody>
</table>

The following instances can occur in the workflow:

- If the project contains any updates, the specific project level node is indicated with <visually represented symbol>.
- If a new object is added to the project, the newly added node is indicated with <visually represented symbol>.
- If the project node is deleted, the specific node is indicated with <visually represented symbol>.

6.6.8.2.3 Examples

Example 1
If User1 modifies Panel_CP600 project, then the node indicator turns to orange with lock symbols. If User2 need to modify the same Panel_CP600 project, the Panel_CP600 project appears with a lock symbol.

To steal the lock of an affected object, proceed as follows:
1. Double-click “Panel_CP600” project.
   - Automatic lock failed dialog is displayed.
2. Enable “Try to steal the lock for the affected objects” and click “OK” to steal the lock.
3. In the Lock Message window, enter the reason to steal the lock and click “OK”.
4. User2 can modify and commit the project.

Example 2
If User1 adds a new object to the project and commit the changes, then User2 can update the project to see the latest modifications.
Example 3

The user can revert to any of the available project revisions.

1. Right-click on object node and select “SVN ➔ Revert to Revision”.
2. Select or enter the revision number and click “OK”.
   ⇒ The revision command reverts local changes of this object back to the specific revision of the working copy.
3. Right-click on the object node and select “SVN ➔ Commit”.
4. In the commit window, enter the reason to change the project and click “OK” to make the changes.
   ⇒ The project node is updated with the latest changes.

Example 4

SVN server allows to select the required revisions of Automation Builder project. You can checkout the project using “Project ➔ SVN ➔ Checkout” and then enter the credentials and click “OK”.

In the check-out dialog, do the following:
1. Select the project repository.
2. Activate “Revision” and select or enter the revision number and click “OK”.

The user can work on the selected revision. To commit the changes to the project, right-click on project and select “SVN ➔ Commit Project”.

6.6.9 Mail service with SMTP/SMTPS

With the integration of the “Mail Service SL” library, the prerequisite for sending mails with the PLC has been created. After appropriate programming of the user requirements and the provision of appropriate hardware and software in the periphery (router, mail program) this service is available.
Mail Service SL library

This library can send, receive and delete emails. An SMTP server is required for sending, and a POP3 server and mail account are required for receiving and deleting. An email can be sent to multiple recipients, with carbon copies and blind copies. Also, any type of file can be attached up to a size of 20 MB if the timeout has been adjusted to the internet speed. If the user specifies a folder, attachments of received e-mails will be stored in this folder. The POP3 server must support unique IDs in case of email deletion.

Simple Mail Transfer Protocol (SMTP)

SMTP is a communication protocol for the exchange of data (e-mails) in networks or in the internet. SMTP is primarily used for sending and forwarding e-mails. Other, specialized protocols (POP3/IMAP) are used to fetch e-mails.

Simple Mail Transfer Protocol Secure (SMTPS)

SMTPS is an independent further development of the SMTPProtocol and authenticates the communication of the e-mail partners by additional encryption protocols (SSL/TSL). This happens before the message is even sent.

Application example

How to send e-mails via the SMTP protocol and how to create the technical requirements for this is described in detail in the application example. AC500 V3 - Sending e-mails via the SMTP protocol

6.6.10 SNMP

Simple Network Management Protocol (SNMP)

SNMP is a network protocol to monitor and control routers, servers, switches, printers, computers etc. from a central station. The protocol controls the communication between the devices and the monitoring station.

SNMP Service SL Library

Use the SNMP Service SL library to read out information from devices via the SNMP protocol. The library provides function blocks for sending and receiving SNMP messages and is part of the software package "IIoT Libraries SL".

Application example

The application example AC500 V3 - SNMP Protocol describes the SNMP communication in a scenario in which an AC500 PLC acts on the one hand as SNMP agent and on the other hand as SNMP manager. In this case, the SNMP protocol is used for network monitoring. The AC500 PLC can receive SNMP requests and respond to them as an agent. As a manager, it can query managed information from any network device that supports SNMP.

6.6.11 Scripting with Python

6.6.11.1 Python

6.6.11.1.1 Python script support

Using scripts

Scripting allows python scripts to be used to automate project configuration in Automation Builder. Parameters can be added to scripts, so that a generic script can be customized before execution. The user can add a script to most parts of the device tree. A script can be started either from the user interface (by a command or with the python scripting editor) or from the Windows command line and is saved with the project.

With the scripting feature commands or complex program operations can be automated. Examples of use cases:
Integration of Automation Builder in automatic build server environments:
- continuous integration (CI)
- continuous delivery (CD)
- continuous testing

Integration with third-party software, for example:
- code generators
- creation of projects that are custom tailored to a specific machine configuration

Creation of documentation

Updating of libraries: Setting of project information during the release process

Automatic testing: Mostly in connection with the Professional Test Manager

Outputting variables via monitoring APIs

Licensing

A valid license is required to use the scripting. If you open a project with the existing script object without a valid license, you are not allowed to add or edit the scripts. However, the scripts are not removed from the project.

Scripting language

The Automation Builder scripting language is modular and based on IronPython. For this purpose, the Automation Builder “ScriptEngine” component combines the IronPython interpreter with the Automation Builder development environment which makes the extensive python framework libraries available including file access in networks and much more.

6.6.11.1.2 Working with script objects

Scripts to execute can be added to and stored in the Automation Builder project. Additionally, parameters can be added to scripts, so that generic scripts can be customized before execution.

Adding a script object to the project

1. In the device tree, right-click on a node (e.g. a PLC node) and click “Add object”.
2. Under “Scripting category” select “Script → Add object”.
   ⇒ The 'Add Script' dialog is displayed.
3. Browse and select a script from the file system or create a new script by clicking [Add].
   ⇒ A script is added below the selected node and the editor is opened.
4. The default parameter values are read from the script. The user can edit the default values as required.

**Editing scripts within Automation Builder is not supported. You can use an external editor to edit the script and then import it to Automation Builder.**

**The script objects can be reused within the project via copy-and-paste around the device tree.**

**Execution**

The user can execute the script with the parameter values via the execute button in the editor or via right-click on the script object in the device tree by selecting “Script ➜ Execute”.

**Import**

The user can import the script from the file system. This will replace the contents of the current script object with the contents of the imported file. Optionally, parameter values will be preserved if the imported script has a matching named parameter. In the device tree, right-click on a script object and select “Script ➜ Import”.

**Export**

The user can export the selected script and save it as a new file in the file system. The exported file does not include any edited parameter values. In the device tree, right-click on a script object and select “Script ➜ Export”.

**Parameters**

The following instructions help the user to create parameters in the python script:

- Parameters must be defined in the script.
- Parameters and values are optional.
- The **ParameterName** and the **ParameterValue** must be delimited with symbols. The format must be as follows:
  - "#AutomationBuilder_Parameter {"ParameterName"} {= "ParameterValue"}
- **ParameterName** is the name given to the parameter. This allows the values to be referenced in the python script.
- **ParameterValue** is the default value given to the parameter. This value can be modified in the editor.

The example below shows the format of the **ParameterName** and **ParameterValue** in the script.

- #AutomationBuilder_Parameter "numWidgets": creates a new parameter called numWidgets.
- #AutomationBuilder_Parameter "numWidgets" = "4": creates a new parameter called numWidgets and initializes to the value 4.

Using parameters within the python script:

- Parameters can be used in the script by creating an instance of the parameter helper:
  - parameterHelper = AutomationBuilder_Parameters.create()
- Individual parameters are retrieved by calling:
  - GetParameter(parameterName). devicename = parameterHelper.GetParameter("Name")

**Python script examples**

A set of python script examples are available in the path %Public%\Documents\AutomationBuilder\Examples\Python scripts.
6.6.11.3  Execute Script

You can execute Python script files (<file name>.py), which contain a sequence of commands for activating CODESYS functionalities, in the following way:

- In the CODESYS user interface by means of commands in the “Tools ➔ Scripting” menu
- From the CODESYS user interface by means of a customized, configured toolbar
- From the Windows command-line

Calling Scripts from Menu Commands

Requirement: A valid Python script file <file name>.py is located in the file system. The CODESYS user interface is open.

1. (optional) To monitor the processing of individual commands used in the script, click “Tools ➔ Scripting ➔ Enable Script Tracing”.
2. In CODESYS, click “Tools ➔ Scripting ➔ Execute Script File”.
   ⇒ The statements in the script are executed and, if script tracing is activated, listed in the message view.

Starting Scripts from the Command Line

In automated environments such as CI (Continuous Integration) servers or if scripts in CODESYS have to be controlled by other programs, menu commands are not appropriate for executing scripts. For these kinds of requirements, you can use the Windows command line to start CODESYS and execute scripts.

Requirement: A valid Python script file <file name>.py is located in the file system.

1. Create a cmd file using start to start CODESYS and with the option --runscript executes the script file. Other options are possible, for example --noUI, if the CODESYS-User interface should not be opened.
2. Open the Windows “Command prompt” and execute the CMD file.

You can pass arguments with additional information to the script. Python scripts can access arguments with the sys.argv[] list. The first element (Index 0) is always the name or path of the Python script that is executed, followed by the "actual" parameters. (This is similar to argc/argv in C.) In addition, scripts can also access environment variables that are set before CODESYS is started with the corresponding Python or .NET APIs.
Example

A CMD batch file `argvtestbat.cmd` has the following contents (all in one line).

```
"C:\Program Files (x86)\CODESYS 3.5.17.0\CODESYS\Common\CODESYS.exe" --profile="CODESYS V3.5 SP17" --runscript="D:\Dokumente\Scripting\ArgvTestScript.py" --scriptargs:'username password 3.14 "path="C:\temp\""' --noUI
```

You have a matching script file `ArgvTestScript.py`.

```python
from __future__ import print_function
import sys
print("sys.argv: ",
      len(sys.argv),
      " elements:"
)
for arg in sys.argv:
    print(" - ", arg)
```

Now when you execute the CMD file, CODESYS starts and executes the script without opening the CODESYS main window. Then CODESYS is exited:

```
C:\Users\user>D:\SUN_Misc\trunk\ScriptEngine\ArgvTestbat
C:\Users\user>"C:\Program Files (x86)\CODESYS 3.5.17.0\CODESYS\Common\CODESYS.exe" --culture=en --profile="CODESYS V3.5 SP17" --runscript="D:\SUN_Misc\trunk\ScriptEngine\ArgvTestScript.py" --scriptargs:'username password 3.14 "path="C:\temp\""'
sys.argv: 5 elements:
 - D:\SUN_Misc\trunk\ScriptEngine\ArgvTestScript.py
 - username
 - password
 - 3.14
 - path="C:\temp\"
```

For a complete reference of all possible command line parameters, see the help page for the command-line interface in CODESYS in the section for "--runscript".

For information about the Python API, see:
https://docs.python.org/2/library/os.html#process-parameters

For information about the .NET-API, see:
https://msdn.microsoft.com/de-de/library/77zkk0b6%28v=vs.110%29.aspx

- See also: % Chapter 6.4.1.16 “Using the Command-Line Interface” on page 2028

Calling Scripts from Toolbar Icons

You can provide your own toolbar in the CODESYS user interface with up to 32 icons for calling script files. For this you need an ICO file where the icon is stored, and a PY file where the Python script to be called is stored.

In the installation directory or in the program files directory under CODESYS, you create a subdirectory named `Script Commands`. In that directory, you create the `config.json` configuration file. Specify the call information outline for each icon in the file. Here you can configure a maximum of 16 icons. You can also store the ICO and PY files in the same directory.

Location

- `<CODESYS installation directory>\CODESYS\Script Commands`
- `Users\<username>\AppData\Local\CODESYS\Script Commands`

Example

Default installation on Windows 10

```
C:\Program Files (x86)\CODESYS 3.5.14.0\CODESYS\Script Commands\
C:\Users\r.smith\AppData\Local\CODESYS\Script Commands`
```
If you store a config.json file with different call information at each of the storage locations, then you can configure up to 32 different icons.

Configuration file

Outline of the configuration file for 2 icons

```
[
    {
        "icon call information"
    },
    {
        "last icon call information"
    }
]
```

Outline of the call information

```
"Name": "<tooltip of the symbol button>",
"Desc": "<description of the symbol button>",
"Icon": "<icon file name>",
"Path": "<path of the script file>"
```

Table 809: Call information

<table>
<thead>
<tr>
<th>&quot;Name&quot;</th>
<th>Required</th>
<th>Displayed as symbol tooltip</th>
<th>Example: &quot;Name&quot;: &quot;Pause&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Desc&quot;</td>
<td>Optional</td>
<td>Comment for the icon</td>
<td>Example: &quot;Desc&quot;: &quot;Operation pause&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Note: Not yet displayed in the user interface</td>
</tr>
<tr>
<td>&quot;Icon&quot;</td>
<td>Required</td>
<td>File path: &lt;directory path&gt;&lt;icon name&gt;.ico of the icon</td>
<td>Example: &quot;Icon&quot;: &quot;pause.ico&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Hint: If the file is in the same folder as the config.json file, then the file name is enough.</td>
<td></td>
</tr>
<tr>
<td>&quot;Path&quot;</td>
<td>Required</td>
<td>Path of the Python script &lt;directory path&gt;&lt;script name&gt;.ico</td>
<td>Example: &quot;Path&quot;: &quot;stop.py&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Hint: If the file is in the same folder as the config.json file, then the file name is enough.</td>
<td></td>
</tr>
<tr>
<td>&quot;Params&quot;</td>
<td>Note: These parameters are not currently assessed.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Example

```json
[{
  "Name": "Start",
  "Desc": "Starts processing",
  "Icon": "start.ico",
  "Path": "goon.py"
},
{
  "Name": "Pause",
  "Desc": "Pause operation",
  "Icon": "pause.ico",
  "Path": "stop.py"
},
{
  "Name": "Processing",
  "Desc": "Process again",
  "Icon": "VarStatSmall.ico",
  "Path": "process.py"
}
]
```

The following files are located in the **Script Commands**:

- config.json
- goon.py
- stop.py
- process.py
- start.ico
- pause.ico
- VarStatSmall.ico

Creating script calls for a toolbar button

1. Create the **Script Commands** folder in one of the storage locations.
   - C:\Users\<username>\AppData\Local\CODESYS

2. Create executable Python files there.
   - Example:
     ```
     File copy.py
     print("The script COPY.PY is executed")
     File delete.py
     print("The script DELETE.PY is executed")
     ```

3. Create the **ICO** files for the scripts.
   - Example: Copy_before.ico, Copy_below.ico, CopyAll.ico
4. Create a configuration file `config.json` there.
   ⇒ The folder `Users\<username>\AppData\Local\CODESYS\Script Commands` has the following content:

5. Open `config.json` and add the outlined call information.
   ⇒
   ```json
   [
   {
     "Name": "Copy Before",
     "Desc": "Copy something",
     "Icon": "Copy_before.ico",
     "Path": "copy.py"
   },
   {
     "Name": "Copy Below",
     "Desc": "Copy something",
     "Icon": "Copy_below.ico",
     "Path": "copy.py"
   },
   {
     "Name": "Copy All",
     "Desc": "Copy something",
     "Icon": "CopyAll.ico",
     "Path": "copy.py"
   },
   {
     "Name": "Delete",
     "Desc": "Delete something",
     "Icon": "Delete.ico",
     "Path": "delete.py"
   }
   ]
   ```

6. Start CODESYS.
   ⇒ The script files, configuration file, and symbol files are read and provided in the “Tools ➔ Customize” dialog on the “Command Icons” tab, in “ScriptEngine Commands” category.

7. Open the dialog “Tools ➔ Customize” and click on the tab .
8. Select the empty toolbar there and click the “Add Toolbar” button.
   ⇒ A line editor opens at the empty toolbar.
9. Type in a name (example: User defined toolbar).
   ⇒ The custom toolbar is displayed in the CODESYS window.
10. Add the recently imported commands and close the dialog.

11. Click one of the icons.
   ⇒ The following output is displayed in the message view.

6.6.11.1.4 Python script editor

In Automation Builder a browser-based python script editor is integrated. This allows the user to modify the existing python script, to create a python script from the scratch and to finally execute the script. Moreover, it assists the user in writing the script with the following features:

- Auto suggest
  - IntelliSense suggestions for the python syntax during typing.
  - IntelliSense for CODESYS script engine and Automation Builder injected script objects.
  - Built-in language service that provides complete code intelligence for objects, properties and methods.
  - Details of the object with [CTRL] + [spacebar].

- Auto completion
  Press the Enter key on a function suggested by IntelliSense in order to insert it.

- Python syntax highlighting (basic syntax colorization)
  The function and its respective namespace is automatically colored in order to match colors.

- Matching brackets
  Matching brackets are highlighted as soon as the cursor is near to one of them using the command palette.

- Zoom
  Changes the font size of the editor's content.

- Find and replace
  Support of 'Find' (search for a keyword) and 'Find and replace' (search and replace a keyword). This feature is supported in the editor, however not integrated in Automation Builder platform.

- Minimap
  High level overview of the script for a quick navigation and code understanding.

- Copy/paste
  Support of 'copy and paste' of the script text within and into the editor.

- Undo/redo
  Support of 'undo/redo' for editing actions. This feature is supported in the editor, however not integrated in Automation Builder platform.

- Keyboard shortcuts
  Keyboard shortcuts allow to perform most tasks directly from the keyboard (e.g. [CTRL] + [Z], [CTRL] + [Y]) including copy and paste. For further keyboard shortcuts refer to the command palette ([F1]).

- Folding
  Support of folding and expanding script regions.
- Comment/uncomment the code
  Support of commenting ([CTRL] + [K]) and uncommenting ([CTRL] + [C]) code through shortcuts.
- 'Execution' button
  Executes the script directly in the editor window.
- In order to start a new script from the scratch the user can start with an empty editor. This can be done via the 'Add script' dialog without script file selection.

For further features that can be used in the python script editor refer to the command palette ([F1]).

### Limitations with CODESYS script engine IntelliSense
- No IntelliSense available for return type of a property.
- No support of IntelliSense for keyword “None”.
- No IntelliSense support for method overloading.
- No IntelliSense support for methods that return an object.
- Private methods are also part of IntelliSense. Refer to the CODESYS script engine documentation to verify the access modifier.

#### 6.6.11.5 Configure port number for python editor server
The python editor server is required for the usage of python script editor.

Earlier versions of Automation Builder than 2.6.0 do not have an option to change the port number of Python editor server via user interface. The user had to update the port number in Automation Builder configuration file if the port was already in use.

With Automation Builder 2.6 onwards, the user has an option to install multiple versions of Automation Builder on a system with separate Python editor servers. Since multiple servers cannot run on a single port, users are given an option to configure the port number from user interface ("Tools ➔ Options ➔ Python Scripting Editor") if the port number are in use.

Default port number of Python editor server is 11030 for Automation Builder versions before 2.6 and 11040 for Automation Builder 2.6 onwards.

#### 6.6.11.6 Creating a Python Script
Python is a dynamic language. You can start in a simple linear programming style ("batch files") and later add the necessary and more powerful means, such as conditions, loops, functions, exceptions, classes, and modules. The focus of the language is on easy and expressive code. Python is more typical at runtime and uses an automatic garbage collector to protect the programmer from accidental damage to the entire system.

IronPython is an implementation of Python for .NET and allows for full access to the .NET framework and classes. The implementation of the IronPython interpreter is based on Python Version 2.7.

There are a variety of free manuals and help pages on the Internet. See the following links for an introduction and detailed introduction about IronPython.

  - Especially for CODESYS-specific questions
  - Also includes some examples
- [https://docs.python.org/2/tutorial/index.html](https://docs.python.org/2/tutorial/index.html): Python tutorial in the official Python documentation
- [http://docs.python.org/release/2.7/](http://docs.python.org/release/2.7/): Official documentation for Python 2.7
- [http://wiki.python.org/moin/GermanLanguage](http://wiki.python.org/moin/GermanLanguage): Collection of links for German help pages
  For general question about (Iron)Python, not CODESYS-specific
Version incompatibility to Python V3.x

The Python programming language will soon be available in the new version V3.x. Some of the older program modules have been removed. CODESYS GmbH is planning an update to this new version. Scripting developers should take this into consideration and design their scripts accordingly, for example by using the expression from __future__ import print_function. You can find more information about this topic at http://wiki.python.org/moin/Python2orPython3 and http://docs.python.org/release/3.1.2/whatsnew/3.0.html

Getting Started with Python for CODESYS

See below for a simple application of a Python script in CODESYS:

1. In any text editor, create a text file hello.py with the following contents:
   
   ```python
   print("Hello, automation!")
   ```

2. Start CODESYS and click "Tools ➔ Scripting ➔ Execute Script File". Select the file hello.py in the file system.
   
   ➔ See the result in the message view:

   ![Message view](image)

For more detailed examples of Python scripts for different use cases with CODESYS, see the following help pages.

Tips for Python Programmers about .NET API Documentation

The current prerelease of the script interface documentation has been generated automatically from the underlying .NET and C# sources. Therefore, the documentation includes some expressions that are not familiar to Python programmers. The following overview provides some tips about how these expressions can be understood from the Python perspective.

- An interface is the contract that tells an instance of a class that implements the interface which members (methods, properties) it has to prepare. In IronPython, you can implement one or more .NET interfaces in one class by inheriting from a superclass. If a method is needed for the interface but is not available in the class definition, then an exception is thrown. (The DeviceImportFromSvn.py example shows a class that implements the ImportReporter interface.)

- Each parameter and each method in .NET is strictly typed. The type of parameter is separated by one space character before the parameter name, and the type of return value from a method by one space character before the method name. You can use instances from subclasses when you define a class (or interface). A method without a return value is marked void.
- You can overload methods. As a result, multiple methods with the same name can exist in one class. However, the number or the types of parameters have to be different. IronPython automatically takes care of the most appropriate method overloading being called.

- The data type `int` corresponds to an integer from -2,147,483,648 to 2,147,483,647. The data type `bool` corresponds to the Python type `bool (True and False)`. The data type `string` corresponds to the Python types `str` or `unicode`, which are identical in IronPython. The `IDictionary<object, object>` data type corresponds to an ordinary Python dictionary. IronPython automatically converts between Python and .NET data types.

- When a `T` type is inherited from `IBaseObject<T>`, it means that this type can be extended by other plug-ins for additional members. The actual use of this extended type as a parameter or return value is marked by `IExtendedObject<T>`.

- The `IEnumerable<T>` interface to a `T` type means that you can use every Python sequence (generators, lists, tuples, etc.) which returns `T` type values (or a subclass). Returns the sequence of incompatible objects, and throws an exception at runtime.

- The `IList<T>` interface to a `T` type identifies a typified list which guarantees to include only elements of type `T` (or a subclass). An exception is thrown at runtime when any attempt is made to add an incompatible object.

- The `params T[]` name id for a parameter of type `T` corresponds to the Python mechanism `*name` for variable argument lists.

- In Python, enumerations (enum) do not exist as language constructs. Its purpose is to define an exact number of constant values for a specific purpose, for example the days of the week. Access to .NET enumerations from IronPython works by using "Name.Member", for example via `OnlineChangeOption.Try`. There are also different approaches to emulate enums in Python. For example, see: [http://pypi.python.org/pypi/enum/](http://pypi.python.org/pypi/enum/)

- The syntax `T name { get; set; }` defines a property with `name` as the name and `T` as the type. If `set;` is missing, then the property is read-only. In Python, the respective construct is `@property` decorator.

**Basic Syntax of Python (with Examples)**

Python is similar to the languages of the "C family", but there are some significant differences and unique properties.

The most obvious syntactic difference between Python and language such as C and ST is that the Python parser recognizes block structures by their indentation. There is no `BEGIN/END` or braces `{}` to identify the blocks of `IF/ELSE` conditions, `FOR` and `WHILE` loops, or functions.

Comments start with `#` and extend to the end of the line. In the first and second line of the source code, you can set a special marker to declare the encoding of the file. We recommend that you use UTF-8 as the encoding if ASCII characters are not required.

For debugging purposes, you use `print` for easy output. With the `%` operator, you achieve functionality similar to the C function `printf()`. The output is displayed in the message view of CODESYS.
Example: print

```python
# encoding:utf-8

# defining a function with the parameter i
def do_something(i):
    # if branch
    if i>0:
        print("The value is: %i" % i)
        sum += i
        print("The new sum is: %i" % sum)
    # else if (optional, there can be none or several elif branches)
    elif i==0:
        print("The sum did not change: %i" % sum)
    # and the final else branch (also optional).
    else:
        handle_error()

# an endless while loop
while True:
    print("I got stuck forever!")
```

Everything that belongs to the same block has to be indented the same distance. The size of the indentation is irrelevant. Elements such as brackets and braces have a higher priority than indentations. Therefore, the following code segment is completely correct, even if it is written in a "poor programming style".

Example: Indentation

```python
# warning: bad style below. Kids, don't try this at home!
if foo >= bar:
    print("foobar")
else:
    print("barfoo")
```

To avoid ambiguity, you should not mix tabs and spaces in a file.

**At this time, mixing tabs and spaces gilt in Python 3 qualifies as a syntax error.**

The official Python Style Guide recommends indentation of four spaces and includes some examples of good and poor style. The Python tutorial provides a summary of coding style.

Python is "case-sensitive", similar to C and in contrast to ST. Keywords, such as `def`, `if`, `else`, and `while`, have to be lowercase (in contrast to the ST rule: keywords are uppercase). Two identifiers, such as "i" and "I", also identify two different variables.

The following keywords are reserved in Python and not permitted for use as identifiers for variables, functions, etc.: `and` | `as` | `assert` | `break` | `class` | `continue` | `def` | `del` | `elif` | `else` | `except` | `exec` | `finally` | `for` | `from` | `global` | `if` | `import` | `in` | `is` | `lambda` | `not` | `or` | `pass` | `print` | `raise` | `return` | `try` | `while` | `with` | `yield`.

Python 3 defined four other keywords: `False` | `None` | `True` | `nonlocal`. While the first three are really new, the first three were already predefined constants in Python 2 and should not be used for any other purposes.
Variables and data types

Python is a powerful, dynamically typed language -- all type information is evaluated at runtime. Variables hold references to objects, and the object knows its type, not the variable. When a programmer attempts to execute an operation that is not possible (for example, adding an integer and a string), Python throws an exception at runtime.

Consequently, there are no declarations of variables and their types. In Python, variables are created only to assign values to them. This is completely different in C and ST where types are strong and static. Every variable is declared with a type, and at compile time the compiler checks that the type and operators are permitted.

See the following examples for handling variables:

Example: Variables

```python
# assign the integer 1 to the variable i (also "creates" the variable")
i = 1

# assign the string "foobar" to the variable s
s = "foobar"

# Add 5 to the integer i - this is equivalent to i = i + 5
i += 5
# i now holds the integer 6.

# Try to add i and s - this will throw an exception when executed
# TypeError: unsupported operand type(s) for +: 'int' and 'str'
result = i + s

# variables can also be "undeclared" by deleting them.
# Further access to the variable i will throw a NameError exception,  
# as the variable does not exist any more.
del i

i += 5 # now throws an exception: NameError: name 'i' is not defined
```

All existing variables reference one value only. There is not any unassigned or uninitialized variables in Python. To express the absence of a value, Python provides a special object: `None`. In C or ST, you would use a null pointer. Its only purpose is to express "no value here", although `None` is actually an existing instance of the class `NoneType`.

Numeric types and floating points

In contrast to the dozens of integer types in IEC or C, there is only one integer type in Python. Integer types in Python do not have a fixed size. Instead, they grow as needed and are limited only by available memory.
Example: 
Integers.py

```python
from __future__ import print_function

i = 1
print(i)

j = 0x1234   # hex number, is 16#1234 in IEC and 4660 in decimal
k = 0o123    # octal number, is 8#123 in IEC and 83 decimal
l = 0b101010 # binary number, is 2#101010 in IEC and 42 in decimal
print(j, k, l)

m = (2 + 3)*10 # k is 50 now
print(m)

n = 10 ** 100 # 10 to the power of 100
print(n)
```

Resulting output:

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
</tbody>
</table>

There is also only one floating-point type in Python which is similar to the IEC data type LREAL. It provides 64-bit IEEE floating point arithmetic.

The syntax is like C-based languages for the most part:

Example: Floating-point types

```python
# A simple float...
a = 123.456

# A float containing the integral value 2
b = 2.

# Leading zeroes can be left off
c = .3 # same as 0.3

# Exponential / scientific representation
d = -123e-5
```

Two special cases are True and False, two constants that define the Boolean truth values. They behave similar to the integer values 0 and 1, except when they are converted into strings and return their names.
Example: Booleans.py

```python
# booleans behave like integers, except when converted to strings.
# The built-in function "type" can be used to query the type of a value.
print("True: ", True, type(True))
print("False: ", False, type(False))
print("1: ", 1, type(1))
print("False + 0: ", False + 0, type(False + 0))
print("True * 5: ", True * 5, type(True * 5))
```

Resulting output:

```
<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>True</td>
<td>True&lt;type 'bool'&gt;</td>
</tr>
<tr>
<td>False</td>
<td>False&lt;type 'bool'&gt;</td>
</tr>
<tr>
<td>1</td>
<td>1&lt;type 'int'&gt;</td>
</tr>
<tr>
<td>False + 0</td>
<td>False + 0&lt;type 'int'&gt;</td>
</tr>
<tr>
<td>True * 5</td>
<td>True * 5&lt;type 'int'&gt;</td>
</tr>
</tbody>
</table>
```

Strings

In IronPython, strings are always in Unicode and any length. It does not make any difference if they are enclosed in ' or " Strings can also have triple quotation marks """" or ""' , which allows for multiline string literals.

Similar to C, special characters can be excluded by means of backslash characters. As a comparison, the dollar sign ($) is used in IEC for this purpose.

There are also raw strings that have other rules for the backslash. This is practical when the string should have literal backslashes. Example: Windows file paths or regular expressions.
Example:

```python
# encoding:utf-8
from __future__ import print_function

a = "a simple string"
b = 'another string'
c = "strings may contain 'quotes' of the other type."
d = "multiple string literals" ' are concatenated ''by the
parser'''
e = "Escaping: quotes: " \" backslash: \ new line: \r\n ascii
code: \x40"
f = """"triple-quoted strings may contain newlines, "single"
"quotes' and """"multiquotes'' of the other type'""
g = "Üniçọđȩ is also possible: 北京, Москва, Αθήνα, الْقاهرة"
h = r"c:\raw\strings\retain\backslashes.txt"

# we iterate over a sequence of all the variables defined above:
for i in (a,b,c,d,e,f,g,h):
    print(i) # prints the contents of the variable
```

Resulting output:

```
ascii code: @
triple-quoted strings may contain newlines, "single"
"quotes' and """"multiquotes'' of the other type
Üniçọđȩ is also possible: 北京, Москва, Αθήνα, الْقاهرة
c:\raw\strings\retain\backslashes.txt
```

Python does not have characters types. Characters are expressed by the use of strings with a length of 1. In this way, iteration via a string, or indexing in a string, returns a single-string.

Lists and tuples (data sets)

Lists and tuples basically correspond to arrays in C and IEC, but there are some noticeable differences:

- The index access is always checked. Accessing a list or a tuple with an invalid index throws an exception.
- Both lists and tuples can contain elements of different types (also other lists and tuples). In contrast in C and IEC, arrays can contain only elements of a single type.
- Lists are dynamic, and elements can be added, removed, or replaced at any time.
- Tuples are not changeable: Once a tuple is created, it cannot be modified anymore.

Lists are created with the list() constructor. As an alternative, you can use brackets []. Tuples are created with the tuple() constructor or parentheses ().
from __future__ import print_function
print("Testing tuples and lists")

# We define a tuple with the numbers from 1 to 10:
t = (1, 2, 3, 4, 5, 6, 7, 8, 9, 10)
print("Tuple:", t)

# We can access the 6th element of the tuple.
# As in C, index counting starts with 0.
print("Element 5:", t[5])

# Subscription is more powerful using the range syntax:
print("Range[2:5]:", t[2:5]) # lower bound is inclusive, upper bound is exclusive.
print("Range[2::2]:", t[2::2]) # start with 3rd element, and print every 2nd element.
print("Range[-3:-1]:", t[-3:-1]) # Start with the 3rd last element, end just before the last element (upper bound is exclusive)
print("Range[::-1]:", t[::-1]) # negative step with - print backwards

# lists are similar to tuples...
l = [11, 12, 13, "8", t] # contains mixed types: 3 integers, a string, and the tuple defined above.
print("List:", l)

# ... but elements can be added or removed dynamically.
l.append(9) # Add a 9 to the list.
print("List with 9:", l)
del l[1] # remove the element at index 1, the 12.
print("Removed[1]:", l)
del l[1:3] # Remove the elements at index 1 and 2, the 13 and the '8'.
print("Removed[1:3]:", l)

Resulting output:

```
List: [11, 12, 13, '8', (1, 2, 3, 4, 5, 6, 7, 8, 9, 10)]
List with 9: [11, 12, 13, '8', (1, 2, 3, 4, 5, 6, 7, 8, 9, 10), 9]
List Range[3:6:2]: ['8', 9]
Removed[1]: [11, 13, '8', (1, 2, 3, 4, 5, 6, 7, 8, 9, 10), 9]
Removed[1:3]: [11, (1, 2, 3, 4, 5, 6, 7, 8, 9, 10), 9]
```

Dictionary

Python also has a hash table type (also "hashmap"). In contrast to the list, it can be indexed with any elements, for example strings. Its constructor is `dict()` and its literals are declared with braces `{}`.

The sample script `dictionaries.py` creates the output displayed below. In the last line, the script is terminated with a "KeyError" exception:
Example:

dictionaries
.-py

    from __future__ import print_function
    print("Testing dictionaries")

    # Declare a dictionary with three entries, the third being a list
    d = {1: "a", 2: "b", "my list": [1, 2, 3]}
    print(d)

    # print the value of the key 1
    print(d[1])

    # remove the value with the key "my list"
    del d["my list"]

    # Add a value 4 with the key 3
    d[3] = 4
    print(d)

    # The "get" method returns the second argument if the key cannot be found.
    print(d.get(1, 42))
    print(d.get(23, 42))

    # print all keys in the dictionary
    for key in d:
        print(key)

    # index access for unknown keys will throw a "KeyError" exception!
    print(d[23])

Resulting output:

    Testing dictionaries

    {1: 'a', 2: 'b', 'my list': [1, 2, 3]}
    a
    {1: 'a', 2: 'b', 3: 4}  
    a
    42
    1
    2
    3

    And then in the last line, the script terminates:
Python Control Structures (with Examples)

Loops

As opposed to C and ST, for loops in Python do not count loop variables, but iterate over a sequence. This kind of sequence can be a "dictionary", a list, a tuple, the characters in a string, or lines in a file.

The following example shows some for loops:
Example:

loops.py

from __future__ import print_function

print("Enumerating over a simple list:")
for i in (1,2,3,4):
    print(i, end="", "") # end= replaces the newline with ", "
print() # but we still need a newline at the end of this case.

print("Enumerating over the characters in a string:")
for i in "CODESYS": # characters are represented as strings of length 1.
    print(i, end="", ")
print()

print("Enumerating over the integers 1 to 4:")
for i in range(1, 5): # upper bound is exclusive.
    print(i, end="", ")
print()

print("Enumerating using xrange:")
for i in xrange(5): # xrange is similar to range, but needs less memory for large ranges.
    print(i, end="", ")
print()

print("Enumerating including the item number:")
for i, v in enumerate("CODESYS"):
    print(i, v)

Resulting output:

If you require an index or number in addition to the item, then you should use `enumerate` as shown in the last case of the sample script. The following code is considered as poor style:
Example: Poor style

text = "CODESYS"
for i in range(len(text)):  # BAD STYLE!
    v = text[i]             # DON'T TRY THIS AT HOME!
    print(i, v)

Besides for loops, Python also has while loops which are very similar to those in C and ST:

Example of "while" loop

i = 0
while i < 3:
    print(i)
    i += 1

Note: This example is not very practical. You would more likely use a for loop with a range.

IF / ELSE

The if/else construct is similar to those in other programming languages. Here is a short example:

Example: "if_else.py"

from __future__ import print_function
i = int(system.ui.query_string("Please enter an integral number..."))
if i < 0:
    print("Your number was negative.")
elif i > 0:
    print("Your number was positive.")
else:
    print("It seems your number was zero.")

The else branch is optional and there can be zero, one, or many elif branches.

Functions, classes, and methods

Python allows for defining functions and classes with methods. A class with methods is basically similar to a function block in ST, or classes in languages such as C++, Java, or C#. However, Python does not support interfaces.

For detailed information, see the Python documentation for defining Functions and Classes.
# Examples: Functions, classes, and methods

```python
# defining a function with name sum and two parameters a and b:
def sum(a, b):
    return a + b  # we return the sum of a and b.

# we can now call the function defined above:
print(sum(5, 7))

# Now we define a class Foo:
class Foo:
    # The class gets a method "bar".
    # Note: for methods, the first parameter is always "self" and
    # points to the current instance. This is similar to "this" in
    # ST and other languages.
    def bar(self, a, b):
        print("bar(%s,%s)" % (a,b))

# We create an instance of the class:
f = Foo()

# We call the method bar on the instance.
f.bar("some", "params")
```

---

## Modules and standard libraries

In IEC, you can import libraries for reuse by other written code. As a pendant, there is the possibility in Python of importing modules.

The **Python standard library** contains many modules for different purposes, such as:

- String processing
- Date and time handling
- Collections
- Threading
- Mathematical functions
- File handling
- Persistence
- Compression and archiving
- Database access
- Encryption services
- Network and Internet access
- Sending of emails

To create your own modules, write a Python file that defines the functions and classes that you want to provide. Save this file to the same directory as your sample script. If you name the file `mymodule.py`, then you can import it with `import mymodule`.

Here is an example of importing and using the cosine function and the pi constant from the `math` module:
from math import cos, pi
print(pi) # prints 3.14159265359
print(cos(pi)) # prints -1.0

The following contains more examples that access information about the operating system, the Python version, and the interpreter:

```python
clprint(os.environ["OS"])
from sys import platform, version, executable
print(platform)
print(version)
print(executable)
```

There is a special module `__future__` for activating new language features. Above all, it is used when Python developers introduce new functionalities that are backward compatible. These kinds of functionalities have to be activated with special "__future__ imports". One example that we use in most of our sample scripts here is the activation of the new power syntax of `print` as a function instead of a statement.

```python
# make print() a function instead of a statement
from __future__ import print_function
```

The Python documentation provides a complete list of all imports. In addition to the normal Python modules, IronPython code can also access .NET assemblies as if they were Python modules. This opens the access to the .NET framework class library and third-party libraries. Here is an example how to open a dialog by means of the Windows Forms library:

```python
import clr
clr.AddReference("System.Windows.Forms")
from System.Windows.Forms import MessageBox
MessageBox.Show("Hello")
```
Transitioning from Python 2 to Python 3

With Python version 3, Python developers introduced some incompatible changes and removed some obsolete functionalities. At this time, the Python community is still in the transitional phase from version 2 to version 3.

IronPython does not yet support Python 3, but it is being worked on. As the Python community no longer supports Python 2, we intend to upgrade to Python 3 as soon as it is supported by IronPython.

Although we strive for a smooth transition, script writers should take care that their scripts are created in a future-proof style. For example, by using the expression \texttt{from \_\_future\_\_ import print\_function}.

For more information, see: \textit{Python 2 or Python 3?} and \textit{New in Python 3}.

Comparison of IronPython and cPython

There are some small differences and Incompatibilities between IronPython and "standard" Python ("cPython"). Some are direct errors in IronPython and should be removed in future versions. However, others are considered "implementation details" and will remain. Some of them are very challenging topics.

The difference that is most obvious for users is the handling of strings. Original cPython has two different string types for "byte strings" and "Unicode strings". This concept is similar to the data types STRING and WSTRING in IEC. IronPython simply uses .NET strings that are always Unicode-capable and use UTF-16 internally. However, IronPython implements a trick to hide the difference to cPython from the programmer. (Interesting: For the new Python version 3, the developers have completely reworked their string handling. The result was a model which is much closer to IronPython. Unicode strings are always used after that and there is a separate data type for handling raw bytes)

Python modules that are written in C cannot be imported into IronPython because cPython uses internal data structures that are completely different from IronPython. Most of the standard library modules were reimplemented in IronPython. However, some modules (such as the TK interface) are not available as long as they are not ported to IronPython explicitly. On the other hand, IronPython provides access to .NET assemblies including the .NET framework (as shown above), which more than compensates for this feature.

While cPython uses reference counting and a deterministic garbage collector for cleaning up cyclic garbage, IronPython relies on the non-deterministic .NET garbage collector. In most cases, this difference does not matter. But when you open files or other resources from the Python standard library or the .NET framework, you should make sure to close them later. It is best to use the \texttt{with} statement with the Python context manager or \texttt{.NET IDisposable} instances.

For more information, see: \textit{Content Managers} and \texttt{.NET IDisposable}

6.6.11.7 Using Scripts to Access CODESYS Functionalities

All objects and command which CODESYS provides for scripting are also available in the "scriptengine" Python module. Whenever a script is started, an implicit \texttt{from scriptengine import \*} results. This allows for easy access to CODESYS. However, if your script imports modules that require access CODESYS APIs, then these modules have to import the module \texttt{scriptengine} themselves.

In the following table, you will find the main objects (categories) that can be used in Python scripts as entry points. For comprehensive documentation about entry points, see the for the CODESYS ScriptEngine.
<table>
<thead>
<tr>
<th>Objects</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>Access to general CODESYS functionalities</td>
</tr>
<tr>
<td></td>
<td>Examples:</td>
</tr>
<tr>
<td></td>
<td>● Exiting CODESYS</td>
</tr>
<tr>
<td></td>
<td>● Handling the general user interface</td>
</tr>
<tr>
<td></td>
<td>● Access to the message memory (including compiler messages)</td>
</tr>
<tr>
<td></td>
<td>● Control of delay and progress bars</td>
</tr>
<tr>
<td>projects</td>
<td>Access to the CODESYS project as an object tree that combines the three navigator views (devices, POU, modules) in one project tree</td>
</tr>
<tr>
<td></td>
<td>Also allows for the loading, creating, saving, and closing of projects</td>
</tr>
<tr>
<td></td>
<td>For most objects in a project, there are special methods with detailed functionality, for example compiling, access to ST POU, export, import, device configuration, etc.</td>
</tr>
<tr>
<td>online</td>
<td>Access to online functionalities</td>
</tr>
<tr>
<td></td>
<td>Examples:</td>
</tr>
<tr>
<td></td>
<td>● Log in to devices and applications</td>
</tr>
<tr>
<td></td>
<td>● Management of access data (user name, password)</td>
</tr>
<tr>
<td></td>
<td>● Performance of network scans</td>
</tr>
<tr>
<td></td>
<td>● Gateway management</td>
</tr>
<tr>
<td>librarymanager</td>
<td>Permits the management of library repositories and viewing, installation, and removal of libraries</td>
</tr>
<tr>
<td>device_repository</td>
<td>Handling of device repositories; import and export of device descriptions</td>
</tr>
<tr>
<td>modulerepository</td>
<td>Management of CODESYS Application Composer modules and CODESYS Application Composer repositories</td>
</tr>
</tbody>
</table>

See the following specific sample scripts for ways to access CODESYS functionalities. For detailed information, see the for the CODESYS.

**Example: Printing the device tree of the current project**

The script `PrintDeviceTree.py` is an example for navigating in a project. It creates the output of a hierarchical display of all devices in the open project.

Load a project that contains some device objects and execute the script.
Example: 
PrintDeviceTree.py

```python
# encoding:utf-8
from __future__ import print_function

# Prints out all devices in the currently open project.
print("--- Printing the devices of the project: ---")

# Define the printing function. This function starts with the
# so called "docstring" which is the recommended way to document
# functions in python.
def print_tree(treeobj, depth=0):
    """ Print a device and all its children

    Arguments:
    treeobj -- the object to print
    depth -- The current depth within the tree (default 0).

    The argument 'depth' is used by recursive call and
    should not be supplied by the user.
    """
    # if the current object is a device, we print the name and
device identification.
    if treeobj.is_device:
        name = treeobj.get_name(False)
        deviceid = treeobj.get_device_identification()
        print("{0}- {1} {2}".format("""*"""*depth, name, deviceid))
    # we recursively call the print_tree function for the child
    # objects.
    for child in treeobj.get_children(False):
        print_tree(child, depth+1)

    # We iterate over all top level objects and call the print_tree
    # function for them.
    for obj in projects.primary.get_children():
        print_tree(obj)

print("--- Script finished. ---")
```

The device tree (from the "Devices" view) is displayed in the message view and all non-device
objects are left out:
Example: Reading of variables

The script `ReadVariable.py` logs in to the device and starts the application if necessary. Then the value of the variable `PLC_PRG.iVar1` is read and output. To try the script, you have to modify the project path and variable names.

```python
# encoding:utf-8
from __future__ import print_function

# close open project if necessary:
if projects.primary:
    projects.primary.close()

# opens project
proj = projects.open(r"D:\data\projects\Ampel.project")

# set "Ampel.project" to active application
app = proj.active_application
onlineapp = online.create_online_application(app)

# login to device
onlineapp.login(OnlineChangeOption.Try, True)

# set status of application to "run", if not in "run"
if not onlineapp.application_state == ApplicationState.run:
    onlineapp.start()

# wait 1 second
system.delay(1000)

# read value of iVar1
value = onlineapp.read_value("PLC_PRG.iVar1")

# display value in message view or command line
print(value)

# log out from device and close "Ampel.project"
onlineapp.logout()
proj.close()
```

In the extension of the script `ReadVariable.py`, the script `MailVariables.py` loads variables and expressions from a recipe file and reads their current values from the controller. Then these values are written back to the same file. In addition, it uses the Python SMTP library to send an email with an attachment containing a list of all variables.

To use the script, you have to modify the paths, email address, and the name of the SMTP server to your environment.
Example:

```
MailVariables.py

# encoding:utf-8
from __future__ import print_function

# Close current project if necessary and open "ScriptTest.project"
if not projects.primary == None:
    projects.primary.close()
project = projects.open("D:\Data\projects\scriptTest.project")

# retrieve active application
application = project.active_application

# create online application
online_application = online.create_online_application(application)

# login to application.
online_application.login(OnlineChangeOption.Try, True)

# start PLC if necessary
if not online_application.application_state == ApplicationState.run:
online_application.start()

# wait 2 seconds
system.delay(2000)

# open recipe file to read values.
recipe_input_file = open("D:\Data\projects\RecipeInput.txt", "r")
watch_expressions = []
for watch_expression in recipe_input_file:
    watch_expressions.append(watch_expression.strip())
print watch_expressions

# read values from the controllerd
watch_values = online_application.read_values(watch_expressions)

# open output file to write values
recipe_output_file = open("D:\Data\projects\RecipeOutput.txt", "w")
for i in range(len(watch_expressions)):
    recipe_output_file.write(watch_expressions[i])
    recipe_output_file.write(" = ")
    recipe_output_file.write(watch_values[i])
    recipe_output_file.write("\n")

# Close files
recipe_input_file.close()
recipe_output_file.close()

# send Email
# import respective libraries
import smtplib
from email.mime.text import MIMEText

#open output file
recipe_output_file = open("D:\Data\projects\RecipeOutput.txt", "r")
mail = MIMEText(recipe_output_file.read())
```
recipe_output_file.close()

# email address sender and recipient
fromm = "info@example.com"
to = "info@example.com"

# set sender and recipient
mail["Subject"] = "Attention value has changed"
mail["From"] = fromm
mail["To"] = to

# send email
smtp = smtplib.SMTP("name of smtp server")
smtp.sendmail(fromm, [to], mail.as_string())
smtp.quit()

# logout and close application
online_application.logout()
project.close()

Example: Creating and editing of POUs

The script CreateDut.py creates the objects MyStruct, MyAlias, and MyUnion in the CODESYS project. The folder DataTypes already has to be present.
Example: User interface / Interaction with the user

In some cases, scripts have to interact with the user. We provide some simple APIs for the most common interactions. The sample script `System_UI_Test.py` shows all of the possible functions in this regard.
```python
# encoding:utf-8
from __future__ import print_function

"""Performs some tests on the messagestore and UI."""

print("Some Error, Warning and Information popups:")
system.ui.error("Fatal error: Everything is OK. :-)")
system.ui.warning("Your bank account is surprisingly low")
system.ui.info("Just for your information: 42")

print("Now, we ask the user something.")
res = system.ui.prompt("Do you like this?", PromptChoice.YesNo,
PromptResult.Yes);
print("The user selected '%s'" % res)

print("Now, the user can choose between custom options:")
res = system.ui.choose("Please choose:", ("First", 2, 7.5,
"Something else"))
print("The user selected option '%s'" % str(res)) # res is a tuple

print("Now, the user can choose several options:")
res = system.ui.select_many("Please select one or more options",
PromptChoice.OKCancel, PromptResult.OK, ("La Premiere", "The
Second", "Das Dritte"))
print("The returned result is: '%s'" % str(res)) # res is a tuple

print("Now, the user can select files and directories")
res = system.ui.open_file_dialog("Choose multiple files:",
filter="Text files (*.txt)|*.txt|Image Files(*.BMP;*.JPG;*.GIF)|
*.BMP;*.JPG;*.GIF|All files (*.*)|*.*", filter_index = 0,
multiselect=True)
print("The user did choose: '%s'" % str(res)) # res is a tuple as
multiselect is true.

res = system.ui.save_file_dialog("Choose a file to save:",
filter="Text files (*.txt)|*.txt|Image Files(*.BMP;*.JPG;*.GIF)|
*.BMP;*.JPG;*.GIF|All files (*.*)|*.*", filter_index = 0)
print("The user did choose: '%s'" % res)

res = system.ui.browse_directory_dialog("Choose a directory",
path="C:\")
print("The user did choose: '%s'" % res)

print("Now we query a single line string")
res = system.ui.query_string("What's your name?")
print("Nice to meet you, dear %s." % res)

print("Now we query a multi line string")
res = system.ui.query_string("Please tell me a nice story about
your life!", multi_line=True)
if (res):
    print("Huh, that has been a long text, at least %s
characters!" % len(res))
else:
    print("Hey, don't be lazy!")

print("Username and password prompts...")
res = system.ui.query_password("Please enter your favourite
password!", cancellable=True)
if res:
    print("Huh, it's very careless to tell me your favourite
password!")
```

password '%%s'!" % res)
else:
    print("Ok, if you don't want...")

res = system.ui.query_credentials("Now, for real...")
if res:
    print("Username '%%s' and password '%%s'" % res) # res is a
2-tuple
else:
    print("Sigh...")

Example: Manipulating the “Project Information” object

In the script ProjectInfoExample.py, we set some information in the “Project Information” object. The most important information items, such as “Title” and “Version”, have explicit properties. However, you can read and write any other information fields by means of the dictionary syntax. For example, those that are recommended for the properties of a library project.

The example below may seem somewhat unrealistic, but similar code is used in build servers that create, test, and possibly release automatic library projects and other projects. The ScriptEngine is one of the key elements for creating CI (Continuous Integration) and CD (Continuous Delivery) systems.

```python
# encoding:utf-8
from __future__ import print_function

proj = projects.load("D:\Some.library")

info = proj.get_project_info()

# Set some values
info.company = "Test Library Ltd"
info.title = "Script Test Project"
info.version = (0, 8, 15, 4711)
info.default_namespace = "testlibrary"
info.author = "Python von Scriptinger"

# some values recommended in the library toolchain
info.values['DefaultNamespace'] = "testlibrary"
info.values['Placeholder'] = "testlibrary"
info.values['DocFormat'] = "reStructuredText"

# now we set a custom / vendor specific value.
info.values['SpecialDeviceId'] = "PLC0815_4711"

# Enable generation of Accessor functions, so the IEC
# application can display the version in an info screen.
info.change_accessor_generation(True)

# And set the library to released
info.released = True;

proj.save()
```
Example: Calling external commands and importing PLCoOpenXML files

The sample script DeviceImportFromSVN.py gets a PLCoOpenXML file from an external program (in this case a SVN client) and imports it into a new created CODESYS project.

To use the script, you have to modify the paths to your environment.

```
# encoding:utf-8
# Imports a Device in PLCoOpenXML from Subversion via command line
# svn client.

# We enable the new python 3 print syntax
from __future__ import print_function

import sys, os

# some variable definitions:
SVNEXE = r"C:\Program Files\Subversion\bin\svn.exe"
XMLURL = "file:///D:/testrepo/testfolder/TestExport.xml"
PROJECT = r"D:\test.project"

# clean up any open project:
if projects.primary:
    projects.primary.close()

# Fetch the plcopenxml data from subversion.
# We'll catch the output of the program into the xmldata variable.
# The 'with' construct automatically closes the open pipe for us.
with os.popen('"' + SVNEXE + '" cat ' + XMLURL, 'r') as pipe:
    xmldata = pipe.read()

# create a new project:
proj = projects.create(PROJECT)

# import the data into the project.
proj.import_xml(xmldata, False)

# and finally save. :-(
proj.save()

print("--- Script finished. ---")
```

Advanced example: Calling a library from SVN and installing it in CODESYS

The following sample script can perform the calling and installing of a library as part of a CT (Continuous Testing) environment so that they can be tested. In addition to standard-CODESYS, the CODESYS SVN add-on also has to be installed with a valid license.
import tempfile

if projects.primary:
    projects.primary.close()

tempdir = tempfile.mkdtemp()
URL = "svn://localhost/testrepo/trunk/SvnTestLibrary/"

proj = svn.checkout(URL, tempdir, "testlibrary", as_library=True)
proj.save()

repo = librarymanager.repositories[0]
librarymanager.install_library(proj.path, repo, True)

proj.close()
6.7 Human machine interface

6.7.1 Control panels

The CP600-eCo, CP600 and CP600-Pro control panels in different screen sizes provide comprehensive HMI functions for a wide range of applications. The engineering tool Panel Builder, part of Automation Builder, ensures easy scalability on the platform of the control panels.

Application examples/ application notes

Control panels can be used with the AC500 PLCs for different purposes and different application environments. Example projects (application examples; ending with *.zip) and step-by-step instructions (application notes; ending with *.pdf) that demonstrate a specific use case can be found on the following topics:

A CP600 project can be converted to a project for control panels of the 2nd generation. The conversion procedure is described in the application note Converting a CP600 project.

Installation, licensing and configuration of the control panel runtime is described in the application note Control panel PC runtime.

How to enable and handle the runtime logging on control panels is demonstrated in the application example Control panel runtime logging.

How to dump data like trends, alarm buffers, audit trail buffers, recipes, etc. from the control panels to a network shared folder is described in the application note How to store data on a network shared folder.

Modbus RTU can be used for communication between an AC500-eCo V3 PLC and a control panel. The connection principle is described using the CP604 control panel as an example: CP604 connection via Modbus RTU.

How to upload a disk image from a control panel is described in the application note Upload disk image.

A summary of frequently asked questions related to the Boot Support Packages (BSP) and the control panels can be found in the application note FAQ on BSP.

How to check the BSP version of a CP600 HMI is described in the application note Check BSP version.

For a description of how to update the BSP in order to improve the control panel security and how to use enhanced product functionality see the application note Update BSP version.

How to update or reinstall a micro browser on an CP600-WEB control panel is described in the application note CP600-WEB and micro browser.

The control panels support web visualization via Chromium browser. How to setup and configure the Chromium browser for the usage in control panels is described in the application note Control panels and Chromium browser.

CP600 control panels contain a buzzer that can be used to give acoustic signals on certain events. The application note CP600 buzzer control describes how the buzzer can be controlled by using AC500 PLC tags on the connected PLC.
How to design and create control panel projects that comply with 21 CFR part 11 standard is described in the application note *PB610 Panel Builder 600 V2.8*.

The procedure for changing from a CP600 device to a CP600 device of the 2nd generation is described in the application example *Converting a CP600 project*. A description of the differences between both device variants can also be found in this application example.

How to connect an MQTT message broker with a CP600 is described in the application example *CP600 MQTT*.

### 6.7.2 Panel Builder interface

#### 6.7.2.1 General

This document describes HMI CP600 Control Panel configuration in Automation Builder and starting HMI configuration and programming software Panel Builder 600 from Automation Builder. The Panel Builder project created for the HMI CP600 is stored within the Automation Builder project.
### Adding desired AC500 PLC to the project

**Configuring the Symbol File**

1. In the Automation Builder device tree, right-click the “Application” node and click “Add object”

![Image of Automation Builder device tree](image1)

2. Click on “Symbol Configuration” and click “Add object”
   - A “Symbol Configuration” object is added to the “Application” node.

3. Double-click on the “Symbol Configuration” object, then click on “Build”

![Image of Symbol Configuration](image2)

   ⇒ A list of all variables in the project is generated. Single variables or groups of variables can be selected by checking the corresponding item in the list.
4. After the symbols have been configured, download the project or click “Build ➔ Generate code” in the Automation Builder to create an .xml file containing all the variables read to be imported in the Tag Editor.

6.7.2.3 Creating a Panel Builder project

Adding a panel object

1. Right-click in the Automation Builder device tree and click “Add object ➔ Panel-CP600”
2. Click on “CP600 Control Panel” and click “Add object”
   ➔ A Control Panel object is added to the Automation Builder device tree.

Starting a Panel Builder project

1. In the device tree, double-click “Panel CP600” object to start Panel CP600 screen.

2. Select the required PLC and enable the checkbox in the 'Use Standard Connection Settings' column to use it as a standard gateway connection.

You can set communication settings using the application program or by creating custom communication settings. Custom communication settings can be configured by clicking the button in the 'Details' column.

3. Enable the “Update Panel Builder project on launch” checkbox and click [Launch Panel Builder Editor].

If you update Automation Builder project with new variables and data types or if there are changes in existing Automation Builder project variables and data types (new, modified, deleted), recompile CODESYS application to refresh the symbol file, then launch Panel Builder editor.

4. Select “New” and click “Open” to create a new HMI project.
   ➔ A project wizard is displayed.

If you want to import an already existing Panel Builder project file from the file system, select “Import existing project file” and proceed.
5. Select the required panel type and orientation and click “Finish”.

The panel projects can be compared in Automation Builder using the “Compare Objects” option.
1. In the Panel project, double-click “Project properties” to change the panel type to the panel which is used.
   ⇒ The Properties dialog is displayed.

   ![Properties dialog](image)

   - Project Widget: Panel Project
   - ID: Panel Project
   - Full Path: C:\Users\Test\AppData\Local\Temp
   - Version
   - Runtime
   - Plug-in
   - Project
     - Home Page: Page1.html
     - PageWidth: 480
     - PageHeight: 272
     - Display Mode: Landscape
     - Project Type: CP604
     - Panel Memory: 2GB
     - PageRequest
     - CurrentPage
     - SyncOptions: disable
     - Hold Time (ms): 2000
     - AutorunInterval Time (ms): 250
     - Background color option: None
     - ComboBox View Mode: Context

2. In the Properties dialog, expand “Project” and click “Project Type”.
   ⇒ A project wizard dialog is displayed.
3. Select the desired panel type and click “Finish”.

### Project information

The project information view provides an overview of the Panel Builder project without opening the project. To open the project information, double-click the “Panel_CP600” object.

The project information is updated every time the Panel Builder project is edited. You can rename the Panel Builder project via context menu.

![Project information](image)

The project name is internally used as a base for the Panel Builder project file name. Therefore, the project name has to comply with general file name restrictions.
The Panel Builder project information shows the list of PLCs added to the project.

6.7.2.4 Configuring Panel Builder

Configuring communication protocols

The user can configure a panel project manually in Panel Builder editor when there is a need to create individual panel projects. Otherwise, the configuration is updated in the panel project while launching Panel Builder editor in Automation Builder.

1. In the Panel Builder project structure, double-click “Config ➔ Protocols”.
2. Click to add a protocol.
3. Select “OPC UA Client” to ensure an encrypted communication between AC500 V3 devices and the control panels. This is necessary to protect passwords and other data in terms of cyber security.

Set the IP address, port, protocol type and PLC models. Click [OK].

Importing tags

1. In the Panel project view, click “Config ➔ Tags”.
2. Select the protocol from the drop-down list and click to import tags.

If the Panel Builder contains multiple tag importers, a dialog is displayed to select the required importer type.
3. Select the symbol file which was exported to the file system.

4. In the lower part of the tag editor, mark the desired tags and click “Import Tag(s)” to import the tags to the Panel Builder project.

Attaching tags to widgets

1. In the project view, expand “Pages” and double-click Page1.

2. In the Panel Builder 600 main menu, select “View ➔ Toolbars and Docking Windows ➔ Widget Gallery”.

3. Drag-and-drop the desired widget to the page editor.
4. Right-click on the widget value and select “Attach To” to attach a tag to the widget.

5. Select the desired tag and select the desired option for the authorization “Read Only” or “Read/Write” or “Write Only”. Then, click [OK].

**Downloading a project to panel**

1. In the Panel Builder main menu, click “Run ➔ Download To Target”.
2. Select the CP600 project from the drop-down list and click “Download”.

**Importing an existing Panel Builder project**

1. In the Automation Builder device tree, right-click the Panel project and click “Import ➔ Panel Builder Project”.
   System prompts to overwrite the exiting project object data.
2. Click “Yes” to confirm.
3. Select the existing Panel Builder 600 project from the file system and click “Open”.
   ➔ The imported project is displayed.
Exporting Panel Builder project

1. In the Automation Builder device tree, right-click the Panel Builder 600 project and click “Export ➤ Panel Builder Project”.
2. Click “Browse” and select the desired location in the file system and save the project file.
   ⇒ A success message is displayed, if the project file exports successfully.

When you double-click the Panel Builder project node, the compressed information of the node is extracted into a temporary folder and then the external Panel Builder program is started. After the external Panel Builder program is closed, the corresponding Panel Builder files can be compressed back into the node and saved in the Automation Builder project.

We recommend to edit the Panel Builder project by starting Panel Builder through the Automation Builder. You can also export a Panel Builder project to the file system to edit the project by using the external Panel Builder. Then, reimport it to Automation Builder.

6.7.3 SCADA Integration

6.7.3.1 General

This document describes SCADA integration configuration in Automation Builder using zenon editor. The configured device network address information and variables are synchronized with zenon editor to avoid double entry.

The Automation Builder supports both standard and multi-user functionality.

6.7.3.2 Creating Workspace and Project

1. In the device tree, double-click “zenon_Project”.

   ⇒ To launch the zenon editor, click [Launch Zenon Editor].

   To update the zenon project with latest changes of application program, click [Update zenon project].
2. Select the required PLC and select the “Use Standard Conn. Settings” option to use as a standard gateway connection. This enables the user to use the same communication settings that Automation Builder uses to communicate to the PLC.

![The configured gateway communication settings made in Automation Builder are displayed in the column ‘Connection Type’.

As an alternative you can create custom communication settings: Deselect the “Use Standard Conn. Settings” option and click the button in the 'Details' column.

3. Click [Launch Zenon Editor] to create a new workspace and project.

![Fig. 356: Connect to zenon project](image)

If Zenon Editor is already running, then select the “Use current workspace” option.

4. Select the “Create a new workspace” option and select the file location to create a new workspace.

5. Select the “Create new project” option to create a project.

    ABB zenon editor is displayed.

![If you update or change an Automation Builder project with new variables or data types (new, modified, deleted), recompile the application to refresh the symbol file and click [Update zenon project].](image)
After creating the project and workspace in Automation Builder, it is not required to set it again for the zenon object. A double-clicking on the zenon project shows the previously configured zenon project and the workspace.

6.7.3.3 Loading existing Workspace and Project

You can load an existing workspace and project to ABB zenon supervisor.

1. In the zenon_Project screen, click [Update zenon project].
   ⇒ Connection to the zenon project dialog is displayed.
2. In the workspace area, enable “Load existing workspace” and select the location.
3. In the project area, enable “Select loaded project” and click [OK].
   ⇒ Zenon editor loads the selected existing workspace and the project.

6.7.3.4 Checking the Gateway Settings in a Zenon Project

The gateway settings configured in Automation Builder can be checked in a zenon project. The IP address configured in Automation Builder are displayed in the zenon driver configuration.

In the Project Manager structure of the zenon editor, click “Variables ➔ Drivers” to configure the driver configuration.

The “Settings” tab shows all gateway settings based on the number of configured PLCs in Automation Builder. The IP address should be similar to the project gateway settings in Automation Builder.

In the zenon project window, the Connect column should be checked to transfer the desired number of PLC connection settings to the zenon editor.
6.7.3.5 Creating a symbol configuration

Requirement: The project can be compiled without any errors.

1. Select the “Application” object in the device tree.
2. Click “Project ➔ Add Object ➔ Symbol Configuration”.
   ⇒ The “Symbol Configuration” object is added to the device tree and the objects editor opens.
3. Open the “View” menu of the editor and activate the categories of variables that should be provided in the configuration editor. Click “Build” in the symbol configuration editor.
   ⇒ All variables (according to the currently defined filter in the “View” menu) are displayed in a tree structure.
4. Select the check boxes of individual variables.

   Pay attention to the current settings (see the “Settings” button in the menu bar of the editor).

   ⇒ In the field below the menu bar of the editor, information is provided about the current situation with accompanying instructions, as well as controls for corrective actions.
5. Follow the prompt in the field below the menu bar. In the following case, this should be only the information that the modified symbol configuration is transferred with the next download or online change.
6. Click “Build Generate Code” on the CODESYS menu bar.
   ⇒ The <project name>.<device name>.<application name> .xml file is generated in the project directory.

CODESYS transmits the symbol configuration to the PLC for an application download or online change.

6.7.3.6 Updating Standard Data Types

The standard data types created in CODESYS application can be updated to the zenon project by clicking on “Update zenon project”.

Data types and variables can be updated from the desired number of PLCs configured in the zenon project of Automation Builder.
In the zenon project, double-click “Variables” and check the updated standard data type.

### 6.7.3.7 Creating Data Types

1. In the CODESYS application open the “Data types” tab. Right-click “Data types ❯ Add object” to create a new data type.
2. Enter the user defined data type name.
3. In “POUs” tab, add the user defined variable data type and compile.
   - The user defined data type is created and can be imported in the zenon editor.

**If you modify or delete the data types in CODESYS application, compile with “Rebuild all option”.**

### 6.7.3.8 Importing Data Types in zenon Editor

1. In the zenon project, click [Update zenon project] to update the data types.
2. Click “Update” to update the variables and data types to the zenon project.
   - The user defined variables and data types are imported to the zenon project.

**Fig. 357: User defined variables**
6.8 System technology

6.8.1 General

This chapter provides advanced information on the system technology of AC500 control systems from a general perspective. It provides information to link the details from the hardware descriptions (provided in the device specifications section) with detailed information on configuring/programming a corresponding library (provided in the individual library sections).

Configuration of a specific device with Automation Builder is described in the PLC configuration section.
6.8.2 System technology of CPU and overall system
6.8.2.1 Handling of remanent variables for AC500 V3 products

6.8.2.1.1 Introduction

The retain / persistent memory must be buffered by a battery TA521 for the PLCs PM56xx-2ETH. Following described functionalities are only working if a battery is inserted. Take care about the handling for TA521 battery.

- Chapter 5.2.8.2.3 “TA521 - Battery” on page 1319
- The AC500-eCo V3 PLCs, PM50xx-ETH PLCs don't need a battery.
- “Detailed data” on page 188

All operands supported by CODESYS are described in ‘Configuring I/O links’.
- Chapter 6.4.1.8 “Configuring I/O Links” on page 1835. For the memory sizes of the different CPUs, see for AC500-eCo V3 ‘Memory sizes’.
- “AC500-eCo V3 processor modules” on page 4413 and for AC500 V3 ‘Memory sizes’.
- “AC500 V3 processor modules” on page 4413.

This part of the documentation describes the declaration of remanent variables for AC500 V3 products.

Different handling of remanent variables in AC500 FW ≥V3.0.2

- No more %R memory area (use instead %M with [no_init])
- Chapter 6.8.2.1.6 “Initialization of %M variables” on page 4417
- Creating of addresses for "VAR RETAIN PERSISTENT" variables automatically by IEC Compiler

It is NOT possible to change the structure (e.g. add, delete, change order, ..) of retain / persistent variables of a project and update the project via memory card.

Up to version of SystemFW 3.4.x the boot project will be deleted (renamed into application.err) and the PLC will not load the boot project anymore. Also download of new/other project with Automation Builder fails.

Workaround:

- Automation Builder ➔ PLC Shell ➔ clearsram all ➔ retain persistent / retain area is deleted (not the %M area) ➔ application is running after reboot with initialized / retain / persistent data
- Automation Builder ➔ PLC Shell ➔ clearsram all ➔ retain persistent / retain area is deleted ➔ sram c m (clear %M) ➔ %M area is deleted ➔ reboot ➔ application is running with initialized /retain/persistent/%M data
- Automation Builder empty project ➔ Reset Origin Device ➔ retain persistent / retain area / %M area is deleted ➔ new update via SD card ➔ application is running after reboot with initialized data
- For midrange reboot without battery ➔ application is running after reboot with initialized data

The application is running with initialized persistent and/or retain after updating the application via memory card and rebooting the PLC.

In version of SystemFW 3.5.x the changed retain persistent / retain area is deleted. Application is running after reboot with initialized / retain / persistent data.

In case of trouble use the above described workaround.
### 6.8.2.1.2 Memory sizes

#### AC500-eCo V3 processor modules

<table>
<thead>
<tr>
<th>PLC type</th>
<th>system RAM disk</th>
<th>userdisk PicLogic ...</th>
<th>Retain, %M area</th>
<th>flash disk</th>
<th>memory card</th>
</tr>
</thead>
<tbody>
<tr>
<td>PM5012-x-ETH</td>
<td>Dynamically /max. 7.6 MB</td>
<td>30 MB</td>
<td>8 kB Retain and persistent 4 kB (of which 88 byte are reserved for allocation table and are not available to the user)</td>
<td>None</td>
<td>% Chapter 5.2.8.2.1 “MC5102 - Micro memory card with adapter” on page 1309</td>
</tr>
<tr>
<td>PM5032-x-ETH</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PM5052-x-ETH</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PM5072-T-2ETH(W)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PM5082-T-2ETH</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### AC500 V3 processor modules

<table>
<thead>
<tr>
<th>PLC type</th>
<th>system RAM disk</th>
<th>userdisk PicLogic ...</th>
<th>SRAM Retain, %M area</th>
<th>flash disk</th>
<th>memory card</th>
</tr>
</thead>
<tbody>
<tr>
<td>PM5630-2ETH</td>
<td>Dynamically /max. 7.6 MB</td>
<td>40 MB</td>
<td>256 kB Retain and persistent 128 kB (of which 68 byte are reserved for allocation table and are not available to the user)</td>
<td>None</td>
<td>% Chapter 5.2.8.2.2 “MC5141 - Memory card” on page 1315</td>
</tr>
<tr>
<td>PM5650-2ETH</td>
<td>Dynamically /max. 16 MB</td>
<td>246 MB (as of V3.0.x)</td>
<td>381 MB (as of V3.1)</td>
<td>285.75 (as of V3.4.0)</td>
<td>% Chapter 5.2.8.2.1 “MC5102 - Micro memory card with adapter” on page 1309</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Configuration and Programming

#### System Technology of CPU and Overall System

<table>
<thead>
<tr>
<th>PLC Type</th>
<th>System RAM Disk</th>
<th>Userdisk PlcLogic</th>
<th>SRAM Retain, %M Area</th>
<th>Flash Disk Memory Card</th>
</tr>
</thead>
<tbody>
<tr>
<td>PM5670-2ET H</td>
<td>Dynamically / max. 69 MB</td>
<td>858 MB 643.50 MB (as of V3.4.0)</td>
<td>1536 MB 1 MB retain and persistent (of which 68 byte are reserved for allocation table and are not available to the user) 512 kB %M</td>
<td>8 GB</td>
</tr>
<tr>
<td>PM5675-2ET H</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

It is not possible to use 100% of a device’s memory space. About 10% of the total available space must remain unused at any time to maintain normal device operation.

#### 6.8.2.1.3 Adding a Global List of Persistent/Retain Variables

A global list of persistent variables will be added with the standard definition for persistent variables **“VAR RETAIN PERSISTENT”** & Chapter 6.4.1.20.2.14 **“Retain Variable - RETAIN”** on page 2124 & Chapter 6.4.1.20.2.13 **“Persistent Variable - PERSISTENT”** on page 2122.

First steps:

1. Expand the object path of your PLC
2. After right click on “App” select “Add object” in the context menu.

   The window “Add object below: Application” appears.

   ![Add object window](image)

3. Select “Persistent Variables” and click [Add object].

   The object name can be chosen freely. In the application it will be reused to reference the persistent variables.
6.8.2.1.4 Declaring a new variable in global list

Declare a new variable in the window “GlobPersist”.

Afterwards the variable can be selected in the program.

In this way the persistent variable can be accessed directly.

Do not use the same persistent variable in different IEC tasks, to avoid problems with consistency.

6.8.2.1.5 Declaring a new persistent/retain variable in local POU

It is also possible to declare a persistent/retain variable in a local POU and not in the global list of persistent variables.

It is not recommended to declare a large number of persistent variables locally, due to the potentially effect to performance.
The auto-declare mechanism declares always a persistent variable locally and not in the global list. If the program will be executed, the following warning appears in the message window:

⚠️ C0244: No VAR_PERSISTENT list is part of the application to enter instance path for variable PLC_PRG new_var1

The locally declared persistent variable has to be added to the global list.

**NOTICE!**

For the initialization of a Retain/Persistent variable the value of the global list is used NOT the value of the local declaration.

For further information see "RetainPersistentExample.project".

1. Right-click in window "PersistentVars".
2. Select option "Add all instance paths".
   ✅ Afterwards the persistent variables are added.
The application can be downloaded to the PLC.

It is NOT recommended to declare a new persistent variable in the application due to performance problems.

For example PM5650-2ETH:
- 1000 DWORD ≈ 600μs additional cycle time of task.

6.8.2.1.6 Initialization of %M variables

After download or restart, all %M variables will be initialized to 0. This can be prevented by setting the "no_init" attribute.

In doing so the %M variables behave similar to the "VAR RETAIN PERSISTENT" variables.

In the example above variable "ProzMivar" has the attribute "no_init". This variable will not be initialized and keeps its last value.

The attribute "no_init" is always and only valid for the next following variable (Chapter 6.4.1.20.6.3.32 “Attribute 'noinit'” on page 2299).

The following two variables "ProzMivarField" and "ProzMivar1" will be further initialized to 0.

6.8.2.1.7 Behavior of retain variables

The declaration of the retain variables strictly follows the 3S standard (see Remanent variables (Chapter 6.4.1.20.2.14 “Retain Variable - RETAIN” on page 2124 (Chapter 6.4.1.20.2.13 “Persistent Variable - PERSISTENT” on page 2122).

For retain variables it does not matter if they are declared locally in a program or in the global variable list.

6.8.2.1.8 PLC shell command for import and export of retain/persistent variables

The syntax of the command is: sram <direction><area><path>

Supported options:

<table>
<thead>
<tr>
<th>Direction:</th>
<th>i=import, e=export</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area:</td>
<td>rp=Retain/Persistent, m=%M area</td>
</tr>
<tr>
<td>Path:</td>
<td>Any pathname</td>
</tr>
</tbody>
</table>
The file will be stored in the user partition of the PLC. This data can be imported or exported via the FTP-Server or the Files dialog in Automation Builder.

If no path is indicated, the files are saved under "PlcLogic/<ApplicationName>/<ApplicationName>.ret or .prozm".

If a path is indicated, the files are saved under or accessed via "<path>/<ApplicationName>.ret or .prozm".

A non-existing path is created with the exception of the memory card. The path for the memory card must be an existing path. On the memory card a non-existing path leads to an error message.

<table>
<thead>
<tr>
<th>Data area</th>
<th>File extension</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retain/Persistent</td>
<td>.ret</td>
<td>PlcLogic/&lt;ApplicationName&gt;/&lt;ApplicationName&gt;.ret</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;path&gt;/&lt;ApplicationName&gt;.ret</td>
</tr>
<tr>
<td>%M (memory area)</td>
<td>.prozm</td>
<td>PlcLogic/&lt;ApplicationName&gt;/&lt;ApplicationName&gt;.prozm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;path&gt;/&lt;ApplicationName&gt;.prozm</td>
</tr>
</tbody>
</table>

Examples:

<table>
<thead>
<tr>
<th>Application</th>
<th>Command</th>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>myApp</td>
<td>sram e rp</td>
<td>PlcLogic/myApp/myApp.ret</td>
</tr>
<tr>
<td></td>
<td>sram e ep data</td>
<td>data/myApp.ret</td>
</tr>
<tr>
<td>Application</td>
<td>sram i m</td>
<td>PlcLogic/Application/Application.prozm</td>
</tr>
<tr>
<td></td>
<td>sram i m data</td>
<td>data/Application.prozm</td>
</tr>
</tbody>
</table>

If the path "data" does not exist, the path is created. The path for the memory card must be an existing path. The path "sdcard/data" leads to an error message if the path "data" does not exist on the memory card.

Only if the application uses Retain or Retain/Persistent variables the command generates an output file.

**Attention!**

It is recommended to execute the PLC shell command only while PLC is in state STOP, or it is ensured that there is no write access to the %M or the Retain/Persistent area.

6.8.2.1.9 Import and export of retain/persistent variables by library functions

**General**

It is also possible to import or export the Retain/Persistent variables and the %M markers via system function calls from the PLC Application. The required system functions are implemented in the IEC library ABB_IntUtils_AC500.library.

It provides the following functions or function blocks:
• **SRAM_IMPORT**
  - Chapter 6.8.2.1.9.2 “SRAM_IMPORT” on page 4419

• **SRAM_EXPORT**
  - Chapter 6.8.2.1.9.3 “SRAM_EXPORT” on page 4419

• **SRAM_CLEARED**
  - Chapter 6.8.2.1.9.4 “SRAM_CLEARED” on page 4419

**SRAM_IMPORT**

The function block **SRAM_IMPORT** is used to import the %M markers and the Retain/Persistent variables from the specified files in the userdisk.

- Import only those %M markers and/or Retain/Persistent variables that are compatible to the application running in the PLC.

- It is recommended to import only when the %M and/or the Retain/Persistent area is not accessed by the application. Otherwise inconsistencies are possible.

For a complete description of the function block see **ABB_IntUtils_AC500.library**.

**SRAM_EXPORT**

The function block **SRAM_EXPORT** is used to export the %M markers and the Retain/Persistent variables to the specified files in the userdisk.

- Export only those %M markers and/or Retain/Persistent variables that are compatible to the application running in the PLC.

- It is recommended to export only when the %M and/or the Retain/Persistent area is not accessed by the application. Otherwise inconsistencies are possible.

For a complete description of the function block see **ABB_IntUtils_AC500.library**.

**SRAM_CLEARED**

The Function **SRAM_CLEARED** is used to check if the SRAM was deleted.

For a complete description of the Function see **ABB_IntUtils_AC500.library**.
6.8.2.2 System processing

6.8.2.2.1 System start-up / Program processing

Definitions: PLC system start-up

Cold start

The AC500-eCo V3 does not use a battery for buffering the operand areas specified below, hence the "cold start" mode does not exist in this product.

- A cold start is performed by switching power OFF/ON if no battery is connected.
- All RAM memory modules are checked and erased ⇒ Chapter 6.4.1.21.3.7.10 “Command 'Reset Cold'” on page 2633.
- If no user program is stored in the Flash EPROM, the default values (as set on delivery) are applied to the interfaces.
- If there is a user program stored in the Flash EPROM, it is loaded into RAM.
- The default operating modes set by the PLC configuration are applied.

Warm start

- A warm start is performed by switching power OFF/ON with a battery connected.
- All RAM memory modules are checked and erased except of the buffered operand areas and the RETAIN variables ⇒ Chapter 6.4.1.21.3.7.11 “Command 'Reset Warm'” on page 2634.
- If there is a user program stored in the Flash EPROM, it is loaded into RAM.
- The default operating modes set by the PLC configuration are applied.
- By booting the CPU the connected IO modules are re-initialized and parameterized, therefore the IO output fails for a short time.

RUN -> STOP

- RUN -> STOP means pressing the RUN function key on the PLC while the PLC is in run mode (AC500 PLC display "run", AC500-eCo PLC "RUN LED" is ON).
- If a user program is loaded into RAM, execution is stopped.
- The behavior of outputs in stop state is configurable. Double click on PLC_AC500_V3 in the project tree. In the "PLC_AC500_V3" tab click on "PLC Settings".
  - To activate update of I/O while in stop state, click the checkbox left of "Update I/O while in stop".
  - To specify the behavior of the outputs in stop state, select an option in the pull down menu right of "Behavior for outputs in stop". Options are:
    “Keep current values”
    “Set all outputs to default”
    “Execute program” (If the “Execute program” option is selected, the “Input Assistant” must be opened via the […] button and a program must be selected which is executed exactly once.)
- Variables keep their current values, i.e., they are not initialized.
- The AC500 PLC display changes from "run" to "StoP", AC500-eCo "RUN LED" changes from ON to OFF.
START -> STOP
- START -> STOP means stopping the execution of the user program in the PLC’s RAM using the menu item “Online/Stop” in the programming system.
- The behavior of the outputs in stop state is configurable. Double click on PLC_AC500_V3 in the project tree. In the “PLC_AC500_V3” tab click on “PLC Settings”.
  - To activate update of I/O while in stop state, click the checkbox left of “Update I/O while in stop”.
  - To specify the behavior of the outputs in stop state, select an option in the pull down menu right of “Behavior for outputs in stop”. Options are:
    - “Keep current values”
    - “Set all outputs to default”
    - “Execute program” (If the “Execute program” option is selected, the “Input Assistant” must be opened via the [...] button and a program must be selected which is executed exactly once.)
- Variables keep their current values, i.e., they are not initialized.
- The AC500 PLC display changes from “run” to “StoP”.

Reset
- Performs a START -> STOP process.
- Preparation for program restart, i.e., the variables (VAR) (exception: RETAIN variables) are set to their initialization values.
- Reset is performed using the menu item “Online/Reset” in the programming system or pressing the function key RUN for ≥ 5 s in STOP mode.

Reset (cold)
- Performs a START -> STOP process.
- Preparation for program restart, i.e., the variables (VAR) (also RETAIN variables) are set to their initialization values.
- Reset (cold) is performed using the menu item “Online/Reset (cold)” in the programming system.

Reset (original)
- Resets the controller to its original state (deletion of Flash, SRAM (%M, area, %R area, RETAIN, RETAIN PERSISTENT), Communication Module configurations and user program!).
- Reset (original) is performed using the menu item “Online/Reset (original)” in the programming system.

STOP -> RUN
- STOP -> RUN means short pressing the RUN function key on the PLC while the PLC is in STOP mode (AC500 PLC display “StoP”, AC500-eCo “RUN LED” is ON). “RUN LED” is OFF of the toggle switch of an AC500-eCo CPU.
- If a user program is loaded into RAM, execution is continued, i.e., variables will not be set to their initialization values.
- The AC500 PLC display changes from “StoP” to “run”, AC500-eCo “RUN LED” changes from OFF to ON.

STOP -> START
- STOP -> START means continuing the execution of the user program in the PLC’s RAM using the menu item “Online/Start” in the programming system.
- If a user program is loaded into RAM, execution is continued, i.e., variables will not be set to their initialization values.
- The AC500 PLC display changes from “StoP” to “run”, AC500-eCo PLC “RUN LED” changes from OFF to ON.

Download
- Download means loading the complete user program into the PLC’s RAM. This process is started by selecting the menu item “Online/Download” in the programming system or after confirming a corresponding system message when switching to online mode (menu item “Online/Login”).
- Execution of the user program is stopped.
In order to store the user program to the Flash memory, the menu item "Online/Create boot project" must be called after downloading the program.

- Variables are set to their initialization values according to the initialization table.
- RETAIN variables can have wrong values as they can be allocated to other memory addresses in the new project!
- A download is forced by the following:
  - changed PLC configuration
  - changed task configuration
  - changed library management
  - changed compile-specific settings (segment sizes)
  - execution of the commands "Project/Clean all" and "Project/Rebuild All".

**Online change**

- After a project has changed, only these changes are compiled when pressing the key <F11> or calling the menu item "Project/Build". The changed program parts are marked with a blue arrow in the block list.
- The term Online Change means loading the changes made in the user program into the PLC's RAM using the programming system (after confirming a corresponding system message when switching to online mode, menu item "Online/Login").
- Execution of the user program is not stopped. After downloading the program changes, the program is re-organized. During re-organization, no further online change command is allowed. The storage of the user program to the Flash memory using the command "Online/Create boot project" cannot be initiated until re-organization is completed.
- Online Change is not possible after:
  - changes in the PLC configuration
  - changes in the task configuration
  - changes in the library management
  - changed compile-specific settings (segment sizes)
  - performing the commands "Project/Clean all" and "Project/Rebuild All".

**Data buffering**

- Data buffering, i.e., maintaining data after power ON/OFF, is only possible, if a battery is connected for AC500 CPU and the buffering will take place in FLASH with AC500-eCo V3 CPU. The following data can be buffered completely or in parts:
  - Data in the addressable flag area (%M area)
  - RETAIN variable
  - PERSISTENT variable (number is limited, no structured variables)
  - PERSISTENT area (%R area)
- In order to buffer particular data, the data must be excluded from the initialization process. See Chapter 6.8.2.1 "Handling of remanent variables for AC500 V3 products" on page 4412.

**Start of the user program**

The user program (UP) is started according to the following table. It is assumed that a valid user program is stored to the Flash memory. See Chapter 5.2.9.4 "Storage device details" on page 1336.
<table>
<thead>
<tr>
<th>Action</th>
<th>No memory card with UP installed</th>
<th>No memory card with UP installed</th>
<th>Memory card with UP installed</th>
<th>Memory card with UP installed</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Auto run = ON</td>
<td>Auto run = OFF</td>
<td>Auto run = ON</td>
<td>Auto run = OFF</td>
</tr>
<tr>
<td>Voltage ON</td>
<td>UP is loaded from Flash into RAM and started from Flash.</td>
<td>No UP is loaded from Flash. When logging in, the message &quot;No program available in the controller ...&quot; is displayed.</td>
<td>UP is loaded from the memory card into Flash memory and then started from RAM.</td>
<td>UP is loaded from the memory card to the Flash memory. RAM remains empty. When logging in, the message &quot;No program available in the controller ...&quot; is displayed.</td>
</tr>
<tr>
<td>or Warm start or Cold start</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>STOP -&gt; RUN</td>
<td>UP in RAM is started.</td>
<td>UP in RAM is started.</td>
<td>UP in RAM is started.</td>
<td>UP in RAM is started.</td>
</tr>
<tr>
<td>STOP -&gt; START</td>
<td>UP in RAM is started.</td>
<td>UP in RAM is started.</td>
<td>UP in RAM is started.</td>
<td>UP in RAM is started.</td>
</tr>
<tr>
<td>Download 1)</td>
<td>The UP currently stored in the CPU's RAM is stopped. The built UP is loaded from the PC into the PLC's RAM.</td>
<td>The built UP is loaded into the PC into the PLC's RAM.</td>
<td>The UP currently stored in the CPU's RAM is stopped. The built UP is loaded from the PC into the PLC's RAM.</td>
<td>The built UP is loaded from the PC into the PLC's RAM.</td>
</tr>
<tr>
<td>Online Change 2)</td>
<td>Processing of the UP currently stored in the CPU's RAM is continued. The changes made to the UP are loaded from the PC into the PLC's RAM. The UP is reorganized and processed.</td>
<td>The changes made to the UP are loaded from the PC into the PLC's RAM. The UP is reorganized.</td>
<td>Processing of the UP currently stored in the CPU's RAM is continued. The changes made to the UP are loaded from the PC into the PLC's RAM. The UP is reorganized and processed.</td>
<td>The changes made to the UP are loaded from the PC into the PLC's RAM. The UP is reorganized.</td>
</tr>
</tbody>
</table>

Remarks:

1): After the download is completed, the program is not automatically stored to the Flash memory. To perform this, create a boot project \( \text{\textsuperscript{a}} \) Chapter 6.4.1.11.7 “Generating boot applications” on page 1978. If the UP is not stored to the Flash memory, the UP is reloaded from the Flash memory after voltage OFF/ON. Start the program either by pressing the RUN/STOP function key or using Automation Builder.

2): After the online change process is completed, the program is not automatically stored to the Flash memory. For this, after reorganization is completed create a boot project. During reorganization and flashing, no further online change command is allowed. If the UP is not stored to the Flash memory, the UP is reloaded from the Flash memory after voltage OFF/ON. If the UP is not stored to the Flash memory, the UP is reloaded from the Flash memory after voltage OFF/ON. If the UP is not stored to the Flash memory, the UP is reloaded from the Flash memory after voltage OFF/ON.
User flash memory for AC500 V3 products

AC500 processor modules for V3 products (PM56xx) are equipped with non-removable and non-volatile onboard user flash memory for program and data storage. The integrated flash management, including a wear levelling algorithm and a power-fail protected file system, is designed for robustness and operation in industrial environments and applications. The user flash memory can be accessed from the user program using the CAA_File library.

NOTICE!
The user flash memory has a finite number of write cycles.

Important: Programmers should keep the amount of cyclic written data low to ensure long availability.

Health monitoring

AC500 V3 products are equipped with non-removable and non-volatile onboard user flash memory for program and data storage. The integrated flash management, including a wear levelling algorithm and a power-fail protected file system, is designed for robustness and operation in industrial environments and applications.

Keep the amount of cyclic written data low to assure long availability of the user flash memory. The spent/remaining lifetime information of the user flash memory can be acquired with the function block PmDiskStatus and PmDiskLife-timeUsed.

Further information is provided in the documentation of the AC500_Pm library.

Since FW version 3.3.0, there is also a diagnosis message issued when the user flash memory reaches the end of its lifecycle. Please refer to the diagnosis documentation for more info.

PID controller

Using PID function blocks, such as HaModPidFixCycle, a PID controller can be configured and used in AC500 PLCs. The procedure is described in the application note PID - function block.

Task configuration

General

This statement is applicable to PM5032-x-ETH, PM5052-x-ETH, PM5072-T-2ETH(W) and PM5082-T-2ETH.

If the main task cycle is faster than 10 ms, remove the onboard inputs I8..I11 and I/O channels of option boards or option boards for serial communication from the main task cycle, but use a separate task cycle.
The task model processes the following kind of tasks:

- Non-real-time system tasks: system tasks with no real-time property (e.g. file access, Ethernet communication, OPC UA, …)
- Non-real-time IEC tasks: IEC tasks with no real-time property
- Real-time system tasks: system tasks with real-time property
- Real-time IEC tasks: IEC tasks with real-time property

The possible number of tasks depends on the type of processor module. How to distribute the IEC tasks over multiple CPU cores and on how to use the IEC task configuration for Automation Builder is described in detail in the CODESYS task configuration section.

- Task configuration Chapter 6.4.1.9.17 “Task Configuration” on page 1914
- Tab 'Configuration' Chapter 6.4.1.21.2.30.2 “Tab 'Configuration’” on page 2538

**Watchdog handling in IEC tasks**

If a new project is created or a new task is inserted in the task configuration Chapter 6.4.1.9.17 “Task Configuration” on page 1914, the task is created with the “default task settings” priority = 15 and cycle time = 10 ms. The watchdog is activated, set to 20 ms and sensitivity = 1.

The watchdog handling depends also on the setting of the CPU parameter “Missed cycle behavior”:

This parameter configures the behavior of a real-time task if the processing time of the task is longer than the cycle time.

- “Next” means – skip the missed cycle and start the task on the next cycle on time. This might result in skipped tasks, but at least the highest priority task is always started on time, if it is not skipped (= default value).
- “ASAP” means - start the task immediately when possible.
This parameter is valid for all real-time tasks (priorities 0 ... 15) of the PLC application.

Example 1: default task settings, $t_{\text{Task}}$ – processing time of the task in [ms]

<table>
<thead>
<tr>
<th>$t_{\text{Task}}$</th>
<th>Par.</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Next</td>
</tr>
<tr>
<td>12</td>
<td>ASAP</td>
</tr>
<tr>
<td>12</td>
<td>Next</td>
</tr>
</tbody>
</table>

No watchdog occurs, also if the processing time of the task is longer than the cycle time (cases 2 and 3) since the processing time is shorter than the watchdog time.

Example 2: default task settings, $t_{\text{Task}}$ – processing time of the task 24 ms, $S_{\text{WD}}$ – sensitivity of the watchdog

<table>
<thead>
<tr>
<th>$S_{\text{WD}}$</th>
<th>Par.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Next</td>
</tr>
<tr>
<td>3</td>
<td>ASAP</td>
</tr>
<tr>
<td>3</td>
<td>Next</td>
</tr>
</tbody>
</table>

Watchdog occurs in all 3 cases since the processing time of the task is longer than the watchdog time. According to the setting of the sensitivity the watchdog occurs after 1 or 3 cycles.

Beside the task watchdog there is the so-called "omitted cycle watchdog" (OMCW). The omitted cycle watchdog is only active if a watchdog has been configured for the task.

The "normal" Watchdog triggers only if the processing time of the task exceeds the set Watchdog value.

The omitted cycle watchdog on the other hand checks completely "failed" cycles. E.g. if the scheduler has a problem and the task never executes its cycle again, then the "normal" watchdog will not be triggered. Therefore, the run time does an additional check, if a task has been executed within the double cycle time or the double watchdog time (the bigger of both is valid). If not, the omitted cycle watchdog is triggered.

Example 3: default task settings, $t_{\text{Task}}$ – processing time of the task in ms, $C_{\text{lost}}$ - lost cycles

<table>
<thead>
<tr>
<th>$t_{\text{Task}}$</th>
<th>$C_{\text{lost}}$</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>3 ... 6</td>
</tr>
<tr>
<td>12</td>
<td>3 ... 6</td>
</tr>
<tr>
<td>$\infty$</td>
<td>2ff</td>
</tr>
</tbody>
</table>
Omitted cycle watchdog occurs after double watchdog time (2 x 20 ms = 40 ms).

Example 4: Two tasks with following settings:

<table>
<thead>
<tr>
<th>Task</th>
<th>Priority</th>
<th>Cycle time [ms]</th>
<th>Watchdog time [ms]</th>
<th>Sensitivity</th>
<th>Parameter</th>
<th>Task processing time [ms]</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10</td>
<td>10</td>
<td>20</td>
<td>1</td>
<td>Next</td>
<td>6</td>
</tr>
<tr>
<td>2</td>
<td>15</td>
<td>50</td>
<td>50</td>
<td>1</td>
<td></td>
<td>30</td>
</tr>
</tbody>
</table>

Watchdog of task 2 is triggered since the task cannot run in the defined task cycle.

Example 5: Two tasks with following settings:

<table>
<thead>
<tr>
<th>Task</th>
<th>Priority</th>
<th>Cycle time [ms]</th>
<th>Watchdog time [ms]</th>
<th>Sensitivity</th>
<th>Parameter</th>
<th>Task processing time [ms]</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10</td>
<td>10</td>
<td>20</td>
<td>1</td>
<td>ASAP</td>
<td>12</td>
</tr>
<tr>
<td>2</td>
<td>15</td>
<td>30</td>
<td>60</td>
<td>1</td>
<td></td>
<td>6</td>
</tr>
</tbody>
</table>

Watchdog of task 2 is triggered since the task cannot start in the defined task cycle.

Example 6: Two tasks with following settings:

<table>
<thead>
<tr>
<th>Task</th>
<th>Priority</th>
<th>Cycle time [ms]</th>
<th>Watchdog time [ms]</th>
<th>Sensitivity</th>
<th>Parameter</th>
<th>Task processing time [ms]</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10</td>
<td>10</td>
<td>20</td>
<td>1</td>
<td>Next</td>
<td>12</td>
</tr>
<tr>
<td>2</td>
<td>15</td>
<td>30</td>
<td>60</td>
<td>1</td>
<td></td>
<td>6</td>
</tr>
</tbody>
</table>
No watchdog is triggered, but task 1 is running in 20 ms cycle instead of configured 10 ms cycle. Task 2 is running alternating every 20 ms or 40 ms.

PLC utilization
General

The parameters `cpuload` and `plcload` represent the actual CPU load or PLC load of the system.

- `cpuload`: This value represents the time the PLC requires to calculate all processes running on the PLC. For a good system performance this value should be less than 80%. In case of a higher value, the degree of utilization should be reduced by using a more powerful PLC or by reducing the amount of processes.
- `plcload`: This value represents the time the PLC requires to calculate all real-time processes. Real-time processes are either high priority system tasks or IEC tasks with a priority between 0 and 15. For a good system performance this value should be less than 60%. In case of a higher value, the degree of utilization should be reduced by using a more powerful PLC.

During commissioning we recommend to monitor the CPU and PLC values online with one of the following methods:

**Automation Builder**
- Commissioning via 'PLC shell commands' ⇨ Chapter 6.9.2.4.4 “PLC shell commands” on page 4647 (command 'plcload' and 'cpuload').
- Commissioning via ‘Application at runtime’ ⇨ Chapter 6.4.1.13.3 “Data Recording with Trace” on page 2007. In order to display the load of the CPU or PLC, create a new Device Trace object in your PLC project. Then upload the data into the views 'Command 'Upload Trace' ⇨ Chapter 6.4.1.21.3.22.19 “Command ‘Upload Trace’” on page 2742.

**IEC applications/IEC program**
To access the parameters `plcload` and `cpuload` please use system functions as follows:
- `plcload`: `SchedGetProcessorLoad()` included in library ‘CmpSchedule’.
- `cpuload`: `SysMCGetLoad()` included in library ‘SysCpuMultiCore’.
Managing priorities by selecting the appropriate communication schema

The AC500 V3 PLCs have an integrated preemptive real-time operating system that supports 100 priorities from 0 (lowest priority) to 99 (highest priority). Hereof 0 ... 49 in the non-real-time area and 50 ... 99 in the real-time area.

For real-time tasks in the IEC user program 16 priorities 0 (highest priority) ... 15 (lowest priority) can be used. They correspond to the operating system priorities 67 (for IEC task priority 0) ... 52 (for IEC task priority 15).

The file system, the memory card and flash tasks run on lowest real-time priority 50.

The non-real-time IEC task priority 16 runs in the non-real-time area. Likewise, all Ethernet protocols and the diagnosis system run in the non-real-time area.

As of Automation Builder 2.4.1 and “SystemFW” 3.4.1 provides a new PLC boot parameter Communication Schema (non-real time vs. real-time Ethernet data) for AC500 V3:

- **Name:** “Default”  
  Description: Balanced priority for communication via communication modules (CMs) and onboard Ethernet communication.  
  § Further information on page 4429

- **Name:** “Communication modules”  
  Description: Priority and high performance for communication module (CM) based communication via sync tasks. Lower priority for onboard Ethernet and I/O bus.  
  § Further information on page 4430

- **Name:** “Onboard Ethernet”  
  Description: Priority for onboard Ethernet communication (e. g. via Modbus TCP). Lower priority for communication via communication modules (CMs)  
  § Further information on page 4431

- **Name:** “Realtime onboard Ethernet”  
  Description: Very high priority for onboard Ethernet communication (e. g. EtherCAT, PROFINET, Ethernet/IP). Low priority for communication via communication modules (CMs)  
  § Further information on page 4431

The value “Realtime onboard Ethernet” is reserved for later use and has currently the same settings as “Onboard Ethernet” and in addition the I/O bus on the same priority as the Ethernet.

In version of “SystemFW” 3.5.0 the priority of onboard CAN interface has been adapted and is now included in the priority schemas.

In addition the parameter Communication Schema is now also available for the eCo-V3 PLCs.

The „Default“ priority schema in “SystemFW” 3.4.1

The default value of the boot-parameter Communication Schema is the balanced priority for communication via communication modules (CMs) and onboard Ethernet communication. The following figure gives an overview about the main task priorities in the AC500 V3 PLCs.
The highest IEC task priority 0 should be used for high prior functions in the PLC with short execution time.

The communication modules interrupts (CM5xx), the I/O bus, the IEC scheduler observer task and the CAA event task are processed with higher priority than all user IEC tasks.

Ethernet runs on non-real-time priority.

The default setting of the priorities is suitable for most applications and corresponds to the settings in the firmware versions 3.4.0 and before.

The “Communication modules” priority schema in “SystemFW” 3.4.1

The communication modules priority schema has been established for priority and high performance for communication module (CM) based communication via sync tasks. Lower priority for onboard Ethernet and I/O bus.
The highest IEC task priority 0 should be used for the sync task of the highest priority communication module, e.g. CM579-ETHCAT, priority 1 for the sync task with second highest priority, and so on.

Only the communication modules interrupts (CM5xx) and the CAA event task is processed with higher priority than the IEC tasks.

The IEC scheduler observer task has been moved to priority 66, means below IEC task priority 0 and on the same level as IEC task priority 1.

The priority of the I/O bus has been moved to priority 59, means inside the IEC task priority area, but below the external event task priorities.

Ethernet runs on non-real-time priority.

The priority schema communication module should be used in applications with one or more communication modules CM5xx with sync mode. As of Automation Builder 2.4.1 these are the CM579-ETHCAT EtherCAT master and CM598-CN CANopen master communication modules.

The sync task with priority 0 will be interrupted only by system interrupts. Since the IEC scheduler observer task is located below IEC priority 0, the watchdog for this task is also ineffective. However, this should not interfere with a sync task.

If more than one CM5xx are used in sync mode, the priority order must be defined. The sync task of highest priority CM5xx receives IEC priority 0, the next priority 1 and so on.

In a mixed PLC configuration with communication modules with and without sync mode the interrupts of the communication modules without sync mode will be handled on the priority of the lowest sync task. Currently supported communication modules without sync mode are CM579-PNIO PROFINET IO controller and SM560-S Safety PLC.

The “Onboard Ethernet” priority schema in “SystemFW” 3.4.1

The “Onboard Ethernet” priority schema has been established for priority for onboard Ethernet communication (e.g. via Modbus TCP).
The Ethernet interrupt task has been moved from non-real-time area to priority 59, means inside the IEC task priority (real-time) area, but below the external event task priorities.

This priority schema should be used for applications with much Ethernet communication, e.g. Modbus TCP communication with a high number of Modbus TCP clients/servers.

**NOTICE!**

Since the Ethernet interrupt task is running in this mode in the real-time priority area, the Ethernet communication can block IEC tasks with priorities 12-15.

Working with real-time priority at onboard Ethernet and using a high number of Modbus TCP client connections can force high CPU load. To avoid this, it is recommended to call the Modbus function blocks in steps.

**Example**

100 Modbus TCP client connections shall be used in a 20 ms task.
Call 20 function blocks in a first cycle, 20 function blocks in a second cycle and so on.
The "Default" priority schema in "SystemFW" 3.5.0

The default value of the boot-parameter Communication Schema is the balanced priority for communication via communication modules (CMs) and onboard Ethernet communication.

The following figure gives an overview about the main task priorities in the AC500 V3 midrange PLCs in version "SystemFW" 3.5.0.

The highest IEC task priority 0 should be used for high prior functions in the PLC with short execution time.

The communication modules interrupts (CM5xx), the I/O bus, the IEC scheduler observer task and the CAA event task are processed with higher priority than all user IEC tasks.

Ethernet runs on non-real-time priority.

The CAN onboard interrupt is moved from non-real-time priority to real-time priority 69, one priority above the CAN transmit and receive threads.
The default setting of the priorities is suitable for most applications and corresponds to the settings in the firmware versions 3.4.0 and before.

The “Communication modules” priority schema in “SystemFW” 3.5.0

The communication modules priority schema has been established for priority and high performance for communication module (CM) based communication via sync tasks. Lower priority for onboard Ethernet and I/O bus.

The highest IEC task priority 0 should be used for the sync task of the highest priority communication module, e.g. CM579-ETHCAT, priority 1 for the sync task with second highest priority, and so on.

Only the communication modules interrupts (CM5xx) and the CAA Event task is processed with higher priority than the IEC tasks.

The IEC scheduler observer task has been moved to priority 66, means below IEC task priority 0 and on the same level as IEC task priority 1.

The priority of the I/O bus has been moved to priority 59, means inside the IEC task priority area, but below the external event task priorities.

The CAN onboard interrupt has the same priority as the I/O bus and the CAN transmit and receive threads one priority below, means 58.

Ethernet runs on non-real-time priority.

The priority schema communication module should be used in applications with one or more communication modules CM5xx with sync mode. As of Automation Builder 2.4.1 these are the CM579-ETHCAT EtherCAT master and CM598-CN CAN master communication modules.

The sync task with Prio 0 will be interrupted only by system interrupts. Since the IEC scheduler observer task is located below IEC Prio 0, the watchdog for this task is also ineffective. However, this should not interfere with a sync task.

If more than one CM5xx are used in sync mode, the priority order must be defined. The sync task of highest priority CM5xx receives IEC Prio 0, the next Prio 1 and so on.

In a mixed PLC configuration with communication modules with and without sync mode the interrupts of the communication modules without sync mode will be handled on the priority of the lowest sync task. Currently supported communication modules without sync mode are CM579-PNIO PROFINET IO controller and SM560-S safety PLC.

The “Onboard Ethernet” priority schema in “SystemFW” 3.5.0

The “Onboard Ethernet” priority schema has been established for priority for onboard Ethernet communication (e.g. via Modbus TCP).

3.5.0 Communication modules

Configuration and programming
System technology > System technology of CPU and overall system
The Ethernet interrupt task has been moved from non-real-time area to priority 59, means inside the IEC task priority (real-time) area, but below the external event task priorities.

The CAN onboard interrupt is moved one priority below the Ethernet interrupt to priority 58 and the CAN transmit and receive threads one priority below the CAN onboard interrupt to priority 57.

This priority schema should be used for applications with much Ethernet communication, e.g. Modbus TCP communication with a high number of Modbus TCP clients/servers.

**NOTICE!**

Since the Ethernet interrupt task is running in this mode in the real-time priority area, the Ethernet communication can block IEC tasks with priorities 12-15.

Working with real-time priority at Onboard Ethernet and using a high number of Modbus TCP client connections can force a high CPU Load. To avoid this, we recommend calling the Modbus FB’s in steps.

**Example**

100 Modbus TCP client connections shall be used in a 20 ms task.

Call 20 function blocks in a first cycle, 20 function blocks in a second cycle and so on.
Communication schema onboard Ethernet/EtherCAT

General

Due to the broad variety of functionality which can run in parallel on AC500 V3 PLCs, it is recommended, or even mandatory depending on the desired functionality, to adjust system behavior to better match the needs of the individual application.

Due to hardware limitations and constraints, it’s necessary to prioritize functionality, especially if it’s intended to execute multiple features in parallel. Prioritizing can be very difficult due to the complexity of the underlying software components. Besides of task priorities, it might also be necessary to adjust low level system configuration to achieve the best possible performance for a specific feature.

To reduce complexity, and thus the risk of negative side-effects the CPU parameter Communication schema has been introduced. This parameter enables the user to specifically define the primary purpose of the corresponding PLC and lay focus on a specific functionality.

The following table shows the available communication schemas for both, PM50xx eCo and PM56xx PLCs.

<table>
<thead>
<tr>
<th>Schema</th>
<th>PM50xx</th>
<th>PM56xx</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td></td>
<td></td>
<td>Balanced priority for communication via communication modules (CMs) and onboard Ethernet communication.</td>
</tr>
<tr>
<td>Chapter 6.8.2.2.1.8.2</td>
<td>X</td>
<td>X</td>
<td>“Communication schema “Default”” on page 4438</td>
</tr>
<tr>
<td>Communication modules</td>
<td>-</td>
<td>X</td>
<td>Priority and high performance for communication module (CM) based communication via sync tasks. Lower priority for onboard Ethernet and I/O bus.</td>
</tr>
<tr>
<td>Chapter 6.8.2.2.1.8.3</td>
<td></td>
<td></td>
<td>“Communication schema “Communication modules”” on page 4439</td>
</tr>
</tbody>
</table>
### Priority classifications and their purpose

The functionality prioritized by each communication schema is grouped into 3 different classes:

- **High priority real-time functionality**
- **IEC tasks with real-time priority**
- **Low priority non-real-time functionality**

### High priority real-time functionality

Functionality with strict timing requirements, e.g., drivers with hardware access or hardware watchdog monitoring failures might lead to exception errors, loss of communication with hardware and other problems which are non-recoverable and might cause a stop of the user application.

Functionality of this class can’t be influenced by activity of user defined IEC tasks. As a result of this, related functionality can interrupt or delay IEC tasks and therefore increase IEC task jitter and the duration of IEC task cycles.

---

<table>
<thead>
<tr>
<th>Schema</th>
<th>PM50xx</th>
<th>PM56xx</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Onboard Ethernet</td>
<td>X</td>
<td>X</td>
<td>Priority and high performance for communication module (CM) based communication via sync tasks. Lower priority for onboard Ethernet and I/O bus.</td>
</tr>
<tr>
<td>Onboard EtherCAT</td>
<td>X</td>
<td>X</td>
<td>Very high priority for onboard Ethernet communication (e.g. EtherCAT, PROFINET, EtherNet/IP). Low priority for communication via communication modules (CMs).</td>
</tr>
</tbody>
</table>

Changing communication schema might have significant impact on the behavior of the user application and should therefore only be done if,

- a feature is configured which relies on a specific schema (e.g., onboard EtherCAT).
- there’s need of optimization of system behavior in terms of performance (decrease of reaction times, increase of throughput etc.).

Note that the increase of flexibility and freedom comes with an increase of responsibility because IEC task configuration and IEC user code might block important system functionality for too long. The following provided information should help to identify appropriate settings to prevent runtime errors like timeout exceptions or communication problems.
**IEC tasks with real-time priority**

This is the priority range of user defined real-time IEC tasks. Priorities 0 to 15 are real-time priorities (IEC priority 16 is mapped to non-real-time priority) and can be used to define an IEC task’s priority in Automation Builder.

Task in this range can be interrupted or delayed by high priority functionality. It’s not possible for IEC user code to suppress high priority activity, thus increasing safety and reducing the risk of negative side effects caused by bugs in IEC user code or libraries or misconfiguration of IEC tasks.

---

**Low priority non-real-time functionality**

The low priority range is intended for non-real-time functionality which doesn’t have any specific timing requirements and which is supposed to execute its activity without delaying or interrupting the user application and its related functionality.

Activity assigned to this range can be suppressed by high priority and real-time IEC tasks. Therefore might show high jitter, sporadic activity or large reaction times, depending on the overall system load.

To avoid suppression of the tasks of this group, the system reserves a short time slot to process low-priority functionality if the CPU load reaches nearly 100%. Under normal circumstances (below an average system load of 80%), this mechanism shouldn’t be engaged. Although this time slot could cause high priority tasks to jitter slightly (± 100 microseconds), it ensures that the system remains responsive and will always be able to run fundamental jobs which must be executed regularly. Note that tasks of low priority still play an important role and need to be scheduled regularly to meet their individual timing requirements.

---

Ensure that the average CPU load doesn’t exceed 80% to ensure that there’s enough time for the system to process low-priority functionality.

The functionality might not be important for the individual application, but it is still necessary to keep alive other functionality like the Automation Builder login or access to diagnosis data.

Once the CPU load exceeds 80%, it will be difficult for the system to correctly schedule tasks.

---

**Communication schema “Default”**

Communication schema “Default” is the default schema selected when creating a new AC500 V3 application. It is the recommended setting to start with and suitable for most applications.

The schema leads to a well balanced task priority setup which lays focus on stability and low risk of negative side effects caused by high IEC task load or hardware activity.

The highest IEC task priority 0 should be used for high prior functions in the PLC with short execution time.

The communication modules interrupts (CM5xx), the I/O bus, the IEC scheduler observer task and the CAA event task are processed with higher priority than all user IEC tasks.

Ethernet runs with non-real-time priority to avoid denial-of-service scenarios and system overload caused by devices located in the same network.

The default setting of the priorities is suitable for most applications and should be used unless there are special requirements or performance issues.

---

**Features and their priorities**

In this schema, the range of IEC task priorities is only shared with tasks related to CM598-CN (CAN communication module) and its CAN2A/2B IO POUs and common POU background job handling. The priorities 9 and 15 can still be used though.

Note that tasks above IEC task priority 9 might have negative side effects on CAN communication in terms of reaction time and throughput, while IEC tasks with priority lower than 9 might be interrupted or delayed by an active CAN communication.
POU background jobs are assigned the lowest IEC real-time priority to avoid negative side effects on IEC tasks and thus on process data synchronization or user code. POUs usually are related to tasks of lower priority and shall not have an impact on higher priority tasks.

Communication schema “Communication modules”

This communication schema is only available for PM56xx series AC500 V3 PLCs supporting communication modules.

The communication schema “Communication modules” is intended for users of a communication module which can be configured to synchronize its stack activity with the user application by a dedicated (external event triggered IEC task) which is mapped to an event (“CouplerEventX”, X = slot number of the communication module).

The bus synchronized IEC task is not scheduled by the PLC runtime system but the stack of the communication module. As a result of this, it’s necessary for the PLC to quickly react on the related event of the communication module. The schema ensures that negative side-effects on the bus synchronized IEC task are reduced as much as possible by adjusting priorities of high priority functionality.

Features and their priorities

The following figure shows the changes the schema applies to the available features of the PLC. The primary goal of this schema is to reduce the number of tasks which are capable of interrupting or delaying the bus synchronized IEC task, while providing as much flexibility as possible. By making use of the priority range of IEC tasks, users can decide whether existing IEC tasks will influence the corresponding features.
● Use IEC priority 0 for the bus synchronized IEC task and a priority lower than 0. For all other features to avoid negative side-effects on the bus synchronized IEC task.
● Use IEC priorities 1 to 5 for functionality which is more important than high priority features like IO bus or CAN.
● To ensure that a high priority feature is not influenced by any IEC user code (besides of the bus synchronized IEC task), use an IEC task priority which is lower than the priority of the corresponding feature.

It is not forbidden to make use of IEC task priorities which are assigned to other PLC functionality.
NOTICE!
Be careful when using this schema to avoid unwanted side-effects on features besides of the protocol realized by the corresponding communication module, caused by violation of individual timing constraints or requirements!

I/O bus must be able to refresh all connected S500 I/O devices within 20 ms. Otherwise, an exception will be raised which will lead to a stop of the application. Use PLC shell command `io-bus desc` to dump information on the bus timing. The output contains information on the I/O bus cycle time:

--- I/O bus information —
Baud rate [baud]: 1714286
Min. cycle time [us]: 1037
Max. cycle time [us]: 10936
Last cycle time [us]: 1567

*Chapter 6.4.1.21.2.8.11 “Tab ‘PLC Shell’” on page 2441*

The maximum cycle time must be below 20 ms to ensure that the system runs stable and won’t raise a timeout exception error.

If the cycle time reaches the limit, try to reduce the amount of code executed by IEC user tasks of higher priority than I/O bus or adjust task priorities if possible.

Communication schema “Onboard Ethernet”

This schema is intended for users who make use of Ethernet protocols which rely on a lot of parallel network connections, like Modbus TCP or IEC 61850.

Features and their priorities

As shown in the diagram below, Ethernet related tasks will be assigned a priority within IEC task priority range to reduce reaction times and increase throughput to meet the requirements of protocols like Modbus TCP or IEC 61850. By making use of IEC task priority 8, users can decide whether their IEC user tasks are capable of interrupting or delaying Ethernet communication or not, depending on the individual requirements.
Communication schema “Onboard EtherCAT” since “SystemFW” 3.4.1

Schema “Onboard EtherCAT” is intended for users who intend to make use of the EtherCAT master protocol, configured at one of the available onboard Ethernet ports of the corresponding AC500 V3 PLC.

Due to the special requirements of EtherCAT, it’s necessary to modify the configuration of system components related to onboard Ethernet, and thus provide a low-latency Ethernet port. In addition to that, priorities of various functionality are adjusted to reduce negative side-effects on the EtherCAT IEC task and achieve best possible performance.

Features and their priorities

The following diagram shows the changes the schema applies to the available features of the PLC. The primary goal of this schema is to reduce the number of tasks which are capable of interrupting or delaying the Ethernet IEC task, while providing as much flexibility as possible. By making use of the priority range of IEC tasks, users can decide whether existing IEC tasks will influence the corresponding features.

- Use IEC priority 0 for the EtherCAT IEC task and a priority lower than 0 for all other features to avoid negative side-effects on EtherCAT.
- Use IEC priorities 1 to 5 for functionality which is more important than high priority features like IO bus or onboard I/O.
- To ensure that a high priority feature isn’t influenced by any IEC user code (besides of EtherCAT), use an IEC task priority which is lower than the priority of the corresponding feature.

It is not forbidden to make use of IEC task priorities which are assigned to other PLC functionality.
NOTICE!

Be careful when using this schema to avoid unwanted side-effects on features other than EtherCAT, caused by violation of individual timing constraints or requirements!

I/O bus must be able to refresh all connected S500 I/O devices within 20 ms. Otherwise, an exception will be raised which will lead to a stop of the application. Use PLC shell command `io-bus desc` to dump information on the bus timing. The output contains information on the IO bus cycle time:

--- I/O bus information —

Baud rate [baud]: 1714286
Min. cycle time [us]: 1037
Max. cycle time [us]: 10936
Last cycle time [us]: 1567

*Chapter 6.4.1.21.2.8.11 “Tab ‘PLC Shell’” on page 2441*

The maximum cycle time must be well below 20 ms to ensure that the system runs stable and won’t raise a timeout exception error.

If the cycle time reaches the limit, try to reduce the amount of code executed by IEC user tasks of higher priority than I/O bus or adjust task priorities if possible.

---

### Low latency port

Besides the adjustment of task priorities, schema “Onboard EtherCAT” also changes the low level Ethernet driver configuration to offer a dedicated low latency port to the user.

Due to technical constraints, the port number of the low latency port depends on the type of PLC which is used:
### Setting standard configuration

If the target setting configuration is changed, standard configuration can be restored:

1. Open CODESYS.
2. In the “Resources” tab, double-click “PLC Configuration”.
3. Select “Menu Extras → Standard Configuration”.

### Real-time clock and battery

#### Real-time clock

The real-time clock is an optional function for AC500-eCo V3 Basic processor modules (e.g. PM5012-x-ETH) require a TA5131-RTC. All other AC500-eCo V3 processor modules have an integrated real-time clock.

The real-time clock operates as a PC clock. It saves date and time to a DWORD in DT format (DATE AND TIME FORMAT), i.e., in seconds passed since the start time: 1 January 1970 at 00:00.

For AC500-eCo V3, Basic CPU with TA5131-RTC buffers the real-time clock for 7 days, and Standard/Pro CPU buffers the integrated real-time clock for 20 days. When the CPU is not powered over the buffering time, the real-time clock data will be cleared.

If a battery is connected and full, the real-time clock continues to run even if the control voltage is switched off.

If no battery is inserted or the battery is empty, the real-time clock starts with the value 0 (=1970-01-01, 00:00:00).

When switching on the control voltage, the system clock of the operating system is set to the value of the real-time clock.

#### Real-time clock with PLC browser

The PLC browser/PLC shell commands `date` and `time` are used to set the real-time clock.

The commands `date <ENTER>` or `time <ENTER>` display the current date and time of the real-time clock.

The command: `date yyyy-mm-dd<ENTER>` (year-month-day) sets the date.

The command: `time hh-mm-ss<ENTER>` (hours-minutes-seconds) sets the time.

---

<table>
<thead>
<tr>
<th>PLC type</th>
<th>ETH1</th>
<th>ETH2</th>
</tr>
</thead>
<tbody>
<tr>
<td>PM50xx eCo V3</td>
<td>Low latency</td>
<td>Maintenance and visualization</td>
</tr>
<tr>
<td>PM56xx V3</td>
<td>Maintenance and visualization</td>
<td>Low latency</td>
</tr>
</tbody>
</table>

The other port remains on low priority to minimize the impact on the activity of the v protocol. It is intended for login (Automation Builder), visualization services or similar (non-real-time) activities.

When configuring eCo V3 CPU “Onboard EtherCAT” parameters, the ETH1 interface is set to the IP address 0.0.0.0. After switching to a different communication scheme than “Onboard EtherCAT”, IP configuration of the Ethernet port used for Onboard EtherCAT remains invalidated (IP address 0.0.0.0). It needs to be re-applied by the user should the port be required by the new application.

The “Onboard EtherCAT” functionality is only usable/visible for the eCo V3 CPU from SystemFW 3.7.0.
Example:
The real-time clock should be set to 22 February 2005, 16:50.

1. Enter the date:
   
   ```
   date 2005-02-22<ENTER>
   ```
   
   Display: date 2005-02-22 Clock set to 2005-02-22 08:01:07
   
   The time remains unchanged.

2. Enter the time:
   
   ```
   time 16:50<ENTER>
   ```
   
   Display: time 16:50 Clock set to 2005-02-22 16:50:00

### Real-time clock with user program

The following function blocks located in the folder "Realtime clock" of the system library `ABB_ExtUtilis_AC500.lib` can be used to set and display the real-time clock (RTC) with help of the user program:

<table>
<thead>
<tr>
<th>Function block</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CLOCK (V3) “Library Manager ➔ ABB-AC500 ➔ Use Cases ➔ AC500 Utilis ➔ PM&lt;Version&gt; (ABB) ➔ Function Blocks ➔ Realtime clock”</td>
<td>Sets and displays the real-time clock with values for year, month, day, hours, minutes and seconds. Also the day of week is indicated (Mo=1, Tue=2, Wed=3, Thu=4, Fr=5, Sa=6, Su=0). Note: The week of day cannot be set. It is given by the real-time clock. The input DAY_SET is ignored.</td>
</tr>
<tr>
<td>CLOCK_DT (V3) “Library Manager ➔ ABB-AC500 ➔ Use Cases ➔ AC500 Utilis ➔ PM&lt;Version&gt; (ABB) ➔ Function Blocks ➔ Realtime clock”</td>
<td>Sets and displays the real-time clock in DT format, for example DT#2005-02-17-17:15:00.</td>
</tr>
</tbody>
</table>

Reference for function blocks, functions, structures etc. Chapter 6.5.14 “Reference, function blocks” on page 4086

### 6.8.2.3 AC500 battery

The AC500 battery buffers the following data in case of "control voltage off":

- Retentive variables in SRAM (VAR_RETAIN..END_VAR) Chapter 6.8.2.1 “Handling of remanent variables for AC500 V3 products” on page 4412
- Date and time of the real-time clock

Further information:

- Chapter 6.9.3 “Diagnosis messages” on page 4655

To prevent data loss when using the AC500 battery, the battery status should be periodically monitored by the user program.

### Battery status

The battery status can be monitored either with the help of a user program on the PLC or in Automation Builder.
In the PLC shell of Automation Builder the command "BATT" can be used. \(\text{Chapter 6.9.2.4.4 "PLC shell commands" on page 4647.}\) The following is output:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Battery empty</td>
</tr>
<tr>
<td>20</td>
<td>Remaining battery charge below 20 %</td>
</tr>
<tr>
<td>100</td>
<td>Battery charge OK</td>
</tr>
</tbody>
</table>

In the user program, the battery status can be checked with the function BATT which is available in the folder "Battery" of the system library ABB_ExtUtils_AC500.lib ("Library Manager \(\rightarrow\) ABB-AC500 \(\rightarrow\) Use Cases"). The following is output:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Battery empty</td>
</tr>
<tr>
<td>20</td>
<td>Remaining battery charge below 20 %, battery must be replaced</td>
</tr>
<tr>
<td>100</td>
<td>Battery charge OK</td>
</tr>
</tbody>
</table>

On the device, the battery status can be checked with the function keys of a processor module. \(\text{Chapter 6.8.2.5 "Display, LEDs and function keys on the front panel" on page 4452}\)

\(\text{Chapter 6.8.2.5.3 "VAL - reading out state values" on page 4459}\)

### 6.8.2.3 AC500-eCo V3 data buffering

The AC500-eCo V3 buffers the following data in case of "control voltage off":
- Retentive variables in FLASH (VAR_RETAIN..END_VAR) \(\text{Chapter 6.8.2.1 “Handling of remanent variables for AC500 V3 products” on page 4412}\)
- Date and time of the real-time clock are using an integrated gold-capacitor with a lower retention time as a battery.

\(\text{The AC500-eCo V3 has no battery but stores the remanent data in flash or the real-time clock using a gold-capacitor, there is no battery or gold-capacitor status or survey.}\)

\(\text{In case of "control voltage off", the real-time clock is buffered for about 7 days for Basic CPU with TA5131-RTC and about 20 days for Standard or Pro CPUs at 40 °C using temperature.}\)
6.8.2.4  AC500-eCo V3 processor module, LEDs, RUN/STOP switch on front panel

6.8.2.4.1  Features

Fig. 358: Example: PM5072-T-2ETH

1  Micro memory card slot
2  5 LEDs to display the states of the processor module (Power, Error, Run, MC, MOD1)
3  RUN button
4  RJ45 female connector for Ethernet1 connection
5  RJ45 female connector for Ethernet2 connection (available for PM50x2-T-2ETH)
6  3-pin terminal block for power supply 24 V DC
7  2 holes for screw mounting
8  Option board slot cover for option board slot (the number of available slots varies according to the CPU type)
9  Cable fixing
10 13-pin terminal block for onboard I/Os
11 12-pin terminal block for onboard I/Os (not available on PM5012-x-ETH)
12 12 LEDs to display the states of the signals
13 10 LEDs to display the states of the signals
14  Cable fixing accessory TA5301-CFA on the top of the housing (optional)

The processor module is shown with pluggable terminal blocks. These terminal blocks must be ordered separately.

The cable fixing accessory on the top of the housing is optional. Please use TA5301-CFA cable fixing accessory to provide strain relief. It can also be used for AC500-eCo I/O modules.
The PM50x2 processor modules are supplied with option board slot covers as standard. 

There are various TA51xx option boards for the processor modules that can be ordered separately.

Which and how many option boards can be plugged, depends on the respective processor module.

6.8.2.4.2 State LEDs and operating elements

**RUN/STOP button**

The processor modules, PM50xx series, have a RUN/STOP button. By pressing the RUN/STOP button, the processor modules switch between RUN mode and STOP mode. By long-pressing RUN/STOP button during the processor module power on phase, the processor module will be in MOD1.

**State LEDs**

The processor modules PM50xx indicate their states of operation via 5 LEDs located on the upper left side of the processor module.

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = ON</th>
<th>LED = OFF</th>
<th>LED flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR</td>
<td>Power supply</td>
<td>Green</td>
<td>Power supply present</td>
<td>Power supply missing</td>
<td>-</td>
</tr>
<tr>
<td>MC</td>
<td>Micro memory card indication</td>
<td>Yellow</td>
<td>Micro memory card is in the socket</td>
<td>Micro memory card is not in the socket</td>
<td>Micro memory card is in read/write state: any file on card is opened, means activity on card</td>
</tr>
<tr>
<td>ERR</td>
<td>Error indication</td>
<td>Red</td>
<td>An error occurred</td>
<td>No errors or only warnings encountered (E4 errors). The LED behavior for the error classes 2 to 4 is configurable.</td>
<td>Fast flashing (4 Hz) displays together with the RUN LED a currently running firmware-upgrade or writing data to the Flash-EPROM. Slow flashing (1 Hz) alone displays shutdown of Request To Send. Medium flashing (2 Hz) alone displays at start of PLC if reboot after watchdog.</td>
</tr>
<tr>
<td>MOD1</td>
<td>Mode 1 indication</td>
<td>Yellow</td>
<td>Processor module is in mode 1 state</td>
<td>Processor module is not in mode 1 state</td>
<td>-</td>
</tr>
</tbody>
</table>
### User configurable LEDs

The AC500-eCo V3 processor module also provides 2 LEDs below the state LEDs which can be used by user and driven by an application.

The LEDs can be used into a project and controlled using special function blocks which are contained in the PM AC500 library. The POU is PmLedSet located in folder LED control.

### I/O LEDs

The processor module provides up to 10 LEDs (PM5012-x-ETH), 20 LEDs (PM5032-R-ETH, PM5052-R-ETH), or 22 LEDs (PM5032-T-ETH, PM5052-T-ETH, PM5072-T-2ETH(W), PM5082-T-2ETH) to display the states of the inputs and outputs.

<table>
<thead>
<tr>
<th>Processor module</th>
<th>LED</th>
<th>State</th>
<th>Color</th>
<th>LED = ON</th>
<th>LED = OFF</th>
</tr>
</thead>
<tbody>
<tr>
<td>PM5012-x-ETH</td>
<td>I0 ... I5</td>
<td>Digital input</td>
<td>Yellow</td>
<td>Input is ON</td>
<td>Input is OFF</td>
</tr>
<tr>
<td></td>
<td>O0 ... O3</td>
<td>Transistor output</td>
<td>Yellow</td>
<td>Output is ON</td>
<td>Output is OFF</td>
</tr>
<tr>
<td>Processor module</td>
<td>LED</td>
<td>State</td>
<td>Color</td>
<td>LED = ON</td>
<td>LED = OFF</td>
</tr>
<tr>
<td>------------------</td>
<td>-----</td>
<td>-------------</td>
<td>-------</td>
<td>------------------</td>
<td>------------------</td>
</tr>
<tr>
<td></td>
<td>NO0 ... NO3</td>
<td>Relay output</td>
<td>Yellow</td>
<td>Output is ON</td>
<td>Output is OFF</td>
</tr>
<tr>
<td>PM5032-x-ETH</td>
<td>I0 ... I11</td>
<td>Digital input</td>
<td>Yellow</td>
<td>Input is ON</td>
<td>Input is OFF</td>
</tr>
<tr>
<td>PM5052-x-ETH</td>
<td>O0 ... O7</td>
<td>Transistor output</td>
<td>Yellow</td>
<td>Output is ON</td>
<td>Output is OFF</td>
</tr>
<tr>
<td></td>
<td>NO0 ... NO5</td>
<td>Relay output</td>
<td>Yellow</td>
<td>Output is ON</td>
<td>Output is OFF</td>
</tr>
<tr>
<td></td>
<td>C12, C13</td>
<td>Digital configurable input/output</td>
<td>Yellow</td>
<td>Input/Output is ON</td>
<td>Input/Output is OFF</td>
</tr>
<tr>
<td>PM5072-T-2ETH(W)</td>
<td>I0 ... I11</td>
<td>Digital input</td>
<td>Yellow</td>
<td>Input is ON</td>
<td>Input is OFF</td>
</tr>
<tr>
<td>PM5082-T-2ETH</td>
<td>O0 ... O7</td>
<td>Transistor output</td>
<td>Yellow</td>
<td>Output is ON</td>
<td>Output is OFF</td>
</tr>
<tr>
<td></td>
<td>C12, C13</td>
<td>Digital configurable input/output</td>
<td>Yellow</td>
<td>Input/Output is ON</td>
<td>Input/Output is OFF</td>
</tr>
</tbody>
</table>

**Table 810: State LEDs at Ethernet connector**

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>OFF</th>
<th>ON</th>
<th>Flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity</td>
<td>Yellow</td>
<td>No activity</td>
<td>---</td>
<td>Activity</td>
</tr>
<tr>
<td>Link</td>
<td>Green</td>
<td>No link</td>
<td>Link</td>
<td>---</td>
</tr>
</tbody>
</table>
6.8.2.5  Display, LEDs and function keys on the front panel

6.8.2.5.1  Overview

The display of a processor module is equipped with a background-lighted 7-segment display. This display consists of 6 digits for plain text or error codes.

Some functionalities may be not yet supported by the product. Please refer to the release notes of the product at time of release.

Display indicators

- A black square (□) denotes the state/working activity of the corresponding object on the left/right side of the display. The black square flashes according to the device's activity, e.g. during data exchange on ETH1, ETH2, COM1, etc.

  MC activity
  
  For the activity of the memory card the black square (□) is shown as long as a file is open on memory card.

- A black triangle (▲) points to the selected item/interface on the left/right side of the display to be configured or read. Further, it acts as a cursor for the count up/count down function keys.

  A black triangle (▲) at the BATT item indicates a missing or uncharged battery.
The indicators point to the following items on the left side of the display:

<table>
<thead>
<tr>
<th>No.</th>
<th>On the left side</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>MC (memory card)</td>
<td>Refers to the memory card state.</td>
</tr>
<tr>
<td>2</td>
<td>SYS (system)</td>
<td>Refers to the system state.</td>
</tr>
<tr>
<td>3</td>
<td>BATT (battery)</td>
<td>Refers to the battery state.</td>
</tr>
<tr>
<td>4</td>
<td>I/O bus</td>
<td>Refers to I/O bus connection.</td>
</tr>
</tbody>
</table>

The indicators point to the following items on the right side of the display:

<table>
<thead>
<tr>
<th>No.</th>
<th>On the right side</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>ETH1</td>
<td>Refers to the first Ethernet interface.</td>
</tr>
<tr>
<td>6</td>
<td>ETH2</td>
<td>Refers to the second Ethernet interface.</td>
</tr>
<tr>
<td>7</td>
<td>COM1</td>
<td>Refers to COM1 interface.</td>
</tr>
<tr>
<td>8</td>
<td>CAN</td>
<td>Refers to CAN interface.</td>
</tr>
<tr>
<td>9</td>
<td>Function keys on front panel</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Processor module</th>
<th>Display variant</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PM56xx-2ETH</td>
<td>![Display Image]</td>
<td>Display of a processor module with support for 2 Ethernet interfaces, CAN and COM1.</td>
</tr>
</tbody>
</table>

### 6.8.2.5.2 Text outputs of the display

<table>
<thead>
<tr>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Display Image]</td>
<td>Display on system start (power on).</td>
</tr>
<tr>
<td>![Display Image]</td>
<td>PLC is in boot mode.</td>
</tr>
<tr>
<td>![Display Image]</td>
<td>Is shown on startup after boot, when a wrong DisplayFW is detected, e.g. an old version. Update display with DisplayFW 4.1 (or higher).</td>
</tr>
</tbody>
</table>

© Chapter 6.3.1.4.3 “Installation and update of the AC500 V3 firmware” on page 1422
<table>
<thead>
<tr>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="PLC in initialization mode" /></td>
<td>PLC is in initialization mode.</td>
</tr>
<tr>
<td><img src="image2" alt="PLC in STOP mode" /></td>
<td>PLC is in STOP mode.</td>
</tr>
<tr>
<td><img src="image3" alt="PLC waiting for firmware download" /></td>
<td>No system firmware (SystemFW) available. Start update firmware. PLC is waiting for a firmware download via Automation Builder or memory card.</td>
</tr>
<tr>
<td><img src="image4" alt="PLC in RUN mode" /></td>
<td>PLC is in RUN mode. Switch into RUN mode is only possible if a valid boot project is available in the flash memory.</td>
</tr>
<tr>
<td><img src="image5" alt="PLC in Demo mode" /></td>
<td>Only in RUN mode and as of SystemFW V3.2.0. Reminder: demo license PLC runs in „Demo mode“, since at least one feature license is missing. Will be displayed for 5 minutes at every license check. If „Demo time“ expires, PLC will go to „Stop“.</td>
</tr>
<tr>
<td><img src="image6" alt="PLC in Grace mode" /></td>
<td>Only in RUN mode and as of SystemFW V3.2.0. 10 minutes step reminder: license was removed PLC runs in „Grace mode“, since at least one feature license which has been available disappeared. PLC is waiting for this license. Will be displayed for 5 minutes. If „Grace time“ expires, PLC will go to „Stop“.</td>
</tr>
<tr>
<td><img src="image7" alt="PLC with no connection" /></td>
<td>New as of SystemFW 3.3.1.103. Text is shown if no communication between CPU and display is possible due to very high CPU load (e.g. endless loop in user program and not activated task watchdog).</td>
</tr>
</tbody>
</table>
### 6.8.2.5.3 Startup procedure of the PLC

#### Startup procedure of a new PLC from factory

<table>
<thead>
<tr>
<th>State</th>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>[Image]</td>
<td>Display on system start (power on).</td>
</tr>
<tr>
<td>1</td>
<td>[Image]</td>
<td>PLC is in boot mode.</td>
</tr>
<tr>
<td>2</td>
<td>[Image]</td>
<td>PLC is in initialization mode.</td>
</tr>
<tr>
<td>3</td>
<td>[Image]</td>
<td>No system firmware (SystemFW) available. Start update firmware. PLC is waiting for a firmware download via Automation Builder or memory card.</td>
</tr>
</tbody>
</table>

Start update firmware.

`Chapter 6.3.1.4.3 "Installation and update of the AC500 V3 firmware" on page 1422`

#### Startup procedure of a PLC with system firmware

The startup procedure depends on the selected PLC mode.

<table>
<thead>
<tr>
<th>PLC mode</th>
<th>Display</th>
<th>Startup behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>00</td>
<td>[Image]</td>
<td>The user program will be loaded and run. PLC changes to mode &quot;RUN&quot;.</td>
</tr>
<tr>
<td>01</td>
<td>[Image]</td>
<td>User program will not be loaded/run. PLC stay in mode &quot;STOP&quot;.</td>
</tr>
<tr>
<td>02</td>
<td>[Image]</td>
<td>Reserved for further development (currently like mode 00).</td>
</tr>
</tbody>
</table>

Mode 01 can be activated via function key **CFG**, or by pressing function key **RUN** during startup of PLC until mode 01 is shown on display. 

Further information on page 4453.

If an available update or a hotfix is displayed in the Automation Builder, it can be installed as described in the "Automation Builder update notification" chapter.

`Chapter 4.8.3 "Execution of a hotfix" on page 151`
<table>
<thead>
<tr>
<th>State</th>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td><img src="state0.png" alt="Display" /></td>
<td>Display on system start (power on).</td>
</tr>
<tr>
<td>1</td>
<td><img src="state1.png" alt="Display" /></td>
<td>PLC is in boot mode.  Further information on page 4453</td>
</tr>
<tr>
<td>2</td>
<td><img src="state2.png" alt="Display" /></td>
<td>PLC is in initialization mode.  Further information on page 4453</td>
</tr>
</tbody>
</table>
| 3     | ![Display](state3.png) | PLC is in STOP mode.  Further information on page 4453  
**Same as state Stop in Automation Builder.** |
| 4     | ![Display](state4.png) | PLC is in RUN mode.  Further information on page 4453  
**Switch into RUN mode is only possible if a valid boot project is available in the flash memory.**  
**Chapter 6.3.1.4.5.2 “Firmware and/or application installation and update” on page 1427** |
| 5     | ![Display](state5.png) | Only in RUN mode and as of SystemFW V3.2.0  
**Reminder:** *demo license*  
PLC runs in „Demo mode“, since at least one feature license is missing.  
Will be displayed for 5 minutes at every license check  
If „Demo time“ expires, PLC will go to „Stop“. |
| 6     | ![Display](state6.png) | Only in RUN mode and as of SystemFW V3.2.0  
10 minutes step reminder: *license was removed*  
PLC runs in „Grace mode“, since at least one feature license which has been available disappeared. PLC is waiting for this license.  
Will be displayed for 5 minutes  
If „Grace time“ expires, PLC will go to „Stop“. |

### 6.8.2.5.4 Description of LEDs

The LEDs below the display indicate the state of the processor module:
### 6.8.2.5.5 Description of the function keys

#### Overview

The processor module can be operated manually using the function keys on the front panel:

<table>
<thead>
<tr>
<th>Function key</th>
<th>Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![RUN]</td>
<td>Run</td>
<td>Toggles between RUN and STOP mode. <strong>Switching into RUN mode is only possible if an error free project has been created and downloaded with Automation Builder.</strong></td>
</tr>
<tr>
<td>![VAL]</td>
<td>Value</td>
<td>Shows different state values of the processor module.</td>
</tr>
<tr>
<td>![ESC]</td>
<td>Escape</td>
<td>Quits the current menu, submenu or function without saving.</td>
</tr>
</tbody>
</table>

---

A running processor module is indicated with the state **RUN** on the display, a deactivated processor module is indicated with the state **STOP**. In both cases the display's backlight is off.
<table>
<thead>
<tr>
<th>Function key</th>
<th>Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>OK/Acknowledgement</td>
<td>Acknowledges the current value or selects a menu/submenu. Changes that have been sent to the processor module successfully are confirmed with done on the display.</td>
</tr>
<tr>
<td>DIAG</td>
<td>Diagnostic</td>
<td>Allows evaluation of error messages in detail.</td>
</tr>
<tr>
<td>CFG</td>
<td>Configuration</td>
<td>Show/set IP configuration, PLC startup mode and Ethernet address. Enter submenus.</td>
</tr>
<tr>
<td>Count up/navigate in submenu</td>
<td>Count up/navigate in submenu</td>
<td>Press the function key repeatedly in order to increase the value each time by 1, or navigate in submenu to previous entry. Keep the function key pressed in order to count up fast.</td>
</tr>
<tr>
<td>Count down/navigate in submenu</td>
<td>Count down/navigate in submenu</td>
<td>Press the function key repeatedly in order to decrease the value each time by 1, or navigate in submenu to next entry. Keep the function key pressed in order to count down fast.</td>
</tr>
</tbody>
</table>

Backlight is switched on for about 20 seconds by pressing any function key.

**RUN - start and stop PLC**

Function key **RUN**

<table>
<thead>
<tr>
<th>State</th>
<th>Description menu level 0</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Press short: State 1 is displayed. Press long (&gt;5 sec): State 2 is displayed.</td>
<td>No action</td>
</tr>
<tr>
<td>1</td>
<td>State 0 is displayed. STOP - same as Online stop in Automation Builder (Stop, no init of variables)</td>
<td>Perform RESET same as Online reset in Automation Builder (stop and init variables)</td>
</tr>
<tr>
<td>2</td>
<td>RUN LED=ON</td>
<td></td>
</tr>
</tbody>
</table>

**PLC only in state RUN if a correct project is in RAM of PLC.**
**VAL - reading out state values**

**Values with SystemFW 3.1.x and DisplayFW 3.0**

The following settings of the processor module can be read out by pressing the function key **VAL** repeatedly:

1. Displays time of the processor module (hh:mm:ss).
2. Displays date of the processor module (yy.mm.dd).
3. Displays state of battery (ub 100 = 100%, ub 020 = 20% or ub 000 = empty).
4. Displays version of display firmware (e.g. d 3.0 r (= display version 3.0 release)).
5. Displays version of CPU firmware (e.g. C 3.1.0r (= CPU version 3.1.0 release)).
6. Displays CPU type.
7. Displays default text (RUN/STOP).

**Values with SystemFW >=V3.2.0 and DisplayFW >=V4.1**

Function key **VAL**

By pressing function key **VAL** state 1 is displayed.

<table>
<thead>
<tr>
<th>State</th>
<th>Description menu VAL</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Time of the processor module (hh:mm:ss).</td>
<td>No action, State 2 is displayed, State 6 is displayed, Go back to main menu RUN/STOP.</td>
</tr>
<tr>
<td>2</td>
<td>Date of the processor module (yy.mm.dd).</td>
<td>State 3 is displayed, State 1 is displayed.</td>
</tr>
<tr>
<td>3</td>
<td>State of battery (ub 100 = 100%, ub 020 = 20% or ub 000 = empty).</td>
<td>State 4 is displayed, State 2 is displayed.</td>
</tr>
<tr>
<td>4</td>
<td>Version of display firmware (e.g. d 4.1 r (= display version 4.1 release)).</td>
<td>State 5 is displayed, State 3 is displayed.</td>
</tr>
<tr>
<td>5</td>
<td>Version of CPU firmware (e.g. C 3.2.0r (= CPU version 3.2.0 release)).</td>
<td>State 6 is displayed, State 4 is displayed.</td>
</tr>
</tbody>
</table>
### CPU type

State Description menu VAL

<table>
<thead>
<tr>
<th>State</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>State 1 is displayed. State 5 is displayed.</td>
</tr>
</tbody>
</table>

**DIAG - reading out diagnosis messages**

#### Table 811: Example - no diagnosis message in state list

<table>
<thead>
<tr>
<th>State</th>
<th>Display</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>The processor module is in RUN/STOP mode. State 1 is displayed.</td>
<td>-</td>
</tr>
<tr>
<td>1</td>
<td>No action</td>
<td>No action</td>
</tr>
</tbody>
</table>

#### Table 812: Example - diagnosis messages in state list

<table>
<thead>
<tr>
<th>State</th>
<th>Display</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>The processor module is in RUN/STOP mode. State 1 is displayed.</td>
<td>-</td>
</tr>
<tr>
<td>1</td>
<td>Number of diagnosis messages; here 4</td>
<td>Go to first/next diagnosis message in state list (e.g., state 2). Go to last/previous diagnosis message in state list. Return into RUN/STOP mode. Return into RUN/STOP mode.</td>
</tr>
<tr>
<td>2</td>
<td>Diagnosis message example: Error battery empty or missing. Toggling between state 2 and 3. Selects displayed diagnosis message and shows details. ☼ Table 8 13 “Example - error battery empty or missing” on page 4461</td>
<td>Go to first/next diagnosis message in state list. Go to last/previous diagnosis message in state list. Return into RUN/STOP mode. Acknowledge and return into RUN/STOP mode.</td>
</tr>
<tr>
<td>State</td>
<td>Display</td>
<td>Result on pressing one of the function keys</td>
</tr>
<tr>
<td>-------</td>
<td>---------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>3</td>
<td><img src="image1" alt="Image" /></td>
<td><strong>DIAG</strong></td>
</tr>
<tr>
<td></td>
<td>Error ID example</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Toggling between state 2 and 3</td>
<td></td>
</tr>
</tbody>
</table>

Table 813: Example - error battery empty or missing

<table>
<thead>
<tr>
<th>State</th>
<th>Display</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td><img src="image2" alt="Image" /></td>
<td><strong>DIAG</strong></td>
</tr>
<tr>
<td></td>
<td>State 2 is displayed.</td>
<td>State 2 is displayed.</td>
</tr>
<tr>
<td></td>
<td>E4 = error severity 4</td>
<td>bAt = subdevice battery</td>
</tr>
<tr>
<td>1</td>
<td><img src="image3" alt="Image" /></td>
<td><strong>DIAG</strong></td>
</tr>
<tr>
<td></td>
<td>State 3 is displayed.</td>
<td>State 0 is displayed.</td>
</tr>
<tr>
<td></td>
<td>Error ID example</td>
<td>Toggling between state 0 and 1.</td>
</tr>
<tr>
<td>2</td>
<td><img src="image4" alt="Image" /></td>
<td><strong>DIAG</strong></td>
</tr>
<tr>
<td></td>
<td>State 4 is displayed.</td>
<td>State 2 is displayed.</td>
</tr>
<tr>
<td></td>
<td>Error number 8</td>
<td>Battery is missing or empty.</td>
</tr>
<tr>
<td>3</td>
<td><img src="image5" alt="Image" /></td>
<td><strong>DIAG</strong></td>
</tr>
<tr>
<td></td>
<td>State 5 is displayed.</td>
<td>State 3 is displayed.</td>
</tr>
<tr>
<td></td>
<td>Detail 1</td>
<td>Subdevice 22: battery</td>
</tr>
<tr>
<td>4</td>
<td><img src="image6" alt="Image" /></td>
<td><strong>DIAG</strong></td>
</tr>
<tr>
<td></td>
<td>State 5 is displayed.</td>
<td>State 3 is displayed.</td>
</tr>
<tr>
<td></td>
<td>Detail 2</td>
<td>Error type 0: device</td>
</tr>
</tbody>
</table>
CFG - configuration

Configuration with SystemFW V3.1.x and DisplayFW V3.0

Navigation starts with the processor module being in RUN/STOP mode (State 0). By pressing one of the 3 function keys a certain action is triggered. The result of this action is described in the result columns of the tables.

<table>
<thead>
<tr>
<th>State</th>
<th>Description - main menu 1</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>The processor module is in RUN/STOP mode.</td>
<td>State 1 is displayed. Remains in RUN/STOP mode. Remains in RUN/STOP mode.</td>
</tr>
<tr>
<td>1</td>
<td>State 2 is displayed. Return into RUN/STOP mode.</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>State 3 is displayed. Return into RUN/STOP mode. Shows DONE, your settings are saved. Return into RUN/STOP mode.</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>State 4 is displayed. Return into RUN/STOP mode. Refers to sub-menu 1.</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>State 5 is displayed. Return into RUN/STOP mode. Shows DONE, your settings are saved. Return into RUN/STOP mode.</td>
<td></td>
</tr>
</tbody>
</table>

CFG main menu with ETH1/ETH2 mode: “Two separate interfaces”

Chapter 6.3.2.9.3 “Switch functionality of Ethernet interfaces ETH1/ETH2” on page 1520

<table>
<thead>
<tr>
<th>State</th>
<th>Display</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Detail 3 Error type number 0: device itself</td>
<td>State 6 is displayed. State 4 is displayed. State 0 is displayed. Return to diagnosis state list. State 0 is displayed Return to diagnosis state list.</td>
</tr>
<tr>
<td>6</td>
<td>Detail 4 Additional information 0: none</td>
<td>State 1 is displayed. State 5 is displayed. State 0 is displayed. Return to diagnosis state list. State 0 is displayed Return to diagnosis state list.</td>
</tr>
</tbody>
</table>
### Chapter 6.3.2.9.3 “Switch functionality of Ethernet interfaces ETH1/ETH2” on page 1520

Navigation starts with the processor module being in RUN/STOP mode (State 0). By pressing one of the 3 function keys a certain action is triggered. The result of this action is described in the result columns of the tables.

<table>
<thead>
<tr>
<th>State</th>
<th>Description - main menu 1</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td><strong>State 1</strong> is displayed.</td>
<td>Return into RUN/STOP mode.</td>
</tr>
<tr>
<td></td>
<td>Shows DONE, your settings are saved. Return into RUN/STOP mode.</td>
<td></td>
</tr>
</tbody>
</table>

**Further information on page 4455**

<table>
<thead>
<tr>
<th>State</th>
<th>Description - main menu 2</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>CFG</strong></td>
<td>ESC</td>
</tr>
<tr>
<td>0</td>
<td>The processor module is in RUN/STOP mode.</td>
<td>State 1 is displayed.</td>
</tr>
<tr>
<td>1</td>
<td>State 2 is displayed.</td>
<td>Return into RUN/STOP mode.</td>
</tr>
<tr>
<td>2</td>
<td>State 3 is displayed.</td>
<td>Return into RUN/STOP mode.</td>
</tr>
<tr>
<td>3</td>
<td>State 1 is displayed.</td>
<td>Return into RUN/STOP mode.</td>
</tr>
</tbody>
</table>

**Further information on page 4455**

<table>
<thead>
<tr>
<th>State</th>
<th>Description - submenu 1</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td><strong>IPETH1</strong> or <strong>IPETH2</strong></td>
<td>State 2 is displayed.</td>
</tr>
</tbody>
</table>

**Function key CFG main menu with ETH1/ETH2 mode: “Switch functionality ETH1-ETH2”**

**Function key CFG submenu IPETH1 or IPETH2; DHCP not active**

---

The content is structured in tables and lists, providing a clear and organized presentation of the information. Each table contains states, descriptions, and results of actions taken after pressing one of the function keys. The tables are labeled with headers and subheaders for easy navigation within the document. The narrative text provides context and explanation for the tables, ensuring that the reader understands the purpose and implications of each state and action.
### State Description - submenu 1

<table>
<thead>
<tr>
<th>State</th>
<th>Description - submenu 1</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.2</td>
<td>IP Configuration (address, subnet mask, gateway)</td>
<td>State 1.3 is displayed. Aborts the menu unchanged. Return to state 1.1. State 3.2 is displayed.</td>
</tr>
<tr>
<td>1.3</td>
<td>Reset to production data (default settings).</td>
<td>State 1.4 is displayed. Aborts the menu unchanged. Return to state 1.1. Activate RESET to default by pressing <strong>OK</strong> twice. Shows DONE, your settings are saved. Return into RUN/STOP mode.</td>
</tr>
<tr>
<td>1.4</td>
<td>Activate DHCP&lt;br&gt; Sets a DHCP address.</td>
<td>State 1.2 is displayed. Aborts the menu unchanged. Return to state 1.1. Activate DHCP to default by pressing <strong>OK</strong> twice. Shows DONE, your settings are saved. Return into RUN/STOP mode.</td>
</tr>
</tbody>
</table>

### State Description - submenu 2

<table>
<thead>
<tr>
<th>State</th>
<th>Description - submenu 2</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.1</td>
<td>IPETH1 or IPETH2</td>
<td>State 2 is displayed. Aborts the menu unchanged. Return to state 0. State 2.2 is displayed.</td>
</tr>
<tr>
<td>2.2</td>
<td>DHCP active</td>
<td>State 2.3 is displayed. Aborts the menu unchanged. Return to state 2.1. --</td>
</tr>
<tr>
<td>2.3</td>
<td>IP Configuration (address, subnet mask, gateway)</td>
<td>State 2.4 is displayed. Aborts the menu unchanged. Return to state 2.1. State 3.2 is displayed.</td>
</tr>
<tr>
<td>2.4</td>
<td>Reset to production data (default settings)</td>
<td>-- Aborts the menu unchanged. Return to state 2.1. Activate RESET to default by pressing <strong>OK</strong> twice. Shows DONE, your settings are saved. Return into RUN/STOP mode.</td>
</tr>
<tr>
<td>State</td>
<td>Description - submenu 3</td>
<td>Result on pressing one of the function keys</td>
</tr>
<tr>
<td>-------</td>
<td>-------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>3.1</td>
<td>IP Configuration (address, subnet mask, gateway)</td>
<td><strong>CFG</strong> Aborts the menu unchanged. Return to state 1.1 (submenu IPETH1 or IPETH2) <strong>ESC</strong> State 2.4 is displayed. <strong>OK</strong> State 3.2 is displayed.</td>
</tr>
<tr>
<td>3.2</td>
<td>IP address A1-A4</td>
<td><strong>CFG</strong> Aborts the menu unchanged. Return to state 1.1 (submenu IPETH1 or IPETH2) <strong>ESC</strong> State 3.3 is displayed. <strong>OK</strong> Sends changed values to CPU and go to default menue RUN/STOP. Displays: DONE New settings stored in CPU. or: FAIL Failed to write new settings to CPU.</td>
</tr>
<tr>
<td>3.3</td>
<td>Subnet mask N1-N4</td>
<td><strong>CFG</strong> Aborts the menu unchanged. Return to state 1.1 (submenu IPETH1 or IPETH2) <strong>ESC</strong> State 3.4 is displayed. <strong>OK</strong> Sends changed values to CPU and go to default menue RUN/STOP. Displays: DONE New settings stored in CPU. or: FAIL Failed to write new settings to CPU.</td>
</tr>
<tr>
<td>3.4</td>
<td>Gateway G1-G4</td>
<td><strong>CFG</strong> Aborts the menu unchanged. Return to state 1.1 (submenu IPETH1 or IPETH2) <strong>ESC</strong> State 3.2 is displayed again. <strong>OK</strong> Sends changed values to CPU and go to default menue RUN/STOP. Displays: DONE New settings stored in CPU. or: FAIL Failed to write new settings to CPU.</td>
</tr>
<tr>
<td>Function key</td>
<td>Config Description - submenu 4</td>
<td>Result on pressing one of the function keys</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>CFG</td>
<td></td>
<td><strong>CFG</strong> Aborts the menu unchanged. Return to state 1.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>ESC</strong> State 4.2 is displayed. <strong>OK</strong> DHCP not active: State 1.2 is displayed. DHCP active: State 2.2 is displayed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>OK</strong> State 4.3 is displayed. Sends changed values to CPU and go to default menu RUN/STOP. Displays: DONE New settings stored in CPU. or: FAIL Failed to write new settings to CPU.</td>
</tr>
</tbody>
</table>

**State 4.1**

Change the values with the **Count up/Count down** function keys starting with current value.

★ Number is blinking if value has changed and is not yet sent to CPU.

**State 2.3** is displayed.
Aborts the menu unchanged. Return to state 4.1.

Configuration with SystemFW >=V3.5.0 and DisplayFW >=V4.1

Function key **CFG** menu level 1, with **ETH1/ETH2 mode: “Two separate interfaces”**

- Chapter 6.3.2.9.3 “Switch functionality of Ethernet interfaces ETH1/ETH2” on page 1520

Navigation starts with the processor module being in RUN/STOP mode (State 0). By pressing one of the 5 function keys a certain action is triggered. The result of this action is described in the result columns of the tables.
<table>
<thead>
<tr>
<th>State</th>
<th>Description - CFG menu level 1</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>The processor module is in RUN/STOP mode. State 1 is displayed. Remains in RUN/STOP mode. Remains in RUN/STOP mode.</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Switch is OFF. Switch is OFF. State 2 is displayed if KNX functionality is active. State 3 is displayed if KNX functionality is inactive. Return into RUN/STOP mode.</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>KNX program button (appears if functionality is active). State 3 is displayed. State 1 is displayed. Return into RUN/STOP mode.</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Refers to submenu level 2. “Function key CFG menu level 2 (IPETH1 or IPETH2);” on page 4470. State 4 is displayed. State 2 is displayed. Return into RUN/STOP mode. Only active if no changes in CFG menu. Return into RUN/STOP mode.</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Refers to submenu level 2. “Function key CFG menu level 2 (IPETH1 or IPETH2);” on page 4470. State 5 is displayed. State 3 is displayed. Return into RUN/STOP mode.</td>
<td></td>
</tr>
<tr>
<td>State</td>
<td>Description - CFG menu level 1</td>
<td>Result on pressing one of the function keys</td>
</tr>
<tr>
<td>-------</td>
<td>---------------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>5</td>
<td><img src="image1.png" alt="Image" /></td>
<td><strong>CFG</strong></td>
</tr>
<tr>
<td></td>
<td>Note: COM1 mode RS-232 (default) or RS-485 can only be shown but not changed. This is a PLC boot parameter. See Chapter 6.3.2.14.1 “Setting up a serial interface” on page 1587 and must be set in AB. See Chapter 6.3.2.14.1.3 “Configuration” on page 1587. Mode is activated in PLC boot process.</td>
<td><strong>State 6 is displayed.</strong></td>
</tr>
<tr>
<td>6</td>
<td><img src="image6.png" alt="Image" /></td>
<td><strong>State 1 is displayed.</strong></td>
</tr>
</tbody>
</table>

Refers to submenu set startup mode of PLC.
See “Function key CFG submenu show/set startup mode of PLC” on page 4475

---

**Function key CFG menu level 1, with ETH1/ETH2 mode:**
“Switch functionality ETH1-ETH2”

See Chapter 6.3.2.9.3 “Switch functionality of Ethernet interfaces ETH1/ETH2” on page 1520

Navigation starts with the processor module being in RUN/STOP mode (State 0). By pressing one of the 5 function keys a certain action is triggered. The result of this action is described in the result columns of the tables.
<table>
<thead>
<tr>
<th>State</th>
<th>Description - CFG menu level 1</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>The processor module is in RUN/STOP mode.</td>
<td><img src="image" alt="CFG" /> State 1 is displayed. <img src="image" alt="↓" /> Remains in RUN/STOP mode. <img src="image" alt="↑" /> Remains in RUN/STOP mode.</td>
</tr>
<tr>
<td>1</td>
<td>Switch is ON</td>
<td><img src="image" alt="CFG" /> State 2 is displayed if KNX functionality is active. <img src="image" alt="↓" /> State 3 is displayed if KNX functionality is inactive. <img src="image" alt="↑" /> Return into RUN/STOP mode. <img src="image" alt="Esc" /> Return into RUN/STOP mode.</td>
</tr>
<tr>
<td>2</td>
<td>KNX program button (appears if functionality is active).</td>
<td><img src="image" alt="CFG" /> State 3 is displayed. <img src="image" alt="↓" /> State 1 is displayed. <img src="image" alt="↑" /> Return into RUN/STOP mode. <img src="image" alt="Esc" /> Return into RUN/STOP mode.</td>
</tr>
<tr>
<td>3</td>
<td>Refers to submenu level 2. “Function key CFG menu level 2 (IPETH1 or IPETH2): &quot; on page 4470</td>
<td><img src="image" alt="CFG" /> State 4 is displayed. <img src="image" alt="↓" /> State 2 is displayed. <img src="image" alt="↑" /> Return into RUN/STOP mode. Only active if no changes in CFG menu. <img src="image" alt="Esc" /> Return into RUN/STOP mode.</td>
</tr>
<tr>
<td>4</td>
<td>Note: COM1 mode RS-232 (default) or RS-485 can only be shown but not changed. This is a PLC boot parameter Chapter 6.3.2.14.1 “Setting up a serial interface&quot; on page 1587 and must be set in AB Chapter 6.3.2.14.1.3 “Configuration&quot; on page 1587. Mode is activated in PLC boot process.</td>
<td><img src="image" alt="CFG" /> State 5 is displayed. <img src="image" alt="↓" /> State 3 is displayed. <img src="image" alt="↑" /> Return into RUN/STOP mode. <img src="image" alt="Esc" /> Return into RUN/STOP mode.</td>
</tr>
<tr>
<td>State</td>
<td>Description - CFG menu level 1</td>
<td>Result on pressing one of the function keys</td>
</tr>
<tr>
<td>-------</td>
<td>--------------------------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>State 1 is displayed. State 4 is displayed. Return into RUN/STOP mode. Return into RUN/STOP mode.</td>
</tr>
</tbody>
</table>

**Function key CFG menu level 2 (IPETH1 or IPETH2):**

<table>
<thead>
<tr>
<th>State</th>
<th>Description - CFG menu level 2</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>IPETH1 or IPETH2</td>
<td>State 1 is displayed. Return into RUN/STOP mode. Return into RUN/STOP mode.</td>
</tr>
<tr>
<td>1</td>
<td>IP Configuration (address, subnet mask, gateway).</td>
<td>State 2 is displayed. State 4 is displayed. Case 1, no submenu is entered: Return into RUN/STOP mode. Case 2, no changes: State 0 is displayed. Send all changes to CPU. State 5 is displayed.</td>
</tr>
<tr>
<td>2</td>
<td>nodHCP</td>
<td>State 3 is displayed. State 1 is displayed.</td>
</tr>
<tr>
<td>3</td>
<td>Activate DHCP Set a DHCP address.</td>
<td>State 4 is displayed. State 2 is displayed. State 1 is displayed.</td>
</tr>
</tbody>
</table>
### State Description - CFG menu level 2

<table>
<thead>
<tr>
<th>State</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td><strong>CFG</strong>: Refer to submenu set <em>rESEt</em>. *Func-</td>
</tr>
<tr>
<td></td>
<td>tion key CFG submenu show/set <em>RESET</em> on page 4474</td>
</tr>
<tr>
<td>5</td>
<td><strong>CFG</strong>: Remain all changes. <strong>↓</strong>: State 1 is displayed. <strong>↑</strong>: State 6 is displayed.</td>
</tr>
<tr>
<td>6</td>
<td><strong>CFG</strong>: Changes applied <em>donE</em> is displayed for 2 sec. then return into RUN/STOP mode. <strong>↓</strong>: Changes failed <em>FAILEd</em> is displayed for 2 sec. then return into RUN/STOP mode.</td>
</tr>
</tbody>
</table>

### Function key CFG menu level 3, show/set STATIC

<table>
<thead>
<tr>
<th>State</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td><strong>CFG</strong>: State 1 is displayed. <strong>↓</strong>: Aborts the menu unchanged. <strong>↑</strong>: Return to IPETH1 or IPETH2. <strong>ESC</strong>: Changes: (STATIC blinks) state 5 of previous table is displayed.</td>
</tr>
<tr>
<td>1</td>
<td><strong>CFG</strong>: Refers to submenu of A1-A4 <strong>↓</strong>: Count down A1-A4 <strong>↑</strong>: Count up A4-A1 <strong>ESC</strong>: Aborts the menu unchanged. <strong>OK</strong>: Take over new values, but don’t send to CPU. Return to CFG menu level 2 STATIC. <strong>ESC</strong>: Return to CFG menu level 2 STATIC.</td>
</tr>
</tbody>
</table>

**IP Configuration** (address, subnet mask, gateway).

**If submenu is entered**: Number is blinking if value has changed and is not yet sent to CPU.
<table>
<thead>
<tr>
<th>State</th>
<th>Description - sub-menu STATIC</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td><strong>CFG</strong></td>
</tr>
<tr>
<td>2</td>
<td>Subnet mask N1-N4</td>
<td>Refers to submenu of N1-N4</td>
</tr>
<tr>
<td></td>
<td><strong>If submenu is entered:</strong> Number is blinking if value has changed and is not yet sent to CPU.</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Gateway G1-G4</td>
<td>Refers to submenu G1-G4</td>
</tr>
<tr>
<td></td>
<td><strong>If submenu is entered:</strong> Number is blinking if value has changed and is not yet sent to CPU.</td>
<td></td>
</tr>
</tbody>
</table>

### Function key
**CFG menu level 4, Example: I/P address A4**

<table>
<thead>
<tr>
<th>State</th>
<th>Description - <strong>CFG menu level 4</strong></th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>A4 is blinking if submenu is entered.</td>
<td><strong>CFG</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>No action</td>
</tr>
</tbody>
</table>

```
### Function key
**CFG menu level 2** Show/set DHCP

<table>
<thead>
<tr>
<th>State</th>
<th>Description - show/set DHCP</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td><img src="image" alt="nodHCP" /></td>
<td><strong>CFG</strong>: State 1 is displayed.</td>
</tr>
<tr>
<td>1</td>
<td><img src="image" alt="dHCP" /></td>
<td><strong>CFG</strong></td>
</tr>
<tr>
<td>2</td>
<td><img src="image" alt="nodHCP" /></td>
<td><strong>CFG</strong></td>
</tr>
<tr>
<td>3</td>
<td><img src="image" alt="APPLY" /></td>
<td><strong>CFG</strong></td>
</tr>
<tr>
<td>4</td>
<td><img src="image" alt="donE" /></td>
<td><strong>CFG</strong></td>
</tr>
</tbody>
</table>

### Function key
**CFG menu level 2** Show/set Id

<table>
<thead>
<tr>
<th>State</th>
<th>Description - show/set Id</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td><img src="image" alt="id 000" /></td>
<td><strong>CFG</strong>: Count down value: 255 ... 000, starting with current value.</td>
</tr>
<tr>
<td>1</td>
<td><img src="image" alt="id 001" /></td>
<td><strong>CFG</strong>: Count down value: 255 ... 000, starting with current value.</td>
</tr>
</tbody>
</table>

*function key CFG menu level 2 Show/set DHCP*

*function key CFG menu level 2 Show/set Id*
### Function key CFG submenu show/set ID

<table>
<thead>
<tr>
<th>State</th>
<th>Description - show/set ID</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
</table>
| 2     | ![Image](image) *255*     | **CFG**<br>Count down value: 255 ... 000, starting with current value.  
**↑**<br>Count up value: 000 ... 255, starting with current value.  
**ESC**<br>Discard the changes. Stop blinking. Show previous value.  
**OK**<br>Go to CFG menu level 2 (IPETH1 or IPETH2) state 5-6. |

### Function key CFG submenu show/set RESET

<table>
<thead>
<tr>
<th>State</th>
<th>Description - submenu show/reset</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
</table>
| 0     | ![Image](image) **RESET**        | **CFG**<br>No action  
**↓**<br>No action  
**↑**<br>No action  
**ESC**<br>Aborts the menu unchanged. Return to submenu level 1  
**OK**<br>Aborts the menu unchanged. Return to submenu level 1 |
| 1     | ![Image](image) **RESET**        | **CFG**<br>Discard all made changes. Stop blinking. Send command “reset to factory settings” to CPU. Reset ask confirmation. Go back to default menu RUN/STOP. State 2 is displayed.  
**↓**<br>Aborts the menu unchanged. Return to submenu level 1  
**↑**<br>Aborts the menu unchanged. Return to submenu level 1  
**ESC**<br>Discard all made changes. Stop blinking. Send command “reset to factory settings” to CPU. Reset ask confirmation. Go back to default menu RUN/STOP. State 2 is displayed.  
**OK**<br>Discard all made changes. Stop blinking. Send command “reset to factory settings” to CPU. Reset ask confirmation. Go back to default menu RUN/STOP. State 2 is displayed. |
| 2     | ![Image](image) **APPLY**       | **CFG**<br>Sends changed values to CPU, displays state 3.  
**↓**<br>Aborts the menu unchanged. Return to submenu STATIC  
**↑**<br>Aborts the menu unchanged. Return to submenu STATIC  
**ESC**<br>Aborts the menu unchanged. Return to submenu STATIC  
**OK**<br>Sends changed values to CPU, displays state 3. |
| 3     | ![Image](image) **donE**        | **CFG**<br>Changes applied  
**↓**<br>Changes applied  
**↑**<br>Changes applied  
**ESC**<br>Changes applied  
**OK**<br>Changes applied  
**donE** is displayed for 2 sec. then return into RUN/STOP mode. |
|       | ![Image](image) **FAILEd**      | **CFG**<br>Changes failed  
**↓**<br>Changes failed  
**↑**<br>Changes failed  
**ESC**<br>Changes failed  
**OK**<br>Changes failed  
**FAILEd** is displayed for 2 sec. then return into RUN/STOP mode. |
### Function key CFG submenu show/set startup mode of PLC

<table>
<thead>
<tr>
<th>State</th>
<th>Description - submenu show/set startup mode of PLC</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td><img src="image1.png" alt="Image" /> <strong>Nod 00</strong></td>
<td><img src="image2.png" alt="Image" /> Count down value: 02 ... 0, starting with current value. <img src="image3.png" alt="Image" /> Count up value: 00 ... 02, starting with current value. <img src="image4.png" alt="Image" /> Aborts the menu. Go back to main menue RUN/STOP. <img src="image5.png" alt="Image" /> Sends changed values to CPU. Displays 2 sec. <strong>donE</strong>or <strong>FAILEd</strong>. Go back to main menue RUN/STOP.</td>
</tr>
<tr>
<td>1</td>
<td><img src="image6.png" alt="Image" /> <strong>Nod 01</strong></td>
<td><img src="image7.png" alt="Image" /> Count down value: 02 ... 00, starting with current value. <img src="image8.png" alt="Image" /> Count up value: 00 ... 02, starting with current value. <img src="image9.png" alt="Image" /> Aborts the menu. Go back to main menue RUN/STOP.</td>
</tr>
<tr>
<td>2</td>
<td><img src="image10.png" alt="Image" /> <strong>Nod 02</strong></td>
<td><img src="image11.png" alt="Image" /> Count down value: 02 ... 00, starting with current value. <img src="image12.png" alt="Image" /> Count up value: 00 ... 02, starting with current value. <img src="image13.png" alt="Image" /> Aborts the menu. Go back to main menue RUN/STOP.</td>
</tr>
</tbody>
</table>

### Function key CFG submenu show/set PLC ID

<table>
<thead>
<tr>
<th>State</th>
<th>Description - submenu show/set PLC ID</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td><img src="image14.png" alt="Image" /> <strong>5 OFF</strong></td>
<td><img src="image15.png" alt="Image" /> State 1 is displayed</td>
</tr>
<tr>
<td></td>
<td>Switch is OFF</td>
<td><img src="image17.png" alt="Image" /></td>
</tr>
<tr>
<td>1</td>
<td><img src="image19.png" alt="Image" /> <strong>PLC 123</strong></td>
<td><img src="image20.png" alt="Image" /> State 2 is displayed</td>
</tr>
<tr>
<td></td>
<td>PLC ID</td>
<td><img src="image22.png" alt="Image" /></td>
</tr>
<tr>
<td>2</td>
<td><img src="image24.png" alt="Image" /> ** PLC 001**</td>
<td><img src="image25.png" alt="Image" /> Count down value: 255→0, starting with current value.</td>
</tr>
<tr>
<td></td>
<td><img src="image27.png" alt="" /> Text is blinking if edit mode with keys up/down is enabled.</td>
<td><img src="image28.png" alt="Image" /> <img src="image29.png" alt="" /> Number is blinking if value has changed and is not yet sent to CPU.</td>
</tr>
</tbody>
</table>

### 6.8.2.5.6 Enable flashing of display

**Blink functionality**

As of SystemFW 3.1.0 and AB 2.1.0 the blink functionality is implemented. “Blink” means – activate flashing of backlight of AC500 display in Automation Builder via “IP-Configuration” tool.
### Wink functionality

As of SystemFW 3.1.0 and AB 2.0.0 the wink functionality is implemented. “Wink” means – activate flashing of backlight of AC500 display in Automation Builder via communication settings wink functionality.

### 6.8.2.5.7 Function blocks

**PmErrLedSet**

This function block switches the ERR-LED ON and OFF.

**PmDispSetText**

With this function block a text can be displayed on the CPU.

> Chapter 6.5.14 “Reference, function blocks” on page 4086

### 6.8.2.6 Onboard technologies

#### 6.8.2.6.1 Ethernet

**Ethernet protocols and ports for AC500-eCo V3 processor modules**

**General**

Supported as of Automation Builder V 2.4.1

<table>
<thead>
<tr>
<th>Description</th>
<th>≥ CPU firmware</th>
<th>PM5012-x-ETH</th>
<th>PM5032-x-ETH</th>
<th>PM5052-x-ETH</th>
<th>PM5072-T-2ETH(W)</th>
<th>≥ CPU firmware</th>
<th>PM5082-T-2ETH</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABB netConfig</td>
<td>V3.4.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.2</td>
<td>x</td>
</tr>
<tr>
<td>Online access with driver 3S TCP/IP BlkDrvTcp</td>
<td>V3.4.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.2</td>
<td>x</td>
</tr>
<tr>
<td>Modbus TCP server</td>
<td>V3.4.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.2</td>
<td>x</td>
</tr>
<tr>
<td>Modbus TCP client with POU ModTcpMast</td>
<td>V3.4.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.2</td>
<td>x</td>
</tr>
<tr>
<td>UDP out of user program with library netBaseService.lib</td>
<td>V3.4.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.2</td>
<td>x</td>
</tr>
<tr>
<td>UDP data exchange, Network variables</td>
<td>V3.4.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.2</td>
<td>x</td>
</tr>
<tr>
<td>TCP/IP out of user program with library netBaseService.lib</td>
<td>V3.4.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.2</td>
<td>x</td>
</tr>
<tr>
<td>Web server on PLC with web visualization</td>
<td>V3.4.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.2</td>
<td>x</td>
</tr>
<tr>
<td>IEC60870-5-104 control station incl. 2nd connection and 2nd port</td>
<td>-</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IEC60870-5-104 substation incl. 2nd port</td>
<td>V3.4.1</td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td>V3.6.2</td>
<td>x</td>
</tr>
<tr>
<td>FTP server</td>
<td>V3.4.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.2</td>
<td>x</td>
</tr>
<tr>
<td>CODESYS network variables</td>
<td>V3.4.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.2</td>
<td>x</td>
</tr>
<tr>
<td>OPC DA server</td>
<td>V3.4.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.2</td>
<td>x</td>
</tr>
<tr>
<td>OPC UA server</td>
<td>V3.4.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.2</td>
<td>x</td>
</tr>
<tr>
<td>ICMP – ping out of user project with POU ETHx_ICMP_PING</td>
<td>V3.4.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.2</td>
<td>x</td>
</tr>
</tbody>
</table>
## Description

<table>
<thead>
<tr>
<th>Description</th>
<th>≥ CPU firmware</th>
<th>PM5012-x-ETH</th>
<th>PM5032-x-ETH</th>
<th>PM5052-x-ETH</th>
<th>PM5072-T2ETH(W)</th>
<th>≥ CPU firmware</th>
<th>PM5082-T2ETH</th>
</tr>
</thead>
<tbody>
<tr>
<td>DHCP client</td>
<td>V3.4.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.2</td>
<td>x</td>
</tr>
<tr>
<td>SNTP (Simple Network Time Protocol) client system solution</td>
<td>V3.4.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.2</td>
<td>x</td>
</tr>
<tr>
<td>Chapter 6.3.4.4.2 “SNTP client configuration” on page 1718</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNTP (Simple Network Time Protocol) server system solution</td>
<td>V3.4.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.2</td>
<td>x</td>
</tr>
<tr>
<td>Chapter 6.3.4.4.3 “SNTP server configuration” on page 1720</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum number of Input/output allowed variable on Ethernet for the protocol</td>
<td>V3.4.1</td>
<td>1 kB /1 kB</td>
<td>1 kB /1 kB</td>
<td>2 kB /2 kB</td>
<td>V3.6.2</td>
<td>2 kB /2 kB</td>
<td></td>
</tr>
<tr>
<td>IEC 61850 (MMS server, GOOSE)</td>
<td>V3.4.1</td>
<td>x</td>
<td></td>
<td></td>
<td>V3.6.2</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>EthernetIP Scanner 1, 2)</td>
<td>AB 2.4.1/FW 3.4.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.2</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>EthernetIP Adapter 1, 2)</td>
<td>AB 2.4.1/FW 3.4.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.2</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>EtherCAT Master</td>
<td>V3.6.1</td>
<td>x</td>
<td></td>
<td></td>
<td>V3.6.2</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Chapter 6.3.4.7.3.2 “Secure web server” on page 1727</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>KNX - Building communication 2)</td>
<td>V3.4.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.2</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>BACnet-BC - Infrastructure communication 2)</td>
<td>V3.3.1</td>
<td>x</td>
<td></td>
<td></td>
<td>V3.6.2</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>HTTPS – secure web server on PLC with CODESYS web visualization</td>
<td>V3.4.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.2</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Chapter 6.3.4.7.3.2 “Secure web server” on page 1727</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WebVisu for data visualisation on webserver HTML5</td>
<td>V3.4.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.2</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>FTPS – secure FTP</td>
<td>V3.4.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.2</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Chapter 6.3.4.7.3.3 “Secure FTP” on page 1728</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Secure online access with driver 3S TCP/IP BlkDrvTcp</td>
<td>V3.4.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.2</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>ICMP – ping out of user project with POU ETHx_ICMP_PING or EthIcmpPing (PLCopen style)</td>
<td>V3.4.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.2</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Modbus TCP client (master) with ModTcpMast (PLCopen style)</td>
<td>V3.4.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.2</td>
<td>x</td>
<td></td>
</tr>
</tbody>
</table>

**Remarks:**

1): in preparation

2): feature is licensed

3): from ≥ AB 2.6.1 and CPU FW ≥ 3.6.2
Default open Ethernet ports of PM50xx-x-xETH

After startup without a PLC project the AC500-eCo V3 PM50xx-x-xETH contains the following Ethernet ports and sockets:

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABB NetConfig 1)</td>
<td>UDP 24576</td>
</tr>
<tr>
<td>Online access with driver 3S Tcp/Ip BlkDrvTcp (no scan)</td>
<td>TCP 11740</td>
</tr>
<tr>
<td>OPC UA server 2)</td>
<td>TCP 4840</td>
</tr>
</tbody>
</table>

Remarks:
1): The port 24576 for ABB NetConfig protocol can be disabled via PLC configuration by deleting the protocol node from configuration tree of Ethernet interfaces ETH1 and ETH2.
2): The port 4840 for OPC UA server is closed by default as of System FW V3.1.0.

All other ports are closed by default.

Overview of protocols, sockets and ports

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Port</th>
<th>Sockets</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABB netConfig</td>
<td>24576</td>
<td>1 permanent socket per interface</td>
</tr>
<tr>
<td>3S gateway client (e.g. CODESYS) to gateway server</td>
<td>1217</td>
<td>1 permanent socket</td>
</tr>
<tr>
<td>Online access with driver 3S block driver TCP/IP (no scan)</td>
<td>11740</td>
<td>1 socket per connection + 1 listen</td>
</tr>
<tr>
<td>Modbus TCP server</td>
<td>502 or configurable</td>
<td>1 socket listen + 1 socket per server connection, number of server connections is configurable in AB</td>
</tr>
<tr>
<td>Modbus TCP client with POU ModTcpMast</td>
<td>Random</td>
<td>1 socket per connection with POU ModTcpMast</td>
</tr>
<tr>
<td>UDP out of user program with library SysLibSockets.lib</td>
<td>1 ... 65535</td>
<td>1 socket per connection</td>
</tr>
<tr>
<td>TCP/IP out of user program with library SysLibSockets.lib</td>
<td>1 ... 65535</td>
<td>1 socket per connection</td>
</tr>
<tr>
<td>Web server on PLC with web visualization</td>
<td>80</td>
<td>1 listen and 1 per connection</td>
</tr>
<tr>
<td>SNTP client</td>
<td>123</td>
<td>1 permanent socket</td>
</tr>
<tr>
<td>IEC60870-5-104 substation</td>
<td>2404</td>
<td>1 per connection</td>
</tr>
<tr>
<td>FTP server</td>
<td>Command port = 21 Data active mode = 20 Data passive mode = random</td>
<td>1 per session, max. 4 allowed</td>
</tr>
<tr>
<td>CODESYS network variables</td>
<td>1202</td>
<td>(UDP broadcast)</td>
</tr>
<tr>
<td>OPC DA server (default 3S block driver)</td>
<td>UDP = 1740 or TCP/IP =11740</td>
<td>1 socket per connection</td>
</tr>
</tbody>
</table>
- **OPC UA server**: Port 4840, 1 permanent socket
- **ICMP – ping out of user project with POU ETHx_ICMP_PING DHCP**: None, no socket
- **DHCP**: Port 67, 1 socket during startup
- **SNTP (Simple Network Time Protocol) client system solution**: Chapter 6.3.4.4.2 “(S)NTP client configuration” on page 1718, 123, 1 permanent socket
- **SNTP (Simple Network Time Protocol) server system solution**: Chapter 6.3.4.4.3 “(S)NTP server configuration” on page 1720, 123, 1 permanent socket
- **HTTPS – secure web server on PLC with CODESYS web visualization**: Port 443, 1 listen and 1 per connection
- **FTPS – secure FTP**: Command port = 21, data active mode = 20, data passive mode = random, 1 per session, max. 4 allowed
- **Secure online access with driver 3S TCP/IP BlkDrvTcp**: Port 11740, 1 socket per connection + 1 listen
- **ICMP – ping out of user project with POU ETHx_ICMP_PING or EthIcmpPing (PLCopen style)**: None, no socket
- **Modbus TCP client (master) with POU ModTcpMast (PLCopen style)**: Random, 1 socket per connection with POU ModTcpMast

### Limitation of connections per protocol

#### AC500-eCo V3 processor modules

<table>
<thead>
<tr>
<th>Protocol</th>
<th>≥ CPU firmware</th>
<th>PM5012-x-ETH</th>
<th>PM5032-x-ETH</th>
<th>PM5052-x-ETH</th>
<th>PM5072-T-2ETH(W)</th>
<th>≥ CPU firmware</th>
<th>PM5082-T-2ETH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modbus TCP server (e.g. for SCADA access)</td>
<td>3.4.1</td>
<td>3</td>
<td>8</td>
<td>10</td>
<td>15</td>
<td>3.6.2</td>
<td>15</td>
</tr>
<tr>
<td>Modbus TCP client with POU ModTcpMast (PLCopen style)</td>
<td>3.4.1</td>
<td>8</td>
<td>13</td>
<td>20</td>
<td>30</td>
<td>3.6.2</td>
<td>30</td>
</tr>
<tr>
<td>IEC60870-5-104 control station incl. 2nd connection and 2nd port</td>
<td>3.4.1</td>
<td>5</td>
<td>3.6.2</td>
<td>5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IEC60870-5-104 substation incl. 2nd port</td>
<td>3.4.1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

2024/01/05 3ADR010583, 1, en_US 4479
The communication module CM5640-2ETH acts as a port extender of the used AC500 V3 CPU. It is not offloading the CPU for the protocols.

- the stacks are still executed in CPU.
- the performance is slightly lower or the load is slightly higher than directly from the main CPU, because each communication module and the communication module bus must also be handled.

Each CM5640-2ETH provides:

- 2 additional independent onboard Ethernet interfaces controlled by the CPU and not switched.
- all Ethernet ports, wherever located - on the communication module or on the CPU - must be in different subnets.

Addressing is not done via slot numbers but via IP addresses.

The Ethernet limitations of the CPU used together with CM5640-2ETH apply to all onboard and additional interfaces.
All interfaces of the onboard and CM5640-2ETH modules need to be in different subnets. Overlapping of subnets must be avoided. The selection of the used interface (ETH port) is done automatically according the match of the IP-address of the server and the subnet of the interfaces.

<table>
<thead>
<tr>
<th>Description</th>
<th>≥ CPU firmware</th>
<th>PM563 0-2ET H</th>
<th>PM565 0-2ET H</th>
<th>PM567 0-2ET H</th>
<th>PM567 5-2ET H</th>
<th>≥ CPU firmware</th>
<th>CM564 0-2ETH</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABB netConfig</td>
<td>V3.0.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>Online access with driver 3S TCP/IP BlkDrvTcp</td>
<td>V3.0.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>Modbus TCP server</td>
<td>V3.0.3</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>Modbus TCP client with POU ModTcpMast</td>
<td>V3.0.1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>UDP out of user program with library netBaseService.lib</td>
<td>V3.0.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>UDP data exchange, Network variables</td>
<td>V3.0.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>TCP/IP out of user program with library netBaseService.lib</td>
<td>V3.0.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>Web server on PLC with web visualization</td>
<td>V3.0.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>NTP/SNTP ((Simple) Network Time Protocol) client with 3S licenced store package SNTPService.package</td>
<td>V3.0.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>Library container: SNTPService</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IEC60870-5-104 control station incl. 2nd connection and 2nd port</td>
<td>V3.0.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>IEC60870-5-104 substation incl. 2nd port</td>
<td>V3.0.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>FTP server</td>
<td>V3.0.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>CODESYS network variables</td>
<td>V3.0.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>OPC DA server</td>
<td>V3.0.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>OPC UA server</td>
<td>V3.0.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>ICMP – ping out of user project with POU ETHx_ICMP_PING</td>
<td>V3.0.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>DHCP client</td>
<td>V3.1.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>NTP/SNTP ((Simple) Network Time Protocol) client system solution</td>
<td>V3.1.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>☞ Chapter 6.3.4.4.2 “(S)NTP client configuration” on page 1718</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NTP/SNTP ((Simple) Network Time Protocol) server system solution</td>
<td>V3.1.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
<tr>
<td>☞ Chapter 6.3.4.4.3 “(S)NTP server configuration” on page 1720</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum number of Input/output allowed variable on Ethernet for the protocol</td>
<td>V3.4.0</td>
<td>2 kB / 2 kB</td>
<td>4 kB / 4 kB</td>
<td>5 kB / 5 kB</td>
<td>5 kB / 5 kB</td>
<td>V3.6.0</td>
<td>Depends on used CPU</td>
</tr>
<tr>
<td>IEC 61850 (MMS server, GOOSE) 2)</td>
<td>V3.1.0</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>V3.6.0</td>
<td>x</td>
</tr>
</tbody>
</table>

2) Version 3.1.0 optimized with new dependencies for performance and security improvements.
Default open Ethernet ports of PM56xx-2ETH

After startup without a PLC project the PM56xx-2ETH contains the following Ethernet ports and sockets:

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABB NetConfig (1)</td>
<td>UDP 24576</td>
</tr>
<tr>
<td>Online access with driver 3S Tcp/lp BlkDrvTcp</td>
<td>TCP 11740</td>
</tr>
<tr>
<td>OPC UA server (2)</td>
<td>TCP 4840</td>
</tr>
</tbody>
</table>

Remarks:
1): The port 24576 for ABB NetConfig protocol can be disabled via PLC configuration by deleting the protocol node from configuration tree of Ethernet interfaces ETH1 and ETH2.
2): The port 4840 for OPC UA server is closed by default as of SystemFW V3.6.0.
All other ports are closed by default.

### Overview of protocols, sockets and ports

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Port</th>
<th>Sockets</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABB netConfig</td>
<td>24576</td>
<td>1 permanent socket per interface</td>
</tr>
<tr>
<td>3S gateway client (e.g. CODESYS) to gateway server</td>
<td>1217</td>
<td>1 permanent socket</td>
</tr>
<tr>
<td>Online access with driver 3S block driver TCP/IP (no scan)</td>
<td>11740</td>
<td>1 socket per connection + 1 listen</td>
</tr>
<tr>
<td>Modbus TCP server</td>
<td>502 or configurable</td>
<td>1 socket per server connection, number of server connections is configurable in AB</td>
</tr>
<tr>
<td>Modbus TCP client with POU ModTcMast</td>
<td>Random</td>
<td>1 socket per connection with POU ModTcMast</td>
</tr>
<tr>
<td>UDP out of user program with library SysLibSockets.lib</td>
<td>1 ... 65535</td>
<td>1 socket per connection</td>
</tr>
<tr>
<td>TCP/IP out of user program with library SysLibSockets.lib</td>
<td>1 ... 65535</td>
<td>1 socket per connection</td>
</tr>
<tr>
<td>Web server on PLC with web visualization</td>
<td>80</td>
<td>1 listen and 1 per connection</td>
</tr>
<tr>
<td>NTP/SNTP client</td>
<td>123</td>
<td>1 permanent socket</td>
</tr>
<tr>
<td>IEC60870-5-104 control station</td>
<td>Random</td>
<td>1 per connection</td>
</tr>
<tr>
<td>IEC60870-5-104 substation</td>
<td>2404</td>
<td>1 per connection</td>
</tr>
<tr>
<td>FTP server</td>
<td>Command port = 21 Data active mode = 20 Data passive mode = random</td>
<td>1 per session, max. 4 allowed</td>
</tr>
<tr>
<td>CODESYS network variables</td>
<td>1202</td>
<td>(UDP broadcast)</td>
</tr>
<tr>
<td>OPC DA server (default 3S block driver)</td>
<td>UDP = 1740 or TCP/IP =11740</td>
<td>1 socket per connection</td>
</tr>
<tr>
<td>OPC UA server</td>
<td>4840</td>
<td>1 permanent socket</td>
</tr>
<tr>
<td>ICMP – ping out of user project with POU ETHx_ICMP_PING DHCP</td>
<td>none</td>
<td>No socket</td>
</tr>
<tr>
<td>DHCP</td>
<td>67</td>
<td>1 socket during startup</td>
</tr>
<tr>
<td>NTP/SNTP ((Simple) Network Time Protocol) client system solution</td>
<td>123</td>
<td>1 permanent socket</td>
</tr>
<tr>
<td>‡Chapter 6.3.4.4.2 “(S)NTP client configuration” on page 1718</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NTP/SNTP ((Simple) Network Time Protocol) server system solution</td>
<td>123</td>
<td>1 permanent socket</td>
</tr>
<tr>
<td>‡Chapter 6.3.4.4.3 “(S)NTP server configuration” on page 1720</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Limitation of connections per protocol

The limitation for each CPU apply to all onboard Ethernet interfaces either directly on the CPU itself or also on all CM5640-2ETH interfaces that are added to this CPU.

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Port</th>
<th>Sockets</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTTPS – secure web server on PLC with CODESYS web visualization</td>
<td>443</td>
<td>1 listen and 1 per connection</td>
</tr>
<tr>
<td>Chapter 6.3.4.7.3.2 “Secure web server” on page 1727</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FTPS – secure FTP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Command port = 21, Data active mode = 20, Data passive mode = random</td>
<td></td>
<td>1 per session, max. 4 allowed</td>
</tr>
<tr>
<td>Chapter 6.3.4.7.3.3 “Secure FTP” on page 1728</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Secure online access with driver 3S TCP/IP BlkDrvTcp</td>
<td>11740</td>
<td>1 socket per connection + 1 listen</td>
</tr>
<tr>
<td>ICMP – ping out of user project with POU ETHx_ICMP_PING or EthICmpPing</td>
<td>None</td>
<td>No socket</td>
</tr>
<tr>
<td>(PLCopen style)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modbus TCP client (master) with POU ModTcpMast (PLCopen style)</td>
<td>Random</td>
<td>1 socket per connection with POU ModTcpMast</td>
</tr>
</tbody>
</table>

### Table: Limitation of connections per protocol

<table>
<thead>
<tr>
<th>Protocol</th>
<th>PM5630-2ETH</th>
<th>PM5650-2ETH</th>
<th>PM5670-2ETH</th>
<th>PM5675-2ETH</th>
<th>&gt; CPU firmware</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modbus TCP server (e.g. for SCADA access)</td>
<td>30</td>
<td>40</td>
<td>15</td>
<td>10</td>
<td>3.0.3</td>
</tr>
<tr>
<td></td>
<td>40</td>
<td>40</td>
<td>25</td>
<td>40</td>
<td>3.1.0</td>
</tr>
<tr>
<td></td>
<td>15</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>3.1.3</td>
</tr>
<tr>
<td>Modbus TCP client with POU ModTcpMast (PLCopen style)</td>
<td>30</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>3.1.0</td>
</tr>
<tr>
<td></td>
<td>30</td>
<td>50</td>
<td>120</td>
<td>120</td>
<td>3.1.3</td>
</tr>
<tr>
<td>IEC60870-5-104 control station incl. 2nd connection and 2nd port</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>3.1.0</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>10</td>
<td>20</td>
<td>20</td>
<td>3.4.0</td>
</tr>
<tr>
<td>IEC60870-5-104 substation incl. 2nd port</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>3.1.0</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>10</td>
<td>20</td>
<td>20</td>
<td>3.4.0</td>
</tr>
<tr>
<td>IEC60870-5-104: No. of free tags + additional license for extension 1)</td>
<td>1.000</td>
<td>5.000</td>
<td>10.000</td>
<td>10.000</td>
<td>3.4.0</td>
</tr>
<tr>
<td>FTP server</td>
<td>n/a</td>
<td>4</td>
<td>n/a</td>
<td>4</td>
<td>3.1.0</td>
</tr>
<tr>
<td>Online access with driver 3S TCP/IP BlkDrvTcp</td>
<td>n/a</td>
<td>8</td>
<td>n/a</td>
<td>8</td>
<td>3.0.0</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>3.1.0</td>
</tr>
<tr>
<td>OPC DA server (number of connections)</td>
<td>n/a</td>
<td>4</td>
<td>n/a</td>
<td>4</td>
<td>3.0.0</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>3.1.0</td>
</tr>
<tr>
<td>OPC UA server (number of connections)</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>3.1.0</td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>20</td>
<td>50</td>
<td>50</td>
<td>3.4.0</td>
</tr>
</tbody>
</table>
The PLC types PM5630-2ETH, PM5670-2ETH and PM5675-2ETH are available as of SystemFW 3.1.0.

### Default Ethernet configuration

<table>
<thead>
<tr>
<th>Module</th>
<th>IP Address</th>
<th>Netmask</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>PM5xx2-x-ETH</td>
<td>ETH: 192.168.0.10 ETH1: 192.168.1.10 ETH2: 192.168.1.10</td>
<td>255.255.255.0</td>
<td>The Ethernet ports must be configured in different sub networks.</td>
</tr>
<tr>
<td>PM5x0x2-T-2ETH</td>
<td>ETH1: 192.168.0.10 ETH2: 192.168.1.10</td>
<td>255.255.255.0</td>
<td>The Ethernet ports must be configured in different sub networks.</td>
</tr>
<tr>
<td>PM56xx-2ETH</td>
<td>ETH1: 192.168.0.10 ETH2: 192.168.1.10</td>
<td>255.255.255.0</td>
<td>The Ethernet ports must be configured in different sub networks.</td>
</tr>
</tbody>
</table>

- Changing the IP addresses using the Automation Builder
- Changing the IP addresses using the CFG key

### Remarks:

1): in preparation
● 1x driver “BlkDrvTcp” on port 11740
● 1x listen on port 11740 if PLC has established online connection

---

**Online access can be established from:**

- Automation Builder command ‘Login’ \(\equiv\) Chapter 6.4.1.21.3.7.2 “Command ‘Login’” on page 2624
- CODESYS OPC DA server
- Panel CP600 series

---

Each established connection needs one socket. In addition one socket on port 11740 is listening.

1. Startup the PLC.
   \(\Rightarrow\) One socket on port 11740 (listen).
2. Login from Automation Builder via driver “BlkDrvTcp”.
   \(\Rightarrow\) 2 sockets on port 11740 (1x online, 1x listen)
3. Additional login out of OPC server with the same driver.
   \(\Rightarrow\) 3 sockets on port 11740 (2x online, 1x listen)
4. Additional connect CP600 via driver “BlkDrvTcp”.
   \(\Rightarrow\) 4 sockets on port 11740 (3x online, 1x listen)

---

**SNTP client and server**

As of version 3.1.0 the SystemFW provides a SNTP Protocol implementation which can be used for time synchronization of PLC clock. It can be used as SNTP Client or / and SNTP Server. But only one instance of each can be executed at the same time on one PLC.

---

**The SNTP server is listening only on the Ethernet interface, which the protocol is configured on. It is not possible to have an SNTP server on several Ethernet interfaces.**

---

To read diagnosis information from the SNTP protocol within an IEC application the function block *PmSntpInfo* can be used. This Function block is part of the library *ABB_Pm_AC500.lib*. It can also be used to determine the synchronization state of the PLC clock.

---

**Using network variables in AC500 V3**

When using network variables via UDP broadcast, the default broadcast address is set to 255.255.255.255.

This will not work on PLCs with multiple Ethernet interfaces, because of undecidable routing.

Set the broadcast address to a matching subnet broadcast address, depending on which interface should be used to send the variables into the network.

---

**Example**

- ETH1 with IP 192.168.0.10 netmask 255.255.255.0
- ETH2 with IP 192.168.1.10 netmask 255.255.255.0

---

If you want the network variables to be broadcast on ETH1, use broadcast address 192.168.0.255.
6.8.2.6.2 Onboard CAN configuration

AC500 V3 PLCs provide the following methods for CAN integration:

- Onboard CAN interface
- CANopen master-slave arrangement (with CM598-CN as a master device)

Table 814: Differences in supported protocols

<table>
<thead>
<tr>
<th></th>
<th>Onboard CAN</th>
<th>CM598-CN</th>
</tr>
</thead>
<tbody>
<tr>
<td>CANopen Manager</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CAN 2A/2B</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>J1939</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

Onboard CAN interface is not available on AC500-eCo V3!

**Supported protocols**

Onboard CAN interface supports the following protocols

- CANopen Manager: Connection of CI581 and CI582 without additional I/O modules
- CAN 2A/2B
- J1939

Configuration in Automation Builder is described in chapter 'CANopen' Chapter 6.3.2.11.1.1 "CM598-CAN - CANopen Manager communication module" on page 1521.

Further information can be found in chapter 'CAN onboard' Chapter 6.3.2.16 “CAN onboard” on page 1594.
6.8.2.7 Hot swap

6.8.2.7.1 Preconditions for using hot swap

**Hot swap**

**WARNING!**

Risk of explosion or fire in hazardous environments during hot swapping!
Hot swap must not be performed in flammable environments to avoid life-threatening injury and property damage resulting from fire or explosion.

**WARNING!**

Electric shock due to negligent behavior during hot swapping!
To avoid electric shock:
- Make sure the following conditions apply:
  - Digital outputs are not under load.
  - Input/output voltages above safety extra low voltage/protective extra low voltage (SELV/PELV) are switched off.
  - Modules are fully interlocked with the terminal unit with both snap-fits engaged before switching on loads or input/output voltage.
  - Never touch exposed contacts (dangerous voltages).
  - Stay away from electrical contacts to avoid arc discharge.
  - Do not operate a mechanical installation improperly.

**NOTICE!**

Risk of damage to I/O modules!
Hot swapping is only allowed for I/O modules.
Processor modules and communication interface modules must not be removed or inserted during operation.

H = Hot swap

**Hot swap**

System requirements for hot swapping of I/O modules:
- Types of terminal units that support hot swapping of I/O modules have the appendix TU5xx-H.
- I/O modules as of index F0.

The following I/O bus masters support hot swapping of attached I/O modules:
- Communication interface modules CI5xx as of index F0.
- Processor modules PM56xx-2ETH with firmware version as of V3.2.0.

**Hot swap is not supported by AC500-eCo V3 CPU!**
NOTICE!
Risk of damage to I/O modules!
Modules with index below F0 can be damaged when inserted or removed from the terminal unit in a powered system.

NOTICE!
Risk of damage to I/O modules!
Do not perform hot swapping if any I/O module with firmware version lower than 3.0.14 is part of the I/O configuration.
For min. required device index see table below.

<table>
<thead>
<tr>
<th>Device</th>
<th>Min. required device index for I/O module as of FW Version 3.0.14</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC522(-XC)</td>
<td>F0</td>
</tr>
<tr>
<td>AI523 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AI531</td>
<td>D4</td>
</tr>
<tr>
<td>AI531-XC</td>
<td>D2</td>
</tr>
<tr>
<td>AI561</td>
<td>B2</td>
</tr>
<tr>
<td>AI562</td>
<td>B2</td>
</tr>
<tr>
<td>AI563</td>
<td>B3</td>
</tr>
<tr>
<td>AO523 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AO561</td>
<td>B2</td>
</tr>
<tr>
<td>AX521 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AX522 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AX561</td>
<td>B2</td>
</tr>
<tr>
<td>CD522 (-XC)</td>
<td>D1</td>
</tr>
</tbody>
</table>

The index of the module is in the right corner of the label.
Device | Min. required device index for I/O module as of FW Version 3.0.14
---|---
DA501 (-XC) | D2
DA502 (-XC) | F0
DC522 (-XC) | D2
DC523 (-XC) | D2
DC532 (-XC) | D2
DC562 | A2
DI524 (-XC) | D2
DI561 | B2
DI562 | B2
DI571 | B2
DI572 | A1
DO524 (-XC) | A3
DO526 | A2
DO526-XC | A0
DO561 | B2
DO562 | A2
DO571 | B3
DO572 | B2
DO573 | A1
DX522 (-XC) | D2
DX531 | D2
DX561 | B2
DX571 | B3
FM562 | A1

6.8.2.7.2 Compatibility of hot swap

*Hot swap is not supported by AC500-eCo V3 CPU!*

<table>
<thead>
<tr>
<th>Central I/O on V3 CPU</th>
<th>I/O module on TU5xx-H connected to I/O bus master</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>AC500 V3 CPU types: PM56xx-2ETH</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Central I/O on V3 CPU</th>
<th>Required version of I/O bus master</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Firmware as of V3.2.0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Central I/O on V3 CPU</th>
<th>Fieldbus master when used as remote I/O with AC500 V3</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>-</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Central I/O on V3 CPU</th>
<th>When used as remote I/O on third party controller (PLC or DCS)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>-</td>
</tr>
</tbody>
</table>
### Hot swap behavior

<table>
<thead>
<tr>
<th>Hot swap behavior</th>
<th>Central I/O on V3 CPU</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start-up behavior with unplugged or damaged I/O module on hot swap terminal unit TU5xx-H</td>
<td>System and I/O modules attached to the CPU are starting (except unplugged or damaged module when plugged on hot swap terminal unit).&lt;br&gt;As soon as the correct and operational I/O module is plugged on the terminal unit, the module is configured and ready to start.&lt;br&gt;No specific setting needed.</td>
</tr>
<tr>
<td>Start-up behavior with wrong I/O module type on any terminal unit</td>
<td>System and I/O modules are not starting</td>
</tr>
<tr>
<td>Diagnosis of presence of hot swap terminal unit</td>
<td>Diagnosis using PLC browser command &quot;io-bus desc&quot; in Automation Builder V3.</td>
</tr>
<tr>
<td></td>
<td>The PLC browser then provides an overview of the modules on the I/O bus including the position of hot swap terminal units in the I/O bus.</td>
</tr>
<tr>
<td></td>
<td>In the application program this can be detected with a function block &quot;IoModuleHotSwapInfo&quot;&lt;br&gt;(Library: AC500_Io/Function Blocks/I/O-Bus).</td>
</tr>
<tr>
<td></td>
<td>One instance of function block is needed per terminal unit on the I/O bus. The function block provides five outputs delivering information about slot number, hot swap capability and plugged/unplugged state of the I/O module</td>
</tr>
<tr>
<td>Diagnosis while hot swap module is pulled or module (mounted on hot swap terminal unit) has stopped working</td>
<td>If module is pulled then diagnosis Err 9480 &quot;Module removed from Hot Swap Terminal Unit&quot; is generated</td>
</tr>
<tr>
<td>Diagnosis after plugging the I/O module on the hot swap terminal unit</td>
<td>Diagnosis Err 9480 is automatically acknowledged</td>
</tr>
</tbody>
</table>

### KNX IP integration

#### 6.8.2.8.1 Introduction

KNX is a bus system used more on the room and floor level in buildings (e.g. for lighting, shading and local HVAC devices).

The KNX as such doesn’t necessarily need a dedicated controller for simple connection of sensor/switch to receiving/actuator devices.

The signals exchanged via the protocol are so called “group addresses” (“objects”), which are downloaded via ETS to all the thereby linked (=grouped) devices.

On the room level it typically has a serial wiring called KNX TP (twisted pair), which then is linked to floor or central building or management level via IP routers. On Ethernet it is called KNXnet/IP abbreviated also as KNX IP.
After the engineering in Automation Builder, the AC500 V3 PLC is a standard KNX device. KNX communication is done via the IP network interface. The PLC is arranged topologically on the area / main line of the KNX IP routers. The PLC communicates with the routers via the KNXnet/IP protocol.

6.8.2.8.2 Engineering workflow

Both engineering software systems for AC500 V3 PLC (Automation Builder) and KNX (ETS) are directly linked.

A data exchange for the group objects (hereinafter also called communication objects) from the Automation Builder to ETS (via an XML file) and received by a DCA (Device configuration APP) for ETS is available.

The AC500 V3 PLC is integrated into the ETS via a certified KNX “device” with the transferred group objects as configured in Automation Builder and a physical KNX address (transferred via ETS and KNX IP to the AC500 V3 PLC).

Programming and commissioning of the AC500 V3 PLC starts with Automation Builder:
Configuration of the AC500 V3 PLC, its communications, here KNX, and I/O modules and all necessary parameters.

1. Configure programmable KNX controller in Automation Builder by adding group objects to the device.
2. Use group objects as inputs and outputs in the IEC application.
3. Download of the above into the AC500 V3 PLC (via the engineering interface)
   The subsequent linking of the AC500 V3 PLC and the other KNX devices takes place with the vendor independent KNX commissioning software ETS:
5. Install DCA Plugin and the AC500 V3 PLC device description in ETS
6. Connect group objects in ETS and assign group addresses.
7. KNX IP download to AC500 V3 PLC.
8. The physical KNX address of the AC500 V3 PLC must be set before or during download of the KNX configuration.

The programming of the AC500 V3 PLC and the KNX commissioning can be done also by different people at different times and with same or separate engineering PCs. Both projects carry out their own download parts of their respective configurations to the AC500 V3 PLC.

The only data exchange between the two Engineering programs are the details about the KNX group objects defined in the ABB Automation Builder. This is done flexibly via the XML configuration file.

### 6.8.2.8.3 Prerequisites
- Basic AC500 and Automation Builder know-how.
- Basic experience and expertise in use of KNX and ETS (engineering software for KNX).
- PC(s) with Windows 7 or higher with administrator right(s)
- At least temporary network access to the internet for downloading and installing of:
  - Automation Builder as of version AB 2.1.2, (and e.g. example .project)
  - ETS5 and the necessary additional files (DCA .etsapp, device description .knxprod) plus possibly an matching example .knxproj) to above Automation Builder .project
- Network access to the local network, were the AC500 V3 PLC and KNX devices are connected.
- PS5604-KNX AC500 runtime license for each dedicated AC500 V3 PLC used in KNX networks.
- The current IP address of the engineering PC(s) where Automation Builder and ETS are located in same Network / masked IP range, as the AC500 V3 PLC to be used.

### 6.8.2.8.4 General settings and system behavior

The KNX interface at the AC500 V3 PLC is only active during the PLC is in RUN.

1. Download Automation Builder program.
2. Run PLC.
3. Set physical address or download KNX application Programm via ETS.
   ⇒ The bus status can be viewed in Online View of Automation Builder.

KNX communication is only working after download the matching ETS application to the AC500 V3 PLC. Until then, the AC500 V3 PLC KNX communication is deactivated and marked with a warning symbol.
6.8.2.8.5 Start-up behavior

**Start/Stop PLC**

KNX bus works only in RUN mode. If the PLC is in "STOP" mode the KNX bus and the outputs are reset.

To avoid this behavior in "STOP" mode set the following preferences at the PLC_AC500_CPU:

1. Double-click PLC_AC500_V3 <...> and click PLC Settings.
2. Enable checkbox Update IO while in stop and select in dropdown-menu Behavior for Outputs in Stop “Keep current values”.

**Warm start / Cold start**

If the PLC is reset also the connected objects will be reset on the KNX bus.

**Power ON/Off**

After Power ON the KNX Interface need approximately 1 s to start after the PLC program had started. During this period no inputs will be recognized by the PLC and no outputs will be send to the bus.

6.8.2.8.6 Engineering of KNX in Automation Builder

**Creation of KNX group objects**

Attention

This information refers to Automation Builder as of version 2.2.0.

The data exchange with the KNX bus is done via KNX group objects.
1. Double-click node “KNX” in the device tree “click General ➔ click Add”.
   ⇒ The window Communication object appears.

2. Enter your properties:
   - Group Object Number:
     The number of the KNX Group Object must match within the controller. It is displayed
     in the ETS and influences the display order in the ETS and the Automation Builder.
   - Type:
     Selection of the communication direction.
     – Input means that the controller receives values from the KNX bus.
     – Output means that the controller sends values to the KNX bus.
   - Data Point Type:
     Specification of the KNX data point type (DPT) of the Group Object. This determines
     the memory size, scaling and unit. For further information see the KNX Standard.
   - Group Object Name:
     The name of the KNX Group Object. It is freely selectable and is displayed in the ETS
     under the field name.
   - Group Object Function:
     The name of the function of the Group Object. It is freely selectable and is displayed in
     the ETS under the field Function.

Based on this selection, the flags of the KNX Group Object are set accordingly in the ETS.

You can use the [Export CSV...] button in the “General” tab menu bar to display the list of KNX
group objects in a spreadsheet program such as Excel and edit and extend it flexibly. Then you
can import them again via [Import CSV].

After you have created all the required KNX group objects, export them using the
[Export to ETS] button. This exported file contains the configuration of the KNX group objects of
the AC500 V3 PLC and is imported by ETS for linking to other KNX devices. If you have not yet
created project information under main menu “Project ➔ Project Information”, the default values
will be used during the export.

To use these KNX group objects in your application program, you must assign them with
IEC61131-3 variables. This additional abstraction layer of an additional variable allows you to
create modular automation programs that are independent of the used bus system or input /
output modules.

The assignment is possible either via the parameter page “KNX I/O Mapping” or “I/O mapping
list”. Both editors offer the same function in different representations.

On the KNX I/O Mapping page, the KNX variables are shown hierarchically. Each KNX Group
Object consists of several channels with additional information. These differ depending on
whether it is an input or an output.

The view is structured as follows:
   - Variable:
     Enter the name of the IEC 61131-3 variable that you want to assign to this channel (KNX
     Group Object).
   - Mapping:
     Shows if the channel is already linked
   - Channel:
     Name of the Channel (Channel name)
   - Address:
     The memory address under which the information is stored in the memory of the AC500 V3
     PLC. Inputs start with %I and outputs start with %Q.
   - Type:
     Specification of the IEC 61131-3 variable type
● Default Value:
The value used after starting the controller.
  – At a KNX Group Object input, this value is used by the automation program until a value has been received from the KNX bus.
  – At a KNX Group Object output, this value is sent to the bus when the controller is started.

● Unit:
  Specification of the KNX data point type (DPT)

● Description:
  Note text

A KNX Group Object “input” consists of a status and a control part:
The Channel name of the status part consists of: Object Number + Object Name + Object Function and include the following informations:

● UpdateFlag:
  This status flag is set to the value “true” for one cycle as soon as a new KNX telegram has been received. Even if the value of the telegram does not differ from the previous one.

● ValueChanged:
  This status flag is set to the value “true” as soon as a new KNX telegram has been received and the value differs from the previous one.

● ValueValid:
  This status flag is set to the value “true” as soon as a KNX telegram has been received for the first time after the controller has been started.

● WatchdogTimeout:
  As of Automation Builder 2.2.1 it will be possible to define a Watchdog Timeout for each input object. If a timeout occur this flag will be set to the value “true” for one cycle.

● Value:
  The current value of the KNX Group Object received from the KNX bus.

The Channel name of the control part consists of: “Control” + Object Number + Object Name + Object Function and include the following control possibilities:

● Reset status flags:
  When this flag is set from “false” to “true” by the automation program then the above-mentioned status flags of the KNX Group Object are reset to the value “false”.

● Send value read:
  When this flag is set from “false” to “true” by the automation program, a ValueRead telegram is sent to the KNX bus. This causes the KNX remote device to send back its current value.

A KNX Group Object “output” is represented as follows:
The Channel name of the Group Object consists of: Object Number + Object Name + Object Function

● Trigger Output:
  When this flag is set from “false” to “true” by the automation program, the current value is sent immediately to the KNX bus. The sending conditions that are may be activated in the ETS (send on change and cyclic sending) will be restarted

● Disable Output:
  As long this flag is set to “true” by the automation program, the sending conditions send on change and cyclic sending in the ETS are deactivated.

● Value:
  The current value of the KNX Group Object that is sent to the KNX bus.

The permanently defined Program LED Status represent the function as known in other KNX devices, showing the status of the programming LED.

Create an application program

The KNX variables defined on the KNX I/O Mapping page are available programwide under IoConfig_Globals_Mapping.
These you can see if you click in to the programming window and either via right-click select "Input Assistant" or press F2.

Export XML file

To exchange the configured KNX group objects the configuration has to be exported via XML file.

If later both projects (from Automation Builder and ETS) are loaded on the PLC, the PLC checks if the two projects have the same source and fit together. This will be done by an automatically calculated Checksum. For calculating the Checksum the following information’s from the Project information will be used:

- Company
- Title
- Version
- Timestamp

This Information will also be shown in the ETS after loading the XML file. If the user has not entered any project information some default values will be set.
6.8.2.8.7 Integration of the PLC in KNX

Insert controller

1. Start the ETS and insert the PS5604-KNX AC500 as controller from the ETS device catalog into your ETS project.
2. Assign a physical KNX address to the controller.
   - The controller is placed topologically on the IP Main Area.

Import configuration
1. Select the “PS5604-KNX AC500” in the ETS explorer tree and click on “DCA” tab in the editor window.
2. Click on Load Configuration and select the configuration XML file.
   ⇒ The KNX group objects defined in AC500 V3 PLC in Automation Builder are displayed in the ETS.

Connect controller with KNX devices
1. Right-click on a “PS5604-KNX AC500” group object and assign a KNX group address or drag and drop from group address window.
2. Interlink group objects by assigning the same KNX Group Address.

Parameters of the device
The following settings are possible in the ETS parameters of the PS5604-KNX AC500.

Tab General settings

![General Settings Tab](image)
● Default Gateway:
The used KNXnet/IP broadcast address. This must match the KNX system (KNX IP router). It is the default setting that is usually not changed.
  – The entry field Default Gateway can contain another IP address for the Multicast communication. The normal Multicast IP address for KNX is 224.0.23.12.
  – If another Multicast IP address is to be used, it can be chosen in the area from 239.0.0.0 to 239.255.255.255. This alternative Multicast IP address can be defined in the input field Default Gateway.

● Telegram rate:
The maximum transmission rate of the AC500 V3 PLC can be limited in order to prevent an excessive bus load and thus to avoid malfunction of the KNX system.
The KNX telegrams are buffered until they have been sent. New values which have been calculated by the automation program in the meantime are updating the cached values. The old cached value is discarded and not sent.

● Project Information:
At this point, the project information of the Automation Builder project is displayed.

Tab Object 1 .. 3

For each KNX Group Object of the AC500 V3 PLC an Object entry is displayed in the device parameters. This is named after the number of the KNX Group Object.

For outputs (controller sends to the KNX bus) the KNX transmission conditions can be set:
- Communication direction:
  Setting of the transmission direction of the object.
  - Input (KNX to PLC): The controller receives values from the KNX bus.
  - Output (PLC to KNX): The controller sends values to the KNX bus.
- Send condition (only for outputs):
  Setting whether the Controller sends a telegram to the KNX bus automatically when the
  object value is changed. The following options are available
  - No automatic sending:
    No automatic sending to the KNX bus. This must be done via the program code by the
    Trigger Output flag.
  - Send on change:
    Every time the object value changes, a telegram is sent to the KNX bus. No matter how
    minor this change is.
  - Send on difference (only for group objects which are not DPT 1.* Boolean): Every time
    the object value changes, this value is only sent to the KNX bus if it differs from the last
    sent value at least by the settable difference.
- Sending difference (only if Send on difference is active):
  Input of the difference by which the object value must change to be send. You can enter
  numbers with decimal places.
- Cyclic sending (only for outputs):
  Setting whether in addition the object value is sent cyclically repeatedly to the bus. This also
  happens if this object value has not changed. Two different range of values for the cycle
  time can be specified.
- Cycle time (only when Cyclic sending is active):
  Specification of the cycle time for the cyclic transmission.
  Input format:
  hour:minute:second
  Note: The cycle time of the KNX stack depends on the cycle time of the task that executes
  the stack. A long task time causes long download times from ETS. Consider the CPU load
  and cycle times of other processes running on the CPU when selecting a cycle time for the
  KNX stack.

Regardless of the set transmission conditions, the program code can trigger by the flag **Trigger Output** a sending of the value to the KNX bus at any time.

By activating the flag **Read on Init** of the KNX group objects in the right ETS properties panel, the Controller sends a value read query to the connected KNX device at startup. This then responds with its current object value.

In this properties panel you can also select the appropriate subdata point type of the KNX Group Object. This defines the unit of the value in the KNX system. For example DPT 9.001 represents temperature in °C.
If for example the response of an actuator state is needed for an input "Aktor A Status", this feature can be enabled in the parameter of the Switch Actuator (e.g. 1.1.6 SA/S4.10.1).
The current IP address as well as further information of the AC500 V3 PLC can be read via the ETS Device Info function. For this the physical KNX address is necessary. You can determine the address by the ETS function **Programming Mode**.

With the ETS function **Group Monitor** you can analyze the telegrams on the KNX bus. You can also use it to write/read KNX telegrams.

### Download ETS configuration to controller

The download of the ETS configuration to the AC500 V3 PLC is done via the ETS function "Download" in the menu bar. This download happens via the KNX interface directly to the AC500 V3 PLC.

Best you select in ETS the network interface of the computer as the bus interface. Thus, a fast data exchange is possible and the data is not routed via the KNX TP bus.

At the first download, the physical KNX address of the controller is programmed. To do this, set the AC500 V3 PLC to KNX programming mode.

This can be done either via the display or functions inside the application program of the controller (e.g. connected to a Webvisu like done in the example program).

#### Via AC500 display

1. Press the **CFG** function key.
   - Switch is OFF (S OFF) is displayed.
2. Press the **Arrow Down** function key
   - Pbut 0 is displayed.
   - (Pbut is standing for programing button, the 0 (or the 1) showing the status of the programming LED (0=Off; 1 =ON))
3. Press the **CFG** function key.
   - The display shows Pbut 1 flashing.
4. Confirm this with the **OK** function key.
   - The display permanently shows Pbut 1. The AC500 V3 PLC is in KNX programming mode.

#### Attention!

The activation of the KNX programming mode via the display only works with Automation Builder as of version 2.2.0.

The KNX configuration of AC500-eCo V3 uses TA5130-KNXPB.

#### The AC500 V3 PLC must be in RUN mode.

1. Ensure the TA5130-KNXPB is plugged in during power up, PLC is in RUN mode.
2. Ensure that TA5130-KNXPB is configured inside Automation Builder configuration.
3. Push the button on the TA5130-KNXPB.

   ✰ The LED on the option board should turn ON. The AC500-eCo V3 is in KNX programming mode.

The AC500 V3 PLC automatically terminates the KNX programming mode after the programming of the physical KNX address.

Alternatively you can terminate the programming mode with Pbut 0 by pressing the CFG function key.

For AC500-eCo V3: push the button on the TA5130-KNXPB again to terminate the programming mode, the LED should turn OFF.

You can exit the menu at any time with the ESC function key.

**Via AC500 application**

Please use the following variable for setting the KNX Program Button:

AC500_IoDrvKNX.GVL.IoDrvKNXCpyChannels.ProgramButton

The controller automatically terminates the programming mode after programming the physical address with the ETS.

The AC500 V3 PLC has then besides the Automation Builder configuration also the appropriate ETS configuration and starts its KNX communication.

Download all other linked KNX devices as well as the KNX IP routers. The ETS automatically creates the filter tables of the KNX IP routers so that the KNX telegrams are routed from the KNX TP lines to the IP line of the AC500 Controller.

**6.8.2.8 Make changes**

Changes can be made in the Automation Builder as well as in the ETS without the need for a change in the other software or the need for a new data exchange.

Only if changes are made to the KNX group objects in the Automation Builder, a data exchange with the ETS is again necessary. Afterwards, a download is required both in the Automation Builder and in the ETS. Only when these two configurations have been downloaded again to the AC500 V3 PLC, the KNX communication is in operation again.

The DCA detects changes to names and numbers of the KNX group objects when importing the configuration file in the ETS and keeps the already made settings and linked Group Addresses of these changed group objects.

**6.8.2.9 Data conversion**

The KNX standard defines a big-endian byte order while the IEC 61131-3 is based on the little-endian byte order. Therefore, the controller automatically converts the data point types.

However, if you access the bits of the structured KNX data point types (DPT) for time, date (DPT 10.*, DPT 16.*, DPT 19.*) in your program code, you have to note the reverse byte order. Therefore, as of Automation Builder version 2.2.0, corresponding function libraries are available that provide conversion functions for these data point types.
Further information

- Example projects can be found in the example folder, “Help ➔ Project examples”.
- **Prerequisite**: Install the related library package with Automation Builder Installation Manager - [Modify].
- Programming in IEC61131 is described in the application example AC500 V3 KNX IP Integration.
- Further information can be found on the ABB website: ABB products and services.
6.8.2.9 Communication with Modbus RTU

6.8.2.9.1 Protocol description

The Modbus RTU protocol is implemented in the AC500 processor modules. Modbus is a master-slave (client-server) protocol. The client sends a request to the server and receives the responses.

The Modbus operating mode of a serial interface is set in the PLC configuration \( \text{Chapter 6.3.2.14.2 "Configuring Modbus RTU on serial interface" on page 1588.} \)

To use the AC500 V3 or AC500-eCo V3 as a Modbus RTU client two possible programming methods can be used:

- ModRtuMast
- ModRtuToken with Read/Write function blocks

**ModRtuMast**

With this method the Modbus client function block ModRtuMast is used to program all read and/or write jobs in a sequence. If more than one ModRtuMast function block is used, e.g. for several server connections, the sequence must take care that only one of those ModRtuMast function blocks is active at a time.

A summary of the function codes that are supported for Modbus RTU communication with an AC500 PLC is given in the application example **Modbus RTU and function block ModRtuMast**.

**ModRtuToken with Read/Write function blocks**

With this method the function block ModRtuToken is used along with ModRtuRead and/or ModRtuWrite and/or ModRtuReadWrite23.

Instead of programming a sequence a simple connection via structure variables between the function blocks is necessary to ensure the sequencial functionality of Modbus RTU.

A sample project for Modbus client and server in order to enable Modbus RTU communication with an AC500 PLC is given in the application example **Modbus RTU and function block ModRtuMast**.

---

To use Modbus RTU protocol on an AC500-eCo V3 PLC, the CPU must be equipped with an option board for COMx serial communication TA5141-RS232I, TA5142-RS485 or TA5142-RS485I option board. The type of the option board adapter must be selected according to the type of physical serial interface needed.

According to the CPU type, up to 3 option boards for COMx serial communication can be used \( \text{Chapter 6.3.2.8.4 “Attach an option board for COMx serial communication” on page 1505.} \)

Modbus RTU can be used for communication between an AC500-eCo V3 PLC and a control panel. The connection principle is described using the CP604 control panel as an example: **CP604 connection via Modbus RTU**.

**Modbus client**

In this operating mode, the telegram traffic with the server(s) is handled via the function block ModRtuMast.

This function block sends Modbus request telegrams to the server(s) via the set interface and receives Modbus response telegrams from the server(s) via this interface.

The Modbus blocks transferred by the server contain the following information:

- Modbus address of the interrogated server (1 byte)
- Function code that defines the request of the client (1 byte)
- Data to be exchanged (n bytes)
- CRC16 control code (2 bytes)

**Modbus server**  
In this operating mode, no function block is required for Modbus communication. Sending and receiving Modbus telegrams is performed automatically.

The AC500 CPUs process the following Modbus operation codes:

<table>
<thead>
<tr>
<th>Function code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 or 02</td>
<td>Read n bits</td>
</tr>
<tr>
<td>03 or 04</td>
<td>Read n words</td>
</tr>
<tr>
<td>05</td>
<td>Write one bit (encoded in one word)</td>
</tr>
<tr>
<td>06</td>
<td>Write one word</td>
</tr>
<tr>
<td>15</td>
<td>Write n bits (encoded in one byte)</td>
</tr>
<tr>
<td>16</td>
<td>Write n words</td>
</tr>
<tr>
<td>22</td>
<td>Mask write</td>
</tr>
<tr>
<td>23</td>
<td>Read/write multiple words in one telegram</td>
</tr>
</tbody>
</table>

The following restrictions apply to the length of the data to be sent:

<table>
<thead>
<tr>
<th>Function code</th>
<th>Max. length</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 or 02</td>
<td>2000 bits</td>
</tr>
<tr>
<td>03 or 04</td>
<td>125 words / 62 double words</td>
</tr>
<tr>
<td>05</td>
<td>1 bit</td>
</tr>
<tr>
<td>06</td>
<td>1 word</td>
</tr>
<tr>
<td>15</td>
<td>2000 bits</td>
</tr>
<tr>
<td>16</td>
<td>123 words / 61 double words</td>
</tr>
<tr>
<td>22</td>
<td>Write: 1 word</td>
</tr>
</tbody>
</table>
| 23            | Read: 125 words / 62 double words  
Write: 121 words / 60 double words |

**6.8.2.9.2 Technical data**

Setting of the Modbus operating mode and the interface parameters
### Table 815: Description of the Modbus protocol

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported standard</td>
<td>§ Chapter 6.3.2.14.2 “Configuring Modbus RTU on serial interface” on page 1588</td>
</tr>
<tr>
<td>Number of connection points</td>
<td>1 client</td>
</tr>
<tr>
<td></td>
<td>Max. 1 server with RS-232 interface</td>
</tr>
<tr>
<td></td>
<td>Max. 31 servers with RS-485</td>
</tr>
<tr>
<td>Protocol</td>
<td>Modbus</td>
</tr>
<tr>
<td>Operating mode</td>
<td>Client/server</td>
</tr>
<tr>
<td>Address</td>
<td>Server only</td>
</tr>
<tr>
<td>Data transmission control</td>
<td>CRC16</td>
</tr>
<tr>
<td>Data transmission speed</td>
<td>From 9,600 bits/s to 115,200 bits/s</td>
</tr>
<tr>
<td></td>
<td>§ Chapter 6.3.2.14.2 “Configuring Modbus RTU on serial interface” on page 1588</td>
</tr>
<tr>
<td>Encoding</td>
<td>1 start bit</td>
</tr>
<tr>
<td></td>
<td>8 data bits</td>
</tr>
<tr>
<td></td>
<td>1 or 2 stop bits</td>
</tr>
<tr>
<td></td>
<td>1 parity bit</td>
</tr>
<tr>
<td></td>
<td>§ Chapter 6.3.2.14.2 “Configuring Modbus RTU on serial interface” on page 1588</td>
</tr>
</tbody>
</table>

### Table 816: Max. cable length

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max. cable length for RS-485 on COM1 for AC500 CPU</td>
<td>1.200 m at 19.200 baud</td>
</tr>
</tbody>
</table>

### 6.8.2.9.3 Modbus addresses for AC500-eCo V3 processor modules PM50x2

Modbus address table

A range of maximum 64 kB is allowed for the access via Modbus to the addressable flag area (%M area). Thus, the complete address range 0000hex up to 7FFFhex is available for Modbus.

The availability of the segments depends on the CPU. The size of the %M area can be found in the technical data of the CPUs and in the target system settings.

Inputs and outputs cannot be directly accessed using Modbus.

Following values apply:

<table>
<thead>
<tr>
<th></th>
<th>PM5012-x-ETH</th>
<th>PM5032-x-ETH</th>
<th>PM5052-x-ETH</th>
<th>PM5072-T-2ETH(W)</th>
<th>PM5082-T-2ETH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size of the %M area</td>
<td>4 kB</td>
<td>16 kB</td>
<td>16 kB</td>
<td>64 kB</td>
<td>64 kB</td>
</tr>
<tr>
<td>Modbus address range (Word accesses)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HEX</td>
<td>0000 … 07FF</td>
<td>0000 … 1FFF</td>
<td>0000 … 1FFF</td>
<td>0000 … 7FFF</td>
<td>0000 … 7FFF</td>
</tr>
<tr>
<td>DEC</td>
<td>0000 … 2047</td>
<td>0000 … 8191</td>
<td>0000 … 8191</td>
<td>0000 … 32767</td>
<td>0000 … 32767</td>
</tr>
<tr>
<td>Byte</td>
<td>%MB0 … %MB4097</td>
<td>%MB0 … %MB16382</td>
<td>%MB0 … %MB16382</td>
<td>%MB0 … %MB65534</td>
<td>%MB0 … %MB65534</td>
</tr>
<tr>
<td>Word</td>
<td>%MW0 … %MW2047</td>
<td>%MW0 … %MW8191</td>
<td>%MW0 … %MW8191</td>
<td>%MW0 … %MW32767</td>
<td>%MW0 … %MW32767</td>
</tr>
</tbody>
</table>
### 6.8.2.9.4 Modbus addresses for AC500 V3 processor modules PM56xx

#### Modbus address table

*Table 817: Modbus addresses (word accesses)*

<table>
<thead>
<tr>
<th>Modbus address</th>
<th>Byte</th>
<th>Bit (byte-oriented)</th>
<th>Word</th>
<th>Double word</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>HEX</td>
<td>BYTE</td>
<td>BOOL</td>
<td>WORD</td>
</tr>
<tr>
<td>0000</td>
<td>0</td>
<td>%MB0</td>
<td>%MX0.0 ... %MX0.7</td>
<td>%MW0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>%MB1</td>
<td>%MX1.0 ... %MX1.7</td>
<td></td>
</tr>
<tr>
<td>0001</td>
<td>1</td>
<td>%MB2</td>
<td>%MX2.0 ... %MX2.7</td>
<td>%MW1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>%MB3</td>
<td>%MX3.0 ... %MX3.7</td>
<td></td>
</tr>
<tr>
<td>0002</td>
<td>2</td>
<td>%MB4</td>
<td>%MX4.0 ... %MX4.7</td>
<td>%MW2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>%MB5</td>
<td>%MX5.0 ... %MX5.7</td>
<td></td>
</tr>
<tr>
<td>0003</td>
<td>3</td>
<td>%MB6</td>
<td>%MX6.0 ... %MX6.7</td>
<td>%MW3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>%MB7</td>
<td>%MX7.0 ... %MX7.7</td>
<td></td>
</tr>
<tr>
<td>...</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7FFE</td>
<td>32766</td>
<td>%MB65532</td>
<td>%MX65532.0 ... %MX65532.7</td>
<td>%MW32766</td>
</tr>
<tr>
<td></td>
<td></td>
<td>%MB65533</td>
<td>%MX65533.0 ... %MX65533.7</td>
<td></td>
</tr>
<tr>
<td>7FFF</td>
<td>32767</td>
<td>%MB65534</td>
<td>%MX65534.0 ... %MX65534.7</td>
<td>%MW32767</td>
</tr>
<tr>
<td></td>
<td></td>
<td>%MB65535</td>
<td>%MX65535.0 ... %MX65535.7</td>
<td></td>
</tr>
<tr>
<td>8000</td>
<td>32768</td>
<td>%MB65536</td>
<td>%MX65536.0 ... %MX65536.7</td>
<td>%MW32768</td>
</tr>
<tr>
<td></td>
<td></td>
<td>%MB65537</td>
<td>%MX65537.0 ... %MX65537.7</td>
<td></td>
</tr>
<tr>
<td>8001</td>
<td>32769</td>
<td>%MB65538</td>
<td>%MX65538.0 ... %MX65538.7</td>
<td>%MW32769</td>
</tr>
<tr>
<td></td>
<td></td>
<td>%MB65539</td>
<td>%MX65539.0 ... %MX65539.7</td>
<td></td>
</tr>
<tr>
<td>8002</td>
<td>32770</td>
<td>%MB65540</td>
<td>%MX65540.0 ... %MX65540.7</td>
<td>%MW32770</td>
</tr>
<tr>
<td>Modbus address</td>
<td>Modbus address</td>
<td>Byte</td>
<td>Bit (byte-oriented)</td>
<td>Word</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------</td>
<td>------</td>
<td>---------------------</td>
<td>------</td>
</tr>
<tr>
<td>HEX</td>
<td>DEC</td>
<td>BYTE</td>
<td>BOOL</td>
<td>WORD</td>
</tr>
<tr>
<td>8003</td>
<td>32771</td>
<td>%MB65541</td>
<td>%MX65541.0 ...</td>
<td>%MW32771</td>
</tr>
<tr>
<td></td>
<td></td>
<td>%MB65542</td>
<td>%MX65542.0 ...</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>%MB65543</td>
<td>%MX65543.0 ...</td>
<td></td>
</tr>
<tr>
<td>FFFE</td>
<td>65534</td>
<td>%MB131068</td>
<td>%MX131068.0 ...</td>
<td>%MW65534</td>
</tr>
<tr>
<td></td>
<td></td>
<td>%MB131069</td>
<td>%MX131068.0 ...</td>
<td></td>
</tr>
<tr>
<td>FFFF</td>
<td>65535</td>
<td>%MB131070</td>
<td>%MX131070.0 ...</td>
<td>%MW65535</td>
</tr>
<tr>
<td></td>
<td></td>
<td>%MB131071</td>
<td>%MX131070.0 ...</td>
<td></td>
</tr>
</tbody>
</table>

Table 818: Address assignment (bit accesses)

<table>
<thead>
<tr>
<th>Modbus address</th>
<th>Modbus address</th>
<th>Byte</th>
<th>Bit (byte-oriented)</th>
<th>Word</th>
<th>Double word</th>
</tr>
</thead>
<tbody>
<tr>
<td>HEX</td>
<td>DEC</td>
<td>BYTE</td>
<td>BOOL</td>
<td>WORD</td>
<td>DWORD</td>
</tr>
<tr>
<td>0000</td>
<td>0</td>
<td>%MB0</td>
<td>%MX0.0</td>
<td>%MW0</td>
<td></td>
</tr>
<tr>
<td>0001</td>
<td>1</td>
<td></td>
<td>%MX0.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0002</td>
<td>2</td>
<td></td>
<td>%MX0.2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0003</td>
<td>3</td>
<td></td>
<td>%MX0.3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0004</td>
<td>4</td>
<td></td>
<td>%MX0.4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0005</td>
<td>5</td>
<td></td>
<td>%MX0.5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0006</td>
<td>6</td>
<td></td>
<td>%MX0.6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0007</td>
<td>7</td>
<td></td>
<td>%MX0.7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0008</td>
<td>8</td>
<td>%MB1</td>
<td>%MX1.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0009</td>
<td>9</td>
<td></td>
<td>%MX1.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>000A</td>
<td>10</td>
<td></td>
<td>%MX1.2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>000B</td>
<td>11</td>
<td></td>
<td>%MX1.3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>000C</td>
<td>12</td>
<td></td>
<td>%MX1.4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>000D</td>
<td>13</td>
<td></td>
<td>%MX1.5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modbus address</td>
<td>Byte</td>
<td>Bit (byte-oriented)</td>
<td>Word</td>
<td>Double word</td>
<td></td>
</tr>
<tr>
<td>----------------</td>
<td>------</td>
<td>---------------------</td>
<td>------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>HEX</td>
<td>DEC</td>
<td>BYTE</td>
<td>BOOL</td>
<td>WORD</td>
<td>DWORD</td>
</tr>
<tr>
<td>000E</td>
<td>14</td>
<td></td>
<td>%MX1.6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>000F</td>
<td>15</td>
<td></td>
<td>%MX1.7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0010</td>
<td>16</td>
<td>%MB2</td>
<td>%MX2.0</td>
<td>%MW1</td>
<td></td>
</tr>
<tr>
<td>0011</td>
<td>17</td>
<td></td>
<td>%MX2.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0012</td>
<td>18</td>
<td></td>
<td>%MX2.2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0013</td>
<td>19</td>
<td></td>
<td>%MX2.3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0014</td>
<td>20</td>
<td></td>
<td>%MX2.4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0015</td>
<td>21</td>
<td></td>
<td>%MX2.5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0016</td>
<td>22</td>
<td></td>
<td>%MX2.6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0017</td>
<td>23</td>
<td></td>
<td>%MX2.7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0018</td>
<td>24</td>
<td>%MB3</td>
<td>%MX3.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0019</td>
<td>25</td>
<td></td>
<td>%MX3.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>001A</td>
<td>26</td>
<td></td>
<td>%MX3.2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>001B</td>
<td>27</td>
<td></td>
<td>%MX3.3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>001C</td>
<td>28</td>
<td></td>
<td>%MX3.4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>001D</td>
<td>29</td>
<td></td>
<td>%MX3.5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>001E</td>
<td>30</td>
<td></td>
<td>%MX3.6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>001F</td>
<td>31</td>
<td></td>
<td>%MX3.7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0020</td>
<td>32</td>
<td>%MB4</td>
<td>%MX4.0</td>
<td>%MW2</td>
<td>%MD1</td>
</tr>
<tr>
<td>0021</td>
<td>33</td>
<td></td>
<td>%MX4.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0022</td>
<td>34</td>
<td></td>
<td>%MX4.2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>0FFF</td>
<td>4095</td>
<td>%MB511</td>
<td>%MX511.7</td>
<td>%MW255</td>
<td>%MD127</td>
</tr>
<tr>
<td>1000</td>
<td>4096</td>
<td>%MB512</td>
<td>%MX512.0</td>
<td>%MW256</td>
<td>%MD128</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>7FFF</td>
<td>32767</td>
<td>%MB4095</td>
<td>%MX4095.7</td>
<td>%MW2047</td>
<td>%MD1023</td>
</tr>
<tr>
<td>8000</td>
<td>32768</td>
<td>%MB4096</td>
<td>%MX4096.0</td>
<td>%MW2048</td>
<td>%MD1024</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>FFFF</td>
<td>65535</td>
<td>%MB8191</td>
<td>%MX8191.7</td>
<td>%MW4095</td>
<td>%MD2047</td>
</tr>
</tbody>
</table>

Calculation of the bit variable from the hexadecimal address:

**Formula:**

\[
\text{Bit variable (BOOL)} := \%\text{MXBYTE.BIT}
\]

where:

- **DEC** Decimal address
- **BYTE** \( \text{DEC} / 8 \)
- **BIT** \( \text{DEC mod 8} \) (Modulo division)
Examples:

- Address hexadecimal = 16#2002
  
  DEC := 8194
  BYTE := 8194 / 8 := 1024
  BIT := 8194 mod 8 := 2
  Bit variable: %MX1024.2

- Address hexadecimal = 16#3016
  
  DEC := 12310
  BYTE := 12310 / 8 := 1538,75 -> 1538
  BIT := 12310 mod 8 := 6
  Bit variable: %MX1538.6

- Address hexadecimal = 16#55AA
  
  DEC := 21930
  BYTE := 21930 / 8 := 2741,25 -> 2741
  BIT := 21930 mod 8 := 2
  Bit variable: %MX2741.2

Calculation of the hexadecimal address from the bit variable:

Examples:

- Bit variable := %MX515.4
  
  DEC := 515 * 8 + 4 := 4124
  Address hex := 16#101C

- Bit variable := %MX3.3
  
  DEC := 3 * 8 + 3 := 27
  Address hex := 16#001B

- Bit variable := %MX6666.2
  
  DEC := 6666 * 8 + 2 := 53330
  Address hex := 16#D052

Peculiarities for accessing Modbus addresses

Peculiarities for bit access:

- A WORD in the %M area is assigned to each Modbus address 0000hex .. FFFFhex.
- Bit addresses 0000hex .. FFFFhex are contained in the word range %MW0 .. %MW4095

Areas protect from read/write access by Modbus client

As described in 'Protocols and special servers' Chapter 6.3.4.3.2 "Configuration of Modbus TCP/IP server" on page 1714, one write-protected and one read-protected area can be defined. If you try to write to a write-protected area or to read from a read-protected area, an exception response is generated.

6.8.2.9.5  Local data of the Modbus client

The address of the area from which data are to be read or to which data are to be written is specified in the function block ModRtuMast at input "Data", via the ADR operator.

For the AC500, the following areas can be accessed using the ADR operator:

- Inputs area (%I area)
- Outputs area (%Q area)
Area of non-buffered variables (VAR .. END_VAR or VAR_GLOBAL END_VAR)
Addressable flag area (also protected areas for %M area)
Area of buffered variables (VAR RETAIN .. END_VAR or VAR_GLOBAL RETAIN .. END_VAR)

6.8.2.9.6 Modbus telegrams

General

The sending and receiving of telegrams shown in this section are not visible in the PLC. However, the complete telegrams can be made visible using a serial data analyzer connected to the connection line between server and client, if required.

The amount of user data depends on the capabilities of the server and the client.

For the following examples, it is assumed that one AC500 Modbus module is used as client and another one is used as server. There may be different properties if modules of other manufacturers are used.

FCT 1 or 2: Read n bits

Table 819: Client request

<table>
<thead>
<tr>
<th>Server address</th>
<th>Function code</th>
<th>Server operand address</th>
<th>Number of bits</th>
<th>CRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>Low</td>
<td>High</td>
<td>Low</td>
<td>High</td>
</tr>
</tbody>
</table>

Table 820: Server response

<table>
<thead>
<tr>
<th>Server address</th>
<th>Function code</th>
<th>Number of Bytes</th>
<th>...Data...</th>
<th>CRC</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>High</td>
</tr>
</tbody>
</table>

FCT 3 or 4: Read n words

Table 821: Client request

<table>
<thead>
<tr>
<th>Server address</th>
<th>Function code</th>
<th>Server operand address</th>
<th>Number of words</th>
<th>CRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>Low</td>
<td>High</td>
<td>Low</td>
<td>High</td>
</tr>
</tbody>
</table>

Table 822: Server response

<table>
<thead>
<tr>
<th>Server address</th>
<th>Function code</th>
<th>Number of Bytes</th>
<th>Data</th>
<th>CRC</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>High</td>
</tr>
</tbody>
</table>

FCT 3 or 4: Read n double words

The function code "read double word" is not defined in the Modbus RTU standard. This is why the double word is composed of a low word and a high word (depending on the manufacturer).

See Chapter 6.8.2.9.6.3 “FCT 3 or 4: Read n words” on page 4513.
FCT 5: Write 1 bit

For the function code "write 1 bit", the value of the bit to be written is encoded in one word.

BIT = TRUE -> Data word = FF 00 HEX  
BIT = FALSE -> Data word = 00 00 HEX

Table 823: Client request

<table>
<thead>
<tr>
<th>Function code</th>
<th>Server operand address</th>
<th>Number of words</th>
<th>CRC</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>High</td>
<td>Low</td>
<td>High</td>
</tr>
</tbody>
</table>

Table 824: Server response

<table>
<thead>
<tr>
<th>Function code</th>
<th>Server operand address</th>
<th>Data</th>
<th>CRC</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>High</td>
<td>Low</td>
<td>High</td>
</tr>
</tbody>
</table>

FCT 6: Write 1 word

Table 825: Server request

<table>
<thead>
<tr>
<th>Server address</th>
<th>Function code</th>
<th>Server operand address</th>
<th>Data</th>
<th>CRC</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>High</td>
<td>Low</td>
<td>High</td>
</tr>
</tbody>
</table>

Table 826: Server response

<table>
<thead>
<tr>
<th>Server address</th>
<th>Function code</th>
<th>Server operand address</th>
<th>Data</th>
<th>CRC</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>High</td>
<td>Low</td>
<td>High</td>
</tr>
</tbody>
</table>

FCT 15: Write n bits

Table 827: Client request

<table>
<thead>
<tr>
<th>Server operand address</th>
<th>Number of bits</th>
<th>Number of bytes</th>
<th>...Data...</th>
<th>CRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>Low</td>
<td>High</td>
<td>Low</td>
<td>High</td>
</tr>
</tbody>
</table>

Table 828: Server response

<table>
<thead>
<tr>
<th>Server address</th>
<th>Function code</th>
<th>Server operand address</th>
<th>Number of bits</th>
<th>CRC</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>High</td>
<td>Low</td>
<td>High</td>
</tr>
</tbody>
</table>

FCT 16: Write n words

Table 829: Client request

<table>
<thead>
<tr>
<th>Server operand address</th>
<th>Number of words</th>
<th>Number of bytes</th>
<th>...Data...</th>
<th>CRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>Low</td>
<td>High</td>
<td>Low</td>
<td>High</td>
</tr>
</tbody>
</table>
**Table 830: Server response**

<table>
<thead>
<tr>
<th>Function code</th>
<th>Server operand address</th>
<th>Number of words</th>
<th>CRC</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>High</td>
<td>Low</td>
<td></td>
</tr>
<tr>
<td></td>
<td>High</td>
<td>Low</td>
<td></td>
</tr>
</tbody>
</table>

**FCT 16: Write n double words**

The function code "write double word" is not defined in the Modbus RTU standard. This is why the double word is composed of a low word and a high word (depending on the manufacturer).

**Table 831: Client request**

<table>
<thead>
<tr>
<th>Server operand address</th>
<th>Number of words</th>
<th>Number of bytes</th>
<th>...Data...</th>
<th>CRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>Low</td>
<td>High</td>
<td>Low</td>
<td></td>
</tr>
</tbody>
</table>

**Table 832: Server response**

<table>
<thead>
<tr>
<th>Server address</th>
<th>Function code</th>
<th>Server operand address</th>
<th>Number of words</th>
<th>CRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>Low</td>
<td>High</td>
<td>Low</td>
<td></td>
</tr>
</tbody>
</table>

**FCT 22: Mask write register**

**Table 833: Client request**

<table>
<thead>
<tr>
<th>Server address</th>
<th>Function code</th>
<th>Server operand address</th>
<th>AND Mask</th>
<th>OR Mask</th>
<th>CRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>Low</td>
<td>High</td>
<td>Low</td>
<td>High</td>
<td>Low</td>
</tr>
</tbody>
</table>

**Table 834: Server response**

<table>
<thead>
<tr>
<th>Server address</th>
<th>Function code</th>
<th>Server operand address</th>
<th>AND Mask</th>
<th>OR Mask</th>
<th>CRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>Low</td>
<td>High</td>
<td>Low</td>
<td>High</td>
<td>Low</td>
</tr>
</tbody>
</table>

**FCT 23: Read/Write n words**

**Table 835: Client request**

<table>
<thead>
<tr>
<th>Server address</th>
<th>Function code</th>
<th>Operands read addr</th>
<th>Number of words read</th>
<th>Operands write addr</th>
<th>Number of words write</th>
<th>Number of bytes write</th>
<th>...Data...</th>
<th>CRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>Low</td>
<td>High</td>
<td>Low</td>
<td>High</td>
<td>Low</td>
<td>High</td>
<td>Low</td>
<td></td>
</tr>
</tbody>
</table>

**Table 836: Server response**

<table>
<thead>
<tr>
<th>Server address</th>
<th>Function code</th>
<th>Number of bytes read</th>
<th>...Data...</th>
<th>CRC</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>High</td>
<td>Low</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Exception response by server

In operating mode Modbus client, the AC500 does only send requests, if the parameters at the ModRtuMast inputs are logically correct.

Nevertheless, it can happen that a server cannot process the request of the client or that the server cannot interpret the request due to transmission errors or in case it’s capabilities are exceeded in any way. In those cases, the server returns an exception response to the client. In order to identify this response as an exception response, the function code returned by the server is a logical OR interconnection of the function code received from the client and the value 80HEX.

Table 837: Server response

<table>
<thead>
<tr>
<th>Server address</th>
<th>OR 80HEX</th>
<th>Error code</th>
<th>CRC</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Possible error codes of the client

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>01DEC</td>
<td>ILLEGAL FUNCTION</td>
</tr>
<tr>
<td></td>
<td>The server does not support the function requested by the client</td>
</tr>
<tr>
<td>02DEC</td>
<td>ILLEGAL DATA ADDRESS</td>
</tr>
<tr>
<td></td>
<td>Invalid operand address in the server or operand area exceeded</td>
</tr>
<tr>
<td>03DEC</td>
<td>ILLEGAL DATA VALUE</td>
</tr>
<tr>
<td></td>
<td>At least one value is outside the permitted range of values</td>
</tr>
<tr>
<td>04DEC</td>
<td>SERVER DEVICE FAILURE</td>
</tr>
<tr>
<td></td>
<td>An unrecoverable error occurred while the server was attempting to perform the requested action</td>
</tr>
<tr>
<td>05DEC</td>
<td>ACKNOWLEDGE</td>
</tr>
<tr>
<td></td>
<td>Specialized use in conjunction with programming commands.</td>
</tr>
<tr>
<td></td>
<td>The server has accepted the request and is processing it, but a long duration of time will be required to do so. This response is returned to prevent a timeout error from occurring in the client. The client can next issue a Poll Program Complete message to determine if processing is completed</td>
</tr>
<tr>
<td>06DEC</td>
<td>SERVER DEVICE BUSY</td>
</tr>
<tr>
<td></td>
<td>Specialized use in conjunction with programming commands.</td>
</tr>
<tr>
<td></td>
<td>The server is engaged in processing a long-duration program command. The client should retransmit the message later when the server is free.</td>
</tr>
<tr>
<td>07DEC</td>
<td>NEGATIVE ACKNOWLEDGE</td>
</tr>
<tr>
<td></td>
<td>Specialized use in conjunction with programming commands.</td>
</tr>
<tr>
<td></td>
<td>The server cannot perform the programming functions. Client should request diagnostic or error information from server.</td>
</tr>
<tr>
<td>08DEC</td>
<td>MEMORY PARITY ERROR</td>
</tr>
<tr>
<td></td>
<td>Specialized use in conjunction with function codes 20 and 21 and reference type 6, to indicate that the extended file area failed to pass a consistency check. The server attempted to read record file, but detected a parity error in the memory. The client can retry the request, but service may be required on the server device.</td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>10DEC</td>
<td>GATEWAY PATH UNAVAILABLE&lt;br&gt;Specialized use in conjunction with gateways, indicates that the gateway was unable to allocate an internal communication path from the input port to the output port for processing the request. Usually means that the gateway is misconfigured or overloaded.</td>
</tr>
<tr>
<td>11DEC</td>
<td>GATEWAY TARGET DEVICE FAILED TO RESPOND&lt;br&gt;Specialized use in conjunction with gateways, indicates that no response was obtained from the target device. Usually means that the device is not present on the network.</td>
</tr>
</tbody>
</table>

**Example**

**Table 838: Modbus request of the client**

<table>
<thead>
<tr>
<th>Function code:</th>
<th>01</th>
<th>Read n bits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server operand address:</td>
<td>4000HEX = 16384DEC</td>
<td>Area for read access disabled in server</td>
</tr>
</tbody>
</table>

**Table 839: Modbus response of the server**

<table>
<thead>
<tr>
<th>Function code:</th>
<th>81HEX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error code:</td>
<td>03</td>
</tr>
</tbody>
</table>

6.8.2.9.7 Processing bits

**General**

Some of the Modbus function codes are used to read or write bits (coils, discrete inputs). While a variable of data type WORD can be accessed easily, accessing a stream of bits is complex.

Data type 'BIT' ◦ [Chapter 6.4.1.20.5.11 “Data Type ‘BIT’” on page 2243](#) must not be mixed up with data type 'BOOL' ◦ [Chapter 6.4.1.20.5.2 “Data type ‘BOOL’” on page 2235](#). Variables of both types may have values ‘TRUE’ or ‘FALSE’. But while BIT means one single bit only, BOOL requires a byte (8 bit) of memory.

**Modbus client**

When accessing bits in a Server, the local data referred to at Client function blocks input data is always expected to be of format BOOL.
Modbus server

Using the bit offset

The simplest way to access a certain bit within a larger variable is to directly use the bit offset (0 based; \( \text{Chapter 6.4.1.20.4.11 "Bit Access in Variables" on page 2229} \)).
Defining symbolic names for the bit offsets

A more convenient way to access bits e.g. within a word is to define a symbolic name for each single offset. Chapter 6.4.1.20.4.11 “Bit Access in Variables” on page 2229.

```plaintext
VAR GLOBAL CONSTANT
  (*bit offsets in awWordVariable[0]*)
  NameBitOffset_0_00 : INT := 0;
  NameBitOffset_0_01 : INT := 1;
  (*...*)
  NameBitOffset_0_15 : INT := 15;
  (*bit offsets in awWordVariable[7]*)
  NameBitOffset_7_00 : INT := 0;
  NameBitOffset_7_01 : INT := 1;
  (*...*)
  NameBitOffset_7_15 : INT := 15;
END VAR

VAR
  awWordVariable AT %M0 : ARRAY [0..7] OF WORD;
END VAR

avWordVariable[0].NameBitOffset_0_00 := TRUE;
awWordVariable[7].NameBitOffset_7_15 := FALSE;
```
Defining a data type

A further alternative is to define your own data types \cite{Chapter 6.4.1.21.2.9 "Object 'DUT'" on page 2461} according to the requirements of your particular application \cite{“Symbolic bit access in structure variables” on page 2230}.

```plaintext
TYPE ControlWordType :
  STRUCT
    NameBitOffset_00 : BIT;
    NameBitOffset_01 : BIT;
    NameBitOffset_02 : BIT;
    NameBitOffset_03 : BIT;
    NameBitOffset_04 : BIT;
    NameBitOffset_05 : BIT;
    NameBitOffset_06 : BIT;
    NameBitOffset_07 : BIT;
    NameBitOffset_08 : BIT;
    NameBitOffset_09 : BIT;
    NameBitOffset_10 : BIT;
    NameBitOffset_11 : BIT;
    NameBitOffset_12 : BIT;
    NameBitOffset_13 : BIT;
    NameBitOffset_14 : BIT;
    NameBitOffset_15 : BIT;
  END_STRUCT
END_TYPE

VAR
  atTypeVariable AT M500 : ARRAY [0..7] OF ControlWordType;
END_VAR

atTypeVariable[0].NameBitOffset_00 := TRUE;
atTypeVariable[7].NameBitOffset_15 := FALSE;
```
Defining a complex data type

In case your application requires some more complex data types you can combine data types (DUT; “Symbolic bit access in structure variables” on page 2230).

```
TYPE ControlWord0Type :
  STRUCT
    NameBitOffset_0_00 : BIT;
    NameBitOffset_0_01 : BIT;
    NameBitOffset_0_02 : BIT;
    NameBitOffset_0_03 : BIT;
    NameBitOffset_0_04 : BIT;
    NameBitOffset_0_05 : BIT;
    NameBitOffset_0_06 : BIT;
    NameBitOffset_0_07 : BIT;
    NameBitOffset_0_08 : BIT;
    NameBitOffset_0_09 : BIT;
    NameBitOffset_0_10 : BIT;
    NameBitOffset_0_11 : BIT;
    NameBitOffset_0_12 : BIT;
    NameBitOffset_0_13 : BIT;
    NameBitOffset_0_14 : BIT;
    NameBitOffset_0_15 : BIT;
  END_STRUCT
END_TYPE

TYPE ControlWord1Type :
  STRUCT
    NameBitOffset_1_00 : BIT;
    NameBitOffset_1_01 : BIT;
    NameBitOffset_1_02 : BIT;
    NameBitOffset_1_03 : BIT;
    NameBitOffset_1_04 : BIT;
    NameBitOffset_1_05 : BIT;
    NameBitOffset_1_06 : BIT;
    NameBitOffset_1_07 : BIT;
    NameBitOffset_1_08 : BIT;
    NameBitOffset_1_09 : BIT;
    NameBitOffset_1_10 : BIT;
    NameBitOffset_1_11 : BIT;
    NameBitOffset_1_12 : BIT;
    NameBitOffset_1_13 : BIT;
    NameBitOffset_1_14 : BIT;
    NameBitOffset_1_15 : BIT;
  END_STRUCT
END_TYPE

TYPE ControlWordListType :
  STRUCT
    ControlWord0 : ControlWord0Type;
    ControlWord1 : ControlWord1Type;
  END_STRUCT
END_TYPE

VAR
  atWordListType AT &HW0 : ControlWordListType;
END_VAR
atWordListType.ControlWord0.NameBitOffset_0_00 := TRUE;
atWordListType.ControlWord1.NameBitOffset_1_15 := FALSE;
```
Pack/unpack BOOL variables

In case you prefer variables of type BOOL you can use the functions for packing MEM_Pack_BitsToByte and unpacking MEM_UnpackWord of the CAA_Memory.library, which can be found with the Library Manager "Chapter 6.5.3 “Library Manager functionality” on page 3773.

```plaintext
VAR
  abBoolVariable : ARRAY [0..15] OF BOOL;
  wWordVariable0 : AT N000 WORD;
  wWordVariable1 : AT N001 WORD;
END_VAR

VAR
  Unpack : Mem.UnpackWord;
END_VAR

abBoolVariable[0] := TRUE;
abBoolVariable[15] := FALSE;

wWordVariable0 := Mem.PackBitsToWord(abBoolVariable[0], abBoolVariable[1], abBoolVariable[2], abBoolVariable[3],
  abBoolVariable[4], abBoolVariable[5], abBoolVariable[6], abBoolVariable[7],
  abBoolVariable[8], abBoolVariable[9], abBoolVariable[10], abBoolVariable[11],
  abBoolVariable[12], abBoolVariable[13], abBoolVariable[14], abBoolVariable[15]);

wWordVariable1 := 1;
Unpack(wValue:= wWordVariable1,
  xBit0=> abBoolVariable[0], xBit1=> abBoolVariable[1], xBit2=> abBoolVariable[2], xBit3=> abBoolVariable[3],
  xBit4=> abBoolVariable[4], xBit5=> abBoolVariable[5], xBit6=> abBoolVariable[6], xBit7=> abBoolVariable[7],
  xBit8=> abBoolVariable[8], xBit9=> abBoolVariable[9], xBit10=> abBoolVariable[10], xBit11=> abBoolVariable[11],
  xBit12=> abBoolVariable[12], xBit13=> abBoolVariable[13], xBit14=> abBoolVariable[14], xBit15=> abBoolVariable[15]);
```

6.8.2.9.8 Function block ModRtuMast

This function block is only required in the operating mode Modbus client. It handles the communication (transmission of telegrams to the servers and receipt of telegrams from the servers). The function block can be used for the local serial interfaces of the controller. A separate instance of the function block has to be used for each interface.

`ModRtuMast` is contained in the library `AC500_ModRtuMast`.
6.8.2.10 Communication with Modbus TCP/IP

6.8.2.10.1 Protocol description

The Modbus TCP protocol is implemented in the AC500 processor modules. Modbus is a master-slave (client-server) protocol. The client sends a request to the server and receives the responses. Each Ethernet interface can work as Modbus client and server interface in parallel if required.

The Modbus operating mode of an Ethernet interface is set in Modbus on TCP/IP protocol in Chapter 6.3.4.3.1 “Modbus on TCP/IP protocol” on page 1713.

Modbus client

In this operating mode, the telegram traffic with the server(s) is handled via the function block ModTcpMast, which can be found through the Library Manager in Chapter 6.5.3 “Library Manager functionality” on page 3773. This function block sends Modbus request telegrams to the server(s) via the set interface and receives Modbus response telegrams from the server(s) via this interface.

The Modbus function blocks transferred by the client contain the following information:

- Transaction identifier for synchronization between messages of server and client (2 byte)
- Protocol identifier (0 for Modbus/TCP) (2 byte)
- Length field (Number of bytes in frame) (2 byte)
- Unit identifier (1 byte)
- Function code that defines the request of the client (1 byte)
- Data to be exchanged (n bytes)

Modbus server

In this operating mode, no function block is required for Modbus communication. Sending and receiving Modbus telegrams is performed automatically.

The AC500 CPUs process the following Modbus operation codes:

<table>
<thead>
<tr>
<th>Function code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 or 02</td>
<td>Read n bits</td>
</tr>
<tr>
<td>03 or 04</td>
<td>Read n words</td>
</tr>
<tr>
<td>05</td>
<td>Write one bit (encoded in one word)</td>
</tr>
<tr>
<td>06</td>
<td>Write one word</td>
</tr>
<tr>
<td>15</td>
<td>Write n bits (encoded in one byte)</td>
</tr>
<tr>
<td>16</td>
<td>Write n words</td>
</tr>
<tr>
<td>22</td>
<td>Mask write</td>
</tr>
<tr>
<td>23</td>
<td>Read/write multiple words in one telegram</td>
</tr>
</tbody>
</table>

The following restrictions apply to the length of the data to be sent:

<table>
<thead>
<tr>
<th>Function code</th>
<th>Max. length</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 or 02</td>
<td>2000 bits</td>
</tr>
<tr>
<td>03 or 04</td>
<td>125 words / 62 double words</td>
</tr>
<tr>
<td>Function code</td>
<td>DEC</td>
</tr>
<tr>
<td>---------------</td>
<td>-----</td>
</tr>
<tr>
<td></td>
<td>05</td>
</tr>
<tr>
<td></td>
<td>06</td>
</tr>
<tr>
<td></td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>16</td>
</tr>
<tr>
<td>Write:</td>
<td>22</td>
</tr>
<tr>
<td>Read:</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 6.8.2.10.2 Technical data

Configuration of Modbus on TCP/IP is described in the chapter 'Protocols and special servers' in Chapter 6.3.4.3 “Modbus protocol” on page 1713.

### 6.8.2.10.3 Modbus addresses for AC500-eCo V3 processor modules PM50xx

**Modbus address table**

A range of maximum 64 kB is allowed for the access via Modbus to the addressable flag area (%M area). Thus, the complete address range 0000hex up to 7FFFhex is available for Modbus. The availability of the segments depends on the CPU. The size of the %M area can be found in the technical data of the CPUs and in the target system settings.

Inputs and outputs cannot be directly accessed using Modbus. Following values apply:

<table>
<thead>
<tr>
<th>Size of the %M area</th>
<th>PM5012-x-ETH</th>
<th>PM5032-x-ETH</th>
<th>PM5052-x-ETH</th>
<th>PM5072-T-2ETH(W)</th>
<th>PM5082-T-2ETH</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 kB</td>
<td>16 kB</td>
<td>16 kB</td>
<td>64 kB</td>
<td>64 kB</td>
<td></td>
</tr>
</tbody>
</table>

**Modbus address range (Word accesses)**

<table>
<thead>
<tr>
<th>HEX</th>
<th>PM5012-x-ETH</th>
<th>PM5032-x-ETH</th>
<th>PM5052-x-ETH</th>
<th>PM5072-T-2ETH(W)</th>
<th>PM5082-T-2ETH</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000 ... 07FF</td>
<td>0000 ... 1FFF</td>
<td>0000 ... 1FFF</td>
<td>0000 ... 7FFF</td>
<td>0000 ... 7FFF</td>
<td></td>
</tr>
<tr>
<td>0000 ... 2047</td>
<td>0000 ... 8191</td>
<td>0000 ... 8191</td>
<td>0000 ... 32767</td>
<td>0000 ... 32767</td>
<td></td>
</tr>
<tr>
<td>Byte</td>
<td>%MB0 ... %MB4097</td>
<td>%MB0 ... %MB16382</td>
<td>%MB0 ... %MB16382</td>
<td>%MB0 ... %MB65534</td>
<td>%MB0 ... %MB65534</td>
</tr>
<tr>
<td></td>
<td>%MBW0 ... %MW2047</td>
<td>%MBW0 ... %MW8191</td>
<td>%MBW0 ... %MW8191</td>
<td>%MBW0 ... %MW32767</td>
<td>%MBW0 ... %MW32767</td>
</tr>
</tbody>
</table>
### Modbus addresses for AC500 V3 processor modules PM56xx

#### Modbus address table

*Table 840: Modbus addresses (word accesses)*

<table>
<thead>
<tr>
<th>Modbus address</th>
<th>Byte</th>
<th>Bit (byte-oriented)</th>
<th>Word</th>
<th>Double word</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000</td>
<td>0</td>
<td>%MB0</td>
<td>%MW0</td>
<td>%MD0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>%MB1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0001</td>
<td>1</td>
<td>%MB2</td>
<td>%MW1</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>%MB3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0002</td>
<td>2</td>
<td>%MB4</td>
<td>%MW2</td>
<td>%MD1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>%MB5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0003</td>
<td>3</td>
<td>%MB6</td>
<td>%MW3</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>%MB7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>...</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7FFE</td>
<td>3276</td>
<td>%MB65532</td>
<td>%MW3276</td>
<td>%MD16383</td>
</tr>
<tr>
<td></td>
<td></td>
<td>%MB65533</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7FFF</td>
<td>3276</td>
<td>%MB65534</td>
<td>%MW3276</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>%MB65535</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8000</td>
<td>3276</td>
<td>%MB65536</td>
<td>%MW3276</td>
<td>%MD16384</td>
</tr>
<tr>
<td></td>
<td></td>
<td>%MB65537</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8001</td>
<td>3276</td>
<td>%MB65538</td>
<td>%MW3276</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>%MB65539</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8002</td>
<td>3277</td>
<td>%MB65540</td>
<td>%MW32770</td>
<td>%MD16385</td>
</tr>
</tbody>
</table>
### Table 841: Address assignment (bit accesses)

<table>
<thead>
<tr>
<th>Modbus address</th>
<th>Byte BYTE</th>
<th>Bit (byte-oriented) BOOL</th>
<th>Word WORD</th>
<th>Double word DWORD</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000</td>
<td>%MB0</td>
<td>%MX0.0</td>
<td>%MW0</td>
<td>%MD0</td>
</tr>
<tr>
<td>0001</td>
<td></td>
<td>%MX0.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0002</td>
<td></td>
<td>%MX0.2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0003</td>
<td></td>
<td>%MX0.3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0004</td>
<td></td>
<td>%MX0.4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0005</td>
<td></td>
<td>%MX0.5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0006</td>
<td></td>
<td>%MX0.6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0007</td>
<td></td>
<td>%MX0.7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0008</td>
<td>%MB1</td>
<td>%MX1.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0009</td>
<td></td>
<td>%MX1.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>000A</td>
<td></td>
<td>%MX1.2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>000B</td>
<td></td>
<td>%MX1.3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>000C</td>
<td></td>
<td>%MX1.4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>000D</td>
<td></td>
<td>%MX1.5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modbus address</td>
<td>Byte</td>
<td>Bit (byte-oriented)</td>
<td>Word</td>
<td>Double word</td>
</tr>
<tr>
<td>----------------</td>
<td>------</td>
<td>---------------------</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>HEX</td>
<td>DEC</td>
<td>BYTE</td>
<td>BOOL</td>
<td>WORD</td>
</tr>
<tr>
<td>000E</td>
<td>14</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>000F</td>
<td>15</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0010</td>
<td>16</td>
<td>%MB2</td>
<td>%MX2.0</td>
<td>%MW1</td>
</tr>
<tr>
<td>0011</td>
<td>17</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0012</td>
<td>18</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0013</td>
<td>19</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0014</td>
<td>20</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0015</td>
<td>21</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0016</td>
<td>22</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0017</td>
<td>23</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0018</td>
<td>24</td>
<td>%MB3</td>
<td>%MX3.0</td>
<td></td>
</tr>
<tr>
<td>0019</td>
<td>25</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>001A</td>
<td>26</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>001B</td>
<td>27</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>001C</td>
<td>28</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>001D</td>
<td>29</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>001E</td>
<td>30</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>001F</td>
<td>31</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0020</td>
<td>32</td>
<td>%MB4</td>
<td>%MX4.0</td>
<td>%MW2</td>
</tr>
<tr>
<td>0021</td>
<td>33</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0022</td>
<td>34</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0FFF</td>
<td>4095</td>
<td>%MB511</td>
<td>%MX511.7</td>
<td>%MW255</td>
</tr>
<tr>
<td>1000</td>
<td>4096</td>
<td>%MB512</td>
<td>%MX512.0</td>
<td>%MW256</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7FFF</td>
<td>32767</td>
<td>%MB4095</td>
<td>%MX4095.7</td>
<td>%MW2047</td>
</tr>
<tr>
<td>8000</td>
<td>32768</td>
<td>%MB4096</td>
<td>%MX4096.0</td>
<td>%MW2048</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FFFF</td>
<td>65535</td>
<td>%MB8191</td>
<td>%MX8191.7</td>
<td>%MW4095</td>
</tr>
</tbody>
</table>

Calculation of the bit variable from the hexadecimal address:

**Formula:**

\[
\text{Bit variable (BOOL)} := \%\text{MXYBYTE.BIT}
\]

where:

- DEC: Decimal address
- BYTE: DEC / 8
- BIT: DEC mod 8 (Modulo division)
Examples:

- Address hexadecimal = 16#2002
  DEC := 8194
  BYTE := 8194 / 8 := 1024
  BIT := 8194 mod 8 := 2
  Bit variable: %MX1024.2

- Address hexadecimal = 16#3016
  DEC := 12310
  BYTE := 12310 / 8 := 1538,75 -> 1538
  BIT := 12310 mod 8 := 6
  Bit variable: %MX1538.6

- Address hexadecimal = 16#55AA
  DEC := 21930
  BYTE := 21930 / 8 := 2741,25 -> 2741
  BIT := 21930 mod 8 := 2
  Bit variable: %MX2741.2

Calculation of the hexadecimal address from the bit variable:

Examples:

- Bit variable := %MX515.4
  DEC := 515 * 8 + 4 := 4124
  Address hex := 16#101C

- Bit variable := %MX3.3
  DEC := 3 * 8 + 3 := 27
  Address hex := 16#001B

- Bit variable := %MX6666.2
  DEC := 6666 * 8 + 2 := 53330
  Address hex := 16#D052

Peculiarities for accessing Modbus addresses

Peculiarities for bit access:

- A WORD in the %M area is assigned to each Modbus address 0000hex .. FFFFhex.
- Bit addresses 0000hex .. FFFFhex are contained in the word range %MW0 .. %MW4095

Areas protect from read/write access by Modbus client

As described in 'Protocols and special servers' Chapter 6.3.4.3.2 "Configuration of Modbus TCP/IP server" on page 1714, one write-protected and one read-protected area can be defined. If you try to write to a write-protected area or to read from a read-protected area, an exception response is generated.

6.8.2.10.5 Local data of the Modbus client

The address of the area from which data are to be read or to which data are to be written is specified in the function block ModTcpMast at input "Data", via the ADR operator.

For more information about the function blocks use the Library Manager Chapter 6.5.3 "Library Manager functionality" on page 3773.

For the AC500, the following areas can be accessed using the ADR operator:
6.8.2.10.6 Modbus telegrams

For a detailed description of the Modbus TCP telegrams and their elements please see the corresponding specifications on public websites.

**Exception response by server**

In operating mode Modbus client, the AC500 does only send requests, if the parameters at the MODMAST inputs are logically correct. Nevertheless, it can happen that a server cannot process the request of the client or that the server cannot interpret the request due to transmission errors or in case it’s capabilities are exceeded in any way. In those cases, the server returns an exception response to the client. In order to identify this response as an exception response, the function code returned by the server is a logical OR interconnection of the function code received from the client and the value 80HEX.

**Table 842: Server response**

<table>
<thead>
<tr>
<th>Error code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>01DEC</td>
<td>ILLEGAL FUNCTION&lt;br&gt;The server does not support the function requested by the client</td>
</tr>
<tr>
<td>02DEC</td>
<td>ILLEGAL DATA ADDRESS&lt;br&gt;Invalid operand address in the server or operand area exceeded</td>
</tr>
<tr>
<td>03DEC</td>
<td>ILLEGAL DATA VALUE&lt;br&gt;At least one value is outside the permitted range of values</td>
</tr>
<tr>
<td>04DEC</td>
<td>SERVER DEVICE FAILURE&lt;br&gt;An unrecoverable error occurred while the server was attempting to perform the requested action</td>
</tr>
<tr>
<td>05DEC</td>
<td>ACKNOWLEDGE&lt;br&gt;Specialized use in conjunction with programming commands.&lt;br&gt;The server has accepted the request and is processing it, but a long duration of time will be required to do so. This response is returned to prevent a timeout error from occurring in the client. The client can next issue a Poll Program Complete message to determine if processing is completed</td>
</tr>
</tbody>
</table>
### Code Description

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
</table>
| 06DEC  | SERVER DEVICE BUSY  
Specialized use in conjunction with programming commands.  
The server is engaged in processing a long-duration program command. The client should retransmit the message later when the server is free. |
| 07DEC  | NEGATIVE ACKNOWLEDGE  
Specialized use in conjunction with programming commands.  
The server cannot perform the programming functions. Client should request diagnostic or error information from server. |
| 08DEC  | MEMORY PARITY ERROR  
Specialized use in conjunction with function codes 20 and 21 and reference type 6, to indicate that the extended file area failed to pass a consistency check. The server attempted to read record file, but detected a parity error in the memory. The client can retry the request, but service may be required on the server device. |
| 09DEC  | UNDEFINED  
Actually not defined by Modbus specification but might be used by particular servers. |
| 10DEC  | GATEWAY PATH UNAVAILABLE  
Specialized use in conjunction with gateways, indicates that the gateway was unable to allocate an internal communication path from the input port to the output port for processing the request. Usually means that the gateway is misconfigured or overloaded. |
| 11DEC  | GATEWAY TARGET DEVICE FAILED TO RESPOND  
Specialized use in conjunction with gateways, indicates that no response was obtained from the target device. Usually means that the device is not present on the network. |

### Example

**Table 843: Modbus request of the client**

<table>
<thead>
<tr>
<th>Function code:</th>
<th>01</th>
<th>Read n bits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server operand address:</td>
<td>4000HEX = 16384DEC</td>
<td>Area for read access disabled in server</td>
</tr>
</tbody>
</table>

**Table 844: Modbus response of the server**

<table>
<thead>
<tr>
<th>Function code:</th>
<th>81HEX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error code:</td>
<td>03</td>
</tr>
</tbody>
</table>

### 6.8.2.10.7 Processing bits

**General**

Some of the Modbus function codes are used to read or write bits (coils, discrete inputs). While a variable of data type WORD can be accessed easily, accessing a stream of bits is complex.
Data type 'BIT' must not be mixed up with data type 'BOOL'. Variables of both types may have values 'TRUE' or 'FALSE'. But while BIT means one single bit only, BOOL requires a byte (8 bit) of memory.

Modbus client

When accessing bits in a Server, the local data referred to at Client function blocks input data is always expected to be of format BOOL.

```plaintext
VAR
abBoolArray : ARRAY [0..15] OF BOOL;
ModMast : ModTcpMast;
END_VAR

abBoolArray[0] := TRUE;

ModMast.Execute := ModMastExecute,
  Eth:= ETH1,
  IPAdr:= IP_ADR_STRING_TO_DWORD('192.168.0.100'),
  UnitID:= 0,
  Fct:= 15,
  Addr:= 16#0000,
  Nb:= SIZEOF(abBoolArray),
  Data:= ADR(abBoolArray));
```

Modbus server

Using the bit offset

The simplest way to access a certain bit within a larger variable is to directly use the bit offset (0 based).
Defining symbolic names for the bit offsets

A more convenient way to access bits e.g. within a word is to define a symbolic name for each single offset \(^\circ\) Chapter 6.4.1.20.4.11 “Bit Access in Variables” on page 2229.

```
VAR GLOBAL CONSTANT
  (*bit offsets in awWordVariable[0]*)
  NameBitOffset_0_00 : INT := 0;
  NameBitOffset_0_01 : INT := 1;
  (*...*)
  NameBitOffset_0_15 : INT := 15;
  (*bit offsets in awWordVariable[7]*)
  NameBitOffset_7_00 : INT := 0;
  NameBitOffset_7_01 : INT := 1;
  (*...*)
  NameBitOffset_7_15 : INT := 15;
END VAR

VAR
  awWordVariable AT %MW0 : ARRAY [0..7] OF WORD;
END VAR

awWordVariable[0].NameBitOffset_0_00 := TRUE;
awWordVariable[7].NameBitOffset_7_15 := FALSE;
```
Defining a data type

A further alternative is to define your own data types according to the requirements of your particular application.

```
TYPE ControlWordType :
  STRUCT
    NameBitOffset_00 : BIT;
    NameBitOffset_01 : BIT;
    NameBitOffset_02 : BIT;
    NameBitOffset_03 : BIT;
    NameBitOffset_04 : BIT;
    NameBitOffset_05 : BIT;
    NameBitOffset_06 : BIT;
    NameBitOffset_07 : BIT;
    NameBitOffset_08 : BIT;
    NameBitOffset_09 : BIT;
    NameBitOffset_10 : BIT;
    NameBitOffset_11 : BIT;
    NameBitOffset_12 : BIT;
    NameBitOffset_13 : BIT;
    NameBitOffset_14 : BIT;
    NameBitOffset_15 : BIT;
  END_STRUCT
END_TYPE
```

```
VAR
atTypeVariable AT &M00 : ARRAY [0..7] OF ControlWordType;
END_VAR

atTypeVariable[0].NameBitOffset_00 := TRUE;
atTypeVariable[7].NameBitOffset_15 := FALSE;
```
Defining a complex data type

In case your application requires some more complex data types you can combine data types (DUT; § “Symbolic bit access in structure variables” on page 2230).
Pack/unpack BOOL variables

In case you prefer variables of type BOOL you can use the functions for packing MEM_Pack_BitsToByte and unpacking MEM_UnpackWord of the CAA_Memory.library, which can be found with the Library Manager Chapter 6.5.3 “Library Manager functionality” on page 3773.

```plaintext
VAR
abBoolVariable : ARRAY [0..15] OF BOOL;
WBoolVariable0 : AT %00 WORD;
WBoolVariable1 : AT %01 WORD;
END_VAR

VAR
Unpack : Mem.UnpackWord;
END_VAR

abBoolVariable[0] := TRUE;
abBoolVariable[15] := FALSE;

WBoolVariable0 := Mem.PackBitsToWord(abBoolVariable[0], abBoolVariable[1], abBoolVariable[2], abBoolVariable[3], abBoolVariable[4], abBoolVariable[5], abBoolVariable[6], abBoolVariable[7], abBoolVariable[8], abBoolVariable[9], abBoolVariable[10], abBoolVariable[11], abBoolVariable[12], abBoolVariable[13], abBoolVariable[14], abBoolVariable[15]);

WBoolVariable1 := 1;
Unpack(WValue := WBoolVariable1,
    xBit0 := abBoolVariable[0], xBit1 := abBoolVariable[1], xBit2 := abBoolVariable[2], xBit3 := abBoolVariable[3],
    xBit4 := abBoolVariable[4], xBit5 := abBoolVariable[5], xBit6 := abBoolVariable[6], xBit7 := abBoolVariable[7],
    xBit8 := abBoolVariable[8], xBit9 := abBoolVariable[9], xBit10 := abBoolVariable[10], xBit11 := abBoolVariable[11],
    xBit12 := abBoolVariable[12], xBit13 := abBoolVariable[13], xBit14 := abBoolVariable[14], xBit15 := abBoolVariable[15]);
```

6.8.2.10.8 Function block ModTcpMast

These function block is only required for the operating mode Modbus client. It handles the communication (transmission of telegrams to the servers and receipt of telegrams from the servers). The function block can be used for the Ethernet interfaces of the controller.

`ModTcpMast` is contained in the library ABB_ModbusTcp_AC500.

6.8.2.11 Communication with PROFINET redundancy

In a high availability system one of the following redundancy solutions can be configured:

- AC500 High Availability CS31 redundancy (HA-CS31)
- AC500 High Availability Modbus redundancy (HA-Modbus TCP) Chapter 6.5.9.1.1 “The AC500 High Availability system” on page 3859
- PROFINET redundancy based on HA-Modbus TCP without CI52x modules.

Normally, two PROFINET IO controllers CM579-PNIO connect to the devices simultaneously. One controller establishes a primary connection that is identical to a regular PROFINET connection. The second controller establishes a special ‘backup’ connection. This connection doesn’t contain any valid output data and doesn’t allow the secondary controller to change any options on the devices. If the primary controller fails, the second parallel controller takes over the tasks of the first.

How to set-up and configure PROFINET redundancy communication based on HA-Modbus TCP (without CI52x modules) is described in the application example `PROFINET redundancy`.

Network redundancy

The Media Redundancy Protocol allows in smaller systems rings of Ethernet switches to overcome any single failure with a maximum recovery times in the following range: 10 ms, 30 ms, 200 ms and 500 ms.

Chapter 6.3.4.1.2.2.7.4 “Network redundancy” on page 1660
### Fast counters in AC500 devices

For AC500 devices the function "fast counter" is available in S500 I/O modules as of firmware version V1.3.

For AC500-eCo V3 devices the function "fast counter" is available in onboard I/Os of PM50x2 modules, according to the CPU type, the fast inputs have different functionality or frequency.

Integrated fast counters are only available for digital I/O modules. The digital I/O modules on the I/O bus contain two fast counters each. If the counter is used, it needs up to 2 digital inputs and one digital output. If the fast counter is deactivated, the inputs and outputs reserved for the counter can be used for other tasks.

.fs. Chapter 6.3.2.13.9 “Fast counter” on page 1574.

A fast counter is available in the following constellations:

- In digital I/O modules, connected to an AC500 processor module.
- In AC500-eCo V3 processor modules PM50x2 with onboard I/Os
- In CANopen communication interface modules.
- In Modbus, PROFIBUS and PROFINET communication interface modules and in the connected digital I/O modules.
- In digital I/O modules, connected to an EtherCAT communication interface module.

The following table shows the S500 modules which contain a fast counter and which of the digital inputs and outputs are reserved for the counter.

<table>
<thead>
<tr>
<th>Module</th>
<th>Assigned inputs ¹)</th>
<th>Assigned output</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Channel A</td>
<td>Channel B</td>
<td>Channel C ²) or (CF)</td>
</tr>
<tr>
<td>DA501</td>
<td>DC16</td>
<td>DC17</td>
<td>DC18</td>
</tr>
<tr>
<td>DA502</td>
<td>DC16</td>
<td>DC17</td>
<td>DC18 - in mode 1 and mode 2 DO0 - in mode 101 and mode 102 ³)</td>
</tr>
<tr>
<td>DC522</td>
<td>C8</td>
<td>C9</td>
<td>C10</td>
</tr>
<tr>
<td>DC523</td>
<td>C16</td>
<td>C17</td>
<td>C18</td>
</tr>
<tr>
<td>DC532</td>
<td>C24</td>
<td>C25</td>
<td>C26</td>
</tr>
<tr>
<td>DI524</td>
<td>I24</td>
<td>I25</td>
<td>No hardware output available</td>
</tr>
<tr>
<td>DX522</td>
<td>I0</td>
<td>I1</td>
<td>The counter does not activate any relay output</td>
</tr>
</tbody>
</table>

¹) Assigned inputs

²) or (CF)
### Module Assigned inputs ¹)

<table>
<thead>
<tr>
<th>Module</th>
<th>Assigned inputs ¹)</th>
<th>Assigned output</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Channel A</td>
<td>Channel B</td>
<td>Channel C ²) or (CF)</td>
</tr>
<tr>
<td>CI501-PNIO, CI541-DP, CI581-CN, CI521-MODTCP</td>
<td>DI0</td>
<td>DI1</td>
<td>DO0</td>
</tr>
<tr>
<td>CI502-PNIO, CI542-DP, CI582-CN, CI522-MODTCP</td>
<td>DI8</td>
<td>DI9</td>
<td>DO8</td>
</tr>
</tbody>
</table>

¹) The two hardware inputs (channels A and B) are also and always available within the normal process image, irrespective of the operating mode of the counter.

²) The hardware output channel C is activated by the fast counter only in the operating modes 1 and 2.

### The counter function is performed within the communication interface module and, accordingly, in the digital I/O module(s). It works independently of the user program and is therefore able to respond quickly to external signals. A simultaneous counter operation of several digital I/O modules is possible.

Each module counter can be configured for one out of 10 possible modes. The desired operating mode is selected in the PLC configuration using module parameters. After that, it is activated during the initialization phase (power-on, cold start, warm start).

The data exchange to and from the user program is performed using input and output operands. While integrating a module containing a fast counter in the PLC configuration, the necessary operands are created and reserved immediately. Thus, a counter implementation carried out later on does not cause an address shift.

### Features independent of the fast counter operating mode

- The pulses at the fast counters' inputs or the evaluated signals of the traces A and B in case of incremental position sensors are counted.
- The counting frequencies of the communication interface modules of PROFINET, PROFIBUS and CANopen are max. 200 kHz (in modes 1 to 6), max. 50 kHz (in mode 7), max. 35 kHz (in mode 9), and max. 20 kHz (in mode 10).
- If the modules DA501, DC522, DC523, DC532 are used, each counting input must be circuited externally in series with a resistor of 470 Ω / 1 W, in order to safely avoid influences from the deactivated module outputs to the connected sensors.
- The positive signal edges are counted, if not noted differently.
- By setting the operating mode 0, the counting function is switched off. In this case, the reserved inputs and outputs can be used for other tasks. Simultaneous use of these terminals for the fast counter and other signals must be avoided.
- The fast counter's actual value is provided as a double word (32 bits).
- The fast counter can count upwards in all operating modes. It counts beginning at the start value (set value) up to the end value (max. from 0 to 4,294,967,295 or hexadecimal from 00 00 00 00 to FF FF FF FF. After reaching 4,294,967,295, the counter jumps with the next pulse to 0. When the counter reaches the programmed end value, the counter output is stored permanently as CF = TRUE (end value reached). Only when the fast counter is set again (set value), CF is reset to FALSE.

### Further information

- Operating modes of the fast counter “Chapter 6.3.2.13.9.1.3 “Operating modes” on page 1577
- Configuration of the fast counter “Chapter 6.3.2.13.9 “Fast counter” on page 1574
6.8.2.13 Fast counter in AC500-eCo V3

For AC500 devices the function “fast counter” is available in S500 I/O modules as of firmware version V1.3.
For AC500-eCo V3 devices the function “fast counter” is available in onboard I/Os of PM50xx.

The AC500-eCo V3 processor modules with onboard I/Os provide some special functionality on the digital inputs or digital outputs. Fast counter, encoder inputs, interrupt inputs or PWM/PTO outputs are available depending on the device used.

The fast counter functionality can be activated within the onboard I/O configuration.

The fast counter can work in pulse/direction mode or A/B track counter mode.

Further information about the operating modes of the fast counter
Further information about the configuration of the fast counter

As AC500-eCo V3 PLCs provide the fast counters via their onboard I/Os not only the correct power distribution to the PLC has to be made, but also the correct wiring to the signal wires. How to connect and use fast counters in AC500-eCo V3 PLCs is described in an application example.

The pulse/direction counter detects the rising edge of the counter input. It will increase or decrease the count value (depending on the direction input) at every rising edge.

The A/B track counter is used to count the signal from an encoder.

The counter can count with quad phases. In the following the behavior of the A/B track counter is described.

6.8.2.14 Onboard I/O on AC500-eCo V3 processor modules

6.8.2.14.1 Intended purpose

The AC500-eCo V3 processor modules have onboard I/Os which provide several functionalities. According to the CPU type, the number or the functionality of the onboard I/Os can be different.

<table>
<thead>
<tr>
<th>Processor module</th>
<th>No. and type of digital inputs</th>
<th>No. and type of digital outputs</th>
<th>No. and type of configurable inputs/outputs</th>
</tr>
</thead>
<tbody>
<tr>
<td>PM5012-T-ETH</td>
<td>6</td>
<td>4</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>24 V DC (one isolation group)</td>
<td>0.5 A max., transistor (one isolation group)</td>
<td></td>
</tr>
<tr>
<td>PM5012-R-ETH</td>
<td>6</td>
<td>4</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>24 V DC (one isolation group)</td>
<td>2 A max., relay (two isolation groups)</td>
<td></td>
</tr>
<tr>
<td>PM5032-T-ETH</td>
<td>12</td>
<td>8</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>24 V DC (one isolation group)</td>
<td>0.5 A max., transistor (one isolation group)</td>
<td>24 V DC input or 0.5 A max., transistor output (one isolation group)</td>
</tr>
<tr>
<td>Processor module</td>
<td>No. and type of digital inputs</td>
<td>No. and type of digital outputs</td>
<td>No. and type of configurable inputs/outputs</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------</td>
<td>---------------------------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>PM5032-R-ETH</td>
<td>12 24 V DC (one isolation group)</td>
<td>6 2 A max., relay (two isolation groups)</td>
<td>2 24 V DC input or 0.5 A max., transistor output (one isolation group)</td>
</tr>
<tr>
<td>PM5052-T-ETH</td>
<td>12 24 V DC (one isolation group)</td>
<td>8 0.5 A max., transistor (one isolation group)</td>
<td>2 24 V DC input or 0.5 A max., transistor output (one isolation group)</td>
</tr>
<tr>
<td>PM5052-R-ETH</td>
<td>12 24 V DC (one isolation group)</td>
<td>6 2 A max., relay (two isolation groups)</td>
<td>2 24 V DC input or 0.5 A max., transistor output (one isolation group)</td>
</tr>
<tr>
<td>PM5072-T-2ETH</td>
<td>12 24 V DC (one isolation group)</td>
<td>8 0.5 A max., transistor (one isolation group)</td>
<td>2 24 V DC input or 0.5 A max., transistor output (one isolation group)</td>
</tr>
<tr>
<td>PM5072-T-2ETHW</td>
<td>12 24 V DC (one isolation group)</td>
<td>8 0.5 A max., transistor (one isolation group)</td>
<td>2 24 V DC input or 0.5 A max., transistor output (one isolation group)</td>
</tr>
<tr>
<td>PM5082-T-2ETH</td>
<td>12 24 V DC (one isolation group)</td>
<td>8 0.5 A max., transistor (one isolation group)</td>
<td>2 24 V DC input or 0.5 A max., transistor output (one isolation group)</td>
</tr>
</tbody>
</table>
### 6.8.2.14.2 Functionality

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Parameter</strong></td>
<td><strong>Value</strong></td>
</tr>
<tr>
<td>PM5012-T-ETH</td>
<td>PM5012-R-ETH</td>
</tr>
<tr>
<td><strong>PM5032-T-ETH</strong></td>
<td><strong>PM5052-T-ETH</strong></td>
</tr>
<tr>
<td><strong>PM5072-T-2ETH(W)</strong></td>
<td><strong>PM5082-T-2ETH</strong></td>
</tr>
<tr>
<td>Digital inputs</td>
<td>6</td>
</tr>
<tr>
<td>6 DI fast input 24 V DC (max. 5kHz) usable as</td>
<td>12</td>
</tr>
<tr>
<td>6 DI 24 V DC standard</td>
<td>4 DI fast input 24 V DC (max. 200 kHz) usable as</td>
</tr>
<tr>
<td>2 channel 5 kHz encoder</td>
<td>4 DI 24 V DC standard or</td>
</tr>
<tr>
<td>with frequency measurement or</td>
<td>4 fast counter (100 kHz) or</td>
</tr>
<tr>
<td>2 channel 5 kHz encoder</td>
<td>2 A/B encoder (200 kHz) with frequency measurement or</td>
</tr>
<tr>
<td>with frequency measurement and</td>
<td>2 full A/B encoders 0 and 1 (200 kHz) with frequency measurement and</td>
</tr>
<tr>
<td>with touch/reset using standard</td>
<td>with touch/reset using standard highspeed (5 kHz) DI</td>
</tr>
<tr>
<td>DI or</td>
<td>1 full A/B encoder 0 (200 kHz) with frequency measurement and optional</td>
</tr>
<tr>
<td>2 fast counter (5 kHz)</td>
<td>with touch/reset using 2 touch/sync inputs with A/B encoder 0</td>
</tr>
<tr>
<td>4 DI as interrupt input with</td>
<td>4 DI fast input 24 V DC (5 kHz) usable as</td>
</tr>
<tr>
<td>1 dedicated interrupt task and</td>
<td>4 DI 24 V DC standard or</td>
</tr>
<tr>
<td>input information</td>
<td>4 DI as interrupt input with 1 dedicated interrupt task and input</td>
</tr>
<tr>
<td></td>
<td>information</td>
</tr>
<tr>
<td></td>
<td>4 standard DI 24 V DC</td>
</tr>
<tr>
<td>Digital outputs</td>
<td>4</td>
</tr>
<tr>
<td>4 standard DI 24 V DC</td>
<td>8</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>PM5012-T-ETH</strong></td>
<td><strong>PM5012-R-ETH</strong></td>
</tr>
<tr>
<td><strong>PM5032-T-ETH</strong></td>
<td><strong>PM5032-R-ETH</strong></td>
</tr>
<tr>
<td><strong>PM5052-T-ETH</strong></td>
<td><strong>PM5052-R-ETH</strong></td>
</tr>
<tr>
<td><strong>PM5072-T-2ETH(W)</strong></td>
<td><strong>PM5082-T-2ETH</strong></td>
</tr>
</tbody>
</table>

**Functionality of digital outputs**

<table>
<thead>
<tr>
<th>4 fast output DO-T</th>
<th>4 DO-R</th>
</tr>
</thead>
<tbody>
<tr>
<td>24 V DC/0.5 A (max. 5 kHz) usable as</td>
<td>24 V DC / 120/240 V AC 2A in 2 groups</td>
</tr>
<tr>
<td>- 4 DO-T 24 V DC/0.5 A or</td>
<td>24 V DC (100 kHz) usable as</td>
</tr>
<tr>
<td>- 4 PWM</td>
<td>- 4 DO-T 24 V DC/0.5 A or</td>
</tr>
<tr>
<td>Note: The speed must be limited below 100 Hz. The low speed PWM can be used for heating control.</td>
<td>- 4 limit/switch outputs for encoder/counter or</td>
</tr>
<tr>
<td>- 4 limit switch</td>
<td>- 4 PWM (30 kHz, 2 µs accuracy and maximum duty 95 %) or</td>
</tr>
<tr>
<td></td>
<td>- 2 PTO (200 kHz) CW/CCW or Pulse/Direction</td>
</tr>
<tr>
<td></td>
<td>- 4 PTO (PWM) 100...200 kHz Pulse/Direction using standard output</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>6 DO-R</th>
<th>24 V DC / 120/240 V AC 2A in 2 groups</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Parameter</strong></td>
<td><strong>Value</strong></td>
</tr>
<tr>
<td>PM5012-T-ETH</td>
<td>PM5012-R-ETH</td>
</tr>
<tr>
<td>PM5032-T-ETH (PM5052-T-ETH)</td>
<td>PM5072-T-2ETH(W) (PM5082-T-2ETH)</td>
</tr>
<tr>
<td>4 fast output DO-T</td>
<td>24 V DC/0.5 A (5 kHz) (max. 5 kHz) usable as</td>
</tr>
<tr>
<td></td>
<td>● 4 DO-T 24 V DC/0.5 A</td>
</tr>
<tr>
<td></td>
<td>● 4 limit/switch outputs for encoder/counter or</td>
</tr>
<tr>
<td></td>
<td>● 4 PWM</td>
</tr>
<tr>
<td></td>
<td>Note: The speed must be limited below 100 Hz. The low speed PWM can be</td>
</tr>
<tr>
<td></td>
<td>used for heating control.</td>
</tr>
<tr>
<td></td>
<td>● 4 direction outputs together with</td>
</tr>
<tr>
<td></td>
<td>● 4 high speed pulses for up to 4 PTO</td>
</tr>
<tr>
<td></td>
<td>Pulse/Direction outputs up to 200 kHz</td>
</tr>
<tr>
<td>Digital inputs/outputs,</td>
<td>-</td>
</tr>
<tr>
<td>configurable</td>
<td>-</td>
</tr>
<tr>
<td>Functionality of digital inputs/</td>
<td>2</td>
</tr>
<tr>
<td>outputs, configurable</td>
<td>2</td>
</tr>
<tr>
<td>LED displays</td>
<td>For signal states</td>
</tr>
<tr>
<td></td>
<td>2 DC 24 V DC</td>
</tr>
<tr>
<td></td>
<td>● 2 standard I/Os usable as</td>
</tr>
<tr>
<td></td>
<td>● 2 DC standard (DI 24 V DC or DO-T) or</td>
</tr>
<tr>
<td></td>
<td>● 2 PWM (30 kHz) or</td>
</tr>
<tr>
<td></td>
<td>● 1 PTO (200 kHz) as</td>
</tr>
<tr>
<td></td>
<td>Pulse/Direction or CW/CCW</td>
</tr>
</tbody>
</table>
### 6.8.2.15 Simple motion

#### 6.8.2.15.1 Introduction

The AC500-eCo V3 PLC provide several hardware and software features allowing to realize some motion application.

Specific fast onboard I/O and dedicated software library function blocks (simple motion) are available and can manage up to 2 axis on the CPU.

The simple motion capability is based on a library for the onboard I/O and some motion control blocks allowing point-to-point or velocity control.

All the AC500-eCo V3 PLC from Basic, Standard or Pro type offer dedicated feature according to their performance classes.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal power supply</td>
<td>Via processor module</td>
</tr>
<tr>
<td>External power supply</td>
<td>Via UP and ZP terminal</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Basic</th>
<th>Standard</th>
<th>Pro</th>
</tr>
</thead>
<tbody>
<tr>
<td>PM5012-x-ETH</td>
<td>PM5032-x-ETH / PM5052-x-ETH</td>
<td>PM50x2-T-2ETH</td>
</tr>
<tr>
<td>Relay outputs</td>
<td>Relay outputs</td>
<td>Relay outputs</td>
</tr>
<tr>
<td>Relay outputs</td>
<td>Transistor outputs</td>
<td>Transistor outputs</td>
</tr>
<tr>
<td>High-speed counter (HSC)</td>
<td>Up to 2 (5 kHz)</td>
<td>Up to 4 (100 kHz)</td>
</tr>
<tr>
<td>Frequency measurement</td>
<td>Up to 2 (5 kHz)</td>
<td>Up to 2 (200 kHz)</td>
</tr>
<tr>
<td>A/B encoder</td>
<td>1 A/B simple encoder (5 kHz) with sync/reset</td>
<td>Up to 2 A/B encoder 200 kHz with sync/reset inputs</td>
</tr>
<tr>
<td>Interrupt inputs</td>
<td>Up to 4</td>
<td>Up to 4</td>
</tr>
<tr>
<td>Pulse-train output (PTO)</td>
<td>-</td>
<td>Up to 2 pulse/direction or CW/CCW both mode with 200 kHz</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Up to 2 pulse/direction or CW/CCW both mode with 200 kHz</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Up to 4</td>
</tr>
</tbody>
</table>
|                        |                          | Pulse/direction with 100...200 kHz using fast output channels for pulse and standard outputs and for direction on software motion function block.
<table>
<thead>
<tr>
<th></th>
<th>Basic</th>
<th>Standard</th>
<th>Pro</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relay outputs</td>
<td>PM5012-x-ETH</td>
<td>PM5032-x-ETH / PM5052-x-ETH</td>
<td>PM50x2-T-2ETH</td>
</tr>
<tr>
<td>Transistor outputs</td>
<td>Relay outputs</td>
<td>Transistor outputs</td>
<td>Transistor outputs</td>
</tr>
<tr>
<td>Pulse-width modulation (PWM)</td>
<td>-</td>
<td>Up to 4 (100 Hz)</td>
<td>Up to 4 (30 kHz)</td>
</tr>
<tr>
<td>Limit switches</td>
<td>-</td>
<td>Up to 2</td>
<td>Up to 8</td>
</tr>
</tbody>
</table>

6.8.2.15.2 Hardware components for motion control

Basic CPU – PM5012-R-ETH and PM5012-T-ETH

![Fig. 361: Example: PM5012-T-ETH](image)

1. High-speed counter 5 kHz frequency measurement interrupt I/O
2. Pulse-width modulation output
Standard and Pro CPU - PM5032-x-ETH/PM5052-x-ETH/PM5072-T-2ETH(W)/PM5082-T-2ETH

Fig. 362: Example: PM5052-T-ETH

1. High-speed counter 100 kHz and 5 kHz A/B encoder 200 kHz interrupt I/O standard inputs
2. Pulse-train output 100 kHz/200 kHz pulse-width modulation 30 kHz limit switch standard outputs
3. Drives, encoder, stepper motor

For PLC with relay outputs, the input features are identical.

The digital configurable inputs or outputs can be used for pulse-train output/pulse-width modulation functions.

6.8.2.15.3 System technology

General

The following chapters describe the system technology of the AC500-eCo V3 using motion examples.

The simple motion set of function blocks is standard part of the system libraries for AC500-eCo V3.
Use the onboard I/Os as encoder with A and B signals

Parameter configuration

The onboard I/O accept encoder signal A and B. When configure the encoder track A, the encoder track B will be automatically inserted.

The user can configure the following input channel as encoder input.

- “Encoder 0 Track – A”: Input channel 4
- “Encoder 0 Track – B”: Input channel 5
- “Encoder 1 Track – A”: Input channel 6
- “Encoder 1 Track – B”: Input channel 7

After configuring the encoder input channel, the user can configure the touch/reset for the respective encoder channel.

More information about this topic can be found in the chapter 'Configuration the I/O channel'.

Chapter 6.3.2.5 “Configure the onboard I/O channel” on page 1483

Function block

OBIOEncoder

Counter
If “Enable” is TRUE, the “OBIOEncoderCounter” instruction increments the counter by one based on the input.

If “Set” bit is TRUE, the “OBIOEncoderCounter” instruction moves the “CounterValueSet” to the “CounterValue”.

If “Enable” is TRUE, the “OBIOEncoderCounter” instruction increments the counter by one based on the input.

If “EnableLimit” bit is TRUE, the accumulated value continues incrementing.

After “CounterValue” reaches the “LimitValueMax”, the “OBIOEncoderCounter” instruction writes 0 to the “CounterValue”.

“Encoder Counter Mode”: 0 = “90° Mode”

In this encoder counter mode, an increasing count results when input B is 90° ahead of input A. The count is initiated on the rising edge of input A, and the direction of the encoder is clockwise (positive).

The module produces a decreasing count when input A is 90° ahead of input B. The count is initiated on the falling edge of input A, and the direction is counterclockwise (negative).

By monitoring both the number of pulses and the phase relationships of input A and B, you can accurately determine the position and direction of the rotation.
In this encoder counter mode, the count increases or decreases based on the state of input B, which can be a random signal.

If input B is high, the counter will count down.
If input B is low, the counter counts up.

Counting is done on the leading edge of input A.

If "Enable" is TRUE, the "OBIOEncoderCounter" instruction increments the counter by one based on the input.
If "EnableRef" bit is TRUE, the "OBIOEncoderCounter" instruction is ready to receive the touch/reset input.
If the "Touch/Reset" input is TRUE, the current "CounterValue" will be replaced by the "CounterValueSet".
If “Enable” is TRUE, the “OBIOEncoderCounter” instruction increments the counter by one based on the input.

If “EnableTouch” bit is TRUE, the “OBIOEncoderCounter” instruction is ready to receive the “Touch/Reset” input.

If the “Touch/Reset” input is TRUE, the current “CounterValue” will be captured and written to the “CounterTouchValue”.

Use the onboard I/Os as forward counter

Parameter configuration

The onboard I/O accept pulse input as forward counter.

User can configure the following input channel as forward counter.

- “Forward Counter 0”: Input channel 4
- “Forward Counter 1”: Input channel 5
- “Forward Counter 2”: Input channel 6
- “Forward Counter 3”: Input channel 7

More information about this topic can be found in the chapter ‘Configuration the I/O channel’. ➤ Chapter 6.3.2.5 “Configure the onboard I/O channel” on page 1483
Function block

OBIOForward Counter

If “Enable” is TRUE, the “OBIOForwardCounter” instruction increments the counter by one based on the input.

If “Set” bit is TRUE, the “OBIOForwardCounter” instruction moves the “CounterSetValue” to the “CounterValue”.

If “Enable” is TRUE, the “OBIOForwardCounter” instruction increments the counter by one based on the input.

If “EnableLimit” bit is TRUE, the accumulated value continues incrementing.

After “CounterValue” reaches the “LimitValueMax”, the “OBIOForwardCounter” instruction writes 0 to the “CounterValue”.

Use the onboard I/Os as interrupt input with dedicated interrupt task

Parameter configuration

The onboard I/O input can be configured as interrupt input to trigger the interrupt task.
The user can configure the following input channel as interrupt input.

- **Interrupt input 0**: Input Channel 0
- **Interrupt input 1**: Input Channel 1
- **Interrupt input 2**: Input Channel 2
- **Interrupt input 3**: Input Channel 3

More information about this topic can be found in the chapter 'Configuration the I/O channel'.

"Chapter 6.3.2.5 “Configure the onboard I/O channel” on page 1483"

After configuring the parameter, the user need to create a new task with the “Type” set to “External” and the “External event” set to “OnBoard_Binary_Input”.

**Function block**

The “**OBIOInterruptPara**” instruction is configured for 4 interrupt inputs.

If “EnableInterrupt” bit is TRUE, the “**OBIOInterruptInfo**” instruction is ready to receive the interrupt input.

If the interrupt input is TRUE, the interrupt task will be executed.
If the second interrupt is TRUE with the interval less than 10 ms (as set), the execution of the interrupt task will be ignored.

If no interrupt occurred in 50 ms (as set), the interrupt task is executed automatically.

Use the onboard I/Os as output limit switch

Parameter configuration

The user can configure the following output channel as limit switch.

- “LimitSwitch 0”: Output channel 0
- “LimitSwitch 1”: Output channel 1
- “LimitSwitch 2”: Output channel 2
- “LimitSwitch 3”: Output channel 3
- “LimitSwitch 4”: Output channel 4
- “LimitSwitch 5”: Output channel 5
- “LimitSwitch 6”: Output channel 6
- “LimitSwitch 7”: Output channel 7

More information about this topic can be found in the chapter 'Configuration the I/O channel'.

Chapter 6.3.2.5 “Configure the onboard I/O channel” on page 1483

Function block

If the counter value reaches the "LowerLimitOn" preset, it will write to the limit switch output based on the signal until the "UpperLimitOn" preset is reached.
Use the onboard I/Os as pulse-train output (PTO)
100 kHz frequency (max. 2 pulse-train outputs using pulse-train output hardware channels)

Parameter configuration

The user can configure the following output channels as pulse-train output (PTO).

- "PTO": Output channel 4
- "PTO": Output channel 5
- "PTO": Output channel 6
- "PTO": Output channel 7

If the user configures the output 4 or 6 as pulse-train output, the output 5 or 7 is automatically configured as pulse-train output.

The input "CwCCw" of the function block "OBIOPulseTrainOutput" determines the output 5 and 7 as "CounterClockWise" or "Direction" if it is set as pulse-train output.

More information about this topic can be found in the chapter 'Configuration the I/O channel'.
☞ Chapter 6.3.2.5 “Configure the onboard I/O channel” on page 1483

Function block

If "Set" bit is TRUE, the instruction moves the "CounterSetValue" to the "CounterValue".
If "EnableLimit" bit is TRUE, the accumulated value continues incrementing. After "CounterValue" reaches the "LimitValueMax", the instruction writes 0 to the "CounterValue".

If the input "CwCCw" of the "OBIOPulseTrainOutput" is set to FALSE, the pulse-train output channel B is toggled based on the direction.

If the input "CwCCw" of the "OBIOPulseTrainOutput" is set to TRUE. The pulse-train output channel A will lead by 90° or pulse-train output channel B will lead by 90° depending on direction.
200 kHz frequency (max. 2 pulse-train output using pulse-train output hardware channels) and simple motion “OBIOMotionPTO” function block

Parameter configuration

**Only the Standard and Pro processor modules can be used with pulse-train outputs. The Basic processor modules PM5012 do not have pulse-train outputs.**

The available pulse-train output can be used as pulse-train output with pulse/direction or pulse-train output with CW/CCW mode when the channels have been configured as pulse-train output.

The user can configure the following output channels as pulse-train output (PTO).

- “PTO”: Output channel 4
- “PTO”: Output channel 5
- “PTO”: Output channel 6
- “PTO”: Output channel 7

If the user configures the output 4 as pulse-train output, the output 5 is automatically configured as pulse-train output.

If the user configures the output 6 as pulse-train output, the output 7 is automatically configured as pulse-train output.

The input “CwCCw” of the function block “OBIOPulseTrainOutput” determines the output 5 and 7 as “CounterClockWise” or “Direction” if it is set as pulse-train output.

More information about this topic can be found in the chapter 'Configuration the I/O channel'.

*Chapter 6.3.2.5 “Configure the onboard I/O channel” on page 1483*
Function block

If the input “CwCCw” of the “OBIOMotionPTO” is set to FALSE, the pulse-train output channel B is toggled based on the direction.

If the input “CwCCw” of the “OBIOMotionPTO” is set to TRUE. The pulse-train output channel A will lead by 90° or pulse-train output channel B will lead by 90° depending on direction.
100 kHz...200 kHz frequency (max. 4 pulse-train output using pulsed-width modulation (PWM) hardware channels) and simple motion “OBIOMotionPWM” function block

Parameter configuration

It is possible to have also up to 4 pulse-train output channels only with pulse/direction mode on the AC500-eCo V3 CPU by using the fast outputs O4...O7 configurated as pulse-width modulation outputs and using a specific motion function block and standard outputs for direction channel.

Only the Standard and Pro processor modules can be used with pulse-train output or pulse-width modulation outputs. The Basic processor modules PM5012 do not have pulse-train outputs.

The available software pulse-train outputs can be used as pulse-train output with pulse/direction or pulse-train output with CW/CCW mode when the channels have been configured as PWM outputs.

The user must configure the following output channels as pulse-width modulation outputs and use the “OBIOMotionPWM” function block.

- “PWM”: Output channel 4
- “PWM”: Output channel 5
- “PWM”: Output channel 6
- “PWM”: Output channel 7

If the user configures the output 4...7 as pulse-width modulation using the “OBIOMotionPWM” function block, up to four software pulse-train output can be realized offering then only the pulse/direction mode.

The pulse output will always use the fast output channels O4…O7 and the direction output of the function block can be assigned to any other output e.g. O0…O3 or also outputs from a S500 I/O module.

More information about this topic can be found in the chapter 'Configuration the I/O channel'. Chapter 6.3.2.5 “Configure the onboard I/O channel” on page 1483

Function block
Use the onboard I/Os as output pulse-width modulation (PWM)

Parameter configuration

The user can configure the following output channels as pulse-width modulation (PWM).

- "PWM 0": Output channel 0
- "PWM 1": Output channel 1
- "PWM 2": Output channel 2
- "PWM 3": Output channel 3
- "PWM 4": Output channel 4
- "PWM 5": Output channel 5
- "PWM 6": Output channel 6
- "PWM 7": Output channel 7

More information about this topic can be found in the chapter "Configuration the I/O channel".
粉尘 Chapter 6.3.2.5 "Configure the onboard I/O channel" on page 1483

Function block

The complete cycle of the "PWM" is based on the "OnTime" and "OffTime".
The duty cycle ratio of the "PWM" is based on the formula \( \frac{T_{\text{on}}}{T_{\text{on}} + T_{\text{off}}} \).

### 6.8.2.15.4 Function block description

Reference for function blocks, functions, structures etc. are available in the reference documentation and in the Library Manager.

- Chapter 6.5.14 “Reference, function blocks” on page 4086
- Chapter 6.5.3.3 “View embedded documentation of all libraries” on page 3775

### 6.8.2.15.5 AC500-eCo V3 option board slots for processor modules PM50xx

#### General

Depending on the processor module type, up to three option board slots are available on the CPU for different purpose like digital or analog I/O extension, serial interface or special module for specific functionality.

The option board slots are not limited to one type of option board. The option boards can be plugged and used in any slot. The only limitation is the number of slots available on the processor module. All types of option boards can be mixed on all slots.

- Chapter 5.2.1.1.3 “Option boards” on page 218
### Table 846: Option board slots

<table>
<thead>
<tr>
<th>Number of option board slots</th>
<th>Basic CPU</th>
<th>Standard CPU</th>
<th>Pro CPU</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PM5012</td>
<td>PM5032</td>
<td>PM5052</td>
</tr>
<tr>
<td></td>
<td>PM5072</td>
<td>PM5082</td>
<td></td>
</tr>
<tr>
<td>Usable option boards on AC500-eCo V3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TA5130-KNXPB</td>
<td>-</td>
<td>-</td>
<td>X ¹) X ¹)</td>
</tr>
<tr>
<td>TA5130-KNXPBW</td>
<td>-</td>
<td>-</td>
<td>X ¹) ²) -</td>
</tr>
<tr>
<td>TA5131-RTC</td>
<td>X</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>TA5101-4DI</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>TA5101-4DIW</td>
<td>-</td>
<td>-</td>
<td>X ²)</td>
</tr>
<tr>
<td>TA5105-4DOT</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>TA5105-4DOTW</td>
<td>-</td>
<td>-</td>
<td>X ²)</td>
</tr>
<tr>
<td>TA5110-2DI2DO T</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>TA5110-2DI2DOB</td>
<td>-</td>
<td>-</td>
<td>X ²)</td>
</tr>
<tr>
<td>TA5120-2AI-UI</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>TA5120-2AI-UIW</td>
<td>-</td>
<td>-</td>
<td>X ²)</td>
</tr>
<tr>
<td>TA5123-2AI-RTD</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>TA5123-2AI-RTW</td>
<td>-</td>
<td>-</td>
<td>X ²)</td>
</tr>
<tr>
<td>TA5126-2AO-UI</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>TA5126-2AO-UIW</td>
<td>-</td>
<td>-</td>
<td>X ²)</td>
</tr>
<tr>
<td>TA5141-RS232I</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>TA5141-RS232IW</td>
<td>-</td>
<td>-</td>
<td>X ²)</td>
</tr>
<tr>
<td>TA5142-RS485I</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>TA5142-RS485IW</td>
<td>-</td>
<td>-</td>
<td>X ²)</td>
</tr>
<tr>
<td>TA5142-RS485</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>TA5142-RS485W</td>
<td>-</td>
<td>-</td>
<td>X ²)</td>
</tr>
</tbody>
</table>

¹) Can be used only once per CPU
²) The W version of PM5072-T-2ETHW is mandatory
Option board for COMx serial communication

One of these option boards is always needed for serial communication like Modbus RTU.

☞ Information about selection and configuration

☞ More information on technical data and ordering information of the option boards

Option board for digital I/O extension

☞ Information about selection and configuration

☞ More information on technical data and ordering information of the option boards

Option board for analog I/O extension

☞ Information about selection and configuration

☞ More information on technical data and ordering information of the option boards

Option board for specific function

☞ More information on technical data and ordering information of the option boards

The TA5130-KNXPB can only be used on AC500-eCo V3 processor modules Pro PM5072-T-ETH(W) and PM5082-T-2ETH.

The TA5131-RTC can only be used on AC500-eCo V3 processor modules Basic PM5012-x-ETH.

These two option boards can only be used once on one slot at a time!

6.8.2.16 Access to digital I/Os transferred as bit strings WORD/DWORD

6.8.2.16.1 General

The AC500 V3 PLCs runs in little-endian mode, means uses little-endian byte order.

<table>
<thead>
<tr>
<th>Address</th>
<th>Addr</th>
<th>Addr+1</th>
<th>Addr+2</th>
<th>Addr+3</th>
</tr>
</thead>
<tbody>
<tr>
<td>BYTE</td>
<td>16#xxxx x000</td>
<td>16#xxxx x001</td>
<td>16#xxxx x002</td>
<td>16#xxxx x003</td>
</tr>
<tr>
<td>BOOL</td>
<td>3</td>
<td>2</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>7</td>
<td>7</td>
<td>7</td>
</tr>
<tr>
<td>WORD</td>
<td>15</td>
<td>7</td>
<td>15</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>0</td>
<td>8</td>
<td>0</td>
</tr>
</tbody>
</table>
### 6.8.2.16.2 Bit strings transferred to PLC in little-endian byte order (Intel)

**Access to bit strings transferred to PLC in little-endian byte order**

If the fieldbus/protocol transfers the data in little-endian byte order, the access to the bits in a bit string will be as followed:

<table>
<thead>
<tr>
<th>Address</th>
<th>Addr</th>
<th>Addr+1</th>
<th>Addr+2</th>
<th>Addr+3</th>
</tr>
</thead>
<tbody>
<tr>
<td>DWORD</td>
<td>0</td>
<td>7</td>
<td>15</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>8</td>
<td>16</td>
<td>24</td>
</tr>
</tbody>
</table>

The layout of the I/Os depends on the byte order of the I/O bus, fieldbus or protocol.

Example

<table>
<thead>
<tr>
<th>%IX1.0 := TRUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>%I01 := 1</td>
</tr>
<tr>
<td>:= 16#01</td>
</tr>
<tr>
<td>(Bit 0 = TRUE)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>%I0W1 := 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>:= 16#0001</td>
</tr>
<tr>
<td>(Bit 0 = TRUE)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>%I0D0 := 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>:= 16#00000001</td>
</tr>
<tr>
<td>(Bit 0 = TRUE)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>%I3.0 := TRUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>%I03 := 1</td>
</tr>
<tr>
<td>:= 16#01</td>
</tr>
<tr>
<td>(Bit 0 = TRUE)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>%I0W1 := 256</th>
</tr>
</thead>
<tbody>
<tr>
<td>:= 16#0100</td>
</tr>
<tr>
<td>(Bit 8 = TRUE)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>%I0D0 := 16777216</th>
</tr>
</thead>
<tbody>
<tr>
<td>:= 16#01000000</td>
</tr>
<tr>
<td>(Bit 24 = TRUE)</td>
</tr>
</tbody>
</table>

The AC500 V3 PLCs support the following busses/protocols with little-endian byte order:

- EtherCAT
- CANopen
- EtherNet/IP

### Representation of bitfields in I/O configuration transferred in little-endian byte order

The values of I/Os can be monitored and controlled in the I/O configuration of a device. If the bit strings are transferred in little-endian byte order the bit channels will be displayed in the following way:
In general, it is not recommended to use the “Address”, e.g. \%QX5.2 directly in the IEC application. Use always symbolic variables to avoid access to wrong I/O channels.

6.8.2.16.3 Bit strings transferred to PLC in big-endian byte order (Motorola)

Access to bit strings transferred to PLC in big-endian byte order

If the fieldbus/protocol transfers the data in big-endian byte order, the access to the bits in a bit string will be as followed:

<table>
<thead>
<tr>
<th>Address</th>
<th>Addr</th>
<th>Addr+1</th>
<th>Addr+2</th>
<th>Addr+3</th>
</tr>
</thead>
<tbody>
<tr>
<td>BYTE</td>
<td>%IB0</td>
<td>%IB1</td>
<td>%IB2</td>
<td>%IB3</td>
</tr>
<tr>
<td>BOOL</td>
<td>7</td>
<td>7</td>
<td>7</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>%IX0.7</td>
<td>%IX1.7</td>
<td>%IX2.7</td>
<td>%IX3.7</td>
</tr>
<tr>
<td></td>
<td>%IX0.0</td>
<td>%IX1.0</td>
<td>%IX2.0</td>
<td>%IX3.0</td>
</tr>
<tr>
<td>WORD</td>
<td>%IW0</td>
<td>%IW1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>15</td>
<td>7</td>
<td>15</td>
<td>7</td>
</tr>
<tr>
<td>DWORD</td>
<td>%ID0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>31</td>
<td>23</td>
<td>15</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>24</td>
<td>16</td>
<td>8</td>
<td>0</td>
</tr>
</tbody>
</table>

Example

\%IX0.0 := TRUE
\%IB0 := 1 : = 16#01 (Bit 0 = TRUE)
\%IW1 := 256 : = 16#0100 (Bit 8 = TRUE)
\%ID0 := 16777216 : = 16#01000000 (Bit 24 = TRUE)
\%IX3.0 := TRUE
\%IB3 := 1 : = 16#01 (Bit 0 = TRUE)
\%IW1 := 1 : = 16#0001 (Bit 0 = TRUE)
\%ID0 := 1 : = 16#00000001 (Bit 0 = TRUE)
The AC500 V3 PLCs support the following busses/protocols with little-endian byte order:

- Local I/O bus
- Modbus TCP
- PROFINET
- PROFIBUS

**Representation of bitfields in I/O configuration transferred in big-endian byte order**

The values of I/Os can be monitored and controlled in the I/O configuration of a device. If the bit strings are transferred in big-endian byte order the bytes inside the word will be swapped.

Up to Automation Builder version 2.2 the bit channels will be displayed in the following way:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Mapping</th>
<th>Channel</th>
<th>Address</th>
<th>Type</th>
<th>Default Value</th>
<th>Current Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>SafeDigi_0</td>
<td></td>
<td>Digital input</td>
<td>%X14.0</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_1</td>
<td></td>
<td>Digital input</td>
<td>%X14.1</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_2</td>
<td></td>
<td>Digital input</td>
<td>%X14.2</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_3</td>
<td></td>
<td>Digital input</td>
<td>%X14.3</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_4</td>
<td></td>
<td>Digital input</td>
<td>%X14.4</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_5</td>
<td></td>
<td>Digital input</td>
<td>%X14.5</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_6</td>
<td></td>
<td>Digital input</td>
<td>%X14.6</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_7</td>
<td></td>
<td>Digital input</td>
<td>%X14.7</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_8</td>
<td></td>
<td>Digital input</td>
<td>%X15.0</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_9</td>
<td></td>
<td>Digital input</td>
<td>%X15.1</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_10</td>
<td></td>
<td>Digital input</td>
<td>%X15.2</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_11</td>
<td></td>
<td>Digital input</td>
<td>%X15.3</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_12</td>
<td></td>
<td>Digital input</td>
<td>%X15.4</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_13</td>
<td></td>
<td>Digital input</td>
<td>%X15.5</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_14</td>
<td></td>
<td>Digital input</td>
<td>%X15.6</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_15</td>
<td></td>
<td>Digital input</td>
<td>%X15.7</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
</tbody>
</table>

Input channel DI3 was set in bit string SafeDigi_W. Since the inputs are transferred in big-endian byte order, the input channel SafeDigi_11 or SafeDigi_W.11 is set. User has to swap the bytes in the IEC application.

As of Automation Builder version 2.3.0 the bit channels will be displayed in the following way:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Mapping</th>
<th>Channel</th>
<th>Address</th>
<th>Type</th>
<th>Default Value</th>
<th>Current Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>SafeDigi_0</td>
<td></td>
<td>Digital input</td>
<td>%X15.0</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_1</td>
<td></td>
<td>Digital input</td>
<td>%X15.1</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_2</td>
<td></td>
<td>Digital input</td>
<td>%X15.2</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_3</td>
<td></td>
<td>Digital input</td>
<td>%X15.3</td>
<td>BOOL</td>
<td>TRUE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_4</td>
<td></td>
<td>Digital input</td>
<td>%X15.4</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_5</td>
<td></td>
<td>Digital input</td>
<td>%X15.5</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_6</td>
<td></td>
<td>Digital input</td>
<td>%X15.6</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_7</td>
<td></td>
<td>Digital input</td>
<td>%X15.7</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_8</td>
<td></td>
<td>Digital input</td>
<td>%X14.0</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_9</td>
<td></td>
<td>Digital input</td>
<td>%X14.1</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_10</td>
<td></td>
<td>Digital input</td>
<td>%X14.2</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_11</td>
<td></td>
<td>Digital input</td>
<td>%X14.3</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_12</td>
<td></td>
<td>Digital input</td>
<td>%X14.4</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_13</td>
<td></td>
<td>Digital input</td>
<td>%X14.5</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_14</td>
<td></td>
<td>Digital input</td>
<td>%X14.6</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>SafeDigi_15</td>
<td></td>
<td>Digital input</td>
<td>%X14.7</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
</tr>
</tbody>
</table>

The representation of a bitfield is changed by swapping the bytes correspondingly to the type used in the IO configuration. Now the correct SafeDigi_3 or SafeDigi_W.3 is set in case of DI3 is set.
In general, it is not recommended to use the “Address”, e.g. $IX15.3 directly in the IEC application. Use always symbolic variables to avoid access to wrong I/O channels.

6.8.3 System technology of the AC500 communication modules
6.8.3.1 CANopen communication modules
6.8.3.1.1 Triggering of event tasks with CAN-IDs

For CM598-CAN module the execution of a PLC application task can be triggered automatically by a certain event, i.e. by incoming CAN 2.0 A or CAN 2.0 B frames. For this, the PLC application task is to be configured as external event task.

**Prerequisites**
- PLC firmware version 3.2.5 and Automation Builder as of version 2.2.5.
- Only one PLC application task can be assigned to a communication module.
- Triggering of event tasks is only supported for the communication module CM598-CAN.

Every incoming CAN frame on a CM598-CAN module processes an event in the AC500 PLC. If the parameter “Trigger PLC Task” is set to TRUE, the CAN protocol task checks via the receive buffer configuration and the corresponding CAN-ID of the CAN frame whether a CAN frame is to be executed or not. Only those CAN-IDs that are configured in the protocol configuration will be processed. All other CAN frames will be rejected. If a CAN frame is to be processed, the CAN frame data is copied to the receive buffer and an event on the IEC event task is triggered.

The IEC event task will be executed for one cycle.

The IEC event task will be triggered continuously until all associated receive buffers have been emptied. Hence, ensure that the buffers are emptied by the task, otherwise the task will run into a loop.

Within the task the function block Cm598CanMsgRecEvt must be used to read the CAN frames from the receive buffers. The function block Cm598CanMsgRec is not suitable as it requires several task cycles for execution.
The following figure shows the sequence CAN frames processing when the triggering of event task is used.

- Only one external event task can be assigned to a CM598-CAN.
- There is only one common event for an external event task and all selected CAN-IDs. It must be evaluated which CAN-IDs have been received.
- It is possible that CAN frames are lost when necessary system resources are in use or when the CAN frames could not be processed in time due to high system load. So, the PLC application must monitor the task which consumes the events of the CAN protocol with a watchdog mechanism or something similar.
- Received CAN frames of the same CAN-ID are internally stored in FIFO buffers. Reading and writing of the FIFO buffers is not possible at the same time.
- Within an external event task the function block Cm598CanMsgRecEvt must be used to read the received CAN frames. The function block Cm598CanMsgRec is not suitable since its execution needs more than one task cycle.
- The CAN-IDs that are enabled to trigger an external event task must be read by the associated task. Otherwise the task is triggered again and again, and the CPU load will be high.
**Event task configuration**

Add the external event task that should be executed to the task configuration of the PLC application:

1. Right-click on "Task Configuration". Enter a name for the task and click "Add object".
2. Right-click on the new task and append a "Program Call". This contains the program code that is executed by the task.
3. Double-click on the task and setup the task parameters.

A parameter description is given in the chapter "Tab 'configuration" of Chapter 6.4.1.21.2.30.2 "Tab 'Configuration" on page 2538. Deviations are described in the following:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priority</td>
<td>16</td>
<td>0..16</td>
<td>Priority of the task</td>
</tr>
<tr>
<td>Type</td>
<td>n.a.</td>
<td>External</td>
<td>Specifies the task type.</td>
</tr>
<tr>
<td>External Event</td>
<td>n.a.</td>
<td>CouplerEvent&lt;slot index of the CM&gt;_CAN</td>
<td>Specifies the event that triggers execution of the task.</td>
</tr>
<tr>
<td>Interval</td>
<td>n.a.</td>
<td>Cycle time</td>
<td>Not used</td>
</tr>
</tbody>
</table>

Configuration of a CM598-CAN module is described in the configuration chapter of Chapter 6.3.2.11.1 “CANopen” on page 1521.

---

**6.8.3.2 CM582-DP/CM592-DP PROFIBUS DP communication modules**

Chapter 6.3.2.11.4.2 “Parameterization of the CM592-DP/CM582-DP communication modules” on page 1553 Chapter 6.3.2.11.4.3.1 “Configuration of a PROFIBUS DP master” on page 1554 Chapter 6.3.2.11.4.3.2 “Configuration of a PROFIBUS DP slave” on page 1557

**6.8.3.3 CM5640-2ETH Ethernet communication module**

Chapter 6.3.2.11.5.1 “CM5640-2ETH – Ethernet communication module” on page 1562
6.8.4  System technology of the communication interface modules

6.8.4.1  Modbus communication interface module

6.8.4.1.1  Overview

The Modbus TCP communication interface module CI52x-MODTCP is used as decentralized I/O module in Modbus TCP networks. The network connection is performed via 2 RJ45 connectors which are integrated in the terminal unit.

Application examples

In AC500 V3 projects in which several Modbus connections are needed at the same time, the number of Modbus sockets can be increased. How to increase the socket number with an additional run time license is described in the application note AC500 Line Mode with AC500 V3 CPU's.

A CI52x cluster can be used for the communication between the CPU and CI52x-MODTCP modules. An example on how to create a CI52x cluster configuration using the bulk data manager tool, is described in the application example CI52x-MODTCP cluster.

A summary of the function codes that are supported for Modbus TCP communication with a PLC is given in the application example Modbus TCP and ModTcpMast2.

A description on how to establish a Modbus TCP communication with fixed and dynamic register mapping in an AC500 PLC is given in the application example Modbus TCP and register mapping.

To operate fast counter on CI52x devices in combination with a V3 PLC correctly via Modbus TCP, a corresponding sample project is available. Setup and use are described in an application example.

CI521-MODTCP  I/O channels properties:

- 4 analog inputs (1.0...1.3)
- 2 analog outputs (1.5...1.6)
- 8 digital inputs 24 V DC in 1 group (2.0...2.7)
- 8 digital outputs 24 V DC in 1 group (3.0...3.7)
### Functionality

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface</td>
<td>Ethernet</td>
</tr>
<tr>
<td>Protocol</td>
<td>Modbus TCP</td>
</tr>
<tr>
<td>Power supply</td>
<td>from the process supply voltage UP</td>
</tr>
<tr>
<td>Supply of the electronic circuitry of the I/O expansion modules attached</td>
<td>Through the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>Rotary switches</td>
<td>For setting the last BYTE of the IP (00h to FFh)</td>
</tr>
<tr>
<td>Analog inputs</td>
<td>4 (configurable via software)</td>
</tr>
<tr>
<td>Analog outputs</td>
<td>2 (configurable via software)</td>
</tr>
<tr>
<td>Digital inputs</td>
<td>8 (24 V DC; delay time configurable via software)</td>
</tr>
<tr>
<td>Digital outputs</td>
<td>8 (24 V DC, 0.5 A max.)</td>
</tr>
<tr>
<td>LED displays</td>
<td>For system displays, signal states, errors and power supply</td>
</tr>
<tr>
<td>External supply voltage</td>
<td>Via terminals ZP, UP and UP3 (process supply voltage 24 V DC)</td>
</tr>
</tbody>
</table>

#### CI522-MODTCP

**I/O channels properties:**
- 8 digital configurable inputs/outputs in 1 group (1.0...1.7)
- 8 digital inputs 24 V DC in 1 group (2.0...2.7)
- 8 digital outputs 24 V DC in 1 group (3.0...3.7)

### Functionality

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface</td>
<td>Ethernet</td>
</tr>
<tr>
<td>Protocol</td>
<td>Modbus TCP</td>
</tr>
<tr>
<td>Power supply</td>
<td>from the process supply voltage UP</td>
</tr>
<tr>
<td>Supply of the electronic circuitry of the I/O expansion modules attached</td>
<td>Through the I/O bus interface (I/O bus)</td>
</tr>
<tr>
<td>Rotary switches</td>
<td>For setting the last BYTE of the IP (00h to FFh)</td>
</tr>
<tr>
<td>Configurable digital inputs/outputs</td>
<td>8 (configurable via software)</td>
</tr>
<tr>
<td>Digital inputs</td>
<td>8 (24 V DC; delay time configurable via software)</td>
</tr>
<tr>
<td>Digital outputs</td>
<td>8 (24 V DC, 0.5 A max.)</td>
</tr>
<tr>
<td>LED displays</td>
<td>For system displays, signal states, errors and power supply</td>
</tr>
<tr>
<td>External supply voltage</td>
<td>Via terminals ZP, UP and UP3 (process supply voltage 24 V DC)</td>
</tr>
</tbody>
</table>

The inputs/outputs are galvanically isolated from the Ethernet network. There is no potential separation between the channels.

The configuration of the inputs/outputs is performed by software.

For usage in enhanced ambient conditions (e.g. wider temperature and humidity range), a special XC version of the device is available.
6.8.4.1.2 Modbus TCP registers

Register layout for CI52x-MODTCP

The registers can be divided in 4 sections:

- Information data section 0x0000 to 0x0D50 (for acyclic use)
- I/O data and diagnosis section 0x0FFA to 0x2B00 (for cyclic use)
- Parameter data section 0x3000 to 0x3B00 (for acyclic use)
- Special functionality section 0x5A00 to 0x6A00 (for acyclic use)

Information data section (acyclic data)

General

The information data section can be used to read out common and module specific information. This section is read only.

<table>
<thead>
<tr>
<th>Register (hex)</th>
<th>Description</th>
<th>Readable by Modbus function code</th>
<th>Writeable by Modbus function code</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Device and FW information CI</td>
<td>3</td>
<td>x</td>
</tr>
<tr>
<td>50</td>
<td>Production data CI</td>
<td>3</td>
<td>x</td>
</tr>
<tr>
<td>100</td>
<td>Device and FW information 1. EXP</td>
<td>3</td>
<td>x</td>
</tr>
<tr>
<td>125</td>
<td>Device and FW information 1. Hot swap terminal unit</td>
<td>3 *)</td>
<td>x</td>
</tr>
<tr>
<td>150</td>
<td>Production data 1. EXP</td>
<td>3</td>
<td>x</td>
</tr>
<tr>
<td>175</td>
<td>Production data 1. Hot swap terminal unit</td>
<td>3 *)</td>
<td>x</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>A00</td>
<td>Device and FW information 10. EXP</td>
<td>3</td>
<td>x</td>
</tr>
<tr>
<td>A25</td>
<td>Device and FW information 10. Hot swap terminal unit</td>
<td>3 *)</td>
<td>x</td>
</tr>
<tr>
<td>A50</td>
<td>Production data 10. EXP</td>
<td>3</td>
<td>x</td>
</tr>
<tr>
<td>A75</td>
<td>Production data 10. Hot swap terminal unit</td>
<td>3 *)</td>
<td>x</td>
</tr>
<tr>
<td>D00</td>
<td>Common device information</td>
<td>3</td>
<td>x</td>
</tr>
</tbody>
</table>

*) supported from CI52x firmware version V3.2.0 (device index F0)

This section can be divided again in two sections:

- The module specific section (containing information for each module CI52x-MODTCP and expansion modules and hot swap terminal units)
  - Chapter 6.8.4.1.2.2.2 “Module specific information registers” on page 4570
- The common device information block
  - Chapter 6.8.4.1.2.2.3 “Common device information registers” on page 4572

Module specific information registers

For each module (CI52x device, expansion modules and hot swap terminal units) the following data can be read out:
- **Device and FW information**
  This section consists of 20 WORDs per module and contains information on each module using the following structure:

<table>
<thead>
<tr>
<th>Data</th>
<th>DATA TYPE</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>WORD</td>
<td>The module ID of the requested module</td>
</tr>
<tr>
<td>Module name</td>
<td>ARRAY [1..10] OF BYTE</td>
<td>The module name of the requested module</td>
</tr>
<tr>
<td>Version 1(^{st}) processor</td>
<td>ARRAY [1..4] OF BYTE</td>
<td>The version of the 1(^{st}) processor of the requested module</td>
</tr>
<tr>
<td>Version 2(^{nd}) processor</td>
<td>ARRAY [1..4] OF BYTE</td>
<td>The version of the 2(^{nd}) processor of the requested module</td>
</tr>
<tr>
<td>Version 3(^{rd}) processor</td>
<td>ARRAY [1..4] OF BYTE</td>
<td>The version of the 3(^{rd}) processor of the requested module</td>
</tr>
<tr>
<td>Version 4(^{th}) processor</td>
<td>ARRAY [1..4] OF BYTE</td>
<td>The version of the 4(^{th}) processor of the requested module</td>
</tr>
<tr>
<td>Hardware version 1(^{st})</td>
<td>ARRAY [1..4] OF BYTE</td>
<td>The hardware version of the 4 processors</td>
</tr>
<tr>
<td>Reserved</td>
<td>ARRAY [1..8] OF BYTE</td>
<td>Reserved</td>
</tr>
<tr>
<td>Number input data</td>
<td>WORD</td>
<td>Number of input data of the requested module in BYTES</td>
</tr>
<tr>
<td>Number output data</td>
<td>WORD</td>
<td>Number of output data of the requested module in BYTES</td>
</tr>
</tbody>
</table>

1) supported from CI52x firmware version V3.2.0 (device index F0)

2) from CI52x firmware version V3.2.0 (device index F0) "Reserved" is ARRAY [1..4] OF BYTE

- **Production / Traceability data:**
  This section consists of 25 WORDs per module and contains the traceability data for each module using following structure:
  - Article number: Byte 01..15
  - Index: Byte 16..17
  - Name: Byte 18..29
  - Production date: Byte 30..33
  - Key number: Byte 34..38
  - Site: Byte 39..40
  - Year: Byte 41..42
  - Serial number: Byte 41..50 (The serial number implies the year)

- **Production / Traceability data from CI5x2 firmware version V3.2.0 (device index F0):**
  This section consists of 26 WORDs per module and contains the traceability data for each module using following structure:
  - Article number: Byte 01..15
  - Index: Byte 16..17
  - Name: Byte 18..31
  - Production date: Byte 32..35
  - Key number: Byte 36..40
  - Site: Byte 41..42
  - Year: Byte 43..44
  - Serial number: Byte 42..52 (The serial number implies the year)
Common device information registers

This section consists of 80 WORDs (90 WORDs from CI52x firmware version V3.2.0 (device index F0)) and contains cluster wide information (CI52x device and connected expansion modules using the following structure:

<table>
<thead>
<tr>
<th>Data</th>
<th>DATA TYPE</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device state</td>
<td>BYTE</td>
<td>The actual state of the device:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0: STATE_PREOP (device booting)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1: STATE_OPERATION (device in operational, no bus supervision active)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2: STATE_ERROR (device detected a bus error, bus supervision active)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3: STATE_IP_ERROR (the device has a IP address error)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4: STATE_CYCLIC_OPERATION (device in operational, bus supervision active)</td>
</tr>
<tr>
<td>Parameter state</td>
<td>BYTE</td>
<td>The actual parameter state of the device:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0: PARA_STATE_NO_PARA (the device has no parameters)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1: PARA_STATE_PARA_ACTIVE (parameterization process running)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2: PARA_STATE_PARA_DONE (the uses valid parameters)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3: PARA_STATE_ERROR (The device has invalid</td>
</tr>
<tr>
<td>Module ID CI device</td>
<td>WORD</td>
<td>Module ID of the CI52x device itself</td>
</tr>
<tr>
<td>Module ID 1st expansion</td>
<td>WORD</td>
<td>Module ID of the 1st connected expansion module</td>
</tr>
<tr>
<td>Module ID 2nd expansion</td>
<td>WORD</td>
<td>Module ID of the 2nd connected expansion module</td>
</tr>
<tr>
<td>...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Module ID 10th expansion</td>
<td>WORD</td>
<td>Module ID of the 10th connected expansion module</td>
</tr>
<tr>
<td>Expansion bus error count</td>
<td>DWORD</td>
<td>Global telegram error count over all expansion modules</td>
</tr>
<tr>
<td>Good count onboard I/O</td>
<td>DWORD</td>
<td>Telegram good count onboard I/Os</td>
</tr>
<tr>
<td>Good count 1st expansion</td>
<td>DWORD</td>
<td>Telegram good count 1st expansion module</td>
</tr>
<tr>
<td>Good count 2nd expansion</td>
<td>DWORD</td>
<td>Telegram good count 2nd expansion module</td>
</tr>
<tr>
<td>...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Good count 10th expansion</td>
<td>DWORD</td>
<td>Telegram good count 10th expansion module</td>
</tr>
<tr>
<td>Error count onboard I/O</td>
<td>DWORD</td>
<td>Telegram error count onboard I/Os</td>
</tr>
<tr>
<td>Error count 1st expansion</td>
<td>DWORD</td>
<td>Telegram error count 1st expansion module</td>
</tr>
<tr>
<td>Error count 2nd expansion</td>
<td>DWORD</td>
<td>Telegram error count 2nd expansion module</td>
</tr>
<tr>
<td>...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Error count 10th expansion</td>
<td>DWORD</td>
<td>Telegram error count 10th expansion module</td>
</tr>
<tr>
<td>Data</td>
<td>DATA TYPE</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Input address onboard I/O</td>
<td>WORD</td>
<td>Modbus TCP register address for inputs of the onboard I/Os</td>
</tr>
<tr>
<td>Input address 1&lt;sup&gt;st&lt;/sup&gt; expansion</td>
<td>WORD</td>
<td>Modbus TCP register address for inputs of the 1&lt;sup&gt;st&lt;/sup&gt; expansion module</td>
</tr>
<tr>
<td>Input address 2&lt;sup&gt;nd&lt;/sup&gt; expansion</td>
<td>WORD</td>
<td>Modbus TCP register address for inputs of the 2&lt;sup&gt;nd&lt;/sup&gt; expansion module</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>Input address 10&lt;sup&gt;th&lt;/sup&gt; expansion</td>
<td>WORD</td>
<td>Modbus TCP register address for inputs of the 10&lt;sup&gt;th&lt;/sup&gt; expansion module</td>
</tr>
<tr>
<td>Output address onboard I/O</td>
<td>WORD</td>
<td>Modbus TCP register address for outputs of the onboard I/Os</td>
</tr>
<tr>
<td>Output address 1&lt;sup&gt;st&lt;/sup&gt; expansion</td>
<td>WORD</td>
<td>Modbus TCP register address for outputs of the 1&lt;sup&gt;st&lt;/sup&gt; expansion module</td>
</tr>
<tr>
<td>Output address 2&lt;sup&gt;nd&lt;/sup&gt; expansion</td>
<td>WORD</td>
<td>Modbus TCP register address for outputs of the 2&lt;sup&gt;nd&lt;/sup&gt; expansion module</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>Output address 10&lt;sup&gt;th&lt;/sup&gt; expansion</td>
<td>WORD</td>
<td>Modbus TCP register address for outputs of the 10&lt;sup&gt;th&lt;/sup&gt; expansion module</td>
</tr>
<tr>
<td>Module ID 1&lt;sup&gt;st&lt;/sup&gt; hot swap terminal unit *)</td>
<td>WORD</td>
<td>Module ID of the 1&lt;sup&gt;st&lt;/sup&gt; connected hot swap terminal unit *)</td>
</tr>
<tr>
<td>Module ID 2&lt;sup&gt;nd&lt;/sup&gt; hot swap terminal unit *)</td>
<td>WORD</td>
<td>Module ID of the 2&lt;sup&gt;nd&lt;/sup&gt; connected hot swap terminal unit *)</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>Module ID 10&lt;sup&gt;th&lt;/sup&gt; hot swap terminal unit *)</td>
<td>WORD</td>
<td>Module ID of the 10&lt;sup&gt;th&lt;/sup&gt; connected hot swap terminal unit *)</td>
</tr>
</tbody>
</table>

*) supported from CI52x firmware version V3.2.0 (device index F0)

---

**I/O / Process data and diagnosis section (cyclic data)**

**General**

*Table 847: The cyclic data section for CI52x-MODTCP*

<table>
<thead>
<tr>
<th>Register (hex)</th>
<th>Description</th>
<th>Readable by Modbus function code</th>
<th>Writeable by Modbus function code</th>
</tr>
</thead>
<tbody>
<tr>
<td>FCE *)</td>
<td>Module state</td>
<td>3, 4, 23</td>
<td>x</td>
</tr>
<tr>
<td>FFA</td>
<td>Diagnosis</td>
<td>3, 4, 23</td>
<td>x</td>
</tr>
<tr>
<td>1000</td>
<td>Inputs CI</td>
<td>3, 4, 23</td>
<td>x</td>
</tr>
<tr>
<td>1100</td>
<td>Inputs 1.EXP</td>
<td>3, 4, 23</td>
<td>x</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>1A00</td>
<td>Inputs 10.EXP</td>
<td>3, 4, 23</td>
<td>x</td>
</tr>
<tr>
<td>2000</td>
<td>Outputs CI</td>
<td>3, 23, 6, 16, 23</td>
<td>x</td>
</tr>
<tr>
<td>2100</td>
<td>Outputs 1.EXP</td>
<td>3, 23, 6, 16, 23</td>
<td>x</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>2A00</td>
<td>Outputs 10.EXP</td>
<td>3, 23, 6, 16, 23</td>
<td>x</td>
</tr>
<tr>
<td>2B00</td>
<td>Dummy output</td>
<td>3, 23, 6, 16, 23</td>
<td>x</td>
</tr>
</tbody>
</table>
*) supported from CI52x firmware version V3.2.0 (device index F0)

This section can be divided again in three sections:

- Module state (containing the state of connected expansion modules and hot swap terminal units)
  ≡ Chapter 6.8.4.1.2.3.2 “Module state” on page 4574
- Diagnosis data (containing diagnosis data in AC500 specific format)
  ≡ Chapter 6.8.4.1.2.3.3 “Diagnosis data” on page 4576
- Process data (containing I/O data)
  ≡ Chapter 6.8.4.1.2.3.4 “I/O data” on page 4576

### Module state

The module state section consists of 44 WORDs and contains the module state of connected expansion modules and hot swap terminal units using the following structure:

<table>
<thead>
<tr>
<th>Data</th>
<th>DATA TYPE</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>WORD</td>
<td>Module ID of the CI52x</td>
</tr>
<tr>
<td>Expected module ID</td>
<td>WORD</td>
<td>Expected (configured) module ID of the CI52x</td>
</tr>
<tr>
<td>Module state</td>
<td>BYTE</td>
<td>The current module state of the CI52x:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0: NO_MOD (no module detected)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1: MOD_INIT (module detected, module is in initialization phase)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2: MOD_RUN (module detected and running or in failsafe state, input data are valid)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3: WRONG_MOD (wrong module detected, module ID doesn’t match expected module ID)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4: MOD_REMOVED (module removed or defective on hot swap terminal unit, no communication to module possible)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5: MOD_ERROR (module defective on hot swap terminal unit, no communication to module possible)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6: MOD_LOST (lost communication to module on not hot swap capable terminal unit)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7: UNKNOWN (module detected but not configured)</td>
</tr>
<tr>
<td>Diagnosis flag</td>
<td>BYTE</td>
<td>Diagnosis flag for the CI52x:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0: NO_DIAG (no diagnosis available from CI52x I/O cards)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1: DIAGAVAILABLE (diagnosis available for CI52x I/O cards)</td>
</tr>
<tr>
<td>Terminal unit state</td>
<td>BYTE</td>
<td>Terminal unit state for the CI52x:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0: NO_HOTSWAP_TU (not hot swap terminal unit detected)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1: HOTSWAP_TU_RUNNING (hot swap terminal unit detected and working)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2: HOTSWAP_TU_ERROR (hot swap terminal unit detected, but communication errors for hot swap terminal unit detected)</td>
</tr>
<tr>
<td>Data</td>
<td>DATA TYPE</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Parameter state</td>
<td>BYTE</td>
<td>Parameter state of the CI52x:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0: NO_PARA (module is in initialization phase and not ready for parameterization)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1: WAIT_PARA (module awaits parameterization)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2: PARA_RUN (parameterization running)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3: LEN_ERR (length of parameters not correct)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4: ID_ERR (module ID inside parameters not correct)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5: PARA_DONE (parameterization finished without errors)</td>
</tr>
<tr>
<td>Module ID</td>
<td>WORD</td>
<td>Module ID of the 1st connected expansion module</td>
</tr>
<tr>
<td>Expected module ID</td>
<td>WORD</td>
<td>Expected (configured) module ID of the 1st connected expansion module</td>
</tr>
<tr>
<td>Module state</td>
<td>BYTE</td>
<td>The current module state of the 1st connected expansion module</td>
</tr>
<tr>
<td>Diagnosis flag</td>
<td>BYTE</td>
<td>Diagnosis flag for the 1st connected expansion module</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0: NO_DIAG (no diagnosis available for expansion module)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1: DIAG_AVAILABLE (diagnosis available for expansion module)</td>
</tr>
<tr>
<td>Terminal unit state</td>
<td>BYTE</td>
<td>Terminal unit state for the 1st connected expansion module</td>
</tr>
<tr>
<td>Parameter state</td>
<td>BYTE</td>
<td>Parameter state of the 1st connected expansion module</td>
</tr>
<tr>
<td>...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Module ID</td>
<td>WORD</td>
<td>Module ID of the 10th connected expansion module</td>
</tr>
<tr>
<td>Expected module ID</td>
<td>WORD</td>
<td>Expected (configured) module ID of the 10th connected expansion module</td>
</tr>
<tr>
<td>Module state</td>
<td>BYTE</td>
<td>The current module state of the 10th connected expansion module</td>
</tr>
<tr>
<td>Diagnosis flag</td>
<td>BYTE</td>
<td>Diagnosis flag for the 10th connected expansion module</td>
</tr>
<tr>
<td>Terminal unit state</td>
<td>BYTE</td>
<td>Terminal unit state for the 10th connected expansion module</td>
</tr>
<tr>
<td>Parameter state</td>
<td>BYTE</td>
<td>Parameter state of the 10th connected expansion module</td>
</tr>
</tbody>
</table>
Diagnosis data

The diagnosis data section contains one diagnosis message with the following structure (according to AC500 diagnosis):

<table>
<thead>
<tr>
<th>Byte Number</th>
<th>Description</th>
<th>Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Diagnosis Byte, slot number</td>
<td>31 = CI52x-MODTCP (e.g. error at integrated 8 DI / 8 DO)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = 1st connected S500 I/O Module</td>
</tr>
<tr>
<td></td>
<td></td>
<td>...</td>
</tr>
<tr>
<td></td>
<td></td>
<td>10 = 10th connected S500 I/O Module</td>
</tr>
<tr>
<td>2</td>
<td>Diagnosis Byte, module number</td>
<td>According to the I/O bus specification passed on by modules to the fieldbus master</td>
</tr>
<tr>
<td>3</td>
<td>Diagnosis Byte, channel</td>
<td>According to the I/O bus specification passed on by modules to the fieldbus master</td>
</tr>
<tr>
<td>4</td>
<td>Diagnosis Byte, error code</td>
<td>According to the I/O bus specification Bit 7 and Bit 6, coded error class</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 = E1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = E2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 = E3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 = E4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bit 0 to Bit 5, coded error description</td>
</tr>
<tr>
<td>5</td>
<td>Diagnosis Byte, flags</td>
<td>According to the I/O bus specification</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bit 7: 1 = coming error</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bit 6: 1 = leaving error</td>
</tr>
<tr>
<td>6</td>
<td>Reserved</td>
<td>0</td>
</tr>
</tbody>
</table>

If a diagnosis message is read out, the next one will be automatically filled in. If no more diagnosis messages are available the buffer will be reset to zero. This ensures that each diagnosis message can be delivered to the Modbus TCP client/slave and no diagnosis will be lost.

I/O data

The I/O data section can use two different formats according to the module parameter "I/O Mapping Structure".

- Fixed I/O mapping
  In case of fixed I/O mapping each module has a predefined register range for each Inputs and Outputs.
- Dynamic I/O mapping
  In case of dynamic I/O mapping the mapping is build according to the actual configuration.

The dummy output at the end of the I/O data section can be used to retrigger the bus supervision and has no effect on the HW outputs.
### Fixed I/O mapping

In case of fixed I/O mapping the following predefined register table is used:

<table>
<thead>
<tr>
<th>Register (hex)</th>
<th>Description</th>
<th>Readable by Modbus function code</th>
<th>Writeable by Modbus function code</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000</td>
<td>Inputs CI</td>
<td>3, 4, 23</td>
<td>x</td>
</tr>
<tr>
<td>1100</td>
<td>Inputs 1.EXP</td>
<td>3, 4, 23</td>
<td>x</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>x</td>
</tr>
<tr>
<td>1A00</td>
<td>Inputs 10.EXP</td>
<td>3, 4, 23</td>
<td>x</td>
</tr>
<tr>
<td>2000</td>
<td>Outputs CI</td>
<td>3, 23</td>
<td>6, 16, 23</td>
</tr>
<tr>
<td>2100</td>
<td>Outputs 1.EXP</td>
<td>3, 23</td>
<td>6, 16, 23</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>2A00</td>
<td>Outputs 10.EXP</td>
<td>3, 23</td>
<td>6, 16, 23</td>
</tr>
<tr>
<td>2B00</td>
<td>Dummy output</td>
<td>3, 23</td>
<td>6, 16, 23</td>
</tr>
</tbody>
</table>

If a certain expansion module has no inputs or outputs the corresponding registers remain empty.

### Dynamic I/O mapping

In case of dynamic mapping only the start addresses of inputs and outputs are predefined:

<table>
<thead>
<tr>
<th>Register (hex)</th>
<th>Description</th>
<th>Readable by Modbus function code</th>
<th>Writeable by Modbus function code</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000</td>
<td>Inputs CI</td>
<td>3, 4, 23</td>
<td>x</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>x</td>
</tr>
<tr>
<td>2000</td>
<td>Outputs CI</td>
<td>3, 23</td>
<td>6, 16, 23</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>2B00</td>
<td>Dummy output</td>
<td>3, 23</td>
<td>6, 16, 23</td>
</tr>
</tbody>
</table>

The register addresses of the connected expansion modules are calculated dynamically based on the number of inputs and outputs of the previous modules (each module starts directly on the next register after the previous module).

The register addresses of each module can be read out via the common device register ⇢ Chapter 6.8.4.1.2.2.3 “Common device information registers” on page 4572.
The difference between fixed I/O mapping and dynamic I/O mapping is shown in the following table.

For this comparison a cluster with CI522, AX522, DC532, AX521, DC523, DC532, AO523, AI523, DI524, AX522 and DC523 is used.

| Fixed Mapping | | Dynamic Mapping |
|---------------|---------------|
| **Register (hex)** | **Description** | **Type** | **Data** | **Register (hex)** | **Description** | **Type** | **Data** |
| 1000 | Inputs CI | 8 DC, 8 DI, FC | 4 BYTE + 4 WORD | 1000 | Inputs CI | 8 DC, 8 DI, FC | 4 BYTE + 4 WORD |
| 1100 | Inputs AX522 | 8 AI | 8 WORD | 1006 | Inputs AX522 | 8 AI | 8 WORD |
| 1200 | Inputs DC532 | 16 DI, 16 DC | 4 BYTE | 100E | Inputs DC532 | 16 DI, 16 DC | 4 BYTE |
| 1300 | Inputs AX521 | 4 AI | 4 WORD | 1010 | Inputs AX521 | 4 AI | 4 WORD |
| 1400 | Inputs DC532 | 24 DC | 3 BYTE | 1014 | Inputs DC532 | 24 DC | 3 BYTE |
| 1500 | Inputs DC532 | 16 DI, 16 DC | 4 BYTE | 1016 | Inputs DC532 | 16 DI, 16 DC | 4 BYTE |
| 1600 | Inputs AO523 | --- | --- | --- | Inputs AO523 | --- | --- |
| 1700 | Inputs AI523 | 16 AI | 16 WORD | 1018 | Inputs AI523 | 16 AI | 16 WORD |
| 1800 | Inputs DI524 | 32 DI | 4 BYTE | 1028 | Inputs DI524 | 32 DI | 4 BYTE |
| 1900 | Inputs AX522 | 8 AI | 8 WORD | 102A | Inputs AX522 | 8 AI | 8 WORD |
| 1A00 | Inputs DC532 | 24 DC | 3 BYTE | 1032 | Inputs DC532 | 24 DC | 3 BYTE |
| 2000 | Outputs CI | 8 DC, 8DO, FC | 4 BYTE + 8 WORD | 2000 | Outputs CI | 8 DC, 8DO, FC | 4 BYTE + 8 WORD |
| 2100 | Outputs AX522 | 8 AO | 8 WORD | 200A | Outputs AX522 | 8 AO | 8 WORD |
| 2200 | Outputs DC532 | 16 DC | 2 BYTE | 2012 | Outputs DC532 | 16 DC | 2 BYTE |
| 2300 | Outputs AX521 | 4 AO | 4 WORD | 2013 | Outputs AX521 | 4 AO | 4 WORD |
| 2400 | Outputs DC532 | 24 DC | 3 BYTE | 2017 | Outputs DC532 | 24 DC | 3 BYTE |
| 2500 | Outputs DC532 | 16 DC | 2 BYTE | 2019 | Outputs DC532 | 16 DC | 2 BYTE |
| 2600 | Outputs AO523 | 16 AO | 16 WORD | 201A | Outputs AO523 | 16 AO | 16 WORD |
| 2700 | Outputs AI523 | --- | --- | --- | Outputs AI523 | --- | --- |
| 2800 | Outputs DI524 | --- | --- | --- | Outputs DI524 | --- | --- |
| 2900 | Outputs AX522 | 8 AO | 8 WORD | 202A | Outputs AX522 | 8 AO | 8 WORD |
| 2A00 | Outputs DC532 | 24 DC | 3 BYTE | 2032 | Outputs DC532 | 24 DC | 3 BYTE |
When commissioning a CI521 module with byte order "big endian" in combination with a V3 PLC, BYTE and DWORD data of inputs and outputs has to be swapped by user. V3 PLC processor is using little endian as standard, high- and low bytes are interchanged! Analog values do not have to be swapped.

Table 848: I/O data (Inputs 20 BYTES)

<table>
<thead>
<tr>
<th>Signal</th>
<th>DATA TYPE</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AI0</td>
<td>WORD</td>
<td>Input value of the 1(^{st}) analog input</td>
</tr>
<tr>
<td>AI1</td>
<td>WORD</td>
<td>Input value of the 2(^{nd}) analog input</td>
</tr>
<tr>
<td>AI2</td>
<td>WORD</td>
<td>Input value of the 3(^{rd}) analog input</td>
</tr>
<tr>
<td>AI3</td>
<td>WORD</td>
<td>Input value of the 4(^{th}) analog input</td>
</tr>
<tr>
<td>DI</td>
<td>BYTE</td>
<td>Input value of the DI channels</td>
</tr>
<tr>
<td>Fast counter actual value counter 1</td>
<td>DWORD</td>
<td></td>
</tr>
<tr>
<td>Fast counter actual value counter 2</td>
<td>DWORD</td>
<td></td>
</tr>
<tr>
<td>Fast counter state counter 1</td>
<td>BYTE</td>
<td></td>
</tr>
<tr>
<td>Fast counter state counter 2</td>
<td>BYTE</td>
<td></td>
</tr>
<tr>
<td>Additional reserve byte</td>
<td>BYTE</td>
<td>reserved, not used</td>
</tr>
</tbody>
</table>

Table 849: I/O data (Outputs 24 BYTES)

<table>
<thead>
<tr>
<th>Signal</th>
<th>DATA TYPE</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AO0</td>
<td>WORD</td>
<td>Output value of the 1(^{st}) analog output</td>
</tr>
<tr>
<td>AO1</td>
<td>WORD</td>
<td>Output value of the 2(^{nd}) analog output</td>
</tr>
<tr>
<td>DO</td>
<td>BYTE</td>
<td>Output value of the DO channels</td>
</tr>
<tr>
<td>Fast counter start value counter 1</td>
<td>DWORD</td>
<td></td>
</tr>
<tr>
<td>Fast counter end value counter 1</td>
<td>DWORD</td>
<td></td>
</tr>
<tr>
<td>Fast counter start value counter 2</td>
<td>DWORD</td>
<td></td>
</tr>
<tr>
<td>Fast counter end value counter 2</td>
<td>DWORD</td>
<td></td>
</tr>
<tr>
<td>Fast counter control counter 1</td>
<td>BYTE</td>
<td></td>
</tr>
<tr>
<td>Fast counter control counter 2</td>
<td>BYTE</td>
<td></td>
</tr>
<tr>
<td>Additional reserve byte</td>
<td>BYTE</td>
<td>reserved, not used</td>
</tr>
</tbody>
</table>
When commissioning a CI522 module with byte order “big endian” in combination with a V3 PLC, BYTE and DWORD data of inputs and outputs has to be swapped by user. V3 PLC processor is using little endian as standard, high- and low bytes are interchanged! Analog values do not have to be swapped.

### Table 850: I/O data (Inputs 12 BYTES)

<table>
<thead>
<tr>
<th>Signal</th>
<th>DATA TYPE</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC</td>
<td>BYTE</td>
<td>Input value of the DC channels</td>
</tr>
<tr>
<td>DI</td>
<td>BYTE</td>
<td>Input value of the DI channels</td>
</tr>
<tr>
<td>Fast counter actual value</td>
<td>DWORD</td>
<td></td>
</tr>
<tr>
<td>counter 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast counter actual value</td>
<td>DWORD</td>
<td></td>
</tr>
<tr>
<td>counter 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast counter state counter</td>
<td>BYTE</td>
<td></td>
</tr>
<tr>
<td>counter 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast counter state counter</td>
<td>BYTE</td>
<td></td>
</tr>
<tr>
<td>counter 2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To operate fast counter on CI52x devices in combination with a V3 PLC correctly via Modbus TCP, a corresponding sample project is available. Setup and use are described in an application example.

### Table 851: I/O data (Outputs 20 BYTES)

<table>
<thead>
<tr>
<th>Signal</th>
<th>DATA TYPE</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC</td>
<td>BYTE</td>
<td>Output value of the DC channels</td>
</tr>
<tr>
<td>DO</td>
<td>BYTE</td>
<td>Output value of the DO channels</td>
</tr>
<tr>
<td>Fast counter start value</td>
<td>DWORD</td>
<td></td>
</tr>
<tr>
<td>counter 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast counter end value</td>
<td>DWORD</td>
<td></td>
</tr>
<tr>
<td>counter 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast counter start value</td>
<td>DWORD</td>
<td></td>
</tr>
<tr>
<td>counter 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast counter end value</td>
<td>DWORD</td>
<td></td>
</tr>
<tr>
<td>counter 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast counter control counter</td>
<td>BYTE</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast counter control counter</td>
<td>BYTE</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Parameter data (acyclic data)

General

<table>
<thead>
<tr>
<th>Register (hex)</th>
<th>Description</th>
<th>Readable by Modbus function code</th>
<th>Writeable by Modbus function code</th>
</tr>
</thead>
<tbody>
<tr>
<td>3000</td>
<td>Parameters CI</td>
<td>3</td>
<td>6, 16</td>
</tr>
<tr>
<td>3080</td>
<td>Stored parameters CI</td>
<td>3</td>
<td>x</td>
</tr>
<tr>
<td>3100</td>
<td>Parameters 1. EXP</td>
<td>3</td>
<td>6, 16</td>
</tr>
<tr>
<td>3180</td>
<td>Stored parameters 1. EXP</td>
<td>3</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3A00</td>
<td>Parameters 10. EXP</td>
<td>3</td>
<td>6, 16</td>
</tr>
<tr>
<td>3A80</td>
<td>Stored parameters 10. EXP</td>
<td>3</td>
<td>x</td>
</tr>
<tr>
<td>3B00</td>
<td>controlword/statusword</td>
<td>3</td>
<td>6, 16</td>
</tr>
</tbody>
</table>

For each connected module the following parameter data are defined (the parameters are represented as ARRAY OF BYTE):

- Actual used parameter for each module
  
  In these sections the actual parameters are stored. This section is also used to write parameters to the module.
  
  § Chapter 6.8.4.1.3.2 “Parameterization” on page 4587

- Stored parameters for each module
  
  If the module has stored nonvolatile parameters these can be read out using the corresponding registers.

The controlword/statusword is used to trigger a parameterization process.

<table>
<thead>
<tr>
<th>Bit</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>End of parameterization use parameters</td>
</tr>
<tr>
<td>1</td>
<td>store parameters temporarily, use stored parameters after bus reconnect</td>
</tr>
<tr>
<td>2</td>
<td>store parameters in flash, use stored parameters after power cycle</td>
</tr>
<tr>
<td>3</td>
<td>reserved</td>
</tr>
<tr>
<td>4</td>
<td>delete stored parameters in flash</td>
</tr>
<tr>
<td>5</td>
<td>ignore parameter errors for saving</td>
</tr>
<tr>
<td>6</td>
<td>reserved</td>
</tr>
<tr>
<td>7</td>
<td>reserved</td>
</tr>
<tr>
<td>8</td>
<td>new diagnosis available</td>
</tr>
<tr>
<td>9</td>
<td>new parameters are available</td>
</tr>
<tr>
<td>10</td>
<td>reserved</td>
</tr>
<tr>
<td>11</td>
<td>reserved</td>
</tr>
<tr>
<td>12</td>
<td>reserved</td>
</tr>
<tr>
<td>13</td>
<td>reserved</td>
</tr>
<tr>
<td>14</td>
<td>reserved</td>
</tr>
<tr>
<td>15</td>
<td>reserved</td>
</tr>
</tbody>
</table>

Fig. 363: Meaning of the single bits

The direction of the first 8 bits is client to server (master to slave).

The direction of the second 8 bits is server to client (slave to master). § Description of the bits.

The parameter register sections (actual and stored parameters) have the structure as explained in the documentation of the corresponding module.
Short description of the CI521-MODTCP parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Single parameter index</th>
<th>Description</th>
<th>Additional Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>Module ID (high Byte)</td>
<td>Fixed, must be 16#1C</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>Module ID (low Byte)</td>
<td>Fixed, must be 16#E8</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>Ignore Module</td>
<td>Reserved, must be 0</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>Length of following parameter block</td>
<td>Fixed, must be 16#3F</td>
</tr>
<tr>
<td>4</td>
<td>0</td>
<td>Error LED / Failsafe</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>1</td>
<td>Master IP Byte 0</td>
<td>IP Address for write restrictions ≤ “Configurable write restriction” on page 4589</td>
</tr>
<tr>
<td>6</td>
<td>2</td>
<td>Master IP Byte 1</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>3</td>
<td>Master IP Byte 2</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>4</td>
<td>Master IP Byte 3</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>5</td>
<td>Master IP 1 Byte 0</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>6</td>
<td>Master IP 1 Byte 1</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>7</td>
<td>Master IP 1 Byte 2</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>8</td>
<td>Master IP 1 Byte 3</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>9</td>
<td>Master IP 2 Byte 0</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>10</td>
<td>Master IP 2 Byte 1</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>11</td>
<td>Master IP 2 Byte 2</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>12</td>
<td>Master IP 2 Byte 3</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>13</td>
<td>Master IP 3 Byte 0</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>14</td>
<td>Master IP 3 Byte 1</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>15</td>
<td>Master IP 3 Byte 2</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>16</td>
<td>Master IP 3 Byte 3</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>17</td>
<td>Master IP 4 Byte 0</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>18</td>
<td>Master IP 4 Byte 1</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>19</td>
<td>Master IP 4 Byte 2</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>20</td>
<td>Master IP 4 Byte 3</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>21</td>
<td>Master IP 5 Byte 0</td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>22</td>
<td>Master IP 5 Byte 1</td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>23</td>
<td>Master IP 5 Byte 2</td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>24</td>
<td>Master IP 5 Byte 3</td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>25</td>
<td>Master IP 6 Byte 0</td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>26</td>
<td>Master IP 6 Byte 1</td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>27</td>
<td>Master IP 6 Byte 2</td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>28</td>
<td>Master IP 6 Byte 3</td>
<td></td>
</tr>
<tr>
<td>33</td>
<td>29</td>
<td>Master IP 7 Byte 0</td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>30</td>
<td>Master IP 7 Byte 1</td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>Single parameter index</td>
<td>Description</td>
<td>Additional Info</td>
</tr>
<tr>
<td>-----------</td>
<td>------------------------</td>
<td>-------------</td>
<td>----------------</td>
</tr>
<tr>
<td>36</td>
<td>Master IP 7 Byte 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>36</td>
<td>Master IP 7 Byte 3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>9</td>
<td>Timeout</td>
<td>Timeout for bus supervision in 10ms steps if set to 0 no bus supervision is active</td>
</tr>
<tr>
<td>38</td>
<td>10 (read only)</td>
<td>I/O Mapping Structure</td>
<td></td>
</tr>
<tr>
<td>39</td>
<td>11</td>
<td>Reserved</td>
<td>Reserved, must be 0</td>
</tr>
<tr>
<td>40</td>
<td>12</td>
<td>Reserved</td>
<td>Reserved, must be 0</td>
</tr>
<tr>
<td>41</td>
<td>13</td>
<td>Reserved</td>
<td>Reserved, must be 0</td>
</tr>
<tr>
<td>42</td>
<td>14</td>
<td>Check supply</td>
<td></td>
</tr>
<tr>
<td>43</td>
<td>15</td>
<td>Analog data format</td>
<td>Reserved, must be 0</td>
</tr>
<tr>
<td>44</td>
<td>16</td>
<td>Input delay</td>
<td></td>
</tr>
<tr>
<td>46</td>
<td>17</td>
<td>Fast counter</td>
<td></td>
</tr>
<tr>
<td>46</td>
<td>18</td>
<td>Short circuit detection</td>
<td></td>
</tr>
<tr>
<td>47</td>
<td>19</td>
<td>Behavior binary outputs at com. fault</td>
<td></td>
</tr>
<tr>
<td>48</td>
<td>20</td>
<td>Substitute value binary outputs</td>
<td></td>
</tr>
<tr>
<td>49</td>
<td>21</td>
<td>Overvoltage monitoring</td>
<td></td>
</tr>
<tr>
<td>50</td>
<td>22</td>
<td>Behavior analog outputs</td>
<td></td>
</tr>
<tr>
<td>51</td>
<td>23</td>
<td>Channel Config AI0</td>
<td></td>
</tr>
<tr>
<td>52</td>
<td>24</td>
<td>Check Channel AI0</td>
<td></td>
</tr>
<tr>
<td>53</td>
<td>25</td>
<td>Channel Config AI1</td>
<td></td>
</tr>
<tr>
<td>54</td>
<td>26</td>
<td>Check Channel AI1</td>
<td></td>
</tr>
<tr>
<td>55</td>
<td>27</td>
<td>Channel Config AI2</td>
<td></td>
</tr>
<tr>
<td>56</td>
<td>28</td>
<td>Check Channel AI2</td>
<td></td>
</tr>
<tr>
<td>57</td>
<td>29</td>
<td>Channel Config AI3</td>
<td></td>
</tr>
<tr>
<td>58</td>
<td>30</td>
<td>Check Channel AI3</td>
<td></td>
</tr>
<tr>
<td>59</td>
<td>31</td>
<td>Channel Config AO0</td>
<td></td>
</tr>
<tr>
<td>60</td>
<td>32</td>
<td>Check Channel AO0</td>
<td></td>
</tr>
<tr>
<td>61</td>
<td>33</td>
<td>Substitute value AO0 (high Byte)</td>
<td></td>
</tr>
<tr>
<td>62</td>
<td>34</td>
<td>Substitute value AO0 (low Byte)</td>
<td></td>
</tr>
<tr>
<td>63</td>
<td>35</td>
<td>Channel Config AO1</td>
<td></td>
</tr>
<tr>
<td>64</td>
<td>36</td>
<td>Check Channel AO1</td>
<td></td>
</tr>
<tr>
<td>65</td>
<td>36</td>
<td>Substitute value AO1 (high Byte)</td>
<td></td>
</tr>
<tr>
<td>66</td>
<td>36</td>
<td>Substitute value AO1 (low Byte)</td>
<td></td>
</tr>
</tbody>
</table>
### Short description of the CI522-MODTCP parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Single parameter index</th>
<th>Description</th>
<th>Additional Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td>Module ID (high Byte)</td>
<td>Fixed, must be 16#1C</td>
</tr>
<tr>
<td>1</td>
<td></td>
<td>Module ID (low Byte)</td>
<td>Fixed, must be 16#ED</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>Ignore Module</td>
<td>Reserved, must be 0</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>Length of following parameter block</td>
<td>Fixed, must be 16#2F</td>
</tr>
<tr>
<td>4</td>
<td>0</td>
<td>Error LED / Failsafe</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>1</td>
<td>Master IP Byte 0</td>
<td>IP Address for write restrictions % “Configurable write restriction” on page 4589</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>Master IP Byte 1</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>Master IP Byte 2</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>Master IP Byte 3</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>2</td>
<td>Master IP 1 Byte 0</td>
<td>IP Address for write restrictions % “Configurable write restriction” on page 4589</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>Master IP 1 Byte 1</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td>Master IP 1 Byte 2</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td>Master IP 1 Byte 3</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>3</td>
<td>Master IP 2 Byte 0</td>
<td>IP Address for write restrictions % “Configurable write restriction” on page 4589</td>
</tr>
<tr>
<td>14</td>
<td></td>
<td>Master IP 2 Byte 1</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td>Master IP 2 Byte 2</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
<td>Master IP 2 Byte 3</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>4</td>
<td>Master IP 3 Byte 0</td>
<td>IP Address for write restrictions % “Configurable write restriction” on page 4589</td>
</tr>
<tr>
<td>18</td>
<td></td>
<td>Master IP 3 Byte 1</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td></td>
<td>Master IP 3 Byte 2</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td>Master IP 3 Byte 3</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>5</td>
<td>Master IP 4 Byte 0</td>
<td>IP Address for write restrictions % “Configurable write restriction” on page 4589</td>
</tr>
<tr>
<td>22</td>
<td></td>
<td>Master IP 4 Byte 1</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td></td>
<td>Master IP 4 Byte 2</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td></td>
<td>Master IP 4 Byte 3</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>6</td>
<td>Master IP 5 Byte 0</td>
<td>IP Address for write restrictions % “Configurable write restriction” on page 4589</td>
</tr>
<tr>
<td>26</td>
<td></td>
<td>Master IP 5 Byte 1</td>
<td></td>
</tr>
<tr>
<td>27</td>
<td></td>
<td>Master IP 5 Byte 2</td>
<td></td>
</tr>
<tr>
<td>28</td>
<td></td>
<td>Master IP 5 Byte 3</td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>7</td>
<td>Master IP 6 Byte 0</td>
<td>IP Address for write restrictions % “Configurable write restriction” on page 4589</td>
</tr>
<tr>
<td>30</td>
<td></td>
<td>Master IP 6 Byte 1</td>
<td></td>
</tr>
<tr>
<td>31</td>
<td></td>
<td>Master IP 6 Byte 2</td>
<td></td>
</tr>
<tr>
<td>32</td>
<td></td>
<td>Master IP 6 Byte 3</td>
<td></td>
</tr>
<tr>
<td>33</td>
<td>8</td>
<td>Master IP 7 Byte 0</td>
<td>IP Address for write restrictions % “Configurable write restriction” on page 4589</td>
</tr>
<tr>
<td>34</td>
<td></td>
<td>Master IP 7 Byte 1</td>
<td></td>
</tr>
<tr>
<td>35</td>
<td></td>
<td>Master IP 7 Byte 2</td>
<td></td>
</tr>
<tr>
<td>36</td>
<td></td>
<td>Master IP 7 Byte 3</td>
<td></td>
</tr>
</tbody>
</table>
### Parameters of connected expansion modules

The parameters of the connected expansion modules are represented as byte array (the parameters valid for "CPU" in the corresponding module are used):

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Additional Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Module ID (high byte)</td>
<td>Fixed, see corresponding module (the module ID of FBP is used)</td>
</tr>
<tr>
<td>1</td>
<td>Module ID (low byte)</td>
<td>Fixed, see corresponding module (the module ID of FBP is used)</td>
</tr>
<tr>
<td>2</td>
<td>Ignore module</td>
<td>Reserved must be 0</td>
</tr>
<tr>
<td>3</td>
<td>Length of following parameter block</td>
<td>Fixed, see corresponding module</td>
</tr>
<tr>
<td>4...</td>
<td>The rest of the parameter are described in the corresponding module</td>
<td></td>
</tr>
</tbody>
</table>
Special functionality

This section contains special services like firmware update or single parameterization.

<table>
<thead>
<tr>
<th>Register (hex)</th>
<th>Description</th>
<th>Readable by Modbus function code</th>
<th>Writeable by Modbus function code</th>
</tr>
</thead>
<tbody>
<tr>
<td>4000</td>
<td>Firmware download</td>
<td>3</td>
<td>16</td>
</tr>
<tr>
<td>4100</td>
<td>Firmware download state</td>
<td>3</td>
<td>x</td>
</tr>
<tr>
<td>5000</td>
<td>Write single parameterization of CI</td>
<td>x</td>
<td>16</td>
</tr>
<tr>
<td>5100</td>
<td>Write single parameterization of 1. EXP</td>
<td>x</td>
<td>16</td>
</tr>
<tr>
<td>...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5A00</td>
<td>Write single parameterization of 10. EXP</td>
<td>x</td>
<td>16</td>
</tr>
<tr>
<td>6000</td>
<td>Read single parameterization of CI</td>
<td>3</td>
<td>16</td>
</tr>
<tr>
<td>6100</td>
<td>Read single parameterization of 1. EXP</td>
<td>3</td>
<td>16</td>
</tr>
<tr>
<td>...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6A00</td>
<td>Read single parameterization of 10. EXP</td>
<td>3</td>
<td>16</td>
</tr>
</tbody>
</table>

6.8.4.1.3 Behavior

IP address assignment

General

The delivery IP address of the CI52x-MODTCP is 192.168.0.xx. xx is the hardware address switch position of the device.

The devices support BOOTP, DHCP and fixed IP address setting. These can be set individual or together.

If BOOTP and DHCP are enabled the following priority takes place:

- If DHCP configuration fails, the device will fall back to BOOTP.
- In case of a BOOTP failure, the fixed IP address will be used.

A new IP address (or changing of BOOTP and DHCP) can be set in two different ways:

- With the address switches of the corresponding module
- With the IP configuration tool
  - Chapter 6.3.2.9.2 “Configuration of the IP settings with the IP configuration tool” on page 1506
Using the address switches

With the address switches only the last byte of the IP address can be changed. The IP address can only be set via the address switches in case of factory default or in case of the last byte of the IP address is set to zero.

☞ Chapter 6.3.2.9.2 “Configuration of the IP settings with the IP configuration tool” on page 1506

The not allowed IP addresses are mapped as followed:

- Address switch position 255 is mapped to fixed IP 192.168.0.254 independent of other stored settings (by IP Configuration Tool). This is a backup so the module can always get a valid IP address and can be configured by the IP Configuration Tool.
- Address switch position 0 is mapped to last byte equal 1 and DHCP enabled.

Using the IP configuration tool

With the 'Configuration of the IP settings with the IP configuration tool' a network scan can be executed, and the found devices can be assigned with new settings, e.g. enable BOOTP or DHCP and set a new fixed IP.

☞ Chapter 6.3.2.9.2 “Configuration of the IP settings with the IP configuration tool” on page 1506

If the last byte of the IP address of the CI52x-MODTCP devices is set to 0 with the IP Configuration Tool the address switch position is used instead.

☞ Chapter 6.8.4.1.3.1.2 “Using the address switches” on page 4587

Parameterization

The parameterization is done via the corresponding registers explained in the Modbus TCP registers ☞ Chapter 6.8.4.1.2.4 “Parameter data (acyclic data)” on page 4581.

In addition to that the parameters can be directly transferred via Automation Builder.

☞ Chapter 6.3.2.12.2 “Unbundled CI52x-MODTCP configuration” on page 1565

There are two different parameter sections with different behavior.

Actual used parameters

After startup this section contains the following data:

- Default parameters (only module id and parameter length set all others zero) if no valid stored parameters are available (no or invalid parameters stored).
- Actual used / stored parameters if valid parameters are stored nonvolatile.

These parameters can be read out and changed by reading or writing of the corresponding registers, but will not be used automatically after writing them, the use of new written parameters has to be triggered by writing the parameter control word with the corresponding bits set (see below).

Stored parameters

This section always contains a copy of the nonvolatile stored parameters, if no parameters are stored nonvolatile this sections will be 0.

Controlword/statusword parameter

This parameter can be used to trigger and save new parameters.

The direction of the first 8 bit is client to server (master to slave). The direction of the second 8 bits is server to client (slave to master).
### Bit Description

<table>
<thead>
<tr>
<th>Bit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Use parameters / start parameterization</td>
</tr>
<tr>
<td></td>
<td>If this bit is set the CI Device starts the parameterization with the parameters in the actual parameters registers.</td>
</tr>
<tr>
<td>1</td>
<td>Store parameters volatile</td>
</tr>
<tr>
<td></td>
<td>If this bit is set the CI device will use the parameters temporarily, which means after a bus error detection and reconnection the parameters will be used again.</td>
</tr>
<tr>
<td></td>
<td><strong>This bit should always be set.</strong></td>
</tr>
<tr>
<td></td>
<td><strong>This bit is only evaluated when bit 0 is set.</strong></td>
</tr>
<tr>
<td>2</td>
<td>Store parameters nonvolatile</td>
</tr>
<tr>
<td></td>
<td>If this bit is set the CI device will store the parameters nonvolatile, which means after a power cycle the stored parameter data will be used again.</td>
</tr>
<tr>
<td></td>
<td><strong>This bit is only evaluated when bit 0 is set.</strong></td>
</tr>
<tr>
<td>3</td>
<td>Reserved</td>
</tr>
<tr>
<td>4</td>
<td>Delete nonvolatile stored parameters</td>
</tr>
<tr>
<td></td>
<td>If this bit is set the CI device will delete its nonvolatile stored parameters.</td>
</tr>
<tr>
<td></td>
<td><strong>This bit is only evaluated when bit 0 is set.</strong></td>
</tr>
<tr>
<td>5</td>
<td>Ignore parameter error for nonvolatile parameter storage</td>
</tr>
<tr>
<td></td>
<td>If this bit is set a parameter error during nonvolatile storage of parameters will be ignored, and the parameters will be stored.</td>
</tr>
<tr>
<td></td>
<td><strong>This bit can only be set in combination with bit 0 and bit 2.</strong></td>
</tr>
<tr>
<td>6</td>
<td>Reserved</td>
</tr>
<tr>
<td>7</td>
<td>Reserved</td>
</tr>
<tr>
<td>8</td>
<td>New diagnosis available</td>
</tr>
<tr>
<td></td>
<td>The device will set this bit if new diagnosis data are available in the diagnosis data section.</td>
</tr>
<tr>
<td>9</td>
<td>New parameters available</td>
</tr>
<tr>
<td></td>
<td>The device will set this bit if new parameters are available in the actual parameter data section and these were not activated by setting bit 0 in the control word.</td>
</tr>
<tr>
<td>10...15</td>
<td>Reserved</td>
</tr>
</tbody>
</table>

### Cyclic I/O data exchange

The I/O data can be exchanged cyclic by the master by reading, writing the corresponding registers.

I/O data exchange is only possible after successful parameterization of the device.

For writing of outputs **bus failure detection** can be activated by setting the corresponding parameter. This bus failure detection is described in the following chapter.

#### Bus failure detection

If the parameter “*timeout*” in the module parameters of the CI52x-MODTCP is set, the module will supervise the Modbus TCP *write telegrams*.

After the first *write telegram* the bus will be supervised. If no new *write telegram* arrives at the CI52x-MODTCP within the configured time, the module will detect a bus failure and switch off its outputs or switch them to the configured failsafe state. [Chapter 5.2.6.5.1.8 “Parameterization” on page 1090](#) [Chapter 5.2.6.5.2.8 “Parameterization” on page 1120](#).
With the module parameters “Master IP”- “Master IP 7” it is possible to set write restrictions on the CI52x-MODTCP device.

If none of the parameters is set, all masters / clients in the network have read and write rights on the CI52x-MODTCP device and its connected expansion modules.

If at least one parameter is set only the configured masters / clients have write rights on the CI52x-MODTCP device.

All other masters / clients still have read access to the CI52x-MODTCP device.

**Diagnosis behavior**

Each diagnosis message signals if this error is coming or going, so it is possible to create a list in the master of actual pending diagnosis.

Diagnosis messages will be transferred again after a bus failure detection and reconnection.

Diagnosis messages can be read out with function code 3,4,23. Function codes 3 and 4 can always read out diagnosis messages, function code 23 can only read out after successful parameterization of the device. See also table “Diagnosis data” in Chapter 6.8.4.1.2.3.3 “Diagnosis data” on page 4576.

**Single parameterization**

The single parameterization services can be used to read or write parameters during run time of device without the need of triggering a new parameterization process.

For indexes used for single parameterization services see parameter lists in section Modbus TCP registers of this document.

The read and write parameterization services are explained below, for each module (CI52x-MODTCP and connected expansion modules) a different section for read and write is defined see chapter Modbus TCP registers in this document). Both services are using the following data structure:

The length of the read / write service depends on the count of parameters that should be transferred (length = 4+ count*8).

**Reading of single parameters**

The read single parameterization works in two steps:

- Writing of a request list containing the indexes that should be read using the structure explained above.
  Only CNT and PARA_IDX has to be set.
  Up to 5 parameters can be requested with one telegram.
  The length of the write service depends on the count of parameters that should be transferred (length = 4+ count*8).

- Reading of the parameters list with the same length then the previous write request.
  If the internal reading process inside the CI52x-MODTCP device is done the data will be read out.
  If the internal reading process inside the CI52x-MODTCP device is not yet finished the read service will be rejected with Modbus TCP exception code 6 (device busy).
**Writing of single parameters**

For writing of single parameters only one step is necessary, the parameters are transferred with one write request using the structure described above.

The length of the write service depends on the count of parameters that should be transferred (length = 4+ count*8).

In case of write of single parameters the following values have to be set:

- CNT: number of parameters to be set
- And for each parameter:
  - Parameter index
  - Parameter length
  - New parameter value

Written single parameters are not stored volatile and not stored nonvolatile. That means after a bus reconnection or power cycle the written parameters will be discarded.

---

**6.8.4.1.4 Commissioning example**

**Set IP Address:**

- The setting of the IP address is the first step to integrate the CI52x-MODTCP devices into a running system.
- The setting of the IP address of the CI52x-MODTCP devices is described in the chapter 'IP address assignment' Chapter 6.8.4.1.3.1 "IP address assignment" on page 4586 in this document.

**Set Parameters (optional read parameters):**

- The second step in configuring the CI52x-MODTCP devices is to set the module and channel parameters.
- A read of parameters is optional but can be used the get the module IDs and the parameter length.
- The reading and or writing of parameters is described in chapter 'Parameterization' Chapter 6.8.4.1.3.2 "Parameterization" on page 4587.

**Set Control Word:**

- After setting the parameter data these have to be activated by writing the control word.
- The meaning and usage of the control word is described in chapter 'Parameterization' Chapter 6.8.4.1.3.2 "Parameterization" on page 4587.

**Exchange data:**

- After setting and activating the parameters the CI52x-MODTCP device is ready for data exchange.
- The registers for data exchange are described in chapter 'I/O / Process data and diagnosis section (Cyclic data)' Chapter 6.8.4.1.2.3 "I/O / Process data and diagnosis section (cyclic data)" on page 4573.

---

**6.8.4.1.5 Hot swap**

**Introduction**

With hot swap for AC500 and S500 it is possible to exchange I/O modules (with same type) during runtime.
Preconditions for using hot swap

**Hot swap**

**WARNING!**

Risk of explosion or fire in hazardous environments during hot swapping!

Hot swap must not be performed in flammable environments to avoid life-threatening injury and property damage resulting from fire or explosion.

**WARNING!**

Electric shock due to negligent behavior during hot swapping!

To avoid electric shock

- make sure the following conditions apply:
  - Digital outputs are not under load.
  - Input/output voltages above safety extra low voltage/protective extra low voltage (SELV/PELV) are switched off.
  - Modules are fully interlocked with the terminal unit with both snap-fits engaged before switching on loads or input/output voltage.
  - Never touch exposed contacts (dangerous voltages).
  - Stay away from electrical contacts to avoid arc discharge.
  - Do not operate a mechanical installation improperly.

**NOTICE!**

Risk of damage to I/O modules!

Hot swapping is only allowed for I/O modules.

Processor modules and communication interface modules must not be removed or inserted during operation.

**H = Hot swap**

**Hot swap**

System requirements for hot swapping of I/O modules:

- Types of terminal units that support hot swapping of I/O modules have the appendix TU5xx-H.
- I/O modules as of index F0.

The following I/O bus masters support hot swapping of attached I/O modules:

- Communication interface modules CI5xx as of index F0.
- Processor modules PM56xx-2ETH with firmware version as of V3.2.0.

**Hot swap is not supported by AC500-eCo V3 CPU!**
The index of the module is in the right corner of the label.

NOTICE!
Risk of damage to I/O modules!
Modules with index below F0 can be damaged when inserted or removed from the terminal unit in a powered system.

NOTICE!
Risk of damage to I/O modules!
Do not perform hot swapping if any I/O module with firmware version lower than 3.0.14 is part of the I/O configuration.
For min. required device index see table below.

<table>
<thead>
<tr>
<th>Device</th>
<th>Min. required device index for I/O module as of FW Version 3.0.14</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC522(-XC)</td>
<td>F0</td>
</tr>
<tr>
<td>AI523 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AI531</td>
<td>D4</td>
</tr>
<tr>
<td>AI531-XC</td>
<td>D2</td>
</tr>
<tr>
<td>AI561</td>
<td>B2</td>
</tr>
<tr>
<td>AI562</td>
<td>B2</td>
</tr>
<tr>
<td>AI563</td>
<td>B3</td>
</tr>
<tr>
<td>AO523 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AO561</td>
<td>B2</td>
</tr>
<tr>
<td>AX521 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AX522 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AX561</td>
<td>B2</td>
</tr>
<tr>
<td>CD522 (-XC)</td>
<td>D1</td>
</tr>
</tbody>
</table>
### Device Min. required device index for I/O module as of FW Version 3.0.14

<table>
<thead>
<tr>
<th>Device</th>
<th>Min. required device index</th>
</tr>
</thead>
<tbody>
<tr>
<td>DA501 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DA502 (-XC)</td>
<td>F0</td>
</tr>
<tr>
<td>DC522 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DC523 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DC532 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DC562</td>
<td>A2</td>
</tr>
<tr>
<td>DI524 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DI561</td>
<td>B2</td>
</tr>
<tr>
<td>DI562</td>
<td>B2</td>
</tr>
<tr>
<td>DI571</td>
<td>B2</td>
</tr>
<tr>
<td>DI572</td>
<td>A1</td>
</tr>
<tr>
<td>DO524 (-XC)</td>
<td>A3</td>
</tr>
<tr>
<td>DO526</td>
<td>A2</td>
</tr>
<tr>
<td>DO526-XC</td>
<td>A0</td>
</tr>
<tr>
<td>DO561</td>
<td>B2</td>
</tr>
<tr>
<td>DO562</td>
<td>A2</td>
</tr>
<tr>
<td>DO571</td>
<td>B3</td>
</tr>
<tr>
<td>DO572</td>
<td>B2</td>
</tr>
<tr>
<td>DO573</td>
<td>A1</td>
</tr>
<tr>
<td>DX522 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DX531</td>
<td>D2</td>
</tr>
<tr>
<td>DX561</td>
<td>B2</td>
</tr>
<tr>
<td>DX571</td>
<td>B3</td>
</tr>
<tr>
<td>FM562</td>
<td>A1</td>
</tr>
</tbody>
</table>

### Compatibility of hot swap

<table>
<thead>
<tr>
<th>Compatibility</th>
<th>Modbus remote I/O</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O module on TU5xx-H connected to I/O bus master</td>
<td>CI521-MODTCP or CI522-MODTCP</td>
</tr>
<tr>
<td>Required version of I/O bus master</td>
<td>Module index as of F0</td>
</tr>
<tr>
<td></td>
<td>Firmware as of V3.2.3</td>
</tr>
<tr>
<td>Fieldbus master when used as remote I/O with AC500 V3</td>
<td>Any AC500 V3 CPU with on-board Ethernet</td>
</tr>
<tr>
<td>When used as remote I/O on third party controller (PLC or DCS)</td>
<td>No limitation known</td>
</tr>
</tbody>
</table>
**Hot swap behavior**

Table 852: Behavior in case of I/O attached to communication interface module for Modbus TCP, CI521-MODTCP or CI522-MODTCP

<table>
<thead>
<tr>
<th>Hot swap behavior</th>
<th>Modbus TCP remote I/O</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start-up behavior with missing or damaged I/O module on hot swap terminal unit TU5xx-H</td>
<td>Remote I/O station is not starting</td>
</tr>
<tr>
<td></td>
<td>As of device index F4 and Automation Builder Version 2.4.1 it is possible to configure the startup in case of missing modules on hot swap terminal units. If configured, the remote I/O station is starting up with missing or damaged I/O module, if the module is plugged later or replaced it will be automatically parameterized and I/O data will be exchanged. As the Automation Builder checks that all modules are available during configuration process, it is necessary that all I/O modules are available and in working order during configuration via Automation Builder. As the parameters are stored nonvolatile inside the CI52x devices later one the parameters have effect for power cycle or reconnection operations.</td>
</tr>
<tr>
<td>Start-up behavior with wrong I/O module type on any terminal unit</td>
<td>Remote I/O station is not starting</td>
</tr>
<tr>
<td>Diagnosis of presence of hot swap terminal unit</td>
<td>Information is available in Modbus registers of the communication interface module which can be accessed by the application program</td>
</tr>
<tr>
<td></td>
<td>As of device index F4 and Automation Builder Version 2.4.1 it is possible to configure a list of required hot swap terminal units. If a required hot swap terminal unit is missing (normal one plugged) this will not prevent a normal operation but a diagnosis message will be generated for the corresponding slot.</td>
</tr>
<tr>
<td>Diagnosis of hot swap capability of I/O module mounted on hot swap terminal unit</td>
<td>Information can be obtained by reading Modbus registers in the communication interface module. Those Modbus registers contain:</td>
</tr>
<tr>
<td></td>
<td>● Diagnosis in case that a not hot-swap-pable I/O module is plugged on a hot swap terminal unit</td>
</tr>
<tr>
<td></td>
<td>● Diagnosis In case that in a mixed configuration with at least one hot swap terminal unit an I/O module, that must not be used in a hot swap configuration, is mounted on any terminal unit of the configuration</td>
</tr>
<tr>
<td></td>
<td>● Production data and version index of the modules</td>
</tr>
<tr>
<td>Diagnosis while hot swap module is pulled or module (mounted on hot swap terminal unit) has stopped working</td>
<td>Diagnosis is available in Modbus registers in the communication interface module</td>
</tr>
<tr>
<td>Input state in process image of controller while module is pulled or module is not operational</td>
<td>Input = ZERO</td>
</tr>
<tr>
<td>Diagnosis after plugging the I/O module on the hot swap terminal unit</td>
<td>Diagnose &quot;diagnosis gone&quot; is available in Modbus registers in the communication interface module</td>
</tr>
</tbody>
</table>
System behavior

If an expansion module is removed or defective during run time, the input data of this module will be set to “0” and the module state will be set to the corresponding value (see Chapter 6.8.4.1.2.3 “I/O / Process data and diagnosis section (cyclic data)” on page 4573). A diagnosis message will be created in that case (see hardware description of CI521 Chapter 5.2.6.5.1 “CI521-MODTCP” on page 1070 / CI522 Chapter 5.2.6.5.2 “CI522-MODTCP” on page 1111 for diagnosis messages).

In case a module is replaced, the new module will automatically be parameterized with the last parameters of the removed module (if single parameters were written to the previously removed module, this parameters will be ignored).

During pulling or plugging of a certain module, all other module will continue to operate with one limitation: The reaction time of modules connected to the right of the affected module will be bigger in that case (up to 50 ms).

If the bus failure detection is active for CI52x and failsafe is configured Chapter 6.8.4.1.3.3 “Cyclic I/O data exchange” on page 4588 the following behavior applies if a module is removed and replugged during failsafe condition:

- Last value configured for output:
  - After a bus failure is detected, failsafe will be activated and the output will remain at its last value.
  - If the module is removed and plugged again, the output will remain off, and not be kept its last value, as the last value of the new module is “0” in that case.

- Substitute value configured for output:
  - After a bus failure is detected, failsafe will be activated and the output will be according to the configured substitute value.
  - If the module is removed and plugged again now, the output will be set according to the configured substitute value again.

- Substitute value for x seconds configured for output:
  - After a bus failure is detected, failsafe will be activated and the output will be according to the configured substitute value for the configured time.
  - If the module is removed and plugged again now, the output will be set according to the configured substitute value again, and the configured time starts again.

Mandatory rules for hot swapping

Mandatory rules for hot swapping:

- Between two pull and / or plug operations of I/O modules a pause of at least 1 second must be observed.
  - That means if a module is pulled or plugged there has to be at least a break of 1 second before the next module is pulled or plugged.

- At boot up of CI52x all configured expansion modules have to be physically available.
  - Start up with missing modules is not supported.

- In the application program it is possible to detect if a hot swap terminal unit is mounted in a specific position on the I/O bus. The information is available in the common device information registers. These can be accessed when the version of the communication interface module supports hot swap.
  - This has to be checked by application:
    - Best way for checking if a hot swap terminal unit is available or not, is reading out the common device information registers Chapter 6.8.4.1.2.2 “Information data section (acyclic data)” on page 4570. If the CI52x rejects this read out the CI52x doesn’t support hot swap at all.
6.8.4.2 PROFINET communication interface module
6.8.4.2.1 Hot swap

Introduction

With hot swap for AC500 and S500 it is possible to exchange I/O modules (with same type) during runtime.

Preconditions for Using Hot Swap

Hot swap

**WARNING!**
Risk of explosion or fire in hazardous environments during hot swapping!
Hot swap must not be performed in flammable environments to avoid life-threatening injury and property damage resulting from fire or explosion.

**WARNING!**
Electric shock due to negligent behavior during hot swapping!
To avoid electric shock
- make sure the following conditions apply:
  - Digital outputs are not under load.
  - Input/output voltages above safety extra low voltage/protective extra low voltage (SELV/PELV) are switched off.
  - Modules are fully interlocked with the terminal unit with both snap-fits engaged before switching on loads or input/output voltage.
  - Never touch exposed contacts (dangerous voltages).
  - Stay away from electrical contacts to avoid arc discharge.
  - Do not operate a mechanical installation improperly.

**NOTICE!**
Risk of damage to I/O modules!
Hot swapping is only allowed for I/O modules.
Processor modules and communication interface modules must not be removed or inserted during operation.

H = Hot swap

**Hot swap**
System requirements for hot swapping of I/O modules:
- Types of terminal units that support hot swapping of I/O modules have the appendix TU5xx-H.
- I/O modules as of index F0.

The following I/O bus masters support hot swapping of attached I/O modules:
- Communication interface modules Ci5xx as of index F0.
- Processor modules PM56xx-2ETH with firmware version as of V3.2.0.

**Hot swap is not supported by AC500-eCo V3 CPU!**
The index of the module is in the right corner of the label.

**NOTICE!**
Risk of damage to I/O modules!
Modules with index below F0 can be damaged when inserted or removed from the terminal unit in a powered system.

**NOTICE!**
Risk of damage to I/O modules!
Do not perform hot swapping if any I/O module with firmware version lower than 3.0.14 is part of the I/O configuration.
For min. required device index see table below.

<table>
<thead>
<tr>
<th>Device</th>
<th>Min. required device index for I/O module as of FW Version 3.0.14</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC522(-XC)</td>
<td>F0</td>
</tr>
<tr>
<td>AI523 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AI531</td>
<td>D4</td>
</tr>
<tr>
<td>AI531-XC</td>
<td>D2</td>
</tr>
<tr>
<td>AI561</td>
<td>B2</td>
</tr>
<tr>
<td>AI562</td>
<td>B2</td>
</tr>
<tr>
<td>AI563</td>
<td>B3</td>
</tr>
<tr>
<td>AO523 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AO561</td>
<td>B2</td>
</tr>
<tr>
<td>AX521 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AX522 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AX561</td>
<td>B2</td>
</tr>
<tr>
<td>CD522 (-XC)</td>
<td>D1</td>
</tr>
<tr>
<td>Device</td>
<td>Min. required device index for I/O module as of FW Version 3.0.14</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>DA501 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DA502 (-XC)</td>
<td>F0</td>
</tr>
<tr>
<td>DC522 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DC523 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DC532 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DC562</td>
<td>A2</td>
</tr>
<tr>
<td>DI524 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DI561</td>
<td>B2</td>
</tr>
<tr>
<td>DI562</td>
<td>B2</td>
</tr>
<tr>
<td>DI571</td>
<td>B2</td>
</tr>
<tr>
<td>DI572</td>
<td>A1</td>
</tr>
<tr>
<td>DO524 (-XC)</td>
<td>A3</td>
</tr>
<tr>
<td>DO526</td>
<td>A2</td>
</tr>
<tr>
<td>DO526-XC</td>
<td>A0</td>
</tr>
<tr>
<td>DO561</td>
<td>B2</td>
</tr>
<tr>
<td>DO562</td>
<td>A2</td>
</tr>
<tr>
<td>DO571</td>
<td>B3</td>
</tr>
<tr>
<td>DO572</td>
<td>B2</td>
</tr>
<tr>
<td>DO573</td>
<td>A1</td>
</tr>
<tr>
<td>DX522 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DX531</td>
<td>D2</td>
</tr>
<tr>
<td>DX561</td>
<td>B2</td>
</tr>
<tr>
<td>DX571</td>
<td>B3</td>
</tr>
<tr>
<td>FM562</td>
<td>A1</td>
</tr>
</tbody>
</table>
### Compatibility of hot swap

<table>
<thead>
<tr>
<th>I/O module on TU5xx-H connected to I/O bus master</th>
<th>PROFINET remote I/O</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI501-PNIO or CI502-PNIO</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Required version of I/O bus master</th>
<th>PROFINET remote I/O</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module index as of F0</td>
<td></td>
</tr>
<tr>
<td>Firmware as of V3.2.10</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Fieldbus master when used as remote I/O with AC500 V3</th>
<th>PROFINET remote I/O</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not supported</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>When used as remote I/O on third party controller (PLC or DCS)</th>
<th>PROFINET remote I/O</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note: alarms must be acknowledged by fieldbus master.</td>
<td></td>
</tr>
<tr>
<td>GSDML as of version</td>
<td></td>
</tr>
<tr>
<td>GSDML-V2.3-ABB-S500-CI501-PNIO-20180822.xml or</td>
<td></td>
</tr>
<tr>
<td>GSDML-V2.3-ABB-S500-CI502-PNIO-20180822.xml</td>
<td></td>
</tr>
<tr>
<td>needed for full scope of vendor specific diagnosis.</td>
<td></td>
</tr>
</tbody>
</table>
# Hot swap behavior

The following table describes the behavior in case of I/O attached to communication interface module for PROFINET, CI501-PNIO or CI502-PNIO.

<table>
<thead>
<tr>
<th>Hot swap behavior</th>
<th>PROFINET remote I/O with AC500 V3 CPU and CM579-PNIO controller</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PROFINET remote I/O with third party controller</td>
</tr>
<tr>
<td>Start-up behavior with missing or damaged I/O module on hot swap terminal unit TU5xx-H</td>
<td>Remote I/O station is not starting</td>
</tr>
<tr>
<td></td>
<td>As of device index F1 and Automation Builder Version 2.4.1 it is possible to configure the startup in case of missing modules on hot swap terminal units. If configured, the remote I/O station is starting up with missing or damaged I/O module, if the module is plugged later or replaced it will be automatically parameterized and I/O data will be exchanged.</td>
</tr>
<tr>
<td>Start-up behavior with wrong I/O module type on any terminal unit</td>
<td>Remote I/O station is not starting</td>
</tr>
<tr>
<td>Diagnosis of presence of hot swap terminal unit</td>
<td>Information is available either:</td>
</tr>
<tr>
<td></td>
<td>● via acyclic services</td>
</tr>
<tr>
<td></td>
<td>● as cyclic state information in the process image</td>
</tr>
<tr>
<td></td>
<td>As of device index F1 and Automation Builder Version 2.4.1 it is possible to configure a list of required hot swap terminal units. If a required hot swap terminal unit is missing (normal one plugged) this will not prevent a normal operation but a diagnosis message will be generated for the corresponding slot.</td>
</tr>
<tr>
<td>Diagnosis of hot swap capability of I/O module mounted on hot swap terminal unit</td>
<td>Diagnosis is transmitted as vendor specific PROFINET channel diagnosis:</td>
</tr>
<tr>
<td></td>
<td>● Diagnosis in case that a not hot-swapable I/O module is plugged on a hot swap terminal unit</td>
</tr>
<tr>
<td></td>
<td>● Diagnosis in case that in a mixed configuration with at least one hot swap terminal unit an I/O module, that must not be used in a hot swap configuration, is mounted on any terminal unit of the configuration</td>
</tr>
<tr>
<td></td>
<td>Production data and version index of the modules is accessible via acyclic services</td>
</tr>
</tbody>
</table>

Diagnosis while hot swap module is pulled or module (mounted on hot swap terminal unit) has stopped working | PROFINET channel diagnosis is generated together with standard "pull alarm" which must be acknowledged |
| Input state in process image of controller while module is pulled or module is not operational | Input = ZERO |
| In addition a standard PROFINET state information is transmitted saying "Inputs not valid" |
| Diagnosis after plugging of the I/O module on the hot swap terminal unit | PROFINET channel diagnosis is generated together with standard "plug alarm" which must be acknowledged |
System behavior

If an expansion module is removed or defective during run time, the input data of this module will be set to "0" and the module state will be set to the corresponding value. A diagnosis message will be created in that case (see hardware description of CI501 ➔ Chapter 5.2.6.7.2 "CI501-PNIO" on page 1203 / CI502 ➔ Chapter 5.2.6.7.3 "CI502-PNIO" on page 1244 for diagnosis messages).

In case a module is replaced, the new module will automatically be parameterized with the last parameters of the removed module (if single parameters were written to the previously removed module, this parameters will be ignored).

During pulling or plugging of a certain module, all other module will continue to operate with one limitation: The reaction time of modules connected to the right of the affected module will be bigger in that case (up to 50 ms).

If the bus failure detection is active for CI50x and failsafe is configured the following behavior applies if a module is removed and replugged during failsafe condition:

- Last value configured for output:
  - After a bus failure is detected, failsafe will be activated and the output will remain at its last value.
  - If the module is removed and plugged again, the output will remain off, and not be kept its last value, as the last value of the new module is "0" in that case.

- Substitute value configured for output:
  - After a bus failure is detected, failsafe will be activated and the output will be according to the configured substitute value.
  - If the module is removed and plugged again now, the output will be set according to the configured substitute value again.

- Substitute value for x seconds configured for output:
  - After a bus failure is detected, failsafe will be activated and the output will be according to the configured substitute value for the configured time.
  - If the module is removed and plugged again now, the output will be set according to the configured substitute value again, and the configured time starts again.

Mandatory rules for hot swapping

Mandatory rules for hot swapping:

- Between two pull and / or plug operations of I/O modules a pause of at least 1 second must be observed.
  - That means if a module is pulled or plugged there has to be at least a break of 1 second before the next module is pulled or plugged.
- At boot up of CI50x all configured expansion modules have to be physically available.
  - Start up with missing modules is not supported.
- In the application program it is possible to detect if a hot swap terminal unit is mounted in a specific position on the I/O bus. The information is available in the process data area or can be read out via acyclic read. These can be accessed when the version of the communication interface module supports hot swap.
  - This has to be checked by application:
    - Best way for checking if a hot swap terminal unit is available or not, is checking the corresponding information inside the process image.
6.8.4.3 PROFIBUS communication interface module
6.8.4.3.1 Hot swap

Introduction

With hot swap for AC500 and S500 it is possible to exchange I/O modules (with same type) during runtime.

Preconditions for using hot swap

Hot swap

**WARNING!**
Risk of explosion or fire in hazardous environments during hot swapping!
Hot swap must not be performed in flammable environments to avoid life-threatening injury and property damage resulting from fire or explosion.

**WARNING!**
Electric shock due to negligent behavior during hot swapping!
To avoid electric shock
- make sure the following conditions apply:
  - Digital outputs are not under load.
  - Input/output voltages above safety extra low voltage/protective extra low voltage (SELV/PELV) are switched off.
  - Modules are fully interlocked with the terminal unit with both snap-fits engaged before switching on loads or input/output voltage.
  - Never touch exposed contacts (dangerous voltages).
  - Stay away from electrical contacts to avoid arc discharge.
  - Do not operate a mechanical installation improperly.

**NOTICE!**
Risk of damage to I/O modules!
Hot swapping is only allowed for I/O modules.
Processor modules and communication interface modules must not be removed or inserted during operation.

H = Hot swap

**Hot swap**
System requirements for hot swapping of I/O modules:
- Types of terminal units that support hot swapping of I/O modules have the appendix TUSxx-H.
- I/O modules as of index F0.

The following I/O bus masters support hot swapping of attached I/O modules:
- Communication interface modules CI5xx as of index F0.
- Processor modules PM56xx-2ETH with firmware version as of V3.2.0.

**Hot swap is not supported by AC500-eCo V3 CPU!**
NOTICE!
Risk of damage to I/O modules!
Modules with index below F0 can be damaged when inserted or removed from the terminal unit in a powered system.

NOTICE!
Risk of damage to I/O modules!
Do not perform hot swapping if any I/O module with firmware version lower than 3.0.14 is part of the I/O configuration.
For min. required device index see table below.

<table>
<thead>
<tr>
<th>Device</th>
<th>Min. required device index for I/O module as of FW Version 3.0.14</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC522(-XC)</td>
<td>F0</td>
</tr>
<tr>
<td>AI523 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AI531</td>
<td>D4</td>
</tr>
<tr>
<td>AI531-XC</td>
<td>D2</td>
</tr>
<tr>
<td>AI561</td>
<td>B2</td>
</tr>
<tr>
<td>AI562</td>
<td>B2</td>
</tr>
<tr>
<td>AI563</td>
<td>B3</td>
</tr>
<tr>
<td>AO523 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AO561</td>
<td>B2</td>
</tr>
<tr>
<td>AX521 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AX522 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>AX561</td>
<td>B2</td>
</tr>
<tr>
<td>CD522 (-XC)</td>
<td>D1</td>
</tr>
<tr>
<td>Device</td>
<td>Min. required device index for I/O module as of FW Version 3.0.14</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>DA501 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DA502 (-XC)</td>
<td>F0</td>
</tr>
<tr>
<td>DC522 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DC523 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DC532 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DC562</td>
<td>A2</td>
</tr>
<tr>
<td>DI524 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DI561</td>
<td>B2</td>
</tr>
<tr>
<td>DI562</td>
<td>B2</td>
</tr>
<tr>
<td>DI571</td>
<td>B2</td>
</tr>
<tr>
<td>DI572</td>
<td>A1</td>
</tr>
<tr>
<td>DO524 (-XC)</td>
<td>A3</td>
</tr>
<tr>
<td>DO526</td>
<td>A2</td>
</tr>
<tr>
<td>DO526-XC</td>
<td>A0</td>
</tr>
<tr>
<td>DO561</td>
<td>B2</td>
</tr>
<tr>
<td>DO562</td>
<td>A2</td>
</tr>
<tr>
<td>DO571</td>
<td>B3</td>
</tr>
<tr>
<td>DO572</td>
<td>B2</td>
</tr>
<tr>
<td>DO573</td>
<td>A1</td>
</tr>
<tr>
<td>DX522 (-XC)</td>
<td>D2</td>
</tr>
<tr>
<td>DX531</td>
<td>D2</td>
</tr>
<tr>
<td>DX561</td>
<td>B2</td>
</tr>
<tr>
<td>DX571</td>
<td>B3</td>
</tr>
<tr>
<td>FM562</td>
<td>A1</td>
</tr>
</tbody>
</table>

CI54x-DP, index >= F1

To support the hot swap feature for PROFIBUS below V3 PLCs, new slaves are available for the CI54x-DP - CI541-DP, index >= F1 and the CI542-DP, index >= F1.

To be able to configure and to use the hot swap functionalities for the S500 modules below PROFIBUS of V3 PLCs, these slaves have to be configured. A double-click on a device object in the device tree opens the associated device editor. The editor provides generic and device-specific tabs for the device configuration.

Copy and paste of I/O modules between the CI54x-DP and the CI54x-DP, index >= F1 is possible.

Drag and drop between the CI54x-DP and the CI54x-DP, index >= F1 is not possible.

*If the I/O modules must be moved from one CI54x-DP to the other one, cut and past must be executed. Drag and drop is not possible.*
6.9 Diagnosis and debugging

6.9.1 The diagnosis system

6.9.1.1 General

The diagnosis system enables uniform diagnosis of the CPU and its local interfaces, of the I/O bus with the connected S500 I/O devices and of the fieldbuses connected via communication modules, considering the special features of the various fieldbuses. The safety CPU is also integrated into the diagnosis system.

Diagnosis data of the devices can be accessed by:
- CPU display
- Automation Builder
- IEC application

To forward the information to notify them by, e.g., webserver or OPC UA server, the data retrieved in IEC application can be stored in variables.

![Overview of the diagnosis system](image)

**Fig. 364: Overview of the diagnosis system**

All diagnosis data is assigned to a device. System diagnosis (e.g., battery low) is coming from the CPU device or one of the child objects (e.g., watchdog diagnosis of a task object).

Diagnosis is available for devices with representation in the Automation Builder device tree.

Diagnosis messages include the severity of an error. Error severity can be used for defining system behavior, e.g., activating the error LED or stop the PLC. See Chapter 6.9.1.6.1 "Error severity" on page 4638.

Details on how to integrate and use function blocks to receive diagnosis messages from the CPU and fieldbus devices are given in the application examples:
- AC500 V3 diagnosis in IEC application
- AC500 V3 diagnosis

**Types of diagnosis messages**
- An event describes the current state of the device. It does not have to be acknowledged.
- An alarm describes that at a certain point of time, there was a diagnosis message. It does not say anything about the current state of the device. Alarms must be acknowledged by the user. After acknowledging, the alarm disappears for all consumers.
Every diagnosis message has a come time.

Device state

With reference to diagnosis, there are different device states:

- Device without events and without unacknowledged alarms.
- Device with events or unacknowledged alarms.
- Device does not respond and is not available for online connection.

Diagnosis descriptions

Diagnosis messages are always available for all consumers.

- ABB AC500 V3 devices:
  - Events and unacknowledged alarms.
  - Every diagnosis message with come time, location, error number and text.
- 3rd party devices:
  - Events and unacknowledged alarms.
  - Every diagnosis message with come time, location and error number.
  - Clear text information if available either from a standard or from the device description.
  - If available: Extended diagnosis: Additional data coming from the device for manual analysis.

Extended diagnosis

Some devices are able to provide extended diagnosis. This additional device-dependant diagnosis will only be collected on request and will be device type specific (e.g. bus scan request on PROFINET I/O controller). Main intention is to cover commissioning use cases, when very specific information is required that typically cannot be stored in error numbers in a reasonable way.

6.9.1.2 Access to diagnosis data

Access to device state

- Error LED on CPU ⇐ Chapter 6.9.1.3 “Diagnosis in CPU display” on page 4607
- Automation Builder device tree ⇐ Chapter 6.9.1.4 “Diagnosis in Automation Builder” on page 4611
- IEC application via device name ⇐ Chapter 6.9.1.5.4 “Device diagnosis” on page 4628
- IEC application via list of all available diagnosis ⇐ Chapter 6.9.1.5.3 “System diagnosis” on page 4619
- External access via global IEC variables Fig. 364

Access to diagnosis descriptions

- CPU display ⇐ Chapter 6.9.1.3.2 “Diagnosis descriptions” on page 4607
  (for CPU, I/O bus and connected S500 I/O modules, not for communication modules and field buses)
- Automation Builder via “All messages” window ⇐ Chapter 6.9.1.4.2 “Diagnosis descriptions” on page 4611:
  - Support for (bulk) acknowledgement of alarm
  - Access to extended diagnosis data of 3rd party devices devices (if available), without any interpretation
- IEC application via a list of all current diagnosis either of a device (device object from the Automation Builder tree) ⇐ Chapter 6.9.1.5.4 “Device diagnosis” on page 4628 or of the complete PLC ⇐ Chapter 6.9.1.5.3 “System diagnosis” on page 4619:
  - Navigation chronologically in both directions (starting either from the oldest or newest diagnosis)
  - Access to the diagnosis numerically (evaluation by IEC application), textual (use on HMI) or to extended diagnosis data of 3rd party devices (if available)
  - Acknowledgement of alarms
- External access via global IEC variables by using the IEC application features for getting all relevant information
Extended diagnosis data will be displayed in Automation Builder via “All messages” window. The data is displayed as it is provided from the device without any interpretation. Refer to e.g., the manual of the device to get information about the extended diagnosis data.

6.9.1.3 Diagnosis in CPU display

6.9.1.3.1 Device state

If there is at least one active diagnosis message, the error LED ERR is on.

The behavior of the error LED depends on the setting of CPU parameter “Error LED” Table on page 1474.

Diagnosis of AC500-eCo CPUs can only be shown by LED ERR at CPU. No display is available.

General information on the LEDs, the display and the function keys can be found in chapter ‘Displays, LEDs and function keys on the front panel’ Chapter 6.8.2.5 “Display, LEDs and function keys on the front panel” on page 4452.

6.9.1.3.2 Diagnosis descriptions

Chapter 6.9.1.3.3 “DIAG - reading out diagnosis messages” on page 4609.

<table>
<thead>
<tr>
<th>Entry</th>
<th>Length [byte]</th>
<th>Values</th>
<th>Description</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error severity</td>
<td>1</td>
<td>0 .. 255</td>
<td>Used values: 1, 2, 3, 4, 11 Chapter 6.9.1.6.1 “Error severity” on page 4638</td>
<td>Ex abc</td>
</tr>
<tr>
<td>Hardware ID (HwId)</td>
<td>1</td>
<td>0 .. 255</td>
<td>Location of diagnosis, e.g., subdevice, as three-letter word Further information on page 4608</td>
<td>Ex abc</td>
</tr>
<tr>
<td>Error code</td>
<td>2</td>
<td>1 .. 6553</td>
<td>Error number (low word)</td>
<td>12345</td>
</tr>
<tr>
<td>SubSystemInfo byte 1</td>
<td>1</td>
<td>0 .. 255</td>
<td>Depends on hardware ID</td>
<td>d1 123</td>
</tr>
<tr>
<td>SubSystemInfo byte 2</td>
<td>1</td>
<td>0 .. 255</td>
<td>Depends on hardware ID</td>
<td>d2 123</td>
</tr>
<tr>
<td>SubSystemInfo byte 3</td>
<td>1</td>
<td>0 .. 255</td>
<td>Depends on hardware ID</td>
<td>d3 123</td>
</tr>
<tr>
<td>SubSystemInfo byte 4</td>
<td>1</td>
<td>0 .. 255</td>
<td>Depends on hardware ID</td>
<td>d4 123</td>
</tr>
</tbody>
</table>

The display of the processor module does not show any communication modules or fieldbus diagnosis. To view these diagnosis messages use Automation Builder or IEC application.

Chapter 6.9.1.4 “Diagnosis in Automation Builder” on page 4611

Chapter 6.9.1.5 “Diagnosis in IEC application” on page 4615

This is valid for:
- all external communication modules including safety processor module
- CANopen on onboard CAN interface
- fieldbuses on Ethernet interfaces ETH1/ETH2 like PROFINET IO controller, EtherCAT master, etc.
The location of a diagnosis is shown in the CPU display with 3 characters.

<table>
<thead>
<tr>
<th>Display</th>
<th>Location of diagnosis</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="CPU display" /></td>
<td>CPU</td>
</tr>
<tr>
<td><img src="image2" alt="CPU RAM display" /></td>
<td>CPU RAM</td>
</tr>
<tr>
<td><img src="image3" alt="CPU flash display" /></td>
<td>CPU flash</td>
</tr>
<tr>
<td><img src="image4" alt="CPU flashdisk display" /></td>
<td>CPU flashdisk</td>
</tr>
<tr>
<td><img src="image5" alt="CPU memory card display" /></td>
<td>CPU memory card</td>
</tr>
<tr>
<td><img src="image6" alt="CPU display" /></td>
<td>CPU display</td>
</tr>
<tr>
<td><img src="image7" alt="CPU battery display" /></td>
<td>CPU battery</td>
</tr>
<tr>
<td><img src="image8" alt="Real-time clock (RTC) display" /></td>
<td>Real-time clock (RTC)</td>
</tr>
<tr>
<td><img src="image9" alt="Floating point unit (FPU) display" /></td>
<td>Floating point unit (FPU)</td>
</tr>
<tr>
<td><img src="image10" alt="Power supply display" /></td>
<td>Power supply</td>
</tr>
<tr>
<td><img src="image11" alt="Communication module 1 display" /></td>
<td>Communication module 1</td>
</tr>
<tr>
<td><img src="image12" alt="Communication module 2 display" /></td>
<td>Communication module 2</td>
</tr>
<tr>
<td><img src="image13" alt="Communication module 3 display" /></td>
<td>Communication module 3</td>
</tr>
<tr>
<td>Display</td>
<td>Location of diagnosis</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------------</td>
</tr>
<tr>
<td><img src="image1" alt="Display 1" /></td>
<td>Communication module 4</td>
</tr>
<tr>
<td><img src="image2" alt="Display 2" /></td>
<td>Communication module 5</td>
</tr>
<tr>
<td><img src="image3" alt="Display 3" /></td>
<td>Communication module 6</td>
</tr>
<tr>
<td><img src="image4" alt="Display 4" /></td>
<td>COM1 serial interface 1</td>
</tr>
<tr>
<td><img src="image5" alt="Display 5" /></td>
<td>COM2 reserved for serial interface 2</td>
</tr>
<tr>
<td><img src="image6" alt="Display 6" /></td>
<td>CAN interface</td>
</tr>
<tr>
<td><img src="image7" alt="Display 7" /></td>
<td>I/O bus</td>
</tr>
<tr>
<td><img src="image8" alt="Display 8" /></td>
<td>Ethernet ETH1</td>
</tr>
<tr>
<td><img src="image9" alt="Display 9" /></td>
<td>Ethernet ETH2</td>
</tr>
</tbody>
</table>

### 6.9.1.3.3 DIAG - reading out diagnosis messages

**Table 853: Example - no diagnosis message in state list**

<table>
<thead>
<tr>
<th>State</th>
<th>Display</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>The processor module is in RUN/STOP mode.</td>
<td>DIAG</td>
</tr>
<tr>
<td></td>
<td>State 1 is displayed.</td>
<td>-</td>
</tr>
<tr>
<td>1</td>
<td>No action</td>
<td>No action</td>
</tr>
</tbody>
</table>
Table 854: Example - diagnosis messages in state list

<table>
<thead>
<tr>
<th>State</th>
<th>Display</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>0</strong></td>
<td>The processor module is in RUN/STOP mode.</td>
<td><strong>DIAG</strong></td>
</tr>
<tr>
<td></td>
<td>State 1 is displayed.</td>
<td>-</td>
</tr>
<tr>
<td><strong>1</strong></td>
<td>Number of diagnosis messages; here 4</td>
<td><strong>DIAG</strong></td>
</tr>
<tr>
<td></td>
<td>Go to first/next diagnosis message in state list (e.g., state 2).</td>
<td>Go to last/previous diagnosis message in state list.</td>
</tr>
<tr>
<td><strong>2</strong></td>
<td>Diagnosis message example: Error battery empty or missing. Toggling between state 2 and 3.</td>
<td><strong>DIAG</strong></td>
</tr>
<tr>
<td></td>
<td>Selects displayed diagnosis message and shows details.</td>
<td>Go to first/next diagnosis message in state list.</td>
</tr>
<tr>
<td><strong>3</strong></td>
<td>Error ID example Toggling between state 2 and 3</td>
<td><strong>DIAG</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>State 2 is displayed.</td>
</tr>
</tbody>
</table>

Table 855: Example - error battery empty or missing

<table>
<thead>
<tr>
<th>State</th>
<th>Display</th>
<th>Result on pressing one of the function keys</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>0</strong></td>
<td>E4 = error severity 4 bAt = subdevice battery Toggling between state 0 and 1</td>
<td><strong>DIAG</strong></td>
</tr>
<tr>
<td></td>
<td>State 2 is displayed.</td>
<td>State 2 is displayed.</td>
</tr>
<tr>
<td><strong>1</strong></td>
<td>Error ID example Toggling between state 0 and 1.</td>
<td><strong>DIAG</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>State</td>
<td>Display</td>
<td>Result on pressing one of the function keys</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>2</td>
<td>![Image]</td>
<td>State 3 is displayed. State 0 is displayed. State 0 is displayed. State 0 is displayed. Displays state 0. Return to diagnosis state list.</td>
</tr>
<tr>
<td>3</td>
<td>![Image]</td>
<td>State 4 is displayed. State 2 is displayed. State 0 is displayed. State 0 is displayed. Return to diagnosis state list.</td>
</tr>
<tr>
<td>4</td>
<td>![Image]</td>
<td>State 5 is displayed. State 3 is displayed. State 0 is displayed. State 0 is displayed. Return to diagnosis state list.</td>
</tr>
<tr>
<td>5</td>
<td>![Image]</td>
<td>State 6 is displayed. State 4 is displayed. State 0 is displayed. State 0 is displayed. Return to diagnosis state list.</td>
</tr>
<tr>
<td>6</td>
<td>![Image]</td>
<td>State 1 is displayed. State 5 is displayed. State 0 is displayed. State 0 is displayed. Return to diagnosis state list.</td>
</tr>
</tbody>
</table>

6.9.1.4 Diagnosis in Automation Builder

6.9.1.4.1 Device state

In Automation Builder, colored icons next to the devices’ nodes in the device tree indicate the device state of each single device. Chapter 6.9.2.3 “Project tree in online mode” on page 4641.

6.9.1.4.2 Diagnosis descriptions

Displayed text For output of diagnosis messages in textual format Automation Builder and IEC application use text lists. Both application use the same text lists. The text lists are part of the device description. When inserting a new device in device tree of project, the corresponding text list is loaded. This text lists are part of PLC program and will be downloaded into the PLC.
It is necessary to include a visualization, even if visualization will not be used. 

Chapter 6.4.5 “CODESYS Visualization” on page 2852

Without visualization the text lists will not be included.

The text lists are generated automatically. We recommend that you do not change them manually because the changes can be overwritten automatically and without prompting.

Displayed text for 3rd party devices

The text lists for 3rd party devices are created during reading of the device description sheets, e.g., GSDML files for PROFINET I/O devices.

The name of a text list for a PROFINET I/O device is: Diag_PNIO_Vendor ID_Device ID

Example

CI501-PNIO: Diag_PNIO_26_22
26 = vendor ID ABB, 22 = device ID CI501-PNIO

The text list for the AC500 PROFINET I/O modules contains all text needed for PROFINET standard diagnosis and AC500 process alarm handling.

Which texts are used, depends on parameter “Selection of diagnosis method”: Double-click on a PROFINET I/O module and open tab “General”. 
6.9.1.3 System diagnosis

In Automation Builder the system diagnosis is activated by default and can be deactivated in: “Tools ➔ Options ➔ Diagnosis ➔ Enable subtree diagnosis”

6.9.1.4.4 Device diagnosis

Each node in the device tree has a diagnosis view, which displays the diagnosis messages for this device only.

The message consists of:

- Type % Chapter 6.9.1.4.5 “Diagnosis history” on page 4614
- Timestamp in date and time YYYY-MM-DD hh:mm:ss.ms
- Error severity
- Error code
- Diagnosis description
- Additional data

To view the diagnosis message:

1. Double-click on a device.
2. Select the tab “Diagnosis”.

**Example**

Battery empty or missing.

<table>
<thead>
<tr>
<th>Type</th>
<th>Device</th>
<th>Timestamp</th>
<th>Severity</th>
<th>Error Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>PLC_AC500_V3</td>
<td>1970-01-01 12:00:13.916</td>
<td>4</td>
<td>8</td>
<td>Battery, Device, Empty or missing</td>
</tr>
</tbody>
</table>

Wrong module configured on I/O bus.

<table>
<thead>
<tr>
<th>Type</th>
<th>Device</th>
<th>Timestamp</th>
<th>Severity</th>
<th>Error Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>D1524</td>
<td>1970-01-01 12:16:30.633</td>
<td>11</td>
<td>16190</td>
<td>Module L, Type of present module does not match configuration</td>
</tr>
</tbody>
</table>

Device diagnosis is disabled by default.

To enable/disable device diagnosis:

1. Double-click on the PLC.
2. Select the tab “PLC Settings”.
3. Under "Additional Settings" enable/disable "Diagnosis for devices".

⇒ When the device diagnosis is disabled, this symbol  will be displayed in the device tree and no diagnosis messages will be shown.

### 6.9.1.4.5 Diagnosis history

The 'Diagnosis History' view provides an overview of the current and past system events that resulted in a diagnosis event.

- Incoming diagnosis events are indicated with +. After the problem that causes a diagnosis event has been resolved, this diagnosis event is indicated automatically with −.
- Alarm events, e.g. PROFINET alarm are indicated with ⚠. In the 'Diagnosis' view the user can acknowledge an alarm. Note that an alarm event can be acknowledged though the problem that causes the alarm still persists. The acknowledge action is indicated with ✔ on the concerning event entry. If the icon changes to ✔, the acknowledge action has been completed by the PLC.

The following buttons are available in the 'Diagnosis History' view:

- **Start/Stop refresh:** Enables or disables the automatic refresh mode. In refresh mode new diagnosis events will be displayed automatically. Only the last 100 entries are shown in this view, the latest events on top of the list.
- **Get next entries:** Adds the previous (older) 100 diagnosis events at the bottom of the list.
- **Export complete history:** Creates a csv file with all events from the diagnosis history (not only the visible ones).
6.9.1.5 Diagnosis in IEC application

6.9.1.5.1 General

There are two possibilities for accessing the diagnosis messages in the IEC application:

- System diagnosis: Access to diagnosis messages of the whole PLC
- Device diagnosis: Access to the diagnosis messages of a device

For both possibilities common data types (structures and enumerations) are defined in the library AC500_DiagTypes. Chapter 6.9.1.5.2 “Data types in library AC500_DiagTypes” on page 4616. The library is automatically included in PLC project.

Details on how to integrate and use function blocks to receive diagnosis messages from the CPU and fieldbus devices are given in the application examples:

- AC500 V3 diagnosis in IEC application
- AC500 V3 diagnosis

Displayed text

For output of diagnosis messages in textual format Automation Builder and IEC application use text lists. Both application use the same text lists. The text lists are part of the device description. When inserting a new device in device tree of project, the corresponding text list is loaded. This text lists are part of PLC program and will be downloaded into the PLC.

It is necessary to include a visualization, even if visualization will not be used. Chapter 6.4.5 “CODESYS Visualization” on page 2852

Without visualization the text lists will not be included.

The text lists are generated automatically. We recommend that you do not change them manually because the changes can be overwritten automatically and without prompting.
The text lists for 3rd party devices are created during reading of the device description sheets, e.g., GSDML files for PROFINET I/O devices.

The name of a text list for a PROFINET I/O device is: Diag_PNIO_{Vendor ID}_Device ID

Example

CI501-PNIO: Diag_PNIO_26_22
26 = vendor ID ABB, 22 = device ID CI501-PNIO

The text list for the AC500 PROFINET I/O modules contains all text needed for PROFINET standard diagnosis and AC500 process alarm handling.

Which texts are used, depends on parameter “Selection of diagnosis method”: Double-click on a PROFINET I/O module and open tab “General”.

6.9.1.5.2 Data types in library AC500_DiagTypes

General

All data types regarding diagnosis are defined in the library AC500_DiagTypes.

Structure DIAG_VAL_TYPE

This data type specifies the format of all kinds of diagnosis messages in numeric format. It consists of one element for each detail of a diagnosis message.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Initial</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>diTimestamp</td>
<td>DT</td>
<td>DATE_AND_TIME#1970-1-1-0:0</td>
<td>RTC time of eDiagEvent_Occured</td>
</tr>
<tr>
<td>uiMs</td>
<td>UINT</td>
<td>0</td>
<td>Milliseconds of event</td>
</tr>
<tr>
<td>eClass</td>
<td>teClass</td>
<td>teClass.eDiagClass_4_Warning</td>
<td>Error severity of diagnosis message</td>
</tr>
<tr>
<td>szDevice</td>
<td>STRING(80)</td>
<td>&quot;&quot;</td>
<td>Name of device, max. 80 characters</td>
</tr>
<tr>
<td>eHwInterfaceId</td>
<td>teHwId</td>
<td>teHwId_CPU</td>
<td>Identifier of hardware interface</td>
</tr>
<tr>
<td>dwSubSysteminfo</td>
<td>DWORD</td>
<td>0</td>
<td>Any number describing details or location</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>within device, device-specific</td>
</tr>
<tr>
<td>dwAdditional</td>
<td>DWORD</td>
<td>0</td>
<td>Additional number describing details or</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>location within device, optional, device-</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>specific</td>
</tr>
<tr>
<td>dwErrorCode</td>
<td>DWORD</td>
<td>0</td>
<td>Error code</td>
</tr>
<tr>
<td>wSizeExtDiag</td>
<td>DWORD</td>
<td>0</td>
<td>Number of bytes of extended diagnosis data</td>
</tr>
</tbody>
</table>
Structure DIAG_TXT_TYPE

This data type specifies the format of all kinds of diagnosis messages in textual format. It consists of a single string containing all details of a diagnosis message.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Initial</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>szDiag</td>
<td>STRING(512)</td>
<td>&quot;&quot;</td>
<td>Diagnosis message as text, max. 512 characters</td>
</tr>
</tbody>
</table>

The text consists of the following data, separated by semicolon:
- Timestamp in Date_And_Time (DT) format of eDiagEvent_Occurred and added milliseconds
- Error severity
- Device name (max. 80 characters) as defined in Automation Builder device tree
- The error text itself, composed of the interpretation of dwSubSysteminfo and dwAdditional and the error text plus remedy (if available) from Automation Builder text list according dwErrorCode. Displayed as: error text -> remedy.

Example

Battery empty or missing.

Enumeration ERROR_ID

Type of the return values of all methods and functions to request information on diagnosis.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Comment</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>NO_ERROR</td>
<td>16#0</td>
<td>Execution successfully completed</td>
<td></td>
</tr>
<tr>
<td>ERR_PARAMETER</td>
<td>16#1</td>
<td>Invalid parameter value in function call</td>
<td>Correct parameter</td>
</tr>
<tr>
<td>ERR_NO_SINK</td>
<td>16#2</td>
<td>Failed to register as sink</td>
<td></td>
</tr>
<tr>
<td>ERR_NO_TEXT_LIST</td>
<td>16#3</td>
<td>Failed to get a device text list</td>
<td>Check text lists</td>
</tr>
<tr>
<td>ERR_NO_TEXT_CONTENT</td>
<td>16#4</td>
<td>Failed to get at least one content from text list</td>
<td></td>
</tr>
<tr>
<td>ERR_COMPETING</td>
<td>16#5</td>
<td>Failed due to competing access of other method</td>
<td>Try again</td>
</tr>
<tr>
<td>ERR_ASYNC</td>
<td>16#6</td>
<td>Failed to create async process</td>
<td></td>
</tr>
<tr>
<td>ERR_INTERNAL</td>
<td>16#7</td>
<td>Any internal error during execution</td>
<td></td>
</tr>
<tr>
<td>BUSY</td>
<td>16#FFF</td>
<td>Busy</td>
<td></td>
</tr>
<tr>
<td>NO_ERROR_NO_DATA</td>
<td>16#FFFF</td>
<td>Execution successfully completed, no more diagnosis messages</td>
<td>Call again to get final result</td>
</tr>
</tbody>
</table>

All values except "BUSY" are final results. In case "NO_ERROR" is returned, the requested action has been successfully performed. "NO_ERROR_NO_DATA" also indicates a successful completion. The only difference to "NO_ERROR" is the fact, that there is one (more) data to be provided. All other return values (except "BUSY") are final error states. In case a method or function returns "BUSY", it has to be called again in the following cycles until it returns a final result.
**Enumeration teClass**

Specifies the error severity of diagnosis messages. See Chapter 6.9.1.6.1 “Error severity” on page 4638.

<table>
<thead>
<tr>
<th>Name</th>
<th>Error severity</th>
</tr>
</thead>
<tbody>
<tr>
<td>eDiagClass_2_SeriousError</td>
<td>2</td>
</tr>
<tr>
<td>eDiagClass_3_Error</td>
<td>3</td>
</tr>
<tr>
<td>eDiagClass_4_Warning</td>
<td>4</td>
</tr>
<tr>
<td>eDiagClass_Parameter</td>
<td>11</td>
</tr>
</tbody>
</table>

**Enumeration teEvent**

The enumeration teEvent specifies the severity of diagnosis messages.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Initial</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>eDiagEvent_Occurred</td>
<td>DINT</td>
<td>1</td>
<td>Error occurred, remains &quot;active&quot; until eDiagEvent_Disappeared</td>
</tr>
<tr>
<td>eDiagEvent_Disappeared</td>
<td>DINT</td>
<td>2</td>
<td>Error disappeared, became &quot;active&quot; due to eDiagEvent_Occurred earlier on</td>
</tr>
<tr>
<td>eDiagEvent_Received</td>
<td>DINT</td>
<td>4</td>
<td>Received a diagnosis message which cannot be analyzed in detail, cannot disappear, needs to be acknowledged</td>
</tr>
<tr>
<td>eDiagEvent_Acknowledged</td>
<td>DINT</td>
<td>8</td>
<td>Acknowledge a diagnosis message which has been received by eDiagEvent_Received, removes diagnosis message from diagnosis system although error may still be present</td>
</tr>
</tbody>
</table>

**Enumeration teHwId**

The enumeration teHwId specifies the hardware component as location of a diagnosis message.

<table>
<thead>
<tr>
<th>Name</th>
<th>Initial</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>eDiagHwId_CPU</td>
<td>0</td>
<td>Any diagnosis message regarding CPU itself, like &quot;battery&quot;, &quot;sd card&quot;, etc.</td>
</tr>
<tr>
<td>eDiagHwId_Coupler1</td>
<td>1</td>
<td>Any diagnosis message regarding communication module at slot 1. May be indicated by any corresponding communication module driver (instance) or a protocol driver (instance)</td>
</tr>
<tr>
<td>eDiagHwId_Coupler2</td>
<td>2</td>
<td>Any diagnosis message regarding communication module at slot 2. May be indicated by any corresponding communication module driver (instance) or a protocol driver (instance)</td>
</tr>
<tr>
<td>eDiagHwId_Coupler3</td>
<td>3</td>
<td>Any diagnosis message regarding communication module at slot 3. May be indicated by any corresponding communication module driver (instance) or a protocol driver (instance)</td>
</tr>
<tr>
<td>eDiagHwId_Coupler4</td>
<td>4</td>
<td>Any diagnosis message regarding communication module at slot 4. May be indicated by any corresponding communication module driver (instance) or a protocol driver (instance)</td>
</tr>
<tr>
<td>Name</td>
<td>Initial</td>
<td>Comment</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>eDiagHwId_Coupler5</td>
<td>5</td>
<td>Any diagnosis message regarding communication module at slot 5. May be indicated by any corresponding communication module driver (instance) or a protocol driver (instance)</td>
</tr>
<tr>
<td>eDiagHwId_Coupler6</td>
<td>6</td>
<td>Any diagnosis message regarding communication module at slot 6. May be indicated by any corresponding communication module driver (instance) or a protocol driver (instance)</td>
</tr>
<tr>
<td>eDiagHwId_COM1</td>
<td>7</td>
<td>Any diagnosis message regarding COM1. May be indicated by any corresponding interface driver (instance) or a protocol driver (instance)</td>
</tr>
<tr>
<td>eDiagHwId_COM2</td>
<td>8</td>
<td>Any diagnosis message regarding COM2. May be indicated by any corresponding interface driver (instance) or a protocol driver (instance)</td>
</tr>
<tr>
<td>eDiagHwId_CAN</td>
<td>9</td>
<td>Any diagnosis message regarding CAN interface. May be indicated by any corresponding interface driver (instance) or a protocol driver (instance)</td>
</tr>
<tr>
<td>eDiagHwId_OnboardIO</td>
<td>10</td>
<td>Onboard I/O, AC500-eCo only</td>
</tr>
<tr>
<td>eDiagHwId_OptionBoard1</td>
<td>11</td>
<td>Option board 1, AC500-eCo only</td>
</tr>
<tr>
<td>eDiagHwId_OptionBoard2</td>
<td>12</td>
<td>Option board 2, AC500-eCo only</td>
</tr>
<tr>
<td>eDiagHwId_OptionBoard3</td>
<td>13</td>
<td>Option board 3, AC500-eCo only</td>
</tr>
<tr>
<td>eDiagHwId_IOBus</td>
<td>14</td>
<td>I/O bus</td>
</tr>
<tr>
<td>eDiagHwId_ETH1</td>
<td>15</td>
<td>Any diagnosis message regarding ETH1. May be indicated by any corresponding interface driver (instance) or a protocol driver (instance)</td>
</tr>
<tr>
<td>eDiagHwId_ETH2</td>
<td>16</td>
<td>Any diagnosis message regarding ETH2. May be indicated by any corresponding interface driver (instance) or a protocol driver (instance)</td>
</tr>
</tbody>
</table>

The hardware ID HwId is only used for diagnosis output in CPU display to identify the location of a diagnosis message. 

6.9.1.3 System diagnosis

**Introduction**

Library AC500_Diag provides several methods and functions to access the diagnosis messages on all devices in the PLC application. It contains also a function to convert numeric diagnosis into a textual format.

The variables and their assigned values can be referred to within the IEC application as well as they can be used to transfer diagnosis messages to any visualization client.

**Device state**

**General**

The library contains a single function block named "Diag", providing several methods to process the device state.

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NumTotal</td>
<td>Provides the total number of currently active diagnosis messages</td>
</tr>
<tr>
<td>NumClass</td>
<td>Provides the number of currently active diagnosis messages related to the error severity</td>
</tr>
</tbody>
</table>
Method NumTotal

This method provides the total number of currently active diagnosis messages (including parameter errors, etc.).

<table>
<thead>
<tr>
<th>Scope</th>
<th>Name</th>
<th>Type</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return</td>
<td>NumTotal</td>
<td>DWORD</td>
<td>Number of diagnosis messages</td>
</tr>
</tbody>
</table>

Example

```var
VAR
    fbDiag : AC500_Diag.Diag; (* instance of FB Diag *)
    dwNumTotal : DWORD;
END_VAR
```
```
dwNumTotal := fbDiag.NumTotal();
```

Method NumClass

This method provides the number of currently active diagnosis messages related to the error severity.

<table>
<thead>
<tr>
<th>Scope</th>
<th>Name</th>
<th>Type</th>
<th>Initial</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return</td>
<td>NumClass</td>
<td>DWORD</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input</td>
<td>DataInVal</td>
<td>AC500_DiagTypes.teClass</td>
<td>eClass.eDiagClass_2_SeriousError</td>
<td>Error severity of diagnosis message</td>
</tr>
</tbody>
</table>

Example

```var
VAR
    fbDiag : AC500_Diag.Diag;
    eDiagClass_4: AC500_DiagTypes.teClass := AC500_DiagTypes.teClass.eDiagClass_4_Warning; (* 4 *)
    eDiagClass_3: AC500_DiagTypes.teClass := AC500_DiagTypes.teClass.eDiagClass_3_Error; (* 3 *)
    eDiagClass_11: AC500_DiagTypes.teClass := AC500_DiagTypes.teClass.eDiagClass_Parameter; (* 11 *)
    dwNumClass_4 : DWORD;
    dwNumClass_3 : DWORD;
    dwNumClass_11 : DWORD;
    dwNumClass_4 := fbDiag.NumClass(eDiagClass := eDiagClass_4);
    dwNumClass_3 := fbDiag.NumClass(eDiagClass := eDiagClass_3);
    dwNumClass_11 := fbDiag.NumClass(eDiagClass := eDiagClass_11);
END_VAR
```
```
dwNumClass_4 := fbDiag.NumClass(eDiagClass := eDiagClass_4);
dwNumClass_3 := fbDiag.NumClass(eDiagClass := eDiagClass_3);
dwNumClass_11 := fbDiag.NumClass(eDiagClass := eDiagClass_11);
```
Diagnosis descriptions

General

The library contains a single function block "Diag", providing several methods to process diagnosis descriptions.

All methods for system diagnosis start with "Get...". For device diagnosis the prefix "Diag" is added: "DiagGet...". For better readability, only the method names for system diagnosis is used in the descriptions of the methods.

Table 856: Methods for handling diagnosis entries

<table>
<thead>
<tr>
<th>Method for system diagnosis</th>
<th>Method for device diagnosis</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ack</td>
<td>DiagAck</td>
<td>Acknowledge a diagnosis alarm previously requested by using any Get... / DiagGet... method</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GetFirstVal</td>
<td>DiagGetFirstVal</td>
<td>Get the first (oldest) diagnosis message, numeric values</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GetNextVal</td>
<td>DiagGetNextVal</td>
<td>Get the next diagnosis message, numeric values</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GetLastVal</td>
<td>DiagGetLastVal</td>
<td>Get the last (newest) diagnosis message, numeric values</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GetPrevVal</td>
<td>DiagGetPrevVal</td>
<td>Get the previous diagnosis message, numeric values</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GetFirstValExt</td>
<td>DiagGetFirstValExt</td>
<td>Get the first (oldest) diagnosis message, numeric and extended numeric values</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GetNextValExt</td>
<td>DiagGetNextValExt</td>
<td>Get the next diagnosis message, numeric and extended numeric values</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GetLastValExt</td>
<td>DiagGetLastValExt</td>
<td>Get the last (newest) diagnosis message, numeric and extended numeric values</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GetPrevValExt</td>
<td>DiagGetPrevValExt</td>
<td>Get the previous diagnosis message, numeric and extended numeric values</td>
</tr>
<tr>
<td>Method for system diagnosis</td>
<td>Method for device diagnosis</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| GetFirstValAndTxt           | DiagGetFirstValAndTxt       | Get the first (oldest) diagnosis message, numeric values and text  
Chapter 6.9.1.5.3.3.6 "Method Get-xxx-ValAndTxt / DiagGet-xxx-ValAndTxt: numeric values and text" on page 4625 |
| GetNextValAndTxt            | DiagGetNextValAndTxt        | Get the next diagnosis message, numeric values and text  
Chapter 6.9.1.5.3.3.6 "Method Get-xxx-ValAndTxt / DiagGet-xxx-ValAndTxt: numeric values and text" on page 4625 |
| GetLastValAndTxt            | DiagGetLastValAndTxt        | Get the last (newest) diagnosis message, numeric values and text  
Chapter 6.9.1.5.3.3.6 "Method Get-xxx-ValAndTxt / DiagGet-xxx-ValAndTxt: numeric values and text" on page 4625 |
| GetPrevValAndTxt            | DiagGetPrevValAndTxt        | Get the previous diagnosis message, numeric values and text  
Chapter 6.9.1.5.3.3.6 "Method Get-xxx-ValAndTxt / DiagGet-xxx-ValAndTxt: numeric values and text" on page 4625 |
| GetFirstValAndTxtExt        | DiagGetFirstValAndTxtExt    | Get the first (oldest) diagnosis message, numeric, extended numeric values and text  
Chapter 6.9.1.5.3.3.7 "Method Get-xxx-ValAndTxtExt / DiagGet-xxx-ValAndTxtExt: numeric values, extended numeric values and text" on page 4626 |
| GetNextValAndTxtExt         | DiagGetNextValAndTxtExt     | Get the next diagnosis message, numeric, extended numeric values and text  
Chapter 6.9.1.5.3.3.7 "Method Get-xxx-ValAndTxtExt / DiagGet-xxx-ValAndTxtExt: numeric values, extended numeric values and text" on page 4626 |
| GetLastValAndTxtExt         | DiagGetLastValAndTxtExt     | Get the last (newest) diagnosis message, extended numeric values and text  
Chapter 6.9.1.5.3.3.7 "Method Get-xxx-ValAndTxtExt / DiagGet-xxx-ValAndTxtExt: numeric values, extended numeric values and text" on page 4626 |
| GetPrevValAndTxtExt         | DiagGetPrevValAndTxtExt     | Get the previous diagnosis message, extended numeric values and text  
Chapter 6.9.1.5.3.3.7 "Method Get-xxx-ValAndTxtExt / DiagGet-xxx-ValAndTxtExt: numeric values, extended numeric values and text" on page 4626 |
Method Ack / DiagAck: acknowledgement

This method can be used to acknowledge a diagnosis alarm previously requested by using any Get... / DiagGet... method. Alternatively, you can acknowledge an alarm in Automation Builder.

After acknowledgement, the alarm is deleted from the diagnosis system.

<table>
<thead>
<tr>
<th>Scope</th>
<th>Name for device diagnosis</th>
<th>Name for device diagnosis</th>
<th>Type</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return</td>
<td>Ack</td>
<td>DiagAck</td>
<td>AC500_DiagTypes.ERROR_ID</td>
<td>Variable containing details of diagnosis alarm to be acknowledged</td>
</tr>
<tr>
<td>Input</td>
<td>Data</td>
<td>Data</td>
<td>AC500_DiagTypes.DIAG_VAL_TYPE</td>
<td></td>
</tr>
</tbody>
</table>

Example

System diagnosis: acknowledge first diagnosis message

```plaintext
VAR
  fbDiag : AC500_DiagDiag;
  eErrorID_First : AC500_DiagTypes.ERROR_ID;
  sFirstVal : AC500_DiagTypes.DIAG_VAL_TYPE;
END_VAR

eErrorID_First := fbDiag.Ack(Data := sFirstVal);
```

Methods Get... / DiagGet...: get and sort diagnosis messages

All these methods can be used to get the first (oldest), next, last (newest) or previous diagnosis message stored in diagnosis system. The only difference are the details the methods provide. While, e.g., Get-xxx-Val just provides the basic information in numeric format, Get-xxx-ValExt additionally provides this information by the extended diagnosis data of the entry.

The numeric format provided by these methods can be converted into textual format later on if required. Chapter 6.9.1.5.3.3.8 “Function DiagValToTxt” on page 4627. Alternatively, the methods Get-xxx-ValAndTxt and Get-xxx-ValAndTxtExt can be used for numeric and textual format in parallel. Chapter 6.9.1.5.3.3.6 “Method Get-xxx-ValAndTxt / DiagGet-xxx-ValAndTxt: numeric values and text” on page 4625. Chapter 6.9.1.5.3.3.7 “Method Get-xxx-ValAndTxtExt / DiagGet-xxx-ValAndTxtExt: numeric values, extended numeric values and text” on page 4626.

All methods may need multiple cycles to process the request. Therefore, they must be called in successive cycles until they return a final result. Chapter 6.9.1.5.2.4 “Enumeration ERROR_ID” on page 4617.

All diagnosis messages sorted by time, ascending

1. Call any GetFirst... method until it indicates a final result.
2. If the result is not "NO_ERROR_NO_DATA": Call any GetNext... method as long as its final result is "NO_ERROR".

All diagnosis messages sorted by time, descending

1. Call any GetLast... method until it indicates a final result.
2. If the result is not "NO_ERROR_NO_DATA": Call any GetPrev... method as long as its final result is "NO_ERROR".

Configuration and programming
Diagnosis and debugging > The diagnosis system

-xxx- = First, Next, Last, Prev. Example: GetFirstVal, DiagGetLastVal.

<table>
<thead>
<tr>
<th>Scope</th>
<th>Name for device diagnosis</th>
<th>Name for device diagnosis</th>
<th>Type</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return</td>
<td>Get-xxx-Val</td>
<td>DiagGet-xxx-Val</td>
<td>AC500_DiagTypes.ERROR_ID</td>
<td>Variable to write data to</td>
</tr>
</tbody>
</table>

Example

System diagnosis: get values for first diagnosis message

```plaintext
VAR
fbDiag : AC500_Diag.Diag;
eErrorID_First : AC500_DiagTypes.ERROR_ID;
sFirstVal : AC500_DiagTypes.DIAG_VAL_TYPE;
END_VAR
```

eErrorID_First := fbDiag.GetFirstVal(Data := sFirstVal);

Example

Online mode: battery empty or missing

<table>
<thead>
<tr>
<th>Expression</th>
<th>Type</th>
<th>Value</th>
<th>Prepared value</th>
<th>Address</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>fbDiag</td>
<td>AC500_Diag.Diag</td>
<td>NO_ERROR</td>
<td>Instance of FB Diag</td>
<td></td>
<td></td>
</tr>
<tr>
<td>eErrorID_First</td>
<td>AC500_DiagTypes.ERROR_ID</td>
<td></td>
<td>return value</td>
<td></td>
<td></td>
</tr>
<tr>
<td>sFirstVal</td>
<td>AC500_Diag.AC500_...</td>
<td></td>
<td>structure of returned values</td>
<td></td>
<td></td>
</tr>
<tr>
<td>dtTimestamp</td>
<td>DATE_AND_TIME</td>
<td>DTF::1970-1-1-00:00:15</td>
<td>RTC time of event</td>
<td></td>
<td></td>
</tr>
<tr>
<td>units</td>
<td>UNIT</td>
<td>356</td>
<td>Milliseconds of event</td>
<td></td>
<td></td>
</tr>
<tr>
<td>eClass</td>
<td>TCLASS</td>
<td>eDiagClass_4_Warning</td>
<td>Severity of error event</td>
<td></td>
<td></td>
</tr>
<tr>
<td>sDevice</td>
<td>STRING64</td>
<td>PLC_AC500_VI3</td>
<td>Name of device</td>
<td></td>
<td></td>
</tr>
<tr>
<td>alarm</td>
<td>TBOOLEAN</td>
<td>eDiagEvent_4Occurred</td>
<td>Type of event</td>
<td></td>
<td></td>
</tr>
<tr>
<td>eHWInterface</td>
<td>TBHWID</td>
<td>eDiagHWd.SelectedIndexChanged</td>
<td>Identifier of hardware interface</td>
<td></td>
<td></td>
</tr>
<tr>
<td>dwSubSysID</td>
<td>DWORD</td>
<td>365058762</td>
<td>Any number describing all location within d...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>dwAdditional</td>
<td>DWORD</td>
<td>0</td>
<td>Additional number describing detail/location within d...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>uLErrorCode</td>
<td>UDINT</td>
<td>0</td>
<td>Error code</td>
<td></td>
<td></td>
</tr>
<tr>
<td>uSizeExtDiag</td>
<td>UINT</td>
<td>0</td>
<td>Number of bytes of extended diagnosis data</td>
<td></td>
<td></td>
</tr>
<tr>
<td>nSource</td>
<td>POINDEX TO BYTE</td>
<td>16#008703D0</td>
<td>Internal reference needed for test conversion</td>
<td></td>
<td></td>
</tr>
<tr>
<td>pConn</td>
<td>POINDEX TO TagVar</td>
<td>16#8124A1D4</td>
<td>Internal reference needed for test conversion</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Method Get-xxx-ValExt / DiagGet-xxx-ValExt: numeric values and extended numeric values

<table>
<thead>
<tr>
<th>Scope</th>
<th>Name for device diagnosis</th>
<th>Name for device diagnosis</th>
<th>Type</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return</td>
<td>Get-xxx-ValExt</td>
<td>DiagGet-xxx-ValExt</td>
<td>AC500_DiagTypes.ERROR_ID</td>
<td></td>
</tr>
<tr>
<td>Inout</td>
<td>Data</td>
<td>Data</td>
<td>AC500_DiagTypes.DIAG_VAL_TYPE</td>
<td>Variable to write data to</td>
</tr>
<tr>
<td>Input</td>
<td>pExt</td>
<td>pExt</td>
<td>POINTER TO BYTE</td>
<td>Address of buffer to copy extended data to</td>
</tr>
<tr>
<td>Input</td>
<td>Size</td>
<td>Size</td>
<td>WORD</td>
<td>Size of buffer to copy extended data to</td>
</tr>
<tr>
<td>Inout</td>
<td>Length</td>
<td>Length</td>
<td>WORD</td>
<td>Size of extended data copied to buffer</td>
</tr>
</tbody>
</table>

**Example**

System diagnosis: get numeric values and extended numeric values for first diagnosis message

```plaintext
VAR
  fbDiag : AC500_Diag Diag;
  eErrorID First : AC500_DiagTypes.ERROR_ID;
  sFirstVal : AC500_DiagTypes.DIAG_VAL_TYPE;
  abyExtData : ARRAY[0..1023] OF BYTE;
  wSize : WORD := 1024;
  wLength : WORD;

END_VAR
```

```
eErrorID First := fbDiag.GetFirstValExt(Data := sFirstVal, pExt := ADR(abyExtData), Size := wSize, Length := wLength);
```

Method Get-xxx-ValAndTxt / DiagGet-xxx-ValAndTxt: numeric values and text

-xxx- = First, Next, Last, Prev. Example: GetFirstValAndTxt, DiagGetPrevValAndTxt

<table>
<thead>
<tr>
<th>Scope</th>
<th>Name for device diagnosis</th>
<th>Name for device diagnosis</th>
<th>Type</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return</td>
<td>Get-xxx-ValAndTxt</td>
<td>DiagGet-xxx-ValAndTxt</td>
<td>AC500_DiagTypes.ERROR_ID</td>
<td></td>
</tr>
<tr>
<td>Inout</td>
<td>DataVal</td>
<td>DataVal</td>
<td>AC500_DiagTypes.DIAG_VAL_TYPE</td>
<td>Variable to write data to</td>
</tr>
<tr>
<td>Inout</td>
<td>DataTxt</td>
<td>DataTxt</td>
<td>AC500_DiagTypes.DIAG_TXT_TYPE</td>
<td>Variable to write text to</td>
</tr>
</tbody>
</table>
System diagnosis: get numeric values and text for first diagnosis message

```
VAR
fbDiag : AC500_Diag.Diag;
eErrorID_First : AC500_DiagTypes.ERROR_ID;
sFirstVal : AC500_DiagTypes.DIAG_VAL_TYPE;
sFirstTxt : AC500_DiagTypes.DIAG_TXT_TYPE;
END_VAR
```
eErrorID_First := fbDiag.GetFirstValAndTxt(DataVal := sFirstVal, DataTxt := sFirstTxt);

Example Online mode: battery empty or missing

```
Expression                      Type                        Value
fbDiag                         AC500_Diag.Diag            
eErrorID_First                 ERROR_ID                    NO_ERROR
sFirstVal                      AC500_Diag.AC500...       
dtTimestamp                   DATE_AND_TIME               DT#1970-1-1-0:0:0:15
uiMs                           UINT                        355
eclass                        TECHCLASS                  eDiagClasstery.Warning
szDevice                      STRING(80)                 "PLC_AC500_V3"
eEvent                        TEEVENT                    eDiagEventOccurred
ethWInterface                 TEHWID                     eDiagHwId_CPU
dwSubSys                      DWORD                      360969752
dwAdditional                  DWORD                      0
udErrorCode                   UDINT                      8
uiSizeExtDiag                 UINT                       0
hSource                       POINTER TO BYTE               16#00070300
pConn                         POINTER TO LOSTat...     16#B124A1D4
sFirstTxt                      AC500_Diag.AC500...       
szDiag                        STRING(12)                 '1970-01-01:00:00:15,356/E4;PLC_AC500_V3;Battery Device Empty or missing'
szColumn                      STRING(1)                  ';' 
```
eErrorID_First := NO_ERROR := fbDiag.GetFirstValAndTxt(DataVal := sFirstVal, DataTxt := sFirstTxt);

Method Get-xxx-ValAndTxtExt / DiagGet-xxx-ValAndTxtExt: numeric values, extended numeric values and text

-xxx- = First, Next, Last, Prev. Example: GetLastValAndTxtExt, DiagGetFirstValAndTxtExt

<table>
<thead>
<tr>
<th>Scop e</th>
<th>Name for device diagnosis</th>
<th>Name for device diagnosis</th>
<th>Type</th>
<th>Initial</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return</td>
<td>Get-xxx-ValAndTxtExt</td>
<td>DiagGet-xxx-ValAndTxtExt</td>
<td>AC500_DiagTypes.ERROR_ID</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inout</td>
<td>DataVal</td>
<td>DataVal</td>
<td>AC500_DiagTypes.DIAG_VAL_TYPE</td>
<td>Variable to write data to</td>
<td></td>
</tr>
</tbody>
</table>
### Scope

<table>
<thead>
<tr>
<th>Scope</th>
<th>Name for device diagnosis</th>
<th>Name for device diagnosis</th>
<th>Type</th>
<th>Initial</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inout</td>
<td>DataTxt</td>
<td>DataTxt</td>
<td>AC500_DiagTypes.DIAG_TXT_TYPE</td>
<td></td>
<td>Variable to write text to</td>
</tr>
<tr>
<td>Input</td>
<td>pExt</td>
<td>pExt</td>
<td>POINTER TO BYTE</td>
<td>0</td>
<td>Address of buffer to copy extended data to</td>
</tr>
<tr>
<td>Input</td>
<td>Size</td>
<td>Size</td>
<td>WORD</td>
<td>0</td>
<td>Size of buffer to copy extended data to</td>
</tr>
<tr>
<td>Inout</td>
<td>Length</td>
<td>Length</td>
<td>WORD</td>
<td>0</td>
<td>Size of extended data copied to buffer</td>
</tr>
</tbody>
</table>

### Example

System diagnosis: get numeric values, extended numeric values and text of first diagnosis message

```plaintext
VAR
  fbDiag : AC500_Diag.Diag;
  eErrorID_First : AC500_DiagTypes.ERROR_ID;
  sFirstVal : AC500_DiagTypes.DIAG_VAL_TYPE;
  sFirstTxt : AC500_DiagTypes.DIAG_TXT_TYPE;
  abyExtData : ARRAY[0..1023] OF BYTE;
  wSize : WORD := 1024;
  wLength : WORD;
END_VAR

eErrorID_First := fbDiag.GetFirstValExt(DataVal := sFirstVal, DataTxt := sFirstTxt,
                                        pExt := ADR(abyExtData), Size := wSize, Length := wLength);
```

### Function DiagValToTxt

Call this function to convert a numeric diagnosis message into a textual one at any time, in case this has not yet been done using a method providing both types when requesting this information.

### Scope

<table>
<thead>
<tr>
<th>Scope</th>
<th>Name</th>
<th>Type</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return</td>
<td>DiagValToTxt</td>
<td>AC500_DiagTypes.ERROR_ID</td>
<td></td>
</tr>
<tr>
<td>Inout</td>
<td>DataInVal</td>
<td>AC500_DiagTypes.DIAG_VAL_TYPE</td>
<td>Variable to convert</td>
</tr>
<tr>
<td>Inout</td>
<td>DataOutTxt</td>
<td>AC500_DiagTypes.DIAG_TXT_TYPE</td>
<td>Variable to write text to</td>
</tr>
</tbody>
</table>
6.9.1.5.4 Device diagnosis

Activate device diagnosis

While the notification of diagnosis messages at the display and the Automation Builder is enabled by default, the functionality to access diagnosis messages from within the IEC application needs to be explicitly enabled.

1. Double-click on the CPU in the device tree.
2. Select tab “PLC Settings”.
3. Under “Additional Settings” select “Enable Diagnosis for devices”.
   - Library CAA Device Diagnosis (namespace DED) is automatically included in the project. This library is needed for displaying and processing the device state.

In case the functionality of diagnosis is no longer needed in IEC application, we recommend to disable this setting.
Device state

1. Open one of the IEC application code editors.
2. Type the device's name as it is written in the device tree, followed by a dot (".").
3. Select the method `GetDeviceState` from the context menu or type the name of the method on yourself.

![Image showing the selection of the GetDeviceState method]

4. Assign the function's parameters.

```plaintext
DeviceState_DC532 := DC532.GetDeviceState(xDiagnosisInfoAvailable => bDiagAvailable, eError => eError);
```

<table>
<thead>
<tr>
<th>Scope</th>
<th>Name</th>
<th>Type</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return</td>
<td>GetDeviceState</td>
<td>DEVICE_STATE</td>
<td>Current device state</td>
</tr>
<tr>
<td>Output</td>
<td>xDiagnosisInfoAvailable</td>
<td>BOOL</td>
<td>If TRUE, diagnosis messages are available regarding the concerning device (= node).</td>
</tr>
<tr>
<td>Output</td>
<td>eError</td>
<td>ERROR</td>
<td>Type of the return values of all methods and functions of library CAA Device Diagnosis</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Initial</th>
<th>Icon in AB</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNKNOWN</td>
<td>INT</td>
<td>0</td>
<td></td>
<td>The device is in state unknown. Example: No supervision mechanism active</td>
</tr>
<tr>
<td>STOPPED</td>
<td>INT</td>
<td>1</td>
<td></td>
<td>The device is stopped.</td>
</tr>
<tr>
<td>RUNNING</td>
<td>INT</td>
<td>2</td>
<td></td>
<td>The device is running.</td>
</tr>
<tr>
<td>ERROR</td>
<td>INT</td>
<td>3</td>
<td></td>
<td>The device is in error state.</td>
</tr>
<tr>
<td>DISABLED</td>
<td>INT</td>
<td>4</td>
<td></td>
<td>The device is disabled in device tree.</td>
</tr>
<tr>
<td>Name</td>
<td>Type</td>
<td>Initial</td>
<td>Icon in AB</td>
<td>Comment</td>
</tr>
<tr>
<td>----------------------</td>
<td>------</td>
<td>---------</td>
<td>------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>NOT_CONFIGURED</td>
<td>INT</td>
<td>5</td>
<td></td>
<td>The device has not been yet configured by the stack. Example: Configuration phase not yet started</td>
</tr>
<tr>
<td>CONFIGURED</td>
<td>INT</td>
<td>6</td>
<td></td>
<td>The device has been configured by the stack. Example: Configuration phase finished but the device is not in running state</td>
</tr>
<tr>
<td>NOT_FOUND</td>
<td>INT</td>
<td>7</td>
<td></td>
<td>The device was not found on bus.</td>
</tr>
</tbody>
</table>

Table 858: Enumeration ERROR (part of the library CAA Device Diagnosis (DED))

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Initial</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>NO_ERROR</td>
<td>INT</td>
<td>0</td>
<td>No error</td>
</tr>
<tr>
<td>FIRST_ERROR</td>
<td>INT</td>
<td>1300</td>
<td>First library-specific error</td>
</tr>
<tr>
<td>TIME_OUT</td>
<td>INT</td>
<td>1301</td>
<td>Timeout occurred.</td>
</tr>
<tr>
<td>ABORT</td>
<td>INT</td>
<td>1302</td>
<td>Operation was aborted.</td>
</tr>
<tr>
<td>REF_INVALID</td>
<td>INT</td>
<td>1303</td>
<td>The interface reference was invalid.</td>
</tr>
<tr>
<td>NOT_SUPPORTED</td>
<td>INT</td>
<td>1304</td>
<td>The function is not supported.</td>
</tr>
<tr>
<td>ERROR_IO</td>
<td>INT</td>
<td>1305</td>
<td>A general I/O configuration error occurred.</td>
</tr>
<tr>
<td>PARAM_INVALID</td>
<td>INT</td>
<td>1306</td>
<td>Invalid parameter</td>
</tr>
<tr>
<td>NODE_NOT_EXISTING</td>
<td>INT</td>
<td>1307</td>
<td>The specified node does not exist.</td>
</tr>
<tr>
<td>NO_MEMORY</td>
<td>INT</td>
<td>1308</td>
<td>Dynamic memory allocation is disabled, or system is out of memory.</td>
</tr>
<tr>
<td>ADR_NOT_FOUND</td>
<td>INT</td>
<td>1309</td>
<td>The specified I/O address is not valid.</td>
</tr>
<tr>
<td>INST_NOT_FOUND</td>
<td>INT</td>
<td>1310</td>
<td>There is no associated [Device] instance for the specific I/O address.</td>
</tr>
<tr>
<td>NO_DATA</td>
<td>INT</td>
<td>1311</td>
<td>There is no data available.</td>
</tr>
<tr>
<td>OPERATION_INVALID</td>
<td>INT</td>
<td>1312</td>
<td>Operation not possible due to the current state</td>
</tr>
<tr>
<td>FIRST_MF</td>
<td>INT</td>
<td>1350</td>
<td>First manufacturer-specific error</td>
</tr>
<tr>
<td>LAST_ERROR</td>
<td>INT</td>
<td>1399</td>
<td>Last error</td>
</tr>
</tbody>
</table>
Diagnosis descriptions

General

The library contains a single function block "Diag", providing several methods to process diagnosis descriptions.

All methods for system diagnosis start with "Get...". For device diagnosis the prefix "Diag" is added: "DiagGet...". For better readability, only the method names for system diagnosis is used in the descriptions of the methods.

Table 859: Methods for handling diagnosis entries

<table>
<thead>
<tr>
<th>Method for system diagnosis</th>
<th>Method for device diagnosis</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ack</td>
<td>DiagAck</td>
<td>Acknowledge a diagnosis alarm previously requested by using any Get... / DiagGet... method ≥ Chapter 6.9.1.5.4.3.2 “Method Ack / DiagAck: acknowledgement” on page 4633</td>
</tr>
<tr>
<td>GetFirstVal</td>
<td>DiagGetFirstVal</td>
<td>Get the first (oldest) diagnosis message, numeric values ≥ Chapter 6.9.1.5.4.3.3 “Methods Get... / DiagGet...: get and sort diagnosis messages” on page 4633</td>
</tr>
<tr>
<td>GetNextVal</td>
<td>DiagGetNextVal</td>
<td>Get the next diagnosis message, numeric values ≥ Chapter 6.9.1.5.4.3.4 “Method Get-xxx-Val / DiagGet-xxx-Val: numeric values” on page 4634</td>
</tr>
<tr>
<td>GetLastVal</td>
<td>DiagGetLastVal</td>
<td>Get the last (newest) diagnosis message, numeric values ≥ Chapter 6.9.1.5.4.3.4 “Method Get-xxx-Val / DiagGet-xxx-Val: numeric values” on page 4634</td>
</tr>
<tr>
<td>GetPrevVal</td>
<td>DiagGetPrevVal</td>
<td>Get the previous diagnosis message, numeric values ≥ Chapter 6.9.1.5.4.3.4 “Method Get-xxx-Val / DiagGet-xxx-Val: numeric values” on page 4634</td>
</tr>
<tr>
<td>GetFirstValExt</td>
<td>DiagGetFirstValExt</td>
<td>Get the first (oldest) diagnosis message, numeric and extended numeric values ≥ Chapter 6.9.1.5.4.3.5 “Method Get-xxx-ValExt / DiagGet-xxx-ValExt: numeric values and extended numeric values” on page 4634</td>
</tr>
<tr>
<td>GetNextValExt</td>
<td>DiagGetNextValExt</td>
<td>Get the next diagnosis message, numeric and extended numeric values ≥ Chapter 6.9.1.5.4.3.5 “Method Get-xxx-ValExt / DiagGet-xxx-ValExt: numeric values and extended numeric values” on page 4634</td>
</tr>
<tr>
<td>GetLastValExt</td>
<td>DiagGetLastValExt</td>
<td>Get the last (newest) diagnosis message, numeric and extended numeric values ≥ Chapter 6.9.1.5.4.3.5 “Method Get-xxx-ValExt / DiagGet-xxx-ValExt: numeric values and extended numeric values” on page 4634</td>
</tr>
<tr>
<td>GetPrevValExt</td>
<td>DiagGetPrevValExt</td>
<td>Get the previous diagnosis message, numeric and extended numeric values ≥ Chapter 6.9.1.5.4.3.5 “Method Get-xxx-ValExt / DiagGet-xxx-ValExt: numeric values and extended numeric values” on page 4634</td>
</tr>
<tr>
<td>Method for system diagnosis</td>
<td>Method for device diagnosis</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>GetFirstValAndTxt</td>
<td>DiagGetFirstValAndTxt</td>
<td>Get the first (oldest) diagnosis message, numeric values and text</td>
</tr>
<tr>
<td>GetNextValAndTxt</td>
<td>DiagGetNextValAndTxt</td>
<td>Get the next diagnosis message, numeric values and text</td>
</tr>
<tr>
<td>GetLastValAndTxt</td>
<td>DiagGetLastValAndTxt</td>
<td>Get the last (newest) diagnosis message, numeric values and text</td>
</tr>
<tr>
<td>GetPrevValAndTxt</td>
<td>DiagGetPrevValAndTxt</td>
<td>Get the previous diagnosis message, numeric values and text</td>
</tr>
<tr>
<td>GetFirstValAndTxtExt</td>
<td>DiagGetFirstValAndTxtExt</td>
<td>Get the first (oldest) diagnosis message, numeric, extended numeric values and text</td>
</tr>
<tr>
<td>GetNextValAndTxtExt</td>
<td>DiagGetNextValAndTxtExt</td>
<td>Get the next diagnosis message, numeric, extended numeric values and text</td>
</tr>
<tr>
<td>GetLastValAndTxtExt</td>
<td>DiagGetLastValAndTxtExt</td>
<td>Get the last (newest) diagnosis message, extended numeric values and text</td>
</tr>
<tr>
<td>GetPrevValAndTxtExt</td>
<td>DiagGetPrevValAndTxtExt</td>
<td>Get the previous diagnosis message, extended numeric values and text</td>
</tr>
</tbody>
</table>
**Method Ack / DiagAck: acknowledgement**

This method can be used to acknowledge a diagnosis alarm previously requested by using any Get... / DiagGet... method. Alternatively, you can acknowledge an alarm in Automation Builder.

After acknowledgement, the alarm is deleted from the diagnosis system.

<table>
<thead>
<tr>
<th>Scope</th>
<th>Name for device diagnosis</th>
<th>Name for device diagnosis</th>
<th>Type</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return</td>
<td>Ack</td>
<td>DiagAck</td>
<td>AC500_DiagTypes.ERROR_ID</td>
<td>Variable containing details of diagnosis alarm to be acknowledged</td>
</tr>
<tr>
<td>Input</td>
<td>Data</td>
<td>Data</td>
<td>AC500_DiagTypes.DIAG_VAL_TYPE</td>
<td></td>
</tr>
</tbody>
</table>

**Example**

System diagnosis: acknowledge first diagnosis message

```plaintext
VAR
  fbDiag : AC500_Diag.Diag;
  eErrorID_First : AC500_DiagTypes.ERROR_ID;
  sFirstVal : AC500_DiagTypes.DIAG_VAL_TYPE;
END_VAR

eErrorID_First := fbDiag.Ack(Data := sFirstVal);
```

**Methods Get... / DiagGet...: get and sort diagnosis messages**

All these methods can be used to get the first (oldest), next, last (newest) or previous diagnosis message stored in diagnosis system. The only difference are the details the methods provide. While, e.g., Get-xxx-Val just provides the basic information in numeric format, Get-xxx-ValExt additionally provides this information by the extended diagnosis data of the entry.

The numeric format provided by these methods can be converted into textual format later on if required (Chapter 6.9.1.5.3.3.8 "Function DiagValToTxt" on page 4627). Alternatively, the methods Get-xxx-ValAndTxt and Get-xxx-ValAndTxtExt can be used for numeric and textual format in parallel (Chapter 6.9.1.5.4.3.6 "Method Get-xxx-ValAndTxt / DiagGet-xxx-ValAndTxt: numeric values and text" on page 4635) (Chapter 6.9.1.5.4.3.7 "Method Get-xxx-ValAndTxtExt / DiagGet-xxx-ValAndTxtExt: numeric values, extended numeric values and text" on page 4636).

All methods may need multiple cycles to process the request. Therefore, they must be called in successive cycles until they return a final result (Chapter 6.9.1.5.2.4 "Enumeration ERROR_ID" on page 4617).

**All diagnosis messages sorted by time, ascending**

1. Call any GetFirst... method until it indicates a final result.
2. If the result is not "NO_ERROR_NO_DATA": Call any GetNext... method as long as its final result is "NO_ERROR".

**All diagnosis messages sorted by time, descending**

1. Call any GetLast... method until it indicates a final result.
2. If the result is not "NO_ERROR_NO_DATA": Call any GetPrev... method as long as its final result is "NO_ERROR".
-xxx- = First, Next, Last, Prev. Example: GetFirstVal, DiagGetLastVal.

<table>
<thead>
<tr>
<th>Scope</th>
<th>Name for device diagnosis</th>
<th>Name for device diagnosis</th>
<th>Type</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return</td>
<td>Get-xxx-Val</td>
<td>DiagGet-xxx-Val</td>
<td>AC500_DiagTypes.ERROR_ID</td>
<td></td>
</tr>
<tr>
<td>Inout</td>
<td>Data</td>
<td>Data</td>
<td>AC500_DiagTypes.DIAG_VAL_TYPE</td>
<td>Variable to write data to</td>
</tr>
</tbody>
</table>

Example System diagnosis: get values for first diagnosis message

```plaintext
VAR
  fbDiag : AC500_Diag.Dia;
  eErrorID_First : AC500_DiagTypes.ERROR_ID;
  sFirstVal : AC500_DiagTypes.DIAG_VAL_TYPE;
END_VAR

eErrorID_First := fbDiag.GetFirstVal(Data := sFirstVal);
```

Example Online mode: battery empty or missing

```plaintext
PLC_PRG X

<table>
<thead>
<tr>
<th>Expression</th>
<th>Type</th>
<th>Value</th>
<th>Prepared value</th>
<th>Address</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>fbDiag</td>
<td>AC500_Diag.Diag</td>
<td>NO_ERROR</td>
<td>Instance of FB Diag</td>
<td>return value</td>
<td></td>
</tr>
<tr>
<td>eErrorID_First</td>
<td>AC500_DiagTypes.ERROR_ID</td>
<td></td>
<td></td>
<td></td>
<td>Return value</td>
</tr>
<tr>
<td>sFirstVal</td>
<td>AC500_Diag.ACC500...</td>
<td></td>
<td>structure of return values</td>
<td></td>
<td></td>
</tr>
<tr>
<td>dtTimestamp</td>
<td>DATE_AND_TIME</td>
<td>DTF:1970-1-1-8:0:15</td>
<td>RTC time of event</td>
<td></td>
<td></td>
</tr>
<tr>
<td>secs</td>
<td>UNIT</td>
<td>356</td>
<td>Milliseconds of event</td>
<td></td>
<td></td>
</tr>
<tr>
<td>eClass</td>
<td>TECLASS</td>
<td>eDiagClass_4_Warning</td>
<td>Severity of error event</td>
<td></td>
<td></td>
</tr>
<tr>
<td>sDevice</td>
<td>STRING</td>
<td>PLC_AC500_V3</td>
<td>Name of device</td>
<td></td>
<td></td>
</tr>
<tr>
<td>dError</td>
<td>_DOUBLE</td>
<td>dErrorOccurred</td>
<td>Type of event</td>
<td></td>
<td></td>
</tr>
<tr>
<td>eHost</td>
<td>_HID</td>
<td>eDiagHost_CPU</td>
<td>Identifier of hardware interface</td>
<td></td>
<td></td>
</tr>
<tr>
<td>dwSubSys</td>
<td>DWORD</td>
<td>365058752</td>
<td>Any number describing all location within d...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>dwAdditional</td>
<td>DWORD</td>
<td>0</td>
<td>Additional number describing detail/location within</td>
<td></td>
<td></td>
</tr>
<tr>
<td>uErrorCode</td>
<td>UINT</td>
<td>0</td>
<td>Error code</td>
<td></td>
<td></td>
</tr>
<tr>
<td>uSizeExtDiag</td>
<td>UINT</td>
<td>0</td>
<td>Number of bytes of extended diagnostic data</td>
<td></td>
<td></td>
</tr>
<tr>
<td>hSource</td>
<td>POINTER TO BYTE</td>
<td>16#008F0D00</td>
<td>Internal reference needed for test conversion</td>
<td></td>
<td></td>
</tr>
<tr>
<td>pConn</td>
<td>POINTER TO IO свои</td>
<td>16#0124A1D4</td>
<td>Internal reference needed for test conversion</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Method Get-xxx-ValExt / DiagGet-xxx-ValExt: numeric values and extended numeric values
### System diagnosis: get numeric values and extended numeric values for first diagnosis message

```plaintext
 VAR
 fbDiag : AC500_Dia.Diag;
 eErrorID_First : AC500_DiaDiagTypes.ERROR_ID;
 sFirstVal : AC500_DiaDiagTypes.DIAG_VAL_TYPE;
 abyExtData : ARRAY[0..1023] OF BYTE;
 wSize : WORD := 1024;
 wLength : WORD;

 END_VAR
```

```plaintext
 eErrorID_First := fbDiag.GetFirstValExt(Data := sFirstVal, pExt := ADR(abyExtData), Size := wSize, Length := wLength);
```
Example
System diagnosis: get numeric values and text for first diagnosis message

```
VAR

fbDiag : AC500_Diag.Diag;
eErrorID_First : AC500_DiagTypes.ERROR_ID;
sFirstVal : AC500_DiagTypes.DIAG_VAL_TYPE;
sFirstTxt : AC500_DiagTypes.DIAG_TXT_TYPE;

END_VAR

eErrorID_First := fbDiag.GetFirstValAndTxt(DataVal := sFirstVal, DataTxt := sFirstTxt);
```

Example
Online mode: battery empty or missing

```
Method Get-xxx-ValAndTxtExt / DiagGet-xxx-ValAndTxtExt: numeric values, extended numeric values and text

-xxx- = First, Next, Last, Prev. Example: GetLastValAndTxtExt, DiagGetFirstValAndTxtExt

<table>
<thead>
<tr>
<th>Scop e</th>
<th>Name for device diagnosis</th>
<th>Name for device diagnosis</th>
<th>Type</th>
<th>Initial</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return</td>
<td>Get-xxx-Val-AndTxtExt</td>
<td>DiagGet-xxx-Val-AndTxtExt</td>
<td>AC500_Dia- gTypes.ERROR_ID</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inout</td>
<td>DataVal</td>
<td>DataVal</td>
<td>AC500_Dia- gTypes.DIAG_VAL_ TYPE</td>
<td>Variable to write data to</td>
<td></td>
</tr>
</tbody>
</table>
### Example

**System diagnosis: get numeric values, extended numeric values and text of first diagnosis message**

```plaintext
VAR
  fbDiag : AC500_Diag.Diag;
  eErrorID_First : AC500_DiagTypes.ERROR_ID;
  sFirstVal : AC500_DiagTypes.DIAG_VAL_TYPE;
  sFirstTxt : AC500_DiagTypes.DIAG_TXT_TYPE;
  abyExtData : ARRAY[0..1023] OF BYTE;
  wSize : WORD := 1024;
  wLength : WORD;
END_VAR
```

```plaintext
eErrorID_First := fbDiag.GetFirstValExt(DataVal := sFirstVal, DataTxt := sFirstTxt,
  pExt := ADR(abyExtData), Size := wSize, Length := wLength);
```

---

### Function DiagValToTxt

Call this function to convert a numeric diagnosis message into a textual one at any time, in case this has not yet been done using a method providing both types when requesting this information.

<table>
<thead>
<tr>
<th>Scope</th>
<th>Name</th>
<th>Type</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return</td>
<td>DiagValToTxt</td>
<td>AC500_DiagTypes.ERROR_ID</td>
<td></td>
</tr>
<tr>
<td>Inout</td>
<td>DataInVal</td>
<td>AC500_DiagTypes.DIAG_VAL_TYPE</td>
<td>Variable to convert</td>
</tr>
<tr>
<td>Inout</td>
<td>DataOutTxt</td>
<td>AC500_DiagTypes.DIAG_TXT_TYPE</td>
<td>Variable to write text to</td>
</tr>
</tbody>
</table>
System diagnosis: convert first diagnosis message from numeric value to text

Example

```c
VAR
  eErrorID_ValToTxt : AC500_DiagTypes.ERROR_ID;
  sFirstVal : AC500_DiagTypes.DIAG_VAL_TYPE;
  szDataOutTxt : AC500_DiagTypes.DIAG_TXT_TYPE;
(* return value *)
(* structure of returned values *)
(* string of converted data *)
END_VAR
```

```
  eErrorID_ValToTx := DiagValToTxt(DataInVal := sFirstVal, DataOutTxt := szDataOutTxt);
```

Example

Battery empty or missing

![Diagram of error numbers structure]

### 6.9.1.6 Structure of error numbers

#### 6.9.1.6.1 Error severity

<table>
<thead>
<tr>
<th>Error severity</th>
<th>Type</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Fatal errors</td>
<td>Safe operation of the operating system is no longer ensured.</td>
<td>Checksum error in system flash, RAM error</td>
</tr>
<tr>
<td>2</td>
<td>Severe error</td>
<td>The operating system works correctly, but the error-free execution of the user program is not ensured.</td>
<td>Checksum error in user flash, task cycle times exceeded</td>
</tr>
<tr>
<td>3</td>
<td>Minor errors</td>
<td>It depends on the application whether the user program has to be stopped by the operating system or not. The user decides which reaction is to be done.</td>
<td>Flash memory cannot be programmed, I/O module failed</td>
</tr>
<tr>
<td>Error severity</td>
<td>Type</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>----------------</td>
<td>---------------</td>
<td>------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>4</td>
<td>Warnings</td>
<td>Errors that occur on peripheral devices or that will have an effect only in the future. The user decides which reactions are to be done.</td>
<td>Short circuit in an I/O module, battery empty/not installed</td>
</tr>
<tr>
<td>11</td>
<td>Parameter error</td>
<td>Error occurred during parameter setting</td>
<td>Different I/O devices in PLC configuration and hardware installation</td>
</tr>
</tbody>
</table>

**Errors with error severity 1 - fatal errors**

Errors with error severity 1 are not entered in the diagnosis system. These errors do not allow normal operation of the PLC. These errors are detected during PLC start-up and stop the PLC immediately.

Examples are RAM errors or checksum errors when starting the firmware. Such errors are indicated by rapid flashing of the ERR LED.

---

6.9.1.7 Diagnosis history file

The diagnosis history file “DiagHistory.csv” collects diagnosis information. It is stored in the root directory of the user disk and provides a maximum of 2.000 entries. When 2.000 entries are reached, the oldest entry is overwritten. The maximum size of extended data is 32 bytes.

The diagnosis history can be accessed with the Automation Builder or with the IEC application.  

☞ Chapter 6.9.1.4.5 “Diagnosis history” on page 4614

The diagnosis history file must be interpreted according to the device and/or the fieldbus. A demonstration of how to read out and receive diagnosis history messages with the IEC application is given in the application example AC500 V3 – Diagnosis History

---

**Example entry - Diagnosis history file**

An entry consists of following data:

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Comment</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>timestamp</td>
<td>ARRAYDT OF BYTE</td>
<td>RTC time of event in milliseconds consists of dITimestamp in DT format and uMs milliseconds.</td>
<td>1603371910177</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See ☞ Chapter 6.9.1.5.2.2 “Structure DIAG_VAL_TYPE” on page 4616 STRUCT.</td>
<td></td>
</tr>
<tr>
<td>event</td>
<td>BYTE</td>
<td>Event type (1=comes, 2=gone). See ☞ Chapter 6.9.1.5.2.6 “Enumeration teEvent” on page 4618.</td>
<td>1</td>
</tr>
<tr>
<td>class</td>
<td>BYTE</td>
<td>Severity of error event. ☞ Chapter 6.9.1.5.2.5 “Enumeration teClass” on page 4618.</td>
<td>4</td>
</tr>
<tr>
<td>complID</td>
<td>UDINT</td>
<td>Component ID</td>
<td>270540802</td>
</tr>
<tr>
<td>Name</td>
<td>Type</td>
<td>Comment</td>
<td>Example</td>
</tr>
<tr>
<td>-------</td>
<td>----------</td>
<td>--------------------------------------------------------------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>conn</td>
<td>UDINT</td>
<td>Connector</td>
<td>0xb17777ac</td>
</tr>
<tr>
<td>connIdx</td>
<td>UDINT</td>
<td>Connector index</td>
<td>0</td>
</tr>
<tr>
<td>sub</td>
<td>DWORD</td>
<td>SubsystemID: Any number describing detail/location within device, device specific</td>
<td>369098752</td>
</tr>
<tr>
<td>addl</td>
<td>DWORD</td>
<td>AdditionalID: Additional number describing detail/location within device, optional, device specific</td>
<td>0</td>
</tr>
<tr>
<td>error</td>
<td>DWORD</td>
<td>Error code</td>
<td>9</td>
</tr>
<tr>
<td>extended data</td>
<td>ARRAYDT OF BYTE</td>
<td>Extended diagnosis data, max. 32 bytes</td>
<td></td>
</tr>
</tbody>
</table>

With the entries compID, conn and connID, the device generating the event is clearly identified in the device tree.

If the PLC configuration is changed, the values of this entries may be changed also.

Therefore, the diagnosis history will be deleted during each download.

### 6.9.2 Online diagnosis in Automation Builder

#### 6.9.2.1 Short description and overview

To use the diagnosis system in Automation Builder, login to the online mode is required. Chapter 6.9.2.2 “Entering/leaving the online mode” on page 4640. The online diagnosis in Automation Builder consists of a set of partly animated, mostly read only views. They can be invoked by a double-click on a project tree element which shows a circle indicating that this element is able to show diagnosis messages. Chapter 6.9.2.3 “Project tree in online mode” on page 4641.

Available online diagnosis and statistics:

- **Diagnosis messages**
  
  When the Automation Builder is switched to online mode, incoming diagnosis messages are displayed as plain-text. Chapter 6.9.1.4 “Diagnosis in Automation Builder” on page 4611.

- **CPU/PLC diagnosis**
  
  Chapter 6.9.2.4 “CPU diagnosis views” on page 4645.

- **I/O module diagnosis**
  
  Chapter 6.9.2.5 “Live values in views with I/O components” on page 4649.

- **Communication module and fieldbus diagnosis**
  
  Chapter 6.9.2.6 “Communication module and fieldbus diagnosis” on page 4649.

- **Diagnosis in IEC application**
  
  Chapter 6.9.1.5 “Diagnosis in IEC application” on page 4615

  For information on the disk status, diagnosis information can be read out with the function blocks PmDiskStatus and PmDiskLifetimeUsed. Chapter 6.8.2.2.1.4 “Health monitoring” on page 4424.

#### 6.9.2.2 Entering/leaving the online mode

Prerequisite: Set the gateway before entering the online mode. Chapter 6.3.2.15 “Gateway configuration” on page 1593.
Enter the online mode

Right-click the “Application” node and select “Login”.

The Automation Builder project login to online mode updates the latest changes of the project.

> The online mode can be entered or left for each PLC in the project separately.

Leave the online mode

Right-click the “Application” node and select Logout.

When online mode is active, a thread is running on Automation Builder project which sends cyclically a message to the PLC and expects a response. If the PLC does not respond, the online mode is left programmatically.

6.9.2.3 Project tree in online mode

When Automation Builder enters the online mode internally, it shows the state of all configured communication modules.

The connection status can be recognized by a symbol in the device tree:

- 💚 Device without diagnosis messages
- 🎉 Device with diagnosis messages or device diagnosis is disabled  
  - Chapter 6.9.2.4.6 “Device diagnosis” on page 4648
- 🔴 Device without diagnosis messages, but with diagnosis messages on at least one device in the branch below
- ⚠️ Device with diagnosis messages and with diagnosis messages on at least one device in the branch below
- ⚠️ Device does not respond to identification message and is not available for online connection
The identification is done in online mode.

- Double-click an element of the device-tree and select "Status" tab. Diagnosis information will be available.
The user will be notified in the device tree with an exclamation mark beside the device having diagnosis messages. The diagnosis messages are provided in the “Diagnosis” tab.

Alarms will be presented with a thunderbolt in the first column of the diagnosis grid.

Acknowledging an alarm
1. Stop diagnosis refreshment by clicking [Stop refresh].
2. Select one or more alarms and click [Acknowledge selected alarms].
Some diagnosis messages contain additional data. Click [View] button to see the additional diagnosis (in hex) for further analysis. If [View] button is not available, no additional data is available for this diagnosis message.

You can copy the additional data to the clipboard with [CTRL] + [C].

When building an IEC application in Automation Builder, diagnosis text lists will be generated and added to the device tree below the diagnosis folder. These text lists contain the device type specific diagnosis texts which are used by the diagnosis functions in the PLC application to show corresponding texts for error numbers.

The diagnosis text lists will only be downloaded to the PLC when a visualization is present in the project.

The text lists will be downloaded automatically to the PLC with the visualization. If there is a problem with downloading the text lists, make sure that the settings are correct:
1. Right-click on a text list and select “Properties”.
2. Open the “Text List” tab. The check box “Download by visualization” has to be selected.

6.9.2.4 CPU diagnosis views
6.9.2.4.1 Version information

Information on the firmware versions of the processor modules or communication modules, is provided on the “Version information” tab.

Remarks:
- The “Version information” tab displays the version identified on the device and the version provided with Automation Builder.
- The firmware on the devices must match to the Automation Builder supported versions. It might be required to upgrade or downgrade the current firmware for using the PLC with the current Automation Builder.
- The “Required Version” might contain more than one user selectable version (drop-down list), this is indicated by an asterisk after the file name.
### State icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🚀</td>
<td>Firmware version on device matches version supplied with Automation Builder.</td>
</tr>
<tr>
<td>🧠</td>
<td>Firmware version (or type) on device is different from version supplied with Automation Builder. Upgrade/downgrade to version supplied with Automation Builder is recommended.</td>
</tr>
<tr>
<td>🚦</td>
<td>Only for communication modules if CPU firmware must be updated first. This happens when CPU firmware has version below 2.5.0.0. Firmware version (or type) on device is different from version supplied with Automation Builder. Upgrade/downgrade to version supplied with Automation Builder is recommended.</td>
</tr>
<tr>
<td>🚧</td>
<td>Identified device is different from configured device, thus no firmware update is possible. Happens only for Communication Modules.</td>
</tr>
<tr>
<td>🧠</td>
<td>No icon</td>
</tr>
<tr>
<td>🧠</td>
<td>Firmware of device is not updateable or no newer firmware than the initial version is available.</td>
</tr>
</tbody>
</table>

[Update Firmware] to download the new firmware is only enabled if there is updateable firmware.

### 6.9.2.4.2 Statistics

The “Statistics” tab shows the following information:

- **Date and time**: The actual date and time of the PLC is shown. It can be set or synchronized with the date/time of the PC via “Set PLC Date & Time” button.

- **Overview resource usage**: This tab shows all the required information (it is collected at latest when the command “Generate Code” is executed, some of the information is not available before then.)

For the limitation “User program code and data” a [Details] button will be available. Clicking this button will open a modal window showing a more detailed view of the memory usage.
6.9.2.3 Log

You can view the PLC log in this tab. It lists the events that were recorded on the target system. This concerns:

- Events during the startup and shutdown of the system (components loaded, with version)
- Application download and loading of the boot application
- Custom entries
- Log entries from I/O drivers
- Log entries from data sources

| Offline logging | □: Default settings  
| The PLC also records actions that are not related to the connection with the controller. |
| UTC time | □: Standard setting; the time stamp is converted to the local time on the computer as indicated by the time zone of the operating system.  
| □: The time stamp of the runtime system is displayed. |
| Severity | There are four categories for the severity of the event:  
| ▶: Message  
| ▼: Warning  
| ▲: Error  
| □: Debugging  
You can show or hide each category with the help of the corresponding button in the bar above the list. Each button shows the number of log entries of the category concerned. |
| Time stamp | Date and time (example: 12-01-2007 09:48) |
| Description | Description of the event, for example Import function failed of |
| Component | Name of the runtime system component concerned, e.g. CmpApp |
| Drop-down list with component names | The log list displays only events that concern the selected component |
| Logger | Drop-down list with all available recordings. The standard setting is the <Default Logger> specified by the target system, at present identical to 'PlcLog' for the CODESYS runtime system |
| | Refreshes the log list |
| | Exports the list contents to an XML file. You can select the file name and storage directory. |
| | Imports a log list from an XML file. The list is then displayed in a separate window. |
| | The displayed log list is emptied, i.e. all entries are deleted. |

6.9.2.4 PLC shell commands

The PLC shell is used for requesting specific information from the controller. By entering a device-specific command the response is returned in a result window. The PLC shell can be issued without login.

Proceed as follows:

1. Ensure the gateway is configured properly and a connection to the controller can be established.
2. In Automation Builder double-click the PLC node and open the tab “PLC Shell”.
3. Enter "?" in the command line of the tab window. All available PLC commands are listed.
If the gateway is able to establish a connection to the controller, an online connection to the PLC is opened automatically.

The commands listed in online mode can differ from the commands shown when pressing the button [...] as Automation Builder version and firmware version can differ.

Chapter 6.4.1.21.2.8.11 “Tab 'PLC Shell'” on page 2441
Chapter 6.2.6 “Version information” on page 1384
Chapter 6.3.1.4 “Firmware identification and update” on page 1419.

6.9.2.4.5 Status

This tab displays status information, for example 'Running' or 'Stopped', and specific diagnosis messages from the respective device, also information about the card used and the internal bus system.

6.9.2.4.6 Device diagnosis

Each node in the device tree has a diagnosis view, which displays the diagnosis messages for this device only.

The message consists of:

- Type
- Timestamp in date and time YYYY-MM-DD hh:mm:ss.ms
- Error severity
- Error code
- Diagnosis description
- Additional data

To view the diagnosis message:
1. Double-click on a device.
2. Select the tab “Diagnosis”.

Example

Battery empty or missing.
Wrong module configured on I/O bus.

Device diagnosis is disabled by default.

To enable/disable device diagnosis:
1. Double-click on the PLC.
2. Select the tab “PLC Settings”.
3. Under “Additional Settings” enable/disable “Diagnosis for devices”.

When the device diagnosis is disabled, this symbol will be displayed in the device tree and no diagnosis messages will be shown.

6.9.2.5 Live values in views with I/O components

“I/O mapping list” tab: In online mode, all Automation Builder views, which contain I/O component mapping tables, show animated live values which are updated every second.

6.9.2.6 Communication module and fieldbus diagnosis

6.9.2.6.1 Fieldbus commissioning

General

Common online diagnosis views for all netX-based communication modules (e.g. CM579-ETHCAT, CM579-PNIO) can be accessed whenever the related PLC is in online mode.

Chapter 6.9.2.2 “Entering/leaving the online mode” on page 4640
Master/controller modules

Master/controller modules like CM579-ETHCAT or CM579-PNIO, provide the following diagnosis views:

- "Diagnostics main": provides diagnosis messages which are common for all protocols (e.g., protocol state and error)
- "Diagnostics live list": provides a list of connected slaves/devices and their state (See Chapter 6.9.2.6.1.4 "PROFINET scan and comparison view" on page 4651)
- "Diagnostics eventlog": provides diagnosis messages from the master/controller and its connected slaves/devices

Slave/device communication modules

Diagnosis views for slave/device communication modules like CM589-PNIO:

- "Diagnostics main": provides diagnosis messages which are common for all protocols
- "Diagnostics details": provides protocol specific diagnosis messages
PROFINET scan and comparison view

PNIO_Controller

1. After going online, double-click on "PNIO_Controller (PROFINET-I/O-Controller)" in the device tree.
   ⇒ The editor "PNIO_Controller" is displayed.

2. Select tab "Diagnostics live list" and click [Scan] to find all hardware devices that exist.
   ⇒ The found devices are listed in a table.

3. Click [Compare] to compare the found hardware I/O devices with the current project configuration.

   Unknown hardware

   If any I/O hardware device is unknown:
   ● The devices will be marked with a red exclamation mark.
   ● A message box will be appear for each unknown device.
   ● Automation Builder generates a message with information about its vendor ID and device ID.

   Comparison view

1. To display the comparison view, install the device description for the unknown device.

2. After installing the device description, click [Scan] and click [Compare].

   ⇒ The message box informs you, that the application will go offline to display the comparison view.
3. Click [Yes].

⇒ The “Project Comparison - Differences” tab displays the difference between the PROFINET configuration in Automation Builder (left side) and the real hardware configuration (right side).

4. Click [Accept Single] to accept only a part of the differences or [Accept Block] to accept all differences.

⇒ After clicking on the Button [Accept Single] or [Accept Block] the found devices will be moved from the right side to the left side.

5. Close tab “Project Comparison - Differences”.

⇒ A message will be displayed to ask if you want to commit the new changes into project.
6. Click [Yes].

⇒ The changes will be saved and the devices will be added to the project.

6.9.2.6 CI52x Modbus diagnosis

1. Double-click node “CI52x_MODTCP” in the device tree.
2. Select “CI52x Diagnosis” tab.

⇒ The button [Get Diagnosis] appears in the tab view.
3. Click on the button [Get Diagnosis].

⇒ One of the following use cases will be displayed:
   - Device not connected  "Device not connected" on page 4654
   - No Errors on the device  "No errors on the device" on page 4654
   - Diagnosis list  "Diagnosis list" on page 4654
Device not connected

If there is no device connected to the project, the following dialog will be displayed:

1. Select tab “Connection Settings” and enter the IP address for the device.
2. Click again button [Get Diagnosis].

No errors on the device

If there are no errors on the device the following dialog will be displayed:

Diagnosis list

If the device is not correctly configured the errors will be displayed with “Error Code” and “Code Description”.

6.9.2.6.3 EtherCAT diagnosis

Due to the nature of the EtherCAT bus, diagnostics cannot be standardized and must be individually adapted to the requirements of the PLC system.

A guideline for EtherCAT diagnosis during commissioning and operation of the AC500 V3 series in combination with Automation Builder diagnosis and the IEC programming is given in the application note EtherCAT diagnosis guideline.
6.9.3 Diagnosis messages

6.9.3.1 Read out the diagnosis messages via display

If the processor module has a display, you can access the diagnosis system via the display and the buttons.

Diagnosis messages can also be accessed within the engineering suite Automation Builder or with the IEC application.

☞ Chapter 6.9.1.4 “Diagnosis in Automation Builder” on page 4611
☞ Chapter 6.9.1.5 “Diagnosis in IEC application” on page 4615

Fig. 365: Example “battery is empty or missing”

<table>
<thead>
<tr>
<th>Error severity</th>
<th>Location</th>
<th>Error code</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>E4</td>
<td>bat (battery)</td>
<td>8</td>
<td>22</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Empty or missing</td>
</tr>
</tbody>
</table>

Err 1 Total number of active diagnosis messages, here: 1
E4 bat Error severity, here: 4, and location of error, here: battery
Id 1 In the list of all errors, the position of the error, here: first error message
8, d1, d2, d3, d4 Error code, here: 8, and system information to identify the error with the help of the diagnosis lists

☞ E2 diagnosis messages
☞ E3 diagnosis messages
☞ E4 diagnosis messages
☞ E11 diagnosis messages
### 6.9.3.2 Error severity E2: Severe errors

**Table 860: Error severity E2: Severe errors**

<table>
<thead>
<tr>
<th>Error severity</th>
<th>Location</th>
<th>Error code</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Description</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>E2</td>
<td>iob (I/O bus)</td>
<td>2</td>
<td>14</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Resource failure</td>
<td></td>
</tr>
<tr>
<td>E2</td>
<td>iob (I/O bus)</td>
<td>3</td>
<td>14</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Timeout</td>
<td></td>
</tr>
<tr>
<td>E2</td>
<td>CPU</td>
<td>11</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Type scaling on PLC startup failed</td>
<td></td>
</tr>
<tr>
<td>E2</td>
<td>Fld (flash-disk)</td>
<td>12</td>
<td>19</td>
<td>0</td>
<td>0..n</td>
<td>0..n</td>
<td>Flash memory is temporary protected (read only, panic mode)</td>
<td></td>
</tr>
<tr>
<td>E2</td>
<td>iob (I/O bus)</td>
<td>17</td>
<td>14</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Error setting I/O bus master parameter</td>
<td></td>
</tr>
<tr>
<td>E2</td>
<td>diS (display)</td>
<td>23</td>
<td>21</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Wrong version of display firmware</td>
<td></td>
</tr>
<tr>
<td>E2</td>
<td>CPU</td>
<td>27</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>Failed to set parameter &quot;Reboot at powerfail&quot;</td>
<td></td>
</tr>
<tr>
<td>E2</td>
<td>CPU</td>
<td>29</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Combination of plugged option boards is invalid</td>
<td></td>
</tr>
<tr>
<td>E2</td>
<td>CPU</td>
<td>49</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Restore failed</td>
<td></td>
</tr>
<tr>
<td>E2</td>
<td>iob (I/O bus)</td>
<td>8482</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Timeout, while initializing</td>
<td></td>
</tr>
<tr>
<td>E2</td>
<td>iob (I/O bus)</td>
<td>9249</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Timeout while waiting for Reset</td>
<td></td>
</tr>
<tr>
<td>E2</td>
<td>iob (I/O bus)</td>
<td>9258</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Breakdown, communication lost</td>
<td></td>
</tr>
<tr>
<td>E2</td>
<td>iob (I/O bus)</td>
<td>16129</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Severe error, see log</td>
<td></td>
</tr>
<tr>
<td>E2</td>
<td>iob (I/O bus)</td>
<td>16130</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Fatal error, see log</td>
<td></td>
</tr>
<tr>
<td>E2</td>
<td>iob (I/O bus)</td>
<td>16194</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Fatal error, not running any more</td>
<td></td>
</tr>
</tbody>
</table>
### 6.9.3.3 Error severity E3: Minor errors

#### Table 861: Error severity E3: Minor errors

<table>
<thead>
<tr>
<th>Error severity</th>
<th>Location</th>
<th>Error code</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Description</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>E3 iob (I/O bus)</td>
<td>3</td>
<td>Module number</td>
<td>1</td>
<td>Channel number</td>
<td>0</td>
<td>Discrepancy time expired</td>
<td>Check discrepancy time value, channel wiring and sensor.</td>
<td></td>
</tr>
<tr>
<td>FLD (flash-disk)</td>
<td>10 19 5 0...n</td>
<td></td>
<td></td>
<td></td>
<td>0</td>
<td>Medium has almost used its complete spare capacity or is already dead, action required</td>
<td></td>
<td></td>
</tr>
<tr>
<td>E3 iob (I/O bus)</td>
<td>12</td>
<td>Module number</td>
<td>1</td>
<td>Channel number</td>
<td>0</td>
<td>Test pulse error</td>
<td>Check wiring and sensor</td>
<td></td>
</tr>
<tr>
<td>E3 iob (I/O bus)</td>
<td>13</td>
<td>Module number</td>
<td>1</td>
<td>Channel number</td>
<td>0</td>
<td>Test pulse cross-talk error</td>
<td>Check wiring and sensor. If this error persists, replace I/O module. Contact ABB technical support.</td>
<td></td>
</tr>
<tr>
<td>E3 iob (I/O bus)</td>
<td>18</td>
<td>Module number</td>
<td>1</td>
<td>Channel number</td>
<td>0</td>
<td>Test error</td>
<td></td>
<td></td>
</tr>
<tr>
<td>E3 diS (display)</td>
<td>22 21 0 0</td>
<td></td>
<td></td>
<td></td>
<td>0</td>
<td>Error at initialization of display</td>
<td></td>
<td></td>
</tr>
<tr>
<td>E3 iob (I/O bus)</td>
<td>25</td>
<td>Module number</td>
<td>1</td>
<td>Channel number</td>
<td>0</td>
<td>Stuck-at error</td>
<td>Check I/O module wiring. Restart I/O module, if needed. If this error persists, replace I/O module.</td>
<td></td>
</tr>
<tr>
<td>E3 iob (I/O bus)</td>
<td>28</td>
<td>Module number</td>
<td>1</td>
<td>Channel number</td>
<td>0</td>
<td>Cross-talk error</td>
<td>Check I/O module wiring. Restart I/O module, if needed. If this error persists, replace I/O module.</td>
<td></td>
</tr>
<tr>
<td>E3 CPU</td>
<td>44</td>
<td></td>
<td>0</td>
<td>7</td>
<td>0</td>
<td>Loading boot project failed due to failing load of retain data</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Error severity</td>
<td>Location</td>
<td>Error code</td>
<td>d1</td>
<td>d2</td>
<td>d3</td>
<td>d4</td>
<td>Description</td>
<td>Remedy</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
<td>------------</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>E3</td>
<td>CPU</td>
<td>45</td>
<td>0</td>
<td>7</td>
<td>0</td>
<td>0</td>
<td>Loading boot project failed due to mismatch of retain data</td>
<td></td>
</tr>
<tr>
<td>E3</td>
<td>CPU</td>
<td>46</td>
<td>0</td>
<td>7</td>
<td>0</td>
<td>0</td>
<td>Loading boot project failed due to insufficient license for application</td>
<td></td>
</tr>
<tr>
<td>E3</td>
<td>CPU</td>
<td>47</td>
<td>0</td>
<td>7</td>
<td>0</td>
<td>0</td>
<td>Loading boot project failed due to unspecified reason</td>
<td></td>
</tr>
<tr>
<td>E3</td>
<td>CPU</td>
<td>48</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Backup failed</td>
<td></td>
</tr>
<tr>
<td>E3</td>
<td>FLd (flash-disk)</td>
<td>54</td>
<td>19</td>
<td>5</td>
<td>0</td>
<td>0</td>
<td>Root partition has 1% or less free space left</td>
<td></td>
</tr>
<tr>
<td>E3</td>
<td>iob (I/O bus)</td>
<td>273</td>
<td>Module number</td>
<td>1</td>
<td>Channel number</td>
<td>0</td>
<td>Test error</td>
<td></td>
</tr>
<tr>
<td>E3</td>
<td>iob (I/O bus)</td>
<td>311</td>
<td>Module number</td>
<td>1</td>
<td>Channel number</td>
<td>0</td>
<td>Value difference too high</td>
<td>Adjust tolerance window for channels. Check channel wiring and sensor configuration.</td>
</tr>
<tr>
<td>E3</td>
<td>iob (I/O bus)</td>
<td>524</td>
<td>Module number</td>
<td>1</td>
<td>Channel number</td>
<td>0</td>
<td>Stuck-at error</td>
<td></td>
</tr>
<tr>
<td>E3</td>
<td>iob (I/O bus)</td>
<td>525</td>
<td>Module number</td>
<td>1</td>
<td>Channel number</td>
<td>0</td>
<td>Readback error</td>
<td>Check I/O module wiring. Restart I/O module, if needed. If this error persists, replace I/O module.</td>
</tr>
<tr>
<td>E3</td>
<td>iob (I/O bus)</td>
<td>530</td>
<td>Module number</td>
<td>1</td>
<td>Channel number</td>
<td>0</td>
<td>Cross-talk error</td>
<td>Check I/O module wiring. Restart I/O module, if needed. If this error persists, replace I/O module.</td>
</tr>
<tr>
<td>E3</td>
<td>iob (I/O bus)</td>
<td>540</td>
<td>Module number</td>
<td>1</td>
<td>Channel number</td>
<td>0</td>
<td>Test error</td>
<td></td>
</tr>
<tr>
<td>E3</td>
<td>iob (I/O bus)</td>
<td>555</td>
<td>Module number</td>
<td>1</td>
<td>Channel number</td>
<td>0</td>
<td>Internal error</td>
<td></td>
</tr>
<tr>
<td>E3</td>
<td>iob (I/O bus)</td>
<td>1037</td>
<td>Module number</td>
<td>1</td>
<td>Channel number</td>
<td>0</td>
<td>Test error</td>
<td></td>
</tr>
<tr>
<td>Error severity</td>
<td>Location</td>
<td>Error code</td>
<td>d1</td>
<td>d2</td>
<td>d3</td>
<td>d4</td>
<td>Description</td>
<td>Remedy</td>
</tr>
<tr>
<td>---------------</td>
<td>----------</td>
<td>------------</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>-------------</td>
<td>--------</td>
</tr>
<tr>
<td>E3</td>
<td>iob (I/O bus)</td>
<td>8480</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Not supported protocol variant</td>
<td></td>
</tr>
<tr>
<td>E3</td>
<td>iob (I/O bus)</td>
<td>8707</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>PROFIsafe watchdog timed out</td>
<td></td>
</tr>
<tr>
<td>E3</td>
<td>iob (I/O bus)</td>
<td>8708</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Overvoltage</td>
<td></td>
</tr>
<tr>
<td>E3</td>
<td>iob (I/O bus)</td>
<td>8711</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Undervoltage</td>
<td></td>
</tr>
<tr>
<td>E3</td>
<td>iob (I/O bus)</td>
<td>8722</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Internal error</td>
<td></td>
</tr>
<tr>
<td>E3</td>
<td>iob (I/O bus)</td>
<td>8723</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Checksum error has occurred in iParameters</td>
<td></td>
</tr>
<tr>
<td>E3</td>
<td>iob (I/O bus)</td>
<td>8724</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>PROFIsafe communication error</td>
<td></td>
</tr>
<tr>
<td>E3</td>
<td>iob (I/O bus)</td>
<td>8732</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Internal error</td>
<td></td>
</tr>
<tr>
<td>E3</td>
<td>iob (I/O bus)</td>
<td>8747</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Internal runtime error</td>
<td></td>
</tr>
<tr>
<td>E3</td>
<td>iob (I/O bus)</td>
<td>8961</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Wrong parameter value, check configuration</td>
<td></td>
</tr>
<tr>
<td>E3</td>
<td>iob (I/O bus)</td>
<td>8979</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Checksum error has occurred in iParameter or F-Parameters</td>
<td></td>
</tr>
<tr>
<td>E3</td>
<td>iob (I/O bus)</td>
<td>8986</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Invalid configuration</td>
<td></td>
</tr>
<tr>
<td>E3</td>
<td>iob (I/O bus)</td>
<td>8988</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>F-Parameter configuration and address switch value do not match.</td>
<td></td>
</tr>
<tr>
<td>E3</td>
<td>iob (I/O bus)</td>
<td>16131</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Timeout</td>
<td></td>
</tr>
<tr>
<td>E3</td>
<td>iob (I/O bus)</td>
<td>16137</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Overflow diagnosis buffer</td>
<td></td>
</tr>
<tr>
<td>E3</td>
<td>iob (I/O bus)</td>
<td>16138</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Non-safety I/O: Voltage overflow on outputs (above UP3 level), Safety I/O: Process voltage too high</td>
<td></td>
</tr>
</tbody>
</table>

2024/01/05 3ADR010583, 1, en_US 4659
<table>
<thead>
<tr>
<th>Error severity</th>
<th>Location</th>
<th>Error code</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Description</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>E3</td>
<td>iob</td>
<td>16139</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Process voltage UP or UP3 too low</td>
<td>Check process voltage</td>
</tr>
<tr>
<td>E3</td>
<td>iob</td>
<td>16146</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Plausibility check failed (iParameter)</td>
<td>Check configuration</td>
</tr>
<tr>
<td>E3</td>
<td>iob</td>
<td>16147</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Checksum error</td>
<td>Non-safety I/O: Replace I/O module</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Safety I/O: Check safety configuration and CRCs for I- and F-Parameters.</td>
<td>Safety I/O: Check safety configuration and CRCs for I- and F-Parameters.</td>
</tr>
<tr>
<td>E3</td>
<td>iob</td>
<td>16148</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>PROFIsafe communication error</td>
<td>Restart I/O module. If this error persists, contact ABB technical support.</td>
</tr>
<tr>
<td>E3</td>
<td>iob</td>
<td>16153</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>PROFIsafe watchdog timed out</td>
<td>Restart I/O module. If this error persists, increase PROFIsafe watchdog time.</td>
</tr>
<tr>
<td>E3</td>
<td>iob</td>
<td>16154</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Parameter error</td>
<td>Check configuration.</td>
</tr>
<tr>
<td>E3</td>
<td>iob</td>
<td>16156</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>F-Parameter configuration and address switch value do not match.</td>
<td>Check I/O module F-Parameter configuration and module address switch value.</td>
</tr>
<tr>
<td>E3</td>
<td>iob</td>
<td>16164</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Internal data interchange failure</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>E3</td>
<td>iob</td>
<td>16168</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Different hard-/firmware versions in the module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>E3</td>
<td>iob</td>
<td>16171</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Internal error</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>E3</td>
<td>iob</td>
<td>16175</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Sensor voltage too low</td>
<td></td>
</tr>
<tr>
<td>E3</td>
<td>iob</td>
<td>16128</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Failed Max Wait Run</td>
<td></td>
</tr>
</tbody>
</table>
### 6.9.3.4 Error severity E4: Warnings

**Table 862: Error severity E4: Warnings**

<table>
<thead>
<tr>
<th>Error severity</th>
<th>Location</th>
<th>Error code</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Description</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>E4</td>
<td>bAt (battery)</td>
<td>8</td>
<td>22</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Empty or missing</td>
<td></td>
</tr>
<tr>
<td>E4</td>
<td>FLd (flash-disk)</td>
<td>9</td>
<td>19</td>
<td>5</td>
<td>0...n</td>
<td>0</td>
<td>Medium has used 80 % of its spare capacity</td>
<td></td>
</tr>
<tr>
<td>E4</td>
<td>FLd (flash-disk)</td>
<td>53</td>
<td>19</td>
<td>5</td>
<td>0</td>
<td>0</td>
<td>Root partition has 15% or less free space left</td>
<td></td>
</tr>
<tr>
<td>E4</td>
<td>iob (I/O bus)</td>
<td>257</td>
<td>Module number</td>
<td>1</td>
<td>Channel number</td>
<td>0</td>
<td>Wrong measurement, false temperature at the compensation channel</td>
<td></td>
</tr>
<tr>
<td>E4</td>
<td>iob (I/O bus)</td>
<td>258</td>
<td>Module number</td>
<td>1</td>
<td>Channel number</td>
<td>0</td>
<td>AI531: wrong measurement, potential difference is too high; CD522: PWM duty cycle out of duty area</td>
<td></td>
</tr>
<tr>
<td>E4</td>
<td>iob (I/O bus)</td>
<td>260</td>
<td>Module number</td>
<td>1</td>
<td>Channel number</td>
<td>0</td>
<td>Measurement overflow</td>
<td>Check channel wiring and sensor power supply.</td>
</tr>
<tr>
<td>E4</td>
<td>iob (I/O bus)</td>
<td>263</td>
<td>Module number</td>
<td>1</td>
<td>Channel number</td>
<td>0</td>
<td>Measurement underflow at analog input</td>
<td>Check channel wiring and sensor power supply.</td>
</tr>
<tr>
<td>E4</td>
<td>iob (I/O bus)</td>
<td>266</td>
<td>Module number</td>
<td>1</td>
<td>Channel number</td>
<td>0</td>
<td>Short circuit and cut wire or &quot;out of range&quot;</td>
<td></td>
</tr>
<tr>
<td>E4</td>
<td>iob (I/O bus)</td>
<td>267</td>
<td>Module number</td>
<td>1</td>
<td>Channel number</td>
<td>0</td>
<td>Output/process voltage to small/low.</td>
<td></td>
</tr>
<tr>
<td>E4</td>
<td>iob (I/O bus)</td>
<td>302</td>
<td>Module number</td>
<td>1</td>
<td>Channel number</td>
<td>0</td>
<td>External voltage fed at the output clamps.</td>
<td></td>
</tr>
<tr>
<td>E4</td>
<td>iob (I/O bus)</td>
<td>303</td>
<td>Module number</td>
<td>1</td>
<td>Channel number</td>
<td>0</td>
<td>Short circuit at the analog input</td>
<td>Check channel wiring</td>
</tr>
<tr>
<td>E4</td>
<td>iob (I/O bus)</td>
<td>304</td>
<td>Module number</td>
<td>1</td>
<td>Channel number</td>
<td>0</td>
<td>Analog value overflow or broken wire at an analog input.</td>
<td></td>
</tr>
<tr>
<td>E4</td>
<td>iob (I/O bus)</td>
<td>530</td>
<td>Module number</td>
<td>1</td>
<td>Channel number</td>
<td>0</td>
<td>Internal fuse at 0 V is defect. 0 V not connected with GND.</td>
<td></td>
</tr>
<tr>
<td>Error severity</td>
<td>Location</td>
<td>Error code</td>
<td>d1</td>
<td>d2</td>
<td>d3</td>
<td>d4</td>
<td>Description</td>
<td>Remedy</td>
</tr>
<tr>
<td>----------------</td>
<td>----------</td>
<td>------------</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
<td>-------------------------------------------------------------------</td>
<td>-----------------------------------------------------</td>
</tr>
<tr>
<td>E4</td>
<td>iob (I/O bus)</td>
<td>559</td>
<td>Module number</td>
<td>1</td>
<td>Channel number</td>
<td>0</td>
<td>Short circuit at the digital output</td>
<td>Check channel wiring</td>
</tr>
<tr>
<td>E4</td>
<td>iob (I/O bus)</td>
<td>772</td>
<td>Module number</td>
<td>1</td>
<td>Channel number</td>
<td>0</td>
<td>Measurement overflow at an analog output</td>
<td>Check channel wiring</td>
</tr>
<tr>
<td>E4</td>
<td>iob (I/O bus)</td>
<td>775</td>
<td>Module number</td>
<td>1</td>
<td>Channel number</td>
<td>0</td>
<td>Measurement underflow at analog output</td>
<td>Check channel wiring</td>
</tr>
<tr>
<td>E4</td>
<td>iob (I/O bus)</td>
<td>796</td>
<td>Module number</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>Different configuration</td>
<td></td>
</tr>
<tr>
<td>E4</td>
<td>iob (I/O bus)</td>
<td>8482</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Timeout while waiting for ready status</td>
<td></td>
</tr>
<tr>
<td>E4</td>
<td>iob (I/O bus)</td>
<td>8483</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Timeout during parameterization</td>
<td></td>
</tr>
<tr>
<td>E4</td>
<td>iob (I/O bus)</td>
<td>9480</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>I/O module removed from hot swap terminal unit</td>
<td>Plug I/O module, replace I/O module</td>
</tr>
<tr>
<td>E4</td>
<td>iob (I/O bus)</td>
<td>9480</td>
<td>Module number</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Module removed from hot swap terminal unit</td>
<td>Remove wrong I/O module and plug projected I/O module</td>
</tr>
<tr>
<td>E4</td>
<td>iob (I/O bus)</td>
<td>9500</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Wrong I/O module replugged on hot swap terminal unit</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>E4</td>
<td>iob (I/O bus)</td>
<td>9514</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>No communication with I/O module on hot swap terminal unit</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>E4</td>
<td>iob (I/O bus)</td>
<td>9526</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>I/O module does not support hot swap</td>
<td>Power off system and replace I/O module</td>
</tr>
<tr>
<td>E4</td>
<td>iob (I/O bus)</td>
<td>9526</td>
<td>Module number</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Module on hot swap terminal unit does not support hot swap</td>
<td></td>
</tr>
<tr>
<td>E4</td>
<td>iob (I/O bus)</td>
<td>9736</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>Hot swap terminal unit required, but not found</td>
<td></td>
</tr>
<tr>
<td>E4</td>
<td>iob (I/O bus)</td>
<td>9764</td>
<td>Module number</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Defective hot swap terminal unit</td>
<td></td>
</tr>
<tr>
<td>E4</td>
<td>iob (I/O bus)</td>
<td>9770</td>
<td>Module number</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>No communication with hot swap terminal unit</td>
<td>Restart, if error persists replace terminal unit</td>
</tr>
</tbody>
</table>
### Error 6.9.3.5 Error severity E11: Parameter errors

**Table 863: Error severity E11: Parameter errors**

<table>
<thead>
<tr>
<th>Error severity</th>
<th>Location</th>
<th>Error code</th>
<th>d1</th>
<th>d2</th>
<th>d3</th>
<th>d4</th>
<th>Description</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>E11 CPU</td>
<td>18</td>
<td>2</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>At least one parameter not found</td>
<td></td>
</tr>
<tr>
<td>E11 CPU</td>
<td>19</td>
<td>2</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>Unable to read at least one parameter value</td>
<td></td>
</tr>
<tr>
<td>E11 CPU</td>
<td>20</td>
<td>2</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>Invalid value of parameter &quot;LED&quot;</td>
<td></td>
</tr>
<tr>
<td>E11 CPU</td>
<td>21</td>
<td>2</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>Invalid value of parameter &quot;Battery&quot;</td>
<td></td>
</tr>
<tr>
<td>E11 CPU</td>
<td>24</td>
<td>2</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>Invalid value of parameter &quot;Diagnosis, stop on error class&quot;</td>
<td></td>
</tr>
<tr>
<td>E11 CPU</td>
<td>25</td>
<td>2</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>Invalid value of parameter &quot;Diagnosis, add Plc name to node name&quot;</td>
<td></td>
</tr>
<tr>
<td>E11 CPU</td>
<td>26</td>
<td>2</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>Invalid value of parameter &quot;Reboot at powerfail&quot;</td>
<td></td>
</tr>
<tr>
<td>E11 CPU</td>
<td>28</td>
<td>2</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>Value of parameter &quot;Missed Cycle Task behaviour&quot; is not in range</td>
<td></td>
</tr>
<tr>
<td>E11 CPU</td>
<td>30</td>
<td>2</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>Value of parameter &quot;Priority Scheme&quot; is not in range</td>
<td></td>
</tr>
<tr>
<td>Error</td>
<td>Location</td>
<td>Error code</td>
<td>d1</td>
<td>d2</td>
<td>d3</td>
<td>d4</td>
<td>Description</td>
<td>Remedy</td>
</tr>
<tr>
<td>--------</td>
<td>----------</td>
<td>------------</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>E11</td>
<td>CPU</td>
<td>40</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>1 (too big) or 2 (too small)</td>
<td>Value of parameter &quot;Reboot on E2&quot; is not in range</td>
<td></td>
</tr>
<tr>
<td>E11</td>
<td>CPU</td>
<td>50</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>1 (too big) or 2 (too small)</td>
<td>Invalid value of parameter &quot;Enable diagnosis history&quot;</td>
<td></td>
</tr>
<tr>
<td>E11</td>
<td>CPU</td>
<td>51</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>1 (too big) or 2 (too small)</td>
<td>Invalid value of parameter &quot;Maximum number of entries in diagnosis history&quot;</td>
<td></td>
</tr>
<tr>
<td>E11</td>
<td>CPU</td>
<td>52</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>1 (too big) or 2 (too small)</td>
<td>Invalid value of parameter &quot;Maximum size of extended diagnosis data in diagnosis history&quot;</td>
<td></td>
</tr>
<tr>
<td>E11</td>
<td>iob (I/O bus)</td>
<td>16133</td>
<td>Module number</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Output data size mismatch</td>
<td></td>
</tr>
<tr>
<td>E11</td>
<td>iob (I/O bus)</td>
<td>16134</td>
<td>Module number</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Input data size mismatch</td>
<td></td>
</tr>
<tr>
<td>E11</td>
<td>iob (I/O bus)</td>
<td>16145</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Error setting I/O bus master parameter</td>
<td></td>
</tr>
<tr>
<td>E11</td>
<td>iob (I/O bus)</td>
<td>16146</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Failed to start the parameterization of modules</td>
<td></td>
</tr>
<tr>
<td>E11</td>
<td>iob (I/O bus)</td>
<td>16147</td>
<td>Module number</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Failed setting parameters</td>
<td></td>
</tr>
<tr>
<td>E11</td>
<td>iob (I/O bus)</td>
<td>16149</td>
<td>Module number</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>No module data</td>
<td></td>
</tr>
<tr>
<td>E11</td>
<td>iob (I/O bus)</td>
<td>16246</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Failed to start the parameterization of modules</td>
<td></td>
</tr>
<tr>
<td>E11</td>
<td>iob (I/O bus)</td>
<td>16247</td>
<td>1..20</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Failed setting parameters</td>
<td></td>
</tr>
<tr>
<td>E11</td>
<td>iob (I/O bus)</td>
<td>16248</td>
<td>Module number</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Failed setting expected module</td>
<td></td>
</tr>
<tr>
<td>E11</td>
<td>iob (I/O bus)</td>
<td>16254</td>
<td>Module number</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Size of parameters expected by module differs from size provided by configuration</td>
<td></td>
</tr>
<tr>
<td>E11</td>
<td>iob (I/O bus)</td>
<td>16158</td>
<td>Module number</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Type of present module does not match configuration</td>
<td></td>
</tr>
</tbody>
</table>
### 6.9.3.6 Communication modules diagnosis

#### 6.9.3.6.1 Diagnosis display

**Table 864: Diagnosis messages of communication modules or fieldbuses**

<table>
<thead>
<tr>
<th>Error severity</th>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>E - CMx (communication module) x = slot number</td>
<td></td>
<td>To view these diagnosis messages use Automation Builder Chapter 6.9.1.4 “Diagnosis in Automation Builder” or IEC application Chapter 6.9.1.5 “Diagnosis in IEC application”</td>
</tr>
<tr>
<td>Ex CAN (CAN interface)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ex E11 or E12 (Ethernet ETH1 or ETH2)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### 6.9.3.6.2 CM579-ETHCAT

**Application example**
The principle of the EtherCAT diagnosis system and its use in the IEC application of an AC500 V3 PLC is described in the application example AC500 EtherCAT - Diagnosis with AC500 V3.

**Status codes**

<table>
<thead>
<tr>
<th>Hexadecimal Value</th>
<th>Definition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x00000000</td>
<td>TLR_S_OK</td>
<td>Status ok</td>
</tr>
<tr>
<td>0xC0650005</td>
<td>TLR_E_ETHERCAT_MASTER_ERROR OR_BUSSCAN_FAILED</td>
<td>Existing bus does not match configured bus.</td>
</tr>
<tr>
<td>0xC0650006</td>
<td>TLR_E_ETHERCAT_MASTER_NOT_ALL_SLAVES_AVAIL</td>
<td>Not all slaves are available.</td>
</tr>
<tr>
<td>0xC065000B</td>
<td>TLR_E_ETHERCAT_MASTER_INV_ALID_BUSCYCLETIME</td>
<td>The requested bus cycle time is invalid.</td>
</tr>
<tr>
<td>0xC065000C</td>
<td>TLR_E_ETHERCAT_MASTER_INV_ALID_BROKEN_SLAVE_BEHAVIOUR_PARA</td>
<td>Invalid parameter for broken slave behavior.</td>
</tr>
<tr>
<td>0xC065000F</td>
<td>TLR_E_ETHERCAT_MASTER_COE_INVALID_SLAVEID</td>
<td>Invalid Slaveld was used for CoE.</td>
</tr>
<tr>
<td>0xC0650012</td>
<td>TLR_E_ETHERCAT_MASTER_COE_INVALID_INDEX</td>
<td>Invalid Index on slave requested.</td>
</tr>
<tr>
<td>Hexadecimal Value</td>
<td>Definition Description</td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------</td>
<td></td>
</tr>
<tr>
<td>0xC0650013</td>
<td>TLR_E_ETHERCAT_MASTER_COMMUNICATION_STATE</td>
<td>Invalid bus communication state for CoE-Usage.</td>
</tr>
<tr>
<td>0xC0650014</td>
<td>TLR_E_ETHERCAT_MASTER_COMMUNICATION_ERROR_FRAME_LOST</td>
<td>Frame with CoE data is lost.</td>
</tr>
<tr>
<td>0xC0650015</td>
<td>TLR_E_ETHERCAT_MASTER_COMMUNICATION_ERROR_TIMEOUT</td>
<td>Timeout during CoE service.</td>
</tr>
<tr>
<td>0xC0650016</td>
<td>TLR_E_ETHERCAT_MASTER_COMMUNICATION_ERROR_SLAVE_NOT_ADDRESSABLE</td>
<td>Slave is not addressable (not on bus or power down?).</td>
</tr>
<tr>
<td>0xC0650017</td>
<td>TLR_E_ETHERCAT_MASTER_COMMUNICATION_ERROR_INVALID_LIST_TYPE</td>
<td>Invalid list type requested (during GetOdList).</td>
</tr>
<tr>
<td>0xC0650018</td>
<td>TLR_E_ETHERCAT_MASTER_COMMUNICATION_ERROR_SLAVE_RESPONSE_TOO_BIG</td>
<td>Data in slave response is too big for confirmation packet.</td>
</tr>
<tr>
<td>0xC0650019</td>
<td>TLR_E_ETHERCAT_MASTER_COMMUNICATION_ERROR_INVALID_ACCESSBITMASK</td>
<td>Invalid access mask selected (during GetEntryDesc).</td>
</tr>
<tr>
<td>0xC065001A</td>
<td>TLR_E_ETHERCAT_MASTER_COMMUNICATION_ERROR_WKC_ERROR</td>
<td>Slave Working Counter Error during CoE service.</td>
</tr>
<tr>
<td>0xC065001C</td>
<td>TLR_E_ETHERCAT_MASTER_COMMUNICATION_ERROR_INVALID_COMMUNICATION_STATE</td>
<td>Command is not usable in the communication state.</td>
</tr>
<tr>
<td>0xC065001E</td>
<td>TLR_E_ETHERCAT_MASTER_BUSSCAN_CURRENTLY_RUNNING</td>
<td>The scan is already running. It cannot be started twice at the same time.</td>
</tr>
<tr>
<td>0xC065001F</td>
<td>TLR_E_ETHERCAT_MASTER_BUSSCAN_TIMEOUT</td>
<td>Timeout during bus scan. But at least a link is established.</td>
</tr>
<tr>
<td>0xC0650020</td>
<td>TLR_E_ETHERCAT_MASTER_BUSSCAN_NOT_READY_YET</td>
<td>The bus scan was not started before or is not finish yet.</td>
</tr>
<tr>
<td>0xC0650021</td>
<td>TLR_E_ETHERCAT_MASTER_BUSSCAN_INVALID_SLAVE</td>
<td>The requested slave is invalid.</td>
</tr>
<tr>
<td>0xC0650022</td>
<td>TLR_E_ETHERCAT_MASTER_COMMUNICATION_ERROR_SLAVE_NOT_ACCESSIBLE</td>
<td>Slave does not allow reading or writing (CoE-Access).</td>
</tr>
<tr>
<td>0xC0650023</td>
<td>TLR_E_ETHERCAT_MASTER_COMMUNICATION_ERROR_NO_MBX_SUPPORT</td>
<td>Slave does not support a mailbox.</td>
</tr>
<tr>
<td>0xC0650024</td>
<td>TLR_E_ETHERCAT_MASTER_COMMUNICATION_ERROR_NO_COE_SUPPORT</td>
<td>Slave does not support CoE.</td>
</tr>
<tr>
<td>0xC0650025</td>
<td>TLR_E_ETHERCAT_MASTER_TASK_CREATION_FAILED</td>
<td>Task could not be created during runtime.</td>
</tr>
<tr>
<td>0xC0650026</td>
<td>TLR_E_ETHERCAT_MASTER_COMMUNICATION_ERROR_SLAVE_SM_CONFIGURATION</td>
<td>The Sync Manager configuration of a slave is invalid.</td>
</tr>
<tr>
<td>0xC0650027</td>
<td>TLR_E_ETHERCAT_MASTER_COMMUNICATION_ERROR_SDO_ABORTCODE_TOGGLE</td>
<td>SDO abort code: Toggle bit not alternated.</td>
</tr>
<tr>
<td>0xC0650028</td>
<td>TLR_E_ETHERCAT_MASTER_COMMUNICATION_ERROR_SDO_ABORTCODE_TIMEOUT</td>
<td>SDO abort code: SDO protocol timed out.</td>
</tr>
<tr>
<td>0xC0650029</td>
<td>TLR_E_ETHERCAT_MASTER_COMMUNICATION_ERROR_SDO_ABORTCODE_NET CS_SCS</td>
<td>SDO abort code: Client/server command specifier not valid or unknown.</td>
</tr>
<tr>
<td>0xC065002A</td>
<td>TLR_E_ETHERCAT_MASTER_COMMUNICATION_ERROR_SDO_ABORTCODE_BLK_SIZE</td>
<td>SDO abort code: Invalid block size (block mode only).</td>
</tr>
<tr>
<td>0xC065002B</td>
<td>TLR_E_ETHERCAT_MASTER_COMMUNICATION_ERROR_SDO_ABORTCODE_SEQNO</td>
<td>SDO abort code: Invalid sequence number (block mode only).</td>
</tr>
<tr>
<td>Hexadecimal Value</td>
<td>Definition</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>0xC065002C</td>
<td>TLR_E_ETHERCAT_MASTER_SD O_ABORTCODE_CRC</td>
<td>SDO abort code: CRC error (block mode only).</td>
</tr>
<tr>
<td>0xC065002D</td>
<td>TLR_E_ETHERCAT_MASTER_SD O_ABORTCODE_MEMORY</td>
<td>SDO abort code: Out of memory.</td>
</tr>
<tr>
<td>0xC065002E</td>
<td>TLR_E_ETHERCAT_MASTER_SD O_ABORTCODE_ACCESS</td>
<td>SDO abort code: Unsupported access to an object.</td>
</tr>
<tr>
<td>0xC065002F</td>
<td>TLR_E_ETHERCAT_MASTER_SD O_ABORTCODE_WRITEONLY</td>
<td>SDO abort code: Attempt to read a write only object.</td>
</tr>
<tr>
<td>0xC0650030</td>
<td>TLR_E_ETHERCAT_MASTER_SD O_ABORTCODE_READONLY</td>
<td>SDO abort code: Attempt to write a read only object.</td>
</tr>
<tr>
<td>0xC0650031</td>
<td>TLR_E_ETHERCAT_MASTER_SD O_ABORTCODE_INDEX</td>
<td>SDO abort code: Object does not exist in the object dictionary.</td>
</tr>
<tr>
<td>0xC0650032</td>
<td>TLR_E_ETHERCAT_MASTER_SD O_ABORTCODE_PDO_MAP</td>
<td>SDO abort code: Object cannot be mapped to the PDO.</td>
</tr>
<tr>
<td>0xC0650033</td>
<td>TLR_E_ETHERCAT_MASTER_SD O_ABORTCODE_PDO_LEN</td>
<td>SDO abort code: The number and length of the objects to be mapped would exceed PDO length.</td>
</tr>
<tr>
<td>0xC0650034</td>
<td>TLR_E_ETHERCAT_MASTER_SD O_ABORTCODE_P_INCOMP</td>
<td>SDO abort code: General parameter incompatibility reason.</td>
</tr>
<tr>
<td>0xC0650035</td>
<td>TLR_E_ETHERCAT_MASTER_SD O_ABORTCODE_I_INCOMP</td>
<td>SDO abort code: General internal incompatibility in the device.</td>
</tr>
<tr>
<td>0xC0650036</td>
<td>TLR_E_ETHERCAT_MASTER_SD O_ABORTCODE_HARDWARE</td>
<td>SDO abort code: Access failed due to an hardware error.</td>
</tr>
<tr>
<td>0xC0650037</td>
<td>TLR_E_ETHERCAT_MASTER_SD O_ABORTCODE_DATA_SIZE</td>
<td>SDO abort code: Data type does not match, length of service parameter does not match.</td>
</tr>
<tr>
<td>0xC0650038</td>
<td>TLR_E_ETHERCAT_MASTER_SD O_ABORTCODE_DATA_SIZE1</td>
<td>SDO abort code: Data type does not match, length of service parameter too high.</td>
</tr>
<tr>
<td>0xC0650039</td>
<td>TLR_E_ETHERCAT_MASTER_SD O_ABORTCODE_DATA_SIZE2</td>
<td>SDO abort code: Data type does not match, length of service parameter too low.</td>
</tr>
<tr>
<td>0xC065003A</td>
<td>TLR_E_ETHERCAT_MASTER_SD O_ABORTCODE_OFFSET</td>
<td>SDO abort code: Sub-index does not exist.</td>
</tr>
<tr>
<td>0xC065003B</td>
<td>TLR_E_ETHERCAT_MASTER_SD O_ABORTCODE_DATA_RANGE</td>
<td>SDO abort code: Range of values of parameter exceeded (only for write access).</td>
</tr>
<tr>
<td>0xC065003C</td>
<td>TLR_E_ETHERCAT_MASTER_SD O_ABORTCODE_DATA_RANGE1</td>
<td>SDO abort code: Value of parameter written too high.</td>
</tr>
<tr>
<td>0xC065003D</td>
<td>TLR_E_ETHERCAT_MASTER_SD O_ABORTCODE_DATA_RANGE2</td>
<td>SDO abort code: Value of parameter written too low.</td>
</tr>
<tr>
<td>0xC065003E</td>
<td>TLR_E_ETHERCAT_MASTER_SD O_ABORTCODE_MINMAX</td>
<td>SDO abort code: Maximum value is less than minimum value.</td>
</tr>
<tr>
<td>0xC065003F</td>
<td>TLR_E_ETHERCAT_MASTER_SD O_ABORTCODE_GENERAL</td>
<td>SDO abort code: General error.</td>
</tr>
<tr>
<td>0xC0650040</td>
<td>TLR_E_ETHERCAT_MASTER_SD O_ABORTCODE_TRANSFER</td>
<td>SDO abort code: Data cannot be transferred or stored to the application.</td>
</tr>
<tr>
<td>0xC0650041</td>
<td>TLR_E_ETHERCAT_MASTER_SD O_ABORTCODE_TRANSFER1</td>
<td>SDO abort code: Data cannot be transferred or stored to the application because of local control.</td>
</tr>
<tr>
<td>Hexadecimal Value</td>
<td>Definition</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>0xC0650042</td>
<td>TLR_E_ETHERCAT_MASTER_SD O_ABORTCODE_TRANSFER2</td>
<td>SDO abort code: Data cannot be transferred or stored to the application because of the present device state.</td>
</tr>
<tr>
<td>0xC0650043</td>
<td>TLR_E_ETHERCAT_MASTER_SD O_ABORTCODE_DICTIONARY</td>
<td>SDO abort code: Object dictionary dynamic generation fails or no object dictionary is present (e.g. object dictionary is generated from file and generation fails because of an file error).</td>
</tr>
<tr>
<td>0xC0650044</td>
<td>TLR_E_ETHERCAT_MASTER_SD O_ABORTCODE_UNKNOWN</td>
<td>SDO abort code: unknown code.</td>
</tr>
<tr>
<td>0xC0CC0001</td>
<td>ECM_ERROR_LLD_TIMEOUT</td>
<td>LLD: Timeout</td>
</tr>
<tr>
<td>0xC0CC0003</td>
<td>ECM_ERROR_LLD_UNSUP- PORTED_COMMAND</td>
<td>LLD: Unsupported command</td>
</tr>
<tr>
<td>0xC0CC0004</td>
<td>ECM_ERROR_LLD_DUPLI- CATE_FIXED_STATION_ADDRESS</td>
<td>LLD: Duplicate fixed station address</td>
</tr>
<tr>
<td>0xC0CC0005</td>
<td>ECM_ERROR_LLD_SII_CHECKSU M_ERROR</td>
<td>LLD: SII Checksum Error</td>
</tr>
<tr>
<td>0xC0CC0006</td>
<td>ECM_ERROR_LLD_SII_EEPROM_ LOADING_ERROR</td>
<td>LLD: SII EEPROM Loading Error</td>
</tr>
<tr>
<td>0xC0CC0007</td>
<td>ECM_ERROR_LLD_SII_MISSING_ ERROR_ACK</td>
<td>LLD: SII Missing Error Ack</td>
</tr>
<tr>
<td>0xC0CC0008</td>
<td>ECM_ERROR_LLD_STATE_CHAN GE_FAILED</td>
<td>LLD: State Change Failed</td>
</tr>
<tr>
<td>0xC0CC0009</td>
<td>ECM_ERROR_LLD_UNEX- PECTED_AL_STATUS</td>
<td>LLD: Unexpected AL Status</td>
</tr>
<tr>
<td>0xC0CC000A</td>
<td>ECM_ERROR_LLD_UNEX- PECTED_WKC</td>
<td>LLD: Unexpected WKC</td>
</tr>
<tr>
<td>0xC0CC000B</td>
<td>ECM_ERROR_LLD_MAILBOX_NO T_AVAILABLE</td>
<td>LLD: Mailbox not available</td>
</tr>
<tr>
<td>0xC0CC000C</td>
<td>ECM_ERROR_LLD_MAILBOX_MESS AGE_TOO_LARGE</td>
<td>LLD: Mailbox message too large</td>
</tr>
<tr>
<td>0xC0CC000D</td>
<td>ECM_ERROR_LLD_Configura TION_IN_PROGRESS</td>
<td>LLD: Configuration in progress</td>
</tr>
<tr>
<td>0xC0CC000E</td>
<td>ECM_ERROR_LLD_TOO_MANY_C YCLIC_FRAMES</td>
<td>LLD: Too many cyclic frames</td>
</tr>
<tr>
<td>0xC0CC000F</td>
<td>ECM_ERROR_LLD_CYCLIC_FRA ME_EXCEEDS_MTU</td>
<td>LLD: Cyclic frame exceeds MTU</td>
</tr>
<tr>
<td>0xC0CC0010</td>
<td>ECM_ERROR_LLD_INVALID_CYCL IC_TELEGRAM_CONFIG</td>
<td>LLD: Invalid cyclic telegram config</td>
</tr>
<tr>
<td>0xC0CC0011</td>
<td>ECM_ERROR_LLD_BUILDING_CO PY_ROUTINES_FAILED</td>
<td>LLD: Building copy routines failed</td>
</tr>
<tr>
<td>0xC0CC0012</td>
<td>ECM_ERROR_LLD_UNSUP- PORTED_SLAVE_STA- TION_ADDRESS</td>
<td>LLD: Unsupported slave station address</td>
</tr>
<tr>
<td>0xC0CC0013</td>
<td>ECM_ERROR_LLD_STA- TION_ADDRESS_NOT_ALLOWED</td>
<td>LLD: Station Address not allowed</td>
</tr>
<tr>
<td>0xC0CC0014</td>
<td>ECM_ERROR_LLD_INVALID_STD_ TX_MBX_PHY_OFFSET</td>
<td>LLD: Invalid Std TxMbx PhysOffset</td>
</tr>
<tr>
<td>Hexadecimal Value</td>
<td>Definition</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>0xC0CC0015</td>
<td>ECM_ERROR_LLD_INVALID_STD_RX_MBX_PHYS_OFFSET</td>
<td>LLD: Invalid Std Rx Mbx PhysOffset</td>
</tr>
<tr>
<td>0xC0CC0016</td>
<td>ECM_ERROR_LLD_INVALID_BOOT_T_TX_MBX_PHYS_OFFSET</td>
<td>LLD: Invalid BOOT Rx Mbx Phys-Offset</td>
</tr>
<tr>
<td>0xC0CC0017</td>
<td>ECM_ERROR_LLD_INVALID_BOOT_T_RX_MBX_PHYS_OFFSET</td>
<td>LLD: Invalid BOOT Tx Mbx Phys-Offset</td>
</tr>
<tr>
<td>0xC0CC0018</td>
<td>ECM_ERROR_LLD_INVALID_STD_TX_MBX_SM_NO</td>
<td>LLD: Invalid Std Tx Mbx SmNo</td>
</tr>
<tr>
<td>0xC0CC0019</td>
<td>ECM_ERROR_LLD_INVALID_STD_RX_MBX_SM_NO</td>
<td>LLD: Invalid Std Rx Mbx SmNo</td>
</tr>
<tr>
<td>0xC0CC001A</td>
<td>ECM_ERROR_LLD_INVALID_BOOT_T_TX_MBX_SM_NO</td>
<td>LLD: Invalid BOOT Tx Mbx SmNo</td>
</tr>
<tr>
<td>0xC0CC001B</td>
<td>ECM_ERROR_LLD_INVALID_BOOT_T_RX_MBX_SM_NO</td>
<td>LLD: Invalid BOOT Rx Mbx SmNo</td>
</tr>
<tr>
<td>0xC0CC001C</td>
<td>ECM_ERROR_LLD_UNCONFIGURED_SLAVE_STATION_ADDRESS</td>
<td>LLD: Unconfigured slave station address</td>
</tr>
<tr>
<td>0xC0CC001D</td>
<td>ECM_ERROR_LLD_WRONG_SLAVE_STATE</td>
<td>LLD: Wrong slave state</td>
</tr>
<tr>
<td>0xC0CC001E</td>
<td>ECM_ERROR_LLD_CYCLE_TIME_TOO_SMALL</td>
<td>LLD: Cycle time too small</td>
</tr>
<tr>
<td>0xC0CC001F</td>
<td>ECM_ERROR_LLD_REPETITION_COUNT_NOT_SUPPORTED</td>
<td>LLD: Repetition count not supported</td>
</tr>
<tr>
<td>0xC0CC0020</td>
<td>ECM_ERROR_LLD_INVALID_CALLBACK_TYPE</td>
<td>LLD: Invalid callback type</td>
</tr>
<tr>
<td>0xC0CC0021</td>
<td>ECM_ERROR_LLD_INVALID_CYCLE_MULTIPLIER</td>
<td>LLD: Invalid cycle multiplier</td>
</tr>
<tr>
<td>0xC0CC0022</td>
<td>ECM_ERROR_LLD_UNKNOWN_ERROR</td>
<td>LLD: Unknown Error</td>
</tr>
<tr>
<td>0xC0CC0023</td>
<td>ECM_ERROR_LLD_INVALID_REG_LENGTH</td>
<td>LLD: Invalid reg length</td>
</tr>
<tr>
<td>0xC0CC0024</td>
<td>ECM_ERROR_LLD_INVALID_PARAMETER</td>
<td>LLD: Invalid parameter</td>
</tr>
<tr>
<td>0xC0CC0025</td>
<td>ECM_ERROR_LLD_IRQ_NOT_AVAILABLE</td>
<td>LLD: IRQ not available</td>
</tr>
<tr>
<td>0xC0CC0026</td>
<td>ECM_ERROR_LLD_IOMEM_IRQ_NOT_AVAILABLE</td>
<td>LLD: IOMem Irq not available</td>
</tr>
<tr>
<td>0xC0CC0027</td>
<td>ECM_ERROR_LLD_HW_INIT_FAILED</td>
<td>LLD: Hardware init failed</td>
</tr>
<tr>
<td>0xC0CC0028</td>
<td>ECM_ERROR_LLD_MUTEX_CREATION_FAILED</td>
<td>LLD: Mutex creation failed</td>
</tr>
<tr>
<td>0xC0CC0029</td>
<td>ECM_ERROR_LLD_DC_RX_LATCH_COMMAND_REQUIRED_FOR_DC</td>
<td>LLD: DC Rx Latch command is not configured within cyclic frames</td>
</tr>
<tr>
<td>0xC0CC002A</td>
<td>ECM_ERROR_LLD_TX_PROCESS_IMAGE_EXCEEDED</td>
<td>LLD: Transmit process image is exceeded</td>
</tr>
<tr>
<td>0xC0CC002B</td>
<td>ECM_ERROR_LLD_RX_PROCESS_IMAGE_EXCEEDED</td>
<td>LLD: Receive process image is exceeded</td>
</tr>
<tr>
<td>0xC0CC002C</td>
<td>ECM_ERROR_LLD_MBX_STATE_IMAGE_EXCEEDED</td>
<td>LLD: Mailbox State image is exceeded</td>
</tr>
<tr>
<td>Hexadecimal Value</td>
<td>Definition</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>0xC0CC002D</td>
<td>ECM_ERROR_LLD_RESULT_DUPPLICATE_BWR_RX_LATCH_CMD</td>
<td>LLD: Duplicate BWR Rx DC Latch command detected in cyclic frames</td>
</tr>
<tr>
<td>0xC0CC002E</td>
<td>ECM_ERROR_LLD_RESULT_DUPPLICATE_EXT_SYSTIME_CONTROL_CMD</td>
<td>LLD: Duplicate External Sync Sys-Time Control command detected in cyclic frames</td>
</tr>
<tr>
<td>0xC0CC002F</td>
<td>ECM_ERROR_LLD_CC_PROCESS_IMAGE_EXCEEDED</td>
<td>LLD: Cross Communication Process image exceeded</td>
</tr>
<tr>
<td>0x40CD0017</td>
<td>ECM_INFO_EMC_BUS_IS_OFF</td>
<td>Bus is off</td>
</tr>
<tr>
<td>0xC0CD0001</td>
<td>ECM_ERROR_EMC_REQUEST_DESTINATION_PROBLEM</td>
<td>Request Destination Problem</td>
</tr>
<tr>
<td>0xC0CD0002</td>
<td>ECM_ERROR_EMC_INVALID_SLAVE_STATION_ADDRESS</td>
<td>Invalid slave station address</td>
</tr>
<tr>
<td>0xC0CD0003</td>
<td>ECM_ERROR_EMC_CONFIGURATION_BUFFER_IS_OPEN</td>
<td>Configuration buffer is open</td>
</tr>
<tr>
<td>0xC0CD0004</td>
<td>ECM_ERROR_EMC_WRONG_STATE_FOR_RECONFIGURATION</td>
<td>Wrong state for reconfiguration</td>
</tr>
<tr>
<td>0xC0CD0005</td>
<td>ECM_ERROR_EMC_CONFIGURATION_BUFFER_IS_NOT_OPEN</td>
<td>Configuration buffer is not open</td>
</tr>
<tr>
<td>0xC0CD0006</td>
<td>ECM_ERROR_EMC_SLAVE_STATION_ADDRESS_ALREADY_IN_CONFIG</td>
<td>Slave station address already in config</td>
</tr>
<tr>
<td>0xC0CD0007</td>
<td>ECM_ERROR_EMC_INVALID_STD_MBX_PARAMETERS</td>
<td>Invalid Std Mbx parameters</td>
</tr>
<tr>
<td>0xC0CD0008</td>
<td>ECM_ERROR_EMC_INVALID_BOOT_MBX_PARAMETERS</td>
<td>Invalid BOOT Mbx parameters</td>
</tr>
<tr>
<td>0xC0CD0009</td>
<td>ECM_ERROR_EMC_STD_MBX_SM_ARE_OVERLAPPING</td>
<td>Std Mbx SMs are overlapping</td>
</tr>
<tr>
<td>0xC0CD000A</td>
<td>ECM_ERROR_EMC_BOOT_MBX_SM_ARE_OVERLAPPING</td>
<td>BOOT Mbx SMs are overlapping</td>
</tr>
<tr>
<td>0xC0CD000B</td>
<td>ECM_ERROR_EMC_SM_PARAMS_ALREADY_ADDED</td>
<td>SM Params already added</td>
</tr>
<tr>
<td>0xC0CD000C</td>
<td>ECM_ERROR_EMC_INVALID_SM_NUMBER</td>
<td>Invalid SM number</td>
</tr>
<tr>
<td>0xC0CD000D</td>
<td>ECM_ERROR_EMC_FMMU_PARAMETERS_ALREADY_ADDED</td>
<td>FMMU params already added</td>
</tr>
<tr>
<td>0xC0CD000E</td>
<td>ECM_ERROR_EMC_INVALID_FMMU_NUMBER</td>
<td>Invalid FMMU number</td>
</tr>
<tr>
<td>0xC0CD000F</td>
<td>ECM_ERROR_EMC_INVALID_MIN_STATE</td>
<td>Invalid min state</td>
</tr>
<tr>
<td>0xC0CD0010</td>
<td>ECM_ERROR_EMC_CYCLE_FRAME_AMOUNT_EXCEEDED</td>
<td>Cycle frame amount exceeded</td>
</tr>
<tr>
<td>0xC0CD0011</td>
<td>ECM_ERROR_EMC_INVALID_CYCLE_FRAME_IN_CONFIGURATION</td>
<td>Invalid cycle frame in configuration</td>
</tr>
<tr>
<td>0xC0CD0012</td>
<td>ECM_ERROR_EMC_CYCLE_FRAME_INDEX_NOT_VALID</td>
<td>Cycle frame index not valid</td>
</tr>
<tr>
<td>0xC0CD0013</td>
<td>ECM_ERROR_EMC_INVALID_TELEGRAM_LENGTH</td>
<td>Invalid telegram length</td>
</tr>
<tr>
<td>0xC0CD0014</td>
<td>ECM_ERROR_EMC_CYCLE_FRAME_LENGTH_EXCEEDED</td>
<td>Cycle frame length exceeded</td>
</tr>
<tr>
<td>Hexadecimal Value</td>
<td>Definition</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>0xC0CD0015</td>
<td>ECM_ERROR_EMC_AMOUNT_OF_TELEGRAMS_IN_CYCLIC_FRAME_EXCEEDED</td>
<td>Amount of telegrams in cyclic frame exceeded</td>
</tr>
<tr>
<td>0xC0CD0016</td>
<td>ECM_ERROR_EMC_STATE_CHANGE_IN_PROGRESS</td>
<td>State change in progress</td>
</tr>
<tr>
<td>0xC0CD0018</td>
<td>ECM_ERROR_EMC_TOO_MANY_SLAVES_GIVEN</td>
<td>Too many slaves given</td>
</tr>
<tr>
<td>0xC0CD0019</td>
<td>ECM_ERROR_EMC_DUPLICATE_STATION_ADDRESS_IN_LIST</td>
<td>Duplicate station address in list</td>
</tr>
<tr>
<td>0xC0CD001A</td>
<td>ECM_ERROR_EMC_COMMAND_TYPE_NOT_ALLOWED_FOR_SLAVE_FSM</td>
<td>Command type not allowed for slave FSM</td>
</tr>
<tr>
<td>0xC0CD001B</td>
<td>ECM_ERROR_EMC_CONFIGURATION_DATA_INCORRECT</td>
<td>Configuration data incorrect</td>
</tr>
<tr>
<td>0xC0CD001C</td>
<td>ECM_ERROR_EMC_VENDORID_MISMATCH</td>
<td>VendorID mismatch</td>
</tr>
<tr>
<td>0xC0CD001D</td>
<td>ECM_ERROR_EMC_PRODUCTCODE_MISMATCH</td>
<td>ProductCode mismatch</td>
</tr>
<tr>
<td>0xC0CD001E</td>
<td>ECM_ERROR_EMC_REVISION_MISMATCH</td>
<td>Revision number mismatch</td>
</tr>
<tr>
<td>0xC0CD001F</td>
<td>ECM_ERROR_EMC_SERIALNO_MISMATCH</td>
<td>Serial number mismatch</td>
</tr>
<tr>
<td>0xC0CD0020</td>
<td>ECM_ERROR_EMC_LOST_CONNECTION</td>
<td>Lost connection</td>
</tr>
<tr>
<td>0xC0CD0021</td>
<td>ECM_ERROR_EMC_UNKNOWN_STATE_CHANGE_HAPPENED</td>
<td>Unknown state change happened</td>
</tr>
<tr>
<td>0xC0CD0022</td>
<td>ECM_ERROR_EMC_UNEXPECTED_STATE_CHANGE_HAPPENED</td>
<td>Unexpected state change happened</td>
</tr>
<tr>
<td>0xC0CD0023</td>
<td>ECM_ERROR_EMC_SLAVE_CHANGED_STATE</td>
<td>Slave changed state</td>
</tr>
<tr>
<td>0xC0CD0026</td>
<td>ECM_ERROR_EMC_DC_RX_TIMESTAMP_ERROR</td>
<td>DC Rx Timestamp error</td>
</tr>
<tr>
<td>0xC0CD0027</td>
<td>ECM_ERROR_EMC_DC_MASTER_PORT_TIMESTAMP_ERROR</td>
<td>DC master port timestamp error</td>
</tr>
<tr>
<td>0xC0CD0028</td>
<td>ECM_ERROR_EMC_INVALID_SLAVE_INDEX</td>
<td>Invalid slave index</td>
</tr>
<tr>
<td>0xC0CD0029</td>
<td>ECM_ERROR_EMC_WRONG_MASTER_STATE</td>
<td>Invalid Master state</td>
</tr>
<tr>
<td>0xC0CD002A</td>
<td>ECM_ERROR_EMC_INVALID_TRANSFER_ID</td>
<td>Invalid Transfer Id</td>
</tr>
<tr>
<td>0xC0CD002B</td>
<td>ECM_ERROR_EMC_INVALID_SEGMENTATION</td>
<td>Invalid Segmentation</td>
</tr>
<tr>
<td>0xC0CD002C</td>
<td>ECM_ERROR_EMC_EOE_PARAMS_ALREADY_ADDED</td>
<td>EoE IP Params already added</td>
</tr>
<tr>
<td>0xC0CD002D</td>
<td>ECM_ERROR_EMC_EOE_SUPPORT_NOT_AVAILABLE</td>
<td>EoE support not available</td>
</tr>
<tr>
<td>Hexadecimal Value</td>
<td>Definition</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>0xC0CD002E</td>
<td>ECM_ERROR_EMC_END_CONFIGURATION_IN_PROGRESS</td>
<td>End configuration in progress</td>
</tr>
<tr>
<td>0xC0CD002F</td>
<td>ECM_ERROR_EMC_WRONG_STATE_FOR_RECONFIGURATION_BUS_IS_ON</td>
<td>Wrong state for reconfiguration (Bus Is On)</td>
</tr>
<tr>
<td>0xC0CD0030</td>
<td>ECM_ERROR_EMC_WRONG_STATE_FOR_RECONFIGURATION_BUS_SCAN_ACTIVE</td>
<td>Wrong state for reconfiguration (Bus Scan Active)</td>
</tr>
<tr>
<td>0xC0CD0031</td>
<td>ECM_ERROR_EMC_WRONG_STATE_FOR_RECONFIGURATION_IN_PROGRESS_TO_BUS_OFF</td>
<td>Wrong state for reconfiguration (In Progress to Bus off)</td>
</tr>
<tr>
<td>0xC0CD0032</td>
<td>ECM_ERROR_EMC_NO_DIAG_ENTRY_AVAILABLE</td>
<td>No Diag Entry available</td>
</tr>
<tr>
<td>0xC0CD0033</td>
<td>ECM_ERROR_EMC_SLAVE_SYNC_PARAMS_NOT_POSIBLE_WITHOUT_WORKING_DC</td>
<td>A slave has been configured to have SYNC0 and/or SYNC1 but does not support DC at all.</td>
</tr>
<tr>
<td>0xC0CD0034</td>
<td>ECM_ERROR_EMC_MANDATORY_SLAVE_MISSING</td>
<td>At least one required slave for boot up is missing.</td>
</tr>
<tr>
<td>0xC0CD0035</td>
<td>ECM_ERROR_EMC_WRONG_SLAVE_AT_POSITION</td>
<td>A wrong slave at a specific position has been detected.</td>
</tr>
<tr>
<td>0xC0CD0036</td>
<td>ECM_ERROR_EMC_NO_DC_REF_CLOCK</td>
<td>No DC reference clock</td>
</tr>
<tr>
<td>0xC0CD0037</td>
<td>ECM_ERROR_EMC_DC_REF_CLOCK_DOES_NOT_PROVIDE_64BIT</td>
<td>DC Reference clock does not provide 64 Bit</td>
</tr>
<tr>
<td>0xC0CD0038</td>
<td>ECM_ERROR_EMC_INVALID_DC_REF_CLOCK</td>
<td>Invalid DC Reference clock</td>
</tr>
<tr>
<td>0xC0CD0039</td>
<td>ECM_ERROR_EMC_COE_SUPPORT_NOT_AVAILABLE</td>
<td>CoE support not available</td>
</tr>
<tr>
<td>0xC0CD003A</td>
<td>ECM_ERROR_EMC_SOE_SUPPORT_NOT_AVAILABLE</td>
<td>SoE support not available</td>
</tr>
<tr>
<td>0xC0CD003B</td>
<td>ECM_ERROR_EMC_FOE_SUPPORT_NOT_AVAILABLE</td>
<td>FoE support not available</td>
</tr>
<tr>
<td>0xC0CD003C</td>
<td>ECM_ERROR_EMC_AOE_SUPPORT_NOT_AVAILABLE</td>
<td>AoE support not available</td>
</tr>
<tr>
<td>0x40CD003E</td>
<td>ECM_INFO_EMC_RECONNECTED</td>
<td>Reconnected</td>
</tr>
<tr>
<td>0x80CD003F</td>
<td>ECM_WARN_EMC_DC_STOPPED</td>
<td>DC stopped</td>
</tr>
<tr>
<td>0xC0CD0040</td>
<td>ECM_ERROR_EMC_STOPPED_DUE_SYNC_ERROR</td>
<td>Stopped due Sync Error</td>
</tr>
<tr>
<td>0xC0CD0041</td>
<td>ECM_ERROR_EMC_MANDATORY_SLAVE_NOT_IN_OP</td>
<td>At least one mandatory slave is not in OP</td>
</tr>
<tr>
<td>0xC0CD0042</td>
<td>ECM_ERROR_EMC_BUS_CYCLE_TIME_NOT_POSSIBLE</td>
<td>Bus Cycle Time not possible</td>
</tr>
<tr>
<td>0xC0CD0043</td>
<td>ECM_ERROR_EMC_TOPOLOGY_ERROR_DETECTED</td>
<td>Topology error detected</td>
</tr>
<tr>
<td>0xC0CD0044</td>
<td>ECM_ERROR_EMC_TOPOLOGY_MISMATCH_DETECTED</td>
<td>Topology mismatch detected</td>
</tr>
<tr>
<td>0xC0CD0045</td>
<td>ECM_ERROR_EMC_NO_VALID_TOPOLOGY_CONFIGURATION_DATA</td>
<td>No valid topology configuration data</td>
</tr>
<tr>
<td>Hexadecimal Value</td>
<td>Definition</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>0xC0CD0046</td>
<td>ECM_ERROR_EMC_UNEXPECTED_SLAVE_AT_PORT0</td>
<td>Unexpected slave at port 0 of slave.</td>
</tr>
<tr>
<td>0xC0CD0047</td>
<td>ECM_ERROR_EMC_UNEXPECTED_SLAVE_AT_PORT1</td>
<td>Unexpected slave at port 1 of slave.</td>
</tr>
<tr>
<td>0xC0CD0048</td>
<td>ECM_ERROR_EMC_UNEXPECTED_SLAVE_AT_PORT2</td>
<td>Unexpected slave at port 2 of slave.</td>
</tr>
<tr>
<td>0xC0CD0049</td>
<td>ECM_ERROR_EMC_UNEXPECTED_SLAVE_AT_PORT3</td>
<td>Unexpected slave at port 3 of slave.</td>
</tr>
<tr>
<td>0xC0CD004A</td>
<td>ECM_ERROR_EMC_UNEXPECTED_SLAVE_RECONNECTED</td>
<td>-</td>
</tr>
<tr>
<td>0xC0CD004B</td>
<td>ECM_ERROR_EMC_UNEXPECTED_MISSING_SLAVE_AT_PORT0</td>
<td>Missing slave at port 0 of slave.</td>
</tr>
<tr>
<td>0xC0CD004C</td>
<td>ECM_ERROR_EMC_UNEXPECTED_MISSING_SLAVE_AT_PORT1</td>
<td>Missing slave at port 1 of slave.</td>
</tr>
<tr>
<td>0xC0CD004D</td>
<td>ECM_ERROR_EMC_UNEXPECTED_MISSING_SLAVE_AT_PORT2</td>
<td>Missing slave at port 2 of slave.</td>
</tr>
<tr>
<td>0xC0CD004E</td>
<td>ECM_ERROR_EMC_UNEXPECTED_MISSING_SLAVE_AT_PORT3</td>
<td>Missing slave at port 3 of slave.</td>
</tr>
<tr>
<td>0xC0CD004F</td>
<td>ECM_ERROR_EMC_SLAVE_NOT_CHECKED</td>
<td>Slave is not checked.</td>
</tr>
<tr>
<td>0xC0CD0050</td>
<td>ECM_ERROR_EMC_UNEXPECTED_SLAVE_AT_PORT0_1</td>
<td>Unexpected slave at port 0 and 1 of slave.</td>
</tr>
<tr>
<td>0xC0CD0051</td>
<td>ECM_ERROR_EMC_UNEXPECTED_SLAVE_AT_PORT0_2</td>
<td>Unexpected slave at port 0 and 2 of slave.</td>
</tr>
<tr>
<td>0xC0CD0052</td>
<td>ECM_ERROR_EMC_UNEXPECTED_SLAVE_AT_PORT0_3</td>
<td>Unexpected slave at port 0 and 3 of slave.</td>
</tr>
<tr>
<td>0xC0CD0053</td>
<td>ECM_ERROR_EMC_UNEXPECTED_SLAVE_AT_PORT1_2</td>
<td>Unexpected slave at port 1 and 2 of slave.</td>
</tr>
<tr>
<td>0xC0CD0054</td>
<td>ECM_ERROR_EMC_UNEXPECTED_SLAVE_AT_PORT1_3</td>
<td>Unexpected slave at port 1 and 3 of slave.</td>
</tr>
<tr>
<td>0xC0CD0055</td>
<td>ECM_ERROR_EMC_UNEXPECTED_SLAVE_AT_PORT2_3</td>
<td>Unexpected slave at port 2 and 3 of slave.</td>
</tr>
<tr>
<td>0xC0CD0056</td>
<td>ECM_ERROR_EMC_UNEXPECTED_SLAVE_AT_PORT0_1_2</td>
<td>Unexpected slave at port 0, 1 and 2 of slave.</td>
</tr>
<tr>
<td>0xC0CD0057</td>
<td>ECM_ERROR_EMC_UNEXPECTED_SLAVE_AT_PORT0_1_3</td>
<td>Unexpected slave at port 0, 1 and 3 of slave.</td>
</tr>
<tr>
<td>0xC0CD0058</td>
<td>ECM_ERROR_EMC_UNEXPECTED_SLAVE_AT_PORT0_2_3</td>
<td>Unexpected slave at port 0, 2 and 3 of slave.</td>
</tr>
<tr>
<td>0xC0CD0059</td>
<td>ECM_ERROR_EMC_UNEXPECTED_SLAVE_AT_PORT1_2_3</td>
<td>Unexpected slave at port 1, 2 and 3 of slave.</td>
</tr>
<tr>
<td>0xC0CD005A</td>
<td>ECM_ERROR_EMC_MISSING_SLAVE_AT_PORT0_1</td>
<td>Missing slave at port 0 and 1 of slave.</td>
</tr>
<tr>
<td>0xC0CD005B</td>
<td>ECM_ERROR_EMC_MISSING_SLAVE_AT_PORT0_2</td>
<td>Missing slave at port 0 and 2 of slave.</td>
</tr>
<tr>
<td>0xC0CD005C</td>
<td>ECM_ERROR_EMC_MISSING_SLAVE_AT_PORT0_3</td>
<td>Missing slave at port 0 and 3 of slave.</td>
</tr>
<tr>
<td>Hexadecimal Value</td>
<td>Definition</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>0xC0CD005D</td>
<td>ECM_ERROR_EMC_MISSING_SLAVE_AT_PORT1_2</td>
<td>Missing slave at port 1 and 2 of slave.</td>
</tr>
<tr>
<td>0xC0CD005E</td>
<td>ECM_ERROR_EMC_MISSING_SLAVE_AT_PORT1_3</td>
<td>Missing slave at port 1 and 3 of slave.</td>
</tr>
<tr>
<td>0xC0CD005F</td>
<td>ECM_ERROR_EMC_MISSING_SLAVE_AT_PORT2_3</td>
<td>Missing slave at port 2 and 3 of slave.</td>
</tr>
<tr>
<td>0xC0CD0060</td>
<td>ECM_ERROR_EMC_MISSING_SLAVE_AT_PORT0_1_2</td>
<td>Missing slave at port 0, 1 and 2 of slave.</td>
</tr>
<tr>
<td>0xC0CD0061</td>
<td>ECM_ERROR_EMC_MISSING_SLAVE_AT_PORT0_1_3</td>
<td>Missing slave at port 0, 1 and 3 of slave.</td>
</tr>
<tr>
<td>0xC0CD0062</td>
<td>ECM_ERROR_EMC_MISSING_SLAVE_AT_PORT0_2_3</td>
<td>Missing slave at port 0, 2 and 3 of slave.</td>
</tr>
<tr>
<td>0xC0CD0063</td>
<td>ECM_ERROR_EMC_MISSING_SLAVE_AT_PORT1_2_3</td>
<td>Missing slave at port 1, 2 and 3 of slave.</td>
</tr>
<tr>
<td>0xC0CD0065</td>
<td>ECM_ERROR_EMC_HC_PARTICIPANT_NOT_ALLOWED_IN_MANDATORY_SLAVE_LIST</td>
<td>A Hot Connect group participant is not allowed to be configured a mandatory slave</td>
</tr>
<tr>
<td>0xC0CD0066</td>
<td>ECM_ERROR_EMC_HC_PARTICIPANT_NOT_ALLOWED_IN_MULTIPLE_HC_GROUPS</td>
<td>A Hot Connect group participant is not allowed to be configured in multiple Hot Connect groups</td>
</tr>
<tr>
<td>0xC0CD0067</td>
<td>ECM_ERROR_EMC_GC_GROUP_HEAD_IS_NOT_LISTED_FOR_HC_DETECTION</td>
<td>Hot Connect group head is not listed for Hot Connect detection</td>
</tr>
<tr>
<td>0xC0CD0068</td>
<td>ECM_ERROR_EMC_DC_SETUP_CALCULATION_ERROR</td>
<td>DC Setup calculation has encountered an error</td>
</tr>
<tr>
<td>0xC0CD0069</td>
<td>ECM_ERROR_EMC_NON_DC_SLAVE_MORE_THAN_2_PORTS_IN_DC_SETUP</td>
<td>A slave, which does not support DC, has more than 2 ports in a DC setup</td>
</tr>
<tr>
<td>0xC0CD006A</td>
<td>ECM_ERROR_EMC_GC_GROUP_CONTAINS_NOT_CONFIGURED_SLAVE</td>
<td>A Hot Connect group has been defined to include a slave address that has no configuration</td>
</tr>
<tr>
<td>0xC0CD006B</td>
<td>ECM_ERROR_EMC_ALCONTROL_TIMEOUT</td>
<td>AL Control Timeout happened i.e. a slave ESM state change was not completed in time</td>
</tr>
<tr>
<td>0xC0CD006C</td>
<td>ECM_ERROR_EMC_DC_MEASUREMENT_ERROR</td>
<td>DC measurement encountered an error</td>
</tr>
<tr>
<td>0xC0CD006D</td>
<td>ECM_ERROR_EMC_RX_DESTINATION_EXCEEDS_RX_IMAGE_SIZE</td>
<td>Receive destination exceeds receive image size</td>
</tr>
<tr>
<td>0xC0CD006E</td>
<td>ECM_ERROR_EMC_TX_SOURCE_EXCEEDS_TX_IMAGE_SIZE</td>
<td>Transmit source exceeds transmit image size</td>
</tr>
<tr>
<td>0xC0CD006F</td>
<td>ECM_ERROR_EMC_WCSTATEBIT_EXCEEDS_RX_IMAGE_SIZE</td>
<td>WcState bit placement exceeds receive image size</td>
</tr>
<tr>
<td>0xC0CD0070</td>
<td>ECM_ERROR_EMC_WKC_MAPPING_EXCEEDS_RX_IMAGE_SIZE</td>
<td>Wkc value placement exceeds receive image size</td>
</tr>
<tr>
<td>0xC0CD0071</td>
<td>ECM_ERROR_EMC_DC_RX_LATCH_ERROR_AT_PORT0</td>
<td>DC Latch Error detected at port 0 of slave</td>
</tr>
<tr>
<td>0xC0CD0072</td>
<td>ECM_ERROR_EMC_DC_RX_LATCH_ERROR_AT_PORT1</td>
<td>DC Latch Error detected at port 1 of slave</td>
</tr>
<tr>
<td>0xC0CD0073</td>
<td>ECM_ERROR_EMC_DC_RX_LATCH_ERROR_AT_PORT2</td>
<td>DC Latch Error detected at port 2 of slave</td>
</tr>
<tr>
<td>Hexadecimal Value</td>
<td>Definition Description</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>0xC0CD0074</td>
<td>ECM_ERROR_EM.EC_DC_RX_LATC H_ERROR_AT_PORT3</td>
<td>DC Latch Error detected at port 3 of slave</td>
</tr>
<tr>
<td>0xC0CD0075</td>
<td>ECM_ERROR_EM.EC_DC_RX_LATC H_ERROR_AT_PORT0_1</td>
<td>DC Latch Error detected at ports 0 and 1 of slave</td>
</tr>
<tr>
<td>0xC0CD0076</td>
<td>ECM_ERROR_EM.EC_DC_RX_LATC H_ERROR_AT_PORT0_2</td>
<td>DC Latch Error detected at ports 0 and 2 of slave</td>
</tr>
<tr>
<td>0xC0CD0077</td>
<td>ECM_ERROR_EM.EC_DC_RX_LATC H_ERROR_AT_PORT0_3</td>
<td>DC Latch Error detected at ports 0 and 3 of slave</td>
</tr>
<tr>
<td>0xC0CD0078</td>
<td>ECM_ERROR_EM.EC_DC_RX_LATC H_ERROR_AT_PORT1_2</td>
<td>DC Latch Error detected at ports 1 and 2 of slave</td>
</tr>
<tr>
<td>0xC0CD0079</td>
<td>ECM_ERROR_EM.EC_DC_RX_LATC H_ERROR_AT_PORT1_3</td>
<td>DC Latch Error detected at ports 1 and 3 of slave</td>
</tr>
<tr>
<td>0xC0CD007A</td>
<td>ECM_ERROR_EM.EC_DC_RX_LATC H_ERROR_AT_PORT2_3</td>
<td>DC Latch Error detected at ports 2 and 3 of slave</td>
</tr>
<tr>
<td>0xC0CD007B</td>
<td>ECM_ERROR_EM.EC_DC_RX_LATC H_ERROR_AT_PORT0_1_2</td>
<td>DC Latch Error detected at ports 0, 1 and 2 of slave</td>
</tr>
<tr>
<td>0xC0CD007C</td>
<td>ECM_ERROR_EM.EC_DC_RX_LATC H_ERROR_AT_PORT0_1_3</td>
<td>DC Latch Error detected at ports 0, 1 and 3 of slave</td>
</tr>
<tr>
<td>0xC0CD007D</td>
<td>ECM_ERROR_EM.EC_DC_RX_LATC H_ERROR_AT_PORTS0_2_3</td>
<td>DC Latch Error detected at ports 0, 2 and 3 of slave</td>
</tr>
<tr>
<td>0xC0CD007E</td>
<td>ECM_ERROR_EM.EC_DC_RX_LATC H_ERROR_AT_PORTS1_2_3</td>
<td>DC Latch Error detected at ports 1, 2 and 3 of slave</td>
</tr>
<tr>
<td>0xC0CD007F</td>
<td>ECM_ERROR_EM.EC_DC_RX_LATC H_ERROR_AT_PORTS0_1_2_3</td>
<td>DC Latch Error detected at ports 0, 1, 2 and 3 of slave</td>
</tr>
<tr>
<td>0xC0CD0080</td>
<td>ECM_ERROR_EM_ASSIGN_PDO _IS_MISSING_PDO_MAPPING</td>
<td>AssignPDO data is missing related PDO mapping data</td>
</tr>
<tr>
<td>0xC0CD0081</td>
<td>ECM_ERROR_EM_EXT_SYNC_OBJ.IS_NOT_MAPPED_TOSAME_SM</td>
<td>Parts of Ext Sync object are not mapped to the same SyncManager</td>
</tr>
<tr>
<td>0xC0CD0082</td>
<td>ECM_ERROR_EM_DUPLICATE_EXT_SYNC_OBJ</td>
<td>Duplicate Ext Sync object mapping</td>
</tr>
<tr>
<td>0xC0CD0083</td>
<td>ECM_ERROR_EM_UNSUPPORTED_EXT_SYNC_OBJ_RECO</td>
<td>Unsupported Ext Sync object record detected</td>
</tr>
<tr>
<td>0xC0CD0084</td>
<td>ECM_ERROR_EM_UNSUPPORTED_MAPPING_OF_EXT_SYNC_OBJ_RECO</td>
<td>Unsupported mapping of Ext Sync object record detected</td>
</tr>
<tr>
<td>0xC0CD0085</td>
<td>ECM_ERROR_EM_MISSING_MAPPING_OF_EXT_SYNC_OBJ_RECO</td>
<td>Missing mapping of Ext Sync object record detected</td>
</tr>
<tr>
<td>0xC0CD0086</td>
<td>ECM_ERROR_EM_EXT_SYNC_OBJ.IS_NOT_MAPPED_TOSAME_FMMU</td>
<td>Parts of Ext Sync object are not mapped to the same FMMU</td>
</tr>
<tr>
<td>0xC0CD0087</td>
<td>ECM_ERROR_EM_EXT_SYNC_OBJ_INTERNAL_ERROR</td>
<td>Internal error detected regarding Ext Sync object</td>
</tr>
<tr>
<td>0xC0CD0088</td>
<td>ECM_ERROR_EM_EXT_SYNC_OBJ.IS_NOT_MAPPED_IN_ONE_CY CLIC_CMD</td>
<td>Parts of Ext Sync object are not mapped within the same cyclic command</td>
</tr>
<tr>
<td>Hexadecimal Value</td>
<td>Definition</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>0xC0CD0089</td>
<td>ECM_ERROR_EMC_UNSUP-PORTED_FMMU_MAP-PING_OF_EXT_SYNC_OBJ_RECO</td>
<td>Unsupported FMMU mapping of Ext Sync object detected</td>
</tr>
<tr>
<td>0xC0CD008A</td>
<td>ECM_ERROR_EMC_EXT_SYNC_R-EQUIRES_ADJUST_EXT_SYNC_CM</td>
<td>Unicast Ext Sync control (APWR/FPWR 0x910) is required</td>
</tr>
<tr>
<td>0xC0CD008B</td>
<td>ECM_ERROR_EMC_EXT_SYNC_CM_DOES_NOT_MATCH_XRMW_CM</td>
<td>Unicast Ext Sync control does not match xRMW command</td>
</tr>
<tr>
<td>0xC0CD008C</td>
<td>ECM_ERROR_EMC_EXT_SYNC_R-EQUIRES_XRMW_CMD</td>
<td>Ext Sync requires DC configuration (xRMW command to 0x910)</td>
</tr>
<tr>
<td>0xC0CD008D</td>
<td>ECM_ERROR_EMC_EXPLICIT_DEV_IDENT_FAILED</td>
<td>Explicit Device identification via ALSTATUS failed</td>
</tr>
<tr>
<td>0xC0CD008E</td>
<td>ECM_ERROR_EMC_EXPLICIT_DEV_IDENT_FAILED</td>
<td>Explicit Device identification via register failed</td>
</tr>
<tr>
<td>0xC0CD008F</td>
<td>ECM_ERROR_EMC_COPY_INFOS_FOUND_AT_UNMAPPED_RECEIVE_DATA</td>
<td>CopyInfos found at unmapped receive data</td>
</tr>
<tr>
<td>0xC0CD0090</td>
<td>ECM_ERROR_EMC_COPY_INFO_RECEIVE_DATA_AREA_NOT_MATCHING</td>
<td>CopyInfo receive data area is not matching</td>
</tr>
<tr>
<td>0xC0CD0091</td>
<td>ECM_ERROR_EMC_SDO UPLOAD_TOO_LONG</td>
<td>SDO Upload data too long</td>
</tr>
<tr>
<td>0xC0CD0092</td>
<td>ECM_ERROR_EMC_SDO UPLOAD_TOO_SHORT</td>
<td>SDO Upload data too short</td>
</tr>
<tr>
<td>0xC0CD0093</td>
<td>ECM_ERROR_EMC_SDO UPLOAD_COMPARE_DOES_NOT_MATCH_EXPECTATION</td>
<td>SDO Upload compare does not match expectation</td>
</tr>
<tr>
<td>0xC0CD0094</td>
<td>ECM_ERROR_EMC_SOE_READ_TOO_LONG</td>
<td>SoE Read IDN data too long</td>
</tr>
<tr>
<td>0xC0CD0095</td>
<td>ECM_ERROR_EMC_SOE_READ_TOO_SHORT</td>
<td>SoE Read IDN data too short</td>
</tr>
<tr>
<td>0xC0CD0096</td>
<td>ECM_ERROR_EMC_SOE_READ_COMPARE_DOES_NOT_MATCH_EXPECTATION</td>
<td>SoE Read compare does not match expectation</td>
</tr>
<tr>
<td>0xC0CD0097</td>
<td>ECM_ERROR_EMC_REG_INITCOMPARE_DOES_NOT_MATCH EXPECTATION</td>
<td>Register read compare does not match expectation</td>
</tr>
<tr>
<td>0xC0CD0098</td>
<td>ECM_ERROR_EMC_REDU- DANCY_PORT_ONLY_POS- SIBLE_ONCE</td>
<td>Redundancy port can only be placed once into configuration</td>
</tr>
<tr>
<td>0xC0CD0099</td>
<td>ECM_ERROR_EMC_STARTUP_SCAN_SII_FAILED</td>
<td>Startup scan of SII failed</td>
</tr>
<tr>
<td>0xC0CD009A</td>
<td>ECM_ERROR_EMC_STARTUP_VERIFY_SII_FAILED</td>
<td>Startup verification of SII failed</td>
</tr>
<tr>
<td>0xC0CD009B</td>
<td>ECM_ERROR_EMC_MAIN_PORT_NOT_CONNECTED</td>
<td>Main port not connected during topology scan</td>
</tr>
<tr>
<td>Hexadecimal Value</td>
<td>Definition Description</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>0xC0CD009C</td>
<td>ECM_ERROR_EMC_BUS_SCAN_TOO_MANY_SLAVES</td>
<td>Bus scan detects too many slaves</td>
</tr>
<tr>
<td>0xC0CD009D</td>
<td>ECM_ERROR_EMC_BUS_SCAN_SPLIT_RING_NOT_SUPPORTED</td>
<td>Bus Scan detects unsupported split ring topology</td>
</tr>
<tr>
<td>0xC0CD009E</td>
<td>ECM_ERROR_EMC_BUS_SHUTDOWN</td>
<td>Bus is shutting down</td>
</tr>
<tr>
<td>0xC0CD009F</td>
<td>ECM_ERROR_EMC_MASTER_ADDRESS_NOT_ALLOWED_AS_STATION_ADDRESS</td>
<td>Master address (0) is not allowed as station address</td>
</tr>
<tr>
<td>0xC0CD00A0</td>
<td>ECM_ERROR_EMC_FIRST_STATION_HAS_INVALID_PORT_0</td>
<td>First station has invalid port 0</td>
</tr>
<tr>
<td>0xC0CD00A1</td>
<td>ECM_ERROR_EMC_STATION_HAS_INVALID_PORT</td>
<td>Station has invalid port</td>
</tr>
<tr>
<td>0xC0CD00A2</td>
<td>ECM_ERROR_EMC_STATION_HAS_NOT_LISTED_STATION_ADDRESS_IN_PORT</td>
<td>Station has not listed station address in port</td>
</tr>
<tr>
<td>0xC0CD00A3</td>
<td>ECM_ERROR_EMC_PORT_CONNECTION_BETWEEN_STATIONS_DOES_NOT_MATCH</td>
<td>Port connection between stations does not match</td>
</tr>
<tr>
<td>0xC0CD00A4</td>
<td>ECM_ERROR_EMC_STATION_HAS_ALREADY_USED_STATION_ADDRESS_IN_PORT</td>
<td>Station has already used station address in port</td>
</tr>
<tr>
<td>0xC0CD00A5</td>
<td>ECM_ERROR_EMC_INVALID_SM_PHYS_START_ADDRESS</td>
<td>Invalid Sm physical start address</td>
</tr>
<tr>
<td>0xC0CD00A6</td>
<td>ECM_ERROR_EMC_DC_TOPOLOGY_ON_REDUNDANCY_PORT_NOT_SUPPORTED</td>
<td>DC topology on redundancy port connection not supported. DC slaves having AutoIncrement positions behind redundancy port</td>
</tr>
<tr>
<td>0xC0CD00A7</td>
<td>ECM_ERROR_EMC_SM_ASSIGNPDO_ALREADY_ADDED</td>
<td>Sm AssignPdo already added</td>
</tr>
<tr>
<td>0xC0CD00A8</td>
<td>ECM_ERROR_EMC_BASE_SYNC_OFFSET_PERCENTAGE_OUT_OF_RANGE</td>
<td>Base Sync Offset percentage out of range</td>
</tr>
<tr>
<td>0xC0CF0001</td>
<td>ECM_ERROR_COE_INITIALIZATION_ERROR</td>
<td>CoE: Initialization Error</td>
</tr>
<tr>
<td>0xC0CF0002</td>
<td>ECM_ERROR_COE_INVALID_TRANSFER_HANDLE</td>
<td>CoE: Invalid transfer handle used</td>
</tr>
<tr>
<td>0xC0CF0003</td>
<td>ECM_ERROR_COE_NO_MAILBOX_AVAILABLE</td>
<td>CoE: No mailbox available</td>
</tr>
<tr>
<td>0xC0CF0004</td>
<td>ECM_ERROR_COE_INVALID_TRANSFER_STATE</td>
<td>CoE: Invalid transfer state</td>
</tr>
<tr>
<td>0xC0CF0005</td>
<td>ECM_ERROR_COE_TRANSFER_SEGMENT_TOO_LONG</td>
<td>CoE: Transfer segment is too long</td>
</tr>
<tr>
<td>0xC0CF0006</td>
<td>ECM_ERROR_COE_SHUTTING_DOWN</td>
<td>CoE is shutting down.</td>
</tr>
<tr>
<td>0xC0CF0007</td>
<td>ECM_ERROR_COE_MAX_TOTAL_BYTES_SMALLER_THAN_ACTUAL_TOTAL_BYTES</td>
<td>CoE: Maximum total bytes is smaller than actual total bytes.</td>
</tr>
<tr>
<td>0xC0CF0008</td>
<td>ECM_ERROR_COE_MAILBOX_TRANSMIT_FAILED</td>
<td>CoE: Mailbox transmit failed</td>
</tr>
<tr>
<td>Hexadecimal Value</td>
<td>Definition</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>0xC0CF0009</td>
<td>ECM_ERROR_COE_TRANSFER_ABORTED</td>
<td>CoE: Transfer has been aborted.</td>
</tr>
<tr>
<td>0xC0CF000A</td>
<td>ECM_ERROR_COE_SDINFO_INITIALIZATION_ERROR</td>
<td>0xC0CF00B</td>
</tr>
<tr>
<td>0xC0CF000C</td>
<td>ECM_ERROR_COE_PROTOCOL_ERROR</td>
<td>CoE Protocol Error</td>
</tr>
<tr>
<td>0xC0CF000D</td>
<td>ECM_ERROR_COE_NO_AOE_AVAILABLE</td>
<td>CoE: No AoE available</td>
</tr>
<tr>
<td>0xC0CF000F</td>
<td>ECM_ERROR_COE_INVALID_SLAVE_ADDRESS</td>
<td>CoE: Invalid slave station address</td>
</tr>
<tr>
<td>0xC0CF8000</td>
<td>ECM_ERROR_COE_ABORT_CODE_TOGGLE_BIT_NOT_ALTERNATED</td>
<td>SDO Abort Code: Toggle Bit not alternated</td>
</tr>
<tr>
<td>0xC0CF8001</td>
<td>ECM_ERROR_COE_ABORT_CODE_COMMAND_SPECIFIER_NOT_VALID</td>
<td>SDO Abort Code: Command specifier not valid</td>
</tr>
<tr>
<td>0xC0CF8002</td>
<td>ECM_ERROR_COE_ABORT_CODE_PROTOCOL_TIMEOUT</td>
<td>SDO Abort Code: Protocol Timeout</td>
</tr>
<tr>
<td>0xC0CF8003</td>
<td>ECM_ERROR_COE_ABORT_CODE_OUT_OF_MEMORY</td>
<td>SDO Abort Code: Out Of Memory</td>
</tr>
<tr>
<td>0xC0CF8004</td>
<td>ECM_ERROR_COE_ABORT_CODE_UNSUPPORTED_ACCESS</td>
<td>SDO Abort Code: Unsupported access</td>
</tr>
<tr>
<td>0xC0CF8005</td>
<td>ECM_ERROR_COE_ABORT_CODE_OBJECT_IS_WRITE_ONLY</td>
<td>SDO Abort Code: Object is write only</td>
</tr>
<tr>
<td>0xC0CF8006</td>
<td>ECM_ERROR_COE_ABORT_CODE_OBJECT_IS_READ_ONLY</td>
<td>SDO Abort Code: Object is read only</td>
</tr>
<tr>
<td>0xC0CF8007</td>
<td>ECM_ERROR_COE_ABORT_CODE_SUBINDEX_CANNOT_BE_WRITTEN_SI0_NZ</td>
<td>SDO Abort Code: Subindex cannot be written if subindex 0 is not zero</td>
</tr>
<tr>
<td>0xC0CF8008</td>
<td>ECM_ERROR_COE_ABORT_CODE_COMPLETE_ACCESS_NOT_SUPPORTED</td>
<td>SDO Abort Code: Complete access not supported</td>
</tr>
<tr>
<td>0xC0CF8009</td>
<td>ECM_ERROR_COE_ABORT_CODE_OBJECT_LENGTH_EXCEEDS_MAILBOX_SIZE</td>
<td>SDO Abort Code: Object length exceeds mailbox size</td>
</tr>
<tr>
<td>0xC0CF800A</td>
<td>ECM_ERROR_COE_ABORT_CODE_OBJECT_MAPPED_TO_RXPDO_NO_WRITE</td>
<td>SDO Abort Code: Object mapped to RxPDO, SDO Download blocked</td>
</tr>
<tr>
<td>0xC0CF800B</td>
<td>ECM_ERROR_COE_ABORT_CODE_OBJECT_DOES_NOT_EXIST</td>
<td>SDO Abort Code: Object does not exist</td>
</tr>
<tr>
<td>0xC0CF800C</td>
<td>ECM_ERROR_COE_ABORT_CODE_OBJECT_CANNOT_BE_PDO_MAPPED</td>
<td>SDO Abort Code: Object cannot be mapped to PDO</td>
</tr>
<tr>
<td>0xC0CF800D</td>
<td>ECM_ERROR_COE_ABORT_CODE_PDO_LENGTH_WOULD_EXCEED</td>
<td>SDO Abort Code: PDO Length would exceed maximum size</td>
</tr>
<tr>
<td>0xC0CF800E</td>
<td>ECM_ERROR_COE_ABORT_CODE_GEN_PARAM_INCOMPATIBILITY</td>
<td>SDO Abort Code: General parameter incompatibility</td>
</tr>
<tr>
<td>Hexadecimal Value</td>
<td>Definition Description</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>0xC0CF800F</td>
<td>ECM_ERROR_COE_ABORT-</td>
<td>SDO Abort Code: Access failed due to hardware error</td>
</tr>
<tr>
<td></td>
<td>CODE_ACCESS_FAILED_DUE_TO_HW_ERROR</td>
<td></td>
</tr>
<tr>
<td>0xC0CF8010</td>
<td>ECM_ERROR_COE_ABORT-</td>
<td>SDO Abort Code: Data type does not match</td>
</tr>
<tr>
<td></td>
<td>CODE_DATA_TYPE_DOES_NOT_MATCH</td>
<td></td>
</tr>
<tr>
<td>0xC0CF8011</td>
<td>ECM_ERROR_COE_ABORT-</td>
<td>SDO Abort Code: Data type length too long</td>
</tr>
<tr>
<td></td>
<td>CODE_DATA_TYPE_LENGTH_TOO_LONG</td>
<td></td>
</tr>
<tr>
<td>0xC0CF8012</td>
<td>ECM_ERROR_COE_ABORT-</td>
<td>SDO Abort Code: Data type length too short</td>
</tr>
<tr>
<td></td>
<td>CODE_DATA_TYPE_LENGTH_TOO_SHORT</td>
<td></td>
</tr>
<tr>
<td>0xC0CF8013</td>
<td>ECM_ERROR_COE_ABORT-</td>
<td>SDO Abort Code: Subindex does not exist</td>
</tr>
<tr>
<td></td>
<td>CODE_SUB_INDEX_DOES_NOT_EXIST</td>
<td></td>
</tr>
<tr>
<td>0xC0CF8014</td>
<td>ECM_ERROR_COE_ABORT-</td>
<td>SDO Abort Code: Range of parameter exceeded</td>
</tr>
<tr>
<td></td>
<td>CODE_RANGE_OF_PARAMETER_EXCEEDED</td>
<td></td>
</tr>
<tr>
<td>0xC0CF8015</td>
<td>ECM_ERROR_COE_ABORT-</td>
<td>SDO Abort Code: Value of parameter written too high</td>
</tr>
<tr>
<td></td>
<td>CODE_VALUE_OF PARAMETER_TOO_HIGH</td>
<td></td>
</tr>
<tr>
<td>0xC0CF8016</td>
<td>ECM_ERROR_COE_ABORT-</td>
<td>SDO Abort Code: Value of parameter written too low</td>
</tr>
<tr>
<td></td>
<td>CODE_VALUE_OF PARAMETER_TOO_LOW</td>
<td></td>
</tr>
<tr>
<td>0xC0CF8017</td>
<td>ECM_ERROR_COE_ABORT-</td>
<td>SDO Abort Code: Minimum value is less than maximum value</td>
</tr>
<tr>
<td></td>
<td>CODE_MIN_VALUE_IS_LESS_THAN_MAX_VALUE</td>
<td></td>
</tr>
<tr>
<td>0xC0CF8018</td>
<td>ECM_ERROR_COE_ABORT-</td>
<td>SDO Abort Code: General Error</td>
</tr>
<tr>
<td></td>
<td>CODE_GENERAL_ERROR</td>
<td></td>
</tr>
<tr>
<td>0xC0CF8019</td>
<td>ECM_ERROR_COE_ABORT-</td>
<td>SDO Abort Code: Data cannot be transferred or stored to the application</td>
</tr>
<tr>
<td></td>
<td>CODE_NO_TRANSFER_TO_APP</td>
<td></td>
</tr>
<tr>
<td>0xC0CF801A</td>
<td>ECM_ERROR_COE_ABORT-</td>
<td>SDO Abort Code: Data cannot be transferred or stored to the application because of local control</td>
</tr>
<tr>
<td></td>
<td>CODE_LOCAL_CONTROL</td>
<td></td>
</tr>
<tr>
<td>0xC0CF801B</td>
<td>ECM_ERROR_COE_ABORT-</td>
<td>SDO Abort Code: Data cannot be transferred or stored to the application because of the present device state</td>
</tr>
<tr>
<td></td>
<td>CODE_NO_TRANSFER_DUE_TO_CURRENT_STATE</td>
<td></td>
</tr>
<tr>
<td>0xC0CF801C</td>
<td>ECM_ERROR_COE_ABORT-</td>
<td>SDO Abort Code: Object dictionary dynamic generation fails or no object dictionary is present</td>
</tr>
<tr>
<td></td>
<td>CODE_NO_OBJECT_DICTIONARY_PRESENT</td>
<td></td>
</tr>
<tr>
<td>0xC0CF801D</td>
<td>ECM_ERROR_COE_ABORT-</td>
<td>SDO Abort Code: Unknown abort code</td>
</tr>
<tr>
<td></td>
<td>CODE_UNKNOWN_ABORT_CODE</td>
<td></td>
</tr>
<tr>
<td>0xC0CF801E</td>
<td>ECM_ERROR_COE_ABORT-</td>
<td>SDO Abort Code: General internal incompatibility in the device</td>
</tr>
<tr>
<td></td>
<td>CODE_GEN_INTERNAL_COMPAT</td>
<td></td>
</tr>
<tr>
<td>0xC0D00001</td>
<td>ECM_ERROR_EOE_INVALID_MAC_ADDRESS</td>
<td>Invalid MAC address</td>
</tr>
<tr>
<td>0xC0D00002</td>
<td>ECM_ERROR_EOE_INVALID_CALLBACK_TYPE</td>
<td>Invalid callback type</td>
</tr>
<tr>
<td>0xC0D00003</td>
<td>ECM_ERROR_EOE_DESTINATION_UNREACHABLE</td>
<td>Destination unreachable</td>
</tr>
<tr>
<td>Hexadecimal Value</td>
<td>Definition</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>0xC0D00004</td>
<td>ECM_ERROR_EOE_INVALID_EOE_RESPONSE</td>
<td>Invalid EoE Response</td>
</tr>
<tr>
<td>0xC0D00005</td>
<td>ECM_ERROR_EOE_UNKNOWN_ERROR</td>
<td>SetIPParam/SetFilterParam: Unknown error</td>
</tr>
<tr>
<td>0xC0D00006</td>
<td>ECM_ERROR_EOE_UNSPECIFIED_ERROR</td>
<td>SetIPParam/SetFilterParam: Unspecified Error</td>
</tr>
<tr>
<td>0xC0D00007</td>
<td>ECM_ERROR_EOE_UNSUPPORTED_FRAME_TYPE</td>
<td>SetIPParam/SetFilterParam: Unsupported frame type</td>
</tr>
<tr>
<td>0xC0D00008</td>
<td>ECM_ERROR_EOE_NO_IP_SUPPORT</td>
<td>SetIPParam/SetFilterParam: No IP support</td>
</tr>
<tr>
<td>0xC0D00009</td>
<td>ECM_ERROR_EOE_DHCP_NOT_SUPPORTED</td>
<td>SetIPParam/SetFilterParam: DHCP not supported</td>
</tr>
<tr>
<td>0xC0D0000A</td>
<td>ECM_ERROR_EOE_NO_FILTER_SUPPORTED</td>
<td>SetIPParam/SetFilterParam: No filter supported</td>
</tr>
<tr>
<td>0xC0D0000B</td>
<td>ECM_ERROR_EOE_TIMEOUT</td>
<td>EoE Timeout</td>
</tr>
<tr>
<td>0xC0D0000C</td>
<td>ECM_ERROR_EOE_SHUTTING_DOWN</td>
<td>EoE is shutting down</td>
</tr>
<tr>
<td>0xC0D0000D</td>
<td>ECM_ERROR_EOE_MASTER_ADDRESS_NOT_ALLOWED</td>
<td>EoE: Master address is not allowed to use here</td>
</tr>
<tr>
<td>0xC0D0000E</td>
<td>ECM_ERROR_EOE_CONFIGURATION_IS_NOT_OPEN</td>
<td>EoE: Configuration is not open</td>
</tr>
<tr>
<td>0xC0D0000F</td>
<td>ECM_ERROR_EOE_CONFIGURATION_IS_ALREADY_OPEN</td>
<td>EoE: Configuration is already open</td>
</tr>
<tr>
<td>0xC0D00010</td>
<td>ECM_ERROR_EOE_DUPLICATE_IP_ADDRESS</td>
<td>EoE: Duplicate IP address</td>
</tr>
<tr>
<td>0xC0D00011</td>
<td>ECM_ERROR_EOE_DUPLICATE_MAC_ADDRESS_ON_MULTIPLE_PORTS</td>
<td>EoE: Duplicate MAC address on multiple ports</td>
</tr>
<tr>
<td>0xC0D00012</td>
<td>ECM_ERROR_EOE_FRAME_TOO_LARGE</td>
<td>EoE: Frame too large</td>
</tr>
<tr>
<td>0xC0D00013</td>
<td>ECM_ERROR_EOE_IF_INITIALIZATION_ERROR</td>
<td>EoE: Interface initialization error</td>
</tr>
<tr>
<td>0xC0D00014</td>
<td>ECM_ERROR_EOE_IF_NO_FRAMEAVAILABLE</td>
<td>EoE: No Frame available</td>
</tr>
<tr>
<td>0xC0D00015</td>
<td>ECM_ERROR_EOE_LINK_DOWN</td>
<td>EoE: Link down</td>
</tr>
<tr>
<td>0xC0D10002</td>
<td>ECM_ERROR_FOE_ERROR_UNKNOW_ERROR</td>
<td>-</td>
</tr>
<tr>
<td>0xC0D10003</td>
<td>ECM_ERROR_FOE_INVALID_TRANSFER_HANDLE</td>
<td>FoE: Invalid transfer handle</td>
</tr>
<tr>
<td>0xC0D10004</td>
<td>ECM_ERROR_FOE_INVALID_TRANSFER_STATE</td>
<td>FoE: Invalid transfer state</td>
</tr>
<tr>
<td>0xC0D10005</td>
<td>ECM_ERROR_FOE_INVALID_SLAVE_STATION_ADDRESS</td>
<td>FoE: Invalid slave station address</td>
</tr>
<tr>
<td>0xC0D10006</td>
<td>ECM_ERROR_FOE_WRONG_SLAVE_STATE</td>
<td>FoE: Wrong slave state</td>
</tr>
<tr>
<td>0xC0D10007</td>
<td>ECM_ERROR_FOE_NO_MAILBOX_AVAILABLE</td>
<td>FoE: No mailbox available</td>
</tr>
<tr>
<td>0xC0D10008</td>
<td>ECM_ERROR_FOE_TRANSFER_ABORTED</td>
<td>FoE: Transfer has been aborted</td>
</tr>
<tr>
<td>Hexadecimal Value</td>
<td>Definition</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------------------------------------</td>
<td>--------------------------------------</td>
</tr>
<tr>
<td>0xC0D10009</td>
<td>ECM_ERROR_FOE_PROTOCOL_TIMEOUT</td>
<td>FoE: Protocol Timeout</td>
</tr>
<tr>
<td>0xC0D1000A</td>
<td>ECM_ERROR_FOE_TRANSFER_SEGMENT_TOO_LONG</td>
<td>FoE: Transfer segment is too long</td>
</tr>
<tr>
<td>0xC0D1000B</td>
<td>ECM_ERROR_FOE_MAILBOX_TRANSFER_FAILED</td>
<td>FoE: Mailbox transmit failed</td>
</tr>
<tr>
<td>0xC0D1000C</td>
<td>ECM_ERROR_FOE_FILENAME_TOO_LONG</td>
<td>FoE: Filename is too long</td>
</tr>
<tr>
<td>0xC0D1000D</td>
<td>ECM_ERROR_FOE_BUFFER_EXCEEDED</td>
<td>FoE: Buffer is exceeded</td>
</tr>
<tr>
<td>0xC0D1000E</td>
<td>ECM_ERROR_FOE_FIRST_SEGMENT_SHOULD_NOT_BE_EMPTY</td>
<td>FoE: First segment should not be empty</td>
</tr>
<tr>
<td>0xC0D1000F</td>
<td>ECM_ERROR_FOE_SEGMENT_SHOULD_BE_EMPTY</td>
<td>FoE: Segment should be empty</td>
</tr>
<tr>
<td>0xC0D18000</td>
<td>ECM_ERROR_FOE_ERROR_NOT_DEFINED</td>
<td>FoE: Error Response: not defined</td>
</tr>
<tr>
<td>0xC0D18001</td>
<td>ECM_ERROR_FOE_ERROR_NOT_FOUND</td>
<td>FoE: Error Response: Not Found</td>
</tr>
<tr>
<td>0xC0D18002</td>
<td>ECM_ERROR_FOE_ACCESS_DENIED</td>
<td>FoE: Error Response: Access Denied</td>
</tr>
<tr>
<td>0xC0D18003</td>
<td>ECM_ERROR_FOE_ERROR_DISK_FULL</td>
<td>FoE: Error Response: Disk full</td>
</tr>
<tr>
<td>0xC0D18004</td>
<td>ECM_ERROR_FOE_ERROR_ILLEGAL</td>
<td>FoE: Error Response: Illegal</td>
</tr>
<tr>
<td>0xC0D18005</td>
<td>ECM_ERROR_FOE_ERROR_PACKET_NUMBER_WRONG</td>
<td>FoE: Error Response: Packet number is wrong</td>
</tr>
<tr>
<td>0xC0D18006</td>
<td>ECM_ERROR_FOE_ERROR_ALREADY_EXISTS</td>
<td>FoE: Error Response: Already exists</td>
</tr>
<tr>
<td>0xC0D18007</td>
<td>ECM_ERROR_FOE_ERROR_NO_USER</td>
<td>FoE: Error Response: No User</td>
</tr>
<tr>
<td>0xC0D18008</td>
<td>ECM_ERROR_FOE_ERROR_BOOTSTRAP_ONLY</td>
<td>FoE: Access to specified file is only allowed in BOOT state</td>
</tr>
<tr>
<td>0xC0D18009</td>
<td>ECM_ERROR_FOE_ERROR_NOT_BOOTSTRAP</td>
<td>FoE: Access to specified file is only allowed when in PREOP, SAFEOP or OP</td>
</tr>
<tr>
<td>0xC0D1800A</td>
<td>ECM_ERROR_FOE_ERROR_NO_RIGHTS</td>
<td>FoE: No Rights</td>
</tr>
<tr>
<td>0xC0D1800B</td>
<td>ECM_ERROR_FOE_ERROR_PROGRAM_ERROR</td>
<td>FoE: Program Error</td>
</tr>
<tr>
<td>0xC0D20001</td>
<td>ECM_ERROR_SOE_UNKNOWN_SOE_ERROR</td>
<td>SoE: Unknown SoE Error</td>
</tr>
<tr>
<td>0xC0D20002</td>
<td>ECM_ERROR_SOE_INITIALIZATION_ERROR</td>
<td>SoE: Initialization error</td>
</tr>
<tr>
<td>0xC0D20003</td>
<td>ECM_ERROR_SOE_INVALID_TRANSFER_HANDLE</td>
<td>SoE: Invalid transfer handle</td>
</tr>
<tr>
<td>0xC0D20004</td>
<td>ECM_ERROR_SOE_NO_MAILBOX_AVAILABLE</td>
<td>SoE: No Mailbox available</td>
</tr>
<tr>
<td>0xC0D20005</td>
<td>ECM_ERROR_SOE_INVALID_TRANSFER_STATE</td>
<td>SoE: Invalid transfer state</td>
</tr>
<tr>
<td>Hexadecimal Value</td>
<td>Definition</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>0xC0D20006</td>
<td>ECM_ERROR_SOE_TRANSFER_SEGMENT_TOO_LONG</td>
<td>SoE: Transfer segment is too long</td>
</tr>
<tr>
<td>0xC0D20007</td>
<td>ECM_ERROR_SOE_SHUTTING_DOWN</td>
<td>SoE is shutting down</td>
</tr>
<tr>
<td>0xC0D20008</td>
<td>ECM_ERROR_SOE_MAX_TOTAL_BYTES_SMALLER_THAN_ACTUAL_TOTAL_BYTES</td>
<td>SoE: Maximum total bytes is smaller than actual total bytes</td>
</tr>
<tr>
<td>0xC0D20009</td>
<td>ECM_ERROR_SOE_MAILBOX_TRANSMIT_FAILED</td>
<td>SoE: Mailbox transmit failed</td>
</tr>
<tr>
<td>0xC0D2000A</td>
<td>ECM_ERROR_SOE_INVALID_SOE_HEADER</td>
<td>SoE: Invalid SoE header</td>
</tr>
<tr>
<td>0xC0D2000B</td>
<td>ECM_ERROR_SOE_PROTOCOL_TIMEOUT</td>
<td>SoE: Protocol Timeout</td>
</tr>
<tr>
<td>0xC0D2000C</td>
<td>ECM_ERROR_SOE_PROTOCOL_ERROR</td>
<td>SoE: Protocol Error</td>
</tr>
<tr>
<td>0xC0D2000D</td>
<td>ECM_ERROR_SOE_TRANSFER_ABORTED</td>
<td>SoE: Transfer has been aborted</td>
</tr>
<tr>
<td>0xC0D2000E</td>
<td>ECM_ERROR_SOE_WRONG_SLAVE_STATE</td>
<td>SoE: Wrong slave state</td>
</tr>
<tr>
<td>0xC0D2000F</td>
<td>ECM_ERROR_SOE_NO_AOE_AVAILABLE</td>
<td>SoE: No AoE available</td>
</tr>
<tr>
<td>0xC0D2010</td>
<td>ECM_ERROR_SOE_INVALID_SLAVE_ADDRESS</td>
<td>SoE: Invalid slave station address</td>
</tr>
<tr>
<td>0xC0D21001</td>
<td>ECM_ERROR_SOE_SSC_NO_IDN</td>
<td>SoE: No IDN</td>
</tr>
<tr>
<td>0xC0D21009</td>
<td>ECM_ERROR_SOE_SSC_INVALID_ACCESS_TO_ELEMENT_1</td>
<td>SoE: Invalid access to element 1</td>
</tr>
<tr>
<td>0xC0D22001</td>
<td>ECM_ERROR_SOE_SSC_NO_NAME</td>
<td>SoE: IDN has no name</td>
</tr>
<tr>
<td>0xC0D22002</td>
<td>ECM_ERROR_SOE_SSC_NAME_TRANSMISSION_IS_TOO_SHORT</td>
<td>SoE: Name transmission is too short</td>
</tr>
<tr>
<td>0xC0D22003</td>
<td>ECM_ERROR_SOE_SSC_NAME_TRANSMISSION_IS_TOO_LONG</td>
<td>SoE: Name transmission is too long</td>
</tr>
<tr>
<td>0xC0D22004</td>
<td>ECM_ERROR_SOE_SSC_NAME_CANNOT_BE_CHANGED</td>
<td>SoE: Name cannot be changed</td>
</tr>
<tr>
<td>0xC0D22005</td>
<td>ECM_ERROR_SOE_SSC_NAME_IS_WRITE_PROTECTED_AT_THIS_TIME</td>
<td>SoE: Name is write protected at this time</td>
</tr>
<tr>
<td>0xC0D23002</td>
<td>ECM_ERROR_SOE_SSC_ATTRIBUTE_TRANSMISSION_IS_TOO_SHORT</td>
<td>SoE: Attribute transmission is too short</td>
</tr>
<tr>
<td>0xC0D23003</td>
<td>ECM_ERROR_SOE_SSC_ATTRIBUTE_TRANSMISSION_IS_TOO_LONG</td>
<td>SoE: Attribute transmission is too long</td>
</tr>
<tr>
<td>0xC0D23004</td>
<td>ECM_ERROR_SOE_SSC_ATTRIBUTE_CANNOT_BE_CHANGED</td>
<td>SoE: Attribute cannot be changed</td>
</tr>
<tr>
<td>0xC0D23005</td>
<td>ECM_ERROR_SOE_SSC_ATTRIBUTE_IS_WRITE_PROTECTED_AT_THIS_TIME</td>
<td>SoE: Attribute is write protected at this time</td>
</tr>
<tr>
<td>0xC0D24001</td>
<td>ECM_ERROR_SOE_SSC_NO_UNIT</td>
<td>SoE: IDN has no unit</td>
</tr>
<tr>
<td>Hexadecimal Value</td>
<td>Definition Description</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>0xC0D24002</td>
<td>ECM_ERROR_SOE_SSC_UNIT_TRANSFORMATION_IS_TOO_SHORT</td>
<td>SoE: Unit transmission is too short</td>
</tr>
<tr>
<td>0xC0D24003</td>
<td>ECM_ERROR_SOE_SSC_UNIT_TRANSFORMATION_IS_TOO_LONG</td>
<td>SoE: Unit transmission is too long</td>
</tr>
<tr>
<td>0xC0D24004</td>
<td>ECM_ERROR_SOE_SSC_UNIT_CANNOT_BE_CHANGED</td>
<td>SoE: Unit cannot be changed</td>
</tr>
<tr>
<td>0xC0D24005</td>
<td>ECM_ERROR_SOE_SSC_UNIT_IS_WRITE_PROTECTED_AT_THIS_TIME</td>
<td>SoE: Unit is write protected at this time</td>
</tr>
<tr>
<td>0xC0D25001</td>
<td>ECM_ERROR_SOE_SSC_NO_MAXIMUM_VALUE</td>
<td>SoE: IDN has no maximum value</td>
</tr>
<tr>
<td>0xC0D25002</td>
<td>ECM_ERROR_SOE_SSC_MINIMUM_VALUE_TRANSMISSION_IS_TOO_SHORT</td>
<td>SoE: Minimum value transmission is too short</td>
</tr>
<tr>
<td>0xC0D25003</td>
<td>ECM_ERROR_SOE_SSC_MINIMUM_VALUE_TRANSMISSION_IS_TOO_LONG</td>
<td>SoE: Minimum value transmission is too long</td>
</tr>
<tr>
<td>0xC0D25004</td>
<td>ECM_ERROR_SOE_SSC_MINIMUM_VALUE_CANNOT_BE_CHANGED</td>
<td>SoE: Minimum value cannot be changed</td>
</tr>
<tr>
<td>0xC0D25005</td>
<td>ECM_ERROR_SOE_SSC_MINIMUM_VALUE_IS_WRITE_PROTECTED_AT_THIS_TIME</td>
<td>SoE: Minimum value is write protected at this time</td>
</tr>
<tr>
<td>0xC0D26001</td>
<td>ECM_ERROR_SOE_SSC_NO_MAXIMUM_VALUE</td>
<td>SoE: IDN has no maximum value</td>
</tr>
<tr>
<td>0xC0D26002</td>
<td>ECM_ERROR_SOE_SSC_MAXIMUM_VALUE_TRANSMISSION_IS_TOO_SHORT</td>
<td>SoE: Maximum value transmission is too short</td>
</tr>
<tr>
<td>0xC0D26003</td>
<td>ECM_ERROR_SOE_SSC_MAXIMUM_VALUE_TRANSMISSION_IS_TOO_LONG</td>
<td>SoE: Maximum value transmission is too long</td>
</tr>
<tr>
<td>0xC0D26004</td>
<td>ECM_ERROR_SOE_SSC_MAXIMUM_VALUE_CANNOT_BE_CHANGED</td>
<td>SoE: Maximum value cannot be changed</td>
</tr>
<tr>
<td>0xC0D26005</td>
<td>ECM_ERROR_SOE_SSC_MAXIMUM_VALUE_IS_WRITE_PROTECTED_AT_THIS_TIME</td>
<td>SoE: Maximum value is write protected at this time</td>
</tr>
<tr>
<td>0xC0D27002</td>
<td>ECM_ERROR_SOE_SSC_OPDATA_TRANSMISSION_IS_TOO_SHORT</td>
<td>SoE: OpData transmission is too short</td>
</tr>
<tr>
<td>0xC0D27003</td>
<td>ECM_ERROR_SOE_SSC_OPDATA_TRANSMISIÓN_IS_TOO_LONG</td>
<td>SoE: OpData transmission is too long</td>
</tr>
<tr>
<td>0xC0D27004</td>
<td>ECM_ERROR_SOE_SSC_OPDATA_CANNOT_BE_CHANGED</td>
<td>SoE: OpData cannot be changed</td>
</tr>
<tr>
<td>0xC0D27005</td>
<td>ECM_ERROR_SOE_SSC_OPDATA_IS_WRITE_PROTECTED_AT_THIS_TIME</td>
<td>SoE: OpData is write protected at this time</td>
</tr>
<tr>
<td>0xC0D27006</td>
<td>ECM_ERROR_SOE_SSC_OPDATA_IS_LOWER_THAN_MINIMUM_VALUE</td>
<td>SoE: OpData is lower than minimum value</td>
</tr>
<tr>
<td>Hexadecimal Value</td>
<td>Definition Description</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>0xC0D27007</td>
<td>ECM_ERROR_SOE_SSC_OPDATA _IS_HIGHER_THAN_MAXIMUM_VALUE</td>
<td>SoE: OpData is higher than maximum value</td>
</tr>
<tr>
<td>0xC0D27008</td>
<td>ECM_ERROR_SOE_SSC_OPDATA _IS_INVALID</td>
<td>SoE: OpData is invalid</td>
</tr>
<tr>
<td>0xC0D27009</td>
<td>ECM_ERROR_SOE_SSC_OPDATA _IS_WRITE_PROTECTED_BY_PASSWORD</td>
<td>SoE: OpData is write protected by password</td>
</tr>
<tr>
<td>0xC0D2700A</td>
<td>ECM_ERROR_SOE_SSC_OPDATA _IS_WRITE_PROTECTED_DUE_CYCLICALLY_CONFIGURED</td>
<td>SoE: OpData is write protected due to being cyclically configured</td>
</tr>
<tr>
<td>0xC0D2700B</td>
<td>ECM_ERROR_SOE_SSC_OPDATA _INVALID_DIRECT_ADDRESSING</td>
<td>SoE: Invalid direct addressing</td>
</tr>
<tr>
<td>0xC0D2700C</td>
<td>ECM_ERROR_SOE_SSC_OPDATA _IS_WRITE_PROTECTED_DUE_OTHER_SETTINGS</td>
<td>SoE: OpData is write protected due to other settings.</td>
</tr>
<tr>
<td>0xC0D2700D</td>
<td>ECM_ERROR_SOE_SSC_OPDATA _INVALID_FLOATING_POINT_NUMBER</td>
<td>SoE: Invalid floating point number</td>
</tr>
<tr>
<td>0xC0D2700E</td>
<td>ECM_ERROR_SOE_SSC_OPDATA _IS_WRITE_PROTECTED_AT_PARAMETERIZATION_LEVEL</td>
<td>SoE: OpData is write protected at parameterization level</td>
</tr>
<tr>
<td>0xC0D2700F</td>
<td>ECM_ERROR_SOE_SSC_OPDATA _IS_WRITE_PROTECTED_AT_OPERATION_LEVEL</td>
<td>SoE: OpData is write protected at operation level</td>
</tr>
<tr>
<td>0xC0D27010</td>
<td>ECM_ERROR_SOE_SSC_OPDATA _PROCEDURE_COMMAND_ALREADY_ACTIVE</td>
<td>SoE: Procedure command already active</td>
</tr>
<tr>
<td>0xC0D27011</td>
<td>ECM_ERROR_SOE_SSC_OPDATA _PROCEDURE_COMMAND_NOT_INTERRUPTIBLE</td>
<td>SoE: Procedure command not interruptible</td>
</tr>
<tr>
<td>0xC0D27012</td>
<td>ECM_ERROR_SOE_SSC_OPDATA _PROCEDURE_COMMAND_NOT_EXECUTABLE_AT_THIS_TIME</td>
<td>SoE: Procedure command is not executable at this time</td>
</tr>
<tr>
<td>0xC0D27013</td>
<td>ECM_ERROR_SOE_SSC_OPDATA _PROCEDURE_COMMAND_NOT_EXECUTABLE_INVALID_PARAMETER</td>
<td>SoE: Procedure command is not executable due to invalid parameter</td>
</tr>
<tr>
<td>0xC0D4005C</td>
<td>ECM_ERROR_ENUM_NO_SLAVES_IN_ENI</td>
<td>ENI does not contain any slaves</td>
</tr>
<tr>
<td>0xC0D50001</td>
<td>ECM_ERROR_ALSTATUS_CODE_UNSPECIFIED_ERROR</td>
<td>ALStatuscode: Unspecified error</td>
</tr>
<tr>
<td>0xC0D50002</td>
<td>ECM_ERROR_ALSTATUS_CODE_NO_MEMORY</td>
<td>ALStatuscode: No memory</td>
</tr>
<tr>
<td>0xC0D50003</td>
<td>ECM_ERROR_ALSTATUS_CODE_INVALID_DEVICE_SETUP</td>
<td>ALStatuscode: Invalid Device Setup</td>
</tr>
<tr>
<td>0xC0D50011</td>
<td>ECM_ERROR_ALSTATUS_CODE_INVALID_REQUESTED_STATE_CHANGE</td>
<td>ALStatuscode: Invalid requested state change</td>
</tr>
<tr>
<td>Hexadecimal Value</td>
<td>Definition</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>0xC0D50012</td>
<td>ECM_ERROR_ALSTATECODE_UNKNOWN_REQUESTED_STATE</td>
<td>ALStatuscode: Unknown requested state</td>
</tr>
<tr>
<td>0xC0D50013</td>
<td>ECM_ERROR_ALSTATECODE_BOOTSTRAP NOT_SUPPORTED</td>
<td>ALStatuscode: Bootstrap not supported</td>
</tr>
<tr>
<td>0xC0D50014</td>
<td>ECM_ERROR_ALSTATECODE_NO_VALID_FIRMWARE</td>
<td>ALStatuscode: No valid firmware</td>
</tr>
<tr>
<td>0xC0D50015</td>
<td>ECM_ERROR_ALSTATECODE_INVALID_BOOT_MAILBOX_CONFIGURATION</td>
<td>ALStatuscode: Invalid BOOT mailbox configuration</td>
</tr>
<tr>
<td>0xC0D50016</td>
<td>ECM_ERROR_ALSTATECODE_INVALID_PREOP_MAILBOX_CONFIGURATION</td>
<td>ALStatuscode: Invalid PREOP mailbox configuration</td>
</tr>
<tr>
<td>0xC0D50017</td>
<td>ECM_ERROR_ALSTATECODE_INVALID_SYNC_MANAGER_CONFIGURATION</td>
<td>ALStatuscode: Invalid sync manager configuration</td>
</tr>
<tr>
<td>0xC0D50018</td>
<td>ECM_ERROR_ALSTATECODE_NO_VALID_INPUTS_AVAILABLE</td>
<td>ALStatuscode: No valid inputs available</td>
</tr>
<tr>
<td>0xC0D50019</td>
<td>ECM_ERROR_ALSTATECODE_NO_VALID_OUTPUTS</td>
<td>ALStatuscode: No valid outputs</td>
</tr>
<tr>
<td>0xC0D5001A</td>
<td>ECM_ERROR_ALSTATECODE_SYNCHRONIZATION_ERROR</td>
<td>ALStatuscode: Synchronization error</td>
</tr>
<tr>
<td>0xC0D5001B</td>
<td>ECM_ERROR_ALSTATECODE_SYNC_MANAGER_WATCHDOG</td>
<td>ALStatuscode: Sync Manager watchdog</td>
</tr>
<tr>
<td>0xC0D5001C</td>
<td>ECM_ERROR_ALSTATECODE_INVALID_SYNC_MANAGER_TYPES</td>
<td>ALStatuscode: Invalid Sync Manager Types</td>
</tr>
<tr>
<td>0xC0D5001D</td>
<td>ECM_ERROR_ALSTATECODE_INVALID_OUTPUT_CONFIGURATION</td>
<td>ALStatuscode: Invalid output configuration</td>
</tr>
<tr>
<td>0xC0D5001E</td>
<td>ECM_ERROR_ALSTATECODE_INVALID_INPUT_CONFIGURATION</td>
<td>ALStatuscode: Invalid input configuration</td>
</tr>
<tr>
<td>0xC0D5001F</td>
<td>ECM_ERROR_ALSTATECODE_INVALID_WATCHDOG_CONFIGURATION</td>
<td>ALStatuscode: Invalid Watchdog configuration</td>
</tr>
<tr>
<td>0xC0D50020</td>
<td>ECM_ERROR_ALSTATECODE_SLAVE_NEEDS_COLD_START</td>
<td>ALStatuscode: Slave needs cold start</td>
</tr>
<tr>
<td>0xC0D50021</td>
<td>ECM_ERROR_ALSTATECODE_SLAVE_NEEDS_INIT</td>
<td>ALStatuscode: Slave needs INIT</td>
</tr>
<tr>
<td>0xC0D50022</td>
<td>ECM_ERROR_ALSTATECODE_SLAVE_NEEDS_PREOP</td>
<td>ALStatuscode: slave needs PREOP</td>
</tr>
<tr>
<td>0xC0D50023</td>
<td>ECM_ERROR_ALSTATECODE_SLAVE_NEEDS_SAFEOP</td>
<td>ALStatuscode: slave needs SAFEOP</td>
</tr>
<tr>
<td>0xC0D50024</td>
<td>ECM_ERROR_ALSTATECODE_INVALID_INPUT_MAPPING</td>
<td>ALStatuscode: Invalid Input Mapping</td>
</tr>
<tr>
<td>Hexadecimal Value</td>
<td>Definition</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>0xC0D50025</td>
<td>ECM_ERROR_ALSTAT-CODE_INVALID_OUTPUT_MAP-PING</td>
<td>ALStatusCode: Invalid Output Mapping</td>
</tr>
<tr>
<td>0xC0D50026</td>
<td>ECM_ERROR_ALSTAT-CODE_INCONSISTENT_SETTINGS</td>
<td>ALStatusCode: Inconsistent settings</td>
</tr>
<tr>
<td>0xC0D50027</td>
<td>ECM_ERROR_ALSTAT-CODE_FREERUN_NOT_SUPPORTED</td>
<td>ALStatusCode: FreeRun not supported</td>
</tr>
<tr>
<td>0xC0D50028</td>
<td>ECM_ERROR_ALSTAT-CODE_SYNCMODE_NOT_SUPPORTED</td>
<td>ALStatusCode: SyncMode not supported</td>
</tr>
<tr>
<td>0xC0D50029</td>
<td>ECM_ERROR_ALSTAT-CODE_FREERUN_NEEDS_3BUFFER_MODE</td>
<td>ALStatusCode: FreeRun needs 3Buffer mode</td>
</tr>
<tr>
<td>0xC0D5002A</td>
<td>ECM_ERROR_ALSTAT-CODE_BACK-GROUND_WATCHDOG</td>
<td>ALStatusCode: Background Watchdog</td>
</tr>
<tr>
<td>0xC0D5002B</td>
<td>ECM_ERROR_ALSTAT-CODE_NO_VALID_INPUTS_AND_OUTPUTS</td>
<td>ALStatusCode: No valid Inputs and Outputs</td>
</tr>
<tr>
<td>0xC0D5002C</td>
<td>ECM_ERROR_ALSTAT-CODE_FATAL_SYNC_ERROR</td>
<td>ALStatusCode: Fatal Sync error</td>
</tr>
<tr>
<td>0xC0D5002D</td>
<td>ECM_ERROR_ALSTAT-CODE_NO_SYNC_ERROR</td>
<td>ALStatusCode: No Sync error</td>
</tr>
<tr>
<td>0xC0D50030</td>
<td>ECM_ERROR_ALSTAT-CODE_INVALID_DC_SYNC_CONFIGURATION</td>
<td>ALStatusCode: Invalid DC SYNC configuration</td>
</tr>
<tr>
<td>0xC0D50031</td>
<td>ECM_ERROR_ALSTAT-CODE_INVALID_DC_LATCH_CONFIGURATION</td>
<td>ALStatusCode: Invalid DC Latch configuration</td>
</tr>
<tr>
<td>0xC0D50032</td>
<td>ECM_ERROR_ALSTAT-CODE_PLL_ERROR</td>
<td>ALStatusCode: PLL error</td>
</tr>
<tr>
<td>0xC0D50033</td>
<td>ECM_ERROR_ALSTAT-CODE_DC_SYNC_IO_ERROR</td>
<td>ALStatusCode: DC Sync IO error</td>
</tr>
<tr>
<td>0xC0D50034</td>
<td>ECM_ERROR_ALSTAT-CODE_DC_SYNC_TIMEOUT_ERROR</td>
<td>ALStatusCode: DC Sync Timeout Error</td>
</tr>
<tr>
<td>0xC0D50035</td>
<td>ECM_ERROR_ALSTAT-CODE_DC_INVALID_SYNC_CYCLE_TIME</td>
<td>ALStatusCode: DC Invalid Sync Cycle Time</td>
</tr>
<tr>
<td>0xC0D50036</td>
<td>ECM_ERROR_ALSTAT-CODE_DC_SYNC0_CYCLE_TIME</td>
<td>ALStatusCode: DC Sync0 Cycle Time</td>
</tr>
<tr>
<td>0xC0D50037</td>
<td>ECM_ERROR_ALSTAT-CODE_DC_SYNC1_CYCLE_TIME</td>
<td>ALStatusCode: DC Sync1 Cycle Time</td>
</tr>
<tr>
<td>0xC0D50041</td>
<td>ECM_ERROR_ALSTAT-CODE_MBX_AOE</td>
<td>ALStatusCode: MBX_AOE</td>
</tr>
<tr>
<td>0xC0D50042</td>
<td>ECM_ERROR_ALSTAT-CODE_MBX_EOE</td>
<td>ALStatusCode: MBX_EOE</td>
</tr>
<tr>
<td>0xC0D50043</td>
<td>ECM_ERROR_ALSTAT-CODE_MBX_COE</td>
<td>ALStatusCode: MBX_COE</td>
</tr>
<tr>
<td>Hexadecimal Value</td>
<td>Definition</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>0xC0D50044</td>
<td>ECM_ERROR_ALSTAT-</td>
<td>ALStatusCode: MBX_FOE</td>
</tr>
<tr>
<td></td>
<td>CODE_MBX_FOE</td>
<td></td>
</tr>
<tr>
<td>0xC0D50045</td>
<td>ECM_ERROR_ALSTAT-</td>
<td>ALStatusCode: MBX_SOE</td>
</tr>
<tr>
<td></td>
<td>CODE_MBX_SOE</td>
<td></td>
</tr>
<tr>
<td>0xC0D5004F</td>
<td>ECM_ERROR_ALSTAT-</td>
<td>ALStatusCode: MBX_VOE</td>
</tr>
<tr>
<td></td>
<td>CODE_MBX_VOE</td>
<td></td>
</tr>
<tr>
<td>0xC0D50050</td>
<td>ECM_ERROR_ALSTAT-</td>
<td>ALStatusCode: EEPROM no access</td>
</tr>
<tr>
<td></td>
<td>CODE_EEPROM_NO_ACCESS</td>
<td></td>
</tr>
<tr>
<td>0xC0D50051</td>
<td>ECM_ERROR_ALSTAT-</td>
<td>ALStatusCode: EEPROM error</td>
</tr>
<tr>
<td></td>
<td>CODE_EEPROM_ERROR</td>
<td></td>
</tr>
<tr>
<td>0xC0D50060</td>
<td>ECM_ERROR_ALSTAT-</td>
<td>ALStatusCode: Slave restarted locally</td>
</tr>
<tr>
<td></td>
<td>CODE_SLAVE_RESTARTED_LOCALLY</td>
<td></td>
</tr>
<tr>
<td>0xC0D50061</td>
<td>ECM_ERROR_ALSTAT-</td>
<td>ALStatusCode: Device identification value updated</td>
</tr>
<tr>
<td></td>
<td>CODE_DEVICE_IDENTIFICATION_VALUE_</td>
<td></td>
</tr>
<tr>
<td></td>
<td>UPDATED</td>
<td></td>
</tr>
<tr>
<td>0xC0D500F0</td>
<td>ECM_ERROR_ALSTAT-</td>
<td>ALStatusCode: Application controller available</td>
</tr>
<tr>
<td></td>
<td>CODE_APPLICATION_CONTROLLER_AVAIL</td>
<td></td>
</tr>
<tr>
<td></td>
<td>able</td>
<td></td>
</tr>
<tr>
<td>0xC0D58000</td>
<td>ECM_ERROR_ALSTAT-</td>
<td>Begin of vendor-specific ALStatus-Code mapping</td>
</tr>
<tr>
<td></td>
<td>CODE_VENDOR_SPECIFIC_CODE_START</td>
<td></td>
</tr>
<tr>
<td>0xC0DFFFFF</td>
<td>ECM_ERROR_ALSTAT-</td>
<td>End of vendor-specific ALStatus-Code mapping</td>
</tr>
<tr>
<td></td>
<td>CODE_VENDOR_SPECIFIC_CODE_END</td>
<td></td>
</tr>
<tr>
<td>0xC0D60001</td>
<td>ECM_ERROR_IF_COE_SUPPORT_NOT_AVAIL</td>
<td>CoE support is not configured</td>
</tr>
<tr>
<td>0xC0D60002</td>
<td>ECM_ERROR_IF_SOE_SUPPORT_NOT_AVAIL</td>
<td>SoE support is not configured</td>
</tr>
<tr>
<td>0xC0D60003</td>
<td>ECM_ERROR_IF_FOE_SUPPORT_NOT_AVAIL</td>
<td>FoE support is not configured</td>
</tr>
<tr>
<td>0xC0D60004</td>
<td>ECM_ERROR_IF_AOE_SUPPORT_NOT_AVAIL</td>
<td>AoE support is not configured</td>
</tr>
<tr>
<td>0xC0D60005</td>
<td>ECM_ERROR_IF_INVALID_TRANSFER_TYPE</td>
<td>Invalid transfer type</td>
</tr>
<tr>
<td>0xC0D60006</td>
<td>ECM_ERROR_IF_SOE_INVALID_DRIVE_NO</td>
<td>SoE: Invalid drive number</td>
</tr>
<tr>
<td>0xC0D60007</td>
<td>ECM_ERROR_IF_SOE_INVALID_ELEMENT_FLAGS</td>
<td>SoE: invalid element flags</td>
</tr>
<tr>
<td>0xC0D60008</td>
<td>ECM_ERROR_IF_INVALID_SOE_TRANSFER_ID</td>
<td>SoE: Invalid transfer ID</td>
</tr>
<tr>
<td>0xC0D60009</td>
<td>ECM_ERROR_IF_TRANSFER_ABORTED</td>
<td>Transfer aborted</td>
</tr>
<tr>
<td>0xC0D6000A</td>
<td>ECM_ERROR_IF_OUT_OF_PACKETS</td>
<td>Out of packets</td>
</tr>
<tr>
<td>0xC0D6000B</td>
<td>ECM_ERROR_IF_OUT_OF_TRANSFERCONTEXTS</td>
<td>Out of transfer contexts</td>
</tr>
<tr>
<td>0xC0D6000C</td>
<td>ECM_ERROR_IF_INVALID_SUBINDEX_FOR_COMPLETE_ACCESS</td>
<td>CoE: Invalid subindex for Complete Access</td>
</tr>
</tbody>
</table>
### Hexadecimal Value Definition Description

<table>
<thead>
<tr>
<th>Hexadecimal Value</th>
<th>Definition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0xC0D6000D</td>
<td>ECM_ERROR_IF_INVALID_COE_TRANSFER_ID</td>
<td>CoE: Invalid transfer ID</td>
</tr>
<tr>
<td>0xC0D6000E</td>
<td>ECM_ERROR_IF_INVALID_COE_SDOINFO_LISTTYPE</td>
<td>CoE: Invalid SDOINFO ListType</td>
</tr>
<tr>
<td>0xC0D6000F</td>
<td>ECM_ERROR_IF_FILE_READ_ERROR</td>
<td>File Read Error</td>
</tr>
<tr>
<td>0xC0D60010</td>
<td>ECM_ERROR_IF_COULD_NOT_OPEN_FILE</td>
<td>Could not open file</td>
</tr>
<tr>
<td>0xC0D60011</td>
<td>ECM_ERROR_IF_INVALID_CONFIG_NXD</td>
<td>Invalid config.nxd detected</td>
</tr>
<tr>
<td>0xC0D60012</td>
<td>ECM_ERROR_IF_CONFIG_NXD_WITHOUT_SLAVES</td>
<td>Config.nxd does not contain any slaves</td>
</tr>
<tr>
<td>0xC0D60013</td>
<td>ECM_ERROR_IF_INVALID_FILE_NAME</td>
<td>Invalid file name</td>
</tr>
<tr>
<td>0xC0D60014</td>
<td>ECM_ERROR_IF_INVALID_FOE_TRANSFER_ID</td>
<td>Invalid FoE transfer id</td>
</tr>
<tr>
<td>0xC0D60015</td>
<td>ECM_ERROR_IF_INVALID_GET_TOPOLOGY_TRANSFER_ID</td>
<td>Invalid GetTopology transfer id</td>
</tr>
</tbody>
</table>

### 6.9.3.6.3 CM589-PNIO(-4) errors

In PLC display the diagnosis messages of “CM589-PNIO” are not shown.

The following diagnosis messages are signaled by “CM589-PNIO”:

<table>
<thead>
<tr>
<th>Error severity</th>
<th>SubSystem</th>
<th>Additional</th>
<th>Error code</th>
<th>Meaning</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>1000</td>
<td>No communication module or wrong type found.</td>
<td>Plug the correct communication module.</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>1001</td>
<td>Type of CM589-PNIO not supported.</td>
<td>Exchange the communication module.</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>1002</td>
<td>Firmware version of CM589-PNIO not supported.</td>
<td>Update firmware of CM589-PNIO.</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>1003</td>
<td>Identification of communication module failed.</td>
<td>Exchange the communication module or plug the correct communication module.</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>2000</td>
<td>Watchdog error</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>2001</td>
<td>CM589-PNIO is not communicating.</td>
<td>Check bus connection and configuration.</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>2002</td>
<td>CM589-PNIO signals communication error.</td>
<td>Check bus connection and configuration.</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>2003</td>
<td>Starting of CM589-PNIO’s protocol stack failed.</td>
<td>Check bus connection and configuration.</td>
</tr>
</tbody>
</table>
### CM598-CN CAN communication module diagnosis

In Automation Builder, diagnosis messages of communication module CM598-CN are displayed at device tree node “CM598-CN” and all nodes below, CANopen remote devices and I/O modules (for CI58x modules only).

Click tab “Diagnosis”.

Within PLC application, diagnosis messages can be read by diagnosis related methods of function block type “Diag”, provided in library “Diag”.

In PLC display, diagnosis messages of CM598-CN are not shown.

Following diagnosis messages are signaled by CM598-CN.

CM598-CN communication module specific diagnosis messages:

<table>
<thead>
<tr>
<th>Error severity</th>
<th>SubSysteminfo</th>
<th>Additional</th>
<th>Error code</th>
<th>Meaning</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>6554600</td>
<td>CM598-CN not found</td>
<td>Plug the correct communication module</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>6554601</td>
<td>Type of CM598-CN not supported</td>
<td>Exchange the communication module</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>6554602</td>
<td>Firmware version of CM598-CN not supported</td>
<td>Update firmware of CM598-CN</td>
</tr>
<tr>
<td>Severity</td>
<td>SubSystem-</td>
<td>Additional</td>
<td>Error code</td>
<td>Meaning</td>
<td>Remedy</td>
</tr>
<tr>
<td>----------</td>
<td>------------</td>
<td>------------</td>
<td>------------</td>
<td>--------------------------------------------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>6554603</td>
<td>Identification of CM598-CN failed</td>
<td>Exchange the communication module</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>6555600</td>
<td>Watchdog error</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>0</td>
<td>0</td>
<td>6555601</td>
<td>CM598-CN is not communicating</td>
<td>Check bus connection and configuration</td>
</tr>
<tr>
<td>4</td>
<td>0</td>
<td>0</td>
<td>6555602</td>
<td>CM598-CN signals communication error</td>
<td>Check bus connection and configuration</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>6555603</td>
<td>Starting of CM598-CN's protocol stack failed</td>
<td>Check bus connection and configuration</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>6555604</td>
<td>Stopping of CM598-CN's protocol stack failed</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>6555605</td>
<td>PLC cannot be set to run due to an error of CM598-CN</td>
<td>Check error log and correct errors</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>6556600</td>
<td>Configuration error</td>
<td>Check configuration and correct errors</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>6556601</td>
<td>Configuration version mismatch</td>
<td>Use matching CPU firmware version</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>6557600</td>
<td>Starting of CM598-CN's SYNC task failed</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>6557600</td>
<td>Stopping of CM598-CN's SYNC task failed</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>6558600</td>
<td>Starting CAN 2A/2B failed</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>6558601</td>
<td>Stopping CAN 2A/2B failed</td>
<td></td>
</tr>
</tbody>
</table>

CANopen common diagnosis, shown at CANopen remote device.
<table>
<thead>
<tr>
<th>Severity</th>
<th>SubSysInfo</th>
<th>Additional</th>
<th>Error code</th>
<th>Meaning</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>65536</td>
<td>SDO timeout</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>65537</td>
<td>Error during SDO transfer</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>65538</td>
<td>Configuration fault</td>
<td>Check configuration and correct errors</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>NMT_state</td>
<td>65543</td>
<td>Node is in unexpected NMT state &lt;NMT state&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>0=unknown</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1=initializing</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2=stopped</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>3=operational</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4=pre-operational</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>5=reset_application</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>6=reset_com</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>m</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>65545</td>
<td>Emergency buffer overflow</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>65547</td>
<td>Unexpected boot up message from node received</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>65548</td>
<td>Parameter set of node is invalid</td>
<td>Check parameter set and correct errors</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>131073</td>
<td>Node configuration error</td>
<td>Check configuration and correct errors</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>131074</td>
<td>Node not communicating</td>
<td>Check bus connection and configuration</td>
</tr>
</tbody>
</table>

CANopen EMCY messages, shown at CANopen remote devices.
Manufacturer specific data can be viewed as raw bytes.
<table>
<thead>
<tr>
<th>Severity</th>
<th>SubSystem minfo</th>
<th>Additional Error code</th>
<th>Meaning</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>0</td>
<td>Error register 200704</td>
<td>Generic error; error register: &lt;error register&gt;</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register 204800</td>
<td>Current - generic error; error register: &lt;error register&gt;</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register 205056</td>
<td>Current, CANopen device input side - generic; error register: &lt;error register&gt;</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register 205312</td>
<td>Current inside the CANopen device - generic; error register: &lt;error register&gt;</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register 205568</td>
<td>Current, CANopen device output side - generic; error register: &lt;error register&gt;</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register 208896</td>
<td>Voltage - generic error; error register: &lt;error register&gt;</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register 209152</td>
<td>Mains voltage - generic; error register: &lt;error register&gt;</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register 209408</td>
<td>Voltage inside the CANopen device - generic; error register: &lt;error register&gt;</td>
<td></td>
</tr>
<tr>
<td>Severity</td>
<td>SubSystem-minfo</td>
<td>Additional</td>
<td>Error code</td>
<td>Meaning</td>
</tr>
<tr>
<td>----------</td>
<td>----------------</td>
<td>------------</td>
<td>------------</td>
<td>---------</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register</td>
<td>209664</td>
<td>Ouput voltage - generic; error register: &lt;error register&gt;</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register</td>
<td>212992</td>
<td>Temperatur - generic error; error register: &lt;error register&gt;</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register</td>
<td>213248</td>
<td>Ambient temperature - generic error; error register: &lt;error register&gt;</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register</td>
<td>213504</td>
<td>Device temperature - generic; error register: &lt;error register&gt;</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register</td>
<td>217088</td>
<td>CANopen device hardware - generic error; error register: &lt;error register&gt;</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register</td>
<td>221184</td>
<td>CANopen device software - generic error; error register: &lt;error register&gt;</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register</td>
<td>211440</td>
<td>Internal software - generic; error register: &lt;error register&gt;</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register</td>
<td>221696</td>
<td>User software - generic; error register: &lt;error register&gt;</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register</td>
<td>221952</td>
<td>Data set - generic; error register: &lt;error register&gt;</td>
</tr>
<tr>
<td>Severity</td>
<td>SubSystem-</td>
<td>Additional</td>
<td>Error code</td>
<td>Meaning</td>
</tr>
<tr>
<td>----------</td>
<td>------------</td>
<td>------------</td>
<td>------------</td>
<td>---------</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register</td>
<td>225280</td>
<td>Additional modules - generic error; error register: &lt;error register&gt;</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register</td>
<td>229376</td>
<td>Monitoring- generic error; error register: &lt;error register&gt;</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register</td>
<td>229632</td>
<td>Communication - generic; error register: &lt;error register&gt;</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register</td>
<td>229684</td>
<td>CAN overrun (objects lost); error register: &lt;error register&gt;</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register</td>
<td>229664</td>
<td>CAN in error passive mode; error register: &lt;error register&gt;</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register</td>
<td>229680</td>
<td>Life guard error or heartbeat error; error register: &lt;error register&gt;</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register</td>
<td>229696</td>
<td>Recovered from bus off; error register: &lt;error register&gt;</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register</td>
<td>229712</td>
<td>CAN-ID collision; error register: &lt;error register&gt;</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register</td>
<td>229888</td>
<td>Protocol error - generic; error register: &lt;error register&gt;</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register</td>
<td>229904</td>
<td>PDO not processed due to length error; error register: &lt;error register&gt;</td>
</tr>
<tr>
<td>Severity</td>
<td>SubSysteminfo</td>
<td>Additional</td>
<td>Error code</td>
<td>Meaning</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>------------</td>
<td>------------</td>
<td>---------</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register</td>
<td>229920</td>
<td>PDO length exceeded; error register: &lt;error register&gt;</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register</td>
<td>229936</td>
<td>DAM MPDO not processed, destination object not available; error register: &lt;error register&gt;</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register</td>
<td>229952</td>
<td>Unexpected SYNC data length; error register: &lt;error register&gt;</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register</td>
<td>229968</td>
<td>RPDO timeout; error register: &lt;error register&gt;</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register</td>
<td>233472</td>
<td>External error - generic error; error register: &lt;error register&gt;</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register</td>
<td>258084</td>
<td>Additional functions - generic error; error register: &lt;error register&gt;</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>Error register</td>
<td>261888</td>
<td>Device specific - generic error; error register: &lt;error register&gt;</td>
</tr>
</tbody>
</table>

ABB Communication Interface Module (CI58x) specific diagnosis messages, shown at I/O modules directly instead of CANopen remote device.

<table>
<thead>
<tr>
<th>Severity</th>
<th>SubSysteminfo</th>
<th>Additional</th>
<th>Error code</th>
<th>Meaning</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>255</td>
<td>0</td>
<td>8722</td>
<td>Internal error</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>255</td>
<td>0</td>
<td>8732</td>
<td>Internal error</td>
<td></td>
</tr>
<tr>
<td>Severity</td>
<td>SubSystem-minfo</td>
<td>Additional</td>
<td>Error code</td>
<td>Meaning</td>
<td>Remedy</td>
</tr>
<tr>
<td>----------</td>
<td>----------------</td>
<td>------------</td>
<td>------------</td>
<td>-------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>4</td>
<td>255</td>
<td>0</td>
<td>9480</td>
<td>I/O module removed from hot swap terminal unit or defective module on hot swap terminal unit</td>
<td>Plug I/O module, replace I/O module</td>
</tr>
<tr>
<td>4</td>
<td>255</td>
<td>0</td>
<td>9500</td>
<td>Wrong I/O module plugged on hot swap terminal unit</td>
<td>Remove wrong I/O module and plug projected I/O module</td>
</tr>
<tr>
<td>4</td>
<td>255</td>
<td>0</td>
<td>9514</td>
<td>No communication with I/O module on hot swap terminal unit</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>4</td>
<td>255</td>
<td>0</td>
<td>9526</td>
<td>I/O module does not support hot swap</td>
<td>Power off system and replace I/O module</td>
</tr>
<tr>
<td>4</td>
<td>255</td>
<td>0</td>
<td>9736</td>
<td>Hot swap terminal unit required but not found</td>
<td>Plug hot swap terminal unit</td>
</tr>
<tr>
<td>4</td>
<td>255</td>
<td>0</td>
<td>9764</td>
<td>Defective hot swap terminal unit</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>255</td>
<td>0</td>
<td>9770</td>
<td>No communication with hot swap terminal unit</td>
<td>Restart, if error persists replace terminal unit</td>
</tr>
<tr>
<td>3</td>
<td>255</td>
<td>0</td>
<td>16131</td>
<td>Timeout in the I/O module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>255</td>
<td>0</td>
<td>16137</td>
<td>Overflow diagnosis buffer</td>
<td>Restart</td>
</tr>
<tr>
<td>4</td>
<td>255</td>
<td>0</td>
<td>16138</td>
<td>Voltage overflow at outputs (above UP3 level)</td>
<td>Check terminals/check process supply voltage</td>
</tr>
<tr>
<td>3/4</td>
<td>255</td>
<td>0</td>
<td>16139</td>
<td>Process voltage UP or UP3 too low</td>
<td>Check process supply voltage</td>
</tr>
<tr>
<td>3</td>
<td>255</td>
<td>0</td>
<td>16145</td>
<td>No communication with I/O module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>255</td>
<td>0</td>
<td>16147</td>
<td>Checksum error in the I/O module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>255</td>
<td>0</td>
<td>16154</td>
<td>Parameter error</td>
<td>Check master</td>
</tr>
<tr>
<td>Severity</td>
<td>SubSystem</td>
<td>Additional</td>
<td>Error code</td>
<td>Meaning</td>
<td>Remedy</td>
</tr>
<tr>
<td>----------</td>
<td>-----------</td>
<td>------------</td>
<td>------------</td>
<td>-------------------------------------------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>4</td>
<td>255</td>
<td>0</td>
<td>16159</td>
<td>At least one module does not support failsafe function</td>
<td>Check modules and parameterization</td>
</tr>
<tr>
<td>3</td>
<td>255</td>
<td>0</td>
<td>16160</td>
<td>Wrong I/O module type on socket</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>4</td>
<td>255</td>
<td>0</td>
<td>16162</td>
<td>No response during initialization of the I/O module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>255</td>
<td>0</td>
<td>16164</td>
<td>Internal data exchange failure</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>255</td>
<td>0</td>
<td>16168</td>
<td>Different hard-/ firmware versions in the module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>255</td>
<td>0</td>
<td>16171</td>
<td>Internal error in the module</td>
<td>Replace I/O module</td>
</tr>
<tr>
<td>3/4</td>
<td>255</td>
<td>0</td>
<td>16173</td>
<td>No process voltage UP or UP3</td>
<td>Check process voltage</td>
</tr>
<tr>
<td>4</td>
<td>255</td>
<td>0</td>
<td>16174</td>
<td>Voltage feedback on activated digital outputs DO0...DO7 on UP3</td>
<td>Check terminals</td>
</tr>
<tr>
<td>3</td>
<td>0 - 31</td>
<td>0</td>
<td>18</td>
<td>Test error</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>0 - 31</td>
<td>0</td>
<td>257</td>
<td>Wrong measurement, false temperature at the compensation channel</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>0 - 31</td>
<td>0</td>
<td>258</td>
<td>AI531: Wrong measurement; potential difference is too high; CD522: PWM duty cycle out of duty area</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>0 - 31</td>
<td>0</td>
<td>260</td>
<td>Measurement overflow</td>
<td>Check channel wiring and sensor power supply</td>
</tr>
<tr>
<td>4</td>
<td>0 - 31</td>
<td>0</td>
<td>263</td>
<td>Measurement underflow at analog input</td>
<td>Check channel wiring and sensor power supply</td>
</tr>
<tr>
<td>Severity</td>
<td>SubSystem-</td>
<td>Additional</td>
<td>Error code</td>
<td>Meaning</td>
<td>Remedy</td>
</tr>
<tr>
<td>----------</td>
<td>------------</td>
<td>------------</td>
<td>------------</td>
<td>---------</td>
<td>--------</td>
</tr>
<tr>
<td>4</td>
<td>0 - 31</td>
<td>0</td>
<td>266</td>
<td>Short circuit and cut wire or &quot;out of range&quot;</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>0 - 31</td>
<td>0</td>
<td>267</td>
<td>Output/ process voltage to small/low</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0 - 31</td>
<td>0</td>
<td>273</td>
<td>Test error</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>0 - 31</td>
<td>0</td>
<td>303</td>
<td>Short circuit at an analog input</td>
<td>Check channel wiring</td>
</tr>
<tr>
<td>4</td>
<td>0 - 31</td>
<td>0</td>
<td>304</td>
<td>Analog value overflow or broken wire at an analog input</td>
<td>Check value or check terminals</td>
</tr>
<tr>
<td>4</td>
<td>0 - 31</td>
<td>0</td>
<td>530</td>
<td>Internal fuse at 0V is defect. 0V not connected with GND</td>
<td>Check I/O module wiring. Restart I/O module, if needed. If this error persists, replace I/O module</td>
</tr>
<tr>
<td>3</td>
<td>0 - 31</td>
<td>0</td>
<td>540</td>
<td>Test error</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0 - 31</td>
<td>0</td>
<td>555</td>
<td>Internal error</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>0 - 31</td>
<td>0</td>
<td>558</td>
<td>Externally voltage detected on digital output DO0...DO7</td>
<td>Check terminals</td>
</tr>
<tr>
<td>4</td>
<td>0 - 31</td>
<td>0</td>
<td>559</td>
<td>Short circuit at digital output</td>
<td>Check channel wiring</td>
</tr>
<tr>
<td>4</td>
<td>0 - 31</td>
<td>0</td>
<td>772</td>
<td>Analog value overflow at an analog output</td>
<td>Check output value</td>
</tr>
<tr>
<td>4</td>
<td>0 - 31</td>
<td>0</td>
<td>775</td>
<td>Analog value underflow at an analog output</td>
<td>Check output value</td>
</tr>
<tr>
<td>4</td>
<td>0 - 31</td>
<td>0</td>
<td>796</td>
<td>Different configuration</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0 – 31</td>
<td>0</td>
<td>1037</td>
<td>Test error</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>0 – 31</td>
<td>0</td>
<td>1070</td>
<td>Externally voltage detected on digital output DC0...DC7</td>
<td>Check terminals</td>
</tr>
<tr>
<td>4</td>
<td>0 – 31</td>
<td>0</td>
<td>1071</td>
<td>Short circuit at digital output</td>
<td>Check terminals</td>
</tr>
</tbody>
</table>
6.9.3.6.5 CM582-DP PROFIBUS DP slave diagnosis

The diagnosis messages of the communication module CM582-DP are displayed in the tab “Diagnosis” of node “CM582-DP” in the device tree of the Automation Builder. Within PLC application they can be read with the diagnosis methods of IO driver or function block “Diag”.

In the PLC display the diagnosis messages of CM582-DP are not shown.

The following diagnosis messages are signaled by CM582-DP:

<table>
<thead>
<tr>
<th>Error severity</th>
<th>SubSysteminfo</th>
<th>Additional</th>
<th>Error code</th>
<th>Meaning</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>1000x</td>
<td>No communication module or wrong type found</td>
<td>Plug the correct communication module</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>1001</td>
<td>Type of CM582-DP not supported</td>
<td>Exchange the communication module</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>1002</td>
<td>Firmware version of CM582-DP not supported</td>
<td>Update firmware of CM582-DP</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>1003</td>
<td>Identification of communication module failed</td>
<td>Exchange the communication module or plug the correct communication module</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>2000</td>
<td>Watchdog error</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>2001</td>
<td>CM582-DP is not communicating</td>
<td>Check bus connection and configuration</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>2002</td>
<td>CM582-DP signals communication error</td>
<td>Check bus connection and configuration</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>2003</td>
<td>Starting of CM582-DP's protocol stack failed</td>
<td>Check bus connection and configuration</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>2004</td>
<td>Stopping of CM582-DP's protocol stack failed</td>
<td>-</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>2005</td>
<td>PLC cannot be set to run due to an error of CM582-DP</td>
<td>Check error log and correct errors</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>3000</td>
<td>Configuration error</td>
<td>Check configuration and correct errors</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>3001</td>
<td>Configuration version mismatch</td>
<td>Use matching CPU firmware version</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>3002</td>
<td>Writing parameters to CM582-DP failed</td>
<td>Check configuration and correct errors</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>3003</td>
<td>Configuration of IM0 data failed</td>
<td>Check configuration and correct errors</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>3004</td>
<td>Reading of a parameter failed</td>
<td>Check configuration and correct errors</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>3005</td>
<td>Parameter value not supported or out of limits</td>
<td>Check configuration and correct errors</td>
</tr>
</tbody>
</table>
## AC500-S: errors from safety CPU and safety I/O modules

### Table 865: Error messages for safety CPU

<table>
<thead>
<tr>
<th>Severity</th>
<th>Error code</th>
<th>Description</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>8235</td>
<td>Internal error</td>
<td>Replace module</td>
</tr>
<tr>
<td>2</td>
<td>8448</td>
<td>Operation finished</td>
<td>Change Safety PLC switch address setting or remove memory card from non-safety PLC. Restart Safety PLC. If this error persists, replace Safety PLC.</td>
</tr>
<tr>
<td>2</td>
<td>8449</td>
<td>Wrong user data</td>
<td>Delete user data from Safety PLC. Restart Safety PLC. If this error persists, replace Safety PLC.</td>
</tr>
<tr>
<td>2</td>
<td>8450</td>
<td>Internal PROFIsafe initialization error</td>
<td>Restart Safety PLC. If this error persists, replace Safety PLC. Contact ABB technical support.</td>
</tr>
<tr>
<td>2</td>
<td>8460</td>
<td>Flash read error</td>
<td>Restart Safety PLC. If this error persists, replace Safety PLC. Contact ABB technical support.</td>
</tr>
<tr>
<td>2</td>
<td>8466</td>
<td>Internal error</td>
<td>Contact ABB technical support. Replace Safety PLC.</td>
</tr>
<tr>
<td>2</td>
<td>8476</td>
<td>Boot project download error</td>
<td>Reload boot project. If this error persists, replace Safety PLC.</td>
</tr>
<tr>
<td>2</td>
<td>8488</td>
<td>Wrong firmware version</td>
<td>Update Safety PLC firmware. Restart Safety PLC. If this error persists, replace Safety PLC.</td>
</tr>
<tr>
<td>2</td>
<td>8491</td>
<td>Internal error</td>
<td>Contact ABB technical support. Replace Safety PLC.</td>
</tr>
<tr>
<td>2</td>
<td>8496</td>
<td>Overvoltage or undervoltage detected</td>
<td>Restart Safety PLC. Check Safety PLC setting for power supply error. If this error persists, replace Safety PLC.</td>
</tr>
<tr>
<td>2</td>
<td>8500</td>
<td>Internal error</td>
<td>Contact ABB technical support. Replace Safety PLC.</td>
</tr>
<tr>
<td>2</td>
<td>8704</td>
<td>User program triggered safe stop</td>
<td>Check user program</td>
</tr>
<tr>
<td>2</td>
<td>8705</td>
<td>Internal error</td>
<td>Contact ABB technical support. Replace Safety PLC.</td>
</tr>
<tr>
<td>2</td>
<td>8706</td>
<td>Internal PROFIsafe error</td>
<td>Restart Safety PLC. If this error persists, replace Safety PLC. Contact ABB technical support.</td>
</tr>
<tr>
<td>2</td>
<td>8707</td>
<td>Internal error</td>
<td>Contact ABB technical support. Replace Safety PLC.</td>
</tr>
<tr>
<td>2</td>
<td>8714</td>
<td>Internal error</td>
<td>Contact ABB technical support. Replace Safety PLC.</td>
</tr>
<tr>
<td>2</td>
<td>8717</td>
<td>Flash write error</td>
<td>Restart Safety PLC. If this error persists, replace Safety PLC. Contact ABB technical support.</td>
</tr>
<tr>
<td>2</td>
<td>8721</td>
<td>Internal error</td>
<td>Contact ABB technical support. Replace Safety PLC.</td>
</tr>
<tr>
<td>2</td>
<td>8722</td>
<td>Internal error</td>
<td>Contact ABB technical support. Replace Safety PLC.</td>
</tr>
<tr>
<td>Severity</td>
<td>Error code</td>
<td>Description</td>
<td>Remedy</td>
</tr>
<tr>
<td>----------</td>
<td>------------</td>
<td>-------------</td>
<td>--------</td>
</tr>
<tr>
<td>2</td>
<td>8723</td>
<td>Checksum error has occurred in Safety PLC</td>
<td>Restart Safety PLC. If this error persists, replace Safety PLC.</td>
</tr>
<tr>
<td>2</td>
<td>8729</td>
<td>Internal error</td>
<td>Contact ABB technical support. Replace Safety PLC.</td>
</tr>
<tr>
<td>2</td>
<td>8741</td>
<td>Cycle time error in Safety PLC</td>
<td>Check Safety PLC watchdog time.</td>
</tr>
<tr>
<td>2</td>
<td>8742</td>
<td>Internal error</td>
<td>Contact ABB technical support. Replace Safety PLC.</td>
</tr>
<tr>
<td>2</td>
<td>8746</td>
<td>Internal error</td>
<td>Contact ABB technical support. Replace Safety PLC.</td>
</tr>
<tr>
<td>2</td>
<td>8747</td>
<td>Internal error</td>
<td>Contact ABB technical support. Replace Safety PLC.</td>
</tr>
<tr>
<td>2</td>
<td>8756</td>
<td>Internal error</td>
<td>Contact ABB technical support. Replace Safety PLC.</td>
</tr>
<tr>
<td>2</td>
<td>8758</td>
<td>Internal error</td>
<td>Contact ABB technical support. Replace Safety PLC.</td>
</tr>
<tr>
<td>2</td>
<td>8990</td>
<td>PROFIsafe configuration error</td>
<td>Check F-Parameter configuration of I/O module and reload boot project</td>
</tr>
<tr>
<td>3</td>
<td>12561</td>
<td>Safety source addresses cannot be checked</td>
<td>Check PROFIsafe F-Host library version (2.0.0 or above). If this error persists, contact ABB technical support.</td>
</tr>
<tr>
<td>3</td>
<td>12570</td>
<td>Error in configuration data, safety PLC has not accepted configuration data, e.g., mismatch between safety and non-safety PLC configuration.</td>
<td>Create new configuration data for both safety and non-safety PLC again, re-create and download boot projects to both safety and non-safety PLC again.</td>
</tr>
<tr>
<td>3</td>
<td>12571</td>
<td>Error in configuration data, Safety PLC cannot read configuration data</td>
<td>Create boot project</td>
</tr>
<tr>
<td>3</td>
<td>12598</td>
<td>PROFIsafe F_Dest_Add rules are violated</td>
<td>Check Safety PLC configuration or switch address setting against PROFIsafe F_Dest_Add configuration rules. Restart Safety PLC. If this error persists, contact ABB technical support.</td>
</tr>
<tr>
<td>3</td>
<td>32770</td>
<td>Watchdog error communication module</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>32771</td>
<td>Wrong firmware version of communication module</td>
<td>Update firmware</td>
</tr>
<tr>
<td>3</td>
<td>32772</td>
<td>Initialisation of safety module on slot failed. More than one safety module plugged -&gt; defective, replace this module</td>
<td>Remove this module or Only that one safety module plugged</td>
</tr>
<tr>
<td>3</td>
<td>32774</td>
<td>Invalid configuration data</td>
<td>Check configuration</td>
</tr>
<tr>
<td>3</td>
<td>32775</td>
<td>Safety module not found</td>
<td>Check configuration. At Safety PLC: Check Safety PLC switch address setting. Restart Safety PLC. If this error persists, replace Safety PLC.</td>
</tr>
<tr>
<td>Severity</td>
<td>Error code</td>
<td>Description</td>
<td>Remedy</td>
</tr>
<tr>
<td>----------</td>
<td>------------</td>
<td>-------------</td>
<td>--------</td>
</tr>
<tr>
<td>3</td>
<td>32776</td>
<td>Safety module has wrong type</td>
<td>Check configuration</td>
</tr>
<tr>
<td>4</td>
<td>16640</td>
<td>Reserved switch address setting</td>
<td>Warning</td>
</tr>
<tr>
<td>4</td>
<td>16644</td>
<td>Boot project not loaded, maximum power dip reached</td>
<td>Restart Safety PLC</td>
</tr>
<tr>
<td>4</td>
<td>16648</td>
<td>Power dip data missed or corrupted. Default power dip data was flashed by Safety PLC</td>
<td>Warning</td>
</tr>
<tr>
<td>4</td>
<td>16659</td>
<td>CRC error boot project</td>
<td>Create new boot project and restart Safety PLC</td>
</tr>
<tr>
<td>4</td>
<td>16909</td>
<td>Flash write error (production data)</td>
<td>Warning</td>
</tr>
<tr>
<td>4</td>
<td>16935</td>
<td>More than one instance of SF_WDOG_TIME_SET or SF_MAX_POWER_DIP_SET</td>
<td>Warning</td>
</tr>
<tr>
<td>4</td>
<td>16922</td>
<td>No or wrong configuration data from PM5x, run state not possible</td>
<td>Create correct boot project at PM5x</td>
</tr>
<tr>
<td>4</td>
<td>17421</td>
<td>Flash write error (boot project)</td>
<td>Warning</td>
</tr>
<tr>
<td>4</td>
<td>17677</td>
<td>Flash write error (boot code)</td>
<td>Warning</td>
</tr>
<tr>
<td>4</td>
<td>17933</td>
<td>Flash write error (firmware)</td>
<td>Warning</td>
</tr>
<tr>
<td>4</td>
<td>18189</td>
<td>Flash write error (password)</td>
<td>Warning</td>
</tr>
<tr>
<td>4</td>
<td>18445</td>
<td>Flash write error (user data)</td>
<td>Warning</td>
</tr>
<tr>
<td>4</td>
<td>18701</td>
<td>Flash write error (user data)</td>
<td>Warning</td>
</tr>
<tr>
<td>4</td>
<td>18957</td>
<td>Flash write error (internal)</td>
<td>Warning</td>
</tr>
<tr>
<td>4</td>
<td>19213</td>
<td>Flash write error (internal)</td>
<td>Warning</td>
</tr>
<tr>
<td>4</td>
<td>19469</td>
<td>Flash write error (internal)</td>
<td>Warning</td>
</tr>
<tr>
<td>4</td>
<td>32777</td>
<td>Program not started because of configuration error</td>
<td>Check configuration</td>
</tr>
<tr>
<td>4</td>
<td>32778</td>
<td>Program not started, no application running in safety module</td>
<td>Check configuration, download safety application to safety module</td>
</tr>
</tbody>
</table>

Table 866: Error messages for safety I/O modules (channel or module reintegration is possible)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Error code</th>
<th>Description</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>3</td>
<td>Discrepancy time expired</td>
<td>Check discrepancy time value, channel wiring and sensor.</td>
</tr>
<tr>
<td>3</td>
<td>12</td>
<td>Test pulse error</td>
<td>Check wiring and sensor.</td>
</tr>
</tbody>
</table>
### Error messages for safety I/O modules (channel or module reintegration is not possible)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Error code</th>
<th>Description</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 13</td>
<td>Channel test pulse cross-talk error</td>
<td>Check wiring and sensor. If this error persists, replace I/O module. Contact ABB technical support.</td>
<td></td>
</tr>
<tr>
<td>3 25</td>
<td>Channel stuck-at error</td>
<td>Check I/O module wiring. Restart I/O module, if needed. If this error persists, replace I/O module.</td>
<td></td>
</tr>
<tr>
<td>3 28</td>
<td>Channel cross-talk error</td>
<td>Check I/O module wiring. Restart I/O module, if needed. If this error persists, replace I/O module.</td>
<td></td>
</tr>
<tr>
<td>3 260</td>
<td>Measurement overflow at the I/O module</td>
<td>Check channel wiring and sensor power supply.</td>
<td></td>
</tr>
<tr>
<td>3 263</td>
<td>Measurement underflow at the I/O module</td>
<td>Adjust channel wiring and sensor power supply.</td>
<td></td>
</tr>
<tr>
<td>3 311</td>
<td>Channel value difference too high</td>
<td>Adjust tolerance window for channels. Check channel wiring and sensor configuration.</td>
<td></td>
</tr>
<tr>
<td>3 525</td>
<td>Channel readback error</td>
<td>Check I/O module wiring. Restart I/O module, if needed. If this error persists, replace I/O module.</td>
<td></td>
</tr>
<tr>
<td>3 530</td>
<td>Channel cross-talk error</td>
<td>Check I/O module wiring. Restart I/O module, if needed. If this error persists, replace I/O module.</td>
<td></td>
</tr>
<tr>
<td>3 16138</td>
<td>Process voltage too high</td>
<td>Check process voltage</td>
<td></td>
</tr>
<tr>
<td>3 16139</td>
<td>Process voltage too low</td>
<td>Check process voltage</td>
<td></td>
</tr>
<tr>
<td>3 16148</td>
<td>PROFIsafe communication error</td>
<td>Restart I/O module. If this error persists, contact ABB technical support.</td>
<td></td>
</tr>
<tr>
<td>3 16153</td>
<td>PROFIsafe watchdog timed out.</td>
<td>Restart I/O module. If this error persists, increase PROFIsafe watchdog time.</td>
<td></td>
</tr>
<tr>
<td>3 16171</td>
<td>Internal error in the device</td>
<td>Replace I/O module</td>
<td></td>
</tr>
</tbody>
</table>

Table 867: Error messages for safety I/O modules (channel or module reintegration is not possible)

<table>
<thead>
<tr>
<th>Severity</th>
<th>Error code</th>
<th>Description</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 16146</td>
<td>Plausibility check failed (iParameter)</td>
<td>Check configuration</td>
<td></td>
</tr>
<tr>
<td>3 16147</td>
<td>Checksum error in the I/O module</td>
<td>Check safety configuration and CRCs for I- and F-Parameters.</td>
<td></td>
</tr>
<tr>
<td>3 16154</td>
<td>Parameter value</td>
<td>Check master or configuration</td>
<td></td>
</tr>
<tr>
<td>3 16156</td>
<td>F-Parameter configuration and address switch value do not match.</td>
<td>Check I/O module F-Parameter configuration and module address switch value.</td>
<td></td>
</tr>
</tbody>
</table>
6.9.3.6.7 CM579-PNIO – PROFINET I/O controller diagnosis

Diagnosis data for CM579-PNIO is not displayed in PLC display. In Automation Builder, we recommend to use methods with text output to get diagnosis messages in clear text format. E.g., DiagGetFirstValAndTxt.

Output string:
<timestamp>; <error severity>; <device name>; <error location>; error ID <id>: <error text>

Advanced: Direct access to the diagnosis data of CM579-PNIO

If you need to access the diagnosis data directly, you have to interpret them manually. ≡ Chapter 6.9.3.6.8 “Advanced: Manual interpretation of CM579-PNIO diagnosis” on page 4704

6.9.3.6.8 Advanced: Manual interpretation of CM579-PNIO diagnosis

General

Diagnosis messages are included in diagnosis text lists “Diag_PNIO_Controller” and “Diag_PNIO_Vendor ID_Device ID”.

≡ We recommend that you refer to the example to learn how to perform the manual interpretation in the correct way.

<table>
<thead>
<tr>
<th>Error severity</th>
<th>SubSysteminfo</th>
<th>Additional</th>
<th>Error code</th>
<th>Meaning</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Word 2 (bit 16..31)</td>
<td>Word 1 (bit 0..15)</td>
<td>Word 2 (bit 16..31)</td>
<td>Word 1 (bit 0..15)</td>
<td>Word 2 (bit 16...31)</td>
</tr>
<tr>
<td>Sub1_</td>
<td>Sub2_</td>
<td>Add_Word 1_Word 2</td>
<td>Err_x or Err_Word 1_Word 2 (Word1/2 in hex format)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>tbd</td>
<td>tbd</td>
<td>0</td>
<td>1 (general)</td>
<td>Err_Gen_x</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>2 (runtime)</td>
<td>Err_Rt_x</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>2 (runtime)</td>
<td>1</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>2 (runtime)</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>2 (runtime)</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>2 (runtime)</td>
<td>4</td>
</tr>
<tr>
<td>11</td>
<td>tbd</td>
<td>tbd</td>
<td>0</td>
<td>3 (configuration)</td>
<td>Err_Cfg_x</td>
</tr>
<tr>
<td>Error severity</td>
<td>SubSysteminfo</td>
<td>Additional</td>
<td>Error code</td>
<td>Meaning</td>
<td>Remedy</td>
</tr>
<tr>
<td>----------------</td>
<td>---------------</td>
<td>------------</td>
<td>------------</td>
<td>---------</td>
<td>--------</td>
</tr>
<tr>
<td></td>
<td>Word 2 (bit 16..31)</td>
<td>Word 1 (bit 0..15)</td>
<td>Word 2 (bit 16..31)</td>
<td>Word 1 (bit 0..15)</td>
<td>Word 2 (bit 16..31)</td>
</tr>
<tr>
<td></td>
<td>Sub1_</td>
<td>Sub2_</td>
<td>Add_Word 1_Word 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (0 – 16#7FFF)</td>
<td>1 (USI: 16#8000) channel diagnosis</td>
<td>4 (diagnosis alarm)</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (16#8000)</td>
<td>1 (USI: 16#8000) channel diagnosis</td>
<td>4 (diagnosis alarm)</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (0 – 16#7FFF)</td>
<td>2 (USI: 16#8002) extended channel diagnosis</td>
<td>4 (diagnosis alarm)</td>
<td>Extended error Type</td>
</tr>
<tr>
<td>3</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (16#8000)</td>
<td>2 (USI: 16#8002) extended channel diagnosis</td>
<td>4 (diagnosis alarm)</td>
<td>Extended error Type</td>
</tr>
<tr>
<td>3</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (0 – 16#7FFF)</td>
<td>3 (USI: 16#8003) qualified channel diagnosis</td>
<td>4 (diagnosis alarm)</td>
<td>Extended error Type</td>
</tr>
<tr>
<td>3</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (16#8000)</td>
<td>3 (USI: 16#8003) qualified channel</td>
<td>4 (diagnosis alarm)</td>
<td>Extended error Type</td>
</tr>
<tr>
<td>3, 4, 11</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (0 – 16#7FFF)</td>
<td>0</td>
<td>5 (S500 process alarm)</td>
<td>32 bit error code</td>
</tr>
<tr>
<td>3, 4, 11</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (16#8000)</td>
<td>0</td>
<td>5 (S500 process alarm)</td>
<td>32 bit error code</td>
</tr>
<tr>
<td>3</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (0 – 16#7FFF)</td>
<td>Alarm type = (14 .. 30) &amp; (32 ..)</td>
<td>6 (alarm)</td>
<td>Alarm type = (14 .. 30) &amp; (32 ..)</td>
</tr>
<tr>
<td>3</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (16#8000)</td>
<td>Alarm type = (14 .. 30) &amp; (32 ..)</td>
<td>6 (alarm)</td>
<td>Alarm type = (14 .. 30) &amp; (32 ..)</td>
</tr>
<tr>
<td>3</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (0 – 16#7FFF)</td>
<td>Alarm type = 1</td>
<td>6 (alarm)</td>
<td>Alarm type = 1</td>
</tr>
<tr>
<td>Error severity</td>
<td>SubSysteminfo</td>
<td>Additional</td>
<td>Error code</td>
<td>Meaning</td>
<td>Remedy</td>
</tr>
<tr>
<td>----------------</td>
<td>---------------</td>
<td>------------</td>
<td>------------</td>
<td>---------</td>
<td>--------</td>
</tr>
<tr>
<td>Sub1_</td>
<td>Sub2_</td>
<td>ADD_Word 1_Word 2</td>
<td>Err_x or Err_Word 1_Word 2 (Word1/2 in hex format)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (16#8000)</td>
<td>Alarm type = 1</td>
<td>6 (alarm)</td>
<td>Alarm type = 1</td>
</tr>
<tr>
<td>3</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (0 – 16#7FFF)</td>
<td>Alarm type = 2</td>
<td>6 (alarm)</td>
<td>Alarm type = 2</td>
</tr>
<tr>
<td>3</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (16#8000)</td>
<td>Alarm type = 2</td>
<td>6 (alarm)</td>
<td>Alarm type = 2</td>
</tr>
<tr>
<td>3</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (16#8000)</td>
<td>Alarm type = 3</td>
<td>6 (alarm)</td>
<td>Alarm type = 3</td>
</tr>
<tr>
<td>3</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (16#8000)</td>
<td>Alarm type = 4</td>
<td>6 (alarm)</td>
<td>Alarm type = 4</td>
</tr>
<tr>
<td>3</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (16#8000)</td>
<td>Alarm type = 5</td>
<td>6 (alarm)</td>
<td>Alarm type = 5</td>
</tr>
<tr>
<td>3</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (16#8000)</td>
<td>Alarm type = 6</td>
<td>6 (alarm)</td>
<td>Alarm type = 6</td>
</tr>
<tr>
<td>3</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (16#8000)</td>
<td>Alarm type = 7</td>
<td>6 (alarm)</td>
<td>Alarm type = 7</td>
</tr>
<tr>
<td>3</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (16#8000)</td>
<td>Alarm type = 8</td>
<td>6 (alarm)</td>
<td>Alarm type = 8</td>
</tr>
<tr>
<td>3</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (16#8000)</td>
<td>Alarm type = 9</td>
<td>6 (alarm)</td>
<td>Alarm type = 9</td>
</tr>
<tr>
<td>3</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (16#8000)</td>
<td>Alarm type = 10</td>
<td>6 (alarm)</td>
<td>Alarm type = 10</td>
</tr>
<tr>
<td>3</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (16#8000)</td>
<td>Alarm type = 11</td>
<td>6 (alarm)</td>
<td>Alarm type = 11</td>
</tr>
<tr>
<td>3</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (0 – 16#7FFF)</td>
<td>Alarm type = 12</td>
<td>6 (alarm)</td>
<td>Alarm type = 12</td>
</tr>
<tr>
<td>3</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (16#8000)</td>
<td>Alarm type = 12</td>
<td>6 (alarm)</td>
<td>Alarm type = 12</td>
</tr>
<tr>
<td>Error severity</td>
<td>SubSysteminfo</td>
<td>Additional</td>
<td>Error code</td>
<td>Meaning</td>
<td>Remedy</td>
</tr>
<tr>
<td>----------------</td>
<td>---------------</td>
<td>------------</td>
<td>------------</td>
<td>---------</td>
<td>--------</td>
</tr>
<tr>
<td></td>
<td>Sub1_</td>
<td>Sub2_</td>
<td>Add_Word 1_Word 2</td>
<td>Err_x or Err_Word 1_Word 2 (Word1/2 in hex format)</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (16#8000)</td>
<td>Alarm type = 13</td>
<td>6 (alarm)</td>
<td>Alarm type = 13</td>
</tr>
<tr>
<td>3</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (16#8000)</td>
<td>Alarm type = 31</td>
<td>6 (alarm)</td>
<td>Alarm type = 31</td>
</tr>
</tbody>
</table>
Example

For better understanding, we show the manual interpretation of CM579-PNIO diagnosis with an example.

System: AC500 CM579-PNIO + CI501-PNIO + optional S500 I/O inserted as PROFINET standard device

Error: discrepancy time expired (class 3, error ID 3) at channel 4 of first attached S500 I/O device on CI501-PNIO

For comparison: If a method with text output is used, e.g. DiagGetFirstValAndTxt the text output will be the string: Timestamp; E3; device name; subslot 1, channel 4, extended channel diagnosis; error ID 3: discrepancy time expired (class 3, error ID 3)

In Automation Builder the following error entry data is displayed:

Analyze the data in the following order: Element "dwAdditional" for the type of diagnosis, element "Error Code", element "SubSysteminfo".

**Type of diagnosis**

1. Analyze element "dwAdditional", column "Additional" in error lists.
   
   Convert the given value from decimal to hexadecimal format.
   
   "dwAdditional" = 131076 = 16#20004

2. Interpretation:
   
   Word 2 = 2
   
   Word 1 = 4

3. Generate error text Add_Word 1_Word 2 = Add_4_2

4. Look up which error type it is.
   
   Add_4_2 = extended channel diagnosis

**Data analysis**

1. Analyze element "Error Code":
   
   "dwErrorCode" = 196867 = 16#30103 →
   
   Word 2 (extended error type) = 16#0003
   
   Word 1 (error type) = 16#0103
   
   Error text: Err_Word 1 (hex)_Word 2 (hex)
   
   Error ID 3 – discrepancy time expired (class 3, error ID 3)

2. Analyze "SubSysteminfo"
   
   "dwSubSysteminfo" = 65540 = 16#10004 →
   
   Word 2 (subslot index) = 1
   
   Word 1 (channel index) = 4
<table>
<thead>
<tr>
<th>Error severity</th>
<th>SubSysteminfo</th>
<th>Additional</th>
<th>Error code</th>
<th>Meaning</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Subslot index (0 – 16#9FFF)</td>
<td>Channel index (0 – 16#7FFF)</td>
<td>2 (USI: 16#8002) extended channel diagnosis</td>
<td>4 (diagnosis alarm)</td>
<td>Extended error type</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>4</td>
<td>2</td>
<td>4</td>
<td>16#0003</td>
</tr>
<tr>
<td></td>
<td>dwSubSysteminfo</td>
<td>Add_Word 1_Word 2</td>
<td>dwErrorCode</td>
<td>Entries in Diag values</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Sub2_ = Subslot</td>
<td>Sub1_ = Channel</td>
<td>Add_4_2 = extended channel diagnosis</td>
<td>Err_Word 1_Word 2</td>
<td>Text search criteria (ID) in text list Diag_PNIO_26_22</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Err_0103_0003 = error ID 3: Discrepancy time expired (class 3, error ID 3)</td>
<td>Text from Automation Builder error list (default) in text list Diag_PNIO_26_22</td>
</tr>
</tbody>
</table>
7 Glossary

AC500 Standard PLCs
AC500-eCo Compact PLCs
AC500-S Safety PLCs
AC500-S Programming Tool IEC 61131-3 editor, integrated in engineering suite Automation Builder
AC500-S-XC Safety PLCs suitable for extreme environmental conditions
AC500 V2 Range of AC500 and AC500-eCo CPUs
AC500 V3 Range of AC500 and AC500-eCo CPUs
AC500-XC Standard PLCs suitable for extreme environmental conditions

Alarm Diagnosis message which must be acknowledged by the user. The alarm will continue
to be displayed even if the issue has been resolved in the meantime until it is acknowl-
edged.

Automation Builder Engineering suite for configuration and programming of all PLCs

Cold start Note: The AC500-eCo V3 does not use a battery for buffering the operand areas speci-
fied below, hence the “cold start” mode does not exist in this product.

- A cold start is performed by switching power OFF/ON if no battery is connected.
- All RAM memory modules are checked and erased \(\text{Command 'Reset Cold'}\) on page 2633.
- If no user program is stored in the Flash EPROM, the default values (as set on
delivery) are applied to the interfaces.
- If there is a user program stored in the Flash EPROM, it is loaded into RAM.
- The default operating modes set by the PLC configuration are applied.

CP600 Control panels for application visualizations

Data buffering

- Data buffering, i.e., maintaining data after power ON/OFF, is only possible, if a battery
is connected for AC500 CPU and the buffering will take place in FLASH with AC500-
eCo V3 CPU. The following data can be buffered completely or in parts:
  - Data in the addressable flag area (%M area)
  - RETAIN variable
  - PERSISTENT variable (number is limited, no structured variables)
  - PERSISTENT area (%R area)
- In order to buffer particular data, the data must be excluded from the initialization
process \(\text {Chapter 6.8.2.1 “Handling of remanent variables for AC500 V3 products” on page 4412.}\)

Download

- Download means loading the complete user program into the PLC's RAM. This
process is started by selecting the menu item "Online/Download" in the programming
system or after confirming a corresponding system message when switching to online
mode (menu item "Online/Login").
- Execution of the user program is stopped.
- In order to store the user program to the Flash memory, the menu item "Online/Create
boot project" must be called after downloading the program.
- Variables are set to their initialization values according to the initialization table.
- RETAIN variables can have wrong values as they can be allocated to other memory addresses in the new project!
- A download is forced by the following:
  - changed PLC configuration
  - changed task configuration
  - changed library management
  - changed compile-specific settings (segment sizes)
  - execution of the commands "Project/Clean all" and "Project/Rebuild All".

**Event**
Diagnosis message which does not require acknowledgement. The event describes the current status of the device. The event disappears once the issue has been resolved.

**HMI**
Human machine interface

**Online change**
- After a project has changed, only these changes are compiled when pressing the key <F11> or calling the menu item "Project/Build". The changed program parts are marked with a blue arrow in the block list.
- The term Online Change means loading the changes made in the user program into the PLC's RAM using the programming system (after confirming a corresponding system message when switching to online mode, menu item "Online/Login").
- Execution of the user program is not stopped. After downloading the program changes, the program is re-organized. During re-organization, no further online change command is allowed. The storage of the user program to the Flash memory using the command "Online/Create boot project" cannot be initiated until re-organization is completed.
- Online Change is not possible after:
  - changes in the PLC configuration
  - changes in the task configuration
  - changes in the library management
  - changed compile-specific settings (segment sizes)
  - performing the commands "Project/Clean all" and "Project/Rebuild All".

**Panel Builder PB610**
Engineering tool for control panels, integrated in engineering suite Automation Builder

**Reset**
- Performs a START -> STOP process.
- Preparation for program restart, i.e., the variables (VAR) (exception: RETAIN variables) are set to their initialization values.
- Reset is performed using the menu item "Online/Reset" in the programming system or pressing the function key RUN for ≥ 5 s in STOP mode.

**Reset (cold)**
- Performs a START -> STOP process.
- Preparation for program restart, i.e., the variables (VAR) (also RETAIN variables) are set to their initialization values.
- Reset (cold) is performed using the menu item "Online/Reset (cold)" in the programming system.

**Reset (original)**
- Resets the controller to its original state (deletion of Flash, SRAM (%M, area, %R area, RETAIN, RETAIN PERSISTENT), Communication Module configurations and user program!).
- Reset (original) is performed using the menu item "Online/Reset (original)" in the programming system.

**RUN -> STOP**
- RUN -> STOP means pressing the RUN function key on the PLC while the PLC is in run mode (AC500 PLC display "run", AC500-eCo PLC "RUN LED" is ON).
- If a user program is loaded into RAM, execution is stopped.
- All outputs are set to FALSE or 0.
- Variables keep their current values, i.e., they are not initialized.
- The AC500 PLC display changes from "run" to "STOP", AC500-eCo "RUN LED" changes from ON to OFF.
START -> STOP
- START -> STOP means stopping the execution of the user program in the PLC's RAM using the menu item "Online/Stop" in the programming system.
- All outputs are set to FALSE or 0.
- Variables keep their current values, i.e., they are not initialized.
- The AC500 PLC display changes from "run" to "StoP".

STOP -> RUN
- STOP -> RUN means short pressing the RUN function key on the PLC while the PLC is in STOP mode (AC500 PLC display "StoP", AC500-eCo "RUN LED" is ON). "RUN LED" is OFF of the toggle switch of an AC500-eCo CPU.
- If a user program is loaded into RAM, execution is continued, i.e., variables will not be set to their initialization values.
- The AC500 PLC display changes from "StoP" to "run", AC500-eCo "RUN LED" changes from OFF to ON.

STOP -> START
- STOP -> START means continuing the execution of the user program in the PLC's RAM using the menu item "Online/Start" in the programming system.
- If a user program is loaded into RAM, execution is continued, i.e., variables will not be set to their initialization values.
- The AC500 PLC display changes from "StoP" to "run", AC500-eCo PLC "RUN LED" changes from OFF to ON.

Warm start
- A warm start is performed by switching power OFF/ON with a battery connected.
- All RAM memory modules are checked and erased except of the buffered operand areas and the RETAIN variables § Chapter 6.4.1.21.3.7.11 “Command 'Reset Warm'” on page 2634.
- If there is a user program stored in the Flash EPROM, it is loaded into RAM.
- The default operating modes set by the PLC configuration are applied.
8 Index

1, 2, 3 ...

__AdrInst ........................................... 2335
__BitOf ............................................. 2335
__Cast .............................................. 2335
__CATCH ............................................ 2206
__COMPARE_AND_SWAP ............................. 2212
__Copy .............................................. 2335
__CRC .............................................. 2335
__CURRENTTASK ................................. 2211
__DELETE ........................................... 2198
__ENDTRY' ........................................ 2206
__FCall ............................................ 2335
__FINALLY .......................................... 2206
__Init ............................................... 2335
__ISVALIDREF .............................. 2201, 2245
__Lazy .............................................. 2335
__Localoffset ................................. 2335
__MaxOffset ...................................... 2335
__NEW .............................................. 2201
__POOL .............................................. 2217
__POSITION ....................................... 2214
__POUNAME ........................................ 2214
__PropertyInfo ................................... 2335
__QUERYINTERFACE ............................... 2204
__QUERYPOINTER .................................. 2205
__RefAdr ........................................... 2335
__RELOC ............................................ 2335
__System.ExceptionCode, data type .......... 2206
__SystemScope .................................... 2335
__TEST_AND_SET .................................. 2215
__TRY ................................................. 2206
__TypeOf ........................................... 2335
__UXINT .......................................... 2243
    convert ...................................... 2159
    _UXINT_TO__XINT ................................ 2159
    _UXINT_TO__XWORD .............................. 2159
    _UXINT_TO_BIT ................................ 2159
    _UXINT_TO_BOOL ................................ 2159
    _UXINT_TO_BYTE ................................ 2159
    _UXINT_TO_DATE ................................ 2159
    _UXINT_TO_DINT ................................ 2159
    _UXINT_TO_DT ................................ 2159
    __UXINT_TO_DWORD .............................. 2159
    __UXINT_TO_INT ................................ 2159
    __UXINT_TO_LDATE ................................ 2159
    __UXINT_TO_LDT ................................ 2159
    __UXINT_TO_LINT ................................ 2159
    __UXINT_TO_LREAL ................................ 2159
    __UXINT_TO_LTOD ................................ 2159
    __UXINT_TO_LWORD ................................ 2159
    __UXINT_TO_REAL ................................ 2159
    __UXINT_TO_SINT ................................ 2159
    __UXINT_TO_STRING ................................ 2159
    __UXINT_TO_TIME ................................ 2159
    __UXINT_TO_TOD ................................ 2159
    __UXINT_TO_UDINT ................................ 2159
    __UXINT_TO_UINT ................................ 2159
    __UXINT_TO_ULINT ................................ 2159
    __UXINT_TO_USINT ................................ 2159
    __UXINT_TO_WORD ................................ 2159
    __UXINT_TO_WSTRING ................................ 2159
    _VarInfo ...................................... 2335
    __VCADD ........................................... 2255
    vector operator ................................ 2255
    __VCDIV ........................................... 2256
    vector operator ................................ 2256
    __VCDOT ........................................... 2257
    vector operator ................................ 2257
    __VCLOAD_LREAL .................................. 2259
    vector operator ................................ 2259
    __VCLOAD_REAL .................................... 2259
    vector operator ................................ 2259
    __VCMAX .......................................... 2258
    vector operator ................................ 2258
    __VMIN .......................................... 2258
    vector operator ................................ 2258
    __VCMUL .......................................... 2256
    vector operator ................................ 2256
    __VCSET_LREAL .................................... 2259
    vector operator ................................ 2259
    __VCSET_REAL .................................... 2258
    vector operator ................................ 2258
Index

__VCSQRT ........................................ 2257
vector operator .................................. 2257
__VCSTORE ........................................ 2260
vector operator .................................. 2260
__VCSUB .......................................... 2255
vector operator .................................. 2255
__VECTOR .......................................... 2253
_Wait ............................................. 2335
__XADD ............................................ 2213
__XINT ............................................ 2243
convert ........................................... 2159
__XINT_TO__UXINT .................................. 2159
__XINT_TO__XWORD .................................. 2159
__XINT_TO_BIT ...................................... 2159
__XINT_TO_BOOL .................................... 2159
__XINT_TO_BYTE .................................... 2159
__XINT_TO_DATE .................................... 2159
__XINT_TO_DINT .................................... 2159
__XINT_TO_DT ...................................... 2159
__XINT_TO_DWORD .................................... 2159
__XINT_TO_INT ..................................... 2159
__XINT_TO_LDATE .................................... 2159
__XINT_TO_LDT ...................................... 2159
__XINT_TO_LINT ..................................... 2159
__XINT_TO_LREAL .................................... 2159
__XINT_TO_LTIME .................................... 2159
__XINT_TO_LWORD .................................... 2159
__XINT_TO_REAL ..................................... 2159
__XINT_TO_SINT ..................................... 2159
__XINT_TO_STRING ................................... 2159
__XINT_TO_TIME ..................................... 2159
__XINT_TO_TOD ...................................... 2159
__XINT_TO_UDINT .................................... 2159
__XINT_TO_UINT ..................................... 2159
__XINT_TO_ULINT .................................... 2159
__XINT_TO_USINT .................................... 2159
__XINT_TO_WORD ..................................... 2159
__XINT_TO_WSTRING .................................. 2159
cnt.library ........................................ 2035
_lafs.library ....................................... 2035
//--timestampingserverurl, command line .......... 2034
//--compare, command line ........................ 2029
//--culture, command line ........................ 2028
//--enforcesignedcompiledlibraries, command line .................. 2033
//--profile, command line ........................ 2028
//--project, command line ........................ 2029
//--projectarchive, command line .......... 2029
//--runscript, command line ....................... 2030
//--signaturethumbprint, command line ............ 2033
//--skipunlicensedplugins, command line .......... 2033
%
format definition %c, %s for text variables ........... 3330
format definition in output text, visualization ..... 3329
%M .................................................. 4417
3rd party device diagnosis .......................... 4606
21 CFR part 11 standard ............................ 4398

A
AB (Automation Builder)
description ....................................... 95
association
insert for SFC action, command .......................... 2680, 2681
AT ........................................ 1902
declaration .................................... 1902
ATAN ...................................... 2198
attribute
for pragma ...................................... 2271
authentication
SVN ............................................ 4352
automatic formatting .............................. 2581
ST code ....................................... 2581
Automation Builder
description ...................................... 95
device state diagnosis ............................ 4611
diagnosis description ............................ 4611, 4615
getting started .................................. 16
installation ...................................... 16
licensing ...................................... 16
AX521 ........................................... 780
AX522 ........................................... 810
AX561 ........................................... 655
B
B .................................................. 2231
size prefix ...................................... 2231
background
designing the visualization ...................... 2884
placing, visualization ........................... 3349
backup ........................................... 2024, 2435
create backup file ................................ 2435
backup and restore ................................ 2024, 2435
backup file ...................................... 2435
create, save .................................... 2435
BACnet ......................................... 1734, 3833
BACnet Building Controller ..................... 1736, 3835
BACnet configuration ............................ 1738, 3838
BACnet libraries ................................ 1748, 3847
BACnet network .................................. 1736, 3835
BACnet server root object ....................... 1739, 3838
BACnet-BC System ................................ 1733, 3833
bar display .................................... 3181, 3606
visualization element .......................... 3181, 3606
Basic CPU ...................................... 176
battery .......................................... 4445
Bézier curve .................................. 3012, 3437
visualization element .................. 3012, 3437
BIBBs and services .................... 1738, 3837
binary
display mode when monitoring ........ 2654
number .................................. 2220
binary number
format definition \%b .................. 3329
BIT .................................. 2243
convert .............................. 2159
structure .......................... 2262
bit access .......................... 2229
in integer variable .................. 2229
in structure variable .............. 2229
BIT_TO___UXINT ...................... 2159
BIT_TO___XINT ...................... 2159
BIT_TO___XWORD .................... 2159
BIT_TO_BOOL ...................... 2159
BIT_TO_BYTE ...................... 2159
BIT_TO_DATE ...................... 2159
BIT_TO_DINT ...................... 2159
BIT_TO_DT ......................... 2159
BIT_TO_DWORD ..................... 2159
BIT_TO_INT ....................... 2159
BIT_TO_LDATE ..................... 2159
BIT_TO_LDT ........................ 2159
BIT_TO_LINT ....................... 2159
BIT_TO_LREAL ..................... 2159
BIT_TO_LTIME ..................... 2159
BIT_TO_LTOD ....................... 2159
BIT_TO_LWORD ...................... 2159
BIT_TO_REAL ....................... 2159
BIT_TO_SINT ....................... 2159
BIT_TO_STRING ..................... 2159
BIT_TO_TIME ....................... 2159
BIT_TO_TOD ......................... 2159
BIT_TO_UDINT ....................... 2159
BIT_TO_UINT ....................... 2159
BIT_TO_ULINT ....................... 2159
BIT_TO_USINT ....................... 2159
BIT_TO_WORD ....................... 2159
BIT_TO_WSTRING .................... 2159
BITADR ................................ 2151
bitmap, properties ................... 2758
clear all .................................. 2571
clear all in active editor .......... 2571
next ............................... 2570
next in active editor ............... 2570
previous ............................. 2570
previous in active editor .......... 2570
set .................................. 1908
toggle ................................ 2569
view .................................. 2585
BOOL ................................. 2235
constant ................................ 2220
convert .............................. 2154
data type ............................. 2235
BOOL_TO___UXINT .................... 2154
BOOL_TO___XINT ..................... 2154
BOOL_TO___XWORD ................... 2154
BOOL_TO_BIT ....................... 2154
BOOL_TO_BYTE ...................... 2154
BOOL_TO_DATE ...................... 2154
BOOL_TO_DINT ...................... 2154
BOOL_TO_DT ......................... 2154
BOOL_TO_DWORD ..................... 2154
BOOL_TO_INT ....................... 2154
BOOL_TO_LDATE ..................... 2154
BOOL_TO_LDT ......................... 2154
BOOL_TO_LINT ....................... 2154
BOOL_TO_LREAL ..................... 2154
BOOL_TO_LTIME ..................... 2154
BOOL_TO_LTOD ....................... 2154
BOOL_TO_LWORD ...................... 2154
BOOL_TO_REAL ....................... 2154
BOOL_TO_SINT ....................... 2154
BOOL_TO_STRING ..................... 2154
BOOL_TO_TIME ....................... 2154
BOOL_TO_TOD ......................... 2154
BOOL_TO_UDINT ....................... 2154
BOOL_TO_UINT ....................... 2154
BOOL_TO_ULINT ....................... 2154
BOOL_TO_USINT ....................... 2154
BOOL_TO_WORD ....................... 2154
BOOL_TO_WSTRING .................... 2154
Index
<table>
<thead>
<tr>
<th><strong>boot application</strong></th>
<th><strong>browse</strong></th>
<th><strong>BSP</strong></th>
<th><strong>build</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>delete</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>encrypt</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>encrypted transfer</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>encryption</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>generate</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>options</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>properties</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>signing</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Boot Support Package</td>
<td>4397</td>
<td></td>
<td></td>
</tr>
<tr>
<td>box</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CFC</td>
<td>2110</td>
<td></td>
<td></td>
</tr>
<tr>
<td>clean, FBD/LD</td>
<td>2710</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FBD/LD/IL</td>
<td>2092</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FBD/LD/IL, empty box with en/eno</td>
<td>2702</td>
<td></td>
<td></td>
</tr>
<tr>
<td>insert parallel LD</td>
<td>2702</td>
<td></td>
<td></td>
</tr>
<tr>
<td>insert, FBD/LD/IL</td>
<td>2701</td>
<td></td>
<td></td>
</tr>
<tr>
<td>repair</td>
<td>2710</td>
<td></td>
<td></td>
</tr>
<tr>
<td>with EN/ENO, FBD/LD/IL</td>
<td>2702</td>
<td></td>
<td></td>
</tr>
<tr>
<td>box input</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>insert, FBD/LD/IL</td>
<td>2703</td>
<td></td>
<td></td>
</tr>
<tr>
<td>bracket, code</td>
<td>2568</td>
<td></td>
<td></td>
</tr>
<tr>
<td>branch</td>
<td>2078</td>
<td></td>
<td></td>
</tr>
<tr>
<td>add</td>
<td>2679</td>
<td></td>
<td></td>
</tr>
<tr>
<td>closed</td>
<td>2096</td>
<td></td>
<td></td>
</tr>
<tr>
<td>insert right</td>
<td>2679</td>
<td></td>
<td></td>
</tr>
<tr>
<td>set end point</td>
<td>2710</td>
<td></td>
<td></td>
</tr>
<tr>
<td>start/end</td>
<td>2095</td>
<td></td>
<td></td>
</tr>
<tr>
<td>branch/tag</td>
<td>4347</td>
<td></td>
<td></td>
</tr>
<tr>
<td>create</td>
<td>1981</td>
<td></td>
<td></td>
</tr>
<tr>
<td>breakpoint</td>
<td>1981</td>
<td></td>
<td></td>
</tr>
<tr>
<td>condition</td>
<td>2750</td>
<td></td>
<td></td>
</tr>
<tr>
<td>define condition</td>
<td>1983</td>
<td></td>
<td></td>
</tr>
<tr>
<td>define execution point</td>
<td>1984</td>
<td></td>
<td></td>
</tr>
<tr>
<td>disable</td>
<td>2646</td>
<td></td>
<td></td>
</tr>
<tr>
<td>edit</td>
<td>2645</td>
<td></td>
<td></td>
</tr>
<tr>
<td>enable</td>
<td>2646</td>
<td></td>
<td></td>
</tr>
<tr>
<td>execution point</td>
<td>2751</td>
<td></td>
<td></td>
</tr>
<tr>
<td>new</td>
<td>2645</td>
<td></td>
<td></td>
</tr>
<tr>
<td>position</td>
<td>2752</td>
<td></td>
<td></td>
</tr>
<tr>
<td>set</td>
<td>1983</td>
<td></td>
<td></td>
</tr>
<tr>
<td>toggle</td>
<td>2646</td>
<td></td>
<td></td>
</tr>
<tr>
<td>view</td>
<td>2586</td>
<td></td>
<td></td>
</tr>
<tr>
<td>broadcast address</td>
<td>1941</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
BYTE_TO_STRING ........................................ 2159
BYTE_TO_TOD ........................................ 2159
BYTE_TO_UDINT .......................................... 2159
BYTE_TO_UINT ........................................ 2159
BYTE_TO_ULINT .......................................... 2159
BYTE_TO_USINT .......................................... 2159
BYTE_TO_WORD ........................................ 2159
BYTE_TO_WSTRING ...................................... 2159
BYTEBIT_TO_TIME ....................................... 2159

C
C integration
   IDE, path .......................................... 2756
   properties ......................................... 2756
C stub file ............................................ 2619
C stub file for external library .............. 2619
C0001 .................................................. 2344
C0002 .................................................. 2344
C0004 .................................................. 2345
C0005 .................................................. 2345
C0006 .................................................. 2346
C0007 .................................................. 2346
C0008 .................................................. 2346
C0009 .................................................. 2347
C0010 .................................................. 2347
C0011 .................................................. 2347
C0013 .................................................. 2348
C0015 .................................................. 2348
C0018 .................................................. 2348
C0020 .................................................. 2349
C0022 .................................................. 2349
C0023 .................................................. 2349
C0026 .................................................. 2350
C0027 .................................................. 2350
C0030 .................................................. 2350
C0031 .................................................. 2351
C0032 .................................................. 2351
C0033 .................................................. 2351
C0035 .................................................. 2352
C0036 .................................................. 2352
C0037 .................................................. 2352
C0038 .................................................. 2353
C0039 .................................................. 2353
C0040 .................................................. 2354
C0041 .................................................. 2354
C0042 .................................................. 2355
C0043 .................................................. 2355
C0044 .................................................. 2356
C0045 .................................................. 2356
C0046 .................................................. 2356
C0047 .................................................. 2357
C0048 .................................................. 2357
C0049 .................................................. 2358
C0050 .................................................. 2358
C0051 .................................................. 2358
C0053 .................................................. 2359
C0061 .................................................. 2359
C0062 .................................................. 2359
C0064 .................................................. 2360
C0065 .................................................. 2360
C0066 .................................................. 2360
C0068 .................................................. 2361
C0069 .................................................. 2361
C0070 .................................................. 2362
C0072 .................................................. 2362
C0074 .................................................. 2362
C0075 .................................................. 2363
C0076 .................................................. 2363
C0077 .................................................. 2363
C0078 .................................................. 2364
C0080 .................................................. 2364
C0081 .................................................. 2365
C0082 .................................................. 2365
C0084 .................................................. 2365
C0085 .................................................. 2366
C0086 .................................................. 2366
C0087 .................................................. 2367
C0089 .................................................. 2367
C0090 .................................................. 2368
C0091 .................................................. 2368
C0094 .................................................. 2368
C0096 .................................................. 2369
C0097 .................................................. 2369
C0098 .................................................. 2370
C0099 .................................................. 2370
C0101 .................................................. 2371
C0102 .................................................. 2371
C0104 .................................................. 2371
C0114 .................................................. 2371
C0115 .................................................. 2372
C0116 ................................. 2372 ................................. 2378
C0117 ................................. 2372 ................................. 2382
C0118 ................................. 2372 ................................. 2382
C0119 ................................. 2373 ................................. 2382
C0120 ................................ 2373 ................................. 2382
C0122 ................................ 2374 ................................. 2382
C0124 ................................ 2374 ................................. 2382
C0125 ................................ 2375 ................................. 2382
C0126 ................................ 2375 ................................. 2382
C0130 ................................ 2375 ................................. 2382
C0131 ................................ 2376 ................................. 2382
C0132 ................................ 2376 ................................. 2382
C0136 ................................ 2376 ................................. 2382
C0138 ................................ 2377 ................................. 2383
C0139 ................................ 2377 ................................. 2383
C0140 ................................ 2377 ................................. 2383
C0141 ................................ 2378 ................................. 2383
C0142 ................................ 2378 ................................. 2383
C0143 ................................ 2378 ................................. 2383
C0144 ................................ 2379 ................................. 2383
C0145 ................................ 2379 ................................. 2383
C0149 ................................ 2380 ................................. 2384
C0161 ................................ 2380 ................................. 2384
C0162 ................................ 2380 ................................. 2384
C0164 ................................ 2381 ................................. 2384
C0165 ................................ 2381 ................................. 2384
C0168 ................................ 2381 ................................. 2384
C0169 ................................ 2382 ................................. 2384
C0173 ................................ 2383 ................................. 2384
C0174 ................................ 2383 ................................. 2384
C0175 ................................ 2383 ................................. 2384
C0177 ................................ 2384 ................................. 2384
C0178 ................................ 2384 ................................. 2384
C0179 ................................ 2385 ................................. 2384
C0180 ................................ 2385 ................................. 2384
C0182 ................................ 2385 ................................. 2384
C0183 ................................ 2386 ................................. 2385
C0185 ................................ 2386 ................................. 2385
C0186 ................................ 2386 ................................. 2385
C0188 ................................ 2387 ................................. 2385
C0189 ................................ 2387 ................................. 2385
C0190 ................................ 2388 ................................. 2385
C0191 ................................ 2388 ................................. 2385
C0195 ................................ 2388 ................................. 2385
C0196 ................................ 2388 ................................. 2385
C0197 ................................ 2389 ................................. 2385
C0198 ................................ 2389 ................................. 2385
C0199 ................................ 2389 ................................. 2385
C0201 ................................ 2390 ................................. 2385
C0203 ................................ 2390 ................................. 2385
C0204 ................................ 2390 ................................. 2385
C0205 ................................ 2391 ................................. 2385
C0206 ................................ 2391 ................................. 2385
C0207 ................................ 2391 ................................. 2385
C0208 ................................ 2391 ................................. 2385
C0209 ................................ 2392 ................................. 2385
C0211 ................................ 2392 ................................. 2385
C0212 ................................ 2393 ................................. 2385
C0213 ................................ 2393 ................................. 2385
C0215 ................................ 2393 ................................. 2385
C0216 ................................ 2393 ................................. 2385
C0217 ................................ 2393 ................................. 2385
C0218 ................................ 2394 ................................. 2385
C0219 ................................ 2394 ................................. 2385
C0221 ................................ 2395 ................................. 2385
C0222 ................................ 2395 ................................. 2385
C0224 ................................ 2395 ................................. 2385
C0225 ................................ 2396 ................................. 2385
C0227 ................................ 2396 ................................. 2385
C0228 ................................ 2397 ................................. 2385
C0230 ................................ 2397 ................................. 2385
C0232 ................................ 2397 ................................. 2385
C0233 ................................ 2398 ................................. 2385
C0234 ................................ 2398 ................................. 2385
C0235 ................................ 2398 ................................. 2385
C0236 ................................ 2399 ................................. 2385
C0237 ................................ 2399 ................................. 2385
C0238 ................................ 2400 ................................. 2385
C0239 ................................ 2400 ................................. 2385
C0240 ................................ 2401 ................................. 2385
C0241 ................................ 2401 ................................. 2385
C0242 ................................ 2401 ................................. 2385
C0243 ................................ 2402 ................................. 2385
C0244 ................................ 2402 ................................. 2385
C0245 ................................ 2402 ................................. 2385
C0509 ................................ 2403 ................................. 2385
C0542 ................................ 2404 ................................. 2385
C0543 ................................ 2405 ................................. 2385
C0549 ................................ 2405 ................................. 2385
C0550 ................................ 2406 ................................. 2385
C0554 ................................ 2406 ................................. 2385
C0555 ................................ 2407 ................................. 2385

2024/01/05 3ADR010583, 1, en_US 4721
<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>CA-signed certificate ............................................. 2044</td>
</tr>
<tr>
<td>CA-signed certificate ............................................. 1830</td>
</tr>
<tr>
<td>CAA library ..................................................... 3849</td>
</tr>
<tr>
<td>CAA SerialCom .................................................. 1590</td>
</tr>
<tr>
<td>CAL ............................................................. 2152</td>
</tr>
<tr>
<td>CALC ............................................................ 2087</td>
</tr>
<tr>
<td>CALCN ............................................................. 2087</td>
</tr>
<tr>
<td>call function ..................................................... 2482</td>
</tr>
<tr>
<td>call stack view ................................................... 2590</td>
</tr>
<tr>
<td>call tree show view .............................................. 2572</td>
</tr>
<tr>
<td>call_after_global_init_slot pragma attribute .................. 2273</td>
</tr>
<tr>
<td>call_after_init pragma attribute ................................ 2273</td>
</tr>
<tr>
<td>call_after_online_change_slot pragma attribute ............... 2274</td>
</tr>
<tr>
<td>call_before_global_exit_slot pragma attribute ................. 2275</td>
</tr>
<tr>
<td>calls function block ............................................. 2479</td>
</tr>
<tr>
<td>cam object properties ........................................... 2763</td>
</tr>
<tr>
<td>CANbus J1939 ....................................................... 1603</td>
</tr>
<tr>
<td>parameters ......................................................... 2433</td>
</tr>
<tr>
<td>CANopen ............................................................. 336, 953</td>
</tr>
<tr>
<td>local device ........................................................ 1602</td>
</tr>
<tr>
<td>modular device ...................................................... 1597</td>
</tr>
<tr>
<td>non-modular device ................................................. 1597</td>
</tr>
<tr>
<td>remote device ......................................................... 1597</td>
</tr>
<tr>
<td>Cartesian XY chart visualization element ....................... 3296</td>
</tr>
<tr>
<td>CASE ............................................................... 2057</td>
</tr>
<tr>
<td>CATCH ............................................................... 2206</td>
</tr>
<tr>
<td>category configure in visualization toolbox ..................... 3368</td>
</tr>
<tr>
<td>create for visualization elements ................................ 2873</td>
</tr>
<tr>
<td>CD522 ............................................................... 907</td>
</tr>
<tr>
<td>central I/O extension .............................................. 86, 88</td>
</tr>
<tr>
<td>centralized I/O expansion ......................................... 86, 88</td>
</tr>
<tr>
<td>centralized I/O extension ........................................... 86</td>
</tr>
<tr>
<td>centralized IO extension ........................................... 88</td>
</tr>
<tr>
<td>certificate ........................................................... 1820</td>
</tr>
<tr>
<td>application ........................................................... 1915</td>
</tr>
<tr>
<td>boot application, download, online change ......................... 4202</td>
</tr>
<tr>
<td>CA-signed ............................................................. 1820, 1830, 2044</td>
</tr>
<tr>
<td>controller ............................................................. 4201</td>
</tr>
<tr>
<td>delete ................................................................. 1830</td>
</tr>
<tr>
<td>encrypted communication ............................................ 1915, 1967</td>
</tr>
<tr>
<td>encryption ............................................................... 1820</td>
</tr>
<tr>
<td>encryption, instructions ............................................ 1830</td>
</tr>
<tr>
<td>expiration date ....................................................... 1967</td>
</tr>
<tr>
<td>expired ............................................................... 2043</td>
</tr>
<tr>
<td>general information .................................................. 2040</td>
</tr>
<tr>
<td>issue more .......................................................... 2043</td>
</tr>
<tr>
<td>project settings ..................................................... 2772</td>
</tr>
<tr>
<td>request from PLC .................................................... 1830</td>
</tr>
<tr>
<td>Security Agent ....................................................... 4201</td>
</tr>
<tr>
<td>sign boot application ............................................... 1917</td>
</tr>
<tr>
<td>signing ............................................................... 1820</td>
</tr>
<tr>
<td>time stamp by command line ....................................... 2034</td>
</tr>
<tr>
<td>via PLC shell ......................................................... 2044</td>
</tr>
<tr>
<td>Windows Certificate Store .......................................... 1820</td>
</tr>
<tr>
<td>CFC ................................................................. 1866</td>
</tr>
<tr>
<td>add input ............................................................. 2695</td>
</tr>
<tr>
<td>add output ............................................................ 2695</td>
</tr>
<tr>
<td>connect structure .................................................... 2698</td>
</tr>
<tr>
<td>connection mark ...................................................... 2696</td>
</tr>
<tr>
<td>create control point .................................................. 2696</td>
</tr>
<tr>
<td>edit page size ........................................................ 2686</td>
</tr>
<tr>
<td>edit parameters ....................................................... 2692</td>
</tr>
<tr>
<td>edit worksheet ........................................................ 2685</td>
</tr>
<tr>
<td>editor ................................................................. 2098</td>
</tr>
<tr>
<td>end with selected elements ......................................... 2689</td>
</tr>
<tr>
<td>force FB .............................................................. 2697</td>
</tr>
<tr>
<td>group ................................................................. 2696</td>
</tr>
<tr>
<td>keyboard shortcuts ................................................... 2102</td>
</tr>
<tr>
<td>move down ........................................................... 2690</td>
</tr>
<tr>
<td>move up ............................................................... 2689</td>
</tr>
<tr>
<td>order by data flow .................................................... 2691</td>
</tr>
<tr>
<td>order by topology ..................................................... 2691</td>
</tr>
</tbody>
</table>
page-oriented .................................. 1867, 2098
parameter values ................................. 2693
programming in CFC editor ...................... 1871
properties ......................................... 2761
reference ........................................... 2687
remove control point ............................... 2695
remove unused pins ................................ 2694
Reset ............................................... 2687
reset connecting line .............................. 2695
reset pins .......................................... 2694
route connections .................................. 2695
select connected pins .............................. 2694
send to front ...................................... 2688
Set .................................................. 2687
set element number within execution order ....... 2690
show next collision ............................... 2694
starting point in feedback network ............ 1869
ungroup ............................................. 2697
unlock connection .................................. 2693
CFC editor .......................................... 2098
breakpoint ......................................... 2103
debugging ......................................... 2103
monitoring ......................................... 2103
online mode ........................................ 2103
option ............................................... 2784
page-oriented ...................................... 2101
setting .............................................. 2784
toolbar ............................................... 2048
Change over to another module type .......... 1414, 1475
change the language ................................
font settings per language ........................ 2909
character string ...................................
with placeholder, visualization ................. 3329
character string literal ........................... 2221
chart ............................................... 2804, 3296
in trace editor ................................... 2804
visualization element ............................ 3296
check ............................................... 2298
avoid implicit checks ............................. 2298
check box .......................................... 3156, 3577
visualization element ............................. 3156, 3577
CheckBounds ...................................... 2502
array .............................................. 2247
CheckDivInt ....................................... 2505
CheckDivLInt' ................................... 2505
CheckDivLReal' ................................... 2507
CheckDivReal ..................................... 2506
CheckLRangeSigned ............................... 2510
CheckLRangeUnsigned ............................ 2512
CheckPointer ..................................... 2513
CheckRangeSigned ................................ 2268, 2508
CheckRangeUnsigned ............................. 2268, 2511
checks_in_libs .................................... 2500
chromium browser .................................. 4397
CI ..................................................... 92
CI501 .............................................. 1203
CI501-PNIO ....................................... 1203
CI502 .............................................. 1244
CI502-PNIO ....................................... 1244
CI511 .............................................. 1018
CI512 .............................................. 1051
CI512-ETHCAT ................................... 1051
CI521 .............................................. 1070
CI521-MODTCP ................................... 1070
CI522 .............................................. 1111
CI522-MODTCP ................................... 1111
CI541 .............................................. 1136
CI541-DP .......................................... 1136
CI542 .............................................. 1176
CI542-DP .......................................... 1176
CI581 .............................................. 953
CI581-CN .......................................... 953
CI582 .............................................. 993
clean all ............................................ 2618
clean gaps .......................................... 2719
clock ................................................
visualization element ............................ 3317, 3737
cloned code ........................................ 4216
closed branch, LD .................................. 2096
CloseDialog ....................................... 3337
CloseDialog2 ...................................... 3337
CM .................................................. 89, 327
CM579 ............................................. 344, 365
CM579- EtherCAT master ......................... 344
CM579-ETHCAT ................................... 344
CM579-PNIO ...................................... 365
CM582 .............................................. 371
CM589 .............................................. 371
CM589-PNIO ...................................... 371
<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
</table>

| CFC, route | 2695 |
| connection mark | 2696 |

**Connection**

| AC522 | 674 |

**connection and wiring**

| AC500 | 137 |
| AC500-eCo | 144 |

**connection mark**

| CFC | 2112 |

**connections**

| EtherNet/IP adapter | 2826 |

**Connections**

| AC522 | 674 |

**const_non_replaced, pragma**

| const_replaced, pragma | 2278 |

**constant**

| BOOL | 2220 |
| date | 2225 |
| input/output variable | 2117 |
| LTIME | 2224 |
| REAL and LREAL | 2221 |
| string | 2221 |
| time | 2223 |
| TIME | 2223 |
| time of day | 2225 |
| variable | 2121 |
| CONSTANT | 2219 |
| variable | 2121 |

**constants**

| numeric | 2220 |

**contact**

| insert | 2094 |
| ld | 2704 |
| negated | 2706 |
| negated, parallel | 2706 |
| paste right after | 2707 |
| right | 2705 |

**Content of the memory card for application update**

| 1432 |

**Content of the memory card for firmware update**

| 1432 |

**Content of the memory card for firmware/application update**

| 1432 |

**Content of the SD card for firmware/application update**

| 1432 |

**content operator**

| 2151 |

**CONTINUE**

| 2060 |

**Continuous Function Chart**

| page-oriented | 1867, 2098 |

**Continuous Function Chart (CFC)**

| 1866 |

**Continuous Function Chart (CFC) - page-oriented**

| 1867, 2098 |

**control cabinet**

| 134 |

**control cabinet assembly**

| 104 |

**control elements**

| 148, 1338 |

**control panel**

| 3282, 3707, 4397 |

**visualization element**

| 3282, 3707 |

**control panels**

| 95 |

**control panels CP600**

| 130, 145 |

**control point**

| CFC | 2109 |
| create | 2696 |
| remove | 2695 |

**control variable**

| IEC 61850 server | 1679 |

**controller**

| communication, certificate-encrypted | 1820 |
| security | 2041 |
| symbol access | 2458 |
| unencrypted communication | 2046 |
| wink | 2640 |

**conversion**

| 1394, 1799 |

**convert**

| device | 2747 |
| integer | 2159 |
| library reference | 2746 |
| strings | 2174 |
| to FBD | 2711 |
| to IL | 2711 |
| to LD | 2711 |
| TO | 2153 |
| TRUNC | 2193 |
| TRUNC_INT | 2193 |
| convert V2 project to V3 project | 1394, 1799 |

**copied code**

| 4216 |

**core dump**

| close | 2654 |
| create | 2653 |
| load | 2653 |
| load device log | 2654 |
| open memory view | 2592 |

<p>| 4726 | 3ADR010583, 1, en_US | 2024/01/05 |</p>
<table>
<thead>
<tr>
<th>Term</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>alias</td>
<td>2267</td>
</tr>
<tr>
<td>ANY</td>
<td>2239</td>
</tr>
<tr>
<td>BIT</td>
<td>2243</td>
</tr>
<tr>
<td>date and time</td>
<td>2238</td>
</tr>
<tr>
<td>enumeration</td>
<td>2263</td>
</tr>
<tr>
<td>integer</td>
<td>2235</td>
</tr>
<tr>
<td>LTIME</td>
<td>2237</td>
</tr>
<tr>
<td>message</td>
<td>2304</td>
</tr>
<tr>
<td>overflow underflow</td>
<td>2129</td>
</tr>
<tr>
<td>reference</td>
<td>2245</td>
</tr>
<tr>
<td>standard data types</td>
<td>2234</td>
</tr>
<tr>
<td>structure</td>
<td>2261</td>
</tr>
<tr>
<td>UNION</td>
<td>2268</td>
</tr>
<tr>
<td>user defined</td>
<td>2263</td>
</tr>
<tr>
<td>WSTRING</td>
<td>2242</td>
</tr>
<tr>
<td>data unit type</td>
<td>2461</td>
</tr>
<tr>
<td>dataflow, pragma attribute</td>
<td>2279</td>
</tr>
<tr>
<td>dataset</td>
<td>1688</td>
</tr>
<tr>
<td>date</td>
<td>2238</td>
</tr>
<tr>
<td>constant</td>
<td>2225</td>
</tr>
<tr>
<td>data type</td>
<td>2238</td>
</tr>
<tr>
<td>DATE</td>
<td>2238</td>
</tr>
<tr>
<td>convert</td>
<td>2187</td>
</tr>
<tr>
<td>data type</td>
<td>2238</td>
</tr>
<tr>
<td>keyword</td>
<td>2225</td>
</tr>
<tr>
<td>date picker</td>
<td>3311, 3730</td>
</tr>
<tr>
<td>visualization element</td>
<td>3301, 3721</td>
</tr>
<tr>
<td>date range picker</td>
<td>3301, 3721</td>
</tr>
<tr>
<td>visualization element</td>
<td>3301, 3721</td>
</tr>
<tr>
<td>DATE_AND_TIME</td>
<td>2238</td>
</tr>
<tr>
<td>data type</td>
<td>2238</td>
</tr>
<tr>
<td>keyword</td>
<td>2225</td>
</tr>
<tr>
<td>DATE_TO__UXINT</td>
<td>2187</td>
</tr>
<tr>
<td>DATE_TO__XINT</td>
<td>2187</td>
</tr>
<tr>
<td>DATE_TO__XWORD</td>
<td>2187</td>
</tr>
<tr>
<td>DATE_TO_BOOL</td>
<td>2187</td>
</tr>
<tr>
<td>DATE_TO_BYTE</td>
<td>2187</td>
</tr>
<tr>
<td>DATE_TO_DINT</td>
<td>2187</td>
</tr>
<tr>
<td>DATE_TO_DT</td>
<td>2187</td>
</tr>
<tr>
<td>DATE_TO_DWORD</td>
<td>2187</td>
</tr>
<tr>
<td>DATE_TO_INT</td>
<td>2187</td>
</tr>
<tr>
<td>DATE_TO_LDATE</td>
<td>2187</td>
</tr>
<tr>
<td>DATE_TO_LDT</td>
<td>2187</td>
</tr>
<tr>
<td>DATE_TO_LINT</td>
<td>2187</td>
</tr>
</tbody>
</table>
device description
  download .................................. 2663
download, option .............................. 2785
install ....................................... 2663
device diagnosis ............................ 2812, 4613, 4628, 4648
device ECAD data
  command .................................. 2665
device editor .................................. 2447
access rights ............................... 2453
add user ................................... 2451
applications ................................ 2434
backup and restore .......................... 2435
communication .............................. 2427
communication settings ....................... 2427
encrypted communication ..................... 2427
EtherCAT ................................... 1610
files ........................................ 2027, 2437
generic ...................................... 2427
I/O mapping .................................. 2444
IEC objects .................................. 2449
information .................................. 2460
KNX ........................................... 1730
log ......................................... 2437
options ...................................... 2786
parameters ................................... 2433
PLC settings .................................. 2439
PLC shell .................................... 2441
status ........................................ 2460
symbol rights ................................ 2458
synchronized file ............................ 2436
task deployment .............................. 2459
users and groups ............................ 2450
device permission management file ........ 2451, 2454
  dm ........................................ 2451, 2454
device user management file .............. 2451, 2454
dum2, dum ................................... 2451, 2454
device version ................................ 2779
DEVICE_STATE .............................. 4629
devices view .................................. 2582
DeviceTrace .................................. 2007
  CPU load ................................... 2014
download ...................................... 2740
object ........................................ 2426
DI524 ........................................ 553
Digital input module ......................... 553
DI561 ......................................... 402
Digital input module ......................... 402
DI562 ......................................... 409
DI571 ......................................... 418
Digital input module ......................... 418
DI572 ......................................... 428
Digital input module ......................... 428
DI581-S ....................................... 94, 174
Diag (function block) ......................... 4621, 4631
DIAG_TXT_TYPE .............................. 4617
DIAG_VAL_TYPE .............................. 4616
Diag.NumClass ................................ 4620
Diag.NumTotal ................................ 4620
DiagAck ....................................... 4621, 4631
DiagGet... (method) ......................... 4621, 4631
diagnosis ...................................... 4605
  acknowledge ................................ 2602
device diagnosis ............................ 4613, 4648
  fieldbus ................................... 2812
  PLC shell .................................. 2022
  subtree ..................................... 2602
  system diagnosis ........................... 4613, 4619
Diagnosis
  AC522 ....................................... 689
  VisuDrvModbusRTUBroadcast .................. 3822
diagnosis description ....................... 4606, 4607, 4611, 4615
diagnosis message
  V3 .......................................... 4605, 4606
diagnosis messages list ...................... 4655
  CM579-ETHCAT .............................. 4665
  CM579-PNIO ................................ 4704
  CM582-DP ................................... 4699
  CM589-PNIO ................................ 4688
  CM598-CN ................................... 4689
Index

diagnosis system .................................. 4605
diagnostic messages list
  CM579-ETHCA .................................. 4665
  CM579-PNIO .................................. 4704
  CM589-PNIO .................................. 4688
  CM598-CN .................................. 4689
diagnostic system .................................. 4605
diagnostics history ............................... 1621
diagram
  autofit Y-trace axis ........................... 2733
  mouse zooming .................................. 2737
  DiagValToTxt .................. 4627, 4637
dialog .................................. 2957, 2962
  calling in a visualization .................. 2957
  close, input action .......................... 3371
  implement with interface ................... 2962
  open, input action .......................... 3371
  opening globally in a visualization ....... 2959
  user management for visualization ....... 3400
  dialog manager ................................ 3335
  methods .................................. 3335
  Differentiation AC500 V2/AC500 V3 .......... 6
digital I/O module ............................ 390
digital/analog I/O module .................. 840
  DINT .................................. 2235
  convert .................................. 2159
  DINT_TO___UXINT .................. 2159
  DINT_TO___XINT .................. 2159
  DINT_TO___XWORD .................. 2159
  DINT_TO_BIT .................. 2159
  DINT_TO_BOOL .................. 2159
  DINT_TO_BYTE .................. 2159
  DINT_TO_DATE .................. 2159
  DINT_TO_DT .................. 2159
  DINT_TO_DWORD .................. 2159
  DINT_TO_INT .................. 2159
  DINT_TO_LDATE .................. 2159
  DINT_TO_LDT .................. 2159
  DINT_TO_LINT .................. 2159
  DINT_TO_LREAL .................. 2159
  DINT_TO_LTIME .................. 2159
  DINT_TO_LTOD .................. 2159
  DINT_TO_LWORD .................. 2159
  DINT_TO_REAL .................. 2159
  DINT_TO_SINT .................. 2159
  DINT_TO_STRING .................. 2159
  DINT_TO_TIME .................. 2159
  DINT_TO_TOD .................. 2159
  DINT_TO_UDINT .............. 2159
  DINT_TO_UINT .................. 2159
  DINT_TO_ULINT .............. 2159
  DINT_TO_USINT .............. 2159
  DINT_TO_WORD .................. 2159
  DINT_TO_WSTRING .............. 2159
dip switch .................................. 3231, 3656
disassembly .................................. 106
  CM .................................. 109
  communication module .................. 109
  CPU .................................. 109, 114
  FM .................................. 107
  function module terminal base .......... 107
  I/O modules ................................ 113, 123
  option boards (AC500-eCo) .......... 114, 127
  processor module .............. 109, 114
terminal base ............................... 107
terminal block for onboard I/O (AC500-eCo) . 116
terminal unit ................................ 111
disassembly file ............................. 2622
disconnect 
  device .................................. 2640
display .................................. 148, 1338
  display variant ...................... 2973
  configure ................................ 2973
  executing as integrated .......... 2976
  executing webvisu ................ 2974
  maximum number .................. 3402
  size of the paintbuffer .......... 3401
  TargetVisu ...................... 3408
  WebVisu ...................... 3409
displaymode, pragma ...................... 2280
  DIV .................................. 2136
division by zero ...................... 2505, 2506, 2507
dm file
  device permission management file ... 2451, 2454
  DO .................................. 2056
  DO524 ................................ 562
  Digital output module .............. 562
  DO526 ................................ 571
DO561 ........................................ 437
  Digital output module .................. 437
DO562 ........................................ 447
  Digital output module .................. 447
DO571 ........................................ 457
  Digital output module .................. 457
DO572 ........................................ 468
  Digital output module .................. 468
DO573 ........................................ 478
  Digital output module .................. 478
document ................................... 2606
dongle ...................................... 1825, 2659
  encryption ................................ 1915
  project settings ....................... 2772
dot product ................................ 2257
download
  command ................................... 2637
  device description from the server .... 2785
  encrypt ................................... 4202
  encrypt code ............................. 1915
  library from server ..................... 2790
  multiple ................................ 2631
  source code, project setting .......... 2770
  trace .................................... 2734
  user data, visualization ............... 3406
download manager
  command ................................... 2631
  download to controller
    multiple ................................ 2631
  Drive parameter settings .............. 3811
  DT ........................................ 2238
    convert ................................ 2187
    data type ............................ 2238
    keyword ............................... 2225
    DT_TO___XWORD ......................... 2187
    DT_TO__UXINT .......................... 2187
    DT_TO__XINT ........................... 2187
    DT_TO__XWORD .......................... 2187
    DT_TO_BIT ............................. 2159
    DT_TO_BOOL ............................. 2159
    DT_TO_BYTE ............................ 2159
    DT_TO_DATE ............................ 2159
    DT_TO_DINT ............................ 2159
    DT_TO_DWORD .......................... 2159
    DT_TO_INT ............................. 2159
    DT_TO_LDATE ............................ 2159
    DT_TO_LDT ............................. 2159
    DT_TO_LINT ............................ 2159
    DT_TO_LREAL ............................ 2159
    DT_TO_LTOD ............................ 2159
    DT_TO_LWORD ........................... 2159
    DT_TO_REAL ............................ 2159
    DT_TO_SINT ............................ 2159
    DT_TO_STRING ........................... 2159
    DT_TO_TIME ............................ 2159
    DT_TO_TOD ............................. 2159
    DT_TO_UDINT ........................... 2159
    DT_TO_UINT ............................ 2159
    DT_TO_ULINT ........................... 2159
    DT_TO_USINT ........................... 2159
    DT_TO_WORD ............................. 2159
    DT_TO_WSTRING ........................ 2159
dum file ................................... 2450
dum2 file, dum file
  device user management file .......... 2451, 2454
duplicated code ......................... 4216
duplication .............................. 2678
  remove ................................ 2683
  SFC ..................................... 2678
  SFC, set ................................ 2683
duplication mode ........................ 2678
  DUT ...................................... 2461
    add .................................... 2462
    DWORD ................................. 2235
      convert ............................. 2159
    DWORD_TO___UXINT ..................... 2159
    DWORD_TO___XINT ...................... 2159
    DWORD_TO___XWORD ..................... 2159
    DWORD_TO_BIT .......................... 2159
    DWORD_TO_BOOL ........................ 2159
    DWORD_TO_BYTE ........................ 2159
    DWORD_TO_DATE ........................ 2159
    DWORD_TO_DINT ........................ 2159
    DWORD_TO_DT ........................... 2159
    DWORD_TO_INT .......................... 2159
    DWORD_TO_LDATE ....................... 2159
    DWORD_TO_LDT .......................... 2159
    DWORD_TO_LINT ........................ 2159
    DWORD_TO_LREAL ....................... 2159
    DWORD_TO_LTOD ........................ 2159
    DWORD_TO_LWORD ....................... 2159
  4732
DWORD_TO_REAL ................................ 2159
DWORD_TO_SINT ................................ 2159
DWORD_TO_STRING .............................. 2159
DWORD_TO_TIME ................................ 2159
DWORD_TO_TOD ................................ 2159
DWORD_TO_UDINT .............................. 2159
DWORD_TO_UINT ................................ 2159
DWORD_TO_ULINT .............................. 2159
DWORD_TO_USINT .............................. 2159
DWORD_TO_WORD ................................ 2159
DWORD_TO_WSTRING ......................... 2159
DX522 ......................................... 581
  Digital input/output module ............... 581
DX531 ......................................... 594
  Digital input/output module ............... 594
DX561 ......................................... 491
DX571 ......................................... 503
DX581-S ................................... 94, 174
dynamic memory allocation .................. 2201

E

earth concept ................................ 131
echo service .................................. 2427
Edge browser .................................. 53, 57, 2855
edit code
graphical editor .............................. 2048
editor
close all ..................................... 2669
close all (inactive applications) .......... 2670
close all other ................................ 2673
next .......................................... 2669
previous ..................................... 2669
visualization ............................... 3393
Electrical Connection
  AC522 ....................................... 674
element
  selection, tab order ...................... 3342
element list
  command, visualization .................. 3342
tab, visualization .......................... 3342
element properties .......................... 2584
  SFC ........................................... 2080
element property
  visualization ................................ 3396
elements for alarms acknowledgement ...... 3365
elimination of security risks ................ 1345
ellipse ........................................ 2988, 3413
  visualization element .................... 2988, 3413
ELSE .......................................... 2055
ELSIF .......................................... 2055
EMC-conforming mounting and construction ... 132
empty box
  insert ....................................... 2702
  empty box with eno ...................... 2702
EN/ENO
  add ........................................... 2686
  FBD/LD/IL .................................. 2092
enable
  breakpoint .................................. 2646
enable_dynamic_creation, pragma ........... 2281
encrypted communication
  data source OPC UA Client ............... 1960
  device editor ................................ 2427
encryption ..................................... 2039
  application ............................... 1915
booth application ........................... 4207
boot application, download, online change, certificate ........... 4202
  certificate ................................ 1820
  certificate, controller ................... 4201
communication with PLC ..................... 1967
dialog, security screen ..................... 2592
dongle ........................................ 1915
download code ................................ 1915
method ........................................ 2039
project ...................................... 1825
properties, application .................... 2754
Security Agent .............................. 4201
signature ..................................... 2039
  with certificate, instructions .......... 1830
wizard, boot application ................. 4207
  encryption wizard ......................... 4207
  boot application, download, online change . 4202
END_ACTION .................................. 2335
END_CASE .................................... 2057
END_FOR ..................................... 2056
Exception
  catch in IEC code .................................. 2206
  exception error, see exception .............. 2206
  exception handling ................................ 2206
display variant ..................................... 2974
exchange localization files
  project ............................................ 1833
  execute ........................................... 2094
  ST code in FBD/LD/IL .......................... 2094
  execute command .................................. 3373
  input action ...................................... 3373
  execution order .................................. 1867
    by data flow .................................... 1867
    CFC .............................................. 1867
  end with selected elements ................... 2689
  move down ........................................ 2690
  move up .......................................... 2689
  order by data flow ................................ 2691
  selected elements to front ................... 2688
  set number of element ........................... 2690
  set start of feedback in CFC POU ............ 2688
  show tags ........................................ 2688
  execution point .................................. 2751
EXIT .................................................. 2060
exit action ......................................... 2076
add, SFC ........................................... 2678
EXP .................................................. 2195
expand all .......................................... 2568
expandfully, pragma ................................ 2284
expert mode process data
  EtherCAT Slave ................................... 1617
export
  library ............................................ 2037
  library from Library Manager .................. 2716
  library from repository ........................ 2657
export server
  IEC 61850 ........................................ 1693, 1713
export/import
  I/O mapping ...................................... 2616
  PLCopen XML ...................................... 1815
  PLCopenXML ....................................... 2612
text list ........................................... 2729
XML .................................................. 1815
Exportieren ........................................ 2611
expression, ST ...................................... 2050
EXPT .................................................. 2195
  operator .......................................... 2195
ExST .................................................. 1879
  reset .............................................. 2053
  Set .................................................. 2052
EXT .................................................. 1885, 2755
  extend memory profile ........................... 2555
  extend profile .................................... 2555
  extended diagnosis ................................ 4606, 4607
  Extended Structured Text ........................ 1879
EXTENDS .............................................. 1930
  external file ...................................... 2464
    properties .................................... 2757
  external implementation ........................ 1885
    configuration ................................... 2755
  external variable ................................ 2120
  extract archive .................................. 2558
F
FALSE .................................................. 2220
FAQ .................................................... 1341
fast counters ...................................... 210, 539, 910, 1135, 4538
FB_Init .............................................. 2336
  method .......................................... 2336
FB_Reinit .......................................... 2336
  method .......................................... 2336
FBD .................................................... 1860
  option ............................................ 2787
  programming in .................................. 1862
FBD/LD/IL
  insert assignment, ............................... 2701
  insert box ........................................ 2701
  insert empty box with en/eno ................... 2702
  insert input ...................................... 2703
  insert jump ....................................... 2703
  insert jump label ................................. 2703
  insert network .................................... 2700
  insert network below .............................. 2701
  insert return ..................................... 2703
  online operation .................................. 2086
  view as function block diagram .................. 2711
  view as instruction list .......................... 2711
  view as ladder logic ................................ 2711
function as operand ................................ 2233
function block ................................ 2479, 3773
add input, CFC .......................... 2112
add output, CFC .......................... 2112
assignment, info .......................... 2293
call ................................ 2479
call with external implementation .......... 1885
call, ST ................................ 2060
extend ................................ 1930
I/O channel ................................ 1840
I/O channel, mapping ...................... 2449
I/O mapping ................................ 1840, 2293, 2444
implement interface ...................... 1932
initialization on call ...................... 2290
map I/O channel ................................ 2444
monitor ................................ 1998
monitor with properties ..................... 2000
property ................................ 2493
select for I/O mapping ..................... 2746
test, reflection ................................ 2313
function block diagram ..................... 1860
function extraction ......................... 4215
function module .......................... 907
function module terminal base
mounting and demounting .................. 107, 111
FUNCTION_BLOCK ...................... 2479
functionality
AC522 ................................ 673
G
gateway
add ................................ 2427
block driver ................................ 2721
configuration ................................ 2721
configuration file .......................... 2721
manage ................................ 2427
gateway.cfg ................................ 2721
GE ................................ 2149
general
EtherCAT Master .......................... 1610
EtherCAT Slave .......................... 1613
EtherNet/IP adapter ...................... 2825, 2831
EtherNet/IP Scanner ..................... 2824
EtherNet/IP scanner NetX ................ 2825
KNX ................................ 1730, 1731, 1732
generate code
IEC 61850 server .......................... 1712
gesture
for operating a visualization .............. 2887
get
access method, interface .................. 2490
Get
accessor method .......................... 2493
Get ...(method) .......................... 4621, 4631
GetClientInterface ......................... 3336
GetDialog ................................ 3336
getting started
display histogram .......................... 2862
trend visualization ........................ 2928
global namespace operator .................. 2216
global network variable list .............. 1946
global text list
add language and translate text ............ 1891
check ................................ 1894
compare and export differences ............. 1893
create ................................ 2728
create again with current IDs .............. 1895
text in visualization element .............. 1894
export ................................ 1891
for static application ...................... 1894
import file ................................ 1892
object ................................ 2465
remove text list entries .................... 1895
update ID ................................ 1895
update with replacement file .............. 1895
global variable .......................... 2118
declare ................................ 1854
global variable list ......................... 2465
declare task-local .......................... 1855	
task-local ................................ 2466
global variables list
namespace ................................ 2216
global_init_slot, pragma .................. 2285
GlobalImagePool ................................ 1899
go to
definition, how to .......................... 1908
definition, line .......................... 2567
matching bracket .......................... 2568
network ................................ 2712
### Index

| go to definition | command ........................................ 2576 |
| go to source position | ........................................ 2583 |
| GOOSE publisher | IEC 61850 server ................................ 1691 |
| GOOSE subscriber | IEC 61850 server ................................ 1694 |
| gradient editor | visualization ................................ 3369 |
| graphical editor toolbar | ........................................ 2048 |
| grid | visualization ................................ 3385 |
| grounding concept | block diagrams ................................ 131 |
| group ........................................ 2450 |
| CFC, create ................................ 2696 |
| CFC, remove ................................ 2697 |
| in the visualization editor ................................ 3347 |
| user management ................................ 1821 |
| user management, visualization ................................ 3403 |
| group box ................................ 3101, 3526 |
| visualization element ................................ 3101, 3526 |
| grouping | ungrouping, visualization editor ................................ 3348 |
| GSD file ........................................ 2663 |
| GT ........................................ 2148 |
| GVL ........................................ 2465 |
| declare task-local ................................ 1855 |
| namespace ................................ 2216 |
| property ................................ 2493 |
| task-local ................................ 2466 |
| H | HA-Modbus TCP ........................................ 4535 |
| System Technology ........................................ 3859 |
| hardware protection ........................................ 1345 |
| hasattribute, pragma ........................................ 2318 |
| hasconstantvalue, pragma ........................................ 2318 |
| hasdtype, pragma ........................................ 2318 |
| help | language ........................................ 2790 |
| offline help ........................................ 2789 |
| online help ........................................ 2789 |
| hexadecimal | display mode when monitoring ........................................ 2654 |
| number ........................................ 2220 |
| hexadecimal number | format definition \%x, \%llx ........................................ 3329 |
| hide windows ........................................ 1807 |
| hide_all_locals, pragma ........................................ 2289 |
| hide, pragma ........................................ 2286 |
| High Availability system ........................................ 3859 |
| High performance range ........................................ 1327 |
| histogram ........................................ 3216, 3641 |
| configure ........................................ 2862 |
| visualization element ........................................ 3216, 3641 |
| HMI ........................................ 95 |
| hot swap behaviour ........................................ 157 |
| HTTP library ........................................ 1757, 1798, 3833 |
| human machine interface ........................................ 95 |

#### I

| I | ........................................ 2231 |
| I/O bus | ........................................ 97 |
| I/O channel | function block ........................................ 1840 |
| IEC objects ........................................ 2449 |
| map to function block ........................................ 2444 |
| map to variable ........................................ 2444 |
| select function block ........................................ 2746 |
| I/O configuration | AC522 ........................................ 684 |
| i/o faq ........................................ 303 |
| I/O mapping ........................................ 1405, 1836, 2812 |
| all devices ........................................ 1843 |
| change address ........................................ 1841 |
| device editor ........................................ 2444 |
| edit ........................................ 2615 |
| EtherCAT ........................................ 1610 |
| export to CSV ........................................ 2616 |
| force ........................................ 1843 |
| function block ........................................ 1840 |
| import from CSV ........................................ 2615 |
| KNX ........................................ 1730 |
| monitoring ........................................ 1842 |
| procedure ........................................ 1837 |
| select function block ........................................ 2746 |
| task deployment ........................................ 1994 |
| update ........................................ 1842 |
Index

I/O module .................................. 387
analog .................................... 606
digital .................................. 390
digital/analog ............................ 840
function module .......................... 907
general .................................. 1644
mounting and demounting .............. 113, 123
I/O selection ............................. 97

Identifier
alias ..................................... 2245
identifiers
rules ...................................... 2327
search order ............................. 2333

IEC 61850
export server ........................... 1693, 1713
IEC 61850 server ....................... 1671
dataset .................................. 1688
generate code ........................... 1712
GOOSE publisher ........................ 1691
import server ........................... 1713
options ................................ 1713
properties ............................. 1679
report ................................. 1689
variable ................................ 1679

IEC action
SFC ..................................... 2075

IEC application
device diagnosis ....................... 4628
device state diagnosis ............... 4619, 4629

IEC objects
device editor ........................... 2449
EtherCAT ............................. 1610
KNX ................................... 1730

IEC task .................................. 4425

IF ........................................ 2055
statement .............................. 2055

if, pragma ................................ 2318
IL ........................................ 1861
online operation ....................... 2086
option .................................. 2787
image ................................... 3038, 3463
visualization element ............... 3038, 3463

image file
insert ................................... 2717
names and directories for visualization ... 3385

image pool ................................ 1899, 2468
create ................................... 1899
download ................................ 2764
global .................................... 1899
object ................................... 2468
properties ............................. 2764
image selection ....................... 2469
image switcher ......................... 3221, 3646
visualization element ............... 3221, 3646
implement interfaces ..................... 2744

IMPLEMENTS ............................ 1932
import
I/O mapping ............................ 2615
PLCopenXML ............................ 2612
project in SVN ........................... 4326
Import .................................. 2612
import assistant
configuration programming system ....... 2745
import server
IEC 61850 ............................... 1713
import users
device user management ............... 2450
index .................................. 2674
index access ............................ 2244
INDEXOF ................................. 2137
information ............................. 2675
device editor ......................... 2460
EtherCAT ............................... 1610
KNX ................................... 1730
information model object ............. 2473
information model OPC UA ............. 2473
INI ....................................... 2218
init step, SFC ............................ 2675
init_namespace, pragma attribute ..... 2291
init_on_onlchange, pragma .......... 2291
initialization ......................... 1851
array ................................... 2247
avoid, pragma ......................... 2299
FB on call .............................. 2290
input call, pragma .................... 2290
namespace, pragma .................... 2291
online change, download .............. 2291
order, pragma .......................... 2285
vector .................................. 2253
with FB_Init, FB_Reinit ................ 2336
integer
convert .................................. 2159
integer data type ........................ 2235

Intended purpose
AC522 ........................................ 673

interface .................................... 2484
call visualization with interface ........... 2952
command, visualization ........................ 3340
editor, visualization .......................... 3340
extend ......................................... 1933
implement ..................................... 1932
property ........................................ 2490
update data source programmatically ......... 1958
update, visualization ......................... 3367

INTERFACE ................................... 2484
interface method ............................... 2490

INTERNAL ..................................... 2485
method ......................................... 2485
property ........................................ 2493

Internal data exchange
AC522 ........................................ 684
interpretation of CM579-PNIO diagnosis ....... 4704
invisible input .................................. 3147, 3572
visualization element .......................... 3147, 3572
IO mapping .................................... 1405
io modules ...................................... 94
IO modules ...................................... 91
configure on visualization 2893
for default keyboard action, visualization 3338

keypad
visualization 3399

keyword 2335
uppercase 2796

KNX 1730
device editor 1730
ETS5 1732
general 1730, 1731, 1732
I/O mapping 1730
IEC objects 1730
information 1730
parameters 1730
status 1730

L
label 2111, 3068, 3493
CFC 2111
visualization element 3068, 3493

ladder diagram 1860

lamp 3226, 3651
visualization element 3226, 3651

language

current in the visualization 3399
help 2790
project localization 1833
switch input action 3372
user interface, command line 2028
user interface, options 2790
visualization 2906

language switching
configure, instructions 2906

latency 1915
task configuration 1915

LD 1860, 2087
closed branch 2096
keyword 2225
online operation 2086
option 2787
programming in 1864

LDATE 2238
convert 2187
data type 2238
keyword 2225

LDATE_AND_TIME 2238
data type 2238
keyword 2225

LDTO___UXINT 2187
LDTO___XINT 2187
LDTO___XWORD 2187
LDTO_BOOL 2187
LDTO_BYTE 2187
LDTO_DATE 2187
LDTO_DINT 2187
LDTO_DDATE 2187
LDTO_DWORD 2187
LDTO_LINT 2187
LDTO_LREAL 2187
LDTO_LSTRING 2187
LDTO_STRING 2187
LDTO_TIME 2187
LDTO_TOD 2187
LDTO_UDINT 2187
LDTO_UINT 2187
LDTO_ULINT 2187
LDTO_USINT 2187
LDTO_WORD 2187
LDTO_WSTRING 2187

LDN 2087

LDT 2187
convert 2187
keyword 2225

LDT___XWORD 2187
LDT___UXINT 2187
LDT___XINT 2187
LDT_BOOL 2187
LDT_BYTE 2187
LDT_DATE 2187
LDT_DINT 2187
LDT_DDT 2187
LDT_DWORD 2187
LDT_INT 2187
LDT_LINT 2187
Index

start point .................................. 2709
start/end .................................. 2095
linkalways .................................. 2294
pragma ..................................... 2294
Lint ....................................... 1904
programming tool for code analysis .... 1904
LINT ...................................... 2235
convert ................................... 2159
data type .................................. 2235
LINT_tO___UXINT ......................... 2159
LINT_tO___XINT ......................... 2159
LINT_tO___XWORD ......................... 2159
LINT_tO_BIT .............................. 2159
LINT_tO_BOOL ............................ 2159
LINT_tO_BYTE ............................ 2159
LINT_TO_DATE ............................ 2159
LINT_TO_DINT ............................ 2159
LINT_TO_DT .............................. 2159
LINT_TO_DWORD ........................... 2159
LINT_TO_INT ............................. 2159
LINT_TO_LDATE ........................... 2159
LINT_TO_LDT ............................. 2159
LINT_TO_LREAL ......................... 2159
LINT_TO_LTIME .......................... 2159
LINT_TO_LTOD ........................... 2159
LINT_TO_LWORD ......................... 2159
LINT_TO_REAL ........................... 2159
LINT_TO_SINT ........................... 2159
LINT_TO_STRING ......................... 2159
LINT_TO_TIME ........................... 2159
LINT_TO_TOD ............................ 2159
LINT_TO_UDINT ......................... 2159
LINT_TO_UINT ........................... 2159
LINT_TO_ULINT ......................... 2159
LINT_TO_USINT ......................... 2159
LINT_TO_WORD ........................... 2159
LINT_TO_WSTRING ....................... 2159
List components .......................... 1886
literal .................................... 2219
character .................................. 2221
date ....................................... 2225
time of day ................................ 2225
typed ....................................... 2228
LN .......................................... 2194
load
  project, option ........................ 2791
loading to the controller .............. 2026
local variable ........................... 2113
localization
  project ................................ 1833
localization template
  project localization ................. 1833
lock
  get, SVN ................................ 4336
  steal, SVN ............................ 4337
locked, operating mode ............... 2642
log
  device .................................. 2654
  open ..................................... 2437
  PLC ..................................... 2021
  SVN ..................................... 4337
  VendorException ...................... 2437
Log ....................................... 4647
LOG ...................................... 2195
log of the PLC
  device editor .......................... 2437
log-in to a CPU ........................... 50
login ...................................... 2624
  as user ................................ 1828
  via user account ..................... 1827
  with certificate only ............... 1820
  wrong password ........................ 2045
logout .................................... 2627, 2637
LOWER_BOUND ............................ 2252
  array ................................... 2252
  lowercase .............................. 2567
LREAL .................................... 2236
  constant .............................. 2221
  convert ................................ 2171
  literal ................................ 2221
LREAL_TO___XWORD ...................... 2171
LREAL_TO__UXINT ....................... 2171
LREAL_TO__XINT ......................... 2171
LREAL_TO_BIT ........................... 2171
LREAL_TO_BOOL .......................... 2171
LREAL_TO_BYTE ......................... 2171
LREAL_TO_DATE .......................... 2171
LREAL_TO_DINT .......................... 2171
LREAL_TO_DT ............................. 2171
LREAL_TO_LDATE ......................... 2171
LREAL_TO_LDT ........................... 2171
LREAL_TO_LREAL ......................... 2171
LREAL_TO_LTIME ......................... 2171
LREAL_TO_LTOD ........................... 2171
LREAL_TO_LWORD ......................... 2171
LREAL_TO_REAL ........................... 2171
LREAL_TO_SINT ........................... 2171
LREAL_TO_STRING ....................... 2171
LREAL_TO_TIME ........................... 2171
LREAL_TO_TOD ............................ 2171
LREAL_TO_UDINT ......................... 2171
LREAL_TO_UINT ........................... 2171
LREAL_TO_ULINT ......................... 2171
LREAL_TO_USINT ......................... 2171
LREAL_TO_WORD ........................... 2171
LREAL_TO_WSTRING ...................... 2171
index
3ADR010583, 1, en_US 2024/01/05
<table>
<thead>
<tr>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>LWORD_TO_LDT</td>
<td>2159</td>
</tr>
<tr>
<td>LWORD_TO_LINT</td>
<td>2159</td>
</tr>
<tr>
<td>LWORD_TO_LREAL</td>
<td>2159</td>
</tr>
<tr>
<td>LWORD_TO_LTIME</td>
<td>2159</td>
</tr>
<tr>
<td>LWORD_TO_LTOD</td>
<td>2159</td>
</tr>
<tr>
<td>LWORD_TO_REAL</td>
<td>2159</td>
</tr>
<tr>
<td>LWORD_TO_SINT</td>
<td>2159</td>
</tr>
<tr>
<td>LWORD_TO_STRING</td>
<td>2159</td>
</tr>
<tr>
<td>LWORD_TO_TIME</td>
<td>2159</td>
</tr>
<tr>
<td>LWORD_TO_TOD</td>
<td>2159</td>
</tr>
<tr>
<td>LWORD_TO_UDINT</td>
<td>2159</td>
</tr>
<tr>
<td>LWORD_TO_UINT</td>
<td>2159</td>
</tr>
<tr>
<td>LWORD_TO_ULINT</td>
<td>2159</td>
</tr>
<tr>
<td>LWORD_TO_USINT</td>
<td>2159</td>
</tr>
<tr>
<td>LWORD_TO_WORD</td>
<td>2159</td>
</tr>
<tr>
<td>LWORD_TO_WSTRING</td>
<td>2159</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>mechanical planning and installation</td>
<td>104</td>
</tr>
<tr>
<td>memory</td>
<td></td>
</tr>
<tr>
<td>display memory snapshot</td>
<td>2592</td>
</tr>
<tr>
<td>dynamic allocation</td>
<td>2201</td>
</tr>
<tr>
<td>memory card</td>
<td>126, 129, 1426</td>
</tr>
<tr>
<td>MC5102 (micro)</td>
<td>1286, 1309</td>
</tr>
<tr>
<td>MC5141</td>
<td>1315</td>
</tr>
<tr>
<td>memory range</td>
<td>2231</td>
</tr>
<tr>
<td>memory reserve</td>
<td></td>
</tr>
<tr>
<td>function block</td>
<td>2595</td>
</tr>
<tr>
<td>online change</td>
<td>2595</td>
</tr>
<tr>
<td>memory view</td>
<td>2592</td>
</tr>
<tr>
<td>menu</td>
<td>2801</td>
</tr>
<tr>
<td>customize</td>
<td>1802</td>
</tr>
<tr>
<td>merge changes</td>
<td>4344</td>
</tr>
<tr>
<td>message</td>
<td></td>
</tr>
<tr>
<td>go to source position</td>
<td>2575</td>
</tr>
<tr>
<td>next</td>
<td>2576</td>
</tr>
<tr>
<td>previous</td>
<td>2576</td>
</tr>
<tr>
<td>message pragma</td>
<td>2269</td>
</tr>
<tr>
<td>message view</td>
<td>2583</td>
</tr>
<tr>
<td>meta-information</td>
<td>1813</td>
</tr>
<tr>
<td>add to project</td>
<td>1813</td>
</tr>
<tr>
<td>meter</td>
<td>3201, 3626</td>
</tr>
<tr>
<td>90°, visualization element</td>
<td>3187, 3612</td>
</tr>
<tr>
<td>180°, visualization element</td>
<td>3194, 3619</td>
</tr>
<tr>
<td>visualization element</td>
<td>3201, 3626</td>
</tr>
<tr>
<td>method</td>
<td>2485</td>
</tr>
<tr>
<td>call</td>
<td>1933, 2486</td>
</tr>
<tr>
<td>call recursively</td>
<td>1935</td>
</tr>
<tr>
<td>call with external implementation</td>
<td>1885</td>
</tr>
<tr>
<td>example of recursive call</td>
<td>2282</td>
</tr>
<tr>
<td>factorial calculation</td>
<td>2282</td>
</tr>
<tr>
<td>FB_Init, FB_Reinit, FB_Exit</td>
<td>2336</td>
</tr>
<tr>
<td>interface</td>
<td>2490</td>
</tr>
<tr>
<td>monitor</td>
<td>2000</td>
</tr>
<tr>
<td>object-oriented programming</td>
<td>2485</td>
</tr>
<tr>
<td>reaction to type change</td>
<td>2275</td>
</tr>
<tr>
<td>recursive call</td>
<td>2487</td>
</tr>
<tr>
<td>virtual call</td>
<td>1933</td>
</tr>
<tr>
<td>METHOD</td>
<td>2485</td>
</tr>
<tr>
<td>Methode</td>
<td>2120</td>
</tr>
<tr>
<td>metrics</td>
<td></td>
</tr>
<tr>
<td>code analysis</td>
<td>4226</td>
</tr>
<tr>
<td>static analysis</td>
<td>4213, 4226</td>
</tr>
</tbody>
</table>
micro browser ........................................ 4397
micro memory card
  MC5102 ........................................ 1286, 1309
micro memory card adapter
  TA5350-AD ...................................... 1286, 1309
migrate third party device
  command ....................................... 2655
migration ....................................... 1394, 1799
MIN .............................................. 2146
MOD ............................................. 2137
Modbus ........................................... 1070
  parameters ................................... 2433
  RTU protocol .................................. 1716
  TCP/IP protocol ................................ 1714, 4523
Modbus configurator .............................. 1565
Modbus sockets .................................. 4568
Modbus TCP ...................................... 3780
modifier. IL .................................... 2087
ModRtuMast ..................................... 4506
ModRtuToken .................................... 4506
ModTcpMast2 .................................... 4568
module
  call tree .................................... 2572
monitoring ...................................... 1996
  area for arrays ................................ 2048, 2752
  CFC editor .................................... 2103
  display mode .................................. 2654
  enable inline monitoring ..................... 2569
  encoding ..................................... 2297
  function call .................................. 2295
  inline ........................................ 1996
  interval ...................................... 2765
  options ....................................... 2792
  pragma ........................................ 2295, 2297
  properties .................................... 2766
  property ...................................... 2295, 2297
SFC .............................................. 2063
  using pous for implicit checks .............. 1928
monitoring area .................................. 2048
  dialog ........................................ 2048
monitoring function
  implicit ....................................... 2500
monitoring variable
IEC 61850 server ................................ 1679
Motion control library ......................... 3958
mounting ......................................... 106
CM ............................................... 109
communication module .......................... 109
FM ............................................. 107
function module terminal base .................. 107
I/O modules ..................................... 113, 123
option boards (AC500-eCo) ....................... 114, 127
processor module ................................ 109, 114
TA5301-CFA ..................................... 123
TB ............................................... 107
terminal base .................................... 107
terminal block for onboard I/O (AC500-eCo) ....... 116
terminal unit ..................................... 111
TU ............................................... 111
mounting a processor module
  on DIN rail .................................... 119
  on metal plate ................................ 121
MOVE ............................................. 2137
move down ....................................... 2718
move up ......................................... 2718
MQTT ............................................. 1722
MQTT client library ............................. 4048
MQTT_CONNECTION ............................... 4050
MQTT_ERROR_ID .................................. 4048
MQTT_MESSAGE ................................... 4050
MQTT_QOS ....................................... 4050
MSSQL .......................................... 1757, 3833
MUL ............................................. 2134
multi online change
  command ....................................... 2665
multicore ....................................... 2537
  show CPU load ................................ 2015
  trace .......................................... 2014
  use task-local global variable list .......... 1855
multicore operator
  __COMPARE_AND_SWAP .......................... 2212
  __XADD ....................................... 2213
  TEST_AND_SET .................................. 2215
multitouch
  for operating a visualization ................. 2887
  implement event handling ..................... 2888
  visualization .................................. 3401
MUX ............................................. 2147
MySQL .......................................... 1757, 3833
Object
  add, command .................................. 2598
  Properties ................................... 2753
Object-oriented programming ......................... 1929
obsolete, pragma ................................ 2304
occurrence location
  variable .................................... 1906
octal
  number ..................................... 2220
octal number
  format definition %o ........................ 3329
OF ....................................... 2247
  array .................................. 2247
offline help
  option .................................... 2789
older versions of this document .................... 10
onboard .................................... 4436
Onboard I/Os
  PM50x2 .................................. 196
Onboard I/Os in processor module PM50x2 .......... 196
online
  log in to application ....................... 2624
  logout from application ................... 2627
  multiple download .......................... 2631
  pointer reference .......................... 2576
online change .................................. 2629
  active application ........................ 2629
  attribute ................................ 2291
  compiler definition ....................... 2291
  encrypt .................................. 4202
  selected application ...................... 2629
online config mode ................................ 2616
online help
  option .................................... 2789
online mode
  task monitoring ............................ 2536
OOP ....................................... 1929
OPC DA
  Communication and protocols ................. 307, 308, 310, 312, 4481, 4483, 4484
OPC DA server ................................ 1750, 1787, 2834
OPC UA
  information model .......................... 2473
  information model repository ............... 2665
OPC UA Client
  data source ............................... 2424
OPC UA companion information model ............... 2846
OPC UA information model
  use ....................................... 2846
OPC UA server .................................. 1787, 2834
OPC UA types
  IEC types ................................ 2848
  map to IEC ................................ 2848
open ........................................ 1808
  library projects .......................... 1808
  project .................................. 1808
  project archives .......................... 1808
  write-protected project .................... 1808
open ports .................................. 1349
open ports and service ........................ 1349
OpenDialog .................................. 3336
operand ..................................... 2235
operating mode
  debug ..................................... 2642
  locked ................................... 2642
  operational ............................... 2642
operation
  description of LEDs ....................... 1431, 4456
operational, operating mode ....................... 2642
operator ..................................... 2129
  binding strength .......................... 2050
  IL ...................................... 2087
  precedence ............................... 2050
option board .................................. 218
  analog input, TA5120-2AI-UI .............. 240
  analog input, TA5120-2AI-UW ............. 240
  analog input, TA5123-2AI-RTD ............ 255
  analog input, TA5123-2AI-RTW ............ 255
  analog output, TA5126-2AO-UI ............ 269
  analog output, TA5126-2AO-UW .......... 269
  COMx serial communication, TA5141-RS232I 285
  COMx serial communication, TA5141-RS232W .... 285
  COMx serial communication, TA5142-RS485 285
  COMx serial communication, TA5142-RS485I .... 285
  COMx serial communication, TA5142-RS485W ... 289
digital I/O, TA5110-2DI2DOT ............... 231
Index

digital I/O, TA5110-2DI2DOW ............. 231
digital input, TA5101-4DI .................. 218
digital input, TA5101-4DIW ............... 218
digital output, TA5105-4DOT .............. 224
digital output, TA5105-4DOTW .......... 224
KNX address push button, TA5130-KNXPB . 280
KNX adress push button, TA5130-KNXPBW .. 280
real-time clock, TA5131-RTC ............. 283

option board for processor modules PM50xx ... 1504
options .................................. 2667, 2668
development status ..................... 1802
device editor ............................ 2786
IEC 61850 server ....................... 1713
import assistant ........................ 2745
monitoring ................................ 2792
SVN ....................................... 4349, 4350
visualization ............................ 3384
OR ......................................... 2139
OR_ELSE .................................. 2140
OR, pragma ................................ 2326
order
  command, visualization editor .......... 3344
  pin ..................................... 2303
Ordering data
  AC522 .................................. 698
ORN ......................................... 2087
output
  assign ST ................................ 2052
  CFC ..................................... 2109
device ................................... 1837
reset .................................... 2687
output memory ............................ 2231
output pin order ......................... 2303
output text
  with placeholder and format definition ... 3330
output variable .......................... 2114
output/input module
  mounting and demounting .............. 113, 123
overflow data type ....................... 2129
overlay icon ................................ 4319
SVN ......................................... 4319
overloading ................................ 2153
overview of product family .............. 85

P
pack_mode, pragma ....................... 2305
package
  manage .................................. 2655
  uninstall ................................ 2655
Package Manager ....................... 2655
packages
  import assistant ....................... 2745
page
  CFC ..................................... 2109
page oriented
  CFC object ................................ 2101
page size
  edit .................................... 2686
page-oriented ............................ 2101
pane
  next .................................... 2671
  previous ................................ 2671
Panel Builder ............................ 4397, 4398
Panel Builder 600 ....................... 148
panning tool ............................. 2048
parallel .................................. 2678
parameter
  update, fbd/ld/il cfc .................. 2710
parameter mode .......................... 2616
Parameterization
  AC522 .................................. 685
  I/O bus ................................ 1569
  IO bus .................................. 1569
parameters
  CANbus .................................. 2433
device editor ............................. 2433
edit ..................................... 2692
EtherCAT ................................ 1610
EtherCAT Master ......................... 1613
EtherCAT Slave .......................... 1623
Modbus ................................... 2433
PROFIBUS DP ............................ 2433
PROFINET IO ............................. 2433
parameterstringof
  pragma, visualization ................. 3338
parametrization .......................... 3384
IEC 61850 server ....................... 1679
Parametrization

I/O bus ............................. 1569
PARAMS .............................. 2335
pass parameters
  pass pointer, visualization ............... 2970
  pass-by-reference parameter ............... 2114
password
  indicate at login .............................. 1827
  project ..................................... 1824
  project settings ................................... 2772
  wrong ......................................... 2045
password manager ........................... 1821
paste after ............................. 2683
path3d
  camera control ................................. 3281, 3706
Path3D ...................................... 3279, 3704
PB610 ........................................ 148
PB610 Panel Builder 600 .......................... 4397
PDOs ........................................ 1599
persistence ...................................... 1920
  clean gaps ...................................... 2719
  rearrange list ................................... 2719
  save values ..................................... 2719
persistence editor ........................... 2476
Persistence Manager
  remanent variable .................................. 1926
PERSISTENT ............................... 2122
  variable ....................................... 1923, 2122
persistent variable ........................... 1920
debute ......................................... 1927
  saving in a recipe .................................... 1928
persistent variable list ........................... 2476
PID controller .................................... 4424
PID function blocks ............................. 4424
pie ........................................... 3025, 3450
  visualization element .......................... 3025, 3450
pin
  reset ........................................... 2694
  select ......................................... 2694
pin_presentation_order_inputs, pragma attribute ............................ 2303
pin_presentation_order_outputs, pragma attribute .............................. 2303
pingroup, pragma ........................... 2302
pins
  remove ........................................... 2694
password manager ........................... 1821
passwords
  indicate at login .............................. 1827
  project ..................................... 1824
  project settings ................................... 2772
  wrong ......................................... 2045
PlcOperationControl .............................. 2023
PlcLoad
  DeviceTrace ...................................... 2015
PLC
  behavior after voltage dip ..................... 1480
  behaviour after voltage dip ....................... 1480
  firmware ...................................... 1446
  load .......................................... 2014
  log ........................................... 2021, 4647
  runtime licensing ................................ 1446
  settings
    device editor .................................. 2439
    shell ......................................... 2022
    device editor .................................. 2441
  plcload
    trace ........................................... 2008, 2740
PlcLoad
  DeviceTrace ...................................... 2015
PLCopenXML
  export/import ..................................... 2612
  import ........................................... 2612
  option .......................................... 2793
PlcOperationControl .............................. 2023
PLCs ........................................ 85
  pluggable label mounting .......................... 1328
  pluggable marker holder ............................ 1328
PM .......................................... 89, 93, 175
PM50xx ........................................ 175
  PM5012-R-ETH ..................................... 175
  PM5012-T-ETH ..................................... 175
  PM5032-R-ETH ..................................... 175
  PM5032-T-ETH ..................................... 175
  PM5052-R-ETH ..................................... 175
  PM5052-T-ETH ..................................... 175
  PM5072-T-2ETH ................................... 175, 4447
  PM5072-T-2ETHW ................................... 175
Index

VisuSymbolLibrary key .................................. 2516
write protection ........................................ 1819, 1823

Project
close ....................................................... 2554
project archive .......................................... 1832
extract by command line ................................ 2029
project compare
configuration ............................................. 2607
detail ..................................................... 2609
differences ............................................... 2607
project compression .................................... 2791
project documentation print ............................ 2606
project environment
symbol library in visualization ....................... 2780, 3386
visualization profile .................................... 2779, 3385
visualization style ...................................... 2780, 3386
project localization .................................... 1833
create template ......................................... 2605
localization template ................................... 1833
manage ..................................................... 2605
toggle ..................................................... 2606
project restore information ............................ 2791
project setting
command .................................................. 2603
project settings ........................................... 2514
command .................................................. 2604
make ....................................................... 1814
object ...................................................... 2514
rules, Static Analysis ................................ 4218
SFC ....................................................... 2767
SVN ....................................................... 4350
user management ....................................... 1825
users and groups ........................................ 2768
visualization ............................................. 2776, 3387

Properties
access control ........................................... 2757
bitmap ..................................................... 2758
boot application ........................................ 2754
build ....................................................... 2755
build, C-integration .................................... 2756
cam ........................................................ 2763
common ................................................... 2753
device ....................................................... 2765
external file .............................................. 2757
IEC 61850 server ........................................ 1679
image pool ............................................... 2764
link to file ............................................... 2763
monitoring ............................................... 2765, 2766
network settings ....................................... 2761
network variables ...................................... 2760
security .................................................... 2754
SFC ....................................................... 2762
task configuration ...................................... 2533
text list .................................................... 2765

Properties
of an object .............................................. 2753

property
CFC execution order .................................... 2761
monitor ...................................................... 1998
object ....................................................... 2493
object-oriented programming ................................ 2493
SFC, do not display embedded objects .................. 2684

PROPERTY ............................................... 2493

object ....................................................... 2493

PROTECTED .............................................. 2485

method ..................................................... 2485

property .................................................... 2493

protected environment ................................ 1342

property
data security ............................................. 1971
project .................................................... 1819

protocols
IEC 60870-5-104 (Telecontrol) ....................... 1647

Protocols
BACnet .................................................... 1733, 3833
Modbus RTU ............................................. 1716
Modbus TCP/IP .......................................... 1714, 4523
MQTT ..................................................... 1722
NTP ......................................................... 1716
OPC UA .................................................... 1787, 2834
Secure ..................................................... 1724
SNTP ....................................................... 1716
UDP ......................................................... 1750

proxy
access data .............................................. 2793
server option ........................................... 2793
server, setting .......................................... 2793

PUBLIC .................................................... 2485

method ..................................................... 2485

property .................................................... 2493

properties
Index

public key ........................................... 2040
push switch ........................................... 3231, 3656
visualization element ....................... 3231, 3656
push switch LED .................................. 3231, 3656
visualization element ....................... 3231, 3656
Python ................................................. 4362

Q
Q .......................................................... 2231
memory range prefix ............................. 2231
qualified_only, pragma ...................... 2312
qualifiers for SFC actions .................. 2065
QUERYINTERFACE ................................... 2204
QUERYPOINTER ....................................... 2205

R
R= .......................................................... 2053
reset assignment .................................. 2053
radio buttons ......................................... 3161, 3586
visualization element ....................... 3161, 3586
READ_ONLY ............................................ 2335
READ_WRITE .......................................... 2335
REAL ..................................................... 2236
constant ............................................. 2221
convert .............................................. 2171
literal .................................................. 2221
REAL_TO___UXINT .................................... 2171
REAL_TO___XINT ...................................... 2171
REAL_TO___XWORD .................................... 2171
REAL_TO_BIT .......................................... 2171
REAL_TO_BOOL ........................................ 2171
REAL_TO_BYTE ....................................... 2171
REAL_TO_DATE ........................................ 2171
REAL_TO_DINT ........................................ 2171
REAL_TO_DT .......................................... 2171
REAL_TO_DWORD ..................................... 2171
REAL_TO_INT .......................................... 2171
REAL_TO_LINT ........................................ 2171
REAL_TO_LREAL ...................................... 2171
REAL_TO_LWORD ..................................... 2171
REAL_TO_SINT ........................................ 2171
REAL_TO_STRING ................................... 2171
REAL_TO_UDINT ...................................... 2171
REAL_TO_UINT ....................................... 2171
REAL_TO_ULINT ..................................... 2171

REAL_TO_WORD ....................................... 2171
REAL_TO_WSTRING ................................... 2171
real-time clock .................................... 4444
Realization with centralized PLC based motion control .................. 3982
realtime clock ....................................... 4444
rearrange list ...................................... 2719
recent projects ..................................... 2561
recipe .................................................. 2003, 2522
add ..................................................... 2723
create, input action .............................. 3373
delete, input action ............................... 3373
insert variable ...................................... 2723
load .................................................... 2724
load and write ...................................... 2725
load from controller ............................ 2006
load from device .................................... 2727
load from file ........................................ 2005
load, input action ................................... 3373
read ..................................................... 2726
read and save ....................................... 2726
read, input action ................................... 3373
remanent variable ................................. 1926
remove ............................................... 2724
remove variables .................................... 2726
save .................................................... 2724
save, input action ................................... 3373
visualization ......................................... 2939
write .................................................... 2725
write, input action ................................... 3373
recipe definition .................................... 2522
recipe file
load .................................................... 2005
recipe management .................................. 2003
controller .............................................. 2006
memory usage ........................................ 2006
Recipe Manager ...................................... 2519
recording, see data recording .................. 2805
rectangle .............................................. 2988, 3413
visualization element ....................... 2988, 3413
Recycling .............................................. 158
redundancy ............................................ 4535
REF= ..................................................... 2054, 2245
refactoring .......................................... 1910
add variable ......................................... 2578

add/remove variable .................................. 1911
code clone ........................................ 4216
declaration order of variables .................... 1912
duplicated code .................................. 4216
function extraction ................................ 4215
option ............................................. 2794
remove variable ................................... 2580
rename ............................................ 2577
rename variable ................................... 1910
reorder variables ................................ 2581
update referenced pins ............................ 2578
reference ......................................... 2245
_ISVALIDREF ..................................... 2246
data type .......................................... 2245
test operator ...................................... 2246
valid ................................................ 2246
REFERENCE TO .................................. 2245
reflection ......................................... 2293, 2313
pragma attribute .................................. 2313
refresh
structured variables ............................... 2727
released ........................................... 1823
remanent ........................................... 2122
recipe ............................................. 1926
remanent variable of the Persistence Manager 1926
variable ............................................ 2122
remanent variables
AC500 V3 products ................................ 4412
Remote Alarms
Object ............................................. 2412
remote data
visualize .......................................... 1959
remove
IL line ............................................ 2707
Reset ............................................. 2687
Set ................................................ 2687
unused parameters, FBD/LD ....................... 2710
remove force list ................................ 2650
remove unused FB call parameters .............. 2710
rename
refactoring ........................................ 2577
repair
box ................................................ 2710
REPEAT ............................................ 2058
replace ............................................ 1910
command .......................................... 2564
replace a module .................................. 152
replacement of a module ........................... 152
replacement of an I/O module with hot swap ... 153
report
IEC 61850 server .................................. 1689
repository .......................................... 2657, 4316
browse SVN repository ............................ 4322
information model OPC UA ......................... 2665
library ............................................. 2657
OPC UA information model ......................... 2665
SVN ............................................... 4316
visualization element ............................. 3361
reserve memory
online change ...................................... 2595
reset
application ......................................... 1990
application (reset cold) .......................... 2633
application (reset origin) ........................ 2635
application (reset warm) .......................... 2634
assignment ST ..................................... 2053
cold ................................................. 2633
device to origin .................................... 2636
origin .............................................. 2635
origin device ...................................... 2636
SVN ................................................. 4339
warm ............................................... 2634
Reset
output .............................................. 2687
remove ............................................. 2687
reset coil .......................................... 2095
insert .............................................. 2704
reset origin ........................................ 2635
application ........................................ 2635
reset warm .......................................... 149
restore ............................................. 2024
restore values from recipe ......................... 2719
RET .................................................. 2087
RETAINT .......................................... 2124
remanent variable ................................ 1925
variable ............................................ 2124
RETC ................................................ 2087
RETCN ............................................. 2087
<table>
<thead>
<tr>
<th>Page Numbers</th>
<th>Entries</th>
</tr>
</thead>
<tbody>
<tr>
<td>4297</td>
<td>SA0046</td>
</tr>
<tr>
<td>4264</td>
<td>SA0047</td>
</tr>
<tr>
<td>4264</td>
<td>SA0048</td>
</tr>
<tr>
<td>4265</td>
<td>SA0051</td>
</tr>
<tr>
<td>4266</td>
<td>SA0052</td>
</tr>
<tr>
<td>4266</td>
<td>SA0053</td>
</tr>
<tr>
<td>4267</td>
<td>SA0054</td>
</tr>
<tr>
<td>4268</td>
<td>SA0055</td>
</tr>
<tr>
<td>4268</td>
<td>SA0056</td>
</tr>
<tr>
<td>4269</td>
<td>SA0057</td>
</tr>
<tr>
<td>4269</td>
<td>SA0058</td>
</tr>
<tr>
<td>4271</td>
<td>SA0059</td>
</tr>
<tr>
<td>4271</td>
<td>SA0060</td>
</tr>
<tr>
<td>4271</td>
<td>SA0061</td>
</tr>
<tr>
<td>4272</td>
<td>SA0062</td>
</tr>
<tr>
<td>4272</td>
<td>SA0063</td>
</tr>
<tr>
<td>4273</td>
<td>SA0064</td>
</tr>
<tr>
<td>4273</td>
<td>SA0065</td>
</tr>
<tr>
<td>4274</td>
<td>SA0066</td>
</tr>
<tr>
<td>4276</td>
<td>SA0072</td>
</tr>
<tr>
<td>4276</td>
<td>SA0073</td>
</tr>
<tr>
<td>4278</td>
<td>SA0075</td>
</tr>
<tr>
<td>4279</td>
<td>SA0076</td>
</tr>
<tr>
<td>4280</td>
<td>SA0077</td>
</tr>
<tr>
<td>4280</td>
<td>SA0078</td>
</tr>
<tr>
<td>4276</td>
<td>SA0080</td>
</tr>
<tr>
<td>4277</td>
<td>SA0081</td>
</tr>
<tr>
<td>4281</td>
<td>SA0090</td>
</tr>
<tr>
<td>4281</td>
<td>SA0095</td>
</tr>
<tr>
<td>4282</td>
<td>SA0100</td>
</tr>
<tr>
<td>4283</td>
<td>SA0101</td>
</tr>
<tr>
<td>4283</td>
<td>SA0102</td>
</tr>
<tr>
<td>4284</td>
<td>SA0103</td>
</tr>
<tr>
<td>4285</td>
<td>SA0105</td>
</tr>
<tr>
<td>4286</td>
<td>SA0106</td>
</tr>
<tr>
<td>4287</td>
<td>SA0107</td>
</tr>
<tr>
<td>4289</td>
<td>SA0111</td>
</tr>
<tr>
<td>4289</td>
<td>SA0112</td>
</tr>
<tr>
<td>4289</td>
<td>SA0113</td>
</tr>
<tr>
<td>4290</td>
<td>SA0114</td>
</tr>
<tr>
<td>4290</td>
<td>SA0115</td>
</tr>
<tr>
<td>4290</td>
<td>SA0117</td>
</tr>
<tr>
<td>4291</td>
<td>SA0118</td>
</tr>
<tr>
<td>4291</td>
<td>SA0119</td>
</tr>
<tr>
<td>4291</td>
<td>SA0120</td>
</tr>
<tr>
<td>4292</td>
<td>SA0121</td>
</tr>
<tr>
<td>4293</td>
<td>SA0122</td>
</tr>
<tr>
<td>4293</td>
<td>SA0123</td>
</tr>
<tr>
<td>4295</td>
<td>SA0124</td>
</tr>
<tr>
<td>4295</td>
<td>SA0125</td>
</tr>
<tr>
<td>4259</td>
<td>SA0130</td>
</tr>
<tr>
<td>4260</td>
<td>SA0131</td>
</tr>
<tr>
<td>4261</td>
<td>SA0132</td>
</tr>
<tr>
<td>4261</td>
<td>SA0133</td>
</tr>
<tr>
<td>4262</td>
<td>SA0134</td>
</tr>
<tr>
<td>4296</td>
<td>SA0140</td>
</tr>
<tr>
<td>4298</td>
<td>SA0145</td>
</tr>
<tr>
<td>4293</td>
<td>SA0147</td>
</tr>
<tr>
<td>4294</td>
<td>SA0148</td>
</tr>
<tr>
<td>4299</td>
<td>SA0150</td>
</tr>
<tr>
<td>4299</td>
<td>SA0160</td>
</tr>
<tr>
<td>4300</td>
<td>SA0161</td>
</tr>
<tr>
<td>4301</td>
<td>SA0162</td>
</tr>
<tr>
<td>4302</td>
<td>SA0163</td>
</tr>
<tr>
<td>4303</td>
<td>SA0164</td>
</tr>
<tr>
<td>4303</td>
<td>SA0165</td>
</tr>
<tr>
<td>4304</td>
<td>SA0166</td>
</tr>
<tr>
<td>4304</td>
<td>SA0167</td>
</tr>
<tr>
<td>4305</td>
<td>sa0168</td>
</tr>
<tr>
<td>4306</td>
<td>sa0169</td>
</tr>
<tr>
<td>1522</td>
<td>SAE J1939</td>
</tr>
<tr>
<td>94, 174</td>
<td>Safety devices</td>
</tr>
<tr>
<td></td>
<td>Safety instructions</td>
</tr>
<tr>
<td></td>
<td>drives library .</td>
</tr>
<tr>
<td></td>
<td>safety notice .</td>
</tr>
<tr>
<td></td>
<td>sample</td>
</tr>
<tr>
<td></td>
<td>show in the trace editor .</td>
</tr>
<tr>
<td></td>
<td>samples</td>
</tr>
<tr>
<td></td>
<td>save in trace file .</td>
</tr>
<tr>
<td></td>
<td>save</td>
</tr>
<tr>
<td></td>
<td>project archive .</td>
</tr>
<tr>
<td></td>
<td>project, option .</td>
</tr>
<tr>
<td></td>
<td>Save</td>
</tr>
<tr>
<td></td>
<td>project .</td>
</tr>
<tr>
<td></td>
<td>save current values to recipe .</td>
</tr>
<tr>
<td></td>
<td>save the project .</td>
</tr>
<tr>
<td></td>
<td>save values to recipe .</td>
</tr>
<tr>
<td></td>
<td>saving</td>
</tr>
<tr>
<td></td>
<td>project .</td>
</tr>
<tr>
<td></td>
<td>scalar product .</td>
</tr>
</tbody>
</table>

Index
4758  
3ADR010583, 1, en_US  
2024/01/05
scan devices .................................. 1607, 1628, 2600, 2832
SCE in LD .................................. 2096
scope ........................................ 2113
script
  execute .................................... 2667
Script
  enable tracing ............................ 2667
script file
  run by command line ....................... 2030
scripting
  execute .................................... 2666
  execute script file ....................... 2666
Scripting
  enable script tracing ..................... 2667
Scripts
  Python ..................................... 4362
scroll bar .................................. 3125, 3550
  visualization element .................. 3125, 3550
SD card ..................................... 126, 129
SD memory card ............................. 126, 129, 1426
dcard ........................................ 1426
dcard.ini ..................................... 1426
SDOs ......................................... 1601
search ........................................ 1910, 2565, 2566
  object ...................................... 2582
search order
  identifiers ................................ 2333
  variable name ............................. 2333
Secure communication ....................... 1724
secure operation ............................ 1342
Secure protocols ............................ 1724
security ..................................... 1340, 2039
  add device user .......................... 2637
  certificate ............................... 2040
  certificate via PLC shell .................. 2044
  certificates ................................ 1819, 2592
  client ..................................... 2043
  communication with controller .......... 4201
  data security ............................. 1971
  development system ....................... 2041
  device ..................................... 1967
  disable user management .................. 2045
  encrypt the boot application, download, and online change ....... 4202
  encrypted communication ................. 2427
  encryption, signing, certificates ......... 1820
general information ....................... 2039
password device user ......................... 2639
project encryption ........................ 1819
project settings ............................ 2772
remove device user .......................... 2638
runtime system / PLC ......................... 2041
Security Agent .............................. 4201
  unencrypted communication .............. 2046
WebVisu ...................................... 2042
Security Agent .............................. 4201
certificate ................................. 2041
security functions
  certificate ............................... 2040
development system ......................... 2041
general information ........................ 2039
runtime system / PLC ......................... 2041
WebVisu ...................................... 2042
security notice ................................ 10, 12
security screen .............................. 2592
SEL ........................................... 2145
select matching bracket ..................... 2568
select none
  of the selected visualization elements .... 3365
selection
  alarm class ............................... 3389
  alarm group ................................ 3390
selector
  CFC ......................................... 2111
semi-transparency
  visualization .............................. 3401
Sequence generator .......................... 4063
sercos
  generate xml ............................... 2614
Server
  FTP .......................................... 1721
services ....................................... 1349
set
  access method, interface ................... 2490
Set
  accessor method ........................... 2493
  assignment ST .............................. 2052
  output ...................................... 2687
  remove ...................................... 2687
Index

set coil ................................ 2095
insert .................................................. 2704
set output connection, FBD/LD ............ 2708
set/reset, FBD/LD/IL .............................. 2708
settings
   code check .................................. 4217
   static analysis ................................ 4217
SFC ...................................................... 1880
   action ........................................ 2075
   action qualifiers .............................. 2065
   analyzation library ............................ 2072
   analyzation, library ........................... 1884
   branch ........................................... 2078
   build ............................................. 2763
   code generation ............................... 2763, 2767
   copy implementation ............................ 2678
   copy reference ................................... 2678
   do not display embedded objects ........... 2684
   duplication mode ................................ 2678
   element properties ............................. 2080
   implicit variables ............................. 2066
   init step ........................................ 2675
   jogging mode .................................... 2067
   jump .............................................. 2079
   library .......................................... 2767
   macro ............................................ 2079
   online mode ..................................... 2063
   processing order ............................... 2064
   programming ....................................... 1880
   project settings ............................... 2767
   properties ....................................... 2762
   step .............................................. 2073
   step time ....................................... 2066
   transition ....................................... 2073
SFC editor ............................................. 2062
   character set .................................... 2795
   layout ............................................ 2795
   online, step time ................................ 2796
   options .......................................... 2795
   properties, visibility .......................... 2796
   settings ......................................... 2795
   step actions, options ........................... 2795
   toolbar ......................................... 2048
SFC flag ................................................. 2067
shadowing ............................................. 2333
shadowing rules ................................. 2333
SHL ....................................................... 2141
short form feature ............................... 1887
short-circuit evaluation ...................... 2096
show source position: ............................ 2589
show windows ....................................... 1807
show/hide implementation view ................ 2672
SHR ..................................................... 2142
signature
   compiled library ............................... 2033
   encryption ....................................... 2039
   enforce signing of compiled libraries ....... 2033
signing
   boot application ................................ 1915
   certificate ....................................... 1820
   library project ................................... 2517
   with certificate, instructions ............... 1830
Simple motion ........................................ 4543
   simulation ....................................... 1980
   command ......................................... 2640
   for testing ...................................... 1980
SIN ...................................................... 2196
   single cycle ..................................... 2196
   convert ........................................... 2159
   SINT .............................................. 2159
   SINT_TO__UXINT ................................. 2159
   SINT_TO__XINT ................................ 2159
   SINT_TO__XWORD ................................. 2159
   SINT_TO_BIT ..................................... 2159
   SINT_TO_BOOL ................................... 2159
   SINT_TO_BYTE .................................... 2159
   SINT_TO_DATE .................................... 2159
   SINT_TO_DINT .................................... 2159
   SINT_TO_DWORD .................................. 2159
   SINT_TO_DT ....................................... 2159
   SINT_TO_INT ..................................... 2159
   SINT_TO_LDATE .................................. 2159
   SINT_TO_LDT ..................................... 2159
   SINT_TO_LINT .................................... 2159
   SINT_TO_LREAL .................................. 2159
   SINT_TO_LTIME ................................... 2159
   SINT_TO_LTOD .................................... 2159
   SINT_TO_LWORD .................................. 2159
   SINT_TO_REAL .................................... 2159
   SINT_TO_STRING .................................. 2159
SINT_TO_TIME ................................. 2159
SINT_TO_TOD ................................. 2159
SINT_TO_UDINT .............................. 2159
SINT_TO_UINT ............................... 2159
SINT_TO_ULINT .............................. 2159
SINT_TO_USINT .............................. 2159
SINT_TO_WORD ............................... 2159
SINT_TO_WSTRING ......................... 2159
SIZEOF ........................................ 2138
slider ........................................ 3134, 3559
visualization element ...................... 3134, 3559
SM560-S ...................................... 94, 174
SM560-S-FD-1 ................................ 94, 174
SM560-S-FD-4 ................................ 94, 174
smart tag .................................... 1888
SmartCoding ................................. 1885
SmartCoding, options ....................... 2796
SMTP/SMTPS .................................. 4361
SNMP .......................................... 4362
SNTP ............................................ 416
IEC 61850 server ........................... 1707
software ........................................ 145
source code .................................. 1980
download from controller .................. 2559
download to controller ..................... 2560
download, project setting .................. 2770
management .................................. 1833
write, to connected device ............... 2631
space character
in the text editor ............................ 2799
spin box ....................................... 3140, 3565
visualization element ...................... 3140, 3565
SQRT .......................................... 2194
ST .............................................. 1878, 2087
assignment ................................... 2051
expression .................................... 2050
extended ........................................ 1879
format code .................................. 2581
programming in ................................ 1879
R= ............................................. 2053
reset assignment ............................ 2053
S= ............................................. 2052
set assignment .............................. 2052
ST code
eexecute, input action ....................... 3379
extract ........................................ 4215
ST code in FBD, LD ......................... 2094
ST editor ..................................... 2049
automatic formatting ...................... 2049
browse .......................................... 2049
format code .................................. 2581
online operation ............................ 2050
option .......................................... 2798
syntax error .................................. 2049
stack checking of recursive methods ....... 2281
standard commands ......................... 2562
Standard CPU ................................ 176
standard data types ......................... 2234
standard keyboard handling
activate, visualization ..................... 2895
standard metrics ............................ 4213
start page ..................................... 2596
startup parameters
EtherCAT module ............................ 1624
EtherCAT Slave .............................. 1619
state
device state .................................. 4606
state LEDs ..................................... 148, 1338
State LEDs
AC522 ......................................... 691
statement ....................................... 2055
IF ............................................. 2055
set next ...................................... 2648
show next ..................................... 2648
static
code analysis ................................ 1904
static analysis
getting started .............................. 4209
pragmas ........................................ 4228
run ............................................. 4212
Static Analysis Light ....................... 1904
project settings ............................. 2773
static variable ............................... 2119
Statistic analysis .......................... 4209
status
device editor ............................... 2460
device state .................................. 4606
EtherCAT ..................................... 1610
KNX ............................................ 1730
SFC actions ................................... 2066
project settings ................................. 4350
repository ....................................... 4316
repository browser .............................. 4322
version control ................................ 4316
version Info ................................... 4355
switch ............................................ 3231, 3656
visualization element .......................... 3231, 3235, 3656, 3660
symbol
  access rights .................................. 1941
  access to controller ............................. 2458
  overlay ........................................... 4319
symbol configuration ............................ 1941, 2523
  access rights .................................. 2523
  add ............................................. 2523
  comments and attributes .................... 2526
  data layout .................................... 2523
  editor ......................................... 2523
OPC UA ............................................ 2523
  symbol set ..................................... 1941
  task synchronization ........................... 2527
symbol file ....................................... 2523
symbol library
  project environment of visualization ...... 2780, 3386
  update ......................................... 2780, 3386
symbol rights
  device editor ................................... 2458
  symbol access .................................. 1941
symbol set
  symbol configuration .......................... 1941
symbol, pragma ................................... 2314
synchronize
  cycle-consistent variables .................. 1855
  file by application download ............... 2436
syntax check .................................... 2621
system diagnosis ............................... 4613, 4619
system event .................................... 2533
  function call .................................. 2533
system libraries
cmp libraries .................................... 3773
system protection ............................... 1341
system structure
AC500 ............................................ 86
AC500-eCo ....................................... 87
S500 ............................................. 86
S500-eCo ........................................ 87

system time
  output in visualization ....................... 3331
system variable ................................. 2022
  operation control ................................ 2022
SYSTEM.VAR_INFO ................................ 2208
  data structure .................................. 2208

T
T
  constant ....................................... 2223
  literal ......................................... 2223
TA521 ........................................... 1319
TA523 ........................................... 1328
TA524 ........................................... 1323
TA525 ........................................... 1330
TA526 ........................................... 1324, 1331
TA535 ........................................... 1332
TA5101-4DI
  digital input option board .................... 218
TA5101-4DIW
  digital input option board .................... 218
TA5105-4DOT
  digital output option board ................... 224
TA5105-4DOTW
  digital output option board ................... 224
TA5110-2DI2DOT
  digital I/O option board ....................... 231
TA5110-2DI2DOW
  digital I/O option board ....................... 231
TA5120-2AI-UI
  analog input option board ..................... 240
TA5120-2AI-UIW
  analog input option board ..................... 240
TA5123-2AI-RTD
  analog input option board ..................... 255
TA5123-2AI-RTW
  analog input option board ..................... 255
TA5126-2AO-UI
  analog output option board .................... 269
TA5126-2AO-UIW
  analog output option board .................... 269
TA5130-KNXPB
  option board KNX address push button ........ 280
TA5130-KNXPBW
  option board KNX address push button ........ 280
Index

TA5131-RTC
   option board for real-time clock ........ 283
TA5141-RS232I
   option board, COMx serial communication ... 285
TA5141-RS232IW
   option board, COMx serial communication ... 285
TA5142-RS485
   option board, COMx serial communication ... 296
TA5142-RS485I
   option board, COMx serial communication ... 289
TA5142-RS485IW
   option board, COMx serial communication ... 289
TA5142-RS485W
   option board, COMx serial communication ... 296
TA5211-TSCL-B ..................... 116, 1292
TA5211-TSPF-B ..................... 116, 1292
TA5212-TSCL ....................... 116, 1292
TA5212-TSPF ....................... 116, 1292
TA5220-SPF5 ....................... 116, 1292
TA5220-SPF6 ....................... 116, 1292
TA5220-SPF7 ....................... 116, 1292
TA5220-SPF8 ....................... 116, 1292
TA5300-CVR ........................... 1302
TA5350-AD ........................ 1286, 1309
TA5400-SIM ............................ 1305
TA5450-CASE ............................ 21

tab
   selection, visualization elements .......... 3342

tab group
   new horizontal ........................ 2670
   new vertical .......................... 2670

tab order
   element list ................................ 3342

table .................................. 3106, 3531
   display structured variables ............ 2864, 2918
   visualization element .................. 3106, 3531
   visualizing data arrays ................. 2917

table of contents ................................ 2674

tabs .................................. 3084, 3509
   reference visualizations ................... 2948
   visualization element .................. 3084, 3509

TAN .................................. 2197

Target change .......................... 1414, 1475

TargetVisu
   object .................................. 3408

task .................................. 2538
   check .................................. 1994
   configuration .......................... 2538
   cycle consistency ...................... 1855
   cycle times ........................... 2021
   jitter, latency .......................... 1915
   monitor ............................... 2021
   monitoring ............................. 2536
   processing order ...................... 1914
   statistics ............................. 2021
   task cycle time ......................... 2538
   task-local time .......................... 2538
   type .................................. 2538
   watchdog ............................... 2538

   task configuration ...................... 1914
     basic settings .......................... 2533
     basics ................................. 1914
     create .................................. 1914
     jitter latency .......................... 1915
     object .................................. 2533
     properties ............................... 2533

   task deployment
     check .................................. 1994
     device editor .......................... 2459

   task groups ............................ 2537

   task monitoring, online .................... 2536

   task-local
     declare GVL .............................. 1855
     GVL ................................... 2466

TB ................................. 90, 377
TB56xx ................................. 377
TB511
   Technical data .......................... 383

TB521
   Technical data .......................... 383

TB523
   Technical data .......................... 383

TB541
   Technical data .......................... 383

TB5600 ................................. 377
   Technical data .......................... 383

TB5610 ................................. 377
   Technical data .......................... 383

TB5620 ................................. 377
   Technical data .......................... 383

4764 3ADR010583, 1, en_US 2024/01/05
Index

TB5640 ................................ 377
Technical data ...................................... 383
TB5660 ................................ 377
Technical data ...................................... 383
Technical data
AC522 ............................................. 694
TB511 ............................................. 383
TB521 ............................................. 383
TB523 ............................................. 383
TB541 ............................................. 383
TB5600 ........................................... 383
TB5610 ........................................... 383
TB5620 ........................................... 383
TB5640 ........................................... 383
TB5660 ........................................... 383
teClass ............................................. 4618
teEvent ............................................. 4618
teHwId ............................................. 4618
Telecontrol ......................................... 1647
template element ................................... 3350
visualization ........................................ 3350
temporary variable ................................... 2119
terminal base ......................................... 377
mounting and demounting ............................ 107, 111
terminal block for onboard I/O (AC500-eCo)  116
terminal unit
for communication modules ....................... 1270
for S500 I/O modules .............................. 938
Terminal unit for PROFINET communication interface modules ....................... 1282
terminal units for communication interface modules ........................................... 1274, 1278
terminal units for I/O modules ....................... 938, 945
test functions ........................................ 2500
also in libraries ...................................... 2500
TEST_AND_SET .................................. 2215
testing a program ..................................... 51, 82
text
display, visualization ................................ 2878
output configuration ................................ 2881
translate and manage ................................. 1891
visualization, multi-language capability .......... 2906
text display
animate in visualization ............................. 2883
animating with a visualization element .......... 2914
text editor ........................................... 2569, 3274, 3699
option .................................................. 2798
show whitespace ...................................... 2566
visualization element ................................ 3274, 3699
Text Editor
configuring, visualization ......................... 2934
text field ............................................. 3113, 3538
configure dynamic text output .................... 2880
configure input ...................................... 2882
visualization element ................................ 3113, 3538
text field
configuring the display, visualization .......... 2934
configuring the processing, visualization .... 2934
text input
define for all visualizations throughout the application ........................................ 2891
text list
add language .......................................... 2728
add language and translate text .................... 1891
availability ........................................... 2765
check ID ............................................... 2731
compare and export differences .................... 1893
display text dynamically .............................. 1898
download ............................................... 2765
DUT ..................................................... 2732
export ................................................ 1891
export as unicode text ................................ 2729
export everything as text ............................ 2728
export/import ........................................ 2729
for dynamic application .............................. 1898
for input assistance ................................... 1892
import file ........................................... 1892
insert text ............................................ 2729
names and directories for visualization .......... 3385
object .................................................. 2532
properties .............................................. 2765
remove language ..................................... 2730
remove unused entries ............................... 2731
rename language ..................................... 2730
update ID ............................................... 2731
visualization .......................................... 2906
text list support
add ...................................................... 2732
DUT ..................................................... 2732

2024/01/05 3ADR010583, 1, en_US 4765
Index

union
  object DUT .................................. 2461
  UNION ........................................ 2268
unit conversion
  link with variable .......................... 2939
  object ....................................... 2549
unlock connection ............................ 2693
UNTIL ........................................... 2058
update
  boot project ............................... 1430
  firmware .................................... 1430
  IDs in text list ............................ 2731
  parameters, fbd/id/il cfc .................. 2710
  SVN project ................................ 4340
update referenced pins
  refactoring .................................. 2578
update structured variables ..................... 2727
upgrade ......................................... 1394, 1799
UPPER_BOUND .................................. 2252
array ........................................... 2252
uppercase ....................................... 2567
keyword ......................................... 2796
URL
  open web page, input action ................... 3373
USB ............................................... 148
user
  login as this .................................. 1828
user group ....................................... 1821, 3404
  activate group hierarchy, visualization .... 3406
  hierarchy for permissions, visualization ... 3404
  import/export user groups, visualization ... 3404
user input
  visualization element .......................... 2886
user input event
  capture in application ........................ 2895
user interface
  language ....................................... 2790
user management .................................. 1821
  controller, device ............................ 1971
  create for visualization ..................... 3400
  device, enforce ................................ 1967
disable .......................................... 2045
general information ............................ 2039
input action, visualization .................... 3370
options, visualization .......................... 3383
project .......................................... 1825
project settings ................................ 2768
visualization ................................... 3403
user-defined attributes ......................... 2272
user-defined data type .......................... 2461
user-defined parameters
  EtherNet/IP adapter ............................ 2829
users and groups
  device editor ................................... 2450
  project settings ................................ 2768
  visualization ................................... 3403
  USINT ......................................... 2235
    convert ....................................... 2159
    USINT_TO___UXINT ............................ 2159
    USINT_TO___XINT ................................ 2159
    USINT_TO___XWORD ................................ 2159
    USINT_TO_BIT .................................. 2159
    USINT_TO_BOOL ................................ 2159
    USINT_TO_BYTE ................................ 2159
    USINT_TO_DATE ................................ 2159
    USINT_TO_DINT .................................. 2159
    USINT_TO_DT ................................... 2159
    USINT_TO_DWORD .................................. 2159
    USINT_TO_DWORD .................................. 2159
    USINT_TO_INT .................................. 2159
    USINT_TO_LDATE ................................ 2159
    USINT_TO_LDT ................................... 2159
    USINT_TO_LINT .................................. 2159
    USINT_TO_LREAL ................................ 2159
    USINT_TO_LTIME ................................ 2159
    USINT_TO_LTOD ................................... 2159
    USINT_TO_LWORD .................................. 2159
    USINT_TO_REAL .................................. 2159
    USINT_TO_SINT .................................. 2159
    USINT_TO_STRING ................................ 2159
    USINT_TO_TIME .................................. 2159
    USINT_TO_UDINT ................................ 2159
    USINT_TO_UINT .................................. 2159
    USINT_TO_ULINT ................................ 2159
    USINT_TO_WSTRING ................................ 2159

V
V2.3 project ....................................... 1809
V2/V3 ............................................... 6
voltage sag .................................. 1480
VUM_ChangePassword
  user management dialog, visualization .... 3400
VUM_Login
  user management dialog, visualization .... 3400
VUM_UserManagement
  user management dialog, visualization .... 3400
W
  W ..................................... 2231
    size prefix .......................... 2231
wall mounting accessory .................... 1324, 1331
warm start ................................ 2634
warning disable, pragma .................... 2315
warning notices ................................ 10, 12
warning restore, pragma ..................... 2315
watch
  add all forces to watchlist ................ 2585
  open view ................................ 2584
  watch all forces .......................... 1989
watch list .................................. 2002
  watch all forces .......................... 2584
Watchdog ................................... 4425
watchlist .................................. 2584
  add variable ................................ 2743
web browser .................................. 3262, 3687
  visualization element ..................... 3262, 3687
  visualization, example ..................... 2865
webvisu ..................................... 2974
  calling a page in the browser ............ 2976
  execute .................................. 2974
WebVisu
  object .................................... 3409
  security .................................. 2042
  WHILE .................................... 2058
whitespace .................................. 2566
  show in text editor ........................ 2566
window
  auto hide ................................ 2671
  dock ...................................... 2671
  float ..................................... 2671
  reset layout ................................ 2670
window <n> .................................. 2673
windows ..................................... 2672
  hide ...................................... 1807
  layout ..................................... 1806
  move ...................................... 1806
  resize ..................................... 1806
  show ....................................... 1807
  toggle ..................................... 1807
Windows Certificate Store ..................... 1820
Windows server ................................ 1594, 1647, 1799
wink ......................................... 2640
word
  addressing mode ............................ 2231
  convert .................................... 2159
    WORD_TO___XWORD ......................... 2159
    WORD_TO__UXINT .......................... 2159
    WORD_TO__XINT ........................... 2159
    WORD_TO_BIT .............................. 2159
    WORD_TO_BOOL .............................. 2159
    WORD_TO_BYTE .............................. 2159
    WORD_TO_DATE ............................. 2159
    WORD_TO_DINT ............................. 2159
    WORD_TO_DT .............................. 2159
    WORD_TO_DWORD ............................ 2159
    WORD_TO_INT .............................. 2159
    WORD_TO_LDATE ............................ 2159
    WORD_TO_LDT .............................. 2159
    WORD_TO_LINT ............................. 2159
    WORD_TO_LREAL ............................ 2159
    WORD_TO_LTOD ............................ 2159
    WORD_TO_LWORD ............................ 2159
    WORD_TO_REAL .............................. 2159
    WORD_TO_SINT ............................. 2159
    WORD_TO_STRING ........................... 2159
    WORD_TO_TIME .............................. 2159
    WORD_TO_TOD .............................. 2159
    WORD_TO_UDINT ............................ 2159
    WORD_TO_UINT ............................. 2159
    WORD_TO_ULINT ............................ 2159
    WORD_TO_USINT ............................ 2159
    WORD_TO_WSTRING .......................... 2159
worksheet ..................................... 2685
  write ...................................... 1987
  write protection ............................ 1824
  project .................................... 1823
writing values

- command .................................. 2649
- prepare value ............................. 2749
- WSTRING .................................. 2242
- convert .................................... 2175
- index access .............................. 2244
- WSTRING_TO___UXINT .................... 2175
- WSTRING_TO___UXWORD .................... 2175
- WSTRING_TO___XINT ...................... 2175
- WSTRING_TO_BIT .......................... 2175
- WSTRING_TO_BOOL ...................... 2175
- WSTRING_TO_BYTE ...................... 2175
- WSTRING_TO_DATE ...................... 2175
- WSTRING_TO_DINT ...................... 2175
- WSTRING_TO_DT ......................... 2175
- WSTRING_TO_DWORD ..................... 2175
- WSTRING_TO_INT ...................... 2175
- WSTRING_TO_LDATE ..................... 2175
- WSTRING_TO_LDT ....................... 2175
- WSTRING_TO_LINT ..................... 2175
- WSTRING_TO_LREAL .................... 2175
- WSTRING_TO_LTOD ..................... 2175
- WSTRING_TO_LWORD .................. 2175
- WSTRING_TO_REAL .................... 2175
- WSTRING_TO_STRING .................. 2175
- WSTRING_TO_TIME .................... 2175
- WSTRING_TO_TOD ..................... 2175
- WSTRING_TO_UDINT ................... 2175
- WSTRING_TO_UINT ..................... 2175
- WSTRING_TO_ULINT .................... 2175
- WSTRING_TO_USINT .................... 2175
- WSTRING_TO_WORD ................... 2175

X

- X ........................................ 2231
  - size prefix ............................ 2231
- XADD ................................ 2213
- XOR .................................. 2140
- XORN ................................ 2087
- XSIZEOF ................................ 2138

Z

- zoom ..................................... 2048
  - factor ................................ 2048